Rome Now Platform Capabilities

Last updated: August 2, 2021
# Table of Contents

**Now Platform capabilities**..............................................................................................................1

- Advanced Work Assignment............................................................................................................6
  - Get started with Advanced Work Assignment..............................................................................9
- Service channels.............................................................................................................................18
- Work item queues...........................................................................................................................47
- Work assignments...........................................................................................................................58
- Using Agent Affinity.......................................................................................................................65
- Agent Inbox controls.......................................................................................................................70
- Management......................................................................................................................................75
- Work items.........................................................................................................................................85
- Advanced Work Assignment monitoring page..............................................................................88
- Activate Conversational Messaging...............................................................................................92
- Configure messaging actions...........................................................................................................93
- Enable logging for Advanced Work Assignment...........................................................................95
- Analytics and Reporting Solutions for Advanced Work Assignment..........................................95

**Workspace**........................................................................................................................................104

- Exploring Workspace.......................................................................................................................105
- Admins using Workspace.................................................................................................................142
- Agents using Workspace....................................................................................................................481

**Cloud Call Center**.........................................................................................................................599

- Exploring Cloud Call Center...........................................................................................................600
- Setting up Cloud Call Center............................................................................................................605
- Using Cloud Call Center...................................................................................................................621
- Integrating Cloud Call Center with other applications...............................................................624
- Cloud Call Center reference............................................................................................................632

**Common Service Data Model**......................................................................................................637

- Common Service Data Model conceptual model............................................................................638
- Set up the CSDM environment..........................................................................................................640
- Common Service Data Model life cycle states...............................................................................640
- Synchronize group assignment attributes.......................................................................................642
Common Service Data Model (CSDM) navigation pane.............................646
Common Service Data Model domains..................................................647
Request Catalog..................................................................................663
Common Service Data Model-to-Configuration Management Database
(CMDB) mapping.............................................................................664
Configuration Item relationships in the Common Service Data
Model.................................................................................................664
Common Service Data Model framework implementation stages......666
Migrate to the Common Service Data Model framework...............680
Common Service Data Model product views.....................................683
Configuration Management Database...................................................740
Configuration Management and the CMDB.......................................741
Domain separation and Configuration Management Database
(CMDB).............................................................................................743
ITIL and Configuration Management....................................................744
ITIL.....................................................................................................745
CMDB schema model..........................................................................748
CMDB CI Class Models store app........................................................813
Populating the CMDB.........................................................................873
Integrating third-party data into the CMDB........................................876
Multisource CMDB.............................................................................999
Baseline CMDB................................................................................1011
Managing proposed changes..............................................................1014
CI relationships in the CMDB...............................................................1021
CMDB classifications..........................................................................1044
Querying the CMDB...........................................................................1054
CMDB Search......................................................................................1083
CMDB groups......................................................................................1089
Application services...........................................................................1092
CMDB Data Manager.........................................................................1161
CMDB CI Lifecycle Management (legacy)............................................1177
CMDB Identification and Reconciliation..............................................1189
Monitor system foundations in the CSDM and the CMDB Data Foundations Dashboards (Version 1.3.0) ................................................................. 1266
CMDB Health ................................................................................................. 1277
Duplicate Cls .................................................................................................... 1324
CI Class Manager ............................................................................................. 1337
Agent Workspace for Configuration Management Database (CMDB) ................................................................. 1338
View CMDB benchmarks ............................................................................... 1343
CMDB APIs (CMDB SDK) ............................................................................... 1345
Quick start tests for Configuration Management Database (CMDB) ................................................................. 1346
Useful related lists in Cl forms ........................................................................ 1351
Activate the Extended CMDB plugins ............................................................ 1352
Enterprise CMDB ............................................................................................ 1353
Table form views ............................................................................................. 1357
Analytics and Reporting Solution for Configuration Management (CMDB) ................................................................. 1358
Connect ............................................................................................................ 1358
Supported browsers for Connect ..................................................................... 1359
Activate Connect .............................................................................................. 1360
Activate Connect Support ................................................................................. 1364
Connect interface ............................................................................................. 1369
Enable or disable Connect notifications globally ............................................. 1376
Edit which notifications you receive for a conversation ................................ 1379
Upload a profile picture ................................................................................. 1381
Drag a file into a Connect conversation .......................................................... 1382
Share a Visual Task Board in a Connect conversation .................................. 1382
Mention a user in a Connect conversation ...................................................... 1383
Connect administration ................................................................................... 1384
Connect Chat .................................................................................................... 1396
Connect Support ............................................................................................... 1405
Content Management System ......................................................................... 1429
Content Management design .......................................................................... 1430
Domain separation and the Content Management System .............................. 1439
Configure Content Management sites ........................................ 1439
Content Management integration points ................................ 1507
Content Management testing ................................................. 1517
Global search in Content Management ................................ 1515
CMS translation ..................................................................... 1516

Conversational Interfaces ..................................................... 1517
Connections and Credentials ................................................. 1523
Introduction to credentials, connections, and aliases .......... 1524
Scope protections for Credentials and Connections .............. 1526
Domain separation and Credentials and Connections ............ 1527
Connection & Credential configuration templates ............... 1528
Getting started with connections ......................................... 1539
Getting started with credentials ......................................... 1552
Configure an authentication algorithm ................................ 1629
Check IP service affinity for Discovery and Orchestration .... 1630

Data Certification .................................................................. 1631
Activate Data Certification .................................................. 1632
Certification schedules ....................................................... 1640
Certification tasks ............................................................. 1641
Certification elements ....................................................... 1643
Certification instances ...................................................... 1644
Certification audit instances .............................................. 1645
Certification audit definition .............................................. 1645
Data Certification Overview module ................................. 1645
Data Certification planning ............................................... 1648
Data certification performance ............................................ 1660
Reassign a certification task ................................................. 1668
Send certification task reminders ........................................ 1669
Mark a certification task as closed incomplete .................... 1670
Certification tasks cancellation ........................................ 1671
Domain separation and Data Certification ......................... 1672
Decision Tables .................................................................. 1674
Cluster nodes in a Dependency Views map................................................. 1730
Virtual grouping of nodes in a Dependency Views map.............................. 1731
Use Dependency Views........................................................................... 1733
Administer Dependency Views................................................................. 1740
Properties for Dependency Views............................................................. 1753
Components installed with Dependency Views.......................................... 1758
E-signature................................................................................................. 1759
Activate e-signature.................................................................................. 1760
Configure an e-signature template............................................................. 1762
Edge Encryption......................................................................................... 1766
Understanding Edge Encryption................................................................. 1767
Planning for Edge Encryption...................................................................... 1781
Edge Encryption installation........................................................................ 1793
Edge Encryption upgrades........................................................................... 1856
Edge Encryption configuration..................................................................... 1866
Domain separation and Edge Encryption.................................................... 1920
Data integration with Edge Encryption....................................................... 1920
Edge Encryption diagnostics and performance......................................... 1925
Entity View Action Mapper....................................................................... 1930
Getting started: Create a multi-data source list display in Entity View Action Mapper......................................................................................... 1933
Create an EVAM definition........................................................................ 1938
Define a datasource..................................................................................... 1940
View configurations, view templates, and configuration bundles for EVAM.............................................................................................................. 1941
Flow Designer............................................................................................. 1947
Getting started with flows........................................................................... 1950
Architecture Overview.................................................................................. 1968
Flows............................................................................................................ 1993
Action Designer.......................................................................................... 2186
Transform functions...................................................................................... 2350
Domain separation and Flow Designer....................................................... 2378
User access to Flow Designer....................................................................... 2382
Spokes ......................................................................................................................... 2394
Change a flow or action's default title ................................................................. 2408
Instance Scan ............................................................................................................. 2410
Getting started with Instance Scan ...................................................................... 2411
Getting started with checks .................................................................................... 2412
Suites management .................................................................................................. 2422
Execution and scheduling of scans ........................................................................ 2423
Reviewing of scans .................................................................................................... 2434
Instance Scan dashboard ......................................................................................... 2441
Instance Scan table cleanup policies ....................................................................... 2445
Timeout threshold ...................................................................................................... 2446
HTTP Response Headers ......................................................................................... 2448
Configure HTTP response headers ........................................................................ 2451
Instance Data Replication ....................................................................................... 2456
Request an Instance Data Replication (IDR) subscription ..................................... 2459
Set up Instance Data Replication (IDR) ................................................................. 2462
Grant access to the replicated data for Instance Data Replication (IDR) .................... 2475
Transform replication data for Instance Data Replication (IDR) ...................... 2478
Bidirectional replication for Instance Data Replication (IDR) ............................... 2482
Discrete mapping in producer replication sets for Instance Data Replication (IDR) ................................................................................................................. 2485
Seed a consumer instance for Instance Data Replication ....................................... 2487
Trigger workflows after replications for Instance Data Replication (IDR) .............. 2489
Data privacy in Instance Data Replication (IDR) .................................................. 2489
Instance Data Replication (IDR) monitoring dashboard ......................................... 2490
Instance Data Replication Queue dashboard ......................................................... 2497
Resolve data replication errors for Instance Data Replication (IDR) .......................... 2501
Adapter descriptions for Instance Data Replication (IDR) ..................................... 2516
Instance Data Replication (IDR) and tables on an exclusion list ............................ 2520
IntegrationHub ............................................................................................................. 2521
Request IntegrationHub ............................................................................................ 2523
Use the IntegrationHub Usage dashboard.......................... 2533
IntegrationHub available spokes...................................... 2535
IntegrationHub - Import.................................................. 3672
Connections dashboard................................................. 3686
Domain separation and IntegrationHub.............................. 3690
Support multiple connections....................................... 3691
Data Stream actions and pagination............................... 3695
REST API trigger......................................................... 3720
Integration steps........................................................ 3726
IntegrationHub Remote Process Sync............................... 3770
Password reset using IntegrationHub............................... 3848
Client Software Distribution using IntegrationHub............. 3848
Interaction Management............................................... 3886
  Activate the interaction management system.................. 3886
  Interaction configuration overview............................ 3887
  Create an interaction............................................... 3889
  Interaction wrap up................................................ 3890
Knowledge Management............................................... 3897
  Additional plugins for Knowledge Management.............. 3899
  Components installed with Knowledge Management Core.. 3901
  Knowledge Management roles.................................... 3904
  Knowledge Management properties............................ 3905
  Scoped knowledge bases......................................... 3938
  Knowledge Management setup guide for admins.............. 3939
  Domain separation and Knowledge Management............... 3941
  Knowledge base setup guide for knowledge admins and managers.................................................... 3945
  Quick start tests for Knowledge Management................ 3947
  Configure Knowledge Management............................... 3954
  Automating feedback management to improve content....... 4088
  Knowledge-Centered Service configuration.................. 4093
  Use Knowledge Management...................................... 4114
  Machine learning solutions for Knowledge Management..... 4272
Knowledge demand insights..........................................................4276
Self-Service Analytics...............................................................4294
Translation management.............................................................4315
Now Mobile for Knowledge Management..................................................4320
Migrate to Knowledge Management v3.................................................4327
Legacy: Chat.................................................................................4335
  Legacy: Get started with Chat.........................................................4336
  Legacy: Installed with Chat..........................................................4337
  Legacy: Chat use..........................................................................4342
  Legacy chat administration............................................................4359
  Legacy: Help desk chat.................................................................4365
Legacy Notify..................................................................................4373
  Working with Legacy Notify.........................................................4373
  Administering Legacy Notify........................................................4381
  Installed with Legacy Notify..........................................................4389
  NotifyNow API (Legacy) - Global..................................................4394
Live Feed..................................................................................4412
  Live Feed browser support..........................................................4413
  Activate Live Feed........................................................................4413
  Administer live feed......................................................................4413
  Use Live Feed..............................................................................4440
MetricBase..................................................................................4491
  Requesting the MetricBase product...............................................4493
  Getting familiar with MetricBase.................................................4494
  Define and collect MetricBase data...............................................4504
  Detect anomalies in MetricBase data using predictive models........4510
  Access MetricBase data...............................................................4514
  MetricBase triggers....................................................................4516
  Maintain MetricBase...................................................................4536
  Get familiar with MetricBase APIs..................................................4539
  Domain separation and MetricBase...............................................4544
MID Server..................................................................................4545
Configure MID Server network connectivity.............................. 4548
Installing the MID Server..................................................... 4553
Configuring MID Servers...................................................... 4593
Securing and encrypting MID Server data................................ 4678
MID Server upgrades........................................................... 4719
Resolving MID Server issues.................................................. 4731
MID Server reference information.......................................... 4759
Notifications........................................................................... 4841
Email setup.............................................................................. 4842
System notifications............................................................... 4910
Provider notification............................................................... 5102
Email client............................................................................ 5114
Automating system responses to inbound email........................ 5140
Notify..................................................................................... 5173
Activate Notify....................................................................... 5174
Notify-Twilio Direct driver...................................................... 5176
Notify Zoom connector........................................................... 5185
Notify voice and SMS capabilities......................................... 5187
Using Notify with tasks........................................................... 5200
Using Notify with Incident Communications Management........ 5203
Using Notify with On-Call Scheduling..................................... 5206
Notify administration............................................................. 5209
Notify connector for Microsoft Teams..................................... 5240
Orchestration.......................................................................... 5264
Introduction to Orchestration.................................................. 5265
Domain separation and Orchestration....................................... 5268
Activate Orchestration............................................................. 5268
Orchestration applications...................................................... 5296
Orchestration examples.......................................................... 5357
Orchestration activity packs.................................................... 5364
Orchestration activity designer............................................... 5520
Orchestration databus............................................................. 5638
Content Management and Service Portal........................................6727
Supported features in Service Portal........................................6745
Domain separation and Service Portal.................................6755
Antivirus Scanning in Service Portal.................................6756
Set up Service Portal..........................................................6758
Create a portal.................................................................6764
Service Portal pages............................................................6792
Service Portal widgets..........................................................6824
Service Portal search............................................................7010
Service Portal announcements........................................7045
Service Portal security.......................................................7051
Service Portal SCSS Primer................................................7078
Performance Analytics Content Pack for Service Portal........7086
User Experience Analytics for Service Portal........................7092
Skills Management..............................................................7106
Configuring skills..............................................................7109
Managing skills...............................................................7114
Associating skills with work items......................................7117
Routing work items to agents based on skills......................7122
Skills Management dashboard and reporting......................7123
Domain separation and Skills Management.........................7127
Quick start tests for Skills Management.............................7128
Subscription Management..................................................7130
Subscription Management overview..................................7132
Setting up Subscription Management...............................7133
Using Subscription Management........................................7148
Survey Management..........................................................7184
Get started with Survey Management...............................7184
Survey responses and results............................................7192
Survey administration.......................................................7208
Task Communications Management....................................7308
Task Communications Management process........................7308
Workflow activities

Index
Now Platform capabilities

Digitize your workflows and run them at scale by using the core capabilities of the Now Platform®. When you activate and configure these features, you can create custom business logic, manage and secure data, and build alternate user interfaces.

Digitize your workflows with the Now Platform

Use native platform intelligence to predict, prioritize, and proactively manage the work that matters most for your own organization.

View and download the full infocard for a highlight of Now Platform capabilities features.

<table>
<thead>
<tr>
<th>Automate work with Flow Designer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Flow Designer to quickly build and extend modern workflow apps on a single, unified platform that works across the enterprise.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Connect your enterprise with IntegrationHub</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build your own reusable workflow apps that are powered by your business data on a single platform, or extend your own apps by using available integrations.</td>
</tr>
</tbody>
</table>
Create engaging app experiences with Service Portal
Design a portal interface that lets your users browse options, discover articles, or get help.

Improve agent efficiency with Agent Workspace
Enable your agents to work on multiple issues concurrently with an intuitive layout.

Automate work with Flow Designer

Turn business processes into digital workflows to deliver more intuitive experiences by extending ServiceNow solutions or building new workflow apps with no-code development tools.
Connect your enterprise with IntegrationHub

Connect your systems and apps using Now Platform APIs and tools. Use the ServiceNow Store to get access to an entire ecosystem of innovation for enterprise software.

Create engaging app experiences with Service Portal

With Service Portal, you can deliver your apps to employees through a portal that they can access from any device, at any time.
Improve agent efficiency with Workspace

Solve issues faster with a workspace that is built to facilitate resolutions. From a single view, agents get full context and AI-assisted recommendations to resolve issues quickly. Agents can communicate with customers from the same interface while reviewing issues.

Get started

• Learn how to build your first flow. See Getting started with flows
• Review the list of available IntegrationHub spokes. See IntegrationHub available spokes
• Learn how to build your first portal. See Understanding Service Portal
• Learn how to set up and use Workspace. See Exploring Workspace

Applications and features

• Advanced Work Assignment
• Cloud Call Center
• Common Service Data Model
• Configuration Management Database
• Connect
• Connections and Credentials
• Conversational Interfaces
• Content Management System
• Dependency Views
• Data Certification
• Decision Tables
• Document Services
• E-Signature
• Edge Encryption
• Flow Designer
• Instance Data Replication
• IntegrationHub
• Interaction Management
• Knowledge Management
• Legacy: Chat
• Legacy Notify
• Live Feed
• MetricBase
• MID Server
• Notifications
• Notify
• Orchestration
• Password Reset application
• Process Automation Designer
• Retrieving external data using remote tables and scripts
• Response templates
• Self-service
• Service administration
• Service Catalog
• Service Portal
• Skills Management
• Subscription Management
• Survey Management
• Task Communications Management
Use the ServiceNow® Advanced Work Assignment (AWA) feature to automatically assign work items to your agents, based on their availability, capacity, and optionally, skills. AWA pushes work to qualified agents using work item queues, routing conditions, and assignment criteria that you define. Agents see their assignments in their Agent Workspace inbox.

Customers use different channels to request service, for example, chats, cases, or incidents. Requests from customers create task or interaction records that store information about these objects, called work items.

AWA automatically routes work items to queues that focus on certain types of support, using criteria (such as priority or customer status) that you provide. Queues can be defined based on need or type, for example product or critical cases. You also identify the agent groups responsible for work in the queue. AWA then applies assignment rules that you set and use agent availability, capacity, and skills (if defined) to assign work to the most qualified agent.

Advanced Work Assignment components

Service channels
A means of providing customer service. AWA offers base system channels for chats, cases, incidents, and walk-up centers. For each channel, you can set attributes such as agent capacity and utilization conditions to control the work handled in the channel.

**Work items**
A single piece of work handled by an agent from start to completion. For example, one chat or one case is an object that is routed and assigned to agents.

**Work item queues**
A queue stores a specific type of work item for a service channel. AWA admins can create queues that focus on certain types of support within the channel, such as VIP customers or critical cases. AWA routes work items to queues based on specific conditions or requirements that you define, such as customer status, or region. Groups assigned to each queue handle the incoming work items. Once work items are placed in a queue, AWA can then assign items to available agents based on assignment rules and agent availability and capacity.

**Assignment groups**
Agents belong to specific groups organized by the type of work assigned to them. You provide details about an assignment group including the name and description, manager, and group email. You can also set up roles, groups and group members, queues, and agent capacity overrides for agents in an assignment group.

**Assignment rule**
Criteria that determines how work items are pushed to the appropriate agent within a qualified assignment group.

**Agent capacity**
The maximum number of work items on a particular service channel that an agent may actively work on at one time. Messaging Interactions in an On Hold state are not calculated as part of an agent’s capacity.

**Agent availability**
States that indicate agent presence and whether the agent is available for work or is busy or offline. AWA uses the agent availability state to determine if an agent is able to receive work.

**Inbox layout**
A configuration tied to a service channel that defines which fields of a record representing a work item are shown in agent inboxes. A layout defines what the agent sees in Agent Workspace.

Advanced Work Assignment roles
AWA adds the following roles for users who configure, manage, and receive work assignments.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AWA administrator [awa_admin]</td>
<td>Admin role for the AWA feature. Configures and administers across all channels.</td>
</tr>
<tr>
<td>AWA agent [awa_agent]</td>
<td>Agent role for the AWA feature. Handles customer interactions and manages workload across multiple service channels.</td>
</tr>
<tr>
<td>AWA developer [awa_integration]</td>
<td>Developer role for using the AWA API.</td>
</tr>
</tbody>
</table>

Reassigning messaging conversations
If you want messaging conversations to be automatically reassigned if the current Assigned To agent on the conversation is not available, set the glide.messaging.reassign.enabled system property to true. The system property only affects messaging conversations and the Assigned To agent is considered not available if the AWA Inbox status is not set to "Available."

Basic process for configuring AWA
Users with the awa_admin role determine:
• What to route – Configure the base service channels to be used.
• Where to route – Define the work item queues and the routing rules, execution order, work item sort order, and strategy
• How to assign work items – Define the assignment rules that determine the work items pushed to agents
• What the agent sees – Set the inbox card layouts and presence (availability) states that agents use in their Agent Workspace inbox.
For details on the AWA components and related configuration, see these sections.

• Get started with Advanced Work Assignment
• Service channels
• Work item queues
• Work assignments
• Using Agent Affinity
• Agent Inbox controls
• Create or modify a work item size override
• Out-of-the-box Performance Analytics Solutions for Advanced Work Assignment
• Advanced Work Assignment properties

Related information
AWA for CSM overview

Get started with Advanced Work Assignment
To implement Advanced Work Assignment, complete these initial configuration and setup steps.

Before you begin
Role required: awa_admin and admin

Procedure
1. Activate the Advanced Work Assignment plugin for your instance.
2. Activate related AWA plugins to enable base system service channels and the Performance Analytics Solution for AWA. For example, activate the Agent Chat plugin to enable the Chat service channel and Agent Chat in Agent Workspace.
3. Configure the service channels that you activated.
   • Create or modify an inbox layout.
   • Override agent capacity as needed.
4. Create agent groups to which work items are assigned.
5. Create work item queues for your service channels.
   • Define the pools of agents eligible for assignment (eligibility assignment).
   • Set the sort order for work items in the queue.
6. Configure the work assignment rules used to push work to the appropriate agents.

7. Set the controls that agents use to manage their availability states and assignments in Agent Workspace.
   - Create or update the presence states that agents use to indicate their availability.
   - Create or update the reasons that agents use to decline work assignments.

**Activate Advanced Work Assignment**

You can activate the Advanced Work Assignment plugin (com.glide.awa) if you have the admin role.

**Before you begin**

Role required: admin

**About this task**

Advanced Work Assignment activates the Skills Management plugin (com.snc.skills_management) to implement user and group skills.

<table>
<thead>
<tr>
<th>Plugins for Skills Management</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Plugin</strong></td>
</tr>
<tr>
<td>Skills Management</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to System Applications > All Available Applications > All.

2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
What to do next
Activate the related AWA plugins to enable the appropriate service channels and the Analytics and Reporting Solutions for Advanced Work Assignment.

Related information

Activate related plugins for Advanced Work Assignment
After activating the Advanced Work Assignment plugin, activate related AWA plugins to enable other base system service channels and the Performance Analytics Solutions dashboard for AWA.

You must have the admin role to activate these additional plugins for AWA. For details, see Activate a plugin.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Chat [com.glide.interaction.awa]</td>
<td>Enables the Chat service channel in AWA and chat messaging in Agent Workspace. Includes default configuration data for chats, including demo data.</td>
</tr>
<tr>
<td>Advanced Work Assignment for CSM [com.snc_csm.awa]</td>
<td>Enables the Case service channel in AWA. Includes configuration data supporting routing, queuing, and assignment of CSM cases.</td>
</tr>
<tr>
<td>Advanced Work Assignment for Incidents [com.snc.incident.awa]</td>
<td>Enables the Incident service channel in AWA. Includes a default configuration to support AWA for incidents.</td>
</tr>
<tr>
<td>Walk-up Experience [com.snc.walkup]</td>
<td>Activates the walk-up contact service channel for prebuilt tech lounges. Enables an IT organization to support online and offsite checkin.</td>
</tr>
<tr>
<td>Performance Analytics Content Pack – Advanced Work Assignment [com.snc.pa.awa]</td>
<td>Activates the Performance Analytics Content Pack for AWA. Provides base system KPIs.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Move from Connect Support to Advanced Work Assignment and Agent Chat

Move from ServiceNow® Connect Support to Agent Chat (live chat), which is the messaging system that agents use in Agent Workspace to interact with customers. Moving from Connect Support also involves using Advanced Work Assignment (AWA) to create the chat queues for routing chat work items to agents.

Before you begin
Role required: admin

About this task
Moving to modern applications such as Advanced Work Assignment and Agent Chat offers features and benefits that are not available in Connect Support. These new capabilities include:

• Automatic assignment of chats and work items to agents based on criteria that you define, such as agent availability, capacity, skills, Agent Affinity, and variable work item sizing.
• Automatic queue overflow handling
• Chat timeout reassignment
• Native pre-chat surveys
• Supervisor features, such as Agent Whisper, that enable managers to join ongoing public customer chats with agents or send private messages to agents.
• Agent features, such as workspace inbox controls for viewing, accepting, or rejecting incoming chats.

If you are currently using Connect Support APIs, see AWA Routing API for information on AWA APIs.

Procedure
1. Activate the Advanced Work Assignment and Agent Chat plugins if they are not currently active.
2. If needed, review your existing Connect Support chat queues and determine whether you want to create a similar set of queues for the Chat service channel in AWA.
Note: You cannot use your Connect Support chat queues in AWA. Chat queues for Connect Support are stored in the Chat Queue [chat_queue] table. Chat queues for AWA are stored in the AWA Queue [awa_queue] table.

3. In AWA, configure the Chat service channel and create the associated chat queues. You also must set up agent work assignments.

4. In the Chat Setup form, specify Agent Workspace as the fulfiller interface for live chat and enable other live chat features.
   a. Navigate to Conversational Interfaces > Chat Setup.
   b. In the Global Fulfiller UI list or the Fulfiller UI list for CSM or ITSM, select Agent Workspace.
   c. Consider enabling other live chat features, such as Agent Whisper. For details, see Setting up Agent Chat.
   d. Click Update.

5. Enable the chat client on your end user Service Portal.

Trouble?

Troubleshooting suggestions

Problem: While using AWA, the chat remains in routing and is not offered to an available agent.

Solution: This problem may happen if AWA attempts to route the chat to a Connect Support queue. In this case, the interaction remains assigned to the Virtual Agent user and no awa_work_item record is created. A common cause of this problem is the Chat Setup entry for the chat’s application still being set to Connect.

Problem: When trying to route to a live agent, the requester is incorrectly told that no live agents are available.

Solution: This problem may be caused by one of these situations:

• Queue conditions that depend on checking interaction fields or context were created on the interaction too late for routing.

• Chat service channel is not associated with the Available presence state. A common cause of this problem is deactivating and reactivating the Chat channel.

Debugging suggestions
Here are a few questions to ask and places to look if agents are not receiving chats:

• Does an awa_work_item record exist for the interaction? If it does not, is the Assigned to field for the interaction empty or is it set to Virtual Agent? If the Assigned to field is set to Virtual Agent, it is probably trying to use Connect Support.

• In the Chat setup, are the fulfillers set appropriately for each application?

• In the interaction_json_blob referenced by the interaction.context_document field, is the Liveagent_application variable set to the expected value?

Components installed with Advanced Work Assignment

Several types of components are installed with activation of the Advanced Work Assignment plugin, including tables, user roles, and scheduled jobs.

⚠️ Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Work Assignment administrator</td>
<td>Admin role for the AWA feature. Configures and manages AWA.</td>
<td>• awa_manager</td>
</tr>
<tr>
<td>[awa_admin]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Work Assignment developer</td>
<td>Developer role for the AWA feature. Uses the AWA integration APIs.</td>
<td>None</td>
</tr>
<tr>
<td>[awa_integration_user]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Work Assignment agent</td>
<td>Agent role for the AWA feature. Handles customer interactions and manages workload across multiple service channels</td>
<td>None</td>
</tr>
<tr>
<td>[awa_agent]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Work Assignment manager</td>
<td>Manager role for the AWA feature. Monitors performance of agents across all service channels</td>
<td>None</td>
</tr>
<tr>
<td>[awa_manager]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AWA WorkItem TimeOut Job</td>
<td></td>
</tr>
<tr>
<td>AWA Cleanup Job</td>
<td></td>
</tr>
</tbody>
</table>

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AWA Agent Capacity</td>
<td>Stores capacity override records for agents on individual channels.</td>
</tr>
<tr>
<td>[awa_agent_capacity]</td>
<td></td>
</tr>
<tr>
<td>AWA Agent Channel Availability</td>
<td>Store the records that determine the agents available in the channel.</td>
</tr>
<tr>
<td>[awa_agent_channel_availability]</td>
<td></td>
</tr>
<tr>
<td>AWA Agent Presence</td>
<td>Stores the records that define the agent availability state.</td>
</tr>
<tr>
<td>[awa_agent_presence]</td>
<td></td>
</tr>
<tr>
<td>AWA Agent Presence History</td>
<td>Stores records on agent presence state changes.</td>
</tr>
<tr>
<td>[awa_agent_presence_history]</td>
<td></td>
</tr>
<tr>
<td>AWA Assignment Rule</td>
<td>Stores the assignment rule records used to determine the work items pushed to agents.</td>
</tr>
<tr>
<td>[awa_assignment_rule]</td>
<td></td>
</tr>
<tr>
<td>AWA Eligibility Pool</td>
<td>Stores the records that define grouping of agents eligible to receive work items in the queue when the items have been rejected by agents or agents are unavailable.</td>
</tr>
<tr>
<td>[awa_eligibility_pool]</td>
<td></td>
</tr>
<tr>
<td>AWA Group Queue Priority</td>
<td>Stores the priority values for queues assigned to groups.</td>
</tr>
<tr>
<td>[awa_group_queue_priority]</td>
<td></td>
</tr>
<tr>
<td>AWA Inbox Layout</td>
<td>Defines the fields that appear on a work item card in the Agent Workspace inbox.</td>
</tr>
<tr>
<td>[awa_inbox_layout]</td>
<td></td>
</tr>
<tr>
<td>AWA Offer Details</td>
<td>Stores whether a work item was assigned using Agent Affinity and how the assignment was completed.</td>
</tr>
<tr>
<td>[awa_offer_details]</td>
<td></td>
</tr>
<tr>
<td>AWA Presence State</td>
<td>Defines presence states.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Table

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[awa_presence_state]</td>
<td>AWA Queue</td>
</tr>
<tr>
<td>[awa_queue]</td>
<td>Stores the work item queue records.</td>
</tr>
<tr>
<td>AWA Queue Item Sorting</td>
<td>AWA Queue Item Sorting</td>
</tr>
<tr>
<td>[awa_queue_item_sorting]</td>
<td>Defines which fields in a work item for a queue you can sort on.</td>
</tr>
<tr>
<td>AWA Reject Reason</td>
<td>AWA Reject Reason</td>
</tr>
<tr>
<td>[awa_reject_reason]</td>
<td>Stores the records that define the reasons that agents use to decline work items assigned to them.</td>
</tr>
<tr>
<td>AWA Service Channel</td>
<td>AWA Service Channel</td>
</tr>
<tr>
<td>[awa_service_channel]</td>
<td>Defines the communication channel for which work items may be queued.</td>
</tr>
<tr>
<td>AWA Work Item</td>
<td>AWA Work Item</td>
</tr>
<tr>
<td>[awa_work_item]</td>
<td>Stores items of work, for example, chats, cases, or incidents, that are routed from service channels to queues and then to agents.</td>
</tr>
<tr>
<td>AWA Work Item Rejection</td>
<td>AWA Work Item Rejection</td>
</tr>
<tr>
<td>[awa_work_item_rejection]</td>
<td>Stores the rejection history records for each work item.</td>
</tr>
</tbody>
</table>

### Properties installed

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.awa.enabled</td>
<td>Enables the auto assignment of work items for Advanced Work Assignment.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Property [sys_properties] table</td>
</tr>
<tr>
<td>com.snc.awa.cache.enabled</td>
<td>Enables the Advanced Work Assignment cache.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Property [sys_properties] table</td>
</tr>
</tbody>
</table>
Domain separation and Advanced Work Assignment

Domain separation is supported in the Advanced Work Assignment feature. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Standard

- Includes Basic level support.
- Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see Application support for domain separation.

Overview

Advanced Work Assignment enables the automatic assignment of work items to qualified agents using work item queues defined for specific service channels. Managed Service Providers can create domain-specific queues by specifying a particular domain as a queue routing condition.

How domain separation works in Advanced Work Assignment

When an instance has a domain hierarchy where users and groups belong to different domains, you may need to restrict the visibility of work items to certain agents in a domain. You may also need to ensure that work items are routed to agents in the proper domain. AWA admins can configure service channels and associated work item queues to:

- Route work by domains
  
  To push work items to agents in domains where only certain tasks or interactions are visible to them, use a routing condition that routes those items to the appropriate queues. For example:
• To restrict a queue to only items that match exactly to a particular domain X, specify this condition: [Domain] [is] [X]
• To route all work items in domain X and its child domains to a queue, use the Domain Path field and specify a condition such as: [Domain Path] [starts with] [!!!/!!#/] 

Assign work to agents in the appropriate domain

To assign work items to agents in the appropriate domain, ensure that the assignment groups specified in the queue Eligibility Assignment pools have agents that belong to the domains where they can see the work items routed to the queue.

If a mismatch occurs, and agents in an eligible assignment group cannot see a work item in a queue, AWA may temporarily assign an item to an agent. However, before the item is moved to the agent’s inbox, AWA automatically rejects the assignment with the reason No access. AWA reassigns the work item to a different agent who might have access. If none of the available agents can see the work item, the item could be rejected multiple times.

⚠️ Warning: The item can get stuck in the queue until the AWA admin corrects the eligible assignment configuration.

Related information

Domain separation for service providers

Service channels

Provide customer support by automatically routing incoming work to agents through service channels.

A service channel is a means of assigning a specific type and scope work to agents. You can configure base system service channels to set the context and attributes that define work handled in the channel, or create your own custom service channel.

Advanced Work Assignment provides several service channels from which work items originate. These channels are:

<table>
<thead>
<tr>
<th>Service channel</th>
<th>Description</th>
<th>Plugin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case</td>
<td>Used to route and assign customer service cases</td>
<td>Included with the Customer Service</td>
</tr>
<tr>
<td>Service channel</td>
<td>Description</td>
<td>Plugin</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Chat</td>
<td>Used to route and assign chat interactions</td>
<td>Included with the Agent Chat plugin (com.glide.interaction.awa)</td>
</tr>
<tr>
<td>Chat - Asynchronous</td>
<td>Used to route long-running conversations that use multiple service channels.</td>
<td>Included with the Install Conversational SMS service channel application.</td>
</tr>
<tr>
<td>Facebook Messenger</td>
<td>Used to route requests from the Facebook Messenger chat conversations</td>
<td>Included with the Conversational Integration with Facebook Messenger store application.</td>
</tr>
<tr>
<td>Incident</td>
<td>Used to route and assign incidents</td>
<td>Included with the Advanced Work Assignment for incidents plugin</td>
</tr>
<tr>
<td>Line</td>
<td>Used to route requests from the LINE chat conversations</td>
<td>Included with the Conversational Integration with LINE store application.</td>
</tr>
<tr>
<td>SMS</td>
<td>Used to route long-running SMS conversations and conversations that use multiple service channels.</td>
<td>Included with the Install Conversational SMS service channel application.</td>
</tr>
<tr>
<td>Walk-up</td>
<td>Used to route requests from a walk-up contact channel</td>
<td>Included with the Walk-up Experience plugin (com.snc.walkup)</td>
</tr>
<tr>
<td>WhatsApp</td>
<td>Used to route requests from the WhatsApp chat conversations</td>
<td>Included with the Conversational Integration with</td>
</tr>
<tr>
<td>Service channel</td>
<td>Description</td>
<td>Plugin</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
<td>--------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WhatsApp (powered by Twilio) store application.</td>
</tr>
</tbody>
</table>

You can also set up a custom service channel to address work that is not supported in the base system channels. For more information, see Set up a custom service channel.

For each service channel, you set attributes such as:

- Agent capacity: Amount of work that can be handled by the agents supporting the channel.
- Filters: Conditions that filter the type of work handled in the channel.
- Utilization: Conditions that determine when work items are generated.

For each service channel, you also:

- Create the agent inbox card layout used in Agent Workspace.
- Set capacity overrides for specific agents.
- Review and modify associated work item queues. For the Chat service channel, you can create queues using the Queues related list.

**Service channel capacity and utilization**

In Advanced Work Assignment, capacity is the number of work items automatically assigned to agents supporting a service channel. Utilization is the condition that identifies the work item states supported in the channel.

Agents have an assigned capacity for each service channel. This capacity is based on the default capacity set for the channel. The agent capacity for one service channel (for example, chat) does not interfere with the capacity on other service channels (for example, case or incident). Admins can set the Default capacity for a channel on the Service Channel form. This setting applies to all agents supporting the channel.

Managers can override the default capacity for:

- Individual agents, by using the Agent Capacity Override related list on the Service Channel form.
- Groups of agents, by using the Agent Capacity Override related list on the Group form.

If an agent already has a capacity override, setting the override again updates the existing capacity for that agent. Override capacity is stored in the Agent Capacity (awa_agent_capacity) table.
Inbox layout

The inbox layout determines the information shown on work item cards displayed in an agent’s inbox.

The AWA admin (awa_admin) can configure layouts that represent items in an agent inbox. The configuration allows agents to see the most important attributes by service channel work items. The fields specified on the inbox layout determine the information displayed for a work item.

Each base system service channel provides preconfigured inbox layouts for work items. The AWA admin can view and edit these layouts and also create new layouts.

Up to five fields can be shown in the card layout.

• Fields can be added from the table that the service channel points to.
• Fields are dot-walkable.
• The first field added to the layout becomes the title field on the card.

Layout example

For chats that do not have either a contact or consumer, the layout includes only the chat subject. You control the display of the Time to accept count (timer) and the Reject button through the agent assignment rules.

Create a service channel

Create or configure a service channel that is used in Advanced Work Assignment. You can specify additional conditions to filter the work items that are handled in the channel, change the agent capacity (workload) for the
channel, set the inbox layouts that your agents use in Workspace, and view associated work item queues.

Before you begin
Role required: awa_admin or admin

About this task
If you activate the corresponding plugins or install the corresponding store applications, AWA provides base system channels for these services:

• Cases plugin (com.snc_csm.awa)
• Chats plugin (com.glide.interaction.awa)
• Chats - Asynchronous plugin (com.glide.interaction.awa)
• Conversational Integration with Facebook Messenger application (sn_va_fb_messenger)
• Incidents plugin (com.snc.incident.awa)
• Conversational Integration with LINE application (sn_va_line)
• Walk-up interactions plugin (com.snc.walkup)
• Conversational Integration with WhatsApp (powered by Twilio) application (sn_va_whatsapp_twi)

For each channel, you can change certain default settings, such as the default capacity (workload) for agents. You can also use the related lists to review associated queues, define the associated inbox layouts (work item cards) that are displayed in Workspace, and override the agent capacity value.

You can also create a service channel record from the Service Channel module, but you must create a queue, assignment rule, and eligible assignment pool to route work through the service channel. For more information, see Set up a custom service channel.

Procedure
1. Navigate to Advanced Work Assignment > Settings > Service Channels.
   • To create a service channel, select New.
   • To modify a service channel, select the service channel record you want to update.
2. On the form, fill in the fields.
### Service Channel form

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the selected base system service channel to be configured:</td>
</tr>
<tr>
<td></td>
<td>• Chat</td>
</tr>
<tr>
<td></td>
<td>• Chat - Asynchronous</td>
</tr>
<tr>
<td></td>
<td>• Case</td>
</tr>
<tr>
<td></td>
<td>• Facebook Messenger</td>
</tr>
<tr>
<td></td>
<td>• Incident</td>
</tr>
<tr>
<td></td>
<td>• Line</td>
</tr>
<tr>
<td></td>
<td>• Walk-up</td>
</tr>
<tr>
<td></td>
<td>• WhatsApp</td>
</tr>
<tr>
<td>Inbox order</td>
<td>Order in which channel items appear in the agent inbox.</td>
</tr>
<tr>
<td>Application</td>
<td>Name of the application.</td>
</tr>
<tr>
<td></td>
<td>• Chat: Global</td>
</tr>
<tr>
<td></td>
<td>• Chat - Asynchronous: Global</td>
</tr>
<tr>
<td></td>
<td>• Case: Advanced Work Assignment for CSM</td>
</tr>
<tr>
<td></td>
<td>• Facebook Messenger: Conversational Integration with Facebook Messenger</td>
</tr>
<tr>
<td></td>
<td>• Incident: Advanced Work Assignment for Incidents</td>
</tr>
<tr>
<td></td>
<td>• Line: Conversational Integration with LINE</td>
</tr>
<tr>
<td></td>
<td>• Walk-up: Walk-up Experience</td>
</tr>
<tr>
<td></td>
<td>• WhatsApp: Conversational Integration with WhatsApp (powered by Twilio)</td>
</tr>
<tr>
<td>Active</td>
<td>Option for activating the service channel. When you select this option,</td>
</tr>
<tr>
<td></td>
<td>the associated queues for the service</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Brief description of the service channel:</td>
</tr>
<tr>
<td></td>
<td>• Chat: Live Agent Chat Interactions</td>
</tr>
<tr>
<td></td>
<td>• Chat - Asynchronous: Asynchronous Live Agent Chat Interactions</td>
</tr>
<tr>
<td></td>
<td>• Case: Cases for Agents</td>
</tr>
<tr>
<td></td>
<td>• Facebook Messenger: Live Agent Facebook Messenger Interactions</td>
</tr>
<tr>
<td></td>
<td>• Incident: Incidents for Agents</td>
</tr>
<tr>
<td></td>
<td>• Line: Live Agent LINE Interactions</td>
</tr>
<tr>
<td></td>
<td>• Walk-up: Walk-up interactions for agents to work on</td>
</tr>
<tr>
<td></td>
<td>• WhatsApp: Live Agent WhatsApp Interactions</td>
</tr>
<tr>
<td>Table</td>
<td>Table that stores the service channel records.</td>
</tr>
<tr>
<td>Advanced condition</td>
<td>If enabled, the advanced conditions that apply to the channel. For example:</td>
</tr>
<tr>
<td></td>
<td>• Chat: [Type] [is] [Chat]</td>
</tr>
<tr>
<td></td>
<td>• Chat - Asynchronous: [Subtype] [is] [mweb], [Type] [is] [Messaging]</td>
</tr>
<tr>
<td></td>
<td>• Facebook Messenger: [Subtype] [is] [Facebook Messenger]</td>
</tr>
<tr>
<td></td>
<td>• Line: [Subtype] [is] [Line]</td>
</tr>
<tr>
<td></td>
<td>• Walk-up: [Type] [is] [Walk-up]</td>
</tr>
<tr>
<td></td>
<td>• WhatsApp: [Subtype] [is] [WhatsApp]</td>
</tr>
<tr>
<td>Assign to field</td>
<td>Field that references the user assigned to the item. In both Case and Interaction (and most other</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>tables) , this is the <strong>Assigned to</strong> (assigned_to) field.</td>
<td></td>
</tr>
<tr>
<td><strong>Assignment group field</strong></td>
<td>Field that references the assignment group assigned to the item. In most tables, this is the <strong>Assignment group</strong> field.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Indicator of whether a communication service channel is handled as a synchronous or asynchronous conversation channel. This field appears when you select <strong>Interaction</strong> in the <strong>Table</strong> field.</td>
</tr>
<tr>
<td></td>
<td>- Chat</td>
</tr>
<tr>
<td></td>
<td>- Messaging</td>
</tr>
<tr>
<td></td>
<td>- Other</td>
</tr>
<tr>
<td><strong>Log level</strong></td>
<td>Amount of information recorded when AWA events are logged.</td>
</tr>
<tr>
<td></td>
<td>- None - no information is logged.</td>
</tr>
<tr>
<td></td>
<td>- Basic - only basic information is logged.</td>
</tr>
<tr>
<td></td>
<td>- Verbose - detailed information, including record details and event details, is logged.</td>
</tr>
<tr>
<td></td>
<td>This field appears if <strong>Enable logging</strong> is enabled.</td>
</tr>
<tr>
<td><strong>Inbox Alert Audio</strong></td>
<td>Audible alert that sounds when a new item arrives in your inbox for this service channel. If you do not specify an audio file, the default audio file sounds.</td>
</tr>
<tr>
<td><strong>Message Alert Audio</strong></td>
<td>Audible alert that sounds when a new message arrives in your conversation for this service channel. If you do not specify an audio file, the default audio file sounds.</td>
</tr>
<tr>
<td><strong>Capacity and Utilization</strong></td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default work item size</td>
<td>Amount of an agent’s capacity that is used when this work item is assigned. The default is 1.</td>
</tr>
<tr>
<td>Default capacity</td>
<td>Number of items automatically assigned to agents (pending overrides).</td>
</tr>
<tr>
<td></td>
<td>• Case: the default is 2.</td>
</tr>
<tr>
<td></td>
<td>• Chat: the default is 4.</td>
</tr>
<tr>
<td></td>
<td>• Chat - Asynchronous: the default is 4.</td>
</tr>
<tr>
<td></td>
<td>• Facebook Messenger: the default is 4.</td>
</tr>
<tr>
<td></td>
<td>• Incident: the default is 2.</td>
</tr>
<tr>
<td></td>
<td>• Line: the default is 4.</td>
</tr>
<tr>
<td></td>
<td>• Walk-up: the default is 1.</td>
</tr>
<tr>
<td></td>
<td>• WhatsApp: The default is 4.</td>
</tr>
<tr>
<td>Utilization condition</td>
<td>Condition that determines what constitutes an active item that counts toward agent workload/capacity. For example, the record state is New, Open, or Awaiting Info.</td>
</tr>
<tr>
<td></td>
<td>• For chat: State is not one of Closed Complete, Closed Abandoned</td>
</tr>
<tr>
<td></td>
<td>• For Chat - Asynchronous: State is not one of Closed Complete, Closed Abandoned</td>
</tr>
<tr>
<td></td>
<td>• For case: State is New or Open</td>
</tr>
<tr>
<td></td>
<td>• For Facebook Messenger: State is New or Work in Progress</td>
</tr>
<tr>
<td></td>
<td>• For incident: State New, In Progress, or On Hold</td>
</tr>
<tr>
<td></td>
<td>• For Line: State is New or Work in Progress</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• For walk-up: State is not On Hold, Closed Complete, or Closed Abandoned</td>
</tr>
<tr>
<td></td>
<td>• For WhatsApp: State is New or Work in Progress</td>
</tr>
</tbody>
</table>

**Logging**

<table>
<thead>
<tr>
<th>Enable logging</th>
<th>Option to record information in the syslog_awa table when AWA events are logged. Specify the level of detail to be recorded in the <strong>Log level</strong> field on this screen.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop logging at</td>
<td>Date and time that logging should stop. This field appears if <strong>Enable logging</strong> is enabled.</td>
</tr>
</tbody>
</table>

3. Select **Submit** or **Update**. The channel is added to or updated in the Service Channels [awa_service_channel] table.

**What to do next**

- Override the agent capacity for selected agents or groups.
- Create or modify an inbox layout for the service channel.
- Configure agent assignment rules for the channel.
- Define agent pools eligible for assignment.
- Create or modify a work item queue for the channel.
- Create or modify a work item size override for the channel.

**Conversational SMS service channel**

Using the Conversational SMS service channel app on the ServiceNow Store, workspace agents can provide support for long-running SMS conversations and conversations that use multiple service channels.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release
notes information for all released apps, see the ServiceNow Store version history release notes.

**Overview**

Requesters can initiate support conversations through SMS. Since these support conversations can be long-running, workspace agents need the ability to track ongoing conversations while also addressing requesters on other service channels. With the Conversational SMS service channel store app, workspace agents can initiate or continue SMS conversations and also accept SMS work items from the Workspace Inbox. Requesters in SMS conversations see a limited subset of system messages. This minimizes the number of system messages in case the conversation is long-running.

**Messaging profiles**

Messaging profiles provide a way to match an incoming phone number to a requester:

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>New SMS is received from a requester who is associated to a phone number on the User [sys_user] table but has no messaging profile match</td>
<td>• A messaging profile record is generated to match the number to the User table.</td>
</tr>
<tr>
<td></td>
<td>• An interaction record is associated to the matching User table.</td>
</tr>
<tr>
<td>New message received from a requester who does not have a phone number match in the User table but does have messaging profile match</td>
<td>• An interaction record is associated to the matching messaging profile user.</td>
</tr>
<tr>
<td></td>
<td>• The User table record is not associated to the phone number. The agent can manually verify.</td>
</tr>
<tr>
<td>New message received from a requester who does not have a phone number match in the User table or messaging profiles</td>
<td>• An interaction record is associated to the guest user (Virtual agent or live agent can manually verify).</td>
</tr>
<tr>
<td></td>
<td>• A messaging profile record is generated for the phone number but not associated to a user.</td>
</tr>
<tr>
<td>If</td>
<td>Then</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>
| New SMS from a requester that conflicts with an existing User table or messaging profile | • An interaction is associated with the messaging profile/user currently associated with the number.  
• Virtual agent or live agent can verify the user and reassociate the interaction/profile with the correct user. |

**Messaging actions**

Messaging actions provide a way to trigger actions based on messaging activity on a conversation.

<table>
<thead>
<tr>
<th>Messaging action parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Event</strong></td>
<td>Sending of a message from a requester or agent starts a timer that can trigger an action</td>
</tr>
<tr>
<td>1. Requester message without agent response</td>
<td></td>
</tr>
<tr>
<td>2. Agent message without requester response</td>
<td></td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td>Time set to trigger an action based on the Event parameter being set</td>
</tr>
<tr>
<td><strong>Filter conditions</strong></td>
<td>Condition needed on the Interaction record for a messaging action to be triggered (for example, State is &quot;On Hold&quot;)</td>
</tr>
</tbody>
</table>
| **Action** | Possible actions include:  
• Prompt agent – Sent Workspace notification to agent  
• Prompt requester – Sent system message in messaging conversation to requester  
• Reassign – Remove assigned agent from interaction  
• Set state – Set Interaction state to desired state |
Ongoing conversations

The Agent Inbox displays new SMS messages and agents can locate currently assigned SMS conversations in the Ongoing tab. The tab indicator and record highlight indicate when an SMS conversation has a new message. Unlike chat conversations, SMS conversations can be long-running. Completed SMS conversations do not display in the Ongoing tab.

Requester initiated SMS conversations

When a requester initiates a support conversation, a virtual agent or a live agent addresses the conversation. Like other service channels, Advanced Work Assignment handles the routing of SMS conversations to live agents. This is how requester-initiated SMS conversations are handled:
An active SMS interaction represents an ongoing conversation between a requester's phone number and a company's phone number.

**Agent initiated SMS conversations**

To initiate an SMS conversation with a requester, agents can select a provider number for an outbound service or manually enter a provider number. If there is a current ongoing SMS conversation, it automatically appears. When an agent initiates an SMS conversation:

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is no active SMS interaction</td>
<td>• Create a new SMS interaction</td>
</tr>
<tr>
<td></td>
<td>• Assign interaction to agent</td>
</tr>
<tr>
<td>There is an active interaction involving an agent</td>
<td>• Inject the message into existing conversation</td>
</tr>
<tr>
<td></td>
<td>• Continue with existing virtual agent topic</td>
</tr>
<tr>
<td></td>
<td>• Track using the same interaction record</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is no active SMS interaction</td>
<td>• Create a new SMS interaction</td>
</tr>
<tr>
<td></td>
<td>• Assign interaction to a virtual agent or a live agent</td>
</tr>
<tr>
<td>There is an active interaction involving a live agent</td>
<td>• Inject the message into an existing conversation</td>
</tr>
<tr>
<td></td>
<td>• Continue with agent in current conversation</td>
</tr>
<tr>
<td></td>
<td>• Track using the same interaction record</td>
</tr>
<tr>
<td>There is an active interaction involving a virtual agent</td>
<td>• Inject the message into existing conversation</td>
</tr>
<tr>
<td></td>
<td>• Continue with existing virtual agent topic</td>
</tr>
<tr>
<td></td>
<td>• Track using the same interaction record</td>
</tr>
</tbody>
</table>
If | Then
---|---
There is an active interaction involving VA | • Close existing interaction
• Create a new interaction and assign to agent

There is an active interaction involving a different contact/consumer/user | • Close existing interaction
• Create a new channel user profile and deactivate the existing channel user profile
• Create a new interaction and assign to agent

An active SMS interaction represents an ongoing conversation between a requester’s phone number and a company’s phone number.

**Install Conversational SMS service channel**

You can install the Conversational SMS service channel application (sn_awa_sms_int) if you have the admin role. The application installs related ServiceNow® Store applications and plugins if they are not already installed.

**Before you begin**

- Ensure that the application and all of its associated store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

- The Conversational Messaging plugin (com.glide.messaging.awa) must be installed.

For more information on activating plugins, see Activate a plugin.

Role required: admin

**About this task**

⚠️ **Note:** The Conversational SMS service channel is automatically installed with an application that implements an SMS provider, such as the Conversational SMS Integration with Twilio (sn_va_sms_twilio) application. For more information, see Install Conversational SMS Integration with Twilio.
Procedure

1. Navigate to **System Applications > All Available Applications > All**.

2. Find the Conversational SMS Service Channel (sn_awa_sms_int) application using the filter criteria and search bar.
   
   You can search for the application by its name or ID.
   
   If you cannot find the application, you may have to request it from the ServiceNow Store. Visit the **ServiceNow Store** website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the **ServiceNow Store version history release notes**.

3. Click **Install**.

4. In the Application installation dialog box, click **Install**.

**What to do next**

Set up Conversational SMS service channel

**Set up Conversational SMS service channel**

Configure the Conversational SMS service channel store app.

**Before you begin**

Role required: admin

Procedure

1. Navigate to **Advanced Work Assignment > Service Channels**.

2. Click the SMS service channel. On the Service Channel - SMS screen, select the Active check box to activate the service channel.

   ![Service Channel - SMS screen](image)

   SMS service channel is connected to an SMS
3. Since the SMS group has no users by default, manually add users to the SMS group. For detailed instructions on how to add a user to a group, see “Add a user to a group” in Create a user group.


5. In the Name column, click **Available**.

7. Select the right-pointing arrow. This moves SMS from the Available column to the Selected column.

8. Click Update.

**Agent initiated SMS conversation**

Customer Service Management supports additional messaging channel such as SMS which tracks interactions between the agent and customer.

**Requirements**

At least one provider configuration for messaging type channel must be available to view the **Compose SMS** option in the agent interaction screen. For more information about provider sys_cs_provider_application.list, see Create a channel identifier.

**Phone number validation**

REST endpoint `/api/now/initiate_message/validate_phone_number` is used to validate if the phone number is in the E.164 format. If the number of a known consumer is not in the E.164 format, the system converts it to the E.164 format based on for example, the location of the consumer. If the location is not found, it will by default convert the number to an E.164 format. For more information about E.164 formats and validation, see Phone number fields.

**Customer profile validation**

REST endpoint `/api/now/initiate_message/validate_profile` is used to validate the channel user profile. When you send an SMS in reply to an interaction of type phone, the message is sent to a consumer originally associated with the interaction. If the same phone number is associated to a different consumer, and you send an SMS, you will get a message that the phone number is currently associated to another consumer and sending the new message will associate the phone number to the current user.

A phone number is associated to consumer A and an interaction has occurred after which the phone number was disconnected for consumer A. There is a new interaction with consumer B and you select the same phone number that was associated with consumer A. A message appears that the phone number is currently associated to consumer A, and sending a new message will associate consumer A’s phone number to consumer B who is the current user.

**Agent initiated SMS conversations**

To initiate an SMS conversation with a requester, agents can select a provider number for an outbound service or manually enter a provider number. If there is
a current ongoing SMS conversation, it automatically appears. When an agent initiates an SMS conversation:

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
</table>
| There is no active SMS interaction | • Create a new SMS interaction  
• Assign interaction to agent |
| There is an active interaction involving an agent | • Inject the message into existing conversation  
• Add agent to live group profile  
• No reassignment |
| There is an active interaction involving VA | • Close existing interaction  
• Create a new interaction and assign to agent |
| There is an active interaction involving a different contact/consumer/user | • Close existing interaction  
• Create a new channel user profile and deactivate the existing channel user profile  
• Create a new interaction and assign to agent |

**Customize the behaviour of send from and to numbers**

The AgentInitiatedConversationUtil extension point is added to implement a customers' logic to change the default behaviour of the **Send from** and **Send to** fields. For more information, see [Associate user profiles on messaging interactions](#). For this store application, AgentInitiatedMessagingUtilExtPointImpl extension point is configured for fetching the from and to numbers.

**Compose an SMS conversation**

An agent can compose an SMS to interact with a customer for resolving various issues. If the interaction is not messaging type, you see the **Compose SMS** option.

**Before you begin**

Role required: agent_workspace_user  
A provider is configured for SMS messaging type channel.
About this task
As an agent, you can compose and send an SMS to an ongoing interaction which is not messaging type.

Procedure

1. Click Compose SMS.
The Send via SMS screen is displayed.

2. Select a phone number from the Send from: drop-down list.
   • If there is only one provider phone number this field is pre-populated with the number.
   • If there are multiple provider profiles available for SMS channels, you can choose from the drop-down list.

3. Select a phone number from the Send to: drop-down list.
   • The phone numbers are pre-populated from the consumer or contact records.
   • If both are not populated, the system looks for the number from the opened for record in the sys_user table.
   • If there is already a channel user profile associated with a consumer or contact, the phone number is pre-populated.

   a. Choose Other and select a phone number in the drop-down list.

   Note: All phone numbers must be in the E.164 format. For more information, about phone number and channel user profile validation, see Phone number validation.

If there is already an ongoing SMS type of interaction with the same or different consumer, you can view the interaction card in the same screen. The interaction card for the consumer number you have selected contains interaction number, message type, last updated time, consumer, and assigned to information.

4. Enter your message in the Message field.

5. Click Attach file, browse, select the file and attach.

   Note: You can attach only image files to the message. For more information about the REST API for uploading attachments, see Attachment - POST /now/attachment/upload.

6. Click Send.
For more information, see Agent initiated SMS conversations.
Set up a custom service channel

Set up a custom service channel to expand the type and scope of work that is routed automatically to your agents.

Before you begin

• Select the table that you want to use to route work to agents automatically. Only Task [task] and Interaction [interaction] tables are supported.

• Ensure that the form layout for the selected table is configured for the workspace view. Record types without a workspace view appear as read-only in Agent Workspace. For more information, see Set up forms in Workspace.

• If you want to open a record in AWA for a table that extends another table that has a service channel defined, ensure that the workspace view for that table has already been defined.

• Assign the awa_agent and workspace_agent roles to whichever agents are receiving work items in Agent Workspace from your custom service channel.

Role required: awa_admin or admin

About this task

You can create a service channel record from the Service Channel module, but you need to create a work item queue, assignment rule, and eligible assignment pool to route work through the service channel. You also need to configure the custom service channel to make it available in an agent's inbox in Agent Workspace.

Procedure

1. Navigate to Advanced Work Assignment > Service Channels, and then click New.

2. Complete the service channel fields, and then click Submit.
   For more information, see Create a service channel.

3. Create an assignment rule.
   For more information, see Configure agent assignment rules.

4. Create a work item queue for your service channel.
   For more information, see Create a work item queue.

5. On the form for the work item queue that you created, go to the Assignment Eligibility related link and create an eligible assignment pool.
   Make sure to associate your assignment rule to the eligible assignment pool.
   For more information, see Define agent pools eligible for assignment.
6. Make your service channel available in Agent Workspace.
   a. Navigate to Advanced Work Assignment > Presence States, and then open Available.
   b. On the form, move your custom service channel to the Selected list.
   c. Select Active option (if not already selected).
   d. Click Update.

7. Optional: Create or modify the inbox card layout to show the most important information from a work item. For more information, see Create or modify an inbox layout.

Results
Your custom service channel routes work to agents. In Agent Workspace, the service channel appears as an available service channel in the agent inbox.

Tutorial: Set up a custom service channel for change requests
Learn how to configure Advanced Work Assignment to automatically assign change requests to agents. Use this tutorial as a guideline to help you understand how service channel records, queues, and assignment rules work together to create a custom service channel.

In this tutorial, you learn how to set up a custom channel that:
• Assigns new change requests to whichever Change Management agent has the most capacity
• Populates the assignee’s agent inbox in Agent Workspace with change requests from the queue
• Displays the change request number, short description, and type on the inbox card
• Enables the agent to accept or reject change requests

For information on setting up custom service channels, see Set up a custom service channel.

Before you begin:
• Ensure that the form layout for the Change Request table is configured for the workspace view; otherwise, work items from the Change Request service channel appear as read-only in Agent Workspace. For more information, see Set up forms in Workspace.
• Assign the awa_agent and workspace_agent roles to the Change Management group so that members can open work items in Agent Workspace.
Create a service channel to route requests
Create a service channel in Advanced Work Assignment so that you can route change requests to agents.

Before you begin
Role required: awa_admin or admin

Procedure
1. Navigate to Advanced Work Assignment > Service Channels, and then click New.
2. On the form, fill in the fields.
   • Name: Change Request
   • Inbox Order: 100
   • Table: Change Request [change_request]
   • Active: Selected
   • Utilization condition: [Active] [is] [true]
3. Click Submit.

Create an assignment rule for change requests
Create an assignment rule in Advanced Work Assignment that assigns change requests to agents who are available to do the tasks.

Before you begin
Role required: awa_admin or admin

Procedure
1. Navigate to Advanced Work Assignment > Assignment Rules, and then click New.
2. On the form, fill in the fields.
   • Name: Change Request Assignment Rule
   • Assign by: Most Capacity
   • Allow agents to reject: Selected
3. Click Submit.

Create a queue to route new change requests
Create a work item queue in Advanced Work Assignment that routes new change requests through the service channel that handles change requests.
Before you begin
Role required: awa_admin or admin

Procedure
1. Navigate to Advanced Work Assignment > Queues, and then click New.
2. On the form, fill in the fields.
   • Name: Change Management
   • Service channel: Change Request
   • Condition mode: Simple
   • Work item routing condition: [State] [is] [New]
3. From the form context menu, click Save.

Create an assignment pool of agents
Create an eligible assignment pool in Advanced Work Assignment that receives overflow work items, just in case you need more help from other agents to handle change requests.

Before you begin
Role required: awa_admin or admin

Procedure
1. Navigate to Advanced Work Assignment > Queues, and then open the Change Management queue.
2. On the form, go to the Assignment Eligibility related list and click New.
3. On the form, fill in the fields.
   • Agent assignment rule: Change Request Assignment Rule
   • Groups: Change Management
4. Click Submit.

Make your service channel available in Agent Workspace
Make your service channel available in Agent Workspace so that agents can receive change requests in their inbox.

Before you begin
Role required: awa_admin or admin
Procedure
1. Navigate to Advanced Work Assignment > Presence States, and then open Available.
2. On the form, move Change Request to the Selected list.
3. Select Active (if not already selected).
4. Click Update.

Customize how change requests appear in an agent inbox
Customize how change requests appear in an agent inbox so that agents receive enough information to decide whether to accept or reject the work item.

Before you begin
Role required: awa_admin or admin

Procedure
1. Navigate to Advanced Work Assignment > Service Channels and open the Change Request service channel record.
2. On the Change Request service channel form, go to the Inbox Layouts related list and open Default Change Request layout.
3. On the form, fill in the fields.
   • Field 1: Number
   • Field 2: Short description
   • Field 3: Type
4. Click Update.

Results
When you create a new change request, the item is routed through the Change Request service channel and assigned to the agent in the Change Management assignment group who is available to receive the change request. When the assignee checks their agent inbox, the change request appears with the option for the agent to either reject or accept the work item.
Create or modify an inbox layout

Create or modify the card layout for inbox items for a given service channel. Card layouts are displayed in the agent inbox view of Agent Workspace.

Before you begin
Role required: awa_admin or admin. Users with the awa_manager or agent role can review inbox layouts.

About this task
Cards represent work items in an agent's inbox in Agent Workspace. Each channel has a default layout for these cards, which can display up to five fields from the related table record. Use the Inbox Layout form to change a default layout, such as the name, short description, and the specific fields displayed on the card, for example channel and contact or consumer name. You can also specify certain conditions that determine when the card layout is used.

Procedure
1. Navigate to Advanced Work Assignment > Service Channels and select the service channel to be updated.
2. In the Service Channel form, click the Inbox Layouts related link.
   - To create a layout, click New.
   - To modify a layout, select the layout to be updated.
3. On the form, fill in the fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the inbox layout.</td>
</tr>
<tr>
<td>Service channel</td>
<td>The name of the selected service channel.</td>
</tr>
<tr>
<td>Short description</td>
<td>The description of the inbox layout.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the layouts appear in the agent inbox.</td>
</tr>
<tr>
<td>Condition</td>
<td>A condition that determines when this layout is used. Use the condition builder to specify a condition that must evaluate to true to apply the layout.</td>
</tr>
<tr>
<td>Card layout</td>
<td>Example card layout.</td>
</tr>
<tr>
<td>Field 1</td>
<td>The field from the table for the channel, for example the Interaction [interaction] table for the chat service channel. Select the field or select None to remove an existing field.</td>
</tr>
<tr>
<td>Field 2</td>
<td>The field from the table for the channel, for example the Interaction [interaction] table for the chat service channel. Select the field or select None to remove an existing field.</td>
</tr>
<tr>
<td>Field 3</td>
<td>The field from the table for the channel, for example the Interaction [interaction] table for the chat service channel. Select the field or select None to remove it.</td>
</tr>
<tr>
<td>Field 4</td>
<td>The field from the table for the channel, for example the Interaction [interaction] table for the chat service channel. Select the field or select None to remove it.</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>--------</td>
<td>------------</td>
</tr>
<tr>
<td>Field 5</td>
<td>The field from the table for the channel. For example, the Interaction [interaction] table for the Chat service channel. Select the field or select <strong>None</strong> to remove it.</td>
</tr>
</tbody>
</table>

4. Click **Submit** for a new layout or **Update** to modify a layout. The layout is added to or updated in the Inbox Layout [awa_inbox_layout] table.

**What to do next**

As needed:

- **Override the agent capacity** value for selected agents or groups.
- **Create or modify a work item queue** for the channel.

**Override agent capacity for selected agents**

Change the default number of work items that an agent can handle for a service channel.

**Before you begin**

Role required: awa_manager, awa_admin, or admin

**About this task**

To change the capacity for selected agents, use the **Agent Capacity Override** related list for the service channel. To change the capacity for one or more members of a selected group, use the **Agent Capacity Override** related list for the group (**Advanced Work Assignment > Groups**).

**Procedure**

1. Navigate to **Advanced Work Assignment > Service Channels** and select the desired service channel.
2. In the **Agent Capacity Override** related list, click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Channel</td>
<td>Name of the selected channel.</td>
</tr>
<tr>
<td>Override Capacity</td>
<td>Number of work items that the selected agents can handle.</td>
</tr>
</tbody>
</table>
What to do next
If you are configuring a service channel, you can create or change an inbox layout for the channel.

Create or modify a work item size override
Create a work item size override if you want Agent Affinity to calculate an agent’s workload using a work item size other than the default.

Before you begin
Role required: awa_admin or admin

Procedure
1. Navigate to Advanced Work Assignment > Service Channels and select the desired service channel.

2. On the form, select the Work Item Size Override list.
   • To create an override, click New.
   • To modify an existing override, select the override that you want to update.

3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>Agents to which this override applies. Move the agent names from the Available list to the Selected list. You can use the filter to identify conditions that restrict the list of agents.</td>
</tr>
<tr>
<td>Note:</td>
<td>The filter shows only users or groups that have AWA roles (awa_agent, awa_manager, awa_admin, admin).</td>
</tr>
</tbody>
</table>

4. Click Submit.
   The selected agents and their associated capacity values are listed in the Agent Capacities table.

Change work item size form

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the override.</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service Channel</td>
<td>Service channel that is assigned to the override.</td>
</tr>
<tr>
<td>Override Size</td>
<td>Size to use instead of the default.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which Advanced Work Assignment considers this size override.</td>
</tr>
<tr>
<td>Condition mode</td>
<td>Type of condition for routing work items using this size override:</td>
</tr>
<tr>
<td></td>
<td>• Simple: Specify a routine condition using the condition builder.</td>
</tr>
<tr>
<td></td>
<td>• Advanced: Specify a JavaScript scripted condition.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Condition that applies to the override work item sizes. This field appears when you select <strong>Simple</strong> in the <strong>Condition mode</strong> field.</td>
</tr>
<tr>
<td>Script</td>
<td>JavaScript condition statement that specifies the override work item size. The condition must evaluate to true. This field appears when you select <strong>Advanced</strong> in the <strong>Condition mode</strong> field.</td>
</tr>
</tbody>
</table>

4. Click **Submit** to create the override or **Update** to modify the override.

**Work item queues**

In Advanced Work Assignment, queues store a specific type of work item for a service channel.

AWA administrators can create or modify queues based on customer need. As part of creating or modifying a queue, the awa_admin identifies some information about the queue, including the service channel to which the queue belongs and which agent groups handle the incoming work items.

The awa_admin can select a schedule that defines when the queue is available and identify a time limit within which an agent should accept a work item in the queue. If the selected service channel is **Chat**, the awa_admin creates the chat messages that are displayed to users.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Routing conditions identify the work items that are routed to a queue. Create routing conditions in one of two ways:

- Simple: use a condition builder to select routing conditions. The fields available for selection are based on the selected service channel.
- Advanced: use a JavaScript script to identify routing conditions.

The awa_admin can also create a queue without routing conditions so that work items are not routed to that queue automatically. Customers can manually assign work items to the queue or assign work items using assignment tools such as matching rules or Flow Designer.

When a case in a queue is assigned manually, the case is removed from the queue. The state of the work item is set to **Canceled** and the cancellation reason is set to **Manually assigned**.

**Note:** New work items may not be assigned if they are routed to queues containing more than 10,000 work items in the queued state.

**Configure routing rules that use chat context variables**

You can specify queue routing rules that use chat context variables in the condition builder. You define chat context variables in Chat Setup. These variables can store contextual information that can be used in routing conditions that control where chat work items are routed.

For example, you can define chat context variables to store user responses from pre-chat surveys. If you store these responses in chat context variables, such as a user's department or a product name, you can specify the context variables in queue routing conditions to direct where the live chat is routed. When you specify a routing condition using the condition builder, you can dot walk to the Context fields. In the fields menu, select **Show Related Fields** and open the fields menu again to select **Context → Interaction Context fields**.
You can then select from the available chat context variables in the condition builder. For example, choosing `csp_category` becomes `Context.csp_category`.

### Assign pools of agents eligible to work on a queue

Assign one or more agent groups to a queue using the [Eligibility Assignment](#) related list. These groups are eligible to receive work items from the queue, which allows work to get prioritized to eligible agents.

Select an agent assignment rule and any eligibility time constraints for each group. The eligibility time constraints are used to determine when the next pool of agents is eligible for assignment. For example, you can assign one group to handle work items immediately and a second group to handle the overflow from the first group after work items sit in the queue for a specified amount of time.

**Note:** If no groups are assigned to a queue, work items can be routed to the queue but Advanced Work Assignment does not assign them.

### Create a sort order for a queue

Use the Work Item Sort Order related list to create one or more sort conditions for work items in a queue. For each sort condition, specify a field from the selected service channel table and the direction to sort, either ascending or descending. Items in the queue are sorted and assigned to agents based on these conditions.

### Create a work item queue

Define or modify a queue so that you can determine which specific work items are routed automatically to agents through a given service channel.
Before you begin
Role required: awa_admin or admin

About this task
Depending on the service channel, additional configuration options are available. For example, in the chat channel you define the standard messages displayed during a chat session with a user.

Procedure
1. Navigate to Advanced Work Assignment > Settings > Queues.
   - To create a queue, click New.
   - To modify a queue, select the queue record to be updated.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the queue. A default queue may be available for the service channel you activated through the AWA-related plugins.</td>
</tr>
<tr>
<td>Number</td>
<td>Base number for the table. For more information, see Record numbering.</td>
</tr>
<tr>
<td>Service channel</td>
<td>Channel to which the queue belongs. For the chat channel, define the standard messages displayed to chat users in the Chat Messages section.</td>
</tr>
<tr>
<td>Active</td>
<td>Option indicating whether the queue is enabled.</td>
</tr>
<tr>
<td>Application</td>
<td>Type of scoped application.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Support schedule that defines when the queue is available.</td>
</tr>
<tr>
<td>Order</td>
<td>During routing, the order in which AWA considers the routing condition for this work item queue, in comparison to other queues.</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief explanation of the queue.</td>
</tr>
<tr>
<td>Routing Condition</td>
<td>Option that indicates a routing condition is to be applied to the queue. If checked, define the</td>
</tr>
<tr>
<td></td>
<td><strong>Condition mode</strong> and <strong>Work item routing condition</strong>.</td>
</tr>
<tr>
<td>Define condition here</td>
<td>Option that indicates a routing condition is to be applied to the queue. If checked, define the</td>
</tr>
<tr>
<td></td>
<td><strong>Condition mode</strong> and <strong>Work item routing condition</strong>.</td>
</tr>
<tr>
<td>Condition mode</td>
<td>Type of condition for routing work items in the queue.</td>
</tr>
<tr>
<td></td>
<td>• Simple: Specify a routing condition using the condition builder.</td>
</tr>
<tr>
<td></td>
<td>• Advanced: Specify a JavaScript scripted condition.</td>
</tr>
<tr>
<td>Work item routing condition</td>
<td>Condition that applies to routing work items to this queue.</td>
</tr>
<tr>
<td></td>
<td>Use the condition builder to select routing conditions. The fields available for selection are based</td>
</tr>
<tr>
<td></td>
<td>on the selected service channel. For the chat service channel, you can specify chat context</td>
</tr>
<tr>
<td></td>
<td>variables in the condition builder by <strong>dot-walking</strong> to related context fields.</td>
</tr>
<tr>
<td></td>
<td>For example, if you defined chat context variables that store pre-chat routing information, you</td>
</tr>
<tr>
<td></td>
<td>can dot walk to those chat context variables in the condition builder. You can use the variables</td>
</tr>
<tr>
<td></td>
<td>in routing conditions to specify where chats are routed.</td>
</tr>
<tr>
<td>Script</td>
<td>JavaScript condition statement that specifies the work items to be routed to the queue. The</td>
</tr>
<tr>
<td></td>
<td>condition must evaluate to true.</td>
</tr>
<tr>
<td></td>
<td>This field appears only when <strong>Advanced</strong> is selected from <strong>Condition mode</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Initial agent response</td>
<td>Message that users see when an agent accepts a chat. For example: Thank you for contacting support. I am looking into your question now and will be with you shortly.</td>
</tr>
<tr>
<td>Max wait time message</td>
<td>Message that users see when a chat ends because the Max Wait Time has elapsed. This field is required if the Max Wait Time is greater than 0.</td>
</tr>
<tr>
<td>Target wait time</td>
<td>Estimated time (Days or Hours, minutes, seconds) allotted for an agent to accept an item in the queue.</td>
</tr>
<tr>
<td>Max Wait Time</td>
<td>Maximum amount of time that an agent has to accept or reject a chat request. After time runs out, the requester receives the No Agents Available Message that is defined in Chat Setup.</td>
</tr>
<tr>
<td>Note: The Max Wait Time field is available after you associate the queue to the chat service channel.</td>
<td></td>
</tr>
<tr>
<td>Chat Messages</td>
<td>For the chat service channel.</td>
</tr>
<tr>
<td>Question</td>
<td>Initial phrase that users see when they start a new chat in the queue. For example: How can we help you?</td>
</tr>
<tr>
<td>Confirm problem</td>
<td>Message to users acknowledging the chat request. For example: Thank you for contacting support. Someone will be with you shortly to assist you.</td>
</tr>
</tbody>
</table>

3. Click **Submit** for a new queue or **Update** to modify the queue. The queue is added to or updated in the Queues [awa_queue_list] table.
What to do next

- Define the Assignment Eligibility.
- Optionally, define the Work Item Sort Order.
- Optionally, define the Set Agent Affinity rules.

Define agent pools eligible for assignment

Specify pools of agents eligible to receive overflow work assignments for a queue. An eligible assignment pool can consist of one or more groups of agents available to work on items in the queue. This feature enables Advanced Work Assignment to find a qualified agent from a wider pool of agents.

Before you begin

Role required: admin

About this task

Use the Assignment Eligibility related link to expand the pool of agents eligible to work on items in the queue when other agents are busy or unavailable. For each agent pool, select the assignment rule that determines the assignment eligibility. If you do not define an eligible assignment pool for a queue, work items are routed to the queue but AWA does not assign them.

Procedure

1. Navigate to Advanced Work Assignment > Queues and in the Queues [awa_queues] table, click the queue to update.

2. To create an assignment pool, go to the Assignment Eligibility related link.
   - To create a new eligible assignment pool, click New.
   - To modify the assignment eligibility for a pool of agents, select the pool to be updated.

3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent assignment rule</td>
<td>The name of the rule that determines how work items are to be assigned. Select an assignment rule from the list.</td>
</tr>
<tr>
<td>Eligible at</td>
<td>The length of time in seconds before AWA considers the next set of agents for assignment.</td>
</tr>
</tbody>
</table>
### Field | Definition
--- | ---
Groups | The set of groups eligible for assignment.
| • Click the lock icon to unlock it and select the agent groups in the eligible assignment pool.
| • Click the lock icon to lock it.

4. Click **Submit** to create the eligible or **Update** if modifying an eligible assignment pool.
The Queues [awa_queues] table is updated with the eligible assignment pool.

**Set work item sort order**
Specify the order in which work items in a queue are sorted.

Before you begin
Role required: awa_admin or admin

Procedure
1. Navigate to **Advanced Work Assignment > Queues > Module** and select the queue.
2. Click the **Work Item Sort Order** related list and click **New**.
3. In the Work Item Sort Order form, select:
   a. **Field**: The field to be used for the sort. The fields are from the table for the associated channel. For example, the fields available for the chat service channel are from the Interaction table.
   b. **Sort Direction**: The order in which work items are sorted. Select either Ascending (smallest to largest or oldest to newest ) or Descending (largest to smallest or newest to oldest).
   c. **Order**: The value of the Order value relative to other items in the queue.
4. Click **Submit**.

**Use external routing**
Configure Advanced Work Assignment to route work items in the queues using external routing.

Before you begin
Role required: awa_admin or admin
About this task
When you configure AWA to use external routing:

- Queues do not check for available agents.
- Work items remain in the queue with a status of “Queued” until the external system routes the work item or the maximum wait time is reached.
- Queues do not need to have Assignment Eligibility Groups defined.
- Related lists do not display at the bottom of the Queues screen.
- Create a REST API to support the external routing system. For information on creating a REST API, see AWA Assignment API.

Procedure
1. Navigate to Advanced Work Assignment > Settings > Queues.
2. If the External field does not appear, select the Update Personalized List icon (🔍) and add the External field to the screen.
3. To use external routing, set the External field to true. If you do not want to use external routing, set the External field to false.

Tutorial: Route interactions by context
Learn how you can configure Advanced Work Assignment to route conversations to agents according to the context of the conversation.

Before you begin
Activate the Customer Service Management Demo Data (com.snc.customerservice.demo) plugin.

A basic understanding of context variables is required. For more information on context variables, see Virtual Agent scripts.

Role required: awa_admin or admin

About this task
The What can we help you with? record producer is available by default with the Customer Service Management Demo Data (com.snc.customerservice.demo) plugin. In the record producer, chat requesters can specify one of three issue categories that they need help with:

- Product
- Billing
- Order
Whichever category they select passes a value through the `liveagent_csp_category` context variable. Learn how to create queues that route conversations to agents according to the values passed through this context variable.

**Create a queue for product issues**
Create a queue for the Chat service channel that routes product issues.

**Procedure**
1. Navigate to **Advanced Work Assignment > Queues**, and then click **New**.
2. Enter the following information in the fields listed:
   - Name: Product Support
   - Service channel: Chat
   - Condition mode: Advanced
3. In the **Script** field, enter this script:

   ```javascript
   (function executeCondition(/* glide record */ current) {
       var contextTable = current.getValue('context_table');
       var interactionBlobRecord = new GlideRecord(contextTable);
       interactionBlobRecord.addQuery('sys_id', current.getValue('context_document'));
       interactionBlobRecord.query();

       if(interactionBlobRecord.next()){
           var jsonBlob = JSON.parse(interactionBlobRecord.getValue('value'));
           if(jsonBlob.liveagent_csp_category == 'product')
               return true;
       }
       return false;
   })(current);
   ```
4. Click **Submit**.

**Create a queue for billing issues**
Create a queue for the Chat service channel that routes billing issues.

**Procedure**
1. From the Queues list view, click **New**.
2. Enter the following information in the fields listed:
3. In the **Script** field, enter this script:

```javascript
(function executeCondition(/* glide record */ current) {
    var contextTable = current.getValue('context_table');
    var interactionBlobRecord = new GlideRecord(contextTable);
    interactionBlobRecord.addQuery('sys_id', current.getValue('context_document'));
    interactionBlobRecord.query();

    if(interactionBlobRecord.next()){
        var jsonBlob = JSON.parse(interactionBlobRecord.getValue('value'));
        if(jsonBlob.liveagent_csp_category == 'billing')
            return true;
    }
    return false;
})(current);
```

4. Click **Submit**.

**Create a queue for order issues**

Create a queue for the Chat service channel that routes order issues.

**Procedure**

1. From the Queues list view, click **New**.
2. Enter the following information in the fields listed:
   - Name: Order Support
   - Service channel: Chat
   - Condition mode: Advanced
3. In the **Script** field, enter this script:

```javascript
(function executeCondition(/* glide record */ current) {
    var contextTable = current.getValue('context_table');
    var interactionBlobRecord = new GlideRecord(contextTable);
    interactionBlobRecord.addQuery('sys_id', current.getValue('context_document'));
    interactionBlobRecord.query();

    if(interactionBlobRecord.next()){
        var jsonBlob = JSON.parse(interactionBlobRecord.getValue('value'));
        if(jsonBlob.liveagent_csp_category == 'order')
            return true;
    }
    return false;
})(current);
```
4. Click **Submit**.

**Work assignments**

After routing work items to the appropriate queues and corresponding agent
groups, Advanced Work Assignment pushes work to the most qualified agent
using the assignment criteria that you specify.

Administrators can choose to push work items to agents based on one of these
assignment rules:

- **Most capacity**: This option pushes work to agents that have the most capacity
  (availability for work) for a given channel. For example, suppose that two
  available agents, John and Beth have different capacities. John has capacity
  for three chats, but Beth has capacity for two chats and is currently working
  on one chat. AWA assigns the next work item to John since he has the most
  capacity.

- **Last assigned**: This option pushes work to the agent who has gone the longest
  without a work assignment in the service channel. If more than one agent has
  the same spare capacity in a service channel, AWA creates and assigns the
  next work item to the agent who has gone the longest without work in the
  service channel.

In addition to selecting the assignment rule, AWA admins can also determine
whether:

- Agents can reject work items
- A timer is used to set a timeout period (the length of a time that an agent has
  to reject or accept a work item)
- Agent skills are to be considered in assignment

**Assignment process**

When an agent is available, AWA:

- Checks the queue priority and gets an item from the queue with the highest
  priority. AWA also reviews items that have timed out or have been rejected by
  agents.

- Identifies the eligible assignment pool. The eligibility assignment pool widens
  the group of agents who are eligible to work on an item.
• Determines the available agents based on their presence state, the assignment rule selected (most capacity or last assigned), and also skills, if defined. Agents have spare capacity when they decline, transfer, or complete a work item. For example, after an agent transfers a chat, the agent has additional capacity.

• Pushes the item to the inbox of most qualified agent (the timer begins).

Skill-based work assignment
In AWA, you can enable skill-based assignment and if needed, make skill assignment mandatory. The basic process for setting up skills involves the following steps:

1. Identify agents that have specific skills (for example, a foreign language or expertise in a certain area such as network routers) and assign the skills to those agents using the Skills Management feature.

2. Make the agents members of the assignment groups for the work item queues involving those skills.

3. Create an assignment rule in AWA that enables skill handling for the specific skills.

4. Create the work item queue with a routing condition that includes the specific skill, and include the appropriate group in the eligible assignment pool.

5. Create a scripted business rule that includes the skill in the table associated with the relevant service channel (for example, the Case table).

During work assignment, AWA routes and assigns work items that require the skills to the Agent Workspace inbox of the most qualified agent.

Configure agent assignment rules
Set the criteria for assigning work items to agents. Choose the assignment rule that considers the agent with the most capacity or the agent who has gone the longest without work. Select the timeout period for rejecting work items and indicate whether agent skills are to be considered during assignment.

Before you begin
• A basic understanding of the Skills Management feature is recommended.

• If you want agent skills to be considered when work is routed to the appropriate agents, define the skills for your agents or groups. When you
enable the skill handling options in the Assignment Rules form. AWA assigns the users in groups with the appropriate skills to corresponding work items.

- You can use rules to identify skills and assign it to work items. For more information on defining and assigning skills for work items, refer to Using rules to identify skills for work items

Role required: admin or awa_admin

**Procedure**

1. Navigate to Advanced Work Assignment > Settings > Assignment Rules.
   - To create a new rule, select **New**.
   - To modify a rule, select the layout to be updated.

2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the assignment rule.</td>
</tr>
<tr>
<td>Application</td>
<td>Name of the application to which this assignment rule belongs. The default application is <strong>Global</strong>.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the assignment rule.</td>
</tr>
<tr>
<td>Assign by</td>
<td>Type of assignment. Select one of the following values:</td>
</tr>
<tr>
<td></td>
<td>• Last Assigned: Routes a work item to the agent who has gone the longest without being assigned work.</td>
</tr>
<tr>
<td></td>
<td>• Most Capacity: Routes a work item to the agent who has the greatest availability for handling the work.</td>
</tr>
<tr>
<td>Rejection handling</td>
<td>Specify how work items are rejected and handled.</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Allow agents to reject</td>
<td>Enable agents to reject work items in their inbox.</td>
</tr>
<tr>
<td>Reassign on timeout</td>
<td>Enable reassignment of work items not accepted or rejected by agents within the specified timeout period:</td>
</tr>
<tr>
<td>◦ Timeout value (Days and Hours, Minutes, Seconds): Length of time allowed for an agent to accept or reject a work item before the assignment times out (ends) and is reassigned to another agent.</td>
<td></td>
</tr>
<tr>
<td>◦ Timeout presence state: Agent availability state after the timeout occurs: Available, Away, or Offline.</td>
<td></td>
</tr>
<tr>
<td>Skill handling</td>
<td>Enable skill-based work assignments.</td>
</tr>
<tr>
<td>◦ Enable skills: Route work items to agents with the appropriate skills.</td>
<td></td>
</tr>
<tr>
<td>◦ Enforce mandatory skills: Route work items to agents with mandatory (required) skills.</td>
<td></td>
</tr>
<tr>
<td>Shift handling</td>
<td>Enable assigning work items to agents based on shifts.</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Note:** This field is available only if the Advanced Work Assignment plugin (com.glide.awa) is activated and the Workforce Optimization for Customer Service plugin (com.snc.wfo.csm) or the Workforce Optimization for ITSM plugin (com.snc.wfo_itsm) plugin, or both, is activated. As a manager, you must have planned schedules for agents to assign them shifts. For more information, see Scheduling in Workforce Optimization for Customer Service and Scheduling in Workforce Optimization for ITSM. | • Enable-shift based assignment: Assign work items to agents based on time available in their shifts.  
• Add time constraints: Add the time required to complete work items in shifts and whether agents should be continuously available for the required time period.  
This field appears only when the **Enable shift-based assignment** check box is selected.  
• Agent criteria: Select an agent based on the time left in the agent’s shift.  
This field appears only when the **Enable shift-based assignment** check box is selected.  
Available options are:  
  ◦ Least time left in shift: Assign a work item to an agent from a group of available agents based on the least time available in their shifts.  
  ◦ Most time left in shift: Assign a work item to an agent from a group of available agents based on the maximum time available in their shifts.  
• Time required: Time required to complete a work item.  
This field appears only when the **Add time constraints** check box is selected.  
• Available continuously for the required time: Assign work items to agents who are continuously available for the required time.
<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>period without any breaks in a shift. Agents who don’t have the minimum time required in their shifts are not considered for work item assignments.</td>
</tr>
<tr>
<td></td>
<td>This field appears only when the <strong>Add time constraints</strong> check box is selected.</td>
</tr>
</tbody>
</table>

3. Select **Submit** for a new rule or **Update** if modifying the rule. The assignment rule is added to or updated in the Assignment Rules [awa_assignment_rule] table.

**Tutorial: Assign work to agents by skill**

Learn how you can configure Advanced Work Assignment to route cases to agents who speak German. Use this tutorial as a guideline to help you understand how you can route work items to agents according to their designated skills.

Before you begin:

- Activate the Skills Management (com.snc.skills_management) plugin.
- A basic understanding of the Skills Management feature is required.
- To have skills automatically assigned to cases, consider activating the Skill Determination (com.snc.skill_determination) plugin.
- Create a group of users who work in customer support.
- Assign the awa_agent and workspace_agent roles to the customer support group.

**Create a skill**

Create a "German" skill.

**Before you begin**

Role required: skill_admin or admin

**Procedure**

1. Navigate to **Skills > All Skills**, and then click **New**.
2. Enter the following information in the fields listed:
• Name: German
  • Active: Selected

3. Click **Submit**.

**Create an assignment rule**
Create an assignment rule that routes cases according to skills.

**Before you begin**
Role required: awa_admin or admin

**Procedure**
1. Navigate to **Advanced Work Assignment > Assignment Rules**, and then click **New**.
2. Enter the following information in the fields listed:
   • Name: Case Assignment Rule with Skills
   • Assign by: Most Capacity
   • Enable skills: Selected
   • Enforce mandatory skills: Selected
3. Click **Submit**.

**Create a queue**
Create a queue where you can route work to agents who have the German skill.

**Before you begin**
Role required: awa_admin or admin

**Procedure**
1. Navigate to **Advanced Work Assignment > Queues**, and then click **New**.
2. Enter the following information in the fields listed:
   • Name: German Cases
   • Service channel: Case
3. Click **Submit**.

**Define assignment eligibility**
Define who is eligible to receive cases from the German Cases queue.
Before you begin
Role required: awa_admin or admin

Procedure
1. Navigate to Advanced Work Assignment > Queues, and then open the German Cases queue.
2. On the form, go to the Assignment Eligibility related link and click New.
3. In the Agent assignment rule field, select Case Assignment Rule with Skills.
4. In the Groups field, select your customer support group.
5. Click Submit.

Results
Cases that require German speakers are routed to users in your customer support group who have the German skill.

Using Agent Affinity
Agent Affinity is an Advanced Work Assignment feature that lets you assign work items by an agent’s work history, related task, or account team affinity.

Advanced Work Assignment assigns work items to agents by their availability, capacity, and skills. You can use Agent Affinity to customize this AWA assignment process and identify the agent best suited for the work item. Agent Affinity ensures that the same agent is assigned to a similar work item instead of orienting a new agent every time.

ℹ️ Note: Agent Affinity rules do not override assignment eligibility or constraints that are specified on AWA assignment rules.

The types of affinities are:

- **Historical**
  Identifies the best agent based on the agent’s history of serving the same customer.

- **Related task**
  Identifies the best agent based on the agent’s past assignments of related tasks.

- **Account team**
  Identifies the best agent based on the agent’s responsibility or role in the account team.
**Note:** Account team affinity is available only to Customer Service Management (CSM) customers.

Affinity rules are associated with AWA queues. Up to three rules can be associated with each queue. The affinity order determines how the assignment engine ranks the agents. The agent with the higher order affinity rule is considered as the best agent first.

The following example shows how AWA uses Agent Affinity to determine the best agent for a work item. In this example, AWA is configured to use all three affinities in this order: related task affinity, account team affinity, and historical affinity. George Warren, who is a customer at the Boxeo company, has a router problem. George previously contacted support to report an issue. That case was assigned to agent Ned. The primary support agent for Boxeo is agent John. Within the past seven days, another agent, agent Beth, addressed a chat with Boxeo.

The next time George initiates a customer service chat from the case page, the case is automatically added as a related task to the chat interaction. Agent Affinity uses the related task affinity to look for an agent who has fulfilled past assignments for a related task. Because agent Ned was assigned to a related task on the record, AWA assigns the work item to agent Ned if he is available and has the capacity.

**Example of related task affinity**

If agent Ned is unavailable or doesn’t have the capacity, AWA uses the account team affinity. AWA looks for another agent based on an agent’s responsibility or role in the account team. Because agent John is the primary support agent for the Boxeo company, AWA assigns the work item to Agent John if he is available and has the capacity.
Example of account team affinity

If agent John is not available, AWA uses the historical affinity and looks for an agent that has recently interacted with the company. This information is stored on the Agent Affinity screen. Because agent Beth addressed a chat with Boxeo within the past seven days, AWA assigns the work item to agent Beth if she is available and has the capacity.

Example of historical affinity

Activate Agent Affinity

You can activate the Agent Affinity plugin (com.glide.awa.agent_affinity) if you have the admin role. This also activates the Advanced Work Assignment plugin.

Before you begin
Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for &lt;plugin name&gt;.

### Configure Agent Affinity rules

Create or modify the Agent Affinity rules that route work items in Advanced Work Assignment.

**Before you begin**

Role required: awa_admin or admin

**Procedure**

1. Navigate to Advanced Work Assignment &gt; Settings &gt; Agent Affinity Rules.
   - To create a new affinity rule, click **New**.
   - To update an existing affinity rule, click the affinity rule.

2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the affinity rule.</td>
</tr>
<tr>
<td>Service channel</td>
<td>Service channel that the rule applies to.</td>
</tr>
<tr>
<td>Application</td>
<td>Name of the application.</td>
</tr>
<tr>
<td>Affinity based on</td>
<td>Type of affinity. Only affinity types corresponding to your selection appear.</td>
</tr>
<tr>
<td></td>
<td>• History</td>
</tr>
<tr>
<td></td>
<td>• Related Tasks</td>
</tr>
<tr>
<td></td>
<td>• Account Team Responsibility</td>
</tr>
</tbody>
</table>
Field | Definition
---|---
Agent's affinity to | Account level or contact level. This field appears when you select History in the Affinity based on field.
Number of days | Past number of days during which the agent has worked with the customer. The maximum number of days is 30. This field appears when you select History in the Affinity based on field.
Responsibility | Agent who is part of the account team. This field appears when you select Account Team Responsibility in the Affinity based on field.

3. Click **Submit** for a new affinity rule or **Update** to modify an existing affinity rule.

### Set Agent Affinity rules

Specify the Agent Affinity rules to determine the order in which work items in a queue are sorted.

**Before you begin**

Role required: awa_admin or admin

**Procedure**

1. Navigate to **Advanced Work Assignment > Settings > Queues** and select the queue.
2. Click the Agent Affinity related list.
   - To create a new Agent Affinity rule mapping, click **New**.
   - To modify an existing Agent Affinity rule mapping, select the mapping to be updated.
3. On the form, fill in the fields.

### Agent Affinity Rule Mapping form

Field | Definition
---|---
Agent Affinity Rule | Agent Affinity rule to be used for the sort.
Order | Value of this rule relative to the other rules in the queue. Rules are ordered
### Field | Definition
---|---
| | from lowest to highest so a rule with an order of 100 is considered before a rule with an order of 200.

4. Click **Submit**.
   You can specify a maximum of three Agent Affinity rules per queue.

**Deactivate Agent Affinity**

Deactivate Agent Affinity if you do not want Agent Affinity to assign work assignments to agents.

**Before you begin**
Role required: awa_admin or admin

**Procedure**

1. In the navigation filter, enter `sys_properties.list`.
   The entire list of properties in the System Properties [sys_properties] table appears.

2. In the **Search** field, enter `glide.awa.agent_affinity.enabled`.

3. Click `glide.awa.agent_affinity.enabled`.

4. On the system property screen, change **Value** from `true` to `false` and click **Update**.
   Agent Affinity is now deactivated.

**Agent Inbox controls**

Control certain elements of the agent experience in Agent Workspace. Define the agent presence (availability) states and the work item rejection reasons used by agents to decline work assignments in their Agent Workspace inbox.
Agent presence states

Agent availability in Agent Workspace Inbox

AWA admins can define the presence states that agents choose in their inbox to indicate their availability. The default states are

- Available: Solid green bubble indicates that the agent is available to receive work.
- Away: Solid yellow bubble indicates that the agent is not available to receive work.
- Offline: Solid grey bubble indicates that the agent is not available to receive work.

AWA developers with the awa_integration_user role can also use JavaScript or REST APIs to get or set agent presence and agent channel availability. For more information, see

- Agent Presence API (REST APIs)
- Agent - Global (JavaScript APIs)

Agent rejection controls

AWA admins can give agents the option to reject work assignments and specify the reason for rejecting it. The **Reject** button displays on work assignment cards. When an agent rejects an assignment, a pop-up window enables the agent to select a reason for declining the work item.

Configure agent presence states

Create or modify the availability states that agents use to indicate whether they can receive work or are offline or away. Agents set these states in their Agent Workspace Inbox.
Before you begin
Role required: awa_admin or admin. Users with the awa_manager and awa_agent roles can review the presence states.

About this task
The default presence states are Available, Away, and Offline. For the Available state, be sure to enable it (using the Active check box) so that AWA can route work to agents.

Procedure
1. Navigate to Advanced Work Assignment > Settings > Presence States.
   • To create a new presence state, click New.
   • To update an existing presence state, click the presence record.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the presence state, for example: Out of office. The default presence states are Available, Away, or Offline.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box for enabling this presence state for agents.</td>
</tr>
<tr>
<td></td>
<td>Note: For the default Available state, be sure to enable this Active check box so that work items are routed to available agents. If the Active state is not enabled, AWA does not route work items to agents.</td>
</tr>
<tr>
<td>Available to receive work items</td>
<td>Check box for indicating that agents can handle work items in this presence state. If the presence state is Away or Offline, this box is not selected.</td>
</tr>
<tr>
<td>Service channels</td>
<td>The service channels that can use this presence state. To select a service channel, move the channel name</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the state.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which this state is displayed in the agent inbox.</td>
</tr>
<tr>
<td>Show channels</td>
<td>Check box that enables you to restrict the service channels in which agents can update their presence using this state. When you select this field, the <strong>Restrict agent updates</strong> field is displayed.</td>
</tr>
<tr>
<td>Restrict agent updates</td>
<td>The service channels in which agents cannot use this state to update their presence. Click the lock icon and select the appropriate channels. When you complete your selections, click the lock icon to lock the field.</td>
</tr>
<tr>
<td>Apply to all groups</td>
<td>Check box that indicates all groups can use this presence state. To specify only certain groups that can use this presence state, unselect this check box to display the <strong>Apply to groups</strong> list.</td>
</tr>
<tr>
<td>Apply to groups</td>
<td>The selected groups that can use this presence state. To select a group, move the group name from the <strong>Available</strong> list to the <strong>Selected</strong> list.</td>
</tr>
</tbody>
</table>

3. Click **Submit** for a new presence state or **Update** if modifying an existing presence state.

The presence state is added to or updated in the Presence States [awa_presence_state] table. The presence state is also listed in the Availability section of the Agent Workspace Inbox for the agents belonging to the groups and channels that use this state.

**Configure reasons for rejecting work items**

Define the reasons that agents can use to decline work assignments that they receive in their Agent Workspace inbox. A reject reason can apply to all service channels or a single channel that you specify.
Before you begin
Role required: awa_admin or admin

Procedure
1. Navigate to Advanced Work Assignment > Settings > Reject Reasons.
   • To create a new rejection reason, click New.
   • To update an existing rejection reason, click the reason record.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason</td>
<td>Name of the reason for rejecting work items.</td>
</tr>
<tr>
<td>Agent selectable</td>
<td>Indicates the reject reason is selectable by agents in their Agent Workspace Inbox.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the reject reasons are listed in the agent inbox.</td>
</tr>
<tr>
<td>Apply to all service channels</td>
<td>Indicates the reject reason applies to all service channels. To make the reason available to a single channel, unselect this check box and in the Service channel field, select the appropriate channel.</td>
</tr>
<tr>
<td>Service channel</td>
<td>Service channel that the rule applies to. This field is displayed when Apply to all service channels is not enabled.</td>
</tr>
<tr>
<td>Reassignable</td>
<td>Indicates if the work item can be reassigned to the agent who rejected it.</td>
</tr>
</tbody>
</table>

3. Click Submit for a new reason, or if changing an existing reason, click Update. The rejection reason is added to or updated in the Reject Reasons [awa_reject_reason] table.

Reassign rejected or timed-out work items
Configure whether an agent who rejected a work item is eligible to be offered the same work item.
Before you begin
Role required: admin

Procedure
1. Navigate to Advanced Work Assignment > Settings > Reject Reasons.
2. Click the reason record you want to change.
3. On the form, configure the Reassignable field:
   - If you want to have an agent who rejected a work item be eligible to be offered the same work item, select the Reassignable field.
   - If you do not want to have an agent who rejected a work item be eligible to be offered the same work item, unselect the Reassignable field.

Management
Configure Advanced Work Assignment properties using the Management menu options.
Only users with awa_manager privileges can access the Management menu options.

Operations dashboard
Enable managers to monitor Operation [operation] work items so that their agents can better support customer needs.
This dashboard is available in the Advanced Work Assignment content pack. For information on activating the content pack, see Analytics and Reporting Solutions for Advanced Work Assignment.
End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>AWA administrator: Configures Advanced Work Assignment to best fit the business needs of customer service.</td>
<td>awa_admin</td>
</tr>
<tr>
<td>AWA manager: Identifies the areas of concern for routing and assignment of work items across service channels.</td>
<td>awa_manager</td>
</tr>
<tr>
<td>Agent manager: Manages agents or agent groups. The agent manager wants to know what agents are working on to make sure that customer needs are being met.</td>
<td>sn_customerservice_manager</td>
</tr>
<tr>
<td>Performance Analytics administrator: Ensures that business managers are making the best use of Performance Analytics solutions.</td>
<td>pa_admin or pa_viewer</td>
</tr>
</tbody>
</table>

Use case

This dashboard provides support managers with an overview of incoming work items and the availability of agents to handle them. Managers can monitor these daily trends to determine if adjustments should be made to the routing criteria, agent capacity values, and other settings that determine how work is pushed to agents.

Indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Work Items</td>
<td>Total number of interaction work items that were created today. The goal for this indicator is to minimize the number of interaction work items that agents receive.</td>
</tr>
<tr>
<td>Accepted Work Items</td>
<td>Percentage of interaction work items that agents have accepted.</td>
</tr>
<tr>
<td>Indicator</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Exceeding Target Work Items</td>
<td>Percentage of interaction work items that have exceeded the target wait time.</td>
</tr>
<tr>
<td>Rejected Work Items</td>
<td>Percentage of interaction work items that agents have rejected.</td>
</tr>
<tr>
<td>Timed Out Work Items</td>
<td>Percentage of interaction work items that timed out.</td>
</tr>
<tr>
<td>Weekly Trends</td>
<td>Number of work items in each of the following states for the past week:</td>
</tr>
<tr>
<td></td>
<td>• New</td>
</tr>
<tr>
<td></td>
<td>• Exceeding Target</td>
</tr>
<tr>
<td></td>
<td>• Abandoned</td>
</tr>
<tr>
<td></td>
<td>• Rejected</td>
</tr>
<tr>
<td></td>
<td>• Timed Out</td>
</tr>
</tbody>
</table>

**Breakdowns**

To analyze data according to different categories, select a breakdown from the dashboard menu:

- Service Channel
- Queue
- Assignment Group

For more information on analyzing data with breakdowns, see Using breakdowns on dashboards.

**Reports**

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accepted Work Items - Last Hour</td>
<td>Single</td>
<td>Number of interaction work items that agents have accepted in the past hour.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Title | Type | Description
--- | --- | ---
Abandoned Work Items - Last Hour | Single | Number of interaction work items that agents have abandoned in the past hour.

| Score | 42 |

Average Wait Time - Last Hour | Single | Average amount of time that customers have spent waiting for an agent response in the past hour.

| Score | 42 |

---

#### Check for an agent’s presence and capacity

View a list of agents in Advanced Work Assignment, their presence status, and capacity for each of the agent's service channels to see which agent can handle a case. This list is filtered across different teams, channels in teams, and channels dashboards.

**Before you begin**

Role required: awa_admin or admin

**Procedure**

1. Navigate to **Advanced Work Assignment > Management > Agent Presence & Capacity**.
2. In the list, check which agent is available to handle a case:

#### AWA Agent Presence and Capacities form

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent</td>
<td>Name of the agent.</td>
</tr>
<tr>
<td>Current presence state</td>
<td>Presence state that is currently assigned to the agent.</td>
</tr>
<tr>
<td>Updated</td>
<td>Date and time that this agent was last updated.</td>
</tr>
<tr>
<td>Channel</td>
<td>Service channel that is assigned to the agent.</td>
</tr>
</tbody>
</table>
Field | Definition
--- | ---
Capacity in use | Current workload of agent.
Capacity | Maximum capacity that the agent can handle.

Check unassigned interactions
View a list of unassigned interactions in Advanced Work Assignment from chat and phone that are currently waiting in the queue and are not assigned to any agents. You can use this list to debug, implement advanced work assignments, or determine why certain work items are not being assigned.

Before you begin
Role required: awa_manager or admin

Procedure
1. Navigate to **Advanced Work Assignment > Management > Unassigned interactions**.
2. In the list, check the unassigned interactions:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Interaction number.</td>
</tr>
<tr>
<td>Type</td>
<td>How the interaction began (for example, chat, phone, or walk-up).</td>
</tr>
<tr>
<td>Created</td>
<td>Date that the interaction was created.</td>
</tr>
<tr>
<td>Opened for</td>
<td>Name of the user starting the interaction.</td>
</tr>
<tr>
<td>Account</td>
<td>Name of the company that is associated with the interaction.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User that is assigned to the interaction.</td>
</tr>
<tr>
<td>State</td>
<td>Status of the interaction.</td>
</tr>
<tr>
<td>Queue</td>
<td>Queue that is assigned to the interaction.</td>
</tr>
<tr>
<td>Offered on</td>
<td>Date that the interaction was first offered to an agent.</td>
</tr>
<tr>
<td>Rejected</td>
<td>Interaction that was rejected by the agent.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Timed Out</td>
<td>Interaction that has exceeded the timeout specified in assignment rule.</td>
</tr>
<tr>
<td>Exceeded Queue Target Wait Time</td>
<td>Interaction that has waited longer than the target wait time of the queue.</td>
</tr>
</tbody>
</table>

**Check unassigned task work items**

View a list of unassigned task work items in Advanced Work Assignment, such as cases and incidents, that are currently waiting in the queue and are not assigned to any agents. You can use this list to debug, implement advanced work assignments, or determine why certain work items are unassigned.

**Before you begin**

Role required: awa_manager or admin

**Procedure**

1. Navigate to **Advanced Work Assignment > Management > Unassigned Task Work Items**.
   - To create a task, click **New**.
   - To modify an existing task, select the task to be updated.
2. On the form, fill in the fields.

**Work Item form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Whether the task is still being worked on or is complete.</td>
</tr>
<tr>
<td>Display Name</td>
<td>Task name.</td>
</tr>
<tr>
<td>Offered on</td>
<td>Date that the task was first offered to an agent.</td>
</tr>
<tr>
<td>State</td>
<td>List that shows the status of the task:</td>
</tr>
<tr>
<td></td>
<td>• Accepted</td>
</tr>
<tr>
<td></td>
<td>• Cancelled</td>
</tr>
<tr>
<td></td>
<td>• Pending Accept</td>
</tr>
<tr>
<td></td>
<td>• Queued</td>
</tr>
<tr>
<td>Assignment rule</td>
<td>Rule that assigns cases that meet the matching rule criteria to a customer service agent.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Exceeded Queue Target Wait Time</td>
<td>Task that has waited longer than the target wait time of the queue.</td>
</tr>
<tr>
<td>Rejected</td>
<td>Task that was rejected by the agent.</td>
</tr>
<tr>
<td>Timed Out</td>
<td>Task that has exceeded the timeout specified in the assignment rule.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User that is assigned to the task.</td>
</tr>
<tr>
<td>Document ID</td>
<td>Document ID that is assigned to the task.</td>
</tr>
<tr>
<td>Previous Work Item</td>
<td>Reference to a previous work item for the same Document ID.</td>
</tr>
<tr>
<td>State changed on</td>
<td>Date that the task state was most recently changed.</td>
</tr>
<tr>
<td>Cancelled reason</td>
<td>Reason that the task was canceled:</td>
</tr>
<tr>
<td></td>
<td>• Disqualified from service channel</td>
</tr>
<tr>
<td></td>
<td>• Manually assigned</td>
</tr>
<tr>
<td></td>
<td>• Time out</td>
</tr>
<tr>
<td></td>
<td>• Transfer was cancelled or rejected</td>
</tr>
<tr>
<td>Is Dismissed</td>
<td>Whether the task has been dismissed.</td>
</tr>
<tr>
<td>Work Item Size</td>
<td>Amount of an agent’s capacity that is used if this task is assigned.</td>
</tr>
<tr>
<td>Wait time</td>
<td>Length of time the task has waited in the queue before being assigned.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group that is assigned to the task.</td>
</tr>
<tr>
<td>Document table</td>
<td>Document table that is assigned to the task.</td>
</tr>
<tr>
<td>Queue</td>
<td>Queue that is assigned to the task.</td>
</tr>
</tbody>
</table>

3. Click **Submit** to create the task or **Update** to modify the task.

**Using Advanced analytics to access AWA dashboards**

Advanced analytics enable you to view cards that represent the Advanced Work Assignment dashboards that you have access to. You can also see a dashboard picker, which lets you view the cards for all the dashboards in a group. You can then search and choose a dashboard from a list.

Navigate to **Advanced Work Assignment > Management > Advanced Analytics**.
The advanced analytics for the dashboards lets you see the dashboards in one of these categories: by default, the Recent category is selected when you visit the advanced analytics for the dashboards.

- **Recent** shows up to nine dashboards that you have visited recently. The most recent are shown first.
- **Owned by me** shows the dashboards that you have created and those dashboards to which you have been assigned ownership.
- **Shared with me** shows the dashboards which have been shared with you as a user, or member of a group or role.
- **All** shows all the dashboards that you have access to.

**Note:** The category that you choose limits the dashboard groups and individual dashboards that you see when you choose from the Groups list and the **Dashboard Picker** field. If no dashboards in the incident group have been shared with you, and you select Incident from the Groups list, then the overview displays a note that no dashboards match your search.

All tabs except for the Recent tab are sorted in ascending order by:

1. **Dashboard group — Order**
   
   The owner of the dashboard can specify an order number in the dashboard group’s form. This field is optional.

2. **Dashboard group — Name**

3. **Dashboard — Order**
   
   The owner of the dashboard can specify an order number in the dashboard’s form. This field is optional.

4. **Dashboard — Name**

**Using Advanced Analytics tiles**

Tiles on Advanced Analytics show thumbnails of the widgets on the dashboard, the dashboard group, your level of access on the dashboard, the name of the dashboard, and the owner of the dashboard. Dashboard access levels are Owner, Editor, and Viewer. For more information, see .
Note: If you can't view a dashboard widget, you'll see a message that prompts you to contact the administrator. You may not be able to view a dashboard widget because of wrong configuration settings, access restrictions, or because there is no data to display.

Using the Advanced Analytics Groups list
The advanced analytics screen defaults to showing only the AWA-related dashboards. You can see other dashboards by changing the Groups list to show only those dashboards in another single group. The Groups list shows all dashboard groups without applying ACL rules. You may see dashboard groups in this list that have not been explicitly shared with you.

Click New to create a responsive dashboard.

Create or modify groups for Advanced Work Assignment queues
Create or manage groups that have associated Advanced Work Assignment queues. Groups are sets of users who share a common purpose. By creating these groups, information that is displayed in AWA is limited to only users that are in AWA groups.

Before you begin
Role required: awa_manager or admin
Procedure

1. Navigate to **Advanced Work Assignment > Management > Groups**.
   - To create a group, click **New**.
   - To modify a group, select the group you want to update.

2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Groups form</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Name of the group.</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Helpful information about the group.</td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Option that indicates whether the group is active or inactive. Inactive groups still appear in any reference field that already references the group but are not visible by non-admin users in:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Lists of groups</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The reference lookup list for reference fields</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The auto-complete list of groups displayed when you enter information into a reference field</td>
<td></td>
</tr>
<tr>
<td>Manager</td>
<td>Group manager or lead.</td>
<td></td>
</tr>
<tr>
<td>Group email</td>
<td>Group email distribution list or the email address of the point of contact, such as the group manager.</td>
<td></td>
</tr>
<tr>
<td>Parent</td>
<td>Other group of which this group is a member. If a group has a parent, the child group inherits the roles of the parent group. The members of the child group are not members of the parent group. For example, if an incident is assigned to the parent group and you click the Assigned to look up icon, only the members in the parent group are available. The members of the child group are not available.</td>
<td></td>
</tr>
<tr>
<td>Updated</td>
<td>Date and time that this group was last updated.</td>
<td></td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**Properties for Advanced Work Assignment**

The Advanced Work Assignment Properties page provides configuration options for AWA.
Users with the admin role can access these properties by navigating to **System Properties > All Properties**.

**Properties for AWA**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Disable Query Business Rules glide.awa.query_br_disable | If the property is enabled, AWA disables before query business rules during its execution. For example, if enabled, an instance can have a custom before query business on the interaction table without affecting how AWA routes/assigns interactions.  
  - **Type**: true | false  
  - **Default value**: false  
  - **Location**: System Properties > All Properties |

For information on adding a system property, see **Work items**

**Work items**

View Advanced Work Assignment work items using the Work Items menu options.

Work items are a single piece of work handled by an agent from start to finish. For example, one chat or one case is an object that is routed and assigned to agents. Only users with awa_manager privileges can access the Management menu options.

Only users with awa_manager privileges can access the Management menu options.

**Check work items and AWA events**

View a list of work items and AWA events.

**Before you begin**

Role required: awa_admin or admin

**Procedure**

1. Navigate to Advanced Work Assignment > Work Item > All.
   
   A list of the work items appears.

2. Select the preview button ( ) for the work item you want to view.
3. On the Work Item modal, select **Open Record**.

### Work Item form

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exceeded Queue Target Wait Time</td>
<td>Indicator that the interaction has waited longer than the target wait time of the queue.</td>
</tr>
<tr>
<td>Queue</td>
<td>Queue assigned to the task.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User assigned to the task.</td>
</tr>
<tr>
<td>Document ID</td>
<td>Document ID assigned to the task.</td>
</tr>
<tr>
<td>State</td>
<td>Status of the task:</td>
</tr>
<tr>
<td></td>
<td>• Accepted</td>
</tr>
<tr>
<td></td>
<td>• Canceled</td>
</tr>
<tr>
<td></td>
<td>• Pending Accept</td>
</tr>
<tr>
<td></td>
<td>• Queued</td>
</tr>
<tr>
<td>Active</td>
<td>Indicator of whether the task is still being worked on (active) or is complete.</td>
</tr>
<tr>
<td>Canceled reason</td>
<td>Reason the task was canceled:</td>
</tr>
<tr>
<td></td>
<td>• Disqualified from service channel</td>
</tr>
<tr>
<td></td>
<td>• Manually assigned</td>
</tr>
<tr>
<td></td>
<td>• Time out</td>
</tr>
<tr>
<td></td>
<td>• Transfer was canceled or rejected</td>
</tr>
<tr>
<td>Is Dismissed</td>
<td>Indicator of whether the task was dismissed.</td>
</tr>
<tr>
<td>Rejected</td>
<td>Task that was rejected by the agent.</td>
</tr>
<tr>
<td>Timed Out</td>
<td>Task that has exceeded the timeout specified in the assignment rule.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group assigned to the task.</td>
</tr>
<tr>
<td>Document table</td>
<td>Document table assigned to the task.</td>
</tr>
<tr>
<td>Previous Work Item</td>
<td>Reference to a previous work item for the same Document ID.</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State changed on</td>
<td>Date that the task state was most recently changed.</td>
</tr>
<tr>
<td>Allocated by</td>
<td>User who assigned the work item.</td>
</tr>
<tr>
<td>Display Name</td>
<td>Task name.</td>
</tr>
<tr>
<td>Offered on</td>
<td>Date the task was first offered to an agent.</td>
</tr>
<tr>
<td>Work Item Size</td>
<td>Amount of an agent’s capacity used when this task is assigned to the agent.</td>
</tr>
<tr>
<td>Wait time</td>
<td>Length of time the task waited in the queue before being assigned.</td>
</tr>
<tr>
<td>Assignment rule</td>
<td>Rule that assigns cases that meet the matching rule criteria to a customer service agent.</td>
</tr>
<tr>
<td>Offer Count</td>
<td>Number of times the work item was offered to agents.</td>
</tr>
</tbody>
</table>

**4.** Scroll to the bottom of the Work Item form to view the list of the AWA Events.

**5.** Select the preview button for the AWA event you want to view.

**6.** On the AWA Event modal, select **Open Record**. The AWA Event form appears.

### AWA Event form

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caused By</td>
<td>User who triggered the AWA event.</td>
</tr>
<tr>
<td>Record ID</td>
<td>Interaction record ID.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of AWA event:</td>
</tr>
<tr>
<td></td>
<td>• Assignment</td>
</tr>
<tr>
<td></td>
<td>• Manual Assignment</td>
</tr>
<tr>
<td></td>
<td>• Routing</td>
</tr>
<tr>
<td></td>
<td>• Acceptance</td>
</tr>
<tr>
<td></td>
<td>• Rejection</td>
</tr>
<tr>
<td></td>
<td>• Cancellation</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the corresponding interaction.</td>
</tr>
<tr>
<td>Channel</td>
<td>Service channel used for the AWA event.</td>
</tr>
<tr>
<td>Record table</td>
<td>Table name of document being logged.</td>
</tr>
<tr>
<td>Record Details</td>
<td>Details of the work item record.</td>
</tr>
<tr>
<td>Timestamp</td>
<td>Date and time the AWA event occurred.</td>
</tr>
<tr>
<td>Event Details</td>
<td>Details about the AWA event:</td>
</tr>
<tr>
<td></td>
<td>• Routing event - details of the queue that was selected.</td>
</tr>
<tr>
<td></td>
<td>• Assignment event - details about which agent was selected and which</td>
</tr>
<tr>
<td></td>
<td>eligibility pools were considered. These details include a listing of all</td>
</tr>
<tr>
<td></td>
<td>candidate agents that were considered from each pool and a summary of</td>
</tr>
<tr>
<td></td>
<td>which agents were filtered from consideration.</td>
</tr>
<tr>
<td></td>
<td>• Rejection events - details about the user who rejected the item and the</td>
</tr>
<tr>
<td></td>
<td>reason.</td>
</tr>
<tr>
<td></td>
<td>• Manual assignments - details about the manager making the assignment,</td>
</tr>
<tr>
<td></td>
<td>the previous and new agents, and the previous work item (if there is one).</td>
</tr>
<tr>
<td></td>
<td>• Cancellation events - no additional details.</td>
</tr>
<tr>
<td>Summary</td>
<td>Event summary.</td>
</tr>
</tbody>
</table>

**Advanced Work Assignment monitoring page**

Administrators can monitor Advanced Work Assignment activity by reviewing information on the Advanced Work Assignment Stats page.
The Advanced Work Assignment Stats page displays AWA performance statistics. Administrators can access the Advanced Work Assignment Stats page by entering `<instance_url>/awa_stats.do` where instance_url is the base of the ServiceNow URL.

ℹ️ **Note:** The mean, median, max, and min statistics are representative of the particular node you are viewing.

### Total Agent Summary

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Status</td>
<td>Overview of agent status for all assigned agents</td>
</tr>
</tbody>
</table>

### Channel Summaries

#### Work Items

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Queued</td>
<td>Number of work items currently queued</td>
</tr>
<tr>
<td>Number Pending Acceptance</td>
<td>Number of work items currently pending acceptance</td>
</tr>
<tr>
<td>Number of Duplicates</td>
<td>Number of duplicate work items (meaning same document id, usually from transfers)</td>
</tr>
<tr>
<td>Number Rejected</td>
<td>Number of work items rejected</td>
</tr>
<tr>
<td>Current Number Meeting Channel Condition</td>
<td>Number of work items with the channel condition met</td>
</tr>
<tr>
<td>Current Number Meeting Utilization Condition</td>
<td>Number of work items with the current utilization condition met</td>
</tr>
<tr>
<td>Current Number Meeting Channel &amp; Utilization Condition</td>
<td>Number of work items meeting both channel and utilization condition</td>
</tr>
<tr>
<td>Total Work Item Count</td>
<td>Total number of work items for the given channel</td>
</tr>
</tbody>
</table>
### Query Performance

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Query Response Time</td>
<td>Maximum amount of time for the response of querying all the active and unassigned work items of a given channel</td>
</tr>
<tr>
<td>Min Query Response Time</td>
<td>Minimum amount of time for the response of querying all the active and unassigned work items of a given channel</td>
</tr>
<tr>
<td>Mean Query Response Time</td>
<td>Mean amount of time for the response of querying all the active and unassigned work items of a given channel</td>
</tr>
<tr>
<td>Median Query Response Time</td>
<td>Median amount of time for the response of querying all the active and unassigned work items of a given channel</td>
</tr>
<tr>
<td>Total Query Count</td>
<td>Total number of times the query for inactive/unassigned work items has been made for the given channel</td>
</tr>
</tbody>
</table>

### Record Watchers

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Watcher Entries Present</td>
<td>True if the required record watchers for the channel exist (channel eligibility responder, work item responder, workload responder).</td>
</tr>
<tr>
<td>Number of Entries Triggered</td>
<td>Number of times onEntry has been called on this node for the given record watcher</td>
</tr>
<tr>
<td>Number of Exits Triggered</td>
<td>Number of times onExit has been called on this node for the given record watcher</td>
</tr>
</tbody>
</table>
### Record Watchers (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Changes Triggered</td>
<td>Number of times onChange has been called on this node for the given record watcher</td>
</tr>
</tbody>
</table>

### Queues

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Number of Queues</td>
<td>Total number of active queues for a given channel</td>
</tr>
<tr>
<td>Number of Queues in Schedule</td>
<td>Number of queues for a given channel that are currently in schedule</td>
</tr>
<tr>
<td>Number of Queues Out of Schedule</td>
<td>Number of queues for a given service channel that are currently out of schedule</td>
</tr>
<tr>
<td>Number of Inactive Queues</td>
<td>Number of queues that are not marked as active</td>
</tr>
</tbody>
</table>

### Agents

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent status overview for the given channel</td>
<td>Number of agents with this status</td>
</tr>
</tbody>
</table>

### Channel Breakdown

#### Queues

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Schedule</td>
<td>True if the queue is in schedule, false otherwise</td>
</tr>
<tr>
<td>Agents Available</td>
<td>True if the given queue has agents available, false otherwise</td>
</tr>
<tr>
<td>Number of Agents Available</td>
<td>Number of agents marked as available for the given queue</td>
</tr>
</tbody>
</table>
Activate Conversational Messaging

You can activate the Conversational Messaging plugin (com.glide.messaging.awa) if you have the admin role.

**Before you begin**
Role required: admin

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

- **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

### Configure messaging actions

Create or modify messaging actions that are performed when an event occurs. These actions apply only to messaging.

**Before you begin**

Activate the Conversational Messaging plugin (com.glide.messaging.awa). For information on activating this plugin, see [Activate Messaging Actions](#).

Role required: admin

**About this task**

- For the Requester Message without Agent Response event, the default length of time that elapses before an agent is sent a reminder is 30 minutes.

- For the Agent Message without Requester Response event, the default length of time that elapses before the conversation is set to the Closed Abandoned state is 2 days.

If you’re using both Virtual Agent and Live Agent, the system closes an abandoned live conversation based on the lowest timeout value for closing conversations. Be aware that other conversation timeout behavior can affect idle live chat timeouts, regardless of the **Duration** and **Action** that you specify. For details, see [Duration and Action](#).

**Procedure**

1. Navigate to **Conversational Interfaces > Messaging > Actions**.
   - To create a new messaging action, click **New**.
   - To update an existing messaging action, click the messaging action.

2. On the form, fill in the fields.

**Messaging Action form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the messaging action.</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Event</td>
<td>Event that starts the timer:</td>
</tr>
<tr>
<td></td>
<td>• Requester Message without Agent Response - message from a requester that has not been responded to by an agent.</td>
</tr>
<tr>
<td></td>
<td>• Agent Message without Requester Response - message from an agent that has not been responded to by a requester.</td>
</tr>
<tr>
<td>Duration</td>
<td>Length of time that elapses after the event before the action runs.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to track the timers and perform actions.</td>
</tr>
<tr>
<td>Filter Conditions</td>
<td>Condition the timer is evaluated for.</td>
</tr>
<tr>
<td>Action</td>
<td>Action to perform after the duration of time has elapsed:</td>
</tr>
<tr>
<td></td>
<td>• Prompt Agent - prompt the agent using a Workspace notification.</td>
</tr>
<tr>
<td></td>
<td>• Prompt Requester - display system message with prompt to requester.</td>
</tr>
<tr>
<td></td>
<td>• Reassign - clear the <strong>Assigned to</strong> field of the interaction so that it can be rerouted to another agent.</td>
</tr>
<tr>
<td></td>
<td>• Set State - set the interaction to the given state.</td>
</tr>
<tr>
<td>Prompt</td>
<td>Message displayed to requester. This field appears when you select <strong>Prompt Agent</strong> in the <strong>Action</strong> field.</td>
</tr>
<tr>
<td>State</td>
<td>State of the interaction. This field appears when you select <strong>State</strong> in the <strong>Action</strong> field.</td>
</tr>
</tbody>
</table>

3. Click **Submit** for a new messaging action or **Update** to modify an existing messaging action.
Enable logging for Advanced Work Assignment

Enable logging to monitor AWA routing and assignment.

Before you begin
Role required: awa_admin or admin

Procedure
1. In the navigation filter, enter sys_properties.list.

2. In the System Property [sys_properties] table, click New and add the com.snc.awa.syslog.enabled property:
   - Name: com.snc.awa.syslog.enabled
   - Description: Log AWA work item routing and assignments in the system log.
   - Type: true | false

3. Set the Value to true.

4. Click Submit.
   Logging for the AWA assignment engine is enabled in the syslog table.

5. To view the system log, navigate to System Logs > System Log > All and perform a search where the Source is AdvancedWorkAssignment.

Analytics and Reporting Solutions for Advanced Work Assignment

Analytics and Reporting Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Enabling Performance Analytics Solutions

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With solutions, you can get value from Performance Analytics for your application with minimal setup.

⚠️ Note: Solutions include some dashboards that are inactive by default. You can activate these dashboards to make them visible to end users according to your business needs.

To enable a solution for Advanced Work Assignment, an admin navigates to System Definitions > Plugins and activates the Performance Analytics - Content Pack - Advanced Work Assignment plugin.
Related information

 Analytics and Reporting Solutions
 Activate your Performance Analytics subscription

Advanced Work Assignment dashboard for interactions

Enable managers to monitor Interaction [interaction] work items so that their agents can better support customer needs.

This dashboard is available in the Advanced Work Assignment content pack. For information on activating the content pack, see Analytics and Reporting Solutions for Advanced Work Assignment.

End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>AWA administrator: Configures Advanced Work Assignment to best fit the business needs of customer service.</td>
<td>awa_admin</td>
</tr>
<tr>
<td>AWA manager: Identifies the areas of concern for routing and assignment of work items across service channels.</td>
<td>awa_manager</td>
</tr>
<tr>
<td>Agent manager: Manages agents or agent groups. The agent manager needs to know what agents are</td>
<td>sn_customerservice_manager</td>
</tr>
</tbody>
</table>
Use case

This dashboard provides support managers with an overview of incoming work items and the availability of agents to handle them. Managers can monitor these daily trends to determine if adjustments should be made to the routing criteria, agent capacity values, and other settings that determine how work is pushed to agents.

Indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Work Items</td>
<td>Total number of Interaction work items that were created today. The goal for this indicator is to minimize the number of Interaction work items that agents receive.</td>
</tr>
<tr>
<td>Accepted Work Items</td>
<td>Percentage of all Interaction work items that agents have accepted.</td>
</tr>
<tr>
<td>Exceeding Target Work Items</td>
<td>Percentage of all Interaction work items that have exceeded the target wait time.</td>
</tr>
<tr>
<td>Rejected Work Items</td>
<td>Percentage of all Interaction work items that agents have rejected.</td>
</tr>
<tr>
<td>Timed Out Work Items</td>
<td>Percentage of all Interaction work items that timed out.</td>
</tr>
<tr>
<td>Weekly Trends</td>
<td>Number of work items in each of the following states for the past week:</td>
</tr>
<tr>
<td></td>
<td>• New</td>
</tr>
<tr>
<td></td>
<td>• Exceeding Target</td>
</tr>
<tr>
<td></td>
<td>• Abandoned</td>
</tr>
</tbody>
</table>
## Breakdowns
To analyze data according to different categories, select a breakdown from the dashboard menu:

- Service Channel
- Queue
- Assignment Group

For more information on analyzing data with breakdowns, see [Using breakdowns on dashboards](#).

## Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accepted Work Items - Last Hour</td>
<td>Single</td>
<td>Number of Interaction work items that agents have accepted in the past hour.</td>
</tr>
<tr>
<td></td>
<td>Score</td>
<td>Number of Interaction work items that agents have accepted in the past hour.</td>
</tr>
<tr>
<td>Abandoned Work Items - Last Hour</td>
<td>Single</td>
<td>Number of Interaction work items that agents have abandoned in the past hour.</td>
</tr>
<tr>
<td></td>
<td>Score</td>
<td>Number of Interaction work items that agents have abandoned in the past hour.</td>
</tr>
<tr>
<td>Average Wait Time - Last Hour</td>
<td>Single</td>
<td>Average amount of time that customers have spent waiting for an agent response in the past hour.</td>
</tr>
</tbody>
</table>
Advanced Work Assignment dashboard for operations

Enable managers to monitor Operation [operation] work items so that their agents can better support customer needs.

This dashboard is available in the Advanced Work Assignment content pack. For information on activating the content pack, see Analytics and Reporting Solutions for Advanced Work Assignment.

Advanced Work Assignment dashboard for Operations

![Dashboard Image]

End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>AWA administrator: Configures Advanced Work Assignment to best fit the business needs of customer service.</td>
<td>awa_admin</td>
</tr>
<tr>
<td>AWA manager: Identifies the areas of concern for routing and assignment of work items across service channels.</td>
<td>awa_manager</td>
</tr>
<tr>
<td>Agent manager: Manages agents or agent groups. The agent manager wants to know what agents are working on to make sure that customer needs are being met.</td>
<td>sn_customerservice_manager</td>
</tr>
<tr>
<td>Performance Analytics administrator: Ensures that business managers are</td>
<td>pa_admin or pa_viewer</td>
</tr>
<tr>
<td>End user and goal</td>
<td>Required role</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>making the best use of Performance Analytics solutions.</td>
<td></td>
</tr>
</tbody>
</table>

### Use case

This dashboard provides support managers with an overview of incoming work items and the availability of agents to handle them. Managers can monitor these daily trends to determine if adjustments should be made to the routing criteria, agent capacity values, and other settings that determine how work is pushed to agents.

### Indicators

Indicators define a performance measurement taken at regular intervals of a business service, an activity, or organizational behavior.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Work Items</td>
<td>Total number of interaction work items that were created today. The goal for this indicator is to minimize the number of interaction work items that agents receive.</td>
</tr>
<tr>
<td>Accepted Work Items</td>
<td>Percentage of interaction work items that agents have accepted.</td>
</tr>
<tr>
<td>Exceeding Target Work Items</td>
<td>Percentage of interaction work items that have exceeded the target wait time.</td>
</tr>
<tr>
<td>Rejected Work Items</td>
<td>Percentage of interaction work items that agents have rejected.</td>
</tr>
<tr>
<td>Timed Out Work Items</td>
<td>Percentage of interaction work items that timed out.</td>
</tr>
</tbody>
</table>
| Weekly Trends                      | Number of work items in each of the following states for the past week:  
  • New  
  • Exceeding Target  
  • Abandoned |
### Breakdowns

Breakdowns divide information into different categories. To analyze data according to different categories, select a breakdown from the dashboard menu:

- Service Channel
- Queue
- Assignment Group

For more information on analyzing data with breakdowns, see Using breakdowns on dashboards.

### Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accepted Work Items - Last Hour</td>
<td>Single</td>
<td>Number of Interaction work items that agents have accepted in the past hour.</td>
</tr>
<tr>
<td>Abandoned Work Items - Last Hour</td>
<td>Single</td>
<td>Number of Interaction work items that agents have abandoned in the past hour.</td>
</tr>
<tr>
<td>Average Wait Time - Last Hour</td>
<td>Single</td>
<td>Average amount of time that customers have spent waiting for an agent response in the past hour.</td>
</tr>
</tbody>
</table>
Advanced Work Assignment dashboard for tasks

Enable managers to monitor Task [task] work items so that their agents can better support customer needs.

This dashboard is available in the Advanced Work Assignment content pack. For information on activating the content pack, see Analytics and Reporting Solutions for Advanced Work Assignment.

Advanced Work Assignment dashboard for Tasks

End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>AWA administrator: Configures Advanced Work Assignment to best fit the business needs of customer service.</td>
<td>awa_admin</td>
</tr>
<tr>
<td>AWA manager: Identifies the areas of concern for routing and assignment of work items across service channels.</td>
<td>awa_manager</td>
</tr>
<tr>
<td>Agent manager: Manages agents or agent groups. The agent manager needs to know what agents are working on in order to make sure customer needs are being met.</td>
<td>sn_customerservice_manager</td>
</tr>
<tr>
<td>Performance Analytics administrator: Ensures that business managers are making the best use of Performance Analytics solutions.</td>
<td>pa_admin or pa_viewer</td>
</tr>
</tbody>
</table>
Use case

This dashboard provides support managers with an overview of incoming work items and the availability of agents to handle them. Managers can monitor these daily trends to determine if adjustments should be made to the routing criteria, agent capacity values, and other settings that determine how work is pushed to agents.

Indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Work Items</td>
<td>Total number of Task work items that were created today. The goal for this indicator is to minimize the amount of Task work items that agents receive.</td>
</tr>
<tr>
<td>Accepted Work Items</td>
<td>Percentage of all Task work items that agents have accepted.</td>
</tr>
<tr>
<td>Exceeding Target Work Items</td>
<td>Percentage of all Task work items that have exceeded the target wait time.</td>
</tr>
<tr>
<td>Rejected Work Items</td>
<td>Percentage of all Task work items that agents have rejected.</td>
</tr>
<tr>
<td>Timed Out Work Items</td>
<td>Percentage of all Task work items that timed out.</td>
</tr>
<tr>
<td>Weekly Trends</td>
<td>Number of work items in each of the following states for the past week:</td>
</tr>
<tr>
<td></td>
<td>• New</td>
</tr>
<tr>
<td></td>
<td>• Exceeding Target</td>
</tr>
<tr>
<td></td>
<td>• Rejected</td>
</tr>
<tr>
<td></td>
<td>• Timed Out</td>
</tr>
</tbody>
</table>

Breakdowns

To analyze data according to different categories, select a breakdown from the dashboard menu:

• Service Channel
• Queue
• Assignment Group
For more information on analyzing data with breakdowns, see Using breakdowns on dashboards.

**Reports**

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Wait Time - Last Hour</td>
<td>Single</td>
<td>Average amount of time that customers have spent waiting for an agent response in the past hour.</td>
</tr>
<tr>
<td>Score</td>
<td></td>
<td>42</td>
</tr>
</tbody>
</table>

**Workspace**

A workspace is a suite of tools that provides agents, case managers, help desk professionals, and managers with tools to help answer customer questions and resolve customer problems. ServiceNow provides many workspaces, each is targeted at a specific user. For example, workspaces are designed for tier 1 agents who solve internal or external customer issues.

Workspaces include all the tools that agents need to find, research, and resolve issues. ServiceNow provides different workspaces for different issue types. For example, agents using IT Service Management Workspace (ITSM) track and resolve IT issues. Agents using Customer Service Management Workspace (CSM) resolve customer cases, such as sending a piece of computer hardware to fulfill a customer's request.

**Workspace in action**

Here's how agents use Workspace.

Workspace overview.
Get started

Explore Workspace
Learn about Workspace concepts and features.

Admins using Workspace
Configure environments, tools, and user access.

Agents using Workspace
Build applications using Workspace.

Troubleshoot and get help
• Ask or answer questions in the Workspace community forum
• Search the Known Error Portal for known error articles
• Contact Customer Service and Support

Exploring Workspace
Get an overview of workspace so you can understand how to set it up and use it for your organization.

Workspace landscape
Workspace is a single-pane view that tier 1 agents use to respond to all task types, view the full context of an issue, and get relevant recommendations to resolve issues.
With Workspace, agents can have multiple issues open at the same time in a tabbed format. Agents can quickly move between each issue without going to a different screen. They can use the ribbon to get useful, high-level information about an issue and use the activity stream to communicate with requesters or view a history of agent and requester interactions. The sidebar on the right automatically provides recommendations that help agents resolve issues.

Agents use the following views in workspace:

- **Landing page**—The first page that an agent sees when opening Workspace shows which issues the agent can work on. For example, the agent can look at the landing page to see the number of open issues and the work that is assigned to the agent.

- **List view**—A filtered list of all records in the database that agents use to see, for example, all cases, only open cases, and only their cases. Agents use this view to find issues to work on.

- **Record view**—The view that agents use to work on issues. This view includes in-depth record information and suggestions about how to resolve issues and communicate with requesters.

- **Agent Chat**—Enables agents to chat with requesters. Automatically route incoming chat requests to appropriate agents.

### Key features

**Single-pane view**

Agents can see all details that are related to an issue in one place.

**Integrated communication channels**
Agents can communicate in real time with customers by Agent Chat or phone in the same interface.

**Integrated email client**

Agents can read and respond to emails side by side.
Agent assistance

Agents can close cases and incidents faster with artificial-intelligence-assisted recommendations.

Playbook

Agents can accomplish business process workflows in a simple, task-oriented view.
Workspace types

All Workspace enable agents to find issues, solve them, and communicate the solutions to requesters. Each workspace is tailored to the kind of issue that the agents work on. ServiceNow supports the following workspaces:

- **Agent Workspace for Configuration Management Database (CMDB)**—Agent Workspace for CMDB provides an easy-to-navigate interface that helps service agents access essential CMDB configuration items and drill down to related items such as changes, incidents, and timeline.

- **Agent Workspace for HR Service Delivery (HR)**—HR agents interact with employees, respond to inquiries, and resolve issues.

- **Agent Workspace for Request Management**—Agent Workspace for Request Management integrates the platform functionality specific to tier 1 agents into an easy-to-navigate interface.

- **Customer Service Management Agent Workspace (CSM)**—Agents support external customers through communication channels such as chat, telephone, and email. (CSM)—Agents support external customers through communication channels such as chat, telephone, and email.

- **Dispatcher Workspace**—Dispatcher Workspace is a configurable service desk application that provides an integrated and intuitive user experience enabling dispatchers to be more efficient.

- **Field Service in CSM Agent Workspace (FS)**—Agents help resolve tasks that need to be performed locally.

- **IT Service Management Agent Workspace (ITSM)**—Agents assign, resolve, and escalate internal incidents.
• **Operator Workspace service monitor**—The Operator Workspace monitors services in your Event Management environment.

• **Project Workspace**—Project Workspace enables project managers to define, plan, track, and monitor a project in a single location.

• **Service Owner Workspace**—Service Owner Workspace provides a premium Service Portfolio Management experience. If you’re a portfolio manager or service owner, you can manage and monitor portfolios and services in one integrated and graphically intuitive user interface.

• **Survey Designer**—Survey administrators use Survey Designer to create pre-chat surveys for gathering information used to route requesters to qualified agents.

• **Vendor Manager Agent Workspace (VM)**—Agents manage and monitor vendor performance and vendor-related information.

• **Workforce Optimization for Customer Service**—Manage and maintain the productivity of your workforce from a single application using Workforce Optimization for Customer Service.

• **Workforce Optimization for ITSM**—Manage and maintain the productivity of your workforce from a single location using Workforce Optimization for ITSM.

**Accessibility**

Accessibility enables agents to use shortcuts to navigate Workspace lists.

<table>
<thead>
<tr>
<th>Keyboard shortcuts for lists</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>← or →</td>
<td>Navigate between cells.</td>
</tr>
<tr>
<td>↑ or ↓</td>
<td>Navigate between rows.</td>
</tr>
<tr>
<td>Page Up or Down</td>
<td>Go to the first or last rows.</td>
</tr>
<tr>
<td>Home or End</td>
<td>Go to the first or last cell in a row.</td>
</tr>
<tr>
<td>Enter or Space bar</td>
<td>Change the focus to an individual cell. Use the Tab key to navigate within the cell.</td>
</tr>
<tr>
<td>Escape</td>
<td>Change the focus from a cell back to the list.</td>
</tr>
</tbody>
</table>

**Browser support for workspaces**

Do not use Internet Explorer 11 to access any workspaces. Internet Explorer 11 is not supported. See [KB0683275](#) for more information on Internet Explorer 11.
and see **Generally supported browsers** for more information about supported browsers that you can use across the platform.

**Next steps**

Do this next if you are a:

- System administrator—Start setting up your workspace
- Agent—Start using your workspace

**Domain Separation in Workspace**

This overview describes domain separation in the Workspace. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Support level: Standard**

- Includes **Basic** level support.
- Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see **Application support for domain separation**.

**Overview**

The Workspace tabbed navigation is fundamentally different from the typical UI framework: In the Platform, an agent looks at one record at a time (though multiple records may be open in separate browser tabs). Workspace’s tabbed navigation supports multi-tasking across incidents or cases in the same browser session.

In the Paris release, agents can multi-task across domains in a single Workspace browser tab.

**How domain separation works in Workspace**

With Workspace, rather than having fulfillers directly interact with the data model (by selecting domains via the Platform domain picker), the core
functionality is seamless to the agent. There is no domain picker in the Workspace global header.

When interacting with existing records:

- Records open in the domain of the record, not the user’s domain session.
  - Form layout: Fields and values (Choice, References, and the like) display based on the domain of the record.
  - Form header: Primary and secondary fields display based on the domain of the record and can be tailored per customer.
  - Related lists layouts use the record domain of the parent.
  - UI actions respect the record's domain and show only what is applicable (such as "Condition evaluates true").
  - Ribbon: Load ribbon components are based on the domain of the record. Any UI actions trigger the record session or carry it over to child records.
  - Knowledge and Catalog display based on the user criteria and domain that the user session has access to. However, any records that display should be filtered based on the record domain.

- You can use an optional Forms enhancement to provide contextual awareness of the company or domain of an existing record using the company/account logo in the Form Header. To learn more see Set up form headers in workspace

When you create new records from a record (cross-tenant intelligence):

- Records created from another record inherit the domain of the originating record.
  - Records created via UI action on a record carry over the domain of the originating record domain.
  - Records created from a parent record (for example, from a related list), carry over the domain of the parent record domain.
  - The new record loads (process/data) in the domain assigned to the originating record. (For example: **Incident > Change > Incident**

- New Interactions are created in the domain "Opened for" (not the domain of the user).

- New records can be created in the domain of the "caller" or "contact (for example, "Opened for") based on an admin configurable interstitial form that allows the safe creation of new records in the correct domain.
User or company record is typically used to determine domain (for example, selecting the user populates the company field and sets the domain). The single owner of the instance determines what sets the domain for that instance on each table.

Those with access to more than one domain can use a configurable lightweight form to populate the fields to set the domain. The user selects companies or accounts, or users from the domains the fulfiller has access to.

The Next button becomes active once the required fields are populated.

Unlike with the platform domain picker, agents can set the domain of the new record without changing their domain session.

Note: The domain determining field doesn’t need to be pre-populated or even configured. It functions much like the platform does. The form waits for the record to be saved before showing the domain-specific process configuration.

New features in the Paris release
Change the domain of an existing record

• An administrator can configure a specific field that controls the domain for a record, such as "company." The same functionality can be achieved with the following system properties.
  ◦ glide.sys.domain.domain_determining_field.default
  ◦ glide.sys.domain.domain_determining_field.[table_name]
  ◦ glide.sys.domain.use_domain_determining_field

• When the specified field is changed, the record’s sys_domain value is set to the domain of the new reference; the domain of the record is changed.

• When you submit the change, a message displays that the domain will be changed and warns of potential data loss.

• When the record is saved, the sys_domain value changes and all the references to the record are removed according to the business rule "Domain-Cascade Domain-Task."

Toggle Domain Scope (Platform Feature Parity)

• Users with the domain_expand_scope role can select the domain scope from the Toggle Domain Scope UI action on the form.

• When record scope is in effect (default), you can click the UI action to expand to session scope and see any data accessible to the user’s domain and child domains.
• When session scope is in effect, you can click the UI action to collapse the record scope and see only data for the current record’s domain.

• Clicking **Toggle Domain Scope** expands the domain scope on a record for related list actions and reference field queries.

To learn more, see **Domain scope**.

Ability for agents to pick one company to see their data (via “My Lists”)

• You can create a “my list” for a curated list, or filter an existing list by company. The platform domain picker acts similarly by filtering data based on domain. When you create a new case or incident without a parent, begin typing in the field used to designate domain to quickly populate the domain.

To learn more, see **Lists**.

**Related information**

**Domain separation for service providers**

**Domain separation and Workspace landing pages**

Landing pages are still an option when you are using domain separation in Workspace. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Workspace landing pages**

Landing pages are the pages that agents see when they open their workspace. The pages typically include:

• Now Intelligence visualizations and widgets; for example, the number of open issues

• Lists of records; for example, all records that are assigned to the agent

Use these guidelines to set up Workspace landing pages when you are using domain separation.

**Creating a page**

Admins can create landing pages that are domain-separated and override (sys_override) certain settings (such as Active) per domain.

**Note:** “Macroponents” are not domain-separated; any changes you make affect all landing pages that use the value stored in this reference field.
Editing an existing page in a subdomain

- Users in a subdomain can edit the global pages.
- If a user creates an override in a subdomain (for example, to change the name or element within components), the changes are saved at the global page.
- Adding a page in a subdomain changes the global page. It does not change the domain of the page but edits the definition of the page itself.
- To make a change in a subdomain, users must create a copy in the domain they want to edit, and then edit that new page.

To learn more, see Workspace landing pages.

Workspace domain separation plugins and tables

When using domain separation in Workspace, you need the domain separation plugins and table properties. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Plugins

Workspace domain separation uses the Platform Domain Separation plugin. When you activate the Domain Separation plugin, the following features are enabled for Workspace:

- You create process separation by record domain. This includes:
  - Form layout
  - UI actions
  - Form header
  - Related lists
  - Policy
  - Client scripts
  - Business rules
  - Reference values
- Change domain and Toggle domain scope
- Cross-tenant intelligence
Note: When you create new records from Related lists, use the parent record domain.

• Record domain context applies to all form components automatically.
  ◦ Internally, the record domain context is added to all enclosed GraphQL queries.

Plugin configuration
These features need additional configuration:

• When configuring a pre-form to select a domain before you create a new record with no parent (domain unknown):
  ◦ If the domain is not passed in and the user has access to multiple domains, the user can be promoted to input the domain determining the field before creating a record.
  ◦ Extra fields can be specified for the agent’s convenience (such as Short description or Notes). However, the pre-form:
    ▪ Shows only the default domain determining field or the fields specified for a specific table.
    ▪ Does not support dependent fields.
    ▪ Does not support dynamic reference qualifiers.
    ▪ Does not support UI policies or client scripts.
    ▪ Does not support dictionary overrides.
  ◦ This interstitial form acts similarly to the platform wizard or interceptor.
  ◦ The new record is initialized with values from the previous form with processes based on the selected domain:
    ▪ Business rules
    ▪ Form layout
    ▪ UI actions
    ▪ Related lists
    ▪ UI policies
    ▪ Client scripts
  ◦ Reference fields only show domain allowed values.
Tables

• The domain determining field (default and by table) is configured via system properties:
  ◦ glide.sys.domain.use_domain_determining_field
  ◦ glide.sys.domain.domain_determining_field.default
  ◦ glide.sys.domain.domain_determining_field.[table_name]

Related information

Domain separation for service providers

Components installed with Workspace

The complete installation of Workspace includes not only the plugin, com.agent_workspace, but also tables and user roles.

Plugins installed

By default, Workspace (com.agent_workspace) is active for all instances. For a list of all the additional plugins installed, search for “workspace” in the list of plugins.

Tables installed

The following table shows many of the tables that get installed with Workspace.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workspace Global Search Configuration [sys_aw_global_search_config]</td>
<td>Provides the default search settings for global search in Workspace</td>
</tr>
</tbody>
</table>
### Table

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workspace Form Header [sys_aw_form_header]</td>
<td>Defines the fields that appear in the header for a form</td>
</tr>
<tr>
<td>My Workspace List [sys_aw_my_list]</td>
<td>Enables agents to create their own filtered list in Workspace</td>
</tr>
<tr>
<td>Workspace List [sys_aw_list]</td>
<td>Creates filtered lists for users in Workspace from this table</td>
</tr>
<tr>
<td>Workspace List Category [sys_aw_list_category]</td>
<td>Creates categories to organize filtered lists for Workspace</td>
</tr>
<tr>
<td>Workspace Settings [sys_aw_master_config]</td>
<td>Accesses global search settings and assigns a service catalog for Workspace</td>
</tr>
<tr>
<td>Workspace New Menu Item [sys_aw_new_menu_item]</td>
<td>Determines the records that agents can create from the New Record menu in Workspace</td>
</tr>
<tr>
<td>Ribbon Settings [sys_aw_ribbon_setting]</td>
<td>Determines the ribbon components that appear in a ribbon</td>
</tr>
</tbody>
</table>

See [setting up workspace](#) for additional Workspace configuration options.

### Workspace Agent Chat

Workspace enables agents to interact directly with requesters using chat. The chat system starts with virtual chat, which is autonomous chat powered by artificial intelligence. A requester can request to chat with a live agent through virtual chat. That chat is called Agent Chat. Configure Workspace Agent Chat to enable customers to ask questions and receive information by chatting with a live agent. Through Agent Chat, agents communicate with customers, create incident or case records, or transfer chats to another agent or queue.

Agent Chat uses a persistent widget for chat conversations on any portal page of the portal that you’re using. You can establish assignment rules to enable chat conversations to reach the best agent available who has the capacity and skills to handle the job. The agent can transfer the chat to another agent if necessary. Agents can use response templates to enable reusable, consistent messages to requesters.
Virtual chat conducts a survey before and after the Agent Chat. The pre-survey gets preliminary information about the requester to aid in the chat session. The post-chat survey gets feedback on the requester's satisfaction with the agent who helped.

Workspace displays a chat inbox icon that agents use to enter chats. Agents set their status to Available or Away to open or close their inbox for chat requests. The icon displays numbers when chats are waiting to be answered.

The chat interface is integrated into workspace so agents can chat while working onscreen with all of other features provided by workspace.

**Routing chats**

Requesters start chats with virtual chat. When they request to chat with a live agent on Agent Chat, their request goes into a queue controlled by Advanced Work Assignment (AWA), which routes chats to different agents based on availability, queue length, and expertise.
Agent Whisper overview

Agent Whisper lets agents and chat managers have a conversation without the requester knowing.

During a chat between a requester and an agent, the agent may want to privately ask a chat manager for assistance or a chat manager and an agent may want to converse without the requester knowing. Using Agent Whisper, the agent can request help and the chat manager and agent can send messages to each other without the requester knowing.

For example, if an agent is newly hired, still in training, or unsure about how to proceed with a requester's request, the agent can request for a chat manager to join the conversation to help walk the agent through the steps of the procedure privately.

Another scenario is if an agent needs to escalate a customer conversation to a chat manager. Agents can request help and chat managers can join the chat conversations publicly to communicate directly with the customer to help deescalate the situation.

For instructions on how to set up Agent Whisper, see Setting up Agent Whisper.

Using the Help quick action

Agents can ask chat managers to join chat conversations with requesters by raising the help flag. Agents can open the Quick Action menu or enter /help to request for help. When using the help quick action, agents can also type a brief private message explaining what they need help with. This way, when a chat manager enters the conversation, they already know what the agent needs.

Chat managers can view the conversations with help requested from different views: interactions list view, manager dashboard, and lists.

• Interactions list view: Agents can navigate to the interactions list view and add in the help requested column to see which conversations agents have requested help in. From here, managers can click directly into the interaction record and join the conversation with the agent and requester.

• Manager dashboard: With the Workforce Optimization for Customer Service (com.snc.wfo.csm) plugin installed, managers can see that
the Help requested tile on the manager dashboard homepage.

- Lists: From Conversation Monitoring > Help Requested, managers can view a list of chat interactions in which agents have requested help.
To learn more about Workforce Optimization for CSM, see Workforce optimization for customer service.

Sending and receiving messages in Private Chat

The agent and chat manager can converse without the requester knowing that they are having a conversation. Messages that only seen by the agent and chat manager are private messages. The requester does not see private messages. The agent and chat manager can toggle between the public and private messages using the Public Chat and Private Chat tabs. The Private Chat tab has a yellow background with "Message only visible internally" and private messages appear on the yellow background. When someone types in the Private Chat tab, the typing event indicator does not display. For example, when the chat manager types in the Private Chat tab, the agent's and requester's screen do not display the typing event indicator.

The tab that the agent types on and sends the message from determines whether a message is posted privately or publicly. If an agent starts typing a message on the Public Chat tab and then switches to the Private Chat tab, the Private Chat tab does not display the message. If the agent then goes back to the Public Chat tab, the message is still there. However, agents can see private messages regardless of whether they are on the Private Chat tab or the Public Chat tab.
Public versus Private chat

<table>
<thead>
<tr>
<th>Example of Public Chat</th>
<th>Example of Private Chat</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Chat</td>
<td>Active Chat</td>
</tr>
<tr>
<td>Hi, I'm your Virtual Agent. Let me know how I can help you today.</td>
<td>Hi, I'm your Virtual agent. Let me know how I can help you today.</td>
</tr>
<tr>
<td>What's your issue or request? Or take a look at what I can help with.</td>
<td>What's your issue or request? Or take a look at what I can help with.</td>
</tr>
<tr>
<td>Show Me Everything</td>
<td>Show Me Everything</td>
</tr>
<tr>
<td>Live Agent Support</td>
<td>Live Agent Support</td>
</tr>
<tr>
<td>Please stand by while I connect you to a live agent.</td>
<td>Please stand by while I connect you to a live agent.</td>
</tr>
<tr>
<td>just now</td>
<td>just now</td>
</tr>
<tr>
<td>Thank you for connecting support. I am looking into your question now and will be with you shortly.</td>
<td>Thank you for connecting support. I am looking into your question now and will be with you shortly.</td>
</tr>
<tr>
<td>Agent has entered the chat.</td>
<td>Agent has entered the chat.</td>
</tr>
</tbody>
</table>

Example of public and private messages

- **Public message**: give me a min
- **Private message**: Is requestors service up and running?
Joining a chat conversation in Private Chat

The first time a chat manager switches from a private conversation (on the Private Chat tab) to a public conversation (on the Public Chat tab), a dialog box displays. The dialog box informs the chat manager that they are about to join the public conversation and the requester will be notified that the chat manager is joining the conversation. The chat manager can select **Yes, I'm sure** to join the public conversation or select **Cancel** to remain in the private conversation.
Sharing attachments in Private Chat

If agents send an attachment while on the Private Chat tab, the attachment is sent only to the agent and chat manager. Message Sent confirmation messages do not display for private message conversations.

Private messages stored in internal chat transcripts

Once the conversation ends, one external transcript and one internal chat transcript are generated.

The public chat transcript does not include private messages and is accessible for the requester to download if the Download Transcript capability has been enabled.

The private chat transcript is shown on the interaction record by default and does include private messages exchanged between agents and managers. Private messages are prefixed with the word [PRIVATE] to clearly indicate when a message came through the Private Chat.

To learn more about downloading the chat transcript, see Download chat transcript.

Custom report

Admins can build a custom report to track the number of help requests. See Build a report to track the number of help requests for instructions.
Chat surveys in Agent Chat

Display conversational questionnaires to your end users to gather important information from them, before and after they chat with a live or virtual agent. For example, you can run pre-chat surveys to collect preliminary information about your requesters and use that information to route chats to appropriate live agents. Use post-chat surveys to get user feedback on their experience with your support agents.

How chat surveys work

Instead of using forms to collect information from your requesters, you can create different questionnaires that run in the chat client to capture preliminary user information or post-chat feedback. The questions in this pre-chat survey example ask users to identify their service issue and to provide additional details.

Example pre-chat survey conversation

Survey administrators and administrators use Survey Designer to:

• Build survey content: Survey Designer provides various controls for defining survey questions. The example above shows the choice list control, which displays a list of items that your users can choose from. Each survey question has corresponding properties that you can set to manage survey behavior. For instance, you can make a survey response mandatory. If you make a survey response optional, users can skip the question in the survey. You can also configure your survey so that an introductory note starts the survey and an end note displays after users finish the survey.
• (Optional) Save certain survey responses as chat context: When defining your survey, you can map a particular survey question to a chat context variable so that survey responses are stored in the context variable. You can then use these variables to route chats to live agents in certain queues (specify the chat context variables in routing conditions) or to the virtual agent.

After creating the surveys, administrators configure the surveys to run as conversations in the chat client. The chat client renders the chat survey as a live chat conversation.

What to do next
Setting up chat surveys involves these main steps:

1. (Optional) Define chat context
   Use the Chat Setup form to set live agent controls and define the chat context variables for storing survey responses.

2. Create your chat surveys
   In Survey Designer, build your conversational questionnaires for gathering pre-chat information and post-chat feedback from your requesters. If you defined chat context variables to store certain survey responses, you can map the appropriate survey question to the corresponding chat context variable.

3. Define pre-chat survey configurations
Determine the pre-chat questionnaire to be presented to your requesters based on conditions that you apply.

4. Define post-chat survey configurations

Control the post-chat questionnaire displayed to your requesters to gather feedback on their experience with live agents.

Quick actions in Workspace Agent Chat

Set up shortcuts in Workspace Agent Chat so agents can work more efficiently with their customers.

Using quick actions

In Workspace chat, an agent can insert a quick action in any of the following ways:

- Enter a command after the forward slash (/).
- Select the lightning bolt icon (⚡) and select a quick action from the menu.
- If available, select the quick action button on the toolbar.

For example, an agent can transfer a conversation to another queue by entering /tq in the message input field.
An agent can also initiate a queue transfer by selecting the lightning bolt icon and then selecting `/tq` from the menu.
Initiate a queue transfer from the quick action menu

Alternatively, an agent can transfer to another queue by selecting the arrow button (→) on the toolbar.
Initiate a queue transfer from the toolbar

Active Chat

PLEASE STAND BY WHILE I CONNECT YOU TO A LIVE AGENT.

Thank you for contacting support. I am looking into your question now and will be with you shortly.

Note: Agents must have the quickactions_user role to use quick actions.
Display chat context details

An agent can view context relevant to a chat interaction. An agent can use a context quick action to show a card with context variables: sysparm_portal, sysparm_page, table, sys_id, and sysparm_language. The agent can initiate this quick action by typing `/context` in the message input field.

Parameters

Some quick actions require a secondary menu so that agents can further control the quick action. For example, after an agent initiates a queue transfer, the agent must select which queue to transfer to. The items that appear on the secondary menu are called parameters.

The following figure shows that, after an agent inserts a quick action to transfer to another queue, the agent sees a list of available queues. The default parameters for the quick action are queues that are available to agents.
To create a quick action that requires a secondary menu, you must define parameters for the quick action. For more information, see Define a quick action parameter for Workspace chat.

**Default quick actions**
The following quick actions are available by default with Workspace chat:

<table>
<thead>
<tr>
<th>Command name</th>
<th>Toolbar button</th>
<th>Action</th>
<th>Default parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>autopilot</td>
<td></td>
<td>Starts a Virtual Agent topic (Conversation Autopilot).</td>
<td>Available topics</td>
</tr>
<tr>
<td>help</td>
<td></td>
<td>Indicates to the chat supervisor that an agent needs help with a conversation. To use this quick action, new customers must enable Agent Chat and Agent Whisper and update customers must enable Agent Whisper on chat setup.</td>
<td></td>
</tr>
<tr>
<td>r</td>
<td></td>
<td>Uses response templates to insert as text in a conversation.</td>
<td>Available response templates</td>
</tr>
</tbody>
</table>
### Activation information

To enable your agents to use quick actions, you must activate the Agent Chat [com.glide.interaction.awa] plugin, which is required for chat in Workspace.

As of the New York release, quick actions replace Connect actions in Workspace chat. If you activated the Agent Chat [com.glide.interaction.awa] plugin prior to New York, your Connect actions are no longer available in Workspace chat. You may need to create new quick actions.

### Conversation Autopilot in Agent Chat

Agents can use Conversation Autopilot to display Virtual Agent topics during Agent Chat conversations. While the requester interacts with the Virtual Agent topics, agents can multitask and work on other items.

While talking to a requester in an Agent Chat conversation, agents can start Conversation Autopilot by using autopilot quick actions to invoke Virtual Agent topics. Depending on the information entered by the requester, agents can search for a specific Virtual Agent topic and display it with parameters. The requester views the topic and responds as needed and Virtual Agent captures the requester’s input.

> **Note:** For the best experience, enable the setting that turns on system messages during autopilot.

### Configuring Autopilot

You must have the Glide Virtual Agent plugin and the Agent Chat plugin installed to view and access the quick action for Autopilot. Admins can setup which Virtual Agent topics are available to agents in Agent Chat.

> **Note:** Admins must be able to configure a quick action based on their organization’s business need and set it up for agents to use as required.

---

<table>
<thead>
<tr>
<th>Command name</th>
<th>Toolbar button</th>
<th>Action</th>
<th>Default parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>ta</td>
<td></td>
<td>Transfers the conversation to another agent.</td>
<td>Available agents</td>
</tr>
<tr>
<td>tq</td>
<td></td>
<td>Transfers the conversation to another queue.</td>
<td>Available queues</td>
</tr>
</tbody>
</table>

**Note:** Only response templates that have a condition of [Type][is] [Chat] are available in Agent Chat.
For information on using quick actions in Agent Chat, see Quick actions in Workspace Agent Chat.

**Using Autopilot**

The agent is able to use quick actions to search for and invoke an Autopilot topic of their choice during their conversation with a requester. The agent can only select Autopilot topics that are relevant to the channel. For example, only topics optimized for SMS are selectable when conversing with a requester who is using SMS.

The agent can have a system message display informing the requester that they are interacting with a bot when autopilot is in use. The agent can hide this message completely so the requester is not explicitly informed that they are interacting with a bot. The requester assumes they are conversing with the agent even when Autopilot is in progress.

The agent is informed by system messages when an Autopilot topic has been initiated and ended. These messages can be configured by admins.
While Autopilot is on

While Autopilot is on, the requester can use the rich controls for text but agents see a read-only version of the rich controls rendered to the requester.
When Autopilot is in use, public chat with the requester is disabled, but agents can contact other agents and supervisors for help. If Agent Whisper is on, the Private Chat tab in Agent Whisper functions normally during Autopilot. While Autopilot is in use, the agent’s capacity is not freed up and messaging actions configured by customers are disabled.

**When Autopilot is ended**
The agent receives a desktop notification in the Notifications tab in Workspace stating that the Virtual Agent topic has ended or been completed by the requester. At this point, the agent resumes control of the conversation.
Download chat transcript

Once a conversation between a requester and a live agent ends, the requester can download a transcript of the conversation.

After a conversation between a requester and a live agent ends, the requester’s chat window displays a **Download** button which enables the requester to download a chat transcript. If the requester clicks the **Download** button, a .txt file is automatically downloaded from the window of the requester’s current web browser. The chat transcript contains only the written text from the conversation; attachments and images from the conversation appear as URLs. Even after the requester starts a new chat session, the **Download** button from the previous session is still available if the requester scrolls up. The chat transcript files are generated at the end of each chat session and multiple chat sessions are not combined into one file.

The requester must be configured for chat transcript downloads for the **Download** button to appear. For information about configuring the download of chat transcripts, see .

Two types of chat transcripts are generated from the conversation: internal and external.

**Internal chat transcripts**

- Available only to the agent and chat supervisor.
- Include any conversations between the requester and virtual agent.
- Include any conversations between the agent and chat supervisor that occurred through Agent Whisper.

**External chat transcripts**
Dynamic Translation for Agent Chat Overview

Dynamic Translation for Agent Chat (DTAC) translates chat conversations from one language to another. This translating enables agents and requesters to have chat conversations with each other without the need of a shared language.

For example, a requester who only speaks French starts a chat conversation with a live agent who only speaks English. From the requester’s view, the entire conversation is conducted in French, while from the agent’s view, the entire conversation is conducted in English.

DTAC enables cross-locale support teams and merger and acquisition projects to save time and money by handling larger volumes of chat conversations from other regions.

Note: DTAC is supported on Agent Workspace, not on Connect Support.

Note: DTAC is currently not supported when autopilot is in progress. When the requester responds to prompts from autopilot topics, these responses are not translated for the agent, even if DTAC is turned on for that conversation. See Autopilot in Agent Chat for more information.

How DTAC works

DTAC uses Dynamic Translation and a translation service provider to translate chat conversations in real time. Available translation service providers include:

• Google Cloud Translator Service
• IBM Translator Service
• Microsoft Azure Translator Service

Watch the 3-minute overview video to learn more about DTAC. Dynamic translation for Agent Chat overview video

Prerequisite steps

These tasks must be completed prior to activating DTAC:
Integrate with a translation service provider
Migrate to version v3 of a translator configuration
Translate a knowledge article

Activating DTAC

DTAC translates chat conversations from one language to another. The preferred languages for the agent and requester are based on their user profiles and a translation service translates the messages into the defined language of the other participant. Translation service providers support language detection for requesters who are not logged in to ServiceNow®, also referred to as guest users.

DTAC is inactive by default. Before activating DTAC, the following requirements must be completed:

• Activate Dynamic Translation and translation service provider
• Set up Workspace Agent Chat
• Activate languages for static translation


This also activates these plugins:

• Dynamic Translation (com.glide.dynamic_translation)
• Conversational Dynamic Translation (com.glide.dynamic_translation.va_async)

and these system properties:

• true - sync
• false - async
• absence of this property - async

Dynamic Translation for Agent Chat considerations and behavior

This section highlights how Dynamic Translation for Agent Chat (DTAC) works with other Agent Chat features and also lists some practical ways of working with the feature.

Language limitations

DTAC can translate in the languages supported by each translation service listed above. Even though the corresponding I18N plugins are activated, DTAC does not support the following language translations:
• Simplified and Traditional Chinese
• Brazilian Portuguese
• Canadian French

Translation support limited to one language
DTAC can only support translation from one language to another therefore additional agents or managers joining chat sessions should speak the same language as the primary agent.

• Agent chat transfers – Agents transferring a chat conversation should both speak the same language.
• Managers joining chat conversation – Managers joining chat conversation to monitor or assist agents should speak the same language as the primary agent.

Attachments within DTAC
When inserting an attachment into a chat, DTAC does not translate the file name or the contents of the attachment.

Admins using Workspace
Set up Workspace for agents, so that they can find, work on, and resolve issues efficiently.

Your job is to make the work that your agents do as effortless as possible. When configuring Workspace, you set up all the tools that agents need to complete their work and eliminate anything extraneous.

Browser requirements
ServiceNow workspaces do not support mobile devices, and, starting with the Orlando release, Internet Explorer, or Microsoft Edge. Instead, use Microsoft Edge-Chromium or one of the other supported browsers listed in Generally supported browsers Browser support. See the Internet Explorer 11 Performance [KB0683275] article in Now Support for more information.

Different ways to set up Workspace components
Workspace provides the following ways that you can access configuration settings:
• Application navigator—Navigate to configuration pages using the application navigator, for example, **Workspace Experience > Forms > Ribbon Settings**.

• Workspace—In the menu under your profile image, you see the following menu items:

  ![Configuration menu](image)

  - **Configure workspace**—Opens the Workspace configuration page where you can set up list categories, list filters, landing pages, and the record types that agents can create. You can also configure the modules that appear on the far left of the screen, such as Home (HOME) and Lists (LISTS).

  - **Configure page**—Provides shortcuts to configuration settings that are based on the page content. This option only works when you are in record view.

The instructions in this documentation use the application navigator.

**Setting up workspace**

Set up Workspace either by:

• Following the Workspace Guided Setup.

  The guided setup walks you through a sequence of tasks that helps you set up Workspace. To start with Workspace Guided Setup, navigate to **Workspace Experience > Agent Workspace Guided Setup**.
• Using the instructions in the following sections.

The following sections provide more details than the guided setup about how to set up workspace components. To start, go to Get started setting up your workspace.

Note: After completing the setup procedures in this guide, your workspace may have a few additional setup procedures that are unique to your workspace. Return to your product documentation, such as the Customer Service Management (CSM) documentation, and complete those procedures.

Get started setting up your workspace

Set up user roles, global search, and service catalogs to give agents the permissions, source documents, and catalogs they need for resolution of issues.

Before you begin

Role required: workspace_admin

About this task

These sections provide general setup instructions. Following these topics are configuration instructions for landing pages, list view, and record view.

Procedure

1. Activate the plugins for your product.

   ITSM plugins are active by default. If you’re using another workspace, such as CSM, you must activate its plugins.

   a. Navigate to System definition > Plugins.

   b. In the search bar, enter your product name.

   c. Click Install for the plugins that are related to your product.

      For more information, see Activate the plugins for your product.

      If you intend to use performance analytics and reports on landing pages you create, make sure to activate the Performance Analytics plugin.

      It’s active by default in new instances starting with Orlando but not for upgraded instances.

2. To assign roles to people in your organization, use the following table. How you assign your agents to these roles is beyond the scope of this documentation.
<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workspace agent [agent_workspace_user]</td>
<td>Required to use Workspace. The itil and sn_esm_agent for CSM roles also contain this role.</td>
<td>• None</td>
</tr>
<tr>
<td>Workspace list administrator [workspace_list_admin]</td>
<td>Required to create list categories and to create and assign filtered lists. This is an elevated role. For more information on elevated roles, see Elevated privilege.</td>
<td>• agent_workspace_user</td>
</tr>
</tbody>
</table>
| Workspace administrator [workspace_admin] | Required to configure Workspace.                                                                                       | • form_admin  
• chat_admin  
• template_editor  
• ui_action_admin  
• personalize_form  
• interaction_admin  
• workspace_list_admin                                                                 |

3. Identify a source of information that agents use when doing searches in Workspace.

   a. Navigate to **Workspace Experience > Administration > Search Sources**.

   b. Click **New** or open an existing record to edit.

   c. On the form, fill in the fields.

   **Search Source form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the search source. This name appears as a search category in the workspace search.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this component applies to. Global means that the component applies to all applications.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that your search source is associated with.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions for your search source.</td>
</tr>
</tbody>
</table>

d. Click Submit.

4. **Optional**: Configure the global search.
   Global search is the field at the top of Workspace that enables agents to search across all records.

   ![Global search](image)

   a. Open the Settings menu by clicking your profile image.

   b. Select **Configure Workspace**.

   c. In **Global Search Data Config**, click the search icon (🔍) and specify a search configuration, or, to create a new configuration, click **New** and fill in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Configuration name.</td>
</tr>
<tr>
<td>Application ID</td>
<td>Name of the application this configuration is meant for.</td>
</tr>
<tr>
<td>Search Results Limit</td>
<td>Maximum number of search results that are returned by global search.</td>
</tr>
<tr>
<td>Suggestions limit</td>
<td>Maximum number of type-ahead suggestions that appear as agents type.</td>
</tr>
</tbody>
</table>

d. In **Global Search View Config**, click the search icon (🔍) and specify a view configuration, or, to create a new configuration, click **New** and fill in the form.
Global Search Configuration Settings form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Configuration name.</td>
</tr>
<tr>
<td>Recent Items count</td>
<td>Number of recently selected search results that appear in the global search field. The default is 5.</td>
</tr>
<tr>
<td>Recent terms count</td>
<td>Number of recently searched terms that appear in the global search field. The default is 5.</td>
</tr>
<tr>
<td>Recent TTL (days)</td>
<td>Time To Live, which is the length of time in days that recently searched terms and recently selected search results remain in the search history. The default is 30.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of this global search. Typically, leave the value as <strong>Global</strong>.</td>
</tr>
<tr>
<td>Tab drill-down items per page</td>
<td>Number of search results that appear at one time when you view search results for a specific search category. The default is 25.</td>
</tr>
<tr>
<td>Tab overview items per section</td>
<td>Number of items that appear in the search results by section. The default is 10.</td>
</tr>
</tbody>
</table>

**e.** Click **Submit**.

**f.** When you return to the Workspace form, select the **Search enabled** check box to use the search parameters that you configured.

(Optional) The **Active** check box must also be selected for all of the parameters on the Workspace form to take effect.

**g.** Click **Update**.

> **Note:** If any access control lists (ACLs) are configured to prevent users from accessing information, the search results show a message about security constraints. For more information on limiting access using ACL rules, see [Access control list rules](#).

**h. Optional:** Hide global search result counts if desired.

**5. Optional:** Associate a Service Catalog with Workspace and add items to it.
A service catalog lists items that an agent can send to a requester, for example, a keyboard, desk chair, phone, and so on. Your implementation of Workspace may or may not require that agents have access to a service catalog. If you associate a service catalog with Workspace, all agents have access to it. For more information about adding a service catalog to Workspace or to add items to a catalog, see Assign a Service Catalog to Workspace. Agents typically use service catalogs in the contextual side panel to resolve requester issues.

What to do next

• Optionally, brand your workspace with your company logo and colors.
• If your agents use a service catalog to send items to requesters, assign a service catalog to your workspace.
• Set up a landing page, which is the page agents typically see when opening your workspace.

Brand your workspace

Customize the look of your workspace with your company's logo and up to two brand colors.

Before you begin

Role required: workspace_admin

About this task

You can replace the ServiceNow logo with your company's logo and use your company's colors to brand the look of your workspace.

Procedure

1. Open the workspace that you want to brand.
   • To brand a workspace that's already open, open the Settings menu by clicking your profile picture and selecting Configure workspace.
   • Navigate to Work Experience > Administration > All Workspaces and click a workspace.
2. On the Workspace form, enter hex values using the format #FFFFFF as color values for **Brand color 1** and **Brand color 2**.

**Brand color 1** specifies the color of the branding bar above the Workspace. **Brand color 2** appears in the heading of the Settings menu and in the left, side pane that contains the icons for home (🏠) and list (≡). Workspace automatically applies different intensities of the colors in different places.

![United Wealth Group](image)

**Note:** Some brand color combinations may make parts of the workspace interface illegible or otherwise fail accessibility requirements. For guidance about color combinations, see sites such as Color Safe.

3. Upload an image for your custom logo by clicking **Click to add** next to **Custom Logo**.

The image can be no larger than 120 kb. It displays 24 pixels high with a maximum width of 400 pixels. Supported file types include .jpg, .png, .bmp, .gif, .jpeg, .ico, and .svg.

4. **Optional:** To revert to the original colors and ServiceNow logo, remove the colors that are specified for **Brand color 1** and **Brand color 2** and delete the uploaded image.

**What to do next**

Set up the landing page for your agents, which is the page they see first when using your workspace.
Assign Service Catalog to a workspace

Assign Service Catalog to a workspace to let agents find and order catalog items to fulfill customer requests.

Before you begin
Role required: workspace_admin

About this task
Service catalogs give agents a way of ordering items to fulfill customer requests. The following image shows categories of items that an agent can order from a service catalog.

You can create service catalogs and fill them with only the items that agents should have access to. For information about creating a service catalog, see Service Catalog.

An overview of catalog items in the Service Catalog: what they are, and how to create and define variables for them.

Catalog items can appear in Agent Assist recommendations.
Agent Assist

This image shows two catalog items as recommended solutions in Agent Assist.

Procedure
1. Navigate to Service Portal > Portals.
2. Click a portal, for example, Service Workspace Portal.
   Alternately, you can create a new portal. For more information, see Create a portal.
3. In the related lists, click the Catalogs tab and click a catalog, for example, Service Catalog.
4. Optional: On the Catalog form, make a catalog active by selecting the Active check box.
5. Optional: In the related lists, click the Categories tab to see the categories of items in the catalog.
6. Optional: In the related lists, click the Catalog Portal pages tab to set up the catalog pages. For more information, see Set up catalog portal pages.
7. Optional: In the related lists, click the Sites tab to select which catalogs are supported within the content management system (CMS) sites.
   (Optional) When your organization uses a CMS as well as a service catalog, you can select which catalogs are supported. For more information, see Manage catalogs in CMS sites.
8. Optional: In the related lists, click the Catalog Items tab to see the items in the catalog.
9. **Optional:** To add items to the catalog, click **New**.

   a. On the form, fill in the fields.

   **Portal Catalog New record form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the item.</td>
</tr>
<tr>
<td>Catalogs</td>
<td>Catalog(s) that the item will be added to.</td>
</tr>
<tr>
<td>Category</td>
<td>Type of item, for example, office, software, and laptops.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this component applies to. Global means that the component applies to all applications.</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle to make the item appear in the catalog(s).</td>
</tr>
</tbody>
</table>

   b. On the related lists, click the **Item Details** tab and enter a short and long description of the item.

c. On the related lists, click the **Picture** tab to upload a picture of the item.

d. On the related lists, click the **Pricing** tab to enter the price of the item.

e. **Optional:** Click **Try it** to view how the item will appear in the catalog.

   f. Click **Submit**.

10. Click **Update**.

**What to do next**

   Set up the landing page for your agents, which is the page they typically see first when using your workspace.

**Hide global search result counts in your workspace**

Disable the display of search result counts in global search for a workspace.

**Before you begin**

Role required: admin

**About this task**

Global search for a workspace displays result counts reflecting the total number of records that match a query. Some matching records may be inaccessible to
your end users for security reasons, causing the global search result counts to be inaccurate for these users. To avoid confusing your users, you can hide the global search result counts for your workspace.

Procedure
1. Navigate to **Workspace Experience > Administration > All Workspaces**. The Workspaces list opens, displaying a record for each of your workspaces.
2. Configure the list layout, adding the **Hide Search Results Count** field to the list of selected fields. The **Hide Search Results Count** field appears in the Workspaces list.
3. Select the **Agent Workspace** application from the application picker.
4. Use the list editor to set the value of the **Hide Search Results Count** field to **true** for each workspace where you want to hide global search result counts.

**Setting up landing pages in a workspace**
Set up the landing pages that were supplied with Workspace or create landing pages starting with an empty page to show agents the issues that need to be resolved.

Landing pages are the pages that agents see when they open their workspace. The pages typically include:

- Performance Analytics and Reporting (PAR) visualizations and widgets, for example, the number of open issues
- Lists of records, for example, all records that are assigned to the agent
Every workspace should have at least one landing page. You can either:

- Use the supplied landing pages or modify them.
- Create a landing page starting from an empty page using the legacy User Interface Builder (UI Builder). The legacy UI Builder enables you to build a landing page. The new UI Builder enables you to build a Configurable Workspace, and is only compatible with CSM. For more information on the new UI Builder, see UI Builder.

**Domain Separation for landing pages**

Domain separation enables the following functionality for landing pages.

- Create a landing page: You can create landing pages that are domain separated. Domain separation enables landing pages to override settings for a specific domain.

  **Note:** Macroponents are not domain separated. Changes made to macroponents affect all landing pages that use the value stored in this reference field.
• Editing a landing page in a sub-domain: To make a change in a sub-domain, you must create a copy in the domain you want to edit and edit the new landing page.

You can edit landing pages in sub-domains that are set to Global. Editing landing pages in sub-domains enables you to change the name or element within a component. The changes are saved to the Global landing page. The definition of the landing page is changed and the domain is unaffected.

Creating custom landing pages for workspaces

Use the User Interface Builder (UI Builder) to create custom landing pages for your agents.

Important: The Now Experience Builder described on this page is for building and editing landing pages in all workspaces except CSM. For information about the new UI Builder that builds and edits all pages in CSM Workspace, see Now Experience UI Builder.

UI Builder overview

UI Builder is a drag-and-drop tool that enables you to arrange workspace components to create custom landing pages. To build a page, all you have to do is:

Note: Only custom landing pages can be created the legacy UI Builder. To build configurable Workspaces, see UI Builder. Configurable Workspaces are only compatible with CSM.

1. Drag components from the +Add component tab on the Page management pane onto the pane in the middle of UI Builder called the Stage.

2. Select each component that you dragged into the Stage. Then, in the Configuration pane, enter configuration values for each selected component.
You can add, remove, and group components to create a landing page that contains the important information you want agents to see when they open their workspace.
Plugin
The Now Experience UI Builder requires the com.sn_ui_builder plugin, which comes by default on new and upgraded instances.

If you intend to use Performance Analytics and Reporting on landing pages you create, make sure to activate the Performance Analytics plugin. It's active by default in new instances starting with Orlando but not in upgraded instances.

Constraints
• The domain separation for Now Experience UI Builder landing pages is the same as the workspace’s.
• The Now Experience UI Builder does not work on the mobile platform.
• Now components cannot talk to one another.

Next steps
Use the tutorial to get familiar with UI Builder.

UI Builder landing page tutorial
Learn how to use the legacy UI Builder to create a custom landing page.
Before you begin

**Important:** The Now Experience Builder described on this page is for building and editing landing pages in all workspaces except CSM. For information about the new UI Builder that builds and edits all pages in CSM Workspace, see Now Experience UI Builder.

This task pertains to the legacy of UI Builder which only enables you to create a landing page. Use the new version of UI Builder to create a Configurable Workspace. For more information, see UI Builder.

Role required: workspace_admin or ui_builder_admin

**About this task**
Before you create your landing page, let’s see how UI Builder works by exploring an existing landing page.

**Procedure**

1. Navigate to **Workspace Experience > Administration > All Workspaces** and click a workspace to open it.
2. If the page that opens is not editable, click the **here** link in To edit this record click here to make the page editable.
3. Click **Open in UI Builder**.
4. In the Page management pane, on the **Pages** tab, click the **Incident Overview** landing page.

This landing page appears in the Stage pane. Notice the **Status** and **Application** fields above the Configuration pane. The **active** status means that the landing page is currently being used. The **Application** field shows that the landing page is being used by ITSM Agent Workspace. If you clicked:

- **Deactivate**, the status would change to **Inactive** and the landing page would no longer display in workspace.

**Deactivate** button would be replaced by the **Activate** button, which would enable you to publish the landing page in workspace.

You typically deactivate landing pages when you're working on them. For example, to update the current landing page, you could:

- a. Clone your current landing page.
- b. Work on it in the inactive state.
- c. Make the updated version **Active**.
- d. Make the original version **Inactive**.
• **Save** button, you would save any changes you made to the landing page. If the **Status** is:
  - **Active**, the changes appear immediately in workspace.
  - **Inactive**, the changes are saved but not published.

5. Click the components and see how the configuration parameters change in the Configuration pane.

6. Click **Happening Now**.

   The container becomes visible around the four, smaller components. **Happening Now** is the container's label. Look in the Configuration pane under **Label**. Containers are how you group other components.

7. With the container still highlighted, slide the **Show border** slider to the right.

   A border appears, which shows the container.

8. Slide the **Can collapse** slider to the right.

   A caret icon (верхняя стрелочка) appears above the container. An agent can click the caret to collapse the container and everything in it.

9. On the top right of the Configuration pane, click the right arrow (>) to collapse the pane.

10. In the Stage pane, click the container and then click its configuration icon (перемещать).

    ![](image)

    The Configuration pane reopens.

    You also notice the move icon (перемещать) that you can use to drag a component around. Don't do that yet.
The **Collapsed** slider in the Configuration pane means that the container starts out collapsed and appears as a downward arrow (▼) that an agent can click to expand the container.

Now that you have seen how to use the different parts of the interface, let’s see how to create a landing page.

**Create new landing page tutorial**

Create a new landing page.

**Procedure**

1. On the **Pages** tab, click the plus icon (+) to open a new landing page.

   ![Page management](image)

   ![Pages](image)

   ![Landing pages](image)

   ![Default Landing Page](image)

   ![Incident Overview](image)

   You can also create a new page by clicking **Page actions > +New page**.

2. On the **OK. Let's get some general info for this page** modal, enter the name of your landing page and click **Create landing page**.

   This title appears above the Stage but not on your landing page.

   ![UI Builder](image)

   ![Agent Workspace](image)

   ![My Landing Page](image)

   ![Configuration](image)

**Add and configure components tutorial**

Add and configure components on a landing page.

**Procedure**

1. Click the **+Add component** tab and drag an image component into the Stage pane.

   Parameters for the image appear in the Configuration pane.
2. Drag a data visualization component far below the image and drop it.
   The component does not appear in the Stage pane.

3. Drag a data visualization component over the image component but do not drop it. Move the data visualization component around the edges of the image component.
   The side of the image component highlights when you move the data visualization component over it.

4. Hold the data visualization component over the left side of the image and drop it.
   The data visualization component appears to the left of the image component.
5. Click and then grab the move icon (drag icon) above the data visualization component and drag it over the bottom edge of the image component and drop it.

Now, you know how to move a component on the landing space. The data visualization component is blank. Let's fill it so it's visible.


A type-ahead list of possible entries appears.

7. Click Open incidents by Priority in the list.

That report opens in the component.

8. In the Configuration pane, delete Open incidents by Priority and in the PA Widget field, type incident.

A type-ahead list of possible entries appears. These entries are Performance Analytics (PA) widgets.

You can only put one data visualization in the component. So, you can either display a report or a PA widget but not both. If you put entries for both a report and a PA widget, UI Builder only displays the report.

You now know how to add and arrange components on a landing page. Let's now see how to group them.

Group and arrange components tutorial
Group and arrange components on a landing page.

Procedure

1. Click Page actions, select Delete page, and then confirm the deletion.

2. Select the data visualization component, click the trash icon (trash icon) and then the delete check mark icon (check mark icon) above the component to remove it.

You have now deleted components on a landing page. If you like, you can also remove the image component.

3. Drag a container component into the Stage pane.

4. In the Component pane, enter a value in the Label field for the container and push the Show border slider to the right so you can see the container.

5. In the Label field, add a title to the container, for example, Important lists.

6. Drag a list component into the container.

7. In the Component pane, in the Table field, enter a value for the table where the list of records comes from, for example, incident.

8. Drag another list component into the container.
You can drop the list inside or outside of the container. Drop it inside the container.

9. In the Component pane, in the **Table** field, enter a value for a different table where the list of records comes from, for example, task.

You now have two list components inside a container component, which has a label that describes the lists.

10. Continue adding components inside or outside of the container and using the move icon (_drag) to drag the components around so that you can get used to adding, deleting, moving, and grouping components.

11. Click **Save**.

If you were making a real landing page, you'd also click **Activate**. Because you're not making a real landing page in this tutorial, let's delete this practice landing page.

**Delete a landing page tutorial**

Delete a landing page.

**Procedure**

1. On the **Pages** tab, select your landing page.

2. Under **Page actions**, click **Delete page**.
What to do next
You now have an idea how to use UI Builder. You’re ready to create your first landing page.

Create a custom landing page in UI Builder
Create a custom landing page to show agents the important tasks they can undertake.

Before you begin
Important: The Now Experience Builder described on this page is for building and editing landing pages in all workspaces except CSM. For information about the new UI Builder that builds and edits all pages in CSM Workspace, see Now Experience UI Builder.

Role required: workspace_admin or ui_builder_admin

About this task
A landing page is an agent’s initial view of their workspace. Fill the landing page with the minimal amount of information that your agents need so that they can start working on the most important tasks. Your instance should have at least one landing page.
Procedure

1. Navigate to Workspace Experience > Administration > All Workspaces and click a workspace.

2. If the page that opens is not editable, click the here link in To edit this record click here.

3. Click Open in UI Builder.

4. To create a landing page, do one of the following:

<table>
<thead>
<tr>
<th>To do this task</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. Click Page Actions and select +New Page.</td>
<td>You can also click the plus icon (+) on the Pages tab.</td>
</tr>
<tr>
<td></td>
<td><img src="https://example.com/image.png" alt="Page Actions and +New Page" /></td>
</tr>
<tr>
<td>Create a landing page starting with no components</td>
<td>b. On the modal, in Enter the name of your landing page, enter the name of the new landing page.</td>
</tr>
<tr>
<td></td>
<td>c. In the Application field, specify what applications that you want this new landing page to appear in.</td>
</tr>
<tr>
<td></td>
<td>d. In the Protection field, specify a policy. None—Enables anyone to view and modify the landing page. Read-only—Enables anyone to view but not modify the landing page. Protected—Prevents everyone but you from viewing or modifying the landing page. In all of these options, the page creator, can view and modify the landing page.</td>
</tr>
</tbody>
</table>
**To do this task** | **Do this**
--- | ---
| Copy a landing place to use as a starting point for a new landing page | a. Click **Pages** and click the landing page that you want to copy.  
b. Click **Page Actions** and select **Copy Page**.  
c. On the modal, in **Enter the name of your landing page**, enter the name of the new landing page.  
d. In the **Application** field, specify what applications that you want this new landing page to appear in.  
e. In the **Protection** field, specify a policy. **None**—Enables anyone to view and modify the landing page. **Read-only**—Enables anyone to view but not modify the landing page. **Protected**—Prevents everyone but you from viewing or modifying the landing page. In all of these options, the page creator, can view and modify the landing page.  
f. Click **Create copy**.  

5. Click **Save**.

**Example:**
In the following example, you can see the two places that the value, *My first landing page*, for **Enter the name of your landing page** appears, and where the value for **Application**, *Agent Workspace*, appears.
What to do next
Now that you’ve created a landing page, you can add components to it.

Add components to a landing page in UI Builder
Drag and drop components into the Stage pane to create a landing page.

Before you begin

**Important:** The Now Experience Builder described on this page is for building and editing landing pages in all workspaces except CSM. For information about the new UI Builder that builds and edits all pages in CSM Workspace, see Now Experience UI Builder.

- You must have created a landing page.
- Role required: workspace_admin or ui_builder_admin

About this task
You add components to landing pages by dragging and dropping components from the +Add component tab into the Stage pane.

Procedure

1. Navigate to Workspace Experience > Administration > All Workspaces and click a workspace to open it.
2. If the page that opens is not editable, click the here link, in To edit this record click here.
3. Click Open in UI Builder.
4. In the Page management pane, on the Pages tab, click the landing page that you want to add components to.

5. Click the +Add component tab to open the list of components that you can add to your landing page.

6. Add components by dragging one component at a time from the +Add component tab into the Stage pane.

When you drag a component, click it first to select it. A box appears around the component when it's selected. When you drop components into the Stage pane, make sure to point to a component that's already on the landing page. Highlights appear where you can drop the component. For more information about dragging and dropping, see the tutorial.

You can add these components:
• Container—Container in which you can group other components, for example, a heading and two data visualization reports. For more information, see Container component in UI Builder.

• Report/PA Widget—Performance Analytics and Reporting visualizations. These values can be updated periodically. For more information, see Data Visualization components in UI Builder.

• Image—Image. For more information, see Image component in UI Builder.

• Rich text—String to use anywhere on the landing page. For more information, see Rich Text component in UI Builder.

• Data visualization—New report visualizations, and visualizations from existing reports and widgets. These values can be updated periodically. For more information, see Data Visualization components in UI Builder.

• Heading—String to use as the title of a landing page. For more information, see Heading component in UI Builder.

• List—List of records that come from a single table. For more information, see List component in UI Builder.

7. Optional: To remove a component from your landing page:

   a. Click the component and click the trashcan icon (🗑️) that appears.

   b. Confirm the deletion by clicking the check mark icon (✓) in the Delete element? pop-up window.

8. Optional: To move a component, click it, use your mouse to grab the move icon ( draggable), and drag the component to a new location.

9. Click each component in the Stage pane and enter values for the component properties that appear in the Configuration pane.
For descriptions of component properties, see the Component reference for UI Builder.

10. Click **Save**.

11. Click **Activate** when you're ready to use the landing page.

**Update a landing page's name in UI Builder**

Update a landing page's name to better reflect its purpose.
Before you begin

Important: The Now Experience Builder described on this page is for building and editing landing pages in all workspaces except CSM. For information about the new UI Builder that builds and edits all pages in CSM Workspace, see Now Experience UI Builder.

Role required: workspace_admin or ui_builder_admin

About this task

You can revise the name of your landing page but not its properties, such as the application associated with the landing page. The landing page name does not appear on the landing page itself. It only appears above the Stage pane and on the Pages tab in UI Builder, as shown in the following figure. To put a name on your landing page, add a heading component.

Procedure

1. Navigate to Workspace Experience > Administration > All Workspaces and click a workspace.
2. If the page that opens is not editable, click the here link in To edit this record click here.
3. Click Open in UI Builder.
4. In the Page management pane, on the Pages tab, click the landing page that you want to modify.
5. Click Page Actions and select Edit page properties.
6. In Enter the name of your page, revise the name of the landing page.
OK. Let's update your My revised name landing page

Enter the name of your page

My revised name

Protection

None (default)

Application

Global

This image shows that the new landing page's name is My revised name.

7. Click Update.

Delete a landing page in UI Builder

Delete a landing page when it's no longer needed.

Before you begin

Important: The Now Experience Builder described on this page is for building and editing landing pages in all workspaces except CSM. For information about the new UI Builder that builds and edits all pages in CSM Workspace, see Now Experience UI Builder.

Role required: workspace_admin or ui_builder_admin

Procedure

1. Navigate to Workspace Experience > Administration > All Workspaces and click a workspace.

2. If the page that opens is not editable, click the here link in To edit this record click here.

3. Click Open in UI Builder.

4. In the Page management pane, on the Pages tab, click the landing page that you want to delete.

5. Click Page Actions and select Delete page.
6. Confirm the deletion.

Component reference for UI Builder

The information in the following sections helps you to understand the parameters for the Now components that are used in UI Builder.

Important: The Now Experience Builder described on this page is for building and editing landing pages in all workspaces except CSM. For information about the new UI Builder that builds and edits all pages in CSM Workspace, see Now Experience UI Builder.

Container components in UI Builder

Use a container component in UI Builder to group other, similar components, such as multiple data visualization components. You can add a title to a container to help agents understand the reason for the grouping.

Important: The Now Experience Builder described on this page is for building and editing landing pages in all workspaces except CSM. For information about the new UI Builder that builds and edits all pages in CSM Workspace, see Now Experience UI Builder.
You can insert any component into a container component. The container has a label that helps agents understand the grouping of the other components. In the following example, the container contains two data visualization components.

The following table explains the container component parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component name</td>
<td>Name that appears in the component controls above a component in the Stage pane. The maximum number of characters is 18.</td>
</tr>
<tr>
<td>Label</td>
<td>String that appears as a title for the container. In the previous image, see &quot;Container label here.&quot;</td>
</tr>
<tr>
<td>Type</td>
<td>Style component. Use the Visualizations type to darken the container, which makes the components inside it stand out.</td>
</tr>
<tr>
<td>Type</td>
<td>Style component. Use the Neutral-1 type to darken the container. Use the Neutral-0 type to prevent the container from being darkened. Both values override the Visualizations type.</td>
</tr>
</tbody>
</table>
Container component parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show border</td>
<td>Toggle to show or hide an outline around a component. The container border is darker and thicker than the other component borders.</td>
</tr>
<tr>
<td>Can collapse</td>
<td>Toggle to enable/disable a component to collapse. When enabled, a caret icon (↑) appears in the component that a user can click to collapse the component.</td>
</tr>
<tr>
<td>Collapsed</td>
<td>Toggle to start or not-start the component in a collapsed state. When enabled, the collapsed component appears as a downward arrow (▼) on the landing page.</td>
</tr>
</tbody>
</table>

Data visualization components in UI Builder

To view overview information relevant to your goals, you can add Performance Analytics and Reporting data visualizations to a workspace landing page.

Important: The Now Experience Builder described on this page is for building and editing landing pages in all workspaces except CSM. For information about the new UI Builder that builds and edits all pages in CSM Workspace, see Now Experience UI Builder.

Heading components in UI Builder

Add a title to your landing page using a header component.

Important: The Now Experience Builder described on this page is for building and editing landing pages in all workspaces except CSM. For information about the new UI Builder that builds and edits all pages in CSM Workspace, see Now Experience UI Builder.

The image shows the heading, My Heading, as the title for a landing page.

The following table explains the heading component parameters.
## Heading component parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component name</td>
<td>Name that appears in the component controls above a component in the Stage pane. The maximum number of characters is 18.</td>
</tr>
<tr>
<td>Label</td>
<td>Text of the heading.</td>
</tr>
<tr>
<td>Style</td>
<td>Size of the heading text.</td>
</tr>
<tr>
<td>Disable text wrap</td>
<td>Toggle to wrap or not wrap the heading text. If you set the heading text not to wrap and the heading is wider than the landing page, UI Builder truncates the end of the heading and appends an ellipsis. If the user widens the landing page, more of the heading text appears.</td>
</tr>
<tr>
<td>Hide bottom margin</td>
<td>Toggle to show or hide a blank line below the heading text.</td>
</tr>
</tbody>
</table>

### Image components in UI Builder

Add images to your landing page with an image component.
Important: The Now Experience Builder described on this page is for building and editing landing pages in all workspaces except CSM. For information about the new UI Builder that builds and edits all pages in CSM Workspace, see Now Experience UI Builder.

When you drag the image component icon ( ![image](image) ) into the Stage pane, a stock image appears that you can change and resize. You can change the stock image by supplying your image's URL.

The following table explains the parameters of the image component.

<table>
<thead>
<tr>
<th>Image component parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parameter</strong></td>
</tr>
<tr>
<td>Component name</td>
</tr>
<tr>
<td>Alt Text</td>
</tr>
</tbody>
</table>
### Image component parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image URL</td>
<td>URL for the image.</td>
</tr>
</tbody>
</table>
| Fit | Image size control.  
  - **Expand to fill** zooms in or out on the image in both X and Y axises proportionally so the image fills the container.  
  - **Stretch to fit** zooms in on the image so it fills the container but the image does not expand proportionally.  
  - **Keep original size** displays the image in its original size, which may be larger or smaller than the container. |
| Position | Location of the image in the container. For example, **Bottom-right** places the image at the bottom-right of the container. This parameter only works when the image is smaller than the container. |
| Height | Height of the image measured by the number of pixels high. If this height is shorter than the image height, the parameter cuts off the top of the image. The width is not reduced proportionally. |

### List components in UI Builder

Use a list component to add lists to your landing page.

> **Important:** The Now Experience Builder described on this page is for building and editing landing pages in all workspaces except CSM. For information about the new UI Builder that builds and edits all pages in CSM Workspace, see [Now Experience UI Builder](#).

When you drag the list component icon ( ![List](#)) into the Stage pane, a sample list appears. List components have the following parts:
The following table explains the list component parameters. Use the previous image for the location of the parameter values in the list component.

### List component parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component Name</td>
<td>Name that appears in the component controls above a component in the Stage pane. The maximum number of characters is 18.</td>
</tr>
<tr>
<td>List Title</td>
<td>Title of your list.</td>
</tr>
<tr>
<td>Table</td>
<td>Database table hat the records come from that appear in the list.</td>
</tr>
<tr>
<td>Query</td>
<td>Button that you use to open the condition builder, which enables you to filter the records that are included in the list. For example, you might display only list records from <strong>Table</strong> that satisfy the conditions: <strong>Active is true</strong> and <strong>Priority is 1 – Critical</strong>. The badge and</td>
</tr>
</tbody>
</table>
### List component parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>count icon ( )</td>
<td>show the number of filters applied. If there is no badge, there are no filters.</td>
</tr>
<tr>
<td>Columns</td>
<td>Number of columns that you specify to appear in the list instead of the default columns. Use the parameter multiple times to display multiple columns.</td>
</tr>
<tr>
<td>Max Rows</td>
<td>Maximum number of rows that you specify to appear in the list. The default is 5. The maximum is 100.</td>
</tr>
<tr>
<td>Max Columns</td>
<td>Maximum number of columns that you specify to appear in the list. The default is 5. If the number of columns is greater than the value of this parameter, only the first columns appear.</td>
</tr>
<tr>
<td>Hide Header</td>
<td>Toggle to show or hide the list's header.</td>
</tr>
<tr>
<td>Hide Title</td>
<td>Toggle to show or hide the list's title.</td>
</tr>
<tr>
<td>Hide Badge with Record Count</td>
<td>Toggle to show or hide the list's badge and record count. The number is the total number of records in the list. Only some records may be seen in the current display.</td>
</tr>
<tr>
<td>Hide Refresh Button</td>
<td>Toggle to show or hide the refresh button.</td>
</tr>
<tr>
<td>Hide &quot;Last Refreshed&quot; Text</td>
<td>Toggle to show or hide the &quot;Last refreshed&quot; text.</td>
</tr>
<tr>
<td>Hide Links</td>
<td>Toggle to make the values in the Number column links or not. If they are not links, the number text is black. In the following image, the numbers on the left are not links. The numbers on the right are links.</td>
</tr>
</tbody>
</table>
List component parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Active Tasks 384</td>
<td><img src="image" alt="Table showing active tasks" /></td>
</tr>
<tr>
<td>Last refreshed 6h ago</td>
<td></td>
</tr>
<tr>
<td>Number  - Priority</td>
<td></td>
</tr>
<tr>
<td>CHG00000001 3 - Moderate</td>
<td></td>
</tr>
<tr>
<td>CHG00000004 4 - Low</td>
<td></td>
</tr>
<tr>
<td>CHG00000005 4 - Low</td>
<td></td>
</tr>
<tr>
<td>All Active Tasks 384</td>
<td><img src="image" alt="Table showing active tasks" /></td>
</tr>
<tr>
<td>Last refreshed 6h ago</td>
<td></td>
</tr>
<tr>
<td>Number  - Priority</td>
<td></td>
</tr>
<tr>
<td>CHG00000001 3 - Moderate</td>
<td></td>
</tr>
<tr>
<td>CHG00000004 4 - Low</td>
<td></td>
</tr>
<tr>
<td>CHG00000005 4 - Low</td>
<td></td>
</tr>
<tr>
<td>Hide &quot;View All&quot; Footer</td>
<td>Toggle to show or hide the &quot;View all&quot; link in the footer.</td>
</tr>
<tr>
<td>Hide Highlighted Values</td>
<td>Toggle to show or hide highlights that have been configured to appear in specified list fields. For more information, see <a href="highlight_list_fields">Highlight list fields in Workspace</a>.</td>
</tr>
<tr>
<td>Hide Empty State Image</td>
<td>Toggle to show or hide the image that appears when filter conditions prevent any records from appearing in the list. The intention is to show a response so agents realize that the list is empty. You cannot change the image.</td>
</tr>
</tbody>
</table>

Rich text components UI Builder

Add text to your landing page with a rich text component to explain parts of your landing page, for example, "Tackle these priority 1 incidents first."

**Important:** The Now Experience Builder described on this page is for building and editing landing pages in all workspaces except CSM. For information about the new UI Builder that builds and edits all pages in CSM Workspace, see [Now Experience UI Builder](now_experience_ui_builder).

![Rich Text Component](image)
The following table explains the rich text component parameters.

### Rich text parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component name</td>
<td>Name that appears in the component controls above a component in the Stage pane. The maximum number of characters is 18.</td>
</tr>
<tr>
<td>HTML</td>
<td>HTML editor that you use to enter text.</td>
</tr>
</tbody>
</table>

Create User Experience filters

Create a single filter for use across all the visualizations in a workspace.

**Before you begin**

Important: The Now Experience Builder described on this page is for building and editing landing pages in all workspaces except CSM. For information about the new UI Builder that builds and edits all pages in CSM Workspace, see Now Experience UI Builder.

Role required: admin
Procedure

1. Navigate to **User Experience Framework > Experiences**.

2. Click the **Admin panel** entry of the experience that you want to filter.

3. On the configuration page, click **Open in UI Builder**. The UI Builder opens in a new window or tab.

4. Create a page template.

5. Select the variant of the page you want to filter.

6. Select the Toolbox icon and drag a filter onto the workspace.
7. In the sidebar, name the filter and select the first table and field that you want to filter. For example, Incident and State.

8. **Optional:** Click **Add** to add another table. When your User Experience contains information from multiple tables, for example Problems and Incidents, you can filter on the same field, such as State, in both.

9. **Optional:** Select the values that appear in the filter. Under Data Source, click the Configure icon. Configuring the values is useful if you’re filtering on something like Created by. The Created by field uses the user table which might have thousands of entries. A dynamic filter that only shows the problems created by the direct reports of the manager using the Experience. In this case, you can configure the filter with the condition Manager | is (dynamic) | Me. For more information, see .

10. Click **Save**.

**Results**
The filter you create is available in the workspace in which you created it.
What to do next
For filters to work in workspaces, you must configure an event handler to apply the filters.

Set up supplied landing pages in workspace
Set up pre-configured reports and relevant data for agents on the landing page to help agents quickly find issues to resolve.

Before you begin
Role required: workspace_designer

About this task
The landing page is an agent’s initial view of Workspace. Your instance should have at least one landing page, depending on the features and products you have. Landing pages are configurable and consist of a layout with containers and widgets that appear on the page. You can use any of the supplied landing pages without modifications or you can clone a landing page and make updates for your installation.

Note: Widgets, such as reports, that appear on a landing page must be pre-configured. If you need to configure a widget, see Performance Analytics and Reporting for Agent Workspace.
You can include these components on a landing page:

- Lists—Display a filtered list of records.
- Single Score—Displays the number of records in a filtered list.
- Time Series/Trend By—Displays a graph of record values over time.

To design your own landing page and add custom components to it, see Creating custom landing pages.

**Procedure**

1. Navigate to **Workspace Experience > Landing Pages**.
2. Optional: Click a landing page to modify.
   If the landing page form is read-only, click here in **To edit this record click here**.
3. Optional: Create a new landing page in one of the following ways:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new landing page based on an existing page</td>
<td>Select a landing page. If the landing page form is read-only, click here in <strong>To edit this record click here</strong>. You can</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>modify this landing page and save it</td>
<td>under a different name to create a new landing page that is based on this one.</td>
</tr>
<tr>
<td>Create a landing page</td>
<td>Click <strong>New</strong>.</td>
</tr>
</tbody>
</table>

4. On the form, fill in the fields.

**UX Custom Content Extension form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Landing page name.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the page shows. If you set up multiple landing pages, the page with a lower value takes precedence over the pages with higher values.</td>
</tr>
<tr>
<td>Note:</td>
<td>If there are permissions on any active page, an agent sees the page with their group or role set. The permissions takes precedence over a user who sees a page without permissions that is the lowest order.</td>
</tr>
<tr>
<td>Applicability</td>
<td>If applicability is for any page or a specific page.</td>
</tr>
<tr>
<td>Applicable Page</td>
<td>Page in the UX page registry. Select <strong>Agent Workspace</strong>. This field only appears when you set <strong>Applicability</strong> to <strong>Specific Page</strong>.</td>
</tr>
<tr>
<td>Registry</td>
<td>Application Name of the application that this landing page applies to. For example, if this value is <strong>ITSM Landing Pages</strong>, this landing page applies only to ITSM.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that you select to determine whether the landing page appears. A page that is not active does not appear.</td>
</tr>
<tr>
<td>Optional Page Title</td>
<td>Title to display on the page.</td>
</tr>
<tr>
<td>Available Child Slots</td>
<td>Pre-defined named location for child elements.</td>
</tr>
<tr>
<td>Layout</td>
<td>Pre-defined list of containers to define the number of slots (columns) that display on a layout.</td>
</tr>
</tbody>
</table>

5. Right-click anywhere on the top banner and click **Save**.
6. Put containers on your landing page.
   Containers hold the components on your landing page. You set up the
   containers on the landing page before putting components into them.

   a. On the **UX Page Elements** tab, click **New Container**.

   b. On the form, fill in the fields.

   **UX Page Element form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the container.</td>
</tr>
<tr>
<td>Component</td>
<td>Name of the container component.</td>
</tr>
<tr>
<td>Parent element</td>
<td>Landing page that this container is on.</td>
</tr>
<tr>
<td>Border</td>
<td>Option to select a border around your container.</td>
</tr>
<tr>
<td>Can Collapse</td>
<td>Toggle to enable agents to collapse this container on the landing page.</td>
</tr>
<tr>
<td>Optional Container Title</td>
<td>Title to display on the container.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of styling for your visualization. You can choose the default styling</td>
</tr>
<tr>
<td></td>
<td>(no background color) or visualization styling (gray background).</td>
</tr>
<tr>
<td>Collapsed</td>
<td>Toggle for the initial state of the container. Select this option to</td>
</tr>
<tr>
<td></td>
<td>collapse the container when the landing page opens.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the container appears in on the landing page. The lower the</td>
</tr>
<tr>
<td></td>
<td>value means the higher it appears on the landing page.</td>
</tr>
<tr>
<td>Available Child Slots</td>
<td>Pre-defined list of containers to define the number of slots (columns) that</td>
</tr>
<tr>
<td></td>
<td>appear in a layout.</td>
</tr>
<tr>
<td>Layout</td>
<td>Column layout on the page. Valid values depend on the value of **Available</td>
</tr>
<tr>
<td></td>
<td>Child Slots**. The total number of columns on a page is 12. For example,</td>
</tr>
<tr>
<td></td>
<td>if you choose <strong>Container - 3 Up</strong> for <strong>Available Child Slots</strong>, the <strong>Layout</strong></td>
</tr>
<tr>
<td></td>
<td>value enables you to specify the width of the three columns.</td>
</tr>
</tbody>
</table>
c. Click **Submit**.

You’ve created a container to put your landing page components in.

7. Add components to the containers on your landing page.

a. On the **UX Page Element Permissions** tab, click **New Visualization**.

b. On the form, fill in the fields.

### UX Page Element form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your component.</td>
</tr>
<tr>
<td>Component</td>
<td>Name of the visualization component.</td>
</tr>
<tr>
<td>Parent element</td>
<td>Container that this component goes into.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the component shows in the container if there's more than one component.</td>
</tr>
<tr>
<td>Report</td>
<td>Report that you want to render in the container, for example, <strong>Open problems older than 30 days</strong> or <strong>Transactions by month for Last 12 months</strong>.</td>
</tr>
<tr>
<td>is_realtime</td>
<td>Toggle to update the Report or PA Widget values in real time.</td>
</tr>
<tr>
<td>PA Widget</td>
<td>PA Widget that you want to render in the container, for example, a single score or a time series.</td>
</tr>
<tr>
<td>Optional Widget Label</td>
<td>Title to display with the PA widget.</td>
</tr>
</tbody>
</table>

<i>Note: You must select either a Report or PA Widget, but you can't display both in a single container. If you define both, only the report displays.</i>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size Variant</td>
<td>Size of the PA Widget. Choosing a size depends on how many containers are on the landing page and what you want to emphasize.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Not all sizes apply to all widgets.</td>
</tr>
<tr>
<td>Border</td>
<td>Toggle to put a border around the report or PA widget.</td>
</tr>
<tr>
<td>Refresh Interval</td>
<td>Number of minutes before the values of this component refresh. The interval begins when an agent navigates away from a landing page and ends when they come back to the landing page.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> There is no auto-refresh, but an agent can click the browser’s refresh button at any time.</td>
</tr>
<tr>
<td>Visualization SysID</td>
<td>Designated ID for the widget.</td>
</tr>
<tr>
<td>Report Type</td>
<td>Type of report that renders.</td>
</tr>
</tbody>
</table>

c. Click Submit.

8. Configure permissions for agents to access the landing page:

a. On the UX Page Element Permissions tab, click New.

b. On the page, fill in the form.

**UX Page Element Permissions form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element</td>
<td>Value of Optional Page Title.</td>
</tr>
<tr>
<td>Role</td>
<td>Role that an agent must have to see this landing page.</td>
</tr>
<tr>
<td>Group</td>
<td>Group that an agent must belong to in order to see this landing page.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this component applies to. Global means that the component applies to all applications.</td>
</tr>
</tbody>
</table>

Any page element (including subelements) can have a restriction to a given set of roles or groups. If no element permissions are set on roles or groups,
all agents see the element. If some element permissions are set, an agent needs just one role or group assignment to see the element.

c. Click Submit.

9. To see your landing pages:

a. Under your profile picture, click Configure Workspace.

Configure Workspace enables you to set up list categories, list filters, landing pages, the record types that agents can create, and the modules that appear in the pane on the far left of the screen.

b. On the Workspace form, click the Landing Pages tab.

What to do next
Set up lists for your agents so they can find additional issues to work on.

Set up landing page permissions
Set up permissions for landing pages so that people see the landing pages suited to their roles or the groups they belong to.

Before you begin
Role required: workspace_admin or ui_builder_admin

About this task
When you have multiple landing pages associated with a workspace, several factors determine which one shows. One factor is the order of the landing page; the one that shows is the one that has the lowest value for Order.

<table>
<thead>
<tr>
<th>Name</th>
<th>Active</th>
<th>Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Overview (enabled for UI Builder)</td>
<td>true</td>
<td>200</td>
</tr>
<tr>
<td>Default Landing Page (enabled for UI Bui...</td>
<td>true</td>
<td>1,000</td>
</tr>
</tbody>
</table>

The second factor is permissions, which are based on roles and groups. You can set permissions on landing pages so they only appear if the user either has
the required role or belongs to a specified group. For example, you might set permissions for managers to see one landing page and agents to see another. If permissions prevent a landing page from displaying, the next landing page in Order displays.

**Procedure**

1. Navigate to **Workspace Experience > Administration > Landing pages** and click the landing page you want to set permissions on.
2. On the UX Page Element Permissions tab, click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element</td>
<td>Landing page name.</td>
</tr>
<tr>
<td>Role</td>
<td>Role, if any, a user must have to see the landing page. Click the search icon (🔍) and select a role.</td>
</tr>
<tr>
<td>Group</td>
<td>Group, if any, a user must belong to to see the landing page. Click the search icon (🔍) and select a group.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of these landing page permissions. Global is the default.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
5. Repeat the procedure starting with step 2 to add other roles or groups that restrict who can see the landing page.

Even though multiple landing pages might have the same Order value, users may see different landing pages based on their roles or the groups they belong to.

**Setting up list view in a workspace**

The list view displays filtered lists of records, such as All tasks, Open tasks, and My tasks. By setting up list categories and filtered lists, you help your agents quickly find the records they need to work on.

Agents use the list view to see records that they want to work on. To get to the list view, they click the list icon (📜) in the navigation bar. When an agent clicks a record in list view, the record opens in record view.
Note: In a typical situation, if you click a field in a record in a list of records, that record opens. If the field is clickable (a reference, document ID, or URL), however, clicking it does not open the record. Instead, it opens the record or URL that the clickable field points to.

List types
The list pane in has the following sections:

Lists
Lists created by the system administrator that are visible to all agents. Includes list categories and filtered lists that system administrators can assign to agents by role or assignment group.

To learn what system administrators can configure in the Lists tab, see Set up list categories.

My Lists
Lists that are created by agents that are not visible to other agents.

To learn what agents can configure in My Lists, see Create a filtered list in a workspace.

What to configure in lists

Create list categories
Create categories for lists, such as All cases, My cases, and Open cases. You must create a list category before you can create a list filter. List categories are names only and not clickable. List categories do not appear unless they contain filtered lists.

Create filtered lists
Create a subset of all the records in the database, such as All cases, My cases, and Open cases. Filtered list names are clickable.

**Highlight list fields**
Highlight record fields in list view to call attention to them.

**Speed up loading large lists**
Remove the list pagination to improve the performance when loading large lists.

**Create custom list operations**
Use an action to create a button that performs a function on the records in the list. For example, you can create a button that assigns a selected record to an agent.

**Set up field lengths for exports to Excel**
Set up the maximum number of characters that are exported in condition fields to prevent the truncation of values.

**Next**
Click the component to set up next.

- **List category**—A name for a group of filtered lists. You must create a list category before you create a filtered list. The list category is not clickable.

- **Filtered list**—A subset of the tables in the database. You must create a list category before you create a filtered list. If you don't create a filtered list, the list category will not show in the Lists tab.

- **Highlighted fields**—Calls attention to fields in list view.
Set up list categories in a workspace

Create list categories in a workspace to group records so that agents can find the records they need to work on.

Before you begin

To create list categories, you need the elevated workspace_list_admin role. If you have the workspace_list_admin role, you can elevate your privileges using the Profile Settings menu. For more information on how to get an elevated role, see Elevated privilege.

About this task

List categories group records that your agents need to do their work. Workspace provides many list categories but you might create additional categories to benefit your agents. The categories are associated with database tables, for example, incidents, cases, tasks, and service level agreements (SLAs).

List categories appear in the list pane, as shown in the following image, but they do not retrieve records when you click them. The filtered lists under the categories do retrieve records. When you create a list category, you must add list filters to it or the category doesn't appear.

![List categories in a workspace](image)

Add a list category
Note: The opening of the video shows a user who is accessing list categories through the application navigator. As of Rome, that module is no longer in the application navigator. The rest of the video, however, shows how to create list categories. Next, see the following procedure to learn how to access list categories.

Procedure

1. In your workspace, click your profile image and then on the Settings menu, select **Configure Workspace**.

2. On the **Workspace List Categories** tab, click **New**.

   Note: If you don’t see the **New** button, click the cog icon (⚙️) and then select **Developer > Agent Workspace**.

3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Category name. The title usually applies to a table of records, for example, <strong>Users</strong>, or <strong>Cases</strong>.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the list category appears in the list pane. Lower numbers appear first. For example, a list category with an order of 100 appears above a list category with 200.</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle to make the list category appear or disappear in the list pane.</td>
</tr>
<tr>
<td>Description</td>
<td>Rationale for creating the category.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

   A new list category appears in the list pane.
5. See your list categories:

a. Under your profile image, click **Configure Workspace**.

b. On the Workspace form, click the **Workspace List Categories** tab.

**What to do next**
You must set up a **filtered list** in the category that you created in order for the category to appear.

**Set up filtered lists in a workspace**
Set up filtered lists to group records that help agents do their work more efficiently. Example groupings are Active Cases, My Cases, and All cases.

**Before you begin**
Before you can create a filtered list you must **Create a list category** for the filtered list to go under.
About this task
List filters display a subset of the records in a table. For example, in the Incident category, a filtered list might only display the records in the Incident table that have the status open. You might call that filtered list, Open Incidents.

List filters, as shown in the following image, appear as subsections under list categories in the list pane. When clicked, list categories do not display lists of records, but list filters do. Set up list filters that agents need to do their work. For example, you can set up list filters for Open Incidents, High Priority Incidents, and My Incidents.

BeforeQuery business rules that apply additional conditions will not appear in the condition builder.

![List filters example]

Configure filtered lists

⚠️ **Note:** The Role required value in the video says workplace_list_admin but the correct role is workspace_list_admin.
Procedure

1. In your workspace, click your profile image and on the Settings menu, select Configure Workspace.

2. On the Workspace Lists tab, click New.

   Note: If you don't see the New button, click the cog icon (🛠️) and then select Developer > Agent Workspace.

3. On the form, fill in the fields.

List filter form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List name</td>
<td>Name for the list filter that appears in the list pane. Choose one or two words that agents can easily understand, for example, Open incidents.</td>
</tr>
<tr>
<td>Category</td>
<td>Category that a list filter appears under in the list pane. The category must already exist.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that you want to retrieve records from. For example, a list filter about open incidents should retrieve records from the incidents table.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace that the list filter appears in.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Restrictions that apply to the list of records that appear with this list filter. For example, Active is true means inactive records do not appear. For more information on creating a filter, see Create a filter.</td>
</tr>
<tr>
<td>Columns</td>
<td>Columns that appear in the filtered list.</td>
</tr>
<tr>
<td>Groups</td>
<td>List of users who can view the list. Add any group to limit the list access to just that group. For example, you might add Customer Service Support. You can add more than one group to the list. If you do not add a group, any user who can access Workspace can access the list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Roles</td>
<td>Roles that can view this list filter. Remove clutter from agents' workspaces if they don't need this list filter. If you don't add a role, this list filter appears for all agents.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope that the filter applies to. Global means that you can use this filter for all applications.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the list filter appears under the list category in the list pane. Lower numbers appear above list filters with lower numbers. For example, a list filter with an order of 100 appears above a list filter with 200 under a list category.</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle to make the list filter appear or disappear in the list pane.</td>
</tr>
</tbody>
</table>

For example, the following filtered list, named Open, displays only active incidents.

4. Click **Submit**.
The list filter appears in the list pane under the category that you specified. Using the example in the previous step, the list filter, **Open**, appears under the **Incidents** list category.
New list filter displays under a category

5. To see your filtered lists:

a. Under your profile picture, click **Configure Workspace**.

b. Click the **Workspace Lists** tab.

**What to do next**

- **Highlight fields that appear in list view** to call agents' attention to them, for example, when priority is critical.
- If you are finished setting up list components, you can now set up the components in the **record view**.

**Highlight list fields in a workspace**

Use colors to highlight list fields so that you can call an agent's attention to them.

**Before you begin**

Role required: workspace_admin

**About this task**

Highlighted list fields appear colored and optionally, have a leading bullet.
The setup involves specifying the field that gets highlighted and the condition that triggers the highlighting.

1. **When you list records from this table**
2. **Highlight this field in each record**

Available colors are:
- Critical
- High
- Warning
- Moderate
- Positive
- Info
- Low

Workspace does not support highlighting the following field types:
- Reference
- URL
- Document IDs
Procedure

1. Navigate to **Workspace Experience > Administration > Highlighted Values** and click **New**.

2. On the form, fill in the fields.

### Highlighted Value form

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Name of the table that contains the fields you want to highlight.</td>
</tr>
<tr>
<td>Field</td>
<td>Name of the field that you want to highlight if the triggering conditions are met.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this component applies to. Global means that the component applies to all applications.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace that this highlighting applies to.</td>
</tr>
</tbody>
</table>

The **Field** value can be unrelated to the condition that triggers the highlighting. In the following example, if the **Caller** is Fred Luddy, workspace highlights the **Priority** field, not the **Caller** field.

3. Right-click the header and click **Save**.

You’ve specified the field where the highlights appear. Now, it’s time to specify the conditions that trigger the highlighting.

4. In **Highlighted Value Conditions**, click **New**.

5. On the form, fill in the fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditions</td>
<td>Conditions that trigger the highlighting. The condition can be different from the field that gets highlighted. For example, if the Caller in that record is Fred Luddy, you might highlight the Priority field in the record. A simpler example is highlighting the Priority field if the priority value is critical.</td>
</tr>
<tr>
<td>Status</td>
<td>Highlighting color.</td>
</tr>
<tr>
<td>Show Icon</td>
<td>Toggle to display (selected) or hide the leading bullet when highlighting. 1 - Critical</td>
</tr>
<tr>
<td>Value Override</td>
<td>Text that replaces the field values from the table. If you don't supply a Value Override, your workspace highlights the field value from the table. If you supply a value, your workspace replaces the field value with your text and highlights that. 1 - Deal with this immediately!</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this component applies to. Global means that the component applies to all applications.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which to evaluate the conditions. When you have multiple conditions for highlighting the same field, they are evaluated in order from the lowest to the highest condition. If any of the conditions are True, your workspace highlights the field.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

In the following example, the highlighting was triggered on the **Priority** field because the priority value was critical.

<table>
<thead>
<tr>
<th>Number</th>
<th>Opened</th>
<th>Short description</th>
<th>Caller</th>
<th>Priority •</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC00000002</td>
<td>2019-05-29 16:07:12</td>
<td>AGAIN UPDATED</td>
<td>Fred Luddy</td>
<td>1 - Critical</td>
<td>On Hold</td>
</tr>
<tr>
<td>INC00000031</td>
<td>2019-05-09 17:18:03</td>
<td>UPDATED VIA MULTI-EDIT</td>
<td>Joe Employee</td>
<td>1 - Critical</td>
<td>In Progress</td>
</tr>
</tbody>
</table>

7. **Optional:** Click **New** on the Highlighted Value Conditions related list and create another condition for highlighting the same field.

For example, highlight the **Priority** field that is associated with the Incident table when the **Priority** field is "critical," or when the **Caller** value is "Fred Luddy." The conditions are ranked according to the **Order** value. Workspace evaluates the lowest value first.
8. **Optional:** Remove the highlighting from a filtered list that would otherwise have highlighting. When setting up highlighting for a table, all filtered lists that are associated with the table display highlighted fields unless you disable highlighting for specific filtered lists.

   **a.** In your workspace, click your profile image and then on the Settings menu, select **Configure Workspace**.

   ![Configure Workspace](image)

   **b.** Click **Configure List Attributes**.

   **c.** In the Disable Highlighted Values column, either select the check box in the title bar of a list category to remove highlighting from all fields in the associated list category, or select the filtered list in each list category where you want to hide the highlighting.

**What to do next**
Set up the components in record view.

**Speed up how fast lists load in workspace**
Speed up how fast lists load by removing the calculation of the total number of records in a list.

**Before you begin**
Role required: workspace_admin

**About this task**
Calculating the total number of records included in a list that’s filtered from large tables can take a long time. After calculating the number of records, workspace calculates the number of pages those records fill and displays the page count.
To load lists faster, you can remove the page calculation for all or only specified filtered lists. When you remove the calculation, the total record count is not displayed and workspace removes the go-to-end-of-list icon (→).

**Procedure**

1. In your workspace, click your profile image and then, on the Settings menu, click **Configure Workspace**.

2. Click **Configure List Attributes**.

3. To omit the page calculation, in the **Omit Count** column, either:
   - Select the check box in the title bar of a list category to remove the pagination calculation for all filtered lists in the associated list category.
   - Select the filtered lists in each list category where you want to omit the page calculation.

4. Click **Save**.

**Create custom list operations in a workspace**

Create an action that enables agents to perform functions on the records in the list. For example, you can create a button that assigns a selected record to an agent.

**Before you begin**

Role required: workspace_admin

**About this task**

A list action appears as a button in list view.
When clicked, the button dispatches a predefined action in Workspace. You can create list actions to:

- Create a new record (client action)
- Assign a record to the user (client side action)
- Group actions, such as selecting multiple records and deleting them (server side action)
- Edit a record. Agents can click a button to open a side panel in list view to edit record details while still in list view.
Procedure

1. Navigate to **Workspace Experience > Actions & Components > List Actions** and click **New**.
2. On the form, fill in the fields.

### Action Assignment form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action label</td>
<td>Name of the list action. Typical names are Edit, Create New, and Update.</td>
</tr>
<tr>
<td>Action name</td>
<td>Name that describes what you’re adding.</td>
</tr>
<tr>
<td>Implemented as</td>
<td>Action type. Select <strong>Client action</strong>. The list action takes place on the client side, such as dialing a phone number, opening a record, or opening a form to edit a record.</td>
</tr>
<tr>
<td>Specify UI component</td>
<td>Component to add in the UI for this action. Shown only when <strong>Implemented as</strong> is <strong>UI component</strong>. Click the magnifying glass icon (🔍) and select the component to add as a list action.</td>
</tr>
<tr>
<td>Specify client action</td>
<td>Action taken by the client when an agent clicks the action icon. Shown only when <strong>Implemented as</strong> is <strong>Client action</strong>. Click the magnifying glass icon (🔍) and select the client action to add as a related list.</td>
</tr>
<tr>
<td>Button type</td>
<td>Primary green button, such as <strong>New</strong> in the following image. The secondary button is gray.</td>
</tr>
<tr>
<td>Tooltip</td>
<td>Text that displays when an agent points their mouse at the icon.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of this component.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this component applies to. Global means that the component applies to all applications.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace that this component belongs in, for example, Agent Workspace, ITSM, CSM, and so forth.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that this component is tied to. When a record from this table is open, this list action appears.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>View</td>
<td>Set of visual configurations. This value is typically <strong>Workspace</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle to make the icon for this list action appear.</td>
</tr>
<tr>
<td>Order</td>
<td>Integer that governs the placement of this icon in the list of list actions. A lower number means that it is higher in the list. The typical practice is to make these numbers hundreds, for example, 100, 200, 300, and 400, so you can put new icons between existing ones in the future.</td>
</tr>
</tbody>
</table>

3. Under **Related Links**, click **Advanced view**.

4. In the value field, specify the action that the button takes.

5. **Optional:** On the **Conditions** tab, use the condition builder to create filters that prevent the list actions from appearing in workspace. For example, you may hide a button to create a new record for specific tables or if the user has the wrong permissions.

6. **Optional:** On the **Confirmations Settings** tab, select the **Confirmation Required** check box if you want to display a pop-up window that asks the agent to confirm the use of this list action.

7. **Optional:** On the **Action Exclusion** tab, click **New** to exclude child tables from inheriting this list action, or this table from inheriting components from a parent table.

   a. On the form, fill in the fields.

### Action Exclusion form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action assignment</td>
<td>Function the action performs, such as, <strong>create new</strong> or <strong>agent assist</strong>. Click the magnifying glass icon (🔍) and select an action assignment.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that is associated with this component. Every time <strong>Workspace</strong> opens a record from this table, this component's icon appears in the Related Items menu.</td>
</tr>
<tr>
<td>Exclude this table</td>
<td>Toggle to prevent this <strong>Table</strong> from inheriting this component from its parent table.</td>
</tr>
</tbody>
</table>
### Field Description

| Exclude all child tables | Toggle to prevent child tables of **Table** from inheriting this component in Related Items menu. |

b. Click **Submit**.

8. Click **Update**.

### Set up the condition field length in exports

Set up the maximum number of characters that can be exported in condition fields to prevent truncated values.

**Before you begin**

Role required: admin

**About this task**

This setup only pertains to exporting condition field types, for example, **SLA definition**.

The default number of characters in the condition field types that you can export to Microsoft Excel spreadsheets is 80. If your data contains longer values, you can use the `glide.ui.export.choice_list_max_characters` system property to increase the number of characters exported. This property has no effect on the length of condition field values in tables.

**Procedure**

1. In the navigation filter, enter **sys_properties.list**.
2. In the **Name** field, search for and click `glide.ui.export.choice_list_max_characters` in the list of system properties.
3. In the System Property form, in the **Value** field, set the maximum number of characters to export in condition fields.
What to do next
Set up the components in record view.

Enable the list refresh prompt
Receive a prompt to refresh a list when a list item has changed. A prompt indicates when to refresh the list, and after refreshing, you see a visual indication showing which records changed.

Before you begin
Role required: admin

About this task
Lists are prompted to refresh when the following changes are made.

• Creation of a record or when a record meets query conditions
• Deletion or when a record no longer meets query conditions
• When a column on the list has been updated

List refresh prompt functionality works on lists that meet the following criteria.

• The list does not exceed 500 records (or the number set in glide.lists.live_list_threshold).
• The list is not a database view.
• At least one condition has been applied to the list.
• The list does not contain any dot-walked columns.
• Omit count is not enabled.
• The list is a sys_aw_list or a sys_aw_my_list. Related lists are not supported.

Procedure
1. Enable the list refresh prompt system property.
   a. Enter sys_properties.list in the Workspace filter navigator.
   b. Search for glide.lists.live_list_enabled in the System Properties list search bar.
   c. Click the Value column field and change the value to true.
Note: The live list system property is set to **false** by default.

**d.** Click the checkmark icon (✔️) to save the selection.

2. (Optional) Change the maximum number of records that the list can contain with the list refresh prompt enabled.

a. Enter `sys_properties.list` in the Workspace filter navigator.

b. Click **New**.

c. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the system property. Enter <code>glide.lists.live_list_threshold</code>.</td>
</tr>
<tr>
<td>Description</td>
<td>Description that is displayed in the System Properties list.</td>
</tr>
<tr>
<td>Choices</td>
<td>Choices for your system property. Leave this field empty.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of system property. Select <strong>Integer</strong>.</td>
</tr>
<tr>
<td>Value</td>
<td>Value for the integer. This value controls the maximum number of records that the list can contain while enabling the list refresh prompt. By default, the value is set to <strong>500</strong>.</td>
</tr>
</tbody>
</table>

Note: Although the value can be increased, be aware of the impact on your nodes.

<p>| Ignore cache | Option to ignore the cache.                                                                                                                    |
| Private      | Option to keep the system property private.                                                                                                |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read roles</td>
<td>Roles that can read the system property.</td>
</tr>
<tr>
<td>Write roles</td>
<td>Roles that can write the system property.</td>
</tr>
<tr>
<td>Application</td>
<td>Application for the system property. <strong>Global</strong> applies the system property to all applications when the system property is set to <strong>true</strong>.</td>
</tr>
</tbody>
</table>

d. Click **Submit**.

Results

Before you refresh the list, the refresh icon (🔍) displays an indicator with the number of records changed and the list header prompts you to check the refresh icon for updates.

After you refresh the list, the affected rows are displayed in bold text with an indicator badge.

⚠️ **Note:** The most recently added or updated record may not be at the top of your list. Records that are removed from the list are not displayed.
Disable list export
Create an action to disable the export button so that the button doesn't display in the Workspace UI.

Before you begin
Role required: admin

About this task
The export button is a default list action. You can control who sees this action and when based on the role of an agent, or by following any rule configured with Actions & Components. To configure list Actions & Components, see Create custom list operations in a workspace.

Procedure
1. Navigate to Workspace Experience > Actions & Components > List Actions.
2. From the Action Assignments list, select Export.
3. On the form, toggle Active.
4. Click the menu icon (≡) and select Save.

Results
The export button no longer appears in the Workspace UI and the function is disabled.
Enable inline editing in lists

Enable inline editing for Workspace lists so that you can inline edit one or multiple cells in a list column.

Before you begin

Inline editing enables you to change a field in a list instead of opening the record and changing it on the form.

After starting inline editing, rights to edit the field are verified. If the field has a dependency relationship, for example Category or Subcategory, then the popover displays all the dependent fields. Buttons appears with complex interactions to confirm or cancel the inline edit.

Inline editing is supported in most common field types. These field types include: boolean, string, choice, reference, integer, date, and date/time.

Role required: admin

Procedure

1. In the Filter navigator enter sys_properties.list.
2. Select glide.lists.inline_editing_enabled.
3. Set the value to true.

Setting up Record View in workspace

Set up the components in the Workspace Record View to optimize the user interface where agents do most of their work.

After agents select a record to work on in list view or on a Landing Page, the record displays in record view.
In this view, agents get record details, can assign records to themselves, get information about resolving the issue, and communicate resolutions with the requester. As system administrator, your job is to optimize the information presented in Record View so the agents can complete their work easily.

Adding custom components
Each component area in Record View comes with standard components that you configure. In the following component areas, you can also add custom components using the Now component library:

- Ribbon
- Contextual Side panel
- Related lists
- Related items
- List action
- Field decorator
-Modal

Now component are the building blocks of Workspace, such as lists, PAR scores, and containers.

For more information about custom components, see Custom components.

Configuring Record View components
Click a component to set it up.
Select the records agents can create in Workspace

Enable agents to create the records they need so they can do their work in Workspace.

**Before you begin**
Role required: workspace_admin

**About this task**
Agents access open records by clicking tabs above the Form Header. Agents create new records by clicking the plus (+) icon. You set up the tables agents can insert new records into.
Create a record

By default, agents only create records in the Interaction table. These records store information about interactions, such as phone or chat conversations between agents and customers. Agents typically create incidents or problems out of those conversations. As the previous image shows, the agent can only create records in the Interaction and Incident tables.

The new record appears in a new tab. In this way, agents can jump between open records just by clicking tabs. The tabs in this image show two incident records are already open. Your job is to set up the correct list of tables agents can insert records into. Agents must have create permissions on those tables.

**Procedure**

1. Navigate to Agent Workspace > New Record Menu.
2. In the New Record Menu Items form, click New.
3. In the New Record form, fill in the values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table that contains the records you want to give agents access to, for example, Incident or Case.</td>
</tr>
<tr>
<td>Workspace settings</td>
<td>Workspace the agents are working in.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of this setting’s applicability. Global means that all workspaces can use this setting.</td>
</tr>
<tr>
<td>Order</td>
<td>Placement of this table in the list of tables in the list under the plus (+) icon. Lower numbers appear higher in the list. The list appears when you hover over the plus (+) icon.</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle to make the table appear (selected) or not in the list of tables under the plus (+) icon.</td>
</tr>
</tbody>
</table>

4. Click Submit.
5. To see the records your agents can open:
a. Under your profile picture, click **Configure Workspace**.

![Configure Workspace](image)

b. On the Workspace form, click the **New Record Menu Items** tab.

**Example:**
If you added the Incident table and made the **Order** value for the Incident table lower than the **Order** value for the Interaction table, Incident appears above Interaction in the list of records an agent can create.

![Workspace Form](image)

**What to do next**
Click a component to set it up.

- **Tabs**
- **Notifications**
- **Form Header**
- **UI Actions**
- **Ribbon**
- **Related Items**
- **Form pane**
- **Actions & Components**
- **Activity Stream**
- **Contextual Side Panel**
Set up forms in Workspace

Select the fields that appear in form pane to help agents do their work.

**Before you begin**

Role required: workspace_admin

**About this task**

The form pane in Workspace displays detailed information stored in the selected record.
Each record contains more fields than can reasonably fit on the screen. Your job is to display only the fields the agents need. You perform this task for each table the agent can access. For example, form panes show the same fields for all incident records, which is likely different from the fields displayed for all case records. You can tell which tables the agents have access to by looking at the list under the plus (+) icon.

The fields displayed in forms can vary by the agent's role.

ℹ️ **Note:** Workspace does not support the display of all fields that might be in a record. For more information about supported fields, see [Supported fields in Workspace form panes](#).

### Configuring the form layout

**Procedure**

1. Navigate to **Workspace > New Record Menu**.
2. Click your avatar.
3. Select **Configure Page > Form Layout**.
4. In the configuration form, move fields into or out of the **Selected** column using the arrows between the **Available** and **Selected** columns.

The fields in the **Selected** column appear in the form pane. For a description of some of the fields, see [Supported fields in Workspace form panes](#).

Available items that appear in green followed by a plus (+) sign represent related tables. To access the fields on these tables, use dot-walking.
5. Use the up and down arrows to the right of the **Selected** column to move highlighted fields up or down in the column.

6. In the **View name** list, select the workspace you're configuring, for example, **Workspace_itil**. These views correspond to **agent roles**.

7. **Optional**: Add a field to the **Selected** column that's not in the **Available** column.

   a. Under **Create new field**, fill in the fields.

   
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the new field.</td>
</tr>
<tr>
<td>Type</td>
<td>Data type of the values in the field.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field length</td>
<td>Maximum length of the string value, if you select String as the <strong>Type</strong>. This field does not display for other types.</td>
</tr>
</tbody>
</table>

b. Click **Add**.

8. Click **Save**.

**Note:** Do not add the same field to more than one section of a form unless the field displays read-only data. Having two or more instances of an editable field can cause data loss and prevent the proper functioning of UI and data policies.

**Example:**
The following image shows the addition of the **Category** and **Subcategory** fields in the form pane.

**New fields in form pane**

---

**What to do next**

- **Hide some of the fields displayed in forms** based on an agent's permissions or set up a different component.
- Click a component to set it up.

- Tabs
- Notifications
- Ribbon
- Related Items
- Activity Stream
- Contextual Side Panel
Hide fields from agents in Workspace

Specify the fields that display in the form pane depending on the agent’s role. Only display the fields in the form pane agents need to do their work.

Before you begin
Role required: workspace_admin

About this task
By default, agents see all of the record fields configured to display in the form pane. You can hide fields from agents according to their role. Hiding field values de-clutters the form pane for them.

Procedure
1. Navigate to Workspace Experience > Forms > Workspace View Rules.
2. Click New.
3. In the Workspace View Rule form, fill in the fields.
## Workspace View Rule

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the rule. Typically, the name expresses what agents are affected by the rule and what privileged information they are allowed to see.</td>
</tr>
<tr>
<td>Table</td>
<td>Table this rule applies to. You can define view rules only at the table level and only once per table.</td>
</tr>
<tr>
<td>View</td>
<td>Select the form view to render for the conditions set. A view defines the elements that appear when an agent opens a form or list. The view corresponds to an agent's role.</td>
</tr>
<tr>
<td>Application</td>
<td>Application this rule applies to. Global means the rule applies to all applications.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace affected.</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle to make this rule active (selected) or not.</td>
</tr>
</tbody>
</table>

**4. Optional:** On the **Conditions** tab, select the roles people must have in order to see the field.  
Use the role selection picker:
In the following example, only an admin or agent_admin will see the **State** field in the form pane if the **State** is **New**. Everyone will see the **State** field in the form pane if the **State** field has a different value.

**View rule condition**

Roles: admin, agent_admin

Conditions:
- Add Filter Condition
- Add "OR" Clause

All of these conditions must be met

<table>
<thead>
<tr>
<th>State</th>
<th>is</th>
<th>New</th>
</tr>
</thead>
</table>

5. Click **Submit**.

**Results**

Users with the specified roles can see the fields for the specified table.

If there are multiple Workspace View Rules in place, the rule with the lower execution order applies. If the execution order is the same for multiple rules, the first rule created applies.

**What to do next**

Set up form annotations to highlight form fields, or set up a different component.

Click a component to set it up.

- Tabs
- Notifications
- Form Header
- UI Actions
- Ribbon
- Related Items
- Form pane
- Actions & Components
- Activity Stream
- Contextual Side Panel
Set up form views based on Agent roles

Set different form views for different agent roles to display on the fields the agent needs to see.

Agent roles can be based on permission levels or products, for example, CSM (for cases) or ITSM (for incidents). A workspace view is configured for each type of agent. Views use the following role-based hierarchy to determine which form the agent sees in Workspace.

Any view/role combination that results in the **Default** form view is read-only.

<table>
<thead>
<tr>
<th>Role</th>
<th>Form view</th>
</tr>
</thead>
<tbody>
<tr>
<td>itil</td>
<td>1. workspace_itil</td>
</tr>
<tr>
<td></td>
<td>2. workspace</td>
</tr>
<tr>
<td></td>
<td>3. default</td>
</tr>
<tr>
<td>sn_esm_agent</td>
<td>1. workspace_csm</td>
</tr>
<tr>
<td></td>
<td>2. workspace</td>
</tr>
<tr>
<td></td>
<td>3. default</td>
</tr>
</tbody>
</table>
### Supported fields in Workspace form panes

Check which fields Workspace supports so that you can plan which fields to display in the form pane.

Workspace can display in the **form pane** all of the following fields found in records.

<table>
<thead>
<tr>
<th>Field type</th>
<th>Description</th>
<th>Supported properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choice</td>
<td>List of configurable choices.</td>
<td>N/A</td>
</tr>
<tr>
<td>Conditions</td>
<td>Field that adds the condition builder to a form. You must specify a dependent field that references the table name.</td>
<td>N/A</td>
</tr>
</tbody>
</table>
| Currency     | Decimal field with four digits after the decimal point. When displayed on a form, a currency field also includes an additional choice list for selecting the currency type. If there is no default value for the field, empty currency fields use the reference currency. Adding a value causes the field to update. | • glide.currency_price.use_all_fraction_digits  
• glide.system.locale  
• glide.i18n.single_currency  
• glide.i18n.single_currency.code  
• glide.currency_price.use_all_fraction_digits |
<table>
<thead>
<tr>
<th>Field type</th>
<th>Description</th>
<th>Supported properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>to use the session currency of the active user. See for how to use two fraction digits.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> Once you assign this type to a field, you cannot change it to an <strong>FX Currency</strong> type.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date</td>
<td>Day, which can be selected with a calendar widget.</td>
<td>glide.ui.date_picker.first_day_of_week</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Day and time of day, which can be selected with a calendar widget.</td>
<td>glide.ui.date_picker.first_day_of_week</td>
</tr>
<tr>
<td>Decimal</td>
<td>Number with up to two digits after the decimal points (for example, 12.34).</td>
<td>glide.system.locale</td>
</tr>
<tr>
<td>Document ID</td>
<td>Reference to any record on any table.</td>
<td>N/A</td>
</tr>
<tr>
<td>Domain ID</td>
<td>System field that contains a reference to the domain. Users only select from domains they have access to. When the form is saved the domain path shows beneath the field. The field defaults to global. System field that contains a reference to the domain.</td>
<td>N/A</td>
</tr>
<tr>
<td>Duration</td>
<td>Length of time. Stored in the database as an integer number of milliseconds, but appears in days, hours, minutes, and seconds.</td>
<td>N/A</td>
</tr>
<tr>
<td>Email</td>
<td>Field for an email address. Entries must contain @ and a top-level domain, such as .com or .edu.</td>
<td>N/A</td>
</tr>
<tr>
<td>Encrypted text</td>
<td>Field that is encrypted for security. Depending on the</td>
<td>N/A</td>
</tr>
<tr>
<td>Field type</td>
<td>Description</td>
<td>Supported properties</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>encryption context</td>
<td>The field may be hidden, the value may be hidden, or field and value may displayed.</td>
<td>N/A</td>
</tr>
<tr>
<td>Floating point number</td>
<td>Number with up to seven digits after the decimal point.</td>
<td>N/A</td>
</tr>
<tr>
<td>FX (Foreign Exchange)</td>
<td>Fields used as an alternative to the default currency fields. FX fields are highly configurable, support use of custom rate tables, report aggregations, and provide for improved visibility into conversion calculations.</td>
<td>N/A</td>
</tr>
<tr>
<td>IP Address</td>
<td>Variable character field that stores IPv4 and IPv6 addresses. See IP Address Field Type for more information.</td>
<td>N/A</td>
</tr>
<tr>
<td>Image</td>
<td>Field that enables image uploading. Once the image is uploaded, the image is viewed in the document viewer. Supports the following file types: .jpg, .png, .bmp, .gif, .jpeg, .ico, and .svg.</td>
<td>N/A</td>
</tr>
<tr>
<td>Integer</td>
<td>Number with zero decimal points.</td>
<td>glide.system.locale</td>
</tr>
<tr>
<td>Field type</td>
<td>Description</td>
<td>Supported properties</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong> To search for an integer, input <code>=</code> followed by the integer in the search bar. For example, if you want to search for an Order of 100, input <code>=100</code>.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Journal Input</td>
<td>Field that accepts text entries but does not display previous entries.</td>
<td>glide.ui.textarea.character_counter</td>
</tr>
<tr>
<td>List</td>
<td>Reference field that accepts multiple references rather than just one.</td>
<td>• glide.ui.max_ref Dropdown</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• glide.ui.reference.disable_displayvalue</td>
</tr>
<tr>
<td>Password (1-way encrypted)</td>
<td>Text field that stores passwords with one-way encryption. One-way encryption stores the password as a secure hash value that cannot be decrypted.</td>
<td>N/A</td>
</tr>
<tr>
<td>Percent Complete</td>
<td>Field that accepts decimal input and appears as progress bars when displayed in lists.</td>
<td>N/A</td>
</tr>
<tr>
<td>Phone number</td>
<td>String field that provides E164-compliant formatting and validation for telephone numbers.</td>
<td>glide.ui.format_phone</td>
</tr>
<tr>
<td>Price</td>
<td>Currency field that enables control over conversions and display. For more information, see Price fields.</td>
<td>• glide.i18n.single_currency</td>
</tr>
<tr>
<td></td>
<td>Switch between these three price value types:</td>
<td>• glide.i18n.single_currency.code</td>
</tr>
<tr>
<td></td>
<td>• Calculated (default)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Fixed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Multi</td>
<td></td>
</tr>
<tr>
<td>Field type</td>
<td>Description</td>
<td>Supported properties</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>Radio Button Choice</td>
<td>Multiple choice button used to select one option amongst two or more choices.</td>
<td>N/A</td>
</tr>
</tbody>
</table>
| Reference           | Query that displays records from another table.                             | • glide.ui.max_ref_dropdown  
                      |                                                | • glide.ui.reference.readonly.clickthrough        |
| Single File Attachment | Attachment reference that enables you to reference a single file attached to the menu item or section record. | N/A                                                 |
| String              | For 255 characters or less, the string field is a single-line text field. Anything 256 characters or over appears as a multi-line text box. | glide.ui.textarea.character_counter             |

**Note:** The database may translate the value that you provide in the **Max length** field to the closest matching database field type. For example, a max string length of 80 maps to the nearest database field type of VARCHAR(100).

For Oracle instances, users are not able to increase the max length of a string field to a value greater than 4000 through the application UI. Changes greater than 4000 require the CLOB data type in Oracle. If you require a field to be larger than 4000 characters, log an incident to request the change.

<p>| Suggestion          | String field that provides suggested values but accepts free-form text. Available when | N/A                                                 |</p>
<table>
<thead>
<tr>
<th>Field type</th>
<th>Description</th>
<th>Supported properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>you add a field by configuring a form or list. Otherwise, you must modify the dictionary entry of an existing string or journal field.</td>
<td>glide_element_sys_class_name</td>
<td></td>
</tr>
<tr>
<td>System class name</td>
<td>Display the value of the current table that the record is on and a list of tables that are hierarchically related. For more information, see Table extension and classes.</td>
<td>N/A</td>
</tr>
<tr>
<td>Time</td>
<td>Specific time. Stored in the database as a date/time field. Only the time part of this field is used.</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field always stores the date as 1970-01-01, which does not fall within the dates for Daylight Savings Time (DST). As a result, the time is not automatically adjusted for DST. If a custom feature uses time as a start time, it is the responsibility of the feature to adjust for DST, if necessary.</td>
<td></td>
</tr>
<tr>
<td>Translated HTML</td>
<td>HTML field that displays different translations that are based on the user's language.</td>
<td>N/A</td>
</tr>
<tr>
<td>Translated text</td>
<td>Text field that displays different translations that are based on the user's language. For more information, see Translating text fields.</td>
<td>N/A</td>
</tr>
<tr>
<td>Field type</td>
<td>Description</td>
<td>Supported properties</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>True/False</td>
<td>Boolean field that appears as a one-digit integer, typically 1 (true) or 0 (false).</td>
<td>N/A</td>
</tr>
<tr>
<td>URL</td>
<td>String field that is a clickable URL field when locked.</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> In the mobile UI, this field appears as a multi-line text field. The field saves as a single line, with the line breaks removed.</td>
<td></td>
</tr>
<tr>
<td>UTC Time</td>
<td>Number of minutes in the hour based on the UTC time zone.</td>
<td>N/A</td>
</tr>
<tr>
<td>Workflow</td>
<td>Choice list field that displays a stage in a workflow.</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Next**
Click a component to set it up.

- Tabs
- Notifications
- Form Header
- UI Actions
- Ribbon
- Related Items
- Form pane
- Actions & Components
- Activity Stream
- Contextual Side Panel
Add help to a field label

Create field-level help in forms by placing help icons in individual fields and converting the field labels to links to external or internal URLs.

Before you begin
Role required: personalize_dictionary

About this task
You can link to any type of file, document, or wiki, and open it in a separate browser window. The following is an example of a form with field label help enabled.

Field label help enabled

Procedure
1. Open the form.
2. Right-click the label for the field and select **Configure Label**.
   The Field Label form appears. The fields in the top portion of the form are pre-populated. The Help field is not currently used.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Type text to use as a tooltip that appears when a user places the cursor on the field label.</td>
</tr>
<tr>
<td>URL</td>
<td>Enter the URL of the target file to open when the field label or icon is clicked. This can be a complete URL to a file outside the instance, or a relative URL to a target on the instance.</td>
</tr>
</tbody>
</table>

**Note:** Links aren't supported in Workspace.

| URL target | Not used. The help file opens in a new tab regardless of the URL target value. |

4. Click **Update**.

**Results**

Help appears when you select or hover over the field.

![Test tooltip](https://docs.servicenow.com/documentation/geneva/product/discovery/concept/0_ConfigureIPAddresses.html)
Set up form annotations
Highlight form elements by displaying blocks of colored text or separators between form elements.

Before you begin
Role required: admin

About this task
Form annotations are colored lines or colored lines of text that you can insert between fields in the form pane.

Procedure
1. Navigate to a form.

2. Click the context menu icon ( ) and select **Configure > Form Layout**.

3. Under **Form view and section**, select a section.

4. In the Available list, double-click *Annotation* to move it to the **Selected** list. The Annotation Details section appears.
5. Place it above the field to annotate.

6. In Annotation Details, select the type of annotation. The available types of annotations include **Info Box Blue**, **Info Box Red**, **Line Separator** (any text you add appears beneath the line), **Section Details**, **Section Separator**, and **Text**.
## Incident

<table>
<thead>
<tr>
<th>Field</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>INC0009005</td>
</tr>
<tr>
<td>Caller</td>
<td>David Miller</td>
</tr>
<tr>
<td>Location</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Software</td>
</tr>
<tr>
<td>Subcategory</td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td></td>
</tr>
<tr>
<td>Configuration item</td>
<td></td>
</tr>
<tr>
<td>Text Impact</td>
<td>1 · High</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
7. Select either Plain Text or HTML for the data type and enter the annotation in the text box. All valid HTML tags are supported.

For example, select the Text annotation type, the HTML data type, and enter `<span style="color:red">Select the primary location:</span>`. The text appears red on the form.

8. Click Save.

What to do next
Click a component to set it up.

• Tabs
• Notifications
• Form Header
• UI Actions

• Ribbon
• Related Items
• Form pane
• Actions & Components

• Activity Stream
• Contextual Side Panel

Configure change and problem task records in Workspace
Configure the record types that are available when you create a change or problem task from a related list in Workspace. This configuration enables you to categorize your change and problem task records according to your preferred categorization.
Before you begin
Role required: admin

About this task
• Types can be changed in the **Type** field on the Workspace form.
• Display values appear in Workspace lists.

Change and problem task example types include the following.
• Change: Normal, Standard, Emergency
• Problem: General, Root Cause Analysis

Procedure
1. Navigate to **Change > Workspace Record Type Selectors**.
2. Select a Workspace record types selector, or click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target table</td>
<td>Table associated with the change or problem request. For example, Change Request or Problem Task.</td>
</tr>
<tr>
<td>Target field</td>
<td>Field type for the record. This field determines the selections in the <strong>Type</strong> field on the Workspace form.</td>
</tr>
<tr>
<td>Value</td>
<td>Specific value from the target field that is displayed on the Workspace form. Change the value on the Workspace form by selecting another value from the list.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this Workspace record types selector applies to. Global means that the Workspace record types selector applies to all Workspace applications.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the Workspace record types selector.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Order</td>
<td>Integer that determines the placement of this Workspace record types selector in the Workspace Record Types Selectors list. The lower the number, the earlier it appears in the list. Typically, these numbers are in the hundreds. For example, 100, 200, 300, and 400.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Disable Document Viewer in Workspace**

Disable Document Viewer at the instance level in Workspace to disable it or at table level to disable it for specific tables within the instance.

**Before you begin**

Ensure the system property `(com.snc.documentviewer.enable_document_viewer)` exists in your instance.

Role required: admin

**About this task**

The legacy form attachment preview is displayed when document viewer is disabled.

**Procedure**

Disable Document Viewer at the instance level or for specific tables.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Document Viewer at the instance level</td>
<td>a. Search for <code>sys_properties.list</code> in the navigation filter.</td>
</tr>
<tr>
<td></td>
<td>b. Set the system property <code>com.snc.documentviewer.enable_document_viewer</code> value to <code>false</code>.</td>
</tr>
<tr>
<td></td>
<td>c. Click <strong>Update</strong>.</td>
</tr>
<tr>
<td>Disable Document Viewer at the table level</td>
<td>a. Navigate to <strong>System Definition → Dictionary</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Open the table and click <strong>New</strong> under the <strong>Attributes</strong> tab.</td>
</tr>
</tbody>
</table>
Option | Description
---|---
c. Search for **Use Document Viewer** in the **Attribute** field.
d. Enter **false** in the **Value** field.
e. Click **Submit**.

**Change the default form section navigation in Workspace**

Change the default form section navigation of your Workspace Experience. By changing the form section navigation, you can simplify forms that are less complex and don’t need form section navigation or section collapsing.

Configure form section navigation.

- Auto-collapse form sections on load.
- Hide section navigation.
- Disable section collapsing.

**Set up form section auto-collapse on load**

Set up auto-collapsing of one or more form sections using client scripts.

**Before you begin**

The collapsed sections can be expanded by using the section collapse or expand control on the form.

Role required: admin

**Procedure**

1. Navigate to **System Definition > Client Scripts**.
2. Click **New**.
3. On the form, fill in the fields.

   ✓ **Note**: See the example configuration to configure section auto-collapse.

**Client Script form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the client script.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to associate with the client script. For example, <strong>Incident</strong>.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
UI Type | UI type for the client script. Choose Desktop, Mobile/Service Portal, or All.
Type | Type of client script. Select the event that triggers the script to run from the Type list.
Application | Scope of the client script applicability. Global means that all workspaces can use this setting.
Active | Option to activate the client script.
Inherited | Option to enable inherited client script.
Global | Global means all workspaces can use this setting.
Description | Description of the client script that also displays in the Client Scripts list.
Messages | Additional information about the client script.

4. Input `input g_aw.setSectionExpanded('section_name', false);` in the scripting field and modify the section name you want to auto-collapse. For example, `g_aw.setSectionExpand('related_records', false);`.

Note: Enter all the forms sections on separate lines to enable auto-collapse on load for all the form sections.

5. Click Submit.

Example:
Example Client Script form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for your client script. For example, Auto Collapse.</td>
</tr>
<tr>
<td>Table</td>
<td>Select Incident.</td>
</tr>
<tr>
<td>UI Type</td>
<td>Select All.</td>
</tr>
<tr>
<td>Type</td>
<td>Select onLoad.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Application</td>
<td>Maintain Global as your application.</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle Active.</td>
</tr>
<tr>
<td>Inherited</td>
<td>Skip this option.</td>
</tr>
<tr>
<td>Global</td>
<td>Toggle Global.</td>
</tr>
<tr>
<td>Description</td>
<td>Skip this field.</td>
</tr>
<tr>
<td>Messages</td>
<td>Skip this field.</td>
</tr>
</tbody>
</table>

**Hide form section navigation**

Hide the default form section navigation to disable jump-to section navigation on forms. Simplify forms that are less complex and don't benefit from form section navigation.

**Before you begin**

Role required: admin

**About this task**

The form section control displays at the of a form.
Procedure

1. Navigate to **Workspace Experience > Forms > Workspace View Rules**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for your Workspace view rule.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to apply your Workspace view rule. For example, <strong>Incident</strong>.</td>
</tr>
<tr>
<td>View</td>
<td>View for your Workspace view rule.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for your Workspace view rule.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace for your Workspace view rule. Associate workspace view rule to a specific workspace.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the Workspace view rule.</td>
</tr>
</tbody>
</table>

4. In related lists, click the **Form Settings** tab.
5. Select **Hide section navigation**.
6. Click **Submit**.

Results

The form section control is removed from the form.
### Incident

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>INC0009005</td>
<td>Contact type</td>
<td>-- None --</td>
</tr>
<tr>
<td>Caller</td>
<td>David Miller</td>
<td>State</td>
<td>New</td>
</tr>
<tr>
<td>Category</td>
<td></td>
<td>Impact</td>
<td>1 - High</td>
</tr>
<tr>
<td>Subcategory</td>
<td></td>
<td>Urgency</td>
<td>1 - High</td>
</tr>
<tr>
<td>Email</td>
<td></td>
<td>Priority</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>Service</td>
<td></td>
<td>Assignment group</td>
<td></td>
</tr>
<tr>
<td>Configuration Item</td>
<td></td>
<td>Assigned to</td>
<td></td>
</tr>
</tbody>
</table>

### Disable form section collapsing

Disable default form section collapsing. Simplify forms that are less complex and don’t benefit from section collapsing.

**Before you begin**

Role required: admin

**About this task**

The form section collapse appears at the top of each section on the form.
Procedure

1. Navigate to **Workspace Experience > Forms > Workspace View Rules**.
2. Click **New**.
3. On the form, fill in the fields.

**Workspace View Rule form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for your workspace view rule.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to apply your Workspace view rule. For example, <strong>Incident</strong>.</td>
</tr>
<tr>
<td>View</td>
<td>View for your Workspace view rule.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for your Workspace view rule.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace for your Workspace view rule.Associate Workspace view rule to a specific Workspace.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the Workspace view rule.</td>
</tr>
</tbody>
</table>

4. Click the **Form Settings** related list.

5. Select **Disable section collapsing**.

6. Click **Submit**.

**Results**

Form section collapsing is disabled on the form.

**Incident**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>INC0090005</td>
</tr>
<tr>
<td>Caller</td>
<td>David Miller</td>
</tr>
<tr>
<td>State</td>
<td>New</td>
</tr>
<tr>
<td>Impact</td>
<td>1 - High</td>
</tr>
<tr>
<td>Urgency</td>
<td>1 - High</td>
</tr>
<tr>
<td>Priority</td>
<td>1 - Critical</td>
</tr>
</tbody>
</table>

**Set up form headers in workspace**

Configure the primary field and secondary values in form headers so that agents can quickly orient themselves to an issue.
Before you begin
Role required: workspace_admin

About this task
Form headers provide an overview of the record. They have two lines:

• Primary field—The top line that serves as the title for the page, such as Laptop won't boot, as shown in the following image. Typically, this is the value of the Short Description field in the record.

• Secondary value—The line below the primary field consists of read-only, name-value pairs of important record information, such as Priority: 5 - Planning. Workspace displays up to the first seven, non-null secondary fields. You can highlight these fields and make them appear conditionally. If you do not have the required role, you would not see the associated secondary value. You can set conditions that have to be met for a secondary value to appear, for example, Active=true.

Your job is to set up what appears in the primary and secondary fields for your agents.

Child tables inherit form header configurations from their parent tables. Form header configurations on a child table take precedence over parent table configurations. For example, if the Incident table does not have a form header configuration, the table inherits all form header configurations from its parent, the Task table.

Procedure
1. Navigate to Forms > Form Headers and click New.
2. On the form, fill in the fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table that is associated with this form header. Whenever an agent selects a record from this table, this form header appears.</td>
</tr>
<tr>
<td>Primary field</td>
<td>Field that appears on the top of the form header and acts like the title of the record. Normally, the field is unique and descriptive, such as short_description. This field helps the agent understand what the record is about.</td>
</tr>
<tr>
<td>Subheading</td>
<td>Value displayed on the form header that is dependent on the Table selection.</td>
</tr>
<tr>
<td>Header Image</td>
<td>Image to display on the form header from an image field. Header images give context to records. They can be set to show agent avatars, differentiate between domains, etc.</td>
</tr>
</tbody>
</table>

*Note:* Header images can only be selected from user image files.

<table>
<thead>
<tr>
<th>Hide Tags</th>
<th>Toggle to hide tags.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore Highlight</td>
<td>Toggle to turn off (selected) highlighting in the form header for fields configured to be highlighted.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of this setting's applicability. Global means that all workspaces can use this setting.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace that is associated with this form header.</td>
</tr>
</tbody>
</table>

3. In the Secondary Values related list, select a field.

4. On the form, fill in the fields.

### Secondary values form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Secondary fields that appear in the form header whenever records from this table are open.</td>
</tr>
<tr>
<td>Field</td>
<td>Secondary field's name.</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle to make the secondary fields appear in the form header.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Order</td>
<td>Arrangement of secondary fields. A lower number means that it is further left in the row of fields.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of this setting’s applicability. Global means that all workspaces can use this setting.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace that is associated with these secondary values.</td>
</tr>
<tr>
<td>Active</td>
<td></td>
</tr>
<tr>
<td>Conditions</td>
<td>Filters that can hide the secondary field. For example, the Field value, <strong>Closed By</strong> appears only if the condition <strong>Active</strong> is <strong>false</strong>.</td>
</tr>
<tr>
<td>Roles</td>
<td>Roles that a user must have for the secondary fields to appear. Click the lock icon (🔒) and select the roles.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

6. To add additional secondary values, click **New** and fill out the table again.

**What to do next**

Highlight values in the form header to call agents' attention to them or set up a different component.

Click a component to set it up.

- Tabs
- Notifications
- Form Header
- UI Actions
- Ribbon
- Related Items
- Form pane
- Actions & Components
- Activity Stream
- Contextual Side Panel
Highlight values in the form header

Highlight secondary field values in the form header in Workspace to alert agents to important information.

Before you begin
Role required: admin

About this task
Highlighted secondary-field values appear with a background color in the form header.

To configure highlights, you specify the fields in tables that should appear highlighted when displayed in the secondary fields of a form header. In that way, whenever any agent accesses a record from the specified table, the configured secondary fields appear highlighted.
Procedure
1. Navigate to **Workspace Experience > Administration > Highlighted Values** and click **New**.
2. On the form, fill in the fields.

### Highlighted Value form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table that contains the field that you want to highlight in the form header.</td>
</tr>
<tr>
<td>Field</td>
<td>Field that you want to highlight.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

4. In the Highlighted Values list, click the record you just created.

5. In the Highlighted Value Conditions related list, and click **New**.

6. On the form, fill in the fields.

### Highlighted Value Condition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditions</td>
<td>Condition builder where you can set the conditions for your highlighted value to display.</td>
</tr>
<tr>
<td>Status</td>
<td>Background color. Each status has its own color, for example, Critical displays a red background, Moderate displays a purple background, and Info displays a blue background.</td>
</tr>
<tr>
<td>Show icon</td>
<td>Toggle that makes a small circle display in addition to the background coloring.</td>
</tr>
<tr>
<td>Value Override</td>
<td>Text that renders instead of the Status value. For example, instead of &quot;Critical,&quot; you can display, &quot;Address this immediately.&quot; You can reference a text value using {{value}}.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains the record.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the highlighted values are evaluated.</td>
</tr>
</tbody>
</table>
**Example: Configure a highlighted value**

Configure a highlighted value for the **Priority** field in problem records when the priority is **1 - Critical**. Select the Incident table and the **Priority** field when creating this highlighted value.

In the **Highlighted Value Conditions**, set the conditions to be **Priority is 1 - Critical** and **Status Critical** and check **Show icon**.

The highlighted value renders for this configuration:

---

**Employee payroll application server is down.**

<table>
<thead>
<tr>
<th>Priority</th>
<th>State</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Critical</td>
<td>New</td>
<td>Hardware</td>
</tr>
</tbody>
</table>

---

**What to do next**

Prevent agents from tagging records or set up a different component.

Click a component to set it up.

---

- Tabs
- Notifications
- Form Header
- UI Actions
- Ribbon
- Related Items
- Form pane
- Actions & Components
- Activity Stream
- Contextual Side Panel
Disable tagging
Prevent agents from tagging records in Workspace.

Before you begin
Role required: admin

About this task
Tags are text labels that agents add to records to organize them. The Tag icon (🏷️) appears in the Form Header.

Tag in form header

Unable to completely uninds…

Priority State Category

Yay! In Progress System Applicati…

After tagging a record, an agent can search for it by entering the tag name in the global search field. Agents add tags by clicking the Tag icon, which displays the Add Tag field.
For more information about using tags, see Tag records in Workspace.

**Procedure**

To prevent agents from tagging records on an entire instance, in the `glide.ui.show_form_tags_bar` system property, set `Type = true | false` and `Value = false`. The Tag icon doesn’t appear on records stored in the instance.

**What to do next**

Click a component to set it up.

- Tabs
- Notifications
- Form Header
- UI Actions
- Ribbon
- Related Items
- Form pane
- Actions & Components
- Activity Stream
- Contextual Side Panel
Set up ribbons in workspace

Set up ribbons in Workspace to help agents quickly scan relevant information about a record, such as the record's time line, a customer summary, and record SLAs.

Before you begin
Role required: workspace_admin

Ribbons provide contextual information about the record displayed in the form. Ribbons do not display by default. Each ribbon can have multiple components and each can occupy a configured amount of screen space. You cannot configure what is in each ribbon component. Ribbon components include:

- **Customer360**—Provides contact information about the account, contact, or consumer in the record.

- **Timeline**—Shows an at-a-glance overview of the activities associated with the record, for example, was there a lot of activity early on and then things went quiet for a while? Were there long delays in communications between the agent and the customer's response? On the right side, the timeline shows how long the agent spent working on the case (**With Agent**) and how long
the agent has waited for info from the customer (With Customer). A case is considered to be with the agent when it is in the New, Open, or Closed state. A case is considered to be with the customer when it is in the Awaiting Info or Resolved state.

- Active SLA—Provides a countdown to the time when the record violates SLA standards.

You associate ribbons with tables. Only one ribbon can be associated with a table. Whenever an agent selects a record from a table associated with a ribbon, the ribbon appears. If the agent then selects a record from a table not associated with a ribbon, the ribbon disappears.

You add components to ribbons one at a time. To add multiple components to a ribbon, repeat the following procedure multiple times, each time adding a different component. You must also repeat the following procedure for each table you want to associate with a ribbon.

Configure ribbon.

**Procedure**

1. Navigate to **Workspace Experience > Forms > Ribbon Settings.**
2. Click **New.**
3. On the New record form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Label that describes this ribbon setting. It often includes the table associated with this ribbon.</td>
</tr>
<tr>
<td>Ribbon component</td>
<td>Component to add to the ribbon, including Customer360, Timeline, Active SLA or a custom ribbon component. You can only add one component at a time. To make a second component appear in the ribbon, repeat this procedure and add a different component.</td>
</tr>
<tr>
<td>Table</td>
<td>Table associated with this ribbon. Any time an agent selects a record from this table, the ribbon appears with this component.</td>
</tr>
<tr>
<td>Width</td>
<td>Number of columns the component occupies in the ribbon. The width of the page is 12 columns. When using multiple components, the total combined width of all the components must equal 12 or less.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of this ribbon. Global means the ribbon works with all applications.</td>
</tr>
<tr>
<td>Workspace</td>
<td>The workspace that uses this ribbon configuration. If this field is empty, the ribbon configuration applies to all workspaces. The <strong>Workspace</strong> field is empty by default.</td>
</tr>
<tr>
<td>Order</td>
<td>Location of this component in the ribbon. Ordering the components goes from left to right. For example, if you associated three components with a table, the component with the lowest order would be on the left and the component with the highest order would be on the right.</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle to turn this component on/off in the ribbon for this table.</td>
</tr>
<tr>
<td>Inherit</td>
<td>If set to true, the ribbon configuration can be inherited by child tables. For this to be effective, a child table should not have any configured ribbon settings. The <strong>Inherit</strong> field is false by default.</td>
</tr>
</tbody>
</table>

4. Right-click the header and select **Save**.

If the **Ribbon component** is either Customer360 or Timeline, the **Ribbon Component Attributes** form appears so you can specify the values that
go into the component. Other ribbon component type attributes are not configurable.

5. Optional: Add a custom component to the ribbon.

a. Click the magnifying glass icon (🔍) next to **Ribbon component**.

b. In the Ribbon Components form, click **New**.

c. In the form, fill in the fields.

<table>
<thead>
<tr>
<th><strong>Ribbon Component</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Name</td>
<td>Name of the Now component.</td>
</tr>
<tr>
<td>UX Component</td>
<td>Click the magnifying glass icon (🔍), in the Application column, find components associated with Agent Workspace and select one. Alternative, click <strong>New</strong> to associate a script with a new component you’ve written and then add that in the UX Component field.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of the Now component.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this component applies to. Global means that the component applies to all applications.</td>
</tr>
</tbody>
</table>

d. Click **Submit** on the Ribbon Components form.

e. Click **Submit** on the New record form to add the Now component to the ribbon.

6. In the **Ribbon Component Attributes** form, fill in the values. The form depends on the **Ribbon component**.

a. If your **Ribbon component** is **Customer360**, fill in the form.

The values specify the source and the kind of the information displayed in this component.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary user</td>
<td>Table column in the <strong>Primary reference table</strong> to use when retrieving name and contact information for this component, for example, <strong>Assigned to</strong> or <strong>Caller</strong>. If this value is missing in the table, Workspace inserts the values specified in <strong>Secondary user</strong>.</td>
</tr>
<tr>
<td>Primary reference table</td>
<td>The table that stores information for the <strong>Primary user</strong> field.</td>
</tr>
<tr>
<td>Primary fields</td>
<td>Table column values in the <strong>Primary reference table</strong> displayed in this component, for example, name, email, phone number, etc.</td>
</tr>
<tr>
<td>Secondary user</td>
<td>Table column in the <strong>Secondary reference table</strong> to use when retrieving name and contact information for this component if the value is missing for the <strong>Primary user</strong>. For example, <strong>Assigned to</strong>. If this value is missing in the table, Workspace inserts the values specified in <strong>Tertiary user</strong>.</td>
</tr>
<tr>
<td>Secondary reference table</td>
<td>The table that stores information for the <strong>Secondary user</strong> field.</td>
</tr>
<tr>
<td>Secondary fields</td>
<td>Table column values in the <strong>Secondary reference table</strong> displayed in this component, for example, name, email, phone number, etc. when Workspace uses the <strong>Secondary user</strong>.</td>
</tr>
<tr>
<td>Tertiary user</td>
<td>Table column in the <strong>Tertiary reference table</strong> to use when retrieving name and contact information for this component if the value is missing for the <strong>Secondary user</strong>. For example, <strong>Assigned to</strong>. If this value is missing, no information displays in this component.</td>
</tr>
<tr>
<td>Tertiary reference table</td>
<td>The table that stores information for the <strong>Tertiary user</strong> field.</td>
</tr>
<tr>
<td>Tertiary fields</td>
<td>Table column values in the <strong>Secondary reference table</strong> displayed in this component, for example, name, email, phone number, etc. when Workspace uses the <strong>Tertiary user</strong>.</td>
</tr>
</tbody>
</table>
b. If your Ribbon component is **Timeline**, specify the role of the person who works on the task summarized in the record.

Generally, the fulfiller is the agent, for example, `sn_esm_agent`. The fulfiller role is different for different versions of Workspace, for example, ITSM and CSM. The timeline shows activities performed by the fulfiller and requester. You can configure the fulfiller and requester labels in the time line using the Resolution Shaper. The **Fulfiller Label** in the Resolution Shaper Config form should match the **Fulfiller role** attribute. For example, if the **Fulfiller role** is set to `sn_esm_agent`, which is an agent role, the **Fulfiller Label** should refer to an agent. For more information about the resolution shaper configuration, see [Customer service case timeline](#).

7. Click **Submit**.

The ribbon appears when an agent selects a record from the specified table. Each component is filled with the information specified in the ribbon component attributes.

**Form ribbon**

![Form ribbon image]

8. **Optional:** Repeat this procedure if you want to add a different component to the same ribbon, or if you want to add a ribbon to a different table.

**What to do next**

Click a component to set it up.

<table>
<thead>
<tr>
<th>Tabs</th>
<th>Ribbon</th>
<th>Activity Stream</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notifications</td>
<td>Related Items</td>
<td>Contextual Side Panel</td>
</tr>
<tr>
<td>Form Header</td>
<td>Form pane</td>
<td></td>
</tr>
<tr>
<td>UI Actions</td>
<td>Actions &amp; Components</td>
<td></td>
</tr>
</tbody>
</table>
Set up Related Items in workspace

Set up the items that are related to the open record so that agents can get a better understanding of the record and its impact.

Before you begin

Role required: admin

About this task

Related items appear like tabs above the form pane. There are three types of items:

- Details—Fields from the open record. You can specify which fields appear.
- Related items—Components other than lists that are related to the open record. Typically, this tab shows Now components. For example, you might create cards with record fields to appear in the form pane.
- Related lists—Lists that are related to the open record. These lists are tables of records.
The following example shows an incident record. The Impacted Services related list shows a list of services that are impacted by this incident. The Child Incidents related list show incidents that are related to this one.

The highlighted section in this image is called the Related Items.

You set up related lists for each table. For example, the related lists that are displayed are the same for all incident records. The related lists that are displayed are the same for all case records but are likely different from those displayed for incident records.

**Procedure**

1. Navigate to the table that you want to create a related list for. For example, in the navigation filter, enter Incident to set up related lists for all incident records.

2. Click any of the records to open it.

3. Right-click the menu icon (Ξ) and navigate to **Configure > Related List**.

4. On the Configuring related lists form, move the fields that you want in the related lists section from the Available column to the Selected column.

5. **Optional:** Select a field in the Selected column and use the vertical arrow heads on the right to move the field in the list order.

6. Click **Save**.
Optional: Change the order of the items in the Related Items. By default, Details appears on the left.


b. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the order of lists in the Related Lists for all records in Table.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that this order of lists pertains to. Whenever a record from this table opens, this form defines the order of the lists in related lists.</td>
</tr>
<tr>
<td>View</td>
<td>View that is shown when the conditions are met. Use Workspace.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this component applies to. Global means that the component applies to all applications.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace that this rule applies to.</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle to turn on (selected) and off this rule.</td>
</tr>
</tbody>
</table>

c. On the Conditions tab, specify the role users must have and the record field conditions that must be met for this reordering to appear. For example, you can select the condition State is resolved.

d. To order the items in the Related Items, on the Form Tabs tab, clear the Default Tab Order check box, click the lock icon (🔒) next to Tab Order. You can then reorder the items in the Related Items by selecting the lists that you want to move. Then, use the up and down arrow to move them.

e. Click Submit unless you want to select which item in the Related Items appears in the form pane when record view opens.

(Optional) If you do want to choose what appears in the form pane when record view opens, right-click the top banner, click Save, and proceed to the next step.
The following example shows that **Details** is no longer on the left.

![Image](created_for_offering-offering2-s2-l1-sp1-4created_for_c)

<table>
<thead>
<tr>
<th>Configuration Item</th>
<th>Managed by</th>
<th>Owned by</th>
<th>Approval group</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offering2-S2-L1-SP1</td>
<td>Davis Heideman</td>
<td>SP1SO Layer1-SP1</td>
<td>(empty)</td>
<td>(empty)</td>
</tr>
</tbody>
</table>

8. **Optional:** Specify which item in the Related Items appears in the form pane when record view opens.
By default, the left-most item is in focus when a record opens. You can, however, put a different item in focus.

a. Navigate to **Workspace Experience > Forms > Workspace View Rules** and click the workspace view rule that you want to edit.

b. On the **Form Tabs** tab, open the **Default Tab Focus** list and select the item that should be in focus when an agent opens a record in the table that is specified in this rule.

c. Click **Submit**.

(Optional) The following image shows that **Impacted Services/CIs** rather than the **Affected CIs** is in focus when the record opens.

![Image](created_for_offering-offering2-s2-l1-sp1-4created_for_c)

<table>
<thead>
<tr>
<th>Configuration Item</th>
<th>Managed by</th>
<th>Owned by</th>
<th>Approval group</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offering2-S2-L1-SP1</td>
<td>Davis Heideman</td>
<td>SP1SO Layer1-SP1</td>
<td>(empty)</td>
<td>(empty)</td>
</tr>
</tbody>
</table>

9. **Optional:** Automatically jump to a section in the form pane when conditions are met.

(Optional) By default, when **Details** is in focus in the Related Items, the first section opens. You can, however, set conditions for the **Details** to open on
a different section. **Details** usually displays many sections in the form pane that require scrolling to reach. If there is a typical work pattern for agents, you can save agents’ time by automatically scrolling to the relevant section when conditions are met. For example, when the condition, **State is On hold**, is true, automatically scroll to the tenth section in **Details** because that is a section that agents need for their resolution notes.

**a.** Navigate to **Workspace Experience > Forms > Workspace View Rules** and click the workspace view rule that you want to edit.

**b.** On the **Form Settings** tab, click **New**.

**c.** On the form, fill in the fields.

```
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of this configuration where a specified section in <strong>Details</strong> automatically appears instead of the first section.</td>
</tr>
<tr>
<td>Order</td>
<td>Sequential order this rule is evaluated in when there are multiple rules. The lower the <strong>Order</strong> value means that it’s evaluated in the sequence sooner.</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle that turns on this customization.</td>
</tr>
<tr>
<td>Form Section</td>
<td>Section of <strong>Details</strong> that opens in the form pane instead of the first section.</td>
</tr>
</tbody>
</table>
```

**d. Optional:** In **Conditions**, add conditions that limit when the specified section in **Form Section** opens first.

**e.** Click **Submit**.

10. **Optional:** Create an **Add** button so agents can add records to the related lists.

**What to do next**

Click a component to set it up.

- Tabs
- Notifications
- Ribbon
- Related Items
- Activity Stream
- Contextual Side Panel
Set up adding records to a related list

Create an **Add** button so agents can add records to a Related List.

**Before you begin**
Role required: workspace_admin

**About this task**
You can create an **Add** button that enables agents to add records to lists. This functionality supports one-to-many (o2m) and many-to-many (m2m) tables. In the following example, we use the task_location tables and create the **Add** button for incidents. So, when you open an incident, you can click the new related list, **Affected Locations**, to see incidents (tasks) that occurred at the same location. Many incidents might occur at one location, and one incident might involve many locations.

The general procedure is to add the Related List, **Affected Locations** that is associated with the many-to-many table, task_location, and then create a Workspace Action to create the **Add** button that adds, in our example, locations to an incident.
When an agent clicks **Add**, a modal opens showing the agent locations he or she can add to the incident.

To understand the following example, enter `task_location.list` in the **Filter Navigator** to show the task_location table.

The table shows the associations between the location (cmn_location) and task (task) tables. In the example, there are none.
Procedure

1. Add a new Related List, **Affected Locations**, which opens with incident records.
   
a. Open an incident by navigating to **Incident > Open** and click an incident.

   b. Confirm that you’re in the Workspace View by clicking your profile icon (≡), selecting **Configure Page**, and then selecting **Form Layout**.

   c. Set up a related list for the Incident table by clicking your profile icon (≡), selecting **Configure Page**, and then selecting **Related Lists**.

   d. On the Configuring related lists on Incident form, in **View name**, select **Workspace**.

   e. Select **Affected Locations** and use the arrows to move it into the **Selected** column.
      The task_location value is called **Affected Locations**.

   f. Click **Save**.
      You’ve added **Affected Locations** as a related list for all incident records.

2. Use a Workspace Action to create an **Add** button that enables agents to add locations to an incident.

   a. Navigate to **Workspace Experience > Actions & Components > Related List Actions** and click **New**.

   b. On the form, fill in the fields.
### Action Assignment form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action label</td>
<td>Label that appears on the button in the Related Lists area. Make this <strong>Add</strong>. In the previous image, the <strong>Add</strong> button will appear next to the <strong>New</strong> button.</td>
</tr>
<tr>
<td>Action name</td>
<td>The name for this record that appears in the list of related list actions. <strong>Workspace Experience</strong> &gt; <strong>Actions &amp; Components</strong> &gt; <strong>Related List Actions</strong>.</td>
</tr>
<tr>
<td>Implemented as</td>
<td>Select <strong>UI Component</strong> because you are creating a button.</td>
</tr>
<tr>
<td>Specify UI component</td>
<td>Select <strong>sn-multi-record-associator</strong>.</td>
</tr>
<tr>
<td>Button type</td>
<td>Select <strong>Primary</strong>. Primary buttons are green. Secondary buttons are gray.</td>
</tr>
<tr>
<td>Record Selection Required</td>
<td>Checkbox to make record selection required.</td>
</tr>
<tr>
<td>Tooltip</td>
<td>Text that appears when agents hover a mouse over the UI component.</td>
</tr>
<tr>
<td>Description</td>
<td>Verbose description of this Workspace Action.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this component applies to. Global means that the component applies to all applications.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace this UI component appears in.</td>
</tr>
<tr>
<td>Table</td>
<td>Table this related list action shows up on.</td>
</tr>
<tr>
<td></td>
<td>• For an o2m relationship, make sure the table is your o2m related list table. For example, incident.</td>
</tr>
<tr>
<td></td>
<td>• For an m2m relationship, make sure the table is your m2m table. For example, task_location. In our example, select task_location.</td>
</tr>
<tr>
<td>View</td>
<td>Select <strong>workspace</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle to turn on (selected) and off this UI component.</td>
</tr>
</tbody>
</table>
c. Under Related Links, click Advanced view to give the component the properties it needs to function.

d. On the Component Attributes tab, fill in the fields.

### Component Attributes form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>label</td>
<td>Name that appears on the top of the modal when you click the Add button.</td>
</tr>
<tr>
<td>extensionPoint</td>
<td>In our example, leave this blank. This field filters the list in the modal. When an agent clicks Add, every possible association is shown between the cmn_location and task tables. This field prevents some of those associations. To learn how to create an extension point, see Using extension points to extend application functionality.</td>
</tr>
</tbody>
</table>
| userGivenTable      | Table that appears in the modal. In our example, we want to open the locations agents can add, so select cmn_location.  
  - Select task_location for m2m relationships.  
  - For o2m relationships, select the table associated with the many portion of your o2m. For example, Incident. |
<p>| hideSelectAll       | Field that enables you to hide Select All. Select True to hide Select All. |
| referencedfieldName | Field displayed in the modal from the userGivenTable. In our example, enter location (lowercase). To find the |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>field name</td>
<td>right-click the <strong>Location</strong> field title on the many-to-many table form.</td>
</tr>
<tr>
<td>type</td>
<td>Record relationship type. Select an <strong>o2m</strong> or <strong>m2m</strong> relationship for the records.</td>
</tr>
<tr>
<td>parentFieldName</td>
<td>The name of the field you’re making the reference from, in this example, it’s <strong>task</strong>. To find the field name, right-click the field title.</td>
</tr>
<tr>
<td>columns</td>
<td>Comma-separated list of columns you want displayed in the modal. For example, in the cmn_location table, you might want name and city. So, enter <strong>name,city</strong>.</td>
</tr>
<tr>
<td>view</td>
<td>The view of the list. Do not add a value; the default view is fine.</td>
</tr>
</tbody>
</table>
e. Click **Update**.
   You've created an **Add** button that shows up in the Related Lists area when an incident record opens.

3. Make sure the **Add** button appears and works.
   a. Open an incident by navigating to **Incident > Open** and clicking an incident.

   b. Click the **Affected Locations** Related List.
      You should see the **Add** button in Related Lists.

   c. Click **Add**.
      A modal appears.

   ![Add location modal](attachment:image.png)

   d. Select several check boxes to add those addresses to the incident record and then click **Add**.
      The addresses you selected appear in **Affected Locations**.
e. Enter `task_location.list` in the Filter Navigator to show the task_location table. The new locations should appear in the table.

4. Add a remove action.

You can create a remove button that enables agents to remove records from a related list and disassociate that record from the parent table. This functionality supports o2m and m2m tables.

a. Navigate to Workspace Experience > Actions & Components > Related List Actions and click New.

b. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action label</td>
<td>Label that appears on the button in the Related Lists area. Make sure the action label includes <code>{{count}}</code>.</td>
</tr>
<tr>
<td>Action name</td>
<td>The name for this record that appears in the list of related list actions, Workspace Experience &gt; Actions &amp; Components &gt; Related List Actions.</td>
</tr>
<tr>
<td>Implemented as</td>
<td>Select Server Script.</td>
</tr>
<tr>
<td>Specify UI component</td>
<td>Select <code>sn-multi-record-associator</code>.</td>
</tr>
<tr>
<td>Button type</td>
<td>Select Primary. Primary buttons are green. Secondary buttons are gray.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Record Selection Required</td>
<td>Checkbox to make record selection required. Toggle the checkbox.</td>
</tr>
<tr>
<td>Tooltip</td>
<td>Text that appears when agents hover a mouse over the UI component.</td>
</tr>
<tr>
<td>Description</td>
<td>Verbose description of this Workspace Action.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this component applies to. Global means that the component applies to all applications.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace this UI component appears in.</td>
</tr>
<tr>
<td>Table</td>
<td>Table this related list action shows up on.</td>
</tr>
<tr>
<td></td>
<td>• For an o2m relationship, make sure the table is your o2m related list table. For example, incident.</td>
</tr>
<tr>
<td></td>
<td>• For an m2m relationship, make sure the table is your m2m table. For example, task_location. In our example, select task_location.</td>
</tr>
<tr>
<td>View</td>
<td>Select workspace.</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle to turn on (selected) and off this UI component.</td>
</tr>
<tr>
<td>Order</td>
<td>The sequence order in which this UI component appears in a horizontal list of UI components. The lower the value, the further left the location.</td>
</tr>
</tbody>
</table>

c. Click the menu icon (≡) and click Save.

d. Under Related Links click Advanced view.

e. Click the Server Script tab.

f. Enter a server script in the scripting field. `current.deleteRecord();` into the server script field.
   • For m2m relationships, enter `current.deleteRecord();`.
   • For o2m relationships, enter `current.[field_name] = ''; current.update();`.
g. Under Related Links click Advanced view, and click the Confirmation Settings tab.

h. Toggle Confirmation required.

i. Click Update.

What to do next
Click a component to set it up.

• Tabs
• Notifications
• Form Header
• UI Actions

• Ribbon
• Related Items
• Form pane
• Actions & Components

• Activity Stream
• Contextual Side Panel

Hide the Details tab and UI actions in workspace
Hide the Details tab in the Related Items menu and UI actions for people who don’t need to see that level of detail.

Before you begin
Role required: admin

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
About this task
Declutter the Related Items menu by removing the Details tab from the form pane and all UI actions for users who are not interested in looking at record details or taking actions on records, such as assigning a record to themselves.

Procedure
1. Navigate to Workspace Experience > Forms > Workspace View Rules.
2. Click the rule that you want to modify.
3. On the Form Settings tab, select the Hide Details & UI Actions check box to hide UI actions and the Details tab in the Related Items menu.

What to do next
Click a component to set it up.

Create a related item in Related Items
Create a custom related item that appears in the Form panel to help agents.
Before you begin
Role required: workspace_admin

About this task
You might want to add a related item to display important information related to the open record. The related item in the following image is AAAAAA.

Procedure
1. Navigate to Workspace Experience > Actions & Components > Related Items and click New
2. On the form, fill in the fields.

Action Assignment form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action label</td>
<td>Name of the component you’re adding to the contextual sidebar.</td>
</tr>
<tr>
<td>Action name</td>
<td>Name that describes what you’re adding.</td>
</tr>
</tbody>
</table>
| Implemented as      | • UI component—Displays an icon in a field, form, list, or related list to perform a function, such as adding an attachment to a record, adding a component in the contextual side panel, displaying a form for users to fill out, or searching for a record.  
  • Client action—Takes action on the client side, such as dialing a phone number, opening a record, or opening a form to edit a record. There are a preset number of client actions, such as call number, remove notification, and show notifications. You cannot create new ones. Use this option, for example, with a phone number field to enable the
agent to dial a phone number by clicking the icon. The client actions that come with Agent Workspace have handlers in the browser that carry out the actions.

- Server script—Executes a script on the server, for example, to assign a record to someone, or delete a record. Use this option whenever your action involves changing the database.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify UI component</td>
<td>Click the magnifying glass icon (🔍) and select the component to add to the contextual side panel.</td>
</tr>
<tr>
<td>Icon</td>
<td>Icon to use on the right side of the contextual side bar that agents click to use this component.</td>
</tr>
<tr>
<td>Tooltip</td>
<td>Text that displays when and agent hovers a mouse over the icon.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of this component.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this component applies to. Global means that the component applies to all applications.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace this component belongs in, for example, Agent Workspace, ITSM, CSM, and so forth.</td>
</tr>
<tr>
<td>Table</td>
<td>Table this component is tied to. When a record from this table is open, this component can appear in the contextual side panel.</td>
</tr>
<tr>
<td>View</td>
<td>A set of visual configurations. This value is typically Workspace.</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle to make this component active in the contextual side panel.</td>
</tr>
<tr>
<td>Order</td>
<td>An integer that governs the placement of this icon in the list of Contextual Side panel icons. The lower the number, the higher in the list. The typical practice is to make these numbers hundreds, for example, 100, 200, 300, and 400, so you can put new icons between existing ones in the future.</td>
</tr>
</tbody>
</table>

3. In the related lists, click **Advanced view**.
4. **Optional:** On the **Conditions** tab, use the condition builder to create filters that prevent the component's icon from appearing in the Contextual Side panel.

5. **Optional:** On the **Confirmations Settings** tab, select the **Confirmation Required** check box if you want to display a pop up that asks the agent to confirm the use of this component.

6. **Optional:** On the **Action Exclusion** tab, click **New** to exclude children table from inheriting this component in the Contextual Side panel, or from this table inheriting components from a parent table.

   (Optional) Components in the Contextual Side panel appear according to the records open in Agent Workspace. Child tables inherit these components by default. You can prevent that from happening.

   **a.** On the form, fill in the fields.

   **Action Exclusion form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action assignment</td>
<td>Click the magnifying glass icon (🔍) and select an action assignment, which specifies the</td>
</tr>
<tr>
<td></td>
<td>Table associated with this component. Every time Agent Workspace opens a record from this table, this</td>
</tr>
<tr>
<td></td>
<td>component's icon appears in the Contextual Side panel.</td>
</tr>
<tr>
<td>Exclude this table</td>
<td>Toggle to prevent this <strong>Table</strong> from inheriting this component from its parent table.</td>
</tr>
<tr>
<td>Exclude all child tables</td>
<td>Toggle to prevent child tables of <strong>Table</strong> from inheriting this component in the Contextual Side panel.</td>
</tr>
</tbody>
</table>

   **b.** Click **Submit**.

7. Click **Update**.

**What to do next**
Click a component to set it up.
Create a related list

Create a related list to provide agents with information related to an open record automatically.

Before you begin
Role required: admin

About this task
Related lists appear as tabs above the Form pane.
Procedure

1. Navigate to **Workspace Experience > Actions & Components > Related List Actions** and click **New**.
2. On the form, fill in the fields.

### Action Assignment form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action label</td>
<td>Name of the component you're adding as a related list.</td>
</tr>
<tr>
<td>Action name</td>
<td>Name that describes what you're adding.</td>
</tr>
</tbody>
</table>

**Implemented as**

- UI component—Displays an icon in a field, form, list, or related list to perform a function, such as adding an attachment to a record, adding a component in the contextual side panel, displaying a form for users to fill out, or searching for a record.
- Client action—Takes action on the client side, such as dialing a phone number, opening a record,
or opening a form to edit a record. There are a preset number of client actions, such as call number, remove notification, and show notifications. You cannot create new ones. Use this option, for example, with a phone number field to enable the agent to dial a phone number by clicking the icon. The client actions that come with Agent Workspace have handlers in the browser that carry out the actions.

- Server script—Executes a script on the server, for example, to assign a record to someone, or delete a record. Use this option whenever your action involves changing the database.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify UI component</td>
<td>Shown only when <a href="#">Implemented as is UI component</a>. Click the magnifying glass icon (🔍) and select the component to add as a related list.</td>
</tr>
<tr>
<td>Specify client action</td>
<td>Shown only when <a href="#">Implemented as is Client action</a>. Click the magnifying glass icon (🔍) and select the client action to add as a related list.</td>
</tr>
<tr>
<td>Icon</td>
<td>Icon to use in the Related Items section that agents click to use this component.</td>
</tr>
<tr>
<td>Tooltip</td>
<td>Text that displays when and agent hovers a mouse over the icon.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of this component.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this component applies to. Global means that the component applies to all applications.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace this component belongs in, for example, Agent Workspace, ITSM, CSM, and so forth.</td>
</tr>
<tr>
<td>Table</td>
<td>Table this component is tied to. When a record from this table is open, this component can appear as a related list.</td>
</tr>
<tr>
<td>View</td>
<td>A set of visual configurations. This value is typically Workspace.</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle to make this component active as a related list.</td>
</tr>
</tbody>
</table>
### Order

An integer that governs the placement of this icon in the list of related lists. The lower the number, the higher in the list. The typical practice is to make these numbers hundreds, for example, 100, 200, 300, and 400, so you can put new icons between existing ones in the future.

3. In the related lists, click **Advanced view**.

4. **Optional:** On the **Conditions** tab, use the condition builder to create filters that prevent the component’s icon from appearing in the related lists.

5. **Optional:** If **Implemented as** is **Server Script**, on the **Server Script** tab, add the server script.

6. **Optional:** On the **Confirmations Settings** tab, select the **Confirmation Required** check box if you want to display a pop up that asks the agent to confirm the use of this component.

7. **Optional:** On the **Action Exclusion** tab, click **New** to exclude children table from inheriting this component as a related list, or from this table inheriting components from a parent table.

   a. On the form, fill in the fields.

   **Action Exclusion form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action assignment</td>
<td>Click the magnifying glass icon (🔍) and select an action assignment, which specifies the Table associated with this component. Every time Agent Workspace opens a record from this table, this component’s icon appears in the Related Items list.</td>
</tr>
<tr>
<td>Exclude this table</td>
<td>Toggle to prevent this Table from inheriting this component from its parent table.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Exclude all child tables</td>
<td>Toggle to prevent child tables of <strong>Table</strong> from inheriting this component in the list of Related Items.</td>
</tr>
</tbody>
</table>

8. **Click Update.**

**What to do next**
Click a component to set it up.

- **Tabs**
- **Notifications**
- **Form Header**
- **UI Actions**
- **Ribbon**
- **Related Items**
- **Form pane**
- **Actions & Components**
- **Activity Stream**
- **Contextual Side Panel**

**Set up a notification in workspace**
Send notifications to an agent or a small group of agents when there are updates to important records.
Before you begin
Role required: workspace_admin or notification_provider_admin

Before you begin
Role required: workspace_admin or notification_provider_admin

About this task
When you configure a workspace notification, you determine the following:
• Who receives the notification
• When users receive the notification

The information that is displayed in each notification follows a default format that you can't configure. For more information on the default formats, see Default notification formats.

You can configure up to five workspace notifications per table.

Important: Workspace notifications can be sent to a maximum of five users. They are intended to direct an individual agent or small group of agents to a record rather than notify a broad distribution list.

Procedure
1. Navigate to System Notification > Provider > Notifications, and then click New.
2. On the form, fill in the fields.

Notifications form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the notification.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to receive notifications about.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the notification.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the notification. The notification is active by default.</td>
</tr>
<tr>
<td>Triggered By</td>
<td>System action that triggers the notification. You can send the notification after a record is changed or after an event is triggered.</td>
</tr>
<tr>
<td>Inserted</td>
<td>Option to send the notification after a record is inserted. This field appears when you select Record Change in the Triggered By field.</td>
</tr>
<tr>
<td>Updated</td>
<td>Option to send the notification after a record is updated.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>This field appears when you select <strong>Record Change</strong> in the <strong>Triggered By</strong> field.</td>
</tr>
<tr>
<td>Event</td>
<td>Event that triggers the notification. For example, to send a notification after an incident is closed or resolved, you would select the <strong>incident.inactive</strong> event. By default, this event is logged in the system each time a user resolves or closes an incident.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can select only an event that shares the same table as the notification.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Filter to specify the table records that users receive notifications about. For example, to send notifications about top-priority incidents, you would select <strong>Incident</strong> [incident] in the <strong>Table</strong> field and set the conditions to <strong>[Priority] [is] [1 - Critical]</strong>.</td>
</tr>
<tr>
<td>Users</td>
<td>Users who receive the notification.</td>
</tr>
<tr>
<td>Users in fields</td>
<td>Record fields that include users who receive the notification. For example, to send the notification to the record assignee, select <strong>Assigned to</strong>.</td>
</tr>
<tr>
<td>Is originating user included?</td>
<td>Option to include the user who changed the record or triggered the event.</td>
</tr>
</tbody>
</table>

3. Click **Submit and Add Common Content**.  
4. Select **Workspace** as the content type for your notification.  

5. On the form, fill in the fields to define the notification content.
### Notification form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the notification.</td>
</tr>
<tr>
<td>Notification</td>
<td>Notification that is associated with the content. This field is populated automatically with the notification that you created.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to receive notifications about. This field is populated automatically with the table defined in the notification.</td>
</tr>
<tr>
<td>Route</td>
<td>Route through which the notification is sent to the recipient. This field is automatically populated with <strong>Agent Workspace</strong>.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the notification content.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the notification content.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

**Results**

After the notification is triggered, it is sent to recipients who aren’t currently looking at the target record. A user clicks the notification to link directly to the record.

The notification tray can contain up to one notification per record. If the same record is updated twice in one day, the first notification is removed with the arrival of the second notification.

Users can customize their notifications using the workspace settings. These options appear only after you've configured an active notification.
If a user isn’t receiving notifications as expected, check that notifications are enabled in the workspace settings.

**What to do next**
Click a component to set it up.

<table>
<thead>
<tr>
<th>Tabs</th>
<th>Ribbon</th>
<th>Activity Stream</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notifications</td>
<td>Related Items</td>
<td>Contextual Side Panel</td>
</tr>
<tr>
<td>Form Header</td>
<td>Form pane</td>
<td></td>
</tr>
<tr>
<td>UI Actions</td>
<td>Actions &amp; Components</td>
<td></td>
</tr>
</tbody>
</table>
Default notification formats

After you configure a workspace notification, the information that is displayed in the notification follows a default format that you can’t configure. Learn about the default notification formats so that you can know what information is being sent to notification recipients.

There are notification formats for three different use cases in workspace:

• Someone assigns a record to an agent
• Someone updates a field in a record
• Someone updates multiple fields

Each format uses the display value of the target record. A display value is a field value that the system displays to represent the record that was updated. For example, in Incident [incident] records, the display value is the incident number by default.

To set a new display value for a record, follow the steps in Select a field as the table display value.

Newly assigned record

When someone assigns a record to an agent, the notification contains the following information:
• Display value of the assigned record
• Priority of the record
• Short description of the record

The notification displays up to two lines of the short description. If the short description doesn't fit inside the notification, the system appends an ellipsis (…) at the place where the short description is cut short.

**Single field update**
When someone updates a field in a record, the notification contains the following information:

• Name of the user who updated the field
• Name of the field that the user updated
• Display value of the updated record
• Priority of the updated record
• Short description of the updated record

The notification displays up to two lines of the short description. If the short description doesn't fit inside the notification, the system appends an ellipsis (…) at the place where the short description is cut short.

**Multiple field updates**
When someone updates multiple fields in a record, the notification contains the following information:
• Name of the user who updated the fields
• Display value of the updated record
• Priority of the updated record
• Short description of the updated record

The notification displays up to two lines of the short description. If the short description doesn't fit inside the notification, the system appends an ellipsis (…) at the place where the short description is cut short.

Setting up the workspace email client

Set up Workspace to include an email client that enables agents to email callers directly from the record view.

To set up the workspace email client, do the following:
• Designate someone to set up the workspace email client by assigning them the email_client_admin role.

• Allow agents to use the workspace email client by assigning them the email_composer role.

• Allow business managers to create quick messages for their agents by assigning them the email_client_quick_message_author role.

• Enable workspace email client for a table
  Enable the email client for a table so that users can send emails directly from the table record.

• Define recipient qualifiers for the workspace email client
  Create a configuration that controls the auto-complete list of recipients displayed in the email client.

• Define from addresses for the workspace email client
  Set an allowable email address that is displayed in the From address of a message sent from the email client.

• Create a workspace email client configuration
  Define a configuration that controls the display and behavior of the email client that is based on a selected ServiceNow table.

• Create a workspace email client template
  You can create a different template for each table that uses the email client.

• Define a quick message for the workspace email client
  Create predefined content to add in the email client so that users can write emails consistently and efficiently.

Related information
  Communicating via email in workspace
  Email client
  Email client configurations

Enable workspace email client for a table
Enable the email client for a table so that users can send emails directly from the table record.

Before you begin
Role required: admin
About this task
The email client is enabled by default on the Incident [incident] table. You can enable the email client for another table by adding the email_client dictionary attribute to the table.

iad: This capability is not inherited by tables that extend the current table. For example, enabling the email client on the Task table does not enable it for the Incident or Problem tables.

Procedure
1. Open a record in the table that you want to enable the email client for. For example, to enable the email client for the Problem [problem] table, navigate to Problem > Open, and then open any problem record.
2. On the form, click the menu icon ( ) and then click Configure > Dictionary.
3. On the Dictionary Entries list, open the first record. The first record has the record type Collection and does not have any entry for Column name.
4. On the form, in the Related Links section, click Advanced view.
5. In the Attributes field, enter email_client=true. If there are other values in the field, separate the attribute with a comma.
6. Click Update.

Define recipient qualifiers for the workspace email client
Create a configuration that controls the auto-complete list of recipients displayed in the email client.

Before you begin
Role required: email_client_admin or admin

About this task
You can specify recipient qualifiers that display additional fields (from a selected ServiceNow table) in the auto-complete list. These fields differentiate email recipients who have the same first and last names. Use the following tabs in the Email Client Recipient Qualifier form to define a recipient configuration.
• **Display Configuration** – Set up the email recipient auto-complete behavior and optionally select additional fields to differentiate recipients who have the same name. The additional fields ensure that users select the proper recipient for an email.

• **Query Configuration** – Specify a condition or script that queries the selected table and filters the recipient results returned.

You can define different recipient configurations, which can be used in an email client configuration.

**Procedure**

1. Navigate to **Email Client > Email Client Recipient Qualifier** and click **New**.
2. Fill in the fields at the top of the Recipient Qualifier form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for this email client recipient configuration.</td>
</tr>
<tr>
<td>Application</td>
<td>The type of scoped application.</td>
</tr>
<tr>
<td>Table</td>
<td>The ServiceNow table to be queried for recipients.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of this recipient configuration.</td>
</tr>
</tbody>
</table>

3. Fill in the fields in the **Display Configuration** tab to control the auto-complete display in the email client.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Address</td>
<td>The field on the table that contains the recipient email address.</td>
</tr>
<tr>
<td>Display Name</td>
<td>The field on the table used for the recipient name displayed.</td>
</tr>
<tr>
<td>Order</td>
<td>The order of results returned relative to other recipient qualifiers defined.</td>
</tr>
<tr>
<td>Additional Display Fields</td>
<td>A content list for choosing additional fields from the table to be displayed in the auto-complete list.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Differentiates recipients who share the same name.</td>
<td>A check box for enabling additional fields to be searched. Expands the recipients returned in the autocomplete list by querying (searching) the Additional Display Fields.</td>
</tr>
</tbody>
</table>

4. Fill in the fields in the Query Configuration tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prefix Search</td>
<td>Option to find the desired recipient using prefix.</td>
</tr>
</tbody>
</table>

Note: Selecting the Prefix Search option displays the Last Name Field drop-down menu with options to filter the recipient's name.

<table>
<thead>
<tr>
<th>Type</th>
<th>Select the method for filtering the recipients returned in the autocomplete list:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Condition</td>
</tr>
<tr>
<td></td>
<td>• Script</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Conditions</th>
<th>If you selected Condition for the Type, use the condition builder to specify the conditions that must be met to return the appropriate recipients.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Script</th>
<th>If you selected Script for the Type, enter a script that uses these variables to return the appropriate recipients:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• recipientQuery: GlideRecord for the table being queried.</td>
</tr>
<tr>
<td></td>
<td>• targetRecord: GlideRecord for the target record from which the email client was opened.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>For example, this recipientQuery is a GlideRecord that represents the Customer Contact table. The targetRecord variable is a Customer Service case from which the email client was opened. This query limits the email client auto-complete results to contacts who belong to the same account as the Customer Service case.</td>
</tr>
</tbody>
</table>

```javascript
(function (recipientQuery, targetRecord) {

    // Limit results to contacts belonging to the account for the case.
    var account = targetRecord.getValue('account');
    recipientQuery.addQuery('account', account);
})
```

5. Click **Submit**.
   The recipient qualifier configuration is added to the Recipient Qualifier [sys_recipient_qualifier] table and is available for use in an email client configuration.

**Define from addresses for the workspace email client**

Set an allowable email address that is displayed in the From address of a message sent from the email client.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to Email Client > Email Client From Address and click **New**.
2. In the **Display name**, enter the name to be displayed in the From field of the email client message.
3. Enter a valid **Email address** for the From address in the email client.
4. Click **Submit**.  
The From address is added to the Email Client From Address [sys_email_client_from_address] table.

**Create a workspace email client configuration**

Define a configuration that controls the display and behavior of the email client that is based on a selected ServiceNow table.

**Before you begin**
Role required: email_client_admin or admin

**About this task**

The configuration determines the recipient auto-complete results that are displayed, email addresses that can be entered, and a set of allowable From addresses to be used when sending a message with the client.

You can create one email client configuration per ServiceNow table.

**Procedure**

1. Navigate to **Email Client > Email Client Configuration** and click **New**.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for this email client configuration.</td>
</tr>
<tr>
<td>Application</td>
<td>Type of scoped application.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that indicates that the configuration is active. The configuration is active by default.</td>
</tr>
<tr>
<td>Table</td>
<td>ServiceNow table that this client configuration applies to. Select a table from the list.</td>
</tr>
</tbody>
</table>

3. In the Recipient Configuration section, select **Recipient Qualifiers** to be used for this client configuration.

   a. Click the lock icon (🔒). By default, two types of recipients are available: Active Users with email accounts and Active Groups with email accounts.

   b. Click the search icon (🔍) and select a recipient configuration from the list of available recipient configurations.

   c. Click the lock icon (🔒) to lock it.

4. In the Display Configuration section:
a. Select the **Display From** option to display the From email address in the email client. To hide the From email address in the email client, clear the check box.

b. Select the **Display Reply-To** option to display the Reply To address in the email client. To hide the Reply To email address in the email client, clear the check box.

5. In the Attachment Handling section, select from one of three choices for the **Attachment Send Action** field:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attach to Email Record</td>
<td>Keep email client attachments on the Email [sys_email] record when you send an email.</td>
</tr>
<tr>
<td>Attach to Target Record</td>
<td>Attach email client attachments to the target record when you send an email. This option is the default value.</td>
</tr>
<tr>
<td>Conditionally Attach to Target Record</td>
<td>Set conditions that define which email client attachments are moved to the target record when you send an email. Attachments that do not meet the conditions remain on the email record when you send an email.</td>
</tr>
</tbody>
</table>

6. In the Filter Configuration section, select **Email Address Filters** to be applied to the email client.

   a. Unlock the lock icon (🔒).

   b. Click the search icon (🔍) and select one or more Email Address Filters.

   c. Click the lock icon (🔒) to lock **Email Address Filters**.

   Each filter that you select evaluates a given email address and determines whether or not the given address is valid to apply to an outbound email.

7. Click **Submit**.
   The configuration is added to the Email Client Configuration [sys_email_client_configuration] table.

**Create a workspace email client template**

You can create a different template for each table that uses the email client.
Before you begin
Role required: admin

About this task
The email client uses its own email templates to define default values for fields. Use the following sections in the Email Client Template form to build a client template:

- **Content**: The message body.
- **Recipients**: The email addresses of users receiving the email message. The email addresses are displayed in the To, Cc, and Bcc fields of the message.
- **Sender Configuration**: The method used to generate the email sender (From email address) of the message.

Procedure
1. Navigate to Email Client > Email Client Templates.
2. Click New.
3. Fill in the fields at the top of the Email Client Template form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique template name.</td>
</tr>
<tr>
<td>Table</td>
<td>The table that the template applies to. Enable the email client for the same table.</td>
</tr>
<tr>
<td>Conditions</td>
<td>The conditions that determine when this client template is used. Use the condition builder to identify the target record that must match before this template is applied to the email client.</td>
</tr>
<tr>
<td>Application</td>
<td>The type of scoped application.</td>
</tr>
<tr>
<td>Execution Order</td>
<td>A number that indicates the order in which template conditions are evaluated.</td>
</tr>
</tbody>
</table>

4. Fill in the fields in the Content tab.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject</td>
<td>Enter a description of the email.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The <strong>Subject</strong> field on the email client allows a larger character count than the default setting for the <strong>Subject</strong> field on the Email [sys_email] table. If the subject text from the client is being truncated, increase the <strong>Max length</strong> value for the <strong>Subject</strong> field on the Email table.</td>
</tr>
<tr>
<td>Content Type</td>
<td>Select the format of the message body content: HTML or plain text.</td>
</tr>
<tr>
<td>Body HTML</td>
<td>If you selected HTML for the <strong>Content type</strong>, enter the content of the message body using the HTML editor toolbar to format the HTML.</td>
</tr>
<tr>
<td></td>
<td>To reference field values, select variables from the variables list or manually type variable references using the syntax ${table_name.variable_name}. To reference the user who launches the email client, enter the variable ${current_user}.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Line breaks don’t appear for multi-line fields such as ${description} and ${comments} in the email client template.</td>
</tr>
<tr>
<td></td>
<td>You can call a mail script by using ${mail_script:script name} in the <strong>Body HTML</strong> field.</td>
</tr>
<tr>
<td>Body text</td>
<td>If you selected plain text for the <strong>Content type</strong>, enter any text or mail script that you want to appear in the message body.</td>
</tr>
</tbody>
</table>
You can insert a mail script in the **Body text** field by using the following syntax:

```html
<mail_script> [code] </mail_script>
```

5. Fill in the fields in the **Recipients** tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Enter a comma-separated list of either field names that contain user email addresses or specific email addresses. To reference an email address using a script, create a script include and then call the script include in the <strong>To</strong> field. Your script must start with the <code>javascript:</code> prefix. The script must return email addresses in a comma-separated string.</td>
</tr>
<tr>
<td>Cc</td>
<td>Enter a comma-separated list of either field names that contain user email addresses or specific email addresses. To reference an email address using a script, create a script include and then call the script include in the <strong>Cc</strong> field. Your script must start with the <code>javascript:</code> prefix. The script must return email addresses in a comma-separated string. This field cannot have the same addresses as the <strong>To</strong> field.</td>
</tr>
<tr>
<td>Bcc</td>
<td>Enter a comma-separated list of either field names that contain user email addresses or specific email addresses. To reference an email address using a script, create a script include and then call the script include in the <strong>Bcc</strong> field. Your script must start with the <code>javascript:</code> prefix. The script must return email addresses in a comma-separated string. This field cannot have the same addresses as the <strong>To</strong> or <strong>Cc</strong> fields.</td>
</tr>
</tbody>
</table>

6. In the **Sender Configuration** tab, select the **From Generation Type** to determine how the sender (From address) in the email client message is generated.
Use this field only if you want a different From address than the one defined in your SMTP email account.

- None: The From address is not generated in the email client message.
- SMTP Email Account: Use the From address of the SMTP email account for the instance as the sender.
- Select From List: Choose from a list of allowable From addresses defined in the Email Client From Address [sys_email_client_from_address] table.
- Script: Run a GlideRecord query on the Email Client From Address [sys_email_client_from_address] table.
  For example, the following script sets the From address based on the location of the incident caller:

```javascript
(function (fromAddressQuery, targetRecord) {
    // targetRecord is incident for this template
    var location = targetRecord.caller_id.country;

    if (location == 'us')
        fromAddressQuery.addQuery('email_address', 'servicedesk.us@example.com');
    else if (location == 'japan')
        fromAddressQuery.addQuery('email_address', 'servicedesk.jp@example.com');
    else if (location == 'uk')
        fromAddressQuery.addQuery('email_address', 'servicedesk.uk@example.com');
})(fromAddressQuery, targetRecord);

- Text: Enter the email From address to be used in the client.

⚠️ **Note:** The From email address does not appear in the email client unless you configure email client to display the From address. For more information on managing the behavior of email client, see **Email client configurations**.

⚠️ **Note:** If the domain for the From address is not the domain of the SMTP email account server, the owner of the From domain must configure the SPF record for the domain. The owner changes the domain settings to allow the instance to send email as if from that domain. For details on using SPF records, see ServiceNow KB0535456.

7. Click **Submit**.
   The template is added to the Email Client Templates [sys_email_client_template] table.
Define a quick message for the workspace email client

Create predefined content to add in the email client so that users can write emails consistently and efficiently.

Before you begin
Role required: email_client_quick_message_author or admin

About this task
Agents can insert quick messages into emails that they draft in workspace. By default, the quick message content is inserted at the place of the cursor. To instead have quick message content replace all existing content in an email draft, set the `glide.email_client.quick_message.insert` property to `false`.

Procedure

1. Navigate to Email Client > Quick Messages.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name that appears in the Quick Message selector.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for activating the quick message. When selected, the quick message is available for selection in the Quick Message selector.</td>
</tr>
<tr>
<td>Application</td>
<td>Type of scoped application.</td>
</tr>
<tr>
<td>User</td>
<td>User who has access to this quick message. Selecting a user restricts access to that user only. Leave the field blank to have no user-based restrictions.</td>
</tr>
<tr>
<td>Group</td>
<td>Group whose members have access to this quick message. Selecting a group restricts access to members of that group only. Leave the field blank to have no group-based restrictions.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to which the quick message applies. To make the quick message available for all tables, leave blank.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Target record that must match the conditions before the quick message appears for selection in the email client.</td>
</tr>
<tr>
<td>Body</td>
<td>Content to insert in the Message Text field in the email client. By default, the field supports HTML format.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>To reference field values, select variables from the variables list or manually type variable references using the syntax <code>${table_name.variable_name}</code>. To reference the user who launches the email client, enter the variable <code>${current_user}</code>.</td>
</tr>
</tbody>
</table>

**Note:** Line breaks don't appear for multi-line fields such as `${description}` and `${comments}` in the email client template.

4. Click **Submit**.

**Setting up the Contextual Side panel in workspace**

The Contextual Side panel provides agents with tools to research and resolve problems. The different components provide the agents with different types of help.

The Contextual Side panel is where agents research and resolve issues. Agents click the icons to open the following tools:
• **Agent Assist** ( )—Automatically displays search results based on the short description. Also displays similar, resolved issues so the agent can determine if the solution applies in this case. Agent Assist takes advantage of artificial intelligence.

• **Attach** ( )—Enables the agent to attach content found in the Knowledge Base in a response to the requester in the Activity Stream. This feature does not require configuration.

• **Playbook** ( )— Enables the agent to work on records with consistent a workflow, moving the record from on state to another.

• **Template** ( )—Populates the Activity Stream with standard content related to resolving the issue. Good templates save the agent time by eliminating repetitive work.

• **Now components**—The building blocks of Workspace, for example, lists, PAR scores, and so forth.

• **Components you design**—You can create your own Workspace components.

Workspace comes preconfigured with components in the Contextual Side panel but you can add more. Each component can appear for all tables or you can set up a component to display only when an agent opens records from specific tables.

Side panel components are responsive, so you can widen the side panel to, for example, make it easier to read a Knowledge Base article.
Next

• Add a custom component to the Contextual Side panel
• Set up templates that fill in form fields for agents
• Set up Agent Assist that provides recommended solutions to issues presented in the open record.

Add custom components to the Contextual Side panel

You can add or remove components in the Contextual Side panel. These components help agents resolve customer issues they’re working on.

Before you begin
Role required: admin
About this task
Workspace comes preconfigured with components in the Contextual Side panel but you can add more. Each component can appear for all tables or you can set up a component to display only when an agent opens records from specific tables. The following image shows Agent Assist in the Contextual Side panel.

Components already available to put in the Contextual Side panel are:

- Agent Assist
- Attachments
- Templates

In the following procedure, you create a Workspace Action that displays an icon in the Contextual Side panel, which opens a component in the panel.
Procedure

1. Navigate to **Workspace Experience > Actions & Components > Contextual Side panel Items** and click **New**.
   The Action Assignments form lists the components that appear in the form side panel depending on the table the open record belongs to. For example, you can set up Agent Assist differently for every table.

2. On the form, fill in the fields.

### Action Assignment form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action label</td>
<td>Name that appears on the component you're adding to the Contextual Side panel.</td>
</tr>
<tr>
<td>Action name</td>
<td>Name that appears for this record in the list of action assignments: <strong>Workspace Experience &gt; Actions &amp; Components &gt; Contextual Side panel Items</strong></td>
</tr>
<tr>
<td>Implemented as</td>
<td><strong>UI component</strong> is the only valid selection. A UI component displays an icon in a field, form, list, or related list to perform a function, such as adding an attachment to a record, adding a component in the form side panel, displaying a form for users to fill out, or searching for a record.</td>
</tr>
<tr>
<td>Specify UI component</td>
<td>Click the magnifying glass icon (🔍) and select the component to add to the form side panel. For example, to add an additional Agent Assist, select <strong>now-agent-assist</strong>.</td>
</tr>
<tr>
<td>Icon</td>
<td>Icon to add to the right side of the form side bar that agents click to use this component.</td>
</tr>
<tr>
<td>Tooltip</td>
<td>Text that displays when and agent hovers a mouse over the icon.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of this component.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this component applies to. Global means that the component applies to all applications.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace this component belongs in, for example, Agent Workspace, ITSM, CSM, and so forth.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
**Table** | Table this component is tied to. When a record from this table is open, this component can appear in the form side panel.

**View** | A set of visual configurations. This value is typically Workspace.

**Active** | Toggle to make this component active in the form side panel.

**Order** | An integer that governs the placement of this icon in the list of Contextual Side panel icons. The lower the number, the higher in the list. The typical practice is to make these numbers hundreds, for example, 100, 200, 300, and 400, so you can put new icons between existing ones in the future.

---

3. Right-click the top banner and select **Save**.

4. In the related lists, click **Advanced view**.

5. **Optional:** On the **Conditions** tab, use the condition builder to create filters that prevent the component's icon from appearing in the form side panel.

6. **Optional:** On the **Confirmations Settings** tab, select the **Confirmation Required** check box if you want to display a pop up that asks the agent to confirm the use of this component.

7. **Optional:** On the **Action Exclusion** tab, click **New** to exclude children tables from inheriting this component in the Contextual Side panel, or this table inheriting components from a parent table.

   (Optional) Components in the Contextual Side panel appear according to the records open in Agent Workspace. Child tables inherit these components by default. You can prevent that from happening.

   **a.** On the form, fill in the fields.

   **Action Exclusion form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action assignment</td>
<td>Click the magnifying glass icon (🔍) and select an action assignment, which specifies the</td>
</tr>
<tr>
<td>Table</td>
<td>Table associated with this component. Every time Workspace opens a record from this table, this</td>
</tr>
</tbody>
</table>
### Field Description

Component's icon appears in the Contextual Side panel.

#### Exclude this table
Toggle to prevent this **Table** from inheriting this component from its parent table.

#### Exclude all child tables
Toggle to prevent child tables of **Table** from inheriting this component in the Contextual Side panel.

---

**b. Click Submit.**

**8. Click Update.**

**What to do next**

Click a component to set it up.

---

- **Tabs**
- **Notifications**
- **Form Header**
- **UI Actions**
- **Ribbon**
- **Related Items**
- **Form pane**
- **Actions & Components**
- **Activity Stream**
- **Contextual Side Panel**
Set up templates in the Contextual Side panel

Reduce an agent's time responding to requesters by automatically filling in record fields using a template.

About this task
Role required: admin

You associate templates with tables. Whenever an agent works on a record from that table, the agent can click a template to fill fields in the form. For example, you might create a High Priority template for the problem table. Whenever agents work on a problem, if they click the template, it sets the Urgency field in the problem record to High.

Configure templates.

Procedure
1. Navigate to System Definition > Templates.
2. Click New.
3. On the form, fill in the fields.

Template form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of this template.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that this template applies to. Select Global to make the template available for use with all tables.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The table list shows only the tables and database views that are in the same scope as the template.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for making the template available for use. A template must be active to be used.</td>
</tr>
<tr>
<td>User</td>
<td>User who can configure and apply the template. If you define a user, no other users can see the template unless you select the Global option.</td>
</tr>
<tr>
<td>Group</td>
<td>Group whose members can configure and apply the template. If you define a group, no other groups can see the template unless you select the Global option.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Global</td>
<td>Option for allowing any user who can access the templates to view and apply this template.</td>
</tr>
</tbody>
</table>
| Short description | Description of the template.  
   \n   **Note:** Adding content to this field does not add that content to the Short description field of the forms that use this template. |
| Template      | Content that automatically populates records that are based on this template. Select a field from the specified table in the left column and then enter the data to automatically populate in the right column.  
   \n   **Note:** Even though you can select dot-walked fields in the template, they do not apply to fields that are on the form. |
| Link element  | Template that links a child table with the template for the parent table. In the template for the child table, set the value to the field that references the parent table. After you set the value, the child template is explicitly linked to the parent table.  
   \n   **Note:** This field does not appear by default. Configure the template form to add the field. |

4. Click **Submit**.

**Results**
You can also create a template by saving a form. For more information, see .

**What to do next**
Set up Agent Assist so agents receive recommendation for issues presented in the open record. Or, set up a different component.

Click a component to set it up.

- Tabs
- Notifications
- Form Header
- UI Actions

- Ribbon
- Related Items
- Form pane
- Actions & Components

- Activity Stream
- Contextual Side Panel

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Set up Agent assist

Set up Agent assist to give agents automatic search results that show possible solutions for records they open. Agent assist is pre-configured to search Incident, Problem, Change, Outages, Knowledge, and Case tables for solutions. You can set up Agent assist to search additional information sources.

Before you begin

- Role required: workspace_admin
- The ITSM plugin, com.snc.agent_workspace.itsm, must be activated on your instance.

About this task

Clicking the graduation cap icon (🎓) in the Contextual Side panel makes Agent assist appear. Agent assist uses contextual search and, optionally, machine learning to surface recommendations based on Knowledge base articles, catalog items, as well as related incidents, cases, problems, and questions relevant to a record an agent is working on.

When an agent opens a record, Agent assist does an automatic search based on a field in the record, typically the short description field. Each search result appears in a card.
Search results typically return multiple cards. You configure the card content, which might be record fields or a custom message. You also configure the card’s heading. To improve recommendations, set up Predictive Intelligence, which has a separate subscription fee.

You set up Agent Assist for every table your agents can access. You can even set up more than one Agent assist for each table. Each of those Agent assists would search a different repository of information.

For each Agent assist, you specify the source of the information to search. A typical implementation just searches Knowledge Base articles, which includes community articles (once called Social Q&A). You can also search a service
catalog if your agents order items to fulfill requests, for example, sending a keyboard to a requester. You can also use Additional Resources, which are tables your agents need to access, for example a table of incidents.

Agent assist, represented by the graduation cap icon (🎓) in the Contextual Side panel, is the workspace version of Contextual Search. So, the set up for Agent assist is almost identical to Contextual Search. To get set up information in addition to that provided in this topic, see Contextual search.

**Procedure**

1. **Optional:** Modify the information sources Agent assist can search. Agent Assist has default information sources it searches. You can modify those sources by defining new search contexts.

2. Navigate to Contextual Search > Table Configuration and click New.

3. In the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Name of the table name associated with this Agent assist, for example, Incident [incident].</td>
</tr>
<tr>
<td>UI type</td>
<td>Select Workspace.</td>
</tr>
<tr>
<td>Search context</td>
<td>Click the Lookup icon (🔍) and select a search context. Search contexts are the groups of Searchers used as information sources for Agent assist searches. Searchers are information sources, such as Knowledge, Catalog, and Pinned. If you associate more than one Agent assist to one table, the search contexts must be different. For more information, see Contextual Search &gt; Search Contexts, or Define a search context.</td>
</tr>
<tr>
<td>Title</td>
<td>Title that appears at the top of Agent Assist. The default is Agent Assist.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable related search box</td>
<td>Toggle that shows or hides the search box in Agent assist. Agents use this box to enter new search terms to find solutions. Otherwise, the agent would have to change the text in the field Agent assist bases its search on, for example, Short Description. This field is read-only when the UI type is <strong>Workspace</strong>.</td>
</tr>
<tr>
<td>Show searcher first</td>
<td>Toggle to display searcher resources before additional resources in the search context. In general, select this check box. Searcher resources are information sources, such as Knowledge Base articles and catalog items. Additional resources are tables that you give agents access to in order to resolve problems, such as closed incidents, resolved problems, and employee records.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this component applies to. Global means that the component applies to all applications. This field is read-only.</td>
</tr>
<tr>
<td>Limit</td>
<td>Maximum number of search results returned.</td>
</tr>
<tr>
<td>Results per page</td>
<td>Number of results to display per page.</td>
</tr>
<tr>
<td>Allow search with empty search text</td>
<td>Toggle to specify whether the search runs when there is no search text. There is no search text when there is no <strong>Search Field</strong> specified or there is a <strong>Search Field</strong> specified but it is empty. You might, for example, want the search field in Agent assist to be empty so that an agent can enter an employee's name to display their records. To look up employee records, it wouldn't make sense to run a sample search on an arbitrary employee. <strong>Search Field</strong> is the field in the open record Agent assist uses as search</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>criteria. The default is <strong>Short description</strong>. You configure this value in the following steps.</td>
</tr>
<tr>
<td>When to display</td>
<td>Conditions that must be satisfied for Agent assist to appear. For example, set <code>[Active] [is] [true]</code> to make Agent assist appear only when the open record is active.</td>
</tr>
<tr>
<td>Search as</td>
<td>Enables agent to search based on the value of a field in the open record, for example, <strong>Caller</strong>. Use this when an agent fills out forms on behalf of a customer. On the tab, select <strong>Enable search as</strong>. In the <strong>Search as field</strong> list, select the field in the open record to use as the person doing the search.</td>
</tr>
</tbody>
</table>

4. Right-click the top banner and click **Save**. The **Search Fields**, **Filter Configurations**, **Email Configurations**, and **Search Action Configurations** related lists appear.

5. **Optional:** On the **Search Fields** tab, click **New** to make Agent assist search on a field different from the default, **Short description**.

6. **Optional:** On the **Filter Configurations** tab, click **New** to create conditions that statically or dynamically change the search results that appear in Agent assist. An example of a static condition is setting the condition for the **Category** field to equal **Software**. In this case, for all search results returned, Agent assist only shows the ones where the **Category** field is **Software**.

You can also create dynamic filters, which are filters based on fields in the form pane. For example, only show knowledge articles that have the same category as the current incident. If an agent changes the value of a dynamic field in the form pane, Agent assist automatically does another search based on the updated value. Click the following link to create a dynamic filter.

7. **Optional:** On the **Email Configurations** tab, select **New** to send a pre-written email notification, such as incident closed, to a user named in a record field, such as **Assigned to**.
8. **Optional:** On the **Search Action Configurations** tab, you can see the actions an agent can take with the search result, for example, **Attach**, **Flag**, **Full View**, and **Helpful**.

9. Click **Update**.

10. **Optional:** **Set up Predictive Intelligence.** Predictive Intelligence is an add-on subscription that provides highly accurate solution recommendations automatically.

11. **(Optional) Set up Agent assist cards.**

12. **Optional:** **Set up more than one Agent assist for a table.**

**What to do next**

Click a component to set it up.
Set up Agent assist information sources

Set up the information sources Agent assist searches to provide your agents with recommended solutions.

Before you begin
Role required: workspace_admin

About this task
Agent assist comes with default information sources it searches. You might change the information sources to provide more relevant information. Some of the resources Agent assist can search include:

- Knowledge base
- Service catalogs
- Tables
- Record producers

These information sources are grouped as follows:

- Searchers—Catalog, Knowledge base, Pinned, and discussions. You cannot add to these. You can see the full list by navigating to Contextual Search > Searchers.
- Additional Resources—Tables that can be queried. You cannot add to these. You can see the full list by navigating to Contextual Search > Additional Resources.
- Search contexts—Combines Searchers and Additional Resources as a single information source to search.

Procedure
1. Navigate to Contextual Search > Search Contexts and click New.
2. In the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Search Context name.</td>
</tr>
<tr>
<td>Short description</td>
<td>Describes this Search Context.</td>
</tr>
<tr>
<td>Searcher</td>
<td>The group of Searchers to use as sources material for searches.</td>
</tr>
<tr>
<td>Searcher text</td>
<td>Label for search results</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Application | Application that this component applies to. Global means that the component applies to all applications.
Active | Toggle to make this Search Context active.
Enable wildcard searches | Toggle to make the regex asterisk (*) valid. * can represent any alphanumeric character in a search term. The recommendation is to enable this option.
Search on tab | This field is not used by Agent assist in workspace.

3. Right-click the top banner and select **Save**.

4. On the **Additional Resource Configurations** tab, click **Edit**.

5. In the slushbucket, select items in the **Collection** column and use the arrowheads to move them to the **Additional Resource Configurations List** column to add the items as source of information for Agent assist to search.

6. Click **Save**.

7. **Optional:** On the **Record Producer Configurations** tab, click **New** to add Record Producers to the resources Agent assist searches.

   (Optional) A Record Producer is a type of catalog item that enables end users to request a task, such as Reboot Windows Server, Password reset, or Replace printer toner. A Record Producer produces a record, for example, a case that embodies the task.

   a. On the **Record Producer Configuration** form, select the Record Producer to add to the search resources and click **Submit**. For information about creating a Record Producer, see [Create a record producer](#).

8. **Optional:** On the **Table Configurations** tab, click **New** to add tables for Agent assist to search.

   (Optional) On the Table Configuration form, select the table to add as a search resource, and optionally, conditions that prevent using this additional resource. For help filling out the form, see this step in [Set up Agent assist](#).

**What to do next**
Set up Agent assist.
Set up Predictive Intelligence in Agent assist

Set up Predictive Intelligence to use machine language to research and create recommendations for issue resolutions automatically. Agent assist works without Predictive Intelligence, which is an upgrade.

Before you begin

- Plugins required: com.snc.contextual_search, com.glide.platform_ml, com.snc.contextual_search_ml - Enables customers to leverage machine-learning algorithms for searching with Contextual Search.
- Implement the initial setup and configuration for Predictive Intelligence on your instance.
- Prediction Intelligence subscription.
- Role required: admin

About this task

Agents use Agent assist to manually look up similar issues, related Knowledge Base articles, and related solutions. The pro version of Agent assist, powered by Predictive Intelligence, does all of that automatically.

When an agent opens a record, Agent assist with Predictive Intelligence:

1. Looks for similar records.
2. Finds what is common among those records, such as a recommendation code of all the records point to the same Knowledge base article.
3. Displays the solutions as recommendations in Agent assist.
The top line beside the magnifying glass icon (🔍) shows the text researched, which is configurable but typically it's the short description field in the open record. Agent assist presents one or more recommendations. Agents can click the article to read more. To use the recommendation, agents click a link, which, in this example is **Link to Problem**. Links include:

- **Attach**—Attach the Knowledge Base article to the record and include the attachment in the Activity Stream.

- **Propose major incident**—Because many records report the same incident, the recommendation is to escalate the priority of fixing the issue.

- **Link to change**—Because many records appear to report the same problem because of a recent change, such as a software release, associate this record with the change, and propose the solution the similar records used.

- **Link to problem**—Associate this record with a common problem and propose the solution similar records used.

The following modules work together to configure predictions:
• Predictive intelligence and similarity (Predictive intelligence > Similarity > Solution Definitions)—A solution definition specifies what commonalities you’re looking for in records, for example, all point to the same Knowledge Base article, or all incidents are related to the same software upgrade.

• Trend definitions (Similarity Analyzer > Trend definitions)—Defines how many records that have something in common constitute a trend, for example, six or more records pointing to the same Knowledge Base article constitutes a trend.

Procedure
1. Define the commonalities you’re looking for.
   
a. Navigate to Predictive intelligence > Similarity > Solution Definitions) and click New.

b. On the Solution Definition form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solution template</td>
<td>Template for this form. Select the option that describes your commonality. Similarity template is the most generic template. Similar Incidents Template looks for incident records with similar short descriptions. Major Incident Template looks for incident records with similar short descriptions in the past 15 minutes.</td>
</tr>
<tr>
<td>Word Corpus</td>
<td>Text that displays in Agent assist that relates to the commonality defined in this form.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to look in for records.</td>
</tr>
<tr>
<td>Fields</td>
<td>One or more fields in the records to examine for common values.</td>
</tr>
<tr>
<td>Filters</td>
<td>Conditions that specify the commonality, for example, State is not Resolved + Severity is High + Short description contains build.</td>
</tr>
<tr>
<td>Processing Language</td>
<td>Agent’s language.</td>
</tr>
</tbody>
</table>
## Field Description

<table>
<thead>
<tr>
<th>Training Frequency</th>
<th>Suggestion how often to retrain the model so it doesn’t go stale. This value is not enforced and does not automatically retrain the model.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh Frequency</td>
<td>Frequency used to run the model on the records to find commonalities.</td>
</tr>
<tr>
<td>Label</td>
<td>Solution template name.</td>
</tr>
<tr>
<td>Name</td>
<td>Read only</td>
</tr>
<tr>
<td>Table to compare</td>
<td>Table to look in for similar records.</td>
</tr>
<tr>
<td>Fields to compare</td>
<td>Fields in records to look in for similar values.</td>
</tr>
</tbody>
</table>

### 2. Specify what constitutes a trend.

**a.** Navigate to **Contextual Search > Agent assist > Trend Definitions** and click **New**.

**b.** On the form, fill in the fields.

#### Trend Definition

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Trend name, for example, Common Change because you're looking for a similar change among records.</td>
</tr>
<tr>
<td>Table</td>
<td>Table the records come from that have been defined as having values in common.</td>
</tr>
<tr>
<td>Trend type</td>
<td>Commonality the trend is defined by. Options include:</td>
</tr>
<tr>
<td></td>
<td>• Common value—If more than the threshold number of records in the Table have the same value, it's a trend. For example, if six or more records have the same resolution code, it's a trend.</td>
</tr>
<tr>
<td></td>
<td>• Common reference—If more than the threshold number of records in the Table have the same reference to another table, it's a trend. For example, if at least the threshold number of records refer to the same Knowledge Base article, it's a trend.</td>
</tr>
<tr>
<td></td>
<td>• Common condition—If records have at least the threshold number of matching conditions, it's a trend. You might define six conditions for records. <strong>Threshold</strong></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>is the number of those conditions that should match to be considered a trend. For example, to detect major incidents, the conditions might be impact is high, creation date is within the past six hours, plus four more conditions. If records have at least the threshold number of matching conditions, there’s a trend, for example, at least four of the six conditions must match for there to be a trend.</td>
</tr>
<tr>
<td>Common field</td>
<td>Field in the table record to examine for common values.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this component applies to. Global means that the component applies to all applications.</td>
</tr>
<tr>
<td>Trend ID</td>
<td>Read only</td>
</tr>
<tr>
<td>Order</td>
<td>Sequence order in which Agent assist evaluates this trend. Trends are evaluated in order from the lowest to highest <em>Order</em> value.</td>
</tr>
<tr>
<td>Threshold</td>
<td>Minimum number of records having this commonality. For example, if the value is 10, then 10 or more records must have the commonality to be considered a trend.</td>
</tr>
<tr>
<td>Condition</td>
<td>Specifies when to show the notification, for example, <em>State is not Resolved + Severity is High + Short description contains build</em>. This field only appears when the <em>Trend Type</em> is <em>Common Condition</em>. You can create a condition that if this record was linked to a problem, you don’t want to link it back to that problem.</td>
</tr>
<tr>
<td>Reference type</td>
<td>Many-to-many (M2M) reference or one-to-one reference. An M2M reference is that many incidents can relate to a single record, and many records can relate to a single incident. Simple reference means there’s a direct relationship between cause and change.</td>
</tr>
<tr>
<td>M2M table</td>
<td>The many-to-many join of two tables. The table name must begin with m2m, for example, m2m_kb_task. This field only appears when the <em>Trend type</em> is <em>Common reference</em>.</td>
</tr>
<tr>
<td>M2M from field</td>
<td>Specifies which field is referring to another table. This field only appears when the <em>Trend type</em> is <em>Common reference</em>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>M2M to field</td>
<td>Specifies which field is being referred to from another table. This field only appears when the Trend type is Common reference.</td>
</tr>
</tbody>
</table>

The following example says that a trend is defined by 6 or more (Threshold) resolution codes (Common field) having the same value (Trend type) in the incident table (Table).

At this point, you've defined what a trend is. You haven't yet defined what action to take when there is a trend.

c. Click Submit.

3. Match solution definitions with trends.
In other words, if Trend A happens, recommend Solution A.

a. Navigate to Agent assist Recommendations and click New to connect solution definitions with a trend definitions.

b. On the form, fill in the fields.

**Agent assist Recommendation**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Recommendation name.</td>
</tr>
<tr>
<td>Table Configuration</td>
<td>Table to look for trends in.</td>
</tr>
<tr>
<td>Source type</td>
<td>Select Predictive Intelligence unless you're writing a script that joins the trends with solutions.</td>
</tr>
<tr>
<td>Solution Definition</td>
<td>Specify the solution definition to match with the trends you will subsequently list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle to make the recommendation active.</td>
</tr>
<tr>
<td>Order</td>
<td>If there are multiple, possible recommendation, this value establishes the priority of this recommendation; the lower the value, the higher the recommendation.</td>
</tr>
</tbody>
</table>

c. Right-click the form and click Save.

d. On the Trend Recommendations related list, click New to associate a trend with the Solution Definition.

e. On the form, fill in the fields.

**Trend Recommendation**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Trend name.</td>
</tr>
<tr>
<td>Agent assist Recommendation</td>
<td>Prefills with the value you specified for the recommendation name.</td>
</tr>
<tr>
<td>Trend definition</td>
<td>Select the trend definition you want to associate with this Solution Definition.</td>
</tr>
<tr>
<td>Order</td>
<td>If you have multiple trends associated with this Solution Definition, the priority of this trend in that list. The lower the number, the higher it appears in the Related list.</td>
</tr>
<tr>
<td>Recommendation title</td>
<td>Recommendation title that appears in Agent assist.</td>
</tr>
<tr>
<td>UI type</td>
<td>In the recommendation that displays in Agent assist, display the record or a message, which you will enter.</td>
</tr>
<tr>
<td>Primary Action</td>
<td>Select the Workspace Action to take, for example, Link to Problem.</td>
</tr>
<tr>
<td>Additional Actions</td>
<td>Additional Workspace Actions to take. Click the lock icon (🔒) and then the Workspace Action icon (🔧) and use the slushbucket to select the actions</td>
</tr>
</tbody>
</table>
### Field Description

- **Field**
  - to take. This field only displays with **UI type is Record display**.

  **Recommendation message**
  - Enter the message you want displayed in the Primary Action area of Agent assist. This field only appears when **UI type is Message display**.

- **Display Condition**
  - Optionally specify conditions when this trend should use this **Solution Definition**.

The following examples show when **UI type is Message display** and **Record display**.

<table>
<thead>
<tr>
<th>Message display</th>
<th>Record display</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Message display" /></td>
<td><img src="image" alt="Record display" /></td>
</tr>
</tbody>
</table>

f. Click **Submit**.

**Example:**

- **Common change (Name)**
- **Across similar records (found in step 1) in the Incident table (Table)**
- **Looking for a common reference (Trend Type), meaning the Analyzer is looking at a reference field to another record**
- **Looking for a simple style reference (Reference type) meaning the Analyzer is looking for a direct relationship between the incident and the change (Change is a parent of Incident)**
What to do next
Configure other components in the Contextual Sidebar or click a component in the following list to set it up.
Click a component to set it up.

- Tabs
- Notifications
- Form Header
- UI Actions
- Ribbon
- Related Items
- Form pane
- Actions & Components
- Activity Stream
- Contextual Side Panel
Configure Agent assist cards

Configure Agent assist cards to customize information agents view at a glance.

Before you begin
Role required: admin

Procedure
1. Navigate to Contextual Search > Search Result Display Configuration.
2. Filter the list by UI type and enter Workspace in the query field.
3. Open a card display configuration record.
4. On the form, fill in the Card View fields.

**Search Result Display Configuration form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI Type</td>
<td>UI type for your configuration. Workspace displays as this is a card for Agent assist.</td>
</tr>
<tr>
<td></td>
<td>⚠ Note: This field is read-only.</td>
</tr>
<tr>
<td>Table</td>
<td>Table associated with your configuration. For example Knowledge [kb_knowledge].</td>
</tr>
<tr>
<td></td>
<td>⚠ Note: This field is read-only.</td>
</tr>
<tr>
<td>Card Icon</td>
<td>Icon displayed on the preview card that indicates the type of card.</td>
</tr>
<tr>
<td></td>
<td>⚠ Note: This field is read-only.</td>
</tr>
<tr>
<td>Card label</td>
<td>Label displayed on the preview card. For example, Article, Incident, or Change Request.</td>
</tr>
<tr>
<td>Card title field</td>
<td>Title field. For example, short_description.</td>
</tr>
<tr>
<td>Card additional fields</td>
<td>Additional fields that display on the card. For example assigned_to, state, or priority.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Card description field</td>
<td>Description field.</td>
</tr>
<tr>
<td>Card display footer</td>
<td>Option to display a card display footer.</td>
</tr>
<tr>
<td>Application</td>
<td>Application this configuration applies to. Global means the rule applies to all applications.</td>
</tr>
</tbody>
</table>
| Note: This field is read-only.
| Context table               | Optional table that provides context to the configuration.                                                                                   |
| Note: This field is read-only.

5. On the form, fill in the Details View fields.

Note: The Details View configuration is not available for Knowledge, Catalog, and Response Templates sources. These sources return their own detail view that Agent assist displays.

<table>
<thead>
<tr>
<th>Search Result Display Configuration form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detail title field</td>
</tr>
<tr>
<td>Detail additional fields</td>
</tr>
<tr>
<td>Details show latest work note</td>
</tr>
</tbody>
</table>

6. Click Update.
Set up multiple Agent assist

Set up multiple Agent assists per table so that your agents can use Agent assist to search through different sources of information to find solutions related to records in the same table. For example, for records from the problem table, one Agent assist might search through employee records, another Agent assist might only search through Knowledge and the Service Catalog.

Before you begin
Role required: workspace_admin

About this task
You can combine multiple information sources that get searched in one Agent assist. If you want to restrict access to some of the information sources, you can set up multiple Agent assists for each information source, and grant permissions accordingly. For example, if you want to restrict some agents from seeing employee records, create an Agent assist that uses employee records as an information source but restrict the permissions of who can use that Agent assist.

Agent Assist appears as an icon in the Contextual side panel. The following example shows two Agent assists that are represented by two graduation cap icons (=edge). You get to choose the icon for the second Agent assist.

Procedure

1. Create an action that adds an additional Agent assist to the Contextual side panel for a table that is already set up for Agent assist.
   To see how, go to Add custom components to the Contextual Side panel. After completing these steps, you should have an icon for your new Agent assist in the Contextual side panel, as shown in the previous image, but when
you click it, nothing appears. The next steps make the icon bring up the second Agent assist in the Contextual side panel.

1. Note: Make sure that the **Action name** of the second Agent assist is different from the **Action name** of the first Agent assist. If the **Action name** is the same, the second Agent assist gets overwritten.

2. Navigate to **Contextual Search > Table Configuration** and click **New** to create a new table configuration for the same database table that you created an action for in the previous step.
   To see how to set up and save a table configuration, see [Set up Agent assist](#).

3. With the table configuration for the second Agent assist displaying, copy the `sys_id` by right-clicking the heading bar and clicking **Copy sys_id**. You will use this value in the following steps.
   Alternately, you can copy the `sys_id` in the URL.

4. Navigate to **Workspace Experience > Actions & Components > Contextual Side panel** and click the action that you created to display the second Agent assist.

5. On the Action Assignment page, under the related links, click **Advanced View**.

6. On the **Component Attributes** tab for `cxTableConfig`, enter the `sys_id` value of the table configuration that you copied in the previous steps.

7. If you add an Agent assist, you must add model fields.
   
   a. Right-click the top banner and navigate to **Configure > Form Layout**.
   
   The Configuring Action Assignment form appears.
   
   b. In the form, move Model Fields Required from the Available column to the **Selected** column and click **Save**.
   
   c. Click the lock icon (_UNLOCKED_LOCKED).
   
   d. Add these model fields: `isNewRecord`, `sysid`, `table`, `fields`.

8. Click **Update**.

9. To check the functioning of the second Agent assist:
a. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.

b. Open a record from the table that you associated with two Agent assists.

c. In the Contextual side panel, click the two Agent assist icons that you created.

**What to do next**
Click a component to set it up.

- Tabs
- Notifications
- Form Header
- UI Actions
- Ribbon
- Related Items
- Form pane
- Actions & Components
- Activity Stream
- Contextual Side Panel

**Personalize Agent assist search results**

Base Agent assist search results on a field in a record to return results for someone other than the agent.

**Before you begin**
Role required: admin
About this task
You can specify a field in a record as the person doing an Agent assist search. When you identify that field, Agent assist watches it and automatically changes the search results if the value of that field changes. You might watch such a field, for example, if agents create cases on behalf of customers or employees. Entering a customer's identity in that field in the form pane returns Agent assist search results that match the customer instead of the agent. Common fields that Agent assist watches are **caller** and **Assigned to**.

Procedure
1. Navigate to **Contextual Search > Table Configuration**.
2. Open any record where the **UI type** is **Workspace**.
3. Select the **Enable search as** check box to make Agent assist use the value of a field for the searcher's identity.
4. In the **Search as field** list, select the field in the record to use as the person doing the search.
   Search results for the user that you defined in the **Search as field** appear in a separate tab next to the search results for the current user.
5. Click **Submit**.
   This option appears in Agent assist as a slider that an agent can use to search while impersonating the user configured in the previous step. For example, the following image shows the value for **Caller** in the record used as the person doing the search.

What to do next
Click a component to set it up.
Set default source for search context

Choose an additional resource to be the default source or the searcher.

**Before you begin**
Role required: admin

**About this task**

- If you set an additional resource as the default source that source is considered the default search source.

- If you do not mark any additional resource as the default source, then the searcher source is considered the default search source.

- If you do not have a searcher and you have not marked any additional resource as the default source, the default is the additional resource with the lowest value in the **Order** field.
Procedure
1. Navigate to Contextual Search > Search Contexts.
2. Open the search context record to change its default source.
3. To set an additional resource as the default search source:
   a. Click the Additional Resource Configuration related list.
   b. Right-click the search resource configuration record and click Set as Default Search.
4. To set a searcher source as the default search source:
   a. Click the Set Searcher as the Default Search related link to set Searcher as the default search source.
   
   Note: The Set Searcher as the Default Search related link appears only if an additional resource is the default search source.
   
   b. To search all searcher sources or a specific searcher source from the list, select All.
   
   Note: The Searcher default search field appears only when the Searcher field contains more than one source.

Set catalog item request method in Agent assist
Set the request method for catalog items to match the catalog order experience.

Before you begin
Role required: admin

Procedure
1. Navigate to Service Catalog > Catalog Definitions > My Items.
2. Select a catalog item from the list.
3. In the related lists, select the Portal Settings tab.
4. In the Request method field, select Order, Request, or Submit.

Results
The request method displays your selection when ordering the catalog item.
Set up a dynamic filter for Agent assist

Use values from a Workspace form to dynamically filter results from Agent assist. If you change the value of a dynamic field in the form pane, Agent assist automatically searches based on the updated value. You can set up a dynamic filter in Agent assist for catalog results, knowledge articles, and open incidents.

Before you begin
Role required: admin

Procedure
1. Navigate to Contextual Search > Table Configuration.
2. Select Incident, Problem, or Change from the list.
3. In related lists, click Filter Configurations.
4. Click New.
5. On the form, fill in the fields.
Filter Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource configuration</td>
<td>Resource data is retrieved from. For example, <strong>Open Incidents</strong>.</td>
</tr>
<tr>
<td>Table configuration</td>
<td>Table configuration for Agent assist. <strong>Note:</strong> This field is automatically populated with the table you selected.</td>
</tr>
<tr>
<td>Scripted filter</td>
<td>Toggle to expand a scripting field.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for your filter configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle to activate the form.</td>
</tr>
</tbody>
</table>

6. Enter a script corresponding to the resource configuration.

**Note:** Use one of these **dynamic filter scripts** to set up your dynamic filter.

7. Click **Submit**.

What to do next
Continue setting up Agent assist from step 7.

Scripting for dynamic filters
Enter the following scripts with the corresponding resource configuration in the Table Configuration form to set up a dynamic filter in Agent assist.

**Catalog Items**
Filter for catalog items with the user-selected category.

**Note:** **Catalog** must be selected in the Resource configuration field of the Table Configuration form.

```javascript
(function(current, query_table){

    // Active results only.
    query_table.addActiveQuery();

    // Results matching the form selected category.
    // Note: Dot-walk from the category (ref) to the category title (category.title).
    query_table.addQuery("category.title", ",=",", current.getValue('category')");

```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Knowledge Articles
Filters for knowledge articles with the user-selected category.

<i>Note: Knowledge Articles</i> must be selected in the Resource configuration field of the Table Configuration form.

```javascript
(function(current, query_table) {
  // Active results only.
  query_table.addActiveQuery();

  // Results matching the form selected category.
  // Note: Dot-walk from the kb_category (ref) to the category label (kb_category.label).
  query_table.addQuery("kb_category.label", "," , current.getValue('category'));

  // Return the encoded query
  return query_table.getEncodedQuery();
})(current, query_table);
```

Open Incidents
Filters for incidents with the user-selected category.

<i>Note: Open Incidents</i> must be selected in the Resource configuration field of the Table Configuration form.

```javascript
(function(current, query_table) {
  // Filter based on the selected category in the form.
  query_table.addQuery('category', current.getValue('category'));

  // Return the encoded query
  return query_table.getEncodedQuery();
})(current, query_table);
```

Set up lookup and verify in Workspace
Configure a <b>Consumer lookup</b> or <b>Contact lookup</b> so that agents can easily verify the consumer or contact information.
Before you begin

- Requires the com.snc.sn_lookup_and_verify_config plugin
- Role required: workspace_admin

About this task

When talking with a customer, agents often want to verify who they're talking to. Lookup and verify pulls up customer information so the agent can ask the customer for personal data, such as a home address, to verify the identity of the person on the phone.

Two lookup and verify configurations are provided: one for contacts and one for consumers. You can configure settings in these configurations to control the type-ahead search and the information displayed in the search results and the verification card.

Procedure

1. Navigate to Workspace Experience > Lookup and Verify > Configuration.
2. Select a configuration from the list.
3. Select the Active option.
   A configuration must be active for the related UI action to appear on the interaction record.
4. Optional: In the Minimum characters to start typeahead search field, enter the minimum number of characters that you want for your search. For example, if the minimum number is 1, type ahead starts searching after the first character an agent enters. If the minimum number is 4, the search starts after the agent enters a fourth character. Too few characters might delay character entry as a search happens. Too many characters reduces the benefits of type-ahead searches.
5. In the Max result count list, set the maximum number of search results up to a maximum of 10.
6. Configure the Search results tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary field</td>
<td>Select the name of the field that you want an agent to see in the search results list.</td>
</tr>
<tr>
<td>Secondary fields</td>
<td>Unlock to access the Secondary fields and move a secondary field from the Available list to the Selected list. Lock when done.</td>
</tr>
</tbody>
</table>
7. Configure the Verification card tab. Unlock to access the Display fields and move a field from the Available list to the Selected list. Lock when done.

8. Click Update to save the configuration.

What to do next
Click a component to set it up.

Verify Contact and Verify Consumer UI action client script
The lookup and verify feature uses a client script for the Verify Contact and Verify Consumer UI actions.

The main function that calls the lookup and verify modal has been changed in the Orlando release. The g_csm.lookupAndVerify function call was replaced by g_modal.sn_lookup_verify.lookupVerify. The call back handling has also changed.
If you modified the lookup and verify UI action script in the Madrid or New York releases, you need to modify the script for the Orlando release. It is not updated automatically during the upgrade to Orlando. You can use the examples below to make the necessary changes.

**Client script for the Verify Contact UI action (Orlando)**

```javascript
function onClick(g_form) {
    if (!g_form.isVisible("contact")) {
        var msg = "You do not have permissions to verify the contact."
        getMessages([msg], function(messages)
            (g_form.addErrorMessage(messages[msg])));
        return;
    }

    var title = "Verify Contact";
    var confirm_title = "Done";
    var cancel_title = "Cancel";
    getMessages([title, confirm_title, cancel_title], function(messages) {
        var lookupConfig = {
            configID: '0a20d0c9b360230001f34d43c6a8dc0a',
            selectedEntityTableName: 'customer_contact',
            selectedEntitySysID: g_form.getValue('contact'),
            selectedEntityDisplayVal: g_form.getDisplayValue('contact'),
            modalTitle: messages[title]
        };

        g_modal.sn_lookup_verify.lookupVerify({
            title: messages[title],
            confirmTitle: messages[confirm_title],
            cancelTitle: messages[cancel_title],
            params: lookupConfig,
            disabledPrimaryButtonOnLoad: true,
            size: 'lg'
        }).then(
            function(confirm) {
                var data = confirm.data;
                var verifiedSysId = data.sysId;
                g_form.setValue('account', '');
                g_form.setValue('contact', verifiedSysId);
                g_form.setValue('verified', 'true');

                var ga = new GlideAjax('global.CSManagementUtils');
                ga.addParam('sysparm_name', 'getGlideRecordData');
                ga.addParam('sysparm_table_name', "customer_contact");
            }
        );
    });
}
```
ga.addParam('sysparm_sys_id', verifiedSysId);
ga.addParam('sysparm_fields', "account");
ga.getXML(function (serverResponse) {
    var items = serverResponse.responseXML.getElementsByTagName("item");
    for (var i = 0; i < items.length; i++) {
        var field = items[i].getAttribute("field");
        if (field == "account") {
            g_scratchpad.csaccountset = true;
            g_form.setValue("account", items[i].getAttribute("value"), items[i].getAttribute("display_value"));
            break;
        }
    }
    var info = "This contact has been verified."
    getMessages([info], function(messages)
        g_form.addInfoMessage(messages[info], 'info', '');
    });
    if (data.stringForLookup) {
        var interactionId = g_form.getUniqueValue();
        var ga = new GlideAjax('sn_lookup_verify.LookupVerifyUtil');
        ga.addParam('sysparm_name', 'associateRecordToInteraction');
        ga.addParam('sysparm_term', data.stringForLookup);
        ga.addParam('sysparm_interaction_id', interactionId);
        ga.getXMLAnswer(function (answer) {
            var result = JSON.parse(answer);
            if (result != null && result.table != null && result.sysId != null) {
                var params = {};
                params.sysparm_parent_table = "interaction";
                params.sysparm_parent_sys_id = g_form.getSysId();
                g_service_catalog.openCatalogItem(result.table, result.sysId, params);
            }
        });
    }
});
});
function (error) {
    console.log('cancel:'+error);
function onClick(g_form) {
    if (!g_form.isVisible("contact")) {
        var msg = "You do not have permissions to verify the contact.";
        getMessages([msg], function(messages)
            (g_form.addErrorMessage(messages[msg]));
        return;
    }

    var title = "Verify Contact";
    getMessages([title], function(messages) {
        var lookupConfig = {
            configID: '0a20d0c9b360230001f34d43c6a8dc0a',
            selectedEntityTableName: 'customer_contact',
            selectedEntitySysID: g_form.getValue('contact'),
            selectedEntityDisplayVal: g_form.getDisplayValue('contact'),
            modalTitle: messages[title]
        };

        var onConfirm = function(data) {
            var verifiedSysId = data.sys_id;
            g_form.setValue('account', '');
            g_form.setValue('contact', verifiedSysId);
            g_form.setValue('verified', true);

            var ga = new GlideAjax('global.CSManagementUtils');
            ga.addParam('sysparm_name', 'getGlideRecordData');
            ga.addParam('sysparm_table_name', "customer_contact");
            ga.addParam('sysparm_sys_id', verifiedSysId);
            ga.addParam('sysparm_fields', "account");
            ga.getXML(function(serverResponse){
                var items =
                    serverResponse.responseXML.getElementsByTagName("item");
                for(var i = 0; i < items.length; i++) {
                    var field = items[i].getAttribute("field");
                    if (field == "account") {
                        g_scratchpad.csaccountset = true;
                    }
                }
            });
        }
    });
}
g_form.setValue("account",
items[i].getAttribute("value"), items[i].getAttribute("display_value"));
break;
}
}
var info = "This contact has been verified."
getMessages([info], function(messages)
(g_form.addInfoMessage(messages[info], 'info', '"");
if (data.stringForLookup) {
  var interactionId = g_form.getUniqueValue();
  var ga = new GlideAjax('sn_lookup_verify.LookupVerifyUtil');
  ga.addParam('sysparm_name',
'associateRecordToInteraction');
  ga.addParam('sysparm_term', data.stringForLookup);
  ga.addParam('sysparm_interaction_id', interactionId);
  ga.getXMLAnswer(function(answer) {
    var result = JSON.parse(answer);
    if (result != null && result.table != null &&
result.sysId != null) {
      var params = {};
      params.sysparm_parent_table =
"interaction";
      params.sysparm_parent_sys_id =
g_form.getSysId();

g_service_catalog.openCatalogItem(result.table, result.sysId, params);
    }
  });
});
}
};
g_csm.lookupAndVerify(lookupConfig, onConfirm);

Set up Activity Stream in Workspace
Set up the options of how agents can interact with Activity Stream to make their
job easier.

Before you begin
Role required: workspace_admin
About this task
Activity Stream enables agents to communicate with requesters and make internal notes about the work done on a record. Internal notes are only visible to fellow agents. External comments are visible to agents and requesters.

In Activity Stream, agents can embed knowledge articles, import solutions from Agent Assist, and ask requesters for more information.

You can set system properties that give agents the option of using a:

- Rich text editor.
  The rich text editor includes the formatting icons for bold, italics, underlining, font, and so forth, as shown in the following image.
- Single box or separate text boxes to enter internal and external comments
  The following image shows the single-box option.
The following image shows separate, stacked boxes for internal and external communication.

Once you use system properties to enable these options, the sliders in the configuration menu appear.

**Procedure**

1. In the Filter Navigator, enter `sys_properties.list`. The list of system properties displays.
2. To give agents the option of having separate boxes for internal and external communications, search for and set the `glide.ui.activity.journal.stacked` property to `true`.

3. To give agents the option of using a rich text editor instead of a plain text editor in Activity Stream, search for and set the `glide.ui.journal.use_html` property to `true`. The default is `false`.

What to do next
Click a component to set it up.

---

Disable the Post Comments button from disappearing in Activity Stream

Disable the Post Comments button from disappearing in Activity Stream when mandatory fields aren’t filled in. The Post Comments button is functional even when mandatory fields aren’t filled in.
Before you begin

The **Post Comments** button disappears by default when the Comments or Work Notes fields are made mandatory by a UI Policy on the incident_task table. This task enables you to disable that functionality so that the button is visible and useable even when mandatory fields aren’t filled in.

Role required: admin

**Procedure**

1. Enter `sys_properties.list` in the Filter navigator.
2. Select `glide.activity.compose.can_post_mandatory_fields` from the list.
3. In the Value field, set the value to **true**.

**Display avatars on Activity Stream tiles**

Configure Activity Stream tiles to display avatars instead of icons, or both avatars and icons.

**Before you begin**

Role required: admin

**Procedure**

1. Display avatars on Activity Stream tiles.

   a. In the Filter navigator, enter `glide.activity.show_tile_avatars`.

   b. Select the property and in the value field enter **true**.

   c. Set the property to **true**.
      This property is set to **false** by default.

   d. Select **Update**.

2. Disable icons on Activity Stream tiles.
The SAP Human Resources application is not accessible

a. In the Filter navigator, enter `glide.asys`.

b. Select the property and in the value field enter `false`. This property is set to `true` by default. Leaving this field `true` displays both avatars and icons.

c. Select **Update**.

Set up Playbook Experiences

ServiceNow® Playbook experiences enable you to customize the default Playbook user experience to interact with your desired business process workflow.

Overview

Playbook provides fulfillers with a way to visualize business process workflows in a simple, task-oriented view. This workflow ensures consistent responses to commonly encountered situations. These business process workflows are designed with Process Automation Designer.

*Note:* The following documentation is for use with playbooks built using Process Automation Designer. If you are looking for information related to Security Incident Response Playbooks, see Security Incident Response Playbook Resources.

Installation

Playbook is available from the ServiceNow Store. For more information, see Install Playbook Experience.

Customize Playbook experiences

Playbook comes with a Global Playbook Experience record that defines a default Playbook configuration. You can use this record without any additional configurations. By default, this record defines a set of overrides for controlling how individual activities appear within Playbook. Activity overrides enable you to override the Playbook UI.
You can customize any of this behavior by creating a custom Playbook experience with your own configurations and activity overrides. These records will extend or, optionally, override the global Playbook experience.

**Start here**

**Install Playbook Experience**
You can install the Playbook Experience application (com.snc:playbook-experience) if you have the admin role.

**Before you begin**
- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

Role required: admin

**About this task**
The following items are installed with Playbook Experience:
- Plugins
- Store applications
- Roles
- Tables

For more information, see Components installed with Playbook.

**Procedure**
1. Navigate to System Applications > All Available Applications > All.
2. Find the Playbook Experience application (com.snc:playbook-experience) using the filter criteria and search bar.
   - You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.
   - Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
3. In the Application installation dialog box, review the application dependencies.
Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Playbook Experience.

4. Click **Install**.

**What to do next**
You have the option to install the Process Automation Experience Demo which contains example Process Definitions, Activity Definitions, Flows, and context records for showing a Playbook within Agent Workspace. For more information, see **Install Process Automation Experience Demo**.

**Components installed with Playbook**
Several types of components are installed with activation of the Playbook application, including tables and user roles.

ℹ️ **Note**: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see **Find components installed with an application**.

Demo data is available for this feature.

**Roles installed with Playbook**
Roles are added with activation of the Playbook application.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Playbook Experience Admin</td>
<td>Role required to configure tables used to render the Playbook Experience.</td>
<td>• pd_shared.admin</td>
</tr>
<tr>
<td>[playbook_experience.admin]</td>
<td></td>
<td>• uxframework_user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_slm_timer.sla_timer_admin</td>
</tr>
<tr>
<td>Playbook Shared Admin</td>
<td>Role required for CRUD operations on shared tables.</td>
<td>• pd_shared.user</td>
</tr>
<tr>
<td>[pd_shared.admin]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Tables installed with Playbook**
Tables are added with activation of Playbook
### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>
| Playbook Activity Override
[sys_playbook_activity_renderer]                | List of overrides that can be applied to Playbook activities.               |
| Playbook Experience
[sys_playbook_experience]                  | List of Playbook Experience configurations.                                 |
| Playbook Experience Action Assignment Map
[sys_playbook_experience_action_assignment_map] | List that maps declarative actions to playbook experiences.                 |
| Playbook Configuration
[sys_playbook_experience_configuration]       | List of Playbook Configurations.                                            |
| Playbook Experience Record Generator
[sys_playbook_experience_record_generator]    | List of playbook record generator configurations.                           |
| Playbook Experience Activity State To Experience Status Map
[sys_playbook_experience_state_to_status]    | List used for mapping experience status records to activity states.         |
| Playbook Experience Status Mapping
[sys_playbook_experience_status_mapping]       | List of status mapping records used in the Playbook Experience Activity State To Experience Status Map. |
| Playbook Experience Status To Activity State Map
[sys_playbook_experience_status_to_state]    | List of activity state mapping records used in the Playbook Experience Activity State To Experience Status Map. |

**Note:** All additional tables installed by the dependent plugins are also needed for Playbook.

**Install Process Automation Experience Demo**

You can install the Process Automation Experience Demo application (sn_pad_demo) if you have the admin role. The application includes demo data and installs related ServiceNow® Store applications and plugins if they are not already installed.
Before you begin

- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

Role required: admin

About this task
The following items are installed with Process Automation Experience Demo:
- Plugins
- Store applications
- Roles
- Tables

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the Process Automation Experience Demo application (sn_pad_demo) using the filter criteria and search bar.

   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.

   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Process Automation Experience Demo.

4. Click Install.

Configure a Playbook user experience
Create a container for your Playbook experience. Your custom Playbook experience acts as a container for your configurations and activity overrides.

Before you begin
Role required: playbook_experience.admin
The sys_id of the Playbook Experience record is used when integrating Playbook into Workspace or a page built with UI Builder.

**About this task**
Enter a name and select the application and domain that you want to associate with the Playbook experience.

**Procedure**
1. Navigate to **Playbook Experience > Playbook Experiences**.
2. Click **New**.
3. On the form, fill in the fields.

### Playbook Experience form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for your Playbook experience.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this Playbook experience applies to. Global means that the Playbook experience applies to all applications.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain for the playbook, if other than Global. A domain associates records with specific callers and companies. Select a domain that the Playbook experience is associated with.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**What to do next**
Create a **playbook configuration** for your Playbook experience.

**Create Playbook experience configurations**
Define a custom configuration for this Playbook experience. Customize the Playbook user experience including activity filters, assignment badges, embedded forms, and SLA timers in each activity.

**Before you begin**
Role required: playbook_experience.admin
About this task
This task is optional. If you don’t define a custom configuration for your Playbook experience, the global Playbook experience configuration is used instead.

Procedure
1. Navigate to Playbook Experience > Playbook Experiences.
2. Select a Playbook experience.
3. Click the Configurations related list.
4. Select a playbook configuration or click New.
5. On the form, fill in the fields.

Playbook Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Activity State</td>
<td>Option to display the state of the activity within the activity card to orient the user.</td>
</tr>
<tr>
<td>Filter fields</td>
<td>List of field names that appear in a drop-down filter at the top of the Playbook. For example: assigned_to or state. Separate each field name with a comma. Field values come from an activity's associated record.</td>
</tr>
<tr>
<td>Filter on playbook card status</td>
<td>Option to include activity states in the drop-down filter.</td>
</tr>
<tr>
<td>Assigned to field</td>
<td>Field used to populate an Assigned to badge and avatar that shows up on each Playbook card. The field value comes from the activity's associated record.</td>
</tr>
<tr>
<td>Max form fields on card</td>
<td>Maximum number of form fields in a Playbook card. Forms that exceed this size instead render in a modal.</td>
</tr>
</tbody>
</table>

Note: An activity's state is not the same as the state of its associated record.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand first prioritized card</td>
<td>Expand the first prioritized card in each stage of the playbook.</td>
</tr>
<tr>
<td>Order</td>
<td>Integer that determines the precedence of this configuration in relation to other matching configurations in this Playbook experience. The lower the number, the more likely it will be selected over another configuration. The typical practice is to use numbers that are in the hundreds. For example, 100, 200, 300, or 400.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate your playbook configuration.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this playbook configuration applies to. Global means that the component applies to all applications.</td>
</tr>
<tr>
<td>Playbook experience</td>
<td>Playbook experience associated with this configuration. This field is automatically populated when you configure the Playbook Experience form.</td>
</tr>
<tr>
<td>Playbook table</td>
<td>Table to limit this configuration to a specific Playbook. Specify the table that contains the Playbook. If the Playbook was built with Process Automation Designer, select Process Definition &lt;sys_pd_process_definition&gt;.</td>
</tr>
<tr>
<td>Playbook record</td>
<td>Playbook record to limit this configuration to a specific Playbook. Choose a record from the table that appears in the Playbook table field. For example, select a specific Process Definition.</td>
</tr>
<tr>
<td>SLA configuration</td>
<td>Activities can be configured to show an SLA timer for the task record.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
|                               | associated with activities. Specify an SLA configuration record used to select the correct SLA to display in this case. If no SLA configuration is selected, the SLA that breaches first is used. SLA configurations include:  
• Do not show SLA timer  
• Incident Response and Resolution Team  
• Show SLA that will breach first |
| Inaccessible Data Visibility  | Option to hide data or activities that the logged-in user cannot access.                                                                      |
| Pending Item Visibility       | Option to hide the activities or stages that are not yet triggered.                                                                           |

6. Click Submit.

**What to do next**
Set up additional **playbook activity overrides**.

**Set up playbook activity overrides**
Create additional activity overrides that extend or replace overrides defined by the global Playbook experience. Playbook activity overrides enable you to override the default display behavior of individual activities within your playbook.

**Before you begin**
Role required: playbook_experience admin

**About this task**
After specifying a set of conditions, you can override the UI. This override enables you to change the default prioritized state, required roles, and the UI component used to display matching activities in a playbook for a specific playbook experience. By default, all activity overrides defined for the global Playbook experience are used. You can extend or override these records with your own records for your Playbook experience.
Procedure

1. Navigate to **Playbook Experience > Playbook Experiences**.
2. Select a Playbook experience.
3. Click the **Activity Overrides** related list.
4. Click **New**.
5. On the form, fill in the fields.

### Playbook Activity Override form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for your activity override.</td>
</tr>
<tr>
<td>Order</td>
<td>Integer that determines the precedence of this activity override over other matching overrides in this Playbook experience. The lower the number, the more likely it will be selected over other overrides. The typical practice is to use numbers that are in the hundreds. For example, 100, 200, 300, or 400.</td>
</tr>
<tr>
<td>Application</td>
<td>Application for the activity override.</td>
</tr>
<tr>
<td>Playbook experience</td>
<td>Playbook experience associated with this activity override. This field is automatically populated when you create the configuration from the Playbook Experience form.</td>
</tr>
<tr>
<td>Description</td>
<td>Description for the activity override. This description is displayed in the Playbook Activity Overrides list and provides context on the form.</td>
</tr>
</tbody>
</table>

6. Click the **When to apply** tab.
7. On the form, fill in the fields.
   This form enables you to specify which activities this override applies to.
### When to apply form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experience Type</td>
<td>Experience type that you want to match.</td>
</tr>
<tr>
<td></td>
<td>Click the search icon (🔍) to select an activity type, or click <strong>New</strong> on the Activity Type form to create a new activity type.</td>
</tr>
<tr>
<td>Parent Table</td>
<td>Parent table for the record. Match the table for the input record that triggered the playbook.</td>
</tr>
<tr>
<td>Parent Table Conditions</td>
<td>Conditions evaluated against the parent record that triggered the playbook.</td>
</tr>
<tr>
<td>Activity State</td>
<td>Match against a specific Activity State such as &quot;In Progress&quot;.</td>
</tr>
<tr>
<td>Associated Table</td>
<td>Table associated with an activity.</td>
</tr>
<tr>
<td>Associated Record Conditions</td>
<td>Conditions evaluated against the activity’s associated record.</td>
</tr>
<tr>
<td>Experience Property Conditions</td>
<td>Conditions evaluated against the activity properties and defined by the <strong>Type</strong> field selection.</td>
</tr>
</tbody>
</table>

8. Click the **What to override** tab.

   This form enables you to specify what behavior you want to override in matching activities.

### What to override form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Renderer</td>
<td>UI component used to render matching activities in Playbook. If no UI component is selected, the default renderer is used.</td>
</tr>
<tr>
<td>Prioritized</td>
<td>Option to prioritize matching activities. Select <strong>None</strong>, <strong>Yes</strong>, or <strong>No</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>None</td>
<td>If None is selected, activities are prioritized while they're in progress. The first prioritized activity within a stage is expanded by default. All other prioritized activities in the same stage have a blue dot when collapsed. A badge in the stage navigation displays how many prioritized activities are in each stage.</td>
</tr>
</tbody>
</table>

Roles Required

<table>
<thead>
<tr>
<th>Roles Required</th>
<th>Roles required to view matching activities. Unless specified, users can view all activities within a playbook.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td>Users can only view a playbook if they have read access on the input record that triggered the playbook.</td>
</tr>
</tbody>
</table>

10. Click **Submit**.

What to do next

Define **Playbook actions**.

**Playbook record generator**

Use the playbook record generator to guide a user through the record creation process using a playbook experience.

Process Automation Designer requires a record to be created or updated before a process can start. However, you can use the playbook record generator to allow users to create a new record using the playbook experience. You can then configure your workspace or UI Builder page to display the record generator playbook experience component in place of the standard new record form when a user opens a new record tab.

Playbook record generator inserts a record generator activity as the first step within a specified process definition created with Process Automation Designer. This record generator activity contains a new record form. Once a user submits the form, the user is redirected to the newly created record, which now contains a running process. The running process guides the user through the rest of the record creation. If no process definition is running after the new record form is submitted, then the playbook will manually trigger whichever process definition was shown to user before record creation. The user stays within the playbook.
experience before and after the record is created for a seamless and guided record creation experience.

Admins can specify the name of the record generator activity, the form view, and the process definition shown to the user before the record is created. Admins can also optionally configure the declarative action used to submit the form.

**Setup playbook record generators**

Use the playbook record generator to display a process before a record is created.

**Before you begin**

Role required: playbook admin

**About this task**

Use playbook record generators to create records using a playbook. Agents no longer need to create records before viewing a playbook.

**Procedure**

1. Navigate to **Playbook Experience > Record Generators**
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select the table for which the new record page should use the record generator entry.</td>
</tr>
<tr>
<td>Process Definition</td>
<td>Select the process definition you want to display before a record is created. All activities will be marked pending. If no process is running after the record is created, playbook will then manually trigger this process definition.</td>
</tr>
<tr>
<td>Create Record Activity Name</td>
<td>Enter a name to display on the record generator activity inserted as the first step within the specified process definition.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Option to activate the record generator.</td>
</tr>
<tr>
<td>Order</td>
<td>Integer that determines the precedence of this configuration in relation to other activities in a Playbook experience. The lower the number, the more likely it will be selected over another configuration. The typical practice is to use numbers that are in the hundreds. For example, 100, 200, 300, or 400.</td>
</tr>
<tr>
<td>Create Record Form View</td>
<td>Select the form view to use for the new record form embedded within the inserted activity.</td>
</tr>
<tr>
<td>Template Fields</td>
<td>Optional field values that can be pre-filled in the new record form.</td>
</tr>
</tbody>
</table>

4. **Click Submit.**

**What to do next**

If you are adding a record generator to a playbook configured in Paris or Quebec, you need to update your workspace integration to include the isNewParentRecord attribute. For more information, see [Integrate Playbook with Workspace](#).

You can override the **Continue** button associated with playbook record generator with your own custom conditions, label, and coloring by creating a new declarative action. Use the same name as the declarative action associated with the global playbook experience and associate it with your custom playbook experience. For more information, see [Custom Playbook actions](#).

**Preview a playbook**

Preview playbooks in real time within a non-production environment.

**Before you begin**

Role required: `pd_author`, `pd_operator`, `pd_trigger_author`, `pd_content_author`, `pd_shared.admin`, `pd_admin`, `pd_shared.user`, or `playbook_experience.admin`
About this task
Use playbook preview to test processes created in Process Automation Designer or HR Lifecycle Events including the following:

• Activity definitions
• Declarative actions
• Record Generator configurations
• Playbook experience configurations
• Activity overrides

Procedure
1. Navigate to Playbook Experience > Playbook Preview.
3. Select a **Parent table**.
4. Select a **Parent record**. You can select an existing record or **New Record** to preview the playbook record generator process in the currently selected table.
5. Select a **Playbook experience**.
6. Click **Done**.
7. A preview of your playbook appears.

The Playbook Preview Configuration Details side panel is where you can change the playbook preview. You can select from the following options:

- **Parent Table**—Select the parent table containing the record you want to see a playbook for.
- **Parent Record**—Select a parent record or **New Record**
- **Playbook Experience**—Select the playbook experience
- **Activity View**—Select stacked or focused view
- **View Compact Mode**—Option to preview your playbook in compact mode.
The playbook preview configuration details sidebar is automatically exposed when previewing a playbook. You can hide the sidebar by clicking the arrow in the top right of the sidebar. If the sidebar is not exposed, click the gear icon to open the configuration details sidebar.

The playbook preview URL updates as changes are made in the configuration details side panel. You can bookmark playbook previews to easily access specific configurations in the future.

**Custom Playbook actions**

Customize Playbook interactions by setting up conditions that add buttons, drop-downs, list items, and clickable icons. This customization enables you to submit forms, open records, and complete and skip activities across all Playbook experiences.

**Overview**

Playbook actions can run server scripts, dispatch client actions, or render UI components when triggered. When running server scripts, the current variable is tied to the activity’s associated record. If you want client actions to trigger events within UI Builder, see Configure UXF client actions for playbook.

Flow Data records (sys_flow_data) are often used as associated records to control the configuration of a flow through an action server script. These server scripts can set the state of the flows to complete or skipped, enabling an agent to directly affect logic within a flow.

Flow Data records can also collect user data from an agent to use within a flow. An associated record can be tied to any table. You can define your own actions beyond these default actions to accomplish the business process workflow logic that you want.

**Default actions**

The following default actions are supported in Playbook.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skip</td>
<td>Skips an instructional process step</td>
</tr>
<tr>
<td>skip_instructional</td>
<td>Skips an instructional process step</td>
</tr>
<tr>
<td>Skip</td>
<td>Skips sending an email</td>
</tr>
<tr>
<td>skip_email</td>
<td>Skips sending an email</td>
</tr>
<tr>
<td>Skip</td>
<td>Skips a knowledge process step</td>
</tr>
<tr>
<td>skip_knowledge</td>
<td>Skips a knowledge process step</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Skip skip_update</td>
<td>Skips an update record process step</td>
</tr>
<tr>
<td>Skip skip_list</td>
<td>Skips a list process step</td>
</tr>
<tr>
<td>Skip skip_create</td>
<td>Skips a create record process step</td>
</tr>
<tr>
<td>Mark Completed</td>
<td>Mark an activity as complete</td>
</tr>
<tr>
<td>complete_activity</td>
<td></td>
</tr>
<tr>
<td>Create Record</td>
<td>Create a new record from a new record form</td>
</tr>
<tr>
<td>create_record</td>
<td></td>
</tr>
<tr>
<td>Send Email send_email</td>
<td>Informs process automation to send email</td>
</tr>
<tr>
<td>Restart restart_activity</td>
<td>Restarts the activity</td>
</tr>
<tr>
<td>Skip skip_activity</td>
<td>Mark activities using an experience status record as skipped.</td>
</tr>
<tr>
<td>View Record View Record</td>
<td>View the current record</td>
</tr>
<tr>
<td>Save save_record</td>
<td>Save the current record</td>
</tr>
<tr>
<td>View Approvers Playbook View Approvers</td>
<td>View approvers for this record</td>
</tr>
<tr>
<td>Mark Complete mark_complete_knowledge</td>
<td>Marks a knowledge process step complete</td>
</tr>
<tr>
<td>Mark Complete mark_complete_instruction</td>
<td>Marks an instructional process step complete</td>
</tr>
<tr>
<td>Mark Complete mark_complete_list</td>
<td>Marks a list process step complete</td>
</tr>
<tr>
<td>Mark Complete</td>
<td>Marks the current process complete</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>mark_complete</td>
<td></td>
</tr>
</tbody>
</table>

**Customize Playbook actions**

Customize Playbook actions using forms, conditions, and scripts, components, or client actions. This customization enables users to submit forms, open records, and complete and skip activities.

**Before you begin**

Role required: playbook_experience.admin

**About this task**

- Default actions can't be edited. These actions are displayed as read only.
- Actions can only operate against one record.

**Procedure**

1. Create the action and specify details.

   a. Navigate to Playbook Experience > Actions Playbook Actions, Stage Actions, or Activity Actions.

   b. Select an action assignment or click New to create a new one.

   i. **Note:** For a list of default actions, see Playbook actions.

   c. On the form, fill in the fields.

---

**Action Assignment form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Label</td>
<td>Label that appears on the button created through the action.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Name for your action that appears in the action assignment list. An action assignment overrides others with the same name.</td>
</tr>
<tr>
<td>Implemented as</td>
<td>Type of action that is implemented. For example, UI Component.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Specify UI Component</td>
<td>When the <strong>Implemented as</strong> field is set to UI Component, this field specifies a UI component that is displayed when the action is triggered.</td>
</tr>
<tr>
<td>Tooltip</td>
<td>Text that displays when an agent points their cursor over a button or icon.</td>
</tr>
<tr>
<td>Icon</td>
<td>Icon that displays in the activity card.</td>
</tr>
<tr>
<td>Render Mode</td>
<td>Render mode on a Playbook card. Specify how the action renders on the Playbook card. <strong>Select Button, Header Dropdown, or Header Icon.</strong></td>
</tr>
<tr>
<td>Button Type</td>
<td>Button type that's displayed in the Playbook UI. Select <strong>Primary</strong>, <strong>Secondary</strong>, or <strong>Tertiary</strong>.</td>
</tr>
<tr>
<td>Form fields required</td>
<td>Option that communicates that the action requires data from the user to proceed. This field is consumed in the Playbook experience UI in the following ways.</td>
</tr>
<tr>
<td></td>
<td><strong>i.</strong> When an activity contains a form that's too large to fit on a card, the form is hidden in a modal.</td>
</tr>
<tr>
<td></td>
<td><strong>ii.</strong> When an Activity contains a form but doesn't have actions that require form fields, the form is not rendered. Instead, the fields on the form are rendered as a stacked collection of label-value pairs.</td>
</tr>
<tr>
<td></td>
<td>This field can be overridden by creating a custom activity renderer.</td>
</tr>
<tr>
<td>Description</td>
<td>Description for the action that's displayed in the Action Assignments list.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Application | Application for the action assignment.
Workspace | Workspace that the playbook action is associated with. For example, ServiceNow® ITSM or HR. **Note:** This field is not required.
Table | Field to limit this action to activities with this associated table.
View | Field to limit this action to activities with this Form View.
Active | Option to activate the action.
Order | Integer that determines the precedence of this action in relation to matching actions with the same name. The lower the number, the more likely it is to be selected against other actions. This ordering enables you to override other actions with your own. The typical practice is to use numbers that are in the hundreds. For example, 100, 200, 300, or 400.

2. Set up conditions for the action.

   **a.** Click the **Conditions** tab.

   **b.** On the form, fill in the fields.

   **Conditions form**

   | Field | Description |
   --- | --- |
   Script Condition | Script condition for the action assignment. Enter `sn_playbook.PlaybookExperience.parentRecordContainsPlaybook(current)`. This script enables you to show a Playbook only when the record has triggered a process execution.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> Adding queries involving multiple joins can impair performance.</td>
<td></td>
</tr>
<tr>
<td>Client Conditions</td>
<td>Choose conditions to limit collisions based on your use case.</td>
</tr>
<tr>
<td>Record Conditions</td>
<td>Choose conditions to limit collisions based on your use case.</td>
</tr>
<tr>
<td>Required Roles</td>
<td>Roles to limit Playbook access.</td>
</tr>
<tr>
<td>Requires create access</td>
<td>Options to require create access.</td>
</tr>
<tr>
<td>Requires read access</td>
<td>Option to require read access.</td>
</tr>
<tr>
<td>Requires write access</td>
<td>Options to require write access.</td>
</tr>
<tr>
<td>Requires delete access</td>
<td>Options to require delete access.</td>
</tr>
</tbody>
</table>

3. If **Server Script** is selected in the **Implemented as** field, provide a script for the action.
   - Server scripts can reference the associated record of an activity using the `Current` variable.
   - Calling `current.update()` updates the associated record with values that the user provides from embedded forms on Playbook cards.

4. If **Client Action** is selected in the **Implemented as** field, optionally specify the payload mapping on the **Action Attributes** tab.
   - Payload mapping enables you to override portions of the payload dispatched by the client action. For example, the Preview Record client action enables you to open a record on a new Workspace tab. Using payload mapping, you can specify a related item tab that displays when the form opens. Set the `defaultTab` to do this.

5. If **UI Component** is selected in the **Implemented as** field, optionally specify the component’s attributes on the **Component Attributes** tab.

6. Click **Submit**.

**Apply playbook actions to playbook experiences**

Apply default or custom playbook actions to playbook experiences.

**Before you begin**

Role required: playbook_experience_admin
Procedure
1. Navigate to **Playbook Experience > Playbook Experiences**.
2. Select a Playbook experience.
3. Click the Action Mapping related list.
4. Click **New**.
5. On the form, fill in the fields.

### Playbook Experience Action Assignment Map

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Assignment</td>
<td>Select the declarative action assignment</td>
</tr>
<tr>
<td>Playbook Experience</td>
<td>Choose which Playbook Experience to apply the action</td>
</tr>
<tr>
<td>Application</td>
<td>Application in which the action is applied</td>
</tr>
<tr>
<td>Activity Definition</td>
<td>Select the activity definition to apply the action</td>
</tr>
</tbody>
</table>

6. Click **Submit**.
7. In the related links section, select the **Playbook Experience Mapping** tab.
8. Verify that the playbook experience has been added to the table.

**What to do next**

**Integrate your Playbook experience** with **Workspace**.

**Configure UXF client actions for playbook**

Create playbook UXF client actions for use within **UI Builder**.

**Before you begin**

Role required: **admin**

Use UXF client actions to trigger events within **UI Builder**. UXF Client Actions can be used in the **Playbook**, **Stage**, and **Activity Actions**.

**Procedure**

1. Navigate to **Playbook Experience > Actions Playbook Actions, Stage Actions, or Activity Actions**.
2. Select an action assignment or click **New** to create a new one.
3. On the form, fill in the fields.

### Action Assignment form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Label</td>
<td>Label that appears on the button created through the action.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Name for your action that appears in the action assignment list. An action assignment overrides others with the same name.</td>
</tr>
<tr>
<td>Implemented as</td>
<td>Select <strong>UXF Client Action</strong>.</td>
</tr>
<tr>
<td>Specify Client Action</td>
<td>Select the magnifying glass icon (🔍) and choose a <strong>Client Action</strong>.</td>
</tr>
<tr>
<td>Tooltip</td>
<td>Text that displays when an agent points their cursor over a button or icon.</td>
</tr>
<tr>
<td>Icon</td>
<td>Icon that displays in the activity card.</td>
</tr>
<tr>
<td>Render Mode</td>
<td>Render mode on a Playbook card. Specify how the action renders on the Playbook card. <strong>Select Button, Header Dropdown, or Header Icon</strong>.</td>
</tr>
<tr>
<td>Button Type</td>
<td>Button type that's displayed in the Playbook UI. Select <strong>Primary</strong>, <strong>Secondary</strong>, or <strong>Tertiary</strong>.</td>
</tr>
<tr>
<td>Form fields required</td>
<td>Option that communicates that the action requires data from the user to proceed. This field is consumed in the Playbook experience UI in the following ways.</td>
</tr>
<tr>
<td></td>
<td><strong>a.</strong> When an activity contains a form that's too large to fit on a card, the form is hidden in a modal.</td>
</tr>
<tr>
<td></td>
<td><strong>b.</strong> When an Activity contains a form but doesn't have actions that require form fields, the form is not</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>Description for the action that’s displayed in the Action Assignments list.</td>
</tr>
<tr>
<td>Application</td>
<td>Application for the action assignment.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace that the playbook action is associated with. For example, ServiceNow® ITSM or HR.</td>
</tr>
<tr>
<td>Note: This field is not required.</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Field to limit this action to activities with this associated table.</td>
</tr>
<tr>
<td>View</td>
<td>Field to limit this action to activities with this Form View.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the action.</td>
</tr>
<tr>
<td>Order</td>
<td>Integer that determines the precedence of this action in relation to matching actions with the same name. The lower the number, the more likely it is to be selected against other actions. This ordering enables you to override other actions with your own. The typical practice is to use numbers that are in the hundreds. For example, 100, 200, 300, or 400.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**What to do next**
Implement the UXF client action for playbook using UI Builder.
Integrate Playbook with Workspace

Integrate Playbook within the related items tab or the Contextual side panel in Workspace

Before you begin
Role required: admin

Procedure

1. Navigate to Workspace Experience > Actions & Components > Related Items or Contextual Side Panel.
2. Click New.
3. On the form, fill in the fields.

Action Assignment form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action label</td>
<td>Label of the Related Item or Contextual Side panel tab.</td>
</tr>
<tr>
<td>Action name</td>
<td>Unique name for your item. This name can be overridden.</td>
</tr>
<tr>
<td>Implemented as</td>
<td>Select <strong>UI Component</strong>.</td>
</tr>
<tr>
<td>Specify UI component</td>
<td>UI component associated with the action. Enter <code>now-playbook-experience</code>.</td>
</tr>
<tr>
<td>Icon</td>
<td>Icon that is displayed in the Contextual side panel to differentiate from other components.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available for the Contextual Side Panel only.</td>
</tr>
<tr>
<td>Application</td>
<td>Application for the action assignment.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Option to limit a Related Item or Contextual Side Panel to a specific Workspace. For example, Agent Workspace or HR Workspace.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table you want to show the Related Item or Contextual Side Panel on.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
View | Field to only display a Playbook when this Form View is selected on the parent record.
Active | Option to activate the action assignment.
Order | Integer that determines the precedence of this action in relation to matching actions with the same name. The lower the number, the more likely it is to be selected against other actions. The typical practice is to use numbers that are in the hundreds. For example, 100, 200, 300, or 400.
Tooltip | Message that’s displayed when your mouse points to the Related Item tab or Contextual Side Panel icon.
Description | Description for the action assignment. This description is displayed in the Action Assignment list and provides context on the form.

4. Click the **Advanced View** related link.

5. Click the **Component Attributes** tab.

6. On the form, fill in the fields.

### Component Attributes form

<table>
<thead>
<tr>
<th>Attribute name</th>
<th>Description</th>
</tr>
</thead>
</table>
| playbookExperienceId | Associated Playbook experience ID. Copy and paste the sys_id of a Playbook Experience record. **Note:** If no Playbook experience ID is provided, the global Playbook experience is used by default.
<p>| parentSysId | Associated parent sys_id. Enter <code>{{sysId}}</code> to automatically take... |</p>
<table>
<thead>
<tr>
<th>Attribute name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>parentTable</td>
<td>Associated parent table. Enter {{table}} to automatically take the parentSysId of the record that you're viewing.</td>
</tr>
<tr>
<td>compactMode</td>
<td>Option to display a Playbook in compact mode. Typically set to true for Contextual Side Panel and false for Related Item.</td>
</tr>
<tr>
<td>recordGeneratorQuery</td>
<td>Not currently supported in Agent Workspace.</td>
</tr>
<tr>
<td>isNewParentRecord</td>
<td>Set to {{isNewRecord}}.</td>
</tr>
</tbody>
</table>

**Note:** Select a different **UI Component** if the attributes are missing from your form. Change the **UI Component** back to **now-playbook-experience** and the attributes will appear.

7. Click the additional actions icon (≡) and select **Save**.
8. Click the **Conditions** tab.

### Conditions form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script Condition</td>
<td>Script condition for the action assignment. Enter <code>sn_playbook.PlaybookExperience.parentRecordContainsPlaybook(current)</code> to show a Playbook only when the record has triggered a process execution.</td>
</tr>
<tr>
<td>Client Conditions</td>
<td>Choose conditions to limit collisions based on your use case.</td>
</tr>
<tr>
<td>Record Conditions</td>
<td>Choose conditions to limit collisions based on your use case.</td>
</tr>
<tr>
<td>Required Roles</td>
<td>Roles to limit Playbook access.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>Requires create access</td>
<td>Option to require create access.</td>
</tr>
<tr>
<td>Requires read access</td>
<td>Option to require read access.</td>
</tr>
<tr>
<td>Requires write access</td>
<td>Option to require write access.</td>
</tr>
<tr>
<td>Requires delete access</td>
<td>Option to require delete access.</td>
</tr>
</tbody>
</table>

10. Click the additional actions icon (Ξ) and click Save.

Playbook activity state mapping

Use playbook activity state mapping to override the status of a playbook card.

Overview

A playbook card's state comes from the Activity State by default. Activity states come from the Sub Flow or Flow Action powering the activity.

Activity Definition authors can specify a record to provide the status shown in playbook cards. This record is referred to as an Experience Status Record. It is specified within an Activity Definition's experience properties.

Any record from any table can be used as an Experience Status Record. Default activity definitions use sys_flow_data records as their Experience Status Record.
Activity States displayed in card view

Default Activity States

Out-of-the-box Default Activity States in sys_flow_data record.

<table>
<thead>
<tr>
<th>Status</th>
<th>Flow State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>Flow has not started</td>
</tr>
<tr>
<td>In Progress</td>
<td>Flow is running</td>
</tr>
<tr>
<td>Complete</td>
<td>Flow has finished</td>
</tr>
<tr>
<td>Skipped</td>
<td>Flow was skipped due to conditions</td>
</tr>
<tr>
<td>Error</td>
<td>Flow encountered an error</td>
</tr>
</tbody>
</table>

Activity states are used in the following:

- Declarative Action conditions
- Activity Override conditions
- Animations
- Card visual experience
Exceptions
Business logic doesn’t always align one-to-one with the flow. The following are examples of exceptions:

- An agent clicks **Skip** on an instructional card. The flow displays as complete, but the business logic is skipped.

- An agent clicks **Restart** on a completed instructional card. The flow does not restart the flow, just update the **Flow Data** record.

- A flow may never complete if a task is waiting for input from an agent to restart a loop. The associated task is effectively complete in this state.

Playbook activity state-mapping rules
Use activity state-mapping rules to control which activity state is shown in a card for a given experience status record.

Activity state-mapping rules are required for each Experience Status Table. These rules determine how to update the experience status record when a playbook user updates an activity state, such as completing an activity.

Out-of-the-box Global Playbook Experience includes a default rule set for the **sys_flow_data** table. This rule set is enough for most playbook activities, but additional rules can be created for custom tables if needed.

Activity state-mapping rules for a given Experience Status Table are unique for each Playbook Experience and can be accessed in the related tabs by clicking **Status Mapping**.

### Status Mapping tab

![Status Mapping tab](image)
Experience status mapping records
Each Experience Status Mapping record specifies which field on the Experience Status Tables contains the Experience Status value. Experience Status Mapping records also have the following related lists.

- Experience Status to Activity State rules
- Activity State to Experience Status rules

Experience Status Mapping record related lists

The Experience Status to Activity State form controls which activity state is shown in a card for a given experience status record value. The form populates the Experience Status Record Value list with the choice values of the Experience Status Field.

Activity State to Experience Status form controls how the experience status record is updated when a playbook user updates an activity state, such as skipping an activity. The form populates Experience Status Record Value list with the choice value of the Experience Status Field.
Playbook activity state-mapping permissions

User permissions must be assigned to allow agents to complete, skip, or restart activities in playbook using activity state mapping.

**Can Complete, Can Skip, and Can Restart** permissions are determined whenever an activity is fetched based on the following conditions:

- **Experience Status Record** must be defined
- Users must have write access on **Experience Status Record**
- Activity State Mapping rule set must exist for **Experience Status Table**
- User must have write access on **Experience Status Field** for that table
- **Activity State to Experience Status** mapping rule must exist for that corresponding operation:

<table>
<thead>
<tr>
<th>Playbook Activities</th>
<th>Activity State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can Complete</td>
<td>Complete</td>
</tr>
<tr>
<td>Skip</td>
<td>Skipped</td>
</tr>
<tr>
<td>Restart</td>
<td>In Progress</td>
</tr>
</tbody>
</table>

If the permissions are not valid, users cannot perform that operation. The corresponding declarative actions that use the **Can Complete, Can Skip, and Can Restart** client conditions will not display.

**Note:** If a user does not have read access on the **Experience Status Field** of the **Experience Status Record**, the default activity state will be used instead. The default activity state is the state of the flow powering the activity.

Configure experience status mapping

Configure experience status mapping for playbook status mapping.
Before you begin
Role required: playbook_experience.admin

Procedure
1. Navigate to Playbook Experience > Playbook Experiences and select a playbook experience.
2. Select Status Mapping.
3. Click New.
4. On the form, fill in the fields.

Playbook Experience Status Mapping form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experience Status Table</td>
<td>Which Experience Status Table this mapping is for</td>
</tr>
<tr>
<td>Experience Status Field</td>
<td>Which choice field on the table contains the Experience Status value</td>
</tr>
<tr>
<td>Order</td>
<td>Order of precedence for multiple mapping records on the same table</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that activates or deactivates the status-mapping table.</td>
</tr>
</tbody>
</table>

5. Click Submit.

6. Select the Experience Status to Activity State tab.
7. Click New.
8. On the form, fill in the fields.

Playbook Experience Status to Activity State Map

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experience Status Record Value</td>
<td>Choose an Experience Status to map to a Playbook Activity State</td>
</tr>
<tr>
<td>Activity Card Value</td>
<td>Choose a corresponding Playbook Activity State to display in a card for the given Experience Status</td>
</tr>
</tbody>
</table>

9. Click Submit.
10. Repeat steps 7 through 9 until all values have been added for every possible Experience Status.

11. Select the Activity State to Experience Status tab.

12. Click New.

13. One the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Card Value</td>
<td>Choose a Playbook Activity State to map to an Experience Status</td>
</tr>
<tr>
<td>Experience Status Record Value</td>
<td>Choose which value should be set on the Experience Status Record when a Playbook user assigns that Activity State to an activity</td>
</tr>
</tbody>
</table>

14. Click Submit.

15. Repeat steps 12 through 14 until all values have been added for every possible Activity State.

Manually trigger a Playbook
Use a server script to manually trigger a playbook.

Trigger Playbook function
Manually trigger a Playbook using a server script function with the following code:

```javascript
sn_playbook.PlaybookExperience.triggerPlaybook('<scoped name>',parentRecord);
```

Replace `<scoped name>` with the scoped name of your playbook. You can find the scoped name by locating the process definition in the `sys_pd_process_definition` table and copying the name and application scope fields. Replace `parentRecord` with the input/parent record you want to run the process on.

The server script throws an exception on failure. You can add an info message when successful and an error message on failure.

Helper functions
Use the following scriptable function to determine if a Playbook is already running on a record before displaying a UI action or declarative action to trigger it.
To view every playbook running on a given parent record use the following code:

```python
sn_playbook.PlaybookExperience.parentRecordContainsPlaybook(parentRecord, '<scoped name>')
```

This information can be used to control when to show a trigger playbook action such as a UI action.

The following section is an example of how to use the trigger playbook function to create an Add Playbook button.

**Create an Add Playbook UI Action**

Create an Add Playbook UI Action in workspace.

**Before you begin**

Role required: workspace_admin

**Procedure**

1. Navigate to **System Definitions > UI Actions**.
2. Click **New**.
3. In the form, fill in the fields.

**Note:** Other fields than those in the following table appear in the form but they do not function in workspaces. For more information on each field on the UI actions form, see **Set up custom UI actions in Workspace**.

**UI Action Form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>UI action name. This appears in the workspace UI, for example, Add Onboarding Playbook.</td>
</tr>
<tr>
<td>Table</td>
<td>Table the UI action applies to. Every time an agent displays a record from this table, this UI action appears.</td>
</tr>
<tr>
<td>Order</td>
<td>Placement in the horizontal list of UI actions. From left to right, the Order numbers go from small to large.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action Name</strong></td>
<td>Equivalent of <strong>Name</strong> that appears in logs and table columns, for example, interaction_add_onboarding</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Toggle to make the UI action appear.</td>
</tr>
<tr>
<td><strong>Show update</strong></td>
<td>Toggle to show the update in the <strong>Table</strong>.</td>
</tr>
<tr>
<td><strong>Condition</strong></td>
<td>Conditions that must be satisfied for the UI Action to appear, for example, current.canWrite() &amp;&amp; ! sn_playbook.PlaybookExperience.parentRecordContainsPlaybook(current, 'sn_pad_demo.playbook_onboarding_demo').</td>
</tr>
<tr>
<td><strong>Script</strong></td>
<td>Server-side script that implements the UI action.</td>
</tr>
<tr>
<td><strong>Application</strong></td>
<td>Application that this component applies to. Global means that the component applies to all applications.</td>
</tr>
</tbody>
</table>

4. To create a server-side script that implements the add playbook action, enter the script in the **Script** field.

```java
try{
    current.update();
    sn_playbook.PlaybookExperience.triggerPlaybook('sn_pad_demo.playbook_onboarding_demo', current);
    gs.addInfoMessage(gs.getMessage("Onboarding Playbook added to Interaction."));
} catch(e){
    gs.addErrorMessage(e.getMessage());
}
```

The system ignores any client scripts that are included in this field. You can only use the workspace client script field for client scripts. Replace `sn_pad_demo.playbook_onboarding_demo` with the scoped name of your playbook. You can find the scoped name by locating the process definition in the `sys_pd_process_definition` table and copying the name and application scope fields.

5. In the **Workspace** tab, select: **Workspace Form Button** to make the add playbook button appear on the line of UI actions, or **Workspace Form Menu** to make it appear as a list in the menu list.

6. In the **Workspace Client Script** field, create a workspace-specific client script.
Workspace has similar client scripting limitations as Service Portal. For example, to open a form by clicking it, you could add the following client script:

```javascript
function onClick(g_form) {
}
```

Add a cancel playbook action

Add a cancel playbook action to the playbook actions menu.

**Before you begin**

Role required: playbook_experience.admin

**Procedure**

1. Create the cancel action and specify details.

   a. Navigate to **Playbook Experience > Actions Playbook Actions**.

   b. Click **New**.

   c. On the form, fill in the fields.

   **Action Assignment form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Label</td>
<td>Label that appears on the button created through the action. For example, Cancel Playbook.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Name for your action that appears in the action assignment list. For example, cancel_student_playbook. An action assignment overrides others with the same name.</td>
</tr>
<tr>
<td>Implemented as</td>
<td>Select <strong>Client Action</strong>.</td>
</tr>
<tr>
<td>Specify Client Action</td>
<td>Select <strong>Cancel Playbook</strong>.</td>
</tr>
<tr>
<td>Tooltip</td>
<td>Text that displays when an agent points their cursor over a button or icon.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>Description for the action that's displayed in the Action Assignments list.</td>
</tr>
<tr>
<td>Application</td>
<td>Application for the action assignment.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace that the playbook action is associated with. For example, ServiceNow® ITSM or HR.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field is not required.</td>
</tr>
<tr>
<td>Table</td>
<td>Field to limit this action to activities with this associated table.</td>
</tr>
<tr>
<td>View</td>
<td>Field to limit this action to activities with this Form View.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the action.</td>
</tr>
<tr>
<td>Order</td>
<td>Integer that determines the precedence of this action in relation to matching actions with the same name. The lower the number, the more likely it is to be selected against other actions. This ordering enables you to override other actions with your own. The typical practice is to use numbers that are in the hundreds. For example, 100, 200, 300, or 400.</td>
</tr>
</tbody>
</table>

2. Set up action attributes.
   a. Select the **Action Attributes** tab.
   b. Select **playbookContextId** in the **Payload Map** drop down.
   c. Enter `{{playbook_context_id}}` into the value field.

3. Set up conditions for the action.
   a. Click the **Conditions** tab.
   b. Select **Playbook Status is In Progress** in the **Client Conditions** drop down.
   c. Select **Requires write access**.

4. Click **Submit**.
Embedding a form in playbook

Use the User Form activity definition when creating a form in which an agent can decide when an activity is complete.

The User Form activity definition lets the process owner specify a table, record, form view, form fields, display fields, SLA Timer, checklist, and attachments and automatically display the corresponding form.

The form automatically renders the following:

- An **Update** button that saves the agent's progress.
- A **Mark Complete** button that will allow the agent to specify when they are done updating the record and ready to move to the next step.
- A **Skip** button to move to the next activity without completing the form.
- A **Restart** button appears once the activity is marked complete or skipped by the agent. The agent can restart the activity if necessary.

Create your own custom activity definition based on the user form activity definition if you want to customize the logic. The process owner can optionally specify the **Assigned To** or **Assignment Group** fields to control which users can mark the activity as complete.

**Declarative Actions that require form fields**

A form without a submit button is rendered as read-only to allow the process owner to control when an agent can complete a form. For example, you could configure a form that can only be submit if the agent is a member of the ITIL user role, the activity is progress, and the incident is high priority. All conditions must be met, otherwise the form remains read only.

**Create a user form for Playbook**

Create an editable user form within a playbook.

**Before you begin**
Role required: process_automation.admin

**Procedure**

1. Navigate to **Process Automation > Process Automation Designer**.
2. Select a process from the list or create a new process.
3. Select **Add an activity**.
4. Select **Global**.
5. Select **User Form**.
6. Select **Configure activity** under **Activity properties**.

7. In the form, fill in the fields.

---

### Configure your activity

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Label</strong></td>
<td>Name of the activity to display to users in Process Automation Designer.</td>
</tr>
<tr>
<td><strong>Start Rule</strong></td>
<td>Select the when to the activity should start running.</td>
</tr>
<tr>
<td><strong>Lane</strong></td>
<td>Select the lane in which the activity runs.</td>
</tr>
<tr>
<td><strong>Activity Definition</strong></td>
<td>Select the activity definition.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Optional description for the activity.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>Name of the table whose records the activity can access as inputs. Typically, this table is either the Task [task] or Global [global] table.</td>
</tr>
<tr>
<td><strong>Record</strong></td>
<td>Reference to the record associated with the activity.</td>
</tr>
<tr>
<td><strong>Assignment Group</strong></td>
<td>Group responsible for completing the task associated with the activity.</td>
</tr>
<tr>
<td><strong>Assign To</strong></td>
<td>User responsible for completing the task associated with the activity.</td>
</tr>
<tr>
<td><strong>Form View</strong></td>
<td>A UI View used to render a form for editing the associated record via Declarative Actions.</td>
</tr>
<tr>
<td><strong>Form Fields</strong></td>
<td>Follows the same rules as Form View but only displays the fields specified in a comma-separated list. Specified form fields must be in the corresponding Form View for access control list purposes. If no Form View is specified, then the Form View view is used. Fields render without a client scripting environment which means that UI Policies, Client</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Scripts and Field Decorators will not work. As such, this should only be</td>
</tr>
<tr>
<td></td>
<td>used if creating a UI View for every combination of fields needed is too</td>
</tr>
<tr>
<td></td>
<td>onerous for your use case.</td>
</tr>
<tr>
<td>Display Fields</td>
<td>Select additional record fields to display in the user form.</td>
</tr>
<tr>
<td>Footer</td>
<td>Text displayed in the card footer.</td>
</tr>
<tr>
<td>Show Attachments</td>
<td>Drop down displaying attachments attached to the parent record, associated</td>
</tr>
<tr>
<td></td>
<td>record, or none.</td>
</tr>
<tr>
<td>Show SLA</td>
<td>Option to render an SLA timer in the header of the card for the associated</td>
</tr>
<tr>
<td></td>
<td>record. The SLA is chosen according to the SLA configuration record specified</td>
</tr>
<tr>
<td></td>
<td>in the playbook configuration.</td>
</tr>
<tr>
<td>Show Checklist</td>
<td>Option to display a checklist that is attached to the associated record.</td>
</tr>
<tr>
<td></td>
<td>Checklists are editable and changes are saved without requiring a declarative action.</td>
</tr>
</tbody>
</table>

8. Select **Update**.

**Configure activity stream for playbook**

Provide agents a way to view the history for a parent record or associated record in playbook.

**About this task**

Role required: process_automation.admin

Activity streams at the playbook and stage level only display history for the parent record. Activity actions display history from associated records.

**Procedure**

1. Navigate to **Playbook Experience > Actions** and select **Playbook Actions**, **Stage Actions**, or **Activity Actions**.

2. On the form fill, in the fields.
# Action Assignment form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Label</td>
<td>Label that appears on the button created through the action.</td>
</tr>
<tr>
<td>Action name</td>
<td>Name for your action that appears in the action assignment list. An action assignment overrides others with the same name.</td>
</tr>
<tr>
<td>Implemented as</td>
<td>Select <strong>UI Component</strong> from the list.</td>
</tr>
<tr>
<td>Specify UI component</td>
<td>Enter <code>now-playbook-activity-stream-modal-connected</code>.</td>
</tr>
<tr>
<td>Icon</td>
<td>Icon that displays in the activity card.</td>
</tr>
<tr>
<td>Render Mode</td>
<td>Render mode on a Playbook card. Specify how the action renders on the Playbook card. Select Button, Header Dropdown, or Header Icon.</td>
</tr>
<tr>
<td>Button type</td>
<td>Button type that's displayed in the Playbook UI. Select <strong>Primary</strong>, <strong>Secondary</strong>, or <strong>Tertiary</strong>.</td>
</tr>
<tr>
<td>Form Fields Required</td>
<td>Option that communicates that the action requires data from the user to proceed. This field is consumed in the Playbook experience UI in the following ways.</td>
</tr>
<tr>
<td></td>
<td><strong>a.</strong> When an activity contains a form that's too large to fit on a card, the form is hidden in a modal.</td>
</tr>
<tr>
<td></td>
<td><strong>b.</strong> When an Activity contains a form but doesn’t have actions that require form fields, the form is not rendered. Instead, the fields on the form are rendered as a stacked collection of label-value pairs. This field can be overridden by creating a custom activity renderer.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Application for the action assignment.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace that the playbook action is associated with. For example, ServiceNow® ITSM or HR.</td>
</tr>
<tr>
<td>Table</td>
<td>Field to limit this action to activities with this associated table.</td>
</tr>
<tr>
<td>View</td>
<td>Field to limit this action to activities with this Form View.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the action.</td>
</tr>
<tr>
<td>Order</td>
<td>Integer that determines the precedence of this action in relation to matching actions with the same name. The lower the number, the more likely it is to be selected against other actions. This ordering enables you to override other actions with your own. The typical practice is to use numbers that are in the hundreds. For example, 100, 200, 300, or 400.</td>
</tr>
<tr>
<td>Description</td>
<td>Description for the action that's displayed in the Action Assignments list.</td>
</tr>
</tbody>
</table>

**Note:** This field is not required.

---

3. Select the **Component Attributes** tab.

4. On the form, fill in the fields.

### Component Attributes form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>table</td>
<td>Select the table you want to display an activity stream for.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>• For playbook and stage level, {{table}} shows an activity stream for the parent table.</td>
</tr>
<tr>
<td></td>
<td>• For activity level, {{table}} shows an activity stream for an associated table.</td>
</tr>
<tr>
<td>sysId</td>
<td>Select the record you want to display an activity stream for.</td>
</tr>
<tr>
<td></td>
<td>• For playbook and stage level, {{sysId}} shows an activity stream for the parent record.</td>
</tr>
<tr>
<td></td>
<td>• For activity level, {{sysId}} shows an activity stream for an associated record.</td>
</tr>
<tr>
<td>modalTitle</td>
<td>Provide a title for the activity stream modal.</td>
</tr>
</tbody>
</table>

5. Select the **Conditions** tab.

6. Set the conditions for when you would like the activity stream to display.

7. Click **Submit**.

**Configure wait for condition form**

Configure the wait for condition form for use in playbook.

**Before you begin**

**Role required**: admin

Use the Wait for Condition activity definition to update records with a form in playbook. The following instructions specify when an activity is complete. For example, you want an agent to set an incident's Assigned to Field and provide a Short Description. You would use the Wait for Condition's condition builder to specify:

• Short description is not empty
• Assigned to not empty (or changed)

The moment an agent fills in the short description and assigned to fields in playbook, workspace, legacy UI, or mobile, the activity completes. The activity is not tied to any user experience.
Procedure


2. Switch to the activity’s advanced view in Process Automation Designer.

3. Select the Activity Experience tab.

4. Choose the corresponding table for Associated Table.

5. Use the pill picker to map the Associated Record to the same record being used in the Wait for Condition:
   • VL > Wait for Condition > Inputs > Record

6. Provide a title and description (optional).
   a. Map the Title to the activity’s Label and Description to the activity’s Description so the process owner can easily change these properties without switching to the advanced view in the future.

7. Specify a Form View that you’d like to show and / or a comma-separated list of Form Fields.

   Note: If you specify a comma-separated list of form fields, those fields must be in the selected form view. If you only specify from fields without specifying a form view, then those fields must be in the default view.

   a. The default view is typically not supported in workspace. This results in "this form is not configured for workspace" error when the form is rendered. Perform the following to resolve the issues.
      • Specify workspace as a form view.
      • Add the table name to the system property sn_agent_workspace.default_view_editable_tables.
      • Create a custom view.

8. Optionally provide a footer, SLA timer, attachments, or checklist.

Upgrading playbooks for Quebec

Upgrade playbooks created in Paris for the Quebec release.

Several new platform features were added to Playbook Experience in Quebec. These features are backward compatible with Playbooks built in the Paris release so that they will not break existing behavior.

Some features require manual upgrade steps to take advantage of them on existing playbooks, activity definitions, and declarative actions.
Playbooks need to be upgraded to render Complete and Skip buttons correctly. Use the following instructions to update your existing playbooks for Quebec.

Upgrade playbooks for Quebec

Before you begin
Role required: process automation admin

Procedure
2. Select the process you want to upgrade from the list.
3. Select an instructional activity.
4. Select Configure activity.
5. Select Advanced View.
6. Use the pill picker for Experience Status Record to choose the record output by the first Collect Flow Data step.
7. Select Update.
8. Select Activate.

Upgrade existing activity definitions for playbook in Quebec

Activity definitions are backwards compatible with Playbook in Quebec, but they require a slight modification to display properly.

Before you begin
Role required: process automation admin

Procedure
2. Select the process you want to upgrade from the list.
3. Select an activity.
4. Make any change to the activity.
5. Select Save.
6. Click Activate.

Results
The activity definition is now updated to work with Quebec.
Set up custom UI actions in Workspace

Set up UI actions to customize Workspace for your organization. UI actions include custom buttons, menu items and limiting access to forms based on a user's role.

Before you begin
Role required: workspace_admin

About this task
UI actions appear either as form buttons or list items in the UI action menu.

Each workspace comes preconfigured with UI actions. You can, however add to or remove preconfigured UI actions.

Custom UI actions.
You can hide UI Actions for people who do not need to take action on records. For more information, see Hide the Details tab and UI Actions.

Procedure
1. Navigate to System Definition > UI Actions and click New.
2. In the form, fill in the fields.

Note: Other fields than those in the following table appear in the form but they do not function in workspaces. For more information on each field on the UI actions form, see UI actions.

<table>
<thead>
<tr>
<th>Name</th>
<th>UI action name. This appears in the workspace UI, for example, Assign incident to me.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table the UI action applies to. Every time an agent displays a record from this table, this UI action appears.</td>
</tr>
<tr>
<td>Order</td>
<td>Placement in the horizontal list of UI actions. From left to right, the Order numbers go from small to large.</td>
</tr>
<tr>
<td>Action name</td>
<td>Equivalent of Name that appears in logs and table columns, for example, assign_incident_to_me</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle to make the UI action appear.</td>
</tr>
<tr>
<td>Show insert</td>
<td>Toggle to insert the record change into the Table.</td>
</tr>
<tr>
<td>Show update</td>
<td>Toggle to show the update in the Table.</td>
</tr>
<tr>
<td>Client</td>
<td>Toggle to make the system check for client-side scripts. The default is server-side scripts. Use the GlideAgentWorkspace API in a script to open a specified record an Workspace tab.</td>
</tr>
<tr>
<td>List v2</td>
<td>Toggle to specify that the UI Action occurs in a V2 list. This is optional. Select it only if the UI Action works for both v2 and v3 lists.</td>
</tr>
<tr>
<td>List v3</td>
<td>Toggle to specify that the UI Action occurs in a V3 list. Select if the UI Action appears in a v3 list.</td>
</tr>
<tr>
<td>Overrides</td>
<td>UI Actions that override this UI Action.</td>
</tr>
<tr>
<td>Comments</td>
<td>Description of this UI Action.</td>
</tr>
<tr>
<td>Hint</td>
<td>Describes the UI action when the mouse hovers over the UI action.</td>
</tr>
<tr>
<td>Onclick</td>
<td>Action taken with mouse click on the UI Action, for example, confirmAndDeleteFromForm().</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions that must be satisfied for the UI Action to appear, for example, current.isValidRecord() &amp; current.canDelete().</td>
</tr>
<tr>
<td>Script</td>
<td>Server-side script that implements the UI action.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this component applies to. Global means that the component applies to all applications.</td>
</tr>
<tr>
<td>Form button</td>
<td>Toggle to show the UI Action as a button in the form pane.</td>
</tr>
<tr>
<td>Form context menu</td>
<td>Toggle to show the UI Action as a tab in the Related Items menu.</td>
</tr>
<tr>
<td>Form link</td>
<td>Toggle to show the UI Action as a link in the form pane.</td>
</tr>
</tbody>
</table>
| Form style      | • Primary—Colors the UI Action blue.  
• Destructive—Colors the UI Action red.  
• Unstyled—Does not color the UI Action.                                                                                                          |
<p>| List banner button | Toggle to show the UI Action as a button in the list banner.                                                                                                                                                |
| List bottom button | Toggle to show the UI Action as a button at the bottom of the list of records.                                                                                                                               |
| List context menu | Toggle to show the UI Action as an entry in the context menu of the list.                                                                                                                                     |</p>
<table>
<thead>
<tr>
<th>List choice</th>
<th>Toggle to show the UI Action as a drop-down list of choices in list view.</th>
</tr>
</thead>
<tbody>
<tr>
<td>List link</td>
<td>Toggle to show the UI Action as a link in list view.</td>
</tr>
<tr>
<td>List style</td>
<td>• Primary—Color the UI Action blue.</td>
</tr>
<tr>
<td></td>
<td>• Destructive—Color the UI Action red.</td>
</tr>
<tr>
<td></td>
<td>• Unstyled—Does not color the UI Action.</td>
</tr>
</tbody>
</table>

3. **Optional:** To create a server-side script that implements the UI action, enter the script in the **Script** field.

For example, if you want to include the caller name and the short description in an incident that is created from an interaction record, you could use the following script that uses **GlideRecord**

```javascript
if(current.update()){
    var inc = new GlideRecord("incident");
    inc.newRecord();
    inc.caller_id = current.opened_for;
    inc.short_description = current.short_description;
    action.openGlideRecord(inc);
}
```

The system ignores any client scripts that are included in this field. You can only use the workspace client script field for client scripts.

4. **Optional:** To create a client-side script that implements the UI action, see **Supported client script types and APIs** and also, **Service Portal and client scripts**
5. In the **Workspace** tab, select: **Workspace Form Button** to make the UI action appear on the line of UI actions, or **Workspace Form Menu** to make it appears as a list item in the menu list.

- **Workspace Form Button** to make the UI action appear on the list of UI actions.
- **Workspace Form Menu** to make the UI action appear as a list item in the menu associated with UI actions.

6. **Optional:** In the **Workspace Client Script** field, create a workspace-specific client script. Workspace has similar client scripting limitations as Service Portal. For example, to open a form by clicking it, you could add the following client script:

   ```javascript
   function onClick(g_form) {
   }
   ```

7. In the **Requires role** tab of the workspace section, add any roles that you want to limit access to the UI action to.

8. Click **Submit** or **Update**.

**What to do next**

Click a component to set it up.

<table>
<thead>
<tr>
<th>Tabs</th>
<th>Ribbon</th>
<th>Activity Stream</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notifications</td>
<td>Related Items</td>
<td>Contextual Side Panel</td>
</tr>
<tr>
<td>Form Header</td>
<td>Form pane</td>
<td></td>
</tr>
<tr>
<td>UI Actions</td>
<td>Actions &amp; Components</td>
<td></td>
</tr>
</tbody>
</table>
Render a Now component in a modal

Use a UI Action to launch a custom Now component in a modal so an agent doesn't have to navigate to a different screen to accomplish a task.

Before you begin
Role required: workspace_admin

About this task
Launch a custom component in a modal so an agent doesn't have to leave the current screen. For example, you can launch a modal that contains contact information about the customer named in an open record so an agent can ask callers to confirm their identity. The following example shows a list in a modal.
Procedure

1. Develop and deploy a custom component to your instance. For more information, see Custom components.

2. Create an entry in the Registered Scripting Modal.
   a. In the Filter Navigator, enter `sys_aw_registered_scripting_modal.list` to open that table.
   b. Click New.
   c. Use the search icon (🔍) to select a component, in this case, use `sn-workspace-header`.
   d. Enter the name of the API, in this case `showHeader`.
   e. Public API gets auto-populated:
f. Click **Save**.

3. Author your UI Action to render your component in a modal.

a. Create a new UI Action for the appropriate table and on the **Workspace** tab, select either **Workspace Form Button** or **Workspace Menu Button** depending on how and where you want the UI Action to appear. For information on creating a UI Action, see Set up UI Actions in **Workspace**.

When you select one of the check boxes, the **Workspace Client Script** text box appears.

b. Enter the following code in the **Workspace Client Script** text box:

```javascript
function onClick(g_form) {
  g_modal.global.showHeader({
    title: 'Test custom modal',
    confirmTitle:'YES',
    params: {
      primaryValue: 'THIS IS A PRIMARY VALUE',
      secondaryItems:{},
    }
  }).then(function(result){
    alert('confirm:'+result);
  }, function(error) {
    alert('cancel:'+error);
  });
}
```
4. Now test the UI Action by opening a record in Workspace from the table you selected when creating this UI Action. The UI Action should appear in the Form pane.

**Close tab and save-and-close tab UI Actions**

Use the `closeRecord()` method to close a tab, or save and close a tab.

**Before you begin**
Role required: admin

**About this task**
You can use the `closeRecord()` method to author a UI Action that closes a tab.

**Procedure**

1. Follow the instructions on Set up custom UI actions in Workspace to set up a client-side UI Action.

2. In the **Workspace Client Script** field, add the following client script UI Action to close a tab.

```javascript
function onClick(g_form) {
    g_aw.closeRecord();
}
```

3. In the **Workspace Client Script** field, add the following client script UI Action to save the contents of the tab and close it.

```javascript
function onClick(g_form) {
    g_form.save().then(function()
    {
        g_aw.closeRecord();
    });
}
```

**Group UI actions in Workspace**

Define a group of one or more UI actions to customize the actions in the form header menu.

The group of UI actions is displayed on the form header under a single menu button or split button. To group your UI actions, first create a layout, then group the UI actions.
Create a layout for your table view

Create a layout for your table view to group your UI actions.

Before you begin
Role required: admin

About this task
Layouts create a place where your UI action groups are placed. You can create layouts specific to a form view. Select a table specific to the form view.

Procedure
1. Navigate to **Workspace Experience > Forms > UI Action Layouts**.
2. Click **New**.
3. On the form, fill in the fields.

**UI Action Layouts form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout name</td>
<td>Name for your UI action layout.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for your UI action layout.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Application scope matches the scope you're in and is read-only.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace for your UI action layout.</td>
</tr>
<tr>
<td></td>
<td>Associate UI actions layout to a specific workspace.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Workspace is by default Global when left empty.</td>
</tr>
<tr>
<td>Table</td>
<td>Table for your UI action layout.</td>
</tr>
</tbody>
</table>
### Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>View for your UI action layout.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> View is by default <strong>Global</strong> when left empty.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the form.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

### Group UI actions in Workspace

Create a UI action group. Define the table, view, and the workspace that displays the UI action layout and the UI action groups. Set the display color of the menu or split button to primary, secondary, or unstyled.

**Before you begin**
Create a layout for your table view before performing this task.
Role required: admin

**About this task**
- Your UI action renders as a standalone UI action when only one UI action from the group renders.
- To reorder your UI actions, open the group record and click the lock icon. Reorder your UI actions then press the lock icon again to lock it.
- To order your split button, change the Order field on the group form.

**Procedure**
1. Navigate to **Workspace Experience > Forms > UI Action Groups**.
2. In the UI Action Groups related list, click **New**.
3. On the form, fill in the fields.

### UI Action Group form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for your UI action group.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of UI action group. Choose between <strong>Menu</strong> and <strong>Split Button</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Overflow</td>
<td>Option to place the UI action group in the overflow menu by default.</td>
</tr>
<tr>
<td>Color</td>
<td>Color for your UI action group. Select <strong>Primary</strong> (green), <strong>Secondary</strong> (red), or <strong>Unstyled</strong> (gray).</td>
</tr>
<tr>
<td>Order</td>
<td>Order for your UI action group.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for your UI action group.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Application matches the scope you're in and is read-only.</td>
</tr>
<tr>
<td>UI Action layout</td>
<td>UI action layout that your UI group is applied to. Select the UI action layout you previously configured.</td>
</tr>
<tr>
<td>UI Actions</td>
<td>UI action to group.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> UI actions evaluate according to individual conditions.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the form.</td>
</tr>
<tr>
<td>Description</td>
<td>Description for your UI action group.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Customizing workspace**

Customize your workspace forms, fields, lists, and related lists without writing custom scripts or learning APIs.

You can create actions and components in workspace that perform an action, such as dialing a phone number, adding a Now component to the Contextual side panel, deleting a related list, or adding a record to the database. Adding actions and components as icons in workspace enables your agents to perform actions while remaining in workspace rather than opening new browser windows. For example, you can create an action that pops up a modal with a caller's personal information so an agent can verify the caller's identity instead of making the agent open a new window with the caller's information to accomplish the same task. You can create all of these actions with little or no scripting.
Action types

There are three action types:

• UI component—Places a Now component in workspace, for example, an Agent assist component in the Contextual side panel.

• Client action—Dispatches an action that the browser carries out. Workspace supplies a limited number of client actions, including dialing a phone number, opening a record, opening a form to modify record content, and opening a URL.

• Server script—Executes a script on the server to change the database, for example, to assign a record to someone, to delete a record, or to add a record.

Action locations

Actions can only appear in a limited number of locations in workspace. For example, list view has only one action, called a list action, that can only appear above the list.

The actions in record view can only appear in the following locations:

• Field decorator—Displays an icon in one or more fields in an open record. An agent can click these icons, for example, to call a phone number or display additional information.

• Related list action—Displays a button in the Related Items menu. Examples include adding or removing a related list.

• Contextual side panel items—Appears as an icon in the Contextual side panel. By clicking the panel, an agent can make a Now component appear in the Contextual side panel. For example, an agent can display additional Agent Assists in the Contextual side panel.

• Related items—Appear as an entry in the Related Items menu. The entry works like a tab and sits, by default, between Details and related lists. Related lists act like tabs that display information from tables that are related to the open record. Related items make any Now component appear in the form pane.
This figure shows the only places where actions can appear in record view.

**Creating actions**
To learn how to create actions in all of the workspace locations, see the following links:

- List action
- Contextual side panel
- Related lists
- Related items
- Field decorator
Using supplied Actions & Components

The workspace interface incorporates the following Actions & Components.

### Actions & Components supplied with your instance

<table>
<thead>
<tr>
<th>Action</th>
<th>Action is available on</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Assist</td>
<td>Form</td>
<td>Adds the information in the form to Agent Assist.</td>
</tr>
<tr>
<td>Assign to Me</td>
<td>List, Related List</td>
<td>Assigns a record to the user.</td>
</tr>
<tr>
<td>Attachments</td>
<td>Form</td>
<td>Adds an attachment to a record in a form.</td>
</tr>
<tr>
<td>Call Number</td>
<td>Field</td>
<td>Calls the phone number in the field.</td>
</tr>
<tr>
<td>Create New</td>
<td>List</td>
<td>Creates a new record in the list.</td>
</tr>
<tr>
<td>Create New</td>
<td>Related list</td>
<td>Creates a new record in a related list.</td>
</tr>
<tr>
<td>Delete</td>
<td>List, Related List</td>
<td>Deletes a record from a list.</td>
</tr>
<tr>
<td>Edit</td>
<td>List</td>
<td>Opens a modal to edit a record.</td>
</tr>
<tr>
<td>Open Record</td>
<td>Field</td>
<td>Opens a record in a new sub-tab.</td>
</tr>
<tr>
<td>Reference Search</td>
<td>Field</td>
<td>Opens a modal to enable users to search a reference table.</td>
</tr>
<tr>
<td>Templates</td>
<td>Form</td>
<td>Opens a template on a form.</td>
</tr>
</tbody>
</table>

### Action & Component tables

**Note:** Declarative Action is the previous name for Actions & Components.

<table>
<thead>
<tr>
<th>Name</th>
<th>Permissions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Declarative Action Model Definition</td>
<td>Read-only for Admin</td>
<td>Defines the section in the workspace that a declarative action can exist and displays available data. Models</td>
</tr>
</tbody>
</table>
### Action & Component tables (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Permissions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Declarative Action Model Field</td>
<td>Read-only for Admin</td>
<td>Represents a field in a specific model. A model can have multiple fields.</td>
</tr>
<tr>
<td>[sys_declarative_action_model_field]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Declarative Action Definition</td>
<td>Read-only for Admin</td>
<td>Accumulates all the declarative actions.</td>
</tr>
<tr>
<td>[sys_declarative_action_definition]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Declarative Action Assignment</td>
<td>Admin only</td>
<td>Defines where and when a declarative action runs.</td>
</tr>
<tr>
<td>[sys_declarative_action_assignment]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Declarative Action Group</td>
<td>Admin only</td>
<td>Allows associating multiple declarative actions into a group. This action is only supported for the list model.</td>
</tr>
<tr>
<td>[sys_declarative_action_group]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Set up custom actions on record fields in Workspace

Set up using a value in a reference field to take action. For example, add an icon in a field with a phone number to dial that phone number. Or, add an icon in a reference field that opens a user record in a tab.

**Before you begin**

Role required: admin

A field decorator is an icon that’s added to a reference field in the Form pane that an agent can click to perform some action. Workspace supports up to three decorators per field.

The objective in setting up Workspace Action field decorators is to enable agents to do things on one page that otherwise would require opening additional pages. For example, instead of opening another page to display the record of the user named in an incident, the agent just clicks the Workspace Action field decorator in the **Caller** field to open the user record in a tab.
The field action, Open Record, must exist as a Workspace Action definition before you create a new action assignment. The icon, icon-user, must be an icon available in your instance.

**Procedure**

1. **Navigate to** Workspace Experience > Actions & Components > Field Decorators.  
   A list of existing field decorators appears.
2. **Click** New.
3. **On the form, fill in the fields.**  
   The following table adds a field decorator icon to URL fields. When agents click the icon, the URL opens.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action label</td>
<td>Name of the field decorator, for example, Open a URL. You can use double</td>
</tr>
<tr>
<td></td>
<td>braces, {{}}, to insert values in the text at runtime, for example, {{count}}.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Action name</td>
<td>Name that appears for this record in the list of action assignments: <strong>Workspace Experience &gt; Actions &amp; Components &gt; Field Decorators</strong>, for example, open_a_url.</td>
</tr>
<tr>
<td>Implemented as</td>
<td><strong>Client Action</strong> is the only valid selection for field decorators. The field decorator appears as an icon in a field, form, list, or related list. When clicked, the decorator performs an action, such as calling a phone number, opening a record, updating content, or opening a URL. <strong>UI component</strong> is a UI element that you can place in many areas in Workspace. <strong>Client Action</strong> dispatches an action specified in <strong>Specify client action</strong>. <strong>Server Script</strong> take actions on the server changing database records, such as adding, removing, or modifying them.</td>
</tr>
<tr>
<td>Specify client action</td>
<td>Click the magnifying glass icon (🔍) and select the action to take. To open a URL, select <strong>Open URL</strong>. This field only appears when Implemented as is <strong>Client Action</strong>. You cannot add custom actions to this list.</td>
</tr>
<tr>
<td>Specify UI component</td>
<td>Click the magnifying glass icon (🔍) and select the component to add. This field only appears when Implemented as is <strong>UI Component</strong>.</td>
</tr>
<tr>
<td>Decorator applies to</td>
<td><strong>Field type</strong> means the decorator appears for all fields of this type. <strong>Specific field</strong> means the decorator appears only when the field you specify opens. Many specific fields are of the same field type. For example, select <strong>Field type</strong> to apply this field decorator icon to all URL fields.</td>
</tr>
<tr>
<td>Field type</td>
<td>Select the field type where you want the field decorator to appear, for example, <strong>Reference</strong>. Many fields are of type <strong>Reference</strong>. As another example, to dial a phone number, select <strong>Phone Number</strong>. This field, <strong>Field type</strong> only appears when <strong>Decorator applies to</strong> is <strong>Field type</strong>.</td>
</tr>
<tr>
<td>Field name</td>
<td>Select the field where you want the field decorator to appear. The choices of fields depends on the value of <strong>Table</strong>. For example, select <strong>Date</strong>. This field only appears when <strong>Decorator applies to</strong> is <strong>Specific field</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Icon</td>
<td>Clickable icon that appears in the field specified by <strong>Field type</strong> or <strong>Field name</strong> that initiates the action.</td>
</tr>
<tr>
<td>Tooltip</td>
<td>Text that displays when and agent hovers a mouse over the icon.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of this component.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that this component applies to. Global means that the component applies to all applications.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace this component belongs in, for example, Agent Workspace, ITSM, CSM, and so forth.</td>
</tr>
<tr>
<td>Table</td>
<td>Table this component is tied to. When a record from this table opens, the field decorator appears in the field(s) specified by <strong>Field type</strong> or <strong>Field Name</strong>. The default is Global. You can leave the default value so that the field decorator icon appears for any open record that has the field specified by <strong>Field type</strong>. If you specify a table, then only when records from that table are open can the field decorator icon appear.</td>
</tr>
<tr>
<td>View</td>
<td>A set of visual configurations. This value is typically Workspace.</td>
</tr>
<tr>
<td>Active</td>
<td>Toggle to make this field decorator appear (selected) or not.</td>
</tr>
<tr>
<td>Order</td>
<td>An integer that governs the placement of this icon in the list of field decorators in a field. The lower the number, the further left in the list. The typical practice is to make these numbers hundreds, for example, 100, 200, 300, and 400, so you can put new icons between existing ones in the future.</td>
</tr>
</tbody>
</table>

4. Right-click the top banner and select **Save**. Related links appear.

5. **Optional:** On the **Action Exclusion** tab, click **New** to exclude children tables from inheriting this component in the Contextual Side panel, or this table inheriting components from a parent table. Components in the Contextual Side panel appear according to the records open in Agent Workspace. Child tables inherit these components by default. You can prevent that from happening.
a. On the form, fill in the fields.

**Action Exclusion form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action assignment</td>
<td>Click the magnifying glass icon (🔍) and select an action assignment, which specifies the action assignment.</td>
</tr>
<tr>
<td>Table</td>
<td>Table associated with this component. Every time Workspace opens a record from this table, this component’s icon appears in the Contextual Side panel.</td>
</tr>
<tr>
<td>Exclude this table</td>
<td>Toggle to prevent this Table from inheriting this component from its parent tables.</td>
</tr>
<tr>
<td>Exclude all child tables</td>
<td>Toggle to prevent child tables of Table from inheriting this field decorator.</td>
</tr>
</tbody>
</table>

b. Click **Submit**.

6. Under **Related Links**, click **Advanced view**.
   Up to this point, you have not specified the URL you want to open when an agent clicks the field decorator icon. This is the task you perform in Advanced view.

7. On the **Action Attributes** tab, in **Payload Map**, select the action attribute you want to define. In this example, select **url**.

8. In the value field, enter the URL to open.

9. **Optional:** On the **Conditions** tab, in **Script Condition**, enter a script that can hide the field decorator.

10. **Optional:** On the **Conditions** tab, in **Client Conditions**, specify conditions on the client that would hide the field decorator.
   (Optional) Client conditions are reevaluated whenever an agent makes a change in a list of records. For example, you might hide the button for a list action until an agent selects one or more records in a list. The client condition, then, is "count is greater than zero," where count is the number of records selected.

11. **Optional:** On the **Conditions** tab, in **Record Conditions**, specify a field and a value such that if an open record has a field with that value, the field decorator icon would not appear.
12. **Optional:** On the **Conditions** tab, in **Required Roles**, specify roles an agent must have to see the field decorator.

13. **Optional:** On the **Confirmations Settings** tab, select the **Confirmation Required** check box if you want to display a pop up that asks the agent to confirm the action to be taken by the field decorator.

14. Click **Update**.

**Results**
The field decorator icon appears in all record fields of type reference for all of the tables you specified in **Table**. Clicking an icon would open the URL specified in the **Payload Map**.

---

**Setting up Advanced Work Assignment (AWA)**

Advanced Work Assignment (AWA) automatically routes work items to agents when you set the criteria for the agent’s availability, capacity, and skills. With AWA, agents can access their work item assignments from their Agent Workspace inboxes.

AWA uses service channels to organize incoming work items, such as chats, cases, and incidents. AWA routes these work items to specific work item queues, such as the product chat, billing chat, VIP chat, critical cases, and IT support.
queues. You can set the capacity for an agent, which is the number of work items on a particular service channel that an agent may actively work on. You can set assignment rules to determine how AWA routes work items to a group of agents. If an agent rejects a work item, the item is rerouted to another agent.

Note:
The Advanced Work Assignment plugin is required for Workspace.

**AWA work flow**

**Service Channels**
- Chats
- Cases
- Incidents

**Work Item Queues**
- Product Chat
- Billing Chat
- VIP Chat
- Critical Chat
- Critical Cases
- IT Support

**Groups**

**Agent Options**
- Agent Presence
- Reject Reasons

**AWA Configuration Components**

**Service channels**
Agents receive work items through service channels, which are preconfigured work channels. You can customize the channel conditions, define the inbox layout for agents, create additional queues, and set the capacity for specific agents. Workspace includes two preconfigured service channels, Chat and Case.

**Work items**
Each work item is a single piece of work that is handled by an agent, such as an incoming chat or case. Work items come through a work item queue, which has definable schedules, target wait times, and routing conditions.

**Assign Groups**
You can use assignment groups to group agents and provide details regarding the name and description, manager, and group email. You can use the related lists to set up roles, groups and group
members, queues, and agent capacity overrides for the agent pool.

**Assignment Rules**

Assignment rules determine how work items, such as cases, chats, or incidents, are routed to an assignment group. You can set the criteria to assign work items to agents and create custom assignment rules to determine work item assignment and handling. You can define agent skills by using the Skills Management feature.

**Agent Presence States**

An agent presence state indicates if an agent is online and available to receive incoming work items or whether the agent is away or offline. You can create or modify these availability states for agents.

**Reject Reasons**

You can define the reasons that agents use to reject a work item, such as out to lunch or on a break.

**Setting up Agent Chat**

Configure Workspace Agent Chat to enable live agent chat with customers. Through Agent Chat, agents interact with customers, create incident or case records, or transfer chats to another agent or queue.

**Before you begin**

Configure the following before starting this task:

- Install the Agent Chat plugin (com.glide.interaction.awa).
- In Advanced Work Assignment:
  - Configure service channels.
  - Define work item queues.
  - Set up work assignments.
- Update agent Live Feed profiles to display agent names and avatars in the chat client.

Watch this video to get started with Workspace Agent Chat:

Role required: workspace_admin

**About this task**

Use Chat Setup to configure these features:
• Activate or disable live chat (enabled by default).
• Activate or disable transcript download.
• Activate the display of the estimated wait time for live chat support (transfer from the virtual agent to a live agent).
• Control the display of agent names and avatars in the chat window.
• Activate notifications to be sent via the Virtual Agent chatbot in the web and mobile chat client.
• Activate Agent Whisper to enable supervisors to message agents privately when agents are interacting with a requester. For new instances, Agent Whisper is enabled by default. If you’re upgrading from a previous release, you must activate Agent Whisper.
• Set the system messages that are displayed when a live agent transfer occurs.

Chat Setup also includes the Context related list for defining chat context variables that can be used in Virtual Agent topic scripts or in chat-related features. For example, you can use chat context variables to pass certain information from the topic to share with the live agent or control how bot conversations are routed to live agents. For details on using Live Agent and context variables, see .

Procedure
1. Navigate to Conversational Interfaces > Chat Setup.

      Note: The Conversational Interfaces module is unrelated to the Collaboration plugin.

2. On the form, fill in the fields, which differ depending on whether you’re a new customer or upgrading from a previous release.

Chat Setup form for new customers in the Rome release

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Live Agent setup configuration.</td>
</tr>
<tr>
<td>Live chat enabled</td>
<td>Option to activate live chat. If you don’t want to use live chat, clear this box.</td>
</tr>
<tr>
<td>Allow transcript download</td>
<td>Option to enable the requester to download a transcript of the conversation.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show agent names and avatars</td>
<td>Option to display agent names and avatars in the Agent Chat client when a live agent enters, transfers, or exits a chat. Agents set their names and pictures in their Live Feed profiles.</td>
</tr>
<tr>
<td></td>
<td>• If enabled, the <strong>Show agent name in chat header option</strong> appears for selectively controlling the display of the agent name in the chat header.</td>
</tr>
<tr>
<td></td>
<td>• If not enabled, agent identities remain anonymous. No names or avatars are displayed in the chat window.</td>
</tr>
<tr>
<td>Show agent name in chat header</td>
<td>Option to selectively suppress the display of the agent name in the header of the chat window. This option is enabled by default.</td>
</tr>
<tr>
<td></td>
<td>This field appears if <strong>Show agent names and avatars</strong> is enabled.</td>
</tr>
<tr>
<td>Enable notifications for all users</td>
<td>Option to activate the delivery of notifications using the Virtual Agent bot in the web chat client.</td>
</tr>
<tr>
<td>Agent Whisper</td>
<td>Option to activate Agent Whisper, which enables supervisors to message agents privately when agents are interacting with a requester.</td>
</tr>
<tr>
<td></td>
<td>📘 <strong>Note:</strong> If you deactivate Agent Whisper, you must manually disable the /help quick action.</td>
</tr>
<tr>
<td>Emoji enabled</td>
<td>Option to activate emojis. See <strong>Using emojis in Agent Chat</strong> for more information.</td>
</tr>
</tbody>
</table>
| Live chat wait status                      | Option to display the estimated wait time for live agent support in the chat menu for web clients. If you’re using the Microsoft Teams messaging integration, the wait time displays in a card that displays the approximate wait time to chat with an agent.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• The wait time is the estimated time, in minutes, for the transfer from the virtual agent to a live agent.</td>
</tr>
<tr>
<td></td>
<td>• The wait time updates once per minute. Wait time is based on the Queue Average Wait Time minus the Waiting Time.</td>
</tr>
</tbody>
</table>

**Fields related to Connect Support plugin**

If you're currently using Connect Support and upgraded to the Rome release, complete the UI, queue, and transfer message fields. These fields appear only if the Connect Support plugin is installed.

- **CSM Fulfiller UI**
  - Chat support interface: Connect Support or Workspace.
  - **Note:** If you're migrating to Agent Chat, select **Agent Workspace** as the fulfiller UI.

- **CSM Queue**
  - Live Agent chat queue is used for Customer Service Management (CSM) if not specified in the chat interface or changed by a Virtual Agent topic.
  - **Note:** If you're using Workspace, a CSM queue is not required.

- **HR Fulfiller UI**
  - Chat support interface: Connect Support or Workspace.
  - **Note:** If you're migrating to Agent Chat, select **Agent Workspace** as the fulfiller UI.

- **HR Queue**
  - Live Agent chat queue is used for HR if not specified in the chat interface or changed by a Virtual Agent topic.
  - **Note:** If you're migrating to Workspace, an HR queue is not required.

- **ITSM Fulfiller UI**
  - Chat support interface: Connect Support or Workspace.
  - **Note:** If you're migrating to Agent Chat, select **Agent Workspace** as the fulfiller UI.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITSM Queue</td>
<td>Live Agent chat support queue is used for IT Service Management (ITSM) if not specified through the chat interface or specified by a Virtual Agent topic.</td>
</tr>
<tr>
<td>Global Fulfiller UI</td>
<td>Chat support interface for the platform: Connect Support or Workspace.</td>
</tr>
<tr>
<td></td>
<td>Note: If you’re migrating to Agent Chat, select <strong>Agent Workspace</strong> as the Global Fulfiller UI.</td>
</tr>
<tr>
<td>Global Queue</td>
<td>Queue used if Virtual Agent doesn’t have information about the queue from the chat interface or a Virtual Agent topic.</td>
</tr>
<tr>
<td></td>
<td>Note: If you’re migrating to Workspace, a Global Queue is not required.</td>
</tr>
<tr>
<td>Transfer message</td>
<td>Message users see when they are transferred to a live agent or another queue. For example: &quot;Please stand by while I connect you to a live agent.&quot;</td>
</tr>
<tr>
<td></td>
<td>Note: You can define only one transfer message, which is displayed for all queues in your instance.</td>
</tr>
<tr>
<td>No Agents Available message</td>
<td>Message that users see when a live agent is not available. For example: &quot;No agents are available at the moment. Please try again later.&quot;</td>
</tr>
<tr>
<td></td>
<td>Note: You can define only one agent availability message, which is displayed for all queues in your instance.</td>
</tr>
<tr>
<td>Enable Autopilot Client Notifications</td>
<td>Option to receive notifications related to Conversation Autopilot. Conversation Autopilot allows agents to use autopilot quick actions to invoke Virtual Agent topics.</td>
</tr>
</tbody>
</table>

3. Select **Update**.
What to do next
You’re almost done with Agent Chat configuration. From here, you can define and publish chat context variables to capture information that can be used in other chat-related features.

Your final step is to enable the chat client on your end-user portal, which is commonly called the Service Portal. After completing this step, you’re done configuring Agent Chat.

Two options are available for setting the Service Portal chat client for Virtual Agent and Live Agent:

• **Service Portal Agent Chat Configuration**: Define a configuration that enables the chat client to persist across all portal pages for selected portals. End users can engage in chat on any portal page in specified portals.

• **Configure the legacy Service Portal widget for Virtual Agent**: Add the Legacy Virtual Agent Service Portal widget to a single, selected portal page, from which your end users run the chat client.

Related information

Conversational options

Setting up Agent Whisper
The Agent Chat plugin [com.glide.interaction.awa] must be installed and configured before using Agent Whisper.

Before you begin
Role required: admin

Procedure
1. New customers or existing customers who do not have the Agent Chat plugin [com.glide.interaction.awa] installed must install the Agent Chat plugin. For instructions on installing the plugin, see Activate a Plugin. Agent Whisper is enabled by default.

2. Existing customers who have the Agent Chat plugin already installed:
a. Navigate to **Conversational Interfaces > Chat Setup**.

b. On the form, select the Agent Whisper check box.

---

**Build a report to track the number of help requests**

Create a report that tracks the number of help requests.

**Before you begin**

Role required: admin

**Procedure**

1. **Activate the Interaction Events business rule.**
   a. Navigate to **Interaction > All**.
   b. Right-click the **Number** heading.
c. Click **Configure > Business Rules**. The Business Rules screen appears.

d. Under the **Name** column, click **Interaction Events**. The Business Rules - Interaction Events screen appears.
e. Select the Active check box if it is not already selected.

f. Click Update.

2. Create a new metric definition for Interaction "help requested." For detailed steps on creating metric definitions, see Create a metric. On the Metric Definition - New record screen, enter Interaction in the Table field and select Help Requested from the Field list.

3. Create a new chat as a requester.

4. Accept the same chat as an agent.

5. While still logged in as that agent, enter the quick action /help.

6. Navigate to Metrics > Instances and observe that there is one instance record created for help_requested=true.
Record the ID of the instance record created.

7. Navigate to the Admin window and open the interaction from the previous step.

8. Join the conversation (either privately or publicly).
9. Navigate to **Metrics > Instances** and observe that one instance record was created for 

```
<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2020-05-15</td>
<td>Help Requested</td>
<td>Interaction: IMS0000011</td>
</tr>
<tr>
<td>11:59:25</td>
<td>false</td>
<td></td>
</tr>
</tbody>
</table>
```

help_requested=true.

10. To learn more about using the Metric Instance Table, see [https://docs.servicenow.com/bundle/rome-platform-administration/page/use/reporting/concept/c_MetricInstance.html](https://docs.servicenow.com/bundle/rome-platform-administration/page/use/reporting/concept/c_MetricInstance.html).

**Idle live chats**
You can configure how the system handles live chats if an active chat becomes idle.

By default, the system automatically checks live chat sessions every two minutes through the Idle Chat Time Task scheduled job to ensure that chat sessions are still active. If the requester does not respond within 180 seconds (three minutes) during an active chat session, the session becomes idle. The user receives a reminder message that the conversation is timing out and asks if they are still there. If they don’t respond, the system automatically cancels (times out) the chat session 360 seconds (six minutes) after the requester’s last response.

You can change the idle chat reminder message and the default time after which the system displays the reminder message and closes an idle chat.

**Change the idle chat reminder message**
The default idle chat reminder message displayed to requesters is: *The conversation is timing out, are you still there?* Agents receive the message and user response will indicate if they want to continue the chat.

You can modify the default message sent to requesters by updating the `com.glide.cs.idle_chat_reminder_message` property.
1. In the navigation filter, enter `sys_properties.list`.

2. Open the `com.glide.cs.idle_chat_reminder_message` property.

3. In the **Value** field, enter the new reminder message to be displayed.

4. Select **Update**.

**Change the idle chat timeout values**

To change the default idle chat timeout values, see `add system properties`. Add the `com.glide.cs.idle_chat_reminder_timeout` and the `com.glide.cs.idle_chat_cancel_timeout` properties to the System Property [sys_properties] table to set the chat reminder message timeout and the idle chat cancel timeout values. Create both properties at the same time.

1. In the Filter navigator, enter `sys_properties.list`.

2. Select **New** to add the `com.glide.cs.idle_chat_reminder_timeout` property.

   a. Complete these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Enter the system property name: <code>com.glide.cs.idle_chat_reminder_timeout</code></td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Enter an explanation for this property: <em>Idle chat reminder timeout (in seconds)</em></td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Select <em>integer.</em></td>
</tr>
<tr>
<td><strong>Value</strong></td>
<td>Enter the number of seconds before the idle chat reminder message is displayed, after the requester's last response. This value must be equal to or greater than 120 seconds, since the Idle Chat Time Task job runs every 120 seconds to check active chat sessions. For example, if the idle chat reminder message is to be displayed 5 minutes after the requester's last response, enter 300 seconds.</td>
</tr>
</tbody>
</table>
If you want to set an idle chat message reminder timeout that is under 120 seconds, you must also change the time at which the Idle Chat Time Task job runs. The job must check for idle chats within a shorter timeframe. For example, if the reminder message timeout is 60 seconds after the requester's last response, set the Idle Chat Time Task job to run every 60 seconds. For more information on base system scheduled jobs, see System scheduler.

b. Select Submit.

3. In the System Properties table, select New to add the com.glide.cs.idle_chat_cancel_timeout property.

a. Complete these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the system property name: com.glide.cs.idle_chat_cancel_timeout</td>
</tr>
<tr>
<td>Description</td>
<td>Enter an explanation for this property: Idle chat cancel timeout (in seconds)</td>
</tr>
<tr>
<td>Type</td>
<td>Select integer.</td>
</tr>
</tbody>
</table>
| Value       | Enter the number of seconds before an idle chat is canceled (times out). This value must be larger than com.glide.cs.idle_chat_reminder_timeout, where the difference between this value and com.glide.cs.idle_chat_reminder_timeout is larger than or equal to 120 seconds (2 minutes, which is when the Idle Chat Time Task job runs).

For example, if the reminder message timeout value is 300 seconds (5 minutes), the idle chat cancel timeout value must be 420 seconds or greater.
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>If you changed the Idle Chat Time Task job, the difference between the chat cancel timeout value and the idle chat reminder timeout must be larger or equal to the Idle Chat Time Task job time. For example, if the reminder timeout is 60 seconds and the Idle Chat Time Task job is also 60 seconds, the idle chat cancel timeout value must be 120 seconds or greater.</td>
</tr>
</tbody>
</table>

### b. Select Submit.

#### Set the inactivity timeout behavior

The `com.glide.cs.start_idle_timeout_after_agent_response` property determines the timeout behavior when inactivity is triggered. When this property is `true`, then the inactivity timer does not start until the agent sends a non-automated response to the requester. To add this property to the System Property [sys_properties] table, see [add system properties](#).

1. In the Filter navigator, enter `sys_properties.list`.
2. Select **New** to add the `com.glide.cs.start_idle_timeout_after_agent_response` property.
   
   a. Complete these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Enter the system property name: <code>com.glide.cs.start_idle_timeout_after_agent_response</code></td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Enter an explanation for this property: <strong>Timeout behavior when inactivity should be triggered.</strong></td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Select <code>true/false</code>.</td>
</tr>
<tr>
<td><strong>Value</strong></td>
<td><code>true</code> or <code>false</code>.</td>
</tr>
</tbody>
</table>

   b. Select **Submit**.

#### Examples

These examples show how the `com.glide.cs.start_idle_timeout_after_agent_response` system setting may affect
how the system handles idle chats. In the following examples, the inactivity timeout is set to 60 seconds and the inactivity reminder is set to 30 seconds.

Example 1: In this example, com.glide.cs.start_idle_timeout_after_agent_response does not affect how the system handles an idle chat.

1. Agent enters the chat.
2. System sends automated message Thank you for contacting support. I am looking into your question now and will be with you shortly.
3. Agent sends the message What can I help you with today?
4. If the requester does not respond after 30 seconds, then the system sends the message The conversation is timing out, are you still there?
5. If the requester does not respond within 60 seconds after the agent’s message, then the system sends the message It seems you have left the conversation and ends the chat.

Example 2: In this example, com.glide.cs.start_idle_timeout_after_agent_response affects how the system handles an idle chat.

1. Agent enters the chat.
2. System sends automated message Thank you for contacting support. I am looking into your question now and will be with you shortly.
3. If the agent does NOT send a message, one of the following occurs:
   - If com.glide.cs.start_idle_timeout_after_agent_response is not set or is set to false, then
     a. The system starts the inactivity timer.
     b. If the requester does not respond after 30 seconds, then the system sends the message The conversation is timing out, are you still there?
     c. If the requester does not respond within 60 seconds after the automated message, then the system sends the message It seems you have left the conversation and ends the chat.
   - If com.glide.cs.start_idle_timeout_after_agent_response is set to true, the system does not start the inactivity timer and the chat will not time out.

**Associating user profiles on messaging interactions**

Use extension points to call custom scripts.

**Before you begin**

Role required: admin
About this task
When a requester sends a message, the system checks if there is an existing user profile that has a matching identifier (such as a phone number) and channel details. If there is a matching user, then the system will populate the interaction record with the identifier, channel details, and the user profile in the Opened for field. If there is no user profile that matches the identifier and channel, then the system creates a channel user profile.

Procedure
1. Navigate to System Extension Points > Scripted Extension Points.
2. Click the desired extension point to view the record details. You can create multiple implementations for each extension point and assign an order number for each implementation. The implementation that has the lowest ordered applicable implementation is executed first.

<table>
<thead>
<tr>
<th>Extension point</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>global.ChannelUserProfileExtPoint</td>
<td>Use channel_user_id to find record to channel_user_profile user_table/user_document</td>
</tr>
<tr>
<td>global.InteractionChannelUserProfileExtPoint</td>
<td>Defines how users are synchronized between the interaction and channel_user_profile tables</td>
</tr>
<tr>
<td>global.AgentInitiatedConversationUtil</td>
<td>Get From and To options to show in UI for agent initiated conversations</td>
</tr>
</tbody>
</table>

Anonymous user chat sessions
Anonymous users (unauthenticated guests) can chat with support agents in the web chat client, without logging in to a service portal. Admins can control certain aspects of the conversational experience for guest users, such as enabling resumable chat sessions after a browser refresh.

When guest users refresh the browser window while chatting with an agent, the refresh automatically starts a new conversation and chat session. By default, the ongoing conversation and chat session history are not retained.

You can change the default guest session behavior to let your guest users resume an ongoing conversation and see the chat session history after a browser refresh. You can also set the duration of the guest chat session user cookie, to let guest users resume chat sessions after they close and reopen their browser.
Enable resumable guest sessions

Use the `com.glide.cs.guest_session_resumable` system property to change the default chat guest session behavior for guest users.

1. In the navigation filter, enter `sys_properties.list`.
2. Open the `com.glide.cs.guest_session_resumable` property.
3. In the Value field, enter `true` to enable resumable guest chat sessions and retain the chat session history.
4. Click Update.

After a browser refresh, your guest users can continue their conversations with agents and see the chat session history in the chat panel.

Change the guest chat session cookie time

The guest chat session cookie time is the length of time (duration), in seconds, of the guest session user cookie. Use the `com.glide.cs.guest_session_cookie_max_age` property to change the guest session cookie time, in case your guest users want to resume a chat after closing and reopening their browser.

For security reasons, the default property value is `-1`, which means the guest session cookie is immediately deleted when the browser is closed. But you can specify a maximum time length that sets the duration of the guest session cookie, for example 900 seconds (15 minutes).

1. In the navigation filter, enter `sys_properties.list`.
2. Open the `com.glide.cs.guest_session_cookie_max_age` property.
3. In the Value field, enter the maximum length of time (seconds) for the guest session cookie.
   - For example, the value `900` is the duration of the guest session cookie in seconds (15 minutes), to give your guest users time to resume a chat session after closing and reopening the browser.
4. Click Update.

Create conversational chat surveys

Use Survey Designer to build conversational questionnaires for gathering pre-chat information and post-chat feedback from end users. These questionnaires run in the chat client for Virtual Agent and Agent Chat.
Before you begin

- Identify the information that you want from your requesters, such as their name or email address. If you’re collecting pre-chat information, determine whether certain survey responses should be stored as chat context variables so that you can use that information for topic discovery or routing chats to certain work item queues. Before you build your survey, define and publish chat context variables for storing responses to certain survey questions. You’ll map these chat context variables to the appropriate questions in your survey.

- Role required: survey_admin or admin

About this task

You define, configure, and publish conversational questionnaires (surveys) using Survey Designer. You can use various survey controls to define the content of your questionnaires. For details on the survey controls available, see Survey designer elements to see how the controls are rendered in the survey. For example, the Choice control provides a multiple choice selection to your users.

The survey controls map to corresponding Virtual Agent Designer input controls that render the survey as a conversation in the chat client. For examples on how Virtual Agent Designer input controls are rendered in run-time conversations, see Virtual Agent Designer user input controls. The following table identifies the survey controls supported in Virtual Agent Designer.

<table>
<thead>
<tr>
<th>Survey Designer controls</th>
<th>Comparable Virtual Agent Designer user input controls</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>Image</td>
</tr>
<tr>
<td>Boolean</td>
<td>Boolean</td>
</tr>
<tr>
<td>Choice</td>
<td>Static Choice</td>
</tr>
<tr>
<td>Date</td>
<td>Date Time</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date Time</td>
</tr>
<tr>
<td>Number</td>
<td>Text input</td>
</tr>
<tr>
<td>Percentage</td>
<td>Text input</td>
</tr>
<tr>
<td>Scale</td>
<td>Static Choice</td>
</tr>
<tr>
<td>Numeric scale</td>
<td>Static Choice</td>
</tr>
<tr>
<td>String</td>
<td>Text</td>
</tr>
<tr>
<td>Image scale</td>
<td>Carousel</td>
</tr>
</tbody>
</table>
Survey controls that map to Virtual Agent Designer input controls (continued)

<table>
<thead>
<tr>
<th>Survey Designer controls</th>
<th>Comparable Virtual Agent Designer user input controls</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference</td>
<td>Not supported</td>
</tr>
<tr>
<td>Multiple selection</td>
<td>Not supported</td>
</tr>
<tr>
<td>Ranking</td>
<td>Not supported</td>
</tr>
<tr>
<td>Template</td>
<td>Not supported</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to **Survey > Survey Designer**.

2. Click the **Configuration** tab and configure the survey. For details on survey configuration, see **Configure a survey in the survey designer**.
   As you configure your survey:
   - If you want an introduction note and end note to begin and end your survey, enter your content in the **Introduction** and **End note** fields.
   - Select the **Chat Survey** option to enable conversational questionnaires. This option also enables the display of the **Context** option in the Properties form for each survey control.
   - Click **Save**.

3. Click the **Design** tab and give your survey a **Name**. In this step, you’ll define your survey questions. For more information, see **Create a question in the survey**.
   As you design your survey questions:
   - To create a question, drag a data type icon from the Controls palette and drop it into the category container. Give each question a **Name** and click the gear icon to open the Properties form for the control.
   - In the Properties form, complete the fields as needed to define the control.
     - If you enable the **Mandatory** option, users are required to answer the survey question. If you leave this field blank, users can skip the question in the survey.
     - If you want to store the user response to this question, enter the chat context variable in the **Context** field.
   - Click **Save**.

4. After you finish defining the questions in your survey, click **Preview** to review your survey.
5. When you are satisfied with the Survey, click **Save and Publish**. Your survey is listed in the Assessment Metric Types [asmt_metric_type] table.

**What to do next**
Define the pre-chat and post-chat survey configurations that control the surveys to be presented to your requesters.

**Using emojis in Agent Chat**
Use emojis in Agent Chat conversations to convey emotions to requesters. This helps requesters feel like they are having a conversation with a friend and builds customer brand loyalty.

**Before you begin**
Emojis must be enabled before you can use them in Agent Chat and can be used by both requesters and agents. See [Setting up Agent Chat](#) for instructions on enabling emojis.

Role required: admin
Procedure

1. While in an active chat, there are several ways to include an emoji:

   • Select the Insert emoji icon 😊 to display the emoji palette. Then select an emoji from the palette or search for an emoji by entering a name in the search bar of the emoji palette.

   • Enter a colon followed by the first few characters of the emoji name. When the pop-up menu of emojis displays, select one.
• Enter a special character combination or short name which is automatically converted into an emoji after entering a space or enter.

2. If you position the cursor over an emoji, a tooltip displays the short name for the emoji.

Define pre-chat survey configurations
Determine the pre-chat questionnaire to be presented to your requesters based on conditions that you apply.
Before you begin

- Create your pre-chat surveys in Survey Designer.
- Role required: admin

About this task

You can apply different questionnaires to collect pre-chat information from your requesters. You can use the survey information to route chats to the appropriate live agent (if using Advanced Work Assignment), or to the virtual agent.

Procedure

1. Navigate to Conversational Interfaces > Pre-Chat Survey.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for this pre-chat survey configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that activates this pre-chat survey.</td>
</tr>
<tr>
<td>Order</td>
<td>Number that indicates the order in which survey configurations run.</td>
</tr>
<tr>
<td></td>
<td>If there are multiple pre-chat survey configurations, the system runs the</td>
</tr>
<tr>
<td></td>
<td>first survey found, from lowest to highest order.</td>
</tr>
<tr>
<td>Show Summary</td>
<td>Option that asks requesters of they want to see a summary of the survey</td>
</tr>
<tr>
<td></td>
<td>responses they entered.</td>
</tr>
<tr>
<td>Condition mode</td>
<td>Type of condition to be used to control the conversational survey presented</td>
</tr>
<tr>
<td></td>
<td>to requesters.</td>
</tr>
<tr>
<td></td>
<td>• Simple: Specify a condition using the condition builder.</td>
</tr>
<tr>
<td></td>
<td>• Advanced: Specify a JavaScript scripted condition.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition that controls when the survey configuration is used.</td>
</tr>
<tr>
<td></td>
<td>Use the condition builder to select the conditions to be applied.</td>
</tr>
<tr>
<td>Script</td>
<td>JavaScript condition statement that specifies the condition for using this</td>
</tr>
<tr>
<td></td>
<td>pre-chat survey. The condition must evaluate to true.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Survey</td>
<td>List of the pre-chat surveys available. Choose the survey to be presented to the requester.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Results**

When a requester completes the pre-chat survey, the user is transferred either to a live agent if Agent Chat is set as the fulfiller interface or a virtual agent if Virtual Agent is set as the fulfiller. The user’s pre-chat responses are stored as context in the chat interaction record.

**What to do next**

Define the post-chat survey configurations that determine the post-chat survey to be applied to the appropriate queue in Advanced Work Assignment.

**Define post-chat survey configurations**

Control the post-chat questionnaire displayed to your requesters to gather feedback on their experience with live agents. You configure the post-chat surveys to be used for chat queues defined in Advanced Work Assignment.

**Before you begin**

- Activate the Agent Chat plugin (com.glide.interaction.awa) if Advanced Work Assignment is not already installed. In AWA, configure the Chat service channel and work item queues.
- Determine the post-chat survey to be displayed to your requesters.
  - Review the existing chat surveys available in the Assessment Metric Types [asmt_metric_type] table by navigating to **Survey View > View Surveys**. You can use a predefined feedback survey, such as the survey for Virtual Agent feedback (a predefined Virtual Agent setup topic).
  - Or, you can create a new post-chat survey using Survey Designer. For details, see **Create conversational chat surveys**.
- Role required: awa_admin or admin

**Procedure**

1. Navigate to **Advanced Work Assignment > Settings > Queues**.
2. Select the queue (in the Chat service channel) to which the post-chat survey configuration applies.
3. Go to the **Post Chat Survey** related link and click **New**.
4. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for this post-chat survey configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that enables this post-chat survey configuration.</td>
</tr>
<tr>
<td>Show Summary</td>
<td>Survey option that asks requesters if they want to see a summary of the survey responses they entered.</td>
</tr>
<tr>
<td>Order</td>
<td>Number that indicates the order in which survey configurations run. If there are multiple chat survey configurations, the system runs the first survey found, from lowest to highest order.</td>
</tr>
</tbody>
</table>
| Requester ended| Option that specifies if the post chat survey should always run regardless of who ends the chat.  
  - True: survey should run when either the requester or the agent ends the chat.  
  - False: survey should run only when the agent ends the chat. |
| Condition mode | Type of condition that determines the conversational survey presented to requesters.  
  - Simple: Specify a condition using the condition builder.  
  - Advanced: Specify a JavaScript scripted condition. |
| Condition      | Condition that determines the conversational survey displayed to requesters.  
  Use the condition builder to select the conditions to be applied. The fields available for selection are based on the Chat service channel. |
| Script         | JavaScript condition statement that specifies the condition for using this chat survey. The condition must evaluate to true. |
| Survey         | List of the chat surveys available. Choose the post-chat survey to be presented to your requesters. |

5. Click Submit.
Results
When a live agent ends the chat session, the post-chat survey (configured for the chat queue) is presented to the requester. When the requester submits the post-chat survey, the chat session ends for the requester. The Interaction Related Records list stores the post-survey chat survey results and creates a related record that links the assessment to the live agent (fulfiller).

Create a quick action for Workspace chat

Create a quick action so that agents can use shortcuts for performing actions in Workspace chat.

Before you begin
Role required: admin

Procedure
1. Navigate to Quick Actions > Actions, and then select New.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the quick action.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for activating the quick action.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the quick action.</td>
</tr>
<tr>
<td>Command Name</td>
<td>Text that triggers the quick action when entered after the forward slash (/) in a conversation.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Work item that the quick action is available for. Filter the table that you select in the Table field to qualify a certain kind of work item. For example, to make the quick action available only for conversations that are assigned to Beth Anglin, you would first select the Interaction [interaction] table in the Table. Then, in the Applies to field, you would create the following filter: [Assigned to] [is] [Beth Anglin].</td>
</tr>
</tbody>
</table>
| Table          | Work item table that the quick action is available for.  

Note: Quick actions are supported only in the Interaction [interaction] table. |
| Apply to all groups | Option for making the quick action available to all user groups. |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply to groups</td>
<td>List of which groups can use the quick action. This field appears only if you clear the <strong>Apply to all groups</strong> option.</td>
</tr>
<tr>
<td>Script</td>
<td>JavaScript code to control what the quick action does.</td>
</tr>
<tr>
<td></td>
<td>In this script, you have access to:</td>
</tr>
<tr>
<td></td>
<td>• The <strong>record</strong> variable, which for Workspace chat is the Interaction [interaction] record</td>
</tr>
<tr>
<td></td>
<td>• The <strong>params</strong> array, if you defined quick action parameters</td>
</tr>
<tr>
<td></td>
<td>If provided, all free-form text entered after all the other parameters are captured as the last item in the <strong>params</strong> array.</td>
</tr>
</tbody>
</table>

**Set the value of answer as follows:**

```javascript
answer = {
    success: <Boolean>,
    message: <success_or_error_message>
};
```

> **Note:** If you do not script a message, the agent receives a default message instead.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Application scope of the quick action.</td>
</tr>
<tr>
<td>Accepts string parameter</td>
<td>Option to indicate that the script accepts text input after any defined parameters.</td>
</tr>
<tr>
<td>Parameter label</td>
<td>Parameter name that displays next to the quick action.</td>
</tr>
<tr>
<td>Parameter hint text</td>
<td>Text that displays as a hint when the agent enters a quick action.</td>
</tr>
</tbody>
</table>

### What to do next

If your quick action requires a secondary menu, define a quick action parameter so that agents can further control the quick action. For more information, see [Define a quick action parameter for Workspace chat](#).

Optionally, you can make the quick action available in Workspace chat as a button. For more information, see [Configure a quick action button for Workspace chat](#).
Define a quick action parameter for Workspace chat

Define a quick action parameter to allow agents to further control a quick action in Workspace chat.

Before you begin
Role required: admin

Procedure
1. Navigate to Quick Actions > Parameters, and then click New.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the parameter.</td>
</tr>
<tr>
<td>Action</td>
<td>Quick action that uses the parameter.</td>
</tr>
<tr>
<td>No Matching Results Message</td>
<td>Message to agents if no records match the record query. If you do not create a No Matching Results Message, a default message is provided.</td>
</tr>
<tr>
<td>Display value field</td>
<td>Field from the parameter record that appears in Workspace chat. This field appears when you select Basic in the Query mode field.</td>
</tr>
<tr>
<td>Query mode</td>
<td>Type of query. You can select Scripted or Basic. To query records with a script, select Scripted. To query records by whichever table that you specify in the Table name field, select Basic.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table to query for parameters. This field appears when you select Basic in the Query mode field.</td>
</tr>
<tr>
<td>No Results Message</td>
<td>Message to agents if there are no available records to query. If you do not create a No Results Message, a default message is provided.</td>
</tr>
<tr>
<td>Value field</td>
<td>Field from the parameter record that agents can enter in Workspace chat to invoke the parameter item. For example, to transfer a conversation to Beth Anglin, an agent would enter /ta &quot;beth.anglin&quot;. In this case, the User ID field in the User [sys_user] record is the Value field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Query Script | JavaScript code to determine which records qualify for your parameter. You are given a query variable that represents the search query that the agent provided. Set the value of the answer variable as follows:  

```javascript
answer = {
  items: [ { value: <value>, displayValue: <displayValue>} ]
};
```

The array of items should contain objects with a value and a displayValue.  

**Note:** This field shows only if you select Scripted in the Query mode field. |

<table>
<thead>
<tr>
<th>Application</th>
<th>Application scope of the parameter.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Order that the parameter is available for the quick action.</td>
</tr>
</tbody>
</table>

3. Click Submit.

**Configure a quick action button for Workspace chat**

Configure a quick action button so that agents can perform actions in Workspace chat with a single click.

**Before you begin**

Role required: admin

**About this task**

The toolbar of the Workspace chat window contains three buttons. By default, clicking the left button (_attach_file_icon_) attaches a file in a conversation, clicking the center button (_queue_icon_) initiates a queue transfer, and clicking the right button (_agent_icon_) initiates an agent transfer. You can’t configure the left button, but you can assign different quick actions to the center and right buttons. However, you can’t change the button icons.
Toolbar in the Workspace chat window

1. Navigate to Conversational Interfaces > Chat Setup.
2. Go to the Quick Actions for Workspace Actions related list and select a button to configure.
   • To configure the arrow button (→), open arrow-right-outline.
   • To configure the add user button (➕), open user-plus-outline.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Action</td>
<td>Quick action that is inserted when you click the button.</td>
</tr>
<tr>
<td>Icon</td>
<td>Button icon that appears on the toolbar of the Workspace chat window. You can't change the button icon.</td>
</tr>
</tbody>
</table>
Setting up quick action toolbar controls

Customize the quick actions that appear on the chat toolbar.

Before you begin
Role required: admin

Procedure

1. Navigate to Conversational Interfaces > Chat Setup. Navigate to the Quick Action Toolbar Controls related list at the bottom of the screen.
   - To create a quick action workspace action, select New.
   - To modify a quick action workspace action, select the quick action workspace action record you want to update.

2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Action</td>
<td>Quick action performed.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the quick actions workspace action.</td>
</tr>
<tr>
<td>Use custom icon</td>
<td>Option to display a custom, downloaded icon in the toolbar.</td>
</tr>
<tr>
<td>Icon</td>
<td>Image to display on the toolbar when Use custom icon is selected. Select Click to add... and on the Choose an image screen, select an image file.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the quick action.</td>
</tr>
</tbody>
</table>

4. Click Update.
<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Value of this quick action. Quick actions are executed from lowest order to highest order, so a quick action with an order of 100 is considered before a quick action of 200.</td>
</tr>
<tr>
<td>Available on private chat tab</td>
<td>Option that defines whether the quick action is available on the private chat tab.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Condition which determines when the quick action is available. * Add Filter Condition- Filter the table that you select in the <strong>Table</strong> field to qualify a certain type of work item. * Add “OR” Clause- Add an “or” clause to the condition. For example, to make the quick action available only for conversations assigned to Beth Anglin, you select the Interaction [interaction] table in the <strong>Table</strong>. Then, in the <strong>Applies to</strong> field, you create the following filter: <em>[Assigned to] [is] [Beth Anglin]</em>.</td>
</tr>
<tr>
<td>Apply to all groups</td>
<td>Option for making the quick action available to all user groups.</td>
</tr>
<tr>
<td>Apply to groups</td>
<td>Option for making the quick action available to only specified user groups.</td>
</tr>
<tr>
<td>Parameter value(s)</td>
<td>Parameters needed for the quick action.</td>
</tr>
<tr>
<td>Auto-submit</td>
<td>Option for the agent to select a button and have the quick action and parameter post to the chat.</td>
</tr>
</tbody>
</table>

3. Select **Submit** or **Update**.
Display chat context variables

Activate context quick actions to enable agents to view context relevant to a chat interaction. When launched in a chat display cards show: sysparm_portal, sysparm_page, table, sys_id, or sysparm_language.

Before you begin
Role required: admin

About this task
Context quick actions are a default quick action, but require activation.

Procedure
1. Navigate to Quick Actions > Actions.
2. Set the Active field to true under Get Chat Context Variables, or use the list editor to set the quick action to active.

Using Dynamic Translation for Agent Chat
Use Dynamic Translation for Agent Chat (DTAC) to translate chat conversations into both the requester's and agent's preferred languages.

Transferring from Virtual Agent to a live agent
Once an agent accepts a chat, they can see the chat history between the Virtual Agent and requester in their preferred language for more context.

Virtual Agent topics must be set up in the desired languages prior to using DTAC. To learn more about how to set up topics, see Virtual Agent Designer.
Translation indicators for agents and requesters

When DTAC is enabled, requesters see a banner at the top of the chat conversation that informs them that the conversation is being translated. The banner helps the requesters understand to be clear and conscious with their messages.

A banner also appears at the top of the agent’s active chats informing them that translation is being used as well as the requester’s source language. Bilingual agents can determine if they’re fluent enough in the requester’s language to temporarily turn off DTAC for individual chat sessions as needed.

Translation support in chat conversations

When DTAC is enabled, these items are translated in chat conversations:

• Users’ messages
• System messages
• Virtual Agent chat history
• Record card field values
• Rich controls

<table>
<thead>
<tr>
<th>Type</th>
<th>Rich Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>User input</td>
<td>String</td>
</tr>
<tr>
<td>User input</td>
<td>Static choice list</td>
</tr>
<tr>
<td>User input</td>
<td>Reference choice</td>
</tr>
<tr>
<td>User input</td>
<td>Boolean</td>
</tr>
<tr>
<td>User input</td>
<td>Date time</td>
</tr>
<tr>
<td>User input</td>
<td>File picker</td>
</tr>
<tr>
<td>User input</td>
<td>Carousel</td>
</tr>
<tr>
<td>Bot response</td>
<td>Text</td>
</tr>
<tr>
<td>Bot response</td>
<td>Single link</td>
</tr>
<tr>
<td>Bot response</td>
<td>Multiple links</td>
</tr>
<tr>
<td>Bot response</td>
<td>Multi-flow output</td>
</tr>
<tr>
<td>Bot response</td>
<td>Script output</td>
</tr>
<tr>
<td>Bot response</td>
<td>Record card</td>
</tr>
</tbody>
</table>

DTAC does not support record card labels. For this functionality to operate, system localization properties must be configured. Navigate to **System Properties > System Localization**. For more information, see ServiceNow® product documentation on Localization settings.
How agents can troubleshoot translated messages

If the translation doesn’t make sense because of idioms or jargon, then the agent can use this to see the requesters original message.

Translation services do not understand idioms or jargon and it is possible that some user messages are lost in translation. Agents can use the translation-indicator icon to view the requester’s original message and look up its meaning as needed.

Agents can navigate to the individual chat message and select the translation-indicator icon (🌐) to see the requester’s original, untranslated message.

Dynamic translations control for bilingual agents

When a bilingual agent accepts a chat conversation to which they’re fluent in the requester’s language, DTAC is not necessary. With the Dynamic translations chat session control, agents can turn off DTAC for individual chat sessions.

Agents can select the ellipsis (…) at the bottom of the chat window then select the Dynamic translations control to the off position.

When DTAC is switched off, a notification displays at the top of the agent’s and the requester’s chat windows, highlighting the change in status, for this chat session.

The translation capability is switched off for both the requester and the agent, for this specific chat session. The selection in one chat session does not affect the selection in other chat sessions and the agent can turn DTAC off and back on within one chat session.
Translated chat transcripts
Two chat transcripts are generated at the end of each DTAC chat session. One for the requester to download and save in the requester’s language. The other is the agent’s transcript which contains the text as seen in the agent’s chat window. If an agent used DTAC in part of the chat, the transcript contains both the translated and non-translated text. For more information, see Download chat transcript.

Analytical reports for DTAC
You can generate a report that counts the number of DTAC chats, to assess how many conversations use the DTAC option.

Monitor the number of true values in the Translated column in the Interaction table. For more information, see the ServiceNow® product documentation on Interaction records in Workspace Interaction records in Agent Workspace.

Mobile clients
DTAC is available for requesters on Agent Chat in mobile for iOS and Android.

Agent-Initiated Messaging Interface
Enable agents to initiate conversations with customers on a messaging app of customers’ choice by using the ServiceNow® Agent-Initiated Messaging Interface application.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Overview
The Agent-Initiated Messaging Interface application supports agent-initiated conversations for any type of messaging channels such as SMS.

Note: The messaging channels are available based on the application associated with the service channel you install. For more information, see Service channels.

By default, the application is configured for the Conversational SMS service channel in the CSM Configurable Workspace. For more information, see Conversational SMS service channel and Initiate messaging conversations from the CSM Configurable Workspace.
Configuring Agent-Initiated Messaging Interface
Set up the Agent-Initiated Messaging Interface application to enable agents to send messages to customers through different messaging channels.

Agent-Initiated Messaging Interface configuration tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Install Agent-Initiated Messaging Interface.</td>
<td>Install the Agent-Initiated Messaging Interface application to integrate a messaging channel with your ServiceNow instance.</td>
</tr>
<tr>
<td>2. Set up Agent-Initiated Messaging Interface for a messaging channel.</td>
<td>Set up the Agent-Initiated Messaging Interface application to send messages from a messaging channel.</td>
</tr>
<tr>
<td>3. (Optional) Associate user profiles with agent-initiated messages.</td>
<td>Use scripted extension points to call custom scripts for associating user profiles with agent-initiated messages.</td>
</tr>
<tr>
<td>4. (Optional) Validate recipient IDs for agent-initiated messages.</td>
<td>Use scripted extension points to call custom scripts for validating the format of a recipient ID associated with a messaging channel.</td>
</tr>
<tr>
<td>5. (Optional) Determine whether messaging channels are available for agent-initiated messages.</td>
<td>Use scripted extension points to call custom scripts for determining whether a messaging channel is applicable to a user profile in an agent-initiated message.</td>
</tr>
</tbody>
</table>

Install Agent-Initiated Messaging Interface
You can install the Agent-Initiated Messaging Interface application (sn_agent_initiated) if you have the admin role. The application installs related ServiceNow® Store applications and plugins if they are not already installed.

Before you begin
- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

Role required: admin

About this task
The following items are installed with Agent-Initiated Messaging Interface:
• Plugins
• Store applications
• Tables

For more information, see Components installed with Agent-Initiated Messaging Interface.

Procedure
1. Navigate to System Applications > All Available Applications > All.

2. Find the Agent-Initiated Messaging Interface application (sn_agent_initiated) using the filter criteria and search bar.
   
   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.

   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Agent-Initiated Messaging Interface.

4. Optional: If demo data is available and you want to install it, click Load demo data.

   (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   **Important:** If you don’t load the demo data during installation, it’s unavailable to load later.

5. Click Install.

Set up Agent-Initiated Messaging Interface for a messaging channel

Set up the Agent-Initiated Messaging Interface application to send messages from a messaging channel.
Before you begin

• Install Agent-Initiated Messaging Interface.

• Review the list of messaging channels available for the Agent-Initiated Messaging Interface application.

• Set the application scope to the application associated with the messaging channel using the application picker. For more information, see Application picker.

  For example, for using the SMS messaging channel, set the application scope to the Conversational SMS service channel application.

Role required: admin

About this task

A messaging channel is available when you install the application associated with a service channel.

For example, use the SMS messaging channel to send an SMS message to a customer. The SMS messaging channel is available when you have installed the Conversational SMS service channel application.

Procedure

1. In the navigation filter, enter **sn_agent_initiated_msg_config.list**.

2. In the Agent initiated messaging configurations list, modify an existing configuration or create another configuration for a messaging channel.

   • To modify an existing configuration, in the **Active** column, click the value link corresponding to the messaging channel displayed in the **Channel** column.

     For example, to send messages by using the SMS messaging channel, click the link in the **Active** column corresponding to the **SMS** channel.

   • To create another configuration for a messaging channel, click **New** in the Agent initiated messaging configurations list.

3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel</td>
<td>Messaging channel using which agents can initiate messages to connect with requesters.</td>
</tr>
<tr>
<td>Check if active recipient</td>
<td>Option to ensure that an active channel user profile exists when sending messages to the user from the channel.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>profile exists</td>
<td>If there are no active channel user profiles, the associated channel is not available for agent-initiated messages. In this case, the channel does not appear in the <strong>Channel</strong> field of the Compose Message form. For information on the Compose Message form available in CSM Configurable Workspace, see <em>Initiate messaging conversations from CSM Configurable Workspace</em>.</td>
</tr>
<tr>
<td>Show option to enter recipient ID manually</td>
<td>Option to display the field to manually enter recipient ID. For example, select this check box to enable agents to enter a phone number manually for sending an SMS message to a consumer.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of the application that contains the channel. This field is automatically set based on the application scope selected in the application picker.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the use of the channel for agent-initiated messages.</td>
</tr>
<tr>
<td>Order</td>
<td>Order number for each channel in which they appear for agent on the Compose Message form when composing messages. The channel that has the lowest order number is displayed first. For information on the Compose Message form available in CSM Configurable Workspace, see <em>Initiate messaging conversations from CSM Configurable Workspace</em>.</td>
</tr>
</tbody>
</table>

4. Save the configuration setting.
   - If you created a new configuration setting, click **Submit**.
   - If you modified an existing configuration setting, click **Update**.

**Associate user profiles with agent-initiated messages**

Use scripted extension points to call custom scripts for associating user profiles with agent-initiated messages.

**Before you begin**

Install the Agent-Initiated Messaging Interface application. For more information, see *Install Agent-Initiated Messaging Interface*.

Role required: admin
About this task
An agent can compose messages from an interaction of type other than Message in the CSM Configurable Workspace. By default, the AgentMessagingInteractionUserDocument script include is available for retrieving user profiles associated with consumers and customer contacts in an interaction record.

By using extension points, you can easily integrate customizations without having to alter the base code. You can extend standard base functionality using customized scripts. For more information, see Using extension points to extend application functionality.

Procedure
1. Navigate to System Extension Points > Scripted Extension Points.
2. In the API Name column, search for and select sn_agent_initiated.AgentInitiatedMessagingUserDocument.
3. On the Extension Point form, either modify a script include to use the sn_agent_initiated.AgentInitiatedMessagingUserDocument extension point or create and register a custom script include.
   - Create and register a custom script include.
     For more information, see Register a custom script include.
   - Modify the existing script include by going to the Implementations related list and selecting a script include in the Class column.

   **Note:** By default, the AgentMessagingInteractionUserDocument script include that use the sn_agent_initiated.AgentInitiatedMessagingUserDocument extension point is available for the Agent-Initiated Messaging Interface application. This script include is configured to retrieve user profiles associated with consumers and customer contacts from the Interaction [interaction] table record.

4. Associate user profiles for an agent-initiated messages by adding the sn_agent_initiated.AgentInitiatedMessagingUserDocument extension point to the script include.
   You can create multiple implementations for an extension point and provide an order number for each implementation. The implementation that has the lowest order number is executed first.
<table>
<thead>
<tr>
<th>Customization</th>
<th>Implementation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associate a table record from which the message was initiated</td>
<td>Include the <code>isValidForTableRecord</code> method in the <code>sn_agent_initiated.AgentInitiatedMessagingUserDocument</code> extension point.</td>
</tr>
<tr>
<td>Retrieve the user details associated with the table record from which the message was initiated</td>
<td>Include the <code>getUserDocument</code> method in the <code>sn_agent_initiated.AgentInitiatedMessagingUserDocument</code> extension point.</td>
</tr>
</tbody>
</table>

**Note:** Based on the table record set in the `isValidForTableRecord` method, the user details are retrieved for sending agent-initiated messages in the `getUserDocument` method.

5. On the Extension Point form, click **Update**.

**Validate recipient IDs for agent-initiated messages**

Use scripted extension points to call custom scripts for validating the format of a recipient ID associated with a messaging channel.

**Before you begin**

Install the Agent-Initiated Messaging Interface application. For more information, see Install Agent-Initiated Messaging Interface.

Role required: admin

**About this task**

By using extension points, you can easily integrate customizations without having to alter the base code. You can extend standard base functionality using customized scripts. For more information, see Using extension points to extend application functionality.

**Procedure**

1. Navigate to System Extension Points > Scripted Extension Points.
2. In the API Name column, search for and select `global.ChannelSendToValidation`.
3. On the Extension Point form, either modify a script include to use the `global.ChannelSendToValidation` extension point or create and register a custom script include.
Create and register a custom script include.
For more information, see Register a custom script include.

Modify the existing script include by going to the Implementations related list and selecting a script include in the Class column.

**Note:** The `PhoneNumberValidationExtPointImpl` script include that use the `global.ChannelSendToValidation` extension point is available for validating recipient IDs profiles associated with the Conversational SMS service channel application.

4. Associate user profiles for an agent-initiated messages by adding the `global.ChannelSendToValidation` extension point to the script include. You can create multiple implementations for an extension point and provide an order number for each implementation. The implementation that has the lowest order number is executed first.

<table>
<thead>
<tr>
<th>Customization</th>
<th>Implementation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associate a channel ID for which the message was initiated</td>
<td>Include the <code>isValid</code> method in the <code>global.ChannelSendToValidation</code> extension point.</td>
</tr>
<tr>
<td>Retrieve the recipient ID associated with the channel for which the message was initiated</td>
<td>Include the <code>channelSendToValidation</code> method in the <code>sn_agent_initiated.AgentInitiatedMessagingUserDocument</code> extension point.</td>
</tr>
</tbody>
</table>

**Note:** Based on the channel ID set in the `isValid` method, the recipient details are retrieved for validating a recipient ID in the `channelSendToValidation` method.

5. On the Extension Point form, click **Update**.

**Determine whether messaging channels are available for agent-initiated messages**

Use scripted extension points to call custom scripts for determining whether a messaging channel is applicable to a user profile in an agent-initiated message.

**Before you begin**

Install the Agent-Initiated Messaging Interface application. For more information, see Install Agent-Initiated Messaging Interface.
Role required: admin

About this task
By using extension points, you can easily integrate customizations without having to alter the base code. You can extend standard base functionality using customized scripts. For more information, see Using extension points to extend application functionality.

Procedure
1. Navigate to System Extension Points > Scripted Extension Points.
2. In the API Name column, search for and select sn_agent_initiated.ChannelsQualifyingForAgentMessaging.
3. On the Extension Point form, create and register a custom script include. For more information, see Register a custom script include.
4. Determine whether a messaging channel is applicable to a user profile in an agent-initiated message by adding the sn_agent_initiated.ChannelsQualifyingForAgentMessaging extension point to the script include.
   You can create multiple implementations for an extension point and provide an order number for each implementation. The implementation that has the lowest order number is executed first.

<table>
<thead>
<tr>
<th>Customization</th>
<th>Implementation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associate a messaging channel ID for agent-initiated messages with the custom script</td>
<td>Include the isValidForChannel method in the sn_agent_initiated.ChannelsQualifyingForAgentMessaging extension point.</td>
</tr>
<tr>
<td>Check whether a user qualifies for the messaging channel for agent-initiated messages</td>
<td>Include the isChannelValidForAgentInitiatedMessaging method in the sn_agent_initiated.ChannelsQualifyingForAgentMessaging extension point.</td>
</tr>
</tbody>
</table>

**Note:** Based on the messaging channel ID set in the isValidForChannel method, the users are evaluated for sending agent-initiated messages in the isChannelValidForAgentInitiatedMessaging method.

5. On the Extension Point form, click Update.
Components installed with Agent-Initiated Messaging Interface

Several types of components are installed with installation of the Agent-Initiated Messaging Interface application, including tables, plugins, and ServiceNow Store applications.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent initiated messaging configuration [sn_agent_initiated_msg_config]</td>
<td>Extends the application file. Base table for all service channel configurations for composing agent-initiated messages.</td>
</tr>
</tbody>
</table>

Plugins installed

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conversational Messaging (com.glide.messaging.awa)</td>
<td>Enables messaging actions that are performed when an event occurs.</td>
</tr>
</tbody>
</table>

ServiceNow Store applications installed

<table>
<thead>
<tr>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Messaging Component</td>
<td>Contains UI components for composing agent-initiated messages.</td>
</tr>
</tbody>
</table>

Related information

Install Agent-Initiated Messaging Interface

Messaging channels for Agent-Initiated Messaging Interface

Install and configure applications to enable a messaging channel for use with the Agent-Initiated Messaging Interface application.

The following table describes the messaging channels available for use with the Agent-Initiated Messaging Interface application and applications required for using those messaging channels.
Messaging channels for Agent-Initiated Messaging Interface

<table>
<thead>
<tr>
<th>Channel</th>
<th>Required applications</th>
</tr>
</thead>
</table>
| SMS     | • Conversational SMS service channel  
          • Twilio spoke  
          • Conversational SMS Integration with Twilio |

Note: The Conversational SMS Integration with Twilio application installs the Conversational SMS service channel and Twilio spoke applications, if not already installed.

Related information
Set up Agent-Initiated Messaging Interface for a messaging channel

Setting up phones in workspace
Enable agents to receive and make phone calls with requesters.

When you connect workspace to your telephony system, agents can make and receive calls with requesters. When receiving calls, workspace automatically creates an interaction record, which an agent uses to enter the details of the phone call request.

Workspace displays a phone icon (📞) that agents use to accept and make phone calls. The icon displays a number when phone calls are waiting to be answered. Agents set their status to Available or Away to allow or prevent phone calls from being routed to them.

The phone interface is integrated into workspace so agents can talk while working onscreen with all of other features provided by workspace.
Next

Set up Phone integration.

Workspace phone integration with OpenFrame and computer telephony integration (CTI)

OpenFrame and CTI enable third-party phone integrations for phone use for agents in Agent Workspace.

- OpenFrame enables CTI with third-party telephony service providers (TSPs) such as Twilio.
- CTI integrates with the Now Platform and the TSPs to support incoming and outgoing calls.

When you integrate OpenFrame and CTI with a TSP, agents in Workspace can use:
• An embedded softphone to place and receive customer calls.
• Click-to-call capability from phone number fields on forms and the Customer 360 ribbon component.
• Contextual identification for incoming calls.
• An additional window that contains contextual links in the softphone window and open related records.

OpenFrame and CTI can also integrate with the Interaction Management System (IMS), which enables you to manage the life cycle of the phone interaction. With this integration, incoming and outgoing calls create phone interaction records.

Related information

OpenFrame overview
Create an OpenFrame configuration

Use embedded softphones with Workspace

Configure Workspace to support embedded softphones so that agents can receive incoming calls and place outgoing calls.

Incoming calls

Agents receive incoming calls in the OpenFrame window. Contextual information, such as the account, contact, consumer, and case number, is displayed in the window.

Agents click links from the contextual information in the OpenFrame window to open the corresponding records in Workspace. Agents can open the forms in primary or child tabs depending on the workspace tab configuration.

• With Interaction Management System (IMS) integration, these records open as sub-tabs to the interaction record.
• Without IMS integration, these records open as primary tabs.

For more information, see the OpenFrame overview.

Outgoing calls

Agents can place outgoing calls from phone number fields on a form or from the ribbon on the Case form.

By clicking these phone fields, agents see the OpenFrame window, where they can place a call to the number which shows on-screen.
Integration with Interaction Management System (IMS)

With OpenFrame, computer telephony integration (CTI), and IMS integration, incoming and outgoing calls create interaction records.

Receive incoming calls through Workspace

When an agent answers an incoming call from the OpenFrame window, an interaction record opens in a parent tab in the New state with the Channel field set to Phone.

If available for your installation, the account information, the contact information, or the consumer information, is added to the interaction record. The case number is also added to the record if the caller provides it to the agent. If an agent clicks a link in the OpenFrame window, such as the account, contact, consumer, or case number, the corresponding record opens in a sub-tab under the interaction record.

The call forwards to an agent. The interaction record is assigned to the agent and the state is set to Pending Acceptance. The interaction record is displayed in the agent’s workspace and includes any details that are provided by the customer.

The agent can accept or reject the call:

• If accepted, the interaction record state is set to Work in Progress.
• If rejected, the interaction record state is set to Closed Complete.
• If the call is not picked up or the caller hangs up before the agent can pick up, the interaction state is set to Closed Complete.

When a call is ended, a phone log record is created for the interaction and the interaction record state is set to Closed Complete.

Make outgoing calls through Workspace

For outgoing calls, the sn_openframe.create_interaction property determines whether or not an interaction record is created.

When an agent places an outgoing call using a click-to-call enabled phone field, the system gathers contextual information about the call, including the account, contact, or consumer details.

If the sn_openframe.create_interaction property is set to true:

• An interaction record is created in the Work in Progress state. The record is populated with the contextual information and is assigned to the agent.
• The interaction record and relevant information is passed to OpenFrame.
• CTI receives the interaction, initiates the call, and manages the interaction life cycle.
• If the outgoing call is unanswered, the interaction record is set to Closed Complete.

If the `sn_openframe.create_interaction` property is set to false:
• The contextual information is passed to OpenFrame.
• CTI receives the contextual information and initiates the call.

Transferring calls to other agents
If an agent transfers a call to another agent, the interaction record is also transferred and a transfer record is created. The call is shown in the OpenFrame window in the new agent's workspace. The interaction record is assigned to the new agent in the Pending Acceptance state and is displayed in the agent's workspace. The state changes to Work in Progress when the agent accepts the call.

Integration with Interactive Voice Response (IVR)
With IVR integration, an interaction record is created as soon as the caller connects and receives an IVR message. The selections made by the caller are captured and added to the interaction record. If the caller enters a case number, the case is added as a related record on the interaction.

Limiting conversation data growth
As operations are performed, conversation-related tables increase in size and can end up affecting system performance. To improve performance while still retaining sufficient records, set up a process to archive past data and clean up the tables that are used for ongoing conversations.

Recommended activations
To limit the data growth associated with heavy use of Virtual Agent and Agent Chat, activate the cleaner jobs in the following table:

<table>
<thead>
<tr>
<th>Table Name</th>
<th>Cleaner Job Summary</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>AWA agent channel availability [awa_agent_channel_availability]</td>
<td>Removes AWA agent channel availability logs older than 90 days.</td>
<td>Activation recommended.</td>
</tr>
<tr>
<td>Table Name</td>
<td>Cleaner Job Summary</td>
<td>Recommendation</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>AWA agent presence [awa_agent_presence]</td>
<td>Removes AWA agent presence logs that are older than 90 days.</td>
<td>Activation recommended.</td>
</tr>
<tr>
<td>AWA agent presence history [awa_agent_presence_history]</td>
<td>Removes AWA agent presence history logs that are older than 180 days.</td>
<td>No action needed, already activated.</td>
</tr>
<tr>
<td>AWA document size [awa_document_size]</td>
<td>Removes AWA document size logs that are older than 90 days.</td>
<td>Activation recommended.</td>
</tr>
<tr>
<td>AWA instance stats [awa_instance_stats]</td>
<td>Removes AWA instance stats logs that are older than 60 days.</td>
<td>No action needed, already activated.</td>
</tr>
<tr>
<td>AWA queue stats [awa_queue_stats]</td>
<td>Removes AWA queue stats logs that are older than 60 days.</td>
<td>No action needed, already activated.</td>
</tr>
<tr>
<td>AWA service channel stats [awa_service_channel_stats]</td>
<td>Removes AWA service channel stats logs that are older than 60 days.</td>
<td>No action needed, already activated.</td>
</tr>
<tr>
<td>AWA work item [awa_work_item]</td>
<td>Removes AWA work item logs that were accepted or cancelled, and are older than 90 days.</td>
<td>Activation recommended.</td>
</tr>
<tr>
<td>Interaction [interaction]</td>
<td>Removes interaction logs that are older than 90 days.</td>
<td>No action needed, already activated.</td>
</tr>
<tr>
<td>Interaction JSON blob [interaction_json_blob]</td>
<td>Removes interaction JSON blob logs that are older than 60 days.</td>
<td>Activation recommended.</td>
</tr>
<tr>
<td>Live group profile [live_group_profile]</td>
<td>Removes live group profile logs that are older than 60 days.</td>
<td>No action needed, already activated.</td>
</tr>
</tbody>
</table>
| Consumer [sys_cs_consumer] | Removes consumer logs that have a User ID [user_id]=5136503cc611227c0183e96598e4f706 | Already set to active or add Name [name] condition. }
### Cleaner Job Summary

<table>
<thead>
<tr>
<th>Table Name</th>
<th>Cleaner Job Summary</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consumer device context</td>
<td>Adds Reference cascade rule to the Consumer account column.</td>
<td>No action needed.</td>
</tr>
<tr>
<td>[sys_cs_consumer_device_context]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conversation</td>
<td>Removes conversation logs that are older than 60 days.</td>
<td>No action needed, already activated.</td>
</tr>
<tr>
<td>[sys_cs_conversation]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Which tables should be cleaned**

These tables should be cleaned because they can grow into the millions of records in long-running instances:

- Agent Presence History [awa_agent_presence_history]
- AWA Document Size [awa_document_size]
- AWA Work Item [awa_work_item]
- Consumer [sys_cs_consumer]
- Consumer Device Context [sys_cs_consumer_device_context]
- Conversation [sys_cs_conversation]
- Interaction [interaction]
- Interaction JSON Blob [interaction_json_blob]
- Live Group Profile [live_group_profile]

There are other related tables, such as the Conversation Message [sys_cs_message] and Live Feed Message [live_message] tables, that can also become large. These tables have `reference_cascade_rule_delete` attributes that cause them to be cleaned as a side effect of cleaning the tables in the preceding list.

**Which records in the tables should be deleted**

The Auto Flush configuration lets you select the **Matchfield** and **Age in seconds** fields. The **Matchfield** field corresponds to a date column in the table and the **Age in seconds** field indicates when the deletions are triggered. When a record...
reaches a point where the **Matchfield** field has a date that is farther in the past than the **Age in seconds** field, the cleaner deletes the record when it runs.

Ideally, the **Matchfield** field should indicate how long the record has been active. The columns in the following table work well as the **Matchfield** field for the tables in question, with the additional condition in the **Conditions** field where indicated.

<table>
<thead>
<tr>
<th>Table</th>
<th>Column</th>
<th>Is column indexed?</th>
<th>Additional condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>AWA agent channel availability [awa_agent_channel_availability]</td>
<td>Updated (sys_updated_on)</td>
<td>No</td>
<td>agent.active=false</td>
</tr>
<tr>
<td>AWA agent presence [awa_agent_presence]</td>
<td>Updated (sys_updated_on)</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>AWA agent presence history [awa_agent_presence_history]</td>
<td>Updated (sys_updated_on)</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>AWA document size [awa_document_size]</td>
<td>Updated (sys_updated_on)</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>AWA work item [awa_work_item]</td>
<td>Updated (sys_updated_on)</td>
<td>Yes</td>
<td>state!=accepted,cancelled</td>
</tr>
<tr>
<td>Interaction [interaction]</td>
<td>Updated (sys_updated_on)</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Interaction JSON blob [interaction_json_blob]</td>
<td>Updated (sys_updated_on)</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Live group profile [live_group_profile]</td>
<td>Updated (sys_updated_on)</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Consumer [sys_cs_consumer]</td>
<td>Updated (sys_updated_on)</td>
<td>No</td>
<td>name=Guest User</td>
</tr>
<tr>
<td>Conversation [sys_cs_conversation]</td>
<td>Updated (sys_updated_on)</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

**interaction.closed_at and sys_cs_conversation.conversation.completed** are not good options for the **Matchfield** field because they do not have values for
faulted conversations and some closed interactions. The gaps can be closed with business rules that set this date if it is empty when an appropriate state change occurs, but for simplicity, use the sys_updated_on field for these tables. Other tables can be limited by conditions on the state field that ensure only closed chats are deleted. Since interactions should never be left open for more than a few days in general, these conditions can be left out to make the queries simpler and run faster after the last update. The state on the awa_work_item table may be more important because longer running tasks like cases are also represented.

The issue with the sys_cs_consumer table is that while normally you may want to keep these records to match new conversations to existing users, in the case of guest users, a different record is created for every conversation. For the sys_cs_consumer_device_context table, there is a reference to the CS Consumer Account [sys_cs_consumer_account] table (which itself has a reference to the sys_cs_consumer table), but the reference is not marked with reference_cascade_rule=delete. The recommendation is to add this rule to the consumer account reference. That way, when the cleaner deletes the records in the sys_cs_consumer and sys_cs_consumer_account tables, it also deletes these.

The awa_agent_presence and awa_agent_channel_availability tables do not grow per chat in the same way as other tables, but are regularly accessed by the assignment engine and can end up with stale entries from users who are no longer active. Long unused entries should be cleaned up here as well. Extra care must be taken with the awa_agent_channel_availability column because it may not be updated often. For this reason, an extra condition should be added to that cleaner so only records associated with inactive users can be removed.

When can the records be safely deleted

There are several considerations in determining when the records can be safely deleted:

• Do not delete records for ongoing conversations.
  For session-based chat conversations, the age threshold is just a couple days. If SMS/messaging conversations are included, the age threshold may extend to a few weeks or longer. One way to evaluate this is to look through all the properties of the form com.glide.cs._idle_timeout and locate the one with the highest value.
• Do not delete records that contribute to dashboards/reports on recent activity.
The AWA for Interactions-Advanced Analytics dashboard includes a Weekly Trends indicator that looks back three months. To fully support this, you must keep interaction and awa_work_item records for at least 90 days.

- Do not delete records if any of their data needs to be archived for later reference.

The timing of this depends on the timing of any custom logic that is added to do the needed archiving. You should be able to set this up so that it runs early enough to not be the deciding factor.

Considering the above, the following ages in seconds thresholds are recommended:

- interaction, awa_work_item: 7776000 (90 days - but this can be reduced if you do not use the Weekly Trends indicator or you are willing to set the lookback for it to a shorter amount of time).

- sys_cs_conversation, live_group_profile, interaction_json_blob, sys_cs_consumer: 2592000 (30 days) or 5184000 (60 days).

**Performance considerations**

Are sys_updated_on indexes needed for the tables missing them?

Tests were run on an instance that had 12,000,000+ interactions, with a table cleanup configured for one table having an index on sys_updated_on field (interaction) and one that does not (interaction_json_blob). In both cases, for initial and subsequent executions, the time spent doing deletions (potentially many minutes) far outweighed the time spent on querying the records (2 seconds or less). Given this result, no additional indices need to be added to the tables as the performance impact would be minimal.

When should the initial and repeated table cleaner job run?

Normally table cleaner sys_trigger runs once per hour. If one or more cleaners are set on tables with many outdated records, the number of deletes done during that first run can be very high and place an additional load on the system. Before adjusting and activating the table cleanup configuration, temporarily change this table cleaner schedule so that its next run occurs during off-hours (a time when the system is usually under a lighter load).

If there are no off hours, there are some properties governing the table cleaners that may help. In particular, glide.db.tablecleaner.chunk_delete_max_time_spent limits how long the cleaner spends trying to batch-delete records during a single run. The value is given in seconds and defaults to 1200 (20 minutes). This means that in the base system setup, the table cleaner runs hourly for a maximum of 20 minutes (for reference, during one test, about 400,000 interactions could be deleted in 20
minutes, including cascaded deletes). If 20 minutes every hour is too aggressive, the property value can be reduced.

**Agents using Workspace**

Use workspace to find and resolve internal or external requester issues.

The following video shows an example of how to resolve an incident using workspace.

Using Agent Workspace

Your general workflow using workspace is:

1. Find an issue to work on.
2. Work on the issue to find a solution.
3. Communicate the resolution to the requester.
Agent task flow

01 Click to start
02 Find a record to work on
03 Work on the record

Landing page

List view

Record view

Next
Get started using workspace by working through some tutorials.

Getting started using workspace
Use the tutorials to walk through many parts of workspace that you’ll use on a regular basis.
The following tutorials are included for you to get a sense of how workspace works:

- Work on issues that are already in the database.
- Work on issues that come in through phone calls or chats.

⚠️ Note: UI may vary between classic Workspace and UIB Workspace, but the functionality of the features is the same.

Once you complete both tutorials, you should have a feeling for what workspace does. The topics after the tutorials provide detailed instructions about how to use all of the functionality in workspace.

**Workspace tutorial for agents starting with a record**

Perform the steps in this tutorial to get an idea how you can use workspace when you begin with a task already stored in the database.

**Before you begin**

Role required: agent

**About this task**

This tutorial starts with finding a task to work on that is already in a record in the database. The other tutorial starts with answering a phone call or chatting with a requester.

You use workspace to:

1. Find a task to work on.
2. Do research to resolve the task.
3. Communicate the solution to the requester or enter notes for yourself and other agents that document your progress in finding a solution.

The following graphic provides a very quick overview of finding and solving an issue.
This tutorial starts with you working on a record that's in the database. Other ways you might start include receiving phone calls or chatting with requesters. The next tutorial shows how to begin work in those cases.
Procedure

1. Open your workspace by navigating to **Workspace Experience > Administration > All Workspaces**.

   ![Workspace Experience screenshot]

   **Note:** In the previous image, you can see **Agent Workspace Home** in the application modules. You can click that to open Workspace. The following steps are for you if you're using a different workspace.

2. Click the name of your workspace and then under Related Links, click **Open workspace**.
   Your workspace opens.

3. Log into your workspace.
The first thing to do is find out what to work on. You can do that by looking at what's on the landing page, as shown in this image. Or, you can go directly to the list of open issues to solve. Let's see how to do both.

4. On the landing page, let's say you want to look at the P1 incidents that haven't been solved. Click the box, **Open P1 Incidents**.

A list of P1 incidents open.

<table>
<thead>
<tr>
<th>Number</th>
<th>Opened</th>
<th>Short description</th>
<th>Caller</th>
<th>Priority</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC0005005</td>
<td>2018-08-31 21:35:21</td>
<td>Email server is down.</td>
<td>David Miller</td>
<td>1 - Critical</td>
<td>New</td>
</tr>
<tr>
<td>INC0007001</td>
<td>2018-10-16 22:47:10</td>
<td>Employee payroll application server is...</td>
<td>David Miller</td>
<td>1 - Critical</td>
<td>New</td>
</tr>
<tr>
<td>INC000055</td>
<td>2019-11-12 20:42:23</td>
<td>SAP Sales app is not accessible</td>
<td>Carol Coughlin</td>
<td>1 - Critical</td>
<td>In Progress</td>
</tr>
<tr>
<td>INC000054</td>
<td>2015-11-02 12:49:08</td>
<td>SAP Materials Management is slow or t...</td>
<td>Christen Mitchell</td>
<td>1 - Critical</td>
<td>On Hold</td>
</tr>
</tbody>
</table>

This display is called List view. It’s a list of records, in this case, incident records. Normally, you'd click one of the records to open it. Before you do, let's see how else you can start from a list to find a task to work on.

5. Click the list icon ( ) in the left, edge menu.
   In the Lists tab, you see the groups of records you can open as lists. For example, you could open **All problems** or **All change requests**.

6. In the Lists tab, under **Incidents**, click **Open**.
   A list of open incidents appears. Let's find out what the problem is and solve it.

7. Click an incident.
   The record opens in what is called Record view.
From top to bottom, here's what to notice:

• This record is on a tab labeled INC000905. You can open other incidents without closing this one. How? Click the list icon ( ) and click another incident. You can always jump from record to record by clicking the tabs.

• The form header shows the record's short description, "Email server is down." The form header is like the title of the incident record.
• Underneath that title in the form header is high-level information, including the importance of the task (Priority), whether it's been worked on (State), and the kind of incident this is (Category).

• On the bottom-left, the Details tab shows a lot of details in the record. This section is called the form pane. Notice that you can scroll this section. You can enter information in this section, for example when you get additional information from the requester.

We'll get to the other things you see in the next steps. But basically, the Activity pane is where you communicate with the requester or make notes to yourself or other agents about your progress in dealing with this incident. On the far right, the Contextual Side panel is where you do your research to find solutions for the task at hand.

8. Click through the tabs to the right of the Details tab to get information related to the open record, such as the service level agreement (Task SLAs) for this task, continuous integrations (Affected CIs) that might be affected, services impacted by the incident, related incidents, outages, and so on. These items that work like tabs are called the Related items menu.

9. Let's say you want to work on this incident. Click Assign to me.

10. Let's solve the issue. Scroll down the stack of cards in Agent assist, which is on the right side. If you don't see a card that suggests a solution, you could enter a search term beside the search icon (🔍). Notice that workspace automatically entered the value of the Short Description field from the record in the search field and used that to search.

11. It looks like the card, Reboot Windows Server, might be the solution you want. Click the card.

Agent assist gives you the opportunity to order a reboot.
12. Click **Helpful** to provide guidance to the predictive intelligence software that this was a good solution for this incident.

13. Click **Order** to issue a change request to reboot the Windows server. Notice a new tab appears as a child tab of the same incident tab. These child tabs enable you to accomplish multiple tasks on one screen. All of the child tabs relate to the same incident, which is shown on the tab at the top.

14. If you were really solving this issue, you’d click **Submit** and then click the option to save the change request. The system would then create the change request, which someone would then perform.

15. Document what you’ve done. In **Activity**, in the **Compose** field, click **Comments** and enter a note to the requester explaining what you did.
16. Click **Post Comments**.

Workspace sends your comment to the requester and also adds it to the **Activity Stream**, which is the history of communications and actions you've taken.
17. Click **Work notes (Private)**, enter a comment, and click **Post Comments** to save information that’s only seen by fellow agents. You might use this internal commenting feature if you’ve not completely resolved an issue but want to document what you’ve done for other agents or yourself when you come back to the issue later.

18. In the form pane, scroll to the section, **Resolution Information**, and do the following.

   a. In **Resolution code**, click on one of the choices from the menu, for example, **Solved (Permanently)**.

   b. In **Resolution notes**, enter a description of your resolution.

   c. In **Resolved by**, select your name.

   d. In **Resolved**, select the date and time of the resolution.
19. If you haven’t resolved the issue but want to save your progress, click Save.

20. If you’ve resolve the issue, click Resolved.
   The incident no longer appears in the list of open records.

What to do next
You’ve walked through finding and solving an incident that was in the database. Next, walk through solving an issue that comes in through a phone call or a chat.

Workspace tutorial for agents starting with a chat
Walk through this tutorial to get an idea how you can use workspace when you receive a task by phone or chat.

Before you begin
Role required: agent
About this task
This tutorial starts with an agent working on a request that started with a chat. The workflow would be almost identical if the issue started with a phone call.

Procedure
1. Open your workspace by navigating to Workspace Experience > Administration > All Workspaces and clicking the name of your workspace.
2. Click the name of your workspace and then under Related Links, click Open workspace.
3. Log into your workspace.
4. Click the inbox icon and set your status to Available.

The green circle at the top left of the icon shows your status is Available. A number appears at the top, right of the icon when there are one or more chats available to answer.

5. Click the inbox to open a chat.
You're given the opportunity to accept the chat.

Chat - CH0001081
How to set up a broadband
Wallace Thompson

Time to accept: 1:30

Reject  Accept
The **Time to accept** counter shows how much time you have to accept the chat. When the counter reaches zero, the chat opportunity disappears from your inbox.

6. Click **Accept**. 
   The chat pane appears and workspace automatically creates an interaction record, assigns it to you, and enters it in the database.

7. Chat with the requester to find out what the issue is.
8. Add information about the customer and issue to the interaction record.
9. Optional: You can verify the customer’s information by clicking the **Verify contact** or **Verify customer** UI action button.

- **Note:** Not all workspaces have these buttons.

A modal appears that displays personal information about the contact or customer. You can ask the requester for this information to confirm their identity.
10. **Optional:** You can transfer the chat to another agent who has more experience with the issue.

   a. From the Action toolbar in the Active chat panel, click the Transfer Agent icon (`).

   b. In the Transfer to Agent window, select the agent to receive the chat and enter a message to that agent.

   ⚠ **Note:** Only the current owner of a chat may transfer the chat to another agent. The transfer button is otherwise disabled.
The transferred chat is listed in the Queues panel for the receiving agent. The receiving agent can accept or decline the transfer request. When the agent accepts the request, you get a confirmation.

Chat - CH0001081
Transfer to: Lisa Gray
Transfer initiated

11. After chatting, you might decide to create an incident out of this interaction record. Click **Create incident** to create an incident and transfer the information from the interaction to the incident record.
The incident is automatically assigned to you.

12. Click **Save** to save the incident.
13. Look at the information in the ribbon to get information about the requester and the record.

14. Click several of the items in the related items menu to see what other records might be linked to the one that's open.

For example, clicking Outages shows related system failures, and Child incidents shows incidents related to this one.

15. Use Agent assist to research the incident.

If the suggestions in Agent assist don't provide answers for the incident, enter a search term.
16. Document what you’ve done. In **Activity**, in the **Compose** field, click **Comments** and enter a note to the requester explaining what you did.

17. Click **Post Comments**.
   Workspace sends your comment to the requester and also adds it to the **Activity Stream**, which is the history of communications and actions you’ve taken.
18. Click **Work notes (Private)**, enter a comment, and click **Post Comments** to save information that’s only seen by fellow agents. You might use this internal commenting feature if you’ve not completely resolved an issue but want to document what you’ve done for other agents or yourself when you come back to the issue later.

19. Click **Save** or **Resolve**, depending on whether or not you’ve completed your work on this incident.

**What to do next**
You’ve walked through answering and solving an incident reported in a chat. Before you tackle your first, real task, you can customize your workspace.

**Customize workspace**
Customize Workspace to display the components you want to see.

**Before you begin**
Role required: agent

**About this task**
You can hide some workspace components if you don’t intend to use them. You can always un-hide them in the future. The following image gives you the layout
of the Record view, which is where you do most of your work and can customize the most features.

Procedure

1. Click your profile image and expand the **Settings** menu.

   Pushing the sliders to the right displays the component. Pushing the sliders left hides the component. The following steps explain each slider.
a. Push the **Show Ribbon** slider to the right to display the ribbon.

The ribbon provides high-level information related to the open record, including the requester's contact information, timeline of agent-requester interactions, issue SLA, and, potentially, custom components created by your system administrator. Your system administrator configures which ribbon elements appear.

![Ribbon Image]

b. Push the **Show Sidebar** slider to the right to display the Contextual side panel.

The Contextual side panel automatically provides suggestions for resolving issues, enables you to search for additional solutions, attaches solutions to your comments in the Activity Stream, and saves you time by using templates to fill out record fields with standard values. Make sure this slider is turned on.
c. Push the **Wrap list text** slider to the right to wrap text onto the next line for record fields in List view.

Wrapped text makes the columns narrower in List view. The following image displays wrapped text:

<table>
<thead>
<tr>
<th>Number</th>
<th>Opened</th>
<th>Short description</th>
<th>Caller</th>
<th>Priority</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC0010112</td>
<td>2019-07-29 11:48:43</td>
<td>Assessment : ATF Assessor</td>
<td>survey user</td>
<td>5 - Planning</td>
<td>New</td>
</tr>
<tr>
<td>INC0010111</td>
<td>2019-07-22 14:04:57</td>
<td>ATF : Test1</td>
<td>System Administrator</td>
<td>5 - Planning</td>
<td>New</td>
</tr>
<tr>
<td>INC0009009</td>
<td>2018-08-30 01:06:16</td>
<td>Unable to access the shared folder.</td>
<td>David Miller</td>
<td>4 - Low</td>
<td>New</td>
</tr>
<tr>
<td>INC0009005</td>
<td>2018-08-31 21:35:01</td>
<td>Email server is down.</td>
<td>David Miller</td>
<td>1 - Critical</td>
<td>New</td>
</tr>
</tbody>
</table>
The following image displays unwrapped text:

<table>
<thead>
<tr>
<th>Number</th>
<th>Opened</th>
<th>Short description</th>
<th>Caller</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC0010111</td>
<td>2019-07-22 14:04:57</td>
<td>ATF : Test1</td>
<td>System Administrator</td>
</tr>
<tr>
<td>INC0009009</td>
<td>2018-08-30 01:06:16</td>
<td>Unable to access the shared folder.</td>
<td>David Miller</td>
</tr>
<tr>
<td>INC0009005</td>
<td>2018-08-31 21:35:21</td>
<td>Email server is down.</td>
<td>David Miller</td>
</tr>
<tr>
<td>INC0009001</td>
<td>2018-09-11 20:56:26</td>
<td>Unable to post content on a Wiki page.</td>
<td>David Miller</td>
</tr>
</tbody>
</table>

d. Push the **Show Banners** slider to the right to display notifications. Notifications display when updates occur to records you’re working on.

Regardless of whether you display notification banners, you can access your notifications by clicking the notification icon () in the top, right of workspace.

e. Push the **Show badge count** slider to the right to display the number of unread notifications you have beside the notification icon ().

2. Set up the **Compose** editor, which is what you use to communicate with requesters and to enter internal notes for fellow agents about work you’ve done on a record.
a. Configure the composition editor in Activity Stream by clicking the configuration icon (⋮).

![Composition Editor Configuration](image)

Note: Your system administrator controls whether these sliders appear. If one or both sliders don’t appear, talk to your system administrator.

b. Push the Rich Text Editor slider to the right to use the rich text editor.

The rich text editor includes formatting icons for bold, italics, underlining, font, and so forth, as shown in the previous image at the top of each text field.

c. Push the Stacked View slider to the right to display two text-entry boxes, one to enter comments for external requesters and one to enter internal notes for yourself and fellow agents, as shown in the previous image.

Internal notes are only visible to you and fellow agents. External comments are visible to agents and sent to requesters. The following image shows the unstacked view, which is a single, text entry box with tabs to enter external comments and internal, work notes.
The pros and cons of these views:

- The stacked view might make it clearer whether you’re entering comments for fellow agents or external requesters.
- The unstacked view consumes less space in Activity Stream.
- The stacked view enables you to copy and paste a message and send it to internal and external audiences.

3. Click one of the icons (≡ □) at the bottom of workspace to select whether you want to display only the Form pane, only the Activity Stream, or both (the default).

- Form pane only icon (≡)—Workspace displays the Form pane but not the Activity Stream to create a wider view of the Form pane. The Form pane displays details of the open record.
- Form pane and Activity Stream icon (≡□)—Workspace displays both the Form pane and Activity Stream in equally-sized panes. You can drag the boundaries of the panes to resize them. This setting is the default.
- Activity Stream only icon (□)—Workspace displays the Activity Stream but not the Form pane to create a wider view for the Activity Stream. The Activity Stream enables you to communicate with requesters and to make internal notes about the work done on the open record.

You can click these icons at any time to change the display.
4. Set up chat notifications.

   a. Click the inbox icon (ぁ). The Inbox pane appears.

   b. Click the gear icon (🔧). The configuration sliders appear.
Desktop Notifications are text boxes that temporarily appear on the screen. Regardless of the settings, when something is in the inbox, a circle appears to the top, left of the inbox icon ( ), and the number of items in the inbox to the top right. The color of the circle matches the agent's status. For example, when an agent is Available, the circle is green.

c. Set the sliders accordingly for audio alerts and desktop notifications.

What to do next
Now that you’ve done the tutorials and customized workspace, learn the different ways to find issues to work on.

Finding issues to work on
Use workspace to find the issues to work on.

The first step in your workflow is finding issues to solve. You can find issues to work on in the following ways:
• Landing page—Provides a high-level overview of tasks that need to get done.

Clicking a link takes you either to list view or a specific record. You get to the landing page by clicking the home icon ( ). For more information, see Use the landing page to find issues to work on.

• List view—Displays lists of records to work on. Records are grouped by the table they’re in, for example, Task, SLA, Incident.

Clicking a link takes you to the record so you can work on it. You get to list view by clicking the list icon ( ). For more information about list view, see Use lists to find work to do.

• Chat inbox—Interact in real time with requesters using chat.
Accepting a chat request automatically creates a record for you to record the work you do to solve the issue. You get to chats by clicking the agent inbox icon ( mingle ). For more information about chatting with requesters, see Getting work from chats.

- Phone inbox—Interact in real time with requesters by phone.
  Accepting a phone call automatically creates a record for you to record the work you do to solve the issue. You answer and make phone calls by clicking the phone icon ( 📞 ). For more information about using phones in workspace, see Get work by phone in workspace.

- Share a record—See a record another agent is working on so you can help.
  You can share the current state of your workspace by sharing its URL. For more information, see Sharing workspace views.

Next
Learn how to use the landing page to find work to do.

Use the landing page to find issues to work on
Use the landing page to get an overall view of work that needs to get done.

Before you begin
Role required: agent

About this task
The landing page is the first page you land on when opening a workspace. It can contain high-level information, such as unassigned, high-priority tasks, or tasks assigned to you. For example, the following landing page shows unassigned, high priority cases, such as open P1 incidents. The page also shows tasks assigned to you under My Work.
Landing pages are configurable by your system administrator so yours might look different.

**Procedure**

1. Navigate to **Workspace Experience > Workspaces** and click your workspace. Your landing page opens.

2. Click any of the links on the landing page to select an issue to work on.

   If you click a group of records, such as, open P1 incidents, list view opens and you see a list of P1 incidents that you can choose to work on. If you click the link to a specific record, such as INC0018313, that record opens in record view.

**What to do next**

Learn how to find work do to in list view. Once you click a record in a list, it opens in record view.

**Using lists to find work to do**

Use lists in workspace to see high-priority issues and which issues are assigned to you.

To get to list view, click the list icon ( ).
You see two tabs of lists: **Lists** and **My Lists**. The system administrator creates the list categories in **Lists**. You create the list categories in **My Lists**.

**List categories**

List categories in the previous image are **Tasks**, **SLAs**, and **Incidents**. List categories are not clickable and therefore serve mainly as headings for the list filters beneath them. For example, under the list category, **Tasks**, are the list filters, **My Work** and **My Group's Work**.

Your system administrator sets up the list categories, which typically correspond with the tables in the database. For example, all incidents are stored in the incident table. All interactions are stored in the interaction table.
categories your system administrator chooses to display in list view correspond to the kinds of issues you work on. If you work on incidents, your system administrator shows incidents in the **Lists** column. If you work on cases, the **Lists** column shows cases.

You can use the up arrowhead icon (▲) to display the list filters under each list category. Clicking the down arrowhead icon (▼) collapses the list categories to make it easier to scroll through the list categories.

You cannot have a list category without list filters.

**List filters**

*List filters* are the subsections under list categories. In the previous image, under **Tasks**, you see **My Work** and **My Group's Work**. Each list filter provides a helpful grouping of records typically from one table. For example, **My Cases** enables you to quickly find cases assigned to you. Your system administrator creates the list filters.

Clicking a list filter opens the corresponding list of records in list view. A list filter must belong to a list category in the **Lists** tab.

**My Lists**

Any lists that you create appear in this section. Lists in this section are only visible to you. For more information about creating your own list categories and list filters, see [Create My Lists in workspace](#).

**Next**

Learn how to [work with lists in list view](#).

**Work with lists in workspace**

Open a list of records in workspace so you can choose one to work on.

**Before you begin**

Role required: workspace_user

**About this task**

List view enables you to see high-level information for all records in a list filter. Normally, clicking a field in a record in a list opens that record. If the field is clickable (a reference, document ID, or URL), clicking it does not open the record; it opens the record or URL that the clickable field points to.
Last refreshed indicates how long ago the values in the list were last refreshed. To refresh the values, refresh the page.

Each list has an associated URL. You can bookmark a list to enable quick access to it.

Here’s how to open a list to find records you want to work on.

Procedure

1. Click the list icon (≡).
2. Find a list category that contains the records you want to work on, for example, Tasks.
3. Click one of the list filters under it.
   For example, under Tasks, you might click on a list filter called My Work. That would open up a list of task records assigned to you. The list filter title and the number of records in the list appear at the top of the list. In the previous image, the All list contains 8383 records.
4. Optional: To preview a record before opening it, move your mouse over a record and click the information icon (ⓘ).

   A side panel opens that shows the record.
5. Optional: To move to a different page of records, click a page number or one of the arrows to move forward or backwards a page, or to the first or last page of records.
6. **Optional:** To change the number of records displayed on a page, click the number beside rows per page and select a number from the menu.

7. Click a record number to open it.

8. **Optional:** To export the records in a list in one of the following formats: CSV, XLSX, JSON, or PDF, click the gear icon and select **Export**.

**What to do next**
Now that you know how to open a list and the records in it, find out how to **edit records in list view**.

**Edit records in list view**
Make updates to a record directly from a list, without leaving the list.

**Before you begin**
Role required: agent_workspace_user

**About this task**
You can revise one or more records while in list view. To learn more about a record before editing it, view and revise it in **record view**.

**Procedure**
1. Revise a single record from a list.

   a. Click the Open Preview icon.
      The record opens.
b. Revise the values in the fields and click **Update**.

2. **Optional:** Revise multiple records at once.

   a. In list view, click the boxes to the left of all the records you want to revise.

   ![Table](image)

   b. Click **Edit**.

   A preview pane opens and shows you the fields you can edit in the selected records.
c. Revise the values in the fields and click Update.

What to do next
Now that you know how to edit a record in list view, find out how to sort and filter the records displayed in a list.

Sort records in lists
Sort the records displayed in list view to more easily find the records you want to work on.

Before you begin
Role required: agent_workspace_user

About this task
Filtered lists can contain thousands of records. Sorting them by field values can help you find the records you want to work on. You can sort the entire list based on any of the columns in the list.

Procedure
1. To change the field the records are sorted by, double click a column heading. An arrowhead icon (↑) appears to the right of the column heading you clicked and workspace sorts the list of records based on the values in that
column. An arrowhead pointed down means the values are sorted from highest to lowest values.

| Number |

2. **Optional:** To reverse the sorting order, click the arrowhead icon so the arrowhead reverses direction.

**What to do next**
Instead of sorting records, you might want to filter records in lists to reduce the number of records displayed in list view.

**Filter records in lists**
Filter the records to reduce the number of records displayed in list view so you can find the records you want to work on.

**Before you begin**
Role required: agent_workspace_user

**About this task**
Filtering removes records from a list so you can view only those records you're interested in working on.

Workspace provides the following ways of filtering records displayed in a list:

- Use the filter icon (🔍).
- Filter directly in the list using the column heading.
- Filter directly in the list using the values in the columns.

**Procedure**

1. To filter out records using the filter icon (🔍):
   a. Click the filter icon (🔍).
   b. Click **Advanced View**.
   c. Use the condition builder to specify the conditions one or more field values must meet for a record to appear in the list.
      For example, [Active][is][true], and [Urgency][is][1 - High].
d. Optional: To add more conditions, click **New condition set** and supply a condition.

e. Optional: Select **Save Filter**, enter a filter name, and choose permissions to determine who can use the filter. Retrieve the filter by selecting **Use existing filter** and select the filter.

f. Click **Update**.

The list filter icon shows the number of conditions that apply to the current list.

2. Filter records based on field values displayed.
   You can work directly with list columns to filter out records.

   a. Click the **More UI Actions** icon to the right of a column heading.

   b. Click the downward pointing arrowhead icon (▼) and select a filter condition, such as **is not, starts with, or contains**.

   c. Enter the field value to filter the list on the bottom line and click **Apply**.
   In the following example, the only records that appear have **Caller** values that start with **David**.
Note: Not all field types support column filtering. You can use the Advanced Filter panel and condition builder to create a filter for those field types.

d. If the values come from the sys_choice table, the possible values (choices) appear with boxes beside them.
If there are more than ten fields, workspace displays a **Filter**, as shown here, so you don’t have to scroll to find a field value. If there are less than ten choices, there’s no entry filter under **Filter**.

You can click **All** to select all of the fields or **None** to uncheck all of the fields. **All** selects all of the field values that meet the filter conditions, not just those shown in the pop up. Likewise, **None** unchecks all of the fields that meet the filter conditions, not just those shown in the pop up. You can combine these functions. For example, you can filter on **Windows** and select **All**, and then filter on **2000** and select **None** and wind up with rows that contain Windows but not Windows 2000.
You cannot configure the number of fields (10) that makes the Filter entry field appear.

**e. Optional:** To remove the filter and restore all of the records, click the More UI Actions icon (⋮) and click Clear.

3. Filter out records based on field values.
   This feature is similar to the one in the previous step but you can't enter a term to filter the records.

   a. Click a field in the record.

   b. Click the More UI Actions icon (⋮).

   c. To remove all records that don't have the same field value, click Show Matching.

   d. To remove all records in the list that have the same field value, click Filter Out.
      By default, a column sorts in an ascending order unless the column data type is a date. Dates sort in a descending order.

**What to do next**
Instead of filtering records, you might like to group records in list view.

**Group records in lists**
Group the records displayed in list view to more easily find the records you want to work on.

**Before you begin**
Role required: agent_workspace_user
About this task
You can group records that have the same values in a column so you can see similar records.

Procedure
1. Move the mouse over a column heading and click the More Options icon (⋮).
2. Click the first option, **Group by <column-heading-name>** where <column-heading-name> is the name of the column you’re clicking in.

The records are grouped based on the values in the selected column.

The display shows the number of records in each group.
3. Open a group by clicking its arrowhead icon (↑).

4. **Optional:** To ungroup the records, mouse over the same column heading, click the More Options icon (⋮) and click `Ungroup by <column-heading-name>`.

**What to do next**

Instead of grouping records, you might like to Filter records in lists.

---

**Create My Lists in workspace**

Create your own filtered lists in workspace to monitor your issues, tasks, or problems, under **My Lists**.

**Before you begin**

Role required: agent_workspace_user

**About this task**

Create different groupings of records than those provided by your system administrator under the **Lists** tab. For example, you might like to group all records that pertain to incidents associated with a specific company. You can create another version of an existing list, or create an entirely new one. Those lists are only visible to you. To access your lists, select **My Lists**.

As you can see, **My Lists** doesn’t have list categories, only list filters.

**Procedure**

1. Navigate to **Workspace Experience > Workspaces** and select your workspace.
   Your workspace opens.

2. Select **My Lists**.

3. Select **+New list**.

4. On the form, fill in the fields.
### New List

<table>
<thead>
<tr>
<th>Type</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start from existing</td>
<td>List</td>
<td>Existing list that you want to modify. The menu displays all available admin defined lists for selection.</td>
</tr>
<tr>
<td></td>
<td>List Name</td>
<td>Name for your list. By default this field appends &quot;_Copy&quot; to the list selected in the previous menu.</td>
</tr>
<tr>
<td></td>
<td>Select columns</td>
<td>Record fields to include in list view. Columns from the list you selected appear. Add or remove columns to create the list you like as needed.</td>
</tr>
<tr>
<td></td>
<td>Add Filters</td>
<td>Condition builder to create filters that appear in your My Lists tab. By default the conditions applied to the list selected appear.</td>
</tr>
<tr>
<td>Create your own</td>
<td>List Name</td>
<td>Name for your list.</td>
</tr>
<tr>
<td></td>
<td>Select Source</td>
<td>Table the records come from.</td>
</tr>
<tr>
<td></td>
<td>Select columns</td>
<td>Record fields to include in list view. Select the columns that display in the list. By default this field populates with columns from a Workspace list view if one exists. If a Workspace list doesn't exist, the columns are</td>
</tr>
<tr>
<td>Type</td>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>populated with the Default list view of the table selected.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Add filters</td>
<td>Condition builder that is applied to the list.</td>
</tr>
</tbody>
</table>

5. Select **Create**.  
The list appears on the **My Lists** tab.

6. **Optional:** To change the order of your lists, select **Reorder**, then drag each list into the order that you want and select **Done**.

7. **Optional:** To modify or delete any of your lists, select the gear icon (⚙️) and select one of the following:

   - **Rename**
     Enables you to rename a list.
   
   - **Personalize Columns**
     Enables you to alter the columns that are displayed in the list.
   
   - **Save**
     Saves the current list and underlying filters.

   - **Save as**
     Saves and renames the current list and underlying filters under **My List**.

   - **Export**
     Export **My List** in a variety of formats.

   - **Delete**
     Removes a list from **My List**.

**Inline edit one or multiple cells in a list**

Inline edit one or multiple cells from the same column of a list to simultaneously change the value of the selected cells.

Inline editing enables you to change a field in a list instead of opening the record and changing it on the form.

- Edited cells must be in the same column when editing multiple cells.
- Most **common field types** are supported.
Inline edit using a mouse

Inline edit one or multiple cells from the same column using a mouse.

Before you begin
Role required: none

Procedure
1. Edit a single cell.
   a. Double click a cell.
   b. Enter the value you want and press Enter.
      To cancel the inline edit, press esc or Cancel on the keyboard, or click outside the cell.

2. Select consecutive cells.
   a. Place focus on a cell.
   b. Hold shift on the keyboard and select the final cell you want to change.
   c. Double click the cell.
   d. Enter the value you want.
      To cancel the inline edit, press esc or Cancel on the keyboard, or click outside the cell.
   e. Press Enter.

Short description

<table>
<thead>
<tr>
<th>testing</th>
</tr>
</thead>
<tbody>
<tr>
<td>my PDF docs are all locked from editing</td>
</tr>
<tr>
<td>Change to what you want</td>
</tr>
</tbody>
</table>

3 record(s) will be updated.
3. Select non-consecutive cells in a column

a. Place focus on a cell.

b. Hold down the **command** key (or **windows** key) and select the cells you want to edit.
   The cells must be in the same column.

c. Double click the cell.

d. Enter the value you want.

e. Press **enter**.

**Results**
The selected cells display the new field value.

**Short description**
Change to what you want
Change to what you want
Change to what you want

**Inline edit using a keyboard**
Inline edit one or multiple cells from the same column using a keyboard.

**Before you begin**
Role required: none

**Procedure**
1. Edit a single cell.

   a. With focus on a cell, press **shift** and **Enter** on the keyboard.

   b. Enter the value you want.
To cancel the inline edit, press **esc** or **Cancel** on the keyboard, or click outside the cell.

**c. Press enter.**

2. Select consecutive cells.

**a.** With focus on a cell, hold **shift** on the keyboard.

**b.** Use the arrow keys to select consecutive cells in a column.

**c.** Press **shift** and **Enter** on the keyboard.

**d.** Enter the value you want.
   To cancel the inline edit, press **esc** or **Cancel** on the keyboard, or click outside the cell.

**e.** Press **Enter.**

---

**Short description**

<table>
<thead>
<tr>
<th>testing</th>
</tr>
</thead>
<tbody>
<tr>
<td>my PDF docs are all locked from editing</td>
</tr>
<tr>
<td>Change to what you want</td>
</tr>
</tbody>
</table>

1 record(s) will be updated.

---

**Results**

The selected cells display the new field value.

**Short description**

| Change to what you want |
| Change to what you want |
| Change to what you want |
Get work by phone in Workspace

Use workspace to make inbound and outbound telephone calls if your instance is integrated with your telephony system.

Before you begin
Role required: workspace_user

About this task
You can do the following with the Workspace phone:

• Make an outgoing call
• Receive an incoming call
• Transfer a call to another user within the system
• Place a call on hold or on mute
• Set your availability status

Procedure
1. Do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the phone icon in the main navigation bar.</td>
<td>Enter the phone number in the <strong>Number</strong> field and click <strong>Call</strong>.</td>
</tr>
<tr>
<td><strong>Click the phone icon next to the Contact or Consumer fields on the form.</strong></td>
<td>For your contacts who may have multiple phone numbers:</td>
</tr>
<tr>
<td></td>
<td>• If only one phone field is populated, a call is placed to that number.</td>
</tr>
<tr>
<td></td>
<td>• If you see a dialog box that displays more than one number, click the</td>
</tr>
<tr>
<td></td>
<td>number that you want and then close the dialog box.</td>
</tr>
</tbody>
</table>

2. Click **End** to end the call.

Getting work from chats

Use the agent inbox to manage your incoming work items, such as chats, cases, and incidents.
To open the agent inbox, select the Inbox icon in the navigation bar. When you accept a chat, an interaction record is automatically created and captures the work done in that session.

### Inbox responsibilities

<table>
<thead>
<tr>
<th>Agent responsibilities</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor your inbox</td>
<td>Use designated service channels to route work items to available agents, such as incoming chat requests, case assignments, and incidents.</td>
</tr>
<tr>
<td>Start a chat session</td>
<td>Accept a chat from your inbox. You have a time limit to accept a chat before it reroutes to another agent. The chat associates to an interaction record that captures the conversation and work done during the session. During a chat session, you can:</td>
</tr>
<tr>
<td></td>
<td>• Add attachments using the Action toolbar.</td>
</tr>
<tr>
<td></td>
<td>• Transfer the chat to another agent.</td>
</tr>
<tr>
<td></td>
<td>• Add another agent to the chat.</td>
</tr>
<tr>
<td></td>
<td>• Perform other support tasks, such as create an incident or case.</td>
</tr>
<tr>
<td></td>
<td>• Use workspace tools, such as the ribbon to glance at information or the activity stream to review related work.</td>
</tr>
</tbody>
</table>

### Agent inbox features
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(A) Agent inbox</td>
<td>Display the queues that are assigned to you, the number of active chats in each queue, and the average wait time for chats in the queue.</td>
</tr>
<tr>
<td>(B) Active chat panel</td>
<td>Display your active chat session. Chat actions appear beneath the chat and allow your agents to attach a file, add an agent, transfer...</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>the chat, and more. You can use quick actions in the active chat panel.</td>
<td></td>
</tr>
<tr>
<td>(C) Toolbar</td>
<td>Display buttons for available actions:</td>
</tr>
<tr>
<td>• Quick actions 🔽 - select to display the quick action menu.</td>
<td></td>
</tr>
<tr>
<td>• Transfer to queue ➕ - select to transfer the conversation to the queue.</td>
<td></td>
</tr>
<tr>
<td>• Transfer to agent ➔ - select to transfer the conversation to an agent.</td>
<td></td>
</tr>
<tr>
<td>• Attach ☐ - select to add an attachment to the conversation.</td>
<td></td>
</tr>
<tr>
<td>• Dynamic Translation for Agent Chat enabled ⬤ - displays if DTAC is enabled.</td>
<td></td>
</tr>
<tr>
<td>• Overflow ⬞ - select to display any additional actions.</td>
<td></td>
</tr>
<tr>
<td>❗ Note:</td>
<td>Not all buttons may be available.</td>
</tr>
<tr>
<td>(D) Interaction record</td>
<td>Display the interaction record (IMS). The IMS initiates from a chat or phone call and lists the initial information about the customer and the communication. You can archive this interaction as a log of communication, or you can create an incident or a case that is based on the customer needs.</td>
</tr>
<tr>
<td>(E) Buttons</td>
<td>Perform an action by selecting a button:</td>
</tr>
<tr>
<td>• Create Incident</td>
<td></td>
</tr>
<tr>
<td>• End Conversation</td>
<td></td>
</tr>
<tr>
<td>• Save</td>
<td></td>
</tr>
<tr>
<td>• End Chat</td>
<td></td>
</tr>
<tr>
<td>• Assign to Me</td>
<td></td>
</tr>
<tr>
<td>❗ Note:</td>
<td>Not all buttons may be available.</td>
</tr>
<tr>
<td>(F) Attachments panel</td>
<td>Add attachments to the interaction. For example, you can add supporting information to a customer issue. If templates are available, they appear in the template section of this panel.</td>
</tr>
</tbody>
</table>

**Ongoing messages**

The Ongoing messages tab displays when you have access to at least one presence state which includes a messaging-based service channel.
Select the clock icon to display cards for ongoing messages. If the clock icon has a number in the upper right-hand corner, this number indicates the number of messaging conversations with unread messages. If a card has a green dot, there is a new message for that messaging conversation. The card also displays the interaction number and when the last update was made on the conversation.

Accept a chat session

Begin a conversation with a customer by selecting a chat queue in the chat session. You can work on multiple chats in different queues simultaneously.

Before you begin
Role required: workspace_user

Procedure
1. Navigate to Workspace Home > Inbox.
2. From your inbox, accept or reject a chat.

Chat - CH0001081

How to set up a broadband
Wallace Thompson

Time to accept: 1:30

Reject  Accept

You are automatically connected to the first customer in the chat queue, which is the oldest request in the queue. The Active Chat panel displays a pre-
chat message acknowledging the customer chat request. You can review the customer information before you enter a response in the Active Chat panel.

In the chat workspace, an interaction parent tab with a details child tab open for the session. The details child tab offers more information on the chat request and provides contextual options for performing related operations during the chat session.

### 3. Use chat tools for managing the chat and contextual options to perform related tasks.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Manage your chat</strong></td>
<td>Do the following actions from the Actions toolbar:</td>
</tr>
<tr>
<td></td>
<td>• Add an attachment.</td>
</tr>
<tr>
<td></td>
<td>• Transfer a chat to another queue.</td>
</tr>
<tr>
<td></td>
<td>• Transfer a chat to another agent.</td>
</tr>
<tr>
<td><strong>Perform additional support tasks</strong></td>
<td>Engage in other support work during the chat session by using the contextual options in the Details tab. For example, you can:</td>
</tr>
<tr>
<td></td>
<td>• Update chat information.</td>
</tr>
<tr>
<td></td>
<td>• Create a new case or incident.</td>
</tr>
<tr>
<td></td>
<td>From the sub-tab, you can select other contextual options to work on a resolution for the case or incident. For example, you might need to escalate the issue.</td>
</tr>
<tr>
<td></td>
<td>• Choose a related task in the More options (….), such as send email.</td>
</tr>
<tr>
<td></td>
<td>• Search for relevant information in the knowledge base using Agent Assist.</td>
</tr>
</tbody>
</table>

### 4. In the Details tab of the interaction, end the chat session by clicking Close.

Ending the chat saves the conversation history and closes out the interaction. You can also end a chat by closing the tab. If you end the chat this way, you lose all of the conversation history and you cannot save the information in the interaction record.
Transfer a chat to another queue

Route a chat to another queue. Any agent who belongs to the associated queue can accept the chat.

Before you begin
Role required: workspace_user

Procedure

1. From the Action toolbar, click the Transfer to Queue icon ( ),
2. In the Transfer to Queue panel, select the queue to transfer the chat to. When you transfer a chat, the current work item associated with the interaction is marked as closed complete. A new work item is associated with the new queue and the chat is added to the selected queue. When a receiving agent accepts the transfer, that agent sees the conversation and the chat history in the Active Chat panel.

Transfer a chat to another agent

Route a chat to another agent in the same service channel.

Before you begin
Role required: workspace_user

Procedure

1. From the Action toolbar in the Active chat panel, click the Transfer Agent icon ( ).
2. In the Transfer to Agent window, select the agent to receive the chat.

Note: Only the current owner of a chat may transfer the chat to another agent. The transfer button is otherwise disabled.
The transferred chat is listed in the Queues panel for the receiving agent. The receiving agent can accept or decline the transfer request.

Add an attachment to a chat
Chat agents can add attachments, such as documents and image files, to the conversation.

Before you begin
Role required: agent_workspace_user

Procedure
From the Action toolbar, click the Attachment icon (_attach_file_ to upload an attachment to the case.

Change your status in the chat panel
Change your status while you are on a break or offline so no new chats are assigned to you. When you return, you can update your status to let everyone know you are back.

Before you begin
Role required: agent_workspace_user

Procedure
1. Navigate to Agent Workspace Home > Chat.
2. In the chat panel, from the status list, select your current status.
• Available: You are available to receive new chats.
• Away: You are not available to receive new chats.
• Offline: You are not available to receive new chats.

What to do next
Adjust your status depending on your availability.

Set up a new chat or work item alert
Set up an audible alert to notify you when a new chat or work item arrives in your Agent Workspace inbox.

Before you begin
• Install the Agent Chat plugin (com.glide.interaction.awa).
• Enable Desktop Notifications for browser.

Role required: agent

About this task
Only agents who are subscribed to the corresponding service channel can change the settings.

Procedure
1. In your Agent Workspace inbox, select the settings (⚙️) icon.
2. To receive desktop notifications for new items in your inbox, turn on Inbox Desktop Notifications.
   These notifications are delivered if the Agent Workspace browser tab is open but not currently in focus.
3. To receive audible alerts for new items in your inbox, turn on Inbox Audio Alerts.
   These alerts are delivered if the Agent Workspace browser tab open, it doesn’t matter whether the tab is in focus or in the background.
4. To receive desktop notifications for new conversations in your inbox, turn on Conversation Desktop Notifications.
   These notifications are delivered if the Agent Workspace browser tab is open but not currently in focus.
5. To receive audible alerts for new chats in your inbox, turn on Conversation Audio Alerts.
   These notifications are delivered if the Agent Workspace browser tab is open, it doesn’t matter whether the tab is in focus or in the background.
6. To receive browser notifications, you must have this set-up:
   a. Chrome as your browser.
   b. Configured to receive Conversation Desktop Notifications.
   c. Workspace browser tab is not in focus.
   d. There is a new message on a conversation assigned to you.

Monitor chat conversations
Chat supervisors can view ongoing chat conversations and join them to assist agents and requesters in Workspace Agent Chat.

Before you begin
Role required: awa_manager

Procedure
1. Navigate to Lists > Interactions > Active Chat Interactions.
2. Select an active chat interaction from the list.
3. If Agent Whisper is installed, an agent can ask for help by typing /help in the Active Chat window. A message is sent only to the chat supervisor, the requester does not see this message.
4. In the Active Chat panel, click Join.
   A notification lets the agent and requester know that you’ve entered the chat. Messages that you submit are visible to the agent and requester.

   Note: Your presence is not known until you join a chat.
5. If Agent Whisper is installed, click Send Private Message to send a message to the agent. The requester does not see this message, only the agent sees the message.

Interaction records in Workspace
Using an interaction record, agents can create or reference customer information from a customer contact. Agents can then decide if the conversation is an incident, case, or request.

An interaction represents a request for assistance made through a chat, phone call, or walk-up. Interactions can be routed to queues for assignment or assigned to agents directly. Support agents can create cases, requests, or incidents from the interaction. Interactions can also be used to capture one-and-done type requests where an agent might not want to create associated tasks.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details, Related Tasks, User's Interactions forms</td>
<td>Details tab that shows detailed information from the interaction record. Related Tasks show tasks related to the interaction in the form pane, for example, a new incident. User's Interactions tab shows all interactions related to specific users.</td>
</tr>
<tr>
<td>Number</td>
<td>Number is associated to each customer interaction.</td>
</tr>
<tr>
<td>Type</td>
<td>Logs the type of channel communication, such as chat, phone, walk-up, or messaging.</td>
</tr>
</tbody>
</table>
### Feature | Description
--- | ---
| 🔄 **Note:** Phone is an available type of channel communication when the OpenFrame plugin (com.sn_openframe) is activated and **Messaging** is an available type when the Conversational Messaging plugin (com.glide.messaging.awa) is activated. |  

### State | State of the interaction record:
- Queued
- Pending Accept
- New
- Work in Progress
- Closed Complete
- Closed Abandoned

### State reason | Reason for the current state of the interaction record:
- Waiting on customer
- Waiting internal
- null

This field appears only for messaging type interactions.

### Opened for | Customer who initiates or receives the communication.

### Duration | Tracks the amount of time an agent spends working on an interaction.

### Assigned to | Agent the interaction record is assigned to.

### Wait time | Time it takes to initially respond to the customer.

### Short Description | Short description of the interaction.
### Feature

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> The short description field is empty by default, but it cannot be empty when the record is closed, saved, or associated to a related task. Populate the short description and then close, save, or associate the record, or you cannot archive the record.</td>
</tr>
</tbody>
</table>

While you are on an interaction, tasks that are viewed or created under the interaction are automatically logged on the Interaction Related tasks.

### Associating user profiles on messaging interactions

When a requester sends a message, the system checks whether the identifier matches an existing channel user profile. Channel user profiles are used to track the identities of conversation participants using an identifier associated with the source of the message. For SMS messages, the identifier is the phone number from which the message was sent.

If there is a matching channel user profile

- A new interaction is started.
- Or the message is associated with an ongoing interaction for the matching channel user profile.

If there is no matching channel user profile

- A new channel user profile is created.
- A new interaction referencing the new channel user profile is created.
- If the identifier matches a user, it populates the User document field of the channel user profile and the Opened for field of the interaction with a reference to that user.

### Create a problem from an interaction

You can create a problem record directly from an Interaction when the customer makes contact regarding an issue and you need to investigate.
Before you begin

- Role required: workspace_user or admin
- Activate the Problem Management Best Practice — com.snc.best_practice.problem plugin
- Select the **Allow Problem creation from Interaction** (glide.problem.interaction.allow_create) problem property

![](danger) **Note:** The Interaction feature is a more efficient way to create a problem from an interaction than the New Call feature from Service Desk Call (com.snc.service_desk_call) plugin that you might have used previously.

Procedure

1. Navigate to **Workspace Experience > Workspaces > Workspace Home**.
2. Click the list icon ( ) and click the Interaction list.
3. Click the interaction record from which you want to create a problem.
4. On the interaction page, click the more actions icon ( ) and select **Create Problem**.
5. On the form, fill in the fields.

**Problem form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Auto-generated. Number that identifies the problem record.</td>
</tr>
<tr>
<td>First reported by</td>
<td>Task that first identified this problem.</td>
</tr>
<tr>
<td>Category and Subcategory</td>
<td>Group to which the problem belongs to such as software or hardware. After selecting the category, select the subcategory, if applicable.</td>
</tr>
<tr>
<td>Service</td>
<td>Business service that the problem applies to.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item (CI) that the problem applies to. The CI class of the selected configuration item identifies the type of problem, for example, hardware, network, or database.</td>
</tr>
<tr>
<td>State</td>
<td>State management process. The field value changes as the problem proceeds from one</td>
</tr>
</tbody>
</table>
state to another state. The states available are: New, Assess, Root Cause Analysis, Fix in Progress, Resolved, and Closed.

Note: To access the new state management process, activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impact</td>
<td>Effect that the problem has on business operations, for example, Major revenue loss.</td>
</tr>
<tr>
<td>Urgency</td>
<td>Extent to which the problem resolution can bear delay.</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the problem. The Priority field is automatically set to the Impact and Urgency values.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group to which the problem is assigned.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Problem coordinator to whom the problem is assigned. If an assignment rule applies, the problem is automatically assigned to the appropriate user or group.</td>
</tr>
<tr>
<td>Problem statement</td>
<td>Brief description of the problem.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the problem.</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users who receive notification when work notes are added to the problem.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Informative notes about the work performed on the problem.</td>
</tr>
<tr>
<td>Analysis Information</td>
<td></td>
</tr>
<tr>
<td>Workaround</td>
<td>Method used to overcome the issue if no resolution is available yet.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cause notes</td>
<td>The cause of the problem.</td>
</tr>
<tr>
<td>Resolution information</td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>Auto-generated. Date and time when the user resolved the problem.</td>
</tr>
<tr>
<td>Resolved by</td>
<td>Auto-generated. The user who resolved the problem.</td>
</tr>
<tr>
<td>Fix notes</td>
<td>How the problem was fixed.</td>
</tr>
<tr>
<td>Auto-generated information</td>
<td></td>
</tr>
<tr>
<td>Opened</td>
<td>Auto-generated. Date and time when the user opened the problem.</td>
</tr>
<tr>
<td>Opened by</td>
<td>Auto-generated. User who opened the problem.</td>
</tr>
<tr>
<td>Confirmed</td>
<td>Auto-generated. Date and time when the issue was confirmed as a problem.</td>
</tr>
<tr>
<td>Confirmed by</td>
<td>Auto-generated. User who accessed the issue and confirmed that it was a problem.</td>
</tr>
</tbody>
</table>

6. Click **Save**.  
A problem record is created and the record appears in the Related tasks related list on the Interaction form.

**Create a standard change from an Interaction**

Create a standard change record directly from an Interaction Management to implement a pre-approved, low-risk change without having to go through the Change Management module to implement it.

**Before you begin**

Role required: workspace_user or admin

**Procedure**

1. Navigate to **Workspace > Workspace Home**.
2. Open the interaction record from which you want to create a standard change.
3. On the Interaction form, click the more actions icon [•••] and then click **Create Standard Change**.
4. On the New Catalog Item page, select the standard change and click Submit.
   A standard change is created and the record appears in the Related tasks related list on the Interaction Management form.

Getting notifications in workspace

You can receive workspace notifications to get immediate updates about records you're working on without leaving workspace.

Notifications present updates about records you’re working on or being assigned to regardless of whether or not the record is open in workspace. For example, a notification might show that you've been assigned in incident.

You can click the notification to open the record.

You can open all of your notifications by clicking on the notifications tray icon (져). The badge number indicates the number of unread notifications.

Workspace deletes notifications after seven days.

Performance Analytics and Reporting for Workspace

Integrate data visualization and reporting functionality into the workspace experience. Get notified about behavioral process changes. Explore KPIs, and
get answers and insights on analytics with these Performance Analytics and Reporting Workspace integrations.

These features enable users to see pre-configured dashboard views. The features also show cases via trend line, column, comparison, proportional, and score visualizations within workspaces. Users can view and drill down into reports that show key performance indicators over time. They also see the current state of instance data, such as how many open incidents of each priority there are.

For more information, see Performance Analytics and Reporting for Workspace.

Working on issues in workspace

Use the following sections to discover answers to the issues you're dealing with in an open record.
Depending on the issue at hand, you might be ordering a hardware component for a requester, issuing a server restart to solve an issue, or creating and assigning an incident record to remedy a software issue.

When you use the landing page or list view to open a record, workspace provides a lot of information about the record. Here’s how you might look at the different parts of workspace to understand and resolve an issue.
1. In the Form Header, read the record’s short description, priority, status, and issue category.

2. In the Ribbon, read about the requester, how long the issue has been open, and what the SLA is in solving the issue.

3. In the Form pane, on the Details tab, scroll through detailed information about the issue.

4. In the Related Items menu, click the tabs to see information related to the open record, such as related incidents. The information appears in the Form pane.

5. In the Contextual side panel, read the search results automatically pulled up by Agent assist that might help solve the issue.

6. In the Activity Stream, read about the history of actions you or other agents have taken in solving this issue.

7. In the Compose section of the Activity Stream pane, write a comment to the requester or make notes to yourself and other agents about your progress in resolving the issue.

Next

Now that you understand how to look through the parts of workspace to get contextual information about an issue, let’s see how to find a solution.

Finding solutions using Agent assist

Agent assist is a search engine that helps you find the information you need to resolve issues.

Agent assist appears in the Contextual side panel by default and when you click the graduation cap icon (🎓). It’s possible for you to have icons for more than one Agent assist. If so, each one would search a different set of information sources.

When you open a record, Agent assist automatically does a search based on a field in the open record. The field value used for the search term is configurable by your system administrator but it’s typically the value for the record’s short description field. The following figure shows the search results for the short description, “HDMI port is not working.” Search results return as cards. In the following example, the card returned links to an article with the title, HDMI port is not working on my PC, and that was updated 14 days ago. The following figure also shows there are two different Agent assists available using the differently-colored graduation caps.
The default number of search results is 10. If there are more than 10 results, the number appears as 10+.

Agent assist is pre-configured to search the Incident, Problem, Change, Knowledge, and Case tables for solutions. Your system administrator can configure Agent assist to search additional information sources, such as the service catalog.

You can use Agent assist in the following ways to find solutions to the record you opened:

• Click a card to go to the search result.
  The search result might provide the answer you need, which you can then send to the requester using the Compose editor in Activity Stream.

• Enter a new search term in the search field next to the search icon (🔍) to get different search results.
  If the search results automatically displayed don't show appropriate results, enter a new search term to get better search results.

• Filter the search results.
  By default, Agent assist returns search results from all of its information sources. You may get too many results. To see the search results from a subset of those information sources, click the configuration icon (🌐) and then click an information source.
• Send a solution to the requester by clicking a link in the card.

The following example shows a link, **Link to Problem**, that, when clicked, adds the link to a similar problem in the **Compose editor** that you can then send to the requester.

• If the card is an article, click the card and then the **Attach** link to send the article to the requester.

For more information, see **Send an article to a requester**.

• If the card links to an item in the service catalog, click the card to order the item.
For more information, see Order a catalog item for a requester.

- Click a different Agent assist icon and repeat the search.

If you have more than one Agent assist in the Contextual side panel, each one searches through a different set of information resources. Your system administrator configures the icon to click for additional Agent assists.

- If your system administrator enables Search as on your instance, you can change search results by changing field values in the form pane.

On the Details tab, you may be able to replace the value for Caller, for example, to change the search results based on that value. For example, if you create cases on behalf of customers or employees, entering a customer’s identity in the Caller field in the form pane returns Agent assist search results, for example 401k information, that match the customer instead of the you.

- Place a catalog order by clicking a catalog item shown on a card.

- Add a knowledge article to the Compose editor by clicking the Attach icon in Agent assist.

No search term

Your system administrator can configure Agent assist to conduct a search without using a search term. The search result is all records from a particular information source, such as employee records. You then can get the record of a particular employee by entering the employee’s name in the search field.

Interact with Playbook

Interact with a business workflow in real time from within Workspace. Agents can use Playbook to update records, upload attachments, and complete tasks across multiple workflow activities in line.

Playbook overview

The Playbook experience provides fulfillers with visibility into cross-business workflows and the actionable tasks used to complete these workflows.

1. Playbooks may appear in the Contextual side panel or in the related items of records configured with Playbook.

2. Activities that you must perform to complete the business workflow are displayed. You’re able to see what you’ve done and what you must do to complete the playbook. You can collapse activities to display relevant activities, and expand them again.
3. Activities are typically performed sequentially. You can go back to those activities to complete them later, if necessary. Complete an activity and go to the next activity, or complete the playbook.

4. Playbook automatically updates playbook tasks if completed outside of a playbook.

Playbook anatomy
Playbooks contain the following UI.

Playbook header
Shows the title of a Playbook. A header exists for each playbook attached to a record. Selecting a Playbook header expands the stages nested under it.
Playbook stages

Click a stage title to view its activities. By default, all activity cards are collapsed, except for the first card in a stage.

The stage progress updates as activities are completed. A check mark inside the playbook header indicates that the stage is complete.

- **Create**
  1 of 1 complete

- **Review and Update**
  1 of 3 complete

Use the stage filter (チョーク) to filter a playbook.
Use the ellipses action menu icon ( ⋮ ) to perform select actions at the playbook and stage level.

Activity cards

See details about an activity in the playbook activity card which may include the status, SLA timer, form data, and attachments. Use playbook activity cards to complete tasks by filling in forms,
completing checklists, adding attachments, and clicking buttons.

Add a playbook
Add a playbook to a record in agent workspace.

About this task
A playbook can be added to a record with no playbook or a record with existing playbooks. The example below shows how a playbook can be added to a record using an Add Playbook button.
Procedure

1. Open a record.
2. Select the **Add Playbook** drop down.
3. Select the playbook you would like to add to the record.

Results

The **Playbook** tab displays when the playbook was successfully added.
Cancel a playbook

Cancel a playbook to stop a business workflow when no longer valid.

Before you begin
Role required: agent

If your playbook admin has added a cancel action to your playbook experience, you can typically find the cancel action under the playbook actions menu. If you are an admin and would like to add a cancel action to a playbook experience, see Add a cancel playbook action.

Note: Certain activities within a playbook cannot be canceled once they have started.

Procedure
1. Open a playbook in workspace.
2. Click the ellipses action menu icon ( ⋮ ) in the playbook header.
3. Click Cancel Playbook.
4. Provide a reason for canceling the playbook.

5. Click Cancel Playbook.
A canceled banner appears below the playbook header confirming that the playbook has been canceled.

**Playbook Experience D... ▼ ▲**

⚠️ Canceled View Reason

- **Assign**
  - 0 of 2 complete

- **Create**
  - 0 of 2 complete

- **Review and Update**
  - 0 of 3 complete

**Open full lists within playbook**

Open a full list within playbook cards to view and update list items.

To open a full list within playbook, click the **Open List** icon (Open List).

**Card view**

- **Interactions**
  - Assigned to Christian Marnell

<table>
<thead>
<tr>
<th>Number</th>
<th>Opened</th>
<th>Short description</th>
<th>Opened for</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMS0000011</td>
<td>2020-10-06 10:52:47</td>
<td>PLAYBOOK-CHILD: Created from IMS00000003</td>
<td>Allyson Gillispie</td>
</tr>
<tr>
<td>IMS0000015</td>
<td>2020-10-06 11:20:05</td>
<td>PLAYBOOK-CHILD: Created from IMS00000014</td>
<td>Allyson Gillispie</td>
</tr>
<tr>
<td>IMS0000020</td>
<td>2020-10-06 14:07:18</td>
<td>PLAYBOOK-CHILD: Created from IMS00000019</td>
<td>Bridget Knightly</td>
</tr>
<tr>
<td>IMS0000022</td>
<td>2020-10-06 14:19:40</td>
<td>PLAYBOOK-CHILD: Created from IMS00000021</td>
<td>Billie Cowley</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
A new tab opens to show a full list.

Using activity stream within playbook

Use activity stream within playbook to add comments or notes, and view communication and task history for the parent or associated record.

Activities may contain a button, icon, or dropdown item to view a record’s activity stream.

Playbook activity stream examples

To open the activity stream within playbook, click the View activity button or select View History from the dropdown list.
Activity stream modal

You can see tabs for comments and work notes related to a parent or associated record. You can use the Compose text box to post new comments or work notes.

![Employee Payroll Setup Request](image)

You can view previous activity by scrolling down to the Activity section.

Create a record in workspace

Create a record in workspace from the Record tab menu or from a list.

Before you begin

Role required: workspace_user

About this task

You might create a record to capture work you're doing. For example, after a phone call, you might create an interaction or incident record. In the record, you capture the information you obtained in the phone call.
The kinds of records you can create is configured by your system administrator. The default is an interaction record. If you place your mouse over the plus sign icon (➕), the list of records you can create appears.

**Procedure**

1. Click the plus sign icon (➕).

Notice that the record type appears when you place your mouse over the icon.

If you can only create one type of record, a blank form of the record appears. If your system administrator configured workspace so you can create multiple record types, workspace displays a list of those record types. You then select the type you want to create and that blank record type appears.

**Note:** If you have access to more than one domain, filling in a caller or company on the record form associates the record with the domain of the caller or company.

2. On the form, fill in the fields and click **Save**.

**Global search in Workspace**

Search across all cases, incidents, problems, knowledge articles, community questions, customers, users, and change requests to find answers.

**Global search feature**

Search results include all the items the search term appears in, for example, in the short description, content, or attached files. By default, global search results can include:

- Cases
- Customers or Users
- Now Community Questions
- Incidents
- Change Requests
- Problems
- Knowledge Articles
To enter search terms, click the search icon (🔍) and enter the search term in the search field.

Search results appear in a separate tab. Links lead to a record or a list of records.

Searching for a customer or user
You can search for a requester by name, for example, Beth:

Global search results show the number of search results by category:
Clicking **Users** shows the search results for users that have the name *Beth*:

**Users (1 of 1)**

*Beth Anglin*

beth.anglin@example.com

ACME North America

**Searching for a case or incident**

You can use case or incident numbers to search for specific cases or incidents. Or, you can search using other values related to the cases or incidents. In the previous example, if you click **Incidents**, Workspace displays all the incidents that have the name *Beth* in one or more record fields.

<table>
<thead>
<tr>
<th>Incidents (9 of 9)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unable to connect to email</strong></td>
</tr>
<tr>
<td>Number</td>
</tr>
<tr>
<td>INC00000...</td>
</tr>
</tbody>
</table>

| **The USB port on my PC stopped working** |
| Number | Opened | Caller | Priority | State | Category | Assignm... | Assigned to | Updated | Updated by admin |
| INC00000... | 2020-06-... | Joe Empl... | 3 - Moder... | Resolved | Hardware | None | None | 2020-07-... | admin |

| **Issue with email** |
| Number | Opened | Caller | Priority | State | Category | Assignm... | Assigned to | Updated | Updated by admin |
| INC00000... | 2020-06-... | Joe Empl... | 3 - Moder... | In Progress | Inquiry / ... | Software | Beth Anglin | 2020-07-... | admin |

| **The SAP HR application is not accessible** |
| Number | Opened | Caller | Priority | State | Category | Assignm... | Assigned to | Updated | Updated by admin |
| INC00000... | 2020-06-... | Margaret... | 1 - Critical | In Progress | Inquiry / ... | Software | Beth Anglin | 2020-07-... | admin |

| **Can't access Exchange server - is it down?** |
| Number | Opened | Caller | Priority | State | Category | Assignm... | Assigned to | Updated | Updated by admin |
| INC00000... | 2020-06-... | Jerrod B... | 1 - Critical | In Progress | Hardware | Software | Beth Anglin | 2020-07-... | admin |
Getting or adding information to a record

Use the form pane to discover detailed information about a record, information related to the open record, and to make entries in the record.

Getting detailed record information

To get detailed record information about a record, click the Details tab. The contents, which appear in the form pane, are many of the fields in a record. Your administrator configures which fields you see.

You can vary the width of the form pane by dragging the right side of it. You can scroll through all the fields or jump to a section in the Detail tab. To jump to a section, click the menu icon (≡) to the left of the record type to display the sections in the form pane. Click the section title you want to jump to. For example, in the following image, if you click Notes, the record fields scroll up to the Notes section.
Getting information related to the open record

The Related items menu provides tabs that display information related to the open record.

Click these tabs to understand what this record might be affecting. For example, clicking **Impacted Services** displays the services affected by the incident in the open record. For more information, see Get information related to the open record.

Adding information to a record

When working on a record, you might add or revise some of the fields in the record. You can do that on the **Details** tab. For example, on the **Details** tab, you might change the **Urgency** value of the record to **1 - late**, or, after solving an issue, enter a resolution summary in the **Resolution notes** section. After entering or changing information in the form pane, click **Save**.
Additional record functionality

- Template value field: For more information, see Configure a template value field.
- Field name field type
- Doc ID field type

Updating records using templated information

Select one of the templates to add standard information to open records to save yourself some work.

Before you begin
Role required: workspace_user

About this task
Templates set field values in the open record to the values specified in the template. For example, the major incident template might set the Impact field in the open record to 1 - High, and the Urgency field to 1 - High. Templates reduce the work you have to do and make actions taken more consistent.
Procedure

1. In Workspace, open an existing record.

2. In the Contextual side panel, click the template icon ( ).

   The available templates appear.

3. From the list of templates, select a template to apply to the open record.

   Field values included in the template automatically populate the record in the Details tab of the form pane. Workspace provides a pop up of the updated fields.

4. Optional: To undo the changes that were made in the open record when you selected the template, navigate away from the form without saving.

5. Fill in the remaining fields in the Details tab of the Form pane.

6. Click Save to save your progress or Resolve to mark the issue as resolved.

What to do next

Communicate your progress or the solution with the requester.

Manage custom form templates

Manage custom form templates by creating, editing, and deleting templates.
**Before you begin**
Create a custom form template that fits the workflow of a customer or activity. Custom form templates enable you to retrieve a form with the fields you want to save time resolving the workflow. They can also be edited to adapt to new demands or similar cases.
Role required: agent

**About this task**
Custom form templates are controlled by group assignments.

**Procedure**
1. In Workspace, select a record.

2. Select the Template icon ( ) in the contextual side panel. Two lists display in the contextual side panel. All displays all available templates, and My Templates displays your custom form templates.

3. Create a custom form template.
   a. On the Templates pane in the contextual side panel, select the plus icon (+).
   b. Enter a name for your custom form template.
   c. Select the fields you want for your template and delete the ones you don’t want.
   d. Select Save.

4. Select the option icon ( ) to Edit or Delete a template. Templates that are deleted can’t be retrieved.

**Configure a template value field**
Select desired fields to create a form template in the Template section of a form.

**Before you begin**
Role required: user

**About this task**
Template value field selections sync with live updates.
Procedure
1. Open a record.
2. In the Template section of the form, select the associated table. For example, Incident.
3. In the Template field, select a field and a value for your template.
   
   **Note:** The table you selected determines which template value fields are available.
4. Select Save.

Results
The template value fields are visible on the form in the Template section.

Example:
Selecting field template values.
1. In the Template section of the form, select the Incident from the Table field.
2. In the Template field, select Description and enter Test text. A description is added to the template.
3. Select Approval from the Template field. A list displays with approval values.
4. Select Caller from the Template field. A list displays to select a caller.
5. Select Active from the Template field. The option appears to activate or deactivate the record.
6. Select Save.

Getting information related to the open record
Use related items to gather information about and to enter information into the open record.
The items in the Related items menu behave like tabs. When you click one, the corresponding content appears in the form pane. Workspace underlines the item that’s active in the form pane. What items appear in the menu, what order they’re in, and which one opens automatically are configurable by your system administrator.

The items contain information related to the record open in the form pane. You click the different items to get contextual information. For example, if the open incident is about a failed service, you might click **Impacted Services/CIs** to see if other services are also down. If the incident is a power outage, you might click **Outages** to see if there are outages in other locations.

The **Details** item usually displays first by default. It is the only item that contains details of the open record. It also provides text fields that you can edit. For example, when you solve an issue, you should enter the resolution description in the section, **Resolution notes**. Your system administrator determines which fields from a record appear in the form pane.

Your configuration of workspace might include the following related items.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>Detailed information about the open record and text fields for you to enter information. The system administrator specifies the record fields that appear in the form pane. You use this</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Task SLAs</td>
<td>Service level agreements (SLAs) for a task. Expected deadlines for resolving a task of this type.</td>
</tr>
<tr>
<td>Affected CIs</td>
<td>Configuration items (CIs) related to an incident. Often, an incident is related to one or more specific configuration items (CIs). If the configuration management database (CMDB) is populated, the CI records hold valuable information to help resolve incidents. You can associate configuration items to an incident to see how the incident affects dependent CIs.</td>
</tr>
<tr>
<td>Impacted Services/CIs</td>
<td>Services and configuration items (CIs) affected by this incident.</td>
</tr>
<tr>
<td>Child incidents</td>
<td>Child incidents are incidents related to the parent incident, the incident open in record view. All work notes or comments in a parent incident are copied into a child incident. When a parent incident is resolved, the child incidents are resolved.</td>
</tr>
<tr>
<td>Outages</td>
<td>Service outages related to the incident open in record view.</td>
</tr>
<tr>
<td>User's Calls</td>
<td>The <strong>User's Calls</strong> related list displays historical calls between a requester and Service Desk agents. This feature is available to the users who has the Service Desk Call plugin (com.snc.service_desk_call) already activated.</td>
</tr>
</tbody>
</table>
  **Note:** The customer name in the **Opened for** field in Interaction is matched with the **Caller** field in Service Desk calls and records are retrieved based on the number of days mentioned in the interaction property **Number of days (integer) for which past user call records are retrieved. The default value is seven (7). A setting of zero (0) disables this feature. (glide.new_call.interaction.records_age). |
| User's Task        | When a requester contacts an agent through chat, phone call, request, or walk-in, the **User's Task** related list shows the agent all of the other tasks (incident, problem, change request, request, and so on) that have been created for the requester. For example, if a requester calls about the status of a request that was made the previous day, the **User's Task** |
Related items (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>related list shows the request. Workspace includes the other tasks in the <strong>User’s Task</strong> related list when the value for the <strong>Opened for</strong> field in the interaction record matches the:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Caller</strong> field in an incident record</td>
</tr>
<tr>
<td></td>
<td>• <strong>Opened by</strong> field in a problem record</td>
</tr>
<tr>
<td></td>
<td>• <strong>Requested by</strong> field in a change record</td>
</tr>
<tr>
<td></td>
<td>• <strong>Requested for</strong> field in a Service Catalog record</td>
</tr>
</tbody>
</table>

**Domain separation for Workspace records**

Workspace supports standard domain separation. In a record, you can safely create another record in the correct domain, change the domain that the record associates with, and temporarily expand the domain scope of a record to a domain outside the record session.

Workspace uses Cross-Tenant Intelligence to automatically handle the data, metadata, business logic, and processing context for tenants that have access to additional tenant data. Cross-tenant intelligence enables the following behavior when you create a record.

- Records created from another record inherit the domain of the originating record.
- Records created with a UI action from a record carry over the domain of the originating record.
- Records created from a parent record, for example a related list, carry over the domain of the parent record.

For more information on Cross-Tenant Intelligence in Domain Separation, see [What is Domain Separation?](#).

Set form header images to provide domain context to a record.

**Toggle domain scope of a record**

Expand the domain scope of a record temporarily to a domain outside the record session. The record expands to include related lists and reference field queries. This enables you to create a master record that applies to issues for more than one domain.
Before you begin
You must first have permission to access the domain that you want to toggle.
Role required: domain_expand_scope user role

Procedure
1. Navigate to Workspace.
2. Select a record.
3. Click the overflow UI action icon (*** in the record and select **Toggle Domain Scope**.
   You can now access related lists and reference field queries.
   
   Note: Domain scope doesn’t toggle when the record is in the global domain or when your domain and the record domain match.

4. Click the overflow UI action icon (*** in the record and select **Toggle Domain Scope** to return the domain scope to the domain associated with the record.

Create a record in a domain without a parent
Create a new record when the domain of the record is unknown and you have access to multiple domains.

Before you begin
Change a domain by modifying the selection of the caller or company on the form of the record.
Role required: user

Procedure
1. Navigate to Workspace > New record menu.
2. On the form, fill in the fields.
   The company or caller selected associates the record with the corresponding domain.
   
   Note: Data available for auto-population is limited to the domains you have access to.

3. Click Next.

Results
The new record includes data and rules specific to the domain.
Sharing workspace views
Send a workspace view to another agent so he or she can look at the same information in workspace.

There may be times when you’re working on a record and want to share what you’re looking at with your manager or a fellow agent. To do that, copy the workspace URL in your browser and send it. The person can open the URL and see exactly what you’re seeing in workspace.

Add records to related lists
Add records to a related list to provide information related to an incident.

Before you begin
Role required: agent

About this task
If there is an Add button on your Related Items menu, your system administrator has made it possible for you to add records to related lists. You’d do this when you find a record that’s related to the one that’s open. For example, if the open record is about a power outage in one location, if there’s a power outage in a second location, you might add it to the related list of the first record.

Note: Not all workspaces have the Add button. It’s added by your system administrator.

When you open an incident, you can add locations that are associated with the incident. For example, let’s say that a power outage occurred in a location. You might find additional locations with the same power outage that you can add to the original incident report.

Procedure
1. Navigate to Incident > Open and click an incident to open it.
2. In the Affected Locations related list, click Add to associate records with the incident you selected.
3. In the pop-up modal, select the records that you want to add to the open incident.
The record data is read-only. Selecting the check box in the table heading selects all of the records in the modal and gives you an option of selecting all of the records in the list. Records that are selected on one page remain selected as you move onto another page.

4. In the modal, click **Add**.
   The addresses that you selected appear in the Affected Locations related list. They are added to the cmn_location table and are associated with this incident.

**Group and find records using tags in workspace**
Add tags to records to group and organize them.

**Before you begin**
Role required: agent
About this task

Tags are labels you can add to records. The tag icon (إنشاء) appears next to the primary value in the form header.

Tags enable you to group and organize records. You create the tag name, which should name the reason for the tag. You can make the tags visible to everyone, some people, or just yourself. The visibility setting specifies who can use the tags to search for records.

An unfilled tag icon (إنشاء) means that no tags have been assigned to the record. When tags are assigned and they're visible to you, the tag icon is filled (إنشاء).

After tagging records, you can use the tags to search for records in the global search field or using the filter icon (إنشاء) in List view.

Procedure

1. Navigate to any open record in a workspace.

   For example, click the list icon (إنشاء)، click a list filter, such as Open incidents، and click a record.

2. Click the Tag icon (إنشاء) next to the primary value in the form header.

3. In Add Tag، enter a tag name.

   The tag name should reveal the organization principal of the tag, for example, all records stemming from a particular incident.

4. Click Enter to save the tag with the record.

   You can add more tags.

   The tag visibility setting defaults to private, which means the tag is only visible to the person who created the tag. So, only that person can use the tag to search for records labeled with that tag.
5. To change the visibility setting of the tag, click the tag and change the **Viewable by** setting:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Me</strong></td>
<td>Tag is visible only to the person who created the tag. Only that person can use the tag to search for records. This setting is the default.</td>
</tr>
<tr>
<td><strong>Groups and Users</strong></td>
<td>Tag is visible to specific groups or users. You can specify the groups and users who can view this tag.</td>
</tr>
<tr>
<td><strong>Everyone</strong></td>
<td>Tag is visible to everyone.</td>
</tr>
</tbody>
</table>

Note: This visibility setting is only available to an admin or tags-admin role.

A record can have multiple tags and each can have a different visibility setting.
6. **Optional:** To remove a tag from a record, click a filled tag icon (✓) to open the list of tags, then click the X next to the tag you want to remove.

7. **Optional:** Search for your tag using the global search field.

**Communicating via email in workspace**

Email requesters and agents while working on issues in workspace.

With the workspace email client, you can email callers or fellow agents directly from the record view.
Compose an email
Compose an email to send to requesters and agents.

Before you begin
Role required: email_composer

Procedure
1. Open a record.
2. On the record view, click the menu icon (・・・) and then click Compose Email.
3. If available, complete the Reply To field.
   This field specifies who the recipient can reply to after receiving your email.
   You may choose to specify an entity apart from yourself (for example, the IT service desk).
4. In the To field, add an email recipient.
   Optionally, you can also add Cc and Bcc recipients by clicking Cc/Bcc.
5. In the Subject field, enter a subject line.
6. Create the email body.
   Optionally, you can insert a quick message in the email body. For more information, see Insert a quick message.
7. Optional: Attach a file to the email.
   For more information, see Attach a file to an email.
8. Click Send.
   Optionally, you can save the email as a draft by clicking Save. For more information on finding email drafts, see Review email drafts.
Results
You can find the sent email in the Emails list. For more information, see Review emails.

Insert a quick message
Insert predefined content into email messages.

Before you begin
Role required: email_composer

Procedure
1. Open an email draft.
2. Click the quick message icon (+).
3. From the quick messages list, select a quick message by clicking the insert icon (+).

Example:
In the following GIF, an agent creates an email requesting more information from the caller Beth Anglin. The agent opens the Quick Messages panel and then inserts several quick messages.
Attach a file to an email

Send a file to a requester or agent by attaching it to an email.

**Before you begin**
Role required: email_composer

**Procedure**

1. Open an email draft.
2. Attach a file using one of the following methods.

<table>
<thead>
<tr>
<th>Method</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attach a file from your computer</td>
<td>a. Click + Attach File, and then click From Computer.</td>
</tr>
<tr>
<td></td>
<td>b. Select a file from your computer.</td>
</tr>
<tr>
<td></td>
<td>You can select multiple files at a time. The system uploads the files si-</td>
</tr>
<tr>
<td></td>
<td>multaneously.</td>
</tr>
<tr>
<td></td>
<td>Alternatively, you can drag files from your computer onto workspace. You</td>
</tr>
<tr>
<td></td>
<td>can’t attach a folder.</td>
</tr>
<tr>
<td>Attach a file from the associated record</td>
<td>a. Click + Attach File, and then click From Record.</td>
</tr>
<tr>
<td></td>
<td>b. On the window, select the files to attach.</td>
</tr>
<tr>
<td></td>
<td>c. Click Add.</td>
</tr>
</tbody>
</table>

**What to do next**

Optionally, you can perform additional actions by clicking the menu icon ( disclosing) next to each attached file:

- **Download**: Download the file to your computer.
- **Rename**: Rename the attached file. Only the first 100 characters of a file name are displayed.
- **Remove**: Remove the attachment from the email.

**Flag an email as important**

Inform recipients that your email is high priority.
Before you begin
Role required: email_composer

Procedure
On an email draft, click the flag icon (.FLAG).

Results
After you send the email, the email is flagged in the recipient's inbox. In workspace, this flag appears as a tag on the email.

Review emails
Review emails that you have sent and received.

Before you begin
Create a workspace list for the Email [sys_email] table. For more information on creating workspace lists, see Create My Lists in workspace.
Role required: workspace_user

Procedure
1. Open the list view by clicking the list icon (LIST).
2. Click My Lists, and then open your emails list.
3. Find an email by filtering the list or sorting columns.
4. Open an email to review.

For more information on using workspace lists, see Work with lists in workspace.

INC0000601 - The USB port …

Hi Beth Anglin,

Thank you for reaching out to IT Support. We are working on your issue now.

Thanks,

IT Service Desk

Ref: MSG0000068_TMEUbli0j3wcP8nwEMr

You can reply to or forward the email by clicking Reply, Reply All, or Forward.
Note: The UI behavior is different when you select Compose Email in the header. For more information, see Communicating with requesters and agents using Compose.

if you reply/reply all/forward from the activity stream, just because that email behavior is different than if you just click Compose Email in the header.

Review email drafts
Continue working on the emails that you saved for later.

Before you begin
Create a workspace list for the Email Draft [sys_email_draft] table. For more information on creating workspace lists, see Create My Lists in workspace.

Role required: workspace_user

Procedure

1. Open the list view by clicking the list icon ( ).
2. Click My Lists, and then open your email drafts list.
3. Find an email draft by filtering the list or sorting columns.

For more information on using workspace lists, see Work with lists in workspace.

4. Open an email draft to continue working on it.

Communicating with requesters and agents using Compose
You use Compose to communicate with requesters and to enter comments about the work that you do on issues that only fellow agents can read.

Composing comments
After researching an issue, you might want to get more information from a requester, communicate a solution, or write an internal note to yourself or
other agents to record your progress in solving an issue. To do that, you use the **Compose** feature. How you enter comments or work notes depends on the configuration.

- If you use a single text field, you select **Comments** or **Work Notes**, enter your comment in the text field, and select **Post Comments**.

Use the **Comments** text field to communicate with external requesters. Use the **Work Notes** field to document your progress on an issue. Work notes are not sent to external requesters and are visible only to you and other internal personnel, such as fellow agents who might also work on the issue.

- In stacked view, where there are two text fields, enter text in the appropriate field and select **Post Comments** or **Post Work notes (Private)**.

You can view emails in the Activity Stream. The **Email** tab appears in **Compose** when you reply, reply all, or forward an email from an existing email in the Activity Stream.
If you configured **Compose** to use the rich text editor, you can use the icons at the top of the field to stylize the text.

**Activity**

**Response via Additional comments (Customer visible)**

With the rich text editor, you can paste an image directly into the text field.
When you post your comment in **Compose**, the comment moves into the Activity Stream, which preserves the entire communication history. Only emails that are user-generated appear, for example existing emails that you write or reply to.

**Activity Stream**

**Service-now:**
2019-12-04 13:23:01 • Additional comments

I entered a change request to restart the Windows server.

**Service-now:**
2019-12-04 13:19:11 • Field changes

- **Impact**: 3 - Low was Empty
- **Opened by**: Empty was Empty
- **Priority**: 4 - Low was Empty
- **State**: New was Empty

**Other communications**

In addition to sending comments to requesters, you can also:
• Use the attachment feature (_attachment) in the Contextual side panel, for example, to add a knowledge article to a comment.

• Select the links in some of the cards in Agent assist that, for example, add a knowledge article to a comment.

**Configuring Compose**

You can configure **Compose** to appear as a single text field or two text fields.

You configure **Compose** by selecting the configuration icon (Configuration).

You can also view **Compose** and the Activity Stream side by side to enable you to write work notes and comments while scrolling the activity stream. The Compose UI displays next to the Activity Stream when column space is adjusted to accommodate the side by side UI. You can enable or disable this feature by selecting the configuration icon (Configuration) and then selecting **Side by side**. This option appears in the UI when column spacing is wide enough to support side by side (700 pixels or more). This feature may not be supported in older versions of Safari.
For more information, see Customize workspace.

Writing Knowledge articles to share solutions

To share a solution you’ve found with the community of workspace users, you can create and publish a knowledge article. The Knowledge Management Service Portal enables users to view knowledge base articles. It is available by default. For more information about creating, editing, and viewing articles, see Knowledge article authoring in Workspace.

Attach a document for a requester

Attach documents to a record to help requesters resolve issues. The attachment icon displays a badge enabling you to see with a quick glance that a document is attached.

Before you begin
Role required: agent_workspace_user

About this task
  • There are two ways to attach documents to a record.
    1. Browse for the document from the Agent Assist panel.
    2. Drag and drop the document on the record and press browse in the pop-up window.
  • Attachments support PDFs and most image files.
Procedure

1. Navigate to **Agent Workspace > Agent Workspace Home**.
2. Open an incident record.
3. In the Agent Assist panel, click the attachment icon (🔗).
4. Select the document for your local computer.
5. Click **Upload**.

Results

The document appears in the Activity Pane and the Attachments icon displays a small dot indicating the record has an attachment.

Send an article to a requester

Use Agent Assist to send articles to requesters to solve their issues.

**Before you begin**

Role required: agent_workspace_user

**About this task**

Agent Assist search results can include links to knowledge articles that you can send to a requester.

Procedure

1. Navigate to **Agent Workspace > Agent Workspace Home**.
2. Open an incident record in list view.
3. In the Agent Assist panel, click a search result that is an article.
4. Click the **Attach** link to send the article to the requester.
5. In the pop-up, enter a message to the requester and click **Attach Article**.

**Attach Article**

Create And Edit A Contact Group  
KB0000026  
4 min read  
1 view  
Average rating: -1/5

Additional comments (Customer visible)  
I think this article might provide the info you need.
You comment and a link to the attachment appears in the activity stream.

Order a catalog item for a requester
Order a catalog item for a requester from Agent Assist search results.

Before you begin
Role required: agent_workspace_user

Procedure
1. Navigate to Agent Workspace > Agent Workspace Home.
2. Open an incident record in list view.
3. In the Agent Assist panel, click a search result that is a catalog item.
4. Click the catalog item, and then click Order.
The form for the catalog item opens in a new sub-tab.
5. Specify the details of the catalog item in the form, such as the number of gigabytes a laptop should have.

Results
Ordering the catalog item creates a service catalog request.

Performance Analytics and Reporting for Workspace
Integrate data visualization and reporting functionality into the workspace experience. Get notified about behavioral process changes. Explore KPIs, and get answers and insights on analytics with these Performance Analytics and Reporting Workspace integrations.

These features enable users to see pre-configured dashboard views. The features also show cases via trend line, column, comparison, proportional, and score visualizations within workspaces. Users can view and drill down into reports that show key performance indicators over time. They also see the current state of instance data, such as how many open incidents of each priority there are.

For more information, see Performance Analytics and Reporting for Workspace
Cloud Call Center

Integrate a third-party phone system with your ServiceNow® instance to drive the efficiency of your call center without having to navigate through multiple systems while attending a call. Help managers analyze the calls and view call metrics at one place.

Cloud Call Center in action

Here's an overview on how Cloud Call Center is integrated with Amazon Connect. Cloud Call Center Integration with Amazon Connect

---

**Explore**

Learn about how customers, agents, and managers use Cloud Call Center.

**Set up**

Set up Cloud Call Center.

**Integrate**

Extend Cloud Call Center capabilities by integrating with other applications.
Use

Receive inbound calls, place outbound calls, and monitor calls.

Reference

Get details about components such as roles, contact flows, and operation handlers.

Additional resources

• Cloud Call Center API on the ServiceNow<sup>®</sup> Developer Site

Exploring Cloud Call Center

Use Cloud Call Center to facilitate inbound and outbound telephone calls by integrating your ServiceNow instance with a third-party phone system such as Amazon Connect.

Key features

Integrate a third-party phone system with Cloud Call Center in the ServiceNow instance

Provide a seamless inbound and outbound voice call experience for your callers and agents.

Integrate third-party phone system

ServiceNow Cloud Call Center

Amazon Connect - Setup Instructions

Home

This guide helps you set up your Amazon Connect instance and integrate it with your ServiceNow instance.

Prerequisites:

1. Ensure an Amazon Web Services (AWS) account with administrative access to complete the setup.
2. Review the pricing guidelines for the services provisioned during this setup. Required services, resources, and roles are set up in your AWS account.
3. Since not all Amazon Services are available in all AWS regions, review the AWS documentation to ensure all resources are deployed to one region.
4. Create a service account in your ServiceNow instance to allow communication from your AWS account to your ServiceNow instance. If you do not have the permissions to create new user accounts on your instance, contact your ServiceNow administrator for creating this service account.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Display relevant data for an agent at the right time

Display relevant data in an interaction for an agent to help a customer during a call.

Route calls to agents

Analyze recording and call metrics of interactions

Within your ServiceNow instance, access recordings, call metrics, and call transcripts of agents to analyze interactions.

Review and analyze call transcripts

As an admin, you can:

• Use pre-built instructions and templates to integrate your ServiceNow instance with a third-party phone system such as Amazon Connect.

• Use pre-built operation handlers that invoke interactions to fulfill requests between a third-party phone system and Cloud Call Center.
As a manager, you can:
• View the call transcript and recording for coaching.
• View call metrics (for example, agent call time) for reporting.
• Analyze agent conversations and provide feedback for quality assurance.

As an agent, you can:
• Get calls routed to your assigned queues and accept or reject the calls via the integrated softphone from within the ServiceNow instance.
• Get the context of caller information before accepting a call.
• Collaborate with managers who can analyze your conversations and provide feedback for quality assurance.
• Manage presence states within the ServiceNow instance. For information about the presence states of an agent, see Agent Inbox controls.
• Access and use your softphone directly from within the ServiceNow interface using the OpenFrame integration. For information about OpenFrame, see OpenFrame overview.

As a caller, you can:
• Create a task using voice-based interactions. For example, create an incident or a case, unlock your account, or get a callback.
• Get your requests fulfilled within the integrated ServiceNow instance through bot interactions using the voice or dual-tone multi frequency (DTMF) inputs. These bot interactions are defined in contact flows in the third-party phone system.
• Get your call transferred to an agent who can help fulfill a request.

Inbound call workflow for the integration of Cloud Call Center with Amazon Connect
When a caller contacts the call center, using the voice or dual-tone multi frequency (DTMF) inputs from a caller, a contact flow is invoked in the Amazon Connect instance based on the caller context such as language. An interaction record is created for this call.
• The caller request can be forwarded to an operation handler in the ServiceNow instance.
• The request can be resolved by an automated interaction with bot. If the caller request is not resolved by an automated interaction with bot, then the request is forwarded to a queue. An agent then receives the call and interaction, and resolves the request.
Here is an example workflow.
Amazon Connect Integration

Zeke calls Support

Amazon Connect → AWS Lambda

Interaction record created

Let’s try and deflect the call
Cloud Call Center recognizes this is Zeke and identifies that there is a wifi issue in his office location

There is a wifi issue in San Diego. Is this why you are calling?

“No, can you please tell me the status of my request?”

Zeke

I will look up the status of your request.
Setting up Cloud Call Center

Enable Cloud Call Center and integrate it with a third-party phone system such as Amazon Connect.

When you set up a third-party phone system and integrate it with the ServiceNow instance, an agent can accept an incoming call or make an outbound call from the ServiceNow instance using the integrated softphone. This experience is based on the configurations made within the third-party phone system.

Get started with Cloud Call Center

1. Procure the Professional license for a ServiceNow application, such as ITSM Pro or CSM Pro, which includes the Cloud Call Center SKU.
2. Install the Cloud Call Center applications in ServiceNow® Store. For information about this installation, see Install Cloud Call Center applications.
3. Sign up and create an account with a third-party phone system. By default, Amazon Connect is supported. For information about creating an Amazon Web Services (AWS) account, see the Amazon documentation.
4. Configure the framework for the third-party phone system within the ServiceNow instance. By default, the framework is supported for Amazon Connect. For information about this configuration, see Integrate Cloud Call Center with Amazon Connect.

Install Cloud Call Center applications

You can install the Cloud Call Center applications if you have the admin role. The application includes demo data and installs related ServiceNow® Store applications and plugins if they are not already installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.
• Your organization must have purchased the Professional license for a ServiceNow application, such as ITSM Pro or CSM Pro, which includes the Cloud Call Center SKU.
• You should install at least one content pack, for example, CSM or ITSM.

Role required: admin

About this task

The following Cloud Call Center applications should be installed.
# Cloud Call Center applications

<table>
<thead>
<tr>
<th>Application</th>
<th>Description</th>
<th>Components installed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloud Call Center Core [sn_cti_core]</td>
<td>Provides the framework that supports the integration with your third-party phone system.</td>
<td>For information about the components installed with this application, see <a href="#">Components installed with Cloud Call Center Core</a>.</td>
</tr>
<tr>
<td>Amazon Connect Integration with Cloud Call Center [sn_cti_amzn_cct]</td>
<td>Integrates Amazon Connect with the Cloud Call Center Core.</td>
<td>For information about the components installed with this application, see <a href="#">Components installed with Amazon Connect Integration with Cloud Call Center</a>.</td>
</tr>
<tr>
<td>Cloud Call Center UX Components [sn_cti_ux]</td>
<td>Enables call recording, transcription, and sentiment analysis for Cloud Call Center with Workspace experience.</td>
<td>None</td>
</tr>
</tbody>
</table>

## Procedure

1. Navigate to **System Applications > All Available Applications > All**.
2. Find these applications using the filter criteria and search bar.
   - Cloud Call Center Core (sn_cti_core)
   - Amazon Connect Integration with Cloud Call Center (sn_cti_amzn_cct)
   - Cloud Call Center UX Components (sn_cti_ux)

You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

Visit the [ServiceNow Store](#) website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the [ServiceNow Store version history release notes](#).

3. In the Application installation dialog box, review the application dependencies.
Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install the Cloud Call Center applications.

- Cloud Call Center Core (sn_cti_core)
- Amazon Connect Integration with Cloud Call Center (sn_cti_amzn_cct)
- Cloud Call Center UX Components (sn_cti_ux)

For the complete Cloud Call Center experience, install Cloud Call Center for ITSM or Cloud Call Center for CSM applications. For information about these installations, see Install Cloud Call Center for ITSM and Install Cloud Call Center for CSM.

4. Optional: If demo data is available and you want to install it, click Load demo data.

(Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

**Important:** If you don’t load the demo data during installation, it’s unavailable to load later.

5. Click Install.

Integrate Cloud Call Center with Amazon Connect

Connect Cloud Call Center of your ServiceNow instance with the Amazon Connect instance to provide a seamless inbound and outbound voice call experience for your callers and agents.

Before you begin

- Procure an Amazon Web Services (AWS) account with the administrative access to complete the integration setup between Amazon Connect and ServiceNow. For information about creating the AWS account, see the Amazon documentation.

- Create a service account in your ServiceNow instance to allow communication from your AWS account to your ServiceNow instance. If you do not have the permissions to create service accounts on your instance, contact your ServiceNow administrator for creating this service account.

Role required: sn_cti_amzn_cct.admin

Watch this 10-minute video to learn more about integrating an Amazon Connect instance. This video covers: Deploying Amazon resources and the
Lex Bot, setting up the Amazon Connect instance and the contact flow, authentication and roles, and User ID and password parameters

Procedure

1. Log in to your Amazon Web Services (AWS) account and setup an Amazon Connect instance. For instructions on setting up this instance, see the Amazon Connect documentation.

2. Integrate the Amazon Connect with your ServiceNow instance.
   a. Log in to your ServiceNow instance.
   b. Navigate to Amazon Connect Integration > Setup Instance.
   c. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the Amazon Connect instance.</td>
</tr>
<tr>
<td>AWS ARN</td>
<td>Amazon resource name of the Amazon Connect instance. For information on AWS ARN, see the Amazon Connect documentation.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that indicates if the record is active.</td>
</tr>
<tr>
<td>Override Params</td>
<td>Option to edit the domain for Amazon Connect instance parameters. You should select this option only when you want to integrate the ServiceNow instance with an Amazon Connect instance created before introducing the new domain for the Amazon Connect console. For information about this new domain, see the Amazon Connect documentation.</td>
</tr>
<tr>
<td>Instance Params</td>
<td>Auto-generated parameters based on the name of the Amazon Connect instance. For example, here are the Amazon Connect instance parameters before and after introducing the new domain for the Amazon Connect console.</td>
</tr>
</tbody>
</table>
3. Configure the Amazon Connect components in your ServiceNow instance.

   a. Navigate to Amazon Connect Integration > View Instances.

   b. Select the instance you want to configure.

   c. Click the Setup Guide related link.

   d. Complete the instructions for components specified in each section.

### Steps to configure Amazon Connect components

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Application</td>
<td>Select an application for which you want to configure the Amazon Connect components.</td>
</tr>
<tr>
<td>Setup S3 Bucket</td>
<td>Host content that can be deployed by Amazon CloudFormation. For more information on creating an S3 bucket, see the Amazon documentation.</td>
</tr>
<tr>
<td>Deploy Stack</td>
<td>Set up a collection of the required Amazon Web Services (AWS) resources. For more information on stacks, see the Amazon documentation. You can deploy the AWS stack using AWS CloudFormation templates.</td>
</tr>
<tr>
<td>Step</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
|              | • Use AWS Cloud Formation template to describe AWS resources and properties  
|              | • Use AWS Cloud Formation stack to provision the resources described in the template                                                      |
| Deploy Lex Bot | Build voice-based conversational interfaces for your users. For more information on Lex Bot, see the Amazon documentation                     |
| Connect Setup | Integrate with your ServiceNow instance with AWS services                                                                                  |
| Import Contact Flows | Define a call tree for inbound and outbound calls between Amazon Connect and your ServiceNow instance. For more information on contact flows, see the Amazon documentation.  
|              | Based on your subscription, you have default inbound and outbound contact flows. For example, for the integration of Cloud Call Center with ITSM applications, see Components installed with Cloud Call Center for ITSM.  
|              | For an inbound contact flow, create queues to route contacts from AWS queues to ServiceNow queues. For information on creating queues in AWS, see the Amazon documentation.  
|              | Amazon Connect (Phone) is a placeholder phone channel for Amazon Connect integration. For queues that you implement in your Amazon Connect instance, you can use this channel to create corresponding Advanced Work Assignment queues. For an example implementation, see Associate Amazon Connect queues for ITSM to a ServiceNow instance or Associate Amazon Connect queues for CSM to a ServiceNow instance. |
| Call Recording Events | Send recording events to the ServiceNow instance by enabling call recording on your Amazon Connect instance. For more information on recording behavior, see the Amazon documentation |
| Setup Authentication | Integrate your Amazon Connect instance with your ServiceNow account by creating a service account                                              |
| Additional Configuration | Launch the Amazon Connect softphone interface within ServiceNow UI by configuring Openframe.                                                  |
Configure a contact flow for an automated caller interaction

Invoke an automated caller interaction with bots to fulfill the caller's request within the ServiceNow instance.

Before you begin
Role required: sn_cti_core.admin

About this task
When a caller contacts the call center, using the voice or dual-tone multi frequency (DTMF) inputs from caller, a contact flow is invoked in the Amazon Connect instance based on the caller context. The contact flow contains nodes that act as integration points between Amazon services and the ServiceNow instance. Based on the nodes defined in the contact flow, the corresponding operation handlers are triggered in the ServiceNow instance. The caller then gets the response that is defined in the operation handler. For information about contact flows, see the Amazon documentation.

In the ServiceNow base system, a few operation handlers are available by default. For information on operation handlers, see Cloud Call Center reference.

Procedure
1. **Optional:** If you do not want to use a default operation handler, create and configure an operation handler in the ServiceNow instance.
   
   a. Navigate to Cloud Call Center - Core > Operation Handlers.
   
   b. Click New.
   
   c. On the form, fill in the fields.
### Operation Handler form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operation Name</strong></td>
<td>Name of the operation that you want to automate.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Type that specifies how the operation is implemented.</td>
</tr>
<tr>
<td></td>
<td>• Script: Implementation is included in a script.</td>
</tr>
<tr>
<td></td>
<td>• Forward to Handler: Request is forwarded to an operation handler, which is invoked by lookup on the sys_id of that handler. This scenario is possible when you have different intents for similar operations, for example, Create an HR incident and Create incident.</td>
</tr>
<tr>
<td></td>
<td>• Forward to Operation: Request is forwarded to an operation handler, which is invoked by lookup on the name of the handler and then name resolution to find the handler.</td>
</tr>
<tr>
<td></td>
<td>• Integration Hub - Action: Calls an IntegrationHub action.</td>
</tr>
<tr>
<td></td>
<td>• Integration Hub - Subflow: Calls an IntegrationHub flow or subflow.</td>
</tr>
<tr>
<td><strong>Application</strong></td>
<td>Application associated with the operation handler.</td>
</tr>
<tr>
<td><strong>Domain</strong></td>
<td>Domain associated with the operation handler.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Option to activate the operation handler.</td>
</tr>
<tr>
<td><strong>Require Authentication</strong></td>
<td>Option to enable authentication for the operation handler.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If this option is selected, the corresponding operation is invoked only when a valid authentication token is passed in the request. It is supported by an authentication operation handler that supports pin-based authentication, which can be leveraged in your contact flows. For information about configuring the PIN, see Configuring a phone PIN.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Summary about the operation handler.</td>
</tr>
</tbody>
</table>
### Nodes in contact flows

<table>
<thead>
<tr>
<th>Node</th>
<th>Description</th>
<th>Configuration</th>
</tr>
</thead>
</table>
| Get Customer Input   | Invokes a Lex Bot. The operation handler that is triggered is based on the name of the intent associated with the Lex Bot. For information about this node, see the Amazon documentation. | a. Create an intent for the required Lex Bot in your Amazon Connect instance. For information about creating an intent, see the Amazon documentation.  
   
b. Specify the following information in the intent.  
   • Intent name: Name of the intent.  
   
   Note: This intent name should match an operation handler in the ServiceNow instance with the same name, or name + ‘_<suffix>’ where suffix can contain any five uppercase alpha characters. |
<table>
<thead>
<tr>
<th>Node</th>
<th>Description</th>
<th>Configuration</th>
</tr>
</thead>
</table>
| Note:                                            | This node can be used when the integration is between Amazon Lex and the ServiceNow instance. | • Sample utterances: Caller utterances that trigger the operation handler.  
• Lambda initialization and validation: If the operation handler being invoked requires authentication, select the **Initialization and validation code hook** check box and select the deployed AWS Lambda function.  
• Lambda function: Deployed AWS Lambda function that is invoked.                                                                 |
| c. Save, build, and publish the intent.          |                                                                             |                                                                                                                                           |
| d. Open the required contact flow in the contact flow designer in your Amazon Connect instance. |                                                                             |                                                                                                                                           |
| e. Click the Get Customer Input node and specify the Lex Bot details in the **Amazon Lex** section. |                                                                             |                                                                                                                                           |
| f. Click **Save**.                               |                                                                             |                                                                                                                                           |
| a. Open the required contact flow in the contact flow designer in your Amazon Connect instance. | Invokes an AWS Lambda function. The operation handler that is triggered is based on the **sn_operation** parameter set on the node in the contact flow. For information about this node, see the Amazon documentation. |                                                                                                                                              |
| b. Click the **Invoke AWS Lambda Function** node and specify the following input parameters. | Invokes an AWS Lambda function. The operation handler that is triggered is based on the **sn_operation** parameter set on the node in the contact flow. For information about this node, see the Amazon documentation. | • Destination key: **sn_component**, Value: Component from where the Lambda function is invoked. For example, **sn_aws_connect_lambda_proxy_component**.  
• Destination key: **sn_operation**, Value: Name of the operation handler that you want to invoke. For example, **interactionEvent**. |
| a. Open the required contact flow in the contact flow designer in your Amazon Connect instance. | Invokes an AWS Lambda function. The operation handler that is triggered is based on the **sn_operation** parameter set on the node in the contact flow. For information about this node, see the Amazon documentation. |                                                                                                                                              |
| b. Click the **Invoke AWS Lambda Function** node and specify the following input parameters. | Invokes an AWS Lambda function. The operation handler that is triggered is based on the **sn_operation** parameter set on the node in the contact flow. For information about this node, see the Amazon documentation. | • Destination key: **sn_component**, Value: Component from where the Lambda function is invoked. For example, **sn_aws_connect_lambda_proxy_component**.  
• Destination key: **sn_operation**, Value: Name of the operation handler that you want to invoke. For example, **interactionEvent**. |

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Node</th>
<th>Description</th>
<th>Configuration</th>
</tr>
</thead>
</table>
|      | **Note:** This node can be used to for data dips (for example, authorizing a caller) where the integration is between the call center and the ServiceNow instance. The data dip configuration allows a caller to enter information, such as an account number, to route calls to a particular queue. Using this number, you can look up the first name of the caller and create an interaction record after the call is initiated. Also, you can customize the greeting with the caller name later in the flow. | • (optional) Destination key: queueName, Value: Name of the queue that you want to transfer the flow to.  
  **Note:** This parameter is used to invoke the workItemEvent operation handler.  
  • (optional) Destination key: queueId, Value: ARN of the queue that you want to transfer the flow to.  
  **Note:** This parameter is used to invoke the workItemEvent operation handler.  
  • (optional) Destination key: authToken, Value: AuthToken received via authentication call. This parameter is required for invoking an operation handler that requires authentication.  
  • (optional) Destination key: interactionId, Value: Interaction ID received via interactionEvent call.  |
|      |             | c. Click **Save**. |
3. Ensure that a caller’s phone number is associated with the contact flow after it is created and published. This process ensures that each time the caller calls, the corresponding contact flow is invoked. For information about associating a phone number with a contact flow, see the Amazon documentation.

Note: For a sample implementation of invoking operation handlers in a contact flow, you can refer to the default contact flows. For information on default contact flows, see Components installed with Cloud Call Center for ITSM and Components installed with Cloud Call Center for CSM.

Configuring a phone PIN

You can set up or reset a phone PIN that can be used for caller authentication during a call with an agent.

If the Require authentication field is set to true for an operation handler, the corresponding operation is invoked only after the caller enters the PIN.

Important: It is applicable for both Cloud Call Center for CSM and Cloud Call Center for ITSM applications.

Reset the phone PIN for a caller

Reset the phone PIN for a caller if the caller's account is locked.

Before you begin
Role required: sn_cti_core.user_manager

About this task

Procedure

1. Navigate to Cloud Call Center - Core > User Pin Reset.
2. For the required CTI user, Click the preview icon and open the record to reset the PIN.
   a. In the PIN field, enter the new PIN.
   b. Clear the Disabled check box.
   c. Click Update.
Set or reset the phone PIN

Set up or reset your phone PIN that can be used for caller authentication when you call an agent.

Before you begin
Role required: none

Procedure

1. Navigate to **Cloud Call Center - Core > My Phone PIN**.
2. On the Request Phone PIN form, enter the PIN and re-enter it.
3. Click **Submit**.

Scripting for operation handlers

You can use the APIs in the Cloud Call Center framework to create a seamless voice call experience for your callers and agents.

The **CTIOperationRequest** API provides methods to set and get data on the current CTIOperationRequest object. For information on this API, see **CTIOperationRequest - Scoped, Global**.

The **CTIOperationResponse** API provides methods to set and get data on the current CTIOperationResponse object. For information on this API, see **CTIOperationResponse - Scoped, Global**.

The **CTI API** provides REST resources that enable Computer Telephony Integration (CTI) providers to interact with the Cloud Call Center framework. For information about this API, see **CTI API**.

Provider configuration in Cloud Call Center

For both inbound and outbound calls, a provider configuration contains settings about the involved components and message transformers for a specific third-party phone system provider. Any request from that phone system provider is handled within ServiceNow based on these settings.

To view the available provider configurations, navigate to **Cloud Call Center - Core > Provider Configurations**.

Any request from a third-party phone system is passed into a ServiceNow instance through the **CTI Operation** endpoint of the **CTI API**. For information about this API, see **CTI API**. Based on the provider and the component specified in the endpoint, the corresponding message transformers are invoked to perform the following:
• Transform the request from the third-party phone system before passing the request to an operation handler.
• Transform the response from the operation handler before passing it on to the third-party phone system.

Provider component
For each component or node available in the third-party phone system, a provider configuration contains a provider component. It contains a mapping between the component and a message transformer.

To view the available provider components, navigate to Cloud Call Center - Core > Provider Components > .

Message transformer
A message transformer defines how a request and response can be transformed between a third-party phone system and the ServiceNow instance.

• The Input Transformer field has a script that defines how a request from a third-party phone system should be transformed within the ServiceNow instance before passing the request to an operation handler.

• The Output Transformer field has a script that defines how the response from the operation handler should be transformed before passing it on to the third-party phone system.

To view the available message transformers, navigate to Cloud Call Center - Core > Provider Message Transformers > .

Provider configuration for the integration of Cloud Call Center with Amazon Connect
For the Cloud Call Center integration with Amazon Connect, the AWS Connect Default Handler provider component is available by default.

⚠ Note: The Amazon Connect Integration with Cloud Call Center application [sn_ctl_amzn_cct] should be installed in ServiceNow® Store. For information on installing this application, see Install Cloud Call Center applications.

For each node that can be used as an integration point between Amazon services and the ServiceNow instance, the following provider components and the corresponding message transformers are available.
When a customer dials using a phone number, a call is placed through the Amazon Connect's phone system. Using one of its components, Amazon Connect provides the request to the ServiceNow instance through the CTI Operation endpoint of the CTI API. For information about this API, see CTI API. Based on the provider and the component specified here, the corresponding message transformers are invoked to perform the following:

- Transform the request from Amazon Connect before passing the request to an operation handler.
- Transform the response from the operation handler before passing it on to Amazon Connect.

**Extension points in Cloud Call Center**

Using extension points, you can call the custom scripts to extend the functionality of Cloud Call Center. While integrating a third-party phone system with Cloud Call Center, you can invoke extension points using the CTI API to handle events in Cloud Call Center.

By using extension points, you can easily integrate customizations without having to alter the base code. You can extend standard base functionality using customized scripts. For more information, see Using extension points to extend application functionality.

To view the extension points that are available by default, navigate to System Extension Points > Scripted Extension Points and group by the Cloud Call Center Core application.
Note: You should install the Cloud Call Center Core, Cloud Call Center for ITSM, Cloud Call Center for CSM, and Amazon Connect Integration with Cloud Call Center applications in ServiceNow® Store. For information about these installations, see Install Cloud Call Center applications, Install Cloud Call Center for ITSM, and Install Cloud Call Center for CSM.

Extension points in Cloud Call Center

<table>
<thead>
<tr>
<th>Extension point</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_cti_core.clickToCallContextMap</td>
<td>Enables the copying of application-specific field values to interaction records for Cloud Call Center outbound calls.</td>
</tr>
<tr>
<td>sn_cti_core.CTICallAnalysisExtractor</td>
<td>Defines how the transcription and the recording data is retrieved for an interaction based on the third-party phone system integrated with Cloud Call Center</td>
</tr>
<tr>
<td>sn_cti_core.SoftPhoneEventSink</td>
<td>Defines if the third-party phone system can handle an event. Maps events from the Softphone interface to back-end events.</td>
</tr>
</tbody>
</table>

Configure the E.164 format for a consumer phone number

Ensure that all the necessary information for a phone number is included and properly formatted to successfully route an international call over a territory’s public telephone network. Provide the E.164-compliant formatting and validation for phone number.

Before you begin
Role required: admin

About this task
An E.164 phone number field displays the following field types:

- A list for the phone number territory
- An input box for entering phone numbers

The E.164 format that does not contain any dashes or spaces and must include the + sign. For example, +14152223456.
Procedure

1. Navigate to Customer Service > Consumers.
2. Select the required consumer record.
3. On the Consumer form, right-click any phone field and select Configure Dictionary.
4. On the Dictionary Entry form, for the Type field, select Phone Number (E164).
5. Click Update.

Results
After this configuration, when entering the consumer phone number in the phone field, select the territory and enter the corresponding phone number. The same format is reflected in Agent Workspace.

Using Cloud Call Center

Agents can use Cloud Call Center to receive inbound calls and make outbound calls with a seamless voice call experience. Managers can use this application to monitor and analyze calls.

Receiving inbound calls in Cloud Call Center

An agent can receive inbound calls using the Agent Softphone interface to handle a caller's request.

As an agent, you should have any of the following roles to receive an inbound call:

- sn_openframe.user and interaction_agent
- If the Advanced Work Assignment plugin (com.glide.awa) is installed, awa_agent & awa_integration_user.

After a customer dials in, the corresponding contact flow is invoked in Amazon Connect. Through the configured nodes, the request is forwarded to an operation handler in the ServiceNow instance.

If an agent is available, the agent can receive the call and handle the request using Agent Softphone interface. For information about the presence states of an agent, see Agent Inbox controls.
Interaction record states

<table>
<thead>
<tr>
<th>If</th>
<th>Then the interaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>The interaction has just been created, is currently in a call tree</td>
<td>Is in <strong>New</strong> state.</td>
</tr>
<tr>
<td>being deflected by an IVR flow, or has not yet been routed and</td>
<td></td>
</tr>
<tr>
<td>assigned to an agent</td>
<td></td>
</tr>
<tr>
<td>The Lex Bot deflects the call or the user disconnects the call any</td>
<td>Moves to <strong>Closed Complete</strong> state.</td>
</tr>
<tr>
<td>time before the call enters the queue</td>
<td></td>
</tr>
<tr>
<td>The interaction gets assigned to an agent</td>
<td>Moves to <strong>Work in Progress</strong> state.</td>
</tr>
<tr>
<td>The user disconnects the call while waiting in the queue</td>
<td>Moves to <strong>Closed Abandoned</strong> state.</td>
</tr>
</tbody>
</table>

**Initiating outbound calls with Cloud Call Center**

Improve your productivity as an agent by initiating outbound calls to connect with customers using the click-to-call feature in the Cloud Call Center application.

As an agent, you can initiate outbound calls using the click-to-call feature when accessing the phone number of a user. The phone number of a user, if available, is displayed on the ServiceNow application UIs. Example application UIs include the contact details on a Case form, the user record on an Incident form, the Consumer form, the Contact form, and other application UIs.

**Note:**

- If not available, you can add the **Caller** field to an incident form.
- The phone number of a user should be in the E.164 format. For information about configuring a phone number in this format, see [Configure the E.164 format for a consumer phone number](#).

You should have any of the following roles to initiate an outbound call:

- **sn_openframe.user** and **interaction_agent**
- If the Advanced Work Assignment plugin (com.glide.awa) is installed, **awa_agent & awa_integration_user**.

You can click the link to the user's phone number displayed on the application UI. The user record must have the mobile phone, business phone, or both.
Agent Softphone pop-up window is displayed letting you know that the call will be recorded, and then the user's number is connected. An interaction record of type Phone is created for the call and is in the **Work in Progress** state.

The following agent presence states are configured by default for the Cloud Call Center application and are displayed in your Agent Workspace Inbox.

### Agent Workspace Inbox statuses

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CallingCustomer</td>
<td>Indicates that you are in the process of connecting with a customer. After the call is connected, the status appears as <strong>Busy</strong>.</td>
</tr>
<tr>
<td>Busy</td>
<td>Indicates that you are on the call.</td>
</tr>
<tr>
<td>AfterCallWork</td>
<td>Indicates that you ended the call and right now working on updating the task such as case details. The status is displayed after you click <strong>End call</strong> in the Agent Softphone pop-up window.</td>
</tr>
<tr>
<td>Available</td>
<td>Indicates that you are available to accept another task such as a case. The status is displayed after you click <strong>Clear contact</strong> in the Agent Softphone pop-up window.</td>
</tr>
<tr>
<td>FailedConnectAgent</td>
<td>Indicates that you were unable to connect with the customer. After the call doesn’t go through, the status appears as <strong>Available</strong>.</td>
</tr>
</tbody>
</table>

**Note:** The Agent Workspace Inbox statuses are synchronized with your Advanced Work Assignment (AWA) activity.

The activity stream of the associated interaction record is populated with your status details, the URL to the call recording, contact trace record, and call transcript.

**Monitoring calls in Cloud Call Center**

A manager can monitor analyze calls to provide feedback and coach agents. As a manager, you can:
• View the call transcript and recording for coaching.
• View call metrics (for example, agent call time) for reporting.
• Analyse agent conversations and provide feedback for quality assurance.

In Agent Workspace, ITSM Manager Workspace, and CSM Manager Workspace, you can use the **Call Analysis** tab in an interaction to analyze transcripts, recordings, and sentiments.

**Integrating Cloud Call Center with other applications**
You can extend the capabilities of Cloud Call Center for inbound and outbound calls by integrating with other applications.

**Integrating Cloud Call Center with ITSM**
Route calls coming through the Cloud Call Center to specific phone queues based on user preference, utterances, or any other ServiceNow data to optimize incident resolution.

**Sample ITSM contact flow**
Use the inbound ([ServiceNow ITSM Inbound Demo Flow](#)) and outbound ([ServiceNow ITSM Outbound Demo Flow](#)) Amazon Connect ITSM sample contact flows that come with the Cloud Call Center integration to get you up and running quickly. The sample flow allows you to deflect voice calls or route them based on the caller context to different queues. When a call comes through the Cloud Call Center, the Amazon Connect application uses data dips to identify the caller and then deflect the call or route it to the right agent. For more information on integrating Cloud Call Center with Amazon Connect see, [Integrate Cloud Call Center with Amazon Connect](#).

Callers can access status updates or make updates to their records when they are authenticated.

**PIN-based authentication**
Callers can use PIN-based authentication to access the phone channel. Managers can set or reset the PIN for the users who can also set or reset their phone PIN. For more information, see [Configure a phone PIN](#).

**Workforce Optimization for ITSM**
Integrate Cloud Call Center with Workforce Optimization for ITSM to visualize call metrics from Amazon Connect. The Cloud Call Center uses **Advanced Work Assignment** to display the call metrics and active calls along with all other...
Channel metrics in the Manager Workspace. For more information, see Using Cloud Call Center with Workforce Optimization for ITSM.

Install Cloud Call Center for ITSM

You can install the Cloud Call Center for ITSM application (sn_cti_itms_cnt) if you have the admin role. This plugin installs the ITSM content for integration between Cloud Call Center and a third-party phone system.

Before you begin

- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.
- Your organization must have purchased ITSM Pro subscription, which includes the Cloud Call Center SKU.
- Cloud Call Center for ITSM requires the following ServiceNow Store application. Ensure that this application is installed before you install Cloud Call Center for ITSM.

**Required ServiceNow Store applications**

Amazon Connect Integration with Cloud Call Center (sn_cti_amzn_cct)

Integrates the ServiceNow instance with the Amazon Connect server.
Role required: admin

About this task
The following items are installed with Cloud Call Center for ITSM application (sn_cti_itsm_cnt):

- Contact flows
- Operation handlers

For more information, see Components installed with Cloud Call Center for ITSM.

Procedure
1. Navigate to System Applications > All Available Applications > All.

2. Find the Cloud Call Center for ITSM application (sn_cti_core) using the filter criteria and search bar.

   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.

   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Cloud Call Center for ITSM application (sn_cti_itsm_cnt).

4. Optional: If demo data is available and you want to install it, click Load demo data.

   (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   **Important:** If you don’t load the demo data during installation, it’s unavailable to load later.

5. Click Install.
Integrating Cloud Call Center with CSM

Access the CSM-specific contact flows and operation handlers when you integrate the Cloud Call Center application with the Customer Service Management application.

The Cloud Call Center for CSM application provides seamless interactive voice response (IVR) and calling experiences for your customers and agents by integrating a cloud contact center provider with the robust capabilities of the Customer Service Management application.

Overview
The Cloud Call Center for CSM application provides the following Customer Service capabilities for the integration with a cloud call center provider such as the Amazon Connect service:

• A bot building framework to automate interactions with consumers and customer contacts.
• An inbound contact flow to define the customer experience in an IVR.
• An outbound contact flow to connect with consumers and customer contacts from the phone number field displayed in any of the ServiceNow application UIs.
• Operation handlers to configure automated interactions for customer service cases.
• A phone PIN setup option for consumers and customer contacts.
• Amazon Connect phone queues for the Workforce Optimization for Customer Service application.

To get started with the Cloud Call Center for CSM application, see Install Cloud Call Center for CSM.

Key features

Customer experience
Engage via voice-based interactions using a natural language process to create a case, update and check case status, and speak with an agent.

Agent experience
• Preview caller information displayed in Agent Workspace before accepting an inbound call.

• Indicate your presence in the Agent Workspace Inbox with voice as a service channel when the Agent Workspace Inbox is integrated with the Agent softphone.

• Make outbound calls to connect with a customer and automatically capture interaction details to simplify data entry.

Manager experience

• Review call transcripts, sentiments, and recordings to explore coaching opportunities for agents.

• Use call metrics, such as the agent call time, to report on agents.

• Monitor real-time phone metrics captured in a unified dashboard by using the Workforce Optimization for Customer Service application.

Note: This feature is available when the Workforce Optimization for Customer Service application is enabled for the Customer Service Management application.

Cloud Call Center for CSM user roles

The users with the roles listed in the following table can use the Cloud Call Center for CSM application.

<table>
<thead>
<tr>
<th>Roles</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent_workspace_user</td>
<td>Initiate or accept voice calls to understand customer issues and resolve issues.</td>
</tr>
<tr>
<td>sn_customerservice_manager</td>
<td>View details of voice calls using the interaction record of the Phone type.</td>
</tr>
<tr>
<td>sn_customerservice.consumer,</td>
<td>Initiate or accept voice calls to create and track one’s own customer service cases.</td>
</tr>
<tr>
<td>sn_customerservice.customer</td>
<td></td>
</tr>
</tbody>
</table>
Example workflow

The following example workflow shows the use of the Cloud Call Center for CSM application in resolving a customer issue:

1. A customer is in an IVR call using the Cloud Call Center for CSM application.
2. The Cloud Call Center for CSM application identifies the customer and starts an interaction.
3. A welcome message is read out to the customer including announcements, if any.
4. Based on customer identification, the Cloud Call Center for CSM application addresses the call.
   - If the caller is identified as an existing customer who has a customer contact or consumer record with the phone number details available in the Customer Service Management application, a personal greeting is read to the caller and the automated interactions are made available.
   - If the caller is not identified, the call is routed to a live agent.
5. The Cloud Call Center for CSM application identifies the customer intent using automated interactions, and then based on the interaction responses, either creates or updates a case.

⚠️ Note: This step in the flow applies only when the caller is an existing customer.

Workforce Optimization for Customer Service

Integrate the Cloud Call Center application with the Workforce Optimization for Customer Service application to visualize call metrics from the Amazon Connect service. The Cloud Call Center application uses the Advanced Work Assignment feature to display the call metrics and active calls along with all other Channel metrics in the Manager Workspace. For more information, see Cloud Call Center in Workforce Optimization for Customer Service.
Install Cloud Call Center for CSM

You can install the Cloud Call Center for CSM application (sn_cti_csm_cnt) if you have the admin role. The application installs related ServiceNow® Store applications if they are not already installed.

Before you begin

- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.
- Your organization must have purchased CSM Pro subscription, which includes the Cloud Call Center SKU.
- Cloud Call Center for CSM requires the following ServiceNow Store applications. Ensure that this application is installed before you install Cloud Call Center for CSM.

Required ServiceNow Store applications
Amazon Connect Integration with Cloud Call Center
(sn_cti_amzn_cct)

Integrates the ServiceNow instance with the Amazon
Connect server.

Role required: admin

About this task
The following items are installed with Cloud Call Center for CSM:
• Contact flows
• Operation handlers

For more information, see Components installed with Cloud Call Center for CSM.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the Cloud Call Center for CSM application (sn_cti_csm_cnt) using the filter
criteria and search bar.
   You can search for the application by its name or ID. If you cannot find the
   application, you may have to request it from the ServiceNow Store.
   Visit the ServiceNow Store website to view all the available apps and for
   information about submitting requests to the store. For cumulative release
   notes information for all released apps, see the ServiceNow Store version
   history release notes.
3. In the Application installation dialog box, review the application
dependencies.
   Dependent plugins and applications are listed if they will be installed,
   are currently installed, or need to be installed. If there are any plugins or
   applications that need to be installed, you must install them before you can
   install Cloud Call Center for CSM.
4. Optional: If demo data is available and you want to install it, click Load demo
data.
   (Optional) Demo data comprises sample records that describe application
   features for common use cases. Load demo data when you first install the
   application on a development or test instance.
   **Important:** If you don't load the demo data during installation, it's
   unavailable to load later.
5. Click Install.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Configuring the phone PIN settings for Cloud Call Center for CSM

Use a PIN-based authentication mechanism for enabling a customer contact or consumer to connect with the Cloud Call Center for CSM application.

An authentication mechanism for inbound dialing enables protecting the details of customer contacts and consumers from unauthorized users. When using the Cloud Call Center for CSM application, you as an administrator can configure the PIN-based authentication mechanism available within the Cloud Call Center for CSM application or set up a custom authentication mechanism.

The PIN-based authentication mechanism available within the Cloud Call Center for CSM application enables customer contacts and consumers to use a custom phone PIN for accessing details related to their customer service cases during inbound dialing.

By default, the My Phone PIN link in the Additional Configuration section of the setup guide for configuring the Amazon Connect components enables the PIN-based authentication mechanism. For more information about the setup guide, see Integrate Cloud Call Center with Amazon Connect.

Note: The My Phone PIN link for customer contacts and consumers is available only with the sample CSM-specific contact flows.

To enable a PIN-based authentication mechanism, the My Phone PIN link in the setup guide uses the predefined Setup PIN record producer that is configured by default for consumers and customer contacts. As an administrator, you can edit the Setup PIN record producer to add any additional ServiceNow roles, include the record producer in a service catalog, and display the service catalog as a module on a customer-facing portal. Customers can then use the module to configure and reset their phone PIN. For more information, see Record Producer and Set up a service catalog.

Cloud Call Center reference

Reference topics provide additional information about components installed with Cloud Call Center.

Components installed with Cloud Call Center Core

Several types of components are installed with activation of the Cloud Call Center Core application (sn_cti_core), including user roles, plugins, and operation handlers.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.
Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTI service account [sn_cti_core.service]</td>
<td>Allows communication between the third-party phone system instance and the ServiceNow instance.</td>
<td>sn_openframe_api_user</td>
</tr>
<tr>
<td>CTI admin [sn_cti_core.admin]</td>
<td>Creates the framework for integration with a third-party phone system.</td>
<td>None</td>
</tr>
<tr>
<td>CTI user manager [sn_cti_core.user_manager]</td>
<td>Manages the CTI-enabled user PIN.</td>
<td>None</td>
</tr>
</tbody>
</table>

Plugins installed

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interaction Management (com.glide.interaction)</td>
<td>Enables interaction logging, routing, and queueing</td>
</tr>
<tr>
<td>Openframe (com.sn_openframe)</td>
<td>Provides an interface to integrate a communication frame to place and receive calls.</td>
</tr>
</tbody>
</table>

Operation handlers installed

Operation handlers are defined in the ServiceNow instance to run a script based on the intent of the caller and provide response to the caller.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$transcript</td>
<td>Saves the call transcript</td>
</tr>
<tr>
<td>$query2ssml</td>
<td>Securely queries tables and returns the response as ssml</td>
</tr>
<tr>
<td>workItemEvent</td>
<td>If the Advanced Work Assignment plugin (com.glide.awa) is installed, creates a work item on Advanced Work Assignment table before routing the call to agent, and associates an interaction with the work item.</td>
</tr>
</tbody>
</table>
### Components installed with Amazon Connect Integration with Cloud Call Center

Several types of components are installed with installation of the Amazon Connect Integration with Cloud Call Center application (sn_cti_amzn_cct), including user roles, plugins, and operation handlers.

⚠️ **Note**: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

#### Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amazon Connect administrator</td>
<td>Configures the integration with the Amazon Connect instance.</td>
<td>sn_cti_core.admin</td>
</tr>
<tr>
<td>[sn_cti_amzn_cct.admin]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Plugins installed

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloud Call Center Core (sn_cti_core)</td>
<td>Provides the framework that supports the integration with your third-party phone system.</td>
</tr>
<tr>
<td>Openframe (com.sn_openframe)</td>
<td>Provides an interface to integrate a communication frame to place and receive calls.</td>
</tr>
</tbody>
</table>
Operation handlers installed

Operation handlers are defined in the ServiceNow instance to run a script based on the intent of the caller and provide response to the caller.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$connect.kinesis.event</td>
<td>Receives and processes the call trace record that is created by Amazon Connect in the Amazon Kinesis stream.</td>
</tr>
<tr>
<td>$connect.s3.event</td>
<td>Receives and processes JSON events from the S3 buckets where the call recording, transcript and analysis data is created and stored. Associates this information with an interaction and Openframe call log records.</td>
</tr>
</tbody>
</table>

Components installed with Cloud Call Center for ITSM

Several contact flows and operation handlers are installed with activation of the Cloud Call Center for ITSM application (sn_cti_itsm_cnt).

Contact flows installed

<table>
<thead>
<tr>
<th>Contact flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNow ITSM Inbound Demo Flow</td>
<td>Contains the call tree for inbound calls. When a caller contacts the call center, using the voice or dual-tone multi frequency (DTMF) inputs from caller, the contact flow is invoked in the Amazon Connect instance based on the caller context. This contact flow contains nodes that act as integration points between Amazon services and the ServiceNow instance. Based on the nodes defined in the contact flow, the corresponding operation handlers are triggered in the ServiceNow instance. The caller then gets the response that is defined in the operation handler.</td>
</tr>
<tr>
<td>ServiceNow ITSM Outbound Demo Flow</td>
<td>Contains the call tree for outbound calls. It specifies the whisper message that a caller hears before getting connecting to an agent.</td>
</tr>
</tbody>
</table>
Operation handlers installed

<table>
<thead>
<tr>
<th>Operation handler</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_FallbackIntent</td>
<td>Captures the user input</td>
</tr>
<tr>
<td>manageIncident</td>
<td>Manages an existing incident</td>
</tr>
<tr>
<td>unlockAccount</td>
<td>Unlocks a user account</td>
</tr>
<tr>
<td>announcements</td>
<td>Makes announcement for a caller</td>
</tr>
<tr>
<td>manageIncident.DialogCodeHook</td>
<td>Initializes the Amazon Connect instance and validates incoming calls</td>
</tr>
<tr>
<td>createIncident</td>
<td>Creates an incident</td>
</tr>
</tbody>
</table>

Components installed with Cloud Call Center for CSM
Several contact flows and operation handlers are installed with Cloud Call Center for CSM application (sn_citi_csm_cnt).

Contact flows installed

<table>
<thead>
<tr>
<th>Contact flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNow CSM Inbound Demo Flow</td>
<td>Contains the call tree for inbound calls. When a caller contacts the call center, using the voice or dual-tone multi frequency (DTMF) inputs from caller, the contact flow is invoked in the Amazon Connect instance based on the caller context. This contact flow contains nodes that act as integration points between Amazon services and the ServiceNow instance. Based on the nodes defined in the contact flow, the corresponding operation handlers are triggered in the ServiceNow instance. The caller then gets the response that is defined in the operation handler.</td>
</tr>
<tr>
<td>ServiceNow CSM Outbound Demo Flow</td>
<td>Contains the call tree for outbound calls. It specifies the whisper message that a caller hears before getting connecting to an agent.</td>
</tr>
</tbody>
</table>
Operation handlers installed

<table>
<thead>
<tr>
<th>Operation handler</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>speakToCSMAgent</td>
<td>Enables customer contacts and consumers to speak with a live agent.</td>
</tr>
<tr>
<td>createCSMCase</td>
<td>Enables customer contacts and consumers to create a customer service case.</td>
</tr>
<tr>
<td>manageCSMCase</td>
<td>Enables customer contacts and consumers to update an existing case.</td>
</tr>
<tr>
<td>csmAnnouncements</td>
<td>Makes announcements for a caller.</td>
</tr>
<tr>
<td>createCSMInteraction</td>
<td>Creates an interaction record in the ServiceNow instance for the incoming calls.</td>
</tr>
<tr>
<td>updateCSMInteraction</td>
<td>Updates an existing interaction record in the ServiceNow instance for the incoming calls.</td>
</tr>
</tbody>
</table>

Common Service Data Model

The Common Service Data Model (CSDM) is a standard and consistent set of terms and definitions that span and can be used with all ServiceNow® products on the Now Platform®. These terms and definitions form the basis for the CSDM framework.

About the CSDM

The CSDM terms and definitions enable service reporting, and provide prescriptive guidelines for service modeling within the ServiceNow® Configuration Management Database (CMDB).

The CSDM data model is a CMDB framework that supports multiple configuration strategies. The data model includes guidelines for using base system tables and relationships. Many ServiceNow products depend on data within this data model.

Benefits of using the CSDM

You can use the CSDM as a blueprint to map your IT services to the ServiceNow platform. The CSDM is a CMDB-based framework that identifies where to place data for the products that you're using. Also, the CSDM is the standard for all ServiceNow products that use the CMDB. Following the CSDM framework ensures that the data your ServiceNow application requires maps correctly to the appropriate CMDB tables.
If you don't follow this standard, you may not receive the full benefit of the ServiceNow products on the Now Platform®.

**CSDM and reports**

You can use the CMDB query builder to create reports showing CMDB configuration items (CIs) and their relationships.

Most of the CSDM follows the CMDB data model, which includes the following components:

- Business capability
- Business application
- Information object
- Application service
- Service
- Service offering

**Additional information about CSDM**

You can find additional information about the CSDM on the Community Forum.

**Common Service Data Model conceptual model**

The Common Service Data Model (CSDM) is a framework or blueprint that you can follow when you set up your ServiceNow® application. Following this model ensures that the data for that application maps correctly to the appropriate tables.

The following figure illustrates the CSDM conceptual model. The figure also defines each of the domains in the CSDM framework, and shows how each domain works together to manage your ServiceNow applications and services.
Domains in the CSDM conceptual model

The CSDM conceptual model contains these domains: Foundation domain, Design domain, Manage Technical Services domain, Sell/Consume domain, and the Manage Portfolio domain.

Each domain in the CSDM conceptual model is associated with one or more products, services, or service types, which you can extend as needed.

Services and service types

A service enables you to achieve the outcomes that you want with minimal risks and without incurring costs. This definition is consistent with the base definition of "service" in ITIL v3 and IT4IT. Services typically have three components: the interaction, the offering, and the service system.

Base system service types

ServiceNow includes these base system service types which you can extend to align with the service types in your organization.

- Technical services

Technical services are associated with service owners. Technical services are typically lower-level leaf nodes of one or more business or application services in a structured hierarchy.
• Application services

  Application services are logical representations of a deployed application stack.

  **Note:** For more information about leaf nodes and structured hierarchies, see **Design domain**.

### Set up the CSDM environment

Set up the Common Service Data Model (CSDM) framework to use standard fields and values to track the life cycle of a CI.

**Procedure**

1. Before you can use the CSDM framework, you must first migrate your life cycle data. This step includes mapping and migrating the legacy life cycle values to the CSDM standard values. For more information, see **Migrate to CSDM life cycle standards**.

2. **Activate the CSDM Activation plugin** `com.snc.cmdb.csdm.activation`. For more information, see **Activate a plugin**.

**Results**

You have successfully set up your CSDM environment. You can use standard values to track assets effectively through their life cycle transitions with the **CMDB Data Manager**.

### Common Service Data Model life cycle states

The CSDM framework provides standard fields and values that you can use to track the life cycle of an asset or a CI.

The life cycle state is a combination of an asset or CI's stage and status in the entire life cycle. You can manage and track the life cycle state for a product model, a specific version, or a product configuration.

A hardware (physical) or software (logical) asset can go through several phases from concept to design until it reaches end of life. A hardware asset includes physical items that are stocked like servers, monitors, keyboards. A software asset includes items like applications, services, licenses.

The following diagrams show the life-cycle phases of physical and logical assets.
If you activate the CSDM framework, you can start using the two new fields, **Life Cycle Stage** and **Life Cycle Stage Status** to track an asset’s life cycle. The following legacy statuses are automatically mapped to these two new fields:

- Product Model Status
- Asset State
• Asset Substate
• Contract Status
• CI Install Status
• CI Operational Status
• CI Hardware Status
• CI Hardware Substatus

To activate the CSDM framework and use the new fields, follow the procedure described in Set up the CSDM environment.

**Synchronize group assignment attributes**

Synchronize group assignment attributes across a large number of CIs or entire CI classes.

If you want a specific user group to manage a collection of CIs or CI classes, you can set group assignment attributes through the CI Class Manager or the technical service offering. This will automatically synchronize the group assignment attribute data across all CIs belonging to a specific class or groups of CIs.

- **Synchronize data using CI Class Manager**: Set the Managed by group attribute for a specific class in the CI Class Manager. This setting is automatically applied to all CIs of this class.

  **Note**: The Managed by group setting is applied only to the CIs that are not associated with a technical service offering.

- **Synchronize data using a technical service offering**: Directly set the Support group, Change group, or Managed by group attributes in a technical service offering. These settings are automatically applied to those CIs that are associated with the Technical service offering.

**Related information**

- CI Class Manager

**Synchronize data using CI Class Manager**

Synchronize group assignment attributes on entire CI classes and individual CIs using the CI Class Manager.

**Before you begin**

- Role: itil and itil_admin
Procedure

1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to expand the CI Classes list, select a class to display details for and click Basic Info.
3. Change the value in the Managed by Group attribute and click Save.
4. To verify this change, click CI List.
   You can see that the change has been applied to the Managed by Group attribute of all CIs of this class unless they are associated with a Technical Service Offering.

   Note: This change is applied only to the CIs in the class and not to the sub classes under a CI.

Example:
As an itil_admin, you can define a user group that can manage all CIs belonging to a specific class by following these steps:

• 1. Navigate to the CI Class Manager and select the Linux Server class from the tree
2. Click Basic Info and in the Managed By Group attribute, select sys_user_group and click Save.
3. To verify that this attribute has been updated, click CI List and navigate to a specific Linux Server class. You will see that the Managed By Group attribute has been updated to sys_user_group.

Synchronize data using a technical service offering

Synchronize group assignment attributes on entire CI classes and individual CIs using a Technical Service Offering

Before you begin
Role required: itil and itil_admin

Procedure

1. Navigate to Configuration > CMDB Groups and create a new CMDB group. See CMDB groups for details.
2. Navigate to Configuration > Dynamic CI Groups.
3. Create a new Dynamic CI group and associate it with the CMDB group you have created.
See Manage Technical Services domain for more information on Dynamic CI groups.

4. Navigate to CSDM > Technical Service Offering and create a new technical service offering. See Manage Technical Services domain for more information on Technical Service Offerings.

5. Navigate to the CI Relationships table and click New and enter the following:
   - Parent: Select the technical service offering you have created.
   - Child: Select the Dynamic CI group you have created.

6. Click Submit. You have now created a relationship between the technical service offering and the Dynamic CI group.

7. Navigate back CSDM > Technical Service Offering and open the technical service offering you have created.

8. Enter values in the following fields:
• Support group
• Change group
• Managed by group

Note the Dynamic CI group associated with the technical service offering.

9. Click Save. You will see a message indicating that data synchronization has been enabled for these fields.

10. The values you have specified are applied to the related Dynamic CI group and all the associated CIs.

ℹ️ Note:

• If a new CI is added to the class, the data will be synchronized only after the scheduled CSDM Data Sync job is completed. If you need to synchronize the data immediately, navigate to Scheduled Jobs > CSDM Data Sync and click Execute.

• The Managed by Group field may be populated both in the CI Class Manager and the Technical service offering. In this case, the value specified in Managed by Group field in the Technical service offering takes precedence.
Common Service Data Model (CSDM) navigation pane

The CSDM navigation pane is the starting point for accessing the CSDM domains. The domains include the Foundation domain, the Design domain, the Manage Portfolio domain, the Manage Technical Services domain, and the Sell/Consume domain. Each domain is associated with one or more products or services.

The CSDM includes a navigation pane used to access the CSDM domains and their components. For more information about the CSDM domains, see Common Service Data Model domains.
Note: If you are using Service Portfolio Management (SPM), the CSDM navigation pane includes a Technology Request Catalog module in the Manage Technical Services domain and a Business Request Catalog module in the Sell/Consume domain. For more information about how SPM integrates with the CSDM framework, see Service Owner Workspace integrations.

CSDM and application services
The Manage Technical Services domain contains an Application Service component. You use this component to create an application service, and choose the population method you want to use. You can also set a relationship between the application services and the components of other CSDM domains. For more information about automatically creating and populating application services, see Service Mapping.

CSDM and the Application Service Dashboard
The CSDM navigation pane also includes an Application Service Dashboard you can use to monitor and manage your application services. For more information about using the Application Service Dashboard, see Monitor the health of application services in the Application Service Dashboard.

The CMDB and CSDM Data Foundations Dashboard
The CMDB and CSDM Data Foundations Dashboards store app contains dashboards which provide insights into the key foundational indicators of your Configuration Management Database (CMDB) and Common Service Data Model (CSDM). This app provides recommendations to ensure that the CMDB and CSDM are properly configured for optimal usage and to mitigate any potential risks. For an introduction, watch the ServiceNow® Data Foundations Dashboards for CSDM and CMDB video. For more information about this store app, see Monitor system foundations in the CSDM and the CMDB Data Foundations Dashboards (Version 1.0.2).

Common Service Data Model domains
The Common Service Data Model (CSDM) contains the Foundation, Design, Manage Technical Services, Sell/Consume, and Manage Portfolio domains. Each domain is associated with one or more products or services.
**Foundation domain**

The Foundation domain is one of the domains in the Common Service Data Model (CSDM). The Foundation domain represents tables that contain base data referenced from or to objects in the other CSDM domains.

The tables in the Foundation Domain aren't used in Configuration Management Database (CMDB) relationships. Instead, these tables contain critical referential data. For example, Foundation data is required before you use ServiceNow® products or add data to the CMDB.

The typical users of this domain are process owners, data stewards, and product owners, and contract managers.

**CMDB group**

A CMDB group is a collection of CIs based on the results of saved Query Builder queries, encoded queries, or manual entries. The CMDB group isn't a CI.

The CMDB group provides a grouping of CIs which you can then use throughout the Now Platform.

For the CSDM, the Dynamic CI Group references a CMDB group to provide a list of CIs based on a common criteria.

CMDB groups are stored in the table `cmdb_group`.

The CMDB group can potentially replace the spreadsheets that you may be using to group your CIs.
**Contracts**

A contract is a binding agreement between two parties. In the Now Platform®, contracts contain detailed information, such as the contract number, start and end dates, active status, terms and conditions statements, documents, renewal information, and financial terms.

Contracts are stored in the table [ast_contract].

A contract isn't a CI. Contracts use contract model types from the Product Models.

Service contracts may support hardware CIs as part of an SLA and used by vendor management. Additionally, Service contracts may be used by Customer Service Management.

**Common data**

Common data are shared data that is used throughout the Now Platform. Common data include the organizational structure (Company, Business Unit, Department), locations, groups, and users. Many ServiceNow products depend on common data to provide business value. Planning your common data is core to the effective implementation of ServiceNow products and features.

Consider your answers to these questions:

- Do you have a trusted source for this data?
- Do you have multiple data sources?
- How often does this data change?
- Do you have the depth of data that the CIs require?
- Who maintains this data?

These are only some of the issues you need to consider. Carefully planning your common data helps ensure that you have the data you need.

Common data are stored in the following tables:

- Company: [core_company]
- Business unit: [business_unit]
- Department: [cmn_department]
- Location: [cmn_location]
- Groups: [sys_user_group]
- Users: [sys_user]

Common data are not CIs.
**Design domain**

The Design domain is one of the domains in the Common Service Data Model (CSDM). The Design domain represents the tables currently used by ServiceNow® Application Portfolio Management (APM).

While the Design domain represents the tables currently used by APM, these tables are not operational. Because these tables are not operational, you can’t select them for Incident Management and Change Management.

The Design domain includes the following tables:

- Business capability table [cmdb_ci_business_capability]
- Business application table [cmdb_ci_business_app]
- Information object table [cmdb_ci_information_object]

While you’re not required to use APM to use these tables, you can use APM to rationalize and manage your business applications.

The typical users are enterprise architects and application owners.

**Information object**

An Information object is part of the information portfolio and the business application references the information object.

The information object is a CI that displays information in an organized form. An information object describes the type of data (or the information) that the application receives from the database.

Information objects are mapped to the information object table [cmdb_ci_information_object] in the CMDB.
You can use the information object table to identify the types of data a business application uses including highly sensitive data such as:

- Personally Identifiable Information (PII)
- Payment Card Industry Data Security Standard (PCI DSS) data
- Health Insurance Portability and Accountability Act (HIPAA) data

**Business capability**

A business capability is a high-level capability that your organization must do to complete a business model or fulfill a mission. A business capability is typically associated with performing specific tasks needed to achieve one or more business outcomes. Business capabilities are often listed as verbs (for example, manage financials or provide IT support services).

Business capabilities are recorded in the table [cmdb_ci_business_capability].

**Create relationships between CIs**

Establish a relationship between the following configuration items (CIs):

- The business capability and the business application (for visualization and reporting purposes).
- The business application and the application services.

These relationships enable you to:

- Determine the risks involved in using these business capabilities.
- Assess services based on their relationships to business capabilities and business applications.

An accurate service model that includes these relationships can serve as the foundation for strategically aligned architectural decisions.

**Business capabilities represented in a hierarchy**

You can represent business capabilities in a hierarchy that includes a parent business capability and one or more lower-level (child) capabilities.

These lower-level capabilities are called “leaf nodes.” Leaf nodes are represented by numeric values, such as 1.0 for the parent and 2.0 through 6.0 for the leaf nodes.

ℹ️ **Note:** If a business capability hierarchy requires more than six levels, consider using multiple business capabilities.
Use the Business Capability form to create, modify, and extend business capabilities.

**Business capability form**

If you add, update, or delete a capability at a leaf node, update the levels of all the capabilities for the leaf nodes in that hierarchy, as applicable.

To update the capabilities, click the **Update Capability Level** and **HierarchyID** related link in the Business Capability form. Updating the capabilities ensures that the capability map reflects the change. When you're updating business capabilities, note the following guidelines:

- When adding a capability, the hierarchy level is automatically assigned based on the parent capability level.
- If the parent capability is updated in the hierarchy, the levels of all its leaf node capabilities are recalculated.
- The total number of leaf node levels can't exceed six in the hierarchy.
- Only leaf node-level capabilities or capabilities without leaf node levels can be deleted.
- Don’t create circular relationships. For instance, when creating a parent capability, a leaf node capability can’t be its parent.

**Business application**

A business application represents the software and infrastructure (for example, the titles catalog) used to provide a business function.

Business applications increase productivity and perform other business functions, such as accounts payables, accounts receivables, and general ledger.

A business application can:

- Span multiple environments (for example, Development, Test, or Production).
- Span geographies (for example, Americas, the Asia Pacific Japan (APJ), or regions (for example, Europe, the Middle East, and Africa [EMEA] )

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Use the Business Application form to add the applications that your organization uses.

You can enter the details of a business application by using the Business Application form. Alternatively, you can import the list of applications from a spreadsheet or a third-party tool. To import data, define a data source and a transform map, and run or schedule an import. Although not required, you should use a business application.

Create relationships between the business application and other CIs

A business application is a manually managed CMDB CI class. Because the business application is a manually managed CI class, you must manually create the required relationships. For example, you must create relationships between the business application and other CIs, such as the instances of the application services in use.

Note: If needed, you can integrate or connect two or more applications to establish their relationship.

Creating relationships also enables you to relate business applications to infrastructure CIs, such as databases and web servers.

Using APM, you can add any business application for which you must track costs, usage, business value, functionality, and risks.

Manage Technical Services domain

The Manage Technical Services domain is one of the domains in the Common Service Data Model (CSDM). This domain represents the tables currently used by
ServiceNow® IT Operations Management (ITOM), such as Service Mapping and Discovery.

While you aren’t required to use Service Mapping and Discovery to use the tables, these two ServiceNow products let you manage configuration items (CIs) and their relationships. The CIs in this domain are the discovered items, such as installed applications, servers, and network components.

The Manage Technical Services domain also represents the portfolio of technical services in use. These services are operational, which means that you can select them for Incident Management and Change Management.

The typical users are application service owners (for the application and platform) and technology service owners (for the infrastructure and delivery).

**Note:** Beginning with the New York release, technology consumers can request technical services through the Request Catalog.

The tables in the Manage Technical Services domain represent the technology that your business sells or consumes in the provider view. The domain includes the following tables:

- Technical service table [cmdb_ci_service_technical]
  (Event Management uses the [cmdb_ci_query_based_service] table.)
**Note:** Starting with the Paris release, the [cmdb_ci_query_based_service] table has been relabeled to Dynamic CI group.

- Request catalog
- Technical service offering table [service_offering]
- Dynamic CI group table [cmdb_ci_query_based_service]
- Application Service table [cmdb_ci_service_discovered]

Starting with the London release, this table is included in the base system.

**Technical services**

Technical services are associated with service owners and are typically layered beneath one or more business or application services.

When you use technical services, you can view and manage the technology that you provide to the business. If you’re using Event Management, you can monitor service performance. You can also use Event Management to identify health issues for related infrastructure CIs and application services.

Previously, technical services were mapped to the [cmdb_ci_service] table and were classified as “technical services.” Starting with the Paris release, technical services are now mapped to the [cmdb_ci_service_technical] table.

The table for Event Management-enabled technical services has also changed. Previously, these technical services were mapped to the [cmdb_ci_query_based_service] table. The new name for the [cmdb_ci_query_based_service] table is Dynamic CI Group.

A technical service may have one or more technical service offerings.

**Technical service offerings**

Technical service offerings (SO) divide technical services into these options:

- Location or geography
- Environment
- Pricing
- Availability
- Capability
- Support group (for incident)
- Technical approval group (for change)
- Packaging options (commitments)
You can use the technical service offering to set different levels of performance and select features for a given technical service.

Technical service offerings typically have the following components:

- One or more service commitments:
  
  A service commitment defines the service delivery obligations agreed to between the consumer and the provider.

  Service commitments uniquely define the level of service in terms of availability, criticality, scope, pricing, and other factors. For example, an organization may offer two levels of support for an application service, as described below:

  - Support for a production-related offering: Provides a high level of availability and criticality for production instances. Includes a 5-minute response time guarantee of 24-hours, seven days per-week.

  - Support for a non-production-related offering: Provides limited availability and criticality for non-production instances. Includes a 60-minute response time guarantee between 8:00 a.m. and 5:00 p.m., Monday through Friday.

- A service offering subscription that records which users have access to an offering.

The technical service offerings are mapped to the [service_offering] table, are classified as “technical service,” and are derived from the service. The technical service offering is based on how the parent serves a specific technical need. Every operational technical service should have at least one technical service offering.

Beginning with the New York release, technology consumers can request technical service offerings through the Request Catalog.

**Dynamic CI group**

A Dynamic CI group is a CI that contains a dynamic grouping of CIs, based on the results of CMDB Groups queries. For example, you can create a Dynamic CI group based on the location of all web servers in Detroit or all Oracle databases in Boston.

ℹ️ **Note:** Dynamic CI groups contain CIs. Dynamic CI groups can’t contain other groups.

A Dynamic CI group is mapped to the [cmdb_ci_query_based_service] table and is classified as either an “Application Service” or “Technical Service,” as applicable.

You might want to use Dynamic CI groups in the following situations:
• As a query-based application service
  You don’t have Service Mapping enabled yet, but you have 12 servers and 3 database instances in MyAppServiceProd. You can delete your spreadsheets and use a Dynamic CI group as an application service.

• As a managed group of Infrastructure CIs
  The web servers in Detroit are managed by the DetroitRockCity Technical Service Offering. You don’t need to manually create relationships from Technical Service Offerings to Infrastructure CIs. You can use a Dynamic CI group. A single relationship from your Technical Service Offering CI (DetroitRockCity) to your Dynamic CI Group (web servers in Detroit) gives you the visibility you need.

• As a way to manage patches for your CIs
  In Change Management, you can select the Dynamic CI group for the CIs you need to update and use a business rule to auto populate the Affected CI field.

See Create a Dynamic CI Group for instructions on how to create a dynamic group.

Application service

An application service is a logical representation of an application stack in use. Using application services, you can view maps and change history for services. If you’re using Event Management, you can monitor service performance and identify health issues for application services.

Application services can be internal, like an organization email system or customer-facing, like an organization website. For example, creating financial reports through a web-based application requires a computer, web server, application server, databases, middleware, and network infrastructure. These applications and hosts are configured to offer the service of financial reporting. In development environments, application services represent instances of a business application or system in different types of environments, such as development, test, or production.

Application services are the entry points for Service Mapping. Application services are mapped to the Configuration Management Database (CMDB) [cmdb_ci_service_auto] table for common reporting and they underpin a business or technical service.

Starting with the Paris release, you can use additional methods you to create application services. Each method maps to a different table as listed below:
Method used to create the application service | Mapped to table
--- | ---
Top Down Discovery | cmdb_ci_service_discovered
Dynamic CI Group | cmdb_ci_query_based_service
Tags | cmdb_ci_service_tags
Manual | cmdb_ci_service_discovered

To create the application service, use the Create an Application Service form.

For more information about application services and the methods you can use to create them, see Application services.

Application services are key relationship entities for IT Service Management (ITSM), IT Operations Management (ITOM), IT Business Management (ITBM), and Customer Service Management (CSM).

Application services include relationships between business applications, business services, technical services, applications, and infrastructure CIs. You can expose an application service by using the related business or technical service offering.

- **Application**

  An application is any program or module used to complete a specific function. An application defines behavior and is associated with a specific function. Applications are typically discoverable instances and provide a specific set of functions for one or more services.
ServiceNow limits applications to those applications on a single host. This limitation ensures that the applications are uniquely identified during discovery.

Also, there's a one-to-many (and not a one-to-one) relationship between the application and the application service. A single installed application, such as a database instance, may support multiple application services.

The application table [cmdb_ci_appl] isn't an inventory or portfolio of your applications. Inventory or application portfolio objects belong in the business application table (as documented in Design domain).

The application table and extended tables contain those uniquely discovered instances of code in use on the host.

Applications are considered infrastructure CIs.

- **Infrastructure CIs**

  Infrastructure CIs are managed physical and logical components.

  A CI may be a single module, such as a server, database, or a router. A CI may also be a complete system (for example, a web server, database, or infrastructure.)

  The underlying infrastructure components or CIs can be complicated. The complexity increases as data structures are layered on top of those physical CIs. For that reason, you should work with a business relationship manager or enterprise architect to define the various business capabilities and business applications.

### Sell/Consume domain

The Sell/Consume domain is one of the domains in the Common Service Data Model (CSDM). The Sell/Consume domain represents the tables currently used by ServiceNow® Service Portfolio Management (SPM) and Customer Service Management.

You're not required to use SPM or CSM to use the referenced tables. However, using these ServiceNow products enables you to manage workflows and report service-related data.
The Sell/Consume domain also represents the portfolio of business services that may sell or consume elements of the Manage Technical Services domain.

**Note:** Beginning with the New York release, business consumers can request business services through the Request Catalog.

The Sell/Consume domain includes the following tables:

- Business service offering table [service_offering]
- Service portfolio table [service_portfolio]
  
  The Service portfolio table is not a Configuration Management Database (CMDB) table.
- Business service table [cmdb_ci_service]

You can select the tables in the Sell/Consume domain to use with Incident Management and Change Management.

The typical users are the business relationship manager and the customer service manager.

**Business service offerings**

Business service offerings are the starting point for configuring SPM. Business service offerings consist of one or more service commitments. These service commitments define the level of service in terms of availability, scope, pricing, and other factors. For example, an organization may offer two levels of desktop support:
• A “standard” offering of upgrades and virus protection.

• An “executive” offering with the standard commitments plus a response time guarantee. For example, this offering could be a response time of 30 minutes between the hours of 8:00 a.m. and 5:00 p.m., Monday through Friday.

Business service offerings have the following characteristics:

• Business service offerings divide the service into capability, availability, pricing, and packaging options. You can use the service offering to set different levels of performance and features for a given service.

• Business service offering commitments define the agreed-upon service delivery obligations. Service offering subscriptions record which users have access to an offering.

• Business service offerings are the specific ServiceNow records that identify the specific business area and the entity where the service is delivered. Some business services and service offerings depend on the application service.

• Business service offerings are derived from the service and are refined depending on how the parent serves a specific business need.

Note: You should have at least one service offering for each operational business or technical service.

You can view your business service offerings from the Service Owner Workspace.

Service Offering view from the Service Owner Workspace
Business service offerings typically have different Service-Level Agreements (SLAs). Without a business service offering, your SLAs remain at a process level only. For example, the SLA stays at a P1 incident or a minor change, and doesn’t refer to the service offering affected.

You can represent business services and offerings in the service catalog (by catalog items) and make them available for consumers.

**Service portfolio**

At the highest level, a portfolio is a collection of services, products, projects, or applications. You can use it to group and manage items for a business. You can group items by:

- Objective
- Capability
- Organization (for example, enterprise resource planning [ERP] or financial management)
- Geography

A service portfolio is a hierarchical collection of business services. The service portfolio contains products and services. You can use these products and services to define strategic business objectives and manage the life cycle of those services.

**Business service**

A business service is associated with business users and is typically layered beneath one or more business capabilities.

Business consumers can use the Request Catalog to order business services, service offerings, and service commitment levels. The business services are mapped to the [cmdb_ci_service] table and are classified as “business services.”

A business service may contain one or more business service offerings.

**Manage Portfolio domain**

The Manage Portfolio domain is one of the domains in the Common Service Data Model (CSDM). This domain represents portions of the other CSDM domains: Foundation, Design, Manage Technical Services, and Sell/Consume.

Think of the Manage Portfolio domain as a layer on top of the CSDM conceptual model. This domain incorporates portions of the other CSDM domains.
The typical user for this domain is the service owner. The service owner may be responsible for services in more than one domain. For example, in the Sell/Consume domain, the service owner for Human Resources (HR) may be financially responsible for the business application that provides HR services.

Request Catalog

A Request Catalog is a list of business and technical products, services, service commitment options, and offerings that you can order. Catalogs enable you to order and manage your available products and services.

Catalogs (such as the Human Resources [HR] service catalog) help manage services that a user can access. Catalogs are the starting point for accessing available services, and contain catalog items.

Catalog Items

A catalog item is an item or a service that you can request from the catalog. A service can contain multiple catalog items (for example, the employee onboarding catalog). Catalog items are listed on the service portal and are
available to the users who need them (either through subscription or job responsibility). Each catalog item is linked to one service offering.

### Common Service Data Model-to-Configuration Management Database (CMDB) mapping

The objects in the Common Service Data Model (CSDM) must map to the tables in the physical model, configuration items (CIs), and classes in the ServiceNow® Configuration Management Database (CMDB).

The following figure shows how objects in the conceptual CSDM framework map to the physical model objects (tables and CI classes) in the CMDB.

#### Conceptual-to-physical object mapping

<table>
<thead>
<tr>
<th>Conceptual Model</th>
<th>Physical Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Capability</td>
<td>cmdb_ci_business_capability</td>
</tr>
<tr>
<td>Business Application</td>
<td>cmdb_ci_business_app</td>
</tr>
<tr>
<td>Information Object</td>
<td>cmdb_ci_information_object</td>
</tr>
<tr>
<td>Technical Service</td>
<td>cmdb_ci_service_technical</td>
</tr>
<tr>
<td>Technical Service Offering</td>
<td>service_offering</td>
</tr>
<tr>
<td>Dynamic CI Group</td>
<td>cmdb_ci_query_based_service</td>
</tr>
<tr>
<td>Application Service</td>
<td>cmdb_ci_service_auto</td>
</tr>
<tr>
<td>Application</td>
<td>cmdb_ci_appl</td>
</tr>
<tr>
<td>Infrastructure CIs</td>
<td>* - various</td>
</tr>
<tr>
<td>Service Portfolio</td>
<td>smc_service_portfolio (not a CMDB CI)</td>
</tr>
<tr>
<td>Business Service</td>
<td>cmdb_ci_service</td>
</tr>
<tr>
<td>Business Service Offering</td>
<td>service_offering</td>
</tr>
<tr>
<td>Request Catalog</td>
<td>sc_catalog (not a CMDB CI)</td>
</tr>
</tbody>
</table>

#### Configuration Item relationships in the Common Service Data Model

For configuration management to be the most effective, establish relationships between the objects and configuration items (CIs) in the conceptual Common Service Data Model (CSDM).
Not all objects in the CSDM conceptual model are Configuration Management Database (CMDB) tables, and not all the objects have relationships. You may need to create the required relationships.

The following figure illustrates the required relationships between the objects in the CSDM conceptual model:

Several ServiceNow® products, such as Application Portfolio Management (APM), depend on the preceding relationships. For example, business application “consumes” application service.

These relationships are critical. Without them, some features, such as the Technology Portfolio Management risk assessment, don’t work.

Also, the relationships commonly created as part of Service Mapping and Discovery are the standard for infrastructure CIs. If you map the elements manually, think about the way Discovery would treat the discovered CIs as you continue.
Common Service Data Model framework implementation stages

When you implement the Common Service Data Model (CSDM) framework, use a phased approach. Implement CSDM in stages that ServiceNow® calls foundation, crawl, walk, run, and fly. Each stage builds on the previous one.

Key CSDM implementation principles

The CSDM is designed for reporting and analytics, with the primary goal of supporting consistent analysis. The key CSDM implementation principles help you achieve that goal. As you implement CSDM on your ServiceNow platform, be sure to adhere to these principles. They help you decide how to proceed and help you to effectively manage your shared information.

Note: If you don’t follow these principles, you could cause implementation errors and get results you don’t want.

- Use simple and unique concepts to avoid duplicates and to clearly identify the correct concept to use.
- Use the prescriptive relationships when linking CSDM tables.
- Collaborate on the shared data model with the other product teams.
  Also, when you’re extending the CSDM and related functionality, be sure to follow the provided guidance. Following the guidance and collaborating with other product teams helps you achieve the best design.
- Use agreed-upon CSDM definitions whenever you’re using a table, reference, or attribute.
- Use the CSDM base tables that are available by default on zBoot.
- Use prescribed technologies when you’re integrating external data sources. Doing so ensures data integrity and integration consistency.
- Use data governance and process to make sure that data in the model is accurate. Otherwise, the data is of little value.
- Follow the provided guidance for using the ServiceNow product.

Implementation Stages

Each implementation stage focuses on specific areas and information types, and provides specific benefits. The stages are:

- Foundation
- Crawl
- Walk
Start with the foundation stage and then proceed to the next stage.

**Stage: Foundation**

This stage focuses on making sure you have the foundational information (that is, the required referential data) you need to get accurate reports. Many of the Configuration Management Database (CMDB) reports need this referential data along with information about the configuration items (CIs). You need accurate reports to make the right business decisions.

The foundation stage focuses on the following referential tables in the ServiceNow® base system:

- **Organizational structure** — The organization structure base system tables include tables that identify internal business structures, and external customers, manufacturers, and vendors. Organization structure tables include the following tables:
  - **Company** — The legal entities of either internal or external companies are populated in the Company table. A hierarchy is permitted using the Parent attribute. Consider the legal entities you need for your reports when the CMDB is populated. Entities can be either internal (your company) or external.

  **Internal**
Entries should focus on a hierarchy of legal entities rather than a hierarchy of business units within a legal entity.

**External**

External entries are identified by the True or False flags. The Customer flag identifies your external customers. The Manufacturer flag identifies those companies that the create products that you consume.

**Note:** Your internal company may also be a manufacturer.

The Vendor flag identifies those companies that provide products that you purchase.

**Note:** Your internal company may also be a vendor.

- **Business Unit** — The hierarchy of your business is populated in the Business Unit table with a reference to the parent company. Business units are parts of your organization that are responsible for specific operations, such as Finance, Human Resources (HR), or IT. A hierarchy within business unit is common. For large multinational companies, you may have business units that identify independent regional operations, and the specific operations within that region.

- **Department** — The Department table contains a finer level of detail about your business unit. The Department table gives you another way to categorize users, groups, assets, and CIs.

- **Location** — Identifies a geographic location. You can create a hierarchy of location data by using the Parent attribute. The hierarchy could include entries that match your reporting requirements. For example, you could populate the location table as follows

  **Location reporting workflow**

  ![Location Reporting Workflow Diagram](image)

  If you need to include more details in your reports, you could extend the Location table to include floors, rooms, and even datacenters.

- **Groups** — Identifies a set of users who share a common purpose. Groups may perform tasks such as approving change requests, resolving incidents, receiving email notifications, or performing work order tasks. Groups also use the referential data in the CMDB to identify how the CIs are managed (for example, the Managed by group) and supported (for example, the Support
group). Any business rules, assignment rules, system roles, or attributes that refer to the group automatically apply to all group members.

- **Users** — Identifies the people who have access to the ServiceNow® instance. You can then organize these people into groups associated with the Company, Business Unit, and Department tables.

- **CMDB Group** — Identifies a collection of CIs based on the results of saved Query Builder queries, encoded queries, or manual entries. CMDB groups are critical elements of Dynamic CI groups and the strategic management of CIs. Decide early how you want to report CI information and how you want to monitor your CIs. These decisions affect how you create the CMDB groups you need.

- **Product models** — Identifies the unique types of products your organization develops or consumes. You can group assets and CIs by these product models. Grouping assets and CIs by product models can help you plan projects, monitor costs, and rationalize your data. Discovery can populate hardware product models once they are operational, but other types of product models require planning from product owners.

- **Contracts** — Identifies a binding agreement between two parties. When you are populating services provided by vendors into the CMDB, consider the role that contracts play when evaluating service level agreements (SLAs).

**Benefit of stage: Foundation**

Using the base system tables when you begin implementing the CSDM provides the following benefits:

- These base system tables act as the foundation for many ServiceNow products and the Now Platform®.

- These tables helps your company align with reporting requirements earlier rather than later.

  Early alignment expedites the value you get from the CSDM. For example, you can reduce or eliminate any costly rework tasks needed to align with reporting requirements.
This stage focuses on goals you can achieve with IT Service Management (ITSM).

Start by focusing on applications and the application-related data in these areas and tables:

- **Business application table [cmdb_ci_business_app]**
  
  A business application is a base system Configuration Management Database (CMDB) table that stores your inventory, application portfolio, and their metadata.

  This table is not an operational configuration item (CI), which means you can’t use it in Incident Management and Change Management.

- **Application Service [cmdb_ci_service_auto] table**

  **Note:** The Paris release includes additional methods you can use to create application services. Each method maps to a different table. For details, see Manage Technical Services domain.

  A mapped application service is a base system CMDB table that identifies the related business application in use.

  You may have several application services representing each deployment based on the environment (development, QA, production) and location or geography (North America, Asia Pacific).
The application service is typically what the caller identifies when they report an issue with an application.

The application service ties all the elements of the CSDM together where applications are present.

- **Application table [cmdb_ci_appl]**
  
  An application is a base system CMDB table that represents the discoverable instance of an application: code related to a process in use on a host. This table isn't an inventory of your applications. Discovery creates and maintains this table.

  The application may be identified as the root cause of an incident. However, if you’re not using Event Management, the application may not be the initial cause.

  If you’re using Discovery, applications are automatically related to their host, which provides an impact hierarchy from server-to-host applications.

  Because of the high level of complexity involved, don’t try to manually populate the application table.

Future products and product enhancements depend on the data populated in each of these tables.

**Benefits of stage: crawl**

The crawl stage focuses on these base system CMDB tables:

- Business application table [cmdb_ci_business_app]
- Mapped Application Service table [cmdb_ci_service_discovered]
- Application table [cmdb_ci_appl] (discoverable)
- Server/host (discoverable)

The crawl stage has the following benefits:

- Provides the minimum CMDB requirements required to provide Incident Management and Change Management.

- Serves as a foundation for using Application Portfolio Management (APM).

  When you use APM, your business application data is in the right place in the CMDB, which makes setting up APM faster.

- Serves as a foundation for using Service Mapping.
When you use Service Mapping, your application service data is populated and ready to use for mapping the entry points.

• Lets you manage the life cycles and versions of the technologies that underlie the business applications you’re using.

When you use APM, Service Mapping and Software Asset Management (SAM) Professional, you can identify outdated or at-risk software.

Stage: Walk

Applications that you’re using, and the network infrastructure, need someone to manage and support them. This stage focuses on doing that management. The following ServiceNow tables identify the technology provider:

• Technical service [cmdb_ci_service] table, or [cmdb_query_based_services] table for Event Management.

This base system CMDB table identifies the provider of the technology that your business consumes.

• Technology service offering [service_offering] table

Technical service offerings may be further divided as follows:

◦ Location and geography
◦ Environment (production or non-production)
◦ Pricing
◦ Availability
◦ Support group (for Incident Management)
◦ Technical approval group (for Change Management)
◦ Packaging options (commitments)

The technical service offering comes from the service. It is based on how the parent serves a specific technical need. Every operational technical service you have needs at least one technical service offering.

⚠ Note: Not all technical service offerings have to be related to applications or infrastructure CIs. Managed Service Providers may provide technical service offerings.

• Dynamic CI group [cmdb_ci_query_based_service] table

A Dynamic CI group is a collection of CIs based on the results of saved Query Builder queries, encoded queries, or manual entries.
For more information about Dynamic CI groups and how you can use them, see Manage Technical Services domain.

Benefits of stage: walk

The walk stage focuses on these additional base system CMDB tables:

- Technical service (service table with a service classification of "technical service")
- Technical service offering (service offering with a service classification of "technical service")
- Dynamic CI group

The walk stage provides the following benefits:

- Facilitates managing the discovered infrastructure CIs. Manually managing the metadata on these CIs, such as support group and technical approval group, can be involved. By identifying the technical service offering that manages these CIs, you can:
  - Configure ServiceNow to populate and synchronize this metadata onto the related child objects.
  - Eliminate the manual effort of maintaining the metadata on thousands of CIs.
- Establishes a view of those CIs, applications, and technology owners.
The technology owners are the users your technical team members support. You can see the specific support assignments, which you can change as needed based on your support structure, operational-level agreements (OLAs), and commitments.

Also, this view enables you to formalize for your process for supporting applications and technology owners.

• Serves as a foundation for using Service Portfolio Management (SPM).

When you use SPM, your service data are in the right place, which lets you start using SPM more quickly.

• Enables you to order technology service offerings through the Request Catalog. You can also automate ordering these offerings as needed to enhance the request workflow and update or create related CIs.

Note: The Request Catalog is not a CMDB table.

• Serves as a foundation for Information Technology Operations Management (ITOM) products, such as Service Mapping and Discovery.

Stage: Run
When you use ITSM, you must understand the impact that a technology can have on your business. For example, your business may:

• Consume the technology provided
• Sell the technology (as is the case with Customer Service Management (CSM)]
• Sell and consume the technology

This stage focuses on the relationship between the technology and the business that sells or consumes (or does both) for that specific technology. ServiceNow has these components that identify that relationship:

• Business service portfolio table [service_portfolio]
  A business service portfolio is a hierarchical collection (not a CMDB table) of business services (products and services) that define a business objective.
• Business service table [cmdb_ci_service]
  The business service table is a base system CMDB table. This table identifies a business objective that uses (and depends on) the infrastructure that technology uses.
This dependency means that the business service must sell or consume that infrastructure.

- **Business service offering table [service_offering]**

Business service offerings are the starting point for configuring SPM. Business service offerings consist of one or more service commitments. These service commitments uniquely define the level of service in terms of availability, scope, pricing, and other factors.

The business service offering comes from the service. The business service offering is fine-tuned based on how the parent serves a specific technical need.
Every business service should have at least one business service offering.

**Benefits of stage: run**

The run stage focuses on these components:

- Business service portfolio table [service_portfolio]
- Business service table [cmdb_ci_service]; (service classified as a "business service")
- Business service offering table [service_offering]; (service offering classified as a "business service")
The run stage provides the following benefits:

- **Impact assessment for Incident Management and Change Management.**
  Within an incident or change, you can identify the impacted business, assuming relationships exist between the selected CI and the impacted businesses.

- **A foundation for using SPM in the Service Owner Workspace.**
  Service owners can monitor service portfolios and understand service-related information including:
  - Service trends
  - Improvement initiatives
  - Service performance
  - Outage monitoring

- **A foundation for ITSM capabilities.**
  This foundation populates the related “Subscribe by” table on a service offering to identify the business and subscribers affected.

Business service offerings can identify subscribers by:
- User
- Company
- Location
- Department
- Group

**Stage: Fly**
Reaching this stage means that you’ve accomplished all or most of the earlier stages. The fly stage completes the remaining elements of CSDM:

- **Request catalog**
  Beginning with the New York release, you can request services through the Request Catalog.

  **Note:** The Request Catalog is not a CMDB table.

- **Business capability table [cmdb_ci_business_capability]**
  A business capability is a high-level capability that your organization must complete for its business model. Or a capability your organization must complete it to fulfill its mission. You can use these capabilities to rationalize and prioritize the cost of business applications and business services.
• Information object table [cmdb_ci_information_object]

An information object is part of the information portfolio. The business application references the information object. You can use the information object table to identify the types of data that a business application uses, including highly sensitive data such as:

◦ Personally Identifiable Information (PII)
◦ Payment Card Industry Data Security Standard (PCI DSS) data
◦ Health Insurance Portability and Accountability Act (HIPAA) data

You may need to implement the information object table as part of an earlier stage and not wait until the fly stage. Your business requirements determine the right stage for implementing this table.
Benefits of stage: fly

The fly stage focuses on these components:

- Business service portfolio table [service_portfolio]
- Business service table [cmdb_ci_service]: (service classified as a "business service")
- Business service offering table [service_offering]: (service offering classified as a "business service")

The fly stage provides the following benefits:
• A foundation for using APM capabilities.
  You can use the APM capabilities to rationalize your business applications. Ask questions such as the following:
  ◦ Are you spending too much on your business capabilities?
  ◦ Are you spending too little on your business capabilities?
  ◦ Should you increase the amount you spend on emerging business capabilities?

• A foundation for using APM with SPM capabilities.
  You can use APM with SPM capabilities to rationalize your business services and related offerings. Ask questions such as the following:
  ◦ Are you spending too much or too little on services?
  ◦ Are you spending too little or too little on services?
  ◦ Are the right services compared to emerging capabilities?

• A foundation for using ITSM capabilities.
  Starting with the New York release, you can use the Request Catalog to relate a service offering to a catalog item. You can also enhance the request workflow to automatically populate the “Subscribe by” table.

  Note: The Request Catalog is not a CMDB table.

• If your environment has a combination of CIs from each of the CSDM domains, this stage provides away to manage business services.

• A way to identify the types of data that may be contained in or used by your business applications. The information object table helps you see what’s in your information portfolio.

Migrate to the Common Service Data Model framework

When you begin using the Common Service Data Model (CSDM) framework, you must complete several tasks to ensure that your application migrates successfully to the new framework. These tasks ensure that your data is in the required locations in the ServiceNow® Configuration Management Database (CMDB).

Before you begin
Role required: admin
About this task
To reduce the risk of making mistakes, migrate your applications carefully, and keep the following points in mind:

• Many of the CSDM-related tables for your ServiceNow products have only been available for a short time, and you may not be familiar with them. See the documentation for your ServiceNow product to learn about any of the tables that are unfamiliar to you.

• You may be using customized or non-conforming CMDB tables.
  You can keep using these tables. However, if you do, you may not get the full benefit of the ServiceNow products.

Manage the attributes you are using
Rationalize your custom attributes. Decide if you must keep all customizations.
Delete the attributes that you don’t use or use only rarely. If there’s a better way to address a use case rather than using an attribute, consider deleting those attributes as well.
Organize your custom attributes into the following categories:
• Best Practice: Doesn’t have a related base system attribute but you want to use it.
• Keep: Doesn’t have a related base system attribute but it’s required for a unique use case.
• Refactor: Does have a base system attribute or a capability that can be migrated.
• Do Not Need (DNN): This customization is no longer needed.

Consider the related dependencies
Moving the configuration items (CIs) to a new table doesn’t automatically move the related dependencies. Identify the related dependencies. To identify the related dependencies, use the script called Migrating into CSDM identifying table dependencies available on the ServiceNow Community.

After running the dependency script and evaluating the data, you have a better idea of the effort required for migrating your data. Decide if you need all referenced reports, rules, and scripts. Then decide what you want to migrate and make a migration plan.

The script doesn’t move your data or their dependencies. It simply identifies the dependencies. Refactor them as part of the migration.

The following figure illustrates the migration workflow.
Migration workflow

To migrate your data from one table or class to another, complete the following steps:

**Procedure**

1. **Back up your data.**
   Export your data (with all attributes) to Excel and keep the file in a secure location.

   ✉ **Note:** Have a contingency plan in case issues arise.

2. **Map the attributes.**
   Identify the table where you want your data to go. Make sure that destination table has the required base system attributes. Rationalize your custom attributes. Decide if you must keep all customizations.

3. **Move the configuration item (CI) from one class to another.**

   ✉ **Note:** Don’t forget about your non-conforming tables and their dependencies. You could have hundreds of reports, business rules, scripts, table references, and more that need the data in your non-conforming tables.

4. **Refactor the attributes.**
   Solidify the data model and get the data ready for migration. Make sure you have completed the attribute mapping-related tasks in step 2. Remember to categorize your attributes (Best Practice, Keep, Refactor, DNN) and refactor your data as needed.

5. **Migrate the data.**

   ✉ **Note:** Make sure that you have a valid and recent backup. Do another backup, if necessary. You lose any customized or base system attributes not in the same table hierarchy.

Keep these points in mind as you proceed:
• Migrate your CIs to the new class. Migrating your CIs to the new class moves the CI and all its related objects, incidents, and changes to the new table.

• Start with a few CIs and increase the number when you feel comfortable.

6. Remediate your table dependencies:

   a. Modify reports to use the new table.
   b. Migrate business rules and scripts, if needed.
   c. Update table references, as needed.

7. Reload data into the new attributes using the backup that you made earlier.

8. Validate all data and dependencies.

Results
You’ve successfully migrated your application to the CSDM framework, and your data is in the required locations in the CMDB.

Common Service Data Model product views
Product views and use cases for using your ServiceNow® product with the Common Service Data Model (CSDM) framework.

Starting with the Orlando release, the CSDM documentation includes product views and use cases for a number of ServiceNow products. Each product included has a separate product view.

Each product view includes the following topics:

• The CSDM tables managed by the ServiceNow product.
• The CSDM tables used by the ServiceNow product.
• Other ServiceNow products that add value to the one you are using.
• Other ServiceNow products that benefit from the one you are using.
• Overview of the ServiceNow product you are using.
• Use case for ServiceNow product you are using.

⚠️ Note: A CSDM use case may have 1 or more data types. Other ServiceNow products may also manage these data types. The use case doesn’t describe all the possible product dependencies.

The product views don’t address:

• Implementing the ServiceNow product.
• Configuring non-base systems.
Non-base systems may be referred to in this product view, but they are out-of-scope.

• Using other ServiceNow products, such as IT Service Management (ITSM), IT Business Management (ITBM), and IT Operations Management (ITOM).

**Common Service Data Model product view: Application Portfolio Management**

Product view and use cases for using ServiceNow® Application Portfolio Management (APM) with the Common Service Data Model (CSDM) framework.

The CSDM is a framework or blueprint that you can follow when you set up your ServiceNow application. Following this model ensures that the data for that application maps correctly to the appropriate tables. For more information about the CSDM, see [Common Service Data Model](#).

**CSDM tables managed by APM**

1. Business Capability table [cmdb_ci_business_capability]
2. Business Application table [cmdb_ci_business_app]
3. Information Object table [cmdb_ci_information_object]

The following figure highlights the CSDM tables managed by APM. The numbers correspond to the specific table.

**CSDM tables used by APM**

1. Application Service table [cmdb_ci_discovered_service]
2. Configuration Item tables [cmdb_ci*]
3. Product Model (software and hardware models) tables for Technology Portfolio Management (TPM)

4. Business Unit table [business_unit] and Department table [cmn_department]

5. IT Owner and Business Owner user table [sys_user]

Products that add value to APM

When you use APM with other ServiceNow products, you increase the value you get from APM. These other ServiceNow products include:

- **Discovery**
  
  Discovery provides details about the hardware and software CIs you are using.

- **Service Mapping**
  
  Service Mapping provides details about the application instance service in the [cmdb_ci_service_discovered] table, relating infrastructure and application [cmdb_ci_appl] CIs.

- **Asset Management**
  
  Provides the related product model. Software Asset Management (SAM) Foundation and Hardware Asset Management (HAM) provide lifecycle data for Technology Portfolio Management (TPM).

- **Financial Management**
  
  Total Cost of Ownership (TCO) calculation based on general ledger data and allocation rules.

- **Project Portfolio Management**
Views the business application roadmaps. Includes demands, projects, sprints and epics.

- Agile Development
  Views the backlog stories and epics of each business application in the application roadmap.

**Products that benefit from APM**
The ServiceNow products that gain value from APM include:

- **IT Service Management (ITSM)**
  Services have the context of the business and applications, along with the information and technologies layered beneath them.

- **Information Technology Operations Management (ITOM)**
  Understands the business context for the application services along with the hardware and software being managed.

- **Governance, Risk, and Compliance (GRC)**
  Auditors can leverage the business applications and related Information Objects. This helps auditors understand the design-time data sensitivity for scoping audits, measuring risks, and managing audit activities.

- **Asset Management**
  Manages the software and hardware lifecycles for business applications and business services.

**APM product overview**

Use APM to gain a comprehensive understanding of the applications used in your organization so you can identify redundancies, and decrease budgetary costs.

The APM home screen organizes many of the CSDM tables used by APM.
With the APM home screen, you can see the following information.

1. Business portfolio

View the number of defined business capabilities that have been or will be assessed, and the number of business applications that support the capabilities but are at-risk.

2. Information portfolio

Capture the asset information as information objects. You can connect the information object to your business applications. Connecting the information object to your business applications creates an application portfolio that you can use at any time.

The information portfolio links to the following data:

- Data Domains: Total number of records in the Data Domain table [sn_apm_data_domain].
- Information Objects: Total number of records in the Information Object table [cmdb_ci_information_object].
- Database Instances: Total number of records in the Database Instance table [cmdb_ci_db_instance].
- Database Catalogs: Total number of records in the Database Catalog table [cmdb_ci_db_catalog].

3. Application Portfolio
Track the applications that support your business capabilities and effectively manage them to meet the goals of your organization. The portfolio provides a list of applications with information such as their category, manufacturer, and type. Click Applications to navigate to the list view of business applications in your organization.

APM use case

APM lets you define a single, version-agnostic entity that represents all instances, technologies, and data used for planning and reporting.

You can use a business application for planning and governance activities, such as funding, road mapping, and risk reporting. Rationalizing business applications is a continuous process, and is critically important to reducing costs, and planning technology transformations. Rationalizing business applications is also critical for completing mergers, divestitures, or other broad-impact business-led changes.

Key features of the APM use case

The CMDB, when used by the CSDM framework, provides value to APM in the following ways:

• Application Lifecycle Management. This includes:
  ◦ Registering a new business application.

    Note: Starting with the Paris release this is now included in the base system.
  ◦ Updating a business application
  ◦ Decommissioning a business application, including all the related application services and infrastructure.

• Business application portfolio assessments based on metrics or related impacts.

• Roadmap planning and creating new ideas, demands and projects.

• TCO calculations (using the Financial Management module)

• Manage the following related entities:
  ◦ Information objects table [cmdb_ci_information_object]
  ◦ Business capabilities table [cmdb_ci_business_capability]
Results of the APM use case
With this use case, CSDM provides APM a consistent way to model business applications and relate critical data. The use case ensures that the application services (instances) are defined as required for automating the technology risk scores, costs, and other metrics used for analysis.

TPM use case
TPM gives you a better understanding of the risks associated with using software and hardware that is at the end-of-life (EOL) date. You can use the details provided by the CSDM framework to determine the risk of using software and hardware that is at the EOL date. Each product lifecycle EOL date is calculated, then combined following the CSDM framework to provide a score at the Business Application level.

Results of the TPM use case
The CSDM framework provides a consistent data structure. This consistent data structure makes it easier for you to manage the lifecycles of your technology and analyze the combined technology risks.

Because of the way the CSDM framework is structured, you can leverage many of the ServiceNow products from ITOM, Service Management (SPM), and IT Application Management (ITAM).

The risks of using EOL technologies are calculated based on the lifecycle of each software and hardware product model identified in the CMDB, and matched with a software and hardware product model.

You can enter the lifecycle data manually, import it from an external source, or use the data provided with your Software Asset / Hardware Asset Management license.

The risks are calculated and displayed in a hierarchy. Business application are at the top level, Application Services indicate each deployment (instance), and software and product models are at the lowest level. Risks are calculated in the order shown below, and are based on the time span between the current date and the EOL date.

1. Hardware and software product model — Displays the current lifecycle phases, sources, and indicates the specific models at-risk
2. Application Service level — Displays the combined risk status of all underlying hardware and software product models used in the Application Service (Instance).
3. Business Application level — Combines all the underlying Application Service (Instances) to determine the overall risk rating at a portfolio level.
The following information is used to determine the EOL impact to business applications and their installed application services (instances):

- The business applications used in your organization are all linked to one or more application services. Each of the application services run on one or more technologies or software models.

  The name of the Application Service Software model table is [sn_apm_tpm_service_software_model]

- The software model has a sequence of lifecycle stages. These lifecycle stages range from the installation date to the retirement date.

  Some business organizations set an internal date based on the lifecycle phase of the software models. These software model phases can be Early Adopter, Mainstream, Declining use, and Retired.

  Similarly, the software vendors may also set a date for the software based on the vendor lifecycle phases, such as Pre-release, General Availability, End of Life, and Obsolete. Vendor support may vary depending on the phase of the technology. For example, when the software model reaches the Obsolete phase, the vendor may stop supporting the technology.

  The name of the Software Model Lifecycle table is [sam_sw_model_lifecycle].

**Frequently asked questions (FAQs)**

- What is the difference between a business capability and a business service?

  Business Services are what IT provides to the customer, while Business Capabilities describe what the business does.
• Is purchasing Software Asset Management Foundation plugin required to receive the benefit of Technology Portfolio Management?

No. Software Asset Management Foundation plugin provides life-cycle data that Technology Portfolio Management uses.

However, you can manage that data manually or get it from another source. Both products share the underlying tables, but are independent. You can use them separately.

• How is an application portfolio managed?

For information about managing your application portfolio, see Application Portfolio Management - Inventory Best Practices.

• What's the difference between a business application and an application?

Each uses a different table, and each represents different elements.

  ◦ Business application:
    ▪ Uses the Business Application table [cmdb_ci_Business_App].
    ▪ Represents the single, logical, construct of the application that comprises application service, environment, software, and hardware in use.

  ◦ Application:
    ▪ Uses the Application table [cmdb_ci_appl].
    ▪ Represents the specific version of software in use on a server (often populated by Discovery or System Center Configuration Manager (SCCM).

• Are there other FAQs about APM?

Yes. For other FAQs about APM, see APM: Application Inventory - Most common questions.

For more information
The CSDM provides additional value to APM in the following areas:

• Application assessment

For more information about measuring the usability, cost, quality, performance, and risk of applications, see Application Assessment.

• Business capability management

For more information about using capability mapping to establish a configuration item (CI) relationship between the business capability and the business applications, see Management of business capability.

• Information portfolio

For more information about the information portfolio and the information portfolio model, see Information portfolio.
Technology portfolio management

For more information about technology portfolio management and how it relates to business applications, see Technology Portfolio Management.

Common Service Data Model product view: Incident Management

Product view and use case for using ServiceNow® Incident Management with the Common Service Data Model (CSDM) framework.

The CSDM is a framework or blueprint that you can follow when you set up your ServiceNow application. Following this model ensures that the data for that application maps correctly to the appropriate tables. For more information about the CSDM, see Common Service Data Model.

CSDM tables managed by Incident Management

The Incident form references the following attributes and related lists:

1. Configuration items (CIs) table [ci_*].
   - Application table [cmdb_ci_appl]
   - Server table [cmdb_ci_server]
   - Virtual machines table [cmdb_ci_vm_instance]
   - Load balancer table [cmdb_ci_lb]
   - Network gear table [cmdb_ci_netgear]

   The following figure highlights the CSDM tables managed by Incident Management. The numbers correspond to the specific table.

CSDM tables used by Incident Management

The Incident form references the following CSDM tables

1. Application Service [cmdb_ci_discovered_service] table or any infrastructure CI.
2. Configuration Item tables [cmdb_ci*]
3. Service [cmdb_ci_service] table: Uses the service classification attribute to identify business services, technical services, and application services as types of services.
4. Service Offering [service_offering] table: Uses the service classification attribute to identify business services, technical services, and application services as types of service offerings.
Products that add value to Incident Management

When you use Incident Management with other ServiceNow products, you increase the value you get from Incident Management. These other ServiceNow products include:

- Discovery
  Discovery provides details about the hardware and software CIs you are using.
- Service Portfolio Management (SPM)

Products that benefit from Incident Management

The ServiceNow products that gain value from Incident Management include:

- IT Service Management (ITSM)
  Services have the context of the business and applications, along with the information and technologies layered beneath them.
- Information Technology Operations Management (ITOM)
  Understands the business context for the application services along with the hardware and software being managed.
- Governance, Risk, and Compliance (GRC)
  Auditors can leverage the business applications and related Information Objects. This helps auditors understand the design-time data sensitivity for scoping audits, measuring risks, and managing audit activities.
- Asset Management
Manages the software and hardware lifecycles for business applications and business services.

• Customer Service Management (CSM)

**Incident Management product overview**

Incident Management lets you report and track issues. You can contact ServiceNow IT over the internet or on your mobile device. Features of Incident Management that get the most benefit from the CSDM include:

• Agent Workspace gives agents the information they need to quickly prioritize and resolve incidents.

• The major incident workbench includes a single-pane view you can use to identify, track, and resolve high-impact incidents.

• The native mobile app allows agents to quickly view and respond to tasks on-the-go, and can approve the requests with a single swipe.

• Incident deflection encourage self-help by suggesting related knowledge base articles.

• Improves collaboration on incident tasks by using drag-and-drop functionality on visual task boards.

• Performance analytics provide detailed insights into performance trends.

Incident Management includes a form you can use to report incidents.
The incident form references the following attributes and related lists.


   **Note:** Earlier ServiceNow releases labeled this attribute Business Service.

2. Service Offering (attribute) — References the [service_offering] table. Displays the service offerings affected by the incident in the Service Offerings related list.

3. Configuration Items — References the [cmdb_ci] table

4. Affected/Causal CIs — Related list [task_ci] table

5. Impacted Services — Related list [task_cmdb_ci_service] table

6. Service Offering — Related list [task_service_offering] table

### Incident Management Use Case

Incident Management restores normal service operation, while also minimizing impact to your business and maintaining the quality of your data.

Use it to create an incident that captures information about the asset-related CIs. An incident keeps a record of the updated, repaired, swapped, or retired CIs.

By keeping track of the assets, you can tell where the assets are located, how they are used, and when changes were made to them. This information helps you systematically monitor and manage the assets in your company.

A CI can result in an incident. Use a dependency view to identify other CIs that are affected by the incident. Associate the affected CIs with an incident record to find out how the incident affects other dependent CIs.

### Key features of the Incident Management use case

The CMDB, when used by the CSDM framework, provides value to Incident Management in the following ways:

- Understands the impact of the Incident on services and service offerings.
- Dynamically routes incidents
- Identifies all of the affected services

### Results of use case

The CSDM framework provides context for the incidents. The context includes the CIs involved in the incident and the services affected.

Use the Incident form to see the impact of the incident and restore the affected services. Complete the following steps:
1. Populate the Configuration Item attribute [configuration_item] with the CI or the service affected. You can then use this CI to identify details for incident routing. For example, you can use the CI data, such as “Support Group” and provide information about the service impact by using dependency relationships.

2. Populate the Impacted Services related list [task_cmdb_ci_service] with the services that are related to the populated CI. These may include services and service offerings.

3. (Optional) Use the Service and Service Offering attributes to help narrow the list of available CIs.

   **Note:** Narrowing the list of available CIs is not a feature of the base system. To narrow the list, you need to configure the Incident form.

4. (Optional) Use the Affected CI related list [task_ci] to identify the CIs that may have caused the incident.

5. (Optional) Use the Impacted Services related list [task_cmdb_ci_service] to see the services and CIs affected by the incident.
Frequently asked questions (FAQs)

• Why doesn’t this use case reference business application?

Business applications are portfolio objects used for designing and planning your enterprise architecture. Business applications don’t contain attribute-level details such as version, environment, and localization (for any deployments using one or more applications).

• Is the application service an application or a service? Where should it be used on an Incident form?

Application service is a service type that is a logical representation of an application. You can use the application service CI on the Incident form in few scenarios such as:

◦ Scenario 1: The incident is for an application-related issue — On the Incident form, you can enter “Application Service” in the Configuration Item field to represent the application. For example, you can report the Application Service called MyApp 3.0 Production as unavailable.

◦ Scenario 2: The incident is for an infrastructure CI that is affecting one or more services — On the Incident form, the Impacted Services/CI related list identifies the Application Service affecting services. For example, the Server OMG124 CI may be identified as affecting the MyApp 3.0 Production and other related services.

For more information

For more details about Incident Management, see Incident Management.

Common Service Data Model product view: Change Management

Product view and use case for using ServiceNow® Change Management with the (CSDM) framework.

The CSDM is a framework or blueprint that you can follow when you set up your ServiceNow application. Following this model ensures that the data for that application maps correctly to the appropriate tables. For more information about the CSDM, see Common Service Data Model.

CSDM tables managed by Change Management

1. Configuration items (CIs) table [ci_*].
   • Application table [cmdb_ci_appl]
   • Server table [cmdb_ci_server]
   • Virtual machines table [cmdb_ci_vm_instance]
- Load balancer table [cmdb_ci_lb]
- Network gear table [cmdb_ci_lb]

The following figure highlights the CSDM tables managed by Change Management. The numbers correspond to the specific table.

CSDM tables managed by Change Management

1. Application Service table [cmdb_ci_discovered_service] or any infrastructure CI.
2. Configuration Item tables [cmdb_ci*]
3. Service [cmdb_ci_service] table: Uses the service classification attribute to identify business services, technical services, and application services as types of services.
4. Service Offering [service_offering] table: Uses the service classification attribute to identify business services, technical services, and application services as types of service offerings.
Products that add value to Change Management
When you use Change Management with other ServiceNow products, you increase the value you get from Change Management. These other ServiceNow products include:

- Discovery
  Discovery provides details about the hardware and software CIs you are using.
- Service Mapping
  Service Mapping provides details about the application instance service in the [cmdb_ci_service_discovered] table, relating infrastructure and application [cmdb_ci_appl] CIs.

Products that benefit from Change Management
The ServiceNow products that gain value from Change Management include:

- Service Portfolio Management (SPM)
  Services have the context of the business and applications, along with the information and technologies that underpin them.
- IT Service Management (ITSM)
  Incidents caused by, impacted by, or fixed by Change Management.
- Asset Management
  Updates assets.
- Information Technology Operations Management
  Updates CIs using a controlled process.
• DevOps
  Provides Change Management governance for pipeline tool chains.

Change Management product overview
Change Management lets you control every aspect of the IT change process from creation to approval. When you have accurate information you can minimize risks to your business and avoid conflicts with scheduling. Change Management also includes the following features:

• You can manage changes more quickly by using the Change Advisory Board (CAB) Workbench to schedule, plan, and manage CAB meetings from one interface.

• The Change Management backlog analysis dashboard provides increased visibility into any changes.

• Service Maps let you see the change impacts at-a-glance.

• The change approval policies increase DevOps velocity and remove IT friction.

The Change Request form references the following attributes and related lists.


   Note: Earlier ServiceNow releases labeled this attribute Business Service.

2. Service Offering — References the [service_offering] table where the offering has a parent service.

3. Configuration Items — References the [cmdb_ci] table

4. Affected/Causal CIs — Related list [task_ci] table

5. Impacted Services — Related list [task_cmdb_ci_service] table
6. Assignment Group — References the Group attribute

**Note:** You can populate the Group attribute by using the Assignment Group for the relevant CI.

**Change Request form**

---

**Change Management use case**

Know where to find your critical data. This essential knowledge helps reduce mean-time-to-repair (MTTR) and eliminates change-related outages.

**Key features of the Change Management use case**

The CMDB, when used by the CSDM framework, provides value to Change Management in the following ways:

- Understands the impact of the change on services and service offerings.
- Dynamically routes changes
- Identifies and notifies all of the affected services so that the change can be approved.
Tables for the Change Management use case

Results of the Change Management use case

The CSDM framework provides context for the changes. The context includes the CIs involved in the change and the services affected.

Use the Change Request form to see the impact of the change. Complete the following steps:

1. Populate the Configuration Item attribute [configuration_item] with the target CI for the change activity. You can then use this CI to identify details for change routing. For example, you can use the CI data, such as “Assignment Group” or “Approval Group,” and provide information about the service impact by using dependency relationships.

2. Populate the Impacted Services related list [task_cmdb_ci_service] with the services that are related to the populated CI. These may include services and service offerings.

3. (Optional) Use the Service and Service Offering attributes to identify the provider services responsible for managing the selected CIs.

4. (Optional) Use the Affected CI related list [task_ci] to identify the CIs that may have caused the change. These CIs are in addition to the CIs previously populated. The [task_ci] table can be populated dynamically or manually.

**Note:** Dynamic population is not part of the base system. To use dynamic population, you need to configure the Change Request form.
Frequently asked questions (FAQs)

• Why aren’t business applications referenced in the change use case?
  Business applications are portfolio objects you can use for designing and planning an Enterprise Architecture. Business application portfolio objects don’t contain version, environment, and localization details for deployments using one or more applications.

• Who approves a change?
  It depends on how you implement Change Management. Once you populate the CIs on the Change form (if there’s a relationship between the CI and the impacted services and service offerings), the Approval group approves the change.

• What CI attributes should I use for routing a change?
  If you are initiating the change or the change task, use the Assignment Group attribute CI. If you are using build run teams, you could use the Support Group attribute CI for the team assignments.

For more information
For more details about Change Management, see Change Management.

Common Service Data Model product view: Service Portfolio Management

Product view and use case for using Service Portfolio Management with the CSDM framework.

The CSDM is a framework or blueprint that you can follow when you set up your ServiceNow application. Following this model ensures that the data for that application maps correctly to the appropriate tables. For more information about the CSDM, see Common Service Data Model.

CSDM tables managed by SPM
1. Service portfolio table [spm_service_portfolio]
  Provides groups of services that share a common budget and management focus. The Service Portfolio table isn’t a configuration item (CI) but is available in the base system.

  Service portfolios consist of:
• Taxonomy Layers table [spm_taxonomy_layer_definition]
• Taxonomy Nodes table [spm_taxonomy_node]

ℹ️ **Note:** Neither of these tables are CIs but both are included in the base system.

2. Service table [cmdb_ci_service]
   Defines the outcomes available from the service provider. Uses a service classification attribute to classify services as one of the following:
   • Business Service – This service is for the business consumer in your organization
   • Technical Service – This service is for a technical consumer (back-end, network, compute)
   • Application Service – This service represents the application consumed by users

3. Service Offering table [service_offering]
   Classifies a service based on consumable units such as performance and consumer. While this table doesn’t follow the CMDB naming schema, it is still considered a CI and is available in the base system.

### CSDM tables managed by SPM

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. Request Catalog table [sc_cat_item]</td>
<td>Service offerings connect to catalog items to see how offerings are consumed.</td>
</tr>
<tr>
<td>2. Application Service table [cmdb_ci_service_discovered]</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
SPM manages dependencies on Application Services by Business Services.

3. Technical Service table [cmdb_ci_service]

Technical services are classified as "Technical." SPM manages dependencies on the Technical Services and their offerings by Business Services.

Products that add value to SPM

When you use SPM with other ServiceNow products, you increase the value you get from SPM. These other ServiceNow products include:

- **Service Catalog**
  Provides the Catalog Items [sc_cat_item] to see how the service is being consumed.

- **Vendor Manager Workspace**
  Provides vendor-related information for services.

- **Financial Management**
  Provides an estimated-spend calculation for each service offering.

- **Continual Improvement Management (CIM)**
  Provides visibility into CIM records that are impacting services or offerings.

- **ITOM Visibility**
  Defines the application services and CIs related to service offerings and business services. These definitions help to better understand the footprint of a service from the CMDB perspective.
Products that benefit from SPM
The ServiceNow products that gain value SPM include:

• Application Portfolio Management (APM)
  Understands the service-to-business capability relationships.

• IT Service Management (ITSM): Incident, Problem, and Change
  Gains insight from access to service and offering information. Uses agreed-upon definitions, Service-Level Agreements (SLAs), and commitments. Uses service and service offering relationships to determine service impacts.

SPM product overview
Service Owner Workspace uses the CSDM framework to let you navigate the service portfolio. Navigating the service portfolio lets you locate the services and their related service offerings, dependents, dependencies, combined metrics, costs, and initiatives. Using the CSDM framework, the associated metrics are aggregated with the related tables.

SPM provides the following features:

1. Overview
   Displays who owns and manages the service and service offerings. Also displays the following service offering health and performance metrics:
   • Performance score
   • Customer score
   • Total subscribers
   • Estimated average spend
   • Outages
   • Service offerings

2. Trends
   Displays the performance trends over a specified time frame, as well as SLA compliance.

3. Related offerings
   Displays the up-stream and down-stream service and offering dependencies for all service types.

4. Info
   Displays the service description, performance weight, and scope. Most of this information comes directly from the service and offering tables.

5. Improvement initiatives
Displays all related CI initiatives associated with the service or offering.

6. Impact stream

Shows the service owner outages, changes, and critical incidents related to their service or offering using three time scales: recent, current, and upcoming.

**SPM service form**

![SPM service form](image)

**SPM use case**

Service owners can define and manage their services, and see where the services are in the portfolio. Knowing where their services are in the portfolio helps prevent service duplication, and helps identify the low-value services in the Service Owner Workspace. Service owners can then decide whether to outsource or redeploy critical resources.

**Key features of the SPM use case**

The CMDB, when used by the CSDM framework, provides value to SPM in the following ways:

- Consolidates service information.
- Provides a framework for defining and viewing both service-to-service and service-to-CI relationships.
• Uses the Service Owner Workspace to complete activities such as connecting the service offerings to the service catalog items.

**Service catalog items**

Results of the SPM use case

SPM uses the CSDM framework to define the service and related items. These definitions are required for you to receive the full benefit of the CSDM framework. The base system of SPM includes well-defined services and provides a way for you to manage a service portfolio. SPM also includes the following:

• Activities related to services or offerings (for example, change requests and incidents)

• Service metrics and data used for reporting, such as:
  ◦ Customer satisfaction (CSAT) scores
  ◦ Stability
  ◦ Breached SLAs
  ◦ Availability
  ◦ Activity (consumption)

Frequently asked questions (FAQs)

• What is the difference between a business capability and a business service?

  A business capability is the ability to complete an activity and deliver an outcome. A business service is how value is added, delivered, and consumed, along with performance and cost considerations.
For more information

- Service Offering Subscriptions
  For more information on how service owners can subscribe users to service offerings, see Service Portfolio Management service offering subscriptions.

- Service Level Management
  For more information about managing your Service Level Agreements (SLAs), see Service Level Management for Service Portfolio Management.

- Service Owner Workspace premium experience
  For more information about the premium experience the Service Owner Workspace provides, see Service Owner Workspace.

Common Service Data Model product view: ITOM Health

Product view and use cases for using ServiceNow® ITOM Health with the Common Service Data Model (CSDM) framework.

The CSDM is a framework or blueprint that you can follow when you set up your ServiceNow application. Following this model ensures that the data for that application maps correctly to the appropriate tables. For more information about the CSDM, see Common Service Data Model.

CSDM tables managed by ITOM Health

- Dynamic CI Group table [cmdb_ci_query_based_service]
CSDM tables used by ITOM Health

- Application Service table [cmdb_ci_service_discovered]
- Configuration Item table [ci_*]
- Dynamic CI Group table [cmdb_ci_query_based_service]

Products that add value to ITOM Health

When you use ITOM Health with other ServiceNow products, you increase the value you get from ITOM Health. These other ServiceNow products include:

- Discovery
  
  Discovery provides details about the hardware and software CIs you are using.

- Service Mapping
  
  Service Mapping provides details about the application instance service in the [cmdb_ci_service_discovered] table, relating infrastructure and application [cmdb_ci_appl] CIs.

- Service Portfolio Management (SPM)
  
  Provides the related product model. Software Asset Management (SAM) and Hardware Asset Management (HAM) provide lifecycle data for Technology Portfolio Management (TPM).

Products that benefit from ITOM Health

The ServiceNow products that gain value from ITOM Health include:
• Incident Management
  Incidents are created using the downstream information from Event Management.

• Customer Service Management (CSM)
  ITOM Health provides the application service impact which, in turn, is used to identify the affected users.

**ITOM Health product overview**
ITOM Health consists of 2 main capabilities that use the CSDM framework.

• Event Management
  Event Management gathers alerts from infrastructure events captured by third-party monitoring tools. Event Management uses IT-related information gathered by Discovery to map alerts to CIs. Based on the collected information, Event Management then provides dashboards showing a consolidated view of all service-impact events.

• Metric Anomaly Detection
  Proactively analyzes your IT infrastructure to spot issues and prevent service outages. Using advanced machine learning to analyze information about your IT infrastructure, the application automatically determines dynamic thresholds and identifies anomalies that may indicate potential service outages.

**ITOM Health use case**
Modern organizations increasingly rely on artificial intelligence (AI) technologies in IT operations (AIOps) to help address rapid growth in data volumes and variety. Modern organizations need to analyze this data and find ways to automate and predict issues before they occur. AIOps platforms have emerged as a solution to many of these challenges.

**Key features of the ITOM Health use case**
Key features of the ITOM Health include the following:

• Event and metrics ingestion using the base system integration to selected monitoring systems

• Event and metric processing and alert creation

• Alert correlation and root cause analysis

• Anomaly detection

• Application service impact calculation
- Operator workspace and alert intelligence user interface
- Alert remediation automation

**Event Management process**

**Results of the ITOM Health use case**

Application service maps help Network Operations Center (NOC) operators at central locations to accurately predict root cause alerts and correlate the alerts with the discovered topology data. Correlating the alerts with the discovered topology data lets NOC operators accurately predict the impact to services. Impact analysis helps you to determine the impact on the application services and visualize it in the application service map.

**Frequently asked questions (FAQs)**

- **What CIs do I need to get the most benefit from Event Management?**
  
  Event Management uses the CIs that are monitored by the operations team to bind an Alert to the correct CI and analyze the impact on the monitored service.

- **Why don't I see Technical Services in Event Management?**
  
  Technical Services are now labeled as Dynamic CI group service. Dynamic CI group services use the CMDBCI Group capability to query the CMDB.

- **What is a common use case for Dynamic CI Group service?**
  
  Dynamic CI Group service is used in Event Management as a logical grouping of CIs. Dynamic CI Group service provides the health status of the group to the technology or service owner.

**For more information**

For more information about the features ITOM Health, see [ITOM Health](#).
Common Service Data Model product view: ITOM Visibility

Product view and use cases for using ServiceNow® ITOM Visibility with the Common Service Data Model (CSDM) framework.

The CSDM is a framework or blueprint that you can follow when you set up your ServiceNow application. Following this model ensures that the data for that application maps correctly to the appropriate tables. For more information about the CSDM, see Common Service Data Model.

CSDM tables managed by ITOM Visibility

1. Application Service tables
   Tables managed vary by the method used to create the application service.
   • Manually created service maps table [cmdb_ci_service_manual]
   • Tag-based maps table [cmdb_ci_service_by_tags]
   • Automated using Service Mapping table [cmdb_ci_service_discovered]
   • There are multiple Application Service types, and different tables used for each type. The specific types and tables managed Service Mapping are as follows: manual service maps: table = cmdb_ci_service_manual tag based maps: table = cmdb_ci_service_by_tags Automated using Service Mapping: table = cmdb_ci_service_discovered

2. Configuration items (CIs) table [ci_*].
   Approximately CMDB tables are available.
   • Application table [cmdb_ci_appl]
   • Server table [cmdb_ci_server]
   • Virtual machines table [cmdb_ci_vm_instance]
   • Load balancer table [cmdb_ci_lb]
   • Network gear table [cmdb_ci_netgear]
CSDM tables managed by ITOM Visibility

The following diagram illustrates the typical ITOM Visibility table structure.

Typical ITOM Visibility table structure
CSDM tables used by ITOM Visibility

1. Dynamic CI Group table [cmdb_ci_query_based_service]
2. Product model tables (for Technology Portfolio Management [TPM]) software and hardware models

Products that benefit from ITOM Visibility

The ServiceNow products that gain value from ITOM Visibility include:

- Service Management
- Customer Service Management (CSM)
- Event Management
- Cloud Management
- Asset Management (Hardware Asset Management and Software Asset Management)
- IT Business Management (Financial Management — Showback statements, Application Portfolio Management [APM])
- Security Operations (Incident Response, software vulnerability management)

ITOM Visibility product overview

ITOM Visibility consists of two ServiceNow products: Discovery and Service Mapping.
• **Discovery**

  Discovery finds computers, servers, printers, a variety of IP-enabled devices, and the applications that run on them. It can then update the CIs in your CMDB with the data it collects.

• **Service Mapping**

  Service Mapping discovers all application services in your organization and builds a comprehensive map of all devices, applications, and configuration profiles used in these business services.

  Service Mapping maps dependencies based on a connection between devices and applications. This method is referred to as top-down mapping. The top-down mapping helps you immediately see the impact of a problematic object on the rest of the application services.

**Discovery use case**

With this use case you can:

• Get increased visibility into your on-premise and cloud resources.

• Keep track of changes in your on-premise, cloud, and serverless infrastructure in the Configuration Management Database (CMDB).

• Set a strong foundation with accurate data and relationship views for ServiceNow products, including Change Management, Software Asset Management, Customer Service Management (CSM), and Security Operations.

**Key features of the Discovery use case**

• Setup and manage Discovery jobs.

• See IT resources and dependencies at-a-glance.

• Build queries to validate the discovered IT resources.

• Manage your Public Key Infrastructure (PKI) certificates in one dashboard.

**Results of the Discovery use case**

The CSDM framework gives Discovery a prescribed model for how infrastructure and software CIs relate to other areas, such as application services, business applications, and assets.

**Service Mapping use case**

You can create application services:
• Manually
• By using an API
• By having Service Mapping discover them.

Regardless of the method, all the application services are stored in the Application Service table [cmdb_ci_service_discovered].

**Results of the Service Mapping use case**

Service Mapping automates a critical aspect of CSDM with a consistent, automated approach to connect the logical layer of the CSDM model to the physical model CIs in the CMDB. This automated approach lets you more effectively manage your business applications. This approach also allows you to automate the modeling of your business applications for impact assessment and analysis. For impact assessments and analysis, you can use a number of ServiceNow products including Change Management, Incident Management, or the CMDB Query Builder.

**Application Services flow**

You can specify a lifecycle status for an application service. Application services with an Operational lifecycle status can be used on service maps for the relevant workflows, such as Artificial Intelligence for IT Operations (AIOPs) workflows.
Lifecycle status for application services

- Operational
- Non-Operational
- Repair in Progress
- DR Standby
- Ready
- Retired

You can view information about the services, such as the criticality, in the Operator Workspace.

Operator Workspace

The Service Map tab lets you see a visual representation of the service.
Frequently asked questions (FAQs)

• Can I define application services without using Service Mapping?

Yes. Service Mapping is just one of the ways you can define application services. You can also:

◦ Define application services manually.
◦ Use a Dynamic CI group, based on a query.
◦ Use a tag-based approach (commonly used for Cloud integrations).

For more information about creating application services, see Create an application service.

For more information

For more information about Discovery, see Discovery basics.
For more information about Service Mapping, see Service Mapping.
Common Service Data Model product view: Service Catalog

Product view and use cases for using the Service Catalog with the Common Service Data Model (CSDM) framework.

The CSDM is a framework or blueprint that you can follow when you set up your ServiceNow application. Following this model ensures that the data for that application maps correctly to the appropriate tables. For more information about the CSDM, see Common Service Data Model.

CSDM tables managed by the Service Catalog

The Service Catalog manages the business services in the Sell/Consume domain primarily. Technical Services are also viewed from the Operate domain of Event Management.

The following CSDM table is managed by the Service Catalog:

1. Catalog Item table [sc_cat_item]: Creates requests in Request Management. These requests usually have an automated, semi-automated or business workflow for fulfilling the request, which can consist of approvals and tasks. When part of Service Portfolio Management, these CIs are associated with service offerings. The CIs can include:
   - PC Hardware Item (pc_hardware_cat_item): Submits hardware asset requests included in Asset Management workflows.
   - PC Software Item (pc_Software_cat_item): Submits software asset requests included in Asset Management workflows
   - Record Producer (sc_cat_item_producer): Submits requests or generates records other than Request Management tables for services that aren’t serviced by Request Management (for example, HR Cases, Facilities Requests, or Legal Requests).
CSDM tables managed by the Service Catalog

1. Configuration Item tables [cmdb_ci*]
2. Service Offering table [sc_cat_item_subscribe]
3. Application Service table [cmdb_ci_discovered_service]
4. Product Model tables [cmdb_model]

Note: The following legacy CMDB relationships provide access to catalog items. However, these legacy relationships are no longer supported. To provide access to the catalog item, instead use the relationships listed in the following table.

Relationship tables

<table>
<thead>
<tr>
<th>CMDB table</th>
<th>Catalog item relationship table</th>
<th>New relationship to use instead</th>
</tr>
</thead>
<tbody>
<tr>
<td>User (sys_user)</td>
<td>sc_cat_item_user_mtom, sc_cat_item_user_no_mtom</td>
<td>User criteria</td>
</tr>
<tr>
<td>Group (sys_user_group)</td>
<td>sc_cat_item_group_mtom, sc_cat_item_group_no_mtom</td>
<td>User criteria</td>
</tr>
<tr>
<td>Department (cmn_department)</td>
<td>sc_cat_item_dept_mtom, sc_cat_item_dept_no_mtom</td>
<td>User criteria</td>
</tr>
<tr>
<td>Location (smn_location)</td>
<td>sc_cat_item_location_mtom, sc_cat_item_location_no_mtom</td>
<td>User criteria</td>
</tr>
<tr>
<td>Company (core_company)</td>
<td>sc_cat_item_company_mtom, sc_cat_item_company_no_mtom</td>
<td>User criteria</td>
</tr>
</tbody>
</table>
Products that benefit from the Service Catalog

The ServiceNow products that gain value from the Service Catalog include:

- **Service Portfolio Management (SPM)**
  Ties catalog items to service offerings. Lets service owners create and maintain catalog items more easily, and gives more visibility into the service offerings.

- **Hardware Asset Management and Software Asset Management**
  Self-service catalog lets you order an asset and track the service delivery.

- **Human Resources (HR)**
  Exposes the creator (Record Producer) of the HR cases and displays the Record Producer in the relevant self-service catalogs (for example, Portal, Mobile, and Virtual Agent).

- **Customer Service Management (CSM)**
  Exposes the creator (Record Producer) of the customer service cases and displays the Record Producer in the relevant self-service catalogs (for example, Self-service Portal, Mobile, and Virtual Agent).

Service Catalog overview

The Service Catalog lets you create other catalogs (such as the Request Catalog and the Product Catalog) that provide self-service opportunities in the channel you want to use, such as the Self-service portal, the Mobile App, or the Virtual Agent (conventional interface).

In addition to offerings that are fulfilled using Request Management application for IT, you can use Service Catalog Record Producers to submit requests or
tickets in non-IT applications such as HR, Legal, Facilities and any record in any custom application.

**Service Catalog use case**

You can create customized catalogs where you can request items such as a specific service or product. With this use case, CSDM provides Service Catalog connection to the service offerings and services.

Request Catalogs and Product Catalogs are two of the customized catalogs you can create from the Service Catalog.

- **Request catalog**
  
  A request catalog is a list of business and technical products, services, service commitment options, and offerings that you can order.

- **Product Catalog**
  
  A Product Catalog is a set of information about individual models. Models are specific versions or various configurations of an asset. Asset managers use the Product Catalog as a centralized repository for model information.

Catalogs are the starting points for accessing available services, and contain catalog items.

**Key features of the Service Catalog use case**

Service Owner Workspace uses the CSDM framework to navigate the Service Portfolio. You can then use the Service Portfolio to locate the services and their related service offerings, catalog items, dependents, dependencies, metric roll-ups, costs and initiatives. The associated metrics are aggregated using the CSDM framework with the related tables.

**Catalog items**

A catalog item is an item or a service that you can request from the catalog. A service can contain multiple catalog items. Catalog items are listed on the catalog portal and are available to the users who need them (either through subscription or job responsibility). Each catalog item is linked to one service offering.

The Catalog Item form lets you specify the following details.

1. **Item Details**: Description of the catalog item.
2. **Process Engine**: The defined process used to fulfill the catalog item request.
3. **Picture**: Picture used to represent the catalog item when it appears in the catalog.
5. Portal Settings: Provides specific settings on how you interact with the catalog item in the catalog portal.

Catalog Item form

Product Catalog use case

Use the Product Catalog to specify information about a product model. Product models are specific versions or various configurations of an asset. Asset managers use the Product Catalog as a centralized repository for model information.

A detailed and well-maintained Product Catalog can coordinate with the Service Catalog, asset, procurement, request, contract, and vendor information. Models published to the Product Catalog are automatically published to the Service Catalog. The Service Catalog includes information about goods (models) and services. If the model is available from multiple vendors, a model can be listed more than once. Models are included with Asset Management.

Key features of the Product Catalog use case

This use case lets you include hardware and software product information as items in the Product Catalog.
Results of Product Catalog use case

The CSDM framework ensures that product models are available in the catalog and that there are processes defined to consume the models.

Frequently asked questions (FAQs)

• What is the difference between the Service Catalog and the Product Catalog?

The Product Catalog builds on the Service Catalog. The Product Catalogs specify the product models that are available for you to use. Product-specific attributes are captured in each catalog Item. You can create Product Catalogs for the types of products you have in your portfolio.

• Can I create other types of catalogs?

Yes. You can create the types of catalogs you need for the types of products and services you have.

For more information

For more information about using the Service Catalog, see Service Catalog.

Common Service Data Model product view: Customer Service Management

Product view and use cases for using Customer Service Management (CSM) with the Common Service Data Model (CSDM) framework.

The CSDM is a framework or blueprint that you can follow when you set up your ServiceNow application. Following this model ensures that the data for that
application maps correctly to the appropriate tables. For more information about the CSDM, see Common Service Data Model.

**CSDM tables managed by CSM**

The CSM references the following CSDM tables.

1. **Sold Product table** [sn_install_base_sold_product in CSM].
   
   Represents the product purchased by an Account or Consumer, and references the Product Model table [cmdb_model] or Service Model table [cmdb_service_product_model] for a Customer (Account or Consumer).

2. **Install Base Item table** [sn_install_base_item] in CSM.
   
   Represents the products installed or in use by an account or consumer. Install Base Items are Configuration Items (CIs) consumed by the customer and generally reference the Application Services table [cmdb_ci_discovered_service] for SaaS products.
   
   Multiple sold products can be used on a given Install Base Item by using the Installed Products table [sn_install_base_m2m_installed_product].

3. **A Service Model references the Service Offerings table** [service_offering].
   
   Multiple Service Offerings can be associated with a single Service Model.

4. **Once the product is sold to a customer, the Sold Product table references the Service Offering table** [service_offering]. This reference helps to identify the customers subscribed to an offering.

5. **Customers can request services related to the products they have purchased by linking the Catalog Items table** [sc_cat_item] to the Product Model or Service Model by using the Product-to-Catalog Items Relationships table [sn_prod_cat_rel_m2m_product_catalog_item].

6. **Account table** [customer_account] in CSM.
   
   Extends the Company table. The Account table can be a customer account, a partner account, or both.

7. **Contact table** [customer_contact] in CSM.
   
   Extends the User table. A user is an employee of an account. A contact record stores information about a contact, such as the name, phone number, and email address. A contact can also have a user ID and can log in to the customer portal.

8. **Consumer table** [csm_consumer] in CSM.
   
   A consumer is a customer in the business-to-consumer (B2C) business model.
CSDM tables used by CSM

1. Company, Business Unit, Department, Location, Groups, Users tables
   [core_company], [business_unit], [cmn_department], [cmn_location],
   [sys_user_group], [sys_user], respectively.

2. Product Model tables [cmdb_model], and [cmdb_service_product_model]

3. Contract table [ast_contract]

4. Application Service table [cmdb_ci_service_discovered]

5. Configuration Item table [cmdb_ci_*]

6. Business Service table [cmdb_ci_service]

7. Business Service Offering table [service_offering]

8. Request Catalog table [sc_cat_item]
CSM-specific data model
CSM uses the following key entities to resolve complex end-to-end issues.

- A case is the primary entity of CSM and is used to track and resolve customer questions or issues.
- Customer information is linked to a case using associated entities such as Accounts, Contacts, Consumers, Household, Products, and Service Contracts. This information provides the customer service agent the information necessary to resolve customer issues.
- An account can be a customer account, a partner account, or both.
- The contact is an employee of an account. A contact record stores information about a contact, such as the name, phone number, and email address. A contact can also have a user ID and can log in to the customer portal.
- A consumer is a customer in the business-to-consumer (B2C) business model.
- Household defines the consumers who constitute a household, and the relationships between household members.
- Sold Product tracks the products or services sold to an account or consumer.
- Install Base Items represent the instance of the product that has been configured for a customer.
- Service Contract defines the type of support that customers receive. A contract can include an account and contact or a consumer and the specific assets that are covered. A contract can also include multiple service entitlements and SLAs.
- Entitlement specifies the type of support that a customer receives as well as the supported communication channels.

Products that add value to CSM
When you use CSM with other ServiceNow products, you increase the value you get from CSM. These other ServiceNow products include:

- IT Service Management (ITSM)
  Services have the context of the business, applications, information, and technologies layered beneath them.
- Event Management
  Enables organizations to identify service health-related issues on a single management console. Event Management provides alert aggregation and root cause analysis (RCA) for discovered services, application services, and automated alert groups.
• Service Portfolio Management (SPM)
  Enables organizations to document and manage services using a standardized, structured format.

Products that benefit from CSM
• IT Service Management (ITSM)
  Enables organizations to link incidents, problems, changes, and requests to cases, and have the context of the customer (consumer or account) reporting the issue.
• IT Operations Management (ITOM)
  Enables organizations to identify the Install Base Items and the customers affected by service issues. Helps organizations to provide proactive customer service.
• Service Portfolio Management (SPM)
  Enables customers, who have subscribed to the Service Offering, see who owns the service.

CSM product overview
The CSM enables you to provide service and support for your external customers through communication channels such as the web, email, chat, telephone, and social media. You can create cases as needed and route cases to the appropriate customer service agents.

CSM use case
The goal of this use case is to understand how CSM key entities work with core CSDM framework to provide proactive customer service, decrease cost of service, and provide end-to-end visibility to both customer service and service delivery groups.

Results of the CSM use case
Understand the tables within the CSDM framework that are needed to support the following CSM functionality:
• Service-aware Install Base
• Proactive Customer Service Operations
• Real Time Service Health and Outage Tracking
• Integration with Service Portfolio Management
• Contextual Service Catalog
The following sections include details of the activities needed for the use case.

**Example scenario: key personas and how they benefit**

This section includes an example of how a fictitious technology company called ACME manages the network monitoring services for their customers.

ACME offers a network monitoring service to its enterprise customers who can purchase either the Platinum, Gold, or Silver offering. A customer, Boxeo, has purchased the network monitoring platinum offering (Sold Product) and is using it in development and production environments (Install Base Item).

**CSM data model example**

The key personas (customer service agents, Network Operations Center (NOC) engineers, service owners, and customers) can complete the relevant tasks listed below:

**Customer service agents can:**
• View the products and services that the customer has purchased (Sold Product) and installed (Install Base).

• View the service offering associated with the sold product. The sold product references the service offering.
• View the health status of Install Base Items

NOC engineers can:

• View customers affected by a service issue and inform customer service. Specifically, they can:

  ◦ View the affected Install Base Items and add it to or remove it from an Account. The Install Base item references the application service (CI). The CI it depends on should be one of the CIs affected. The CI should also be
referenced in the Alert to show that Install Base Item (and therefore the Account or Consumer) as affected.

- Create a proactive case from an alert and inform the customer service team of the service issue or outage.

Service owners can:

- View the customers who are subscribed to a service offering.

Customers can:

- View the install base items and details.
- View outages and service issues.
• View products they have purchased.
• Request services related to the products they have purchased.

Example CSM and CSDM use cases
The following diagrams are examples of typical CSM and CSDM use cases. These examples refer to the fictitious technology company, ACME, used in the earlier examples.

• Service with multiple packages
  Example: ACME offers a Credit Check Service to its enterprise customers who can purchase either the Platinum, Gold, or Silver offering.
• **Service with optional components**

Example: ACME offers a Billing Service to its enterprise customers who can purchase the bundle, or one or more of the component offerings (for example, invoices, payments, or discounts).

• **Service with a physical product**

Example: ACME offers a Digital Printing Solution to its customers who can purchase either the bundle or the printer along with one more service offerings (for example, Scan and Email, Monitoring)
• Service sold to multiple customers

Example: ACME sells a Pharmacy Manager Service to two customers: Boxeo and Avid Inc.

• Service used by multiple customers

Example: ACME deploys both Boxeo and Avid on the same production instance (multi-tenant model)
• Service used on-premise

Example: ACME offers an Order Management service. This purchase is tracked in ServiceNow but is used on-premise

Frequently asked questions (FAQs)

• What is a Service-aware Install Base?

A Service-aware Install Base enables companies to track the digital products and services in use. A Service-aware Install Base also tracks the relationships of the products and services to dependent services and CIs that affect their health.

• What are Proactive Customer Service Operations?

Proactive Customer Service Operations bring CSM and Event Management together to enable companies to proactively trigger case workflows and notify the affected customers.
• **Do I need to purchase CSM Professional package to use the Service-aware Install Base?**

No. The Service-aware Install Base is include in the CSM base system.

• **Can multiple sold products reference the same service offering?**

Yes. Multiple sold products (that is, Service Models) purchased by different companies can reference the same service offering. For example, multiple customers can purchase the same SaaS offering with same service commitments.

• **Can multiple Install Base Items reference the same application service?**

Yes. Multiple Install Base Items (either for the same account or for different accounts) can reference the same application service. For example, a multi-tenant SaaS offering where multiple customers (each with their own Install Base Item) are used on the same production instance (application service).

• **When do I create an incident rather than a proactive case from an alert?**

Typically, some companies create an incident so that their NOC engineers can resolving the issue. Once they determine that the issue impacts multiple customers, they also proactively create a major case and related child cases (one for each impacted customer) to notify the affected customers. Thus, the alert, incident, and case are all linked.

Updates made by the resolving teams to the incident status or additional comments are reflected in the case. The customer service teams use these updates to keep customers informed.

To meet the customer notification time requirements of the SLAs, companies may also automate creating incidents and cases from the alert. In addition, companies can also create a proactive case from the alert while the issue is being resolved.

• **What is the difference between entitlements managed at the CSDM Service Offering and the CSM Contracts and Entitlements?**

Service Commitments in CSDM define the expected level of a service. A service offering consists of a set of service commitments which uniquely define the service offerings. For example, a service offering may include a service commitment to perform a data backup each night.

Service contracts in CSM store information about the type of support that is provided to a customer. A contract can include an account or consumer, a contact, and the specific assets that are covered. A contract can also include multiple service entitlements and SLAs. An entitlement defines the type of support that a customer receives, as well as the supported communication
channels. For example, a customer may sign a service contract to receive support from 6:00 a.m. to 9:00 p.m. on weekdays.

- How can I request additional services based on the product that I've purchased?

The relationship between the product model and the catalog items enables you to use the customer portal to request additional services for the products you've purchased. Multiple catalog items can be associated with a product model.

- Do I need elements from all the CSDM domains to set up CSM?

No. The approach mentioned in this use case is based on the recommended guidelines and assumes you are in the Run or Fly stage of the CSDM implementation.

When you are implementing CSM, start with the tables in the CSDM Foundation domain and the CSM Customer Service domain. Using these domains enables you to leverage the capabilities included in CSM.

To enable the proactive customer service operations, use tables from the CSDM Manage Technical Services domain for monitoring the application services tied to the customers' install base. Using this domain enables you to leverage the CSM and ITOM integration.

Service-centric organizations can leverage the tables from the CSDM Sell/Consume domain to connect the product model to the service offerings and then to sold product. These connections so enable you to track the service portfolio and see a complete view of how customers are consuming these services.

**For more information**

For more information about the relevant CSM features and tasks, see the following links:

- Configure form views for Service Portfolio Management integration
- View product information from the Customer Service Portal
- Create a proactive case from an alert
- Create a case for install base from the Customer Service homepage
- Proactive Customer Service Operations
- Service health status for install base
- Configure install base
- Outage tracking for install base
- View install base information from the Customer Service Portal
View install base information in Agent Workspace
View product information from the Customer Service Portal
View sold product information in Agent Workspace

Configuration Management Database

With the ServiceNow® Configuration Management Database (CMDB) application, build logical representations of assets, services, and the relationships between them that comprise the infrastructure of your organization. Details about these components are stored in the CMDB which you can use to monitor the infrastructure, helping ensure integrity, stability, and continuous service operation.

Use core features such as CMDB Health, CMDB Identification and Reconciliation, and CMDB CI Lifecycle Management to monitor and detect health issues, reconcile data integrity issues, and manage data life cycle.

Note: CMDB modules, features, and wizards are not supported on mobile devices. You cannot use a mobile device to access the CI Class Manager, Query Builder, or Duplicate CI Remediator. Or to access or configure CMDB features such as Identification and Reconciliation, CMDB Health, CI Lifecycle Management, baseline CMDB, and proposed changes.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Upgrade to Rome</td>
<td>• Populating the CMDB</td>
<td>• Baseline CMDB</td>
</tr>
<tr>
<td>• Video: CMDB</td>
<td>Overview</td>
<td>• Whitepaper: CMDB Design &amp; Configuration</td>
</tr>
<tr>
<td>• Configuration Management and the CMDB</td>
<td>• Whitepaper: CMDB Design</td>
<td>• CMDB classifications</td>
</tr>
<tr>
<td>• CMDB Identification and Reconciliation</td>
<td>• Whitepaper: Improving Configuration Item Data Quality</td>
<td>• Video: CMDB Health dashboard</td>
</tr>
<tr>
<td>• CMDB Health</td>
<td>• Whitepaper: CMDB Design Guidance</td>
<td>• CMDB 101 - What is a configuration management database and why do you need one? (ServiceNow® Community post)</td>
</tr>
<tr>
<td>• CMDB Data Manager</td>
<td>• Activate the Extended CMDB plugins</td>
<td></td>
</tr>
<tr>
<td>• Domain separation in CMDB</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Use
- Create a CI class
- Create or edit a CI relationship
- Add a proposed change to a CI
- Querying the CMDB
- Apply CMDB remediation

### Develop
- CMDB APIs (CMDB SDK)
- CMDB CI Class Models store app
- Developer training
- Developer documentation

### Troubleshoot and get help
- Search the Known Error Portal for known error articles
- Contact Customer Service and Support

---

### Configuration Management and the CMDB

The Configuration Management data base (CMDB) creates and maintains the logical configurations your network infrastructure needs to support a ServiceNow service.

These logical service configurations are mapped to the physical layout data of the supporting network and application infrastructure in each of your respective domains. They track the physical and logical state of IT service elements and associate incidents to the state of service elements, which helps in analyzing trends and reducing problems and incidents.

The configurations are stored in a configuration management database (ServiceNow CMDB) which consists of entities, called Configuration Items (CI), that are part of your environment. A CI may be:

- A physical entity, such as a computer or router
- A logical entity, such as an instance of a database
- Conceptual, such as a Requisition Service

In each case, there are attributes about the CI that you want to maintain, and there is control you want to have over the CI. There are changes that may need to be made and tracked against the CI. Also, a CI does not exist on its own. CIs have dependencies and relationship with other CIs. For example, the loss of disk drives may take a database instance down, which affects the requisition service that the HR department uses to order equipment for new employees.

It is this relationship data that makes the CMDB a powerful decision support tool. Understanding the dependencies and other relationships among your CIs
can tell you, for example, exactly who and what is affected by the loss of that bank of disk drives. When you find out that a router has failed, you will be able to assess the effect of that outage. When you decide to upgrade the processor in a server, you can tell who or what will be affected during the outage.

Configuration items differ from environment to environment because each customer has unique needs. Details about the exact physical attributes of a computer may be needed by one customer, but may represent meaningless data to another. The NOW Platform provides a mechanism to easily define new classes of configuration items and new relationships that may exist between CIs. New classes can be defined that extend other classes. For example, a laptop class exists that extends the computer class. The computer class itself extends the base CI class. Customer class extensions are automatically part of the ServiceNow environment and blend seamlessly into the integration points for other ITIL processes.

You can for example, set the `Used for` attribute in the `cmdb_ci_server` table to a value such as ‘development’, ‘test’, or ‘production’. These values indicate the environment that the CI is supporting, and serve as a way of tracking a CI through its lifecycle in a changing environment.

**CI Class Manager**

Use the CI Class Manager to manage CMDB classes, CMDB Health, and other class-related definitions. For example, in the CI Class Manager you can view class attributes, class identification rules, and the list of CIs for a specific class. To view the list of CIs in the CMDB, you can also enter `cmdb_ci_list.do` in the filter navigator.

**Architecture**
Roles required
Reading CMDB tables directly requires the cmdb_read role, however accessing the Configuration module requires the asset, itil, or itil_admin roles. For viewing CMDB-related records in the user interface, the itil role is usually sufficient. For updating records and for other manipulation of records, roles with higher credentials are usually required, as noted in each procedure throughout the documentation set.

Related information
CMDB schema model

Domain separation and Configuration Management Database (CMDB)
Domain separation is supported in the Configuration Management Database (CMDB). Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Standard
- Includes Basic level support.
- Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see Application support for domain separation.

Overview
The following topics provide details about domain separation in Configuration Management (CMDB) modules:
- Domain separation in CMDB Health
- Domain separation and CMDB Query Builder
- Domain separation and CMDB Identification and Reconciliation
• Domain separation and the relations formatter and the CI relationship editor
• CMDB APIs (CMDB SDK)

Related information

Domain separation and Configuration Management Database (CMDB)

ITIL and Configuration Management

The CMDB has relationships with IT service management processes in the following areas: ITIL incident management, ITIL problem management, ITIL change management, ITIL service catalog management, and financial management.

ITIL Incident Management

Configuration management assists Incident Management by providing the Service Desk with immediate information on the CIs affected, and more timely resolution of faults by understanding what CIs have been affected and changed.

ITIL Problem Management

Configuration Management assists Problem Management by linking the CIs affected by problems to the Incident / Problem / Change Management processes, and ensuring the CI status is properly maintained.

ITIL Change Management

Configuration Management assists Change Management by recording which CIs have been changed and controlling the status of CIs throughout the entire CI lifecycle. Configuration Management ensures that any changes made to CIs are recorded and kept accurate. Configuration Management is also used in the integration of Change Management with the DiscoverNow Discovery feature.

ITIL Service Catalog Management

With Service Portfolio Management, business services in the CMDB can also be managed by the Service Catalog team, and exposed to end users who can then request items from them.

Financial Management

With Cost Management, costs can be associated with configuration items, so that the cost associated with Configuration Management can be tracked and bundled into expense lines, budgets, or cost centers.
**IT4IT**

IT4IT provides reference architecture about the implementation of ITIL strategy. For more information, see the Now Community blog *Running IT as a Business using IT4IT and ServiceNow*.

**Related information**
- Configuration Management Database

**ITIL**

The IT Infrastructure Library (ITIL) is an integrated, process-based framework for managing IT services.

It provides guidance for creating and operating a Service Desk that provides efficient communication between the user community and the IT provider. Originally initiated to improve IT service management for the UK central government, it has become a standard for many organizations; public or private sector, large or small, centralized, or distributed.

ITIL provides processes for three service concepts: design, transition, and operation.

<table>
<thead>
<tr>
<th>Service concept</th>
<th>Processes</th>
</tr>
</thead>
</table>
| Design          | • service level management  
                  • availability management  
                  • capacity management  
                  • supplier management  
                  • service catalog management |
| Transition      | • change management  
                  • knowledge management  
                  • asset management  
                  • configuration management  
                  • release management |
| Operation       | • request fulfillment management  
                  • event management  
                  • incident management |
Watch this 11-minute video for an overview of the ITIL role including the ITSM process, capabilities of ITIL users, working on incidents and problems, change requests, and the Incident Overview dashboard. Overview of incident management, problem management, and change management components of the information technology service management (ITSM) process.

**Service design**
This guide provides a general overview of ITIL service design concepts.

**Service level management**
The service level management process is designed to ensure customer satisfaction within IT service processes. Service level agreements are made between the IT staff and the customers, and the IT desk must monitor their performance as compared to the agreements. In addition, underpinning contracts with external vendors and operational level agreements with internal vendors ensures that these service level agreements are feasible.

**Availability management**
The availability management process ensures that availability within a system is kept as close to 100% as possible. By both reacting to past service failures, and planning to avoid future service failures, availability management can greatly increase end-user satisfaction with services.

**Capacity management**
The capacity management process is designed to ensure that business services are not made unavailable by over-capacity. By analyzing past failures and planning for growth of demand of services, capacity management can increase end-user satisfaction with services.

**Supplier management**
Supplier management is a process that defines and monitors agreements between an IT department and an external supplier.
Service catalog management
The service catalog provides a front end for customers to request items and services. Service catalog management ensures that this service catalog provides accurate and useful information on the items and services.

Related information
- Service Catalog Management
- Service Level Management

Service transition
This guide provides a general overview of ITIL service transition concepts and how the Now Platform can enable these processes.

Change management
The change management process ensures that standardized methods and procedures are used for efficient and prompt handling of all changes to minimize the impact of change related incidents on service quality. Consequently, change management aims to improve the day-to-day operation of the organization. IT-related changes that may affect one or many customers are tracked with change management. Adding memory to one machine, getting a new server, and installing the latest Windows OS on all PCs are all examples. To find out how the ServiceNow platform implements change management, see Change Management.

Knowledge management
The knowledge management process ensures that important information flows freely throughout the IT organization. Knowledge management keeps the CMDB and knowledge base of an organization up-to-date, and uses a knowledge-centered support approach to reduce repeat incidents and problems. For more information on how the ServiceNow platform implements knowledge management, see Knowledge Management.

Asset management
Asset management enables a process of monitoring processes, organizations, people, information, applications, infrastructure, and financial capital within an organization. This allows the organization to collect accurate records of these business components, making them available for both internal and external auditing processes. To find out how the Now Platform implements asset management, see Asset Management.
Configuration management

Configuration management provides a logical model of the infrastructure or a service by identifying, controlling, maintaining and verifying the Configuration Items in existence. To find out how the Now Platform implements configuration management, see Configuration Management Database.

Release management

This discipline of IT service management is the management of all software configuration items within the organization. It is responsible for the management of software development, installation and support of an organization’s software products. Software Control & Distribution procedures include the management of the software Configuration Items and their distribution and implementation into a production environment. This involves the definition of a release program suitable for the organization, the definition of how version control is implemented, and the procedures surrounding how software is built, released and audited. To find out how the Now Platform implements release management, visit Release Management.

CMDB schema model

The Configuration Management Database (CMDB) schema model is a series of connected tables that contain all the assets and business services controlled by a company and its configurations.

Related ServiceNow® Store apps and reference information:

- **CMDB tables descriptions**: Descriptions of key CMDB tables in the base system.
- **CMDB CI Class Models**: A ServiceNow Store app that adds class models that extend the base CMDB class hierarchy. This includes class descriptions, identification rules, identifier entries, and dependent relationships if applicable. You can then use the added classes as any other CMDB base class.
- **Populating the CMDB**: Information about the various options for populating the CMDB.
- **Discovery patterns**: A ServiceNow Store app that provides a library of Discovery patterns for discovering specific devices and applications in the industry.
- **Service Graph connectors**: ServiceNow Store apps that provide pre-defined integrations for importing and integrating common third-party data into CMDB classes. Also includes the IntegrationHub ETL wizard for creating new ETL transform maps.
CMDB tables contain information about computers and devices on the network, software contracts and licenses, business services, and so on. The IT desk can use the CMDB to better understand their network users' equipment, and the relationships between them. The CMDB can also be referenced by other processes within the system.

Applications such as Asset Management and Contract Management, operate in conjunction with the CMDB. Asset Management and Software Asset Management link to CMDB all assets, hardware, software, assets in stock, as well as records for manufacturers and vendors. The Contract Management application contains information about contracts, including leases, service contracts, purchase orders, warranties, and software licenses. The Configuration Management Database (CMDB) application has a focus on operation.

For more background information about the CMDB, see the Now Community post) at CMDB 101- What is a configuration management database and why do you need one?.

**Key CMDB tables**

Key tables in the configuration management database (CMDB):

- The Base Configuration Item [cmdb] table, which is the core CMDB table for non IT CIs (descending classes are non IT CIs).
- The core Configuration Item [cmdb_ci] table, which stores the basic attributes of all the CIs. The admin, itil, or asset user role is required to access this table (descending classes are IT CIs).
- The CI Relationship [cmdb_rel_ci] table, which defines all relationships between CIs.

The Configuration Item table is extended to other tables, such as Database [cmdb_ci_database] and Computer [cmdb_ci_computer]. The Computer table is extended to the Server [cmdb_ci_server] table, which is extended to the UNIX Server [cmdb_ci_unix_server] table, and so on.

**Note:** The Base Configuration Item [cmdb] table uses the table per partition extension model, which has different behaviors for replicating and deriving information than other extended tables. See Table extension and classes.

You can use the schema map to view more details of tables and their relationships:

1. Navigate to **System Definition > Tables & Columns**.
2. Select a table and click **Schema Map**.
Note: CIs not extended from the Configuration Item [cmdb_ci] table, are not displayed in Dependency Views maps and in CI relation formaters.

CI attributes
Attributes apply to all the CIs in a classification. To change attribute values for a CI, edit the appropriate CI. To add a unique attribute to a class, extend the class table and create a new classification for that CI.

The position of a CI in a classification hierarchy is determined by the attributes it shares with the CIs below it. Each time a CI has a single different attribute from its parent, the classification hierarchy branches.

For example, servers have different attributes from computers, which include workstations and laptops. Linux servers and UNIX servers have different attributes from the parent server classification and from each other, so they occupy separate branches in the hierarchy.

CMDB tables descriptions
List of all the tables in the CMDB in a base system, and for each table, its name, label, and a description of the type of information that is stored in the table.
You can extend tables in a base system by installing a CMDB CI Class Models store app which adds class models that support specific technologies. These extensions include class definitions, identification rules, identifier entries, and dependent relationships if applicable. For more information, see CMDB CI Class Models store app.

<table>
<thead>
<tr>
<th>Table name</th>
<th>Table label</th>
<th>Table description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cmdb_ci</td>
<td>Configuration Item</td>
<td>Base configuration item table.</td>
</tr>
<tr>
<td>cmdb_ci_acc</td>
<td>Accessory</td>
<td>Accessories for phones, computers, and so on.</td>
</tr>
<tr>
<td>cmdb_ci_ad_controller</td>
<td>Active Directory Domain Controller</td>
<td>Microsoft Active Directory domain controller.</td>
</tr>
<tr>
<td>cmdb_ci_ad_domain</td>
<td>AD Domain</td>
<td>Microsoft Active Directory domain.</td>
</tr>
<tr>
<td>cmdb_ci_aix_server</td>
<td>AIX Server</td>
<td>Server running the AIX operating system.</td>
</tr>
<tr>
<td>cmdb_ci_alias</td>
<td>Alias</td>
<td>Pseudonym for data locations, virtual email addresses, pointers, and so on.</td>
</tr>
<tr>
<td>cmdb_ci_apache_web_server</td>
<td>Apache Web Server</td>
<td>Server hosting Apache web server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl</td>
<td>Application</td>
<td>Application, which is a collection of files and data that deliver a service and manage business processes.</td>
</tr>
<tr>
<td>cmdb_ci_application_cluster</td>
<td>Application Cluster</td>
<td>Logical group of servers with clustering software installed on each of the servers in the group so that the group acts like a single system.</td>
</tr>
<tr>
<td>cmdb_ci_application_software</td>
<td>Application Software</td>
<td>Computer program, which is designed to</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_app_server</td>
<td>Application Server</td>
<td>A base table for logical CIs, which indicate the primary function of a physical or virtual server such as a Tomcat server or a WebSphere server.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_composer</td>
<td>Composer</td>
<td>Server hosting IBM WebSphere Multichannel Bank Transformation Toolkit.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_datapower</td>
<td>DataPower</td>
<td>Server hosting IBM DataPower Gateway Secure software.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_domino</td>
<td>Domino</td>
<td>Server hosting IBM Domino software.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_hp_uCMDB</td>
<td>uCMDB</td>
<td>Server hosting HP uCMDB software.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_java</td>
<td>JavaServer</td>
<td>Server hosting Java application.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_jb_module</td>
<td>Delivery Controller</td>
<td>Server hosting inner module of JBoss application (deployed application).</td>
</tr>
<tr>
<td>cmdb_ci_app_server_jboss</td>
<td>JBoss</td>
<td>Server hosting JBoss Application Server (JBoss AS), which is a cross-platform Java application server, open-source developed by JBoss software company.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_jrun</td>
<td>Jrun</td>
<td>Server hosting JRun application.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_app_server_jrun_war</td>
<td>Jrun WAR</td>
<td>Server hosting the inner module of JRun application (deployed application).</td>
</tr>
<tr>
<td>cmdb_ci_app_server_ora_ess</td>
<td>Oracle Essbase Server</td>
<td>Server hosting Oracle Essbase software.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_ora_ias</td>
<td>Oracle iAS</td>
<td>Server hosting Oracle Internet Application Server.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_ora_ias_web_module</td>
<td>Oracle iAS Web module</td>
<td>Server hosting the inner module of Oracle iAS application (deployed application).</td>
</tr>
<tr>
<td>cmdb_ci_app_server_remedy</td>
<td>Remedy HSServer</td>
<td>Server hosting Remedy HSServer application.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_tomcat</td>
<td>Tomcat</td>
<td>Server hosting Apache Tomcat software.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_tomcat_war</td>
<td>Tomcat WAR</td>
<td>Server hosting inner module of Apache Tomcat application (deployed application).</td>
</tr>
<tr>
<td>cmdb_ci_app_server_vendavo</td>
<td>Vendavo Application Server</td>
<td>Server hosting Vendavo Application Server software.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_weblogic</td>
<td>WebLogic</td>
<td>Server hosting Oracle WebLogic Server.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_webseal</td>
<td>Webseal</td>
<td>Server hosting IBM Tivoli Access Manager solution.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_websphere</td>
<td>Websphere</td>
<td>Server hosting IBM WebSphere software.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_wl_module</td>
<td>WeblogicModule</td>
<td>Server hosting inner module of Tomcat.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_app_server_ws_ear</td>
<td></td>
<td>Server hosting inner module of IBM WebSphere software.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_ws_odr</td>
<td></td>
<td>Server hosting WebSphere ODR LB application.</td>
</tr>
<tr>
<td>cmdb_ci_appl_active_directory</td>
<td>Active Directory Service</td>
<td>Inner software module of AD Domain application.</td>
</tr>
<tr>
<td>cmdb_ci_appl_biztalk</td>
<td>BizTalk</td>
<td>Microsoft BizTalk Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_biztalk_orch</td>
<td>BizTalk Orchestration</td>
<td>Inner module of Microsoft Biztalk Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ca</td>
<td>CA Enterprise Communicator</td>
<td>CA Enterprise Communicator software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ca_ent_manager</td>
<td>CA Introscope Enterprise Manager</td>
<td>CA introscope Enterprise Manager software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ca_id_man</td>
<td>CA Identity Manager Provisioning Server</td>
<td>CA Identity Manager Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_cisco_call</td>
<td>Cisco CallManager</td>
<td>Cisco CallManager (Cisco Unified Communications Manager) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_cisco_fibre</td>
<td>Cisco Fibre InterConnect software.</td>
<td></td>
</tr>
<tr>
<td>cmdb_ci_appl_citrix_app</td>
<td>Citrix Application Icon</td>
<td>Inner module of Citrix software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_citrix_collector</td>
<td>Citrix Collector</td>
<td>Citrix Collector software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_citrix_xenapp</td>
<td>Citrix XenAPP or Presentation Server</td>
<td>Citrix XenApp software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_connectit</td>
<td>Connect-It Service</td>
<td>Connect-It software.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_appl_controlm</td>
<td>Control-M</td>
<td>Control-M software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_delivery_controller</td>
<td>Delivery Controller</td>
<td>Application delivery controller software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_doc_brava_job_processor</td>
<td>Documentum Brava Job Processor</td>
<td>Brava (EMC Documentum) job processor software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_doc_brava_license_server</td>
<td>Documentum Brava License Server</td>
<td>Brava (EMC Documentum) License Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_doc_docbase</td>
<td>Docbase</td>
<td>Documentum Docbase software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_doc_docbroker</td>
<td>Docbase broker</td>
<td>Documentum Docbase broker software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_dot_net</td>
<td>.NET Application</td>
<td>Microsoft .NET application software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_fastsearch</td>
<td>Fast Search</td>
<td>Microsoft FAST Search software (for the SharePoint collaboration platform).</td>
</tr>
<tr>
<td>cmdb_ci_appl_generic</td>
<td>Generic Application</td>
<td>Generic application, which is identified by the system when there is an endpoint with an open port in listen mode and there is no pattern for it.</td>
</tr>
<tr>
<td>cmdb_ci_appl_glassfish</td>
<td>GlassFish</td>
<td>Oracle GlassFish Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_glassfish_war</td>
<td>GlassFish WAR</td>
<td>Inner module of GlassFish application (deployed application).</td>
</tr>
<tr>
<td>cmdb_ci_appl_groundwork</td>
<td>Groundwork</td>
<td>Groundwork (open source) monitoring software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_hp_index</td>
<td>HP SM Index Server</td>
<td>HP Service Manager Index Server software.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_appl_hp_operations</td>
<td>Operations Manager</td>
<td>HP Operations Manager software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_hp_qc</td>
<td>HP Quality Center</td>
<td>HP Quality Center software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_hp_service</td>
<td>HP Service Manager</td>
<td>HP Service Manager software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_hp_sm_kb</td>
<td>HP SM KnowledgeBase</td>
<td>HP Service Manager KnowledgeBase software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ibm_cics</td>
<td>IBM CICS</td>
<td>IBM CICS Transaction Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ibm_ctg</td>
<td>IBM CTG</td>
<td>IBM CICS Transaction Gateway software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ibm_wmb</td>
<td>IBM WebSphere Message Broker</td>
<td>IBM WebSphere Message Broker software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ibm_wmb_listener</td>
<td>IBM WMB Http Listener</td>
<td>IBM WebSphere HTTP Listener software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ibm_wmq</td>
<td>IBM WebSphere MQ</td>
<td>IBM Websphere MQ software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ibm_wmq_queue</td>
<td>IBM WebSphere MQ Queue</td>
<td>Inner module of IBM WebSphere MQ software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_itam</td>
<td>ITAM Asset Center</td>
<td>HP Asset Center software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_mongo_config_serv</td>
<td>Mongo Config Server</td>
<td>Mongo Configuration Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_mongos</td>
<td>Mongos Server</td>
<td>MongoDB server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ms_dynamics</td>
<td>Dynamic CRM Component</td>
<td>Microsoft Dynamic CRM software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_msmq</td>
<td>MSMQ</td>
<td>Microsoft Message Queuing (MSMQ) software.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_conc</td>
<td>Oracle Concurrent Server</td>
<td>Oracle Concurrent Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_disc</td>
<td>Oracle Discoverer Engine</td>
<td>Oracle Discoverer software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_disc_ui</td>
<td>Oracle Discoverer UI</td>
<td>Oracle Discoverer UI module software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_ebs</td>
<td>Oracle ESB</td>
<td>Oracle Enterprise Service Bus software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_forms</td>
<td>Oracle Forms Engine</td>
<td>Oracle Forms software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_forms_ui</td>
<td>Oracle Forms UI</td>
<td>Oracle Forms UI software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_fs</td>
<td>Oracle Fulfillment Server</td>
<td>Oracle Fulfillment Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_http</td>
<td>Oracle HTTP Server</td>
<td>Oracle HTTP Server software (web tier of Oracle Fusion middleware).</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_jms_queue</td>
<td>Oracle Weblogic JMS Queue</td>
<td>Oracle WebLogic JMS software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_metric_client</td>
<td>Oracle Metric Client</td>
<td>Oracle Metric client software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_metric_server</td>
<td>Oracle Metric Server</td>
<td>Oracle Metric server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_notif_svr</td>
<td>Oracle Notification Server</td>
<td>Oracle Notification Server (ONS) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_oacore</td>
<td>Oracle OACORE Server</td>
<td>Oracle OACORE server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_oafm</td>
<td>Oracle OAFM Server</td>
<td>Oracle OAFM server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_pm</td>
<td>Oracle Process Manager</td>
<td>Oracle BPEL Process Manager server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_queue</td>
<td>Advanced Queue Queue</td>
<td>Oracle Advanced Queuing software.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_appl_oracle_tns</td>
<td>Oracle App TNS Service</td>
<td>Oracle Application Express (TNS) listener software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_oracle_tnslnsr</td>
<td>Oracle TNS Listener Engine</td>
<td>Oracle Application Express software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_peoplesoft</td>
<td>Peoplesoft Application Server</td>
<td>Peoplesoft Application Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_rabbitmq</td>
<td>RabbitMQ</td>
<td>RabbitMQ (open source) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_rabbitmq_cluster</td>
<td>RabbitMQ Cluster</td>
<td>RabbitMQ Cluster (open source) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_ascs</td>
<td>SAP ASCS Application</td>
<td>SAP ASCS software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_bo_scheduler</td>
<td>SAP BOXIScheduleRouter</td>
<td>SAP BO BOXIScheduleRouter software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_bus_obj</td>
<td>SAP Business Objects</td>
<td>SAP business Object application.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_ci</td>
<td>SAP CI Application</td>
<td>The SAP Central Instance software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_di</td>
<td>SAP DI Application</td>
<td>Oracle Development Infrastructure (DI) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_ers</td>
<td>SAP ERS Application</td>
<td>Oracle Evaluated Receipt Settlement (ERS) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_hana</td>
<td>SAP Hana Db</td>
<td>SAP HANA software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_jc</td>
<td>SAP JC Application</td>
<td>SAP JC (java application) software.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_scs</td>
<td>SAP SCS Application</td>
<td>SAP SCS (central services) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_server</td>
<td>SAP Application Server</td>
<td>SAP NetWeaver Application Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_system</td>
<td>SAP System</td>
<td>SAP ERP software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sendmail</td>
<td>Sendmail</td>
<td>Sendmail (open source) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sharepoint</td>
<td>Microsoft SharePoint</td>
<td>Microsoft SharePoint software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sp_service</td>
<td>SharePoint Service</td>
<td>Microsoft Windows Sharepoint Services (WSS) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_tibco_hawk</td>
<td>Tibco Hawk</td>
<td>TIBCO Hawk software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_tibco_message</td>
<td>Tibco Enterprise Message Service</td>
<td>TIBCO Enterprise Message Service software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_tibco_queue</td>
<td>Tibco EMS Queue</td>
<td>Tibco EMS (Enterprise Message Service) Queues software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_tuxedo</td>
<td>Tuxedo</td>
<td>Tuxedo software (middleware transactions for Unix, Extended for Distributed Operations).</td>
</tr>
<tr>
<td>cmdb_ci_appl_tuxedo_portal</td>
<td>Tuxedo Portal</td>
<td>Tuxedo portal software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_vign_content</td>
<td>Vignette Content Management Server</td>
<td>Vignette (Open Text Corp) Content Management Server software.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_appl_vignette_search</td>
<td>Vignette Search Starter</td>
<td>Vignette (Open Text Corp) Search Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_vignette_server</td>
<td>Vignette Server</td>
<td>Vignette (Open Text Corp) Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_weblogic_jms</td>
<td>Weblogic JMS Server</td>
<td>WebLogic JMS software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_weblogic_lb</td>
<td>Weblogic LB</td>
<td>WebLogic Server load balancer software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_weblogic_module</td>
<td>Weblogic Module Server</td>
<td>WebLogic Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_websphere</td>
<td>WebSphere Portal</td>
<td>WebSphere Portal software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_wmb</td>
<td>WMB Flow</td>
<td>WebSphere Message Broker software.</td>
</tr>
<tr>
<td>cmdb_ci_application_cluster</td>
<td>Application Cluster</td>
<td>Logical cluster of application-tier servers.</td>
</tr>
<tr>
<td>cmdb_ci_application_software</td>
<td>Application Software</td>
<td>Computer program designed to perform a group of coordinated functions, tasks, or activities for the benefit of the user.</td>
</tr>
<tr>
<td>cmdb_ci_application_software</td>
<td>Application Software</td>
<td>An extension of the Software table, providing installed software information (not a running process).</td>
</tr>
<tr>
<td>cmdb_ci_ats_power_eq</td>
<td>Automatic Transfer Switch</td>
<td>Electrical power switch that switches a load between two sources.</td>
</tr>
<tr>
<td>cmdb_ci_availability_set</td>
<td>Availability Set</td>
<td>Logical grouping of virtual machines running on Microsoft Azure platform.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------</td>
<td>------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_batch_job</td>
<td>Batch Job</td>
<td>A computer program or set of programs processed in batch mode.</td>
</tr>
<tr>
<td>cmdb_ci_aws_datacenter</td>
<td>AWS datacenter</td>
<td>Logical representation of an Amazon Web Services datacenter.</td>
</tr>
<tr>
<td>cmdb_ci_azure_datacenter</td>
<td>Azure datacenter</td>
<td>Logical representation of a Microsoft Azure datacenter.</td>
</tr>
<tr>
<td>cmdb_ci_business_process</td>
<td>Business Process</td>
<td>A process that is owned and carried out by the business and contributes to the delivery of a product or business service to a business customer.</td>
</tr>
<tr>
<td>cmdb_ci_chassis_server</td>
<td>Server Chassis</td>
<td>A metal structure that is used to house or physically assemble servers in various different form factors.</td>
</tr>
<tr>
<td>cmdb_ci_cim_profile</td>
<td>CIM Profiles</td>
<td>CIM Profiles (UML).</td>
</tr>
<tr>
<td>cmdb_ci_cim_server</td>
<td>CIM Server</td>
<td>Server hosting CIM profiles.</td>
</tr>
<tr>
<td>cmdb_ci_circuit</td>
<td>Circuit</td>
<td>Electrical circuits information.</td>
</tr>
<tr>
<td>cmdb_ci_cloud_database</td>
<td>Cloud Database</td>
<td>Database which runs on a cloud computing platform.</td>
</tr>
<tr>
<td>cmdb_ci_cloud_ip_address</td>
<td>Cloud IP Address</td>
<td>Web server which runs on a cloud computing platform.</td>
</tr>
<tr>
<td>cmdb_ci_cluster</td>
<td>Cluster</td>
<td>Logical group of computing resources bound together by</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_cluster_node</td>
<td>Cluster Node</td>
<td>Single computing resource which is logically/operationally bound into a cluster.</td>
</tr>
<tr>
<td>cmdb_ci_cluster_resource</td>
<td>Cluster Resource</td>
<td>System object that is a set or grouping of cluster resources that are used to manage events that occur in a clustered environment.</td>
</tr>
<tr>
<td>cmdb_ci_cluster_vip</td>
<td>Cluster Virtual IP</td>
<td>Cluster VIP information.</td>
</tr>
<tr>
<td>cmdb_ci_comm</td>
<td>Communication Device</td>
<td>Communication devices information. A choice list containing devices such as cellphone, phone, conference phone, and Wi-Fi.</td>
</tr>
<tr>
<td>cmdb_ci_computer</td>
<td>Computer</td>
<td>An extension of the Hardware table, capturing computer properties.</td>
</tr>
<tr>
<td>cmdb_ci_computer_room</td>
<td>Computer Room</td>
<td>Logical representation of a computer room.</td>
</tr>
<tr>
<td>cmdb_ci_config_file</td>
<td>Configuration file</td>
<td>Configuration files which establish the parameters and initial settings for some computer programs.</td>
</tr>
<tr>
<td>cmdb_ci_crac</td>
<td>Computer Room AC</td>
<td>Air conditioning units used to cool data centers.</td>
</tr>
<tr>
<td>cmdb_ci_csu_dsu_network</td>
<td>CSU/DSU</td>
<td>Digital-interface device used to connect</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_database</td>
<td>Database</td>
<td>Organized collection of data such as the set of files where data is stored, the reason for a database, and the metadata about the data.</td>
</tr>
<tr>
<td>cmdb_ci_datacenter</td>
<td>Data Center</td>
<td>Facility used to house computer systems and associated components, such as telecommunications and storage systems. It generally includes redundant or backup power supplies, redundant data communications connections, environmental controls (such as air conditioning and fire suppression), and various security devices.</td>
</tr>
<tr>
<td>cmdb_ci_datapower_server</td>
<td>Data Power Hosting Server</td>
<td>Server running IBM DataPower Gateway software.</td>
</tr>
<tr>
<td>cmdb_ci_db_catalog</td>
<td>Database Catalog</td>
<td>Metadata which defines database objects such as base tables, views (virtual tables), synonyms, value ranges, indexes, users, and user groups, for a specific database instance.</td>
</tr>
<tr>
<td>cmdb_ci_db_db2_catalog</td>
<td>DB2 Catalog</td>
<td>Database catalog for DB2 database.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_db_db2_instance</td>
<td>DB2 Instance</td>
<td>Instance of a DB2 database.</td>
</tr>
<tr>
<td>cmdb_ci_db_hbase_instance</td>
<td>HBase Instance</td>
<td>Instance of an HBase database.</td>
</tr>
<tr>
<td>cmdb_ci_db_instance</td>
<td>Database Instance</td>
<td>Software and memory used to manipulate data in a database.</td>
</tr>
<tr>
<td>cmdb_ci_db_mongodb_instance</td>
<td>MongoDB Instance</td>
<td>Instance of a MongoDB database.</td>
</tr>
<tr>
<td>cmdb_ci_db_mssql_analysis_services</td>
<td>SQL Server Analysis Services</td>
<td>Microsoft SQL Server Analysis Services software.</td>
</tr>
<tr>
<td>cmdb_ci_db_mssql_catalog</td>
<td>MSFT SQL Catalog</td>
<td>Database catalog for a specific instance of a Microsoft SQL database.</td>
</tr>
<tr>
<td>cmdb_ci_db_mssql_int_job</td>
<td>SQL Server Integration Services Job</td>
<td>Scheduled job to run a SQL Server Integration Service package.</td>
</tr>
<tr>
<td>cmdb_ci_db_mssql_integration</td>
<td>SQL Server Integration Services</td>
<td>MSQl Server Integration Services software.</td>
</tr>
<tr>
<td>cmdb_ci_db_mssql_reporting</td>
<td>SQL Server Reporting Services</td>
<td>SQL Server software used for server-based reporting generation.</td>
</tr>
<tr>
<td>cmdb_ci_db_mssql_server</td>
<td>MS SQL Server</td>
<td>Microsoft SQL Server.</td>
</tr>
<tr>
<td>cmdb_ci_db_mysql_catalog</td>
<td>MySQL Catalog</td>
<td>Database catalog for a specific instance of a MySQL database.</td>
</tr>
<tr>
<td>cmdb_ci_db_mysql_cluster_mgmtnode</td>
<td>MySQLClusterMGMNode</td>
<td>MySQL primary administrative interface to a running cluster.</td>
</tr>
<tr>
<td>cmdb_ci_db_mysql_cluster_data</td>
<td>MySQLClusterDataNode</td>
<td>Summary table used in the [ndbd] or [ndbd default] sections of a config.ini file for</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_db_mysql_instance</td>
<td>MySQL Instance</td>
<td>Instance of a MySQL database.</td>
</tr>
<tr>
<td>cmdb_ci_db_ora_catalog</td>
<td>Oracle Catalog</td>
<td>Database catalog for a specific instance of an Oracle database.</td>
</tr>
<tr>
<td>cmdb_ci_db_ora_instance</td>
<td>Oracle Instance</td>
<td>Instance of an Oracle database.</td>
</tr>
<tr>
<td>cmdb_ci_db_ora_listener</td>
<td>Oracle Database Listener</td>
<td>Process that runs on an Oracle Database Server.</td>
</tr>
<tr>
<td>cmdb_ci_db_postgresql_instance</td>
<td>PostgreSQL Instance</td>
<td>Instance of a PostgreSQL database.</td>
</tr>
<tr>
<td>cmdb_ci_db_syb_catalog</td>
<td>Sybase Catalog</td>
<td>Database catalog for a specific instance of a Sybase database.</td>
</tr>
<tr>
<td>cmdb_ci_db_syb_instance</td>
<td>Sybase Instance</td>
<td>Instance of a Sybase database.</td>
</tr>
<tr>
<td>cmdb_ci_desktop_software</td>
<td>Desktop Software</td>
<td>Software used on desktops and laptops.</td>
</tr>
<tr>
<td>cmdb_ci_dir_policy_server</td>
<td>Policy Server</td>
<td>Policy server, which provides a security component of a policy-based network that provides authorization services and facilitates tracking and control of files.</td>
</tr>
<tr>
<td>cmdb_ci_dir_site_minder</td>
<td>SiteMinder</td>
<td>Server running SiteMinder software.</td>
</tr>
<tr>
<td>cmdb_ci_directory_ad_forest</td>
<td>AD Forest</td>
<td>Active Directory forest.</td>
</tr>
<tr>
<td>cmdb_ci_directory_ha</td>
<td>HA Proxy</td>
<td>HAPProxy software.</td>
</tr>
<tr>
<td>cmdb_ci_directory_iifp</td>
<td>IIFP</td>
<td>Identity Identification Feature Pack (Active Directory) software.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_directory_server</td>
<td>Directory Server</td>
<td>Server running LDAP software.</td>
</tr>
<tr>
<td>cmdb_ci_disk</td>
<td>Disk</td>
<td>General category of data storage mechanisms.</td>
</tr>
<tr>
<td>cmdb_ci_disk_partition</td>
<td>Disk Partition</td>
<td>Sections of a disk separated so that information in each section can be managed separately.</td>
</tr>
<tr>
<td>cmdb_ci_display_hardware</td>
<td>Display Hardware</td>
<td>Hardware used to display information in visual form.</td>
</tr>
<tr>
<td>cmdb_ci_dns_alias</td>
<td>DNS Alias</td>
<td>Synonym for the host used to resolve DNS addresses.</td>
</tr>
<tr>
<td>cmdb_ci_dns_name</td>
<td>DNS Name</td>
<td>Primary DNS names.</td>
</tr>
<tr>
<td>cmdb_ci_docker</td>
<td>Docker Container</td>
<td>Docker containers (a runtime instance of a docker image).</td>
</tr>
<tr>
<td>cmdb_ci_docker_engine</td>
<td>Docker Engine</td>
<td>Docker software for running and managing Docker containers.</td>
</tr>
<tr>
<td>cmdb_ci_docker_image</td>
<td>Docker Image</td>
<td>Docker images. Ordered collection of root filesystem changes and the corresponding execution parameters for use within a container runtime.</td>
</tr>
<tr>
<td>cmdb_ci_docker_image_tag</td>
<td>Docker Image Tag</td>
<td>Docker tag, which is a label applied to a</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_docker_local_image</td>
<td>Docker Local Image</td>
<td>Docker image in a repository.</td>
</tr>
<tr>
<td>cmdb_ci_drs_vm_config</td>
<td>DRS VM Config</td>
<td>Distributed Resource Scheduler (DRS) behavior for the VMs in the vCenter that override the cluster behavior.</td>
</tr>
<tr>
<td>cmdb_ci_ec2_instance</td>
<td>EC2 Virtual Machine Instance</td>
<td>Virtual machine running in the Amazon Elastic Compute Cloud (EC2) platform.</td>
</tr>
<tr>
<td>cmdb_ci_email_server</td>
<td>Email Server</td>
<td>Server running email software.</td>
</tr>
<tr>
<td>cmdb_ci_email_server_jes</td>
<td>JES</td>
<td>Server running JES software (multi-featured hybrid MTA/MDA server).</td>
</tr>
<tr>
<td>cmdb_ci_endpoint</td>
<td>Endpoint</td>
<td>Endpoint, which represents the entry point to a service, a process, or a queue or topic destination in service-oriented architecture.</td>
</tr>
<tr>
<td>cmdb_ci_environment</td>
<td>Environment</td>
<td>Logical grouping of hardware and software used to develop, test, and deliver computing services. For example: development, test, quality assurance, and production.</td>
</tr>
<tr>
<td>cmdb_ci_esx_resource_pool</td>
<td>ESX Resource Pool</td>
<td>VMware set of physical resources.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_esx_server</td>
<td>ESX Server</td>
<td>Physical ESX server running the VMware ESXi operating system.</td>
</tr>
<tr>
<td>cmdb_ci_exchange_cas</td>
<td>Exchange Client Access Server</td>
<td>Server running Exchange software providing client access services.</td>
</tr>
<tr>
<td>cmdb_ci_exchange_edge</td>
<td>Exchange Edge Transport Server</td>
<td>Server running Exchange Edge Transport software.</td>
</tr>
<tr>
<td>cmdb_ci_exchange_front</td>
<td>ExchangeFrontEndServer</td>
<td>Server running Exchange software.</td>
</tr>
<tr>
<td>cmdb_ci_exchange_hub</td>
<td>ExchangeHub</td>
<td>Server running Exchange Hub software.</td>
</tr>
<tr>
<td>cmdb_ci_exchange_mailbox</td>
<td>Exchange MailBox</td>
<td>Exchange email account.</td>
</tr>
<tr>
<td>cmdb_ci_exchange_mailbox_server</td>
<td>Exchange Mailbox Server</td>
<td>Server running Exchange software providing client access services.</td>
</tr>
<tr>
<td>cmdb_ci_exchange_service</td>
<td>Exchange Service Component</td>
<td>Exchange Service Component software.</td>
</tr>
<tr>
<td>cmdb_ci_facility_hardware</td>
<td>Facility Hardware</td>
<td>Base class for hardware used to facilities services such as electric, water, sewer, air, and security.</td>
</tr>
<tr>
<td>cmdb_ci_fc_disk</td>
<td>Fibre Channel Disk</td>
<td>Base table for fibre channel disk.</td>
</tr>
<tr>
<td>cmdb_ci_fc_export</td>
<td>Fibre Channel Export</td>
<td>Storage volume exported by a storage server via Fibre Channel protocol.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_fc_port</td>
<td>Fibre Channel Port</td>
<td>Fibre Channel port on a storage server, FC switch, or on a host's HBA.</td>
</tr>
<tr>
<td>cmdb_ci_fddi_network</td>
<td>FDDI Cards</td>
<td>Fiber Distributed Data Interface cards.</td>
</tr>
<tr>
<td>cmdb_ci_file_system</td>
<td>File System</td>
<td>File system information for a server, capturing details such as mount point, capacity, and type of file system.</td>
</tr>
<tr>
<td>cmdb_ci_file_system_nfs</td>
<td>NFS File system</td>
<td>Extension of File System, which provides NFS file system information.</td>
</tr>
<tr>
<td>cmdb_ci_file_system_smb</td>
<td>SMB File system</td>
<td>Extension of File System, which provides SMB file system information.</td>
</tr>
<tr>
<td>cmdb_ci_firewall_network</td>
<td>Firewall Hardware</td>
<td>Firewall hardware.</td>
</tr>
<tr>
<td>cmdb_ci_ftp_server</td>
<td>FTP Server</td>
<td>Server providing FTP services.</td>
</tr>
<tr>
<td>cmdb_ci_fuel_tank</td>
<td>Fuel Tank</td>
<td>Fuel tank.</td>
</tr>
<tr>
<td>cmdb_ci_generator_power</td>
<td>Power Generator</td>
<td>Power generator.</td>
</tr>
<tr>
<td>cmdb_ci_group</td>
<td>Group</td>
<td>Logical group of CIs.</td>
</tr>
<tr>
<td>cmdb_ci_hardware</td>
<td>Hardware</td>
<td>Base class for hardware.</td>
</tr>
<tr>
<td>cmdb_ci_hpux_server</td>
<td>HPUX Server</td>
<td>Server running HPUX software.</td>
</tr>
<tr>
<td>cmdb_ci_hub_network</td>
<td>Hub Hardware</td>
<td>Physical network hub.</td>
</tr>
<tr>
<td>cmdb_ci_hvac</td>
<td>HVAC Equipment</td>
<td>Heating, ventilation, and air conditioning equipment.</td>
</tr>
<tr>
<td>cmdb_ci_hyper_v_cluster</td>
<td>Hyper-V Cluster</td>
<td>Cluster of the Hyper-V servers.</td>
</tr>
<tr>
<td>cmdb_ci_hyper_v_instance</td>
<td>Hyper-V Virtual Machine Instance</td>
<td>Hyper-V virtual machine instance. This table extends the generic</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_hyper_v_network</td>
<td>Hyper-V Network</td>
<td>Hyper-V virtual network.</td>
</tr>
<tr>
<td>cmdb_ci_hyper_v_object</td>
<td>Hyper-V Object</td>
<td>Base class for all Hyper-V objects.</td>
</tr>
<tr>
<td>cmdb_ci_hyper_v_resource_pool</td>
<td>Hyper-V Resource Pool</td>
<td>Hyper-V resource pool.</td>
</tr>
<tr>
<td>cmdb_ci_hyper_v_rpool_component</td>
<td>Hyper-V Resource Pool Component</td>
<td>Resource pool component belonging to resource pool.</td>
</tr>
<tr>
<td>cmdb_ci_hyper_v_server</td>
<td>Hyper-V Server</td>
<td>Server running Hyper-V software.</td>
</tr>
<tr>
<td>cmdb_ci_ids_network</td>
<td>Intrusion Detection System</td>
<td>Security intrusion detection systems.</td>
</tr>
<tr>
<td>cmdb_ci_iisdirectory</td>
<td>IIS Virtual Directory</td>
<td>Virtual Directory in IIS Manager.</td>
</tr>
<tr>
<td>cmdb_ci_imaging_hardware</td>
<td>Imaging Hardware</td>
<td>Hardware used to create electronic/physical images.</td>
</tr>
<tr>
<td>cmdb_ci_inetinfo</td>
<td>Inetinfo service</td>
<td>Inetinfo service of IIS application.</td>
</tr>
<tr>
<td>cmdb_ci_inf_software</td>
<td>Infrastructure Software</td>
<td>Base class for enterprise software or programs specifically designed to help business organizations perform basic tasks such as workforce support, business transactions and internal services, and processes.</td>
</tr>
</tbody>
</table>
| cmdb_ci_information_object  | Information Object   | Types of information that a business application or any other entity handles.     
<p>|                             |                      | For example: 'Employee Salary Data', Employee                                        |</p>
<table>
<thead>
<tr>
<th>Table name</th>
<th>Table label</th>
<th>Table description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cmdb_ci_infra_service</td>
<td>Infrastructure Service</td>
<td>IT services which support providing computing infrastructure.</td>
</tr>
<tr>
<td>cmdb_ci_infra_service_ldap</td>
<td>LDAP Service</td>
<td>Running LDAP service.</td>
</tr>
<tr>
<td>cmdb_ci_ip_address</td>
<td>IP Address</td>
<td>IP address.</td>
</tr>
<tr>
<td>cmdb_ci_ip_device</td>
<td>IP Device</td>
<td>Base class for devices with an IP address.</td>
</tr>
<tr>
<td>cmdb_ci_ip_firewall</td>
<td>IP Firewall</td>
<td>Firewall hardware.</td>
</tr>
<tr>
<td>cmdb_ci_ip_network</td>
<td>IP Network</td>
<td>IP network information capturing details such as subnet, router, and router_interface_type.</td>
</tr>
<tr>
<td>cmdb_ci_ip_phone</td>
<td>IP Phone</td>
<td>IP-enabled (VOIP) phone.</td>
</tr>
<tr>
<td>cmdb_ci_ip_router</td>
<td>IP Router</td>
<td>Specialization of the Network Gear [cmdb_ci_netgear] table.</td>
</tr>
<tr>
<td>cmdb_ci_ip_server</td>
<td>IP Server</td>
<td>Server hardware.</td>
</tr>
<tr>
<td>cmdb_ci_ip_service</td>
<td>IP Service Instance</td>
<td>Base table for IP services running on a server such Unix daemon or Windows service.</td>
</tr>
<tr>
<td>cmdb_ci_ip_switch</td>
<td>IP Switch</td>
<td>Specialization of the Network Gear [cmdb_ci_netgear] table.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_iplanet_web_server</td>
<td>IPlanet Web Server</td>
<td>Server running Oracle iPlanet Web Server (OiWS) software.</td>
</tr>
<tr>
<td>cmdb_ci_isam_server</td>
<td>ISAM Server</td>
<td>Server running ISAM software.</td>
</tr>
<tr>
<td>cmdb_ci_iscsi_disk</td>
<td>iSCSI Disk</td>
<td>Host mount of an iSCSI disk.</td>
</tr>
<tr>
<td>cmdb_ci_iscsi_export</td>
<td>iSCSI Export</td>
<td>Storage volume exported by a storage server via iSCSI.</td>
</tr>
<tr>
<td>cmdb_ci_kvm</td>
<td>KVM</td>
<td>Hypervisor that manages kernel-based virtual machines (KVMs).</td>
</tr>
<tr>
<td>cmdb_ci_kvm_network</td>
<td>Network</td>
<td>KVM Virtual network.</td>
</tr>
<tr>
<td>cmdb_ci_kvm_object</td>
<td>KVM Object</td>
<td>Base object for all KVM objects.</td>
</tr>
<tr>
<td>cmdb_ci_kvm_storage_pool</td>
<td>Storage Pool</td>
<td>KVM storage pool.</td>
</tr>
<tr>
<td>cmdb_ci_kvm_storage_volume</td>
<td>Storage Volume</td>
<td>KVM storage volume.</td>
</tr>
<tr>
<td>cmdb_ci_kvm_vm_instance</td>
<td>KVM Virtual Machine Instance</td>
<td>Virtual machine instance running on a KVM hypervisor.</td>
</tr>
<tr>
<td>cmdb_ci_lb</td>
<td>Load Balancer</td>
<td>Server functioning as a load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_a10</td>
<td>A10 Load Balancer</td>
<td>Server functioning as an A10 load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_ace</td>
<td>ACE</td>
<td>Server functioning as an ACE load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_alteon</td>
<td>Alteon</td>
<td>Server functioning as an Alteon load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_appl</td>
<td>Load Balancer Application</td>
<td>Application that provides load balancing functionality.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_lb_backend_servers</td>
<td>Backend Server</td>
<td>Server functioning as a backend load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_bigip</td>
<td>F5 BIG-IP</td>
<td>Server functioning as an F5 BIG-IP load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_cisco_csm</td>
<td>Cisco CSM</td>
<td>Server functioning as a Cisco CSM load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_cisco_css</td>
<td>Cisco CSS</td>
<td>Server functioning as a Cisco CSS load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_f5_gtm</td>
<td>F5 BigIP GTM</td>
<td>Server functioning as an F5 BigIP GTM load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_f5_ltm</td>
<td>F5 BigIP LTM</td>
<td>A server functioning as an F5 BigIP LTM load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_haproxy</td>
<td>HAProxy Load Balancer</td>
<td>Server functioning as an HA Proxy load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_isa</td>
<td>ISA Server</td>
<td>Server functioning as an ISA load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_modjk</td>
<td>Modjk Load Balancer</td>
<td>Server functioning as a Cisco CSM load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_modproxy</td>
<td>ModProxy Load Balancer</td>
<td>Server functioning as a ModProxy load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_netscaler</td>
<td>Citrix Netscaler</td>
<td>Server functioning as a Citrix Netscaler load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_network</td>
<td>Network Load Balancer</td>
<td>Server performing network load balancing.</td>
</tr>
<tr>
<td>cmdb_ci_lb_nginx</td>
<td>Nginx Load Balancer</td>
<td>Server functioning as an Nginx load balancer.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_lb_pool</td>
<td>Load Balancer Pool</td>
<td>Collection of host-to-port mappings to be balanced.</td>
</tr>
<tr>
<td>cmdb_ci_lb_pool_member</td>
<td>Load Balancer Pool Member</td>
<td>Host-to-port mapping of a request to be balanced.</td>
</tr>
<tr>
<td>cmdb_ci_lb_radware</td>
<td>Radware Load Balancer</td>
<td>Server functioning as a Radware load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_service</td>
<td>Load Balancer Service</td>
<td>Virtual service that the device balances by forwarding requests to members within a pool.</td>
</tr>
<tr>
<td>cmdb_ci_lb_template</td>
<td>Load Balancer Template</td>
<td>Load balancer template which contains load balancer-related configuration settings for a specific type of network traffic.</td>
</tr>
<tr>
<td>cmdb_ci_lif</td>
<td>LIF</td>
<td>Logical interface.</td>
</tr>
<tr>
<td>cmdb_ci_lb_vlan</td>
<td>Load Balancer VLAN</td>
<td>Virtual LAN segment.</td>
</tr>
<tr>
<td>cmdb_ci_linux_server</td>
<td>Linux Server</td>
<td>Server running Linux software.</td>
</tr>
<tr>
<td>cmdb_ci_logical_datacenter</td>
<td>Logical Datacenter</td>
<td>VMware vCenter logical datacenter.</td>
</tr>
<tr>
<td>cmdb_ci_lpar</td>
<td>Logical Partition</td>
<td>Logical partition, commonly called an LPAR, is a subset of a computer's hardware resources, virtualized as a separate computer.</td>
</tr>
<tr>
<td>cmdb_ci_lvm_pool</td>
<td>LVM Pool</td>
<td>Linux Volume Manager storage pool.</td>
</tr>
<tr>
<td>cmdb_ci_lvm_pool_member</td>
<td>LVM Pool Member</td>
<td>Linux Volume Manager storage pool member.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_mainframe</td>
<td>IBM Mainframe</td>
<td>IBM large-scale computer system.</td>
</tr>
<tr>
<td>cmdb_ci_mainframe_hardware</td>
<td>Mainframe Hardware</td>
<td>The hardware components of a large-scale computer system.</td>
</tr>
<tr>
<td>cmdb_ci_mainframe_lpar</td>
<td>IBM Mainframe LPAR</td>
<td>Logical partition, which is commonly called an LPAR, and is a subset of a mainframes computer's hardware resources, virtualized as a separate computer.</td>
</tr>
<tr>
<td>cmdb_ci_memory_module</td>
<td>Memory Module</td>
<td>Circuit board that provides for memory storage.</td>
</tr>
<tr>
<td>cmdb_ci_mfp_printer</td>
<td>Multi-function Printer</td>
<td>Physical device with scan, copy, and fax capabilities.</td>
</tr>
<tr>
<td>cmdb_ci_microsoft_iis_web</td>
<td>Microsoft iis Web Server</td>
<td>Server running Internet Information Services (IIS) for Windows software.</td>
</tr>
<tr>
<td>cmdb_ci_modem_network</td>
<td>Modem Hardware</td>
<td>Physical modem hardware.</td>
</tr>
<tr>
<td>cmdb_ci_mpio_pool</td>
<td>Multipath IO Pool</td>
<td>Multipath IO pool, representing multiple redundant paths to storage.</td>
</tr>
<tr>
<td>cmdb_ci_mpio_pool_group</td>
<td>Multipath IO Pool Group</td>
<td>Group of multipath IO pools.</td>
</tr>
<tr>
<td>cmdb_ci_mpio_pool_path</td>
<td>Multipath IO Pool Path</td>
<td>Single path in an MPIO pool.</td>
</tr>
<tr>
<td>cmdb_ci_msd</td>
<td>Mass Storage Device</td>
<td>Physical storage device.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_nat_gateway</td>
<td>NAT Gateway</td>
<td>Functionality for NAT gateway.</td>
</tr>
<tr>
<td>cmdb_ci_netapp_cdot</td>
<td>NetApp CDOT</td>
<td>Functionality of NetApp Clustered Data OnTap operating system.</td>
</tr>
<tr>
<td>cmdb_ci_netapp_datacenter</td>
<td>NetApp Datacenter</td>
<td>NetApp logical datacenter.</td>
</tr>
<tr>
<td>cmdb_ci_net_app_server</td>
<td>Network Appliance Hardware</td>
<td>Server configured to perform as a networking appliance.</td>
</tr>
<tr>
<td>cmdb_ci_netgear</td>
<td>Network Gear</td>
<td>Extension of the Hardware table, that captures network equipment such as router, switch, hub, gateway, and bridge.</td>
</tr>
<tr>
<td>cmdb_ci_netware_server</td>
<td>Netware Server</td>
<td>Server running NetWare software.</td>
</tr>
<tr>
<td>cmdb_ci_network</td>
<td>Cloud Network</td>
<td>VMware vCenter cloud network.</td>
</tr>
<tr>
<td>cmdb_ci_network_acl</td>
<td>Network ACL</td>
<td>Network access control list (ACL).</td>
</tr>
<tr>
<td>cmdb_ci_network_acl_rule</td>
<td>Network ACL Rule</td>
<td>Rule used to control networking access rights.</td>
</tr>
<tr>
<td>cmdb_ci_network_adapter</td>
<td>Network Adapter</td>
<td>Network adapter hardware.</td>
</tr>
<tr>
<td>cmdb_ci_network_policy_group</td>
<td>Network Policy Group</td>
<td>Group policy consumed by Active Directory services.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><code>cmdb_ci_network_template</code></td>
<td>Network Template</td>
<td>OpenStack file used to configure a network.</td>
</tr>
<tr>
<td><code>cmdb_ci_nic</code></td>
<td>Cloud Mgmt Network Interface</td>
<td>Virtual network adapter.</td>
</tr>
<tr>
<td><code>cmdb_ci_nginx_web_server</code></td>
<td>Nginx Web Server</td>
<td>Server running Nginx software.</td>
</tr>
<tr>
<td><code>cmdb_ci_openstack_datacenter</code></td>
<td>OpenStack Datacenter</td>
<td>OpenStack logical datacenter.</td>
</tr>
<tr>
<td><code>cmdb_ci_oslv_container</code></td>
<td>Operating-system-level Virtualization Container</td>
<td>Containers (a runtime instance of a docker image).</td>
</tr>
<tr>
<td><code>cmdb_ci_oslv_engine</code></td>
<td>Operating-system-level Virtualization Engine</td>
<td>Software for running and managing containers.</td>
</tr>
<tr>
<td><code>cmdb_ci_oslv_image</code></td>
<td>Operating-system-level Virtualization Image</td>
<td>Container images. Ordered collection of root filesystem changes and the corresponding execution parameters for use within a container runtime.</td>
</tr>
<tr>
<td><code>cmdb_ci_oslv_image_tag</code></td>
<td>Operating-system-level Virtualization Image Tag</td>
<td>Container tag, which is a label applied to a container image in a repository.</td>
</tr>
<tr>
<td><code>cmdb_ci_oslv_local_image</code></td>
<td>Operating-system-level Virtualization Local Image</td>
<td>Locally managed container image.</td>
</tr>
<tr>
<td><code>cmdb_ci_osx_server</code></td>
<td>OS/X Server</td>
<td>Server running OS/X operating system.</td>
</tr>
<tr>
<td><code>cmdb_ci_os_template</code></td>
<td>Image</td>
<td>Software files used to create a new instance of a compute resource such as server, desktop, virtual machine, and virtual router.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_outofband_device</td>
<td>Out-of-Band Device</td>
<td>Hardware used to perform out-of-band management.</td>
</tr>
<tr>
<td>cmdb_ci_patches</td>
<td>Patch</td>
<td>Patch software to fix or improve a computer program or its supporting data.</td>
</tr>
<tr>
<td>cmdb_ci_pc.hardware</td>
<td>Personal Computer</td>
<td>Multi-purpose electronic computer whose size, capabilities, and price make it feasible for individual use.</td>
</tr>
<tr>
<td>cmdb_ci_pdu</td>
<td>PDU</td>
<td>Power distribution unit (PDU).</td>
</tr>
<tr>
<td>cmdb_ci_pdu_outlet</td>
<td>Outlet</td>
<td>Single outlet of a PDU.</td>
</tr>
<tr>
<td>cmdb_ci_peripheral</td>
<td>Computer Peripheral</td>
<td>Various computer peripherals such as monitor, docking station, KVM switch, projector, scanner, keyboard, mouse, and UPS.</td>
</tr>
<tr>
<td>cmdb_ci_personal_printer</td>
<td>Personal Printer</td>
<td>Printer whose size, capabilities and price make it feasible for individual use.</td>
</tr>
<tr>
<td>cmdb_ci_plotter</td>
<td>Plotter</td>
<td>Printer with capabilities to print large vector graphic images.</td>
</tr>
<tr>
<td>cmdb_ci_power_eq</td>
<td>Power Equipment</td>
<td>Hardware used to manage electrical power.</td>
</tr>
<tr>
<td>cmdb_ci_port</td>
<td>Port</td>
<td>Interface between a computer and other electronic devices.</td>
</tr>
<tr>
<td>cmdb_ci_port_group</td>
<td>Port Group</td>
<td>Group of ports on a virtual switch.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><code>cmdb_ci_print_queue</code></td>
<td>Print Queue</td>
<td>Print queue, which is a list of printer output jobs held in a reserved memory area, including the most current status of all active and pending print jobs.</td>
</tr>
<tr>
<td><code>cmdb_ci_printer</code></td>
<td>Printer</td>
<td>Physical device which makes a persistent human-readable representation of graphics or text on paper or similar physical media.</td>
</tr>
<tr>
<td><code>cmdb_ci_printing_hardware</code></td>
<td>Printing Hardware</td>
<td>Physical device which makes a persistent human-readable representation of graphics or text on paper or similar physical media.</td>
</tr>
<tr>
<td><code>cmdb_ci_puppet_master</code></td>
<td>Puppet Primary</td>
<td>Server running PuppetMaster application.</td>
</tr>
<tr>
<td><code>cmdb_ci_qtree</code></td>
<td>Qtree</td>
<td>Qtree file system.</td>
</tr>
<tr>
<td><code>cmdb_ci_rack</code></td>
<td>Rack</td>
<td>Datacenter racks containing details such as rack units, rack units in use, and power consumption.</td>
</tr>
<tr>
<td><code>cmdb_ci_raid</code></td>
<td>RAID</td>
<td>Storage pool using RAID mechanisms to ensure data integrity.</td>
</tr>
<tr>
<td><code>cmdb_ci_raid_member</code></td>
<td>RAID Member</td>
<td>Member of storage pool using RAID mechanisms.</td>
</tr>
<tr>
<td><code>cmdb_ci_resource_group</code></td>
<td>Resource Group</td>
<td>Resource pool is a logical abstraction for</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_san</td>
<td>Storage Area Network</td>
<td>Network which provides access to block level storage.</td>
</tr>
<tr>
<td>cmdb_ci_san_connection</td>
<td>SAN Connection</td>
<td>Connection in a SAN network.</td>
</tr>
<tr>
<td>cmdb_ci_san_endpoint</td>
<td>SAN Endpoint</td>
<td>One end of a SAN connection.</td>
</tr>
<tr>
<td>cmdb_ci_san_fabric</td>
<td>SAN Fabric</td>
<td>Hardware that connects workstations and servers to storage devices in a SAN. Referred to as a &quot;fabric.&quot;</td>
</tr>
<tr>
<td>cmdb_ci_san_zone</td>
<td>SAN Zone</td>
<td>Subset of SAN storage that certain users are restricted to.</td>
</tr>
<tr>
<td>cmdb_ci_san_zone_alias</td>
<td>SAN Zone Alias</td>
<td>Collection of SAN zone members.</td>
</tr>
<tr>
<td>cmdb_ci_san_zone_alias_memb</td>
<td>SAN Zone Alias Member</td>
<td>M2m relationship between SAN zone aliases and SAN zone members.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_san_zone_member</td>
<td>SAN Zone Member</td>
<td>Ports and devices in a SAN zone.</td>
</tr>
<tr>
<td>cmdb_ci_san_zone_set</td>
<td>SAN Zone Set</td>
<td>Collection of SAN zones.</td>
</tr>
<tr>
<td>cmdb_ci_scanner</td>
<td>Scanner</td>
<td>Hardware used to create digital imagine of paper documents.</td>
</tr>
<tr>
<td>cmdb_ci_server</td>
<td>Server</td>
<td>Base class for all types of servers.</td>
</tr>
<tr>
<td>cmdb_ci_server_snapshot</td>
<td>Server Snapshot</td>
<td>Server snapshot, which is the state of a system at a particular point in time.</td>
</tr>
<tr>
<td>cmdb_ci_service</td>
<td>Business Service</td>
<td>IT Service that directly supports a Business Process (ITIL).</td>
</tr>
<tr>
<td>cmdb_ci_solaris_instance</td>
<td>Solaris Virtual Machine Instance</td>
<td>Virtual machine instance running Solaris software.</td>
</tr>
<tr>
<td>cmdb_ci_solaris_server</td>
<td>Solaris Server</td>
<td>Physical server running Solaris software.</td>
</tr>
<tr>
<td>cmdb_ci_spkg</td>
<td>Software</td>
<td>Software package information containing details such as version, install count, license count, package name, and key (when SAM enabled).</td>
</tr>
<tr>
<td>cmdb_ci_storage_controller</td>
<td>Storage Controller</td>
<td>Logical device that controls a storage volume or Fibre Channel port.</td>
</tr>
<tr>
<td>cmdb_ci_storage_device</td>
<td>Storage Device</td>
<td>Base table for block storage devices such as DAS, SAN, and NAS.</td>
</tr>
<tr>
<td>cmdb_ci_storage_disk</td>
<td>Storage Disk</td>
<td>Disk installed in a storage server.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_storage_export</td>
<td>Storage Export</td>
<td>Base table for the SAN Export [cmdb_ci_san_export] table.</td>
</tr>
<tr>
<td>cmdb_ci_storage_fileshare</td>
<td>Storage File Share</td>
<td>NAS file system on a storage server (an exported file system).</td>
</tr>
<tr>
<td>cmdb_ci_storage_hba</td>
<td>Storage HBA</td>
<td>Host bust adapter for Fibre Channel. The physical device that provides Fibre Channel ports.</td>
</tr>
<tr>
<td>cmdb_ci_storage_pool</td>
<td>Storage Pool</td>
<td>Logical collection of storage.</td>
</tr>
<tr>
<td>cmdb_ci_storage_pool_member</td>
<td>Storage Pool Member</td>
<td>Logical volume in a storage pool.</td>
</tr>
<tr>
<td>cmdb_ci_storage_switch</td>
<td>Storage Switch</td>
<td>Fibre Channel switch.</td>
</tr>
<tr>
<td>cmdb_ci_storage_volume</td>
<td>Storage Volume</td>
<td>Volume on a storage server.</td>
</tr>
<tr>
<td>cmdb_ci_storage_vol_snapshot</td>
<td>Storage Volume Snapshot</td>
<td>Server snapshot is the state of a system at a particular point in time.</td>
</tr>
<tr>
<td>cmdb_ci_subnet</td>
<td>Cloud Mgmt Subnet</td>
<td>Part of a larger network.</td>
</tr>
<tr>
<td>cmdb_ci_surge_power_eq</td>
<td>Surge Protection Equipment</td>
<td>Power equipment used to prevent power surges.</td>
</tr>
<tr>
<td>cmdb_ci_tape_server</td>
<td>Server Tape Unit</td>
<td>Hardware for using magnetic tape storage.</td>
</tr>
<tr>
<td>cmdb_ci_tomcat_connector</td>
<td>Tomcat Connector</td>
<td>Software which provides web server plugins to</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>connect web servers with Tomcat and other backends.</td>
<td>connect web servers with Tomcat and other backends.</td>
<td>connect web servers with Tomcat and other backends.</td>
</tr>
<tr>
<td>cmdb_ci_translation_rule</td>
<td>NAT</td>
<td>Rules to allow router to remap one network address to another.</td>
</tr>
<tr>
<td>cmdb_ci_ucs_blade</td>
<td>Cisco UCS Blade</td>
<td>Physical Cisco UCS Blade server hardware.</td>
</tr>
<tr>
<td>cmdb_ci_ucs_chassis</td>
<td>Cisco UCS Chassis</td>
<td>Physical Cisco UCS chassis hardware used to hold Cisco UCS Blade server hardware.</td>
</tr>
<tr>
<td>cmdb_ci_unix_cluster</td>
<td>UNIX Cluster</td>
<td>Set of computers clustered together to present a single Unix server resource.</td>
</tr>
<tr>
<td>cmdb_ci_unix_daemon</td>
<td>UNIX Daemon</td>
<td>Long running Unix background process used to answer requests for services.</td>
</tr>
<tr>
<td>cmdb_ci_unix_server</td>
<td>UNIX Server</td>
<td>Server running Unix software.</td>
</tr>
<tr>
<td>cmdb_ci_ups</td>
<td>UPS</td>
<td>Uninterrupted Power Supply devices.</td>
</tr>
<tr>
<td>cmdb_ci_ups_alarm</td>
<td>UPS Alarm</td>
<td>Uninterrupted Power Supply alarm.</td>
</tr>
<tr>
<td>cmdb_ci_ups_bypass</td>
<td>UPS Bypass</td>
<td>Uninterrupted Power Supply bypass.</td>
</tr>
<tr>
<td>cmdb_ci_ups_input</td>
<td>UPS Input</td>
<td>Electrical input to an Uninterrupted Power Supply device.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_ups_output</td>
<td>UPS Output</td>
<td>Electrical output from an Uninterrupted Power Supply device.</td>
</tr>
<tr>
<td>cmdb_ci_ups_power_eq</td>
<td>Uninterruptible Power</td>
<td>Uninterrupted Power Supply devices.</td>
</tr>
<tr>
<td>cmdb_ci_vcenter</td>
<td>VMware vCenter Instance</td>
<td>Installed instance of VMware VCenter software.</td>
</tr>
<tr>
<td>cmdb_ci_vcenter_cluster</td>
<td>VMware vCenter Cluster</td>
<td>Set of servers that work together while running VMware VCenter software.</td>
</tr>
<tr>
<td>cmdb_ci_vcenter_datacenter</td>
<td>VMware vCenter</td>
<td>VMware VCenter datacenter objects.</td>
</tr>
<tr>
<td>cmdb_ci_vcenter_datastore</td>
<td>VMware vCenter</td>
<td>VMware VCenter datastore objects containing details such as capacity, freespace, filesystem, and type.</td>
</tr>
<tr>
<td>cmdb_ci_vcenter_datastore_disk</td>
<td></td>
<td>Individual VMware VCenter datastore disk.</td>
</tr>
<tr>
<td>cmdb_ci_vcenter_folder</td>
<td>VMware vCenter Folder</td>
<td>VCenter folders, which can be used to group objects of the same type for easier management.</td>
</tr>
<tr>
<td>cmdb_ci_vcenter_network</td>
<td>VMware vCenter Network</td>
<td>VMWare vCenter virtual network.</td>
</tr>
<tr>
<td>cmdb_ci_vcenter_object</td>
<td>VMware vCenter Object</td>
<td>Base class for most VMware VCenter objects.</td>
</tr>
<tr>
<td>cmdb_ci_vcenter_server_object</td>
<td>VMware vCenter</td>
<td>VMware hypervisor.</td>
</tr>
<tr>
<td>cmdb_ci_veritas_disk</td>
<td>Veritas Disk</td>
<td>Physical disk that is controlled by Veritas Volume Manager.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>----------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_veritas_disk_group</td>
<td>Veritas Disk Group</td>
<td>Collection of disks in Veritas Volume Manager.</td>
</tr>
<tr>
<td>cmdb_ci_veritas_plex</td>
<td>Veritas Plex</td>
<td>Logical partition in Veritas Volume Manager.</td>
</tr>
<tr>
<td>cmdb_ci_veritas_subdisk</td>
<td>Veritas Subdisk</td>
<td>Partition of a Veritas_disk.</td>
</tr>
<tr>
<td>cmdb_ci_veritas_volume</td>
<td>Veritas Volume</td>
<td>Aggregation of plexes.</td>
</tr>
<tr>
<td>cmdb_ci_virtualization_server</td>
<td>Virtualization Server</td>
<td>Base table used by the ESX Server [cmdb_ci_esx_server] table.</td>
</tr>
<tr>
<td>cmdb_ci_virtual_desktop</td>
<td>Virtual Desktop</td>
<td>User's desktop environment (such as icons, wallpaper, windows, folders, toolbars, and widgets) is stored remotely on a server.</td>
</tr>
<tr>
<td>cmdb_ci_virtual_pvt_gateway</td>
<td>Virtual Private Gateway</td>
<td>Two VPN endpoints for automatic failover.</td>
</tr>
<tr>
<td>cmdb_ci_vm</td>
<td>Virtual Machine</td>
<td>Hypevisor software.</td>
</tr>
<tr>
<td>cmdb_ci_vm_instance</td>
<td>Virtual Machine Instance</td>
<td>Generic virtual machines information.</td>
</tr>
<tr>
<td>cmdb_ci_vm_object</td>
<td>Virtual Machine Object</td>
<td>Base class for all VM objects. Parent for all objects such as Hyper-V object and KVM object.</td>
</tr>
<tr>
<td>cmdb_ci_vm_parallels</td>
<td>Parallels</td>
<td>Instance of Parallels software.</td>
</tr>
<tr>
<td>cmdb_ci_vm_template</td>
<td>Virtual Machine Template</td>
<td>Template, which is a master copy of a virtual machine that can be used to create many</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>clones</td>
<td></td>
<td>clones. Base table for all VM templates.</td>
</tr>
<tr>
<td>cmdb_ci_vm_user_credentials</td>
<td>User Credentials</td>
<td>Credentials, which are used to authenticate access rights and permissions.</td>
</tr>
<tr>
<td>cmdb_ci_vm_vmware</td>
<td>VMware</td>
<td>VMWare specialization of the Virtual Machine table. No longer used.</td>
</tr>
<tr>
<td>cmdb_ci_vm_zones</td>
<td>Zones</td>
<td>Partitioned virtual OS environment working in a Solaris operating system space.</td>
</tr>
<tr>
<td>cmdb_ci_volume_template</td>
<td>Volume Template</td>
<td>Set of rules that specify one or more capabilities of a storage volume (storage selection and layout rules).</td>
</tr>
<tr>
<td>cmdb_ci_vmware_instance</td>
<td>VMware Virtual Machine Instance</td>
<td>VMware VM instance on VMware hypervisor.</td>
</tr>
<tr>
<td>cmdb_ci_volume_template</td>
<td>VMware Virtual Machine Template</td>
<td>Master copy of a VMware virtual machine that can be used to create many clones.</td>
</tr>
<tr>
<td>cmdb_ci_vpc</td>
<td>Virtual Private Cloud</td>
<td>On-demand configurable pool of shared computing resources allocated within a public cloud environment.</td>
</tr>
<tr>
<td>cmdb_ci_vpn</td>
<td>Virtual Private Network</td>
<td>Private network configured to run across a public network.</td>
</tr>
<tr>
<td>cmdb_ci_vpn_connection</td>
<td>VPN Connection</td>
<td>Secure connection to another network over the Internet.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_wap_network</td>
<td>Wireless Access Point</td>
<td>Networking hardware device that allows a Wi-Fi compliant device to connect to a wired network.</td>
</tr>
<tr>
<td>cmdb_ci_web_application</td>
<td>Web Application</td>
<td>Client–server software application in which the client (or user interface) runs in a web browser.</td>
</tr>
<tr>
<td>cmdb_ci_web_domino</td>
<td>Lotus Domino HTTP Server</td>
<td>Server running IBM Notes software (formerly Lotus Notes/IBM Domino).</td>
</tr>
<tr>
<td>cmdb_ci_web_service</td>
<td>Web Service</td>
<td>Service offered by an electronic device to another electronic device, communicating with each other via the World Wide Web.</td>
</tr>
<tr>
<td>cmdb_ci_web_site</td>
<td>Web Site</td>
<td>A collection of related web pages.</td>
</tr>
<tr>
<td>cmdb_ci_websphere_cell</td>
<td>Websphere Cell</td>
<td>A logical grouping of IBM Websphere nodes (each of which runs one or more application servers) that are centrally managed.</td>
</tr>
<tr>
<td>cmdb_ci_win_cluster</td>
<td>Windows Cluster</td>
<td>A single (virtual) server composed of one or more IBM Websphere nodes.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>cmdb_ci_win_cluster_node</td>
<td>Windows Cluster Node</td>
<td>A physical member of the Windows Cluster application.</td>
</tr>
<tr>
<td>cmdb_ci_win_cluster_resource</td>
<td>Windows Cluster Resource</td>
<td>A logical or physical entity managed by the Windows Cluster application.</td>
</tr>
<tr>
<td>cmdb_ci_win_domain_controller</td>
<td>Windows Domain Controller</td>
<td>A server that responds to security authentication requests within a Windows Server domain.</td>
</tr>
<tr>
<td>cmdb_ci_win_server</td>
<td>Windows Server</td>
<td>A server running Microsoft Windows Server operating system.</td>
</tr>
<tr>
<td>cmdb_ciwindows_service</td>
<td>Windows Service</td>
<td>A Windows computer program that operates in the background.</td>
</tr>
<tr>
<td>cmdb_ci_zone</td>
<td>Data Center Zone</td>
<td>A specified portion of a data center facility.</td>
</tr>
</tbody>
</table>

**Configuration Item [cmdb_ci] class**

Attributes in the Configuration Item [cmdb_ci] class, which extends the Configuration Item [cmdb] class.

⚠️ **Attention:** Do not modify any of these attributes in the dictionary. For example, do not modify the type of the `location` attribute from reference to list. Such modifications may prevent features that use the CMDB, from functioning properly.
Common, core, user tables

CMDB CI schema related to common core and non-core tables

Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset tag</td>
<td>Asset tag/service tag for the specific asset</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assigned</td>
<td>Date and time of assignment to user</td>
</tr>
<tr>
<td>Attributes</td>
<td>Description of usage of attributes for the instance</td>
</tr>
<tr>
<td>Can Print</td>
<td>Indicates whether the instance can print</td>
</tr>
<tr>
<td>Category</td>
<td>Name of category applicable to the instance</td>
</tr>
<tr>
<td>Checked in</td>
<td>Date and time of checking in</td>
</tr>
<tr>
<td>Checked out</td>
<td>Date and time of checking out</td>
</tr>
<tr>
<td>Class</td>
<td>System class name</td>
</tr>
<tr>
<td>Comments</td>
<td>Comments related to the instance</td>
</tr>
<tr>
<td>Correlation ID</td>
<td>ID of the instance from another data source</td>
</tr>
<tr>
<td>Cost</td>
<td>Financial value in local currency (as defined in the Cost Currency field)</td>
</tr>
<tr>
<td>Cost currency</td>
<td>Name of currency (such as dollars, pounds, Euros)</td>
</tr>
<tr>
<td>Created</td>
<td>Date and time record was created</td>
</tr>
<tr>
<td>Created by</td>
<td>Name of person/data source which initially created the record</td>
</tr>
<tr>
<td>Description</td>
<td>Fit (how deployed) and function (purpose) of the instance</td>
</tr>
<tr>
<td>Discovery source</td>
<td>Name of primary (most trusted) discovery source</td>
</tr>
<tr>
<td>DNS Domain</td>
<td>Name of the DNS domain to which the instance belongs</td>
</tr>
<tr>
<td>Domain</td>
<td>ID of the domain to which the instance belongs</td>
</tr>
<tr>
<td>Domain Path</td>
<td>Path of the domain to which the instance belongs</td>
</tr>
<tr>
<td>Due</td>
<td>Date and time instance was due</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Due in</td>
<td>Description of the manner of which the instance was due</td>
</tr>
<tr>
<td>Fault Count</td>
<td>Number of faulty recorded against the instance to date</td>
</tr>
<tr>
<td>First Discovered</td>
<td>Date and time instance was initially discovered</td>
</tr>
<tr>
<td>Fully Qualified Domain Name</td>
<td>Full path name of domain to which the instance belongs</td>
</tr>
<tr>
<td>GL account</td>
<td>General Ledger account name/number</td>
</tr>
<tr>
<td>Installed</td>
<td>Date and time instance was most recently installed</td>
</tr>
<tr>
<td>Invoice number</td>
<td>Invoice number used in acquisition process</td>
</tr>
<tr>
<td>IP Address</td>
<td>Primary IP address used by the instance</td>
</tr>
<tr>
<td>Justification</td>
<td>Description of the justification for the instance</td>
</tr>
<tr>
<td>Lease contract</td>
<td>Number of current leasing contracts</td>
</tr>
<tr>
<td>MAC Address</td>
<td>MAC address of the instance</td>
</tr>
<tr>
<td>Model Number</td>
<td>Manufacturer original model number</td>
</tr>
<tr>
<td>Monitor</td>
<td>Indicates whether the instance is monitored</td>
</tr>
<tr>
<td>Most Recent Discovery</td>
<td>Date and time instance was last discovered</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the CI instance</td>
</tr>
<tr>
<td>Operational Status</td>
<td>Configurable choice list for current operational states</td>
</tr>
<tr>
<td>Order received</td>
<td>Date and time instance was initially received</td>
</tr>
<tr>
<td>Ordered</td>
<td>Date and time instance was initially ordered</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PO number</td>
<td>Purchase order number used in acquisition process</td>
</tr>
<tr>
<td>Purchased</td>
<td>Date instance was purchased</td>
</tr>
<tr>
<td>Requires verification</td>
<td>Flag indicating whether verification is required for the instance</td>
</tr>
<tr>
<td>Serial number</td>
<td>Serial number of the instance</td>
</tr>
<tr>
<td>Skip sync</td>
<td>Flag indicating whether synchronization between Asset Management and CMDB can be skipped</td>
</tr>
<tr>
<td>Start Date</td>
<td>Date and time the instance was last started</td>
</tr>
<tr>
<td>Status</td>
<td>Configurable choice list with values for current functional states</td>
</tr>
<tr>
<td>Subcategory</td>
<td>Name of Subcategory applicable to the instance</td>
</tr>
<tr>
<td>Sys ID</td>
<td>ServiceNow Sys ID (GUID)</td>
</tr>
<tr>
<td>Tags</td>
<td>Related tags</td>
</tr>
<tr>
<td>Updated</td>
<td>Date and time instance was last updated</td>
</tr>
<tr>
<td>Updated by</td>
<td>Person/data source which last updated the record</td>
</tr>
<tr>
<td>Updates</td>
<td>Configurable choice list with values for update states</td>
</tr>
<tr>
<td>Warranty expiration</td>
<td>Date current warranty expires</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reference attribute</th>
<th>Reference to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Group</td>
<td>Group table</td>
</tr>
<tr>
<td>Asset</td>
<td>Asset table</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User table</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group table</td>
</tr>
<tr>
<td>Reference attribute</td>
<td>Reference to</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>Company</td>
<td>Company table</td>
</tr>
<tr>
<td>Cost center</td>
<td>Cost Center table</td>
</tr>
<tr>
<td>Department</td>
<td>Department table</td>
</tr>
<tr>
<td>Location</td>
<td>Location table</td>
</tr>
<tr>
<td>Maintenance Schedule</td>
<td>Schedule table</td>
</tr>
<tr>
<td>Managed by</td>
<td>User table</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Company table</td>
</tr>
<tr>
<td>Model ID</td>
<td>Product Model table</td>
</tr>
<tr>
<td>Owned by</td>
<td>User table</td>
</tr>
<tr>
<td>Schedule</td>
<td>Schedule table (for normal processing)</td>
</tr>
<tr>
<td>Support group</td>
<td>Group table</td>
</tr>
<tr>
<td>Supported by</td>
<td>User</td>
</tr>
<tr>
<td>Vendor</td>
<td>Company table</td>
</tr>
</tbody>
</table>

**Hardware [cmdb_ci_hardware] class**

Attributes, identification rule, and other important schema structures for the CMDB Hardware [cmdb_ci_hardware] class.
Attributes
The Hardware class adds the following unique attributes:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hardware_status</td>
<td>Status of hardware such as <strong>In Maintenance</strong> or <strong>Retired</strong>. Used to sync status to the Asset class.</td>
</tr>
<tr>
<td>hardware_substatus</td>
<td>Secondary hardware status. Each setting in <code>hardware_status</code> results in a different set of choices available for this field.</td>
</tr>
<tr>
<td>default_gateway</td>
<td>Default gateway that the computer is connected through.</td>
</tr>
</tbody>
</table>

Key relationship structures
Use the following key relationships as important guidelines when creating Hardware, Computer, or Server CIs:

- **Serial number**: During CI identification, Identification and Reconciliation Engine (IRE) processes search for a serial number in two locations. One is the CI serial number attribute, and the second one is the Serial Number [cmdb_serial_number] table, with reference back to the Hardware [cmdb_ci_hardeware] table.
- Store any serial number of any type other than System, only in the Serial Number table (and not in the server CI attribute).

- If the system serial number is available, store it in both the Serial Number attribute of the CI and in the Serial Number table.

The Serial Number table is a many to one relationship linking back to the server CI. This table has a type field for specifying the type of the serial number (system, uuid, chassis, bios, or baseboard) and storing the actual value itself. Use the following Windows standards for serial number types in the Serial Number \([\text{cmdb\_serial\_number}]\) table:

- **system**: Product identification such as a serial number for software, a die number on a hardware chip, or a project number (for noncommercial products).

- **uuid**: Universally unique identifier (UUID) for the product. A UUID is a 128-bit identifier that is guaranteed to be different from other generated UUIDs.

- **chassis**: Manufacturer-allocated number that is used to identify a physical element. Value is the Serial Number member of the System Enclosure or Chassis structure in the SMBIOS information. This type represents the properties associated with a physical system enclosure.

- **bios**: The assigned serial number of the BIOS. This type represents the attributes of the computer system basic input/output services (BIOS) that are installed on the computer.

- **baseboard**: Manufacturer-allocated number that is used to identify the physical element. This property is inherited from CIM_PhysicalElement, and is sometimes referred to as the 'Motherboard Serial Number'.

**Network adapter:**

- Use the Network Adapter \([\text{cmdb\_ci\_network\_adapter}]\) class to store network adapters.

- Set the **Name** attribute in the Network Adapter class to be the name of the Network Adapter device (such as eth0, eth1).

- Set the **MAC Address** attribute to be the MAC address value. Format the string with colon separators between octets and lower case hexadecimal characters with padded zeros.

For example: ‘f8:f2:1e:00:d4:66’
In the CI Relationship [cmdb_rel_ci] table, create an **Owned By::Owns** relationship to the associated Hardware CI. Specify a reference from the Network Adapter [cmdb_ci_network_adapter] table using the CI with a reference to the associated Hardware CI.

**IP address:**

- Use the IP Address [cmdb_ci_ip_address] class to store IP addresses.
- Store an IP address value in the **IP Address** attribute, and in the **Name** attribute (to avoid empty **Name** attributes).
- Store an IPv4 IP address value using the format 'NNN.NNN.NNN.NNN', with decimal-based octets and period separators. Non-conforming values should be considered invalid and cleansed to null values.
- Store an IPv6 IP address value using lower case hexadecimal with colon separators. Non-confirming values should be considered invalid and cleansed to null values.
- Set the **Netmask** attribute to the IP address.
- In the CI Relationship [cmdb_rel_ci] table, create an **Owned By::Owns** relationship to the associated Hardware CI.
- Specify for the IP address a reference to the Network Adapter [cmdb_ci_network_adapter] table using the Configuration Item with a reference to the associated Hardware CI.
- To ensure that base system identification rules work properly, also store the IP address in the associated Network Adapter class.

**Network adapter and IP address:**

- Store the MAC address of the network adapter installed on a server, in the Network Adapter [cmdb_ci_network_adapter] class.
- Store the IP address in the IP Address [cmdb_ci_ip_address] class.
- Do not store the MAC address or the IP address in the Server [cmdb_ci_server] class.

**Key reference structures**

Use the following key references as important guidelines when creating Hardware, Computer, or Server CIs:

- **Software and processes running on a server:** The Software [cmdb_ci_spkg] class contains the generic software package that is related to the server CI. The cmdb_sw_instance table instantiates each instance of the software package with:
One to one reference back to the Server [cmdb_ci_server] class

Many to one reference back to the Software class

These references are stored in the Installed on and the Product Name reference attributes respectively.

If either the Software Asset Management Foundation [com.snc.sams] or the Software Asset Management [com.snc.software_asset_management] plugin is installed, then store software details in the Software Installation [cmdb_sam_sw_install] table instead of the cmdb_sw_instance table.

- The Manufacturer and Model ID are reference attributes to the Company [core_company] and Product Model [cmdb_model] tables respectively.
- The Owned By, Assigned To, Managed By, and Supported By are reference attributes to the User [sys_user] table. The Assignment Group and Support Group are reference attributes to the Group [sys_user_group] table.

Identification rule
The base system contains pre-defined identification rules for the Hardware, Computer, and Server classes, which are identical. That identification rule has the following key identifier entries, listed in priority order:

1. Identifier entry which uses lookup-based identification specified with Serial Number [cmdb_serial_number] as the lookup table. The Serial Number table is a many to one reference from Serial Number back to the server CI.

2. Identifier entry specified with the Serial Number attribute in the CI.

3. Identifier entry for the Name attribute. If Serial Number is not available, then the Name (which is the hostname) attribute is used. If both the Serial Number and the Name attributes are provided, then Identification and Reconciliation Engine (IRE) looks first for the Serial Number. Then, if a Serial Number is not found, IRE falls back to using Name.

4. Identifier entry specified for the MAC Address/IP Address attributes in the Network Adapter table. However, do not rely only on the MAC Address/IP Address.

   If both Serial Number and Name are not available, and only MAC Address/IP Address are available, use MAC Address as the name of the CI. Using the MAC Address as the name of the CI ensures that you don’t create an empty CI.

For more information, see CMDB Identification and Reconciliation.

Computer [cmdb_ci_computer] class

Attributes, identification rule, and other important schema structures for the CMDB Computer [cmdb_ci_computer] class.
Attributes
The Computer class adds the following unique attributes:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD_ROM</td>
<td>Denotes whether a CD ROM exists.</td>
</tr>
<tr>
<td>CD Speed</td>
<td>Speed of CD_ROM.</td>
</tr>
<tr>
<td>Chassis type</td>
<td>Type of computer chassis.</td>
</tr>
<tr>
<td>CPU core count</td>
<td>Number of cores per CPU.</td>
</tr>
<tr>
<td>CPU core thread</td>
<td>Number of threads per core.</td>
</tr>
<tr>
<td>CPU count</td>
<td>Number of CPUs.</td>
</tr>
<tr>
<td>CPU name</td>
<td>Name of CPU.</td>
</tr>
<tr>
<td>CPU speed (MHz)</td>
<td>Speed of CPU.</td>
</tr>
<tr>
<td>CPU type</td>
<td>CPU type.</td>
</tr>
<tr>
<td>Disk space (GB)</td>
<td>Amount of disk space (in GB).</td>
</tr>
<tr>
<td>Floppy</td>
<td>Type of floppy drive.</td>
</tr>
<tr>
<td>Form factor</td>
<td>Form factor of the computer.</td>
</tr>
</tbody>
</table>
### Attribute Description

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object ID</td>
<td>Object ID of the computer (such as the virtual machine ID associated with the computer).</td>
</tr>
<tr>
<td>Operating System</td>
<td>Name of the operating system.</td>
</tr>
<tr>
<td>OS Address Width (bits)</td>
<td>Operating system bit (such as 32, 64).</td>
</tr>
<tr>
<td>OS Domain</td>
<td>NA</td>
</tr>
<tr>
<td>OS Service Pack</td>
<td>Service pack installed on the operating system.</td>
</tr>
<tr>
<td>OS Version</td>
<td>Version of the operating system.</td>
</tr>
<tr>
<td>RAM (MB)</td>
<td>Amount of RAM on the computer.</td>
</tr>
<tr>
<td>IsVirtual</td>
<td>True/False denoting whether the device is running on a virtual machine instance.</td>
</tr>
</tbody>
</table>

### Reference attribute

<table>
<thead>
<tr>
<th>Reference attribute</th>
<th>Reference to</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU manufacturer</td>
<td>Company [core_company] table</td>
</tr>
</tbody>
</table>

### Schema description

The CMDB schema model does not separate between servers and computers that are physical and servers and computer that are virtual. Instead, the Computer and the Server classes have a field named **IsVirtual**. If a computer or server is a virtual instance, set this **IsVirtual** attribute to **true**.

As described in the Virtual Machine schema section, to fully model a virtual machine, set the **IsVirtual** attribute in the Computer or Server CI to **true**. Create a Virtual Machine Instance [cmdb_ci_vm_instance] record using the BIOS UUID attribute as the key identifier. Then create a Hosted_On relationship between the Virtual Machine Instance record and the Computer or Server instance and set **IsVirtual** to **true**.

### Key relationship structures

Use the following key relationships as important guidelines when creating Hardware, Computer, or Server CIs:

- **Serial number**: During CI identification, Identification and Reconciliation Engine (IRE) processes search for a serial number in two locations. One is the CI serial number attribute, and the second one is the Serial Number
[cmdb_serial_number] table, with reference back to the Hardware [cmdb_ci_hardware] table.

- Store any serial number of any type other than System, only in the Serial Number table (and not in the server CI attribute).
- If the system serial number is available, store it in both the Serial Number attribute of the CI and in the Serial Number table.

The Serial Number table is a many to one relationship linking back to the server CI. This table has a type field for specifying the type of the serial number (system, uuid, chassis, bios, or baseboard) and storing the actual value itself. Use the following Windows standards for serial number types in the Serial Number [cmdb_serial_number] table:

- **system**: Product identification such as a serial number for software, a die number on a hardware chip, or a project number (for noncommercial products).
- **uuid**: Universally unique identifier (UUID) for the product. A UUID is a 128-bit identifier that is guaranteed to be different from other generated UUIDs.
- **chassis**: Manufacturer-allocated number that is used to identify a physical element. Value is the Serial Number member of the System Enclosure or Chassis structure in the SMBIOS information. This type represents the properties associated with a physical system enclosure.
- **bios**: The assigned serial number of the BIOS. This type represents the attributes of the computer system basic input/output services (BIOS) that are installed on the computer.
- **baseboard**: Manufacturer-allocated number that is used to identify the physical element. This property is inherited from CIM_PhysicalElement, and is sometimes referred to as the 'Motherboard Serial Number'.

- **Network adapter**:
  - Use the Network Adapter [cmdb_ci_network_adapter] class to store network adapters.
  - Set the Name attribute in the Network Adapter class to be the name of the Network Adapter device (such as eth0, eth1).
  - Set the MAC Address attribute to be the MAC address value. Format the string with colon separators between octets and lower case hexadecimal characters with padded zeros.

    For example: 'f8:f2:1e:00:d4:66'
In the CI Relationship [cmdb_rel_ci] table, create an Owned By::Owns relationship to the associated Hardware CI. Specify a reference from the Network Adapter [cmdb_ci_network_adapter] table using the CI with a reference to the associated Hardware CI.

• IP address:
  - Use the IP Address [cmdb_ci_ip_address] class to store IP addresses.
  - Store an IP address value in the IP Address attribute, and in the Name attribute (to avoid empty Name attributes).
  - Store an IPv4 IP address value using the format 'NNN.NNN.NNN.NNN', with decimal-based octets and period separators. Non-conforming values should be considered invalid and cleansed to null values.
  - Store an IPv6 IP address value using lower case hexadecimal with colon separators. Non-confirming values should be considered invalid and cleansed to null values.
  - Set the Netmask attribute to the IP address.
  - In the CI Relationship [cmdb_rel_ci] table, create an Owned By::Owns relationship to the associated Hardware CI.
  - Specify for the IP address a reference to the Network Adapter [cmdb_ci_network_adapter] table using the Configuration Item with a reference to the associated Hardware CI.
  - To ensure that base system identification rules work properly, also store the IP address in the associated Network Adapter class.

• Network adapter and IP address:
  - Store the MAC address of the network adapter installed on a server, in the Network Adapter [cmdb_ci_network_adapter] class.
  - Store the IP address in the IP Address [cmdb_ci_ip_address] class.
  - Do not store the MAC address or the IP address in the Server [cmdb_ci_server] class.

Key reference structures
Use the following key references as important guidelines when creating Hardware, Computer, or Server CIs:

• Software and processes running on a server: The Software [cmdb_ci_spkg] class contains the generic software package that is related to the server CI. The cmdb_sw_instance table instantiates each instance of the software package with:
• One to one reference back to the Server [cmdb_ci_server] class.
• Many to one reference back to the Software class.
These references are stored in the Installed on and the Product Name
reference attributes respectively.

If either the Software Asset Management Foundation [com.snc.sams] or
the Software Asset Management [com.snc.software_asset_management]
plugin is installed, then store software details in the Software Installation
[cmdb_sw_instance] table instead of the cmdb_sw_instance table.

• The Manufacturer and Model ID are reference attributes to the Company
[core_company] and Product Model [cmdb_model] tables respectively.

• The Owned By, Assigned To, Managed By, and Supported By are reference
attributes to the User [sys_user] table. The Assignment Group and Support Group
are reference attributes to the Group [sys_user_group] table.

**Identification rule**
The base system contains pre-defined identification rules for the Hardware,
Computer, and Server classes, which are identical. That identification rule has
the following key identifier entries, listed in priority order:

1. Identifier entry which uses lookup-based identification specified with Serial
   Number [cmdb_serial_number] as the lookup table. The Serial Number table is
   a many to one reference from Serial Number back to the server CI.

2. Identifier entry specified with the Serial Number Attribute in the CI.

3. Identifier entry for the Name attribute. If Serial Number is not available, then the
   Name (which is the hostname) attribute is used. If both the Serial Number and
   the Name attributes are provided, then Identification and Reconciliation Engine
   (IRE) looks first for the Serial Number. Then, if a Serial Number is not found, IRE
   falls back to using Name.

4. Identifier entry specified for the MAC Address/IP Address attributes in the
   Network Adapter table. However, do not rely only on the MAC Address/IP
   Address.

   If both Serial Number and Name are not available, and only MAC Address/IP
   Address are available, use MAC Address as the name of the CI. Using the MAC
   Address as the name of the CI ensures that you don't create an empty CI.

For more information, see CMDB Identification and Reconciliation.

**Server [cmdb_ci_server] class**
Attributes, identification rule, and other important schema structures for the
CMDB Server [cmdb_ci_server] class.
Attributes
The Server class adds the following unique attributes:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Classification</td>
<td>Type of server, such as production, development, disaster recovery, or user acceptance testing (UAT).</td>
</tr>
<tr>
<td>Firewall status</td>
<td>Internet or intranet facing server.</td>
</tr>
<tr>
<td>Host name</td>
<td>Use the Name attribute to store the host name of the server instead of the Host name attribute.</td>
</tr>
<tr>
<td>Used for</td>
<td>Business service supported by the server, such as production, staging, or quality assurance (QA). This attribute uses the <strong>Used for</strong> choice list field from the Service [cmdb_ci_service] table.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reference attribute</th>
<th>Reference to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disaster backup</td>
<td>Server [cmdb_ci_server] table. Reference to another server that is the backup server for this server.</td>
</tr>
</tbody>
</table>
# Reference classes

The following reference classes extend the Server class. They do not add any new attributes.

<table>
<thead>
<tr>
<th>Reference class</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cmdb_ci_solaris_server</td>
<td>Solaris Server</td>
<td>Server running Oracle Solaris operating system.</td>
</tr>
<tr>
<td>cmdb_ci_lb_cisco_csm</td>
<td>Cisco CSM</td>
<td>Cisco Security Manager (CSM) load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_win_server</td>
<td>Windows Server</td>
<td>Server running Microsoft Windows Server operating system.</td>
</tr>
<tr>
<td>cmdb_ci_lb_ace</td>
<td>ACE</td>
<td>Cisco Application Control Engine load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_netscaler</td>
<td>Citrix Netscaler</td>
<td>Citrix Netscaler load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_alteon</td>
<td>Alteon</td>
<td>Alteon load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb</td>
<td>Load Balancer</td>
<td>Generic load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_a10</td>
<td>A10 Load Balancer</td>
<td>A10 load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_cisco_css</td>
<td>Cisco CSS</td>
<td>Cisco Content Services Switch (CSS) load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_cisco_gss</td>
<td>Cisco GSS</td>
<td>Cisco Global Site Selector (GSS) load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_osx_Server</td>
<td>OS/X Server</td>
<td>Server running OS/X operating system.</td>
</tr>
<tr>
<td>cmdb_ci_HPUX_Server</td>
<td>HPUX Server</td>
<td>Server running HP-UX operating system.</td>
</tr>
<tr>
<td>cmdb_ci_tape_server</td>
<td>Server Tape Unit</td>
<td>Server using a tape drive.</td>
</tr>
<tr>
<td>cmdb_ci_Server_Hardware</td>
<td>Server Hardware</td>
<td>Server hardware.</td>
</tr>
<tr>
<td>cmdb_ci_datapower_server</td>
<td>Data Power Hosting</td>
<td>IBM DataPower hosting server.</td>
</tr>
<tr>
<td>Reference class</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>cmdb_ci_net_app_server</td>
<td>Network Appliance Hardware</td>
<td>NetApp hardware.</td>
</tr>
<tr>
<td>cmdb_ci_netware_server</td>
<td>Netware Server</td>
<td>Server running NetWare operating system.</td>
</tr>
<tr>
<td>cmdb_ci_ibm_zos_server</td>
<td>IBM zOS Server</td>
<td>Server running IBM z/OS operating system.</td>
</tr>
<tr>
<td>cmdb_ci_storage_node_element</td>
<td>Storage Node Element</td>
<td>Storage node.</td>
</tr>
<tr>
<td>cmdb_ci_chassis_server</td>
<td>Server Chassis</td>
<td>Server chassis.</td>
</tr>
<tr>
<td>cmdb_ci_lb_network</td>
<td>Network Load Balancer</td>
<td>Network load balancer hardware.</td>
</tr>
<tr>
<td>cmdb_ci_Unix_Server</td>
<td>Unix Server</td>
<td>Server running Unix operating system.</td>
</tr>
<tr>
<td>cmdb_ci_virtualization_server</td>
<td>Virtualization Server</td>
<td>Abstract base table used by Hyper-V Server [cmdb_ci_hyper_v_server] and ESX Server [cmdb_ci_esx_server].</td>
</tr>
<tr>
<td>cmdb_ci_mainframe</td>
<td>IBM Mainframe</td>
<td>Large-scale computer system with high-end capabilities.</td>
</tr>
</tbody>
</table>

**Schema description**

The CMDB schema model does not separate between servers and computers that are physical and servers and computer that are virtual. Instead, the Computer and the Server classes have a field named `IsVirtual`. If a computer or server is a virtual instance, set this `IsVirtual` attribute to `true`. As described in the Virtual Machine schema section, to fully model a virtual machine, set the `IsVirtual` attribute in the Computer or Server CI to `true`. Create a Virtual Machine Instance [cmdb_ci_vm_instance] record using the `BIOS UUID` attribute as the key identifier. Then create a `Hosted_On` relationship between the Virtual Machine Instance record and the Computer or Server instance and set `IsVirtual` to `true`.

**Key relationship structures**

Use the following key relationships as important guidelines when creating Hardware, Computer, or Server CIs:
• Serial number: During CI identification, Identification and Reconciliation Engine (IRE) processes search for a serial number in two locations. One is the CI serial number attribute, and the second one is the Serial Number [cmdb_serial_number] table, with reference back to the Hardware [cmdb_ci_hardware] table.
  ◦ Store any serial number of any type other than System, only in the Serial Number table (and not in the server CI attribute).
  ◦ If the system serial number is available, store it in both the Serial Number attribute of the CI and in the Serial Number table.

The Serial Number table is a many to one relationship linking back to the server CI. This table has a type field for specifying the type of the serial number (system, uuid, chassis, bios, or baseboard) and storing the actual value itself. Use the following Windows standards for serial number types in the Serial Number [cmdb_serial_number] table:
  ◦ **system**: Product identification such as a serial number for software, a die number on a hardware chip, or a project number (for noncommercial products).
  ◦ **uuid**: Universally unique identifier (UUID) for the product. A UUID is a 128-bit identifier that is guaranteed to be different from other generated UUIDs.
  ◦ **chassis**: Manufacturer-allocated number that is used to identify a physical element. Value is the Serial Number member of the System Enclosure or Chassis structure in the SMBIOS information. This type represents the properties associated with a physical system enclosure.
  ◦ **bios**: The assigned serial number of the BIOS. This type represents the attributes of the computer system basic input/output services (BIOS) that are installed on the computer.
  ◦ **baseboard**: Manufacturer-allocated number that is used to identify the physical element. This property is inherited from CIM_PhysicalElement, and is sometimes referred to as the 'Motherboard Serial Number'.

• Network adapter:
  ◦ Use the Network Adapter [cmdb_ci_network_adapter] class to store network adapters.
  ◦ Set the **Name** attribute in the Network Adapter class to be the name of the Network Adapter device (such as eth0, eth1).
Set the MAC Address attribute to be the MAC address value. Format the string with colon separators between octets and lower case hexadecimal characters with padded zeros.
For example: 'f8:f2:1e:00:d4:66'

In the CI Relationship [cmdb_rel_ci] table, create an Owned By::Owns relationship to the associated Hardware CI. Specify a reference from the Network Adapter [cmdb_ci_network_adapter] table using the CI with a reference to the associated Hardware CI.

• IP address:

  ◦ Use the IP Address [cmdb_ci_ip_address] class to store IP addresses.
  ◦ Store an IP address value in the IP Address attribute, and in the Name attribute (to avoid empty Name attributes).
  ◦ Store an IPv4 IP address value using the format 'NNN.NNN.NNN.NNN', with decimal-based octets and period separators. Non-conforming values should be considered invalid and cleansed to null values.
  ◦ Store an IPv6 IP address value using lower case hexadecimal with colon separators. Non-confirming values should be considered invalid and cleansed to null values.
  ◦ Set the Netmask attribute to the IP address.
  ◦ In the CI Relationship [cmdb_rel_ci] table, create an Owned By::Owns relationship to the associated Hardware CI.
  ◦ Specify for the IP address a reference to the Network Adapter [cmdb_ci_network_adapter] table using the Configuration Item with a reference to the associated Hardware CI.
  ◦ To ensure that base system identification rules work properly, also store the IP address in the associated Network Adapter class.

• Network adapter and IP address:

  ◦ Store the MAC address of the network adapter installed on a server, in the Network Adapter [cmdb_ci_network_adapter] class.
  ◦ Store the IP address in the IP Address [cmdb_ci_ip_address] class.
  ◦ Do not store the MAC address or the IP address in the Server [cmdb_ci_server] class.
Key reference structures
Use the following key references as important guidelines when creating Hardware, Computer, or Server CIs:

• Software and processes running on a server: The Software [cmdb_ci_spkg] class contains the generic software package that is related to the server CI. The cmdb_sw_instance table instantiates each instance of the software package with:
  ◦ One to one reference back to the Server [cmdb_ci_server] class
  ◦ Many to one reference back to the Software class

These references are stored in the Installed on and the Product Name reference attributes respectively.

If either the Software Asset Management Foundation [com.snc.sams] or the Software Asset Management [com.snc.software_asset_management] plugin is installed, then store software details in the Software Installation [cmdb_sam_sw_install] table instead of the cmdb_sw_instance table.

• The Manufacturer and Model ID are reference attributes to the Company [core_company] and Product Model [cmdb_model] tables respectively.

• The Owned By, Assigned To, Managed By, and Supported By are reference attributes to the User [sys_user] table. The Assignment Group and Support Group are reference attributes to the Group [sys_user_group] table.

Identification rule
The base system contains pre-defined identification rules for the Hardware, Computer, and Server classes, which are identical. That identification rule has the following key identifier entries, listed in priority order:

1. Identifier entry which uses lookup-based identification specified with Serial Number [cmdb_serial_number] as the lookup table. The Serial Number table is a many to one reference from Serial Number back to the server CI.

2. Identifier entry specified with the Serial Number attribute in the CI.

3. Identifier entry for the Name attribute. If Serial Number is not available, then the Name (which is the hostname) attribute is used. If both the Serial Number and the Name attributes are provided, then Identification and Reconciliation Engine (IRE) looks first for the Serial Number. Then, if a Serial Number is not found, IRE falls back to using Name.
4. Identifier entry specified for the **MAC Address/IP Address** attributes in the Network Adapter table. However, do not rely only on the **MAC Address/IP Address**.

If both **Serial Number** and **Name** are not available, and only **MAC Address/IP Address** are available, use **MAC Address** as the name of the CI. Using the **MAC Address** as the name of the CI ensures that you don't create an empty CI.

For more information, see **CMDB Identification and Reconciliation**.

**VMware vCenter Object [cmdb_ci_vcenter_object] class**

Attributes, identification rule, and other important schema structures for Virtual Machine related classes.

**Schema description**

ServiceNow® has an extensive modeling of virtual machines (VMs) environment, with classes such as:

- VMware vCenter Cluster [cmdb_ci_vcenter_cluster]
- VMware vCenter datacenter [cmdb_ci_vcenter_datacenter]
- VMware Virtual Machine Instance [cmdb_ci_vmware_instance]

Virtual machines are modeled just like any other server, but with the **IsVirtual** attribute set to **true**.
In the diagram above, the 'Discovered' virtual server is referred to as the 'Guest' (VM object). Follow the preceding diagram for any further modeling of VMWare components.

**Key reference structures**

The Guest has the following important key reference structures:

- An Instantiates::InstantiatedBy relationship with the cmdb_ci_vmware_instance (which is the VM instance reported by Center).
- A Virtualizes::Virtualized by relationship with ESXi Server (the hardware with the ESXi virtualization software installed).
- Guest (Discovered, VMObject) also has a HasRegistered::RegisteredOn relationship to ESXi Server.

**Identification rules**

- Guest operating system: Guest operating system is modeled as Server (with **IsVirtual** set to **true**) and therefore identification rules follow the rules for the Server class. In most operating systems, BIOS UUID is reported as serial number. It is essential that you follow proper VMware guidelines to ensure that BIOS UUID is not being reused. Having a cloned BIOS UUID causes issues with identification rules.
- VM Instances: IRE uses instance MosRef ID as key identifier.
- ESX Server: Server is modeled as bare metal Server (with **IsVirtual** set to **false**) and therefore applies the Server class identification rules.

**Cloud class**

Description, identification rule, and other important schema structures for the CMDB cloud classes.

**AWS/Azure/OpenStack class model**

![AWS/Azure/OpenStack class model diagram](image-url)
Cloud schema description

ServiceNow has extensive models of cloud environments including Amazon Web Services (AWS), Microsoft Azure service, Google Cloud Platform (GCP), and IBM Cloud. Focusing on the compute side, the models for cloud environments and for Virtual Servers are similar. For example, instances of Amazon Elastic Compute Cloud (EC2) and Microsoft® Azure Cloud Compute, are an extension of Virtual Machine instances, where CIs are typically created by connecting directly to
cloud inventory. However, Virtual Machine instances do not represent actual usage of the cloud instance.

For example, you can represent a Linux guest host running on Amazon EC2 by the Server [cmdb_ci_server] class, with the `IsVirtual` attribute set to `true` and with the relationship Runs on:Runs to the EC2 instance. Integrating the AWS Config Service or the Amazon CloudWatch application, provides information on the EC2 object ID. Running Discovery or another discovery program on the guest Linux host, provides the `hostname`.

Ensure the following:

- Getting the correct UUID which gets stored in the Serial Number [cmdb_serial_number] table.
- Connecting/creating the cloud instance to Host OS, matching on the UUID/Object ID and creating the Runs On:Runs relationship.

Also, there is a complete model of Storage, Networking, Lamda/Functions in addition to modeling of different regions using the concept of the table Logical Datacenter [cmdb_ci_logical_datacenter] with Hosts:HostedOn relationship with Compute, Storage, and such.

**Identification rule**

The base system contains pre-defined identification rules for cloud schema classes. A cloud object requires the following identification items:

- **Object ID**: Which is synonymous with the IDs that cloud vendors use for each type of cloud resource, such as Azure Compute, EC2, and Amazon Simple Storage Service (S3).

- **Object ID** is unique per region and therefore has dependent relationship requiring information from the Logical Datacenter [cmdb_ci_logical_data_center] table, about the region where the cloud resource is being hosted. For example, AWS Datacenter [cmdb_ci_aws_datacenter], Azure Datacenter [cmdb_ci_azure_datacenter], Google Datacenter [cmdb_ci_google_datacenter] that are extended from Logical Datacenter.

Logical Datacenter itself, has two identifier entries:

- **Object ID**: Unique ID of the logical datacenter where applicable
  
  Or

- **Region**: The region of the cloud resource

- **Logical Datacenter** has a dependency on cloud service accounts, which has two identifier entries:
Object ID: Unique ID of the account where applicable.

Or

Account ID: The unique Account ID that encompasses the different cloud resources. Account ID is generally more applicable than Object ID.

For more information, see CMDB Identification and Reconciliation.

CMDB CI Class Models store app

The ServiceNow Configuration Management Database (CMDB) contains out-of-the-box classes that store data about Configuration Items (CIs). The CMDB CI Class Models store app adds class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable.

You can use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping can use these class extensions to populate CIs and discover various technologies and software.

Related ServiceNow® Store apps and reference information:

• **CMDB schema model**: A collection of class diagrams and class attributes for key CMDB classes.

• **CMDB tables descriptions**: Descriptions of key CMDB tables in the base system.

• **Populating the CMDB**: Information about the various options for populating the CMDB.

• **Discovery patterns**: A ServiceNow Store app that provides a library of Discovery patterns for discovering specific devices and applications in the industry.

• **Service Graph connectors**: ServiceNow Store apps that provide pre-defined integrations for importing and integrating common third-party data into CMDB classes. Also includes the IntegrationHub ETL wizard for creating new ETL transform maps.

Add class models

The app adds classes, columns, and the associated metadata as related records in the following tables:

• **CMDB Class Information [cmdb_class_info]**: Class descriptions

• **Identifier [cmdb_identifier]**: Identification rules
Discover using extension classes

The table lists the software and technologies that applications can discover using the extension classes. It provides links to documentation for CMDB CI Class Models and the corresponding ServiceNow Store discovery patterns.

<table>
<thead>
<tr>
<th>Software/Technology</th>
<th>CMDB CI Class Models Store app</th>
<th>ServiceNow Store discovery patterns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avi load balancer</td>
<td>Avi load balancer extension classes</td>
<td></td>
</tr>
<tr>
<td>BYOL Model of RDS for Oracle</td>
<td>BYOL model of RDS for Oracle extension classes</td>
<td></td>
</tr>
<tr>
<td>Firewall</td>
<td>Firewall extension classes</td>
<td></td>
</tr>
<tr>
<td>IBM Hardware Management Console (HMC)</td>
<td>IBM Hardware Management Console (HMC) extension classes</td>
<td></td>
</tr>
<tr>
<td>Internet of Things (IoT)</td>
<td>Internet of Things (IoT) extension classes</td>
<td>N/A</td>
</tr>
<tr>
<td>Nutanix</td>
<td>Nutanix extension classes</td>
<td></td>
</tr>
<tr>
<td>OpenStack</td>
<td>OpenStack extension classes</td>
<td></td>
</tr>
<tr>
<td>Red Hat Virtualization (RHV)</td>
<td>Red Hat Virtualization (RHV) extension classes</td>
<td></td>
</tr>
<tr>
<td>Transport Layer Security (TLS)</td>
<td>Transport Layer Security (TLS) extension classes</td>
<td>Discovery procedures provided by Certificate Inventory and Management ServiceNow Store app</td>
</tr>
<tr>
<td>VMware NSX load balancer</td>
<td>VMware NSX load balancer extension classes</td>
<td></td>
</tr>
</tbody>
</table>
Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Verify successful installation
After installing the CMDB CI Class Models store app, make sure the classes were added successfully:

1. Navigate to Configuration and then click CI Class Manager.
2. Click Hierarchy to display the CI Classes list.
   - This list contains the added classes, such as the Nutanix classes.
3. Select a class to see the corresponding class details, identification rules, identifier entries, and dependent relationships, if applicable.

Note: Uninstalling the CMDB CI Class Models application might compromise the integrity of the CMDB and result in unexpected behavior.

Avi load balancer extension classes
The CMDB CI Class Models store app adds or updates classes for the Avi load balancer.

The app adds class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable. You can use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs and discover various technologies and software.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Avi load balancer
The Avi Vantage platform is built on software-defined principles, enabling a next generation architecture to deliver the flexibility and simplicity expected by IT and lines of business. The Avi Vantage platform architecture separates the data and control planes to deliver application services beyond load balancing, such as application analytics, predictive autoscaling, micro-segmentation, and
self-service, for app owners in on-premises or cloud environments. The platform provides a centrally managed, dynamic pool of load balancing resources on commodity x86 servers, virtual machines, or containers, to deliver granular services close to individual applications. Providing these services allows network services to scale near infinitely without the added complexity of managing hundreds of disparate appliances.

ServiceNow Discovery uses the Avi Vantage load balancer discovery pattern to find Avi load balancer resources.

**Avi load balancer classes integrated with the CMDB class hierarchy**

![Diagram of Avi load balancer classes integrated with the CMDB class hierarchy]

**Classes**

This section lists the classes that the CMDB CI Class Models store app adds or updates. CMDB CI Class Models: Release 1.6.0 adds the following classes for the Avi load balancer. For the list of classes in a base system, including classes that this store app might be extending, see CMDB tables descriptions.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avi Controller [cmdb_ci_avi_controller]</td>
<td>Virtual Machine Object [cmdb_ci_vm_object]</td>
<td>Avi Controller is a single point of management and control that is the 'brain' of the entire Avi Vantage system, and typically deployed as a</td>
</tr>
</tbody>
</table>
### Class columns

CMDB CI Class Models: Release 1.6.0 adds the following column to the respective class.

<table>
<thead>
<tr>
<th>Added column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>version</td>
<td>The version of the Avi Service Engine resource.</td>
</tr>
</tbody>
</table>

### Related information

**CMDB schema model**

**BYOL model of RDS for Oracle extension classes**

The CMDB CI Class Models store app adds or updates classes for the BYOL Model of RDS for Oracle.

The app adds class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable. You can use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use...
these class extensions to populate CIs and discover various technologies and software.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**BYOL Model of RDS for Oracle**

The Amazon RDS for Oracle is a fully managed commercial database that makes it easy to set up, operate, and scale Oracle deployments in the cloud. You can run Amazon RDS for Oracle under two different licensing models – “License Included” and “Bring-Your-Own-License (BYOL)“. In the “License Included” service model, you do not need separately purchased Oracle licenses; the Oracle Database software has been licensed by AWS.

We support discovery of the RDS Databases and their licenses.

**Classes**

This section lists the classes that the CMDB CI Class Models store app adds or updates. CMDB CI Class Models: Release 1.23.0 adds the following classes for the BYOL Model of RDS for Oracle. For the list of classes in a base system, including classes that this store app might be extending, see CMDB tables descriptions.

<table>
<thead>
<tr>
<th>Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cmdb_ci_cloud_database</td>
<td>The cloud databases.</td>
</tr>
<tr>
<td>cmdb_ci_serverless_hardware</td>
<td>Hardware type information of the databases.</td>
</tr>
</tbody>
</table>

**Class Columns**

CMDB CI Class Models: Release 1.23.0 adds the following column to the respective class.

<table>
<thead>
<tr>
<th>Serverless Hardware [cmdb_ci_serverless_hardware]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Added column</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>cloud_vendor</td>
</tr>
<tr>
<td>host_type</td>
</tr>
</tbody>
</table>
Serverless Hardware [cmdb_ci_serverless_hardware] (continued)

<table>
<thead>
<tr>
<th>Added column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cpu_core_count</td>
<td>Amount of CPU cores.</td>
</tr>
<tr>
<td>cpu_core_thread</td>
<td>Amount of CPU threads.</td>
</tr>
<tr>
<td>cpu_count</td>
<td>Amount of CPUs.</td>
</tr>
<tr>
<td>object_id</td>
<td>ID of the CI.</td>
</tr>
</tbody>
</table>

Cloud Database [cmdb_ci_cloud_database]

<table>
<thead>
<tr>
<th>Added column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>multi_az</td>
<td>Determines if the database is deployed on multiple availability zones (true/false).</td>
</tr>
<tr>
<td>replication_enabled</td>
<td>Determines if replication is enabled (true/false).</td>
</tr>
<tr>
<td>replication_type</td>
<td>Replication type.</td>
</tr>
<tr>
<td>replica_source</td>
<td>Database name of the replication source.</td>
</tr>
</tbody>
</table>

Firewall extension classes

The CMDB CI Class Models store app adds or updates classes for firewall devices.

The app adds class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships (if applicable). You can use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs and discover various technologies and software.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Firewalls

A firewall is a network security system that monitors and controls incoming and outgoing network traffic, based on security policies. Firewalls typically form a barrier between an internal network and an untrusted external network, such as the internet. It usually consists of security policies that help secure an organization from external threats and cyber attacks. Firewall vendors may provide a centralized firewall manager to manage many firewall devices and the security policies residing on them. For example, Panorama™ is the centralized management system for Palo Alto Networks firewalls.

Firewall extension classes integrated with the CMDB class hierarchy (CMDB CI Class Models: Release 1.11.0)
Firewall extension classes integrated with the CMDB class hierarchy (CMDB CI Class Models: Release 1.10.0)

Classes

This section lists the classes that the CMDB CI Class Models store app adds or updates.

CMDB CI Class Models: Release 1.10.0 adds or updates the following classes for the discovery of network firewall devices. For the list of CMDB classes in a base system, including ones that this store app might be extending, see CMDB tables descriptions.
<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Firewall</td>
<td>NETGEAR [cmdb_ci_netgear]</td>
<td>Contains all network firewalls.</td>
</tr>
<tr>
<td>Firewall Device</td>
<td>IP Firewall [cmdb_ci_ip_firewall]</td>
<td>Network security system that monitors and controls incoming and outgoing network traffic, based on security policies.</td>
</tr>
<tr>
<td>Fortinet Firewall Device</td>
<td>Firewall Device [fortinet]</td>
<td>Fortinet firewall device.</td>
</tr>
<tr>
<td>Juniper Firewall Device</td>
<td>Firewall Device [juniper]</td>
<td>Juniper firewall device.</td>
</tr>
<tr>
<td>Panorama Firewall Device Group</td>
<td>Firewall Device Group [group_panorama]</td>
<td>Group of Panorama devices.</td>
</tr>
<tr>
<td>Palo Alto Firewall Device</td>
<td>Firewall Device [palo_alto]</td>
<td>Palo Alto firewall device.</td>
</tr>
<tr>
<td>Firewall Cluster</td>
<td>[cmdb_ci_cluster]</td>
<td>Group of firewall nodes that work as a single logical entity.</td>
</tr>
<tr>
<td>Fortinet Firewall Cluster</td>
<td>Firewall Cluster [fortinet]</td>
<td>Fortinet firewall cluster.</td>
</tr>
<tr>
<td>Firewall Manager</td>
<td>CMDB CI [cmdb_ci]</td>
<td>System that provides centralized management for many firewall devices and the security policies residing on them.</td>
</tr>
<tr>
<td>Panorama Firewall Manager</td>
<td>Firewall Manager [panorama]</td>
<td>The centralized network security management system.</td>
</tr>
</tbody>
</table>
Class | Extends | Description
--- | --- | ---

CMDB CI Class Models: Release 1.12.0 adds the following class for the discovery of network firewall devices.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
</table>

### Class columns

CMDB CI Class Models: Release 1.10.0 adds the following columns to the respective classes.

**IP Firewall [cmdb_ci_ip_firewall] class**

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware Operating System</td>
<td>OS running on the hardware.</td>
</tr>
<tr>
<td>Hardware OS Version</td>
<td>OS version running on the hardware.</td>
</tr>
</tbody>
</table>

**Firewall Cluster [cmdb_ci_firewall_cluster] class**

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware Operating System</td>
<td>OS running on the hardware.</td>
</tr>
<tr>
<td>Hardware OS Version</td>
<td>OS version running on the hardware.</td>
</tr>
</tbody>
</table>

CMDB CI Class Models: Release 1.12.0 adds no columns to the existing classes.

### Related information

CMDB schema model
IBM Hardware Management Console (HMC) extension classes

The CMDB CI Class Models store app adds or updates classes for the IBM Hardware Management Console (HMC).

The app adds class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable. You can use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs and discover various technologies and software.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IBM Hardware Management Console (HMC)

The IBM HMC extension classes support discovery of IBM virtualization technology by providing:

- Discovery of LPARs/FRAMEs, which SAM use cases need
- Topology data of IBM HMC, which event correlation requires
- Topology data for ITSM use cases, such as in-frame migration
IBM HMC extension classes integrated with the CMDB class hierarchy

Classes
This section lists the classes that the CMDB CI Class Models store app adds or updates. See the class columns table for further details about the columns added for each class.

CMDB CI Class Models: Release 1.3.0 adds the following classes for the IBM HMC. For the list of CMDB classes in a base system, including ones that this store app might be extending, see CMDB tables descriptions.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Frame</td>
<td>Server</td>
<td>IBM physical machine with considerable resources which can be virtualized.</td>
</tr>
<tr>
<td>[cmdb_ci_ibm_frame]</td>
<td>[cmdb_ci_server]</td>
<td></td>
</tr>
<tr>
<td>IBM HMC Processor pool</td>
<td>Virtual Machine Object</td>
<td>IBM shared pool used to allocate processors to a group of LPARs.</td>
</tr>
<tr>
<td>[cmdb_ci_processor_pool]</td>
<td>[cmdb_ci_vm_object]</td>
<td></td>
</tr>
</tbody>
</table>

CMDB CI Class Models: Release 1.2.0 adds the following classes for the IBM HMC.
<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM HMC Server [cmdb_ci_hmc_server]</td>
<td>Server [cmdb_ci_server]</td>
<td>IBM console that manages frames and assigns logical partitions (LPARs) to pools.</td>
</tr>
<tr>
<td>IBM Frame [cmdb_ci_ibm_frame]</td>
<td>Server [cmdb_ci_server]</td>
<td>IBM physical machine with considerable resources which can be virtualized.</td>
</tr>
<tr>
<td>IBM LPAR Instance [cmdb_ci_lpar_instance]</td>
<td>Virtual Machine Instance [cmdb_ci_vm_instance]</td>
<td>IBM logical partition representing the virtual aspect of the operating system.</td>
</tr>
<tr>
<td>IBM HMC Processor pool [cmdb_ci_processor_pool]</td>
<td>Virtual Machine Object [cmdb_ci_vm_object]</td>
<td>IBM shared pool used to allocate processors to a group of LPARs.</td>
</tr>
</tbody>
</table>

### Class columns

CMDB CI Class Models: Release 1.3.0 adds the following columns to the respective classes.

#### IBM Frame [cmdb_ci_ibm_frame] class

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current available processor units</td>
<td>Current available processor units.</td>
</tr>
<tr>
<td>Configurable processor units</td>
<td>Configurable processor units.</td>
</tr>
<tr>
<td>Configurable memory units</td>
<td>Configurable memory units.</td>
</tr>
<tr>
<td>Installed processor units</td>
<td>Installed processor units.</td>
</tr>
<tr>
<td>Current available memory units</td>
<td>Current available memory units.</td>
</tr>
<tr>
<td>Installed memory units</td>
<td>Installed memory units.</td>
</tr>
</tbody>
</table>
IBM HMC Processor pool [cmdb_ci_processor_pool] class

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LPAR IDs</td>
<td>LPAR IDs.</td>
</tr>
<tr>
<td>LPAR names</td>
<td>LPAR names.</td>
</tr>
<tr>
<td>Frame name</td>
<td>Frame name.</td>
</tr>
</tbody>
</table>

CMDB CI Class Models: Release 1.2.0 adds the following columns to the respective classes.

IBM HMC Server [cmdb_ci_hmc_server] class

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame count</td>
<td>Count of frames.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is VIO</td>
<td>Flags whether this VM is a (VIO) virtual input/output server in the HMC topology.</td>
</tr>
<tr>
<td>High Watermark VCPU</td>
<td>Peak in the utilization of virtual CPU assigned to during the reporting period.</td>
</tr>
<tr>
<td>Frame Serial Number</td>
<td>Serial number of a frame (frame being a physical machine such as ESX).</td>
</tr>
<tr>
<td>VIO Servers</td>
<td>List of VIO servers.</td>
</tr>
</tbody>
</table>

LPAR Resource [cmdb_ci_lpar_resource] class

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node name</td>
<td>Name of the node.</td>
</tr>
<tr>
<td>Partition Name</td>
<td>Name of the partition.</td>
</tr>
<tr>
<td>Partition Number</td>
<td>Number of the partition.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of LPAR Resource.</td>
</tr>
</tbody>
</table>
### LPAR Resource [cmdb_ci_lpar_resource] class (continued)

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>Mode of LPAR Resource.</td>
</tr>
<tr>
<td>Entitled Capacity</td>
<td>Allotted capacity granted.</td>
</tr>
<tr>
<td>Partition Group-ID</td>
<td>ID of a group of partitions.</td>
</tr>
<tr>
<td>Shared Pool ID</td>
<td>ID of a pool of shared processors.</td>
</tr>
<tr>
<td>Online Virtual CPUs</td>
<td>A virtual CPU.</td>
</tr>
<tr>
<td>Maximum Memory</td>
<td>Maximum amount of memory.</td>
</tr>
<tr>
<td>Minimum Memory</td>
<td>Minimum amount of memory.</td>
</tr>
<tr>
<td>Variable Capacity Weight</td>
<td>Logical partition processor capacity weight.</td>
</tr>
<tr>
<td>Minimum Capacity</td>
<td>Minimum number of processes.</td>
</tr>
<tr>
<td>Capacity Increment</td>
<td>Increments of process.</td>
</tr>
<tr>
<td>Maximum Physical CPUs in system</td>
<td>Maximum CPUs allotted in system.</td>
</tr>
<tr>
<td>Active Physical CPUs in system</td>
<td>Current CPUs in system.</td>
</tr>
<tr>
<td>Active CPUs in Pool</td>
<td>Number of active CPUs within a pool.</td>
</tr>
<tr>
<td>Shared Physical CPUs in system</td>
<td>Number of shared CPUs within a system.</td>
</tr>
<tr>
<td>Maximum Capacity of Pool</td>
<td>Maximum capacity of processes within a pool.</td>
</tr>
<tr>
<td>Entitled Capacity of Pool</td>
<td>Number of processes that are entitled.</td>
</tr>
<tr>
<td>Unallocated Capacity</td>
<td>Number of free spaces.</td>
</tr>
<tr>
<td>Physical CPU Percentage</td>
<td>Number of CPUs allocated to system.</td>
</tr>
<tr>
<td>Unallocated Weight</td>
<td>At no extra charge resources on instance.</td>
</tr>
<tr>
<td>Desired Virtual CPUs</td>
<td>Target number of virtual CPUs.</td>
</tr>
<tr>
<td>Desired Memory</td>
<td>Target amount of memory.</td>
</tr>
<tr>
<td>Desired Variable Capacity Weight</td>
<td>Targeted processor load.</td>
</tr>
<tr>
<td>Desired Capacity</td>
<td>Target resources used within instance.</td>
</tr>
</tbody>
</table>
LPAR Resource [cmdb_ci_lpar_resource] class (continued)

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Watermark VCPU</td>
<td>Peak in the utilization of virtual CPU assigned to during the reporting period.</td>
</tr>
</tbody>
</table>

IBM HMC Processor pool [cmdb_ci_processor_pool] class

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pool ID</td>
<td>ID of pool of processors.</td>
</tr>
<tr>
<td>CPU Core count</td>
<td>Number of CPU cores.</td>
</tr>
<tr>
<td>Memory count</td>
<td>Amount of memory used.</td>
</tr>
<tr>
<td>Unassigned cores</td>
<td>Number of unused cores.</td>
</tr>
<tr>
<td>Unassigned memory</td>
<td>Amount of unassigned memory.</td>
</tr>
</tbody>
</table>

The following class has no added columns:

- IBM Frame [cmdb_ci_ibm_frame]

Related information

**CMDB schema model**

**Internet of Things (IoT) extension classes**

The CMDB CI Class Models store app adds or updates classes for the Internet of Things (IoT).

The app adds class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable. You can use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs and discover various technologies and software.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
Internet of Things (IoT)

IoT is a system of interrelated computing devices, mechanical and digital machines, objects, animals or people that are provided with unique identifiers and the ability to transfer data over a network without requiring human-to-human or human-to-computer interaction. The classes added in this release, extend the Data Model to provide a foundation for the representation of IoT CI classes. This foundation underpins workflows for Enterprise Asset Management (EAM), Governance Risk Compliance (GRC), Component Supply Management (CSM), and Field Service Management (FSM) surrounding the management of IoT devices and the transport vehicles that some reside in.

IoT extension classes integrated with the CMDB class hierarchy

Classes

This section lists the classes that the CMDB CI Class Models store app adds or updates.

CMDB CI Class Models: Release 1.6.0 adds the following classes for IoT. For the list of CMDB classes in a base system, including ones that this store app might be extending, see CMDB tables descriptions.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transport Type</td>
<td>cmdb_ci</td>
<td>Types of transportation that contain interconnected technology.</td>
</tr>
<tr>
<td>Class</td>
<td>Extends</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Converged Infrastructure</td>
<td>cmdb_ci_hardware</td>
<td>Devices that serve both computing and networking functions.</td>
</tr>
<tr>
<td>[cmdb_ci_converged_infra]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IoT Device</td>
<td>cmdb_ci_hardware</td>
<td>Parent table that contains Internet of Things device types.</td>
</tr>
<tr>
<td>[cmdb_ci_IoT]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Aircraft</td>
<td>Transport Type [cmdb_ci_transport]</td>
<td>A transportation method that utilizes air or space as its primary pathway.</td>
</tr>
<tr>
<td>[cmdb_ci_aircraft]</td>
<td></td>
<td>For example, airplanes and helicopters.</td>
</tr>
<tr>
<td>Ship</td>
<td>Transport Type [cmdb_ci_transport]</td>
<td>A transportation method that utilizes water as its primary pathway.</td>
</tr>
<tr>
<td>[cmdb_ci_ship]</td>
<td></td>
<td>For example, ships.</td>
</tr>
<tr>
<td>Train</td>
<td>Transport Type [cmdb_ci_transport]</td>
<td>A transportation method that utilizes rails as its primary pathway.</td>
</tr>
<tr>
<td>[cmdb_ci_train]</td>
<td></td>
<td>For example, Amtrak.</td>
</tr>
<tr>
<td>Vehicle</td>
<td>Transport Type [cmdb_ci_transport]</td>
<td>A transportation method that utilizes wheels or tracks as its method of</td>
</tr>
<tr>
<td>[cmdb_ci_vehicle]</td>
<td></td>
<td>movement. For example, cars, trucks, bulldozers.</td>
</tr>
<tr>
<td>IoT Gateway</td>
<td>Converged Infrastructure [</td>
<td>A device that provides the following services:</td>
</tr>
<tr>
<td>[cmdb_ci_IoT_gateway]</td>
<td>cmdb_ci_converged_infra]</td>
<td>• Forwards packets between LAN and WAN on the IP layer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Performs application layer functions between IoT nodes and other entities.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Enables local, short-range communication between IoT devices.</td>
</tr>
<tr>
<td>Class</td>
<td>Extends</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Security Device [cmdb_ci_security]</td>
<td>IoT Device [cmdb_ci_IoT]</td>
<td>Connected device that serves a security function such as badge readers.</td>
</tr>
<tr>
<td>Single Board Computing [cmdb_ci_sbc]</td>
<td>IoT Device [cmdb_ci_IoT]</td>
<td>Single Board Computing device such as a Raspberry Pi.</td>
</tr>
<tr>
<td>Display Device [cmdb_ci_display]</td>
<td>IoT Device [cmdb_ci_IoT]</td>
<td>Connected device that displays images.</td>
</tr>
<tr>
<td>Imaging Device [cmdb_ci_imaging]</td>
<td>IoT Device [cmdb_ci_IoT]</td>
<td>Connected device that captures images.</td>
</tr>
<tr>
<td>Medical Device [cmdb_ci_medical]</td>
<td>IoT Device [cmdb_ci_IoT]</td>
<td>Connected device that serves a Medical Care function such as a nurse call unit.</td>
</tr>
<tr>
<td>Multimedia Device [cmdb_ci_multimedia]</td>
<td>IoT Device [cmdb_ci_IoT]</td>
<td>A connected device that helps the generation or delivery of media content.</td>
</tr>
<tr>
<td>Payment Device [cmdb_ci_payment]</td>
<td>IoT Device [cmdb_ci_IoT]</td>
<td>Connected device that allows for purchasing goods or services.</td>
</tr>
<tr>
<td>Drone [cmdb_ci_drone]</td>
<td>IoT Device [cmdb_ci_IoT]</td>
<td>Unmanned connected device with mobility.</td>
</tr>
<tr>
<td>Wearable Technology [cmdb_ci_wearable]</td>
<td>IoT Device [cmdb_ci_IoT]</td>
<td>Connected device that is worn by an entity such as a smart watch.</td>
</tr>
<tr>
<td>Smart Television [cmdb_ci_stv]</td>
<td>Display Device [cmdb_ci_display]</td>
<td>A television that is network connected and can run applications.</td>
</tr>
<tr>
<td>IP Camera [cmdb_ci_ip_camera]</td>
<td>Imaging Device [cmdb_ci_imaging]</td>
<td>A camera that is network connected.</td>
</tr>
<tr>
<td>Class</td>
<td>Extends</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Medical Measuring Device</td>
<td>Medical Device [cmdb_ci_medical]</td>
<td>A device that is network connected which takes medical measurements such as the Abbott iStat System.</td>
</tr>
<tr>
<td>[cmdb_ci_med_measuring]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Medical Diagnostic Device</td>
<td>Medical Device [cmdb_ci_medical]</td>
<td>A medical diagnostic device that is network connected, such as a CT system.</td>
</tr>
<tr>
<td>[cmdb_ci_med_diagnostic]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Medical Monitoring Device</td>
<td>Medical Device [cmdb_ci_medical]</td>
<td>A device that is network connected which is used to monitor medical patients. For example, the Phillips Patient Monitoring System.</td>
</tr>
<tr>
<td>[cmdb_ci_med_monitoring]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Medical Therapeutic Device</td>
<td>Medical Device [cmdb_ci_medical]</td>
<td>A device that is network connected which provides medical patient therapy. For example, the Compex Muscle Stimulator.</td>
</tr>
<tr>
<td>[cmdb_ci_med_therapeutic]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Medical Support Device</td>
<td>Medical Device [cmdb_ci_medical]</td>
<td>A device that is network connected that helps deliver medical care. For example, the Pyxis MedStation.</td>
</tr>
<tr>
<td>[cmdb_ci_med_support]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Process Logic Controller</td>
<td>Manufacturing Device [cmdb_ci_manufacturing]</td>
<td>A logic controller that is network connected which is used in manufacturing. For example, devices made by Siemens and Allen Bradley.</td>
</tr>
<tr>
<td>[cmdb_ci_plc]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Machine Interface</td>
<td>Manufacturing Device [cmdb_ci_manufacturing]</td>
<td>An HMI that is network connected which is used in manufacturing. For example, devices made</td>
</tr>
<tr>
<td>[cmdb_ci_hmi]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Class</td>
<td>Extends</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Game Console</td>
<td>Multimedia Device</td>
<td>A device that is network connected which is used to play games or stream media. For example, an Xbox or Playstation.</td>
</tr>
<tr>
<td>[cmdb_ci_game_console]</td>
<td>[cmdb_ci_multimedia]</td>
<td></td>
</tr>
<tr>
<td>Media Player</td>
<td>Multimedia Device</td>
<td>A device that is network connected which is used to play digital media content. For example, Amazon Fire TV.</td>
</tr>
<tr>
<td>[cmdb_ci_media_player]</td>
<td>[cmdb_ci_multimedia]</td>
<td></td>
</tr>
<tr>
<td>Display Monitor Control</td>
<td>Multimedia Device</td>
<td>A device that is network connected that controls the display of media on a monitor. For example, a Crestron Media Controller.</td>
</tr>
<tr>
<td>[cmdb_ci_monitor_control]</td>
<td>[cmdb_ci_multimedia]</td>
<td></td>
</tr>
<tr>
<td>Point of Sale Device</td>
<td>Payment Device</td>
<td>A device that is network connected which is used in the purchase of goods or services. For example, a credit card reader.</td>
</tr>
<tr>
<td>[cmdb_ci_pos]</td>
<td>[cmdb_ci_payment]</td>
<td></td>
</tr>
</tbody>
</table>

**Related information**

**CMDB schema model**

**Kubernetes extension classes**

The CMDB CI Class Models store app adds or updates classes for the Kubernetes pattern.

The app adds class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable. You can use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs and discover various technologies and software.
Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Kubernetes pattern

The Kubernetes pattern main flow helps with discovering Kubernetes core elements. The classes in this release, extend the support to discover Kubernetes workload controller components like deployments, daemonsets, and statefulsets. The Workload Share library captures information about deployments, daemonsets, and statefulsets and stores them in the respective tables. Other extensions include a YAML and service mesh extension that generates a YAML file to track configuration files and creating service to service relations by discovering service mesh information.

**Kubernetes extension class integrated with the CMDB hierarchy**

![Diagram showing Kubernetes extension class integrated with the CMDB hierarchy](image-url)
Classes

This section lists the classes that the CMDB CI Class Models store app adds or updates.

CMDB CI Class Models: Release 1.12.0 adds the following classes for Kubernetes pattern. For the list of CMDB classes in a base system, including ones that this store app might be extending, see CMDB tables descriptions.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Fields</th>
<th>Relation</th>
</tr>
</thead>
</table>
| cmdb_ci_kubernetes_workload | cmdb_ci_kubernetes_components | • Replicas Desired  
• Replicas Updated  
• Replicas Total  
• Replicas Available  
• Replicas Unavailable | Provides from cmdb_ci_kubernetes_service  
Hosted on Cluster |
| cmdb_ci_kubernetes_workload | cmdb_ci_kubernetes_deployment | • Pods running  
• Pods Waiting  
• Pods Succeeded | Hosted on Cluster |
### Related information

#### CMDB schema model

#### Nutanix extension classes

The CMDB CI Class Models store app adds or updates classes for Nutanix. The app adds class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable. You can use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs and discover various technologies and software.

#### Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

#### Nutanix Enterprise Cloud platform

The Nutanix Enterprise Cloud platform is a converged, scale-out compute and storage system that hosts and stores virtual machines. All nodes in a Nutanix cluster share the management of cluster resources. The foundational unit for the cluster is a Nutanix node which runs a standard hypervisor and contains processors, memory, and local storage (SSDs and hard disks). A Nutanix Controller virtual machine runs on each node, enabling the pooling of local storage from all nodes in the cluster.

---

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Classes

This section lists the classes that the CMDB CI Class Models store app adds or updates. See the class columns table for further details about the columns added for each class.

CMDB CI Class Models: Release 1.6.0 adds the following classes for Nutanix. For the list of CMDB classes in a base system, including ones that this store app might be extending, see CMDB tables descriptions.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nutanix Prism Central</td>
<td>Virtual Machine Object</td>
<td>Multi-cluster manager responsible for managing multiple Acropolis Clusters to provide a single, centralized management interface.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_prism_central]</td>
<td>[cmdb_ci_vm_object]</td>
<td></td>
</tr>
</tbody>
</table>

CMDB CI Class Models: Release 1.2.0 adds the following classes for Nutanix.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nutanix Cluster</td>
<td>Virtual Machine Object</td>
<td>Cluster comprising of the physical nodes running Nutanix software.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_cluster]</td>
<td>[cmdb_ci_vm_object]</td>
<td></td>
</tr>
<tr>
<td>Nutanix Controller VM</td>
<td>Application</td>
<td>Nutanix controller virtual machine that is present in each node and that provides the storage clustering and management capabilities.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_controller_vm]</td>
<td>[cmdb_ci_appl]</td>
<td></td>
</tr>
<tr>
<td>Nutanix Storage Container</td>
<td>Storage Volume</td>
<td>Subset of Nutanix storage pool used to apply policies such as reserved capacity, replication factor, and storage optimization options.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_storage_container]</td>
<td>[cmdb_ci_storage_volume]</td>
<td></td>
</tr>
<tr>
<td>Nutanix Storage Pool</td>
<td>Storage Pool</td>
<td>Grouping of physical disks within a Nutanix cluster which is typically</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_storage]</td>
<td>[cmdb_ci_storage_pool]</td>
<td></td>
</tr>
</tbody>
</table>
### CMDB CI Class Models: Release 1.1.5 adds the following classes for Nutanix.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Nutanix Host</strong></td>
<td>Virtualization Server</td>
<td>Physical host on which all virtual machines run.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_host]</td>
<td>[cmdb_ci_virtualization_server]</td>
<td></td>
</tr>
<tr>
<td><strong>Nutanix Virtual Machine Instance</strong></td>
<td>Virtual Machine Instance</td>
<td>A virtual machine that runs on Nutanix infrastructure.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_vm_instance]</td>
<td>[cmdb_ci_vm_instance]</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Class Table

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[cmdb_ci_nutanix_host]</td>
<td>[cmdb_ci_virtualization_server]</td>
<td>Nutanix Virtual Machine Instance</td>
</tr>
<tr>
<td></td>
<td>[cmdb_ci_vm_instance]</td>
<td>Virtual Machine Instance</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_vm_instance]</td>
<td>[cmdb_ci_vm_instance]</td>
<td>A virtual machine that runs on Nutanix infrastructure.</td>
</tr>
<tr>
<td>Nutanix Cluster</td>
<td>[cmdb_ci_vm_object]</td>
<td>Virtual Machine Object</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_cluster]</td>
<td></td>
<td>Cluster comprising of the physical nodes running Nutanix software.</td>
</tr>
<tr>
<td>Nutanix Controller VM</td>
<td>[cmdb_ci_appl]</td>
<td>Application</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_controller_vm]</td>
<td>[cmdb_ci_appl]</td>
<td>Nutanix controller virtual machine that is present in each node and that provides the storage clustering and management capabilities.</td>
</tr>
<tr>
<td>Nutanix Storage Container</td>
<td>[cmdb_ci_storage_volume]</td>
<td>Storage Volume</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_storage_container]</td>
<td></td>
<td>Subset of Nutanix storage pool used to apply policies such as reserved capacity, replication factor, and storage optimization options.</td>
</tr>
<tr>
<td>Nutanix Storage Pool</td>
<td>[cmdb_ci_storage_pool]</td>
<td>Storage Pool</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_storage_pool]</td>
<td></td>
<td>Grouping of physical disks within a Nutanix cluster which is typically used to create physical separation between virtual machines.</td>
</tr>
<tr>
<td>Nutanix Host</td>
<td>[cmdb_ci_virtualization_server]</td>
<td>Virtualization Server</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_host]</td>
<td>[cmdb_ci_virtualization_server]</td>
<td>Physical host on which all the virtual machines run.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_vm_instance]</td>
<td>[cmdb_ci_vm_instance]</td>
<td></td>
</tr>
</tbody>
</table>
Class columns

CMDB CI Class Models: Release 1.6.0 adds no columns to the Nutanix Prism Central [cmdb_ci_nutanix_prism_central] class.

CMDB CI Class Models: Release 1.2.0 adds the following columns to the respective classes.

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block Serial Numbers</td>
<td>Serial numbers of blocks that are connected to the cluster.</td>
</tr>
<tr>
<td>Cluster ID</td>
<td>UUID (Universal Unique Identifier) of the cluster.</td>
</tr>
<tr>
<td>External Subnet</td>
<td>Subnet of the external IP address of the cluster.</td>
</tr>
<tr>
<td>Full Version</td>
<td>Full version of the cluster.</td>
</tr>
<tr>
<td></td>
<td>For example: el7.3-release-euphrates-5.10.3.1-stable-655d4def34bf18785782f2adb8ccdd5f8457d1</td>
</tr>
<tr>
<td>Hypervisor Types</td>
<td>Types of hypervisors that are related to this cluster.</td>
</tr>
<tr>
<td>Internal Subnet</td>
<td>Subnet of internal IP addresses.</td>
</tr>
<tr>
<td>NCC Version</td>
<td>Nutanix cluster check version.</td>
</tr>
<tr>
<td>NTP Servers</td>
<td>NTP servers that are related to this cluster.</td>
</tr>
<tr>
<td>Number of Nodes</td>
<td>Number of nodes that are connected to the cluster.</td>
</tr>
<tr>
<td>Timezone</td>
<td>Timezone of the cluster.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the cluster.</td>
</tr>
<tr>
<td></td>
<td>For example: 5.10.3.1</td>
</tr>
</tbody>
</table>
**Nutanix Controller VM [cmdb_ci_nutanix_controller_vm] class**

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hypervisor Type</td>
<td>Type of hypervisor.</td>
</tr>
<tr>
<td>Memory (MB)</td>
<td>Amount of memory (in MB) available on the controller.</td>
</tr>
<tr>
<td>State</td>
<td>On/off power state of controller.</td>
</tr>
<tr>
<td>VM ID</td>
<td>UUID of the controller virtual machine.</td>
</tr>
<tr>
<td>Object ID</td>
<td>ID of the controller virtual machine.</td>
</tr>
</tbody>
</table>

**Nutanix Storage Container [cmdb_ci_nutanix_storage_container] class**

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compression</td>
<td>Indicates whether compression is enabled.</td>
</tr>
<tr>
<td>Container ID</td>
<td>UUID of the container.</td>
</tr>
<tr>
<td>Deduplication</td>
<td>Indicates whether on disk deduplication is enabled, that is dedup compression applied to data on hard disks (HDD). Performance tier deduplication is a prerequisite for on disk deduplication.</td>
</tr>
<tr>
<td>Erasure Code</td>
<td>Indicates whether erasure coding is enabled.</td>
</tr>
<tr>
<td>Replication Factor</td>
<td>Number of maintained data copies. The replication factor is specified (2 or 3) when the container is created.</td>
</tr>
</tbody>
</table>

The following classes have no added columns:

- Nutanix Storage Pool [cmdb_ci_nutanix_storage_pool]
- Nutanix Host [cmdb_ci_nutanix_host]
- Nutanix Virtual Machine Instance [cmdb_ci_nutanix_vm_instance]

CMDB CI Class Models: Release 1.1.5 adds the following columns to the respective classes.
### Nutanix Cluster [cmdb_ci_nutanix_cluster] class

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block Serial Numbers</td>
<td>Serial numbers of blocks that are connected to the cluster.</td>
</tr>
<tr>
<td>Cluster ID</td>
<td>UUID (Universal Unique Identifier) of the cluster.</td>
</tr>
<tr>
<td>External Subnet</td>
<td>Subnet of the external IP address of the cluster.</td>
</tr>
<tr>
<td>Full Version</td>
<td>Full version of the cluster.</td>
</tr>
<tr>
<td></td>
<td>For example: el7.3-release-euphrates-5.10.3.1-stable-655d4def34bf18785782f2adb8cdd5f8457d1</td>
</tr>
<tr>
<td>Hypervisor Types</td>
<td>Types of hypervisors that are related to this cluster.</td>
</tr>
<tr>
<td>Internal Subnet</td>
<td>Subnet of internal IP addresses.</td>
</tr>
<tr>
<td>NCC Version</td>
<td>Nutanix cluster check version.</td>
</tr>
<tr>
<td>NTP Servers</td>
<td>NTP servers that are related to this cluster.</td>
</tr>
<tr>
<td>Number of Nodes</td>
<td>Number of nodes that are connected to the cluster.</td>
</tr>
<tr>
<td>Timezone</td>
<td>Timezone of the cluster.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the cluster.</td>
</tr>
<tr>
<td></td>
<td>For example: 5.10.3.1</td>
</tr>
</tbody>
</table>

### Nutanix Controller VM [cmdb_ci_nutanix_controller_vm] class

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hypervisor Type</td>
<td>Type of hypervisor.</td>
</tr>
<tr>
<td>Memory</td>
<td>Amount of memory (in MB) available to the virtual machine.</td>
</tr>
<tr>
<td>State</td>
<td>On/off state of power.</td>
</tr>
<tr>
<td>VM ID</td>
<td>UUID of the controller virtual machine.</td>
</tr>
</tbody>
</table>
Nutanix Controller VM [cmdb_ci_nutanix_controller_vm] class. (continued)

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object ID</td>
<td>ID of the controller virtual machine.</td>
</tr>
</tbody>
</table>

Nutanix Storage Container [cmdb_ci_nutanix_storage_container] class

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compression</td>
<td>Indicates whether compression is enabled.</td>
</tr>
<tr>
<td>Container ID</td>
<td>UUID of the container.</td>
</tr>
<tr>
<td>Deduplication</td>
<td>Indicates whether on disk deduplication is enabled, that is dedup compression applied to data on hard disks (HDD). Performance tier deduplication is a prerequisite for on disk deduplication.</td>
</tr>
<tr>
<td>Erasure Code</td>
<td>Indicates whether erasure coding is enabled.</td>
</tr>
<tr>
<td>Replication Factor</td>
<td>Number of maintained data copies. The replication factor is specified (2 or 3) when the container is created.</td>
</tr>
</tbody>
</table>

The following classes have no added columns:

- Nutanix Storage Pool [cmdb_ci_nutanix_storage_pool]
- Nutanix Host [cmdb_ci_nutanix_host]
- Nutanix Virtual Machine Instance [cmdb_ci_nutanix_vm_instance]

CMDB CI Class Models: Release 1.1.4 adds the following columns to the respective classes.

Nutanix Cluster [cmdb_ci_nutanix_cluster] class

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block Serial Numbers</td>
<td>Serial numbers of blocks that are connected to the cluster.</td>
</tr>
</tbody>
</table>
### Nutanix Cluster [cmdb_ci_nutanix_cluster] class (continued)

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster ID</td>
<td>UUID (Universal Unique Identifier) of the cluster.</td>
</tr>
<tr>
<td>External Subnet</td>
<td>Subnet of the external IP address of the cluster.</td>
</tr>
<tr>
<td>Full Version</td>
<td>Full version of the cluster. For example: el7.3-release-euphrates-5.10.3.1-stable-655d4def34bf18785782f2adb8cdd5f8457d1</td>
</tr>
<tr>
<td>Hypervisor Types</td>
<td>Types of hypervisors that are related to this cluster.</td>
</tr>
<tr>
<td>Internal Subnet</td>
<td>Subnet of internal IP addresses.</td>
</tr>
<tr>
<td>NCC Version</td>
<td>Nutanix cluster check version.</td>
</tr>
<tr>
<td>NTP Servers</td>
<td>NTP servers that are related to this cluster.</td>
</tr>
<tr>
<td>Number of Nodes</td>
<td>Number of nodes that are connected to the cluster.</td>
</tr>
<tr>
<td>Timezone</td>
<td>Timezone of the cluster.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the cluster. For example: 5.10.3.1</td>
</tr>
</tbody>
</table>

### Nutanix Controller VM [cmdb_ci_nutanix_controller_vm] class.

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hypervisor Type</td>
<td>Type of hypervisor.</td>
</tr>
<tr>
<td>Memory</td>
<td>Amount of memory (in MB) available to the virtual machine.</td>
</tr>
<tr>
<td>State</td>
<td>On/off state of power.</td>
</tr>
<tr>
<td>VM ID</td>
<td>UUID of the controller virtual machine.</td>
</tr>
<tr>
<td>Object ID</td>
<td>ID of the controller virtual machine.</td>
</tr>
</tbody>
</table>
Nutanix Storage Container [cmdb_ci_nutanix_storage_container] class

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compression</td>
<td>Indicates whether compression is enabled.</td>
</tr>
<tr>
<td>Container ID</td>
<td>UUID of the container.</td>
</tr>
<tr>
<td>Deduplication</td>
<td>Indicates whether on disk deduplication is enabled, that is dedup compression applied to data on hard disks (HDD). Performance tier deduplication is a prerequisite for on disk deduplication.</td>
</tr>
<tr>
<td>Erasure Code</td>
<td>Indicates whether erasure coding is enabled.</td>
</tr>
<tr>
<td>Replication Factor</td>
<td>Number of maintained data copies. The replication factor is specified (2 or 3) when the container is created.</td>
</tr>
</tbody>
</table>

The following classes have no added columns:
- Nutanix Storage Pool [cmdb_ci_nutanix_storage_pool]
- Nutanix Host [cmdb_ci_nutanix_host]
- Nutanix Virtual Machine Instance [cmdb_ci_nutanix_vm_instance]

Related information

CMDB schema model

OpenStack extension classes

The CMDB CI Class Models store app adds or updates classes for OpenStack.

The app adds class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable. You can use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs and discover various technologies and software.
Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

OpenStack

OpenStack is a cloud operating system that controls large pools of compute, storage, and networking resources throughout a datacenter. All of these resources are managed and provisioned through APIs with common authentication mechanisms. Other components provide services such as orchestration, fault management, and service management to ensure high availability of user applications. OpenStack is broken up into services to enable you to plug and play components depending on your needs. These components are designed for horizontal scalability, so you can easily add new resources to grow your cloud over time.

OpenStack classes integrated with the CMDB class hierarchy

Classes

This section lists the relevant classes that the CMDB CI Class Models store app adds or updates. See the class columns table for further details about the columns added for each class.

CMDB CI Class Models: Release 1.8.0 adds the following classes for OpenStack. For the list of CMDB classes in a base system, including ones that this store app might be extending, see CMDB tables descriptions.
<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OpenStack Services (<a href="#">cmdb_ci_cloud_openstack_service</a>)</td>
<td>Virtual Machine Object (<a href="#">cmdb_ci_vm_object</a>)</td>
<td>An OpenStack web service that can be accessed via a URL.</td>
</tr>
<tr>
<td>OpenStack Endpoint (<a href="#">cmdb_ci_cloud_openstack_endpoint</a>)</td>
<td>Virtual Machine Object (<a href="#">cmdb_ci_vm_object</a>)</td>
<td>The access point of a Service.</td>
</tr>
<tr>
<td>OpenStack Domain (<a href="#">cmdb_ci_cloud_openstack_domain</a>)</td>
<td>Virtual Machine Object (<a href="#">cmdb_ci_vm_object</a>)</td>
<td>A collection of users, groups, and projects.</td>
</tr>
</tbody>
</table>

**Class columns**

CMDB CI Class Models: Release 1.8.0 adds the following columns to the respective classes.

**OpenStack Services ([cmdb_ci_cloud_openstack_service](#)) class**

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>type</td>
<td>The Service type, which describes the API implemented by the Service. Possible values: Compute, ec2, identity, image, network, or volume.</td>
</tr>
<tr>
<td>enabled</td>
<td>Defines if the service and its endpoints appear in the Service catalog (true/false).</td>
</tr>
</tbody>
</table>

**OpenStack Endpoint ([cmdb_ci_cloud_openstack_endpoint](#)) class**

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>interface</td>
<td>The interface type, which describes the visibility of the endpoint. Possible values:</td>
</tr>
<tr>
<td></td>
<td>• public - Visible by end users on a publicly available network interface.</td>
</tr>
<tr>
<td></td>
<td>• internal - Visible by end users on an unmetered internal network interface.</td>
</tr>
<tr>
<td></td>
<td>• admin - Visible by administrative users on a secure network interface.</td>
</tr>
</tbody>
</table>
OpenStack Endpoint [cmdb_ci_cloud_openstack_endpoint] class (continued)

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>enabled</td>
<td>Defines if the Service and its endpoints appear in the Service catalog (true/false).</td>
</tr>
</tbody>
</table>

OpenStack Domain [cmdb_ci_cloud_openstack_domain] class

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>enabled</td>
<td>Defines if the domain is enabled (true/false).</td>
</tr>
</tbody>
</table>

Related information

CMDB schema model

Operational Technology (OT) extension classes

The CMDB CI Class Models store app adds or updates classes for Operational Technology (OT).

The store app adds class models that extend the CMDB class hierarchy, including:

- Class descriptions
- Identification rules
- Identifier entries
- Dependent relationships, if applicable.

You can use the added classes as any other CMDB class. Applications such as Discovery for Operational Technology, and Service Graph Connector for Operational Technology (Excel) use these class extensions to populate CIs and discover various technologies and software. To learn more, see:

- Service Graph Connector for Operational Technology (Excel)
- Discovery for Operational Technology

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
**Note:** In Operational Technology, CIs in the OT class structure are often referred to as OT Assets. This term shouldn’t be confused with an asset record commonly used in the practice of Asset Management in the IT domain.

### Operational Technology (OT) schema structure

![Operational Technology (OT) schema structure diagram]

### Classes

This section lists the relevant classes that the CMDB CI Class Models store app adds or updates. See the class columns table for further details about the columns added for each class.

CMDB CI Class Models: Release 1.23 adds the following classes for Operational Technology (OT). For the list of CMDB classes in a base system, including ones that this store app might be extending, see **CMDB tables descriptions**.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operations Technology</td>
<td>cmdb_ci_hardware</td>
<td>Base class for Operational Technology, used for industrial control. For instance, in manufacturing.</td>
</tr>
<tr>
<td>[cmdb_ci_ot]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Class</td>
<td>Extends</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>OT Supervisory System</td>
<td>cmdb_ci_ot</td>
<td>Base class for supervisory systems, usually at Purdue Model Level 2 or 3</td>
</tr>
<tr>
<td>EWS [cmdb_ci_ot_ews]</td>
<td>cmdb_ci_ot_supervisory</td>
<td>Engineering Workstation. A computing platform for configuration, maintenance, and diagnostics of ICS applications and other control system equipment.</td>
</tr>
<tr>
<td>Historian</td>
<td>cmdb_ci_ot_supervisory</td>
<td>Data Historian. A centralized database supporting data analysis for industrial processes.</td>
</tr>
<tr>
<td>HMI [cmdb_ci_ot_hmi]</td>
<td>cmdb_ci_ot_supervisory</td>
<td>Human-Machine Interface. Hardware or software through which an operator interacts with a controller.</td>
</tr>
<tr>
<td>SCADA Client</td>
<td>cmdb_ci_ot_supervisory</td>
<td>Supervisory Control and Data Acquisition. Client that enables an operator to manage a SCADA server.</td>
</tr>
<tr>
<td>OT Control System</td>
<td>cmdb_ci_ot</td>
<td>Base Class for industrial control systems (ICS), usually at Purdue Model Level 1 or 2</td>
</tr>
<tr>
<td>CNC [cmdb_ci_ot_cnc]</td>
<td>cmdb_ci_ot_control</td>
<td>Computer Numerical Control, used for automated control of machining tools such as drills, lathes, mills, and for 3D printers.</td>
</tr>
<tr>
<td>Class</td>
<td>Extends</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DCS [cmdb_ci_ot_dcs]</td>
<td>cmdb_ci_ot_control</td>
<td>Distributed Control System. Achieves control using intelligence distributed about the controlled process, rather than by a centrally located single unit.</td>
</tr>
<tr>
<td>DPU [cmdb_ci_ot_dpu]</td>
<td>cmdb_ci_ot_control</td>
<td>Distributed Processing Units. ICS on a dedicated network, with each DPU handling thousands of points of I/O.</td>
</tr>
<tr>
<td>IED [cmdb_ci_ot_ied]</td>
<td>cmdb_ci_ot_control</td>
<td>Intelligent Electronic Device. Receives or sends data/control from or to an external source for power grids.</td>
</tr>
<tr>
<td>OT Control Module [cmdb_ci_ot_control_module]</td>
<td>cmdb_ci_ot_control</td>
<td>Module such as a PLC or DCS connected to an OT Control System.</td>
</tr>
<tr>
<td>PLC [cmdb_ci_ot_plc]</td>
<td>cmdb_ci_ot_control</td>
<td>Programmable Logic Controller. Used to control OT devices.</td>
</tr>
<tr>
<td>RTU [cmdb_ci_ot_rtu]</td>
<td>cmdb_ci_ot_control</td>
<td>Remote Terminal Unit. Special purpose data acquisition and control unit designed to support DCS and SCADA remote stations</td>
</tr>
<tr>
<td>SCADA Server [cmdb_ci_ot_scada_server]</td>
<td>cmdb_ci_ot_control</td>
<td>Supervisory Control and Data Acquisition. System capable of gathering and processing data and applying operational controls over long distance.</td>
</tr>
</tbody>
</table>
### Class columns
CMDB CI Class Models: Release 1.23 adds the following columns to the respective classes.

<table>
<thead>
<tr>
<th>Operational Technology (OT) [cmdb_ci_ot] class</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Added columns</strong></td>
</tr>
<tr>
<td>firmware_version</td>
</tr>
<tr>
<td>hardware_version</td>
</tr>
</tbody>
</table>
**OT Control System [cmdb_ci_ot_control_system] class**

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>has_module</td>
<td>true/false value describing if the system has modules, such as chassis / blade architecture.</td>
</tr>
<tr>
<td>backplane_name</td>
<td>System-reported string name or number for the backplane.</td>
</tr>
<tr>
<td>backplane_id</td>
<td>System-reported unique ID for the backplane</td>
</tr>
</tbody>
</table>

**OT Control Module [cmdb_ci_ot_control_module] class**

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>slot_number</td>
<td>Reported slot in the control system this module is using.</td>
</tr>
<tr>
<td>module_type</td>
<td>Module type reported by the discovery source.</td>
</tr>
</tbody>
</table>

**OT Field Device [cmdb_ci_ot_field_device] class**

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>device_type</td>
<td>List that describes if the device provides input, output, or both to the parent control system.</td>
</tr>
</tbody>
</table>

**Roles**

Three new roles have been introduced with the Operational Technology (OT) [cmdb_ci_ot] classes and associated tables that follow:

**Editor (cmdb_ot_editor)**

Can view and edit OT asset records.

**Viewer (cmdb_ot_viewer)**

Can only view OT asset records.

**Admin (cmdb_ot_admin)**

Can edit and manage specific configurations on the OT entity tables.
Key relationship structures

Use the following key relationships as important guidelines when creating Operational Technology (OT) CIs:

**OT Entity**
Since any CI class may be found on an OT network, the OT Entity table [cmdb_ot_entity] captures additional attributes required in an OT Environment:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business criticality</td>
<td>Business criticality assigned in the discovery source.</td>
</tr>
<tr>
<td>OT Asset</td>
<td>Reference to the CI that is on the OT network.</td>
</tr>
<tr>
<td>OT Class</td>
<td>Class that the OT asset is functioning as.</td>
</tr>
<tr>
<td></td>
<td>• For a dedicated HMI appliance, the CI is in the cmdb_ci_ot_hmi class, and the OT class should be HMI.</td>
</tr>
<tr>
<td></td>
<td>• For a computer performing the function of an HMI, the CI is in the cmdb_ci_computer class and the OT class should be HMI</td>
</tr>
<tr>
<td>Purdue level</td>
<td>Purdue level of the OT asset.</td>
</tr>
</tbody>
</table>

The OT Entity is a related list added to the Operational Technology (OT) [cmdb_ci_ot] table and extended tables. If you want to view OT entity metadata on an existing CI class, first add the related list to the form.

**OT Entity Type**
The [cmdb_ot_entity_type] table tracks the type of OT asset that an OT or non-OT CI is performing the function of. It serves as a necessary part of the Purdue level data model, and extends the Application File [sys_metadata] table.

The Now Platform includes a few records representing common types of OT CIs:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Display name of a specific type.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Name</td>
<td>Value used to identify a specific type.</td>
</tr>
<tr>
<td>OT table</td>
<td>Value used for auto-populating the Type field for the OT entity record [cmdb_ot_entity] of an OT CI.</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent type of a specific type, which is a reference to a record in the same table [cmdb_ot_entity].</td>
</tr>
</tbody>
</table>

**Serial number**

During CI identification, the Identification and Reconciliation Engine (IRE) processes search for a serial number in two locations. One is the CI serial number attribute, and the other is the Serial Number [cmdb_serial_number] table, with reference back to the Operational Technology (OT) [cmdb_ci_ot] table.

- It stores any serial number of any type other than system serial number, and only in the Serial Number table (and not in the server CI attribute).
- If the system serial number is available, it stores it in both the Serial Number attribute of the CI and in the Serial Number table.
- The Serial Number table is a many-to-one relationship, linking back to the Operational Technology (OT) CI. This table has a Type field for specifying the type of the serial number.
- For Operational Technology (OT), use the string value `system` for the serial number type to ensure proper reconciliation across various sources.

**Network adapter**

Use the Network Adapter [cmdb_ci_network_adapter] class to store network adapters.

1. Set the MAC Address attribute to be the MAC address value.
   - Format the string with colon separators between octets and lower case hexadecimal characters with padded zeros.
   - For example, ‘f8:f2:1e:00:d4:66’.
2. Set the Name attribute in the Network Adapter class to be the same as the MAC Address.
3. In the CI Relationship [cmdb_rel_ci] table, create an Owned By:Owns relationship to the associated Hardware CI.
4. Using the CI with a reference to the associated Hardware CI, specify a reference from the Network Adapter [cmdb_ci_network_adapter] table.
IP Address
Use the IP Address [cmdb_ci_ip_address] class to store IP addresses.

1. Store an IP address value in the IP Address attribute, and in the Name attribute to avoid empty Name attributes.
   • Store an IPv4 IP address value using the format ‘NNN.NNN.NNN.NNN’, with decimal-based octets and period separators. Non-conforming values should be considered invalid and cleansed to null values.
   • Store an IPv6 IP address value using lower case hexadecimal with colon separators. Non-confirming values should be considered invalid and cleansed to null values.

2. Set the Netmask attribute to the IP address.

3. Set the Name attribute in the Network Adapter class to be the same as the MAC Address.

4. In the CI Relationship [cmdb_rel_ci] table, create an Owned By::Owns relationship to the associated Hardware CI.

5. In the CI Relationship [cmdb_rel_ci] table, create an Owned By::Owns relationship to the associated Hardware CI.

6. For the IP address, specify a reference to the Network Adapter [cmdb_ci_network_adapter] table, using the Configuration Item with a reference to the associated Hardware CI.

7. To ensure that base system identification rules work properly, also store the IP address in the associated Network Adapter class.

Network adapter and IP address
Use the IP Address [cmdb_ci_ip_address] class to store IP addresses.

1. Store the MAC address of the network adapter installed on a server, in the Network Adapter [cmdb_ci_network_adapter] class.

2. Store the IP address in the IP Address [cmdb_ci_ip_address] class.

   Note: Do not store the MAC address or the IP address in the Operational Technology (OT) [cmdb_ci.ot] table. The default Operational Technology (OT) form is configured to display the IP address from the Network Adapter table.

Key reference structures
Use the following key references are important guidelines when creating Operational Technology (OT) records:
• When creating computer or server records for OT assets that are running on computers or servers, see the following topics:
  ◦ Computer [cmdb_ci_computer] class
  ◦ Server [cmdb_ci_server] class
• The Manufacturer and Model ID attributes are reference attributes to the Company [core_company] and Product Model [cmdb_model] tables respectively.
• The Owned By, Assigned To, Managed By, and Supported By attributes are reference attributes to the User [sys_user] table. The Assignment Group and Support Group attributes are reference attributes to the Group [sys_user_group] table.

Identification rules
The Now Platform contains a pre-defined identification rule for the Operational Technology (OT) classes. That identification rule has the following key identifier entries, listed in priority order:

1. Identifier entry that uses the identification specified in Serial Number [cmdb_serial_number] as the lookup table. The Serial Number table is a many-to-one reference from the serial number back to the server CI.
2. Identifier entry specified in the Serial Number attribute in the CI.
3. Identifier entry specified in the Mac Address attribute in the Network Adapter table.
4. Identifier entry for the Name attribute.
   • If Serial Number and MAC Address are not available, then the Name (which is usually the system reported hostname) attribute is used.
   • If both Serial Number and Name are not available, and only MAC Address is available, use MAC Address as the name of the CI. Using the MAC Address as the name of the CI ensures that you don’t create an empty CI.

  Note: To learn more, see CMDB Identification and Reconciliation.

Deprecated classes
CMDB CI Class Models: Release 1.23 soft deprecated (not removed, but marked as follows) with the release of the OT class model:
<table>
<thead>
<tr>
<th>Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Human Machine Interface [cmdb_ci_hmi]</td>
<td>OT assets moved to cmdb_ci_ot to support broader use cases. Use cmdb_ci_ot_hmi instead.</td>
</tr>
<tr>
<td>Manufacturing Device [cmdb_ci_manufacturing]</td>
<td>OT assets moved to cmdb_ci_ot to support broader use cases. Use cmdb_ci_ot as the base class or other generic child classes as appropriate.</td>
</tr>
<tr>
<td>Programmable Logic Controller [cmdb_ci_plc]</td>
<td>OT assets moved to cmdb_ci_ot to support broader use cases. Use cmdb_ci_ot_plc instead.</td>
</tr>
</tbody>
</table>

A script has been provided to migrate records from these classes to the new class tables. The admin role is required to perform the following tasks:

1. Navigate to **System Definition > Script Includes**
2. Find the record named **OTAssetsMigrationUtils**.
3. Navigate to **Definition > Script Includes**.
4. In the background window, copy and paste the provided script.
5. Select the appropriate scope and run the script.

**Troubleshooting**
The following are some troubleshooting tips:

<table>
<thead>
<tr>
<th>Problem</th>
<th>Suggested resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to see OT Asset menu items</td>
<td>Ensure that the logged in user has been assigned the appropriate roles. To learn more, see the preceding Roles section.</td>
</tr>
<tr>
<td>Error creating or updating an OT Asset record</td>
<td>Allow only one OT Asset record (cmdb_ot_entity) per CI.</td>
</tr>
</tbody>
</table>

**Related information**

CMDB schema model
Red Hat Virtualization (RHV) extension classes

The CMDB CI Class Models store app adds or updates classes for Red Hat Virtualization (RHV).

The app adds class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable. You can use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs and discover various technologies and software.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Red Hat Virtualization (RHV)

Red Hat Virtualization (RHV) is a virtualization product which is based on the Kernel-based Virtual Machine (KVM) hypervisor. RHV uses the SPICE protocol and Virtual Desktop Server Manager (VDSM) with a RHEL-based centralized management server. RHV solution is based on two primary software components: Red Hat Virtualization Manager (RHV-M) and Red Hat Virtualization Hypervisors or hosts: Red Hat Enterprise Linux or RHV Host (RHV-H).
Classes

This section lists the relevant classes that the CMDB CI Class Models store app adds or updates. See the class columns table for further details about the columns added for each class.

CMDB CI Class Models: Release 1.8.0 adds the following classes for RHV. For the list of CMDB classes in a base system, including ones that this store app might be extending, see CMDB tables descriptions.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RHV LDC</td>
<td>Logical Datacenter</td>
<td>RHV logical datacenter.</td>
</tr>
<tr>
<td>[cmdb_ci_rhv_ldc]</td>
<td>[cmdb_ci_logical_datacenter]</td>
<td></td>
</tr>
<tr>
<td>RHV Datacenter</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>[cmdb_ci_rhv_datacenter]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: This class is being deleted in the CMDB CI Class Models 1.6.0 release.

CMDB CI Class Models: Release 1.6.0 adds the following classes for RHV.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RHV Server</td>
<td>Virtualization Server</td>
<td>The RHV virtualization host.</td>
</tr>
<tr>
<td>[cmdb_ci_rhv_server]</td>
<td>[cmdb_ci_virtualization_server]</td>
<td></td>
</tr>
<tr>
<td>RHV Object</td>
<td>Virtual Machine Object</td>
<td>A base class for other classes to derive from.</td>
</tr>
<tr>
<td>[cmdb_ci_rhv_object]</td>
<td>[cmdb_ci_vm_object]</td>
<td></td>
</tr>
<tr>
<td>RHV Manager</td>
<td>Application</td>
<td>RHV Manager instance.</td>
</tr>
<tr>
<td>[cmdb_ci_rhv_manager]</td>
<td>[cmdb_ci_appl]</td>
<td></td>
</tr>
<tr>
<td>RHV Cluster</td>
<td>RHV Object</td>
<td>RHV cluster.</td>
</tr>
<tr>
<td>[cmdb_ci_rhv_cluster]</td>
<td>[cmdb_ci_rhv_object]</td>
<td></td>
</tr>
<tr>
<td>RHV Datacenter</td>
<td>RHV Object</td>
<td>RHV datacenter.</td>
</tr>
<tr>
<td>[cmdb_ci_rhv_datacenter]</td>
<td>[cmdb_ci_rhv_object]</td>
<td></td>
</tr>
<tr>
<td>Class</td>
<td>Extends</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>RHV Virtual Machine Instance</td>
<td>Virtual Machine Instance</td>
<td>RHV virtual machine instance.</td>
</tr>
<tr>
<td>[cmdb_ci_rhv_vm_instance]</td>
<td>[cmdb_ci_vm_instance]</td>
<td></td>
</tr>
</tbody>
</table>

**Class columns**

CMDB CI Class Models: Release 1.6.0 adds the following columns to the respective classes.

**RHV Server [cmdb_ci_rhv_server] class**

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>url</td>
<td>URL used to access the object.</td>
</tr>
</tbody>
</table>

**RHV Object [cmdb_ci_rhv_object] class**

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>href_id</td>
<td>Href ID.</td>
</tr>
<tr>
<td>manager_id</td>
<td>Manager ID.</td>
</tr>
<tr>
<td>url</td>
<td>URL to access the object (used in child classes).</td>
</tr>
</tbody>
</table>

**RHV Manager [cmdb_ci_rhv_manager] class**

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>url</td>
<td>URL of the manager.</td>
</tr>
<tr>
<td>product_name</td>
<td>Product name.</td>
</tr>
</tbody>
</table>

**RHV Cluster [cmdb_ci_rhv_cluster] class**

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cpu_type</td>
<td>CPU type.</td>
</tr>
<tr>
<td>cpu_architecture</td>
<td>CPU architecture.</td>
</tr>
<tr>
<td>ksm</td>
<td>Enabled state of kernel same-page merging (KSM) memory policy.</td>
</tr>
</tbody>
</table>
### RHV Cluster [cmdb_ci_rhv_cluster] class (continued)

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fencing_policy</td>
<td>Fencing policy.</td>
</tr>
<tr>
<td>memory_overcommitment</td>
<td>Amount of over-commitment memory allowed on the cluster.</td>
</tr>
<tr>
<td>transparent_huge_pages</td>
<td>Transparent huge memory pages policy.</td>
</tr>
<tr>
<td>ballooning</td>
<td>Memory ballooning for guests.</td>
</tr>
<tr>
<td>compatibility_version</td>
<td>Compatibility version.</td>
</tr>
</tbody>
</table>

### RHV Virtual Machine Instance [cmdb_ci_rhv_vm_instance] class

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mgmt_url</td>
<td>Management URL.</td>
</tr>
<tr>
<td>cpu_architecture</td>
<td>CPU architecture.</td>
</tr>
<tr>
<td>delete_protected</td>
<td>Delete protected (true/false).</td>
</tr>
<tr>
<td>ha_priority</td>
<td>HA priority.</td>
</tr>
<tr>
<td>high_availability</td>
<td>High availability (true/false).</td>
</tr>
<tr>
<td>memory_policy_guaranteed</td>
<td>Amount of memory guaranteed (MB).</td>
</tr>
<tr>
<td>memory_policy_max_mb</td>
<td>Maximum memory in the dynamic memory allocation policy.</td>
</tr>
<tr>
<td>multi_queues</td>
<td>Multi queues.</td>
</tr>
<tr>
<td>placement_policy</td>
<td>Placement policy.</td>
</tr>
<tr>
<td>cpu.Sockets</td>
<td>Number of CPU sockets.</td>
</tr>
<tr>
<td>stateless</td>
<td>Stateless (true/false).</td>
</tr>
<tr>
<td>storage_error_resume_behaviour</td>
<td>Behavior of a virtual machine that is paused due to storage I/O error. For examples, AUTO_RESUME, LEAVE_PAUSED, and KILL.</td>
</tr>
<tr>
<td>start_time</td>
<td>Start time.</td>
</tr>
<tr>
<td>stop_time</td>
<td>Stop time.</td>
</tr>
</tbody>
</table>
RHV Virtual Machine Instance [cmdb_ci_rhv_vm_instance] class (continued)

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>threads</td>
<td>Number of threads.</td>
</tr>
<tr>
<td>time_zone</td>
<td>Time zone.</td>
</tr>
<tr>
<td>usb</td>
<td>USB enabled state.</td>
</tr>
<tr>
<td>run_once</td>
<td>Run once.</td>
</tr>
<tr>
<td>type</td>
<td>RHV type.</td>
</tr>
</tbody>
</table>

The following class was deleted in the CMDB CI Class Models 1.6.0 release.

RHV Datacenter [cmdb_ci_rhv_datacenter] class

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>quota_mode</td>
<td>Quota mode policy.</td>
</tr>
</tbody>
</table>

Related information
CMDB schema model

Transport Layer Security (TLS) extension classes

The CMDB CI Class Models store app adds or updates a class for TLS certificates.

The app adds class models that extend the CMDB class hierarchy. You can use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs and discover various technologies and software.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Transport Layer Security (TLS)

TLS is a cryptographic protocol designed to provide communications security over a computer network. The TLS protocol provides privacy and data integrity between communicating computer applications. Once the client and the server have agreed to use TLS, they negotiate a stateful connection by using a handshaking procedure. The server usually provides identification in the form
of a digital certificate. The certificate contains the server name, the trusted certificate authority (CA) that vouches for the authenticity of the certificate, and the server's public encryption key. The client confirms the validity of the certificate before proceeding. When the handshake is completed, a secured connection is established.

**TLS certificate classes integrated with the CMDB class hierarchy**

**Scoped apps certification class**

The scoped apps certification class supports TLS certificates. With this class you can proactively manage certificates by keeping stakeholders informed about any impending expiries. Use this extension class to ensure that certificates are monitored and renewed before they expire, to prevent severe outage of production systems.

**Classes**

This section lists the relevant classes that the CMDB CI Class Models store app adds or updates. See the class columns table for further details about the columns added for each class.

The CMDB CI Class Models: Release 1.4.0 updates the following class:

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
</table>
The CMDB CI Class Models store app changes the Unique Certificate [cmdb_ci_certificate] class as follows:

- The `assigned_to` attribute now depends on the `assignment_group` attribute so that users in the `assigned_to` attribute are filtered based on the specified `assignment_group`.

- The Certificate Inventory and Management store app populates the Unique Certificate [cmdb_ci_certificate] table. The list view for that class does not have a New button and you can no longer add new records to the table. This is because there are certain fields that are extracted from binary encoded parameters in the certificate which users may not be able to provide. Also, certificates have to be discovered rather than uploaded.

- You can no longer add or delete attachments in the Certificate file attribute.

The CMDB CI Class Models: Release 1.3.0 adds the following classes. For the list of CMDB classes in a base system, including ones that this store app might be extending, see CMDB tables descriptions.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unique Certificate [cmdb_ci_certificate]</td>
<td>Configuration Item [cmdb_ci]</td>
<td>N/A</td>
</tr>
<tr>
<td>Certificate Domain [certificate_domain]</td>
<td>N/A</td>
<td>Fully qualified domain name.</td>
</tr>
</tbody>
</table>

**Class columns**

CMDB CI Class Models: Release 1.4.0 adds the following columns to the respective classes.

<table>
<thead>
<tr>
<th>Unique Certificate [cmdb_ci_certificate] class</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Added columns</strong></td>
</tr>
<tr>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Certificate file</td>
</tr>
<tr>
<td>Fingerprint</td>
</tr>
<tr>
<td>Fingerprint algorithm</td>
</tr>
<tr>
<td>Is certificate authority</td>
</tr>
<tr>
<td>Added columns</td>
</tr>
<tr>
<td>-------------------------------</td>
</tr>
<tr>
<td>Is selfsigned</td>
</tr>
<tr>
<td>Issuer</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Issuer common name</td>
</tr>
<tr>
<td>Issuer distinguished name</td>
</tr>
<tr>
<td>Key size</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Renewal tracking</td>
</tr>
<tr>
<td>Root issuer</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Service type</td>
</tr>
<tr>
<td>Signature algorithm</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
### Unique Certificate [cmdb_ci_certificate] class (continued)

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Lifecycle states of the certificate.</td>
</tr>
<tr>
<td>Subject alternative name</td>
<td>List of fully qualified domain names secured by the certificate. Reference: Certificate Domain [certificate_domain]</td>
</tr>
<tr>
<td>Subject common name</td>
<td>Identifies the hostname/domain associated with the certificate.</td>
</tr>
<tr>
<td>Subject country</td>
<td>Subject's two letter country code.</td>
</tr>
<tr>
<td>Subject distinguished name</td>
<td>Identifying information of the subject.</td>
</tr>
<tr>
<td>Subject email</td>
<td>Subject's email.</td>
</tr>
<tr>
<td>Subject locality</td>
<td>Subject's locality.</td>
</tr>
<tr>
<td>Subject organization</td>
<td>Subject's organization.</td>
</tr>
<tr>
<td>Subject organizational unit</td>
<td>Subject's organizational unit.</td>
</tr>
<tr>
<td>Subject state</td>
<td>Subject's state.</td>
</tr>
<tr>
<td>Valid from</td>
<td>Validity start period of the certificate.</td>
</tr>
<tr>
<td>Valid to</td>
<td>Validity end period of the certificate.</td>
</tr>
<tr>
<td>Version</td>
<td>X.509 version of the certificate.</td>
</tr>
</tbody>
</table>

### Certificate Domain [certificate_domain] class

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain</td>
<td>Fully qualified domain name.</td>
</tr>
</tbody>
</table>

CMDB CI Class Models: Release 1.3.0 adds no columns.

**Related information**

CMDB schema model
VMware NSX load balancer extension classes

The CMDB CI Class Models store app adds or updates classes for VMware NSX load balancers.

The app adds class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable. You can use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs and discover various technologies and software.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

VMware NSX load balancer

NSX is a network virtualization solution offered by VMware. Among the virtual resources included in the NSX solution are virtual LANs (VLANs), virtual load balancers, virtual routers, switches, and firewalls.

ServiceNow Discovery uses the VMware NSX load balancer discovery pattern to find VMware NSX load balancers and their components: Listeners, pools, pool members, and health services.

Classes

This section lists the classes that the CMDB CI Class Models store app adds or updates.
CMDB CI Class Models: Release 1.10.0 adds the following classes for the VMware NSX load balancer. For the list of CMDB classes in a base system, including ones that this store app is extending, see CMDB tables descriptions.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NSX Load Balancer</td>
<td>[cmdb_ci_nsx_lb]</td>
<td>The table containing the NSX Load Balancer resources.</td>
</tr>
<tr>
<td>[cmdb_ci_lb]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Class columns**

The VMware NSX load balancer discovery pattern introduces one new table with one identification rule and entry. The table uses only the columns inherited from its parent.

**Related information**

- CMDB schema model

**Extend classes and rules**

Extend and update CMDB CI Class Models store app classes and rules when using third-party integration tools.

When using a third-party tool to integrate with ServiceNow apps, gaps can occur between the integration and different CIs. Some of the integrated tables and classes may be missing classes and rules not included with the CMDB CI Class Models store app.

The classes and rules in the following table enable you to add and extend the CMDB CI Class Models store app for integrations:

<table>
<thead>
<tr>
<th>Table</th>
<th>Extends</th>
<th>Rules and related entries</th>
</tr>
</thead>
<tbody>
<tr>
<td>Postgresql Schema</td>
<td>[cmdb_ci_db_catalog]</td>
<td>Containment rule:</td>
</tr>
<tr>
<td>cmdb_ci_postgresql_schema</td>
<td></td>
<td>&gt;Contains:Contained By- &gt;cmdb_ci_postgresql_schema</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Identification Rule:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Dependent, Attributes: name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Related Entries (cmdb_related_entry):</td>
</tr>
<tr>
<td>Table</td>
<td>Extends</td>
<td>Rules and related entries</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------</td>
<td>------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Information Object</td>
<td>cmdb_ci</td>
<td><strong>Identification rule:</strong> Independent, attributes: name</td>
</tr>
<tr>
<td>cmdb_ci_information_object</td>
<td></td>
<td><strong>Related Entries (cmdb_related_entry):</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Identifier: cmdb_ci_information_object</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Related table: cmdb_key_value</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Referenced field: configuration_item</td>
</tr>
<tr>
<td>Oracle Catalog</td>
<td>cmdb_ci_db_catalog</td>
<td><strong>Related Entries (cmdb_related_entry):</strong></td>
</tr>
<tr>
<td>cmdb_ci_db_ora_catalog</td>
<td></td>
<td>• Identifier: cmdb_ci_db_ora_catalog</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Related table: cmdb_key_value</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Referenced field: configuration_item</td>
</tr>
<tr>
<td>MySQL Catalog</td>
<td>cmdb_ci_db_catalog</td>
<td><strong>Containment rule:</strong></td>
</tr>
<tr>
<td>cmdb_ci_db_mysql_catalog</td>
<td></td>
<td>cmdb_ci_db_mysql_instance-&gt;Contains:Contained By-&gt;cmdb_ci_db_mysql_catalog</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Identification rule:</strong> Dependent, attributes: name</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Related Entries (cmdb_related_entry):</strong></td>
</tr>
<tr>
<td>Table</td>
<td>Extends</td>
<td>Rules and related entries</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------</td>
<td>------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Identifier:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>cmdb_ci_db_mysql_catalog</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Related table: cmdb_key_value</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Referenced field: configuration_item</td>
</tr>
<tr>
<td>MS SQL Database</td>
<td>cmdb_ci_db_instance</td>
<td>Related Entries (cmdb_related_entry):</td>
</tr>
<tr>
<td>cmdb_ci_db_mssql_database</td>
<td></td>
<td>• Identifier:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>cmdb_ci_db_mssql_database</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Related table: cmdb_key_value</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Referenced field: configuration_item</td>
</tr>
<tr>
<td>Sybase Catalog</td>
<td>cmdb_ci_db_catalog</td>
<td>Containment rule:</td>
</tr>
<tr>
<td>cmdb_ci_db_syb_catalog</td>
<td></td>
<td>cmdb_ci_db_syb_instance-&gt;Contains:Contained By-&gt;cmdb_ci_db_syb_catalog</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Identification rule:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Dependent, attributes: name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Related Entries (cmdb_related_entry):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Identifier:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>cmdb_ci_db_syb_catalog</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Related table: cmdb_key_value</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Referenced field: configuration_item</td>
</tr>
<tr>
<td>DB2 Catalog</td>
<td>cmdb_ci_db_catalog</td>
<td>Containment rule:</td>
</tr>
<tr>
<td>cmdb_ci_db_db2_catalog</td>
<td></td>
<td>cmdb_ci_db_db2_instance-&gt;Contains:Contained By-&gt;cmdb_ci_db_db2_catalog</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Identification rule:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Dependent, attributes: name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Related Entries (cmdb_related_entry):</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Table</th>
<th>Extends</th>
<th>Rules and related entries</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>• Identifier: cmdb_ci_db_db2_catalog</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Related table: cmdb_key_value</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Referenced field: configuration_item</td>
</tr>
</tbody>
</table>

For the list of CMDB classes in a base system, including ones that this store app is extending, see **CMDB tables descriptions**.

**Related information**

**CMDB schema model**

**Populating the CMDB**

You can populate the CMDB by using Discovery, by using the IntegrationHub ETL or Import Sets to import and integrate data from a third-party source, by integrating with an external CMDB, or by manually creating CIs.

When you populate the CMDB with information, you create a record for each configuration item in the cmdb_ci table or on one of the tables that extend that table.

**Related ServiceNow® Store apps and reference information:**

- **CMDB schema model**: A collection of class diagrams and class attributes for key CMDB classes.
- **CMDB tables descriptions**: Descriptions of key CMDB tables in the base system.
- **CMDB CI Class Models**: A ServiceNow Store app that adds class models that extend the base CMDB class hierarchy. This includes class descriptions, identification rules, identifier entries, and dependent relationships if applicable. You can then use the added classes as any other CMDB base class.
- **Discovery patterns**: A ServiceNow Store app that provides a library of Discovery patterns for discovering specific devices and applications in the industry.
- **Service Graph connectors**: ServiceNow Store apps that provide pre-defined integrations for importing and integrating common third-party data into CMDB classes. Also includes the IntegrationHub ETL wizard for creating new ETL transform maps.
ITIL configuration management auto-discovery
The key to any configuration management business practice is the initial and on-going inventory or discovery of what you own. The ServiceNow platform provides three options for auto-discovery:

- The separate and highly robust Discovery product.
- For organizations that want to leverage the discovery technologies they already have deployed (SMS, Tally NetCensus, LanDesk, and so on), the ServiceNow platform supports integrations to those technologies via web services. Scanned data can be mapped directly into the CMDB.

For further information on designing, constructing, and maintaining the CMDB, see the CMDB Design & Configuration white paper.

Discovery
The Discovery product automatically populates the CMDB. Discovery searches the network for all attached computers and devices, then populates the CMDB with information on each computer/device's configuration, provisioning, and current status. Discovery uses probes, sensors, and patterns, to collect and process data about computers, servers, printers, a variety of IP-enabled devices, and the relationships between all the items found. Discovery also reports on any software which is running, and the TCP connections between computer systems, thereby establishing their relationships. This information is sent back to the instance and is used to populate the CMDB.

For more information about Discovery see:
- ITOM Visibility
- Discovery basics

Integrate third-party data using IntegrationHub ETL
Use the IntegrationHub ETL to import and integrate data from a third party into the CMDB. Using IntegrationHub ETL, create ETL transform maps which are used for integrating data from specific data sources. IntegrationHub ETL guides you through importing source data, transforming any data if needed, and selecting target CMDB classes and attributes to map the data to. You then preview the integration results and adjust any configurations before scheduling recurring integrations.

Visit the ServiceNow Store website to view and download common integrations.

Import data from another source using Import Sets
You can import data to the CMDB using Import Sets. Import sets find files of information (in formats such as XML, Excel, or CSV), import them, and transform
them onto the required table. This process can be scheduled or performed on demand.

To import relationships between CIs, use import sets to populate the table [cmdb_rel_ci] with information on the parent, the child, and the nature of the relationship. The [cmdb_rel_ci] table displays a list of all CI relationships and is useful when importing CI data.

**CMDB instance API**

Use the CMDB instance API to populate the CMDB by creating or updating CMDB tables.

**Manually create a CI**

Create a single CI for a specific class. The role required is based on the selected table settings.

1. Use the CI Class Manager:
   a. Navigate to **Configuration > CI Class Manager**.
   b. Click **Hierarchy** to display the list of CI Classes. Select the class to use for the CI.
c. In the class navigation bar, select CI List and then on the CI list view, click New.

d. Fill out the CI form and then click Submit.

2. Or, directly use a table:

a. Navigate to and expand Configuration and then elect the class to use for the CI, such as Business Services.

b. In the navigation filter of the application navigator, enter the table label (such as 'Linux'), or the table name in the format of <table name>.list (such as 'cmdb_ci_linux_server.list'). Then, press Enter.

c. In the list view of the table, click New and fill out the form fields for the table.

d. Click Submit.

Integrating third-party data into the CMDB

Use Service Graph Connectors to import and integrate third-party data into CMDB classes and properties. You can use predefined Service Graph Connectors for common applications from the ServiceNow Store. You can also use IntegrationHub ETL to create new ETL transform maps or edit existing ones.

Related ServiceNow® Store apps and reference information:

- **CMDB schema model**: A collection of class diagrams and class attributes for key CMDB classes.
- **CMDB tables descriptions**: Descriptions of key CMDB tables in the base system.
- **CMDB CI Class Models**: A ServiceNow Store app that adds class models that extend the base CMDB class hierarchy. This includes class descriptions, identification rules, identifier entries, and dependent relationships if applicable. You can then use the added classes as any other CMDB base class.
- **Populating the CMDB**: Information about the various options for populating the CMDB.
- **Discovery patterns**: A ServiceNow Store app that provides a library of Discovery patterns for discovering specific devices and applications in the industry.

IntegrationHub ETL (2.1.0)

Use the IntegrationHub ETL store app to create and manage ETL transform maps, which integrate third-party data into the CMDB without compromising the integrity of the CMDB. IntegrationHub ETL provides a simplified user interface
that guides you through the integration process end-to-end, including a test integration run of sample data.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

When you create an integration, you import source data, transform data if needed, and select target CMDB classes and attributes to map the data to. Eventually, you run an integration test of the sample data, using your settings in the IntegrationHub ETL. You can then preview the integration test results and adjust any settings before scheduling recurring integration runs for large data sets. If you develop and test the ETL transform map on a development instance, then you can test and adjust the configuration before implementation on a production instance.

For example, you can integrate data from SCCM (Microsoft System Center Configuration Manager).

For more information, watch the IntegrationHub ETL | Importing resources into the CMDB video for an introduction and walk through of the IntegrationHub ETL tool.

**Roles required**

Users with the cmdb_inst_admin role can use IntegrationHub ETL to create integrations, or customize a pre-existing integration provided by ServiceNow or a vendor at the ServiceNow Store. A vendor can create a new integration and provide it as an application for anyone to use.

**IntegrationHub ETL and Import Sets**

Using IntegrationHub ETL and ETL transform maps has the following advantages over using Import Sets and transform maps:

- Identification and Reconciliation Engine (IRE) processes are incorporated into the IntegrationHub ETL so all data is automatically processed by IRE as part of the integration. Using Import Sets and transform maps does not provide a simple way to apply IRE processes.
- IntegrationHub ETL uses guided setup which provides guidance and a simple user interface for the entire process of integrating third-party data.
- IntegrationHub ETL includes an integration test for a small data set using the new ETL transform map. This test lets you review the results and adjust configuration settings before scheduling recurring integrations.
Terms
The following terms are associated with the IntegrationHub ETL:

CMDB application
Name of the third-party vendor such as SCCM 2019. A CMDB application has two associated attributes: Name and Discovery Source. When creating a new integration, ensure to configure a discovery source for the CMDB application that you plan to use, before using the IntegrationHub ETL.

Data source
The source feed, such as SCCM 7.0 Computer Identity, where the raw source data is imported from. If you use various REST endpoints for different types of data, then each REST endpoint is associated with its own data source and an ETL transform map.

ETL transform map
The output generated by IntegrationHub ETL. You can integrate third-party data into the CMDB, using an ETL transform map which is configured for the respective integration.

Source data
Original, raw data that have been imported into IntegrationHub ETL. Source data can be used in its original form, or you can transform the data before mapping and integration.

Transform
An operation, that you can apply to a specific data column to transform the data values. For example, to transform the format of the data values. Use transforms to standardize data formats and meet other system requirements.

Transformed data
Some of the source data might not be compliant with the requirements of its target CMDB attributes and classes. In those cases, you can apply various types of transforms to the source data, before mapping the data to the target CMDB classes and attributes. Transforms, can for example convert data format, replace values, and concatenate values from multiple data columns.

Robust Transform Engine
Robust Transform Engine (RTE) is used to transform raw source data that is stored in staging tables, into the data that is mapped and
integrated into the CMDB. RTE uses ETL transform maps that were created for the integration during data transformation.

Each CMDB application can have multiple connections for retrieving raw data. Each connection that is used to retrieve a certain type of data, has its own pair of data source and an ETL transform map. Therefore, one CMDB application can have multiple ETL transform maps, and each of those ETL transform maps is associated with a single Data Source.

For example:

<table>
<thead>
<tr>
<th>CMDB Application</th>
<th>ETL Transform Map</th>
<th>Data Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCCM</td>
<td>SCCM Computer Identify</td>
<td>/sccm/2019/comp</td>
</tr>
<tr>
<td></td>
<td>SCCM Disk</td>
<td>/sccm/2019/disk</td>
</tr>
<tr>
<td></td>
<td>SCCM Application</td>
<td>/sccm/2019/appl</td>
</tr>
</tbody>
</table>

**Nested data payloads**

To process nested data payloads, you must first ensure that the data source that is used for the integration, is set with the Data in single column option. With that setting, you can correctly represent nested data in a JSON payload which IntegrationHub ETL then processes as nested data, rather than as flat data.

Sample of nested data:

```json
{
    "u_computer_fqdn": "computer2-fqdn",
    "u_computer_id": 2,
    "u_computer_ip": "computer2-ip",
    "u_computer_location": "PDX",
    "u_computer_mac": "computer2-mac",
    "u_computer_name": "nested-payload-computer2",
    "u_computer_os": "computer2-os",
    "interfaces": [ {
        "u_interface_ip": "computer2-eth1-ip",
        "u_interface_mac": "computer2-eth1-mac",
        "u_interface_name": "computer2-eth1",
        "ip": "",
    }, {
        "u_interface_ip": "computer2-eth2-ip",
        "u_interface_mac": "computer2-eth2-mac",
        "u_interface_name": "computer2-eth2",
    }
```
You can view the layers of nested data in a separate panel in IntegrationHub ETL, apply transforms, map, and integrate that data into the CMDB.

When creating a nested data JSON payload, the following restrictions apply:

- Column names can't contain special characters such as *, [, ], #, $, spaces, and dot.
- Column names can't be “temp” or “object”, which are reserved for internal use.
- Consistently throughout the payload, you must use an array or an object to represent data in a specific level, regardless of the number of items in the level. If you use an array for multiple items in one object, you must also use an array to represent a single item in other objects.

**Process**

IntegrationHub ETL uses both, RTE and IRE, that work together to process and integrate data. Data is first imported from a data source, and is then stored in temporary staging tables in Import Sets systems. Using the data in the staging tables and the ETL transform map created by IntegrationHub ETL, RTE creates IRE payloads which are then processed by IRE. IRE applies reconciliation processes...
to avoid potential problems such as duplicate CIs, ensuring that the CMDB remains healthy, and then integrates the resulting data into the CMDB.

**Related reference**

- Teams related list

**Create an ETL transform map**

IntegrationHub ETL provides a guided setup which walks you through the completion of all necessary tasks for creating an ETL transform map for a specific integration.

**Guided setup**

Guided setup organizes all the tasks in the correct order, tracks the completion of tasks, and enforces any task dependencies. Tasks that depend on the completion of other tasks, are enabled or disabled as you step through the tool and complete tasks.

Use guided setup to complete the following tasks.

**Import source data and specify basic details**

Provide basic details for the integration, such as the source of the data that you want to integrate into CMDB, and import the source data.

**Before you begin**

The data source that you plan to select for the ETL Transform Map must exist in the same application scope as the one being used in the current session.

Role required: cmdb_inst_admin

**Procedure**

1. **Navigate to Configuration > IntegrationHub ETL.**
   The landing page of the IntegrationHub ETL lists all integrations that exist in the system, including integrations that were downloaded from the ServiceNow Store.

2. **Click the Name of an integration to view or modify, or click Create new.**
   IntegrationHub ETL validates the ETL transform map that you are loading and automatically deletes invalid data records. If there are any validation errors then the Invalid Mapping Data dialog box appears, listing all the specific errors that were detected. The system detects errors such as:
• Missing source or target fields in corresponding Robust Transform Engine (RTE) field mappings records
• Missing table columns in an import set
• Missing an Identification and Reconciliation Engine (IRE) lookup rule for a lookup class

3. On the ETL Transform Map Assistant page, in the Specify Basic Details section of the guided setup, select the Import Source Data and Provide Basic Details task.

4. Fill out the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB Application</td>
<td>The CMDB application associated with the ETL transform map. You can select Add new, which adds the CMDB Application and the Discovery Source fields for the new CMDB application.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the ETL transform map.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the integration.</td>
</tr>
<tr>
<td>Data Source</td>
<td>List of all data sources in the system.</td>
</tr>
<tr>
<td>Sample Import Set</td>
<td>An existing Import Set that is associated with the specified Data Source.</td>
</tr>
<tr>
<td></td>
<td>A subset of that Import Set data is used to preview source data.</td>
</tr>
<tr>
<td></td>
<td>If you don't select an Import Set or if the specified Data Source isn't associated with any Import Sets, an Import Set of up to 100 records, is automatically created and selected.</td>
</tr>
<tr>
<td>CMDB Application</td>
<td>Name of a new CMDB Application. Appears if you set CMDB Application to Add new.</td>
</tr>
<tr>
<td>Discovery Source</td>
<td>Discovery source associated with a new CMDB Application. Appears if</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
you set CMDB Application to Add new.

5. Click **Save** to save the current changes or **Mark as Complete**.

A time stamp appears in the header when you click **Save**, which remains for the duration of the Integration Hub ETL session for the ETL transform map. When you re-enter the session or switch between ETL maps, the time stamp disappears.

**Related information**

- Create an Import Set data source

**Preview and prepare data**

Review sample records of raw source data, which will be integrated into the CMDB. Transform and prepare data to align with the target classes and attributes, if needed.

**Before you begin**

The number of records in the sample data is determined by the system property `sn_int_studio.preview.size`, which is set to 100 by default. The maximum number of records in the sample data that IntegrationHub ETL can process is 10,000. If you set that property above the 10,000 limit, then IntegrationHub ETL will only process up to 10,000 records and a message will appear to that effect.

To process nested data from a nested payload, the respective data source must be set with the **Data in single column** option.

**Role required:** cmdb_inst_admin

**About this task**

Review the values in the data columns of the sample data and identify columns that do not align with the requirements of the intended target classes and attributes. You can transform data, for example, by converting the data format, replacing values, and concatenating data columns. You can apply transformations one on top of another, creating a chain of data transformations. You can also set a data column to be ignored in the mapping and integration process.

Columns for nested data appear alongside the rest of the data, with a **Nested Objects** notation in the data column header. The count of nested data items per object appear with a link which lets you drill to deeper levels of the nested data. To show the data structure of nested data in a separate panel, enable the **Show data structure** option.
The Data Structure panel has two options for displaying nested data:

- **Tree**: Nested data grouped by objects, where each object node corresponds to a record entry in the source data. Expand object nodes to show all nested data for the record.

- **Collection**: Nested data grouped by the top-level object (by default) and then by nested data items such as software. Expand a node such as software, to show which software is installed on each computer.

You can navigate through the levels of nested data in the Data Structure panel, the breadcrumbs path, or through number links that appear in the source data itself. Your selections and the data that appears are kept synchronized between all views of the nested data, regardless of navigation.

**Procedure**

1. Navigate to **Configuration > IntegrationHub ETL**, and click the **Name** of an integration.

   The landing page of the IntegrationHub ETL lists all integrations that exist in the system, including integrations that were downloaded from the ServiceNow Store.

2. In the ETL Transform Map Assistant page, in the Prepare Source Data for Mapping section of the guided setup, select **Preview and Prepare Data**. Then, on the Preview and Prepare Data page, you can perform any of the following optional steps.

3. **Optional**: Select **Show data structure** to open the Data Structure panel which shows the structure of nested data. In the Data Structure panel, you can drill down through the levels of nested data.

4. **Optional**: Select the action menu for a column and then select a **Sort** operation.

5. Select the action menu for a column and then select **Group by** to group the data by the respective column. Select **Ungroup** to undo the grouping operation.

6. **Optional**: Click **New Transform** and then select **Use Source Column**. Or, select the action menu for a column, and then select **New Transform** to transform the selected column.

   (Optional) You can't create new transforms for nested objects at this top-level view of the data. A nested object column contains number links which indicate the number of nested items for the record. To create a new transform for nested objects, click that number link to drill down to the actual nested...
data. Alternatively, navigate in the Data Structure panel to the nested object for which you want to create a transform.

A transform of nested data can reference parent objects of the nested data being transformed. Using the sample payload for nested data as an example, a transform for an interface object can reference the parent computer object but can't reference a software object.

a. In the New Transform sidebar on the right, select a **Transform Type** and modify the **Transform Description** if appropriate. For more details about transform types, see Transform types in IntegrationHub ETL.

b. (Optional) Select **Hide initial column used for this transform** to hide from the current view all the columns that were used for this transform. This setting is temporary for the current session, and if you refresh the page, the hidden column reappears. To show a hidden column, you can also click the gear icon on the banner frame. Then, move the hidden column from the Available to the Selected list and click **OK**.

c. Select or verify the **Input Column** whose values are being transformed.

d. (Optional) Modify the **Output Column Name** for any of the columns that will be added with the transformed values.

e. Click **Apply**.

A new column with the transformed values appears, placed in alphabetical order based on the output column name. If you used the suggested output column name, then the new column appears to the right of the input column.

f. Review the transformed data and adjust any transforms, if needed.

7. **Optional:** To apply the 'Set Fixed Value Column' transform:

a. Click **New Transform** and then select **Set Fixed Value Column**.

b. In the Set Fixed Value Column sidebar, enter a **Column Name** and a **Column Description** for the new column. Then, set **Assign Column Value** to the value that is fixed for the new column.

c. Click **Apply**.

8. **Optional:** Select the action menu for a column, and then select **Ignore in Mapping** to exclude the column from mapping and integration in the current session.
(Optional) In a subsequent session, the **Ignore in Mapping** setting does not apply, and the column will be included in mapping.

You can click **Include in Mapping** to undo the **Ignore in Mapping** setting for the column.

9. **Optional:** Select the action menu for a column, and then select **Delete This and Downstream Columns**. This delete action deletes the column along with any columns that were added using this column as an input column.

10. **Optional:** Click **New Transform** and then select **Table Lookup** which lets you specify a table to look up and extract additional values from. Fill out the fields in the Table Lookup sidebar on the right.

Values from the specified lookup table are matched with the mapped data. For the records that match, the specified values from the lookup table, are added as a column, to the data that is being prepared for mapping.

<table>
<thead>
<tr>
<th>Table Lookup</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Lookup Table</td>
</tr>
<tr>
<td>Lookup Condition</td>
</tr>
</tbody>
</table>

- **If values of target table column:**
  The column in the target table to match to a column in the mapped data.

- **Match values of source data table:**
  The column in the mapped data to match to a column in the lookup table.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>You can add multiple pairs of columns to match on.</td>
</tr>
<tr>
<td>Lookup Condition</td>
<td>(Optional) Values to extract from the <em>Lookup Table</em> when there is a match</td>
</tr>
<tr>
<td></td>
<td>with the mapped data.</td>
</tr>
<tr>
<td></td>
<td>• <em>Then output values from the following columns:</em> The lookup table</td>
</tr>
<tr>
<td></td>
<td>columns to extract values from, when values from the lookup table and the</td>
</tr>
<tr>
<td></td>
<td>mapped data, satisfy the <em>Lookup Condition</em>.</td>
</tr>
<tr>
<td></td>
<td>You can specify multiple lookup table columns to extract values from. For</td>
</tr>
<tr>
<td></td>
<td>every column that you specify, a corresponding <em>Output Column Name</em> field</td>
</tr>
<tr>
<td></td>
<td>automatically appears. Specify a label for the column that will be added</td>
</tr>
<tr>
<td></td>
<td>with the extracted values.</td>
</tr>
<tr>
<td>Output Column Name</td>
<td>(Optional) A label for the column</td>
</tr>
<tr>
<td></td>
<td>that will be added to the mapped data, with the values extracted from the</td>
</tr>
<tr>
<td></td>
<td>lookup table.</td>
</tr>
<tr>
<td></td>
<td>An <em>Output Column Name</em> field is automatically added for every column that</td>
</tr>
<tr>
<td></td>
<td>you specify in <em>Then output values from the following columns</em>.</td>
</tr>
</tbody>
</table>

11. Review the data and ensure that the intended set of data to be integrated is transformed, correctly formatted and prepared for import.

12. Click **Mark as Complete**.

**Results**

Data is prepared when the set of source data columns and transformed columns that you want to integrate, meet any formatting and other value requirements of the target CMDB classes and attributes. These columns are then ready to be mapped and integrated to CMDB classes and attributes.
About mapping data columns to CMDB classes and attributes

There are several requirements and guidelines for mapping source data to target CMDB classes and attributes. Also, there is an option of deactivating class mappings while preserving the settings for an easy reactivation. Review these concepts to ensure proper processing by the Identification and Reconciliation Engine (IRE).

Required mappings

You must map data to all required attributes of the target class in addition to mapping to attributes that are not configured as required. Also, the following two fields appear by default and you cannot delete them:

**Source Native Key**

Required by Identification and Reconciliation Engine (IRE) to uniquely identify a record and used for building relationships and references. Also, improves performance of insert and update operations. When processing a payload, IRE generates an error if this field is empty.

**Source Recency Timestamp**

Used by IRE to identify records that are older than the current record and therefore can be ignored, to help resolve conflicting attribute values.

For more information about how IRE uses `source_native_key` and `source_recency_timestamp` for CI identification, see Identification and Reconciliation engine (IRE).

Conditional class

A conditional class lets you map different sets of data records to different target classes according to specific column values, or the status of a specific plugin.

For example, if a display name contains 'Windows', then 'Windows Server' is selected as the target class. But if the display name contains 'Linux', then 'Linux Server' is selected as the target class. For records that do not meet any of these conditions (display name does not contain 'Windows' nor 'Linux'), 'Server' is selected as the target class.

Associated class

An associated class lets you select the CMDB class to be associated with a target non-CMDB class, which is required for IRE processing.

If the target class for mapping is a non-CMDB class with a reference to a CMDB class, you must select the CMDB class to associate the non-CMDB target class with. A non-CMDB class refers to a class, such Serial Number
[cmdb_serial_number], that does not extend the Configuration Item [cmdb_ci] class. The Related Entry [cmdb_related_entry] class might contain multiple CMDB class associations for the same non-CMDB class. Therefore, select the appropriate association to allow IRE processes to update the target non-CMDB class.

For example, the Related Entry [cmdb_related_entry] class has a record which associates the non-CMDB Software Instance [cmdb_software_instance] class with the CMDB Software Package [cmdb_ci_spkg] class. If you select Software Instance as a target class, you must associate the Software Instance class with the Software Package [cmdb_ci_spkg] class.

### Deactivating class mappings

When you edit an ETL transform map, provided by a Service Graph connector for example, you can delete a class mapping to prevent the class from being populated when the integration runs. However, if you later decide to populate that class, you must readd that class and reconfigure all the class mappings. Instead, you can deactivate a class mapping to temporarily ignore the class during the integration run, while preserving all of its mapping configuration. A class that you choose to deactivate is grayed out in the user interface but you can continue and edit the class mappings. Later, you can reactivate a class mapping to enable populating the class, without needing to reconfigure the class mappings.

Some classes that you choose to deactivate, trigger an automatic deactivation of additional classes that you did not directly choose to deactivate. Which classes are automatically deactivated, depends on the class that you chose to deactivate. For example, whether the class has dependent relationships or associated classes. Those automatically deactivated classes:

- Appear in light gray in the user interface and you can't reactivate them.
- Are automatically reactivated when you reactivate:
  - The class that you initially deactivated which triggered the automatic deactivation
  - Any class that the deactivated class depends on

All classes that you directly deactivate mappings for and the resulting class mappings that are automatically deactivated, are not populated when the integration runs. Also, any relationships and lookup tables associated with those classes, are not populated when the integration runs.

Class mapping and other deactivation scenarios:
• Deactivate a class which no class depends on and which has no associated classes:
  ◦ Triggers an automatic deactivation of any lookup rules and relationships associated with the deactivated class.
• Deactivate a lookup rule, such as serial number, within a class mapping:
  ◦ Does not trigger any automatic deactivations.
• Deactivate a CMDB class which is associated with a non-CMDB class:
  ◦ Triggers an automatic deactivation of the associated non-CMDB class.
  ◦ Deactivating the non-CMDB class, does not impact the associated CMDB class.
• Deactivate a class with dependent relationships (Applies only if the dependent relationship exists in IntegrationHub ETL):
  ◦ Triggers an automatic deactivation of any class that has a single dependent relationship with the deactivated class.
  ◦ If a class has multiple dependent relationships, then it is automatically deactivated only when you deactivate all of the dependent on classes.
  
  For example, a scenario in which the File System class has dependent relationships with both, the Computer and a Server class. If you deactivate the Computer class, the File System class is not automatically deactivated. Only if you also deactivate the Server class, the File System class is automatically deactivated.
• Deactivate a conditional class or a class mapping within a conditional class:
  ◦ Deactivating or activating a conditional class, triggers an automatic deactivation or activation of all conditional class mappings within the conditional class.
  ◦ Deactivating a class mapping within a conditional class: Prevents the deactivated class from getting populated during integration runs. However, the associated ‘If’, ‘Else if’, or ‘Else’ conditions themselves remain in effect within the condition of the conditional class. For example, if you deactivate the following class mapping:

  \[\text{[If]} \text{[operating\_system]} \text{[contains]} \text{[Linux]} \text{Then \[Class\]} \text{[is]} \text{[Linux Server]}\].

  Then, the Linux Server class is not populated, but the \[\text{[If]} \text{[operating\_system]} \text{[contains]} \text{[Linux]}\] condition is in effect.
Map data columns to CMDB classes and attributes

Choose target classes and attributes in the CMDB to map source data columns to. You can map a data column to a specific target class, or add conditions so that the choice of target class depends on specific data values.

Before you begin
Role required: cmdb_inst_admin

About this task
Data columns that you map can be either source data columns which were not transformed, or transformed data columns. For example, to integrate a data column into the Computer and Software Package classes, select those classes as target classes and then map data columns into specific attributes in those classes.

When you configure mapping for a class, relationship, or a lookup rule, those items are always initially set as activated. For details about the results of deactivating mappings, see Deactivating class mappings.

Procedure
1. Navigate to Configuration > IntegrationHub ETL, and click the Name of an integration.
   The landing page of the IntegrationHub ETL lists all integrations that exist in the system, including integrations that were downloaded from the ServiceNow store.

2. In the ETL Transform Map Assistant page, in the Map Data to CMDB and Add Relationships section of the guided setup, select Select CMDB Classes to Map Source Data.
   Attributes that are configured as required in the platform, are noted, and you must map a data column to each of those attributes.

3. Click Add Class to add a target class to map to, or click Edit Class to edit a class.
   a. In the Add Class dialog box, select a CMDB Class.
   b. Click Save.
   c. Optional: Set the Activate/Deactivate Mapping toggle switch for a class, to on or off. If the Affected class mappings dialog box appears, review the list of affected classes, and then click Proceed.

4. Click Add Conditional Class to specify different conditions for selecting different target classes.
a. In the **Add Conditional Class** dialog box, specify the conditions that must be met for data to be mapped to various target classes. In the **choose field** list, select attribute conditions that data values must meet, or enter plugins in the search box and specify a plugin condition. You can then specify that the rest of the records, which did not match any conditions, are mapped to yet a different target class.

When processing nested data, a prefix denotes the first level in the nested hierarchy for attribute items.

Data records are mapped to different target classes according to the conditions met.

b. Click **Save**.

c. **Optional:** Set the Activate/Deactivate Mapping toggle switch for a conditional class, to on or off. If the Affected class mappings dialog box appears, review the list of affected classes, and then click **Proceed**.

d. **Optional:** Click **Edit Class** to edit the settings of a conditional class. In the Edit Conditional Class dialog box, set the Activate/Deactivate Mapping toggle switch for a class mapping, to on or off. Click **Save**, and if the Affected class mappings dialog box appears, review the list of affected classes and then click **Proceed**.

- A deactivated class is not populated during integration runs, however, this doesn't affect the associated condition. The 'If', 'Else if', and 'Else' conditions themselves remain in effect within the condition of the conditional class and matching CIs are filtered accordingly.

- The toggle switch of the conditional class reflects the summary of the states of all the conditional class mappings within the conditional class. If at least one of the conditional class mappings is activated, then the toggle switch of the conditional class appears as activated. Otherwise, the toggle switch of the conditional class appears as deactivated.

5. For a non-CMDB class, click **Add Associated Class** to associate the non-CMDB class with a CMDB class. Or, click **Edit Associated Class** to edit an already associated class.
a. In the Add Associated Class dialog box, select a CMDB class. The list includes all entries in the Related Entry [cmdb_related_entry] class for the specified non-CMDB table.

b. Click Add.

c. Optional: Set the Activate/Deactivate Mapping toggle switch for an associated class, to on or off.

6. Click Set Up Mapping to configure mapping for a newly added class, or click Edit Mapping to edit a mapping.

a. To map, drag data columns from the Data sidebar on the right, to CMDB target attribute on the left side of the mapping page. Or, click the icon to search and select data columns for the mapping.

When mapping nested data:

• Data columns in the Data sidebar appear in a tree format that represents the structure of the nested data. Each attribute is associated with sample data for the attribute.

• Transformed columns are noted by a cyan-shaded dot.

• All mappings to a specific CMDB class must be from the same source branch in the nested data. Only the branch from which you selected the first column to map, is valid for selecting columns in subsequent mappings. This restriction applies differently when mapping to attributes in lookup tables. All mappings to attributes in a lookup table also must be from the same source branch. However, that source branch can be different than the source branch you used with non-lookup tables.

   Note: You can work around this restriction by using the Copy transform in the data preparation step, to copy attributes from a parent level to a child level. Prepare the data so that all the attributes that you want to map, are at the same level.

• When you drag a column to map from the Data sidebar, the fields of CMDB target attributes that are valid for the mapping, are highlighted by a green frame. If you attempt to drop a column in an invalid target attribute, the respective field is highlighted by a red frame and an error appears.

b. Click Add Attribute. Then, in the Add Attribute dialog box, from the Attribute list, select one or more items as target attributes to map data to. Close the Attribute list and click Save.
c. Map any lookup rules such as the ‘Serial Number Lookup 1’ rule. Lookup rules are in a deactivated state until you map them. After mapping a field of a lookup rule, you can set the Activate/Deactivate Lookup rule toggle switch for a rule, to on or off.

d. Optional: Click View Class Details to view the current class in CI Class Manager.

e. Optional: Click the Transform Data tab to navigate to the data preparation page where you can review and further transform data that you want to map.

f. Return to the Select CMDB Classes to Map Source Data page.

7. Click Mark as Complete.

Add Relationships
Add relationships that exist among the target CMDB classes, for an integration.

Before you begin
• A class that you want to add in the relationship, must be in an activated state.
• A base relationship or a relationship within a conditional relationship, that you want to edit, must be in an activated state.
• In a conditional relationship that you want to edit, at least one relationship condition must be in an activated state. Otherwise, the Edit Relationship button is grayed out.

Role required: cmdb_inst_admin

About this task
When creating relationships with nested data, you can’t create a relationship between sibling objects from the nested data. Using the sample payload for nested data as an example, you can’t create a relationship between interfaces and software.

ITOM Visibility, if available, uses enhanced discovery patterns to identify and add CI relationships to the Suggested Relationships table in the base system. When applicable, use the Suggested Relationships table to select relationships that are in compliance with Common Service Data Model (CSDM) standards.
Procedure

1. Navigate to Configuration > IntegrationHub ETL, and click the Name of an integration.
   The landing page of the IntegrationHub ETL lists all integrations that exist in the system, including integrations that were downloaded from the ServiceNow Store.

2. In the ETL Transform Map Assistant page, in the Map Data to CMDB and Add Relationships section of the guided setup, select Add Relationships.

3. To add relationships, select Add Relationship or Add Conditional Relationship if you want to specify attribute conditions that must be met before adding a relationship. Then, complete the following actions as needed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Relationship</td>
<td>a. Select the Parent, Child, and Relationship Type values.</td>
</tr>
<tr>
<td></td>
<td>b. Click Add.</td>
</tr>
<tr>
<td>Add Conditional Relationship</td>
<td>a. In the choose field list, select attribute conditions that the data values must meet.</td>
</tr>
<tr>
<td></td>
<td>b. Select the Parent, Child, and Relationship Type values.</td>
</tr>
<tr>
<td></td>
<td>c. Click Save. To add a relationship, click Save. When processing nested data, a prefix denotes</td>
</tr>
<tr>
<td></td>
<td>the first level in the nested hierarchy for attribute items.</td>
</tr>
</tbody>
</table>

The Relationship Type list menu changes based on the selected parent and child class:

- If there is a dependent relationship, the list is disabled and the relationship type is automatically populated.
- If there is more than one dependent relationship, the list displays both containment and hosting relationship options and the containment relationship type is automatically populated.
• If there is no dependent relationship, the list displays **Suggested relationships** with the first suggested relationship automatically selected, followed by the base system relationship types.

• If there is no suggested relationship, the list displays **No suggested relationships** followed by the base system relationship types.

4. Click **Save** to save the current changes or **Mark as Complete**.
   
   A time stamp appears in the header when you click **Save**, which remains for the duration of the Integration Hub ETL session for the ETL transform map. When you re-enter the session or switch between ETL maps, the time stamp disappears.

**Preview mapping results**

Preview the results of the sample data integration.

**Before you begin**

Role required: cmdb_inst_admin

**About this task**

Run an integration test and view a summary of the results, for the sample data (by default, up to 100 records). The summary includes total numbers for relationships that were created, mapped classes, partial and incomplete payloads that IRE couldn’t process. You can also view detailed messages from RTE and IRE. After you view the details in the summary page, you can return to any step to make adjustments and then rerun the integration.

**Procedure**

1. Navigate to **Configuration > IntegrationHub ETL**, and click the **Name** of an integration.
   
   The landing page of the IntegrationHub ETL lists all integrations that exist in the system, including integrations that were downloaded from the ServiceNow Store.

2. In the ETL Transform Map Assistant page, in the Preview Sample Integration Results and Schedule Import section of the guided setup, select **Test and Rollback Integration Results**.

3. On the Test and Rollback Integration Results page, click **Run Integration**.

4. View the summary page and click the various tabs to see the integration run results for the affected CMDB classes. You can click **i** to open CI forms and view information.
Note: The order of the attribute columns follows the default columns list for the class in the platform. First, the default columns for the class appear from left to right, followed by the rest of the attribute columns organized in alphabetical order. For example, to see the default columns list for the Computers class, navigate to Configuration > Computers.

5. Optional: Select any class tab and click Edit Mapping to return to the Select CMDB Classes to Map Source Data page where you can review and change mapping settings.

Note: Clicking Edit Mapping rolls back all the changes that were made to the CMDB as a result of this integration run.

6. Optional: Click the Relationships tab and review any relationships that were created. Click Edit Relationships to return to the Add Relationships page where you can review and change any relationship configurations.

Note: Clicking Edit Relationships rolls back all the changes that were made to the CMDB as a result of this integration run.

7. Click the Error Log and Activity Log tabs for details about the activities and any errors logged by IRE and RTE during the integration.

8. Click the Incomplete Payloads and Partial Payloads tabs for details about IRE payloads for the integration run.

9. Click Mark as Complete. The Rollback options dialog box appears and you can choose either of the following options.

• Retain Data: All the changes to the CMDB resulting from this integration, are retained.

• Perform Rollback: All the changes to the CMDB resulting from this integration, are rolled back and the CMDB is restored to its state before running the integration.

Provide integration schedule

Configure a schedule for importing data to CMDB using this ETL Transform Map.

Before you begin

Role required: cmdb_inst_admin
Procedure

1. Navigate to **Configuration > IntegrationHub ETL**, and click the **Name** of an integration.
   The landing page of the IntegrationHub ETL lists all integrations that exist in the system, including integrations that were downloaded from the ServiceNow Store.

2. In the ETL Transform Map Assistant page, in the Preview Sample Integration Results and Schedule Import section of the guided setup, select **Set Import Schedule**.

3. On the Provide Schedule page, click **Set Schedules**.

4. In the Scheduled Data Imports list view (which opens in a new tab), click **New**.

5. Fill out the Scheduled Data Import form and then click **Submit**.
   See **Schedule a data import** for details about the form fields.

6. Click **Mark as Complete**.

Transform types in IntegrationHub ETL

Use various transforms in IntegrationHub ETL to convert and prepare source data for mapping to the CMDB.

Transforms from the **Integration Commons for CMDB** store app, are also available in IntegrationHub ETL.

**Concatenation**

Combines the values from input fields into a single string, joining them on the optional **joining_string** field.

<table>
<thead>
<tr>
<th>Details</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>sys_rteEb_concat_operation</td>
</tr>
<tr>
<td>Input fields</td>
<td>source_sys_rte_pb_fields</td>
</tr>
<tr>
<td>Output field</td>
<td>target_sys_rte_pb_field</td>
</tr>
<tr>
<td>Additional Fields</td>
<td>joining_string (optional)</td>
</tr>
</tbody>
</table>

**Example**

<table>
<thead>
<tr>
<th>Input</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“input_1”, “input_2”, “input_3”</td>
<td></td>
</tr>
</tbody>
</table>
Example

<table>
<thead>
<tr>
<th>Additional Fields</th>
<th>joining_string = &quot;, &quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Result</td>
<td>“input_1, input_2, input_3”</td>
</tr>
</tbody>
</table>

### Convert to Boolean

Converts the incoming value to a boolean. ‘true’ and ‘1’ values convert to ‘true’ (case insensitive), and any other values convert to ‘false’.

<table>
<thead>
<tr>
<th>Details</th>
<th>sys_rte_eb_to_boolean_operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>sys_rte_eb_to_boolean_operation</td>
</tr>
<tr>
<td>Input fields</td>
<td>source_sys_rte_eb_field</td>
</tr>
<tr>
<td>Output field</td>
<td>target_sys_rte_eb_field</td>
</tr>
</tbody>
</table>

Examples:

- All of the following inputs return ‘true’:
  - true
  - 1
- All of the following inputs return ‘false’:
  - “input_1”
  - “”
  - 0
  - 11

### Convert to Date

Attempts to convert the incoming value to a GlideDateTime value by applying the date_format to the incoming value. Attempts to directly convert using GlideDateTime if the date_format is incorrect.

<table>
<thead>
<tr>
<th>Details</th>
<th>sys_rte_eb_to_date_operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>sys_rte_eb_to_date_operation</td>
</tr>
<tr>
<td>Input fields</td>
<td>source_sys_rte_eb_field</td>
</tr>
<tr>
<td>Output field</td>
<td>target_sys_rte_eb_field</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Details

Returns an empty value if unable to parse at all.

Additional Fields

date_format (Java simple date format)

Example

<table>
<thead>
<tr>
<th>Input</th>
<th>2018/09/20 11:21:00 AM EST</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Fields</td>
<td>date_format = “yyyy/MM/dd hh:mm:ss a z”</td>
</tr>
<tr>
<td>Result</td>
<td>“2018-09-20 16:21:00”</td>
</tr>
</tbody>
</table>

Example

<table>
<thead>
<tr>
<th>Input</th>
<th>2018/09/20 01:21:00 PM EST</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Fields</td>
<td>date_format = “yyyy/MM/dd hh:mm:ss a z”</td>
</tr>
<tr>
<td>Result</td>
<td>“2018-09-20 18:21:00”</td>
</tr>
</tbody>
</table>

Example

<table>
<thead>
<tr>
<th>Input</th>
<th>09/20/18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Fields</td>
<td>date_format = “yyyy/MM/dd hh:mm:ss a z”</td>
</tr>
<tr>
<td>Result</td>
<td>“0018-09-20 00:00:00”</td>
</tr>
</tbody>
</table>

Convert to Numeric

Converts the incoming value to a number.

Details

Table | sys_rte_eb_to_numeric_operation |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Input fields</td>
<td>source_sys_rte_eb_field</td>
</tr>
<tr>
<td>Output field</td>
<td>target_sys_rte_eb_field</td>
</tr>
</tbody>
</table>

If the incoming value is non-numeric, then the output is empty.
### Example

<table>
<thead>
<tr>
<th>Input</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.23</td>
<td>1.23</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>input_1</td>
<td>null</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>two</td>
<td>null</td>
</tr>
</tbody>
</table>

#### Copy

Copies the source field’s value to all of the target fields.

<table>
<thead>
<tr>
<th>Details</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>sys_rte_eb_copy_operation</td>
</tr>
<tr>
<td>Input fields</td>
<td>source_sys_rte_eb_field</td>
</tr>
<tr>
<td>Output field</td>
<td>target_sys_rte_eb_fields</td>
</tr>
<tr>
<td>Additional Fields</td>
<td>overwrite_existing_value (optional, boolean): If true, then the values of target fields are replaced. Otherwise, any non-empty value is not overwritten.</td>
</tr>
</tbody>
</table>

#### Extract Leading Numeric

Sets the target field to be the first numeric value found in the source field.
<table>
<thead>
<tr>
<th>Details</th>
<th>sys_rte_eb_extract_numeric_operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input  fields</td>
<td>source_sys_rte_eb_field</td>
</tr>
<tr>
<td>Output field</td>
<td>target_sys_rte_eb_field</td>
</tr>
<tr>
<td>Additional Fields</td>
<td></td>
</tr>
</tbody>
</table>
|  | • **decimal_places** (optional, number): Forces the output to have a specified number of decimal places.  
|  | • **remainder_target_field** (optional, reference to a field): Set to the trimmed remainder of the source field, after removing the first numeric value.  

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
</table>
| Input | “100 mb”  
| Result | “100”  

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
</table>
| Input | “100.123 mb”  
| Result | “100.123”  

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
</table>
| Input | “100.123 mb”  
| Additional Fields | **decimal_places** = 2  
| Result | “100.12”  

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
</table>
| Input | “100 mb”  
| Additional Fields | **decimal_places** = 2  
| Result | “100.00”  

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Glide Lookup

Performs a lookup in the database on the `target_table`.  

<table>
<thead>
<tr>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table</strong></td>
</tr>
<tr>
<td><strong>Input fields</strong></td>
</tr>
<tr>
<td><strong>Output field</strong></td>
</tr>
<tr>
<td><strong>Additional Fields</strong></td>
</tr>
<tr>
<td>• <code>target_table</code></td>
</tr>
<tr>
<td>• <code>glide_matching_fields</code> (string): Comma-separated list of column names in the target table. For each input field in <code>source_sys_rte_eb_fields</code>, there must be an equal number of values in <code>glide_matching_fields</code></td>
</tr>
<tr>
<td>• <code>glide_target_fields</code> (string): Comma-separated list of column names in the target table. For each target field in <code>target_sys_rte_eb_fields</code>, there must be an equal number of values in <code>glide_target_fields</code>.</td>
</tr>
</tbody>
</table>

**Example**

<table>
<thead>
<tr>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Input Field 1: 100 South Charles Street, Baltimore</td>
</tr>
<tr>
<td>• Input Field 2: MD</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Additional Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Target Table: Location (cmn_location)</td>
</tr>
<tr>
<td>• Glide Matching Fields: street,state</td>
</tr>
<tr>
<td>• Glide Target Fields: sys_id</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Field 1: 25ab9c4d0a0a0bb300f7dabdc0ca7c1c</td>
</tr>
</tbody>
</table>
Min/Max
Sets the target field to either the maximum or minimum of the values from all input fields.

<table>
<thead>
<tr>
<th>Details</th>
<th>sys_rte_eb_min_max_operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>source_sys_rte_eb_fields</td>
</tr>
<tr>
<td>Input fields</td>
<td>target_sys_rte_eb_field</td>
</tr>
<tr>
<td>Output field</td>
<td></td>
</tr>
<tr>
<td>Additional Fields</td>
<td>data_type (choice list &lt;STRING,NUMERIC,DATE&gt;)</td>
</tr>
<tr>
<td></td>
<td>min_max (choice list &lt;MIN,MAX&gt;)</td>
</tr>
</tbody>
</table>

Example

<table>
<thead>
<tr>
<th>Input</th>
<th>&quot;2&quot;, &quot;-1&quot;, &quot;0&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Fields</td>
<td>data_type = NUMERIC</td>
</tr>
<tr>
<td></td>
<td>min_max = MAX</td>
</tr>
<tr>
<td>Result</td>
<td>&quot;2&quot;</td>
</tr>
</tbody>
</table>

Example

<table>
<thead>
<tr>
<th>Input</th>
<th>&quot;a&quot;, &quot;b&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Fields</td>
<td>data_type = STRING</td>
</tr>
<tr>
<td></td>
<td>min_max = MAX</td>
</tr>
<tr>
<td>Result</td>
<td>&quot;b&quot;</td>
</tr>
</tbody>
</table>

Example

<table>
<thead>
<tr>
<th>Input</th>
<th>&quot;2&quot;, &quot;-1&quot;, &quot;0&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Fields</td>
<td>data_type = NUMERIC</td>
</tr>
<tr>
<td></td>
<td>min_max = MIN</td>
</tr>
<tr>
<td>Result</td>
<td>&quot;-1&quot;</td>
</tr>
</tbody>
</table>
### Example

<table>
<thead>
<tr>
<th>Input</th>
<th>&quot;a&quot;, &quot;b&quot;</th>
</tr>
</thead>
</table>
| Additional Fields | • data_type = STRING  
• min_max = MIN |
| Result | "a" |

### Multiple Input Script

Runs a script with multiple inputs, setting the `target_field == output` for that script.

Each source field is available inside of the ‘batch’ variable as JavaScript fields. The name of the JavaScript field is the field attribute of the entity field (looking at `sys_rteEb_field.field`, not `sys_rteEb_field.name`).

### Details

<table>
<thead>
<tr>
<th>Details</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td><code>sys_rteEb_multiIn_script_operation</code></td>
</tr>
<tr>
<td>Input fields</td>
<td><code>source_sys_rteEb_fields</code></td>
</tr>
<tr>
<td>Output field</td>
<td><code>target_sys_rteEb_field</code></td>
</tr>
</tbody>
</table>
| Additional Fields | • script (script)  
• use_unique_input_sets (boolean): When `true`, only unique input values are included in the data batch for IRE processing. Otherwise, all input object’s field values are included. |

Example for using `use_unique_input_sets`, with a script function that takes `record_type` and `operating_system` as input and returns `record_with_os`:

### Input data

<table>
<thead>
<tr>
<th>Record</th>
<th>record_type</th>
<th>operating_system</th>
<th>record_with_os</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>computer</td>
<td>Windows XP</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>computer</td>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>computer</td>
<td>Windows XP</td>
<td></td>
</tr>
</tbody>
</table>
If `use_unique_inputs_sets` is set to `true`, then the script processes only two values (computer + Windows XP and computer + Linux). If `use_unique_inputs_sets` is set to `false`, then each of the three values is individually processed (computer + Windows XP, computer + Linux, and computer + Windows XP).

Sample script:

```javascript
(function(batch, output) {
    for (var i = 0; i < batch.length; i++) {
        // batch[i] is the unique set of inputs/individual record
        // batch[i].<field> gives access to the field value
        var in0 = gs.nil(batch[i].record_type) ? '' : batch[i].record_type;
        var in1 = gs.nil(batch[i].operating_system) ? '' : batch[i].operating_system;

        // output[i] is the output for the specific combination of inputs/individual record
        output[i] = in0 + "_" + in1;
    }
})(batch, output);
```

Sample script:

```javascript
/* Example Script
   // In this example the script input fields are 'input_field_1',
   'input_field_2' - replace these with the fields used as script inputs
   // There is a static field 'input' that has all the input field values concatenated with a '|' (function(batch, output) {

    for (var i = 0; i < batch.length; i++) {

        //step1: access the input variables
        var a = batch[i].input_field_1; //Value of the first source field.
        var b = batch[i].input_field_2; //Value of the second source field.

        //step2: Your script/code goes here.
        var c = a + b;

        //step3: set the output for each elements
        output[i] = b;
    }

})(batch, output);
*/
```
**Rexeg Replace**
Replaces each substring of the incoming string that matches the specified `match_regex`, with the specified `replacement_regex` string value.

<table>
<thead>
<tr>
<th>Details</th>
<th>sys_rte_eb_regex_replace_operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input fields</td>
<td>source_sys_rte_eb_field</td>
</tr>
<tr>
<td>Output field</td>
<td>target_sys_rte_eb_field</td>
</tr>
</tbody>
</table>
| Additional Fields| • `match_regex` (string, regular expression)  
|                  | • `replacement_regex` (string)       |

<table>
<thead>
<tr>
<th>Example</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>“String&amp;With(Special)$Characters”</td>
</tr>
</tbody>
</table>
| Additional Fields| • `match_regex` = “[^0-9a-zA-Z]+”    
|                  | • `replacement_regex` = “ “         |
| Result           | “String With Special Characters”    |

**Replace**
Replaces each substring in the incoming string that matches the specified `match_string`, with the `replacement_string` string value.

<table>
<thead>
<tr>
<th>Details</th>
<th>sys_rte_eb_replace_operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input fields</td>
<td>source_sys_rte_eb_field</td>
</tr>
<tr>
<td>Output field</td>
<td>target_sys_rte_eb_field</td>
</tr>
</tbody>
</table>
| Additional Fields| • `match_string` (string)             
|                  | • `replacement_string` (string)       |

<table>
<thead>
<tr>
<th>Example</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>“Original String”</td>
</tr>
</tbody>
</table>
**Example**

| Additional Fields | • `match_string` = "Original"
| | • `replacement_string` = "Replacement"
| Result | "Replacement String"

**Round Numeric**

Rounds the number value to the nearest whole number. Non-numbers are truncated.

**Details**

| Table | `sys_rte_eb_round_numeric_operation`
| Input fields | `source_sys_rte_eb_field`
| Output field | `target_sys_rte_eb_field`

**Example**

| Input | "1.5"
| Result | "2"

| Input | "1.4"
| Result | "1"

| Input | "i’m a string"
| Result | ""

**Script**

Runs a script with input, setting the target_field == output for that script.

This transform has been superseded by the Multi Input Script transform and is included for backwards compatibility with existing configurations.
The source field is included in the ‘batch’ variable as the JavaScript field ‘input’.

```javascript
(function(batch, output) {
    for (var i = 0; i < batch.length; i++) {
        // batch[i] is the unique set of inputs/individual record
        // batch[i].input gives access to the field value
        var in0 = gs.nil(batch[i].input) ? '' : batch[i].input;
        // output[i] is the output for the specific combination of
        inputs/individual record
        output[i] = in0 + " modified by script";
    }
})(batch, output);
```

Example:

```javascript
/* Example Script
(function(batch, output) {
    for (var i = 0; i < batch.length; i++) {
        //step1: access the input variables
        var a = batch[i].input; //Value of the source field.
        //step2: Your script/code goes here.
        var b = a + 1;
        //step3: set the output for each elements
        output[i] = b;
    }
})(batch, output);
*/
```
Set
Sets the target field’s value to the string specified in `set_value`.

<table>
<thead>
<tr>
<th>Details</th>
<th>sys_rte_eb_set_operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td></td>
</tr>
<tr>
<td>Input fields</td>
<td>source_sys_rte_eb_field</td>
</tr>
<tr>
<td>Output field</td>
<td>target_sys_rte_eb_field</td>
</tr>
<tr>
<td>Additional Fields</td>
<td>• <code>set_value</code> (string)</td>
</tr>
<tr>
<td></td>
<td>• <code>overwrite_existing_value</code> (optional, boolean): When true, the current value of the target field is overwritten. Otherwise, a non-empty value isn’t replaced.</td>
</tr>
</tbody>
</table>

Split
Splits the source field’s value on the `splitting_string` and assigns each resulting item from the split to the `target_sys_rte_eb_fields`, in order.

<table>
<thead>
<tr>
<th>Details</th>
<th>sys_rte_eb_split_operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td></td>
</tr>
<tr>
<td>Input fields</td>
<td>source_sys_rte_eb_field</td>
</tr>
<tr>
<td>Output field</td>
<td>target_sys_rte_eb_fields</td>
</tr>
<tr>
<td>Additional Fields</td>
<td><code>splitting_string</code> (string)</td>
</tr>
</tbody>
</table>

Example
```
Input  | “value1 | | value2 | | value3”, with target_sys_rte_eb_fields {target1,target2,target3}
Additional Fields | splitting_string = ” | | ”
Result  | target1 : value1, target2 : value2, target3 : value3
```
Example

| Input                                           | “value1 | | value2 | | value3”, with `target_sys_rte_eb_fields` {target1} |
| Additional Fields                               | `splitting_string = " | | "` |
| Result                                         | `target1 : value1` |

Example

| Input                                           | “value1”, with `target_sys_rte_eb_fields` {target1,target2,target3} |
| Additional Fields                               | `splitting_string = " | | "` |
| Result                                         | `target1 : value1, target2 : <null>, target3 : <null>` |

**Trim**

Trims leading and trailing whitespace from the `source_sys_rte_eb_field` value and assigns the result to the `target_sys_rte_eb_field`. This transform is equivalent to a Java String.trim().

**Details**

| Table                                           | `sys_rte_eb_trim_operation` |
| Input fields                                    | `source_sys_rte_eb_field` |
| Output field                                    | `target_sys_rte_eb_field` |

Example

| Input                                           | “ value 1 " |
| Result                                         | “value 1” |

**Uppercase**

Uppercases the `source_sys_rte_eb_field` value and assigns the result to `target_sys_rte_eb_field`. 
### Uppercase Trim

Combines both the Uppercase and the Trim transforms.

<table>
<thead>
<tr>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
</tr>
<tr>
<td>Input fields</td>
</tr>
<tr>
<td>Output field</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
</tr>
<tr>
<td>Result</td>
</tr>
</tbody>
</table>

### Duplicate an ETL transform map

Use an existing ETL transform map if you need to create a map that is mostly similar to that existing map. Select an existing map, specify a new data source for the new duplicate map, and then change or retain other settings such as data transforms.

**Before you begin**

The data source for the new duplicated ETL transform map must satisfy these requirements:
• The schema of the data source must be identical to the schema of the original ETL transform map. For example, both data sources must have an identical number of columns and identical column labels.

• The data source must preexist.

• The data source must not be used in any other ETL transform map.

Role required: cmdb_inst_admin

Procedure
1. Navigate to Configuration > IntegrationHub ETL.
   The landing page of the IntegrationHub ETL lists all integrations that exist in the system, including integrations that were downloaded from the ServiceNow Store.

2. Click Duplicate and then fill out the Duplicate ETL Transform Map form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate from</td>
<td>The ETL transform map to duplicate from.</td>
</tr>
<tr>
<td>CMDB application</td>
<td>The CMDB application associated with the ETL transform map.</td>
</tr>
<tr>
<td></td>
<td>You can select Add new, which adds the CMDB Application and the Discovery Source fields for the new CMDB application.</td>
</tr>
<tr>
<td>Discovery Source</td>
<td>Discovery source associated with a new CMDB Application. Appears if you set CMDB Application to Add new.</td>
</tr>
<tr>
<td>CMDB Application Name</td>
<td>Name of a new CMDB Application. Appears if you set CMDB Application to Add new.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the ETL transform map.</td>
</tr>
<tr>
<td>Data Source</td>
<td>The source feed, unique for this ETL transform map, where the raw source data is imported from.</td>
</tr>
</tbody>
</table>

3. Click Create Duplicate.
Results
Data for the new duplicated ETL transform map is imported, and the Import Source Data and Provide Basic Details task, is set as complete.

What to do next
Continue with the next steps on the guided setup steps to review the imported data and complete the integration using the duplicated ETL transform map.

Integration Commons for CMDB (2.5.0)
The Integration Commons for CMDB store app contain a set of RTE (Robust Transform Engine) transforms and script includes. Use these transforms and script includes to standardize the values stored in the CMDB by different data integrations or by changes.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

CMDB Integrations Dashboard
The Integration Commons for CMDB store app provides a dashboard with a central view of status, processing results, and processing errors of all installed Service Graph Connectors. You can see metrics for all Service Graph Connector runs, or filter the view to a specific connector, a specific time duration, or a specific connector run.

To access the CMDB Integrations Dashboard:
1. Navigate to Self-Service > Dashboards.
2. On the Dashboards view, select CMDB Integrations Dashboard and do any of the following actions:
   - Click the CMDB Execution Status tab to see metrics such as the total number of integrations and processed rows, integration runs actively running, daily statistics, and details about the classes that were updated.
   - Click the CMDB Integration Errors tab to see metrics such as number of import and integration errors, and number of erroneous imported records.
   - Point to the score on the various tiles to drill down to the list views for the associated records. Point to charts to show more details for the chart.
   - Narrow down the scope of the integration runs included in the metrics on the dashboard by configuring filters on the right-hand side of the
dashboard. Set any of the following filters and then click **Apply**. The filter settings apply to any metric with a filter icon in its upper left corner.

### Filters

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Date</td>
<td>Select <strong>All</strong> or a time period, such as <strong>Last 7 days</strong>, from which to include integration runs in metrics.</td>
</tr>
<tr>
<td>CMDB Applications</td>
<td>Select <strong>All</strong>, or a CMDB application, such as <strong>SCCM</strong>, from which to include integration runs in metrics.</td>
</tr>
<tr>
<td>CMDB Import</td>
<td>Select <strong>All</strong>, or a specific integration run to include in metrics.</td>
</tr>
</tbody>
</table>

### Using the transforms and script includes in Integration Commons for CMDB

The attributes that are included in the Integration Commons for CMDB store app are attributes that Identification and Reconciliation Engine (IRE) requires for identification or attributes that could be used to derive classes.

The transforms are templated operations, meaning that there is a script that controls the logic for the transform. The result is that there can be only a single output. When a transform returns multiple values, then those values are concatenated by a triple pipe (|||). You then must use the split transform to retrieve the values that you are interested in. The inputs are either a single field or a list of fields. For all but one transform, the inputs are assumed to be a fixed list of fields as described for each of the following individual transform.

ServiceNow Service Graph Connectors that are available at the ServiceNow Store, have dependencies on the transforms and script includes in the Integration Commons for CMDB store app. Therefore, when you install such CMDB integration, the Integration Commons for CMDB store app is automatically installed too.

The following RTE transforms are included in Integration Commons for CMDB store app, and are available in the **IntegrationHub ETL (2.1.0)** store app.

### Cleanse Company

Use to cleanse hardware manufacturer name and add the record to the Company [core_company] table to populate a reference, when the manufacturer is not linked to a model or software (cpu_manufacturer).
### Details

<table>
<thead>
<tr>
<th>Table</th>
<th>sn_cmdb_int_util_cleanse_company_operation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input fields</strong></td>
<td></td>
</tr>
<tr>
<td>source_sys_rte_eb_field</td>
<td>Input is a company/manufacturer name.</td>
</tr>
<tr>
<td><strong>Output field</strong></td>
<td></td>
</tr>
<tr>
<td>target_sys_rte_eb_field</td>
<td>Output is the resulting sys_id and name of the company in core_company, concatenated by triple pipe (</td>
</tr>
<tr>
<td><strong>Script include function</strong></td>
<td></td>
</tr>
<tr>
<td>sn_cmdb_int_util.CmdbIntegrationHardwareModelUtil().cleanseCompany(input)</td>
<td></td>
</tr>
</tbody>
</table>

If a matching record does not exist, then a new record is created in core_company so the return always includes a sys_id and name (unless the input is empty or invalid). The name is cleansed and a fuzzy lookup is done via the CmdbIntegrationCompanyModelUtil script include before the MakeAndModelIJS platform API is called.

#### Example:

<table>
<thead>
<tr>
<th>Input</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERVICENOW</td>
<td>93d4ecfac0a8000b6294d71b733977fb</td>
</tr>
</tbody>
</table>

### Cleanse Hardware Model

Use to create, cleanse, or lookup a hardware model to create a reference (model_id).

<table>
<thead>
<tr>
<th>Table</th>
<th>sn_cmdb_int_util_cleanse_hardware_model_operation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input fields</strong></td>
<td></td>
</tr>
<tr>
<td>source_sys_rte_eb_fields</td>
<td>Input in order is:</td>
</tr>
<tr>
<td>1. The manufacturer name</td>
<td></td>
</tr>
<tr>
<td>2. The model name</td>
<td></td>
</tr>
<tr>
<td>If either value is provided by itself, then the operation only processes what is found.</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Details

<table>
<thead>
<tr>
<th>Output field</th>
<th>target_sys_rte_eb_field</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Output is the resulting sys_id and name of the company in core_company, and sys_id and name of the model in cmdb_model - all concatenated by triple pipe (</td>
</tr>
</tbody>
</table>

Script include function

| sn_cmdb_int_util.CmdbIntegrationHardwareModelUtil().cleanseModelAndCompany(manufacturer_in, model_in) |

For either the manufacturer or model, if a matching record does not exist then a new record is created so the return always includes sys_ids and names for both records (unless the input is empty or invalid).

The manufacturer name is processed like the Cleanse Company transform and then both the manufacturer name and model name are sent to the MakeAndModelJS platform API.

Example:

<table>
<thead>
<tr>
<th>Manufacturer Name</th>
<th>Model Name</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNow Incorporated</td>
<td>SERVICENOW</td>
<td>93d4ecfac0a8000b6294d71b733977f7</td>
</tr>
</tbody>
</table>

**Cleanse IP Address**

Use when a field provides an IP address.

Details

<table>
<thead>
<tr>
<th>Table</th>
<th>sn_cmdb_int_util_cleanse_ip_operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input fields</td>
<td>source_sys_rte_eb_field</td>
</tr>
<tr>
<td></td>
<td>Input is the IP address to cleanse.</td>
</tr>
<tr>
<td>Output field</td>
<td>target_sys_rte_eb_field</td>
</tr>
<tr>
<td></td>
<td>Output is the resulting IP address, which can be empty.</td>
</tr>
<tr>
<td>Script include function</td>
<td>sn_cmdb_int_util.CmdbIntegrationNetworkUtil().cleanseIpAddress(input)</td>
</tr>
</tbody>
</table>
The IP address is tested for both IPv4 and IPv6 structures along with some known derivations (an IPv4 with spaces instead of periods). If a result is found, then it is formatted and returned.

Examples:

<table>
<thead>
<tr>
<th>Ip</th>
<th>Ip Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>192.160.89.1</td>
<td>192.160.89.1</td>
</tr>
<tr>
<td>192.160.89.1,54.21.12.311</td>
<td>192.160.89.1</td>
</tr>
<tr>
<td>192 160 89 1 54 21 12 311</td>
<td>192.160.89.1</td>
</tr>
<tr>
<td>192-160-89-1</td>
<td>192.160.89.1</td>
</tr>
<tr>
<td>2001:0db8:0000:0000:0000:ff00:0042:8329</td>
<td>2001:0db8:0000:0000:0000:ff00:0042:8329</td>
</tr>
<tr>
<td>junk</td>
<td>10.124.54.89</td>
</tr>
<tr>
<td>175912537</td>
<td>10.124.54.89</td>
</tr>
<tr>
<td>-1</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

Cleanse IP Version

Use when the source of data does not provide an IP version or when the IP version might be unreliable.

<table>
<thead>
<tr>
<th>Details</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td><code>sn_cmdb_int_util_cleanse_ip_version_operation</code></td>
</tr>
<tr>
<td>Input fields</td>
<td><code>source_sys_rte_eb_field</code>&lt;br&gt;Input is the IP address to cleanse.</td>
</tr>
<tr>
<td>Output field</td>
<td><code>target_sys_rte_eb_field</code>&lt;br&gt;Output is the resulting cmdb_ci_ip_address.ip_version lookup key (either 4, 6, or empty).</td>
</tr>
<tr>
<td>Script include function</td>
<td><code>sn_cmdb_int_util.CmdbIntegrationNetworkUtil().deriveIpVersion(input)</code></td>
</tr>
</tbody>
</table>

The input IP address value is checked for either proper IPv4 or IPv6 structure, otherwise the return is empty. This function provides no IP cleansing.
Example:

<table>
<thead>
<tr>
<th>Input</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>192.160.89.1</td>
<td>4</td>
</tr>
</tbody>
</table>

**Cleanse MAC Address**

Use when a field provides a MAC address.

<table>
<thead>
<tr>
<th>Details</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>sn_cmdb_int_util_cleanse_mac_operation</td>
</tr>
<tr>
<td>Input fields</td>
<td>source_sys_rte_eb_field</td>
</tr>
<tr>
<td></td>
<td>Input is the MAC address to cleanse.</td>
</tr>
<tr>
<td>Output field</td>
<td>target_sys_rte_eb_field</td>
</tr>
<tr>
<td></td>
<td>Output is the resulting MAC address which can be empty.</td>
</tr>
<tr>
<td>Script include function</td>
<td>sn_cmdb_int_util.CmdbIntegrationNetworkUtil().cleanseMacAddress(input)</td>
</tr>
</tbody>
</table>

The MAC address is tested for proper structure along with some known derivations (for example, a MAC address with spaces instead of colons). If a result is found, then it is formatted and returned.

Example:

<table>
<thead>
<tr>
<th>Input</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>00 0A 95 9D 68 16</td>
<td>00:0a:95d:68:16</td>
</tr>
</tbody>
</table>

**Cleanse Operating System**

Use to extract, cleanse, and format an operating system name, when the source provides an operating system value.

<table>
<thead>
<tr>
<th>Details</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>sn_cmdb_int_util_cleanse_os_operation</td>
</tr>
<tr>
<td>Input fields</td>
<td>source_sys_rte_eb_field</td>
</tr>
<tr>
<td></td>
<td>Input is the operating system name to cleanse.</td>
</tr>
</tbody>
</table>
Details

Output field  | target_sys_rte_eb_field
---|---
Output is the resulting operating system name. The resulting operating system name is also written to the cmdb_ci_computer.os list field.

Script include function  | sn_cmdb_int_util.CmdbIntegrationOsUtil().cleanseAndInsertOs(input)

Most of the current cleansing is centered on Microsoft operating system values aside from common cleansing such as fixing casing.

Examples:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Operating System Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2003</td>
<td>Windows 2003</td>
</tr>
<tr>
<td>Windows Vista 64 bit Edition</td>
<td>Windows Vista</td>
</tr>
<tr>
<td>Windows XP Service Pack 2-3</td>
<td>Windows XP</td>
</tr>
<tr>
<td>Microsoft Windows 2003</td>
<td>Microsoft Windows 2003</td>
</tr>
<tr>
<td>Microsoft Windows Vista 64 bit Edition</td>
<td>Microsoft Windows Vista</td>
</tr>
<tr>
<td>Microsoft Windows 2000 Professional Service Pack 4</td>
<td>Microsoft Windows 2000 Professional</td>
</tr>
<tr>
<td>Microsoft Windows XP Service Pack 2-3</td>
<td>Microsoft Windows XP</td>
</tr>
<tr>
<td>linux ubuntu</td>
<td>Linux Ubuntu</td>
</tr>
<tr>
<td>Linux Ubuntu Server</td>
<td>Linux Ubuntu Server</td>
</tr>
</tbody>
</table>

Cleanse Serial Number

Use to cleanse and remove invalid serial numbers.
Details | sn_cmdb_int_util_cleanse_serial_number_operation
---|---
Input fields | source_sys_rte_eb_fields
Input is the serial number to cleanse.
Output field | target_sys_rte_eb_field
Output is the resulting serial number.

Examples:

<table>
<thead>
<tr>
<th>Serial Number</th>
<th>Serial Number Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>ec2aa2da-5312-aa3e-804c-c35feabeda5f</td>
<td>ec2aa2da-5312-aa3e-804c-c35feabeda5f</td>
</tr>
</tbody>
</table>

Cleanse Software Model

Use to cleanse and create a software model. Also, to create manufacturer and software model if they do not exist and follow with a split operation.

Details | sn_cmdb_int_util_cleanse_software_model_operation
---|---
Input fields | source_sys_rte_eb_fields
Input in order is:
1. The manufacturer name
2. The software name
3. The software version (not required)
If only manufacturer or name is provided, then only those values are processed and returned.
Output field | target_sys_rte_eb_field
Output is the resulting sys_id and name of the company in core_company, the cleansed software name, and the cleansed software version all concatenated by a triple pipe (|||).
If a matching manufacturer record does not exist, then a new record is created so the return always includes the sys_id and name for the manufacturer (if the manufacturer is not empty or invalid).

The manufacturer name is processed the same as in the Cleanse Company transform and then the manufacturer name is sent to the MakeAndModelJS platform API.

The software name and version are cleansed and formatted and returned. The version is removed from the software name if present.

### Examples:

<table>
<thead>
<tr>
<th>Manufacturer</th>
<th>Software Name</th>
<th>Software Version</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell Inc.</td>
<td>NoManufacturer</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1.0.0.0</td>
<td></td>
</tr>
<tr>
<td>Dell Inc.</td>
<td>DataEngine</td>
<td>1.0.17.2</td>
<td>b7e7d7d8c0a8016900a5d7f291acce5c</td>
</tr>
<tr>
<td>GenuineIntel</td>
<td>TestSoftware</td>
<td>1.0.0.1</td>
<td>7aad6d00c611228400f00e0f80b67d2d</td>
</tr>
<tr>
<td>Dell Inc.</td>
<td>TestSoftware</td>
<td>232</td>
<td>b7e7d7d8c0a8016900a5d7f291acce5c</td>
</tr>
<tr>
<td>Dell Inc.</td>
<td>TestSoftware</td>
<td>123.0.0.0</td>
<td>b7e7d7d8c0a8016900a5d7f291acce5c</td>
</tr>
<tr>
<td>America Online</td>
<td>TestSoftware</td>
<td>1.0.0.0</td>
<td>0c43d035c61122750000251553f8e8</td>
</tr>
<tr>
<td>America Online</td>
<td>TestSoftware</td>
<td>1.0.0.0</td>
<td>0c43d035c61122750000251553f8e8</td>
</tr>
</tbody>
</table>
Examples: (continued)

<table>
<thead>
<tr>
<th>Manufacturer</th>
<th>Software Name</th>
<th>Software Version</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>dell</td>
<td>LowerCase</td>
<td>1.0.0.0</td>
<td>b7e7d7d8c0a8016900a5d7f291acce5c</td>
</tr>
<tr>
<td>Dell Corporation, Inc.</td>
<td>TestSoftware</td>
<td>1.0.0.0</td>
<td>b7e7d7d8c0a8016900a5d7f291acce5c</td>
</tr>
<tr>
<td>Microsoft</td>
<td>Microsoft SQL Server</td>
<td>2.0.0</td>
<td>0e8b8e650a0a0b3b004f285ffbab1a4fc</td>
</tr>
<tr>
<td>Dell Computer</td>
<td>DataEngine</td>
<td>1.0.17.2</td>
<td>b7e7d7d8c0a8016900a5d7f291acce5c</td>
</tr>
<tr>
<td>Adobe</td>
<td>TestSoftware</td>
<td>1</td>
<td>b7e8b5c4c0a80169008b49e468920048</td>
</tr>
</tbody>
</table>

**Create Software Instance Name**

Use when a hardware name, software name, and software version is provided, to create a new software instance name.

**Details**

<table>
<thead>
<tr>
<th>Table</th>
<th>sn_cmdb_int_util_create_software_instance_name_operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input fields</td>
<td><strong>source_sys_rte_eb_fields</strong></td>
</tr>
<tr>
<td></td>
<td>Input in order is:</td>
</tr>
<tr>
<td></td>
<td>1. The hardware name</td>
</tr>
<tr>
<td></td>
<td>2. The software name</td>
</tr>
<tr>
<td></td>
<td>3. The software version (not required)</td>
</tr>
<tr>
<td>Output field</td>
<td><strong>target_sys_rte_eb_field</strong></td>
</tr>
<tr>
<td></td>
<td>Output is the software instance name.</td>
</tr>
<tr>
<td>Script include function</td>
<td><strong>sn_cmdb_int_util.CmdIntegrationSoftwareModelUtil().createSoftwareInstanceName</strong></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Examples:

<table>
<thead>
<tr>
<th>Hardware Name</th>
<th>Software Name</th>
<th>Software Version</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>computer1</td>
<td>microsoft</td>
<td>2.0.1</td>
<td>microsoft 2.0.1-computer1</td>
</tr>
<tr>
<td>computer2</td>
<td>adobe</td>
<td></td>
<td>adobe-computer2</td>
</tr>
<tr>
<td>computer3</td>
<td>adobe</td>
<td>2.1</td>
<td></td>
</tr>
<tr>
<td>hw2</td>
<td>sw3</td>
<td>301</td>
<td>sw3 301-hw2</td>
</tr>
</tbody>
</table>

Derive CI Class from Model

Use when processing a computer record and a model is provided but the class of the computer is ambiguous otherwise. Can be used along with other Derive CI Class transforms.

Details

<table>
<thead>
<tr>
<th>Details</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>sn_cmdb_int_util_derive_class_from_model_operation</td>
</tr>
<tr>
<td>Input fields</td>
<td>source_sys_rte Eb fields</td>
</tr>
<tr>
<td></td>
<td>Input in order is:</td>
</tr>
<tr>
<td></td>
<td>1. The model name</td>
</tr>
<tr>
<td></td>
<td>2. The current class name</td>
</tr>
<tr>
<td>Output field</td>
<td>target_sys_rte Eb field</td>
</tr>
<tr>
<td></td>
<td>Output is the resulting class name.</td>
</tr>
<tr>
<td>Script include</td>
<td>function</td>
</tr>
<tr>
<td></td>
<td>sn_cmdb_int_util.CmdbIntegrationClassUtil().deriveClassNameFromModelInput(class_in)</td>
</tr>
</tbody>
</table>

Does not return a value of a class which is higher in the class hierarchy (a parent class) than the provided input class. For example, does not return cmdb_ci_computer if the input is cmdb_ci_server. Looks only at the cmdb_ci_computer hierarchy, going through cmdb_ci_server (cmdb_ci_computer, cmdb_ci_server, children of cmdb_ci_server).

Currently looks for Server, Windows Server, and Linux Server indicators in the model.
### Derive CI Class from Native Class Identifier

Use when processing a computer record and a native class indicator is provided but the class of the computer is ambiguous otherwise. Can be used along with other Derive CI Class transforms.

#### Table Details

<table>
<thead>
<tr>
<th>Details</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>sn_cmdb_int_util_derive_class_from_native_value_operation</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input fields</th>
<th>source_sys_rte_eb_fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input in order</td>
<td>cmdb_ci_computer</td>
</tr>
<tr>
<td></td>
<td>cmdb_ci_computer</td>
</tr>
<tr>
<td></td>
<td>cmdb_ci_server</td>
</tr>
<tr>
<td></td>
<td>cmdb_ci_server</td>
</tr>
<tr>
<td></td>
<td>cmdb_ci_win_server</td>
</tr>
<tr>
<td></td>
<td>cmdb_ci_win_server</td>
</tr>
<tr>
<td></td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td></td>
<td>cmdb_ci_linux_server</td>
</tr>
</tbody>
</table>

#### Examples:

<table>
<thead>
<tr>
<th>Model</th>
<th>Class</th>
<th>Class Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>window server</td>
<td>cmdb_ci_computer</td>
<td>cmdb_ci_win_server</td>
</tr>
<tr>
<td>Microsoft server</td>
<td>cmdb_ci_computer</td>
<td>cmdb_ci_win_server</td>
</tr>
<tr>
<td>linux server</td>
<td>cmdb_ci_computer</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Red hat server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Arch server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Centos server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Debian server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Fedora server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Suse server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Oracle server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Rhel server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Ubuntu server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Junk</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_server</td>
</tr>
<tr>
<td>Junk server</td>
<td>cmdb_ci_computer</td>
<td>cmdb_ci_server</td>
</tr>
<tr>
<td>Junk</td>
<td>cmdb_ci_computer</td>
<td>cmdb_ci_computer</td>
</tr>
<tr>
<td>Junk</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_server</td>
</tr>
</tbody>
</table>
| Details | 1. The native class identifier
2. The current class name |
| --- | --- |
| Output field | target_sys_rte_eb_field  
Output is the resulting class name. |
| Script include function | sn_cmdb_int_util.CmdIntegrationClassUtil().deriveClassNameFromNativeValue(native_id_in, class_in) |

Does not return a value of a class which is higher in the class hierarchy (a parent class) than the provided input class. For example, does not return `cmdb_ci_computer` if the input is `cmdb_ci_server`. Looks only at the `cmdb_ci_computer` hierarchy, going through `cmdb_ci_server` (`cmdb_ci_computer, cmdb_ci_server, children of cmdb_ci_server`).

Currently looks for Server, Windows Server, and Linux Server indicators in the native identifier.

| Examples: |
| --- | --- | --- |
| **Model** | **Class** | **Class Results** |
| window server | cmdb_ci_computer | cmdb_ci_win_server |
| Microsoft server | cmdb_ci_computer | cmdb_ci_win_server |
| linux server | cmdb_ci_computer | cmdb_ci_linux_server |
| Microsoft server | cmdb_ci_server | cmdb_ci_win_server |
| linux server | cmdb_ci_server | cmdb_ci_linux_server |
| Red hat server | cmdb_ci_server | cmdb_ci_linux_server |
| Arch server | cmdb_ci_server | cmdb_ci_linux_server |
| Centos server | cmdb_ci_server | cmdb_ci_linux_server |
| Debian server | cmdb_ci_server | cmdb_ci_linux_server |
| Fedora server | cmdb_ci_server | cmdb_ci_linux_server |
| Suse server | cmdb_ci_server | cmdb_ci_linux_server |
| Oracle server | cmdb_ci_server | cmdb_ci_linux_server |
| RHEL server | cmdb_ci_server | cmdb_ci_linux_server |
Examples: (continued)

<table>
<thead>
<tr>
<th>Model</th>
<th>Class</th>
<th>Class Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ubuntu server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Junk</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_server</td>
</tr>
<tr>
<td>Junk server</td>
<td>cmdb_ci_computer</td>
<td>cmdb_ci_server</td>
</tr>
<tr>
<td>Junk</td>
<td>cmdb_ci_computer</td>
<td>cmdb_ci_computer</td>
</tr>
</tbody>
</table>

**Derive CI Class from Operating System**

Use when processing a computer record and an operating system is provided but the class of the computer is ambiguous otherwise. Can be used along with other Derive CI Class transforms.

**Details**

<table>
<thead>
<tr>
<th>Details</th>
<th>sn_cmdb_int_util_derive_class_from_os_operation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table</strong></td>
<td>sn_cmdb_int_util_derive_class_from_os_operation</td>
</tr>
<tr>
<td><strong>Input fields</strong></td>
<td>source_sys_rteEb_fields</td>
</tr>
<tr>
<td></td>
<td><strong>Input in order is:</strong></td>
</tr>
<tr>
<td></td>
<td>1. The operating system name</td>
</tr>
<tr>
<td></td>
<td>2. The current class name</td>
</tr>
<tr>
<td><strong>Output field</strong></td>
<td>target_sys_rteEb_field</td>
</tr>
<tr>
<td></td>
<td>Output is the resulting class name.</td>
</tr>
<tr>
<td><strong>Script include function</strong></td>
<td>sn_cmdb_int_util.CmdbIntegrationClassUtil().deriveClassNameFromOsName(os_in, class_in)</td>
</tr>
</tbody>
</table>

Does not return a value of a class which is higher in the class hierarchy (a parent class) than the provided input class. For example, does not return cmdb_ci_computer if the input is cmdb_ci_server. Looks only at the cmdb_ci_computer hierarchy, going through cmdb_ci_server (cmdb_ci_computer, cmdb_ci_server, children of cmdb_ci_server).

Currently looks for Server, Windows Server, and Linux Server indicators in the operating system name.
### Examples:

<table>
<thead>
<tr>
<th>Model</th>
<th>Class</th>
<th>Class Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>window server</td>
<td>cmdb_ci_computer</td>
<td>cmdb_ci_win_server</td>
</tr>
<tr>
<td>Microsoft server</td>
<td>cmdb_ci_computer</td>
<td>cmdb_ci_win_server</td>
</tr>
<tr>
<td>linux server</td>
<td>cmdb_ci_computer</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Microsoft server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_win_server</td>
</tr>
<tr>
<td>linux server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Red hat server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Arch server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Centos server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Debian server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Fedora server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Suse server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Oracle server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Rhel server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Ubuntu server</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_linux_server</td>
</tr>
<tr>
<td>Junk</td>
<td>cmdb_ci_server</td>
<td>cmdb_ci_server</td>
</tr>
<tr>
<td>Junk server</td>
<td>cmdb_ci_computer</td>
<td>cmdb_ci_server</td>
</tr>
<tr>
<td>Junk</td>
<td>cmdb_ci_computer</td>
<td>cmdb_ci_computer</td>
</tr>
</tbody>
</table>

### Derive Virtual From Hardware Model

Use when processing a computer record that may be virtual, a hardware model is provided, and the virtual status is ambiguous. Can be used along with other Derive Virtual From transforms.

<table>
<thead>
<tr>
<th>Details</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>sn_cmdb_int_util_derive_virtual_from_model_operation</td>
</tr>
<tr>
<td>Input fields</td>
<td>source_sys_rte_eb_fields</td>
</tr>
<tr>
<td>Input in order is:</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Details

1. The hardware model name
2. The current virtual flag value

<table>
<thead>
<tr>
<th>Output field</th>
<th>target_sys_rte_eb_field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output</td>
<td>is the resulting virtual flag (true/false). If the current virtual flag is ‘true’, the result is true. Otherwise the result is ‘true’ or ‘false’.</td>
</tr>
</tbody>
</table>

| Script include function | sn_cmdb_int_util.CmdbIntegrationVirtualDetectionUtil().detectVirtualFromModelName(model_in, is_virtual_in) |

Looks for indicators in the model name for a virtual device (VMware).

#### Examples:

<table>
<thead>
<tr>
<th>Model Name</th>
<th>Virtual Flag</th>
<th>Virtual Flag Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>thinkpad</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td>thinkpad</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>thinkpad</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>vmware inc</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td></td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td></td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td></td>
<td>false</td>
<td>false</td>
</tr>
</tbody>
</table>

### Derive Virtual From Native Indicator

Use when processing a computer record that may be virtual, a virtual indicator is provided by the source, and the virtual status is ambiguous. Can be used along with other Derive Virtual From transforms.

<table>
<thead>
<tr>
<th>Details</th>
<th>sn_cmdb_int_util.derive_virtual_from_native_value_operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>sn_cmdb_int_util.derive_virtual_from_native_value_operation</td>
</tr>
<tr>
<td>Input fields</td>
<td>source_sys_rte_eb_fields</td>
</tr>
<tr>
<td></td>
<td>Input in order is:</td>
</tr>
</tbody>
</table>
1. The native indicator
2. The current virtual flag value

Output field: `target_sys_rte_eb_field`
Output is the resulting virtual flag (true/false). If the current virtual flag is ‘true’, the result is true. Otherwise the result is ‘true’ or ‘false’.

Script include function: `sn_cmdb_int_util.CmdIntegrationVirtualDetectionUtil().detectVirtualFromNativeIdentifier(native_in, is_virtual_in)`

Tests native indicator against a list of common values and looks for a ‘true’ boolean indicator.

<table>
<thead>
<tr>
<th>Native Virtual Value</th>
<th>Virtual Flag</th>
<th>Virtual Flag Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>virtual</td>
<td>false</td>
<td>true</td>
</tr>
<tr>
<td>virtual</td>
<td></td>
<td>true</td>
</tr>
<tr>
<td>virtual</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td>y</td>
<td>false</td>
<td>true</td>
</tr>
<tr>
<td>y</td>
<td></td>
<td>true</td>
</tr>
<tr>
<td>y</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td>yes</td>
<td>false</td>
<td>true</td>
</tr>
<tr>
<td>yes</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td>yes</td>
<td></td>
<td>true</td>
</tr>
<tr>
<td>true</td>
<td>false</td>
<td>true</td>
</tr>
<tr>
<td>true</td>
<td></td>
<td>true</td>
</tr>
<tr>
<td>true</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td>t</td>
<td>false</td>
<td>true</td>
</tr>
<tr>
<td>t</td>
<td></td>
<td>true</td>
</tr>
<tr>
<td>t</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td>other</td>
<td>false</td>
<td>false</td>
</tr>
</tbody>
</table>
Examples: (continued)

<table>
<thead>
<tr>
<th>Native Virtual Value</th>
<th>Virtual Flag</th>
<th>Virtual Flag Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>other</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>other</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td>not virtual</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>not virtual</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>not virtual</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td>not virtual</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>not virtual</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td>other</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>other</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td>not virtual</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>not virtual</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>not virtual</td>
<td>true</td>
<td>true</td>
</tr>
</tbody>
</table>

**Derive Virtual From Serial Number**

Use when processing a computer record that may be virtual, a serial number is provided by the source, and the virtual status is ambiguous. Can be used along with other Derive Virtual From transforms.

<table>
<thead>
<tr>
<th>Details</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>sn_cmdb_int_util_derive_virtual_from_serial_number_operation</td>
</tr>
<tr>
<td>Input fields</td>
<td>source_sys_rteEb_fields</td>
</tr>
<tr>
<td></td>
<td>Input in order is:</td>
</tr>
<tr>
<td></td>
<td>1. The serial number</td>
</tr>
<tr>
<td></td>
<td>2. The current virtual flag value</td>
</tr>
<tr>
<td>Output field</td>
<td>target_sys_rteEb_field</td>
</tr>
<tr>
<td></td>
<td>Output is the resulting virtual flag (true/false). If the current virtual flag is ‘true’, the result is true. Otherwise the result is ‘true’ or ‘false’.</td>
</tr>
<tr>
<td>Script include function</td>
<td>sn_cmdb_int_util.CmdbIntegrationVirtualDetectionUtil().detectVirtualFromSerialNumber(serial_in, is_virtual_in)</td>
</tr>
</tbody>
</table>

Looks for indicators in the serial number for a virtual device (VMware).
### Examples:

<table>
<thead>
<tr>
<th>Serial Number</th>
<th>Virtual Flag</th>
<th>Virtual Flag Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>123</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td>123</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>123</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>vmware-123</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td></td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td></td>
<td>false</td>
<td>false</td>
</tr>
</tbody>
</table>

### Extract and Scale by Units

Use when the source has numerical values that need to be scaled and numerical value with an input such as 2048Mb. The source does not always provide the units so it may be required to calculate or guess the units being provided. The target units depend on the target field in the CMDB. If not specified, the decimal units field is set at 2 by default.

<table>
<thead>
<tr>
<th>Details</th>
<th>sn_cmdb_int_util_extract_and_scale_by_units_operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>sn_cmdb_int_util_extract_and_scale_by_units_operation</td>
</tr>
<tr>
<td>Input fields</td>
<td>source_sys_rte Eb Fields</td>
</tr>
<tr>
<td>Output field</td>
<td>target_sys_rte Eb Field</td>
</tr>
<tr>
<td>Script include function</td>
<td>sn_cmdb_int_util.CmdbIntegrationExtractScaleUtilUtil().extractAndScaleUnits</td>
</tr>
</tbody>
</table>

### Examples:

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Default Unit</th>
<th>Output Unit</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>2048Mb</td>
<td>Mb</td>
<td>GB</td>
<td>2GB</td>
</tr>
<tr>
<td>17179869184</td>
<td>B</td>
<td>GB</td>
<td>16GB</td>
</tr>
</tbody>
</table>
First Non Null Value

Use when you have a list of fields providing similar information that must map to a single field and you want to rank the order in which they can provide those values.

For example: Internally in SolarWinds, there is a hierarchy of tables that are join. In one example, a computer’s name could come from the child most table or any of that tables parents but each of those is a separate field in the pull. Starting with the most specific table, the values are searched for the first instance of a name value.

<table>
<thead>
<tr>
<th>Details</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>sn_cmdb_int_util_first_non_null_operation</td>
</tr>
<tr>
<td>Input fields</td>
<td>source_sys_rte_eb_fields</td>
</tr>
<tr>
<td></td>
<td>Input is a list of fields of any length.</td>
</tr>
<tr>
<td>Output field</td>
<td>target_sys_rte_eb_field</td>
</tr>
<tr>
<td></td>
<td>Output is the value from the first field in the list that doesn’t have a null (or empty) value.</td>
</tr>
<tr>
<td>Script include</td>
<td>function</td>
</tr>
<tr>
<td></td>
<td>sn_cmdb_int_util.CmdbIntegrationFirstNonNullValueUtil().firstNonNullValue(batch[i])</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>Field 1</th>
<th>Field 2</th>
<th>Field 3</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>foo</td>
<td></td>
<td></td>
<td>foo</td>
</tr>
</tbody>
</table>

Process Name, Domain, FQDN, DNS set

Use when the source provides name, domain, FQDN, or DNS information. Can be used for only a subset of these (if for example, the source only provides name and domain). In the case that a source only provides fields that are lower in the input list (FQDN) the CmdbIntegrationHardwareNameUtil script include can be called from a script operation to minimize having to create empty dummy fields.

<table>
<thead>
<tr>
<th>Details</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>sn_cmdb_int_util_process_name_set_operation</td>
</tr>
<tr>
<td>Input fields</td>
<td>source_sys_rte_eb_fields</td>
</tr>
</tbody>
</table>
### Details

Takes up to four Input fieldss (any additional fields are ignored), in the following order:

1. Name
2. Domain
3. FQDN
4. DNS

You don’t have to provide all four input values, but you must provide those values in the specified order. If for example, you only want to cleanse domain, you must provide a name attribute, even if empty.

<table>
<thead>
<tr>
<th>Output field</th>
<th>target_sys_rte_eb_field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output is a concatenated set of values in the same order, using a triple pipe (</td>
<td></td>
</tr>
</tbody>
</table>

### Script include function

```python
sn_cmdb_int_util.CmdbIntegrationHardwareNameUtil().processNameDomainFqdnDnsSet(name, domain, fqdn, dns)
```

FQDN and DNS are first processed to see if their formats are correct. FQDN has an additional discovery regex it must pass (via properties):

- `glide.discovery.fqdn.regex` - default: `^([^.]\.)\.([^.]\.)+$`

Possible name and domain values are extracted if possible. When name and domain are processed, if there is no FQDN, a value is generated if possible. A resulting name value is also modified using the following discovery flags:

1. `glide.discovery.hostname.case` – default: No change. Can be set to ‘Lower case’, ‘Upper case’, ‘No change’
2. `glide.discovery.hostname.include_domain` – default: false. If ‘true’ the domain is added to the final name value

### Examples:

<table>
<thead>
<tr>
<th>Name</th>
<th>Domain</th>
<th>FQDN</th>
<th>DNS</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>myName</td>
<td>other.net</td>
<td>otherName.other</td>
<td>mycomp.servicenow.com</td>
<td>myName</td>
</tr>
</tbody>
</table>
Examples: (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Domain</th>
<th>FQDN</th>
<th>DNS</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>na</td>
<td>other.net</td>
<td>otherName.other.net</td>
<td></td>
<td>mycomp.servicenow.com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>servicenow.com</td>
<td></td>
<td>name.servicenow.com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>name.servicenow.com</td>
<td></td>
<td>name.servicenow.com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>name.servicenow.com</td>
<td></td>
<td>name.servicenow.com</td>
</tr>
<tr>
<td>name</td>
<td>servicenow.com</td>
<td></td>
<td></td>
<td>name.servicenow.com</td>
</tr>
</tbody>
</table>

**Process FQDN**

Use when the source provides a suspected FQDN value but no other naming fields such as name, domain, or DNS.

<table>
<thead>
<tr>
<th>Details</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>sn_cmdb_int_util_process_fqdn_operation</td>
</tr>
<tr>
<td>Input fields</td>
<td>source_sys_rte_eb_field&lt;br&gt;Input is a single field containing an FQDN.</td>
</tr>
</tbody>
</table>
| Output field  | target_sys_rte_eb_field<br>Output is a concatenated set of values in the same order using a triple pipe (|||): {name} || {domain} || {fqdn} || {dns}
The processing follows the same logic as the ‘Process Name, Domain, FQDN, DNS set’ transform except that only FQDN is used as an input.

Example:

<table>
<thead>
<tr>
<th>Input</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>mycomputer.servicenow.com</td>
<td>mycomputer</td>
</tr>
</tbody>
</table>

**Scale Units**

Use when the source has numerical inputs that must be scaled. The source does not always provide the current units so it may be required to calculate or guess the units being provided. The target units depend on the field being targeted in the CMDB.

<table>
<thead>
<tr>
<th>Details</th>
<th>sn_cmdb_int_util_scale_unit_operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>sn_cmdb_int_util_scale_unit_operation</td>
</tr>
<tr>
<td>Input fields</td>
<td>source_sys_rte_eb_fields</td>
</tr>
<tr>
<td></td>
<td>Inputs in order are:</td>
</tr>
<tr>
<td></td>
<td>1. The input value</td>
</tr>
<tr>
<td></td>
<td>2. The current units</td>
</tr>
<tr>
<td></td>
<td>3. The target units</td>
</tr>
<tr>
<td>Output field</td>
<td>target_sys_rte_eb_field</td>
</tr>
<tr>
<td></td>
<td>Output is the input value scaled from the current units to the target units. If no units are found for the current units, then the input value is returned. If no current or target units are found the input is returned as the output.</td>
</tr>
<tr>
<td>Script include function</td>
<td>sn_cmdb_int_util_CmdbIntegrationScaleUnitUtil().scaleUnits(input_value, input_unit, output_unit)</td>
</tr>
</tbody>
</table>
Quick start tests for Integration Commons for CMDB

Validate that integrations for CMDB pass validation still works after you make any configuration changes such as applying an upgrade or developing an application. Copy and customize these quick start tests to pass when using your instance-specific data.

⚠️ **DANGER:** By default, the system property that is used to run automated tests is disabled to prevent you from accidentally running these tests on a production system. To avoid data corruption or an outage, run tests only on development, test, and other non-production instances. See Enable or disable executing Automated Test Framework tests.

Integration Commons for CMDB

**CMDB INT: CMDB Integrations Validation test suite**

*Test suite to verify the integrity of an integration using multiple tests.*

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB INT: Set Test Session Application</td>
<td>Modify the run server-side script to set an application name so that you can test only one integration. Otherwise, all integrations installed will be tested.</td>
<td>Paris</td>
</tr>
<tr>
<td>CMDB INT: Test Against Source Analysis</td>
<td>Test an integration against the values in the CMDB Integration Source Analysis [sn_cmdb_int_util_cmdb_integration_source_analysis] table.</td>
<td>Paris</td>
</tr>
</tbody>
</table>
CMDB INT: CMDB Integrations Validation test suite

*Test suite to verify the integrity of an integration using multiple tests.*

(continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB INT: Validate Application Feed</td>
<td>Validate all application feeds in an integration.</td>
<td>Paris</td>
</tr>
<tr>
<td>CMDB INT: Validate Discovery Source</td>
<td>Validate that the discovery source exists.</td>
<td>Paris</td>
</tr>
<tr>
<td>CMDB INT: Validate Entity Mappings</td>
<td>Validate all entity mappings of an integration.</td>
<td>Paris</td>
</tr>
<tr>
<td>CMDB INT: Validate Fields</td>
<td>Validate fields for CMDB Integrations.</td>
<td>Paris</td>
</tr>
<tr>
<td>CMDB INT: Validate Lookups</td>
<td>Validate CMDB integration lookups.</td>
<td>Paris</td>
</tr>
<tr>
<td>CMDB INT: Validate Mandatory Operations</td>
<td>Validate that all integrations for mandatory operations exist for mapped fields.</td>
<td>Paris</td>
</tr>
<tr>
<td>CMDB INT: Validate Operations</td>
<td>Validate all operations for an integration.</td>
<td>Paris</td>
</tr>
<tr>
<td>CMDB INT: Validate References</td>
<td>Validate CMDB integration references.</td>
<td>Paris</td>
</tr>
<tr>
<td>CMDB INT: Validate Related Entries</td>
<td>Validate all related classes against the data dictionary for related entries.</td>
<td>Paris</td>
</tr>
<tr>
<td>CMDB INT: Validate Relationships</td>
<td>Validate CMDB integration relationships.</td>
<td>Paris</td>
</tr>
</tbody>
</table>

To learn more about Integration Commons for CMDB, see [Integration Commons for CMDB](#).

**Related information**

Quick start tests
Service Graph connector for ExtraHop (2.0.3)

Use the Service Graph connector for ExtraHop to pull data from the ExtraHop application into your ServiceNow instance.

The Service Graph connector for ExtraHop provides real-time network visibility across your enterprise by implementing stream processing, so that you can transform your network data into structured wire data.

The Service Graph connector for ExtraHop pulls network visibility data into the ServiceNow® Configuration Management Database (CMDB) application. The connector enriches discovered device data and establishes relationships between devices based on network traffic flow.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

System requirements and supported versions

Dependencies and requirements:

- MID Server that is installed on Linux or Windows, unless the ExtraHop appliance is publicly accessible.
- ExtraHop Discover appliance with firmware version 7.2 or later with a user account that has unlimited privileges.

Supported versions: ExtraHop v7.9

Supported ServiceNow versions:

- Starting with Orlando Patch 7.
- Starting with Paris Patch 1.
- Starting with Quebec.

Use cases

The following are examples on how you can use the Service Graph connector:

- Identification of network interactions between CIs.
- Discovery of network traffic flow data between computers or other types of hardware.
- Creation of relationships between devices. The relationships are based on network traffic flow.
Guided setup
The guided setup for the Service Graph connector for ExtraHop provides an organized sequence of tasks to configure the integration on your instance. To access the guided setup, see Configure Service Graph connector for ExtraHop.

CMDB Integrations Dashboard
The Integration Commons for the CMDB store app provides a dashboard with a central view of the status, processing results, and processing errors of all installed Service Graph connectors. You can see metrics for all integration runs. You can also filter the view to a specific CMDB integration, a specific time duration, or a specific integration run. For more details about monitoring ExtraHop integrations in the CMDB Integrations Dashboard, see CMDB Integrations Dashboard.

Data mappings
Data from data sources in the ExtraHop application is mapped and transformed into the ServiceNow CMDB Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is inserted into the ServiceNow CMDB using the Identification and Reconciliation Engine (IRE).

When you complete the guided setup, you can configure the integration to periodically pull data from the ExtraHop application. The data is loaded into the following staging tables:

- ExtraHop Computer [sn_extrahop_integr_computer]
- ExtraHop Network Activity [sn_extrahop_integr_activity]

The data is then inserted into the following target tables:

- CI Relationship [cmdb_rel_ci]
- Hardware [cmdb_ci_hardware]
- IP Address [cmdb_ci_ip_address]
- Network Adapter [cmdb_ci_network_adapter]

Configure Service Graph connector for ExtraHop
Set up a REST message and scheduled jobs to import ExtraHop data into your CMDB.

Before you begin
To use this Service Graph connector, you need a subscription to a Subscription Unit that is based in the ServiceNow® IT Operations Management (ITOM) Visibility application or in the ITOM Discovery application. As defined in the section titled "Managed IT Resource Types" in ServiceNow Subscription Unit Overview,
for managed IT resources that are created or modified in the CMDB by this Service Graph connector, but that are not yet managed by ITOM Visibility or ITOM Discovery, these resources will increase Subscription Unit consumption from that application. Review your current Subscription Unit consumption within ITOM Visibility or ITOM Discovery to ensure available capacity.

Dependencies and requirements:

- The Integration Commons for CMDB store app, which is automatically installed.
- The CMDB CI Class Models store app, which is automatically installed.
- ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery.
- ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this plugin.
- MID Server that is installed on Linux or Windows, unless the ExtraHop appliance is publicly accessible.
- ExtraHop Discover appliance with firmware version 7.2 or later, with a user account that has unlimited privileges.
- To connect to the ExtraHop application, configure an API key. For more information, see ExtraHop REST API Guide, specifically, see the "ExtraHop API requirements" section.

Roles required: admin

Procedure

1. Navigate to Service Graph Connector ExtraHop > Setup.
2. On the Getting started page, click Get Started.
3. On the Service Graph connector for the ExtraHop page, in the Configure REST message section, select the task Configure ExtraHop REST message.
4. To configure a REST message to use when sending requests to the ExtraHop API, complete the following steps:

   a. On the next page, in the Configure ExtraHop REST message task section, click Configure.

   b. On the form, fill in the fields.
### REST Message form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name for this REST Message. This field is automatically set.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>URL to the web service API endpoint. Set the field to a base URL. For example, <a href="https://myextrahop.com">https://myextrahop.com</a>.</td>
</tr>
<tr>
<td><strong>Note:</strong> Updating the Endpoint base URL also updates the base URLs for all HTTP methods that are associated with the ExtraHop REST message. In the HTTP Request tab, update the Authorization header to use your API key in the Value field.</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Description for this REST Message. This field is automatically set.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that contains this message. The field is automatically set.</td>
</tr>
<tr>
<td>Authentication type</td>
<td>Type of authentication to apply to HTTP requests. The field is automatically set.</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use multiple authentication by authenticating HTTP requests. Mutual authentication cannot be used with a MID Server.</td>
</tr>
</tbody>
</table>

c. Click **Update** if necessary.

d. In the Configure ExtraHop REST message task section, click **Mark as Complete**.

5. To test the connection to the ExtraHop Computer API, complete the following steps:
a. In the Test Computer connection task section, click **Configure**.

b. On the form, fill in the fields.

### HTTP Method form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique identifier for this HTTP method. This field is automatically set.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>URL to the web service API endpoint</td>
</tr>
<tr>
<td>Use MID Server</td>
<td>MID Server that sends this HTTP request. Using a MID Server is not compatible with mutual authentication.</td>
</tr>
<tr>
<td>REST Message</td>
<td>REST message record that this method is based on. This field is automatically set.</td>
</tr>
<tr>
<td>HTTP method</td>
<td>HTTP method that is implemented by this method. This field is automatically set.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that contains this method. This field is automatically set.</td>
</tr>
<tr>
<td>Authentication type</td>
<td>Type of authentication to apply to HTTP requests.</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use multiple authentication by authenticating HTTP requests. Mutual authentication cannot be used with a MID Server.</td>
</tr>
</tbody>
</table>

c. Select the **HTTP Request** tab and fill out the **Use MID Server** field.

d. Click the **Authentication** tab and then click the **Test** related link.
   Testing the connection takes a few moments. When the test is complete, the page is refreshed and shows the test results.
e. Select **Mark as Complete**.

   **Note:** The connection is successful if the **HTTP Status** field is set to **200**. If there are any errors in the **Error Message** field, then the connection failed and further troubleshooting is required.

f. Click **Update** if necessary.

g. In the Test Computer connection task section, click **Mark as Complete**.

6. To test the connection to the ExtraHop Network Activity Create API, complete the following steps:

a. In the Test Network Activity Create connection task section, click **Configure**.

b. On the form, fill in the fields.

**HTTP Method form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique identifier for this HTTP method.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>URL to the web service API endpoint</td>
</tr>
<tr>
<td>Use MID Server</td>
<td>MID Server that sends this HTTP request. Using a MID Server is not compatible with mutual authentication.</td>
</tr>
<tr>
<td>REST Message</td>
<td>REST message that this method is based on. This field is automatically set.</td>
</tr>
<tr>
<td>HTTP method</td>
<td>HTTP method that is implemented by this method. This field is automatically set.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that contains this record. This field is automatically set.</td>
</tr>
<tr>
<td>Authentication type</td>
<td>Type of authentication to apply to HTTP requests. This field is automatically set.</td>
</tr>
</tbody>
</table>
Use mutual authentication | Option to use multiple authentication by authenticating HTTP requests. Mutual authentication cannot be used with a MID Server.

c. Click the **Authentication** tab and then click the **Test** related link. Testing the connection takes a few moments. When the test is complete, the page is refreshed and shows the test results.

d. **Select Mark as Complete.**

   - **Note:** The connection is successful if the **HTTP Status** field is set to **200**. If there are any errors in the **Error Message** field, then the connection failed and further troubleshooting is required.

e. **Click Update if necessary.**

f. In the Test Network Activity Create connection task section, click **Mark as Complete**.

7. **On the left sidebar, click the **Set up scheduled import jobs** button.**

8. **On the Service Graph Connector for ExtraHop page, in the Set up scheduled import jobs section, select the task **Configure Computer scheduled job**.**

   a. In the Configure Computer scheduled job task section, click **Configure**.

   b. On the form, fill in the fields.

### Scheduled Data Import form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the scheduled job.</td>
</tr>
<tr>
<td>Data source</td>
<td>Data source record that defines the data to import.</td>
</tr>
<tr>
<td>Run as</td>
<td>Option to run the scheduled job with the credentials of the specified user.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the scheduled job. Select this option.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Concurrent Import</td>
<td>Function that loads the data from multiple import sets. The function then processes and transforms the data concurrently.</td>
</tr>
<tr>
<td>Partition Method</td>
<td>Partition method for the concurrent import set.</td>
</tr>
<tr>
<td>Partition Size</td>
<td>Import set size for early scheduling.</td>
</tr>
<tr>
<td>Execute pre-import script</td>
<td>Option to specify a script to run before the import is performed.</td>
</tr>
<tr>
<td>Execute post-import script</td>
<td>Option to specify a script to run after the import is performed.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that contains this scheduled job.</td>
</tr>
<tr>
<td>Run</td>
<td>Frequency of running the import.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Conditions under which this job is executed.</td>
</tr>
</tbody>
</table>

**c. Click Update if necessary.**

**d. In the Configure Computer scheduled job task section, click Mark as Complete.**

9. On the Service Graph Connector for ExtraHop page, in the Set up scheduled import jobs section, select the task **Configure Network Activity scheduled job**.

**a. In the Configure Network Activity scheduled job task section, click Configure.**

**b. On the form, fill in the fields.**

**Scheduled Data Import form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the scheduled job.</td>
</tr>
<tr>
<td>Data source</td>
<td>Data source record that defines the data to import.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Run as</td>
<td>Option to run the scheduled job with the credentials of the specified user.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the scheduled job. Select this option.</td>
</tr>
<tr>
<td>Concurrent Import</td>
<td>Function that loads the data from multiple import sets. The function then processes and transforms the data concurrently.</td>
</tr>
<tr>
<td>Partition Method</td>
<td>Partition method for the concurrent import set.</td>
</tr>
<tr>
<td>Partition Size</td>
<td>Import set size for early scheduling.</td>
</tr>
<tr>
<td>Execute pre-import script</td>
<td>Option to specify a script to run before the import is performed.</td>
</tr>
<tr>
<td>Execute post-import script</td>
<td>Option to specify a script to run after the import is performed.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that contains this scheduled job.</td>
</tr>
<tr>
<td>Run</td>
<td>Frequency of running the import.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Conditions under which this job is executed.</td>
</tr>
</tbody>
</table>

c. Click **Update** if necessary.

d. In the Configure Network Activity scheduled job task section, click **Mark as Complete**.

**Service Graph connector for Microsoft Intune (2.0.0)**

Use the Service Graph connector for Microsoft Intune to pull data from the Microsoft Intune application into your ServiceNow instance.

The Service Graph connector for Microsoft Intune pulls data from mobile devices and software applications into the ServiceNow® Configuration Management Database (CMDB) application. The integration provides greater visibility into mobile devices, computers and related software applications that run on them.
Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Supported versions
Supported versions: Microsoft Intune Graph API v1.0
Supported ServiceNow versions:
• Starting with Orlando Patch 7.
• Starting with Paris Patch 1.
• Starting with Quebec.

Use Cases
The following are examples on how you can use the Service Graph connector for different ServiceNow® applications:

• IT Operations Management (ITOM) Visibility
  ◦ Detailed hardware and application inventory for Android, Apple, and Windows mobile devices. The inventory can be used with or without Software Asset Management (SAM).
  ◦ Compliance tracking for mobile devices. You can build your own device (BYOD) or use corporate-owned devices.

• IT Service Management (ITSM)
  ◦ Incidents, problems, and changes on discovered configuration items (CI).
  ◦ Ownership tracking and assignment for mobile devices.

You can also do the following types of administrative actions:
• Device Management: You can locate, wipe, or retire a device. You can report on various aspects of the device.
• Integration with Azure Monitor: Delta notification.

Guided Setup
The guided setup for the Service Graph connector for Microsoft Intune provides an organized sequence of tasks to configure the integration on your instance. To access the guided setup, see Configure Service Graph connector for Microsoft Intune.
CMDB Integration Dashboards

The Integration Commons for CMDB store app provides a dashboard with a central view of the status, processing results, and processing errors of all installed integrations. You can see metrics for all integration runs. You can filter the view to a specific CMDB integration, a specific time duration, or a specific integration run. For more details about monitoring Microsoft Intune integrations in the CMDB Integrations Dashboard, see CMDB Integrations Dashboard.

Data Mappings

Data from data sources in the Microsoft Intune application is mapped and transformed into the ServiceNow CMDB Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is inserted into the ServiceNow CMDB using the Identification and Reconciliation Engine (IRE).

When you complete the guided setup, you can configure the integration to periodically pull data from the Microsoft Intune application. The data is loaded into the following staging tables:

- SG-Intune Computer [sn_intune_integrat_computer]
- SG-Intune Devices [sn_intune_integrat_devices]
- SG-Intune Software [sn_intune_integrat_software]

The data is then inserted into the following target tables:

- Computer [cmdb_ci_computer]
- Hardware [cmdb_ci_handheld_computing]
- Network Adapter [cmdb_ci_network_adapter]
- Serial Number [cmdb_serial number]
- Software [cmdb_ci_spkg]
- Software Installation [cmdb_sam_sw_install]
- Software Instance [cmdb_software_instance]

⚠️ Note: To view any additional information about a handheld device or computer, you can add the SG-Intune Device Related and SG-Intune Computer Related related lists by configuring the Related lists view.

Configure Service Graph connector for Microsoft Intune

Set up authentication credentials and a scheduled job to import Microsoft Intune data into your CMDB.
Before you begin
To use this Service Graph connector, you need a subscription to a Subscription Unit that is based in the IT Operations Management (ITOM) Visibility application or in the ITOM Discovery application. As defined in the section titled “Managed IT Resource Types” in ServiceNow Subscription Unit Overview, for managed IT resources that are created or modified in the CMDB by this Service Graph connector, but that are not yet managed by ITOM Visibility or ITOM Discovery, these resources will increase Subscription Unit consumption from that application. Review your current Subscription Unit consumption within ITOM Visibility or ITOM Discovery to ensure available capacity.

Before you start the configuration, ensure that the Microsoft Intune administrator is registered with the DeviceManagementManagedDevices.Read.All. permission. For more information about how to register the Microsoft Intune application, see the How to use Azure AD to access the Intune APIs in Microsoft Graph article on the Microsoft documentation site.

Dependencies and requirements:
• The Integration Commons for CMDB store app, which is automatically installed.
• The CMDB CI Class Models store app store app, which is automatically installed.
• Datastream Action plugin (com.glide.hub.action_type.datastream), which is automatically installed.
• ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this plugin.
• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery.

Role required: admin

Procedure
1. Navigate to Service Graph Connector for Microsoft Intune > Setup.
2. On the Getting Started page, select Get started.
3. On the Service Graph connector for Microsoft Intune page, in the Configure the connection section, select the task Configure credentials.
4. To configure your credentials, complete the following steps:
   a. On the next page, in the Configure credentials task section, click Configure.
   b. On the form, fill in the fields.
### Application Registries form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>The client id of the OAuth app.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>The client secret of the OAuth app.</td>
</tr>
<tr>
<td>Token URL</td>
<td>OAuth token end-point to retrieve access and refresh tokens.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Update the <code>tenantId</code> in the URL.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the OAuth app. This field is automatically set.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>The script used to customize request and response to external OAuth provider.</td>
</tr>
<tr>
<td>Logo URL</td>
<td>Optional OAuth app logo URL.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>The Default Grant Type used to establish the OAuth token.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>The number of seconds a refresh token issued will be good for. This field is automatically set.</td>
</tr>
<tr>
<td>PKCE required</td>
<td>Option to enable for Public Clients to require PKCE during the authorization flow.</td>
</tr>
<tr>
<td>Application</td>
<td>Application containing this record. This field is automatically set.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Where the OAuth is accessible from. This field is automatically set.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the OAuth app. Select this option.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>OAuth authorization code end-point.</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>OAuth access token revocation end-point.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>The OAuth’s app end-point to receive authorization code.</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use mutual authentication for token request and revocation. Requires Mutual Auth Profile to be specified.</td>
</tr>
<tr>
<td>Send Credentials</td>
<td>OAuth Client will populate client credentials in the request per the choice selected. This field is automatically set.</td>
</tr>
<tr>
<td>Comments</td>
<td>Comments about the OAuth app.</td>
</tr>
</tbody>
</table>

c. Click **Update** if necessary,

d. In the Configure credentials task section, click **Mark as Complete**

5. In the Configure MID Server section, select **Configure** and complete the following steps:

   a. Select the **Use MID server** check box.
   
   b. Click **Update** to save the record.

   ! **Note:** You do not need to update the other fields.

6. To test the connection to the Intune API, complete the following steps:

   a. In the Test the connection section, select **Configure**.
   
   b. On the form, review the fields.

---

**Data Source form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for this data source.</td>
</tr>
<tr>
<td>Import set table label</td>
<td>Label of the table that will be created for this data source.</td>
</tr>
<tr>
<td>Import set table name</td>
<td>Name of the table that will be created for this data source.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data in single column</td>
<td>Option to set to data in single column.</td>
</tr>
<tr>
<td>Type</td>
<td>Data storage type of the data to be imported.</td>
</tr>
<tr>
<td>Application</td>
<td>Application containing this record.</td>
</tr>
</tbody>
</table>

c. Click the **Test Load 20 Records** related link to start the process. Testing the connection takes a few moments, after which the page refreshes to show the test results.

**Note:** The connection is successful if the **HTTP Status** is **200**. If there is an **Error Code** and **Error Message**, the connection failed and further troubleshooting is required.

**Note:** Do not click **Load All Records** during this step.

d. In the Test the connection task section, click **Mark as Complete**.

7. On the left sidebar, click the **Set up scheduled import jobs** button.

8. On the Service Graph Connector for Microsoft Intune page, in the Set up scheduled import jobs section, select the task **Configure the scheduled job**.

a. In the Configure the scheduled import jobs task section, click **Configure**.

b. On the form, fill in the fields.

### Scheduled Data Import form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the scheduled job.</td>
</tr>
<tr>
<td>Data source</td>
<td>Data source record that defines the data to import.</td>
</tr>
<tr>
<td>Run as</td>
<td>Option to run the scheduled job with the credentials of the specified user.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the scheduled job. Select this option.</td>
</tr>
<tr>
<td>Concurrent Import</td>
<td>Function that loads the data from multiple import sets. The function</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>then processes and transforms the data concurrently.</td>
<td></td>
</tr>
<tr>
<td>Partition Method</td>
<td>Partition method for the concurrent import set.</td>
</tr>
<tr>
<td>Partition Size</td>
<td>Import set size for early scheduling.</td>
</tr>
<tr>
<td>Execute pre-import script</td>
<td>Option to specify a script to run before the import is performed.</td>
</tr>
<tr>
<td>Execute post-import script</td>
<td>Option to specify a script to run after the import is performed.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that contains this scheduled job.</td>
</tr>
<tr>
<td>Run</td>
<td>Frequency of running the import.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Conditions under which this job is executed.</td>
</tr>
</tbody>
</table>

c. Click **Execute Now**.

d. In the Configure the scheduled job task section, click **Mark as Complete**.

**Service Graph connector for Jamf (2.5.0)**

Use the Service Graph connector for Jamf to pull data from Jamf into your ServiceNow instance.

The Service Graph connector for Jamf pulls data from computers, disks, networks, and software into the ServiceNow® Configuration Management Database (CMDB) application.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**Supported versions**

Supported versions: Jamf API v2.1.0 and Jamf Pro API 10.28.0

Supported ServiceNow versions:
Starting with Orlando Patch 7.
Starting with Paris Patch 1.
Starting with Quebec.

**Use Cases**
The following are examples on how you can use the Service Graph connector for different ServiceNow® applications:

- **IT Operations Management (ITOM) Visibility**
  - Detailed hardware and software inventory tracking for Mac hardware and apps. The tracking can be done with or without Software Asset Management (SAM).
  - Detailed hardware and software inventory tracking for hardware and apps for both iPhones and iPads. The tracking can be done with or without Software Asset Management (SAM).
  - Compliance tracking for mobile devices and end-user computers.
  - Duplicate data detection on imports to improve performance of nightly imports.

- **Software Asset Management (SAM) and IT Asset Management (ITAM)**
  - Software package and installation tracking.
  - License reclamation by detecting removed software.
  - Software Usage tracking.

- **IT Service Management (ITSM)**
  - Incidents, problems, and changes on discovered configuration items (CI).
  - Automatic ownership assignment based on top users.

**Guided Setup**
The guided setup for the Service Graph connector for Jamf provides an organized sequence of tasks to configure the integration on your instance. To access the guided setup, see [Configure Service Graph connector for Jamf](#).

**CMDB Integrations Dashboard**
The Integration Commons for the CMDB store app provides a dashboard with a central view of the status, processing results, and processing errors of all installed integrations. You can see metrics for all integration runs. You can filter the view to a specific CMDB integration, a specific time duration, or a specific integration run. For more details about monitoring Jamf integrations in the CMDB Integrations Dashboard, see [CMDB Integrations Dashboard](#).
Data mapping

Data from the Jamf data source is mapped and transformed into the ServiceNow CMDB Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is inserted into the ServiceNow CMDB using the Identification and Reconciliation Engine (IRE).

When you complete the guided setup, you can configure the integration to periodically pull data from Jamf. The data is loaded into the following tables:

- Jamf Computer [sn_jamf_integrate_jamf_computers] staging table
- Jamf mobile devices [sn_jamf_integrate_jamf_mobile] table

The data is then inserted into the following target tables:

- CI Relationship [cmdb_rel_ci]
- Computer [cmdb_ci_computer]
- Disk [cmdb_ci_disk]
- Handheld Computing device [cmdb_ci_handheld_computing]
- IP Address [cmdb_ci_ip_address]
- Network Adapter [cmdb_ci_network_adapter]
- Printer [cmdb_ci_printer]
- Serial Number [cmdb_serial_number]
- Software [cmdb_ci_spkg]
- Software Installation [cmdb_sam_sw_install]
- Software Instance [cmdb_software_instance]
- Software Usage [samp_sw_usage]

Configure Service Graph connector for Jamf

Set up authentication credentials and scheduled jobs to import Jamf data into your CMDB.

Before you begin

To use this Service Graph connector, you need a subscription to a Subscription Unit that is based in the IT Operations Management (ITOM) Visibility application or in the ITOM Discovery application. As defined in the section titled "Managed IT Resource Types" in ServiceNow Subscription Unit Overview, for managed IT resources that are created or modified in the CMDB by this Service Graph connector, but that are not yet managed by ITOM Visibility or ITOM Discovery, these resources will increase Subscription Unit consumption from that
application. Review your current Subscription Unit consumption within ITOM Visibility or ITOM Discovery to ensure available capacity.

Dependencies and requirements:

- The Integration Commons for CMDB store app, which is automatically installed.
- The CMDB CI Class Models store app store app, which is automatically installed.
- ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this plugin.
- ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery.
- Jamf Classic API version 10.x.
- To access Jamf data: API user with read-only access to Jamf database.

Roles required: admin

Procedure

1. Navigate to Service Graph Connector for Jamf > Setup.
2. On the Getting Started page, select Get started.
3. (Optional) On the Service Graph Connector for Jamf page, in the Configure the connection section, select the task Enable Jamf proAPI property.
4. To enable the use of Jamf proAPI property, set the proAPI property to true for the computer data source, and complete the following steps:
   a. In the Enable Jamf proAPI property task section, click Configure.
   b. Set the Value field to true.
   c. Click Update.

   Note: When you configure the Jamf HTTP connection, ensure that the Base Path field is empty so that you can set up the endpoint URL for the Jamf proAPI property.
5. In the Configure the connection section, select the task Configure Jamf authentication credentials.
6. To configure your Jamf authentication credentials, complete the following steps:
a. On the next page, in the Configure Jamf authentication credentials task section, click **Configure**.

b. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name of this authentication configuration.</td>
</tr>
<tr>
<td>User name</td>
<td>User name that is used to authenticate the HTTP request when this Basic authentication profile is enabled.</td>
</tr>
<tr>
<td>Password</td>
<td>Password that is used to authenticate the HTTP request when this Basic authentication profile is enabled.</td>
</tr>
</tbody>
</table>

> **Note:** The Jamf user must have a role with read privileges for Computers so that the integration can pull computer data.

> **Note:** The Jamf user must have a role with read privileges for Mobile Devices so that the integration can pull mobile device data.

c. Click **Update** if necessary.

d. In the Configure Jamf authentication credentials, click **Mark as Complete**.

7. In the Configure Jamf HTTP Connection task section, click **Configure** and complete the following steps:

a. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the connection.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to select a MID Server that sends this HTTP connection. Using a MID Server is not compatible with mutual authentication.</td>
</tr>
</tbody>
</table>
| Host                     | Target host value used by the connection. The Connection URL will automatically fill in the hostname.  

⚠️ **Note:** Update the Host field with a Jamf base URL or IP address. For example, demojamfhost.com or 127.0.0.1. |
| Credential               | Credential value used by this connection. |
| Connection alias         | Connection value that is used to refer to the connection. |
| URL builder              | URL builder that is used to build the connection URL. |
| Connection URL           | Connection URL for the connection. You can either manually enter a URL or use the URL builder to build the connection string. |
| Mutual authentication    | Option to set the connection with mutual authentication. |
| Protocol                 | Underlying protocol used by the connection.  

⚠️ **Note:** Update the Protocol field if you are using anything other than https. |
| Active                   | Option to activate the HTTP connection. |
| Domain                   | Domain that contains the connection. |
| Override default port    | Target value port that is used by the connection. |
**Field** | **Description**  
---|---  
Base path | Base path for HTTP(s) connection.  

> **Note:** You do not need to update this field. This field is automatically set to `/JSSResource`. If you are upgrading the Service Graph connector for Jamf and want to use the Jamf proAPI property, you must clear this field.

**b.** Click **Update** if necessary.

**c.** In the Configure Jamf HTTP Connection task section, click **Mark as Complete**.

**8.** To test the connection to the Jamf API, complete the following steps:

**a.** In the Test the connection task section, click **Configure**.

**b.** Review the fields on the form.

---

**Data Source form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of this data source.</td>
</tr>
<tr>
<td>Import set table label</td>
<td>Label of the import set table that this data source will produce.</td>
</tr>
<tr>
<td>Import set table name</td>
<td>Name of the table that will be created for this data source.</td>
</tr>
<tr>
<td>Type</td>
<td>Data storage type of the data to be imported.</td>
</tr>
<tr>
<td>Data in single column</td>
<td>Option to set to data in single column.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that contains this record.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Data Loader | Script that loads data in the import set table.

c. Click the **Test Load 20 Records** related link to test the connection. Testing the connection takes a few moments, after which the page refreshes to show the test results.

**Note:** The connection is successful if the **HTTP Status** is **200**. If there is anything displayed in the **Error Code** and **Error Message** fields, then the connection failed and further troubleshooting is required.

**Note:** Do not click **Load All Records** during this setup.

d. In the Test the connection task section, click **Mark as Complete**.

9. On the left sidebar, click the **Duplicate detection rules** button.

10. On the Service Graph Connector for Jamf page, in the Duplicate detection rules section, select the task **Configure duplicate detection rules**.

   a. In the Configure duplicate detection rules section, click **Configure**.

   b. On the CMDB Duplicate Row Rules form, update the **Active** column value to **true** to activate the duplicate detection rule.

   c. When you're finished, in the Help side bar, select **Mark as Complete**.

11. On the left side bar, click the **Set up scheduled import jobs** button.

12. On the Service Graph Connector for Jamf page, in the Set up scheduled import jobs section, select the task **Configure the scheduled job**.

   a. In the Configure the scheduled job task section, click **Configure**.

   b. Select the name of the scheduled job that you want to activate.

   c. Review the pre-populated fields on the Scheduled Data Import form.

   **Note:** By default, the **SG-Jamf Mobile Devices** scheduled job is automatically set as **Active** and runs SG-Jamf Computer as a parent.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source</td>
<td>Data source record that defines the data to import.</td>
</tr>
<tr>
<td>Run as</td>
<td>Option to run the scheduled job with the credentials of the specified user.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the scheduled job. Select this option.</td>
</tr>
<tr>
<td>Concurrent Import</td>
<td>Function that loads the data from multiple import sets. The function then processes and transforms the data concurrently.</td>
</tr>
<tr>
<td>Partition Method</td>
<td>Partition method for the concurrent import set.</td>
</tr>
<tr>
<td>Partition Size</td>
<td>Import set size for early scheduling.</td>
</tr>
<tr>
<td>Execute pre-import script</td>
<td>Option to specify a script to run before the import is performed.</td>
</tr>
<tr>
<td>Pre-script</td>
<td>Optional processing before import.</td>
</tr>
</tbody>
</table>

**Note:** For the SG-Jamf Remove Software scheduled job, you can import information about deleted software instances or software installs onto your ServiceNow instance. To run the import from the beginning, set the code as:

```javascript
var resetLastRunDateTime = true;
```

<table>
<thead>
<tr>
<th>Execute post-import script</th>
<th>Option to specify a script to run after the import is performed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Application that contains this scheduled job.</td>
</tr>
<tr>
<td>Run</td>
<td>Frequency of running the import.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Conditions under which this job is executed.</td>
</tr>
</tbody>
</table>
d. Click **Execute Now** and repeat the previous steps for the other imports if needed.

e. In the Configure the scheduled job task section, click **Mark as Complete**.

Create multi-instance support for Jamf

If you need to connect multiple instances for Jamf, you can create connection aliases, HTTP connections, and scheduled data imports to pull in data from multiple data servers.

**Before you begin**

Confirm you are in the Service Graph connector for Jamf application scope.

Role required: admin

**Procedure**

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. On the Connection & Credentials Aliases list, select **Jamf_CMDB_Connection**, then the **Child Aliases** tab and **New**, to create a new child alias.
3. On the Connection & Credential Aliases form, enter a name for the alias and click **Submit**.
4. Click the **Connections** tab and select **New**, to create a new connection.
5. On the HTTP(s) Connection form, complete the following steps:

   a. Review the HTTP(s) Connection form and fill in fields as needed.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential used by this connection.</td>
</tr>
</tbody>
</table>

**Note:** Create a new Basic Auth credential by selecting **Get** > **New** > **Basic Auth Credentials**. When you create a new Basic Auth credential, enter a new Jamf user name and password.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL builder</td>
<td>Check box to build a URL. The connection URL will be automatically generated based on the Host and Base path.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Update the <strong>Host</strong> field with a Jamf host name or IP address and the <strong>Base path</strong> field with <code>/JSSResource</code>.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>(Optional) For more information on how to configure a MID Server, see the Configuring a MID Server for the Service Graph Connector for Jamf [KB0853427] KB article on the HI Knowledge Base.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you create more than one instance, it will only use one MID Server.</td>
</tr>
</tbody>
</table>

The URL builder builds a URL in the Connection URL which is based on values in the Host and Base path fields.

---

**Fields that are automatically set on the HTTP(s) Connection form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Option to activate the HTTP connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain to which the connection belongs.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Connection value with which the connection can be referred to.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Use to enter connection URL for the new connection.</td>
</tr>
</tbody>
</table>

b. **Click Submit.**

6. Select the alias you created and right-click the form context menu icon ☰️, then select **Copy sys_id**.

⚠️ **Note:** You will need the system ID for an upcoming step.

7. Navigate to **Service Graph Connector for Jamf > Import Schedules**.
8. Select **New** to create a new import schedule for the new instance.
9. On the Scheduled Data Import form, complete the following steps:

a. **Fill out the Scheduled Data Import form.**

<table>
<thead>
<tr>
<th>Scheduled Data Import</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Name of the scheduled data import.</td>
</tr>
<tr>
<td><strong>Data Source</strong></td>
<td>Data source record that defines the data to import. By default, select <strong>SG-Jamf Computer</strong>.</td>
</tr>
<tr>
<td><strong>Run as</strong></td>
<td>Name of a user whose credentials the import job uses. By default, select <strong>System Administrator</strong>.</td>
</tr>
<tr>
<td><strong>Concurrent Import</strong></td>
<td>Function that loads the data from multiple import sets. The function then processes and transforms the data concurrently.</td>
</tr>
<tr>
<td><strong>Partition Method</strong></td>
<td>Partition method for the concurrent import set.</td>
</tr>
<tr>
<td><strong>Partition Size</strong></td>
<td>Import set size for early scheduling.</td>
</tr>
<tr>
<td><strong>Execute pre-import script</strong></td>
<td>Option to specify script to run before the import is performed.</td>
</tr>
<tr>
<td><strong>Run</strong></td>
<td>Frequency at which you want to run the import.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Conditional</td>
<td>Conditions under which this job is executed.</td>
</tr>
</tbody>
</table>

b. Select the Concurrent Import box to set the Partition Method to **Custom size** and Partition Size to **15,000**.

c. Select the Execute pre-import script box, then paste the sys_id of the new Connection Alias you copied from Step 6 into the following script:

```javascript
var devConnectionAliasSysId = "your_sys_id";

gs.getSession().putClientData("jamf_connection_alias_sys_id", devConnectionAliasSysId);
```

d. In the Run field, select **After Parent Runs** to run the scheduled data imports sequentially then select the parent in the **Parent** field.

**Note:** These scheduled imports shouldn’t run simultaneously since they share the same data source.

e. Click **Submit**.

**What to do next**
Repeat the steps for each additional Jamf instance, as needed.

**Service Graph connector for Microsoft SCCM (2.4.1)**

Use the Service Graph connector for Microsoft System Center Configuration Manager (SCCM) to pull data from SCCM into your ServiceNow instance.

The Service Graph connector for Microsoft SCCM imports SCCM data into the ServiceNow® Configuration Management Database (CMDB) application. The integration does not write to the SCCM database. The integration pulls data from computers, processors, operating systems, disks, networks, and software.
Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Supported versions


Supported ServiceNow versions:

• Starting with Orlando Patch 7.
• Starting with Paris Patch 1.
• Starting with Quebec.

Use Cases

The following are examples on how you can use the Service Graph connector for different ServiceNow applications:

• IT Operations Management (ITOM) Visibility

  ◦ Ability to get visibility into your infrastructure.
  ◦ Detailed hardware and software inventory tracking. The tracking can be done with or without Software Asset Management (SAM).
  ◦ Ability to detect delta changes for efficient incremental imports from SCCM to NOW.

• IT Service Management (ITSM)

  ◦ Incidents, problems, and changes on discovered configuration items (CI).
  ◦ Automatic device ownership assignment.

• Software Asset Management (SAM) and IT Asset Management (ITAM)

  ◦ Tight integration with Software Asset Management Professional and client software distribution workflows.
  ◦ Inventory Software package and installation tracking.
  ◦ Software Usage tracking.
  ◦ License reclamation by detecting removed software.
  ◦ Support for software editions, normalizing publisher information, and normalizing product Information.
  ◦ Support for SCCM Asset Intelligence.
Guided Setup
The guided setup for the Service Graph connector for Microsoft SCCM provides an organized sequence of tasks to configure the integration on your instance. To access the guided setup, see Configure Service Graph connector for Microsoft SCCM.

Note: When you install and configure the Service Graph connector for Microsoft SCCM, only active SG-SCCM data sources will be configured with credentials/MID configuration during the guided setup. If a Software Asset Management plugin is enabled after the connector has been installed, any additional SAM-related data sources will not be configured with credentials and will not function correctly. In this scenario, you must go back into guided setup for SG-SCCM and re-enter the credentials and MID configuration, in order for these new SAM-related data sources to function correctly.

CMDB Integrations Dashboard
The Integration Commons for CMDB store app provides a dashboard with a central view of the status, processing results, and processing errors of all installed integrations. You can see metrics for all integration runs. You can filter the view to a specific CMDB integration, a specific time duration, or a specific integration run. For more details about monitoring Microsoft SCCM integrations in the CMDB Integrations Dashboard, see CMDB Integrations Dashboard.

Data mapping
Data from the SCCM data sources is mapped and transformed into the ServiceNow CMDB Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is inserted into the ServiceNow CMDB using the Identification and Reconciliation Engine (IRE). The SCCM data sources include the following:

• SG-SCCM Computer Identity
• SG-SCCM Disk
• SG-SCCM Last Discovered Update, this data source will run at the end of the import schedules to update the last_discovered date on the Computer CI. This will conduct a full pull of all the computers and brings in only the ResourceID and the LastHWScan columns to update the CMDB Computer table.
• SG-SCCM Network
• SG-SCCM Operating System
• SG-SCCM Processor
• SG-SCCM Removed Software, ensure the Use last run datetime option is cleared for every run.
• SG-SCCM Removed Software AI, ensure the **Use last run datetime** option is cleared for every run.

• SG-SCCM Software

• SG-SCCM Software AI

**Note:** If you have Asset Intelligence on your instance, you have to run SG-SCCM Removed Software AI and SG-SCCM Software AI. If you do not have Asset Intelligence on your instance, you have to run SG-SCCM Removed Software and SG-SCCM Software.

When you complete the guided setup, you can configure the integration to periodically pull data from SCCM. The data is loaded into staging tables and then inserted into the following target tables:

- CI Relationship [cmdb_rel_ci]
- Computer [cmdb_ci_computer] (required)
- Disk [cmdb_ci_disk]
- Network Adapter [cmdb_ci_network_adapter]
- Serial Number [cmdb_serial_number]
- Software [cmdb_ci_spkg]
- Software Installation [cmdb_sam_sw_install]
- Software Instance [cmdboftware_instance]
- Software Usage [samp_sw_usage]

**Note:** By default, network adapters that are missing an IP address or MAC address are not imported. To include these network adapters in the import, do the following:

1. Navigate to **Service Graph Connector for Microsoft SCCM > Data Sources**.
2. Select **SG-SCCM Network**.
3. Remove the where clause from the **SQL statement** field.

**Configure Service Graph connector for Microsoft SCCM**

Set up and validate data source connection credentials to import Microsoft SCCM data into your CMDB.
Before you begin

**Important:** If you are currently using the SCCM plugin, please refer to the following topic, Update from the Microsoft SCCM 2016 plugin to the Service Graph connector for Microsoft SCCM.

**Note:** If you have the Service Graph connector for Microsoft SCCM version 2.1.6 or lower installed in your production environment, you will need to contact Customer Service and Support for additional steps to remove the ITOM Licensing dependency. The dependency is removed for Service Graph connector for Microsoft SCCM version 2.3.1 and greater.

Confirm that you are in the SCCM application scope instead of a global scope so that you are able to save your information.

Dependencies and requirements:

- The Integration Commons for CMDB store app, which is automatically installed.
- The CMDB CI Class Models store app store app, which is automatically installed.
- Integration - JDBC (com.snc.integration.jdbc)
- Windows MID Server required for access to SCCM environment.

To access SCCM data, you must have appropriate access to the SCCM database. You must have sufficient credentials to query the SQL Server that contains the SCCM database. You must do the following:

1. Create a SQL Server account in order to connect to the SCCM database on the MID Server to use the data sources.

2. Connect to your SCCM SQL Server and configure the following:
   - Create a new login user name and password for SQL authentication.
   - Choose the SCCM database that ServiceNow data sources will connect to.
   - Assign the 'db_datareader' role membership to the new user.

Role required: admin

Procedure

1. Navigate to **Service Graph Connector for Microsoft SCCM > Setup**.
2. On the Getting Started page, select **Get Started**.
3. On the Service Graph Connector for Microsoft SCCM page, in the Configure the connection section, select the task **Configure SCCM JDBC Connection**.
4. To enter your configuration details to your Microsoft SCCM data sources, complete the following steps:

a. On the next page, in the Configure SCCM JDBC Connection task section, click **Configure**.

b. On the form, fill in the fields.

### Microsoft SCCM data source configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database name</td>
<td>Name of the database.</td>
</tr>
<tr>
<td>User name</td>
<td>User name for connecting to the database.</td>
</tr>
<tr>
<td>Password</td>
<td>Password for connecting to the database.</td>
</tr>
<tr>
<td>Server</td>
<td>Server name or IP address for the database server.</td>
</tr>
<tr>
<td>Use MID Server</td>
<td>MID Server that has access to SCCM environment to access the JDBC server. If you need an integrated authentication, then select the <strong>User Integrated Authentication</strong> check box.</td>
</tr>
<tr>
<td>Instance name</td>
<td>Name of the database instance. If you’re using a default name, then this field should be left empty.</td>
</tr>
<tr>
<td>Database port</td>
<td>Port of the database server. Enter 1433 as a default port.</td>
</tr>
<tr>
<td>Connection timeout</td>
<td>Number of seconds before the MID server connection cache pool closes the connection and removes it. Zero means no timeout.</td>
</tr>
<tr>
<td>Query timeout</td>
<td>Number of seconds the JDBC driver waits for a query to complete. Zero means no timeout. If the timeout runs out, the integration considers</td>
</tr>
</tbody>
</table>
c. Click **Save**.

d. In the Configure SCCM JBDC Configuration task section, click **Mark as Complete**.

5. In the Validate data sources task section, click **Configure** and complete the following steps:

a. Review the fields on the Data Source form, which are automatically set. There is no need to update any values on this page. The data source is pre-configured to use the SCCM JDBC Connection that you set up in the previous step.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of this data source.</td>
</tr>
<tr>
<td>Import set table label</td>
<td>Label of the table that will be created for this data source.</td>
</tr>
<tr>
<td>Import set table name</td>
<td>Name of the table that will be created for this data source.</td>
</tr>
<tr>
<td>Type</td>
<td>Data storage type of the data to be imported.</td>
</tr>
<tr>
<td>Use MID Server</td>
<td>MID server to use to access the JDBC server.</td>
</tr>
<tr>
<td>Format</td>
<td>Format of the data file.</td>
</tr>
<tr>
<td>Instance name</td>
<td>Named instance for SQLServer.</td>
</tr>
<tr>
<td>Database name</td>
<td>Name of the database.</td>
</tr>
<tr>
<td>Database port</td>
<td>Port of the database.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that contains this record.</td>
</tr>
<tr>
<td>Use integrated authentication</td>
<td>Windows JDBC integrated authentication.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User name</td>
<td>User name for connecting to the JDBC server.</td>
</tr>
<tr>
<td>Password</td>
<td>Password for the JDBC server.</td>
</tr>
<tr>
<td>Server</td>
<td>Server name for the JDBC connection.</td>
</tr>
<tr>
<td>Query</td>
<td>Query type. Query all data from a table or run a specific SQL statement.</td>
</tr>
<tr>
<td>Query timeout</td>
<td>Number of seconds the JDBC driver will wait for a query to complete. Zero means no timeout. If timeout is exceeded, the integration considers the JDBC result inaccessible and places it in an Error state.</td>
</tr>
<tr>
<td>Connection timeout</td>
<td>Number of seconds before the MID server connection cache pool closes the connection and removes it. Zero means no timeout.</td>
</tr>
<tr>
<td>SQL statement</td>
<td>SQL statement to extract the desired data from the database.</td>
</tr>
<tr>
<td>Use last run datetime</td>
<td>Option to control the amount of data that is retrieved from a database during an import run. If unselected, then all rows in the table specified are imported, every time. You might want to use this setting if this is a one-time import, or if all the data in the target table is new. If selected, two additional fields appear, enabling you to select a <code>datetime</code> value to limit imported data to delta values only.</td>
</tr>
</tbody>
</table>

b. To validate your data sources, click the **Test Load 20 Records** related link.

**Note:** If the displayed completion code is **Success**, mark this step as complete. If the displayed completion code is **Error**, there is an error in the SCCM JDBC Connection that you must fix.
c. In the Help sidebar, click **Back to Guided Setup**.

d. In the Validate data sources task section, click **Mark as Complete**.

6. In the Reset 'Last run datetime' in test load source task section, click **Configure** and complete the following steps:

   a. Select the **Last run datetime** field and delete the value.

   b. Click **Update** to save the change and return to the Configure the connection page.

7. On the left side bar, click the **Set up scheduled import jobs** button.

8. On the Service Graph Connector for Microsoft SCCM page, in the Set up scheduled import jobs section, select the task **Configure scheduled jobs**.

   a. In the Configure scheduled jobs task section, click **Configure**.

   b. On the form, fill in the fields.

   **Scheduled Data Import form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the scheduled job.</td>
</tr>
<tr>
<td>Data source</td>
<td>Data source record that defines the data to import.</td>
</tr>
<tr>
<td>Run as</td>
<td>Option to run the scheduled job with the credentials of the specified user.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the scheduled job. Select this option.</td>
</tr>
<tr>
<td>Concurrent Import</td>
<td>Function that loads the data from multiple import sets. The function then processes and transforms the data concurrently.</td>
</tr>
<tr>
<td>Partition Method</td>
<td>Partition method for the concurrent import set.</td>
</tr>
<tr>
<td>Partition Size</td>
<td>Import set size for early scheduling.</td>
</tr>
<tr>
<td>Execute pre-import script</td>
<td>Option to specify a script to run before the import is performed.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Execute post-import script</td>
<td>Option to specify a script to run after the import is performed.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that contains this scheduled job.</td>
</tr>
<tr>
<td>Run</td>
<td>Frequency of running the import.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Conditions under which this job is executed.</td>
</tr>
</tbody>
</table>

c. Click **Execute Now**.

d. In the Configure scheduled jobs task section, click **Mark as Complete**.

**Update from the Microsoft SCCM 2016 plugin to the Service Graph connector for Microsoft SCCM**

Deactivate the scheduled imports and pull records to update from the Microsoft SCCM 2016 plugin to the Service Graph connector for Microsoft SCCM.

**Before you begin**

If you are upgrading to the Service Graph connector for Microsoft SCCM, the following steps are mandatory. The steps must be executed in any instance with an existing install of the Microsoft SCCM 2016 plugin or with an earlier version of the plugin.

**Note:** The Service Graph connector for Microsoft SCCM is an independent implementation that does not reuse any components from the Microsoft SCCM 2016 plugin.

**About this task**

The Service Graph connector for Microsoft SCCM is a successor to the Microsoft SCCM 2016 plugin. If you already have the Microsoft SCCM 2016 plugin or an earlier version installed in your instance, you must follow these steps to enable the successful transition from using the SCCM plugin to using the Service Graph connector. If you brought in data into the Software Package and Software Instance table from other sources, other than SCCM, you have to delete or clean up the software that was brought in only by SCCM and not from any other discovery source. Also, you can run a SG-SCCM cleanup to delete the Network Adapters and Disks created from the older SCCM plugin to make the migration faster.
When the Service Graph connector for Microsoft SCCM is installed in an instance, you must no longer run any components from the Microsoft SCCM 2016 plugin, including Data Sources and Scheduled Data Imports. The SCCM 2016 plugin Scheduled Data Imports must be disabled. The Service Graph connector for Microsoft SCCM installs a new set of SG-SCCM Data Sources and Scheduled Data Imports.

⚠️ **Warning:** This upgrade process should be performed and validated in a non-production or test instance that is based on a recent clone of the customer production instance. Failure to first validate upgrade in a non-production instance may result in unexpected outcomes and possible data loss or corruption.

Any customizations to the SCCM 2016 plugin will not automatically migrate and would have to be reimplemented in the Service Graph connector for Microsoft SCCM, such as by using IntegrationHub-ETL.

**Procedure**

1. Deactivate the scheduled imports from the older SCCM plugin.
   For more information on how to deactivate scheduled imports, see .

2. To delete duplicate OS software records in the older SCCM plugin, complete the following steps:
   
   ✋ **Note:** There is no cleanup required for Computer OS Software records if SAM is enabled.

   a. Navigate to the Software Package or Software Instance table in the older SCCM plugin.

   b. Search for the duplicate OS records, you want to delete. Additionally, you can tell which records are the SG-SCCM software OS records if the version number is included in the Name or Product Name. Complete the following steps to delete the duplicate software OS records on each software table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Package table</td>
<td>a. On the Software Package table, select the duplicate OS record that does not have <strong>SG-SCCM</strong> in the <strong>Discovery Source</strong> column.</td>
</tr>
<tr>
<td></td>
<td>b. Delete the duplicate OS record and repeat with other records as needed.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Software Instance table</strong></td>
<td></td>
</tr>
</tbody>
</table>
  a. On the Software Instance table, select the duplicate OS record that has the **SCCM group ID** column empty.  
  b. Delete the duplicate OS record and repeat with other records as needed. |

3. After you are finished deactivating the scheduled imports and deleting the duplicate OS records from the older SCCM plugin, configure the connector. For instructions, see Configure the Service Graph connector for Microsoft SCCM.

4. If you need to run the SG-SCCM cleanup utility to delete the SCCM Network Adapters and Disks created from the older plugin, complete the following steps:

   a. Confirm that you are in the Service Graph connector for Microsoft SCCM application scope.

   b. Navigate to **Scheduled Job > SG-SCCM CleanupUtil**.

   c. Select the **SG-SCCM CleanupUtil** scheduled job, and then switch to the global application scope.

   d. To make a copy of the scheduled job, right-click the header of the scheduled job and select **Insert and Stay**.

   e. Change the name to **SG-SCCM CleanupUtil Global**.

   f. Click **Update**.

   g. When you need to run the scheduled job, click **Execute Now**.

   h. **Optional:** To check the progress of the run, do the following:
      
      i. Navigate to **System Log > All**.

      ii. Under the **Message** search box, type in **SG-SCCM CleanupUtil** to filter the records for the script run.
The script will have a log message for each batch so that you know the status of the current run and its progress.

ℹ️ Note: The duration of the run depends on the amount of Network Adapter and Disk data in the CMDB from the previous SCCM integration. The data must meet the condition for the cleanup.

What to do next
When you execute the Service Graph connector components, your existing CMDB data created by the SCCM 2016 plugin becomes managed and maintained by Service Graph connector for Microsoft SCCM.

Enable Software Editions in Service Graph connector for Microsoft SCCM
Enable software editions so that you can gather edition information for products such as Adobe Acrobat, Microsoft SQL Server, and Windows Exchange Server into the Service Graph connector for Microsoft SCCM.

Before you begin
ℹ️ Note: There are two types of setup that are required, one on the SCCM Manager and the other on the ServiceNow Instance. For more information on how to set up the SCCM Manager, see the SCCM Manager Setup section of the Custom solution to gather editions in SCCM [KB0721360] article on the HI Knowledge Base. When you’re finished setting up the SCCM Manager, refer back to this task and complete the steps.

Role required: admin

About this task
You can set up the ServiceNow Instance on the Service Graph connector for Microsoft SCCM.

Procedure
1. Navigate to Service Graph Connector Microsoft SCCM > Import Schedules.
2. Select the SG-SCCM Software Edition scheduled import to edit this import record.
3. Select the Active check box.
4. Click Update.
5. Navigate to Service Graph Connector Microsoft SCCM > Data Sources.
8. Edit the data source and select the Active check box.

9. Click Update.

What to do next
You can verify that the edition information has been gathered by doing the following:

1. Navigate to Service Graph Connector Microsoft SCCM > Data Sources > SG-SCCM Software Edition.

2. Select Load All Records.

Note: If the displayed completion code is Success, then the software edition data source was executed successfully. If the displayed completion code is Error, then there is an error that must be fixed.

Service Graph connector for SolarWinds (2.2.1)
Use the Service Graph connector for SolarWinds to pull in data from the SolarWinds software into your ServiceNow instance.

Important:
SolarWinds has publicly disclosed vulnerabilities specific to its SolarWinds Orion Platform software. ServiceNow does not use the SolarWinds Orion Platform software in its cloud.

Work with your internal Security team to verify whether you are affected by reviewing the SolarWinds Security Advisory.

The Service Graph connector for SolarWinds pulls in asset inventory data (hardware and software) from the SolarWinds database into the ServiceNow® Configuration Management Database (CMDB) application.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Supported versions
Supported versions: SolarWinds Orion 2019.4 HF6 or 2020.2.1. HF2
Supported ServiceNow versions:
• Starting with Orlando Patch 7.
• Starting with Paris Patch 1.
• Starting with Quebec.

Use cases
The following are examples on how you can use the Service Graph connector:
• Automatic normalization of asset information for hardware, virtualization and cloud resources, and software.
• Ability to configure and save synchronization schedules.

Guided setup
The guided setup for the Service Graph connector for SolarWinds provides an organized sequence of tasks to configure the integration on your instance. To access the guided setup, see Configure Service Graph connector for SolarWinds.

CMDB Integrations Dashboard
The Integration Commons for CMDB store app provides a dashboard with a central view of the status, processing results, and processing errors of all installed Service Graph connectors. You can see metrics for all integration runs. You can filter the view to a specific integration, a specific time duration, or a specific integration run. For more details about monitoring SolarWinds integrations in the CMDB Integrations Dashboard, see CMDB Integrations Dashboard.

Data mappings
Data from data sources in the SolarWinds software is mapped and transformed into ServiceNow CMDB tables using the Robust Transform Engine (RTE). Data is inserted into ServiceNow CMDB using the Identification and Reconciliation Engine (IRE).

When you complete the guided setup, you can configure the integration to periodically pull data from the SolarWinds software. The data is loaded into staging tables and then inserted into the following CMDB target tables:
• AIX Server [cmdb_ci_aix_server]
• Availability Zone [cmdb_ci_availability_zone]
• CI Relationship [cmdb_rel_ci]
• Cloud Network [cmdb_ci_network]
• Cloud Service Account [cmdb_ci_cloud_service_account]
• Cloud Subnet [cmdb_ci_cloud_subnet]
Configure Service Graph connector for SolarWinds

Set up authentication credentials and scheduled jobs to import SolarWinds data into your CMDB.

Before you begin
To use this Service Graph connector, you need a subscription to a Subscription Unit that is based in the IT Operations Management (ITOM) Visibility application or in the ITOM Discovery application. As defined in the section titled "Managed
IT Resource Types in ServiceNow Subscription Unit Overview, for managed IT resources that are created or modified in the CMDB by this Service Graph connector, but that are not yet managed by ITOM Visibility or ITOM Discovery, these resources will increase Subscription Unit consumption from that application. Review your current Subscription Unit consumption within ITOM Visibility or ITOM Discovery to ensure available capacity.

Before you start the configuration, navigate to System Definition > Business Rules and deactivate the ValidateServiceAccountID business rule.

Dependencies and requirements:

- The Integration Commons for CMDB store app, which is automatically installed.
- The CMDB CI Class Models store app store app, which is automatically installed.
- Discovery Core plugin (com.snc.discovery.core), which is automatically installed by Discovery.
- ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this plugin.
- ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery.
- SolarWinds Orion Platform.
- SolarWinds Server & Application Monitor and/or Network Performance Monitor.

Roles required:

- To configure the ServiceNow platform: admin
- To access SolarWinds data: User with SWIS (SolarWinds Information Service) access (the same as through the Orion website, not database users).

⚠️ **Attention:** You must agree to the statement that acknowledges you are aware of the recent SolarWinds Security Advisory before navigating the guided setup.

**About this task**

⚠️ **Note:** SolarWinds Integration can work with or without Service & Application Monitor (SAM) and Network Performance Monitor (NPM) being installed.

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Procedure

1. Navigate to Service Graph Connector for SolarWinds > Setup.

2. On the Getting started page, click Get Started.

3. On the Service Graph Connector for SolarWinds page, in the Configure the connection section, select the task Configure the authentication credentials used to connect to SolarWinds SWIS API.

4. To configure your authentication credentials used to connect to the SolarWinds SWIS API, complete the following steps:

   a. On the next page, in the Configure the authentication credentials task section, click Configure.

   b. On the form, fill in the fields.

Basic Auth Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This field is automatically set to a human-readable name for this credential. You can optionally change this setting.</td>
</tr>
<tr>
<td>User name</td>
<td>SolarWinds user name.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The SolarWinds user must have a role with read privileges to the SolarWinds Information Service API for all SolarWinds data sources that the integration can pull data.</td>
</tr>
<tr>
<td>Password</td>
<td>SolarWinds password, which is stored in the database in encrypted form.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to check if this credential is active.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Advanced selection criteria for this credential.</td>
</tr>
<tr>
<td>Order</td>
<td>Determines the order in which credentials are tried (smaller numbers are tried first)</td>
</tr>
</tbody>
</table>
c. Click **Update** if necessary.

d. In the Configure the authentication credentials used to connect to SolarWinds SWIS API task section, click **Mark as Complete**.

5. In the Configure SolarWinds HTTP connection task section, click **Configure** and complete the following steps:

a. Review the HTTP(s) Connection form and fill in fields as needed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This field is automatically set to the name of the connection, which you can optionally change.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option denoting if this Connection uses MID server or not.</td>
</tr>
<tr>
<td>Host</td>
<td>Target fully qualified host value used by the connection. The Connection URL will automatically fill in the &lt;hostname&gt;.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential value used by this connection.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Connection alias value with which the connection can be referred.</td>
</tr>
<tr>
<td>URL builder</td>
<td>Use URL builder to build the connection URL.</td>
</tr>
<tr>
<td>Mutual authentication</td>
<td>Enable if this is Mutual Authentication.</td>
</tr>
<tr>
<td>Protocol</td>
<td>Underlying protocol used by the connection.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the HTTP connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain to which the connection belongs.</td>
</tr>
</tbody>
</table>
b. Click **Update** if necessary.

c. In the Configure SolarWinds HTTP connection task section, click **Mark as Complete**.

6. In the Configure SolarWinds Modules section, click **Configure** and complete the following steps:

   a. On the System Properties page, configure the SolarWinds modules. Update the **Value** for the `sn_solarwinds_inte.npm_installed` and the `sn_solarwinds_inte.sam_installed`or `properties`.

      • Set to **true**: If the respective module is installed on the SolarWinds instance
      • Set to **false**: If the respective module is not installed on the SolarWinds instance

   📘 **Note:** This update changes the API class and the data that is returned from them.

   b. In the Help sidebar, click **Mark as Complete**.

7. In the Test the connection task section, click **Configure** and complete the following steps to test the connection:

   a. Review the fields on the Data Source form, which are automatically set.

   **Data Source form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for this data source.</td>
</tr>
<tr>
<td>Import set table label</td>
<td>Label of the table that will be created for this data source.</td>
</tr>
<tr>
<td>Import set table name</td>
<td>Name of the table that will be created for this data source.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Type</td>
<td>Data storage type of the data to be imported.</td>
</tr>
<tr>
<td>Format</td>
<td>Format of the data file.</td>
</tr>
<tr>
<td>Path for each row</td>
<td>Path expression used to select JSON objects which will become rows in the import set table.</td>
</tr>
<tr>
<td>Discard Arrays</td>
<td>Determines whether to discard or serialize JSON arrays as a value.</td>
</tr>
<tr>
<td>Expand node children</td>
<td>Determines whether to load inner object attributes as new columns for JSON or XML nodes.</td>
</tr>
<tr>
<td>Data in single column</td>
<td>Data in single column.</td>
</tr>
<tr>
<td>Application</td>
<td>Application containing this record.</td>
</tr>
<tr>
<td>Request action</td>
<td>The Data Source request action that will be invoked to get data.</td>
</tr>
<tr>
<td>Support pagination</td>
<td>Enable pagination to request action.</td>
</tr>
<tr>
<td>Limit</td>
<td>Maximum records per page.</td>
</tr>
<tr>
<td>Offset</td>
<td>Initial offset used for pagination.</td>
</tr>
</tbody>
</table>

b. Click the **Test Load 20 Records** related link to test the connection to the SolarWinds API. Testing the connection takes a few moments, after which the page refreshes to show the test results.

This step tests the SG-Solarwinds Hardware data source and ensures that data is loaded into the staging table. A successful connection for SG-Solarwinds Hardware means that all SolarWinds data sources connect successfully, so you do not need to individually test all data source.

The connection is successful if the **HTTP Status** is **200**. If there is an **Error Code** and **Error Message**, the connection failed and further troubleshooting is required.

c. In the Help sidebar, click **Back to Guided Setup**.

d. In the Test the connection task section, click **Mark as Complete**.
8. On the left sidebar, click the **Set-up scheduled import jobs** button.

9. On the Service Graph Connector for SolarWinds page, in the Set up scheduled import jobs section, select the task **Configure the scheduled import jobs**.

a. In the Configure the scheduled import jobs task section, click **Configure**.

b. Review the fields on the Scheduled Data Import form, which are automatically set.

### Scheduled Data Import form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the scheduled job.</td>
</tr>
<tr>
<td>Data source</td>
<td>Data source record that defines the data to import.</td>
</tr>
<tr>
<td>Run as</td>
<td>Option to run the scheduled job with the credentials of the specified user.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the scheduled job. Select this option.</td>
</tr>
<tr>
<td>Concurrent Import</td>
<td>Function that loads the data from multiple import sets. The function then processes and transforms the data concurrently.</td>
</tr>
<tr>
<td>Partition Method</td>
<td>Partition method for the concurrent import set.</td>
</tr>
<tr>
<td>Partition Size</td>
<td>Import set size for early scheduling.</td>
</tr>
<tr>
<td>Execute pre-import script</td>
<td>Option to specify a script to run before the import is performed.</td>
</tr>
<tr>
<td>Execute post-import script</td>
<td>Option to specify a script to run after the import is performed.</td>
</tr>
<tr>
<td>Application</td>
<td>Application containing this record.</td>
</tr>
<tr>
<td>Run</td>
<td>Frequency of running the import.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Conditions under which this job is executed.</td>
</tr>
</tbody>
</table>
Note: All active SolarWinds scheduled jobs will run in their specified order after the SG-Solarwinds Hardware scheduled job runs. You can modify the Active setting for each SolarWinds scheduled job as appropriate for your integration.

c. Click Update if necessary.

d. In the Configure the scheduled import jobs task section, click Mark as Complete.

Service Graph connector for VMware Workspace ONE UEM (1.1.1)

Use the Service Graph connector for VMware Workspace One UEM to pull data from Workspace One into your ServiceNow Instance.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

The integration imports different hardware assets into the ServiceNow® Configuration Management Database (CMDB) application.

Supported versions

Supported versions: VMware Workspace ONE UEM API v.2

Supported ServiceNow versions:
• Starting with Paris Patch 1.
• Starting with Quebec.

Use Cases

The following are examples on how you can use the Service Graph connector for different ServiceNow applications:

• IT Operations Management (ITOM) Visibility
  ◦ Detailed hardware and application inventory for Android, Apple, and Windows mobile devices. The inventory can be used with or without Software Asset Management (SAM).
  ◦ Compliance tracking for mobile devices. You can build your own device (BYOD) or use corporate-owned devices.

• IT Service Management (ITSM)
- Incident, problem, change on discovered configuration items (CI).
- Ownership tracking and assignment for mobile devices.

**Guided Setup**

The guided setup for the Service Graph connector for VMware Workspace ONE UEM provides an organized sequence of tasks to configure the integration on your instance. To access the guided setup, see Configure Service Graph connector for VMware Workspace One UEM.

**CMDB Integrations Dashboard**

The Integration Commons for CMDB store app provides a dashboard with a central view of the status, processing results, and processing errors of all installed integrations. You can see metrics for all integration runs. You can filter the view to a specific CMDB integration, a specific time duration, or a specific integration run. For more details about monitoring Workspace ONE integrations in the CMDB Integrations Dashboard, see CMDB Integrations Dashboard.

**Data Mapping**

Data from the VMware Workspace ONE UEM Devices and Apps data sources is mapped and transformed into the ServiceNow CMDB Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is inserted into the ServiceNow CMDB using the Identification and Reconciliation Engine (IRE).

When you complete the guided setup, you configure the integration to periodically pull data from VMware Workspace ONE UEM. The data is loaded into the SG-Workspace ONE UEM Devices and Apps staging [sn_vmwoneuem_integ_devices_and_apps] table.

The data is then inserted into the following target tables:

- Computer [cmdb_ci_computer]
- Handheld Computing Device [cmdb_ci_handheld_computing]
- Media Player [cmdb_ci_media_player]
- Network Adapter [cmdb_ci_network_adapter]
- Printer [cmdb_ci_printer]
- SAM Software Installation [cmdb_sam_sw_install], if com.snc.sams plugin is installed.
- Serial Number [cmdb_serial_number]
• Software Instance [cmdb_software_instance], if com.snc.sams plugin is not installed.
• Software Package [cmdb_ci_spkg], if com.snc.sams plugin is not installed.

Note: To view any additional information such as the device owner, type of ownership, or compliance status, you need to switch to the SG-Workspace ONE UEM view. This view will display a SG-Workspace ONE UEM Device Related tab in the related list tabs with the additional information.

Configure Service Graph connector for VMware Workspace One UEM

Use the Service Graph connector for VMware Workspace One UEM to pull mobile and computing devices data from Workspace One into your ServiceNow instance.

About this task
To use this Service Graph connector, you need a subscription to a Subscription Unit that is based in the IT Operations Management (ITOM) Visibility application or in the ITOM Discovery application. As defined in the section titled "Managed IT Resource Types" in ServiceNow Subscription Unit Overview, for managed IT resources that are created or modified in the CMDB by this Service Graph connector, but that are not yet managed by ITOM Visibility or ITOM Discovery, these resources will increase Subscription Unit consumption from that application. Review your current Subscription Unit consumption within ITOM Visibility or ITOM Discovery to ensure available capacity.

Dependencies and Requirements:
• The Integration Commons for CMDB store app, which is automatically installed.
• The CMDB CI Class Models store app store app, which is automatically installed.
• ITOM Discovery License plugin (com.snc.itom.discovery.license), you must activate this plugin.
• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery.
• Datastream Action plugin (com.glide.hub.action_type.datastream), which is automatically installed.

Roles required: admin
Procedure

1. Navigate to Service Graph Connector VMware Workspace > Setup.

2. On the Getting started page, select Get Started.

3. On the Service Graph Connector for VMware Workspace ONE UEM, in the Configure the connection section, select the task Configure authentication credentials.

4. To configure your authentication credentials, complete the following steps:

   a. On the next page, in the Configure authentication credentials section, select Configure.

   b. On the form, fill in the following fields.

   Application Registries form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Client ID of the VMware Workspace ONE UEM console.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client secret of the VMware Workspace ONE UEM console.</td>
</tr>
<tr>
<td>Token URL</td>
<td>The Token URL of VMware Workspace ONE UEM console so that you can fetch the access token.</td>
</tr>
</tbody>
</table>

   Note: You can click the lock icon (🔒) to view the client secret.

   Note: For more information about the Token URL, see the VMware knowledge base article on the VMware documentation site.

To get more information about how to get OAuth credentials, see the VMware documentation on the VMware documentation site.

   c. Review the other fields on the Applications Registries form as needed.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the OAuth app.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Script that is used to customize requests and responses to the external OAuth provider.</td>
</tr>
<tr>
<td>Logo URL</td>
<td>Logo URL for the OAuth app.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>The Default Grant Type that is used to establish the OAuth token.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>Number of seconds that a refresh token issued will be good for.</td>
</tr>
<tr>
<td>PKCE required</td>
<td>Option to enable public clients to require PKCE during the authorization flow.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that contains this record.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Location where the OAuth is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the OAuth app.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>OAuth authorization code end-point.</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>OAuth access token revocation end-point.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>The OAuth app end-point to receive authorization code.</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use mutual authentication for token requests and revocations. This option requires that a Mutual Auth Profile is specified.</td>
</tr>
<tr>
<td>Send Credentials</td>
<td>Option to enable OAuth Client populate client credentials in the request per the choice selected.</td>
</tr>
<tr>
<td>Comments</td>
<td>Comments about the OAuth app.</td>
</tr>
</tbody>
</table>
d. Click **Update** if necessary.

e. In the Configure authentication credentials task section, click **Mark as Complete**.

5. In the Configure HTTP connection task section, click **Configure** and complete the following steps:

a. On the form, fill in the fields.

**HTTP(s) Connection form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the connection.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>MID Server that sends this HTTP connection. Using a MID Server is not compatible with mutual authentication.</td>
</tr>
<tr>
<td>Host</td>
<td>Target host value that is used by the connection. The Connection URL will automatically fill in the hostname.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential value used by this connection.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Connection value that is used to refer to the connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td>URL builder that is used to build the connection URL.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Connection URL of the connection. You can either manually enter your connection URL or use the URL builder to build the connection string.</td>
</tr>
</tbody>
</table>

**Note:** Update the **Host** field with a VMware Workspace ONE UEM base URL. For example, `as4855.awmdm.com`.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mutual authentication</td>
<td>Optional to enable mutual authentication.</td>
</tr>
<tr>
<td>Protocol</td>
<td>Underlying protocol used by the connection.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Update the Protocol field if you are using anything other than https.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the HTTP connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that contains the connection.</td>
</tr>
<tr>
<td>Override default port</td>
<td>Target value port that is used by the connection.</td>
</tr>
<tr>
<td>Base path</td>
<td>Base path for HTTP(s) connection.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You do not need to update this field.</td>
</tr>
</tbody>
</table>

**Note:** The HTTP connection will be pre-configured to use the authentication credentials that were configured during the previous setup task.

**b.** Click **Update** if necessary.

**c.** In the Configure HTTP Connection task section, click **Mark as Complete**.

6. In the Validate data sources task section, click **Configure** and complete the following steps:

**a.** Review the fields on the Data Source form, which is automatically set.

### Data Source form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of this data source.</td>
</tr>
<tr>
<td>Import set table label</td>
<td>Specify the import set table that is produced by this data source.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Import set table name</td>
<td>Name of the table that will be created for this data source.</td>
</tr>
<tr>
<td>Type</td>
<td>Data storage type of the data to be imported.</td>
</tr>
<tr>
<td>Data in single column</td>
<td>Data in single column.</td>
</tr>
<tr>
<td>Use Batch Import</td>
<td>Option to use batch insert to import set table.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that contains this record.</td>
</tr>
<tr>
<td>Data Stream action</td>
<td>Data Stream action that provides complex object streams to load data.</td>
</tr>
<tr>
<td>Data Loader</td>
<td>Script that loads data in import set table.</td>
</tr>
</tbody>
</table>

b. To test the connection, click the **Test Load 20 Records** related link. Testing the connection takes a few moments, after which the page refreshes to show the test results. The connection is successful if the **HTTP Status** is **200**. If there is an **Error Code** and **Error Message**, the connection failed and further troubleshooting is required.

   ✨ **Note:** Do not click **Load All Records** during this setup.

c. In the Help sidebar, click **Back to Guided Setup**.

d. In the Validate data sources task section, click **Mark as Complete**.

7. On the left side bar, click the duplicate detection rules icon.

8. On the Service Graph Connector for VMware Workspace ONE UEM page, in the Duplicate detection rules section, select the task **Configure duplicate detection rules**.

9. In the Configure duplicate detection rules section, click **Configure**.

10. On the CMDB Duplicate Row Rules form, update the **Active** column value to **true** to activate the duplicate detection rule.

   ✨ **Note:** To remove fields from being evaluated, add the field names with a comma in a separated list in the **Ignore Fields** column.
11. In the Help side bar, select **Mark as Complete**.

12. On the left side bar, click the **Set up scheduled import jobs** button.

13. On the Service Graph Connector for VMware Workspace ONE UEM page, in the Set up scheduled import jobs section, select the task **Configure the scheduled job**.

   a. In the Configure the scheduled job task section, click **Configure**.

   b. Select the name of the scheduled import that you want to run.

   c. Review the pre-populated fields on the Scheduled Data Import form.

### Scheduled Data Import form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the scheduled job.</td>
</tr>
<tr>
<td>Data source</td>
<td>Data source record that defines the data to import.</td>
</tr>
<tr>
<td>Run as</td>
<td>Option to run the scheduled job with the credentials of the specified user.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the scheduled job. Select this option.</td>
</tr>
<tr>
<td>Concurrent Import</td>
<td>Function that loads the data from multiple import sets. The function then processes and transforms the data concurrently.</td>
</tr>
<tr>
<td>Partition Method</td>
<td>Partition method for the concurrent import set.</td>
</tr>
<tr>
<td>Partition Size</td>
<td>Import set size for early scheduling.</td>
</tr>
<tr>
<td>Execute pre-import script</td>
<td>Option to specify a script to run before the import is performed.</td>
</tr>
<tr>
<td>Execute post-import script</td>
<td>Option to specify a script to run after the import is performed.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that contains this scheduled job.</td>
</tr>
<tr>
<td>Run</td>
<td>Frequency of running the import.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditional</td>
<td>Conditions under which this job is executed.</td>
</tr>
</tbody>
</table>

d. Click **Execute Now** and repeat the previous steps for the other imports if needed.

e. In the Help task bar, click **Mark as Complete**.

**Create multi-instance support for VMWare Workspace ONE UEM**

If you need to connect to multiple instances of Workspace ONE UEM, you can create multiple connections and scheduled imports to import data from multiple data servers.

**Before you begin**
Confirm that you are in the Service Graph connector for the Workspace ONE UEM application scope.

Role required: admin

**Procedure**

1. Navigate to **Service Graph Connector VMWare Workspace > Setup**.
2. On the left side bar, click the **Create another connection** button.
3. On the Service Graph Connector for VMware Workspace ONE UEM page, in the Create another connection section, select the task **Update Scheduled Data Import access**.
   a. In the Update Scheduled Data Import access task section, select **Configure**.
   b. Select the Scheduled Data Import [scheduled_import_set] table.
   c. To edit the record, select **Global** from the Scope menu.
   d. Under the **Application Access** tab, select the **Can create**, **Can update**, and **Can delete** check boxes.
   e. Save the record.
   f. From the Scope menu, select **Service Graph Connector for VMWare Workspace ONE UEM**.
   g. In the Help task bar, click **Mark as Complete**.
4. On the Service Graph Connector for VMware Workspace ONE UEM page, in the Create another connection section, select the task **Create or Edit connection**.
Note: You need to the following information from your VMWare Workspace ONE UEM administrator:

- Client ID
- Client Secret
- Token URL
- Connection URL

To get more information about how to get OAuth credentials, see the VMware documentation on the VMware documentation site. To get more information about the Token URL, see the Workspace ONE Access Token URL documentation on the VMware documentation site.

a. In the Create or Edit connection, select Configure.

b. Do one of the following:
   - To create a new connection, select Add Connection.
   - To edit an existing connection, select the Edit button.

c. On the form, fill in the fields or edit as needed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Name</td>
<td>Display name for the connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Connection URL for the new connection.</td>
</tr>
<tr>
<td>Use MID Server</td>
<td>Option to select a MID Server that sends this connection. Using a MID Server is not compatible with mutual authentication.</td>
</tr>
<tr>
<td>MID Server</td>
<td>MID Server for the connection.</td>
</tr>
<tr>
<td>OAuth Entity Name</td>
<td>Display name for OAuth Entity.</td>
</tr>
<tr>
<td>OAuth Client ID</td>
<td>Client ID for the provider.</td>
</tr>
<tr>
<td>OAuth Client Secret</td>
<td>Client Secret for the provider.</td>
</tr>
<tr>
<td>OAuth Token URL</td>
<td>Callback URL for the provider.</td>
</tr>
</tbody>
</table>
d. Do one of the following:

• To create the new connection, select **Create and Get OAuth Tokens**.

• To save the edits for the existing connection, select **Edit and Get OAuth Token**.

5. On the Service Graph Connector for VMware Workspace ONE UEM page, in the Create another connection section, select the task **Create scheduled import jobs**.

a. In the Create scheduled import jobs, select **Configure**.

b. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled Data Import name prefix</td>
<td>Contents of this field that will be prepended to the Scheduled Data Import name.</td>
</tr>
<tr>
<td>Connection and Credential Alias</td>
<td>Connection and Credential Alias of the import. Select the connection alias that was created in the previous step.</td>
</tr>
<tr>
<td>Run Scheduled Imports as User</td>
<td>User who will run the scheduled data import.</td>
</tr>
</tbody>
</table>

c. In the Help task bar, click **Mark as Complete**.

**Multisource CMDB**

Multisource CMDB retains complete history about discovery sources and proposed values, involved in updates of CI attributes. Use Multisource CMDB data to track how the CMDB is populated by various discovery sources at the CI attribute level. Also, to revert CI updates from a specific discovery source, or to recompute attribute values using updated reconciliation rules.

When multiple discovery sources attempt to update the same CI attribute, the Identification and Reconciliation Engine (IRE) uses reconciliation rules to select a single discovery source for the update. Without Multisource CMDB, details about the lower-priority discovery sources whose values were rejected, are discarded.
Also, it is difficult to identify the source of an attribute value without Multisource CMDB.

With Multisource CMDB, the raw details for every discovery source and CI combination are retained for both, discovery sources that were selected for an update and all others that were not. Multisource CMDB data, consisting of records for each discovery source and CI combination, is stored in the CMDB MultiSource Data [cmdb_multisource_data] table. You can examine, query, and report on this Multisource CMDB data store.

Use Multisource CMDB to:

• Control CI updates at the discovery source and CI attribute level.
• Visualize discovery sources of attribute values, at the attribute level.
• Modify reconciliation rules and then recompute CMDB data, reflecting the updated reconciliation rules.
• Revert CMDB data integration from a specific discovery source, if, for example, you realize that the discovery source is not reliable. Recompute CI attribute values, while excluding the discovery source that you want to ignore.
• Validate a new discovery source by comparing its data to data from other discovery sources, which are known to be valid.
• Improve data management, data quality, and operational insights, by querying on Multisource CMDB data. Use the Multisource Report Builder to create queries for Multisource CMDB records, discovery sources, and CI records.

Enable Multisource CMDB

• Activate the ITOM Discovery License (com.snc.itom.discovery.license) plugin.
• Add the Multisource CMDB system property `glide.identification_engine.multisource_enabled` and set it to 'true'.

By default, Multisource CMDB tracks discovery source information for CIs from both CMDB and non-CMDB classes. You can independently enable or disable tracking data for CMDB and for non-CMDB classes, using these system properties:

• `glide.identification_engine.multisource_cmdb_ci_enabled`
• `glide.identification_engine.multisource_non_cmdb_ci_enabled`

Report on Multisource CMDB data

Use the Multisource Report Builder to gain insights into the Multisource CMDB data store. Build reports to, for example, do the following:
• Find CIs not reported by any discovery source.
• Find discovery sources populating data in your CMDB.
• Compare attribute values across discovery sources.
• Compare attribute values between CMDB and another discovery source.
• Limit reports for Multisource CMDB data, to a specific application service, technical service, or a CMDB group.

See Sample Multisource CMDB queries for more details.

**Visualize Multisource CMDB data**
Multisource CMDB is highly verbose in the user interface:

• On the Reconciliation Rules page in CI Class Manager, click the Preview Data tab to see per attribute, discovery sources that are authorized to update that attribute, in precedence order.

• On a CI form, click the Multisource Data Preview related link to see per CI attribute, current value in the CMDB and incoming values from other discovery sources.

**Logging**
Enable logging for Multisource CMDB by adding and enabling the system property glide.cmdb.logger.source.cmdb_multisource. In the Log [syslog] table, search for entries in which source="cmdb_multisource".

**Recompute CI attribute values**
Modify reconciliation rules, or exclude a discovery source which is found to be invalid. Then, use the updated reconciliation rules in recomputing CI attribute values, for which those reconciliation rules or discovery source are applicable to.

**Before you begin**
Enable Multisource CMDB.

If you want to recompute to apply updated reconciliation rules, then you must first update the reconciliation rules.

Role required: itil_admin

**About this task**
Multisource CMDB automatically generates a recompute task for each recompute that you submit. If you submit multiple recomputes, a recompute task is generated for each operation, but only one task runs at any given time. To list all recompute tasks, enter cmdb_multisource_recomp_task.list in the left navigation search box.
There is a maximum number of records that can be included in a single recompute operation. This number is specified by the system property `glide.identification_engine.multisource.recompute.max.ci.limit` (100,000 by default).

**Note:** Recompute skips CIs which are reported by multiple discovery sources, but with different class names.

**Procedure**

1. Navigate to **Configuration > CI Class Manager**.
2. Select a class from the CI Classes hierarchy list.
3. In the left-side pane, expand **Class Info**, and select **Reconciliation Rules**.
4. On the Reconciliation Rules page, click **Recompute**.
5. Select the **Recompute Type**.
   
   • **Replace values from the specified discovery source with value from the discovery source next in priority, according to reconciliation rules:** Recompute attribute values for the class CIs, applying priorities specified in reconciliation rules and while excluding the specified Discovery Source. Records for the discovery source you are excluding, are also removed from the Multisource CMDB data store.

   This operation applies to data that exists in the CMDB. If reconciliation rules remain in effect for the discovery source that you have excluded, then future data from that discovery source, can populate the CMDB.

   • **Apply updated reconciliation rules:** Recompute attribute values for the class CIs, applying the updated reconciliation rules which are now in effect.

6. Select the **Recompute Scope**.

   The scopes grow from one option to the next:
   
   • **Recompute only CIs of this class:** Basic scope of CIs to recompute.
   
   • **Recompute CIs of this and derived classes:** Expand the basic scope to include CIs from derived classes.
   
   • **Recompute CIs of this and derived classes, along with selected related items:** Expand the previous scope to also include CIs from specified related items. Select the related items to include in the recompute.

7. Select the **Delete action** for CIs for which the excluded discovery source, is the only discovery source.
• **Delete record**: Delete the CI record from CMDB.

• **Set record attributes to custom value**: Set a specified CI attribute to a custom value to remove the CI from regular operations without deleting the CI. For example, set the *Operational status* attribute to *Retired*.

8. Click **Next** and then, on the Review page, carefully review the counts for the affected CIs. Ensure that all record counts are as you expect. Click **Back** to adjust any settings for the recompute.

9. Click **Recompute**.

**What to do next**

You can do any of the followings:

• In the status message that appears for the recompute operation, click the link to see the CMDB Multisource Recompute Task for more details. The Recompute Task shows the progress and status of the recompute operation.

  You can abort the recompute by setting **Status** to **Closed Incomplete** and selecting **Update**. You can then set **Status** back to **Work in progress** to resume recompute from where it was aborted.

• Enter `cmdb_multisource_recomp_task.list` in the left navigation search box, to see the status and progress of all recompute tasks.

**Create a query in the Multisource Report Builder**

Improve CMDB data management by querying the Multisource CMDB data store. Use the Multisource Report Builder to gain insights about how discovery sources are populating the CMDB and the reliability of the different discovery sources. Then, adjust reconciliation rules to improve the quality of CMDB data.

**Before you begin**

**Enable Multisource CMDB**.

Role required: *itil*

**About this task**

Build reports with a query such as:

• All the discovery sources populating data in your CMDB.

• CIs not reported by any discovery source.

• All CIs discovered by one discovery source, but not by another discovery source.
You can also create queries that show differences in CI attribute values between two discovery sources, or between the CMDB and another discovery source:

- For a given Multisource CMDB record, show how an attribute value is different between a discovery source and the current CMDB record. For example, find Hardware CIs with different location than what SCCM reports.
- For a given Multisource CMDB record, show how an attribute is different between SourceA and SourceB. For example, show all Computer CIs where RAM is different between SCCM and ServiceWatch.

You can show the query results by CI records, Multisource CMDB data records, or Discovery sources. You can also limit the report results to CIs within a specific application service, technical service, or a CMDB group.

Procedure

2. On the Multisource Data Report Builder page, select a query to edit or run, or click New.
3. Enter Name and Description for the report.
4. Select the Result type for the report.
   - **CI Records**: Results show unique CIs from the Multisource CMDB data store.
   - **Multisource Records**: Results show all entries of CI/discovery source combinations from Multisource CMDB data.
   - **Discovery sources**: Results are grouped by discovery sources that match the query criteria.
5. Select Only show difference to show differences in CI attribute values between discovery sources or compared to CMDB data. Select the Type of difference.
   - **Between CMDB record and discovery source**: Show differences in attribute values between the CMDB data and the specified discovery source.
   - **Between discovery sources**: Show differences in attribute values between two specified discovery sources.

a. Set Field to compare to the class attribute for which to show differences for. The list of attributes is a pre-populated subset of the class attributes, to which you cannot add or remove items.
6. Select a **Class** to apply the query to, or multiple classes. For each class, specify a criteria for CIs to be included in the query. Select **All Classes** to apply the query to all classes.

7. Select the **Discovery source** to query on. If **Only show difference** and **Between discovery sources** are selected, select the two discovery sources for the attribute values comparison.

8. Set **Limit results to** to limit the query to CIs that belong to a specific application service, technical service, or a CMDB group.

9. Click **Save**.

10. Click **Run**.

What to do next
On the CMDB Multisource Query Results page:

- If the number of results exceeds the number of results appearing on the page:
  - Click **Load More Results**: To show the next page of results. The number of results that appear on each result page is specified by the `glide.identification_engine.multisource.query.batch.limit` system property (100 items by default).
  - Click **Load All Results**: To show all results, up to the limit specified by the `glide.identification_engine.multisource.query.max.limit` system property (10000 by default).
  - Click a Multisource CMDB value link or a CI value link to access the respective records and see more details.

- In the Configuration Item column, click a CI link to open the CI form. In the Related Links section on the CI form, click the **Multisource Data** tab to show Multisource data, such discovery sources, related to the CI.

Sample Multisource CMDB queries
Use sample queries to create your own Multisource CMDB queries.

<table>
<thead>
<tr>
<th>Field</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Missing Discovery by Tivoli</td>
</tr>
<tr>
<td>Description</td>
<td>Servers discovered by ServiceNow but not by Tivoli</td>
</tr>
<tr>
<td>Result type</td>
<td>CI records</td>
</tr>
</tbody>
</table>
### Servers discovered by ServiceNow but not by Tivoli (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td><code>Server [cmdb_ci_server]</code></td>
</tr>
<tr>
<td>Discovery Source</td>
<td><code>[is] [ServiceNow]</code></td>
</tr>
<tr>
<td></td>
<td><code>[is not] [Tivoli]</code></td>
</tr>
<tr>
<td>Limit results to</td>
<td>All</td>
</tr>
</tbody>
</table>

### All discovery sources for backup servers

<table>
<thead>
<tr>
<th>Field</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Discovery Sources Backup Servers</td>
</tr>
<tr>
<td>Description</td>
<td>All discovery sources for backup servers</td>
</tr>
<tr>
<td>Result type</td>
<td>Data sources</td>
</tr>
<tr>
<td>Class</td>
<td><code>Server [cmdb_ci_server]</code> and class condition:</td>
</tr>
<tr>
<td></td>
<td><code>[Host name][starts with][backup]</code></td>
</tr>
<tr>
<td>Limit results to</td>
<td>All</td>
</tr>
</tbody>
</table>

### All Multisource CMDB records where the reported value of Location is different between Altiris and Tivoli discovery sources

<table>
<thead>
<tr>
<th>Field</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Compare Location-Altiris vs. Tivoli</td>
</tr>
<tr>
<td>Description</td>
<td>List all Multisource CMDB records where the reported value of Location is different between Altiris and Tivoli discovery sources</td>
</tr>
<tr>
<td>Result type</td>
<td>Multisource data records</td>
</tr>
<tr>
<td>Only show difference</td>
<td>Selected</td>
</tr>
<tr>
<td>Type of difference</td>
<td>Between discovery sources</td>
</tr>
</tbody>
</table>
All Multisource CMDB records where the reported value of Location is different between Altiris and Tivoli discovery sources (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovery Source</td>
<td>• Altiris</td>
</tr>
<tr>
<td></td>
<td>• Tivoli</td>
</tr>
<tr>
<td>Field to compare</td>
<td>Location</td>
</tr>
<tr>
<td>Limit results to</td>
<td>All</td>
</tr>
</tbody>
</table>

All Multisource CMDB records for Linux Server, where the Location value is different than the reported value by Tivoli

<table>
<thead>
<tr>
<th>Field</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Linux Server Location - Diff than Tivoli value</td>
</tr>
<tr>
<td>Description</td>
<td>All Multisource CMDB records for Linux Server, where the Location value is different than the value reported by Tivoli.</td>
</tr>
<tr>
<td>Result type</td>
<td>Multisource data records</td>
</tr>
<tr>
<td>Class</td>
<td>Linux Server</td>
</tr>
<tr>
<td>Only show difference</td>
<td>Selected</td>
</tr>
<tr>
<td>Type of difference</td>
<td>Between CMDB record and discovery source</td>
</tr>
<tr>
<td>Discovery Source</td>
<td>[is][Tivoli]</td>
</tr>
<tr>
<td>Field to compare</td>
<td>Location</td>
</tr>
<tr>
<td>Limit results to</td>
<td>All</td>
</tr>
</tbody>
</table>

Components installed with Multisource CMDB

Several types of components are installed with Multisource CMDB (included in the com.snc.cmdb plugin), such as tables and properties.
## Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB MultiSource Data</td>
<td>Multisource CMDB data store. Contains the raw data sent by all discovery sources.</td>
</tr>
<tr>
<td>[cmdb_multisource_data]</td>
<td></td>
</tr>
<tr>
<td>CMDB MultiSource Column Metadata</td>
<td>Mapping of attributes for each class to floatable columns. Used to improve performance of queries that involve high volumes of data.</td>
</tr>
<tr>
<td>[cmdb_multisource_column_metadata]</td>
<td></td>
</tr>
<tr>
<td>CMDB Multisource Queries</td>
<td>Multisource CMDB query definitions created by the user in the Multisource Report Builder.</td>
</tr>
<tr>
<td>[cmdb_multisource_query]</td>
<td></td>
</tr>
<tr>
<td>Query Status</td>
<td>State of execution, of queries created in the Multisource Report Builder.</td>
</tr>
<tr>
<td>[cmdb_multisource_query_status]</td>
<td></td>
</tr>
<tr>
<td>CMDB Multisource Query Results</td>
<td>Results for queries created in the Multisource Report Builder, configured with result type of CI records.</td>
</tr>
<tr>
<td>[cmdb_multisource_query_result]</td>
<td></td>
</tr>
<tr>
<td>CMDB Multisource Query Result Multisource Records</td>
<td>Results for queries created in the Multisource Report Builder, configured with result type of Multisource records.</td>
</tr>
<tr>
<td>[cmdb_multisource_query_result_ms_record]</td>
<td></td>
</tr>
<tr>
<td>CMDB Multisource Query Result Discovery Sources</td>
<td>Results for queries created in the Multisource Report Builder, configured with result type of Discovery source records.</td>
</tr>
<tr>
<td>[cmdb_multisource_query_result_disco_source]</td>
<td></td>
</tr>
<tr>
<td>CMDB MultiSource Recompute Task CIs</td>
<td>All CIs that are involved in a recompute operation.</td>
</tr>
<tr>
<td>[cmdb_multisource_recomp_task_ci]</td>
<td></td>
</tr>
<tr>
<td>CMDB MultiSource Recompute Tasks</td>
<td>Recomputation requests and progress status.</td>
</tr>
<tr>
<td>[cmdb_multisource_recomp_task]</td>
<td></td>
</tr>
</tbody>
</table>
Properties installed

Note: To open the System Properties [sys_properties] table, enter `sys_properties.list` in the navigation filter.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.identification_engine.multisource_enabled   | Enables Multisource CMDB.  
• Type: true | false  
• Default value: false  
• Location: Add to System Properties [sys_properties] table. |
| glide.identification_engine.multisource_cmdb_ci_enabled | Enables capturing Multisource CMDB data for CIs from CMDB classes (derived from the cmdb_ci class).  
• Type: true | false  
• Default value: false  
• Location: Add to System Properties [sys_properties] table. |
<p>| glide.identification_engine.multisource_non_cmdb_ci_enabled | Enables capturing Multisource CMDB data for CIs from non-CMDB classes (not derived from the cmdb_ci class). For example, the Serial Number [cmdb_serial_number] class, or the Software instance [cmdb_software_instance] class. |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.identification_engine.multisource.query.batch.limit | Max number of items to show per query results page, in the Multisource Report Builder. Changing the value of this property might affect performance when running a query.  
• Type: numeric  
• Default value: 100  
• Location: Add to System Properties [sys_properties] table. |
| glide.identification_engine.multisource.query.max.limit | Max number of query results to show when you click **Load All Results** in the Multisource Report Builder. Changing the value of this property might affect performance when running a query.  
• Type: numeric  
• Default value: 10000  
• Location: Add to System Properties [sys_properties] table. |
| glide.identification_engine.multisource.recompute.max.ci.limit | Max number of CIs that can be included in a Multisource CMDB recompute operation. |
### Baseline CMDB

CMDB baseline provides capabilities that help you understand and control the changes that have been made to your configuration items (CIs) in the CMDB.

- You can create a baseline, which is a snapshot of your configuration items in the CMDB. You can review the changes that have been made to that configuration item since a previous baseline. Multiple baselines may be created and the system tracks the changes that have been made per baseline.

Creating a baseline captures the attributes of the CI as well as all first-level relationships for the CI. Any changes to the base CI or to any related CIs are captured and displayed. Newly created CIs are not automatically added to a baseline.

- Associate a configuration item with a task, a change or change task, and to propose changes to the CI after the change is complete. You can record changes, and these changes are not applied to the CI immediately but are delayed until the change is complete.

When the change is complete, you can choose to apply the proposed changes which makes all changes previously proposed and associates the changes with the task.

---

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.cmdb.logger.source.cmdb_multisource</td>
<td>Enable logging for Multisource CMDB.</td>
</tr>
</tbody>
</table>
| | • Type: string  
| | • Values: info, warn, error, debug, or debugVerbose  
| | • Location: Add to System Properties [sys_properties] table. |

---
Create a CMDB baseline

You can create a baseline for a CI to track updates to the CI over time.

About this task
Role required: ecmdb_admin and itil

Procedure

1. Navigate to Configuration > Baselines > Baselines.
   If the Baselines module is not visible in the Configuration application, the module is inactive. In that case append /sys_app_module.do?sys_id=f4463879a9fe3dba01b30bc100cbf404 to the instance URL, and in the Module - Baselines form, ensure that the module is Active.

2. Click New.

3. Enter a Name for the baseline.
   By default, the cmdb_ci table is selected so that the record creates the baseline for all configuration items in the system.

4. Optional: To limit the baseline to specific CIs, select a different Table or choose Conditions that a CI must meet for it to have a baseline entry.

   Example
   For example, you might create a baseline for the Database table with the condition [Location] [is] [<configured location>].

5. Click Submit.
   The creation of a baseline is time consuming and occurs in the background. A message at the top of the record list notifies you that your baseline has been scheduled and you will receive an email when the process is complete.

Display baseline differences

You can see the changes that have been made to a CI or any first level related CIs by configuring the CI form layout to display the CMDB Baseline diff field. This field is labeled Baseline differences on the form.

Before you begin
Role required: itil

About this task
Changes are displayed only for the cmdb_ci table and child tables. You can change the com.cmdb.baseline.max_changes system property to limit the number of relationships and changes that appear in a baseline diff section on a CI form (set to 100 by default).
Procedure

1. Open a CI record.

2. Select the baseline you want to see for this CI from the choice list. The field displays the details of any changes that were made to the current record for the selected baseline, or indicates that no changes were made.

   Details of baseline differences

   - **Baseline differences**
     - For: SQL Baseline
   - **Basic attribute changes**
     - **2009-09-14 14:46:49** System Administrator - Changed: RAM (MB), Disk space (GB)
       - RAM (MB): 4 was: -1
       - Disk space (GB): 500 was: 100

3. To add a relationship to the CI, click the green plus icon in the Related Items toolbar. The new relationship appears below the toolbar. For more information about the Related Items toolbar and how to control the display, see CI relations formatter.

4. Update a related CI and see the changes displayed as Basic attribute changes in the current CI record.

   Basic Attribute Changes

   - **Baseline differences**
     - For: SQL Baseline
   - **Basic attribute changes**
     - **2009-09-14 15:17:42** System Administrator - Changed: Sys audit, RAM (MB), Disk space (GB)
       - Storage Area Network 002 was: (relationship added) - CI Relationship Change
       - Application Server PeopleSoft was: (relationship added) - CI Relationship Change
       - RAM (MB): 4 was: -1
       - Disk space (GB): 500 was: 100

Properties for baseline CMDB

Use the baseline CMDB properties to configure how many changes and relationships for a CI can appear in the baseline diff for the CI.

These properties are available for baseline CMDB. To view and edit these properties, the admin role is required.
Properties for Baseline CMDB

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of changes and relationships for a CI that can appear in</td>
<td>com.cmdb.baseline.max_changes</td>
</tr>
<tr>
<td>the baseline diff for the CI.</td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 100</td>
</tr>
<tr>
<td></td>
<td>• Location: Configuration &gt; CMDB Properties &gt; Baseline Properties</td>
</tr>
</tbody>
</table>

Managing proposed changes

The proposed changes feature allows you to pre-configure changes to configuration items and their associated relationships. These pre-configured changes are prepared to be implemented, but do not actually happen until they are applied at a later time.

When you view a CI, the proposed changes can be displayed so that you can see what is planned.

This feature is useful when you want to make modifications while a change process is in the approval stage, and only implement the changes after the approvals are complete. If the change is never approved, no changes to records have to be reversed. If the change is approved, a quick command applies all the proposed changes.

You can make the following proposed changes to a CI:

- Modify any field on the CI form.
- Add or delete a relationship to that CI.

To modify a relationship, you must delete the current relationship and add a new relationship. You cannot delete a proposed change.

View CI history

You can view the history of changes to a CI in a list, calendar, or timeline format.
View the proposed changes of a CI

You can view the proposed changes so that you can see what is planned for the CI.

Before you begin
Role required: personalize_form

About this task
To view any proposed changes, configure the CI form layout to display the CMDB Scheduled Changes field. Proposed changes are not displayed in a CI form by default.

Procedure
1. Navigate to Change > Open and open a change request.
2. In the Affected CIs related list, open the Configuration Item. You may also navigate directly to the CI form.
3. Right-click the form header bar.
4. Select Configure > Form Layout.
5. Move the CMDB Scheduled Changes field to the Selected pane.
6. Click Save. The CI form shows the details of any proposed changes in the Scheduled changes area.

Add a proposed change to a CI

Proposed changes to a CI can be made while viewing a change request or any task-related record.

Before you begin
Role required: itil

Procedure
1. In the Change Request form, go to the Affected CIs related list. If there are no CIs in the Affected CIs list, click Edit to add CIs that are affected by this change request.
2. Right-click the CI that you want to configure for a proposed change, and select Proposed Change.
3. Complete the form to make the proposed changes, and click Save Proposed Change.
Click **Update** to apply the changes immediately. Click **Delete** to delete the CI.

4. To propose an addition or a removal of a CI relationship:
   a. Click the plus icon in the **Related Items** section.
   b. In the Relationships section, add or delete a relationship. For information about using the relationship editor, see [Create or edit a CI relationship](#).
   c. Click **Save Propose Change**.
   d. Confirm saving the proposed change.
   
   Click **Update** or **Delete** to commit the changes immediately.

   **Note:** Use only with CI relationships. Proposing additions or removal of relationships is not valid for user relationships and group relationships.

What to do next

After the proposed changes are saved, the **Apply Proposed Changes** button appears on the Change Request form. This button lets the user commit the proposed changes to the CI. Your business processes determine the appropriate time to commit the changes. The CI retains the existing data until the proposed changes are committed. However, users can see that changes have been proposed.

### Apply a proposed change to a CI

When you apply the proposed changes, all the proposed changes for that change request are applied to the configuration item. You can apply proposed changes without verification, or if verification tests of the proposed changes have failed.

**Before you begin**

Role required: itil

**About this task**

After you apply the proposed changes, the **Scheduled changes** part of the form displays **No scheduled changes found**. You can configure proposed change verification rules which you can use to verify proposed changes before applying the changes.

**Procedure**

1. Navigate to the **Change Request** form.
2. Click the **Apply Proposed Changes** button.
   
   You may have to right-click the form header and select the **Reload Form** option to see the changes.
Create or edit a proposed change verification rule

Ensure that proposed changes meet business requirements and do not introduce invalid data to the CMDB, create a rule that includes a script to verify the proposed changes.

Before you begin
Role required: asset or itil

About this task
When you configure proposed change verification rules for a CI, you have an option to verify that the proposed changes pass the verification test script in the rule. The verification test results are logged as passed or failed, and you can view the results. Running the verification test is not mandatory, and a failed verification test does not prevent you from applying proposed changes.

Procedure
1. Navigate to Configuration > Change Verification > Proposed Change Verification Rules.
2. Click New or select an existing rule to edit.
3. Fill in the fields, as appropriate.

Proposed Change Verification Rules form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule name</td>
<td>The name of this rule.</td>
</tr>
<tr>
<td>Table name</td>
<td>The table to which the rule applies.</td>
</tr>
<tr>
<td>Filter condition</td>
<td>Conditions to apply this rule to specific CIs.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate this rule.</td>
</tr>
<tr>
<td>Rule script</td>
<td>A verification Java script that needs to return true or false. For example:</td>
</tr>
</tbody>
</table>

```javascript
validateRule()
{
    var os = current.getValue("os");
    var cpu = current.getValue("cpu_count");
}```
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>//Use current.getValue(fieldName) to get the proposed change value, eg. var os = current.getValue(&quot;os&quot;); //Your verification code</td>
</tr>
<tr>
<td></td>
<td>if (os != &quot;SunOS&quot;</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

Results
On the Change Request form, you can click **Verify Proposed Changes** to verify proposed changes for the affected CIs.

**Verify proposed changes**
Before applying proposed changes to affected CIs, use proposed change verification rules to verify that the changes meet business requirements and do not add invalid data to the CMDB.

**Before you begin**
Create or edit the rules used to verify proposed changes. For details, see [Create or edit a proposed change verification rule](#).

Role required: none

**About this task**
You can apply proposed changes even if they are unverified or fail a verification test.

**Procedure**
1. Open the Change Request form that affects the CI.
2. Click **Verify Proposed Changes**.
   The proposed changes are verified against any proposed change verification rules in which the CI meets the Filter condition criteria.
3. Review the message that appears at the top of the form after the verification process is finished.
   The message states whether the verification tests passed or failed.
What to do next
To view the details of any verification tests that were performed for the change request in the past two days, click the Proposed Change Verification Log related link.

Create or edit a planned change validation script
Create a custom script that checks if a change to a class was valid according to business requirements, and whether the change was planned or not. A planned change validation script is used whenever a CI change is viewed in the CI timeline or change history.

Before you begin
Role required: admin or itil

About this task
The system attempts to validate each CI change as follows:

• If a custom script exists for the CI or one of the CI parents, then the script is executed and the results are used to flag the change as valid or invalid. Parent CIs are examined in the hierarchical order.

• If a custom script does not exist for the CI or any of its parents, then a predefined validation script is used. The change is determined as a planned change if the change occurred between the Work start and Work end dates of the change request associated with the changed CI.

However, this check is not always reliable because a user might have manually modified the CI within the work dates, which flags the change as valid even if it is invalid.

The script needs to return a boolean, true or false, which depends on meeting the test criteria in the script. You can define a separate script for each CI class, and you can define multiple planned change validation scripts for a single class. For example, to maintain different versions of the script. Only one script can be active for a CI class at any given time.

These are the parameters that uniquely characterize a change:

• The fields that were changed
• The data source that performed the change
• The time stamp of the change

To correctly determine the validity of a change, examine the parameters and apply business logic to evaluate if the validation tests are met. A planned
change validation script can test any of these characteristics and determine when a change meets pre-established criteria. For example, the custom script can check if the mode of the CI is operational or maintenance, or who initiated the change.

**Procedure**

1. Navigate to **Configuration > Change Verification > Planned Change Validation Script**.
2. Click **New** or select a validation script to edit.
3. Complete the form.

### Planned change validation script form

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check box to activate this script for validating changes.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Class that this script applies to.</td>
</tr>
<tr>
<td>Script</td>
<td>Script to run to validate a change. If the script does not return a boolean value, then it is configured to false.</td>
</tr>
</tbody>
</table>

The script has a template which displays the input variables of the script.

### Template script input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>current</td>
<td>GlideRecord</td>
<td>Current record that is being processed.</td>
</tr>
<tr>
<td>updatedOn</td>
<td>GlideDateTime</td>
<td>Time stamp of the change.</td>
</tr>
<tr>
<td>updatedBy</td>
<td>String</td>
<td>Entity responsible for the change.</td>
</tr>
<tr>
<td>fieldsChanged</td>
<td>String</td>
<td>Comma-separated list of the names of all fields that were changed.</td>
</tr>
</tbody>
</table>

**Example**

This sample script checks who initiated the record update. It returns true if admin initiated the record update. Otherwise, the script returns false.

```javascript
isValidChange();

function isValidChange(/*GlideRecord current, GlideDateTime updatedOn, String updatedBy, String changedFields*/) {
  // Template script input variables
  // current
  // updatedOn
  // updatedBy
  // fieldsChanged

  return admin; // Return true if admin initiated the change, false otherwise.
}
```
//Return true if the user that updated the record has an admin role
return isUserAdmin(updatedBy);
}

function isUserAdmin(userName)
{
    var grUser = new GlideRecord("sys_user");
grUser.addQuery('name', userName);
grUser.query();
if(grUser.next())
{
    var roles = new GlideRecord("sys_user_has_role");
roles.addActiveQuery();
roles.addQuery('user', grUser.sys_id);
roles.query();
while(roles.next())
{
    if(roles.role.name == 'admin')
        return true;
}
return false;
}

4. Click Submit.

CI relationships in the CMDB

The CMDB, in contrast to a static asset list, helps you track not only the configuration items (CIs) within your system, but also the relationships between those items.

A relationship in the CMDB consists of two CIs and a relationship type:

- Parent CI
- Child CI
- Type of the relationship that links both CIs

For example, in the [Server1] [Managed by] [Server2] relationship:

- Server1 is the child CI
- Server2 is the parent CI
- [Managed by] is the relationship type
For example, a web application might read data from an instance of Oracle, which in turn might depend on a piece of underlying hardware. Most CIs in a CMDB have multiple relationships to other CIs, users, and groups.

The relationships between CIs can be automatically discovered. If you use Discovery, many relationships can be automatically loaded into the system through the discovery process. If you import your data from another system, you get some form of relationships.

You can add to automatically discovered relationships, create relationships, or edit relationships for a CI by launching the CI relationship editor from the CI form.

**Dependent and non-dependent relationships**

**Dependent relationships**, such as tomcat RunsOn Hardware, are used by the Identification and Reconciliation Engine (IRE) to identify dependent CIs.

Non-dependent relationships are not used for CI identification, and therefore can be deleted if no longer needed. CMDB tracks discovery source and last scanned time for non-dependent relationship in the Relationship Sources [sys_rel_source] table. Dependent relationships are used for CI identification. Therefore they should not be directly deleted and they are not tracked.

Information in the Relationship Sources [sys_rel_source] table can be used to decide if it is safe to delete a non-dependent relationship. For example, a discovery source which is attempting to delete a non-dependent relationship can confirm that:

- There are no other data sources for that relationship.
- The relationship was not updated for some specified length of time and therefore is no longer needed.

When a non-dependent relationship is deleted from the CI Relationship [cmdb_rel_ci] table, all cascading corresponding records in the Relationship Sources [sys_rel_source] table are deleted.

**Related information**

Create a CI relation rollup

**Suggested class relationships**

The system keeps a table (Suggested Relationship [cmdb_rel_type_suggest]) of relationship types that are appropriate for a CI type, based on its class. You can manage suggested relationships by navigating to Configuration > Suggested Relationships, or in the CI Class Manager.
Suggestion model

The relationship editor has a base CI. The base CI designates the CI that a user was on before launching the editor, as the base CI in the new relationship. If you launched the relationship editor from the Linux100 CI, then Linux100 becomes the base CI. Also, every CI in the system has a type (class). For example, bond Linux100 is of the Linux server type.

Many CI types are children of other types in the hierarchy. For example, the class hierarchy for a Linux server is:

```
cmdb_ci -> cmdb_ci_computer -> cmdb_ci_server -> cmdb_ci_linux_server
```

The suggestion model works by analyzing the suggested relationship table for all relationships whose base class is the current base class of the user or any one of its parent classes. For example, looking at a Linux server, the suggestion model would retrieve any relationships whose base class was:

```
cmdb_ci_linux_server, cmdb_ci_server, cmdb_ci_computer, Of cmdb_ci
```

ITOM Visibility, if available, uses enhanced discovery patterns to identify and add CI relationships to the Suggested Relationships table.

Suggested CI relationships in the relationship editor

The CI relationship editor uses the suggestion model to help users select reasonable relationships for configuration items.

For example, consider these relationship types in the system:

- Provides Power for :: Receives Power From
- Runs on :: Hosts

Typically, a user uses these relationships to define the following reasonable relationships between two items as follows:

- a database runs on a server
- a rack provides power for a server

Typically, neither of the following definitions would be appropriate:

- a rack runs on a server
- a server runs on a database

Related information

CI Class Manager
Add a suggested relationship

Add a suggested relationship for a class. The list of suggested relationships for a class is available when you create a new relationship for a CI of that class.

Before you begin
Role required: To view — itil. To create, update, or delete suggested relationships — itil_admin.

Procedure

1. Use the CI Class Manager (Role required: itil_admin):
   a. Navigate to Configuration > CI Class Manager.
   b. Click Hierarchy to expand the CI Classes list. Then select the class to add a suggested relationship to.
   c. In the class navigation bar, click Suggested Relationships.
   d. Click New.
   e. In the Add Suggested Relationship dialog box, select a Relationship and a Target Class for the relationship. This Class and the Target Class become parent or child in the suggested relationship, based on your selection of the Relationship.
   f. Click Save.

2. Or, navigate to Configuration > Relationships > Suggested Relationships (Role required: admin):
   a. Click New.
   b. Complete the form.

Suggested Relationship fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base class</td>
<td>The base class in the relationship, which depending on the relationship type, is either the parent or the child in the relationship.</td>
</tr>
<tr>
<td>Relationship</td>
<td>Relationship type.</td>
</tr>
<tr>
<td>Dependent class</td>
<td>The dependent class in the relationship, which depending</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
 | on the relationship type, is either the parent or the child in the relationship.

**Example: Suggested relationship you can add**

<table>
<thead>
<tr>
<th>Base Class</th>
<th>Relationship</th>
<th>Dependent/Target Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle</td>
<td>Is Hosted On</td>
<td>Linux Server</td>
</tr>
<tr>
<td>Oracle</td>
<td>Is Hosted On</td>
<td>Solaris Server</td>
</tr>
</tbody>
</table>

⚠️ **Note:** The same parent class and relationship can appear more than once.

**What to do next**

You may need to delete a suggested relationship, for example, to limit the choice of available relationships in the CI relationship editor. Removing a suggested relationship does not affect relationships that are created or updated by Discovery.

**Relationship governance rules**

Relationship governance rules is a set of relationship rules used to ensure consistency and validity in modeling relationships between configuration items (CIs) in the CMDB. Use relationship governance rules to prevent the selection of relationship types or directions that are not allowed between specific CI types.

Different applications such as Discovery and Service Mapping, create relationships between CIs. Each application might use inconsistent relationship type or direction to represent the same entity, resulting in multiple views of the same CIs. Relationship governance rules define what are valid relationship types and valid directions between pairs of CI types resulting in valid and consistent relationships in the CMDB.

Relationship governance rules consist of:

- **CMDB dependent relationship rules:** Rules (hosting and containment rules) that are used for CI identification. You can view and modify dependent relationship rules in the CI Class Manager, after selecting a class from the class hierarchy and clicking **Dependent Relationship**.

- **Suggested relationships:** Rules that are based on existing suggested relationships in the Suggested Relationship [cmdb_rel_type_suggest] table. Suggested relationships are used in the **CI relationship editor**. You can view
and modify suggested relationships in the CI Class Manager, after selecting a class from the class hierarchy and clicking **Suggested Relationships**.

- **Reference rules**: Rules that are used mostly by Cloud Management to represent all the possible valid combinations of pairs of referencing and referenced CIs in the service definition.

- **Built-in valid relationships**: The following relationships are pre-defined in the base system as valid relationships:
  - cmdb_ci_endpoint -> Applicative Flow To::Applicative Flow From -> cmdb_ci_endpoint
  - cmdb_ci_endpoint -> Implement End Point To::Implement End Point From -> cmdb_ci
  - cmdb_ci -> Use End Point To::Use End Point From -> cmdb_ci_endpoint

**General behavior**

- **Relationship governance rules support inheritance**.
  
  For example, suppose that the suggested relationship cmdb_ci_appl Runs On::Runs cmdb_ci_hardware exists. Then a Runs On::Runs relationship between a cmdb_ci_appl_dot_net CI and a cmdb_ci_windows_server CI is valid. That is because .Net Application class inherits from the Application class and the Windows Server class inherits from the Hardware class.

- **Duplicate relationship governance rules are not allowed**.

- **Relationship governance rules are not domain separated**.

- **It is allowed to have more than one relationship type between the same two CI types**.
  
  For example, the following relationships are valid:
  - cmdb_ci_appl Depends On::Used by cmdb_ci_service
  - cmdb_ci_appl Receives data from::Sends data to cmdb_ci_service

**Reports**

A relationship between CIs is considered valid if it conforms to any of the relationship governance rules. Use the CMDB dashboard to view reports about **overall relationships health** including relationships compliance with relationship governance rules. The 'Relationships not compliant with all relationship rules' report shows CI relationships that are not compliant with any of the relationship governance rules.
CI relations formatter

The default CI form includes a CI relations formatter from which you can examine a CI and its relationships in various views. From the CI relations formatter, you can also launch the CI relationship editor for the CI.

If the domain separation plugin is activated, then only relationships in which the logged on user is authorized to view both CIs, are displayed.

The CI relations formatter contains a list of related CIs and a toolbar with controls for viewing the relationships between the current CI and related CIs. You can configure the controls in this formatter to modify varying aspects of the view. For more information about formatters, see Create a formatter and add it to the form.
Note:

- If an endpoint is a child in one relationship and the same endpoint is a parent in another relationship, then that endpoint is hidden and does not appear in the relations formatter view. Similarly, relationship qualifier chains are also hidden and do not appear in the relationship formatter view.

  ◦ Example: CI1 > endpoint > CI2

    In this example, CI1 is related to CI2 through relationships with endpoint. A single relationship appears in the relations formatter:

    CI1 > CI2 (These relationships appear as a direct relationship without endpoint, because endpoint is a parent in one relationship and a child in another relationship)

  ◦ Example: CI1 > endpoint1 > CI2 > endpoint2

    Two relationships appear in the relations formatter:

    CI1 > CI2 (endpoint1 is hidden because it is a parent in one relationship and a child in another relationship)

    CI1 > CI2 > endpoint2 (appears as level 2 relationship – endpoint1 is hidden and endpoint2 appears as it a child and not a parent in any other relationship)

- On instances that do not meet the internet browser requirements for the CI relations formatter, the default CI form includes the legacy CI relations formatter instead. For more information, see Legacy CI relations formatter.

- CIs not extended from the Configuration Item [cmdb_ci] table, are not displayed in Dependency Views maps and in CI relation formatters.

- The Applicative Flow To::Application Flow From relationship is a special relationship type used only between Service Mapping endpoints. This relationship type is not intended for use in the CMDB as a relationship between CIs and therefore it is not displayed in the relations formatter.

Controls for viewing related CIs

<table>
<thead>
<tr>
<th>Control</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Starts the relationship editor to manually create CI relationships. For more information, see Create or edit a CI relationship.</td>
</tr>
</tbody>
</table>
Controls for viewing related CIs (continued)

<table>
<thead>
<tr>
<th>Control</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image](36x756 to 120x780)</td>
<td><strong>Show dependency views</strong> Launches a Dependency Views map in another window or tab. The CI is the central node in the map, with a configurable number of levels above and below that node in the hierarchy. Map indicators next to the nodes indicate the number of tasks, incidents, problems, changes, or outages related to that node. Right-click to expand collapsed nodes or display a list of related tasks or problems. For more information, see Dependency Views map.</td>
</tr>
<tr>
<td>![Image](89x649 to 118x768)</td>
<td><strong>Search for CI</strong> Filters the CIs included in the display.</td>
</tr>
</tbody>
</table>

Click the **Settings ( )** icon to configure additional view settings that filter the data displayed. Settings are preserved through logging out and logging back in.

**Related items settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show Relations in Flat/Tree Layout</strong></td>
<td>To view a flat list of related CIs that are grouped by relationship type in alphabetical order, click <strong>Flat</strong> (default value). To view groups of related CIs in a hierarchical tree, click <strong>Tree</strong>. If you select the tree view, you cannot configure any other settings for viewing related CIs. A single list of upstream and downstream relationships is displayed.</td>
</tr>
<tr>
<td><strong>Show Relations in Split/Merge Layout</strong></td>
<td>To view a single list that includes both upstream and downstream relationships, click <strong>Merge</strong> (default value). Relationships are grouped by relationship type. To view separate lists for upstream and downstream relationships, click <strong>Split</strong>.</td>
</tr>
<tr>
<td><strong>Filter Relations by Max Level</strong></td>
<td>Select the number of levels in the hierarchy to include when displaying CIs in a flat view. Default value is 3.</td>
</tr>
<tr>
<td><strong>Filter Relations by</strong></td>
<td>Select the types of relationships to view. Default value is ‘All Relationship Types’.</td>
</tr>
</tbody>
</table>
Related items settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relationship Type</td>
<td></td>
</tr>
<tr>
<td>Filter Relations by CMDB View</td>
<td>Filter by tables specified in CMDB views, if any relationship filters exist.</td>
</tr>
</tbody>
</table>

The relations formatter uses the following icons to provide additional information about changes, problems, and outages related to CIs in the relationship:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recently closed changes</td>
<td></td>
</tr>
<tr>
<td>Planned changes</td>
<td></td>
</tr>
<tr>
<td>Currently open changes</td>
<td></td>
</tr>
<tr>
<td>Recently closed outages</td>
<td></td>
</tr>
<tr>
<td>Problems</td>
<td></td>
</tr>
<tr>
<td>Incidents</td>
<td></td>
</tr>
<tr>
<td>Planned outages</td>
<td></td>
</tr>
<tr>
<td>Currently open outages</td>
<td></td>
</tr>
</tbody>
</table>

In large networks, a list of related CIs might be excessively long, which can slow performance when a CI form is rendered. You can configure these properties to control the amount of data that is displayed. To find a property, enter `sys_properties.list` in the left navigation filter and search for the property.

Properties related to performance

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ecmdb.find_relationship_issues</td>
<td>Hides or displays an icon in the CI relations formatter that links to open</td>
</tr>
</tbody>
</table>
Properties related to performance (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.max_relation_levels</td>
<td>Specifies the maximum level for displaying CIs in flat view before reaching the maximum relations limit. The default value is 5.</td>
</tr>
<tr>
<td>glide.ui.max_relations</td>
<td>Specifies the maximum number of related CIs to display. When exceeded, a notification is displayed indicating that the limit has been reached, and that not all relations are displayed. The default value is 1000.</td>
</tr>
</tbody>
</table>

Related information

Create a formatter and add it to the form
Create or edit a relationship filter

Domain separation and the relations formatter and the CI relationship editor

Domain separation is supported in the relations formatter and the CI relationship editor. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Overview

How domain separation works in the relations formatter and relationship editor

- Relations formatter

  The relations formatter is domain-separation supported. The relations formatter is used to display CMDB relationships in the UI in different views. Since the CI Relationship (cmdb_rel_ci) table is not domain separated, relationships are visible in the relations formatter only if both parent and child CIs (cmdb) are visible in the domain.
The CI Relationship Type (cmdb_rel_type) table is not domain separated. Therefore, in the relations formatter, all the relationship types are available to be selected as a filter.

By default domain separation is supported in the relations formatter.

**Relationship editor**

The relationship editor is domain-separation supported. You can use the relationship editor to add new relationships or delete existing relationships for the current CI.

- The CI relationship editor displays a list of CIs to add or remove from relationships. Since they are domain separated, the CI list view in the relationship editor displays the CIs that are visible to the current domain.
- The CI relationship editor displays a list of relationships to add or remove. Since the CI Relationship [cmdb_rel_ci] table is not domain separated, the relationships list view displays all the relationships of the current CI.

The Suggested Relationship (cmdb_rel_type_suggest) table is not domain separated, which means that all the suggested relationship types in the relationship editor are visible for all domains.

By default domain separation is supported in the relationship editor.

**Related information**

Domain separation and Configuration Management Database (CMDB)

**Create or edit a relationship filter**

Create a custom relationship filter to display CI relationships from selected tables in the CI relations formatter.

**Before you begin**

Role required: ecmdb_admin

**About this task**

The CI relations formatter displays related CIs for the base CI, and the relationships between the CIs. You can use relationship filters on the CI relations formatter to customize CI relationship views.

**Procedure**

1. Navigate to **Configuration > Relationships > Relationship Filters**.
2. Click **New** or select a filter to edit.
3. Enter or edit the relationship filter name.
4. Right-click the form header and click **Save**.
5. In the **Configuration Types** section, click **Edit**.
6. On the **Edit Members** form, select the tables of the CIs that you want to show with the filter and then move the tables to the **Configuration Types list**.
7. Click **Save**.

**Results**

On a CI form, in the relations formatter settings, you can select the newly defined relationship filter from the **Filter Relations by CMDB View** list.

In the legacy CI relations formatter, you can click **View** and select the newly defined relationship filter.

After you select a filter, the relations formatter displays only CIs from the tables specified in the filter or from descending tables.

**Exclude relationships from the relations formatter view**

Create a list of relationships that should not appear in the relations formatter view on CI forms.

**Before you begin**

**Role required:**

- To view the relationship type exclusion list — itil
- To create, update, or delete the relationship type exclusion list — itil_admin

**Procedure**

1. Navigate to **Configuration > Relationships > Relationship Type Exclusion List**.
2. In the CI Relation Filters list view, click **New**.
3. Fill out the CI Relation Filter form to specify the relationship that you want to exclude from view.
4. Click **Submit**.

   Excluded relationships do not appear in Related Items on CI forms.

**Legacy CI relations formatter**

On instances that do not meet the internet browser requirements for the latest CI relations formatter, the default CI form includes the legacy CI relations formatter instead.
This element contains the list of related CIs and a toolbar with controls for viewing the relationships between the current CI and related CIs.

**Related items field**

<table>
<thead>
<tr>
<th>Related Items:</th>
<th>Show 3 Levels</th>
</tr>
</thead>
</table>

**Note:** The legacy BSM map provides a more complete view of CI relationships.

Configure the controls in this formatter with two properties that restrict varying aspects of the view.

**Flat layout**

Click the flat layout icon (†) to group the related CIs by relationship.

**Flat layout view**

- **Used by - Business Services**
  - Bond Trading
  - Client Services
  - [Bond Trading → ]IT Services
- **In Rack - Racks**
  - NY-02-02
- **Located in - Computer Rooms**
  - [NY2A → ]NY Floor 2
- **Runs - Web Servers**
  - apache linux den 200
- **Located in Zone - Data Center Zones**
  - [NY-02-02 → ]NY2A

**Tree layout**

Click the tree layout icon (†) to group the related CIs in a hierarchical tree.
CI relationship editor

Use the CI relationship editor to create CI relationships.

When you use the relationship editor, the CI from which the editor was launched is designated as the base CI. You can then select one or more CIs as a second CI for the relationship. Depending on the selected relationship type, the base CI can become the parent CI or the child CI in the new relationship.

The relationship editor operates differently, depending on whether you select the **Use suggested relationship** check box.

- With suggested relationships, the relationship editor lists all available relationship types for the base CI. To define a new relationship, select a relationship type, and then select a second CI for the relationship.

  Suggested relationships are highlighted for you. These relationships are displayed in blue with a prefix of [Suggested].

- Without suggested relationships, you define a new relationship by first selecting a second CI for the relationship and then selecting a parent or a child relationship type.

  **Note:** The following relationship types are used only for Service Mapping endpoints, and you cannot use them as a relationship type between two CIs:

  - Implement End Point To: Implement End Point From
  - Use End Point To: Use End Point From
  - Applicative Flow To: Applicative Flow From

Suggested relationships

If you select the **Use suggested relationship** check box in the editor, the **Suggested relationship** list appears. It displays all available CI, user and group relationship types for the base CI. Relationship types have a suffix of **(Parent)** or **(Child)** to note the relationship descriptor, and suggested relationship types are displayed in blue and have a "*" prefix.
When you select a relationship, you are also designating the base CI as being the parent or the child CI in the new relationship. For example, if you select the ‘Feeds’ relationship type, the base CI becomes the designated parent CI, and the second CI that you select becomes the child CI in this relationship.

**Downstream relationships**

If you do not select the *Use suggested relationship* check box in the editor, the **Downstream relationships** list appears. It displays all relationships in which the base CI is the parent CI. The child CI of the relationship is displayed in the **Child** column.

**Upstream relationships**

If you do not select the *Use suggested relationship* check box in the editor, the **Upstream relationships** list appears. It displays all relationships in which the base CI is the child CI. The parent CI in each relationship is displayed in the **Parent** column.

**Related information**

- Add a suggested relationship
- Create or edit a CI relationship
- Legacy CI relationship builder

**Supported browsers for the relationship editor**

You must use supported browser versions in order to use the latest CI relationship editor. If you do not use a supported browser version, the instance provides the legacy CI relationship builder.

- Firefox version 20 and up
- Chrome version 25 and up
- Safari version 6 and up
- Internet Explorer version 9 and up

**Create or edit a CI relationship**

Use the relationship editor to view, create or modify CI relationships. You can open the relationship editor from the CI Relations formatter.

**Before you begin**

Role required:
• To create relationships: ITIL or asset
• To view relationships, depending on the state of the Table API ACL:
  ◦ If inactive (default): ITIL or asset
  ◦ If active: ITIL or asset, and snc_platform_rest_api_access

For more information, see REST API and Table API.

About this task
The relationship editor operates differently, depending on whether you check the Use suggested relationship option or not.

Procedure
1. Launch the relationship editor:
   a. Open a CI form.
   b. Locate the Related Items section near the center of the form.
   c. Click the plus (+) icon on the Related items section.
2. To use suggested relationships, first select a relationship type, and then select one or more CIs to be the child CIs in the relationship:
a. Select **Use suggested relationship**.

b. From the **Suggested relationship type** list, select a relationship type. You can filter the list of suggested relationships by using the filter check boxes.

<table>
<thead>
<tr>
<th>Filter option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide CI relationship</td>
<td>Hides any relationships between the base CI and another CI (such as &quot;Receives data from&quot;). Default filter is stored in the ci_manage_relationships_filter_hint.cmdb_ci user preference.</td>
</tr>
<tr>
<td>Hide user relationship</td>
<td>Hides any relationships between the base CI and a user (such as &quot;Logs reviewed by&quot;). The default filter is stored in the ci_manage_relationships_filter_hint.sys_user preference.</td>
</tr>
<tr>
<td>Hide group relationship</td>
<td>Hides any relationships between the base CI and a group (such as &quot;Backups done by&quot;). Default filter is stored in the ci_manage_relationships_filter_hint.sys_user_group user preference.</td>
</tr>
</tbody>
</table>

The **Configurations Items** list displays all the CIs that are appropriate for the base CI and the selected relationship type. The **Relationships** list at the bottom of the editor, displays all existing relationships of the selected relationship type, in which the base CI is a parent CI or a child CI.

c. From the **Configuration Items** list, select one or more CIs as a second CI for the relationship. You can filter the list of **Configurations Items** by adding conditions in the **Filter** section and clicking **Run filter**. If you selected a parent relationship type, these CIs becomes the child CI in the relationship, and if you selected a child relationship type, then the selected CIs become the parent CI in the relationship.

d. In the **Relationships** section, click the plus icon (+) to add the new relationships. Alternatively, you can drag the selected CIs to the **Relationships** list. Each new relationship will consist of the base CI, the selected relationship type, and a selected second CI.

3. To not use suggested relationships, first select one or more CIs to be the child CIs in the relationship, and then select the relationship type:
a. Clear Use suggested relationship.

b. In the Configuration Items list, select one or more CIs as a second CI for the relationship. You can filter the list of Configuration Items by adding conditions in the Filter area and clicking Run filter. Depending on the relationship type that you will select, the selected CIs might become a parent or a child CI in the relationship.

c. With at least one CI selected in the Configuration Items list, click the ‘+’ sign in the Downstream Relationships section or the Upstream Relationships section to create the relationship.

- Add the relationship to Downstream Relationships to create a relationship in which the base CI is the parent CI and the selected CI is the child CI.
- Add the relationship to Upstream Relationships to create a relationship in which the base CI is the child CI and the selected CI is the parent CI.

d. For each newly created relationship in either the Downstream Relationships or the Upstream Relationships lists, click Please select a relationship and select a relationship type.

- The list of available relationship types in the Downstream Relationships list contains parent relationships only, in which the base CI is the parent CI.
- The list of available relationship types in the Upstream Relationships list contains child relationships only, in which the base CI is the child CI.
e. Click **Save** or **Save and Exit**. Only after you enter all the information that is necessary for creating the relationship, these buttons light up indicating that there are pending updates that require saving.

**Related reference**
- Suggested class relationships

**Related information**
- CI relationships in the CMDB
- CI relationship security

**Legacy CI relationship builder**

Used to define CI relationships manually, this page is a sophisticated version of the standard slushbucket. In the legacy CI relations formatter, click the CI relationship builder icon (⊕) to display the legacy Define Relationships page.

**Select a CI relationship type**

The top half of the legacy relationship editor contains a large option box that allows you to select which type of relationship you want to manipulate. Click the particular type of relationship you are interested in working with.

**Filter the list of CI relationships**

In the legacy relationship editor, the checkboxes along the right hand edge of the select box provide a quick way to filter down the list of available relationships.

By default, the system displays a list of all suggested relationships for the type of CI you selected. For example, if you selected a Database instance, a relationship of "Runs on" makes sense, but a relationship of "Provides HVAC for" does not. The default filter is stored in the user preferences `ci_manage_relationships_filter_hint.cmdb_cici_manage_relationships_filter_hint.sys_user`, and `ci_manage_relationships_filter_hint.sys_user_group`.

- **Hide CI relationship** -- Hides any relationships between this CI and another CI (e.g. "Receives data from").
- **Hide user relationships** -- Hides any relationships between this CI and a user (e.g. "Logs reviewed by").
- **Hide group relationships** -- Hides any relationships between this CI and a group (e.g. "Backups done by").
Show all relationships -- If you have the appropriate role (out of the box this is itil_admin) you will have an additional checkbox labeled "Show all relationships." If you click that checkbox, the system will let you choose any relationship defined in the system, regardless of where it is on the "suggested" list for this type of CI.

Select CI relationship targets
In the legacy relationship editor, users can link or unlink CIs for a relationship type.

As soon as you pick a relationship type, the system will fill in the two select boxes at the bottom of the screen with CIs that are appropriate for the relationship you suggested. The left hand select box will contain a list of CIs that might reasonably be linked via this relationship, while the right hand box contains a list of those CIs which are already linked.

1. Link or unlink items.

<table>
<thead>
<tr>
<th>Link new items</th>
<th>Move that CI from the left hand box to the right hand box.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlink existing items</td>
<td>Move them from the right hand box to the left.</td>
</tr>
</tbody>
</table>

Result: When you make either type of change, a message appears indicating that you have pending changes.

2. Apply or cancel your changes.

<table>
<thead>
<tr>
<th>Click the Save button.</th>
<th>This will save your set of changes, and go back to the previous screen (either a CI or the BSM map depending on how you got here).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the Cancel button.</td>
<td>This causes you to exit without saving your changes.</td>
</tr>
</tbody>
</table>

Related information
CI relationships in the CMDB

Relation qualifier
A relation qualifier, which is a CI of the Qualifier [cmdb_ci_qualifier] type, stores important information about the CI relationships.
In a relation qualifier, you can annotate arbitrary unique information about the relationship between two CIs. You can define multiple qualifiers for a single relationship, resulting in a qualifier chain. But, there can be only a single qualifier chain for a specific relationship type between two CIs.

For example, for a relationship between a parent CI and a child CI, you can add a relation qualifier to note that the relationship was discovered based on traffic (such as `cmdb_ci_qualifier_trafficbased`). This results in having two records in the CI Relationship [cmdb_rel_ci] table for the relationship.

- A record that links the parent CI and the new qualifier
- A record that links the new qualifier and the child CI

For this relationship, there is a parent CI and a child CI, and a relation qualifier of type `cmdb_ci_qualifier_trafficbased`.

For information about usage of relation qualifiers in the identification process, see [Identification rules](#).

**CI relationship security**

When applying security to CI relationships, it is important to apply the access controls both to the CI Relationship (cmdb_rel_ci) table and to create an operation `editCIRelations` to the * table as well.

If the current instance has defined security for `editCIRelations`, it will be applied to `edit_ci_relations` automatically in the process of upgrading, and the out-of-date security will be removed.

**Related information**
- CI relationships in the CMDB
- Create a CI relation rollup

**Create a CI relation rollup**

A CI relation rollup allows you to sum, count, max, min, or mean a relationship type. You can create CI relation rollups.

**Before you begin**
Role required: ecmdb_admin

**About this task**
CI relation rollup can be useful for tracking and for receiving notifications. For example:
In a sum roll up, add up fields from multiple CIs and display the result on another CI to which they are related. So, if you have four configuration items in a rack that are all consuming power, create a CI relation rollup to add all the power usage together and display the result in one field on the rack CI form.

If a certain level of power consumption in a rack is exceeded, send a notification.

With a rack that has 10 slots, send a notification when 9 slots are filled.

CI relation rollups use the `cmdb synch event` business rule on the `[cmdb_ci]` table. Although this business rule is active by default, you must modify the rule slightly before it will run.

**Procedure**

1. Navigate to **Configuration > Relationships > CI Relation Rollups**.
2. Click **New**.
3. Complete the form.

<table>
<thead>
<tr>
<th>CI Relationship Rollup fields</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>CI Relationship Type</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Parent field</td>
</tr>
<tr>
<td>Child field</td>
</tr>
<tr>
<td>Rollup class</td>
</tr>
</tbody>
</table>

4. To run the `cmdb synch event` business rule, navigate to **Business Rules**.
5. Use the search box to find the `[cmdb synch event]` table.
6. Click the `cmdb synch event` business rule to go to the **Business Rule** page.
7. Select the **Update**, **Delete**, and **Query** check boxes.

   Additionally, if you wish CI relation rollups to recalculate when there is a change to a relationship, use a similar procedure to select the **Active** check box on the `cmdb_rel_ci synch event` business rule.

**Related information**

**CI relationships in the CMDB**

**CMDB classifications**

CMDB classifications are groups of configuration items (CIs) that share attributes and are stored in their own table. Classifications allow administrators to define the hierarchy of CIs within the CMDB. A CI class refers to the actual table name in the instance database. In that context, CI Type is a friendly name that a CI is known by, such as computer, router, or printer.

As good practice, keep CI classifications as simple as possible.

**CMDB record types**

The CMDB contains the following major record types.

<table>
<thead>
<tr>
<th>Record types</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Item (CI)</td>
<td>Any computer, device, or service in the CMDB. A CI's record includes all of the relevant data, such as manufacturer, vendor, location, etc. Configuration items can be created or maintained either using tables, lists, and forms within the platform, or using the Discovery application.</td>
</tr>
<tr>
<td>Relation Type</td>
<td>A defined relationship between a CI and either another CI, a user, or a group. Relation types are defined twice, once from the perspective of the child CI and once from the parent CI's perspective. For example, a parent CI that powers a child CI uses relation type <strong>Powers::Is Powered By</strong>. Example relation types include <strong>In Rack::Rack contains</strong>, <strong>Log Reviewed by::Reviews logs</strong> for, or <strong>Backup done by::Does backups</strong> for. CMDB relationships can be established using Discovery or using the tables, lists, and forms within the platform. The CMDB form</td>
</tr>
</tbody>
</table>
Related Lists of CI components

Related lists in CI records display additional components contained by that CI, such as disk drives on a server and the rules that control the behavior of a network router.

When Discovery runs, the Related List is populated with the components that Discovery finds running on the CI. The CI record might show different lists from scan to scan, depending on whether or not Discovery found the component.

By default, the Related Lists only display those components that are associated with that CI in the CMDB that has been discovered by the last scan. Components that are recorded in the CMDB but are not discovered in a scan, are deemed absent and do not appear in the list.

There are two types of components that appear in the Related List: components that are CIs themselves (such as hard disks), and components that are not (serial numbers and rules). The default filter condition in the breadcrumbs for components that are CIs is [Status] [!=] [Absent]. The filter condition for components that are not CIs is [Absent] [=] [false].

For example, a router can have several Related Lists affected by these filter conditions, including routing rules, disk drives, interfaces, and network adapters. Only those components found during the last Discovery appear in these Related Lists.

Teams related list

The Teams related list associates a user group to a CI based on group type, providing flexibility in keeping track of the different types of groups assigned to a CI. Using the Teams related list can be useful if many data sources are used in the organization, and when using the IntegrationHub ETL.

In the base system, the Teams related list contains group types that match the fields:

- Approval Group
- Change Group
• Managed by Group
• Support Group

The Teams related list appears on CI forms for CIs of the Service [cmdb_ci_service] class and its descendent classes such as the Application Service [cmdb_ci_service_auto] class. When you set a group assignment on a CI form of one of those classes, that group assignment is automatically synchronized with the Teams related list. If you set an assignment group for an application service, a relationship record is created to represent the new group assignment for the CI. The Teams related list on such CI forms, always shows the current settings for the various group assignments for the CI.

If there are multiple groups assigned to a CI, then on the Teams related list on a CI form, you can designate one of those groups as primary. When an incident involving that CI is created, the incident is assigned to that primary group. Only one group type can be designated as primary for a CI at any given moment.

As an example, use the Teams related list for an application service with the following characteristics:

• Requires access to a database
• Runs on Linux servers
• Has a group assigned to manage the software portion of the actual application

In that example, you can track all of these group assignments by adding the appropriate group types and setting CIs with the new custom group types. The Teams related list lets you add group types that are needed in your organization, extending the initial list of supported group types. To add a group type, modify the dictionary definition of the group_type column in the cmdb_rel_team table:

1. On a CI form, select the Teams related list.
2. Click the Group type column. Select the Configure menu item and then click Dictionary.
3. Select the dictionary entry for the cmdb_rel_team table and the group_type column.
4. On the Dictionary Entry form, click the Choices tab and then click New. Fill out the form to add a new group type choice, such as DB Group (db_group).
Create a CI class

Create a CI class (table) that is an extension of an existing CI class. Then create identification and reconciliation rules for the new class.

Before you begin
The class that is being extended must have its *Is_Extendable* field checked, indicating that the class is extendable.

Roles:
- Itil_admin and personalize_dictionary: Required for editing the dictionary table
- admin: Full access

About this task
The CI Class Manager is a centralized location for managing CMDB tables and for creating a class that is derived from another CMDB class. Creating a class requires basic details such as a label and a name. Identification and reconciliation rules are also required to ensure that the class can be successfully identified by the identification engine.

For more information about extending a class and how attributes are derived from a parent class in that process, see Table extension and classes.

Procedure
1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to expand the CI Classes list. Then select the class that the new class is extended from.
3. Click Add Child Class.
   The Add Child Class option appears only if the selected class is extendable.
4. On the Provide Basic Info tab, fill out the information and then click Next.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>A unique label for the class (such as Laptops or Thin Clients). The label appears on list and form views for the class. Updating the Label field also updates the label record in the language file for the current language. See Field Labels in Data dictionary tables.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Table name</strong></td>
<td>Automatically populated based on the table label and a prefix as follows:</td>
</tr>
<tr>
<td></td>
<td>• For a table in a scoped application, the name is prefixed with a namespace identifier to indicate that it is part of an application.</td>
</tr>
<tr>
<td></td>
<td>• For a table in the global application, the name is prefixed with the string 'u_cmdb_ci'. This prefix denotes that the table is created by a user in the CMDB.</td>
</tr>
<tr>
<td></td>
<td>You cannot modify the prefix; however, you can modify the rest of the table name. The name can contain only lowercase, alphanumeric ASCII characters and underscores (_).</td>
</tr>
<tr>
<td></td>
<td>Maximum string length is 80 characters.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Explanation of the use purpose of the class.</td>
</tr>
<tr>
<td><strong>Icon</strong></td>
<td>The icon associated with the class.</td>
</tr>
<tr>
<td><strong>Extensible</strong></td>
<td>Indicator of whether this class can be extended.</td>
</tr>
<tr>
<td><strong>Principal Class</strong></td>
<td>Denotes whether this class is included in the Principal Class filter. If this class is included in the Principal Class filter, then CIs from this class appear in CI list views when the Principal Class filter is applied.</td>
</tr>
</tbody>
</table>

5. On the **Add Attributes** tab, click the + sign and enter details for each new class column. Then click **Next**. For description of the different columns in the
list view, see Dictionary entry form. Set **Identification** to true to designate the column as a CI identifier for class identification.

6. On the **Set Identification Rule** tab, examine the **Derived** identification rule and its **Identifier Entries**. You can click **Replace** to replace the derived rule with a new identification rule and new identifier entries specific to the new class. See **Identification rules** for details about identification rules and identifier entries.

7. On the **Dependencies** tab, click **Add dependency** to add dependent rules. The **Dependencies** tab appears only if there are dependent identification rules for the selected class.

8. On the **Add Reconciliation Rules** tab, click **Add** to create the following rules:
   a. **Reconciliation Rules**
   b. **Data Refresh Rules**

9. On the **Add Suggested Relationships** tab, review the diagram of the class derived suggested relationships. Use the filter to display only inbound, outbound, or specific relationship types. To add a suggested relationship for the class:
   a. Click **New**.
   b. In the Add Suggested Relationship dialog box, select a **Relationship** and a **Target Class** for the relationship. **This Class** and the **Target Class** become parent or child in the suggested relationship, based on your selection of the **Relationship**.
   c. Click **Save**.
      When building relationships for the class in the Query Builder, the list of suggested relationships is updated.

10. Click **Done**.

**Related information**

CMDB Identification and Reconciliation

**Reclassify a CI**

You can upgrade, downgrade, or switch the class of a CI by modifying its **Class** attribute.

**Before you begin**
Role required: itil or asset (In general, the roles required to update a CI)
About this task
Each class is defined with a unique set of attributes. This set consists of attributes that were derived from the parent class, and additional attributes defined for the class.

When you reclassify a class, the following occurs.

1. The set of attributes is adjusted to match the set of attributes of the newly assigned class. Attributes are added or removed as needed.
2. If any attributes are unique to the current class and are not defined in the newly reclassified class, they are lost.
3. A new record with the CI's current sys_id is inserted to the table of the new class, with the appropriate set of attributes for the class (the sys_id of the CI is retained).

Depending on the reclassification, the following occurs.

**Downgrade**

The CI class is updated to a class that is higher in the class hierarchy, and the newly assigned class is a parent of the current class. For example, reclassifying a CI from the `cmdb_ci_server` class to the `cmdb_ci_computer` class.

For example, the `cmdb_ci_server` class has attributes that the `cmdb_ci_computer` class does not have. During the downgrade, these attributes and their respective values are not included in the new CI record that is inserted into the `cmdb_ci_computer` class.

**Upgrade**

The CI class is updated to a class that is lower in the class hierarchy, and the newly assigned class is a derived child of the current class and has additional attributes. For example, reclassifying a CI from the `cmdb_ci_computer` class to the `cmdb_ci_server` class.

**Switch**

The newly assigned class is in a different branch in the class hierarchy and has a different set of attributes than the current class. For example, reclassifying a CI from the `cmdb_ci_linux_server` class to the `cmdb_ci_win_server` class.

A switch is a combination of a downgrade and an upgrade. For example if the CI is downgraded to the `cmdb_ci_server`, and then upgraded to the `cmdb_ci_win_server` class. Therefore, attributes are lost in the same manner as in a downgrade operation.
Avoid the CI class downgrade and CI class switch operations as those can lead to data loss. When automatic CI reclassification is enabled (which is by default), the identification process can result in some automatic reclassifications which lead to data loss.

For information about CI reclassification by the Identification and Reconciliation Engine (IRE) and related system properties that control the behavior of automatic CI reclassification, see CI reclassification during IRE processing.

**Procedure**

1. Locate the CI that you want to reclassify and display it in a list view.
   You can use the application navigator. Or for example, if the CI is a server, then in the navigation search box, type `cmdb_ci_server.list` to display the CI in the **Servers** view.

2. Ensure that the **Class** field is displayed in the list.
   If you do not see this attribute, personalize the list to add the **Class** field.

3. Double-click the **Class** value for the CI, and select a new class.

4. Click the green check box to confirm your selection.

**Delete CIs for a CMDB class**

You can use the CI Class Manager to delete CIs that are no longer needed.

**Before you begin**

Role required: itil_admin

**Procedure**

1. Navigate to **Configuration > CI Class Manager**.

2. Click **Hierarchy** to expand the CI Classes list and then select the class from which you want to delete CI records.

3. In the class navigation bar on the left, click **CI List**.

4. On the CI List form view, select the CIs that you want to delete.
   Select the check box in the header to select all the CIs that are visible.

5. Click **Actions on selected rows** and then click **Delete**.

6. Click **Delete** in the **Confirmation** dialog box.

**View and edit class definitions and metadata**

Use the CI Class Manager as a central location to explore the CMDB class hierarchy, CI table definitions, and class CIs. View the details of each table such as its label and fields, relationships, and all related metadata definitions.
About this task
The CI Class Manager displays the entire CMDB class hierarchy in a tree-view format, consolidating class definitions into a central location. It lets you display metadata information for a class, such as reconciliation rules, mandatory and recommended fields, and audit templates. You can also select a specific class to view, to modify, or to extend its definition to create a derived class. For each class, you can directly access CMDB Health settings, identification and reconciliation rules, orphan scorecard, and certificate template, defined for the class.

For more information about extending a class and how attributes are derived from a parent class in that process, see Table extension and classes.

Procedure
1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to expand the CI Classes list and then select a class to display details for.
3. On the class navigation bar, expand the following items to display further details for the class.
   - Class Info:
     - Basic Info: Displays details for the selected class, such as the display and table name, description, and class icon. Lets you edit some of the class definitions, and prevents editing of some details such as the table name. Role required: itil for reading, and itil_admin and personalize_dictionary for writing.
     - Attributes: Displays table attributes (columns). Lets you edit those attributes and add new ones. For description of the different attributes in the list view, see Dictionary entry form. Role required: personalize_dictionary and itil_admin for editing, and personalize_dictionary and itil for reading

To add an attribute:

a. Click the Added tab and scroll to the bottom of the list.
b. Double-click Insert new column, and enter details for each new class attribute. Set Identification to true to designate an attribute as a CI identifier for class identification.
c. Click Save, and fix any errors that appear.

- Identification and Reconciliation: Displays and lets you edit, create, and delete identification and inclusion rules, reconciliation and data refresh rules for the class.
See CMDB Identification and Reconciliation for more information.
Role required: itil for reading, and itil_admin (on top of itil) for writing.

- **Dependent Relationships**: Displays and lets you edit, create, and delete hosting and containment relationships for the class. See CMDB dependent relationship rules for more information.

  Role required: itil for reading and itil_admin (on top of itil) for writing.

- **Suggested Relationships**: Displays a diagram of all suggested relationships for the class, and lets you delete or add suggested relationships for the class. Use the navigation tools to increase or decrease the diagram, and to move the diagram on the page. Use the filter to display specific relationship types. See Suggested class relationships for more information.

  Role required: itil

- **All Relationship Rules**: Displays a combined diagram of all suggested relationships and all dependent relationships for the class. Use the navigation tools to zoom in or out, and to move or center the diagram on the page. Use the filter to display specific relationship categories.

- **Health**: Lets you review and configure CMDB Health-related system properties, scorecards, and rules and settings for all CMDB health KPI and metrics, at the class level. See CMDB Health for information about enabling and configuring CMDB Health, and displaying health reports.

  Role required: Itil for reading and itill_admin (on top of itil) for writing.

- **CI List**: Displays the CIs of the selected class. Lets you create CIs of the selected class and perform other operations such as delete.

  Role required: Itil for reading. Writing requirements follow the selected table settings.

**Related information**

Create or modify map icons

Update the list of classes in the Principal Class filter

Manage the list of classes that are included in the Principal Class filter to restrict the CIs that appear in CIs list views to only specific classes that you need. You can add or remove CMDB classes from the Principal Class filter.

**Before you begin**

Role required: itil_admin and personalize_dictionary
About this task
Apply the CMDB Principal Class filter in list views of CMDB CIs so that only CIs that belong to the classes in the filter, appear. In a base system, the Principal Class filter doesn’t contain any classes. The principal class setting applies only to the current class and is not derived by child classes.
For more information about list view filters, see Save and use filters in a list view.

Procedure
1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to expand the CI Classes list and then select a class to add or remove from the Principal Class filter.
3. On the class navigation bar, navigate to Class Info > Basic Info.
4. On the Basic Info form, select or clear Principal Class.
5. Click Save.

Results
The Principal Class filter is updated with the addition or the removal of the class from the list of classes in the filter. When you apply the Principal Class filter to a Configuration Items list view, only CIs from classes included in the filter, appear.

What to do next
In both of the following scenarios, the list of CIs refreshes to display only CIs whose class is included in the Principal Class filter:

• 1. In the Filter navigator, type cmdb_ci.list and then press the Enter key.
   2. In the Configuration Items list view, click the List controls menu icon, select Filters and then click Principal Class.

• 1. Open a Change Request form.
   2. Scroll down and select the Affected CIs tab. Click Add.
   3. In the Add Affected CIs form, click the List controls menu icon, select Filters and then click Principal Class.

For more information about adding affected CIs to change requests, see Associated CIs on a change request.

Querying the CMDB
The CMDB Query Builder allows you to easily build complex infrastructure and service queries, that span multiple CMDB classes, non-CMDB tables, and that involve many CIs that are connected by different relationships.
The CMDB Query Builder provides a canvas into which you drag the CI classes that you want to include in a query. Then you add relationships, AND/OR operators between the CI classes, and define the relationship properties to query for. You can use saved queries to populate a CMDB group with CIs, and then use scriptable APIs to retrieve the CI list and apply actions collectively to all the CIs in the group.

There are two query types: CMDB Query and a Service Mapping query, which you can use separately or in combination to create queries such as:

- All hardware in my service offering that has Windows installed.
- All CIs of a certain type in an application service. For example, all Apaches/Web Servers/Linux servers per service.
- All virtual servers and the physical servers that host them.
- All servers that are not mapped to any application service.
- All application services and their associated servers and the cost of each server. This query helps evaluate the cost of technology for each application service.

**Starting node**

The starting point of the query which is labeled as **STARTING NODE** on the Query Builder canvas. The first class that you drag to the canvas becomes automatically the starting node of the query and you cannot select a different starting node. In a complex query, the starting node must always be the only node connected to an AND/OR operator. If you try to connect a second node to an operator that the starting node is connected to, the query fails to run and a prompt to select a different starting node appears.

**CMDB Query**

A query type that queries the infrastructure for CI classes and the relationships and references that connect them. You can optionally add the context of non-CMDB tables to a CMDB query.

You can include **Application services** in a CMDB query, to find, for example:

- All critical application services in your database.
- All infrastructure in a particular application service.
- All incidents for a particular CI in an application service, or all incidents for all the CIs of an application service.
- All application services with a pattern of a service connected to a database, and where the database has incidents.
The list of available non-CMDB tables includes a subset of tables within the system, which have a reference to the Configuration Item [cmdb_ci] class or its children. The list of non-CMDB tables, includes tables such as Asset, Task, and Problem. You can use the system property glide.cmdb.query.non_cmdb.blacklisted_tables to narrow down the list of non-CMDB tables to choose from.

Service Mapping Query

A query type that queries application services. The query is framed within an application service map. You define a pattern, and query for application service maps that have that pattern in their definition. The relationships in Service Mapping queries are matched by single-level direct relationships which is similar to the CMDB queries, and in addition, they are also matched by multi-level indirect relationships if they exist. A query for a relationship between two CI classes is satisfied even if the two CI classes are connected by intermediate CI classes that are not specified in the query.

Combination Query

You can combine the two query types by incorporating a saved Service Mapping query into a CMDB query. For example, create a CMDB query for Windows Servers that are connected to Tomcat WAR. Then connect the Tomcat WAR CI class to a Service Mapping query. The query changes to find Windows Servers that are connected to Tomcat WAR which is included in the services that returned by the Service Mapping query. You can inverse that query by choosing Does Not Belong To Service. This changes the query to find Windows Servers that are connected to Tomcat WAR that is not included in services returned by the Service Mapping query.

Relationship properties

When you connect CI classes on the canvas, the CMDB Query Builder displays the Connection Properties in the right-side bar, where you can configure the properties of the relationship, such as the relationship direction. For Service Mapping queries, you can configure whether to query for related or unrelated CIs.

Connection properties include:

- Relationship type: Query for CIs and descending classes with specific relationship types.
- Relationship direction: Which CI class is the parent and which CI class is the child in the relationship.
- Relationship level: Query only on first-level relationship or also on second-level relationships.
• No relationships: Query for CIs which have no relationship to the set class.
• References fields: A field that the parent and ancestor parent CI classes use to reference the child CI class.

Newly added relationships between CI classes may take up to 30 minutes to appear in the relationship list.

Related information
CMDB groups

Domain separation and CMDB Query Builder
Domain separation is supported in the CMDB Query Builder. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Overview

How domain separation works in the CMDB Query Builder
With the CMDB Query Builder you can easily build complex infrastructure and service queries that span multiple CMDB classes, and that involve many CIs that are connected by different relationships. Domain separation is set to be on by default.

• Saved Query
The user creates a query by dragging a class node from the class hierarchy and dropping it to the canvas and connecting the nodes with the relationships type.

The user can save the created query as an XML file to the database [qb_saved_query] table in the CMDB for future use. The saved query is domain separated.

• Query results
With a saved query, the user clicks Run and the query result is saved and displays in the platform list view.

In the query results, the domain separation behaves in the same way as the platform list view for the CI relationship [cmdb_rel_ci] table and CMDB CI [cmdb] table. Consequently, since the CI relationship is not domain separated, all relationships of the query result display, regardless of the domains. Conversely, if the query result is CI only, since the CMDB CI is domain separated, the results display only if visible in the current domain.
Related information

Domain separation and Configuration Management Database (CMDB)

Build a CMDB query using the CMDB Query Builder

A CMDB query type that queries the infrastructure for CI classes and optionally non-CMDB tables, and the relationships and references that connect them.

Before you begin

The UI16 plugin (com.glide.ui.ui16) must be activated.

Role required: cmdb_query_builder_read to only view and run saved queries, and cmdb_query_builder (contained for itil, itil_admin, and asset) to create and save queries, modify saved queries, and run queries.

Authorized users can update and delete a query created by another user.

About this task

Build the query by dragging the CI classes and non-CMDB tables that you want to include in the query. Then dropping them as nodes on the canvas, and defining relationship properties between them. You can filter on the attributes of any node to narrow down the results to a specific set of CIs of that class or to a single specific CI. You can also select which property columns appear in the query results.

As you step through building a query, list options and other user interface elements of the CMDB Query Builder, are dynamically filtered as appropriate to your selections.

See Sample queries for a step-by-step walk through of building CMDB queries in the CMDB Query Builder, including queries that integrate application services.

Procedure

1. Navigate to Configuration and click CMDB Query Builder.

2. On the CMDB Query Builder page do either of the following steps:
   - Click Create new. Type in a Name, choose CMDB Query as the Query type, and then click Create.
   - Click a widget of a saved query to continue building an existing query. Search saved queries first if needed.
   - Point to the upper right corner of a saved query widget, and click the Duplicate Query icon to edit a copy of a saved query. The default name of the new query contains the string 'copy'.

3. On the canvas, you can do any of the following operations:
• Add CI classes to the query: On the CMDB Classes tab, select classes from the hierarchy list and drag them to the canvas.

• Add an Application Service CI to the query: On the CMDB Classes tab, select the Application Service class from the hierarchy list and drag it to the canvas.

In Application Service Properties on the right-side bar, you can select Convert attached nodes to pattern to query on patterns between the application service and other CMDB class nodes. When querying on a pattern, the nodes on both ends of the pattern connection, can be any number of levels apart. If Convert attached nodes to pattern is not selected, then the connection between the application service node and other CMDB class nodes, represent direct relationships.

• Add non-CMDB tables to the query: Select a table from the Non-CMDB Tables list and drag it to the canvas.

  Note: A non-CMDB table cannot be the starting node in the query.

• Add connections (relationships or patterns for application services) between two nodes on the canvas:

  a. On the first node in the connection, click the small square at the center of the right side.

  b. On the second node in the connection, click the small square at the center of the left side to create the connection.

### Connection UI Notations

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full line</td>
<td>A relationship in a CMDB query.</td>
</tr>
<tr>
<td>Red asterisk at the center of the connection line</td>
<td>Information such as relationship type is missing, invalidating the query.</td>
</tr>
<tr>
<td>Levels:&lt;n&gt; Types:&lt;n&gt; or a &lt;Reference type&gt; notation on the connection line</td>
<td>As applicable: The number of relationship levels and the number of relationship types included for the connection. Or, a reference type for a relationship that is a reference.</td>
</tr>
<tr>
<td>Dashed line</td>
<td>A pattern connection between an application service node and another node.</td>
</tr>
</tbody>
</table>
• In Connection Properties on the right-side bar, configure relationship settings (click the connection line if necessary):
  a. In the Relationship Direction section, select the **Parent** node (the **Child** node automatically adjusts).
  b. In the Relationship Levels section, set **Level** to **First level relationships** if the CIs are directly connected. Or, **Up to 2nd level relationships** if the CIs are connected either directly or indirectly through another CI.
  c. In the Relationship Types and Related Items section, select either option:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Relationships</td>
<td>To query for CIs with no connecting relationships, such as All Tomcat WAR CIs which are not connected to a Windows Server.</td>
</tr>
<tr>
<td>Add Relationship Types</td>
<td>To select specific or any relationship type.</td>
</tr>
<tr>
<td>Add a Related Item</td>
<td>To query for related CIs between the nodes.</td>
</tr>
</tbody>
</table>

• Configure CI reference column for a connection to a non-CMDB table: In the Connection Properties right-side bar, in the CI Reference Column section, select the column with a reference to a CI from the **Use CI reference column** list. If only one option is available, it is automatically selected.

• Configure the pattern between an application service node set with the **Convert attached nodes to pattern** option, and a non-CMDB table node: Select **Apply <table> reference filter to all nodes in the pattern** to apply the query to the application service CI itself and to the CIs within the application service.

• Add filters to a class node: Apply filters to narrow down a class query to a specific set of CIs or to a single specific CI.
  a. Point to the node to add a filter to, and then click the **Apply filters** icon that pops up above the node.
  b. In the Filters section, add attribute and **related list conditions**.
  c. Close the **Filters** section.
  For example: Add a filter for database location to query for databases located in Seattle.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Click **Applied Filters** in the right-side bar to view all filters for each node on the canvas.

- **Add And/Or operators to the query:**
  - a. Connect one node to two other nodes.
  - b. Click the **And** box that appears on the connection line, to toggle between the **And/Or** operators.
    For example: C1 is Tomcat WAR, C2 is Linux Server, and C3 is Windows Server. Query for **All Tomcat WAR CIs which are connected either to Linux Server Or to a Windows Server**.

- **Add property columns for a node, to appear in the query results:**
  - Note: For a relationship, the query results include the **parent**, **child**, and **type** columns. You cannot add any other columns from the [cmdb_rel_ci] table.
    
    a. Click **Properties** in the right-side pane.
    b. Click a node once or twice, so that the Report Columns section appears in the right-side bar, and then click **Add Columns**.
    c. Select properties and then click outside the properties list to close it.

- **Create a combination query by integrating a Service Mapping query into a CMDB query:**
  a. When building a CMDB query, click **Saved Service Queries** in the left-side bar.
  b. Select and then drag a Service Mapping query to the canvas.
    This query returns all CIs that satisfy the CMDB query, and that are included in the services returned by the embedded Service Mapping query.

- **Add a search tag that can then be used as a search criteria for saved queries:**
  a. Click the **Add Tags** icon at the top of the canvas.
  b. Click **Add Tag** and in the **Query Tags** dialog box enter one or more tag strings.
  c. Click the **Add Tags** icon again to close the **Query Tags** dialog box.

**4. Click Save.**

On the **Saved Queries** tab, point to a saved query widget and click **Query Information**. Query details such as the query type, last update date, CMDB groups associated with the query, and the query schedules appear.
What to do next

• Click **Run**.

Only the first 100 results of the query appear in the results pane.

  ◦ Click **Load More Results** to view the next set of 100 results.
  ◦ Click **Load All Results** to view the rest of the query results, up to the number specified by the glide.cmdb.query.max_results_limit system property (10,000 by default).

Click a CI to open its CI form, and on the CI form click **Dashboard** to view CI health in the CI dashboard.

**Note:**

  ◦ Ensure that the glide.security.use_csrf_token property is set to true, allowing all results to appear.
  ◦ When **Level** is set to **Up to 2nd level relationships**, the relationship type does not appear in the query results.
  ◦ When a query is running, wait for it to complete or to time out before opening or running another query.

• **Modify Query Builder settings:** Click the **(Settings)** icon to open the **Query Builder Settings** dialog box.

• Copy and share the URL of a saved query with users that have access to the CMDB Query Builder. Pasting the shared URL in a new internet browser window, directly opens the saved query in the CMDB Query Builder.

• **Create reports in CMDB Query Builder.**

• **Create a schedule** to run the query at a future time, and to email the results to interested parties.

• **Export query results:**

    Click the Query Results context menu and select **Export**. Even if the **Load More Results** button is visible, indicating that there are additional query results, only the results that are visible are exported.

• **Export and import a CMDB query** to port a query definition between instances.

• **Populate a CMDB group** using a saved query.

**Related information**

**Sample queries**
Build a Service Mapping query using the CMDB Query Builder

The Service Mapping query type is a pattern consisting of classes and relationships between those classes. After you build the pattern and run the query, the query returns all the Service Mapping services that contain that pattern.

Before you begin

The UI16 plugin (com.glide.ui.ui16) must be activated.

Role required: cmdb_query_builder_read to only view and run saved queries, and cmdb_query_builder (contained for itil, itil_admin, and asset) to create and save queries, modify saved queries, and run queries.

Authorized users can update and delete a query created by another user.

About this task

Build the query by dragging the CI classes that you want to include in the query, dropping them as nodes on the canvas, and then defining relationship properties between them. For every class node in the query, you can filter on its attributes to narrow down the results to a specific set of CIs of that class or to a single specific CI. You can also select which property columns appear in the query results.

As you step through building a query, list options and other user interface elements of the CMDB Query Builder, are dynamically filtered as appropriate to your selections.

See Sample queries for a step-by-step walk through of building a Service Mapping query in the CMDB Query Builder.

Procedure

1. Navigate to Configuration and click CMDB Query Builder.

2. On the CMDB Query Builder page do either of the following:
   
a. Click Create new. Type in a Name, choose Service Mapping Query as the Query type, and then click Create.
   
b. Click on a widget of a saved query to continue building an existing query. Search saved queries first if needed.
   
c. Point to the upper right corner of a saved query widget, and click the Duplicate Query icon to edit a copy of a saved query. The new query's default name contains the string 'copy'.

3. On the canvas, you can do any of the following:
• Add CI classes to the query: Select classes from the CMDB Classes hierarchy list and drag them to the canvas.

• Add connections (relationships) between two nodes on the canvas:
  a. On the first node in the relationship, click the small square at the center of the right side.
  b. On the second node in the relationship, click the small square at the center of the left side to create the connection.
  c. In Connection Properties on the right-side bar, configure the following (click the connection line if necessary):
     ◦ In the Relationship Direction section, select the Parent node (the Child node automatically adjusts).
     ◦ In the Service Query Properties section, select Find Related CIs or Find Unrelated CIs to query for a pattern in which the two classes have or do not have relationships with each other, respectively.
     For example, All Tomcat WAR CIs which are not connected to a Windows Server.

<table>
<thead>
<tr>
<th>Relationship UI Notations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Notation</strong></td>
</tr>
<tr>
<td>Dashed line</td>
</tr>
</tbody>
</table>

• Add filters to a class node: Apply filters to narrow down a class to a specific set of CIs or to a single specific CI.
  a. Point to the node to add a filter to, and then click the Apply filters icon that pops up above the node.
  b. In the Filters section, add attribute and related list conditions.
  c. Close the Filters section.
      For example: Add a filter for business criticality to query for businesses that are 'most critical'.
      Click Applied Filters in the right-side bar to view all filters for each node on the canvas.

• Add And/Or operators to the query:
  a. Connect one node to two other nodes.
  b. Click the And box that appears on the connection line, to toggle between the And and the Or operators.
For example C1 is Tomcat WAR, C2 is Linux Server, and C3 is Windows Server.
Query for all Tomcat WAR CIs which are connected either to Linux Server Or to a Windows Server.

• Add property columns for a node, to display in the query results:

  Note: For a relationship, the query results display the parent, child, and type columns. You cannot add any other columns from the [cmdb_rel_ci] table.

  a. Click Properties in the right-side pane.
  b. Click a node once or twice, so that the node’s Report Columns section appears in the right-side bar, and then click Add Columns.
  c. Select properties and then click outside the properties list to close it.

• Select columns and add filters that will be applied to the resulting set of services:

  a. Select Properties in the right-side bar, and then click an empty space on the canvas to ensure that nothing is selected.
  b. Click Add Columns at the bottom of the right-side bar and select columns to add. Click outside the columns list to close it.
  c. Click the Apply Service Mapping Query Filters icon at the top of the canvas and add filters.

• Inverse the entire query and search for all Service Mapping services that do not include the query pattern:

  ◦ Click a node once or twice so that Query Properties appear in the right-side bar. In the Metadata section, toggle Services Including This Pattern to enable or disable the option.

• Add a search tag that can then be used as a search criteria for saved queries:

  a. Click the Add Tags icon at the top of the canvas.
  b. Click Add Tag and in the Query Tags dialog box enter one or more tag strings.
  c. Click the Add Tags icon again to close the Query Tags dialog box.

4. Click Save.

On the Saved Queries tab, point to a saved query widget and click Query Information to view query details such as the query type, last update date, and the query schedules.
What to do next

• Click **Run**.

The query results pane displays only the first 100 results of the query.
  ◦ Click **Load More Results** to display the next set of 100 results.
  ◦ Click **Load All Results** to display the rest of the query results, up to the number specified by the `glide.cmdb.query.max_results_limit` system property (10,000 by default).

Click a CI to open its CI form, and on the CI form click **Dashboard** to view CI health in the CI dashboard.

⚠ Note: When a query is running, wait for it to complete or to time out before opening or running another query.

• Modify Query Builder settings: Click the (Settings) icon to open the **Query Builder Settings** dialog box.

• Copy and share the URL of a saved query with users that have access to the CMDB Query Builder. Pasting the shared URL in a new internet browser window, directly opens the saved query in the CMDB Query Builder.

• Create reports in CMDB Query Builder.

• Create a schedule to run the query at a future time, and to email the results to interested parties.

• Export query results:
  Export query results that are visible: Click the Query Results context menu and select **Export**. Even if the **Load More Results** button is visible, indicating that there are additional query results, only the results that are visible are exported.

• Export and import a CMDB query to port a query definition between instances.

• Populate a CMDB group using the saved query.

Related information

Sample queries

Sample queries

Use the following sample queries to build your own CMDB queries and Service Mapping queries.

Using the CMDB Query Builder requires that the **UI16 plugin** (com.glide.ui.ui16) is activated.
CMDB query sample

Use this example to build a CMDB query to find all servers with a connection to a database.

Example:

1. Navigate to Configuration and click CMDB Query Builder
2. Click Create new. Enter a Name - All servers with a connection to a DB. Choose CMDB Query, and click Create.
3. In the CMDB Classes list, locate the Server class, and drag it to the canvas.
4. Locate the Database class, and place it to the right of the Server class node on the canvas.
5. Click at the center of the right side of Server, and then at the center of the left side of Database to create a connection.
6. Select the Server 1 node on the canvas. In the Relationship Types and Related Items section in the right-side bar, click Add Relationship Types and add all the relationships from the list.
   Note that the added relationships appear in the right-side bar, in the Relationship Types and Related Items section.
7. Click Save, and then click Saved Queries on the left to see the widget for the saved query.
8. Click the query widget to return to the canvas in edit mode.
9. Click Run to execute the query.
   Review the query results. Each row displays the name of a server CI, the name of a database CI, and the relationship type between them.
10. Add columns to the query results:
    a. Click the Server 1 node on the canvas once or twice so that the Server 1 Report Columns section appears in the right-side pane. Click Add Columns.
    b. Select Manufacturer and then click outside the columns list to close it.
    c. Click Run.
       Review the query results which now include the Manufacturer column.
    d. Click Save again to save all your customization for this query.

CMDB query sample - Application service 1

Use this example to build a CMDB query to find all critical application services, and their owner.
Example:

1. Navigate to **Configuration** and then click **CMDB Query Builder**.
2. Click **Create new**.
3. Enter **All critical application services** as the query **Name**. Choose **CMDB Query** and then click **Create**.
4. In the **CMDB Classes** list, locate the **Application Service** class, and then drag it to the canvas.
5. Add a filter to the application service node:
   a. Point to the application service node, and then click the **Apply filters** icon that appear.
   b. In the Filters section, add the condition **[business criticality] [is] [1 - most critical]**.
   c. Close the Filters section.
6. Add columns to the query results:
   a. In the Properties right-side bar, click **Add Columns**.
   b. Select **business criticality** and **owned by**, and then click outside the columns list to close it.
7. Click **Save**.
8. Click **Run** and then review the results. You can for example, locate any of the critical application services without an owner.

**CMDB query sample - Application service 2**

Use this example to build a CMDB query to find all application services, for which there is an incident or a change request, for either, the application service itself, or any CI within the service.

Example:

1. Navigate to **Configuration** and then click **CMDB Query Builder**.
2. Click **Create new**.
3. Enter **Application services with incidents or change requests** as the query **Name**. Choose **CMDB Query** and then click **Create**.
4. In the **CMDB Classes** list, locate the **Application Service** class and then drag it to the canvas.
5. Click **Non-CMDB Tables**.
6. Locate the **Incidents** class in the class hierarchy, and then drag it to the canvas.
7. Locate the **Change Requests** class in the class hierarchy, and then drag it to the canvas.

8. Connect the Application Service and the Incidents nodes, and then, in the Properties right-side bar:
   a. Select **Apply Incidents reference filter to all nodes in the pattern**.
   b. Set **Use CI reference column** to **Configuration item**.

9. Connect the Application Service and the Change Request node, and then, in the Properties right-side bar:
   a. Select **Apply Change Request reference filter to all nodes in the pattern**.
   b. Set **Use CI reference column** to **Configuration item**.

10. Click the **And** operator between the Incidents and the Change Request nodes, and switch it to **Or**.

11. Click **Save**.

12. Click **Run** and then review the results.

**CMDB query sample - Application service 3**

Use this example to build a CMDB query to find all hardware in my service offering that has Windows installed.

**Example:**

1. Navigate to **Configuration** and then click **CMDB Query Builder**.

2. Click **Create new**.

3. Enter **All hardware in my service offering that has Windows installed** as the query **Name**. Choose **CMDB Query** and then click **Create**.

4. In the **CMDB Classes** list, locate the following classes, and then drag them to the canvas.
   - Service
   - Service Offering
   - Application Service
   - Searching for infrastructure, Hardware

5. Connect the Service node to the Service Offering node.

   In the Properties right-side bar, click **Add Relationship Type** and select the **Connect to::Connected by** relationship.

6. Connect the Serviced Offering node to the Application Service node.
In the Properties right-side bar, click **Add Relationship Type** and select the **Connect to::Connected by** relationship.

7. Click the Application Service node.

   In the Properties right-side bar, select **Convert attached nodes to pattern** to include all CIs within the application service, in the query.

8. Connect the Application Service node to the Hardware node.

9. All infrastructure under Service,

10. Click **Save**.

11. Click **Run** and then review the results.

   You can click **Column options** of the Service column header, and select to **Group by Service**. Then expand a service to see all the hardware infrastructure under that service.

12. Return to the CMDB Query Builder window, to expand the query to include only infrastructure CIs on which Windows is installed.

13. Click **Non-CMDB Tables**, locate the **Software Instance** class, and drag it to the canvas.

14. Connect the Hardware node to the Software Instance node.

   In the Properties right-side bar, set **Use CI reference column** to **Installed on**.

15. Point to the Software Instance node, and click on the **Apply filters** icon that appears. In the Filters section, add the condition **[Product Name.Name] [is] [windows]**. Close the Filters section.

16. Click **Save**.

17. Click **Run** and review the new results.

**Service Mapping query sample**

Use this example to build a Service Mapping query to find all Linux servers in services.

**Example:**

1. Navigate to **Configuration** and click **CMDB Query Builder**

2. Click **Create new**. Enter a **Name** - **Linux server in services**. Choose **Service Mapping Query**, and click **Create**.

3. In the **CMDB Classes** hierarchy list, locate **Linux Server** and drag it to the canvas.

4. Click **Run**.
Review the query results. Each row displays the name of a Service Mapping Service and the name of a Linux Server that is a member of that service.

5. On the right-side pane, click **Disable Service Including This Pattern** and then click **Run** again.

Review the query results. Now, each row displays the name of a Service Mapping Service that does not include the specified Linux Server.

**Run a partial CMDB query**

You can run a partial query in the CMDB Query Builder by defining a section of a query, and then running it.

**Before you begin**

The UI16 plugin (com.glide.ui.ui16) must be activated.

Role required: cmdb_query_builder (contained for itil, itil_admin, and asset)

**About this task**

While building a query or reviewing a saved query, you can run only a section of the query. On the canvas in the CMDB Query Builder, highlight a section of the query which contains the nodes and relationships of the partial query that you want to run. You can then examine the results of the partial query, and update the query if needed.

**Procedure**

1. Navigate to **Configuration** and click **CMDB Query Builder**.
2. On the CMDB Query Builder page, click a tile to open an existing query.
3. Click the selection tool under the **navigation tool** to switch to a section selection mode.
4. Border a section of the query:
   a. Click the mouse device on the upper left corner of the section that you want to create.
   b. Drag the mouse device to the bottom right corner of the section that you want to create. As you drag the mouse device, the selected section is highlighted in light blue.
   c. Release the mouse device. The query nodes that are included in the partial query, appear with a blue border.
5. Click **Run**.
6. In the Pick Starting Node dialog box, select the starting node for the partial query, and click **Confirm**.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Results
The results of the partial query appear in the Results pane.

Batch size for CMDB Query Builder queries
In a base system, a global batch size of 100 is allocated for every Query Builder query run. If needed, you can use a system property to override the default global batch size, or optimize the batch size value per saved query.

Queries can differ widely as they can be configured to query a wide variety of classes. Therefore, the batch size in the base system might not be optimal for every query, and some queries might time out or take a long time to complete. The optimal batch size for running queries depends on system load such as amount of data and number of relationships in your system. Contact Customer Service and Support for assistance in calculating the batch size for your query.

Batch size is applicable and behaves the same in all query run scenarios, regardless of how the run was initiated:

- Query Builder user interface (ad hoc or saved query)
- Query Builder Scriptable API
- Scheduled jobs
- CMDB groups

The batch size for query runs is allocated in the following priority order:

1. The value in the **Execution Batch Size** field in the Saved Queries table, for a specific saved query. If set, this value applies only to the saved query, and has priority over the global value of 100 and the value of the `glide.cmdb.query.batch_size` system property.

2. The value of the system property `glide.cmdb.query.batch_size`, if exists, determines globally the batch size that is allocated to all query runs. If you add and set this property, the value applies to all queries, other than saved queries with **Execution Batch Size** value set.

3. A global value of 100, if the previous two options are not configured.

Modifying batch size for queries
If you are experiencing performance problems when running queries, you can modify the batch size value:

- Globally for all queries: By adding (if necessary) and setting the value of the system property `glide.cmdb.query.batch_size`.

- Per saved query: Set batch size for a specific saved query
Set batch size for a specific saved query

Configure a custom batch size for a CMDB Query Builder saved query that takes a long time to complete or that times out. A custom batch size overrides the global batch size in the base system and the value of the glide.cmdb.query.batch.size system property.

Before you begin
Role required: admin

About this task
Contact Customer Service and Support for assistance in calculating the batch size for your query. Also, see KB.... for more details.

Procedure
1. In the Filter navigator, enter qb_saved_query.list and press Enter to navigate to the Saved Queries table.
2. In the Saved Queries list view, locate the saved query for which you want to change batch size.
3. Set or modify the value in the Execution Batch Size field. Set the value to be greater than the global value in the glide.cmdb.query.batch.size property, or increase any existing value.

Navigation in CMDB Query Builder
Use the navigation tools to enlarge or shrink the query, to move the query, or to border a section of the query to run.

Using the Query Builder requires that the UI16 plugin (com.glide.ui.ui16) is activated.

Use the buttons in the navigation tool as follows:
• Use the plus sign (+) to increase magnification of the query.
• Use the minus sign (-) to decrease magnification of the query.
• Click the center dot to center the query on the canvas.
• Use the direction arrows to move the query in that direction.
• Use the selection tool under the navigation tool to toggle between two states:
Moving the entire query on the canvas.
Bordering a section of the query, which you can then run as a partial query.

Create reports in CMDB Query Builder

Use CMDB Query Builder reports to show the results of a CMDB query or a Service Mapping query. Create a basic report, or a dynamic report that automatically updates when the results of the associated saved query change.

Create a dynamic report

After running a saved query in the CMDB Query Builder, create a dynamic report that continuously updates to show the latest query results. You can use a dynamic report as any other report created using Reporting and you can add it to Performance Analytics dashboards.

Before you begin

Ensure that the query that you want to create a dynamic report for is a saved query, and that there is a specified schedule for the query. Also, run the saved query and ensure that all query results are visible.

Role required:
• To create: cmdb_query_builder and report_user
• To view: Reporting role requirements might apply, see Administering reports for Reporting role requirements.

In a base system, the cmdb_query_builder role is contained in the itil and asset roles.

About this task

The Create Report button in CMDB Query Builder which is used to create a dynamic report, is activated only if:
• The query is saved
• The query has a schedule
• The entire set of query results is present after a query run

The initial dynamic report that you create, is based on the results from the initial run of the saved query. Then, on every subsequent run of the saved query, the associated report automatically updates with the latest query results.

However, if you change the query definition itself, the query and the report are no longer in sync and you must create a new report.
Procedure

1. Navigate to **Configuration > CMDB Query Builder**.

2. In the **Saved Queries** tab, select the saved query for which you want to create a report.
   Ensure that the query has a specified schedule.

3. Click **Run** and ensure that all query results appear. Click **Load All Results** if available, to load all results.
   The **Create Report** button is enabled only if all query results are showing.

4. Click **Create Report**.
   If the CMDB Query Builder displays the query results in a new tab, then after the new tab opens with the query results, return to the CMDB Query Builder window.

5. In the Report Designer, click **Next** or **Back** to view and configure the new report in the **Data**, **Type**, **Configure**, and **Style** tabs.
   The report is pre-populated with the CMDB query results and a few other report details.
   - **Report name** is set to the name of the saved query.
   - **Source type** is set to **Data source**.
   - **Data source** is set to the table in which the query results are stored.
   - **Query Sys ID** is the ID of the latest run of the query.
   For more details about Reporting and about configuring a report in the Report Designer, see **Reporting, Creating reports**.

6. Click **Save** or **Run**.

Results
CMDB Query Builder creates a report source which you can attach to a report and use with dashboards. For more details about report sources, see **Report sources**.

What to do next
Use either of the following steps to view the new report source. The name of the new report source is set to the name of the CMDB query it was created from, and cannot be changed.

- In Query Builder, click **Saved Queries**. In the Saved Queries window, click the **Query Information** icon in the tile of the saved query. Scroll to the bottom of the information list and then click the link under **Report source**.

- Navigate to **Reports > Administration > Report Sources** and locate the new report source.
Create a basic report

After running a query in the CMDB Query Builder, you can create a basic report that is scoped to the query execution.

Before you begin

The UI16 plugin (com.glide.ui.ui16) must be activated.

Role required:

• View report: cmdb_query_builder or cmdb_query_builder_read
• Create report: cmdb_query_builder or cmdb_query_builder_read, and report_user

In a base system, the cmdb_query_builder role is contained in the itil and asset roles.

Procedure

1. Navigate to Configuration and click CMDB Query Builder.
2. Build a query.
3. In the query results pane, click the list context menu and select Bar Chart or Pie Chart.

Results

The Reports application creates a basic report, which is scoped to the query execution and is static.

Related information

Reporting

Build a CMDB query using the CMDB Query Builder
Build a Service Mapping query using the CMDB Query Builder
Run a partial CMDB query

Search saved queries

The CMDB Query Builder allows you to search for a specific saved query using any combination of search criteria based on the query’s title, type, custom tags, and who created or updated the query.

Before you begin

To locate a saved query using a Query Tags search criteria, the query must have a query tag associated with it. For more information see Build a CMDB query
using the CMDB Query Builder, or Build a Service Mapping query using the CMDB Query Builder.

The UI16 plugin (com.glide.ui.ui16) must be activated.

Role required: cmdb_query_builder (contained for itil, itil_admin, and asset)

Procedure
1. Navigate to Configuration > CMDB Query Builder.
2. In the Search Saved Queries box on the Saved Queries tab, enter a string to search for.
   The resulting list displays all search categories that can be applied using the search string.
3. Select an item from the list to add it as a search criteria.
4. Refine the search string or select additional search criteria as needed.

Create a schedule for a CMDB query
Schedule a saved CMDB query to run once at a scheduled time or on a recurring schedule, and to email the query results to specified users.

Before you begin
The UI16 plugin (com.glide.ui.ui16) must be activated and a saved CMDB query that was built in the CMDB Query Builder must exist.

Role required: cmdb_query_builder (contained for itil and asset)

About this task
The query results are attached to the email as a file in the specified format. By default, the maximum result rows that can be attached is 10,000. This is controlled by a system property.

Procedure
1. If need to, navigate to Configuration, click CMDB Query Builder, and then click a saved query.
2. Click Create Schedule and fill out the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query</td>
<td>The query to run.</td>
</tr>
<tr>
<td>Users</td>
<td>Users who should receive query results email.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>To receive emails, users must have an Email address defined and have Notifications set to Enable in their user records.</td>
<td></td>
</tr>
<tr>
<td>Groups</td>
<td>Groups to email the query results to.</td>
</tr>
<tr>
<td>Zip output</td>
<td>Indicates whether the report should be sent as a zip file.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates whether to run the query according to the specified schedule.</td>
</tr>
<tr>
<td>Run</td>
<td>Frequency for running the query.</td>
</tr>
<tr>
<td>Time</td>
<td>Time of day to run the query.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Indicates whether to display the <strong>Condition</strong> field, which allows you to specify conditions under which the query runs.</td>
</tr>
<tr>
<td>Omit if not records</td>
<td>Indicate whether to distribute email if the query returns zero results.</td>
</tr>
<tr>
<td>Email addresses</td>
<td>Email addresses of users who should receive the email but who are not in the system.</td>
</tr>
<tr>
<td>Subject</td>
<td>Text that appears in the subject line of the distribution email.</td>
</tr>
<tr>
<td>Introductory message</td>
<td>Additional message that is delivered with the query results.</td>
</tr>
<tr>
<td>Condition</td>
<td>User-created script that checks for certain conditions to be true before running the query.</td>
</tr>
<tr>
<td></td>
<td>This field is visible only when <strong>Conditional</strong> is checked.</td>
</tr>
<tr>
<td>Type</td>
<td>File format to use for the query results.</td>
</tr>
</tbody>
</table>

**Note:** Configure the form layout to add this field to the form.
Export and import a CMDB query

Export a saved CMDB or Service Mapping query definition to an XML file which you can later import and run in the CMDB Query Builder. This process lets you port a saved query between instances, such as from a development environment to a production environment.

Before you begin

• You must save a query before you can export it.
• Domain in an exported query must be visible in both, source and destination instances.

Role required: cmdb_query_builder (contained in itil, itil_admin, and asset).

About this task

When exporting a combination query, the integrated Service Mapping query definition is included in the exported query.

For backward compatibility, you can alternatively Export and import a query as an update set.

Procedure

1. Navigate to Configuration > CMDB Query Builder.
2. Export a saved query:
   a. In the Saved Queries tab, in either list view or card view, select a saved query.
   b. Click the Export query icon at the top of the Query Builder canvas.
   c. Wait for the Query Export Complete message to appear and then click Download.
      You can now access the query XML file.
3. Import a saved query:
   a. In the Saved Queries tab, click the Import query icon at the top of the CMDB Query Builder window.
   b. In Finder, select the saved query XML file and click Open.
      The imported query is available in the Saved Queries tab of the CMDB Query Builder on the instance.
Export and import a query as an update set

Export a saved query definition to an XML file as an update set, which you can later import.

Before you begin
Role required: To export — cmdb_query_builder (contained in itil and asset). To import — user with permission to import an update set.
Domain in the exported query must be visible in both, source and destination instances.

About this task
Export a query definition as an update set which you can later import and commit. This process lets you port a query between instances, such as from a development environment to a production environment. For more information about exporting and then committing update sets using XML files, see Save an update set as a local XML file.

When exporting a combination query, the integrated Service Mapping query definition is included in the exported update set.

Procedure
1. Export a saved query:
   a. In the Filter navigator, enter qb_saved_query.list and hit Enter to navigate to the Saved Queries table.
   b. In the Saved Queries list view, select the query that you want to export.
   c. Click Actions on selected rows and then select Export query.
   d. Wait for the Query Exporter to complete the export.

2. Import the exported saved query:
   b. On the Retrieved Update Sets form, click Import Update Sets from XML.
   c. On the Import XML page, click Choose file and select the exported XML file. Then click Upload.
   d. Open the new record that was added to the Retrieved Update Sets list view.
   e. On the Retrieved Update Set form, click Preview Update Set Batch and then close the Batch Update Set Preview dialog box.
   f. Click Commit Update Set Batch and then close the Commit Update Set Batch dialog box.
Results
The imported query is added to the Query Builder saved queries on the instance.

Settings for CMDB Query Builder
Use settings to control some aspects of the CMDB Query Builder behavior.

Using the Query Builder requires that the UI16 plugin (com.glide.ui.ui16) is activated.

Open the Query Builder Settings dialog box:
1. Navigate to Configuration and click CMDB Query Builder.
2. On the CMDB Query Builder page, click the (Settings) icon.
3. Click the Settings icon again to close the dialog box.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Relationships in Results</td>
<td>Display the relationship between CIs in the query results.</td>
</tr>
<tr>
<td>Display Suggested Connections</td>
<td>Filter the CMDB classes and the non-CMDB tables lists in the left pane to</td>
</tr>
<tr>
<td></td>
<td>display only classes and tables that the selected node on the canvas has a</td>
</tr>
<tr>
<td></td>
<td>relationship with. You can then drag any item from the filtered list to</td>
</tr>
<tr>
<td></td>
<td>the canvas, and connect it to the selected node on the canvas.</td>
</tr>
<tr>
<td></td>
<td>This setting applies only to CMDB queries.</td>
</tr>
<tr>
<td>Display Results in New Tab</td>
<td>Display query results in a separate browser tab titled Query Results.</td>
</tr>
</tbody>
</table>

Properties for CMDB Query Builder
Use the CMDB Query Builder properties to configure query processing.

These properties are available for CMDB Query Builder. To view and edit these properties, the admin role is required.

Note: To open the System Properties [sys_properties] table, enter sys_properties.list in the navigation filter.
### Properties for CMDB Query Builder

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Limits the number of results for a scheduled query and in the results section in the Query Builder when you click **Load All Results**. glide.cmdb.query.max_results_limit | • Type: integer  
• Default value: 10000  
• Location: Configuration > CMDB Properties > Query Builder Properties |
| Time limit (in seconds) for running one batch to get one batch of query results (100 results). glide.cmdb.query.batch_time_limit_in_sec | • Type: integer  
• Default value: 300  
• Location: Configuration > CMDB Properties > Query Builder Properties |
| Time limit (in seconds) for running an entire query to get all results. glide.cmdb.query.query_time_limit_in_sec | • Type: integer  
• Default value: 1800  
• Location: Configuration > CMDB Properties > Query Builder Properties |
| Blacklist of non-CMDB tables that appear in the CMDB Query Builder when creating a CMDB query. glide.cmdb.query.non_cmdb.blacklisted_tables | • Type: string  
• Default value: empty  
• Other values: Comma separated list of table names (not labels). Can include '*abc' to exclude all tables containing 'abc' in their table name.  
• Location: Configuration > CMDB Properties > Query Builder Properties |
| glide.cmdb.query.batch_size                                      | Batch size allocated globally when saved queries run.  
• Type: integer  
• Default value: 100  
• Location: Add to System Properties [sys_properties] table. |
CMDB Search

Query on CMDB CIs and relationships by entering a search text with configurable synonyms and stop words, which CMDB Search converts into a properly formulated query.

CMDB Search is integrated into global text search, providing enhanced capabilities for searching the CMDB. CMDB Search is designed to search within CMDB tables and relationships, allowing for queries that are more complex than basic text search. For example, you can query for all Tomcat instances that are running on Linux, or for all applications of a specific version that are running on Linux.

CMDB Search parses the search text that you enter, to formulate a properly formatted query that runs on the CMDB. Your search text can include plain words which are then parsed to identify any CMDB table, column, or relationship names. CMDB Search also uses synonyms and stop words to replace any plain text strings within your search text.

Localization is not supported for CMDB Search. In a localized instance, query words such as CI, relationship, or server, must be in English.

Stop Words

A collection of words that are ignored when CMDB Search parses your search text. When CMDB Search finds a stop word in your search text, that word is ignored. CMDB Search provides default stop words such as 'if', 'me', and 'have'. You can delete or add stop words.

To view stop words, navigate to Configuration > CMDB Search > Stop Words.

Relation Synonyms

A collection of synonyms for relationships. CMDB Search searches your search text for strings that match any relationship synonym. For any such string that is found, CMDB Search replaces that string with the relationship type specified in the relation synonym. CMDB Search provides relationship synonyms for common words that stand for any relationship between two tables. For example, the strings "connect", "in", and "on" in your search text, are all treated as a general reference to a relationship, without specifying any relationship in particular. You can modify, delete, or add relationship synonyms.

To view relationship synonyms, navigate to Configuration > CMDB Search > Relation Synonyms.

CI Class Synonyms
A collection of synonyms for CI classes. CMDB Search searches your search text for strings that match any CI class synonym. For any such string that is found, CMDB Search replaces that string with the CI class name specified in the CI class synonym. CMDB Search provides at least one default CI class synonym for each CMDB table. Most default CI class synonyms are the class label. You can modify, delete, or add CI class synonyms.

To view CI class synonyms, navigate to Configuration > CMDB Search > CI Class Synonyms.

Column Synonyms

A collection of synonyms for table columns. CMDB Search searches your search text for strings that match any column synonym. For any such string that is found, CMDB Search replaces that string with the column name specified in the column synonym. CMDB Search provides at least one default column synonym for each table column in the CMDB. Most default column synonyms are similar to the column name itself. You can modify, delete, or add column synonyms.

To view column synonyms, navigate to Configuration > CMDB Search > Column Synonyms.

CMDB Search supports domain separation, searching CIs according to the user domain.

Plugin

To use CMDB Search, activate the CMDB Search (com.snc.cmdb_search) plugin. Activating CMDB Search triggers Zing text search indexing of all CMDB tables, since the Zing search engine is required for some CMDB Searches.

Search text format and examples

The format of the search text is:

```
(<CI class name> (<attribute> "value")* (<relationship>)* )*
```

Consisting of a table name, followed by pairs of '<column> "<value>"', without any separating commas, and with values surrounded by quotation marks. For column, table, and relationship names, you can search by actual names, labels, or synonyms, and column names can be omitted.

Examples:

- application runs on ci name "ciname"
- application name "JBoss Server13" version "1.0.0.0" on tomcat name "Tomcat10" version "2.1"
• tomcat on linux
• tomcat name “My Tomcat” version “2.0” running on linux server name “Linux8”
• tomcat “My Tomcat”
• tomcat name “My Tomcat”
• tomcat name related to Linux server “my server”
• tomcat name related to Linux server ip 1.1.1.1
• services related to tomcat “my tomcat”
• CI impacted by service “EmailService”

Sometimes the search text contains a name, such as Port, which is both a class and a column name. In this situation, the CMDB Search strategy is to first search for a class with the specified name, and then search for a column with the specified name. If this strategy does not yield the expected results, then use the actual class or column name to prevent ambiguity.

Results
Up to 10 query results appear after running the query. To view any additional results, click View all <record> matches. The total number of results that you can view depends on the value of the cmdb.search.rows.limit system property, which is set to 100 by default. You can increase this property value, or you can change the query to return a smaller number of results. Increasing the number of query results might impact performance.

Add synonyms and stop words to CMDB Search
Create, delete, or modify CI class synonyms, column synonyms, relationship types synonyms, and stop words for CMDB Search.

Before you begin
The CMDB Search (com.snc.cmdb_search) plugin must be activated.
Role required: cmdb_read

About this task
You can add any number of synonyms or stop words. There can be multiple synonyms for the same CI class, column, or relationship type.
Procedure

• Add a CI class synonym:

1. Navigate to Configuration > CMDB Search > CI Class Synonyms.

2. Click New and fill out the CMDB Search CI class synonym form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Designates that the synonym is in effect.</td>
</tr>
<tr>
<td>Synonym</td>
<td>String to replace with CI type when parsing the search text.</td>
</tr>
<tr>
<td>CI class</td>
<td>The CMDB class for which the synonym applies.</td>
</tr>
<tr>
<td>Is attribute value</td>
<td>Designates that the synonym is applied only for CIs with an attribute whose value equals the synonym. When checked, the synonym is searched through the columns of the CI class. For example, 'Ubunto' is specified as a synonym for the cmdb_ci_linux_server CI class, but only if one of the CI's attributes (such as operating system) is 'Ubunto'.</td>
</tr>
</tbody>
</table>

3. Click Submit.

• Add a column synonym:

1. Navigate to Configuration > CMDB Search > Column Synonyms.

2. Click New and fill out the CMDB Search column synonyms form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Designates that the synonym is in effect.</td>
</tr>
</tbody>
</table>
3. Click **Submit**.

• Add a relationship type synonym:

1. Navigate to **Configuration > CMDB Search > Relation Synonyms**.

2. Click **New** and fill out the CMDB Search relation synonym form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column</td>
<td>The CMDB column for which the synonym applies.</td>
</tr>
<tr>
<td>Synonym</td>
<td>String to replace with <strong>Column</strong> when parsing the search text.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

• Add a stop word:

1. Navigate to **Configuration > CMDB Search > Stop Words**.

2. Click **New** and fill out the Stop Words form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Designates that the synonym is in effect.</td>
</tr>
<tr>
<td>Synonym</td>
<td>String that represents any relationship type.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
Results
When parsing a search text in the global text search box, CMDB Search uses all synonyms and stop words.

Components installed with CMDB search
Several types of components are installed with activation of the CMDB Search (com.snc.cmdb_search) plugin, including tables and properties.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronize CMDB Search synonyms for new CIs and Columns</td>
<td>Synchronizes new CI types and new columns to synonym tables. Runs once a day.</td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI synonyms [search_cmdb_ci_synonym]</td>
<td>CI class synonyms used by CMDB search when parsing search text.</td>
</tr>
<tr>
<td>Column synonyms [search_cmdb_column_synonym]</td>
<td>Column synonyms used by CMDB search when parsing search text.</td>
</tr>
<tr>
<td>CMDB Search classifier synonyms [search_cmdb_classifier_synonym]</td>
<td>Relationship types synonyms used by CMDB search when parsing search text.</td>
</tr>
</tbody>
</table>

Properties installed

Note: To open the System Property [sys_properties] table, enter sys_properties.list in the navigation filter.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cmdb.search.raws.limit</td>
<td>Maximum number of records to include in the query results.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb.search.timeout.sec</td>
<td>Number of seconds to wait before timing out the query.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 45</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties [sys_properties] table.</td>
</tr>
</tbody>
</table>

CMDB groups

A CMDB group is a collection of CIs that lets you apply CI actions collectively to all the CIs that are members in the group.

For example, a CMDB CI Lifecycle Management API can use a CMDB group scriptable API to retrieve the group's list of CIs, and then apply a CI Lifecycle Management action collectively to all the CIs. You can also use a CMDB group with the Dynamic CI Group service population method, to populate an application service.

Group type

A CMDB group is configured with a group type. If a CMDB group is set with the Health group type, then the CIs in the group can be monitored by CMDB Health, and the aggregated health is reported for the group as a whole in the CMDB group view dashboard. For example, you can monitor health only for CIs in a specific location.

Populate a CMDB group

Depending on the group type, you can populate a CMDB group by manually adding individual CIs, selecting saved CMDB queries, or building encoded queries in the CMDB group itself. The resulting CIs from each query are added as members to the group.

Before you begin

Roles required:

• To view CMDB groups - itil
• To use a CMDB queries - cmdb_query_builder on top of itil
• To manually add CIs - itil or asset
Also, to populate a CMDB group using a CMDB query, a saved CMDB query must exist.

Procedure

1. Navigate to **Configuration > CMDB Group**.
2. In the CMDB Groups pane, click **New**.
3. Fill out the form, right-click the title bar and select **Save**.

### CMDB Group form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Name</td>
<td>A unique name for the group.</td>
</tr>
</tbody>
</table>
| Group type                 | • **Default**: Basic group type which can be populated by manually adding CIs, saved queries, and encoded queries.  
                             | • **Health**: Sets CMDB Health to monitor the health of the group CIs and aggregate health results for the group as a whole. Can be populated only by encoded queries.  
                             | **Note**: Dynamic filters are not supported when populating this type of CMDB groups. |

4. To use saved CMDB queries:
   a. Click **CMDB Group Contains Saved Queries** and then click **Add Query**.
   b. Select a query from the **Query Builder Saved Query** list.
   c. Click **Submit**.
      The query that is used returns a list of CIs of the class in the starting node of the query.

5. To manually add CIs:
   a. Click **CMDB Group Contains Configuration Items** and then click **Edit Manual CI**.
   b. Optionally, add filters.
   c. Select CIs in the **Configuration Item** list and click the '+' icon at the bottom.
d. In the Group members list, select the CIs to add to the group.

e. Click Save or Save and Exit.

f. In the Save Confirmation dialog box, click OK.

g. Click Submit.

6. To use encoded queries:

a. Click CMDB Group Contains Encoded Queries and then click New.

b. Select a class for which the encoded query applies to and add conditions to build a query. The resulting CIs are included in the group.

Note: Dynamic filters aren’t supported for CMDB health-type groups, even though it’s possible to add them in a condition clause.

c. Click Submit.

What to do next
Click Show All CI to show all CIs from all the result columns of the query. However, only CIs from CMDB tables are shown.

Show CI Lifecycle Management details for CMDB group CIs
Display CI Lifecycle Management operational state and CI actions that apply to the CIs that are members of a CMDB group.

About this task
If the CMDB group is based on a CMDB query, then the query runs in real-time and displays the resulting CIs. If the query does not complete successfully due to timing out or for other reasons, then appropriate error messages are displayed.

Procedure
1. Navigate to Configuration > CMDB Groups.

2. On the CMDB Groups page, click a CMDB group.

3. Click Show All CI.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Item</td>
<td>CI group member.</td>
</tr>
<tr>
<td>Class</td>
<td>Class of CI group member.</td>
</tr>
</tbody>
</table>
### Application services

Understand application services, learn about different application service types and how multiple ServiceNow® business units and products use them.

#### What application services are

An application service is a set of interconnected applications and hosts which are configured to offer a service to the organization. Application services can be internal, like an organization email system or customer-facing, like an organization website. For example, creating financial reports through a web-based application requires a computer, web server, application server, databases, middleware, and network infrastructure. These applications and hosts are all configured to offer the service of financial reporting. In development environments, application services represent instances of a business application or system in different types of development environments, like development, test, or production.

ServiceNow applications refer to devices and applications that comprise an application service as configuration items (CIs). The various CIs and the relationships between them, that comprise an application service, are stored in the Configuration Management Database (CMDB).

Each application service contains an entry point as the top-level CI. An entry point is how clients access an application service. Typically, it is a URL, or a combination of the IP address and port for application services in enterprise deployments. For cloud-based deployments, an entry point can be a URL to a cloud resource like an gateway.
The Common Service Data Model (CSDM) helps you streamline service types and service offerings. You can add relationships between application services and other service-related objects in the CSDM: Business Application, Technical Service Offerings, or Business Service Offerings.

There are the following types of application services:

**Discovered**

Service Mapping discovers application services using patterns and by following traffic connections.

Pattern-based discovery creates precise and complete application services that represent the service-centric view of the IT infrastructure. It creates a high-fidelity map that is well suited to managing mission-critical application services.

In addition, it provides visibility of cloud-native services such as compute, load balancers, and API gateways. You can use service entry points such as S3 buckets, API gateways, Lambda functions, and functions to map services. It can also detect
Lambda to Lambda calls and Lambda to RDS connections to build dynamic service maps.

Top-down method maps VMs on-premises and in public clouds. However, it requires these VMs to be fully discovered for the top-down discovery to determine which applications are running in the VM. If a VM isn’t fully discovered, use the tag-based method to bridge the gap (see later in this document). Tag-based mapping also maps containers, that you cannot map using the top-down discovery.

Discovered application services have the service classification of application service. They are stored in the Mapped Application Service [cmdb_ci_service_discovered] table.

Dynamic CI Group

These application services are dynamic CI group CIs which act as application services. The members of the CMDB group that is associated with the dynamic CI group, populates the application service.

If created from the wizard, the service classification is application service, and if created from the legacy Event Management UI or Service Mapping UI, the classification is technical service. Application services of the Dynamic CI Group type are stored in the Dynamic CI Group [cmdb_ci_query_based_service] table.

Tag-based

A tag is a label that consists of a key-value pair. Your organization may use tags to categorize its assets, to enhance query and reporting capabilities. Discovery and Cloud Provisioning and Governance can discover tags used by all major cloud providers and container ecosystems. Once the tags are discovered, Service Mapping can create application services based on these tags. For example, you can use tags to map all application services your organization uses in the production environment in the EMEA region.

Tag-based application services have the service classification of application service. They are stored in the Tag-based Application Service [cmdb_ci_service_by_tags] table.

Created Manually

With manual mapping, application owners manually document the applications, IT infrastructure, and relationships that support each application service. This methodology is the best fit for configuration items that are not fully discoverable due to security access issues.
For example, IPS devices which support an intrusion prevention service for the security business unit.

Try to avoid manual mapping wherever possible. It’s incredibly time consuming to map services manually, and often the information needed for mapping is not available due to evolving technology and a lack of processes that track and document the infrastructure dependencies needed for application context. And, whenever subsequent changes are made to the application service topology, the service map must be manually updated.

Manually created application services have the service classification of application service. Application services of the created manually type are stored in the Mapped Application Service [cmdb_ci_service_discovered] table.

**Dynamic**

A dynamic application service includes only CIs that are part of CI relationships stored in the CMDB CI Relationship [cmdb_rel_ci] table.

You can’t edit a dynamic application service by directly adding or removing CIs from it. Dynamic application services are updated automatically to reflect any change to CI relationships in the CMDB CI Relationship [cmdb_rel_ci] table. When you add a relationship to a CI that is contained in a dynamic application service, then that service automatically updates to reflect the addition of the relationship and the associated new CI. In a similar manner, a dynamic application service automatically updates upon the removal of a relationship and its associated CI from a CI within the service.

The only way to create dynamic application services, is by converting legacy business services or legacy manual services (created with Event Management, for example) into application services of the dynamic type.

Dynamic application services have the service classification of application service. Dynamic application services are stored in Calculated Application Services [cmdb_ci_service_calculated] table.

**Who uses application services**

Application services provide foundation for operation of the following business units and products of the Now Platform:
- **ITOM Health** gathers alerts from infrastructure events captured by third-party monitoring tools. It then uses IT-related information gathered by Discovery to map alerts to configuration items. Based on the collected information, then provides dashboards showing a consolidated view of all service-impact events.

- **ITOM Optimization** gives you tools to provision private and public cloud infrastructure and services and to achieve consistent management and cost visibility. The **Cloud Insights** application, available in the ServiceNow Store, helps you to analyze the full range of costs associated with cloud assets so you can identify and take action on opportunities to save money and optimize operations.

- **IT Service Management** users rely on the application services reflecting the IT infrastructure to manage and deliver services to their customers.

- **Customer Service Management** users efficiently diagnose and resolve issues related to the IT infrastructure in the context of application services.

- **Software Asset Management** users understand the software running in your IT environment and track configurations that impact software license consumption across your IT environments and datacenters.

- **IT Business Management** users utilize data collected for application services to gain a comprehensive understanding of the applications used in your organization.

- **Security Operations** users view security incidents to find out which application services are at risk. They also use this information to prioritize and resolve threats based on the impact they pose to their organization.

### How to create application services

Depending on the needs of your organization, you can deploy different methods of creating and populating application services.

**Important:** You can use the top-down and manual methods for the same application service. You cannot combine any other methods for creating or populating the same application service.

Analyze the IT infrastructure and service deployment in your organization to pick the optimal method of creating and populating application services.

### Choosing the right method for your deployment

<table>
<thead>
<tr>
<th>Method</th>
<th>When to use</th>
<th>Additional considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top-down discovery</td>
<td>Use this method to discover industry-</td>
<td>Pattern-based mapping requires configuring</td>
</tr>
</tbody>
</table>
Choosing the right method for your deployment (continued)

<table>
<thead>
<tr>
<th>Method</th>
<th>When to use</th>
<th>Additional considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Mapping</td>
<td>recognized or customized second-tier and third-tier applications. Such</td>
<td>credentials, users, and user permissions to let Service Mapping access applications inside your organization's private network. This process may take time and effort.</td>
</tr>
<tr>
<td></td>
<td>applications may include load-balancing solutions, application or web</td>
<td></td>
</tr>
<tr>
<td></td>
<td>servers with database connections.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Traffic-based discovery is a complimentary method that enriches the results of top-down discovery.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tag-based</td>
<td>Map resources on cloud workloads like IaaS/ Paas/FaaS/CaaS as well as on container workloads using Kubernetes, OpenShift, or ECS.</td>
<td>Unlike other mapping methods, tag-based mapping doesn't require configuring credentials or providing users with elevated rights. Tag-based application services may not include relevant CIs, if these CIs don’t have correct tags assigned to them.</td>
</tr>
<tr>
<td></td>
<td>Also, map resources in the Site Reliability Engineering (SRE) or Customer Reliability Engineering (CRE) deployments.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Using tag-based method, you can map</td>
<td></td>
</tr>
</tbody>
</table>
Choosing the right method for your deployment (continued)

<table>
<thead>
<tr>
<th>Method</th>
<th>When to use</th>
<th>Additional considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag-based service mapping complements top-down service mapping. It provides visibility of containers and also maps VMs that aren’t fully discovered, which top-down service mapping is unable to do. However, while tag-based mapping associates tagged components with specific application services, it doesn’t map the connections between these components—This is another reason why tag-based mapping complements rather than replaces top-down service mapping.</td>
<td>container resources in your deployments. Typically, you use this method to discover applications on cloud virtualizations or PaaS deployments.</td>
<td></td>
</tr>
<tr>
<td>Ingesting Application Performance Management (APM) maps from integrated Dynatrace or AppDynamics deployments Create application services using the integration with AppDynamics application model and Dynatrace monitoring platform available on ServiceNow Store.</td>
<td>Use this integration to create application services based on APM maps from Dynatrace or AppDynamics. You are able to use application services created by this method for monitoring Health.</td>
<td>Analyze discovered resources in the CMDB before ingesting from 3rd party to avoid creating duplicate CIs.</td>
</tr>
<tr>
<td>Method</td>
<td>When to use</td>
<td>Additional considerations</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Dynamic CI Group</strong></td>
<td>Use this method as a simple and fast way to create dynamic CI groups for deployments including Microsoft Active Directory, Microsoft Exchange or other DNS-related services. Dynamic CI Groups are especially useful if only a list of resource is available, without configuration details or credentials. Using a CMDB group lets you use CMDB Health to monitor health, and use a CMDB Query Builder saved query to filter for the CIs included in the application service.</td>
<td>There is no map view for application services created using this method. You can only view CIs belonging to such an application service as a list. Need to ensure that the CMDB group accurately filters for the CIs that should be included in the application service.</td>
</tr>
<tr>
<td><strong>Application service API</strong></td>
<td>Create an automation for creating application services in bulk. Use this method, if your organization has performed cross-organization mapping and analysis and collected some information about services. Application services created using APIs belong to the manual type are stored in the Mapped</td>
<td>Use this method for environments that require tracing of DevOps Continuous Integration/Continuous Deployment (CI/CD) process. You can import third-party service maps into manual application services individually or in bulk. For example, see the Digital Guidebook: Importing 3rd-party service maps into ServiceNow Service Mapping. Be familiar with the exact service structure: sys_id of each CI comprising the service and the hierarchy that the CIs form. This method requires knowledge of the scripting infrastructure that your organization uses.</td>
</tr>
</tbody>
</table>
Choosing the right method for your deployment (continued)

<table>
<thead>
<tr>
<th>Method</th>
<th>When to use</th>
<th>Additional considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Service [cmdb_ci_service_discovered] table.</td>
<td>Use the manual method if you can’t use other methods of creating or populating application services. Create application services manually for intrusion prevention.</td>
<td>This method doesn't require any preexisting setup or object configuration. You can include CIs of any class in manually created application services. Manually created application services reflect some changes to CIs, like CI attributes. However, they do not automatically reflect changes to CI relationships.</td>
</tr>
<tr>
<td>Creating manual application services</td>
<td>Alternatively, create and populate manual application services by converting business services created in the CMDB and stored in [cmdb_ci_service]. Use this method to transform legacy business services into application services that other ServiceNow products can utilize. For example, dynamic application services can be used for service monitoring and change management.</td>
<td>You can’t edit a dynamic application service by adding or removing CIs from it. The system automatically modifies an application service of the dynamic type when you modify relevant relationships for CIs that are part of that application service.</td>
</tr>
<tr>
<td>Convert legacy business services into dynamic application services</td>
<td>To conform with Common Service Data Model, convert legacy business services created in the CMDB and stored in [cmdb_ci_service]. Conversion from legacy business services or from legacy manual services, is the only way to create application services of the dynamic type.</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Choosing the right method for your deployment (continued)

<table>
<thead>
<tr>
<th>Method</th>
<th>When to use</th>
<th>Additional considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Convert legacy manual services into dynamic application services</strong></td>
<td>Use this method to transform legacy manual services into application services that other ServiceNow products can utilize. For example, dynamic application services can be used for service monitoring and change management.</td>
<td>You can't edit a dynamic application service by adding or removing CIs from it. The system automatically modifies an application service of the dynamic type when you modify relevant relationships for CIs that are part of that application service.</td>
</tr>
<tr>
<td><strong>From CSV file</strong></td>
<td>If necessary, you can import service candidates from multiple CSV files.</td>
<td>Organize all the collected information in a specific order in a CSV file, precisely as described in the documentation.</td>
</tr>
</tbody>
</table>

Conversion from legacy business services or from legacy manual services, is the only way to create application services of the dynamic type.

Service Mapping extracts information from this file and creates potential application services referred to as service candidates. Use this method, if your organization has performed cross-organization mapping and analysis and collected some information about services.

To comply with CSDM 2.0, convert manual services created using IT Operations Management Event Management and stored in [cmdb_ci_service_manual] as covered in or . Converted services become application services of the manual type stored in the Mapped Application Service [cmdb_ci_service_discovered] table.
Domain separation

Domain separation, if deployed, impacts application services as follows:

• When creating an application service, the application service is assigned to the user’s domain.

• When manually adding a CI to an application service, you can choose only CIs that belong to the service domain.

• When using the `createOrUpdateService - POST` REST API for creating or updating an application service, the process stops if one of the CIs referenced in the API belongs to a different domain than the application service itself.

• When converting business services into application services, the newly created application service belongs to the same domain as the original business service. The application service comprises only CIs belonging to the same domain as the application service itself.

Create an application service

Create an application service to adhere to CSDM standards and to standardize the organization, maintenance, and monitoring of services in your organization.

Before you begin

Role required: app_service_admin

About this task

An application service is a set of interconnected applications and hosts which are configured to offer a service to the organization. Application services can be internal, like an organization email system or customer-facing, like an organization website.

An application service has an entry point, which lets users access the application service. If you are at the planning stage and do not know what the entry points are for an application service, you can create the application service without entry points. Such an application service is referred to as an empty application service, to which you can add entry points at any later time.

All application services created in the wizard, are set with the `application service` service classification.

Service Mapping, if activated, can automatically discover and map application services as described in Application service mapping. A discovered application service contains the CIs and the connections between them that Service Mapping discovered and mapped.

You can also create an application service by using the `createOrUpdateService - POST` REST API.
Procedure

1. Navigate to CSDM > Manage Technical Services > Application Service.
2. In the Application Services list view, click New.
3. In the Provide Basic Details tab:

   a. fill out the fields for Basic Details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Pre-populated unique ID for the application service.</td>
</tr>
<tr>
<td>Name</td>
<td>Application service name which must be unique. Use self-explanatory names such as mailing service or printing service.</td>
</tr>
<tr>
<td>Environment</td>
<td>The environment of the offering such as production, development, or test, as identified by some service offerings. Used by Incident Management and Change Management.</td>
</tr>
<tr>
<td>Version</td>
<td>The application service configuration version.</td>
</tr>
<tr>
<td>Model ID</td>
<td>A product model such as a software model where end of life data is stored.</td>
</tr>
<tr>
<td>Operational Status</td>
<td>Operational status of the application service, such as Ready or Retired.</td>
</tr>
<tr>
<td>Support Group</td>
<td>Used by Incident Management as the group managing the contract covering the asset.</td>
</tr>
<tr>
<td>Assignment Group</td>
<td>Used by ITSM for routing of change and change-related tasks.</td>
</tr>
<tr>
<td>Managed By Group</td>
<td>Group responsible for managing the data.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Owned By</td>
<td>User who is familiar with the infrastructure and applications making up the service. This user is the application service Subject Matter Expert (SME) who provides information necessary for a successful creation of an application service. If the owner name is not listed, create a user with the sm_app_owner role, as the owner. Alternatively, you can choose a user with the sm_admin role.</td>
</tr>
</tbody>
</table>

**Note:** See Teams related list for details about the automatic synchronization between the assignment group fields and the Teams related list.

**b.** In the Set Relationships section, add relationships between the application service and other components in the CSDM domain. Click the **Business Application**, **Technical Service Offering**, **Business Service Offering**, or the **Parent Application Service** tab, and add items to the respective **Selected** list.

- The technical service offering list includes records in the Service Offering [service_offering] table, in which the **Service classification** attribute is **Technical Service**.

- The business service offering list includes records in the Service Offering [service_offering] table, in which the **Service classification** attribute is **Business Service**.

- The parent application service list includes application service records from the Application Service [cmdb_ci_service_auto] table. Adding a parent application service relationship creates hierarchies and dependencies of application services in deployments such as:
○ Platform host and platform application deployments
○ Micro service deployments in which one or more micro services identified as an application service, is part of a larger application service deployment
○ Shared technical service dependencies

c. Click Next.

For information about CSDM relationships, see CI relationships in the Common Service Data Model.

Also, some fields and relationships are noted as required on the page. To change which fields and which relationships are required, see Modify the attributes and relationships required for application services.

4. On the Populate the Application Service tab:

a. Click Choose a Method or click Next to skip selecting a service population method.

b. On the Choose a Method page, select a Service Population Method, and then follow the respective link to complete the specific population method:
   • Top Down Discovery: Populate application services using top-down discovery
   • Dynamic CI Group: Populate an application service using the Dynamic CI Group method.
   • Tags: Populate application services using tags
   • Manual: Populate an application service using the Manual method

   Note: The Top Down Discovery and the Tags options are available only if Service Mapping is installed.

c. On the Service Population Methods page, you can click Add Method to add another method to populate the application service. Or, click Next.

   • You can add any combination of the Top Down Discovery and the Manual methods. However, if you select the Dynamic CI Group or the Tags method, the Add Method button is grayed out and you cannot add additional methods.
   • You can click a card for a Converted Business Service method to see details about the service conversion, such as the conversion type. For more information, see Convert business services to application services.
5. On the **Preview the Service** tab, review and verify the summaries for creating and populating the application service.

   a. Review **Relationships**. You can click **Edit Relationships** to modify the relationships to other CSDM objects.

   b. Review **Population Methods Summary**. You can click **Edit Methods** to modify the selection methods.

   c. Click **Done**.

**Results**

The application service is created, and you can access the new application service by navigating to application services list views:

- **CSDM > Manage Technical Services > Application Service**: Contains application service CIs from any class extending the Application Service [cmdb_ci_service_auto] class, except alert groups. The list view includes the tag-based, discovered, manual, dynamic CI groups, converted, and empty application service types.

- **Configuration > Application Services > Application Services**: Contains application service CIs from any class extending the Application Service [cmdb_ci_service_auto] class, except alert groups. The list view includes the tag-based, discovered, manual, dynamic CI groups, converted, and empty application service types.

- **Service Mapping > Services > Application Services**: Contains application service CIs from the Mapped Application Service [cmdb_ci_service_discovered] class. The list view includes the top-down (discovered) and empty application service types.

**What to do next**

- If the service population method is **Dynamic CI Group**:
  
  - Click **View CMDB Group CI's** to list all the CIs in the CMDB group that is associated with the application service.
  
  - Click **View Service CI's** to list all the CIs in the application service. Both lists of CIs are identical, unless the CMDB group contains more than 10,000 CIs. In this case, **View CMDB Group CI's** shows all the CIs in the CMDB group, and **View Service CI's** shows only the 10,000 CIs that are members of the application service.

- If the service population method is **Tags, Top Down Discovery**, or **Manual**:
Click View Map to view the application service map, where you can:

- Link application services
- View CI attributes in an application service map
- View the change history of application services
- Compare two versions of an application service

Click Advanced, and then on the Advanced Details page, click Additional Info, Questionnaire, Reject Messages, or Worknotes, to add details.

Populate application services using top-down discovery

Use top-down discovery to populate an application service. This discovery method deploys discovery patterns to find configuration items (CIs) belonging to the service and connections between these CIs. Pattern-based discovery creates precise and complete application services that reliably represent the service-aware view of your organization’s IT infrastructure.

Before you begin

- Verify that Service Mapping is set up properly.
- Ensure you know which entry point to use for this application service and which attributes you must be able to define for this entry point. Learn about preconfigured entry points available with Service Mapping.

Role required: sm_admin

About this task

A pattern is a sequence of steps whose purpose is to detect attributes of a CI and its outbound connections. Service Mapping and Discovery share a set of preconfigured patterns that cover most of the commonly used devices and applications.

Service Mapping starts pattern-based top-down discovery process from the entry point you define.

An entry point is how clients access an application service. Usually, it is either a URL or a combination of the IP address and port. Service Mapping starts the mapping process from this point. For example, to map your electronic mailing application service, define an IP address or host name of the email server as an entry point.

Entry points vary depending on the nature of the application service. Service Mapping comes with a wide range of preconfigured entry point types that cover many commonly used applications.
Procedure

1. From the Service Population Method list in the Choose a Method window, select Top-Down Discovery.

2. From the Application Type list, select the CI class of the application that serves as the entry point for this application service. Entry point parameters depend on the type you select.

3. Define attributes for the selected entry point as described in .

4. Optional: Add free-text comment that may provide useful information for handling this application service later.

5. Click Save.

Related information

Populate an application service using the Dynamic CI Group method

The Dynamic CI Group method for populating an application service, automatically generates a dynamic CI group. The members of the CMDB group that the dynamic CI group is based on, populates the application service. The application service continuously synchronizes with the CMDB group to reflect any changes in membership in the CMDB group.

Before you begin

The Dynamic CI Group is one of several methods for populating an application service with CIs. Choosing a method for populating an application service, is only one step of the generic procedure for creating an application service. This procedure complements the generic procedure to Create an application service. By itself, this procedure is incomplete.

Note:
- The number of CIs in an application service that is populated by the Dynamic CI Group method, is limited to 10,000, even if the associated CMDB group has more than 10,000 CIs.
- A CMDB group can be used to populate only a single application service. For more information about populating and using CMDB groups, see CMDB groups.

Role required: app_service_admin
Procedure

1. In the Choose a Method page, select **Dynamic CI Group** as the **Service Population Method**.

2. Fill out the fields that appear, which are specific to the Dynamic CI Group service population method.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Population Method</td>
<td>The method used for populating the application service with CIs. Set to <strong>Dynamic CI Group</strong>.</td>
</tr>
<tr>
<td>CMDB Table</td>
<td>Notes the Dynamic CI Group [cmdb_ci_query_based_service] table, in which application services created by the Dynamic CI Group method, are stored.</td>
</tr>
<tr>
<td>Group Name</td>
<td>The CMDB group whose members become members the application service.</td>
</tr>
</tbody>
</table>

> **Note:** CIs from a class that extends the **cmdb_ci_service** class (Services), are automatically filtered out and are not added to the application service.

3. Click **Save**.

**What to do next**
Complete the generic procedure **Create an application service**.

**Populate application services using tags**

Use tags that help categorize and organize configuration items (CIs) in your organization to populate application services. Tag-based mapping doesn’t require configuring credentials or providing users with elevated rights. Tag-based population method requires the Service Mapping feature of ITOM Visibility.
Before you begin

1. Analyze the tag usage in your organization and make a list of all tags and their purposes. Use the Key Value [cmdb_key_value] table to see the tags in the CMDB.

2. If necessary, assign tags to CIs that you want to include in application services.

3. Create an application service as described in Create an application service.

Role required: sm_admin

About this task

A tag is a label that consists of a key-value pair. Your organization may use tags to categorize its assets, to enhance query and reporting capabilities. Discovery and Cloud Provisioning and Governance can discover tags used by all major cloud providers and container ecosystems. Once the tags are discovered, Service Mapping can create application services based on these tags. For example, you can use tags to map all application services your organization uses in the production environment in the Europe, the Middle East and Africa (EMEA) region.

If you have configured tag-based service families and tag categories, you can use these tag definitions for populating an application service. Part of defining a tag-based service family is defining a tag category, which contains tag keys. If necessary, you can also define tag values to narrow the criteria used for populating application services. Based on the tag definitions for the tag-based service family, Service Mapping creates service candidates - suggested application services. When you use the tag-based service families to populate an application service, you must select the relevant service candidate. Alternatively, you can define tag keys and their values while choosing the tag-based population method for a new application service. Define up to three tag keys and tag values for the population criteria. CIs that have discovered tag keys and tag values, become part of an application service.

Note: Service Mapping includes CIs that are part of CI relationships even if these CIs do not have tags assigned to them. For more information, see.

Procedure

1. From the Service Population Method list in the Choose a Method window, select Tags.

2. To define new tag criteria, perform the following steps:
a. Select **Use a list of tags**.

b. Enter the tag key and its respective tag value.
   Matching tag keys that exist in the system, appear in the auto-fill options.

   **Important:** Tag-based mapping is not case-sensitive; same key names and key values spelled with upper and lower case are identified as the same.

c. **Optional:** Click the plus icon and add another tag key and tag value.

d. Click **Preview Result** to see the list of CIs that match the defined criteria. If necessary, refine the tag definitions.

   **Note:** You can add no more than three tag key-value pairs for one application service.

3. To use tag definitions from a preconfigured tag-based service family, perform the following steps:
a. Select **Use a candidate from a tag-based service family**.

b. **Optional:** To see the tag definitions for this tag-based service family, click the **Preview** button.

c. From the **Tag-Based Service Family** list, select the relevant family.

d. Review the tag categories and values assigned to the service family.

e. From the **Service Candidate** list, select the relevant candidate.

f. **Optional:** To review the service candidate form, click the **Preview** button.

4. **Optional:** Add free-text comment that may provide useful information for handling this application service later.

5. Click **Save**.

**Populate an application service using the Manual method**

The Manual method for populating an application service, is based on selecting an entry point CI, which lets users access the application service. To populate
the application service, you then manually add CIs to the new application service.

**Before you begin**
Role required: app_service_admin

**About this task**
Manual is one of several methods for populating an application service with CIs. Choosing a method for populating an application service, is only one step of the generic procedure for creating an application service. This procedure complements the generic procedure to Create an application service. By itself, this procedure is incomplete.

**Procedure**
1. In the Choose a Method page, select Manual as the Service Population Method.
2. Fill out the fields that appear, which are specific to the Manual service population method.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Population Method</td>
<td>Manual</td>
</tr>
<tr>
<td>CMDB Table</td>
<td>Notes the Mapped Application Service [cmdb_ci_service_discovered] table, in which application services, created by the Manual service population method, are stored.</td>
</tr>
<tr>
<td>Class</td>
<td>The class from which to choose the entry point CI for the application service.</td>
</tr>
<tr>
<td>CI</td>
<td>The CI from the specified Class, to be the entry point for the application service.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

**What to do next**
1. Complete the generic procedure Create an application service.
2. Manually add CIs to populate the application service.
Monitor the health of application services in the Application Service Dashboard

Monitor counts indicating the health state of application services, in the Application Service Dashboard. Then, reduce the number of incomplete application services by populating them and adding any missing details. To use application services effectively, ensure that application services are fully configured and are populated.

**Before you begin**
Role required: itil_admin or app_service_admin

**About this task**
Edit the application services that are showing on the Application Service Dashboard as missing important details. For example, if an application service is not configured with a service population method, edit that application service to set it with a service population method.

The data that appears in the Application Service Dashboard is calculated during night hours, on a 24-hour cycle.

**Procedure**
1. Navigate to **CSDM > Application Service Dashboard**.
2. View counts on the **Application Service Overview** tab, which indicate basic configurations of application services that are incomplete.
   - Count of all application services, complete and incomplete (Total Application Services).
   - Count of application services configured with a service population method (Population method defined).
   - Count of application services missing a service population method (No population method defined). Data for the tags and top down discovery methods appear only if Service Mapping is installed.
   - Breakdown of application services by their missing essential data such as an Owner, an Assignment Group, or a Business Service.
   - Application services without relationships to technical service offerings or to business service offerings.
   - Breakdown of application services by service population methods, including business services that were converted to application services.
3. View counts on the **Related Focus Areas** tab, which indicate other potentially incomplete configurations of application services.
• Total number of application servers, and from those, the number of application servers which are not in any application service. Also, the breakdown of these application servers by class.

• Total number of databases, and from those, the number of databases which are not in any application service. Also, the breakdown of these databases by class.

• Total number of hardware servers, and from those, the number of hardware servers which are not in any application service. Also, the breakdown of these servers by class.

   Note: Application servers, hardware servers, and databases, not included in application services, are counted only up to about 100,000, even if the actual count is greater than this limit. This number limit is determined by the value of the glide.cmdb.csdm.app_service.max_results property.

4. Optional: Filter the count results in either the Application Service Overview or the Related Focus Areas tab, by specific application service properties. You can filter by the Owner, Assignment Group, or the Support Group properties. A filter does not impact counts of application services in which the respective filter property is missing. For example, filtering by Owner, doesn't change the count of Missing Owner.

5. Optional: Select a widget in either the Application Service Overview or the Related Focus Areas tab, to drill down to the respective CI list view. For example, click the No population method defined widget to see the CI list view of application services in which no population method is defined.

6. Optional: Edit the coloring rules that determine the threshold for displaying counts in red. This applies only to the widgets for application services that are not fully configured, such as the No population method defined widget.
   a. Click the Add Widgets (+) icon.
   b. Point to the banner of a widget and click the Edit Content icon.
   c. In the Edit Report window, click the Style tab and then click Edit coloring rules.
   d. See Create coloring rules for multilevel pivot table reports to complete this edit, and for more details.
   Role required for this step is report_admin or admin.

What to do next
After identifying any application services that are missing important details, edit those application services to add those missing details.
1. Navigate to **CSDM > Manage Technical Services > Application Services**.
2. In the Application Services list view, select an application service to edit.
3. Add any missing details.
   
   For details about configuring an application service, see Create application service.

**Modify the attributes and relationships required for application services**

Modify the lists of attributes and relationships that are required when creating application services.

**Before you begin**

Role required: itil_admin

**About this task**

In application service settings, the lists of required attributes and required relationships determine which of those items are required when creating application services. By default, the list of required attributes contains the **Name** and **Number** attributes. Also by default, no relationships are required.

You can change the requirement status of attributes by removing or adding items to the list of required attributes. However, you can't remove the default **Name** and **Number** attributes. You can also add any of Business Application, Technical Service Offering, or Business Service Offering, to the list of required relationships.

**Procedure**

1. Navigate to **CSDM > Application Service Settings**.
2. Add or remove items in the **Required Attributes** and **Required Relationships** lists.
3. Click **Save**.

**Results**

Next time that you create an application service, the required attributes and relationships, are visibly noted in the Basic Details section on the Create an Application Service page.

**Convert business services to application services**

Unify the way you manage services in the organization by converting manually created records in the Service [cmdb_ci_service] table into application services. Conversion lets you streamline the different types of services in your organization,
leverage ITOM Visibility capabilities, and align with the Common Service Data Model (CSDM). The conversion is irreversible: You can’t transform application services back into business services.

Using application services has benefits such as:

• Viewing service maps and change history of services.
• Easily seeing the service context by providing a flat list of all CIs in the application service.
• Monitoring service health. If Event Management is deployed, you can monitor service performance and identify health issues for application services.
• In Change Management, the list of impacted services on a change request form is more accurate because the list includes only application services.
• Applying Customer Service Management tools to open and manage cases at the service level.

Discovery doesn’t run on converted application services, because converted services are manual. However, if after the conversion you add Discoverable by Service Mapping entry points to the application service, then Service Mapping starts discovering such this application service.

**Choosing between application services of the manually created and dynamic type**

You can convert business services into application services of the manually created type or of the dynamic type. You can edit manually created application services by adding or removing CIs at any time. The system does not update manually created services automatically. If there are changes to CIs making up a manually created application service, the service does not automatically reflect it.

Dynamic services are updated automatically to reflect any change to CI relationships stored in the CMDB CI Relationship [cmdb_rel_ci] table. When you add a relationship to a CI that is contained in a dynamic service, then that service automatically updates to reflect the addition of the relationship and the associated new CI. In a similar manner, a dynamic service automatically updates upon the removal of a relationship and its associated CI from a CI within the service.

To learn more about different types of application services, see application services.

**Conversion process**

During conversion, the following changes and processes occur:
• The service record is moved from the Service [cmdb_ci_service] table into the Mapped Application Service [cmdb_ci_service_discovered] table by changing the record class.

• The application service is set with all the original business service attributes such as name, owner, and operational status.

• The system adds related items from the business service to the converted application service, up to the specified level.

• The system queries the CMDB for the latest CI changes.

• Event Management, if activated, applies CI impact rules to CIs that are associated with alerts and that are part of the application service. Event Management deploys CI impact rules for alert monitoring.

• You can edit a converted application service of the manually created type by navigating to CSDM > Manage Technical Services > Application Service. Then select a converted application service. The service population method for a converted application service, is set to Converted Business Service. For more information about editing application services, see Create an application service.

   Note: You can’t edit a dynamic application service by adding or removing CIs from it. The system automatically modifies an application service of the dynamic type when you modify relevant relationships for CIs that are part of that application service.

Non-compliant CIs
A conversion might involve adding CIs of the following CI types, which cannot be added to an application service:

• cmdb_ci_endpoint
• cmdb_ci_translation_rule
• cmdb_ci_config_file
• cmdb_ci_qualifier
• cmdb_ci_application_cluster

If the original business service contains related items belonging to these CI types, then the system does not add such CIs or connections coming from them. If necessary, you can prevent CIs of other CI types from being added to application services by modifying the sa.mapping.user.manual.citype.blacklist property.
Domain separation
In environments with domain separation, only CIs belonging to the same domain as the application service are added to the application service. If there is a domain hierarchy, CIs must belong to the same child domain as the application service.

Convert business services to application services in bulk
Convert a subset or all business services to application services, in bulk and automatically rather than individually. Specify a criteria for a conversion, for the system to convert all business services that match that criteria into application services. The conversion is irreversible: You can't transform application services back into business services.

Before you begin
Role required: app_service_admin, ecmdb_admin, or itil_admin

About this task
Use bulk conversion to convert legacy business services to application services. You can create multiple bulk conversion records, each filtering for a different set of business services. However, do not include a business service in more than one bulk conversion.

Procedure
1. Navigate to Configuration > Services.
2. In the Services list view, click Convert to Application Services.
3. Fill out the Bulk Convert Services form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query</td>
<td>Filter that business services must satisfy to participate in the bulk conversion. The number of business services that satisfy the query appear as a link. This number updates as you modify the query. Click the link to see the list of those services.</td>
</tr>
</tbody>
</table>
Levels

The number of levels of related CIs to include in the converted application service.

Update service when CMDB updates

Select this check box to convert the business service into an application service of the dynamic type.

4. Click **Submit**.

**What to do next**

- Check the status of a conversion: On the Bulk Convert Services form, scroll to the Bulk Convert Services Entries section to see the status (such as Ready or Completed) of a conversion.

- Track the progress of a conversion as it runs: In the navigation filter, enter `cmdb_convert_bulk_services.list` and press the Enter key to see the list of conversions, and their progress.

- (Optional) On a change request form, view affected dynamic services. For example, after you add an affected CI that is associated with a dynamic service:

  1. Navigate to **Change > Open**.
  2. Select a new change request to add affected CIs to.
  3. On the Change Request form, scroll to the Related Links section.
  4. Click the **Affected CIs** tab and then click **Add** to add an affected CI to the change request.
  5. Open the form context menu and click **Refresh Impacted Services**.
  6. Click the **Impacted Services/CIs** tab to see any dynamic services that are associated with the affected CI and that are impacted by the change request.

For more information about affected CIs on a change request, see **Associated CIs on a change request**.
Convert an individual business service to an application service
Manually convert a specific business service to an application service.

Before you begin
Review the original business service to evaluate it.

• Make sure that all CIs and CI relations are relevant for the future application service. If necessary, change the CI relations in the CMDB.
• Make sure that the original business service doesn’t contain more than 5000 CI relations. Application services that contain more than 5000 CI relations cause mapping and monitoring performance issues.
• Decide how many levels of CI relations you are going to use during conversion.

⚠️ Attention: The conversion is irreversible: You can't transform application services back into business services.

Role required: app_service_admin

Procedure
1. Navigate to Configuration > Business Services.
2. Select the business service that you want to convert to an application service.
3. Click Convert to Application Service.
   The Converting to Application Service dialog box opens.
4. Select a number from the Up to list, as the number of levels of related CIs to include in the conversion.
   The maximum number of levels is eight.
5. Select Update service when CMDB updates to convert the business service into an application service of the dynamic type.
6. Click OK.

Results
The system adds the CIs from the business service to the converted application service.

What to do next
Open the map for the newly converted application services.
Make sure that the application services aren't too large:
• Service Mapping doesn't offer to view CI list instead of a map for an application service.

• There is no discovery message indicating that the application service is too large: The map does not display the entire service, because it is too large. The number of CI connections exceeded the allowed maximum.

If the service is too large, perform the following actions:

• Review the converted application service to identify CI relations irrelevant or redundant for this service. Remove such CI relations in the CMDB.

• Decide how many levels of related CIs you must include into this application service. If necessary, change the number of levels used in conversion to reduce the service size.

Related information
https://docs.servicenow.com/bundle/quebec-servicenow-platform/page/product/configuration-management/concept/application-services.html

Application services

Convert legacy manual services into dynamic application services
Unify the way you manage services in your organization by converting legacy manual services into dynamic application services. Conversion lets you streamline the different types of services in your organization, leverage ITOM capabilities, and align with the Common Service Data Model (CSDM). The conversion is irreversible: You can't transform application services back into legacy manual services.

Before you begin
Role required: app_service_admin

About this task
You can't edit a dynamic application service directly. Instead, the system automatically updates a dynamic application service to reflect any change to CI relationships in the CMDB CI Relationship [cmdb_rel_ci] table.

During conversion, the following changes and processes occur:

• The service record is moved from the Service [cmdb_ci_service] or the Manual Service [cmdb_ci_service_manual] table into the [cmdb_ci_service_calculated] table by changing the record class.

• The dynamic application service is set with all the original attributes of the legacy manual service such as name, owner, and operational status.
• The system adds related items from the legacy manual service to the converted dynamic application service, up to three levels by default.
• All connections created between CIs in the dynamic application service are endpoint CIs with the relationship uses, implement, or application flow.
• Event Management, if activated, applies CI impact rules to CIs that are associated with alerts and that are part of the application service. Event Management deploys CI impact rules for alert monitoring.

A conversion might involve adding non-compliant CIs, which cannot be added to an application service:
• cmdb_ci_endpoint
• cmdb_ci_translation_rule
• cmdb_ci_config_file
• cmdb_ci_qualifier
• cmdb_ci_application_cluster

If the original manual service contains related items belonging to these CI types, then the system does not add such CIs or connections coming from them. If necessary, you can prevent CIs of other CI types from being added to application services by modifying the sa.mapping.user.manual.citype.blacklist property.

Procedure
1. Navigate to Configuration > Application Services > Application Services.
2. Open the legacy manual service that you want to convert to a dynamic application service.
3. In the Related Links section on the service form, click Convert to Dynamic Service.

Manually add CIs to an application service
Add configuration items (CIs) to manually created application services or to services discovered by Service Mapping. You can edit discovered and manually created application services.
Before you begin

- Verify that the CI type for the CI that you are planning to add, exists. If necessary, create the CI type as described in Create CI types for Service Mapping and Discovery.

- Add CIs to the CMDB for the device or application that you want to add, if necessary. See Populate the CMDB for more information.

Role required: app_service_admin or sm_admin

About this task

Adding a CI to an application service requires creating a relationship between the new CI and a CI in the application service. You can add CIs to an application service that was created manually, by either:

- Adding a method to populate the application service.
  
  Navigate to CSDM > Manage Technical Services > Application Service. Select an application service and then use the Populate the Application Service tab to choose a method to populate the application service. For more details, see Create an application service.

- Using the application service service map as described in the steps below.

  The default relationship type of the added connection in this case is Depends on: :Used by. You can modify this default relationship type by changing the value of the sa.it_service.manual_ci_rel_type property.

  
  Attention: You cannot fine-tune or edit tag-based and dynamic services from the map.

Information about the CI in application service, to which you are connecting a new CI, is updated in the CMDB. This information includes the type of the relationship between the CIs. If other application services use the same applicative flow, the CMDB recognizes it and adds the CI you added manually to these application services by analogy. For example, you manually added an IBM WebSphere Message Broker to an IBM WebSphere HTTP Listener in the Bank Customer Portal service. The system also adds this IBM WebSphere Message Broker to the same HTTP Listener in the Bank Internal Portal, because it uses this HTTP Listener. The same logic applies when you remove a CI you added manually: The system removes it from all application services where you either manually added it or the system added it by analogy.

You can manually connect a CI only to actual CIs existing in the CMDB, not to a visualization of other items on the map such as clusters or boundaries. Also, it is prohibited to add CIs of these CI types to an application service:
• cmdb_ci_endpoint
• cmdb_ci_translation_rule
• cmdb_ci_config_file
• cmdb_ci_qualifier
• cmdb_ci_application_cluster

If necessary, you can prevent CIs of other CI types from being added to application services by modifying the sa.mapping.user.manual.citype.blacklist property.

In environments with domain separation, only CIs belonging to the same domain as the application service are added to the application service. If there is a domain hierarchy, CIs must belong to the same child domain as the application service.

If working with an application service discovered by Service Mapping, manually add a CI:

• To indicate that an application service contains a device or application, which Service Mapping cannot discover. For example, add an A/C unit to the Production Floor service.

• To add a temporary placeholder for a CI, which Service Mapping did not discover. In this case you are planning to perform necessary troubleshooting to ensure that Service Mapping discovers this CI in the future. For example, add an IBM WebSphere Message Broker to the Bank Customer Portal service.

• To create an application service that combines entry points and CIs automatically discovered by Service Mapping with entry points and CIs from the CMDB. After you manually add an entry point, you can update the application service with CIs from the CMDB based on the relationships defined there.

For additional information related to Service Mapping, see Pattern customization and Enable traffic-based discovery for CI types or specific CIs.

**Procedure**

1. Open the application service map.
   a. Navigate to CSDM > Manage Technical Services > Application Service.
   b. Select the needed application service.
   c. On the application service page, select View Map.

2. If needed, click Edit to ensure that the map is in Edit mode.
If Service Mapping is deployed, then in Edit mode, the Discovery Messages section appears below the map.

3. To connect a CI to another CI on the map, right-click the CI to which you want to connect the new CI, and then select Add a CI.

4. In the Add A CI dialog box, specify the CI to add:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Type</td>
<td>Select the CI type (CI class) for the CI you are adding. Every CI belongs to a CI type which contains a set of attributes configured for this kind of CI, for example, cmdb_ci_appl for applications.</td>
</tr>
<tr>
<td>CI Name</td>
<td>Select the CI from the list of CIs of the selected CI type.</td>
</tr>
</tbody>
</table>

The CI type list includes only allowed CI types. For example, you cannot add an application cluster.

5. Click Submit.
The manually added CI appears on the map.

Note: When you manually add a CI, which is an application, as a child to a service that already includes its parent application CI, the newly added child application CI is hidden inside the inclusion. Click the plus (+) symbol next to the parent application CI to see the child application CI.

6. Optional: (If Service Mapping is activated) To add a discoverable outgoing connection for the manually added CI:

a. Right-click the manually added CI.

b. Select Manually add a connection.

Note: If you do not see the Manually add a connection option in the right-click menu, check that you are logged in with the user that belongs to the same domain as the application service.

c. Configure attributes for the entry point as described in Entry points attributes.
d. Click **Submit**.
   Discovery and Service Mapping attempt to discover this CI. If successful, the CI appears on the map. Otherwise, a warning icon (⚠️) appears.

7. **Optional:** (If Service Mapping is activated) If you want Service Mapping to automatically discover a CI, which you previously added manually:

   a. Customize the relevant pattern or fine-tune traffic-based discovery to enable Service Mapping to discover the CI.

   b. Navigate to the relevant application service map.

   c. Click **Run discovery**.

   d. After the discovery process finishes, verify that Service Mapping discovered the CI by checking the connector leading to the CI. If Service Mapping discovered the CI, then two connectors, a manual and automatically discovered, appear for the CI.
e. Right-click the CI you added manually.  
   In the example, it is IBM WebSphere Message Broker.

f. Select Remove manually added CI.  
   The map shows the CI with only one connector leading to it. If this CI had any manually added connections, they are removed together with the manually added CI.

Related information

Link application services

addCI()

Manually update an application service with changes from the CMDB

Ensure that an application service is up-to-date and reflects all the latest changes to its configuration items (CIs). Regularly update application services to reflect any changes to CIs and their relationships in the CMDB.

Before you begin

Role required: app_service_admin

About this task

There is no mechanism or an API that automatically updates application services that were created manually. Also, you may need to manually update application services discovered by Service Mapping, if they contain manually added CIs. You can only update application services which contain manually created entry points and which are not discovered by Service Mapping.

An example of a change is deleting CIs from the CMDB or connecting two CIs one of which is part of an application service. In the first case, your application service may show a CI that no longer exists. In the second case, on the contrary, the application service omits a CI.

An update might involve adding CIs of the following CI types, which cannot be added to an application service:

- cmdb_ci_endpoint
- cmdb_ci_translation_rule
- cmdb_ci_config_file
- cmdb_ci_qualifier
- cmdb_ci_application_cluster
If necessary, you can prevent CIs of other CI types from being added to application services by modifying the `sa.mapping.user.manual.citype.blacklist` property.

Also, the system can connect a CI from the application service only to actual CIs that exist in the CMDB, not a visualization of other items on the map like clusters or boundaries.

The maximum number of CI connections added to application services during this operation is controlled by the `sa.service_max_ci_service_population` property. By default, the value is 1,000 (one thousand connections). Increasing the number of CI connections may cause performance issues. To adjust the maximum number of added CI connections, add the `sa.service_max_ci_service_population` property, as described in Add a system property.

In environments with domain separation, only CIs belonging to the same domain as the application service are added into the application service. If there is a domain hierarchy, CIs must belong to the same child domain.

You can also update application services by using APIs.

**Procedure**

1. Navigate to CSDM > Manage Technical Services > Application Service.
2. On the Application Services list view, select the application service that you want to update.
3. Click Advanced and then click Advanced Configurations.
4. On the Additional Info page, click the Update with changes from CMDB related link.
5. Select a number in the Up to list to limit the number of levels of related items to be updated.
   If the specified number is higher than the number of levels of related items that already exist in the application service, then the system adds the missing CIs and their connections.

   **Warning:** Specifying a lower number than the number of levels that already exist in the application service, does not result in the removal of CIs from the application service.

6. Click OK.
Results

• The system updates the application service with the changes from the CMDB and shows them on the map.
• After the update process is complete, the application service form opens.

Link application services

You can manually link two application services by adding a reference to one application service into another application service. The service that contains the reference, becomes a dependent service. The service that you include as a reference is a contained service. You can link application services to create dependencies for impact monitoring in Event Management.

Before you begin

You can edit discovered and manually created application services.

**Important:** You cannot fine-tune or edit tag-based and dynamic services from the map.

Ensure that you know the name and the service type of the application service, to which you want to add a reference.

Role required: app_service_admin or sm_admin

About this task

To create a link, add a reference to the relevant application service as an outgoing connection of the relevant CI inside another application service. For example, you can add the UK Portal application service as a link to the Online Store application service. In this case, the Online Store service becomes dependent on the UK Portal service that it contains. The Online Store service reflects discovery errors for its contained service in the Edit map mode, as well as alerts in Event Management.
When you link an application service to another application service, the information about the CI, to which you linked the service, is updated in the CMDB. The CMDB recognizes other application services that use the same applicative flow, and adds the contained application service to these application services by analogy. The same logic applies when you remove a contained application service: The system removes it from all application services where you either manually linked this service or the system linked this service by analogy.

When using Service Mapping, you may want to link application services to create:
• A dependency between two application services.
• A placeholder for a map branch that Service Mapping failed to discover. If you create or customize a pattern to discover the configuration item (CI) serving as an entry point for the contained application service, Service Mapping can discover this contained service.
• An indication that an application service contains a branch, which Service Mapping cannot discover.

You can add an application service as a contained service to as many application service as necessary.

Procedure
1. Navigate to Service Mapping > Application Services.
2. Click View map next to the relevant application service.
3. If needed, click Edit to ensure that the map is in Edit mode.
4. Right-click the CI to which you want to link an application service as a reference.
5. Select Add A CI.
6. In the Add a CI dialog box, select the application service you want to add as a contained service:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| CI Type    | Select the relevant service type from this list:  
• Tag-Based Application Service  
• Mapped Application Service for discovered or manually created application services  
• Calculated Application Service for dynamic services  
• Dynamic CI Group |
| CI Name    | Select the name of the application service that you want to link as a contained service. |

7. Click Submit.
The icon for the contained service appears on the map.
Related information

Application services

Group application services

Organize application services by groups to perform actions simultaneously on multiple services, and to control user access to services. You can use Event Management to track service health by service groups.

Before you begin

Role required: sm_admin or app_service_admin

About this task

Typically, enterprises have hundreds of services which makes it impractical to manage them individually. Service groups can make service lists much shorter and easier to manage, especially in large organizations or service providers.

How you group application services depends on the user and on service provisioning policies in your enterprise. The relation between application services in groups is purely logical and the same application service can belong to multiple groups. For example, the Mobile service can be part of the following service groups: Sales, Beijing, and Telephony.

Example of an application service belonging to different groups
You can embed a service group within another service group to create a hierarchy of service groups. If users have access to a parent service group, they automatically have access to all its child groups. By default, all new services are assigned to the All service group that lets all users view and manage application services. When you assign a role to a service group, the users with this role can access application services in this service group and in the All service group. To enable users with this role to access other services, assign this role to the respective service group. Do not assign user roles directly to the All service group.

If Service Mapping is activated, service groups can contain a mixture of manually created application services and application services discovered by Service Mapping.

You can use Now Platform Notifications to alert users if the service group severity changes to critical. The overall severity of the group is determined by the highest alert severity within the group.

**Procedure**

1. Navigate to **Configuration > Application Services > Service Groups**.
2. Click **New**.
3. Enter the name of the new application service group in the **Name** field.
4. To embed this group in another group, enter the name of the other group in the **Parent Group** field.
5. Right-click the form header and click **Save**.
6. Add an application service to the newly created service group.
   a. In the Service Group Members section, click **New**.
   b. In the **Name** field, enter the name of the application service. If you are using Event Management, you can also enter an alert group name.
   c. Click **Submit**.
7. Alternatively, add an application service to a group from the application service form.
   a. Navigate to **Configuration > Application Services > Application Services**.
   b. Select the application service you want to add to a service group.
   c. In the **Service Group Members** section, double-click **Insert a new row**.
   d. Enter the name of the service group to which you want to add the selected application service.
Control user access to application services

Assign user roles to service groups to grant users access to application services in your organization. Your organization may restrict access to some services for security or secrecy reasons.

Before you begin
Make sure that you have performed the user provisioning tasks for the users you want to grant access:
1. Add users to user groups.
2. Create new roles.
3. Assign roles to users or user groups.

Also, make sure that you have created service groups as described in Group application services.

Role required: app_service_admin or sm_admin

About this task
In the base system, the following roles provide access to application services:

app_service_admin
Creates and modifies application services, creates service groups, views, and edits application service maps.

app_service_user
Views application service maps. The itil role that serves as the basic helpdesk technician role contains the app_service_user role.

Service Mapping provides these preconfigured roles:

sm_admin
Sets up the Service Mapping application. Maps, fixes, and maintains application services. Also performs advanced configuration and customization of the product. Assign this role to application administrators.

sm_user
Views maps for operational application services to plan change or migration, as well as analyze the continuity and availability of services. Assign this role to application users.

**sm_app_owner**

Provides information necessary for successful mapping of an application service. Once a service is mapped, this user reviews the results and either approves it or suggests changes. Assign the sm_app_owner role to users who own application services and are familiar with the infrastructure and applications that make up the services.

Event Management provides these preconfigured roles:

**evt_mgmt_admin**

Has read and write access to all Event Management features to configure Event Management.

**evt_mgmt_operator**

In addition to the evt_mgmt_user permissions, can also activate operations on alerts such as acknowledge, close, open incident, and run remediations.

**evt_mgmt_user**

Has read access to all Event Management features. Has write access to alerts to manage the alert life. Has the itil role to be able to manage incidents that are created from alerts.

**evt_mgmt_integration**

Has create access to the Event [em_event] and Registered Nodes [em_registered_nodes] tables to integrate with external event sources.

Typically, enterprises have hundreds of services which makes it impractical to manage them individually. Service groups can make service lists much shorter and easier to manage, especially in large organizations or service providers. In a hierarchy of service groups, access to a parent service group automatically grants access to all the child service groups.

Users inherit permissions from roles that are assigned to them. You can assign some roles directly to service groups to allow all users with this role to access all application services belonging to this group. However, most enterprises choose to organize their roles as a hierarchy. It helps to manage roles across multiple ServiceNow applications. For example, the Service Mapping administrator [sm_admin] can be part of a broader administrator role like administrator...
[admin]. You can add users to user groups and then assign roles to the user groups to give permissions of this role simultaneously to all the group users.

### Assigning a role to an application service group

![Diagram showing role assignment to service group]

By default, all new services are assigned to the **All** service group that lets all users view and manage application services. When you assign a role to a service group, the users with this role can access application services in this service group and in the **All** service group. To enable users with this role to access other services, assign this role to the respective service group. Do not assign user roles directly to the **All** service group.

**Note:** Some references in the user interface to business services are actually references to application services.

### Procedure

1. Navigate to either of the following:
   - **Configuration** > **Application Services** > **Service Group Responsibilities**.
   - If Service Mapping is activated: **Service Mapping** > **Services** > **Service Group Responsibilities**.
   - If Event Management is activated: **Event Management** > **Services** > **Service Group Responsibilities**.

   **Note:**
   The following user interface screens refer to application services as business services: Business Service Group Responsibilities, Approve, Service Mapping Properties, and Service Map Planner.

2. Click **New** and fill out the Business Service Group Responsibilities form.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Service Group</td>
<td>Service group to which you want to assign a role.</td>
</tr>
<tr>
<td>Role</td>
<td>Role you want to assign to the selected service group.</td>
</tr>
<tr>
<td></td>
<td>For example, financial_services_admin.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**Example:**
To manage access to services that contain sensitive financial information in your organization:

1. Organize the services into the Financial Services group.
2. Create a new user role, financial services administrator [financial_services_admin] role, that contains the [app_service_admin] role.
3. Assign the Financial Services administrator role to the Financial Services group.

As a result, only users with the Financial Services administrator role can access application services belonging to the Financial Services group.

**View an application service map in base system**
An application service map provides a visualization of data for the CIs comprising an application service, and the relationships and connections between these CIs.

**Before you begin**
Role required: app_service_user to view the map in View mode, and app_service_admin to modify services in Edit mode.

**About this task**
When you create an application service, the system generates an associated application service map. The system then updates the map to reflect any changes to the application service. This map consists of icons representing CIs and arrows that represent the connections between them.

If Service Mapping is deployed, see Application service maps and View CI connection attributes in an application service map for more details.
To open an application service map, navigate to **CSDM > Manage Technical Services > Application Service**, select an application service, and then click **View map**.

Perform any of the following operations in the application service map.

**Procedure**

- Click \( \downarrow \) on the windows bar to navigate to a different application service.
- Use the navigation tools to increase or decrease the view of the map and to move the map on the page. You can also click anywhere on the map area and drag a segment of the map into the visible area.

- View changes: You can view changes and change records associated with the application service as a whole or with any of its CIs, within a time range. For more information, see **View the change history of application services**. Records under the **Change** tab underneath the map, which are associated with a selected CI or connection, are highlighted. If you select a change record under the **Change** tab, then the associated CI icon appears yellow on the map.

- View attributes: When you select a device, application, or connector on the map, it appears in blue and its attributes appear in the Properties pane on the right of the map. When nothing is selected on the map, the details of the application service itself appear on the Properties pane.
  
  ◦ Open the CI's form for further details by clicking **Detailed Properties** at the bottom of the Properties pane.

- Click **Edit** or **View** to switch the map mode. Edit mode lets you add or remove CIs from the map.

- Click \( \text{Menu} \) for **Additional actions**.
Set **Group CIs on map**: Simplify maps by grouping 10 or more CIs belonging to the same type and hosted on servers sharing prefix and domain name.

Set **Spanning tree view**: Simplify the map by organizing CIs into a tree structure and hiding some connection lines. This option is especially useful for very large maps.

**Map Indicators**: Show additional information for a CI or for the application service itself by displaying related records such as alerts, outages, incidents, and problems. For each indicator that is enabled, the corresponding indicator icon appears next to CIs with associated records, and the corresponding tab appears underneath the map. If a record is associated with the application service itself, the indicator appears next to the application service name.

For information about managing map indicators, see [Create or modify map indicators](#). For more general information, see [Event Management Map Indicators (Video)](#).

**Export to PDF**: Export the map to a .PDF file which you can then share as needed. After the PDF file is ready, click 🖼️ to download the PDF file to your local drive.

- View the details of a connection.
  By default, connection lines for the same CI on an application service map, are merged. This merge reduces clutter on the map and helps to make the map more readable. For a merged connection line, you can view details for all the underlying connection lines.

  ![merged connection lines](merged_connection_lines.png)

- To view the source and target CIs of a connection, right-click a connection line.
  If spanning tree view is enabled:
1. Click the CI whose connections you want to view to show all the concealed connections for the CI.

2. Right-click one of the connection lines.

   ◦ To view properties of a connection, click a connection line. For manually added connections, Endpoint Type is Manual Endpoint.

   ◦ To view properties of a connection within a merged connection:
     1. Right-click the merged connection line.
     2. Select one of the connections.
     3. Select **Select edge**.

**What to do next**
You can change the details that appear in the Properties pane by updating the form view 'Form view and section', as described in Configuring the form layout.

**Related reference**
  - Spanning tree view property

**View CI attributes in an application service map**
An application service map displays attributes for each configuration item (CI) that is part of the application service, as well as for the application service itself. The attributes come from the CMDB.

**Before you begin**
Role required: sm_admin or sm_user

**About this task**
You can view the following information for each CI:

**Name label**
The CI name. This attribute is either preconfigured on the CI or configured during CI installation.

**Basic attributes**
A summary of the most important CI attributes.

**Detailed attributes**
A complete list of all attributes collected for the CI.

Each CI type (CI class) has different attributes. For example, the Linux Server type has different attributes than the SQL Instance type.
If Service Mapping is deployed, the way CIs appear on the map depends on the view you select for the map. Attributes available for viewing also depend on the Service Mapping setup. For more information see description of components installed with Service Mapping.

The following user interface screens refer to application services as business services: Business Service Group Responsibilities, Approve, Service Mapping Properties, and Service Map Planner.

**Procedure**

1. Open the application service map.
   a. Navigate to **CSDM > Manage Technical Services > Application Service**.
   b. Select the needed application service.
   c. On the application service page, select **View Map**.

2. If needed, click **Edit** to ensure that the map is in Edit mode.
   If Service Mapping is deployed, then in Edit mode, the Discovery Messages section appears below the map.

3. To see the full name of a CI whose name has been shortened on the map, point to the CI.
   A tooltip displays the full CI name.

4. Click a CI to see its details in the **Properties** pane.
   The attributes of applications and the servers that host them appear separately.
5. To view more detailed attributes for the CI, click **Detailed properties** at the bottom of the Properties pane.

6. **Optional:** (If Service Mapping or Discovery are enabled, and if tracking changes to configuration files is enabled for a CI) To view configuration files associated with a CI:
   - Review the list of files under **Tracked Files** in the **Properties** pane. Click the file name to open the actual file.
   - Click the **Affected CIs** tab and view the list of configuration files. Click the file name to open the actual file.

**View the change history of application services**

You can view the changes made to an application service as a whole and to the individual configuration items (CIs) comprising the service. Change history is useful for maintenance, planning, or troubleshooting procedures.

**Before you begin**
Role required: admin, sm_admin, sm_user, app_service_admin, or app_service_user
About this task
Details about changes to an application service and to its CIs are stored in the CMDB. Typically, these changes reflect adding or removing CIs from an application service, upgrading or updating CIs, or modifying CI configuration files. The system gathers this data by querying CMDB tables and then creating the change history view. In deployments where Service Mapping is activated, the type of change information Service Mapping queries depends on discovery patterns that Service Mapping uses to discover CIs.

Changes to configuration files are associated with CIs to which these files belong. Maps show configuration file changes as changes to related CIs.

While you can see change records for a specific CI in the context of application services, you can also see detailed history of a specific CI separate from its application service as described in History Timeline.

If the Now Platform is configured to validate changes, all changes are evaluated and rendered as valid or not. If a change is valid, its change record on the application service map is marked as approved. For more information about configuring the platform for change validation, see Managing proposed changes.

Changes to the application service appear on the history timeline.

The type of change mark depends on the nature of changes that it represents:

Light gray balloon (📍)
Unapproved change that does not influence the application service behavior. For example, a change in a network path or adding a node to a cluster.

Dark gray balloon (📍)
Unapproved change that changes the application service behavior.

Green balloon (📍)
An approved change in deployments where the Now Platform is configured to validate changes.

**Double balloon (9)**

Multiple separate changes that happened a short time from each other.

You can mark times on the history scale by creating baselines to quickly return to the marked view.

**Procedure**

1. Open the application service map.
   a. Navigate to CSDM > Manage Technical Services > Application Service.
   b. Select the needed application service.
   c. On the application service page, select **View Map**.

2. Review change records created for this application service on the **Changes** tab at the bottom of the page.
   If Service Mapping is deployed, then in Edit mode, the Discovery Messages section appears below the map.

3. On the history timeline, set the time range of changes that you want to view.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>To set the time range of the history timeline</td>
<td>Click the hour, day, week, or month icons.</td>
</tr>
<tr>
<td>To increase or decrease the time range</td>
<td>Click the zoom in and zoom out icons.</td>
</tr>
<tr>
<td>To change the upper limit on your history range</td>
<td>Click the history scale.</td>
</tr>
<tr>
<td>Option</td>
<td>Action</td>
</tr>
<tr>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td></td>
<td>The time that serves as the upper limit appears above the history timeline.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot set the lower limit on your history range to a time before this application service was created. This time is marked with the <strong>IT Service Created</strong> event on the history timeline.</td>
</tr>
</tbody>
</table>

The map shows the history view of the application service for the time you selected.

**Note:** The **Change** tab shows all change records, even the ones which are filtered out of the history view.

4. To mark a time on the time scale, set a baseline:

a. Click the **Compare** icon.

b. Navigate to the time you want to mark as a baseline on the history scale.

c. Click **Set baseline**.
d. Enter the name of the baseline and click **OK**. The new baseline appears as a button above the history scale and as a blue flag on the history scale.

5. View the change history:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a change record on the <strong>Changes</strong> tab.</td>
<td>The related CI is marked yellow in the map.</td>
</tr>
</tbody>
</table>

To see the CI responsible for a change record
<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To see only change records related to a CI</strong></td>
<td>Select the required CI or the connection on the map. The <strong>Changes</strong> tab displays only change records related to the selected CI or connection.</td>
</tr>
</tbody>
</table>
| **To see the configuration file at the selected moment in the past** | a. Set the time on the history scale.  
   b. In the **Properties** pane, scroll to **Tracked Configuration Files**, and click the file name. The new tab opens displaying the content of the tracked configuration file at the selected time. |
| **To see the network at the selected moment in the past** | a. Set the time on the history scale.  
   b. Right-click the connection and select **Show network path**. The new tab opens displaying the network or storage path map for the time you selected. |

**Note:** You cannot view the network path for connections marked as boundaries to this application service.
6. To exit the history view and see the current status of the application service, click the current icon.

Related information
- View an application service map in base system
- Compare two versions of an application service
- Modify tracking changes in configuration files

Compare two versions of an application service
You can see a summary of application service changes at a glance by comparing two versions of an application service. This feature is useful for checking the application service status before and after a certain change or problem.

Before you begin
Role required: admin, app_service_admin, app_service_user, sm_admin, or sm_user

About this task
Specify two points in time for which to compare the two versions of an application service. You can use the change indicators on the timeline to specify one point in time that is before and another that is after a change for which to see the details. For example, if you know that the application service started to fail at a certain time, you can compare two versions of the application service, one before and one after the problem started. This comparison lets you see the summary of changes that possibly led to the problems.

Service Mapping, if deployed, tracks and shows all changes to a CI including configuration files associated with a CI. When you compare two versions of an application service, you can see changes made to configuration files as changes to CIs. You can also compare two versions of a configuration file to see the actual changes in the files, during the time range specified for the comparison.
The following user interface screens refer to application services as business services: Business Service Group Responsibilities, Approve, Service Mapping Properties, and Service Map Planner.

Procedure

1. Open the application service map.
   a. Navigate to CSDM > Manage Technical Services > Application Service.
   b. Select the needed application service.
   c. On the application service page, select View Map.

2. If needed, click Edit to ensure that the map is in Edit mode.
   If Service Mapping is deployed, then in Edit mode, the Discovery Messages section appears below the map.

3. On the history timeline, set the time range of changes that you want to view.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>To set the time range of the history timeline</td>
<td>Click the hour, day, week, or month icons.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Hours Days Weeks Months" /></td>
</tr>
<tr>
<td>To increase or decrease the time range</td>
<td>Click the zoom in and zoom out icons.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Hours Days Weeks Months" /></td>
</tr>
<tr>
<td>To change the upper limit on your history range</td>
<td>Click the history scale.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="History Scale" /></td>
</tr>
<tr>
<td></td>
<td>The time that serves as the upper limit appears above the history timeline.</td>
</tr>
<tr>
<td>Option</td>
<td>Action</td>
</tr>
<tr>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Note:</td>
<td>You cannot set the lower limit on your history range to a time before this application service was created. This time is marked with the <strong>IT Service Created</strong> event on the history timeline.</td>
</tr>
</tbody>
</table>

The map shows the history view of the application service for the time you selected.

**Note:** The **Change** tab shows all change records, even the ones which are filtered out of the history view.

4. Click the **Compare** icon.

5. Set **Compare point 1** and **Compare point 2** as the two points in time for the comparison.
   
   You can drag the pointers on the history scale to set corresponding time points.

   ![Diagram of Compare points](image)

   If the history scale does not include the time set for comparison, then its corresponding pointer appears next to the compare point in yellow:
6. **Note:** If there are no changes to the service during the time interval specified by **Compare point 1** and **Compare point 2**, then no change details are displayed.

7. **Optional:** If Service Mapping is deployed, you can compare two versions of a configuration file that appears on the map as Updated:
   
   a. Select the CI that is associated with the updated configuration file.
   
   b. In the **Properties** pane, click the link to the updated file.
The Tracked Configuration Files Version Compare tab opens showing two versions of the configuration file side by side.

c. Review actual changes.

(Optional) Highlight colors indicate the type of change:

- Purple — Updated line
- Pink — New line
- Gray — Deleted line

d. Navigate between the changes using the arrows in the upper right corner.

e. Close the Tracked Configuration Files Version Compare tab when finished.

9. Close the comparison view when finished.

Related information

View the change history of application services
Compare versions of CI configuration files
Use application services APIs

Application services provide APIs that let you perform operations such as creating and updating an application service, populating it with CIs from the CMDB, and retrieving details from an existing application service.

Role required: app_service_admin

An application service is a set of interconnected applications and hosts which are configured to offer a service to the organization. Application services can be internal, like an organization email system or customer-facing, like an organization website.

Create an application service

Using the createOrUpdateService - POST REST API to create an application services suits your organization if the ServiceNow CMDB already contains the CIs making up the service. Typically, it is the case when you have manually added CIs directly into the CMDB, or used the Discovery application to discover CIs and store information about them in the CMDB. You can also use this API to create application services containing CIs discovered using non-ServiceNow applications.

By default, when an application service is created, all CI connections are of the Depends on: :Used by relationship type. You can modify this default type by changing the value of the sa.it_service.manual_ci_rel_type property.

Before creating an application service, ensure that:

• The CMDB contains all the CIs comprising the application service.
• You have the sys_id of each CI comprised in the application service you want to create.
• You understand the hierarchy that the CIs form.

The Mapped Application Service [cmdb_ci_service_discovered] table contains all application services including services you create using APIs.

You can also manually create application services using the user interface as described in Create an application service.

Retrieve content from an application service

Use the getContent - GET REST API to retrieve a list of CIs and the relationships between them, for an application service that was created manually.

Additional APIs

The following JavaScript APIs are also available:
- **addCl()**: Add a CI to a manually created application service.
  
  For restrictions on the CIs being added and other details about adding CIs to application services, see [Manually add CIs to an application service](#).

- **addManualConnection()**: Add a manually created connection to an application service.

- **migrateManualToApplicationService()**: Convert a manual service to an application service.

- **populateApplicationService()**: Populate an application service with CIs and relationships from the designated entry point.

- **removeCI()**: Remove a manually created CI from an application service.

- **removeManualConnection()**: Remove a manually created connection and the connected CI from an application service.

### Related information

**Application Service API**

### Components installed with application services

Several types of components are installed with activation of the Application Service [com.snc.cmdb.it_service] plugin, including tables, user roles, and scheduled jobs.

**Note**: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see [Find components installed with an application](#).

### Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>[app_service_user]</td>
<td>Provides read-only access to application services, and ability to call any GET APIs (GetContent).</td>
<td>• None</td>
</tr>
<tr>
<td>[app_service_admin]</td>
<td>Provides access to all basic functionality related to application services. This basic functionality includes creating services, and adding and removing CIs from services.</td>
<td>• itil</td>
</tr>
</tbody>
</table>
# Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BaseLines [sa_baselines]</td>
<td>Storing points in the time defined as baselines for application services.</td>
</tr>
<tr>
<td>Business Service User preferences [sa_business_service_user_prefs]</td>
<td>User preferences associated with a specific application service.</td>
</tr>
<tr>
<td>Menu Action [sa_context_menu]</td>
<td>Data on configurable menu options for CIs in the application service map.</td>
</tr>
<tr>
<td>Hash [sa_hash]</td>
<td>Internal table which contains counters and hashes on various types of updates related to application services.</td>
</tr>
<tr>
<td>Entry Point [sa_m2m_service_entry_point]</td>
<td>Maps entry points to application services.</td>
</tr>
<tr>
<td>Discovered Service Notification [sa_notification]</td>
<td>Internal table which contains data on notifications between different parts of the software. Mostly used after activating Service Mapping.</td>
</tr>
<tr>
<td>Service Group Members [sa_service_group_member]</td>
<td>Maps service groups to application service members.</td>
</tr>
<tr>
<td>Business Service Group Responsibilities [sa_service_group_responsibilities]</td>
<td>Data on users having access to application service groups.</td>
</tr>
<tr>
<td>Checkpoint Attribute Description [checkpoint_attribute_description]</td>
<td>Links between history timeline changes and service model internal entities (checkpoints). Used in lists of history of changes in application service maps.</td>
</tr>
<tr>
<td>Application Service [cmdb_ci_service_auto]</td>
<td>Services that can be monitored by the system, which in the base system, includes only application services. If Service Mapping is activated, there can also be records for dynamic CI groups. If Event Management is...</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Mapped Application Service [cmdb_ci_service_discovered]</td>
<td>Application service CIs. For each application service, there is a container CI record that models the application service.</td>
</tr>
<tr>
<td>Bulk Convert Services [cmdb_convert_bulk_services]</td>
<td>All bulk conversions of business services to application services (current and past), along with the conversion progress which is refreshed every 10 seconds.</td>
</tr>
<tr>
<td>Application Services Action Results [csdm_dashboard_action_report_result]</td>
<td>Results for the 'Application Services Missing Data' report in the Application Service Dashboard.</td>
</tr>
<tr>
<td>Application Services Types Results [csdm_dashboard_type_report_result]</td>
<td>Results for the 'Application Services by Type' report in the Application Service Dashboard.</td>
</tr>
<tr>
<td>Application Services Dashboard Results [csdm_dashboard_reports_result]</td>
<td>Results for the '&lt;Application Servers</td>
</tr>
</tbody>
</table>

**Properties installed**

To access application services properties, navigate to **Configuration > Application Services > Properties**. The role required for modifying property values, is `app_service_admin`.

If Service Mapping is deployed, see **Properties installed with Service Mapping** for additional application service properties.

ℹ️ **Note:** To open the System Properties `[sys_properties]` table, enter `sys_properties.list` in the navigation filter.
<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
</table>
| The sys_id of the default relation type to be added between source and target when adding CI manually to application service `sa.it_service.manual_ci_rel_type` | • Type: string  
• Default value: 5599a965c0a8010e00da3b58b113d70e (Depends on::Used by)  
• Learn more: Manually add CIs to application service |
| Coefficient of aggregation interval. 0 value means no aggregation is performed on history timeline. The purpose of this property is to decrease number of changes in history timeline by increasing the interval allowed between changes `sa.history.aggr_interval_coef` | • Type: integer  
• Default value: 1 |
| A list of comma delimited CI types that are excluded when using the 'Convert to Application Service' and 'Populating Application Service from CIs in the CMDB' operations. Example: `cmdb_ci_service,cmdb_ci_endpoint,cmdb_ci_hardware` `sa.mapping.user.manual.citype.blacklist` | This exclusion list applies when:  
• Manually adding CIs to an application service  
• Converting a business service to an application service  
• Creating or updating an application service using APIs  
• Manually updating an application service with changes from the CMDB  
• Type: string  
• Default value: None |
| Sync Service Mapping operations with Service Modeling `sa.service_modeling.use` | • Type: true|false  
• Default value: true |
| Enable limitation of application service maps drawing by number of nodes and edges. `sa.map.LIMIT_MAX_GRAPH_SIZE` | Limit the number of nodes and edges in application service maps.  
• Type: true|false  
• Default value: true |
<p>| Setting this property to false may reduce performance in maps of large services. | |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Maximal number of displayable nodes on application service map.</strong> Maps with larger values will not be displayed.</td>
<td>The max number of nodes displayed on an application service map. If the number of nodes exceeds the specified number, the map does not appear and an error message appears.</td>
</tr>
</tbody>
</table>
| *sa.map.MAX_NODES_FOR_LAYOUT* | • Type: integer  
• Default value: 5000 |
| **Global flag to allow or disable spanning tree view for maps. true (default) - allows but not forces spanning tree view on maps.** | Enable spanning tree view for application service maps. |
| *sa.map.ALLOW_SPANNING_TREE_VIEW* | • Type: true | false  
• Default value: true |
| **Maximal number of displayable edges on application service map before spanning tree view applied.** | The max number of edges displayed on an application service map, before applying spanning tree view. |
| *sa.map.MAX_EDGES_FOR_FULL_LAYOUT* | • Type: integer  
• Default value: 1000 |
| **Maximal number of displayable edges on application service map.** Maps with larger values will not be displayed. | Max number of edges displayed on an application service map. If the number of edges exceeds the specified number, the map does not appear and an error message appears. |
| *sa.map.MAX_EDGES_FOR_LAYOUT* | • Type: integer  
• Default value: 100000 |
| **Maximal degree of node on application service map for large map mode.** Maps with smaller degrees will be displayed in regular mode. Maps with larger degrees will apply more edges merging for more compact view. | Increasing the default value may reduce performance in maps for large services. |
| *sa.map.LIMIT_GRAPH_DEGREE* | • Type: integer  
• Default value: 1000 |
| **Limit of amount of services that displayed on Services Tree on maps.** Then this limit reached, Services Tree will be blocked. | Increasing the default value may reduce performance in maps for large services. |
| | • Type: integer  
• Default value: 7000 |
<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
</table>
| sa.service_tree.MAX_ITEMS_TO_DISPLAY                          | **• Type:** integer  
**• Default value:** 50                                                   |
| Maximal amount of connection properties to be shown at once when connection line selected on service map. If selected line contains more connections than defined here, then properties panel will have notification about cut-off connections. |                                                                      |
| sa.map.max_connections_in_properties_panel                    | **• Type:** true | false  
**• Default value:** true                                                   |
| Enable grouping of CIs on map.                                |                                                                      |
| sa.map.enable_auto_grouping                                   | **• Type:** integer  
**• Default value:** 10                                                   |
| Minimal number of CIs on a map to apply CI grouping. Relevant only if CI grouping is enabled on the map. The following CIs are not counted: discovered clusters, internal CIs inside inclusion boxes, entry points, error nodes, host CIs or CIs that are not hosted on other CIs. |                                                                      |
| sa.map.min_nodes_for_auto_grouping                            |                                                                      |
| Render full labels on CIs on map. Applicable to all CI labels (CI name, host name, cluster label, etc.) Enabling this will disable labels truncation, and labels will most probably overlap with other map elements. Not applicable to network/storage path maps. | The default value of disabled, mean none.  
**• Type:** choice list  
**• Default value:** Disabled  
**• Other possible values:**  
◦ Exported PDF only: pdf  
◦ Map and PDF views: all |
| sncCommonMap.RENDER_FULL_LABELS                               |                                                                      |
| Maximal width of CI node labels in pixels. Relevant for any kind of labels (CI name, host name, cluster label etc.) This size also modifies horizontal space between CI elements. Applied to map view and exported PDF view. Not applicable to network/storage path maps. | **• Type:** integer  
**• Default value:** 95  
**• Other possible values:**  
◦ Min value: 20  
◦ Max value: 1000 |
<p>| sncCommonMap.NODE_LABEL_WIDTH                                 |                                                                      |
| glide.cmdb.csdm.app_service.max_results                       | Max number of items that are calculated in the <code>&lt;Application Servers | Databases | Hardware Servers&gt; Not in an Application Service</code> report in the Application Service Dashboard. |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>sa.service_max_ci_service_population</td>
<td>The maximum number of CI connections added to application services during the following operations: Converting manual services created in Event Management into application services and updating application services with changes from the CMDB.</td>
</tr>
</tbody>
</table>
| | • Type: integer  
| | • Default value: 100000  
| | • Location: Add to System Properties [sys_properties] table. |
| sa.service.population.stop_expansion_under_ci_classes | The list of application service CI classes. If an application service belongs to a CI class that extends one of the CI classes in the list, the system does not insert CIs under this application service CI during Manually updating an application service with changes from the CMDB. |
| | • Type: string  
| | • Default value: cmdb_ci_service  
| | • Location: System Property [sys_properties] table. |

**CMDB Data Manager**

CMDB Data Manager is a policy-driven framework for managing CI life cycle operations such as deletion and archival, in bulk. The CMDB Data Manager is a comprehensive and integrated solution which scales to large CMDBs and copes with rapid changes in a cloud-based world.
Large CMDBs can over time accumulate large amounts of stale CIs which can impact overall performance. Custom mitigating solutions can be difficult to develop and to maintain, and are also prone to errors. The CMDB Data Manager is the tool where you can create, publish, and manage policies. Create policies to automate and govern CI life cycle operations to help maintain the CMDB in a healthy and efficient operational state.

Terms

Policy

A CMDB Data Manager policy captures the overall management plan for a specific life cycle event, such as CI retirement. A policy is associated with a specific subflow (the policy subflow) which creates the tasks (the policy tasks) for the target CIs of the policy. A policy is configured with a policy type and the policy tasks perform operations associated with that policy type, such as archiving or deleting a CI record. Also, you can configure a policy to require an approval.

The policy type, policy subflow, and the policy tasks, are all aligned to a specific life cycle event of CIs. For example, a policy set with the delete policy type, is associated with the delete subflow, and its policy tasks handle the deletion of CIs.

A daily scheduled job processes all published CMDB Data Manager policies.

Policy subflow

The policy subflow contains the underlying logic to process a life cycle event such as retire or delete. If the policy is configured to require approval, then the policy subflow runs only after a policy task is approved.

The base system provides several common subflows, such as delete, archive, and retire, which you can use with policies. You can also create custom subflows that are needed in the organization.

Policy task

A separate task is created and assigned to each unique Managed By Group value within the set of target CIs in a policy. A policy task triggers the policy subflow, tracks the set of target CIs for the task, and handles the approval of the task, if required.

If a policy requires an approval, the policy tasks do not trigger the policy subflow until a member of the group assignment in the Managed by Group attribute of the target CIs, approves the tasks. If a task is rejected or if the Managed by Group attribute is empty, the task
is assigned to an administrator who needs to manually intervene to resolve the task.

If a policy isn’t configured to require an approval, then the policy tasks are always approved, automatically.

**CI exclusion lists**

A set of CIs to which policies of a specific type do not apply.

**CSDM life cycle state definitions**

CMDB Data Manager follows the Common Service Data Model (CSDM) life cycle states and standards, which basically places the CI in an end of life status. Following CSDM standards, a CI progresses from the state of retired, to archived, and then to deleted. For example, a CI must be retired before it can be archived and then deleted.

**Configure the environment for CMDB Data Manager**

To use CMDB Data Manager, you must first configure your environment as follows:

1. **Prerequisite:** Set up the CSDM environment.
2. Populate the **Manage by Group** attribute of CIs that you plan to target in policies. You can use the CI Class Manager to populate that attribute for an entire class, in a single synchronization operation. For more information about this data synchronization, see Synchronize data using CI Class Manager. If the **Managed by Group** attribute is not populated for a CI, then the approval process is directed to the administrator.

**Use CMDB Data Manager**

To open the CMDB Data Manager, navigate to **Configuration > CMDB Data Manager**.

The CMDB Data Manager tool lets you centrally create, edit, review, publish, and track Data Manager policies and the tasks generated by the policies. Use the CMDB Data Manager to **create CMDB Data Manager policies** that represent your organizational policies for managing the life cycle of CIs. You can create policies such as:

- Retire all computers without owners which were created more than a year ago.
- Archive all Linux servers in the Seattle data center which have not been updated for 6 months.
- Delete all containers which have not been discovered in the past week.
The home page of the CMDB Data Manager provides a dashboard view of policies, excluded CIs, and open policy tasks. Access the open policy tasks that need attention from the management group or from the CMDB Data Manager administrator. Preview those tasks, and then approve or reject to continue the process.

Components installed with CMDB Data Manager

### Scheduled jobs

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB Data Manager Archive/Delete Policy Processor</td>
<td>Processes all published polices of type Archive and Delete:</td>
</tr>
<tr>
<td></td>
<td>• Applies policies only to CIs that are already retired.</td>
</tr>
<tr>
<td></td>
<td>• Processes all Archive policies first, and if no errors encountered,</td>
</tr>
<tr>
<td></td>
<td>continues to process any Delete policies.</td>
</tr>
<tr>
<td>CMDB Data Manager Retire Policy Processor</td>
<td>Processes all published polices of type Retire:</td>
</tr>
<tr>
<td></td>
<td>• Applies policies only to CIs that are not retired.</td>
</tr>
<tr>
<td>CMDB Data Manager - Stale Task Cleaner</td>
<td>Cleans up stale CMDB Data Manager tasks.</td>
</tr>
</tbody>
</table>

### Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB Data Management Policy</td>
<td>Details about CMDB Data Manager policies.</td>
</tr>
<tr>
<td>[cmdb_data_management_policy]</td>
<td></td>
</tr>
<tr>
<td>CMDB Data Management Policy Executions</td>
<td>Execution records corresponding to each policy evaluation.</td>
</tr>
<tr>
<td>[cmdb_data_management_policy_execution]</td>
<td></td>
</tr>
<tr>
<td>CMDB Data Management Policy Runtime Attributes</td>
<td>Current policy metadata including status and summary.</td>
</tr>
<tr>
<td>[cmdb_data_management_policy_runtime_attributes]</td>
<td></td>
</tr>
</tbody>
</table>
### Tables (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB Data Management Task Control</td>
<td>Open policy tasks generated by published policies.</td>
</tr>
<tr>
<td>[cmdb_data_management_task]</td>
<td></td>
</tr>
<tr>
<td>CMDB Data Management Tasks to CIs</td>
<td>Associations of tasks to CIs.</td>
</tr>
<tr>
<td>[cmdb_data_management_task_to_ci]</td>
<td></td>
</tr>
<tr>
<td>Excluded CIs</td>
<td>Tracks the CIs that are set to be excluded during policy evaluation.</td>
</tr>
<tr>
<td>[cmdb_policy_ci_exclusion_list]</td>
<td></td>
</tr>
<tr>
<td>CMDB Policy Types</td>
<td>Policy types supported by the CMDB Data Manager.</td>
</tr>
<tr>
<td>[cmdb_policy_type]</td>
<td></td>
</tr>
<tr>
<td>CMDB Policy Type Categories</td>
<td>Associations of policy types to Flow Designer Categories.</td>
</tr>
<tr>
<td>[cmdb_policy_type_categories]</td>
<td></td>
</tr>
</tbody>
</table>

### Roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB Data Manager administrator</td>
<td>Can access all features in the CMDB Data Manager, including:</td>
<td>• task_editor&lt;br&gt;</td>
</tr>
<tr>
<td>[data_manager_admin]</td>
<td>• Full access to assigned tasks&lt;br&gt;</td>
<td>• data_manager_user&lt;br&gt;</td>
</tr>
<tr>
<td></td>
<td>• Full access to policies&lt;br&gt;</td>
<td>• cmdb_query_builder_read</td>
</tr>
<tr>
<td></td>
<td>• Ability to associate subflow categories to policy type</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Can create, edit, and delete policies, calculate previews, approve tasks,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>and manage exclusion lists.</td>
<td></td>
</tr>
</tbody>
</table>
### Roles (continued)

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB Data Manager user [data_manager_user]</td>
<td>Can view CMDB Data Manager policies in read-only mode and calculate previews.</td>
<td>cmdb_read</td>
</tr>
<tr>
<td></td>
<td>Can perform the following tasks:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View assigned tasks</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Update, approve, or reject an assigned task</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Add a CI to an exclusion list from their task</td>
<td></td>
</tr>
</tbody>
</table>

### System properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cmdb.data.manager.stale.task.life.in.days</td>
<td>Number of days that a stale CMDB Data Manager task stays open until it is set to closed cancelled.</td>
</tr>
<tr>
<td></td>
<td>• Type: Integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 90</td>
</tr>
<tr>
<td>glide.cmdb.data.manager.delete.batch.size</td>
<td>Size of each batch of CIs that is deleted or archived (affects performance optimization).</td>
</tr>
<tr>
<td></td>
<td>• Type: Integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 1000</td>
</tr>
<tr>
<td>glide.cmdb.data.manager.subflow.timeout</td>
<td>Threshold (in milliseconds) for subflow running time. A subflow that passes this threshold while running, is cancelled.</td>
</tr>
<tr>
<td></td>
<td>• Type: Integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 60,000 (10 minutes)</td>
</tr>
</tbody>
</table>
### System properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| `glide.cmdb.data_manager.default_archive_time` | Number of days that it is still possible to restore archived CIs from archive tables. After the specified number of days pass, archived CIs are permanently deleted from the archive tables.  
  - **Type:** Integer  
  - **Default value:** 120 |
| `cmdb.data.manager.stale.task.life.in.days`    | Number of days after which a task is considered stale and is set to **Closed Cancelled** by a daily scheduled job. A task becomes stale if:  
  - The task was created at least 90 days ago and it is still open.  
  - The approval requests are older than 90 days and the task is not yet approved.  
  - **Type:** Integer  
  - **Default value:** 90 |

### Migrate to CSDM life cycle standards

Common Service Data Model (CSDM) provides standard fields and values for tracking life cycle stages and stage statuses for CIs. Using these standard values consistently across applications helps to effectively track assets through their life cycle transitions.

Streamline life cycle management by migrating all life cycle fields and field values across the platform, into a CSDM standard set of fields with a standard set of values. Then, to maintain consistency, continue to use only the standard fields and values when updating or creating CIs. Using standard life cycle values is important in scenarios such as:
• Event Management and Operational Intelligence need to know if a CI is in maintenance to be able to handle alerts accordingly.

• Cloud Insights need to know the state of a CI to be able to report cost data effectively.

• Audit and Compliance need to use standard life cycle values to be able to generate consistent tasks and workflows.

You must activate life cycle migration to migrate legacy life cycle values in the system to the CSDM standard fields and values.

**Life Cycle Mapping table**

The base system contains the Life Cycle Mapping [life_cycle_mapping] table, which is pre-populated with different legacy life cycle mappings, that are widely used. Each mapping record specifies how to map a legacy life cycle field’s value, based on which table it’s in, to CSDM life cycle standards. Similar legacy stage and status from different legacy tables might map to different CSDM life cycle values. Life cycle migration stores standard stage and stage status values in the **Life cycle stage** and the **Life cycle status** fields.

The standard values specified in the Life Cycle Mapping [life_cycle_mapping] table limit the values that the **Life cycle stage** and the **Life cycle status** fields can be set to. The standard values are the only valid settings for these fields.

The Life Cycle Mapping [life_cycle_mapping] table typically contains multiple record entries per class, each entry for a specific legacy life cycle and life cycle value pair. When there are multiple record entries for the same class, the entries are prioritized by importance and likelihood for containing meaningful values to use for the mapping process.

**Custom life cycle values**

In an upgrade scenario, life cycle migration checks for custom legacy life cycle values that were added in the system. For each custom value, if any, the system adds a record to the Life Cycle Mapping [life_cycle_mapping] table. However, those mapping records are incomplete and inactive.

Before you activate life cycle migration, you must edit and activate those records to supply the desired life cycle control to use for mapping.

**Activate life cycle migration**

Map any custom and non-standard life cycle settings in the CMDB, to the Common Service Data Model (CSDM) standard life cycle values of stages and stage status values. Activating life cycle migration applies to existing data and to incoming data.
Before you begin
Before activating life cycle migration, navigate to CSDM > Life Cycle Mapping. Review the pre-populated mappings in the Life Cycle Mappings list view:

- Adjust and add any mappings as needed for your environment.
- Review mappings for any custom legacy life cycle values. Those mappings are incomplete and you must provide the desired standard life cycle control to map to.
- Ensure that all mappings are configured with a life cycle control.
- Ensure that all mappings are activated.

Role required: itil_admin or asset_admin

Procedure
2. On the Life Cycle Mappings list view, click Activate. Activation can complete only if all mapping records are set to active and are configured with a life cycle control, and all mapping records for custom legacy values are fully configured.

Results
Activating life cycle migration starts the following processes:

1. One-time bulk mapping of legacy life cycle values to the new Life cycle stage and Life cycle status fields. The mappings are based on the mapping records in the Life Cycle Mapping table, which contain values, source, and target fields.

2. Setting the csdm.lifecycle.migration.activated system property to true (set to false in the base system), which then activates the Update lifecycle from legacy business rule. Future insert or update CI operations will then trigger this business rule to populate the standard Life cycle stage and Life cycle status fields. These processes ensure that the life cycle standards are used continually and consistently.

For example, when creating a Hardware CI, and setting the legacy Status and Operational status fields. After saving, the new life cycle standard fields are automatically populated with the matching life cycle standard values based on the corresponding record entry in the Life Cycle Mapping table. If you modify legacy values, the standard fields are automatically updated based on another matching record in the Life Cycle Mapping table.
Life cycle migration is a one-time process. Therefore, after activation, the **Activate** button is no longer available.

**What to do next**
After the data has migrated successfully, you can start managing data following the CSDM model:

1. **Activate the CSDM Activation** (com.snc.cmdb.csdm.activation) plugin.
2. Use the **CMDB Data Manager** to centrally govern the life cycle of CIs, in bulk, and in a standard and consistent way.

**Create a mapping record for lifecycle migration**
In addition to pre-populated lifecycle mappings in the Life Cycle Mapping table, you can add mappings for any custom lifecycle values used in your environment. Lifecycle mappings are then used to populate the CSDM standard lifecycle fields with standard lifecycle stage and status values.

**Before you begin**
Role required: itil_admin or asset_admin

**Procedure**
1. Navigate to **CSDM > Life Cycle Mapping**.
2. On the Life Cycle Mappings list view, click **New**.
3. Fill out the Life cycle mappings form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mapping for table</td>
<td>Legacy CMDB table and descending tables, that this mapping applies to. Applies to a descending table unless there is a mapping configured specifically to that descending table.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority of applying this mapping definition for the table. Priority is used when the Life Cycle Mapping table contains multiple entries for the same class. The highest priority entry is used first when searching for meaningful legacy values. If the first entry can’t be used, the next record in priority is used.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Lower numerical values, indicate higher priority.</td>
</tr>
<tr>
<td>Active</td>
<td>Denotes whether to apply this mapping definition or not. Deactivation results in lower-priority mappings being used, or setting standard lifecycle fields to 'TBD'.</td>
</tr>
<tr>
<td>Legacy field name</td>
<td>Legacy field in the specified Mapping for table that is currently being used for lifecycle management to store a lifecycle stage. The value should be used as the source for the lifecycle mapping.</td>
</tr>
<tr>
<td>Legacy field value</td>
<td>Legacy field in the specified Mapping for table that is currently being used for lifecycle management to store lifecycle status. The value should be used as the source for the lifecycle mapping.</td>
</tr>
<tr>
<td>Legacy subfield name</td>
<td>Additional legacy field in the specified Mapping for table which is also used for lifecycle management.</td>
</tr>
<tr>
<td>Legacy subfield value</td>
<td>Additional legacy field in the specified Mapping for table which is also used for lifecycle management.</td>
</tr>
<tr>
<td>Life cycle control</td>
<td>Class, and life cycle stage and status, which are used as the authoritative source of valid combinations for life cycle mapping.</td>
</tr>
<tr>
<td>Table</td>
<td>Standard life cycle table to map the specified Mapping for table to. Setting is based on the selection in Life cycle control.</td>
</tr>
<tr>
<td>Lifecycle stage</td>
<td>Standard life cycle stage to map the specified Legacy field name to. Setting is based on the selection in Life cycle control.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>If there is no match in the Life Cycle Mapping [life_cycle_mapping] table, value is set to 'TBD'.</td>
<td>If there is no match in the Life Cycle Mapping [life_cycle_mapping] table, value is set to 'TBD'.</td>
</tr>
<tr>
<td>Lifecycle stage status</td>
<td>Standard lifecycle stage value to map the specified Legacy field value to. Setting is based on the selection in Life cycle control.</td>
</tr>
<tr>
<td>If there is no match in the Life Cycle Mapping [life_cycle_mapping] table, value is set to 'TBD'.</td>
<td>If there is no match in the Life Cycle Mapping [life_cycle_mapping] table, value is set to 'TBD'.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Create a CMDB Data Manager policy**

Create a CMDB Data Manager policy to automatically process CIs life cycle event such as deletion. Applying consistent and standard life cycle policies to CIs helps maintain the health of the CMDB.

**Before you begin**

- Ensure that any custom subflow that you want to associate with a policy, exist.
- To require a review and an approval for a policy task: Ensure that the **Managed by Policy** attribute is populated in target CIs. Also, ensure that the assigned users have the privilege to approve the policy tasks.
- Life cycle attributes of CIs that you plan to target in an archive or delete policy types, must be set as follows:
  - **Lifecycle Stage** is **End of Life**
  - **Lifecycle Status** is **Retire**
- Life cycle attributes of CIs that you plan to target in a retired policy type, must be set as follows:
  - **Lifecycle Stage** is **not** **End of Life**

**Role required:**

- **Data_manager_admin**: Full access to policies
- **Data_manager_user**: Can read and preview policies
About this task
Specify for each policy a policy type, a life cycle subflow, and a set of CIs to operate on as target CIs.

Set condition filters to specify the initial set of CIs that the policy applies to. You can then further narrow down the initial set of CIs by using a CI exclusion list for the policy type. During the final preview of the policy, or from a policy task, you can select individual CIs to also exclude for the policy type. The policy eventually applies to the resulting set of CIs, after applying all those filters.

If the policy is configured to require an approval for its tasks, then email notifications are sent to members of the assignment group in the Managed by Group attribute of the CI. A policy task triggers the policy subflow only after the task is approved.

Procedure
1. Navigate to Configuration > CMDB Data Manager.
2. On the CMDB Data Manager home page, in the Policies tile, click View Policies.
3. In the CMDB Data Manager Policy and Attributes list view, click New.
4. Fill out the fields on the New Policy tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the policy.</td>
</tr>
<tr>
<td>Needs Review</td>
<td>Check to require a review and an approval of the policy tasks, by the group assignment in CIs' Managed by Group attribute or by an administrator. Otherwise, all policy tasks are approved automatically.</td>
</tr>
<tr>
<td>Policy Type</td>
<td>Life cycle event that this policy manages. Policy type determines the type of actions to perform on target CIs.</td>
</tr>
<tr>
<td>Apply Retention Time</td>
<td>The length of time for retaining archived CIs in the archive table before they are deleted. Applies only when Policy Type is Archive.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition Filter</td>
<td>Criteria that CIs must meet to be included for the policy as target CIs. Further filtering such as a CI exclusion list, can further narrow down the set of target CIs.</td>
</tr>
<tr>
<td>Subflow</td>
<td>A subflow with the actions that will be executed on the target CIs for the policy. The type of subflow typically matches the policy type.</td>
</tr>
</tbody>
</table>

5. **Optional:** Click **Run filter** in the Condition Filter section, to see the resulting list of CIs that match the condition filters.

6. Click **Save**.

7. Click **Preview** and wait for an impact analysis for the policy on the **Preview Policy Impact** page to complete.
   This analysis estimates the number of CIs that the policy applies to based on the policy filters, any CI exclusion lists, and the life cycle stage of CIs. For example:
   - If the policy type is retired, CIs that meet the policy filters but are already in a retired state, are not targeted for the policy.
   - If the policy type is archive or delete, CIs that meet the policy filters but are not retired, are not targeted for the policy.

8. **Optional:** Select CIs in the target CIs list that you want to also exclude for the policy type. Click **Exclude CI** and then click **Recalculate Preview** to recalculate the data on the preview page.

9. Click **Publish** to activate the policy.
   Unpublished tasks are saved as draft policies.

### Results

After you publish a policy:

- A daily scheduled job processes the published policy and policy tasks trigger the policy subflow. Policy execution issues are recorded in an error log with notifications sent to the CMDB Data Manager Administrator.

  If a policy task requires an approval, then the policy subflow is triggered only after the task is approved.
• After a policy task is complete, the policy subflow closes the task. The list of the target CIs is rolled up in a CSV file that is then attached to the task for tracking purposes.

> Note: A CSV file is not created for Retire policy types.

• Stale tasks are set to **Closed Cancelled** by a daily scheduled job. A task becomes stale when it is still open and not approved after at least 90 days. The number of days after which a task is considered stale is determined by the `cmdb.data.manager.stale.task.life.in.days` system property.

**What to do next**

• Track the processing of policy tasks.

• You can open a policy in CMDB Data Manager and click **Deactivate** to temporarily prevent the policy from running.

• Manage CI exclusion lists of CMDB Data Manager.

**Related information**

CMDB Data Manager

**Approve or reject a CMDB Data Manager task**

If you are an authorized approver, you might receive an email notification directing you to review a CMDB Data Manager policy task. Approve the task to continue its processing, or reject the task to send it to the CMDB Data Manager administrator for a more detailed review.

**Before you begin**

Role required:

• **data_manager_admin**: Full access to policy tasks and can set state to 'Work in progress' of an unassigned task.

• **data_manager_user**: Read access to policy tasks and can approve or reject an assigned policy task.

**About this task**

Authorized approvers for a task are all users in the assignment group of the task, with the `data_manager_user` or `data_manager_admin` roles.
Procedure

1. Navigate to **Configuration > CMDB Data Manager**.
2. On the CMDB Data Manager home page, in the Open Policy Tasks tile, click **View Open Tasks**.
3. On the CMDB Data Management Task Control list view, click a task to review.
4. Click the **Approvers** tab in the related lists section.
5. In a record where you are the **Approver**, click the **Requested** value in the **State** column. Then, on the Approval form, set **State** to your approval choice such as **Approved** or **Rejected**.
6. Click **Update**.

Results

1. The **Approval** field of the task is set to **Approved** or **Rejected**.
2. If the task is approved, then the policy subflow is triggered to continue processing the policy tasks for the target CIs.

Manage CI exclusion lists of CMDB Data Manager

Create a CI exclusion list for the various CMDB Data Manager policy types. Policies of a specific policy type will not target CIs in the exclusion list for that policy type.

**Before you begin**

**Role required:**

- data_manager_admin: Full access to CI exclusion lists
- data_manager_user: Read access and can add a CI to a CI exclusion list

**Procedure**

1. Navigate to **Configuration > CMDB Data Manager**.
2. On the CMDB Data Manager home page, in the Excluded CIs tile, click **View Excluded CIs**.
3. On the Excluded CIs list view, click **Edit Exclusion List** and fill out the Specify Excluded CIs form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy Type</td>
<td>Type of policy from which to exclude the specified CIs.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Condition Filter</td>
<td>Conditions that CIs must meet to be excluded for the specified policy type.</td>
</tr>
</tbody>
</table>

4. Click **Run filter**. All the CIs that meet the condition filters, appear in the Results section.

5. In the Results list, select any or all of the CIs that you want to exclude from the policies of the respective policy type. Then, in the Excluded CIs section, click the '+' icon to add the selected CIs to the Excluded CIs list.

6. **Optional:** In the Excluded CIs list, select CIs that you want to remove from the exclusion list. Then, click the trash icon.

7. Click **Save**.

**CMDB CI Lifecycle Management (legacy)**

From the time of its creation to the time that it is no longer needed, a CMDB CI would typically transition through several operational states while undergoing various operations. CI Lifecycle Management provides the mechanism to define states and actions for a CI and lets you apply appropriate actions based on a CI's state to tailor the management of CI lifecycle to business needs.

Terms associated with CI Lifecycle Management:

**Operational states**

A set of states that a CI can be at such as 'Operational' or 'Repair in Progress'. A CI can be associated with only a single operational state at any given time. The choices for operational states are based on the `operational_status` field in the `[cmdb_ci]` table. There are several operational states that are defined in the base system such as 'Retired' and 'Repair in Progress'. You can modify this list to reflect operational states that are relevant in your business.

**Note:** By default, Service Mapping is configured to ignore all host CIs for which the value of Operational status `operational_status` is not 1 (Operational) or the value of status `install_status` is 100 (absent). For additional information about this behavior, see Preparing customized ServiceNow deployments to work with Service Mapping [KB0647574] in the HI Knowledge Base.

CI Lifecycle Management allows multiple operators and automations to simultaneously set different operational states of a CI. Since a CI cannot be associated with multiple operational
states, it is important to configure each operational state with a priority. These priorities are then used in such situation to determine which of the operational states is the cumulative operational state.

**CI actions**

A set of actions that can be applied to a CI during its lifetime. You can define CI actions that are relevant in your business.

**Compatible CI Actions**

CI Lifecycle Management allows a CI to have multiple active CI actions simultaneously, however they must be specifically defined as compatible. By default, there are no two actions for a CI that are compatible with each other. You can change this behavior by specifying pairs of actions that are compatible and thus allowed to be applied simultaneously to a CI. For example, you can specify that the ‘Patching’ and the ‘Provisioning’ CI actions are compatible making it possible to apply both simultaneously to a CI.

**Not Allowed CI Actions**

By default, any CI action can be applied to any CI. You can restrict this behavior by defining a rule that an action is not allowed for a CI when it is in a specific operational state. For example, you can define a Not Allowed CI Action in which it is not allowed to apply the ‘Provisioning’ action to a Linux Server that is in a ‘Non-Operational’ state.

**Not Allowed Operational Transitions**

By default, transitions are allowed from any operational state to another. You can restrict this behavior by defining a rule that for a specified CI, a transition from a certain operational state to another operational state is not allowed. For example, you can define that for a Linux Server it is not allowed to transition from ‘Repair in progress’ to ‘Non-Operational’.

**Requestor**

A requestor can be a workflow or a non-workflow operator that is trying to set operational states and apply CI actions. Each requestor has an associated requestor ID that is a GUID and that can be an active workflow context or a non-workflow registered operator ID.

**Lease time**

A time period that each requestor (especially non-workflow operators) can provide, during which a specified CI action is allowed to be active for a specified CI.
CMDB CI Lifecycle Management provides a set of APIs to manage CI operational states and CI actions. And the UI where you define a set of rules to restrict certain operational state transitions and to restrict actions based on operational states. It also provides a mechanism to audit CI operational state and CI actions during the entire CI lifecycle.

Providers such as automation, workflows, or Change Management can use CI Lifecycle Management as a mechanism to manage CI operational states and apply CI actions. By default, the behavior of CI Lifecycle Management has no restrictions on some operations, and full restrictions on other operations. The CI Lifecycle Management UI lets you modify this default behavior by specifying Not Allowed CI Actions, Compatible CI Actions, and Not Allowed Operational Transitions that restricts some operations and enables for others.

With CI Lifecycle Management you can:

- Manage CI operational states and CI actions throughout the entire CI lifecycle.
- Manage CI operational state transitions.
- Restrict certain operational state transitions.
- Associate certain actions for certain CI types that are in specific operational state.
- Restrict IT Service Management applications based on CI operational state.
- Audit CI operational states and CI actions during the entire CI lifecycle.

**Lifecycle management APIs**

CI Lifecycle Management provides a set of APIs to manage CI operational state and CI actions during the entire CI lifecycle. All restrictions and allowances specified by rules in the UI are enforced when state management APIs run, and if an API attempts to perform a restricted operation, the operation is blocked and an error is logged.

**Registering requestors**

When using the lifecycle management APIs to apply CI actions, requestors are required to be registered and to obtain a requestor ID which is unique within the lifecycle management tables. To register and to obtain a requestor ID, non-workflow users should call the `registerOperator` API. Workflow users can use the active Workflow context as the requestor ID, and they do not need to explicitly call `registerOperator`.

After completing the CI lifecycle operations, the requestor should call the `unregisterOperator` API to unregister. All the state management records associated with that specific requestor ID are then marked as inactive or...
they are removed by the CI Lifecycle Management — Restore Internal State Management Tables scheduled job.

Integration with Incident Management and Problem Management

A base instance includes the pre-defined CI action CreateTask used for creating a task for a CI. New instances have a pre-defined Not Allowed CI Action, specifying that the 'CreateTask' action is not allowed for any CI with a Retired operational state. This restriction is integrated with Incident Management and with Problem Management to prevent the creation of incident or problem tasks for retired CIs. The 'CreateTask' CI action is used as a reference qualifier to the Configuration Item field of the Incident/Problem tables. In a new incident or problem, CIs in which operational Status is 'Retired' — are filtered out from the Configuration Item list on the form. For more information about reference qualifiers, see Reference qualifiers.

Integration with Asset Management

In a base system, a CI's Operational Status field and the Status/Hardware Status (if its hardware) fields are kept synchronized if one of the two fields' values is Retired. When Operational Status of a CI is set to Retired, then the Status/Hardware Status field is automatically set to Retired. In the opposite direction, when the Status/Hardware Status field of a CI is set to Retired, Operational Status is automatically set to Retired too.

- When an Operational Status field changes from Retired to another status, the CI's Status/Hardware Status field is set to Installed.

- When a CI's Status/Hardware Status field changes from Retired to another status, the Operational Status field is automatically set to Non-Operational.

The change of state from 'Retired' to another state is seldom, and by default, the state is changed to 'Non-Operational'. However, this might not be the intended state for the record. Therefore, it important that administrators review and manage the state appropriately in this case.

Whenever CI’s Status/Hardware Status changes, it is synchronized to the CI’s corresponding Asset State field, and vice versa — keeping the CI’s Operational Status and the CI’s corresponding Asset State synchronized.

For more information about mapping Asset State and Substate fields to a CI’s Status/Hardware Status (if its hardware) field, see Map asset state and CI hardware status. And for more information about retiring assets, see Retire assets.
Get started with CI Lifecycle Management

Follow these high level steps to get started and to track activities of the CI Lifecycle Management module of the CMDB application.

Procedure

1. Activate the base system CI Lifecycle Management - Restore Internal State Management Tables scheduled job that continuously checks and maintains data integrity of all internal CI Lifecycle Management tables.
2. Define CI actions.
3. Define compatible CI actions rules.
   Navigate to Configuration > CI Lifecycle Management > CMDB CI Actions to display currently active/inactive CI actions in the CMDB.
4. Define not-allowed CI actions rules.
5. Define not-allowed operational state transitions rules.
6. Define new operational states by modifying the operational_status field in the [cmdb_ci] table in the system dictionary.
   Navigate to Configuration > CI Lifecycle Management > View Internal Operational States to display available operational states set by each requestor.
7. Set priority for operational states.
8. Call APIs to apply CI actions.
   Navigate to Configuration > CI Lifecycle Management > CMDB CI Actions to display which actions were submitted and their active/inactive state in the CMDB.
9. Navigate to Configuration > CI Lifecycle Management > View CI State Registered Users to display currently registered operators that were registered via the registerOperator API.
10. Review Renew Lease tasks and extend leases as needed: Navigate to Configuration > CI Lifecycle Management > Renew Lease Tasks. These tasks are created automatically by the CI Lifecycle Management - Restore Internal State Management Tables scheduled job for CI action records in which the lease for a valid requester has expired. The Requestor should use the lifecycle management API ExtendCIActionLease to extend the lease. Otherwise, if the lease remains expired for a specified grace period, the CI Lifecycle Management - Restore Internal State Management Tables scheduled job marks the respective CI action record as ‘inactive’. 

The grace period for expired lease time is configurable by the system property `glide.cmdb.statemgmt.max_lease_expired_days`.

11. Navigate to **Configuration > CI Lifecycle Management > State Management Logs** to display logs of CI Lifecycle Management operations.

**Lifecycle management APIs**

CI Lifecycle Management provides a set of state management APIs for manipulating CI operational states, and applying CI actions. State management APIs adhere to restrictions and allowances specified by Not Allowed CI Actions, Compatible CI Actions, and Not Allowed Operational Transitions. If an API attempts to perform a restricted operation, the operation is blocked, an error is logged, and a task is automatically created if appropriate.

Lifecycle management APIs can set operational states and CI actions to CMDB groups by utilizing lifecycle management bulk APIs.

**Registration APIs**

- `registerOperator()` - Method to register operator with state management for non-workflow user.
- `unregisterOperator(String requestorId)` - Method to unregister operator for non-workflow users.
- `isValidRequestor(String requestorId)` - Method to determine if the specified requestor is a valid active workflow user or a registered user.
- `isLeaseExpired(String requestorId, String ciSysId, String ciActionName)` - Method to check if registered user lease expired.
- `extendCIActionLease(String requestorId, String ciSysId, String ciActionName, String leaseTime)` - Method to extend CI Action Lease time, for registered users. If previous lease already expired, extend lease from now.

**Operational State APIs**

- `setBulkCIOperationalState(String requestorId, String sysIdList, String opsLabel, String opsStateListOld)` - Method to set Operational State for an array of CIs.
- `getOperationalState(String ciSysId)` - Method to get CI Operational State.
CI Actions APIs

- **addBulkCIAction(String requestorId, String sysIdList, String ciActionName, String ciActionListOld, String leaseTime)** - Method to add CI Action for an array of CIs.
- **removeBulkCIAction(String requestorId, String sysIdList, String ciActionName)** - Method to remove a CI Action for a list of CIs.
- **getCIActions(String ciSysId)** - Method to get CI Actions.

Not Allowed Action Based on Operational State API

- **isNotAllowedAction(String ciType, String opsLabel, String actionName)** - Method to check if a specific CI action is not allowed for specific Operational State on a CI Type.

Not Allowed Operational State Transition API

- **isNotAllowedOpsTransition(String ciType, String opsLabel, String transitionOpsLabel)** - Method to check if specific operational state transition is not allowed on a CI Type.

Compatible Action API

- **isCompatibleCIAction(String actionName, String otherActionName)** - Method to check if two specific actions are compatible with each other.

Example: Using state management APIs

```javascript
// 1. Register Operator with State Mgmt
var output = SNC.StateManagementScriptableApi.registerOperator();
var jsonUntil = new JSON();
var result = jsonUntil.decode(output);
var requestorId = result.requestorId;

// Get list of sys_ids to update
var sys_ids;

// 2. Set list of sys_ids's Operational State to 'Repair in Progress'
output = SNC.StateManagementScriptableApi.setBulkCIOperationalState(requestorId, sys_ids, 'Repair in Progress');
gs.print(output);

// 3. Set list of sys_ids's CI Action State to 'Patching'
output = SNC.StateManagementScriptableApi.addBulkCIAction(requestorId, sys_ids, 'Patching');
gs.print(output);
```
Components installed by CI Lifecycle Management

Several types of components are installed by CI Lifecycle Management (included in the com.snc.cmdb plugin), including tables, scheduled jobs, and properties.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled Job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Lifecycle Management - Restore Internal State Management Tables</td>
<td>Continuously checks and maintains the data integrity of all internal CI Lifecycle Management tables.</td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI State Registered Users [statemgmt_register_users]</td>
<td>All currently active registered users that were created via the registerOperator API. You cannot manually add new records to this table.</td>
</tr>
<tr>
<td>CI Actions [statemgmt_ci_actions]</td>
<td>A set of CI actions that can be applied to a CI during its lifetime.</td>
</tr>
<tr>
<td>CMDB CI Actions [statemgmt_cmdb_actions]</td>
<td>Active/inactive CI actions set by a specific requestor for a specific CI. You cannot manually add new records to this table.</td>
</tr>
<tr>
<td>Compatible CI Actions [statemgmt_compat_actions]</td>
<td>Set of rules that define pairs of CI actions that are compatible for a CI and can be applied simultaneously.</td>
</tr>
<tr>
<td>Not Allowed CI Actions [statemgmt_not_allow_actions]</td>
<td>Set of rules that define specific actions that are not allowed for a CI when its in a specific operational state.</td>
</tr>
<tr>
<td>Internal Operational States [statemgmt_ops_state]</td>
<td>Internal operational states set by a specific active requestor for a specific CI. You cannot manually add new records to this table.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Renew Lease Task</td>
<td>Set of tasks that were automatically created to renew the lease of CI actions whose lease has expired. You cannot manually add new records to this table.</td>
</tr>
<tr>
<td>[statemgmt_renew_lease_task]</td>
<td></td>
</tr>
<tr>
<td>Operational State Priorities</td>
<td>Priorities of operational states which determine precedence when multiple operational states are set for same CIs by different requestors.</td>
</tr>
<tr>
<td>[statemgmt_ops_state_pri]</td>
<td></td>
</tr>
<tr>
<td>Not Allowed Operational Transitions</td>
<td>Set of rules that define specific operational state transitions that are not allowed.</td>
</tr>
<tr>
<td>[statemgmt_not_allow_ops]</td>
<td></td>
</tr>
</tbody>
</table>

**Properties installed**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.cmdb.statemgmt.max_lease_expired_days</td>
<td>Maximum number of days that lease expiration can be set with for CI Actions.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 15</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property [sys_properties] table.</td>
</tr>
<tr>
<td>glide.cmdb.statemgmt.max_bulk_count</td>
<td>Maximum number of CIs that CI Lifecycle Management can process in a bulk update operation.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 1000</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property [sys_properties] table.</td>
</tr>
</tbody>
</table>

**Activate the CI Lifecycle Management scheduled job**

When starting to use the CI Lifecycle Management module, ensure to activate the **CI Lifecycle Management - Restore Internal State Management Tables** scheduled job which is disabled by default. This scheduled job continuously
checks and maintains the data integrity of all internal CI Lifecycle Management tables.

About this task
When CI Lifecycle Management operations do not complete properly, for example due to a failure of the requestor or a requestor whose lease has expired, the integrity of tables related to CI Lifecycle Management might be compromised. The **CI Lifecycle Management - Restore Internal State Management Tables** scheduled job scans tables related to CI Lifecycle Management, and does the following:

- De-activates or removes all internal lifecycle management records with invalid requestors, and closes any corresponding Renew Lease Tasks if present.
- Detects records associated with a valid requestor whose lease has expired, and automatically creates a Renew Lease Task to notify the user and to provide details for extending the lease. If the requestor takes no action and the lease remains expired for a specified grace period (default 15 days), automatically de-activates the corresponding CI action record, and closes any corresponding Renew Lease Task if present.

Procedure
1. Navigate to **System Definition**, and click **Scheduled Jobs**.
2. Search for the **CI Lifecycle Management - Restore Internal State Management Tables** job.
3. In the respective **Active** column, double-click the value **false**, and select **true**.
4. Click the **Save** icon.

Define a CI action
Define a CI Lifecycle Management CI action that can be later applied to CIs.

About this task
You can view a list of all the actions that are currently applied to CIs by navigating to **Configuration** and clicking **CMDB CI Actions**.

Procedure
1. Navigate to **Configuration > CI Lifecycle Management > CI Actions**.
2. On the **CI Actions** page, click **New**. Fill in **Name** and **Description**, and then click **Submit**.
Define compatible CI actions

Allow a CMDB CI Lifecycle Management operation in which two specified CI actions can be applied simultaneously to a CI.

About this task
By default, it is not allowed to apply more than a single action to a CI. You can change that behavior by defining pairs of CI actions as compatible and therefore these actions can be applied simultaneously to a CI. For example you can specify that Provisioning and Patching are compatible CI actions, which lets you apply both to a CI at the same time.

Procedure
1. Navigate to Configuration, and click Compatible CI Actions.
2. On the Compatible CI Actions page click New and fill out the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>First action in the compatibility actions pair.</td>
</tr>
<tr>
<td>Compatible Action</td>
<td>Second action in the compatibility actions pair.</td>
</tr>
</tbody>
</table>

Results
An API can successfully apply the two specified actions simultaneously to a CI.

Define a not-allowed CI action

Define a restriction for CI Lifecycle Management in which a specified action is not allowed for a CI that is in a specified operational state.

About this task
By default, there are no restrictions in the CMDB CI Lifecycle Management on applying CI actions. You can restrict this behavior by not allowing a specified action to be applied to a CI when it is in a specified operational state. For example, you can define a restriction in which the provisioning action cannot be applied to a Linux Server that is in a non-operational state.
Procedure

1. Navigate to **Configuration > CI Lifecycle Management > Not Allowed CI Actions**.

2. Click **New** on the **Not Allowed CI Actions** page, and fill out the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Allowed Action</td>
<td>The action that is being restricted.</td>
</tr>
<tr>
<td>CI Type</td>
<td>The CI type for which the restriction applies to. To apply a rule to all CIs, select Configuration Item.</td>
</tr>
<tr>
<td>Operational State</td>
<td>The operational state that the CI must be at in order to apply the restriction.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**Results**
If an API attempts to apply the specified action to the specified CIs, while it is in the specified operational state, the operation fails and an error is logged.

**Set priority for an operational state**
CI Lifecycle Management allows multiple operators or automations to simultaneously set different operational states for a CI. A CI can have only a single operational state, so in this case, the cumulative operational state of the CI is set to the one with the highest priority. It is recommended that you specify a priority for each operational state that you define so that a cumulative state can be correctly calculated.

**About this task**

**Procedure**

1. Navigate to **Configuration > CI Lifecycle Management > Operational State Priority**.

2. On the **Operational State Priority** page, click the operational state for which you want to set or update priority.

3. Enter a **Priority** and click **Update**. Smaller numbers represent higher priority.
Define a non-allowed operational transition

Define a restriction for CI Lifecycle Management in which a specified CI cannot transition from one operational state to another.

About this task

By default, CI Lifecycle Management has no restrictions for transitioning CIs from one operational state to another. You can restrict this behavior by defining transitions that are not allowed for a specified CI. For example, you can define a restriction on transitioning a Linux server from non-operational state to repair in progress state.

Procedure

1. Navigate to Configuration > CI Lifecycle Management > Not Allowed Operational Transitions.

2. On the Not Allowed Operational Transitions page, click New and fill out the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Type</td>
<td>The CI type for which the restriction applies.</td>
</tr>
<tr>
<td>Not Allowed Transition</td>
<td>The CI state into which transitioning is restricted.</td>
</tr>
<tr>
<td>Operational State</td>
<td>The operational state that the CI must be in for the restriction to apply.</td>
</tr>
</tbody>
</table>

Results

If an API attempts to transition a CI that is in the specified operational state to a state that is not allowed, the operation fails and an error is logged.

CMDB Identification and Reconciliation

The Identification and Reconciliation module provides a centralized framework for identifying and reconciling data from different data sources. It helps maintain the integrity of the CMDB when multiple data sources are used to create and update CI records.

The use of multiple sources, such as EventManagement, Discovery, ImportSets, CloudInsights, pattern discovery, and ManualEntry, increases the risk of introducing inconsistencies through duplicate records. To maintain the integrity
of the database, it is important to correctly identify CIs and services so that new records are created only for CIs that are truly new to the CMDB. Identification and Reconciliation helps you prevent duplication of CI records, reconcile CI attributes, reclassify CIs, and allow only authoritative data sources to update the CMDB.

Related information

Relation qualifier

Domain separation and CMDB Identification and Reconciliation

Domain separation is supported in the CMDB Identification and Reconciliation feature. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Overview

This topic explains how domain separation is enforced during the CMDB Identification and Reconciliation process. In addition this topic addresses how domain separation is applied to the Identification and Reconciliation rules.

How domain separation works in Identification and Reconciliation

The identification process is domain aware. If the domain separation plugin has been activated, then identification processes only those CIs in which the domain ID is identical to the domain of the currently logged on user. If duplicate CIs exist across domains (including parent and child domains), then those CIs are not considered duplicate CIs because their domain IDs do not match. Domain separation in the identification engine is enforced as soon as users activate the domain separation plugin.

Domain separation during the Identification and Reconciliation Process

• Domain separation during the Identification/Reconciliation process is enforced through the domain ID.
  ◦ Domain IDs do not need to be explicitly sent in the input payload of the identification engine APIs. Internally, the identification engine causes the current domain ID of the user to call the identification engine APIs.
  ◦ Only CIs that have the same domain ID as the currently logged-in user’s domain display during matching.
During matching, if no records are found and a CI needs to be inserted, the CI’s domain ID is the same as the domain ID of the currently logged-in user’s domain.

During matching, if duplicates are found, De-Duplication tasks created in the [reconcile_duplicate_task] table, have the same domain ID as those of the duplicate CIs.

Duplicate CIs that exist across domains (including parent and child domains) are not considered as duplicate CIs by the identification engine.

During matching, if reclassification of the CI is not allowed, reclassification tasks are created in the [reclassification_task] table, with the same domain ID as the CI for which reclassification is needed.

**Domain separation and Identification Rules**

- The identification rules and identification inclusion rules used during the identification process are always defined at the global level. For example, the tables below do not have a sys_domain field:
  - Identifier (cmdb_identifier), Identifier Entries (cmdb_identifier_entry), Related Entries (cmdb_related_entry), and Identification Inclusion Rules (cmdb_ie_active_config).

**Domain separation and Reconciliation Rules**

- The reconciliation definition rules that are used during the reconciliation process can be defined for different domains. For example, the tables below do have sys_domain, sys_overrides, sys_domain_path fields:
  - Reconciliation Definition (cmdb_reconciliation_definition), Datasource Precedence (cmdb_datasource_precedence), and Data Source Staleness Definitions (cmdb_datasource_staleness).

**Components and process of Identification and Reconciliation**

The CMDB Identification and Reconciliation functionality is supported by the Identification and Reconciliation engine (IRE) and rules and tasks. Identification rules, reconciliation rules, IRE data source rules, de-duplication tasks, and reclassification tasks determine how IRE identifies and reconciles CI.

**Concepts and Components of Identification and Reconciliation**

Identification

Process of uniquely identifying CIs, to determine if the CI already exists in the CMDB or if it is a newly discovered CI that must be
added to the CMDB. Identification processes rely on identification rules, or on unique IDs for CIs that data sources can provide.

**Reconciliation**

Process of reconciling CIs and CI attributes by allowing only designated authoritative data sources to write to the CMDB at the CI table and attribute level. The CMDB is updated in real time as records are being processed. There is no staging area to verify the reconciliation activities before they are committed. Reconciliation processes rely on reconciliation rules and IRE data source rules.

**De-duplication tasks**

If the instance encounters duplicate CIs during the Identification and Reconciliation process, it groups each set of duplicate CIs into a de-duplication task. Review the information in these tasks to see how it was determined that these CIs are duplicates.

**Reclassification tasks**

During the CI identification process, a matched CI might need to be upgraded, downgraded, or switched to another CI class. If automatic reclassification is disabled, then the system generates a reclassification task. Review the information in these tasks, and decide whether a manual reclassification of the CI is appropriate.

**APIs**

The Identification and Reconciliation APIs are a centralized set of APIs that can be used with different sources of data such as Discovery, Monitoring, or Import Sets. You can use it to enforce Identification and Reconciliation before data is stored in the CMDB. Data sources do not directly write to the CMDB. Instead, they call APIs first to ensure that the data being written does not introduce inconsistencies.

Identification engine APIs are accessible in scoped apps. The Configuration Management For Scoped Apps (CMDB) plugin (com.snc.cmdb.scoped) allows a scoped app in scripts to use the prefix 'sn_cmdb.IdentificationEngine.<method>' to access identification engine APIs. The Configuration Management For Scoped Apps (CMDB) plugin is activated in base systems.

- **createOrUpdateCI()**: A scriptable API that creates or updates a CI based on Identification and Reconciliation rules.
- **identifyCI()**: Similar to the createOrUpdateCI API, but does not commit the result to the database. Use this API with a given
payload to find out if the identification engine will perform insert or update operations, without committing the operation.

- `CreateOrUpdateCIEnhanced()`: A scriptable API that provides the functionality of enhanced IRE features such as partial payload, partial commit, incomplete payload, and deduplication of payload items. You can select the enhanced features to use. However, if you enable partial payloads, then deduplication of payload items and partial commit are automatically enabled.

- `identifyCIEnhanced`: Similar to the `createOrUpdateCIEnhanced` API, but does not commit the result to the database. Use this API with a given payload to find out if the identification engine will perform insert or update operations, without committing the operation.

- `CMDBTransformUtil`: An API to be used exclusively with Import Sets to apply Identification and Reconciliation processes to data imported by Import Sets.

Predefined Identification and Reconciliation rules are included for tables that are in the base instance. You can customize these rules for your organization. When a new table is created in the CMDB, it derives Identification and Reconciliation rules from its parent table if these rules exist. To apply Identification and Reconciliation rules to a new table, create the rules either at the child level or at its parent level.

### Process flow of Identification and Reconciliation

![Process flow of Identification and Reconciliation](image)

**Identification and Reconciliation Engine (IRE)**

Identification and Reconciliation engine (IRE) is an underlying key component in Identification and Reconciliation, providing a centralized framework to perform
Identification and reconciliation processes across different data sources. IRE uses identification rules, reconciliation rules, and IRE data source rules when processing incoming data before inserting that data to the CMDB. IRE processes help maintain data integrity in the CMDB.

- IRE prevents duplicate CIs by uniquely identifying CIs.
- IRE reconciles CI attributes by allowing only authoritative data sources to write to CMDB.

Identification and Reconciliation engine (IRE)

IRE is an underlying key component in Identification and Reconciliation, providing a centralized framework to perform identification and reconciliation processes across different data sources. IRE uses identification rules, reconciliation rules, and IRE data source rules when processing incoming data before inserting that data to the CMDB.

IRE processes help maintain data integrity in the CMDB.

- IRE prevents duplicate CIs by uniquely identifying CIs.
- IRE reconciles CI attributes by allowing only authoritative data sources to write to CMDB.

ServiceNow® applications such as Service Mapping, horizontal discovery, and pattern discovery, use APIs to apply identification and reconciliation processes. You can also apply IRE processes to data imported by import sets. Other data sources including third-party data sources, can leverage REST or scriptable IRE APIs to perform identification and reconciliation.

Additional information:

- About properties that affect some functions of IRE: See Properties for Identification and Reconciliation.
- About using IRE APIs: See IdentificationEngine - Scoped.

CI identification

The CMDB identification process relies on identification rules to uniquely identify CIs. When possible, CIs can also be uniquely identified using source_name and source_native_key values provided in the sys_object_source_info section of the payload, and the Discovery Source [sys_object_source] table. If identification is successful using that method, then it is not necessary to apply matching algorithms that rely on identification rules, which is a slower identification method.

A unique CI identifier can be provided in the optional sys_object_source_info object in the IRE payload.
Payload items identification
IRE generates identifier keys for all payload items in an incoming payload and then uses those keys when trying to match partial payload and incoming payloads. An identifier key is based either on:

- Combination of the `source_name` and `source_native_key` values from the `sys_object_source_info` object.
- Identification criterion attributes.

IRE stores the identifier keys associated with partial items in the `cmdb_ire_partial_payloads_index` table, and then uses those keys to try to match with identifier keys of incoming payloads.

Enhanced IRE features
The `CreateOrUpdateCIEnhanced()` and `identifyCIEnhanced` scriptable APIs provides the functionality for the following enhanced IRE features, which can be enabled or disabled as needed:

**Partial payloads**
IRE isolates items for which data sources did not provide enough information to uniquely identify the CI and therefore processing cannot continue. Some of these items are identified as partial items, which get stored for potential later processing. Other items are identified as incomplete items, which get stored for logging purposes only.
For example: SCCM has multiple feeds such as a disk feed and a computer feed. The disk feed might have complete information about the disk but insufficient information about the computer CI that it depends on.

API option: `partial_payloads` which is enabled by default. When `partial_payloads` is enabled, `partial_commits` and `deduplicate_payloads` are automatically enabled regardless of their setting in options.

**Partial commits**

Errors in some items do not prevent committing the rest of the items in a payload. Therefore, when a payload contains items with errors, IRE still commits the remaining valid items in the payload.

API option: `partial_commits` which is enabled by default.

**Deduplicate payload items**

IRE deduplicates duplicate items within the payload, merging those duplicates into a single payload item for processing.

API option: `deduplicate_payloads` which is enabled by default.

**Generate summary**

IRE generates summaries in the output payload with processing details such as the number of updates per class.

API option: `generate_summary` which is disabled by default.

**Partial items**

A payload item is determined to be a partial item if it contains the necessary data for unique identification and if it has one of the following errors. Unique identification requires that the payload item has the `sys_object_source_info` section with `source_name` and `source_native_key` values, or the full set of the identification criterion attributes specified for the CI class, or both.

IRE errors for a partial item:

- `MISSING_MATCHING_ATTRIBUTES` — Item does not have identification criterion attributes to use at least one identifier entry for matching.
- `REQUIRED_ATTRIBUTE_EMPTY` — Unable to create a CI because a required attribute is missing.
- `MISSING_DEPENDENCY` — Dependent CI is missing a dependency relation which is specified in the payload.
- `INSERT_NOT_ALLOWED_FOR_SOURCE` — An IRE data source rule prevents the specified data sources from creating CIs of the specified class.
For more details about IRE error messages, see IRE error messages.

If processing fails because payload items are determined to be partial items, then the partial items are saved as partial payloads in the CMDB IRE Partial Payloads [cmdb_ire_partial_payloads] table in JSON format for later potential processing. IRE uses identifier keys to attempt to match incoming payloads with stored partial payloads.

If later, a data source sends the data that was missing in the partial item, IRE matches the incoming payload with the stored partial payloads. IRE then merges any matching partial payloads with the incoming payload. To resolve any conflicting attributes, IRE uses either source_recency_timestamp (when source_native_key and source_name are identical), or reconciliation rules specified for the class. The result is a complete and valid payload which IRE then processes to create or update the respective CIs.

Partial payloads older than 90 days are deleted from the CMDB IRE Partial Payloads [cmdb_ire_partial_payloads] table.

Sample of a partial payload:

```json
Disk feed:
{
  "items": [
    {
      "className": "cmdb_ci_computer",
      "sys_object_source_info": {
        "source_native_key": "Server001",
        "source_name": "SCCM",
        "source_feed": "DISK_FEED",
        "source_recency_timestamp": "2019-08-26 13:00:00"
      }
    },
    {
      "className": "cmdb_ci_disk",
      "values": {
        "name": "disk1"
      }
    }
  ],
  "relations": [{
    "parent": 0,
    "child": 1,
    "type": "Contains::Contained by"
  }]
}
```
The computer item in the above payload does not have any attributes and therefore IRE can’t process it. However, source_name and source_native_key are provided making it a partial item. Because the computer item is partial, the disk item that depends on the computer item, is a partial item too.
Sample of a subsequent payload that completes the previous partial payload by providing the missing details:

Server/Computer feed:
{
  "items": [
    {
      "className": "cmdb_ci_linux_server",
      "values": {
        "name": 'linux001',
        "ip_address": "100.126.38.19",
        "mac_address": "DSWER4587"
      },
      "sys_object_source_info": {
        "source_native_key": "Server001",
        "source_name": "SCCM",
        "source_feed": "COMPUTER_IDENTITY",
        "source_recency_timestamp": "2019-08-26 14:00:00"
      }
    }
  ]
}

The computer in the partial payload and the server in the new payload match because they have identical source_name and source_native_key. Therefore, the partial payload and the new payload are merged, the operation is committed, and the partial payload is deleted from the Partial Payloads table.

There is a limit on the number of items per partial payload, which is set by the glide.identification_engine.partial_payload_items_max_size property (1000 by default). Storing associated relationships, references, and dependent items, in one partial payload, can result in reaching that limit, in which case, the payload is split into multiple partial payloads.

For more information about partial payloads, see CreateOrUpdateCIEnhanced().

Incomplete items
A payload item is determined to be an incomplete item if:
• It does not contain all the data necessary for unique identification
• It has an error that is not associated with a partial item
Unique identification is not possible if neither source_name and source_native_key within the sys_object_source_info object, nor the full set of identification criterion attributes specified for the CI class, is provided.

Incomplete items are saved as incomplete payloads in the CMDB IRE Incomplete Payloads [cmdb_ire_incomplete_payloads] table in JSON format. Incomplete items are stored for the purpose of logging payloads with unrecoverable errors, and are never processed again.

**Adding relationships**

Add relationships by using either indices, or the optional JSON internal_id element.

Use the relations object in the payload to add or update relationships by referring to internal_idS of items. Relationships can be created using main items and related items in the payload. For example:

- Relation (parent Index, child Index, Relation Type)
- Relation (parent Internal Id, child Internal Id, Relation Type)

For more information and for code samples, see CreateOrUpdateCIEnhanced().

**Adding references between payload items**

Add references between two payload items by using the optional JSON internal_id element, which uniquely identifies payload items.

Use the referenceItems block to add or update references. You can add references between any two items, including main items, lookup items, and related items, in a single payload.

For more information and for code samples, see CreateOrUpdateCIEnhanced().

**CI reclassification**

Use the updateWithoutUpgrade, updateWithoutDowngrade, and updateWithoutSwitch flags in the settings block in a payload, to prevent unintentional updates to CIs' class. These flags prevent upgrading, downgrading, or switching the class of a CI that multiple data sources unintentionally might attempt while updating the same CI. For more information and for code samples, see CreateOrUpdateCIEnhanced().

Reclassification flags have precedence over any other system settings for CI reclassification during IRE processing.
Adding custom before and after scripts

Use the IntegrationHub ETL to add custom Java scripts for a data source of a CMDB integration application. Those scripts provide access to the IRE input and output payloads, while processing CMDB integrations.

Before scripts provide access to a batch of input payloads that will be sent to IRE. Using a custom before script lets you:

• Skip a payload in the batch by setting the status to SKIPPED. Optionally, provide a reason for skipping the payload which will appear as a comment on the respective import set row table.
• Modify the input payload.
• Write other custom logic inside the script that uses the IRE payload.

After scripts provide access to the IRE input and output payloads. Using a custom after script lets you:

• Easily compare the input and output payloads and identify the different operations that IRE performed on each CI.
• Access the sys_ids of the CIs that IRE created or updated.
• Write other custom logic inside the script that uses the IRE output payload.

Apply CI Identification and Reconciliation to Import Sets

You can apply CMDB Identification and Reconciliation processes when Import Sets are used to import CIs into the CMDB. CI identification can prevent duplicate CIs in the CMDB, which Import Sets might otherwise cause.

Populating CMDB tables using Import Sets can inadvertently result in duplicate CIs when multiple imported records are identical to an existing CI. To minimize this duplication, you can apply CMDB Identification and Reconciliation processes to Import Sets when importing new records into CMDB tables.

Transform map script

In the onBefore transform map script for an import set, add a call to the CMDBTransformUtil API, similar to the following code sample:

```javascript
(function runTransformScript(source, map, log, target) {
  // Call CMDB API to do Identification and Reconciliation of current row
  var cmdbUtil = new CMDBTransformUtil();
  cmdbUtil.identifyAndReconcile(source, map, log);
  ignore = true;

  if (cmdbUtil.hasError()) {
    var errorMessage = cmdbUtil.getError();
  }
}
```
The `ignore = true` code phrase prevents Import Sets from creating the same record again after it is processed by the identification engine.

**Process**

The identification engine performs identification of each source record before it is inserted into the CMDB. The identification engine determines if the record is a duplicate of an existing CI, and then:

- If not duplicate: Inserts the record to the target table.
- If duplicate: Updates the existing CI in the CMDB, with data from the source record.

The CMDBTransformUtil API pre-processes the source data, then passes the input values to the identification engine with import set being the data source by default. The CMDBTransformUtil API supports a target field that is a reference field in the same manner that Import Sets supports it. The CMDBTransformUtil API also supports a source script, evaluating source scripts to determine the target value which is then passed to the identification engine. For more information, see Creating a field map.

**Specify multiple target tables for an import set**

You can configure each record in an import set with its own target table. Then, instead of inserting all the transformed records into a single target table, the records are inserted into the different target tables that are specified per record. For example, you might need to insert some records from the import set to the Computer class and other records to the Server class.

When importing data using Import Sets, incorporate the following steps:

- In the data source file, add a target table column. Use a string such as "MyTable" to label the column header. In each record row, enter the target table for the record, as a valid CMDB class name such as "cmdb_ci_computer".
- After you Auto Map Matching Fields on the Table Transform Map form, add a field map for the added target table column to establish a relationship between classes and the target tables in the CMDB.
1. In the **Field Map** related list on the Table Transform Map form, click **New**.

2. Set **Source field** to the header of the target table column that you added in the data source file, such as **MyTable**.

3. Set **Target field** to **Class**.

4. Click **Submit**.

When you configure an import set with multiple target tables as described in the steps above, the **Target table** that is specified on the Table Transform Map form is not used.

**Restrictions**
The following restrictions apply:

- An import set should be associated with a single transform map. While adding a call to the CMDBTransformUtil API, ensure that still a single transform map exists for the import set.

- The CMDBTransformUtil API does not check if mandatory fields have values when used with Import Sets. Regardless of how **enforce mandatory fields** is set in the transform map, data import fails if a mandatory field does not have a value.

- CI Identification and Reconciliation cannot be applied to Import Sets for dependent CIs (CIs with dependent identification rules).

**Related information**
- Create a transform map

**Identification rules**
The CMDB identification process relies on identification rules to uniquely identify CIs.

An identification rule applies to a CI class and consists of a single **CI identifier** and one or more **identifier entries** and **related entries**, each with a different priority. Each identifier entry defines a unique attribute set with a specific priority and each related entry defines rules for identifying related items. Create strong identification rules that are set with the highest priority for the strongest identifier entries and related entries.

The identification process and identification rules use the CIs attributes for identification:

- **Unique attributes**
Designated sets of criterion attribute values of a CI, that can be used to uniquely identify the CI. Unique attributes can be from the same table or from derived tables.

**Required attributes**

Designated attributes of a CI that cannot be empty.

**Identification rule types**

The steps for identifying dependent CIs can be different from the steps for identifying independent CIs. This difference is reflected in the differences between dependent identification rules and independent identification rules.

**Independent identification rule**

A rule that identifies a CI based on the CI's own attributes, independently of other CIs or relationship.

**Dependent identification rule**

A rule in which identifying a CI requires identifying a dependent CI first. A CI can have dependency on one or more CIs, and a dependent CI can have only a single parent CI with dependency. The relationship types between the CI and its dependent CIs are also included in the identification process. To help with the identification process of dependent CIs, create **dependent relationships** that define the dependency chain within CI types.

The payload used for identification of a dependent CI, can include a relationship with a qualifier chain. For such relationship, if there is a matching parent/child pair, the system compares the qualifier chain in the payload, with the qualifier chain of the CIs in the database. If there is a difference, the qualifier chain in the database is updated to match the qualifier chain in the payload for that relationship.

**Identifier entries**

You can configure an identifier entry to match a CI not only based on the CI's own attributes (field-based identification) but also based on the CI's related list (lookup-based identification) such as **Serial Numbers** or **Network Adapters**. The lookup table that is used for identification, needs to have a reference field that points to `cmdb_ci`.

There are three types of identifier entries:

**Regular identifier entry**

Based on CI's attributes that uniquely identify the CI.

**Lookup identifier entry**
Uses a lookup table (related table) which can be any table that has a reference to the CI that is being identified. After you select a related lookup table, you select identifier attributes from the related table that reference either the cmdb_ci table itself, or one of its descendants.

If the lookup records do not already exist, then they are inserted in the lookup table referenced in the identifier entry.

**Hybrid identifier entry**

A combination of both, a regular identifier entry and a lookup identifier entry.

Example: When discovering virtual machines in a cloud environment which contains two virtual machines with identical serial numbers. A regular identifier entry for the Hardware table such as $[Table: Serial Number, Criterion Attributes: Serial Number, Serial Number Type]$ cannot uniquely identify these two virtual machines. However, a hybrid identifier entry such as $[Table: Serial Number, Criterion Attributes: Serial Number, Serial Number Type + (Name field from main Hardware table)]$ can uniquely identify the two virtual machines.

**Guidelines for lookup tables**

Follow these guidelines when specifying a lookup table in an identifier entry.

1. Ensure that lookup tables reference the cmdb_ci table.

2. It is preferable to enforce exact count match (check box Enforce exact count match (Lookup)) for a stronger identification rule. During lookup identification, this option enforces matching only on exact lookup records count match. See Create or edit a CI identification rule for more details.

3. Do not create conflicting identification rules especially for lookup-based rule.

Example: In a CI Identifier for the Hardware class, you specify a lookup-based rule for the Network Adapter class and you also define a CI Identifier for the Network Adapter class. Duplicates might potentially be created in the Network Adapter table, because there are contradicting rules to identify a unique CI in that table:

- One rule that looks only at criterion attributes (CI identifier rule)
- Another rule that looks at criterion attributes and referenced sys_id (lookup rule).

Example: CI with related items that needs to be inserted - sysId is available.
Related entries

You can define related entries which are rules that are based on related CIs. A related entry is based on a related table which can be any table (CMDB or non-CMDB) that has a reference to the CI that is being identified. Related entries let you create or update records on other tables in which the data is associated with the CI being identified by the identifier entries. Related entries are not used to directly identify CIs.

After you select a related table for the rule, the list in **Referenced field** is populated with fields from the related table that reference either the cmdb_ci table itself, or one of its descendants.

A related entry for a class is derived by child classes for which there no related entries are specified.

**Related information**

**Relation qualifier**

**Create or edit a CI identification rule**

Identification rules are used to uniquely identify CIs in the CMDB, as part of the identification and reconciliation process. Each CMDB class can be associated with a single identification rule.

**Before you begin**

Role required: itil has read access, itil_admin (on top of itil) has full access.

**About this task**

In a CI identification rule, specify a CI identifier, and identifier entries and related entries that uniquely identify the CI.

Review the following before creating identification rules:
• Identification rules
• Effective usage of CMDB Identification

Procedure
1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to display the CI Classes list. Select the class for which to create an identification rule.
3. In the class navigation bar, expand Class Info and then click Identification Rule.
4. Click Edit to edit an existing rule, or click Add in the Identification Rule section to create one. Fill out the form, and then click Save.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Independent/Dependent</td>
<td>Designation of whether the CI identifier can identify the CI independently of other CIs, or not.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of CI identifier.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the CI identifier.</td>
</tr>
</tbody>
</table>

5. In the Identifier Entries section, click an existing identifier entry to edit, or click Add to create one.
6. In the Identifier Entry dialog box, choose an option and then click Next. Continue with one of the following three steps according to the option you selected.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use attributes from main table &lt;table&gt;</td>
<td>Lets you select attributes from the currently selected table (regular identifier entry).</td>
</tr>
<tr>
<td>Use attributes from another table (Lookup table)</td>
<td>Lets you select attributes from any related table, other than the currently selected table (lookup identifier entry).</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use attributes from main and another table (Hybrid)</td>
<td>Lets you select attributes from both the currently selected table, and from another table (hybrid identifier entry).</td>
</tr>
</tbody>
</table>

7. **Use attributes from main table <table>** option: Set the options on the form and then click **Save**.

**Search On Table** is preset to the currently selected table in the CI Classes list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check box that specifies the identifier entry is active. At least one identifier entry in an identification rule must be active for the rule to apply.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority of the identifier entry. Identifier entries are applied based on priority. Rules with lower priority numbers are given higher priority. Identifier entries of identical priorities are applied randomly. You can keep gaps between the priority numbers, so you can assign the unused priority numbers to new entries without modifying the existing priority order.</td>
</tr>
<tr>
<td>Criterion Attributes</td>
<td>Set of attributes that uniquely identify the CI. Attributes can belong to the current class, or to a parent class. It is not possible to add reference fields as a criterion attribute. Reference fields store sys_ids that point to a record in another table, and thus is considered a weak criterion attribute (in terms of uniqueness) for the current table.</td>
</tr>
<tr>
<td>Allow null attribute</td>
<td>When selected, then if at least one criterion attribute is not null, allow to attempt matching with an identifier entry even if there are criterion attributes which are null. Otherwise, all criterion attributes must have values to attempt matching with an identifier entry.</td>
</tr>
<tr>
<td>Allow fallback to parent's rules</td>
<td>Allows the identification rules of the CI's parent to be used if a match is not found for this identification rule. Applies only for dependent identification rules.</td>
</tr>
</tbody>
</table>
Note:

- If criterion attributes have only two attributes and `sys_class_name` is one of them (for example `[name, sys_class_name]`, `[ip_address, sys_class_name]`), then the other attribute cannot be NULL, even if Allow null attribute is enabled. This restriction is due to `sys_class_name` being considered a special system matching attribute.

- Optional condition is applicable only for lookup or hybrid identifier entries (and not applicable when using attributes from the main table).

The Optional condition does not apply, although you are able to customize the default Identifier Entry form by adding the Optional condition field. Then navigating to Configuration > Identification/Reconciliation > CI Identifiers to use that customized form (not using the CI Class Manager).

8. Use attributes from another table (Lookup table) option:

   a. Set Search On Table to a table other than the currently selected table in the CI Classes list. The Search On Table must have a reference field to `cmdb_ci`, otherwise the identifier entry is considered invalid.

   b. Set the rest of the fields as described in the previous step.

   c. Optionally, click Advanced options and enter the information for a lookup identifier (scroll down if necessary).

<table>
<thead>
<tr>
<th>Advanced Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All of these conditions must be met</td>
<td>A filter to narrow the set of records that will be searched for a matching CI.</td>
</tr>
</tbody>
</table>
| Enforce exact count match            | For lookup identification, match a CI only on exact lookup records count match. When enforced, all lookup items for a CI in the payload must have matching records in the lookup table, that reference the same CI:
  
  i. Only matches CIs that have all the lookup items from the input payload referencing the CI in CMDB.
  
  ii. If there are multiple matches, selects the oldest created CI as the final match. |
When not enforced, one lookup item for a CI in the payload matching a record in the lookup table, is sufficient to consider a match:

i. Matches any CI that has at least one of the lookup items from the input payload referencing the CI in CMDB.

ii. If there are multiple matches, selects the CIs with the max number of lookup items from the input payload referencing the CI in CMDB.

iii. If there are still multiple matches, selects the oldest created CI as the final match.

d. Click Save.

9. Use attributes from main and another table (Hybrid) option:

a. Set the options on the General Settings tab as described in previous steps, and then click Next.

b. On the Main Table Settings tab, select the attributes to use from the currently selected table, and then click Next. Search On Table is preset to the currently selected table in the CI Classes list.

c. On the Lookup Table Settings tab, select a Search On Table and then in Criterion Attributes select attributes from the specified table. Search On Table must have a reference field to cmdb_ci, otherwise the identifier entry is considered invalid.

You can click Advanced options and enter the information for a lookup identifier as described in the previous step (scroll down if necessary).

d. Click Save.

Note: The Allow null attribute option in the hybrid option, is set to 'false'. Therefore, all of the selected criterion attributes from both the currently selected table and the lookup table, must have a value.

10. Optional: On the Related Entries section click an existing related entry to edit, or click Add to create one.
a. Update the Related Entry form and then click **Save**.

### Related Entry form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check box that specifies that the related entry is active.</td>
</tr>
<tr>
<td>Related table</td>
<td>A related table that references the CI that is being matched.</td>
</tr>
<tr>
<td>Referenced field</td>
<td>A referenced field in <strong>Related table</strong> that should store the referenced CI. This field always references the <code>cmdb_ci</code> table, or a descendent of the <code>cmdb_ci</code> table.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority of the related entry for the specified <strong>Related table</strong>. Rules with lower priority numbers are given higher priority while matching a related item for specific related table. Related entries for the specified related table with identical priorities are applied randomly. You can keep gaps between the priority numbers, so you can assign the unused priority numbers to new entries without modifying the existing priority order.</td>
</tr>
<tr>
<td>Criterion attributes</td>
<td>The set of attributes to uniquely identify the related item. Attributes can belong to the current class, or to a parent class. (Optional) Click the lock icon to view, add, or remove attributes from the identification rule.</td>
</tr>
<tr>
<td>Allow null attribute</td>
<td>If at least one criterion attribute in the related table is not null, allow to attempt matching with an identifier entry even if there are criterion attributes which are null.</td>
</tr>
<tr>
<td>Optional condition</td>
<td>Use the <strong>Add Filter Condition</strong> and the <strong>Add &quot;OR&quot; Clause</strong> buttons to construct a filter to narrow the set of records that will be searched for a matching related item.</td>
</tr>
</tbody>
</table>
Note: If criterion attributes have only two attributes and `sys_class_name` is one of them (for example `[name, sys_class_name]`, `[ip_address, sys_class_name]`), then the other attribute cannot be NULL, even if **Allow null attribute** is enabled. This restriction is due to `sys_class_name` being considered a special system matching attribute.

A related entry for a class is derived by child classes for which there no related entries are specified.

Example:
For example, the pre-defined **Hardware Rule** applies to the Hardware [cmdb_ci_hardware] table. It has an identifier entry with the criterion attribute **Serial Number, Serial Number Type** and its **Search on table** field is set to **Serial Number**.

The following payload snippet adds a CI to the `cmdb_ci_linux_server` class, that is a child of the Hardware class. It also shows how you can add related items in the payload for which you should create **Related Entries** on the CI Identifier page for the Hardware [cmdb_ci_hardware] table:

```
{
  "items": [
    {
      "className": "cmdb_ci_linux_server",
      "lookup": [
        {
          "className": "cmdb_serial_number",
          "values": {
            "serial_number": "VMware-42 21 e3 da 44 14 5a a6-56 48 2b 0a 28 53 42 4c",
            "serial_number_type": "system",
            "valid": "true"
          }
        },
        {
          "className": "cmdb_serial_number",
          "values": {
            "serial_number": "4221E3DA-4414-5AA6-5648-2B0A2853424C",
            "serial_number_type": "uuid",
            "valid": "true"
          }
        }
      ]
    }
  ]
}
```
When the **Hardware Rule** is applied, the Serial Number [cmdb_serial_number] table is searched for a match with the values specified within the lookup key. Unless **Enforce exact count match (Lookup)** is checked, it is not necessary for every lookup key to return a match, as long as there is at least one match. If all matches reference the same CI, then that CI is considered to be the existing CI record. If no match is found, then the identification search continues to the next rule entry. If after all the rules are exhausted without finding a match, a new CI record is created in the database.
What to do next
You can optionally **create an inclusion rule** to narrow the scope of CIs that are included in identification.

Create an identification inclusion rule
Narrow the scope of CIs that are included in the identification process by creating an identification inclusion rule.

Before you begin
Role required: itil has read access, itil_admin (on top of itil) has full access.

About this task
During duplication detection of independent CIs, the identification and reconciliation engine (IRE) processes only the CIs that satisfy the identification inclusion rules. For example, you can set a filter to include only CIs whose state is operational. When no identification inclusion rules exist, all CIs are included in the identification process and in the CMDB Health duplicate metric calculations. In the base system, there are no predefined identification inclusion rules. Identification inclusion rules are defined at the class level.

Identification inclusion rules also indirectly impact what appears in CMDB health dashboards for duplicate CIs, in addition to any health inclusion rules.

**Note:** Identification inclusion rules impact any script that calls IRE, therefore create them carefully. Identification inclusion rules can prevent the identification of certain types of CIs, affecting some features of Discovery and Service Mapping.

Procedure

1. Navigate to **Configuration > CI Class Manager**.
2. Click **Hierarchy** to display the CI Classes list. Select the class for which to create an identification inclusion rule.
3. In the class navigation bar, expand **Class Info** and then click **Identification**.
4. In the Inclusion Rule (Advanced) section, click **Add** to create a rule or click **Edit** to edit an existing rule. In the Create Inclusion Rules dialog box, specify a criteria in the **Active record condition** field. CIs must meet this criteria to be included in the identification process and in the duplicate CMDB Health metric.
5. Click **Save**.
What to do next
Navigate to Configuration > Identification/Reconciliation > Identification Inclusion Rules > to see the list of all identification inclusion rules.

Related information
Create health inclusion rule

Reconciliation rules
Reconciliation rules specify which discovery sources can update class attributes, and the precedence order among these discovery sources. Ensure that there is a reconciliation rule for each discovery source that is authorized to update an attribute. Reconciliation rules can be defined at the parent and the child class level.

Discovery sources, such as EventManagement, ImportSet, ManualEntry, and Tivoli, are used with the createOrUpdateCI() API to simulate manual updates to CIs. Without reconciliation rules, discovery sources are allowed to overwrite each other's updates to attribute values.

As you create reconciliation rules, keep the following principles and guidelines in mind. These principles are designed for flexibility and the refinement of rules at the attributes level.

Example reconciliation rules
For example, you might have the following reconciliation rules. The rules are created for the cmdb_ci_computer class and one of its child classes, the cmdb_ci_linux_server class. The rules specify the following:

1. Discovery is exclusively authorized to update the name attribute in the cmdb_ci_computer class.
   
   Because reconciliation rules are derived by child classes from parent classes, this rule also authorizes Discovery to update the name attribute in any child classes for the cmdb_ci_computer class.

2. ServiceWatch is exclusively authorized to update the name attribute in the cmdb_ci_linux_server class.

3. ServiceWatch is exclusively authorized to update all attributes in the cmdb_ci_linux_server class, as configured by leaving the Attributes field empty in the rule.

Authorization for all attributes in a class
You can authorize a discovery source to update all attributes in a class. However, this authorization can be overridden for some of the attributes by rules for child classes in which specific attributes are listed.
For example, if only example rules #1 and #3 are created, then Discovery is authorized to update the name attribute in the cmdb_ci_linux_server class. ServiceWatch is authorized to update all other attributes in the class except for the name attribute.

To override the authorization of Discovery to update the name attribute, example rule #2 is added to specifically authorize ServiceWatch to update the attribute.

**Authorization to only specific attributes in a class**

If you want to authorize a discovery source to update specific attributes in a class, list these attributes in the reconciliation rule for the discovery source. A rule that grants access to specific attributes in a class overrides other rules with an empty attribute list that grants access to the entire class.

Example rule #1 grants Discovery with exclusive authority to update the name attribute of the cmdb_ci_computer class. All other discovery sources are prevented from updating the name attribute of any CI in the cmdb_ci_computer class.

**Child class rules overrides parent class rules**

Any reconciliation rules defined for a child class override the rules defined for its parent class.

For example, rule #1 lets Discovery update the name attribute in the cmdb_ci_computer class and all of its child classes. However, rule #2 for the cmdb_ci_linux_server child class, which overrides rule #1 for the parent class, explicitly authorizes ServiceWatch to update this attribute in the child class.

As a result:

- Discovery cannot update the name attribute of the child cmdb_ci_linux_server class. Only ServiceWatch is authorized to update this attribute.
- Discovery is authorized to update the name attribute of CI records in all other child classes of the cmdb_ci_computer class.

**Overlapping rules**

Rules that authorize different discovery sources for the same attributes of the same class can coexist and do not exclude each other.

For example, assume the following rule is added. It is similar to example rule #1 but authorizes a different discovery source:

- ServiceWatch is authorized to update the name attribute in the cmdb_ci_computer class.
Like example rule #1, this new rule applies to the name attribute in the cmdb_ci_computer class so both Discovery and ServiceWatch can update the attribute. Any reconciliation rules are enforced to prevent the discovery sources from overwriting each other's updates.

**Domain separation**

If Domain Separation is enabled, then you can scope reconciliation rules to specific domains. Rules of the parent domain, if not overridden, apply to CIs of child domain. All rules that are visible to a domain are applied, and a rule overriding the parent domain displays the child domain version.

**Create a CI reconciliation rule**

A reconciliation rule specifies class attributes that discovery sources are authorized to update, and prevents unauthorized discovery sources from overwriting the attributes' values. A reconciliation rule also specifies the prioritization among multiple discovery sources. Without reconciliation rules, discovery sources are allowed to overwrite each other's updates to attribute values.

**Before you begin**
Role required: itil has read access, itil_admin (on top of itil) has full access.

**About this task**
Reconciliation rules are used in conjunction with data refresh rules to determine reconciliation steps for a CI. These rules determine if, when, and by which discovery source a CI can be updated. If multiple discovery sources are authorized to update the same class attributes, assign a priority to each of these discovery sources to prevent them from overwriting each other's updates.

After an authorized discovery source updates an attribute, subsequent updates are accepted only from the same discovery source or from a discovery source with a higher priority. Updates from a discovery source with a lower priority are rejected, unless these two conditions are met:

- The lower priority source is the first source updating the CI.
- The CI became stale based on data refresh rules for the CI class.

Precedence order of reconciliation rules:
• Rule configured for a specific attribute, has precedence over rule set with **Apply to all attributes** (regardless of priority value).

• Between two rules for the same attribute or between two rules set with **Apply to all attributes**, the rule that is specific directly for the class has precedence over the derived rule.

• Between two rules for the same attribute or between two rules set with **Apply to all attributes** at the same class level, precedence is determined by rule priorities.

Information about the last discovery source that updates each attribute is stored in the Data Source History `[cmdb_datasource_last_update]` table.

Reconciliation rules affect reconciliation of stale CI attributes. During reconciliation, the information in the Data Source History table is considered along with the data refresh rules for the CI's class, to determine if a CI attribute is stale. A CI attribute is determined to be stale if it was not updated by the latest discovery source to update the CI, within a time period. The time period is specified by the Effective Duration time in the data refresh rule for the class for the discovery source. In this case, if another authorized discovery source, with a lower priority attempts to update the stale CI attribute, the update is allowed.

**Procedure**

1. Navigate to **Configuration > CI Class Manager**.
2. Click **Hierarchy** to open the CI Classes hierarchy list. Then select a class for which to create a reconciliation rule.
3. In the class navigation bar, expand **Class Info** and then click **Reconciliation Rules**.
4. In the Reconciliation Rules section, click **Add** to create a rule or select an existing rule to edit.
5. Fill out the fields on the **Add Data Sources & Prioritize** tab, and then click **Next**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check box to activate this reconciliation rule.</td>
</tr>
<tr>
<td>Discovery Source</td>
<td>The discovery source that you are configuring this rule for.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority of <strong>Source</strong> within other discovery sources for the specified attributes. Smaller numbers designate</td>
</tr>
</tbody>
</table>
You can add multiple pairs of **Discovery Source** and **Priority**.

6. Fill out the fields on the **Select Attributes** tab, and then click **Next**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply to all attributes</td>
<td>Authorizes the specified discovery sources to update all attributes of the specified class.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This rule will be overridden by any rule that applies to a specific attribute. In which case, instead of using this option, you can directly include all attributes for <strong>Attributes</strong>.</td>
</tr>
<tr>
<td>Attributes</td>
<td>Attributes, from the current or from a parent class, that the specified discovery sources are authorized to update. Available only if <strong>Apply to all attributes</strong> is not selected.</td>
</tr>
<tr>
<td>Update with Null</td>
<td>Attributes that the specified discovery sources can update with a null value. By default, authorized discovery sources cannot overwrite a non-null value with a null value. Attributes in this list, which are not in the <strong>Attributes</strong> list, are not included with the attributes that the discovery sources can update with a null value.</td>
</tr>
</tbody>
</table>

7. Fill out the fields on the **Set Filter Condition** tab, and then click **Save**.
### Field | Description
--- | ---
Filter Condition | Conditions that CIs must meet for the rule to be applicable. For example, to apply this rule only to CIs that are associated with the Finance department, select this condition: [Department] [is] [Finance].

**What to do next**

- Click the filter icon (🔍) and select:
  - **Attributes**: To show only reconciliation rules for a specific attribute.
  - **Discovery sources**: To show only reconciliation rules for a specific discovery source.

- Click **Preview Rule** to see per attribute, discovery sources that are authorized to update that attribute, in precedence order.

- Click **Preview Data** to see all attributes for a specific CI. Also, for each attribute, the current CMDB value and discovery sources reported values for the attribute.

  ✉ **Note**: Available only if Multisource CMDB is enabled.

- **Recompute CI attribute values**.

  ✉ **Note**: Available only if Multisource CMDB is enabled.

- Navigate to **Configuration > Identification/Reconciliation > Reconciliation Definitions** to see a list view of all definitions of reconciliation rules.

**Create data refresh rules**

Specify data refresh rules to determine if a CI is stale for a specific discovery source. Such CIs can then be updated by a lower-priority authorized discovery source.

**Before you begin**

Role required: itil has read access, itil_admin (on top of itil) has full access.

**About this task**

Data refresh rules are used in conjunction with reconciliation rules to determine reconciliation steps for a CI. These rules determine if, when, and by which discovery source a CI can be updated.
Procedure

1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to display the CI Classes list. Select the class for which to create a data refresh rule.
3. In the class navigation bar, expand Class Info and then click Reconciliation Rules.
4. In the Data Refresh Rules section, click Add to create a rule or select an existing rule to edit. Fill out the details in the Create Data Refresh Rules dialog box.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovery source</td>
<td>Discovery source of the class.</td>
</tr>
<tr>
<td>Effective Duration</td>
<td>The time period that is used for the staleness test. If the fields specified in the reconciliation rule for the CI's class were not updated by the specified discovery source within the specified time period — the CI is determined to be stale for that discovery source. If you enter a value with a prefix that is valid and a suffix that is not, such as $15\times$ — the valid portion of the value is used (‘15’). If the entire value is invalid — the default value of 0 is used.</td>
</tr>
<tr>
<td>Active</td>
<td>Specifies that the rule is active.</td>
</tr>
</tbody>
</table>

5. Click Save.

Create an IRE data source rule

When using Identification and Reconciliation Engine (IRE), you can prevent a specific discovery (data) source from inserting new CIs for a specific class. Create IRE data source rules for discovery sources that you don't trust in creating CIs but continue to trust in updating those CIs that exist.

Before you begin
Role required: itil_admin
About this task
For example, an IP scan tool that discovers network gear but does not discover servers and therefore creates server CIs without details. You can prevent such discovery source from creating specific CIs, while still permitting it to update those specific CIs if they exist. IRE data source rules are stored in the IRE Data Source Rule [cmdb_ire_data_source_rule] table.

- Child classes derive IRE data source rules from parent classes like identification rules do.
- IRE data source rules that are specified for a child class, override any IRE data source rules derived from a parent class.

When IRE processes an insert operation that is prohibited by an IRE data source rule, the insert operation fails. This failure happens when the discovery source and CI class in the insert operation and in an IRE data source rule, match. When CreateOrUpdateCIEnhanced() is used, IRE stores the failed payload in the CMDB IRE Partial Payloads [cmdb_ire_partial_payloads] table for future potential use.

If later, a permitted discovery source attempts to insert that same CI, then IRE inserts the CI after merging it with the matching CI from the partial payloads. IRE then deletes the partial payload from the CMDB IRE Partial Payloads [cmdb_ire_partial_payloads] table, and allows future updates by the discovery source specified in the rule.

IRE data source rules do not apply to lookup and related items, and only a single rule can be active for any class/discovery source pair.

Procedure
1. Navigate to Configuration > Identification/Reconciliation > IRE Data Source Rule.
2. In the list view, click New and fill out the IRE Data Source Rule form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Activates the IRE data source rule.</td>
</tr>
<tr>
<td>Applies to</td>
<td>The class (and child classes) that the specified discovery (data) source is not allowed to create CIs of.</td>
</tr>
<tr>
<td>Data source</td>
<td>Discovery (data) source that is not allowed to create CIs of the specified class.</td>
</tr>
</tbody>
</table>
### Field Description

| Insert Not Allowed | Enables the specified discovery (data) source from inserting new CIs from the specified class, to the CMDB. |

3. Click **Submit**.

**Results**

If a payload item with an insert request, and in which the discovery source and the CI class match the discovery source and the CI class specified in the IRE data source rule:

1. The insert operation fails and IRE logs the following message:
   
   `INSERT_NOT_ALLOWED_FOR_SOURCE` Insert into `[xyz]` is blocked for data source `[xyz]` by IRE data source rule.

2. If using `CreateOrUpdateCIEnhanced()`, then IRE stores the payload item as a partial payload in the CMDB IRE Partial Payloads `[cmdb_ire_partial_payloads]` table.

If later, a permitted discovery source successfully inserts a CI that matches the CI from a partial payload item:

1. The current CI is merged with the matching CI from the partial payload, applying reconciliation rules as needed.

2. The respective partial payload in the CMDB IRE Partial Payloads `[cmdb_ire_partial_payloads]` table is deleted.

3. Later payloads in which the non-permitted discovery source updates the respective CI, run successfully.

4. IRE allows the discovery source, that was previously prohibited from inserting the CI, to update that same CI which now exists in the CMDB.

**Detecting duplicate CIs**

When the identification process encounters duplicate CIs, it groups each set of duplicate CIs into a de-duplication task for review and remediation. A large number of duplicate CIs might be due to weak identification rules. You can configure the identification engine to reconcile duplicate CIs.

During CMDB Identification, processing of duplicate CIs is determined by the properties `glide.identification_engine.skip_duplicates` (set to true by default) and `glide.identification_engine.skip_duplicates.threshold` (set to 5 by default),
and on the number of duplicate CIs that are detected. You can configure these properties so duplicate CIs are automatically reconciled, skipping duplication.

- If `glide.identification_engine.skip_duplicates` is true, and the number of duplicate CIs is less than the threshold specified by `glide.identification_engine.skip_duplicates.threshold`, then the oldest of the duplicate CIs is picked as a match and gets updated. That oldest duplicate CI also becomes the master CI for that set of duplicate CIs. The rest of the duplicate CIs are tagged as duplicates by setting the cmdb_ci's `duplicate_of` to the appropriate master CI. During matching, the identification engine filters out any CI that is tagged as duplicate of any CI.

- If `glide.identification_engine.skip_duplicates` is false, then matching of duplicate CIs fails with an error, and none of the duplicate CIs are updated.

In either case, de-duplication tasks are always created.

ℹ️ Note: For a duplicate CI, if any of the CI's attributes, other than `duplicate_of`, is updated by IRE processing, then the CI is no longer considered a duplicate CI. In that situation, the value of `duplicate_of` is cleared in the CI.

For more information about these properties, see Properties for Identification and Reconciliation.

**Review de-duplication tasks**

For information about reviewing and remediating de-duplicate tasks, and how the master CI is used, see Duplicate CIs.

**Generate and simulate payload execution using identification simulation**

Identification simulation is a central location for automatically constructing a payload that is guaranteed to be complete and valid. You can then simulate the processing of the payload by the identification and reconciliation engine (IRE) and examine the results before actually submitting it for execution by IRE.

Use identification simulation to construct an input payload, and simulate processing of the payload by IRE. You can then examine the results, adjust identification rules if needed, and re-run the simulation of the updated payload.

Use the identification simulation to:
• Automatically construct input payload that is based on existing identification rules, hosting and containment rules.

• Simulate execution of a payload (automatically constructed by identification simulation, or manually created).

• Browse payload output and execution log messages for a simulated run.

⚠️ Note: Identification simulation does not commit any updates to the CMDB.

Automatically generate payload using identification simulation

Use identification simulation to automatically construct an input payload for a specified class. The constructed payload is complete with any required dependent CIs, correctly structured, and syntactically valid for processing by the identification and reconciliation engine (IRE).

Before you begin
Role required: admin

About this task
The payload that is constructed during identification simulation is for the specified class. For a dependent CI class, you will be prompted for information about all dependencies. After you provide the required details, identification simulation constructs the payload based on your input.

Procedure
1. Navigate to Configuration > Identification/Reconciliation, and click Identification Simulation.

2. In the Start with CI Class box click Start.

3. On the Payload Information form, in the Data source field, select the data source that is associated with this class update. For the ServiceNow Discovery data source, select ServiceNow.

4. Select the Class in the payload.
   a. In the Criterion Attributes area select the CI identifier attributes and then specify the values that uniquely identify a CI.
   b. In the Additional Attributes area specify attributes and values that matching CIs will be updated with.
5. For dependent CIs associated with dependent identification rules, fill out the **Criterion Attributes** and **Additional Attributes** sections in all **Container level** sections that display.

6. Click **Generate Script**. If any errors indicate that there are missing fields, fill in the missing fields and then click **Generate Script** again.

**What to do next**

- Click **Run Simulation** to simulate processing of the payload by IRE.
- Examine the results of the simulation, fine-tune the payload as needed, and combine with other payloads for other classes as desired. After finalizing the payload, use the `createOrUpdateCI()` API to execute the payload by IRE which will result in actual updates to the CMDB.
- Click **Copy Script** to copy the JSON script into the clipboard. You can then paste that script into a third party software or to another screen of the identification simulation.

**Simulate payload processing using identification simulation**

Use identification simulation to simulate the identification and reconciliation engine (IRE) process of CI identification for an input payload. Provide a valid payload, which was constructed using identification simulation or that was created manually.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **Configuration > Identification/Reconciliation**, and click **Identification Simulation**.

2. **Optional:** To run a simulation of an existing payload:
   a. Click **Start** in the **Start with Existing Payload** tile.
   b. On the **Insert JSON Payload** page, select the **Data source** that is associated with this class update.
   c. **Optional:** Select **Use Enhanced Identification** to apply the `identifyCIEnhanced` API for enhanced CI identification, instead of using the `identifyCI` API.
   d. Paste the JSON payload into the empty canvas.
3. Optional: To construct a new payload click **Start** in the **Start with CI Class** tile. See **Automatically generate payload using identification simulation** for more information.

4. Click **Run Simulation** to simulate processing of the payload by IRE.

**What to do next**

1. Examine the results of the simulation in the results pane, and fine-tune the payload as needed:
   a. Click **Run #1** to display the **Context ID** and the **Run ID** of the simulated run.
   b. Click the drop down arrow next to **Run #1** to display additional details.
      • **Input**: Displays the payload for the simulation.
      • **Logs**: Displays all the logged messages that IRE generated while simulating processing of the payload, according to the specified logging level.
      • **Output**: Displays the output payload returned by IRE.

2. After finalizing the payload, use the `createOrUpdateCI()` API to execute the payload by IRE which will result in actual updates to the CMDB.

**Set logging level for identification simulation**

Identification simulation logs each step of a simulated payload processing. You can then examine these run logs to determine if a payload was processed as expected, and if identification rules are effective. You can adjust the level of logging so it is helpful, and so that the amount of messages is not excessive or insufficient.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **Configuration > Identification/Reconciliation**, and click **Identification Simulation**.

2. Click the **Settings** icon.

3. Select logging level for the identification and reconciliation engine (IRE) under **IE Log Level** and for the service cache under **Service Cache Log Level**. The logging levels are displayed in ascending order, from the minimum level to the maximum level of logging.

4. Click on the **Settings** icon again to close the **Settings** dialog box.
Examine run logs

Identification simulation provides run logs which are generated by Identification and Reconciliation Engine (IRE). You can access these run logs for payload runs, to examine results and for debugging purposes. IRE payload output logs appear in a user friendly format on a central page.

Before you begin
Role required: admin

About this task
Also, internal applications that use IRE (such as Discovery) can call an internal API to provide a URL to viewing IRE run logs.

Logging is in the context of a specific run of the identification engine, and you can filter the log list by a specific data source and time range. Up to 1000 run logs that are up to 2 months old are listed, grouped by Context IDs, and run times. You can use the glide.identification_logs.max_run_ids property to modify the 1000 limit.

You can control the logging level by using the glide.discovery.identification.log_level Discovery system property and setting the value to one of the following:

- Info
- Warn
- Error
- Debug
- DebugVerbose
- DebugObnoxious

Note: IRE performs an initial verification of a payload before processing identification rules. If IRE detects any duplicate CIs based on any class identifiers, the payload is rejected and processing stops.

Procedure

1. Navigate to Configuration > Identification/Reconciliation > Identification Logs.
2. Filter the runs list as follows:
   a. Source: Select the data source for which to display run logs.
   b. Time Range: Specify a time range for which to display run logs.
      The Runs list displays all runs for the specified data source, during the specified time range.
3. In the **Runs** list, click a **Run #** to display its **Context ID** and **Run ID**.

   A unique Context ID is associated with each specific payload that is run. Each run of that payload, is associated with a unique Run ID. A single Context ID for a payload that is run multiple times is associated with multiple Run IDs.

4. Click the drop down arrow for a **Run #** to display additional details.

   - **Input**: Displays the payload for the run.
   - **Logs**: Displays all the logged messages that the identification engine generated while running the payload, according to the specified logging level.
   - **Output**: Displays the output payload returned by the identification engine.

**IRE error messages**

The Identification and Reconciliation Engine (IRE) generates the following errors and messages. Depending on settings, these messages appear in the Identification Logging pane and in the system logs.

For information about lookup-based CI identification and qualifier chains, see [Create or edit a CI identification rule](#).

**Note**: IRE performs an initial verification of a payload before processing identification rules. If IRE detects any duplicate CIs based on any class identifiers, the payload is rejected and processing stops.

**Error: IDENTIFICATION_RULE_MISSING**

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identity Rule Missing for table [xyz]</td>
<td><strong>Description:</strong> Identification rule is missing for a class.</td>
</tr>
<tr>
<td></td>
<td><strong>Resolution:</strong> Ensure that there is an identification rule for table [xyz], and that the rule is active.</td>
</tr>
</tbody>
</table>
### MISSING_MATCHING_ATTRIBUTES

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>In payload missing minimum set of input values for criterion (matching) attributes from identify rule for table [xyz]. Add these input values in payload item 'abc'</td>
<td>Description: Missing minimum set of values for criterion attributes for an identification rule.</td>
</tr>
<tr>
<td></td>
<td>Resolution: In the payload, add minimum set of values for criterion attributes for CI Identifier for table [xyz]. Open the CI Class Manager, click Hierarchy and select the [xyz] class. Check the identification rule and the identifier entries for table [xyz].</td>
</tr>
</tbody>
</table>

**Error: NO_CLASS_NAME_FOR_INDEPENDENT_CI**

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot have 'sys_class_name' as a key field in an Independent Identity Rule on 'xyz'</td>
<td>Description: The class attribute was added to the CI identifier which is not supported.</td>
</tr>
<tr>
<td></td>
<td>Resolution: Remove the class attribute from CI Identifier for table [xyz].</td>
</tr>
</tbody>
</table>

**Error: IDENTIFICATION_RULE_FOR_LOOKUP_MISSING**

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identity Rule for table [xyz] missing Lookup Rule for class [abc]</td>
<td>Description:</td>
</tr>
<tr>
<td>Message</td>
<td>Description and Resolution</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>The payload has a lookup class name, but the corresponding lookup rule is missing.</td>
<td></td>
</tr>
<tr>
<td><strong>Resolution:</strong></td>
<td></td>
</tr>
<tr>
<td>Add lookup identifier entry with [Search on table] as [abc] for CI Identifier for table [xyz].</td>
<td></td>
</tr>
</tbody>
</table>

**Error: IDENTIFICATION_RULE_FOR_RELATED_ITEM_MISSING**

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identity Rule for table [xyz] missing Related Rule for class [abc]</td>
<td></td>
</tr>
<tr>
<td><strong>Description:</strong></td>
<td></td>
</tr>
<tr>
<td>The payload has a related class name, but the corresponding related rule is missing.</td>
<td></td>
</tr>
<tr>
<td><strong>Resolution:</strong></td>
<td></td>
</tr>
<tr>
<td>Add related entry with [Related table] as [abc] within CI Identifier for table [xyz].</td>
<td></td>
</tr>
</tbody>
</table>

**Error: NO_LOOKUP_RULES_FORDEPENDENT_CI**

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot have Lookup Rule for a Dependent Identity Rule on 'xyz'.</td>
<td></td>
</tr>
<tr>
<td><strong>Description:</strong></td>
<td></td>
</tr>
<tr>
<td>Cannot have Lookup Rule for a Dependent Identity Rule.</td>
<td></td>
</tr>
<tr>
<td><strong>Resolution:</strong></td>
<td></td>
</tr>
<tr>
<td>Remove lookup identifier entry from dependent CI Identifier for table [xyz].</td>
<td></td>
</tr>
</tbody>
</table>
## Error: INVALID_INPUT_DATA

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Found invalid sys_id in payload. No record with sys_id [xyz] exist in table [abc] or is a duplicate record with [duplicate_of] field set to a master CI | **Description:** The payload has a reference to an invalid sys_id.  
**Resolution:** Remove the referenced sys_id, or provide a valid sys_id. |
| In payload no data source exist. You need to provide choice value from choice field [discovery_source] in table [cmdb_ci] | **Description:** In payload no data source exists.  
**Resolution:** In the payload, provide a valid choice value from choice field [discovery_source] from table [cmdb_ci]. |
| In payload invalid data source [xyz] exist. You need to provide a valid choice value from field [discovery_source] in table [cmdb_ci] | **Description:** The payload contains an invalid data source.  
**Resolution:** In the payload, provide a valid choice value from choice field [discovery_source] from table [cmdb_ci]. |
| No such relationship with name [xyz] exist in table [cmdb_rel_type]. If out-of-box relationship for [xyz] has been removed or renamed, it should be restored | **Description:** The payload is referencing a relationship that does not exist in the [cmdb_rel_type] table.  
**Resolution:** |
<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Verify that the reference to the relationship is accurate. Or, if it is a new relationship, add it to the [cmdb_rel_type] table. Or, If out-of-box relationship for [xyz] has been removed or renamed, restore it.</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Payload relations ‘xyz’ has invalid parent record index: [0]**

**Description:**
Payload references invalid parent indexes.

**Resolution:**
Check payload indexes and ensure that they are all valid.

**Payload relations ‘xyz’ has invalid child record index: [0]**

**Description:**
Payload references invalid child indexes.

**Resolution:**
Check payload indexes and ensure that they are all valid.

**Error: DUPLICATE_RELATIONSHIP_TYPES**

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate relationship type records exists with name [xyz] in table [cmdb_rel_type] having sys_ids: [abc]</td>
<td></td>
</tr>
</tbody>
</table>

**Description:**
There are duplicate records in the [rel_ci_type] table for the relationship.

**Resolution:**
Remove the duplicate records.
### Error: DUPLICATE_PAYLOAD_RECORDS

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Found duplicate items in the payload (index 0 and 1), using className [xyz] and fields [abc]. Remove duplicate items from payload | Description: The payload contains two items whose criterion attributes have identical values.  
Resolution: Remove one of the duplicate items. |

### Error: LOCK_TIMEOUT

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Failed to acquire synchronization lock for xyz                         | Description: Failed to acquire the system mutex lock.  
Resolution: Increase the mutex expiration time by adding the system property `glide.identification_engine.mutex_expiration_time` and setting to an integer value that is greater than the default value (15 min). |

### Error: MULTIPLE_DUPLICATE_RECORDS

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
Resolution: Fix the duplicate records found by the |
### Error: **REQUIRED_ATTRIBUTE_EMPTY**

**Message**

Missing mandatory field [xyz] in table [abc]. Add input value for mandatory field in payload.

**Description and Resolution**

**Description:**

A required attribute is missing in the payload.

**Resolution:**

In the payload, add input value for mandatory field [xyz] in table [abc].

### Error: **MISSING_DEPENDENCY**

**Message**

In payload no relations defined for dependent class [xyz] that matches any containment/hosting rules: [abc]. Add appropriate relations in payload for 'def'.

**Description and Resolution**

**Description:**

No relations defined for the dependent class that matches any of its metadata rules.

**Resolution:**

In payload add appropriate relations for dependent class [xyz] that matches any containment/hosting rules: [abc].
### Error: METADATA_RULE_MISSING

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| No containment or hosting rules defined for dependent class [xyz]. Add containment/hosting rules for ‘abc’ | **Description:**
|                                                                         | There are no containment or hosting rules defined for dependent class.                      |
|                                                                         | **Resolution:**
|                                                                         | Add containment or hosting rules for dependent class [xyz].                                  |

### Error: MULTIPLE_DEPENDENCIES

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Found multiple dependent relation items [xyz] and [abc] in payload      | **Description:**
|                                                                         | Multiple dependent relation items exist.                                                    |
|                                                                         | **Resolution:**
|                                                                         | Remove one of the multiple dependent relation items [xyz] or [abc].                          |
| Multiple paths leading to the same destination: xyz -> abc               | **Description:**
|                                                                         | Multiple paths leading to the same destination.                                             |
|                                                                         | **Resolution:**
|                                                                         | Remove duplicate relationship/qualifier chains that might exists between xyz -> abc.        |
## Error: ABANDONED

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abandoning processing payload item 'xyz', since its depends on payload</td>
<td><strong>Description:</strong> Dependent payload item has errors, so abandoning</td>
</tr>
<tr>
<td>item 'abc' has errors</td>
<td>processing.</td>
</tr>
<tr>
<td></td>
<td><strong>Resolution:</strong> Resolve the error on the dependent payload item</td>
</tr>
<tr>
<td></td>
<td>'abc'.</td>
</tr>
<tr>
<td>Can't find matched record with sys_id [xyz] in table [abc]</td>
<td><strong>Description:</strong> Matched sys_id does not exist in the corresponding</td>
</tr>
<tr>
<td></td>
<td>table.</td>
</tr>
<tr>
<td></td>
<td><strong>Resolution:</strong> Check in table [abc] whether matched record is a</td>
</tr>
<tr>
<td></td>
<td>valid record based on input payload.</td>
</tr>
<tr>
<td>Identification engine API got called recursively, aborting...</td>
<td><strong>Description:</strong> The Identification engine API was called</td>
</tr>
<tr>
<td></td>
<td>recursively.</td>
</tr>
<tr>
<td></td>
<td><strong>Resolution:</strong> Avoid calling the Identification engine API</td>
</tr>
<tr>
<td></td>
<td>recursively.</td>
</tr>
<tr>
<td>Detected error while processing payload from xyz</td>
<td><strong>Description:</strong> Error occurred during processing payload.</td>
</tr>
<tr>
<td></td>
<td><strong>Resolution:</strong> Resolve all errors mentioned in the output</td>
</tr>
<tr>
<td></td>
<td>payload from xyz.</td>
</tr>
<tr>
<td>Message</td>
<td>Description and Resolution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| While processing relations encountered errors in payload item: \texttt{xyz} | **Description:** Payload item has errors.  
**Resolution:** Resolve errors in payload item '\texttt{xyz}'. |
| Error occurred during parsing input json payload: \texttt{xyz}          | **Description:** Error occurred during parsing JSON payload.  
**Resolution:** Ensure that input JSON payload has correct JSON format. |
| Duplicate dependent records found having relationship [\texttt{xyz}] with same CI (className:[\texttt{abc}], sysId:[\texttt{def}]) | **Description:** Found duplicate dependent CIs.  
**Resolution:** Check de-duplication tasks for information about all duplicates, and then delete duplicate records. |
| Found multiple relations between payload items: '\texttt{xyz}' and '\texttt{abc}' | **Description:** Found multiple relations between payload items.  
**Resolution:** Check for duplicate relationship chains and qualifier chains that might exist. |

**Error: MULTI_MATCH**

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Duplicate dependent records found having relationship [\texttt{xyz}] with same CI (className:[\texttt{abc}], sysId:[\texttt{def}]) | **Description:** Found duplicate dependent CIs.  
**Resolution:** Check de-duplication tasks for information about all duplicates, and then delete duplicate records. |
| Found multiple relations between payload items: '\texttt{xyz}' and '\texttt{abc}' | **Description:** Found multiple relations between payload items.  
**Resolution:** Check for duplicate relationship chains and qualifier chains that might exist. |
<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Found duplicate records in lookup table [xyz] using fields [abc] and reference field [def] | **Description:**
Found duplicate records in lookup table.

**Resolution:**
Check de-duplication tasks for information about all duplicates, and then delete duplicate records. |

### Error: QUALIFICATION_LOOP

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Qualification chain has loop that contains relation ‘xyz’ | **Description:**
Qualification chain has a loop.

**Resolution:**
Remove the loop from the qualification chain with relation ‘xyz’. |

### Error: TYPE_CONFLICT_IN_QUALIFICATION

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Invalid payload, qualification chain has multiple possible paths for payload items: ‘xyz’ and ‘abc’ | **Description:**
Multiple qualification paths found.

**Resolution:**
Remove multiple possible qualification paths between items ‘xyz’ and ‘abc’. |
## Error: RECLASSIFICATION_NOT_ALLOWED

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Reclassification not allowed from class: [xyz] to [abc]</td>
<td><strong>Description:</strong> CI reclassification not allowed.</td>
</tr>
<tr>
<td></td>
<td><strong>Resolution:</strong> Check reclassification tasks for information about reclassification, and check if reclassification from class: [xyz] to [abc] is valid.</td>
</tr>
</tbody>
</table>

## Error: DUPLICATE_RELATED_PAYLOAD

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Found duplicate Related items (0 and 1) in the payload index 1 using fields xyz</td>
<td><strong>Description:</strong> Duplicate Related items present.</td>
</tr>
<tr>
<td></td>
<td><strong>Resolution:</strong> Remove one of the duplicate related items present in the payload.</td>
</tr>
</tbody>
</table>

## Error: DUPLICATE_LOOKUP_PAYLOAD

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Found duplicate Lookup items (0 and 1) in the payload index 1 using fields xyz</td>
<td><strong>Description:</strong> Duplicate lookup items present.</td>
</tr>
<tr>
<td></td>
<td><strong>Resolution:</strong> Remove one of the duplicate lookup items present in the payload.</td>
</tr>
</tbody>
</table>
**INSERT_NOT_ALLOWED_FOR_SOURCE**

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Insert into [xyz] is blocked for data source [abc] by IRE data source rule | **Description:**  
An IRE data source rule is configured to prevent data source [abc] from inserting CIs of the [xyz] class.  

**Resolution:**  
Delete or update the appropriate IRE data source rule to let data source [abc] insert CIs of the [xyz] class.  
Or, wait for another permitted data source to create the same CI. |

---

**CI reclassification during IRE processing**

During the Identification and Reconciliation Engine (IRE) CI identification process, a CI might need to be reclassified to a different `sys_class_name` type. By default, CIs are reclassified automatically. If automatic reclassification is disabled, then the CI is not reclassified and the system generates a reclassification task for your review.

The class of a CI can be upgraded, downgraded, or switched to a different branch in the class hierarchy. For more details about reclassification operations, see [Reclassify a CI](#). You can use system properties and payload flags to configure the IRE behavior of CI reclassification, globally or individually per CI.

⚠️ **Note:** CI reclassification is possible only between two classes that have identical identification rules.

**Configure automatic CI reclassification using system properties**

You can use system properties to configure system-wide IRE behavior for CI reclassification.
• The following properties enable or disable automatic reclassification updates that are specified in a payload. These properties are set to true in the base system, enabling processing of CI updates, including CI reclassification updates.

To disable any automatic reclassification update, set the respective property to false. In that case, IRE rejects a payload (or a payload item in Enhanced IRE) with the respective reclassification updates, and creates a reclassification task.

○ glide.class.upgrade.enabled
○ glide.class.downgrade.enabled
○ glide.class.switch.enabled

• The following properties enable IRE to process CI updates with reclassification operations. However, depending on the property setting, IRE processes or skips the reclassification update. These properties are set to false in the base system, in which case IRE processes CI updates including any CI reclassifications.

Set a property to true to configure IRE to process CI updates but not the CI respective reclassification update.

○ glide.identification_engine.update_without_switch_enabled
○ glide.identification_engine.update_without_downgrade_enabled
○ glide.identification_engine.update_without_upgrade_enabled

This set of properties takes precedence over the previous set of properties (glide.class.<reclassification>.enabled). For example, with the following conflicting property settings, the second property takes precedence over the first:

○ glide.class.downgrade.enabled = false
○ glide.identification_engine.update_without_downgrade_enabled = true

Example for IRE processing of a payload item with a switch of a CI from Linux Server to Window Server. With the following default property settings in the base system, IRE updates the attributes including the class switch:

• glide.class.switch.enabled = true
• glide.identification_engine.update_without_switch_enabled = false

However, with the following property settings, IRE updates the attributes but skips the class switch:
glide.class.switch.enabled = true

glide.identification_engine.update_without_switch_enabled = true

For more information about CI reclassification-related properties, see Properties for Identification and Reconciliation.

Configure automatic CI reclassification in input payloads

You can use flags which correspond to the system properties, in the input payload of the CreateOrUpdateCIEnhanced() or the createOrUpdateCI() APIs. In the payload, set these flags to true or false to temporarily override the respective system property settings, at the payload item level.

Payload flags that control reclassification behavior:

• classUpgrade
• classDowngrade
• classSwitch
• updateWithoutUpgrade
• updateWithoutDowngrade
• updateWithoutSwitch

The following sample JSON payload enables automatic reclassification for the specified CI:

```
{ items: [{className: 'cmdb_ci_server', classUpgrade: true, classDowngrade: true,
            classSwitch: true, values: {name: 'linux123', serial_number: '12srt567', ip_address:
            '10.2.3.4'}}, ]}
```

Reclassification restriction rules

Prevent IRE from downgrading or switching a CI class during payload processing to help prevent data loss. A reclassification restriction rule prevents a CI class change for specific source and target classes, while still processing any other property updates for the CI.

You can use a reclassification restriction rule, for example, to prevent a CI class downgrade from cmdb_ci_linux_server (source class) to cmdb_ci_server (target class). Or, to prevent a CI class switch from Linux Server to Windows Server. Reclassification restriction rules can be useful when using a Service Graph connector which might lead to a class downgrade or switch, and a potential loss of important data.

To control the application of reclassification restriction rules:
• Use the `glide.identification_engine.reclassification_restriction_rules_enabled` system property to globally enable or disable the application of active reclassification restriction rules. This property is set to `true` by default.

• Use the `skipReclassificationRestrictionRules` payload flag in an IRE payload to prevent the application of active reclassification restriction rules.

For example, a payload with the `skipReclassificationRestrictionRules` flag:

```json
{
  "items": [
    {
      "className": "cmdb_ci_server",
      "values": {
        "short_description": "Linux server description",
        "name": "Linux Server 1"
      },
      "settings": {
        "skipReclassificationRestrictionRules": "true"
      }
    }
  ]
}
```

For information about how to create a reclassification restriction rule, see Create a reclassification restriction rule.

Create a reclassification restriction rule

Reduce data loss during IRE processing by preventing a CI class change for specific source and target classes. A reclassification restriction rule affects only the `class` attribute and does not prevent the update to the rest of the CI properties.

Before you begin
Role required: Itil_admin (Itil has read privilege only)

About this task
If during IRE processing of a payload, a CI needs to be reclassified (downgrade or switch class), IRE checks reclassification restriction rules. If any reclassification restriction rule applies to the current CI reclassification, IRE processes the CI properties update, but skips the CI reclassification.

IRE output provides specific details about any processing related to reclassification restriction rules.
A reclassification restriction rule applies only to the direction between the specified source and the target classes. The rule doesn’t prevent a reclassification in the opposite direction, from the specified target class to the source class. To restrict reclassification between two classes in both directions, specify two separate reclassification restriction rules, one for each direction.

**Procedure**

1. Enter `cmdb_ire_reclassification_restriction.list` in the filter navigator.
2. Fill out the Reclassification Restriction form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the reclassification restriction rule.</td>
</tr>
<tr>
<td>Source table</td>
<td>Current CI class.</td>
</tr>
<tr>
<td>Source inheritance</td>
<td>Whether to apply the reclassification restriction rule to child classes of Source table.</td>
</tr>
<tr>
<td>Target class</td>
<td>Reclassification target class.</td>
</tr>
<tr>
<td>Target inheritance</td>
<td>Whether to apply the reclassification restriction rule to child classes of Target table.</td>
</tr>
<tr>
<td>Type</td>
<td>CI reclassification type: <strong>Downgrade</strong> or <strong>Switch</strong>.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**What to do next**

In the Reclassification Restrictions list view, you can activate or deactivate a reclassification restriction rule by setting its **Active** value to true or false.

**View a reclassification task**

When automatic CI reclassification is disabled, reclassification tasks are created for CIs that could not be automatically reclassified during the identification process. Review these tasks to locate the CIs and decide if to reclassify them.

**Before you begin**

Role required: admin or itil
Procedure
1. Navigate to **Configuration > Identification/Reconciliation > Reclassification Tasks**.
2. Select a reclassification task.
3. Examine the details on the Reclassification Task form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration item</td>
<td>The CI that must be reclassified.</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description noting that CI reclassification was not allowed.</td>
</tr>
<tr>
<td>Description</td>
<td>Description noting the current class of the CI and the class that the CI must be changed to.</td>
</tr>
<tr>
<td>Internal payload</td>
<td>Payload used in the identification process.</td>
</tr>
</tbody>
</table>

**What to do next**
After examining the task details, you can locate the CI that is noted in the task Description and manually reclassify it. For details, see [Reclassify a CI](#).

**CMDB dependent relationship rules**
Service definitions consist of CI types and relationship types. Dependent relationship rules define the dependency structure of the CI types and the relationship types in these service definitions, helping in CI identification and in the construction of business service maps.

The dependencies that are defined by these rules are used when identifying dependent CIs to prioritize the order of CI identification, and to match CIs and respective dependent CIs in a payload. Dependent relationship rules are also used by Service Mapping and can be defined for custom CI types. After defining a new CI type, you can define dependent relationship rules that specify how the new CI type is related to existing types in the CMDB.

Dependent relationship rules consist of hosting and containment rules (dependent relationship rules), each type modeling the data from a different perspective of the CI. Containment rules represent CIs’ configuration hierarchy, describing which CI contains which other CIs. Hosting rules represent CIs’ placement in a business definition, describing what CIs run on.
Both hosting and containment rules describe a relationship type between two CI types and the same relationship type can be used in a hosting rule and in a containment rule. It is the context in which the relationship is used that distinguishes between a containment and hosting rule.

Manage dependent relationship rules:

• To access rules at the class level, use the CI Class Manager. Navigate to Configuration > CI Class Manager.

• To access grouped rules, use the Metadata Editor. Navigate to Configuration > Identification/Reconciliation > Metadata Editor.

The plugins that have been activated on an instance determine which hosting and containment rules exist in a base system.

**Hosting rules**

Hosting rules represent all the possible valid combinations of pairs of hosting and hosted CIs in the service definition. Hosting rules are a flat set of rules that can be only one level deep, and which always involve resources, typically physical or virtual hardware. Each hosting rule is a stand-alone rule between two CI types, describing either a valid CI type that another CI type can host, or by which another CI type can be hosted. A hosting rule consists of a parent CI type, a relationship type (such as Hosted On::Hosts) and a child CI type. For example, you can have a hosting rule that specifies that the CI type 'Application' 'Runs On::Runs', the CI type 'Hardware'.

A CI can be hosted on multiple resources (such as Windows and Linux). This CI is represented by a hosting rule for the CI with each resource that the CI can be hosted on. During CI identification, the pair of CIs that are being examined, should satisfy at least one hosting rule.

Hosting rules are stored in the CMDB Metadata Hosting Rules [cmdb_metadata_hosting] table.

**Containment rules**

Containment rules represent the containment hierarchy for a CI type, describing valid objects that a CI type can contain in the service definition, and valid objects that can be contained by the CI type. Containment rules are chained to each other in a containment rules group, with a CI type that is the top-level (root) parent of the group. The collection of containment rules construct a hierarchy-like map of containment relationships. Containment rules are logical concepts used to represent logical CIs, for example to describe software that runs on a server. A containment rule consists of a parent CI type, a relationship type (such as 'Contained By::Contains'), and a child CI type. For example,
you might have a containment rule specifying that the CI type ‘Tomcat’ ‘Contains::Contained By’ CI type ‘WAR File’.

Endpoints are special containment rules that specify incoming or outgoing connections in the model, designating the CI types that data of some specified type flows in to or out from the service definition. After adding an endpoint to a containment rule, you cannot add any child rules to the endpoint rule.

Containment rules are stored in the CMDB Metadata Containment Rules [cmdb_metadata_containment] table.

Reference rules
Reference rules are used mostly by Cloud Management to represent all of the possible valid combinations of pairs of referencing and referenced CIs in the service definition.

• Reference rules are a flat set of rules that can be only one level deep.
• Reference rules always involve resources, typically virtual entities. Each reference rule is a stand-alone rule between two CI types, describing either a valid CI type that another CI type can reference, or by which another CI type can be referenced. Both the CI classes should be able to live independent of each other.
• A referencing rule consists of a parent CI type, a relationship type (such as Provisioned From::Provisioned) and a child CI type. For example, you can have a referencing rule that specifies that the CI type ‘Virtual Machine’ Provisioned From::Provisioned, the CI type ‘Image’.
• A CI can reference multiple resources (for example, a VM Instance can have a reference relation with both the Image and the Hardware templates). This CI is represented by a referencing rule for the CI with each resource that the CI can be referenced from.
• The reference rule cannot be part of the CI identification.
• Reference rules are stored in the CMDB Metadata Reference Rules [cmdb_metadata_reference] table.

Rules requirements
The rules that you create are bound by the following requirements which narrow the relationships and ensure that only valid options are available in the drop-down lists in the Metadata Editor.
• Given a CI type that is as a child in a containment rule: Not this CI type or its children can be a top-level (root) parent of any other containment rule, and it cannot be in any hosting rule, either as a parent or as a child.

• Given a CI type that is a top-level (root) parent of a containment rule: It cannot be a child in a hosting rule (for example, you cannot be hosted on Tomcat, if Tomcat has any containment rules).

• Given a CI type that is a child in a hosting rule: It cannot be in any containment rule, either as a parent or a child.

• Given a CI type that is a parent in a hosting rule: It cannot be a child in any containment rule.

• Hosting rules cannot create loops such as Tomcat –runs_on- VMWare –runs_on- Tomcat.

Example: Hosting and containment rules model

Hosting rules that model the diagram:
• Tomcat 'Runs on' Hardware

Containment rules that model the diagram:
• Tomcat 'Contains' Configuration File
• Tomcat 'Contains' WAR
• WAR has two endpoints for JDBC with MySQL:
  ◦ Inbound
  ◦ Outbound
Example: Valid set of rules

<table>
<thead>
<tr>
<th>Tomcat Hosted Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linux Hosted Computer</td>
</tr>
</tbody>
</table>

The second metadata entry triggers the third requirement, which is satisfied (it is a hosting rule, not a containment rule).

Create dependent relationship rules

Create hosting and containment rules (dependent relationship rules) for CI classes to help with correctly identifying dependent CIs during the business discovery process and service mapping. Discovery calls the identification API that applies dependent relationship rules.

You can create a basic hosting or containment rule in the CI Class Manager. Or, use the Metadata Editor to create groups of hosting and containment rules, and inbound or outbound endpoints in containment rules. The CI Class Manager and the Metadata Editor are synchronized, and you can use each of those tools to display and edit a dependent rule.

Create a dependent relationship rule for a CMDB class

Use the CI Class Manager to create a basic dependent relationship rule (hosting or containment relationship rule) for a CMDB class.

Before you begin

Role required: itil has read access, itil_admin (on top of itil) has full access.

About this task

The class for which you create dependent relationship rule, must have a dependent identification rule.

Procedure

1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to display the CI Classes list, and select the class for which you want to create a hosting or a containment rule.
3. In the class navigation bar, click Dependent Relationships.
4. In the Dependent Relationships view, click Add dependency.
5. Fill out the details in the Add Dependent Relationship Rule dialog box.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule Type</td>
<td>Designation of whether this rule is a hosting rule or a containment rule.</td>
</tr>
<tr>
<td>This Class</td>
<td>The class that the rule applies to.</td>
</tr>
<tr>
<td>Relationship</td>
<td>The relationship type for the rule.</td>
</tr>
<tr>
<td>Target Class</td>
<td>The target class for the dependent relationship rule. The designation of this class as a child or parent class, is based on the specified Relationship.</td>
</tr>
</tbody>
</table>

6. Click **Save**.

**What to do next**
You can click **Reset to derived** and then confirm the operation to delete all dependent relationship rules that were added specifically for the selected class. Only dependent relationships that are derived from a parent class, remain.

For more information about child and parent classes, see [Table extension and classes](#).

**Create or edit a collection of containment rules**
Create containment rule for CIs to help with correctly identifying dependent CIs during the business discovery process and service mapping. Discovery calls the identification API that applies dependent relationship rules.

**Before you begin**
Role required: admin

**About this task**
A containment rule is a dependent relationship rule which defines a relationship between two CIs, structured as: CIType1 RelationshipType CIType2. The first CI type that you add becomes the top level CI of a containment rules group which is a chain of containment rules. The entire set of containment rules is organized as groups according to top-level CIs.

To create a containment rules group for a new CI type, you need to first add the CI Type1 of the relationship. To add a child containment rule for a CI type that exists, you need to select that CI type, and define the second portion of the relationship rule which is the relationship type and CI Type2.

To each rule within a containment rules group you can add inbound or outbound endpoints, which are noted by blue up and down arrows. After
adding an endpoint, you can not add a containment rule in that branch of the containment rules hierarchy.

**Procedure**

1. Navigate to Configuration > Metadata Editor.
2. In the Metadata Editor, click the Containment Rules tab.
3. Click Add New Rule to add a top-level rule. Or, point to a rule for which you want to add a child rule and click the green '+' icon that appears on the right.
4. Complete the Add Containment Rule to <class> form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Item Type</td>
<td>The CI class that the rule applies to.</td>
</tr>
<tr>
<td>Relationship Type</td>
<td>The relationship type for the rule.</td>
</tr>
<tr>
<td>Reverse Relationship Direction</td>
<td>Enable to use the reverse relationship in the rule.</td>
</tr>
<tr>
<td>Always include in Service Model</td>
<td>Enable to always include the CIs of the specified class in the Service Map if their parent CI (based on the containment relationship) is present in the Service Map.</td>
</tr>
</tbody>
</table>

5. Click Create.
6. Add an endpoint to a child rule:

   a. Point to a child rule for which you want to add an endpoint.

   b. Click the blue "+" icon that appears on the right.

   c. Complete the Add Endpoint To <class> form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint Type</td>
<td>The type of endpoint.</td>
</tr>
</tbody>
</table>
Create or edit a collection of hosting rules

Create hosting rule for CIs to assist in correctly identifying dependent CIs during the business discovery process and service mapping. Discovery calls the identification API that applies dependent relationship rules.

Before you begin
A hosting rule is a dependent relationship rule which defines a relationship between two CIs, structured as: `<CI Type1> <relationship type> <CI Type2>`. To create a hosting rule, you need to add a CI type as `<CI Type1>` in the relationship rule, and then define the second portion of the relationship rule which is the relationship type and `<CI Type2>`. The entire set of hosting rules is organized as groups according to the top-level hosted CIs.

A hosting rule implicitly contains two rules, which are the reversal of each other. When you create the rule '<CI Type1> <relationship type> <CI Type2>', the rule '<CI Type2> <reversed relationship type> <CI Type1>' is automatically added.

Role required: admin

Procedure
1. Navigate to **Configuration > Metadata Editor**.
2. In the Metadata Editor, click the **Hosting Rules** tab.
3. Click **Add New Rule** to add a top-level rule. Or, point to a rule for which you want to add a child rule and click the green '+' icon that appears on the right.
4. Complete the **Add Hosted/Hosting Rule to <class>** form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Item Type</td>
<td>The <code>&lt;CI Type2&gt;</code> in the rule.</td>
</tr>
<tr>
<td>Relationship Type</td>
<td>The relationship type for the rule.</td>
</tr>
<tr>
<td>Reverse Relationship Direction</td>
<td>Check to reverse relationship in the rule.</td>
</tr>
</tbody>
</table>

5. Click **Create**.
Effective usage of CMDB Identification

Use CMDB Identification effectively.

Identification rules

An independent identification rule identifies a CI based on the CI’s attributes, independently of other CIs.

A dependent identification rule identifies a CI by its dependent CIs and the relationships of the identified CI with those dependent CIs. Identification with a dependent identification rule is based on the dependent CIs and the relationships and qualifiers between the identified CI and its dependent CIs. Identification then requires more time than with an independent identification rule and is prone to some identification errors. Usage of dependent rules should therefore be minimized.

CI modeling determines which type of identification rules are required for proper CI identification.

Create identification rules using the following order of importance:

1. Independent identification rules — It is always preferable to create independent identification rules rather than dependent identification rules. When you model a CI, define the CI with a complete set of attributes that lend themselves to independent identification, eliminating the need to use additional CIs for identification.

2. Dependent identification rules — If it is necessary to create dependent identification rules, then define a single level of dependency. Two is the maximum number of dependency levels that is supported.

3. Avoid creating lookup identifier entries. The use of lookup identifier entry is highly discouraged as it can reduce performance. If unavoidable, ensure to first review class definitions and consider updates that allow usage of independent identification rules.

4. Limit the number of identifier entries within an identification rule, ideally to 1. A second identifier entry can further reduce performance, as will each additional identifier entry.

5. Create strong identification rules in which the strongest identifier entries and related entries are set with the highest priority.

6. Ensure that the identification rule is at the class level that it needs to be.

Payload

Create the payload using the following order of importance:
1. Payload size — Limit the number of CIs per payload to 500.

2. Avoid duplicate entries in the payload.
Example: If an identification rule has a criterion attribute for the name field, then the following payload has duplicate items resulting in failure:

```javascript
var payload = {
  items: [{
    className: 'cmdb_ci_linux_server',
    values: {
      name: 'Win Server 200',
      ram: '2048'
    }
  }, {
    className: 'cmdb_ci_linux_server',
    values: {
      name: 'Win Server 200',
      ram: '4096'
    }
  }]
};
```

3. Do not pass system data such as the following in the payload.

```javascript
var payload = {
  items: [{
    className: 'cmdb_ci_linux_server',
    values: {
      name: 'Win Server 200',
      sys_domain: 'global',
      sys_domain_path: 'xyz',
      sys_updated_on: '2017-06-15 16:25:11',
      sys_mod_count: 23
    }
  }]
};
```

4. Provide the minimum necessary set of criterion attributes for each payload item, according to what is specified in the corresponding identification rules.

5. When matching CIs, use CIs’ sysIds if available. If provided, IRE can use the sysId to directly locate a CI without requiring any criterion attributes from the identification rule. In this case, IRE does not use the sysId in the matching process.
   - Example: Independent CI that needs to be updated — sysId is available.

```javascript
var payload = {
  items: [{
    className: 'cmdb_ci_linux_server',
    values: {
      name: 'Win Server 200'
    }
  }]
};
```
• Example: Dependent CI that needs to be inserted. Tomcat War CI depends on Tomcat CI, and Tomcat CI depends on Linux Server CI. SysIds for the Tomcat and the Linux CIs are available.

```javascript
var payload = {
  items: [
    {
      className: 'cmdb_ci_app_server_tomcat_war',
      values: {
        name: 'war1',
        short_description: 'my description'
      }
    },
    {
      className: 'cmdb_ci_app_server_tomcat',
      values: {
        sys_id: '194876usytrr65378098'
      }
    },
    {
      className: 'cmdb_ci_linux_server',
      values: {
        sys_id: '09876tysueyt6345lakiu'
      }
    }
  ],
  relations: [
    {
      parent: 1,
      child: 0,
      type: 'Contains::Contained by'
    },
    {
      parent: 1,
      child: 2,
      type: 'Runs on::Runs'
    }
  ]
};
```

• Example: Dependent CI that needs to be updated — sysId is available.

```javascript
var payload = {
  items: [
    {
      className: 'cmdb_ci_app_server_tomcat_war',
      values: {
        sys_id: '039387euey637465sytet',
        short_description: 'my description new'
      }
    }
  ];
```
6. When inserting many CIs, all of which depend on the same CI, you should serialize your API calls. Otherwise, attempting to concurrently process many CIs can clog the system, significantly degrading overall system performance.

**Properties for Identification and Reconciliation**

Use the Identification and Reconciliation properties to configure the identification and reconciliation engine (IRE).

These properties are available for Identification and Reconciliation. To view and edit these properties, the admin role is required.

---

### Note:

To open the System Properties [sys_properties] table, enter `sys_properties.list` in the navigation filter.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enforce the requirement that required attributes cannot be null during identification and reconciliation. glide.required.attribute.enabled | - Type: true | false  
- Default value: true  
- Location: Configuration > CMDB Properties > Identification/Reconciliation Properties  
  - Learn more: CI reclassification during IRE processing.  
  When false, IRE rejects a payload (or a payload item in Enhanced IRE) with the respective reclassification update, and creates a reclassification task. |
| Allow class upgrade during IRE identification and reconciliation. glide.class.upgrade.enabled | - Type: true | false  
- Default value: true  
- Location: Configuration > CMDB Properties > Identification/Reconciliation Properties  
  - Learn more: CI reclassification during IRE processing. |
| Allow class downgrades during IRE identification and reconciliation. glide.class.downgrade.enabled | - Type: true | false  
- Default value: true  
- Location: Configuration > CMDB Properties > Identification/Reconciliation Properties  
  - Learn more: CI reclassification during IRE processing. |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.class.switch.enabled</td>
<td>When <strong>false</strong>, IRE rejects a payload (or a payload item in Enhanced IRE) with the respective reclassification update, and creates a reclassification task.</td>
</tr>
</tbody>
</table>
| glide.class.switch.enabled                   | • Type: true | false  
• Default value: true  
• Location: **Configuration > CMDB Properties > Identification/Reconciliation Properties**  
• Learn more: CI reclassification during IRE processing |
| glide.identification_engine.update_without_upgrade_enabled | Enable IRE to process CI updates. This property takes precedence over the glide.class.upgrade.enabled property.  
• Type: true | false  
• Default value: false  
• Location: **Add to System Properties [sys_properties] table**  
• Learn more: CI reclassification during IRE processing  
Depending on the property setting, IRE processes or skips the upgrade update:  
• true: IRE processes the CI updates but doesn’t process the CI upgrade reclassification update  
• false: IRE processes the CI updates including the CI upgrade reclassification update |
| glide.identification_engine.update_without_downgrade_enabled | Enable IRE to process CI updates. This property takes precedence over the glide.class.downgrade.enabled property.  
• Type: true | false  
• Default value: false  
• Location: **Add to System Properties [sys_properties] table**  
• Learn more: CI reclassification during IRE processing  
Depending on the property setting, IRE processes or skips the downgrade update:  
• true: IRE processes the CI updates but doesn’t process the CI downgrade reclassification update  
• false: IRE processes the CI updates including the CI downgrade reclassification update |
## Properties for Identification and Reconciliation (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>glide.identification_engine.update_without_switch_enabled</strong></td>
<td>Enable IRE to process CI updates with switch reclassification updates. This property takes precedence over the <code>glide.class.switch.enabled</code> property.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false</td>
</tr>
<tr>
<td></td>
<td>- Location: Add to System Properties [sys_properties] table.</td>
</tr>
<tr>
<td></td>
<td>- Learn more: CI reclassification during IRE processing</td>
</tr>
<tr>
<td></td>
<td>Depending on the property setting, IRE processes or skips the switch update:</td>
</tr>
<tr>
<td></td>
<td>- <strong>true</strong>: IRE processes CI updates, but doesn't process the CI switch reclassification update.</td>
</tr>
<tr>
<td></td>
<td>- <strong>false</strong>: IRE processes CI updates including the CI switch reclassification update.</td>
</tr>
<tr>
<td><strong>glide.identification_engine.reclassification_restriction_rules_enabled</strong></td>
<td>Globally enable or disable the application of active reclassification restriction rules.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>- Location: Add to System Properties [sys_properties] table.</td>
</tr>
<tr>
<td></td>
<td>- Learn more: CI reclassification during IRE processing</td>
</tr>
</tbody>
</table>
### Properties for Identification and Reconciliation (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| **glide.reconciliation.override.null** | Allow the update of an empty field by a lower priority data source.  
- **Type:** true | false  
- **Default value:** true  
- **Location:** Configuration > CMDB Properties > Identification/Reconciliation Properties |
| **glide.identification_engine.skip_duplicates** | Controls how identification processes a small set of duplicate CIs.  
- **Type:** true | false  
- **Default value:** true  
- **Other values:**  
  - true  
  - If the number of duplicate CIs is less than the threshold specified by glide.identification_engine.skip_duplicates.threshold, then the oldest of the duplicate CIs is picked as a match and gets updated. That oldest CI is also designated as the master CI for that set of duplicate CIs.  
  - For the rest of the duplicate CIs, the duplicate_of field is set as a reference to the master CI.  
  - false  
  - Matching a CI fails, and an error is logged.  
- **Location:** Configuration > CMDB Properties > Identification/Reconciliation Properties |
| **glide.identification_engine.skip_duplicates.threshold** | Maximum number of CIs that can be in a set of duplicate CIs to allow identification to process the duplicate CIs according to the setting of glide.identification_engine.skip_duplicates.  
- **Type:** Integer  
- **Default value:** 5  
- **Location:** Configuration > CMDB Properties > Identification/Reconciliation Properties |
### Properties for Identification and Reconciliation (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.identification_logs.max_run_ids</td>
<td>Maximum number of log runs that can be displayed when navigating to <strong>Configuration &gt; Identification Logs</strong>.</td>
</tr>
<tr>
<td>glide.cache.size.service_cache</td>
<td>Maximum cache size (in MB) that is used by the identification engine for inbound and outbound relations. When the limit is reached, the least recently used cached data is discarded, releasing space for new data.</td>
</tr>
<tr>
<td>glide.identification_engine.granular_insert_locking</td>
<td>Determines whether to use multiple granular insert locks or single global insert lock. Set to false if there are performance issues associated with the usage of multiple granular insert locks.</td>
</tr>
<tr>
<td>glide.identification_engine.batch_update_last_discovered</td>
<td>Controls batch update of <strong>last_discovered</strong> field in CIs that are being processed by the identification engine. Set to false if there are business rules that apply to the <strong>last_discovered</strong> field, and you want to trigger these rules when calling an Identification and Reconciliation API.</td>
</tr>
<tr>
<td>glide.identification_engine.related_items_local_cache_count</td>
<td>For optimization, a custom number of locally cached query result entries of related/lookup items.</td>
</tr>
</tbody>
</table>
### Properties for Identification and Reconciliation (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.identification_engine.dependent_items_local_cache_count</td>
<td>For optimization, a custom number of locally cached query result entries of dependent CIs.</td>
</tr>
<tr>
<td>Type: integer</td>
<td>Default value: 10000</td>
</tr>
<tr>
<td>Location: Add to System Properties [sys_properties]</td>
<td>Note: If there is a memory issue due to optimization related to using local cache, set the <code>glide.identification_engine.related_items_local_cache_count</code> and the <code>glide.identification_engine.dependent_items_local_cache_count</code> properties to 0.</td>
</tr>
</tbody>
</table>

| glide.identification_engine.independent_items_local_cache_count | For optimization, a custom number of locally cached query result entries of independent CIs. |
| Type: integer                                                 | Default value: 100000                                                       |
| Location: Add to System Properties [sys_properties]           | Note: If there is a memory issue due to optimization related to using local cache, set the `glide.identification_engine.related_items_local_cache_count` and the `glide.identification_engine.dependent_items_local_cache_count` properties to 0. |

| glide.cmdb.logger.source.identification_engine               | Enable and configure what type of details the system logs when using IRE outside the scope of identification simulation. For example, when using an API, ECC queue or scheduled jobs. |

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Properties for Identification and Reconciliation (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.identification_engine.partial_payload_items_max_size</td>
<td>Maximum number of items allowed when creating a partial payload. When that limit is reached, the partial payload is split. For example, when IRE creates a partial payload, items and associated relations are merged in one partial payload. This merge could result in a large partial payload. Adjusting this property can help with performance issues related to IRE processing of partial items.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default: 1000</td>
</tr>
<tr>
<td></td>
<td>• Learn more: Identification and Reconciliation engine (IRE)</td>
</tr>
<tr>
<td></td>
<td>• Location: Add to System Properties [sys_properties] table</td>
</tr>
<tr>
<td>glide.identification_engine.partial_items_process_limit</td>
<td>Maximum number of partial items to be fetched in a single IRE call. After reaching this limit, IRE fetches only partial items corresponding to complete items in the input payload. Adjusting the value can help with performance issues related to IRE processing of partial items.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default: 2000</td>
</tr>
<tr>
<td></td>
<td>• Location: Add to System Properties [sys_properties] table</td>
</tr>
<tr>
<td>glide.identification_engine.partial_items_process_absolute_limit</td>
<td>Absolute limit of the number of partial items for IRE to fetch, after which, IRE stops fetching partial payloads from the CMDB IRE Partial Payloads [cmdb_ire_partial_payloads] table. Adjusting the value can help with performance issues related to IRE processing of partial items.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default: 5000</td>
</tr>
<tr>
<td></td>
<td>• Location: Add to System Properties [sys_properties] table</td>
</tr>
</tbody>
</table>
Components installed with Identification and Reconciliation

Several types of components are installed with Identification and Reconciliation (included in the com.snc.cmdb plugin), including tables.

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifier [cmdb_identifier]</td>
<td>Identification rule sets defined for different classes of CIs.</td>
</tr>
<tr>
<td>Reconciliation Definition [cmdb_reconciliation_definition]</td>
<td>Reconciliation rules defined for different classes of CIs at the table and field level.</td>
</tr>
<tr>
<td>Identifier Entry [cmdb_identifier_entry]</td>
<td>Rule entries with different priorities assigned to each identifier.</td>
</tr>
<tr>
<td>Duplicate Audit Result [duplicate_audit_result]</td>
<td>Duplicate audit results corresponding to a specific duplicate task. These results are generated automatically during the identification process and should not be added manually.</td>
</tr>
<tr>
<td>RemEDIATE Duplicate Task [reconcile_duplicate_task]</td>
<td>Task to address duplication that is detected during the identification process. Records are generated automatically, and users should not add records manually.</td>
</tr>
<tr>
<td>Reclassification Task [reclassification_task]</td>
<td>Reclassification tasks that were generated during the identification process.</td>
</tr>
<tr>
<td>Data Source History [cmdb_datasource_last_update]</td>
<td>Information about the last data source that updated each attribute. Used to determine if a data source can update a stale CI.</td>
</tr>
<tr>
<td>Data Source Staleness Definition [cmdb_datasource_staleness]</td>
<td>Effective duration per data source. When effective duration is exceeded, then CMDB Health determines that the information provided by that data source is stale.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Identification Engine Context</td>
<td>Input payload, and data source (cmdb_ci’s discovery_source) that will be used as input for a specific identification engine API. Stores information about which specific identification engine API will be called (identifyCI or createOrUpdateCI API). Also stores information about enhanced IRE options used in Identification Simulation.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Internal table used by identification simulation.</td>
</tr>
<tr>
<td>Identification Engine Run</td>
<td>Specific cmdb_ie_context record that was used to run against the identification engine. Also details about the output payload returned by APIs, such as start and end time of the run and whether the run was successful.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Internal table used by identification simulation.</td>
</tr>
<tr>
<td>Identification Engine Log</td>
<td>Identification engine logs for a specific cmdb_ie_run simulated in the identification simulation. Also details about logs level and order.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Internal table used by identification simulation.</td>
</tr>
<tr>
<td>IRE Data Source Rule</td>
<td>IRE data source rules.</td>
</tr>
<tr>
<td>CMDB IRE Partial Payloads</td>
<td>Payload items that were determined to be partial, and which might be later matched with an incoming payload. If a partial payload is matched and processed, it is deleted from the CMDB IRE Partial Payloads table. Partial payloads older than 90 days are deleted from the table.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>CMDB IRE Partial Payloads Index</strong></td>
<td>Identifier keys associated with partial items. IRE uses those keys to try to match with identifier keys of incoming payloads.</td>
</tr>
<tr>
<td>[cmdb_ire_partial_payloads_index]</td>
<td>For more information about usage of this table in IRE processes, see Identification and Reconciliation engine (IRE).</td>
</tr>
<tr>
<td><strong>CMDB IRE Incomplete Payloads</strong></td>
<td>Incomplete items, stored using JSON format as incomplete payloads. Incomplete items are stored for the purpose of logging payloads with irrecoverable errors, and are never processed again.</td>
</tr>
<tr>
<td>[cmdb_ire_incomplete_payloads]</td>
<td>The table is configured for table rotation, with duration of one day and seven table rotations.</td>
</tr>
<tr>
<td><strong>IRE Output Aggregate Stats</strong></td>
<td>This table is populated when RTE invokes IRE, for example, when processing integrations.</td>
</tr>
<tr>
<td>[cmdb_ire_output_aggregate_stats]</td>
<td>Details about data inserted by Import Sets or Robust Transform Engine (RTE) to the CMDB (via IRE). Numbers of items inserted, partial items, and updated items, are stored for each type of CI, per run.</td>
</tr>
<tr>
<td><strong>IRE Output Target Items</strong></td>
<td>This table is populated when RTE invokes IRE, for example, when processing integrations.</td>
</tr>
<tr>
<td>[cmdb_ire_output_target_item]</td>
<td>Details about data inserted by Import Sets or Robust Transform Engine (RTE) to the CMDB (via IRE). Target class and the</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>sys_id</td>
<td>are stored per ImportSet row id, within a run. For this table to populate, RTE must pass the <code>ire_output_detailed_stats</code> property.</td>
</tr>
<tr>
<td>Reclassification Restrictions</td>
<td>Reclassification restriction rules. These rules prevent switch and downgrade reclassification updates for specific source and target classes. For more information, see CI reclassification during IRE processing.</td>
</tr>
</tbody>
</table>

**Related reference**

Properties for Identification and Reconciliation

**Monitor system foundations in the CSDM and the CMDB Data Foundations Dashboards (Version 1.3.0)**

The ServiceNow® CSDM and CMDB Data Foundations Dashboards store app contains dashboards which provide insights into the key foundational indicators of your CMDB and Common Service Data Model (CSDM). This app provides recommendations to ensure that the CMDB and CSDM are properly configured for optimal usage and to mitigate any potential risks.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

The CSDM and CMDB Data Foundations Dashboards store app provides these dashboards which complement each other:

**CMDB Data Foundations dashboard**

Evaluates various configurations and customizations in the CMDB. This dashboard checks that important data is valid and properly configured, and identifies and provides visibility into potential risks in the implementation. Use the CMDB Data Foundations dashboard to prevent issues and support continuous effective functioning of the CMDB.

**CSDM Data Foundations dashboard**
Evaluates the key indicators of the CSDM. This dashboard lets you see if you have the information that you need to get the full benefit of the CSDM. For example, you may see that some of your business service offerings don’t have the required relationship to an application service. Use this dashboard to see those areas and then provide whatever data the CSDM requires.

To access these dashboards, navigate to Configuration, and then select CMDB Data Foundations Dashboard or CSDM Data Foundations Dashboard. You can toggle between the two dashboards by clicking the change dashboard icon (▼) on the title bar of either dashboard.

For an introduction, watch the ServiceNow Data Foundations Dashboards for CSDM and CMDB video.

**CMDB Data Foundations dashboard**

Use the CMDB Data Foundations dashboard to monitor foundational key indicators in CMDB.

**Requirements**

- To access the CMDB Data Foundations dashboard, users must be configured with the admin, itil_admin, or asset roles.

- The CMDB Data Foundations dashboard adds the following scheduled jobs, which must be running:
  
  - **CMDB Get Well Metric Collection**: Calculates and stores details for compliant CIs associated with indicators. Data appears on the dashboard only after the first run of this scheduled job. Indicators' scores are stored in the CMDB Data Foundations Metric Scores [sn_getwell_cmdb_score] table. This job runs daily by default.
  
  - **CMDB Data Foundations PA Metric Collection**: Calculates the total non-compliant CIs associated with indicators. Also, provides trending data over time for the non-compliant CIs associated with indicators.

To access the dashboard, navigate to Configuration > CMDB Data Foundations Dashboard.
The CMDB Data Foundations dashboard has these sets of indicators:

• The **CMDB Data Foundations** tab provides higher priority key indicators.

  Drill down the tiles associated with the indicators in this tab to access Performance Analytics widgets, which are provided by the **CMDB Data Foundations PA Metric Collection** scheduled job.

  ◦ Ensure that the real-time option is selected ( ) and then click **Show Records** to see a list view of the respective CIs.
  ◦ Click the **Breakdowns** context menu to see any available breakdowns.

• The **CMDB Insights** tab provides additional important indicators, which are less critical.

The following columns appear on the CMDB Data Foundations dashboard.

**Name**
This column shows the CMDB indicators. Click the **CMDB Data Foundations** tab or the **CMDB Insights** tab to access the following indicators.

**Hardware CIs with Serial Numbers**
Percentage of Computer or Network Gear CIs with a serial number versus those CIs without one. The indicator is based on the following conditions:

- Class is an instance of Computer or Network Gear
- Status = installed
- Operational status = operational
- Serial number is empty

The complete set of CIs for this indicator consists of the CIs that satisfy the first three conditions. The CIs that satisfy all conditions, are counted as Computer or Network Gear CIs without a serial number.

Note: If the percentage of compliant CIs is less than 70%, then the result displayed for this indicator is set to 0.

The Hardware CIs Missing Serial Number tile shows the total number of CIs which are not in compliance with the indicator, correlating the black portion of the indicator bar. Click the tile to access the Performance Analytics widget for further details, such as the list all those CIs.

The Hardware CIs Missing Serial Number by Key Classes chart shows those CIs that are missing a Serial Number, grouped by key classes. Point to a class bar on the chart to show more details, and click a class bar to access a list view of those CIs for class.

CIs Processed via IRE

Percentage of Hardware [cmdb_ci_hardware] or VMware Virtual Machine Instance [cmdb_ci_vmware_instance] CIs processed via IRE versus those CIs not processed via IRE. The indicator is based on the following conditions:

- Status = installed
- Operational status = operational
- Sys_id is IN (target_sys_id FROM sys_object_source table)

The complete set of CIs for this indicator consists of the CIs that satisfy the first three conditions. The CIs that satisfy all conditions are counted as Hardware [cmdb_ci_hardware] or VMware Virtual Machine Instance [cmdb_ci_vmware_instance] CIs not processed via IRE.

CI with Relationships to Parent and Child
Percentage of non-orphan CIs versus orphan CIs.

The complete set of CIs for this indicator consists of CIs in records from the CI Relationship [cmdb_rel_ci] table. CIs in which [parent.sys_class_name=(empty)] OR [child.sys_class_name=(empty)], are counted as orphan CIs.

The Orphan CIs tile shows the total number of orphan CIs, correlating the black portion of the indicator bar. Click the tile to access the Performance Analytics widget for further details, such as the list all those CIs.

**Active CIs Updated in Last 90 days**

Percentage of Hardware [cmdb_ci_hardware] or VMware Virtual Machine Instance [cmdb_ci_vmware_instance] active CIs that were updated in the past 90 days versus those CIs that were not (stale CIs). The indicator is based on the following conditions:

- Class is an instance of Hardware or VMware Virtual Machine Instance
- Status = installed
- Operational status = operational
- Updated >= 90 days

The complete set of CIs for this indicator consists of CIs that satisfy the first three conditions. The CIs that satisfy all conditions, are counted as stale CIs of the Hardware [cmdb_ci_hardware] and VMware Virtual Machine Instance [cmdb_ci_vmware_instance] classes.

**Note:** If the percentage of compliant CIs is less than 65%, then the result displayed for this indicator is set to 0.

The Active CIs Not Updated in 90 Days tile shows the total number of CIs which are not in compliance with the indicator, correlating the black portion of the indicator bar. Click the tile to access the Performance Analytics widget for further details, such as the list all those CIs.

**Handled Duplicate CIs**

Percentage of duplicate CIs of the Hardware [cmdb_ci_hardware] or VMware Virtual Machine Instance [cmdb_ci_vmware_instance] class, that were remediated, versus those CIs that were not. The indicator is based on the following conditions:
• Class is an instance of Hardware or VMware Virtual Machine Instance
• Status = installed
• Operational status = operational
• Duplicate_of in not empty

The complete set of CIs for this indicator consists of the CIs that satisfy the first three conditions. The CIs that satisfy all conditions are counted as Hardware [cmdb_ci_hardware] or VMware Virtual Machine Instance [cmdb_ci_vmware_instance] duplicate CIs that were not remediated. For more information, see Duplicate CIs.

The Unhandled Duplicate CIs tile shows the total number of CIs which are not in compliance with the indicator, correlating the black portion of the indicator bar. Click the tile to access the Performance Analytics widget for further details, such as the list all those CIs.

Managed CIs with Model Entries

Percentage of Hardware [cmdb_ci_hardware] CIs with a model ID versus those CIs without.

The complete set of CIs for this indicator consists of all the CIs in the Hardware [cmdb_ci_hardware] table. Those CIs in which model_id is null are counted as Hardware CIs missing a model ID.

Unique Locations

Percentage of unique locations versus duplicate locations.

The complete set of locations for this indicator consists of all the locations in the Location [cmn_location] table records, in which name is not null. A duplicate location is defined by Location [cmn_location] table records, in which name is not null, and the same name is used more than once.

CIs With Names

Percentage of Hardware [cmdb_ci_hardware], VMware Virtual Machine Instance [cmdb_ci_vmware_instance], or Application [cmdb_ci_appl] CIs with a name versus those CIs without. The indicator is based on the following conditions:

• Class is an instance of Hardware, VMware Virtual Machine Instance, or Application
• Status = installed
- Operational status = operational
- Name is empty

The complete set of CIs for this indicator consists of CIs that satisfy the first three conditions. The CIs that satisfy all conditions, are counted as Hardware, VMware Virtual Machine Instance, or Application CIs missing a name.

The CIs Missing Names tile shows the total number of CIs which are not in compliance with the indicator, correlating the black portion of the indicator bar. Click the tile to access the Performance Analytics widget for further details, such as the list all those CIs.

**Create Asset Business Rule is Enabled**

Checks for the existence of the Create Asset on insert business rule. If the business rule exists, the score for the indicator is 100. Otherwise, the score is set to 0.

**Custom CMDB Attributes at the Right Level**

Percentage calculation of custom attributes that should be added at a higher level in the CMDB hierarchy. For example, the custom attribute Warranty duration was added three times in the Computer class, instead of adding the attribute once at a higher level in the hierarchy, which is more efficient.

- If (total number of attributes that can be moved up > 10): Percentage is set to 0.
- Otherwise: Percentage is set to \((10 - \text{total number of attributes that can be moved up}) \times 10\).

**Use of Custom Attributes**

Percent calculation of custom attributes that were added to CMDB tables in the base system. Custom attributes are identified by a table name that starts with “cmdb_ci” and a column name that starts with “u_.”

Percentage is calculated as follows:

- If (total custom attribute count > 50): Percentage is set 0.
- If (total custom attribute count < 10): Percentage is set to 100.
- If (total custom attribute count is 10–50): Percentage is set to \((\text{total custom attribute count} - 10)/(50-10)\times100\).
**Priority**
This column shows the priority of an indicator. The priority for an indicator is a calculation of the weight of the indicator and the severity of the actual score. Priority ranges from **1 - Critical** as the highest priority, to the lowest priority which is **5 - Low**.

**Result**
This column shows the percentage number of CIs (or the measured item) which are in compliance with the indicator. A bar shows the percentage of CIs (or the measured item) which are in compliance versus the percentage of items which are not in compliance. The portion on the bar that represents CIs (or the measured item) which are in compliance, uses the following color scheme to note the level of compliance:

- **Red**: 0–50% of the total CIs (or the measured item), are in compliance for the indicator.
- **Yellow**: 50–90% of the total CIs (or the measured item), are in compliance for the indicator.
- **Green**: Above 90% of the total CIs (or the measured item), are in compliance for the indicator.

The portion on the bar that represents the percentage of items which are not in compliance for the indicator, always appears in black. Also, all indicator scores are aligned so that a higher percentage score and a smaller black portion on an indicator bar, always indicate the more optimal state.

⚠️ **Note**: Some indicators use a lower threshold value which impacts the result that appears in the dashboard. For these indicators, if the percentage of compliant CIs is less than the lower threshold value, then the result appears as 0 for the indicator.

**Remediation playbook URL**
This column provides links to remediation playbook articles in Now Support. These knowledge articles provide context for the respective issue, guidelines to help remediate the issue, and other necessary details to bring CIs into compliance. Click the link and use your Now Support credentials to access the knowledge article.

**CSDM Data Foundations dashboard**
The CSDM Foundations dashboard evaluates the data (specifically, the key foundational indicators) used in the Common Service Data Model (CSDM)
framework. The key foundational indicators give you insight into the CSDM framework and help you identify any potential problem areas.

**About the dashboard**
Use the CSDM Data Foundations dashboard to monitor and gain insights into the key foundational indicators of the CSDM framework.

This dashboard lets you see if the CSDM framework has what it needs to provide the full benefit of the model. For example, you may see that some of your business service offerings don't have the required relationship to an application service. Use this dashboard to see those areas and then provide whatever data the CSDM framework requires.

**Key foundational indicators grouped by implementation stage**
The key foundational indicators are grouped by the CSDM implementation stage (foundation, crawl, walk, run, and fly). Each stage has a separate tab. For information about these stages, see Common Service Data Model framework implementation stages.

The CSDM Data Foundations dashboard provides the following information:
Name
A list of the key foundational indicators for each of the CSDM implementation stages.

Priority
The priority given to that key foundational indicator. The priority is a calculation of the weight of the indicator and the severity of the actual score. Priority ranges from 1 - Critical (the highest priority), to 5 - Low (the lowest priority).

Result
A color-coded bar showing the percentage of configuration items (CIs) (or the measured item) which are in compliance with the key foundational indicator.

- Red: 0–50% of the total CIs (or the measured item) that are in compliance for the key foundational indicator.
- Yellow: 50–90% of the total CIs (or the measured item) that are in compliance for the key foundational indicator.
- Green: Above 90% of the total CIs (or the measured item) that are in compliance for the key foundational indicator.
- The portion on the bar that represents the percentage of items that aren't in compliance with the key foundational indicator appear in black.

Remediation playbook URL
Links to remediation playbooks in Now Support. These remediation playbooks are knowledge articles that provide context for the respective issue. The playbooks include the steps for fixing (remediating) the respective issue, and for bringing the CIs into compliance. Click the link and use your Now Support credentials to access the knowledge article.

Use the CSDM Data Foundations dashboard
Use the CSDM Data Foundations dashboard to monitor and evaluate key foundational indicators of the CSDM framework.

Before you begin
Before you use this dashboard for the first time, navigate to System Scheduler > Scheduled Jobs and run the CSDM Get Well Metric Collection job. Otherwise, the dashboard will not have any data.

Role required: app_service_admin, app_service_user, asset, cmdb_read, itil_admin, portfolio_admin, service_viewer, or technology_service_owner
Procedure

1. Navigate to CSDM > Configuration > CSDM Data Foundations Dashboard. The list of key foundational indicators appears on the CSDM Data Foundation dashboard.

2. Click the tab for the CSDM implementation stage (foundation, crawl, walk, run, or fly) that you want to view.

3. Review each line of the results.

4. Look at the percentages and the color-coding shown in the Result column for each of the key foundational indicators.
   - If the percentage is 100%, the CSDM framework has the information it needs. You don't need to do anything else.
   - Otherwise, required information is missing and additional actions are required. Continue with step 5.

Note the indicators on the Foundation tab:

- **Named Product Models with Product Owners**
  - Shows cmdb_model records that meet the following conditions:
    - Status = in production
    - Name and Owner is not empty

- **Business Units with Companies**
  - Shows business unit records where Company field is not empty.

- **Locations with Parents**
  - Shows cmdb_ci records that meet the following conditions:
    - Status = installed
    - Operational status = operational
    - Location and Location.parent is not empty

5. Click the tiles associated with the foundational indicators to access Performance Analytics widgets, which are provided by the CSDM PA Metric Collection scheduled job. These widgets provide trending data over time for the non-compliant CIs associated with the indicator.

- Ensure that the real-time option is selected and then click Show Records to see a list view of the respective CIs.
- Click the Breakdowns context menu to see any available breakdowns.
6. Click a CI from the list view to drill down to the form view. Use the form view to provide the required information. If you don’t see the form, you may not have sufficient access privileges. Talk to your ServiceNow administrator.

7. When you’re finished using the form, click Update or Delete (as applicable) to return to the list view.

8. Navigate to return to the CSDM Data Foundations dashboard.

Results
The key foundational indicator results are available for you to review and analyze.

CMDB Health
Monitoring and maintaining the health of the CMDB is essential to an effective and continuous use of the product. Health indicators such as duplicate CIs, required CI fields, and audits contribute to the calculation of health scorecards at the CI, class, and CMDB level.

The health of the CMDB data is monitored and reported for the following KPIs, each further consisting of sub metrics:

- Completeness: CIs are tested for required and recommended fields that are not populated.
- Correctness: CIs are tested against pre-defined data integrity rules such as identification rules (to detect duplicate CIs), orphan CI rules, and stale CI rules.
- Compliance: The CMDB data is audited for adherence to pre-defined certificates.
- Relationships: The health of CI relationships is tested for indicators such as orphan and duplicate relationships. And for compliance with suggested relationships, hosting and containment rules.

After CIs are tested for various health indicators, the results are aggregated at the class level, and eventually at the overall CMDB level. You can configure how health is calculated and the weight of each KPI and each metric at every level of the aggregation. For most health tests, you can configure the health tests themselves.

CMDB Health is domain aware. If the domain separation plugin has been activated, then the CMDB dashboard displays health based on data, rules, and settings from the logged-on user domain. If rules and settings are not defined for a child domain, then the parent’s settings are applied, recursively.
CI remediation

CMDB Health provides a framework for configuring CI remediation. Remediation lets you proactively apply corrective actions to unhealthy CIs in a managed and standardized fashion.

Setup

You need to configure CMDB Health related system properties, and health KPI and metric rules, to customize how aggregated data is calculated and other CMDB Health behavior. To start gathering and aggregating health data, you need to enable the CMDB Health-related jobs (CMDB Health Dashboard jobs) which are initially disabled. See Setup and configure CMDB Health for details about enabling these jobs and about configuring other CMDB Health settings.

Domain separation in CMDB Health

This is an overview of domain separation as it pertains to CMDB Health. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Overview

CMDB dashboards should be set up with their own set of rules to best accommodate how the user needs them. CMDB dashboard jobs adhere to those rules to produce reports. These are covered in separate sections below.

How domain separation works in CMDB Health

For dashboards to be the most effective, users should configure the dashboard accordingly. This is done by setting up the orphan, staleness, and inclusion rules to meet their needs, and which then affect the reports displayed on the dashboard.

The settings and metrics define different aspects of each application because each domain can be configured differently. These rules are set up in addition to those that are included in the base system. There are different types of owners for different CIs; each domain has its own set of rules.

⚠️ Note: Domain separation is on by default, but each domain can be configured as needed.

Health Preferences

Configure these preferences during setup:
1. Global system properties that control CMDB Health – System properties are not domain separated. To learn more see CMDB Health system properties.

2. CMDB Health Dashboard Jobs – There is a dashboard job for each major KPI, such as Completeness. That job finds the health of the CIs across all the enabled domains. There is only one job run for all domains and jobs themselves are not domain separated.

   Users can define the frequency with which they want to run jobs; the report runs for all the domains. The more domains included in the job, the longer the job runs.

3. Health Metrics – These selections are domain-separated and adhere to the established “system overrides” logic of domain separation. Changes are made according to the domain for which the user is logged in. Base system values are defined at the global domain. The overriding domain logic means these values apply for all domains. If users want different values for a domain, they must be logged in to a specific domain and change the property from there. The new property setting applies only to that domain and any domain that inherits this domain. To learn more see Health Metrics.

   Note: Regarding the Completeness, Compliance, and Correctness KPIs: Users can disable this KPI if they don’t want to see that as part of the dashboard score. All these settings are domain-separated and the user can define specific properties for the domain.

   a. Weighted averages – These settings can affect all or part of the metrics in Completeness, Compliance, Correctness, and Relationship. They can be set differently for different domains.

   b. Active – This setting is the most important because it affects how long the jobs run. The more domains with flags set to Active, the longer the jobs take. It’s best to select only those domains you wish to be Active and render the rest Active = false. You can set this in Health Preferences. The default settings for global domain are set to Active = true, but you can modify or disable specific domains the user wants to see in the dashboard. Users should consider the domain hierarchy when changing these values. If there is a large number of domains (>100) the job can take a very long time. To mitigate this, set Active to False for all the root domains, thereby disabling all the other domains in the hierarchy. If there is a rule at the top, all child domains inherit that rule.

   c. Failure Threshold, Create Task, Task Assignee Group – All these settings can be set differently for different domains depending on what is needed in each domain.
d. Exceptions – For Relationship metrics (relationship, duplicate relations, orphan relations, stale relations) the failure threshold setting is not domain separated. The Failure Threshold for the global domain is applied to all domains. For example, even if users were to override the Failure Threshold for a domain, the global domain setting for Threshold is still applied.

e. Troubleshooting / Implementation detail – These settings are stored in the `cmdb_health_metric_pref` table, which is domain separated.

Health Rules

Health rules settings are addressed here:

- Required
- Recommended
- Orphan
- Staleness

Most of the CMDB Health Rules are domain separated and provided by the users. Users can define different rules for different domains by logging in to each domain and adding/overriding rules in the CI Class Manager.

These are the rules for the different metrics:

1. Completeness
   a. Required fields – These are based on the class schema defined in the platform’s and is fixed for all domains. These cannot be changed.
   b. Recommended fields – These are domain separated. The table used is `cmdb_recommended_fields`, which is domain separated. The user can set these up for different domains.

2. Correctness
   a. Duplicates – Duplicates are based on Identification rules, which are not domain separated, so the same rules apply to all domains.
   b. Orphan – Orphan rules are domain separated; there are different orphan rules for different domains. The table used is `cmdb_health_orphan_rule` and is domain separated.
   c. Staleness – Staleness rules are domain separated. The table used is `cmdb_health_staleness_rule`. The base system rule (60 days) is set for global domain so is inherited by all domains as the default rule.

3. Compliance
a. Audit – Audit scores are based on the desired state or scripted audits defined in the compliance module by the user.

Audits themselves are domain separated. When audit score evaluation is enabled for a domain, scores become based only on the audits visible in that domain.

Note: Health Inclusion Rules are also domain separated. The table used is `cmdb_health_config`, which is domain separated.

Health Dashboards (CMDB View/ Service View / Group View)

If a user is logged into a domain and views a health dashboard:

1. Only scores for enabled metrics in that domain display (based on the Health Preferences Active flag as discussed above).

2. All scores are based on CIs that are visible from the specific domain. (These are regular domain visibility rules: From that domain you can see CIs in global domain, the specific domain, any child domain of that domain or any domain that gets directly or indirectly contained by that domain.)

3. The dashboard view is based on domain rules defined in domain mapping, as opposed to those provided by the logged-in user. This view overrides any additional domain visibility rules that a logged-in user might have. The admin sets the basic rules, but does not set each individual domain. The admin can give specific users or user groups additional visibility to other domains and the dashboard still does not change. The dashboard strictly follows the domain rules mentioned above, based on the domain hierarchy for the domain in which the user is logged in.

4. As explained in the Health Preferences section, users can define different preference values for any domain which impact the scores reported in the dashboard. Preferences that can impact scores include Weighted Averages, Failure Threshold, and Active.

5. As explained in the CMDB Health Rules section, the scores reported for the metrics are based on the health rules defined for them (staleness, orphan, recommended, audit, and inclusion rules) which can be defined differently for a specific domain (in the CI Class Manager). Only the required metric and duplicate metric are based on rules that apply in all domains.

6. Service View/ Group View – These reports also largely follow the above points. Typically, these views differ from various views/filters for the Health Report. One is based off business rules, the other is based off CMDB Health groups.
**Setup and configure CMDB Health**

The data collection system is highly configurable, however, the base system is minimally configured for aggregating CMDB health data. Most importantly, the CMDB Health Dashboard jobs are disabled by default and data is not collected. To display valuable and meaningful data, you should review and adjust settings.

1. **Review CMDB Health KPIs and metrics** to learn what CMDB Health can monitor, and what needs to be configured to enable and support each metric.

2. **For each KPI and associated metric that you want monitored**, define the necessary rules and fulfill other needed requirements. For example, create orphan rules for detecting orphan records, if you are interested in this metric.

3. **Review and adjust the threshold ranges for best, at risk, and critical states** for the CMDB health metrics scorecards - see **Configure CMDB Health scorecard thresholds**.

4. **Set metric aggregation preferences**, deactivate KPI and metrics that you are not interested in reporting, set failure thresholds, and adjust weighted averages of aggregation - see **Configure KPI and metrics aggregation preferences**.

5. **Narrow the scope of CIs that are included in health calculations** - see **Create health inclusion rule**.

6. **Enable the Health Dashboard jobs for the KPIs that you want reported** - see **Enable and configure a CMDB Health Dashboard job**.

7. **Customize the CI dashboard (optional)**.

**CMDB Health system properties**

Configure the following system properties to customize how CMDB Health is monitored and evaluated.

Role required: itil_admin
**Note:** To open the System Property [sys_properties] table, enter `sys_properties.list` in the navigation filter.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max time in minutes for which individual metric</td>
<td>If processing of a metric exceeds the specified time, CMDB Health processing halts until the next CMDB Health job is scheduled to run.</td>
</tr>
</tbody>
</table>
| processor will run in each scheduled cycle            | • Type: integer  
• Default value: 120  
• Location: Navigate to **Configuration > Health Preference**. In the right hand-side navigator, click **System Properties**. For performance reasons, it is recommended not to set this property to a value greater than 120.  
**Note:** If you enter an invalid value, the default value is used. |
<p>| [glide.cmdb.health.metricProcessor.maxRunningTime]    | |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| sys_properties | This logging helps debugging if there is a failure. For example, to log error and info messages, set the value to 'error,info'.
| | • Type: String  
| | • Default value: error  
| | • Other possible values: Comma-separated list with any of the following values:  
| | ◦ info  
| | ◦ error  
| | ◦ warn  
| | Or '*' which is equivalent to including all possible values.  
| | • Location: System Property [sys_properties] table.  

<p>| glide.cmdb.health.src.cmdb_health_audit_only | When set to true, disables health results from sources other than CMDB Health audit (such as cloud discovery). Only results generated by CMDB Health audit appear in the CMDB dashboard. For example, by default, if a CI is determined to be stale... |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.cmdb.health.staleness_exclude_dependent_cis</td>
<td>by Discovery, then that CI appears as stale in the CMDB dashboard even though CMDB Health audit did not determine that CI to be stale. To disable these stale CI health results, set the property to true.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property [sys_properties] table.</td>
</tr>
<tr>
<td></td>
<td>• Learn more: ◦ CMDB Health KPIs and metrics ◦ Discovery for VMware vCenter</td>
</tr>
</tbody>
</table>

Exclude dependent CIs for the staleness CMDB Health metric.

When enabled, dependent CIs are not checked for staleness, regardless of any staleness or inclusion rules that are defined for the respective CI types.

• Type: true | false
• Default value: false
**Property**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Location:</td>
<td>System Property [sys_properties] table.</td>
</tr>
</tbody>
</table>

**Related information**

CMDB Health Dashboard for Helsinki | Overview

**Enable and configure a CMDB Health Dashboard job**

Enable and configure the jobs that process CMDB health tests, to start calculating CMDB health scores for the *completeness*, *compliance*, *correctness*, and *relationship* KPI. These health scores are then aggregated into the overall CMDB health report.

**Before you begin**

Role required: admin

**About this task**

In the base system, CMDB Health Dashboard jobs are disabled by default. Enable and configure the respective job for the CMDB health KPI that you want data collected and aggregated for. You can schedule a job to run on a recurring schedule, or execute it once at any time.

**Procedure**

1. Navigate to **Configuration > CMDB Dashboard > CMDB View**, and then click **CMDB Health Dashboard Jobs**.
2. Select a job that you want to enable or configure.

<table>
<thead>
<tr>
<th>CMDB Health Dashboard job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB Health Dashboard - Completeness Score Calculation</td>
<td>Script for calculating the completeness KPI of CMDB health.</td>
</tr>
<tr>
<td>CMDB Health Dashboard - Compliance Score Calculation</td>
<td>Script for calculating the compliance KPI of CMDB health.</td>
</tr>
<tr>
<td>CMDB Health Dashboard - Correctness Score Calculation</td>
<td>Script for calculating the correctness KPI of CMDB health.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
3. Review the default configuration, and update as necessary.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Job name. It is recommended that you do not modify the job's name.</td>
</tr>
<tr>
<td>Active</td>
<td>Select to activate the job.</td>
</tr>
<tr>
<td>Run</td>
<td>Configure recurring schedule of job execution, or select <strong>On Demand</strong>.</td>
</tr>
<tr>
<td>Time</td>
<td>If <strong>Active</strong> is selected, set the time (hour, minute, and second) to run the job.</td>
</tr>
<tr>
<td>Conditional</td>
<td>If selected, the scripted condition must evaluate to true before the job can run.</td>
</tr>
<tr>
<td>Run this script</td>
<td>The job's script. Modifications to the script are not recommended.</td>
</tr>
</tbody>
</table>

4. Click **Execute Now** to run the job once immediately.

**Results**

After you enable a CMDB Health Dashboard job, the results for the KPI are aggregated and displayed in the CMDB dashboard and CI dashboard, at the CMDB, class, and CI levels.

**Related information**

CMDB Health Dashboard for Helsinki | Overview

**Configure CMDB Health scorecard thresholds**

Configure the thresholds for best, at risk, and critical state definitions for the KPIs and metrics scorecards. You can configure these settings globally for the entire CMDB, or individually per class.
Before you begin
Role required: itil has read access, itil_admin (on top of itil) has full access.

About this task
Scorecard thresholds are used to determine overall metric state, and are defined by upper and lower thresholds. For example, scorecards thresholds for completeness:
- 0 - lower threshold: Best state
- Lower threshold - upper threshold: At risk state
- Upper threshold - 100: Critical state

In the base system, upper thresholds are set to 67 and lower thresholds are set to 33 for all KPIs and metrics. You can adjust scorecard thresholds to reflect the range of failures that should be used for each health state. Applying the change to a scorecard is based on the selected class in the CI Classes list:
- If the top level Configuration Item class is selected in the CI Classes list, changes to metric scorecards apply to the entire hierarchy.
- If any other class is selected in the CI Classes list, changes to metric scorecards apply to the selected class.

For CMDB groups, you can specify a separate set of scorecard thresholds, per CMDB group/KPI or metric. See Configure CMDB groups scorecard thresholds for more details.

Procedure
1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to display the CI Classes list, and then select a class to set scorecards for.
3. In the class navigation bar, expand Health.
4. To configure the overall scorecard, select Other Scorecards and then select Overall Scorecard.
5. To configure a scorecard for any of the KPIs (such as Compliance), or for relationship-related metrics (such as duplicate relations):
   a. Select configuration item at the top of the Hierarchy list.
   b. Click a KPI item, Completeness, Compliance, or Correctness.
   c. Click the tab CMDBCompleteness Scorecard, CMDB Compliance Scorecard, or CMDB Correctness Scorecard.
When you select the top-level Configuration Item class, changes to threshold settings in any metric scorecard apply to the entire class hierarchy.

6. To configure a scorecard for any metric:

   a. In the CI Classes list, select the class to which the updated scorecard should apply to. Select the top level Configuration Item to apply the change to the entire hierarchy.

   b. Click the KPI that contains the metric for which you want to configure scorecard. For example, click Completeness to configure the Required Fields scorecard.

   c. Select the scorecard tab of the metric to configure, such as Required Fields Scorecard. You might need to click New to edit the scorecards.

7. Slide the threshold sliders, or enter specific numbers to increase or to decrease the threshold bars to fit your definitions for best, at risk, and critical levels for the scorecard.

8. Click Save.

Related reference
CMDB Health KPIs and metrics

Related information
CMDB Health Dashboard for Helsinki | Overview

Configure CMDB groups scorecard thresholds

Each CMDB group can have its unique set of scorecard thresholds for best, at risk, and critical state definitions for specific KPIs or metrics.

Before you begin
Role required: itil_admin (on top of itil)

About this task
Scorecard thresholds are used to determine overall metric state, and are defined by upper and lower thresholds:

- 0 - lower threshold: Best state
- Lower threshold - upper threshold: At risk state
- Upper threshold - 100: Critical state

In the base system, for all KPIs and metrics, upper thresholds are set to 67 and lower thresholds are set to 33. You can adjust scorecard thresholds for a specific CMDB group per KPI or metric, to reflect the range of failures that should be used in health reporting.
CMDB groups scorecard thresholds are stored in the [cmdb_health_scorecard_group_threshold] table.

Procedure

1. In the search box in the navigation bar, enter `cmdb_health_scorecard_group_threshold.list` and press the Enter key.
2. In the **CMDB Health Group Scorecard Thresholds** list, click **New**.
3. Fill out the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upper threshold</td>
<td>Upper range of percentage of CIs failing the specified metric tests, that is used to calculate best and at risk states.</td>
</tr>
<tr>
<td>CMDB Group</td>
<td>The CMDB group to which this scorecard threshold setting applies to.</td>
</tr>
<tr>
<td>Lower threshold</td>
<td>Lower range of percentage of CIs failing the specified metric tests, that is used to calculate at risk and critical states.</td>
</tr>
<tr>
<td>Metric</td>
<td>The metric to which the scorecard threshold setting applies to.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

Related information

- **Configure CMDB Health scorecard thresholds**
- **Configure KPI and metrics aggregation preferences**

Metrics health scorecards are aggregated into their respective KPI, which in return are aggregated into the overall CMDB Health report. Set aggregation preferences for KPIs, and for each of their respective metrics, deactivate KPIs and metrics that you are not interested in reporting, and adjust weighted averages of aggregation.

Before you begin

To start collecting and reporting CMDB health KPIs and metrics, you must first enable and configure the CMDB health dashboard jobs.
Role required: itil_admin (on top of itil)

**About this task**
The completeness KPI for example, consists of the metrics *required fields* and *recommended fields*, each contributing a different weight to the sum. You can configure the proportional weight of required fields and recommended fields within completeness to be 25 and 75 respectively. You can also configure the proportional weight of completeness, compliance and correctness within the aggregated sum of the overall CMDB health.

⚠️ **Note:** Non-active KPI or metrics are displayed on the CMDB dashboard in faded coloring, displaying the most recent aggregations that were calculated when the KPI or metric was active.

If Domain Support - Domain Extensions is activated, then you can configure aggregation preferences per domain.

In the ServiceNow base system, the weights of KPIs have default settings, and metrics are globally set.

**Procedure**
1. Navigate to **Configuration > Health Preferences**.
2. Select **Health Metrics** on the right-hand side navigator.
3. From the **Select Metric** list select one of the KPIs such as **Completeness**, or a metric.
   For **Completeness, Compliance** and **Correctness**:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Activate the KPI so it is included in the aggregated CMDB health report.</td>
</tr>
<tr>
<td>Weighted Averages</td>
<td>Specify the weight of each metric in the aggregated KPI health report. The sum of weighted averages of all metrics should be 100.</td>
</tr>
</tbody>
</table>

For a metric:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Activate the metric so it is included in the aggregated health report for the respective KPI.</td>
</tr>
<tr>
<td>Create Task</td>
<td>If a record fails the metric test, create a task with details about the failure. You can then view the task on the CI dashboard, and configure remediation for the task.</td>
</tr>
<tr>
<td>Failure Threshold</td>
<td>When the threshold number of CIs that fail the health metric test is reached, health processing stops for the metric for this cycle.</td>
</tr>
<tr>
<td>Task Assignee Group</td>
<td>An assignment group for the task.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

**Related information**

CMDB Health Dashboard for Helsinki | Overview

**Set a CI attribute to be mandatory**

Configure a CI attribute as mandatory so it is included in the CMDB Health tests for the **required** metric if enabled. **Required** is a metric of the CMDB Health **completeness** KPI.

**Before you begin**

Role required: itil_admin

**About this task**

When a field is configured as mandatory, then if the **required** metric is enabled, the CMDB health tests check whether that field is populated or not. The CMDB dashboard displays the aggregated report of the percentage of CIs for which one or more required fields is empty.

**Procedure**

1. Navigate to Configuration > CI Class Manager.

2. Click **Hierarchy** to display the CI Classes list. Then select the class with the field that needs to be set as mandatory.
3. In the class navigation bar, expand **Class Info** and then select **Attributes**. In the Attributes view, click **Added**.

4. Locate the attribute that you want to set as mandatory, and then double-click its **Mandatory** value and set it to true. The next time the form is opened, a field status indicator appears next to the field label, indicating that a value is mandatory.

**Note**: Mandatory fields are global. The field is marked as mandatory everywhere it appears on a form. Also, mandatory fields do not appear correctly when using Service Mapping tag-based discovery. For more information, see **Tag-based discovery in Service Mapping**.

**Related information**

- [CMDB Health Dashboard for Helsinki | Overview](#)
- [Make a field mandatory](#)

**Set a CI field to be recommended**

Define a list of CI fields as **recommended**, noting that it is desirable that they are populated by a data source such as Discovery. You can then configure the CMDB completeness KPI to include recommended fields in its aggregated health reports.

**Before you begin**

Role required: itil has read access, itil_admin (on top of itil) has full access.

**About this task**

Use this for fields which should not be mandatory, but that might have useful information that the CI should have. For example, a field with information that might at some point help with diagnosis. Initially, a derived class is set with the recommended fields that are defined at the parent level. You can add or remove recommended fields for a derived class, setting it with its own recommended fields, without affecting the recommended fields at the parent or sibling levels. If all recommended fields for a derived class are removed, then the derived class automatically derives the recommended fields from its parent class.

For more information about child and parent classes, see **Table extension and classes**.
Procedure

1. Navigate to **Configuration > CI Class Manager**.

2. Click **Hierarchy** to display the CI Classes list. Then select the class that contains the fields that need to be set as recommended.

3. In the class navigation bar, expand **Health** and click **Completeness**. Then click **Recommended Fields**.

4. In the Recommended Fields tab, use the slushbucket to move the fields that you want to designate as recommended, from the **Available** list to the **Selected** list.

5. Click **Save**.

Related information

CMDB Health Dashboard for Helsinki | Overview

Create or edit a CMDB Health orphan rule

Create an orphan rule to determine the percentage of orphan CIs in the CMDB. This sum is then aggregated into the correctness CMDB Health KPI, and weighed into the overall CMDB health report. Orphan rules are defined per class, and only a single orphan rule can be defined per class.

Before you begin

Role required: itil has read access, itil_admin (on top of itil) has full access.

About this task

Specify the conditions that CIs must meet to be considered an orphan CI. Specify attributes that a CI must have, relationships that a CI should not have, or both. In the relationship conditions, you can either specify that the CI has no relationships, or a set of specific relationships that the CI doesn't have.

⚠️ Note: If there is a health inclusion rule for the orphan metric, then the conditions in the health inclusion rule and the conditions in the health orphan rule, shouldn’t be identical.

A health orphan rule can for example, identify a CI of the cmdb_ci_computer class as an orphan CI if the CI is not set with an owner or an asset.

Procedure

1. Navigate to **Configuration > CI Class Manager**.

2. Click **Hierarchy** to display the CI Classes list. Select the class for which to create an orphan rule.
3. In the class navigation bar, expand **Health**. Click **Correctness** and then click **Orphan Rule**.

4. Select a rule to edit if one exists, or click **New**. Fill out the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>The class for which the orphan rule applies.</td>
</tr>
<tr>
<td>Attributes</td>
<td>Attribute conditions that a CI must satisfy to be considered an orphan CI. For example, the filter conditions in which both the <strong>Assigned to</strong> and the <strong>Owned by</strong> fields are empty, will identify the matching CIs as orphans.</td>
</tr>
<tr>
<td>Condition</td>
<td>And/Or operation between the <strong>Attributes</strong> conditions and the <strong>Relationship</strong> conditions.</td>
</tr>
<tr>
<td>Relationship</td>
<td>The relationship conditions that a CI must fail in order to be considered an orphan CI. To specify that a CI must have no relationships, choose <strong>Any Relation</strong> and <strong>Any Class</strong> respectively.</td>
</tr>
</tbody>
</table>

5. Click **Submit** or **Update** to save the rule.

**Related information**

CMDB Health Dashboard for Helsinki | Overview

Create or edit a CMDB Health staleness rule

If the staleness metric is in effect, then staleness rules are used to determine the percentage of stale CIs in the CMDB. This sum is then aggregated into the correctness KPI, and weighs into the overall CMDB health calculation. Staleness rules are defined per class.

**Before you begin**

Role required: itil has read access, itil_admin (on top of itil) has full access.
About this task
The Discovery setting of certain types of CIs as stale takes precedence over a CMDB Health staleness rule defined for the CI. For more information about Discovery marking CIs as stale, see Discovery for VMware vCenter.

Procedure
1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to display the CI Classes list. Select the class for which to create a staleness rule.
3. In the class navigation bar, expand Health and then click Correctness. Click Staleness Rule.
4. Select a staleness rule to edit or click New, and then fill out the Staleness Rule form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applies to</td>
<td>The class for which the rule applies.</td>
</tr>
<tr>
<td>Effective Duration</td>
<td>The time period that is used for the staleness test.</td>
</tr>
<tr>
<td></td>
<td>If the CI was not updated (based on Updated sys_updated_on) within the specified time period — the CI is determined to be stale.</td>
</tr>
<tr>
<td></td>
<td>If you enter a value with a prefix that is valid and a suffix that is not, such as 15 x — the valid portion of the value is used ('15'). If the entire value is invalid — the value is ignored and the previous valid value is used.</td>
</tr>
</tbody>
</table>

5. Click Submit or Update to save the rule.

Related information
CMDB Health Dashboard for Helsinki | Overview

Create health inclusion rule
Filter the CIs that are included in health calculations and that appear in CMDB health dashboards by defining health inclusion rules. Health inclusion rules can be specified per domain.
Before you begin
Role required: itil has read access, itil_admin (on top of itil) has full access.

About this task
Evaluation for the required, orphan, recommended, duplicate and staleness health metrics, will apply only to CIs that satisfy health inclusion rules. For example, if you want scores of the duplicate metric to appear only for server and network CIs.

Note:
• Creating health inclusion rules at the level of the base cmdb_ci table can potentially filter out health results of all classes in CMDB health dashboards.
• Applying a health inclusion rule to the duplicate metric, is supported only in the global domain.

In addition to any health inclusion rules, identification inclusion rules also indirectly impact what appears in CMDB health dashboards for duplicate CIs. The dashboard itself uses the identification engine (IRE) to identify duplicate CIs and therefore identification inclusion rules are applied.

Inheritance of health inclusion rules:
• If there are no health inclusion rules specified for a child class, then rules specified on a parent class are applied to the child class.
• If health inclusion rules are specified for a child class, then those rules take precedence over rules specified on a parent class.

In the base system, there are no predefined health inclusion rules, in which case all CIs are included in the CMDB Health calculations.

Procedure
1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to display the CI Classes list. Select the class for which to create a health inclusion rule.
3. In the class navigation bar, expand Health and then click Health Inclusion Rules.
4. Click an existing rule to edit or click New and then fill out the Health Inclusion Rules form.
### CMDB Health KPIs and metrics

The overall CMDB health score consists of three Key Performance Indicators (KPIs) which are correctness, compliance and completeness, each further consisting of sub-metrics. Each KPI and metric is associated with a scorecard that determines its contribution to the aggregated health at the overall CMDB level, class, and CI level.

You can configure which KPIs and metrics are included in the aggregated calculation, and set their weight in the aggregation. In the base system, all KPIs and all metrics are included in the aggregated health report.

#### Overall

An aggregation of all three KPIs (correctness, completeness and compliance), according to their overall scorecard weight settings.

#### Correctness

A KPI which is an aggregation of the following metrics, according to the correctness scorecard weight settings.

##### Orphan

Measures the percentage of orphan CIs in the CMDB. A CI can become orphan if it was unintentionally left in the CMDB when it is no longer needed. A CI is determined to be orphan if:

- The CI satisfies the criteria in an orphan rule. This criteria checks for specific attributes that a CI must have, and for CIs that have no relationships or that don't have specific relationships.

- Data is missing for the CI in its respective table, or in one of its parents’ table.

##### Staleness

5. Click **Save** or **Update**.

---

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applies to</td>
<td>Class this rules applies to.</td>
</tr>
<tr>
<td>Active record condition</td>
<td>Criteria that CIs must meet to be included in the evaluation for the specified health metrics.</td>
</tr>
<tr>
<td>Applies to metric</td>
<td>Metrics that the rule applies to.</td>
</tr>
</tbody>
</table>
Measures the percentage of stale CIs in the CMDB. A CI is stale if it was not updated within the Effective Duration time period that is specified in the staleness rule that applies to the class.

The base system includes a default staleness rule for the Configuration Item [cmdb_ci] class, which sets the Effective Duration time to 60 days. This rule applies to all extended CMDB classes, and can be overridden by class specific staleness rules defined by the user. To determine CI staleness, a staleness rule for the CI's class is used if it exists, otherwise, the default staleness rule is used.

In addition, a relationship in which a stale CI is a parent or a child, is determined to be a stale relationship.

**Note:** Discovery marks VMware vCenter CIs that no longer physically exist, as stale. By default, this setting takes precedence over a CMDB Health staleness rule defined for the CI. When drilling-down in the CMDB dashboard to Health Results, the **Source** for CIs determined to be stale by Discovery, is **CLOUD_DISCOVERY**. Setting the glide.cmdb.health.src.cmdb_health_audit_only system property to true, ensures that the CMDB dashboard displays health results generated only by CMDB Health. For more information, see CMDB Health system properties and Discovery for VMware vCenter.

**Duplicate**

Measures the percentage of duplicate CIs in the CMDB using identification rules. Only independent CIs are evaluated for duplication. In a set of duplicate CIs, the count of duplicate CIs is the total number of CIs in the set, minus one. The detailed graphs for a duplicate set of CIs display all the CIs in the set.

**Completeness**

A KPI which is an aggregation of the following metrics, according to the completeness scorecard weight settings.

**Required**

Measures the percentage of CIs in which fields that are defined as mandatory, are not populated. Missing fields are tagged as incomplete noting that for this CI some information is missing. Required fields are equivalent to the fields that are specified as mandatory in the system dictionary.

**Recommended**
Measures the percentage of CIs in which fields that are set as recommended, are not populated. Out-of-box, no recommended fields are specified.

You can use the Add Identifier Fields In Recommended Rules scheduled job to set criterion attributes from active identification rules, as recommended fields. You can use the Remove Identifier Fields In Recommended Rules scheduled job to unset criterion attributes from active identification rules, as recommended fields.

Compliance
Based on the results of actual CMDB audit runs.

Audit
Audit compares actual values of specified fields, against expected values defined in template and scripted audits. Based on the Last run date of audits, CMDB Health identifies the set of the most recent complete audit run, and uses those audit results. To pass the CMDB Health audit test, a CI must be in compliance with all audits for that CI. Create a compliance-type audit, for which the results are calculated into the CMDB Health compliance KPI.

Relationships
Measures the health of CI relationships, consisting of the following metrics which are not-configurable:

**Duplicate relationships**
Relationships that have identical parent and child CIs, identical relationship type, and an identical port. Duplicate relationships are displayed per relationship type. In a set of duplicate relationships, the duplicate relationship count is the total number of duplicate relationships in the set, minus one. The detailed graphs for a duplicate set of relationships display all the relationships in the set.

**Orphan relationships**
A relationship that is missing either a parent CI, a child CI, or both.

**Stale relationships**
A relationship in which the parent CI or the child CI is a stale CI.

A single relationship can fail more than one health test. For example, a duplicate relationship can also be stale.

Also reports the following relationship-related summaries:
• Relations not compliant with suggested relations
• Relations not compliant with containment rules
• Relations not compliant with hosting rules

Related reference
CMDB Health system properties

Related information
Configure KPI and metrics aggregation preferences
Configure CMDB Health scorecard thresholds

CMDB Health dashboards
CMDB dashboards display CMDB health reports and let you configure the CMDB health KPIs and metrics that CIs are evaluated for.

<table>
<thead>
<tr>
<th>Dashboard</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB Dashboard</td>
<td>Main CMDB health dashboard:</td>
</tr>
<tr>
<td>Configuration &gt; CMDB Dashboard &gt; CMDB View</td>
<td>• Overall CMDB and class level aggregated CI health. Aggregation is displayed from the metric level up to the overall CMDB level.</td>
</tr>
<tr>
<td></td>
<td>• Aggregated health for CI relationships, and its metrics.</td>
</tr>
<tr>
<td></td>
<td>• Displays the tasks that were generated for CIs that failed a health test.</td>
</tr>
<tr>
<td></td>
<td>• Drill down for each KPI to a detailed report of associated metrics, broken by class.</td>
</tr>
<tr>
<td></td>
<td>• Manage the CMDB Health Dashboard jobs.</td>
</tr>
</tbody>
</table>

<p>| CI Dashboard                  | Health reports at the CI level:                      |
|&lt;CI form&gt; &gt; Dashboard          | • Pass/fail results for each metric, per CI.         |
|                               | • Displays incidents, changes, and other tasks affecting the CI, and business services affected by the CI. |</p>
<table>
<thead>
<tr>
<th>Dashboard</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Class Manager</td>
<td>Central location to manage CI classes and to configure CMDB health settings:</td>
</tr>
<tr>
<td><strong>Configuration &gt; CI Class Manager</strong></td>
<td>• Configure scorecard thresholds of all KPIs and associated metrics.</td>
</tr>
<tr>
<td></td>
<td>• Configure weight of KPIs and associated metrics in health aggregation.</td>
</tr>
<tr>
<td></td>
<td>• Manage rules and definitions that are used for health tests, such as orphan rules, audit certificates, and recommended fields rule.</td>
</tr>
<tr>
<td></td>
<td>• Explore the class hierarchy.</td>
</tr>
<tr>
<td></td>
<td>• Update and extend a CI class.</td>
</tr>
<tr>
<td></td>
<td>• Delete all records for a class.</td>
</tr>
<tr>
<td>CMDB Health Preferences</td>
<td>Central location for configuring CMDB Health settings:</td>
</tr>
<tr>
<td><strong>Configuration &gt; Health Preferences</strong></td>
<td>• Configure CMDB Health preferences.</td>
</tr>
<tr>
<td></td>
<td>• Manage the CMDB Health Dashboard jobs.</td>
</tr>
<tr>
<td></td>
<td>• Activate and configure weighted averages for KPIs and metrics.</td>
</tr>
<tr>
<td></td>
<td>• Set the maximum failure threshold for the KPIs.</td>
</tr>
<tr>
<td></td>
<td>• Configure creation of tasks for failed CIs.</td>
</tr>
<tr>
<td>CMDB Service Dashboard</td>
<td>Main CMDB service health dashboard:</td>
</tr>
<tr>
<td><strong>Configuration &gt; CMDB Dashboard &gt; Service View</strong></td>
<td>• Overall service aggregated health and detailed health for CIs per service. Aggregation is displayed from the metric level up to the overall services level.</td>
</tr>
<tr>
<td></td>
<td>• Displays the tasks that were generated for CIs in a service that failed a health test.</td>
</tr>
</tbody>
</table>
View CMDB health reports

The CMDB dashboard serves as a central location to view aggregated health reports for your CMDB at a glance which helps you understand the CMDB health status. Also, it provides functions to address health issues, and improve CMDB health.

The CMDB dashboard requires some configuration before it can display meaningful data. Once CMDB Health is configured and the CMDB Health Dashboard Jobs are enabled, the dashboard displays data that is automatically collected and calculated on a recurring schedule. The CMDB dashboard uses the Performance Analytics framework for dashboards and employs some of the capabilities it provides. The CMDB dashboard is domain aware.

Using the CMDB dashboard requires the asset or itil role, and if the system property `glide.cms.enable.responsive_grid_layout` exists, then its value must be true. For more information, see Enable responsive dashboards.

For information about sharing a responsive dashboard (Sharing), see Share a responsive dashboard.

ℹ️ Note: Only users with the itil role can view a CMDB dashboard which has been shared.
Access the CMDB dashboard by navigating to **Configuration > CMDB Dashboard > CMDB View**. On the CMDB dashboard:

- Click **CMDB Health Dashboard Jobs** to enable and manage the jobs that monitor and collect health data for CIs and CI relationships.
- Click the default **CMDB Dashboard - CMDB View** dashboard to list additional CMDB drill-in dashboards.

The CMDB dashboard has two viewing modes. Click **CI Health** or **Relationship Health** to toggle between them.

**CMDB Health view**

The CMDB Health view is the default view for the CMDB dashboard which contains:

- Scorecards detailing the overall health of CIs in your CMDB, per health KPI and metric
- Useful reports showing a breakdown of any duplicate, orphan, or stale CIs by class
- Widgets that list the top 10 incident, alert, and change generating CIs in the CMDB

<i>Note:</i> To improve performance, you can use the system property `glide.cmdb.health.src.top_10_cache_time_in_minutes` to extend browser caching time for those top 10 CIs widgets. The value is set to 30 (minutes) by default.

All the default widgets in the CI Class view can be filtered using the CMDB class hierarchy tree. Initially, the class hierarchy filter is set to the root class, **Configuration Item (All)**. Click **All** to select a different class, filtering all widgets on the dashboard to display data only for the selected class and its child classes.

In each scorecard widget, the horizontal bar in the center and the % number are correlated, displaying the aggregated health summary for the KPI. Health results of associated metrics are displayed underneath, each contributing according to the configuration of the metric scorecard, and its threshold.

Except for the Overall health scorecard, you can drill into any widget in the CI Class view:
• In a scorecard widget: Click the large aggregated percent number or the health bar to drill into a more detailed dashboard for that KPI.
• In a charts widget: Click a bar to display a list of all the records that the bar represents.
• In lists: Click the ‘i’ icon to view a list of all the tasks or alerts related to the CI.

**Relationship Health view**
The Relationship Health view displays various scorecards for health indicators of CI relationships in your CMDB. It contains charts detailing any duplicate, orphan or stale relationships, broken down by relationship type. You can drill down these charts for further details.

Changing the CI Class selection while in the Relationship view has no effect on the data displayed in this view.

**Color codes**
Both, the CI class view and the relationship view, use color codes when displaying aggregated health status. The status definitions are based on each scorecard’s threshold limits that are defined in the CI Class Manager.

<table>
<thead>
<tr>
<th>Color code</th>
<th>Definition</th>
<th>Default threshold setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Best</td>
<td>Less than or equal to 33</td>
</tr>
<tr>
<td>Orange</td>
<td>At risk</td>
<td>More than 33 and less than or equal to 67</td>
</tr>
<tr>
<td>Red</td>
<td>Critical</td>
<td>More than 67</td>
</tr>
<tr>
<td>Gray</td>
<td>Incomplete</td>
<td>N/A</td>
</tr>
</tbody>
</table>

ℹ️ **Note:** The icon is a notation that the maximum failure threshold for the scorecard has been reached. The tests for the metric are halted for this cycle, and all associated aggregated summaries are 0%. Review the scorecard rules which might be ineffective, or the CMDB might be in an unstable state.

**Dashboard layout configuration**
The CMDB dashboard uses some of the capabilities that Performance Analytics provides for responsive dashboards. You can, for example, add or remove widgets from the layout.
For information about adding a widget (Add Widgets) and changing other layout settings such as adding a tab (Create Tab) to the dashboard, see Edit a dashboard. The drop-down that appears when adding a widget, includes CMDB-related widgets that are used in CMDB dashboards and other system widgets which are typically not relevant in CMDB reports.

**Domain separation**

If the Domain Support — Domain Extensions Installer plugin is activated, then the CMDB dashboard is domain aware:

- The CMDB dashboard aggregates and reports health failures and scores based on user’s domain visibility of CIs. If domain visibility lets a user see a CI, then the audit rule in that user’s domain applies to that CI, whether the CI is in the user’s domain or in a contained domain. If a CI fails health tests from different user domains, then separate failure records are created.

- Users can configure KPI and metric settings specific to the needs in their domain. So different domains can have different settings such as active/inactive, and thresholds.

- A child domain derives its immediate parent’s domain health configurations if the child domain does not configure its own. A child domain can override parent’s configurations by modifying them.

**Related information**

- CMDB Health Dashboard for Helsinki | Overview
- Working with responsive dashboards

**View services health reports**

The CMDB service dashboard serves as a central location to view aggregated health reports for services at a glance. Also, it lets you drill into a service to perform remediation actions that address health issues, and that improve CMDB health. The CMDB service dashboard uses the Performance Analytics framework for dashboards and employs the capabilities it provides.

**Requirements**

- The Event Management and Service Mapping Core plugin must be activated.

- If the system property glide.cms.enable.responsive_grid_layout exists, then it needs to be set to true. For more information, see Enable responsive dashboards.

- Role required: asset or itil


Configuration

The CMDB service dashboard requires some configuration before it can display meaningful data, using the same settings as the CMDB dashboard. The CMDB service dashboard uses the settings for the Business Service, Manual Service, and Technical Service classes. For each CI that is included in a service, the rule settings of its respective class are applied. You can customize these settings in the CI Class Manager, and on the CMDB Health Preferences page. Once CMDB Health is configured and the CMDB Health Dashboard Jobs are enabled, the CMDB service dashboard displays data that is automatically collected and calculated on a recurring schedule.

Note: The CMDB service dashboard doesn’t include all services from the Service [cmdb_ci_service] table. Only services from the cmdb_ci_service_auto table and its descendants (cmdb_ci_service_discovered, cmdb_ci_service_manual, cmdb_ci_query_based_service), are included.

CMDB Health is domain aware. If domain separation has been activated, then the CMDB service dashboard displays health based on data, rules, and settings from the logged-on user domain. If rules and settings are not defined for a child domain, then the parent’s settings are applied, recursively.

Access

Access the CMDB service dashboard by navigating to Configuration > CMDB Dashboard > Service View.

Report details

The CMDB service dashboard displays aggregated health for services, and also details for individual services. For a specific service, the CMDB service dashboard displays aggregated health for all the CIs in that service, including the service CI itself. Also it provides useful reports about service classes such as the Business Service class. You can drill down those reports to display further details of duplicate, orphan, or stale CIs per service and lists of the top 10 incident, alert, and change generating CIs in the service.

All default widgets can be filtered using the CMDB service hierarchy tree. Initially, the service hierarchy filter is set to Business Service. Click Business Service to expand it and to select a different class, filtering all widgets on the dashboard to display data only for the selected class, its child classes, or services of that class.

In each scorecard widget, the horizontal bar in the center and the % number are correlated, displaying the aggregated health summary for the KPI. Health
results of associated metrics are displayed underneath, each contributing according to the weight configuration of the metric scorecard, and its threshold. With the exception of the Overall health scorecard, you can drill into any widget in the service dashboard:

- In a scorecard widget: Click the large aggregated percent number or the health bar to drill into a more detailed dashboard for that KPI.
- In a charts widget: Click a bar to display a list of all the records that the bar represents.
- In lists: Click the ‘i’ icon to view a list of all the tasks or alerts related to the CI.

**Color codes**

The CMDB service dashboard uses color codes when displaying aggregated health status. The status definitions are based on the threshold limits for each scorecard, defined in the CI Class Manager.

<table>
<thead>
<tr>
<th>Color code</th>
<th>Definition</th>
<th>Default threshold setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Best</td>
<td>Less than or equal to 33</td>
</tr>
<tr>
<td>Orange</td>
<td>At risk</td>
<td>More than 33 and less than or equal to 67</td>
</tr>
<tr>
<td>Red</td>
<td>Critical</td>
<td>More than 67</td>
</tr>
<tr>
<td>Gray</td>
<td>Incomplete</td>
<td>N/A</td>
</tr>
</tbody>
</table>

The icon is a notation that the maximum failure threshold for the scorecard has been reached. The tests for the metric are halted for this cycle, and all associated aggregated summaries display 0%.

**Related information**

- View CMDB health reports
- View CMDB groups health reports

**View CMDB groups health reports**

The CMDB group view dashboard serves as a central location to view aggregated health reports for CMDB groups at a glance. Also, it lets you drill into a CMDB group to perform remediation actions that address health issues, and that improve CMDB health. The CMDB group view dashboard uses the Performance Analytics framework for dashboards and employs the capabilities it provides.
Configuration

The CMDB group view dashboard requires some configuration before it can display meaningful data, using the same settings as the CMDB dashboard. For each CI that is included in a CMDB group, the rule settings of its respective class are applied. You can customize these settings in the CI Class Manager, and on the CMDB Health Preferences page. Once CMDB Health is configured and the CMDB Health Dashboard Jobs are enabled, the CMDB group view dashboard displays data that is automatically collected and calculated on a recurring schedule.

If the system property `glide.cms.enable.responsive_grid_layout` exists, then it needs to be set to true. For more information, see Enable responsive dashboards.

CMDB Health is domain aware. If domain separation has been activated, then the CMDB group view dashboard displays health based on data, rules, and settings from the logged-on user domain. If rules and settings are not defined for a child domain, then the parent’s settings are applied, recursively.

Role required: asset or itil

Access

Access the CMDB group view dashboard by navigating to Configuration > CMDB Dashboard > Group View. Then, select a CMDB group from the CMDB Health Group List drop-down list.

Report details

For each CMDB group, the CMDB group view dashboard displays aggregated health for all the CIs in that group. You can drill down those reports to display further details of duplicate, orphan, or stale CIs per CMDB group. In each scorecard widget, the horizontal bar in the center and the % number are correlated, displaying the aggregated health summary for the KPI. Health results of associated metrics are displayed underneath, each contributing according to the weight configuration of the metric scorecard, and its threshold.

With the exception of the Overall health scorecard, you can drill into any widget in the CMDB group view dashboard:

- In a scorecard widget: Click the large aggregated percent number or the health bar to drill into a more detailed dashboard for that KPI.
- In a chart widget: Click a bar to display a list of all the records that the bar represents.
- In lists: Click the ‘i’ icon to view a list of all the tasks or alerts related to the CI.
Color codes

The CMDB group view dashboard uses color codes when displaying aggregated health status. The status definitions are based on the threshold limits for each scorecard, defined in the CI Class Manager.

<table>
<thead>
<tr>
<th>Color code</th>
<th>Definition</th>
<th>Default threshold setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Best</td>
<td>Less than or equal to 33</td>
</tr>
<tr>
<td>Orange</td>
<td>At risk</td>
<td>More than 33 and less than or equal to 67</td>
</tr>
<tr>
<td>Red</td>
<td>Critical</td>
<td>More than 67</td>
</tr>
<tr>
<td>Gray</td>
<td>Incomplete</td>
<td>N/A</td>
</tr>
</tbody>
</table>

The 🔄 icon is a notation that the maximum failure threshold for the scorecard has been reached. The tests for the metric are halted for this cycle, and all associated aggregated summaries display 0%.

Related information

- Configure CMDB groups scorecard thresholds
- View CMDB health reports
- View services health reports

View CI health

The CI dashboard is a central location displaying health report for an individual CI, history of changes to the CI in a timeline view, and the relation formatter. The CI dashboard also displays incidents, changes, and other tasks affecting the CI, and business services affected by the CI. You can access the CI dashboard from a CI form, or from the CMDB dashboard.

Before you begin

Role required: asset or itil

About this task

The health scores are based on settings of CMDB Health KPIs and metrics. The report is calculated in real-time from data stored in health-related tables which the CMDB Dashboard jobs update on a recurring schedule. The completeness and correctness KPIs are always up to date, but for other KPIs, it is possible that updates to the CMDB are not reflected because one of the dashboard jobs hasn’t run yet, as follows:
• Compliance: Depends on audit cycles and on the 'CMDB Health Dashboard - Compliance Score Calculation' job.

• Relationships: Depends on the 'CMDB Health Dashboard - Correctness Score Calculation' job.

To ensure that the latest updates to these KPIs are reflected on the CI dashboard, navigate to the respective dashboard job, and click **Execute Now**.

**Procedure**

1. On a CI form click **Dashboard**.

2. Or, navigate to **CMDB Dashboard > CMDB Health** and click **CMDB Dashboard - All** to display the class hierarchy. Enter a search string and then select a CI from the **Configuration Items** group.

   The search results are grouped by **Classes** and **Configuration Items** that match the search string.

**Results**

Various widgets in the report display CI's health with the following color codes:

• Green: The CI passed the health test (for example, it is not a duplicate).

• Red: The CI failed the health test (for example, it is a duplicate)

• Grey: The CI was not tested for this metric, because the threshold was not set for the CI (class) in the CI module.

The report displays the change history for the CI in a timeline format, that you can zoom in or out to select a time period for which to display details for. Use the related lists tabs **Change**, **Incident**, **Task**, **Business Services**, and **Alerts** to further drill into additional details.
Missing rules or other class definitions can prevent some health scores from being evaluated for a CI. The results in the CI dashboard in these situations, are described below:

**Duplicate**

- If no identification rules ([cmdb_identifier]) are defined for the CI's class or its ancestors: A notification to that effect appears.
- If only dependent identification rules are defined: **Not applicable** notification appears.

**Orphan**

- If the CI is excluded by health inclusion rules: **Not applicable** notification appears.
- If no orphan rules ([cmdb_health_orphan_rule]) are defined for the CI's class or its ancestors: A notification about missing a rule appears.

**Staleness**

- If the CI is excluded by health inclusion rules: **Not applicable** notification appears.
- If no staleness rules ([cmdb_health_staleness_rule]) are defined for the CI's class or its ancestors: A notification about missing a rule appears.

**Audit**

- If no audits ([cert_audit]) are defined for the CI (CI dashboard checks only desired states and scripted audits): **Not applicable** notification appears.
- If there are audits defined for the CI but the audits did not run: **Not applicable** notification appears.

**Related information**

- Enable and configure a CMDB Health Dashboard job
- Timeline of CI changes
- CI relations formatter
Customize the CI dashboard
You can add, remove or re-arrange content on the CI dashboard to display the CI health statistics that are important to you.

Role required: itil_admin

On a CI form click Dashboard and customize the CI dashboard as follows:

• Drag a tile near its upper edge and drag it to a different location on the dashboard to rearrange the current layout.
• Click the X in the upper right side of a widget to hide the widget.
• Click the + sign in the upper left corner of the dashboard to add content. In the Add content dialog box, select the content to add and the location to place it.
• Click the gear icon in a widget tile to edit widget settings such as title and height.
• Click Reset to Default to revert to the base system settings.

View CI relationships health
View aggregated orphan, stale, and duplicate CI relationships in the CMDB dashboard. You can configure the relationship scorecards, but you cannot configure the underlying relationship KPI health tests.

Before you begin
The CMDB Health Dashboard - Relationship Compliance Processor dashboard job must run to generate data for these reports.

Role required: itil or asset

About this task
CMDB Health measures CI relationship health using a separate KPI and metrics.

Orphan relationship
A relationship that is missing parent, child, or relationship type.

Duplicate relationship
Relationships that have identical parent, child, and relationship type.

Stale relationship
A relationship in which one of the CIs is stale. For a stale CI — its associated relationships are also stale.

In addition, the following relationship compliance reports are available:

Relationships not compliant with all relationship rules
Relationships that do not comply with any relationship governance rule, including suggested relationships and dependent relationship rules.

**Relationships not compliant with suggested relationships**

Suggested CI relationships are used as rules to test if relationships comply with specified suggested relationships.

**Relationships not compliant with containment rules**

Containment rules are used to test if relationships comply with specified containment relationships.

**Relationships not compliant with hosting rules**

Hosting rules are used to test if relationships comply with specified hosting relationships.

For each of the compliance reports, testing a relationship requires a rule (suggested relationship, hosting rule, or containment rule) in which the parent and child CI classes match the parent and child CI classes in the tested relationship. If the relationship types in the rule and in the tested relationship do not match, then the relationship is not in compliance. If an applicable rule is not found, then the relationship is considered to be in compliance. Rules apply to the classes specified in the rule, and also to descendant classes. Therefore, when testing a relationship, rules that apply to ascendant parents of the CIs in the tested relationship are used. If there are multiple rules that match the parent and the child CI classes of the tested relationship, then the tested relationship needs to satisfy only one of these rules to be in compliance.

**Procedure**

1. Navigate to Configuration > CMDB Dashboard > CMDB View.
2. Select the Relationship Health tab.
3. Scroll to the bottom of the page to examine the relationship compliance reports.
   
   Report results are grouped by relationship type, and you can drill down for further details:
   
   - Point to a relationship type to display its label and the % of relationships that are not in compliance.
   - Click on a relationship type to drill down to a detailed list of all the relations of that type that are not compliant. Click on a specific relationship to display more details such as the failure description. The Failure Description field lists only a single rule that the relationship did not comply with, even if there are additional rules that the relationship fails to comply with.
Related information
Enable and configure a CMDB Health Dashboard job

Create CMDB remediation rule
A CMDB remediation rule is associated with a task that was created for a failed CMDB health test. A CMDB remediation rule is applied automatically or manually to execute a remediation workflow that can, for example, delete stale CIs.

Before you begin
You need to first create and publish a remediation workflow that addresses the CI issue. The workflow can be a regular workflow, or an Orchestration workflow, and the table in the workflow needs to match the task type in the remediation rule. Do not configure the workflow with any filter conditions by setting If condition matches to None, so that the filters of the CMDB remediation rule will apply.

Role required: itil_admin (on top of itil)

Procedure
1. Navigate to Configuration > CMDB Remediations.
2. Fill in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Remediation name.</td>
</tr>
<tr>
<td>Task type</td>
<td>Type of CMDB health-related tasks to apply the remediation to.</td>
</tr>
<tr>
<td>Task filter</td>
<td>Filters tasks to apply remediation to. Also applies dot-walking on CI fields so that remediation is applied to tasks associated with matching CIs.</td>
</tr>
<tr>
<td>Execution</td>
<td>• Manual: Remediation is applied manually.</td>
</tr>
<tr>
<td></td>
<td>• Automatic: The workflow is applied once, upon the creation of a task that matches the Task type and Task filter.</td>
</tr>
<tr>
<td>Active</td>
<td>Allowing the workflow to run.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Workflow</td>
<td>The CMDB remediation workflow (regular or Orchestration) that will execute automatically or manually, depending on the Execution setting. You can click the Lookup using list icon, and then click New to create a new workflow.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

Results

If **Execution** is set to Automatic, then the business rule **Run remediations for CMDBHealth task** applies the remediation workflow to CIs that match the Task filter. If **Execution** is set to Manual, then you can manually apply the remediation workflow defined in the rule.

Related information

**Dot-Walking**

**Apply CMDB remediation**

Manually initiate a workflow to remediate a CI that failed a CMDB health test. For example, you can remediate CIs that are orphan or stale.

**Before you begin**

To manually apply a CMDB remediation, a CMDB remediation rule must exist, in which **Execution** is set to **Manual**.

Role required: itil_admin

**About this task**

Except for the duplicate and audit health metrics, you can choose to create tasks for health test failures for a metric. To remediate failures of the duplicate metric, use de-duplication tasks.

For all metrics except for audit, each CI that failed a metric test is associated with a single task. Because a CI can fail multiple audits, a single CI can be associated with multiple audit tasks. The first of those tasks is in the Task field, and any additional tasks are in the Additional Tasks field. To remediate failures of the audit metric, refer to the audit tasks for the audits that the CI failed.
Procedure

1. Navigate to Configuration > CMDB Dashboard, and then click CMDB View, Service View, or Group View.

2. Click on one of the bars in a bar chart on the page. Or, click on a metric tile that is associated with the remediation that you want to apply, and then in a detailed report click on a bar in a bar chart. For example, to remediate an orphan CI, click the Completeness tile.

3. In the Task column in the CMDB Health Results list, select the task that is associated with the CI that you want to remediate. Point to the information icon ( ) for a result record to display the CMDB Health Results dialog box with more details about the health test. The CMDB Health Results list contains records only for the CIs that failed a metric test.

<table>
<thead>
<tr>
<th>Field</th>
<th>Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI</td>
<td>The CI associated with the test results.</td>
</tr>
<tr>
<td>Class Name</td>
<td>The CI’s class.</td>
</tr>
<tr>
<td>Description</td>
<td>Details about the reasons for the CI failing the metric test.</td>
</tr>
<tr>
<td>Last Evaluated On</td>
<td>Time that the CI was evaluated for the metric, and which resulted in failure.</td>
</tr>
<tr>
<td>Metric</td>
<td>The CMDB Health metric associated with this test result.</td>
</tr>
<tr>
<td>Source</td>
<td>Source of the health test failure:</td>
</tr>
<tr>
<td></td>
<td>• CMDB Health Audit: Corresponds to the dashboard</td>
</tr>
<tr>
<td></td>
<td>• Cloud discovery</td>
</tr>
<tr>
<td>Task</td>
<td>The task associated with the health test failure. For the audit metric, if there are multiple failures, then only the first task is listed.</td>
</tr>
<tr>
<td>Additional Tasks</td>
<td>If there are multiple tasks related to the audit metric, contains all tasks</td>
</tr>
<tr>
<td>Field</td>
<td>Column</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>other than the first which is in the Task field.</td>
</tr>
<tr>
<td>Active</td>
<td>Used internally in combination with the To Delete field to determine the correct results set that this failure belongs to.</td>
</tr>
<tr>
<td>To Delete</td>
<td>Used internally in combination with the Active field to determine the correct results set that this failure belongs to.</td>
</tr>
</tbody>
</table>

4. On the task form, click **Remediate**.

5. In the **Run Remediations** dialog box, select the remediation rule that you want to apply.
   The list of remediation rules is based on the type of health metric (such as orphan, stale), and on the filter defined in the rule.

6. Click **Execute**.

**Related information**

**Create CMDB remediation rule**

**Components installed with CMDB Health**

Several types of components are installed with CMDB Health (included in the com.snc.cmdb plugin), including tables and scheduled jobs.

**Note**: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see **Find components installed with an application**.

**Scheduled jobs installed**

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB Health Dashboard - Completeness Score Calculation</td>
<td>Script for calculating the completeness KPI of CMDB health.</td>
</tr>
<tr>
<td>Scheduled job</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CMDB Health Dashboard - Compliance Score Calculation</td>
<td>Script for calculating the compliance KPI of CMDB health.</td>
</tr>
<tr>
<td>CMDB Health Dashboard - Correctness Score Calculation</td>
<td>Script for calculating the correctness KPI of CMDB health.</td>
</tr>
<tr>
<td>CMDB Health Dashboard - Relationship Score Calculation</td>
<td>Script for calculating the CI relationships KPI of CMDB health.</td>
</tr>
<tr>
<td>CMDB Health Dashboard - Relationship Compliance Processor</td>
<td>Script for calculating compliance of relationships with suggested relationships, and with hosting and containment rules.</td>
</tr>
<tr>
<td>Add Identifier Fields In Recommended Rules</td>
<td>Sets all criterion attributes from all active identifier entries from all active identification rules, as recommended fields. These added recommended fields are then checked by the CMDB Health Dashboard - Completeness Score Calculation scheduled job when evaluating the recommended health metric.</td>
</tr>
<tr>
<td>Remove Identifier Fields In Recommended Rules</td>
<td>Identifies any recommended field that is a criterion attribute in any active identifier entry in any active identification rule. Then removes the recommended setting for that field.</td>
</tr>
</tbody>
</table>
# Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB Health Metric [cmdb_health_metric]</td>
<td>Details such as if a KPI or metric is enabled, maximum failure threshold, and other settings for all CMDB Health KPIs and metrics.</td>
</tr>
<tr>
<td>CMDB Health Result [cmdb_health_result]</td>
<td>Results from the most recent CMDB Health processing cycle.</td>
</tr>
<tr>
<td>CMDB Health Scorecard [cmdb_health_scorecard]</td>
<td>Current and historic health scores. Status of historic score records is 'Historic', and of latest score records is 'Complete'.</td>
</tr>
<tr>
<td>CMDB Health Orphan Rule [cmdb_health_orphan_rule]</td>
<td>Rules for calculating orphan records per class.</td>
</tr>
<tr>
<td>CMDB Recommended Fields [cmdb_recommended_fields]</td>
<td>Recommended fields per class.</td>
</tr>
<tr>
<td>CMDB Health Metric Status [cmdb_health_metric_status]</td>
<td>Internal table that tracks the status of each KPI and metric that is being processed. Includes status, processing time, and processing start date. State for a KPI or metric changes from 'In Progress' to either of:</td>
</tr>
<tr>
<td></td>
<td>• Complete</td>
</tr>
<tr>
<td></td>
<td>• MaxFailures</td>
</tr>
<tr>
<td></td>
<td>• Daily Processing Time Out</td>
</tr>
<tr>
<td></td>
<td>Processing of a timed out KPI or metric continues on the following day.</td>
</tr>
<tr>
<td>CMDB Health Processor Status [cmdb_health_processor_status]</td>
<td>Internal table that tracks the processing progress of each KPI and metric. Contains a list of tables that are processed for each KPI and metric, and processing status. Classes are processed sequentially, changing status from Draft -&gt; In Progress -&gt; Complete.</td>
</tr>
<tr>
<td>CMDB Relationship All Rules Health Results</td>
<td>Stores results about relationship health, to be used by the All Relationships report.</td>
</tr>
</tbody>
</table>
CMDB Health process tracking
Use the following information to track and resolve issues with the CMDB Health processes.

Logging
By default, only error messages are logged to the syslog table, with the source name CmdbHealth. To enable logging of 'info' and 'warning' messages (which are typically logged at the start and end of each processing cycle), update the system property glide.cmdb.logger.use_syslog.CMDBHealth. For information about using this property, see CMDB Health system properties.

Processing status
If scheduled jobs are enabled, but data is not displaying on the CMDB dashboard, you can check the processing status in the CMDB Health Metric Status [cmdb_health_metric_status] table. Depending on the status of the inactive metric, decide how to proceed.
Initially, the state of all metrics is 'In Progress'.
Possible final states of a metric:

  **Complete**
  All classes are processed and the number of failures is under the maximum failures threshold.

  **Max Failures**
  The number of failures for this metric reached the maximum failures threshold. Processing has been aborted and will start over in the next run.

  **Daily Time Out Pause**
  The processor reached the processing time limit. Processing is paused and will resume in the next run.

At the end of a processing cycle, the final state of a KPI depends on the final state of its associated metrics. Possible final state of a KPI:

  **Complete**
  All associated metrics are in Complete state and score calculation is complete.

  **Incomplete**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[cmdb_health_result_rel_all]</td>
<td></td>
</tr>
</tbody>
</table>
Score is not calculated because one of the associated metrics reached its maximum failure thresholds.

**Daily Time Out Pause**

Timed out because one of the associated metrics has reached its processing time limit.

**Processing time**

If processing of a metric times out, you can find out which class takes too long to process. Use this information to find out if any validation rules are weak.

The progress of each metric is tracked in the CMDB Health Processor Status table [cmdb_health_processor_status]. Status for classes that have been processed for a metric is **Complete**, and for classes that are yet to be processed is **Draft**. By looking at the update time for each class, you can calculate the length of processing time for each class.

**Orphan records due to broken hierarchy**

Orphan rules might detect an orphan CI, which you are not able to access and delete. Or, there might be a mismatch between the list view that displays the orphan records, and the total number of records. These findings are due to records being deleted in the database from only one table in the CMDB hierarchy.

These CI records are not accessible via GlideRecord and must be deleted directly from the database. Therefore, in this case, to delete an orphan CI from the database you must get help from Customer Service and Support.

Orphan test results provide the details of where exactly the hierarchy is broken. For example, the message "This cmdb_ci_linux_server CI [91054fc24f22520053d6e1d18110c713] is missing record in cmdb_ci_computer table" means that a record of that sys_id must be deleted from the CMDB, cmdb_ci, cmdb_ci_hardware, cmdb_ci_server, and the cmdb_ci_linux_server tables (the Computer class is between the Hardware and the Server classes in the hierarchy.)

**Scripted audits Skipped**

An error message is logged if the results from a scripted audit are not included in the compliance KPI. The reason can be that the script in the audit was not updated to populate its **Last ran date** field. Without a **Last ran date** value, CMDB Health is unable to identify these run results as part of a recent complete audit run, and skips those results.
CMDB Health process status: failure threshold reached

The CMDB dashboard displays the string ‘failure threshold reached’ when the number of CIs that are failing the metric tests, reaches the failure threshold set for the metric.

CMDB Health stops processing for this metric in the current cycle, and therefore there is no aggregated health score for the metric. Processing will be attempted again in the next cycle. Also, status in the CMDB Health Metric Status [cmdb_health_metric_status] table is set to Max Failures for this metric.

When the health score of a metric cannot be evaluated, then the processing status of the respective KPI (for example, correctness) is set to Incomplete. The CMDB dashboard displays the string Incomplete score for the respective KPI and for the CMDB Health overall score. Also, aggregated health scores for the metric are not available for any class in the CMDB hierarchy.

Review and adjust the following definitions as needed:

- Review and refine the rules defined for the metric which has reached max failures. If a rule associated with the metric is too generic, resulting in large number of failures, attempt to refine it. For Example:
  - Completeness – Review the recommended fields that are causing failures and remove the ones that are not critical for the health score. For more information see Set a CI field to be recommended.
  - Correctness – For the staleness metric, depending on the cause of the failures it might be helpful to increase the value of the glide.cmdb.health.staleness CMDB Health system property.

- Reduce the number of failures by fixing CI records: If after adjusting the metric test rules the max failures for some metrics is still reached, then address the failures by updating CI records with the relevant missing information.

- Increase the failure threshold for the metric that is failing and check if processing for this metric completes successfully in the next cycle. Increasing the failure threshold beyond 500K might reduce overall performance.

CMDB Health process status: incomplete score

The CMDB dashboard displays the string 'incomplete score' for a metric when it fails to calculate the score for the metric.

'incomplete score' is displayed when:

- The number of CIs that are failing the tests of one of its sub-metric, reaches the failure threshold set for the metric. In this situation, the processing status for the respective parent metric (for example, correctness) is set to 'incomplete' in the CMDB Health Metric Status [cmdb_health_metric_status] table. Processing for the failing metric in the current cycle stops, and therefore there are no
aggregated health scores for the sub-metric, the parent parent metric, or the overall CMDB Health.

To remediate, you need to resolve the underlying cause of CIs failing the sub-metric tests. See CMDB Health process status: failure threshold reached for more information about resolving the failures of the sub-metric.

• An error is encountered while processing the sub-metric.

To remediate, examine the system logs system logs to determine the cause of the error. After fixing the cause of the problem, restart processing by manually executing the respective parent metric dashboard job.

Duplicate CIs

When the instance encounters duplicate CIs during identification and reconciliation, it groups each set of duplicate CIs into a de-duplication task for review and remediation.

De-Duplication tasks

De-duplication tasks provide details about the duplication, including a list of all the duplicate CIs. Review the details of each duplicate CI in the task and the data that was used to determine that the CI is a duplicate.

From a de-duplication task, you can run the Duplicate CI Remediator wizard to reconcile a set of duplicate CIs into a single CI, eliminating the duplication.

Duplicate CI Remediator

The Duplicate CI Remediator is a wizard-like tool that you can use to reconcile a set of duplicate CIs associated with a de-duplication task. You can choose one of the duplicate CIs to retain as an active CI, and then decide how to process the rest of the duplicate CIs. The Duplicate CI Remediator lets you set reconciliation options for attributes, relationships, and related items.

For information about using the Duplicate CI Remediator, see Remediate a de-duplication task.

Properties that affect processing of duplicate CIs

During CMDB Identification, processing of sets of duplicate CIs is determined by:

• Property glide.identification_engine.skip_duplicates (true by default).
• Property glide.identification_engine.skip_duplicates.threshold (5 by default).
• Number of duplicate CIs in a set.

For information about how these properties affect the management of duplicate CIs, see Detecting duplicate CIs.
Master CI

The master CI plays an important role in the remediation of duplicate CIs. The master CI is a single CI from a set of duplicate CIs, that remains active while the rest of the duplicate CIs in the set are potentially retired, deleted, or reconciled into the master CI. Using the Duplicate CI Remediator, you can select a master CI for a set of duplicate CIs associated with a de-duplication task.

The `duplicate_of` attribute in duplicate CIs, is used to store a reference to the master CI. For duplicate CIs which existed in an instance that was upgraded to the New York release or later, the master CI is unknown. After upgrade, `duplicate_of` for those duplicate CIs is set to 'Unknown', indicating that the CI is a duplicate but the master CI is unknown.

Duplicate CIs set

Before remediation, the CIs in a duplicate CIs set are all duplicates of each other. After remediation, a set of duplicate CIs consists of one master CI, and any number of CIs, each considered a duplicate of the master CI. The `duplicate_of` attribute of the master CI is empty. The `duplicate_of` attribute for all the rest of the duplicate CIs in the set, is a reference to the master CI of the set.

If you attempt to modify the value of `duplicate_of` directly on a CI form or by using a script, the following restrictions are enforced to ensure data integrity:

- A CI cannot be its own master CI (you cannot set a CI as a duplicate of itself).
- A CI and its master CI cannot be from different domains.
- The `duplicate_of` attribute of the master CI cannot reference any CI as its master CI (you cannot set a CI as a duplicate of another duplicate CI to create a chain of duplicate CIs).

If you attempt to set a CI as a duplicate of another duplicate CI, then the CI is set as a duplicate of the master CI of the duplicate CI you are trying to set. If the master CI of the duplicate CI you are trying to set is 'Unknown', the operation fails.

Example: Attempt to set a CI as duplicate of another duplicate CI

<table>
<thead>
<tr>
<th>CIs</th>
<th>Attempted setting</th>
<th>Result (System enforced)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI1: <code>duplicate_of</code> = empty</td>
<td>CI1: <code>duplicate_of = CI2</code></td>
<td>CI1: <code>duplicate_of = CI3</code></td>
</tr>
<tr>
<td>CI2: <code>duplicate_of</code> = CI3</td>
<td></td>
<td>CI2: <code>duplicate_of = CI3</code></td>
</tr>
<tr>
<td>CI3: Master CI</td>
<td></td>
<td>CI3: Master CI</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
If CI2 is a duplicate of 'Unknown', the operation fails.

- If a master CI becomes a duplicate of another CI, then it can no longer be a master CI. All CIs that were duplicates of that master CI are set as duplicates of the new master CI.

**Example: Attempt to set a master CI as duplicate of another CI**

<table>
<thead>
<tr>
<th>CIs</th>
<th>Attempted setting</th>
<th>Result (System enforced)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI1: duplicate_of = CI4</td>
<td>CI4: duplicate_of = CI5</td>
<td>CI1: duplicate_of = CI5</td>
</tr>
<tr>
<td>CI2: duplicate_of = CI4</td>
<td></td>
<td>CI2: duplicate_of = CI5</td>
</tr>
<tr>
<td>CI3: duplicate_of = CI4</td>
<td></td>
<td>CI3: duplicate_of = CI5</td>
</tr>
<tr>
<td>CI4: Master CI</td>
<td></td>
<td>CI4: duplicate_of = CI5</td>
</tr>
<tr>
<td>CI5: duplicate_of = empty</td>
<td></td>
<td>CI5: Master CI</td>
</tr>
</tbody>
</table>

- If a master CI becomes a duplicate of a CI within the same duplicate CI set, then the selected duplicate becomes the master CI in the duplicate CI set. The rest of the duplicate CIs in the set are set as duplicates of the new master CI.

**Example: Attempt to set a master CI as duplicate of a CI within the duplicate CIs set**

<table>
<thead>
<tr>
<th>CIs</th>
<th>Attempted setting</th>
<th>Result (System enforced)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI1: duplicate_of = CI4</td>
<td>CI4: duplicate_of = CI1</td>
<td>CI1: Master CI</td>
</tr>
<tr>
<td>CI2: duplicate_of = CI4</td>
<td></td>
<td>CI2: duplicate_of = CI1</td>
</tr>
<tr>
<td>CI3: duplicate_of = CI4</td>
<td></td>
<td>CI3: duplicate_of = CI1</td>
</tr>
<tr>
<td>CI4: Master CI</td>
<td></td>
<td>CI4: duplicate_of = CI1</td>
</tr>
</tbody>
</table>

- You cannot delete a CI that is the master CI of duplicate CIs. To delete a master CI, you must first disassociate that master CI with all of its duplicate CIs. Either delete all duplicate CIs that are associated with that master CI, or remove the reference to that master CI from all `duplicate_of` attributes in any duplicate CIs that have it.

**Review de-duplication tasks**

Review details of de-duplication tasks, and then potentially remediate a de-duplication task.
About this task
Role required: itil to view and itil_admin to remediate a de-duplication task.

If a duplicate CI is a dependent CI, then you can view the details of the dependent relationship, the Depend on CI, and any relation qualifier chain. If the dependent CI has a lookup table, then you can see the details of the respective lookup table.

Procedure
1. Navigate to Configuration > Identification/Reconciliation > De-duplication Tasks.
2. Select a task.

Remediate Duplicate Task form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique task number.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Person who is responsible for resolving the task.</td>
</tr>
<tr>
<td>Short description</td>
<td>Description for the task.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Details describing how the CI was identified as a duplicate.</td>
</tr>
<tr>
<td></td>
<td>☀ Note: Not available in de-duplication tasks that were created prior to the London release. The field also contains user notes about the decisions and steps of resolving the task.</td>
</tr>
<tr>
<td>Priority</td>
<td>Task priority.</td>
</tr>
<tr>
<td>State</td>
<td>State of the de-duplication task as it progresses through resolution.</td>
</tr>
</tbody>
</table>

3. In the related lists section, click the Duplicate Audit Results tab to see the list of duplicate CIs in this task. You can click a CI to display more CI details.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate CI</td>
<td>Reference to the duplicate CI.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field is a document ID type, which means that it can reference any record on any table. If the referenced CI is deleted as part of resolving duplicate tasks, then this field is empty.</td>
</tr>
<tr>
<td>Relationship</td>
<td>For a duplicate CI that is a dependent CI, this field shows the relationship between the duplicate CI and depend on CI.</td>
</tr>
<tr>
<td>Depend on CI</td>
<td>If the duplicate CI is a dependent CI, then this field displays the depend on CI.</td>
</tr>
<tr>
<td>Discovery source</td>
<td>Discovery method used for the CI.</td>
</tr>
</tbody>
</table>

**What to do next**
Analyze de-duplication tasks to determine which CIs should remain active and which of the duplicate CIs in the Duplicate Audit Results lists are stale or incorrect. Click **Remediate** to remediate a de-duplication task (requires the itil_admin role).

**Related information**
- Relation qualifier
- Document ID field

**Manually create a de-duplication task**
Manually create a de-duplication task when it cannot be automatically created. You can then use the Duplication CI Remediator to remediate the manually created task.

In some situations, duplicate CIs are not automatically detected and de-duplication tasks are not automatically generated. Such situation happens with a class for which identification rules are not defined and the identification engine cannot be applied. However, you still want to reconcile these duplicate CIs by utilizing the Duplicate CI Remediator.

Use the **CMDBDuplicateTaskUtils** API to manually create a de-duplication task in which all duplicate CIs are specified. The de-duplication tasks that you create manually and the automatically created tasks, are stored in the same table ([reconcile_duplicate_task]) and are processed in the same manner.

**Note:** You can manually create a de-duplication task only for CMDB CIs and a CI can be specified as a duplicate CI only in a single de-duplication task.
Remediate a de-duplication task

Remediate a de-duplication task by using the Duplicate CI Remediator wizard. Use the wizard to guide you through the duplicate CI reconciliation process or to apply a custom workflow.

Before you begin

Important concepts associated with the Duplicate CI Remediator:

**Master CI**

The master CI is one of the duplicate CIs that you want to retain as an active CI while potentially retiring or deleting the rest of the duplicate CIs. The first step in the Duplicate CI Remediator is to select a master CI for the remediation process. The Duplicate CI Remediator lets you choose which attribute values, relationships, and related items from the duplicate CIs to reconcile into the master CI. Alternatively, you can choose not to consolidate any data and retain the master CI as it is.

**Default related items list**

A list of related items that is used globally in the Duplicate CI Remediator for all de-duplication tasks. All items from the default related items list are selected by default to be merged to the master CI, on the **Merge Relationships and Related Items** tab. Adding or removing items from that slushbucket does not affect the default related items list. See **Manage default related items list** for more information.

ℹ️ **Note:** Asset related tables are not included in the default related items list and therefore they are not available for merge.

Review **Properties for duplicate CIs** for information about important properties that affect how the Duplicate CI Remediator operates. Including the glide.duplicate_ci_remediator.dry_run property that determines if the Duplicate CI Remediator actually updates the CMDB or not.

Role required: itil user to read and itil_admin to write

**About this task**

As you progress through the tabs of the Duplicate CI Remediator, CIs are not updated. All updates are applied only in the final step, after you click **Remediate**.
Note:

• Merging of attributes and related items that are associated with assets is not supported in the Duplicate CI Remediator.

• The Duplicate CI Remediator behaves differently in remediations that involve a large number of duplicate CIs or where the duplicates are serial numbers. For information about those special cases, see the 'Special remediation scenarios' section at the bottom.

Procedure

1. Navigate to Configuration > Identification/Reconciliation > De-duplication Tasks.

2. Open the de-duplication task that you want to remediate. On the task form, click Remediate.

3. In the RemEDIATE dialog box, select either of the following options:

• **Use the Duplicate CI Remediator (Recommended):** Use the wizard to consolidate duplicate CIs according to your configurations and settings. Follow the Duplicate CI Remediator tabs to configure the reconciliation.

• **Use a custom remediation workflow:** Use an existing CMDB remediation rule or select Add New to create a new one.
  
  ◦ On the CMDB Remediation Rule form, set Task type to Remediate Duplicate Task and select Active.
  
  ◦ On the Workflow form, set Table to Remediate Duplicate Task [reconcile_duplicate_task] and If condition matches to None.
  
  ◦ Ensure that the associated workflow remediates duplicate CIs. In the Remediate dialog box, click Next to start the workflow and to exit the Duplicate CI Remediator. The RemEDIATE Duplicate Task form appears, where you can update the State of the task.

4. On the Select Master CI tab in the Duplicate CI Remediator:

   a. Select the master CI for this reconciliation using either of the following lists of duplicate CIs. For any CI, you can click the Name link to display the CI’s attributes, or click the Related Items link to display the number of related items.

   • **Recommended:** A subset of the All list, containing only system recommended master CIs. System recommendations are based on checking the duplicate CIs for the following criteria:
     
     ◦ CI with most related items.
     
     ◦ CI with most relationships.
- Newest discovered CI.
- Newest updated CI.
- Oldest created CI.
- Previous master CI, if one was previously selected.

- **All**: All duplicate CIs for the de-duplication task.

Either option lets you review a summary of the remediation settings before starting the remediation.

**b.** Select one of the following options to choose whether to consolidate any attribute values, relationships, or related items from any of the duplicate CIs into the master CI:

- **Remediate Manually**: Lets you specify which attribute values, relationships, and related items from duplicate CIs to consolidate into the master CI.
- **Use Master CI**: Retains master CI attribute values, merges relationships, and merges only the default related items.

Skip to step number 7 as this selection skips all configurations other than choosing the action for the duplicate CIs on the **Determine Duplicate CI Actions** page.

**5.** On the **Merge Attribute Values** tab review inconsistent values of each attribute. For each attribute, choose to retain the master CI’s value, or choose a value from a duplicate CI for the master CI to be set with. Then click **Next**.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute</td>
<td>Attribute for which there are different values.</td>
</tr>
<tr>
<td>Master CI Value</td>
<td>Attribute value in the master CI.</td>
</tr>
<tr>
<td>Other Values</td>
<td>The number of unique Attribute values within the duplicate CIs.</td>
</tr>
</tbody>
</table>

To override the master CI attribute value with a duplicate CI value:

**a.** Click the **Other Values** link.

**b.** In the attribute dialog box, click **Unique Values** to display only unique attribute values, or **All** to display all attribute values including identical values.
c. Select a value for the master CI **Attribute** to be set with. You can click **Reset to Original** to undo the selection of a different attribute value for the master CI.

d. Click **Select**.

**Note:** Attributes, such as system fields, discovery fields (**discovery_source**, **last_discovered**, **first_discovered**), and read-only fields (such as the asset field) do not appear in the list.

6. On the **Merge Relationships and Related Items** tab:

a. In the Merge Relationships section, select whether to merge all relationships from all duplicate CIs into the master CI. Click **View all relationships** to display all the relationships in which a duplicate CI is a parent or a child. You can click a **Parent** or a **Child** link to display more details. Orphan and duplicate relationships of duplicate CIs are deleted if you choose to merge relationships. For more information about the CMDB Health relationship KPI, see CMDB Health KPIs and metrics.

b. In the Merge Related Items section use the slushbucket to select related items to be merged into the master CI. Click **View all related items** to display all related tables (items) and the count of references in each table to one of the duplicate CIs. You can click the links in **Master CI Related Items** and **Duplicate CIs Related Items** to display details about the related items.

Related items in the slushbucket have the following format:

- **Related table label**
- **Related table name**
- **Reference field in related table**

Change Request [change_request] -> Configuration item (2)

Count of records in related table where the reference field points to one of the duplicate CIs
• By default, all items in the default related items list are selected to be merged.

• Related items (tables) that have no references to a duplicate CI are not listed, unless that table is included in the default related items list.

• Since asset related tables are part of the exclusion list, they are not available for merge.

See Manage default related items list for more information about configuring a default list of related items.

c. Click Next.

7. On the Determine Duplicate CI Actions tab, choose one of the following actions to perform after completing the reconciliation. Then click Next.

• Set attributes to custom values (recommended): Retain all duplicate CIs. Mark the duplicate CIs as invalid by setting a specific Attribute to a specific Value for all duplicate CIs. For example, set Operational Status to Retired to retire the duplicate CIs. The duplicate_of attribute of the duplicate CIs is automatically set to the appropriate master CI. Also, the duplicate CIs will not be added to any de-duplication task after this task is remediated. If the identification engine is not configured to skip duplication, ensure that identification inclusion rules are configured to exclude the duplicate CIs during identification. This configuration prevents new de-duplication tasks with the same duplicate CIs from being created after remediation.

   Note: Discovery fields, system fields, read only fields, and date fields are excluded from the attributes list.

• Delete: Delete all duplicate CIs (only the master CI remains).

   Note: Review Roll back and delete recovery for information about reverting the deletion of CIs and related records.

8. On the Review and Confirm tab:

   a. Review the summary of the expected updates for this duplicate CIs reconciliation. Updates are based on your selections and therefore the summary includes only the details that are applicable. This summary can include details of the relationships and related items that will be merged to the master CI, the attribute values that the master CI will be set with, and the number of CIs that will be deleted. Click Attributes, Relationships, Related Items, or Duplicate CI Actions if applicable, to display further details such as changes to attribute values.
b. Click **Remediate** to complete the reconciliation according to your reconciliation settings. Once complete, the task **State** is set to **Closed Complete**.

**Results**

The following relationships are deleted without being merged to the master CI:
- Relationships in which the type, child, or parent field is empty.
- Relationships for which merging to the master CI will result in cyclic relationships.
- Relationship for which merging to the master CI will result in duplicate relationships.

**What to do next**

The reconciliation process runs in the background and may take a while to complete. Upon completion, the system sends a confirmation notice to the remediator of the task. Meanwhile, you can:

- **Review Identification Rules**: Review identification and inclusion rules and make any necessary updates to reduce CI duplication.
- **Check Progress**: View the task activities that are logged as the remediation progresses.
- **View Master CI**: View the master CI for this reconciliation process.

**Special remediation scenarios**

There are a few special remediation scenarios in which the Duplicate CI Remediator behaves differently.

**Large number of duplicate CIs**

Support for reconciliation of duplicate CIs in the Duplicate CI Remediator is limited when the number of duplicate CIs exceeds a certain threshold. This threshold is based on the value of the `glide.duplicate_ci_remediator.max.cis` property, which is 1,000 by default. You can update this property to increase the threshold. However, this threshold never exceeds 5,000, even if you set the property to a value greater than 5,000.

When the number of duplicate CIs for a de-duplication task exceeds the threshold, the options available in the wizard are limited:
• On the Select Master CI tab, only the **Recommended** list of master CIs appears, and only the **Use Master CI** option is available.

• Recommendations are based only on the oldest created, newest updated, and most recently discovered CIs.

• Reconciliation of attribute conflicts and CI relationships is not supported, and only default related items are reconciled.

**Duplicate serial numbers:**
The Duplicate CI Remediator is usually applied to duplicate CMDB CIs. However, in some situations de-duplication tasks might be created for duplicate serial numbers. When the Duplicate CI Remediator processes duplicate serial numbers, the merge of relationships from duplicate records, is not referenced and is not applied.

**Manage default related items list**
You can add or remove items from the default list of related items which is used globally in the Duplicate CI Remediator for all de-duplication tasks.

**Before you begin**
Role required: itil_admin

**About this task**
The default related items list appears on the **Merge Relationships and Related Items** tab in the Duplicate CI Remediator. Globally modifying the list affects all de-duplication tasks being remediated by the Duplicate CI Remediator.

Alternatively, you can modify the list for only a specific task in the Duplicate CI Remediator without affecting the default global list.

**Note:** Only related items in which the reference field points to Configuration Item [cmdb_ci] in **sys_dictionary** can be selected for the default related items list. Related items with references to any child of the Configuration Item class cannot be selected for the default related items list, but are still available for merging in the Duplicate CI Remediator for a specific task.
Procedure

1. Navigate to **Configuration > Identification/Reconciliation > Duplicate CI Remediator Default Related Items**.

2. On the Default Related Items List for Duplicate CI Remediator page, use the slushbucket to add or remove items from the **Selected** list.

3. Click **Save**.

Properties for duplicate CIs

Use the properties for duplicate CIs to configure how duplicate CIs are processed.

These properties are available for duplicate CIs. To view and edit these properties, the admin role is required.

### Properties for duplicate CIs

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Attributes in which `max_length` exceeds this property value (4000 by default) are excluded from the **Select Master CI, Merge Attribute Values, and Determine Duplicate CI Actions** tabs in the Duplicate CI Remediator wizard. glide.duplicate_ci_remediator.max.field_length | If the `max_length` for an attribute is equal to the property value and the size of the data exceeds the property value, then the data is truncated to the property value and the attribute appears in attribute lists.  
• Type: integer  
• Default value: 4000  
• Location: **Configuration > CMDB Properties > Duplicate CI Remediator Properties**  
  
  Note: This property impacts the performance of de-duplication tasks, therefore be cautious about setting this value. |
| Comma separated list of related tables in the format `<table>.<reference column>`, that are excluded from merging during duplicate CI remediation. glide.duplicate_ci_remediator.related_items_blacklist |  
• Type: string  
• Default value: `cert_task.cmdb_ci,cert_audit_result.configuration_item,discovery_log.cmdb_ci,alm_hardware.ci,alm_asset.ci,fm_expense_line.cmdb_ci`  
• Location: **Configuration > CMDB Properties > Duplicate CI Remediator Properties**  
| Threshold for the number of duplicate CIs, which if exceeded, support for reconciliation in the Duplicate CI Remediator is limited (1,000 by default). glide.duplicate_ci_remediator.max.cis |  
• Type: integer  
• Default value: 1000  
• Location: **Configuration > CMDB Properties > Duplicate CI Remediator Properties**  
  
  Learn more: See 'Large number of duplicate CIs' in Remediate a de-duplication task.  
This threshold never exceeds 5,000, even if you set the property to a value greater than 5,000. |
Properties for duplicate CIs (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.duplicate_ci_remediator.dry_run</td>
<td>Determines whether the Duplicate CI Remediator actually remediates CI duplication by updating records in the CMDB, or not. When set to false (default value), updates specified in the wizard are actually performed. You can set this property to true and then test run through the Duplicate CI Remediator without any records actually being updated. In this case, the work notes for the task describe the changes that will happen in an actual remediation.</td>
</tr>
</tbody>
</table>

• Type: true | false
• Default value: false
• Location: Configuration > CMDB Properties

Components installed for duplicate CI remediation

Tables installed to support duplicate CI remediation (included in the com.snc.cmdb plugin).

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RemEDIATE Duplicate Task [reconcile_duplicate_task]</td>
<td>De-duplication tasks.</td>
</tr>
<tr>
<td>Duplicate Audit Result [duplicate_audit_result]</td>
<td>CIs associated with each de-duplication task.</td>
</tr>
<tr>
<td>Duplicate CI Remediation [cmdb_duplicate_ci_remediation]</td>
<td>Input, selections on each tab, overall status of remediation, and results of each run of the Duplicate CI Remediator.</td>
</tr>
</tbody>
</table>

CI Class Manager

Use the CI Class Manager to centrally view, create, or edit basic class definitions, and class settings for identification, reconciliation, and CMDB Health. To access the CI Class Manager, navigate to Configuration > CI Class Manager.
<table>
<thead>
<tr>
<th>Create a class</th>
<th>CMDB Health orphan rule</th>
<th>Identification:</th>
</tr>
</thead>
<tbody>
<tr>
<td>View class basic information</td>
<td>CMDB Health staleness rules</td>
<td>◦ CI identification rules</td>
</tr>
<tr>
<td>Class columns</td>
<td>Set a CI field to be recommended</td>
<td>◦ Identification inclusion</td>
</tr>
<tr>
<td>Add a suggested relationship</td>
<td>Set a CI attribute to be mandatory</td>
<td>rules</td>
</tr>
<tr>
<td>Display all CIs for a class</td>
<td>CMDB health scorecard thresholds</td>
<td>◦ Reconciliation:</td>
</tr>
<tr>
<td>Dependency Views map icons for</td>
<td></td>
<td>◦ CI reconciliation rules</td>
</tr>
<tr>
<td>a class</td>
<td></td>
<td>◦ Data refresh rules</td>
</tr>
<tr>
<td>Delete CIs for a CMDB class</td>
<td></td>
<td>◦ Dependencies:</td>
</tr>
<tr>
<td>Update the list of classes in</td>
<td></td>
<td>◦ Dependent relationship</td>
</tr>
<tr>
<td>the Principal Class filter</td>
<td></td>
<td>rules (hosting and contain-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ment)</td>
</tr>
</tbody>
</table>

**Service Mapping**

- Entry point types for Service Mapping
- CI types for Service Mapping and Discovery

**Agent Workspace for Configuration Management Database (CMDB)**

Agent Workspace for CMDB provides an easy-to-navigate interface that helps service agents access essential CMDB configuration items and drill down to related items such as changes, incidents, and timeline.

Agent Workspace for CMDB provides:

- Key health scores for CIs
- Level 1 CI relationships
- Condensed timeline view of incidents, changes, and change requests for a CI, for the past 7, 14 (default), or 30 days
- Critical incidents and change requests for CIs
- Key attributes related to CIs.
- Ability to create incidents and change requests for CIs, and to delete a CI
Plugins
The CMDB Agent Workspace plugin (com.cmdb-workspace) is activated by default in a base system. The CMDB Workspace plugin adds the following to Agent Workspace:

- CMDB list category and associated filtered lists
- Configured CMDB Workspace forms for many common CMDB classes
- CMDB-specific widgets: CMDB Health, CMDB Relationships, and CMDB Timeline

Roles
To access Agent Workspace for CMDB, the workspace_agent and itil roles are required.

CMDB Workspace form view in Agent Workspace
Service agents see forms in the CMDB Workspace form view for the CMDB classes that this view is configured for:

The CMDB Workspace form view for CMDB classes contains the following components:

- **Widgets**
• **CI Health:**
  Shows Critical Incidents, Change Requests, and the following CMDB Health scores: incomplete attributes, non-compliant relationships, stale relationships. Lets you open the CI Dashboard.

• **Level 1 Relationships:**
  Shows level 1 relationships. Lets you open the Dependency Views map.

• **CI Timeline:**
  Shows record changes, change requests, and incidents on a timeline. The timeline is for the past 14 days, condensing details that might be relevant to a current issue.

**Actions**

The **more** icon in the upper right corner lets you create a change, create an incident, or delete the CI.

**Related lists**

The CMDB Workspace form includes CIs’ related lists such as Change Requests, Incidents, Tasks, or other related lists that apply to the class.

**Derivation of the CMDB Workspace form**

The CMDB Workspace form is derived throughout the hierarchy as follows:

- CMDB Workspace form definitions are not derived by child classes in the CMDB hierarchy.
- In a base instance, the ribbon of the CMDB Workspace form is defined for the top level Configuration Item class and is derived throughout the hierarchy.
- The form header of the CMDB Workspace form view is derived by child classes. However, in a base instance, the CMDB Workspace form header is specified per class for the classes that a CMDB Workspace is configured for.

**Default CMDB filtered lists**

Agent Workspace for CMDB includes by default several filtered lists such as Applications, Databases, Infrastructure Gear, Servers, and PC. Those filtered lists are not always aligned with the CMDB hierarchy. Instead, they represent user-friendly groupings of several categories of CMDB classes. The columns that appear for each class, are the default columns for the class as specified in the platform.

To see the list of classes that are included in a CMDB list category:
1. Navigate to **Workspace Experience > Workspace > Agent Workspace Home**.

2. In Agent Workspace, click the **User Menu** icon in the upper right corner and select **Configure Workspace**.

3. Select the **Workspace List Categories** tab under **Related Links**, and then select the **CMDB** list category.

4. Select a filtered list such as **Applications**, to open the Workspace List form for the selected filtered list.

For information about configuring filtered lists in Agent Workspace, see [Set up filtered lists in Workspace](#).

**Default form view**

CMDB classes that do not have a CMDB Workspace form view configured for, appear with the default Agent Workspace form view which you can use for updating CIs. You can configure CMDB Workspace form views for any additional CMDB table that is commonly used in your organization, for which a CMDB Workspace form is not configured by default.

**Related information**

- Agent Workspace
- CMDB Health
- CI relationships in the CMDB
- CI Timeline
- Related lists

**Configure a CMDB Workspace view**

Configure a CMDB Workspace view for a CMDB table that is commonly used in your organization, for which a CMDB Workspace form is not configured by default.

**Before you begin**

Roles required vary by the element being configured in each step:

- Form headers: `workspace_admin`
- Form sections: `personalize_form`
- Related lists: `personalize_form`
- System property: `admin`
- Workspace view rules: `workspace_admin`
Procedure

1. Configure form header:

   See Set up form headers in Workspace for the steps to configure a form header. When configuring a form header, set the Table field on the configuration forms to the CMDB class that you are creating a CMDB Workspace form for.

   If not configured for the class, form headers are derived from parent classes.

2. Configure form sections:

   a. Open a CI form for the class that you are creating a CMDB Workspace form for.

   b. Right-click the CI form banner and select Configure > Form Layout in the menu.

   c. On the layout configuration form, create a new view named CMDB Workspace:

      i. Ensure that the default section, which is named as the class name, contains the class key attributes. Note the name of that section and then rename it to Key attributes.

         Navigate to System UI > Form Sections. In the Section Elements list view, locate that form section (which is associated with the CMDB Workspace view) and set its Caption value to Key attributes.

      ii. Add a new section named More attributes. Add the rest of the attributes to this section, and as the last item add Activities (filtered) to see activity stream on the form.

         For more information about configuring form layout, see Configure form layout.

3. Select the class attributes to appear in the activity stream on the form:

   a. Create a system property, using the ‘glide.ui.cmdb_ci_<class name>_activity.fields’ format for the property name.

   b. Set the property Type to string.

   c. Set the Value to the field names that you want to include in the activity stream on the form.

4. Add related lists to the form:
a. Right-click the CI form banner and select **Configure > Related Lists**.

b. On the Configuring related lists form, create a new view named **CMDB Workspace**.

c. Add the related lists you want to see on the form, such as **Change Request → Configuration Item**.
For more details, see *Add a related list to a form*.

5. **Configure a Workspace View Rule** to tie the respective class table to the CMDB Workspace view.

**View CI in Agent Workspace**

View various details for a CI using CMDB Workspace form view, in Agent Workspace. The CMDB Workspace form view provides details such as key health scores, a timeline view of incidents, changes, and change requests, and critical incidents, change requests, and attributes related to CIs.

**Before you begin**

CIs appear in a CMDB Workspace form view only if a CMDB Workspace form view is configured for the respective CMDB class. Otherwise, CIs appear in the default CMDB Workspace form view, which you can use for updating CIs.

Role required: agent_workspace_user and itil

**Procedure**

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. Click **Lists**, navigate to **CMDB** and then click a class such as **Servers**.
3. In the class list view, select a CI.

**What to do next**

- Click the **more** icon in the upper right area and select **Create Change**, **Create Incident**, or **Delete** to delete the CI.
- In the CI Health widget, click **CI Dashboard** to open the CI Dashboard.
- In the Level 1 Relationship widget, click **Dependency Map** to open the Dependency Views map for the CI.
- In the CI Timeline widget, click **Show Legend** and set what type of events appear on the timeline.

**View CMDB benchmarks**

CMDB calculates several CMDB Health benchmarks which then display in the Benchmarks dashboard. These benchmarks are based on various CMDB Health
metrics, displaying monthly averages, trends, comparisons to industry averages of your ServiceNow peers, and global benchmarks.

**Before you begin**
The CMDB Health Dashboard jobs must be enabled and health data must be collected. Also, navigate to **Benchmarks > Setup** and ensure that the CMDB KPIs are enabled under **IT Operations Management**.

**About this task**
CMDB provides the following benchmarks:

- % of non-compliant CIs
- % of duplicate CIs
- % of stale CIs

For an instance, each of these benchmarks is the calculated monthly average for the corresponding CMDB Health metric. Calculating a monthly average requires that there is a metric result value for each day of the month. Therefore, each day on which the respective Health Dashboard job did not run, is assumed with the aggregated result from the run that is most recent to that day. The monthly average is then calculated based on the sum of all the daily aggregated results for the metric in that month, divided by the number of days of the month. For a CMDB Health Dashboard job that ran multiple times in a single day, only the results of the last run in that day are used for the monthly average calculation.

 electrónico: The frequency of CMDB Health Dashboard job executions depend on whether the job is enabled, its schedule and on manual runs.

Global averages are based on the sum of monthly averages of all peer instances, divided by the number of instances (aside from instances for which the monthly average is 0).

**Procedure**
1. Navigate to **Benchmarks > Dashboard**.
2. Click the ✔ icon and select **IT Operations Management**.
3. Click **ALL** or **CMDB**.
4. Click on a CMDB benchmark to drill down to trend data, and other benchmark details.
Related information

CMDB Health
Benchmarks
Benchmarks dashboard

CMDB APIs (CMDB SDK)
Use CMDB APIs to create, update, and read operations on the CMDB. Domain separation is supported in CMDB APIs.

CMDB APIs (CMDB SDK)
Use the following CMDB APIs to create, update, and read operations on the CMDB:

• CMDBGroupAPI - Scoped
• CMDBTransformUtil - Global
• CMDBUtil - Global
• IdentificationEngineScriptableApi
• IdentificationEngine - Scoped

Domain separation in CMDB APIs
Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

CMDB APIs are used for accessing the CMDB from a script. CMDB stores the CI and relation information; CMDB is domain separated.

CMDB APIs support the following operations:

• Create a new CI
  ◦ This operation goes through the Identification and Reconciliation Engine which supports domain separation when creating a CI. The domain of the caller is used for this operation.

• Update an existing CI
  ◦ This operation goes through the Identification and Reconciliation Engine which supports domain separation when creating a CI. The domain of the caller is used for this operation.
• Create/Delete relations
  ◦ The cmdb_rel_ci table is not domain separated.

• Query CMDB CI/Query CMDB table
  ◦ Results are filtered by the domain(s) visible to the caller.

• Query CMDB metadata table
  ◦ Metadata information is not domain separated.

Setting up domain separation for CMDB APIs
If domain separation is enabled for CMDB, then it is also available for CMDB APIs.

Data separation
Data is stored and domain separated in CMDB. There is no additional work needed from the CMDB API perspective.

Configuring a domain-separated environment
The configuration is done at the CMDB level.

If a domain column is present for base system application tables
See the Domain separation in CMDB Health topic.

Tenant domains and application data
There is no application-specific data to manage with CMDB.

Related information
  Domain separation and Configuration Management Database (CMDB)

Quick start tests for Configuration Management Database (CMDB)
Validate that Configuration Management Database (CMDB) still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Configuration Management Database (CMDB) quick start tests require activating the Configuration Management (CMDB) plugin (com.snc.cmdb) and the CMDB - ATF Tests plugin (com.snc.cmdb.atf).
### CMDB BSM: Dependency Views test suite

*Test suite to check functionality of Dependency Views APIs.*

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB BSM: Dependency Views</td>
<td>Test functionality of Dependency Views APIs. These APIs retrieve Dependency Views map and associated map items such as context menu items, for a given CI sys_id and using itil user role.</td>
<td>New York</td>
</tr>
</tbody>
</table>

### CMDB HEALTH: CI Health Dashboard test suite

*Test suite to check whether CMDB CI Health Dashboard is functional at a basic level.*

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB HEALTH: Health Job Status</td>
<td>Checks whether any CMDB Health dashboard jobs, which were started 30 or more days ago, are still in progress.</td>
<td>New York</td>
</tr>
</tbody>
</table>
| CMDB HEALTH: CMDB Health Completeness/Recommended | Checks whether the CI dashboard is functional for the recommended metric (included in the CMDB Health completeness KPI). This test validates:  
• Creation of a health inclusion rule for the recommend metric.  
• Creation of a recommended field that satisfies the health inclusion rule.  | New York        |
**CMDB HEALTH: CI Health Dashboard test suite**

*Test suite to check whether CMDB CI Health Dashboard is functional at a basic level.*

(continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Validate that the health inclusion rule is correctly applied to a test record with missing data in the recommended field.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**CMDB IRE: Identification Reconciliation Engine test suite**

*Test suite to check Identification and Reconciliation Engine (IRE) functionality.*

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB IRE: IRE Validation</td>
<td>Validate CI identifiers and reconciliation definitions and check indexes for CI identifiers.</td>
<td>Madrid</td>
</tr>
<tr>
<td>CMDB IRE: Reconciliation Rule</td>
<td>Check operations on a reconciliation rule, in CI Class Manager, using itil and itil_admin roles. Operations include create, edit, and delete a reconciliation rule. Also, check for active and not active setting, and derived rules.</td>
<td>Paris</td>
</tr>
<tr>
<td>CMDB IRE: Identification Rule</td>
<td>Check operations on an identification rule, in CI Class Manager, using itil and itil_admin roles. Operations include create, edit, and delete an identification rule.</td>
<td>Paris</td>
</tr>
</tbody>
</table>
CMDB IRE: Identification Reconciliation Engine test suite
Test suite to check Identification and Reconciliation Engine (IRE) functionality.
(continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Also, check for active and not active setting, and derived rules.</td>
<td></td>
</tr>
</tbody>
</table>

CMDB QB: Query Builder test suite
Test suite to verify CMDB Query Builder functions such as create query, read query, and execute query using two related user roles - cmdb_query_builder and cmdb_query_builder_read.

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB QB: Query Builder - cmdb_query_builder Role</td>
<td>Verify that cmdb_query_builder user role can save queries, and access and run all saved queries, in CMDB Query Builder.</td>
<td>New York</td>
</tr>
<tr>
<td>CMDB QB: Query Builder - cmdb_query_builder_read Role</td>
<td>Verify that cmdb_query_builder_read user role can access and run all saved queries, and cannot save any query, in CMDB Query Builder.</td>
<td>New York</td>
</tr>
</tbody>
</table>

CMDB REL: Relationship Editor and Formatter test suite
Test suite to verify functionality of Relationship Editor and Relationship Formatter.

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB REL EDITOR:Relationship Editor</td>
<td>Check addition of relations to a CI and deletion of relations from a CI using itil user role.</td>
<td>New York</td>
</tr>
</tbody>
</table>
CMDB REL: Relationship Editor and Formatter test suite

*Test suite to verify functionality of Relationship Editor and Relationship Formatter.*

(continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB REL FORMATTER:Relationship Formatter</td>
<td>Check accuracy of CI information, relationship types, relationships, associated records such as change tickets, and settings such as CMDB views (relationship filters), displayed for a specific CI in relationship formatter using itil user role.</td>
<td>New York</td>
</tr>
</tbody>
</table>

CMDB Workspace: Agent Workspace test suite

*Test suite to verify functionality of CMDB Agent Workspace*

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB Workspace: Workspace Validation</td>
<td>Test adding, editing, and deleting of a list item, and editing of a filtered list, using itil and admin roles.</td>
<td>Paris</td>
</tr>
</tbody>
</table>

CMDB SDK: SDK REST API test suite

*Test suite to verify functionality of CMDB SDK Rest APIs.*

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB SDK: Query CMDB Metadata</td>
<td>Test querying CMDB metadata.</td>
<td>New York</td>
</tr>
<tr>
<td>CMDB SDK: Create a relation for a CI using REST APIs</td>
<td>Test creation of a relationship for a CI in the CMDB using the CMDB REST APIs.</td>
<td>New York</td>
</tr>
</tbody>
</table>
CMDB SDK: SDK REST API test suite

Test suite to verify functionality of CMDB SDK Rest APIs.

(continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB SDK: Delete a relation for a CI using REST APIs</td>
<td>Test deletion of a relationship for a CI using CMDB REST APIs.</td>
<td>New York</td>
</tr>
<tr>
<td>CMDB SDK: Create a CI using REST API</td>
<td>Test creation of a CI using CMDB REST APIs.</td>
<td>New York</td>
</tr>
<tr>
<td>CMDB SDK: Query CMDB using REST APIs</td>
<td>Test querying the CMDB using CMDB REST APIs.</td>
<td>New York</td>
</tr>
<tr>
<td>CMDB SDK: Update a CI using REST APIs</td>
<td>Test updating of a CI using CMDB REST APIs.</td>
<td>New York</td>
</tr>
<tr>
<td>CMDB SDK: Query for a CI using REST APIs</td>
<td>Test querying a CI using CMDB REST APIs.</td>
<td>New York</td>
</tr>
</tbody>
</table>

Related information

Quick start tests

Useful related lists in CI forms

By default, the forms that display manageable configuration items (CI) - computers, printers, network gear, uninterruptible power supplies (UPS), and power distribution units (PDU) - provide a number of related lists for the form.

The following related lists are common to all forms for manageable CIs:

- Network Adapters - Displays all the NICs installed on a CI.
- CI IPs - Displays all the IP addresses on this CI:
  - Computers (workstations, laptops using various Mac and Windows operating systems)
  - Windows servers
  - Linux servers
  - AIX servers
  - Solaris servers
  - Devices discovered through SNMP.
- DNS Names for CIs - Displays all the DNS names on a CI.
The IP version information appears in all IP address related lists and forms.

**Note:** Since all paths here click into the IP Address to DNS Names list that associates an IP address with a DNS name, this part of the common flow was not added to the tree structure.

**Discovery source**

A table called Source [sys_object_source] stores information identifying the source of a discovery (by ServiceNow Discovery or another product), the ID of that source, and the date/time of the last scan. To view this information, configure a CI form and add the Sources related list. This table is populated automatically when the Discovery plugin is enabled.

**Activate the Extended CMDB plugins**

The Configuration Management (CMDB) application provides core functionality for the configuration management database, including modules for hardware and configuration items. The separate Extended CMDB plugin includes a collection of modules for specialized configuration items, such as radio hardware, test equipment, and voice system hardware.

**Before you begin**

Role required: admin

**About this task**

The Configuration Management (CMDB) plugin is automatically active for all instances. You must activate related plugins to access the modules for specialized configuration items.

- CMDB Mainframe (com.snc.cmdb.mainframe)
- CMDB Radio Category (com.snc.cmdb.radio.category)
- CMDB Telecom Category (com.snc.cmdb.telecom.category)
- CMDB Test Equipment (com.snc.cmdb.test.equipment)

**Procedure**

1. Navigate to System Definition > Plugins.
2. Right-click the plugin name on the list and select Activate/Upgrade. If the plugin depends on other plugins, these plugins and their activation status are listed.
3. **Optional:** Select the Load demo data check box.
Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when first activating the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.

4. Click **Activate**.

**Enterprise CMDB**

The Enterprise Configuration Management Database (ECMDB) is targeted toward businesses that want to monitor, manage, measure, track, alert on change, and generally understand business systems that consist of a large number of components, business, and support personnel.

For example, a bond trading service may have multiple application, and web servers, several databases, Linux, UNIX, and Windows servers. There will be security products, network storage, disaster recovery procedures and hardware, etc. that are necessary for the service to operate properly.

The ECMDB makes it easy to either manually enter the relationships or have them populated automatically by discovery tools. In addition to the hardware, software, network, database, and storage areas, it is beneficial to know which individuals or groups are responsible for the service from both a business perspective as well as an IT perspective. Who are the line of business users and managers? Who starts and stops the application or its components? Who monitors the log files? Who is in charge of backup and restore, business continuity, and disaster recovery?

Enterprise CMDB is available with the Configuration Management (CMDB Enterprise Edition) (com.snc.cmdb.enterprise) plugin, which is active in the base system.

**CMDB Relationships**

The ECMDB lets you easily track all relationships by relationship type.

The Enterprise CMDB extends the capabilities of the ServiceNow platform CMDB in the following areas.

**Extended configuration item types**

- Clusters
- Database Instances (Oracle, MySQL, MSFT SQL Server)
- File Systems (Direct and network attached)
- Linux Servers
Extended relationships

Accurate description of relationships between items, and between items and people or groups, is important to understand the fabric of a business service. ECMDB provides many relationship types out of the box, but it is easy to extend the number of relationship types. Example relationship types include the following.

- Connects to
- Depends on / Provides Service to
- Powered by / Powers
- Protected by / Protects
- Disaster Recovery Provided by / Provides Disaster Recovery for

Visualization

The system can show relationships as a hierarchy using a standard treeview, flattened, or graphically, all in a simple web interface.

Auditing

Auditing of changes to configuration items is turned on by default.

Federation

Federation of third party discovery and configuration data is supported through standard synchronization offerings (SMS, LAN Desk, others) and through the CMDB Discovery [cmdb_discovery] table.

Configuration item modeling (product models)

Model driven configuration management allows the definition of CI models up front that can be associated to product maintenance lifecycles, cost centers, and support organizations, as well as provides a means for capacity and inventory planning. By defining models for CIs (which have a many to one relationship to the model), you can dynamically group actual discovered or imported CIs into logical, operational, and financial models. This facilitates an organized approach to managing your assets (CIs) in their respective domains.
Enterprise Configuration Management Database (ECMDB) action icons

Any of the following icons may appear in the ECMDB lists of related items.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗</td>
<td>For currently active incidents against this configuration item</td>
</tr>
<tr>
<td>🚨</td>
<td>For currently active problems against the configuration item</td>
</tr>
<tr>
<td>🔴</td>
<td>For currently active changes against the configuration item that are not covered in the past, current, pending changes. For example, a request to update the operating system on a server that is currently in progress may display this icon.</td>
</tr>
<tr>
<td>🔵</td>
<td>For changes that were recently completed against the configuration item. Changes with an &quot;Actual_end_date&quot; in the past.</td>
</tr>
<tr>
<td>🔴🔺</td>
<td>For changes that are planned soon against the configuration item. Changes with an &quot;Actual start date&quot; in the future.</td>
</tr>
<tr>
<td>🔴🔻</td>
<td>For currently active changes against the configuration item that have an &quot;Actual start date&quot;</td>
</tr>
<tr>
<td>🔵</td>
<td>For outages that were recently completed against the configuration item. Outages with an &quot;end&quot; date in the past.</td>
</tr>
<tr>
<td>🔵🔺</td>
<td>For outages that are planned soon against the configuration item. Outages with a &quot;begin&quot; date in the future.</td>
</tr>
<tr>
<td>🔵🔻</td>
<td>For currently active outages against the configuration item that have a &quot;begin&quot; date in the past and no &quot;end&quot; date</td>
</tr>
<tr>
<td>■</td>
<td>This will only show up in the Tree view and indicates that a configuration item that is downstream has at least one of the above issues against it.</td>
</tr>
</tbody>
</table>

The system looks 5 calendar days in the past and 7 calendar days in the future when looking at recent outages and changes.
Business service tables

In the CMDB, child tables of the Service table [cmdb_ci_service] store information about services, including application services.

An application service is work or goods that are supported by an IT infrastructure. For example, delivering email service to an employee can require services such as email servers, web servers, and the work to configure the user's account. An application service management map graphically displays the configuration items (CI) that support an application service and the relationships between the CIs.

The Service table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business criticality</td>
<td>The importance of this service to the business. This field can be used to determine disaster recovery strategies for this service. Default options are:</td>
</tr>
<tr>
<td></td>
<td>• 1 - most critical</td>
</tr>
<tr>
<td></td>
<td>• 2 - somewhat critical</td>
</tr>
<tr>
<td></td>
<td>• 3 - less critical</td>
</tr>
<tr>
<td></td>
<td>• 4 - not critical</td>
</tr>
<tr>
<td>Service classification</td>
<td>Designates the type of the service. For more information, see Application services</td>
</tr>
<tr>
<td></td>
<td>• Technical Service (For more information, see )</td>
</tr>
<tr>
<td></td>
<td>• Service Offering (For more information, see Service offerings)</td>
</tr>
<tr>
<td></td>
<td>• Shared Service (For more information, see )</td>
</tr>
<tr>
<td></td>
<td>• Billable Service (To represents a service that is billed, or that is cost managed)</td>
</tr>
<tr>
<td>Used for</td>
<td>Designates how this service is used. Default options are:</td>
</tr>
<tr>
<td></td>
<td>• Production</td>
</tr>
<tr>
<td></td>
<td>• Staging</td>
</tr>
<tr>
<td></td>
<td>• QA</td>
</tr>
<tr>
<td></td>
<td>• Test</td>
</tr>
<tr>
<td></td>
<td>• Development</td>
</tr>
</tbody>
</table>
The Service table (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Demonstration</td>
<td></td>
</tr>
<tr>
<td>• Training</td>
<td></td>
</tr>
<tr>
<td>• Disaster Recovery</td>
<td></td>
</tr>
</tbody>
</table>

**Users supported**
The users that this service supports. A reference to the Group [sys_users_group] table.

**Version**
Use this field for your own versioning processes.

The Service Configuration Item Association table

The Service Configuration Item Association table [svc_ci_assoc] binds an application service and a CI to track which CIs are part of each application service.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Item Id</td>
<td>A reference to the Configuration Item [cmdb_ci] table.</td>
</tr>
<tr>
<td>Service Id</td>
<td>A reference to the Service [cmdb_ci_service] table.</td>
</tr>
</tbody>
</table>

Table form views

When you view a table definition form, you can open the context menu, and select a form view in which to display the table. The default view for a table is the Default view. For any class that is an extension of the CMDB table, you can select the CI Definition view which provides additional access to related tables and information.

The CI Definition form view is a centralized location from which you can configure and view a table. In addition to the information that the default view displays, the CI Definition form view provides the following controls,

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icon tab</td>
<td>View and create new NG-BSM icons for CI types</td>
</tr>
<tr>
<td>CI Identifier tab</td>
<td>View and create new CI identifiers</td>
</tr>
<tr>
<td>Reconciliation Definitions tab</td>
<td>View and create new data source definitions</td>
</tr>
</tbody>
</table>
To access these additional controls on the CI Definition form view, you need to first create a new table that is derived from the CMDB table, and then view it using the CI Definition form.

**Related information**

Create a CI class

**Analytics and Reporting Solution for Configuration Management (CMDB)**

Analytics and Reporting Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With Analytics and Reporting Solutions, you can get value from Performance Analytics for your application with minimal setup. You can always create your own objects as well.

**Important:** Set up and test Analytics and Reporting Solutions on a non-production instance before enabling them in production.

**Note:** Analytics and Reporting Solutions provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see Configure Analytics and Reporting Solutions.

To enable the solutions for Configuration Management (CMDB), an admin can navigate to **Performance Analytics > Guided Setup**. Click **Get Started** then scroll to the section for Configuration Management (CMDB). The guided setup takes you through the entire setup and configuration process.

**Related information**

Analytics and Reporting Solutions
Activate your Performance Analytics subscription
Connect

ServiceNow® Connect is a real-time messaging platform that connects you to your coworkers, bypassing email and static documents.

Connect integrates with other features within the system, such as Visual Task Boards, Human Resources Management, and Customer Service Management. The Connect interface overlays the standard interface, which allows users to participate in conversations while they work.

Connect contains the following features:

• **Connect Chat**: Enables users to chat with individuals and groups, quickly share files, and collaborate on any record by connecting with the right people instantly.

• **Connect Support**: Enables support agents to provide real-time assistance to end users, using queues. Requires the Connect Support plugin.

UI16 or UI15 is required to use Connect.

⚠️ **Note:**

• Connect does not replace legacy chat but offers some of the same functionality. Do not use these features concurrently.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Upgrade to New York</td>
<td>• Activate Connect</td>
<td>• Properties for Connect</td>
</tr>
<tr>
<td>• Connect interface</td>
<td>• Activate Connect Support</td>
<td>• Connect actions</td>
</tr>
<tr>
<td>• Connect Chat</td>
<td>• Supported browsers for Connect</td>
<td>• Configure the fields on a record card in Connect</td>
</tr>
<tr>
<td>• Connect Support</td>
<td></td>
<td>• Properties for Connect Support</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Start a direct or group conversation</td>
<td>• Developer training</td>
<td>• Ask or answer questions in the Connect community</td>
</tr>
<tr>
<td>• Follow a record in Connect</td>
<td>• Developer documentation</td>
<td>• Search the Known Error Portal for known error articles</td>
</tr>
<tr>
<td>• Create an incident from a Connect Support conversation</td>
<td></td>
<td>• Contact Customer Service and Support</td>
</tr>
</tbody>
</table>
Supported browsers for Connect
The system supports Connect Chat and Connect Support on most modern browsers.

• The latest public release of Firefox or Firefox ESR
• The latest public release of Chrome
• Safari version 9.1 and later
• Microsoft Edge version 90
• Internet Explorer version 11
  ◦ Edge mode is supported.
  ◦ Compatibility mode is not supported.
  ◦ Setting Security Mode to High (via the Internet Options > Security tab) is not supported.
  ◦ Internet Explorer 11 is susceptible to memory leaks, which may impact performance, especially in Windows 7.

Activate Connect
Connect is active by default on new instances. For upgraded instances, you can activate the Connect plugin (com.glide.connect) if you have the admin role.

Before you begin
Role required: admin

About this task
If you used Collaboration in the Fuji release, the Connect plugin is activated automatically.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears:

```
Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
```

**Related information**

- List of plugins

**Properties installed with Connect**

Properties are added with activation of Connect.

**Note:** To open the System Property [sys_properties] table, enter `sys_properties.list` in the navigation filter.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>collaboration.email_interval</td>
<td>Sets the number of minutes the system waits before sending a Connect notification email to an inactive user.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 3</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Collaborate &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td></td>
<td>• <strong>Learn more</strong>: Configure the email notification interval</td>
</tr>
<tr>
<td>collaboration.frameset</td>
<td>Determines whether the Connect overlay is visible (enabled). This property also impacts Connect Support.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Collaborate &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td></td>
<td>• <strong>Learn more</strong>: Disable the Connect overlay</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><code>collaboration.polling_interval</code></td>
<td>Sets the number of seconds the system waits between polling for new Connect messages. This property also impacts Connect Support.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 10</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Property [sys_properties] table</td>
</tr>
<tr>
<td><code>connect.notification.audio_alert</code></td>
<td>Specifies the audio file to play to notify users of new messages, support conversation transfers, and @mentions in Connect. This property’s value must point to the <strong>Name</strong> field of a record in the Audio File [db_audio] table. This property also impacts Connect Support.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: string</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: <code>connect_alert.mp3</code></td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Collaborate &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td></td>
<td>• <strong>Learn more</strong>: Customize the Connect audio notification sound</td>
</tr>
<tr>
<td><code>connect.retrieve_external_link_content</code></td>
<td>Enables Connect to render URLs for external sites as links. When this property is disabled, URLs that point anywhere outside the instance appear as plain text. This property also impacts Connect Support.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Collaborate &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td><code>connect.roles</code></td>
<td>Determines which user roles are required to access Connect. When the value is blank, no role is required.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.connect.enabled</td>
<td>Hides the <strong>Create or Join Chat Room</strong> related link, which appears on the Incident form when legacy chat is enabled. Legacy chat and Connect Chat should not be used concurrently and this property should not be modified.</td>
</tr>
<tr>
<td>glide.connect.chat.disabled</td>
<td>Disables and hides all UI elements related to Connect.</td>
</tr>
<tr>
<td>glide.live_feed.task_header_button</td>
<td>Determines whether the show live feed icon ( <img src="image" alt="Live Feed Icon" />) and <strong>Follow</strong> button are available in the form header of tables that have the <code>live_feed=true</code> dictionary attribute.</td>
</tr>
</tbody>
</table>
Activate Connect Support

You can activate the Connect Support plugin (com.glide.connect.support) if you have the admin role. This plugin includes demo data.

Before you begin

⚠️ Important:
In Paris and future releases, Connect Support no longer receives enhancements or non-priority bug fixes. Consider migrating to ServiceNow® Advanced Work Assignment and Agent Chat in workspace to automatically assign chat requests and other work items to agents. For details, see Migrate from Connect Support to Advanced Work Assignment and Agent Chat.

If you are currently using the legacy chat feature to provide help desk support, close any open help desk chats before activating Connect Support. Legacy chat and Connect Support should not be used concurrently. When you activate Connect Support, the system automatically sets the stWorkplace from Facebookate of all Chat Queue Entry [chat_queue_entry] records to Closed Complete. This ends any open help desk chats. For more information, see Migrate from legacy chat to Connect Support.

Role required: admin
Procedure

1. Navigate to **System Applications > All Available Applications > All.**
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see **Request a plugin.**
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: *Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.*

Properties installed with Connect Support

Properties are added with activation of Connect Support.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connect.support.conversation_limit</td>
<td>Determines how many support conversations an individual agent can have at one time. When the value is set to -1, an agent can participate in an unlimited number of conversations.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> -1</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> Collaborate &gt; Support Administration &gt; Properties</td>
</tr>
<tr>
<td>connect.support.idle.delay</td>
<td>Determines how many seconds a user must be inactive in a support conversation before an idle countdown timer appears.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>connect.support.idle.count_down</td>
<td>Determines how many seconds the idle countdown timer remains open after it appears. If the idle user does not dismiss the timer before the countdown completes, the system closes the support session.</td>
</tr>
<tr>
<td>connect.support.show_agent_avatar</td>
<td>Determines whether an agent's avatar is shown in a support conversation (enabled). When the property is disabled, users see the agent's name only.</td>
</tr>
<tr>
<td>connect.support.user.closed.conversation_limit</td>
<td>Determines how many closed conversations appear in a user's support conversation history. When the value is set to 0, all previous conversations appear in the history.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>glide.connect.support.enabled</strong></td>
<td>Disables or enables Connect Support. When the property is enabled, the Service Desk Chat button in the Employee Self-Service portal opens the conversation in Connect Support, rather than legacy chat. Additionally, the Support tab appears in the Connect sidebar.</td>
</tr>
<tr>
<td><strong>Type</strong>: integer</td>
<td></td>
</tr>
<tr>
<td><strong>Default value</strong>: 0</td>
<td></td>
</tr>
<tr>
<td><strong>Location</strong>: Collaborate &gt; Support Administration &gt; Properties</td>
<td></td>
</tr>
<tr>
<td><strong>glide.connect.support.reflect_system_messages</strong></td>
<td>Controls whether Connect Support reflects system messages in records created from a support chat, for example, transfer notices, automated queue messages, etc.</td>
</tr>
<tr>
<td><strong>Type</strong>: true</td>
<td>false</td>
</tr>
<tr>
<td><strong>Default value</strong>: false</td>
<td></td>
</tr>
<tr>
<td><strong>Location</strong>: System Property [sys_properties] table</td>
<td></td>
</tr>
</tbody>
</table>

**Additional plugins for Connect Support**

Additional plugins are available for Connect Support. These plugins integrate Connect Support with other features and provide capabilities to track performance metrics.
You must have the admin role to activate these additional plugins. For details, see [Activate a plugin](#).

### Additional plugins for Connect Support

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
</table>
| Connect Support Manager's Dashboard [com.glide.connect.managers_dashboard] | Provides a homepage for Connect Support and all required configuration records. Though the plugin name contains the term dashboard, the plugin does not provide functionality related to Performance Analytics dashboards. Homepages are similar to dashboards, but do not require Performance Analytics roles to view.  

> **Note:** The Connect Support Manager's Dashboard plugin does not activate Connect Support automatically. You must activate Connect Support to collect data for the homepage.  

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
</table>
| Human Resources Application: HR Connect [com.snc.hr.hr_connect]        | Sets up a human resources (HR) chat queue and makes it available on the HR Service Portal.                                                                                                                     

> **Note:** This plugin does not appear in the System Definition>Plugins list. Contact ServiceNow personnel to activate it.  

If not already active, the Human Resources Application: HR Connect plugin activates these related plugins:  

- **Human Resources Application: Core [com.snc.hr.core]:** Provides basic HR features.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
</table>
### Additional plugins for Connect Support (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Performance Analytics - Content Pack - Service Desk Chat plugin</td>
<td>The Performance Analytics - Content Pack - Service Desk Chat plugin activates these related plugins if they are not already active: • Connect Support Manager's Dashboard [com.glide.connect.managers_dashboard]</td>
</tr>
<tr>
<td></td>
<td>See description in this table.</td>
</tr>
<tr>
<td>Performance Analytics - Context Sensitive Analytics for Chat</td>
<td>Provides in-form analytics for Connect Support. These analytics are available as a related link on the Chat Queue Entry [chat_queue_entry] form, and also as the Context Sensitive Analytics - Chat dashboard. The Performance Analytics - Context Sensitive Analytics for Chat plugin activates these related plugins if they are not already active: • Performance Analytics - Content Pack - Service Desk Chat [com.snc.pa.chat]: See description in this table.</td>
</tr>
<tr>
<td>[com.snc.pa.chat.context_sensitive_analytics]</td>
<td></td>
</tr>
</tbody>
</table>

### Connect interface

Users can work in a compact view of Connect, which overlays the standard user interface, or in a full-screen workspace.

Connect Chat and Connect Support share the same interface, so support agents can keep track of all their conversations in one place.

### Connect overlay

The Connect overlay appears over the standard user interface. It consists of the Connect sidebar, which is the primary interface for Connect Chat and Connect Support, and any Connect mini windows that are open. Each mini window contains a header, a conversation area, and a message field.
**Connect overlay**

[Image of a ServiceNow interface with Connect overlay]

**Note:** An administrator can disable the Connect overlay so users can only use the Connect workspace, a full-screen interface with additional Connect tools.

**Connect sidebar**

The Connect sidebar is the primary interface for Connect Chat and Connect Support. It lists your conversations and provides access to create conversations.

The sidebar is collapsed by default. Click the toggle Connect sidebar icon in the banner frame to expand or collapse the sidebar, which appears on the right edge of the interface.

**Connect Chat**

The chat view of the sidebar is available to all users. If Connect Support is enabled, users must click the chat tab of the sidebar, which is represented by a speech bubble icon. If Connect Support is not enabled, there are no tabs in the sidebar and the chat view displays by default.

The chat view of the sidebar lists all your current Connect Chat conversations. It also contains a filter tool and a button to create conversations.
If you have unread messages in a conversation, a number appears by the conversation in the sidebar. Point to a conversation and click the x icon to remove the conversation from the sidebar.

**Connect Support**

The support view of the sidebar is available when Connect Support is activated. The support view is visible only to users who are agents for at least one support queue. Users must click the support tab of the sidebar, which is represented by a headset icon.

The support view displays **Queues** to which you belong. It also displays your open support conversations under **Cases**.
If you have unread messages in a conversation, a number appears by the conversation in the sidebar.

**Connect mini windows**

When you open a Connect Chat or Connect Support conversation in the Connect overlay, it opens in a Connect mini window. Each mini window contains a header, a conversation area, and a message field.

Several icons appear in the mini window header and by the message field.

**Note:** The icons you see for each conversation depend on the conversation type and other conditions.

**Chat mini window icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌟</td>
<td>Add user</td>
<td>Add a user to the conversation. This icon is visible for group and record conversations only. Administrators can enable this icon for Connect Support conversations.</td>
</tr>
<tr>
<td>📄</td>
<td>View document</td>
<td>View the record associated with the conversation. This icon is visible for record and support conversations only.</td>
</tr>
</tbody>
</table>
Chat mini window icons (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>New window</td>
<td>Open the conversation in the Connect workspace, a full-screen window with additional Connect tools.</td>
</tr>
<tr>
<td>❌</td>
<td>Collapse/Expand conversation</td>
<td>Hide or show the conversation. Alternatively, click anywhere in the mini window header to the left of the icons.</td>
</tr>
<tr>
<td>✗</td>
<td>Close window</td>
<td>Close the mini window. The conversation remains in the Connect sidebar and the history is preserved when you reopen the conversation. You can also close a mini window by pressing the Escape key.</td>
</tr>
<tr>
<td>⌋</td>
<td>Connect actions</td>
<td>Open the Connect actions menu, which contains options like Transfer and Create Incident. This icon is visible only when Connect actions are available for the conversation. By default, this icon is visible for support conversations only. Administrators can add options to this menu by creating Connect actions.</td>
</tr>
<tr>
<td>⌨️</td>
<td>Message type</td>
<td>Choose whether messages are added to the associated record as comments or work notes. This icon is visible only for record and support conversations.</td>
</tr>
<tr>
<td>📂</td>
<td>Attach file</td>
<td>Attach and send a file. Select one or more files and click Open. You can also add an attachment by dragging and dropping it directly in the conversation.</td>
</tr>
</tbody>
</table>

Connect workspace

The Connect workspace is a full-screen view of all your Connect Chat and Connect Support conversations in one place. It contains the conversation pane, which displays the conversation header and an expanded version of the mini window, and the conversation tools area.

To open the Connect workspace, navigate to Collaborate > Connect Chat or click the new window icon (往来) in a Connect mini window. If you do not have any recent conversations, a screen appears with helpful information about Connect.

The Connect workspace is composed of the following elements.
## Connect workspace elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sidebar</td>
<td>Provides access to conversations. The Connect sidebar behaves the same way in the workspace as it does in the Connect overlay. The only difference is that the sidebar appears on the left edge of the Connect workspace. For more information about using the sidebar, see <a href="#">Connect sidebar</a>.</td>
</tr>
<tr>
<td>Conversation pane</td>
<td>Displays the currently selected conversation.</td>
</tr>
<tr>
<td>Conversation tools</td>
<td>Provides quick access to key information, conversation members, attachments, and notification preferences for the currently selected conversation. Some of the conversation tools vary depending on the type of conversation.</td>
</tr>
</tbody>
</table>

### Connect workspace

The conversation pane of the Connect workspace displays the conversation header and an expanded version of the mini window.
The header displays basic conversation details like the avatar and name. You can edit these details for group or record conversations.

Below the header, messages appear in chronological order. You can enter messages in the text entry field at the bottom of the window.

**Connect conversation tools**

The conversation tools area in the Connect workspace contains several tabs, each represented by an icon.

Click an icon to open the tab. Click the same icon again to hide the tab. The tabs you see for each conversation depend on the conversation type and other conditions.

### Conversation tool tabs

<table>
<thead>
<tr>
<th>Tab icon</th>
<th>Tab name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📃</td>
<td>Info</td>
<td>Contains the following sections, each of which appears only if it contains information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Record</strong>: Lists details about the record the current conversation follows, such as record number, state, assignee, and short description. The fields displayed in this section vary by the type of record. This section is available only for record conversations.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Related Records</strong>: Lists Visual Task Boards and task records that have been referenced in the conversation, such as incidents, problems, or changes. When you send a record number as a message or drag a record in a conversation, it appears as a link. The list displays the short description for each task. Click a task to open the record in a new browser tab. Only conversation members who have rights to view the tasks can access them.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Links</strong>: Lists URLs that have been referenced in the conversation. Click a link to open the destination page in a new browser tab.</td>
</tr>
<tr>
<td>📝</td>
<td>Record</td>
<td>Displays a compact form view of a record created from the current conversation, such as an incident.</td>
</tr>
</tbody>
</table>
### Conversation tool tabs (continued)

<table>
<thead>
<tr>
<th>Tab icon</th>
<th>Tab name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>If more than one record has been created from the conversation, there is a separate record tab for each one. These tabs are available only for support conversations.</td>
</tr>
<tr>
<td>📚</td>
<td>Knowledge Base</td>
<td>Displays a compact view of the knowledge homepage. For more information, see Share knowledge in a Connect Support conversation.</td>
</tr>
<tr>
<td>🧑‍💻</td>
<td>Members</td>
<td>Lists all members of the current conversation. You can add or remove conversation members for group and record conversations.</td>
</tr>
<tr>
<td>📇</td>
<td>Attachments</td>
<td>Lists all attachments in the conversation. Click an attachment to open it. Click Add Attachment to upload an attachment.</td>
</tr>
<tr>
<td>🕉</td>
<td>Notification preferences</td>
<td>Contains settings to control which notifications you receive for the current conversation. For more information, see Edit which notifications you receive for a conversation.</td>
</tr>
</tbody>
</table>

### Enable or disable Connect notifications globally

You can edit your Connect notification settings globally to enable or disable mobile, desktop, email, or audio notifications for all your Connect Chat and Connect Support conversations.

**Before you begin**
Role required: none

**About this task**
By default, Connect mobile, email, and audio notifications are enabled globally. You must enable desktop notifications.

An administrator can customize the sound used for audio notifications.

⚠️ **Note:** You receive mobile notifications only if you have installed the ServiceNow mobile app.
Procedure

1. In the banner frame, click the gear icon (⚙️) to open the system settings.
2. In the system settings window, click the Notifications tab.
3. In Notifications by Category, navigate to Connect.
4. Enable or disable Connect mobile, desktop, email, or audio notifications.
5. Optional: Configure the following system notifications. For more information on how to configure system notifications, see Apply notification conditions.

<table>
<thead>
<tr>
<th>Notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Stream @Mention Email</td>
<td>Sends an email alert to a user anytime they get @mentioned in an activity stream</td>
</tr>
<tr>
<td>Collaboration Offline Group Message(s)</td>
<td>Sends email to offline users who are members of a group conversation after a certain number of minutes determined by the collaboration.email_interval property to limit spam.</td>
</tr>
<tr>
<td>Note: It takes 90 seconds after a user logs out for the system to register that the user is offline. If a message is sent to the user within 90 seconds of them logging out, then the user does not receive the notification.</td>
<td></td>
</tr>
<tr>
<td>Collaboration Offline Message Bundle</td>
<td>Sends email to offline users after a certain number of minutes determined by the collaboration.email_interval property to limit spam.</td>
</tr>
<tr>
<td>Note: It takes 90 seconds after a user logs out for the system to register that the user is offline. If a message is sent to the user within 90 seconds of them logging out, then the user does not receive the notification.</td>
<td></td>
</tr>
</tbody>
</table>
### Notification Description

<table>
<thead>
<tr>
<th>Notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConnectMessagePushNotification</td>
<td>Uses a push notification to inform users when there are new messages in a conversation</td>
</tr>
<tr>
<td>ConnectNotificationPushNotification</td>
<td>Uses a push notification to inform a user when they have been @Mentioned in a record</td>
</tr>
</tbody>
</table>

### What to do next
Edit which notifications you receive for a specific conversation.

### Connect notification browser support
The following browsers support Connect chat notifications.

#### Connect chat browser support

<table>
<thead>
<tr>
<th>Browser</th>
<th>Enable notification steps</th>
</tr>
</thead>
</table>
| Chrome                                           | 1. From a Chrome window, click the Chrome menu in the upper right corner.  
2. Go to Settings > Show advanced settings... > Privacy > Content settings.  
3. In the Content settings window, from the notifications section, select your notification settings. |
| Mozilla Firefox (starting with version 44)        | Manage browser notification settings using the information icon next to the URL.                                                                              |
| Safari (starting with OS X Mavericks)             | 1. From a Safari window, open Preferences.  
2. Select the notifications tab.  
3. Select Allow or Deny to control which websites have access to notifications. |
Connect chat browser support (continued)

<table>
<thead>
<tr>
<th>Browser</th>
<th>Enable notification steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Edge</td>
<td>Notifications are enabled by default on Windows 10 PCs and tablets starting with EdgeHTML 14. For more information, see <a href="https://blogs.windows.com/msegedev/2016/05/16/web-notifications-microsoft-edge/#pVkwubg7uvROayyl.97">https://blogs.windows.com/msegedev/2016/05/16/web-notifications-microsoft-edge/#pVkwubg7uvROayyl.97</a>.</td>
</tr>
</tbody>
</table>

⚠️ Note: Internet Explorer does not support Connect notifications out of box.

**Edit which notifications you receive for a conversation**

You can control which types of Connect notifications you receive for each conversation and when you receive them.

**Before you begin**

Role required: none

**About this task**

Connect can send mobile, desktop, email, and audio notifications to inform you of messages and other activity, when you are not actively viewing Connect. You can edit your notification preferences in each conversation to control which notifications you receive for the conversation and under what circumstances. For example, if you are a member of a large group conversation, you might want to receive mobile, desktop, and email notifications for all activity, and audio notifications only when someone mentions you. You might also want to disable a certain type of notification entirely for a conversation.

By default, you receive mobile, email, and audio notifications for all activity in every conversation you belong to. You must enable desktop notifications manually. Not all browsers allow desktop notifications. For more information, see Enable or disable Connect notifications globally.

An administrator can customize the sound used for audio notifications.

⚠️ Note: You receive mobile notifications only if you have installed the ServiceNow mobile app.
**Procedure**

1. Open a conversation in the Connect workspace.
2. In the conversation tools to the right of the conversation, click the notification settings tab (⋯).
3. Edit the following settings according to your preferences.

   **Note:** If a notification type is disabled globally, a link to enable that type appears. You must click the link before you can edit conversation-specific notification settings.

<table>
<thead>
<tr>
<th>Notification type disabled globally</th>
<th>Choose to receive push notifications:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobile Notification Settings</td>
<td>• For all activity</td>
</tr>
<tr>
<td></td>
<td>• Only when @ mentioned (this option is not available for direct conversations)</td>
</tr>
<tr>
<td></td>
<td>• Never</td>
</tr>
<tr>
<td>Desktop Notification Settings</td>
<td>• For all activity</td>
</tr>
<tr>
<td></td>
<td>• Only when @ mentioned (this option is not available for direct conversations)</td>
</tr>
<tr>
<td></td>
<td>• Never</td>
</tr>
<tr>
<td>Email Settings</td>
<td>• For all activity</td>
</tr>
<tr>
<td></td>
<td>• Only when @ mentioned (this option is not available for direct conversations)</td>
</tr>
<tr>
<td></td>
<td>• Never</td>
</tr>
<tr>
<td>Audio Notification Settings</td>
<td>Choose to receive audio notifications:</td>
</tr>
</tbody>
</table>
Upload a profile picture

You can upload a profile picture in your Live Feed profile to use as an avatar in Connect Chat and Connect Support conversations.

Before you begin
Role required: none

About this task
Users who do not have profile pictures are represented by an avatar with their initials. Administrators can upload a profile picture in a user record which displays if there is no Live Feed photo.

Procedure
1. Navigate to Collaborate > Live Feed.
2. Click the tile with your picture or initials and title.
3. Use one of the following actions to add your photo.
• Locate the photo file you want to use and drag it over the existing photo.
• Point to the existing picture (or tap the photo in the smartphone or tablet interface) to display the **Upload a picture** link. Click the link, navigate to the location of the photo you want to use, and click **Open**.

![Upload a picture](image)

**Related information**

Update your Live Feed profile

**Drag a file into a Connect conversation**

Drag and drop functionality in Connect Chat and Connect Support provides an easy way to share external attachments and links or items from within your instance.

**Before you begin**

Role required: none

**About this task**

You can drag several things from within an instance, including items from the application navigator, records or breadcrumbs from lists, and Visual Task Boards from the My Task Boards page.

**Procedure**

Drag an item in a Connect mini window.

To drag a record from a list, drag the reference icon ( mädchen ), the record number, or a reference column value.

Connect accepts the same file extensions as the platform. For more information, see .
Share a Visual Task Board in a Connect conversation
You can share a Visual Task Board in a Connect Chat or Connect Support conversation.

Before you begin
Role required: none

Procedure
2. Drag a task board to a Connect mini window.
   A link to the task board appears in the conversation. The task board is also listed in the conversation tools, which are visible in the Connect workspace. Only conversation members who are members of the board can access it. If you share a task board in a record conversation, it appears as a URL in the record activity stream.

Related information
   Connect
   Visual Task Boards

Mention a user in a Connect conversation
You can get someone's attention in a group conversation by mentioning them.

Before you begin
Role required: none

About this task
Users can set their notification preferences so they receive notifications only when they are mentioned. Mentioning a user creates a shortcut to view their basic information and send them a direct message.
**Procedure**

1. Open a Connect group conversation.
2. In the message field, type the @ character. A suggestion menu appears with the names of the conversation members.
3. Select the person you want to mention and send the message.

**Connect administration**

Administrators can configure various performance settings and features that impact both Connect Chat and Connect Support.

⚠️ **Note:** There are also administrative options specifically for Connect Chat or Connect Support. For more information, see Connect Chat administration and Connect Support administration.

**Properties for Connect**

The Connect Properties page provides several configuration options for Connect.

Users with the admin role can access these properties by navigating to Connect > Administration > Properties.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Disable Presence glide.ui.presence.disabled | Turns off user presence globally when enabled. Enabling this property turns off user presence throughout the platform, not just in Connect.  
  - **Type:** true | false  
  - **Default value:** false  
  - **Location:** Connect > Administration > Properties  
  - **Learn more:** |
| Enable Connect in the frameset collaboration.frameset | Determines whether the Connect overlay is visible (enabled). This property also impacts Connect Support.  
  - **Type:** true | false  
  - **Default value:** true  
  - **Location:** Collaborate > Administration > Properties  
  - **Learn more:** Disable the Connect overlay |
| Enable Connect to retrieve external link metadata in order to render richer content in messages with links to YouTube, news articles, images, etc. connect.retrieve_external_link_content | Enables Connect to render URLs for external sites as links. When this property is disabled, URLs that point anywhere outside the instance appear as plain text. This property also impacts Connect Support.  
  - **Type:** true | false  
  - **Default value:** true  
  - **Location:** Collaborate > Administration > Properties |
| Number of minutes to wait before collecting unread messages and sending an email to offline users. | Sets the number of minutes the system waits before sending a |
# Properties for Connect (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| collaboration.email_interval | Connect notification email to an inactive user.  
  - **Type**: integer  
  - **Default value**: 3  
  - **Location**: Collaborate > Administration > Properties  
  - **Learn more**: Configure the email notification interval |
| Maximum number of latest conversations to show during search. (Default = 50) | Sets the number of results that appear when you search conversations in Connect. In the System Properties [sys_properties] table, this property appears as connect.search.conversation_limit.  
  - **Type**: integer  
  - **Default value**: 50 |
| Audio file to play to notify users of new messages, support conversation transfers and @mentions in Connect. This property's value should point to the 'name' field of an audio file in the db_audio table. connect.notification.audio_alert | Specifies the audio file to play to notify users of new messages, support conversation transfers, and @mentions in Connect. This property's value must point to the **Name** field of a record in the Audio File [db_audio] table. This property also impacts Connect Support.  
  - **Type**: string  
  - **Default value**: connect_alert.mp3  
  - **Location**: Collaborate > Administration > Properties  
  - **Learn more**: Customize the Connect audio notification sound |
| Comma separated allow list of roles able to access Connect. Empty allows all roles. connect.roles | Determines which user roles are required to access Connect. When the value is blank, no role is required. This property also impacts Connect Support. |
### Properties for Connect (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>glide.connect.enabled</strong></td>
<td>Hides the <strong>Create or Join Chat Room</strong> related link, which appears on the Incident form when legacy chat is enabled. Legacy chat and Connect Chat should not be used.</td>
</tr>
<tr>
<td><strong>glide.live_feed.task_header_button</strong></td>
<td>Determines whether or not a button is shown in task forms to view the Collaboration document conversation or Live Feed Record Feed related to the task. Note: The Collaboration button will only be enabled if the frameset view is also enabled with <code>collaboration.frameset = true</code>.</td>
</tr>
</tbody>
</table>

---

**Note:** If you choose to restrict Connect access to specific roles, consider updating the role requirements for Connect modules and other access points.

- **Type:** string
- **Default value:** `<empty>`
- **Location:** Collaborate > Administration > Properties

---

Determine whether the show live feed icon (📖) and **Follow** button are available in the form header of tables that have the `live_feed=true` dictionary attribute.

- **Type:** choice list
- **Default value:** `collaboration`
- **Other possible values:**
  - **both:** enables both the show live feed icon and the **Follow** button.
  - **live_feed:** enables the show live feed icon.
  - **none:** disables both the show live feed icon and the **Follow** button.

- **Location:** Collaborate > Administration > Properties
- **Learn more:** Configure record conversations
Properties for Connect (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>concurrently and this property should not be modified.</td>
</tr>
<tr>
<td>• <strong>Type</strong>: true</td>
<td>false</td>
</tr>
<tr>
<td>• <strong>Default value</strong>: true</td>
<td></td>
</tr>
<tr>
<td>• <strong>Location</strong>: Collaborate &gt; Administration &gt; Properties</td>
<td></td>
</tr>
</tbody>
</table>

Configure the polling interval

The polling interval determines how frequently the system polls for new Connect messages.

**Before you begin**

Role required: admin

**About this task**

The default interval is 10 seconds. You can change this value. The shorter the polling interval, the more frequently the system checks for new messages and the greater the impact on performance.

⚠️ **Note:** This setting impacts Connect Chat and Connect Support.

**Procedure**

1. Navigate to `sys_properties.list`.

2. Locate the `collaboration.polling_interval` property.

3. Set the **Value** to a different number of seconds.

   Setting the polling interval to a value smaller than 2 is likely to tax the system too heavily, while a value greater than 10 is likely to result in a poor user experience.

Disable the Connect overlay

The Connect overlay is enabled by default and is integrated with the standard user interface. You can disable the Connect overlay.

**Before you begin**

Role required: admin
About this task
To disable the Connect overlay and remove the toggle Connect sidebar icon from the banner frame, set the `collaboration.frameset` property to `false`.

Procedure
1. Navigate to Connect > Administration > Properties.
2. Locate the property called `Enable Connect in the frameset (collaboration.frameset)` and clear the check box.
3. Click Save.

Results
When the frameset is disabled, any Connect chats open in the Connect workspace. For more information on completely disabling Connect Chat, see Disable Connect Chat.

Customize the Connect audio notification sound
You can replace the default Connect audio notification sound with an audio file of your choice.

Before you begin
Upload the audio file you want to use as the notification sound.

Role required: admin

About this task
The audio notification sound is used for all Connect conversation types, including Connect Support conversations.

Procedure
1. Navigate to System UI > Audio Files.
2. Locate the audio file you want to use as the notification sound and copy the Name value.
3. Navigate to Connect > Administration > Properties.
4. Locate the property called `Audio file to play to notify users of new messages, support conversation transfers and @mentions in Connect (connect.notification.audio_alert)` and replace the default value with the name of the audio file.
5. Click Save.
Results
End users receive audio notifications when sending and receiving support chats. Support agents only receive audio notifications for inbound chats when the chat window is not in focus.

Administer Connect actions
You can create or modify Connect actions to provide custom functionality in Connect Chat or Connect Support conversations.

Before you begin
If you want to customize the icon for a Connect action, navigate to Collaborate > Administration > Action Icons to view the available icons and their class names. Note the class name of the icon you want to use.

Role required: admin

About this task
The Connect action menu appears by the message entry field when one or more Connect actions are available for a conversation, based on defined conditions. When a user selects a Connect action, the system runs the script defined for that action.

Procedure
1. Navigate to Connect > Administration > Actions.
2. Click New or open an existing record to edit a table.
3. On the form, fill in the fields.

Connect Action form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>JavaScript condition statement that must return true for the action to be available in a conversation. For example, to show the action in Connect Support conversations only, enter conversation.type === &quot;support&quot; Or conversation.table === 'chat_queue_entry'. For information about the conversation object, see the GlideConversation API reference documentation.</td>
</tr>
<tr>
<td>Hint</td>
<td>This field is not used.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Icon Class Name</td>
<td>Class name of the icon to use. To view all available icons and their class names, navigate to Collaborate &gt; Administration &gt; Action Icons.</td>
</tr>
<tr>
<td>Order</td>
<td>Order of the action relative to other items in the Connect action menu.</td>
</tr>
</tbody>
</table>
| Script      | Script to execute when the action is run. For example, to create a new incident that is based on the conversation, enter the following code: response.newRecord("incident",{  
  short_description: conversation.document.short_description || "",  
  caller_id: conversation.document.opened_by  
});   

For information about the response object, see the ConnectActionResponse API reference documentation.  

⚠ **Note:** You can only create a Connect action that is based on a task table.                                                                                                                                 |
| Shortcut    | Text that triggers the action when entered after the "/" character in a conversation.                                                                                                                          |
| Title       | Text that appears in the Connect action menu. The title for each Connect action should be unique.                                                                                                           |
Configure the fields on a record card in Connect

When a record is either linked to or created from a Connect Chat conversation, the details of the record display as a card in the chat window.

About this task
The card view only applies to the full Connect Chat page and the end-user view of Connect Support conversations.

Role required: admin
Procedure

1. Select the menu icon (≡) on any of the column names of the incident list view.

2. Right-click on the column name and select **Configure > List Layout**.
3. On the Configuring Incidents List screen, select **New** from the View name list.

![Configuring Incidents List screen](image)

4. In the Create New View dialog, enter **Connect** in the View name field.

![Create New View dialog](image)

For more information on creating a form view, see **Create and delete views**. You cannot remove the Author or the Updated fields from the card regardless of whether they are on the view or not. The card always shows the Short Description field in the top even if it is in a different order in the list.
5. Choose the fields that you want to display on the Connect card and select the fields.

6. Validate that the card displays the fields in a Connect Chat conversation.

**Disable specific URLs for Connect**

Prevent users from accessing certain websites by disabling linking to specific Top-Level Domains (TLDs).

**Before you begin**

Role required: admin

**Procedure**

1. In the navigation filter, type `sys_properties.list`.
2. Search for the `glide.ui.url.external.top_level_domains` system property.
3. In the value field, remove any TLDs that you do not want your users to have access to. For example, remove any TLDs that are commonly used for restricted websites, such as `xxx` or `adult`.

   The list of TLDs is based on the top 200 most common domains.

**Results**

Any TLD not included in the value field becomes unclickable in Connect.
Connect Chat

Connect Chat is a real-time messaging tool that enables users to chat with individuals and groups, quickly share files, and collaborate on any record by connecting with the right people instantly.

Connect Chat animates communication around records, Visual Task Boards, topics of interest, or groups of people.

Features include:

• Direct conversations between two users.
• Group conversations between three or more users.
• Conversations linked to records. Comments and work notes appear in conversations in real time and users can update the record directly from the conversation.
• Drag-and-drop sharing of links, files, and records.

UI16 or UI15 is required to use Connect Chat.

This video demonstrates how to use Connect Chat.

How to use Connect Chat

This video demonstrates how to use Connect Support.

How to use Connect Support

🤔 Note:

• Connect Chat does not replace legacy chat but offers some of the same functionality. The features should not be used concurrently.

Connect Chat use

All users have access to Connect Chat, a convenient way to stay updated on all the people and documents you work with in a familiar chat interface.

You can start using Connect Chat right away with virtually no setup. Connect Chat supports a few different types of conversations so you can use it as a social tool or a quick way to follow specific records.

Start a direct or group conversation

You can start a conversation with one or more users in Connect Chat.

Before you begin

Role required: none
About this task
A conversation between two users is called a direct conversation. A conversation between three or more users is called a group conversation.

Procedure
1. In the chat view of the Connect sidebar, click the plus icon (+) by the filter. A Connect mini window appears.
2. In the To field, enter the name of the user you want to chat with. Suggestions appear as you type.
3. Optional: Enter additional names to create a group conversation. You can add or remove group conversation members later. You cannot add members to a direct conversation after you create it.
4. Press the Enter key to shift focus to the message field.
5. Send a message to create the conversation. The conversation is added to the Connect sidebar for quick access.

Follow a record in Connect
You can follow a record in Connect Chat to track activity as it happens, in a familiar chat interface. When you follow a record, you become a member of a record conversation.

Before you begin
Role required: whichever role is required to access the record you want to follow in Connect

About this task
You must first activate the Connect (com.glide.connect) plugin to complete this task.

Any record conversation you create in Connect becomes a record feed in live feed, and vice versa. Unlike direct or group conversations, all messages in record conversations are comments or work notes.

Note: By default, record conversations are enabled for all tables that extend Task [task]. Administrators can enable record conversations for additional tables or disable them if desired.

Procedure
1. Navigate to a task record.
2. Do one of the following actions.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Follow the record</td>
<td>a. In the form header, click <strong>Follow</strong>. The system adds you as a member of the record conversation, but does not open the conversation. You can open the conversation from the Connect sidebar.</td>
</tr>
</tbody>
</table>
| Follow the record and open a chat mini window | a. In the form header, click the down arrow in the **Follow** button.  
  b. Select **Open Connect Mini**.  
  The system adds you as a member of the record conversation and opens it in a Connect mini window. |
| Follow the record and open the Connect workspace | a. In the form header, click the down arrow in the **Follow** button.  
  b. Select **Open Connect Full**.  
  The system adds you as a member of the record conversation and opens it in the Connect workspace, the full-screen view. |

The **Follow** button is relabeled **Following**.

3. Add comments or work notes to the record directly from Connect.  
Any comments or work notes added to the record appear in the record conversation. Likewise, comments and work notes you add to the conversation appear on the record.

a. In the record conversation, by the text entry field, click the message type icon (💬).  

b. Select **Comment** or **Work Note**.

c. Enter a message.  
By default, record conversation messages are added as work notes.

ℹ️ **Note:** If you add an attachment to a record conversation, it is attached to the underlying record as well.
What to do next
Edit your notification settings for the record conversation.

Related information
Live Feed

Edit basic conversation details
In Connect Chat, you can customize the avatar, name, and description for a group or record conversation.

Before you begin
Role required: none

About this task
These details are not editable for direct conversations.

Note: The name and description for a record conversation default to the record name and short description. However, editing the name or description for a record conversation does not change anything on the underlying record.

Procedure
1. Open the a group or record conversation in the Connect workspace.
2. Click anywhere in the conversation header to the left of the icons.
   A pop-up appears to edit conversation details.
3. Edit the conversation image, name, and description as needed.
4. Click Save.

Add or remove conversation members
In Connect Chat, any member of a group or record conversation can add or remove other conversation members. In a direct conversation with only two people, you cannot add members to the conversation after you create it.

Before you begin
Role required: none
Procedure

1. Open a group or record conversation in the Connect workspace.
2. In the conversation tools to the right of the conversation pane, click the member list tab (👥).
3. Do one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a member</td>
<td>a. Click Add Member to Group.</td>
</tr>
<tr>
<td></td>
<td>b. Use the search field to find and select a user.</td>
</tr>
<tr>
<td>Remove a member</td>
<td>a. Point to a member name.</td>
</tr>
<tr>
<td></td>
<td>b. Click the minus icon (−).</td>
</tr>
</tbody>
</table>

Create a Connect conversation from a Visual Task Board

Create a Connect Chat conversation from a Visual Task Board to collaborate with board members and keep track of activity as it happens.

Before you begin
Role required: none

About this task
When you create a conversation from a task board, all the board members become members of the conversation. The members are synchronized between the task board and the conversation. For example, if you remove a user from the conversation, the system automatically removes the user from the board as well.

Procedure

2. Open a task board.
3. In the board header, click the connect with board members icon (👥). The system automatically opens a record conversation for the board. Each board member becomes a member of the conversation.

Related information

Connect Chat
Visual Task Boards
Connect Chat administration

Administrators can configure various performance settings and features of Connect Chat.

? Note: There are also settings that apply to both Connect Chat and Connect Support. For more information, see Connect administration.

Configure the email notification interval

The email notification interval determines how long the system waits before sending a Connect Chat email notification to an inactive user.

Before you begin
Role required: admin

About this task
The default interval is 3 minutes. You can change this value.

Procedure
1. Navigate to Connect > Administration > Properties.
2. Locate the property called Number of minutes to wait before collecting unread messages and sending an email to offline users. (collaboration.email_interval) and set the value to a different number of minutes.
3. Click Save.

Results
When an offline user is sent a Connect message, the collaboration.new_offline_message event fires. The system waits the amount of time provided in the collaboration.email_interval property, then triggers the collaboration.notify_offline_user and collaboration.notify_offline_user.group events (depending on if the conversation was peer to peer or a group conversation). The sysevent_email_action record listens for collaboration.notify_offline_user(.group) then builds an email notification containing all the messages from the last collaboration.email_interval minutes that the user has received in that conversation.
Enable record conversations for a table

Record conversations are enabled for all tables that extend Task [task] by default. You can configure record conversations for additional tables that extend Task.

Before you begin
Role required: admin

About this task
To create record conversations, users must have access to the Follow button in the form header. To show the button and thus enable record conversations for a table, the following conditions must be true.

- The live_feed dictionary attribute must be set to true for the table.
  - By default, live_feed=true for all tables that extend Task [task].
- The glide.live_feed.task_header_button property must be set to both or collaboration.
  - By default, glide.live_feed.task_header_button is set to collaboration.

Procedure
1. Navigate to the list view of a table for which you want to enable record conversations.
2. Perform the appropriate action for the list version.

<table>
<thead>
<tr>
<th>Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v3</td>
<td>a. Click the list title menu and select Configure.</td>
</tr>
<tr>
<td></td>
<td>b. In the Configure window, click Dictionary.</td>
</tr>
<tr>
<td>List v2</td>
<td>Right-click any column header and select Configure &gt; Dictionary.</td>
</tr>
</tbody>
</table>

The list of dictionary entries for the table appears.
3. Open the dictionary entry that has Type set to Collection. The Dictionary Entry form appears.
4. In the Attributes related list, click New. The Dictionary Attribute form appears.
5. In the Attribute field, enter Live feed.
6. In the Value field, enter true.
7. Click Submit.
8. Navigate to Collaborate > Administration > Properties.
9. Locate the property called Determine whether or not a button is shown in task forms to view the Collaboration document conversation or Live Feed Record Feed related to the task (glide.live_feed.task_header_button).
10. Ensure the property is set to both or collaboration. The glide.live_feed.task_header_button property also controls whether the show live feed icon (_DBG) appears. If the property is set to collaboration, the show live feed icon does not appear on form headers.

Related information
Dictionary attributes

Prevent users from following records in Connect for all tables
Users can follow records in Connect for any table that extends Task [task] by default. You can disable this functionality for all tables.

Before you begin
Role required: admin

About this task
To disable record conversations for all tables, prevent the Follow button from appearing in all form headers by editing the glide.live_feed.task_header_button property.

Procedure
1. Navigate to sys_properties.list.
2. Locate the glide.live_feed.task_header_button property.
3. Set the Value to live_feed.

Prevent users from following records in Connect for a specific table
Users can follow records in Connect for any table that extends Task [task] by default. You can disable this functionality for a specific table.

Before you begin
Role required: admin
### About this task
To disable record conversations for a specific table, prevent the **Follow** button from appearing in form headers for the table. To do so, set the `live_feed` dictionary attribute to `false` for the table.

### Procedure
1. Navigate to the list view of a table for which you want to disable record conversations.
2. Perform the appropriate action for the list version.

<table>
<thead>
<tr>
<th>Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v2</td>
<td>Right-click any column header and select <strong>Configure &gt; Dictionary</strong>.</td>
</tr>
<tr>
<td>List v3</td>
<td>Open the list title menu and select <strong>Configure</strong>, and then select <strong>Dictionary</strong>.</td>
</tr>
</tbody>
</table>

The list of dictionary entries for the table appears.

3. Open the dictionary entry that has **Type** set to **Collection**. The Dictionary Entry form appears.
4. In the **Attributes** related list, locate the **Live feed** dictionary attribute.
5. Set the **Value** to **false**.
   Setting the dictionary attribute to **false** also removes the show live feed icon ( sqlSession ) for the table.

### Related information
- Dictionary attributes

### Disable Connect Chat
You can disable Connect Chat to prevent users from being able to chat within the platform.

**Before you begin**
Role required: admin

**About this task**
Disabling Connect Chat hides the Connect Chat sidebar icon. Users who try to access Connect Chat from the navigation pane receive a message that says Connect has been disabled.
Procedure

1. In the navigation filter, type `sys_properties.list` and press Enter.
2. Search for the `glide.connect.chat.disabled` property.
3. Set the property value to `true`.

Connect Support

Connect Support is a real-time messaging tool that enables support agents to easily track their support cases, find solutions, and resolve problems quickly.

**Important:**

Starting with the Paris release, Connect Support no longer receives enhancements or non-priority bug fixes. Consider moving to ServiceNow® Advanced Work Assignment and Agent Chat in workspace to automatically assign chat requests and other work items to agents. For details, see Move from Connect Support to Advanced Work Assignment and Agent Chat.

Connect Support builds on the messaging platform provided with Connect. For general information about the Connect interface, setup, and administration, see Connect. When Connect Support is enabled, users designated as support agents can access the support tab of the Connect sidebar.

Using Connect Support:

- Administrators can create chat queues and enable users to access live support.
- Support agents can monitor the queues to provide instant support.
- Users can share links, files, and records using drag-and-drop.

UI16 or UI15 is required to use Connect Support.

**Note:**

- Connect Support does not replace legacy chat but offers some of the same functionality. Do not use the features concurrently.

Monitor incoming Connect Support conversations

In the support tab of the Connect sidebar, you can monitor the queues for which you are an agent and accept incoming conversations.
Before you begin
Role required: none

About this task

Note: The support tab is visible only if you are an agent for one or more queues.

Procedure

1. Navigate to Connect > Connect Support.
   The Connect workspace opens in a new tab.

2. Click the support tab of the Connect sidebar, indicated by a headset icon (㎝).
   The support tab displays Queues to which you belong. It also displays your open support conversations under Cases. When a user starts a support conversation or an agent transfers a conversation to a queue, any agent who belongs to the associated queue can accept the conversation. An agent can also request to transfer a conversation directly to you.

3. Accept a conversation in one of the following ways.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Accept a conversation from a queue</strong></td>
<td>Under <strong>Queues</strong>, click <strong>Accept</strong> by the queue. The conversation opens in the conversation pane and an entry appears in the <strong>Cases</strong> section of the sidebar.</td>
</tr>
<tr>
<td><strong>Accept a transfer request</strong></td>
<td>Under <strong>Cases</strong>, click <strong>Accept</strong> by a transfer request. The conversation opens in the conversation pane. The agent who transferred the conversation can stay in the conversation.</td>
</tr>
</tbody>
</table>

4. Respond to the user and help resolve the issue.
   By default, your messages are added to the conversation record as comments and are visible to the user.

5. **Optional**: Initiate a Zoom meeting to help resolve customer issues faster. For more information, see [Initiate Zoom meetings from chats](#).

**Related information**
- Configure a survey in the Connect chat support

**Share knowledge in a Connect Support conversation**

The support view of the Connect workspace has a built-in knowledge tool that makes it easy to search for knowledge articles and share them in a conversation.

**Before you begin**
Role required: none
About this task
Use the knowledge tool to research user questions and provide solutions quickly and easily.

Procedure
1. Open a support conversation in the Connect workspace.
   The knowledge tool is not available in Connect mini windows.
2. In the conversation tools area to the right of the conversation pane, click the knowledge base tab, which is represented by an open book icon.

   The knowledge homepage appears in the conversation tools pane.

3. Search for articles related to the user's issue.
   For more information about finding knowledge, see Search using Knowledge Management v3.
4. To share an article in the conversation, drag a knowledge article link to the conversation pane and drop it anywhere in the drop zone that appears.
Transfer a Connect Support conversation to a different agent or queue

You can transfer a Connect Support conversation to a different agent in the queue or to a different queue.

Before you begin
Role required: none

Procedure
1. Open a Connect Support conversation.
2. At the bottom of the conversation, click the menu icon (≡) to open the Connect actions menu.
3. In the Connect actions menu, select Transfer. A transfer dialog box opens.

4. Do one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer the conversation to an agent</td>
<td>a. To start the transfer request, click Transfer by an agent's name. Be sure to choose an agent who is online. A green dot on their avatar indicates that a user is online. You can cancel the transfer any time before it is accepted.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **b.** When the transfer is accepted, select one of the following options in the dialog box that appears. | • **Stay:** Remain in the conversation, which is also known as a warm transfer. This option is ideal if you want to provide the new agent with background information or introduce the user to the new agent.  
  • **Leave:** Exit the conversation, which is also known as a cold transfer. |
3. Do one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a member</td>
<td>a. Click Add Member to Group.</td>
</tr>
<tr>
<td></td>
<td>b. Use the search field to find and select a user.</td>
</tr>
<tr>
<td>Remove a member</td>
<td>a. Point to a member name.</td>
</tr>
<tr>
<td></td>
<td>b. Click the minus icon (−).</td>
</tr>
<tr>
<td></td>
<td>The assigned support agent cannot be removed from a Connect Support conversation.</td>
</tr>
</tbody>
</table>

**Note:** Only the assigned support agent can create an incident from the Connect Support conversation.

## Escalate a Connect Support conversation

If an escalation path is defined for a Connect Support conversation, you can use a shortcut to escalate a Connect Support conversation to a different queue.

**Before you begin**

Define an escalation path for the queue, using the Escalate to field on the Chat Queue [chat_queue] table. For more information, see Administer Connect Support queues.

**Procedure**

1. Open a Connect Support conversation.
2. At the bottom of the conversation, click the menu icon (≡) to open the Connect actions menu.
3. In the Connect actions menu, select Escalate. A confirmation dialog box appears.
4. In the dialog box, click Escalate.
   The system automatically removes you from the conversation and the conversation enters the escalated queue.
Create an incident from a Connect Support conversation

You can use a shortcut to create an incident on behalf of a user, directly from a Connect Support conversation.

Before you begin
Role required: none

About this task
You might want to create an incident if you cannot resolve the user's issue over chat or if you want to create a record of the conversation to share with the user. When you create an incident from a support conversation, the system copies the conversation history to the incident activity stream as comments and work notes. Future messages are tracked in the incident as well.

Note: Administrators can customize the behavior of the Create Incident Connect action. For more information, see Administer Connect actions.

Procedure

1. Open a Connect Support conversation.

2. At the bottom of the conversation, click the menu icon (≡) to open the Connect actions menu.

3. In the Connect actions menu, select Create Incident.
   In the conversation tools area to the right of the conversation, a new incident form opens in a record tab. The system automatically sets the Caller field to the user who opened the support conversation.

4. Complete the form as necessary and click Submit.
   Any comments or work notes in the record conversation appear as comments on the incident form. Work notes do not appear in the chat for the ESS user. The chat agent can select whether a message is a Comment or Work Note in the conversation.

   a. In the record conversation, by the text entry field, click the message type icon (💬).

   b. Select Comment or Work Note.

   c. Enter a message.
   By default, record conversation messages are added as comments.

   Note: If you add an attachment to a record conversation, it is attached to the underlying record as well.
The system automatically shares the record in the conversation, copies the conversation to the record activity stream, and references the record on the Chat Queue Entry [chat_queue_entry] table. Any new journal fields added to the record do not appear in the chat. The system also changes the document ID for the conversation to reference the incident number instead of the entry in the Chat Queue Entry table.

**Connect Support chat states**

Connect Support chats move through specific states.
## Connect Support chat states

<table>
<thead>
<tr>
<th>Composite state</th>
<th>State</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Waiting</td>
<td>• Requester/end user enters a queue by sending a message. Agent has not yet accepted it.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Requester/end user rejoins a session that is in a Reopenable state.</td>
</tr>
<tr>
<td></td>
<td>Work in Progress</td>
<td>• Agent accepts a chat from a queue. Both requester and agent engage in a chat session.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Requester/end user temporarily leaves an ongoing conversation; requester or agent does not end the session; requester rejoins session.</td>
</tr>
<tr>
<td>Reopenable</td>
<td>Closed Abandoned</td>
<td>Requester/end user clicks <strong>End Chat</strong> button before agent accepts the request.</td>
</tr>
<tr>
<td>Permanently closed</td>
<td>Closed by Client</td>
<td>• Requester/end user clicks <strong>End Chat</strong> button after agent accepts the request.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Requester/end user times out.</td>
</tr>
<tr>
<td></td>
<td>Closed Escalated</td>
<td>Agent escalates an ongoing conversation by performing the Escalate action from the menu icon.</td>
</tr>
<tr>
<td></td>
<td>Closed Complete</td>
<td>• Agent ends the session.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• During a chat, if an agent creates an incident or case and closes it, the chat session closes automatically.</td>
</tr>
</tbody>
</table>

## Connect Support administration

Administrators can configure various performance settings and features of Connect Support.

ℹ️ **Note:** There are also settings that apply to both Connect Chat and Connect Support. For more information, see [Connect administration](#).
Migrate from legacy chat to Connect Support

Connect Support is an extension of Connect. Users designated as support agents have access to the support tab of the connect sidebar. Do not use Connect Support concurrently with legacy chat.

Before you begin
Before you activate Connect Support, inform your support agents to close out any existing chats.

Legacy chat uses a different field to determine which state a help desk chat is in. A fix script is included in the Connect Support plugin that circumvents this issue by closing out any existing help desk chat sessions. Manually closing out any existing chats before allowing this script to run helps prevent any loss of chat information.

If you do not close out existing help desk chats, your metrics and chat queue will not work accurately.

Procedure

1. Activate the Connect Support plugin.
   When you activate the Connect Support plugin, the `glide.connect.support.enabled` property redirects the legacy chat URL to Connect Support.
   For more information, see Activate Connect Support.

2. Hide the Social IT application.
   Activating Connect Support does not completely eliminate the legacy chat module. To prevent users from using the legacy chat, hide the Social IT application menu. For more information, see Enable or disable an application menu or module.

Properties for Connect Support

The Connect Support Properties page provides several configuration options specifically for Connect Support.

These properties are available for Connect Support.
Properties for Connect Support

Users with the admin role can access these properties by navigating to Connect > Support Administration > Properties.

ℹ️ **Note:** The Connect Properties page contains many general Connect properties that impact Connect Support.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Should Connect be used for handling chat queue entries | Disables or enables Connect Support. When the property is enabled, the Service Desk Chat button in the Employee Self-Service portal opens the conversation in Connect Support, rather than legacy chat. Additionally, the Support tab appears in the Connect sidebar.  
  • **Type:** true | false  
  • **Default value:** true  
  • **Location:** Collaborate > Support Administration > Properties |
| glide.connect.support.enabled                 |                                                                                                                                                                                                                                                                                                                                                                                                                                                                 |
| Number of support conversations an individual agent can have at one time (-1 is unlimited) | Determines how many support conversations an individual agent can have at one time. When the value is set to -1, an agent can participate in an unlimited number of conversations.  
  • **Type:** integer  
  • **Default value:** -1  
  • **Location:** Collaborate > Support Administration > Properties |
| connect.support.conversation_limit           |                                                                                                                                                                                                                                                                                                                                                                                                                                                                 |
| Show agent avatar in Connect Support conversations. | Determines whether an agent's avatar is shown.                                                                                                                                                                                                                                                                                                                                                          |

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Properties for Connect Support

Users with the admin role can access these properties by navigating to Connect > Support Administration > Properties.

Note: The Connect Properties page contains many general Connect properties that impact Connect Support.

(continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connect.support.show_agent_avatar</td>
<td>in a support conversation (enabled). When the property is disabled, users see the agent’s name only.</td>
</tr>
<tr>
<td>• Type: true</td>
<td>false</td>
</tr>
<tr>
<td>• Default value: true</td>
<td></td>
</tr>
<tr>
<td>• Location: Collaborate &gt; Support Administration &gt; Properties</td>
<td></td>
</tr>
<tr>
<td>connect.support.idle.delay</td>
<td>Determines how many seconds a user must be inactive in a support conversation before an idle countdown timer appears.</td>
</tr>
<tr>
<td>• Type: integer</td>
<td></td>
</tr>
<tr>
<td>• Default value: 120</td>
<td></td>
</tr>
<tr>
<td>• Location: Collaborate &gt; Support Administration &gt; Properties</td>
<td></td>
</tr>
<tr>
<td>connect.support.idle.count_down</td>
<td>Determines how many seconds the idle countdown timer remains open after it appears. If the idle user does not dismiss the timer before the countdown completes, the system closes the support session.</td>
</tr>
<tr>
<td>Number of seconds to count down from before marking end user as having left their support session</td>
<td></td>
</tr>
</tbody>
</table>
Properties for Connect Support

Users with the admin role can access these properties by navigating to Connect > Support Administration > Properties.

Note: The Connect Properties page contains many general Connect properties that impact Connect Support.

(continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Type: integer</td>
<td>Limits the number of closed conversations that the support user can see. (0 = unlimited)</td>
</tr>
<tr>
<td>• Default value: 60</td>
<td>connect.support.user.closed.conversation_limit</td>
</tr>
<tr>
<td>• Location: Collaborate &gt; Support Administration &gt; Properties</td>
<td>Determines how many closed conversations appear in a user's support conversation history. When the value is set to 0, all previous conversations appear in the history.</td>
</tr>
<tr>
<td>• Type: integer</td>
<td>• Default value: 0</td>
</tr>
<tr>
<td>• Location: Collaborate &gt; Support Administration &gt; Properties</td>
<td></td>
</tr>
</tbody>
</table>

Administer Connect Support queues

You can define the support agents, default messages, schedule, and escalation path for each Connect Support queue.

Before you begin
Role required: admin

About this task

Note: Both Connect Support queues and legacy chat queues are stored on the Chat Queue [chat_queue] table. Do not use Connect and legacy chat concurrently.
**Procedure**

1. Navigate to **Connect > Queues**.
2. Click **New** or open an existing queue from the list.
3. Complete the Chat Queue form, as appropriate.

### Chat Queue form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the queue.</td>
</tr>
<tr>
<td>Active</td>
<td>Not used in Connect.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>User group that contains the support staff for the queue. Any user in the group can view the queue in the Connect sidebar and accept chats. No other users can access the queue. This field must be populated.</td>
</tr>
<tr>
<td>Average wait time</td>
<td>Average time it takes for an agent to accept a chat in the queue. This value is automatically calculated. Do not manually edit.</td>
</tr>
<tr>
<td>Confirm problem</td>
<td>Not used in Connect.</td>
</tr>
<tr>
<td>Escalate to</td>
<td>Different queue to which an agent can escalate a chat. For example, there is a queue for high priority support chats. When a queue is defined in this field, agents can access the <strong>Escalate</strong> option in conversations.</td>
</tr>
<tr>
<td>Initial agent response</td>
<td>Message that users see when an agent accepts their chat. For example, <em>Thank you for contacting support. We are looking into your question now and will be with you shortly.</em></td>
</tr>
<tr>
<td>Not available</td>
<td>Message that users see when they attempt to start a chat outside the defined queue <strong>Schedule</strong>. You can use HTML to format the message and include links or media.</td>
</tr>
<tr>
<td>Question</td>
<td>Initial phrase that users see when they start a new chat in the queue. For example, <strong>How can I help you?</strong></td>
</tr>
<tr>
<td>Schedule</td>
<td>Schedule that defines when the queue is available. Leave the field blank to make the queue available all the time. Users cannot start a new conversation in the queue outside the schedule hours.</td>
</tr>
</tbody>
</table>
4. To review conversations associated with the queue, add the Chat Queue Entries related list and review the records for the following information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>How long the user waited and the result</td>
<td>Review information in the State and Wait time columns.</td>
</tr>
<tr>
<td>Who is actively helping employees in the queue</td>
<td>Review the names of agents in the Assigned to column.</td>
</tr>
</tbody>
</table>

**Make a Connect Support queue accessible to end users**

To make a Connect Support queue accessible to end users, use the accepted URL format.

**Before you begin**
Create a queue. Create agents for the queue by assigning users to the assignment group associated with the queue.
Role required: admin

**About this task**
For example, you might create a module or add a link to a portal.
The accepted URL format is `https://<instancename>.service-now.com/$chat_support.do?queueID=<sys_id>`.

**Procedure**
1. Navigate to Connect > Administration > Queues.
2. Right-click the name of the queue to which you want to link.
3. In the context menu, select Copy sys_id. Follow browser instructions to copy the sys_id if browser security measures restrict this function.
4. Preview the support queue by navigating to `https://<instancename>.service-now.com/$chat_support.do?queueID=<sys_id>`.
5. Create a module or other link to the queue using the URL.

**Add a scripted extension point for Connect Support chats**

Implement the ConversationServerInteractionService extension point, which enables you to create custom scripts that use context variables from pre-chat surveys presented to requesters in the Agent Chat client.
Before you begin
Role required: admin

Procedure

1. Navigate to **System Extension Points > Scripted Extension Points** and select the **ConversationServerInteractionService** scripted extension point.

2. Click the **Create implementation** related link to create a new custom script include.

3. In the Script Include form, create the code that uses the pre-chat context variables to route chats to the appropriate Connect Support queue.

4. Click **Update**.

Results

The custom script is created and registered against the **ConversationServerInteractionService** scripted extension point.

Connect Support metrics

Optional plugins provide a homepage and Performance Analytics dashboards, which contain helpful Connect Support metrics.

The reporting homepage is ideal for support managers who want a simple solution to track the recent performance of the support organization. The Performance Analytics dashboards provide a more full-featured solution for support managers who want to analyze trends over time.

Users with the admin role can activate the following plugins to use these features.

<table>
<thead>
<tr>
<th>Connect Support homepage and dashboard plugins</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect Support Manager's Dashboard [com.glide.connect.managers_dashboard]</td>
<td>Provides a homepage for Connect Support, and all required configuration records. Though the plugin name contains the term dashboard, the plugin does not provide functionality related to Performance Analytics dashboards. Homepages are similar to dashboards, but</td>
</tr>
<tr>
<td>Plugin</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Performance Analytics - Context Sensitive Analytics for Chat [com.snc.pa.chat.context_sensitive_analytics]</td>
<td>Provides in-form analytics for Connect Support. These analytics are available as a related link on the Chat Queue Entry [chat_queue_entry] form, and also as the Context Sensitive Analytics - Chat dashboard.</td>
</tr>
</tbody>
</table>

Note: For more information about these plugins, including which other plugins they activate, see Additional plugins for Connect Support.

Related information

Use the Connect Support homepage
Use the Connect Support homepage to view key indicators and metrics related to support conversations, queues, and agents.

Before you begin
Activate the Connect Support Manager's Dashboard plugin (com.glide.connect.managers_dashboard) to view this homepage.
Role required: chat_admin

About this task
The homepage is called Service Desk - Chat.

Procedure
1. Navigate to Connect > Support Administration > Reporting Dashboard.

Note: Though the module name contains the term dashboard, the module does not provide functionality related to Performance Analytics dashboards. Homepages are similar to dashboards, but do not require Performance Analytics roles to view.
The Connect Support homepage, which is called **Service Desk - Chat**, opens.

2. Click a widget to drill down into its data.

**Use the Connect Support dashboards**

Use the Connect Support dashboards in Performance Analytics to understand trends in your support organization's performance over time.

**Before you begin**

Activate one or both of the following plugins, according to your analytics needs:

- Performance Analytics - Content Pack - Service Desk Chat (com.snc.pa.chat)
- Performance Analytics - Context Sensitive Analytics for Chat (com.snc.pa.chat.context_sensitive_analytics)

Role required: both chat_admin and pa_viewer

**About this task**

The Performance Analytics - Content Pack - Service Desk Chat plugin (com.snc.pa.chat) includes the **Service Desk Chat Monitor** dashboard, which contains the following tabs:

- **Chat Monitor By State**: Contains metrics related to closed support conversations.
- **Overview**: Contains several metrics related to support conversations, queues, and agents.
- **KPI Process**: Contains metrics that are key performance indicators (KPIs) of the Connect Support process, including the average queue response time, the average duration of support conversations, and the number of new support conversations per day.

The Performance Analytics - Context Sensitive Analytics for Chat plugin (com.snc.pa.chat.context_sensitive_analytics) includes the **Context Sensitive Analytics - Chat** dashboard. The dashboard contains additional metrics related to support queues, including the number of support conversations closed.

**Note**: You must license Performance Analytics to collect scores for the indicators on the dashboards. Without Performance Analytics premium, the dashboards display the indicators with no data.
Procedure

1. Navigate to Performance Analytics > Dashboards.
   The last dashboard you viewed opens.
2. In the dashboard picker, under the Connect Chat group, select the dashboard you want to view.
3. View the indicators.

Related information

Configure the add support users property
To enable support agents to add users to a Connect Support conversation, add the glide.connect.support.add_members property.

Before you begin
Role required: admin

About this task
When the glide.connect.support.add_members property is added and enabled, support agents can add users to a support conversation. Any added user can also add other users. Only the assigned agent can create an incident from the chat. When non-support agents are added to a chat, the chat appears in their chat tab.

⚠️ Note: Make sure you are in the Global scope when adding this property.

Procedure

1. Enter sys_properties.list in the navigation filter.
   The entire list of properties in the System Properties [sys_properties] table appears.
2. Verify that the property does not exist by searching for the property name. If it does exist, update the property with the information in the following table.
3. Click New.
4. Complete the form as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.connect.support.add_members</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>Type</td>
<td>true</td>
</tr>
<tr>
<td>Value</td>
<td>true</td>
</tr>
</tbody>
</table>

## Service Desk Chat Analytics and Reporting Solutions

Analytics and Reporting Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With Analytics and Reporting Solutions, you can get value from Performance Analytics for your application with minimal setup. You can always create your own objects as well.

⚠️ **Important:** Set up and test Analytics and Reporting Solutions on a non-production instance before enabling them in production.

⚠️ **Note:** Analytics and Reporting Solutions provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see Configure Analytics and Reporting Solutions.

To enable the solution for Service Desk Chat, an admin can navigate to **Performance Analytics > Guided Setup**. Click **Get Started** then scroll to the section for Service Desk Chat. The guided setup takes you through the entire setup and configuration process.

### Related information

- Analytics and Reporting Solutions
- Activate your Performance Analytics subscription

### Connect Support and Service Portal

Use Connect Support in your portal to allow your users to ask questions or submit requests to support agents. You configure the instance options to control the appearance of your widget and how it functions.

The Connect Support and Service Portal integration creates a Connect Support widget that you can add to a page in the Service Portal.
Activate Connect Support for Service Portal

Activate the Connect Support and Service Portal integration plugin so you can add the Connect Support widget to a portal page.

Before you begin

Important:
Starting with the Paris release, Connect Support no longer receives enhancements or non-priority bug fixes. Consider moving to ServiceNow® Advanced Work Assignment and Agent Chat in workspace to automatically assign chat requests and other work items to agents. For details, see Move from Connect Support to Advanced Work Assignment and Agent Chat.

Role required: admin

About this task
Activating the Connect Support and Service Portal integration plugin automatically activates the Connect Support plugin.

Procedure
1. Navigate to System Definition > Plugins.
2. Search for and activate the Connect Support and Service Portal integration plugin [com.glide.connect.support.service-portal].

What to do next
After activating the plugin, the Connect Support widget appears in the list of widgets under Service Portal > Widgets. Use Connect Support in a portal by adding the widget to any page within the portal. For more information on adding a widget to a page, see Create and edit a page using the Service Portal Designer.

Connect Support widget

Chat Support

Click here to start a chat

Avg wait: 30 Seconds
Configure Connect Support widget instance options

You can control the appearance of your widget and how it functions by configuring the instance options.

Before you begin
Role required: admin

Procedure

1. Navigate to Service Portal > Service Portal Configuration and open the Service Portal Designer.

2. From the Service Portal Designer, select the page you added the Connect Support widget to. If you have not yet added the widget to a page, see Create and edit a page using the Service Portal Designer for more information.

3. Click the edit icon in the corner of the widget to open the instance options menu.

4. Complete the fields using the following table. Depending on the functionality you want to add, you may not need to add all these fields. For example, if you include the Queue ID, you do not also need to include the Queue Name or the Queue URL.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>Select a color for your widget from a list of common bootstrap colors. Themes control the overall color of a widget, but if you want your widget to be a specific color, you can select it from the list.</td>
</tr>
<tr>
<td>Queue URL</td>
<td>The URL for the Connect Support chat queue that you want questions to be directed to. For example, https://&lt;instancename.service-now.com/$chat_support.do?queueID=&lt;sys_id&gt;</td>
</tr>
<tr>
<td>Queue Name</td>
<td>The name of the queue you want the questions to be directed to. You can find a list of queue names in Collaborate &gt; Connect Support &gt; Queues.</td>
</tr>
<tr>
<td>Queue ID</td>
<td>The sys_id of the queue you want questions to be directed to. You can find this ID by going to the support queue and either copying the queue ID from the support link, or by selecting Copy sys_id from the context menu.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Message</td>
<td>The text for the button in the Connect Support widget</td>
</tr>
<tr>
<td>Window</td>
<td>Use this option to open the chat in another tab rather than in a new window.</td>
</tr>
<tr>
<td>Title</td>
<td>The name in the widget header</td>
</tr>
</tbody>
</table>

**Content Management System**

The Content Management System (CMS) is a ServiceNow application that enables users to create a custom interface for the ServiceNow platform and ServiceNow applications.

The CMS application is powerful and flexible. Customers use it for a wide variety of projects, from creating entire websites to integrating with other products. The Content Management application is active by default.

This video provides an overview of the CMS application.

**CMS application**

A CMS typically requires a systems administrator or a web developer to set up and add features. Non-technical users can use the CMS application as a tool for website maintenance. You also want to consider the timing of the addition of content management, and the maturity level of ServiceNow data. For more information, see [CMS Planning](#).

Following are several CMS project ideas:

- Design a company-wide service catalog that offers a collection of services.
- Present a customized UI for a knowledge base.
- Create customized login pages, search pages, views of lists, tables, charts, or graphs.
- Design a complete website.
- Integrate ServiceNow with other company applications.
- Build a tailored self-service portal for end users that is in compliance with a corporate style guide.

**Example CMS sites**

There are two common interface approaches within the ServiceNow community:

- An image and text-based interface similar to Amazon.com
- A search-based interface similar to Google

© 2021 ServiceNow, Inc. All rights reserved.
Both approaches have been used successfully. The approach you select depends on the needs of the people using the data and how easy it is to train them. While the two design philosophies are different, both approaches share the common goal of UI simplicity.

**Activating CMS**

You must request the Content Management System (CMS) application from ServiceNow personnel. Instead of activating CMS, use Service Portal for new development. Service Portal is an alternative to CMS with a refined user experience, and is active by default in the base system. See Service Portal and Content Management and Service Portal.

**Content Management design**

Before building a website in the CMS, it is important to have a good understanding of what to build and who the audience is.

A high volume of content can heavily influence the look and feel of the site and the site hierarchy. When deciding the content, design for ease of maintenance for the people who take care of the system. This level of planning can be time-consuming, but is important.

Review website design prerequisites to help you set expectations, scope deliverables, and define reasonable time lines. Consider both the planning and execution of site design, to understand how sites are built, and to provide a working overview of the CMS.

Timing is important when considering the addition of content management. Successful deployments of the content management system usually take place after phase 1 processes (for example, Incident, Problem, Change, Catalog, and Knowledge) are in place. This is especially true if the team has limited website design experience. Waiting until phase 2 of deployment gives administrators time to work in ServiceNow and to understand how the organization uses the system and what business needs it meets.

Also consider the maturity level of data in the ServiceNow system. Depending on the ITIL processes used, content management is only useful and effective once the data within ServiceNow is established. Ensure that hierarchies, tasks, and workflows are well-defined. For example, before creating a catalog interface, confirm that the service catalog has been in place for some time, has been used, and contains data. The same is true for a knowledge management interface, particularly when high ratings or view counts define article placement on the page.
Content organization

Before you begin to build the CMS website, list all the content that you want to include and take the time to organize it.

A site created in CMS relies on two different types of content.

• CMS site information, such as site pages, images, and menus
• System information, such as knowledge base articles and catalog items

CMS content

Begin by listing all the content you want to host on the CMS pages. Examples include help pages, My Requests, My Approvals, and specific catalog items. Think about current solutions that you can implement immediately, and note ideas for future implementation phases.

Within CMS, you group pages to define the top-down menu structure. You establish a home or starting page, and other pages in the site reference the home page in the Parent Page reference field.

There are several ways to group, such as by audience or the purpose of the website. After listing the content to host, group it logically and identify a common name for each group, as shown in the following examples.

<table>
<thead>
<tr>
<th>IT environment groups</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Content built for</td>
<td>Common name</td>
</tr>
<tr>
<td>End user</td>
<td>End User Page</td>
</tr>
<tr>
<td>IT professional</td>
<td>IT Professional Page</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General groups</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose of site</td>
<td>Common name</td>
</tr>
<tr>
<td>Reports</td>
<td>Reporting Page</td>
</tr>
<tr>
<td>Help and knowledge</td>
<td>Knowledge page</td>
</tr>
</tbody>
</table>

System content

Organize the content so the interface is easy to navigate and understandable to the user. Determine the organization based on the data that you are leveraging, both in the CMS (using sites, parent pages, pages, and navigational menus) and throughout the rest of the system. For example, within the catalog you have "category," and in the knowledge base you have "category" and...
"subcategory." You can use these hierarchies with filtered lists for good search results.

Organizing CMS content logically is important for long-term maintenance of the site, however, the data typically comes from other ServiceNow applications. Communicate with the administrators for these applications, such as the knowledge base, service catalog, and business service portfolio. Work with them to offer the application data appropriately through the CMS pages you create. For example, the team that created the ServiceNow corporate website in CMS began by evaluating the naming conventions used in the corporate knowledge base.

**Branding elements**
Branding refers to the logo, name, colors, and symbols that identify an organization. It imposes consistency in design and use of terms. Your marketing department defines branding elements and can provide them to you as you plan your CMS pages. Consider how to incorporate the following branding elements.

- Logos
- Color palette
- Tag line
- Trademarked elements
- Graphics

**Site design**
During planning, consider providing a core set of features with a standard appearance throughout the site. The following web design elements are often used to create a consistent look.

- Page templates
- Navigation schemes
- Header
- Breadcrumbs
- Footer
- Forms

**ServiceNow features**
Analyze and organize the following ServiceNow features in your instance if you plan on using any of them with CMS pages.
Team member identification

Identify the team members who assist you with website design, branding, and development.

Engage team members for each listed function before you begin to build pages for the CMS website. Each function can be performed by the same or different people.

- Gather corporate style design guidelines.
- Define the written terminology and content for the site.
- Gather and define the site flow.
- Manage the CMS project as the webmaster. The CMS webmaster is responsible for executing the design and making the site work. The following skills are required:
  - Basic ServiceNow administration skills
  - HTML
  - CSS
  - Graphic design
  - Web design

After you identify the project team members, establish who is responsible to complete the tasks involved in building the CMS website.

- Determine who owns each page.
- Set a page update schedule so owners do not overwrite each other.
- Formalize content management processes, including content review and page updates.

Data preparation

It is important that there is enough data in the ServiceNow instance before you begin to build the CMS website.
Ensure that the necessary data and content are available in the instance by taking the following actions.

- Review the ITIL processes that you intend to implement in the CMS. Ensure that the data in the instance is a mature representation of the applications being used, for example, service catalog, knowledge management, and incident management.

- Review the defined hierarchies, such as the categories and subcategories for the knowledge base or service catalog. You use these categories to design the entry page into the application.

**Corporate style guide**

When you build a CMS website, you design the look and feel based on guidelines in the corporate style guide.

A corporate style guide provides detailed information for designing any corporate interface, including corporate websites.

**Corporate design team**

Many organizations have a web development team that designed the corporate website. Contact this team and involve the designers early in the planning, as they provide help and give their approval to the interface you design. Without approval, there is the risk of having to redesign the entire site because it does not adhere to the organizational guidelines.

**Corporate style guide**

A corporate style guide takes the guesswork out of designing the CMS website. The example style guide shown is defined down to the pixel. Creating a site with the style guide makes it easy to create clean CSS and HTML. Without the style guide, building the site can take a great deal of time.

**Design considerations**

Some modifications to the base design for forms may be necessary. The content area of any CMS design should be no smaller than 860px, or service catalog forms are clipped. The sample style guide entry specifies the content area to be 576px, which clips service catalog forms.
Prototypes and rapid web design

Many user interface designers use prototypes and rapid web design techniques to visualize the final product before it is developed.

Design revisions are the most time consuming and expensive phase of site design. When the team analyzes and then uses prototypes to create pages, revisions to the published pages are minimal.

Develop the prototype and print it. Review the design with the appropriate team members and annotate the prototype, and annotate what to update on each page.
Define the following elements within the prototype.

- The site map for the entire site.
- A detailed prototype of every intended page, including elements such as links, link destinations, content, page names, and page descriptions.

**Content Management navigation**

After you design the hierarchical structure of the site, begin planning site navigation.

Consider the following as you plan site navigation.

- Placing navigation elements on every page.
- Locating navigation elements in the same place on every page.
- Using either text or images for navigation.
- Providing visitors with an easy way to understand where they are in the site, for example, with breadcrumbs or a specific color scheme.
- Adding a site map, which is a one-page, hyperlinked, hierarchical outline of the site.
- Providing a link to the home page from every site page, as visitors often enter the site on a page other than the home page.
- Designing navigation to help visitors find information quickly with as few clicks as possible.

In the CMS, navigation menus define your site navigation. Build menus as navigational blocks to create navigation paths. The menu chosen for the task depends on the size and complexity of your site. Available menu options include the following items.

- List menus
- Two types of tab menus
  - Vertical, clickable list, usually placed on the left side
  - Horizontal blocks
- Vertical blocks
- Super menu (a menu of menus)
**System content management**

Most of the content in a CMS site is managed in different locations throughout the system.

For example, if you are building a knowledge website, the pages and blocks exist in CMS, but the knowledge articles are authored and managed in the Knowledge application. The same is true for any other type of content you plan to leverage. It is important to take time to understand the table structure of data to become acquainted with content.

Links to content are typically static, however, take time to look at the document tree and review how field values are formatted for use within the CMS. To understand the information provided below, right-click within forms in the platform and select **Show XML** to view the document tree for the referenced table. To see the table values for each field, right-click the form label and choose **Show - (field name)** or **Configure Dictionary** for reference.

Look at several internet news sites for ideas on how to format dynamic list data and also the full article detail. Research blog sites, shopping sites, and any other site you find easy to use, as layout and usability design can be time-consuming. If you find a site that inspires you, emulate it in your design.

- This [New York Times example](#) has two separate list formats.
- The [CNN example](#) has several list formats on the page.
- Several different list formats are used on the ServiceNow website.

**Knowledge articles - kb_knowledge table**

When you right-click and select **Show XML** on any form within the system, the document tree for the referenced database table becomes reference-able. Review the following selected subset of the document tree so you can acquaint yourself with the content readily available to your site design.

```xml
<kb_knowledge>
  <active>true</active>
  <author display_value= "First Last Name" >Use this field value if author name is important</author>
  <short_description>Use this field value as the link to the full article detail</short_description>
  <description>Provide this field value as a 1-2 sentence summary of the article</description>
  <number>Unique ID can be leveraged in a number of different ways</number>
  <published>Published time stamp of the article</published>
  <rating>This field value provides a 1 to 5 star rating similar to iTunes</rating>
  <sys_updated_on>Add to supplement article published timestamp</sys_updated_on>
  <sys_view_count>8</sys_view_count>
</kb_knowledge>
```
Useful field value in creating hierarchical breadcrumbs

Also useful in organizing articles hierarchically

Use this similar to Facebook's "like" feedback, answer to the question was this useful

<?xml version= "1.0" encoding= "utf-8" ?>
<j:jelly trim = "false" xmlns:j = "jelly:core" xmlns:g = "glide" xmlns:j2 = "null" xmlns:g2 = "null" >
<div class = "cms_knowledge_list customer_success" >
<g:for_each_record file = "${current}" max = "${jvar_max_entries}" ><br />
<table cellspacing = "0" cellpadding = "0" border = "0" class = "background_transparent" >
<tr><td class = "cms_knowledge_list_image" >
<j:if test = "${current.u_logo.getDisplayValue() != ''}" >
<div class = "knowledge_article_logo" >
<a href = "knowledge.do?sysparm_document_key=kb_knowledge,${current.sys_id}" >
<img src = "${current.u_logo.getDisplayValue()}" alt = "${current.text}" width = "110px" />
</a>
</div>
</j:if>
</td>
<td width = "100%" >
<a href = "knowledge.do?sysparm_document_key=kb_knowledge,${current.sys_id}" target = "_top" >
<span class = "cms_knowledge_list_link" >${current.short_description}}</span>
<p class = "kb_description" >"${current.description}"
</p>
</a>
</td></tr>
</g:for_each_record></div>
</j:jelly>
Domain separation and the Content Management System

Domain separation is supported in the Content Management System. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: No support

• The domain field may exist on data tables but there is no business logic to manage the data.
• This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation.

Related information

Domain separation for service providers

Configure Content Management sites

Planning a CMS site involves obtaining resources, communicating with others about design, and gathering content.

Before you begin
Role required: content_admin or admin

About this task
The following steps are a high-level overview of how to set up a site.

Procedure
1. Plan and design your content.
2. Create a site.
   The site is the container that holds all the content. To simplify your process, you can copy an existing site and edit its components. For more information on creating a site, see Create a site. For more information on copying a site, see Copy a site.
3. Add pages to the site.
   Pages contain blocks of information for the site. For more information, see Create a content page.
4. Create content blocks to customize the layout, headers, menu navigation, lists, and static and dynamic content.
Content blocks are chunks of actual HTML that make up the content page. There are various content block types available to help with your customization. For more information, see Content blocks.

5. Add style to your site using themes, style sheets, and frames. Neither content sites or content pages reference style sheets directly. Configure them using the Themes or Style Sheets options. For more information, see Style in Content Management.

6. Test the site.
After you create or modify a site, test the site to ensure that content displays properly and all links work correctly. For more information, see Test the site.

Related information
Content Management design

Content sites
A content site is a group of related content pages that have the same basic theme, layout, and URL suffix.
Content sites are made up of a series of basic building blocks. The Employee Self-Service site is an out-of-box sample site that is included in the CMS activation. It provides existing, working examples or each CMS component, which you can use like a template to build your own site.

Site components

[Diagram of site components]
Create a site

Configure a site by either creating a new site with CMS or by editing a copy of either the ESS Portal or the Service Management Portal.

Before you begin
Role required: content_admin or admin

About this task
If you are creating a catalog site in CMS, follow the steps in Manage catalog sites in Service Catalog

Procedure
1. Navigate to Content Management > Sites.
2. Click New.
3. Complete the form.
   Since you have not yet created pages, you cannot select the Home, Search, Login, and Gauge target pages. Add them to the site record after you create them.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the site.</td>
</tr>
<tr>
<td>URL suffix</td>
<td>The URL suffix that identifies the site. The URL suffix is case-sensitive, the suffix you enter impacts the CMS site URL used to launch the site. It is incorporated into the URL as follows: http://&lt;instance name&gt;.service-now.com/url_suffix/page.do</td>
</tr>
<tr>
<td>Note:</td>
<td>Do not use portal and cms in the URL suffix. They are reserved terms and return a Page not found if you use them.</td>
</tr>
<tr>
<td>Home page</td>
<td>The page to display when the user does not specify a page name in their URL: http://&lt;instance name&gt;.service-now.com/url_suffix/</td>
</tr>
<tr>
<td>Search page</td>
<td>The page that displays search results when a user searches from any page within the site.</td>
</tr>
<tr>
<td>Login page</td>
<td>The page to use for logging in to the site. If specified, users must log in to access the pages on the site. If left blank, no login is required to access the pages within the site.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Gauge target page</td>
<td>The page that displays gauge content. When the user clicks a gauge on the new site, the gauge target page opens to show the gauge content. The gauge target page replaces the CMS page in the current tab.</td>
</tr>
<tr>
<td>Title</td>
<td>A title for the site. The title can be the same as or different from the Name.</td>
</tr>
<tr>
<td>Description</td>
<td>A full description of the site.</td>
</tr>
<tr>
<td>Default layout</td>
<td>The layout for pages to use by default. Any page in the site that has a blank Layout field uses the layout selected in this field.</td>
</tr>
<tr>
<td>Default theme</td>
<td>The theme for pages to use by default. Any page in the site that has a blank Theme field uses the theme selected in this field.</td>
</tr>
<tr>
<td>Simple catalog display</td>
<td>Selecting this option simplifies catalog pages in the site by hiding the search bar, breadcrumbs, and the results per page choice list. It also prevents you from adding attachments from record producers to your CMS site.</td>
</tr>
<tr>
<td>Use external cart</td>
<td>Option to omit the default cart when rendering catalog pages within a site that contains catalog pages. Provide a catalog cart block somewhere on the site to allow users to make catalog requests.</td>
</tr>
</tbody>
</table>

**Note:** If you use an external cart, the no cart check box on a service catalog item has no effect. The external cart appears for all items.

4. Click **Submit**.

**Example:**
The following is the site record for the ESS Portal:
Related information

Copy a site

Copy a site

To create a new site quickly, you can copy an existing site.

Before you begin

Role required: content_admin or admin

About this task

The site copy option creates a complete standalone copy of the site and all its resources. If you are copying a site to create a second site, use this option after the first site is complete, tested, and production ready. This consideration is important because the blocks, CSS, and pages are duplicated to support the new site. There are various reasons why site copying is useful, such as site versioning, branding, or creating a backup.

Images are not included when you use the Copy Site option. They are stored separately in the sys_attachments table.

To copy just a few pages without duplicating all the resources (CSS, blocks, menus), use the page copy option. Page copy duplicates the page but not the resources used in the page. For more information, see Copy a page.
Procedure

1. Navigate to Content Management > Sites > [Site Name].
2. On the Site form, click Copy.
3. In the dialog box that opens, type a name for the new site.
   This name is a prefix for all the site elements that are duplicated. Do not use Portal or CMS in the site name.
   A progress bar shows the copy process. When the process is complete, the Site form shows information for the new site.

Related information

Create a site

Content Management security

There are several methods for securing CMS sites and pages. Site security is set in the Login page field on the site record. You can control if a page is public or private through the URL.

Every content page has its own URL that users can access outside of the platform. Depending on how the Login page or roles are defined, the URL may or may not be public.

- If the content page has no defined Read role or there is no defined Login page, any internet user can navigate to the URL and view the content page.
- If there is a defined Read role, then anyone who goes to the URL is asked to log in before they can view the site.
- If there is a defined Login page on the site record, all pages in the site are private.

Content Management URLs

The format for Content Management URLs is as follows.

<path to the instance> + /<site suffix> + /<page suffix> + .do

The <site suffix> is defined by the URL Suffix field on the site form. The <page suffix> is defined by the URL Suffix field in the page form. The URL suffix is case-sensitive.

For example, the page Austere - Site Entry has a site URL Suffix of austere and a page URL Suffix of entry. The constructed URL looks like the following URL.

<instance name>.service-now.com/austere/entry.do
If the site **URL Suffix** field is left blank, the `<site suffix>` is **cms**, as shown in this example:

```
instance.service-now.com/cms/page.do
```

If the page **URL Suffix** is left blank, the name of the page is used as shown in this example:

```
instance.service-now.com/austere/Page Name.do
```

Special characters in the name of the page have to be escaped.

**Login pages instead of login rules**

You set a login page on the site record to allow users to log in or out directly through the content site.

Login rules were used in earlier versions to dictate what users saw after logging in, based on their roles or permissions. Login rules still work, but their use is deprecated.

**Configure CMS sites to use single sign-on (SSO)**

To configure CMS to use SSO, make the view_content page private.

**About this task**

Because public pages do not require login, and CMS sites are public by default, CMS pages do not use SSO. Use the following procedure to turn off public-facing content pages and enable SSO.

**Procedure**

1. Navigate to Public Pages [sys_public.list].
2. For the view_content page, set **Active** to **false**.

**Content pages in CMS**

Content pages are the core of the Content Management System. A content page is a web page that displays blocks of content.

Pages are built from content blocks and organized into sites. Pages display as regular webpages that are rendered in HTML. Constructing a content page requires a basic knowledge of HTML. Content pages are formed by arranging content blocks in predefined layouts. They can be used to present login pages, search pages, or ServiceNow content.
Create a content page

Pages are built from content blocks and organized into sites.

Before you begin
Role required: content_admin or admin

Procedure
1. Navigate to **Content Management > Sites**.
2. Open the site to add the page.
3. In the **Pages** related list, click **New**.
4. Complete the form.

**Page form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the page. Prefix each page name with the name of the site followed by a dash and the page function. For example, <strong>ESS - Catalog Detail</strong> and <strong>ESS - Search Results</strong> are page names within the <strong>ESS</strong> site.</td>
</tr>
<tr>
<td>URL suffix</td>
<td>The URL suffix that identifies the page. It is incorporated into the URL as follows: <a href="http://instance">http://instance</a> name.service-now.com/site/url_suffix.do</td>
</tr>
<tr>
<td>Parent page</td>
<td>The existing page that is the parent of the current page. Parent pages keep sections sortable on the site list of pages and are used to create breadcrumbs dynamically. Use CSS to define menus that give the Parent page context within the user interface.</td>
</tr>
<tr>
<td>Layout</td>
<td>The layout to use for the page. Layouts define dropzones where content blocks can be added to the page. If this field is left blank, the page inherits the default layout of the site. If the site does not have a default layout, there is a single dropzone for the entire page.</td>
</tr>
<tr>
<td>Content theme</td>
<td>The theme to use for the page. Themes bundle CSS style sheets that are applied to all content within the page. If this field is left blank, the page inherits the default theme of the site. Use the default theme unless the page requires a different set of CSS style sheets from the other pages in the site.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Frame buster</td>
<td>Select the check box to remove any restrictions placed by frames that contain the page. This way you avoid frame-within-frame issues that sometimes occur with improper linking.</td>
</tr>
<tr>
<td>Content site</td>
<td>The site associated with the content page. If you created the page from the related list in the site, the value defaults. The content site provides the &lt;site_suffix&gt; in the page URL, as follows: http://&lt;instance name&gt;.service-now.com/site_suffix/page_suffix.do</td>
</tr>
<tr>
<td>Read roles</td>
<td>Users with the selected roles can view the page. Click the lock icon to select roles.</td>
</tr>
<tr>
<td>Model document</td>
<td>A document ID of a record to display by default.</td>
</tr>
<tr>
<td>Page status</td>
<td>The status for the page, such as Draft or Published.</td>
</tr>
<tr>
<td>Created by</td>
<td>The user who created the page. If your role has higher privileges than your user name and you enter your user name, the field defaults to the role. For example, if you are logged in as an Admin and you type your name, which has lower privileges, this field displays Admin.</td>
</tr>
<tr>
<td>Title</td>
<td>The title for the page. The title displays on the browser tab when the page is accessed.</td>
</tr>
<tr>
<td>Description</td>
<td>Type a description of the page that displays for users when they access the page.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Add content to a page

After you define the page settings, set the content of the page by adding content blocks. Setting content blocks is similar to how you add content to homepages.

Before you begin
Role required: content_admin or admin
Note: Do not add any type of report, such as a calendar, to iFrames. For more information on adding a report directly onto a page without using iFrames, see Embedding reports in Jelly.

Procedure
2. Click Add Content.
3. Select a content block from the picker.
4. Select the dropzone where the content goes.
   Create content blocks by adding one of the content blocks named *New [block type] to the page.

Related information
Content blocks
Copy a page

Copying pages is an efficient way to avoid duplicating the same work and to create pages quickly from a guiding base template.

Before you begin
Role required: content_admin or admin

Procedure
1. Navigate to Content Management > Sites and select the site.
2. Select the page to copy.
3. Click Copy.
4. Rename the page.

Note: Do not use service_catalog to rename a page. It is already a valid page in the system.
5. Edit the page fields.
6. Click Update.

Assign a page to a site

If you have created multiple sites, you can add pages from one site to another site.

Before you begin
Role required: content_admin or admin

Procedure
1. Navigate to Content Management > Sites.
2. Select a site.
3. In the Pages related list, click Edit.
4. Select other pages to include in the site.
5. Click Save.
6. Update the site.
Add a page to an application

Homepages and content pages are not added automatically to update sets and applications. They must be manually added.

Before you begin
Role required: content_admin or admin

Procedure
1. Navigate to Content Management > Pages.
2. Right-click a content page record.
   The page is added to the current application and to the current update set.

Configure a private UI page for CMS links

With single sign-on (SSO) in place, you can generate email links that take users directly to tickets and applications through the CMS interface.

Before you begin
Role required: content_admin or admin

About this task
You accomplish this procedure by creating a private UI page to redirect CMS links. Because the page is not public, it requires authentication and redirects to SSO appropriately.

Procedure
1. Check that your CMS site is private by completing the following steps.
   a. Navigate to Content Management > Sites > [Your Site]
   b. Verify that the Login page field has a page listed.
2. Create a new UI page by completing the following steps.
   a. Navigate to System UI > UI Pages.
   b. Click New.
   c. Enter a Name, for example, redirector.
   d. Enter the following Adobe Jelly code into the HTML field.
The CMS now supports email links with following format:

http://<path to instance>/<UI page>.do?uri=/<CMS suffix>/<record type>.do %26sys_id=<record ID>

For example:

http://<instance name>.service-now.com/redirector.do?sysparm_uri=/ess/incident.do%26sys_id=46e3e949a9fe19810069b824ba2c761a

Note: If you are using SAML 2.0 update 1 for SSO, use the UI page saml_redirector instead of creating a new UI page. For example, an email link to a SAML 2.0 redirector page would use the URL format: http://<instance name>.service-now.com/saml_redirector.do?sysparm_uri=/ess/incident.do%26sys_id=46e3e949a9fe19810069b824ba2c761a.

Content Management templates

Templates are content pages that are reused to provide a consistent look and feel.

Templates are useful when creating CMS sites for the following reasons.

<table>
<thead>
<tr>
<th>Create new pages rapidly without risk by copying pages</th>
<th>Using a template to create new pages saves time because you do not have to keep repeating the same steps.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provide a restore point for pages within the system</td>
<td>Have a working template available if something goes wrong in one of the blocks or in the theme CSS. It is often easier to start over from the template instead of trying to undo complex changes.</td>
</tr>
<tr>
<td>Provide a functional reference for editors on the site project</td>
<td>Having the template as a reference ensures that pages continue to conform to the style guide.</td>
</tr>
</tbody>
</table>

Page templates

Every page that is part of the site needs a template.
Critical page reference fields
When you build a new site, there are four page reference fields on the site record that are critical. Understanding these pages and how they are used helps you define page templates and site defaults.

- Home page: landing page for the site. A home page is mandatory.
- Search page: page that displays search results when a user searches from any page within the site. A search page is mandatory for your site to have a Search Results block.
- Login page: a standalone login page, which is useful to force authentication for the entire CMS site.
- Gauge target page: page used to display the drill-through content from a gauge. When the user clicks a gauge, the gauge target page opens showing the drill-through content for that gauge.

Detail pages
Depending on the data or tables that you plan to use, you may need detail pages. These detail pages use one of the content types in the following list.

- Knowledge detail page: displays a full knowledge article detail (mandatory for a knowledge site).
- Incident page: detail page for an incident record.
- Catalog page: detail page for all items, content items, order guides, and record producers.

Templates for creating sections
There are two page templates you can use when creating sections:
• Parent page: keeps sections within large sites organized and sortable on the site list of pages. Parent pages are also used to create breadcrumbs dynamically.

• Detail page: differs from the parent page in that the content area displays a full article or detail instead of a selection of related content. Detail pages must have a Current Document block.

These pages are mandatory if you plan on accessing system data. For example, if you plan on showing the service catalog in your CMS, you need the following items.

• A service catalog content type that references the [sc_cat_item table].
• A detail page that provides the full view of the item.

New templates
If the base system sample site pages are not suitable, you can create a template from scratch. Create a page and then use it as a template. For more information, see Create a Content Page.

When you save a new template, include the word “template” in the page name.

Configure a base template
An easy way to create a base template is to copy the existing ESS sample site and customize it to suit your own needs. You can also configure a base template from scratch.

Before you begin
Role required: content_admin or admin

About this task
Follow these steps to create a single base page and generate all important components within the site.

Procedure
1. Design a layout.
   Regardless of the interface, a site can be distilled into a few simple layouts.

2. Create a theme.
   The theme defines the structure of the layouts in CSS and the base styles, such as fonts and colors. For more information, see Design themes.

3. Build the common blocks.
Pages are composed of content blocks. Most content blocks are reused on multiple pages. For the base template, create basic blocks such as a header, side navigation, and some basic content for the main content area of the page. More detailed content can be added later, but define content for reuse on many of the site pages here. For more information, see Content blocks.

4. Build a site entry page.
Use the common content blocks you just created to design the first page that users see when they enter the site. For more information, see Create a content page.

5. Build a detail page.
Design the detail pages to determine how pages such as knowledge articles, catalog items, and search results are displayed. You can build a detail page by copying the site entry page and adding additional content blocks. For more information, see Copy a page.

6. Assign the pages created to the new site.
Create the site and apply the layout and theme to the site defaults. Then, navigate to the All Pages list and specify the base template site in the Site column for each of the base template pages. For more information, see Create a site.

Customize a copy of a page template

One good source for templates is the base system sample site. It is easy to copy pages and restyle them into new page templates to meet different business requirements.

Before you begin
The Employee Self-Service portal is provided as a working example and design template in the following procedure.

Procedure
1. Navigate to Content Management > Sites > Employee Self-Service.
2. Select a page.
   For example, to copy the ESS sample site homepage, select Portal.
3. Click Copy.
4. Rename the page.
5. Right-click in the header and select Save.
7. Point your cursor to the content block to change and click the edit icon that appears on the right. For example, change the menus, alter the layout, or add a different logo.

8. Click **Update**.

9. Use the page in other sites you created by assigning pages to a site.

**Content types**

Content types provide site-specific control of how system data defined by templates is rendered.

In the site, one page displays a list of knowledge articles, and another page displays catalog items or incidents or a combination of the two. Different themes can be used for types of content and each theme can provide different user interaction. Content types define the pages that display content from a table. Each content type corresponds to a table.

Every type of document that the CMS displays has an associated content type. Changing the content type requires knowledge of Apache Jelly scripting. However, the common content types (such as service catalog or knowledge base) come in the base system. Content types can be associated with particular sites. This association allows different sites to use different detail pages for the same content type.

Content types define three features of associated documents.

- What does a link to one of these documents look like? For example, if a list of these documents is displayed on a page, how does each entry appear?
- What does a detailed view of one of these documents look like?
- What detail page is used to display the document? This decision is important and is often an area of confusion for new CMS users.

The document content type determines the page that a list of documents points to, the list itself does not determine the page. The content from a link is displayed in a detail content block on a page. The content type determines in which detail block on a page the document content is displayed.

For example, the list block **Catalog Top 5** displays the top five items in the Service Catalog table [sc_cat_item]. Because the table is [sc_cat_item], the content type **sc_cat_item** controls how the **Catalog Top 5** list is displayed. Clicking any item in the list displays the Service Catalog Detail page with the item displayed on it according to the detail template script. These content types are applied:
• in search results to link to the correct page.
• in the Current Document block to display the current record.
• in links on lists and other places that link to record types.

Several content types are available by default for tables such as Catalog Item [sc_cat_item], Gauge [sys_gauge], and Page [content_page].

Content type defaults that are set for CMS can be overridden for individual sites. Use the Content Types related list on the site record to customize content types.

Note: To learn more about the properties that affect use of content types, see the following topics in Instance Security Hardening Settings:

Configure a content type

Users with the content_admin role can create a content type.

Before you begin
Role required: content_admin or admin

Procedure
1. Navigate to Content Management > Content Types.
2. Click New.
3. Complete the Content Type form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select the table whose content will be rendered in Content Management.</td>
</tr>
<tr>
<td>Content site</td>
<td>Select the site that will use this content type.</td>
</tr>
<tr>
<td>Media type</td>
<td>Enter one of the following media types to use with this content type.</td>
</tr>
<tr>
<td></td>
<td>• doctype: UI15 desktop interface only</td>
</tr>
<tr>
<td></td>
<td>• m: Smartphone interface only (not for CMS use)</td>
</tr>
<tr>
<td></td>
<td>• tablet: Tablet interface only (not for CMS use)</td>
</tr>
<tr>
<td>Field</td>
<td>Input Value</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default detail page</td>
<td>Select which page loads after a user clicks a link.</td>
</tr>
<tr>
<td>Gauge page</td>
<td>Select which page is the drill-through target for any gauge. If you display a gauge on a CMS page, then clicking the links loads the page specified here.</td>
</tr>
<tr>
<td>Summary Template</td>
<td>Write an XML script that determines how the list is displayed in the list block, if the link is displayed in a list block.</td>
</tr>
<tr>
<td>Detail Template</td>
<td>Write an XML script that determines how to display the associated information after a user clicks the link.</td>
</tr>
</tbody>
</table>

**CMS gauge support**

Gauges are a graphical way to display information from an instance.

A gauge might, for example, show a bar chart breaking down all open incidents by category. Gauges are fully supported within the CMS system. This means:

1. You can put a gauge on a CMS page
2. You can control what will happen when a user clicks on a cell within that gauge

**Put a gauge on a CMS page**

You have control over the gauges on a CMS page.

**Procedure**

1. Bring up the CMS page in edit mode.
2. Click **Add Content**.
3. Select the gauge you want to add.
4. Place the gauge on the page in the desired location.

**Related reference**

- Control what happens on a click

**Related information**

- CMS gauge support
Control what happens on a click

Since a CMS system uses multiple pages you have to tell the system which page to use to display drill through content.

In the normal (non CMS) system, when you click a bar in a bar chart or a wedge on a pie chart, you drill through and your current screen is replaced with a list of records meeting the chart's criteria. For example, if you have a gauge of Incidents by Category and you click the bar labeled Hardware you drill through to a list of all incidents with a category=hardware.

Within the CMS system, there is a similar drill through mechanism at work, but you must manually specify which page to display.

There are two different models of the drill through, use an in-place target frame to receive the content, or use another page to display the content.

Using an In-Place Target

An in-place target is a named iframe on the same CMS page as the gauge. When the gauge is clicked, the drill-through content appears within that iframe rather than changing out the CMS page. The gauge (and the rest of the page other than the target) remain in place and active.

Using a Gauge Target Page

A gauge target page is a separate CMS page that is used to display the drill-through content from a gauge. When a gauge is clicked, the current CMS page is replaced with the gauge target page and the drill-through content is rendered within that second page.

• Gauge Target Page

To set a site default, select Gauge Target Page, on the site configuration page. This page is used as the drill-through target for any gauges in the system that do not have a more specific gauge page specified in their content type.

• Gauge Page

To set a content-type specific page, you can specify a Gauge Page, on a content type page. Any gauges for this type of content then use that page for any drill through.

Note: The gauge target on a particular content type overrides the default, site level, gauge target.

• Gauge Target block

A gauge target page is a normal CMS page, with one special requirement. Somewhere on that page, there must be a Gauge Target block. This market block tells the system where to output the drill through data.
Related information

CMS gauge support
Put a gauge on a CMS page

View content types
The following is an example of where you might use Content Types.

Before you begin
This example uses the out-of-box Employee Self-Service (ESS) site as an example.
Role required: content_admin or admin

About this task
Use any out-of-box instance of a CMS site.

Procedure
   The Issue Status, or incident_status CMS page contains two content blocks:
   Common Answer and Current Issues. These content blocks both use Content Types to render results.
   This block matches the Common Answers section of the Issue Status page. The Table field describes the Content Type associated with Common Answers.
4. Use the link to view existing Content Types.
5. Click the Content Type to view the XML that determines how the list and record are rendered in CMS.
   The Default Detail Page field indicates a CMS page that displays a record selected from a List of Content block.
6. Click the Information icon next to the Default Detail Page, to go to that page.
7. From the Default Detail Page, under Related Links, click Edit Page.
   The Detail Block contains a content type formatter. When editing or viewing the page, it is looking for a URL to be passed to determine the record to display, which is why it says "Detail record could not be located".
8. Click the pencil icon to edit and view the Detailed Content block.
   The Type drop down list has "Show the page's current document" selected, which indicates that the document_id must be passed to this block from the CMS pages, then it can display the record based on the content type listed in the document_id.
9. From the Common Answers block, on the Self Service page, select a record. The page opens with a URL similar to: https://<instance name>.service-now.com/ess/knowledge.do?sysparm_document_key=kb_knowledge,02255450d731310013ab49547e61038e

The table sysparm_document_key=kb_knowledge and sys_id 02255450d731310013ab49547e61038e determine the record. The associated content type, kb_knowledge, renders the content on the Default Detail Page, Portal - Knowledge Detail / url_suffix=knowledge.

**Content blocks**

A block is a defined piece of content within the system that can be reused. A content page is constructed by arranging customized blocks of content on a page. Content blocks are an important part of a CMS site. Existing content such as reports, gauges, and record lists are automatically available as content blocks and more can be created within the CMS.

After defining content blocks, use them on any content page by adding them to drop zones. For more information, see Add content to a page.

Create content blocks after sites and pages have been designed.

**Related information**

- View CMS block tags
- Configure a header block
- Configure a static HTML block
- Format an image as a static HTML block
- Configure dynamic blocks
- Catalog cart block
- Integrate Live Feed with CMS
- Configure Flash movie blocks
- Configure a detailed content block
- Configure iFrames

**Configure a content block**

To configure a content block, define it in the appropriate form.

**Before you begin**

Role required: content_admin or admin
Procedure

1. Perform one of the following actions to create a content block.
   • Navigate to Content Management > Blocks > [Block type] > New. The form for creating the selected block type opens.
   • Navigate to Content Management > Blocks > All and select the type of content to create from the list.
   • Edit a content page and add a stub block of the desired content block type. Click the link in the stub block.

2. Complete the content block form and save it.

3. Add the content block to any content page.

Related information

Configure a header block
Configure a static HTML block
Format an image as a static HTML block
Configure dynamic blocks
Catalog cart block
Integrate Live Feed with CMS
Configure Flash movie blocks
Configure a detailed content block
Configure iFrames

View CMS block tags

A CMS block tag is used for advanced block creation and site flexibility.

Before you begin
Role required: content_admin or admin

About this task

It is constructed as <g:content_block> {{Jelly_Tags|Jelly}} and can be used in either of the following ways.

• Blocks: to display a block inside a block.
• Layouts: to display a block inside a layout.

The tag appears in the format, <g:content_block type="<type>" id="<sys_id>"/>.

An example of the block tag is included in the ESS Portal sample site.
Procedure

1. Navigate to **Content Management > Design > Frames**.
2. Click **cms_admin_home_frame**.
3. View the code.

```html
<style>
DIV.cms_administration_home {
    background: url(gray_${current_page.getURLSuffix()}.pngx) no-repeat right top;
}
</style>

<div class="cms_administration_home">
  ${body}
<br/>
<!--[if test="${current_page.getURLSuffix()=='administration'}"]>
  <g:content_block type="content_block_menu" id="7afc342def002000914304167b2256ac"/>
<![endif]-->
  The defaults use the page URL suffix to define sub menus
  <!--[if test="${current_page.getURLSuffix()=='community_inspired'}"]>
  <g:requires name="ess.portal.globals.jsdbx"/>
  <g:content_block type="content_block_menu" id="ccd4b8c7efb7000914304167b22566e"/>
  <![endif]-->
<br/>
</div>
```

4. To see what the page looks like, navigate to the ESS Portal administration page. For example, [http://instance name.service-now.com/ess/administration.do](http://instance name.service-now.com/ess/administration.do).

Related information

- Content blocks
- Configure a header block
- Configure a static HTML block
Types of content blocks
Content blocks, which make up content pages, are reusable pieces of content defined within the system.

Each content block can be used for a different type of content.

Related information
- Format an image as a static HTML block
- Catalog cart block
- Integrate Live Feed with CMS

Configure a header block
A header block is a visual element placed at the top of pages. It provides a place for branding and other important site-wide functionality.

Before you begin
Role required: content_admin or admin

About this task
Some of the options that are available in headers include, global search, text size toggle, menus for navigational purposes, and the user name with logout link.

Procedure
1. Navigate to Content Management > Blocks > Headers.
2. Click New.
3. Complete the form.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a unique name for the header block.</td>
</tr>
<tr>
<td>Background</td>
<td>Select a background for the header logo and menus.</td>
</tr>
<tr>
<td>- None</td>
<td>No background is rendered.</td>
</tr>
<tr>
<td>- Gradient/Image</td>
<td>Specify an image or gradient image to serve as the background.</td>
</tr>
<tr>
<td>- Colored Bars</td>
<td>Specify colors for three different sections of the header, top, middle, and bottom.</td>
</tr>
<tr>
<td>Image</td>
<td>If <strong>Background</strong> is <strong>Gradient/Image</strong>, upload an image for the header block background. For gradients, upload a gradient image.</td>
</tr>
<tr>
<td>Top bar color</td>
<td>If <strong>Background</strong> is <strong>Colored Bars</strong>, enter a CSS color or color name to use as the background for the top menu.</td>
</tr>
<tr>
<td>Middle bar color</td>
<td>If <strong>Background</strong> is <strong>Colored Bars</strong>, enter a CSS color or color name to use as the background for the logo and text.</td>
</tr>
<tr>
<td>Bottom bar color</td>
<td>If <strong>Background</strong> is <strong>Colored Bars</strong>, enter a CSS color or color name to use as the background for the bottom menu.</td>
</tr>
<tr>
<td>Logo</td>
<td>Select a logo image. The image is also a link to the main page.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make the block available for use.</td>
</tr>
<tr>
<td>Text</td>
<td>Type the text to display beside the logo.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Select the check box and type any scripted conditions to apply in the <strong>Condition</strong> script field that appears.</td>
</tr>
<tr>
<td>Category</td>
<td>Select a category to provide organization for the header block. The category also determines the detail page in which header block links open. Detail pages often display information in different ways.</td>
</tr>
<tr>
<td>Top Menu</td>
<td>Select a navigational menu block to use as a menu above the logo.</td>
</tr>
<tr>
<td>Bottom Menu</td>
<td>Select a navigational menu block to use as a menu below the logo.</td>
</tr>
<tr>
<td>Height</td>
<td>Specify the height for the header.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Search</td>
<td>Select this check box to add a search element in the header.</td>
</tr>
<tr>
<td>Font sizer</td>
<td>Select this check box to include text sizing controls in the header.</td>
</tr>
<tr>
<td>Login</td>
<td>Select this check box to include a login link in the header. If the user is logged in, this element displays the user name and a logout link. If you specify a login page on the site record, it is important to include a login link so users can enter their username and password.</td>
</tr>
<tr>
<td>Chat Queue</td>
<td>Select the chat queue that users access by clicking the <strong>Help Desk Chat</strong> button in the header. Clear the field to remove the button. This field appears only if the Chat plugin is active.</td>
</tr>
</tbody>
</table>

**Related information**

Configure a content block

**Create a navigation menu block**

Navigation menu blocks enable you to create a menu of links to different content pages.

**Before you begin**

Role required: content_admin or admin

**About this task**

The following three objects define navigation menus.

- **Menu block**: The menu block defines the entire menu block and how it displays.
- **Menu section**: The menu sections define groups of links displayed within the block.
- **Menu item**: The menu items define the links within each menu section.

**Procedure**

1. Navigate to **Content Management > Navigation Menus**.
2. Click **New**.
   
   A gallery of available navigation menu blocks displays.
3. Select the desired menu block style.
4. Complete the Navigation Menu form to define the block.

**Navigation Menu form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the block.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of navigation menu, which determines how the links are displayed.</td>
</tr>
<tr>
<td>Frame</td>
<td>Select a border style for the navigation menu block.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Select this check box to enable the use of scripted conditions. If selected, the <strong>Condition</strong> and <strong>Logged On</strong> fields appear.</td>
</tr>
<tr>
<td>Logged on</td>
<td>Select this check box to display the navigation menu block only if the user is logged on. This field appears only if <strong>Conditional</strong> is selected.</td>
</tr>
<tr>
<td>Condition</td>
<td>Enter a script to define the conditions for the navigation menu block. This field appears only if <strong>Conditional</strong> is selected.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make the block available for use.</td>
</tr>
<tr>
<td>Category</td>
<td>Select a category to provide organization for the navigation menu block. The category also determines the detail page in which menu links open.</td>
</tr>
</tbody>
</table>
Related information

Menu style customization

Configure menu sections

Menu sections define groups of links displayed within the navigation menu block.

Before you begin

Role required: content_admin or admin

Procedure

1. Navigate to Content Management > Blocks > Navigation Menus and select a block.
2. In the Menu Sections related list, click New.
3. Complete the Menu Section form.

Menu Section form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the menu section.</td>
</tr>
<tr>
<td>Content block menu</td>
<td>Select the navigation menu on which this menu section appears.</td>
</tr>
<tr>
<td>Redirect to</td>
<td>Select what appears when a user clicks the menu section name and icon.</td>
</tr>
<tr>
<td>URL</td>
<td>Click the lock icon to open the edit field, then enter the URL to display when a user clicks the menu section title and icon. This field is available only if Redirect to is set to The specified URL.</td>
</tr>
<tr>
<td>Detail page</td>
<td>Select the content page to open when a user clicks the menu section title or icon. This field is available only if Redirect To is set to A content page.</td>
</tr>
<tr>
<td>Left image DB</td>
<td>Select the image database where your site images are stored.</td>
</tr>
<tr>
<td>Right image DB</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Left image</td>
<td>Select icons to appear on the left and on the right of the name.</td>
</tr>
<tr>
<td>Right image</td>
<td></td>
</tr>
<tr>
<td>Second level text</td>
<td>Enter a description to appear beside the menu section title.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make the menu section available for use.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter a number to indicate where this section appears on the menu relative to other menu sections.</td>
</tr>
<tr>
<td>Logged on</td>
<td>Select this check box to display the menu section only if the user is logged on.</td>
</tr>
<tr>
<td>Roles</td>
<td>Click the lock to open a list, then select the roles that can access this menu section if you restrict access by role.</td>
</tr>
<tr>
<td>Category</td>
<td>Select the category in which the menu section belongs.</td>
</tr>
<tr>
<td>Open In</td>
<td>Select the behavior of clicked links.</td>
</tr>
<tr>
<td>iFrame</td>
<td>Enter the name of the iFrame where the link opens when a user clicks the menu section title and icon. Make sure that there is an iFrame on the page where the link opens. This field is available only if Open In is set to Named iFrame.</td>
</tr>
<tr>
<td>Header</td>
<td>Enter header information for the menu section.</td>
</tr>
<tr>
<td>Footer</td>
<td>Enter footer information for the menu section.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Related reference**

- **Menu types**
- **Related information**
  - **Menu style customization**

**Configure menu items**

Menu items are the links that appear within each menu section.

**Before you begin**

Role required: content_admin or admin
About this task
Not all navigation menu sections require menu items. Use menu items to link users to other pages or additional information. These steps use the ESS sample portal site as an example.

Procedure
1. Navigate to Content Management > Blocks > Navigation Menus and select a navigation menu.

   **Example**
   For example, select the Documentation Menu.

2. From the Menu Sections related list, select a menu section.

   **Example**
   For example, select Getting Started.

3. From the Menu Items related list, click New.

4. Complete the form.

### Menu Item form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a unique name for the menu item.</td>
</tr>
<tr>
<td>Menu section</td>
<td>Select the menu section in which this item appears.</td>
</tr>
<tr>
<td>Redirect to</td>
<td>Select what appears when the menu item name and icon are clicked.</td>
</tr>
<tr>
<td>URL</td>
<td>Click the lock icon to open the edit field, then enter the URL to open when the menu item title and icon are clicked. This field is available only if Redirect to is set to The specified URL.</td>
</tr>
<tr>
<td>Detail page</td>
<td>Select the content page to open when the name or icon is clicked. This field is available only if Redirect To is set to A content page.</td>
</tr>
<tr>
<td>Image</td>
<td>Select an icon to appear with the name.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make the menu item available for use.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter a number to indicate where this item appears on the menu relative to other menu items.</td>
</tr>
<tr>
<td>Logged on</td>
<td>Select this check box to display the menu item only if the user is logged on.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Roles</td>
<td>Click the lock to open a list, then select the roles that can access this menu item to restrict access by role.</td>
</tr>
<tr>
<td>Category</td>
<td>Select the category in which the menu item belongs.</td>
</tr>
<tr>
<td>Open in</td>
<td>Select the behavior of clicked links.</td>
</tr>
<tr>
<td>iFrame</td>
<td>Type the name of the iFrame where the link opens when a user clicks the menu item name and icon. Make sure that there is an iFrame on the page. This field is available only if Open In is set to Named iFrame.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Related reference**
- Menu types
- Related information
  - Menu style customization

**Menu types**

By changing the **Type** field on the navigation menu block, you can format the same menu in different ways.

<table>
<thead>
<tr>
<th>Type</th>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Super Menu for Headers</td>
<td></td>
<td>The super menu is a hybrid between the drop-down menu and the tabbed system. The user can use a super menu to create a menu from any number of menus.</td>
</tr>
<tr>
<td>Drop-Down Menu for Headers</td>
<td></td>
<td>The drop-down menu renders the menu sections as drop-down list. Use the mouse to point to the menu name and view the menu items.</td>
</tr>
<tr>
<td>Tab Menu for Headers</td>
<td></td>
<td>The tab menu renders the menu sections as tabs. Use the mouse to click the tab and view the menu items.</td>
</tr>
<tr>
<td>Horizontal Blocks</td>
<td></td>
<td>The horizontal blocks menu renders the menu sections as block headings with menu items as links within the blocks. The blocks are arranged horizontally.</td>
</tr>
</tbody>
</table>
Menu types (continued)

<table>
<thead>
<tr>
<th>Type</th>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab Content Block</td>
<td></td>
<td>The tab content block (horizontal) menu renders the menu sections as tabs with menu items as links within the block.</td>
</tr>
<tr>
<td>Vertical List</td>
<td></td>
<td>The vertical list menu renders the menu sections as headings with menu items as links below them.</td>
</tr>
<tr>
<td>Vertical Blocks</td>
<td></td>
<td>The vertical blocks menu renders the menu sections as block headings with menu items as links within the block. The blocks are arranged vertically.</td>
</tr>
</tbody>
</table>

Menu style customization

You can customize menu styles in the style sheets your site uses.

Navigate to Content Management > Design > Style Sheets to customize style sheets.

Supplementary page navigation menu example code

In the following example, look at the CSS class selectors and rules. Also, review how the block containers (div.cms_menu_section_blocks) are defined based on the outer container (TD.layout_content_submenu_column). The outer container is actually a part of the site layout.

This concept is clearer if you compare the styles to the styles used in the super menu further down in the example. This example shows that there is no need to make a completely new menu system. You can use CSS to change the look and feel of existing menus.

```
/*
 **********************************************
 "SUB MENU VARIATIONS FOR HORIZONTAL MENUS" - Section Blocks Menu (cms_menu_section_blocks UI Macro)
 **********************************************

TD.layout_content_submenu_column DIV.cms_menu_section_blocks { 
  width: 156px; 
  height: auto; 
  float: left; 
  position: relative; 
  border-style: solid; 
} 
```
Super menu sections example code

The following menu is a simple float grid. The defaults are written first. Then, below the "SUPER MENU VARIATIONS..." comment, the defaults are overwritten by adding a containing div with a unique class. In the code that renders the header for the base system, the bottom menu resides in a table cell with the class of `cms_header_bottom_menu` (refer to the `TD.cms_header_bottom_menu` CSS selector).

```
/
******************************************************************************
************************************************************
SUB MENU VARIATIONS FOR HORIZONTAL MENUS - Section Blocks Menu (cms_menu_section_blocks UI Macro)
******************************************************************************
="/*
TD.layout_content_submenu_column DIV.cms_menu_section_blocks {
    width: 156px;
    height: auto;
    float: left;
    position: relative;
    border-style: solid;
    margin: 0px 0px 0px 0px;
    border: 0px solid #e0e0e0;
    padding: 0px;
    background: none;
    padding: 24px 12px 0px 12px;
}

TD.layout_content_submenu_column DIV.sub_menu_section {
    width: 156px;
    height: 20px;
    float: left;
    border-style: solid;
    border: 0px solid #e0e0e0;
    padding: 0px;
    background: none;
    padding: 0px 12px 0px 12px;
} 
*/
```
4.2 2. Super Menu Sections Example Code

This menu is essentially a simple float grid. The defaults are written first. Then, below the "SUPER MENU VARIATIONS..." comment, the defaults are overwritten by adding a containing div with a unique class. In the code that renders the header for the base system, the bottom menu resides in a table cell with the class of "cms_header_bottom_menu" (note the TD.cms_header_bottom_menu CSS selector).
Example menu items and content links

The method for choosing a link target (current window, iFrame, or new window) and referencing the item linked (page, attachment, or URL) are similar. Review examples of how to link within these elements.

• A content page reference helps you select the desired page. For example, the value `home.do` links to the site homepage.

• An attachment reference allows you to reference a single file attached to the menu item or section record. If there is more than one attachment, only the
first attachment is referenced. The link is then generated automatically and displays a Browser File Save prompt.

- The specified URL reference allows you to link to a full URL string in your instance or from another system. For example, `com.glideapp.servicecatalog_cat_item_view.do?sysparm_id=66c313e7c0a8016b008ebel1a8e3d97f5&sysparm_nameofstack=b654d15bef9210091430416` links to the Ask a Question record producer. Use this reference to link to a page in an existing intranet system.

Menu items can be seen as featured links from each section. There are many choices in URL definitions and link options. Links within the ESS Portal open content pages within the site. In turn, each page has an iFrame or set of blocks that houses the corresponding data. This method is useful for rapid prototyping, but consider where to create dynamic detail pages and use the available linking options.

Menu items are similar to content links except they are called by the list block, not as part of a navigation menu block. Menu items and content links function the same as far as how they are defined and the options available for linking to items. Content links are meant to be called through a list block that calls the Content Link `[content_link]` table. Content links do not have the Logged in field or the Roles option used to control the UI experience for various roles.
Before you begin
Role required: content_admin or admin

About this task
For example, link behavior determines which page opens when the link is clicked and how it opens, such as in a new page or a new frame. Use the following procedure to view a sample menu section.

Procedure
2. Click Portal - Block Menu.
3. In Menu Sections related list, click Order Things.
4. Click the reference icon next to Detail Page to open the page.
5. In Related Links, click Edit Page.
   By default, the link goes to the Order Things page with the Portal - Order Splash Menu (Vertical Block Menu) in the page content area.

   In most default CMS menus, the menu section has the menu title with secondary text, a separation line, and the links you define as menu items. Although the design is versatile and flows well between pages, there could be questions about linking and scalability to large catalogs. This practice may only be useful for a small catalog with limited items.

6. To view an example of dynamic content, follow these steps to look at the request catalog list/grid view on the ESS Portal.
a. Add /ess/manage.do to your instance URL. For example, https://<instance name>.service-now.com/ess/manage.do.

b. In the Code Example Demos section, click Request Catalog List / Grid View.

c. Browse the catalog items.

Configure dynamic blocks
Use dynamic blocks to use scripting or to pull information from the system. Dynamic blocks are where most of your content resides.

Before you begin
Role required: content_admin or admin

About this task
A good use of dynamic blocks is job postings. Store the postings in knowledge articles and display the postings with a dynamic block.

Several dynamic blocks are predefined, including the following items.

• **New Content**: Each of the new content blocks allows for creating blocks while editing content pages.

• **Clean Login**: The default login page requesting user name and password, which includes a “Remember Me” check box. After the user logs in, this block triggers login rules.

• **Login**: An area that allows a logged out user to log in and a logged in user to log out. This block is especially useful on publicly available content pages.

• **Search**: The global text search field. Currently, global text search is the only form of search that can be included in a content page.

• **Search Results**: An area for displaying global text search results.

For information about Apache Jelly, see .

Procedure
1. Navigate to **Content Management > Dynamic**.
2. Click **New**.
3. Complete the Dynamic Content form.
Dynamic Content form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a unique name for the dynamic content block.</td>
</tr>
<tr>
<td>Category</td>
<td>Select a category to provide organization for the dynamic block. The category also determines the detail page in which dynamic block links open.</td>
</tr>
<tr>
<td>Frame</td>
<td>Select a border styling for the dynamic block. For more information, see Format a frame.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make the block available for use.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Enter any scripted conditions to be applied. If selected, adds a Condition script field to the form.</td>
</tr>
<tr>
<td>Two phase</td>
<td>Select this check box to allow two phase Jelly tags.</td>
</tr>
<tr>
<td>Dynamic content</td>
<td>Enter the XML script field that determines the behavior of the dynamic block.</td>
</tr>
</tbody>
</table>

Related information

- Content blocks
- Configure a content block
- View CMS block tags
- Customize the list block
- Format an image as a static HTML block

Catalog cart block

The catalog cart block is a dynamic block provided in the base system.

This block provides the same cart that is available within the service catalog. If the site definition has the Use external cart option selected, include this block in the site so users can interact with their catalog cart.

Catalog cart block is available when the glide.sc.use_cart_layouts property is set to false.

Related reference

- Types of content blocks
**Related information**
- Content blocks
- Configure a content block

**Customize the list block**
List blocks are content blocks that dynamically generate a list of links to records within the instance. When a user clicks a link in a list block, the associated information is displayed in a detail page determined by its content type.

**Before you begin**
Role required: content_admin or admin

**About this task**
Make the list using a simple query on any table or by scripting a more advanced query. Lists are powerful and flexible. Here are some places that allow you to have complete control over the list display.

**List control**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frames</td>
<td>Frames provide a method to create decorative containers for content blocks and other elements within the site. When frames are used with the <strong>Type</strong> field, the designer has complete control over list placement.</td>
</tr>
<tr>
<td>List Type</td>
<td>The List Definitions module defines the type of lists available for content pages. On the List Block form, select a list definition in the <strong>Type</strong> field.</td>
</tr>
<tr>
<td>List Filtering</td>
<td>Provides every field in the referenced table for more granular results.</td>
</tr>
<tr>
<td>Max Entries</td>
<td>Limits the results from a table to fit the design of the block.</td>
</tr>
<tr>
<td>Order and Order Direction</td>
<td>Allows sorting by any field in the referenced table, in either ascending or descending order.</td>
</tr>
</tbody>
</table>

You can also use list blocks to create a list of links to information outside your instance. Create the external links as records on the Content Link [content_link] table, and then follow the steps in this procedure.
Procedure
1. Navigate to Content Management > Lists.
2. Click New.
3. Complete form.

List Block fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the list content block. It is used to identify the record in the instance and is not displayed on the content page. Use the Title field for that purpose.</td>
</tr>
<tr>
<td>Category</td>
<td>Select a category to provide organization for the list content block.</td>
</tr>
<tr>
<td>Type</td>
<td>Select a list definition UI macro to format the list of links.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to enable generating a list from a script, rather than from a simple filtered query.</td>
</tr>
<tr>
<td>Query</td>
<td>Filters the results using a condition builder.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make the block available for use.</td>
</tr>
<tr>
<td>Title</td>
<td>Enter the name to display at the top of the list block when it appears in a content page.</td>
</tr>
<tr>
<td>Maximum entries</td>
<td>Set the maximum number of entries to display in this list block.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table to query for the list items. The table determines which detail page displays when a user clicks a link in the list block. For more information, see Configure a content type</td>
</tr>
</tbody>
</table>

Note: The list shows only tables and database views that are in the same scope as the list block.

Conditional | Select this check box to enable the use of scripted conditions. If selected, a Condition script field appears. Other fields that
### Configure list definitions

List definitions, similar to content management frames, are decorative containers that control the look and feel of lists.

**Before you begin**
- Role required: content_admin or admin

**About this task**
- Specifically, list definitions are UI macros that use Apache Jelly script to define how a list is rendered inside a list block. Site design often requires multiple list styles within the layout. Lists are often the primary form of navigation within a site, so it is important to have control over their formatting.
- Configuring list definitions requires a knowledge of Apache Jelly.

**Procedure**

1. Navigate to **Content Management > Configuration > List Definitions > ..**
2. Click **New**.
3. Complete the List Definition form.

**Related reference**
- [Content Management and the Apache Jelly engine](#)

### Configure a static HTML block

Use static blocks for text that does not change. For example, use a static block for a site footer with only the company or organization name. A static HTML block allows any HTML code to be run within a page.

**Before you begin**
- Role required: content_admin or admin

**About this task**
- Anyone who edits their own HTML, Jelly, or Javascript may find the HTML editor in the static block limited. The HTML editor can also add tags or formats that
advanced coders find unnecessary. For more advanced options, use dynamic blocks.

Procedure

1. Navigate to Content Management > Blocks > Static HTML.
2. Click New.
3. Complete the Static Content form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a unique name for the static HTML content block.</td>
</tr>
<tr>
<td>Category</td>
<td>Select a category to provide organization for the static HTML block.</td>
</tr>
<tr>
<td></td>
<td>The category also determines the detail page in which static HTML block</td>
</tr>
<tr>
<td></td>
<td>links open. Detail pages often display information in different ways.</td>
</tr>
<tr>
<td>Frame</td>
<td>Select a border styling for the static HTML block. For more information, see</td>
</tr>
<tr>
<td></td>
<td>Format a frame.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make the block available for use.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Enter any scripted conditions to be applied. If selected, adds a Condition</td>
</tr>
<tr>
<td></td>
<td>script field and Logged on check box to the form.</td>
</tr>
<tr>
<td>Static Content</td>
<td>Enter HTML code that determines the behavior of the static HTML block.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Related information

- Content blocks
- Configure a content block
- View CMS block tags

Format an image as a static HTML block

An easy way to add an image to a CMS page is to use a static HTML block. After the block is created, you can reuse it throughout the site.

Before you begin

Role required: content_admin or admin
Procedure

1. Navigate to Content Management > Design > Images.
2. Click New.
3. Select a Category to help organize the images.
4. Type the file name of the image, including the extension (such as .png).
5. Upload the file by selecting Click to add and browsing for the image.
6. Click OK.
7. Click Update.
9. Paste the following code into the HTML block, substituting the image name as uploaded in the previous step. The "x" at the end of the filename is required for image caching.

   ```html
   <img src="<image_name>.gifx"/>
   ```

   Now the image is a static HTML block and you can add it to any content page. Use standard HTML code to alter the image in the content block.

Related information

Content blocks
    Configure a content block
    Configure a header block

Configure Flash movie blocks

Use a Flash movie block to embed any Flash movie (.swf file) as an attachment or by referencing a URL in a content page.

Before you begin

Role required: content_admin or admin

About this task

To add streaming video or Flash video (.flv), for example, to a knowledge article, see Embed videos in HTML fields.

Procedure

1. Navigate to Content Management > Specialty Content > Flash Movies.
2. Click New.
3. Complete the Flash Movie form.
Flash Movie form

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a unique name for the Flash movie block.</td>
</tr>
<tr>
<td>Source</td>
<td>Specify where the Flash movie is found.</td>
</tr>
<tr>
<td>• Attachment: If this choice is selected, upload the Flash movie to this record.</td>
<td></td>
</tr>
<tr>
<td>• Link to External Object: If this choice is selected, a URL field appears. Specify the Flash movie URL and ensure that the Flash movie is publicly accessible.</td>
<td></td>
</tr>
<tr>
<td>Height</td>
<td>Enter the height of the Flash movie in pixels.</td>
</tr>
<tr>
<td>Width</td>
<td>Enter the width of the Flash movie in pixels.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Related information
- Add and manage attachments
- Content blocks
- Configure a content block

Configure content links
Content links are the predecessors to navigation menus. You can use content links to create navigational links to information outside of your instance.

Before you begin
Role required: content_admin or admin

About this task
After the content link is configured, it must be defined in a list block. List blocks use content links to reference information outside of your CMS.

Procedure
1. Navigate to Content Management > Specialty Content > Content Links.
2. Click New.
3. Complete the Content Link form.
### Content Link form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a unique name for the content link</td>
</tr>
<tr>
<td>Redirect to</td>
<td>Select the location of the external link</td>
</tr>
<tr>
<td>Category</td>
<td>Select a category to provide organization for the list content block.</td>
</tr>
<tr>
<td>URL</td>
<td>Click the lock icon to open the edit field, then enter the site URL to open when the link is clicked. This field is available only if Redirect to is set to The specified URL.</td>
</tr>
<tr>
<td>Open in</td>
<td>Select the behavior of the clicked link.</td>
</tr>
<tr>
<td>Detail page</td>
<td>Select the page where the link opens when it is clicked. This field is available only if Redirect to is set to A content page.</td>
</tr>
<tr>
<td>iFrame</td>
<td>Enter the name of the iFrame where the link opens when it is clicked. Make sure that there is an iframe on the page where the link opens. This field is available only if Open In is set to Named iFrame.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

5. From **Content Management > Blocks > Lists**, create a list block that references the content links by selecting **Content Link** in the table field.

6. Create a query to determine which external links display on the page. For example, the query **Category is Search** displays any external links that have a category defined as **Search**.

7. Click **Update**.

### Configure iFrames

An iFrame embeds a URL on a page within a frame. It can embed external pages or render ServiceNow content.
Before you begin
Role required: content_admin or admin

About this task
Configure an iFrame with forms you create in the instance and link to the page in which the iFrame resides.

Note: Do not add any type of report, such as a calendar, to iFrames. For more information on adding a report directly onto a page without using iFrames, see Embedding reports in Jelly.

Note: To deliver ServiceNow content from a web page, see Service Portal instead.

Note: To learn more about this property, see in the Instance Security Hardening Settings.

Procedure
1. Navigate to Content Management > Specialty Content > iFrames.
2. Click New.
3. Complete the iFrame form fields.

<table>
<thead>
<tr>
<th>iFrame form fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Frame name</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>URL</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
### Field Input value

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sizing</td>
<td>Select an option for iFrame block size.</td>
</tr>
</tbody>
</table>

**Note:** The *Expand to fit content* choice only works with ServiceNow content. If *Fixed Size* is selected, height and width fields are displayed for you to enter the size in pixels.

**Note:** Some browsers suppress iFrames because they use an X-Frame-Options header value of SAMEORIGIN. The X-Frame-Options header was introduced in Internet Explorer 8 RC1, to help detect and prevent frame-based redressing. The SAMEORIGIN value causes the browser to render a blank page instead of the target page of the `<frame>` or `<iframe>` when the frame target is not on the same origin as the page itself. Support for this header has been implemented in Safari 4.0, Chrome 4.1.249.1042, and Firefox 3.6.9 and above.

### Related information

**Content blocks**

**Configure a content block**

### Integrate Live Feed with CMS

You can provide access to Live Feed from pages built in the Content Management System (CMS). For example, allow an end user to access your company feed via the ESS portal.

### About this task

The ESS Portal template includes the **Portal - Live page** and **Live Feed** dynamic block (requires the Live Feed plugin). To provide access to Live Feed from CMS pages, add the **Live Feed dynamic block** to a CMS page or include the **Portal - Live page** in a site.

### Procedure

1. Navigate to **Content Management > Specialty Content > iFrames**.
2. Click **New**.
3. Complete the iFrame block form with the following values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a unique name: Live Frame</td>
</tr>
<tr>
<td>Field</td>
<td>Input value</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Frame name</td>
<td>Type a frame name: <strong>live_frame</strong></td>
</tr>
<tr>
<td>URL</td>
<td>Enter <strong><a href="https://instance">https://instance</a> name/live_feed.do?sysparm_doctype=true</strong>. Replace instance name with your instance URL, for example, <code>&lt;myinstance&gt;.service-now.com</code>.</td>
</tr>
<tr>
<td>Sizing</td>
<td>Select <strong>Fixed Size</strong> and enter height and width pixel dimensions according to the page on which you plan to display the feed. For example, enter a width of 1024 and height of 768.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

5. Complete the steps in **Add the block to a page**.

**Related information**

- **Content blocks**
  - **Configure a content block**

**iFrame methods**

The following examples show how system records are pulled into an iFrame that is placed on a content page.

For system lists or forms, use the frame name **gsft_main** so that links work properly.

- **Order Hardware** is an example of linking to a catalog category.
  - **URL**: com.glideapp.servicecatalog_category_view.do?
    sysparm_parent=d258b953c611227a0146101fb1be7c31&sysparm_view=
  - **Frame name**: **gsft_main**

- **My Approvals List** is an example of linking to a list with a view filter and a JavaScript that reference the authenticated user.
  - **URL**: sysapproval_approver_list.do?
    sysparm_query=approver=javascript:getMyApprovals()&sysparm_view=ess
  - **Frame name**: **gsft_main**

- **Service Catalog Home Page (system)** references the system catalog page within the Service Catalog application. If you are satisfied with the way the catalog looks, this method is an easy way to bring the page into a CMS design.
  - **URL**: catalog_home.do?sysparm_view=catalog_default
  - **Frame name**: **gsft_main**
**Problem Management Overview** references a homepage. .. / makes the URL string relative to system homepages. Without it, the URL string resolves to the default CMS homepage reference in the site.

- URL: ../home.do?sysparm_view=problem_overview
- Frame name: gsft_main

**Configure a detailed content block**

A detailed content block displays the content of an existing document, such as an incident, knowledge article, or service management request. The document type determines the page that a list of documents points to.

**Before you begin**

Role required: content_admin or admin

**About this task**

The block works with content types in the **Default detail page** field. For more information, see Configure a content type.

If you plan to use a script to find a document, configure the form to add the **Script** field if it is not displayed.

**Procedure**

1. Navigate to **Content Management > Configuration > Page Detail Settings**.
2. Click **New**.
3. Complete the Detailed Content form.

**Detailed Content form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a unique name for the Detailed Content block.</td>
</tr>
<tr>
<td>Category</td>
<td>Select a category to provide organization for the detailed content block. If the block Type is <strong>Show the page's current document</strong>, the category displays content from any link of the same type.</td>
</tr>
<tr>
<td>Frame</td>
<td>Select a border styling for the detailed content block. For more information, see Format a frame.</td>
</tr>
<tr>
<td>Model Document</td>
<td>Select the document to display by default.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make the block available for use.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the behavior for the block.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Show a Specific Document</strong>: Displays the Model Document.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Show the page's current document</strong>: Displays the currently selected document.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use a script to find a document</strong>: Uses the Script field to select a particular document.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Select the check box and enter any scripted conditions to be applied. Selecting this check box adds a Condition script field and Logged on check box to the form.</td>
</tr>
<tr>
<td>Script</td>
<td>Enter a script to find an appropriate document if the Type is set to <strong>Use a script to find a document</strong>. Set the Return to the GlideRecord of the desired document.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Related information

Content blocks
  Configure a content block

Content Management and the Apache Jelly engine

Apache Jelly is a Java-based and XML-based scripting and processing engine for turning XML into executable code.

The Apache Jelly engine closely resembles XML and should be comfortable for developers familiar with JavaScript, XML, XHTML, or HTML. In the ServiceNow instance, the Apache Jelly engine renders items such as forms, lists, and UI Pages. Apache Jelly code renders well within a dynamic content block, but can have issues when used in static blocks. You can use Jelly tags, calls, and statements, but HTML acts just like XHTML.

```xml
<?xml version= "1.0" encoding= "utf-8" ?>
<j:jelly trim = "false" xmlns:j = "jelly:core" xmlns:g = "glide" xmlns:j2 = "null" xmlns:g2 = "null" >
  <j:if test = "${current_page.getName()=='Solutions'}" >
    <h1 class = "page_name" > <b> <a href = "solutions.do?" title = "${gs.getMessage('Solutions')}">${gs.getMessage('Solutions')}</a> </b> </h1>
  </j:if>
</j:jelly>
```
Ensure that all tags are closed. If the tag is not a naturally closing tag, then place a forward slash before the end bracket. For example, a `<BR />` or an `<IMG src="cms.png" />`.

If you are unfamiliar with Jelly scripting, review these topics:

-  

- Jelly escaping types

Include the following tag with all Apache Jelly scripts.

```jelly
<j:jelly trim= "false" xmlns:j= "jelly:core" xmlns:g= "glide" xmlns:j2= "null" xmlns:g2= "null">
</j:jelly>
```

The tag looks complex, but keep the following information in mind.

- Apache Jelly script uses multiple namespaces.
- There are two types of prefixes in tags: j and g. The j prefix is used for tags that are natively part of Apache Jelly. The g prefix is used for tags that the ServiceNow platform created and is using for platform purposes.

The j2 and g2 prefixes are just like j and g, except that they are processed in a second phase. The Apache Jelly script parser runs through each j and g tag respectively. For example:

```jelly
<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null" xmlns:g2="null">
<j:set var="jvar_phase1" value="Hello" />
<j2:set var="jvar_phase2" value="World" />
${jvar_phase1} ${jvar_phase2}
</j:jelly>
```
In phase 1, the parser runs through all the j and g tags. It then caches the result. Before it runs the second phase, it takes the j and g namespaces and moves the namespaces to the second phase. It looks something like the following code.

```xml
<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="jelly:core"
xmlns:g2="glide">
    <j2:set var="jvar_phase2" value="World" />
    Hello ${jvar_phase2}
</j:jelly>
```

For subsequent calls of this script, only phase 2 is parsed.

⚠️ **Note:** If you plan to use phase 2 Jelly tags (g2 and j2) on the Content Type [content_type] or Dynamic Content [content_block_programmatic] tables, select the **Two phase** option on the content form.

Another example is to create a report of all open incidents assigned to each group. For this purpose, you could use a report and save time, but it is a good example for learning Jelly. Start with the Jelly tag:

```xml
<j:jelly trim= "false" xmlns:j= "jelly:core" xmlns:g= "glide" xmlns:j2= "null" xmlns:g2= "null">
</j:jelly>
```

First, you need a list of open incidents. Use a g2:evaluate tag. The evaluate tag runs the script. Anything inside the tag is parsed like a business rule, so, for example, you can call global business rules, script includes, and gliderecord.

```xml
<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null" xmlns:g2="null">
    <g:evaluate var="jvar_groups" object="true">
        var now_GR = new GlideRecord("sys_user_group");
        gr.orderBy('name');
        gr.query();
        gr;
    </g:evaluate>
</j:jelly>
```

This script is in phase 1 because frequent changes to incident assignment groups are not expected. Also notice the `var` attribute on the evaluate tag. This attribute specifies what variable is set from this block. At the end of the script, there is a `gr` on a line by itself. That last line is what sets the variable.

You can omit the `jvar_groups` variable, but then all the variables in the evaluate tag become Apache Jelly variables. The `object=true` specifies that the variable is not a primitive data type. If `object=true` is omitted, the script would break because `jvar_groups` would only be able to hold items like integers and strings.
After the evaluate tag, loop through these groups and find the incidents for each one.

```xml
<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null" xmlns:g2="null">
  <g:evaluate var="jvar_groups" object="true">
    var now_GR = new GlideRecord("sys_user_group");
    gr.orderBy('name');
    gr.query();
    gr;
  </g:evaluate>
  <table>
    <tr>
      <th>Name</th>
      <th>Incidents</th>
    </tr>
    <j:while test="${jvar_groups.next()}">
      <tr>
        <td>${HTML:jvar_groups.getValue('name')}</td>
        <td></td>
      </tr>
    </j:while>
  </table>
</j:jelly>
```

You can include normal XML in the Apache Jelly script at any time. Since there is no namespace, the Apache Jelly script does not try to parse the XML tags. Notice the `j:while` loop. It is a normal while loop and can iterate through a GlideRecord object. Also notice that you output a value with `${HTML:jvar_groups.getValue('name')}`. Here are the important elements:

- The outer brackets, `{}`, specify the output of the variable and the phase in which the variable is output: `{}` means first phase, `[]` means second phase.
- HTML before the expression is for escaping the output. The expression `jvar_groups.getValue('name')` is being escaped for HTML. For other types of escaping, there are JS (Javascript), NS (No Script), and some other options.

To select only one record and not iterate through many records, the code looks like the following example:

```xml
<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null" xmlns:g2="null">
  <g:evaluate var="jvar_groups" object="true">
    var now_GR = new GlideRecord("sys_user_group");
    gr.orderBy('name');
    gr.query();
    gr;
  </g:evaluate>
```
Content management and Jelly code examples

Code examples

Header Example Code

This dynamic content block needs to be active and have the "Two Phase" option clicked. The g:requires tag is including the UI script defined in the system whose name is "servicenow.website.globals". The file extension in the call is .jsdbx and is used only in the call to the UI script, not in the name of the script in the system. For JSDBX, the file being called is a JavaScript(.js) defined within the database (db) that needs to be cached (x).

```xml
<?xml version= "1.0" encoding= "utf-8" ?><j:jelly trim = "false" xmlns:j = "jelly:core" xmlns:g = "glide" xmlns:j2 = "null" xmlns:g2 = "null" >
  <g:requires name = "servicenow.website.globals.jsdbx" />
</j:jelly>
```

Page Title and Description Example Code

This dynamic content block needs to be active. There are two actions within this code snippet. First is a forward-looking string container that allows site translation, the ${gs.getMessage('Your Text')} string call). The second action pulls in the page title and description, ${current_page.getName()} and ${current_page.getDescription()}.

```xml
<?xml version= "1.0" encoding= "utf-8" ?><j:jelly trim = "false" xmlns:j = "jelly:core" xmlns:g = "glide" xmlns:j2 = "null" xmlns:g2 = "null" >
  <j:if test = "${current_page.getName()}=='Solutions'" >
    <h1 class = "page_name" > <b> <a href = "solutions.do?" title = "${gs.getMessage('Solutions')}">${gs.getMessage('Solutions')}</a> </b> </h1>
    <p class = "page_description" >
      ${current_page.getDescription()}
    </p>
  </j:if>
  <j:if test = "${current_page.getName()}=='IT 3.0'" >
    <h1 class = "page_name" > <b> <a href = "solutions.do?" title = "${gs.getMessage('Solutions')}">${gs.getMessage('Solutions')}</a> </b> |
      ${current_page.getName()}
    </h1>
    <p class = "page_description" >
      ${current_page.getDescription()}
    </p>
</j:if>
</j:jelly>
```
List Block Pulling From Knowledge Articles Example Code

This code example contains one of the best tricks in the CMS. Using the type field with draws from a number of defined list definitions to make slight, or very dramatic changes, to list display. Because the UI is open to configuration and innovation, this is a good opportunity to use design skills. Anyone who can use HTML and CSS knows that a basic list can be turned into a float grid or be made inline. The combinations are limited only by what the designer can dream up and code.

In the code example, there is a custom logo field (u_logo) added to the Knowledge form. The custom field displays customer logos, partner logos, and award images on the awards page. There are a number of different sections that use this list definition so efficient reuse is taking place.

- **div class="cms_knowledge_list customer_success"** - Begin by creating an outer container with a unique class name that can be used as a basis for CSS style selectors and rules. From the outer container, many of the child elements can be accessed for theming.

- **<g:for_each_record file="${current}" max="${jvar_max_entries}"** - Loop for list creation that calls the selected table record and the entries set on the list form.

- **<a href="knowledge.do?sysparm_document_key=kb_knowledge,"${current.sys_id}"><img src="${current.u_logo.getDisplayValue()}" alt="${current.text}" width="110px"/>** - Defines linking to the article detail in the knowledge base. For further reference, look at content types within the site definition and you will see some similarities. The knowledge.do? portion of the URL points to the knowledge detail page which (as mentioned above) is mandatory if you plan to call the knowledge base in your CMS site. The rest of the URL represents the syntax for calling a knowledge article by its sys_id. Each and every item housed within the system has a unique sys_id.

- **<tt>${SP}-${SP}${current.author.first_name}${SP}${current.author.last_name}</tt>** - This example is commented out and not used, but it is still interesting in that it has a jelly call ${SP} and it pulls the knowledge article's author by first and last name.

```xml
<?xml version= "1.0" encoding= "utf-8"?><j:jelly trim = "false" xmlns:j = "jelly:core"
xmlns:g = "glide" xmlns:j2 = "null" xmlns:g2 = "null">
<div class = "cms_knowledge_list customer_success" ><g:for_each_record file = "${current}" max = "${jvar_max_entries}" /><br/>
<table cellspacing = "0" cellpadding = "0" border = "0"
```
Related reference

Content Management and the Apache Jelly engine

Style in Content Management

Content pages can be styled with CSS, just like any HTML website.

Three elements control CSS styles:

- **Style Sheets** are records containing CSS declarations.
- **Themes** are groups of style sheets that can be invoked together.
- **Frames** are UI macros that define the outer border of individual content blocks as they appear on a content page. Frames work by calling on particular definitions in the style sheets.

Related information

- Define a frame in a style sheet
- Create a frame UI macro
Style sheets

Stylesheets are standard Cascading Style Sheets (CSS) that define the look and feel of all elements within the interface.

Cascading Style Sheets (CSS) can either be internal (stored in the database) or external (hosted on the server), based on organizational needs. To define an internal style sheet, use standard CSS in the style field. Using external CSS allows the Content Management System to use the same CSS as a corporate website or other online resource.

Use an external style sheet by defining a URL that points to the .cssx file. If you upload a .cssx file to the platform, you can reference the .cssx file using a URL.

Content pages do not reference style sheets directly. To invoke a style sheet, you assign the style sheet to a Theme using the related list on the Theme form.

Related information
- Customize a design theme

Design themes

Design themes are the convergence of structure and styling, making them a critical tool for creating a powerful user interface.

For a successful project, review the corporate style guide and communicate with the corporate website art team. If the organization has an art or design department that maintains branding, include them in this process.

A theme is a collection of one or more style sheets (CSS files) that define a consistent look for a set of pages. In most environments, many pages share a few themes. Use multiple themes within a site to create stylistic differentiators between site areas. You can also use a single theme to create one unified look and feel for the site.

Related information
- Define a frame in a style sheet
- Create a frame UI macro

Customize a design theme

A theme is a collection of one or more style sheets (CSS files) that define a consistent look for a set of pages.

Before you begin
Role required: content_admin or admin
About this task
Themes can be invoked in any of the following ways.
• Directly by content pages.
• As the default theme of a content site.
• On the configuration page as a global default.

Procedure
1. Navigate to Content Management > Design > Themes.
2. Click New.
3. Type a name for the theme and mark it as Active.
4. Right-click the form header and click Save
   The Style Sheet related list appears.
5. Use the Style Sheet related list to add style sheets to the theme.

Doctypes
The view_content html page template on which all CMS is based defaults to
doctype=html.

The code looks like the following HTML source code.

```html
<!DOCTYPE HTML>
```

If your CMS site does not render properly, remove the doctype from the page by
setting the following property:

• `glide.html.doctype.pages =` chat_desktop,live_feed,live_feed_small,navigator,navpage11,image_browse

The following is the default for this property.

• `glide.html.doctype.pages =` chat_desktop,live_feed,live_feed_small,navigator,navpage11,image_browse,view_content

Setting this doctype offers these benefits for building new sites:
• Incorporating common practice: Use a practice that is becoming widely adopted across the Internet and can prevent certain browsers from running in quirks mode.

• Cleaner CSS and markup: Write more standards-based CSS and markup to promote code sharing.

• A step towards browser compatibility: Find solutions that work across browsers and avoid browser-specific workarounds.

**Format a frame**

Frames provide a way to manage decorative containers for content blocks and any other elements within the site. For example, one frame can be a container, made of div or span tags, that is styled with rounded corners.

**Before you begin**

Role required: content_admin or admin

**About this task**

Individual content blocks use a frame UI macro to define the frames. When viewing a content block form, the **Frame** field offers a choice between the different frame UI macros. The frame UI macro does not, however, have the definition for the frame within its Jelly script. Instead, it references a particular frame as defined in a style sheet.

Configuring a new frame is a two-step process.

**Procedure**

1. Define the frame in a style sheet.
2. Create the frame UI macro to invoke the frame definition.

**Define a frame in a style sheet**

Add style definitions for any custom frame UI macro you create.

**Before you begin**

Role required: content_admin or admin

**About this task**

Each frame has its own class name.
Procedure

1. Navigate to Content Management > Design > Style Sheets.
2. Select a style sheet to contain the frame definition.
   Base system themes use a separate Frames style sheet.
3. Add the following code, substituting the desired frame name and style:

   ```html
   div.FRAMENAME{border:STYLE;}
   ```
4. Click Update.

Create a frame UI macro

Copy an existing frame UI macro to display content in a custom frame.

Before you begin
Role required: content_admin or admin

About this task
Create a custom frame UI macro if you want to control the style of the frame with your own style sheet definitions.

Procedure

1. Navigate to Content Management > Design > Frames and select one of the existing frame UI macros.
2. Change the name to match the FRAMENAME you used in the style sheet.
3. Right-click the header bar and select Insert and Stay.
4. Update the frame name in the XML field as shown:

   ```xml
   <div class="FRAMENAME">
   ```
5. Click Submit.

What to do next
- In any content block form, select the UI macro.
- Define the frame in a style sheet.

Related information

Content blocks
Content Management meta tags

Meta tags are special tags in web pages that contain information about the page but are not rendered with the page. You can define custom meta tags for content pages.

Meta tags are not noticeable to a page visitor unless the visitor looks at the page source code. Web search engines read meta tags as they "crawl" the web, identifying and organizing content. Modern website designers often use meta tags to embed "hints" to search engines about how to index or otherwise crawl the site.

Structurally, a meta tag consists of a tag and a name/content pair and looks similar to the following code.

```html
<meta name="generator" content="MediaWiki 1.16wmf4" />
```

The Content Management System allows you to define both site level and page level tags.

Configure a page level meta tag

A page level tag is a meta tag defined on a specific page and included on only that page.

Before you begin
Role required: content_admin or admin

About this task
If an individual page has a specific tag with the same name as the site, the page tag takes precedence.

Procedure
1. Navigate to Content Management > Pages.
2. Open the page.
3. If not already included, add the Meta Tags related list to the form.
4. In the Meta Tags related list, click New.
5. Type a Name and Content for the tag.
6. Click Submit.

Configure a site level meta tag

A site level tag is a meta tag is defined on a site and included on every page within that site.
Before you begin
Role required: content_admin or admin

About this task
If an individual page has a specific tag with the same name as the site tag, the page tag takes precedence.

Procedure
1. Navigate to Content Management > Sites.
2. Open the site.
3. If not already included, add the Meta Tags related list to the form.
4. In the Meta Tags related list, click New.
5. Enter a Name and Content for the tag.
6. Click Submit.

Configure DIV-based layouts
After you create your site, you can change the site layout with DIV tags.

Before you begin
Role required: content_admin or admin

About this task
Many web page layouts use tables for a consistent look and feel. Tables are effective for numbers and statistics, but can be limiting for designing other types of information. DIV tags are flexible block-element tags. To use DIV tags for layouts, give the tag an ID and assign attributes using CSS.

Changing to CSS and DIV tags help in the following ways:

• simplify code
• reduce the amount of code
• increase page load speed
• separate content from presentation
• help pages adapt to different device resolutions
• make pages easier for search engines to crawl
• make code more compliant with evolving web page design standards
A theme named **Administration Theme - Charcoal** is included as an example of CSS-driven, DIV-based layouts. To view the **Administration Theme - Charcoal** DIV-based layout, complete the following steps.

**Procedure**

1. Navigate to **Content Management > Design > Layouts**.
2. Click **Admin 1 Column**
3. Review the code.

**Content meta tag hierarchy**

Page and site level meta tags are included in a content meta tag hierarchy.

**Site and page level tags**

CMS supports page level and site level tags. The system behavior is to show the sum of all page level and site level tags. For example, if you have two tags on the site and one tag on the page, all with different names, you see three tags on the page. Two are from the site and one is from the page. If both the site and the page have a tag of the same name, only the page tag is used.

⚠️ **Note:** The Content Management System does not support some commonly used meta tags. For example, you cannot use the X-UA-Compatible meta tag, which allows you to specify which version of Internet Explorer a site should be rendered in.

**Example: all tags have unique names**

<table>
<thead>
<tr>
<th>Site Level</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Content</td>
<td></td>
</tr>
<tr>
<td>breakfast</td>
<td>eggs</td>
<td></td>
</tr>
<tr>
<td>lunch</td>
<td>sandwich</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Page Level</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Content</td>
<td></td>
</tr>
<tr>
<td>dinner</td>
<td>steak</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Output</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Content</td>
<td></td>
</tr>
<tr>
<td>breakfast</td>
<td>eggs</td>
<td></td>
</tr>
<tr>
<td>lunch</td>
<td>sandwich</td>
<td></td>
</tr>
<tr>
<td>dinner</td>
<td>steak</td>
<td></td>
</tr>
</tbody>
</table>
Example: page level tag overrides site level tag

<table>
<thead>
<tr>
<th>Site Level</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>breakfast</td>
<td>eggs</td>
</tr>
<tr>
<td>lunch</td>
<td>sandwich</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Page Level</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>lunch</td>
<td>tacos</td>
</tr>
<tr>
<td>dinner</td>
<td>steak</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Output</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>breakfast</td>
<td>eggs</td>
</tr>
<tr>
<td>lunch</td>
<td>tacos</td>
</tr>
<tr>
<td>dinner</td>
<td>steak</td>
</tr>
</tbody>
</table>

Content Management integration points

Integration points use content blocks in CMS to link different applications together using static and dynamic methods.

By using integration points, users can connect to different systems from a single page. The power of the CMS is that it can display any data within the ServiceNow platform. The ESS portal, for example, connects users to a service catalog, a knowledge base, and a help and incident reporting site. Each section contains a set of links to additional content. List blocks offer the easiest way to display data dynamically. Content types define how lists link to the detailed data they reference.

Generating lists from the ServiceNow platform is straightforward, especially if you use filtering. When the CMS was first introduced, lists were the only method available to create navigational systems for sites. Content types define system record links using specific templates to define the list and the details.

- Summary template: defines the list
- Detail template: defines the detail as it is rendered in a page.

The templates work together to pass data attributes or unique record identifiers (sysid) into a single detail page that manages the data. Any attribute variations use the URL sent to the page.

Understanding how content types work can mean the difference between a site with 20 pages versus a site with 200 pages. There is a time for both types.
of data calls. Depending on the task, there are appropriate times to use static content and times for dynamic methods.

**View links between system elements and URLs**

You can view the links between your system elements and their URLs to render more specific content within your site.

**Before you begin**

Role required: content_admin or admin

**About this task**

See the [page](#) for an overview of URL syntax in the ServiceNow platform.

The Incidents list offers a quick example of viewing a form within its own tab. This viewing method illustrates how to append the URL string to render more specific content within your site.

**Procedure**

1. Navigate to **Incident > All**.
2. Right-click in a blank area within the content frame and select **Open Frame in New Window** or **Open Frame in New Tab**.

   The URL returned looks similar to this example.

   `<instance_name>/incident_list.do?
sysparm_userpref_module=b55b4ab0c0a80009007a9c0f03fb4da9`

   The URL is comprised of the following elements.

   - **incident_list.do?** is the call to the list with no parameters passed into it. Explore context menu options and list filtering variations to see how the URL string is appended with each action.
   - **incident_list.do?sysparm_query=&sysparm_view=ess** is an example of how the view is passed in the URL string.
   - **incident_list.do?sysparm_query=GROUPBYactive&sysparm_view=** is how the URL looks when the **group by** option is chosen from the context menu.
   - **incident_list.do?sysparm_query=category%3Dsoftware** is the result of applying a **category is software** filter to the list.

   Explore all the options available within the right-click menu. Click through to the Incident form itself (incident.do) to see what the URL string does when parameters are passed into it.
Element link examples

View examples that show how to create a site pointing to various system data in several different data tables.

The following examples illustrate setting up access to the following system data.

- Knowledge: building a versatile front end for a knowledge base, from overview page to variations on the list definitions used in the site.
- Catalog: ideas for a business-to-consumer shopping experience that pulls various items and forms from your service catalog.
- Service Portfolio: using the business service portfolio to contain all defined services offered by your organization.
- Featured reports: methods for linking to the most important reports.

Example links to system data

Page source view

Use the tools available in your browser to view the frame source page and understand what URL address bars pass between system frame sets.

The Firefox browser, for example, has the developer tools option. This option provides an easy way to view records that render within the main content frame (`gsft_main`) of the ServiceNow platform. Also, Firefox quickly builds menus and links to records within the system.
This Firefox functionality is useful when stepping through the menu items section.

Static methods

Static methods in the CMS application were created for ease of use.

Form-based menu management and WYSIWYG code editing can be useful to both advanced and entry-level users. The technical ability of subject matter experts (SMEs) managing the language of your site can vary considerably. Letting SMEs write the content and having a technical resource manage the linking expedites menu and link creation within the system.
Navigation Menu Links

Use base system templates to group similar links for placement on the page. Though the terminology is different (menu sections and menu items), this type of linking behaves the same way as content links. For more information on creating a navigation menu block, see Create a navigation menu block.

Static HTML Details

Content blocks that are useful for areas administered by developers unfamiliar with HTML or markup. Anyone familiar with markup can use dynamic blocks because they are extendable. For more information on static HTML, see Using Content Blocks.

Content Links

The predecessors to navigation menus from when the CMS was first introduced. Use content links to make navigational links by defining several content links under the same category. Then, call the links as a list referencing the Content Link [content_link] table.

iFrame Details
Used both dynamically and statically throughout the system. Using them is an easy way to bring any form or list into your CMS pages. For more information on iFrame methods, see Using Content Blocks.

**Dynamic methods**

While static methods are a powerful navigational tool, you have more control over data rendering using the dynamic methods.

Reference common code in the system to make long-term maintenance of the site easier. Coding skills are useful when implementing dynamic methods.

**Static and dynamic methods**

<table>
<thead>
<tr>
<th>Content Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sites</td>
</tr>
<tr>
<td>Pages</td>
</tr>
<tr>
<td>Blocks</td>
</tr>
<tr>
<td>All</td>
</tr>
<tr>
<td>Headers</td>
</tr>
<tr>
<td>Navigation Menus</td>
</tr>
<tr>
<td>Dynamic</td>
</tr>
<tr>
<td>Lists</td>
</tr>
<tr>
<td>Static HTML</td>
</tr>
<tr>
<td>Specialty Content</td>
</tr>
<tr>
<td>Flash Movies</td>
</tr>
<tr>
<td>Content Links</td>
</tr>
<tr>
<td>IFrames</td>
</tr>
<tr>
<td>Design</td>
</tr>
<tr>
<td>Configuration Page</td>
</tr>
<tr>
<td>Page Detail Settings</td>
</tr>
<tr>
<td>Content Types</td>
</tr>
<tr>
<td>List Definitions</td>
</tr>
<tr>
<td>Login Rules</td>
</tr>
</tbody>
</table>

**Dynamic Blocks**

These blocks are where the majority of your work resides. For more information, see Configure dynamic blocks.

**Frames**

Frames are meant to be decorative wrappers around any block in the system. They are mentioned with dynamic blocks because frames are essentially UI macros with the category of Frame. Frames apply the \$\{body\} variable to a block and define where the block is inserted when rendered on the page.
Lists

Lists generate links to records based on the filtering rules you define. Lists can be sorted for presentation by any field in the corresponding record. Lists help supplement navigation and pull data from outside the CMS. For more information, see Customize the list block.

Content Types

Content types provide site-specific control of how system data defined as templates is rendered. The rendering of lists is considered first (summary templates). The next consideration is the detail template, which allows control over the record rendering.

List Definitions

List definitions enable you to extend the summary template defaults defined on the site level. Used with frames, list definitions render the same data differently based on the placement on the page or site. For more information, see Configure list definitions.

Detailed Content

Detailed content in page detail settings) are blocks that display the content of an existing document as a block on a content page. For more information, see Configure a detailed content block.

Example integration points

Each element on the page links to a specific URL point.

Business Services links to a content page (CMS page referenced: Business Service Portfolio, URL: business_service_category.do) that pulls the system service catalog homepage into a frame within the content area. Each link within this section uses the browse by category page, where you pass in the name of the category to return results.
• Target page iFrame URL: catalog_home.do?
sysparm_nameofstack=aabdae07ef22100914304167b22567d&sysparm_view=business&sysparm_clear_stack=yes

• Target page frame name: gsft_main
  ◦ Desktop Computing URL: category_browse.do?category=Desktop Computing
  ◦ Business Applications URL: category_browse.do?category=Business Applications
  ◦ Communications Services URL: category_browse.do?category=Communications Services
  ◦ Infrastructure Services URL: category_browse.do?category=Infrastructure Services
  ◦ Hosting Services URL: category_browse.do?category=Hosting Services

**Featured Services** links to a content page which pulls a small subset of services into an iFrame.

• iFrame URL: com.glideapp.servicecatalog_category_view.do?
sysparm_parent=d67c446ec0a80165000335aa37eafbc1&sysparm_view=

• Frame name: gsft_main
  ◦ Install Software URL: catalog.do?
    url=com.glideapp.servicecatalog_cat_item_view.do?
sysparm_id=10d69689c611227600ffeba41c664824
  ◦ Email Account URL: catalog.do?
    url=com.glideapp.servicecatalog_cat_item_view.do?
sysparm_id=d67a86b6c0a80165009386c752cd4a09
  ◦ Electronic Messaging URL: catalog.do?
    url=com.glideapp.servicecatalog_cat_item_view.do?
sysparm_id=533798810a0a0b2600f1a03593e19058
  ◦ VPN RSA Token URL: catalog.do?
    url=com.glideapp.servicecatalog_cat_item_view.do?
sysparm_id=d67b099ac0a80165019d0c276b772502
  ◦ Shared Storage (SAN) URL: catalog.do?
    url=com.glideapp.servicecatalog_cat_item_view.do?
sysparm_id=cedd458a0a0b8300c3b1e32e7a3ac2

**Reporting** links to a content page that pulls the reports page into an iFrame. All links within this menu leverage homepages in the system, which creates an issue with the home.do URL. Notice in the following links that ../ is used to create a relative URL outside of the CMS site home.do definition. Without this path, the site homepage would render within the iFrame.
Content Management testing

Test your site to ensure that all pages display correctly, links go to the specified address, and images are not broken. It is important to test the site as you build it. Do not wait until just before launch to begin testing.

Also, test templates as you create them so any issues are resolved before creating other content based on the templates. Recruit as many people as possible to help you test.

Here are some general site testing guidelines:

• Test on the browsers and platforms your site visitors use
• Test on various monitors (for example, LCD and CRT)
• View pages using different screen resolutions
• View pages using different color settings
• Test all navigation and links
• Test items that can be downloaded (for example, PDF files)
• Test the search functionality
• Test site security
• If necessary, test for accessibility (for guidelines, see the W3C Website Accessibility Initiative)
Global search in Content Management

When you add global search to a CMS site, two different search result blocks can display, depending on the user role: global or no global.

Roles are defined at **System Properties > Global Text Search**.

- **Search Results (Global)**: For users with permission to use the global search within the normal frame set. The normal frame set is defined as the default, non-CMS user interface with the set of frames.
- **Search Results (No Global)**: For users without permission to use the global search. Searches only the knowledge base and the catalog.

The header search bar and the Search dynamic block in the base system both automatically handle the permissions and direct the user to the appropriate search results. In the base system, the search result blocks are deployed on the same Search Results content page.

In order for the global search to work properly, it is important to ensure that the DEFAULT directs users to a working content page. If not, the results from the global search link back to the frame set, not to pages within the CMS site.

⚠️ **Note**: The global search is similar to the normal frame set user interface and ties to the same roles ().

**Search Results (Global)**

Before you use the **Search Results (Global)** dynamic block, define content types to control the behavior a search result is clicked. If no content type is defined for a table, selecting a link on that table renders the results according to the DEFAULT content type. It is good practice to point the DEFAULT content type to a page with a normal "Current Document" detailed block. Set the content type detail (Detail Template field) to have just an iFrame.

The **Search Results (No Global)** dynamic block does not require any additional configuration.

**CMS translation**

You can translate CMS sites by activating internationalization plugins and manually translating custom interface strings.

Two tables support the translation of a CMS site into other languages.

- **Translated Name / Field [sys_translated]**: Stores strings that are shared or commonly used within a site. These include menu section names, menu item names, site breadcrumb names, link names, and footer menu links.
Internationalization plugins typically provide translations for these strings. See Localization settings.

- Translated Text [sys_translated_text]: Stores unique string translations which you create when you manually translate interface elements. See.

**View a translated CMS site**

Activating an internationalization plugin provides a quick way to see translated strings for CMS menus, breadcrumbs, and links. For a full translation, you must translate the instance manually.

**About this task**
The following example explains how to view a translated site in Japanese.

**Procedure**

1. Navigate to System Definition > Plugins.
2. In the Go to filter, select Name, enter i18N, and then press the Enter key.
3. Activate both the I18N - Japanese Translations and the I18N: Knowledge Management Internationalization Plugin v2 plugins.
4. Refresh the browser.
6. Browse the site to see the translated language strings.
7. Navigate to the ESS Portal. The path is: http://Instance Name.service-now.com/ess/.
8. Browse the site to see the translated language strings in the ESS Portal.

**Related information**

**Conversational Interfaces**

Enable your users to engage with live agents, virtual agents, or both using ServiceNow® Conversational Interfaces. These interfaces provide tools for creating and managing optimal conversational experiences for your users, in the chat channels that they prefer.

**Conversational Interfaces operational impact**

Conversational Interfaces includes Virtual Agent and Live Agent. These interfaces empower you to enable the solutions that you prefer for your
organization. You can reach your operational goals and improve end-user satisfaction in the following ways:

- Achieve greater levels of productivity and satisfaction by simplifying and automating your user experiences.
- Increase scalability of your organization, as well as user productivity, with automation support.
- Enable your technicians and agents to better manage their daily interactions and workload.
- Integrate with a number of messaging channels that are already familiar to your users.
- Monitor user engagement analytics and metrics with a configurable dashboard.

Conversational Interfaces applications, features, and channels

For first time set up, you can access the Conversational Interfaces guided setup interface that walks you through setting up and configuring your conversational interfaces. Conversational Interfaces are available to support organizations throughout your enterprise with applications, features, and supported channels, including:

Conversational Interfaces Guided Setup

Work through the steps necessary to setup and configure your conversational interfaces for the first time with this helpful interface.
Create a personalized setup process for the conversational interface features you need.

**Workspace Agent Chat**

Provide your agents with a workspace that has built-in productivity features for engaging with customers. Your agents can:

- Use shortcuts, known as **quick actions**, for common activities, such as transferring a chat to another queue or displaying contextual info related to the chat.
- Reuse common responses, such as greetings or answers to frequent questions, with **response templates**.
- Get possible solutions for issues, derived from searches of related issues in Knowledge articles, Q&A, and previous incidents or cases with **Agent Assist**.
- Interact with customers in their native language using **Dynamic Translation for Agent Chat**.
- Manage work assignments delivered to agents’ inboxes, enabling them to set their availability and accept, reject, or transfer chats.
- Trigger a Virtual Agent self-service topic that walks end users through a task with **Agent Autopilot**.
- Provide agents with the option to add work notes or updates after they finish a support session with **Interaction wrap up**.

**Advanced Work Assignment**

Automatically assign and route work to your agents by using work item queues, routing conditions, and other items that affect your support staff, such as agent availability, agent work history, relationships with certain customers, capacity, and skills.

Advanced Work Assignment provides supervisors with management tools to:

- Set the service channels you prefer, such as chat, messaging for assigning work to your agents, and more.
- Monitor agent presence, capacity, and unassigned work items. You can also Reassign chats that timeout.
- Privately converse with agents to provide guidance or assistance during support chats or publicly join customer chats as needed with **Agent Whisper**.
• Automatically handle queue overflows.
• Set the controls that agents use to set their availability and accept or reject work items with inbox controls.

Virtual Agent

Augment customer service with a virtual agent that handles common support issues, using pre-built conversations.

• Determine the pre-built Virtual Agent conversations best suited for your organization through a quick analysis of your incidents and cases using Topic Recommendations.

• Create bot conversation flows using Virtual Agent Designer.
  ◦ Use Natural Language Understanding (NLU) models, including multi-language support.
  ◦ Extend search functionality in conversations using AI Search.
  ◦ Reuse subflows created in Flow Designer.
  ◦ Update ServiceNow NLU models from Virtual Agent Designer.
  ◦ Use categories to manage how topics are organized and displayed.

• Transfer to Live Agent.

• Control Virtual Agent chat experiences for end users with Custom Greetings and setup.

• Use Virtual Agent to intercept and resolve common incidents and issues submitted by users with Incident Auto-Resolution.

• Access the Custom Chat Integration Framework.

Conversational channels

Several supported channels are available across conversational products, including:

• Synchronous – Chat channels such as, web client, ServiceNow mobile, pre-built conversational integrations.

• Asynchronous – Messaging channels for long running conversations.
  ◦ SMS channel.
  ◦ Web and mobile channel configured for messaging rather than chat.

• Conversation management based on channel type.
◦ Conversation timeouts for chats in Virtual Agent and Agent Chat.
◦ Conversation timeouts for long-running chats.

Conversational integrations

Run Virtual Agent or Agent Chat in chat or messaging channels familiar to your users, using integrations for Slack, Microsoft Teams, and Workplace by Facebook.

If you’re using messaging channels different from the supported pre-built channels, you can create custom integrations for them.

Conversational analytics

Use pre-built dashboards to monitor user engagement with Virtual Agent conversations and metrics related to Agent Chat.

Conversational Interfaces benefits

User satisfaction

Provide better self-service by helping users and customers get what they need quickly with always-on, omni-channel experiences.

Enable your users to get immediate help, day or night, with Virtual Agent.

Boost user and customer satisfaction by offering a personalized Virtual Agent experience, whereby user information is remembered and applied during the conversation.

Increased productivity

Fuel agent and technician productivity with Workspace Agent Chat and its built-in productivity features.

Users and customers contacting support also reap the benefits of this productivity by experiencing a seamless, quick, and professional response to requests and issues.

Automation support

Scale your support organizations and deliver great experiences for your users, customers, and your agents and technicians with Advanced Work Assignment.

Manage queue overflows by automatically assigning and routing work to available agents.
Configure work to route to agents with special skills to handle an interaction or to agents with an interaction history with a particular user or customer.

Get started with Conversational Interfaces
Select a tile to get started with Conversational Interfaces.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Learn how employees, customers, and agents use Conversational Interfaces.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Workspace Agent Chat</td>
</tr>
<tr>
<td></td>
<td>• Advanced Work Assignment</td>
</tr>
<tr>
<td></td>
<td>• Virtual Agent</td>
</tr>
<tr>
<td></td>
<td>• Conversational channels</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Configure</th>
<th>Plan and configure your Conversational Interfaces implementation with <strong>Conversational Interfaces Guided Setup</strong> as well as the following processes:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Conversational Interfaces Guided Setup</td>
</tr>
<tr>
<td></td>
<td>• Set up Agent Workspace Chat</td>
</tr>
<tr>
<td></td>
<td>• Get started with Advanced Work Assignment</td>
</tr>
<tr>
<td></td>
<td>• Configuring Virtual Agent</td>
</tr>
<tr>
<td></td>
<td>• Set up Incident Auto Resolution</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Integrate</th>
<th>Extend Conversational Interfaces capabilities by integrating with other applications.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Design and build automated conversations and reusable topic components using Virtual Agent.</th>
</tr>
</thead>
</table>
Analytics and Reporting Solution

Improve processes with the analytics dashboards.

- Analytics and Reporting Solutions for Advanced Work Assignment
- Analytics and Reporting Solution for Virtual Agent

Additional resources

Connections and Credentials

Credentials and connection information are required to gain access to a computer or network device for Discovery, Service Mapping, and Cloud Management or to perform work using Orchestration. When adding content to Share or AppStore, you can configure connections and credentials relevant to your environment without modifying built content.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Upgrade to Rome</td>
<td>• Create and test your credentials</td>
</tr>
<tr>
<td>• Introduction to credentials, connections, and aliases</td>
<td>• Check IP service affinity for Discovery and Orchestration</td>
</tr>
<tr>
<td>• Getting started with credentials</td>
<td>• Prepare network connections for MID Servers</td>
</tr>
<tr>
<td>• Domain separation and Credentials and Connections</td>
<td></td>
</tr>
<tr>
<td>• Credential affinity for Discovery and Orchestration</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Integrate</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td>• External credential storage</td>
<td>• Credentials troubleshooting</td>
</tr>
<tr>
<td>• CyberArk credential storage integration</td>
<td>• Search the Known Error Portal for known error articles</td>
</tr>
<tr>
<td></td>
<td>• Contact Customer Service and Support</td>
</tr>
</tbody>
</table>
Introduction to credentials, connections, and aliases

All application integrations in the Now Platform use connections, credentials, and aliases to enable applications to access resources.

Before you can execute an application integration in the Now Platform, you must create and configure connection information, corresponding credentials, and add an alias. To understand how ServiceNow defines these terms:

Connection

A connection is an integration with a system, such as an IP address or endpoint with protocols. It contains specific details, such as database particulars, when integrating with a database.

Credential

A credential is the authentication data required to make the connection, such as an ID and password.

Alias

An alias is a naming convention, or tag, that ties to a set of connections or credentials on your instance. An alias contains the necessary connection and credential information to make an application integration. Rather than enter that information every time you integrate, you can use an alias. For example, you can designate an alias to house your QA, development, and production credentials for the same application integration. The alias resolves the application integration for each environment. The Now Platform distinguishes different types of aliases:

Credential Alias

This alias associates to credential data only, and resolves during runtime.

Connection and Credential Alias

This alias associates to connection information and the credential data required to complete the integration, and resolves during runtime.

Within connection and credential aliases, you can also create additional aliases called child aliases. Child aliases allow you to create multiple connections within the same application integration. When you create a child alias, the alias you created it under becomes a parent alias. While child aliases inherit properties from their parent alias, child aliases carry their own connection and credential information.
Benefits to using Connections, Credentials, and Aliases

- Central location to store and manage credentials to an external service
- Define once and reuse for multiple platform features
- Minimize configuration of other platform features
- Allow non-administrators to use predefined connections and credentials
- Increased security

Features using Connections, Credentials, and Aliases
The following features use connections, credentials, and aliases:

- Flow Designer
- IntegrationHub
- Cloud Management
- Discovery
- Orchestration
- Service Mapping

You can set up aliases on the Now Platform in one of two ways:

- Using the Connections and Credentials module. See Create a Connection & Credential alias.
- In the Connections dashboard of IntegrationHub. See Add a connection.

Note: IntegrationHub requires a separate subscription. For more information, see Request IntegrationHub.

Credential synchronization on MID Servers

Each MID Server in your network synchronized with the instance keeps a copy of every credential that you create. The Management, Instrumentation, and Discovery (MID) Server is a Java application that enables communication and the movement of data between a ServiceNow instance and external applications, data sources, and services. This synchronization speeds up the reading of credentials when applications like Discovery or Service Mapping need to access multiple devices on the network. The MID Servers synchronize when they find a credentials_reload job in the ECC Queue. The reload job instructs the MID Server to make a SOAP call to the instance to get the entire list of credentials in the Credentials [discovery_credentials] table, including all the field values. To learn more, see MID Server.

The SOAP response that your instance sends to each MID Server also includes custom fields that you added to any credential form that you customized. If
you added reference fields, the data in the referenced table is also sent as part of the SOAP response. This can lead to performance issues when credential synchronization occurs with multiple MID Servers. To control this, manually add these properties to the System Properties [sys_properties] table:

⚠️ **Note:** To change the values in these properties, add them to the System Properties [sys_properties] table. If you do not add them, the system uses the default value.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.credentials_user_fields</td>
<td>Includes all customized fields in credential sync. Set this property to false if you do not want to include the fields that you added to credential forms.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> true</td>
</tr>
<tr>
<td>com.snc.credentials_recursion_depth</td>
<td>Defines the number of tables to traverse when the credential-sync mechanism collects fields from reference tables. Lower this number if you are experiencing performance issues and you have customized credential forms that include reference fields to tables that also have reference fields.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 3</td>
</tr>
</tbody>
</table>

**Scope protections for Credentials and Connections**

You can classify certain types of Connection & Credential records as belonging to a scope, and extend scope protections to them. These scope policies protect records you create in a table, and prevent interactions with records that are private to another scope.

An **Application** field is available in the Connection [sys_connection] and Discovery Credentials [discovery_credentials] tables for associating these types of records to specific scopes. It is not visible on UI forms in Rome, but you can easily add it to them. To learn more about these record types, and adding the field to their UI forms, see:

- Getting started with connections
- Getting started with credentials
• Credential aliases for Discovery
• Configuring the form layout

Restricting the use of a Connection & Credentials record to a specific scope is important for managing applications that require enforced security. These applications include HR Service Delivery or Security Operations Connection & Credentials records created in scoped administered applications are not visible to admin users. Associating a Connection & Credentials record to a specific application scope affords the following protections:

• Applies Access Control List rules (ACLs) to restricted scopes. To learn more about scoped ACLs, see Access control list rules.

ℹ️ Note: Some applications using scope administration and enforced security may require additional setup. To learn more, see Manage HR roles

• Protects records when queried using a script. If you do a query from the Global scope, and the Connection & Credential record is in a protected scope, it doesn’t appear in the query, unless given access to it.

You can customize and grant access to query-restricted records by using Restricted Caller Access. To learn more, see Restricted caller access privilege settings. Scoping restrictions also apply to all children tables of the Connection [sys_connection] and Discovery Credentials [discovery_credentials] tables. Empty fields and other scopes are not restricted.

ℹ️ Note: Scope protections are only enabled for specific secured scopes to avoid confusion when setting up new records. If someone makes a connection in their scoped application scope, it doesn’t have automatic scope restriction.

**Domain separation and Credentials and Connections**

Domain separation is supported in Credentials and Connections. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.
Support level: Standard

- Includes Basic level support.
- Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see Application support for domain separation.

Overview

Credentials are tied to various ServiceNow features which access systems outside the instance. Credentials follow the domain separation tied to the feature employing the credentials.

Connections are protocol-specific information referencing a target host outside the instance. A connection can specify the domain to run an activity.

How domain separation works in Credentials and Connections

Credentials access resources outside of the instance, and are used by the Orchestration, Orchestration, and Orchestration applications. These credentials are not tied to a specific domain, rather, they can be bound to an application and then follow the domain separation that the application uses. Credentials can also be assigned to a MID Server, and then follow the domain separation specified by the MID Server configuration.

Connections access a target host using a JMS, JDBC, or HTTP(s) connection. You can specify global or a specific domain to which the connection belongs.

Related information

Domain separation for service providers

Connection & Credential configuration templates

Enable users with the admin and flow_designer roles to set up spoke integrations with third-party systems using a single, customizable form.

For example, you can set up an OAuth integration, which registers an OAuth provider, generates a token, and creates connection and credential records.
An action designer or developer can use a configuration template to set up the spoke in one place and the system creates the associated records.

**Benefits**

Configuration templates enable:

- Admins or flow designers to set up a complex integrations using a single form.
- Developers to set static values in an integration, simplifying the setup process for admins and flow designers.

**Supported credential types**

You can create configuration templates for integrations with these credential types:

- Basic auth
- API key
- OAuth JWT Bearer grant type
- OAuth Authorization Code grant type
- Custom authentication

**Configuration template components**

**Default Data Template**

Sets static information that applies to every integration. For example, you can set the API and token URL if the value applies to every integration.

**Dynamic Data Template**

Defines the information that the user must complete to set up the integration. For example, you can add user name and password key-value pairs to gather user-defined values.

**Post Processing Script**

Creates additional records required by the integration. For example, if your spoke includes custom tables, you can create records in those tables based on user input in the configuration template. This script executes after the connection and credential records are created.
Demo data
The Connection & Credential Templates [sys_alias_templates] table includes example templates to demonstrate how to set up templates for common authentication types. Use these examples as a guide when creating your own.

Configure a template for OAuth JWT Bearer grant type
This example configuration template sets up Credential and Connection records using the JWT Bearer grant type to authenticate requests to Docusign.

Default data template
Each top-level item in the default data template creates an associated record. The template includes these sections:

- **Credential**: Creates a record in the Credentials table.
- **Connection**: Creates a record in the Connections [sys_connection] table and any associated connection records.
- **Additional**: Optionally creates records in a custom table. The post processing script tells the system what to do with these records.

The following example creates the records required for OAuth JWT Bearer grant type authentication.

```json
{
  "credential": {
    "oauth_entity": {
      "oauth_entity_profile": [
        {
          "grant_type": "urn:ietf:params:oauth:grant-type:jwt-bearer",
          "name": "Docusign Profile",
          "default": true,
          "oauth_entity_profile_scope": [
            "users:read.email"
          ]
        }
      ],
      "code_challenge_method": "S256",
      "type": "consumer",
      "oauth_entity_scope": [
        {
          "oauth_entity_scope": "users:read.email",
          "name": "email"
        }
      ]
    }
  }
}
```
"client_id": "<provider-client-id>",
"use_mutual_auth": false,
"revoke_token_url": "https://<provider-domain-name>.com/oauth2/revoke",
"default_grant_type": "urn:ietf:params:oauth:grant-type:jwt-bearer",
"public_client": false,
"oauth_api_script": "3e3a3a11c333210016194ffe5bba8f70",
"name": "Docusign Spoke OAuth",
"client_secret": "<provider-client-secret>",
"auth_url": "https://<provider-domain-name>.com/oauth2/auth",
"token_url": "https://<provider-domain-name>.com/oauth2/token",
"redirect_url": "https://<instance-name>.service-now.com/oauth_redirect.do"
},
"jwt_provider": { 
  "jwt_keystore_aliases": { 
    "kid": "<provider-key-id>",
    "name": "Docusign Spoke JWT Key",
    "signing_keystore": "<signing-keystore-sys-id>",
    "signing_algorithm": "rsa_256",
    "signing_key_password": "password"
  },
  "jwt_claim_validation": [ 
    { 
      "name": "iss",
      "is_standard": true,
      "data_type": "string",
      "value": "<docusign-iss-claim>"
    },
    { 
      "name": "sub",
      "is_standard": true,
      "data_type": "string",
      "value": "<docusign-sub-claim>"
    },
    { 
      "name": "aud",
      "is_standard": true,
      "data_type": "string",
      "value": "<docusign-aud-claim>"
    },
    { 
      "name": "scope",
      "is_standard": false,
      "data_type": "string",
      "value": "signature impersonation"
    }
  ],
  "name": "Docusign Spoke JWT Provider",
  "jwt_api_script": "9ef6af86ff10330001d3cd6bd53bf144"}
Dynamic data schema

The dynamic data schema defines what the user sees when they create a Connection & Credential alias and collects their input. Use dot-walking syntax to map user input to fields created in the default data template. For example, `connection_fields` maps user input to the `connection_url` field in the `connection` object created by the default data template.

```json
{
  "connection_fields": [
    {
      "name": "connection.connection_url",
      "label": "Connection URL",
      "type": "text",
      "defaultValue": "https://demo.docusign.net",
      "hint": "Connection URL for Docusign"
    }
  ],
  "additional_fields": [
    {
      "name": "additional.docusign_account_id",
      "label": "Docusign Account Number",
      "type": "text",
      "hint": "Docusign Account Number"
    },
    {
      "name": "additional.docusign_account_name",
      "label": "Docusign Account Name",
      "type": "text",
      "hint": "Name to identify the Docusign account"
    }
  ]
}
```
{  
  "name": "additional.docusign_account_email",
  "label": "Docusign Account Email",
  "type": "text",
  "hint": "Docusign Account Email"
},
"credential_fields": [
  
  {  
    "name": "credential.oauth_entity.client_id",
    "label": "OAuth Client ID",
    "type": "text",
    "hint": "Client ID for Docusign"
  },
  {  
    "name": "credential.oauth_entity.redirect_url",
    "label": "OAuth Redirect URL",
    "type": "text",
    "defaultValue": "https://<instance-name>.service-now.com/oauth_redirect.do",
    "hint": "Callback URL for Docusign"
  },
  {  
    "name": "credential.jwt_provider.jwt_claim_validation[0].value",
    "label": "Issuer (iss) Claim value",
    "type": "text",
    "hint": "The integrator key (also known as client ID) of the application"
  },
  {  
    "name": "credential.jwt_provider.jwt_claim_validation[1].value",
    "label": "Subject (sub) Claim value",
    "type": "text",
    "hint": "The user ID of the user to be impersonated"
  },
  {  
    "name": "credential.jwt_provider.jwt_claim_validation[2].value",
    "label": "Audience (aud) Claim value",
    "type": "text",
    "defaultValue": "account-d.docusign.com",
    "hint": "The URI of the authentication service instance to be used e.g. account.docusign.com"
  },
  {  
    "name": "credential.jwt_provider.jwt_keystore_aliases.kid",
    "label": "Key ID (kid)"
  }
]
Post processing script

The following post processing script maps user input to fields in the sn_docusign_spoke_accounts table.

```javascript
(function execute(aliasId, connectionSysId, jsonDefaultData, jsonDynamicData) {
    var jsonDynamicDataP = JSON.parse(jsonDynamicData);
    var accountGR = new GlideRecord("sn_docusign_spoke_accounts");
    accountGR.setValue("account_name", jsonDynamicDataP["additional.docusign_account_name"]);
    accountGR.setValue("alias", aliasId);
    accountGR.setValue("email", jsonDynamicDataP["additional.docusign_account_email"]);
    accountGR.setValue("id", jsonDynamicDataP["additional.docusign_account_id"]);
    accountGR.insert();
})(aliasId, connectionSysId, jsonDefaultData, jsonDynamicData);
```

Resulting Docusign Connection and Credential configuration form

When the user navigates to the associated Docusign Connection & Credential Alias and selects Create New Connection & Credential, the following dialog appears.
Create a configuration template

Create a template that defines the inputs required to set up a spoke. Set static key-value pairs to create records and set values that apply to every integration. Set dynamic key-value pairs to gather user input and set field values that may vary. Using this template, admins and flow designers can set up the spoke from a single form.
Before you begin
Role required: admin or action designer

Procedure
1. Navigate to **IntegrationHub > Connections & Credentials > Configuration Templates**.
2. Click **New**.
3. Select the type of configuration template you want to create. Selecting a type provides starter data to help you configure the template.

<table>
<thead>
<tr>
<th>Configuration type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP Connection with OAuth Authorization Code grant type</td>
<td>Creates a template to register the third-party system as an OAuth provider using an authorization code.</td>
</tr>
<tr>
<td>HTTP Connection with OAuth JWT Bearer grant type</td>
<td>Creates a template to register the third-party system as an OAuth provider using a JSON Web Token.</td>
</tr>
<tr>
<td>HTTP Connection with Basic Auth Credential</td>
<td>Creates a template to integrate with the third-party system using basic authentication.</td>
</tr>
<tr>
<td>HTTP Connection with API Key Credential</td>
<td>Creates a template to integrate with the third-party system using an API key.</td>
</tr>
<tr>
<td>Other Configuration</td>
<td>Creates a blank template, enabling you to set up a template for custom authentication.</td>
</tr>
</tbody>
</table>

4. In the **Name** field, add a name to easily identify the template.

5. In the **Default Data Template** field, make any required changes. This field sets static information that applies to every integration. For example, you can set the API and token URL if the value applies to every integration.

These objects in the default data template are required:

- `credential`: Creates a credential record with the required fields.
- `connection`: Creates a connection record with the required fields. Access connection attributes using the `extended_attributes` child object. For example:

```json
"connection": {
    "extended_attributes": {
        "api_version": "v1"
    }
```
You can use the additional object to set up data for a custom table, and use the post processing script to insert the data into the table.

**Note:** In the default data template for the OAuth Authorization Code grant type, the values for the `oauth_entity_profile_scope` and the `oauth_entity_scope` keys must match. In the following example, both keys have the Read user's email value.

```json
"oauth_entity_profile": [
  {
    "grant_type": "authorization_code",
    "name": "<provider-name> Profile",
    "default": true,
    "oauth_entity_profile_scope": [
      "Read user's email",
      "email"
    ]
  },

  "code_challenge_method": "S256",
  "type": "consumer",
  "oauth_entity_scope": [
    {
      "oauth_entity_scope": "Read user's email",
      "name": "email"
    }
  ]
]
```

6. In the **Dynamic Data Schema** field, make any required changes. This field defines the information that the user must complete to set up the integration. For example, you can add user name and password key-value pairs to gather user-defined values.

Fields in the dynamic data schema include these properties:

- **name**: The field that the user's input maps to. For example, to map user input to the Connection URL field in the Connection record, enter `connection.connection_url`.
- **label**: The field label. This is the label that the user sees when completing the template.
- **type**: The field type. Make sure that this data type matches the data type of the field you are mapping the value to.

- **defaultValue**: Optional. The field's default value. If no default is provided, the hint displays.

- **hint**: Optional. Hint text to display when there is no default value.

**Note:** If setting up a template for OAuth JWT Bearer grant type authentication, you may want user input for a single key-value pair in the `jwt_claim_validation` array. You can refer to a single key-value pair in the dynamic data schema by referring to its index in the array. For example, your default data template might include this snippet.

```json
"jwt_claim_validation" : [ {
  "name" : "iss",
  "is_standard" : true,
  "data_type" : "string",
  "value" : "<docusign-iss-claim>"
}, {
  "name" : "sub",
  "is_standard" : true,
  "data_type" : "string",
  "value" : "<docusign-sub-claim>"
}, {
  "name" : "aud",
  "is_standard" : true,
  "data_type" : "string",
  "value" : "<docusign-aud-claim>"
}, {
  "name" : "scope",
  "is_standard" : false,
  "data_type" : "string",
  "value" : "signature impersonation"
} ]
```

Refer to the `iss` key-value pair using the item's zero-based index: `credential.jwt_provider.jwt_claim_validation[0].value`.

**7. Optional:** In the **Post Processing Script** field, add a script that creates additional records required by the integration. For example, if your spoke includes custom tables, you can create records in those tables based on user input in the configuration template. This script executes after the connection and credential records are created. The post-processing script has access to these global objects.
<table>
<thead>
<tr>
<th>Global object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>aliasId</td>
<td>Sys_id of the alias record from the Connection &amp; Credential Alias [sys_alias] table.</td>
</tr>
<tr>
<td>connectionSysId</td>
<td>Sys_id of the connection record created by the template.</td>
</tr>
<tr>
<td>jsonDefaultData</td>
<td>JSON content from the <strong>Default Data Template</strong> field in String format.</td>
</tr>
<tr>
<td>jsonDynamicData</td>
<td>JSON content from the <strong>Dynamic Data Template</strong> field in String format.</td>
</tr>
</tbody>
</table>

8. Add the template to a Connection & Credential alias.
   a. Navigate to **IntegrationHub > Connections & Credentials > Connection & Credential Aliases**.
   b. Open the alias record for the spoke.
   c. In the **Configuration Template** field, click the Lookup icon.
   d. Select the template you created from the list.
   e. Click **Update**.

**Results**
When the user navigates to the associated Connection & Credential alias and selects **Create New Connection & Credential**, a dialog appears to collect their input. If you created a template for the OAuth Authorization Code grant type, you can also retrieve an OAuth token from this dialog.

**What to do next**
Test the template by navigating to the associated Connection & Credential alias and selecting **Create New Connection & Credential**. Verify that the dialog collects the expected data and creates the required records in the system.

**Getting started with connections**
Use the connections table to set up a Basic, JMS, JDBC, or HTTP(s) connection to a target host.

**Connection Table**
The Connection table (sys_connection) is the base table for all connection tables. You can set up connections for the following protocols:
• Basic connection for PowerShell and SSH
• JDBC
• JMS
• HTTP(s)

The connection table references the connection alias table, which couples the connection alias to connection information. Every connection records the following information:

**Base connection properties**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the connection. This field must be unique on the table.</td>
</tr>
<tr>
<td>Credential</td>
<td>Specify the credential to use with this connection. This is optional.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>The connection alias resolves your connection and credentials at run time. Only one connection is active per Connection alias at any one time.</td>
</tr>
<tr>
<td>Active</td>
<td>Check to make the current connection active.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain to which the connection belongs.</td>
</tr>
</tbody>
</table>

Credential is unique across active connections, if not empty.

**Upgrading connection information**

• The JDBC connection [jdbc_connection] and JMS connection [orch_jms_ds] tables are existing Orchestration connection tables that now extend from the Connection [sys_connection] table. The tables originally extended from sys_metadata. The sys_metadata related data is removed.

• The tables move from the Orchestration run time plugin [com.snc.runbook_automation.runtime] to the Credentials & Connections plugin.

• The upgrade process obtains JDBC and JMS connection information and creates corresponding connection aliases and assigns the alias to its corresponding connection.

• JDBC field name changes:
- JDBC server is renamed to host
- Database port is renamed to port
- Data of the JDBC server and database migrates to host and port during the upgrade

Create a basic connection for PowerShell and SSH

Configure connection information to use with a custom activity or action that uses the PowerShell or Secure Shell (SSH) protocol.

Before you begin
Role required: admin or connection_admin

Procedure
1. Navigate to Credentials & Connections > Connections.
2. Click New.
3. Select Basic Connection for PowerShell & SSH.
4. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the connection record.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the credential record used to authorize the connection.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Select the alias record to associate with this connection. Using an alias enables you to update the connection record without having to reconfigure any actions or activities that use the alias.</td>
</tr>
<tr>
<td>Host</td>
<td>Fully qualified domain name of the target host where the system runs the activity or action. For example, host.domain.com.</td>
</tr>
<tr>
<td>Active</td>
<td>Select to make this connection active.</td>
</tr>
<tr>
<td>Domain</td>
<td>Determines the domain the activity runs in. Flow Designer does not support domain separation and ignores this field.</td>
</tr>
<tr>
<td>Override default port</td>
<td>Target port used by the connection. If you leave this field blank, the system uses the default port value.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Use MID Server   | Select to connect to the target host through a MID Server. If selected, define fields in the Advanced MID Server Configuration section.  
Note: PowerShell requires a MID Server.                                                                                           |
| MID Selection    | Option to select MID Server as required.  
Note: Ensure that the IntegrationHub connection record is referred, not an Orchestration connection record.                                                                                     |
| Capabilities     | The capabilities the MID Server must support to be eligible for selection. The system runs the action or activity from a MID Server that supports the selected capabilities. Only displays if Use MID server is selected. Required capabilities determine which MID Server is selected at runtime. To learn more about how a MID Server is selected during runtime, see MID Server selection. This field is visible only when Auto-Select MID Server is selected from the MID Selection list. |
| MID Application  | The application the MID Server must support to be eligible for selection. The system runs the action from a MID Server that supports the selected application. Only displays if Use MID server is selected.  
To learn more about how a MID Server is selected during runtime, see MID Server selection.                                                                                             |
| MID Server       | Specific MID Server on which the step runs. This field is visible only when Specific MID Server is selected from the MID Selection list.                                                                              |

5. Click **Submit**.

Create an HTTP(s) connection

The HTTP(s) connection provides the information custom HTTP(s) actions or activities use to connect.

**Before you begin**

Role required: connection_admin
Procedure

1. Navigate to **Credentials & Connections > Connections**, click **New**, and select **HTTP(s) Connection**.
2. Add the following connection information and click **Submit**:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of this HTTP(s) connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the credential record used to authorize the connection.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Select the alias record to associate with this connection. Using an alias enables you to update the connection record without having to reconfigure any actions or activities that use the alias.</td>
</tr>
</tbody>
</table>
| URL builder         | Either manually enter the connection URL or use system to build the URL based on the inputs. Default is unchecked. If checked, the connection URL is calculated from the following fields:  
  - Mutual authentication — Check box if mutual authentication is used.  
  - Protocol — If mutual authentication is not used, enter protocol. The default is HTTPs.  
  - Protocol profile — If mutual authentication is used, enter protocol profile from sys_protocol_profile.  
  - Host  
  - Port  
  - Base path — Path of the connection string.  
  
  **Note**: If mutual authentication is checked, connection URL is built: **Protocol + :// + host:port +URL**. If mutual authentication is unchecked, connection URL is built: **Protocol profile + :// + host:port +URL** |
<p>| Connection URL      | If URL builder is unchecked, enter the connection URL into this field.     |
| Active              | Check the box to make this connection active.                               |
| Domain              | Determine the domain the action or activity runs in.                        |
| Use MID Server      | Check to use a MID Server for this action or activity. If selected, define fields in the Advanced MID Server Configuration section. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Selection</td>
<td>Option to select MID Server as required.</td>
</tr>
<tr>
<td><strong>Note:</strong> Ensure that the IntegrationHub connection record is referred, not an Orchestration connection record.</td>
<td></td>
</tr>
<tr>
<td>Capabilities</td>
<td>The capabilities the MID Server must support to be eligible for selection. The system runs the action or activity from a MID Server that supports the selected capabilities. Only displays if Use MID server is selected.</td>
</tr>
<tr>
<td></td>
<td>Required capabilities determine which MID Server is selected at runtime. To learn more about how a MID Server is selected during runtime, see MID Server selection. This field is visible only when Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>MID Application</td>
<td>The application the MID Server must support to be eligible for selection. The system runs the action from a MID Server that supports the selected application. Only displays if Use MID server is selected.</td>
</tr>
<tr>
<td></td>
<td>To learn more about how a MID Server is selected during runtime, see MID Server selection.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Specific MID Server on which the step runs. This field is visible only when Specific MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Connection Timeout</td>
<td>Number of milliseconds the system waits for a successful host connection. If a successful connection does not occur during this time, the connection request times out. Leave this field empty to use the system default connection timeout value.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
   You are ready to create a custom HTTP(s) action or activity.

**Create a JDBC connection**

The JDBC Connection provides the information custom JDBC actions or activities use to connect to various target databases.

**Before you begin**

You must have an appropriate JAR file, whether it is supplied with the instance or a custom JAR file.
Note: The ServiceNow instance supplies mysql-connector-java-5.1.21.jar, sql-server-jdbc-4.0.jar, and ojdbc6.jar files as part of the current release, which supports MySQL, SQLServer, and Oracle databases. Other databases, such as Sybase or DB2 Universal, must use a custom JAR file that must be uploaded to the instance before setting the JDBC connection.

Role required: connection_admin

About this task
JDBC credentials are retrieved separately by the activity designer template and support external credential storage, such as CyberArk.

Procedure
1. Navigate to Credentials & Connections > Connections, click New and select JDBC Connection.
2. Complete the form using the fields in the table.
   The database selection in the Format field determines which fields are available.

<table>
<thead>
<tr>
<th>Field</th>
<th>Database Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>All</td>
<td>Unique name of this JDBC connection. For example, you might enter JDBC MySQLProd.</td>
</tr>
<tr>
<td>Credential</td>
<td>All</td>
<td>Add credentials for JDBC provider.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>All</td>
<td>Select the alias record to associate with this connection. Using an alias enables you to update the connection record without having to reconfigure any actions or activities that use the alias.</td>
</tr>
<tr>
<td>Query timeout</td>
<td>All</td>
<td>Maximum elapsed time the JDBC query is allowed to run without a response.</td>
</tr>
<tr>
<td>Connection timeout</td>
<td>All</td>
<td>Number of seconds the system waits for a successful JDBC connection. If a successful connection does not occur during this time, the connection request times out. Leave this field empty to use the system default connection timeout value.</td>
</tr>
<tr>
<td>Active</td>
<td>All</td>
<td>Check the box to make this an active connection.</td>
</tr>
<tr>
<td>Field</td>
<td>Database Format</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Domain</td>
<td>All</td>
<td>Domain for this table. By default, the JDBC Connection [jdbc_connection] table runs in the <strong>global</strong> domain.</td>
</tr>
<tr>
<td>Format</td>
<td>All</td>
<td>Database type for this connection. The default choices are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MySQL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Oracle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SQLServer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• None</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can add <strong>Sybase</strong> or <strong>DB2 Universal</strong> to the choice list by uploading the appropriate JDBC driver JAR file to the instance. Orchestration automatically recognizes these drivers when they are loaded into the system and adds them to this list.</td>
</tr>
<tr>
<td>Host</td>
<td>Oracle, MySQL, SQLServer</td>
<td>Host name or IP address of the database server.</td>
</tr>
<tr>
<td>Oracle sid</td>
<td>Oracle</td>
<td>The Oracle database site identifier. The default value is <strong>orcl</strong>.</td>
</tr>
<tr>
<td>Oracle port</td>
<td>Oracle</td>
<td>Port that the Oracle database is using. The default value is <strong>1521</strong>.</td>
</tr>
<tr>
<td>Database name</td>
<td>MySQL, SQLServer</td>
<td>Name of the database.</td>
</tr>
<tr>
<td>Port</td>
<td>My SQL, SQLServer</td>
<td>Port that the selected database is using.</td>
</tr>
<tr>
<td>Instance name</td>
<td>SQLServer</td>
<td>Instance name for the selected SQLServer</td>
</tr>
<tr>
<td>Connection URL</td>
<td>All</td>
<td>URL that the MID Server uses to connect to the specified database. The URL is created automatically when you save the form, and is read-only for the default databases.</td>
</tr>
<tr>
<td>Field</td>
<td>Database Format</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> If the format selected is not one of the default databases, you must create the connection URL manually so that the MID Server knows how to create the connection.</td>
</tr>
<tr>
<td>JDBC driver</td>
<td>None, DB2 Universal, Sybase</td>
<td>The JDBC driver to use for this connection when it is not a default database. <strong>Note:</strong> If you add a Sybase or DB2 Universal database, you must enter the driver name in this field and upload the driver JAR file to the instance.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>All</td>
<td>Check to use a MID server for this action or activity. If selected, define fields in the Advanced MID Server Configuration section.</td>
</tr>
<tr>
<td>MID Selection</td>
<td>All</td>
<td>Option to select MID Server as required. <strong>Note:</strong> Ensure that the IntegrationHub connection record is referred, not an Orchestration connection record.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>All</td>
<td>The capabilities the MID Server must support to be eligible for selection. The system runs the action or activity from a MID Server that supports the selected capabilities. Only displays if Use MID server is selected. Required capabilities determine which MID Server is selected at runtime. To learn more about how a MID Server is selected during runtime, see MID Server selection. This field is visible only when Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>MID Application</td>
<td>All</td>
<td>The application the MID Server must support to be eligible for selection. The system runs the action from a MID Server that supports the selected application. Only displays if Use MID server is selected.</td>
</tr>
</tbody>
</table>
### Field | Database Format | Description
--- | --- | ---
 |  | To learn more about how a MID Server is selected during runtime, see [MID Server selection](#). |
MID Server | All | Specific MID Server on which the step runs. This field is visible only when **Specific MID Server** is selected from the MID Selection list. |

3. Click **Submit**.

#### Related reference

**JDBC credentials**

### Create a JMS connection

Configure your system to use Java Messaging Service (JMS) with a custom JMS activity or action.

#### Before you begin

**Role required:** connection_admin

#### About this task

The MID Server must have the correct JMS connection factories for your organization. Configure those values in the `mid.property.jms.command.allowed_factory_names` property, found in **MID Server > Properties**. The default values for this property can be changed to any value or comma-separated list of values that the third-party JMS provider advertises.

#### Procedure

1. Navigate to **Credentials & Connections > Connections**.
2. Click **New**, select **JMS Connection**, fill in the form, and then click **Submit**:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of this connection factory.</td>
</tr>
<tr>
<td>Credential</td>
<td>Add credentials for JMS provider.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Select the alias record to associate with this connection. Using an alias enables you to update the connection record without having to recon-</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Initial Context Factory</strong></td>
<td>Name of the JNDI class that is used to create the InitialContext.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>For example, to connect to ActiveMQ V5.10 (JMS Provider), the value is org.apache.activemq.jndi.ActiveMQInitialContextFactory.</td>
</tr>
<tr>
<td><strong>Provider URL</strong></td>
<td>Location of the running JMS provider installation.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>For example, to connect to ActiveMQ V5.1: tcp://ipAddressOrHostName:61616.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Check the box to make this an active connection.</td>
</tr>
<tr>
<td><strong>Domain</strong></td>
<td>Determine the domain the action or activity runs in.</td>
</tr>
<tr>
<td><strong>Use MID server</strong></td>
<td>Check to use a MID Server for this action or activity. If selected, define fields in the Advanced MID Server Configuration section.</td>
</tr>
<tr>
<td><strong>Capabilities</strong></td>
<td>The capabilities the MID Server must support to be eligible for selection. The system runs the action or activity from a MID Server that supports the selected capabilities. Only displays if <strong>Use MID server</strong> is selected.</td>
</tr>
<tr>
<td><strong>MID Application</strong></td>
<td>The application the MID Server must support to be eligible for selection. The system runs the action from a MID Server that supports the selected</td>
</tr>
</tbody>
</table>
### Create connection attributes for IntegrationHub

Define connection-specific variables that you can use in IntegrationHub integration steps.

**Before you begin**

- The admin role is required to create connection attributes.
- The connection_admin or admin role is required to assign attribute values.
- The action_designer or admin role is required to use attributes in a custom action.

Connection attributes are only used by integration steps, which require a subscription to IntegrationHub. For more information about activating IntegrationHub, see Request an IntegrationHub plugin.

**About this task**

When using an integration step, you must establish a connection with an external system. Use a Connection & Credential alias instead of defining the connection inline. An alias enables you to update the connection details once without having to reconfigure every action. Any action step that uses an alias inherits the attributes associated with it. Flow Designer displays attributes as data pills that you can drag into your action step. For example, you can create a page size attribute that becomes a REST step query parameter.

For more information about building custom Flow Designer actions, see Action Designer.

---

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>application. Only displays if <strong>Use MID server</strong> is selected.</td>
</tr>
<tr>
<td></td>
<td>To learn more about how a MID Server is selected during runtime, see <strong>MID Server selection</strong>.</td>
</tr>
</tbody>
</table>

3. Navigate to **Connections & Credentials > Credentials**.

4. Click **New**, select **JMS Credentials**, and then provide the user name and password the MID should use to communicate with the JMS provider. For more information, see **JMS credentials**.

5. Click **Submit**. You are ready to create a custom JMS action or activity.
Procedure

1. Navigate to **Credentials & Connections > Connection & CredentialAliases**.
2. Create or select an alias record.
3. From the Connection Attributes related list, click **New**. The Connection Attributes form opens.
4. Define the attribute label and field type. For a list of field types, see **field types**.
5. Click the Advanced view related link to set advanced dictionary preferences for the attribute.
   For example, to create an attribute with a dynamically calculated value. See **Dictionary entry form**.
6. Click **Submit**.
7. Define the attribute values in the connection record.
   a. Navigate to **Credentials & Connections > Connections**.
   b. Create or select a connection record with the same connection type as the alias.
   c. From **Connection alias**, select the alias with connection attributes.
   d. Save the record.
      The Attributes tab populates with the connection attributes defined in the alias record.
   e. Set values for the attributes.
      If the alias has **Support Multiple Active Connections** enabled, you can associate more than one connection record with an alias and define attribute values in each connection record. If there are multiple connection records with attribute values for the same alias, the connection used when the flow executes determines the attribute values. For example, suppose that you have one action that uses an alias with two active connections endpoints: production and test. The attribute resolves to the value defined by the connection used at runtime.
8. Add the alias to an integration step in Action Designer.
   a. Navigate to Flow Designer and create or select an action.
   b. Add an integration step to the action.
   c. Under Connection Details, add the alias you created attributes for.
The connection attributes associated with the alias display as data pills in the Data pane.

**Note:** The system does not track changes to connection attribute labels and data types after you associate the alias to a step. To refresh the connection attribute label or data type, delete the alias from the step and add it again.

## Getting started with credentials

The MID Server uses the credentials you create in the Credentials [discovery_credentials] table to access resources for Discovery, Orchestration, Service Mapping, and Cloud Management.

### How MID Servers use credentials

By default, Windows MID Servers use the login credentials of the MID Server service on the host machine to discover Windows devices in the network. You should configure these service credentials so that they have at least local administrator privileges. For Linux and UNIX machines and network devices, the MID Server uses the SSH and SNMP credentials configured in the instance in **Discovery > Credentials**.

MID Servers that Orchestration uses must have access to the necessary credentials to execute commands on computers in the network, as specified by the **Workflow activities**. Orchestration can use the same SSH and SNMP credentials as Discovery, but has two additional credentials designed for specific Workflow activities: Windows (for PowerShell) and VMware.

### Encryption and decryption

The platform stores credentials in an encrypted field on the Credentials [discovery_credentials] table. Once they are entered, they cannot be viewed.

When the MID Server requests credentials, the Now Platform decrypts the credentials using the following process:

1. The credentials are decrypted on the instance with the password2 fixed key.
2. The credentials are re-encrypted on the instance with the MID Server's public key.
3. The credentials are encrypted on the load balancer with SSL.
4. The credentials are decrypted on the MID Server with SSL.
5. The credentials are decrypted on the MID Server with the MID Server's private key.
Note: The platform does not have separate encryption keys for multi-tenant instances.

**Credential order**

Credentials can be assigned an order value in the Credentials Form, which forces the application to try all the credentials at their disposal in a certain sequence. If you do not specify an order value, the application tries the credentials in the Credentials [discovery_credential] table randomly, until it finds one that works. For example, when:

- Orchestration attempts to run a command on an SSH server, such as a Linux or a UNIX machine.
- Discovery attempts to query an SNMP device, such as a printer, router, or UPS.

After identifying the credentials for a device, Discovery and Orchestration create an affinity between the credentials and the device using the Credential Affinity [dscy_credentials_affinity] table. All subsequent discoveries or Orchestration activities attempt to match the credentials in this table with a device for which an affinity exists. If credentials for a device change, Discovery and Orchestration try all available credentials again until they create a new affinity.

Note: If Orchestration and Discovery are installed, and credential alias is enabled, multiple affinities can exist. In this case, the platform looks up credentials for each affinity and inserts the credential for the affinity with the lowest order into the probe.

Ordering credentials is useful in the following situations:

- The credentials table contains many credentials, with some used more frequently than others. For example, the table contains 150 SSH credentials, and five of those credentials are used to log in to 90% of the devices. It is good practice to configure those five credentials with low-order numbers, which place them at the top of the execution list. Discovery and Orchestration work faster when they try these common credentials first. After the first successful connection, the Now Platform knows which credentials to use the next time for each device.

- The Now Platform has aggressive login security. For example, configure database credentials with a low-order value if Solaris database servers in the network only provide three failed login attempts before locking out the MID Server.

**Credential aliases**

Credential aliases are available for Discovery and Orchestration.
Aliases for Discovery enable an administrator to:

- Employ a credential filtering behavior with configurable levels of compliance.
- Assign multiple credential aliases to a Discovery schedule.
- Prevent the creation of credential affinities that use inappropriate or sensitive credentials. To learn more, see credential affinities.

Aliases for Orchestration enable workflow creators to:

- Assign individual credentials to any activity in an Orchestration workflow
- Assign individual credentials to any action in Flow Designer
- Assign different credentials to each occurrence of the same activity type in an Orchestration workflow.
- Assign different credentials to each occurrence of the same action in designer flow.

**External credential stores**

If you do not want credentials stored in your instance, you can use external credential repositories. External credential stores save the credentials in an external site that your instance can access. CyberArk is the only supported external credential store. However, other external stores can be configured using the ServiceNow API.

**Create a Connection & Credential alias**

Define an alias to label a credential or connection record.

**Before you begin**

- The admin role is required to create an alias.
- The credential_admin and connection_admin roles have read access to the alias record.

**About this task**

The Connection & Credential alias defines an alias that labels a credential or connection record. The alias contains these fields.

**Procedure**

1. Navigate to Credentials & Connections > Connection & Credential Aliases.
2. Click New.
3. Complete the fields on the form.
## Connection & credential aliases

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the alias. An alias can only contain alpha, number, and underscore characters. During an upgrade, the tag in the credential record migrates to a Connection &amp; Credential Alias. If the credential tag contains special characters other than alphabets, numbers, and underscores, it preserves the tag name after the upgrade. You can still use this migrated alias, but you cannot update the alias until you change the name to meet the naming restrictions.</td>
</tr>
<tr>
<td>ID</td>
<td>Unique identifier for the Connections &amp; Credentials alias, based on the format <code>scope_name.alias_name</code>.</td>
</tr>
<tr>
<td></td>
<td>• If the scope is Global, the ID is the alias name. For example, if you create a Workday alias in the global scope, it sets the ID to <code>workday</code>.</td>
</tr>
<tr>
<td></td>
<td>• If you create a workday alias in the HR app scope, it sets the ID to <code>x_hr_app.workday</code>.</td>
</tr>
<tr>
<td>Type</td>
<td>Select either <strong>Credential</strong> or <strong>Connection and Credential</strong>. The default is Connection and Credential.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope against which the Connection &amp; Credentials alias is assigned. The current session scope you last selected in the application picker appears.</td>
</tr>
<tr>
<td></td>
<td>• For example, <strong>Global</strong> appears if it is the current scope for this session.</td>
</tr>
<tr>
<td></td>
<td>• You can change the scope in the application picker before creating an alias. To learn more application scopes and how to select them, see:</td>
</tr>
<tr>
<td></td>
<td>◦ Application scope</td>
</tr>
<tr>
<td></td>
<td>◦ Select an application from the application picker</td>
</tr>
<tr>
<td>Connection type</td>
<td>Name of the connection type, either Basic, HTTP, JDBC, JMS. The default is HTTP.</td>
</tr>
<tr>
<td>Support Multiple Active Connections</td>
<td>Designator that indicates whether the alias supports multiple active connections. Add connections using the Connections table and associated them to the alias using the Connections related list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default Retry Policy</td>
<td>Retry policy for the alias. For more information, see <a href="#">Retry policy</a>.</td>
</tr>
<tr>
<td>Configuration Template</td>
<td>Configuration template to use to create a connection and credential record.</td>
</tr>
</tbody>
</table>

4. Click **Save**.
The Connections and Connection Attributes related list appears.

<table>
<thead>
<tr>
<th>Related List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>Related connection records associated with this alias. After creating the alias, you can define connection records and associate them with the alias. If <strong>Support Multiple Active Connections</strong> is selected, you can associate more than one connection with an alias.</td>
</tr>
<tr>
<td>Connection Attributes</td>
<td>Attributes for the connection. Define data specific to a connection and use it in an IntegrationHub integration step. For more information, see <a href="#">Create connection attributes for IntegrationHub</a>.</td>
</tr>
<tr>
<td>Child Aliases</td>
<td>Child aliases associated with the parent alias. After creating a connection and credential alias, you can create child alias to configure multiple connections for the same application integration.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>Related connection records associated with this alias. After creating the alias, you can define connection records and associate them with the alias. If <strong>Support Multiple Active Connections</strong> is selected, you can associate more than one connection with an alias.</td>
</tr>
<tr>
<td>Connection Attributes</td>
<td>Attributes for the connection. Define data specific to a connection and use it in an IntegrationHub integration step. For more information, see <a href="#">Create connection attributes for IntegrationHub</a>.</td>
</tr>
</tbody>
</table>

5. **Optional:** If you want to create a new credential and connection associated with your credential alias, under **Related Links**, click **Create New Connection & Credential**.
The resulting connection and credential records are based on a pre-defined configuration template. See connection and credential configuration templates.

6. Optional: If you want to create a child alias for your connection and credential alias, under the Child Aliases related list, select New.

   a. Enter a name for the child alias and select Submit. The child alias inherits properties from the parent alias. You can then configure a child alias to contain its own set of connection and credential information.

What to do next
Create one or more connection records to associate with the alias or child aliases. For more information about creating connections, see Getting started with connections. Add connection attributes to the alias to make connection meta data available to flows in Flow Designer.

Credential aliases for Discovery
Credential aliases for Discovery allow an administrator to use specific credentials on Discovery schedules. You can configure behaviors for your aliases that determine how strictly the system enforces their use.

Without credential aliases, Discovery schedules can access all credentials that are defined in the instance. This behavior might not be desirable in some circumstances, particularly for credentials with elevated privileges. Credential aliases provide more control over which credentials a Discovery schedule is allowed to use and prevents the unnecessary exposure of credentials with elevated privileges.

How credential aliases work
A business rule called Insert Discovery Affinity & Cred Aliases (previously named Insert Discovery Affinity) runs when a record is inserted into the ECC Queue. The business rule attaches the credential aliases defined in the Discovery schedule to the probe, so that the MID Server can perform credential filtering.

The MID Server's first task is to create the list of credentials to search. It filters the credentials by affinity and then by tags, if any exist. The affinities go to the top of the list, and the matching tags go to the bottom of the list. The MID Server iterates through the list until it finds a credential that works. The MID Server then creates an affinity for this credential.

If the business rule determines that an affinity exists for the device, the rule identifies the proper credential_id to use. This is the sys_id of the record in the Credentials [discovery_credentials] table. When the platform encounters an
affinity with a credential alias value, defined as `credential_alias` in the business rule, the business rule determines whether or not the credential referenced by the affinity has the specified alias. If it does, the business rule selects the `credential_id` of the alias and passes that value to the MID Server. If the credential does not have the specified credential alias, any other affinities that exist for the target system are checked.

Create a Discovery credential alias

Create the alias and then add that alias to a credential in the credential record. You can add a credential to multiple aliases and add multiple credentials to a single alias.

Before you begin

Role required: admin, credential_admin (read access only), connection_admin (read access only)

About this task

A Discovery schedule only uses credentials that are contained in the aliases defined for that schedule.

Note: If a credential alias is defined for a schedule, it will ignore any previously existing credential affinity between the credential and the target that is discovered in a schedule that is setup to use that credential alias.

Procedure

1. Create an alias.


   b. Click New.

   c. Enter a unique name for the alias and select Credential for the alias Type.

   d. Click Submit.
The **Credentials** related list appears. You can add new credentials for this alias in this list but not existing credentials.

2. Configure a credential for the new alias.

   **a.** Navigate to **Connections & Credentials > Credentials**.

   **b.** Select an existing credential from the list or click **New** to create a new credential.

   **c.** In the credential record, unlock the **Credential alias** field and select the alias you created.
d. Save or submit the record.

3. Return to **Connections & Credentials > Connection & Credential Aliases** and open your new alias. The credential you attached to the alias now appears in the related list.

4. To create an additional credential for this alias, click **New** in the related list and select a credential type.
The alias name is pre-populated in the **Credential alias** field of the credential record.

5. Complete the fields in the form and submit the record.

**Credential aliases for Orchestration activities**

Credential alias gives an administrator more control over the credentials used in Orchestration activities.

This is useful when an activity requires specific credentials to perform a task. You can use a credential tag to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow.

Credential alias interacts with **credential affinity** to determine which credentials should be used for an Orchestration activity.

**How credential alias works**

A **business rule** called *Insert Discovery Affinity* (renamed from *Insert Credential Affinity* in the Geneva release) runs when a record is inserted into the ECC Queue. This rule determines whether a credential affinity exists for the device and identifies the proper `credential_id` (the `sys_id` of the record in the **Credentials [discovery_credentials]** table) to use. When the platform encounters an affinity with a credential alias value defined (`credential_alias` in the business rule), the business rule determines if the credential referenced by the affinity has the specified alias. If it does, the business rule selects the `credential_id` of the credential alias and passes that value to the MID Server. If the credential does not have the specified credential alias, any other affinities that exist for the target system will be checked. If no affinity references an appropriately tagged credential, the MID Server iterates through the **Credentials [discovery_credentials]** table and selects the credential with the appropriate tag. The MID Server then creates a new affinity for this credential.

**Create and test your credentials**

Create and test the credentials that Discovery, Service Mapping, Cloud Management, and Orchestration require to access hardware and software in your network.

**Before you begin**

Role required: admin

Review your security policy and options with your organization's security team.
About this task
This task contains general procedures for creating credentials. Refer to the documentation for your credential type for details on specific fields and requirements.

<table>
<thead>
<tr>
<th>Supported credential types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applicative credentials</td>
</tr>
<tr>
<td>CIM credentials</td>
</tr>
<tr>
<td>JDBC credentials</td>
</tr>
<tr>
<td>SAP credentials</td>
</tr>
<tr>
<td>VMware credentials</td>
</tr>
</tbody>
</table>

Note: To improve security, limit the scope of credentials to a specific MID Server or schedule to avoid unnecessary credentials.

Procedure
1. Navigate to one of these modules:
   - Discovery > Credentials
   - Service Mapping > Credentials
   - Orchestration > Credentials
2. Click New.
3. On the Credentials page, click a link for the credential type and complete the form. Refer to the documentation for the credential type you selected for details.
   You can submit a credential record first and then test it later, or test the credential immediately before saving it.
   Credential testing is supported for these credential types:
   - SSH private keys
   - Windows
   - SNMP v3
   - VMware
   - JDBC
   - JMS
4. Under Related Links, click Test credential.
Note: Credentials are encrypted at all times during the test.

5. Complete the fields in the Test Credential dialog box.

![Test credentials dialog box](image)

### Credential test fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Credential type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>Target host on which these credentials are run. This value must be an IP address for all credential types except VMware, which can be the host URL. You can not target any MID servers.</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For JMS, this is the provider URL. The information in this URL tells JNDI how to find and access the JMS Provider. An example value for connecting to ActiveMQ V5.1, is tcp://ipAddressOrHost:61616.</td>
<td></td>
</tr>
<tr>
<td>Port</td>
<td>Port on the target to use for this test. The system pre-populates this field</td>
<td>All</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Credential type</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td></td>
<td>with the default port for the selected credential type.</td>
<td></td>
</tr>
<tr>
<td>MID Server</td>
<td>MID Server to use for this test. You must use a Windows MID Server to test Windows credentials. Only <strong>Up</strong> and <strong>Validated</strong> MID Servers are available.</td>
<td>All</td>
</tr>
<tr>
<td>DB Type</td>
<td>Type of database on which to test these credentials.</td>
<td>JDBC</td>
</tr>
<tr>
<td>DB Name</td>
<td>Name of the database on which to test these credentials.</td>
<td>JDBC</td>
</tr>
<tr>
<td>Initial Context Factory</td>
<td>Name of the JNDI class that is used to create the InitialContext. Using this <strong>Initial Context Factory</strong>, various JMS objects, such as JMS Connection, are created. For example, to connect to ActiveMQ V5.10, (JMS Provider), the value in this field would be <code>org.apache.activemq.jndi.ActiveMQInitialContextFactory</code></td>
<td>JMS</td>
</tr>
</tbody>
</table>

6. Click **OK** to begin the test.

An indicator appears, showing that the system is attempting to contact the target using the credentials you have provided. When the instance connects to the target it displays a success message. If the instance encounters a problem with the test inputs you have provided, it displays the appropriate error message. The following are some common error messages.
• Incorrect target or port number:

TCP connection failure

Test Credential

Failed to connect TCP: Connection refused:

Cancel Retry

• Incorrect user name or password:

Authentication failure

Test Credential

Failed to authenticate with user: root

Cancel Retry

• Incorrect MID Server for Windows credentials:

MID Server error

Test Credential

Selected MID Server must have Powershell v2.0 or higher

Cancel Retry

7. Click Retry to open the test Credential dialog box and correct the input error.

8. When your credentials test is successful, click Submit to save the record.

Important: Testing credentials does not ensure that the credentials have the necessary privileges required for the intended Discovery or Orchestration workflow tasks.

Ansible Tower credentials

Ansible Tower credentials are required to access your Ansible configuration management account. Use these credentials to manage Ansible resources through the Cloud Management application.

To integrate Cloud Provisioning and Governance with the Ansible configuration management account, you must configure the user name and password for the administrator account in Ansible.
Form fields for Ansible Tower credentials

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Provide a descriptive name.</td>
</tr>
<tr>
<td>User name/Password</td>
<td>Enter the authentication credentials for the Ansible Tower user with administrator rights.</td>
</tr>
</tbody>
</table>

ℹ️ **Note:** You do not need to configure the other fields.

### API key credentials

An API key is a unique code that is passed in to an API to identify the calling application or user.

### API key credentials form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>API Key</td>
<td>Enter the API key.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Allow flow and workflow creators to assign individual credentials to any activity in a flow or workflow or assign different credentials to each occurrence of the same activity type in a flow or workflow.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select whether to apply these credentials to <strong>All MID servers</strong> in your network, or to one or more <strong>Specific MID servers</strong>. Specify the MID Servers that should use these credentials in the <strong>MID servers</strong> field.</td>
</tr>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
</tbody>
</table>
Applicative credentials

Some applications require credentials in addition to the credentials that the host machine requires. Credentials required to access these applications are referred to as applicative credentials.

A typical credential contains a user name and a password for logging into a device or application. While most applications require only one credential for accessing them, sometimes hosts and applications have separate credentials for extra security. For example, ABAP SAP Central Services (ASCS) requires applicative credentials in addition to the SSH or Windows host credentials for the server that hosts ASCS.

Note: ServiceNow applications refer to devices and applications that comprise an application service as configuration items (CIs).

Just like with host credentials, you assign applicative credentials to MID Servers.

You create applicative credentials per CI type, for example the CI type for ASCS is SAP ASCS Application [cmdb_ci_appl.sap.ascs]. The preconfigured pattern for discovering CIs belonging to this CI type contains commands that require a MID Server to use the applicative credential for this CI type. If there is more than one credential configured for this CI type, the MID Server tries using these credentials in the order you define until it finds the credential that fits.

Check the Discovery requirements information in the ServiceNow documentation to determine if you need to configure applicative credentials for specific application CIs. There is no need to configure applicative credentials, if Discovery prerequisites do not mention it.

Applicative credentials form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the credential. Use a descriptive name like Oracle DB or London Oracle for an Oracle database. Do not use spaces or special characters for the credential name.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to use the credential.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the actual user name of the applicative credential.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the actual password of the applicative credential. Do not use spaces or special characters for the credential name.</td>
</tr>
<tr>
<td>CI type</td>
<td>Select a CI type to which the CI belongs.</td>
</tr>
<tr>
<td>Credential Alias</td>
<td>Create an alias to assign specific credentials for specific discovery schedules. When assigning an alias, you must identify the table name for the CI type whose applicative credentials you are assigning.</td>
</tr>
</tbody>
</table>
### Applicative credentials form fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>credentials</td>
<td>credentials the application uses. Applications may use applicative credentials of a type different from their own. For a specific application, see the list for the applicable table:</td>
</tr>
<tr>
<td></td>
<td>- ABAP SAP Central Services (ASCS): cmdb_ci_appl_sap_ascs</td>
</tr>
<tr>
<td></td>
<td>- IBM Security Access Manager appliance: cmdb_ci_app_server_webseal</td>
</tr>
<tr>
<td></td>
<td>- SAP Central Instance: cmdb_ci_appl_sap_ascs</td>
</tr>
<tr>
<td></td>
<td>- SAP Central Services (SCS): cmdb_ci_appl_sap_ascy</td>
</tr>
<tr>
<td></td>
<td>- SAP Evaluated Receipt Settlement (ERS): cmdb_ci_appl_sap_ascy</td>
</tr>
<tr>
<td></td>
<td>- SAP Java Cluster: cmdb_ci_appl_sap_ascs</td>
</tr>
<tr>
<td></td>
<td>- SAP NetWeaver Dialog Instance: cmdb_ci_appl_sap_ascy</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Exchange Mailbox (for Microsoft Exchange): cmdb_ci_exchange_mbox</td>
</tr>
<tr>
<td></td>
<td>- Microsoft SQL Database: cmdb_ci_db_mssql_instance</td>
</tr>
<tr>
<td></td>
<td>- MySQL Server: cmdb_ci_db_mysql_instance</td>
</tr>
<tr>
<td></td>
<td>- Oracle Advanced Queue Queue: cmdb_ci_db_ora_instance</td>
</tr>
<tr>
<td></td>
<td>- Oracle Database: cmdb_ci_db_ora_instance</td>
</tr>
<tr>
<td></td>
<td>- Oracle E-Business Suite: cmdb_ci_db_ora_instance</td>
</tr>
<tr>
<td></td>
<td>- Oracle WebLogic Module: cmdb_ci_app_server_weblogic</td>
</tr>
<tr>
<td></td>
<td>- Tibco Enterprise Message Service (EMS): cmdb_ci_appl_tibco_message</td>
</tr>
</tbody>
</table>

### Applies to

Select whether to apply these credentials to **All MID servers** in your network, or to one or more **Specific MID servers**. Specify the MID Servers that should use these credentials in the **MID servers** field.

### Order

Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order (or none), the instance tries the credentials in a random order.

---

**Basic authentication credentials**

The basic authentication credential type manages access to store basic authentication credentials.

These fields are available in the Credentials form for basic authentication.
## Basic Auth credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential. For example, you might call it <strong>Basic Authentication</strong>.</td>
</tr>
<tr>
<td>User Name</td>
<td>Enter the user name.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
<tr>
<td>Credential ID</td>
<td>Enter the unique key configured for these credentials in the CyberArk external credential storage system. The credential ID may be used as a safe override when multiple safes are in use. By default, the syntax in the Credential ID field is this: <code>&lt;safe name&gt;:&lt;Credential ID&gt;</code>. If the safe name is omitted, there must be a safe name defined in the <code>config.xml</code> file. To change the separator character from the default colon to another character, override the value with the optional <code>ext.cred.safe_name</code> parameter. The Credential ID field has a limit of 40 characters. This field is only visible when the External storage check box is selected.</td>
</tr>
<tr>
<td>External credential store</td>
<td>Select this check box to use an external credential storage system. When you select this option the User name and Password fields are replaced with the Credential ID field. Currently, the only supported external storage system is CyberArk.</td>
</tr>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
</tbody>
</table>

### Chef server credentials

Chef server credentials access chef integrations with the instance.

These fields are available on the Credentials form for Chef server type credentials. This information comes from the settings you configured when you performed Chef server installation.
### CIM credentials

The CIM credential type manages access to a CIM server (also referred to as a CIMOM - Common Information Model Object Manager) for information about VMware ESX servers. This credential type is available for Discovery.

These fields are available in the Credentials form for CIM.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name to create in the Credentials table. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name. For CIM discovery, the user must have the admin role.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
<tr>
<td>Credential ID</td>
<td>Enter the unique key configured for external credentials in the JAR file uploaded to the MID Server for an external credential system. The Credential ID field has a limit of 40 characters.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>This field is only visible when the External credential store check box is selected.</td>
<td></td>
</tr>
</tbody>
</table>
| Credential alias          | Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow.  
To use the credential for discovering CIs not belonging to this CI type using Service Mapping and Discovery patterns, enter the table name for the CI type to which the CI belongs, for example cmdb_ci_apache_web_server. For more information, see Change credentials to non-default. |
| External credential store | Select this check box to use an external credential storage system. When you select this option the User name and Password fields are replaced with the Credential ID field. External credential storage is only available when the External Credential Storage plugin in activated.  
Note: Currently, the only supported external storage system is CyberArk.                                                                                                                                           |
| Applies to                | Select whether to apply these credentials to All MID servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use these credentials in the MID servers field.                                        |
| MID servers               | Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select Specific MID servers from the Applies to field.                                      |
| Order                     | Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order. |
| Windows MID Server Service Account | When active, the defined credential represents the MID Server service account.                                                                                                                                                  |
Configure NetApp storage devices for CIM credentials

NetApp storage devices require additional configuration in order for Discovery to explore them.

Before you begin
Role required: admin

Procedure
1. Install the SMI-S agent on the storage device host. See the Data ONTAP SMI-S Agent 5.2 Installation and Configuration Guide for instructions and requirements.

![Note:](image)

ServiceNow does not maintain the documentation on this site. Be aware that this document can change without notice.

2. Create a user account and password for the SMI-S agent.

3. Create a credential record for the SMI-S agent credentials. Set the credential type to CIM.

Cloud credentials

Cloud credential types manage access to cloud-based applications, including Amazon Web Services and the Microsoft Azure cloud.

AWS Identity and Access Management (IAM) roles

If you have a MID Server installed on Amazon EC2 in an AWS cloud, and if that MID Server is configured to discover resources within the cloud, you can use security credentials provided by AWS Identity and Access Management (IAM) roles rather than credentials managed on your instance. These AWS credentials grant permissions in the cloud through an instance profile, based on roles. These credentials are temporary and rotate automatically on a configurable interval. When an IAM role is defined for the MID Server, Discovery ignores any credentials stored on the instance in favor of the credentials granted by the role in the instance profile. For more information on AWS instance profiles, see IAM Roles for Amazon EC2.
AWS credentials

### AWS Credentials form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique and descriptive name for the AWS credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to use the credential.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>The <strong>Access key ID</strong> that you generated on the AWS Management Console, such as: APIAIOSFODNN7EXAMPLE.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>The <strong>Secret access key</strong> that you generated on the AWS Management Console, such as: wPalrXUtnFEMI/K7MDENG/bPxRfiCYEXAMPLEKEY.</td>
</tr>
</tbody>
</table>

### Azure Service Principal credential form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the service principal to register with the instance.</td>
</tr>
<tr>
<td>Tenant ID and</td>
<td>Paste the Azure <strong>Directory ID</strong> value from the Azure portal into the Cloud Management <strong>Tenant ID</strong> field.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Paste the Azure <strong>Application ID</strong> value of the application that you registered in Azure into the Cloud Management <strong>Client ID</strong> field.</td>
</tr>
<tr>
<td>Authentication Method</td>
<td>Select <strong>Client secret</strong>.</td>
</tr>
<tr>
<td>Note:</td>
<td><strong>Client assertion</strong> is not supported.</td>
</tr>
<tr>
<td>Secret key</td>
<td>Paste the secret key that was generated while creating the Azure Service Principal.</td>
</tr>
<tr>
<td>This field appears when <strong>Authentication method</strong> is <strong>Client secret</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

### Azure Enterprise Agreement credentials

Azure Enterprise Agreement credentials are necessary for the billing functionality that the Cloud Management application provides.
### Azure Enterprise Agreement credentials form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Enrollment number</td>
<td>Enter the enrolment number from Azure.</td>
</tr>
<tr>
<td>Access Key</td>
<td>Paste the access key that Azure provides.</td>
</tr>
</tbody>
</table>

### Cloud Management credentials

This credential type is available for Orchestration.

### Cloud Management credentials form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential. For example, you might call it <strong>Cloud Atlanta</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>Type</td>
<td>Specify <strong>AWS</strong>.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the CIM user name to create in the Credentials table. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the CIM password.</td>
</tr>
<tr>
<td>SSH Passphrase</td>
<td>Enter a memorable phrase for key generation. For example, you might enter <strong>Friday is a good day</strong>.</td>
</tr>
<tr>
<td>SSH private key</td>
<td>Enter the SSH private key.</td>
</tr>
<tr>
<td>Authentication protocol</td>
<td>Select the <strong>MD5</strong> or <strong>SHA</strong> authentication protocol that was used to generate the <strong>Authentication Key</strong>.</td>
</tr>
<tr>
<td>Authentication Key</td>
<td>Enter a SSH-generated authentication key.</td>
</tr>
<tr>
<td>Privacy protocol</td>
<td>Enter one of the following privacy protocols that describes encryption for the <strong>Privacy Key</strong>:</td>
</tr>
<tr>
<td></td>
<td>• <strong>3DES</strong> for Triple Data Encryption Standard (DES)</td>
</tr>
<tr>
<td></td>
<td>• <strong>AES128</strong> for Advanced Encryption Standard (AES) with 128 bit encryption</td>
</tr>
</tbody>
</table>
Cloud Management credentials form fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• AES192 for AES with 192 bit encryption</td>
</tr>
<tr>
<td></td>
<td>• AES256 for AES with 256 bit encryption</td>
</tr>
<tr>
<td></td>
<td>• DES for legacy DES encryption</td>
</tr>
</tbody>
</table>

Enter an additional privacy key.

Credential alias  Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow.

External credential store  Select this check box to use an external credential storage system. When you select this option the User name and Password fields are replaced with the Credential ID field. Currently, the only supported external storage system is CyberArk.

Applies to  Select whether to apply these credentials to All MID servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use these credentials in the MID servers field.

Classification  Enter the Application Classification for CI discovery.

Order  Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.

---

**Cloud Management (CMP) node credentials**

Cloud Management (CMP) node credentials associate credentials for a virtual server that Cloud Management provisions. The Cloud Management application automatically creates these credentials.

<i>Note:</i> You might need to deactivate these credentials if you no longer want them used, change the order precedence, or select a MID Server that is allowed to access them. Otherwise, you do not need to manually create or modify this type of credential.
### CMP node credentials form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The automatically generated name based on the datacenter where the virtual machine is located.</td>
</tr>
<tr>
<td>Active</td>
<td>If the credentials are active.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Choose whether this credential is available to a specific MID Server or all MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
<tr>
<td>User Name and Password</td>
<td>The virtual server user name and password.</td>
</tr>
<tr>
<td>SSH passphrase and SSH private key</td>
<td>The private key and the passphrase that protects the key if the virtual server requires it.</td>
</tr>
<tr>
<td>Authentication Protocol and Authentication Key</td>
<td>The private key and the passphrase that protects the key if the virtual server requires it.</td>
</tr>
<tr>
<td>Privacy Protocol and Privacy Key</td>
<td>The encryption protocol used with the virtual server and enter the privacy key.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow.</td>
</tr>
</tbody>
</table>

### Cloud Management (CMP) SSH key pair credentials

Cloud Management (CMP) SSH key pairs store the keys that the Cloud Management application automatically generates when users provision stack resources.
Note: You might need to deactivate these credentials if you no longer want them used. Otherwise, you do not need to manually create or modify this type of credential.

**CMP SSH key pair credentials form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The automatically generated name.</td>
</tr>
<tr>
<td>Active</td>
<td>If the credentials are active.</td>
</tr>
<tr>
<td>SSH Public Key</td>
<td>The public key.</td>
</tr>
<tr>
<td>SSH Private Key</td>
<td>A secure private key that can be used instead of a password for SSH logins.</td>
</tr>
</tbody>
</table>

**Infoblox credentials**

Infoblox credentials are required to set up IP pools (IPAM) in the Cloud Management application.

These fields are available on the Credentials form for Infoblox type credentials.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Choose whether this credential is available to a specific MID Server or a all MID Servers.</td>
</tr>
</tbody>
</table>
| Order       | Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order. Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>same order number (or none), the instance tries the credentials in a random order.</td>
<td></td>
</tr>
<tr>
<td>wAPI Version</td>
<td>Enter the version of wAPI you are using.</td>
</tr>
<tr>
<td>User Name and Password</td>
<td>Enter the InfoBlox user name and password.</td>
</tr>
</tbody>
</table>

**JDBC credentials**

The JDBC credential type manages access to a Java Database Connectivity (JDBC) connection. This credential type is available for Discovery and Orchestration.

These fields are available in the Credentials form for JDBC type credentials.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name to create in the Credentials table. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name. For CIM discovery, the user must have the admin role.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
<tr>
<td>Credential ID</td>
<td>Enter the unique key configured for external credentials in the JAR file uploaded to the MID Server for an external credential system. The Credential ID field has a limit of 40 characters. This field is only visible when the External credential store check box is selected.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow. To use the credential for discovering CIs not belonging to this CI type using Service Mapping and Discovery patterns, enter the</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>table name for the CI type to which the CI belongs, for example cmdb_ci_apache_web_server. For more information, see Change credentials to non-default.</td>
<td></td>
</tr>
<tr>
<td>External credential store</td>
<td>Select this check box to use an external credential storage system. When you select this option the User name and Password fields are replaced with the Credential ID field. External credential storage is only available when the External Credential Storage plugin in activated. Note: Currently, the only supported external storage system is CyberArk.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select whether to apply these credentials to All MID servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use these credentials in the MID servers field.</td>
</tr>
<tr>
<td>MID servers</td>
<td>Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select Specific MID servers from the Applies to field.</td>
</tr>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
<tr>
<td>Windows MID Server Service Account</td>
<td>When active, the defined credential represents the MID Server service account.</td>
</tr>
</tbody>
</table>

**JMS credentials**

The JMS credentials type manages access to a Java Message Service (JMS). This credential type is available for Discovery and Orchestration.

These fields are available in the Credentials form for JMS.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name to create in the Credentials table. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name. For CIM discovery, the user must have the admin role.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
<tr>
<td>Credential ID</td>
<td>Enter the unique key configured for external credentials in the JAR file uploaded to the MID Server for an external credential system. The Credential ID field has a limit of 40 characters.</td>
</tr>
<tr>
<td></td>
<td>This field is only visible when the External credential store check box is selected.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow.</td>
</tr>
<tr>
<td></td>
<td>To use the credential for discovering CIs not belonging to this CI type using Service Mapping and Discovery patterns, enter the table name for the CI type to which the CI belongs, for example cmdb_ci_apache_web_server. For more information, see Change credentials to non-default.</td>
</tr>
<tr>
<td>External credential store</td>
<td>Select this check box to use an external credential storage system. When you select this option the User name and Password fields are replaced with the Credential ID field. External credential storage is only available when the External Credential Storage plugin in activated.</td>
</tr>
<tr>
<td>Note:</td>
<td>Currently, the only supported external storage system is CyberArk.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select whether to apply these credentials to All MID servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use these credentials in the MID servers field.</td>
</tr>
<tr>
<td>MID servers</td>
<td>Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select Specific MID servers from the Applies to field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
<tr>
<td>Windows MID Server Service Account</td>
<td>When active, the defined credential represents the MID Server service account.</td>
</tr>
</tbody>
</table>

**OAuth 2.0 credentials**

OAuth 2.0 credentials enable ServiceNow to obtain access to user accounts on an HTTP service.

These fields are available in the Credentials form for OAuth 2.0.

### OAuth 2.0 credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential. For example, you might call it OAuth2 credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Specify whether this credential is active.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>An OAuth profile is a combination of a grant type and at least one scope.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Specify whether the credential is for all MID Servers, or specific MID servers. If specific, add the MID servers as necessary.</td>
</tr>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
</tbody>
</table>
OAuth 2.0 credentials form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credential alias</td>
<td>Specify the credential alias you want to tie to the OAuth 2.0 credential.</td>
</tr>
</tbody>
</table>

SAP credentials

The SAP credential type manages access to SAP JCo systems. This credential type is available for Discovery and Orchestration.

These fields are available in the Credentials form for SAP type credentials.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name to create in the Credentials table. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name. For CIM discovery, the user must have the admin role.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
<tr>
<td>Credential ID</td>
<td>Enter the unique key configured for external credentials in the JAR file uploaded to the MID Server for an external credential system. The Credential ID field has a limit of 40 characters. This field is only visible when the External credential store check box is selected.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow. To use the credential for discovering CIs not belonging to this CI type using Service Mapping and Discovery patterns, enter the table name for the CI type to which the CI belongs, for example cmdb_ci_apache_web_server. For more information, see Change credentials to non-default.</td>
</tr>
</tbody>
</table>
**Field** | **Description**
---|---
External credential store | Select this check box to use an external credential storage system. When you select this option the User name and Password fields are replaced with the Credential ID field. External credential storage is only available when the External Credential Storage plugin is activated.

> **Note:** Currently, the only supported external storage system is CyberArk.

Applies to | Select whether to apply these credentials to All MID servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use these credentials in the MID servers field.

MID servers | Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select Specific MID servers from the Applies to field.

Order | Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.

Windows MID Server Service Account | When active, the defined credential represents the MID Server service account.

**SNMP credentials**

Discovery explores many kinds of devices (switches, routers, printers, etc.) using the SNMP protocol. Credentials for SNMP do not include a user name, just a password, called the community string.

The default read-only community string for many SNMP devices is public, and Discovery will try that automatically. Enter the appropriate SNMP credentials if they differ from the public community string.

Discovering SNMP uses all community strings that are configured. This behavior does not apply to discovering SNMPv3.
The default Orchestration activity SNMP Query returns the object identifier (OID) of a device and requires SNMP credentials.

**SNMP community credentials**

The SNMP Community credential type manages access to discover many kinds of devices (switches, routers, printers, etc.) using the SNMP protocol. This credential type is available for Discovery, Service Mapping, and Orchestration.

Credentials for SNMP do not include a user name, just a password (the community string). The default read-only community string for many SNMP devices is public, and the system will try that automatically. Enter the appropriate SNMP credentials if they differ from the public community string.

These fields are available in the Credentials form for SNMP community.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name to create in the Credentials table. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name. For CIM discovery, the user must have the admin role.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
</tbody>
</table>
| Credential ID     | Enter the unique key configured for external credentials in the JAR file uploaded to the MID Server for an external credential system. The Credential ID field has a limit of 40 characters.  
This field is only visible when the External credential store check box is selected. |
| Credential alias  | Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow.  
To use the credential for discovering CIs not belonging to this CI type using Service Mapping and Discovery patterns, enter the table name for the CI type to which the CI belongs, for example cmdb_ci_apache_web_server. For more information, see Change credentials to non-default. |
### Field Description

**External credential store**

Select this check box to use an external credential storage system. When you select this option the **User name** and **Password** fields are replaced with the **Credential ID** field. External credential storage is only available when the External Credential Storage plugin is activated.

ℹ️ **Note:** Currently, the only supported external storage system is CyberArk.

**Applies to**

Select whether to apply these credentials to **All MID servers** in your network, or to one or more **Specific MID servers**. Specify the MID Servers that should use these credentials in the **MID servers** field.

**MID servers**

Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select **Specific MID servers** from the **Applies to** field.

**Order**

Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.

**Windows MID Server Service Account**

When active, the defined credential represents the MID Server service account.

### SNMPv3 credentials

SNMPv3 credentials accept a privacy protocol and an additional privacy key and are available for Discovery and Orchestration. For external storage in CyberArk, you can select a privacy account key.

These fields are available in the Credentials form for SNMPv3.
### SNMPv3 credential fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique and descriptive name for this credential. For example, you might call it <strong>SNMP Community Atlanta</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select whether to apply these credentials to <strong>All MID servers</strong> in your network, or to one or more <strong>Specific MID servers</strong>. Specify the MID Servers that should use these credentials in the <strong>MID servers</strong> field.</td>
</tr>
<tr>
<td>MID servers</td>
<td>Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select <strong>Specific MID servers</strong> from the <strong>Applies to</strong> field.</td>
</tr>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the SNMP user name. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name.</td>
</tr>
<tr>
<td>Authentication protocol</td>
<td>Select the authentication type to use for this credential. The choices are <strong>MD5</strong> and <strong>SHA</strong>.</td>
</tr>
<tr>
<td>Authentication Key</td>
<td>Enter the authentication key to use for this credential.</td>
</tr>
</tbody>
</table>
| Privacy protocol  | Select the encryption protocol for this credential. The choices are:  
  • 3DES  
  • AES128  
  • AES192                                                                                                                                       |
### SNMPv3 credential fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>• AES256</td>
<td>• DES</td>
</tr>
<tr>
<td>Privacy key</td>
<td>Enter the key associated with the selected privacy protocol.</td>
</tr>
<tr>
<td>Credential ID</td>
<td>Enter the unique key configured for external credentials in the JAR file uploaded to the MID Server for an external credential provider. The <strong>Credential ID</strong> field has a limit of 40 characters. This field is only visible when the <strong>External credential store</strong> check box is selected.</td>
</tr>
<tr>
<td>Privacy Credential ID</td>
<td>Enter the privacy account key configured for SNMPv3 credentials in CyberArk. If you are using a privacy protocol in CyberArk, this field must have the same value as the <strong>Name</strong> field for the CyberArk SNMPv3 Privacy Account. This field is only visible for SNMPv3 when you select <strong>CyberArk</strong> from the <strong>Credential Store Type</strong> field. If you are not using a privacy key for CyberArk, leave this field empty.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow.</td>
</tr>
<tr>
<td>External credential store</td>
<td>Select this check box to use an external credential storage system. When external storage is enabled, the <strong>Credential ID</strong> field appears. External credential storage is only available when the <strong>External Credential Storage plugin</strong> is activated and the <strong>External Storage</strong> view is selected.</td>
</tr>
<tr>
<td>Credential Store Type</td>
<td>Select the external storage provider. Select <strong>CyberArk</strong> only if you are using a CyberArk SNMPv3 privacy key. The <strong>Privacy Credential ID</strong> field appears to allow entry of the key.</td>
</tr>
<tr>
<td>Use Context</td>
<td>Select this check box to add a context value for this credential. This field is visible in the <strong>Discovery</strong> view.</td>
</tr>
</tbody>
</table>
SNMPv3 credential fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Contexts are not currently supported for external credential storage.</td>
</tr>
<tr>
<td>Note:</td>
<td>A context is a collection of management information accessed by an SNMPv3 credential that references a specific OID. Contexts are sometimes referenced to collect information about the device that cannot be accessed by the normal credential. A context can be provided by the manufacturer or configured separately. For additional information, see Context Name and Context ID.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you have multiple SNMPv3 credentials with the same user name and keys, but some of your devices need a context and some do not, then you will need to create separate records for each device.</td>
</tr>
</tbody>
</table>

Context Name | Enter the context name value for this credential. This should only be used if you have devices that require this value for full access. This field is visible when the Use Context check box is selected.

SSH credentials

Discovery, Orchestration, and IntegrationHub explore UNIX and Linux devices by using SSH credentials to execute commands over Secure Shell (SSH). SSH commands must run with root privileges, either with root credentials or through the use of sudo. SSH private key credentials provide additional security.

Granting root privileges

Before granting root privileges, review your security policy and options with your organization's security team.

Use either of these approaches to allow users to run SSH commands with root privileges:

- Give other credentials for Discovery, Orchestration, or IntegrationHub, but grant the user in those credentials the right to execute certain commands with root privileges, using sudo. This is a secure way to grant limited privileges. Discovery, Orchestration, or IntegrationHub use sudo on any probe that has
the `must_sudo` parameter set to `true` (it defaults to `false`). However, each system must be configured to allow sudo to work. This is done by editing the `/etc/sudoers` file using the `visudo` command.

- Give root credentials. These are obviously the most powerful credentials, but may not be desirable from a security perspective. If Discovery, Orchestration, or IntegrationHub have the root credentials to any UNIX or Linux system, no further configuration is required.

### Privileged commands

The platform provides default privileged commands for the MID Server to use and the ability to add additional commands to the system. For details about using sudo and other privileged commands, see MID Server privileged commands.

### SSH private key credential type

> **Note:** SSH private key credentials should be used in most cases, as they provide better security than SSH password credentials.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique and descriptive name for this credential. For example, you might call it <strong>SSH Atlanta</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter a UNIX or Linux user name. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the UNIX or Linux password. For <strong>SSH Private Key</strong> type credentials, enter the sudo password if one is required for the user name.</td>
</tr>
<tr>
<td>SSH passphrase</td>
<td>Type a secure SSH passphrase. This field is available only for <strong>SSH Private Key</strong> credentials.</td>
</tr>
</tbody>
</table>
| SSH private key| Enter a secure, private key that can be used instead of a password for SSH logins.  
  The private key must be entered in the proper format to ensure it is correctly encrypted. The private key must start with the string `-----BEGIN`.  
  Here is an example of a correctly formatted private key |
The Now Platform supports private keys in the PEM format generated by the OpenSSH ssh-keygen utility. To convert PPK keys that were generated by PuTTY:

- Open your private key in PuTTYGen.
- Export it in OpenSSH format from the menu **Conversions > Export OpenSSH key**.
- Save the new OpenSSH key.

**Credential alias**

- Allow flow designers to use aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you do not need to update any actions that use the connection. For more information, see **Credentials and connection information**.
- Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow.

**External credential store**

Select this check box to use an external credential storage system. When you select this option the **User name** and **Password** fields are replaced with the **Credential ID** field. Currently, the only supported external storage system is CyberArk.

**MID servers**

Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select **Specific MID servers** from the **Applies to** field.

**Applies to**

Select whether to apply these credentials to **All MID servers** in your network, or to one or more **Specific MID servers**. Specify the MID Servers that should use these credentials in the **MID servers** field.

**Order**

The order (sequence) in which the platform tries this credential as it attempts to log onto devices. The smaller the number, the
higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), Discovery or Orchestration tries the credentials in a random order.

### SSH credential type
These fields are available in the SSH credentials form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name to create in the Credentials table. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name. For CIM discovery, the user must have the admin role.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
<tr>
<td>Credential ID</td>
<td>Enter the unique key configured for external credentials in the JAR file uploaded to the MID Server for an external credential system. The Credential ID field has a limit of 40 characters. This field is only visible when the <strong>External credential store</strong> check box is selected.</td>
</tr>
</tbody>
</table>
| Credential alias | • Allow flow designers to use aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you do not need to update any actions that use the connection. For more information, see Credentials and connection information.  
• Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow. To use the credential for discovering CIs not belonging to this CI type using Service Mapping and Discovery patterns, enter the table name for the CI type to which the CI belongs, for example cmdb_ci_apache_web_server. For more information, see Change credentials to non-default. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>External credential store</td>
<td>Select this check box to use an external credential storage system. When you select this option the <strong>User name</strong> and <strong>Password</strong> fields are replaced with the <strong>Credential ID</strong> field. External credential storage is only available when the External Credential Storage plugin in activated.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select whether to apply these credentials to <strong>All MID servers</strong> in your network, or to one or more <strong>Specific MID servers</strong>. Specify the MID Servers that should use these credentials in the <strong>MID servers</strong> field.</td>
</tr>
<tr>
<td>MID servers</td>
<td>Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select <strong>Specific MID servers</strong> from the <strong>Applies to</strong> field.</td>
</tr>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
</tbody>
</table>

**Commands that require root privileges for Discovery, Orchestration, and IntegrationHub**

These examples assume that the user name is **Disco**. Substitute the actual user name and ensure that the paths for the commands match the paths on the system.

**Note:** Sudo commands do not work with private key credentials, because there is no password to supply to the sudo command. A solution is to add the **NOPASSWD** option to the sudo configuration. For example, you might enter: `disco ALL=(root) NOPASSWD:/usr/sbin/dmidecode,/usr/sbin/lsof,/sbin/ifconfig`.

**UNIX and Linux commands requiring root privileges**

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP-UX</td>
<td></td>
</tr>
</tbody>
</table>
### UNIX and Linux commands requiring root privileges (continued)

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>adb</strong></td>
<td>Gathers CPU speed and memory.</td>
</tr>
<tr>
<td></td>
<td>• <code>/etc/sudoers line example</code>: Disco ALL=(root) /usr/bin/adb</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by</strong>: Discovery</td>
</tr>
<tr>
<td><strong>chage</strong></td>
<td>Changes the number of days between password changes and the date of the last password change.</td>
</tr>
<tr>
<td></td>
<td>• <code>/etc/sudoers line example</code>: Disco ALL=(root) /usr/bin/chage</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by</strong>: Orchestration and IntegrationHub</td>
</tr>
<tr>
<td><strong>chpasswd</strong></td>
<td>Changes user passwords.</td>
</tr>
<tr>
<td></td>
<td>• <code>/etc/sudoers line example</code>: Disco ALL=(root) /etc/chpasswd</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by</strong>: Orchestration and IntegrationHub</td>
</tr>
<tr>
<td><strong>dmidecode</strong></td>
<td>Gathers several pieces of information about the hardware, including the serial number embedded within the motherboard.</td>
</tr>
<tr>
<td></td>
<td>• <code>/etc/sudoers line example</code>: Disco ALL=(root) /sbin/dmidecode</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by</strong>: Discovery</td>
</tr>
<tr>
<td><strong>fdisk</strong></td>
<td>Gathers the disks and size information on the system.</td>
</tr>
<tr>
<td></td>
<td>• <code>/etc/sudoers line example</code>: Disco ALL=(root) /usr/bin/fdisk -l</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by</strong>: Discovery</td>
</tr>
<tr>
<td><strong>multipath</strong></td>
<td>Gathers device mappings for MPIO.</td>
</tr>
<tr>
<td></td>
<td>• <code>/etc/sudoers line example</code>: Disco ALL=(root) /usr/bin/multipath -ll</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by</strong>: Discovery</td>
</tr>
</tbody>
</table>

**All Linux and UNIX versions**
### UNIX and Linux commands requiring root privileges (continued)

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>dmsetup</td>
<td>Examines a low level volume.</td>
</tr>
<tr>
<td></td>
<td>• <code>/etc/sudoers line example:</code></td>
</tr>
<tr>
<td></td>
<td>◦ Disco ALL=(root) /usr/bin/dmsetup table *</td>
</tr>
<tr>
<td></td>
<td>◦ Disco ALL=(root) /usr/bin/dmsetup ls</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by:</strong> Discovery</td>
</tr>
</tbody>
</table>

**All UNIX versions**

<table>
<thead>
<tr>
<th>lsof</th>
<th>Determines the relationship between processes and the connections being made to the system.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <code>/etc/sudoers line example:</code></td>
</tr>
<tr>
<td></td>
<td>Disco ALL=(root) /sbin/lsof</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by:</strong> Discovery</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>oratab</th>
<th>Grants read access to the oratab file for locating the Oracle Home and pfile.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <code>/etc/sudoers line example:</code></td>
</tr>
<tr>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by:</strong> Discovery</td>
</tr>
</tbody>
</table>

**Solaris**

<table>
<thead>
<tr>
<th>iscsiadm</th>
<th>Gets iSCSI IQNs</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <code>/etc/sudoers line example:</code></td>
</tr>
<tr>
<td></td>
<td>${sudo:iscsiadm list target -S}</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by:</strong> Discovery</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>fcinfo</th>
<th>Gets WWPNs for ports.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <code>/etc/sudoers line example:</code></td>
</tr>
<tr>
<td></td>
<td>${sudo:fcinfo remote-port -sl -p $port}</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by:</strong> Discovery</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>prtvtoc</th>
<th>Reports information about disk partitions.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <code>/etc/sudoers line example:</code></td>
</tr>
<tr>
<td></td>
<td>Disco ALL=(root) /usr/bin/prtvtoc</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by:</strong> Discovery</td>
</tr>
</tbody>
</table>

| /usr/bin/ps | Lists running process. As an alternative to running with root access, add a proc_owner role.|

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
UNIX and Linux commands requiring root privileges (continued)

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>• /etc/sudoers line example: Disco ALL=(root) /usr/bin/ps</td>
<td></td>
</tr>
<tr>
<td>• Used by: Discovery</td>
<td></td>
</tr>
<tr>
<td>/usr/ucb/ps</td>
<td>Lists running process. As an alternative to running with root access, add a proc_owner role. The use of the /usr/ucb/ps command is deprecated as of Solaris 11. Because Discovery, Orchestration, and IntegrationHub require the use of this command for all Solaris versions, you must install the ucb utility manually on Solaris 11 systems. For instructions, see KB0564262.</td>
</tr>
<tr>
<td>• /etc/sudoers line example: Disco ALL=(root) /usr/ucb/ps</td>
<td></td>
</tr>
<tr>
<td>• Used by: Discovery</td>
<td></td>
</tr>
</tbody>
</table>

For a list of privileged commands that you need for Discovery and Service Mapping, see for a list of the commands that require elevated rights to discover and map Unix-based hosts in your organization.

**Access Requirements for Non-Root Credentials**
If you do not provide Discovery with root access credentials, you must provide credentials with the following access requirements.

<table>
<thead>
<tr>
<th>Application</th>
<th>File or Directory</th>
<th>Access Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apache</td>
<td>httpd.conf</td>
<td>Read</td>
</tr>
<tr>
<td>Hbase</td>
<td>hbase-site.xml</td>
<td>Read</td>
</tr>
<tr>
<td>JBoss</td>
<td>jboss-service.xml</td>
<td>Read</td>
</tr>
<tr>
<td></td>
<td>JBoss home directory</td>
<td>Read</td>
</tr>
<tr>
<td></td>
<td>web.xml</td>
<td>Read</td>
</tr>
<tr>
<td>MySQL</td>
<td>my.cnf</td>
<td>Read</td>
</tr>
<tr>
<td>NGINX</td>
<td>nginx.conf</td>
<td>Read</td>
</tr>
<tr>
<td>Oracle</td>
<td>oratab</td>
<td>Read</td>
</tr>
<tr>
<td></td>
<td>Associated (s) pfiles</td>
<td>Read</td>
</tr>
<tr>
<td>Oracle Listener</td>
<td>lsnrctl</td>
<td>Execute</td>
</tr>
</tbody>
</table>
### VMware credentials

The VMware credentials type manages access to vCenter credentials.

Applications that access VMware cloud resources need access to VMware credentials. For example, the VMware credential type allows Discovery to explore VMware's vCenter running on a Windows machine to discover ESX machines, virtual machines, and resource pools. The VMware Discovery and automation API (vCenter API) now provides the globally unique serial number for computer CIs. CIM credentials are not needed to allow access to each VMware host.

⚠️ **Note:** Windows credentials are not necessary for vCenter Discovery, when valid VMware credentials are used.

⚠️ **Important:** Do not use **VMware** Type credentials for Orchestration activities that perform work on the individual virtual machines cloned by vCenter (for example, restarting a Linux VM). For these activities, the credential **Type** depends on the operating system of the virtual machine (either **SSH** or **Windows**).
## VMWare credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for the VMware credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name you use for your VMware account. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name. The VMware credentials must have the read-only role in vCenter.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password for the VMware account.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select Specific MID servers from the Applies to field.</td>
</tr>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
</tbody>
</table>

## Windows credentials

Windows credentials provide access to Windows computers. This credential type is available for Discovery and Orchestration.

## Credential requirements

Discovery and Orchestration have the following requirements for Windows credentials:

- Install a MID Server on a Windows host as a service.
- Add Windows credentials to one of these locations:
  - An entry in the Credentials [windows_credentials] table
  - A MID Server service account to run as a specific Windows user or domain account.
Granting proper permissions
To provide sufficient permissions, Windows credentials must be one of the following:

• A domain user with local administrator access on the target Windows hosts.
• A local account that has administrator privileges and User Access Control (UAC) disabled on the same target host.
• A user who meets the requirements of Windows probes and permissions (Discovery only).
• A user who meets the requirements of the Orchestration activity to be run (Orchestration only).

Note: No logon privileges are needed. Account does NOT need to be interactive.

Security around granting privileged access can be enhanced by using JEA profiles to run Discovery. For more information, see Microsoft Just Enough Administration (JEA) for Discovery.

Workgroup computers
To run Powershell commands to discover a Workgroup computer, configure the MID Server credentials for either of these users:

• Built-in administrator account on the Workgroup computer.
• Domain user on the Workgroup computer.

Multi-domain configuration
To enable Windows credentials to function across multiple domains, make sure to use the correct name formats and MID Server configuration.

Discovery and Orchestration support Windows domain credentials in both User Principal Name and Down-Level Logon Name user name formats. For example, Domain\UserName or UserName@example.domain.com. You can provide Windows workgroup credentials in the following format: WORKGROUP \UserName.

Note: You can also provide a local account by using the . \ user name.

These additional actions are required to enable credentials to function across multiple Windows domains.
<table>
<thead>
<tr>
<th>Condition</th>
<th>Additional actions required</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server host on the same domain as the Windows target.</td>
<td>None</td>
</tr>
<tr>
<td>MID Server host on a different domain than the Windows target.</td>
<td>Ensure that PowerShell 3.0 (or higher up to 5.1) is installed on the MID Server host.</td>
</tr>
<tr>
<td>MID Server host on a different domain than the Microsoft SQL Server target.</td>
<td>See MSSQL server discovery.</td>
</tr>
</tbody>
</table>

**Windows credentials type**

These fields are available in the Credentials form for Windows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name to create in the Credentials table. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name. For CIM discovery, the user must have the admin role.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
</tbody>
</table>
| Credential ID      | Enter the unique key configured for external credentials in the JAR file uploaded to the MID Server for an external credential system. The **Credential ID** field has a limit of 40 characters. 
This field is only visible when the **External credential store** check box is selected. |
| Credential alias   | Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow. 
To use the credential for discovering CIs not belonging to this CI type using Service Mapping and Discovery patterns, enter the table name for the CI type to which the CI belongs, for example cmdb_ci_apache_web_server. For more information, see **Change credentials to non-default**. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>External credential store</td>
<td>Select this check box to use an external credential storage system. When you select this option the User name and Password fields are replaced with the Credential ID field. External credential storage is only available when the External Credential Storage plugin in activated.</td>
</tr>
<tr>
<td></td>
<td>Note: Currently, the only supported external storage system is CyberArk.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select whether to apply these credentials to All MID servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use these credentials in the MID servers field.</td>
</tr>
<tr>
<td>MID servers</td>
<td>Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select Specific MID servers from the Applies to field.</td>
</tr>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
<tr>
<td>Windows MID Server Service Account</td>
<td>When active, the defined credential represents the MID Server service account.</td>
</tr>
</tbody>
</table>

Configure Windows credentials for the MID Server

Configure the MID Server to use either the credentials of its own Windows service or credentials from the Credentials [discovery_credentials] table.

Before you begin
Role required: admin
Procedure

1. Configure the MID Server to use credentials from the MID Server service account.
   a. Set the MID Server service account to a user who meets the permission requirements.
   b. Verify the user name meets the name format requirements.
   c. Fill in the fields on the form, as appropriate.
   d. Verify the credentials meet domain requirements.

2. Configure the MID Server use credentials from the Credentials [discovery_credentials] table.
   a. Add individual Windows credentials to the Credentials [windows_credentials] table.
      • Verify each credential meets the permission requirements.
      • Verify each username meets the name format requirements.
      • Verify each credential meets the Windows domain requirements.
   b. [Optional] Configure the MID Server to use Powershell by setting the mid.use_powershell parameter to true. See MID Server Configuration.
   c. Select the Windows MID Server Service Account check box to create a credential that represents the windows MID Server service account to run as a specific Windows user or domain account.

Credential affinity for Discovery and Orchestration

Credential affinity is an association between a set of credentials and a device on your network.

When Discovery or Orchestration first attempts to access a device, they try all available credentials until they find the correct ones. After identifying the credentials for a device, Discovery and Orchestration create an affinity between the credentials and the device using the Credential Affinity [dscy_credentials_affinity] table. All subsequent discoveries or Orchestration activities attempt to match the credentials in this table with a device for which an affinity exists. If credentials for a device change, Discovery and Orchestration try all available credentials again until they create a new affinity.
### Credential Affinity diagram

Does an affinity exist?

- **Yes**: Look up credential for existing affinity and insert it into the probe.
- **No**: MID Server iterate through discovery_credentials table and insert appropriate credential_id. Create new affinity.

---

#### Note:
If Orchestration and Discovery are installed, and credential alias is enabled, multiple affinities can exist. In this case, the platform looks up credentials for each affinity and inserts the credential for the affinity with the lowest order into the probe.

#### Credentials troubleshooting

Review the `<credentials_debug>` section of the ECC queue payload to troubleshoot issues with credentials.

Certain probes support credential debugging. Credential debugging inserts a `<credentials_debug>` section in the payload that the MID Server returns to the instance ECC queue. You can view the `<credentials_debug>` section to see detailed information about the credential lookup.

The `<credentials_debug>` section appears in the payload if:

- Credentials fail for WMIRunner probe, PowerShell probe, JMS, or SSHCommand probe.
- You set the `credentials_debug` parameter to `true` for the WMIRunner, PowerShell, or SSHCommand probes. If you set the parameter to true, the `<credentials_debug>` section appears even if the credential lookup is successful.

The `<credentials_debug>` section shows:

- Information about the credential search, such as the credential types, tags, and affinities.
- The IP address targeted.
- Information about each credential (in order) that the MID Server used, including the type, classification, tag, name, Sys ID, and external credential ID if present.
Details appear for the PowerShell parameter:

- If the local MID Server credentials were used after all the Windows credentials failed.
- If the credentials were skipped because you are trying to discover the same machine that the MID Server is on.
- If the `mid.powershell.use_credentials` parameter is set to `true`.

Details appear for the SSHCommand:

- If the credential search was skipped because the target IP is excluded.
- If the target IP was added to the exclusion list.

**Note:** The MID Server saves IP addresses for failed credential searches in an exclusion list in cache memory. This exclusion list specifies which devices the MID Server should stop trying to access. IP addresses are added to the exclusion list after every credential has failed. The IP addresses are cleared from the exclusion list cache either after five minutes, if the MID Server is restarted, or if the credential records on the instance are updated.

### External credential storage

An instance can store credentials used by Discovery, Orchestration, and Service Mapping in an external credential repository rather than directly in a ServiceNow credentials record.

The instance maintains a unique identifier for each credential, the credential type (such as SSH, SNMP, or Windows), and any credential affinities. The MID
Server obtains the credential identifier from the instance, and then uses a customer-provided JAR file to resolve the identifier from the repository into a usable credential. Currently, the ServiceNow® platform supports the use of the CyberArk vault for external credential storage.
Credential process flow
The MID Server retrieves credentials from an external store using this process:

1. MID Server downloads credential objects from the ServiceNow Credentials [discovery_credentials] table that contain the corresponding credential ID from the target vault.

2. As each probe or pattern runs from Discovery or Orchestration jobs, the MID Server requests the credential by passing information such as credential ID, target IP address, and credential type to the Credential Resolver Java Jar file. The details about the correct credential object to retrieve from the vault are determined by the Credential Resolver.

   Many Credential Resolvers such CyberArk call an application supplied by the third-party vault vendor running on same machine as the MID Server. That application can often be configured to cache credentials and knows to update the cache when a credential changes in the vault, which is very important to avoid unnecessary network calls to the vault each time MID Server requests a credential. The Credential Resolver (using optional vendor application if present) makes a call to the vault to get the actual user name, password, etc.

   For Credential Resolvers supplied out-of-box (only CyberArk today), the MID Server only caches a credential for up to several seconds using encryption in MID Server process memory. This means the MID Server can make multiple requests to the Credential Resolver for the same credential even when discovering a single device. Contact third party vendors for information about caching implementations for other Credential Resolvers.

3. MID Server executes the probe with the appropriate credential.

   Note: Credential affinity still applies. The mechanism remains the same, since the only real difference from the MID Server's perspective is that the real credential details (user name and password) come from the third party vault.

External credential storage logging
The MID Server posts log messages about external credential storage.

If the repository encounters an error while attempting to resolve a credentials request, the MID Server posts log messages with this prefix: Problem with client's CredentialResolver:

Components installed with External Credential Storage

Business rule
The External Credential Storage business rule performs the following tasks when an administrator makes any change to the Enable External Credential Storage property:

- Changes the view for the Credentials record list and form to the External Storage view. This view enables users to see the Credential ID column in the list.
- Instructs the MID Server to refresh its credentials cache in preparation for a change in the way credentials are obtained.

**Property**

A property called Enable External Credential Storage [com.snc.use_external_credentials] enables or disables the External Credential Storage plugin after it is activated. The property is located in **Discovery Definition > Properties** and **Orchestration > MID Server Properties**, and is enabled when you activate the plugin.

If you disable external credential storage with the system property, the system automatically sets all the external credentials to inactive in the instance. If you re-enable the feature with this property, the system does not reset the external credential records to active. You must reactivate each credential record manually.

**Request external credential storage for Discovery and Orchestration**

The External Credential Storage plugin is available by request.

**Before you begin**

Role required: admin

**About this task**

There are two ways to request a plugin:

- Access the Now Support Service Catalog directly by clicking **Service Catalog > Activate Plugin** on Now Support.
- Access the Now Support Service Catalog through the All Applications page on your instance by following these steps.

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. On the All Applications page, click **Request Plugin** to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. On the form, fill in the fields.

**Activate Plugin request form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the <strong>Reason/Comments</strong> field.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**CyberArk credential storage integration**

The MID Server integration with the CyberArk vault enables Orchestration, Discovery, and Service Mapping to run without storing any credentials on the instance.

**Introduction to CyberArk**

CyberArk’s Application Identity Management (AIM) product uses the Privileged Account Security solution to eliminate the need to store application passwords embedded in applications, scripts or configuration files, and allows these highly-sensitive passwords to be centrally stored, logged and managed within the CyberArk vault. This approach enables organizations to comply with internal and regulatory requirements of periodic password replacement and to monitor activities associated with all types of privileged identities, whether on-premise or in the cloud.

The instance maintains a unique identifier for each credential, the credential type (such as SSH, SNMP, or Windows), and any credential affinities. The MID Server obtains the credential identifier, credential type, and IP address from the instance, and then uses the CyberArk vault to resolve these elements into a usable credential. The credential resolver can also look up the hostname, fqdn, and use reverse DNS lookup to get fqdn.
The CyberArk integration requires the ServiceNow® External Credential Storage plugin, which is available in System Definitions > Plugins. The MID Server and CyberArk AIM/API client must be installed on the same machine.

**Installed with CyberArk**

- **Business rule:** The External Credential Storage business rule performs the following tasks when an administrator makes any change to the external credential storage property:
  - Changes the view for the Credentials record list and form to the External Storage view. This view enables users to see the Credential ID column in the list.
  - Instructs the MID Server to refresh its non-external credentials cache in preparation for a change in the way credentials are obtained.

- **System property:** A property called Enable External Credential Storage [com.snc.use_external_credentials] enables or disables the External Credential Storage plugin after it is activated. This property is located in Discovery Definition > Properties and Orchestration > MID Server Properties, and is enabled when you activate the plugin.

  **Note:** If you disable external credential storage with the system property, the system automatically sets all the external credentials to inactive in the instance. If you re-enable the feature with this property, the system does not reset the external credential records to active. You must reactivate each credential record manually.

**Supported credential types**
The CyberArk integration supports these ServiceNow credential types:

- GCP
- Azure
- CIM
- JMS
- SNMP forum
- SNMPv3
- Basic Auth
- SSH Key Pair
- SSH Private Key (with key, pass phrase, and password)
- VMware
• Windows
• Applicative Credentials

Orchestration activities that use these network protocols support the use of credentials stored on a CyberArk vault:
• SOAP (with basic authentication overrides)
• REST (with basic authentication overrides)
• JDBC
• SSH
• PowerShell
• JMS
• SFTP

**Important:** You cannot manage credentials stored on a CyberArk vault and a custom external credential storage system using the same MID Server. The MID Server and CyberArk AIM/API client must be installed on the same machine.
How the MID Server handles Windows accounts

Credential lookup initially attempts to match the specified credential ID to an existing value in the CyberArk vault **Name** field. If a match is found, that credential is returned. If no match is found, the credential lookup attempts to find a match using the IP address. If the IP address lookup matches more than one credential, such as Windows and Tomcat on the same server, the lookup
fails. To avoid this issue, set the `ext.cred.type_specifier` parameter in the MID Server config.xml file to `true` to force CyberArk to return credentials that match both the credential type and the IP address. For example, if an IP address is shared by both Windows and Tomcat, a credential type of Windows returns the Windows credential only.

**CyberArk integration configuration**

These procedures include both CyberArk and ServiceNow configuration tasks, including references to the appropriate CyberArk documentation.

The credential identifier configured in the ServiceNow instance must be mapped to the credential name in the CyberArk vault. When looking up a credential, the MID Server finds the credential by matching the credential identifier to a name in vault, which must be unique. If the credential identifier is blank, then the MID Server finds the credential by IP address. To identify the credential by IP address, the system looks at the credential type to ensure that there is only one credential of that type at that address. An example of this might be when a Windows server and vCenter are both running on the same IP address. To support strict credential requirements like this in an SSH environment, a MID Server configuration parameter allows you to require that the credential type requested matches the type returned by CyberArk.

⚠️ **Note:** The Credential ID field is the only field necessary to map your credentials to CyberArk, in all cases except for SNMPv3. The Privacy Credential ID field is optional and is required only when using SNMPv3 credentials and using a privacy protocol for the credentials. See Configure the CyberArk credential identifier for more details.

To configure your instance to obtain credentials from a CyberArk vault, complete these tasks in the order in which they appear below.

**Configure the CyberArk vault and install the AIM API**

Configure the CyberArk vault to allow MID Server access and install the CyberArk AIM API on the MID Server machine.

**Before you begin**
Role required: admin
Before starting this procedure, ensure that the External Credential Storage plugin is activated.
Procedure

1. Configure the CyberArk vault with the application ID and authentication details that all MID Servers requesting credentials will use. For details, refer to the CyberArk Credential Provider and ASCP Implementation Guide.

   a. Ensure that CyberArk is configured to allow the MID Server to access the vault by creating an App-ID in CyberArk called `ServiceNow_MID_Server`.

   b. Make sure that every credential the MID Server needs is granted access to the `ServiceNow_MID_Server` App-ID.

   Note: You can override the default `ServiceNow_MID_Server` App-ID in the MID Server `config.xml` file using the `ext.cred.app_id` parameter. If you change the value in this parameter, make sure to configure a matching value in the vault.

2. Install the CyberArk Credential Provider, including the AIM API, on each machine that hosts a MID Server service that is used to access the credential store.


   a. In the CyberArk Password Safe, create the privileged accounts required by Discovery, Orchestration, or Service Mapping to access different devices and ensure that these accounts are members of the safes in which the necessary credentials are stored.

   b. Add the Credential Provider and application users as members of the Password Safes where the application passwords are stored.

Import the CyberArk JAR file

Import the CyberArk JavaPasswordSDK.jar file into the instance to make it accessible to the MID Server.

Before you begin

Role required: agent_admin or admin

Before starting this procedure, ensure that CyberArk is configured to allow the MID Server access to credentials. Ensure that the CyberArk AIM API is installed on each server hosting a MID Server that is used to access the vault.
About this task
Use this process even if the JavaPasswordSDK.jar file already exists on the MID Server.

Procedure
1. Navigate to MID Server > JAR Files.
2. Click New.
3. Complete the form using the fields in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique and descriptive name for identifying the file in the instance.</td>
</tr>
<tr>
<td>Version</td>
<td>Optional version number for the file, if one is available.</td>
</tr>
<tr>
<td>Source</td>
<td>Provider of the JAR file. Source information is not used by the system.</td>
</tr>
<tr>
<td>Description</td>
<td>Optional short description of the JAR file and its purpose in the instance.</td>
</tr>
</tbody>
</table>

4. Attach the JAR file to this record.
   The AIM JavaPasswordSDK.jar file comes with the AIM SDK installation files and is typically located on the MID Server in the AIM installation directory at <install_dir>/CyberArk/ApplicationPasswordSdk.

5. Click Submit.

6. Restart the MID Server service.
   The platform makes the JAR file available to any MID Server configured to communicate with the instance.

Configure the MID Server for CyberArk
Configure the config.xml file to grant the MID Server access to the CyberArk vault.

Before you begin
Role required: admin
Before starting this procedure, import the JavaPasswordSDK.jar file into the instance.
Procedure

Manually configure the MID Server `config.xml` file with these parameters. This configuration cannot be done from the instance.

### Required configuration parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>ext.cred.safe_folder</code></td>
<td>NameOfFolder</td>
<td>Folder to use for all credential lookups. For example, <code>root</code>.</td>
</tr>
<tr>
<td><code>ext.cred.use_cyberark</code></td>
<td><code>true</code></td>
<td>Boolean parameter indicating that this MID Server is integrated with CyberArk.</td>
</tr>
</tbody>
</table>

### Optional configuration parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>ext.cred.safe_timeout</code></td>
<td><code>5 (sec)</code></td>
<td>Timeout of each credential lookup in the vault, specified in seconds.</td>
</tr>
<tr>
<td><code>ext.cred.safe_name</code></td>
<td>NameOfSafe</td>
<td>Default safe name used for all credential lookups. If parameters are in multiple safes, the credential ID may be specified in the format <code>&lt;safeName&gt;:&lt;CredentialID&gt;</code>. When configured like this, the <code>NameOfSafe</code> field is ignored. If all external credentials have their credential IDs specified in this format, then leave out the <code>NameOfSafe</code> field.</td>
</tr>
<tr>
<td><code>ext.cred.app_id</code></td>
<td><code>ServiceNow_MID_Server</code></td>
<td>Specifies the App-ID used to grant permission to the MID Server to access the CyberArk vault. The default value, <code>ServiceNow_MID_Server</code>, must be</td>
</tr>
</tbody>
</table>

Note: By default the separator character in this format is a colon. To assign any character you want as a separator, add this line to the `CredMap.properties` file:

```
safe.cred.split.string=<string>
```

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| ext.cred.type_specifie     | true    | Forces an IP address lookup to return credentials that match both the CyberArk platform ID and the IP address. For example, if an IP address is shared by both Windows and Tomcat, a credential with a platform ID starting with **Win** returns the Windows credential only. When this parameter is set to true, CyberArk looks for platform IDs that begin with:
  - Win: Windows
  - Unix: SSH
  - VMWare: VMware |
| ext.cred.check_ssh_type    | false   | When set to true, requires that the type of SSH credential returned from CyberArk matches the type of credential requested. For example, if a normal SSH username/password credential is requested and only SSH keys are available, the credential lookup fails. |

**Configure CyberArk for SNMPv2 credentials**

If your system uses SNMPv2, you can create a special file to map the attribute in a credential to the community string.

**Before you begin**

Role required: admin

Before starting this procedure, configure the MID Server to have access to the CyberArk vault.
About this task

Note: If the community string appears in the password field of the CyberArk credential, it is not necessary to perform this procedure.

SNMPv2 is not natively supported in CyberArk. If your organization has created custom SNMPv2 credentials in which the community string does not appear in the password field of the credential, use this procedure to map the attribute in the credential to the community string.

Procedure
1. In a text editor, create a file called CredMap.properties, containing this code:
   ```plaintext
   SNMPv2.Community=attribute_name
   ```
2. Save the file to the /agent directory of your MID Server installation.
   On credential lookup, the MID Server attempts to find this attribute for the credential. If the attribute is not found, the MID Server then looks in the password field. If the password field is empty, the credential lookup fails.

Configure the CyberArk credential identifier
Create the unique key that CyberArk can use to identify specific credentials in the external repository.

Before you begin
Role required: admin
Before starting this procedure, ensure that the External Credential Storage plugin is activated, and the com.snc.use_external_credentials system property is set to true.

Procedure
1. Navigate to Discovery > Credentials or Orchestration > Credentials.
2. Click New.
3. From the list of credential types, select a type that supports CyberArk external storage.
4. Complete the form using the fields from your credential type.
5. Select the External credential store check box.
   The User name and Password fields are replaced with the Credential ID field.
   Note: If the check box is not visible, click the menu icon in the header bar and select View > External Storage.
6. In the Credential ID field, enter an expression using one of these formats:
If all your credentials are in the same safe, configure this safe name in the MID Server config.xml file using the ext.cred.safe_name parameter, and then specify the credential ID by name only, as <credential ID>.

To name credentials for a given platform that reside in a specific safe, define the credential ID as <safe>:<credential ID>:<platform ID>.

If your credentials are in multiple safes, specify the credential ID in this format: <safe>:<credential ID>.

If you want CyberArk to look up the credential by IP address, using an alternate safe, specify the credential ID in this format: <safe>:

If you want CyberArk to look up the credential for an alternate platform ID in the same safe, use this format: ::<platform ID>

If you want CyberArk to look up the credential in a configured safe by the IP address rather than the credential ID, leave this field blank. This is the best practice for handling installations in which each server has a unique credential. Without this type of lookup, you must create a credential ID record in your instance for every server in your environment.

Note: The credential ID must match the value in the Name field for the CyberArk account. The Credential ID field has a limit of 180 characters.

7. If you are storing SNMPv3 credentials in CyberArk and are using the privacy protocol and privacy key, configure the ID as follows:

   a. In the Credential Store Type field, select CyberArk.
      The Privacy Credential ID field appears.

   b. Enter the Name of the CyberArk SNMPv3 privacy account in the Privacy Credential ID field.

8. Click Submit.

Configure AWS credentials on a CyberArk vault

Configure your CyberArk vault with the AWS credentials to be retrieved for use by your instance.

About this task
Store the credentials as an SSH key on the CyberArk vault. When you configure access to the vault on your instance, the name you give to the SSH key must also be used as the credential ID.
Procedure

1. In CyberArk, go to Accounts > Add SSH Key.
2. Enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Type</td>
<td>Select Cloud Service.</td>
</tr>
<tr>
<td>Platform Name</td>
<td>Select Amazon Web Services - AWS - Access Keys.</td>
</tr>
<tr>
<td>AWS Access Key ID</td>
<td>Enter the AWS Access Key, as provided by AWS.</td>
</tr>
<tr>
<td>AWS IAM Username</td>
<td>Enter the AWS IAM Username, as you configured in CyberArk.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the AWS Secret Access Key, as provided by AWS.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a name for this key.</td>
</tr>
</tbody>
</table>

3. Choose Save.

What to do next
If you have not done so already, create a credential identifier on your instance to configure access to the CyberArk vault. For more details, see Configure access to external credential storage for AWS.

Configure Azure credentials on a CyberArk vault
Configure your CyberArk vault with the Azure credentials to be retrieved for use by your instance.

Before you begin
Role required: admin

About this task
To store an Azure credential, first create an Azure credential template in the CyberArk vault. This process only needs to be completed once for the vault.

Procedure

1. Log in to CyberArk in Administration mode.
2. Navigate to the Administration tab.
3. In **System Configuration**, edit **Platform Management**.

4. Navigate to **Cloud Provider Template** and duplicate it.

5. Edit the template for Azure credentials.

6. Add the following two properties:

   * **Name** as **Username** and **Display Name** as **Client ID**

   * **Name** as **Address** and **DisplayName** as **Tenant ID**

7. Apply the changes.

8. Navigate to the **Account** section and select **Add account**.

9. Select **Safe**.

10. Set the **Device Type** to **Cloud Service**.

11. Select the Azure template that was previously edited.

12. Fill in the information in for the **Client ID**, **Tenant ID**, and **Password** fields.

13. Select **Save**.

**External credential storage configuration**

Configure your instance to obtain credentials from a remote repository.

These procedures assume that you already have an external repository configured with the credentials you want to protect. The credential identifier configured in the ServiceNow instance must be mapped to the actual credential in the repository through the JAR file.

To configure External Credential Storage, complete the following tasks in order.

**Create a JAR file to resolve credentials**

Create a JAR file to resolve credential identifiers sent from the MID Server into actual credentials from the repository.

**About this task**

Make sure to include all the credential elements that the instance expects, such as the private key.

To create a JAR file to resolve credentials:

**Procedure**

Use either the templates provided on the ServiceNow github or the sample Java file.
a. Download the open source JAR files with instructions from the ServiceNow github:

- HashiCorp External Credential Resolver
- Thycotic External Credentials Resolver
- CyberArk External Credential Resolver

b. Use the following sample Java file as a template and modify it to suit your environment:

Example

```java
package com.snc.discovery;

import java.util.*;
import java.io.*;

/**
 * Basic implementation of a CredentialResolver that uses a properties file.
 */

public class CredentialResolver {

    private static String ENV_VAR = "CREDENTIAL_RESOLVER_FILE";
    private static String DEFAULT_PROP_FILE_PATH = "C:\dummycredentials.properties";

    // These are the permissible names of arguments passed INTO the resolve()
    // method.

    // the string identifier as configured on the ServiceNow instance...
    public static final String ARG_ID = "id";

    // a dotted-form string IPv4 address (like "10.22.231.12") of the target
    // system...
    public static final String ARG_IP = "ip";

    // the string type (ssh, snmp, etc.) of credential as configured on the
    // instance...
    public static final String ARG_TYPE = "type";
```
public static final String ARG_MID = "mid";

// These are the permissible names of values returned FROM the resolve() // method.

// the string user name for the credential, if needed...
public static final String VAL_USER = "user";

// the string password for the credential, if needed...
public static final String VAL_PSWD = "pswd";

// the string pass phrase for the credential if needed:
public static final String VAL_PASSPHRASE = "passphrase";

// the string private key for the credential, if needed...
public static final String VAL_PKEY = "pkey";

// the string authentication protocol for the credential, if needed...
public static final String VAL_AUTHPROTO = "authprotocol";

// the string authentication key for the credential, if needed...
public static final String VAL_AUTHKEY = "authkey";

// the string privacy protocol for the credential, if needed...
public static final String VAL_PRIVPROTO = "privprotocol";

// the string privacy key for the credential, if needed...
public static final String VAL_PRIVKEY = "privkey";

private Properties fProps;

public CredentialResolver() {
}

private void loadProps() {
    if(fProps == null)
        fProps = new Properties();

    try {
        String propFilePath = System.getenv(ENV_VAR);
        if(propFilePath == null) {
            // further handling...
        }
    }
}
System.err.println("Environment var "+ENV_VAR+" not found. Using default file: "+DEFAULT_PROP_FILE_PATH);
    propFilePath = DEFAULT_PROP_FILE_PATH;
}

File propFile = new File(propFilePath);
if(!propFile.exists() || !propFile.canRead()) {
    System.err.println("Can't open "+propFile.getAbsolutePath());
} else {
    InputStream propsIn = new FileInputStream(propFile);
    fProps.load(propsIn);
}

//fProps.load(CredentialResolver.class.getClassLoader().getResourceAsStream("dummycredentials.properties");
} catch (IOException e) {
    System.err.println("Problem loading credentials file: ");
    e.printStackTrace();
}

/**
 * Resolve a credential.
 */
public Map resolve(Map args) {
    loadProps();
    String id = (String) args.get(ARG_ID);
    String type = (String) args.get(ARG_TYPE);
    String keyPrefix = id+".\+type=";";

    if(id.equalsIgnoreCase("misbehave")
        throw new RuntimeException("I've been a baaaaaaaaad CredentialResolver!");

    // the resolved credential is returned in a HashMap...
    Map result = new HashMap();
    result.put(VAL_USER, fProps.get(keyPrefix + VAL_USER));
    result.put(VAL_PSWD, fProps.get(keyPrefix + VAL_PSWD));
    result.put(VAL_PKEY, fProps.get(keyPrefix + VAL_PKEY));
    result.put(VAL_PASSPHRASE, fProps.get(keyPrefix + VAL_PASSPHRASE));
    result.put(VAL_AUTHPROTO, fProps.get(keyPrefix + VAL_AUTHPROTO));
    result.put(VAL_AUTHKEY, fProps.get(keyPrefix + VAL_AUTHKEY));
    result.put(VAL_PRIVPROTO, fProps.get(keyPrefix + VAL_PRIVPROTO));
    result.put(VAL_PRIVKEY, fProps.get(keyPrefix + VAL_PRIVKEY));
System.err.println("Error while resolving credential id/type["+id+"/"+type+"]) 

return result; 
}

/** 
 * Return the API version supported by this class. 
 */ 
public String getVersion() { 
return "1.0"; 
}

public static void main(String[] args) { 
CredentialResolver obj = new CredentialResolver(); 
obj.loadProps(); 

System.err.println("I spy the following credentials: "); 
for(Object key: obj.fProps.keySet()) { 
 System.err.println(key+": "+obj.fProps.get(key)); 

}

}

Import a JAR file to resolve credentials
Import a JAR file created to resolve credential identifiers sent from the MID Server into actual credentials from the repository.

About this task
After you create the JAR file, import it into the instance, where it becomes accessible to the MID Server.

Procedure
1. After creating the JAR and properties files, copy the properties file to the MID Server. 
2. Navigate to MID Server > JAR Files. 
3. Click New. 
4. Complete the following fields:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique and descriptive name for identifying the file in the instance.</td>
</tr>
<tr>
<td>Version</td>
<td>A version number for the file, if one is available.</td>
</tr>
<tr>
<td>Source</td>
<td>Location of the JAR file for reference purposes. Source information is not used by the system.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of the JAR file and its purpose in the instance.</td>
</tr>
</tbody>
</table>

5. Click the paper clip icon in the banner and attach the JAR file to the record.

**Example**

![Attaching a JAR file](image)

6. Click **Submit**.

7. Restart the MID Server service.
   The platform makes the JAR file available to any MID Server configured to communicate with the instance.

Configure the credential identifier
Configure the credential identifier in the instance.

**Before you begin**
Role required: admin
Verify the following items:

- The **External Credential Storage** plugin must be active.
- The **Enable External Credential Storage** Discovery property is enabled.
Procedure

1. Navigate to Discovery > Credentials or Orchestration > Credentials.
2. Click New.
3. Select a credential type.
4. Select the External credential store check box.
   The User name and Password fields disappear, and the Credential ID field and Credential storage vault menu appear.
5. From the Credential storage vault menu, select either None, the CyberArk vault, or a custom external credential storage vault.

Note:
If CyberArk vault is selected, the Lookup key menu appears with four lookup key choices: Credential ID, Lookup key, FQDN, All of the above. Selecting All of the above can degrade performance because it requires accessing the vault multiple times.

a. To use a custom external credential storage vault, navigate to Vault Configurations [vault_configuration.list] in the instance.

b. Create a new record using a name associated an imported JAR file for a custom credential resolver.
   See the procedures Create a JAR file to resolve credentials and Import a JAR file to resolve credentials for information on creating a custom external credential storage vault.

6. Complete the Credentials form using the fields from the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
</tbody>
</table>
| Credential ID   | Enter the unique key configured for external credentials in the JAR file uploaded to the MID Server for an external credential system. This is the ID passed to the Java class in the parameter map:  
                  
                  public static final String ARG_ID = "id";                                                                                             |
<p>|                 | The MID Server uses this identifier to resolve the actual credentials on the repository.                                                    |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> This field is only visible when the <strong>External credential store</strong> check box is selected.</td>
<td><strong>Tag</strong></td>
</tr>
<tr>
<td><strong>Tag</strong></td>
<td><strong>External credential store</strong></td>
</tr>
<tr>
<td><strong>Credential storage vault</strong></td>
<td><strong>Apply to</strong></td>
</tr>
<tr>
<td><strong>Apply to</strong></td>
<td><strong>MID servers</strong></td>
</tr>
<tr>
<td><strong>Order</strong></td>
<td><strong>Order</strong></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Name</td>
<td>A unique and descriptive name for this credential. For example, Amazon Web Services.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use these credentials. The choices are All MID Servers or Specific MID Servers. If you select the latter, the MID Servers field appears.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to enable or disable the credential.</td>
</tr>
</tbody>
</table>

Configure the credential identifier for AWS

Configure your instance to obtain credentials from a remote repository.

Before you begin

Role required: cloud_admin

Verify that these plugins are active, and the MID Server has been installed:

- Discovery [com.snc.discovery]
- Cloud Provisioning and Governance [com.snc.cloud.mgmt]
- External Credential Storage [com.snc.discovery.external_credentials]

About this task

These procedures assume that you already have an external repository configured with the credentials you want to protect. The credential identifier configured in the ServiceNow instance must be mapped to the actual credential in the repository through the JAR file.

Procedure

1. Navigate to Discovery > Credentials.
2. Select a credential that your external credential storage provider supports.
3. Complete the form, using the fields from the table.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AWS Account</td>
<td>Enter your AWS account ID if your AWS credentials are on an external storage provider.</td>
</tr>
<tr>
<td>MID Servers</td>
<td>Select one or more MID Servers that can use these credentials.</td>
</tr>
<tr>
<td>Credential ID</td>
<td>Enter the Name under which this credential is stored in the external credential storage provider.</td>
</tr>
<tr>
<td>Privacy Credential ID</td>
<td>Enter the name of an SNMPv3 privacy key from CyberArk. This field is only visible for SNMPv3 when you select CyberArk from the Credential Store Type field. If you are not using a privacy key for CyberArk, leave this field empty.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Select an alias for this credential that contains specific behaviors. See Credential aliases for Discovery for more information.</td>
</tr>
<tr>
<td>External credential store</td>
<td>Select this check box to use an external credential storage system. When external storage is enabled, the Credential ID field appears. If this check box is not visible, click the menu icon in the header bar and select View &gt; External Storage from the context menu.</td>
</tr>
<tr>
<td>Credential Store Type</td>
<td>Select CyberArk only if you are using a CyberArk SNMPv3 privacy key. The Privacy Credential ID field appears to allow entry of the key.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Configure an authentication algorithm**

Configure an authentication algorithm so that you can sign outbound HTTP requests.

**Before you begin**
You should have a script include configured before you configure an authentication algorithm.
Role required: admin

**Procedure**

1. Navigate to **Credentials & Connections > Authentication Algorithms**, and click **New**.
2. On the form, fill in the fields.
The database selection in the **Format** field determines which fields are available.

### Authentication form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of this algorithm.</td>
</tr>
<tr>
<td>Algorithm</td>
<td>Outbound request type.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of what your algorithm does.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope that your application runs in.</td>
</tr>
<tr>
<td>Instance Authentication Script</td>
<td>Script that you select from the Script Includes table.</td>
</tr>
<tr>
<td>MID Authentication Script</td>
<td>Script that you select from the MID Server Script Includes [Discovery view] table.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

### Check IP service affinity for Discovery and Orchestration

You can check the IP Services table for a list of IP addresses that are associated with a protocol.

**Before you begin**

Role required: admin

**About this task**

The IP Services table maps a port to a protocol. Several mappings are provided by default for commonly used port-protocol combinations, such as port 80 for HTTP, port 22 for SSH, and port 161 for SNMP.

A system property called `glide.discovery.ip_service_affinity` allows Discovery to remember the last port of the IP address that was discovered. This property is set to **false** by default.

⚠️ **CAUTION:** You should not modify IP services unless your organization uses custom ports.
Procedure

1. Navigate to Discovery Definition > IP Services.
2. Filter the list to find the appropriate IP service.
3. Click the name of the service to go to that IP service page.
4. Click the IP Service Affinities tab for the list of IP addresses associated with that service.

IP Service Affinities

Data Certification

Data Certification manages scheduled and on-demand validations of the configuration management database (CMDB) data.

Information is added to the CMDB by Discovery, by importing from third-party tools, or manually. For regulatory or procedural reasons, information in the CMDB requires checks for accuracy and certification. The person or team responsible for certification can define what information requires verification and a verification schedule. The schedule then generates a checklist for verifying the data. Individuals assigned to certification tasks answer a series of questions to verify the data.

Data certification can be performed against specific fields on specific tables. Based on the certification schedule, certification tasks are automatically
created and assigned. For example, you can set up a certification to validate key information fields, such as Operating System and CPU count, on all Windows servers located in Chicago. You can then assign the tasks to the appropriate team member automatically.

Domain separated systems can use the Data Certification application.

Activate Data Certification

Activate the Data Certification plugin to access the application. Activating this plugin also activates the Version Management plugin, which manages certification filter versions.

**Before you begin**
Role required: admin

**Procedure**

1. Navigate to System Applications > All Available Applications > All.
2. Find the Data Certification plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   🌟 Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Installed With Data Certification**

Activating the Data Certification plugin installs the following components.

Demo data is available with Data Certification. The demo data provides information including filters, schedules, instances, and tasks.

**Tables**

Data Certification adds the following tables:
### Table Description

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certification Audit Definition [cert_audit_definition]</td>
<td>Stores collections of certification schedules that can be run as a single entity.</td>
</tr>
<tr>
<td>Certification Audit Definition Elements [m2m_cert_audit_def_cert_sched]</td>
<td>Lists the certification schedules in each certification audit definition.</td>
</tr>
<tr>
<td>Certification Audit Instance [cert_audit_instance]</td>
<td>Stores the certification instances associated with a specific audit definition.</td>
</tr>
<tr>
<td>Certification Element [cert_element]</td>
<td>Stores the data elements that are grouped into certification tasks.</td>
</tr>
<tr>
<td>Certification Filter [cert_filter]</td>
<td>Stores the data that requires certification using a filtering condition for the certification.</td>
</tr>
<tr>
<td>Certification Instance [cert_instance]</td>
<td>Stores a collection of certification tasks representing a single instance of a scheduled certification. This table extends the Audit [cert_audit] table.</td>
</tr>
<tr>
<td>Certification Schedule [cert_schedule]</td>
<td>Stores certification for a specific set of information on a specific table, what user or group the tasks are assigned to, and how often this certification is done.</td>
</tr>
</tbody>
</table>

### Script Includes

Data Certification adds the following script includes:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CertificationAjax</td>
<td>Provides utilities that enable individual certification elements to be certified, rejected, or reverted.</td>
</tr>
<tr>
<td>CertificationTaskCreate</td>
<td>Custom code that extends the standard code for certification tasks.</td>
</tr>
<tr>
<td>CertTaskEscalationTimerPercentage</td>
<td>Updates time and percentage complete information for a certification.</td>
</tr>
</tbody>
</table>
### Client Scripts
Data Certification adds the following client scripts:

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert If Boxes Checked</td>
<td>Certification Task [cert_task]</td>
<td>Provides a warning if the certifier attempts to leave a record without certifying the checked elements</td>
</tr>
<tr>
<td>Check Table Name</td>
<td>Certification Schedule [cert_schedule]</td>
<td>Updates the table name when a different filter is selected.</td>
</tr>
</tbody>
</table>

### UI Policies
Data Certification adds the following UI policies:

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide next scheduled run</td>
<td>Certification Schedule [cert_schedule]</td>
<td>Hides the Next Scheduled Run field when the schedule is set to run once or on demand only.</td>
</tr>
<tr>
<td>• Hide &quot;run&quot; associated fields when active is set to false</td>
<td>Certification Schedule [cert_schedule]</td>
<td>Hides the Run field when Active is set to False.</td>
</tr>
<tr>
<td>• Hide Run When Not Active</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Make table name read only</td>
<td>Certification Schedule [cert_schedule]</td>
<td>Makes the Table field read-only.</td>
</tr>
<tr>
<td>Hide Table field</td>
<td>Certification Element [cert_element]</td>
<td>Hides the Table field on the certification task form.</td>
</tr>
</tbody>
</table>
### Name | Table | Description
--- | --- | ---
Make percent complete field read only | Certification Instance [cert_instance] | Makes the Percent complete field read only when the State is Work in Progress, Closed Complete, Closed Incomplete, or Cancelled.
Show Assign to fields | Certification Schedule [cert_schedule] | Shows the Assign To field when the assignment type is User and hides the Assign To field for all other assignment types.
Show Group field | Certification Schedule [cert_schedule] | Shows the Assignment Group field when the assignment type is Group and hides the Assignment Group field for all other assignment types.
Show User field | Certification Schedule [cert_schedule] | Shows the User field when the assignment type is User.
Show Assignment Fields | Certification Schedule [cert_schedule] | Shows the Assign To Empty option when the assignment type is User Field or Group Field.

### Business Rules
Data Certification adds the following business rules:

### Name | Table | Description
--- | --- | ---
Adjust dates for cert tasks | Certification Instance [cert_instance] | Adjusts dates for tasks belonging to the certification instance when the dates are changed for an active certification.
Cancel Instance | Certification Instance [cert_instance] | Cancels all open certification tasks when an active certification is canceled.
certification audit instance events | Certification Audit Instance [cert_audit_instance] | Sends an inserted event when an active certification audit instance is created. Sends a completed event when an active certification audit instance is marked as complete or incomplete.
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>certification element events</td>
<td>Certification Element [cert_element]</td>
<td>Sends a failed event when an element of a certification is marked as failed.</td>
</tr>
<tr>
<td>certification instance events</td>
<td>Certification Instance [cert_instance]</td>
<td>Sends an inserted event when an instance of a certification is created. Sends a completed event when an instance of a certification is completed.</td>
</tr>
<tr>
<td>Certification Instance Rollup</td>
<td>Certification Task [cert_task]</td>
<td>Updates the Percent complete field on the certification instance record.</td>
</tr>
<tr>
<td>certification task events</td>
<td>Certification Task [cert_task]</td>
<td>Sends an inserted event when a task is inserted. Sends a completed event when a task is deactivated. Sends a canceled event when a task is canceled.</td>
</tr>
<tr>
<td>Certification Task Values</td>
<td>Certification Element [cert_element]</td>
<td>Updates the percent complete of the parent task when a certification element is updated.</td>
</tr>
<tr>
<td>Check Certification Audit Progress</td>
<td>Certification Instance [cert_instance]</td>
<td>Updates the completion status of the audit instance as a whole when a certification that is part of an audit is complete.</td>
</tr>
<tr>
<td>Clean Certification Views</td>
<td>Certification Instance [cert_instance]</td>
<td>Cleans all related records when a certification instance is deleted.</td>
</tr>
<tr>
<td>Copy certification schedule fields</td>
<td>Certification Instance [cert_instance]</td>
<td>Copies changes to the certification schedule to the certification instance.</td>
</tr>
<tr>
<td>Merge Certification Tasks</td>
<td>Certification Task [cert_task]</td>
<td>Merges two tasks together when a task is reassigned and there is another task for the same instance with the new user.</td>
</tr>
<tr>
<td>Prevent delete of Filter with Schedule</td>
<td>Certification Filter [cert_filter]</td>
<td>Prevents the deletion of a filter that is used in a schedule.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reassign Notification</td>
<td>Certification Task [cert_task]</td>
<td>Sends out a notification to the new and previous assignees when a task is reassigned.</td>
</tr>
<tr>
<td>Rollup State</td>
<td>Certification Task [cert_task]</td>
<td>Updates all necessary parent items when task state is changed.</td>
</tr>
<tr>
<td>Update audit reference</td>
<td>Certification Task [cert_task]</td>
<td>Makes Data Certification records compatible with Desired State records. This rule makes sure that the Audit field is correctly completed when a record is inserted using Insert and Stay.</td>
</tr>
<tr>
<td>Update audit result</td>
<td>Certification Element [cert_element]</td>
<td>Makes Data Certification records compatible with Desired State records for reporting purposes. This rule puts certified values in the Desired value column when an audit is Certified. It also puts actual values in the Discrepancy value column when an audit is Failed.</td>
</tr>
<tr>
<td>Update follow_on_task &amp; audit references</td>
<td>Certification Element [cert_element]</td>
<td>Makes Data Certification records compatible with Desired State records for reporting purposes. This rule makes certification tasks compatible with follow-on tasks and displays all tasks, regardless of origin.</td>
</tr>
<tr>
<td>Update next run time</td>
<td>Certification Schedule [cert_schedule]</td>
<td>Updates the Next scheduled run field when a schedule runs Daily, Weekly, Monthly, or Periodically.</td>
</tr>
<tr>
<td>Verify Fields</td>
<td>Certification Schedule [cert_schedule]</td>
<td>Verifies that no field is used in both Display and Certification fields when the fields of a certification schedule are changed.</td>
</tr>
</tbody>
</table>

**Formatter**

Data Certification adds the following formatter:
**Formatter**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certification Task Elements</td>
<td>Enables custom user interface formatting of elements on a certification task. For example, displays the green check mark and red exclamation point to use when certifying an element.</td>
</tr>
</tbody>
</table>

**Properties**

**Properties**

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.cert_task_activity.fields</td>
<td>System Properties [sys_properties]</td>
<td>Defines which journal field is the task activity field. Default: work_notes</td>
</tr>
</tbody>
</table>

**User Roles**

Data Certification adds the following user roles:

**User Roles**

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains Roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>certification_admin</td>
<td>certification</td>
<td>Can:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create and configure certifications</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Override provided answers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Perform certification tasks for certification task owners</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Send certification task notifications to users and owners at any time</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Cancel or delete certifications in any state</td>
</tr>
<tr>
<td>certification_filter_admin</td>
<td>certification</td>
<td>Can create and manage all data certification filters.</td>
</tr>
<tr>
<td>certification</td>
<td>none</td>
<td>Can update active or incomplete tasks assigned to them or to groups of which they are a member. Can also update configuration items owned by them or by groups of which they are a member.</td>
</tr>
</tbody>
</table>
User Roles (continued)

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains Roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>member. Receives email notifications when assigned certification tasks.</td>
</tr>
</tbody>
</table>

Events
Data Certification adds the following events. The ServiceNow system uses these events to send email notifications to task owners and managers about changes in certification records.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cert_audit_instance.completed</td>
<td>A certification audit instance has been completed.</td>
</tr>
<tr>
<td>cert_audit_instance.inserted</td>
<td>A certification audit instance has been inserted.</td>
</tr>
<tr>
<td>cert_element.failed</td>
<td>A certification element has failed certification.</td>
</tr>
<tr>
<td>cert_instance.complete</td>
<td>A certification instance has been completed.</td>
</tr>
<tr>
<td>cert_instance.inserted</td>
<td>A certification instance has been inserted.</td>
</tr>
<tr>
<td>cert_task.cancelled</td>
<td>A certification task has been canceled.</td>
</tr>
<tr>
<td>cert_task.completed</td>
<td>A certification task has been completed.</td>
</tr>
<tr>
<td>cert_task.escalate</td>
<td>A certification task record has been escalated.</td>
</tr>
<tr>
<td>cert_task.inserted</td>
<td>A new certification task has been created.</td>
</tr>
<tr>
<td>cert_task.notifications</td>
<td>A certification task notification has been resent to a user.</td>
</tr>
<tr>
<td>cert_task.overdue</td>
<td>A certification task is past its specified completion date.</td>
</tr>
<tr>
<td>cert_task.reassign</td>
<td>A certification task has been reassigned.</td>
</tr>
<tr>
<td>cert_task.warning</td>
<td>A new task escalation point has been reached.</td>
</tr>
</tbody>
</table>

Email Templates
Data Certification adds the following email templates:
<table>
<thead>
<tr>
<th>Name</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>certification.task.cancelled</td>
<td>A certification task assigned to you/your group as part of the data certification and management process has been canceled.</td>
</tr>
<tr>
<td>certification.task.reminder.inserted</td>
<td>A certification task that has been assigned to you/your group as part of the data certification and management process requires attention.</td>
</tr>
<tr>
<td>certification.task.reminder.outstanding</td>
<td>A certification task that has been assigned to you/your group as part of the data certification and management process requires attention.</td>
</tr>
<tr>
<td>certification.task.reminder.overdue</td>
<td>A certification task that has been assigned to you/your group as part of the data certification and management process is overdue.</td>
</tr>
</tbody>
</table>

**Certification schedules**

A certification schedule defines the information that requires certification and the frequency of execution.

At each time interval specified, or on-demand, the certification schedule generates a set of certification tasks based on set conditions. Use the Preview Certification Tasks related link to preview the certification tasks generated from a certification schedule.
Certification tasks

A certification task represents the work of verifying the data associated with a particular record.

Task owners are responsible for performing the certification tasks. Tasks have an associated workflow that sends reminders to the task owner and, if necessary, the manager of the owner at regular intervals.
Certification task

**Certification data for Certification Task TSK00009072**

UNIX Servers

- **All**
- **CPU speed (MHz)**
- **RAM (MB)**
- **CPU core count**

<table>
<thead>
<tr>
<th>CPU speed (MHz)</th>
<th>RAM (MB)</th>
<th>CPU core count</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.600</td>
<td>8.192</td>
<td></td>
</tr>
<tr>
<td>1.600</td>
<td>8.192</td>
<td></td>
</tr>
<tr>
<td>1.600</td>
<td>8.192</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** If the message

```
Record cannot be certified until the instance is finished creating all certification tasks and elements. Reload the page to try again
```

appears, it signifies that:

- A large amount of data is present in the cmdb_ci and cmdb_ci_server tables.
- Data certification task processing is not complete (Data Certification jobs are still in process).

As directed, reload the page and wait for the processing to complete.

**Clean up invalid elements**

Use the **Clean up invalid elements** UI action to query and delete certification elements that reference invalid records. Each certification task has a certification schedule, and each certification schedule has Table and Filter fields. When you use this UI action, it performs the following processing:
1. Collects all available records from Table field in the certification schedule with filters that are available in certification schedule.

2. Collects all certification elements associated with the current certification task.

3. Deletes the certification elements that are no longer available for the data collected in the previous step.

4. After deleting invalid records, it recomputes the certification completion percentage using the following formula:
   \[(1 - \text{(number of certification elements pending / total no of certification elements associated)}) \times 100;\]

5. If there are no certification elements with a Pending status, it marks the associated certification task as Closed, and deactivates it.

6. If there are remaining certification elements with a Pending status, it activates the associated certification task and changes its status to Work in Progress.

**Certification elements**

Each element of each record being certified is tracked in its own certification element record.

Also tracked are the date and time when the element was certified, comments, and the original and certified values of the field. You can view elements on individual certification tasks.
Certification elements

A certification instance is the collection of certification tasks for one execution of a certification schedule.
Certification audit instances

A certification audit instance is a collection of the certification instances and tasks generated by a single execution of the certification audit definition.

Certification audit definition

A certification audit definition is a collection of certification schedules that can be run at once.
Data Certification Overview module

The Data Certification Overview module displays various data certification-related reports on the Data Certification Console homepage.

The Overview module is a type of homepage.

The different levels of access are:

<table>
<thead>
<tr>
<th>Role</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>certification</td>
<td>View (view overview page and refresh reports)</td>
</tr>
<tr>
<td>certification_admin</td>
<td>• View (view overview page and refresh reports)</td>
</tr>
<tr>
<td></td>
<td>• Customize (refresh, add, delete, and rearrange reports)</td>
</tr>
<tr>
<td>admin</td>
<td>• View (view overview page and refresh reports)</td>
</tr>
<tr>
<td></td>
<td>• Customize (refresh, add, delete, and rearrange reports)</td>
</tr>
<tr>
<td></td>
<td>• Edit (can edit reports)</td>
</tr>
</tbody>
</table>

Data Certification Overview Module

The Overview module includes the following reports:

<table>
<thead>
<tr>
<th>Data Certification Overview Module Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>report</td>
</tr>
<tr>
<td>30/60/90 Day Aging</td>
</tr>
<tr>
<td>Certification Instances</td>
</tr>
<tr>
<td>Certification Progress Report</td>
</tr>
<tr>
<td>Certification Task Completed Report</td>
</tr>
</tbody>
</table>
### Data Certification Overview Module Description (continued)

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exceptions To Date</td>
<td>Lists all task elements that have comments added and a state of Failed or In Progress.</td>
<td>Certification Element</td>
</tr>
<tr>
<td>Functional Roll Up</td>
<td>Lists the managers that have groups with assigned certification tasks. The report is a horizontal bar chart, grouped by status, with each bar representing a manager of an assignment group.</td>
<td>Certification Task</td>
</tr>
<tr>
<td>Hierarchical Roll Up</td>
<td>Shows the managers that have employees with assigned certification tasks (task owners). The report is a horizontal bar chart, grouped by status, with each bar representing a manager of a task owner (identified in the Assigned to field).</td>
<td>Certification Task</td>
</tr>
<tr>
<td>Upcoming Schedules</td>
<td>Lists all schedules that are scheduled to run within the next 30 days.</td>
<td>Certification Schedule</td>
</tr>
</tbody>
</table>

### Related information

Use the Data Certification Overview module

### Use the Data Certification Overview module

View the status of data certification tasks.

### Procedure

1. Navigate to **Data Certification > Overview**.

2. Click elements within the reports to obtain more information.
   
   For example, click any of the colored bars in the **Functional Roll Up** bar chart and detailed information replaces the Data Certification Console screen.

3. Update some fields directly on the overview page.

   **Example:**
   
   For example, in the red box on the image shown, a certification schedule is being updated in the certification instances report.
Data certification overview module

Related reference
Data Certification Overview module

Data Certification planning
Initial planning can make the certification process more successful.

By defining certification schedules and certification audit definitions, users with the certification_admin role establish when certifications are performed, who performs it, and what data must be certified.

Required Roles
Users with the certification_admin role can view filter versions. These users can create, update, and delete filters, if they have the proper access to necessary tables. In the base ServiceNow system, certification_admin users have limited system rights and do not have access to all the tables required for creating a filter. When assigning compliance resources, make sure to grant additional roles to the certification_admin user as needed. For example, this user requires roles that grant access to these tables:
Planning Data Certification
Planning the data certification process requires defining:

- The certification schedule defines certification for a particular set of information on a particular table. It also generates certification tasks to perform that certification. One certification task is generated per task owner and a certification instance record groups the tasks.
- The optional certification audit definition groups some certification schedules to be performed together and generates certification audit instances to perform them.

The following questions require answers for each certification schedule:

- What information requires certification?
- When is the due date for certification?
- Who must perform the certification?

Create a certification filter
A filter is a subset of configuration items from any ServiceNow table that is created with a standard condition builder.

About this task
An example is a filter that selects all UNIX servers in the Australian data center.

With filters, you can:

- Create multiple versions of a filter and then select the version you want to use.
- Use one filter on multiple certification schedules.
- View the number of records that match your filter as you create the conditions.

⚠️ Note: Be sure to create certification filters before creating certification schedules.

Procedure
1. Navigate to Data Certification > Certification Filters.
2. Click New.
3. Fill in the form (see table).

4. Click **Submit**.
   This action saves the filter as version 1.

5. To create another filter version, modify the filter conditions and click **Update**.
   The system saves the new filter and increments the version number.

By default, the Certification Filters list shows only the current version of each filter. To see all filter versions, click **All** in the breadcrumbs.
6. To make an inactive filter the current version, open the inactive filter and click Revert. This action creates a new, active version of the filter and makes all previous versions inactive.

7. To delete a single filter version, open that version record and click Delete.

8. To delete inactive versions of a filter, click Delete inactive versions under Related Links in that filter record.

You cannot delete a filter that is used in a schedule definition. The system displays a warning and the filter is not deleted.
### Creating certification filters

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>[Required] Filter name.</td>
</tr>
<tr>
<td>Description</td>
<td>[Optional] Brief description of the filter.</td>
</tr>
<tr>
<td>Number</td>
<td>[Read-only] Automatically assigned filter identification number.</td>
</tr>
<tr>
<td>Table</td>
<td>Table containing the records to be filtered. Use of the Database View [sys_db_view] table is limited by version.</td>
</tr>
<tr>
<td>Active</td>
<td>Control to make the filter available for use from the Filter field on the Certification Schedule form.</td>
</tr>
<tr>
<td>Version</td>
<td>Current version of this filter. Any significant changes to the filter make the current version inactive. The system copies the updated filter, marks it as active, and increments the version number. The system saves all versions of the filter and makes them available to users. More than one version of a filter can be marked active.</td>
</tr>
<tr>
<td>Filter condition</td>
<td>Field, operator, and value to create the condition. The available options depend on the table selected. You can view the number of records that match the filter by clicking the refresh icon.</td>
</tr>
</tbody>
</table>

**Refresh Conditions**

If the filter does not match any records, the system marks the certification instance as **Closed Complete**, with the **Percent complete** value set to **100%**.

### Related information

**Data Certification planning**

**Define a certification schedule**

A certification schedule specifies the fields to display, the fields that require certification, certification task assignments, completion requirements for task owners, frequency of schedule, and detailed instructions.
About this task
Use the preview option to see what tasks are created before saving the schedule. If the tasks are not what you want, edit the schedule and preview the tasks again. The system creates certification tasks automatically when it executes a schedule.

To schedule a certification:

Procedure
1. Navigate to Data Certification > Schedule Definitions.
2. Click New
3. Fill in the fields (see table).
4. Click Submit.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A schedule name.</td>
</tr>
<tr>
<td>Filter</td>
<td>A certification filter for this schedule.</td>
</tr>
<tr>
<td>Table</td>
<td>[Read-only] The table holding the records to be certified. To change the table name, select a different Filter or create a new Filter.</td>
</tr>
<tr>
<td>Display fields</td>
<td>The fields displayed in the Certification Task list to provide context. These do not require certification themselves. For example, although users are not required to certify the Name field of a record, it displays so that users know what record they are certifying.</td>
</tr>
<tr>
<td>Certification fields</td>
<td>The fields to certify on this certification schedule.</td>
</tr>
<tr>
<td>Assignment type</td>
<td>A choice list to select how the certification schedule assigns the certification tasks.</td>
</tr>
<tr>
<td></td>
<td>• <strong>User Field:</strong> Select a user reference field on the table being certified. As an example, select the user named in the Managed by field to identify the user who performs the task. This selection displays the Assign to and Assign to empty fields. If the reference field on the record is empty, the value in the Assign to empty field is used.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Specific User:</strong> Select a specific user to perform the tasks. This selection displays the User field.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Group Field</strong>:</td>
<td>Select a group reference field on the table being certified. As an example, select the Support group field to identify the user who performs the task. This selection displays the <strong>Assign to group</strong> and <strong>Assign to empty</strong> fields. All members of the group from the reference field on the record are assigned to the tasks. If the reference field on the record is empty, the value in the <strong>Assign to empty</strong> field is used.</td>
</tr>
<tr>
<td><strong>Specific Group</strong>:</td>
<td>Select a specific group to perform the tasks. This selection displays the <strong>Group</strong> field. All members of the named group are assigned to the tasks.</td>
</tr>
<tr>
<td><strong>User</strong></td>
<td>This field appears when:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Assignment type</strong> is <strong>Specific User</strong>. This system assigns this user to all certification tasks for this schedule.</td>
</tr>
<tr>
<td></td>
<td>• The <strong>Assign to empty</strong> field is set to <strong>Create Assigned Task</strong>, and you have selected <strong>User Field</strong> as the assignment type. The system assigns this user to certification tasks containing unassigned records.</td>
</tr>
<tr>
<td></td>
<td>You can only select users with the certification role.</td>
</tr>
<tr>
<td><strong>Assign to group</strong></td>
<td>The group field that defines the group assigned to the certification tasks. This field is available only when the <strong>Assignment type</strong> is <strong>Group Field</strong>.</td>
</tr>
<tr>
<td><strong>Group</strong></td>
<td>The specific group to which certification tasks are assigned for this schedule. This field is available only when the <strong>Assignment type</strong> is <strong>Specific Group</strong>.</td>
</tr>
<tr>
<td><strong>Assign to</strong></td>
<td>The user field that defines which user is assigned to the certification task. This field is available only when the <strong>Assignment type</strong> is <strong>User Field</strong>.</td>
</tr>
<tr>
<td><strong>Assign to empty</strong></td>
<td>The behavior to use if the field selected in <strong>Assign to</strong> or <strong>Assign to group</strong> is blank on the record being certified. For example, if a task must be assigned to a manager, but no manager is identified, the value in this field determines what happens. This field appears only when the <strong>Assignment type</strong> is <strong>User Field</strong> or <strong>Group Field</strong>. The possible selections are:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Do Not Create Task</td>
<td>No task is created when the Assign to or Assign to group field is empty.</td>
</tr>
<tr>
<td>Create Unassigned Task</td>
<td>Create a task, but do not assign it to any user or group. The task can be manually assigned later.</td>
</tr>
<tr>
<td>Create Assigned Task</td>
<td>Create a task and assign it to the user or group specified. If you selected an assignment type of User Field, the User field is available. If you selected the Group Field type, the Group field is available.</td>
</tr>
</tbody>
</table>

The schedule automatically creates certification tasks for all records that do have "Assign to" populated, regardless of which selection you make for "Assign to empty."

<table>
<thead>
<tr>
<th>Days to complete</th>
<th>[Required] The number of days that task owners have to complete the certification tasks. When the certification schedule is part of a certification audit definition, the Days to Complete audit definition value overrides the value set for the certification schedule.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check box to activate this certification schedule, generating certification tasks at the scheduled date and time. Clear this check box to hide scheduling fields on the form (except Last run date) and not generate certification tasks.</td>
</tr>
<tr>
<td>Run</td>
<td>How often to run the schedule that generates certification tasks:</td>
</tr>
<tr>
<td></td>
<td>- Daily</td>
</tr>
<tr>
<td></td>
<td>- Weekly</td>
</tr>
<tr>
<td></td>
<td>- Monthly</td>
</tr>
<tr>
<td></td>
<td>- Periodically</td>
</tr>
<tr>
<td></td>
<td>- Once</td>
</tr>
<tr>
<td></td>
<td>- On Demand</td>
</tr>
<tr>
<td>Day</td>
<td>When Run is Weekly, the day of the week when the schedule runs and generates certification tasks.</td>
</tr>
<tr>
<td></td>
<td>When Run is Monthly, the day of the month the schedule runs and generates certification tasks. If the day is 29, 30 or 31, the certification runs on the last day of the month for shorter months.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Repeat Interval</td>
<td>When Run is Periodically, the frequency that the schedule runs to generate certification tasks, entered in time, days, or both. For example, set Days to 10 and Hours to 14:00:00 to run the schedule and generate certification tasks every 10 days at 14:00.</td>
</tr>
<tr>
<td>Starting</td>
<td>When Run is Periodically or Once, the date and time the schedule runs and generates certification tasks.</td>
</tr>
<tr>
<td>Time</td>
<td>When Run is Daily, Weekly, Monthly, or Once, the time of day, on a 24-hour clock, the schedule runs and generates certification tasks.</td>
</tr>
<tr>
<td>Last run date</td>
<td>[Read-only] The date and time that the schedule ran last, either on its regular schedule or manually, and generated certification tasks.</td>
</tr>
<tr>
<td>Next scheduled run</td>
<td>[Read-only] The next date and time the schedule runs and generates certification tasks.</td>
</tr>
<tr>
<td>Task Description</td>
<td>A description to add to the Short Description field of the certification task.</td>
</tr>
<tr>
<td>Instructions</td>
<td>An HTML field for providing instructions to the user or group performing the certification.</td>
</tr>
</tbody>
</table>

**Related information**

**Data Certification planning**

**Preview a certification task**

Previewing certification tasks saves any changes to the Certification Schedule form and displays the tasks that are created when you execute the certification schedule.

**About this task**

Previewing tasks is especially useful if you want to test different combinations of options in the Assignment type, Assign to, and Assign to empty fields.

**Procedure**

1. Navigate to Data Certification > Schedules > Schedule Definitions.
2. Click a certification schedule Name.
3. In Related Links, click Preview Certification Tasks. The tasks to be created appear at the top of the screen.

Certification info message

- 0 Servers
  One Certification Task would be created unassigned to certify 31 Servers
  One Certification Task would be created for Bow Ruggeri to certify 7 Servers
  One Certification Task would be created for Bud Richman to certify 1 Server
  One Certification Task would be created for David Loo to certify 1 Server

Related information

- Data Certification planning
- Define a certification schedule

Use a certification schedule notification

After you define a certification schedule, the system automatically sends notifications to specific users based on the information in the schedule.

About this task

The following notifications are sent automatically:

<table>
<thead>
<tr>
<th>Time elapsed to end date</th>
<th>Email template name</th>
<th>Notification message is sent to</th>
</tr>
</thead>
<tbody>
<tr>
<td>0% (when task is created)</td>
<td>certification.task.reminder.inserted</td>
<td>Task owner or assignment group, if specified</td>
</tr>
<tr>
<td>50%</td>
<td>certification.task.reminder.outstanding</td>
<td>Task owner or assignment group, if specified</td>
</tr>
<tr>
<td>75%</td>
<td>certification.task.reminder.outstanding</td>
<td>Task owner, assignment group, if specified, and manager of the task owner, if specified</td>
</tr>
<tr>
<td>95%</td>
<td>certification.task.reminder.outstanding</td>
<td>Task owner, assignment group, if specified, and</td>
</tr>
</tbody>
</table>
Certification Schedule Notifications (continued)

<table>
<thead>
<tr>
<th>Time elapsed to end date</th>
<th>Email template name</th>
<th>Notification message is sent to</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>manager of the task owner, if specified</td>
</tr>
<tr>
<td>100%</td>
<td>certification.task.reminder.overdue</td>
<td>Task owner, assignment group, if specified, and manager of the task owner, if specified</td>
</tr>
</tbody>
</table>

The email templates used in the notifications can be edited, for example, to change the email message text.

Executing a Certification Schedule

Executing a certification schedule generates certification tasks based on the schedule.

**Procedure**

1. Navigate to **Data Certification > Schedules > Schedule Definitions**.
2. Click a certification schedule **Name**.
3. Click **Execute Now**.

   The related lists **Certification Instances** and **Certification Tasks** display the instances or tasks generated by the schedule. The amount of time it takes to generate all certification tasks depends on the size of the table selected and how many fields require certification.
Define and create a certification audit

A certification audit is a collection of certification schedules that can be run as a single entity.

About this task

Certification audits can be useful when there are multiple certification schedules. After creating a certification audit definition, you can generate a certification audit instance. The certification audit instance is a collection of the certification instances and tasks generated by a single execution of the certification audit definition.

Procedure

1. Navigate to **Data Certification > Audits > Audit Definitions**.
2. Click **New**.
3. Fill in the fields (see table).
4. Right-click the header bar and select **Save**.
5. In the **Certification Schedules** related list, click **Edit**.
6. In the **Collection** list on the left, select one or more schedules and click **Add**.
7. Click **Save**.
8. In **Related Links**, click **Create Certification Audit Instance**. The system generates an audit instance based on the certification schedules selected. All audit instances based on this audit definition are listed in the **Certification Audit Instances** related list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the audit definition.</td>
</tr>
<tr>
<td>Days to Complete</td>
<td>The number of days that task owners have to complete the certification tasks created by this audit definition. Overrides the identical field on the certification schedule.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description of the intended audit.</td>
</tr>
</tbody>
</table>

Related information

Data Certification planning

Track a certification audit instance

You can view a list of all certification audit instances at any time.
Procedure

1. Navigate to Data Certification > Audits > Audit Instances.

2. View the Certification Instances related list.

   The list contains each of the associated instances generated as part of the audit.

Related information

Data Certification planning

Data certification performance

After the certification process has been planned, certification tasks can be performed according to defined schedules.

Users with the certification role can perform certification tasks. The certification tasks can be tracked as part of certification instances.

Related reference

Installed With Data Certification

Related information

Data Certification planning
Define a certification schedule

Fulfill certification tasks

After you execute a certification schedule manually or at a scheduled time, the ServiceNow system performs certain actions.

• Creates tasks for any records that meet the filter requirements in the specified table, like tasks from the Configuration Item \texttt{[cmdb\_ci]} table.

• Assigns the new tasks to the user or group identified in one of these certification schedule fields:
  
  ◦ Assign to
  ◦ User
  ◦ Assign to group
  ◦ Group

• Places the new tasks in the Work in Progress state.
• Adds the certification schedule *Short description* and *Assigned to* values to the corresponding fields on the certification task record.

• Adds the certification schedule *Days to complete* and *Complete by date* fields to the certification task record, based on when the task is created.

**Note:** If the certification filter does not match any CIs, the system sets the *State* to *Closed Complete* and the *Percent complete* to 100.

To view tasks assigned to you, navigate to **Data Certification > Tasks > My Tasks**.

The following information is tracked on the certification task record:

### Certification task record

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>An identification number for the certification task.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user responsible for certifying the data.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The group responsible for certifying the data.</td>
</tr>
<tr>
<td>Complete by</td>
<td>[Read-only] A date field containing a deadline for the task. This field is automatically filled in based on the <em>Days to Complete</em> field on the certification schedule.</td>
</tr>
<tr>
<td>State</td>
<td>[Read-only] The current state of the certification task. The selections are: Work in Progress, Closed Incomplete, Closed Complete, and Cancelled.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>The task progress as a percentage. This field is read-only when a task is in a Closed Incomplete, Closed Complete, or Cancelled state.</td>
</tr>
<tr>
<td>Escalation</td>
<td>[Read-only] The escalation level of the task. When 0–49% of the time to Complete By has elapsed, this field is set to Normal. At 50%, this field changes to Moderate and an email reminder is sent to the task owner. At 75%, this field changes to High and an email reminder are sent to the task owner and the manager of the task owner. At 95%, this field remains set to High, but a second email reminder is sent to the task owner and manager.</td>
</tr>
<tr>
<td>Short Description</td>
<td>A short description of the task. This field is automatically filled in with the text from the certification schedule of the Task description field.</td>
</tr>
</tbody>
</table>
Export the certification list

Users with the certification_admin role can export the certifications list and save the list in Excel, CSV, XML, or PDF format. This list is useful when you have a long list of certification elements or if many different users are assigned to certify elements on a single certification schedule.

**About this task**
For general information and common export steps, see [List export](#).

**Procedure**
1. Navigate to **Data Certification > Tasks > All Tasks**
2. Open a task.
3. Open any column context menu in the certification data list and complete the export.

Certify an element

The Certification Task form contains a list of all elements to be certified.

**About this task**

⚠️ **Note:** After you certify all the elements in a task, no elements can be reverted.

**Procedure**
1. Navigate to **Data Certification > Tasks > My Tasks**.
2. Open a certification task with a State of **Work in Progress**.
3. In the upper right corner of the list, select records that require certification for this task or all records that are part of this certification task.
4. Select the check box beside a certification element.

5. In *Optional comment for checked elements*, above the list, enter information that would be useful to others.

Certification list

<table>
<thead>
<tr>
<th>Certification list</th>
<th>Certifications required for Certification Task TSK0009065</th>
<th>Task</th>
<th>Server not at the designated location</th>
<th>Server &quot;applicationServerPeopleSoft&quot;</th>
<th>Server &quot;AS400&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6. Do:

- Click the green check mark to certify the element.
- Click the red exclamation point to fail the element.

7. To see the certified or failed element, set the view to *Show All Records*.

A green check mark or red exclamation mark appears beside the element.

8. Point to an icon to see any certification comments.
9. Ensure that all elements have the correct certification, either accepted or rejected.

After you certify all elements, no elements can be reverted. When all elements of a certification task are certified or rejected, the task State changes to Closed Complete.

View an audit result
View audit results after you certify the elements.

Procedure
1. Navigate to Data Certification > Schedules > Audit Results.

The list of data certification audit results appears, grouped by certification instances. Certified configuration items show the Original value only. Failed CIs contain the Certified value and the Original value.

2. Click the links in the list to open any of the related records.

Reset certifications
You cannot reset any element after all elements are certified.

• To reset individual certifications, right-click the element in the certification list and select Revert Certification.

• To reset the entire task to its starting point, click the Reset all Certifications to Pending related link.
Track a task with a certification instance

The Certification Tasks related list on the certification instance record provides information about associated tasks.

**About this task**

The *State* field on the certification instance record is read-only and is based on the cumulative states of the certification tasks associated with the instance. The *Percent complete* column allows users with the certification_admin role to track task progress quickly. For more information, see Track Certification Tasks.

To track a certification instance:

**Procedure**

1. Navigate to **Data Certification > Schedules > Instances**.
2. Click a certification instance *Number*.
3. View and edit the following fields as necessary.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>[Read-only] Automatically generated identification number for the instance.</td>
</tr>
<tr>
<td>Certification Schedule</td>
<td>The certification schedule used to create the certification instance.</td>
</tr>
<tr>
<td>State</td>
<td>[Read-only] Current state of the certification instance: Work in Progress, Complete, Closed Incomplete, or Cancelled. For more information, see Track Certification Tasks.</td>
</tr>
<tr>
<td>Created</td>
<td>[Read-only] Date and time the certification instance was created. Date is filled in automatically when the Execute Now button clicks the associated certification schedule.</td>
</tr>
<tr>
<td>Complete by</td>
<td>[Required] Date and time when the certification instance must be completed. The system updates this field when it executes the schedule, using the deadline specified on the instance. All certification tasks associated with the certification instance must be marked Complete, Closed Incomplete, or Cancelled before the instance is complete.</td>
</tr>
</tbody>
</table>
### Cancel a certification instance

Users with the certification_admin role can cancel a certification instance.

**About this task**

The instance must have a State of Work in Progress. Canceling a certification instance:

- Changes the certification instance State to Cancelled.
- Changes all associated Work in Progress certification tasks to Cancelled.

To cancel a certification instance:

**Procedure**

1. Navigate to Data Certification > Schedules > Instances.
2. Click a certification instance Number.
3. Click Cancel.

### Track a certification task

Use the certification task state to track the progress of a task.

**About this task**

The available task states are Work in Progress, Closed Complete, Closed Incomplete, and Cancelled.

When the state of a certification task changes, the certification instance state also changes in the following cases:
If any certification task is in Work in Progress state, the certification instance is placed in Work in Progress state.

If all certification tasks are in Cancelled state, the certification instance is placed in Cancelled state.

If all certification tasks are in Cancelled or Closed Complete state, the instance is placed in a Closed Complete state. For example, if three certification tasks are Cancelled, and one task is Closed Complete, the instance state is changed to Closed Complete.

When one certification task is Closed Incomplete and the remainder of the tasks are Cancelled or Closed Complete, the instance is placed in Closed Incomplete.

To view the state of certification tasks:

**Procedure**

1. Navigate to Data Certification > Tasks and select My Tasks or All Tasks.
2. View the State column for each task.

**Escalate a certification task**

Users with the certification_admin role can escalate a task in the Work in Progress state. To escalate a task, the task owner identified in the Assigned to field on the task record must have an associated manager.

**About this task**

Personalize the User form to see the Manager field.

Escalating a task:

- Sends an email message to the task owner and the manager of the task owner stating that the task has been escalated.
- Sets the manager as the new task owner.

The event that triggers the escalation is named cert_task.escalate and the email notification is named Escalation Notification. To edit the text of the email message that is sent, edit the Escalation Notification email notification directly.

For more information, see Email notifications.

To escalate a certification task from the Certification Task form:
Procedure
1. Navigate to Data Certification > Tasks > All Tasks.
2. Click a certification task Number.
3. Click Escalate. If the Escalate button is not available, the user in the Assigned to field does not have an associated Manager.

**Escalate a certification task from the certification task list**
Escalate a certification task to notify the manager of the current task owner.

**Before you begin**
To escalate a task, the task owner identified in the Assigned to field on the task record must have an associated manager.

Procedure
1. Navigate to Data Certification > Tasks > All Tasks.
2. Select the check box to the left of a certification task Number. Multiple check boxes can be selected.
3. From the Actions on Selected Rows menu below the list, select Escalate. If the Escalate button is not available, the user in the Assigned to field does not have an associated Manager. Select multiple tasks from the list. The menu option shows how many tasks are not eligible for escalation, such as Escalate (4 of 6).

**Reassign a certification task**
If you have the certification_admin role, you can reassign any certification task in the Work in Progress state. Tasks in Closed Complete, Closed Incomplete, or Cancelled state cannot be reassigned. When a task is reassigned, the current task owner and the new task owner are sent a message.

**Before you begin**
Role required: certification_admin

**About this task**
The event associated with the reassignment is named cert_task.reassign and the email notification is named Certification Task Reassignment. To edit the text of the email message that is sent, edit the Certification Task Reassignment email notification directly.

For more information, see Email notifications.
To reassign a certification task:

**Procedure**

1. Navigate to Data Certification > Tasks > All Tasks.
2. Click a certification task Number.
3. Enter a new name in the Assigned to field.

**Send certification task reminders**

The Certification Task Escalations workflow sends automatic email reminders.

The Certification Task Escalations workflow sends automatic email reminders to the:

- Certification task owner.
- Assignment group, if the assignment group was specified on the Certification Task form.
- Manager of the certification task owner, if necessary and if a manager was specified on the User form.

The reminders are based on the Complete by field on the certification task record. If the Complete by date is changed, the reminder schedule automatically adjusts to reflect the new date.

**Certification task reminders**

<table>
<thead>
<tr>
<th>Time elapsed to end date</th>
<th>Email reminder is sent to</th>
<th>Escalate field on task record reads</th>
</tr>
</thead>
<tbody>
<tr>
<td>50%</td>
<td>task owner and assignment group (if specified)</td>
<td>Moderate</td>
</tr>
<tr>
<td>75%</td>
<td>task owner, assignment group, and manager of the task owner</td>
<td>High</td>
</tr>
<tr>
<td>95%</td>
<td>task owner, assignment group, and manager of the task owner</td>
<td>High</td>
</tr>
<tr>
<td>100%</td>
<td>task owner, assignment group, and manager of the task owner</td>
<td>High</td>
</tr>
</tbody>
</table>
To set reminders for different or more intervals, edit the workflow Certification Task Escalations. In addition to the email reminders sent automatically, users with the certification_admin role can send email reminders manually at any time.

**Send an email reminder from the certification task form**

How to manually send email reminders from the Certification Task form.

**Procedure**

1. Navigate to Data Certification > Tasks > All Tasks.
2. Click a certification task Number.
3. Right-click the header bar and select Resend email notifications.

**Send an email reminder from the certification task list**

How to manually send email reminders from the Certification Task list.

**Procedure**

1. Navigate to Data Certification > Tasks > All Tasks.
2. Select the check box to the left of a certification task Number. Multiple check boxes can be selected.
3. From the Actions on Selected Rows menu below the list, select Resend email notifications. Select multiple tasks from the list. The menu option shows how many notifications are outstanding and how many were sent, such as Resend email notifications (15 of 18).

**Mark a certification task as closed incomplete**

Mark a task as closed incomplete if, for example, only some of the elements can be certified.

**About this task**

The following users can mark a task as closed incomplete:

- Users with the certification_admin role.
- User identified in the Assigned to field on the certification task record.

To mark a task as closed incomplete:
Procedure

1. Navigate to Data Certification > Tasks and select All Tasks, or My Tasks.
2. Click a certification task Number.
3. In Work Notes, enter information about why the task could not be completed.
4. Click Close Incomplete.

If at least one task on a certification instance is marked Closed Incomplete, the Completed date and Percent complete fields on the certification instance record are not updated. A user with the certification_admin role can:
- Complete the incomplete task or tasks.
- Cancel the incomplete task or tasks.

When all tasks on the certification instance are Closed Complete or Cancelled:
- The system sets the Completed date field on the certification instance record to the current date and time.
- The Percent complete field on the certification instance record is set to 100 percent.

Certification tasks cancellation

Users with the certification_admin role can cancel a certification task in the Work in Progress or Closed Incomplete state.

When a certification task is cancelled, a notification email is sent to the task owner or assignment group assigned to the task. The task owner or assignment group manager is not notified.

Cancel an individual task

Cancel a particular data certification tasks in the Work in Progress state.

Procedure

1. Navigate to Data Certification > Tasks > All Tasks.
2. Find a task with a State of Work in Progress.
3. Click the task Number.
4. Click Cancel.
Cancel all tasks in an instance
Cancel data certification tasks in the Work in Progress state.

Procedure
1. Navigate to Data Certification > Schedules > Instances.
2. Find an instance with a State of Work in Progress.
3. Click the instance Number.
4. Click Cancel.

All tasks in the instance with a state of Work in Progress are cancelled. The task owner or assignment group is notified.

The email template used for the notification is named certification.task.cancelled. The email templates can be edited to change the email message text, for example.

Domain separation and Data Certification
Domain separation is supported in Data Certification processing. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Basic
• Business logic: Ensure data goes into the proper domain for the application’s service provider use cases.
• In the application, the user interface, cache keys, reporting, rollups, aggregations, and so on, all consider domain at production run time.
• The owner of the instance needs to be able to set up the application to function normally across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see my response.

How domain separation works in Data Certification
• Data Certification has only basic domain separation. As long as the Certification Instances (CIs) or records that must be certified are correctly domain-separated and the users who must certify the CIs or records are in a domain that can view the data, Data Certification works as expected.
• Recommendation: The instance owner must be responsible for assigning Certification Tasks and Certification Instances to the correct domain. Changing the domain for these records does not change functionality, but limits the view of the records.

How to set up domain separation for Data Certification

After enabling the Domain Separation plugin, there are no additional steps required to set up domain separation for Data Certification.

• instance owners determine which CIs or records that need to be certified can be domain-separated.
• Customers can configure a domain-separated environment by assigning tasks to a domain, but if the data is already domain-separated, then only users with the right domain permissions can view the data in a certification task.

How tenant domains manage their own application data

It's not necessary to set the domain on the certification tables but it can be done if the instance owner should want that. As long as the CI’s or records that must be certified are domain-separated, users with the correct domain permissions can view them.

Domain-separated tables

• cert_instance – Changing the domain on this table does not change any functionality, nor does it change the domains of the tasks created from the table.
• cert_task – Changing the domain on this table changes the domain viewing permissions of the task.
• cert_element – It is not recommended to change the domain on these records. As long as the CIs or records to be certified are already domain-separated, cert_element records will reflect that.
• cert_filter – Changing the domain on this table changes the domain viewing and filtering of CIs or records.

Use cases

Instance owners who have multiple clients that certify the infrastructure they own can assign domains to those CIs and the Certification Tasks to restrict the view from one client to another.

Related information

Domain separation for service providers
Decision Tables

Use decision tables to help you resolve a complex decision that depends on multiple factors.

Use decisions tables to help you reach outcomes that depend on multiple factors. In these tables, each factor is a decision input. For example, if you are trying to make a decision about car insurance coverage, your inputs might include the location where the insured person lives, the age and accident history of the insured person, the car make, the car model, and the car year. This logic can save time and present a more organized, readable format than using a script. Decision tables provide a single point where you can create, view, and modify decisions.

To interact with Decision Tables in script, use the Decision Table API.

Components of a decision

- **Decision Table [sys_decision] records**
  Decision table records represent a single decision. In this record, you specify which table you want to use for your answers. This record also contains related lists where you can create your decision inputs and decisions.

- **Decision inputs [sys_decision_input] records**
  Decision input records represent your inputs that are used to obtain answers in a decision. These inputs can include a variety of types, including strings, references, true/false inputs, and dates. Each decision input has a specified input type and can be assigned a default value.

- **Decision [sys_decision_question] records**
  Each decision record represents a decision that is based on your inputs. Use the condition builder on the decision record form to create a condition that is based on the inputs for this decision. Then, you can select an answer record for this decision. The answer record can be any record from the table that you have defined in the Decision Table record. You can select the same answer record for more than one decision.

- **Answer records**
  Answer records represent answers that are reached using different decision input values. Answers records can be records on any table, but you need to choose the table when creating your Decision Table record. You could, for example, use the sys_choice table to use existing choice records. From the example about insurance
coverage, you could create a table where each record contains details about the levels of insurance coverage.

**Example: Use a decision table to determine a discount rate**

The following example shows a decision table. In this example, you see two inputs, Units Ordered and Cash on Delivery. The two possible answers, Yes and No, are reached depending on the answers to the two questions. For example, a customer would qualify for a silver discount when ordering more than 50 items or paying in cash, and get a gold discount if doing both.

**Sample decision table — discount rates**

<table>
<thead>
<tr>
<th>Decision inputs</th>
<th>Decision input entries</th>
</tr>
</thead>
<tbody>
<tr>
<td>More than 50 units ordered</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Cash on delivery</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>No</td>
</tr>
</tbody>
</table>

**Decision Answers**

<table>
<thead>
<tr>
<th>Discount</th>
<th>Silver Discount</th>
<th>Bronze discount</th>
<th>Gold discount</th>
<th>Silver discount</th>
</tr>
</thead>
</table>

**Create a decision table to resolve complex decisions**

Create a decision table to help you resolve a complex decision that depends on multiple factors.

**Before you begin**

Role required: decision_table_admin

**Procedure**

1. Create or select a table to use for your decision answer records. You will associate an answer record to each decision on your decision table in later steps. This answer record is returned when that decision is reached based on your inputs. For information on creating a table, see Create a table.

2. Ensure that one field on the table that you use for your decision records has been set as the display value. This field is used as a label when you display decision answers in Flow Designer.

   You can use an existing table or create a new table to use for your decision records.

3. Create a record on this table to each answer in your decision.
If you have modified an existing table, you may need to customize the form to show the new fields that you have added.

4. Create a decision table record.

   a. Navigate to System Definition > Decision Tables, and click New.

   b. On the form, fill in the fields.

     **Decision Table form**

     | Field            | Description                                                                 |
     |------------------|------------------------------------------------------------------------------|
     | Name             | Descriptive label for this decision.                                        |
     | Application      | Application scope of this decision. This field defaults to the current scope.|
     | Answer table     | Table that this decision uses for answer records. Select the table that you created in the previous steps. |
     | Accessible From  | Option to limit the availability of this decision to the current scope. Select All application scopes or This application scope only. |

   c. Right-click the form header and select Save. The form refreshes with the Decision Inputs and Decisions related lists.

5. Create decision input records.

   a. In the Decision Inputs related list, click New.

   b. On the decision input form, fill in the fields.

     **Decision Input form**

<pre><code> | Field | Description                                                                 |
 |-------|------------------------------------------------------------------------------|
 | Name  | Name of the decision that is associated to this decision input. This field is automatically populated. |
</code></pre>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Application scope of this decision input. This field defaults to the current scope.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of data that is used for this input. When you use this decision in a flow, you can only use data pills that match this type.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate this input. This field is selected by default.</td>
</tr>
<tr>
<td>Label</td>
<td>Descriptive label for this input.</td>
</tr>
<tr>
<td>Read only</td>
<td>Check box to make this decision input read-only.</td>
</tr>
<tr>
<td>Column name</td>
<td>Column name for this input. This field is automatically populated when you give the Label field a value.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Check box to make this decision input mandatory.</td>
</tr>
<tr>
<td>Display</td>
<td>Check box to indicates that this decision input is the display value for reference fields.</td>
</tr>
<tr>
<td>Choice</td>
<td>Select a method for users to see a list of suggested values:</td>
</tr>
<tr>
<td></td>
<td>• List menu without -- None --</td>
</tr>
<tr>
<td></td>
<td>• List menu with -- None --</td>
</tr>
<tr>
<td></td>
<td>• Suggestion field type</td>
</tr>
<tr>
<td></td>
<td>If a choice is used, define your choices in the Choices related list at the bottom of the form.</td>
</tr>
<tr>
<td>Default Value</td>
<td>Default value for this input.</td>
</tr>
</tbody>
</table>

**c. Click **Submit.  
Your changes are saved and the decision table record reopens.

**6. Create decision records.**
a. In the Decisions related list, click **New**.

b. On the Decision form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Descriptive label for this decision table.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of this decision. This field defaults to the current scope.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the flow evaluates decisions. The order can be important in flows that use the First decision that matches option and ends after the first match is found.</td>
</tr>
<tr>
<td>Answer</td>
<td>Answer that is used when the conditions in this decision are met.</td>
</tr>
<tr>
<td>Default Answer</td>
<td>Check box to enable this decision as the default for your decision table.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions that are needed to reach this decision. The fields available for your condition are the Decision inputs that are associated with this decision table.</td>
</tr>
</tbody>
</table>

c. Click **Submit**.  
Your changes are saved and the decision table record reopens.

**What to do next**  
With Flow Designer, you can add your decision to the **Make a decision** flow logic. For more information about the **Make a decision** flow logic, see **Make a decision flow logic**.
Decision table properties

Use decision table properties to set limits on the maximum number of allowed inputs and questions for decision records.

These properties are available for decision tables.

Note: To open the System Properties [sys_properties] table, enter `sys_properties.list` in the navigation filter.

Properties for decision tables

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| com.glide.decision_table.max_inputs | Maximum number of decision inputs that can be defined on a model (sys_decision) record.  
• Type: integer  
• Default value: Empty. There are no limits on inputs when this property is left empty.  
• Location: System Property [sys_properties] table |
| com.glide.decision_table.max_questions | Maximum number of decision questions that can be defined on a decision table (sys_decision) record.  
• Type: integer  
• Default value: Empty. There are no limits on inputs when this property is left empty.  
• Location: System Property [sys_properties] table |

Document Services

Document Services provides a broad range of services related to document management, creation, maintenance, and conversion, and integrating with third parties such as Microsoft SharePoint.

Document Services offerings

Document Management
Manage large numbers of documents efficiently. Document Management provides storage space and a tracking system to easily upload, retrieve and delete documents.

**Document Viewer**

View documents directly in the Now Platform rather than having to download them. Document Viewer supports viewing various file types in the platform. The maximum document file size is 50 MB. To use Document Viewer, enable it at the instance level and the tables with which you want to use it.

**Managed Documents**

Control electronic documents within your instance. After parameters have been set by the administrator and the Knowledge Document plugin installed, documents move through the managed document cycle.

<table>
<thead>
<tr>
<th>Document generation apps</th>
<th>Explore</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td>• PDFGenerationAPI API</td>
<td>• Upgrade to Rome</td>
<td>• Ask or answer questions in the Platform community</td>
</tr>
<tr>
<td>• Document API</td>
<td>• Document Services Release Notes</td>
<td>• Search the Known Error Portal for known error articles</td>
</tr>
<tr>
<td>• ServiceNow Plugins:</td>
<td>• Developer training</td>
<td>• Contact Customer Service and Support</td>
</tr>
<tr>
<td>◦ Microsoft OneDrive Spoke</td>
<td></td>
<td></td>
</tr>
<tr>
<td>◦ Microsoft OneDrive document service Spoke</td>
<td></td>
<td></td>
</tr>
<tr>
<td>◦ Microsoft Azure AD Spoke for IntegrationHub</td>
<td></td>
<td></td>
</tr>
<tr>
<td>◦ Multi Provider Document Service Framework</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Document Management**

With the ServiceNow Document Management application you can manage large numbers of documents efficiently. Document Management provides storage space and a tracking system to easily upload, retrieve and delete documents.

**Overview**

With Document Management you can create documents and track them, uploading and annotating the documents throughout the lifecycle of the workflow.
Service providers need to collect and manage many documents for each customer case. When customers want to include additional information on their documents, they can create an overview checklist and upload the documents accordingly. For example, when customers submit documents such as loan, policy, or student applications, the submission form can have a checklist of action items and user interface commands. These features make it easier to add comments and note and track the status of the submission.

Action items might include phases of a workflow such as Uploaded, Reviewed, Filed, Rejected and so on. There are also additional UI action options that ServiceNow admins and customers can configure.

The Document Management plugin

The Document Management plugin (com.snc.platform_document_management) can be installed by the System administrator. You can then search for Documents in the filter navigator and then select Documents. Using the Documents tab you can create Documents and create Versions under them. This is an independent plugin with no dependencies on any existing plugins.

Related information

Document Management plugin

Document Management plugin

With the Document Management plugin (com.snc.platform_document_management), you can create documents and then track each version of those documents. Search for “Documents” in the filter navigator and then select Documents with the Documents tab. The plugin is independent, with no dependencies on existing plugins. The plugin has been built on the existing sys_attachment framework.

Overview

When customers want to include additional information on their documents, they can create an overview checklist and upload the documents accordingly. For example, when customers submit documents such as loan, policy, or student applications, the submission form can have a checklist of action items and user interface commands that make it easier to add comments and note and track the status of the submission.

There are a total of four roles assigned by the system admin used to maintain the lifecycle of documents:
• platform_document_management_admin – Storage application features: create, read, update and delete.

• platform_document_management_delete – Delete operation in documents and its related tables.

• platform_document_management_reader – Read access in documents and related tables.

• platform_document_management_writer – Write access on documents and related tables.

The system admin installs the plugin and then assigns users with one of these roles.

**Tables**
The following tables are contained within the plugin:

• ds_document

• ds_document_version

• ds_document_lists

• ds_document_list_entry

• ds_document_references

**Document Viewer**

Document Viewer enables you to view documents directly in the Now Platform rather than having to download them.

Document Viewer supports viewing various file types in the platform. The maximum document file size is 50 MB. To use Document Viewer, enable it at instance level and for the tables for which you want to use it.

⚠  **Note:** Document Viewer now supports FedRAMP instances.

You can view the following file types:

• MS Word (.doc) and (.docx)

• MS PowerPoint (.ppt) and (pptx)

• MS Excel (.xls) and (.xlsx)

• PDF

• PNG

• JPEG
Other document types, for example, .zip or .exe files, are automatically downloaded without requiring Document Viewer.

**PDF view in Document Viewer**

The following table describes the icons used in Document Viewer.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="folder.png" alt="Folder" /></td>
<td>Toggle the sidebar to see a preview of all the pages in the document.</td>
</tr>
<tr>
<td><img src="download.png" alt="Download" /></td>
<td>Download the attachment.</td>
</tr>
<tr>
<td><img src="arrow-up-down.png" alt="UpDown" /></td>
<td>Page up or down using the arrow buttons. You can also scroll or use your keyboard arrow keys.</td>
</tr>
</tbody>
</table>
Icons in Document Viewer (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Rotate right" /></td>
<td>Rotate the page to the right.</td>
</tr>
<tr>
<td><img src="image" alt="Rotate left" /></td>
<td>Rotate the page to the left.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom" /></td>
<td>Zoom in or out of the document.</td>
</tr>
<tr>
<td><img src="image" alt="Full width" /></td>
<td>Increase the page to the full width of Document Viewer.</td>
</tr>
<tr>
<td><img src="image" alt="Search" /></td>
<td>Search for keywords in the document. Use the arrows to toggle to the next search result.</td>
</tr>
</tbody>
</table>

Related information

View attachments with Document Viewer
Enable Document Viewer

Enable Document Viewer

Enable Document Viewer to view documents directly rather than download them to view them in their native applications.

Before you begin
Role required: admin

About this task
Document Viewer is enabled by default. Activate it at the instance level and then enable it at the table level for the tables where you want to use it. Ensure that the system property `com.snc.documentviewer.enable_document_viewer` is set to true or create it if it does not already exist. To de-activate Document Viewer, create the system
property `com.snc.documentviewer.enable_document_viewer` manually and set it to false.

**Procedure**

1. Activate Document Viewer at the instance level
   a. Navigate to **System Definition → Plugin**.
   b. Enter **Document Viewer** in the Search field.
   c. Click **Install**

2. Activate **Document Viewer** for the tables where you want to use it.
   a. Navigate to **System Definition → Dictionary**.
   b. Open the table **Collection** record to update.
   c. Enter `use_document_viewer=true` in the **Attribute** field.

Document Viewer is enabled at the table level. Repeat this procedure for each table for which you want to enable Document Viewer.

**Related information**

- **Disable Document Viewer**

**Document Viewer plugins**

With Document Viewer, you can view documents directly in the ServiceNow Platform rather than having to download them. Two new plugins enhance the experience and provide more options for document viewing. You can collaborate with other people, copy, delete, restore, and view version history directly in a ServiceNow instance.

**Overview**

In previous ServiceNow releases, not all documents could be shared and used for team collaboration. With new plugins for the Platform Document Viewer, now you can:

- Collaborate (edit, share) with Microsoft OneDrive and copy documents to your ServiceNow instance.
- Upload a policy document authored in your ServiceNow instance as a Microsoft Office 365 document in Microsoft Office 365 SharePoint.
- Attach shared links to a record. Clicking the link opens the document in Microsoft Office 365 SharePoint.
• The link can be shared with a co-worker, who can view and edit the document in real time.
  ◦ The current version is also viewable in the ServiceNow instance.
• Use collaboration tools such as Microsoft Office 365 for review and co-authoring documents.

Plugins
To use this feature, install the following plugins:
• Microsoft OneDrive Spoke
• Microsoft OneDrive document service Spoke
• Microsoft Azure AD Spoke for IntegrationHub
• Multi Provider Document Service Framework

See List of plugins (Rome) for a complete list of ServiceNow plugins.

After installation, you can use the base system subflows or customize them. Configure the subflows in the Document actions table. Once configured, they can be invoked as UI actions from List views or can be invoked through Script Include APIs.

Microsoft OneDrive integration plugin
Collaborate in Microsoft OneDrive and perform copy, delete, restore, and version actions on documents directly in a ServiceNow instance. This integration is bi-directional (performs in both directions): Changes are reflected in both Microsoft OneDrive and in the instance.

Microsoft Azure AD Spoke for IntegrationHub
The Microsoft Azure AD Spoke for IntegrationHub provides actions that a Process Analyst can use when designing flows. The actions allow them to automate the management of users, security groups, and office groups. User management includes applying licenses that result in user provisioning into Office 365.

Multi Provider Document Service Framework plugin (glide plugin)
Plugin contains the data model needed to integrate with third-party document service providers.
Note: To activate a plugin:
1. Navigate to System Definition→Plugin.
2. Enter the plugin name in the Search field.
3. Select install.

Tables
mp_provider_details
- Provider Details Name
- Provider Name
- Attributes

mp_document_version
- Version
- Document
- Version Modified By
- Version Last Modified

mp_document_activity
- Document Name
- Document sys_id
- Document Version sys_id
- Document Action
- Provider Detail
- Notes

mp_documents
- Document name
- Provider Details
- Attachment
- URL
- Description

mp_document_action
• document_action_name
• provider_detail
• subflow
• provider_permission

**mp_permission_configuration**
• Entity_type
• Entity_id
• Attributes
• Provider_group_id
• Provider_group_name
• permission

**mp_provider_permission**
• permission
• provider
• Attributes
• description

**mp_collaborator**
• collaborator_attributes
• collaborator_email
• collaborator_id
• collaborator_name
• Provider_detail
• user

**Related information**
  Document Viewer

**View attachments with Document Viewer**
View documents within the platform using Document Viewer rather than having to download them to your own file system.
Before you begin
Make sure that Document Viewer is enabled for the table containing the record. For more information, see Enable Document Viewer.
Role required: none

About this task
Document Viewer supports inline viewing of certain document types within the platform.

Procedure
1. Navigate to a record (incident, form, list, and so on) with an attachment.
2. Click View next to the file attachment name.
   Document Viewer displays the document.
   If the document does not display, Document Viewer does not support inline viewing in your situation and a message instructs you to download the document. The possible reasons are:
   • The document uploaded is platform encrypted or edge encrypted.
   • The file size exceeds the maximum allowed value of 50 MB.
   • The document is password-protected but it is not a PDF file.
   Click Download Document to view the document in the relevant external application.

Related information
Enable Document Viewer

Disable Document Viewer
Disable Document Viewer at the instance level to disable it or at table level to disable it for specific tables within the instance.

Before you begin
Ensure the system property (com.snc.documentviewer.enable_document_viewer) exists in your instance.
Role required: admin

Procedure
Disable Document Viewer at the instance level or for specific tables.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Document Viewer at the instance level</td>
<td>a. Search for <code>sys_properties.list</code> in the navigation filter.</td>
</tr>
<tr>
<td></td>
<td>b. Set the system property <code>com.snc.documentviewer.enable_document_viewer</code> value to <code>false</code>.</td>
</tr>
<tr>
<td></td>
<td>c. Click <strong>Update</strong>.</td>
</tr>
<tr>
<td>Disable Document Viewer at the table level</td>
<td>a. Navigate to <strong>System Definition → Dictionary</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Open the table and click <strong>New</strong> under the <strong>Attributes</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>c. Search for <strong>Use Document Viewer</strong> in the <strong>Attribute</strong> field.</td>
</tr>
<tr>
<td></td>
<td>d. Enter <code>false</code> in the <strong>Value</strong> field.</td>
</tr>
<tr>
<td></td>
<td>e. Click <strong>Submit</strong>.</td>
</tr>
</tbody>
</table>

**Related information**

**Enable Document Viewer**

**Managed Documents**

Use the ServiceNow® Managed Documents application to control electronic documents within your instance.

After parameters have been set by the administrator and the Knowledge Document plugin installed, documents can move through the managed document cycle.

**Managed Document features**

Managed Documents is a lightweight, ITIL-based solution for creating and managing electronic documents within your instance.

This application adds a layer of control around any document by providing workflow, storage, security, and categorization options. It can be used for a variety of internal documents, such as policies and procedures, compliance documentation, and knowledge articles. Because it is integrated within the instance, Managed Documents offers a seamless alternative to 3rd-party systems.
## Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check-in/Check-out</td>
<td>Track revisions, approval history, and automated notifications for approvers and reviewers. Useful for compliance and risk authors, policy and procedure writers, and contract administrators.</td>
</tr>
<tr>
<td>Categorization</td>
<td>Classify documents for organization and search.</td>
</tr>
<tr>
<td>Access control</td>
<td>Share documents with selected users.</td>
</tr>
<tr>
<td>Revision control</td>
<td>Track changes to documents.</td>
</tr>
<tr>
<td>Digital signature for approval</td>
<td>Integration with the Approval with E-Signature plugin.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Support consistent content review and approval.</td>
</tr>
<tr>
<td>Security</td>
<td>Use high security setting.</td>
</tr>
</tbody>
</table>

### Managed Document concepts

The following concepts explain Managed Documents: Managed Document, Document Collection, Document Revisions, and Document Parameters.

## Concepts

<table>
<thead>
<tr>
<th>Concept</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managed Document</td>
<td>The Document [dms_document] table contains the documents controlled through the managed documents process.</td>
</tr>
<tr>
<td>Document Collection</td>
<td>The Document Collection [dms_collection] table allows related documents to be grouped together.</td>
</tr>
<tr>
<td>Document Revisions</td>
<td>Because managed documents must have clear records of individual versions of a document, revisions (including the file) are attached to the primary document record through a related list. Document revisions are controlled to keep a standard naming scheme and consistent version numbers. Once a document revision is ready, it can be submitted for review.</td>
</tr>
</tbody>
</table>
Concepts (continued)

<table>
<thead>
<tr>
<th>Concept</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Parameters</td>
<td><strong>Attention:</strong> Parameters do not control application or document security. Parameters only organize documents, they do not affect who can access documents. To grant access to the Managed Documents application, you can assign a role. To grant access to a specific document, set user and group permissions. Each document can be associated with predefined parameters. The parameters can help with grouping documents.</td>
</tr>
<tr>
<td></td>
<td>• Type: Defines the type of document being controlled. Documents of the same type use the same controls.</td>
</tr>
<tr>
<td></td>
<td>• Classification: Defines document restriction level, such as public, restricted, or confidential.</td>
</tr>
<tr>
<td></td>
<td>• Audience: Defines the groups with access to the document, such as internal or external.</td>
</tr>
<tr>
<td></td>
<td>• Name Formats: Defines the format of document names, ensuring that documents of the same type have the same name scheme assembled from name components.</td>
</tr>
<tr>
<td></td>
<td>• Name Components: Defines the document values used in the name formats.</td>
</tr>
<tr>
<td></td>
<td>• Approval Rules: Defines the approvals the document must have before it can be published.</td>
</tr>
</tbody>
</table>

**Install the Managed Documents plugin**

The Managed Documents plugin is available for activation by users with the admin role.

**Procedure**

1. Navigate to **System Definition > Plugins**.
2. Right-click the plugin name on the list and select **Activate/Upgrade**.
   - If the plugin depends on other plugins, these plugins and their activation status are listed.
3. [Optional] Select the **Load demo data** check box.
Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when first activating the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.

4. Click **Activate**.

**Managed Documents plugin**

This page describes the applications and modules, database table structure, scripts, and roles.

**Database table structure**

The following tables are added:

<table>
<thead>
<tr>
<th>Display Name (Table Name)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revision [dms_revision]</td>
<td>The document revisions.</td>
</tr>
<tr>
<td>Classifications [classification]</td>
<td>The document restriction level, such as public or confidential. (Does not define access to the document. Document security is set in user and group permissions.)</td>
</tr>
<tr>
<td>Type [dms_type]</td>
<td>The document purpose.</td>
</tr>
<tr>
<td>Component [dms_component]</td>
<td>The components of name formats. The value field is a dot-walking expression that is evaluated. An exception is made for the revision because it does not exist when the revision name is generated.</td>
</tr>
<tr>
<td>Name format [dms_name_format]</td>
<td>The composition of components to generate revision names.</td>
</tr>
<tr>
<td>Approval sequence [approval_sequence]</td>
<td>The approval sequences that users need to follow.</td>
</tr>
</tbody>
</table>
## Tables (continued)

<table>
<thead>
<tr>
<th>Display Name (Table Name)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Rule [dms_approval_rule]</td>
<td>The criteria that records of the dms_document table must match. Used to automatically add approvers to a document.</td>
</tr>
<tr>
<td>Collection [dms_collection]</td>
<td>The document groups created by the user.</td>
</tr>
</tbody>
</table>

## Scripts

### Business rules that are added to sys_script

<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Document</td>
<td>Changes the state of a document depending on its revisions.</td>
</tr>
<tr>
<td>Add Approvers</td>
<td>Populates the list of approvers in the document.</td>
</tr>
</tbody>
</table>

### Script includes that will be added to sys_script_include

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DocumentManagement</td>
<td>Contains the main logics for the Managed Documents plugin.</td>
</tr>
<tr>
<td>DocumentManagementDB</td>
<td>Contains methods to perform CRUD operations on the database.</td>
</tr>
<tr>
<td>DocumentManagementSecurity</td>
<td>Helps manage the security of the Managed Documents system.</td>
</tr>
<tr>
<td>DocumentManagementAjax</td>
<td>Updates the details of the temporary revision that is created when opening the upload/check in revision form.</td>
</tr>
<tr>
<td>DocumentAttachmentAjax</td>
<td>Renames an attachment file.</td>
</tr>
<tr>
<td>DocumentRevisionWorkflowHelper</td>
<td>Helps perform basic workflow operations on a revision.</td>
</tr>
</tbody>
</table>
### Script includes that will be added to sys_script_include (continued)

<table>
<thead>
<tr>
<th>Script Include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DocumentManagementApprovalMatcher</td>
<td>Helps obtain the user and group approvers for a document that matches approval rules.</td>
</tr>
<tr>
<td>DocumentApproverHelper</td>
<td>Contains logics to handle document approvers.</td>
</tr>
<tr>
<td>DocumentManagementUtils</td>
<td>Useful methods.</td>
</tr>
<tr>
<td>DocumentReferenceQualifiers</td>
<td>Static methods that return reference qualifiers.</td>
</tr>
</tbody>
</table>

### Client script that is added to sys_script_client

<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document type change</td>
<td>Updates the name format field in the revision settings section of the document. Each type has a default name format.</td>
</tr>
</tbody>
</table>

### Roles

This plugin introduces two new roles:

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>document_management_user</td>
<td>This role enables a user to access the Managed Documents plugin, create documents, and search for documents. Document reviewers and approvers need the document_management_user role to access the Managed Document plugin. (Please note that reviewers and approvers can also access a document revision from an approval record.)</td>
</tr>
<tr>
<td>document_management_admin</td>
<td>This role enables a user to change administrative settings for the Managed Documents plugin.</td>
</tr>
</tbody>
</table>
Note: Each document has individual permissions, so even if a user is given the document_management_user role and has permissions to the application, the user can only view documents to which they have been given access.

Create a new managed document record
Configure the properties and policies for a managed document.

Procedure
1. Navigate to Managed Documents > Create New.
2. In the Name field, type Policy.
3. In the Requested by field, add your name.
4. In the Owner field, add your name.
5. In the Reviewer field, add your name.
6. In the Type field, select Policy.
7. In the Classification field, select Confidential.
8. In the Audience field, select Internal.
9. Under Revision Settings, select the Auto increment revision option.

Example

10. Click Submit.

Check in a document after making changes
After making changes to a document, check the revised document into Managed Documents.

Procedure
1. Open the document record.
2. Click the Upload/Check in Revision related link.
3. Click Choose File, select the revised file, and click Open.
4. Check that the Name and Revision Number contain the updated number.
5. Ensure that the **Check in** option is selected.

6. Click **OK**.

   The Document Revisions list updates to contain the most recent revision.

<table>
<thead>
<tr>
<th></th>
<th>Name</th>
<th>Revision number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Policy POL_0.1</td>
<td>0.1</td>
</tr>
<tr>
<td>2</td>
<td>Policy POL_0.2</td>
<td>0.2</td>
</tr>
</tbody>
</table>

### Check out a document to make changes

After a document is added to a managed document record, check the file out to make changes. Checking documents in and out keeps a record of document changes and ensures that only one person at a time is editing the document.

#### Procedure

1. Open the document record.
2. Select the **Check Out Document** related link.

   ![Check out latest revision of document: Policy](image)

   - **Name**: Policy POL_0.1
   - **Revision**: 0.1
   - **Created by**: joseph, 2011-07-11 20:07:14
   - **Last modified by**: joseph, 2011-07-11 20:07:22
   - **Document type**: Policy
   - **Download file**: ✔

   ![Check Out button](image)

3. Select **Download file**.
4. Click **Check Out**.
5. Open the file and make a small change.
6. Save the document with the same name, but a new revision number. For example, **Policy_POL_02.txt**.

### Publish a document in Managed Documents

After the document is reviewed and approved, publish the document within Managed Documents.
Procedure

1. Open the document record.
2. In the Document Revisions list, click the name of the revision that was approved and is listed in the Ready for Publishing stage.
3. In the header bar, click **Publish Revision**.

4. In the Publish revision dialog box, check that the name and revision number are correct and click **Publish**.
   In the Document Revisions list, the revision you just published is now in the Published stage.

Send a document out for review and approval

When a document is ready, send it out for review and approval. If a reviewer or approver is not identified in the document record, the document is moved directly to the publishing stage.

Procedure

1. In the Document Revisions list, right-click the revised document and select **Submit Revision**.

   Because you identified yourself as the reviewer, you receive an approve request email message.

2. In the email message, click the link next to **Click here to view Approval Request**.
3. (Optional) View the document by clicking the attachment name under Document Revision.

4. Click Approve.
   The Approvals page displays and lists the document you just approved.

5. Open the document record.

6. In the Document Revisions list, the revision you approved is now in the Ready for Publishing stage.

Upload a document as an attachment

After creating a document record, add the document to the record as an attachment.

Procedure

1. Open the document record.

2. Select the Upload/Check in Revision related link.

   ![Update Delete]

   Related Links
   Upload/Check In Revision

3. Click Choose File.

4. Select a simple document, such as a text file, and click Open.

5. Check that the name reads Policy_POL_0.1.

6. Click OK.
   The document is listed under Document Revisions.

Defining Document Parameters

Before using the Managed Documents application, the user with the document_management_admin role needs to set the parameters that define the kinds of documents to be managed through the application. Managed Documents provides both base and custom parameter options.

Defining Document Parameters
The following document parameters should be defined:
• **Type**: identifies the purpose of the document. The type also determines the default document format and name format.

• **Classification**: indicates the security level assigned to the document and determines who can view or edit the document.

• **Audience**: specifies the intended readers of the document.

• **Name format**: specifies the name format to use when a document revision is added.

• **Name components**: are individual identifiers used inside a name format. Name components define a reference path (often by dot-walking) that holds the value specific to the document.

• **Approval rules**: determine which approvers are added to documents (in addition to the **Reviewers** specified on the document record).

### Defining Types

To define a new type, navigate to **Managed Documents > Administration > Type** and click **New**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the type.</td>
</tr>
<tr>
<td>Code</td>
<td>A short code for the type. Referenced as a name component for the name format.</td>
</tr>
<tr>
<td>Label</td>
<td>A label to display in the <strong>Type</strong> choice list.</td>
</tr>
<tr>
<td>Name Format</td>
<td>The name format that documents of this type will use.</td>
</tr>
<tr>
<td>Order</td>
<td>A number indicating the type's sequence in the choice list.</td>
</tr>
</tbody>
</table>

The following types are available in the base system.

<table>
<thead>
<tr>
<th>Name</th>
<th>Code</th>
<th>Label</th>
<th>Name format</th>
<th>Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>-- None --</td>
<td>null</td>
<td>-- None --</td>
<td>null</td>
<td>1</td>
</tr>
<tr>
<td>policy</td>
<td>POL</td>
<td>Policy</td>
<td>Default Policy</td>
<td>2</td>
</tr>
<tr>
<td>guideline</td>
<td>GUI</td>
<td>Guideline</td>
<td>Default</td>
<td>3</td>
</tr>
<tr>
<td>procedure</td>
<td>PROC</td>
<td>Procedure</td>
<td>Default</td>
<td>4</td>
</tr>
<tr>
<td>contract</td>
<td>CON</td>
<td>Contract</td>
<td>Default</td>
<td>5</td>
</tr>
</tbody>
</table>
Note: For documents with a Type of Contract, a Contracts related list appears on the document record, listing any contracts the document is associated with.

Defining Approval Rules

To define a new approval rule, navigate to Managed Documents > Administration > Approval Rules and click New.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique identifier for the approval rule.</td>
</tr>
<tr>
<td>Active</td>
<td>A check box indicating whether this approval rule is used.</td>
</tr>
<tr>
<td>Condition</td>
<td>A condition builder that determines which documents use this approval rule.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description of the approval rule.</td>
</tr>
</tbody>
</table>

Once the approval rule is saved, the Approvers related list defines which approvers are added if the conditions in the Condition field are met.

The following approval rules are available in the base system.

<table>
<thead>
<tr>
<th>Name</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal policy</td>
<td>type=Policy ^ audience=Internal</td>
</tr>
<tr>
<td>Development policy</td>
<td>type=Policy ^ department=Development</td>
</tr>
</tbody>
</table>

Related reference

Defining Document Parameters

Defining Audiences

To define a new audience, navigate to Managed Documents > Administration > Audience and click New.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audience Name</td>
<td>A unique name for the audience.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
**Audience Code** | A short code for the audience. Referenced as a name component for the name format.
**Label** | A label to display in the Audience choice list.
**Order** | A number indicating this audience’s sequence in the choice list.

The following audiences are available in the base system.

<table>
<thead>
<tr>
<th>Audience</th>
<th>Audience code</th>
<th>Label</th>
<th>Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>internal</td>
<td>INT</td>
<td>Internal</td>
<td>1</td>
</tr>
<tr>
<td>external</td>
<td>EXT</td>
<td>External</td>
<td>2</td>
</tr>
</tbody>
</table>

**Related reference**

Defining Document Parameters

**Defining Classifications**

Define a new classification on the Classification form.

Navigate to **Managed Documents > Administration > Classification** and click **New**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>A unique name for the classification.</td>
</tr>
<tr>
<td><strong>Code</strong></td>
<td>A short code for the classification. Referenced as a name component for the name format.</td>
</tr>
<tr>
<td><strong>Label</strong></td>
<td>A label to display in the Classification choice list.</td>
</tr>
<tr>
<td><strong>Order</strong></td>
<td>A number indicating this classification’s sequence in the choice list.</td>
</tr>
</tbody>
</table>

The following classifications are available in the base system.

<table>
<thead>
<tr>
<th>Name</th>
<th>Code</th>
<th>Label</th>
<th>Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>public</td>
<td>P</td>
<td>Public</td>
<td>1</td>
</tr>
<tr>
<td>restricted</td>
<td>R</td>
<td>Restricted</td>
<td>2</td>
</tr>
<tr>
<td>Name</td>
<td>Code</td>
<td>Label</td>
<td>Order</td>
</tr>
<tr>
<td>---------</td>
<td>------</td>
<td>-----------</td>
<td>-------</td>
</tr>
<tr>
<td>confidential</td>
<td>C</td>
<td>Confidential</td>
<td>3</td>
</tr>
</tbody>
</table>

### Defining Name Components

Name components define the document values used in the name format.

For example, the name component `document.audience.code` dot-walks from the document record to the audience **Code**.

To define a new name component, navigate to **Managed Documents > Administration > Components** and click **New**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique identifier for the name component.</td>
</tr>
<tr>
<td>Short Description</td>
<td>A short description of the name component value.</td>
</tr>
</tbody>
</table>
| Value          | The path to the field holding the value used for the name format. Defined relative to a current revision record. For example:  
  - Enter `revision` to use the revision **Number** field on the revision record.  
  - Enter `document.name` to use the **Name** field on the revision's referenced document.  
  - Enter `document.audience.code` to use the **Code** field for the audience referenced by the document. |

This dot-walking approach makes it possible to get any value related to the revision into the name format.

**Note:** The **revision** component is a special component replaced by the appropriate revision number (rather than querying a value related to the current record). The revision is either automatically incremented or uses the latest revision number, depending on the setting on the document form.

The following components are defined in the base system.
Defining Name Formats

The name format automatically generates a name for a document revision by arranging name components in a standard code to match naming conventions.

For example, a name format with the name components **Type Code**, **Document Name**, and **Revision Number** and the separator `-`, would be formatted as:

```
TYPECODE-Name-RevNumber.fileformat
```

In this example, a policy (code POL) named IT Off-Boarding Policy, with revision number 1.0, and uploaded as a `.docx` file would have the name:

```
POL-IT Off-Boarding Policy-1.0.docx
```

To define a new name format, navigate to **Managed Documents > Administration > Name Formats** and click **New**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the name format.</td>
</tr>
<tr>
<td>Separator</td>
<td>A separator to put between each of the components. Hyphens (-) and underscores (_) are commonly used. Using alphanumeric characters can create a confusing name format.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the name format.</td>
</tr>
</tbody>
</table>

Use the related list to add name components. Use the **Order** field to set the sequence in which name components are used.
The following name formats are defined in the base system.

<table>
<thead>
<tr>
<th>Name</th>
<th>Separator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>_</td>
<td>The default format. Document name and revision separated by an underscore.</td>
</tr>
<tr>
<td>Default Policy</td>
<td>_</td>
<td>The format for the policy document type.</td>
</tr>
<tr>
<td>Development documentation</td>
<td>(no separator)</td>
<td>The format for the software documentation type.</td>
</tr>
<tr>
<td>Development Sources</td>
<td>(no separator)</td>
<td>The format for the development and code sources type.</td>
</tr>
<tr>
<td>Intranet Improvement</td>
<td>(no separator)</td>
<td>The format for documents that describe intranet use.</td>
</tr>
</tbody>
</table>

**Defining Document Workflow**

In the base system, all managed documents use the Managed Documents workflow after the **Active** check box is selected.

The document parameters defined in the workflow are often used as conditions to trigger more specific workflows, such as type-specific workflows.
or classification-specific workflows. If different kinds of documents should follow different workflows, use the Graphical Workflow Editor to create new workflows.

### Knowledge document

The Knowledge Document plugin extends the Managed Documents plugin by providing the functionality for managed documents to be published to the knowledge base.

### Installed with knowledge document

These elements are installed with the knowledge document plugin.

### Dependencies

The Knowledge Document plugin depends on the Managed Documents plugin. Activating Knowledge Document activates Managed Documents.

### Tables

<table>
<thead>
<tr>
<th>Display Name [table_name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Records [m2m_document_knowledge]</td>
<td>A many-to-many table storing the relationship between a document and a knowledge article.</td>
</tr>
</tbody>
</table>

### UI Actions

<table>
<thead>
<tr>
<th>UI action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link to Knowledge</td>
<td>Creates or updates a knowledge article related to the current document, depending on whether a knowledge article already exists.</td>
</tr>
</tbody>
</table>
## Scripts

### Script Includes

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>KnowledgeDocument</td>
<td>Holds the main logic for the Knowledge Document plugin.</td>
</tr>
<tr>
<td>KnowledgeDocumentDB</td>
<td>Class that gets, inserts, and updates data for the Knowledge Document plugin.</td>
</tr>
</tbody>
</table>

## Link documents to knowledge articles

Manage a document and access the latest version of the document from an article by linking the document to a knowledge article.

### Before you begin

Your administrator must have activated the following plugins:

- Knowledge document plugin (com.snc.knowledge_document)
- Knowledge Management Advanced plugin (com.snc.knowledge_advanced)

The document is already uploaded and published. For more information, see [Upload a document](#) and [Publish an approved revision](#).

You must have contribute access to the knowledge base within which the article linked to the document is stored.

If a knowledge article is already linked to the document, you must have contribute access to the article.

Role required: document_management_user and knowledge

### About this task

You can link the initial or revised version of a document to a knowledge article. The document appears as an attachment to the linked article. Revising a document doesn’t automatically update the document attached to the linked knowledge article. Therefore, every time you revise a document, you must again link the revised document to the knowledge article.

**Note:** As the owner of a document or an administrator, you can link the document to a published article. If the article is checked out by another user, you can't link the document to the associated article, unless the article is published.
**Procedure**

1. Navigate to Managed Documents > Documents > All.
2. Click the document.
3. In the Knowledge Settings related list, fill in the fields.

### Knowledge settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Behavior</strong></td>
<td>Process performed when the <strong>Link to Knowledge</strong> related link is clicked. A behavior is one of the following types:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always create record</strong>: A new knowledge article is created and linked with the latest published revision of the document as an attachment.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Update existing record</strong>: The linked knowledge article is updated with the latest published revision of the document as an attachment. If no knowledge articles exist for the document, a new knowledge article is created.</td>
</tr>
<tr>
<td></td>
<td>⚠ <strong>Note</strong>: Once you select a behavior setting for a document, you can’t modify it later when revising the document.</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>Knowledge base in which the knowledge article is stored. You can associate a knowledge article with one knowledge base only. If you are using an article template, you can modify this value only if the template is available in the other knowledge base.</td>
</tr>
<tr>
<td>Type</td>
<td>Article template to create a knowledge article using defined fields and values.</td>
</tr>
<tr>
<td></td>
<td>⚠ <strong>Note</strong>: when a knowledge article is created, the <strong>Type</strong> field becomes read-only.</td>
</tr>
<tr>
<td>Valid to</td>
<td>Date that the article expires. Adds valid to date information to the same field in the knowledge article.</td>
</tr>
<tr>
<td>Short description</td>
<td>A few words or short phrase describing the knowledge article. Adds the short description to the same field in the knowledge article.</td>
</tr>
</tbody>
</table>
4. Click the **Link to Knowledge** related link.

5. **Optional:** In the information message that is displayed, click the message link to view the knowledge article.

**Results**

The uploaded document is added as an attachment to a knowledge article. Depending on the **Behavior** field value specified in the Knowledge settings related list, the knowledge article is created or updated with the document.

**Create a document**

After Managed Documents parameters have been set by the administrator, documents can be created, requested, checked out, edited, checked in, copied, and, if necessary, rolled back to an earlier version.

Once documents have been added to the Managed Documents application, they can be grouped into document collections.

**Approval process**

During the approval process, the approver approves or rejects the document. A document goes through the approval process after the review process.

**Approval workflow**

After the document has been reviewed, submit the document for approval. If the document does not have an approver, the approval process is omitted.

When the document is **Active**, the workflow **Document Management Default** is used to manage approvals:
If the approver rejects the document, the author and owner are notified and the document review is cancelled. The author, owner, and approver should discuss what changes need to be made to the document. When the document is ready, a new review can be initiated.

If the final approver approves the document, the author and the owner are notified. Once final approval is successful, the document stage changes to Ready for Publishing in the Document Revisions list:
Process modification for multiple approvers

If there are multiple approvers, the approval process works in sequence and multiple approvers can be assigned to a single sequence. For example:

Sequence 1: approvers A and B
Sequence 2: approvers C and D
Sequence 3: approver E

Because the sequences take place in ascending chronological order, approvers A and B receive the approval request first (approvers C, D, and E are not part of the process yet). Similar to the review process, the first approver to act within a sequence dictates what happens to the document. If approver A acts first and rejects the document, the approval process stops and the state is set to Cancelled. Approver B's status is changed to No Longer Required. If approver A acts first and approves the document, the process stops and approver B's status is changed to No Longer Required. Then, the document moves to approval sequence 2. After at least one approver in each sequence approves the document, the author and the owner are notified that the document has been approved.

Review process

During the review process, the reviewer approves or rejects the document. Sometimes a document will have multiple reviewers.
If the reviewer rejects the document, the author and owner are notified and the review is cancelled. The author, owner, and reviewer should discuss what changes need to be made to the document. If the reviewer approves the document, the author and owner are notified that the review was successful and the document can move to the approval stage.

If multiple reviewers are assigned to a document, the first reviewer to act dictates what happens to the document. For example, there are two reviewers, A and B. If reviewer A acts first and rejects the document, the review process stops and the revision state is set to Cancelled. Reviewer B receives a notification email stating that the review was rejected and their status is changed to No Longer Required. If reviewer A acts first and approves the document, the review process stops and the document can move to the approval stage. Reviewer B's status is changed to No Longer Required.

Enable electronic signature for approval

This topic explains how to enabling electronic signatures for approval. Electronic signatures are helpful if you must obtain a digital signature for compliance or auditing purposes.

About this task
You can activate the Approval with E-Signature plugin to require that users type in a user name and password when reviewing and approving documents.

The digital signature is not tracked or stored in the document record. Users must simply type in a user name and password after clicking the Approve or Reject button.

![Digital signature](Image)

After activating the Approval with E-Signature plugin, ensure that a row in the e-signature registry table is created for the dms_document_revision table.
Procedure

1. Navigate to System Definition > e-Signature Registry.
2. Check if dms_document_revision is already listed and Enabled is set to true.
3. If not listed, click New.
4. In Table name, select Document Revision.
5. Select Enabled.

Example

```
        e-Signature Registry

<table>
<thead>
<tr>
<th>Table name:</th>
<th>Document Revision [dms_document_revision]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled:</td>
<td>✔</td>
</tr>
</tbody>
</table>
```

6. Click Submit.

Publish an approved revision

This topic explains how to publish a document revision that has been approved.

About this task

Once a document has been created and edited, a specific revision can be submitted for draft review and final approval. After final approval, the document can be published.

Publish the approved revision from the Document Revisions list.

Note: Publishing documents to the Knowledge Base requires the Knowledge Document Plugin.

Procedure

1. Navigate to the document record.
2. In the Document Revisions List, click the revision marked Ready for Publishing.
3. Click Publish Revision to display the Publish dialog box.
Example

The revision number matches the latest revision number. If your standard is to change the revision number when the document is published, such as incrementing the version number to 1.1 or 1.0.1, the change can be made on this dialog box manually.

4. Click Publish.

The published revision is highlighted in green and the stage of previous revisions is automatically changed to Retired:

Note: If the approval and publishing process is repeated, the published revision is retired when the new revision is published. Any workflows running against previous revisions are canceled when the document is published.

Submit a revision for draft review

This topic explains how to submit a document draft for review.

About this task

Once a document has been created and edited, a specific revision can be submitted for draft review and final approval. After final approval, the document can be published.
When a draft of the document is ready, submit the draft for review. If the document does not have reviewers identified in the Reviewers field of the document record, the review process is omitted.

Procedure
1. Navigate to the document record.
2. Right-click the appropriate revision.
3. Select **Submit Revision**.
   The revision stage is set to Awaiting Review.

The document name and parameters are changed to read-only. The document state is set to **Active**.

Create or request a new document
Once an administrator has set parameters for the Managed Documents application, you can create or request new documents.

Procedure
1. Navigate to **Managed Documents > Create New**.
2. Complete the following fields:
### New document fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>An identifying number for the document. Automatically generated using number maintenance.</td>
</tr>
<tr>
<td>Name</td>
<td>A name for the document. Note that the name for the document is combined with other naming components (as defined by the name format) to create the names for each document revision.</td>
</tr>
<tr>
<td>Requested by</td>
<td>The person asking that the document be created or updated.</td>
</tr>
<tr>
<td>Owner</td>
<td>The approver of the document request. Also responsible for setting completion date with requesters and authors.</td>
</tr>
<tr>
<td>Reviewers</td>
<td>The user or users who review the document and provide feedback to owners and authors.</td>
</tr>
<tr>
<td>Department</td>
<td>The department responsible for the document.</td>
</tr>
<tr>
<td>Type</td>
<td>The document purpose. This is a choice list derived from the type parameters.</td>
</tr>
<tr>
<td>Classification</td>
<td>The document classification, based on security, audience, and confidentiality. This is a choice list derived from the classification parameters.</td>
</tr>
<tr>
<td>Audience</td>
<td>The document readers, such as external or internal. This is a choice list derived from the audience parameters.</td>
</tr>
<tr>
<td>State</td>
<td>The current status of the document in the editing and publication process.</td>
</tr>
<tr>
<td>Checked out by</td>
<td>The user who currently has the document checked out.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description of the document.</td>
</tr>
<tr>
<td>Revision Settings</td>
<td></td>
</tr>
<tr>
<td>Name format</td>
<td>The format for the name of each individual revision of the document. For more information, see Defining Name Formats.</td>
</tr>
<tr>
<td>Revision format</td>
<td>A choice between the two digit (0.x) or the three digit (0.0.x) revision format.</td>
</tr>
</tbody>
</table>
### Field | Input value
--- | ---
Auto increment revision | If selected, the revision number automatically increments each time the document is revised.

The *User Permissions* related list determines which users have rights to view and contribute to the document:

**User permissions**

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>A reference to a user who is entitled to read but not contribute to a document.</td>
</tr>
</tbody>
</table>
| Type | A choice list describing how the user can interact with the document. Options are:  
  - Reader - The user can read the document versions.  
  - Editor - The user can upload new versions.  
  - Owner - The user can edit the document. |

The *Group Permissions* related list determines which groups have rights to view and contribute to the document:

**Group permissions**

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>A reference to a group of users who are entitled to read and contribute to the document.</td>
</tr>
</tbody>
</table>
| Type | A choice list describing how group members can interact with the document. Options are:  
  - Reader - Group members can read the document versions.  
  - Editor - Group members can upload new versions.  
  - Owner - Group members can edit the document. |

**Specify an approver**

You can specify approvers for a document record after you save it.
About this task
You can have one approver or multiple approvers. For example, set multiple approvers to have one person do a quality check of the document and a different individual to serve as a final approver. Approvers are assigned a number. The lowest number (usually number one) approver always goes first, then any other approvers in ascending chronological order. Multiple approvers can have the same sequence number. For example, two approvers can do a quality check and be assigned sequence number 1. Then, two individuals can be final approvers and be assigned sequence number 2.

Procedure
1. Navigate to the document record.
2. Right-click in the document header bar and select Add Approver.
3. Add a user name.
4. Select a sequence number from the drop-down list. (Lower numbers approve before higher numbers. For example, approver number one approves before number two.)
5. Click Add User.
6. Repeat steps 2-5 to add more approvers.

Check in a document
Check in the document after you revise it so other users can check out the document.

Procedure
1. Navigate to the document record.
2. Select the Upload/Check In Revision related link.
3. Click Browse and navigate to the revised file.
4. Click Open.
5. Check the Name and Revision Number.
6. Click OK.
The Document Revisions related list updates to contain the most recent revision:

### Copy a document

A document can be duplicated at any time. This is useful if you have an existing document that you want to use as a base for a new document.

**Procedure**

1. Navigate to the document record.
2. Right-click the header bar and select **Copy Document**.
   
   An information message with a link to the new document displays:
3. Click **OK**.
   
   The new document is renamed and includes the word "Copy."

*Note:* Only the latest revision is copied.

### Deactivate a document

To change the document state to **Inactive**, deactivate the document. This is useful when changes to a document have been put on hold. An inactive document can be reopened at any time.

**Procedure**

1. Navigate to the document record.
2. Right-click the header bar and select **Deactivate Document**.

*Note:* To activate a document, right-click on the header and click **Reopen Document**.
Reopen a deactivated document
A document that has been deactivated can be reopened.

Procedure
1. Navigate to the document record.
2. Right-click the header bar and select **Reopen Document**.

Roll back a document
A document can be rolled back to an earlier revision at any time. Before rolling back to an earlier revision, ensure that the document is not checked out and that you have Editor or Owner permissions for the document.

Procedure
1. Navigate to the document record.
2. In the Document Revisions list, click the revision to which you want to roll back.
3. Right-click the header bar and select **Rollback**. The Rollback to Revision dialog box displays. The name and revision number are new. The note specifies the revision to which you are rolling back.

![Rollback to revision dialog box](image)

4. Change any information on the Rollback to Revision dialog box as necessary.
5. Click **OK**. The latest revision is now the revision you selected for rollback.

Cancel a document
Change the document state to **Cancelled** when no more changes will be made to the document.
About this task
When canceling a document, there is no confirmation message, so ensure that you want to cancel the document.

Procedure
1. Navigate to the document record.
2. Right-click the header bar and select **Cancel Document**.
   An info message confirms the cancellation:
The **State** is set to **Cancelled**:

![MDOC cancel 3](image)

Check out a document
Documents in the Managed Documents application can only be revised by one user at a time. Check out the document to revise it.

Procedure
1. Navigate to the document record.
2. Select the **Check Out Document** related link.
3. Select **Download file** to download the current version of the document when it is checked out.
4. Click **Check Out**.
   After checking out a document, you can edit the document and make any necessary changes.
Create a document collection

A document collection is a set of individual documents. After documents have been uploaded into Managed Documents, organize the documents by grouping them into collections.

Procedure

1. Navigate to Managed Documents > Document > My Collections.
2. Select New.
3. Type in a Name.
4. (Optional) Type in a Description.
5. Click Submit.
6. Click the name of the collection you created.
7. Click Edit.
8. On the left, double-click an available document or select a document and click Add.
9. Click Save. The Document Collection page displays and the individual documents in the collection are listed:
Upload a document

Upload a document into a saved record. You can upload text files, spreadsheets, presentations, PDF files, and more.

Procedure

1. Navigate to the document record.
2. Click the **Upload/Check In Revision** related link.
3. Click **Choose File** and navigate to the file.
4. Click **Open**.
5. Check the Name and Revision Number.
6. Click **OK**.

   After the initial document is uploaded, subsequent revisions can be created by checking out the document.

Domain separation and Managed Documents

Domain separation is unsupported in Managed Documents. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: No support

- The domain field may exist on data tables but there is no business logic to manage the data.
- This level is not considered domain-separated.

For more information on support levels, see [Application support for domain separation](#).

Related information

- [Domain separation for service providers](#)

Dependency Views

ServiceNow® Dependency Views graphically displays an infrastructure view for a configuration item (CI) and the application or business services that it is part of and that it supports. Dependency Views indicates the status of its configuration items, and allows access to CIs related alerts, incidents, problems, changes, and services.
If Service Mapping is activated, Dependency Views maps are enhanced to display dependencies that reflect connections in service maps.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Administer</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrade to Rome</td>
<td>Create or modify map indicators</td>
<td>Dependency Views map</td>
</tr>
<tr>
<td>Domain separation and Dependency Views</td>
<td>Create or modify map icons</td>
<td>Dependency Views map menus and controls</td>
</tr>
<tr>
<td>Create a predefined filter</td>
<td>Create or modify Map Related Items</td>
<td>View a Dependency Views map</td>
</tr>
<tr>
<td>Create or modify Dependency Views menu actions</td>
<td>Create or edit a dependency type</td>
<td>Change the layout of Dependency Views map</td>
</tr>
<tr>
<td>Create or modify Dependency Views</td>
<td></td>
<td>Filter the view of a Dependency Views map</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Perform actions on nodes in a Dependency Views map</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Supported browsers for Dependency Views</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Develop</th>
<th>Integration</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Developer training</td>
<td>View metrics for CIs in a Dependency Views map</td>
<td>Ask or answer questions in the Now Community</td>
</tr>
<tr>
<td>Developer documentation</td>
<td></td>
<td>Search the Known Error Portal for known error articles</td>
</tr>
<tr>
<td>Properties for Dependency Views</td>
<td></td>
<td>Contact Customer Service and Support</td>
</tr>
<tr>
<td>Components installed with Dependency Views</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Supported browsers for Dependency Views**

The latest version or service pack of internet browsers are required to view and manipulate Dependency Views maps.

The Dependency Views module supports the latest version or service pack of the following browsers:

- Firefox with the latest ESR
- Chrome latest version
• Safari version 8 or later (latest is recommended)
• Microsoft Internet Explorer (IE) version 11 and Microsoft Edge.

The Dependency Views module is not supported on tablets and on mobile devices.

Domain separation and Dependency Views

Domain separation is unsupported in Dependency Views. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
• The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.
• The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.

How domain separation works in Dependency Views

Dependency views are generated using both Configuration Item [cmdb_ci] and CI Relationship [cmdb_rel_ci] tables. The [cmdb_ci] table is domain separated, but the [cmdb_rel_ci] table is not. You can create relationships only by selecting two CIs. They should be in the same domain for you to be able to see them.

To be successful with domain separation in Dependency Views, make sure that relevant CIs are visible for the current domain. If the instance is domain separated, ServiceNow domain separation rules apply (see Related information link below).

Tenant domains will be able to see only their domain and global CIs.
Related information

Domain separation for service providers

Dependency Views map

ServiceNow® Dependency Views maps graphically display CIs that support application or business services and the relationships between the CIs.

A ServiceNow service (application service or business service) is work or goods that are supported by an IT infrastructure. For example, delivering email service to an employee can require services such as email servers, web servers, and the work to configure the user's account.

A Dependency Views map has one starting point, called the root CI or root node of the map. The root CI is surrounded by a darker frame that repaints itself with a pulsing effect drawing the attention to the root CI. The maps can show both upstream and downstream dependencies for the root CI. By default the Dependency Views map displays 3 levels, both upstream and downstream relationships. Administrators can configure the number of levels displayed. The map collapses and expands clusters to make them easier to view. By default, clusters are collapsed.

In a Dependency Views map, map indicators indicate if a CI has any active, pending issues. You can investigate the tasks that are connected to a CI to get more details. When you return to the map from another form, the system restores the last map viewed, using the default filter and layout settings. When you click the icon (🔍) on a CI record or on a task record that identifies a CI, the map opens.

Many of the relationships in map are created through the discovery process. You can also create, define, and delete CI relationships in the map. You can display the map from different perspectives and open specific records that relate to configuration items. The system refreshes the map automatically to reflect changes to the CMDB.

❗ Note: CIs not extended from the Configuration Item [cmdb_ci] table, are not displayed in Dependency Views maps and in CI relation formatters.

The Dependency Views module is active in all instances, and includes demo data.
When you click the map icon on a CI record or on a task record that identify a CI, a map opens.

Roles

Users with the itil and ecmdb_admin roles can view maps and perform all actions in the map. Actions include access to the map views and saved filters, both from the lists in the map and from the Saved Filters module.

Dependency Views map menus and controls

Dependency Views maps contain the following menus and controls.

Map options

The following options are available across the top of the map.
Next to the menu icon is the name of the current root node (CI) of the map.

Enter the name of a CI, application service, or business service to load into the map. Alternatively, you can start typing to have the auto-complete feature present a list of CIs and services that match your partial value.

Vertical Display the map in vertical view.

Horizontal Display the map in horizontal view.

Radial Display the map in radial view.

Force Centers the elements around the parent CI, regardless of upstream or downstream relationships.

Group Groups the elements according to their CI type.

Details Displays related lists such as Problems, Changes and Related Services that are associated with the selected CI.

- Click a service to highlight the CIs that are associated with that service.
- Click Related Services, then double-click a service to display the map in the Event Management dashboard.

If the Event Management plugin is active, then events and alerts are also displayed.

Settings Set filters for the map.

Use the navigation tools to increase or decrease the view of the map, rearrange the icons on the map, and move the map on the page.

- Use the plus sign (+) to increase magnification of the map.
- Use the minus sign (-) to decrease magnification of the map.
- Click the center dot to center the map on the page.
- Use the direction arrows to move the page in that direction.
- Use the selection tool under the navigation tool to toggle between moving the entire map or moving one CI on the map.

Map menu
The following options are available if you right-click the map background.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Layout</td>
<td>Redraws the map with the current layout option.</td>
</tr>
<tr>
<td>Fit To Screen</td>
<td>Resizes the map to fit all the nodes in the map window.</td>
</tr>
<tr>
<td>Reset Filters</td>
<td>Performs the same action as the Filters &gt; Reset option.</td>
</tr>
</tbody>
</table>
## Node menu

The following options are available if you right-click a node.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Form</td>
<td>Displays the CMDB record of the selected CI in a new tab of the browser.</td>
</tr>
<tr>
<td>View Map</td>
<td>Reloads the map using the selected CI as the new root node, with the currently defined layout setting. This option does not display on the root node.</td>
</tr>
<tr>
<td>View Related Tasks</td>
<td>Displays all tasks or outages associated with the selected CI, including incidents, problems, change requests, and follow-on tasks. This option is always available, even if there are no tasks associated with the CI. This option does not appear on collapsed nodes.</td>
</tr>
<tr>
<td>View Affected CIs</td>
<td>Shows a list of all tasks that have the CI listed as an Affected CI. This option is only visible when you access the map from the map icon in a task record's Configuration item field.</td>
</tr>
<tr>
<td>View Related Outages</td>
<td>Displays all outages involving the selected CI. This option only appears when there is an outage associated with the CI. This option does not appear on collapsed nodes.</td>
</tr>
<tr>
<td>Add Relationship</td>
<td>This option displays a dotted green line that you can drag to another CI to create a relationship link. A popup dialog allows you to define the relationship type.</td>
</tr>
</tbody>
</table>
| Expand               | Displays all CIs and components within a clustered node, or virtual groups (virtual nodes that appear when `glide.bsm.too_many_children` is reached). This option appears only if the node is a cluster node or a virtual group node.  
  If **Load More** was previously used, then **Expand** reverts the results of the **Load More** operation.  
  The number of additional icons to display is bound by the value of the `glide.bsm.max_nodes` property. |
| Collapse             | Collapses all CIs and components within a cluster node back to a single node. Also, collapses a virtual group that has been expanded. This option only appears if the node has been expanded using the **Expand** menu item.  
  If **Load More** was previously used, then **Expand** reverts the results of the **Load More** operation. |
| Run Layout From Here | This option re-runs the chosen layout using the current node. Use this option to get a new or clearer view on the same map. |
| Load More            | Starting at the selected icon, loads the next level of the map, past the setting of **Max Levels**.  
  Virtual grouping is not applied at the newly loaded level even if the criteria for virtual grouping is met. |
The number of additional icons to display is bound by the value of the `glide.bsm.max_nodes` property.

**Relationship menu**

The following options are available if you right-click a relationship link.

<table>
<thead>
<tr>
<th>View Relationship Form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Relationship Form</td>
<td>Opens the CI Relationship form. You can modify the Parent, Type, and Child of the relationship from this form.</td>
</tr>
<tr>
<td>Modify Relationship</td>
<td>Searches for and selects a new relationship for this link.</td>
</tr>
<tr>
<td>Delete Relationship</td>
<td>Deletes a relationship. The relationship is deleted after prompting for confirmation.</td>
</tr>
</tbody>
</table>

**Cluster nodes in a Dependency Views map**

Dependency Views maps can display cluster group nodes alongside individual CI nodes, and the child nodes of these cluster groups.

Clusters are CIs in the Cluster [cmdb_ci_cluster] table. A cluster CI is an organized set of computer CIs that work together as a single system. Each node in a cluster group represents a CI, typically a server, that can have referenced hardware, such as disks and network adapters.

Cluster nodes on a Dependency Views map can display in two modes:

- **Collapsed mode**: Displays only the cluster CI node without its child CI nodes. This mode avoids unnecessary clutter in large maps.
- **Expanded mode**: Displays the cluster CI node and all its child CI nodes.

Menu options available for a clustered node include **Collapse** and **Expand** which allow you to control the density on the map.

By default, Dependency Views collapses all cluster groups and displays clusters in collapsed mode on the map.

**Annotation**

Icons for cluster nodes and cluster group CI nodes are noted by the string "Cluster" and by a unique cluster icon. The system searches through all the component nodes in a cluster CI or collapsed node looking for tasks, outages, and trouble, such as incidents, problems, or change requests. This search evaluates only the number of levels that are displayed in the diagram.
Virtual grouping of nodes in a Dependency Views map

To reduce the density on a map, Dependency Views automatically groups CIs of a similar CI type from the same level.

A large number of nodes can cause a Dependency Views map to become too dense to be helpful. Therefore, if the number of nodes with a similar CI type from same level, exceeds the value of the Maximum number of nodes (of a similar CI type and at the same level) to display before applying virtual grouping property, then those nodes are automatically grouped into a virtual group. A single node, the virtual group node is displayed to represent the virtual group, while all actual nodes in the virtual group (that are of a similar CI type), are hidden. Virtual group nodes represent CIs of a similar CI type but are not CIs by themselves and cannot have tasks assigned to them. The number of actual collapsed nodes in the virtual group is noted on the virtual group node.
By default, child nodes of a virtual group are not displayed. You can enable the **Show children of virtual groups** property to display child nodes underneath virtual groups.

Virtual grouping is not applied at the level underneath a virtual group even if the criteria for virtual grouping is met (the number of nodes with a similar CI type from that level exceeds the preconfigured property value). However, virtual grouping can happen at the following level if that criteria is met. This behavior does not depend on any property settings, and you cannot change it.

Menu options for a virtual group include **Expand** and **Collapse**, which allow you to apply virtual grouping and display only the virtual group node, or to undo the virtual grouping and display all actual nodes.

**Virtual links**

A virtual node is connected to other nodes with a **virtual link**. A virtual link denotes that there such link between at least one CI in the virtual group, to another CI node on the map.

⚠️ **Note:** Predefined filters do not apply to virtual groups. Therefore a virtual group displays even if it contains CIs that a predefined filter would have excluded. Upon the expansion of a virtual group, predefined filters are applied, and any or all of the CIs that were previously virtually grouped, might no longer display on the map.

Also, when using the node menu option **Load More**, virtual grouping is not applied at the newly loaded level even the criteria for virtual grouping is met.
Related reference

Properties for Dependency Views

Use Dependency Views

Use the layout controls on a Dependency Views map to display elements in different configurations for easier management. Use the filter panel on the map to display fewer levels or to filter out elements you don’t want to see, then save the filter for use later. Draw new relationships between elements or edit existing relationships.

View a Dependency Views map

When you display a Dependency Views map using one of the options below, the map is centered on the root CI, and displays the layout and number of levels defined in the map properties. If Operational Intelligence is activated, then a Dependency Views map provides a mode that lets you directly access metrics information for the CIs on the map.

Before you begin

General role requirements:
To access a Dependency Views map from either the navigation menu, a script API, or directly from a URL, the minimum role required is the dependency_views. Some operations that are related to icons, indicators, and menu actions require the ecmdb_admin role. Some operations that are related to properties and dependency types require the admin role.

Dependency Views enforces ACL permissions on CIs, and visually hides them and their relationship from the map if the permission requirement is not met.

About this task
The maps generated by Dependency Views are based on D3 and Angular technology, providing a modern interactive graphical interface to visualize configuration items and their relationships.

If Service Mapping is activated, Dependency Views maps are enhanced to display dependencies that reflect connections in service maps. In addition, the list of related services in the Details section, includes application services, and technical and manual services if Event Management is activated. All CIs that are included in a service, are displayed underneath the service node on the map.

Maps provided by Service Mapping are for application services, including comprehensive maps from the perspective of application services. For more information, see Service Mapping.

Administrators can configure the setting for the default layout of the map and number of levels displayed. When you access the map from a saved view, the map opens using the properties in the saved view, and not the default map properties.

Procedure
Navigate to Dependency Views and open one of these modules:

- **View Map in New Tab**: Opens the map in a new, full screen tab without the application navigator.
- **View Map**: Opens the map in the content pane of the current tab.
- **Saved Views**: Opens a view of a map that you previously saved.

Click a number in the Version column, and then click the ( ) icon.

Save or load a Dependency Views map
In the View Map module, use the menu icon to save and load Dependency Views maps.
Procedure
1. Navigate to **Dependency Views > View Map**.
2. Click the view menu icon ( ).
3. Select **Save View, Load View, or Last View**.

**Delete a saved Dependency Views map view**
Use the **Saved Views** module to delete a previously saved view.

Procedure
1. Navigate to **Dependency Views > Saved Views**.
2. Use the checkbox in the first column of the table to select the map view that you wish to delete.
3. Select **Delete** from the **Actions on selected rows** drop-down menu.

**Change the layout of Dependency Views map**
You can select from different layout options for your Dependency Views map.

Procedure
1. Navigate to **Dependency Views > View Map**.
2. Select one of the following layout options from the menu across the top of the view.
   - **Vertical**: Displays the elements in a vertical tree pattern according to their upstream and downstream relationships. This is the default value for the initial display of the map.
   - **Horizontal**: Displays the elements in a horizontal tree pattern according to their upstream and downstream relationships.
   - **Radial**: Displays the elements in a radial pattern according to their upstream and downstream relationships.
   - **Force**: Centers the elements around the parent CI, regardless of upstream or downstream relationships.
   - **Group**: Groups the elements according to their CI type.
   - **Details**: Displays related alerts, incidents, problems, and related services.
**Related Services** displays application services, and if Event Management is activated then also technical services and manual services. You can double-click a service to display the map in the Event Management dashboard.

**Filter the view of a Dependency Views map**

You can filter a Dependency Views map to display specific types or categories of configuration items.

**About this task**

Use the filter panel to control which elements of the map are displayed and to save versions of a filter for later use.

**Procedure**

1. Navigate to **Dependency Views > View Map**.

2. Click the button to open **Map Settings**. Click a filter strip to expand or collapse it, and to set filter items.

<table>
<thead>
<tr>
<th>Filter panel strips and options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save Custom Settings</strong></td>
<td>Configure desired custom settings, then enter a name and click <strong>Save</strong>. Custom settings can be loaded by using the <strong>Load Saved Custom Settings</strong> option. Navigate to <strong>Dependency Views &gt; Saved Settings</strong> to display all saved custom settings.</td>
</tr>
<tr>
<td><strong>Load Custom Settings</strong></td>
<td>Apply previously saved custom settings to the current map.</td>
</tr>
<tr>
<td><strong>Predefined Filters</strong></td>
<td>Apply previously defined filters consisting of configuration type, CI type, and relationship filters. You can <strong>Set a predefined filter as default</strong>. This filter is applied first, before any other filters (such as <strong>Filter CIs by Depth</strong>) are applied.</td>
</tr>
<tr>
<td><strong>Dependency Type</strong></td>
<td>Apply a filter that runs in real time and generates a custom view of a service map for a specific CI.</td>
</tr>
</tbody>
</table>
### Filter panel strips and options

<table>
<thead>
<tr>
<th>Filter panel strips and options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Max Levels</strong></td>
<td>Designate how many levels from the root CI display on the map.</td>
</tr>
<tr>
<td><strong>Filter CIs by Depth</strong></td>
<td>Designate which levels of CI display on the map.</td>
</tr>
<tr>
<td><strong>Filter CIs by CI Type</strong></td>
<td>Designate what CI types display in the map.</td>
</tr>
<tr>
<td><strong>Filter CIs By CI Location</strong></td>
<td>Designate what CI locations display in the map.</td>
</tr>
<tr>
<td><strong>Filter CIs By CI Manufacturer</strong></td>
<td>Designate what CI manufacturers display in the map.</td>
</tr>
<tr>
<td><strong>Filter CIs By Audit Failure</strong></td>
<td>Hides CIs that failed the CMDB health staleness test. This option is available only if there are any such CIs.</td>
</tr>
<tr>
<td><strong>Filter Relationship Types</strong></td>
<td>Designate what relationship types display in the map.</td>
</tr>
<tr>
<td><strong>Map Indicators</strong></td>
<td>Designate what types of tasks display and get counted in the map.</td>
</tr>
<tr>
<td><strong>Remove Filtered Items</strong></td>
<td>Off: Gray out filtered items on the map. &lt;br&gt;On: Do not display filtered items on the map.</td>
</tr>
<tr>
<td><strong>Run Layout Automatically</strong></td>
<td>On: The configured layout to the map is reapplied whenever the filter is changed. &lt;br&gt;Off: The map layout remains static when the filter is changed.</td>
</tr>
<tr>
<td><strong>Fit to Screen Automatically</strong></td>
<td>On: The map magnification will increase or decrease automatically to display all CIs on the map. &lt;br&gt;Off: The map magnification remains unchanged when the map is reloaded.</td>
</tr>
</tbody>
</table>

---

**View metrics for CIs in a Dependency Views map**

Operational Intelligence processes metrics data for CIs, calculates statistics and aggregations, and detects metrics anomalies. A Dependency Views map lets you switch to metrics mode to directly access the Insights Explorer that displays metrics data for CIs on the map.
Before you begin
The Operational Intelligence (com.snc.sa.metric) plugin must be activated to enable this functionality, and metrics data needs to be processed for the CIs on the Dependency Views map.

About this task
Open a Dependency Views map in metric mode which integrates a Dependency Views map with the Insights Explorer functionality that is tailored to the map. In this mode, you can access Insights Explorer functions directly from the map, to explore metrics data for the CIs on the map. All map CIs are accessible in the right hand side pane, from where you can drill into metrics data.

Procedure
1. Navigate to Dependency Views > View Map to open a map.
2. Right-click on a CI on the map and select View Metrics to open the Dependency View map in metrics mode.
   In the panel on the right side, the CI that you selected on the Dependency View map is selected by default, and the list of all the metrics available for that CI are displayed.
3. Click the ‘<’ sign on the left of the CI to display all the CIs that you can explore metrics for.
   The Insights Explorer is scoped for exploring only the CIs that currently display on the Dependency Views map, and you cannot add or remove CIs from the list. If you use map settings or filters to filter out CIs from the map, the same filtering will apply to the list of CIs that you can explore metrics for.
4. Click on a CI in the CIs list or right-click on a CI on the Dependency Views map, to drill down to the CI’s metrics.
5. Click the Dependencies Map tab or the Metrics tab to switch modes:
   a. In Metrics mode: The full functionality of the Insights Explorer is available, you can create metric charts by dragging metrics into the canvas. You can modify chart settings, select different time ranges for the charts, and perform other actions as described in View metric values in the Insights Explorer.
   b. In Dependencies Map mode: Select a CI on the map to drill down to its metrics data, drop-down the Layout list to choose a different layout, or modify map settings.

Perform actions on nodes in a Dependency Views map
You can view various related items for the nodes in a Dependency Views map.
About this task
If the node is a collapsed node or represents a cluster, the incidents, problems and change requests are for all the collapsed nodes.

Procedure
1. Navigate to **Dependency Views > View Map**.

2. Click the ▼ icon next to a node or right-click a node on the map, to access the following menu items:

<table>
<thead>
<tr>
<th>Node Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Form</td>
<td>Displays the CMDB record of the selected CI in a new tab of the browser.</td>
</tr>
<tr>
<td>View Map</td>
<td>Reloads the view using the selected CI as the new root node, with the currently defined layout setting. This option does not display on the root node.</td>
</tr>
<tr>
<td>View Related Tasks</td>
<td>Displays all tasks or outages associated with the selected CI, including incidents, problems, change requests, and follow-on tasks. This option is always available, even if there are no tasks associated with the CI. This option does not appear on collapsed nodes.</td>
</tr>
<tr>
<td>View Affected CIs</td>
<td>Shows a list of all tasks that have the CI listed as an Affected CI. This option is only visible when you access the view from the view icon in a task record's Configuration item field.</td>
</tr>
<tr>
<td>View Related Outages</td>
<td>Displays all outages involving the selected CI. This option only appears when there is an outage associated with the CI. This option does not appear on collapsed nodes.</td>
</tr>
<tr>
<td>Add Relationship</td>
<td>This option displays a dotted green line that you can drag to another CI to create a relationship link. A popup dialog allows you to define the relationship type.</td>
</tr>
<tr>
<td>Expand</td>
<td>Displays all CIs and components within a cluster node or a collapsed node. This option only appears if the node is a collapsed or cluster node. The number of additional icons to display is bound by the value of the glide.bsm.max_nodes property.</td>
</tr>
<tr>
<td>Collapse</td>
<td>Collapses all CIs and components within a cluster node or a collapsed node back to a single node. This option only appears if the node has been expanded using the Expand menu item.</td>
</tr>
<tr>
<td>Run Layout From Here</td>
<td>This option re-runs the chosen layout using the current node. Use this option to get a new or clearer view on the same map.</td>
</tr>
</tbody>
</table>
Load More

Starting at the selected icon, loads the next level of the map, past the setting of **Max Levels**.

The number of additional icons to display is bound by the value of the `glide.bsm.max_nodes` property.

## Export a Dependency Views map

You can export a Dependency Views map to an image in PNG format.

**Procedure**

1. Navigate to **Dependency Views > View Map**.
2. Configure the map view as you want the image to appear. The exported image displays the current view of the map.
3. Click the view menu icon (Ionic icon).
4. Click **Export Image**.
5. Right-click the image and select **Save Image As, Print**, or any other menu option.

   **Note:** You cannot export images from a Dependency Views map using Internet Explorer as your browser.
6. Click the "X" button to close the **Export Image** window.

## View collapsed nodes in a Dependency Views map

Cluster and virtually grouped nodes can be displayed in a collapsed mode to avoid unnecessary clutter in large maps.

**Procedure**

1. To expand a collapsed node, right-click the CI and select **Expand** from the context menu.
2. To collapse an expanded cluster node with children, right-click the CI and select **Collapse** from the context menu.

## Administer Dependency Views

Users with the admin role can control the appearance and behavior of Dependency Views by configuring map indicators, map related items, map icons, and menu actions.
Create or modify map indicators

Dependency Views maps and application service maps, use icons to display additional information for a CI by displaying its related records such as alerts, outages, incidents and problems. These icons are called map indicator.

About this task
The default configuration includes map indicators for the following record types:

- Open incident.
- Open alert.
- Unplanned current outage.
- Planned current outage, or an open problem.
- Current, planned, or recent change request.

You can filter out the display of affected CIs, alerts, current change requests, incidents and problems from the map settings menu.

The Affected CI’s map indicator appears for CIs in two related but not identical situations. It appears for CIs for which tasks such as change request, incident, or problem were directly created for, and for any CIs that were added in those tasks (parent tasks) as Affected CIs (The CI for which a task is directly created for, is automatically added as an affected CI in that task). The state of affected CI's depends on the status of the respective parent task. For as long as the parent task is active, the associated affected CIs continue to be impacted by the task issue. In a map, the Affected CI’s indicator displays for all affected CIs for as long as the parent task is active. On a map, the Affected CI tooltip displays the details of the task records in which the CI was added as an affected CI. However, the Details pane does not contain an Affected CI’s tab, and no further details about affected CIs, or the associated tasks are displayed. After the parent task is closed, the Affected CI’s indicator no longer displays for any of the tasks’ affected CIs. For information about affected CIs in Change Management, see Associate CIs to a change request.

Note: Details about affected CIs are derived from the task and the cmdb_ci tables and their extensions. Therefore, if you use custom tables to store CIs for incidents, problems and changes, it affects the details that are displayed for affected CIs.

For more information on how map indicators are used to show tasks and outages in clusters and collapsed nodes, see Cluster nodes in a Dependency Views map.
Procedure

1. Navigate to Dependency Views > Map Indicators.

2. Click New to create a new map indicator, or click the name of an indicator from the Table column to modify an existing map indicator.

3. Fill in the fields on the form, as appropriate.

Map Indicator form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Name of the table represented by this map indicator.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The list shows only tables and database views that are in the same scope as the map indicator. Views are not supported, although included in the list.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the indicator.</td>
</tr>
<tr>
<td>Order</td>
<td>Priority order of the task. The highest priority task is the indicator with the lowest order number.</td>
</tr>
<tr>
<td>Icon</td>
<td>File name and path of the icon image file, which can be a system image.</td>
</tr>
<tr>
<td></td>
<td>•To create a new icon, see Create or modify map icons</td>
</tr>
<tr>
<td></td>
<td>•To create or use a system image see Storing images in the database.</td>
</tr>
<tr>
<td>CMDB CI field</td>
<td>Name of the field on the selected table that contains the configuration item.</td>
</tr>
<tr>
<td>Start field</td>
<td>The record property that determines the time-point on the metric chart timeline for placing records in the Insights Explorer. Possible values depend on the selected Table. For example, the incident indicator has values such as Actual end, Actual Start, and Approval Set.</td>
</tr>
<tr>
<td>Description field</td>
<td>Name of the field on the selected table that contains the description of the configuration item.</td>
</tr>
<tr>
<td>Description</td>
<td>Text to display when hovering over the indicator. Alphanumeric characters and spaces are valid for this field.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Condition builder that specifies for which CIs to apply this indicator. For example, a CI that has a current past outage is highlighted for 5 days. You can configure a condition to</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Active in Service Map</td>
<td>Enable to make the toggle for the specified table available in the Settings dialog box for application service maps. You can then toggle between displaying or not displaying the respective records on the map.</td>
</tr>
<tr>
<td>Active Dependencies</td>
<td>Enable to make the toggle for the specified table available in the Settings dialog box for Dependency Views maps. You can then toggle between displaying or not displaying the respective records on the map.</td>
</tr>
<tr>
<td>Active in Metrics</td>
<td>Enable to make the toggle for the specified table available in the Settings dialog box for the Insights Explorer. You can then toggle between displaying or not displaying the respective records on the Insights Explorer.</td>
</tr>
<tr>
<td>Label</td>
<td>Text to display for the indicator on the map.</td>
</tr>
<tr>
<td>Tooltip Label</td>
<td>The prefix portion of the tooltip (Tooltip Label : Tooltip info).</td>
</tr>
<tr>
<td>Tooltip Info</td>
<td>The suffix portion of the tooltip (Tooltip Label : Tooltip info).</td>
</tr>
</tbody>
</table>

4. Click **Submit** to enter a new map indicator. Click **Update** to modify an existing map indicator.

**Results**

For an indicator to appear in a Dependency Views map, a CI must meet all filter conditions, and **Active Dependencies** must be selected.

**Create or modify map icons**

You can upload new icons or modify existing icons to customize the icon displayed for a CI in maps in Dependency Views, Service Mapping, and Event Management.

**About this task**

The icons used in Dependency Views maps are listed in the Map Icons module. Records in the Map Icons list are arranged by CI classes, such as cmdb_ci_linux_server. The path to the default image files is https://<instance name>.service-now.com/images/app.ngbsm/<image name.svg>. For information about uploading images to the database, see Storing images in the database.

Role required: admin or cmdb_admin roles are required to access the records in this table [ngbsm_icon] to upload new icons.
Procedure

• Navigate to Configuration > CI Class Manager, and:
  1. Click Hierarchy to display the CI Classes list.
  2. Select a class to modify the icon for.
  3. In the class navigator bar, expand Class Info and then select Basic Info. On the Basic Info form, click Icon.
  4. In the Icons dialog box, select an icon and then click Update.
  5. On the Basic Info form, click Update.

• Navigate to Dependency Views > Map Icons, and:
  1. Click New to create a new map icon or click the name of an existing icon in the Label column to modify an existing icon.
  2. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Type</td>
<td>Label or the informal name of the CI table that this icon represents in the view.</td>
</tr>
<tr>
<td>Icon</td>
<td>Name of the icon.</td>
</tr>
<tr>
<td>URL</td>
<td>Path to the icon image using the following format: /image name.svg Click the lock icon to enter a new path.</td>
</tr>
</tbody>
</table>

  3. Fill in the fields on the form, as appropriate.
  4. Click Submit to enter a new icon. Click Update to modify an existing icon.

What to do next
You can modify a Dependency Views map indicator to use the new icon.

Create a predefined filter
Create filters to narrow down the CIs that are displayed on a Dependency Views map. You can create filters that are based on CIs' class, CIs' attributes, or CIs' relationships.

Before you begin
Role required: ecmdb_admin
About this task
Create a predefined filter that you can then select to determine the scope of the CIs that are displayed in a Dependency Views map. Configuration type filters filter by CI class, CI filters filter by CI attributes, and relationship filters filter by relationships. Only CIs that match at least one of the configuration type filters (if any exists), and at least one of the CI filters (if any exists), and at least one of the relationship type filters (if any exists) - are displayed on the map. If no filters are defined, then no filtering is applied.

Note: Predefined filters do not apply to virtual groups. Therefore a virtual group displays even if it contains CIs that a predefined filter would have not included. Upon the expansion of a virtual group, predefined filters are applied, and any or all of the CIs that were previously virtually grouped, might no longer display on the map.

Procedure
1. Navigate to Dependency Views > Predefined Filters.
2. On the Predefined Filters page, click New.
3. Type in a Name for the filter. Click Roles, and in the Roles dialog box, select the roles that this filter will be available for.
4. Right-click on the page header, and click Save.
5. To create a configuration type filter:
   a. Click Configuration Types, and then click Edit.
   b. In the Collection slushbucket, select the classes that CIs must belong to in order to be displayed on the map, and move them to the Configuration Types List.
   c. Click Save.
6. To create a CI filter:
   a. Click CI Filters, and then click New.
   b. In the CI Filters page enter conditions to filter CIs by specific attribute values.
   c. Click Submit.
7. To create a relationship type filter:
   a. Click Relationship Type, and then click New.
   b. In the Collection slushbucket, select the relationships that CIs must have in order to be displayed on the map, and move them to the Relationship Types List.
   c. Click Save.
What to do next
After creating a predefined filter, you can apply it to a map:

1. Click the icon to open Map Settings.
2. Select a filter from the Predefined Filters list.
3. Click Apply.

Related information
Filter the view of a Dependency Views map

Set a predefined filter as default
You can set a custom predefined filter as the default predefined filter for viewing maps.

Procedure
1. Create the custom predefined filter to be used as the default predefined filter.
2. On the predefined filter form, click the context menu and select Copy sys_id.
3. Navigate to User Administration > User Preferences.
4. Click New and create a new user preference record using these values:
   - Name: ecmdb.ciview
   - Type: String
   - Value: Paste the sys_id of the custom predefined filter
   - User: Leave blank to create a system-wide setting
   - Description: Description of the predefined filter
   - System: Selected
5. Click Submit.

What to do next
In Map Settings, when you select the Default option for Predefined Filters, the custom predefined filter that was set, will be applied.

Related information
Filter the view of a Dependency Views map
Create or modify Map Related Items

The Map Related Items module relates referenced CIs to one another, which allows them to be displayed in a Dependency Views map.

About this task

The base system configuration includes the following tables and relates them to items in the Computer [cmdb_ci_computer] and Server [cmdb_ci_server] tables.

- Disk [cmdb_ci_disk]
- Network Adapter [cmdb_ci_network_adapter]
- Database [cmdb_ci_database]

Some additional referenced CIs that can be related in this manner are file systems and running processes.

In the following example, computer nodes in the map are related to network adapter nodes if the Configuration Item field of the adapter records reference the specific CI node. Access or create a network adapter record from the Network Adapter related list in the cmdb_ci_computer record.

The Dependency Views map for the *JEMPLOYEE-IBM computer shows the network adapter attached to the computer.
You can configure Dependency Views to display CIs that have no relationship record, but are related to other CIs by reference fields.

**Procedure**

1. Navigate to **Dependency Views > Map Related Items**.
2. Click **New** to create a new related item, or click in the row of an existing CI to modify an existing map related item.
3. Fill in the fields on the form, as appropriate. See the Related Items form table.
4. Click **Submit** to enter a new map related item. Click **Update** to modify an existing map related item.

**Related Items form**

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration item</td>
<td>CI that represents the base node or a CI in a table that extends the base node table. In the base system, the configuration item that represents the base node is Computer [cmdb_ci_computer], which includes all types of workstations and servers.</td>
</tr>
<tr>
<td>Related item</td>
<td>Table name of the related item. Only the cmdb_ci table and tables that extend it are displayed in the choice list.</td>
</tr>
<tr>
<td>Related field</td>
<td>Field that links this related item to the configuration item. In many cases, the appropriate value is automatically</td>
</tr>
</tbody>
</table>
Create or modify Dependency Views menu actions

To modify an existing menu option, first you create a copy of the original menu action record, and then you modify the copy.

About this task
This ensures that your instance can update the record normally during the upgrade process and allows you to quickly restore the original menu option, if necessary.

Procedure
1. To create a new menu option, navigate to **Dependency Views > Map Menu Actions** and click **New**.
   Fill in the fields on the form, as appropriate. See the Menu Action form table.
2. To modify an existing menu option, navigate to **Dependency Views > Map Menu Actions**.
3. Open the menu action you want to edit.
4. Right-click in the header and click **Insert and Stay**.
   This step creates a duplicate copy of the menu action and leaves it open for editing.
5. Change the name of the copied record to avoid confusion.
6. Modify the form fields as necessary and save the record.
7. Open the original record and disable it by clearing the **Active** check box.

Menu Action form

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name that appears as the menu option.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that allows you to enable or disable this record.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition that triggers the display of this menu option. If the condition evaluates to <strong>false</strong> the menu option does not display. Script is evaluated in JavaScript in the user's browser and does not have access to all the APIs that Business Rules do. For details on available parameters, see Condition Parameters.</td>
</tr>
</tbody>
</table>
# Control and script parameters for menu actions

You can use the following condition and script parameters for menu actions.

## Condition parameters

**Note:** The usual regular expression conventions are valid in the condition field, such as `!` for NOT, `&&` for AND, and `||` for OR.

The **Condition** field contains a boolean expression that evaluates to true or false. If the condition is true or if there is no condition, the specified option appears in the menu when you right-click a CI or a relationship link. When you select the option from the menu, ServiceNow executes the associated script.

### Common Elements for Building a Condition

<table>
<thead>
<tr>
<th>Text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>item</td>
<td>Node or reference link's data on which you performed the right-click action.</td>
</tr>
<tr>
<td>item.label</td>
<td>Label of the node.</td>
</tr>
<tr>
<td>item.ci_type</td>
<td>CI's type (table), such as <code>cmdb_ci_service</code>.</td>
</tr>
</tbody>
</table>
### Common Elements for Building a Condition (continued)

<table>
<thead>
<tr>
<th>Text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>item.name</td>
<td>Name of CIs. CI’s type name or the table label.</td>
</tr>
<tr>
<td>item.location</td>
<td>Location of the CI, such as New York.</td>
</tr>
<tr>
<td>item.manufacturer_name</td>
<td>Name of the CI’s manufacturer, such as Dell Inc.</td>
</tr>
<tr>
<td>item.id</td>
<td>The sys_id of the CI.</td>
</tr>
<tr>
<td>item.is_selected</td>
<td>The item that is selected in the map.</td>
</tr>
<tr>
<td>item.level</td>
<td>The current default level.</td>
</tr>
<tr>
<td>item.locationId</td>
<td>The sys_id of the CI node’s location.</td>
</tr>
<tr>
<td>item.locationName</td>
<td>The full address of the location.</td>
</tr>
<tr>
<td>item.manufacturerId</td>
<td>The sys_id of the CI’s manufacturer.</td>
</tr>
</tbody>
</table>

### Valid Conditions for Condition Parameters

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>item.isCollapsed</td>
<td>The node is a collapsed node.</td>
</tr>
<tr>
<td>item.is_cluster</td>
<td>The node is a cluster node.</td>
</tr>
</tbody>
</table>

### Script parameters

Menu action scripts are executed on the client when a user clicks the menu option. You can use the same building blocks in scripts as in conditions. Menu action scripts do not function on separators. These are some additional, useful expressions for scripts:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>item.id</td>
<td>The sys_id of the CI node or relationship link.</td>
</tr>
<tr>
<td>item.source</td>
<td>The sys_id of the relationship's parent or child.</td>
</tr>
<tr>
<td>item.target</td>
<td>The sys_id of the relationship's parent or child.</td>
</tr>
<tr>
<td>item.label</td>
<td>The name of the CI node, such as IronMail-SD-02.</td>
</tr>
<tr>
<td>item.location</td>
<td>The sys_id of the CI node’s location.</td>
</tr>
</tbody>
</table>
**Create or edit a dependency type**

Use one of the dependency types provided, or create a custom dependency type with a script that will execute in real time to generate a custom view of a Dependency Views map for a specific CI.

**About this task**

Create a JavaScript to customize the map. The script must comply with JavaScript syntax guidelines and the directions in the default script template, and it can call platform APIs. Use a dependency type, for example:

- To narrow down and simplify a map, leaving out CIs that are not important for a specific task.
- To include only specific CIs that are hidden by default, such as qualifiers, endpoints, and entry points.
- To display virtual relationships that are calculated, and that otherwise do not exist in the CMDB.
- As a tool to plan a new topology deployment that is based on existing resources.

The following dependency types are available in the base system:

**Default**

The default setting in the base system. With this setting, there is no processing of the dependency map through any dependency type scripts that might filter or modify the map.

**Show All Relationships**

Returns all qualifiers, end points, and entry points. This dependency type is available in the base system and is disabled by default. Typically, you would enable this dependency type for debugging and tracking purposes.

The following dependency types are available with Service Mapping:

**Application to Network Devices**

Returns the network devices in the network paths leading to/from the given CI.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>item.location_name</td>
<td>The full address of the location, such as 4616 Clairemont Drive, North Clairemont, San Diego CA.</td>
</tr>
<tr>
<td>item.manufacturer_id</td>
<td>The sys_id of the CI's manufacturer.</td>
</tr>
</tbody>
</table>
Network Device to Applications

Returns the applicative CIs which are target or source of network paths containing the given network device. In addition, returns the hosts of those applicative CIs, and for an applicative CI that is an inclusion, its parent CI is returned too.

Physical Network Connections

Returns hosts/network devices that are physically connected to the given host or network device.

Flow Dependencies

Returns all the server to server connections that were discovered using the Netflow collector. The script builds a graph based on data in the [sa_flow_server_comm] table. This table contains pairs of services represented by an IP and a listening port that are communicating with each other. For more information, see Data collection and discovery using Netflow and Data collection and discovery using VPC Flow Logs.

Procedure

1. Navigate to Dependency Views > Dependency Types.
2. In the Load Filter Scripts list view, select an existing dependency type, or click New.
3. Enter or modify a script, adhering to the guidelines and requirements in the script template that is provided.
4. Click Submit.

Results

In a Dependency Views map, you can click Dependency Type to apply a custom script defined in a dependency type.

Related information

Data collection and discovery using Netflow

Properties for Dependency Views

Use Dependency Views properties to configure how data appears in Dependency Views maps.

These properties are available for Dependency Views. To view and edit these properties, the admin role is required.

© 2021 ServiceNow, Inc. All rights reserved.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Type</th>
<th>Default value</th>
<th>Possible values</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.bsm.max_nodes</td>
<td>The maximum number of nodes to retrieve from the database. If more nodes exist in the database, they are not displayed in the map.</td>
<td>Integer</td>
<td>1000</td>
<td>1-49</td>
<td>Dependency Views &gt; Map Properties</td>
</tr>
<tr>
<td>glide.bsm.max_levels</td>
<td>Level depth is the graph distance between the root CI and a node.</td>
<td>Integer</td>
<td>3</td>
<td>1-49</td>
<td>Dependency Views &gt; Map Properties</td>
</tr>
<tr>
<td>glide.bsm.show_virtual_node_children</td>
<td>Display the continuation of the map underneath virtual group. Virtual links are used to connect virtual groups to their child nodes.</td>
<td>Yes</td>
<td>No</td>
<td>Dependency Views &gt; Map Properties</td>
<td></td>
</tr>
<tr>
<td>glide.bsm.too_many_children</td>
<td>Maximum number of child nodes to display (the rest will be collapsed).</td>
<td>Integer</td>
<td>1000</td>
<td>1-49</td>
<td>Dependency Views &gt; Map Properties</td>
</tr>
<tr>
<td>glide.bsm.too_many_children</td>
<td>Maximum number of nodes (of a similar CI type and at the same level) to display before applying virtual grouping. Nodes are collapsed for the map to meet this limit.</td>
<td>Integer</td>
<td>1000</td>
<td>1-49</td>
<td>Dependency Views &gt; Map Properties</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>glide.ngbsm.filters_remove_filtered_items</td>
<td>A value of true indicates that filtered out items will be removed from the graph along with any disconnected children while a value of false indicates that the items will be dimmed in color.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>glide.bsm.max_num_rels</td>
<td>Maximum number of relations per node. The maximum number of relations to retrieve from the database. If more relations exist in the database, they are not displayed in the map.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>glide.ngbsm.filters_run_layout_automatically</td>
<td>A value of true indicates that when filters are changed the graph will recalculate its layout using the currently selected layout algorithm.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>glide.ngbsm.filters_fit_to_screen_automatically</td>
<td>A value of true indicates that when filters are changed the graph will be fit to the screen automatically.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Properties for Dependency Views (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ngbsm.performance_allow_curves</td>
<td>A value of true allows relationship lines to be drawn using smooth curves instead of straight line segments. These curves can be more taxing on the browser, setting to false may improve fluidity of animation and interaction for Dependency Views.</td>
</tr>
</tbody>
</table>
| Amount of time in milliseconds a notification stays on the screen. | **Type:** Integer  
**Default value:** 5000  
**Location:** Dependency Views > Map Properties |
| glide.ngbsm.notification_display_time               | The maximum amount of results displayed when searching for CIs.                                                                                         |
| The maximum amount of results displayed when searching for Relationship Types. | **Type:** Integer  
**Default value:** 5  
**Location:** Dependency Views > Map Properties |
| glide.ngbsm.search_ci_limit                        | When available, the map should display the class labels for each CI.                                                                                         |
| glide.ngbsm.show_class_labels                      | Truncate node labels to a single line and to fit available space (default). Disable to display entire labels on multiple lines and wrapped as needed. |

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Properties for Dependency Views (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Minimum horizontal distance between nodes in horizontal layout.  
glide.bsm.layout_horizontal_spacing_x | The distance is measured in pixels between one node’s center to another node’s center.  
- Type: Integer  
- Default value: 200  
- Location: Dependency Views > Map Properties |
| Minimum vertical distance between nodes in horizontal layout.  
glide.bsm.layout_horizontal_spacing_y | The distance is measured in pixels between one node’s center to another node’s center.  
- Type: Integer  
- Default value: 100  
- Location: Dependency Views > Map Properties |
| Minimum horizontal distance between nodes in vertical layout.  
glide.bsm.layout_vertical_spacing_x | The distance is measured in pixels between one node’s center to another node’s center.  
- Type: Integer  
- Default value: 125  
- Location: Dependency Views > Map Properties |
| Minimum vertical distance between nodes in vertical layout.  
glide.bsm.layout_vertical_spacing_y | The distance is measured in pixels between one node’s center to another node’s center.  
- Type: Integer  
- Default value: 200  
- Location: Dependency Views > Map Properties |
Properties for Dependency Views (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Type: Integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 125</td>
</tr>
<tr>
<td></td>
<td>• Location: Dependency Views &gt; Map Properties</td>
</tr>
</tbody>
</table>

Components installed with Dependency Views

Several types of components are installed with the activation of the Next_Gen BSM (com.snc.ng_bsm) plugin, such as tables.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available CI icons</td>
<td>Stores all available CI class icons.</td>
</tr>
<tr>
<td>[ngbsm_ci_icons]</td>
<td></td>
</tr>
<tr>
<td>Icons for CI types</td>
<td>Maps icons to CI class names.</td>
</tr>
<tr>
<td>[ngbsm_ci_type_icon]</td>
<td></td>
</tr>
<tr>
<td>Map Script</td>
<td>Custom scripts that run in real time and generate a custom view of a map for a specific CI.</td>
</tr>
<tr>
<td>[ngbsm_script]</td>
<td></td>
</tr>
<tr>
<td>Map View</td>
<td>Serialized map views saved by users.</td>
</tr>
<tr>
<td>[ngbsm_view]</td>
<td></td>
</tr>
<tr>
<td>Map Filter</td>
<td>Filters saved by users.</td>
</tr>
<tr>
<td>[ngbsm_filter]</td>
<td></td>
</tr>
<tr>
<td>Menu Action</td>
<td>Default and custom context menu actions that appear when users right click a map.</td>
</tr>
<tr>
<td>[ngbsm_context_menu]</td>
<td></td>
</tr>
<tr>
<td>Related Item</td>
<td>Stores which reference fields should be treated as relationships when building the map. This allows users</td>
</tr>
<tr>
<td>[ngbsm_related_item]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Edge Colors</td>
<td>Color definitions to use when drawing the relationships between nodes based on relationship type.</td>
</tr>
<tr>
<td>[bsm_edge_color]</td>
<td></td>
</tr>
<tr>
<td>Map Indicator</td>
<td>Stores all map indicators.</td>
</tr>
<tr>
<td>[bsm_indicator]</td>
<td></td>
</tr>
<tr>
<td>BSM Saved Map</td>
<td>Details of maps.</td>
</tr>
<tr>
<td>[bsm_graph]</td>
<td></td>
</tr>
<tr>
<td>BSM Map Actions</td>
<td>Actions on the map.</td>
</tr>
<tr>
<td>[bsm_action]</td>
<td></td>
</tr>
<tr>
<td>BSM Map View</td>
<td>Parents' predefined filters.</td>
</tr>
<tr>
<td>[map_view]</td>
<td></td>
</tr>
<tr>
<td>Map View Configuration Types</td>
<td>Configuration type filters, limiting the CI class types to be displayed, per predefined filter.</td>
</tr>
<tr>
<td>[map_view_ci_type]</td>
<td></td>
</tr>
<tr>
<td>Map View Relationship Types</td>
<td>Relationship type filters, limiting the links to be displayed between CIs, per each predefined filter.</td>
</tr>
<tr>
<td>[map_view_rel_type]</td>
<td></td>
</tr>
<tr>
<td>[map_viewroles]</td>
<td>Roles that a specific predefined filter should be applied to.</td>
</tr>
<tr>
<td>CI Filters</td>
<td>CI attribute filters, limiting the CIs to be displayed, per predefined filter.</td>
</tr>
<tr>
<td>[map_filter]</td>
<td></td>
</tr>
</tbody>
</table>

### E-signature

Sign electronic documents from any desktop or mobile device with e-signature. E-signature is a scoped application that enables users to sign managed documents or knowledge articles with their typed or drawn e-signature, credentials, or as an acknowledgment.
Role assignment

Before you begin using e-signature, you must assign the e-signature roles to the appropriate roles, groups, or users in your application. See Components installed with e-signature for more information.

How to use e-signature templates

Users with the e-signature administrator [sn_esign.admin] or manager [sn_esign.config_manager] role can create e-signature templates. Each e-signature template pairs a document type to sign (managed document or knowledge article) with a signature type (signature, credential, or acknowledgment). For example, you could create an e-signature template for a non-disclosure agreement that requires a typed or drawn signature.

Configure an e-signature template

You can then use the e-signature template in task forms to request electronic signatures from users. In the HR Service Delivery application, for example, you can add HR tasks to HR cases or configure HR task templates to request electronic signatures per the selected e-signature template. See E-signature for HR for HR-specific examples.

Activation information

To use e-signature in your application, you must activate e-signature. For information on what components are installed with the feature, see Components installed with e-signature.

Activate e-signature

You can activate the e-signature plugin (com.snc.esign) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

About this task
E-signature activates these related plugins if they are not already active.

Plugins for E-signature

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNow document viewer [com.snc.documentviewer]</td>
<td>Document viewer is a platform feature that will enable users to view enterprise class documents inline within the</td>
</tr>
</tbody>
</table>
Plugins for E-signature (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>platform attachment instead of downloading it to the local device and then opening the documents with a locally installed viewer.</td>
</tr>
<tr>
<td>Managed documents</td>
<td>Managed Documents application. To enable the ability to publish to the knowledge base, activate the knowledge document plugin.</td>
</tr>
<tr>
<td>[com.snc.document_management]</td>
<td></td>
</tr>
<tr>
<td>Signature pad</td>
<td>Provides a tool to allow a digital signature in a .pdf document. The Human Resources application uses this with various documents.</td>
</tr>
<tr>
<td>[com.snc.signaturepad]</td>
<td></td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with e-signature

Several types of components are installed with activation of e-signature, including tables and user roles.

   Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.
Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-signature administrator [sn_esign.admin]</td>
<td>Can manage the e-signature module.</td>
<td>• sn_esign.config_manager</td>
</tr>
<tr>
<td>E-signature manager [sn_esign.config_manager]</td>
<td>Can manage the e-signature configurations.</td>
<td>• None</td>
</tr>
</tbody>
</table>

You can assign these roles to the appropriate roles, groups, or users in your application.

• To assign a role to another role, see Add a role to an existing role.
• To assign a role to a group, see Assign a role to a group.
• To assign a role to a user, see Assign a role to a user.

For further information on user administration and how to manage users, see User administration.

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-Signature Configuration [sn_esign_configuration]</td>
<td>E-signature configuration table.</td>
</tr>
<tr>
<td>E-Signature Acknowledgement [sn_esign_acknowledgement]</td>
<td>E-signature acknowledgment table.</td>
</tr>
</tbody>
</table>

For further information on table administration and how to manage data, see Table administration.

Configure an e-signature template

Create or modify an e-signature template to define an electronic document and signature configuration for use in task forms. Each template is associated with a document type such as a managed document or knowledge article, and you can configure the template so that the signatory is required to sign the document with their typed or drawn signature, credentials, or as an acknowledgment.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Before you begin
Role required: sn_esign.admin or sn_esign.config_manager

Procedure
1. Navigate to **E-signature > E-signature template**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

### E-signature template form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the e-signature template.</td>
</tr>
<tr>
<td>Task table</td>
<td>Task table that the e-signature template is associated with.</td>
</tr>
<tr>
<td>Document type</td>
<td>Document type of the e-signature template. Select one of the following:</td>
</tr>
<tr>
<td>HR document template</td>
<td>(HR Service Delivery only) An HR document template is the document type for signing.</td>
</tr>
</tbody>
</table>

**Note:**
- Make sure that the **Task table** field is set to HR Task [sn_hr_core_task].
- The HR document template that the signatory will sign is selected on the HR case form. See [Select an HR document template for an e-signature task](#) for more information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge article</td>
<td>A knowledge article is the document type for signing. In the <strong>Knowledge article</strong> field, select the knowledge article that the signatory will sign.</td>
</tr>
<tr>
<td>Managed document</td>
<td>A managed document is the document type for signing. In the <strong>Managed document</strong> field, select...</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Signature type</td>
<td>Signature type of the e-signature template. Select one of the following:</td>
</tr>
<tr>
<td>Acknowledgment</td>
<td>The signatory acknowledges the document by accepting and completing the task.</td>
</tr>
<tr>
<td>Note:</td>
<td>This option is not available for HR document templates.</td>
</tr>
<tr>
<td>Credential</td>
<td>The signatory signs the document with their credentials.</td>
</tr>
<tr>
<td>Note:</td>
<td>This option is not available for HR document templates.</td>
</tr>
<tr>
<td>Signature</td>
<td>The signatory signs the document with their typed or drawn signature.</td>
</tr>
<tr>
<td>Acknowledgment text</td>
<td>Adds a check box with accompanying acknowledgment text that the user must select before the signing is completed. This option can be used with any signature type.</td>
</tr>
<tr>
<td>Note:</td>
<td>Acknowledgment text is limited to 1,000 characters.</td>
</tr>
</tbody>
</table>
Example
The following GIF shows an example of an HR agent creating an e-signature template for an intellectual property agreement.

4. Click Submit or Update.

What to do next
You can use the e-signature template in task forms to request electronic signatures from users.

The following GIF shows an example of an HR agent creating an e-signature task for an employee, Eva Seahorn, as part of an HR case.
The following GIF shows an example of the employee, Eva Seahorn, then completing the e-signature to-do in the Employee Service Center.
Edge Encryption

ServiceNow® Edge Encryption™ encrypts sensitive data on your company premises before sending it over the Internet to your ServiceNow instance (encrypted in flight), where it remains encrypted at rest.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Understanding Edge Encryption</td>
<td>• Planning for Edge Encryption</td>
<td>• Key management for Edge Encryption</td>
</tr>
<tr>
<td>• Edge Encryption components</td>
<td>• Edge Encryption system requirements</td>
<td>• Encrypt fields using encryption configurations</td>
</tr>
<tr>
<td>• Encryption configurations and patterns</td>
<td>• Edge Encryption installation</td>
<td>• Encrypt attachments using standard encryption</td>
</tr>
<tr>
<td>• Domain separation and Edge Encryption</td>
<td>• Edge Encryption upgrades</td>
<td>• Tokenize strings using encryption patterns</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Integrate</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Define a custom encryption rule</td>
<td>• Edge Encryption ODBC driver integration</td>
<td>• Ask or answer questions in the Edge Encryption community</td>
</tr>
<tr>
<td>• Schedule an encryption job</td>
<td>• Edge Encryption MID Server integration</td>
<td>• Edge Encryption diagnostics and performance</td>
</tr>
<tr>
<td>• Repair or recover order-preserving encrypted data</td>
<td></td>
<td>• Search the Known Error Portal for known error articles</td>
</tr>
</tbody>
</table>

Understanding Edge Encryption

Edge Encryption is a network encryption system that resides on your network and that encrypts and decrypts sensitive data as it travels between your data center and the ServiceNow cloud.

What is Edge Encryption

The Edge Encryption feature is an additional cost option that provides you with the ability to control the end-to-end encryption of your data and key management. Edge Encryption uses a proxy application, provided by ServiceNow and installed by you within your own network. This proxy application tokenizes specified data patterns or encrypts string fields, Date fields, Date/Time fields, and attachment data before it is sent from your environment to your
instance. The proxy application also decrypts the same data, again only within your own network, using keys stored only within your own network.

The relevant encryption keys and configuration exist only on the Edge proxy within your network and are not visible to ServiceNow. The data is encrypted from the moment it leaves your environment and is only decrypted upon retrieval. At no point is the data accessible in plaintext by ServiceNow systems or personnel.

**Who uses Edge Encryption**

Only a user logged into the instance through a proxy server on your network can view encrypted data in clear text. Likewise, only a security_admin user logged in to an instance through a proxy server in your network can configure and administer Edge Encryption.

Because the proxy server resides in your network, you own and manage the encryption keys, and they are never sent to the instance. As a result, ServiceNow never shows sensitive data in clear text.

In addition to the Edge proxy configuration and management of rules, you are responsible for the usual requirements of operating a server within your environment (including hosting, routing, backup, DNS configuration, etc.) to enable and support your Edge proxies.

**Encryption and tokenization**

Edge Encryption supports both encryption (through encryption configurations) and tokenization (through encryption patterns) as a means of protecting your sensitive information.

**Encryption configurations**

You can encrypt individual fields using encryption configurations. Edge Encryption supports AES 128-bit and AES 256-bit encryption keys. Edge Encryption supports standard, equality-preserving, and order-preserving encryption types.

In addition to attachments, you can encrypt the following field types:

- String
- Date
- Date/Time
- Journal
- Journal Input
- URL
If a Journal field marked for encryption is added to the activity stream, all user input to the field is encrypted in the activity stream.

**Note:** Multi-byte characters within supported field types can be encrypted.

### Encryption patterns

You can use encryption patterns to tokenize strings that match regular patterns such as social security and credit card numbers. While encryption configurations should be the primary method of encryption, use encryption patterns as a supplement to secure sensitive information found outside of encrypted fields.

**Note:** The Edge Encryption proxy server requires a MySQL database in your network only if using order preserving encryption or encryption patterns. Clear text values are stored in the proxy database in your network. For this reason, it is critical that you secure and regularly back up your proxy database. For recommendations, see Edge Encryption components.

---

**Edge Encryption on the Now Platform**

Edge Encryption acts as a gateway between your browser and your ServiceNow instance. Traffic from your browser passes through the gateway on its way to the ServiceNow instance. The gateway, in turn, is configured to encrypt outbound data that is marked for encryption. Inbound traffic is decrypted through the gateway, and the end user sees clear text in the browser. The advantage of this implementation from a security control perspective is that the encryption and key management are handled externally from ServiceNow.
Pros and cons

As with Platform Encryption and Column Level encryption, Edge Encryption imposes some functional limitations within an instance as a result of the additional security. The local Edge proxy does, however, also provide some additional functionality relating to sorting when compared to column-level encryption.

Pros:

• Edge Encryption provides absolute control of who sees your information and prevents data breaches.
• Information remains on your proxy server and never leaves your network unencrypted.
• Information is encrypted in transit, before it even reaches the ServiceNow instance.
• You hold and manage all your own encryption keys. No one else, not even ServiceNow personnel, can access your keys.
• You can choose the strength of the encryption algorithm: AES-128 or AES-256.
• Edge Encryption includes the ability to encrypt String text, Date and Date/Time fields, attachments, URLs, and journals.
• Edge Encryption provides Standard, Equality Preserving, and Order Preserving encryption of data at rest within the database and instance.
• Encryption rules allow you to write custom scripts that tell the proxy server specifically what to encrypt and where to put that encrypted information in the instance. This is useful when the data structure doesn’t exactly match the ServiceNow instance.
• Encryption patterns allow you to tokenize information such as passwords.

Cons:

• Edge Encryption requires an extra network hop through the Edge proxies cluster, and extra processing, which can add delay to traffic. The added processing delay of the Edge Encryption application is negligible compared to the network hop.
• Maintaining your own encryption keys can be complex and time-consuming.
• You can maintain a maximum of two keys, with no flexibility to define different keys for different subsets of columns/data, or for different roles, etc.
• Edge Encryption has the side effect that the server or platform can’t decrypt the data to perform any manipulation of the decrypted data. As a consequence, functionality and data processing on the Now Platform may be restricted when encrypting columns with Edge Encryption.
What to know before you begin

Because encryption and tokenization change the nature of your data, Edge Encryption can affect other instance processes. Before using Edge Encryption, carefully consider the impact on your instance.

Because the proxy server is installed and maintained in your network, Edge Encryption requires network administration and management. Review the network requirements to ensure a smooth implementation.

Review the following topics to understand the impact of Edge Encryption on your instance:

- Planning for Edge Encryption
- Edge Encryption system requirements
- Sizing your Edge Encryption environment
- Calculate the order-preserving and tokenization database size
- Edge Encryption limitations
- Key management for Edge Encryption

Edge Encryption components

Edge Encryption is comprised of the Edge Encryption proxy server that runs on a server in your network, and the Edge Encryption plugin that must be installed on your ServiceNow instance. If using order-preserving encryption types or encryption patterns, a proxy database must also be installed in your network.

Proxy application

When going through the Edge Encryption proxy server, the Edge Encryption plugin allows you to specify which fields, patterns, and attachments should be encrypted. You can also manage encryption rules to encrypt specific requests and schedule mass encryption jobs.

Proxy server

The Edge Encryption proxy server uses encryption rules to identify in an HTTP request what, if anything, needs to be encrypted and encrypts it before forwarding the request to the instance. For decryption, the Edge Encryption proxy server looks at the HTTP responses for any encrypted data and decrypts it before sending the response back to the client. In order for this to happen, all HTTP requests and responses must go through the Edge Encryption proxy server. This includes any requests originating from a browser, as well as any SOAP or REST requests.
Proxy database

If using order preserving encryption or encryption patterns, your proxy servers rely on a MySQL database located in your network. All proxy servers in your network must use the same database.

The proxy database contains these tables.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>db_id</td>
<td>Unique database ID</td>
</tr>
<tr>
<td>edge_token_map</td>
<td>Encryption pattern data</td>
</tr>
<tr>
<td>token_map</td>
<td>Order-preserving encryption data</td>
</tr>
</tbody>
</table>

Backing up your proxy database

Because encryption patterns rely on tokenization, clear text values are stored in your proxy database. If the database is lost, clear text values cannot be restored. It is critical that you maintain regular backups. To avoid data loss, back up your proxy database according to ServiceNow recommendations.

- Back up your database every 24 hours.
- Retain MySQL database binary log files for at least two days. After a backup has been restored, use the binary log to regenerate any data lost since the most recent backup. Refer to MySQL database backup best practices for your database version.

Edge Encryption clients

Edge Encryption uses three clients to inform the instance that the proxy is running, to synchronize requests between the proxy and the instance, and to forward all end user requests to the instance after any potential encryption.

<table>
<thead>
<tr>
<th>Client</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>heartbeat/keepalive client</td>
<td>In charge of sending a request to the ServiceNow instance every 5 seconds to let the instance know that this proxy is up and running. The requests drive the last_response_on field on the Edge proxy table, and as a consequence drive the state of the proxy. If your system has issues sending the requests,</td>
</tr>
<tr>
<td>Client</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>or if the request or request processing is delayed, the instance may mark the proxy as unresponsive, even if the other clients (including the one for user traffic) are up and running.</td>
</tr>
<tr>
<td></td>
<td>This client also controls the online status of the proxy on the instance.</td>
</tr>
<tr>
<td></td>
<td>The <code>edgeencryption.proxy.keepalive.interval</code> property controls the polling rate for this client. The default is 5 (seconds).</td>
</tr>
<tr>
<td>polling/sync client</td>
<td>In charge of various requests the proxy sends to the instance to synchronize on the Edge Encryption configuration (for example, which table, column, or attachment to encrypt, keys, jobs, rules, and tokenization patterns).</td>
</tr>
<tr>
<td></td>
<td>The <code>edgeencryption.config.poll.interval</code> property controls the polling rate for this client.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning:</strong> Do not change this setting. Changing the default setting of the proxy poll interval may result in synchronization delays when updating Edge Encryption settings on the instance.</td>
</tr>
<tr>
<td>default/user traffic client</td>
<td>For everything else, this client handles all end user requests and forwards them to the ServiceNow instance after any potential encryption. This client also handles responses from the instance, forwarding them to the end user after any potential decryption.</td>
</tr>
</tbody>
</table>
Key management for Edge Encryption

You are responsible for providing and managing the encryption keys used by Edge Encryption.

This topic refers to keys for the Edge Encryption product. If you are looking for information on the Key Management Framework, which can be used with Column Level Encryption, see Key Management Framework.

When obtaining and creating encryption keys to support the encryption types used by Edge Encryption, consider the following:

• Whether to use AES 128-bit or AES 256-bit. You must define a default AES 128-bit encryption key, even if it is not used.
• Whether to use file system, Java KeyStore, or Enterprise Key Management (EKM).
• When to rotate encryption keys.
• When and if to use a mass encryption job to re-encrypt data using the new key.

Before removing a key from the proxy configuration files and the keystore, it is critical that you decrypt all data on the instance that uses the key. You can do this by adding a new encryption key and scheduling a mass key rotation job.

Keystores

Edge Encryption supports the following types of key storage.

File store
Keys are stored in a file in a file system that is accessible by the Edge Encryption proxy. Encryption keys stored in a file are not encrypted, so it is your responsibility to protect these files.

Java KeyStore
Keys are stored in Java's JCEKS KeyStore. A Java KeyStore is protected by a password, so it is more secure than storing keys in a file in the file store. A single Java KeyStore can store multiple keys, and the keys are identified by a key alias, making it easier to manage multiple keys.

Enterprise Key Management (EKM)
Keys are stored and retrieved with the SafeNet KeySecure or Unbound Technology key management systems.

The Edge Encryption proxy ships with the Java JCEKS KeyStore file named keystore.jceks in the keystore directory. This keystore file contains the ServiceNow public key used to validate encryption rules signed by ServiceNow.
Note: If using a keystore other than the base system Java JCEKS KeyStore, you must import the ServiceNow public key into your keystore. The public key alias is servicenow.

In addition to the encryption keys, the Java JCEKS KeyStore is used to store the RSA key pair for digitally signing the encryption configuration and encryption rules that are stored in the instance, and the digital certificate that the Edge Encryption proxy uses to establish a secure connection with the browsers and any other clients.

SafeNet key versioning for Edge Encryption

Use SafeNet key versioning to simplify changing keys. Instead of creating a new alias for every new key, SafeNet key versioning keeps the same alias and increments the version.

You must set up key versioning in SafeNet before you can configure SafeNet key versioning on the Edge proxy server.

Note: Edge proxies installed before the London release support SafeNet keys, but do not support SafeNet key versioning. If you mistakenly use a versioned key on a Kingston or earlier proxy, when you upgrade to a London or later release, the London or later proxy detects this problem, and to prevent potential data loss the proxy does not start.

You must first schedule a mass key rotation job or a single key rotation job to replace the old SafeNet versioned key with a non-versioned key, and then create a new SafeNet versioned key, if needed. This new versioned key is safe to use with the London or later proxy, and you can restart the proxy.

Encryption key configuration

If using SafeNet versioned keys, the Change Default Keys section of the Encryption Key Configuration form includes new fields for the Key version of the default 128-bit and 256-bit keys. Key version fields are grayed out and cannot be edited.
For procedures, see Configure encryption keys on the instance.

**Versioned keys**

If using SafeNet versioned keys, when you navigate to Edge Encryption Configuration > Encryption Key Configuration > All Keys, versioned keys include the **Key version**.

A version number does not appear for the initial entries you make in the Change Default Keys section of the Encryption Key Configuration form. When the proxy server requests a key from SafeNet, the system adds a new line for the alias and adds the **Key version**.

In the above example, **AES128key** is listed three times:

- The first listing, with no **Key version** indicated, is the initial entry.
- The second listing, with **1** in the **Key version** column, is the first version of the key returned from SafeNet.
• The third listing, with 2 in the Key version column, is the second version of the key returned from SafeNet.

• As other versions of the key are returned from SafeNet, new lines are added to record the Key version now in use.

Encryption configurations and patterns
With Edge Encryption, you can encrypt fields and tokenize strings.

Encryption configurations
You can encrypt individual fields using encryption configurations. Edge Encryption supports AES 128-bit encryption keys. If the Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy files are installed, Edge Encryption supports AES 256-bit encryption keys for each encryption type. Edge Encryption supports the following types of encryption configurations.

Standard encryption
The encrypted value of a field is different each time the field is encrypted, even when the field value remains the same. Standard encryption is the most robust form of encryption. Fields using standard encryption cannot be sorted, grouped by, or filtered on.

Equality-preserving encryption
The encrypted value of a field is the same when the field value remains the same. Supports equality comparisons and group by operations on a field.

Note: When equality-preserving encryption is selected for a field that already contains data, performing a group by action on the field may not group fields with the same value if one is encrypted and the other is not.

Order-preserving encryption
Uses tokens and encryption to secure data in your proxy database. Supports equality comparisons, group by operations, and the ability to sort data. The order preserving encryption type is only supported if there is a MySQL database configured for the Edge Encryption proxy server.
Note: When using order-preserving encryption and the proxy database is down, updates can be made to fields using order-preserving encryption. However, the sort order will not be correct when trying to sort data based on those fields. Groups also will not work as expected. When the proxy database is again operational, schedule an order token repair job to repair missing tokens.

Encryption types
The following encryption types are listed in decreasing security quality.

<table>
<thead>
<tr>
<th>Encryption type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard AES 256</td>
<td>Fields cannot be filtered, sorted, or compared.</td>
</tr>
<tr>
<td>Standard AES 128</td>
<td>Fields cannot be filtered, sorted, or compared.</td>
</tr>
<tr>
<td>Equality preserving AES 256</td>
<td>Fields can be filtered using equality comparisons.</td>
</tr>
<tr>
<td>Equality preserving AES 128</td>
<td>Fields can be filtered using equality comparisons.</td>
</tr>
<tr>
<td>Order preserving AES 256</td>
<td>Fields can be sorted and equality comparison filtering can be used. Requires the use of a MySQL database in your network.</td>
</tr>
<tr>
<td>Order preserving AES 128</td>
<td>Fields can be sorted and equality comparison filtering can be used. Requires the use of a MySQL database in your network.</td>
</tr>
</tbody>
</table>

Encryption Patterns
You can secure sensitive data found in strings using encryption patterns. Once an encryption pattern is stored and activated, the Edge Encryption proxy server identifies strings that match the pattern in requests. Once located, the clear text string is stored in the proxy database and replaced on the instance with a token. Use encryption patterns to tokenize strings that match regular patterns such as social security and credit card numbers. While we recommend that encryption configurations be the primary method of encryption, use encryption patterns
as a supplement to locate and secure sensitive information found outside of encrypted fields.

[Note: The Edge Encryption proxy server requires a MySQL database in your network only if using order preserving encryption or encryption patterns. Clear text values are stored in the proxy database in your network. For this reason, it is critical that you secure and regularly back up your proxy database. For recommendations, see Edge Encryption components.]

Related information

Encrypt fields using encryption configurations
Tokenize strings using encryption patterns

Installed with Edge Encryption

Edge Encryption installs tables to store encryption-related data, system properties to configure default behavior, and the edge_encryption role to administer Edge Encryption.

Tables installed with Edge Encryption

Edge Encryption installs the following tables.

- **Edge Encryption Configuration [sys_encryption_configuration]**
  - Contains encrypted fields and tables for which attachments are encrypted.

- **Edge Encryption Rule [sys_encryption_rule]**
  - Contains a record for each rule. A rule has a name, the condition when it is used, a script, and an order field.

- **Edge Encryption Invalid Insert Log [sys_edge_encryption_invalid_insert_log]**
  - Contains log messages created for attempts to save unencrypted data to an encrypted field.

- **Edge Encryption Proxy [sys_encryption_proxy]**
  - Contains information about the encryption proxy application.

- **Edge Proxy Encryption Type [sys_proxy_encryption_type]**
  - Used for enabling and disabling encryption types on the encryption form.

- **Encryption Job Execution [sys_encryption_job_execution]**
  - Supports mass encryption jobs.

- **Encryption Job Execution Chunk [sys_encryption_job_execution_chunk]**
Supports mass encryption jobs.

**Scheduled Encryption Job [sysauto_encryption_job]**

Lists scheduled jobs for encryption, decryption, key rotation, order token repair, and database recovery.

**Encryption Key Configuration [sys_encryption_key_configuration]**

Lists default encryption keys.

**Encryption Key [sys_encryption_key]**

Lists available keys and key attributes.

**Proxy Encryption Key [sys_encryption_proxy_key]**

Lists proxy encryption keys.

**Properties installed with Edge Encryption**

Edge Encryption adds the following properties.

<i>Note:</i> To open the System Properties [sys_properties] table, enter `sys_properties.list` in the navigation filter.

**glide.edge.pattern.disallowed.chars**

A list of characters that are not allowed in patterns.

- **Type:** a string of a comma-separated list of values
- **Location:** System Properties [sys_properties] table

**glide.edge.pattern.min.size**

The minimum pattern size allowed. Allowing smaller patterns means finding more matches, which increases overhead.

- **Type:** number
- **Default value:** 5
- **Location:** System Properties [sys_properties] table

**sn_edge_encryption.logging.destination**

Where messages are logged.

- **Type:** string
- **Default value:** file
- **Location:** System Properties [sys_properties] table

**sn_edge_encryption.logging.verbosity**
The logging level to use.

- **Type**: string
- **Default value**: info
- **Location**: System Properties [sys_properties] table

**sn_edge_encryption.encryption.proxy.buildtag**

The proxy version registered with your instance.

- **Type**: string
- **Location**: System Properties [sys_properties] table

**sn_edge_encryption.cleartext.allowed**

When true, allows clear text to be saved in an encrypted field. This happens when a user is accessing the instance without going through the Edge Encryption proxy. When false, the system prevents clear text from being saved in an encrypted field.

- **Type**: Boolean
- **Default value**: false
- **Location**: System Properties [sys_properties] table

**Role installed with Edge Encryption**

**edge_encryption**

Edge Encryption proxies log into the instance as a user, with a user name and password. The user must have this role assigned.

Contains roles: None

**Planning for Edge Encryption**

Successful implementation of Edge Encryption requires planning and preparation.

Answer the following questions in the planning stage.

- Which fields are to be encrypted?
- Which encryption types are to be used?
- How many Edge Encryption proxies are needed? See Sizing your Edge Encryption environment for recommendations and considerations.
• If an order preserving encryption type or encryption patterns are to be used, where is the MySQL database located?

• Which key management system is to be used?

System administrators, network administrators, and security team members have different tasks to fulfill for implementing Edge Encryption.

• System administrators need the security-admin role. The system administrator needs to:
  ◦ Download the Edge Encryption proxy application.
  ◦ Set up an Edge Encryption user account for the proxies to use to connect to the instance. The user must be assigned the edge_encryption role.
  ◦ Configure encryption keys, and set the default keys.
  ◦ Configure Edge Encryption on the instance.
  ◦ Schedule encryption jobs.
  ◦ Monitor Edge Encryption.
  ◦ Create and edit encryption rules.

• Your network administrator needs to:
  ◦ Install the Edge Encryption proxy application.
  ◦ Know the network addresses for the proxy servers and the proxy database used for order-preserving encryption and encryption patterns.
  ◦ Install the proxy database to be used for order-preserving encryption and encryption patterns.
  ◦ Start and stop the proxy applications.
  ◦ Perform encryption key management.
  ◦ Determine how to map users to encryption proxy applications. This can be done with DNS settings or routing rules, and is specific to each network.
  ◦ Manage multiple proxy servers.
  ◦ Configure load balancer pools and settings.

• Your security administrator must determine the encryption types to be assigned to each field.

Edge Encryption system requirements

You can run the Edge Encryption proxy application on servers or virtual machines that run on Microsoft Windows or Linux operating systems.
For optimum performance, ensure that your configuration meets these requirements.

**Java requirements**
The host machine installing or running the Edge Encryption proxy server must maintain a supported version of Java:

- Java 8 update 121 (8u121)
- Java 8 update 141 (8u141)
- Java 8 update 151 (8u151) or later

ℹ️ **Note:** Java 8 update 131 (8u131) is not supported.
- Java 11.0.6 or later

ℹ️ **Note:** Before installing the Edge Encryption proxy server, check that the $JAVA_HOME variable is pointing to a supported version of Java for each user that will run the proxy server. For example, if installing the proxy server as a local administrator on Windows, check that the $JAVA_HOME variable is pointing to the correct version of Java system-wide. If installing on Linux, check that each user that will run the proxy server has this variable correctly defined. If a supported version of Java is not found, the Edge Encryption proxy server will not run.

<table>
<thead>
<tr>
<th>Java Version</th>
<th>Enabling AES 256-bit Encryption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java 8 update 141 (8u141) or earlier</td>
<td>Install the Java Cryptography Extension (JCE) jurisdiction policy files by copying them into the system Java home directory of each Edge Encryption proxy server host. Add these files to the &lt;Java-home-directory&gt;/jre/lib/security folder before performing a scheduled or manual upgrade. To install the AES 256-bit encryption policy files, see Enable AES 256-bit encryption for Java 8 update 141 (8u141) or earlier.</td>
</tr>
<tr>
<td>Java 8 update 151 (8u151) or later</td>
<td>A java.security file is downloaded with the update. Edit the java.security file to enable AES 256-bit encryption.</td>
</tr>
<tr>
<td>Java Version</td>
<td>Enabling AES 256-bit Encryption</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td></td>
<td>To edit the java-security file, see Enable AES 256-bit encryption for Java 8 update 151 (8u151) or later.</td>
</tr>
<tr>
<td></td>
<td>Note: If upgrading an Edge Encryption proxy server running on Windows to a new version of Java, you may need to copy the JCE policy files from your previous Java folder to the new Java folder.</td>
</tr>
</tbody>
</table>

**Note:** Java does not automatically allow unlimited strength keys. You must specifically enable the use of AES 256-bit encryption.

### Support for OpenJDK
Starting with the Orlando release, the Now Platform supports the following versions of openJDK:

- OpenJDK version 8
- AdoptOpenJDK version 8
- OpenJDK version 11

### Proxy server minimum configuration
A proxy server requires this minimum configuration:

- 4 GB of RAM per proxy server (6 GB is recommended for most deployments).

**Note:** The proxy server host requires at least 1 GB of RAM more than the proxy server. The proxy server host needs the extra 1 GB for operating system services. For example, if you configure a proxy server to use 4 GB of RAM, you must install at least 5 GB of RAM on the proxy server host.

Because the proxy server requires at least 4 GB of memory, 32-bit JREs and 32-bit operating systems are no longer supported starting with the London release.

- 3 or more GHz CPU (4-core CPU preferred for optimum performance).
- Multiple proxy servers behind a load balancer. The number of proxy servers you need depends on the number of application nodes, the number of
simultaneous users, and the number of servers needed for failover. See Sizing your Edge Encryption environment for more information.

- Ability to run concurrently with other services, depending on the server utilization and resource availability.

**Proxy server supported systems**

The following systems are supported:

<table>
<thead>
<tr>
<th>Supported System</th>
<th>Description</th>
</tr>
</thead>
</table>
| Windows Server 2012, 2012-R2, and 2016 editions | • Virtual machines or physical hardware  
• 64-bit systems |
| Linux | • Virtual machines or physical hardware  
• 64-bit systems |

On 64-bit Linux systems, you must install the 32-bit GNU C library (glibc). The installation command for CentOS is `yum install glibc.i686`.

**Proxy server connection requirements**

The proxy server that runs the Edge Encryption application must be able to communicate with machines in your network. Make sure that the proxy server has these network privileges:

<table>
<thead>
<tr>
<th>Network Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firewall access</td>
<td>Configure any firewalls between the proxy server and the client devices to allow a connection. If your network uses a DeMilitarized Zone (DMZ) to add an extra layer of security to your Local Area Network (LAN), and if your network security protocols limit port access from within the network to the DMZ, you might have to deploy a proxy server to a machine within the DMZ.</td>
</tr>
</tbody>
</table>
Network Privilege | Description
--- | ---
Network access | Configure each client to enable the proxy server to connect with it. If network security prevents you from configuring new machines that can connect to the clients, install the proxy server on an existing machine with connection privileges.

Instance access | Ensure that the proxy server has network access to the instance. Make sure that you configure the proxy server network to allow traffic over TCP port 443.

Network account | Install the proxy server with either a local or domain administrator.

### Order-preserving and tokenization database system requirements

Order-preserving encryption and encryption patterns require that you configure an Oracle MySQL database for the Edge Encryption proxy server. Order-preserving encryption allows any comparison operation to be directly applied on encrypted data, without first decrypting the data. Encryption patterns let you replace string patterns with tokens (called tokenization) before they are sent to and stored in the database. Because of the size of the MySQL database, use a dedicated proxy server to run the order-preserving and tokenization database.

The minimum database system requirements include:

<table>
<thead>
<tr>
<th>MySQL Database</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>MySQL database versions 5.5 to 5.7</td>
</tr>
<tr>
<td>OS</td>
<td>64-bit systems</td>
</tr>
<tr>
<td>CPU</td>
<td>2 or more GHz CPU (4-core CPU preferred for optimum performance)</td>
</tr>
<tr>
<td>RAM</td>
<td>16 GB</td>
</tr>
<tr>
<td>Disk</td>
<td>Storage Area Network (SAN) or local storage (RAID 10 recommended)</td>
</tr>
</tbody>
</table>
| Size | Determined by the number of potential records multiplied by the record size. See Calculate the order-
**MySQL Database**

<table>
<thead>
<tr>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>preserving and tokenization database size.</td>
</tr>
</tbody>
</table>

**Configuration**

<table>
<thead>
<tr>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>High availability cluster. If you are unsure of how to configure your MySQL server, contact MySQL for configuration information.</td>
</tr>
</tbody>
</table>

---

### Sizing your Edge Encryption environment

Choosing the number of proxy servers for your environment is an important task. Consider the number of users, redundancy needs, and acceptable latency.

### Redundancy

Maintain redundant proxy servers in case of hardware failure. Proxy servers should be located behind a load balancer to provide a functional path for all users if a proxy server is unreachable. At a minimum, ensure that two proxy servers are always available.

### Size

Size refers to the number of proxy servers required to avoid additional latency that the encryption of data produces. Depending on use, you may want to reduce the amount of latency by adding additional proxy servers. For example, if regular mass encryptions are run, add additional proxy servers to handle the load, or run the mass encryptions when the user load is light. In addition, the hardware that the proxy server runs on influences performance and latency. Proxy servers running on hardware with faster CPUs, more CPUs, and more RAM have higher throughput than slower, limited systems.

The following guidelines assume that your proxy server is running on at least the minimum hardware requirements. To determine the number of proxy servers:

- Consider setting up one proxy server for every two application nodes on the instance.
- For redundancy, set up a minimum of two proxy servers behind a load balancer.
- Add an extra proxy server for every 500 simultaneous users.
- Depending on the desired redundancy, add additional proxy servers for failover.
For example, for an instance with 2,000 users, you should have at least five proxy servers behind a load balancer. This calculation includes one proxy server for every 500 users, with an extra proxy server for failover. Determine ahead of time when you will approach a threshold of 500 users and place another proxy server in the load balancer pool.

**Load balancers**

To balance requests and improve server response time, distribute proxy servers in a load balancer pool. Configure load balancers to use the "least connections" method. This method connects requests to the proxy server with the fewest active connections, preventing the overloading of a single proxy.

**CPU utilization**

Because data encryption and tokenization are CPU intensive operations, CPU spikes while encrypting data are normal and expected. When CPU utilization is over 80% for several minutes at a time, it likely means that the proxy server has too much work to do. When this happens, latency increases for the period that the CPU utilization is high. If latency persists, adding another proxy server may help decrease the latency.

**Memory**

The proxy server must have a minimum of 4 GB of RAM available (6 GB recommended). Set the proxy server initial and upper bound memory limits to the recommended settings.

**Calculate the order-preserving and tokenization database size**

If using order-preserving encryption or encryption patterns, determine the size of your MySQL database by multiplying the number of potential records by record size.

**About this task**

Use a dedicated machine to run the order-preserving and tokenization database. Do not run the database on the same hardware as the proxy server.

**Procedure**

1. Determine the potential number of records that could include fields encrypted with order-preserving encryption.
   a. Multiply the number of encryption configurations using order-preserving encryption by the number of records each configuration is applied to.
   b. To allow for growth, multiply the result by three.
2. Multiply the result of step 1 by 1,536.  
   1,536 is the average size of a record in bytes.

3. If using encryption patterns, perform steps 1–2 for tokenized records and add the result to the total.

**Results**
The calculated value is the recommended size in bytes for your order-preserving and tokenization database.

**Edge Encryption limitations**
Edge Encryption impacts system functions. Carefully evaluate the impact of encrypting a field.

**Field type restrictions**
You can encrypt only the following field types:

- String
- Date
- Date/Time
- Journal
- Journal Input
- URL

You cannot encrypt the following field types:

- Choice fields
- Virtual fields
- Fields in system tables, except for certain fields in sys_user
- System fields in tables
- Number fields or fields associated with an auto-numbering scheme
- Any other field type not listed above

Additional restrictions:
• When a Journal field is encrypted, the Post button is disabled, even if there are multiple Journal fields and only one of those fields is encrypted.

• Encrypted fields are not available in Go to and header filter boxes.

• When encrypting fields used as an index, you can use only order-preserving and equality-preserving encryption types. Indexed fields cannot be encrypted using the standard encryption type.

For more information, see Field types.

Filtering and searching restrictions

Standard encryption

When you select a String, Date, Date/Time, or URL field with a standard encrypted field configuration as the left operand in a filter, no filtering options are available.

Equality-preserving encryption

When you select a String, Date, Date/Time, or URL field with an equality-preserving encrypted field configuration as the left operand in a filter, the following operators are available:

• is
• is not
• is empty
• is not empty

Order-preserving encryption

When you select a String field with an order-preserving encrypted field configuration as the left operand in a filter, the following operators are available, in addition to is, is not, is empty, and is not empty:

• greater than
• less than

When you select a Date or Date/Time field with an order-preserving encrypted field configuration as the left operand in a filter, the following operators are available, in addition to is, is not, is empty, and is not empty:

• after
• before
• after or on
• before or on

Date and Date/Time pickers

For Date fields, use the date picker to specify the date:

For Date/Time fields, use the date and time picker to specify the date and time:

List condition filters

The Show Matching and Filter Out options are supported in lists. Only exact matches are returned or filtered out.

ℹ️ Note: Adding encrypted fields in condition filters is supported in scripts such as UI policies and business rules.

Configuration restrictions

Restrictions and behavior of encryption configurations:
• After you add a field to the Edge Encryption Configuration table, you cannot delete the configuration record. If you no longer want a field to be encrypted, deactivate the record in the Edge Encryption Configuration table and schedule an encryption job to decrypt the data.

• If a field in a parent table is marked to be encrypted, the field is also encrypted in all inherited tables. For example, if the Short description field in the Task table is encrypted, then the contents of the Short description field in the Incident table are encrypted.

• If a field inherited from a parent table is marked to be encrypted, the field in the parent table cannot be encrypted. For example, if the Short description field in the Incident table is marked to be encrypted, then the Short description field in the Task table cannot be encrypted. In this example, you can encrypt the Short description in the Problem table.

• When a field with an encryption configuration defined is exported to any format, the output includes encrypted values even when exported through the proxy server.

• You cannot import data to a field with an encryption configuration defined.

• You cannot encrypt inherited Date and Date/Time fields. Date or Date/Time fields inherited from a parent table are not listed on the Column field drop-down list, and you cannot create Date or Date/Time encryption configurations for those fields.

• You can encrypt a String or URL field only from a parent table or a child table, but not both.

**Instance restrictions**

Impact of using Edge Encryption on the instance:

• Back-end logic cannot process encrypted data. When the instance contains encrypted data, any business rule, back-end script, or back-end feature that relies on evaluating the data in the encrypted field does not run correctly.

  ❪ Note: Data encrypted with equality-preserving or order-preserving encryption still passes equivalence checks when compared against an identical encrypted value.

• Since email processing goes from the mail systems straight to the instance and cannot pass through the Edge proxy, data sent in or out via email cannot be encrypted or decrypted by the Edge proxy.
  - Data and attachments in inbound emails are not encrypted.
  - Data and attachments in outbound emails remain encrypted and cannot be decrypted.
• Scripts run on the server cannot change encrypted data.

• Global search is not supported. Because global search attempts to search both encrypted and clear text data, the results may not be as expected.

• Encrypted data cannot be copied and pasted into a record where the field is not encrypted.

• Depending on the type of encryption selected, the user interface functionality for the encrypted fields is reduced. For example, being able to compare, group by, sort, and search may be impacted. Generally, the stronger the encryption selected, the more functionality is reduced.

• Except for Java KeyStore, SafeNet, and Unbound Technology, no third-party software or hardware encryption key management is supported.

• Although multiple proxy servers connected to a single instance are supported, encryption proxy cluster management and monitoring are not available. Each proxy must be managed separately.

• System configurations such as workload and the number of encrypted fields can impact the performance of encrypted fields.

• The Edge Encryption proxy server can only connect to a single instance.

• If your instance uses an Oracle database and the String field you are marking to be encrypted is greater than 2925 characters, that field cannot be sorted even when order preserving encryption is selected.

• If your instance uses an Oracle database, Unicode AL32UTF8 is the only supported character set.

• Encrypted data cannot be used in reports.

Edge Encryption installation

You can install an Edge Encryption proxy manually or using the Edge Encryption interactive installer.

Java requirements

The host machine installing or running the Edge Encryption proxy server must maintain a supported version of Java:

• Java 8 update 121 (8u121)
• Java 8 update 141 (8u141)
• Java 8 update 151 (8u151) or later
Note: Java 8 update 131 (8u131) is not supported.

• Java 11.0.6 or later

Note: Before installing the Edge Encryption proxy server, check that the 
$JAVA_HOME variable is pointing to a supported version of Java for 
each user that will run the proxy server. For example, if installing the proxy 
server as a local administrator on Windows, check that the $JAVA_HOME 
variable is pointing to the correct version of Java system-wide. If installing 
on Linux, check that each user that will run the proxy server has this variable 
correctly defined. If a supported version of Java is not found, the Edge 
Encryption proxy server will not run.

Installing the proxy server
Installing Edge Encryption includes these steps.

• Install the Edge Encryption proxy application on a server in your network using 
the interactive installer or the manual installer.

• Generate the RSA key pair for digitally signing encryption configurations and 
encryption rules.

• Install the Java Cryptography Extension (JCE), if you plan to use AES 256 
encryption.

• If you are using a secure SSL connection, obtain a server certificate and 
import it to the Java KeyStore.

• Set up your keystore and encryption key.

• If order preserving encryption types or encryption patterns are to be used, set 
up a MySQL database on a machine in your network.

• Set the desired properties. Properties are located in the 
edgeencryption.properties configuration file.

• Specify that a proxy server is a trusted source so that Edge Encryption can 
process requests coming from that proxy server.

Accessing the proxy server
Once installation is complete, point each user’s browser to an Edge Encryption 
proxy using the URL format: <host>:<port>. Values are determined by the host 
and port properties in the edgeencryption.properties file.

As an example with the following values:
A client will access the proxy server using the following address: `http://hostname.mycompany.com:8081/`.

**Note:** DNS settings and routing rules may be used. Host and port values are determined by your network administrator.

### Request Edge Encryption

The Edge Encryption plugin (com.glide.edgeencryption) is available as a separate subscription.

**Before you begin**

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization's production and subproduction instances, generally within a few days.

If you don't have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps.

Role required: none

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. On the All Applications page, click **Request Plugin** to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. On the form, fill in the fields.

**Activate Plugin request form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Note: Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.</td>
<td></td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Set up an Edge Encryption user account**

The Edge Encryption proxies connect to the instance as a user to obtain and update encryption configuration information. Create a user account for this purpose and give the edge_encryption role to the user.

**Before you begin**
The Edge Encryption plugin must be installed before you can assign the role.

Role required: admin

**Procedure**

1. On your ServiceNow instance, create a user account to be used by the Edge Encryption proxy applications.

2. Assign the edge_encryption role to the user.

**Download the Edge Encryption proxy server**

Download the Edge Encryption proxy server application from your instance, and then copy the file to each computer that is to run the Edge Encryption proxy server.
Before you begin
Before starting this procedure, the Edge Encryption plugin must be installed and activated on your instance.

Note: The Edge Encryption proxy is officially supported only on Oracle JRE.

Role required: security_admin

About this task

Procedure

1. Navigate to Encryption Configuration > Installation & Downloads > Downloads.
2. If using the interactive installer, click Download. If manually installing the proxy server, select the OS version for your proxy server.

Note: Because the proxy server requires at least 4 GB of memory to run, 32-bit JREs and 32-bit operating systems are no longer supported starting with the Rome release.

3. Copy the installer to each computer that is to run the Edge Encryption proxy server. If manually installing the Edge Encryption proxy server, copy the ZIP file to each computer that is to run the Edge Encryption proxy server.

What to do next

After downloading the Edge Encryption installer, Install the Edge Encryption proxy server using the interactive installer. If installing manually, Install the Edge Encryption proxy server using the command line installer.

Install the Edge Encryption proxy server using the interactive installer

Install the Edge Encryption proxy server on a Windows or Linux computer using the interactive installer.

Before you begin

Note: SafeNet KeySecure keystore files are not supported by the Edge Encryption installer. To use a SafeNet KeySecure keystore, Install the Edge Encryption proxy server using the command line installer.

The Edge Encryption plugin must be installed and activated on your instance before you start this procedure. Ensure that the latest version of Java 8 is installed on the machine running the Edge Encryption installer.

The latest version of Java 8 is Java SE 8u171/ 8u172.
• Java SE 8u171 includes important bug fixes. Oracle strongly recommends that all Java SE 8 users upgrade to this release.

• Java SE 8u172 is a patch-set update, including all of 8u171 plus additional bug fixes.

Role required:
• security_admin on your ServiceNow instance
• local or domain administrator on a Windows host
• service user with full file system access on a Linux host

About this task
After installing a new proxy server, you can run the installer again to perform tests to detect issues with an installation or modify current settings. Your options include:

• **Install New**: Install a new proxy server.

• **Verify Installation**: Perform tests to detect and fix issues in a previous installation.

• **Reinstall Existing**: Perform tests to detect and fix issues in a previous installation and view or modify existing settings.

**Note:** If installing the proxy server on a Linux machine on a privileged port (port 80 or 443), you must run the installer as a root user with full file system access. To restrict file system access after the proxy server is installed, you can use the SetUID feature in the proxy installer. To enable this feature, start the installer as root or sudo root. When prompted by the installer, provide the username and usergroup of an unprivileged user. The proxy server will install with file system privileges of the given user. You can skip this step to continue the default installation with root privileges.

Use the installer to install multiple proxies for your instance on multiple machines, ensuring that the following criteria apply:

• All proxies must have the same encryption keys and the same RSA key pair used to digitally sign encryption configurations and rules.

• The encryption key must be the default key configured on the instance.

• When a proxy database is set up as part of the installation, all proxies must use the same proxy database.

You may need a proxy database for equality-preserving encryption, order-preserving encryption, or tokenization. If you do not use any of these features, you do not need a proxy database.
To use NVDA, an Assistive Technology screen reader designed to read accessibility-enabled Java applications built for keyboard users, see Configure a Windows 64-bit host to use 32-bit NVDA with Java applications.

What to do next
After installing the Edge Encryption proxy server, Set the proxy server initial memory limit and upper bound memory limit.

Install the Edge Encryption proxy server (interactive installer)
Install the Edge Encryption proxy on a Windows or Linux computer.

Procedure
1. Download the Edge Encryption proxy server installer.
2. Open the Edge Encryption proxy installer.

   Note: If installing on a Windows machine, you must run the installer as Administrator.

   a. To run the installer as Administrator on a Windows machine, right-click the Command Prompt and select Run as administrator.

   b. From the command line, navigate to the directory that contains the downloaded .jar file.

   c. Run the following command: java -jar <file name>.jar.
3. To install a new proxy server, select **Install New**. If a proxy is already installed, you can run the installer to:

   - **Verify Installation**: Perform tests to detect and fix issues in a previous installation.
   - **Reinstall Existing**: Perform tests to detect and fix issues in a previous installation and view or modify existing settings.

4. Configure the **Installation Location** and **Target ServiceNow Instance**.

   a. Click **Browse** to select an installation location or manually enter an installation path.

   b. Enter the URL of the target ServiceNow instance. Include the protocol and port number.

      **Example**
      
      `https://example.servicenow.com:443`

   c. Enter the user name and password for a user with the edge_encryption role on the target ServiceNow instance.

5. Click **Next**.
6. Configure the **Connection Settings** and **Proxy Settings**.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proxy Host</td>
<td>Fully qualified domain name of the machine on which you are installing the proxy server.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Click <strong>Detect FQDN</strong> to look up the machine’s fully qualified domain name and auto-populate the <strong>Proxy Host</strong> field.</td>
</tr>
<tr>
<td></td>
<td>Along with the port, this property defines the URL used by the client to access the proxy server.</td>
</tr>
<tr>
<td>HTTP Port</td>
<td>Port on the proxy for HTTP communication.</td>
</tr>
<tr>
<td>HTTPS Port</td>
<td>Port on the proxy for HTTPS communication.</td>
</tr>
<tr>
<td>Proxy Name</td>
<td>Name of the proxy and the service. The proxy name must be unique.</td>
</tr>
<tr>
<td>Proxy Poll Interval</td>
<td>Poll interval in seconds. With the default setting, it takes 5 seconds for the proxy to learn of encryption configuration changes. Larger values cause the instance to take longer to detect proxies that have come online.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Changing the default setting of the <strong>Proxy Poll Interval</strong> can result in detection delays when a proxy comes online.</td>
</tr>
<tr>
<td>Proxy Keep-Alive Ping Interval</td>
<td>Time in seconds between pings issued by the proxy to the instance. Pings are issued periodically to verify connectivity between the proxy and the instance. The default value is 10. The minimum value is 5.</td>
</tr>
</tbody>
</table>
7. Click **Install**.
   The Edge Encryption proxy server installs. The installation may take a few minutes.

**Configure CyberArk properties protection**

Optionally, configure CyberArk properties protection to securely store Edge Encryption passwords in a centralized and secure digital vault.

**About this task**

You must purchase and configure CyberArk AIM (Application Identity Management) before you can configure CyberArk connection parameters and protected credentials for a proxy server. As part of the installation of the AIM client, the `JavaPasswordSDK.jar` file is installed in the AIM client installation directory. The CyberArk vault is installed on an independent hardened server, and the AIM clients allow secure access to that server.

⚠️ **Note:** You must install the CyberArk AIM client on every host computer where an Edge proxy is installed.

In the Edge installer, you must specify the location of the `JavaPasswordSDK.jar` file to set up the CyberArk connection to the Edge proxy. You must also enter other values you defined during the AIM client installation.

Setting up CyberArk password storage is optional. If you do not want to set up CyberArk password storage, click **Skip** through the CyberArk screens.

**Procedure**

1. On the CyberArk Connection page of the Edge Encryption installer, enter the CyberArk connection parameters.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path to PasswordSDK.jar</td>
<td>The path to the <code>JavaPasswordSDK.jar</code> file installed on the host Windows machine during CyberArk configuration.</td>
</tr>
<tr>
<td>App ID</td>
<td>The <strong>App ID</strong> entered during CyberArk configuration.</td>
</tr>
<tr>
<td>Safe Name</td>
<td>The <strong>Safe Name</strong> entered during CyberArk configuration.</td>
</tr>
</tbody>
</table>
2. Click Next.

3. On the CyberArk Protected Credentials page of the installer, enter the credentials to be protected by CyberArk.

   - To use a single credential name for all protected passwords, select the **Apply one Credential Name to all Credentials** check box, enter the credential name, and click **Apply**.

   - Enter the credential name for one or more of the following fields. Credential names are the usernames entered for the SSH keys during CyberArk configuration.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge Encryption User</td>
<td>The CyberArk credential name for an Edge Encryption user.</td>
</tr>
<tr>
<td>Signature Key Keystore</td>
<td>The CyberArk credential name for the signature key keystore.</td>
</tr>
<tr>
<td>HTTPS Cert Keystore</td>
<td>The CyberArk credential name for the HTTPS certification keystore.</td>
</tr>
<tr>
<td>Encryption Key Keystore</td>
<td>The CyberArk credential name for the encryption key keystore.</td>
</tr>
<tr>
<td>Database</td>
<td>The CyberArk credential name for the database keystore.</td>
</tr>
<tr>
<td>SafeNet HTTPS Cert Keystore</td>
<td>The CyberArk credential name for the SafeNet HTTPS certification keystore.</td>
</tr>
<tr>
<td>SafeNet Server</td>
<td>The CyberArk credential name for the SafeNet server.</td>
</tr>
<tr>
<td>Forward Proxy</td>
<td>The CyberArk credential name for the forward proxy.</td>
</tr>
</tbody>
</table>

4. Click Next.

**Configure the signature key**

Configure the signature key after installing the proxy server through the Edge Encryption proxy installer.
About this task
The signature key signs changes to configurations and properties made by the proxy server. The signature key must be an asymmetric RSA key pair in a JCEKS KeyStore.

Note: If installing multiple proxies, each proxy must use the same signature key.

Procedure
1. On the Signature Key page of the Edge Encryption installer, select the keystore on the host machine to store the signature key.
   - Create New Java KeyStore: Enter the directory location, name, and password for the new keystore.
   - Use Existing Keystore: Enter the keystore file location and password.
2. Click Next.
3. Select or create a signature key.
   - New Key: Create a signature key for this proxy.
   - Use Existing Key: Use an RSA key-pair from the selected keystore.
   - Import Existing Key: Import an RSA key-pair from a different keystore. Browse to the keystore file, enter the password for the keystore, and select the key alias. Provide a new alias for the key.
4. Click Next.

Configure the HTTPS certificate
To enable clients to connect to the Edge Encryption proxy server using a secure SSL connection, import the HTTPS certificate to the proxy server.

About this task
The Edge Encryption proxy provides the HTTPS certificate to clients trying to connect.

Procedure
1. On the HTTPS Certificate page of the Edge Encryption installer, select the keystore to store the certificate.
   - Create New Java KeyStore: Enter the directory location, name, and password for the new keystore.
   - Use Existing Keystore: Enter the keystore file location and password.
2. Click Next.

3. Select or import a certificate.
   The key alias is the given alias for the certificate.
   - **Use Existing Certificate**: Use an existing certificate in the selected keystore.
   - **Import from File or KeyStore**: Import a certificate from a different keystore or a .cer file. Browse to the keystore or .cer file, enter the password, and select the alias. You must provide a new alias for the certificate.

4. Click Next.

**Configure the AES 128-bit encryption key**

After you configure the HTTPS certificate through the Edge Encryption proxy installer, configure the AES 128-bit encryption key to encrypt your data.

**About this task**

The encryption key is either a plain text file inside the /keys directory or a secret key inside a keystore. If you use a keystore for your AES 128-bit and AES 256-bit encryption keys, they must both use the same keystore.

If you are updating an SSL certificate on an Edge proxy server, see Update SSL certificate.

**Procedure**

1. Select the encryption key location.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Store</td>
<td>Use a file to store a single encryption key. You can use an existing file in the /keys directory, or you can generate a new file. To generate a new file, enter an alias and click Generate. A file containing an encryption key is created.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This choice designates both the storage location and the encryption key. If you select File Store, click Next and go to step 5.</td>
</tr>
<tr>
<td>Create New Java KeyStore</td>
<td>Create a keystore to store the encryption key.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Java KeyStore File</td>
<td>Store the encryption key in an existing Java KeyStore file.</td>
</tr>
</tbody>
</table>

2. Click **Next**.

3. Select or create the encryption key.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Key</td>
<td>Create an encryption key and alias.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You must use lowercase letters and numbers for the alias name (key name, key alias), per Java KeyStore requirements. To find out more about the key-tool utility, see the Java SE Documentation.</td>
</tr>
<tr>
<td>Use Existing Key</td>
<td>Use an existing encryption key in the selected keystore.</td>
</tr>
<tr>
<td>Import Existing Key</td>
<td>Import an encryption key from a different keystore.</td>
</tr>
</tbody>
</table>

4. Click **Next**.

5. Configure the key on the instance according to the requirements defined in your installer.

   To configure the key on the instance, navigate to the instance and define a default key. See **Configure encryption keys on the instance**. Ensure that the key alias, size, and type match the requirements defined in the installer.
Default key requirements

6. Once the key is configured on the instance, return to the installer and click Next.

Configure the AES 256-bit encryption key

After you configure the AES 128-bit key through the Edge proxy installer, you can optionally configure an AES 256-bit encryption key to encrypt your data.

About this task

The encryption key is either a plain text file inside the /keys directory or a secret key inside a keystore. If you use a keystore for your AES 128-bit and AES 256-bit encryption keys, both keys must use the same keystore. If you do not want to configure an AES 256-bit encryption key, click Skip to continue installing the proxy server.

If you are updating an SSL certificate on an Edge proxy server, see Update SSL certificate.
Procedure

1. Select the encryption key location.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File Store</strong></td>
<td>Use a file to store a single encryption key. You can use an existing file in the /keys directory, or you can generate a new file. To generate a new file, enter an alias and click Generate. A file containing an encryption key is created. Note: This choice designates both the storage location and the encryption key. If you select <strong>File Store</strong>, click <strong>Next</strong> and go to step 5.</td>
</tr>
<tr>
<td><strong>Create New Java KeyStore</strong></td>
<td>Create a keystore to store the encryption key.</td>
</tr>
<tr>
<td><strong>Java KeyStore File</strong></td>
<td>Store the encryption key in an existing Java KeyStore file.</td>
</tr>
</tbody>
</table>

2. Click **Next**.

3. Select or create the encryption key.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New Key</strong></td>
<td>Create an encryption key and alias.                                         Note: You must use lowercase letters and numbers for the alias name (key name, key alias), per Java KeyStore requirements. To find out more about the keytool utility, see the Java SE Documentation.</td>
</tr>
<tr>
<td><strong>Use Existing Key</strong></td>
<td>Use an existing encryption key in the selected keystore.</td>
</tr>
<tr>
<td><strong>Import Existing Key</strong></td>
<td>Import an encryption key from a different keystore.</td>
</tr>
</tbody>
</table>
4. Click Next.

5. Optional: If you want to use AES 256-bit encryption, do the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java 8 update 141 or earlier</td>
<td>Install the Java Cryptography Extension (JCE) and overwrite the policy files in the Java home directory. See Enable AES 256-bit encryption for Java 8 update 141 (8u141) or earlier.</td>
</tr>
<tr>
<td>Java 8 update 151 or later</td>
<td>Edit the java.security policy file to allow the use of unlimited strength keys. See Enable AES 256-bit encryption for Java 8 update 151 (8u151) or later.</td>
</tr>
</tbody>
</table>

6. To use AES 256-bit encryption, you must also configure the AES 256-bit default encryption key on the instance by navigating to the instance and defining a default key.

   See Configure encryption keys on the instance. Ensure that the key alias, size, and type match the requirements defined in the installer.

7. After the key is configured on the instance, return to the installer and click Next.

Update SSL certificate

When updating an SSL certificate on an Edge proxy server, you must delete the old one.

Before you begin

Role required: admin

About this task

When updating the SSL certificate on the Edge proxy server, you must also delete the old certificate. If you don’t, the old certificate (in the form of an alias in the KeyStore file) continues to be used even though the Edge proxy server is configured to use the new certificate.

Procedure

1. On the Edge proxy server, list the entries in the Java KeyStore:

   ```bash
   keytool -list -keystore keystore.jceks -storetype jceks -storepass MY_SUPER_PASSWORD
   ```

2. Remove the old SSL certificate:
3. Add the new SSL certificate into the Java KeyStore.

Configure the Edge Encryption proxy database
If using order-preserving encryption types or encryption patterns, you can optionally configure the Edge Encryption proxy database properties.

About this task
To use order-preserving encryption types or encryption patterns, a MySQL database running in your network is mandatory. This task connects the proxy to the database, but it does not install or configure the database.

⚠️ Note: If using multiple proxy servers, all proxy servers must use the same proxy database. The values entered in the installer must be the same for all proxy servers.

Procedure
1. Confirm or change the database URL. This URL is the location of the proxy database.
2. In the Name field, enter the name of the proxy database. The default value is edgeencryption.
3. Enter the username and password for accessing the proxy database.
4. Click Next.

Launch the Edge Encryption proxy server
After an Edge Encryption proxy is installed and configured, you can start the proxy from the installer.

Procedure
1. After configuring keys on the instance and optionally configuring the proxy database, return to the Edge Encryption proxy installer and click Launch.
2. If an issue is detected, or to check the status of your proxy server, you can click Check Status to verify that the proxy is running.
A message displays the proxy status.

What to do next
After successfully installing the Edge Encryption proxy server, Set the proxy server initial memory limit and upper bound memory limit.

Verify and troubleshoot the Edge Encryption proxy server installation
After your Edge Encryption proxy is installed, you can verify the installation to locate problems or start and stop the proxy.

Procedure
1. Open the Edge Encryption proxy installer.
2. Select Verify Installation.
3. Click Proxy Directory and select the proxy directory.
4. Click Run Tests.
   Test results display.
5. Click Next.
If an issue is encountered, you can move through the installer to correct the configuration. If no issues are encountered, the installer jumps to the Launch page. You can check the proxy status, stop the proxy, or start the proxy from the Launch page.

Install the Edge Encryption proxy server using the command line installer
Manually install multiple Edge Encryption proxy servers in your network.

Before you begin
Roles required: security_admin on your ServiceNow instance and local administrator on the host machine.

If order preserving encryption types or encryption patterns are to be used, set up a MySQL database on a machine in your network if not already present.

Note: If using Unbound Technology encryption keys with Edge Encryption, install the proxy server using the command line installer on the Unbound client machine. The Edge Encryption proxy server must run on the same machine as the Unbound technology client.
About this task
First, set up a single Edge Encryption proxy server. After your first proxy server is successfully running, add additional proxy servers for one instance to ensure an optimal environment. See Sizing your Edge Encryption environment to determine the number of additional proxy servers needed.

Install the Edge Encryption proxy server (command line installer)
Install an Edge Encryption proxy on a 64-bit Windows or Linux computer.

Before you begin
Java 8 is required to run the installer.

About this task
Install the Edge Encryption proxy server on a machine in your network using the appropriate command for your target machine. If installing the Edge Encryption proxy server on a Windows machine, you must additionally install the proxy server as a Windows service.

When you upgrade the Edge Encryption proxy server, the system backs up the old proxy in the backup.dist-upgrade-<timestamp> directory under the current installation directory. The backup directory is generated during the upgrade process and stores the old proxy information.

When you run an upgrade via the command line, a dist-upgrade.log may be generated in the directory where the command runs. The dist-upgrade.log contains logs for the upgrade process.

In case of a failed upgrade, the system creates a failed-backup.dist-upgrade-<timestamp> directory. In addition, logs/wrapper.log in the original proxy directory may also contain failure information.

Procedure
1. Create the installation directory.
2. Download the Edge Encryption proxy archive file to the installation directory.
3. Open the terminal and change to the installation directory.

Note: If installing on a Windows machine, you must start the Windows Command Prompt with administrator privileges.

4. Run this command for the target machine and change the variables according to your configuration: java -jar edgeencryption-<version>-all.jar -m install -n <ProxyName> --instancehost <host> -p <InstancePort> --protocol https
<table>
<thead>
<tr>
<th>Option</th>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>none</td>
<td>version</td>
<td>Version number of the Edge Encryption proxy being used to perform the current operation.</td>
</tr>
<tr>
<td>-m</td>
<td>mode</td>
<td>The operation or mode to run in (install or dist-upgrade).</td>
</tr>
<tr>
<td>-n</td>
<td>ProxyName</td>
<td>The name of the encryption proxy instance. Use a unique ProxyName to be able to identify specific proxy instances.</td>
</tr>
<tr>
<td>--instancehost</td>
<td>host</td>
<td>The host name of your ServiceNow instance (for example, mycompany.service-now.com).</td>
</tr>
<tr>
<td>-p</td>
<td>InstancePort</td>
<td>The port of your instance. When the protocol is https, the port is normally 443.</td>
</tr>
<tr>
<td>--protocol</td>
<td>protocol</td>
<td>The protocol used to access your ServiceNow instance (typically https).</td>
</tr>
</tbody>
</table>

**Note:** Do not copy and paste commands from the browser. Occasionally, copy/paste operations cause unexpected characters to be pasted to the target machine and results in the command being executed incorrectly. It is best to type out the command by hand using documentation as a reference.

To see the help screen, execute this command without arguments: `java -jar edgeencryption-<version>-all.jar`

5. If installing on a Windows machine, install the Edge Encryption proxy as a Windows service.
a. Optionally change the name of the service. Open the `conf/wrapper.conf` file on the new proxy and set the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>wrapper.ntservice.name</td>
<td>Unique name of the Edge Encryption proxy service.</td>
</tr>
<tr>
<td>wrapper.ntservice.displayname</td>
<td>Edge Encryption proxy service display name.</td>
</tr>
<tr>
<td>wrapper.ntservice.description</td>
<td>Proxy server description.</td>
</tr>
</tbody>
</table>

If this step is not performed, the Edge Encryption proxy service is installed under the name **Edge Encryption**.

b. Save and close the file.

c. Open the Windows Command Prompt and `cd` to `ServerName_port/bin`.

d. Execute `edgeencryption.bat install`.

**Results**
The `ProxyName_port` directory is created in the current directory. The `edgeencryption.properties` file is updated with the host, port, and protocol values from the command line.

**Create and configure the RSA key pair for the digital signature**

Create an RSA key pair that the proxy server can use to create the digital signature for signing changes to the encryption properties and configuration.

**Before you begin**

To generate and validate the digital signature, an RSA key pair must be generated and stored in the JCEKS Java KeyStore and each proxy must be configured to use this key pair. Generate an encryption key pair using the `keytool` command.

To use the `keytool` utility with a proxy installed on SElinux (CentOS), you must enable loading of shared libraries from the proxy java-installation directory. To do this, run the following command as root.
You must use the Java 1.8 version of the keytool utility. A copy of the utility can be found in `<proxy install dir>/java/jre/bin/keytool`.

**Procedure**

1. Change to the KeyStore directory in the proxy download directory.
2. Change the default password.
   
   The default password is `changeme`.

   ```
   keytool -keystore keystore.jceks -storetype jceks -storepass -new <newpassword>
   ```

3. Create an encryption key pair.

   **Note:** Do not enter a password for the key when the keytool utility prompts for one.

   Enter this command on a single line.

   ```
   keytool -genkeypair -alias <key alias> -keyalg rsa -keystore keystore.jceks -storetype jceks -storepass <keystore password> -keysize 2048
   ```

4. Update the encryption proxy property file (`edgeencryption.properties`).

   a. Change to the `<installation directory>/conf/` directory.

   b. Open the `edgeencryption.properties` file.

   c. Enter the properties for the digital signature.

      These properties must be the same for all proxies.

5. Save and close the `edgeencryption.properties` file.

**Import and configure the certificate for secure SSL connection**

To use a secure SSL connection, import a server certificate and add it to the Java KeyStore.

**Before you begin**

You must obtain the server certificate before you can add it to the Java KeyStore.
Procedure

1. Add a server certificate to the Java KeyStore.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you have the RSA private key in the Java Keystore and generated the certificate from that key.</td>
<td>keytool -import -alias keyname -file server.cert -storetype JCEKS -keystore keystore.jceks -storepass pwd</td>
</tr>
<tr>
<td>If you have a PKCS12 (.pfx) file that contains the RSA key and the certificate.</td>
<td>keytool -importkeystore -destkeystore keystore.jceks -deststoretype jceks -srckeystore &lt;PKCS12 filename&gt; -srcstoretype pkcs12</td>
</tr>
</tbody>
</table>

Make sure that the private key password is the same as the Java KeyStore password.

You can run this command to change the password.

keytool -keypasswd -keystore keystore.jceks -alias <key alias>

For testing, you can use this command to generate a self-signed certificate.

keytool -genkeypair -alias cert -keystore keystore.jceks -storetype jceks -keyalg rsa

2. Update the edgeencryption.properties file.

   a. Change to the <installation directory>/conf/ directory.

   b. Open the edgeencryption.properties file.

   c. Enter the properties for the SSL certificate.

      The certificate must be the same for all proxies connecting to the same instance.

3. Save and close the edgeencryption.properties file.

Enable AES 256-bit encryption

256-bit encryption is more secure than 128-bit encryption, and you can optionally configure AES 256-bit encryption on the Edge Encryption proxy server host. How you enable AES 256-bit encryption depends on the Java update installed on each proxy server host.

Edge Encryption supports only AES 128-bit and AES 256-bit keys.
Note: Java does not automatically allow unlimited strength keys. You must specifically enable the use of AES 256-bit encryption.

Follow the procedure for the Java version that is installed on your proxy server host:

- Enable AES 256-bit encryption for Java 8 update 141 (8u141) or earlier
- Enable AES 256-bit encryption for Java 8 update 151 (8u151) or later

Enable AES 256-bit encryption for Java 8 update 141 (8u141) or earlier

Copy the Java Cryptography Extension (JCE) jurisdiction policy files to the Java home directory of each Edge Encryption proxy server host to enable AES 256-bit encryption for Java update 141 or earlier. 256-bit keys provide greater security than 128-bit keys.

Before you begin
Role required: admin

About this task
Your Java home directory includes the AES 128-bit policy files by default. To enable AES 256-bit encryption, you must overwrite the Java home directory policy files with the AES 256-bit policy files. You only need to download the JCE once, but you must update every Edge Encryption proxy server host.

Note: Java does not automatically allow unlimited strength keys. You must specifically enable the use of AES 256-bit encryption.

Procedure

1. Download the JCE policy 8 ZIP file from Oracle.
2. Unzip the file.
3. On each proxy server host, copy the local_policy.jar and US_export_policy.jar files into the <Java-home-directory>/jre/lib/security folder.

Enable AES 256-bit encryption for Java 8 update 151 (8u151) or later

Edit the java.security policy file to enable AES 256-bit encryption for Java update 151 or later. 256-bit keys provide greater security than 128-bit keys.

Before you begin
Role required: admin
About this task
Perform this task in the Java home directory of each Edge Encryption proxy server host on which you want to enable AES 256-bit encryption.

Note: Java does not automatically allow unlimited strength keys. You must specifically enable the use of AES 256-bit encryption.

Procedure
1. Navigate to `<jre_home>/lib/security/java.security` on the proxy server host, where `JRE_HOME` is an environment variable for both Microsoft Windows and Linux.
2. Open the `java.security` policy file and find the line for the `crypto.policy` parameter, which is commented out by default.
3. Remove the `#` character from the beginning of the `crypto.policy` line to uncomment the line, and then save the file.

Note: If you do not uncomment the `crypto.policy` line, Java uses `crypto.policy=limited`, which restricts encryption to AES 128-bit keys.

Set up a keystore and encryption keys
Set up the keystore and encryption keys used by the Edge Encryption proxy server.

Procedure
1. Carefully determine the appropriate type of keystore to use based on your organization's needs.

<table>
<thead>
<tr>
<th>Supported keystore</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File store</td>
<td>Keys are stored in a file in a file system accessed by the Edge Encryption proxy server. Because encryption keys stored in a file are not encrypted, it is your responsibility to protect these files.</td>
</tr>
<tr>
<td>Java KeyStore</td>
<td>A Java KeyStore:</td>
</tr>
<tr>
<td>Supported keystore</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>• Stores keys in a Java JCEKS KeyStore.</td>
<td></td>
</tr>
<tr>
<td>• Is password protected and more secure than storing keys in a file in the file system.</td>
<td></td>
</tr>
<tr>
<td>• Can store multiple keys. A key alias represents each key, making it easier to manage multiple keys.</td>
<td></td>
</tr>
</tbody>
</table>

The Edge Encryption proxy ships with the Java JCEKS KeyStore file named keystore.jceks in the keystore directory. This keystore file contains the ServiceNow public key used to validate encryption rules signed by ServiceNow.

<table>
<thead>
<tr>
<th>Enterprise Key Management (EKM)</th>
<th>SafeNet KeySecure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keys are stored and retrieved with SafeNet KeySecure key management.</td>
<td></td>
</tr>
</tbody>
</table>

You must secure a license with Gemalto, download the libraries, and install the SafeNet KeySecure keystore on a host machine in your network before configuring the keystore on the Edge Encryption proxy server.

**Unbound Technology**

The base64-encoded wrapped encryption key is stored as text file on the Edge Encryption proxy server. The Unbound Technology implementation (previously Dyadic Security) maintains control of the wrapping key.

The Edge Encryption proxy server must run on the same machine as the Unbound technology client.

⚠️ **Note:** If using a keystore other than the base system Java JCEKS KeyStore, you must import the ServiceNow public key into your keystore. The public key alias is servicenow.

2. Set up the keystore and encryption keys in your local network.

**Set up a Java KeyStore keystore**

You can use a Java KeyStore keystore to store encryption keys.

**Before you begin**

You must use the Java 1.8 version of the keytool utility. A copy of the utility can be found in <proxy install dir>/java/jre/bin/keytool.
About this task
The Edge Encryption proxy ships with the Java JCEKS KeyStore file named keystore.jceks in the keystore directory. This keystore file contains the ServiceNow public key used to validate encryption rules signed by ServiceNow.

Procedure
1. Set up the keystore properties.
   a. Change to the <installation directory>/conf/ directory.
   b. Open the edgeencryption.properties file.
   c. Enter the properties for the Java KeyStore.
2. Save and close the edgeencryption.properties file.

What to do next
After setting up the Java KeyStore, Create encryption keys using the Java KeyStore keytool.

Create encryption keys using the Java KeyStore keytool
You can use the keytool shipped with the encryption proxy distribution to create AES 128-bit and AES 256-bit encryption keys.

Before you begin
You must use the Java 1.8 version of the keytool utility. A copy of the utility can be found in <proxy install dir>/java/jre/bin/keytool.

To find out more about the keytool utility, see the Java SE Documentation.

About this task
ℹ️ Note: The Java KeyStore requires that the alias name (key name, key alias) use lowercase letters and numbers.

Procedure
1. Change to the keystore directory, <installation directory>/keystore/.
2. To create the encryption key, run one of the following commands.

ℹ️ Note: If you choose to run these commands from a directory other than the keystore directory, that is you skipped the previous step, you must change the -keystore option to include the path from your current directory to the keystore directory. For example, if you were in the <installation directory>/bin directory, the option would be -keystore ../keystore/keystore.jceks.
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AES 128</td>
<td>keytool -genseckey -alias 128bitkey -keyalg aes -keysize 128 -keystore keystore.jceks -storetype jceks</td>
</tr>
<tr>
<td>AES 256</td>
<td>keytool -genseckey -alias 256bitkey -keyalg aes -keysize 256 -keystore keystore.jceks -storetype jceks</td>
</tr>
</tbody>
</table>

You add the alias on the instance when you assign default keys.

ℹ️ **Note:** The key password must be the same as the keystore password.

## Set up a SafeNet KeySecure keystore

If you are using a SafeNet keystore, copy a set of libraries into the proxy distribution directory.

### Before you begin

You must install and set up the SafeNet keystore before performing this step. Secure a license with Gemalto in order to download the libraries.

### About this task

ℹ️ **Note:** On Linux, file paths use a forward slash (/).

### Procedure

1. Copy these files to the `<installation directory>/lib` directory:
   - ingrianNAE-<version>.jar
   - ingrianlog4j-api-<version>.jar
   - ingrianlog4j-core-<version>.jar

2. Change to the `<installation directory>/conf/` directory, and open the `edgeencryption.properties` file.

3. Enter the properties for the **SafeNet keystore**.

### Example

An example for a SafeNet keystore using username and password authentication.

```plaintext
edgeencryption.nae.retries = 3
edgeencryption.nae.enabled = true
edgeencryption.nae.server = url
```
edgeencryption.nae.port = 9000
edgeencryption.nae.protocol = ssl
edgeencryption.nae.keystore.path = keystore/safenet_truststore
edgeencryption.nae.keystore.password = password
edgeencryption.nae.user = safenet_user
edgeencryption.nae.password = safenet_password

Example
An example for a SafeNet keystore using client certificate authentication.
This authentication method eliminates the need to store the SafeNet server
username and password in the properties file.

edgeencryption.nae.retries = 3
edgeencryption.nae.enabled = true
edgeencryption.nae.server = url
edgeencryption.nae.port = 9000
edgeencryption.nae.protocol = ssl
edgeencryption.nae.keystore.path = keystore/safenet_clientcert
edgeencryption.nae.keystore.password = password
edgeencryption.nae.client.certificate = cert_name

4. Add or create a key in the SafeNet keystore.
   You add the key name (alias) on the instance when you assign default keys.

   Note: If you have deployed Java 11 proxy or plan to upgrade proxy to
   Java 11, add the folder where all SafeNet jar files are located by adding
   the following line in the wrapper.conf:

   wrapper.java.classpath.1=<directory path to the directory where you copied the jar
   files in step 1>/*

5. Save and close the edgeencryption.properties file.

Upgrade from Kingston or lower to London or higher

If you use a SafeNet NAE server for key storage with Edge, before upgrading
the proxy from Kingston or lower to London or higher, you must copy Gemalto
SafeNet client ProtectApp JAR files and add new properties.

About this task

   Note: On Linux, file paths use a forward slash (/).
Procedure

1. Copy the following files from `<installation directory>/lib` to a directory path that is completely outside of the proxy installation directory path:
   - `ingrianNAE-<version>.jar`
   - `ingrianlog4j-api-<version>.jar`
   - `ingrianlog4j-core-<version>.jar`

2. On the current version (not upgraded) of the proxy, update the `<installation directory>/conf/edgeencryption.properties` file by adding the following two properties:
   - `edgeencryption.ekm.provider.classname = com.snc.edgeencryption.encryption.CloudEdgeNaeKeyProvider`
   - `edgeencryption.thirdparty.vendor.library.path = <directory path to the directory where you copied the jar files in step 1>`

3. Save the changes.

4. Proceed with the upgrade to London or higher.

Set up Unbound Technology keys

To use Unbound Technology (previously Dyadic Security) keys with Edge Encryption, store the base64-encoded wrapped encryption key as text file on the Edge Encryption proxy server and provide the wrapping key alias. The Unbound Technology implementation maintains control of the wrapping key.

Before you begin

Role required: security_admin

In your Unbound Technology implementation, identify both the wrapping key and the wrapped key. Use the RSA/ECB/OAEPWITHSHA-256ANDMGF1PADDING algorithm for wrapping and padding. Export the wrapped key in base64-encoded text format. Save the file using the key alias as the name with no file extension.

Note: If using Unbound Technology encryption keys with Edge Encryption, install the proxy server using the command line installer on the Unbound client machine. The Edge Encryption proxy server must run on the same machine as the Unbound technology client.
Procedure

1. Add the wrapped encryption key in base64-encoded text format to the <proxy-installation-directory>/keys directory. The name of the file must be the key alias with no file extension.

2. Update the edgeencryption.properties file.
   a. Change to the <proxy-installation-directory>/conf directory.
   b. Open the edgeencryption.properties file.
   c. Enter the File store properties. Set the value of edgeencryption.keyfile.directory to keys. This property directs the proxy server to look for the encryption key in the <Java-home-directory>/keys directory.
      For more information on Edge Encryption properties, see Edge Encryption proxy server properties.
   d. Uncomment the properties for the Dyadic provider configuration. Set the value of edgeencryption.ekm.provider.rsa.wrapping.key.alias to the wrapping key alias in your Unbound implementation.
   e. Save and close the file.

What to do next
Add the encryption key alias to the instance. The encryption key alias is the file name of the wrapped encryption key added to the <proxy-installation-directory>/keys directory. For example, if the file in the directory is named myunboundkey, add this name to the Key alias field. See Configure encryption keys on the instance.

Create an encryption key stored in a file
You can use a simple text file as a keystore. Each file holds a single encryption key.

About this task
This step creates both the key storage and the encryption key.

i Note: The name of the key file must match the key alias specified in the encryption keys table in the instance. See Configure encryption keys on the instance.
Procedure

1. Create a file in the `/keys` folder of the proxy server installation directory.
2. Add the encryption key to the file.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AES 128</td>
<td>Place the encryption key, exactly 16 bytes, into the file.</td>
</tr>
<tr>
<td>AES 256</td>
<td>Place the encryption key, exactly 32 bytes, into the file.</td>
</tr>
</tbody>
</table>

3. Update the `edgeencryption.properties` file.
   a. Change to the `<installation directory>/conf/` directory.
   b. Open the `edgeencryption.properties` file.
   c. Enter the properties for the file store.
   d. Save and close the file.

Configure encryption keys on the instance

Edge Encryption provides the tools to manage encryption keys without taking the proxy offline.

Before you begin
Role required: security_admin
Before setting up new encryption keys on the instance:

1. Create the encryption key.
2. Make the new key available to all encryption proxies. Either copy the file or Java KeyStore file to each proxy, or ensure that each proxy has access to the Java KeyStore or Enterprise Key Management (EKM) device.

About this task
Key aliases must be unique. Each key alias must have the same key size and type on each proxy, or the key cannot be assigned as the default.

Procedure

1. Navigate to Edge Encryption Configuration > Encryption Key Configuration > Set Up Keys.
2. On the Add New Keys section of the form, complete the following steps to add a new key.
Note: If using SafeNet versioned keys, an additional column appears for the Key version. The Key version cannot be edited.

Important: If using SafeNet versioned keys, click the Retrieve latest key versions link in the Related Links to retrieve the latest version of each key from the Edge proxy.

Rows in the list with an X in the left column can be deleted. Keys that have been used as the default or that have a Status of Available cannot be deleted.

a. Double-click in the row that says Insert a new row....

b. In the edit box, enter a name for the key, then click the check mark. Key aliases are lowercase letters and numbers. Capital letters are changed to lowercase letters when you click Update. Key aliases must be unique.

Note: If using Unbound technology keys, add the encryption key alias. The encryption key alias is the file name of the wrapped encryption key added to the <proxy-installation-directory>/keys directory. For example, if the file in the directory is named myunboundkey, add this name to the Key alias field.

c. In the same row, double-click in the Key size column.

d. In the select box, select a key size, either 128 bits or 256 bits, then click the check mark.

e. In the same row, double-click in the Type column.

f. In the select box, select a key type, either File, Keystore, SafeNet, or Unbound, then click the check mark.

g. When you are done adding keys, click Next Step. You must specify an alias, key size, and key type for each key before moving on.

3. On the Keys Status section of the form, check the State of the key and ensure that it is Available. This may take a few minutes. When the key is Available, click Next Step.

Note: If using SafeNet versioned keys, an additional column appears for the Key version. The Key version cannot be edited.
The instance tracks the status of every encryption key available to any proxy. When a key is available on all proxies, its state becomes **Available**. If the state does not change after a few minutes, check to ensure that the key is available on all proxies. If the state remains **Unavailable**, one or more of the proxies does not have the key.

### Encryption key states

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available</td>
<td>All online proxies have the key.</td>
</tr>
<tr>
<td>Unavailable</td>
<td>This is a new key and the proxies have not yet loaded the key, or at least one proxy failed to load the key.</td>
</tr>
</tbody>
</table>

4. On the Change Default Keys section of the form, do one of the following:
   - Type in the key alias.
   - Click the magnifying glass icon and select an alias.

   **Note:** If using SafeNet versioned keys, an additional field appears for the **Key version**. The **Key version** is grayed out and cannot be edited.

   **Note:** If using SafeNet versioned keys, choose only the most recent key version. If you choose an earlier version, the following message appears when you click **Update** or **Next Step**:

   ```markdown
   One of the default keys chosen is not the latest version available for the key. Please use the latest version.
   ```

   **Note:** If using SafeNet versioned keys, and if the default keys are not the latest versions of the SafeNet keys, an **Update default keys to latest version** link appears in the Related Links. Click the link to update the default keys to use the latest version.

   Click **Next Step**.

5. On the Schedule Key Rotation section of the form, schedule a mass key rotation job or single key rotation job to encrypt existing data using the new encryption key.

   If you do not run a mass key rotation job or single key rotation job, existing data remains encrypted with the old key until the data is accessed again.
Configure additional properties in the Edge Encryption properties file

After installing the Edge Encryption proxy server in your network and setting up your keystore and keys, configure the additional Edge Encryption properties.

Procedure

1. Open the `<installation directory>/conf/edgeencryption.properties` file and configure the following Edge Encryption proxy server properties:
   - Target (instance) properties
   - User account properties
   - Proxy properties
   - If using order preserving encryption types or encryption patterns, configure the Proxy database properties
   - Clear text and static IV properties

2. Save and close the file.

Configure a web proxy

If your network uses a web proxy, you can set up the Edge Encryption proxy to use the web proxy.

About this task

If your network does not use a web proxy, leave the web proxy properties in the configuration file commented out.

The Edge Encryption proxy server supports HTTP connection to and basic authentication with the web proxy.

Procedure

1. Change to the `<installation directory>/conf/` directory.
2. Open the `edgeencryption.properties` file.
3. Configure the web proxy properties.
4. Save and close the `edgeencryption.properties` file.
5. If the web proxy is using a customer-specific server certificate, add this certificate to the JVM used by the Edge Encryption proxy server to establish trust between the web proxy and the Edge Encryption proxy server.
   a. `cd` to `<Java home directory>/jre/lib/security/cacerts`
   b. Execute the command: `keytool -keystore cacerts -importcert -alias <chooseAlias> -file <certificateFile>`
Set the proxy server initial memory limit and upper bound memory limit

Set the initial memory limit and upper bound memory limit to specify how much memory the proxy server can consume. Set these limits to avoid performance issues in your Edge Encryption implementation.

About this task
As a guideline, set both the initial memory limit and the upper bound memory limit to the same value. On any machine, allocate 2 GB of the physical memory to the operating system (OS). Then allocate the rest of the physical memory to the heap using the initial memory limit and upper bound memory limit properties. For example, on a machine with 8 GB of memory, allocate 2 GB to the OS, and allocate the remaining 6 GB (6144 m) to the initial and upper bound memory.

Important: If your Edge Encryption proxy server is running, you must stop and restart the proxy server after updating these properties.

Procedure
1. In your proxy server directory, open <install dir>/conf/wrapper.conf.
2. To set the initial memory limit, add the following line at the end of the file:

   wrapper.java.additional.<number>=-Xms<min_memory_in_MB>m

   Set <number> to the next available <number> in the sequence of
   wrapper.java.additional.<number> properties defined in the wrapper.conf file.

   Example
   For example, you have the following list of wrapper.java.additional.<number> properties:

   wrapper.java.additional.1=
   wrapper.java.additional.2=

   The maximum <number> in the above list is 2. When you add the
   wrapper.java.additional.<number>=-Xms<min_memory_in_MB>m line, set <number> to
   3, the next available number.

   Important: Do not leave gaps in the numbering sequence.

   Set <min_memory_in_MB> to the number of megabytes of memory remaining
   after allocating 2 GB of memory to the OS.

3. Set the upper bound memory limit.
   Because an upper bound memory limit is not set in the base system, the proxy server can use all available memory. If other services are running on the server, you may want to set the upper bound memory limit.
Add the following line at the end of the file:

```java
wrapper.java.additional.<number>=-Xmx<max_memory_in_MB>m
```

Set `<number>` to the next available `<number>` in the sequence of `wrapper.java.additional.<number>` properties defined in the `wrapper.conf` file.

**Example**

For example, you have the following list of `wrapper.java.additional.<number>` properties:

```
wrapper.java.additional.1=
wrapper.java.additional.2=
```

The maximum `<number>` in the above list is 2. When you add the `wrapper.java.additional.<number>=-Xmx<max_memory_in_MB>m` line, set `<number>` to 3, the next available number.

-duration: Note:

Do not leave gaps in the numbering sequence.

Set `<max_memory_in_MB>` to the number of megabytes of memory remaining after allocating 2 GB of memory to the OS.

4. Save and close the file.

**Example: Example: Setting proxy server initial and upper bound memory limits**

```
wrapper.java.additional.1 = -Djava.io.tmpdir=../tmp
wrapper.java.additional.2 = -Dcloudedge.home.dist=..
# must ensure UTF8 encoding when running on Windows
wrapper.java.additional.3 = -Dfile.encoding=UTF8
# additional properties for heap settings
wrapper.java.additional.4 = -Xms6144m
wrapper.java.additional.5 = -Xmx6144m
```

**What to do next**

Start the Edge Encryption proxy.

**Start the Edge Encryption proxy**

After an Edge Encryption proxy is installed and configured, you can start the proxy from the command line.

**Before you begin**

Before starting the encryption proxy, verify the following:
• The Edge Encryption plugin is activated on the instance.
• The edgeencryption.properties file on this machine has been configured.
• If using an order preserving encryption type or encryption patterns, the proxy database is running.

⚠️ Note: The first time you set up the edgeencryption.properties file or change properties, you may not want to set the password encryption property. After you have verified that everything is working, you can set the password encryption property, shut down the proxy, and then restart the proxy.

Procedure
1. Run the proxy server.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On a Linux machine</td>
<td>a. cd to ServerName_port</td>
</tr>
<tr>
<td></td>
<td>b. Execute ./startup.sh</td>
</tr>
<tr>
<td>On a Windows machine</td>
<td>Perform the following steps from the command line as admin:</td>
</tr>
<tr>
<td></td>
<td>a. cd to ServerName_port/bin</td>
</tr>
<tr>
<td></td>
<td>b. Execute edgeencryption.bat start</td>
</tr>
</tbody>
</table>

2. Check the log on the proxy server to verify that the proxy is running.

Obfuscate passwords in the properties file
You can obfuscate passwords in the edgeencryption.properties file to share the properties file without revealing clear text passwords.

Before you begin
Make sure that the Edge Encryption proxy server is set up and successfully running before you set this property. Before setting this property, Stop the Edge Encryption proxy.

About this task
Setting this property may make it difficult to debug connection and access issues during initial startup. Only set this property in production environments after the proxy has been set up and tested successfully.
Procedure

1. Change to the `<installation directory>/conf/` directory.

2. In the `conf` directory, create a text file containing a complex string or phrase that can be used as a passphrase which the proxy uses to obfuscate the passwords in the `edgeencryption.properties` file. This passphrase should be a random and complex phrase not related to the passwords themselves.

3. Open the `edgeencryption.properties` file.

4. Set the `password encryption property`.

5. Save and close the `edgeencryption.properties` file.

What to do next

After setting this property, you can Start the Edge Encryption proxy.

Manually add an additional proxy

After the first Edge Encryption proxy is properly configured and tested, you can set up additional proxies on a Linux or Windows machine. Installing multiple proxies on the same machine is not recommended.

About this task

Add additional proxy servers on additional machines to ensure an optimal environment. See Sizing your Edge Encryption environment to determine the number of additional proxies needed.

**Note:** Make sure that all proxies have the same encryption keys and the same RSA key pair used to digitally sign encryption configuration and encryption rules. If a proxy database was set up as part of the installation, all proxies must use the same proxy database.

Procedure

1. Install the proxy using the appropriate command. See Install the Edge Encryption proxy server (interactive installer).

2. Copy all the encryption keys and the `edgeencryption.properties` file from the first proxy to the new proxy.

   Encryption keys may be located in the proxy keystore, in the `/keys` directory, or in a SafeNet KeySecure keystore.

3. Open the `edgeencryption.properties` file on the new proxy.

4. Change the following properties:
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.proxy.name</td>
<td>Unique name of the proxy server</td>
</tr>
<tr>
<td>edgeencryption.proxy.host</td>
<td>The server name, IP address, or fully-qualified domain name of the computer running the proxy.</td>
</tr>
<tr>
<td>edgeencryption.proxy.http.port</td>
<td>Port on the proxy for HTTP communication. Must be unique across all processes on the machine.</td>
</tr>
<tr>
<td>edgeencryption.proxy.https.port</td>
<td>Port on the proxy for HTTPS communication. Must be unique across processes on the machine.</td>
</tr>
</tbody>
</table>

5. If installing the proxy server on a Windows machine, you must change the name of the service. Open the `conf/wrapper.conf` file on the new proxy and add the following properties.

ℹ️ Note: You must perform this step before launching the proxy server.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>wrapper.ntservice.name</td>
<td>Unique name of the Edge Encryption proxy service.</td>
</tr>
<tr>
<td>wrapper.ntservice.displayname</td>
<td>Edge Encryption proxy service display name.</td>
</tr>
<tr>
<td>wrapper.ntservice.description (Optional)</td>
<td>Proxy server description.</td>
</tr>
</tbody>
</table>

6. Save and close the file.

7. Launch the proxy using the appropriate command. See Start the Edge Encryption proxy.

**Authenticate an Edge Encryption proxy server**

Specify that a proxy server is a trusted source so that Edge Encryption can process requests coming from that proxy server.

**Before you begin**

If a proxy server is not authenticated, the console log includes the following message:
WARN This Edge Encryption proxy has not yet been authenticated by the instance. Please navigate to the matching Proxy record on your ServiceNow instance and authenticate it.

If you attempt to access the proxy, you receive the following message: This site can't be reached.

To maintain the proxy in an operational state during the upgrade process, authentication is not required until after the proxy update is successful.

Role required: admin

Procedure
1. Navigate to Edge Encryption Configuration > Proxies.
2. Select the proxy and click Authenticate.

Results
The proxy moves from Unauthenticated to Pending to Authenticated. The status changes from Unauthenticated to Pending when you start the authentication. When authentication is complete, the status changes from Pending to Authenticated, and you can access the proxy and Edge Encryption can accept requests from the proxy.

Note: If you stop and restart the proxy, the proxy remains Authenticated and restarts successfully.

Stop the Edge Encryption proxy
You can stop an Edge Encryption proxy from the command line.

Procedure
1. Stop the proxy server.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On a Linux machine</td>
<td>Execute ./shutdown.sh</td>
</tr>
<tr>
<td>On a Windows machine</td>
<td>Execute edgeencryption.bat stop</td>
</tr>
<tr>
<td></td>
<td>To remove the Windows service, execute edgeencryption.bat remove</td>
</tr>
</tbody>
</table>

2. Check the log on the proxy server to verify that the proxy has stopped.
Uninstall the Edge Encryption proxy on Linux

You can uninstall the Edge Encryption proxy. If you are upgrading the proxy, it is not necessary to shut down and uninstall the current version.

Before you begin
You must have access to the computer running the Edge Encryption proxy.

About this task
Before shutting down the Edge Encryption proxy, ensure that no users are connected to the instance using the proxy.

The encryption proxy running on Linux operates as a single process. You can end this process to accommodate such tasks as redeploying the encryption proxy to another host machine, updating the proxy version, updating the Java version, or changing the unique name of the encryption proxy when deploying the encryption proxy on multiple proxy servers.

Procedure
1. You may want to save the edgeencryption.properties file before deleting the distribution directory.
2. Execute the shutdown.sh shell script.
3. Check the log on the proxy server to verify that the proxy server is shut down.
4. Delete the files in the distribution folder.

Uninstall the Edge Encryption proxy on Windows

You can uninstall the Edge Encryption proxy. If you are upgrading the proxy, it is not necessary to shut down and uninstall the current version.

Before you begin
You must have access to the computer running the Edge Encryption proxy.

Before shutting down the Edge Encryption proxy, ensure that no users are connected to the instance using the proxy.

Procedure
1. You may want to save the edgeencryption.properties file before deleting the distribution directory.
2. Execute edgeencryption.bat stop
3. Execute edgeencryption.bat remove
4. Check the log on the proxy server to verify that the proxy server is shutdown.
5. Delete the files in the distribution folder.

**Set up multiple provider SSO with Edge Encryption**

If implementing multiple provider single sign-on (SSO) with Edge Encryption enabled, some users may need to log in to your instance through the Edge Encryption proxy server, while other users may not. Set up multiple provider SSO to enable logging in through the Edge Encryption proxy server URL or the instance URL.

**Before you begin**

- Role required: admin
- Enable the Edge Encryption plugin (com.glide.edgeencryption) and ensure that one or more proxy servers are set up in your network.
- Determine the URL for the Edge Encryption proxy server that users will log in through using multiple provider SSO. To determine the URL of an Edge Encryption proxy server, see Edge Encryption installation.

**About this task**

- If routing all users through the Edge Encryption proxy server, set up your identity provider record and define the proxy server URL in the **ServiceNow Homepage**, **Entity ID / Issuer**, and **Audience URI** fields.
- To route some users through the proxy server and some users to the instance, create two identity provider records. Both records use the same value in the **Identity Provider URL** field. However, one of the records routes through the proxy server, while the other routes to the instance.

**Procedure**

1. Enable the duplication of identity provider URLs in identity provider records. A unique constraint prevents duplication of the identity provider URL in two different identity provider records. You can enable duplication of the identity provider URL in multiple IdP records by setting a field to false.
   
   a. Navigate to **System Definition > Dictionary**.
   
   b. Open the definition record for the **idp** field of in the Identity Providers table [saml2_update1_properties].
c. Configure the form to add the **Unique** field.

d. Ensure that the value of the **Unique** field is set to **false**.

2. Navigate to **Multi-Provider SSO > Identity Providers**.

3. Create two identity provider records for the same identity provider: one using the instance URL and one using the Edge Encryption proxy server URL. To create an identity provider record, see .

   a. For the Edge Encryption proxy server URL, complete the form using these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identity Provider URL</td>
<td>Imported from IdP metadata.</td>
</tr>
<tr>
<td>ServiceNow Homepage</td>
<td>The URL for your proxy server homepage. For example: https://&lt;proxy hostname&gt;:&lt;port&gt;/ navpage.do</td>
</tr>
<tr>
<td>Entity ID / Issuer</td>
<td>https://&lt;proxy hostname&gt;:&lt;port&gt;</td>
</tr>
<tr>
<td>Audience URI</td>
<td>https://&lt;proxy hostname&gt;:&lt;port&gt;</td>
</tr>
</tbody>
</table>

   b. Click **Submit**.

   c. For the instance URL, complete the form using these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identity Provider URL</td>
<td>Imported from IdP metadata.</td>
</tr>
<tr>
<td>ServiceNow Homepage</td>
<td>https://&lt;instance&gt;.service-now.com/navpage.do</td>
</tr>
<tr>
<td>Entity ID / Issuer</td>
<td>https://&lt;instance&gt;.service-now.com/navpage.do</td>
</tr>
<tr>
<td>Audience URI</td>
<td>https://&lt;instance&gt;.service-now.com/navpage.do</td>
</tr>
</tbody>
</table>

   d. Click **Submit**.

4. **Optional**: If using more than one identity provider, modify the MultiSSO installation exit.
a. Navigate to **System Definition > Installation Exits.**
   The system displays the current list of installation exits.

b. Open the **MultiSSO** installation exit.

c. Locate the following statement in the **Script** field.

   ```javascript
   var samlResponseTxt = request.getParameter("SAMLResponse");
   if (GlideSession.get().isLoggedIn() && GlideStringUtil.notNil(samlResponseTxt)) {
       var idpRecord = this.getIdPRecord(request);
       if (idpRecord) {
           SSO_Helper.debug("IdP found based on SAML response: " +
           idpRecord.getUniqueValue());
           return new SSO_Helper(idpRecord.getUniqueValue(), false, null, true);
       }
   }
   ``

   **Note:** IdP initiated login does not work in this configuration.

d. Replace the statement with the following code.

   ```javascript
   var samlResponseTxt = request.getParameter("SAMLResponse");
   if (GlideSession.get().isLoggedIn() && GlideStringUtil.notNil(samlResponseTxt)) {
       /* // You have two profiles that use the same IdP entity id it cannot use
       // the IdP issuer / entity id from the response otherwise it may result in the
       // wrong IdP profile. IdP initiated login will not work
       var idpRecord = this.getIdPRecord(request);
       if (idpRecord) {
           SSO_Helper.debug("IdP found based on SAML response: " +
           idpRecord.getUniqueValue());
           return new SSO_Helper(idpRecord.getUniqueValue(), false, null, true);
       }*/
       return new SSO_Helper(null, true);
   }
   ``

e. Click **Update.**

5. **Optional:** If using more than one company, update the sys_id of the identity provider record depending on the user.
• To configure a user to log in through the Edge Encryption proxy server, use the sys_id of the identity provider record that uses the Edge Encryption proxy server URL.

• To configure a user to log in to the instance, use the sys_id of the identity provider record that uses the instance URL.

### Login URLs

<table>
<thead>
<tr>
<th>URL</th>
<th>Login destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>https://&lt;instance name&gt;.service-now.com/login_with_sso.do?glide_sso_id=&lt;sys_id of IdP record for the instance URL&gt;</td>
<td>Logs in through the instance.</td>
</tr>
</tbody>
</table>

### Edge Encryption proxy server properties

The `edgeencryption.properties` configuration file located in the `<installation directory>/conf/` folder contains properties used to configure your environment.

You must restart the proxy server after making changes to any proxy server properties. Changes on the instance and changes to the `log4j.properties` do not require a proxy restart.

### Target (instance) properties

- **edgeencryption.target.host**
  
  Host name for the instance. Must be the same for all encryption proxies connecting to the same instance. This property is set when the proxy is installed. For example, `instancename.servicenow.com`

- **edgeencryption.target.port**
  
  Instance port. Must be the same for all encryption proxies connecting to the same instance. This property is set when the proxy is installed.

- **edgeencryption.target.protocol**
Instance protocol. Must be the same for all encryption proxies connecting to the same instance. This property is set when the proxy is installed. Options include:

- http
- https

User account properties

edgeencryption.target.username

User name that the proxy uses to log in to the instance. The user must have the edge_encryption role. See Set up an Edge Encryption user account.

edgeencryption.target.password

Password that the proxy uses to log in to the instance.

Proxy properties

edgeencryption.proxy.host

Server name, IP address, or fully qualified domain name of the computer running the proxy. Along with the port, this property defines the URL used by the client to access the proxy server.

edgeencryption.proxy.name

Proxy name. Must be unique for each proxy.

edgeencryption.proxy.http.port

Port on the proxy for HTTP communication.

edgeencryption.proxy.https.port

Port on the proxy for HTTPS communication.

SSL certificate properties

Restart your proxy if you change the value of any SSL certificate property. The system uses the HTTPS keypair on startup to establish the proxy server connection and determine how the proxy answers client requests.

edgeencryption.proxy.https.cert.alias

Alias of the certificate provided by the proxy server to connecting clients.

edgeencryption.proxy.https.keystore.path

Path to the keystore that contains the HTTPS certificate.

edgeencryption.proxy.https.keystore.password
Password for the keystore that contains the HTTPS certificate.

**Proxy configuration locked property**

*edgeencryption.proxy.locked*

When true, the proxy does not accept encryption configuration changes or encryption rule changes from the instance. Set this property on the production instance after all encryption configurations and rules are final.

**Proxy database properties**

*edgeencryption.db.url*

Proxy database location. Must be the same for all encryption proxies connecting to the same instance.

*edgeencryption.db.user*

User name for accessing the proxy database. Must be the same for all encryption proxies connecting to the same instance.

*edgeencryption.db.password*

Password to access the proxy database. Must be the same for all encryption proxies connecting to the same instance.

*edgeencryption.db.name*

Proxy database name. Must be the same for all encryption proxies connecting to the same instance.

- Default value: edgeencryption

*edgeencryption.db.bootstrap.file*

Bootstrap file for the proxy database. The file is relative to the sql/ directory. Must be the same for all encryption proxies connecting to the same instance.

⚠️ **Warning:** Under normal circumstances, do not change this parameter.

**Digital signature properties**

*edgeencryption.proxy.signature.keystore.path*

Path and Java KeyStore file name.

*edgeencryption.proxy.signature.keystore.password*

Password. The default password is <changeme>. Change the password after installing the Java KeyStore.
edgeencryption.proxy.signature.keystore.keyalias
   The key alias given as the \texttt{-alias} argument when the RSA key pair is generated.

NAE device keystore properties
edgeencryption.nae.retries
   Number of retries to make.
edgeencryption.nae.enabled
   Setting indicates whether an NAE device is available.
edgeencryption.nae.server
   Name of the NAE server.
edgeencryption.nae.port
   Port used by the NAE server.
edgeencryption.nae.protocol
   Protocol used by the NAE server.
edgeencryption.nae.keystore.path
   Path to the keystore on the NAE server.
edgeencryption.nae.keystore.password
   NAE keystore password.
edgeencryption.nae.username
   User name to use to authenticate with the NAE device.
edgeencryption.nae.password
   Password to use to authenticate with the NAE device.
edgeencryption.nae.client.certificate
   Certificate located in the keystore on the NAE server. Set this property to authenticate using a certificate instead of a username and password.

Clear text and static IV properties
edgeencryption.customer.assigned.known.cleartext
   Clear text to let the instance verify that all proxies are using the same keys. At startup, the proxy encrypts the clear text and sends the encrypted text to the instance. The instance does not know the clear text, nor are keys sent to the instance. This property must be the same for all proxies.
edgeencryption.encrypter.static.iv

Static IV (initialization vector) used in equality-preserving and order-preserving encryption. This property must be the same for all proxies and must be exactly 16 bytes (16 ASCII characters).

Password property

edgeencryption.encrypter.properties.password

Name of the file in the conf folder that contains a string used within a secure process to obfuscate passwords in the edgeencryption.properties file.

If this property is not set, passwords in your properties file appear in clear text. Leave this property blank until after the proxy configuration has been set up and tested.

Web proxy properties

edgeencryption.webproxy.host

Web proxy name or IP address.

edgeencryption.webproxy.port

Port on the web proxy.

edgeencryption.webproxy.user

User name used to connect to the web proxy. If your web proxy does not use authentication, leave this property commented out.

edgeencryption.webproxy.password

Password to use to connect to the web proxy. If your web proxy does not use authentication, leave this property commented out.

Java KeyStore properties

edgeencryption.keystore.path

Path to the Java KeyStore. If using a file store or a SafeNet KeySecure keystore, leave this property commented out.

Example:

edgeencryption.keystore.path = keystore/keystore.jceks

edgeencryption.keystore.password

Password the proxy uses to connect to the Java KeyStore. If using a file store or a SafeNet KeySecure keystore, leave this property commented out.
File store property

**edgeencryption.keyfile.directory**

The directory specifies where key files are stored. If using the Java KeyStore or a SafeNet KeySecure keystore, leave this property commented out.

Example:

```
edgeencryption.keyfile.directory=keys
```

If using Unbound Technology keys, uncomment this property and set the value to the keys directory.

Unbound Technology provider properties

**edgeencryption.ekm.provider.classname**

Internal class name for the implementation.

⚠️ **Warning:** Do not change this property.

**edgeencryption.thirdparty.vendor.library.path**

Path to the Unbound API JAR file on the Unbound client machine.

**edgeencryption.ekm.provider.rsa.wrapping.key.alias**

Wrapping key alias in the Unbound Technology implementation.

Must be the same for all proxies.

General configuration properties

**edgeencryption.config.poll.interval**

Poll interval in seconds. The default setting means that it takes 5 seconds for the proxy to learn of encryption configuration changes. Larger values cause the instance to take longer to detect an offline proxy.

⚠️ **Warning:** Do not change this property. Changing the default setting of the Proxy Poll Interval can result in detection delays when a proxy comes online.

**edgeencryption.rules.dir**

Folder where the encryption rules are stored on the proxy.

**edgeencryption.encryption.order_preserving.cache.enable**

Setting determines whether caching is used to support order-preserving encryption types.
edgeencryption.encryption.order_preserving.cache.size
  Maximum cache size, in bytes.

edgeencryption.jobs.concurrency
  Maximum number of mass encryption jobs that can run concurrently on this proxy.

edgeencryption.jobs.requests_per_second
  Number of http job requests per second that can be sent to the instance by this proxy.

edgeencryption.attachments.request.timeout.seconds
  Attachment upload request timeout in seconds.

edgeencryption.request.buffer.size
  Size of an encryption request. If an encryption request is larger than this size, the excess is saved to disk.

⚠️ Warning: Do not change this property.

edgeencryption.httpclient.request.buffer.size
  Size of the client request. If the client request is larger than this size, the excess is saved to disk.

⚠️ Warning: Do not change this property.

edgeencryption.proxy.idle.timeout
  Time in seconds after which a transaction times out.
  • Default value: 300 (seconds)

edgeencryption.proxy.keepalive.interval
  Time in seconds between pings issued by the proxy to the instance. Pings are issued periodically to verify connectivity between the proxy and the instance.
  • Default value: 10 (seconds)
  • Minimum value: 5 (seconds)

edgeencryption.register.retry.count
  Maximum number of times the proxy pings the instance to try to register.
  • Default value: 0 (no limit)
edgeencryption.tokenization.exclusion.list

Encryption patterns cannot tokenize strings found in these fields.

Proxy server performance properties

Proxy server performance properties are not present in the configuration file by default. To change the default values, you must add the properties and restart the proxy server. For more information, see Edge Encryption diagnostics and performance.

edgeencryption.stat.collection.enabled

Enables the collection of statistics used by the Edge Encryption proxy server performance dashboard.

• Default value: true

Add this property and set the value to false to disable the collection of statistics used by the Edge Encryption proxy server performance dashboard.

edgeencryption.stat.collection.interval

Interval length in seconds during which the Edge Encryption proxy server collects statistics. The value cannot be less than 30 seconds.

• Default value: 30 (seconds)

Deprecated proxy encryption properties

edgeencryption.encrypter.default.key128

Specifies the name of the current AES 128 key. An AES 128 key must be available even if it is not used. Must be the same for all proxies.

Perform maintenance of these keys on the instance.

edgeencryption.encrypter.default.key256

Specifies the name of the current AES 256 key. Must be the same for all proxies.

Perform maintenance of these keys on the instance.

edgeencryption.encrypter.key

Specifies the key name for each key and is used to specify the default keys. This is the key alias integrated with the metadata that is included with each encrypted item and, therefore, is stored on the instance. The key name must use lowercase letters.

edgeencryption.encrypter.type
Specifies the type of encryption keystore system.

`edgeencryption.encrypter.file`

Specifies the path and file name of the text file associated with the key.

`edgeencryption.encrypter.password`

Specifies the password for accessing the keystore.

**CyberArk integration with the Edge proxy server**

Use CyberArk to store passwords in a centralized and secure digital vault to secure passwords that were previously stored in clear text and secured by file access, or that were previously encrypted via a second file.

CyberArk AIM (Application Identity Management) prevents unauthorized access by eliminating hard-coded and visible passwords. AIM stores passwords in a digital vault on an independent hardened server, where the passwords are represented as digital credentials. The AIM clients (the Edge proxy servers) use CyberArk digital credentials and access the independent server to retrieve the secured passwords. No passwords are stored on the Edge proxy servers or in the instance.

**CyberArk digital vault credentials**

You must purchase and configure CyberArk before you can set up CyberArk integration with the Edge proxy server.

To add a credential to CyberArk (which is read by the Edge proxy), set the **Platform Name** of the credential to **Unix via SSH** and make sure you either create a **Custom** credential **Name** or write down the **Auto-generated** credential **Name**. When you configure the Edge proxy to use this credential, the proxy server matches this credential **Name** to the setting in the proxy.
Each credential entry holds a **Password** that is being secured, as well as a credential **Name** used by an application to access that password.

⚠️ **Note:** CyberArk credentials are not encryption keys.

**Adding CyberArk during an Edge proxy installation**

The proxy installer includes a new configuration page for a CyberArk integration. This page is optional if you do not want to include CyberArk when installing your proxy with the proxy installer. You can also manually set up and configure CyberArk integration in the configuration file.
The proxy installer also includes a new page for CyberArk protected credentials. This page allows configurations of different properties using a single credential name or multiple credential names. This page is optional if you do not want to include CyberArk when installing your proxy with the proxy installer.
CyberArk password protection
Any password field in the Edge proxy installer that has a CyberArk credential configured in the CyberArk vault and specified on the CyberArk Protected Credentials page of the installer is grayed out and contains the message Protected by CyberArk.
Using a load balancer with the Edge proxy server

You can use a load balancer to balance the load across the proxy servers in your Edge Encryption proxy setup. If the load balancer and proxy servers are using different ports, specify the host name and HTTPS port of the load balancer to enable users to view responses on their browser.

**Important:** All production environments should include at least two Edge Encryption proxy servers for redundancy.

**Edge request processing without a load balancer**

If you are not using a load balancer, a request is processed as described below.

1. The user issues a request from a browser.
2. The browser sends the request to the Edge proxy server.
3. The proxy server sends the request to the ServiceNow instance.
4. The ServiceNow instance returns the response to the proxy server.
5. The proxy server adds its own port number in the response header before returning the response to the user's browser.

The request is completed successfully because the user can view the response from the proxy server at the port number specified in the response header.
Edge request processing with a load balancer

However, if you are using a load balancer, the user’s browser communicates directly with the load balancer, not with the proxy server. A request is processed as described below.

ℹ️ Note: The following example uses 1025 as the proxy server port number.

1. The user issues a request from a browser.
2. The browser sends the request to a load balancer Virtual IP (VIP), also known as a Virtual Server.
3. The VIP is configured to point to the proxy server (for example, 10.2.200.148:1025), so the load balancer forwards the request to the proxy server.
4. The proxy server sends the request to the ServiceNow instance.
5. The ServiceNow instance returns the response to the proxy server.
6. The proxy server rewrites the location header in the response with values configured in the properties for risk-servicenow.dev.echonet:1025.
   - Host: edgencryption.proxy.host
   - HTTP port: edgeencryption.proxy.http.port
   - HTTPS port: edgeencryption.proxy.https.port
7. The proxy server forwards the response to the load balancer with the location header pointing to the proxy server port.

The outcome depends on whether the load balancer and proxy servers are using the same port.

- If the load balancer and proxy servers are using the same port, the request succeeds because the user receives the response from the same port identified in the response header.
- If the load balancer and proxy servers are using different ports, the request fails because the user's browser communicates only with the load balancer, but the response is on the proxy server.

Solution

You could resolve the issue by simply using the load balancer and all Edge proxy servers on the same port, but this is not an ideal solution. A better solution is to enable the system to know which port the load balancer uses.
The following properties enable the Edge proxy server to reroute response messages to the load balancer if the proxy server and load balancer are using different ports.

- `edgeencryption.proxy.rewrite.location.host` specifies the host name used to access ServiceNow through the load balancer.
- `edgeencryption.proxy.rewrite.location.https.port` specifies the HTTPS port used to access ServiceNow through the load balancer.

**Configure the load balancer**

If the load balancer and proxy servers are using different ports, specify the host name and HTTPS port of the load balancer to enable users to view responses on their browser.

**Before you begin**

Roles required:
- local or domain administrator on a Windows host
- service user with full file system access on a Linux host

**Procedure**

1. Login to the proxy server host as admin, domain admin, or a service user.
2. Navigate to the installation directory for the Edge proxy and select `conf/edgeencryption.properties`.
3. Set the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| `edgeencryption.proxy.rewrite.location.host` | If your Edge configuration includes a load balancer to balance the load among proxy servers, rewrites responses to the load balancer so requests can be completed.  
  • If there is a load balancer in the proxy setup, specify the host name used to access ServiceNow through the load balancer.  
  • **Optional**: If there is no load balancer in the proxy setup, can be set to the host name used by the proxy server. |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| edgeencryption.proxy.rewrite.location.https.port | If your Edge configuration includes a load balancer to balance the load among proxy servers, specifies the HTTPS port used to access ServiceNow through the load balancer.  
- If there is a load balancer in the configuration, specify the HTTPS port used to access ServiceNow through the load balancer.  
- **Optional**: If there is no load balancer in the configuration, can be set to the HTTPS port used by the proxy server. |

4. Save the file.

**Results**
Requests can be completed because users can now view responses on their browser.

**Edge Encryption upgrades**
Both instance upgrades and proxy server upgrades require special consideration in an Edge Encryption environment.

**Instance upgrades**
Instance upgrades in an Edge Encryption environment require caution to ensure that Edge controls work properly after the instance upgrade.

During an instance upgrade, you should not add, edit, or delete the following:
- Edge Encryption configurations
- Edge Encryption rules
- Edge Encryption tokenization patterns
- Edge Encryption scheduled jobs
- Edge Encryption key configurations
- Edge Encryption scheduled upgrades
- Edge Encryption denylist IP configurations
Any scheduled job running during the instance upgrade will not complete. To complete the interrupted job, rerun the job once the instance is upgraded. When you reschedule the job, the processing that occurred before the instance upgrade is not lost, and the job continues to process only the data that has not yet been processed.

**Proxy server upgrades**
Schedule a proxy upgrade to enable the instance to upgrade the Edge Encryption proxy server, or manually upgrade the proxy server at any time.

⚠️ **Warning:** For an upgrade on Windows, you may encounter file lock issues and the upgrade may fail. For the upgrade to succeed, you should not have any files open under the installation directory. Also, there should be no existing shell in the installation directory. In particular, if you start the proxy from the command line (via `bin\edgeencryption.bat install/start`) while in the installation directory, you should close that shell or move it out of the installation directory afterward. No files under the installation directory should be opened by an editor or by any other application.

**Third party libraries**
Third party libraries, such as Gemalto, are lost during instance and proxy server upgrades if they are kept in the same directory. You can perform the following to prevent the loss of third party libraries during upgrades:

1. Manually add the following property to `edgeencryption.properties`:

   ```
   edgeencryption.ekm.provider.classname = com.snc.edgeencryption.encryption.CloudEdgeNaeKeyProvider
   ```

2. Add the `edgeencryption.thirdparty.vendor.library.path` vendor library location property and set it to `/path/to/jars`.

   For example:

   ```
   edgeencryption.thirdparty.vendor.library.path = /app/servicenow/libs
   ```

3. Copy the SafeNet JARs into that path.

After you install the third party libraries outside of the Edge Encryption installation, they are no longer lost during upgrades.

**Scheduled upgrades**
Schedule an upgrade to allow the instance to upgrade the proxy server at the scheduled time. This functionality is available by default after upgrading. A scheduled upgrade includes these events:
1. The proxy server checks with the instance to see if there is a new version available for upgrade. New versions generally become available when the instance is upgraded.

2. The administrator receives a notification upon logging in when a new version of the proxy server is available.

3. The administrator can Schedule an Edge Encryption proxy server upgrade for each proxy server.

   Note: Only users with the security_admin role can create an upgrade schedule through the proxy server.

4. Once the upgrade is scheduled, the proxy server automatically upgrades at the scheduled time. During the upgrade, the proxy server is offline for only a short time.

   Note: Because the proxy server restarts during the upgrade, it is offline for a short time. The amount of time is determined by your environment and how long it takes to stop and restart the proxy service.

5. During the scheduled upgrade, a new proxy directory is created and your configuration files are copied to the new directory. New properties are written to your existing properties file. The following files or directories in your old proxy directory are copied to the new proxy directory.

   • /conf directory
   • /keys directory
   • /keystore directory
   • java/jre/lib/security/cacerts file

   As a result, your keys, keystores, settings, and certificates are preserved.

   Note: Only the above files are copied to the new proxy directory. Any other customized files in the proxy server directory are not preserved during a scheduled upgrade. The upgrade log file can be found in the original proxy directory in the following folder: <original-proxy-directory>/tmp/upgrade-wrapper/bin.

**Prerequisites for scheduled upgrades**

Before scheduling an upgrade for an Edge Encryption proxy, ensure the following:

1. The JAVA_HOME environment variable points to a java installation on the machine that is outside the Edge Encryption proxy’s directory structure.

2. The JAVA_HOME environment variable points to a java installation that is at version 1.8_u144 or higher.
3. The `-Djava.io.tmpdir` parameter in the wrapper.conf file of the Edge Encryption proxy points to a directory that is OUTSIDE the Edge Encryption proxy’s directory structure, and the proxy has read/write/execute permissions on the directory. Optionally, you could comment out the parameter entirely so that Java uses its default tmp location.

Manual upgrades

Instead of creating an upgrade schedule, you can manually upgrade each proxy server through the command line. See Manually upgrade an Edge Encryption proxy server running on Linux or Manually upgrade an Edge Encryption proxy server running on Windows.

Proxy build status

You can easily identify whether a proxy server is out of date by navigating to Edge Encryption Configuration > Proxies > All. The status of your proxy build is indicated in the Proxy build column by the following colors:

- **Green**
  - Your proxy server is up-to-date.

- **Yellow**
  - Your proxy server is out-of-date and an upgrade is needed.

- **Orange**
  - Upgrade failed. Your proxy server reverts to the old version to ensure that there is no downtime.

Troubleshoot a failed scheduled proxy upgrade

When a scheduled proxy upgrade fails, the proxy server reverts to the version you are upgrading from. All original data, keys, and configuration files are preserved. This process may take several minutes. Contact Customer Service and Support to ensure a successful upgrade.
To determine the reason for the failure, you can check the **Failure Reason** in the upgrade schedule. In addition, the installation directory for the failed upgrade is maintained so that log files are available for troubleshooting.

⚠️ **Note:** Before deleting any extra proxy directories, always confirm which directory is current by reviewing the log files. If the log files have recent activity, the proxy might be connected to your instance.

If a scheduled proxy upgrade fails repeatedly, you can manually upgrade your proxy server. See [Manually upgrade an Edge Encryption proxy server running on Linux](#) and [Manually upgrade an Edge Encryption proxy server running on Windows](#).

### Java minimum requirements

The host machine installing or running the Edge Encryption proxy server must maintain a supported version of Java:

- Java 8 update 121 (8u121)
- Java 8 update 141 (8u141)
- Java 8 update 151 (8u151) or later

⚠️ **Note:** Java 8 update 131 (8u131) is not supported.
- Java 11.0.6 or later

⚠️ **Note:** Before installing the Edge Encryption proxy server, check that the `$JAVA_HOME` variable is pointing to a supported version of Java for each user that will run the proxy server. For example, if installing the proxy server as a local administrator on Windows, check that the `$JAVA_HOME` variable is pointing to the correct version of Java system-wide. If installing on Linux, check that each user that will run the proxy server has this variable correctly defined. If a supported version of Java is not found, the Edge Encryption proxy server will not run.

If using AES 256-bit encryption with Java 8 update 141 (8u141) or lower, you must install the Java Cryptography Extension (JCE) jurisdiction policy files by copying them into the system Java home directory of each Edge Encryption proxy server host. Add these files to the `<Java-home-directory>/jre/lib/security` folder before performing a scheduled or manual upgrade. To install the AES 256-bit encryption policy files, see [Enable AES 256-bit encryption for Java 8 update 141 (8u141) or lower](#).
Mixed proxy-version environments

Although an environment running old versions of the proxy server with up-to-date versions of the proxy server is not recommended, it is supported if all proxy servers are within the same version family as your instance. For example, if you have an instance on the Rome release, your environment supports proxy servers from any Rome patch or hot fix. However, the following limitations apply.

- If one proxy server supports functionality that another proxy does not support, you will see inconsistent behavior, depending on which proxy server is used.
- If a proxy server is out-of-date, it may not include recent security enhancements.

If a proxy server from a previous release is registered with a newer release of the instance, you will receive regular notifications that the proxy server is out-of-date. To ensure an optimal and secure environment, ServiceNow recommends always upgrading your proxy server to the most recent version of the software supported by your instance.

Schedule an Edge Encryption proxy server upgrade

Create an upgrade schedule to enable the instance to upgrade an out-of-date proxy server.

Before you begin

To schedule an upgrade, you must be logged in to your instance through the proxy server.

If using AES 256-bit encryption with Java 8 update 141 (8u141) or lower, you must install the Java Cryptography Extension (JCE) jurisdiction policy files by copying them into the system Java home directory of each Edge Encryption proxy server host. Add these files to the `<Java-home-directory>/jre/lib/security` folder before performing a scheduled or manual upgrade. To install the AES 256-bit encryption policy files, see Enable AES 256-bit encryption for Java 8 update 141 (8u141) or lower.

Role required: security_admin

About this task

Once the upgrade is scheduled, the proxy server automatically upgrades at the scheduled time. During the upgrade, the proxy server is offline for only a short time.

Note: Because the proxy server restarts during the upgrade, it is offline for a short time. The amount of time is determined by your environment and how long it takes to stop and restart the proxy service.
During the scheduled upgrade, a new proxy directory is created and your configuration files are copied to the new directory. New properties are written to your existing properties file. The following files or directories in your old proxy directory are copied to the new proxy directory.

- /conf directory
- /keys directory
- /keystore directory
- java/jre/lib/security/cacerts file

As a result, your keys, keystores, settings, and certificates are preserved.

**Note:** Only the above files are copied to the new proxy directory. Any other customized files in the proxy server directory will not be preserved during a scheduled upgrade. The upgrade log file can be found in the original proxy directory in the following folder: `<original-proxy-directory>/tmp/upgrade-wrapper/bin`.

If multiple proxy servers are out-of-date, you must schedule an upgrade for each proxy server individually.

**Note:** Avoid hosting multiple proxy servers on the same machine. However, if your environment includes this configuration, do not schedule upgrades to multiple proxies on the same machine at the same time.

**Procedure**

1. Navigate to **Edge Encryption Configuration > Proxies > Upgrade Schedules**.
2. Click **New**.
3. Complete the form.

**Edge Encryption Proxy Upgrade Schedule form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proxy server</td>
<td>Proxy server being upgraded.</td>
</tr>
<tr>
<td>Target version</td>
<td>Version to which you are upgrading your proxy server. This value is read-only and set to the most up-to-date proxy version available for your instance.</td>
</tr>
<tr>
<td>Scheduled Start Time</td>
<td>Date and time on which to start the upgrade.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Whether the scheduled upgrade is active. If this field is not selected, the upgrade will not perform on the scheduled date and time.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the upgrade. This value is read-only. Possible statuses include:</td>
</tr>
<tr>
<td></td>
<td>• Pending</td>
</tr>
<tr>
<td></td>
<td>• Running</td>
</tr>
<tr>
<td></td>
<td>• Complete</td>
</tr>
<tr>
<td></td>
<td>• Failed</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**What to do next**
After an upgrade is executed, you can review the upgrade details to learn more about it. If your upgrade failed, review the **Failure Reason** to determine next steps.

**Upgrade details**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Version</td>
<td>The version that the server was upgraded from.</td>
</tr>
<tr>
<td>To Version</td>
<td>The version that the server was upgraded to.</td>
</tr>
<tr>
<td>Actual Start Time</td>
<td>Time that the upgrade began.</td>
</tr>
<tr>
<td>End Time</td>
<td>Time that the upgrade ended.</td>
</tr>
<tr>
<td>Failure Reason</td>
<td>Reason that the upgrade failed.</td>
</tr>
</tbody>
</table>

**Manually upgrade an Edge Encryption proxy server running on Linux**
Update a proxy running on Linux.

**Before you begin**
If using AES 256-bit encryption with Java 8 update 141 (8u141) or lower, you must install the Java Cryptography Extension (JCE) jurisdiction policy files by copying them into the system Java home directory of each Edge Encryption proxy server.
host. Add these files to the `<Java-home-directory>/jre/lib/security` folder before performing a scheduled or manual upgrade. To install the AES 256-bit encryption policy files, see Enable AES 256-bit encryption for Java 8 update 141 (8u141) or lower.

Role required: security_admin or local administrator on the host machine

**Procedure**

1. Copy the Edge Encryption update-archive file to the installation directory.
2. Change to the installation directory.
3. Run the following command:
   ```
   java -jar edgeencryption-dist-<version>-linux-x86-64.jar -m dist-upgrade -c <proxy directory>
   ```

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>proxy directory</td>
<td>The directory in the installation directory where the proxy was initially installed. This directory is created by the install.</td>
</tr>
</tbody>
</table>

If you want to see the help screen, execute this command without arguments:

```java
java -jar edgeencryption-dist-<version>-linux-x86-64.jar
```

A new proxy directory is created with a current timestamp. A backup of the old proxy directory is maintained as backup.dist-upgrade_timestamp in the new proxy installation directory. The old proxy shuts down and the new proxy starts up. Any open connections/transactions on the old proxy server are terminated.

4. Check the proxy log in the new directory and the instance to verify that the new proxy is running.

**Manually upgrade an Edge Encryption proxy server running on Windows**

Update a proxy running on Windows.

**Before you begin**

If using AES 256-bit encryption with Java 8 update 141 (8u141) or lower, you must install the Java Cryptography Extension (JCE) jurisdiction policy files by copying them into the system Java home directory of each Edge Encryption proxy server host. Add these files to the `<Java-home-directory>/jre/lib/security` folder before performing a scheduled or manual upgrade. To install the AES 256-bit encryption
policy files, see Enable AES 256-bit encryption for Java 8 update 141 (8u141) or lower.

Role required: security_admin or local administrator on the host machine

**Procedure**

1. Download the Edge Encryption proxy-update archive file to the installation directory.
2. Start the Windows cmd terminal program with administrator privileges.
3. Change to the installation directory.
4. Run the following command:

   ```
   java -jar edgeencryption-dist-<version>-all.jar -m dist-upgrade -c <proxy directory>
   ```

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>proxy directory</td>
<td>The directory in the installation directory where the proxy was initially installed. This directory is created by the install.</td>
</tr>
</tbody>
</table>

If you want to see the help screen, execute this command without arguments:

```java -jar edgeencryption-dist-<version>-all.jar```

A new proxy directory is created with a current timestamp. A backup of the old proxy directory is maintained as backup.dist-upgrade_timestamp in the new proxy installation directory. The old proxy shuts down and the new proxy starts up. Any open connections/transactions on the old proxy server are terminated.

5. Check the proxy log in the new directory and the instance to verify that the proxy has been updated and is running.

**Roll back an Edge Encryption proxy server upgrade**

If a proxy upgrade is unsuccessful, you can go back to the earlier version.

**About this task**

If an upgrade fails when using the scheduled upgrade feature in the Rome release, the proxy server will automatically roll back to the old version. The old proxy server is stored unmodified in a backup directory.

If you would like to roll back a manual upgrade, you can follow these steps.
Procedure

1. Shut down the proxy.
2. Delete the new proxy directory.
3. Rename the backup directory to the proxy name.
   The backup directory is in the proxy installation directory with the name `<proxy name>_backup`
4. Start the proxy.
5. Check the proxy log and the instance to verify that the proxy is online.

Edge Encryption configuration

After the Edge Encryption proxy server is installed and running, manage Edge Encryption through the proxy server.

You must complete all the steps in Edge Encryption installation before creating encryption configurations and encryption patterns on the instance.

ℹ️ Note: To access the Edge Encryption configuration, you must log in through the proxy server and elevate to the security_admin role.

Rotate encryption keys

Perform encryption key rotation from the instance. Add a new key, change the default key assignment, and then schedule a mass key rotation or a single key rotation.

Before setting an encryption key as the default key, make the key available to each proxy. This ensures that the proxies have the key to encrypt data when the key is assigned as the default key. All proxies must have access to a key before that key can be assigned as the default key.

⚠️ Warning: Before deleting a key from the proxy, set up and run a mass key rotation job to ensure that no data on the instance uses the key. If any information is still encrypted with that key, you cannot decrypt the information after you delete the key.

Edge filtering and sorting behavior

Whenever you change default keys, be sure to perform a key rotation (either mass or single key rotation). Otherwise, you may receive unexpected results when sorting and filtering records. For example, consider the following scenario:
1. You create encrypted records using one encryption key.
2. You create a new key and set it as default.
3. You create a new set of encrypted records using the new encryption key.

If you filter by any encrypted field when connected through the Edge proxy, all records may not be filtered out correctly, or records may appear unexpectedly. The filter works only for records encrypted using the current default key. The records encrypted using the previous default key still appear in the list view.

If you sort by any encrypted field when connected through the Edge proxy, you see two groups of records with the same human readable text in the encrypted field.

**Schedule a single key rotation job**

Schedule a job to find data encrypted using a specified key alias and then re-encrypt the data with the current default encryption key. The data is decrypted before it is re-encrypted with the default key.

**Before you begin**
Role required: security_admin
Before scheduling this job, update the default key in Edge Encryption Configuration > Encryption Key Configuration > Set Default Keys.

**Procedure**
1. Navigate to Edge Encryption Configuration > Maintenance > Schedule Single Key Rotation.
2. Fill in the fields on the form as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Select <strong>Single Key Rotation</strong>.</td>
</tr>
<tr>
<td>Key</td>
<td>Enter the key to be retired. Verify that this key is no longer the default key in Edge Encryption Configuration &gt; Encryption Key Configuration &gt; Set Default Keys.</td>
</tr>
<tr>
<td>Estimate record count</td>
<td>Total estimated number of records to process. Not available when running a single key rotation.</td>
</tr>
</tbody>
</table>
Field | Value
---|---
Process Historical Records | Select to process historical records in the Audit table if the field is audited. When encrypting historical records for a field in the Audit table, both new values and old values are encrypted. This field is read only and active. To learn more about audited fields, see Auditing.

Estimate Maximum Audit Record Count | Estimated maximum number of audited records to process. Not available when running a single key rotation.

Active | Clear this check box if you want to deactivate this job.

Run | Select the period between job executions.

Starting | Enter the date and time to run the job for the first time.

3. Click the menu icon in the form header and select Save. Estimate Record Count is not supported when processing audited fields.

Schedule a mass key rotation job

Schedule a job to find data encrypted with any previous key, and then re-encrypt the data with the current default encryption keys. The data is decrypted before it is re-encrypted with the current default key.

Before you begin
Role required: security_admin

Procedure
1. Navigate to Edge Encryption Configuration > Maintenance > Schedule Mass Key Rotation.
2. Fill in the fields on the form as appropriate.

Field | Value
---|---
Name | Enter a descriptive name.

Job Type | Select Mass Key Rotation.
### Estimate Record Count

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Estimate record count</td>
<td>Total estimated number of records to process. Not available when running a mass key rotation.</td>
</tr>
<tr>
<td>Process Historical</td>
<td>Select to process historical records in the Audit table if the field is audited. When encrypting historical records for a field in the Audit table, both new values and old values are encrypted. This field is read only and active.</td>
</tr>
<tr>
<td>Records</td>
<td>To learn more about audited fields, see Auditing.</td>
</tr>
<tr>
<td>Estimate Maximum Audit</td>
<td>Estimated maximum number of audited records to process. Not available when running a mass key rotation.</td>
</tr>
<tr>
<td>Record Count</td>
<td></td>
</tr>
</tbody>
</table>

### Active
Clear this check box to deactivate this job.

### Run
Select the period between job executions.

### Starting
Enter the date and time to run the job for the first time.

3. Click the menu icon in the form header and select **Save**. **Estimate Record Count** is not supported when processing audited fields.

### Schedule an attachment key rotation job

Schedule a job to find attachments encrypted using a specified key alias, and then re-encrypt the attachments with the current default encryption key. The attachment is decrypted before it is re-encrypted with the default key.

**Before you begin**
Role required: security_admin

**Procedure**

1. Navigate to **Edge Encryption Configuration > Maintenance > Schedule Attachment Key Rotation**.

2. Fill in the fields on the form as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Job Type</td>
<td>Select <strong>Attachment Key Rotation</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear the check mark if you want to deactivate this job.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table.</td>
</tr>
<tr>
<td>Run</td>
<td>Select the period between job executions.</td>
</tr>
<tr>
<td>Starting</td>
<td>Enter the date and time to run the job for the first time.</td>
</tr>
</tbody>
</table>

3. Click the menu icon in the form header and select **Save**.

4. To see an estimated count of records to be updated, click **Estimated Record Count**.

5. To run the job immediately, click **Execute Now**.

**Encrypt fields using encryption configurations**

Encrypt fields by creating encryption configurations.

To configure Edge Encryption, you must be connected to the instance through the proxy. Test all changes on a non-production instance before making the changes to the production instance.

**Define encryption keys**

After setting up one or more proxies and configuring a default encryption key, the instance verifies that the keys are available to all proxies. You cannot make an encryption key the default key unless all proxies have the key. Once a default key is defined, you can create encryption configurations.

**Assign fields and attachments to be encrypted**

Assigning fields and attachments to be encrypted means assigning an encryption type to the field or attachment. Before marking a field as encrypted, evaluate these issues.

- Determine what system features might be impacted.
- Examine all scripts for use of the field.
- Make any desired adjustments to the field size. After a field has been configured for encryption, the field size cannot be changed.

Marking a field to be encrypted expands the field size to store the encrypted data. The process of expanding the field size can take a long time, depending on the number of records in the table.
Create an encryption configuration
Select the fields to be encrypted and identify the encryption type.

Before you begin
Role required: security_admin

Procedure
2. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The table that contains the field to be encrypted.</td>
</tr>
<tr>
<td>Type</td>
<td>Whether to encrypt a table column or attachments for the table. Select Column.</td>
</tr>
<tr>
<td>Column</td>
<td>The field to be encrypted. Appears only when the Type is Column. Only String, Date, Date/Time, Journal, Journal Input, and URL fields are supported.</td>
</tr>
<tr>
<td>Encryption type</td>
<td>The encryption type to use.</td>
</tr>
</tbody>
</table>

- **String and URL fields**: You can add an encryption configuration to either a parent table or a child table.
- **Date and Date/Time fields**: You can add an encryption configuration to a parent table only. You cannot add a new encryption configuration to a child table.

⚠️ Note: Depending on the number of records affected by the Date and Date/Time fields you are encrypting, it may take up to a few minutes to create the encryption configuration. Make sure that you create the encryption configuration for Date and Date/Time fields when transaction volume on the instance is low.

⚠️ Note: A specific table and field combination can have only one active configuration at a time.

3. Click Submit.
What to do next
After you add the encryption configuration record, you can create an encryption job to encrypt existing data. If you do not run an encryption job, Edge encrypts the existing data the next time the data changes.

Deactivate an encryption configuration
After configuring a field or a table’s attachments to be encrypted, you can stop encryption by deactivating the encryption configuration. After deactivating encryption, you can run a Decryption job for fields or an Attachment Decryption job for attachments to remove the encrypted data from the instance.

Before you begin
Role required: security_admin

About this task

⚠️ Warning: Deactivating an encryption configuration does not delete the encryption record and the encryption type cannot be changed.

Procedure

1. Navigate to Edge Encryption Configuration > Edge Encryption Configurations > All.
   The Edge Encryption Configurations list is shown.

2. Click on the encryption configuration to be deactivated.
   The Edge Encryption Configuration form is shown.

3. Click on the Active box.
   The Active box is clear.

4. Click Update.
   The Edge Encryption Configurations list is shown.

What to do next
You can run a Decryption or Attachment Decryption job to decrypt data on the instance. If you do not run a job, the encrypted data is decrypted the next time it is changed.

Schedule an encryption job
You can schedule a job to find and encrypt any unencrypted data in a specified field, using the default encryption key configured for the field. If you do not create an encryption job after configuring a field for encryption, only new values are encrypted.
Before you begin
Role required: security_admin

Procedure
1. Navigate to Edge Encryption Configuration > Encryption Configurations > All.
2. Click the field that you want to schedule an encryption job for.
   The Scheduled Encryption Job form is shown with all fields populated. The bottom of the form shows records for any previous job executions.
4. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear this check box if you want to deactivate this job.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Select Encryption.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table.</td>
</tr>
<tr>
<td>Column</td>
<td>Select a column.</td>
</tr>
<tr>
<td>Estimated record count</td>
<td>Total estimated number of records to process. Populates after selecting Estimate Record Count.</td>
</tr>
<tr>
<td>Process Historical Records</td>
<td>Select to process historical records in the Audit table if the field is audited. When encrypting historical records for a field in the Audit table, both new values and old values are encrypted. To learn more about audited fields, see Auditing.</td>
</tr>
<tr>
<td>Estimate Maximum Audit Record Count</td>
<td>Estimated maximum number of audited records to process. Populates after selecting Estimate Record Count. This field is only visible when Process Historical Records is selected.</td>
</tr>
<tr>
<td>Note: The estimate may be larger than the actual number of records processed.</td>
<td></td>
</tr>
<tr>
<td>Run</td>
<td>Select the period between job executions.</td>
</tr>
<tr>
<td>Starting</td>
<td>Enter the date and time to run the job for the first time.</td>
</tr>
</tbody>
</table>

5. Click the menu icon in the form header and select Save.
6. To see an estimated count of records to be updated, click **Estimate Record Count**.

7. To run the job immediately, click **Execute Now**.

### Schedule a decryption job

You can schedule a job to decrypt data in an encrypted field, to store clear data in the instance.

#### Before you begin

**Note:** You must mark the encryption record for the field as inactive (clear the **Active** box) in order to run the decryption job.

Role required: security_admin

#### Procedure

1. Navigate to **Edge Encryption Configuration > Encryption Configurations > All**.

2. Click the field that you want to decrypt.

3. Under **Related Links**, click **Schedule Mass Decryption Job**.

   The **Scheduled Encryption Job** form is shown with all fields populated. The bottom of the form shows records for previous job executions.

4. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Select <strong>Decryption</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear this check box if you want to deactivate this job.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table.</td>
</tr>
<tr>
<td>Column</td>
<td>Select a column.</td>
</tr>
<tr>
<td>Estimated record count</td>
<td>Total estimated number of records to process. Populates after selecting <strong>Estimate Record Count</strong>.</td>
</tr>
<tr>
<td>Process Historical Records</td>
<td>Select to process historical records in the Audit table if the field is audited. When encrypting historical records for a field in the Audit table, both new values and old values are encrypted.</td>
</tr>
</tbody>
</table>
To learn more about audited fields, see Auditing.

**Estimate Maximum Audit Record Count**
Estimated maximum number of audited records to process. Populates after selecting **Estimate Record Count**. This field is only visible when **Process Historical Records** is selected.

**Note:** The estimate may be larger than the actual number of records processed.

**Run**
Select the period between job executions.

**Starting**
Enter the date and time to run the job for the first time.

5. Click the menu icon in the form header and select **Save**.

6. To see an estimated count of records to be updated, click **Estimate Record Count**.

7. To run the job immediately, click **Execute Now**.

**Encrypt attachments using standard encryption**
You can encrypt attachments for specific tables.

All attachments to a table use the same encryption type. Encrypted attachments are not searched when performing a text search. Only the standard encryption types are allowed for attachments. The order preserving or equality preserving encryption types are not allowed.

For a session bypassing the Edge Encryption proxy:

- **On a record with attachment encryption activated:**
  - The user can see that there are attachments and the attachment names.
  - The user cannot add new attachments.

- **On a record without attachment encryption activated:**
  - The user can open and download existing attachments.
  - The user can add new attachments.

For a session using the encryption proxy, the user can open and download existing attachments and add new attachments.
Configure attachment encryption

Select the tables whose attachments are to be encrypted and identify the encryption type.

Before you begin
Role required: security_admin

Procedure

2. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a table whose attachments are to be encrypted.</td>
</tr>
<tr>
<td>Type</td>
<td>Whether to encrypt a table column or attachments for the table. Select Attachment.</td>
</tr>
<tr>
<td>Column</td>
<td>The table field to be encrypted. This field appears when the Type is Column, and not when Type is Attachment.</td>
</tr>
<tr>
<td>Encryption type</td>
<td>The encryption type to use. For attachments, only Standard AES128 and Standard AES256 are allowed.</td>
</tr>
</tbody>
</table>

3. Click Submit.

What to do next

After the encryption record has been added, you can create an attachment encryption job to encrypt existing attachments. If you do not run an attachment encryption job, the system encrypts new attachments when you attach them.

Schedule an attachment encryption job

You can schedule a job to find and encrypt any unencrypted attachments for a specified table, using the default encryption key configured for the table.

Before you begin
Role required: security_admin
Procedure

1. Navigate to **Edge Encryption Configuration > Encryption Configurations > All.**
2. Click the table you want to schedule an encryption job for.
3. Under **Related Links**, click **Schedule Mass Encryption Job.**

The **Scheduled Encryption Job** form is shown with all fields populated. The bottom of the form shows records for previous job executions.

4. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear this check box if you want to deactivate this job.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Select <strong>Attachment Encryption.</strong></td>
</tr>
<tr>
<td>Table</td>
<td>Select a table.</td>
</tr>
<tr>
<td>Run</td>
<td>Select the period between job executions.</td>
</tr>
<tr>
<td>Starting</td>
<td>Enter the date and time to run the job for the first time.</td>
</tr>
</tbody>
</table>

5. Click the menu icon in the form header and select **Save.**

6. To see an estimated count of records to be updated, click **Estimate Record Count.**

7. To run the job immediately, click **Execute Now.**

**Schedule an attachment decryption job**

You can schedule a job to decrypt any encrypted attachments for a specified table, to store clear attachments in the instance.

**Before you begin**

⚠️ **Note:** You must mark the encryption record for the table as inactive (clear the **Active** box) before the decryption job runs, otherwise, nothing happens.

Role required: security_admin
**Procedure**

1. Navigate to **Edge Encryption Configuration > Encryption Configurations > All.**
2. Click the table with the attachments that you want to decrypt.
3. Under **Related Links,** click **Schedule Mass Attachment Decryption Job.**
   
The **Scheduled Encryption Job** form is shown with all fields populated. The bottom of the form shows records for previous job executions.
4. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Select <strong>Attachment Decryption.</strong></td>
</tr>
<tr>
<td>Active</td>
<td>Clear the check mark if you want to deactivate this job.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table.</td>
</tr>
<tr>
<td>Run</td>
<td>Select the period between job executions.</td>
</tr>
<tr>
<td>Starting</td>
<td>Enter the date and time to run the job for the first time.</td>
</tr>
</tbody>
</table>

5. Click the menu icon in the form header and select **Save.**
6. To see an estimated count of records to be updated, click **Estimate Record Count.**
7. To run the job immediately, click **Execute Now.**

**Change a field or attachment's encryption type**

You can change a field or attachment's encryption type by selecting a new encryption type in the existing encryption configuration record. A specific table and field combination can only have one active configuration at a time.

**Before you begin**

Role required: security_admin

**Procedure**

1. Navigate to **Edge Encryption Configuration > Encryption Configurations > All.**
   
The **Edge Encryption Configurations** list is shown.
2. Open the record for the encryption configuration to be changed.
3. Click the **Encryption type** dropdown and select a new encryption type.
Note: For attachments, only Standard AES128 and Standard AES256 are allowed.

4. If needed, run an encryption or attachment encryption job.
   It is not necessary to run an encryption job. If you do not run an encryption job, the field or attachment is encrypted using the new encryption type the next time the field or attachment is changed.

**Tokenize strings using encryption patterns**

You can replace string patterns with tokens before they are sent to and stored in the instance.

**Before you begin**

To use encryption patterns, you must install and set up a MySQL database in your network. This is the same database used for order-preserving encryption. To create or edit encryption patterns, you must be connected to the instance through the proxy.

Role required: security_admin

**About this task**

You can use base system patterns, or create your own patterns. Base system patterns are advanced patterns. Encryption patterns include the following limitations.

- A pattern of all alpha characters is not allowed.
- The minimum pattern size is five characters. You can change this setting using a system property.
- The * and + quantifiers are forbidden in encryption patterns.
- Encryption patterns match complete words, not parts of strings embedded in a larger string. Words are defined by spaces and characters not available for inclusion in a pattern.
- If the same string is sent to the instance multiple times, it is replaced with the same token.
- Text search on exact matches is supported. The query string is exchanged with a token when sent to the instance, the search is performed on tokens, and when the search results are returned to the proxy server, the tokens are replaced with the clear text. Features such as stemming are not supported.

When using patterns, the clear text never leaves your network. When the proxy server matches a pattern in a request going to the instance, the proxy replaces the string with a token of the same size. The token is sent to instance instead of
the clear text string. When the response is sent from the instance to the proxy server, the proxy replaces the token with the string. When viewed through the proxy server, the string displays as clear text.

⚠️ Note: Encrypted fields are not checked for encryption patterns.

Procedure

1. Navigate to **Edge Encryption Configuration > Encryption Patterns > Create New**.
   Alternatively, you can navigate to **Advanced Patterns** to activate or edit a preconfigured pattern.

2. Enter the pattern name.

3. Define the **Edge pattern input type**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic</td>
<td>A series of character types. In the <strong>Basic Pattern Input</strong> tab, click <strong>Add</strong> and select a character type. The <strong>Sample pattern</strong> displays the pattern as characters are added. Click <strong>New Block</strong> to move the next character to the next line. This enables you to group characters in a long pattern. Click <strong>X</strong> to delete the last character in the pattern.</td>
</tr>
<tr>
<td>Advanced</td>
<td>A Java RegEx expression. If advanced is selected, you cannot change the input type back to basic. In the <strong>Sample match</strong> field, enter a sample pattern to test the RegEx expression. In the <strong>Pattern</strong> field, enter a Java RegEx expression. Click <strong>Validate</strong> to verify that the expression matches the sample pattern.</td>
</tr>
</tbody>
</table>

The input type defines how you are going to enter the pattern. It does not impact how the pattern is used.

4. Click **Submit**.
Repair or recover order-preserving encrypted data

If you have the security-admin role, you can schedule jobs performed by the Edge Encryption proxy to repair or recover fields that use order preserving encryption.

You can schedule jobs to:

- Repair order tokens.
- Recreate the proxy database.

Running these jobs can be a time-consuming operation which might impact the performance of the Edge Encryption proxy. Schedule these jobs at a time when no users or a minimum set of users are using the system, such as midnight on the weekend.

Schedule an order token repair job

You can schedule a job to find and repair fields where the order token is missing.

Before you begin
Role required: security_admin

About this task
Use these jobs to repair individual fields in a table or to repair all fields using order preserving encryption. Run this job when the proxy database has been offline while the instance has been running, which results in order preserving fields that are missing order tokens.

Procedure

1. Navigate to Edge Encryption Configuration > Maintenance > Schedule Order Token Repair.
2. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Select Order Token Repair.</td>
</tr>
<tr>
<td>All fields</td>
<td>Select this check box to repair all tables.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table.</td>
</tr>
<tr>
<td>Column</td>
<td>Select a column.</td>
</tr>
</tbody>
</table>
3. Click the menu icon in the form header and select **Save**.

4. To see an estimated count of records to be updated, click **Estimated Record Count**.

### Schedule a proxy-database recovery job

Run this job when the proxy database has lost data. This job finds all records that have been encrypted with a token (order preserving encryption type) and sends them to the proxy so that the proxy database can be rebuilt.

**Before you begin**

Role required: security_admin

**Procedure**

1. Navigate to **Edge Encryption Configuration > Maintenance > Schedule Database Recovery**.

2. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name for this job.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Select <strong>Database Recovery</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear this check box if you want to deactivate this job.</td>
</tr>
<tr>
<td>Run</td>
<td>Select the period between job executions.</td>
</tr>
<tr>
<td>Starting</td>
<td>Enter the date and time to run this job for the first time.</td>
</tr>
</tbody>
</table>

3. Click the menu icon in the form header and select **Save**.

4. To see an estimated count of records to be updated, click **Estimate Record Count**.
Prevent an IP address in your network from sending requests to your instance

Because the Edge Encryption proxy server resides in your network, it may be subject to vulnerability scans by your network software. To prevent IP scanner or other requests from being forwarded to your ServiceNow instance, you can add IP addresses, IP ranges, or network masks to a deny list. Any connection to the proxy server from a deny listed address is terminated and is not forwarded to your instance.

Before you begin
Role required: security_admin
To place an IP address on a deny list, you must be logged in to your instance through the proxy server.

Important: Ensure that you understand your network topology before adding IP addresses in your network to a deny list. If an IP address is added to the deny list, any user with that IP address will be blocked from accessing the Edge Encryption proxy server.

Procedure
1. Navigate to **Edge Encryption Configuration > Maintenance > Denylist IP Addresses**.
   The Encryption Proxy IP Denylists [edge_encryption_ip_blacklist] list view opens.
2. Click **New**.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proxy server</td>
<td>The Edge Encryption proxy server that is prevented from forwarding requests from addresses on the deny list.</td>
</tr>
<tr>
<td>IP, IP range, or net-mask</td>
<td>Requests from this IP address, range, or network mask are not forwarded to your ServiceNow instance. Example values include:</td>
</tr>
<tr>
<td></td>
<td>• IP address: 10.10.10.5</td>
</tr>
<tr>
<td></td>
<td>• IP range: 10.10.10.1-15</td>
</tr>
<tr>
<td></td>
<td>• Network mask: 10.10.10.0/24</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Whether the record is active. Only IP addresses from active records are prevented from sending requests to the instance.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the deny list record.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

5. Repeat these steps for all other proxies for which an IP address should be denied.

**Results**
The Edge Encryption proxy server terminates any connection from IP addresses, ranges, or network masks on the deny list and cannot forward the request to the instance.

**Encrypt data from a record producer**

Record producers allow end users to create task-based records, such as incident records, from the Service Catalog and Service Portal. If a record producer attempts to insert data into a field marked for encryption, an invalid insert message displays and the data is not saved to the field. To configure your Edge Encryption proxy server to allow inserts from a record producer, create encryption rules from the record producer record.

**Before you begin**

Role required: security_admin

Encrypting data from a record producer requires an encryption configuration defined for the target field. Check that you have created an encryption configuration for the target field and table before creating an encryption rule from a record producer. See [Create an encryption configuration](#). To encrypt attachments from a record producer, see [Configure attachment encryption](#).

**Procedure**

1. Log in to your instance through the Edge Encryption proxy server.
2. Navigate to **Service Catalog > Catalog Definitions > Record Producers**.
3. Create a record producer record or open an existing record producer record.
4. Under **Related Links**, select **Create Edge Encryption Rule**.
   
   Two inactive encryption rules are automatically created to encrypt data sent from the record producer to the field marked for encryption.
<table>
<thead>
<tr>
<th>Encryption rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;RecordProducerName&gt;</td>
<td>Rule created to process POST parameters from the Service Catalog and map variables to fields in the instance.</td>
</tr>
<tr>
<td>&lt;RecordProducerName&gt;Json</td>
<td>Rule created to process a JSON payload from the Service Portal and map variables to fields in the instance.</td>
</tr>
</tbody>
</table>

5. Activate the necessary encryption rules created by the record producer.

   a. Navigate to Edge Encryption Configuration > Rules > All.

   b. Depending on where the record producer will be used, open the associated encryption rule created by the record producer and select the Active flag.

      If using the record producer in the Service Catalog, activate the <RecordProducerName> encryption rule. If using the record producer in the Service Portal, activate the <RecordProducerName>Json encryption rule.

6. Optional: Examine the Encryption rule Action field and add any necessary field names or statements.

   (Optional) If a record producer directly maps a variable to a field in a table, the encryption rule automatically maps the variable to the correct field. However, if a variable is indirectly mapped through various scripts on the platform, you may need to update the rules to map each variable to the correct field.

   Example

   (Optional) The below encryption rule was created from the Report Outage record producer and processes POST parameters from the Service Catalog to map variables to fields in the instance. Replace 'FILL ME IN' with the target field.
The below encryption rule was created from the Report Outage record producer and processes a JSON payload from the Service Portal to map variables to fields in the instance. Add additional statements to map any scripted variables to the target fields.

When the payload from the record producer is examined, the error_message element contains the value for the short_description field. By adding the following statement, you can map the scripted variable error_message to the short_description field.

```javascript
if (jsonElement.getName() == 'error_message')
    jsonElement.valueFor(tableName, 'short_description');
```

The value of the **Action** field becomes:
function ReportOutageJsonAction(request) {
    var tableName = 'incident';
    // Some fields are set in script, additional parameter lines may need to be added
    // current.comments is accessed via script from notes; // assignment to current.comments
does NOT replace existing values
    // current.short_description is accessed via script from short_description;
    // current.description is accessed via script from current.short_description;
    // current.caller_id is accessed via script from gs.getUserID();
    var jsonContent = request.getAsJsonContent();
    for (var jsonElementItr = jsonContent.getIterator('variables');
        jsonElementItr.hasNext();)
        { var jsonElement = jsonElementItr.next();
            if (jsonElement.getName() == 'error_message')
                jsonElement.valueFor(tableName, 'short_description');
            else {
                jsonElement.valueFor(tableName, jsonElement.getName());
            }
        }
}

Results
The two encryption rules enable the record producer to insert values into fields
marked for encryption from either the Service Catalog or Service Portal.

Define a custom encryption rule
It may be necessary to identify and encrypt sensitive information in HTTP requests
on the way to your instance. You can write encryption rules to identify, interpret,
and encrypt data in such requests, mapping fields in the request to table-field
names on your instance.

What is an encryption rule
Encryption rules are scripts executed on the Edge Encryption proxy server to
map fields in a request to fields in a table on your ServiceNow instance. An
encryption rule tells the Edge Encryption proxy server how to encrypt data in
custom payloads.

Note: Encryption rules only support ECMAScript 3 and below.

When to use custom rules
A set of encryption rules is included as part of the Edge Encryption plugin. These
rules handle core platform use cases such as editing a field from the list edit
form, updating a record from the record form, managing direct web services,
and processing data from the REST API. Applications created using standard forms and lists should work without custom encryption rules.

If you develop scripted processors, scripted web services, scripted REST APIs, UIs, or Ajax scripts that contain data that should be encrypted, you must write encryption rules to find and map the data to Glide table-field names.

**Format of an encryption rule**

Rules include three parts:

- **Condition**: Identifies the type of request.
- **Action**: Maps fields in the request to fields in a table, encrypting values that map to fields with encryption configurations defined.
- **Order**: Priority of the rule. The lowest priority rule with a satisfied condition is the only rule that runs. Like business rules, rules run from lowest to highest.

Except for attachment requests, when an HTTP request hits the Edge Encryption proxy server, the Edge Encryption proxy server evaluates all encryption rule conditions in priority order until either all conditions return false, or one condition returns true. When a condition returns true, the action is executed on the request and the result is forwarded to the instance. No other conditions are evaluated. As a result, encryption rule conditions should be as specific as possible. A generic rule might evaluate as true for a request meant to be processed by another rule, causing the request to be processed by the wrong action. If a generic condition is unavoidable, the rule should be marked with a high-order value so that more specific rules are evaluated first.

**Guidelines for creating encryption rules**

Creating efficient, optimized encryption rules can reduce processing time for script validation.

**Overall guideline**: When rules get very long, do your best to minimize the number of blocks and break the rules apart whenever possible. Ideally, custom rules should apply to specific use cases, rather than encompassing several cases, with `if` statements in the action script.

1. Split rules whenever possible. For example,
   - Create different rules for different tables and ensure that each rule runs only on its respective table.
   - Create different rules for each record producer you are targeting, or at least for each subset of record producers. Instead of one rule targeting dozens of
sys_ids, you could create several different rules targeting smaller subsets of record producers, or even create one rule per sys_id.

Note: Creating multiple rules requires more maintenance. The trade-off is that multiple, simpler rules can be validated more efficiently than longer, more complex rules.

2. Minimize the number of blocks. Because the processing engine scans each block while evaluating scripts, a large number of blocks causes delays in validation. For example,

- Replace all if blocks with an array lookup, and replace all blocks in the array lookup with just one if block.
- Combine if blocks whenever it is possible to group them.

Encryption rule APIs

Encryption rules are written in JavaScript and utilize Edge Encryption APIs to locate and encrypt sensitive information in the body of a request. The API uses expressions similar to xPath to navigate through both JSON and XML content.

Edge Encryption APIs process the request off the stream as it is being written to the output stream. Stream parsing allows encryption rules to be network performant. However, fetching and parsing content from the body multiple times could lead to unexpected results. To account for this, requests should be processed by the action in a single pass.

When creating encryption rules, you cannot use Glide APIs, script includes, business rules, or any global parameters such as current. Because the rules are created for HTTP objects, a global request object is available.

When creating encryption rules, you cannot use APIs from the white list manager or scoped applications.

Error handling

If an encryption rule condition or action throws an exception, check the proxy log for troubleshooting information.

Inspect the client request

Before creating a custom encryption rule, you must determine the format of the client request entering the Edge Encryption proxy server.

About this task

Because encryption rules iterate over client requests and determine what, if anything, needs to be encrypted, you must understand the type of request you are creating a rule for. The format of the client request determines the structure of your encryption rule and the APIs available for use in the rule.
Procedure

1. Inspect the client request.

   Depending on the source of the request, the following tools are available to inspect the request and determine the format.

<table>
<thead>
<tr>
<th>Source of request</th>
<th>Available tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client browser</td>
<td>Use the developer console in your browser to inspect the client request. Useful tools include:</td>
</tr>
<tr>
<td></td>
<td>• Firefox Network Monitor</td>
</tr>
<tr>
<td></td>
<td>• Chrome Network Panel</td>
</tr>
<tr>
<td>Third-party/external source</td>
<td>Use an HTTP protocol analyzer to inspect the request. Useful tools include:</td>
</tr>
<tr>
<td></td>
<td>• Wireshark</td>
</tr>
<tr>
<td></td>
<td>• HTTP Scoop</td>
</tr>
<tr>
<td></td>
<td>Alternatively, you can often use documentation for the external source to determine the format of the request.</td>
</tr>
</tbody>
</table>

2. From the client request, inspect the packet and determine:

   • The client request method
   • The URL path of the request
   • The URL parameters
   • The POST parameters, if any
   • The format of the request body, if included

Example

```
<table>
<thead>
<tr>
<th>Headers</th>
<th>Preview</th>
<th>Response</th>
<th>Cookies</th>
<th>Timing</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Response Headers (13)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request Headers (14)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Form Data</td>
<td>view source</td>
<td>view URL encoded</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

system_data: 
{{"action":"Post","args":{{"_0ModelCall":true,"intention":"INSERT"},"data":{{"message":"Hello world"}}}}
```
Results
Inspecting the request provides an understanding of the fields you need to filter for and iterate over in your encryption rule. To understand the fields in the request object, see request.

Create an encryption rule
Encryption rules are used by the proxy to find content in HTTP requests that should be encrypted.

Before you begin
Role required: security_admin
Before creating an encryption rule, you must Inspect the client request to determine the format.

About this task
To create or edit encryption rules, you must be connected to the instance through an encryption proxy.

Procedure
1. Navigate to Edge Encryption Configuration > Rules > Create New.
2. In the Name box, enter a name.
3. In the Request Type, select an HTTP method.
   - HTTP Post
   - HTTP Get
   - HTTP Put
   - HTTP Patch
   - HTTP Delete
   
   Note: Pre-Jakarta instances allow only HTTP Get and HTTP Post methods.
4. In the Condition box, enter a JavaScript statement defining when the rule should run.
5. In the Action box, enter a JavaScript function to be executed when the condition is true.
6. In the Order box, enter the relative priority of the rule.
7. Click Submit, or save the form.
**Encryption rule conditions**

Encryption rule conditions determine if the rule should be executed.

An encryption rule condition must return true if the rule is to handle the HTTP request; otherwise, it must return false.

As you build your condition, keep in mind that only one rule is executed per request. As a result, the condition must be as general or specific as needed to run under the intended circumstances.

>i Note: Be careful when performing checks on content in the condition. Excessive checks can be expensive for the proxy server and may cause increased latency when handling complex requests.

The condition can use the method type, content type, URL path, or any URL query string parameters to determine if the rule should handle the request. The condition has access to these fields via the `request` object. Be sure that, prior to creating an encryption rule condition, you have inspected the client request and understand the conditions needed to trigger the rule.

>i Note: To build efficient rules, consider easy ways to rule out requests that you do not want to be evaluated by a rule. Build your condition to return false for those requests first. This method increases performance and quickly routes the request to the correct rule faster.

Encryption rule objects and APIs are available to encryption rule conditions.

**Example using path and postParams**

```javascript
/* This condition checks if the request coming in has a path ending in 
"/sample_processor.do" and if a post parameter exists in that request called myPostParam */

function SampleCondition(request) {
  if (endsWith(request.path, "/sample_processor.do") && request.postParams.myPostParam) {
    return true;
  }
  return false;
}
```

**Example using urlParams and contentType**

```javascript
/* This condition checks if a url parameter exists in the query called 
myUrlParam and if the content type contains 'xml' 
(if so, you can expect the body to be an XML payload). 
Then, it checks if the xml payload contains myXmlTag */
```
function SampleCondition2(request) {
    if (request.urlParams.myUrlParam && request.contentType.indexOf('xml') > -1 &&
    request.xmlContains('myXmlTag')) {
        return true;
    }
    return false;
}

Encryption rule actions

An encryption rule maps fields in a client request to fields in a table on your instance and identifies fields marked for encryption.

An encryption rule action only runs when the encryption rule condition returns true. An encryption rule identifies the data to be encrypted in your request payload. Because the rule iterates over the content in the request object, you must understand the form and structure of your request body and determine what in the request needs to be encrypted. The data to be encrypted might be located within:

- A POST or URL parameter.
- JSON or XML content within a POST or URL parameter.
- A JSON payload.
- An XML payload.

Before writing an encryption rule action, be sure to:

- Inspect the client request.
- Identify where the sensitive data is located in the request object.
- Determine the field and table name to insert data into, or understand how to dynamically pull this from the request.

Encryption rule objects and APIs are available to encryption rule actions and conditions.

Encryption rule objects and APIs

Use encryption rule APIs to parse and encrypt values in requests moving through the Edge Encryption proxy server to the instance.

The APIs available for your encryption rule depend on the format of the request object. For example, if the contentType parameter of the request object is XML, you can use the XML APIs to parse and encrypt values in the payload. After you
determine the type of object in your request, you can build an encryption rule using the available APIs.

Encryption rule APIs are available in both encryption rule condition and action scripts.

**request**

The `request` object is a global object available in Edge Encryption rule action and condition scripts.

The `request` object is a JavaScript object that represents the client request coming in to the Edge Encryption proxy server. You must build your encryption rule to parse the `request` object, map `request` object values to fields in a table on the instance, and encrypt any sensitive data in the `request` object.

The `request` object includes the following attributes and data from the client request:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>path</td>
<td>The path portion of the URL.</td>
</tr>
<tr>
<td>requestMethod</td>
<td>GET, POST, PUT, PATCH, DELETE.</td>
</tr>
<tr>
<td>contentType</td>
<td>The Content-Type header field.</td>
</tr>
<tr>
<td>urlParams</td>
<td>The parameters in the query string. This can also be evaluated to a String.</td>
</tr>
<tr>
<td>postParams</td>
<td>If this is a form post, this contains the post parameters.</td>
</tr>
</tbody>
</table>

**request - getAsJsonContent()**

Returns the request as an iterable object of type `JsonNode`.

This method is available only in an Edge Encryption rule if the request body is a valid JSON payload. If you are not sure what format the request body includes, check the `contentType` field on the `request` object.

Once the request is returned as a `JsonNode` object, you can use the `JSON APIs` to iterate over the object and encrypt fields.
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JsonNode</td>
<td>The request as an iterable JsonNode.</td>
</tr>
</tbody>
</table>

**request - getAsXmlContent()**

Returns the request content as an iterable object of type XMLContent.

This method is available only in an Edge Encryption rule if the request body is a valid XML payload. If you are not sure what format the request body includes, check the contentType field on the request object.

Once the request is returned as an XMLContent object, you can use the XML APIs to iterate over the object and encrypt fields.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XMLContent</td>
<td>The request as an iterable object of type XMLContent.</td>
</tr>
</tbody>
</table>

**request - XMLContains(String path)**

Returns true if the given path exists in the XML DOM.

This method is available only if the request body is a valid XML payload. If you are not sure what format the request body includes, check the contentType field on the request object.
### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>path</td>
<td>String</td>
<td>XPath statement you are searching for.</td>
</tr>
</tbody>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>Whether the given path exists in the XML DOM.</td>
</tr>
</tbody>
</table>

### POST and URL parameter APIs

POST and URL parameters can be accessed as properties of the `request` object using `request.postParams` and `request.urlParams`.

Any single parameter can be accessed as a property of the `postParams` and `urlParams` parent objects by calling `request.postParams.myParam`. Any parameter accessed this way is an object of the underlying class `ParameterValue`. Any APIs in this class can be called on any parameter.

After inspecting the client request, it may be necessary to access and encrypt parameter values from the `request` object. Depending on the data in the client request, you can encrypt values and map them to fields on the instance in multiple ways.

### Encrypt the value of a known table and field

If you know the name of the instance table and field that will hold the encrypted data, you can explicitly define them in the encryption rule. For example, you may know that the request will be processed on the instance to create an incident and you want to encrypt the `text` parameter in the `description` field. In this case, you can create the following action.

```javascript
function SampleAction1() {
    request.postParams.text.valueFor('incident', 'description');
}
```

### Encrypt the value of a dynamically defined table and field

If, conversely, you do not know the name of the field that the encrypted data will populate, you can dynamically define them using `tableName` and `fieldName`.

The below example processes a generic request that might store data in different task tables (such as incident, problem, and change_request) on the instance.
function SampleAction2() {
    var tableName = request.urlParams.table;
    for (var parameter in request.postParams) {
        var currentParam = request.postParams[parameter];
        var fieldName = currentParam.toString();
        if (fieldName == 'text') {
            currentParam.valueFor(tableName, 'description');
        } else {
            currentParam.valueFor(tableName, fieldName);
        }
    }
}

This action:

• Gets the destination table from the URL parameters.
• Iterates over the URL parameters.
• Asks the Edge Encryption proxy server to encrypt any URL parameter with a name that matches a field marked for encryption.
• Looks for a specific parameter called text and asks the Edge Encryption proxy to encrypt the value based on the encryption configuration for the description field on the incident table.

In this example, the valueFor() method is not actually performing any encryption. Rather, the method asks the Edge Encryption proxy server to check whether the table/field pair in the request object is marked for encryption with an encryption configuration and, if applicable, encrypt it.

Encrypt JSON or XML within a parameter

A POST or URL parameter might include JSON or XML content. In this case, you can process the content within the parameter, iterate over the values, and encrypt required fields. In this example, the tableName is still accessed from a POST parameter, but the value of the field is the JSON object data.

function SampleAction3() {
    var tableName = request.postParams.table;
    var data = request.postParams.data;
    var dataIterator = data.getAsJsonContent().iterator();
    while (dataIterator.hasNext()) {
        var jsonElement = dataIterator.next();
        var fieldName = jsonElement.getName();
        if (fieldName == 'text') {
            jsonElement.valueFor(tableName, 'description');
        }
    }
}
An example of an encryption rule action that processes XML within a POST parameter.

```javascript
function SampleAction4() {
    var tableName = request.postParams.table;
    var data = request.postParams.data;
    var dataIterator = data.getAsXmlContent().getIteratorOverAllChildren();
    while (dataIterator.hasNext()) {
        var jsonElement = dataIterator.next();
        var fieldName = jsonElement.getName();
        if (fieldName == 'text') {
            jsonElement.valueFor(tableName, 'description');
        } else {
            jsonElement.valueFor(tableName, fieldName);
        }
    }
}
```

**Encrypt a query**

You might encounter an encoded query within a parameter in the client request that contains sensitive data. To match a field in a query to an encrypted value in the instance database, you must create an encryption rule that asks the proxy to check whether a field in the query is marked for encryption. The `encodedQueryFor()` method parses an encoded query on a given table, and checks if any fields in the query have encryption configurations.

In this example, the rule iterates over the parameters looking for the `filter` parameter, which is expected to be a Glide encoded query.

```javascript
function SampleAction5() {
    var tableName = request.urlParams.table;
    for (var parameter in request.postParams) {
        var currentParam = request.postParams[parameter];
        var fieldName = currentParam.toString();
        if (fieldName == 'filter') {
            currentParam.encodedQueryFor(tableName);
        } else {
            currentParam.valueFor(tableName, fieldName);
        }
    }
}
```
For example, if the value of filter is: short_description=My sensitive information^number=INC000056^category=Outage, the query would become short_description=<Encrypted(My sensitive information)>^number=INC000056^category=Outage on the instance.

ParameterValue - toString()

Converts the POST or URL parameter value to a string.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The parameter value as a string.</td>
</tr>
</tbody>
</table>

ParameterValue - getAsJsonContent()

Returns the request as an iterable object of type JsonNode.

This method is available only in an Edge Encryption rule if the request body is a valid JSON payload. If you are not sure what format the request body includes, check the contentType field on the request object.

Once the request is returned as a JsonNode object, you can use the JSON APIs to iterate over the object and encrypt fields.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JsonNode</td>
<td>The request as an iterable JsonNode.</td>
</tr>
</tbody>
</table>

**ParameterValue -getAsXmlContent()**

Returns the request content as an iterable object of type XMLContent.

This method is available only in an Edge Encryption rule. This method assumes that the request body is a valid XML payload. You can check the contentType to make sure.

Once the request is returned as an XMLContent object, you can use the XML APIs to iterate over the object and encrypt fields.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XMLContent</td>
<td>The request as an iterable object of type XMLContent.</td>
</tr>
</tbody>
</table>

**ParameterValue - encodedQueryFor(String tableName)**

Specifies that the value of the element is an encoded query on the specified table.

Calling this function on a parameter tells the proxy that the value of the parameter is an encoded query for the specified table. The proxy parses the encoded query and encrypts the fields in the encoded query that must be encrypted.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tableName</td>
<td>String</td>
<td>The table that you expect the query to run on.</td>
</tr>
</tbody>
</table>
>Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

**ParameterValue - valueFor(String tableName, String fieldName)**  
Specifies that the value of the element maps to the specified field in the specified table.

Calling this method on an element value tells the proxy that the value for this element maps to the specified field in the specified table. The proxy then checks if the field must be encrypted.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tableName</td>
<td>String</td>
<td>The table name.</td>
</tr>
<tr>
<td>fieldName</td>
<td>String</td>
<td>The field name.</td>
</tr>
</tbody>
</table>

**XML APIs**

XML APIs can be used after calling `getAsXmlContent()` on either the request object or a `ParameterValue` property.

When using XML APIs to write your encryption rule, you can follow a general format:

1. Call `getAsXmlContent()` on the request object or `ParameterValue` property. This returns an iterable object of the `XMLContent` underlying class.

2. Call `getIterator()` or `getIterator(String xpath)` on the `XMLContent` object. This returns an `XMLElementIterator` object that can be used to iterate over XML elements.

3. Call the `hasNext()` method on the `XMLElementIterator` object to determine whether another element is available.
4. Call `next()` on the `XMLElementIterator` object to return the next XML element. You cannot call `next()` without first calling `hasNext()`.

5. Call `valueFor(String tableName, String fieldName)` on the XML element. This method tells the proxy that the value for this element maps to the specified field in the specified table. The proxy then checks if the field must be encrypted.

   **Note:** To determine if you want to call `valueFor(String tableName, String fieldName)` on an XML element, you can use the `getName()` method to return the name of the element.

**Mapping to a known table-field on the instance**

In this example, the XML payload will be processed on the instance to insert records in the incident table. The description field will populate `short_description` on the incident.

```
<data>
  <record>
    <name>'Test Record 1'</name>
    <description>'Test Record 1 Description'</description>
    <tag>critical</tag>
  </record>
  <record>
    <name>'Test Record 2'</name>
    <description>'Test Record 2 Description'</description>
    <tag>security</tag>
  </record>
</data>
```

The following encryption rule action can apply:

```
function sampleXmlAction1() {
  var xmlContent = request.getAsXmlContent();
  // This loop iterates over all description tags that match the given path
  var xmlElementIterator = xmlContent.getIterator('data/record/description');
  while (xmlElementIterator.hasNext()) {
    var xmlElement = xmlElementIterator.next();
    xmlElement.valueFor('incident', 'short_description');
  }
}
```

This action iterates through the `description` tags and asks the proxy server to encrypt the values and insert them into `incident.short_description` on the instance.
Note: This rule finds all `description` tags within all `record` tags in the XML payload. If there is only one occurrence of a tag to encrypt, the rule still uses the XPath and iterator structure. However, it iterates only once in the loop.

Mapping to an unknown table-field on the instance

In this example, the rule iterates over the `record` tags, but does not know what tags to expect within the `record` tag. The only known is that the tags within the `record` tags match the names of the columns specified in the table URL parameter.

The rule also specifies that, if the table is incident, then the data in the `description` tag should be encrypted and stored in the short_description field on the instance.

```javascript
function sampleXmlAction2() {
  var xmlContent = request.getAsXmlContent();
  var tableName = request.urlParam.table;
  // This first iterator will iterate over all record elements
  var xmlElementIterator = xmlContent.getIterator('data/record');
  while (xmlElementIterator.hasNext()) {
    encryptFieldsInRecord(xmlElementIterator.next());
  }
}

function encryptFieldsInRecord(xmlElement) {
  // Then, iterate over all tags representing fields in the table
  var fieldIterator = xmlElement.getIteratorOverAllChildren();
  while (fieldIterator.hasNext()) {
    var field = fieldIterator.next();
    var fieldName = childElement.getName();
    // if table is incident, then description is encrypted for the short_description field
    if (tableName == 'incident' && fieldName == 'description') {
      field.valueFor(tableName, 'short_description');
    } else {
      // if table is not incident, ask the proxy to check if the given field is encrypted for the given table
      field.valueFor(tableName, fieldName);
    }
  }
}
```

In the `encryptFieldsInRecord()` function, the `valueFor()` method is called on a table and a field that are dynamically assigned based on the request. Even though the table and field names can change, the rule asks the proxy to check
whether the field in the table must be encrypted based on the encryption configurations defined.

If the field is not configured for encryption, or if the tag does not match a field in the table, the proxy skips that tag. If the tag matches a field marked for encryption, then the Edge Encryption proxy server encrypts the value.

**Using an encoded query**

In this example, all tags have the `filter` attribute, which indicates whether the tag contains an encoded query.

```xml
<data>
  <record>
    <name filter="false">'Test Record 1'</name>
    <description filter="false">'Test Record 1 Description'</description>
    <query filter="true">category=1^name=edge</query>
  </record>
  <record>
    <name filter="false">'Test Record 2'</name>
    <description filter="false">'Test Record 2 Description'</description>
    <query filter="true">category=2^severity=3</query>
  </record>
</data>
```

The following encryption rule action can apply:

```javascript
function sampleXmlAction3() {
  var xmlContent = request.getAsXmlContent();
  var tableName = request.urlParam.table;
  // This first iterator will iterate over all record elements
  var xmlElementIterator = xmlContent.getIterator('data/record');
  while (xmlElementIterator.hasNext()) {
    encryptFieldsInRecord(xmlElementIterator.next());
  }
}

function encryptFieldsInRecord(xmlElement) {
  // this time we want to iterate over all tags representing fields in the table
  var fieldIterator = xmlElement.getIteratorOverAllChildren();
  while (fieldIterator.hasNext()) {
    var field = fieldIterator.next();
    var fieldname = childElement.getName();
    // let's look at the filter attribute, if true, then encrypt as encoded query
    if (field.getAttributeValue('filter') == 'true') {
      field.encodedQueryFor(tableName);
    } else {
      // handle the rest of the tags...
    }
  }
}
```
If the **filter** attribute value is true, the rule asks the proxy server to encrypt the values in the encoded query. If false, the rule asks the proxy to check whether the field should be encrypted.

**XMLContent**

A global object that provides methods to iterate over the XML content.

You can access an `XMLContent` object by calling `getAsXmlContent()` on a `request` object.

You access XML data in a **POST or URL parameter** by calling

```java
request.postParams.<parameter name>.getAsXmlContent()
```

or

```java
request.urlParams.<parameter name>.getAsXmlContent()
```

**XMLContent - getIterator()**

Returns an `XMLElementIterator` object for the XML content.

<table>
<thead>
<tr>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>None</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Returns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td><code>XMLElementIterator</code></td>
</tr>
</tbody>
</table>

**XMLContent - getIterator(String xpath)**

Returns an `XMLElementIterator` object for the XML content based on the specified parameter.
## Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>xPath</td>
<td>String</td>
<td>An xPath-like expression that specifies where in the XMLContent object to start.</td>
</tr>
</tbody>
</table>

## Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XMLElementIterator</td>
<td>An object that can be used to iterate over elements in the XMLContent object.</td>
</tr>
</tbody>
</table>

### XMLElementIterator

Provides methods for iterating over XML elements.

You get an XMLElementIterator object by calling the `getIterator()` method of the XMLContent class.

### XMLElementIterator - hasNext()

Determines if there is another element available.

#### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>True if another element is available.</td>
</tr>
</tbody>
</table>

### XMLElementIterator - next()

Returns the next element in the iterator.

You cannot call `next()` without first calling `hasNext()`.
XMLElement

Provides methods for iterating through XML elements and mapping values to fields in a table.

You get an XMLElement object by calling the next() method of an XMLElementIterator object.

XMLElement - getIterator(String xPath)

Returns an XMLElementIterator object for the XML element based on the specified parameter.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>xPath</td>
<td>String</td>
<td>An xPath-like expression that specifies where in the XMLElement object to start.</td>
</tr>
</tbody>
</table>

XMLElement - getIteratorOverAllChildren()

Returns an XMLElementIterator object that includes all sub-elements for the XML element based on the specified parameter.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XMLElementIterator</td>
<td>An object that can be used to iterate over elements in the XMLElement object.</td>
</tr>
</tbody>
</table>
XMLElement - valueFor(String tableName, String fieldName)

Specifies that the value of the element maps to the specified field in the specified table.

Calling this method on an element value tells the proxy that the value for this element maps to the specified field in the specified table. The proxy then checks if the field must be encrypted. If the table and field names are unknown, you can call the `valueFor()` method on a table and a field that are dynamically assigned based on the request.

### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tableName</td>
<td>String</td>
<td>The table name.</td>
</tr>
<tr>
<td>fieldName</td>
<td>String</td>
<td>The field name.</td>
</tr>
</tbody>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

XMLElement - encodedQueryFor(String tableName)

Specifies that the value of the element is an encoded query for the specified table.
Calling this function on an element tells the proxy that the value of the element is an encoded query for the specified table. The proxy parses the encoded query and encrypts the fields in the encoded query that must be encrypted.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tableName</td>
<td>String</td>
<td>The table that you expect the query to run on.</td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

**XMLElement - getName()**

Returns the element name.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**XMLElement - getAttributeValue(String attribute)**

Returns the value of the specified attribute.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>attribute</td>
<td>String</td>
<td>Attribute name.</td>
</tr>
<tr>
<td>Returns</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>String</td>
<td>The attribute value.</td>
<td></td>
</tr>
</tbody>
</table>

**JSON APIs**

JSON APIs can be used after calling `getAsJsonContent()` on either the request object or a `ParameterValue` property.

When using JSON APIs to write your encryption rule, you can follow a general format:

1. Call `getAsJsonContent()` on the `request` object. This returns an iterable object of the `JsonNode` underlying class.

2. Call `getIterator()` or `getIterator(String xPath)` on the `JsonNode` object. This returns a `JsonNodeIterator` object that can be used to iterate over nodes in the JSON object.

3. Call the `hasNext()` method on the `JsonNodeIterator` object to determine whether another element is available.

4. Call `next()` on the `JsonNodeIterator` object to return the next JSON element. You cannot call `next()` without first calling `hasNext()`.

5. Call `valueFor(String tableName, String fieldName)` on the JSON element. This method tells the proxy that the value for this element maps to the specified field in the specified table. The proxy then checks whether the field must be encrypted.

   **Note:** To determine if you want to call `valueFor(String tableName, String fieldName)` on a JSON element, you can use the `getName()` method to return the name of the element.

**Mapping to a known table-field on the instance**

In this example, the JSON payload is processed on the instance to insert records in the incident table. The description field populates `short_description` on the incident.

```json
{
    data: {
        records: [
            {
                "name": "Test Record 1",
                "description": "Test Record 1 Description",
            }
        ]
    }
}
```
The following rule can apply:

```javascript
function sampleJsonAction1() {
  var jsonContent = request.getAsJsonContent();
  // This loop iterates over all description elements in the records array
  var jsonNodeIterator = jsonContent.getIterator('/data/records/description');
  while (jsonNodeIterator.hasNext()) {
    var jsonNode = jsonNodeIterator.next();
    jsonNode.valueFor('incident', 'short_description');
  }
}
```

This action iterates through the `description` nodes and asks the proxy server to encrypt the values and insert them into `incident.short_description` on the instance.

⚠️ **Note:** This rule finds all `description` nodes within the JSON payload. If there is only one occurrence of a node to encrypt, the rule still uses the XPath and iterator structure. However, it iterates only once in the loop.

**Mapping to an unknown table-field on the instance**

In this example, the rule iterates over `records`, but is not sure what nodes to expect. The only known is that for each object within `records`, the nodes match the names of the columns specified in the table URL parameter.

The rule also specifies that, if the table is `incident`, then the data in the `description` node should be encrypted and stored in the `short_description` field on the instance.

```javascript
function sampleJsonAction2() {
  var jsonContent = request.getAsJsonContent();
  var tableName = request.urlParam.table;
  // This first iterator will iterate over all record elements
  var jsonNodeIterator = jsonContent.getIterator('data/records');
  ```
while (jsonNodeIterator.hasNext()) {
    encryptFieldsInRecord(jsonNodeIterator.next());
}

In the encryptFieldsInRecord() function, the valueFor() method is called on a table and a field that are dynamically assigned based on the request. Even though the table and field names can change, the rule asks the proxy to check whether the field in the table must be encrypted based on the encryption configurations defined.

If the field is not configured for encryption, or if the node name does not match a field in the table, the proxy skips that node. If the node name matches a field marked for encryption, then the proxy encrypts the value.

Using an encoded query

function sampleJsonAction3() {
    var jsonContent = request.getAsJsonContent();
    var tableName = request.urlParam.table;
    // This first iterator will iterate over all record elements
    var jsonNodeIterator = jsonContent.getIterator('data');
    while (jsonNodeIterator.hasNext()) {
        var jsonNode = jsonNodeIterator.next();
        if (jsonNode.getName() == 'records')
            encryptRecords(jsonNodeIterator.next());
        else if (jsonNode.getName() == 'query')
            jsonNode.encodedQueryFor(tableName);
    }
}

function encryptRecords(jsonNode) {
    // we iterate over all fields in the node
    var fieldIterator = jsonNode.iterator();
    while (fieldIterator.hasNext()) {
        var field = fieldIterator.next();
        var fieldName = childElement.getName(); 
        if (fieldName == 'description') {
            field.valueFor(tableName, 'short_description');
        } else {
            field.valueFor(tableName, fieldName);
        }
    }
}
var recordIterator = jsonNode.iterator();
while (recordIterator.hasNext()) {
  encryptFieldsInRecord(recordIterator.next());
}
}

function encryptFieldsInRecord(jsonNode) {
  // this time we want to iterate over all nodes
  var fieldIterator = jsonNode.iterator();
  while (fieldIterator.hasNext()) {
    var field = fieldIterator.next();
    var fieldname = childElement.getName();
    field.valueFor(tableName, fieldName);
  }
}

In this example, the rule iterates over data. As it finds records, it performs the same logic as in the second example, iterating over fields in each node. When it finds the query node, it calls encodedQueryFor() to encrypt values that should be encrypted in the query.

**JsonNode**

A global object that provides methods to iterate over the JSON content.

You can access a JsonNode object by calling getAsJsonContent() on a request object.

You access JSON content from a POST or URL parameter by calling request.postParms.<parameter name>.getAsJsonContent() or request.urlParms.<parameter name>.getAsJsonContent().

**JsonNode - getIterator(String xPath)**

Returns a JsonNodeIterator object for the JSON content.

This method can only be used on the root node, but can be used to traverse deep into the JSON object. Subsequent traversals must use the iterator() method.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>xPath</td>
<td>String</td>
<td>An xPath expression.</td>
</tr>
</tbody>
</table>
Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JsonNodeIterator</td>
<td>An object that can iterate over nodes in the JSON object.</td>
</tr>
</tbody>
</table>

**JsonNode - iterator()**

Returns a `JsonNodeIterator` object that iterates over all child nodes of the current node.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JsonNodeIterator</td>
<td>An object that can iterate over nodes in the JSON object.</td>
</tr>
</tbody>
</table>

**JsonNode - getAsString()**

Returns the current node value as a string.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The current node value.</td>
</tr>
</tbody>
</table>

**JsonNode - getAsString(String propertyName)**

Returns the string value of the specified property.
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>propertyName</td>
<td>String</td>
<td>Name of the property.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The property value.</td>
</tr>
</tbody>
</table>

JsonNode - getName()

Returns the name of the current JSON node.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Name of the current JSON node.</td>
</tr>
</tbody>
</table>

JsonNode - valueFor(String tableName, String fieldName)

Specifies that the JSON property maps to the specified field in the specified table.

Calling this method on a JSON property tells the proxy that the value for this property maps to the specified field in the specified table. The proxy then decides if the field must be encrypted. If the table and field names are unknown, you can call the valueFor() method on a table and a field that are dynamically assigned based on the request.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tableName</td>
<td>String</td>
<td>The table name.</td>
</tr>
</tbody>
</table>
Parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fieldName</td>
<td>String</td>
<td>The field name.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

JsonNode - encodedQueryFor(String tableName)

Specifies that the value of the JSON property is an encoded query for the specified table.

Calling this function on a JSON node tells the proxy that the value is an encoded query for the specified table. The proxy parses the encoded query and encrypts the values for fields in the encoded query that must be encrypted.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tableName</td>
<td>String</td>
<td>The table that you expect the query to run on.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

JsonNodeIterator

You get a JsonNodeIterator object by calling the getIterator() or iterator() methods of the JsonNode class.

JsonNodeIterator - hasNext()

Determines if there is another property available.
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>True if another property is available.</td>
</tr>
</tbody>
</table>

JsonNodeIterator - next()
Returns the next property in the iterator.

You cannot call `next()` without first calling `hasNext()`.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JsonNode</td>
<td>The next JsonNode.</td>
</tr>
</tbody>
</table>

print(String message)
Prints a message to the wrapper log file: `<proxy server directory>/logs/wrapper_<date>.log`.

This method is available only in an Edge Encryption rule action script.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>message</td>
<td>String</td>
<td>The message to be written to the wrapper log file.</td>
</tr>
</tbody>
</table>
### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

### Prohibited keywords

The Edge Encryption proxy validates encryption rule scripts before saving the rule. Many JavaScript keywords are not allowed in encryption rule scripts.

**Prohibited keywords**

<table>
<thead>
<tr>
<th>Keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DIR</strong></td>
</tr>
<tr>
<td><strong>FILE</strong></td>
</tr>
<tr>
<td><strong>LINE</strong></td>
</tr>
<tr>
<td><strong>parent</strong></td>
</tr>
<tr>
<td><strong>proto</strong></td>
</tr>
<tr>
<td>Error</td>
</tr>
<tr>
<td>eval</td>
</tr>
<tr>
<td>getClass</td>
</tr>
<tr>
<td>getPrototypeOf</td>
</tr>
<tr>
<td>Java</td>
</tr>
<tr>
<td>javax</td>
</tr>
<tr>
<td>javafx</td>
</tr>
<tr>
<td>JavalImporter</td>
</tr>
<tr>
<td>load</td>
</tr>
<tr>
<td>loadWithNewGlobal</td>
</tr>
<tr>
<td>new</td>
</tr>
<tr>
<td>Packages</td>
</tr>
<tr>
<td>Object</td>
</tr>
<tr>
<td>prototype</td>
</tr>
</tbody>
</table>
Prohibited keywords (continued)

<table>
<thead>
<tr>
<th>Keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td>RegExp</td>
</tr>
<tr>
<td>setPrototypeOf</td>
</tr>
<tr>
<td>this</td>
</tr>
<tr>
<td>throw</td>
</tr>
</tbody>
</table>

**Edge Encryption dictionary attributes**

You can add Edge Encryption dictionary attributes to tables and fields.

To set an Edge Encryption dictionary attribute to true, you must enter `attribute=true` in the **Attributes** field. To add a dictionary attribute to a record, see .

**Edge Encryption Excluded [edge_encryption_excluded]**

When set to true, the field or table cannot be encrypted.

- Value: true/false
- Target element: field or table
- Default value: false

**Edge Encryption Enabled [edge_encryption_enabled]**

When set to true, the field is eligible for encryption through an encryption configuration. Because this attribute is used by the system and cannot be modified, it is not always displayed to the user.

**Note:** This attribute does not indicate that a field is encrypted, nor does it trigger any encryption logic on the field. Rather, the attribute determines the possibility of the field being encrypted by a user.

- Value: true/false
- Target element: field
- Default value: true for String fields

**Edge Encryption Clear Text Allowed [edge_encryption_clear_text_allowed]**
When set to true, allows server-side scripts to append non-encrypted data to an encrypted string within the field for user actions performed through the proxy server, or any server-side automated scripts, such as scheduled jobs.

- Value: true/false
- Target element: field
- Default value: false

**Domain separation and Edge Encryption**

Domain separation is unsupported in Edge Encryption. This application provides the ability to encrypt data from within the customer’s environment through the use of specific configurations, rules, and keys defined on the Edge Encryption proxy. The Edge Encryption proxy is not domain aware and cannot support domain-specific settings. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: No support**

- The domain field may exist on data tables but there is no business logic to manage the data.
- This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation.

**How domain separation works in Edge Encryption**

Edge Encryption can be used where domain-specific keys, configurations, and rules are not required.

ℹ️ **Note:**

It is not recommended to install Edge Encryption on domain instances at all even for internal service provider usage.

**Related information**

Domain separation for service providers
Data integration with Edge Encryption

To integrate third-party data with an instance using Edge Encryption, you must route the data through the Edge Encryption proxy server using supported integrations. Supported integrations use base system encryption rules that map data in each payload to fields in a table.

Upload data to fields marked for encryption

Edge Encryption does not support importing data from or exporting data to Excel, CSV, XML, or other file types to or from fields with encryption configurations defined.

**ODBC driver**

Encrypt requests and query data through the Edge Encryption proxy server using the ODBC driver.

Learn more: Edge Encryption ODBC driver integration

**MID Server**

You can configure the MID Server to route data through an Edge Encryption proxy server. However, some restrictions apply.

Learn more: Edge Encryption MID Server integration

**REST/SOAP web services**

Use REST/SOAP web services to update or retrieve record data through the Edge Encryption proxy server.

Learn more:

**JSONv2 web service**

Use JSONv2 web service APIs to update or retrieve record data through the Edge Encryption proxy server. Base system encryption rules support data retrieval and data modification APIs.

- To insert a single record using the data modification API, use the `insert()` or `insertMultiple()` methods.
- To insert multiple records using the data modification API, use the `insertMultiple()` method.

Learn more:

To encrypt data from custom third-party integrations not listed above, create custom encryption rules. See Define a custom encryption rule.
Upload attachments to records marked for encryption

Attachments can be uploaded to tables with attachment encryption configured using REST and SOAP web services.

Edge Encryption ODBC driver integration

Configure your ODBC driver to query data encrypted by Edge Encryption. The Edge Encryption proxy server encrypts ODBC driver requests to the ServiceNow instance when Edge Encryption is integrated with the ODBC driver.

Encrypted responses from the instance are decrypted through the Edge Encryption proxy server before passing to the ODBC driver in your network.

For a successful integration, the ODBC driver must trust the Edge Encryption proxy server certificate. If the Edge Encryption proxy server certificate is signed by a Certificate Authority trusted by the ODBC driver, the Edge Encryption proxy server is automatically trusted. However, if a Certificate Authority trusted by the ODBC driver has not signed the Edge Encryption proxy server certificate, you must import the self-signed certificate to the ODBC truststore.

Import a self-signed certificate to the ODBC truststore

If a Certificate Authority trusted by the ODBC driver has not signed the Edge Encryption proxy server certificate, you must import a self-signed certificate to the ODBC truststore. You can export the certificate from the Edge Encryption proxy server and import it into the ODBC truststore.

Before you begin

To determine whether a Certificate Authority trusted by the ODBC driver has signed the Edge Encryption proxy server certificate, run the following command in the keystore directory in the proxy home directory to view a list of Certificate Authorities trusted by the ODBC driver:
keytool -keystore "<ODBC directory>\ip\Java\jre\lib\security\cacerts" -list

**Procedure**

1. Change to the keystore directory in the proxy home directory.
2. Check the keystore for the self-signed certificate.
   
   a. To check the keystore for the certificate, you can run the following command to list all the items in the keystore.
   
   ```
   keytool -list -keystore keystore.jceks -storetype jceks -v
   ```
   
   b. Locate the key alias in the list of items.
3. Using the key alias, export the certificate to a .cer file.
   
   ```
   keytool -export -alias <key alias> -keystore keystore.jceks -storetype jceks -rfc -file <file name>.cer
   ```

4. Change to your ODBC truststore directory: ODBC\ip\Java\jre\lib\security \cacerts.
5. Import the certificate to your ODBC truststore.
   
   ```
   keytool -keystore cacerts -importcert -alias $<key alias> -file <file name>.cer
   ```

**Set the ODBC driver properties**

Set the ODBC driver properties to route requests through the Edge Encryption proxy server.

**Procedure**

1. In Windows, navigate to Start > Programs > ServiceNow ODBC Management Console.

2. Expand the console tree root to: ServiceNow ODBC Manager\Manager \<installation location>\Services\ServiceNow_ODBC\Data Source Settings \ServiceNow\IP Parameters.

3. Double-click the DataSourceIPProperties attribute.

4. Change the Value to the URL of your Edge Encryption proxy server, such as https://<IP address>:<port>
5. Click **OK**.

**What to do next**
The ODBC driver is now configured to route requests to the instance through the Edge Encryption proxy server.

**Edge Encryption MID Server integration**
Configure the MID Server to route data through an Edge Encryption proxy server.

When integrated with the MID Server, the Edge Encryption proxy server acts as the MID Server's endpoint. The Edge Encryption proxy server then encrypts and decrypts data passing between the ServiceNow instance and the MID Server.

**Limitations when integrating with the MID Server**
When MID Server data is configured to pass through the Edge Encryption proxy server, the following limitations apply:

- Encryption of ECC Queue fields is not supported.
- Encrypted data cannot be used with Discovery or Service Mapping.
Point the MID Server to the Edge Encryption proxy server

To pass data from the MID Server through the Edge Encryption proxy server, update the MID Server configuration file to point the MID Server to the Edge Encryption proxy server.

About this task

When configuring the MID Server to pass through the Edge Encryption proxy server, you cannot use the web proxy properties in the MID Server configuration file to route traffic through the Edge Encryption proxy server to your instance. Instead, you must set the Edge Encryption proxy server as the MID Server's endpoint.

Procedure

1. Navigate to your local MID Server directory and open the config.xml file.
2. Find the element `<parameter name="url" value="https://YOUR_INSTANCE.service-now.com" />` and change the value property to the URL of your Edge Encryption proxy server. For example, http://hostname.mycompany.com:8081. This step directs the MID Server to pass traffic to the Edge Encryption proxy server instead of the instance. The Edge Encryption proxy server in turn encrypts any necessary fields and passes the payload to the instance.
3. Save and close the file.
4. If running, restart the MID Server.

Edge Encryption diagnostics and performance

Monitor Edge Encryption proxy server performance trends and drill into errors generated by the Edge Encryption proxy server.

Edge proxy performance

View key Edge Encryption proxy server performance trends using the Edge Proxy graph set on the ServiceNow Performance homepage. Monitored trends include:

- Maximum and average response times between the client, proxy server, and instance.
- CPU, disk space, and memory usage of the host machine.
- Maximum and average network latency between the proxy server and the ServiceNow instance.

Note: Edge Encryption proxy servers with duplicate names do not report performance trends.
Edge Processing (Max and Average)
Maximum and average time in milliseconds to process a request. These data points are general trends over time.

- **Total Time**: Time for the proxy server to receive a request from a client and send a response. This data point is the sum of the subsequent data points.

- **Proxy Response**: Time for the proxy server to process a response from the instance.

- **Proxy-Instance Round Trip**: Time for the proxy server to send a request to the instance and receive a response. Includes network latency between the proxy server and the instance and time spent by the instance to process the request.

- **Rules**: Time for the proxy server to evaluate a request using defined encryption rules.

- **Proxy Request**: Time for the proxy server to process a client request and forward it to the instance.

**Edge Proxy Performance (Max and Average)**

Maximum and average percentage of resources used on the host machine.

- CPU Usage
- Memory Usage
- Disk Usage

**Edge Proxy Latency**

Maximum and average network latency in milliseconds at a given point in time. Latency is determined by round-trip time for a proxy server to send a simple ping to the instance and receive a response.

**Proxy Error Reports**

Navigate to *Edge Encryption Configuration > Diagnostics and Troubleshooting > Proxy Error Reports* to view all proxy server errors collected over the past seven days.
Errors are collected over a one-minute period. Each minute, an error report is generated. The vertical axis displays the number of error reports over the last seven days that include each error. For example, even if the DEFAULT_ERROR_CODE error is thrown multiple times over a one-minute report period, the DEFAULT_ERROR_CODE bar will only reach one on the Number of Error Reports axis.

From this view, you can:

• Click each proxy error code bar to see the report on a single error for each proxy server. From this view, you can click the bar again to view the error text in the Edge Encryption Proxy Stat table [edge_encryption_stat]. Follow links in the error text to see more information and possible remediation steps.

• Click Other to see page two of the error report.

Note: If you have more than one proxy server with the same name, a single DUPLICATE_PROXY_NAME error appears in the Proxy Error Report. No other errors are reported for proxy servers with duplicate names. If you encounter this error, make sure that all proxy servers have unique names.

Additional monitoring resources
The instance tracks all encryption proxies. Each Edge Encryption proxy server registers when it starts up. The instance is notified when:

• A new Edge Encryption proxy server starts up.

• An Edge Encryption proxy server is intentionally shut down.

If an Edge Encryption proxy server attempts to register with an instance that does not have Edge Encryption installed, the proxy does not start.
All encryption configuration files are audited. Deleted records are audited on all encryption configuration files. Audit records are put in the sys_audit table. To view the history of a specific configuration record, view the record, and click History > List in the menu. The Mass Encryption Job is not audited.

Use the following additional resources to monitor your proxy servers.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid Insert Attempts</td>
<td>List of attempts to save the following data to encrypted fields:</td>
</tr>
<tr>
<td>[sys_edge_encryption_invalid_insert_log]</td>
<td>- Unencrypted data.</td>
</tr>
<tr>
<td></td>
<td>- Data that did not come from an Edge Encryption proxy.</td>
</tr>
<tr>
<td></td>
<td>The instance rejects and then logs any attempts to save this data. If you have the security-admin role, you can view the logs in the Invalid Insert Attempts list.</td>
</tr>
<tr>
<td>Job Failures</td>
<td>A list of jobs that did not execute successfully.</td>
</tr>
<tr>
<td>[sys_encryption_job_execution]</td>
<td>The instance periodically checks for messages from each registered proxy server. If a proxy server has not sent a message in the required time frame, an error is logged. The log message contains information about the encryption proxy and the last time the proxy pinged the instance. If the instance determines that none of the encryption proxies are online, it logs a message. These messages are added to the system log.</td>
</tr>
</tbody>
</table>

Disable or reduce Edge Proxy statistic collection

Prevent the Edge Encryption proxy server from sending Edge Proxy Graph Set statistics to the ServiceNow Performance homepage, or reduce the frequency of statistic collection.

Before you begin
Role required: admin or security_admin
About this task
By adding properties in the edgeencryption.properties configuration file, you can:

• Disable the Edge Proxy graph set.
• Change the interval during which statistics are collected by the Edge Encryption proxy server. By default, statistics are collected every 30 seconds.

Procedure
1. In your proxy server installation directory, open the edgeencryption.properties configuration file located in the <installation directory>/conf/ folder.
2. Add one of the Edge Encryption proxy server properties.
3. Restart the proxy server.

Entity View Action Mapper
Entity View Action Mapper (EVAM) is an application that standardizes how different data sources display in cards and lists.

EVAM enables you to show information as a card grid view or as a list of information in a list view. Users can page through large data sets of search results and see different views based on filtering.

Prior to EVAM, lists were restricted to a single type of data source. If there were more data sources, you would have to write a custom implementation. EVAM enables you ingest multiple lists from different data sources, and then configure specific views without the need for customization.
EVAM flow

EVAM consists of the following:

- **Entity (datasource)** - The entity that has associated data that you intend to display. For example, a community post or a user.

- **Map** – The mapping process maps the datasource data to component properties that display on the card. You can also associate actions that trigger from the card view.

- **View** – A view is how a card displays data and actions.

- **Actions** – An entity can have an action that performs on the card. For example, you can activate a user into your system.
Features of EVAM

**Use multiple datasources for a single list view**

EVAM can accept multiple disparate datasources and configure the data through sorting and filtering to return the data as a single list.

**Define view templates**

Map the datasource output to a UX component view by using view templates. You can configure multiple view templates per datasource based on a condition to customize how data displays for users.

**Create view configurations to combine conditions, database fields, and declarative actions**

Create a view configuration to combine conditions, database fields, and declarative actions with an associated view template. You can also group view configurations together to create configuration bundles.
Enable user interactions to trigger actions

EVAM enables user interactions to trigger a server script or UXF client action.

What to do

• Define a datasource
• Create an EVAM definition
• Associate a view configuration, view template, and action.

Activation information

EVAM is a Now Platform application that is active by default.

Getting started: Create a multi-data source list display in Entity View Action Mapper

This is a step-by-step process to use EVAM to take in different datasources, configure views, and show them in a card display view.

Before you begin

Role required: admin or evam_admin

About this task

A typical scenario is showing user requests and incidents in a single display view. A user might want to see requests that can be made from a catalog, such as a computer order. They also might want to see open or closed incidents. These items come from different datasources, but need to display through a consistent standard that can be easily configured.

This tutorial runs through creating an EVAM definition with two datasources, a configuration bundle for each datasource which contains two view configurations, and associated actions and view templates. Many tasks are repeated, instead of repeating each step, the following table lists the unique configurations and definitions:

<table>
<thead>
<tr>
<th>EVAM Definition</th>
<th>Datasource [Table]</th>
<th>Configuration Bundle</th>
<th>Action</th>
<th>Configuration View</th>
<th>View Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Requests</td>
<td>Catalog Requests [Requested Item]</td>
<td>Catalog Request Bundle</td>
<td>Navigation</td>
<td>Open Requests</td>
<td>Open Request Template</td>
</tr>
</tbody>
</table>
(continued)

<table>
<thead>
<tr>
<th>EVAM Definition</th>
<th>Datasource [Table]</th>
<th>Configuration Bundle</th>
<th>Action</th>
<th>Configuration View</th>
<th>View Template</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Closed Requests</td>
</tr>
<tr>
<td>Incidents Submitted [Incidents]</td>
<td>Incidents Submitted Bundle</td>
<td></td>
<td></td>
<td></td>
<td>Closed Request Template</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Open Incidents</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Open Incidents Template</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Closed Incidents</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Closed Incidents Template</td>
</tr>
</tbody>
</table>

**Procedure**

1. **Create an EVAM definition for user requests.**
   
   An EVAM definition houses datasources, configuration bundles with associated view configurations, data filters, actions, and templates. After you initially submit your EVAM definition, you will see the related lists to add datasources, configuration bundles, and data filters.

2. **Define datasources for your EVAM definition.**
Create and link each datasource to the User Request definition. The initial datasource is for catalog requests. You can also make one for incidents submitted.

3. Create and link a view configuration bundle.
   You should create two configuration bundles, a catalog request bundle and an incidents submitted bundle.
4. Use the Create and Link to add create and add view configurations. The first one will be for Open Requests. Use the Create and Link to add create and add view configurations. The first one will be for Open Requests.

5. Create an action definition. You can use the create and link related list.
6. Create view templates for requested items and associate with the view configuration.
Here is the template info for the Requested Items Template:

```json
{
  "component": "now-card-evam-record",
  "staticValues": {
    "highlightedHeaderIcon": {
      "key": "clock-outline"
    },
    "highlightedHeaderBkgColor": {
      "key": "positive"
    }
  }
}
```
7. Repeat steps 3-5 to add another view configuration for closed requests. You created a configuration bundle with one view configuration. Add another configuration called Closed requests. This view configuration references the same datasource [requested item], but uses different conditions to show ().

8. Associate view templates to view configurations, click update.

9. View your finished product.

Create an EVAM definition

Define the list of data sources to render. The EVAM definition is the main record for an EVAM configuration.
Before you begin
Role required: admin or evam_admin

Procedure
1. Navigate to **Entity View Action Mapper (EVAM) > EVAM Definitions**, and then click **New**.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the EVAM configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the EVAM definition.</td>
</tr>
<tr>
<td>Sort Order</td>
<td>Order the data is ordered on the EVAM definition. You can select <strong>Ascending</strong> or <strong>Descending</strong>.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the EVAM definition.</td>
</tr>
</tbody>
</table>

3. Click **Submit** and then select your EVAM definition.

4. In the **EVAM Datasource M2Ms** related list, add a datasource:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and Link</td>
<td>You can define a new data source and then link this datasource to your EVAM definition.</td>
</tr>
<tr>
<td>Link Existing</td>
<td>You can add a pre-defined datasource to your EVAM definition.</td>
</tr>
<tr>
<td>Unlink Selected</td>
<td>You can remove the selected datasource from your EVAM definition.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

6. In the **EVAM View Config Bundle M2Ms** related list, add a configuration bundle:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and Link</td>
<td>You can define a new configuration bundle and then link this bundle to your EVAM definition.</td>
</tr>
<tr>
<td>Link Existing</td>
<td>You can add a pre-defined configuration bundle to your EVAM definition.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unlink Selected</td>
<td>You can remove the selected configuration bundle from your EVAM definition.</td>
</tr>
</tbody>
</table>

After you link the configuration bundles, you can define an order to prioritize the bundles, with the lowest number receiving the higher precedence.

7. In the **EVAM Data Filters** related list, click **New** and fill in the form to add data filters:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Label name of the EVAM data filter.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the EVAM data filter.</td>
</tr>
<tr>
<td>Order</td>
<td>Priority that the EVAM view configuration takes over other view configurations. To give higher priority to a view configuration, enter a lower number.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the EVAM view configuration.</td>
</tr>
<tr>
<td>EVAM Definition</td>
<td>Associate an EVAM definition with the data filter.</td>
</tr>
</tbody>
</table>

8. Click **Submit**.

**Define a datasource**

The datasource is an entity that has associated data that you intend to display. For example, a community post or a user.

**Before you begin**

Role required: admin or evam_admin

**Procedure**

1. Navigate to **Entity View Action Mapper (EVAM) > Datasources**, and then click **New**.

2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Application scope of the datasource.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the datasource.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the datasource.</td>
</tr>
<tr>
<td>Table</td>
<td>Choose a table to use for the datasource.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition to define how to filter the data from the selected table.</td>
</tr>
<tr>
<td>Sort By</td>
<td>Table column to use for sorting the table data. For example, you can select to sort knowledge articles by the creation date.</td>
</tr>
</tbody>
</table>

Note: You can only use Sort By for datetime fields when sorting different records.

3. Click Submit.

**View configurations, view templates, and configuration bundles for EVAM**

A view configuration combines conditions, database fields, and declarative actions with an associated view template. You can also group view configurations together to create configuration bundles.

EVAM has pre-defined view configurations, view templates, and configuration bundles to make it easier to use the feature. The OOB configuration bundles include:

- Service Portal Search Bundle
- Service Portal bundle (sp_bundle)

These bundles have view configurations attached that are anticipated to fit the business unit associated. You can also create or edit configuration bundles to meet your needs.

View configurations have an associated view template, tables and conditions, designated table field with data, and associated declarative actions. You can look at the demo_evam_dataset for examples of OOB configuration views. These view configurations are ready to use and are meant to work with many use cases. You can also create or edit view configurations to meet specific needs.

The OOB view templates match an associated view configuration. The templates contain the JSON used to give the necessary information for the card display and use. For example, the Attachment Search Template contains the following:
The JSON structure has the following sections:

<table>
<thead>
<tr>
<th>Template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>component</td>
<td>The card component name.</td>
</tr>
<tr>
<td>staticValues</td>
<td>The static text mapping to component properties. These values have the following properties:</td>
</tr>
</tbody>
</table>
These view templates are ready to use and are meant to work with many use cases. You can also create or edit view templates to meet specific needs.

**Define an EVAM view configuration**
Create a view configuration to combine conditions, database fields, and declarative actions with an associated view template.

**Before you begin**
Role required: admin or evam_admin

**Procedure**
1. Navigate to **Entity View Action Mapper (EVAM) > View Definitions > View Configurations**, and then click **New**.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the EVAM view configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the EVAM view configuration.</td>
</tr>
<tr>
<td>Required Roles</td>
<td>Roles to define who can view the EVAM view configuration</td>
</tr>
<tr>
<td>View Template</td>
<td>Template to associate with the EVAM view configuration.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the EVAM view configuration.</td>
</tr>
</tbody>
</table>
3. Click **Submit**.

### Define an EVAM view template

You can configure multiple view templates per datasource based on conditions to customize how data displays for users. The view template maps fields from the view configuration to component.

**Before you begin**

Role required: admin or evam_admin

**Procedure**

1. Navigate to Entity View Action Mapper (EVAM) > View Definition > View Templates, and then click **New**.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the EVAM view template.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the EVAM view template.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the EVAM view template.</td>
</tr>
<tr>
<td>Template</td>
<td>A JSON template which defines the view for a mapped datasource. For example, the default search template contains the following:</td>
</tr>
</tbody>
</table>

```json
{
    "component": "sn-search-result-evam-card",
    "staticValues": {
```

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Priority that the EVAM view configuration takes over other view configurations. To give higher priority to a view configuration, enter a lower number.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to associate with the EVAM view configuration.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions for when to use the EVAM view configuration.</td>
</tr>
<tr>
<td>Table Fields</td>
<td>Table fields to display on the EVAM view configuration.</td>
</tr>
<tr>
<td>Custom Fields</td>
<td>A custom field to display on the EVAM view configuration.</td>
</tr>
</tbody>
</table>
3. Click **Submit**.

**Create an EVAM action definition**

You can associate a declarative action with a view template. EVAM also enables user interactions to trigger a server script or UXF client action.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **Entity View Action Mapper > Action Definition**, and then click **New**.

2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action label</td>
<td>Display label of the EVAM action.</td>
</tr>
<tr>
<td>Action name</td>
<td>Database name for the EVAM action name.</td>
</tr>
<tr>
<td>Implemented as</td>
<td>Implementation of the EVAM action definition. Select one of the following:</td>
</tr>
<tr>
<td></td>
<td><strong>Server Script</strong>&lt;br&gt;Executes a script on the server, for example, to assign a record to someone, or delete a record.</td>
</tr>
<tr>
<td></td>
<td><strong>UXF Client Action</strong>&lt;br&gt;Takes action on the client side, such as opening a record or making a phone call.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Specify client action | You can choose a pre-defined action. For example, SC Content Items KB Article Navigation, to display KB articles.

Note: This field appears only if you select to implement the action as a UXF client action.

Application | Application scope of the EVAM action.
Active | Option to activate the EVAM action.
Description | Description of the EVAM action.

3. Click **Submit**.

**Define an EVAM configuration bundle**

Create a view configuration to combine conditions, database fields, and declarative actions with an associated view template.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **Entity View Action Mapper (EVAM) > View Definitions > View Configurations**, and then click **New**.
2. On the form, fill in the fields.

Field | Description
--- | ---
Name | Name of the EVAM view configuration.
Active | Option to activate the EVAM view configuration.
Required Roles | Roles to define who can view the EVAM view configuration
View Template | Template to associate with the EVAM view configuration.
Application | Application scope of the EVAM view configuration.
Order | Priority that the EVAM view configuration takes over other view configurations. To give higher priority to a view configuration, enter a lower number.
Table | Table to associate with the EVAM view configuration.
### Condition

Conditions for when to use the EVAM view configuration. Click **Add Filter Condition** to select which conditions should be met.

### Table Fields

Table fields to display on the EVAM view configuration. You can choose from available table fields and move them to **Selected**. You can also order the order they are shown.

### Custom Fields

A custom field to display on the EVAM view configuration. You must supply a comma-separated list of table fields are required for the template.

---

**Flow Designer**

Flow Designer is a Now Platform® feature for automating processes in a single design environment. Flow Designer lets process owners use natural language to automate approvals, tasks, notifications, and record operations without coding.

You can expand Flow Designer to communicate with external instances and third-party systems by requesting a separate subscription to **IntegrationHub**.

**Flow Designer in action**

Watch this seven-minute video to learn how to create and test a flow in Flow Designer. Demonstrates how to create a flow in Flow Designer.

For developer training, see **Using Flow Designer** on the ServiceNow® Developer Site.

**Flow Designer benefits**

Flow Designer provides process owners and developers these benefits:

- Automates repetitive work to improve efficiency and experience.
- Describes a workflow in natural language to help non-technical users understand what it does.
- Enables creating and testing a workflow from a single interface to ensure it works as expected.
- Promotes process automation by enabling subject matter experts to develop and share reusable actions with flow designers.
- Reduces upgrade costs, with upgrade-safe Now Platform logic replacing complex custom script.
• Reduces development costs by providing a library of reusable actions.

• Enables extending Flow Designer content by subscribing to ServiceNow IntegrationHub or installing spokes.

Design considerations
While learning Flow Designer, make sure that you understand how existing Now Platform automation processes such as business rules and workflows change records to avoid creating conflicting logic. See the Architecture Overview to understand how Flow Designer works within the Now Platform. Avoid duplicating existing business logic from business rules and workflows. If you’re replacing an existing automation process, you may need to deactivate it before replacing it with Flow Designer flows and actions.

Flow Designer components
Flow Designer consists of the following components:

Flows
A flow is an automated process consisting of a trigger and a sequence of actions. Flows automate business logic for a particular application or process. For example, the VTB Sample Flow creates and assigns a VTB card whenever a priority 1 incident is created. Building and managing flows requires that you have some familiarity with the Now Platform tables and fields that the application or process uses. Process analysts can create flows using available actions or copy an existing flow to use it as a template.

Subflows
A subflow is an automated process consisting of a sequence of reusable actions, data inputs, and outputs. In contrast to flows, subflows do not have a trigger but instead run within a flow, another subflow, or a script. Building and managing subflows requires that you have some familiarity with the Now Platform tables and fields that the application or process uses. Process analysts can create subflows using available actions or use an existing subflow as a template.

Actions
An action is a reusable operation that enables process analysts to automate Now Platform features without having to write code. For example, the Create Record action allows process analysts to generate records in a particular table with particular values when certain conditions occur. ServiceNow core actions like Create Record require some familiarity with Now Platform tables and fields.
Action designers can create application-specific actions to preset configuration details. For example, creating a Create Incident Task action ensures that the process analyst uses the correct table and field configuration each time the action is used. You can add application-specific actions by activating the associated spoke.

**Spokes**

A spoke is a scoped application containing Flow Designer actions and subflows for managing specific tables. For example, the **ITSM Spoke** contains actions for managing Incident and Problem records. For a list of available spokes, see Spokes. You can activate additional spokes on your instance by installing the appropriate app from the ServiceNow Store or activating the appropriate plugin. Building your own spoke requires familiarity with application development on the Now Platform.

**Action steps**

An action step or step is a single reusable operation within an action. For example, the **Create Record** step allows action designers to specify the table and field values to use during record creation. Action steps require subject matter expertise with application tables, fields, and business logic. Application developers or IT generalists add action steps to actions from the Action Designer design environment. Flow Designer provides a set of ServiceNow core action steps to automate Now Platform processes. You can add application-specific action steps by activating the associated spoke.

**Flow Designer environment**

The Flow Designer environment consists of the following interfaces:

- **Flow Designer landing page**
  - Access or create actions, flows, subflows, or their execution details.

- **Flow Designer design environment**
  - Create and edit flows by defining a trigger and adding actions. Test flows to see if they complete successfully and to review the runtime values they generate. Activate flows to make them available for execution on your instance and to preserve their current actions, inputs, and sequence as a snapshot separate from further configuration changes.

- **Action Designer design environment**
Create and edit actions by defining inputs and adding action steps. Test actions to verify if they complete successfully and review the runtime values they generate. Copy actions to use existing actions as templates. Publish actions to activate them, which makes them available to activated flows and to preserve their current action steps, variables, and sequence as a snapshot separate from further configuration changes.

**Flow and action execution details**

View runtime information about an action or flow directly from the design environment such as the current state, actions or steps run, and values produced. Open related records from embedded Now Platform editors or in a new tab.

**Getting started with flows**

Create a sample flow with a trigger and base system actions that requires an approval.

**Before you begin**

Role required: admin

⚠️ **Note:** While Flow Designer is designed to use the flow_designer and delegated_developer roles in most scenarios, this tutorial uses the admin role to illustrate functionality without requiring additional roles to set up records and approve requests.

The ITSM application is required to access the Task table.

Watch this 11-minute video for an introduction to using Flow Designer. Introduction to spokes, setting up an application, granting access, creating a flow, setting up an ATF test, and publishing the flow.

**About this task**

A flow can include these components:

- **Trigger:** An activity that initiates the flow, such as a record created in a specified table or a scheduled job.
- **Conditions:** Statements that determine when or how an action runs. For example, run an action only if a field is over a certain value.
- **Actions:** Operations executed by the system, such as a field value updated, approval requested, or a value logged.

To understand basic flows, create an expense approval flow. This flow:
1. Runs when an Expenses record is created.
2. Uses the total amount to determine which action to run.
3. Approves the request if it is under the specified dollar amount.
4. Requires manager approval if it is over a specified dollar amount. Another approver can be manually added.

Procedure
1. Create a custom application for the flow. Creating flows and actions within an application enables you to publish flows and actions to an application repository and deploy them on other instances. While this example does not use delegated development, you can optionally delegate action and flow designer development by assigning developers to the application.
   a. Navigate to System Applications > Studio.
   b. Create a custom application called Expenses Getting Started.
2. In Studio, create an Expenses table.
   a. Click Create Application File.
   b. Under Data Model, select Table and click Create. A Table form opens.
   c. Complete the form with the following values.
      • Label: Expenses
      • Extends table: Task
   d. Save the form.
   e. Add three additional columns to the table.

<table>
<thead>
<tr>
<th>Column label</th>
<th>Type</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>Floating point number</td>
<td>None</td>
</tr>
<tr>
<td>Destination</td>
<td>String</td>
<td>None</td>
</tr>
<tr>
<td>Requested for</td>
<td>Reference</td>
<td>User [sys_user]</td>
</tr>
</tbody>
</table>
3. Add four records to the Expenses table to use in Flow Designer tests. When you test your flow in later steps, you can specify which record is used as the trigger, enabling you to test specific record values.

   a. On the Expenses table record, click the Show list related link.

   b. Click New.

   c. Configure the form to add the Amount, Destination, and Requested for fields, and the Approvers related list.

   d. Complete the Destination and Requested for fields. In the Amount field, add a value under 100.00.
      Make sure that the user in the Requested for field in the test record has a manager assigned in the system. If the user in the test record does not have a manager, configure the User form to add the Manager field, and assign a manager to the user.

   e. Submit the form.

   f. Add another record to the table with an amount under 100.00.

   g. Add two more records to the table with a value over 100.00 in the Amount field.

4. In Studio, create a new flow.

   a. Click Create Application File.


   c. Select the Flow option, click Next.

   d. In the Flow Name field, enter Expense Approval.

   e. Click Submit.
      An Expense Approval flow is created in the Expenses Getting Started scope.

5. Create a trigger that runs the flow when a record is created in the Expenses table.
• Trigger: Created
• Table: Expenses [x_expenses_getting_expenses]

6. Add an if condition to the flow.
   a. Select Flow Logic > If.
   b. In the right-hand pane, expand the Trigger - Record Created category and the [Expenses Record] pill. Drag-and-drop the [Amount] pill into Condition 1. A data pill represents the value of a record or a field at a particular stage in your flow. Dragging the [Amount] data pill from the trigger populates the condition with the value of the field in the triggering record.
   c. Set Condition 1 to [Trigger->Expenses Record->Amount] [less than] [100.00].

7. Underneath action 1, click + to add an action that runs when the If condition is met.
8. Create an Update Record action that approves the request.
   - **Action:** Update Record
   - **Record:** Expand the Trigger - Record Created category and drag the [Expenses Record] data pill from the right-hand pane.
   - **Table:** Set to Expenses [x_expenses_getting_expenses].
   - **Fields:**
     - Approval: Approved
     - Work notes: Auto-approved. Amount less than $100.00

9. Add an else condition to the flow.
   - **a.** Select Flow Logic > Else.

10. Underneath action 2, click + to add an Ask for Approval action that runs when the Else condition is met.
a. Complete the fields in the Ask for Approval step.
   
   • **Action:** Ask for Approval
   
   • **Record:** Expand the [Trigger - Record Created] category and drag the [Expenses Record] data pill from the right-hand pane.
   
   • **Table:** Set to Expenses [x_expenses_getting_expenses].
   
   • **Approval Field:** Set to Approval.
   
   • **Journal Field:** Set to Approval history.

b. Define the rules in the Ask for Approval step.

   • **[Approve]** when [Anyone approves] from the field [Trigger->Expenses Record->Requested for->Manager], [OR]

   • [Anyone approves] from the [Manual User(s)] list. Select 🧵 to allow a manual approver to process an approval or rejection. A manual approver is a user manually added to the Approvers related list who can then approve the request. For example, you can manually add a subject matter expert to a task to approve the request. To learn more about adding manual approvers, see Generate approvals using the approvers related list.

   Select Add another OR rule set to define rejection rules. When defining approvals, make sure to include rejection rules to avoid creating flows that remain in a waiting state if there are no matching approval rules.

   • **[Reject]** when [Anyone rejects] from the field [Trigger->Expenses Record->Requested for->Manager], [OR]

   • [Anyone rejects] from the [Manual User(s)] list.
c. Define a due date to automatically approve, cancel, or reject an approval if the request is not approved or denied by the designated time. Adding a due date ensures that the flow does not remain in a waiting state.

- **[Approve]** if pending by **[Relative date] [1][Days]** from **[Trigger->Expenses Record->Created]**.

- **Days schedule [8-5 weekdays excluding holidays]**.

This due date automatically approves all requests that have not been approved or denied within one day from when the request was created.

11. Click **Save**.

12. Test the flow using a record with an amount below the designated limit.

a. From the flow, click **Test**.

   The Test flow modal appears.

b. In the **Record** field, select a record you created in earlier steps that has value in the **Amount** field under the 100.00 limit. This field is a reference to the table defined in the trigger.

   **Note:** Testing a flow bypasses the trigger conditions and immediately runs it. To test a flow with a record-based trigger, you must select a specific record to act as the trigger.

c. Select **Run Test**.
d. After the flow executes, click **Flow has been executed. To view the flow, click here**. The Execution Details open.

Because the amount is less than 100.00, the first condition is met and the request is approved.

13. Navigate back to the flow and run the test again using a record with an amount over the designated amount.

14. After the flow executes, open the flow Execution Details. Because the amount is over the designated limit, the request must be approved. Until a manager or a manual approver approves the request, the state is **Waiting**.
15. Approve the request. In an active flow, a user from the Approvers list would approve or reject the request. However, because the flow is being tested, an admin can approve the flow.

a. Navigate to the test record.
   The associated manager appears in the Approvers related list with Requested in the State field. Alternatively, you can edit the list to add manual approvers.

b. Change the value of the State field in the Approvers related list to Approved.

c. Navigate back to the flow Execution Details and refresh the browser.
Because the request is approved, the flow completes.

What to do next
Transform the Ask for Approval action into a reusable action using Action Designer. Actions enable flow designers to add complex actions to multiple flows with minimal configuration. See Getting started with actions.

Build your first flow in Flow Designer
Step through an example of how to build, test, and activate a sample flow in Flow Designer.

Before you begin
- Role required: admin, flow_designer, or delegated_developer
- Make sure to familiarize yourself with any features that your business uses to automate operations on the Now Platform, such as Flow Designer, business rules, and workflows. Learning about these concepts can help you avoid creating any conflicting logic in your processes.

About this task
To help you get started with building your first flow in Flow Designer, follow along with the steps below. The example flow that we'll build will start, or trigger, every time a user on the instance creates a request for a Service Catalog item. When a request is created, our flow will automatically run the following actions:
• Check if the catalog item's price is greater than $1,000.
• If the price is greater than $1,000, notify the requester's manager to approve the request.
• Otherwise, if the price is less than or equal to $1,000, automatically approve and close the request.

Procedure
1. Use the filter navigator to go to Process Automation > Flow Designer.
3. In the Flow properties window, fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flow name</td>
<td>Enter Approval flow for requested items</td>
</tr>
</tbody>
</table>

All other fields are optional, so simply click Submit to open your flow in the Flow Designer design environment.

4. Under the TRIGGER section, select Add a trigger.
5. In the trigger picker, either enter Service Catalog in the search field, or locate the Service Catalog trigger under the APPLICATION category. Then, select the Service Catalog trigger to add this trigger to your flow. Later, when we test this flow, we can simulate firing this trigger by creating a new Service Catalog Item Request record.

6. Click Done to finish adding the Service Catalog trigger to your flow.
7. Under the ACTIONS section, select Add an Action, Flow Logic, or Subflow. Then, select Flow Logic to open the flow logic picker.
8. In the flow logic picker, select If

9. Next to the Condition 1 input, click the pill picker icon (pill picker) to open the dot-walker.
   The dot-walker lets you access data from the trigger in your flow. Later, when you add actions to your flow, you can also use the dot-walker to access data from those actions. You can use the dot-walker to drill down into data that references other records in order to get the proper field placeholder value that you want to drop as a data pill in an action's input.
   10. Navigate, or dot-walk, to Trigger - Service Catalog > Requested Item Record > Price and select Price to add this data pill to the Condition 1 input.
11. In the condition builder's next field, choose greater than, and then enter 1000 in the final field. Now, you’ve successfully set up a condition that will check if the price of the catalog item that a user requests is greater than $1,000.

12. Click Done to finish adding the if flow logic to your flow.

13. Under your if flow logic condition, select Action.

14. In the action picker, either enter Ask For Approval in the search field, or locate the Ask For Approval action by selecting ServiceNow Core > Ask For Approval under the Default subcategory.

15. Add the following values for the Ask For Approval action's inputs:

<table>
<thead>
<tr>
<th>Input</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Click the pill picker icon ( ) to open the dot-walker. Then, navigate, or dot-walk, to Trigger - Service Catalog &gt; Requested Item Record and select Requested Item Record to add this data pill to the input.</td>
</tr>
<tr>
<td>Table</td>
<td>Leave as Requested Item [sc_req_item].</td>
</tr>
<tr>
<td>Approval Field</td>
<td>Leave as Approval.</td>
</tr>
<tr>
<td>Journal Field</td>
<td>Leave as Approval history.</td>
</tr>
<tr>
<td>Rules</td>
<td>Leave the first field as Approve. Under When, select Anyone approves from the list. Then, click the pill picker icon ( ) to open the dot-walker. Navigate, or dot-walk, to Trigger - Service Catalog &gt; Requested Item Record &gt; Opened by &gt; Manager and select Manager to add this data pill to the field.</td>
</tr>
<tr>
<td>Due Date</td>
<td>Leave as None.</td>
</tr>
</tbody>
</table>

Now, you’ve successfully set up a conditional action that will automatically ask for approval from the requester's manager for any catalog item they request that has a price greater than $1,000.
16. Click **Done** to finish adding the conditional Ask for Approval action within the *If* flow logic of your flow.

17. Select **Add an Action, Flow Logic, or Subflow**.
   Then, select **Flow Logic** and choose **Else** from the flow logic picker.

18. Under your **Else** flow logic, click the plus icon (➕) and then select **Action**.
   Finally, select the **Update Record** action from the action picker.

19. Add the following values for the Update Record action's inputs:

```
<table>
<thead>
<tr>
<th>Input</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Click the pill picker icon (🔍) to open the dot-walker. Then, navigate, or dot-walk, to Trigger - Service Catalog &gt; Requested Item Record and select Requested Item Record to add this data pill to the input.</td>
</tr>
<tr>
<td>Table</td>
<td>Leave as Requested Item [sc_req_item].</td>
</tr>
<tr>
<td>Fields</td>
<td>Select + Add field value. Then, select the Approval field and choose Approved as the field's value. Next, select the State field and choose Closed Complete as the field's value. Finally, select the Close notes field and enter Request automatically approved, as requested item's value is less than $1,000 for the field's value.</td>
</tr>
</tbody>
</table>
```

Now, you’ve successfully set up a conditional action that will automatically approve and close the catalog item request if the requested item’s price is less than or equal to $1,000.

20. Click **Done** to finish adding the conditional Update Record action within the Else flow logic of your flow.

21. In the main header, click **Save** to save the changes you’ve made to your flow.
   Your flow should look similar to the following example:
22. Next, in the main header, click Test to test your flow and see if it will trigger and run properly and without any errors.

23. In the Test Flow window, select any Requested Item Record from the list, or you can create a new one by selecting the Create new record icon ( ). Then, select Run Test.

24. Select Your test has finished running. View the flow execution details.

25. On the Execution Details page, you can see the values that populated for the trigger and each automated action in your flow. For more information, see Flow execution details.

26. Navigate back to your flow.

27. In the main header, click Activate so that your flow’s trigger fires whenever a user on your instance creates a new Service Catalog Item Request record.

What to do next
Your flow is now active and will run whenever it’s triggered. Next, you can manage your flow every time it runs by viewing your flow’s execution history. To view this history, open your flow in the Flow Designer design environment and click Executions in the main header. The resulting page shows you the state of completion for each flow execution as well as how long it took for each flow execution to run, or its runtime. To troubleshoot a flow execution for errors, select an execution from this list to open the Flow execution details.
Build a flow from a template in App Engine Studio

Step through an example of how to build, test, and activate a flow using a flow template in App Engine Studio.

**Before you begin**
Create an application in App Engine Studio. Once your application is built, you can use flow templates to create flows. For more information, see Building applications in App Engine Studio.

Role required: admin, flow_designer, or delegated_developer

**About this task**
To help you get started with building a flow from a flow template, follow along with the steps below. The example flow that we’ll build will start, or trigger, every time a user on the instance creates a request for a Service Catalog item. When a request is created, our flow will automatically run the following actions:

• Check if the catalog item’s price is greater than $1,000.
• If the price is greater than $1,000, notify the requester’s manager to approve the request.
• Otherwise, if the price is less than or equal to $1,000, automatically approve and close the request.

**Procedure**

1. Navigate to **App Engine Studio > App Engine Studio**.
2. From the My Apps page, open your application.
3. In your application, next to Automation, click the add icon (+).
4. From the gallery of automation templates, select **Create an approval for a requested catalog item**, then click **Begin**.
5. From the **Template catalog item** list, select the **Standard Laptop**.
6. In the **Ask for approval if the catalog item’s price is greater than** field, enter 1000, then click **Done**.
7. In the **Name** field, enter **Approval flow for requested items**.
8. In the **Description** field, enter **Approval flow for requested items**, then click **Continue**.
9. Once your flow is created, click **Edit this flow**.
10. On the flow page, click the **If not approved** step, then click **Delete** to remove the step.
11. At the bottom of the flow, click the Log step, then click Delete to remove the step.

12. In the same way, delete the last two log actions at the bottom of the flow.

13. Select Add an Action, Flow Logic, or Subflow. Then, select Flow Logic and choose Else from the flow logic picker.

14. Under your Else flow logic, click the plus icon (➕) and then select Action. Finally, select the Update Record action from the action picker.

15. Add the following values for the Update Record action’s inputs:

<table>
<thead>
<tr>
<th>Input</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Click the pill picker icon (➕) to open the dot-walker. Then, navigate, or dot-walk, to Trigger - Service Catalog &gt; Requested Item Record and select Requested Item Record to add this data pill to the input.</td>
</tr>
<tr>
<td>Table</td>
<td>Leave as Requested Item [sc_req_item].</td>
</tr>
<tr>
<td>Fields</td>
<td>Select + Add field value. Then, select the Approval field and choose Approved as the field’s value. Next, select the State field and choose Closed Complete as the field’s value. Finally, select the Close notes field and enter Request automatically approved, as requested item’s value is less than $1,000 for the field’s value.</td>
</tr>
</tbody>
</table>

Now, you’ve successfully set up a conditional action that will automatically approve and close the catalog item request if the requested item’s price is less than or equal to $1,000.

16. Click Done to finish adding the conditional Update Record action within the Else flow logic of your flow.

17. In the main header, click Save to save the changes you’ve made to your flow. Your flow should look similar to the following example:
18. Next, in the main header, click Test to test your flow and see if it will trigger and run properly and without any errors.

19. In the Test Flow window, select any Requested Item Record from the list, or you can create a new one by selecting the Create new record icon (➕). Then, select Run Test.

20. Select Your test has finished running. View the flow execution details.

21. On the Execution Details page, you can see the values that populated for the trigger and each automated action in your flow. For more information, see Flow execution details.

22. Navigate back to your flow.

23. In the main header, click Activate so that your flow’s trigger fires whenever a user on your instance creates a new Service Catalog Item Request record.

What to do next
Your flow is now active and will run whenever it’s triggered. Next, you can manage your flow every time it runs by viewing your flow’s execution history. To view this history, click Executions in the main header. The resulting page shows you the state of completion for each flow execution as well as how long it took for each flow execution to run, or its runtime. To troubleshoot a flow execution for errors, select an execution from this list to open the Flow execution details.
Use the Flow Designer help panel

Browse topics in the side help panel to learn more about building flows and actions, working with data and spokes, and stepping through guided tours in Flow Designer.

Before you begin
Role required: admin, flow_designer, or delegated_developer

Procedure

2. In the Flow Designer landing page's main header, select the question mark icon to open the help panel.
   You'll see help topics that you can select and browse for more information about building flows and actions, working with data, and setting up IntegrationHub spokes.

3. To close the help panel, select the question mark icon again.

4. Open any flow from the list of flows to go to the Flow Designer design environment.

5. Next to the name for any action in the flow, select the Open help panel icon.
   The help panel opens with information about the action and how to use the action's inputs and outputs in your flow. If no help content is available for your selected action, then the panel displays No help content found for: and the action's name.

6. You can also access guided tours from the help panel by selecting the question mark icon while in the Flow Designer design environment.
   After opening the help panel, locate a help card beginning with Tour: and select that card to start the tour.

Results
The help panel opens with help content about flows, actions, spokes, and guided tours.
Architecture Overview

Understand how Flow Designer works within the Now Platform to activate, trigger, and process flows and actions.

A flow consists of a trigger and one or more actions. The trigger specifies when to start the flow, which can be record-based, schedule-based, or application-based. Record-based triggers run a flow after a record has been created, updated, or deleted. The flow can use the triggering record as input for actions. Schedule-based triggers run a flow at the specified date and time. The flow can use the execution time as input for actions. Application triggers are added when the associated application is activated. For example, the MetricBase trigger is present when the MetricBase application is active.

Flow processing
Flow processing occurs in this sequence.

1. When the flow trigger conditions occur or an API directly calls the flow, the system creates an entry in the event queue to start the flow.
2. The scheduler processes the event and starts the flow in the background.
3. The system builds a process plan from the flow.

4. The system runs the process plan using the record that triggered the flow.

5. The system stores the execution details in a context record.

1. **Process flow triggers and API calls**

   Each time trigger conditions are met or an API directly calls a flow, Flow Designer creates an event entry. The system processes triggers after database operations. To learn more, see . Typically, business rules and workflows that run synchronously run before a triggered flow.

2. **Process events in the queue**

   Each flow event contains a reference to the flow to start and a reference to either the triggering record or the execution time. The system processes these events using Standard event processing where a scheduler periodically works through the current items in the event queue in the order in which they were added. Depending on what other events are in the queue, the system may not immediately start a flow. Flow designers should expect some lag time between when the trigger conditions occur and when the flow actually starts.

3. **Build the process plan**

   When Flow Designer pulls an event from the queue, it builds a process plan to actually run the flow. A process plan contains all the information necessary to execute a flow such as the sequence of published actions or subflows, the input values for each subflow or action, the action steps to run for each action, and the data provided by the trigger or subflow output.

   Flow Designer uses a just-in-time compilation scheme to ensure that process plans contain the latest changes to flows, subflows, and actions. If no changes are detected, Flow Designer uses a cached copy of the process plan. Otherwise, it builds a new process plan.

   By automatically checking for updated flows, subflows, and actions with process plans, Flow Designer enables you to apply changes from update sets and upgrades without having to edit current flows.
If you move published actions to a target instance, every flow that uses the published action will automatically update the next time it is executed.

⚠️ **Warning:** If changing subflows or actions used in activated flows, do not change the inputs and outputs used in the subflow or action. Changing inputs and outputs may cause errors when the activated flow is next triggered because it has not been configured to use the new inputs and outputs. Any currently running flows are unaffected by changes to inputs or outputs as the flow uses the compiled subflows and actions from the process plan.

4. **Run the process plan**

Flow Designer runs the process plan as the **System** user within the flow application scope.

When running a flow with a record-based trigger, Flow Designer stores the triggering record in memory as an instance that is represented in the interface as a data pill.

The instance contains the record values from when the flow started, which may be different than the current record stored in the database. For example, suppose that creating an incident record triggers a flow. Any changes a user makes to the incident record after the flow has started do not update the triggering record unless an action specifically looks up the current record value.

5. **Store flow execution details**

Flow Designer stores flow execution details in a **flow context record**, which contains this information.

- Flow outcome state
- Flow runtime duration
- Flow log messages
- Flow configuration and runtime values

Each time a flow runs, Flow Designer adds an entry to the **Flow Executions** list. Each entry has its own context record and matching execution details page.
**Note:** A flow execution context runs in a single thread. However, there may be times when you want to run flows within separate contexts even though this may consume more of your instance’s resources. To run subflows in separate flow contexts within the same flow, see [Dynamic flows](#).

A flow can have one of these outcome states.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete</td>
<td>The flow completed successfully.</td>
</tr>
<tr>
<td>In Progress</td>
<td>The flow is running. By default, a transaction quota rule prevents flows from running longer than an hour.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The flow is waiting for another event to occur. For example, a user must update a task or approval, or a record must reach a specific state. When in the waiting state, the flow is quiesced and serialized into a context record.</td>
</tr>
<tr>
<td>Canceled</td>
<td>The flow was canceled by a user.</td>
</tr>
<tr>
<td>Error</td>
<td>The flow encountered an error and has stopped running. For example, an action is missing an input value, or a quota transaction rule has stopped the flow.</td>
</tr>
</tbody>
</table>

**Flow, subflow, and action life cycle**

Flow Designer uses the flow or action status to describe the current state of configuration changes.

**Flow and subflow status and activation state**

The **Status** field indicates whether there is a process plan associated with the flow or subflow.

<table>
<thead>
<tr>
<th>Flow status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modified</td>
<td>Indicates that there are unsaved changes to a flow or subflow. Modified flows or subflows have not been saved.</td>
</tr>
<tr>
<td>Draft</td>
<td>Indicates that there are saved changes to a flow or subflow, which have not been stored in a</td>
</tr>
</tbody>
</table>
### Flow Status

<table>
<thead>
<tr>
<th>Flow status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>process plan. Draft flows have been saved but not activated. Draft subflows have been saved but not published.</td>
<td></td>
</tr>
</tbody>
</table>

| Published | Indicates that there is a stored process plan for the flow or subflow. Published flows have either been activated or deactivated. |

The **Active** field indicates whether the system runs a flow or subflow.

<table>
<thead>
<tr>
<th>Active</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>True</td>
<td>Indicates that the flow or subflow is active and runs when triggered or called. The flow has been activated or the subflow has been published. Active flows run when the trigger conditions are met or when called. Active subflows run when called.</td>
</tr>
</tbody>
</table>

| False | Indicates that the flow is inactive and does not run when triggered or called. An inactive flow has either never been activated or has been deactivated. An inactive subflow has never been published. |

When working with flows, you can:

- **Save** a flow: Creates a draft of the flow.
- **Activate** a flow: Enables the flow trigger and transform the flow into a process plan.
- **Deactivate** a flow: Disables the flow trigger and prevents new flow executions. Currently running flows continue to run.

When working with subflows, you can:

- **Save** a subflow: Creates a draft of the subflow. If the subflow is modified after being published, the subflow moves into a draft state. Any active flows that use the subflow only run the published subflow.
- **Publish** a subflow: Enables you to activate a flow containing the subflow. Publishing adds the subflow to the list of available subflows in a flow.
Action status

The Action Designer interface does not display the configuration status of actions. To view action status, navigate to the Action Types table [sys_hub_action_type_definition] and display the Draft state field.

<table>
<thead>
<tr>
<th>Action Draft status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>Indicates that there are changes to an action that have not been published. Draft actions are only available to flows when the Show draft actions option is enabled. You cannot activate a flow containing draft actions.</td>
</tr>
<tr>
<td>Published</td>
<td>Indicates that the action has been published. Published actions are available to all flows and allow flows to be activated.</td>
</tr>
</tbody>
</table>

When working with actions, you can:

- **Save** an action: Creates a draft of the action that is only available to flows when Show draft actions is enabled. If the action is modified after being published, the action moves into a draft state. Any active flows that use the action only run the published action.

- **Publish** an action: Enables you to activate a flow containing the action. Publishing adds the action to the list of available actions in a flow. Only actions in a published state run during flow execution.
Application development

When designing an action or a flow, use these design considerations as a guide.

Use standard Now Platform application development capabilities to create, manage, protect, and deploy Flow Designer content. Flow and action designers typically perform these application development tasks.

- Create a custom application to store flows and actions.
- Set application permissions to share or restrict access to application data.
- Grant application developers access to Flow Designer.
- Publish custom applications to the application repository to deploy flows and actions on other instances.

Security

Control access to Flow Designer processes and records.

- Administrators can grant users access to Flow Designer by creating an application and assigning users as developers with the Flow Designer delegated development permission. Delegated development allows administrators to control whether flow designers can access features normally restricted to admin users such as assigning user roles, creating access controls, or creating scripts. For more information, see Developer permissions.

- Administrators can grant access to Flow Designer by directly assigning users the flow_designer user role, which includes the role to view flow execution details.

⚠️ Warning: Directly granting a user the flow_designer role is equivalent to giving the user the admin role, because Flow Designer can run flows as the System user, which has access to all tables and all database operations.

- Flow and action designers can use standard to manage how their content interacts with other applications.
**Action limit**

By default, flows can have no more than 50 actions. To change the default behavior, increase the value of the `sn_flow_designer.max_actions` system property. However, consider the performance impact that a large flow may have on your instance.

**Trigger options for record updates**

Flow designers can specify how often a flow can update a particular record with the **Run Trigger** option. Use the **Once** option when you want a flow to run only once. The first time a record is updated, the flow runs, but any further record updates do not trigger the flow. Use the **Always** option when you want the flow to run every time a record is updated and there is not already an active flow running for it. For example, you might set a flow that assigns an incident record to run only once, and set a flow that notifies the incident watch list to always run. The **Run Trigger** field is only available for these trigger types.

- Created or Updated
- Updated

**Direct recursion prevention and indirect recursion limit**

To prevent instance outages and consumption of system resources, Flow Designer ignores any request to start a flow or subflow that is the result of direct recursion. Direct recursion occurs under these conditions.

- An action calls the same flow that it is part of. For example, a script step makes an API call to a flow.

- An action or subflow produces a result matching the flow trigger. For example, a flow that runs when an incident record is updated contains an update record action that updates an incident record.

Flow Designer also limits the number of times a flow can be started from indirect recursion. Indirect recursion occurs under these conditions.

- The same flow is called multiple times in a chain of subflow calls. For example, if subflow A calls subflow B, and subflow B calls subflow A, then calling either subflow produces indirect recursion.

- The same flow is triggered multiple times in a chain of subflows. For example, suppose that there are two flows triggered by record creation. Suppose that creating record A triggers flow A and also creates record B. Furthermore, creating record B triggers flow B and creates record A. Creating either record type produces indirect recursion.

By default, the system stops triggering flow runs after the run count reaches the indirect recursion limit of three runs. Administrators can change the limit by
setting the system property `com.glide.hub.flow_engine.indirect_recursion_limit` to an integer value equal to or greater than one. The system ignores any property value less than one and instead uses a limit of one. Consider the performance impact that increasing the indirect recursion limit may have on your instance.

⚠️ **Note:** By default, a transaction quota rule prevents flows from running longer than an hour.

**Flow and action testing**

Testing a flow bypasses the trigger conditions and immediately runs it. Testing a flow with a record-based trigger requires selecting a specific record to act as the trigger. Flow designers should generate appropriate sample records prior to testing.

During the design phase, you can test an inactive flow and unpublished actions by setting **Show draft actions** on the flow. If testing with draft actions, use these guidelines.

- Design flows and actions on a non-production instance. Only deploy active, working flows to your production instance.
- Leave **Show draft actions** set to true until your draft is in a final state. Once final, publish each action, set **Show draft actions** to false, and activate the flow.

⚠️ **Warning:** Disabling **Show draft actions** before publishing your actions removes all draft actions from your flow.

- Any change you make to an active flow or published action causes it to return to a draft state. If the flow is triggered, the system only runs the activated flow and published actions, and the flow execution details only display what was run. When there is a draft of an active flow, the trigger and actions listed in the flow execution details may be different than those listed in the draft flow.

**Flow Designer data**

Each time you add an action to a flow, Flow Designer adds a data pill to store its results. The data pill name indicates its sequence in the flow and its data type.

Flow designers use action result data pills to provide input for other flows, actions, or subflows. Flow designers can use the sequence value in the data pill name to ensure that they select the correct data pill as an input value. When a flow runs an action, it generates the data pill runtime value, which remains the same for the duration of the flow. For example, if a data pill for `[Trigger->Incident`
record] gets populated with incident record values at the start of a flow, the data pill preserves these values for the rest of the flow.

Data pill population
Flow Designer populates data pill values as soon as the data becomes available regardless of where the data pill is located in the flow sequence. For example, suppose that you have a flow triggered by the creation of an incident record with the following actions.

1. Update [Incident] Record that adds a text string to [Trigger->Incident Record->Short description].
2. Log the value of [Trigger->Incident Record->Short description].
3. Log the value of [1->Incident Record->Short description].

Action-1 and Action-2 both use the data pill [Trigger->Incident Record->Short description]. Since the trigger record is available as soon as the flow starts, these values are set before running these actions.

Delayed data pill population
When an action, flow logic, or step includes more than one data pill in the same input, the system delays running it until all data pill values have been populated. This delay might produce unexpected values or prevent flow logic from running at all.

For example, this flow produces unexpected values.

1. Update [Incident] Record that adds a text string to [Trigger->Incident Record->Short description].
2. Log the value of [Trigger->Incident Record->Short description].
3. Log the value of [1->Incident Record->Short description].
4. Log the value of [Trigger->Incident Record->Short description] and [1->Incident Record->Short description].

This flow produces the unexpected result of both data pills in Action-4 evaluating to the same value.

Data security and HTML sanitization
Flow Designer protects against cross-site scripting and code injection by evaluating all string data for HTML markup. The system only preserves HTML markup that is present in its inclusion list. All other HTML markup is removed from string data.
The inclusion list supports these HTML elements and attributes, which cannot be modified.

**HTML inclusion list**

<table>
<thead>
<tr>
<th>HTML element</th>
<th>Included Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>class, href, target, title</td>
</tr>
<tr>
<td>abbr</td>
<td>class, title</td>
</tr>
<tr>
<td>address</td>
<td>class</td>
</tr>
<tr>
<td>area</td>
<td>alt, class, coords, href, shape</td>
</tr>
<tr>
<td>article</td>
<td>class</td>
</tr>
<tr>
<td>aside</td>
<td>class</td>
</tr>
<tr>
<td>audio</td>
<td>autoplay, class, controls, loop, preload, src</td>
</tr>
<tr>
<td>b</td>
<td>class</td>
</tr>
<tr>
<td>bdi</td>
<td>class, dir</td>
</tr>
<tr>
<td>bdo</td>
<td>class, dir</td>
</tr>
<tr>
<td>big</td>
<td>class</td>
</tr>
<tr>
<td>blockquote</td>
<td>cite, class</td>
</tr>
<tr>
<td>br</td>
<td>class</td>
</tr>
<tr>
<td>caption</td>
<td>class</td>
</tr>
<tr>
<td>center</td>
<td>class</td>
</tr>
<tr>
<td>cite</td>
<td>class</td>
</tr>
<tr>
<td>code</td>
<td>class</td>
</tr>
<tr>
<td>col</td>
<td>align, class, span, valign, width</td>
</tr>
<tr>
<td>colgroup</td>
<td>align, class, span, valign, width</td>
</tr>
<tr>
<td>dd</td>
<td>class</td>
</tr>
<tr>
<td>del</td>
<td>class, datetime</td>
</tr>
<tr>
<td>details</td>
<td>class, open</td>
</tr>
<tr>
<td>div</td>
<td>class</td>
</tr>
<tr>
<td>dl</td>
<td>class</td>
</tr>
<tr>
<td>HTML element</td>
<td>Included Attributes</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>dt</td>
<td>class</td>
</tr>
<tr>
<td>em</td>
<td>class</td>
</tr>
<tr>
<td>emp</td>
<td>class</td>
</tr>
<tr>
<td>font</td>
<td>class, color, face, size</td>
</tr>
<tr>
<td>footer</td>
<td>class</td>
</tr>
<tr>
<td>h1</td>
<td>class</td>
</tr>
<tr>
<td>h2</td>
<td>class</td>
</tr>
<tr>
<td>h3</td>
<td>class</td>
</tr>
<tr>
<td>h4</td>
<td>class</td>
</tr>
<tr>
<td>h5</td>
<td>class</td>
</tr>
<tr>
<td>h6</td>
<td>class</td>
</tr>
<tr>
<td>header</td>
<td>class</td>
</tr>
<tr>
<td>hr</td>
<td>class</td>
</tr>
<tr>
<td>html</td>
<td></td>
</tr>
<tr>
<td>i</td>
<td>class</td>
</tr>
<tr>
<td>img</td>
<td>alt, class, height, src, title, width</td>
</tr>
<tr>
<td>input</td>
<td>aria-label, class, type, value</td>
</tr>
<tr>
<td>ins</td>
<td>class, datetime</td>
</tr>
<tr>
<td>li</td>
<td>class</td>
</tr>
<tr>
<td>mark</td>
<td>class</td>
</tr>
<tr>
<td>nav</td>
<td>class</td>
</tr>
<tr>
<td>ol</td>
<td>class</td>
</tr>
<tr>
<td>p</td>
<td>class</td>
</tr>
<tr>
<td>pre</td>
<td>class</td>
</tr>
<tr>
<td>s</td>
<td>class</td>
</tr>
<tr>
<td>section</td>
<td>class</td>
</tr>
</tbody>
</table>
### HTML inclusion list (continued)

<table>
<thead>
<tr>
<th>HTML element</th>
<th>Included Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>small</td>
<td>class</td>
</tr>
<tr>
<td>span</td>
<td>class</td>
</tr>
<tr>
<td>sub</td>
<td>class</td>
</tr>
<tr>
<td>sup</td>
<td>class</td>
</tr>
<tr>
<td>svg</td>
<td>class</td>
</tr>
<tr>
<td>strong</td>
<td>class</td>
</tr>
<tr>
<td>style</td>
<td></td>
</tr>
<tr>
<td>table</td>
<td>align, border, class, valign, width</td>
</tr>
<tr>
<td>tag</td>
<td>class</td>
</tr>
<tr>
<td>tbody</td>
<td>align, class, valign</td>
</tr>
<tr>
<td>td</td>
<td>align, class, colspan, rowspan, valign, width</td>
</tr>
<tr>
<td>tfoot</td>
<td>align, class, valign</td>
</tr>
<tr>
<td>th</td>
<td>align, class, colspan, rowspan, valign, width</td>
</tr>
<tr>
<td>thead</td>
<td>align, class, valign</td>
</tr>
<tr>
<td>tr</td>
<td>align, class, rowspan, valign</td>
</tr>
<tr>
<td>tt</td>
<td>class</td>
</tr>
<tr>
<td>u</td>
<td>class</td>
</tr>
<tr>
<td>ul</td>
<td>class</td>
</tr>
<tr>
<td>video</td>
<td>autoplay, class, controls, height, loop, preload, src, width</td>
</tr>
</tbody>
</table>

### Flow administration modules

Identify and troubleshoot potential issues by reviewing action and flow executions, their result state, and their runtime duration.

Flow Designer provides administrators and flow operators these modules to manage flows.

**Today’s Executions**

Displays a list of flow context records for flows run today. Use this information to identify flows run today.
Active flows
Displays a list of flow context records for running flows where the State is Waiting. Use this information to identify flows that are waiting for a trigger or condition to continue.

Event Queue
Displays a filtered list of event records where the Queue is flow_engine and the State is Ready. Use this information to identify flows that are waiting on event processing.

Operations Dashboard
Displays a responsive dashboard containing a count of flows run and the average flow runtime. View statistics for today or over the last 30 days. Use this information to determine the health and performance of flow execution.

Settings
Displays the list of Flow and Action Settings records. Use this table to identify which actions and flows have had reporting disabled. Create records on this table to control whether reporting is done on an action or flow.

Properties
Displays the system properties used to configure how the system processes flows.

Complex Object Templates
Displays templates for complex objects that you can use in flows with IntegrationHub integrations. To learn more about creating and using complex object templates, see create an action and the Object data type.

Usage Overview
Displays transaction counts between your instance and third-party systems. The Usage Overview is not available in the base system and requires the ServiceNow® IntegrationHub subscription.

Flow Designer landing page
Access or create actions, flows, subflows, or their execution details.

Flows
The Flows screen contains all the flows that your installation of Flow Designer can use. Selecting a flow opens the flow in a new tab. You can see the scope the flow was created in, the internal name of
the flow, whether the flow is published or in draft status, whether the flow is active, and update information.

**Subflows**

The Subflows screen contains all the subflows that your installation of Flow Designer can use. Selecting a subflow opens the subflow in a new tab. You can see the scope the subflow was created in, the internal name of the subflow, whether the subflow is published or in draft status, whether the subflow is active, and update information.

**Actions**

The Actions screen contains all the actions that your installation of Flow Designer can use. Selecting an action opens the action in a new tab. You can see the scope the action was created in, where the action is accessible from, whether the action is active, and update information.

**Executions**

The Executions screen shows a history of actions and flows run, including the current state and duration of each run.

**Connections**

Manage your connections and credentials for IntegrationHub spokes.

**Help**

The Help landing page contains links to Flow Designer documentation, videos, and Community forum discussions.

**New**

You can create a new flow, subflow, or action by selecting an option from the list.

**Help panel**

You can click the question mark icon (❓) to open the Flow Designer help panel and browse topics and guided tours that can help you get started building flows and actions. For more information, see Use the Flow Designer help panel.
Flow Designer system properties

Configure how the system processes flows.

These properties are available for Flow Designer.

To set Flow Designer system properties, click Process Automation > Properties or navigate to the System Properties [sys_properties] table.

Properties for Flow Designer

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The maximum number of records to return when fetching data</td>
<td>Specify the maximum number of records a look up action or step can return. Flow Designer ignores records that exceed this limit.</td>
</tr>
<tr>
<td>sn_flow_designer.action_picker_limit</td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 1000</td>
</tr>
</tbody>
</table>
### Properties for Flow Designer (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Location:** Process Automation > Properties  
**Learn more:** Architecture Overview  
**Set to True to show duration in the stage column**  
com.glide.hub.flow_engine.stage_display.show_duration |
| Specify whether flows with stages display a duration.  
**Type:** true | false  
**Default value:** true |
| **Location:** Process Automation > Properties  
**Learn more:** Flow Designer stages  
**Allow the option for select users to write a script to populate the value of an input on Flow and Action Designers.**  
sn_flow_designer.input_scripts_enabled |
| Specify whether users can write inline scripts to compute input values.  
**Type:** true | false  
**Default value:** true |
| **Location:** Process Automation > Properties  
**Learn more:** Inline scripts  
**Specify the log level of system log entries to replicate to the flow log. The system only replicates log entries of the specified level or higher.**  
com.glide.hub.flow_engine.listener_trace.threshold |
| Specify the threshold required for Flow Designer to replicate a system log entry to the flow log. Flow Designer only replicates system log entry at the given level or higher. Options include: |

---

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
## Properties for Flow Designer (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• DEBUG</td>
<td>• INFO</td>
</tr>
<tr>
<td>• WARN</td>
<td>• ERROR</td>
</tr>
<tr>
<td>• NONE: Disables the replication of system log entries to the flow log.</td>
<td></td>
</tr>
<tr>
<td>• Type: choice</td>
<td>• Default value: ERROR</td>
</tr>
</tbody>
</table>

### Maximum iterations per loop

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_flow_designer.max_iterations</td>
<td>The maximum amount of iterations that a loop will run in Flow Designer. A loop will error out if it iterates beyond this value, preventing infinite loops.</td>
</tr>
<tr>
<td>• Type: integer</td>
<td>• Default value: 1000</td>
</tr>
<tr>
<td>• Location: Process Automation &gt; Properties</td>
<td>• Learn more: Architecture Overview</td>
</tr>
</tbody>
</table>

**Note:** Changing this value will not effect flows that are already in progress.
### Properties for Flow Designer (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Enable flow engine debug messages in the system log**<br>com.glide.hub.flow_engine.debug | Enable or disable logging Flow Designer debug messages in the system log. All debug messages start with a `Flow Designer: string` prefix.  
- **Type:** true | false  
- **Default value:** false  
- **Location:** Process Automation > Properties  
- **Learn more:** Architecture Overview |
| **Number of times that a flow or subflow can be indirectly triggered during a transaction**<br>com.glide.hub.flow_engine.indirect_recursion_limit | Specify the maximum number of times a flow or subflow permits indirect recursion. Flow Designer ignores all further calls or trigger condition matches from indirect recursion after the limit has been reached. Set the value to any integer equal to or greater than one. The system ignores any property value less than one and instead uses a limit of one. Set the value to one to prevent all indirect recursion.  
- **Type:** integer  
- **Default value:** 3 |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Maximum actions per flow**<br>sn_flow_designer.max_actions | Specify the maximum number of actions a flow or subflow can contain. Flow Designer prevents you from adding further actions after the maximum number of actions has been reached. Consider the performance impact raising the maximum number of actions may have. For example, running more actions may conflict with the default transaction quota rule that prevents flows from running longer than an hour.  
  • Type: integer  
  • Default value: 50  
  • Location: Process Automation > Properties  
  • Learn more: Architecture Overview |
| **Maximum steps per action.**<br>sn_flow_designer.max_action_steps | Specify the maximum number of steps that an action can contain. Flow Designer prevents you from adding further steps after the maximum number of steps has been reached.  
  • Type: integer  
  • Default value: 50  
  • Location: Process Automation > Properties  
  • Learn more: Architecture Overview |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>number of steps has been reached. Consider the performance impact raising the maximum number of steps may have. For example, running more steps may conflict with the default transaction quota rule that prevents flows from running longer than an hour.</td>
<td></td>
</tr>
<tr>
<td>• Type: integer</td>
<td></td>
</tr>
<tr>
<td>• Default value: 20</td>
<td></td>
</tr>
<tr>
<td>• Location: Process Automation &gt; Properties</td>
<td></td>
</tr>
<tr>
<td>• Learn more: Architecture Overview</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Level of reporting data generated by the flow engine com.snc.process_flow.reporting.level</th>
<th>Specify when Flow Designer generates execution details and what information the details include. Options include:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Reporting is deactivated. The system generates execution details only when you test a flow.</td>
<td></td>
</tr>
<tr>
<td>Flows Only</td>
<td></td>
</tr>
</tbody>
</table>
### Properties for Flow Designer (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporting is activated</td>
<td>Reporting is activated for all flows and subflows.</td>
</tr>
<tr>
<td>Flows and Actions</td>
<td>Reporting is activated for all flows, subflows, and actions.</td>
</tr>
<tr>
<td>Flows Actions and Steps</td>
<td>Reporting is activated for all flows, subflows, actions, and custom action steps.</td>
</tr>
<tr>
<td>Developer Trace</td>
<td>Reporting is activated for all flows, subflows, actions, and steps (custom and base system).</td>
</tr>
</tbody>
</table>

The reporting level determines what if any information is saved in the flow execution details. If a flow runs while reporting is off, execution details are never available for the
Properties for Flow Designer (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>flow, even if the reporting level changes. If a flow runs while reporting is activated, execution details are always available for that flow execution, even if the reporting level changes. The reporting level has no effect on context and log records.</td>
</tr>
</tbody>
</table>

**Note:** Testing an action or flow generates execution details at the Developer Trace level.

- Type: choice
- Default value: Off
- Location: Process Automation > Properties

Truncate runtime values in the flow execution details step configuration com.snc.process_flow.reporting.serialized.val_size_limit

Specify the number of bytes allowed for runtime values in each step in the flow execution details. To prevent truncation, set the value to an integer equal to or less than zero.

- Type: integer
- Default value: 16384
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Maximum inputs per action</strong></td>
<td>Specify the maximum number of inputs that can be added to an action. Flow Designer prevents you from adding further inputs after the maximum number of inputs has been reached. Consider the performance impact raising the maximum number of action inputs may have. For example, processing more action inputs may risk the action running for more than an hour and being stopped by the default transaction quota rule.</td>
</tr>
</tbody>
</table>
| sn_flow_designer.max_action_vars | • Type: integer  
• Default value: 20  
• Location: System Properties [sys_properties] table |

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Maximum script variables per Script step</strong></td>
<td>Specify the maximum number of input and output variables that can be added to a Script step. Flow Designer prevents you from adding further script variables after the execution finishes.</td>
</tr>
<tr>
<td>sn_flow_designer.max_script_variables</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **Maximum number of branches allowed for the Make a decision flow logic**<br>sn_flow_designer.max_decision_branches | Specify the maximum number of branches to use when the **Use Branches** option is selected for the Make a decision flow logic.  
- **Type:** integer  
- **Default value:** 100  
- **Location:** System Properties [sys_properties] table |
| **Number of recent iterations to report for Do Until and For Each loops**<br>com.snc.process_flow.reporting.iteration.lastn | Specify the number of recent iterations to report upon in the flow execution details. Use this property to sample a recent portion of flow |
Properties for Flow Designer (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logic iterations. Use a positive value to specify the number of recent iterations to display. Use the value of -1 to display all iterations. The system treats the value 0 as a value of 1.</td>
<td>Type: integer</td>
</tr>
<tr>
<td></td>
<td>Default value: 50</td>
</tr>
<tr>
<td></td>
<td>Location: System Properties [sys_properties] table</td>
</tr>
</tbody>
</table>

Option to enable users to create flow variables. Specify whether users can create custom variables for their flow. | Type: true | false |
| | Default value: true |
| | Location: System Properties [sys_properties] table |

Flows

Automate processes with a sequence of reusable actions such as manage records, ask for approvals, create tasks, and send notifications. Define trigger conditions to start a flow and variables to pass information between actions.

Flows consist of a trigger and a sequence of actions. When you add actions to a flow, the data collected or created appears in the data panel, which you can use in other actions.

Triggers

The trigger specifies the conditions that start running the flow. When the trigger conditions are met, the system starts running the flow.

Flow Designer supports record-based, schedule-based, and application-based trigger types. For more information, see Flow trigger types.
Actions

Within Actions, flow designers can add actions, flow logic, and subflows to a flow.

Actions are reusable elements that perform specific operations. Add an action to a flow by opening the action picker. After you add an action, there are a set of inputs that you must configure in order for the action to run when your flow triggers. Enter values for inputs directly, or use data from the Data panel to configure an action’s inputs. At the start of a flow, the data may be limited to the flow trigger or subflow inputs. As you add actions to a flow, the output values of each action appear as data pills in the Data panel.

Action picker

In the ACTION section of a flow, select Add an Action, Flow Logic, or Subflow > Action to open the action picker. You can either enter text in the search window to search for an action, or browse the action categories to find an action that you want to add to your flow.

Action numbering

Sequential numbers appear next to each flow action in the Flow Designer interface. Flow action numbers start with 1 and then increment by 1 as you add more flow actions to your flow.
Note: If you upgraded from a prior release, your inline scripts may still contain references to legacy flow action numbering. See Flow action numbering to automatically update these references for your flow.

Core actions

Your instance comes with a collection of core actions, or frequently used Now Platform operations, that can be added to any flow.

Spoke actions

Some applications include spokes which add application-specific actions. Spoke actions are typically read-only but can be copied and customized.

Custom actions

Developers may also create their custom actions from the Action Designer interface.

Data panel

Flows store any data gathered or generated as variables in the data panel. Each variable has its own pill that Flow designers can use to drag the variable value to an action input or output. Flow Designer generates the pill name based on the contents and its data type. The system specifies the variable data type next to the pill.
Testing flows

You can test a flow directly from the Flow Designer interface. Each test runs your flow as if the trigger conditions were met. If the flow has record trigger, you can specify the record to use for your test. After the flow runs, use the flow execution details to verify that your flow is running properly.

**Important:** Always run tests on a non-production instance where flow record changes cannot interfere with your production data.

Flow execution details

Each time you test a flow, the system generates flow execution records, log messages, and reports. The flow context is a related record containing the current state and runtime values of the flow. The system generates a context record each time a flow is run.
Optionally, you can configure the system to generate execution details anytime a flow is run, not just during testing. For more information, see Activate flow reporting.

**Flow properties**

The flow properties contain information about your flow. In the main header, select **Properties** to view or edit your flow’s properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the flow</td>
</tr>
<tr>
<td>Protection</td>
<td>Choose whether the flow is read only by choosing from <strong>None</strong> or <strong>Read-only</strong></td>
</tr>
<tr>
<td>Application</td>
<td>Select an application for the flow. This property is set when creating the flow and cannot be changed afterwards.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the flow.</td>
</tr>
<tr>
<td>Run As</td>
<td>Use this option to specify if the flow runs as system user or the user who initiates the session. Select the user who initiates the session option when updates should come from the user who triggered the flow. For example, when you want incident record comments to come from the current user, or approval emails to originate from the approver. Settings for the Run as option in a flow don’t apply to child subflows.</td>
</tr>
<tr>
<td>Run with role(s)</td>
<td>Select the roles the flow runs with. This option is only available when Run as is set to <strong>user who initiates the session</strong>.</td>
</tr>
</tbody>
</table>

**Printing flows**

Flow Designer supports multipage printing for flows, subflows, actions, and flow execution details. For a list of supported browsers, see **Browser support**.

**Roles**

To access Flows, a user must have the flow_designer or admin roles.
**Design considerations**

**Create flows when you require the trigger data as a flow input**

Since flows always run whenever their trigger conditions are met, make sure that your flow needs a trigger. Triggered flows always provide the same trigger data as a flow input. If you need variable flow input data, create a subflow instead.

**Create subflows when you want to reuse business logic**

A subflow allows you to configure its input values differently each time you call it. For example, design a subflow to accept different record types as an input. Reuse this generic record subflow instead of writing a specific flow for each record type.

**Grant flow roles to access role-protected data and preserve user information**

Instead of running a flow as the system user, use flow roles to preserve user information and grant access to data. Adding flow roles allows a user-initiated flow access to data it would not otherwise have. The roles granted only apply to the flow. They do not apply to the user who initiated the flow.

**Use flow logic or a schedule-based trigger to control flow timing**

To pause a flow for a specific duration, use **Wait for a duration flow logic**. To run a flow at a specific time, use a schedule-based trigger. Avoid using the `gs.sleep()` method to wait within a flow.

**More Actions**

Click the **More Actions** icon to access additional options for your flow.

**Stages**

Access the stages for a flow.

**Manage flow catalog variables**

Manage the catalog variables available to Service Catalog-triggered-flows.

**Flow Variables**

Create flow variables to set and retrieve data throughout a flow.

**Copy flow**

Create a copy of the open flow in an application you specify.

**Flow preferences**
Enable or disable the **Show draft actions**, **Show triggered flows**, **Show store spokes**, and **Show inline script toggle** options.

### Create code snippet
Generate a code snippet to call a specific flow, subflow, or action.

### Manage security
Enable or disable the **Callable by Client API** option.

### Change default flow title
Change the default title for your flow by adding styled or dynamic text. For more information, see [Create a natural language title](#).

---

## Create a flow
Automate a process to run one or more actions when a trigger condition occurs.

### Before you begin
- Set up an application in Guided Application Creator to store Flow Designer content.
- Role required: flow_designer or admin

### About this task
Users with the flow_designer or admin role should know the application table structure and be aware of any existing business logic associated with the target tables of a flow or subflow. Be sure to disable any conflicting business rules or workflows before creating a flow or subflow.

Creating a custom application to contain your Flow Designer content enables you to deploy the application using the application repository or the ServiceNow Store.

Demonstrates how to create a flow in the Flow Designer.

### Procedure
1. Navigate to **Process Automation > Flow Designer**.
2. Click **New > Flow**.

### Field | Description
--- | ---
Name | Name to uniquely identify your flow. The system computes the internal name of the flow from the name.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Application scope to create your flow in. Global is the default.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of your flow.</td>
</tr>
<tr>
<td>Protection</td>
<td>Selection to specify if the flow is read-only. You can only select a value when you create the flow in an application scope that you own.</td>
</tr>
<tr>
<td>Run as</td>
<td>Use this option to specify if the flow runs as system user or the user who initiates the session. Select the user who initiates the session option when updates should come from the user who triggered the flow. For example, when you want incident record comments to come from the current user, or approval emails to originate from the approver. Settings for the Run as option in a flow don’t apply to child subflows. When flows run as the user who initiates the session, the system limits flow actions by user ACL restrictions. Ensure that security restrictions don’t prevent users who trigger the flow from performing flow actions. Flows run by the initiating user also respect user-specific settings such as date/time formats. <strong>Note:</strong> Inbound email flows ignore this setting and always run as the user who initiates the session. To test access controls for an inbound email flow, impersonate a typical inbound email user and manually trigger the flow.</td>
</tr>
<tr>
<td>Run with roles</td>
<td>Select the roles the flow runs with. This option is only available when Run as is set to user who initiates the session.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Note:** If this is your first time in Flow Designer, a welcome screen appears. You can choose to either take the welcome tour or skip the tour for now.

The system displays the Flow Designer design environment.

5. Add a trigger to your flow.

a. From the Trigger list, select a trigger that will start running your flow. For more information on trigger types, see **Flow trigger types.**
The system displays a set of fields depending on the type of trigger that you’ve selected.

b. Set up your trigger by filling in the fields.
   For a record-based trigger, for example, select a table and optionally set field conditions that, when met, will start running your flow.

c. Click Done.

6. To add actions, flows, subflows, or flow logic, click Select to add an Action, Flow Logic, or Subflow.

a. Select an option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Select the desired action. Flow Designer includes a set of Actions available to flows and subflows. Alternatively, a user with the action_designer role can create additional actions to add to flows. The IntegrationHub and spoke plugins install additional actions. To add draft actions from the More Actions menu, set Show draft actions to true. To view spokes available in the ServiceNow Store, set Show store spokes to true from the More Actions menu.</td>
</tr>
<tr>
<td>Flow Logic</td>
<td>Select an option to specify conditional or repeated operations.</td>
</tr>
<tr>
<td>Subflow</td>
<td>Select a published subflow and define input values. In addition to adding a subflow as a flow action, you can enable the Show triggered flows option from the More Actions menu to select an activated flow and define the required inputs. Running a triggered flow ignores its trigger conditions and runs all actions.</td>
</tr>
</tbody>
</table>

To change the order of an action in a flow, drag the handle on the left side of the action to the desired location.
The system displays a set of fields depending on the option selected.

b. To configure the action, flow logic, or subflow, fill in the fields.

c. Click Done.

d. Repeat adding actions until complete.

7. Click Save.
   Flow Designer saves a draft of the flow, trigger, and actions.

What to do next

• Test your flow until you're ready to activate it.

⚠️ Note: The system only triggers activated flows.

• Deploy or transfer your flow to another instance.
  ◦ Deploy your flow from the application repository when your application is complete and ready for release.
  ◦ Transfer your flow from an update set XML file when you want to test the flow on another instance. When you save a flow, Flow Designer generates a single update set file containing its subflows and actions.

Create a flow with an inbound email trigger
Start a flow when your instance receives an email.

Before you begin
Role required: flow_designer or admin

Procedure
2. Click + New > Flow.
3. Define the flow properties, and then click Submit.
   For more information, see Create a flow.
4. In the Trigger section, click the plus icon (+) to add a trigger.
5. Select Inbound Email.
6. On the form, fill in the fields.
### Field | Description
--- | ---
Email conditions | Conditions to qualify which emails start your flow. The condition builder uses fields from the Email [sys_email] table. For example, to trigger a flow for an inbound email in which a user replies to a system notification, set the condition to [Receive type] [is] [Reply].

### Results
When an inbound email meets the conditions that you set, the associated flow triggers and runs the actions.

### Allow multiple triggers to process an inbound email
Configure Flow Designer to allow an inbound email to be processed by multiple inbound email triggers in a specific order.

### Before you begin
Role required: admin

### About this task
Although you can process an inbound email with multiple inbound email actions, you can’t process an inbound email with multiple flows by default. You can add a system property to let process owners use multiple triggers to process an inbound email.

⚠️ **Warning:** Allowing multiple triggers to process an inbound email may increase maintenance and decrease system performance.
Procedure

1. **Add a property** with the following settings:
   - Name: `glide.hub.flow.inbound_email_trigger.show_advanced`
   - Type: true | false
   - Value: true
   After you activate the system property, the Order and Stop processing fields appear on the inbound email trigger.

2. Create multiple flows with an inbound email trigger.
   For more information, see Create a flow with an inbound email trigger.

3. Specify the processing order for each of the inbound email flows:
   a. Open each flow and enter a value in the Order field.
      To give the flow higher priority over other flows, enter a lower number.
   b. Enable or disable stop processing for each flow in your sequence.
      To allow an inbound email to be processed by the next flow in your sequence, clear the Stop processing option.
      To end the sequence on a particular flow, leave the option selected in that flow.

**Create a flow with a MetricBase trigger**

Start a flow when a MetricBase trigger is met. MetricBase triggers track time series data and can monitor when a threshold is reached, when a trend is detected, or when a system stops reporting data.

**Before you begin**
Role required: flow_designer or admin

MetricBase triggers are not available on the base system. The MetricBase application requires a separate subscription and must be activated by ServiceNow personnel.

**Procedure**

1. Navigate to **Process Automation > Flow Designer**.
2. Click **+ New > New Flow**.
3. Define the flow properties.
   For more information, see Create a flow.
4. In the Trigger section, add a trigger and select MetricBase.

5. Complete the trigger fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MetricBase Trigger</td>
<td>Select or create a MetricBase trigger record to start the flow. For types of MetricBase triggers, see MetricBase triggers.</td>
</tr>
<tr>
<td>Table</td>
<td>Read-only table that contains the metric.</td>
</tr>
<tr>
<td>Condition</td>
<td>Click Add filters to set field-based conditions that determine when the flow runs.</td>
</tr>
<tr>
<td>Condition Script</td>
<td>Define a script in the Additional MetricBase Trigger Filtering and Moderation table to prevent duplicate metric events from re-triggering a flow. For example, if a metric hovers at a defined trigger threshold, create a script that defines whether to run the flow once when the metric is met, or every time the triggering threshold is exceeded.</td>
</tr>
</tbody>
</table>

6. Add actions, subflows, and flow logic to the flow.

7. Test the flow. Once behaving as desired, activate the flow. For more information, see Test a flow and Activate a flow.

Results
The MetricBase application monitors time series data on the Now Platform. When the selected trigger is met, the flow runs.

Create a flow with a Service Catalog trigger
Start a flow when a Service Catalog item is requested to automate the fulfillment process.

Before you begin
Role required: flow_designer or admin

About this task
Unlike a record trigger which runs on all records in a table, the Service Catalog trigger runs on all catalog item requests for a specific item when the catalog item is configured to run a specific flow. For example, you can define a flow that runs every time there is a request for a tablet. The requested item becomes the flow trigger record.
Note: Service Catalog records are created in the global scope. They are not part of the source control or application repository transfer, and they are not part of the default Flow Designer update set.

Procedure
1. If not already created, create the catalog item to associate with the flow.
   b. Click New.
   c. Complete the fields. For a detailed description of catalog item fields, see Create or edit a catalog item.

   Note: If you plan to add stages to your flow, verify that there is not an existing workflow associated with the item that also has stages. Clear the values of the Workflow and Execution Plan fields to prevent conflicting stages from reporting to the requested item stage field.

2. Create the flow to associate with the catalog item. When triggered, this flow processes the catalog item request.
   b. Click + New > New Flow.
   c. Define the flow properties. For more information, see Create a flow.
   d. In the Trigger section, add a trigger and select Service Catalog.
   e. Optional: Create flow-specific catalog variables available only to flow actions. See Create flow Service Catalog variables.
   f. Add actions, subflows, and flow logic to the flow. Some actions enable you to manage catalog items. For example, the Create Catalog Task action generates a task for the requested item, and the Get Catalog Variables action enables you to access catalog variables as data pills in the flow. See Create Catalog Task action and Get Catalog Variables action.
g. **Optional:** Add stages to the flow to report progress to the requester. See Flow Designer stages.

h. Test the flow. Once behaving as desired, activate the flow. For more information, see Test a flow and Activate a flow.

   - **Note:** You can’t activate a flow if it references catalog variables that are inactive or don’t exist.

3. Add the flow to the **Flow** field of the catalog item you created.

   a. Navigate to the catalog item.

   b. In the **Flow** field, select the flow you created.

   - **Note:** The **Flow** field only displays flows with a Service Catalog trigger.

   c. Click **Update**.

**Results**
When the catalog item is requested, the associated flow triggers and runs the actions.

**Create flow Service Catalog variables**
Create Service Catalog variables that are only available to a specific Service Catalog-triggered-flow. Flow-specific variables are available to catalog tasks and actions in the flow.

**Before you begin**
Role required: flow_designer or admin

**About this task**
Flow Service Catalog variables display in the **Catalog Variables** field of the Create Catalog Task and Get Catalog Variables actions. They display in the **Flow:variablename** format and are only available to the flow in which they are defined.

For more information about Service Catalog actions, see Create Catalog Task action and Get Catalog Variables action.
Procedure

1. Open or create a flow with a Service Catalog trigger.

2. Click ☰ and select **Manage flow catalog variables**.
The Flow catalog variables table opens.

3. Click **New** to add a new variable available to the flow.

4. Complete the form.

Variable form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Read-only field that indicates which applications can use this variable.</td>
</tr>
<tr>
<td>Map to field</td>
<td>Maps the variable to a specific field on the table for the record producer.</td>
</tr>
<tr>
<td></td>
<td>This field appears if the variable belongs to a record producer.</td>
</tr>
<tr>
<td>Type</td>
<td>The <strong>variable type</strong> that you want to create.</td>
</tr>
<tr>
<td>Catalog item</td>
<td>Catalog item using the variable.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the variable is placed on the page for the catalog item. The variables are organized from top to bottom from least to greatest order value. For example, a variable with an order value of 1 is placed above other variables with higher-order values.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to make the variable available for use</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Check box to make the variable mandatory as part of the ordering process.</td>
</tr>
<tr>
<td>Read only</td>
<td>Option to make a variable read only or editable.</td>
</tr>
<tr>
<td>Hidden</td>
<td>Option to hide a variable.</td>
</tr>
<tr>
<td>Unique</td>
<td>Option to disallow duplicate values for this variable within a multi-row variable set.</td>
</tr>
</tbody>
</table>

⚠️ **Note:** This behavior is applicable only on page load, and can be changed via client APIs.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>• This field appears only for a variable created in a multi-row variable set.</td>
</tr>
<tr>
<td></td>
<td>• This behavior is applicable only in Now Platform, Service Portal, and variable editor in Agent Workspace.</td>
</tr>
<tr>
<td>Selection Required</td>
<td>Check box to require users to select the check box variable. For example, use this option to require users to select an I agree check box for an agreement form. If users try to submit the agreement form without selecting the check box, an alert message is displayed to tell users that they must select the check box.</td>
</tr>
<tr>
<td>Global</td>
<td>If selected, the variable is available for all catalog tasks within service catalog workflows or execution plans by default. If deselected, the variable must be associated with individual catalog tasks.</td>
</tr>
<tr>
<td>Field</td>
<td>Field that the variable maps to.</td>
</tr>
<tr>
<td></td>
<td>This field appears if the variable belongs to a record producer.</td>
</tr>
<tr>
<td>Record producer table</td>
<td>Table that the record producer creates a record in.</td>
</tr>
<tr>
<td></td>
<td>This field appears if the variable belongs to a record producer.</td>
</tr>
<tr>
<td><strong>Question</strong></td>
<td></td>
</tr>
<tr>
<td>Question</td>
<td>Question to ask users ordering the catalog item.</td>
</tr>
<tr>
<td>Name</td>
<td>A name to identify the question.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If this field is empty, its value is auto-populated based on the Question field for all variable types except break, container split, and container end.</td>
</tr>
<tr>
<td>Tooltip</td>
<td>Tooltip text to display when users point to the variable. Enter a brief note to describe the purpose of the 'Question'.</td>
</tr>
<tr>
<td>Example text</td>
<td>Hint that is displayed in the question field before a user enters a value. Applicable for the following variables:</td>
</tr>
<tr>
<td></td>
<td>• IP Address</td>
</tr>
<tr>
<td></td>
<td>• Email</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>URL, Single Line Text, Wide Single Line Text, Multi Line Text, Date, Date/Time</td>
<td>Formatted label to be displayed on a catalog item form. Applicable for the Rich Text Label variable.</td>
</tr>
<tr>
<td><strong>Rich Text</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Annotation</strong></td>
<td></td>
</tr>
<tr>
<td>Show help</td>
<td>If selected, displays the help text and instructions for the variable.</td>
</tr>
<tr>
<td>i <strong>Note:</strong></td>
<td>- It is not available for break and check box variables.</td>
</tr>
<tr>
<td></td>
<td>- Help text and instructions are not available for a variable set.</td>
</tr>
<tr>
<td>Always Expanded</td>
<td>If selected, the Help text and Instructions field value are expanded by default when the catalog item page loads.</td>
</tr>
<tr>
<td></td>
<td>This check box appears only when the Show help check box is selected.</td>
</tr>
<tr>
<td>i <strong>Note:</strong></td>
<td>- This field is also applicable in Service Portal.</td>
</tr>
<tr>
<td></td>
<td>- This field is not applicable in the variable editor in Workspace and Catalog Item UIB component.</td>
</tr>
<tr>
<td></td>
<td>- If the <strong>Expand help for all questions</strong> check box is selected at the catalog item level, then the <strong>Always Expanded</strong> field setting at the variable level is overridden.</td>
</tr>
<tr>
<td></td>
<td>- If the <strong>Expand help for all questions</strong> check box is deselected at the catalog item level, then the <strong>Always Expanded</strong> field setting at the variable level is applicable.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Help tag</td>
<td>If the <strong>Always Expanded</strong> check box is deselected, click the value specified in this field to display the <strong>Help text</strong> and <strong>Instructions</strong> field values. This field is not applicable in the variable editor in Workspace and Catalog Item UIB component.</td>
</tr>
<tr>
<td>Help text</td>
<td>Help information for a service catalog variable. This field is applicable in Now Platform, Service Portal, and variable editor in Workspace, and Catalog Item UIB component. However, in Workspace and Catalog Item UIB component, you can view either help text or instructions. If both instructions and help text are available, you can view only the instructions. This field is not applicable for Break, CheckBox, Container End, Container Split, Macro, and UI Page variables. In Workspace and Catalog Item UIB component, this field is additionally not applicable for a Masked variable.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Information that requires rich text formatting or adding images to support help information. This field is applicable in Now Platform, Service Portal, and variable editor in Workspace, and Catalog Item UIB component. However, in Workspace and Catalog Item UIB component, you can view either help text or instructions. If both instructions and help text are available, you can view only the instructions. In Workspace and Catalog Item UIB component, this field is additionally not applicable for a Masked variable.</td>
</tr>
</tbody>
</table>

**Note:** For HTML tables, use sizes that are within the width of the variable.

<table>
<thead>
<tr>
<th>Type Specifications</th>
<th>(The fields in this section vary for each variable type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable Width</td>
<td>Width for the variable on the catalog item page, to specify what percentage of the screen size that it can span. For details, see <strong>Configure a default width for service catalog variables</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>This field appears for all variable types except for break, container end, container start, container split, container layout, and label variables.</td>
<td></td>
</tr>
</tbody>
</table>
| Enable also request for       | Option to allow a catalog item request to be submitted for multiple users. After you select this option, the Also request for field is displayed along with Requested For variable in a catalog item.  
  • This functionality is only applicable in Service Portal.  
  • This field is applicable only for the Requested For variable.  
  For information about delegated request experience, see Delegated request experience. |
| Roles to use also request for | Option to specify the roles that can submit a catalog item request for multiple users.  
  • This functionality is only applicable in Service Portal.  
  • This field is applicable only for the Requested For variable.  
  • This field appears only when the Enable also request for check box is selected.  
  ⚠️ Note: If no role is specified, anyone who has access to the catalog item can submit the request.  
  For information about delegated request experience, see Delegated request experience. |
| Choice direction              | The direction in which the choice list is arranged.  
  • Across: Arranges choices horizontally.  
  • Down: Arranges choices vertically.  
  This field appears for lookup multiple choice variables.  
  ⚠️ Note: The selected direction is also applicable in Service Portal. |
| Choice field                  | Table field to populate options for the variable. If no choices are defined for a field, then the variable loads field-related distinct values from the table.  
  This field appears for select box variables. |
<p>| Choice table                  | Table with values to populate in the Choice field. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not select the first choice</td>
<td>Check box to leave all options for the variable cleared on the catalog item page. If this check box is selected, the first choice for the variable selected by default. This field appears for multiple choice and numeric scale variables.</td>
</tr>
<tr>
<td>Dynamic ref qual</td>
<td>Dynamic qualifier. Select a dynamic filter to run a query against the reference field. This field appears for reference variables when Use reference qualifier is set to Dynamic.</td>
</tr>
<tr>
<td>Include none</td>
<td>Check box to include the None option in a list of choices. This field appears for lookup multiple choice, lookup select box, multiple choice, and select box variables.</td>
</tr>
<tr>
<td>Layout</td>
<td>Layout for a container, whether one or two columns. This field appears for container start variables.</td>
</tr>
<tr>
<td>List table</td>
<td>Table with the values for the list collector. The table should have a display column specified. This field appears for list collector variables.</td>
</tr>
<tr>
<td>Lookup from table</td>
<td>Table from which values are obtained for users to select. The values from this table are populated in the Lookup value field. This field appears for lookup multiple choice and lookup select box variables.</td>
</tr>
<tr>
<td>Lookup value field</td>
<td>Field in the lookup table that populates options for the variable. This field appears for lookup multiple choice and lookup select box variables.</td>
</tr>
<tr>
<td>Lookup label field(s)</td>
<td>Comma-separated list of fields in the lookup table whose values are used to display options. This field appears for lookup multiple choice and lookup select box variables.</td>
</tr>
<tr>
<td>Lookup price field</td>
<td>Field in the lookup table whose value is used to modify the price of the item being ordered.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>This field appears for lookup multiple choice and lookup select box variables.</td>
</tr>
<tr>
<td>Lookup recurring price field</td>
<td>Field in the lookup table whose value is used to modify the recurring price of the item being ordered. This field appears for lookup multiple choice and lookup select box variables.</td>
</tr>
<tr>
<td>Macro</td>
<td><strong>UI macro</strong> to insert into the catalog item. This field appears for macro, macro with label, and UI page variables.</td>
</tr>
<tr>
<td>Summary macro</td>
<td>Applicable only for Marco, and Macro with Label type variables.</td>
</tr>
<tr>
<td>Widget</td>
<td>Applicable only for Marco, and Macro with Label type variables.</td>
</tr>
<tr>
<td>Price if checked</td>
<td>Price of the item. This field appears for check box variables.</td>
</tr>
<tr>
<td>Recurring price if checked</td>
<td>Price that increments for the item, when the user requests more than one order of the item. This field appears for check box variables. For more information about prices and recurring prices, see Using variables for price setup.</td>
</tr>
<tr>
<td>Reference</td>
<td>Reference table for the variable. The table should have a display column specified. This field appears for reference variables.</td>
</tr>
<tr>
<td>Reference qual</td>
<td>Qualifiers to restrict data that is available in the field. Supports reference qualifiers and advanced reference qualifiers. Returns all matching results (no maximum).</td>
</tr>
</tbody>
</table>

⚠️ **Note:** For security reasons, the use of scripts in the **Reference qual** field is restricted to system administrators through the **Allow javascript in Default Value** business rule.

This field appears for list collector, lookup multiple choice, lookup select box, reference and Requested For variables.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference qualifier condition</td>
<td>Options to build conditions. This field appears for reference variables when <strong>Use reference qualifier</strong> is set to <strong>Simple</strong>.</td>
</tr>
<tr>
<td>Scale max</td>
<td>Highest value on the scale of available options for the variable. This field appears for numeric scale variables.</td>
</tr>
<tr>
<td>Scale min</td>
<td>Lowest value on the scale of available options for the variable. This field appears for numeric scale variables.</td>
</tr>
<tr>
<td>Unique values only</td>
<td>Check box to require a unique value for the field. When this check box is selected, two records cannot have the same value for that field.</td>
</tr>
<tr>
<td>Use confirmation</td>
<td>Check box to prompt users to reenter data to verify their entries. This field appears for masked variables.</td>
</tr>
<tr>
<td>Use encryption</td>
<td>Check box to store the answer in encrypted format in the database. If not encrypted, the answer is stored in plain text format. Encryption uses Triple DES with system encryption. This field appears for masked variables.</td>
</tr>
<tr>
<td>Use reference qualifier</td>
<td>Type of qualifier to use. This field appears for reference variables.</td>
</tr>
<tr>
<td>Validation Regex</td>
<td>Regular expression that validates the variable value. This field is displayed only for Single Line Text and Wide Single Line Text variable types.</td>
</tr>
<tr>
<td></td>
<td>To define regular expressions, see <strong>Define a regular expression for a variable</strong>.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>• This field is also applicable in Service Portal.</td>
</tr>
<tr>
<td></td>
<td>• The max_length attribute value is valid even when the validation regex is set.</td>
</tr>
<tr>
<td></td>
<td>• You cannot add a catalog item with regex validation errors to the wishlist.</td>
</tr>
</tbody>
</table>

| Variable attributes | Attributes that define the behavior and restrictions for a variable. For information on variable attributes, see Service Catalog variable attributes. |

### Default Value

| Default value | Default value for the variable. |

### Permission

If no role is specified in this tab for the read, write, or create actions, all users who can access the catalog item can perform these actions irrespective of their role. For example, if no role is specified for the **Write roles** field, all users who can access the catalog item can edit the variable value in the variable editor.

A user with a role that does not match any of the following roles cannot set variable values even through scripting.

These roles are not available for Label, Break, Container Split, Container End, Macro, Macro with Label, and UI Page variables.

<table>
<thead>
<tr>
<th>Read roles</th>
<th>Roles that can view the variable before or after requesting the catalog item or record producer. Only a user with the roles specified in this field can view the variable.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Write roles</td>
<td>Roles that can edit the variable in the variable editor after requesting the catalog item or record producer. If a user does not have the roles specified in this field, the variable is read-only in the variable editor.</td>
</tr>
<tr>
<td>Create roles</td>
<td>Roles that can create values for the variable before requesting the catalog item or record producer. If a user does not have the specified role, the variable is read-only before requesting the catalog item or record producer.</td>
</tr>
</tbody>
</table>

### Availability

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible Elsewhere</td>
<td>If selected, the variable is visible in the item form before ordering the item, in VEditor after ordering the item, and in the cart view of the item.</td>
</tr>
<tr>
<td>Visible on Bundles</td>
<td>If selected, the variable is visible when the item is added to a bundle.</td>
</tr>
<tr>
<td>Visible on Guides</td>
<td>If selected, the variable is visible when it is added to an order guide, or when it is added to a catalog item that is included in the order guide.</td>
</tr>
<tr>
<td></td>
<td>Note: If an order guide has too many items and variables, consider clearing this check box on as many items as possible, to improve loading performance on order guides.</td>
</tr>
<tr>
<td>Visible on Summaries</td>
<td>If selected, the variable is visible on any variable summarizer of the catalog item.</td>
</tr>
<tr>
<td></td>
<td>In Service Portal, the variable is visible in the RITM ticket page and the Approval page.</td>
</tr>
<tr>
<td></td>
<td>In Now Mobile, the variable is visible in the RITM and the Approval records.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Results**

Access the variable in the flow by adding a Create Catalog Task or Get Catalog Variables action.

**Create a flow with an SLA Task trigger**

Configure your Service Level Agreement (SLA) definition to run a flow as the action plan.

**Before you begin**

- Set up an application in Guided Application Creator to store Flow Designer content.
- Role required: flow_designer or admin

**About this task**

An SLA Task trigger only runs when a task record matches the conditions of a Service Level Agreement (SLA) definition. For example, you can run a flow
whenever an incident record matches the **Priority 1 resolution (8 hour) SLA Definition.**

**Procedure**

1. Navigate to **Process Automation > Flow Designer.**
2. Select **+ New > New Flow.**
3. On the form, fill in the fields.

**Flow Properties form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify your flow. The system computes the internal name of the flow from the name.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope to create your flow in. Global is the default.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of your flow.</td>
</tr>
<tr>
<td>Protection</td>
<td>Selection to specify if the flow is read-only. You can only select a value when you create the flow in an application scope that you own.</td>
</tr>
</tbody>
</table>
| Run As     | Use this option to specify if the flow runs as system user or the user who initiates the session. Select the user who initiates the session option when updates should come from the user who triggered the flow. For example, when you want incident record comments to come from the current user, or approval emails to originate from the approver. Settings for the Run as option in a flow don’t apply to child subflows. The system runs flow actions as the user who initiates the flow. Verify that all users who can trigger a flow have the necessary security access to run its actions. The initiating user also determines user-specific settings such as date/time formats.  
  
  **Note:** Inbound email flows ignore this setting and always run as the user who initiates the session. To test access controls for an inbound email flow, impersonate a typical inbound email user and manually trigger the flow. |

4. Select **Submit.**
The system displays the Flow Designer page.

5. Select **Select to add a Trigger > Application > SLA Task**.

6. Add actions, subflows, and flow logic to the flow.
   Add **SLA Percentage Timer actions** to specify what to do when a task record attached to an SLA reaches specific percentages of completion.

7. Test the flow. Once behaving as desired, activate the flow.
   For more information, see **Test a flow and Activate a flow**.

8. **Create an SLA definition**

   a. In the **Flow** field, select the SLA Task flow you previously created.

   i. **Note:** The **Flow** field only displays flows with an SLA Task trigger.

   b. Click **Submit**.

**Results**
When the SLA Definition conditions are true, the system runs the specified SLA task flow.

**Create a flow with roles**
Create a flow or subflow that runs with assigned roles. Assigning roles enables you to create a user-initiated flow that runs with its own roles rather than the user's roles.

**Before you begin**
Role required: flow_designer or admin

**About this task**
Create a user-initiated flow that runs with its own roles and not the roles of the user. For more information about assigning roles to a flow, go to **Flow roles**.

**Procedure**

1. Navigate to **Process Automation > Flow Designer**.

2. Click **+ New > Flow** or **+ New > Subflow**.

3. On the Flow Properties form, define the Name, Protection, Application, and Description for the flow.
   For more information, see **Create a flow**.

4. In the **Run As** field, select **User who initiates session**.
   Role selection is not available if the **System User** option is selected in the **Run As** field.
5. In the **Run with role(s)** field, select the roles that you want the flow to execute with.

6. Click **Submit**.

   **Note:** If you have the Explicit Roles plugin (com.glide.explicit_roles) activated, add the snc_internal role to your flow.

**What to do next**

Continue to build and test your flow until you’re ready to activate it. You can modify your flow’s roles at any time by updating the Flow Properties form.

**Duplicate an action or subflow**

Duplicate an action or subflow within a flow.

**Before you begin**

Role required: admin or flow_designer

**Procedure**

1. Navigate to **Process Automation > Flow Designer**.

2. On the Flow Designer landing page, select the flow containing the action or subflow that you want to duplicate.

3. Under Actions, point to the action or subflow that you want to duplicate and then select the duplicate action icon (ไกล).

**Results**

Your selected action or subflow duplicates directly under itself. All configurations, including transform functions, are copied over to the duplicated action or subflow.

**Test a flow**

Before activating a flow so other users can access it, test to make certain it works the way you expect.

**Before you begin**

Role required: flow_designer or admin

**About this task**

Testing a flow bypasses the flow trigger conditions to run it with the test data you provide. For example, testing a flow with a record **Created** trigger causes the system to act as if the selected record was created. For a list of data pills available by trigger type, see **Flow trigger types**.
Because testing a flow creates or changes records on the instance, flow designers should always test flows on a non-production instance containing relevant demonstration data.

Procedure

1. Navigate to Process Automation > Flow Designer, then double-click the row for the flow you want to test.

2. Save the flow.

3. Select Test.
   The system displays the Test flow dialog. The contents of the Test flow dialog depend on the type of trigger.

4. If the flow has a record trigger, create or select a record to use for the test.
   To create a record, select the Create new record button.

5. If the flow has a record Updated or Created or Updated trigger, specify which fields and values changed in the update.
   To specify a field value change, select the Create new changed field button for each field whose value you want to change. Complete the changed field details for each changed field.

6. Select Run Test.

   Note: Select the Run test in background option to test a flow asynchronously in the background.

   The system tests the flow.

7. Select Your test has finished running. View the flow execution details.
Note: This link is created irrespective of your choice for the Run test in background option. If you have selected the Run test in background option, the execution details are displayed only after the execution is completed asynchronously in the background. Also, the execution details are associated with the flow only after execution is completed.

The system displays the flow execution details for the test.

What to do next
Review the Flow execution details.

Activate a flow
Activate a flow to make it available to other users.

Before you begin
Role required: flow_designer or admin

About this task
When you save a flow, you can test it, but no other users on the instance can see or run it. To make the flow available to other users, activate it.

Procedure
2. Locate the flow you want to activate from the list of saved flows and open it.
3. Click Activate.

Allow flow designers to dynamically set field values
Enable flow designers to dynamically set field values when adding the subflow or action to a flow. For example, allow flow designers to set the priority and short description of a Create Task action.

Before you begin
A dynamic field can only be created in a subflow action or action step that creates or updates a record, such as Create Catalog Task, Create Task, Create Record, and Update Record.

Role required: admin or action_designer

About this task
When creating or updating a record in a subflow action or action step, you can set static or dynamic values. A static value is the same every time a flow runs. A dynamic value allows a flow designer to change it every time a flow runs. For
example, setting the Urgency to the static value 1 - High generates an urgent catalog task every time the flow runs.

**Procedure**

1. Open an action in Action Designer or a subflow in Flow Designer that you want to create a dynamic value for.

2. Create an input.
   a. In the **Label** field, enter a label to help flow designers understand the purpose of the field. This is the label for the field when the flow designer adds the subflow or action to a flow. For example, enter **Select fields**.
   b. In the **Type** field, select Template Value. Select the table containing the record you will create or update. For example, if you are adding a Create Catalog Task action in a subflow, set the Type to Template Value. Requested Item [sc_req_item].

3. Add an action step or action that will use the template value.
   The action step or action must create or update a record. For example, add a Create Task action to a subflow that will create an incident task.

4. Drag the Template Value data pill into the **Field Values** or **Fields** field.

5. **Optional**: Add static values in addition to the dynamic field by selecting **Add Field Value**.

   ❗ **Note**: Avoid setting static values that you want flow designers to set from the dynamic field. The flow always uses the static value from the subflow or action step over a value entered from a dynamic field. You can use static values to enforce business policies that you do not want flow designers to change.

**Results**

When the subflow or action is added to a flow, a flow designer can set field values for the record being created or updated.

**Edit a flow**

Edit an existing flow.

**Before you begin**

Role required: flow_designer or admin
Procedure

1. If necessary, navigate to Process Automation > Flow Designer, then double-click the row for the flow you want to edit. The Flow Designer landing page appears.

2. Take the appropriate actions to edit the flow.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the flow name, description, or roles</td>
<td>In the main header, click Properties, enter the values you want into the appropriate fields, then click Update.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot change the scope of an automationHub flow after you have saved it.</td>
</tr>
<tr>
<td>To edit the trigger</td>
<td>In your flow, click the trigger description, fill in the fields as desired, then click Done.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Modifying triggers can result in the deletion of referenced action configurations.</td>
</tr>
<tr>
<td>To edit an existing action</td>
<td>In your flow, click the action description, fill in the fields as desired, then click Done.</td>
</tr>
<tr>
<td>To add a new action</td>
<td>To add an action at the end of a flow, click the plus icon in the ACTION section. Proceed as you would for adding an action to a new flow.</td>
</tr>
<tr>
<td></td>
<td>To insert an action into an existing flow, point to the vertical line between the action icons where you want to insert the action. When the plus icon appears, click it. Add the action just as you would add it to a new flow.</td>
</tr>
</tbody>
</table>

3. To save your changes, click Save.

Delete a flow

Delete a flow that you no longer need.
Before you begin
Role required: flow_designer or admin

About this task
You can only delete records that are in the same application scope as the current session. If your instance uses domain separation, make sure that you are in the Global scope. For more information, see Domain separation and Flow Designer.

Procedure
1. If necessary, navigate to Process Automation > Flow Designer to display the Flow Designer landing page.
2. Check the selection box for the row corresponding to the flow you want to delete.
3. Click Actions on selected rows . . . , then click Delete.

View activated flows for a table
View flows with record-based triggers that run on a specific table.

Before you begin
Role required: flow_designer or admin

Procedure
1. Navigate to a table.
2. Right-click the form header and select Configure > Flow Designer Flows. The Flows table opens and displays all flows that have been activated to run on the specified table.

Supported Service Catalog types
Flow Designer supports several Service Catalog variable types for both single-row and multi-row variable sets.

Supported variable types

<table>
<thead>
<tr>
<th>Service Catalog variable type</th>
<th>Flow Designer variable type for single-row variable sets</th>
<th>Flow Designer variable type for multi-row variable sets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check box</td>
<td>True/false</td>
<td>True/false</td>
</tr>
<tr>
<td>Date</td>
<td>Date</td>
<td>Date/time</td>
</tr>
<tr>
<td>Date and time</td>
<td>Date/time</td>
<td>Date/time</td>
</tr>
</tbody>
</table>
### Supported variable types (continued)

<table>
<thead>
<tr>
<th>Service Catalog variable type</th>
<th>Flow Designer variable type for single-row variable sets</th>
<th>Flow Designer variable type for multi-row variable sets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>Duration</td>
<td>String</td>
</tr>
<tr>
<td>Email</td>
<td>Email</td>
<td>String</td>
</tr>
<tr>
<td>HTML</td>
<td>HTML</td>
<td>Not supported</td>
</tr>
<tr>
<td>IP Address</td>
<td>IP Address</td>
<td>String</td>
</tr>
<tr>
<td>Label</td>
<td>String</td>
<td>Not supported</td>
</tr>
<tr>
<td>List collector</td>
<td>List</td>
<td>Not supported</td>
</tr>
<tr>
<td>Lookup multiple choice</td>
<td>Choice</td>
<td>String</td>
</tr>
<tr>
<td>Lookup select box</td>
<td>Choice</td>
<td>String</td>
</tr>
<tr>
<td>Macro</td>
<td>String</td>
<td>Not supported</td>
</tr>
<tr>
<td>Macro with label</td>
<td>String</td>
<td>Not supported</td>
</tr>
<tr>
<td>Masked</td>
<td>Masked code</td>
<td>String</td>
</tr>
<tr>
<td>Multi-line text</td>
<td>Multiple line small text area</td>
<td>String</td>
</tr>
<tr>
<td>Multiple choice</td>
<td>Choice</td>
<td>Choice</td>
</tr>
<tr>
<td>Numeric scale</td>
<td>Integer</td>
<td>Integer</td>
</tr>
<tr>
<td>Reference</td>
<td>Reference</td>
<td>String</td>
</tr>
<tr>
<td>Select box</td>
<td>Choice</td>
<td>Choice</td>
</tr>
<tr>
<td>Single-line text</td>
<td>String</td>
<td>String</td>
</tr>
<tr>
<td>URL</td>
<td>URL</td>
<td>String</td>
</tr>
<tr>
<td>Wide single-line text</td>
<td>String</td>
<td>String</td>
</tr>
<tr>
<td>Yes/No</td>
<td>True/false</td>
<td>True/false</td>
</tr>
</tbody>
</table>

### Flow trigger types

The trigger specifies the conditions that start running the flow. When the trigger conditions are met, the system starts running the flow.
**Record triggers**

Use record triggers to start a flow when a record is created or updated.

Follow these design considerations when creating record triggers.

**Add conditions to only start record flows when needed**

Use conditions to specify what record values start your flow. Starting a flow only when needed consumes fewer system resources than starting a flow, pausing it, and waiting to resume the flow until a specific record condition applies. Instead of creating a flow that starts with a Wait for condition action, redesign the flow to include the wait condition as part of the record trigger.

**Create unique conditions for record triggers on the same table**

To prevent flows from overwriting each other, create unique conditions for each flow running on the same table. If multiple flows on the same table have the same filter, there is no way to know the order in which the flows will run.

**Ignore records added or updated by import and update sets**

Record triggers ignore records added or updated by applying an update set or importing an XML file. These operations apply to the entire application or table rather than an individual record.

**Replace record triggers on Service Catalog tables with Service Catalog application triggers**

Flow Designer no longer displays Service Catalog tables as options for record triggers. Instead, create flows that use the Service Catalog application trigger type.

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created</td>
<td>Starts a flow when a record is created in a specific table.</td>
</tr>
</tbody>
</table>
| Updated | Starts a flow when a record is updated in a specific table. Requires selecting when to run the flow.  
  
  - **For each unique change**: Triggers the flow for every unique update to a non-system field even if the flow is currently running.  
  
  **Note**: The system stores a history of every change to a record and determines whether the change is unique. For example, if an incident record’s State field changes from In Progress to On Hold, the flow will run. However, if the State field then changes back to In Progress, the flow will not run. |
<table>
<thead>
<tr>
<th>Trigger</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> Flows that have a record trigger that runs <strong>For each unique change</strong> can produce recursions when run in a non-interactive session. When such flows make a change to the trigger record, the change meets the flow trigger conditions and causes a recursion.</td>
<td></td>
</tr>
<tr>
<td><strong>Once:</strong> Triggers the flow once for the life of the record.</td>
<td></td>
</tr>
<tr>
<td><strong>Only if not currently running:</strong> Triggers the flow for every unique change if the flow is not currently running. This behavior is the same as the <strong>Always</strong> option in previous releases.</td>
<td></td>
</tr>
<tr>
<td><strong>For every update:</strong> Triggers the flow every time the record is updated, regardless of whether there has already been or there currently are any running contexts for the flow.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Created or Updated</th>
<th>Starts a flow when a record is either created or updated in a specific table. Requires selecting when to run the flow.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>For each unique change:</strong> Triggers the flow for every unique update to a non-system field even if the flow is currently running.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The system stores a history of every change to a record and determines whether the change is unique. For example, if an incident record’s **State** field changes from In Progress to On Hold, the flow will run. However, if the **State** field then changes back to In Progress, the flow will not run.

**Note:** Flows that have a record trigger that runs **For each unique change** can produce recursions when run in a non-interactive session. When such flows make a change to the trigger record, the change meets the flow trigger conditions and causes a recursion.

| **Once:** Triggers the flow once for the life of the record. |
| **Only if not currently running:** Triggers the flow for every unique change if the flow is not currently running. This behavior is the same as the **Always** option in previous releases. |
| **For every update:** Triggers the flow every time the record is updated, regardless of whether there has already been or there currently are any running contexts for the flow. |

**Note:** Flows including approval actions should only run the trigger once.
REST triggers

Use REST triggers to start a flow after a specific REST API request.

ℹ️ **Note:** This feature requires an IntegrationHub Enterprise subscription. For more information, see Request IntegrationHub.

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>REST API - Asynchronous</td>
<td>Start a flow from an inbound API call or webhook from an external system. Configure the trigger start conditions without having to write or maintain custom code. For more information, see REST API trigger.</td>
</tr>
</tbody>
</table>

Date triggers

Use date triggers to start a flow after a specific date and time or repeatedly at scheduled intervals.

ℹ️ **Note:** Because flows are processed asynchronously, a flow with a date trigger may not run at the exact scheduled time its trigger conditions were met. For example, if a scheduled flow is triggered during core business hours, the system may have to process other events in the queue before it can run the scheduled flow.

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily</td>
<td>Starts a flow at a specific time every day.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Starts a flow at a specific time every week.</td>
</tr>
<tr>
<td>Monthly</td>
<td>Starts a flow at a specific time every month.</td>
</tr>
<tr>
<td>Run Once</td>
<td>Starts a flow once at a specific time but does not repeat. If you select a past date or time, the system schedules the flow to run as soon as possible.</td>
</tr>
<tr>
<td>Repeat</td>
<td>Starts a flow at regular intervals you define.</td>
</tr>
</tbody>
</table>

Application triggers

Use application triggers to start a flow when application-specific conditions are met.
<table>
<thead>
<tr>
<th>Trigger</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MetricBase</td>
<td>Starts a flow when a MetricBase trigger is met. Requires the MetricBase application. For more information, see Create a flow with a MetricBase trigger.</td>
</tr>
<tr>
<td>Service Catalog</td>
<td>Starts a flow from a Service Catalog item request. For more information, see Create a flow with a Service Catalog trigger. Note: Service Catalog records are created in the global scope. They are not part of the source control or application repository transfer, and they are not part of the default Flow Designer update set.</td>
</tr>
<tr>
<td>SLA Task</td>
<td>Starts a flow from an SLA Definition record. For more information, see Create a flow with an SLA Task trigger.</td>
</tr>
</tbody>
</table>

**Inbound email triggers**

Start a flow when your instance receives an email.

Inbound email flows take priority over inbound email actions. If you create flows with inbound email triggers, emails are first processed by the inbound email triggers before they are processed by inbound email actions.

With inbound email actions, you don’t have full control over email attachment handling or assigning the target record of an email. When you create a flow with an inbound email trigger, you can perform these actions with the Move Email Attachments to Record action and the Associate Record to Email action. For greater control over email attachments, you can also use the Look up email attachments action to access a specific attachment as a data pill.

Although you can process an inbound email with multiple inbound email actions, you can’t process an inbound email with multiple flows by default. Additional configuration is required. For information on how to stop processing in inbound email actions, see Specify the inbound email processing order.

For more information on running multiple flows on an inbound email, see Allow multiple triggers to process an inbound email.

The following diagram shows how inbound emails are processed by inbound email triggers. After the email has been classified as a reply, forward, or new email, the system tries to match the email to an active inbound email trigger. If the email meets the conditions of an inbound email trigger, the flow runs. If the flow issues stop processing, the email is finished being processed. If the flow does not issue stop processing, the system tries again to match the email to an active inbound email trigger. If at any point the email does not match an
active inbound email trigger, the system tries to match the email with an active inbound email action instead.

**Processing emails with inbound email triggers**

1. Email Classification
2. Start
   - Email matches conditions of an active inbound email trigger
     - Yes
     - Flow issues stop processing
       - Yes
       - Stop
     - No
   - Yes
   - There are more inbound email triggers to evaluate
     - Yes
     - Inbound Email Action Execution
     - No
     - No

**Note:** With other types of flows, you can choose to run as a system user or the user who initiates the session. However, inbound email flows always run as the sender of the inbound email. If the system does not recognize the sender, inbound email flows will run as the Guest user. The actions of inbound email flows are limited by user ACL restrictions. To test access controls for an inbound email flow, impersonate a typical inbound email user and manually trigger the flow.

**Advanced options**

Specify the user session requirements needed to start a flow with **Advanced Options**.

**When to run the flow**

Determine the type of session that can trigger the flow, whether to run the flow when triggered by certain users, and which tables can trigger the flow.
### Interactive session options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only Run for Non-Interactive Session</td>
<td>Flow that is only triggered in non-interactive sessions. See Non-interactive sessions.</td>
</tr>
<tr>
<td>Only Run for User Interactive Session</td>
<td>Flow that is only triggered in interactive sessions.</td>
</tr>
<tr>
<td>Run for Both Interactive and Non-Interactive Sessions</td>
<td>Flow that is triggered in all sessions.</td>
</tr>
</tbody>
</table>

### User options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not run if triggered by the following users</td>
<td>Flow that does not trigger for a selected list of users. Click the Add User icon (Ω) to add users to the list.</td>
</tr>
<tr>
<td>Only run if triggered by the following users</td>
<td>Flow that triggers only for a selected list of users. Click the Add User icon (Ω) to add users to the list.</td>
</tr>
<tr>
<td>Run for any user</td>
<td>Flow that runs for any user.</td>
</tr>
</tbody>
</table>

### Table options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run only on current table</td>
<td>Flow that is only triggered for the selected table.</td>
</tr>
<tr>
<td>Run on current and extended tables</td>
<td>Flow that is triggered for the selected table and any extended tables.</td>
</tr>
</tbody>
</table>

### Where to run the flow

Determine whether to run the flow in the background or in the current session.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run flow in background (default)</td>
<td>Flow that runs asynchronously in the background. Use this option for flows that do not require immediate updates and to allow other system processes to run at the same time.</td>
</tr>
<tr>
<td>Run flow in foreground</td>
<td>Flow that runs synchronously in the current session. Use this option to provide immediate updates to an end user. For example, if a flow opens a task after the previous task closes, use this option to open the next task immediately after a user closes one.</td>
</tr>
</tbody>
</table>

 đổ  Note: Running a flow in foreground may block the current session thread and prevent user input until the flow finishes. Avoid running flows in the foreground when they contain actions that cannot be interrupted, such as actions that run script. Actions or flow logic that pause a flow will not block a session.

**Data pills available by trigger type**

Flow designers have access to data pills from the trigger.

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Data pills available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td><strong>[Table Label] Record</strong></td>
</tr>
<tr>
<td></td>
<td>An object containing the triggering record.</td>
</tr>
<tr>
<td></td>
<td><strong>Changed Fields</strong></td>
</tr>
<tr>
<td></td>
<td>An array of objects containing the field values that changed. This data pill is only available for the Updated or Created or Updated trigger types.</td>
</tr>
</tbody>
</table>

Note: To process the Changed Fields array data pill, you will need to use For Each flow logic. For more information on working with array data pills, see Complex data.
<table>
<thead>
<tr>
<th>Trigger</th>
<th>Data pills available</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>[Table Label] Table</strong></td>
<td>The Sys ID of the table containing the trigger record.</td>
</tr>
<tr>
<td><strong>Run Start Time:</strong></td>
<td>The Date/Time value of when the flow started.</td>
</tr>
<tr>
<td>REST API - Asynchronous Path Parameters</td>
<td>An object containing path parameters in the inbound request.</td>
</tr>
<tr>
<td><strong>Query Parameters</strong></td>
<td>An object containing query parameters in the inbound request.</td>
</tr>
<tr>
<td><strong>Request Headers</strong></td>
<td>An object containing headers in the inbound request.</td>
</tr>
<tr>
<td><strong>Request Body</strong></td>
<td>Complex data object that defines the body structure of the inbound request. For more information on complex objects, see Complex data.</td>
</tr>
<tr>
<td><strong>Date</strong></td>
<td><strong>Run Start Time:</strong> The Date/Time value of when the flow started.</td>
</tr>
<tr>
<td><strong>SLA Task</strong></td>
<td><strong>Task SLA Record</strong> An object containing the triggering Task SLA record. <strong>sla_flow_inputs</strong> An Object containing Task SLA Definition values.</td>
</tr>
<tr>
<td><strong>Inbound Email</strong></td>
<td><strong>Email Record</strong> An object containing the triggering Email record. <strong>[Table Label] Table</strong> The Sys ID of the table associated with the target email. <strong>Body Text</strong></td>
</tr>
<tr>
<td>Trigger</td>
<td>Data pills available</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Trigger</td>
<td>A String containing the body of the email message.</td>
</tr>
<tr>
<td>Subject</td>
<td>A String containing the subject of the email message.</td>
</tr>
<tr>
<td>User Record</td>
<td>An object containing the user who sent the triggering email. If the sender does not have an associated User record, the data pill lists the object for the Guest user.</td>
</tr>
<tr>
<td>From address</td>
<td>A String containing the sender email address.</td>
</tr>
<tr>
<td>Metric Base</td>
<td><strong>MetricBase Trigger Definition Record</strong></td>
</tr>
<tr>
<td></td>
<td>An object containing the triggering MetricBase Trigger Definition Record.</td>
</tr>
<tr>
<td>Level</td>
<td>The Integer value of the MetricBase trigger level.</td>
</tr>
<tr>
<td>Time of Metric Event</td>
<td>The Date/Time value of when the metric event occurred.</td>
</tr>
<tr>
<td>Record</td>
<td>An object containing the record for which metric events have been collected.</td>
</tr>
<tr>
<td>Service Catalog</td>
<td><strong>Requested Item Record</strong></td>
</tr>
<tr>
<td></td>
<td>An object containing the triggering Requested Item record.</td>
</tr>
<tr>
<td>Run Start Time</td>
<td>The Date/Time value of when the flow started</td>
</tr>
<tr>
<td>Table Name</td>
<td>The table name containing the requested catalog item.</td>
</tr>
</tbody>
</table>
Flow roles
Create flows and subflows that run with specific roles. Assigning roles enables you to create user-initiated flows that run with their own roles rather than the user's roles.

Role selection
A flow runs as either the system user or as the user who initiates the session. You can only assign roles to flows that run as the user who initiates the session. When the flow runs as the system user, it runs with the system role, and individual role selection isn't available. For more information, see Create a flow.

You can assign multiple roles to a flow. Selecting new roles replaces the flow's original roles. If roles aren't selected, the flow runs with the roles of the user who initiates the session.

The roles you can select for a flow depend on the roles you have and the application scope of the flow. Assign any roles you that have access to in a particular scope, except high-security roles. You can't assign the following roles to a flow:

- admin
- security_admin
- application-specific admin roles, such as an application admin role for Human Resources.

Modified and copied flows
Other users can modify and copy your flow. To modify a flow, a user must have the same roles as the flow. Users missing any of the roles assigned to the flow, sees the flow as read-only.

When you copy a flow, the assigned roles are removed. The copied flow runs with either the system role or the roles of the user who initiated the session.

Missing roles
Sometimes a flow refers to a role that is not on the instance. The missing role may have been removed or may not exist on the instance. Either situation can occur when moving a flow between instances. When a role is unavailable, the Run with role(s) field displays the sys_id of the role instead of its name. While the role is missing, you cannot save changes to the flow. To save flow changes, either remove the role from the flow or add it to the instance.
Flow roles in execution details
You can see the "Run with" roles for a flow by viewing the flow execution details. Use the Run As field to determine which user ran the flow. Only flows that ran as the initiating user can have roles assigned. These flows have a Run with role(s) field that displays the roles assigned to the flow.

Subflow roles
Flows and subflows each run with their own roles. Subflows don’t inherit roles from a parent flow. When flow execution returns to a parent flow from a child flow, any special roles associated with the child flow are removed. The parent continues execution with its own roles.

Access control lists
Assigning a role to a flow doesn't guarantee that the flow can access a record or table. While roles are an important part of access control lists (ACLs), they are just one possible condition. If a flow cannot access the records you expect it to, review the record ACL rules for the table and fields. The ACL rules might require additional criteria to grant access. For more information, see access control list rules.

Actions
Actions can be added to any flow, enabling process analysts to automate Now Platform features without having to write code.

An action is a reusable operation that enables process analysts to automate Now Platform features without having to write code. For example, the Create Record action allows process analysts to generate records in a particular table with particular values when certain conditions occur. ServiceNow core actions like Create Record require some familiarity with Now Platform tables and fields. Action designers can create application-specific actions to preset configuration details. For example, creating a Create Incident Task action ensures that the process analyst uses the correct table and field configuration each time the action is used. You can add application-specific actions by activating the associated spoke.

In Flow Designer, a process analyst adds actions to a flow and defines the configuration options.

ServiceNow Core actions
A ServiceNow core action is a ServiceNow-provided action available to any flow that cannot be viewed or edited from the Action Designer design environment. For example, the Ask for Approval action is a ServiceNow core action that allows process analysts to use Now Platform approvals.
provides a set of ServiceNow core actions to automate Now Platform processes. You can add application-specific ServiceNow core actions by activating the associated spoke.

**Custom actions**

Using a core action enables the process analyst to configure the desired behavior within the flow. To create an action with a pre-set configuration, or to define custom configuration options, a subject matter expert can create a custom action in Action Designer.

**Action limit**

By default, flows can have no more than 50 actions. To change the default behavior, increase the value of the `sn_flow_designer.max_actions` system property. However, consider the performance impact that a large flow may have on your instance.

**Missing actions**

If an administrator added your flow from an update set, you might have some missing actions in your flow. This normally happens when your instance doesn’t have the appropriate IntegrationHub spokes installed. For more information on how to install the spokes you need to get these actions to appear, see spokes.

**Add Worknote Link to Context action**

Add a journal field entry containing a link to the current flow context record. Use the link to view the flow execution details of the current flow. You can add a flow context link to any record that has a journal field.

**Roles and availability**

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Set to the table name associated with the record. For example, the Task table.</td>
</tr>
<tr>
<td>Record</td>
<td>The record to be updated. Drag a record data pill or use the data pill picker to select a record. For example, the trigger record.</td>
</tr>
</tbody>
</table>
### Ask for Approval action

Request approval for a record with an approval field. You can configure a rule set for an approval, rejection, or cancellation. If a due date is added to an approval, the approval is automatically approved, rejected, or canceled if the approvers have not responded by the designated time.

**Approvals** is a platform feature that enables users or groups to approve or reject a task.

### Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the `flow_designer` or `admin` role can add an action to a flow and define configuration details.

### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Select a record under the data panel and drag the record pill into the Record field. If selecting a table with an approval field already configured, the Approval field is set to the correct field.</td>
</tr>
<tr>
<td>Table</td>
<td>Set to the table name associated with the record.</td>
</tr>
<tr>
<td>Approval field</td>
<td>Select a field from the designated table to use for approval status.</td>
</tr>
<tr>
<td>Journal field</td>
<td>Select a field from the designated table to use for journal entries.</td>
</tr>
<tr>
<td>Rules</td>
<td>Define the approval and rejection rules. Approval rules determine which users can approve or reject requests, and what happens after approval or rejection. Approval or rejection rules include:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
|         | • Anyone approves  
|         | • All users approve  
|         | • All responded and anyone approves  
|         | • % of users approve  
|         | • # of users approve |

In the field beside the approval rule, add the desired approvers. To add approvers:

• Select individual users or groups.  
• Drag or select a field from a record.  

• Select 🛡️ to allow a manual approver to process an approval or rejection. A manual approver is a user manually added to the Approvers related list who can then approve the request. For example, you can manually add a subject matter expert to a task to approve the request. To learn more about adding manual approvers, see Generate approvals using the approvers related list.

Define rejection rules by adding another OR rule set. When defining approvals, include rejection rules that run when there are no matching approvals. Such rejection rules prevent the flow from remaining in a waiting state. For example, if an approval can be approved by anyone, create a time-based rejection rule in case no one approves it.

ℹ️ **Note:** If you set an approval rule with no rejection rule (or vice versa) and the expected approval state is not met, the runtime value will be **canceled**.

**Due Date**

Define a due date to prevent the flow from remaining endlessly waiting for approval.

• None: The approval is not dependent on a specific date.  
• Approve: Automatically approve the step if an action is still pending by the specified date.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Reject: Automatically reject the step if an action is still pending by the specified date.</td>
<td></td>
</tr>
<tr>
<td>• Cancel: Automatically cancel the step if an action is still pending by the specified date.</td>
<td></td>
</tr>
</tbody>
</table>

ℹ️ **Note:** Relative dates always treat days as 24 hours regardless of the days schedule you select. For example, if you create a due date that expires in 1 relative day, the due date will occur in 24 hours based on the schedule you select. For an 8-5 weekdays excluding holidays schedule, a 24-hour duration is the equivalent of 2 complete business days and 6 hours into the third business day. When working with schedules where the business day is less than 24 hours, consider using relative hours instead of days.
Example

**TRIGGER**
[Incident] Created or Updated

**ACTION**

1. **Ask For Approval**
   - **Action**: Ask For Approval
   - **Record**: Trigger:Incident Record
   - **Table**: Incident [incident]
   - **Approval Field**: Approval
   - **Journal Field**: Approval history

   **Rules**
   - **Approve**
     - **When**: Anyone approves
     - **When**: Trigger:Incident Record = Assigned to:Manager

   - **Reject**
     - **When**: Anyone rejects
     - **When**: Trigger:Incident Record = Assigned to:Manager

   **Due Date**
   - **Approve**
     - **If pending by**: Relative date: 1
     - **Days**: From: Trigger:Incident Record = Assigned to:Created
     - **Days schedule**: 8.5 weekdays

**Output**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval State</td>
<td>State of the approval request</td>
<td>Choice</td>
</tr>
</tbody>
</table>

**Associate Record to Email action**

Associate a record with an Email [sys_email] record so that you can track which record is affected by the email.

**Roles and availability**

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.
Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Record</td>
<td>Email [sys_email] record that the Target Record associates with.</td>
</tr>
<tr>
<td>Target Record</td>
<td>Record to associate to the email record</td>
</tr>
</tbody>
</table>

Output

- This action updates the **Target** field on the Email [sys_email] record.

Example

In the following example, a process owner adds the Associate Record to Email action under an inbound email trigger. The user has also added a Create Catalog Task action in the flow. In the **Email Record** field, the user selects to associate a record to the email that triggered the flow. In the **Target Record** field, the user selects to associate the Catalog Task [sc_task] record that is created in the Create Catalog Task action.

Create Catalog Task action

Creates a record in the Catalog Task [sc_task] table associated to a requested item in the Requested Items [sc_req_item] table. Adds the catalog task record as data to be used in the flow.
Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Name</td>
<td>The Catalog Task [sc_task] table where the catalog task is created. This value is read only.</td>
</tr>
<tr>
<td>Requested Item [Requested Item]</td>
<td>The requested item record from the Requested Items [sc_req_item] table that this catalog task fulfills.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Short description for the catalog task.</td>
</tr>
<tr>
<td>Fields [Catalog Task]</td>
<td>To add the action to a flow, set fields in the catalog task record to the desired value. For example, to set the Urgency, select Urgency and set the desired value. If adding the action to a subflow, you can allow flow designers to dynamically set field values.</td>
</tr>
<tr>
<td>Wait</td>
<td>Pauses the flow until this task completes and is no longer active (active=false). Alternatively, you can add a wait condition by dragging-and-dropping a true/false field from the data panel into the Wait field. The flow only waits for the task to complete when this field is true.</td>
</tr>
<tr>
<td>Template Catalog Item [Catalog Item]</td>
<td>Select an item from the Catalog Items [sc_cat_item] table to populate the Catalog Variables slushbucket with the associated variables.</td>
</tr>
<tr>
<td>Catalog Variables</td>
<td>Select catalog variables to show on the catalog task form to provide more information or allow the fulfiller to modify the variables. You can define flow-specific variables that are displayed in the Available list. To define flow-specific variables, see Create flow Service Catalog variables.</td>
</tr>
</tbody>
</table>
Example

**Create Flow Data action**

Collect data from agents interacting with a Workspace playbook. Use this data to create reusable activities for process owners using Process Automation Designer.
Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition</td>
<td>Reference.Data Definition[sys_flow_data_definition]</td>
<td>Reference to the Data Definition record that defines the variables the system uses to collect data within the flow.</td>
</tr>
<tr>
<td>Assigned To</td>
<td>Reference.User[sys_user]</td>
<td>User responsible for completing the task associated with the Process Automation Designer activity.</td>
</tr>
<tr>
<td>Assignment Group</td>
<td>Reference.Group[sys_user_group]</td>
<td>User group responsible for completing the task associated with the Process Automation Designer activity.</td>
</tr>
<tr>
<td>Wait for user input</td>
<td>Choice</td>
<td>Option to prompt users in Process Automation Designer that determines if the activity pauses for input in a user-facing view of the process. Options include:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Yes - Pause the activity and prompt end users for input</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• No - Don't pause the activity for end user input</td>
</tr>
</tbody>
</table>
Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Reference.Flow Data[sys_flow_data]</td>
<td>Reference to the Flow Data record created from end user input in a user-facing view of the Process Automation Designer activity.</td>
</tr>
</tbody>
</table>

Create Record action

Creates a record on any table. You can dynamically add and configure fields for the record.

Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a table from the list.</td>
</tr>
<tr>
<td>Field Values</td>
<td>Set the values of fields in the record to be created. For example, to set the short description to a certain value, select <strong>Short description</strong> and set the desired value. If adding the action to a subflow, you can allow flow designers to dynamically set field values.</td>
</tr>
</tbody>
</table>

Create or Update Record action

Create or update a record in a ServiceNow table using a single action. Update a record that exists, or create a record using the values provided.

Identification of existing records

The Create or Update Record action identifies existing records by searching for matching values in the fields that you select as unique identifiers. For example, you can specify that the short description and priority fields uniquely identify an
incident. When the action finds an incident with a matching short description and priority, it updates the matching record rather than creating a new record.

⚠️ Note:

- If no field is selected as a unique identifier, the action creates a record with the field values provided.
- If more than one record matches the value of the unique identifiers, the action doesn’t update any records and displays an error message in the flow execution details.

Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Name</td>
<td>Table in which a record is created or updated.</td>
</tr>
<tr>
<td>Fields</td>
<td>Values of fields in the record to be created or updated.</td>
</tr>
<tr>
<td></td>
<td>If adding the action to a subflow, you can Allow flow designers to dynamically set field values. Dynamically set field values can trigger server-side validation rules but cannot trigger UI policies.</td>
</tr>
<tr>
<td>Determines uniqueness</td>
<td>Option for selecting the field as a unique identifier. This field appears when the required table name and fields are selected.</td>
</tr>
</tbody>
</table>

Create Task action

Create a task on any ServiceNow task table. After you choose the task table, you can dynamically select the fields to configure the action. Defining the Parent field associates the task to a parent record.

Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.
### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a task table.</td>
</tr>
<tr>
<td></td>
<td>• Catalog Task [sc_task]</td>
</tr>
<tr>
<td></td>
<td>• Change Phase [change_phase]</td>
</tr>
<tr>
<td></td>
<td>• Change Request [change_request]</td>
</tr>
<tr>
<td></td>
<td>• Chat Queue Entry [chat_queue_entry]</td>
</tr>
<tr>
<td></td>
<td>• Feature Task [release_task]</td>
</tr>
<tr>
<td></td>
<td>• Follow On Task [cert_follow_on_task]</td>
</tr>
<tr>
<td></td>
<td>• Group approval [sysapproval_group]</td>
</tr>
<tr>
<td></td>
<td>• Guided Setup Task [gsw_task]</td>
</tr>
<tr>
<td></td>
<td>• IMAC [change_request_imac]</td>
</tr>
<tr>
<td></td>
<td>• Incident [incident]</td>
</tr>
<tr>
<td></td>
<td>• Incident Task [incident_task]</td>
</tr>
<tr>
<td></td>
<td>• KB Submission [kb_submission]</td>
</tr>
<tr>
<td></td>
<td>• Orphan CI Remediation [orphan_ci_remeditation]</td>
</tr>
<tr>
<td></td>
<td>• Private Task [vtb_task]</td>
</tr>
<tr>
<td></td>
<td>• Problem [problem]</td>
</tr>
<tr>
<td></td>
<td>• Problem Task [problem_task]</td>
</tr>
<tr>
<td></td>
<td>• Reclassification Task [reclassification_task]</td>
</tr>
<tr>
<td></td>
<td>• Recommended Field Remediation [recommended_field_remediation]</td>
</tr>
<tr>
<td></td>
<td>• RemEDIATE Duplicate Task [reconcile_duplicate_task]</td>
</tr>
<tr>
<td></td>
<td>• Release Phase [release_phase]</td>
</tr>
<tr>
<td></td>
<td>• Renew Lease Task [statemgmt_renew_lease_task]</td>
</tr>
<tr>
<td></td>
<td>• Request [sc_request]</td>
</tr>
<tr>
<td></td>
<td>• Request new Knowledge Base</td>
</tr>
<tr>
<td></td>
<td>• [kb_knowledge_base_request]</td>
</tr>
<tr>
<td></td>
<td>• Requested Item [sc_req_item]</td>
</tr>
<tr>
<td></td>
<td>• Required Field Remediation [required_field_remediation]</td>
</tr>
<tr>
<td></td>
<td>• Security Case [sn_ti_case]</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>• Security Incident</td>
<td>[sn_si_incident]</td>
</tr>
<tr>
<td>• Security Incident</td>
<td>Response Task [sn_si_task]</td>
</tr>
<tr>
<td>• Security Request</td>
<td>[sn_si_scan_request]</td>
</tr>
<tr>
<td>• Service Order</td>
<td>[sm_order]</td>
</tr>
<tr>
<td>• Service Order Task</td>
<td>[sm_task]</td>
</tr>
<tr>
<td>• Service Task</td>
<td>[service_task]</td>
</tr>
<tr>
<td>• Stale CI Remediation</td>
<td>[stale_ci_remediation]</td>
</tr>
<tr>
<td>• Standard Change</td>
<td>Proposal [std_change_proposal]</td>
</tr>
<tr>
<td>• Ticket</td>
<td>[ticket]</td>
</tr>
</tbody>
</table>

Field Values
Set the values of fields in the task to be created. For example, to set the short description to a certain value, select **Short description** and set the desired value. To associate the task with a parent record, define the **Parent** field.

If adding the action to a subflow, you can **Allow flow designers to dynamically set field values**.

Wait
Waits to complete the action until the task completes and is no longer active (active=false).
Alternatively, you can add a wait condition by dragging-and-dropping a true/false field from the data panel into the **Wait** field. The flow only waits for the task to complete when the condition field is true.

**Copy Attachment action**
Copies an attachment from the Attachments [sys_attachment] table to a target record.

**Roles and availability**
- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

**Note:** Server-side validation rules, such as data policies, business rules, and dictionary-defined mandatory fields are enforced. UI policies do not apply.
Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Attachment Record</td>
<td>Select an attachment record from the Attachments [sys_attachment] table.</td>
</tr>
<tr>
<td>Target Record</td>
<td>Select a record to attach the <strong>Source Attachment Record</strong> to, or drag a Record data pill from the data panel.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table from the list to select a Target Record.</td>
</tr>
</tbody>
</table>

Delete Attachment action

Removes one or all attachments associated with a record and deletes the attachment record from the Attachments [sys_attachment] table.

Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Record</td>
<td>Drag a Record data pill from the data panel to delete one or all attachment records from.</td>
</tr>
<tr>
<td>Table</td>
<td>Automatically populates with the <strong>Source Record</strong> table.</td>
</tr>
<tr>
<td>Attachment File Name</td>
<td>Enter the name of the attachment file to delete a single attachment associated with the selected record.</td>
</tr>
<tr>
<td></td>
<td>❯ <strong>Note:</strong> If a record has multiple attachments with same name, all matching attachments are deleted.</td>
</tr>
<tr>
<td>Delete All Attachments?</td>
<td>Select to delete all attachments associated with the selected record.</td>
</tr>
</tbody>
</table>

Delete Record action

Deletes a record on any table.
Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>The record to be deleted. Drag-and-drop a record data pill or use the data pill picker to select a record.</td>
</tr>
</tbody>
</table>

Get Attachments on Record action

Access the list and count of the attachments associated with the provided source record as data pills in a flow. Use flow logic or scripting to process each attachment in the list of the attachments that the action returns.

Roles and availability

Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>Entire file name or part of the file name.</td>
</tr>
<tr>
<td>Source Record</td>
<td>Record as a data pill from the data panel or the record that the attachment is associated with.</td>
</tr>
</tbody>
</table>

Get Catalog Variables action

Select variables from multiple template catalog items and variable sets using the Get Catalog Variables action.

Roles and availability

Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.
Submitted Request [Requested Item]  Submitted request from any ServiceNow table.

Template Catalog Items and Variable Sets [Catalog Items and Variable Sets]  Item from the Catalog Items [sc_cat_item] table and single row variable sets to populate the Catalog Variables list with the associated variables.

Catalog Variables  Catalog variables to be displayed in the data panel. Select variables, single-row variable sets, or multi-row variable sets.

**Note:** For optimal performance, avoid selecting Masked variables.

For a list of supported Service Catalog types, see Supported Service Catalog types.

You can define flow-specific variables that are displayed in the Available list. To define flow-specific variables, see Create flow Service Catalog variables.

**Note:** You can’t choose the same variable name from multiple Template Catalog Items and Variable Sets.

Get Email Header action
Access an email header value as a data pill in a flow.

Roles and availability
- Available as a Flow Designer core action. Process analysts use the flow_designer role to add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Record</td>
<td>Record from the Email [sys_email] table.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Target Header</td>
<td>Header from the email record. Upon completion of the action, the header value is added as a data pill in the flow.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If multiple headers have the same name, the action gets the value of the first header that appears.</td>
</tr>
</tbody>
</table>

**Example**

In the following example, a process owner adds the Get Email Header action under an inbound email trigger. In the **Email Record** field, the user selects to get an email header from the email that triggered the flow. In the **Target Header** field, the user selects to get the Subject header from the email.

**Get Latest Response Text From Email action**

Provide the most recent reply or forward message in an e-mail chain to other actions in your flow.

**Roles and availability**

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.
Inputs
Provide a value for each input that your action needs. To add dynamic values, you can also drag and drop pills from the Data panel or select them from the pill picker.

<table>
<thead>
<tr>
<th>Input</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Record</td>
<td>Record</td>
<td>Email record whose most recent reply or forward message you want to provide to other actions in your flow. Select an Email [sys_email] record from the list, or add an Email [sys_email] record data pill from the Data panel.</td>
</tr>
</tbody>
</table>

Outputs
These outputs appear in the Data panel. You can use them as inputs elsewhere in your flow.

<table>
<thead>
<tr>
<th>Output</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Latest Response Text</td>
<td>String</td>
<td>Body text for the most recent reply or forward message in the Email [sys_email] record that you selected for the action's input.</td>
</tr>
</tbody>
</table>

Note: If you select an Email [sys_email] record with a Type of New for this action's input, the Latest Response Text output will be the entire body text of the e-mail.
Log action
Logs a message in the Flow Designer log table.

Roles and availability
• Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log level</td>
<td>Level of importance of the log message.</td>
</tr>
<tr>
<td></td>
<td>• Error</td>
</tr>
<tr>
<td></td>
<td>• Warn</td>
</tr>
<tr>
<td></td>
<td>• Info</td>
</tr>
<tr>
<td>Log message</td>
<td>Message to display in the log. Enter text or drag data pills into the field.</td>
</tr>
</tbody>
</table>

Look up email attachments action
Look up files that are attached to an email so that you can perform an action on the files.

Roles and availability
• Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email record [Email]</td>
<td>Record from the Email [sys_email] table. For example, select the email record from the flow trigger. After you select an email record, the related Email Attachment [sys_email_attachment] record and its fields become available as data pills.</td>
</tr>
</tbody>
</table>
Output

- This action generates a list of Email Attachment [sys_email_attachment] records, which list the attachments that are associated with a given email record. To perform an action on an attachment, add flow logic that runs for each Attachment pill under the Email Attachment Record pill. For more information, see For each flow logic.

Example

In the following example, a process owner adds the Look up email attachments action under an inbound email trigger. In the Email record [Email] field, the user selects to look up files that are attached to the email that triggered the flow.

Look Up Record action

Look up a record from any table based on defined conditions.

Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a table from the list.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions the returned record must meet.</td>
</tr>
<tr>
<td></td>
<td>When building a condition that looks up the value of a reference field, use</td>
</tr>
<tr>
<td></td>
<td>a data pill that explicitly provides</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>the Sys ID value. Ensure the condition has the format <code>[reference field][is][Reference type data pill-&gt;Sys ID]</code>. For example, both the Change and Incident tables contain a reference field to the User table. To look up change records where the requester is the caller from an incident record, create the condition <code>[Requested by][is][Trigger-&gt;incident record-&gt;Caller-&gt;Sys ID]</code>.</td>
<td></td>
</tr>
<tr>
<td>Order by</td>
<td>Determines how to sort results when more than one record matches the defined conditions. Select the field you want to use to sort results.</td>
</tr>
<tr>
<td>Sort Type</td>
<td>Select whether to sort alphabetically in ascending or descending order.</td>
</tr>
</tbody>
</table>
| If multiple records are found | Determines what information to return when more than one record matches the defined conditions.  
- Return only the first record  
- Fail the step |
| Don't fail on error | Determines whether to fail the flow when the lookup can't find a record. |
Look Up Records action

Look up multiple records on any table using defined conditions.

Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a table from the list.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions to search for in records.</td>
</tr>
</tbody>
</table>

When building a condition that looks up the value of a reference field, use a data pill that explicitly provides the Sys ID value. Ensure the condition has the format `[reference field] [is] [Reference type data pill->Sys ID]`. For example, both the Change and Incident tables contain a reference field to the
Input

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User table. To look up change records where the requester is the caller from an incident record, create the condition [Requested by][is][Trigger-&gt;incident record-&gt;Caller-&gt;Sys ID].</td>
</tr>
</tbody>
</table>

Order by

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the field you want to use to sort results.</td>
</tr>
</tbody>
</table>

Sort Type

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select whether to sort alphabetically in ascending or descending order.</td>
</tr>
</tbody>
</table>

Max Results

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of results returned.</td>
</tr>
</tbody>
</table>

Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Records</td>
<td>Records</td>
<td>Records found based on the lookup criteria you provided</td>
</tr>
<tr>
<td>Table</td>
<td>Table</td>
<td>Table name for the records found</td>
</tr>
<tr>
<td>Count</td>
<td>Integer</td>
<td>Number of records found</td>
</tr>
</tbody>
</table>

Example

**TRIGGER**

```
Incident Created or Updated
```

**ACTIONS**

```
Look Up Incident Records
```

**Action**

```
Look Up Records
```

**Table**

```
incident [incident]
```

**Conditions**

```
Assigned to  is  Bow Ruggieri
State  is  New
```

**Order by**

```
Short description  a to z
```

**Max Results**

```
1000
```
Lookup Attachment action
Looks up an attachment associated with a record and returns the Attachment Sys ID as a data pill.

Roles and availability
• Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Note: Server-side validation rules, such as data policies, business rules, and dictionary-defined mandatory fields are enforced. UI policies do not apply.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>Enter the name of the attachment to look up. If the record includes multiple attachments with the same file name, the system returns the first Sys ID encountered.</td>
</tr>
<tr>
<td>Source Record</td>
<td>Drag a Record data pill from the data panel, or select the record that the attachment is associated with.</td>
</tr>
</tbody>
</table>

Move Attachment action
Associates a record from the Attachment [sys_attachment] table with a target record. Removes the attachment from any other associated records.

Roles and availability
• Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Note: Server-side validation rules, such as data policies, business rules, and dictionary-defined mandatory fields are enforced. UI policies do not apply.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Attachment</td>
<td>Select an attachment record from the Attachments [sys_attachment] table.</td>
</tr>
</tbody>
</table>
### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record [Attachment]</td>
<td>Drag a Record data pill from the data panel to attach the Source Attachment Record to.</td>
</tr>
<tr>
<td>Target Record</td>
<td>Automatically populates with the Source Record table.</td>
</tr>
</tbody>
</table>

### Move Email Attachments to Record action

Move attachments from an email to a record so that the files are available to your users when they view the record.

### Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Record</td>
<td>Email [sys_email] record to move attachments from.</td>
</tr>
<tr>
<td>Target Record</td>
<td>Record to move attachments to.</td>
</tr>
</tbody>
</table>

### Output

- This action updates the Email Attachment [sys_email_attachment] record. The Action field changes to Attached to Target Record.

### Example

In the following example, a process owner adds the Move Email Attachments to Record action under an inbound email trigger. The user has also added the Create Catalog Task action in the flow. In the Email Record field, the user selects to move attachments from the email that triggered the flow. In the Target Record field, the user selects to move email attachments to the Catalog Task [sc_task] record that is created in the Create Catalog Task action.
Record Producer action

Create a Task record from a Record Producer Catalog Item [sc_cat_item]. The Task record inherits values from the catalog item's variable values.

Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Inputs

Provide a value for each input that your action needs. To add dynamic values, you can also drag and drop pills from the Data panel or select them from the pill picker.

<table>
<thead>
<tr>
<th>Input</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog Item</td>
<td>Record</td>
<td>Reference to catalog item used to create a Task record.</td>
</tr>
<tr>
<td>Catalog Item Inputs</td>
<td>String</td>
<td>Catalog variables associated with the catalog item you choose. You can view associated catalog variables for Catalog Items from Service Catalog &gt; Catalog</td>
</tr>
<tr>
<td>Input</td>
<td>Data type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Don't fail on error</td>
<td>True/False</td>
<td>Catalog variable indicating whether to fail on error.</td>
</tr>
</tbody>
</table>

**Outputs**

These outputs appear in the Data panel. You can use them as inputs elsewhere in your flow.

<table>
<thead>
<tr>
<th>Output</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table Name</td>
<td>Table where Task record was created.</td>
</tr>
<tr>
<td>Record</td>
<td>Record</td>
<td>Reference to Task record created.</td>
</tr>
<tr>
<td>Error Message</td>
<td>String</td>
<td>Error message produced when the record operation fails.</td>
</tr>
<tr>
<td>Status</td>
<td>Choice</td>
<td>Completion status of the action. The flow execution details page displays one of these numeric values.</td>
</tr>
</tbody>
</table>

- Success [0]: The action succeeded.
- Error [1]: The action produced an error.

**Error messages**

If an error occurs with this action, the following error messages appear in the execution details page.

<table>
<thead>
<tr>
<th>Error message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record generation failed, check logs to get more information.</td>
<td>This error typically occurs when your flow or action contains logic to insert</td>
</tr>
</tbody>
</table>
Error message

<table>
<thead>
<tr>
<th>Error message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a record or records into other tables. When this logic exists, the Record Producer action aborts inserting the record into the table.</td>
<td></td>
</tr>
</tbody>
</table>

Send Email action

Send an email to specified users or groups as an action in a flow.

Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Record</td>
<td>Record that the email is associated to. When a user sends a reply to your email, the target record is updated with the reply email content.</td>
</tr>
<tr>
<td>Table</td>
<td>Table of the target record.</td>
</tr>
<tr>
<td>Include Watermark</td>
<td>Option to apply a watermark to the email that is sent. To include a watermark, you must set a target record.</td>
</tr>
<tr>
<td>To</td>
<td>The main recipients of the email. Enter a list of user email addresses separated by commas or white spaces. You can also drag data pills that contain email addresses into the field, such as a User record. For example, if you want to send an email to the group assigned to the incident, drag the [Assignment group] data pill from the data panel.</td>
</tr>
<tr>
<td>CC</td>
<td>Additional recipients copied on this email. Enter a list of user email addresses separated by commas or white spaces. You can also drag data pills that contain email addresses into the field.</td>
</tr>
<tr>
<td>BCC</td>
<td>Additional recipients of this email, who are visible only to the sender (blind copied). Enter a list of user email addresses separated by commas or white spaces. You can also drag data pills that contain email addresses into the field.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject</td>
<td>Subject of the email. You can enter text or drag data pills into the field.</td>
</tr>
<tr>
<td>Body</td>
<td>The content of the message body. You can enter text or drag data pills into the field.</td>
</tr>
</tbody>
</table>

**Note:** Flow Designer does not support the `${URI}` parameter in the email message body. To create a link to a record, use data pills, or create a notification step instead.

### Testing the email action

To verify that the email was generated when testing the action, review the email record in the Email [sys_email] table. The **Headers** field indicates whether the email was successfully generated. For example:

- **X-ServiceNow-Source:** FlowDesigner-9ad2747b0b710300f4eb8bf637673a1e
- **Message-ID:** <193756824.0.15085345686438@[10.0.66.70]>
- **X-ServiceNow-Generated:** true

ACL restrictions apply to the Send Email action. If you configured your flow to run as the user who initiates the session, ensure that the user can access email. To test access controls for a Send Email action, impersonate a typical email sender and manually trigger the flow.

### Send Notification action

Send a notification as specified by a notification record. The notification record determines the notification formats and recipients.

### Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>The record that triggers the notification. The notification has access to the data from this record.</td>
</tr>
</tbody>
</table>
Table | The table containing the triggering record. The system automatically determines the table from the record you select.
---|---
Notification | The notification record you want to use to format the notification and generate its recipients.

### Send SMS action

Send an SMS text message to specified users or groups as an action in a flow.

### Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recipients</td>
<td>Recipients of the SMS text message. Specify a user or group by dragging a pill from the data panel.</td>
</tr>
<tr>
<td>Message</td>
<td>Content of the SMS text message. You can enter text directly or drag a pill from the data panel.</td>
</tr>
</tbody>
</table>

### SLA Percentage Timer action

Identify when a task SLA record reaches a specific percentage value and perform other actions or flow logic that is based on the SLA percentage. For example, send a notification when an SLA percentage timer completes.

### Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait for percentage</td>
<td>The positive integer percentage of the total SLA duration used to compute an end time. For example, a 50% percentage results in the system computing an end date-time value that is 50% of the total duration.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>total SLA duration</td>
<td>If an SLA requires tasks to be completed within 24-hours, then 50% of that SLA would be 12 hours.</td>
</tr>
</tbody>
</table>

**Scheduled End Date/Time**
The **Scheduled End Date/Time** data pill lists when the SLA percentage timer action is expected to end.

- If the end date is in the future, the system creates a system event to continue running the action at that future date. While the system waits for the scheduled end date, it pauses the flow and action.
- If the end date is in the past, the system immediately sets the **Status** of the SLA Percentage Timer action.

**Status**
The **Status** data pill contains the result of the SLA percentage timer.

**SLA Percentage Timer status descriptions**

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completed</td>
<td>The timer action reached its scheduled end date/time. Flow designers can build specific flow logic for this action status.</td>
</tr>
<tr>
<td>Paused</td>
<td>The timer was paused before its scheduled end date/time. If the timer resumes running, Flow Designer generates a new scheduled end date/time value. Flow designers can build specific flow logic for this action status.</td>
</tr>
<tr>
<td>Repair</td>
<td>The flow is running in repair mode, and the scheduled end date/time is in the past. Flow designers can build specific flow logic for this action status.</td>
</tr>
<tr>
<td>Skipped</td>
<td>The timer did not run because the scheduled end date/time is in the past. Flow designers can build specific flow logic for this action status.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The timer is running and has yet to reach the scheduled end date/time.</td>
</tr>
</tbody>
</table>

Flow Designer sets the action status when the SLA state matches an **SLA condition** or when certain UI actions are selected.
**Action status set for SLA state**

<table>
<thead>
<tr>
<th>SLA state</th>
<th>Action status set</th>
<th>Flow run state</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA attaches and the scheduled end date/time is in the future.</td>
<td>Set action status to <strong>Waiting</strong>.</td>
<td>The flow waits until the SLA timer completes, is cancelled, or is paused.</td>
</tr>
</tbody>
</table>
| SLA attaches and the scheduled end date/time is in the past. | • If the flow was started in Repair mode, set action status to **Repair**.  
• Otherwise, set action status to **Skipped**. | The flow runs the next action or flow logic in the flow sequence. |
| SLA Cancels. | Set action status to a null value. | The flow stops with a state of **Cancelled**. |
| SLA Pauses. | Set action status to **Paused**. | The flow waits until the SLA Task flow is cancelled or is resumed. |
| SLA reaches Scheduled End Date/Time. | Set action status to **Completed**. | The flow runs the next action or flow logic in the flow sequence. |
| SLA Resumes. | Set action status to **Waiting**. | The flow waits until the SLA timer completes, is cancelled, or is paused. |
| SLA Stops. | Set action status to a null value. | The flow stops with a state of **Cancelled**. |

**Total Duration**

The **Total Duration** data pill lists the total number of seconds that the action ran. The total duration is computed from the action start time and the time when the action reached the **Completed** status. Status values other than **Completed** produce a null value **Total Duration**.

**Design considerations**

Follow these design considerations when creating flows that contain SLA Percentage Timer actions.

**Add SLA Percentage Timer actions only to flows with an SLA Task trigger**
An SLA Percentage Timer action can only run when the flow starts from an SLA Task trigger. You cannot activate a subflow containing an SLA Percentage Timer action.

Create conditional flow logic for expected Status values
Use the value of the Status field as a condition for flow logic. Build flow logic for expected Status values such as Completed, Repair, and Skipped. For example, add an If flow logic block to send a notification when the SLA Percentage Timer has a status of Completed.

Assign each SLA Percentage Timer action a unique cumulative Wait for percentage value
Each SLA Percentage Timer action computes its own Scheduled End Date/Time using its Wait for percentage value. If you create multiple SLA Percentage Timer actions, give each action its own unique cumulative Wait for percentage value. For example, create three separate actions with different percentage complete values such as 25%, 50%, and 75% complete. Setting all three actions to the same percentage complete value such as 25% causes the timers to complete at the same time.

Copy existing flows to make customizations
Reduce development time by copying the default SLA flows and customizing the copies with your own logic. Select a customized flow to run from the SLA definition. See Create an SLA definition.

Submit Catalog Item Request action
Create a requested item [sc_req_item] on a Service Catalog Request [sc_req].

Roles and availability
• Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog Item</td>
<td>Name of the requested catalog item. Extra inputs may be added dynamically, depending on which catalog item is selected. For example, when the requested</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>catalog item is a new email account, a field for <strong>Preferred Email address</strong> appears.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Number of items requested.</td>
</tr>
<tr>
<td>Special Instructions</td>
<td>Text describing any special instructions about the item request.</td>
</tr>
<tr>
<td>Delivery Address</td>
<td>Location where the requested item should be delivered.</td>
</tr>
<tr>
<td>Requested for</td>
<td>User that the item is requested for.</td>
</tr>
<tr>
<td>Don’t fail on error</td>
<td>Option to determine whether to fail the flow if the action produces an error.</td>
</tr>
<tr>
<td>Wait for Completion</td>
<td>Option to force the flow to wait until the action has been completed before continuing.</td>
</tr>
<tr>
<td>Enable timeout</td>
<td>Option to limit the amount of time that the flow waits for the action to be completed before continuing.</td>
</tr>
<tr>
<td></td>
<td>This field appears only when the <strong>Wait for Completion</strong> option is selected.</td>
</tr>
<tr>
<td>Duration</td>
<td>Amount of time that the flow waits before continuing when the <strong>Enable timeout</strong> option is selected. Enter the time to wait in hours, minutes, and seconds. If you leave this field empty, the flow does not wait.</td>
</tr>
<tr>
<td></td>
<td>This field appears only when the <strong>Wait for Completion</strong> option is selected.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Schedule used to compute the timeout duration when the <strong>Enable timeout</strong> option is selected. For example, waiting for 10 hours as part of an 8-5 weekdays schedule causes the flow to wait for one or more business days. If you leave this field empty, the timeout runs without a schedule.</td>
</tr>
<tr>
<td></td>
<td>This field appears only when the <strong>Wait for Completion</strong> option is selected.</td>
</tr>
</tbody>
</table>
Example

**OUTPUT**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Message</td>
<td>Message that displays if the action produces an error.</td>
<td>String</td>
</tr>
<tr>
<td>Requested Item</td>
<td>Document ID for the requested item.</td>
<td>Document ID</td>
</tr>
<tr>
<td>Status</td>
<td>The completion status of the action as a numeric value.</td>
<td>Choice</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Update Multiple Records action

Look up and update multiple records as a single action. Using this action removes the need to separately look up a list of records and then process the list with For Each flow logic. Set field values with a template or add and configure them using data pills.

Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select the table containing the records to look up and update.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Define the filter conditions used to look up records.</td>
</tr>
<tr>
<td>Field Values</td>
<td>Set the fields and field values you want to update. Set static or dynamic values for the fields in the records. For example, to set the short description to a certain value, select <strong>Short description</strong> and set the desired value. To add dynamic values, see <strong>Allow flow designers to dynamically set field values.</strong></td>
</tr>
<tr>
<td>Order by</td>
<td>Select the field you want to use to sort the records when more than one record matches the defined conditions.</td>
</tr>
<tr>
<td>Sort Type</td>
<td>Determine whether to sort the records alphabetically in ascending or descending order.</td>
</tr>
<tr>
<td>Don’t fail on error</td>
<td>Specify whether to continue running the flow when there is an error.</td>
</tr>
</tbody>
</table>
**Example**

**TRIGGER**

Problem Updated where (State is Closed)

**ACTIONS**

Update Multiple Incident Records

- **Action**: Update Multiple Records
- **Table**: Incident (incident)

**Conditions**

All of these conditions must be met

- Parent Number is Trigger + Problem Record + Number

**Fields**

- State
- Resolution code
- Resolution notes

**Order by**

- Number

**Sort Type**

- a to z

**Don't fail on error**


**Outputs**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count</td>
<td>Number of records updated. If no records are updated, the count is 0.</td>
<td>Integer</td>
</tr>
<tr>
<td>Error</td>
<td>Message that displays if the action produces an error.</td>
<td>String</td>
</tr>
<tr>
<td>Message</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>The completion status of the action as a numeric value.</td>
<td>Choice</td>
</tr>
<tr>
<td></td>
<td>• 0 (success)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 1 (error)</td>
<td></td>
</tr>
</tbody>
</table>

**Update Record action**

Update an existing record in a table. You can dynamically add and configure fields for the record.
Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>The record to be updated. Drag-and-drop a record data pill or use the data pill picker to select a record.</td>
</tr>
<tr>
<td>Table</td>
<td>The table associated with the record. When you select a record, this field is automatically set to the table associated with the record.</td>
</tr>
<tr>
<td>Field Values</td>
<td>Set the values of fields in the record to be updated. For example, to set the short description to a certain value, select Short description and set the desired value. If adding the action to a subflow, you can Allow flow designers to dynamically set field values.</td>
</tr>
</tbody>
</table>

Wait For Condition action

Pause a flow until record values match a specific set of conditions.

Roles and availability

- Available as a Flow Designer ServiceNow core action. Users with the flow_designer or admin role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Drag an input record or a record from a previous step.</td>
</tr>
<tr>
<td>Note:</td>
<td>If this record is deleted, the flow stops waiting and continues running.</td>
</tr>
<tr>
<td>Table</td>
<td>Read-only. Set to the table associated with the record. Confirm that the system supports Wait for Condition for your selected table.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Conditions</td>
<td>Select the record values necessary to resume running the flow. For example, if the condition is [<strong>State</strong>][is][<strong>Closed</strong>], the flow pauses until the condition is met. Once met, the flow moves on to the next step or action. Set static or dynamic conditions to filter records. To define a static condition applied each time the action runs, define the conditions with the condition builder. To enable flow designers to dynamically apply conditions, define an input of type Conditions and drag-and-drop the input data pill into the <strong>Conditions</strong> field.</td>
</tr>
<tr>
<td>Enable timeout</td>
<td>Option to limit the amount of time that the flow waits for the action to be completed before continuing.</td>
</tr>
<tr>
<td>Duration</td>
<td>Amount of time that the flow waits before continuing when the <strong>Enable timeout</strong> option is selected. Enter the time to wait in hours, minutes, and seconds. If you leave this field empty, the flow does not wait.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Schedule used to compute the timeout duration when the <strong>Enable timeout</strong> option is selected. For example, waiting for 10 hours as part of an 8-5 weekdays schedule causes the flow to wait for one or more business days. If you leave this field empty, the timeout runs without a schedule.</td>
</tr>
</tbody>
</table>

**Unsupported tables**

The system does not support Wait for Condition for the following tables.

<table>
<thead>
<tr>
<th>Table Category</th>
<th>Table Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit</td>
<td>Sys Audit [sys_audit], Audit Deleted Record [sys_audit_delete], Audit Relationship Change [sys_audit_relation], Audit Roles [sys_audit_role], Audit Relationship Change [sys_audit_relation], Audit Deleted Record [sys_audit_delete]</td>
</tr>
<tr>
<td>Email</td>
<td>Email [sys_email], Email Account [sys_email_account], Email Log [sys_email_log]</td>
</tr>
<tr>
<td>Events</td>
<td>Event [sysevent], Notification [sysevent_email_action], Stationery</td>
</tr>
<tr>
<td>Table Category</td>
<td>Table Names</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>[sysevent_email_style], Email Template [sysevent_email_template], Inbound Email Actions [sysevent_in_email_action], Slow Event [sysevent_pattern], Event Registration [sysevent_registration], Script Action [sysevent_script_action]</td>
</tr>
<tr>
<td>Import Sets</td>
<td>Import Set [sys_import_set], Import Set Row [sys_import_set_row], Import Set Row Error [sys_import_set_row_error], Transform History [sys_import_set_run], Computer [imp_computer], Notification [imp_notification], Location [imp_location], User [imp_user]</td>
</tr>
<tr>
<td>JRobin</td>
<td>JRobin Database [jrobin_database], JRobin Shard [jrobin_shard], Graph Line [jrobin_graph_line], JRobin Shard Fragments [jrobin_shard_location], Member [jrobin_graph_set_member], Round Robin Archive [jrobin_archive], Round Robin Data Source [jrobin_datasource], Round Robin Definition [jrobin_definition], Round Robin Graph [jrobin_graph], Round Robin Graph Set [jrobin_graph_set]</td>
</tr>
<tr>
<td>Logs</td>
<td>Log Entry [syslog], Service Portal Log Entry [sp_log]</td>
</tr>
<tr>
<td>MID Server</td>
<td>MID Server Property [ecc_agent_property], Mid Server Log [ecc_agent_log], Queue [ecc_queue], Configuration [ecc_queue_config], ECC Queue Statistics (by ECC Agent) [ecc_queue_stats_by_ecc_agent]</td>
</tr>
<tr>
<td>Performance Analytics</td>
<td>Job Log [pa_job_logs]</td>
</tr>
<tr>
<td>Record Watcher</td>
<td>Responders [sys_rw_action], Channel Responders [sys_rw_amb_action]</td>
</tr>
<tr>
<td>Table Category</td>
<td>Table Names</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reporting</td>
<td>Summary Set [sys_report_summary], Report Summary Line [sys_report_summary_line]</td>
</tr>
<tr>
<td>Scheduled Jobs</td>
<td>Schedule Item [sys_trigger], Broadcast Message [sys_broadcast_message], Broadcast Message Relationships [sys_broadcast_message_m2m], Progress Worker [sys_progress_worker], Progress Worker Domain [sys_progress_worker_domain]</td>
</tr>
<tr>
<td>SSO</td>
<td>SSO Properties [sso_properties], Digest Token Properties [digest_properties], SAML Update 1 Properties [saml2_update1_properties], SSO Federation [sso_federation]</td>
</tr>
<tr>
<td>System Cache</td>
<td>Cache Flush [sys_cache_flush], Cache Entry [sys_db_cache]</td>
</tr>
<tr>
<td>System Clone</td>
<td>ServiceNow Instance [instance], Clone Security Token [clone_token], Preserved Data [clone_preserved_data]</td>
</tr>
<tr>
<td>System Dictionary</td>
<td>Dictionary Entry Override [sys_dictionary_override]</td>
</tr>
<tr>
<td>System Events</td>
<td>Event Processor [sys_event_processor]</td>
</tr>
<tr>
<td>System Fields</td>
<td>Field Class [sys.glide_object]</td>
</tr>
<tr>
<td>System Performance</td>
<td>Component Status [sys_status], Cluster Message [sys_cluster_message], Node State [sys_cluster_state]</td>
</tr>
<tr>
<td>Text Index</td>
<td>Ts Attachment [ts_attachment], Text Index Attribute Map [ts_attribute_map], Ts Chain [ts_chain], Chain Summary [ts_chain_summary], Text Index Column Attribute Map [ts_column_attribute_map], Text Index Configuration [ts_configuration], Text Index Configuration Attribute [ts_configuration_attribute], Ts</td>
</tr>
<tr>
<td>Table Category</td>
<td>Table Names</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Table Category</td>
<td>Delete Doc [ts_deleted_doc], Ts Document [ts_document], Ts Field [ts_field], Text Search Groups [ts_group], Japanese User Token [ts_japanese_token_dictionary], Ts Phrase [ts_phrase], Global Searches [ts_query], Knowledge Searches [ts_query_kb], Text Search Stat [ts_search_stats], Text Search Summaries [ts_search_summary], Stop Word [ts_stop], Synonym Dictionary [ts_synonym_dictionary], Synonym Set [ts_synonym_set], Text Search Table [ts_table], Text Index Table Attribute Map [ts_table_attribute_map], Service Catalog Searches [sc_ts_query], Ts Word [ts_word], Ts Word Roots [ts_word_roots]</td>
</tr>
<tr>
<td>Update Sets</td>
<td>Update Set [sys_update_set], Update Version [sys_update_version], Customer Update [sys_update_xml], Update Set Log [sys_update_set_log]</td>
</tr>
<tr>
<td>Upgrades</td>
<td>System Upgrades [sys_upgrade_history], Upgrade Details [sys_upgrade_history_log], System Upgrade Metric [sys_upgrade_metric], Upgrade Blame Log [sys_upgrade_blame], Upgrade Manifest [sys_upgrade_manifest], Upgrade State [sys_upgrade_state]</td>
</tr>
<tr>
<td>Usage Analytics</td>
<td>Usage Data for Applications [ua_app_usage], UsageAnalytics Count Configurations [usageanalytics_count_cfg], Application Metadata [ua_app_metadata], UsageAnalytics Count for Tables [usageanalytics_count], Subscription [license_details], Role for Subscription [role_has_license]</td>
</tr>
</tbody>
</table>
### Condition Evaluation

The Wait for Condition action only evaluates the wait condition when there are changes to the **Record** you select. A valid wait condition meets these criteria.

- Each condition evaluates a field from the table to which the record belongs.

  ℹ️ **Note:** Avoid conditions that dot-walk to another table or depend upon catalog item variables from a related record.

- Each condition specifies a field value change rather than a relative time period.

  ℹ️ **Note:** For conditions that depend on a specific duration, consider using **Wait for a duration flow logic** instead.
Valid wait condition

In this example, the wait condition is valid because the **State** field belongs to the Incident table and the condition is a field value change to **Closed**.

Invalid wait condition

In this example, the wait condition is invalid because it is a time relative to the **Created** date. Actions that have a condition that relies on a time interval will not be met, so the action is never performed.

Output

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>The completion status of the action as a numeric value.</td>
<td>Choice</td>
</tr>
</tbody>
</table>
Design considerations

Follow these design considerations when creating flows that wait for a condition.

**Use record triggers instead of wait conditions to start flows**

If you only want a flow to run when certain record conditions are met, create a flow with a record trigger instead of starting and pausing a flow. A waiting flow consumes more system resources than a flow trigger.

**Cancel flows whose resume conditions can never occur**

Prevent your flows from waiting indefinitely by specifying flow stop conditions with *End flow logic*. To free up system resources, you can also cancel any flow whose resume conditions can never be met. For example, cancel flows waiting for incident record updates where the related incident is closed.

**Restrict wait conditions to fields present on the current table**

The **Wait For Condition** action can only monitor changes to the fields of the table to which the record belongs. The action cannot detect changes to fields in related records or catalog variables. For example, if an action waits for changes to an Incident record, then it cannot detect changes to a related record such as a catalog item or change task record. Avoid building wait conditions that dot-walk to another record as these fields actually belong to the related record. Avoid building wait conditions that rely on catalog variables.

**Flow action numbering**

The action outline displays a whole number besides each action and flow logic block in a flow. You can update flows containing legacy action numbering from within Flow Designer.

**Current action numbering**

The current number sequence increments each item in the action outline by a whole value of one. For example, if a flow logic block is step 2 in the action...
outline, then the actions within the flow logic block are steps 3, 4, and 5. Inline scripts reference the whole number value of actions and flow logic.

**Legacy action numbering**
The legacy number sequence increments each item within a flow logic block by a decimal value of 0.1. For example, if a flow logic block is step 2 in the action outline, then the actions within the flow logic block are steps 2.1, 2.2, and 2.3. Inline scripts reference the decimal values of actions and flow logic.

**Important:** Inline scripts produce an error when they refer to actions using legacy action numbering. Update all inline script references to use the new action numbering.

**Automatic action numbering updates**
Flow Designer automatically updates the action numbering of all flows during upgrade. Whenever you open a flow that contains inline scripts, Flow Designer checks the script for references to legacy action numbering. If the script contains legacy references, it displays a prompt to update the action numbering.

**Prompt to automatically update action numbers in inline scripts**

Allow Flow Designer to update action numbering in your scripts?

There are scripts that use legacy action numbering on actions. More Info

- [ ] Do not show this again

The system attempts to match the actions referred to by the legacy action numbering to actions with the new numbering. Review the inline script changes to ensure that your inline scripts refer to the correct actions.

**Flow Designer stages**
Communicate the current stage of a request or flow with an end user.

When configuring stages in Flow Designer, you can:
• Create any number of stages.
• Change stage labels and names.
• Set the estimated duration for a stage.
• Import a copy of a pre-defined stage set from the Stage Sets table. To learn more about stage sets, see Workflow stage sets. Any changes made to the copy do not affect the original stage set record.

While stages can be added to a flow with a scheduled trigger, the stages are never displayed to an end user because there is no associated record for the stage field. Only use stages in flows with record and Service Catalog triggers. Stages are not supported on subflows.

View the stages of a flow in the flow execution details.

Displaying stages in a stage field

A stage field is a field of type Workflow that displays the stages of a flow to a user. The Service Catalog table uses a Stage field to indicate the progress of a request as it is processed.

Stage fields display:

• Stages from flows with record or Service Catalog triggers.
• Stages from the associated flow. If the associated flow calls another flow, stages set on the child flow do not display.
• Stages from flows that have started.

State icons in stage fields cannot be modified. Limit the number of stages and the length of each stage name to prevent wrapping text and icons onto multiple lines.

Note: Only add one stage field per table. If there is more than one stage field, the system only displays stages from the first stage field defined in the table dictionary entry.

Stage field and trigger types

Associating a flow to a stage field depends on the flow trigger type.

<table>
<thead>
<tr>
<th>Flow trigger type</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>For a stage field to report stages on a record-based flow, a stage field must be present on the same table as the triggering record. When a flow has</td>
</tr>
<tr>
<td>Flow trigger type</td>
<td>Requirements</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------</td>
</tr>
<tr>
<td></td>
<td>stages, Flow Designer communicates the status of each stage back to the triggering table and displays the current stage state as an icon. If more than one stage field exists on the table, only the first stage field defined in the table's dictionary definition is used.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Avoid creating stages for multiple flows that trigger from the same table. A stage field only displays the stages of the final flow to run. Add different conditions to each flow to ensure that the stages of one flow do not overwrite another flow.</td>
</tr>
<tr>
<td>Service Catalog</td>
<td>If using the Service Catalog trigger, the flow must be associated with the Service Catalog item through the <strong>Flow</strong> field. Remove any workflows associated with the item by clearing the <strong>Workflow</strong> and <strong>Execution Plan</strong> fields. The <strong>Stage</strong> field displays the current stage state on any list view of the Requested Items [sc_req_item] table.</td>
</tr>
</tbody>
</table>

### Stage states
During flow execution, each stage can be in one of five states.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>This stage has not yet started.</td>
</tr>
<tr>
<td>In progress</td>
<td>This stage is executing.</td>
</tr>
<tr>
<td>Skipped</td>
<td>This stage was skipped and did not run. Typically, this state is reached when a conditional flow logic block is not executed.</td>
</tr>
<tr>
<td>Complete</td>
<td>This stage is complete.</td>
</tr>
<tr>
<td>Error</td>
<td>This stage has reached an error condition. When designing a flow, you can manually set the flow to report an Error state. To set an Error state:</td>
</tr>
</tbody>
</table>
Each stage can have its own custom state labels. For example, suppose that you have a flow with two stages. Stage 1 could have the Pending state with the label Waiting, and Stage 2 could have a Pending state with a label of Not yet started. Flow Designer provides options to generate either the default states or approval states.

**Design considerations**

Follow these design considerations when creating flows with stages.

- **Avoid defining stages that depend on a For Each flow logic**

  Flow Designer prevents you from adding stages within a For Each block. You can only add stages before or after a For Each block.

- **Avoid having multiple flows with stages on the same table**

  A stage field always displays the stage information provided by the last flow to run on a table or record. If multiple flows run on the same records, then the stages defined in one flow can in theory overwrite the stages from another flow. To avoid multiple flows overwriting each other’s stages, define unique trigger conditions for each flow.

- **Avoid updating stage fields**

  If you manage stages with a flow, avoid directly updating stage fields with actions, business rules, script calls, or workflows. Manually updating the value of a stage field may produce unexpected or undesired results.

- **Ensure that each flow on a table has unique trigger conditions**

  Adding unique trigger conditions to each flow ensures the flows only run under those conditions and prevents the stages from one flow overwriting the stages of another flow. Specifying unique trigger conditions makes it easier to troubleshoot flows by limiting the number of flow executions that can produce record changes.

- **Use error stages to communicate with the user**

  The flow error state does not affect flow execution. A flow continues running even if it reaches an error stage. Use a conditional flow...
logic block to set the error stage and communicate to the user that the state of the current stage is Error. For example, if an approval is not approved within the required limit, you may want to communicate an error to the user.

**Use the error stage to stop processing a flow**

Use a conditional flow logic block to identify when a flow enters the error stage. Use the flow logic to stop processing the flow or take some kind of remediation action. For example, you may want to change the record state or assignment when a flow reaches an error state.

**Configure stages and add them to a flow**

Configure when stages display to a user, define stage state labels, and add stages to a flow within Flow Designer.

**Before you begin**

While stages can be added to a flow with a scheduled trigger, the stages are never displayed to an end user because there is no associated record for the stage field. Only use stages in flows with record and Service Catalog triggers.

Role required: flow_designer or admin

**Procedure**

1. **Optional:** If not already present, create a stage field on the table that triggers the flow. A stage field is a field of type Workflow that displays the stages of a flow to a user. The Service Catalog Requested Items [sc_req_item] table has a stage field by default.

   (Optional) For a stage field to report stages on a record-based flow, a stage field must be present on the same table as the triggering record.

   To add a field to a table, see Add and customize a field in a table.

2. **Optional:** If adding stages to a flow with a Service Catalog trigger, select the flow in the Flow field of the Service Catalog Item [sc_cat_item] table. If using the Service Catalog trigger, the flow must be associated with the Service Catalog item through the Flow field. Remove any workflows associated with the item by clearing the Workflow and Execution Plan fields. This enables a request for a catalog item to initiate a flow specific to that catalog item.

3. Open the flow in Flow Designer.

4. Create and configure stages.
a. Click 🔽 and select Stages. The Flow Stages menu opens.

b. Click New Stage to create and configure stage options.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Display name for the stage. Must be unique.</td>
</tr>
<tr>
<td>Value</td>
<td>Internal name for the stage. Must be unique.</td>
</tr>
<tr>
<td>Duration</td>
<td>Estimated duration displayed to the user.</td>
</tr>
<tr>
<td>Always Show</td>
<td>If selected, the stage always displays in the stage field, even if the stage is set within a flow logic block that might not execute.</td>
</tr>
</tbody>
</table>

c. Optional: Select a stage set to import stages from the Stage Sets table. To learn more about stage sets, see Workflow stage sets. Any changes made to the copy do not affect the original stage set record.

d. Order stages from top to bottom in the order you want the stage field to display them. The stage at the top appears first in the stage field, and the stage at the bottom appears last in the stage field.

   Note: If you create stages inline, the Flow Stages menu displays them in the order they were created, not in the order they appear in the flow.

5. Add stages to the flow. Point to a location in the flow, click Add a Stage, and select an existing stage. Stages can be applied at the beginning of any Flow Designer action or flow logic block, or within an If block.

   Important: Stages are unavailable from within a For Each flow logic block. You can only add stages before and after a For Each flow logic block.
6. **Optional:** Create stages inline. Point to a location in the flow, click **Add a Stage**, and click + to create a new stage.

**Important:** When you create stages inline, stage fields display the stages in the order they were created, not in the order they appear in the flow. To configure or change the order of stages you create inline, open the More Actions menu.

7. **Optional:** Set a stage to the Error state within a conditional flow logic block.

   a. Point to a location and select **Set "Error" State**.

   To set a stage to the Error stage:
   - The flow must have at least one stage defined.
   - The Error can only be set within a stage. When an Error condition is reached, the current stage is set to Error.
   - The Error can only be set within a conditional flow logic block.

When the flow reaches the indicated point, the currently executing stage is set to Error in the stage field.

**Results**

When the flow runs, the stage details appear in any field of type Workflow. In a flow with a record-based trigger, the Workflow field of the triggering table displays the current stage state. In a flow with a Service Catalog trigger, the
Stage field of the Requested Items [sc_req_item] table displays the current stage state.

Flow execution details

View runtime information about an action or flow directly from the design environment such as the current state, actions or steps run, and values produced. Open related records from embedded Now Platform editors or in a new tab.

Each time you test a flow, the system generates information about the configuration and runtime values produced as flow execution details. Process analysts can view flow execution details from the Executions tab. Select a flow execution to open its associated execution details page.

Optionally, you can configure the system to generate execution details each time a flow is run, not just during testing. For more information, see Activate flow reporting.

Sample execution details of the VTB Sample Flow

<table>
<thead>
<tr>
<th>FLOW STATISTICS</th>
<th>ACTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>Look Up Record</td>
</tr>
<tr>
<td>3</td>
<td>Create VTB Card</td>
</tr>
</tbody>
</table>

Each execution details page displays:

- Calling source
- Flow state
- Related record options
- Flow Statistics

Calling source

The calling source lists what started a flow or subflow.
## Source

<table>
<thead>
<tr>
<th>Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flow Designer Test</td>
<td>The flow started because a user selected the <strong>Test</strong> option from the Flow Designer interface. The flow trigger conditions were ignored.</td>
</tr>
<tr>
<td>CRUD Trigger</td>
<td>The flow started when the record-based trigger conditions were met.</td>
</tr>
<tr>
<td>Date Trigger</td>
<td>The flow started when the schedule-based trigger conditions were met.</td>
</tr>
<tr>
<td>Metric Trigger</td>
<td>The flow started when the MetricBase trigger conditions of a <strong>MetricBase</strong> were met.</td>
</tr>
<tr>
<td>Service Catalog Trigger</td>
<td>The flow started when a Service Catalog item was requested.</td>
</tr>
<tr>
<td>Script</td>
<td>The flow started from an API method call in a script, such as a business rule.</td>
</tr>
<tr>
<td>Background Script</td>
<td>The flow started from an API method call in the <strong>Scripts - Background</strong> module.</td>
</tr>
</tbody>
</table>

## Flow state

All active flows are in one of these states.

**Completed**

The flow successfully ran all actions. The flow statistics display configuration and run-time details for each action.

**Waiting**

The flow paused on an action that is waiting for some condition to be met before continuing. The flow statistics display configuration and run-time details for completed actions and configuration details for any actions waiting for a condition to be met. Flows in the Waiting state display a **Cancel Flow** UI action in the header.

**Error**

The flow stopped with an error. The flow statistics display configuration and run-time details for completed actions and configuration details for the action that produced the error. Flows in the Error state display a **Go to error** UI action in the header.

ℹ️ **Note:** When an action results in an error, the flow stops executing at that point and results in an error state.
Related record options
From the Execution details page, you can access records related to the current flow.

Refresh Flow Data
Use this option to update flow runtime data.

Open Flow
Use this option to make configuration changes and publish a new instance of the flow. Changing the flow configuration does not change any currently active flow.

Open Context Record
Use this option to view the flow state, run duration, and related log entries from a standard form view. This option opens the context record in a new tab.

Open Flow Logs
Use this link to view detailed log information about each action. This link opens the log entries list in a new tab.

Open Current Record
For flows that have a record-based trigger, use this link to view the triggering record in a pop-up window.

Open Action
Use this link to make configuration changes and publish a new instance of the action. Changing the action configuration does not change any currently active flow. This link is unavailable for ServiceNow-provided core actions.

Flow statistics
Use flow statistics to see configuration details and run-time values for each flow component. Clicking a trigger or action expands the row and displays configuration and run-time details about it.
The following types of execution details are available.

**Roles**

Use role information to identify whether the flow was **Run as the system** or the user who triggered the flow. If the flow ran with specific roles, the roles are listed after **Run with role(s).**

**Integration Metadata**

Use Integration Metadata to view transaction data such as connection and credential used, target host, and payload size. Integration Metadata only displays for integration steps and requires a separate IntegrationHub subscription. For more information, see Integration steps.

**Configuration Details**

Use the list of input variables to identify any configuration errors with the action. Each variable has its own row displaying its name, data type, configuration settings, and run-time value. The configuration settings display dynamic values as pills. The run-time values display generated records as a link.

**Output Data**

Use the list of output variables to identify any configuration errors with the action.
Logs

Use the log entries to identify potential processing or performance issues. Each log entry has its own row displaying the creation date, log level, and log message. If the action does not generate any logs, the statistics displays the string **No Logs**.

Steps

Use the list of steps to identify any configuration errors with the action. Each step has its own row displaying the variable name, data type, configuration settings, and run-time value. Core actions do not display steps because users cannot change their configuration.

Change the

```
com.snc.process_flow.reporting.serialized.val_size_limit
```

system property to truncate runtime values in the flow execution details step configuration. To learn more, see Flow Designer system properties.

Run duration

Use the run duration to identify potential processing or performance issues. Each action and step displays the duration in milliseconds. System quota rules prevent any action from running longer than a minute.

Embedded text viewer

Flow Designer displays large text-based configuration and runtime output records such as email output, XML payloads, or script steps using an embedded text viewer. The embedded text viewer can format text as HTML, plain text, or color-coded JavaScript. For script steps, the text viewer highlights code lines containing errors.
### Viewing results for each item in flow logic

Flow Designer displays a selector control to view the configuration and run-time results for each item processed by flow logic. Select a record number to see its configuration and run-time details.
Subflow execution details

Process analysts can view subflow execution details from multiple locations.

**Parent flow execution details**

A parent flow lists the flow execution details of each subflow it calls as inline elements. Expand the subflow step to see the subflow execution details.

**Subflow execution details**

The system generates flow execution details for each subflow run. View subflow execution details directly from the list of flow executions.

**Activate flow reporting**

Generate execution details anytime a flow, subflow, action, or step is run, not just during testing.

**Before you begin**

Role required: admin

**About this task**

**Important:** To avoid performance issues on your production instance, activate and configure reporting on the non-production instance that you use for testing.

You activate reporting for an individual flow, subflow, or action by creating a record on the Settings [sys_flow_execution_setting] table. You specify the flow, subflow, or action in the Settings record. Then, the system generates execution
details each time the flow, subflow, or action is run. You can create as many Settings records as you like.

**Note:** Setting records don’t affect actions and subflows running within a parent flow. These settings are only honored when an action or subflow is run using the action API or script API.

Alternatively, you can activate the system to generate execution details each time any of your flows, subflows, actions, or steps are run. To activate reporting globally, configure the `com.snc.process_flow.reporting.level` system property.

**Procedure**

Activate and configure reporting.

<table>
<thead>
<tr>
<th>Option</th>
<th>Procedure</th>
</tr>
</thead>
</table>
| **Activate reporting for an individual action** | a. Navigate to Process Automation > Settings and select New.  

b. In the Flow/SubFlow/Action field, select the lookup icon (🔍) to select an action.  

c. On the dialog box that appears, in the Table name field, select action Type.  

d. In the Document field, select the lookup icon (🔍) and then select an action.  

e. Select OK to close the dialog box.  

f. In the Reporting field, select Flows, Actions, and Steps.  

g. Select Submit. |

| **Activate reporting for an individual flow or subflow** | a. Navigate to Process Automation > Settings and select New.  

b. In the Flow/SubFlow/Action field, select the lookup icon (🔍) to select a flow or subflow.  

c. On the dialog box that appears, in the Table name field, select Flow. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>d. In the <strong>Document</strong> field, select the lookup icon (…) and then select a flow or subflow.</td>
</tr>
<tr>
<td></td>
<td>e. Select <strong>OK</strong> to close the dialog box.</td>
</tr>
<tr>
<td></td>
<td>f. In the <strong>Reporting</strong> field, select <strong>Flows Only</strong>.</td>
</tr>
<tr>
<td></td>
<td>g. Select <strong>Submit</strong>.</td>
</tr>
<tr>
<td>Activate reporting for all flows and subflows</td>
<td>a. Navigate to <strong>Process Automation &gt; Properties</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Set the property <strong>Level of reporting data generated by the flow engine</strong> to <strong>Flows Only</strong>.</td>
</tr>
<tr>
<td></td>
<td>c. Select <strong>Save</strong>.</td>
</tr>
<tr>
<td>Activate reporting for all flows, subflows, and actions</td>
<td>a. Navigate to <strong>Process Automation &gt; Properties</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Set the property <strong>Level of reporting data generated by the flow engine</strong> to <strong>Flows and Actions</strong>.</td>
</tr>
<tr>
<td></td>
<td>c. Select <strong>Save</strong>.</td>
</tr>
<tr>
<td>Activate reporting for all flows, subflows, actions, and custom action steps</td>
<td>a. Navigate to <strong>Process Automation &gt; Properties</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Set the property <strong>Level of reporting data generated by the flow engine</strong> to <strong>Flows Actions and Steps</strong>.</td>
</tr>
<tr>
<td></td>
<td>c. Select <strong>Save</strong>.</td>
</tr>
<tr>
<td>Activate reporting for all flows, subflows, actions, and steps (custom and base system)</td>
<td>a. Navigate to <strong>Process Automation &gt; Properties</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Set the property <strong>Level of reporting data generated by the flow engine</strong> to <strong>Developer Trace</strong>.</td>
</tr>
<tr>
<td></td>
<td>c. Select <strong>Save</strong>.</td>
</tr>
</tbody>
</table>
**Related reference**

Flow Designer system properties

**Flow execution details retention**

Due to the large amount of data consumed by flow execution details, your instance uses data retention policies to delete this data after a set time period.

**Scheduled table cleanup**

The time period used for scheduled table cleanup depends on the type of data stored. Once a record is older than its default retention period, it is deleted if it is in a completed state and the default skip_schedule_cleanup value is false.

### Flow reporting data tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Default retention period</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_flow_report_doc</td>
<td>Report table storing all Flow Designer execution details as of the New York release.</td>
<td>6 Months</td>
</tr>
<tr>
<td>sys_flow_context</td>
<td>Table storing all Flow Designer context records. Context records store the state and a reference to the process plan used to run a flow or action.</td>
<td>6 Months</td>
</tr>
<tr>
<td>sys_json_chunk</td>
<td>Table storing compiled process plans for future, running, and completed flows and actions.</td>
<td></td>
</tr>
<tr>
<td>sys_flow_flow_report</td>
<td>Legacy report table storing flow execution details. Replaced by the sys_flow_report_doc table as of the New York release.</td>
<td>6 Months</td>
</tr>
<tr>
<td>sys_flow_action_report</td>
<td>Legacy report table storing action execution details. Replaced by</td>
<td>6 Months</td>
</tr>
</tbody>
</table>
Flow reporting data tables (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Default retention period</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_flow_step_report</td>
<td>Legacy report table storing step execution details. Replaced by the sys_flow_report_doc table as of the New York release.</td>
<td>1 Week</td>
</tr>
</tbody>
</table>

Every month, the system deletes Flow Designer-related entries from the Variables [var_dictionary] table if they haven’t been used for over a year.

Unavailable flow data
A message displays at the top of the flow report to indicate that action reports are not available for a flow because of table cleanup. The **Show Action Details** link and Action states are not available in this case. A similar message is shown to indicate when reporting for a flow has been deactivated. In this case, a link to the report settings also displays.

Flow logic
Enable flows and subflows to specify conditional or repeated actions. Combine the elements of flow logic to create workflows in a graphical interface with little or no scripting.
The system provides these flow logic options.

<table>
<thead>
<tr>
<th>Flow logic option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If</td>
<td>Selectively apply one or more actions only when a list of conditions is met.</td>
</tr>
<tr>
<td>For each</td>
<td>Apply one or more actions to each record in a list of records.</td>
</tr>
<tr>
<td>Do the following until</td>
<td>Apply one or more actions repeatedly until an end condition is met. You can use the flow data to specify the end conditions.</td>
</tr>
<tr>
<td>Do the following in parallel</td>
<td>Run actions and subflows in separate paths within an isolated flow logic block.</td>
</tr>
<tr>
<td>Make a decision</td>
<td>You can use the decision table branching logic in situations where multiple conditional paths are required, as an alternative to nested If, Else If, or Else flow logic. For example, if you want to determine what kind of car insurance you need, you can add inputs such as your age, accident history, and car model to the decision table to determine a level of insurance coverage. This logic can save you time and present a more readable format than nested if conditions or switch case statements.</td>
</tr>
<tr>
<td>Wait for a duration of time</td>
<td>Use this flow logic to give your users time to act during automated processes or to wait for a specific date and time to complete actions</td>
</tr>
<tr>
<td>Call a Workflow</td>
<td>Run a published and active workflow from your flow. You can use the flow data as a workflow input. For example, you can specify the current record as a workflow input.</td>
</tr>
<tr>
<td>Flow logic option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>End</td>
<td>Use this flow logic to stop a flow within flow designer.</td>
</tr>
<tr>
<td>Dynamic Flow</td>
<td>Identify and run a flow or subflow dynamically by using runtime data. Build templates to provide expected inputs for dynamically called flows or subflows.</td>
</tr>
<tr>
<td>Get Flow Outputs</td>
<td>Use this flow logic to access flow contexts and derive the runtime values for dynamic flow outputs.</td>
</tr>
<tr>
<td>Set Flow Variables</td>
<td>Assign a value to one or more flow variables. Change or update a variable's value during a flow.</td>
</tr>
</tbody>
</table>

**Flow logic inputs**

Each flow logic option displays one or more fields that are used to determine its behavior. For example, the **Call Workflow** flow logic has an input where you are able to select a workflow to run. Use these inputs to define the behavior of the flow and enable optional functionality depending on your needs. See flow logic option documentation for a list of the available inputs and how they control the function of that element.

**Flow logic outputs**

Flow logic options may also have outputs. These represent information that is returned by the flow logic. For example, the **Make a decision** flow logic has an output that contains a decision answer record representing the decision reached by the flow. See the documentation for a flow logic option to see definitions for its outputs.

**If flow logic**

Selectively apply one or more actions only when a list of conditions is met.

Use this flow logic by specifying conditions that are based on the current record. Actions or subflows can be added to the flow within the if flow logic. The flow only applies the actions within this flow logic if the conditions evaluate to true. Conditions are based on data in records, such as a records state or urgency.
## Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition label</td>
<td>Descriptive label for the branch.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions under which the branch runs.</td>
</tr>
</tbody>
</table>

### Example: Perform an action on if an incident has a high urgency

In this example, the action is triggered when the incident record has a high urgency value.

![Example](image)

### Execution details

**Execution details for if flow logic**

1. The header shows the state, start time, and runtime for the flow logic.
2. The Configuration Details section shows the details about the variables that are used by the flow, including the type, configuration, and runtime values for each variable. Use the condition variable to see if the branch conditions were met.

**For Each flow logic**

Apply one or more actions to each record in a list of records.
The **For Each** flow logic applies one or more actions to a list of records. The flow applies the actions contained within the flow logic to each record in the list.

⚠ **Note:** Iterating over a large number of records can be resource intensive, especially when the For Each logic block includes complex actions for each iteration. To avoid performance issues, turn off reporting using the `com.snc.process_flow.reporting.level` system property. For more information, see Flow Designer system properties.

### Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>List or Records data pill specifying the records to process in sequence.</td>
</tr>
<tr>
<td></td>
<td>• Array data pill</td>
</tr>
<tr>
<td></td>
<td>• List data pill</td>
</tr>
<tr>
<td></td>
<td>• Records data pill</td>
</tr>
<tr>
<td></td>
<td>For example, you could use the additional Assignee list for an incident record. For information on data pills, see Flow Designer data.</td>
</tr>
</tbody>
</table>

### Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Table name] Record</td>
<td>Current record in the loop.</td>
</tr>
</tbody>
</table>

⚠ **Note:**

To optimize performance, avoid iterating over lists with more than 1000 records. To iterate over lists with more than 1000 records, divide the list into smaller sections and use multiple flows.

You can nest a **For Each** flow logic block inside of another flow logic block to repeat an action over a series of records. However, avoid nested For Each loops that process many records. Nested loops may cause the flow to run until it is stopped by the flow transaction quota rule, which prevents flows from running longer than an hour. For more information about transaction quotas, see Transaction quotas.
Note: By default, when viewing a flow's execution details, the last 50 iterations for a For Each flow logic's actions appear in the step details. To view more action iterations for a For Each flow logic in the execution details, change the value of the following property at Process Automation > Flow Administration > Properties:

• Number of recent iterations to report for Do Until and For Each loops. For example, if we have 100 iterations and the number is 5, we would report iterations 96-100. If the number is -1 we report all iterations. If the number is 0 we report 1 iteration.

Example: Send an email to each person assigned to a problem

This sample flow starts when a problem record is created. The flow uses For Each flow logic to send an email to each additional assignee listed in the trigger record. The Additional Assignee field of the triggering problem record contains the list of records you want to process.

When the loop is created, a new entry appears in the data panel on the right called 1 - For Each. In that entry, you see an Additional assignee list Record data pill that contains the user information for the users in that field.

The plus icon (+) below this email action is used to add additional actions, such as logging, to the loop.
The flow execution details tab provides runtime information on the flow logic.

1. The header shows the state, start time, and runtime for the flow logic.

2. This flow logic can run actions or subflows multiple times. Use the arrow keys to cycle through each of these instances to see their values.

3. The Configuration Details section shows which records the flow has evaluated.

4. After the For Each section are the actions taken within it. The values for these actions change as you cycle through the actions that are taken by this flow logic.

**Do the following until flow logic**

Apply one or more actions repeatedly until an end condition is met. You can use the flow data to specify the end conditions.

You can use **Do the following until** flow logic to create a loop that repeatedly applies actions. This flow logic requires a condition specifying when to stop the loop.

**Inputs**

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition label</td>
<td>Descriptive label for the loop.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions under which the loop terminates. You could, for example, end a loop when the state of an incident changes.</td>
</tr>
</tbody>
</table>
Example: Send a daily email until an incident is resolved

In this example, the flow sends a daily email about the incident, until the incident is in a closed or canceled state. Inside the Do the following branch, there is a step for looking up the incident record. This is necessary because the record that triggers the flow is only loaded when it is triggered. By adding this look up step, you can get the current state of the incident each time the loop runs.

Outputs
This flow logic produces no outputs.
1. The header shows the state, start time, and runtime for the flow logic.
2. This flow logic can run actions or subflows multiple times until its condition is met. Use the arrow icons to select an iteration and its values.
3. The Actions section shows details on the actions, flows, or subflows that are run during this loop iteration.

**Do the following in parallel flow logic**

Run actions and subflows in separate paths within an isolated flow logic block.

With this flow logic, you can run actions and subflows in separate paths. If any action within the Do the following in parallel flow logic block must wait, other actions run until all paths within the block finish processing.
Paths in a Do the following in parallel flow logic block

**Inputs**
Do the following in parallel flow logic does not have field inputs. Instead, it displays a plus (➕) icon that enables you to create a path with actions or subflows.

The actions and subflows in each path run until all tasks within the flow logic block have completed.

**Outputs**
This flow logic has no outputs, but actions and subflows in each path may have outputs. While the flow is running, outputs from a path are only accessible to other actions in the same path. After the Do the following in parallel flow logic completes, its final outputs are accessible to the rest of the flow.
Example: Create two tasks in parallel when a change request is created

In this example, a flow triggers when a new change request is created. Using Do the following in Parallel, two tasks are created in separate paths and are assigned to different groups. The flow uses the Number field data pill from the triggering change request to display the number in the short description for the task record.

Execution details

<table>
<thead>
<tr>
<th>Action</th>
<th>Table</th>
<th>Field Values</th>
<th>State</th>
<th>Start time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Do the following in Parallel</td>
<td>Flow Logic</td>
<td></td>
<td>2018-09-05 15:20:44</td>
<td>0ms</td>
</tr>
<tr>
<td>1.1</td>
<td>Log</td>
<td>Core Action</td>
<td>Completed</td>
<td>2018-09-05 15:20:44</td>
</tr>
<tr>
<td>1.2</td>
<td>Log</td>
<td>Core Action</td>
<td>Completed</td>
<td>2018-09-05 15:20:44</td>
</tr>
</tbody>
</table>
1. The header shows the state, start time, and runtime for the flow logic.

2. The Configuration Details section shows the state, start time, and runtime for each path in the flow logic block.

**Make a decision flow logic**

You can use the decision table branching logic in situations where multiple conditional paths are required, as an alternative to nested If, Else If, or Else flow logic. For example, if you want to determine what kind of car insurance you need, you can add inputs such as your age, accident history, and car model to the decision table to determine a level of insurance coverage. This logic can save you time and present a more readable format than nested if conditions or switch case statements.

The **Make a decision** flow logic requires that you create an external decision table for its branch paths. Each decision table answer produces a separate branch path within Flow Designer. Decision tables accept any number of inputs and support any number of decisions. You can configure the Make a decision flow logic to return a single or multiple answers and to display the answers as branch paths or record data pills. For more information on decision tables, see **Decision Tables**.

**Note:**

- When the **Use Branches** check box is cleared, the Make a decision data pills in other flow components is supported only if there are no branches.
- The Make a decision data pill can be used in the answer branches only when the **Use Branches** check box is selected.
- When the **Use Branches** check box is selected, don't use the Make a decision data pill in other flow components when there are branches.

**Inputs**

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decision Label</td>
<td>Descriptive label for the decision that you want to make. For example, you can create the <strong>Recommended Insurance Policy</strong> label if you want to determine the level of insurance coverage that you need. This value overrides the default action label.</td>
</tr>
<tr>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Decision Table</td>
<td>Reference to a Decision Table [sys_decision] record. This record provides the decision input answers that are available to the flow.</td>
</tr>
<tr>
<td>Execution</td>
<td>Decision answers you want the flow to run.</td>
</tr>
<tr>
<td></td>
<td>• <strong>First decision that matches</strong>: Run only the first matching decision answer. This option produces these outputs.</td>
</tr>
<tr>
<td></td>
<td>◦ Answer record</td>
</tr>
<tr>
<td></td>
<td>◦ Answer table</td>
</tr>
<tr>
<td></td>
<td>• <strong>Run all decisions that match</strong>: Run all matching decision answers. This option produces these outputs.</td>
</tr>
<tr>
<td></td>
<td>◦ Answer table</td>
</tr>
<tr>
<td></td>
<td>◦ Ordered IDs</td>
</tr>
<tr>
<td></td>
<td>◦ Answer records</td>
</tr>
<tr>
<td></td>
<td>◦ Count</td>
</tr>
<tr>
<td>Use Branches</td>
<td>Option to display each possible decision answer in its own branch flow logic block. Use the branch flow logic block to specify what Flow Designer content to run where the condition matches a specific decision table answer. Each branch flow logic block is equivalent to an If flow logic block for each answer. Disable branches when you want to return one or more answer records instead of branch flow logic blocks.</td>
</tr>
</tbody>
</table>

| Note: | Set the **Use Branches** option to specify how Flow Designer displays matching decision answers. |

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
CAUTION: When you clear and confirm the Use Branches option, Flow Designer removes the flow logic blocks for each branch and removes the Include Otherwise check box. Reselecting the Use Branches check box does not restore any removed branch flow logic blocks.

Include Otherwise
Option to add the otherwise branch to the list of available answers. This option is only available when Use Branches is selected. You can use this branch to specify the actions and subflows to run when the decision table does not generate an answer. An Otherwise branch is equivalent to an Else flow logic block.

Note: If you specify a decision table default answer, this branch will never run because the decision table always selects an answer.

Decision table inputs
List of Decision Input [sys_decision_input] records that are associated with your decision table. Flow Designer displays a separate input for each record. For example, if you have decision inputs for Units Ordered and Location of Sale, an input displays for each record.

Outputs

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Answer table</td>
<td>Table containing the answer records. Each Decision [sys_decision_question]</td>
<td>Table Name</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ordered IDs</td>
<td>List of matching answer record sys_id values generated by the decision table. Flow Designer only generates this output when the <strong>Use Branches</strong> option is false and the <strong>Execution</strong> option is <strong>Run all decisions that match</strong>. You can use this output as the input for a For Each flow logic block or a Look Up Record action. Flow Designer sorts the list by the Order value listed in the Decision [sys_decision_question] table.</td>
<td>List</td>
</tr>
<tr>
<td>Answer records</td>
<td>Answer records returned by the decision table. Returns a single record when <strong>Execution</strong> is <strong>First decision that matches</strong>. Returns a list of records when Execution is <strong>Run all decisions that match</strong>.</td>
<td>Record or Records</td>
</tr>
<tr>
<td>Count</td>
<td>The number of answer records returned by the decision table. Only displayed when Execution is <strong>Run all decisions that match</strong>.</td>
<td>Integer</td>
</tr>
</tbody>
</table>
Example: Use make a decision flow logic to determine insurance coverage

In this example, the flow uses a decision from the Insurance Coverage decision table, which an administrator had configured to determine the insurance coverage that was based on three inputs. The flow displays all the inputs that were used by the decision table in Flow Designer. These inputs can be entered manually, or by dragging data pills into the inputs from the data panel on the right side of the screen. Below this section, the branches for each answer are shown in the decision table.
The **Flow execution details** tab provides runtime information about the flow logic.
1. The header shows the state, start time, and runtime for the flow logic.
2. The action shows details about the decision table configuration and inputs.
3. Each possible answer for the decision table is represented as a branch. The state field indicates whether the branch was evaluated and the evaluation result. This section also displays details about the actions that are taken within a branch. Branches that evaluate to true are highlighted in green.

**Wait for a duration flow logic**

Use this flow logic to give your users time to act during automated processes or to wait for a specific date and time to complete actions.

**Inputs**

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration Type</td>
<td><strong>Explicit Duration</strong>: Wait for a specific time period, such as 5 minutes.</td>
</tr>
<tr>
<td></td>
<td><strong>Relative Duration</strong>: Wait for a specific time period from a selected Duration data pill or date/time value, such as 5 minutes after the flow start.</td>
</tr>
<tr>
<td></td>
<td><strong>Percentage Duration</strong>: Type to specify a certain percentage of time duration between the start of the flow logic and specified end time.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: The percentage value must be from 0 through 100 only.</td>
</tr>
<tr>
<td>Wait for</td>
<td>Set this value manually or select a Duration data pill from the data pill picker ( ).</td>
</tr>
<tr>
<td></td>
<td><strong>Explicit Duration</strong>: Wait duration in hours, minutes, and seconds.</td>
</tr>
<tr>
<td></td>
<td><strong>Relative Duration</strong>: Wait duration in hours, minutes, and seconds before or after a specific time. Select Relative Duration to specify a wait duration from a specific date.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Past dates don't affect the wait duration.</td>
</tr>
</tbody>
</table>

You can enter a wait value of up to 999 hours.
### Note:
The actual wait duration can vary due to the instance processing time. The flow always waits for the time that you specify for this field, but other work in the queue may add to the wait time.

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait for Percentage</td>
<td>Wait duration as a percentage of the time period between the start of flow logic and specified end time. If you select a past date for the end time, the wait duration is set to 0. This field appears when <strong>Percentage Duration</strong> is selected from the Duration Type list.</td>
</tr>
<tr>
<td>During the following schedule</td>
<td>Select the schedule used to calculate the <strong>Scheduled End date/time</strong> value from the selected wait duration. For example, waiting for a 10-hour duration as part of an 8-5 weekdays schedule causes the flow to wait for one or more business days. If you leave this field blank, the timer runs without a schedule. For information on creating schedules, see <strong>Define a schedule</strong>.</td>
</tr>
</tbody>
</table>

### Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>Total time that the flow ran in milliseconds. You can drag this data pill into the duration fields.</td>
</tr>
<tr>
<td>Date/time</td>
<td>Date/time that the flow completed. You can drag this data pill into the date/time fields.</td>
</tr>
</tbody>
</table>

**Example:** Close an incident if it has been in the resolved state for 10 days

In this example, a flow starts when the incident state changes to Resolved.
Example: Wait 10 days after the last update to a record
In this example, the flows waits for 10 days after the incident record has been resolved.

Example: Update a record after 10 days
In this example, the flows closes the incident record 10 days after it was resolved.
Example: Wait for a duration of 50% of the time between the start of the flow logic and the due date

In this example, the flows send a notification email to the relevant manager when a critical problem is created and 50% of the time between the problem record creation and the problem due date has lapsed.

Relative Duration type

When the duration type is Relative Duration, the flow logic first evaluates the relative date and time, the schedule, and finally, the duration. Schedules, dates, and times set in the past don’t affect the wait duration. This table provides examples of how the flow processes the wait duration in these scenarios.
<table>
<thead>
<tr>
<th>Duration Setting</th>
<th>Relative Date/Time</th>
<th>Schedule</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set to 0.</td>
<td>None</td>
<td>None</td>
<td>Duration ends immediately.</td>
</tr>
<tr>
<td>Greater than 0.</td>
<td>Past date</td>
<td>None</td>
<td>Duration ends immediately.</td>
</tr>
<tr>
<td>Greater than 0.</td>
<td>Future date</td>
<td>None</td>
<td>Flow waits for the date/time, and then waits for the duration.</td>
</tr>
<tr>
<td>Greater than 0.</td>
<td>Past date</td>
<td>Future date</td>
<td>Flow waits for schedule, and then waits for the duration.</td>
</tr>
<tr>
<td>Greater than 0.</td>
<td>Future date</td>
<td>Past date</td>
<td>Flow waits for the date/time, and then waits for the duration.</td>
</tr>
<tr>
<td>Greater than 0.</td>
<td>Future date</td>
<td>Future date</td>
<td>Flow waits for the future date, then for the schedule, and then for the duration.</td>
</tr>
</tbody>
</table>

The timer waits for the next instance of a selected schedule. For example, if you set a schedule for Monday through Friday from 8 a.m. to 5 p.m., and the timer is initiated on Saturday, the timer waits until Monday at 8 a.m. before starting.

**Execution details**

**Execution details for Wait for a duration flow logic**

<table>
<thead>
<tr>
<th>Hide Action Details</th>
<th>Flow Logic</th>
<th>State</th>
<th>Start time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Completed</td>
<td>2018-08-14 13:50:06 0ms</td>
</tr>
</tbody>
</table>

**Configuration Details**

<table>
<thead>
<tr>
<th>VARIABLE NAME</th>
<th>TYPE</th>
<th>CONFIGURATION</th>
<th>RUNTIME VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration Type</td>
<td>Choice</td>
<td>Duration</td>
<td>explicit, duration</td>
</tr>
<tr>
<td>Duration</td>
<td>Reference</td>
<td></td>
<td>0 hour(s) 0 minute(s) 20 second(s)</td>
</tr>
</tbody>
</table>

**Output Data**

<table>
<thead>
<tr>
<th>VARIABLE NAME</th>
<th>TYPE</th>
<th>RUNTIME VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled end date/time</td>
<td>Date/Time</td>
<td>2018-08-14 13:50:26</td>
</tr>
<tr>
<td>Total Duration</td>
<td>Duration</td>
<td>20 seconds</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
1. The header shows the state, start time, and runtime for the flow logic.

   ![Note:](image) The runtime value in the header only includes the time that it takes to execute the flow logic and doesn’t include the wait duration that is specified in the flow.

2. The Configuration Details section shows details about the variables that are used by the flow, including the type, configuration, and runtime values for each variable.

### Call a workflow flow logic

Run a published and active workflow from your flow. You can use the flow data as a workflow input. For example, you can specify the current record as a workflow input.

### Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
</table>
| Select a Workflow | Published and active workflow that you can select to run. The workflow that you select determines the records that are associated with it. If the workflow has inputs, Flow Designer displays them as additional flow inputs.  
   ![Note:](image) To prevent the workflow from running outside of Flow Designer, modify it to remove its start conditions. |
| Wait?         | Workflow that you set to true so that the flow waits for workflow completion before continuing. Only workflows that wait for completion can return certain output values to the flow. Set to false to continue running the flow separately from the workflow. |
### Input | Description
--- | ---
**Note:** If the workflow is canceled or its context record is deleted prior to the workflow finishing, the flow stops waiting and instead continues running.

Current | Current record that the workflow processes. Select a data pill that contains a record from the associated workflow table.

### Outputs
The flow execution details only display workflow output values that are generated while the flow is running. If you configure the flow to wait for the workflow to finish, the flow execution details can display all workflow output values. If the flow does not wait, the flow execution details only display the workflow output values that were generated before the **Call a Workflow** flow logic completes. If **Call a Workflow** completes before the workflow finishes, the workflow output values stop updating and only display the last known value.

| Output | Description |
--- | --- |
State | State of the workflow. This value comes from the workflow context record. The state will be **Complete** if the workflow executes successfully. If the workflow is canceled, the workflow state is set to **Canceled**. If the context record is deleted prior to the workflow finishing, the workflow state is set to **Invalid**. |
Context | Reference to the workflow context record. |
Result | String that contains the result from the workflow. This value comes from the workflow context record. |
Return value | String that contains the return_value from the workflow. This value comes from the workflow context record. |
Example: Calling the Routine Change workflow

In this example, the flow calls the **Routine Change** workflow. The **Wait?** option is checked, so the flow pauses until this workflow completes. The **Current** field is filled using a data pill representing the record that triggered this flow.

### ACTIONS

1. **Call a Workflow**

   - **Select a Workflow**: Routine Change
   - **Wait?**: 
   - **Current**: Trigger > Incident Record > Change Request

### Execution details

1. **Call Workflow execution details**

   - **Workflow Configuration**
     - **VARIABLE NAME**: wait, current, Workflow
     - **TYPE**: Trigger, False
     - **DOCUMENT ID**: Knowledge
     - **CONFIGURATION**: Trigger + Knowledge Record
     - **RUNTIME VALUE**: Knowledge - Instant Publish

   - **Workflow Output**
     - **RESULT**: finished
     - **STATE**: Knowledge - Instant Publish

### Note:

If you cancel the workflow or delete the context record prior to the workflow finishing, the flow logic state is set to **Complete**.
End flow logic

Use this flow logic to stop a flow within flow designer.

End flow logic can be contained within a conditional flow logic block, such as an If, Else If, or Else flow logic block. Use this flow logic to stop a flow when certain conditions are met. You cannot add actions or flow logic after you use the End flow logic. All branches of a flow are ended when a flow reaches the End flow logic, including the Wait for a duration logic. Any branches that run in parallel also stop their progress when you use the End flow logic.

Inputs

This flow logic has no inputs.

Execution Details

When a flow ends, the flow state becomes Complete.

Dynamic flows

Identify and run a flow or subflow dynamically by using runtime data. Build templates to provide expected inputs for dynamically called flows or subflows.

The Dynamic Flow flow logic calls a flow or subflow during runtime by using the data that you specify during the flow design. You can use Dynamic Flow to select which flow to run when multiple flows have similar names or purposes.

To use Dynamic Flow, the flow designer does the following:

1. Creates and publishes a flow or subflow to use as a template.
2. Adds Dynamic Flow to a parent flow.
4. Enters the flow name for Dynamic Flow.
5. Enters the required inputs specified by the flow template.

Dynamic flow templates

The template for Dynamic Flow can be a flow or a subflow. The template's inputs must match the inputs of any flow or subflow that you call dynamically. An input matches when it has the same Label and Name field values in each flow or subflow.

After you build a template, consider copying it to create similarly named and similarly performing flows or subflows. Make sure that you name each flow or subflow with a standard naming convention that can be generated by Dynamic Flow. For more information on creating a template for Dynamic Flow, see Getting started with Dynamic Flow and Get Flow Outputs.
## Inputs

The following inputs always appear when you add the Dynamic Flow flow logic to a flow.

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Flow Template</strong></td>
<td>Template whose inputs the dynamic flow copies and displays. The inputs for the template must match the inputs of the subflow that you want to run.</td>
</tr>
<tr>
<td><strong>Flow</strong></td>
<td>Name of the flow or subflow that you want to run. Generate a flow or subflow name dynamically by entering a string and concatenating it with data pill values.</td>
</tr>
</tbody>
</table>

**Note:** You can call a flow or subflow that is associated with another application scope by entering a scope-name.flow-name format. The user running the flow or subflow must have access to the application scopes that you specify. If you do not specify an application scope, the dynamic flow runs in the parent flow's scope.

**Note:** If the system can't find the flow or subflow, it skips the Dynamic Flow flow logic step and logs an error message.

| **Wait for completion** | Option to force the parent flow to wait until the dynamic flow finishes running before proceeding with the next action. |

**Note:** You see more inherited inputs after you select a **Flow Template**.

## Get flow outputs

Dynamic Flow outputs appear in the data panel as Record type data pills that are named as Context. You can use these flow contexts to derive the runtime
values for dynamic flow outputs with the Get Flow Outputs flow logic. To use Get Flow Outputs, the flow designer does the following:

1. Adds a Dynamic Flow to a flow.
2. Adds Get Flow Outputs after the dynamic flow.
3. Specifies the value for the Context input by clicking the data pill picker (şık) and selecting Dynamic Flow > Context.

For more information on using Get Flow Outputs, see Getting started with Dynamic Flow and Get Flow Outputs.

Design considerations

Consider using dynamic flows if you have multiple subflows with similar functionality

Dynamic flows let you compartmentalize your processes by applying a template to handle the inputs of multiple similar subflows. Compartmentalization lets you distinguish between subflows that perform similar functions, such as subflows for IntegrationHub spokes.

Ensure dynamically called subflow inputs match template flow inputs

If the inputs of the dynamic flow don't match the inputs of the flow template, the system throws an error and the main flow can’t run properly.

Use the correct context when getting flow outputs

If you are using Dynamic Flow more than once within a flow, make sure to drop in the correct context data pill from Get Flow Outputs.

Get started with Dynamic Flow and Get Flow Outputs

Create a sample flow that dynamically calls subflows for provisioning cloud services.

Before you begin
Role required: flow_designer or admin

About this task
To understand how to use the Dynamic Flow and Get Flow Outputs flow logic together, the flow that you create in this task dynamically runs subflows that are related to provisioning cloud services. This flow does the following:
1. Triggers when a Cloud Instance Provisioning Request record is created.
2. Calls the appropriate subflow to create a Cloud Instance record.
3. Gets an output from the dynamically called subflow and updates the Cloud Instance Provisioning Request record with the output’s value.

Procedure
1. Navigate to System Applications > Studio.
2. On the Select Application screen, click Create Application.
3. On the Guided App Creator welcome screen, click Let’s get started.
4. In the Name field, enter Cloud Instance Provisioning and then click Create.
5. In the Roles field, enter flow_designer or admin and then click Continue.
6. From the list of app formats, select Classic and then click Continue.
7. Select Create new table > Create table from scratch > Continue to create two new tables for your application.
   • Add the following fields for the first table and name the table Cloud Instance.

<table>
<thead>
<tr>
<th>Field label</th>
<th>Field type</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Reference</td>
<td>User [sys_user]</td>
</tr>
<tr>
<td>Instance Type</td>
<td>String</td>
<td>None</td>
</tr>
<tr>
<td>Instance URL</td>
<td>URL</td>
<td>None</td>
</tr>
<tr>
<td>Build Status</td>
<td>String</td>
<td>None</td>
</tr>
</tbody>
</table>

• Add the following fields for the second table and name the table Cloud Instance Provisioning Request.

<table>
<thead>
<tr>
<th>Field label</th>
<th>Field type</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested Instance Type</td>
<td>String</td>
<td>None</td>
</tr>
<tr>
<td>Requested by</td>
<td>Reference</td>
<td>User [sys_user]</td>
</tr>
<tr>
<td>Approval Status</td>
<td>String</td>
<td>None</td>
</tr>
<tr>
<td>Approved Instance</td>
<td>URL</td>
<td>None</td>
</tr>
</tbody>
</table>
8. After creating both tables, click **Done with tables**.

9. Select **Start > Create > Done with apps** to finish creating your application.

**Create a subflow template**

Create a sample subflow template for provisioning cloud services.

**Before you begin**

Role required: flow_designer or admin

**Procedure**

1. Under Business logic, process automation, and integrations, select **Go to Flow Designer**.

2. In the Flow Designer landing page main header, select **New > New Subflow**.

3. On the Subflow Properties screen, enter **TEMPLATE: Create Cloud Instance Record** in the **Name** field and then select **Submit**.

4. Under Inputs & Outputs, select the plus icon ( + ) to create two inputs for your subflow template.

<table>
<thead>
<tr>
<th>Label</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested by</td>
<td>Reference.User</td>
</tr>
<tr>
<td>Requested Instance Type</td>
<td>String</td>
</tr>
</tbody>
</table>

5. Select the plus icon ( + ) to create one output for your subflow template.

<table>
<thead>
<tr>
<th>Label</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance URL</td>
<td>URL</td>
</tr>
</tbody>
</table>

6. Under your output, select **Done**.
7. Select the add action, flow logic, or subflow to end of flow icon ( ) and then select Action.

8. From the list of ServiceNow Core actions, select Log.

9. In the data panel, drag the data pills for the Requested by and Requested Instance Type inputs you created earlier, and drop both of the pills into the Message field.

10. In the Subflow header, select Save and then select Publish to publish your subflow template.

Create a subflow for Jira cloud instance provisioning requests
Create a sample subflow for provisioning cloud services from Jira.

Before you begin
Role required: flow_designer or admin

Procedure

1. In the Subflow header, select the more actions icon ( ) and select Copy subflow.

2. On the Copy Subflow screen, enter Create Cloud Instance Record - Jira in the New Subflow Name field, and then select Copy.

3. Under the Log action, add a Create Record action.

4. In the Table Name field, select Cloud Instance and then fill in the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the data pill picker ( ) and select Subflow - Inputs &gt; Requested by.</td>
</tr>
<tr>
<td>Instance Type</td>
<td>Select the data pill picker ( ) and select Subflow - Inputs &gt; Requested Instance Type.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Instance URL</td>
<td>Enter <a href="https://mycompany-">https://mycompany-</a>. Then, select the data pill picker (-packages) and select Subflow - Inputs &gt; Requested by &gt; Name. Finally, enter .atlassian.net</td>
</tr>
<tr>
<td>Build Status</td>
<td>Enter In Progress.</td>
</tr>
</tbody>
</table>

5. Under the create record action, select Add an Action, Flow Logic, or Subflow > Flow Logic > Assign Subflow Outputs.
6. Select the plus icon to add an output.
7. For Name, select Instance URL.

8. For Data, select the data pill picker (-packages) and then 2 - Create Record - > Cloud Instance Record > Instance URL

9. In the Subflow header, select Save and then Publish to publish the subflow.

Create a subflow for Salesforce cloud instance provisioning requests
Create a sample subflow for provisioning cloud services from Salesforce.

Before you begin
Role required: flow_designer or admin

Procedure

1. In the Subflow header, select the more actions icon (more) and select Copy subflow.
2. On the Copy Subflow screen, enter Create Cloud Instance Record - Salesforce in the New Subflow Name field, and then select Copy.
3. Expand the Create Cloud Instance Record action and replace the .atlassian.net value for the Instance URL field with .salesforce.com
4. In the Subflow header, select Save, accept the data change warning message, and then Publish to publish the subflow.

Create a flow that runs your subflows dynamically
Create a sample flow to run your provisioning cloud services subflows.

Before you begin
Role required: flow_designer or admin

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Procedure

1. Under the Flow Designer header, select the **Create flow, subflow, or action** icon and select **Flow**.

2. On the Flow Properties screen, enter **Process Cloud Instance Provisioning Request** in the **Name** field, and then select **Submit**.

3. Under Trigger, select the plus icon (+) to add a trigger to your flow, and then fill out the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger</td>
<td>Select <strong>Created</strong>.</td>
</tr>
<tr>
<td>Table</td>
<td>Enter <strong>Cloud Instance Provisioning Request</strong> [x_cloud_instance_p_cloud_instance_provisioning_request]</td>
</tr>
</tbody>
</table>

4. Under Actions, select the plus icon (+) and then select **Flow Logic > Dynamic Flow**.

5. Fill in the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flow Template</td>
<td>Select <strong>TEMPLATE: Create Cloud Instance Record</strong></td>
</tr>
<tr>
<td>Flow</td>
<td>Enter <strong>Create Cloud Instance Record</strong> and then select the data pill picker (_picker) and select <strong>Trigger - Record Created &gt; Cloud Instance Provisioning Request Record &gt; Requested Instance Type</strong>.</td>
</tr>
<tr>
<td>Wait for completion</td>
<td>Enable this option to run your subflow dynamically first before other actions in your flow occur.</td>
</tr>
</tbody>
</table>
| Requested by   | Select the data pill picker (_picker) and select **Trigger - Record Created** > }
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested Instance Type</td>
<td>Select the data pill picker (.FILL) and select Trigger - Record Created &gt; Cloud Instance Provisioning Request Record &gt; Requested Instance Type.</td>
</tr>
</tbody>
</table>

6. Under your **Dynamic Flow** flow logic, add the Get Flow Outputs flow logic, and then fill in the following fields.

7. For **Flow Template**, select **TEMPLATE: Create Cloud Instance Record**

8. For **Context**, select the data pill picker (.FILL) and select 1 - Dynamic Flow - > Context.

9. Under your **Get Flow Outputs** flow logic, select the plus icon (.FILL) and then select Action > Update Record to add an Update Record action to your flow.

10. Fill in the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Select the data pill picker (.FILL) and select Trigger - Record Created &gt; Cloud Instance Provisioning Request Record.</td>
</tr>
<tr>
<td>Fields &gt; Approved Instance</td>
<td>Select the data pill picker (.FILL) and select 2 - Get Flow Outputs - &gt; Instance URL.</td>
</tr>
<tr>
<td>Fields &gt; Approval Status</td>
<td>Enter Approved.</td>
</tr>
</tbody>
</table>

11. Select **Save**.

**Test your flow**

Test your sample flow for provisioning cloud services.
Before you begin
Role required: flow_designer or admin

Procedure

1. In the Flow header, select Test to test your flow.

2. On the Test Flow screen, select the Create new record (+) icon to create a new record.

3. For Requested By, select the Lookup using list icon ( ) and select any user from the list.

4. For Requested Instance Type, enter either Jira or Salesforce. The value you enter determines which subflow runs dynamically at runtime. Entering Jira runs the Create Cloud Instance Record – Jira subflow, and entering Salesforce runs the Create Cloud Instance Record – Salesforce.

5. Select Submit.

6. Select Run Test, and when the flow finishes running, select Your test has finished running. View the flow execution details. Your flow runs successfully if the values in the State column for each step in your flow shows Completed and each step’s runtime value populates appropriately.

7. Select the tab for your Process Cloud Provisioning Requests flow and close the Test Flow modal.

8. In the Flow header, select Activate to make your flow accessible within the Cloud Instance Provisioning application scope.

Results
When a user in your instance creates a new record in the Cloud Provisioning Request table, your Process Cloud Provisioning Requests flow runs automatically. This flow dynamically creates the proper Cloud Instance record that is based on the requested instance type. It also generates a cloud instance URL, which populates in the Cloud Instance Provisioning Request record.

Set Flow Variables flow logic
Assign a value to one or more flow variables. Change or update a variable’s value during a flow.

This flow logic sets values for flow variables that have already been created. For instructions on creating flow variables, see Create a flow variable.
### Inputs

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the variable. Select from the list of variables available for the flow.</td>
</tr>
<tr>
<td>Data</td>
<td>Value for the variable. Enter a specific value, input a script, or use a data pill. To assign a blank value, leave this field empty.</td>
</tr>
</tbody>
</table>

### Outputs

This flow logic produces no outputs.

**Example: Use Set flow variables flow logic to store a record number**

In this example, the flow asks for approval for an incident record. If the record is approved, a flow variable is used to store the approved record number.
Execution details

Set flow variables flow logic execution details

1. The header shows how the flow was run, the state, the start time, and the runtime.

2. The Configuration Details section shows the variables that were assigned values with the flow logic. It displays the variable name, type, configuration, and runtime value for each flow variable.

3. Actions that use a flow variable display the variable’s type, configuration, and runtime value.

Subflows

Define a sequence of reusable actions that can be started from a flow, subflow, or script. Define inputs and outputs to pass data to and from the subflow.

Unlike flows, subflows lack a trigger. Use a subflow when:

- You only want to start a flow by calling it from another flow or script.
- You want to create a set of reusable operations for use in multiple flows.
- You want to specify the inputs available to the subflow when it starts.
- You want to specify the outputs available to the parent flow after the subflow ends.

All subflows consist of properties, one or more inputs, one or more outputs, a sequence of actions, and the data collected or created.

Subflow properties

The subflow properties specify the subflow name, application, category, description, in-flow annotation, roles, and status. Flow designers can update the
subflow name, category, description, in-flow annotation, and roles at any time, but can only set the application during subflow creation. The subflow status is set when you save or publish a subflow.

**Subflow inputs**

Subflow inputs specify the data available to the subflow when it starts. Each input you define for a subflow becomes a configuration option in the Flow Designer interface. To use the subflow in a flow, flow designers must define a value for each mandatory input. The more inputs a subflow has, the more data flow designers must define and the more familiar they must be with the underlying data model to use the subflow effectively.

Inputs provide advanced options based on their data type. All inputs have advanced options to add a hint or provide a default value. Use advanced options to guide flow designers through adding and configuring a subflow to a flow. For example, create a choice input to provide flow designers with a pre-defined list of configuration options to choose from. For more information about the configuration options available to particular data types, see field types.

**Subflow outputs**

Subflow outputs specify the data available to the parent flow after the subflow completes. Subflow outputs are defined as variables with a name and data type. Subflow designers assign values to an output using the Assign Subflow Output flow logic. Output values can be based on the subflow logic conditions, action results, or a manually set value. For example, an output may have one value when a condition is met and another value when a condition is not met. During runtime, the value of the output is determined by the condition that is met.

Consider the following example of a subflow with two conditions that both result in a value for a single output variable. The value of the variable depends on which condition is met during runtime.

**Outputs**

[Manager ID] [String]

**Actions**

- 1 Look Up [User] Record where (Created on Today)
- 2 If ([1->User Record->Title] contains Manager) then
  - 2.1 Assign Subflow Outputs [Manager ID] to [1->User Record->User ID]
• 3 Else
  ◦ 3.1 Assign Subflow Outputs [Manager ID] to [1->User Record->Manager->User ID]

In this case, if the user's title contains "Manager" then the user ID is assigned as output. Otherwise, the subflow looks up the user's manager and assigns the user ID of the manager as output.

Flow Designer allows you to define a value for the same variable multiple times. However, if a variable is given two or more possible values without conditional logic, only the last value defined in the subflow is applied to the output at runtime.

**Outputs**

[Manager ID] [String]

**Actions**

• 1 Look Up [User] Record where (Created on Today)
• 2 Assign Subflow Outputs [Manager ID] to [1->User Record->User ID]
• 3 Assign Subflow Outputs [Manager ID] to [1->User Record->Manager->User ID]

In this example, action three overwrites the value of action two and [1->User Record->Manager->User ID] is applied to the [Manager ID] output at runtime because it was the last value defined. Typically, subflows should only include multiple values for one variable if conditional flow logic is used.

**Subflow execution details**

Process analysts can view subflow execution details from multiple locations.

**Parent flow execution details**

Flow Designer displays subflow execution details within the parent flow execution details. The parent flow execution details list each subflow as inline elements. You can expand a subflow step to see its execution details.

**Subflow execution details**

The system generates flow execution details for each subflow run. View subflow execution details directly from the list of flow executions.
**Actions**

Within **Actions**, flow designers can add actions, flow logic, flows, or other subflows.

An action is a reusable operation that enables process analysts to automate Now Platform features without having to write code. For example, the **Create Record** action allows process analysts to generate records in a particular table with particular values when certain conditions occur. ServiceNow core actions like Create Record require some familiarity with Now Platform tables and fields. Action designers can create application-specific actions to pre-set configuration details. For example, creating a Create Incident Task action ensures that the process analyst uses the correct table and field configuration each time the action is used. You can add application-specific actions by activating the associated spoke.

**Flow logic**

Subflows can contain flow logic to specify conditional or repeated actions, or to assign output variables to subflow data. The system provides these flow logic options.

### Available flow logic

<table>
<thead>
<tr>
<th>Flow logic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>For Each</td>
<td>Applies actions to each record in a list of records. Flow designers must specify the list of records from the subflow data.</td>
</tr>
<tr>
<td><strong>Note:</strong> You can nest a For Each flow logic block inside of another flow logic block to repeat an action over a series of records. However, avoid nested For Each loops that process many records. Nested loops may cause the flow to run until it is stopped by the flow transaction quota rule, which prevents flows from running longer than an hour. For more information about transaction quotas, see Transaction quotas.</td>
<td></td>
</tr>
<tr>
<td>If</td>
<td>Applies actions when a list of conditions is met. Flow designers can specify the conditions with subflow data. Once an If condition is added, you can add an Else or Else If flow logic option to define behavior when conditions are not met.</td>
</tr>
<tr>
<td>Assign Subflow Outputs</td>
<td>Assigns an output variable to subflow data. Only outputs defined in Inputs &amp; Outputs can be assigned a value. Assigning outputs enables you to assign a different output variable for each logical path in the subflow.</td>
</tr>
</tbody>
</table>
More Actions

Click the More Actions (⋮) button to access additional options for the subflow.

**Copy action**
Create a copy of the open subflow in an application you specify.

**Configurations**
Enable or disable the Show draft actions, Show triggered flows, Show store spokes, and Show inline script toggle options.

**Code Snippet**
Generate a code snippet for the action.

**Manage security**
Enable or disable the Callable by Client API option.

**Manage natural language title**
Create or edit a subflow title with styled or dynamic text. For more information, see Manage natural language titles.

**Testing subflows**
You can test a subflow alone, or when added to a flow. When testing a subflow alone, you must define the inputs that the subflow uses in its actions. Because a subflow does not have a trigger, testing a subflow runs the actions using the defined input values.

ℹ️ Note: Because testing a subflow creates or changes records on the instance, flow designers should always test subflows on a non-production instance containing relevant demonstration data.

**Roles**
To access subflows, a user must have the flow_designer or admin role.

**Create a subflow**
Create a reusable sequence of actions that can be added to multiple flows.

**Before you begin**
- Role required: flow_designer or admin
- Set up an application in Guided Application Creator to store Flow Designer content.
About this task
Users with the flow_designer or admin role should know the application table structure and be aware of any existing business logic associated with the target tables of a flow or subflow. Be sure to disable any conflicting business rules or workflows before creating a flow or subflow.

Creating a custom application to contain your Flow Designer content allows you to deploy it using the application repository or the ServiceNow Store.

Procedure
2. Click New > Subflow.
   The Subflow properties screen displays.
3. Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the subflow.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope to create the subflow in.</td>
</tr>
<tr>
<td>Category</td>
<td>Logical group for subflow.</td>
</tr>
<tr>
<td>Protection</td>
<td>Select whether the subflow is read-only. You can only select a value when you create the subflow in an application scope you own. The default value is None.</td>
</tr>
<tr>
<td>In-flow annotation</td>
<td>Help text that appears under the subflow title in Flow Designer to help flow designers understand what the subflow does when used in a flow.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the subflow.</td>
</tr>
<tr>
<td>Run as</td>
<td>Use this option to specify if the flow runs as system user or the user who initiates the session. Select the user who initiates the session option when updates should come from the user who triggered the flow. For example, when you want incident record comments to come from the current user, or approval emails to originate from the approver. Settings for the Run as option in a flow don't apply to child subflows. Running as the initiating user also ensures the actions taken during flow execution are limited by the user's ACL restrictions. Flows run by the initiating user will also respect user-specific settings like date/time format.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Note</td>
<td>When choosing the option to run as the user who initiates the session, ensure that your security restrictions do not prevent your users from making any changes the flow executes.</td>
</tr>
</tbody>
</table>

Run with roles
Select the roles the flow runs with. This option is only available when Run as is set to user who initiates the session.

4. Create subflow inputs to specify the data available to the subflow when it starts running.
Each input you define for a subflow becomes a configuration option in the Flow Designer interface. To use the subflow in a flow, flow designers must define a value for each mandatory input. The more inputs a subflow has, the more data flow designers must define and the more familiar they must be with the underlying data model to use the subflow effectively.

a. Click + to open the Inputs & Outputs pane.

b. Click + to add a new input.

c. Define the name and type for the input.

Note: Subflow input names can’t include any of the following reserved system names:

- `sys_id`
- `sys_created_by`
- `sys_created_on`
- `sys_updated_on`
- `sys_updated_by`
- `sys_mod_count`

d. To make the input a mandatory configuration option, select the Mandatory flag.

e. Click ‾‾‾ to view the advanced options and define values.
Inputs provide advanced options based on their data type. All inputs have advanced options to add a hint or provide a default value. Use advanced
options to guide flow designers through adding and configuring a subflow to a flow. For example, create a choice input to provide flow designers with a pre-defined list of configuration options to choose from. For more information about the configuration options available to particular data types, see field types.

5. Create subflow outputs by defining the names and data types.
Subflow outputs specify the data available to the parent flow after the subflow completes.

a. Click + to add a new output.

b. Define the name and the data type.
Output values are assigned in later steps.

Note: Subflow output names can't include any of the following reserved system names:
- sys_id
- sys_created_by
- sys_created_on
- sys_updated_on
- sys_updated_by
- sys_mod_count

6. To add actions, flows, subflows, or flow logic, click Select to add an Action, Flow Logic, or Subflow.
a. Select an option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Select the desired action. Flow Designer includes a set of Actions available to flows and subflows. Alternatively, a user with the action_designer role can create additional actions to add to flows. The IntegrationHub and spoke plugins install additional actions. To add draft actions from the More Actions menu, set <strong>Show draft actions to true</strong>. To view spokes available in the ServiceNow Store, set <strong>Show store spokes to true</strong> from the More Actions menu. <strong>Note:</strong> Under <strong>Not Installed Spokes</strong>, the system displays spokes available in the ServiceNow Store based on compatibility with the ServiceNow version and application dependency on Flow Designer.</td>
</tr>
<tr>
<td>Flow Logic</td>
<td>Select an option to specify conditional or repeated operations.</td>
</tr>
<tr>
<td>Subflow</td>
<td>Select a published subflow and define input values. In addition to adding a subflow as a flow action, you can enable the <strong>Show triggered flows</strong> option from the More Actions menu to select an activated flow and define the required inputs. Running a triggered flow ignores its trigger conditions and runs all actions.</td>
</tr>
</tbody>
</table>

To change the order of an action in a flow, drag the handle on the left side of the action to the desired location.

The system displays a set of fields depending on the option selected.

b. To configure the action, flow logic, or subflow, fill in the fields.

c. Click **Done**.

d. Repeat adding actions until complete.

7. Assign subflow outputs to a value.
   - You can assign a subflow output to multiple values, enabling you to create conditional outputs based on flow logic.
a. Under Actions, click + and select Flow Logic.

b. Click Assign Subflow Outputs.

c. In the Name field, select an output you created in the Inputs & Outputs section. You can only assign values to outputs that have already been given a name and data type.

d. In the Data field, enter a value or select a data pill from the data panel.

e. Click Done.

What to do next
Test the subflow, and publish it when it is ready to be added to a flow or called from a script.

⚠ Note: You can only test or publish subflows that contain at least one action.

Test a subflow
You can test a subflow alone, or when added to a flow. When testing a subflow alone, you must define the inputs that the subflow uses in its actions. Because a subflow does not have a trigger, testing a subflow runs the actions using the defined input values. Unless updated, subsequent tests use the same inputs defined in the initial test run.

Before you begin
Role required: flow_designer or admin
Create a subflow that contains at least one action and save it. Flow Designer only tests saved subflows that contain at least one action.

About this task
Because testing a subflow creates or changes records on the instance, flow designers should always test subflows on a non-production instance containing relevant demonstration data.

Procedure
2. Click the subflows tab and open a saved subflow.
3. Click Test.
   The Test Subflow dialog opens.
4. Define input values for the subflow to use in its actions. The values defined are remembered on future test runs.
5. Click Run Test.
Note: Select the Run test in background option to test a subflow asynchronously in the background.

If you select the Run test in background option, the execution details are displayed only after the execution is completed asynchronously in the background. Also, the execution details are associated with the subflow only after execution is completed.

6. After the flow executes, click Subflow has been executed. To view the subflow, click here.
   The Execution Details open.

What to do next
Review the Flow execution details.

Once the subflow behaves as desired, you can publish the subflow and add it to a flow.

Publish a subflow
Publish a subflow to make it available to other users and to add it to activated flows.

Before you begin
Role required: flow_designer or admin
Create a subflow, test the subflow, and verify that it is working as expected.

About this task
When you make changes to a published subflow, the changes remain in the draft state until you publish the subflow again. You must publish a changed subflow to make the changes available to activated flows.

Procedure
2. Click the subflows tab and open a tested subflow.
3. Click Publish.

Results
The subflow can be added to activated flows. If you update the subflow after it is published, you must click Publish again to see the changes when the parent flow is run. After publishing changes, all parent flows that use the subflow are automatically updated to use the current version.
Complex data

Use a graphical interface to work with collections of complex structured data. Help design users understand the organization of structured data, and add, remove, or configure its individual elements.

Complex data allows you to encode and store structured data in a machine-readable format such as JavaScript Object Notation (JSON) or eXtensible Markup Language (XML). You can use the Flow Designer interface to view and understand the organization of structured data as well as create data structures. For example, you can create a contact data structure consisting of information you look up from a user record such as first name, last name, and email address.

You can create complex data from these Flow Designer interfaces.

Complex data usage examples

<table>
<thead>
<tr>
<th>Flow Designer interface</th>
<th>Example usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action inputs and outputs</td>
<td>Create an action that generates an object from record data. Populate the object using record data the action looks up. See Create a custom action to generate an object from a record</td>
</tr>
<tr>
<td>Script step input and output variables</td>
<td>Write a script to create an array of objects from a list of records. See Create a custom action to generate an array of objects from a list of records. Write a script to parse a JSON document into an output of type Object.</td>
</tr>
<tr>
<td>Subflow inputs and outputs</td>
<td>Create a subflow that accepts an object as an input and uses it to call an external service.</td>
</tr>
<tr>
<td>XML parser step Target field configurations</td>
<td>Parse an XML payload into a complex data object using the XML parser step.</td>
</tr>
<tr>
<td>REST API Trigger Body field</td>
<td>Parse an inbound REST API request into a complex data object and use the values in a flow. See REST API trigger.</td>
</tr>
</tbody>
</table>

Benefits

Complex data offers these benefits.
• Parse and format data without having to write code. For example, create data variables to parse a response message or format a request message.

• Create arbitrary data structures. For example, create an issue data structure that combines information from existing interaction and incident records, or create a data structure to support a custom integration.

• View the organization of data structures. For example, an issue data structure might consist of a user object to describe who to contact about the issue and a history object to describe the work done to resolve it. You could configure a notification action with the path to the email address listed in the user object, and call an escalate issue subflow with the path to the status or reassign count from the history object.

• Allow access to data structure from API calls. For example, call an action or subflow from a script and use the predefined data structure as input values.

• Save and reuse data structures as templates. For example, save the user object as a template data structure for reuse in other actions and flows.

Data structure
A data structure is a collection of related data elements organized into a hierarchy. Each element in a data structure has its own data type and its own unique position in the hierarchy.

The Editor pane displays data structure hierarchy with indentation. The indentation level identifies whether an element is a parent, child, or sibling in the hierarchy. Parent elements have children indented underneath them, and siblings have the same indentation level.

⚠️ Note: The Flow Designer interface allows you to create hierarchies with an unlimited number of child levels, but you may have to scroll horizontally to see them.

For example, this data structure consists of an Employee parent element with four child elements for ID Number, Name, Start Date, and Contact Email. The Contact Email element is also a parent element with one child.
The data panel displays data structure hierarchy as a tree of collapsible and expandable data pills just like it does with record variables. Parent elements have an arrow icon to collapse or expand the hierarchy.

For example, here is the Employee data structure as seen from the data panel.

You can use the data panel or Data picker to select specific values from a data structure. Data structures are similar to data pills for records in that you can dot-walk or navigate to specific elements within the structure. When you select a data element, Flow Designer displays the path to it as a data pill just like any other data element selection. For example, if you select the Start Date data element, the path is [Input->Employee->Start Date].

You can use an element data path the same way you can an XPath or JPath. Sometimes you may even convert the data pill path into one of these path notations.
Complex data types

You build data structures using one or more Array or Object variables. Only these variable data types support child variables.

An Array variable contains values for one type of item. The parent variable is always of an Array data type, and there is always only one child variable, which is one instance of the data type supported by the array. Create Array variables when an input or output accepts multiple values of the same data type.

For example, you could create a Contact Email array to list all the email addresses associated with a given person.

Sample data structure for the Contact Email array

<table>
<thead>
<tr>
<th>Component label</th>
<th>Data Type</th>
<th>Sample Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Email</td>
<td>Array.String</td>
<td><a href="mailto:beth.anglin@example.com">beth.anglin@example.com</a> and <a href="mailto:beth@anglin.com">beth@anglin.com</a></td>
</tr>
<tr>
<td>Contact Email_child0</td>
<td>String</td>
<td></td>
</tr>
</tbody>
</table>

An Object variable contains any number and arrangement of child variables that each have their own data type and values. Nesting Object variables allows you to create complex data structures similar to a table schema where one table has related records in another table. Create Object variables when an input or output accepts one or more related properties.

For example, you can create an Employee object to define information about the people who work at a company.

Sample data structure for the Employee object

<table>
<thead>
<tr>
<th>Component label</th>
<th>Data Type</th>
<th>Sample Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>Object</td>
<td></td>
</tr>
<tr>
<td>ID Number</td>
<td>Integer</td>
<td>20190304000101</td>
</tr>
<tr>
<td>Name</td>
<td>String</td>
<td>Beth Anglin</td>
</tr>
<tr>
<td>Start Date</td>
<td>Date/Time</td>
<td>March 4, 2019</td>
</tr>
<tr>
<td>Contact Email</td>
<td>Array.String</td>
<td><a href="mailto:beth.anglin@example.com">beth.anglin@example.com</a> and <a href="mailto:beth@anglin.com">beth@anglin.com</a></td>
</tr>
</tbody>
</table>

Only these variable data types can be parents.
## Parent data types

<table>
<thead>
<tr>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array.Array</td>
<td>A container for arrays. Adds a read-only child item of type Array.</td>
</tr>
<tr>
<td>Array.True/False</td>
<td>A container for true/false values. Adds a read-only child item of type True/False.</td>
</tr>
<tr>
<td>Array.Choice</td>
<td>A container for choice values. Adds a read-only child item of type Choice.</td>
</tr>
<tr>
<td>Array.Date/Time</td>
<td>A container for date/time values. Adds a read-only child item of type Date/Time.</td>
</tr>
<tr>
<td>Array.Integer</td>
<td>A container for integer values. Adds a read-only child item of type Integer.</td>
</tr>
<tr>
<td>Array.Object</td>
<td>A container for objects. Adds a read-only child item of type Object, which displays the Add Child Item option.</td>
</tr>
<tr>
<td>Array.String</td>
<td>A container for string values. Adds a read-only child item of type String.</td>
</tr>
<tr>
<td>Object</td>
<td>A container for other data elements. Displays the Add Child Item option.</td>
</tr>
</tbody>
</table>

Array and Object variables only support these child data types.
- Array
- True/False
- Choice
- Date/Time
- Integer
- Object
- String

**Note:** The data types in array and object variables are not Glide elements. There may not be complete compatibility between these items and Now platform types.
Advanced options

Object variables have advanced options to save and load data structures. These options allow you to reuse a data structure defined in one location in another. For details on advanced options see action variable data types.

Data structure templates

Data structure templates allow you to reuse Object variables in multiple actions or subflows. For example, you can create a data structure to parse a response and then later reuse that same data structure to format a request. A template stores the list of child variables and their structure within an object. Each Object variable has an Advanced Option to save it as a template.

When you apply a template, you are creating a copy of the original structure. Any changes you make after applying a template do not affect the template, nor do they affect other actions that use the template.

Array data pills

Objects that contain array data may require For Each flow logic to process. For example, a user object that contains an array of email addresses would require a For Each flow logic loop to send a notification to each email address.

Object data pills

You can design actions that accept object data pills as input values. For example, you might create a notification action that accepts a user object as an input. If the user object consists of values for first name, last name, and addresses, then the notification action has access to all these values. To configure an action input with an object data pill, you must create an object earlier in the flow.

Sample action that accepts an object data pill
You can use an object data pill or any of its child elements to configure an input. When you configure an input value with an object data pill, Flow Designer makes any child elements of the object read-only, and the action uses the values provided by the object. For example, you can create a flow where one action generates a user object and another action sends a notification to the user specified in the object.

Sample action configured to use an object data pill

<table>
<thead>
<tr>
<th>Action</th>
<th>Complex data action</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Label</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>A = User object X</td>
</tr>
<tr>
<td></td>
<td>First name</td>
</tr>
<tr>
<td></td>
<td>Last name</td>
</tr>
<tr>
<td>Addresses</td>
<td>Drag and drop array data pill here</td>
</tr>
<tr>
<td>Address 1</td>
<td>Drag and drop array data pill here</td>
</tr>
</tbody>
</table>

When you configure the child elements of an object, you must manually provide data pills for each child element of the object. For example, you can manually configure the user object with record values from an earlier action.

**Script support**

Create and reference complex data from a script. Use a script when your source data comes from a data stream, a REST step response, or a Look Up Records step. See [Script support for complex data](#) for more information about scripting with complex data.

**Design considerations**

Follow these design guidelines to create reusable and maintainable data structures.

**Minimize the number of child levels in the hierarchy**

The more child levels a data structure has, the more difficult it is to view and select any specific data variable from the hierarchy. While you can build data structures with any number of child levels, it becomes difficult to navigate and understand data structures with more than seven child levels. For the best user experience, avoid creating data structures that have so many child levels you must scroll horizontally to see and populate them.
Create a separate object for each type of record data

Most Flow Designer data is record data whether it is from an instance or an external system. This design method ensures that you know what the object contains and where the data came from.

Recreate record data structures

When building objects that receive or transmit record data, review the database dictionary entries for these records and create matching object data structures. For example, suppose that you want an object to contain data from incident and configuration item records. You might create a string element for the incident short description field and an array of strings element for the configuration item class field.

Create objects to combine different types of records

If you need information from multiple types of records, create an object that contains all the information you need. You can then use the object to format or parse data in Flow Designer.

Create data structure

Organize multiple data variables into a structure to process them as a unit and identify the individual items within it.

Before you begin

- Role required: action_designer, flow_designer, or admin
- Set up an application in Guided Application Creator to store Flow Designer content.
- Create an action or Create a subflow

About this task

A data structure is a collection of related data elements organized into a hierarchy. Each element in a data structure has its own data type and its own unique position in the hierarchy.

Procedure

1. Create a data variable.

<table>
<thead>
<tr>
<th>Action or subflow input</th>
<th>Click Create Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action or subflow output</td>
<td>Click Create Output</td>
</tr>
</tbody>
</table>
XML parser step

2. Set **Type** to **Object**.
The top level of a data structure hierarchy must be an Object variable.

3. Click the **Add Child Item** icon.
Flow Designer adds a child data variable to the bottom of the object list.

   **Note:** You can insert a child item variable between existing variables by hovering your mouse pointer between two variables, and click the insert item icon (⁺) that appears.

   **Note:** When hovering your mouse pointer between a child and sibling variable, you will see a add child icon (⁺⁺). Click the left side of the icon to add a new sibling variable to the child's parent, or the right side to add another child variable under the current variable.

4. Set the child variable **Label** and **Type**.
To add another branch to the data structure hierarchy, set the Type to Object.

5. Repeat steps 3-4 for each data variable in the hierarchy.

**What to do next**
Use the data structure to populate action, step, or subflow inputs. If you can reuse the data structure, save it as a template.

**Save data structure**
Save the data structure of child variables within an Object variable for later reuse.

**Before you begin**
• Role required: action_designer, flow_designer, or admin
• Set up an application in Guided Application Creator to store Flow Designer content.
• Create an action or Create a subflow

**Procedure**
1. **Create data structure.**
2. Expand the Advanced options for the Object variable you want to save.
3. Click **Save as Template**.
   Flow Designer displays a pop-up dialog.
4. Enter the template name.

5. Click **Save**.
   
   If the template name already exists, Flow Designer displays a confirmation dialog to overwrite the existing template.

**What to do next**

Load the data structure in another action or subflow. Make updates to the data structure and save them.

**Load data structure**

Load a data structure of child variables within an Object variable.

**Before you begin**

- Role required: action_designer, flow_designer, or admin
- Set up an application in Guided Application Creator to store Flow Designer content.
- Create an action or Create a subflow

**Procedure**

1. Create a data variable.

2. From **Type**, select **Object**.

3. Expand the Advanced options for the Object variable whose data structure you want to replace.

4. From **Structure**, select **Start from Template**.
   
   Flow Designer displays the **Template** field.

5. From **Template**, select the template containing the template you want to load.
   
   If the Object variable has no existing data structure, Flow Designer loads the data structure into it. If the Object variable has an existing data structure, Flow Designer displays a confirmation dialog to replace the existing structure.

**Create a custom action to generate an object from a record**

Generate an object from a User record. Learn how to use an Action output to create an object from record values.

**Before you begin**

Role required: admin
About this task
Use this example to see demonstrations of these operations and steps.

• Create action inputs for the User record fields First name, Last name, and Email.
• Lookup a User record matching the action input values.
• Create an action output for a contact object.
• Save the contact object as a template.
• Map contact object values to User record field values.
• Test the action with a sample user.

Procedure
1. Create an application to store your work.
   Use the Guided Application Creator.

   Example
   For example, create My Application.

   The system displays the Flow Designer landing page.

3. Select New > Action
   The system displays the Action Properties dialog.

4. Enter these sample values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Create Contact Object From User</td>
</tr>
<tr>
<td>Application</td>
<td>My Application</td>
</tr>
<tr>
<td>Accessible From</td>
<td>All application scopes</td>
</tr>
</tbody>
</table>

5. Select Submit.
   The system displays the Action Designer interface.

6. From the Action Outline, select Inputs > Create Input
   The system displays a new action input.

7. Configure the action input with these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>First name</td>
</tr>
</tbody>
</table>
8. From the Action Outline, select **Inputs > Create Input**
   The system displays a new action input.

9. Configure the action input with these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>String</td>
</tr>
<tr>
<td>Mandatory</td>
<td>True</td>
</tr>
</tbody>
</table>

10. From the Action Outline, select **Inputs > Create Input**
    The system displays a new action input.

11. Configure the action input with these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Last name</td>
</tr>
<tr>
<td>Type</td>
<td>String</td>
</tr>
<tr>
<td>Mandatory</td>
<td>True</td>
</tr>
</tbody>
</table>

12. From Action Outline, select **Outputs > Create Output**.
    The system displays a new action output.

13. Configure the output variable with these values.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>contact</td>
<td>contact</td>
<td>Object</td>
<td>False</td>
</tr>
</tbody>
</table>

14. From the row for the contact Object, select **Add Child Item**.

15. Configure the child item with these values.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td>first_name</td>
<td>String</td>
<td>True</td>
</tr>
</tbody>
</table>
16. From the row for the contact Object, select **Add Child Item**.
17. Configure the child item with these values.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last name</td>
<td>last_name</td>
<td>String</td>
<td>True</td>
</tr>
</tbody>
</table>

18. From the row for the contact Object, select **Add Child Item**.
19. Configure the child item with these values.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email address</td>
<td>email_address</td>
<td>String</td>
<td>False</td>
</tr>
</tbody>
</table>

20. From the row for the contact Object, select **Toggle Advanced Inputs**.
21. From the Advanced Options, select **Save As Template**.
   The system displays the Save As Template dialog.
22. For **Enter a Name**, enter `contact`.
23. Click **Save**.
24. Select **Exit Edit Mode**.
   The System displays the output fields you created.
25. Configure the outputs with these values.

<table>
<thead>
<tr>
<th>Label</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td>[step-&gt;Look Up Record step-&gt;Record-&gt;First name]</td>
</tr>
<tr>
<td>Last name</td>
<td>[step-&gt;Look Up Record step-&gt;Record-&gt;Last name]</td>
</tr>
<tr>
<td>Email Address</td>
<td>[step-&gt;Look Up Record step-&gt;Record-&gt;Email]</td>
</tr>
</tbody>
</table>

*Note:* You can select data pills from the data panel or from the Data Pill Picker button.

26. Select **Save**.
27. Select **Test**.
   The system displays the Test Action dialog.
28. Enter these test values.
29. Select **Run Test**.
The system runs the action with the test values provided.

30. Select **Action has executed. To view the action, click here**.
The system displays the action execution details.

31. Review the runtime value for the action **Output data**.
The system displays output data in JSON format.

**Example**
For example, sample contact object JSON for the user Abel Tuter.

```json
{
    "contact": {
        "email_address": "abel.tuter@example.com",
        "last_name": "Tuter",
        "first_name": "Abel"
    }
}
```

**Results**
You have a custom action that looks up a User record and converts it into a contact object.

**What to do next**
Customize the action to use your own logic.

**Create a custom flow to generate an object for each record in a list**
Generate an object for each User record in a list. Learn how to use flow logic to iterate through a list of records.

**Before you begin**
- Role required: admin
- **Create a custom action to generate an object from a record**

**About this task**
Use this example to see demonstrations of these operations and steps.
• Create a flow that runs on a daily schedule.
• Look up User records filtered by the Department provided as an input.
• Add flow logic that runs for each User record you looked up previously.
• Create a contact object for each User record using the custom action you created previously.
• Create a log message for each User record.

Procedure

1. Navigate to **Process Automation > Flow Designer**.
   The system displays the Flow Designer landing page.
2. Select **New > Flow**
   The system displays the Flow Properties dialog.
3. Enter these sample values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Create Contact Objects From Users</td>
</tr>
<tr>
<td>Application</td>
<td>My Application</td>
</tr>
<tr>
<td>Run As</td>
<td>User who initiates session</td>
</tr>
</tbody>
</table>

4. Select **Submit**.
   The system displays the Flow Designer interface.
5. Select **Click to add a Trigger > Date > Daily**.
6. Select **Done** to close the trigger.
7. Select **Click to add an Action, Flow Logic, or Subflow > Action > ServiceNow Core > Look Up Records**.
   The system adds the action to the flow.
8. For **Table**, select **User [sys_user]**.
9. For **Conditions**, add these values.
   • `[Department][is][Development] [AND]
   • `[Email][is not empty]`
10. Configure these field values.
11. Select **Done** to close the action.

12. Select **Click to add an Action, Flow Logic, or Subflow > Flow Logic > For Each.** The system adds the flow logic to the flow.

13. For **Items**, select [1->User Records].

   ![Note:](Note) You can select the Action 1 **User Records** data pill from the data panel or from the Data Pill Picker button.

14. Select **Done** to close the flow logic.

15. Select the plus icon to add a child item to the For Each flow logic.

16. Select **Action > My Application > Create Contact Object.**

17. For **userRecord [User]**, select [2->User Record].

   ![Note:](Note) You can select the Action 2 **User Record** data pill from the data panel or from the Data Pill Picker button.

18. Select **Done** to close the flow logic action.

19. Select the plus icon to add a child item to the For Each flow logic.

20. Select **Action > ServiceNow Core > Log.**

21. For **Message**, select [2.1->contact].

   ![Note:](Note) You can select the Action 2.1 **contact** data pill from the data panel or from the Data Pill Picker button.

22. Select **Done** to close the flow logic action.

23. Select **Save**.

**Script support for complex data**

Create and reference complex data from a script. Use a script when your source data comes from a data stream, a REST step response, or a Look Up Records step.

Use script to create complex data when data comes from these sources.
## Data sources requiring script

<table>
<thead>
<tr>
<th>Data source</th>
<th>Create/map complex data from</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Stream action response stream</td>
<td>Script Parser step</td>
</tr>
<tr>
<td>REST step response</td>
<td>Script step</td>
</tr>
<tr>
<td>Look Up Records step</td>
<td></td>
</tr>
</tbody>
</table>

### Data Stream action response stream

Data Stream actions use a parser script to map stream item values to complex object values. When writing a parser script, use JavaScript methods appropriate to the data stream format. For example, use the JSON - Scoped class to parse or encode a JSON data stream.

Parser scripts have access to the data stream input and output objects as well as a targetObject property. See Data Stream actions for more information about parsing a response stream to create complex data.

### REST step response

You can convert a REST step response into one or more complex objects by parsing it with a Script step. To access a response from a Script step, you must create an input script variable and map it to the response payload from the prior REST step. See Script step for more information about creating script input variables.

Write a script that maps REST response values to complex object values. When writing REST response script, use JavaScript methods appropriate to the response format such as the JSON parse() method.

**Note:** When you use complex data as the source of a string input, Flow Designer automatically converts it into a JSON string.

You do not need to use a Script step to create a REST request from complex data. You can generate complex data in a prior action or step and then map it to a string input of the REST step. At run time, the action or flow converts the complex data into a JSON representation.

### Look Up Records step

While flows can use **For each** flow logic to process a list of records, actions require a Script step. The Script step replaces the **For each** flow logic with JavaScript such as a **For** or **While** loop.
To access record data from a Script step, you must create an input script variable and map it to the record data from the prior look up step. See Script step for more information about creating script input variables.

See Create a custom action to generate an array of objects from a list of records for an example action that converts a list of user records into an array of contact objects.

⚠️ Note: The Look Up Records action does not require a Script step to convert record data into complex data. You can create a custom action to convert a record into an object and apply For each flow logic to the custom action. See Create a custom action to generate an object from a record and Create a custom flow to generate an object for each record in a list for an example of creating a complex object without using script.

**Dot-walking object structures**

You can reference elements from the structure of an object by dot-walking the path of the structure. All complex data paths start with the name of the data source, which is either the global object for inputs, the global object for outputs, or the name of the array or object you created in script.

Next in the path are the names of each structural element referenced separated by period characters (also known as dots). Listing the names of structural elements is identical to dot-walking a reference field where you list the table structure to a particular reference field.

⚠️ Note: A dot-walk path always lists the name of a structural element rather than its label.

For example, suppose that you define a contact object as an Output variable. The object has the following structure.
Sample Contact object

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact</td>
<td>contact</td>
<td>Object</td>
<td></td>
</tr>
<tr>
<td>First name</td>
<td>first_name</td>
<td>String</td>
<td></td>
</tr>
<tr>
<td>Last name</td>
<td>last_name</td>
<td>String</td>
<td></td>
</tr>
<tr>
<td>Email Addresses</td>
<td>email_addresses</td>
<td>Array.Object</td>
<td></td>
</tr>
<tr>
<td>Email Address</td>
<td>email_address</td>
<td>Object</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>type</td>
<td>Choice</td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td>email</td>
<td>String</td>
<td></td>
</tr>
<tr>
<td>Telephone Numbers</td>
<td>telephone_numbers</td>
<td>Array.Object</td>
<td></td>
</tr>
<tr>
<td>Mailing Addresses</td>
<td>mailing_addresses</td>
<td>Array.Object</td>
<td></td>
</tr>
</tbody>
</table>

The dot-walk path to the **First name** structural element would be `outputs.contact.first_name` while the path to the **Email** structural element would be `outputs.contact.email_addresses[0].email` since you must specify an individual element of the array by its JavaScript index value.
Note: A dot-walk path omits the name of the repeated element within the array. For example, an array of objects does not have to specify the object element name. However, since objects are containers for other elements, you can specify a child element of the object within a dot-walk path.

Design considerations

Keep these design considerations in mind when scripting with complex data.

Use string inputs to convert complex data into a JSON string

When you map complex data to a string input, Flow Designer automatically converts it into a JSON string. Instead of writing a script, you can add a string input to a REST step and map it to complex data from a prior action or step.

Save your objects as templates

Save your objects as templates so you can reuse them in other actions, flows, and Script steps.

Create script input variables to access prior data

Create a script input variable for any data you want to access from the action input or a prior step. Map the script input variable to the input or step data pill. For example, map the script input variable to a list of user records you looked up in a prior step.

Create a script output variable to store complex data

Create a script output variable to store any complex data your script creates. The script output variable data structure, data types, and names must match the values defined in the script. For example, create a contacts array of objects to store multiple contact objects. Save the contact object as a template so you can reuse it.

Map the action output to the script output variable

When you want a custom action to output complex data, add an action output and map it to the data pill for your Script step output variable. For example, create a contacts array and load the contact object template you saved earlier. Map the action output to the contacts array produced by your Script step.

Create a custom action to generate an array of objects from a list of records

Generate an array of objects from a list of User records. Learn how to use a Script step to iterate through a list of records.
Before you begin
Role required: admin

About this task
Use this example to see demonstrations of these operations and steps.

• Create an action input for a Department record.
• Look up a maximum of three User records for the Department action input.
• Configure a Script step to process a list of User records.
• Create a script input variable containing the list of User records.
• Write script that creates an empty contacts array.
• Write script that iterates through the list of User records.
• Write script that creates a contact object and maps User record field values to the contact object.
• Write script that populates the contacts array with the current contact object.
• Create script output variables for the contacts array and child contact object.
• Save the contact object as a template.
• Output the generated contacts array of objects as a data pill.
• Test the action with a sample department.

Procedure

1. Create an application to store your work.
   Use the Guided Application Creator.

   Example
   For example, create My Application.

   The system displays the Flow Designer landing page.

3. Select New > Action
   The system displays the Action Properties dialog.

4. Enter these sample values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Create Contacts Array Of Objects</td>
</tr>
<tr>
<td>Application</td>
<td>My Application</td>
</tr>
<tr>
<td>Accessible From</td>
<td>All application scopes</td>
</tr>
</tbody>
</table>
5. Select **Submit**.
   The system displays the Action Designer interface.

6. From the Action Outline, select **Inputs > Create Input**
   The system displays a new action input.

7. Configure the action input with these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Department</td>
</tr>
<tr>
<td>Type</td>
<td>Record.Department [Reference.cmn_department]</td>
</tr>
<tr>
<td>Mandatory</td>
<td>True</td>
</tr>
</tbody>
</table>

8. From the Action Outline, select **Add a new step**.
   The system displays a list of available steps.

9. Select **Look Up Records**

10. Configure the step with these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>User [sys_user]</td>
</tr>
<tr>
<td>Conditions</td>
<td>[Department][is][action-&gt;Department]</td>
</tr>
<tr>
<td>Order by</td>
<td>Name</td>
</tr>
<tr>
<td>Sort Type</td>
<td>a to z</td>
</tr>
<tr>
<td>Max Results</td>
<td>3</td>
</tr>
</tbody>
</table>

**Note:** This example limits the **Max Results** setting to three records just for demonstration purposes.

11. From the Action Outline, select **Add a new step**.
   The system displays a list of available steps.

12. Select **Script**.

13. For **Required Runtime**, select **Instance**.

14. From the Input Variables section, select **Create Variable**.

15. Configure the input variable with these values.
### Step 16. For Script, enter the following text.

```javascript
(function execute(inputs, outputs) {
  // Create an empty array
  var contactsArray = [];
  var i = 0;
  // Iterate through the list of User records
  while (inputs.userRecords.next()) {
    // Create an empty object for each iteration
    var contactObject = {};
    // Query User records to assign object values
    contactObject.first_name = inputs.userRecords.getValue('first_name');
    contactObject.last_name = inputs.userRecords.getValue('last_name');
    contactObject.email = inputs.userRecords.getValue('email');
    // Add current object to array
    contactsArray[i] = contactObject;
    i += 1;
  }
  outputs.contacts = contactsArray;
}) (inputs, outputs);
```

### Step 17. From Output Variables, select Create Variable.

### Step 18. Configure the output variable with these values.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>contacts</td>
<td>contacts</td>
<td>Array.Object</td>
<td>True</td>
</tr>
</tbody>
</table>

### Step 19. Expand the contacts Array.Object, and rename the child item as contact.

### Step 20. From the row for the contact Object, select Add Child Item.

### Step 21. Configure the child item with these values.
<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>first name</td>
<td>first_name</td>
<td>String</td>
<td>True</td>
</tr>
</tbody>
</table>

22. From the row for the contact Object, select **Add Child Item**.
23. Configure the child item with these values.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>last name</td>
<td>last_name</td>
<td>String</td>
<td>True</td>
</tr>
</tbody>
</table>

24. From the row for the contact Object, select **Add Child Item**.
25. Configure the child item with these values.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>email address</td>
<td>email_address</td>
<td>String</td>
<td>True</td>
</tr>
</tbody>
</table>

26. From the row for the contact Object, select **Toggle Advanced Inputs**.
27. From the Advanced Options, select **Save As Template**.
   The system displays the Save As Template dialog.
28. For **Enter a Name**, enter **contact**.
29. Click **Save**.
30. From the Action Outline, select **Outputs > Create Output**.
31. Configure the Action Output with these values.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>contacts</td>
<td>contacts</td>
<td>Array.Object</td>
<td>True</td>
</tr>
</tbody>
</table>

32. Expand the contacts Array.Object.
33. From the row for the contact Object, select **Toggle Advanced Inputs**.
34. From the Advanced Options, select **Structure > Start from Template**.
   The system displays **Template**.
35. For **Template**, select the template you previously saved.
   **Example**
   For example, select **My application: contact**.
36. Select **Exit Edit Mode**.
The System displays the output fields you created.

37. For **contacts**, select **[step->Script step->contacts]**.

   **Note:** You can select the Script step **contacts** data pill from the data panel or from the Data Pill Picker button.

38. Click **Save**.

39. Select **Test**.
   The system displays the Test Action dialog.

40. Enter the following test value:

<table>
<thead>
<tr>
<th>Input</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>Development</td>
</tr>
</tbody>
</table>

41. Select **Run Test**.
   The system runs the action with the test values provided.

42. Select **Action has executed. To view the action, click here.**
   The system displays the action execution details.

43. Review the runtime value for the action **Output data**.
   The system displays output data in JSON format.

**Example**
For this example, the contacts object contains an array of contact objects with first name, last name, and email information for three users in the Development department.

```json
{
    "contacts":
        "contact": [
            {
                "email_address": "allyson.gillispie@example.com",
                "first_name": "Allyson",
                "last_name": "Gillispie"
            },
            {
                "email_address": "alva.pennigton@example.com",
                "first_name": "Alva",
                "last_name": "Pennigton"
            },
            {
                "email_address": "andrew.och@example.com",
                "first_name": "Andrew",
            }
        ]
}
```
Results
You have a custom action that looks up the Users for a given department and converts those users into an array of contact objects.

What to do next
Customize this action to use your own logic.

Flow variables
Similar to Workflow scratchpad variables, create variables that you can use and modify directly in your flow. Access flow variables as data pills directly in the Data panel.

Use flow variables to set and retrieve values throughout a flow. Flow variables are similar to subflow inputs and outputs. Both define data available to a flow or subflow. The main difference between them is when they are accessible. Flow variables are accessible throughout a flow. Inputs are only accessible at the start of a subflow, and outputs are only accessible when a subflow completes.

Creating flow variables
Create variables with the Flow Variables option on the More Actions menu. You can create several variables at a time by choosing a name and data type for each one. Flow variables appear as data pills in the Flow Variables section of the Data panel.

Assigning values to flow variables
Assign values to variables with the Set Flow Variables flow logic. Set Flow Variables has the following inputs:

• The name of the variable.
• The data value for the variable.

You can assign values to all of your variables with a single use of Set Flow Variables. Unlike other data pills, the values assigned to flow variables are mutable and can be changed at any time. Using Set Flow Variables overrides the current value of the variable. If no value is assigned to a variable, the default value is null.
Flow execution details

A summary of the Set Flow Variables flow logic appears in the execution details. The details show the name, type, configuration, and runtime values for all the variables set with the action. Execution details also provide information about the variables when they're used in actions or flow logic. In that case, it shows the type, configuration, and runtime values.

Supported data types

Flow Designer supports the following data types for flow variables:

- Integer
- JSON
- Reference
- String
- True/False

Create a flow variable

Create a flow variable to store and retrieve a value throughout a flow.

Before you begin

Role required: flow_designer or admin

Procedure

2. Click New > Flow.
3. On the Flow Properties form, fill in the fields. For more information, see Create a flow.
4. Click Submit.
5. Click the more actions icon (⋯) and select Flow Variables.
6. In the upper-right side of the Flow Variables form, click the plus icon (+) to create a variable.
7. On the form, fill in the fields.

Flow Variables form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Unique label for the variable. It can consist of any text. The label is visible to the user.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Name</td>
<td>Unique name for the variable. Displays the name used to identify the variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters. The name is not visible to the user, it's what the system uses behind-the-scenes.</td>
</tr>
<tr>
<td>Type</td>
<td>Data type for the variable.</td>
</tr>
</tbody>
</table>

8. Click **Save**.

**Results**
The Data panel displays the variable in the Flow Variables section. It appears as a data pill, with its name and type.

**What to do next**
To assign a value to the variable, use the **Set Flow Variables flow logic**. If you don’t assign a value, the default value is null.

**Flow error handler**
Enable flows to catch errors. Run a sequence of actions and subflows to identify and correct issues. For example, have flows log output values, send notifications, and run corrective subflows when they produce an error.

**Benefits**
Enable a flow error handler to gain these benefits.

- Automate the identification of flow errors as they happen. Capture and push flow error information rather than manually search for issues caused by flow errors.
- Automate the resolution of flow errors. Run actions and subflows to update records rather than manually updating records affected by flow errors.
- Build your own action error handling logic. Specify when actions return an error rather than always return an error.
Flow error handling consists of these components.

1. **Error Handler switch**
   Option to enable or disable flow error handling. When enabled, the flow displays the Error Handler section.

2. **Error Handler section**
   Section of flow that runs when the flow catches an error. Use this section to automate the identification and resolution of flow errors. You can add up to 10 items in this section.

   Note: The 10-item limit includes any combination of actions, flow logic, or subflows.

3. **Error Status**
   Object data pill containing details about the error caught by the flow.
4. Error Status > Code

Integer data pill indicating whether the flow produced an error. By default, a value of 1 indicates that the flow produced an error. A value of 0 indicates that the flow ran successfully. You can define your own error codes when you create a custom action.

5. Error Status > Message

String data pill containing the error message produced by the action, step, or system operation.

Available error states

Enabling the Error Handler changes the states reported in the flow execution details. The Error Handler can produce these flow states.

Completed (error caught)

State generated when the flow caught an error and successfully ran the items in the Event Handler section. The flow generates this state even when the Event Handler section is empty. This state is only available when you enable a flow Error Handler. This state is only visible from a flow execution details page. Flow context records instead display the state as **Complete**.

Completed (error skipped)

State generated when a custom action continues running after a step failure. When an action generates this state, it passes it to the parent flow. This state is only available when you enable a flow Error Handler. This state is only visible from a flow execution details page. Flow context records instead display the state as **Complete**.

Error

State generated when an error remains uncaught.

- An error occurs in the flow while the Error Handler is disabled
- An error occurs in the Error Handler section

Design considerations

Follow these guidelines to achieve the benefits offered by flow error handling.

Avoid adding error handling items to the main section of the flow

A flow normally stops running when an action or subflow returns an error in the main section. A stopped flow cannot run any actions or subflows past the point where it returned an error. Adding error handling actions and subflows to the Error Handler section ensures they run when there is an error.
Capture Error Status information

The Error Status object contains information about the action that produced an error. You can use this information to identify the cause of the error as well as record data that may need correction.

Suppress subflow error messages

You can enable the Error Handler for a subflow to prevent its errors from cascading to a parent flow. Leaving the subflow Error Handler section empty ensures that it always generates the Completed (error caught) state.

Use subflows to avoid the 10-item limit

Rather than force your error-handling-process to fit within a 10-item limit, call subflows, which can contain many more items. You can also use the subflow outputs to trigger automation in other flows.

Use subflows to take corrective actions

Rather than recreate the same sequence of actions in multiple flows, create reusable subflows to correct errors to your record data. When a flow error leaves your record data in an undesired state, use subflows to correct these records. You can use the error handler to identify such record data as a subflow output.

Add an error handler to a flow

Run a sequence of actions and subflows when your flow catches an error.

Before you begin

Role required: flow_designer or admin

About this task

A flow error handler allows your flow to catch an error and run a set of actions, flow logic, and subflows. Enable a flow error handler when you want to identify and correct issues caused by flow errors.

Important: A flow error handler cannot resume or restart a flow that produces an error.

Procedure

2. Create a flow or open an existing flow.
3. Enable the ERROR HANDLER switch.
   Flow Designer adds an Error Handler section to the flow and the Data pane.
4. Add actions, flow logic, or subflows to the Error Handler section.
You can add up to 10 actions, flow logic, or subflows to this section. Consider calling a subflow to capture error information or correct issues with record data.

The **Error Status** object contains information about the flow error. You can also use the **Action Status** object returned by each action to build conditional logic.

5. Add a custom action to the main body of the flow that throws an error. See **Create a custom action to throw an error** for an example action.

6. **Test your flow** to ensure that the error handler works as expected.

7. When your flow error handling is working as expected, remove the custom action that throws an error from your flow.

**Results**

Your flow runs the actions, flow logic, and subflows you specify when the flow produces an error. The flow execution details display the state **Completed (error caught)** for both the flow and the action that returned an error.

**Create a custom action to throw an error**

Create an action that intentionally throws an error to test flow error handling.

**Before you begin**

Role required: flow_designer, action_designer, or admin

**About this task**

This custom action throws an error when the action input value is set to 1. Any other input value allows the action to run without throwing an error. You can add this custom action to a flow to test flow error handling.

**Procedure**

1. **Navigate to Process Automation > Flow Designer.**
   The system displays the Flow Designer landing page.

2. **Select New > Action**
   The system displays the Action Properties dialog.

3. Enter these sample values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Throw an error</td>
</tr>
<tr>
<td>Application</td>
<td>Global</td>
</tr>
</tbody>
</table>
4. Select **Submit**.
The system displays the Action Designer interface.

5. From the Action Outline, select **Inputs > Create Input**
The system displays a new action input.

6. Configure the action input with these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessible From</td>
<td>All application scopes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Error Code</td>
</tr>
<tr>
<td>Type</td>
<td>Integer</td>
</tr>
<tr>
<td>Mandatory</td>
<td>True</td>
</tr>
</tbody>
</table>

7. From the Action Outline, select **Add a new step**.
The system displays a list of available steps.

8. Select **Script step**.

9. From the **Input Variables** section, select **Create Variable**.

10. Configure the variable with these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>code</td>
</tr>
<tr>
<td>Value</td>
<td>Select the data pill [action-&gt;Error Code]</td>
</tr>
</tbody>
</table>

11. In **Script**, enter this JavaScript code.

```javascript
(function execute(inputs, outputs) {
  if (inputs.code == 1) {
    throw 'My custom error message'
  }
})(inputs, outputs);
```

12. Click **Save**.
13. Select **Test**.
   The system displays the Test Action dialog.

14. Enter the following test value:

<table>
<thead>
<tr>
<th>Input</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Code</td>
<td>1</td>
</tr>
</tbody>
</table>

15. Select **Run Test**.
   The system runs the action with the test values provided.

16. Select **Your test has finished running. View the action execution details**.
   The system displays the action execution details.

17. Verify that the action ran the Script step and threw your custom error message.
   The **Action Status** object should list an error on line 3 and display the text of your custom error message.
18. Close the action execution details.

19. Select **Cancel** to stop testing the action.

20. Select **Publish** to make your custom action available to your flows.

**Results**

You have a custom action that throws an error when you set the action input **Error Code** to 1.

**What to do next**

Add this action to a flow to test the contents of the Error Handler section.

**Inline scripts**

Enable users with coding experience to write inline scripts that set and modify input values during the configuration of an action or flow. Use inline scripts to modify input values that require small format conversions, data transformations, or math operations.

Flow Designer displays a Script button when you configure these components.

- Action instance inputs when you configure the action for a flow
- Action instance outputs when you configure the action for a flow
- Flow logic inputs when you configure the flow logic for a flow
• Flow logic outputs when you configure the flow logic for a flow.
• Step inputs when you configure the step for an action.
• Subflow inputs when you configure the subflow for a flow.
• Subflow outputs when you configure the subflow for a flow.

Inline scripts must return values in the same data type as the input expects. For example, an inline script for a Record input must return a GlideRecord object and an inline script for a Date input must return a date-time value. Always test actions and flows containing inline scripts, and verify that there are no runtime errors in the flow execution details.

Script writers should be familiar with Now Platform table structures and field types. In addition, they should know how to work with record and system data using the ServiceNow API.

**Benefits**

Inline scripts offer these benefits.

• Enable simple data conversion or transformation without having to create custom actions or flows.
• Identify which input data a script affects.
• Restricted access to scripting features to users or groups who are knowledgeable with the available ServiceNow APIs.

**Access to inline script**

You can grant users access to online scripting by either granting them the flow_designer_scripting role or the Allow Scripting delegated development permission. Both the role and the developer permission display a script button field for each Flow Designer input.

**Script button**

When you enable a user to create inline scripts, Flow Designer displays a script button next to flow and step inputs.
Clicking the **Script** button opens the Script editor, which replaces the standard input interface. Enter a script to compute the input value. Script writers can use the `fd_data` object to access data from previous actions and steps. Ensure your script includes a `return` statement with the results of your script. For example, `return shortDesc;` returns the value of the `shortDesc` variable.

Clicking the **Collapse Script** button hides the Script editor and displays a read-only version of the input. Clicking the **Expand Script** button displays the Script editor and allows you to edit the script.
Design considerations

Follow these design guidelines to create reusable and maintainable inline scripts.

Write inline script for small non-reusable logic

Use inline script to format or modify the data for specific inputs and use cases. For reusable logic, create an action or subflow instead.

Create custom actions or subflows for reusable code rather than inline script

Create custom actions or subflows for reusable or complex data logic such as changing the data type of source data. You may also want to provide custom actions or subflows for flow designers who are not comfortable with code.

Avoid duplicating action and flow functionality

Avoid writing inline script that duplicates action and flow functionality. For example, rather than write inline script to perform record operations, use the create and update record baseline actions.

Avoid data type changes

Avoid runtime errors by verifying that your inline script provides information in the same data type as the input or output expects.

Create variables by declaring them with the var keyword

Use the var keyword to declare variables so that they remain within the proper JavaScript scope. When you create a variable by assigning it a value, JavaScript may attach it to the global object, which can result in variable values persisting outside of the local scope and causing errors.

Process records outputs with For Each flow logic and the flow data object

Inline script can only access the records output of a Look Up Records action from For Each flow logic. Add a Look Up Records action to the flow to generate the records output. Add a For Each flow logic to the flow to process each record in the records output. Create an inline script reference to the For Each flow logic using the fd_data and item objects. For example, this reference assumes the For Each flow logic is the second item in your flow outline fd_data._2__for_each.item.

Use type ahead suggestions to generate references to flow and action data.

Create references to flow and action data using the fd_data object. The script editor displays type ahead suggestions for existing
flow and action data when you type \texttt{fd\_data}. Select a suggestion to build references to flow and action data.

\textbf{Note:} Refer to record data in a For Each flow logic using the \texttt{item} object.

\section*{Licensing considerations}

Inline scripts that call integration APIs are subject to IntegrationHub licensing.

\section*{Code editor}

The code editor provides text editor support for inline scripts.

The code editor has these features for the supported language services and scripts.

- Syntax coloring, indentation, line numbers, and automatic creation of closing braces and quotes
- Auto-suggestions and auto-completions

\section*{Editing tips}

- To insert a fixed space anywhere in your code, press Tab.
- To indent a single line of code, click in the leading white space of the line and then press Tab.
- To indent one or more lines of code, select the code and then press Tab. To decrease the indentation, press Shift+Tab.
- To remove one tab from the start of a line of code, click in the line and press Shift+Tab.
- To declare variables, use the \texttt{var} keyword so that they remain within the proper JavaScript scope.
Action Designer

Automate a task with a sequence of related steps such as lookup a record, create a record, and log details about the record creation. Actions separate complexity from the Flow Designer environment, enabling flow designers to add actions to multiple flows with minimal configuration.

Using Action Designer, you can:

• Create application-specific actions with pre-set configuration details, enabling process analysts to easily add actions to a flow with little configuration.
• Create scripted actions that appear code-less when added to a flow.
• Build integrations using IntegrationHub.

Core actions

Core actions that come with your instance cannot be viewed or edited from the Action Designer interface. Some applications include spokes which include application-specific actions. Spoke actions are typically read-only but can be copied and customized.

Custom actions

Unlike core actions where flow designers must manually configure flow logic, custom actions always use the same configuration when added to a flow. If your flow designers often use an action with the same configuration, you might create a reusable action.

A reusable action includes these components.

Inputs

Inputs are data variables used in your action. For example, if an action step creates a record in the incident table, your input might be a reference to the incident table. Once added as an input, the table and its fields are available to steps and outputs in the flow.

Each input you define for an action becomes a configuration option in the Flow Designer interface. To use the action in a flow, flow designers must define a value for each mandatory input. The more inputs an action has, the more data flow designers must define and the more familiar they must be with the underlying data model to use the action effectively.

Inputs provide advanced options based on their data type. All inputs have advanced options to add a hint or provide a default value. Use advanced options to guide flow designers through adding and configuring an action to a flow. For example, create
a choice input to provide flow designers with a pre-defined list of configuration options to choose from. For more information about the configuration options available to particular data types, see field types.

**Action steps**

An action step or step is a single reusable operation within an action. For example, the **Create Record** step allows action designers to specify the table and field values to use during record creation. Action steps require subject matter expertise with application tables, fields, and business logic. Application developers or IT generalists add action steps to actions from the Action Designer design environment. Flow Designer provides a set of ServiceNow core action steps to automate Now Platform processes. You can add application-specific action steps by activating the associated spoke.

**Outputs**

Outputs are data variables that represent the results of the action. These results are available to other actions in a flow.

**Action Designer design environment**

Create and edit actions by defining inputs and adding action steps. Test actions to verify if they complete successfully and review the runtime values they generate. Copy actions to use existing actions as templates. Publish actions to activate them, which makes them available to activated flows and to preserve their current action steps, variables, and sequence as a snapshot separate from further configuration changes.

**More Actions**

Click the More actions icon (⋯) to access additional options for the action.

**Copy action**

Create a copy of the open action in an application you specify.

**Configurations**

Enable or disable the **Show inline script toggle** option.
Code Snippet
Generate a code snippet for the action.

Manage security
Enable or disable the Callable by Client API option.

Manage natural language title
Create or edit an action title with styled or dynamic text. For more information, see Manage natural language titles.

Testing actions
After adding inputs and action steps, users with the action_designer or admin role can test an action. To test an action, provide the required inputs. Action designers should always test actions on non-production instances containing relevant demonstration data because testing an action can make significant changes to records on your instance.

Roles
To create custom actions, you must have the action_designer or admin role.

Getting started with actions
Transform the Ask for Approval action into a reusable action that always requires manager approval.

Before you begin
Role required: admin

Note: While Action Designer is designed to use the action_designer and delegated_developer roles in most scenarios, this tutorial uses the admin role to illustrate functionality without requiring additional roles to set up records and approve requests.

Complete the steps in Getting started with flows. This tutorial replaces the Ask for Approval action in the Expense Approval flow.

About this task
Actions are made up of:
• Inputs: Data variables used in your action.
• Steps: Operations on the inputs or results from a prior step that generate data that can be used in later steps.
• Outputs: Data variables that represent the results of the action. These results are available to other actions in a flow.

Unlike the core Ask for Approval action where flow designers must manually configure the approval rules, this custom action always uses the same approval rules when added to a flow. You might create a reusable action if your flow designers often use an action with the same configuration. For example, if your flow designers always use the request manager approval and due date options, this action automatically uses them and therefore requires less flow configuration.

Demonstrates creating actions within a flow in the Flow Designer, and testing a flow.

Procedure


2. Create an action.
   a. Click Create Application File.
   b. Under Flow Designer, select Action and click Create.
   c. In the Name field, enter Ask for Manager Approval.
   d. In the Description field, enter Approve or reject a request based on manager approval or rejection. Allow manual approvers to be added.
   e. Click Submit.
   An Ask for Manager Approval action is created in the Expenses Getting Started scope.

3. Define the inputs in the Ask for Manager Approval action.
a. Select + Create Input and add the following values.

- Name: **Request**
- Type: **Reference**
- Reference Table: **Expenses [x_expenses_getting_expenses]**

This input enables you to reference any field or record from the Expenses table. Use the data pills on the right-hand side to add the record or its fields to action steps.

4. Add an Ask for Approval step.

   a. Click the + underneath Inputs in the Action Outline.

   b. Select Ask for Approval.

   c. Complete the fields in the Ask for Approval step.

      - Record: Under the Input Variables category, drag the [Request] data pill from the right-hand pane.
      - Table: Set to Expenses [x_expenses_getting_expenses].
      - Approval Field: Set to Approval.
      - Journal Field: Set to Approval history.
d. Define rules in the Ask for Approval step. You can use the data pill picker, or drag the data pills from the right-hand pane to select the data you need.

- **[Approve]** when **[Anyone approves]** from the field **[action->Requested for->Manager]**. [OR]
- **[Anyone approves]** from the field **[Manual User(s)]**.

Select **Add another OR rule set** to define rejection rules:

- **[Reject]** when **[Anyone rejects]** from the field **[action->Requested for->Manager]**. [OR]
- **[Anyone rejects]** from the field **[Manual User(s)]**.

![Rules diagram]

e. Define a due date in the Ask for Approval step.

- **[Approve]** if pending by **[Relative date] [1][Days]** from **[action->Created]**.
- Days schedule **[8-5 weekdays excluding holidays]**.

This due date automatically approves all requests that have not been approved or denied within one day from when the request was created.

![Due Date diagram]

5. Define the outputs in the Ask for Manager Approval action. Adding an output makes data available to a flow. For example, this action outputs the approval state of the record.
a. Select + Create Outputs and add the following values.

- **Name:** Approval state
- **Value:** In the right-hand pane, expand the **Ask for Approval step** category and drag the [Approval State] data pill.

b. Click **Save**.

6. Add a custom icon for your application that displays in Flow Designer. All actions in the application scope use the custom icon.

a. In Studio, navigate to **File > Settings**. The application settings open.

b. In the **Logo** field, select **Click to add**....

c. Upload an icon to use with your reusable actions.

7. Test the reusable action within your flow.

a. Return to the Expense Approval flow.

b. Remove the 2.1 Ask for Approval action from the flow. This action will be replaced by the reusable Ask for Manager Approval action.

c. Set **Show draft actions** to true.

d. Add the Ask for Manager Approval action to your flow.

e. In the right-hand pane, expand the **Trigger - Record Created** category and drag the [Expenses Record] data pill into the **Request [Expenses]** field.
8. Click **Save**.

9. Test the flow using a record with an amount below the designated limit.

   a. From the flow, click **Test**.
      
      The Test flow modal appears.

   b. In the **Record** field, select a record you created in earlier steps that has value in the **Amount** field under the 100.00 limit. Verify that you have not already run tests using this record.

   c. Select **Run Test**.

   d. After the flow executes, click **Flow has been executed. To view the flow, click here**.
      
      The Execution Details open.

      Because the amount is less than 100.00, the first condition is met and the request is approved. The Else condition is not evaluated.
10. Test a record with an amount over the designated limit. Verify that you have not already run a test on the test record. Because the amount is over the designated limit, the second condition is evaluated.

11. Approve the request.

   a. Navigate to the test record and change the value of the State field in the Approvers related list to Approved.

   b. Navigate back to the flow execution details and refresh the browser.
Because the request is approved, the flow completes.

12. Navigate to the Ask for Manager Approval action and click Publish. Publishing an action enables you to activate any flow that uses it.

13. Navigate to the flow and set Show draft actions to false.

14. Click Activate. Activating a flow sets it to run every time the trigger conditions are met.

Results
The Expense Approval flow runs every time a record is created in the Expenses table. Now that the flow is activated and working as expected, you can publish it to the application repository and deploy it to other instances.

Create an action
Create a reusable component to automate one or more steps of a process.

Before you begin
- Set up an application in Guided Application Creator to store Flow Designer content.
- Role required: flow_designer, action_designer or admin

About this task
Action designers should know the application table structure and be aware of any existing business logic associated with the target tables of an action. Be sure to disable any conflicting business rules or workflows before creating an action.

Creating a custom application to contain your Flow Designer content enables you to deploy it using the application repository or the ServiceNow Store.
Procedure

1. Navigate to **Process Automation > Flow Designer**.
2. Click the **Actions** tab and select **New Action**.
3. Fill in the Action Properties and click **Submit**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for your action.</td>
</tr>
<tr>
<td>Accessible From</td>
<td>Accessible from all application scoped or only within the specified application scope.</td>
</tr>
<tr>
<td>Category</td>
<td>Defined category within the application scope for an action.</td>
</tr>
<tr>
<td>Protection</td>
<td>Select whether the action is read-only. You can only select a value when you create the action in an application scope you own. The default value is None.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the action.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the action.</td>
</tr>
<tr>
<td>In-Flow Annotation</td>
<td>Help text that appears under the action title in Flow Designer to help flow designers understand what the action does when used in a flow.</td>
</tr>
</tbody>
</table>

An empty action opens.

4. Define action inputs to make data available to the action steps and outputs.

   **a. Select + Create Input** and complete the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the input. This value is used as the name of the data pill in the right-hand pane.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Action input names can't include any of the following reserved system names:</td>
</tr>
<tr>
<td></td>
<td>• sys_id&lt;br&gt;• sys_created_by&lt;br&gt;• sys_created_on&lt;br&gt;• sys_updated_on&lt;br&gt;• sys_updated_by&lt;br&gt;• sys_mod_count</td>
</tr>
<tr>
<td>Type</td>
<td>Data type of the input. For supported data types, see Action input and output data types.</td>
</tr>
<tr>
<td>Reference Table</td>
<td>Reference table for the data type. Only required for the following data types:&lt;br&gt;• Records&lt;br&gt;• Reference</td>
</tr>
<tr>
<td>Advanced options</td>
<td>Inputs provide advanced options based on their data type. All inputs have advanced options to add a hint or provide a default value. Use advanced options to guide flow designers through adding and configuring an action to a flow. For example, create a choice input to provide flow designers with a pre-defined list of configuration options to choose from. For more information about the configuration options available to particular data types, see field types.</td>
</tr>
<tr>
<td></td>
<td>Click to view the advanced options and define values.</td>
</tr>
</tbody>
</table>

Inputs are represented as data pills in the right-hand pane. You can add inputs to steps and outputs in the flow by dragging and dropping data pills.

5. **Add an action step to perform an operation on the action inputs.**
   a. Click the + underneath Inputs in the Action Outline.
   b. Select the step you would like to perform.
   c. Complete the fields in the step.

6. **For If this step fails**, select the action error evaluation behavior you want the step to take.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop the action and go to error evaluation</td>
<td>Stop running the action at the current step and go to error evaluation. The Step Status object contains the error information returned by the step.</td>
</tr>
<tr>
<td>Don’t stop the action and go to the next step</td>
<td>Ignore the failure and continue running the action from the next step. The Step Status object contains the error information returned by the step. Action error evaluation runs regardless of whether the action continues running.</td>
</tr>
</tbody>
</table>

7. Add action outputs to make data available to a flow.

a. Select + Create Outputs and complete the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the output. This value is the name of the data pill in the right-hand pane when the action is added to a flow.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Action output names can’t include any of the following reserved system names:</td>
</tr>
<tr>
<td></td>
<td>• sys_id</td>
</tr>
<tr>
<td></td>
<td>• sys_created_by</td>
</tr>
<tr>
<td></td>
<td>• sys_created_on</td>
</tr>
<tr>
<td></td>
<td>• sys_updated_on</td>
</tr>
<tr>
<td></td>
<td>• sys_updated_by</td>
</tr>
<tr>
<td></td>
<td>• sys_mod_count</td>
</tr>
<tr>
<td>Value</td>
<td>Data used previously in the action either in a step or input. Adding a variable to the output makes the value available to the flow.</td>
</tr>
</tbody>
</table>

8. Click Save.
Action Designer saves a draft of the action.
What to do next
Test the action until it is ready to be published.

ℹ️ Note: By default, the system only runs published actions.

Test an action
Test an action before publishing it for other users.

Before you begin
• Create an action and save it.
• Role required: flow_designer, flow_operator, action_designer, or admin.

About this task
A user with the flow_designer role should always test actions on non-production instances containing relevant demonstration data because testing an action creates or changes records on the instance.

Procedure
2. Click the Actions tab and select the action that you want to test.
3. Click Test.
   The system displays the Test Action dialog box.
4. Fill in the fields for the action.
   ℹ️ Note: Complete all mandatory fields in the Test Action dialog box.
5. Click Run Test.
   ℹ️ Note: Select the Run test in background option to test an action asynchronously in the background.
   If you select the Run test in background option, the execution details are displayed only after the execution is completed asynchronously in the background.

What to do next
Click Action has been executed. To view the action, click here to view the action execution details. See Flow execution details for information about the executions.

ℹ️ Note: Users must have the flow_operator or admin role to view the executions.
Action input and output data types

The inputs and outputs of an action are variables. Each variable has a data type that determines what data it stores and its advanced configuration options.

Data variables available in Action Designer

Inputs are displayed as data pills in the Input Variables section of the Data pane. Outputs are listed as data pills in the Output Variables section of the Data pane.

Sample Action Designer data panel

Each data pill consists of a label and a data type description. For example, the Incident input uses the Record data type to store an incident Sys ID. The Problem output uses the Record data type to store a problem Sys ID. You can expand data pills to see the contents and hierarchy of any child elements.

Data variables available in Flow Designer

Only action outputs are displayed as data pills in the Data pane. Output data pills are associated with the action that created them.

Supported variable data types

Flow Designer supports variable data types for Now Platform record data and complex data. Variables that store record data must have a data type matching the Now Platform field type of the record. Variables for complex data must match the type of complex data stored, either an array or an object.

Approval rules data type

Store the conditions for approving or rejecting an approval requests.
Basic options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of data stored by the data variable.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Indicates whether the data variable must contain a value when configured in an action.</td>
</tr>
</tbody>
</table>

Advanced options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Default value</td>
<td>Specifies the value used when a flow or action designer does not provide a value.</td>
</tr>
</tbody>
</table>

Design considerations

Provide a default value

Create or select an approval rule as a default value.

Array. Boolean data type

Store a sequence of true or false values in an array.

Basic options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters.</td>
</tr>
</tbody>
</table>
### Advanced options for Array variables

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Max rows</td>
<td>Specifies the maximum number of entries to display in the Flow Designer interface. The array can store more values than it displays.</td>
</tr>
</tbody>
</table>

### Advanced options for Boolean variables

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Default value</td>
<td>Specifies the value used when a flow or action designer does not provide a value.</td>
</tr>
</tbody>
</table>

### Array Choice data type

Store a sequence of choice list values in an array.

### Basic options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters.</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
Type | Indicates the type of data stored by the data variable.
Mandatory | Indicates whether the data variable must contain a value when configured in an action.

### Advanced options for Array variables

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Max rows</td>
<td>Specifies the maximum number of entries to display in the Flow Designer interface. The array can store more values than it displays.</td>
</tr>
</tbody>
</table>

### Advanced options for Choice variables

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls.</td>
</tr>
<tr>
<td>Max length</td>
<td>Specifies the maximum length a user can enter for a choice value. Use this option to restrict the length of input values stored during action design.</td>
</tr>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
</tbody>
</table>
| Choice | Specifies whether the choice list has a value for no selection. Options include:  
  • Dropdown with --None--  
  • Dropdown without --None--  
  
  **Note:** The *Dropdown with --None--* option requires selecting a default choice. |
| Default | Specifies the choice used when a flow or action designer does not select a choice. |
| Choices | Specify the choices available to select. Use the add button (⁺) to create a choice. Each choice must have a **Name**, **Value**, and **Order**. See [Choice list field type](#) for more information about choice lists. |
Array.Datetime data type
Store a sequence of date-time values in an array.

Basic options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of data stored by the data variable.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Indicates whether the data variable must contain a value when configured in an action.</td>
</tr>
</tbody>
</table>

Advanced options for Array variables

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Max rows</td>
<td>Specifies the maximum number of entries to display in the Flow Designer interface. The array can store more values than it displays.</td>
</tr>
</tbody>
</table>

Advanced options for Datetime variables

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Default value</td>
<td>Specifies the value used when a flow or action designer does not provide a value.</td>
</tr>
</tbody>
</table>

Array.Integer data type
Store a sequence of numeric integer data in an array.
## Basic options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of data stored by the data variable.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Indicates whether the data variable must contain a value when configured in an action.</td>
</tr>
</tbody>
</table>

## Advanced options for Array variables

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Max rows</td>
<td>Specifies the maximum number of entries to display in the Flow Designer interface. The array can store more values than it displays.</td>
</tr>
</tbody>
</table>

## Advanced options for Integer variables

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Default value</td>
<td>Specifies the value used when a flow or action designer does not provide a value.</td>
</tr>
</tbody>
</table>

## Array/Object data type

Store a sequence of JavaScript objects in an array.
## Basic options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of data stored by the data variable.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Indicates whether the data variable must contain a value when configured in an action.</td>
</tr>
</tbody>
</table>

## Advanced options for Array variables

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Max rows</td>
<td>Specifies the maximum number of entries to display in the Flow Designer interface. The array can store more values than it displays.</td>
</tr>
</tbody>
</table>

## Advanced options for Object variables

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structure</td>
<td>Specifies how to structure the object hierarchy. Options include:</td>
</tr>
<tr>
<td></td>
<td>• Create Structure Manually</td>
</tr>
<tr>
<td></td>
<td>• Start from Template</td>
</tr>
<tr>
<td>Note:</td>
<td>Creating the structure manually enables the <strong>Save as Template</strong> option. Starting from a template enables the <strong>Template</strong> option</td>
</tr>
<tr>
<td>Save as Template</td>
<td>Stores a manually created object structure for later reuse.</td>
</tr>
<tr>
<td>Template</td>
<td>Specifies the existing object structure to apply to this object.</td>
</tr>
</tbody>
</table>
Array.String data type

Store a sequence of alphanumeric text values in an array.

**Basic options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of data stored by the data variable.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Indicates whether the data variable must contain a value when configured in an action.</td>
</tr>
</tbody>
</table>

**Advanced options for Array variables**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Max rows</td>
<td>Specifies the maximum number of entries to display in the Flow Designer interface. The array can store more values than it displays.</td>
</tr>
</tbody>
</table>

**Advanced options for String variables**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max length</td>
<td>Specifies the maximum length a string value can have when entered from the user interface. The variable can store longer strings than it can display.</td>
</tr>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Default value</td>
<td>Specifies the value used when a flow or action designer does not provide a value.</td>
</tr>
</tbody>
</table>
Choice data
Store choice list values for a specific choice field.

Basic options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of data stored by the data variable.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Indicates whether the data variable must contain a value when configured in an action.</td>
</tr>
</tbody>
</table>

Advanced options for Choice variables

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls.</td>
</tr>
<tr>
<td>Max length</td>
<td>Specifies the maximum length a user can enter for a choice value. Use this option to restrict the length of input values stored during action design.</td>
</tr>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
</tbody>
</table>
| Choice  | Specifies whether the choice list has a value for no selection. Options include:  
  * Dropdown with --None--  
  * Dropdown without --None--  

  **Note:** The Dropdown with --None-- option requires selecting a default choice. |
<p>| Default | Specifies the choice used when a flow or action designer does not select a choice. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choices</td>
<td>Specify the choices available to select. Use the add button (➕) to create a choice. Each choice must have a <strong>Name</strong>, <strong>Value</strong>, and <strong>Order</strong>. See <a href="#">Choice list field type</a> for more information about choice lists.</td>
</tr>
</tbody>
</table>

**Conditions data type**
Store a set of conditions for a specific type of record.

**Basic options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of data stored by the data variable.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Indicates whether the data variable must contain a value when configured in an action.</td>
</tr>
</tbody>
</table>

**Advanced options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Default value</td>
<td>Specifies the value used when a flow or action designer does not provide a value.</td>
</tr>
</tbody>
</table>

**Datetime data type**
Store date-time values.
Basic options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of data stored by the data variable.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Indicates whether the data variable must contain a value when configured in an action.</td>
</tr>
</tbody>
</table>

Advanced options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Default value</td>
<td>Specifies the value used when a flow or action designer does not provide a value.</td>
</tr>
</tbody>
</table>

Integer data type

Store numeric integer data.

Basic options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of data stored by the data variable.</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
Mandatory | Indicates whether the data variable must contain a value when configured in an action.

Advanced options

| Option | Description |
--- | --- |
| Hint | Provides guidance to flow or action designers on how to configure the data. |
| Default value | Specifies the value used when a flow or action designer does not provide a value. |

List.[Table] data type
Stores a list of record Sys IDs associated to a specific table. This variable is intended to store the contents of a Now Platform List field.

Basic options

| Option | Description |
--- | --- |
| Label | Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text. |
| Name | Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters. |
| Type | Indicates the type of data stored by the data variable. |
| Mandatory | Indicates whether the data variable must contain a value when configured in an action. |

Advanced options for List variables

| Option | Description |
--- | --- |
<p>| Hint | Provides guidance to flow or action designers on how to configure the data. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default value</td>
<td>Specifies the value used when a flow or action designer does not provide a value.</td>
</tr>
<tr>
<td>Add [Record Label]</td>
<td>Select one or more records to include as default values for the list. If you filter the list with a reference qualifier, you can only select records that match the reference qualifier conditions.</td>
</tr>
<tr>
<td>Reference qualifier conditions</td>
<td>Select the filter conditions applied to the list of records. Flow designers can only select records that match the reference qualifier conditions.</td>
</tr>
</tbody>
</table>

**Design considerations**

**Add a reference qualifier to filter list records**

Filter the records the list variable displays as valid options by adding a reference qualifier. The reference qualifier acts as a mandatory list filter and causes the list variable to only display records that match the reference qualifier conditions. For example, to only displays active incident records add the reference qualifier condition `[Active][is][true]`.

**Avoid selecting default records for actions intended for ServiceNow Store**

Avoid selecting default records for a list unless you know all instances will have access to the selected records. Spoke developers typically do not have access to the data of the customers who install their custom action. You may need to provide any default records as demo data if you intend to publish a custom action on the ServiceNow Store.

**Use List variables in For Each flow logic**

You can use a List variable to specify the records to process within For Each flow logic. The For Each flow logic ignores any non record Sys ID present in the data. For example, if the List variable contains an email address, the flow logic ignores it.

**Object data type**

Store a JavaScript object.
Basic options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of data stored by the data variable.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Indicates whether the data variable must contain a value when configured in an action.</td>
</tr>
</tbody>
</table>

Advanced options for Object variables

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structure</td>
<td>Specifies how to structure the object hierarchy. Options include:</td>
</tr>
<tr>
<td></td>
<td>• Create Structure Manually</td>
</tr>
<tr>
<td></td>
<td>• Start from Template</td>
</tr>
<tr>
<td>Note:</td>
<td>Creating the structure manually enables the Save as Template option.</td>
</tr>
<tr>
<td></td>
<td>Starting from a template enables the Template option</td>
</tr>
<tr>
<td>Save as Template</td>
<td>Stores a manually created object structure for later reuse.</td>
</tr>
<tr>
<td>Template</td>
<td>Specifies the existing object structure to apply to this object.</td>
</tr>
</tbody>
</table>

Password (2 Way Encrypted) design considerations

Store encrypted password data that can be decrypted.

Basic options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of data stored by the data variable.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Indicates whether the data variable must contain a value when configured in an action.</td>
</tr>
</tbody>
</table>

### Advanced options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Default value</td>
<td>Specifies the value used when a flow or action designer does not provide a value.</td>
</tr>
</tbody>
</table>

### Design considerations

Follow these guidelines when designing flows containing Password (2 Way Encrypted) data.

**Assign values using existing Password (2 Way Encrypted) data pills.**

You can only assign a value to a password2 variable by selecting an existing password2 data pill. Selecting values from other field types is not supported. Flow Designer presents a warning message when invalid data pill types are selected.

![Image](image_url)

**Note:** You cannot manually enter Password (2 Way Encrypted) values.

**Use Password (2 Way Encrypted) variables only for valid field types**

Flow Designer prevents selecting Password2 data pills as the value for invalid field types. The system presents a warning message when the field is incompatible type.
Flow Designer only allows Password2 data pills to be dragged into the following field types.

- Email body fields
- HTML fields
- Password 2 Fields
- PowerShell Input Variables
- REST fields
  - Variables
  - REST payload body
  - Query parameters
  - Headers
  - REST multi-part form values
  - Form URL-encoded values
- SOAP fields
  - Headers
  - Envelope

**Note:** you cannot use Password (2 Way Encrypted) variables as conditions

Flow Designer performs a validation check when a user saves, publishes, or tests actions and flows. This check shows an alert for any data pills dropped in restricted field types and prevents the action or flow from executing. Update the action or flow to remove the invalid data pill and then retry the action.

**Set up encryption contexts to allow decryption**

Only users with a valid encryption context can decrypt and view the contents of password2 variables. To specify the encryption algorithm and the roles allowed to access encrypted data, see [Setup encryption contexts](#).
**Records.[Table] data type**

Stores one or more Sys ID references to records in a specific table.

**Basic options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of data stored by the data variable.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Indicates whether the data variable must contain a value when configured in an action.</td>
</tr>
</tbody>
</table>

**Advanced options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Default value</td>
<td>Specifies the value used when a flow or action designer does not provide a value.</td>
</tr>
</tbody>
</table>

**Reference.[Table] data type**

Store a single Sys ID reference to a record in a specific table.

**Basic options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of data stored by the data variable.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Indicates whether the data variable must contain a value when configured in an action.</td>
</tr>
</tbody>
</table>

**Advanced options for Reference variables**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Default value</td>
<td>Specifies the value used when a flow or action designer does not provide a value.</td>
</tr>
<tr>
<td>Reference qualifier conditions</td>
<td>Specifies the conditions used to filter records from the target table. The system only displays records from the target table that match the reference qualifier conditions. Use the condition builder to add one or more conditions.</td>
</tr>
</tbody>
</table>

**String data type**

Store alphanumeric text values using JavaScript data conventions.

**Basic options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of data stored by the data variable.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Indicates whether the data variable must contain a value when configured in an action.</td>
</tr>
</tbody>
</table>
Advanced options for String variables

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max length</td>
<td>Specifies the maximum length a string value can have when entered from the user interface. The variable can store longer strings than it can display.</td>
</tr>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Default value</td>
<td>Specifies the value used when a flow or action designer does not provide a value.</td>
</tr>
</tbody>
</table>

Table name data type
Store a table name value as specified in the database dictionary. Table names are always alphanumeric strings.

Basic options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of data stored by the data variable.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Indicates whether the data variable must contain a value when configured in an action.</td>
</tr>
</tbody>
</table>

Advanced options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Default value</td>
<td>Specifies the value used when a flow or action designer does not provide a value.</td>
</tr>
</tbody>
</table>
**True/false data type**

Store true or false values using JavaScript data conventions.

**Basic options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the label used to identify the data variable in the Flow Designer interface. The label can consist of any text.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name used to identify the data variable in script calls. The name can only consist of alphanumeric and underscore characters. The system automatically converts the label into a valid name by removing or replacing any special characters.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of data stored by the data variable.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Indicates whether the data variable must contain a value when configured in an action.</td>
</tr>
</tbody>
</table>

**Advanced options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Provides guidance to flow or action designers on how to configure the data.</td>
</tr>
<tr>
<td>Default value</td>
<td>Specifies the value used when a flow or action designer does not provide a value.</td>
</tr>
</tbody>
</table>

**Dynamic inputs**

Build dynamic choice and template inputs for an action. Dynamically display and assign values to the inputs during flow design.

ℹ️ **Note:** Dynamic inputs are not available in the base system. To use dynamic inputs in Flow Designer, you must request an IntegrationHub Enterprise Pack subscription.

During flow design, dynamic inputs retrieve values and display them as inputs within an action dynamically. Dynamic input types include:

- Dynamic choice
- Dynamic template
A dynamic input must point to a data gathering action that collects the displayed data. For example, a data gathering action can retrieve values from a third-party system and populate a dynamic choice for an action that runs in an IntegrationHub spoke. To use a dynamic input in Flow Designer:

1. An action designer creates a data gathering action.
2. An action designer creates a parent action with a dynamic input that points to the child data gathering action.
3. A flow designer adds the parent action to a flow.

**Data gathering actions**

A data gathering action collects data, typically from a third-party system via a REST call, and dynamically builds its output based on the returned payload. A data gathering action must:

- Have a script step that contains an output variable of type JSON.
- Have an action output named `output` of type JSON whose value is derived from the script step's JSON output variable.

**Note:** The action can have multiple outputs but can only have one of type JSON.

- Format the payload in the script step so that `output` has a property named `data`.
- Wait for up to 300 seconds (5 minutes) to gather data before it times out.

**Note:** To change the timeout period for a data gathering action, modify the value of the `sn_flow_designer.sync_action_execution_timeout_in_seconds` system property.

**Dynamic choice**

A dynamic choice displays gathered data as a list of choice values during flow design. For more information on building a dynamic choice, see Create a data gathering action for a dynamic choice.

**Dynamic template**

A dynamic template displays a gathered list of fields whose associated values can be specified during flow design. Because this list populates dynamically, you don’t have to change the flow if new fields are added to or removed from the table that is accessed in the data gathering action. For more information on building a dynamic template, see Create a data gathering action for a dynamic template.
Design considerations

Consider dynamic inputs for third-party integrations

Dynamic inputs let you create flows that fetch data dynamically from external sources. In third-party integrations, dynamic inputs can provide data values that pertain to a particular endpoint. For more information on setting up third-party integrations with Flow Designer, see IntegrationHub.

Be aware of the time required to retrieve large amounts of data

By default, dynamic inputs have up to 300 seconds to gather data before they time out. If your data gathering action needs more time to gather data, set the `sn_flow_designer.sync_action_execution_timeout_in_seconds` system property to a higher value. However, don't use long timeout values for interactive flows where an end user must enter or select a value.

Be aware of scripting errors

Because all data gathering actions use a script step, potential errors could occur from scripting. When using scripts to output JSON variables for your dynamic inputs, you may encounter errors which prevent inputs from receiving the JSON values they need. When a dynamic input scripting error occurs, the following warning message may appear.

Message displayed for scripting error

![Warning: A dynamic action error occurred.](image)

Get started with dynamic inputs

Create a sample action that builds a dynamic choice and dynamic template for use in a flow.

Before you begin

Role required: action_designer or admin

About this task

In this task, you create a custom action that dynamically generates a list of tables and associated fields in your instance. To accomplish this, you create two data gathering actions: one that collects a list of tables in your instance, and another that collects a list of fields for the selected table. Each data gathering action consists of the following:
• A REST step to gather table and field data from your instance
• A script step to construct the payload from the REST step’s Response Body
• An output variable named `output` of type JSON

You then use these data gathering actions to build a dynamic choice and a dynamic template. Finally, you will create a custom action that calls the data gathering action during flow design.

ℹ️ **Note:** This task recreates the demo actions that are installed when you request a ServiceNow IntegrationHub Enterprise Pack subscription for your instance.

**Procedure**
1. Navigate to **Process Automation > Flow Designer**.
2. Click **New** and select **New Action**.
   a. On the Action Properties screen, in the **Name** field, enter `Get ServiceNow Tables (Dynamic)`.
   b. Click **Submit**.
3. In the Action Outline, click the Add a new step icon (∇) under **Inputs** and select the **REST** step. Enter the following information.
4. Under the REST step header, fill in the following fields.

<table>
<thead>
<tr>
<th>Input</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Leave <strong>Use Connection Alias</strong> selected.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Click the Create new record icon (+) to create a new HTTP(s) connection, or use an existing connection for your instance. The <strong>Credential</strong> for the HTTP(s) connection must use basic auth. Additionally, the <strong>Connection URL</strong> must be the base URL for your instance, including the forward slash at the end. For more information on connections and credentials, see Getting started with</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Input | Value
--- | ---
connections and Getting started with credentials.
Build Request | Leave the Manually option selected
Resource Path | Enter api/now/doc/table/schema
HTTP Method | Enter GET

5. In the Action Outline, click the Add a new step icon (➕) under your REST step and select the **Script** step.

a. In the Input Variables section, click **Create Variable**.

b. In the **Name** field, enter **payload**.

c. Next to the **Value** field, click the data pill picker (🔍) and select **REST Step > Response Body**.

d. In the **Script** field, enter the following code.

```javascript
(function execute(inputs, outputs) {
    var payload = JSON.parse(inputs.payload);
    var tables = payload.result
        .filter(function(table) { return table.value.indexOf('_') < 0; }) // Filter the tables we want
        .map(function(table) {
            return { label: table.label, name: table.value };
        });
    outputs.tables = { data: tables }; // Final, properly formatted output
})(inputs, outputs);
```

e. In the Output Variables section, click **Create Variable**.

f. In the **Label** and **Name** fields, enter **tables**.

g. In the **Type** field, select **JSON**.

6. In the Action Outline, click **Outputs**.

a. Click **Create Output**.

b. In the **Label** and **Name** fields, enter **output**.
c. In the **Type** field, select **JSON**.

d. Click **Exit Edit Mode**.

e. Next to the **Value**, click the data pill picker (🔍) and select **Script Step > tables**.

7. In the Action header, click **Save** and then click **Test** to test the action.

a. Click **Run Test**.

b. Check the action's execution details. Your data gathering action runs successfully if the runtime value for `tables` is a complex object containing an array of key-value pairs for `label` and `name` as shown in the following abbreviated example.

```
{
    "data": [  
        {
            "name": "sla",
            "label": "Agreement"
        },
        {
            "name": "announcement",
            "label": "Announcement"
        },
        {
            "name": "cmdb",
            "label": "Base Configuration Item"
        },
        {
            "name": "checklist",
            "label": "Checklist"
        }, ...
    ]
}
```

8. In the Action header, click **Publish** to make the **Get ServiceNow Tables (Dynamic)** action available to other flows and actions within the Global scope.

**Create the Get ServiceNow Fields (Dynamic) action**

Create a sample action that generates a list of fields for a dynamically selected table.

**Before you begin**

Role required: action_designer or admin
Procedure

1. In the main header, click the Create flow, subflow, or action icon (+) and select Action.
   a. On the Action Properties screen, in the Name field, enter Get ServiceNow Fields (Dynamic).
   b. Click Submit.

2. In the Action Outline, select Inputs.
   a. In the Action Input header, click Create Input.
   b. In the Label and Name fields, enter Table.
   c. In the Type field, select String.
   d. To make the input required, toggle the Mandatory slider so that it is active.

3. In the Action Outline, click the Add a new step icon (+) under Inputs and select the REST step. Enter the following information.

4. Under the REST step header, fill in the following fields.

<table>
<thead>
<tr>
<th>Input</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Leave Use Connection Alias selected.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Click the Create new record icon (+) to create a new HTTP(s) connection, or use an existing connection for your instance. The Credential for the HTTP(s) connection must use basic auth. Additionally, the Connection URL must be the base URL for your instance, including the forward slash at the end.</td>
</tr>
<tr>
<td>Build Request</td>
<td>Leave Manually selected.</td>
</tr>
<tr>
<td>Resource Path</td>
<td>Enter api/now/table/ and then click the data pill picker ( ), Select Inputs &gt; Table.</td>
</tr>
<tr>
<td>HTTP Method</td>
<td>Enter GET</td>
</tr>
</tbody>
</table>
5. In the Action Outline, under the REST step, click the Add a new step icon (.addButton) and select the **Script** step.

a. In the Input Variables section, click **Create Variable**.

b. In the **Name** field, enter `payload`.

c. Next to the **Value**, click the data pill picker (pill) and select **REST Step > Response Body**.

d. In the **Script** field, enter the following code.

   ```javascript
   (function execute(inputs, outputs) {
     var payload = JSON.parse(inputs.payload);
     var fields = Object.keys(payload.result[0]).map(function(property) {
       return {
         label: property.charAt(0).toUpperCase() + property.slice(1).replace(/_/g, ' ')
           ,
         name: property,
         value: '' // value is always empty
           ,
       };
     });
     outputs.fields = { data: fields }; // final properly formatted output
   })(inputs, outputs);
   
   e. In the Output Variables section, click **Create Variable**.

f. In the **Label** and **Name** fields, enter `fields`.

g. In the **Type** field, select **JSON**.

6. In the Action Outline, click **Outputs**.

a. On the Action Output header, click **Create Output**.

b. In the **Label** and **Name** fields, enter `output`.

c. In the **Type** field, select **JSON**.

d. Click **Exit Edit Mode**.

e. Next to the **Value** field, click the data pill picker (pill) and then select **Script Step > fields**.
7. In the Action header, click **Save** and then click **Test** to test the action.

   a. On the Test Action screen, in the **Table** field, enter **incident**.

   b. Click **Run Test**.

   c. Check the action’s execution details.

       Your data gathering action runs successfully if the runtime value for **fields** is a complex object containing an array of key-value pairs for **label**, **name**, and **value** as shown in the following abbreviated example.

       ```json
       {
         "data": [
           {
             "name": "Parent",
             "label": "parent",
             "value": ""
           },
           {
             "name": "Made sla",
             "label": "made_sla",
             "value": ""
           },
           {
             "name": "Caused by",
             "label": "caused_by",
             "value": ""
           },
           {
             "name": "Watch list",
             "label": "watch_list",
             "value": ""
           }, ...
       ]
       ```

8. In the Action header, click **Publish** to make the Get ServiceNow Fields (Dynamic) action available to other actions within the Global scope.

Create the Create ServiceNow Record (Dynamic) action

Create a sample action to generate a record in a dynamically chosen table.

**Before you begin**

Role required: action_designer or admin
Procedure

1. Click the Create flow, subflow, or action icon (+) and then select Action.
   a. On the Action Properties screen, in the Name field, enter Create ServiceNow Record (Dynamic).
   b. Click Submit.
2. In the Action Outline, click Inputs.
   a. Click Create Input.
   b. In the Label and Name fields, enter Table.
   c. In the Type field, select Dynamic Choice.
   d. To make the input required, toggle the Mandatory slider so that it is active.
   e. Click the Toggle advanced inputs icon ( ) to display the advanced options for the Table input.
   f. Under Dynamic Options, in the Action field, select Get ServiceNow Tables (Dynamic).
   g. Click Create Input to create another action input.
   h. In the Label and Name fields, enter Fields.
   i. In the Type field, select Dynamic Template.
   j. To make the input required, toggle the Mandatory slider so that it is active.
   k. Click the Toggle advanced inputs icon ( ) to display the advanced options for the Table input.
   l. Under Dynamic Options, in the Action field, select Get ServiceNow Fields (Dynamic).
   m. Toggle the Depends-On Another Input slider to make it active.
   n. In the Table field, select Table.
3. In the Action Outline, under Inputs, click the Add a new step icon (+) and then select the Script step.
   a. In the Input Variables section, click Create Variable.
   b. In the Name field, enter table.
   c. Next to the Value field, click the data pill picker ( ) and select Inputs > Table.
d. Click **Create Variable** to create another input variable.

e. In the **Name** field, enter *fields*.

f. In the **Type** field, select **String**.

g. Next to the **Value** field, click the data pill picker (🔍) and select **Inputs > Fields**.

h. In the **Script** field, enter the following code.

```
(function execute(inputs, outputs) {
  var now_GR = new GlideRecord(inputs.table);
  gr.applyEncodedQuery(inputs.fields);
  gr.insert();
})(inputs, outputs);
```

4. In the Action header, click **Save** and then click **Test** to test the action.

a. On the Test Action screen, in the **Table** input, select any dynamically-generated choice value.

b. Click **Add Field Value** and then select any field and enter any value.

c. Click **Run Test**.

d. Check the action’s execution details. Your action runs successfully if the runtime values for **Table** and **Field** match the values you entered for the test.

5. In the Action header, click **Publish** to make the *Create ServiceNow Record (Dynamic)* action available to flows within the Global scope.

**Results**

You can now add the *Create ServiceNow Record (Dynamic)* action to a flow in Flow Designer. This sample action dynamically generates a list of tables and
Create a data gathering action for a dynamic choice

Create an action to collect input values to pass to a parent action as a dynamic choice.

**Before you begin**
Role required: action_designer or admin

**Procedure**

2. Click New > New Action.
3. In the Name field, enter a name for your action, choose the proper Application scope, and then click Submit.
4. In the Action Outline, click the add a new step icon (+) under Inputs and select the REST step.
   Configure your REST step to get data from the proper Base URL and Resource Path with any applicable Query Parameters for the HTTP Method GET. For more information on using the REST step in IntegrationHub, see REST step and REST in IntegrationHub.
5. In the Action Outline, click the add a new step icon (+) under your REST step and select the Script step.
   This script step must transform the REST step's Response Body into a format that can be used as a dynamic choice for a parent action. Format the JSON output variable so that it contains a property named data with a structure similar to the following example.
6. In the Action Outline, click **Outputs** and create an output named `output` of type JSON.

7. Use the data pill picker (🔍) to assign the data pill for the JSON output variable from your script step to the action output's **Value**.

   ⚠ **Note:** The action can have multiple outputs, but there can only be one of type JSON.

8. Click **Save** and **test the action**.
   In the execution details, your data gathering action runs successfully if the runtime value for `output` contains the `data` property in the proper format.

9. Click **Publish** to make the action available to other flows and actions within the same application scope.
Results
You can now use your data gathering action to populate the options that appear for a dynamic choice input in a parent action.

Create a data gathering action for a dynamic template
Create an action to collect input values to pass to a parent action as a dynamic template.

Before you begin
Role required: action_designer or admin

Procedure
2. Click New > New Action.
3. In the Name field, enter a name for your action, choose the proper Application scope, and then click Submit.
4. In the Action Outline, click the add a new step icon (➕) under Inputs and select the REST step. Configure your REST step to get data from the proper Base URL and Resource Path with any applicable Query Parameters for the HTTP Method GET. For more information on using the REST step in IntegrationHub, see REST step and REST in IntegrationHub.
5. In the Action Outline, click the add a new step icon (➕) under your REST step and select the Script step. This script step must transform the REST step's Response Body into a format that can be used as a dynamic choice for a parent action. Format the JSON
output variable so that it contains a property named `data` with a structure similar to the following example:

```json
{
  data: [
    {
      label: "Template Option 1",
      name: "template_option_1",
      value: ""
    },
    {
      label: "Template Option 2",
      name: "template_option_2"
    },
    {
      label: "Template Option 3",
      name: "template_option_3",
      value: ""
    }
  ]
}
```

**Note:** The JSON output structure for a dynamic template can include the optional properties `type` and `choices`.

- **type:** Specify a valid field type to render the appropriate UI control for the dynamic template.
- **choices:** If specifying `choice` for the `type` property, you can then specify an array of choice options that will render in a list for the dynamic template.

6. In the Action Outline, click **Outputs** and create an output named `output` of type JSON.

7. Use the data pill picker (📅) to assign the data pill for the JSON output variable from your script step to the action output's **Value**.

**Note:** The action can have multiple outputs, but there can only be one of type JSON.
8. Click **Save** and test the action.
   In the execution details, your data gathering action runs successfully if the runtime value for **output** contains the **data** property in the proper format.

9. Click **Publish** to make the action available to other flows or actions within the same application scope.

**Results**

You can now use your data gathering action to populate the options that appear for a dynamic template input in a parent action.

**Dynamic input configuration options**

Use these options to configure your dynamic inputs for a parent action.

**Dynamic input configuration**

**Dynamic input options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter a label that appears for the action input when the action is added to a flow.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a descriptive name for the dynamic choice or template.</td>
</tr>
<tr>
<td>Max length</td>
<td>Enter the maximum character length for one choice or template field value.</td>
</tr>
<tr>
<td>Hint</td>
<td>Enter a hint to display for the dynamic input.</td>
</tr>
<tr>
<td>Choice</td>
<td>Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• Dropdown with --None--</td>
</tr>
<tr>
<td></td>
<td>• Dropdown without --None--</td>
</tr>
</tbody>
</table>
Dynamic input options (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Value</td>
<td>Enter a string value to use as a default for the dynamic input.</td>
</tr>
<tr>
<td>Action</td>
<td>Select a data gathering action that generates values as JSON output.</td>
</tr>
<tr>
<td>Depends-on Another Input</td>
<td>Enable this option to require an input value from the parent action to be passed as an input to the data gathering action. If enabled, select a dependent input from the parent action.</td>
</tr>
</tbody>
</table>

Dynamic outputs

Access action and subflow outputs as dynamically generated data pills during flow design. You can also build data gathering actions to generate complex objects from Now Platform and IntegrationHub outputs.

⚠️ Note: Dynamic outputs are not available in the base system. To use dynamic outputs in Flow Designer, you must request an IntegrationHub Enterprise Pack subscription.

During the flow design, a dynamic output retrieves the complex object’s schema values and displays them as data pills in the data panel.

A dynamic output must point to a data gathering action that collects the displayed data. For example, a data gathering action can retrieve values from a third-party system as part of an IntegrationHub spoke. To use a dynamic output in Flow Designer:

1. An action designer creates a data gathering action.
2. An action designer creates a parent action with a dynamic output that points to the child data gathering action.
3. A flow designer adds the parent action to a flow.

Data gathering actions

A data gathering action collects data, typically from a third-party system via a REST call, and dynamically builds its output based on the returned payload. A data gathering action must:

- Have a script step that contains an output variable of type JSON.
- Have an action output named output of type JSON whose value is derived from the script step’s JSON output variable.
Note: The action can have multiple outputs but can only have one of type JSON.

- Format the payload in the script step so that `output` has a property named `data`.
- Wait for up to 300 seconds (5 minutes) to gather data before it times out.

Note: To change the timeout period for a data gathering action, modify the value of the `sn_flow_designer.sync_action_execution_timeout_in_seconds` system property.

Dynamic object

A dynamic object is either a complex object or an array of complex objects. Action designers build the object structure dynamically with a data gathering action rather than hard-coding it. For more information on building a dynamic object, see Create a data gathering action for a dynamic object.

Design considerations

Consider dynamic outputs for third-party integrations

Use dynamic outputs to introspect and fetch data from external systems during the flow design. For example, you can specify service endpoints or call actions that interact with specific endpoint APIs. For more information on setting up third-party integrations with Flow Designer, see IntegrationHub.

Be aware of the time that is required to retrieve large amounts of data

By default, dynamic outputs have up to 300 seconds to gather data before the system stops them. If your data gathering action needs more time to gather data, set the `sn_flow_designer.sync_action_execution_timeout_in_seconds` system property to a greater value. Avoid long timeout values for interactive flows where an end user is expecting to enter or select a value.

Be aware of scripting errors

Because all data gathering actions use a script step, be aware of any potential errors that could arise from scripting. Review any scripts that are used to output JSON variables because script errors may prevent the outputs from receiving the JSON values that they need. When a dynamic output scripting error occurs, the following warning message may appear.
Get started with dynamic outputs
Create a sample action that builds dynamic objects for use in a flow.

Before you begin
Role required: action_designer or admin

About this task
In this task, you create two data gathering actions: one that collects the schema for a record on your instance, and another that collects the schema for multiple records in the same table on your instance. The goal is to create both a complex object and a complex object array to use as dynamic outputs. Each data gathering action will consist of the following:

- A REST step to gather table schema data from your instance.
- A script step to construct the payload from the REST step's Response Body.
- An output variable named `output` of type JSON.

You use these data gathering actions to build two dynamic objects. Then, you create a custom action that calls the data gathering actions during the flow design.

ℹ️ Note: This task re-creates the demo actions that are installed when you request an IntegrationHub Enterprise Pack subscription for your instance.

Procedure
2. Click New and select New Action.
   a. On the Action Properties screen, in the Name field, enter `Get ServiceNow Object Schema (Dynamic)`.
   b. Click Submit.
3. In the Action Outline, click Inputs.
   a. In the Action Input header, click Create Input.
   b. In the Label and Name fields, enter Table.
c. In the **Type** field, select **String**.

d. To make this input required, toggle the **Mandatory** slider so that it is active.

4. In the Action Outline, click the add a new step icon (➕) under Inputs and select **REST Step**.

5. Under the REST step header, fill in the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Leave the <strong>Use Connection Alias</strong> option selected.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Click the create new record icon (➕) to create a new <strong>HTTP(s)</strong> connection, or use an existing connection for your instance. The <strong>Credential</strong> for the <strong>HTTP(s)</strong> connection must use <strong>basic auth</strong>. Additionally, the <strong>Connection URL</strong> must be the base URL for your instance, including the forward slash at the end. For more information on connections and credentials, see Getting started with connections and Getting started with credentials.</td>
</tr>
<tr>
<td>Build Request</td>
<td>Leave the <strong>Manually</strong> option selected.</td>
</tr>
<tr>
<td>Resource Path</td>
<td>Enter <code>api/now/processflow/table/</code> and then click the data pill picker (🔍). Select <strong>Inputs &gt; Table</strong>. Next, enter <code>/schema</code>.</td>
</tr>
<tr>
<td>HTTP Method</td>
<td>Enter <strong>GET</strong></td>
</tr>
<tr>
<td>Query Parameters</td>
<td>Click the plus icon (➕) to add a new query parameter. Then, in the <strong>Name</strong> field, enter <code>get_choices</code> and <code>true</code> in the <strong>Value</strong> field.</td>
</tr>
</tbody>
</table>

6. In the Action Outline, click the add a new step icon (➕) under your REST step and select the **Script** step.
a. In the Input Variables section, click Create Variable.

b. In the Name field, enter `payload`.

c. Next to the Value field, click the data pill picker (🔍) and select REST Step > Response Body.

d. In the Script field, enter the following code.

```javascript
(function execute(inputs, outputs) {
  var payload = JSON.parse(inputs.payload);

  var columns = payload.result.data.columns;
  var schema = columns.map(function(column) {
    var value = {
      label: column.label,
      name: column.name,
      type: getCOType(column.definition.base_type),
    };
    if (column.definition.type === 'choice') {
      value.type = 'choice';
      value.choices = column.definition.choices;
    }
    if (column.definition.base_type === 'GUID') {
      value.children = [
        { label: 'Link', name: 'link', type: 'string' },
        { label: 'Value', name: 'value', type: 'string' },
      ];
    }
    return value;
  });
  outputs.schema = {
    data: {
      type: 'object',
      children: schema,
    },
  };

  function getCOType(type) {
    if (type === 'GUID') return 'reference';
    return type;
}
```
e. In the Output Variables section, click **Create Variable**.

f. In the **Label** and **Name** fields, enter `schema`.

g. In the **Type** field, select **JSON**.

7. In the Action Outline, click **Outputs**.

   a. In the Action Output header, click **Create Output**.
   
   b. In the **Label** and **Name** fields, enter `output`.
   
   c. In the **Type** field, select **JSON**.
   
   d. In the Action Output header, click **Exit Edit Mode**.

   e. Next to the **Value** field, click the data pill picker (.Optional) and select **Script Step > schema**.

8. In the Action header, click **Save** and then click **Test** to test the action.

   a. On the Test Action screen, enter `incident` for the **Table** input.

   b. Click **Run Test**.

   c. Check the action’s execution details.

Your data gathering action runs successfully if the runtime value for `fields` is a complex object in a format that is similar to the following abbreviated example.

```json
{
    "data": {
        "type": "object",
        "children": [
            {
                "name": "active",
                "label": "Active",
                "type": "boolean"
            },
            {
                "name": "activity_due",
                "label": "Activity due",
```
9. In the Action header, click **Publish** to make the **Get ServiceNow Object Schema (Dynamic)** action available to other flows and actions within the Global scope.

**Create the Get ServiceNow Array.Object Schema (Dynamic) action**

Create a sample data gathering action to generate an array of objects.

**Before you begin**

Role required: action_designer or admin

**Procedure**

1. In the main header, click the create flow, subflow, or action icon (➕) and select **Action**.
   
   a. On the Action Properties screen, in the **Name** field, enter **Get ServiceNow Array.Object Schema (Dynamic)**.
   
   b. Click **Submit**.

2. In the Action Outline, click **Inputs**.
   
   a. In the Action Input header, click **Create Input**.
   
   b. In the **Label** and **Name** fields, enter **Table**.
   
   c. In the **Type** field, select **String**.
   
   d. To make the input required, toggle the **Mandatory** slider so that it is active.

3. In the Action Outline, click the add a new step icon (➕) under Inputs and select the **REST** step.

4. Under the REST step header, fill in the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Leave <strong>Use Connection Alias</strong> selected.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Click the create new record icon (➕) to create a new <strong>HTTP(s)</strong> connection, or use an existing connection for your instance. The <strong>Credential</strong> for the <strong>HTTP(s)</strong> connection must use <strong>basic auth</strong>. Additionally, the</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection URL</td>
<td><strong>Connection URL</strong> must be the base URL for your instance, including the forward slash at the end.</td>
</tr>
<tr>
<td>Build Request</td>
<td>Leave <strong>Manually</strong> selected.</td>
</tr>
<tr>
<td>Resource Path</td>
<td>Enter <code>api/now/processflow/table/</code> and then click the data pill picker (🔍). Select <strong>Inputs &gt; Table</strong>. Finally, enter <code>/schema</code></td>
</tr>
<tr>
<td>HTTP Method</td>
<td>Enter <strong>GET</strong></td>
</tr>
<tr>
<td>Query Parameters</td>
<td>Click the plus icon (+) to add a new query parameter. Then, in the <strong>Name</strong> field, enter <code>get_choices</code> and <code>true</code> in the <strong>Value</strong> field.</td>
</tr>
</tbody>
</table>

5. In the Action Outline, click the **Add a new step** (➕) icon under your REST step and select the **Script** step.

a. In the Input Variables section, click **Create Variable**.

b. In the **Name** field, enter `payload`.

c. Next to the **Value** field, click the data pill picker (🔍) and select **REST Step > Response Body**.

d. In the **Script** field, enter the following code.

```javascript
(function execute(inputs, outputs) {
    var payload = JSON.parse(inputs.payload);

    var columns = payload.result.data.columns;
    var schema = columns.map(function(column) {
        var value = {
            label: column.label,
            name: column.name,
            type: getCOType(column.definition.base_type),
        };
        if (column.definition.type === 'choice') {
            value.type = 'choice';
        }
    });
}
```
value.choices = column.definition.choices;
}
return value;
});
outputs.schema = {
data: {
type: 'array.object',
attributes: {
child_type: 'object',
},
children: schema,
},
};

function getCOType(type) {
if (type === 'GUID') return 'string';
return type;
}
})(inputs, outputs);

e. In the Output Variables section, click Create Variable.

f. In the Label and Name fields, enter schema.

g. In the Type field, select JSON.

6. In the Action Outline, click Outputs.

a. On the Action Output header, click Create Output.

b. Enter output in the Label field and Name field.

c. Select JSON for the Type field.

d. Click Exit Edit Mode.

e. Next to the Value field, click the data pill picker (-script-step) and select Script Step > schema.

7. In the Action header, click Save and then click Test to test the action.

a. On the Test Action screen, in the Table field, enter incident.

b. Click Run Test.

c. Check the action's execution details.
Your data gathering action runs successfully if the runtime value for fields output is a complex object that contains an array of key-value pairs for label, name, and value as shown in the following abbreviated example.

```json
{
  "data": {
    "type": "array.object",
    "children": [
      {
        "name": "active",
        "label": "Active",
        "type": "boolean"
      },
      {
        "name": "activity_due",
        "label": "Activity due",
        "type": "datetime"
      }, ...
    ]
  }
}
```

8. In the Action header, click Publish to make the Get ServiceNow Array.Object Schema (Dynamic) action available to other actions within the Global scope.

Create the Get ServiceNow Records (dynamic) action

Create a sample action to dynamically generate two action outputs, Record and Records which refresh dynamically when the value for the Table input changes.

Before you begin
Role required: action_designer or admin

Procedure

1. In the main header, click the create flow, subflow, or action icon (➕) and select Action.
   a. In the Action Properties modal, in the Name field, enter Get ServiceNow Records (Dynamic).
   b. Click Submit.

2. In the Action Outline, click Inputs.
   a. In the Action Input header, click Create Input.
   b. In the Label and Name fields, enter Table.
   c. In the Type field, select Dynamic Choice.
   d. To make the input required, toggle the Mandatory slider so that it is active.
e. Click the Toggle advanced inputs icon (✓) to display the advanced options for the Table input.

f. In the Default value field, enter incident.

g. Under Dynamic Options, in the Action field, select Get ServiceNow Tables - Dynamic.

h. Click Create Input to create another action input.

i. In the Label and Name fields, enter NumberOfRecords.

j. In the Type field, select Integer.

k. To make the input required, toggle the Mandatory slider so that it is active.

l. Click the Toggle advanced inputs icon (✓) to display the advanced options for the Table input.

m. In the Default value field, enter 3.

3. In the Action Outline, click the add a new step icon (➕) under Inputs and select the REST step.

4. Under the REST step header, fill in the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Leave Use Connection Alias selected.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Click the create new record icon (➕) to create a new HTTP(s) connection, or use an existing connection for your instance. The Credential for the HTTP(s) connection must use basic auth. Additionally, the Connection URL must be the base URL for your instance, including the forward slash at the end.</td>
</tr>
<tr>
<td>Build Request</td>
<td>Leave Manually selected</td>
</tr>
<tr>
<td>Resource Path</td>
<td>Enter api/now/table/ and then click the data pill picker ( ExecutionContext). Select Inputs &gt; Table.</td>
</tr>
<tr>
<td>HTTP Method</td>
<td>Enter GET</td>
</tr>
</tbody>
</table>
5. In the Action Outline, click the add a new step icon (➕) under Inputs and select the **Script** step.

a. In the Input Variables section, click **Create Variable**.

b. In the **Name** field, enter `payload`.

c. Next to the **Value** field, click the data pill picker (🔍) and select **REST Step > Response Body**.

d. In the **Script** field, enter the following code.

   ```javascript
   (function execute(inputs, outputs) {
   var response = JSON.parse(inputs.payload);
   var records = response.result;
   outputs.record = records[0];
   outputs.records = JSON.stringify(records);
   })(inputs, outputs);
   ```

e. In the Output Variables section, click **Create Variable**.

f. In the **Label** and **Name** fields, enter `record`.

g. Select **JSON** for the **Type** field.

h. Toggle the **Mandatory** slider so that it is active.

i. Click **Create Variable** to create another output variable for the script step.

j. In the **Label** and **Name** fields, enter `records`.
In the **Type** field, select **JSON**.

To make the input required, toggle the **Mandatory** slider so that it is active.

6. In the Action Outline, click **Outputs**.
   
a. In the Action Output header, click **Create Output**.
   
b. In the **Label** and **Name** fields, enter **Records**.
   
c. In the **Type** field, select **Dynamic Object**.
   
d. Click the Toggle advanced inputs icon ( ▼ ) to display the advanced options for the **Records** output.
   
e. Under Dynamic Options, select **Get ServiceNow Array.Object Schema (Dynamic)** as the **Action**.
   
f. To make the Table input dependent on another input, toggle the **Depends-On Another Input** slider to make it active.
   
g. In the **Table** field, select **Table**.
   
h. In the Action Output header, click **Exit Edit Mode**.
   
i. Next to the **Value** field, click the data pill picker ( △ ) and select **Script Step > records**.
   
j. In the Action Output header, click **Edit Outputs > Create Output** to create another action output.
   
k. In the **Label** and **Name** fields, enter **Record**.
   
l. In the **Type** field, select **Dynamic Object**.
   
m. Click the Toggle advanced inputs icon ( ▼ ) to display the advanced options for the **Record** output.
   
n. Under Dynamic Options, in the **Action** field, select **Get ServiceNow Object Schema (Dynamic)**.
   
o. To make the Table input dependent on another input, toggle the **Depends-On Another Input** slider to make it active.
   
p. In the **Table** field, select **Table**.
   
q. In the Action Output header, click **Exit Edit Mode**.
   
r. For the **Value**, click the data pill picker ( △ ) and select **Script Step > record**.
   
7. In the Action header, click **Save** and then click **Test** to test the action.
a. On the Test Action screen, select any dynamically generated choice value for the Table input.

b. Click Run Test.

c. Check the action's execution details. Your action runs successfully if the runtime value for Record is a properly formatted complex object and the runtime value for Records is a properly formatted complex object array.

8. In the Action header, click Publish to make the Get ServiceNow Records (Dynamic) action available to flows within the Global scope.

Results
You can now add the Get ServiceNow Records (Dynamic) action to a flow in Flow Designer. This sample action dynamically generates two action outputs, Record and Records, which can be accessed as data pills in the data panel. The data pills refresh dynamically when the value for the Table input changes.

Create a data gathering action for a dynamic object
Create an action to collect output values. Then, pass the values to a parent action as a dynamic object.

Before you begin
Role required: action_designer or admin

Procedure
3. In the Name field, enter a name for your action, choose the proper Application scope, and then click Submit.

4. In the Action Outline, click the add a new step icon (➕) under Inputs and select the REST step. Configure your REST step to get data from the proper Base URL and Resource Path with any applicable Query Parameters for the HTTP Method GET. For more information on using the REST step in IntegrationHub, see REST step and REST in IntegrationHub.

5. In the Action Outline, click the add a new step icon (➕) under your REST step and select the Script step. This script step must transform the response from the REST step's Response Body into a format that defines the schema of a dynamic object output for a parent action. Your script step must:

- Have a single JSON output variable. The script step can have other output variables, but only one must be of type JSON.
- Format the JSON output variable so that it contains a property named data. For a complex object output, your data property must have a format similar to the following example:

```json
{
    data: {
        type: "object",
        //Required
        children: [
            //Required - This is a collection of field definitions
            {
                name: "Name 1",
                //Required - Unique name
                label: "Label 1",
                //Required - Display name
                type: "string"
                //Required - Supported field type (See the Note below)
            },
            {
                name: "Name 2",
                label: "Label 2",
            }
        ]
    }
}
```
For a complex object array output, your `data` property must have a format similar to the following example:

```json
{
  data: {
    type: "object",
    //Required

    attributes: { child_type: "object" }  
    //Required - Indicates that the array's children are of type object

    children: [  
      //Required - This is a collection of field definitions

      {
        name: "Name 1",
        //Required - Unique name

        label: "Label 1",
        //Required - Display name

        type: "string"
        //Required - Supported field type (See the Note below)
      },

      {
        name: "Name 2",
        label: "Label 2",
        type: "string"
      }
    ]
  }
}
```
6. In the Action Outline, click **Outputs**. Create an output named `output` of type JSON. Then, use the data pill picker (تظ) to assign the data pill for the JSON output variable from your script step to the action output's **Value** field.

   **Note:** The action can have multiple outputs, but there can only be one of type JSON.

7. Click **Save** and **test the action**. In the execution details, your data gathering action runs successfully if the runtime value for `output` contains the `data` property in the proper format.
8. Click **Publish** to make the action available to other flows or actions within the same application scope. You can now use your data gathering action to populate the schema values for a dynamic object in a parent action.

### Dynamic output configuration options

Use these options to configure your dynamic outputs for a parent action.

#### Dynamic output configuration

##### Dynamic output options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Label</strong></td>
<td>Enter a label that appears within the output data pill for the action.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Enter a descriptive name for the dynamic object.</td>
</tr>
<tr>
<td><strong>Action</strong></td>
<td>Select a data gathering action that generates values as JSON output.</td>
</tr>
<tr>
<td><strong>Depends-On Another Input</strong></td>
<td>Enable this option to require an input value from the parent action to be passed as an input to the data gathering action. If enabled, select a dependent input from the parent action.</td>
</tr>
</tbody>
</table>

##### Action error evaluation

Enable actions to catch step failures and continue running. Identify when specific error conditions occur and return your own action status code, status message, and error state.

#### Benefits

Enable action error evaluation to gain these benefits.
• Catch step failures and allow an action to continue running. Specify the failure behavior of each step you add to an action.

• Create your own error conditions. Specify when an action returns an error state as well as the status codes and messages they return.

• Provide more error handling information and options to flow designers. Use your own action status codes and messages to identify issues and provide details for corrective actions.

**Action error evaluation step components**

Each step offers these error evaluation components.

1. **If this step fails option**

   Option to continue running the next step or go to error evaluation. This option has no effect on the Step Status.

2. **Step Status**

   Object data pill containing runtime details about the step. Each step in an action returns a Step Status.

3. **Step Status > Code**

   Integer data pill indicating whether the step produced an error. By default, a value of 1 indicates that the step produced an error. A value of 0 indicates that the step ran successfully. You cannot customize these codes.

4. **Step Status > Message**
String data pill containing the error message produced by the step or system operation. You cannot customize this message.

Action error evaluation configuration components

Action error evaluation consists of these configuration components.

Error evaluation configuration components

5. Error Evaluation section

Section containing possible error conditions. When an action runs, it evaluates the available error conditions from top to bottom looking for a possible match. An action returns the Action Status specified by the first matching error condition. If there is no matching error condition, the Action status is set to the Step Status of the last step run.

6. Add error condition option

Option to add an error condition. Each error condition is equivalent to an else if flow logic block. Only one error condition can be true at a time.

7. Error condition configuration

Options available to configure an error condition.

- Label you want to use to identify this error condition
- Conditions that must be met to match this error condition
- Error state you want the action to return to flow
• Action Status Code you want the action to return to flow
• Action Status Message you want the action to return to flow

8. Action Status
   Object data pill containing runtime details about the action. An action always returns an Action Status.

9. Action Status > Code
   Integer data pill containing the code returned by the first matching error condition or the last step run. You can return your own code when you create a custom error condition.

10. Action Status > Message
    String data pill containing the message produced by a matching error condition or the last step run. You can return your own message when you create a custom error condition.

Design considerations
Follow these guidelines to achieve the benefits offered by action error evaluation.

Allow only independent steps to continue running
   Allow a step to continue running if it does not return data required by a later step. If a step provides data necessary for later steps, then you know that the later steps cannot run successfully.

Avoid more than 10 error conditions
   While there is no limit to the number of error conditions you can create, each error condition requires evaluation. The more error conditions your action has to evaluate, the potentially slower your action can run.

Identify specific step failures
   You can use the Step Status to identify when a specific step fails. Identifying a specific step can be useful when your action contains multiple instances of the same type of step. You may also want to identify a specific step so that a flow error handler can take specific corrective actions for the failure.

Put specific error conditions before general error conditions
   Error evaluation stops as soon as the action finds a matching error condition. Putting general error conditions first may prevent the action from ever matching specific error conditions.
Use descriptive error condition labels

By default, you can only see error condition conditions when you edit them. A descriptive label allows you to identify an error condition without having to edit it.

Add error condition

Enable an action to return custom status information when specific conditions are met. Specify whether a flow considers your custom action status as an error or a successful run.

Before you begin

- Role required: flow_designer, action_designer, or admin
- Create an action

About this task

An action always returns an Action Status object. When an action runs, it evaluates the available error conditions from top to bottom looking for a possible match. An action returns the Action Status specified by the first matching error condition. If there is no matching error condition, the Action status is set to the Step Status of the last step run.

Procedure

2. Select the Actions tab and select the custom action you want to edit.
3. From the Action Outline, select Error Evaluation.
4. Select Add error condition for each error condition you want to define. Action Designer adds an If block for configuration.
5. Configure each error condition.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If</td>
<td>Description of your error condition. You can use this label to identify the error condition when the condition builder is not visible. Each error condition is equivalent to an else if flow logic block. Only one error condition can be true at a time.</td>
</tr>
<tr>
<td>Condition N</td>
<td>Condition builder to specify the matching criteria for the error condition. You can add conditions or condition sets to define the matching criteria.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Don’t treat as error</td>
<td>Option to report the Action Status as an error or a success when returned to a flow.</td>
</tr>
<tr>
<td>Action Status Code</td>
<td>Integer value you want the action to return as part of the Action Status object. You can use this integer value as part of a Flow error handler.</td>
</tr>
<tr>
<td>Action Status Message</td>
<td>String value you want the action to return as part of the Action Status object. You can use this string value as part of a Flow error handler.</td>
</tr>
</tbody>
</table>

6. Order error conditions from top to bottom in the order you want the action to evaluate them.

7. Select Save.

### Results

Your custom action evaluates each error condition for matching conditions. The action returns the Action Status Code and Action Status Message for the first matching error condition. If there is no matching error condition, the Action status is set to the Step Status of the last step run.

### Retry policy

Automatically retry failed requests when a step encounters an intermittent issue such as a network failure or request rate limit. Set a retry policy to prevent having to manually trigger the step again.

### Features

Retry policies can be:

- Created to support connection timeouts or failed requests based on header, status, response body, error, and HTTP method.
- Applied to all actions that use a given connection alias.
- Applied directly to an action step.

Use retry policies to define:
• The conditions that must be met to retry a step.
• The time interval to wait before retrying a step.
• The maximum number of retry attempts the step makes before stopping.

Associate a default retry policy to a Connection & Credentials alias and apply the retry policy to all HTTP connections.

⚠️ Note: You can only create retry policies for REST and SOAP steps.

Create a retry policy

Automatically retry failed requests when a step encounters an intermittent issue such as a network failure or request rate limit. Set a retry policy to prevent having to manually trigger the step again.

Before you begin
Role required: flow_designer or admin

Procedure
1. Navigate to IntegrationHub > Retry Policy > Create New.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the retry policy.</td>
</tr>
<tr>
<td>Connection Type</td>
<td>HTTP</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions that must be met to trigger the retry policy.</td>
</tr>
<tr>
<td></td>
<td>Conditions that trigger a retry policy include the is, is not, contains, and contains not operators.</td>
</tr>
<tr>
<td>Retry Strategy</td>
<td>• Exponential Backoff: Option to exponentially increase the time interval for the subsequent retry attempts. The multiplier is 2.</td>
</tr>
<tr>
<td></td>
<td>• Fixed Interval: Option to specify a fixed time interval after which a retry attempt should be made.</td>
</tr>
<tr>
<td>Interval (seconds)</td>
<td>Time interval in seconds after which a retry attempt should be made.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If <strong>Retry Strategy</strong> is <strong>Exponential Backoff</strong>, the time interval exponentially increases after every retry attempt till the maximum numbers of attempts is reached.</td>
</tr>
</tbody>
</table>

### Count
- Maximum number of retry attempts. If no value is specified, the maximum number of retry attempts is based on the value provided in the `glide.fdih.retry.max_count` system property. Default value of the `glide.fdih.retry.max_count` system property is 0. For more information about system properties, see Available system properties.

3. Click **Submit**.

**Example:Retry policy with Retry Strategy as Exponential Backoff**

**Sample retry policy**

<table>
<thead>
<tr>
<th>Name</th>
<th>HTTP Retry Policy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Type</td>
<td>HTTP</td>
</tr>
<tr>
<td>Conditions</td>
<td>Add Filter Condition Add &quot;OR&quot; Clause</td>
</tr>
</tbody>
</table>

*All of these conditions must be met*

- **HTTP Method** is **GET**
- **Error** is **Connection Timeout**

*OR all of these conditions must be met*

- **HTTP Method** is **GET**
- **Status Code** is **429**

**Retry Strategy**

- **Retry Strategy**: **Exponential Backoff**
- **Interval (seconds)**: 10
- **Count**: 3

In this example, the policy is defined to attempt retry when one of these conditions is met:

- **HTTP Method** is **GET** and **Error** is **Connection Timeout**
- **HTTP Method** is **GET** and **Status Code** is **429**

When the condition is met, retry attempts are made for a maximum number of three times. The time interval between the retry attempts is exponentially increased. The time intervals in this example are 10 seconds, 20 seconds, and 40 seconds.
What to do next

- **Create Connection & Credential alias**, if you do not have the required alias.
- Assign the retry policy as **Default Retry Policy** to the required Connection & Credential alias.

  🔴 **Note:** A default retry policy is provided and is selected as **Default Retry Policy**. If you have created retry policies, you can select the required policy as **Default Retry Policy**.

- Create an HTTP(s) Connection in the Connections related list for the Connection & Credential alias. For more information, see credentials, connections, and aliases.
- Verify and view the details of the retry attempts by navigating to **System Logs > Outbound HTTP Requests**.

Ask for Approval step

Request approval for a record with an approval field. You can configure a rule set for an approval, rejection, or cancellation. If a due date is added to an approval, the approval is automatically approved, rejected, or canceled if the approvers have not responded by the designated time.

**Approvals** is a platform feature that enables users or groups to approve or reject a task.

Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Select a record under the data panel and drag the record pill into the Record field. If selecting a table with an approval field already configured, the <strong>Approval field</strong> is set to the correct field.</td>
</tr>
<tr>
<td>Table</td>
<td>Set to the table name associated with the record.</td>
</tr>
<tr>
<td>Approval field</td>
<td>Select a field from the designated table to use for approval status.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal field</td>
<td>Select a field from the designated table to use for journal entries.</td>
</tr>
<tr>
<td>Rules</td>
<td>Define the approval and rejection rules. Approval rules determine which users can approve or reject requests, and what happens after approval or rejection. Approval or rejection rules include:</td>
</tr>
<tr>
<td></td>
<td>• Anyone approves</td>
</tr>
<tr>
<td></td>
<td>• All users approve</td>
</tr>
<tr>
<td></td>
<td>• All responded and anyone approves</td>
</tr>
<tr>
<td></td>
<td>• % of users approve</td>
</tr>
<tr>
<td></td>
<td>• # of users approve</td>
</tr>
<tr>
<td></td>
<td>In the field beside the approval rule, add the desired approvers. To add approvers:</td>
</tr>
<tr>
<td></td>
<td>• Select individual users or groups.</td>
</tr>
<tr>
<td></td>
<td>• Drag or select a field from a record.</td>
</tr>
<tr>
<td></td>
<td>• Select to allow a manual approver to process an approval or rejection. A manual approver is a user manually added to the Approvers related list who can then approve the request. For example, you can manually add a subject matter expert to a task to approve the request. To learn more about adding manual approvers, see Generate approvals using the approvers related list.</td>
</tr>
<tr>
<td></td>
<td>Define rejection rules by adding another OR rule set. When defining approvals, include rejection rules that run when there are no matching approvals. Such rejection rules prevent the flow from remaining in a waiting state. For example, if an approval can be approved by anyone, create a time-based rejection rule in case no one approves it.</td>
</tr>
</tbody>
</table>

**Note:** If you set an approval rule with no rejection rule (or vice versa) and the expected approval state is not met, the runtime value will be canceled.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Due Date</td>
<td>Define a due date to prevent the flow from remaining endlessly waiting for approval.</td>
</tr>
<tr>
<td></td>
<td>• None: The approval is not dependent on a specific date.</td>
</tr>
<tr>
<td></td>
<td>• Approve: Automatically approve the step if an action is still pending by the specified date.</td>
</tr>
<tr>
<td></td>
<td>• Reject: Automatically reject the step if an action is still pending by the specified date.</td>
</tr>
<tr>
<td></td>
<td>• Cancel: Automatically cancel the step if an action is still pending by the specified date.</td>
</tr>
</tbody>
</table>

**Note:** Relative dates always treat days as 24 hours regardless of the days schedule you select. For example, if you create a due date that expires in 1 relative day, the due date will occur in 24 hours based on the schedule you select. For an 8-5 weekdays excluding holidays schedule, a 24-hour duration is the equivalent of 2 complete business days and 6 hours into the third business day. When working with schedules where the business day is less than 24 hours, consider using relative hours instead of days.

### Example

**1. Ask for Approval step**

#### Approval Request Definition

- **Record**: `incident`  
- **Table**: `incident`  

**Rules**

- **Approve**:  
  - **Anyone approves**:  
  - **When**: `action = incident = Assigned to = Manager`  

- **Reject**:  
  - **Anyone rejects**:  
  - **When**: `action = incident = Assigned to = Manager`  

**Due Date**

- **Approve**: If pending by `Relative date` 1 Days from `action = incident = Created`  
- **Days schedule**: 8-5 weekdays excluding holidays
Output

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval State</td>
<td>State of the approval request</td>
<td>Choice</td>
</tr>
</tbody>
</table>

Create Record step
Create a record on any table. You can dynamically add and configure fields for the record.

Roles and availability
- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a table from the list.</td>
</tr>
<tr>
<td>Field Values</td>
<td>Set static or dynamic values of fields in the record. For example, to set the short description to a static value, select <strong>Short description</strong> and set the desired value. To add dynamic values, see Allow flow designers to dynamically set field values.</td>
</tr>
</tbody>
</table>

Create or Update Record step
Create or update a record in a ServiceNow table by determining if it already exists. Add records that do not exist, and update existing ones. Identify existing records by selecting unique fields. Set field values dynamically and enforce server-side validation rules (data policy, business rules, dictionary-defined mandatory fields). UI policy does not apply.

Roles and availability
Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.
Create Task step

Create a task on any ServiceNow task table. After you choose the task table, you can dynamically select the fields to configure the action. Defining the Parent field associates the task to a parent record.

Roles and availability

• Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Name</td>
<td>Table in which a record is created or updated.</td>
</tr>
<tr>
<td>Fields</td>
<td>Values of fields in the record to be created or updated.</td>
</tr>
<tr>
<td></td>
<td>If adding the action to a subflow, you can <strong>Allow flow designers to dynamically set field values</strong>. Dynamically set field values can trigger server-side validation rules but cannot trigger UI policies.</td>
</tr>
<tr>
<td>Determines uniqueness</td>
<td>Option for selecting the field as a unique identifier. This field appears when the required table name and fields are selected.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a task table.</td>
</tr>
<tr>
<td></td>
<td>• Catalog Task [sc_task]</td>
</tr>
<tr>
<td></td>
<td>• Change Phase [change_phase]</td>
</tr>
<tr>
<td></td>
<td>• Change Request [change_request]</td>
</tr>
<tr>
<td></td>
<td>• Chat Queue Entry [chat_queue_entry]</td>
</tr>
<tr>
<td></td>
<td>• Feature Task [release_task]</td>
</tr>
<tr>
<td></td>
<td>• Follow On Task [cert_follow_on_task]</td>
</tr>
<tr>
<td></td>
<td>• Group approval [sysapproval_group]</td>
</tr>
<tr>
<td></td>
<td>• Guided Setup Task [gsw_task]</td>
</tr>
<tr>
<td></td>
<td>• IMAC [change_request_imac]</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| • Incident [incident]  
• Incident Task [incident_task]  
• KB Submission [kb_submission]  
• Orphan CI Remediation [orphan_ci_remeditation]  
• Private Task [vtb_task]  
• Problem [problem]  
• Problem Task [problem_task]  
• Reclassification Task [reclassification_task]  
• Recommended Field Remediation [recommended_field_remediation]  
• Remediate Duplicate Task [reconcile_duplicate_task]  
• Release Phase [release_phase]  
• Renew Lease Task [statemgmt_renew_lease_task]  
• Request [sc_request]  
• Request new Knowledge Base [kb_knowledge_base_request]  
• Requested Item [sc_req_item]  
• Required Field Remediation [required_field_remediation]  
• Security Case [sn_ti_case]  
• Security Incident [sn_si_incident]  
• Security Incident Response Task [sn_si_task]  
• Security Request [sn_si_scan_request]  
• Service Order [sm_order]  
• Service Order Task [sm_task]  
• Service Task [service_task]  
• Stale CI Remediation [stale_ci_remediation]  
• Standard Change Proposal [std_change_proposal]  
• Ticket [ticket] |

Field Values: Set static or dynamic values of fields in the record. For example, to set the short description to a static value, select **Short description** and set the desired value.
To add dynamic values, see Allow flow designers to dynamically set field values.

To associate the task with a parent record, define the **Parent** field.

**Wait**

Waits to complete the step until the task completes and is no longer active (active=false).

Alternatively, you can add a wait condition by dragging-and-dropping a true/false field from the data panel into the **Wait** field. The flow only waits for the task to complete when the condition field is true.

### Delete Multiple Records step

Look up and delete multiple existing records as a single action. Using this action removes the need to separately look up a list of records and then delete the list with **For Each** flow logic.

### Roles and availability

Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select the table containing the records to delete.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Define the filter condition used to look up records.</td>
</tr>
<tr>
<td>Order by</td>
<td>Select the field that you want to use to sort the records when more than one record matches the defined conditions.</td>
</tr>
<tr>
<td>Sort Type</td>
<td>Determine whether to sort the records alphabetically in ascending or descending order.</td>
</tr>
<tr>
<td>Run Business Rules and Workflow</td>
<td>Determine whether to call any business rules and workflows associated with the table.</td>
</tr>
<tr>
<td>Don't fail on error</td>
<td>Specify whether to continue running the flow when there is an error.</td>
</tr>
</tbody>
</table>
Example

1. Delete Multiple Records step

<table>
<thead>
<tr>
<th>Table</th>
<th>Catalog Item (sc_cat_item)</th>
</tr>
</thead>
</table>

**Conditions**

All of these conditions must be met

- **tags** have **discontinued**

*OR*

- **New Criteria**

**Order by** Name  
**Sort Type** a to z

**Run Business Rules and WorkFlow**

**Don’t Fail on Error**

**Data**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Count</strong></td>
<td>Number of records deleted. If no records are deleted, the count is 0.</td>
<td>Integer</td>
</tr>
<tr>
<td><strong>Error Message</strong></td>
<td>Message that is displayed if the step produces an error.</td>
<td>String</td>
</tr>
</tbody>
</table>
| **Status**  | The completion status of the step as a numeric value.  
  • 0 (success)  
  • 1 (error) | Choice    |

**Note:** The example is for illustration purposes only.

**Outputs**

**Delete Record step**

Deletes a record on any table.

**Roles and availability**

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.
Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>The record to be deleted. Drag-and-drop a record data pill or use the data pill picker to select a record.</td>
</tr>
<tr>
<td>Table</td>
<td>Read-only. Set to the table associated with the record.</td>
</tr>
</tbody>
</table>

Get Connection Info step

Provide the connection and credential details from another step, such as a REST step, to other steps in your action.

**Note:**
- The Get Connection Info step is not available in the base system and requires the subscription to IntegrationHub Starter Pack Installer (com.glide.hub.integrations) or later. For more information about the ServiceNow® IntegrationHub subscription packages, see IntegrationHub usage and subscription. After the required plugin is activated, the step is visible under Integrations.

Roles and availability

After setting up your IntegrationHub Starter subscription, the Get Connection Info step is available as an Action Designer action step. Users with the action_designer role can create a custom action with the Get Connection Info step.

Inputs

Provide a value for each input that your step needs. To add dynamic values, you can also drag and drop pills from the Data panel or select them from the pill picker.

<table>
<thead>
<tr>
<th>Input</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Choice</td>
<td>Choose from:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Connection Alias - Associates to connection information required to connect to the remote system.</td>
</tr>
<tr>
<td>Input</td>
<td>Data type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Credential Alias</td>
<td></td>
<td>- Associates to credential data required to connect to the remote system. Depending on which option you choose, the following input requires that you choose the appropriate Connection Alias or Credential Alias.</td>
</tr>
</tbody>
</table>

**Outputs**

These outputs appear in the Data panel. You can use them as inputs elsewhere in your action.

<table>
<thead>
<tr>
<th>Output</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Runtime Alias ID</td>
<td>String</td>
<td>Sys ID of the Connection Alias or Credential Alias record used to connect to the remote system.</td>
</tr>
<tr>
<td>Connection ID</td>
<td>String</td>
<td>Sys ID of the Connection record used to connect to the remote system.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>String</td>
<td>URL used to connect to the remote system.</td>
</tr>
<tr>
<td>Credential ID</td>
<td>String</td>
<td>Sys ID of the Credential record used to connect to the remote system.</td>
</tr>
<tr>
<td>Credential Value</td>
<td>Password (2 Way Encrypted)</td>
<td>2-way encrypted password used to authenticate when connecting to the remote system.</td>
</tr>
</tbody>
</table>
JDBC step

Create a reusable action to send SQL commands to a relational database.

Note:

- The JDBC step is not available in the base system and requires the subscription to IntegrationHub Standard Pack Installer (com.glide.hub.integrations.standard) or later. For more information about the ServiceNow® IntegrationHub subscription packages, see IntegrationHub usage and subscription. After the required plugin is activated, the step is visible under Integrations.

- The JDBC step runs only on a ServiceNow® MID Server with JDBC step capabilities. Activate the plugin, IntegrationHub Standard Pack Installer (com.glide.hub.integrations.standard) or later to use the JDBC capability for the MID Server.

Roles and availability

The JDBC step is available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Sanitizing inputs

Escape all user inputs to eliminate the possibility of a malicious user from executing malicious SQL statements that can result in SQL injection on your target database. When you use data pills in JDBC step SQL statements, sanitize them first using Sanitize SQL transform functions. This transform function category automatically appears when a data pill is dropped into the SQL Statement input.

SQL operations inclusion list

By default, you can run the following SQL operations.

- SELECT
- INSERT
- UPDATE
- DELETE
- SHOW
- DESCRIBE

To enable only some of these SQL operations that the JDBC step can perform, create a MID Server property, mid.property.jdbc_operations and enter the SQL
operations, separated by comma. To learn more about MID Server properties, see **MID Server properties**.

### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection Details</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Connection</strong></td>
<td>Type of connection to use.</td>
</tr>
<tr>
<td></td>
<td><strong>Define Connection Inline</strong>: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td><strong>Use Connection Alias</strong>: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action.</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see <strong>credentials, connections, and aliases</strong>.</td>
</tr>
<tr>
<td><strong>Connection Alias</strong></td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see <strong>credentials, connections, and aliases</strong>. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when <strong>Use Connection Alias</strong> is selected from the Connection list.</td>
</tr>
<tr>
<td><strong>Credential Alias</strong></td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don't need to update your custom action.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list.</td>
</tr>
</tbody>
</table>
| Database Type          | Database type for this connection. The choices are:  
• MySQL  
• Oracle  
• SQLServer  
• Custom  
The default choice is **Custom**. This field is available when **Define Connection Inline** is selected from the Connection list. |
<p>| JDBC Driver            | Driver to use for this connection when it's not a default database type such as DB2 Universal and Sybase. The database Type is <strong>Custom</strong>. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list and <strong>Custom</strong> is selected from the Database Type list. |
| Connection URL         | URL that the MID Server uses to connect to the specified database. The URL is created automatically when you save the form, and is read-only for the default databases. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list and <strong>Custom</strong> is selected from the Database Type list. |
| MID Application        | Application that the MID Server must support to be eligible for selection. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list. |
| Capabilities           | Capability of the MID Server. Select <strong>JDBC</strong>. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list. |
| Connection Timeout     | Maximum elapsed time, in seconds, for the activity to wait while attempting to connect to the target database. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list. |
| Query Timeout          | Maximum elapsed time, in seconds, that the query is allowed to run without a response. This field is available |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When <strong>Define Connection Inline</strong> is selected from the Connection list.</td>
<td></td>
</tr>
<tr>
<td>JDBC Configuration</td>
<td>SQL statement that the step executes.</td>
</tr>
<tr>
<td><strong>Note:</strong> When you use data pills in step SQL statements, sanitize them first using a preprocessing Script step. For more information, see <strong>Sanitizing inputs using the escape functions</strong>.</td>
<td></td>
</tr>
<tr>
<td>Maximum Rows</td>
<td>Maximum number of rows to be returned from the SQL statement. The default value is <strong>1000</strong>.</td>
</tr>
<tr>
<td>Maximum Payload Size (KB)</td>
<td>Maximum allowable payload size, in KB, to be returned from the SQL statement. The default payload size is <strong>5120 KB</strong>. The maximum payload size is <strong>5 MB</strong>.</td>
</tr>
</tbody>
</table>

**Retry Policy**

| Enable Retry Policy           | Option to enable the retry policy. For more information, see **Retry policy**. |
| Override Default Policy for Alias | Option to override the default retry policy. This option is not applicable when **Define Connection Inline** is selected from the Connection list. |
| Retry Policy                  | Default retry policy associated with **Connection Alias**. If **Override Default Policy for Alias** is selected, you can override the default retry policy and select another existing retry policy based on your requirement. |

**Test JDBC step**

Test the JDBC step before testing or publishing an action that contains the JDBC step.

**About this task**

It is mandatory that you test the JDBC step before testing the action. Testing ensures that the relevant complex object output schema is created from table columns, which can be used as data pills in subsequent steps.

**Procedure**

1. Navigate to **Process Automation > Flow Designer**.
2. Create an action with a JDBC step.
3. Click **Test JDBC Step**.
   The **Test JDBC Step** pop-up window is displayed.

4. If the JDBC step takes an action input or output of the previous step as its input, provide required input values in the **Step input pills** field to test the JDBC step.

   Note: Input values in the **Step input pills** fields are not needed when records are updated, inserted, or deleted.

5. Click **Run Test**.
   - When a SELECT query is executed, **Sample Result** is displayed in the **Test JDBC Step** pop-up window. **Sample Result** includes column names, columns types, and the values of the first row.
   - When an UPDATE, INSERT, or DELETE query is executed, a message is displayed mentioning the number of rows affected.

6. To use the sample result as the JDBC step output, click **Use Result**.

   Note: **Use Result** is not displayed when records are updated, inserted, or deleted.

7. To retrieve schema of a different table when a SELECT query is executed in the JDBC step, enter the required value in the **Step input pills** field and click **Run Test**.

**Results**
When a SELECT query is executed in the JDBC step, **ResultSet** is displayed under **Outputs**. The relevant complex object output is populated. To learn more about complex objects, see **Complex data**.

**What to do next**
Test and publish the action.

**Get Latest Response Text From Email step**
Provide the most recent reply or forward message in an e-mail chain to other steps in your action.

**Roles and availability**
- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.
**Inputs**

Provide a value for each input that your step needs. To add dynamic values, you can also drag and drop pills from the Data panel or select them from the pill picker.

<table>
<thead>
<tr>
<th>Input</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Record</td>
<td>Record</td>
<td>Email record whose most recent reply or forward message you want to provide to other steps in your action. Select an Email [sys_email] record from the list, or add an Email [sys_email] record data pill from the Data panel.</td>
</tr>
</tbody>
</table>

**Outputs**

These outputs appear in the Data panel. You can use them as inputs elsewhere in your action.

<table>
<thead>
<tr>
<th>Output</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Latest Response Text</td>
<td>String</td>
<td>Body text for the most recent reply or forward message in the Email [sys_email] record that you selected for the step’s input.</td>
</tr>
</tbody>
</table>

**Note:** If you select an Email [sys_email] record with a Type of New for this step’s input, the Latest Response Text output will be the entire body text of the e-mail.
Log step
Logs a message in the Flow Designer log table.

Roles and availability
• Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log level</td>
<td>Level of importance of the log message.</td>
</tr>
<tr>
<td></td>
<td>• Error</td>
</tr>
<tr>
<td></td>
<td>• Warn</td>
</tr>
<tr>
<td></td>
<td>• Info</td>
</tr>
<tr>
<td>Log message</td>
<td>Message to display in the log. Enter text or drag data pills into the field.</td>
</tr>
</tbody>
</table>

Look Up Record step
Look up a record from any table based on defined conditions.

Roles and availability
• Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a table from the list.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Set static or dynamic conditions to filter records. To define a static condition applied each time the action runs, define the conditions with the condition builder. To enable flow designers to dynamically apply conditions, define an input of type Conditions and drag-and-drop the input data pill into the Conditions field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>When building a condition that looks up the value of a reference field, use a data pill that explicitly provides the Sys ID value. Ensure the condition has the format <code>[reference field][is][Reference type data pill-&gt;Sys ID]</code>. For example, both the Change and Incident tables contain a reference field to the User table. To look up change records where the requester is the caller from an incident record, create the condition <code>[Requested by][is][action-&gt;incident-&gt;Caller-&gt;Sys ID]</code> where <code>incident</code> is an input variable for an incident record.</td>
</tr>
<tr>
<td>Order by</td>
<td>Determines how to sort results when more than one record matches the defined conditions. Select the field you want to use to sort results.</td>
</tr>
<tr>
<td>Sort Type</td>
<td>Select whether to sort alphabetically in ascending or descending order.</td>
</tr>
<tr>
<td>If multiple records are</td>
<td>Determines what is returned if more than one record matches the defined conditions.</td>
</tr>
<tr>
<td>found</td>
<td>• Return only the first record</td>
</tr>
<tr>
<td></td>
<td>• Fail the step</td>
</tr>
<tr>
<td>Don't fail on error</td>
<td>Determines whether to fail the flow if a record can’t be found.</td>
</tr>
</tbody>
</table>
Look Up Records step

Look up multiple records on any table using defined conditions.

Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a table from the list.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Set static or dynamic conditions to filter records. To define a static condition applied each time the action runs, define the conditions with the condition builder. To enable flow designers to dynamically apply conditions, define an input of type Conditions and drag-and-drop the input data pill into the Conditions field. When building a condition that looks up the value of a reference field, use a data pill that explicitly provides the Sys ID value. Ensure the condition has the format <code>[reference field] [is] [Reference type data pill -&gt; Sys ID]</code>. For example, both the...</td>
</tr>
</tbody>
</table>
Field | Description
---|---
| | Change and Incident tables contain a reference field to the User table. To look up change records where the requester is the caller from an incident record, create the condition [Requested by][is][action->incident->Caller->Sys ID] where incident is an input variable for an incident record.

Order by | Select the field you want to use to sort results.
Sort Type | Select whether to sort alphabetically in ascending or descending order.
Max Results | Maximum number of results returned.

**Outputs**

<table>
<thead>
<tr>
<th>Output</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Records</td>
<td>Records</td>
<td>Records found based on the lookup criteria you provided</td>
</tr>
<tr>
<td>Table</td>
<td>Table</td>
<td>Table name for the records found</td>
</tr>
<tr>
<td>Count</td>
<td>Integer</td>
<td>Number of records found</td>
</tr>
</tbody>
</table>

**Example**

1. **Look Up Records step**

   Table: Incident [incident]
   Conditions: All of these conditions must be met
     - Assigned to: is Bow Ruggieri
     - State: is New
   Order by: Short description
   Sort Type: a to z
   Max Results: 1000
**Notification step**

Trigger a notification as a step within an action by selecting a record (such as an incident, change request, problem, or user record) to trigger a notification and defining the associated notification.

**Notifications** is a platform feature. Before triggering a notification as an action step in Flow Designer, ensure that the notification is set up for use in the platform.

- When you **create or update the notification**, set the **Send when** field in the **When to send** tab of the Notification form to Triggered.
- Verify that your users have an active primary email channel and that all their notifications are active.

**Roles and availability**

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Drag-and-drop an input record or a record from a previous step. This is the record that will trigger a notification.</td>
</tr>
<tr>
<td>Note:</td>
<td>Some notifications are not associated with a specific record or table, such as the <strong>Passwords Require Updating</strong> notification. If configuring such a notification, leave this field blank.</td>
</tr>
<tr>
<td>Table name</td>
<td>Read-only. Set to the table of the triggering record.</td>
</tr>
<tr>
<td>Notification</td>
<td>Select the notification to be triggered. The notifications that can be selected are associated with the table of the specified record. If no record was selected, you can select a notification that does not have an associated record or table. To create notifications, see Create an email notification.</td>
</tr>
</tbody>
</table>

**Example**

1. **Notification step**

   ![Notification step example](image-url)
## Payload Builder step

Enable action designers to easily create name-value pairs in JSON and XML payloads using dynamic data.

### Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

### Fields

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name Value Pairs</td>
<td>The name-value pairs to include in the payload. Click the plus icon to add name-value pairs. Drag data pills into either field to produce dynamic payloads.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Name</strong> becomes a key in JSON and an element in XML. For example, suppose you create this name-value pair.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Name</strong>: short_description</td>
</tr>
<tr>
<td></td>
<td>- <strong>Value</strong>: [action]-&gt;[short_description]</td>
</tr>
<tr>
<td></td>
<td>When the system formats the name-value pair as JSON:</td>
</tr>
<tr>
<td></td>
<td>&quot;short_description&quot;: &quot;[action]-&gt;[short_description]&quot;</td>
</tr>
<tr>
<td></td>
<td>When the system formats the name-value pair as XML:</td>
</tr>
</tbody>
</table>

| Omit if empty           | The option to exclude a name-value pair if the value is empty or null.                                                                       |
|                        | **Note**: This field is only visible after clicking the down arrow to display advanced options.                                              |

| Output Format           | The payload file format.                                                                                                                      |
|                        |   - **JSON**: Select to format the payload as a JSON document.                                                                               |
|                        |   - **XML**: Select to format the payload as an XML document.                                                                               |

<p>| Namespace               | The XML namespace to apply to each element. For example, when the namespace is set to incident:                                              |</p>
<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note: This field is only visible when the <strong>Output Format</strong> is set to <strong>XML</strong>.</td>
<td></td>
</tr>
</tbody>
</table>
| Include Outer Structure| The option to include or exclude a top level container appropriate to the output format. When the **Output Format** is JSON, curly braces contain the name-value pairs. When the **Output Format** is XML, a specified XML element contains the name-value pairs. For example, when the system formats the name-value pair as JSON:  
   ```json
   {
     "short_description": "[action]->[short_description]
   }
   ```
   When the system formats the name-value pair as XML:  
   ```xml
   <xml>
   </xml>
   ```
| Send Empty Structure   | The option to send valid JSON or XML structures when the payload is empty. Enable this option to include JSON or XML structural text in the payload. For example, when the system formats an empty structure as JSON:  
   ```json
   {}
   ```
   When the system formats an empty structure as XML:  
   ```xml
   </xml>
   ```
   Disable this option to produce an empty payload. Empty payloads can occur when you select the **Omit if empty** option for every name-value pair, and all name-value pairs in the payload produce empty values. |
| Parent Node            | The name of the XML element that contains the name-value pairs. The default parent node element is `xml`.  
   **Note:** This field is only visible when the **Output Format** is set to **XML** and the option to **Include Outer Structure** is enabled. |
| Preview                | The read-only payload the step produces. |
PowerShell step

Run PowerShell scripts on remote machines from your ServiceNow instance through a MID Server.

PowerShell is built on the Windows .NET Framework and is designed to control and automate the administration of Windows machines and applications. ServiceNow supports PowerShell 3.0 to 5.1. PowerShell 3.0 does not support Windows 2003 Server.

Note: PowerShell step is not available in the base system and requires the ServiceNow® IntegrationHub subscription. After the required plugin is activated, the step is visible under Integrations.

Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Type of connection to use.</td>
</tr>
<tr>
<td></td>
<td>• Define Connection Inline: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• Use Connection Alias: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action.</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see credentials, connections, and aliases.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Credential Alias | Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel.  
<p>| Note: This field is available when <strong>Use Connection Alias</strong> is selected from the Connection list.                                                                                                                                                                                                                                             |
| Host            | Specify the fully-qualified domain name of the target host where the system runs the action step. For example, host.domain.com.                                                                                                                                                                                                                                                                       |
| Port            | Specify the communications port on which the target host listens for connections. For example, 5985. Leave blank to use the default port.                                                                                                                                                                                                                                                                   |
| MID Selection   | Option to select MID Server as required. This field is available when <strong>Define Connection Inline</strong> is selected from the Source Connection list.                                                                                                                                                                                                                                                                  |
| MID Application | Specify the application the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected application. If                                                                                                                                                                                                                                                                  |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>you use a data pill for this field, the pill must reference the MID Application’s name, not the MID Application record. This field is available when Define Connection Inline is selected from the Connection list and Auto-Select MID Server is selected from the MID Selection list.</td>
<td></td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capabilities the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected capabilities. This field is available when Define Connection Inline is selected from the Connection list and Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Data pill of the required MID Server. This field is available when Define Connection Inline is selected from the Connection list and Specific MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Remoting Type</td>
<td>The location where the PowerShell script runs such as the MID or a remote server.</td>
</tr>
<tr>
<td>▪ Explicit Remoting (Most Common): Establish a connection with and run the script on a remote server.</td>
<td></td>
</tr>
<tr>
<td>▪ Implicit Remoting (Advanced): Run a script on a MID Server while importing necessary modules from a remote server. If selected, define the Remote name prefix and Modules to import fields. For optimal performance, only import modules necessary to the step. If blank, all available modules are imported from the server.</td>
<td></td>
</tr>
<tr>
<td>▪ Run on a MID Server or have your script establish a remote session: Run a script directly on a MID Server, or define remoting specifications within the script. This value is the default.</td>
<td></td>
</tr>
</tbody>
</table>

⚠️ Note: To invoke a function in a PowerShell script command or PowerShell script file, the command must define the function param block if the function has input parameters. This requirement applies to explicit and implicit remoting. For additional information on param block, see Microsoft’s documentation on Windows Powershell parameters at https://technet.microsoft.com/.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote name prefix</td>
<td>The file path, excluding file names, to the modules to load from the remote server.</td>
</tr>
<tr>
<td><strong>Note</strong>: This field is only visible when the Remoting Type is Implicit Remoting (Advanced).</td>
<td></td>
</tr>
<tr>
<td>Modules to import</td>
<td>The comma-separated list of modules to import from the remote server at the defined file path.</td>
</tr>
<tr>
<td><strong>Note</strong>: This field is only visible when the Remoting Type is Explicit Remoting (Most Common) or Implicit Remoting (Advanced).</td>
<td></td>
</tr>
<tr>
<td>Script type</td>
<td>The type of script to run on the PowerShell host.</td>
</tr>
<tr>
<td>• Inline script: Enter the script to run in the Command field of the step.</td>
<td></td>
</tr>
<tr>
<td>• MID Server Script File: Select the PowerShell script to run from the MID Server Script Files [ecc_agent_script_file] table. This is the default value and separates scripting logic from the action, enabling you to update the script without having to modify and redeploy the action.</td>
<td></td>
</tr>
<tr>
<td>MID Server Script</td>
<td>Pre-defined PowerShell script from the MID Server Script Files table [ecc_agent_script_file].</td>
</tr>
<tr>
<td><strong>Note</strong>: This field is only available if the Script type is MID Server Script File.</td>
<td></td>
</tr>
<tr>
<td>Script path</td>
<td>Read-only path to the selected MID Server script.</td>
</tr>
<tr>
<td><strong>Note</strong>: This field is only visible when the Script type is MID Server Script File.</td>
<td></td>
</tr>
<tr>
<td>Input variables</td>
<td>The optional name-value pairs that represent the values of PowerShell script variables. You can use action inputs and data from other steps within the PowerShell script. Define the following fields for each variable:</td>
</tr>
</tbody>
</table>
| • Name: The name of the script variable to pass a value to. The name cannot match a reserved or prohibited PowerShell variable. Some variable names are reserved for internal processing and should not be used as input variables. See Reserved variables in PowerShell scripting variables.
### Field | Description
--- | ---
• **Type**: The type of PowerShell variable. Select plain text, encrypted, or boolean. If encrypted is selected, the value appears in plain text in this field and is only encrypted when it passes to the ECC Queue.
• **Value**: The value to map to the variable. Manually enter a value, or drag a data pill into the field.

### Command
The inline PowerShell script to run on the target host.

**Note**: This field is only visible when the **Script type** is **Inline script**.

---

**PowerShell scripting variables**

To access input variables from the **Command** field, you must call them using special syntax. The syntax you use depends on the value of a system property. If the **Remoting Type** is **Run on a MID Server or have your script establish a remote session**, some reserved variables are available in addition to input variables.

#### Input variable syntax

By default, prefix variable names with a $ character. For example, if an input variable is named `message`, use `$message` to access the variable in script.

If the `mid.powershell.command.script.parameter_passing` parameter is set to false, prefix the variable name with `$env:SNC_`. For example, if an input variable is named `message`, use `$env:SNC_message` to access the variable in script. To learn more about the `mid.powershell.command.script.parameter_passing` parameter, see **MID Server parameters**.

#### Reserved variables

When the **Remoting Type** is **Run on a MID Server or have your script establish a remote session**, the following variables are available for use in script. Reserved variables cannot be used as custom input variable names.

<table>
<thead>
<tr>
<th>Reserved variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>$computer</code></td>
<td>Host IP address defined in the Connection alias record.</td>
</tr>
<tr>
<td><code>$cred</code></td>
<td>Credential object that contains the credentials defined in the connection record. Use this</td>
</tr>
</tbody>
</table>
### Reserved variable

<table>
<thead>
<tr>
<th>Reserved variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>variable</code></td>
<td>variable with any PowerShell cmdlet that supports the credential parameter. For example, <code>New-PSSession -credential $cred</code>.</td>
</tr>
<tr>
<td><code>$log_info</code></td>
<td>If the <code>mid.property.powershell.log_info</code> property is set to true, adds logging information to a PowerShell script.</td>
</tr>
</tbody>
</table>

The following variable names are reserved for internal processing and should not be used as input variables.

- `script`
- `useCred`
- `isMid`
- `isDiscovery`
- `debug`
- `user`
- `password`
- `executingScriptDirectory`
- `midScriptDirectory`
- `hresult`

### REST step

Send an outbound REST web service request to an external system.

**Note:** REST step is not available in the base system and requires the ServiceNow® IntegrationHub subscription. After the required plugin is activated, the step is visible under Integrations.

Outbound REST web service is a platform feature that enables you to retrieve, create, update, or delete data on a web services server that supports the REST architecture.

### Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.
## Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Type of connection to use.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Define Connection Inline</strong>: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Connection Alias</strong>: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action.</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see <a href="#">credentials, connections, and aliases</a>.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see <a href="#">credentials, connections, and aliases</a>. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel.</td>
</tr>
<tr>
<td></td>
<td>️ <strong>Note:</strong> This field is available when <strong>Use Connection Alias</strong> is selected from the Connection list.</td>
</tr>
<tr>
<td>Credential Alias</td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don't need to update your custom action. To learn more about connections and credentials, see <a href="#">credentials, connections, and aliases</a>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Use MID</td>
<td>Option to use a ServiceNow® MID Server to run the REST step. Select this check box to display the MID Application and Capabilities fields.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The system doesn't log REST request, response, and parameter runtime data sent via a MID server in the same way that outbound web services logging occurs. Instead, you can view this data in the flow execution details.</td>
</tr>
<tr>
<td>Base URL</td>
<td>Base URL for the REST request. If Use Connection Alias is selected, this field is read-only and displays the base URL associated with alias. If Define Connection Inline is selected, enter a base URL for the connection.</td>
</tr>
<tr>
<td>Connection Timeout</td>
<td>Number of milliseconds the system waits for a successful host connection. If the step does not make a successful connection during this time, the connection request times out. If Define Connection Inline is selected, enter a timeout value for the connection. Leave this field empty to use the system default connection timeout value.</td>
</tr>
<tr>
<td>MID Selection</td>
<td>Option to select MID Server as required. This field is available when Define Connection Inline is selected from the Source Connection list.</td>
</tr>
<tr>
<td>MID Application</td>
<td>Capabilities the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected capabilities. This field is available when Define Connection Inline is selected from the Connection list, Use MID check box is enabled, and Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capabilities the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected capabilities. This field is available when Define Connection Inline is selected from the Connection list, Use MID check box is enabled, and Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Data pill of the required MID Server. This field is available when Define Connection Inline is selected from the Connection list, Use MID check box is enabled, and Specific MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Build Request</td>
<td>Option to create the request manually, or import an OpenAPI Specification.</td>
</tr>
<tr>
<td></td>
<td>• Manually: Create action inputs and complete the REST step form manually.</td>
</tr>
<tr>
<td></td>
<td>• From OpenAPI specification: Import an OpenAPI Specification to generate action inputs and complete the REST step form. For more information, see OpenAPI support in the REST step.</td>
</tr>
<tr>
<td>API Source</td>
<td>Option to select an OpenAPI Specification used to construct the request, or select Import OpenAPI to import a new OpenAPI Specification. You can import specifications by providing a URL to the YAML or JSON, or copying and pasting content.</td>
</tr>
<tr>
<td></td>
<td>✠ Note: This field is available when you select From OpenAPI specification from the Build Request list.</td>
</tr>
<tr>
<td>API Operation</td>
<td>Option to select an operation from the list. Available operations are provided by the OpenAPI Specification in the API Source field.</td>
</tr>
<tr>
<td></td>
<td>✠ Note: This field is available when you select From OpenAPI specification from the Build Request list.</td>
</tr>
<tr>
<td>Resource Path</td>
<td>Path for the resource.</td>
</tr>
<tr>
<td>HTTP Method</td>
<td>HTTP method used to process the request.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>GET</td>
<td></td>
</tr>
<tr>
<td>POST</td>
<td></td>
</tr>
<tr>
<td>PUT</td>
<td></td>
</tr>
<tr>
<td>PATCH</td>
<td></td>
</tr>
<tr>
<td>DELETE</td>
<td></td>
</tr>
</tbody>
</table>

**Query Parameters**

Name-value pairs to pass to the REST endpoint. You can create these parameters manually, or drag input variables into the parameter fields, and then assign a value.

Support REST step requests that contain duplicate query parameter names. If you create a REST request that contains duplicate query parameter names, Flow Designer adds the query parameters to the request in the same order as you defined them.

**Note:** When importing an OpenAPI Specification, the system adds all parameters and headers present in the specification to the REST step. Review the final REST step values and remove parameters you do not want to send in the request. For example, if the API accepts content type headers for both JSON and XML, the system adds both headers to the REST step. Remove one of the headers depending on the content type you want to receive in the response.

<p>| Headers        | Headers to send with the request. You can create headers manually, or drag input variables into the parameter fields, and then assign a value. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Note: When importing an OpenAPI Specification, the system adds all parameters and headers present in the specification to the REST step. Review the final REST step values and remove parameters you do not want to send in the request. For example, if the API accepts content type headers for both JSON and XML, the system adds both headers to the REST step. Remove one of the headers depending on the content type you want to receive in the response.</td>
<td></td>
</tr>
<tr>
<td>Request Type</td>
<td>Format of the request. Options include.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Text</strong>: A request in JSON, XML, or other text format.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Binary</strong>: A request in a binary file format.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Multipart</strong>: A request consisting of multiple content types.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Form URL-Encoded</strong>: A request in a URL-encoded query.</td>
</tr>
<tr>
<td>Note: This field is editable when the HTTP Method is POST, PUT, PATCH, or DELETE.</td>
<td></td>
</tr>
<tr>
<td>Request Body [Text]</td>
<td>Body of the request in JSON or XML format. The flow execution details display the response body as either a link to the embedded text viewer or the sys_id of the attachment record containing the response.</td>
</tr>
<tr>
<td>Note: This field is editable if you select <strong>Text</strong> from the Request Type list.</td>
<td></td>
</tr>
<tr>
<td>Attachment</td>
<td>Attachment record containing the request. You can look up or create this record in a prior step and define it as an input variable. Create it using the <strong>JSONStreamingBuilder</strong> and <strong>XMLStreamingBuilder</strong> APIs in the Script step.</td>
</tr>
<tr>
<td>Note: This field is available when you select <strong>Binary</strong> from the Request Type list.</td>
<td></td>
</tr>
<tr>
<td>Name, Type, Value</td>
<td>Content of a multiple part request. For each request part, specify its name, content type, and value. The name can be any valid string and the type can be</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Name, Value</td>
<td>Content of a form URL-encoded request. Specify each part of the URL-encoded request with a name-value pair.</td>
</tr>
<tr>
<td>Enable Retry Policy</td>
<td>Option to enable the retry policy. For more information, see Retry policy.</td>
</tr>
<tr>
<td>Override Default Policy for Alias</td>
<td>Option to override the default retry policy. This check box is not applicable when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Default retry policy associated with Connection Alias. If Override Default Policy for Alias is selected, you can override the default retry policy and select another existing retry policy based on your requirement.</td>
</tr>
<tr>
<td>Save As Attachment</td>
<td>Option to specify whether to save the response as a record in the Attachment [sys_attachment] table.</td>
</tr>
<tr>
<td>Attachment File Name</td>
<td>Name of the attachment created by the REST response. For example, rest-response.txt.</td>
</tr>
<tr>
<td>Attachment File Record</td>
<td>Target record to which the attachment is associated. The target record must be a data pill of type Record. For example, a specific incident record. You can look</td>
</tr>
</tbody>
</table>
REST response size limits

By default, the system limits the size of REST responses that are not saved as attachments to 5 MB. Direct REST responses that exceed this limit generate an error. To support larger response sizes, either save the response as an attachment or increase the response size limit with the `glide.pf.rest.response_payload_max_size` system property. This system property supports a maximum value of 10 MB.

Script step

Add custom JavaScript to execute within a reusable action. While most core actions and steps fit common use cases, you can build a Script step to execute behavior not satisfied by the core steps.

Roles and availability

- Available as an Action Designer action step. Users with the `action_designer` role can create a custom action with one or more action steps.
- The Script step is available by default to run JavaScript on a local instance.

Note: An IntegrationHub subscription is required to enable integration features such as running a Script step on a MID Server. See Request IntegrationHub for information about IntegrationHub usage and subscriptions.

Fields

The Script step includes separate input and output variables that enable you to map JavaScript data to Flow Designer data. By defining input and output variables within the step, you can define what Flow Designer data is available within your script, and which scripting variables are available to other steps in your action.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Required Runtime         | The runtime environment required to support the script. Choices include:  
  • **Instance**: The action step runs the script from instance. Select this option when the script needs access to the ServiceNow API or instance data. This is the default value.  
  • **MID**: The action step runs the script from the MID Server. Select this option when the script needs access to MID Server script files and APIs. Selecting this option displays the **Select MID Server Using** field.  
  • **Vanilla (Core JavaScript)**: The action step runs the script from either the instance or MID Server. Select this option when the script only needs the core JavaScript APIs and not the ServiceNow API or instance data.  
  The runtime you select determines the JavaScript objects and methods displayed in the Context-sensitive help.  
  **Note**: This field is only visible when IntegrationHub is activated. |
| Select MID Server Using  | Specify the MID Server selection process to use. Choices include:  
  • **Any MID**: The system runs the action step from any available MID Server.  
  • **Use Connection Alias**: The system runs the action using the connection alias you specify. Selecting this option displays the **Connection Alias** field.  
  • **Use Inline Selection**: The system runs the action using the connection details you specify in the action. Selecting this option displays the **Host**, **MID Application**, and **Capabilities** fields.  
  **Note**: This field is only visible when IntegrationHub is activated, and you select **MID** from **Required Runtime**. |
<p>| Connection Alias         | Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. Only aliases of connection type Basic are supported.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field is only visible when IntegrationHub is activated, and you select <strong>Use Connection Alias</strong> from Select MID Server Using.</td>
</tr>
<tr>
<td>Host</td>
<td>The fully-qualified domain name of the MID Server where the system runs the action step. For example, mid-server.domain.com.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field is only visible when IntegrationHub is activated, and you select <strong>Use Inline Selection</strong> from Select MID Server Using.</td>
</tr>
<tr>
<td>MID Selection</td>
<td>Option to select MID Server as required. This field is available when <strong>Define Connection Inline</strong> is selected from the Source Connection list.</td>
</tr>
<tr>
<td>MID Application</td>
<td>Specify the application the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected application. This field is only visible when IntegrationHub is activated, <strong>Auto-Select MID Server</strong> is selected from the MID Selection list, and you select <strong>Use Inline Selection</strong> from Select MID Server Using.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capabilities the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected capabilities. This field is only visible when IntegrationHub is activated, <strong>Auto-Select MID Server</strong> is selected from the MID Selection list, and you select <strong>Use Inline Selection</strong> from Select MID Server Using.</td>
</tr>
<tr>
<td>Specific MID Server</td>
<td>Data pill of the required MID Server. This field is only visible when IntegrationHub is activated, <strong>Specific MID Server</strong> is selected from the MID Selection list, and you select <strong>Use Inline Selection</strong> from Select MID Server Using.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Input variables</td>
<td>Name-value pairs that represent data from the action, enabling you to use action inputs and data from other steps within a script.</td>
</tr>
<tr>
<td>Script</td>
<td>Script that executes within the action. To access input and output variables in your script, use the global objects inputs and outputs. For example, <code>inputs.myVariable</code>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Script step input and output names can’t include any of the following reserved system names:</td>
</tr>
<tr>
<td></td>
<td>• <code>sys_id</code></td>
</tr>
<tr>
<td></td>
<td>• <code>sys_created_by</code></td>
</tr>
<tr>
<td></td>
<td>• <code>sys_created_on</code></td>
</tr>
<tr>
<td></td>
<td>• <code>sys_updated_on</code></td>
</tr>
<tr>
<td></td>
<td>• <code>sys_updated_by</code></td>
</tr>
<tr>
<td></td>
<td>• <code>sys_mod_count</code></td>
</tr>
<tr>
<td></td>
<td>By default, Flow Designer run scripts on the instance. To run script from a MID Server requires an IntegrationHub subscription.</td>
</tr>
<tr>
<td></td>
<td>Flow Designer runs script from the domain from which it is triggered or initiated. See Domain separation and Flow Designer.</td>
</tr>
<tr>
<td></td>
<td>For available classes and methods, see the JavaScript API context-sensitive help or the JavaScript API reference.</td>
</tr>
<tr>
<td>Output variables</td>
<td>Map JavaScript output to Flow Designer data pills. Define output variables when you want other steps in the action to use the script output.</td>
</tr>
</tbody>
</table>

**Example**

This example builds a JSON payload that can be easily updated or changed and added to a subsequent REST step.

**Note:** REST step is not available in the base system and requires the ServiceNow® IntegrationHub subscription.
By creating an output variable that represents the payload, you can drag the [Payload] data pill into the REST step **Body** field.

### Send Email step
Send an email to specified users or groups as an action in a flow.

### Roles and availability
- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Record</td>
<td>Record that the email is associated to. When a user sends a reply to your email, the target record is updated with the reply email content.</td>
</tr>
<tr>
<td>Table</td>
<td>Table of the target record.</td>
</tr>
<tr>
<td>Include Watermark</td>
<td>Option to apply a watermark to the email that is sent. To include a watermark, you must set a target record.</td>
</tr>
<tr>
<td>To</td>
<td>The main recipients of the email. Enter a list of user email addresses separated by commas or white spaces. You can also drag data pills that contain email addresses into the field, such as a User record. For example, if you want to send an email to</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
| the group assigned to the incident, drag the **[Assignment group]** data pill from the data panel.  
CC | Additional recipients copied on this email. Enter a list of user email addresses separated by commas or white spaces. You can also drag data pills that contain email addresses into the field.  
BCC | Additional recipients of this email, who are visible only to the sender (blind copied). Enter a list of user email addresses separated by commas or white spaces. You can also drag data pills that contain email addresses into the field.  
Subject | Subject of the email. You can enter text or drag data pills into the field.  
Body | The content of the message body. You can enter text or drag data pills into the field.  

**Note:** Flow Designer does not support the `${URI}` parameter in the email message body. To create a link to a record, use data pills, or create a notification step instead.

### Testing the email step
To verify that the email was generated when testing the action, review the email record in the Email `[sys_email]` table. The **Headers** field indicates whether the email was successfully generated. For example:

```
X-ServiceNow-Source:FlowDesigner-9ad2747b0b710300f4eb8bf637673a1e
Message-ID:<193756824.0.1508534586438@[10.0.66.70]>
X-ServiceNow-Generated:true
```

ACL restrictions apply to the Send Email action. If you configured your flow to run as the user who initiates the session, ensure that the user can access email. To test access controls for a Send Email action, impersonate a typical email sender and manually trigger the flow.

### SFTP step
Create a reusable action to manage files and directories on an SFTP server and to move files from one SFTP server to another.
Note:

• The SFTP step is not available in the base system and requires the subscription to IntegrationHub Professional Pack Installer (com.glide.hub.integrations.professional). For more information about the ServiceNow® IntegrationHub subscription packages, see IntegrationHub usage and subscription. After the required plugin is activated, the step is visible under Integrations.

• The SFTP step runs only on a ServiceNow® MID Server with SSH capabilities. Activate the plugin, IntegrationHub Professional Pack Installer (com.glide.hub.integrations.professional) to use the JDBC capability for the MID Server.

Roles and availability
The SFTP step is available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Prerequisite
Activate the Managed File Transfer Extensions for the SFTP Step (com.glide.hub.action_step.sftp_mft) plugin.

SFTP commands
• Copy File
• Copy Directory
• Create Directory
• Get File List
• Remove File
• Remove Files
• Delete Directory
• Rename File or Directory
• Set File Attributes
• Copy Attachments To SFTP Server
• Copy Files To This Instance

Note: The SFTP commands can be performed on a maximum of 10,000 files at a time.

Copy File
Copies a file from the source SFTP server to target SFTP server.
# Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Connections**            | Type of connection to use to connect to the source SFTP server.  
• **Define Connection Inline**: Define connection information within the action step.  
• **Use Connection Alias**: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action.  
To learn more about connections and credentials, see credentials, connections, and aliases. |
| **Source Connection**      | Connection & Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when Use Connection Alias is selected from the Source Connection list. |
| **Target Connection**      | Type of connection to use to connect to the target SFTP server.  
• **Define Connection Inline**: Define connection information within the action step.  
• **Use Connection Alias**: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Connection Alias</td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases.</td>
</tr>
<tr>
<td>Source Credential alias</td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when Define Connection Inline is selected from the Source Connection list.</td>
</tr>
<tr>
<td>Host</td>
<td>Name or IP address of the SFTP server that contains the files you wish to copy.</td>
</tr>
<tr>
<td>Port</td>
<td>Port number to communicate with the server.</td>
</tr>
<tr>
<td>MID Selection</td>
<td>Option to select MID Server as required. This field is available when Define Connection Inline is selected from the Source Connection list.</td>
</tr>
<tr>
<td>MID Application</td>
<td>Option to use a MID Server to run the SFTP step. This field is available when Define Connection Inline is selected from the Source Connection list and Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capability of the MID Server. Select SSH. This field is available when Define Connection Inline is selected from the Source Connection list and Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
</tbody>
</table>
**Field** | **Description**
---|---
MID Server | Data pill of the required MID Server. This field is available when Define Connection Inline is selected from the Source Connection list and Specific MID Server is selected from the MID Selection list.

**Command Details**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Path</td>
<td>Full path to the file in the source server you wish to copy. For example, /root/doc/tempwsdl.rtf.</td>
</tr>
<tr>
<td>Target Path</td>
<td>Full path to the file in the target server you wish to copy the contents. For example, /root/doc/attribute.rtf. In this case, the contents of the tempwsdl.rtf are copied to the file, attribute.rtf.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Option to enable the retry policy. For more information, see Retry policy.</td>
</tr>
<tr>
<td>Override Default Policy for Alias</td>
<td>Option to override the default retry policy. This option is not applicable when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Default retry policy associated with Connection Alias. If Override Default Policy for Alias is selected, you can override the default retry policy and select another existing retry policy based on your requirement.</td>
</tr>
</tbody>
</table>

**Copy Directory**

Copies a directory from the source SFTP server to the target SFTP server.

*Note:* If you wish to use the Managed File Transfer feature while copying a directory, activate the ServiceNow IntegrationHub Action Step - MFT (com.glide.hub.action_step.mft) plugin.

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>Type of connection to use to connect to the source SFTP server.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source Connection Alias</td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when Use Connection Alias is selected from the Source Connection list.</td>
</tr>
<tr>
<td>Target Connection</td>
<td>Type of connection to use to connect to the target SFTP server.</td>
</tr>
<tr>
<td>Target Connection Alias</td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases.</td>
</tr>
</tbody>
</table>

**Define Connection Inline**: Define connection information within the action step.

**Use Connection Alias**: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action.

To learn more about connections and credentials, see credentials, connections, and aliases.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when Define Connection Inline is selected from the Source Connection list.</td>
</tr>
<tr>
<td>Host</td>
<td>Name or IP address of the SFTP server that contains the files you wish to copy.</td>
</tr>
<tr>
<td>Port</td>
<td>Port number to communicate with the server.</td>
</tr>
<tr>
<td>MID Selection</td>
<td>Option to select MID Server as required.</td>
</tr>
<tr>
<td>MID Application</td>
<td>Option to use a MID Server to run the SFTP step. This field is available when Define Connection Inline is selected from the Source Connection list and Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capability of the MID Server. Select SSH. This field is available when Define Connection Inline is selected from the Source Connection list and Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Data pill of the required MID Server. This field is available when Define Connection Inline is selected from the Source Connection list and Specific MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Command Details</td>
<td></td>
</tr>
<tr>
<td>Source Path</td>
<td>Full path to the file in the source server you wish to copy. For example, /root/doc/tempwsdl.rtf.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Target Path</td>
<td>Full path to the file in the target server you wish to copy the contents. For example, /root/doc/attribute.rtf. In this case, the contents of the tempwsdl.rtf are copied to the file, attribute.rtf.</td>
</tr>
</tbody>
</table>
| Include Files         | List of target files to remove. This is a comma separated list that accepts wild cards, such as *.txt.  

**Note:**  
• If no value is provided, subfolders in the specified directory are deleted.  
• If a value is provided, subfolders are not deleted even if they are empty.  
| Exclude Files         | List of target files that should not be removed. This is a comma separated list that accepts wild cards, such as *.txt.  

**Note:**  
• If no value is provided, subfolders in the specified directory are deleted.  
• If a value is provided, subfolders are not deleted even if they are empty.  
| Include Subfolders    | Option to copy subfolders in the source directory.                          |
| Managed File Transfer |                                                                             |
| Target File Name      | Name of the target file.                                                   |
| Target Directory Name | Name of the target directory.                                              |
| Datetime Format       | Format in which the date and time should be appended to the file name upon copying to the target server.  

${DateTime}$  
<p>| Preserve File Attributes | Option to preserve the file attributes upon copying files to the target directory. |
| Apply Move Conditions  | Option to specify conditions while moving files.                            |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Minimum File Size (Bytes)</strong></td>
<td>Minimum size requirements to move files.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Note: This field is available when Apply Move Conditions is enabled." /></td>
</tr>
<tr>
<td><strong>Maximum File Size (Bytes)</strong></td>
<td>Maximum size requirements to move files.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Note: This field is available when Apply Move Conditions is enabled." /></td>
</tr>
<tr>
<td>File is Newer than</td>
<td>Files created after this date are moved.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Note: This field is available when Apply Move Conditions is enabled." /></td>
</tr>
<tr>
<td>File is Older than</td>
<td>Files created before this date are moved.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Note: This field is available when Apply Move Conditions is enabled." /></td>
</tr>
<tr>
<td>Move Order</td>
<td>Order in which the files should be moved.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Note: This field is available when Apply Move Conditions is enabled." /></td>
</tr>
<tr>
<td>Sort Order</td>
<td>Order in which the files should be sorted.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Note: This field is available when Apply Move Conditions is enabled." /></td>
</tr>
<tr>
<td>Duplicate File Action</td>
<td>Action to be performed when a duplicate file exists in the target directory.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Note: This field is available when Apply Move Conditions is enabled." /></td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Option to enable the retry policy.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Retry policy." /></td>
</tr>
<tr>
<td>Override Default Policy for Alias</td>
<td>Option to override the default retry policy. This option is not applicable when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Default retry policy associated with Connection Alias. If Override Default Policy for Alias is selected, you can override the default retry policy.</td>
</tr>
</tbody>
</table>
retry policy and select another existing retry policy based on your requirement.

Managed File Transfer Error Cleanup

<table>
<thead>
<tr>
<th>Upon Failure, Remove Files on Target</th>
<th>Option to remove files from the target SFTP server when the copy command fails.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upon Success, Remove Files from Source</td>
<td>Option to remove files from the source SFTP server when the copy command is executed successfully.</td>
</tr>
</tbody>
</table>

Create Directory

Creates a new directory on an SFTP server.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>Type of connection to use to connect to the source SFTP server.</td>
</tr>
<tr>
<td>Source Connection</td>
<td>• Define Connection Inline: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• Use Connection Alias: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action.</td>
</tr>
<tr>
<td>Source Connection Alias</td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials</td>
</tr>
</tbody>
</table>

To learn more about connections and credentials, see credentials, connections, and aliases.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when <strong>Use Connection Alias</strong> is selected from the Source Connection list.**</td>
<td></td>
</tr>
<tr>
<td>Source Credential alias</td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when <strong>Define Connection Inline</strong> is selected from the Source Connection list.**</td>
</tr>
<tr>
<td>Host</td>
<td>Name or IP address of the SFTP server where you wish to create directory.</td>
</tr>
<tr>
<td>Port</td>
<td>Port number to communicate with the server.</td>
</tr>
<tr>
<td>MID Selection</td>
<td>Option to select MID Server as required. This field is available when <strong>Define Connection Inline</strong> is selected from the Source Connection list.</td>
</tr>
<tr>
<td>MID Application</td>
<td>Option to use a MID Server to run the SFTP step. This field is available when <strong>Define Connection Inline</strong> is selected from the Source Connection list and <strong>Auto-Select MID Server</strong> is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capability of the MID Server. Select <strong>SSH</strong>. This field is available when <strong>Define Connection Inline</strong> is selected from the Source Connection list and <strong>Auto-Select MID Server</strong> is selected from the MID Selection list.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Data pill of the required MID Server. This field is available when <strong>Define Connection Inline</strong> is selected from the Source Connection list and <strong>Specific MID Server</strong> is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Command Details</td>
<td></td>
</tr>
</tbody>
</table>
### Get File List

Returns a list of files from a given directory and its subfolders on an SFTP server.

⚠ **Note:** This SFTP command runs only on a ServiceNow® MID Server.

### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Path</td>
<td>Path of the directory you wish to create.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td></td>
</tr>
<tr>
<td>Enable Retry Policy</td>
<td>Option to enable the retry policy. For more information, see Retry policy.</td>
</tr>
<tr>
<td>Override Default Policy for Alias</td>
<td>Option to override the default retry policy. This option is not applicable when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Default retry policy associated with Connection Alias. If Override Default Policy for Alias is selected, you can override the default retry policy and select another existing retry policy based on your requirement.</td>
</tr>
</tbody>
</table>

### Get File List

Returns a list of files from a given directory and its subfolders on an SFTP server.

⚠ **Note:** This SFTP command runs only on a ServiceNow® MID Server.

### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Connection</td>
<td>Type of connection to use to connect to the source SFTP server.</td>
</tr>
<tr>
<td></td>
<td>• Define Connection Inline: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• Use Connection Alias: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action.</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see credentials, connections, and aliases.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source Connection Alias</td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when <strong>Use Connection Alias</strong> is selected from the Source Connection list.</td>
</tr>
<tr>
<td>Source Credential alias</td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when <strong>Define Connection Inline</strong> is selected from the Source Connection list.</td>
</tr>
<tr>
<td>Host</td>
<td>Name or IP address of the SFTP server that contains the files you wish to list.</td>
</tr>
<tr>
<td>Port</td>
<td>Port number to communicate with the server.</td>
</tr>
<tr>
<td>MID Selection</td>
<td>Option to select MID Server as required. This field is available when <strong>Define Connection Inline</strong> is selected from the Source Connection list.</td>
</tr>
<tr>
<td>MID Application</td>
<td>Option to use a MID Server to run the SFTP step. This field is available when <strong>Define Connection Inline</strong> is selected from the Source Connection list and <strong>Auto-Select MID Server</strong> is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capability of the MID Server. Select <strong>SSH</strong>. This field is available when <strong>Define Connection Inline</strong> is selected from the Source Connection list and <strong>Auto-Select MID Server</strong> is selected from the MID Selection list.</td>
</tr>
</tbody>
</table>
### Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server</td>
<td>Data pill of the required MID Server. This field is available when Define Connection Inline is selected from the Source Connection list and Specific MID Server is selected from the MID Selection list.</td>
</tr>
</tbody>
</table>

#### Command Details

<table>
<thead>
<tr>
<th>Source Path</th>
<th>Path of the directory that contains the files you wish to list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Files</td>
<td>List of target files to include. This is a comma separated list that accepts wild cards, such as *.txt.</td>
</tr>
<tr>
<td>Exclude Files</td>
<td>List of target files to exclude. This is a comma separated list that accepts wild cards, such as *.txt.</td>
</tr>
<tr>
<td>Include Subfolders</td>
<td>Option to specify if files from subfolders are included in the list.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td></td>
</tr>
<tr>
<td>Enable Retry Policy</td>
<td>Option to enable the retry policy. For more information, see Retry policy.</td>
</tr>
<tr>
<td>Override Default Policy for Alias</td>
<td>Option to override the default retry policy. This option is not applicable when Define Connection Inline is selected from the Connection list.</td>
</tr>
</tbody>
</table>

#### Retry Policy

| Retry Policy | Default retry policy associated with Connection Alias. If Override Default Policy for Alias is selected, you can override the default retry policy and select another existing retry policy based on your requirement. |

### Remove File

Removes a file on an SFTP server, including subfolders, when configured.

### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>Type of connection to use to connect to the source SFTP server.</td>
</tr>
<tr>
<td>Source Connection</td>
<td></td>
</tr>
</tbody>
</table>
- **Define Connection Inline**: Define connection information within the action step.

- **Use Connection Alias**: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action.

To learn more about connections and credentials, see credentials, connections, and aliases.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Connection Alias</td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when <strong>Use Connection Alias</strong> is selected from the Source Connection list.</td>
</tr>
<tr>
<td>Source Credential alias</td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when <strong>Define Connection Inline</strong> is selected from the Source Connection list.</td>
</tr>
<tr>
<td>Host</td>
<td>Name or IP address of the SFTP server that contains the file you wish to remove.</td>
</tr>
<tr>
<td>Port</td>
<td>Port number to communicate with the server.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MID Selection</td>
<td>Option to select MID Server as required. This field is available when Define Connection Inline is selected from the Source Connection list.</td>
</tr>
<tr>
<td>MID Application</td>
<td>Option to use a MID Server to run the SFTP step. This field is available when Define Connection Inline is selected from the Source Connection list and Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capability of the MID Server. Select SSH. This field is available when Define Connection Inline is selected from the Source Connection list and Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Data pill of the required MID Server. This field is available when Define Connection Inline is selected from the Source Connection list and Specific MID Server is selected from the MID Selection list.</td>
</tr>
</tbody>
</table>

**Command Details**

<table>
<thead>
<tr>
<th>Source Path</th>
<th>Path of the directory that contains the file you wish to remove.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retry Policy</td>
<td>Option to enable the retry policy. For more information, see Retry policy.</td>
</tr>
<tr>
<td>Enable Retry Policy</td>
<td>Option to override the default retry policy. This option is not applicable when Define Connection Inline is selected from the Connection list.</td>
</tr>
</tbody>
</table>

**Override Default Policy for Alias**

| Retry Policy       | Default retry policy associated with Connection Alias. If Override Default Policy for Alias is selected, you can override the default retry policy and select another existing retry policy based on your requirement. |

**Remove Files**

Remove files on an SFTP server, including subfolders, when configured.
## Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connections</strong></td>
<td></td>
</tr>
<tr>
<td>Source Connection</td>
<td>Type of connection to use to connect to the source SFTP server.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Define Connection Inline</strong>: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Connection Alias</strong>: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases.</td>
</tr>
<tr>
<td>Source Connection Alias</td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when Use Connection Alias is selected from the Source Connection list.</td>
</tr>
<tr>
<td>Source Credential alias</td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when Define Connection Inline is selected from the Source Connection list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Host</td>
<td>Name or IP address of the SFTP server that contains the file you wish to remove.</td>
</tr>
<tr>
<td>Port</td>
<td>Port number to communicate with the server.</td>
</tr>
<tr>
<td>MID Selection</td>
<td>Option to select MID Server as required. This field is available when Define Connection Inline is selected from the Source Connection list.</td>
</tr>
<tr>
<td>MID Application</td>
<td>Option to use a MID Server to run the SFTP step. This field is available when Define Connection Inline is selected from the Source Connection list and Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capability of the MID Server. Select SSH. This field is available when Define Connection Inline is selected from the Source Connection list and Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Data pill of the required MID Server. This field is available when Define Connection Inline is selected from the Source Connection list and Specific MID Server is selected from the MID Selection list.</td>
</tr>
</tbody>
</table>

**Command Details**

- **Source Path**: Path of the directory that contains the files you wish to remove.
- **Apply Remove Conditions**: Option to specify conditions to remove files.

**Include Files**: List of target files to remove. This is a comma separated list that accepts wild cards, such as *.txt.*

<details>
<summary>Note:</summary>

- If no value is provided, subfolders in the specified directory are deleted.
- If a value is provided, subfolders are not deleted even if they are empty.

</details>

**Exclude Files**: List of target files that should not be removed. This is a comma separated list that accepts wild cards, such as *.txt.*
### Field Description

####  Note:
- If no value is provided, subfolders in the specified directory are deleted.
- If a value is provided, subfolders are not deleted even if they are empty.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Subfolders</td>
<td>Option to specify if files from the subfolders should be removed.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Option to enable the retry policy. For more information, see Retry policy.</td>
</tr>
<tr>
<td>Enable Retry Policy</td>
<td>Option to override the default retry policy. This option is not applicable when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Override Default Policy for Alias</td>
<td>Default retry policy associated with Connection Alias. If Override Default Policy for Alias is selected, you can override the default retry policy and select another existing retry policy based on your requirement.</td>
</tr>
</tbody>
</table>

### Delete Directory

Deletes directory on an SFTP server, including subfolders, when configured.

### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>Type of connection to use to connect to the source SFTP server.</td>
</tr>
<tr>
<td>Source Connection</td>
<td>• Define Connection Inline: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• Use Connection Alias: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Source Connection Alias</strong></td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when <strong>Use Connection Alias</strong> is selected from the Source Connection list.</td>
</tr>
<tr>
<td><strong>Source Credential alias</strong></td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when <strong>Define Connection Inline</strong> is selected from the Source Connection list.</td>
</tr>
<tr>
<td><strong>Host</strong></td>
<td>Name or IP address of the SFTP server that contains the directory you wish to delete.</td>
</tr>
<tr>
<td><strong>Port</strong></td>
<td>Port number to communicate with the server.</td>
</tr>
<tr>
<td><strong>MID Selection</strong></td>
<td>Option to select MID Server as required. This field is available when <strong>Define Connection Inline</strong> is selected from the Source Connection list.</td>
</tr>
<tr>
<td><strong>MID Application</strong></td>
<td>Option to use a MID Server to run the SFTP step. This field is available when <strong>Define Connection Inline</strong> is selected from the Source Connection list and <strong>Auto-Select MID Server</strong> is selected from the MID Selection list.</td>
</tr>
<tr>
<td><strong>Capabilities</strong></td>
<td>Capability of the MID Server. Select SSH. This field is available when <strong>Define Connection Inline</strong> is selected from the Source Connection list.</td>
</tr>
</tbody>
</table>
**Field** | **Description**
--- | ---
Connection list and **Auto-Select MID Server** is selected from the MID Selection list.

**MID Server** | Data pill of the required MID Server. This field is available when **Define Connection Inline** is selected from the Source Connection list and **Specific MID Server** is selected from the MID Selection list.

**Command Details**

**Source Path** | Path of the directory you wish to remove.

**Include Subfolders** | Option to specify if the subfolders should be deleted.

*Note:* If this option is selected, all subfolders are deleted. Else, only empty subfolders are deleted.

**Retry Policy** | Option to enable the retry policy. For more information, see **Retry policy**.

**Override Default Policy for Alias** | Option to override the default retry policy. This option is not applicable when **Define Connection Inline** is selected from the Connection list.

**Retry Policy** | Default retry policy associated with **Connection Alias**. If **Override Default Policy for Alias** is selected, you can override the default retry policy and select another existing retry policy based on your requirement.

---

**Rename File or Directory**

Renames a file or directory on an SFTP server.

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>Type of connection to use to connect to the source SFTP server.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Define Connection Inline</strong></td>
<td>Define connection information within the action step.</td>
</tr>
<tr>
<td><strong>Use Connection Alias</strong></td>
<td>Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases.</td>
</tr>
<tr>
<td>Source Connection Alias</td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when Use Connection Alias is selected from the Source Connection list.</td>
</tr>
<tr>
<td>Source Credential alias</td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when Define Connection Inline is selected from the Source Connection list.</td>
</tr>
<tr>
<td>Host</td>
<td>Name or IP address of the SFTP server that contains the file or directory you wish to rename.</td>
</tr>
<tr>
<td>Port</td>
<td>Port number to communicate with the server.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MID Selection</td>
<td>Option to select MID Server as required. This field is available when Define Connection Inline is selected from the Source Connection list.</td>
</tr>
<tr>
<td>MID Application</td>
<td>Option to use a MID Server to run the SFTP step. This field is available when Define Connection Inline is selected from the Source Connection list and Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capability of the MID Server. Select SSH. This field is available when Define Connection Inline is selected from the Source Connection list and Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Data pill of the required MID Server. This field is available when Define Connection Inline is selected from the Source Connection list and Specific MID Server is selected from the MID Selection list.</td>
</tr>
</tbody>
</table>

**Command Details**

<table>
<thead>
<tr>
<th>Source Path</th>
<th>Full path to the file or directory.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Path</td>
<td>Full path with the renamed file or directory.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td></td>
</tr>
<tr>
<td>Enable Retry Policy</td>
<td>Option to enable the retry policy. For more information, see Retry policy.</td>
</tr>
<tr>
<td>Override Default Policy for Alias</td>
<td>Option to override the default retry policy. This option is not applicable when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Default retry policy associated with Connection Alias. If Override Default Policy for Alias is selected, you can override the default retry policy and select another existing retry policy based on your requirement.</td>
</tr>
</tbody>
</table>

**Set File Attributes**

Sets common file attributes, such as timestamps, size, permissions, and UID/GID, for a file or directory on an SFTP server.

A good practice is to use the Get File List command to return a list of files and their attributes first. Then, after you have moved the files from a source host to a
target host, use the Set File Attributes command to set the source file attributes on the target file.

### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td></td>
</tr>
<tr>
<td>Source Connection</td>
<td>Type of connection to use to connect to the source SFTP server.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Define Connection Inline</strong>: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Connection Alias</strong>: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action.</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see credentials, connections, and aliases.</td>
</tr>
<tr>
<td>Source Connection Alias</td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when <strong>Use Connection Alias</strong> is selected from the Source Connection list.</td>
</tr>
<tr>
<td>Source Credential alias</td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments.</td>
</tr>
</tbody>
</table>
environments. Likewise, if the credential information changes, you don’t need to update your custom action. To learn more about connections and credentials, see [credentials, connections, and aliases](#). The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when **Define Connection Inline** is selected from the Source Connection list.

### Host
Name or IP address of the SFTP server that contains the file you wish to remove.

### Port
Port number to communicate with the server.

### MID Selection
Option to select MID Server as required.

### MID Application
Option to use a MID Server to run the SFTP step. This field is available when **Define Connection Inline** is selected from the Source Connection list and **Auto-Select MID Server** is selected from the MID Selection list.

### Capabilities
Capability of the MID Server. Select **SSH**. This field is available when **Define Connection Inline** is selected from the Source Connection list and **Auto-Select MID Server** is selected from the MID Selection list.

### MID Server
Data pill of the required MID Server. This field is available when **Define Connection Inline** is selected from the Source Connection list and **Specific MID Server** is selected from the MID Selection list.

### Command Details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Path</td>
<td>Path of the directory that contains the files you wish to remove.</td>
</tr>
<tr>
<td>User ID</td>
<td>User ID attribute to apply to the file or directory. The UID and GUID variables must be set together as a pair.</td>
</tr>
<tr>
<td>Group ID</td>
<td>Group ID attribute to apply to the file or directory. The UID and GUID variables must be set together as a pair.</td>
</tr>
<tr>
<td>Permissions (chmod)</td>
<td>File or directory permissions to set for the user and group specified. This value must be specified in Octal notation only. For example, 755.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The permissions number is an internal value returned by the Get File List command.</td>
</tr>
<tr>
<td><strong>Modified Timestamp (epoch)</strong></td>
<td>Override the timestamp when the file or directory was last modified.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Timestamp must be in epoch format.</td>
</tr>
<tr>
<td></td>
<td>• Access and modification timestamps must be set together as a pair.</td>
</tr>
<tr>
<td><strong>Accessed Timestamp (epoch)</strong></td>
<td>Override the timestamp when the file or directory was last accessed.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Timestamp must be in epoch format.</td>
</tr>
<tr>
<td></td>
<td>• Access and modification timestamps must be set together as a pair.</td>
</tr>
</tbody>
</table>

**Retry Policy**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable Retry Policy</strong></td>
<td>Option to enable the retry policy. For more information, see <strong>Retry policy</strong>.</td>
</tr>
<tr>
<td><strong>Override Default Policy for Alias</strong></td>
<td>Option to override the default retry policy. This option is not applicable when <strong>Define Connection Inline</strong> is selected from the Connection list.</td>
</tr>
<tr>
<td><strong>Retry Policy</strong></td>
<td>Default retry policy associated with <strong>Connection Alias</strong>. If <strong>Override Default Policy for Alias</strong> is selected, you can override the default retry policy and select another existing retry policy based on your requirement.</td>
</tr>
</tbody>
</table>

**Copy Attachments To SFTP Server**

Copies the specified attachments from ServiceNow instance to an SFTP server.

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connections</strong></td>
<td>Type of connection to use to connect to the source SFTP server.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Define Connection Inline</td>
<td>Define connection information within the action step.</td>
</tr>
<tr>
<td>• Use Connection Alias</td>
<td>Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action.</td>
</tr>
<tr>
<td>To learn more about connections and credentials, see credentials, connections, and aliases.</td>
<td></td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when Use Connection Alias is selected from the Connection list.</td>
</tr>
<tr>
<td>Credential Alias</td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Host</td>
<td>Name or IP address of the SFTP server to which the files you should be copied. This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Port</td>
<td>Port number to communicate with the server. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list.</td>
</tr>
<tr>
<td>MID Selection</td>
<td>Option to select the specific MID Server.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Auto-Select MID Server</strong>: Selects the MID Server automatically.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Specific MID Server</strong>: Selects the MID Server you select.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Specific MID Server to run the SFTP step. This field is available when <strong>Specific MID Server</strong> is selected from the MID Selection list.</td>
</tr>
<tr>
<td>MID Application</td>
<td>Option to use a MID Server to run the SFTP step. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list and <strong>Auto-Select MID Server</strong> is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capability of the MID Server. Select <strong>SSH</strong>. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list and <strong>Auto-Select MID Server</strong> is selected from the MID Selection list.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Data pill of the required MID Server. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list and <strong>Specific MID Server</strong> is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Attachments to Copy</td>
<td></td>
</tr>
<tr>
<td>Attachment Records</td>
<td>Records in your ServiceNow instance that you want to copy to SFTP server.</td>
</tr>
<tr>
<td>Copy to SFTP Target</td>
<td></td>
</tr>
<tr>
<td>Target Path</td>
<td>Full path to the file in the target server you want to copy the contents. For example, <code>/root/doc/</code>. In this case, the attachments would be copied to this path on the server.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td></td>
</tr>
<tr>
<td>Enable Retry Policy</td>
<td>Option to enable the retry policy. For more information, see <strong>Retry policy</strong>.</td>
</tr>
<tr>
<td>Override Default Policy for Alias</td>
<td>Option to override the default retry policy. This option is not applicable when <strong>Define Connection Inline</strong> is selected from the <strong>Connection</strong> list.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retry Policy</td>
<td>Default retry policy associated with <strong>Connection Alias</strong>. If <strong>Override Default Policy for Alias</strong> is selected, you can override the default retry policy and select another existing retry policy based on your requirement.</td>
</tr>
</tbody>
</table>

**Copy Files To This Instance**

Attaches the specified files in the SFTP server to the specified record in ServiceNow instance.

### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>Type of connection to use to connect to the source SFTP server.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Define Connection Inline</strong>: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Connection Alias</strong>: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action.</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see <a href="#">credentials, connections, and aliases</a>.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see <a href="#">credentials, connections, and aliases</a>. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available.</td>
</tr>
</tbody>
</table>
### Fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Credential Alias</strong></td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td><strong>Host</strong></td>
<td>Name or IP address of the SFTP server to which the files you should be copied. This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td><strong>Port</strong></td>
<td>Port number to communicate with the server. This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
</tbody>
</table>
| **MID Selection** | Option to select the specific MID Server.  
  - **Auto-Select MID Server**: Selects the MID Server automatically.  
  - **Specific MID Server**: Selects the MID Server you select.                                                                                                                                                                                                 |
<p>| <strong>MID Server</strong> | Specific MID Server to run the SFTP step. This field is available when Specific MID Server is selected from the MID Selection list.                                                                                                                                                         |
| <strong>MID Application</strong> | Option to use a MID Server to run the SFTP step. This field is available when Define Connection Inline is selected from the Connection list and Auto-Select MID Server is selected from the MID Selection list.                                                                                       |
| <strong>Capabilities</strong> | Capability of the MID Server. Select SSH. This field is available when Define Connection Inline is selected from the Connection list and Auto-Select MID Server is selected from the MID Selection list.                                                                                     |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server</td>
<td>Data pill of the required MID Server. This field is available when Define Connection Inline is selected from the Connection list and Specific MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>SFTP Files To Copy</td>
<td></td>
</tr>
<tr>
<td>Source Path</td>
<td>Path of the directory that contains the files you want to copy. For example, /root/doc/.</td>
</tr>
<tr>
<td>Include Files</td>
<td>List of target files to copy. This is a comma separated list that accepts wild cards, such as *.txt.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If no value is provided, subfolders in the specified directory are copied.</td>
</tr>
<tr>
<td>Exclude Files</td>
<td>List of target files that should not be copied. This is a comma separated list that accepts wild cards, such as *.txt.</td>
</tr>
<tr>
<td>Maximum File Size (KB)</td>
<td>Maximum size of the file that can be copied.</td>
</tr>
<tr>
<td>Maximum Number of Files</td>
<td>Maximum number of files that can be copied in a request.</td>
</tr>
<tr>
<td>Attach Files To This Target Record</td>
<td>Record in ServiceNow instance to which you want to attach the files.</td>
</tr>
<tr>
<td>Table</td>
<td>ServiceNow table in which the target record is saved.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td></td>
</tr>
<tr>
<td>Enable Retry Policy</td>
<td>Option to enable the retry policy. For more information, see Retry policy.</td>
</tr>
<tr>
<td>Override Default Policy for Alias</td>
<td>Option to override the default retry policy. This option is not applicable when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Default retry policy associated with Connection Alias. If Override Default Policy for Alias is selected, you can override the default retry policy and select another existing retry policy based on your requirement.</td>
</tr>
</tbody>
</table>
**SSH step**

The SSH step executes SSH commands on an external *nix system through a ServiceNow® MID Server. The step also stores scripts and commands for the *nix systems.

⚠️ **Note:**

- The SSH step is not available in the base system. The step requires the subscription to ServiceNow® IntegrationHub and activation of IntegrationHub Professional Pack Installer (com.glide.hub.integrations.professional) or later. For more information about the IntegrationHub subscription packages, see IntegrationHub usage and subscription. After you activate the required plugin, the step is visible under Integrations.
- IntegrationHub supports ServiceNow SSH only.

**Roles and availability**

The SSH step is available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

**Sanitizing inputs**

Escape all user inputs to eliminate the possibility of a malicious user executing arbitrary commands on your target server. Escape and validate data pills before the command field uses them by sanitizing arguments using Sanitize shell arguments transform functions. This transform function category automatically appears when a data pill is dropped into the Command input.

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection Details</strong></td>
<td></td>
</tr>
<tr>
<td>Connection</td>
<td>Type of connection to use.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Define Connection Inline:</strong> Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Connection Alias:</strong> Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when Use Connection Alias is selected from the Connection list.</td>
</tr>
<tr>
<td>Credential Alias</td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don’t need to update your custom action. To learn more</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Host</td>
<td>Host name or IP address of the target server. This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Port</td>
<td>Port number to communicate with the server. This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>MID Selection</td>
<td>Option to select MID Server as required. This field is available when Define Connection Inline is selected from the Source Connection list.</td>
</tr>
<tr>
<td>MID Application</td>
<td>Option to use a MID Server to run the SSH step. This field is available when Define Connection Inline is selected from the Connection list and Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capability of the MID Server. Select SSH. This field is available when Define Connection Inline is selected from the Connection list and Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Data pill of the required MID Server. This field is available when Define Connection Inline is selected from the Connection list and Specific MID Server is selected from the MID Selection list.</td>
</tr>
</tbody>
</table>
### Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSH Configuration</td>
<td>Optional target directory on the target host where the command is run.</td>
</tr>
<tr>
<td>Working Directory</td>
<td>Command that runs on the target directory. The command can also include MID Serverscripts. See Advanced SSH script options for more information.</td>
</tr>
<tr>
<td>Command</td>
<td>Option to disable the SSH connection timeout for commands that might take longer than the default time of 120 seconds to run. When selected, the engine detaches from the execution thread until completion.</td>
</tr>
<tr>
<td>Long Running</td>
<td>Option to elevate privileges to execute the script.</td>
</tr>
</tbody>
</table>

**Note:** Escape and validate data pills before the command field uses them by sanitizing arguments using a preprocessing Script step. For more information, see Sanitizing arguments using the escape class and function.

For more information, see SSH credentials.

### Advanced SSH Script Options

To run a MID Server script on the target host, specify the script type and pass the name of the script into the `syncFile()` parameter. The system uses this parameter to locate the named script in the MID Server Script File [ecc_agent_script_file] table and run it on the target host. For example, a bash script can be expressed as:

```
bash syncFile("<MID script name>") argument1 argument2 argument3
```

A base script (main_script.bash) can reference another script (my_include.bash) as well as a separate file (.my_profile) located on the target host. Both scripts and the file referenced must be synced to the MID Server, using the `syncFile()` parameter, to execute properly.
A Python example with inline comments might look like this:

```python
set $LIB_DIR=/usr/bin;.
# Sync a file that is referenced inside myF5CreateLBPool.py
cp ${syncFile("specialFunctions.py")} ~/specialFunctions.py
# set up environment variables
source ${syncFile(".python_profile")}
# call script that sets up dependencies on the box from remote package repos
python ${syncFile("setupPythonDependencies.py")} pycontrol
# call a script that requires functions from the package as well as a function from
# myIncludedFile
python ${syncFile("myF5CreateLBPool.py")} snow_pool myActualValue
# user is responsible for their own cleanup
rm ~/specialFunctions.py
```

To see the list of available MID Server scripts, navigate to **MID Server > Script Files**.

**SOAP step**

Enable action designers to send outbound SOAP web service requests to external systems.

⚠️ **Note:** SOAP step is not available in the base system and requires the ServiceNow® IntegrationHub subscription. After the required plugin is activated, the step is visible under Integrations.

**Roles and availability**

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

- Action designers need the web_service_admin role to perform these web services tasks.
  - Select WSDL
  - Load new WSDL
  - Select a WS-Security policy

- The ServiceNow® MID Server doesn't support WS-Security policies
## Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection Details</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Connection</strong></td>
<td>The type of connection to use.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Define Connection Inline</strong>: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Use Connection Alias</strong>: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action.</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see credentials, connections, and aliases.</td>
</tr>
<tr>
<td><strong>Connection Alias</strong></td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Credential Alias</td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. Note: This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Connection Timeout</td>
<td>Number of milliseconds the system waits for a successful host connection. If the step does not make a successful connection during this time, the connection request times out. If Define Connection Inline is selected, enter a timeout value for the connection. Leave this field empty to use the system default connection timeout value.</td>
</tr>
<tr>
<td>Use MID</td>
<td>Option to use a MID Server to run the SOAP step. Select this check box</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Endpoint</td>
<td>The URL endpoint for the SOAP request. If Use Connection Alias is selected, this field is read-only and displays the endpoint URL associated with alias. If Define Connection Inline is selected, enter an endpoint URL for the connection.</td>
</tr>
<tr>
<td>Request Details</td>
<td></td>
</tr>
<tr>
<td>Build Envelope</td>
<td>The method to use when building the SOAP envelope.</td>
</tr>
<tr>
<td></td>
<td>• From WSDL: Select this option to display the Select a WSDL and Operation fields.</td>
</tr>
<tr>
<td></td>
<td>• Manually: Select this option to manually enter or paste WSDL text.</td>
</tr>
<tr>
<td>Select a WSDL</td>
<td>The WSDL to use to build the SOAP envelope. Select an existing WSDL record or click Load New WSDL to download or manually enter a WSDL file. The selected WSDL populates the values of the Operation, SOAP action, and SOAP Envelope fields.</td>
</tr>
<tr>
<td>Load New WSDL</td>
<td>Option to download or manually enter a WSDL file.</td>
</tr>
<tr>
<td>Operation</td>
<td>The operation to run from the selected WSDL. Each WSDL has its own list of available operations.</td>
</tr>
<tr>
<td>SOAP Action</td>
<td>The URL to run the SOAP action. If Build Envelope is set to From WSDL, this field is read-only and displays the URL to run SOAP action. If Build Envelope is set to</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Manually, enter a URL to run the SOAP action. | **Request Type**  
Format of the request. Options include.  
- **Text**: A request in JSON, XML, or other text format.  
- **Binary**: A request in a binary file format. |   |
| SOAP Envelope       | The XML text sent to the endpoint. If **Build Envelope** is set to From WSDL, the system adds the necessary XML for the **Operation** that you select. If **Build Envelope** is set to Manually, enter the XML text that you want to use. Enter record values in the appropriate SOAP envelope elements. For example, enter an incident short description in the `<short_description>` element.  
**Note**: This field is available when the **Request Type** is Text. |
| Attachment          | Attachment record containing the request. You can look up or create this record in a prior step and define it as an input variable. Create it using the JSONStreamingBuilder and XMLStreamingBuilder APIs in the Script step.  
**Note**: This field is available when the **Request Type** is Binary. |
| Reset Envelope      | Option to discard all manual changes that you made to the SOAP envelope. Select this check box to revert the SOAP envelope to its original state.  
**Note**: This field is available when you select From WSDL from the Build Envelope list. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New WSDL</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>The name of the WSDL record you want to create.</td>
</tr>
<tr>
<td>Import Method</td>
<td>The method to enter WSDL.</td>
</tr>
<tr>
<td></td>
<td>• Download from URL: Select to display the WSDL URL, User name, and Password fields to retrieve the WSDL from an external source, typically the web service provider.</td>
</tr>
<tr>
<td></td>
<td>• Manually Populate WSDL Content: Select to display the WSDL Content field to manually enter or paste WSDL text.</td>
</tr>
<tr>
<td>WSDL URL</td>
<td>The URL to the SOAP web service.</td>
</tr>
<tr>
<td></td>
<td>❓ Note: This field is available when you select Download from URL from the Import Method list.</td>
</tr>
<tr>
<td>User name</td>
<td>The user name to authenticate with the SOAP web service.</td>
</tr>
<tr>
<td></td>
<td>❓ Note: This field is available when you select Download from URL from the Import Method list.</td>
</tr>
<tr>
<td>Password</td>
<td>The password to authenticate with the SOAP web service. The system always masks passwords in the user interface and prevents exporting them as plain text.</td>
</tr>
<tr>
<td></td>
<td>❓ Note: This field is available when you select Download from URL from the Import Method list.</td>
</tr>
<tr>
<td>WSDL Content</td>
<td>The XML document describing the SOAP web service and its operations.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong> This field is available when you select <strong>Manually Populate WSDL Content</strong> from the Import Method list.</td>
<td></td>
</tr>
<tr>
<td>Import</td>
<td>Option to add the SOAP web service WSDL to the instance.</td>
</tr>
<tr>
<td>WS-Security</td>
<td>Option to restrict the SOAP web service to a security policy. Select this check box to display the <strong>Policy</strong> field.</td>
</tr>
<tr>
<td>Enable WS-Security Policy</td>
<td>Option to restrict the SOAP web service to a security policy. Select this check box to display the <strong>Policy</strong> field.</td>
</tr>
<tr>
<td>Policy</td>
<td>The policy record that you want to use to restrict web service connections. Select an existing policy record.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Option to enable the retry policy. For more information, see <strong>Retry policy</strong>.</td>
</tr>
<tr>
<td>Enable Retry Policy</td>
<td>Option to enable the retry policy. For more information, see <strong>Retry policy</strong>.</td>
</tr>
<tr>
<td>Override Default Policy for Alias</td>
<td>Option to override the default retry policy. This check box is not applicable when <strong>Define Connection Inline</strong> is selected from the Connection list.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Default retry policy associated with <strong>Connection Alias</strong>. If <strong>Override Default Policy for Alias</strong> is selected, you can override the default retry policy and select another existing retry policy based on your requirement.</td>
</tr>
<tr>
<td>Advanced Options</td>
<td>The name-value pairs to include in the SOAP message as HTTP headers. Click the plus icon + to add headers. Add a <strong>Name</strong> and <strong>Value</strong> for each HTTP header.</td>
</tr>
<tr>
<td>Omit if empty</td>
<td>Option to exclude a name-value pair if the value is empty or null.</td>
</tr>
</tbody>
</table>
SOAP response size limit

The system limits the size of SOAP responses to 5 MB. Direct SOAP responses that exceed this limit generate an error. To support larger response sizes, increase the response size limit with the `glide.pf.soap.response_payload_max_size` system property. This system property supports a maximum value of 10 MB.

Update Multiple Records step

Look up and update multiple records as a single step. Using this step removes the need to separately look up a list of records and then process the list with a Script step. Set field values with a template or add and configure them using data pills.

Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select the table containing the records to look up and update.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Define the filter conditions used to look up records.</td>
</tr>
<tr>
<td>Field Values</td>
<td>Set the fields and field values that you want to update. Set static or dynamic values for the fields in the records. For example, to set the short description to a certain value, select <strong>Short description</strong> and enter the desired value. To add dynamic values, see <strong>Allow flow designers to dynamically set field values</strong>.</td>
</tr>
<tr>
<td>Order by</td>
<td>Select the field that you want to use to sort the records when more than one record matches the defined conditions.</td>
</tr>
<tr>
<td>Sort Type</td>
<td>Determine whether to sort the records alphabetically in ascending or descending order.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Run Business Rules and Workflow</td>
<td>Determine whether to call any business rules and workflows associated with the table.</td>
</tr>
<tr>
<td>Update System Fields</td>
<td>Select if you want to automatically update system fields such as Updated by.</td>
</tr>
<tr>
<td>Don't fail on error</td>
<td>Specify whether to continue running the flow when there is an error.</td>
</tr>
</tbody>
</table>

### Example

![Action Outline](image)

### Outputs

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count</td>
<td>Number of records updated. If no records are updated, the count is 0.</td>
<td>Integer</td>
</tr>
<tr>
<td>Error Message</td>
<td>Message that is displayed if the step produces an error.</td>
<td>String</td>
</tr>
</tbody>
</table>
| Status | The completion status of the step as a numeric value.  
- 0 (success)  
- 1 (error) | Choice |
Update Record step

Update an existing record in a table. You can dynamically add and configure fields for the record, or use a template to set field values.

Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>The record to be updated. Drag-and-drop a record data pill or use the data pill picker to select a record.</td>
</tr>
<tr>
<td>Table</td>
<td>The table associated with the record. When you select a record, this field is automatically set to the table associated with the record.</td>
</tr>
<tr>
<td>Field Values</td>
<td>Set static or dynamic values of fields in the record. For example, to set the short description to a static value, select Short description and set the desired value. To add dynamic values, see Allow flow designers to dynamically set field values.</td>
</tr>
</tbody>
</table>

Wait For Condition step

Pause a flow until record values match a specific set of conditions.

Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Drag an input record or a record from a previous step.</td>
</tr>
</tbody>
</table>

Note: If this record is deleted, the flow stops waiting and continues running.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Read-only. Set to the table associated with the record. Confirm that the system supports Wait for Condition for your selected table.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Select the record values necessary to resume running the flow. For example, if the condition is <code>[State][is][Closed]</code>, the flow pauses until the condition is met. Once met, the flow moves on to the next step or action. Set static or dynamic conditions to filter records. To define a static condition applied each time the action runs, define the conditions with the condition builder. To enable flow designers to dynamically apply conditions, define an input of type Conditions and drag-and-drop the input data pill into the Conditions field.</td>
</tr>
<tr>
<td>Enable timeout</td>
<td>Option to limit the amount of time that the flow waits for the action to be completed before continuing.</td>
</tr>
<tr>
<td>Duration</td>
<td>Amount of time that the flow waits before continuing when the Enable timeout option is selected. Enter the time to wait in hours, minutes, and seconds. If you leave this field empty, the flow does not wait.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Schedule used to compute the timeout duration when the Enable timeout option is selected. For example, waiting for 10 hours as part of an 8-5 weekdays schedule causes the flow to wait for one or more business days. If you leave this field empty, the timeout runs without a schedule.</td>
</tr>
</tbody>
</table>

**Unsupported tables**

The system does not support Wait for Condition for the following tables.

<table>
<thead>
<tr>
<th>Table Category</th>
<th>Table Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit</td>
<td>Sys Audit [sys_audit], Audit Deleted Record [sys_audit_delete], Audit Relationship Change [sys_audit_relation], Audit Roles [sys_audit_role], Audit Relationship Change [sys_audit_relation], Audit Deleted Record [sys_audit_delete]</td>
</tr>
<tr>
<td>Table Category</td>
<td>Table Names</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Email</td>
<td>Email [sys_email], Email Account [sys_email_account], Email Log [sys_email_log]</td>
</tr>
<tr>
<td>Events</td>
<td>Event [sysevent], Notification [sysevent_email_action], Stationery [sysevent_email_style], Email Template [sysevent_email_template], Inbound Email Actions [sysevent_in_email_action], Slow Event [sysevent_pattern], Event Registration [sysevent_registration], Script Action [sysevent_script_action]</td>
</tr>
<tr>
<td>Import Sets</td>
<td>Import Set [sys_import_set], Import Set Row [sys_import_set_row], Import Set Row Error [sys_import_set_row_error], Transform History [sys_import_set_run], Computer [imp_computer], Notification [imp_notification], Location [imp_location], User [imp_user]</td>
</tr>
<tr>
<td>JRobin</td>
<td>JRobin Database [jrobin_database], JRobin Shard [jrobin_shard], Graph Line [jrobin_graph_line], JRobin Shard Fragments [jrobin_shard_location], Member [jrobin_graph_set_member], Round Robin Archive [jrobin_archive], Round Robin Data Source [jrobin_datasource], Round Robin Definition [jrobin_definition], Round Robin Graph [jrobin_graph], Round Robin Graph Set [jrobin_graph_set]</td>
</tr>
<tr>
<td>Logs</td>
<td>Log Entry [syslog], Service Portal Log Entry [sp_log]</td>
</tr>
<tr>
<td>MID Server</td>
<td>MID Server Property [ecc_agent_property], Mid Server Log [ecc_agent_log], Queue [ecc_queue], Configuration [ecc_queue_config], ECC</td>
</tr>
<tr>
<td>Table Category</td>
<td>Table Names</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Queue Statistics (by ECC Agent)</td>
<td>[ecc_queue_stats_by_ecc_agent]</td>
</tr>
<tr>
<td>Performance Analytics</td>
<td>Job Log [pa_job_logs]</td>
</tr>
<tr>
<td>Record Watcher</td>
<td>Responders [sys_rw_action], Channel Responders [sys_rw_amb_action]</td>
</tr>
<tr>
<td>Reporting</td>
<td>Summary Set [sys_report_summary], Report Summary Line [sys_report_summary_line]</td>
</tr>
<tr>
<td>Scheduled Jobs</td>
<td>Schedule Item [sys_trigger], Broadcast Message [sys_broadcast_message], Broadcast Message Relationships [sys_broadcast_message_m2m], Progress Worker [sys_progress_worker], Progress Worker Domain [sys_progress_worker_domain]</td>
</tr>
<tr>
<td>SSO</td>
<td>SSO Properties [sso_properties], Digest Token Properties [digest_properties], SAML Update 1 Properties [saml2_update1_properties], SSO Federation [sso_federation]</td>
</tr>
<tr>
<td>System Cache</td>
<td>Cache Flush [sys_cache_flush], Cache Entry [sys_db_cache]</td>
</tr>
<tr>
<td>System Clone</td>
<td>ServiceNow Instance [instance], Clone Security Token [clone_token], Preserved Data [clone_preserved_data]</td>
</tr>
<tr>
<td>System Dictionary</td>
<td>Dictionary Entry Override [sys_dictionary_override]</td>
</tr>
<tr>
<td>System Events</td>
<td>Event Processor [sys_event_processor]</td>
</tr>
<tr>
<td>System Fields</td>
<td>Field Class [sys_glide_object]</td>
</tr>
<tr>
<td>System Performance</td>
<td>Component Status [sys_status], Cluster Message [sys_cluster_message], Node State [sys_cluster_state]</td>
</tr>
<tr>
<td>Text Index</td>
<td>Ts Attachment [ts_attachment], Text Index Attribute Map [ts_attribute_map], Ts Chain [ts_chain],</td>
</tr>
<tr>
<td>Table Category</td>
<td>Table Names</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Table Category</td>
<td>Chain Summary [ts_chain_summary], Text Index Column Attribute Map [ts_column_attribute_map], Text Index Configuration [ts_configuration], Text Index Configuration Attribute [ts_configuration_attribute], Ts Delete Doc [ts_deleted_doc], Ts Document [ts_document], Ts Field [ts_field], Text Search Groups [ts_group], Japanese User Token [ts_japanese_token_dictionary], Ts Phrase [ts_phrase], Global Searches [ts_query], Knowledge Searches [ts_query_kb], Text Search Stat [ts_search_stats], Text Search Summaries [ts_search_summary], Stop Word [ts_stop], Synonym Dictionary [ts_synonym_dictionary], Synonym Set [ts_synonym_set], Text Search Table [ts_table], Text Index Table Attribute Map [ts_table_attribute_map], Service Catalog Searches [sc_ts_query], Ts Word [ts_word], Ts Word Roots [ts_word_roots]</td>
</tr>
<tr>
<td>Update Sets</td>
<td>Update Set [sys_update_set], Update Version [sys_update_version], Customer Update [sys_update_xml], Update Set Log [sys_update_set_log]</td>
</tr>
<tr>
<td>Upgrades</td>
<td>System Upgrades [sys_upgrade_history], Upgrade Details [sys_upgrade_history_log], System Upgrade Metric [sys_upgrade_metric], Upgrade Blame Log [sys_upgrade_blame], Upgrade Manifest [sys_upgrade_manifest], Upgrade State [sys_upgrade_state]</td>
</tr>
<tr>
<td>Usage Analytics</td>
<td>Usage Data for Applications [ua_app_usage], UsageAnalytics Count Configurations [usageanalytics_count_cfg],</td>
</tr>
<tr>
<td>Table Category</td>
<td>Table Names</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Application Metadata</td>
<td>[ua_app_metadata], UsageAnalytics Count for Tables [usageanalytics_count], Subscription [license_details], Role for Subscription [role_has_license]</td>
</tr>
<tr>
<td>Users</td>
<td>User Session [sys_user_session], User Token [sys_user_token], User Preference [sys_user_preference], Navigator History [sys_ui_navigator_history]</td>
</tr>
<tr>
<td>Workflow</td>
<td>Workflow Execution [wf_workflow_execution], Workflow History [wf_history], Workflow Executing Activity [wf_executing], Workflow Queued Command [wf_command], Workflow Context [wf_context], Workflow Transition History [wf_transition_history]</td>
</tr>
</tbody>
</table>

**Example**

**Action Outline**

1. Inputs
   - Create Record step
2. Outputs
   - Wait For Condition step

**2. Wait For Condition step**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
</table>
| State | The completion status of the action as a numeric value.  
• 0 (success)  
• 1 (error) | Choice |
Transform functions

Transform data pill values without the need to write a script. Use transform functions to reformat text, perform mathematical calculations, sanitize potentially unsafe SQL statements, and serialize complex objects to raw XML.

Available transform function categories include date and time, string, utilities, simple math, sanitize shell arguments, sanitize SQL, and complex data. Some examples of transform function uses include:

- Trimming white space from a string before integrating it into the CMDB.
- Adding days, hours, minutes, and seconds to a date or time to localize for a specific time zone.
- Sanitizing SQL values to prevent injection as part of a JDBC step for an IntegrationHub spoke.
- Retrieving an appropriate value from a map of priorities that have equivalent values in a third-party database.
- Transforming a complex object into raw XML as part of a REST step Request Body field.

ℹ️ **Note:** Custom transform functions are not currently supported. For information on creating custom functions to transform Flow Designer data, see Inline scripts.

**Applying a transform function**

You can apply a transform function to a data pill when you are designing or creating a flow. To apply a transform function, point or tab to a data pill and select the \( f(x) \) icon that appears. Selecting the icon displays the Available Transforms list. Select the transform function that you want to apply to your data pill, enter information into any required fields, and select **Apply.** Your selected transform function appears in the Applied Transforms list.

![Image of a data pill with transform icon](image-url)
Applying multiple transform functions

You can apply multiple transform functions to the same data pill. The system applies transform functions sequentially from top to bottom as listed in the Applied Transforms list. For example, you can apply a String to Date transform function followed by the Add Time transform function.

Viewing applied transform functions

You can find out which transform functions are applied to a data pill by looking at the Applied Transforms list. When you are designing or creating a flow or action, point to or tab into the data pill and select the $f(x)$ icon. You can also view applied transform functions in the flow execution details.

Note: The output values for applied transform functions are field values, not display values.

When a data pill is dropped into certain types of inputs, the system automatically suggests a transform function category that is related to the input. For example, the system suggests transform functions to escape special characters in SQL statements, prevent script injection in shell scripts, and validate API or operation requests. Currently, the system suggests transform function categories for these inputs:

- For data pills dropped in the JDBC step's SQL Statement input, the sanitize SQL transform function category is displayed automatically.
- For data pills dropped in the SSH step's Command input, the sanitize shell arguments transform function category is displayed automatically.

Design considerations

Apply transform functions to valid input data pill types

Be sure to check the input data pill type before applying a transform function. Applying a transform function to an invalid data pill type results in the system skipping the transform. An error also occurs if transform functions produce results that the system cannot parse. For example, when transforming a string into a date, the system throws an error if the transform does not produce a valid date.

Confirm applied transform functions for multiple inputs with the same data pill

Transform functions only affect the runtime value of a data pill for one specific input. The actual field value that is associated with a data pill remains unchanged. To apply a transform function to the
same data pill across multiple actions or steps, you must apply the transform function to the data pill in each input separately.

**View final transformed values in the flow execution details**

Only the final transformed value, and not the value for each applied transform, appears in the flow execution details.

**Test transform functions to verify they produce expected results**

Verify that your transform functions produce the expected data pill runtime values. For more information on confirming the runtime values for data pills with applied transform functions, see Test a flow and Test an action.

**Date and time transform functions**

Use date and time transform functions to recalculate or reformat data pills for Date/Time values.

Date and time transform functions require a Date/Time or String input data pill. Make sure to use the correct input data pill type when applying date and time transform functions. If a date and time transform function is applied to an improper data pill type, the data is not transformed at runtime and the input value is returned instead. For more information on confirming your flow runtime values, see Test a flow.

⚠️ Note: Runtime Date/Time values are not localized and appear in the UTC (Coordinated Universal Time) time zone. For more information, see time zones and time zone representation.

### Add Time

Adds days, hours, minutes, or seconds to the input Date/Time, Date, or Due Date.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time, Date, or Due Date</td>
<td>Duration - Amount of time to add in days, hours, minutes, and seconds</td>
<td>Date/Time - Transformed Date/Time value after adding the specified Duration</td>
</tr>
</tbody>
</table>

⚠️ Note: If the input is a Date or Due Date, the transform creates a full Date/Time value using time values of hour 0, minute 0, and second 0.
Example

- **Input:** 2019-09-12 11:00:00
- **Duration:** 3 hours
- **Output:** 2019-09-12 13:00:00

In this example, the flow retrieves a CMDB Configuration Item record from a remote instance. The Subtract Time transform function then localizes the value of the **Created** field by subtracting three hours from the input Date/Time.

**Subtract Time**

Subtracts days, hours, minutes, and/or seconds from the input Date/Time, Date, or Due Date. Enter a **Duration** of time to subtract from the input Date/Time.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time, Date, or Due Date</td>
<td><strong>Duration</strong> - Enter an amount of time to subtract in days, hours, minutes, and seconds</td>
<td>Date/Time - Transformed Date/Time value after subtracting the specified Duration</td>
</tr>
</tbody>
</table>

**Note:** If the input is a Date or Due Date, the transform creates a full Date/Time value using time values of hour 0, minute 0, and second 0.

Example

- **Input:** 2019-09-12 11:00:00
- **Duration:** 2 days, 1 hours, 5 minutes, 10 seconds
- **Output:** 2019-09-10 09:54:50
**String to Date**

Converts the input String to a Date/Time.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
</table>
| String formatted as specified in the **Input Date Format** | - **Input Date Format** - Date/Time or date format of the input String  
- **Custom Format** - Valid Date/Time or date format represented as a String. Required only if Custom Format is selected as the **Input Date Format**. | Date/Time |

**Note:**

- If the Date/Time value for the **Custom Format** input is incomplete, the transform creates a full Date/Time value using default dates and times. In such a case, the transform defaults to the current year, the current month, day 1 of a month, hour 0, minute 0, and second 0. For example, an input data pill value of **Oct 2019** and a custom date format of **MMM yyyy** produces an output of **2019-10-01 00:00:00**.

- If you use an incorrect data pill type or invalid **Custom Format**, the flow cancels during runtime.

**Example**

- Input: `'1995-11-20'`
- **Input Date Format**: ISO Date `(2004-06-28)`
- Output: `1995-11-20 00:00:00`

---

**Date to String**

Converts the input Date/Time, Date, or Due Date to a String. Select a **Date Format** for the input Date/Time. Alternatively, enter a **Custom Format** for the input Date/Time.
### Input data pill

<table>
<thead>
<tr>
<th>Date/Time, Date, or Due Date</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Output Date Format</strong> - Date/Time or date format of the output String</td>
</tr>
<tr>
<td><strong>Custom Format</strong> - Valid Date/Time or date format represented as a String. Required only if selecting Custom Format as the Date Format.</td>
</tr>
</tbody>
</table>

#### Note:
If you use an incorrect input data pill type or invalid Custom Format, the flow cancels during runtime.

#### Example
- **Input**: 1969-12-31 14:23:57
- **Output Date Format**: Custom (enter below)
- **Custom Format**: 'On' MMM dd, yyyy 'at' hh:mm a
- **Output**: 'On Dec 31, 1969 at 2:23 PM'

In this example, the flow retrieves a User [sys_user] record from a third-party database. The Date to String transform function converts the format of the Created field and then logs the date, time, and name that is associated with the record.

### Custom date formats
You can specify a custom date format with a sequence of specific date and time pattern strings. A pattern string consists of one or more uppercase and lowercase letters from A to Z. Any text within quotation marks is ignored and is instead copied into the date output.
<table>
<thead>
<tr>
<th>String</th>
<th>Description</th>
<th>Output Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>Era designator</td>
<td>Text</td>
<td>AD</td>
</tr>
<tr>
<td>y</td>
<td>Year</td>
<td>Year</td>
<td>2019; 19</td>
</tr>
<tr>
<td>Y</td>
<td>Week in year</td>
<td>Year</td>
<td>2019; 19</td>
</tr>
<tr>
<td>M</td>
<td>Month in year (within date)</td>
<td>Month</td>
<td>July; Jul; 07</td>
</tr>
<tr>
<td>L</td>
<td>Month in year (standalone value)</td>
<td>Month</td>
<td>July; Jul; 07</td>
</tr>
<tr>
<td>w</td>
<td>Week in year</td>
<td>Number</td>
<td>52</td>
</tr>
<tr>
<td>W</td>
<td>Week in month</td>
<td>Number</td>
<td>1</td>
</tr>
<tr>
<td>D</td>
<td>Day in year</td>
<td>Number</td>
<td>365</td>
</tr>
<tr>
<td>d</td>
<td>Day in month</td>
<td>Number</td>
<td>2</td>
</tr>
<tr>
<td>F</td>
<td>Day of week in month</td>
<td>Number</td>
<td>3</td>
</tr>
<tr>
<td>E</td>
<td>Day name in week</td>
<td>Text</td>
<td>Wednesday; Wed</td>
</tr>
<tr>
<td>u</td>
<td>Day number of week</td>
<td>Number</td>
<td>3</td>
</tr>
<tr>
<td>a</td>
<td>a.m. or p.m.</td>
<td>Text</td>
<td>p.m.</td>
</tr>
<tr>
<td>H</td>
<td>Hour in day from 0 through 23</td>
<td>Number</td>
<td>0</td>
</tr>
<tr>
<td>k</td>
<td>Hour in day from 1 through 24</td>
<td>Number</td>
<td>24</td>
</tr>
<tr>
<td>K</td>
<td>Hour in a.m. or p.m. from 0 through 11</td>
<td>Number</td>
<td>0</td>
</tr>
<tr>
<td>h</td>
<td>Hour in a.m. or p.m. from 1 through 12</td>
<td>Number</td>
<td>12</td>
</tr>
<tr>
<td>m</td>
<td>Minute in hour</td>
<td>Number</td>
<td>59</td>
</tr>
<tr>
<td>s</td>
<td>Second in minute</td>
<td>Number</td>
<td>1</td>
</tr>
<tr>
<td>S</td>
<td>Millisecond</td>
<td>Number</td>
<td>500</td>
</tr>
<tr>
<td>z</td>
<td>Time zone in default format</td>
<td>Time zone in default format</td>
<td>Pacific Standard Time; PST</td>
</tr>
<tr>
<td>Z</td>
<td>Time zone in RFC 822 format</td>
<td>Time zone in RFC 822 format</td>
<td>-0800</td>
</tr>
</tbody>
</table>
String transform functions

Use string transform functions to reformat or perform calculations on String data pills.

String transform functions require a String input data pill. Make sure to use the correct input data pill type when applying string transform functions. If a string transform function is applied to an improper data type, the data is not transformed at runtime and the input value is returned instead. For more information on confirming your flow runtime values, see Test a flow.

Contains?

Returns true when the input string contains a given sequence of characters.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Characters to search for.</td>
<td>Boolean indicating whether a sequence of characters exists in the input string</td>
</tr>
</tbody>
</table>

Example

- Input: Cheese Pizza
- Parameter: Cheese
- Output: true

Does not Contain?

Returns true when the input string does not contain a given sequence of characters.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Characters to search for.</td>
<td>Boolean indicating whether a sequence of characters does not exist in the input string</td>
</tr>
</tbody>
</table>

---

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Example
- Input: Cheese Pizza
- Parameter: Joey
- Output: true

**Ends With?**
Returns **true** when the input string ends with a given sequence of characters.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Characters to search for.</td>
<td>Boolean indicating whether the input string ends with the given sequence of characters</td>
</tr>
</tbody>
</table>

Example
- Input: Cheese Pizza
- Parameter: Pizza
- Output: true

**First Character**
Returns the first character of the input String.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>String - Transformed String as the first character of the input String</td>
</tr>
</tbody>
</table>
Example

- **Input:** Madrid
- **Output:** m

In this example, the flow triggers when a User [sys_user] record is created. The flow then updates the City field for the User [sys_user] record with a code that is represented as the first character of the city's name.

Last Character

Returns the last character of the input String.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>String - Transformed String as the last character of the input String</td>
</tr>
</tbody>
</table>

Example

- **Input:** Madrid
- **Output:** d

Replace String

Returns a replaced string from the input string based on the provided regex and replacement string.
### String

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
</table>
| String         | • Regex - Regular expression to be matched for replacement  
                 • Replace String - Replacement string | Resulting string after replacement with given parameters |

**Example**

- **Input**: Pepperoni Pizza
- **Parameters**:
  - Regex: Pepperoni
  - Replacement string: Cheese
- **Output**: Cheese Pizza

### Size

Returns the total number of characters in the input String.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Integer</td>
</tr>
</tbody>
</table>

**Example**

- **Input**: Example input string
- **Output**: 21

### Split

Returns an Array.String based on a provided **Separator** that splits the input String. If the **Separator** field is left blank, the transformation is ignored and the system returns the input String. If entering any data type other than a String as the **Separator**, the system converts the provided value to a String.
<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td><strong>Separator</strong> - Enter a delimiter that specifies where the input String should be split. If left blank, the input String is not transformed at runtime.</td>
<td>Array.String - An array of substrings from the input String</td>
</tr>
</tbody>
</table>

**Example**
- **Input:** Example, input, string.
- **Separator:** ,
- **Output:** ["Example", "input", "string."]

**Starts With?**
Returns **true** when the input string starts with a given sequence of characters.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Characters to search for.</td>
<td>Boolean indicating whether the input string starts with the given sequence of characters</td>
</tr>
</tbody>
</table>

**Example**
- **Input:** Cheese Pizza
- **Parameter:** Chees
- **Output:** true

**Substring**
Returns a substring from the input String that is based on the provided **Start Index** and **End Index**. Input String index starts at 0.
### Parameters

- **Start Index** - Index of the first character to include in the returned substring
- **End Index** - Index of the last character to include in the returned substring

### Output data pill

String - Transformed String as a substring of the input String

### Example

- **Input**: Example input string
- **Start Index**: 3
- **End Index**: 6
- **Output**: mple

### To Lower Case

Converts the input String to all lowercase characters.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>String in all lowercase characters</td>
</tr>
</tbody>
</table>

**Example**

- **Input**: Example input string
- **Output**: example input string

### To Proper Case

Changes the case of words in the input string. Capitalizes the first letter of each word and makes the remaining letters in the word lower case. A word is considered any string separated by a space, hyphen, backslash, or forward slash character. The transform function always evaluates words from left-to-right to determine the first letter.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>String in proper case</td>
</tr>
</tbody>
</table>
Example

- **Input**: exAMPle-input string/TEXT
- **Output**: Example-Input String/Text

**To Upper Case**

Converts the input String to all uppercase characters.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>String in all uppercase characters</td>
</tr>
</tbody>
</table>

**Example**

- **Input**: ExamPle inpuT stRing
- **Output**: EXAMPLE INPUT STRING

**Trim**

Removes white space from the beginning and end of the input String. Does not remove white space within the input String.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>String - Transformed String with trimmed white space</td>
</tr>
</tbody>
</table>
Example

- **Input:** SQL Server APAC 1
- **Output:** SQL Server APAC 1

In this example, the action makes a REST call to a third-party system and GETs a response body containing data about a server. Then, the Trim transform function removes any unwanted white space before adding the server’s name to a new record in the Server [cmdb_ci_server] table.

Utilities transform functions

Use utilities transform functions to return a Complex Object from an Array, or a value associated with a specific key.

Utilities transform functions require an Array, Name-Value Pair, String, Integer, or Choice input data pill. Make sure to use the correct input data pill when applying utilities transform functions. If a utilities transform function is applied to an improper data type, the data is not transformed at runtime and the input value is returned instead. For more information on confirming your flow runtime values, see Test a flow.

Get First Item from Array

Returns the first item from the input array as a complex object.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array</td>
<td><strong>Complex Object</strong> - First item found in the input array</td>
</tr>
</tbody>
</table>
Get Item from Array

Returns a Complex Object from the input Array. Enter a value for the Nth Item in
the input Array that you want to return. The Nth Item represents the Array index,
starting at 0.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array</td>
<td>Nth Item - Enter the index of the target object in the input Array. The Array index starts at 0.</td>
<td>Complex Object</td>
</tr>
</tbody>
</table>

Get Item from Name/Values

Returns a value that is associated with a matching key from a map of Name-
Value Pairs.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name-Value Pairs</td>
<td>• Key - Name of the key that is used to look up its corresponding value • Default - The value returned when there is no matching key</td>
<td>String associated with the matching key</td>
</tr>
</tbody>
</table>

Note: When applying the Get Item from Name/Values transform function, consider that the runtime value might be the system value, not the display value. For example, if mapping the Priority field in the Incident table to a similar field in a remote table, the returned runtime value might be 2, not 2 - High.
Example

• Input: "username":"abel.tuter"
• Key: username
• Default: example.username
• Output: abel.tuter

In this example, an action makes a REST call to a third-party system and GETs ticket data as a map of Name-Value Pairs. A Ticket ID is provided as an output for this action. The Get Item from Name/Values transform function returns either the value that is associated with the ticket_id key or Ticket ID not found.

Get Last Item from Array
Returns the last item from the input array as a complex object.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array</td>
<td>Complex Object - Last item found in the input array</td>
</tr>
</tbody>
</table>

Is Blank?
Returns true when the input is blank. A string input is blank when it is an empty string. An integer input is blank when it is zero. A Boolean input is blank when it is false.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Returns true or false</td>
</tr>
</tbody>
</table>
Example

- Input: an integer data pill with 0
- Output: true

Is False?

Returns true when the input is false. A string is false when it is an empty string. An integer is false when it is zero. A Boolean input is false when it is false.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Returns true or false</td>
</tr>
</tbody>
</table>

Example

- Input: an integer data pill with 13
- Output: false

Is Not Blank?

Returns true when the input is not blank. A string is not blank when it is not an empty string. An integer is not blank when it is anything but zero. A Boolean input is not blank when it is true.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Returns true or false</td>
</tr>
</tbody>
</table>

Example

- Input: an integer data pill with 13
- Output: true

Is Null?

Returns true when the input value is null. An input is null if it is not initialized, or if it is a null object or reference.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Returns true or false</td>
</tr>
</tbody>
</table>
Example

- Input: an integer data pill with 725
- Output: false

Is True?

Returns true when the input is true. A string is true when it is not an empty string. An integer is true when it is anything but zero. A Boolean input is true when it is true.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Returns true or false</td>
</tr>
</tbody>
</table>

Example

- Input: an integer data pill with 13
- Output: true

Key Value Map

Returns a value associated with a matching key, or a default value if there is not a match.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
</table>
| String or Integer
| • Name - The key that is used to find the corresponding value
| • Value - The value matched to a specific key
| • Default - The value returned when there is no matching name |
| String associated with the matching key |
Example

In this example, a log action stores a record’s priority as a message. In the Name-Values section, each priority is mapped to a corresponding string value. When the flow runs, the record’s priority number is transformed to a string, and the string is logged to a message.

Simple math transform functions

Use simple math transform functions to perform basic mathematical calculations on Number data pills.

Simple math transform functions require an Array.Number, Array.Integer, or Array.Decimal input data pill. Make sure to use the correct input data pill type when applying simple math transform functions. If a simple math transform function is applied to an improper data type, the data is not transformed at runtime and the input value is returned instead. For more information on confirming your flow runtime values, see Test a flow.

Absolute Value

A mathematical function that returns the distance from zero for any real number. An absolute value is always a positive or zero value.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number, Integer, or Decimal</td>
<td>Number as the absolute value of the input number</td>
</tr>
</tbody>
</table>

Example

• Input: -3
• Output: 3
Add

Adds the given value to the input.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number, Integer, or Decimal</td>
<td>Number to be added.</td>
<td>Number as the addition of the input value by the parameter.</td>
</tr>
</tbody>
</table>

Example

- Input: 12
- Parameter: 4
- Output: 16

Average

Returns the average value of the elements in the input array.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array.Number, Array.Integer, or Array.Decimal</td>
<td>Number as the average value of the input array.</td>
</tr>
</tbody>
</table>

Example

- Input: [10, 30, 20]
- Output: 20

Count

Returns the number of elements in the input array.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array.Number, Array.Integer, Array.Decimal, Array.Object, Array.String, or Array.Boolean</td>
<td>Number of elements in the input array</td>
</tr>
</tbody>
</table>

Example

- Input: [2, 10, 30]
- Output: 3
Divide
Divides the input value by a given value.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number, Integer, or Decimal</td>
<td>Number to divide the input value by.</td>
<td>Number as the division of the input value by the parameter.</td>
</tr>
</tbody>
</table>

**Example**
- Input: 12
- Parameter: 4
- Output: 3

Max
Returns the highest value found in the input Array.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array.Number, Array.Integer, or Array.Decimal</td>
<td>Number as the highest value in the input Array</td>
</tr>
</tbody>
</table>

**Example**
- Input: [1, -5, 20, 6]
- Output: 20

Median
Returns the median value of elements in the input array.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array.Number, Array.Integer, or Array.Decimal</td>
<td>Number as the median value of the input array.</td>
</tr>
</tbody>
</table>

**Example**
- Input: [10, 30, 15]
- Output: 15
Min

Returns the lowest value found in the input Array.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array.Number, Array.Integer, or Array.Decimal</td>
<td>Number as the lowest value in the input Array</td>
</tr>
</tbody>
</table>

Example
- Input: [1, -5, 20, 6]
- Output: -5

Multiply

Multiplies the input value by a given value.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number, Integer, or Decimal</td>
<td>Number to be multiplied.</td>
<td>Number as multiplication of the input value by the parameter.</td>
</tr>
</tbody>
</table>

Example
- Input: 12
- Parameter: 4
- Output: 48

Power

Returns the value of the input value raised to the power of a given value.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number, Integer, or Decimal</td>
<td>Number as the exponent of the power.</td>
<td>Number as the power of input value to the parameter.</td>
</tr>
</tbody>
</table>
Example

- Input: 2
- Parameter: 3
- Output: 8

Round
A mathematical function that approximates a numeric value based on rounding rules and a digit position. The function rounds up by adding one to the digit to be rounded and then replacing all digits to its right with zeroes.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number, Integer, or Decimal</td>
<td><strong>Number of Digits</strong> - A positive integer specifying the position of the digit to be rounded starting on the left</td>
<td>Number as the rounded value of the input number</td>
</tr>
</tbody>
</table>

Example

- Input: 194
- Parameter: 2
- Output: 190

Note: The function uses the digit to the right of the parameter digit to round up or down. If the digit to the right has a value from zero through four, the function rounds down. If the digit to the right has a value from five through nine, then the function rounds up. If there is no digit to the right, then the function rounds down.

Square Root
A mathematical function that computes a positive number that when multiplied by itself produces the input value. The input value must be a positive real number.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number, Integer, or Decimal</td>
<td>Number as the square root of the input number</td>
</tr>
</tbody>
</table>

Example

- Input: 16
- Output: 4
**Subtract**

Subtracts the given value from the input.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number, Integer, or Decimal</td>
<td>Number to subtract from the input value.</td>
<td>Number as the subtraction of the input value by the parameter.</td>
</tr>
</tbody>
</table>

**Example**

- Input: 12
- Parameter: 4
- Output: 8

**Sum**

Returns the sum of all values in the input Array.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array.Number, Array.Integer, or Array.Decimal</td>
<td>Number as a sum of all values in the input Array</td>
</tr>
</tbody>
</table>

**Example**

- Input: [1, -5, 20, 6]
- Output: 22

**Sanitize shell arguments transform functions**

Use sanitize shell arguments transform functions to remove any potentially unsafe command injections in String data pills to be used for Bash shell scripting.

Sanitize shell arguments transform functions require a String input data pill. Make sure to use the correct input data pill type when applying sanitize shell arguments transform functions. If a sanitize shell arguments transform function is applied to an improper data type, the data is not transformed at runtime and the input value is returned instead. For more information on confirming your flow runtime values, see Test a flow.

**Note:** When a data pill is dropped into the Command input for an SSH step, the sanitize shell arguments transform function category automatically appears.
**Sanitize Bash shell arguments**

Returns a String free of any unsafe command injections in your Bash shell script. Wraps the input String with single quotes and escapes any existing single quotes so that you can pass the String directly to a shell function as a safe argument.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>String - String with Bash shell arguments properly escaped</td>
</tr>
</tbody>
</table>

**Sanitize SQL transform functions**

Use sanitize SQL transform functions to escape special characters and prevent injection in String data pills to be used for SQL statements.

Sanitize SQL transform functions require a String input data pill. Make sure to use the correct input data pill type when applying sanitize SQL transform functions. If a sanitize SQL transform function is applied to an improper data type, the data is not transformed at runtime and the input value is returned instead. For more information on confirming your flow runtime values, see [Test a flow](#).

ℹ️ **Note:** When a data pill is dropped into the **SQL Statement** input for a JDBC step, the sanitize SQL transform function category automatically appears.

**Sanitize SQL Identifier**

Returns a String with escaped special characters/injected values for SQL identifiers (such as table, view, and column names). Wraps the input String in database-specific quotes.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Parameters</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>• <strong>Database</strong> - The database-specific context in which characters are escaped. Choices include MySQL, Oracle, PostgreSQL, and Microsoft SQL Server.</td>
<td>String - String with SQL identifiers that are properly escaped based on the selected database</td>
</tr>
</tbody>
</table>
Example

- Input: `simple_column`
- Database: `MySQL`
- Output: `simple_column`
Complex data transform functions

Use complex data transform functions to serialize Complex Object data pills into an XML format.

Complex data functions require a Complex Object input data pill. Make sure to use the correct input data pill type when applying complex data transform functions. If a complex data transform function is applied to an improper data type, the data is not transformed at runtime and the input value is returned instead. For more information on confirming your flow runtime values, see Test a flow.

To XML

Serializes the input Complex Object to XML.

<table>
<thead>
<tr>
<th>Input data pill</th>
<th>Output data pill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complex Object</td>
<td>XML - XML document formatted as a String</td>
</tr>
</tbody>
</table>

**Example**

- **Input:** { "article_id": KB3843202, "article_description": "How do I reset my Active Directory password?" }
- **Output:**
  ```xml
  <article_id>KB3843202</article_id>
  <article_description>How do I reset my Active Directory password?</article_description>
  ``

In this example, an action makes a REST call to a third-party knowledge base and retrieves KB article IDs and descriptions. The To XML transform function changes the response body's JSON text into XML format before it is integrated into the system's knowledge base.
Domain separation and Flow Designer

Domain separation is supported in Flow Designer. Flow Designer supports domain separation of business logic, which lets each tenant domain have its own flows, actions, and subflows. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Standard*

- Includes Basic level
- Business logic: Processes can be created or modified per customer by the service provider. The use cases reflect proper use of the application by multiple service provider customers in a single instance.
- The owner of the instance needs to be able to configure MVP business logic and data parameters per tenant as expected for the specific application.

Use case: As an admin, I need the ability to make comments mandatory on close of a record for one tenant, but not for another.

How domain separation works in Flow Designer

The system domain separates Flow Designer content according to these rules.

**Flow Designer content inherits the domain of the user who creates them**

Flows, actions, and subflows belong to the domain of the user who creates them. For example, when a service provider (SP) administrator in the TOP domain creates a flow, it belongs to the TOP domain.

*Note:* The domain selected from the domain picker overrides the domain the user belongs to. For example, when an SP administrator in the TOP domain selects the ACME domain from the domain picker, any content created belongs to the ACME domain.

**Flow Designer content runs from the domain from which it is triggered or initiated**

Flows, actions, and subflows run from the domain of the record or user who initiates them. For example, when a user from the child domain ACME triggers a flow belonging to the parent domain TOP, the flow runs in the context of the child domain ACME.
### Domain assignment by trigger type

<table>
<thead>
<tr>
<th>Trigger type</th>
<th>Domain assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>API call</td>
<td>Domain of the user making API call</td>
</tr>
<tr>
<td>Email trigger</td>
<td>Domain of the email sender</td>
</tr>
<tr>
<td>Record trigger</td>
<td>Domain of the triggering record</td>
</tr>
<tr>
<td>Scheduled trigger</td>
<td>Domain of the flow</td>
</tr>
<tr>
<td>Service Catalog trigger</td>
<td>Domain of the requested item record</td>
</tr>
</tbody>
</table>

**Flow Designer only runs content accessible from the current domain context**

The system can only run content to which the current domain context allows access. See [Understanding domain separation](#) to understand data separation and the domain hierarchy. For example, a user in the child domain ACME can trigger flows belonging to the parent domain TOP, but cannot trigger flows belonging to a sibling domain such as INITECH.

Flow Designer runs record operations from the current user domain context. A read operation such as the Lookup Records action returns records based on the currently selected domain and its children. For example, if the currently selected domain is the TOP domain, you will see records from the TOP domain and all its children such as the ACME and INITECH domains. If the currently selected domain is the ACME domain, you will see records from the ACME domain and its children, but you will not see records from the parent TOP domain.

**Note:** Record operations use the data or process separation rules applied to the table the record belongs to. For example, suppose you have process-separated the Business Rule table. If you add a business rule to the TOP domain, the business rule will be accessible to record operations in child domains such as the ACME domain because process separation allows access to records from parent domains.

Flows that call another application such as a decision table or workflow also run from the current user domain context.

**Flow Designer runs all flows whose trigger conditions are met**

A flow in one domain cannot override or prevent a flow from another domain from running. Flow Designer runs any flow that
is visible to the current user and whose trigger conditions have been met. For example, a flow belonging to the TOP domain that is triggered by the creation of an incident record runs anytime an incident is created, regardless of whether the incident is created in the ACME or INITECH child domains.

**Design considerations**

Follow these design considerations when using domain separation with Flow Designer.

**Have a service provider (SP) administrator in the TOP domain author and manage tenant flows, actions, and subflows**

Since tenants cannot override Flow Designer content, an SP administrator from the TOP domain must author and manage them to ensure they run properly for all domains. While you can create domain-specific flows, be aware that users working from domains higher in the hierarchy may trigger multiple child domain flows. For example, a user working in the TOP domain can trigger flows in child domains such as ACME and INITECH.

ℹ️ **Note:** Flow authors can see only Flow Designer content available from their current domain and any parent domains in the hierarchy. Flow Designer does not display content visible from Contains domains.

**Provide a unique name for each flow, action, and subflow**

Since all domains share the same Flow Designer content, have an SP administrator in the TOP domain uniquely name each flow, action, and subflow to ensure that a flow intended for one domain does not duplicate the name of a flow in another domain. For example, add the domain to the flow name such as `Validate incidents - TOP`, `Validate incidents - ACME`, and `Validate incidents - INITECH`.

**Ensure flows and actions only contain artifacts available from the current or parent domains**

Flow Designer prevents the activation of any flow containing artifacts unavailable to the current or parent domains. For example, if you create a domain-specific flow that belongs to the ACME domain, it cannot contain actions or subflows belonging to the sibling domain INITECH.

**Edit Flow Designer content in the domain to which it belongs**
While users in a parent domain can see flows, actions, and subflows in a child domain, they must edit them in the domain they belong to. For example, an administrator in the TOP domain can see flows from the ACME domain but must switch to the ACME domain to edit it.

Related information
Domain separation for service providers

Generate group approvals for domain separated requests

Configure Flow Designer to generate approvals for all members of a group or to restrict approvals to only group members who are visible from the domain of the request.

Before you begin
Role required: admin

About this task
By default, Flow Designer generates approvals for all group members who can access the parent request regardless of domain visibility. This configuration allows requests from members of a child domain to generate approvals for members of a parent domain who are not otherwise visible from lower in the domain hierarchy. You can use this procedure to restrict the generation of approvals to only those group members who are visible from the domain of the parent request. For information about domain hierarchies, see Understanding domain separation. For more information about visibility and contains domains, see Visibility domains and contains domains.

Procedure
1. Add a system property.
2. For the system property name, enter `com.glide.hub.flow.approval.group_member.use_query_no_domain`.
3. For the system property type, select `true` or `false`.
4. For the system property value, enter one of these values.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>Generate approvals for all members of the group who have access to the domain of the parent request. Select this option to exclude domain visibility from the approval generation query.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>For example, generate approvals for users who belong to domains higher in the domain hierarchy. This is the default value.</td>
<td></td>
</tr>
<tr>
<td>Generate approvals only for group members who are visible from the domain of the parent request. Select this option to include domain visibility in the approval generation query. For example, do not generate approvals for users who belong to domains higher in the domain hierarchy.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Flow Designer only generates approvals for users who can access the domain of the request.

**Results**

Flow Designer only generates approvals for group members who belong to the same domain or child domains of the parent request.

**User access to Flow Designer**

Administrators can grant users access to Flow Designer by assigning delegated development permissions or directly assigning a user role. Administrators can also specify which features and content a user can access based on user roles. Application developers can access Flow Designer functionality through APIs for flows, subflows, and actions.

**Flow Designer user roles**

Administrators can grant access to Flow Designer by directly assigning users the flow_designer user role, which includes the role to view flow execution details.

**Warning:** Directly granting a user the flow_designer role is equivalent to giving the user the admin role, because Flow Designer can run flows as the System user, which has access to all tables and all database operations.

Administrators can also grant users one or more Flow Designer roles to enable them to create flows and subflows, view flow execution details, and create actions.
### Flow Designer roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>flow_designer</td>
<td>Enables a user to launch the Flow Designer design environment to create and edit flows and subflows.</td>
<td>flow_operator</td>
</tr>
<tr>
<td>flow_designer_scripting</td>
<td>Enables a user with the flow_designer or action_designer role to set and modify input values by writing inline scripts. For information, see Inline scripts.</td>
<td>none</td>
</tr>
<tr>
<td>flow_operator</td>
<td>Enables a user to view flow execution details, dashboards, and logs. Administrators can grant this role to users that want to be able to view flow results but not create, change, or test them.</td>
<td>none</td>
</tr>
<tr>
<td>action_designer</td>
<td>Enables a user to launch the Action Designer design environment to create and edit actions.</td>
<td>none</td>
</tr>
<tr>
<td>action_category_creator</td>
<td>Enables a user with the action_designer role to create action categories for actions and subflows.</td>
<td>none</td>
</tr>
</tbody>
</table>

### API access

Application developers can access Flow Designer functionality through APIs for flows, subflows, and actions. Flow designers can enable individual flows, subflows, and actions to be client callable during design. For more information, see API access to Flow Designer.

### Delegated development access

Administrators can grant users access to Flow Designer by creating an application and assigning users as developers with the Flow Designer delegated development permission. Delegated development allows administrators to control whether flow designers can access features normally restricted to admin users such as assigning user roles, creating access controls, or creating scripts. For more information, see Developer permissions.
Feature access and content filtering by user role
Administrators can specify which features and content a user can access based on their role.

Feature access
Specifies the user roles necessary to access the UI elements of Flow Designer. For example, the buttons to save, test, or activate a flow or the option to copy a code snippet. Manage feature access directly through the Feature Access List. For more information, see Manage access to Flow Designer features.

Content filtering
Specifies the user roles necessary to access Flow Designer content. For example, flows, flow triggers, actions, and subflows. Manage content filtering by creating content definitions and content filtering rules. For more information, see Content filtering for Flow Designer.

Note: Users must have the flow_designer role to create and edit flows. Administrators can specify the additional roles that a user must have to access particular features or content.

API access to Flow Designer
Application developers can access Flow Designer functionality through APIs for flows, subflows, and actions. Flow designers can enable individual flows, subflows, and actions to be client callable during design.

Available Flow Designer APIs
Trigger flows, subflows, and actions using these APIs from server or client scripts.

Server side
FlowAPI: Trigger a flow, subflow, or action using synchronous or asynchronous methods, with or without execution details.

Client side
GlideFlow: Perform client-side interactions with actions, flows, and subflows. Flow designers must enable a flow, subflow, and action to be called from the client.

FlowAPI quick methods
Use quick methods in the FlowAPI class to run an action, flow, or subflow from a server-side script without creating execution details or other related records. Use these methods to increase the speed of high-volume processing in a production environment, and to improve performance by eliminating record-keeping overhead. Methods include:
• `executeActionQuick()`, `executeFlowQuick()`, `executeSubflowQuick()`: Run an action, flow, or subflow from a server-side script synchronously from the current user session.

• `startActionQuick()`, `startFlowQuick()`, `startSubflowQuick()`: Run an action, flow, or subflow from a server-side script asynchronously.

**XML and JSON streaming APIs**

Build a large streaming or non-streaming JSON or XML payload to use in a REST or SOAP request to send bulk data to a third-party API. For example, you can use these APIs to create a JSON payload in the ServiceNow® Flow Designer Script step and pass the returned value to the REST step to send the request to a third-party service. For more information, see `JSONStreamingBuilder` and `XMLStreamingBuilder`.

**Client callable APIs**

By default, the flows, subflows, and actions can only be called by the FlowAPI within a server script. Flow and action designers can make individual flows, subflows, or actions available to client calls by enabling the **Client callable** option during design.

**Run as support**

Flows and subflows can run as either the system user or the user who initiates the session. Set this behavior from the flow properties. All API quick methods ignore the run as property, and always run as the system user.

Actions always run as the user who initiates the session.

**Code snippets**

Application developers can generate a JavaScript function that calls a specific flow, subflow, or action with the **Code Snippet** option. Use the code snippet in scripts such as business rules or the **Scripts - Background** module to call specific Flow Designer elements. The system only generates code snippets for published flows, subflows, and actions. Flow Designer elements in the draft or modified status do not generate code snippets.

**Create code snippets for flows, sub-flows, and actions**

Generate a code snippet to call a specific flow, subflow or action.
Before you begin

- Role required: flow_designer or admin
- Activate the flow or subflow you want to call.
- Publish the action you want to call.

Procedure

2. Open a flow, subflow, or action.
3. Click the More Actions icon in the upper right corner of the flow designer.
5. A modal window appears containing the code snippet. The text of the snippet is selected by default. To copy the code, manually copy the code from the pop-up modal, or click the Copy Code Snippet Clipboard button.

Create a client callable flow, subflow, or action

Enable a client script to trigger a flow, subflow, or action.

Before you begin

- Role required: security_admin
- Consider the implications of making a flow, subflow, or action client callable, such as whether it exposes protected data or bypasses validation logic.

About this task

By default, the flows, subflows, and actions can only be called by the FlowAPI within a server script. Flow and action designers can make individual flows, subflows, or actions available to client calls by enabling the Client callable option during design.

Procedure

1. Elevate privileges to security_admin.
3. Click New.
4. Create an access control.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>client_callable_flow_object</td>
</tr>
</tbody>
</table>
### Manage access to Flow Designer features

Specify which features a user can access based on the user's role.

#### Before you begin

Create any custom roles that you want to use for feature access. When you specify which roles are required to access a feature, you select from a list of existing roles.

**Role required:** admin

#### About this task

Features are elements of the Flow Designer UI. When feature filtering is turned off, users with the flow_designer role have access to all Flow Designer features. When feature filtering is turned on, administrators can specify which roles a user must have to access individual features.

**Note:** Users must have the flow_designer role to create and edit flows. Administrators can specify the additional roles that a user must have to access particular features or content.

---

#### Table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation</td>
<td>create</td>
</tr>
<tr>
<td>Admin overrides</td>
<td>Selected</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a name for the ACL.</td>
</tr>
<tr>
<td>Requires role</td>
<td>Create a role to provide access to the APIs. For example, create a flow_api_access role.</td>
</tr>
</tbody>
</table>
Procedure


2. For each feature on the list, click the edit icon (📝) next to the feature.

3. Enter the role or roles required to access the feature.

   Note: Add the flow_designer role to each feature on the Feature Access List. Users must have the flow_designer role to access Flow Designer features.

4. Continue until you have added roles to each feature on the list.

5. Click OK.

6. To turn on feature access, select the Enable feature access filtering? option. Once enabled, users must have the required roles to access the features. If a user doesn't have the required roles for a feature, the feature will not render for that user.

What to do next

Assign users the roles necessary to access your features.

Content filtering for Flow Designer

Specify which content a user can access based on the user's role.

Display only content that is relevant for a particular user, hiding content that is unnecessary or sensitive. Specify the Flow Designer content that you want to control access to and the role that a user must have to access it. For example, if a user with the hr_manager role in human resources is creating a flow, show only the set of actions and subflows that are relevant to HR cases.

Content filtering uses:

• Content definitions to specify types of content.

• Content filtering rules to determine who can access the content.

Flow Designer includes several default definitions and filtering rules. Set up content filtering by modifying pre-existing rules or creating your own.

Content definitions

Content definitions specify a type of Flow Designer resource. Resources are the key components of Flow Designer, such as triggers, actions, and subflows. Create definitions to include an entire resource, or refine your definitions through conditions. For example, you can create a definition that includes all flow
triggers, or you can use conditions to include only triggers with a category of date.

You can further refine content definitions through tagging. Add tags to items in a resource list, then design your content definition to only include resources with that tag.

**Content filtering rules**

Content filtering rules specify the role that a user must have to access the content in a particular definition. Each rule associates a single user role with a single content definition. When a user accesses Flow Designer, content filtering rules determine what content the user may access based on the user's role.

**Feature access**

You can also filter access to Flow Designer features. Features are UI elements and sections. Access to both elements and sections can be managed by configuring content definitions and filtering rules. However, access to UI elements can also be managed through a simplified UI. For more information, see Manage access to Flow Designer features.

**Read-only flows**

Users may be able to view a flow, subflow, or action containing content that they can't normally access. For example, a flow that's visible to a user might include an action the user wouldn't usually be able to view. When a flow contains restricted content, the entire flow becomes read-only. Users can run the flow but can't modify or copy it.

The creation of read-only flows doesn't apply to feature filtering. If a user doesn't have access to a feature, the feature doesn't render for that user. It doesn't affect the ability to copy or modify a flow. If a user doesn't have access to transform functions and uses a flow that already has a transform function applied, the transform function is read-only. The rest of the flow can still be copied and modified.
## Access summary

<table>
<thead>
<tr>
<th>Resource filtered</th>
<th>User has role</th>
<th>User does not have role</th>
</tr>
</thead>
</table>
| Flow              | • The flow is visible to select during design.  
                    • The flow can be copied.  
                    • The flow can be modified. | • The flow is hidden and cannot be selected during design. For example, the flow is hidden when creating a Process Automation Designer activity definition.  
                    • The flow cannot be copied.  
                    • The flow is read-only. |
| Trigger           | • The trigger is visible to select during design.  
                    • Any flow that includes the trigger can be copied.  
                    • Any flow that includes the trigger can be modified. | • The trigger is hidden and cannot be selected during design.  
                    • Any flow that includes the trigger cannot be copied.  
                    • Any flow that includes the trigger is read-only. |
| Subflow           | • The subflow is visible to select during design.  
                    • Any flow that calls the subflow can be copied.  
                    • Any flow that calls the subflow can be modified. | • The subflow is hidden and cannot be selected during design.  
                    • Any flow that calls the subflow cannot be copied.  
                    • Any flow that calls the subflow is read-only. |
| Flow logic        | • The flow logic is visible to select during design.  
                    • Any flow that includes the flow logic can be copied. | • The flow logic is hidden and cannot be selected during design.  
                    • Any flow that includes the flow logic cannot be copied.  
                    • Any flow that includes the flow logic is read-only. |
## Access summary (continued)

<table>
<thead>
<tr>
<th>Resource filtered</th>
<th>User has role</th>
<th>User does not have role</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Any flow that includes the flow logic can be modified.</td>
<td>• The action is hidden and cannot be selected during design.</td>
</tr>
<tr>
<td>Action</td>
<td>• The action is visible to select during design.</td>
<td>• Any flow that includes the action cannot be copied.</td>
</tr>
<tr>
<td></td>
<td>• Any flow that includes the action can be copied.</td>
<td>• Any flow that includes the action is read-only.</td>
</tr>
<tr>
<td></td>
<td>• Any flow that includes the action can be modified.</td>
<td></td>
</tr>
<tr>
<td>Step</td>
<td>• The step is visible to select during design.</td>
<td>• The step is hidden and cannot be selected during design.</td>
</tr>
<tr>
<td></td>
<td>• Any action that includes the action can be copied.</td>
<td>• Any action that includes the step cannot be copied.</td>
</tr>
<tr>
<td></td>
<td>• Any action that includes the step can be modified.</td>
<td>• Any action that includes the step is read-only.</td>
</tr>
<tr>
<td>UI elements and sections, excluding transform functions</td>
<td>• The UI element or section is visible to use during design.</td>
<td>• The UI element or section is hidden and cannot be used during design.</td>
</tr>
<tr>
<td></td>
<td>• Any flow, subflow, or action that includes the UI element or section can be copied.</td>
<td>• Any flow, subflow, or action that includes the UI element or section can be copied.</td>
</tr>
<tr>
<td></td>
<td>• Any flow, subflow, or action that includes the UI element or section can be modified.</td>
<td>• Any flow, subflow, or action that includes the UI element or section can be modified.</td>
</tr>
</tbody>
</table>
configure content filtering definitions

Specify which content a user can access by creating content definitions.

Before you begin
Content filtering requires some familiarity with user roles and Flow Designer tables and records.

Role required: flow_designer, action_designer, or admin

About this task
Filter Flow Designer content based on user role. Filtering content requires you to set up:

1. Content definitions to describe the content that you want to filter. Content definitions specify types of Flow Designer resources, such as actions and subflows.

2. Content filtering rules to state the role a user must have to access the resource in a particular definition.

Flow Designer includes several content definitions and filtering rules by default. Get started with content filtering by modifying the preexisting definitions and rules or creating your own.
Procedure

1. To modify or create a content definition, navigate to Process Automation > Flow Administration > Content Definitions.
2. Select the definition that you want to modify or click New to create one.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the content definition.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for the definition. This field is automatically set to the currently selected application scope. If no application scope is selected, the field is set to Global.</td>
</tr>
<tr>
<td>Table</td>
<td>Table containing the resource type that you’re defining. For example, the Flow [sys_hub_flow] table includes all the flows and subflows available on your instance.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions used to filter the records in the table. For example, creating a condition where [Flow Type] [is] [SubFlow] returns only the subflows from the Flow table.</td>
</tr>
<tr>
<td>Resource Tags</td>
<td>Tags used to filter the resources in the table.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Configure content filtering rules

Use content filtering rules to specify the role a user must have to access content.

Before you begin
Role required: flow_designer, action_designer, or admin

Content filtering requires some familiarity with user roles and Flow Designer tables and records.

Role required: flow_designer, action_designer, or admin

About this task
Filter Flow Designer content based on user role. Filtering content requires you to set up:
1. Content definitions to describe the content that you want to filter. Content definitions specify types of Flow Designer resources, such as actions and subflows.

2. Content filtering rules to state the role a user must have to access the resource in a particular definition.

Flow Designer includes several content definitions and filtering rules by default. Get started with content filtering by modifying the pre-existing definitions and rules or creating your own.

**Procedure**

1. To modify or create a content filtering rule, navigate to Process Automation > Flow Administration > Content Filtering Rules.

2. Select the rule that you want to modify or click New to create one.

3. On the form, fill in the fields.

**Flow Designer Resource Filter Rule form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the content filtering rule.</td>
</tr>
<tr>
<td>User Role</td>
<td>The role a user must have to access the content in the Resource Definition field.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to enable the rule.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for the rule. This field is automatically set to the currently selected application scope. If no application scope is selected, the field is set to Global.</td>
</tr>
<tr>
<td>Resource Definition</td>
<td>The name of the content definition that specifies the resource to filter.</td>
</tr>
</tbody>
</table>

4. Click Submit.

**Spokes**

Add application-specific content to Flow Designer by installing spokes.

A spoke is a scoped application containing Flow Designer content dedicated to a particular application or record type. For example, the **ITSM Spoke** contains actions for managing Task records such as the **Create Task** action. Spokes are activated when their parent application is activated. For example, the **ITSM Spoke** is activated when the Incident, Problem, and Change applications are...
activated. Creating a spoke requires familiarity with application development as developers must add Flow Designer content to a scoped application.

### Default spokes available

<table>
<thead>
<tr>
<th>Spoke</th>
<th>Description</th>
<th>Plugin</th>
<th>Included with</th>
</tr>
</thead>
<tbody>
<tr>
<td>Benchmarks Spoke</td>
<td>Provides read-only actions for the read-only Benchmark Recommendation Evaluator flow.</td>
<td>[com.sn_bm_client.spoke]</td>
<td>Now Platform</td>
</tr>
<tr>
<td>Connect spoke</td>
<td>Provides actions to automate the creation of conversations, to add users to a conversation, and to send messages to a conversation. These actions work with Connect API version 3 and later.</td>
<td>[com.glide.connect.client.spoke]</td>
<td>Now Platform</td>
</tr>
<tr>
<td>External Related Files Spoke</td>
<td>The External Related Files spoke stores information about files in third-party systems and helps you manage the information.</td>
<td>[com.sn.external.files]</td>
<td>Now Platform</td>
</tr>
</tbody>
</table>
### Default spokes available (continued)

<table>
<thead>
<tr>
<th>Spoke</th>
<th>Description</th>
<th>Plugin</th>
<th>Included with</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Service Spoke</td>
<td>Provides actions for flow designers to use when creating Field Service Management business processes.</td>
<td>[com.snc.field_service.spoke]</td>
<td>Field Service Management application</td>
</tr>
<tr>
<td>ITSM spoke</td>
<td>Provides flow and actions associated with ITSM. Requires the ITSM application suite.</td>
<td>[com.snc.itsm.spoke]</td>
<td>ITSM application</td>
</tr>
<tr>
<td>Predictive Intelligence for Flow Designer</td>
<td>Provides actions to make predictions from trained Predictive Intelligence solutions.</td>
<td>[com.snc.ml_flowdesigner]</td>
<td>Predictive Intelligence</td>
</tr>
<tr>
<td>Visual Task Board (VTB) Spoke</td>
<td>Provides VTB actions for flow designers to manage the boards, lanes, cards, board members, and assignees.</td>
<td>[com.glide.ui.vtb.ah]</td>
<td>Now Platform</td>
</tr>
</tbody>
</table>

Additional spokes are available with an IntegrationHub subscription. To see a list of IntegrationHub spokes, see IntegrationHub available spokes. For more
information about requesting an IntegrationHub subscription, see Request IntegrationHub.

**Benchmarks Spoke**

Provides read-only actions for the read-only Benchmark Recommendation Evaluator flow.

The Benchmarks Spoke is designed for the Recommendations feature of the Benchmarks application.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Action Inputs</th>
<th>Action Outputs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Recommendation Activity Records</td>
<td>Create or update recommendation activity records.</td>
<td>• Recommendation</td>
<td>N/A</td>
</tr>
<tr>
<td>Delete Recommendation Evaluations</td>
<td>Delete recommendation evaluations for the specified month.</td>
<td>• Activity record</td>
<td>N/A</td>
</tr>
<tr>
<td>Evaluate Recommendation Condition</td>
<td>Evaluate the conditions and script specified for the recommendation.</td>
<td>• Record count</td>
<td>• Result</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Threshold</td>
<td>• Score</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Direction</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Recommendation</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Activity record</td>
<td></td>
</tr>
</tbody>
</table>

**Connect spoke**

Provides actions to automate the creation of conversations, to add users to a conversation, and to send messages to a conversation. These actions work with Connect API version 3 and later.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Group Users to Task Conversation</td>
<td>Create a task conversation, and add all users of a group to it.</td>
</tr>
<tr>
<td>Add User to Task Conversation</td>
<td>Create a task conversation, and add a user to it.</td>
</tr>
<tr>
<td>Send Message to Task Conversation</td>
<td>Send a message to all users of a task conversation.</td>
</tr>
</tbody>
</table>
Customer Service Spoke


<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Case</td>
<td>Retrieve a case record using the case number. If multiple records are found, only the first record is returned.</td>
</tr>
<tr>
<td>Create Case</td>
<td>Create a case using one or more attributes. This action mimics the structure of the Case table (sn_customerservice_case) and exposes the fields present on the Case table.</td>
</tr>
<tr>
<td>Create Quick Case</td>
<td>Create a case using the customer, description, channel, priority, and category attributes.</td>
</tr>
<tr>
<td>Create Task on Case</td>
<td>Create a case task and optionally associate it with a case.</td>
</tr>
<tr>
<td>Update Case</td>
<td>Update a case by providing the case reference and the fields that you want to update.</td>
</tr>
<tr>
<td>Assign Case</td>
<td>Assign a case using matching rules. To use this action, you must first define the matching rules that match cases with resources (assignment groups, agents).</td>
</tr>
<tr>
<td>Escalate Case</td>
<td>Request case escalation. This action does not automatically approve escalation. Approval is based on the selected escalation template.</td>
</tr>
<tr>
<td>Escalate Account</td>
<td>Request account escalation. This action does not automatically approve escalation. Approval is based on the selected escalation template.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Add Work Note to Task</td>
<td>Add a work note to a task or to task extended objects (for example, a case or case task).</td>
</tr>
<tr>
<td>Add Comment to Task</td>
<td>Add a comment to a task or to task extended objects (for example, a case or case task).</td>
</tr>
</tbody>
</table>

**External Related Files spoke**

The External Related Files spoke stores information about files in third-party systems and helps you manage the information.

**External Related Files spoke tables**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Provider</td>
<td>Stores information about the external provider. For example, Box or DocuSign services.</td>
</tr>
<tr>
<td>[sn_ext_files_spoke_provider]</td>
<td></td>
</tr>
<tr>
<td>External Related Files</td>
<td>Stores metadata information about the files in third-party systems. This table is extensible.</td>
</tr>
<tr>
<td>[sn_external_related_files]</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** If you extend the table, ensure that you perform the data separation for the scoped applications

- To store metadata information of files in a specific third-party system, create a table with a column that contains a reference field to the External Related Files table. For more information about reference fields, see reference field type.
- To establish a relationship between a specific ServiceNow table and External Related Files table, create defined related lists.
### External Related Files spoke actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create External File Record</td>
<td>Creates a record in the External Related Files table.</td>
</tr>
<tr>
<td>Update External File Record</td>
<td>Updates a record in the External Related Files table.</td>
</tr>
<tr>
<td>Delete External File Record</td>
<td>Deletes a record in the External Related Files table.</td>
</tr>
</tbody>
</table>

### External Related Files spoke user roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_ext_files_spoke.doc_reader</td>
<td>Read records in the External Related Files and External Provider tables.</td>
</tr>
<tr>
<td>sn_ext_files_spoke.file_admin</td>
<td>• Read, update, and delete records in the External Related Files table.</td>
</tr>
<tr>
<td></td>
<td>• Read records in the External Provider table.</td>
</tr>
<tr>
<td>sn_ext_files_spoke.provider_admin</td>
<td>Read, update, and delete records in the External Provider table.</td>
</tr>
</tbody>
</table>

### Field Service Spoke

Provides actions for flow designers to use when creating Field Service Management business processes.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Work Order</td>
<td>Retrieve a work order record using the work order number. If multiple records are found, only the first record is returned.</td>
</tr>
<tr>
<td>Create Work Order</td>
<td>Create a work order and optionally associate it with a case.</td>
</tr>
<tr>
<td>Update Work Order</td>
<td>Update a work order by providing the work order reference and the fields that you want to update.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Get Work Order Task</td>
<td>Retrieve a work order task record using the work order task number. If multiple records are found, only the first record is returned.</td>
</tr>
<tr>
<td>Create Work Order Task</td>
<td>Create a work order task and optionally associate it with a work order.</td>
</tr>
<tr>
<td>Update Work Order Task</td>
<td>Update a work order task by providing the work order task reference and the fields that you want to update.</td>
</tr>
<tr>
<td>Add Work Note to Task</td>
<td>Add a work note to a task or to task extended objects (for example, a work order or work order task).</td>
</tr>
</tbody>
</table>

**ITSM spoke**

Provides flow and actions associated with ITSM. Requires the ITSM application suite.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Comment</td>
<td>Adds a comment to a task record.</td>
</tr>
<tr>
<td>Add Worknote</td>
<td>Adds a work note to a task record.</td>
</tr>
<tr>
<td>Apply Change Approval Policy</td>
<td>Controls the approval process for a change request by creating user and group approvals according to a change approval policy record. Multiple actions can be used in a flow, where each action references the same or different Change Approval Policies.</td>
</tr>
<tr>
<td>Assign Incident to CI Support Group</td>
<td>Updates an incident record to assign it to the CI Support Group.</td>
</tr>
<tr>
<td>Cancel Change Tasks from Flow</td>
<td>Cancels all related pending and open change tasks that are created from Flow.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Check Change for User Approval</td>
<td>Checks if the specified user has already approved the change request.</td>
</tr>
<tr>
<td>Create Catalog Task on Request</td>
<td>Creates a Catalog Task record from a Request record.</td>
</tr>
<tr>
<td>Create Catalog Task on Request Item</td>
<td>Creates a Catalog Task record from a Request Item record.</td>
</tr>
<tr>
<td>Create Change Task on Change Request</td>
<td>Creates a Change Task record from a Change Request record.</td>
</tr>
<tr>
<td>Create Emergency Change Request</td>
<td>Creates a Change Request record of type Emergency.</td>
</tr>
<tr>
<td>Create Emergency Request from Incident</td>
<td>Creates a Change Request record of type Emergency from an Incident record.</td>
</tr>
<tr>
<td>Create Incident</td>
<td>Creates an Incident record.</td>
</tr>
<tr>
<td>Create Incident Task on Incident</td>
<td>Creates an Incident Task record from an Incident record.</td>
</tr>
<tr>
<td>Create Normal Change Request from Incident</td>
<td>Creates a Change Request record of type Normal from an Incident record.</td>
</tr>
<tr>
<td>Create Outage</td>
<td>Creates a cmdb_ci outage record for a configuration item. The Task field is populated only if the source is a task record. If the source is non-task record such as an alert record, the Task field is empty.</td>
</tr>
<tr>
<td>Create Problem from Incident</td>
<td>Creates a Problem record from an Incident record.</td>
</tr>
<tr>
<td>Create Request</td>
<td>Creates a Request record.</td>
</tr>
<tr>
<td>Create Standard Change Request</td>
<td>Creates a Change Request record of type Standard.</td>
</tr>
<tr>
<td>Create Task</td>
<td>Creates a child task record for a Task table record. For example, creates an Incident Task record for an Incident record.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Create Task Outage Relationship</td>
<td>Creates a Task Outage Relationship record where cmdb_ci outage record and task record are inputs to the action.</td>
</tr>
<tr>
<td>Create Standard Change Request from Incident</td>
<td>Creates a Change Request record of type Standard from an Incident record.</td>
</tr>
<tr>
<td>Disregard Change Approvals</td>
<td>Sets all related pending approvals to no longer required.</td>
</tr>
<tr>
<td>Update Assignee</td>
<td>Updates the Assigned to field of a Task table record.</td>
</tr>
<tr>
<td>Update Assignment Group</td>
<td>Updates the Assignment Group field of a Task table record.</td>
</tr>
</tbody>
</table>

**Predictive Intelligence for Flow Designer**

Provides actions to make predictions from trained Predictive Intelligence solutions.

**Predictive Intelligence subscription**

This spoke requires a subscription to Predictive Intelligence. For more information, see Activate Predictive Intelligence.

**Key features**

Predictive Intelligence for Flow Designer provides four frameworks that you can use to create machine-learning solutions in your instance. Each framework delivers a different solution type for training the system to predict, recommend, and organize data outcomes.

- Classification framework
- Similarity framework
- Clustering framework
- Regression framework

**Spoke requirements**

- A sharedservice.worker user to train solutions
- A pre-trained solution for your Predictive Intelligence framework
Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- Predictive Intelligence (com.glide.platform_ml) plugin
- Predictive Intelligence Reporting (com.glide.platform_ml_pa) plugin

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
Predictive Intelligence for Flow Designer provides actions to make predictions using existing models without having to write or maintain script. Available actions include:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Classification</td>
<td>Obtain a predicted value from an active classification solution definition using multiple input records.</td>
</tr>
<tr>
<td>Batch Prediction</td>
<td></td>
</tr>
<tr>
<td>Classification Prediction</td>
<td>Obtain a predicted value from an active classification solution definition using a single input record.</td>
</tr>
<tr>
<td>Pi Confidence Check</td>
<td>Compare an output value (number) from Predictive intelligence with a number specified by the user. For example: Compare the confidence value of a prediction with a specified value.</td>
</tr>
<tr>
<td>Regression</td>
<td>Obtain a predicted value from an active regression solution definition using multiple input records.</td>
</tr>
<tr>
<td>Batch Prediction</td>
<td></td>
</tr>
<tr>
<td>Regression</td>
<td>Obtain a predicted value from an active regression solution definition using a single input record.</td>
</tr>
<tr>
<td>Prediction</td>
<td></td>
</tr>
<tr>
<td>Similarity Prediction</td>
<td>Obtain similar records that exist in the table specified by the user in their similarity solution definition.</td>
</tr>
</tbody>
</table>

Spoke user roles
Predictive Intelligence for Flow Designer provides these user roles to control access to data:

<table>
<thead>
<tr>
<th>User role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ml_admin</td>
<td>Grants access to all Predictive Intelligence features</td>
</tr>
</tbody>
</table>
**Related information**

Use Predictive Intelligence in Flow Designer with ML actions

**Security Operations spoke**


**Security Incident Response flow templates**

The Security Incident Response flow templates are created using the Flow Designer.

⚠️ **Note:** Each of the flows is triggered when the Category in a security incident is set or changed.

<table>
<thead>
<tr>
<th>Template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Perform a series of tasks designed to handle the exposure of sensitive data.</td>
</tr>
<tr>
<td></td>
<td>Perform a series of tasks designed to handle Denial of Service (DOS) attacks.</td>
</tr>
<tr>
<td></td>
<td>Perform a series of tasks designed to handle lost equipment.</td>
</tr>
<tr>
<td></td>
<td>Perform a series of tasks designed to handle malicious software on your network.</td>
</tr>
<tr>
<td></td>
<td>Perform a series of tasks designed to handle spear phishing emails on your network.</td>
</tr>
<tr>
<td></td>
<td>Perform a series of tasks designed to handle security policy violations.</td>
</tr>
<tr>
<td></td>
<td>Perform a series of tasks designed to handle reconnaissance on your network.</td>
</tr>
<tr>
<td></td>
<td>Perform a series of tasks designed to handle activity from rogue servers or services affecting your network.</td>
</tr>
<tr>
<td></td>
<td>Perform a series of tasks designed to handle email spam on your network.</td>
</tr>
<tr>
<td></td>
<td>Perform a series of tasks designed to handle unauthorized access to your network.</td>
</tr>
<tr>
<td></td>
<td>Perform a series of tasks designed to handle vandalism directed against one of your BBS or web sites.</td>
</tr>
</tbody>
</table>
# Visual Task Board (VTB) Spoke

Provides VTB actions for flow designers to manage the boards, lanes, cards, board members, and assignees.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Action Inputs</th>
<th>Action Outputs</th>
</tr>
</thead>
</table>
| Create Freeform VTB Action | Creates a Freeform VTB for any task type. The default lanes are: Todo, Doing, and Done. These lanes can be modified with actions: Add Lane, Rename Lane, Reorder Lane, and Delete Lane | • Name  
• Board Owner  
• Default view  
• Label visibility  
• Picker visibility  
• Background color | • Board record |
| Create Flexible VTB Action | Creates a Flexible VTB bound to a single Task table. The default lanes are: Todo, Doing, and Done. These lanes can be modified with actions: Add Lane, Rename Lane, Reorder Lane, and Delete Lane | • Name  
• Task table  
• Filter  
• Board Owner  
• Default view  
• Label visibility  
• Picker visibility  
• Background color | • Board record |
| Create Guided VTB Action | Creates a data-driven VTB bound to a single Task table along with the fields the lanes are derived.                                                                                                          | • Name  
• Task table  
• Land field  
• Filter  
• Board Owner  
• Default view  
• Label visibility | • Board record |
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Action Inputs</th>
<th>Action Outputs</th>
</tr>
</thead>
</table>
| Add VTB Member Action       | Add a user to a VTB. Only members of the VTB can access the board. Any VTB member can add other members. | • Board record  
• User record                                      | N/A            |
| Remove VTB Member Action    | Remove a user from a VTB. Only members of a VTB can access the board. Any VTB member can remove other members. | • Board record  
• User record                                      | N/A            |

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Action Steps</th>
<th>State</th>
</tr>
</thead>
</table>
| Add VTB lane                | Add a lane to a Freeform or Flexible VTB. This action does not apply to Guided boards, which are constrained to fixed lanes based on fields configured. | • Board record  
• Lane name                                              | • VTB lane record                                           |
| Rename VTB Lane             | Rename an existing lane on a Freeform or Flexible VTB.                       | • Lane record  
• New lane name                                              | N/A            |
| Reorder VTB Lane            | Reorder lanes on any VTB.                                                   | • Lane record  
• New lane name                                              | N/A            |
| Delete VTB Lane             | Delete an existing lane from a Freeform or Flexible VTB.                     | • Lane record                                              | N/A            |
## Card Management Actions

<table>
<thead>
<tr>
<th>Flow/Action</th>
<th>Description</th>
<th>Action Steps</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create VTB Card</td>
<td>Create a VTB card on a Freeform board for a task.</td>
<td>• Lane record</td>
<td>• Card</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Task record</td>
<td>record</td>
</tr>
<tr>
<td>Assign VTB Card</td>
<td>Assign a user to a VTB card.</td>
<td>• Card record</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• User record</td>
<td></td>
</tr>
<tr>
<td>Move VTB Card</td>
<td>Move a VTB card from one lane to another lane.</td>
<td>• Card record</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Lane record</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For Flexible boards, use the Update Record action to change the state of the underlying task. For Guided boards, this action changes the field on the task associated with that card.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remove Assignee from VTB Card</td>
<td>Remove an assignee from a card.</td>
<td>• Card record</td>
<td>N/A</td>
</tr>
</tbody>
</table>

## Change a flow or action’s default title

Change the default title for a flow, subflow, or action by adding styled and dynamic text.

### Before you begin

Role required: admin, flow_designer, or action_designer

### Procedure

2. On the Flow Designer landing page, click New and then select Flow, Subflow, or Action from the list.
3. In the Flow Designer main header, click the more actions icon ( ...).

4. Click **Change default title**.

5. On the Change default title screen, enter a title.

   a. Use any combination of the following options to create a styled title:

<table>
<thead>
<tr>
<th>Text style</th>
<th>Example input for new title</th>
<th>Example output in Flow Designer environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold</td>
<td>A <em>bold</em> title</td>
<td><img src="image" alt="A bold title" /></td>
</tr>
<tr>
<td>Italic</td>
<td>An <em>italic</em> title</td>
<td><img src="image" alt="An italic title" /></td>
</tr>
<tr>
<td>Underline</td>
<td>An <del>underlined</del> title</td>
<td><img src="image" alt="An underlined title" /></td>
</tr>
<tr>
<td>Strikethrough</td>
<td>A <del>strikethrough</del> title</td>
<td><img src="image" alt="A strikethrough title" /></td>
</tr>
<tr>
<td>Title (bold and colored)</td>
<td>A #titled# title</td>
<td><img src="image" alt="A titled title" /></td>
</tr>
</tbody>
</table>
b. Add dynamically generated text for your title from an input, output, action, or action step by clicking the data pill picker (дается) and selecting the input, output, action, or action step that you want to include in your title.

Note: The value that is associated with the Label field for an input or output appears in the title.

6. Click Submit.

Results
When you change your action or subflow's default title, the new title appears in the Flow Designer environment.

Instance Scan
Use ServiceNow® Instance Scan to interrogate your instance for configurations that indicate health issues and identify opportunities to address best practices. Instance Scan checks your existing configurations and helps you avoid creating future configuration issues. Instance Scan is a tool that can be used as a part of your development operations, release management as well as pre- and post-upgrades.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Upgrade to Quebec</td>
<td>• Now Platform feature - active by default</td>
<td>• Instance Scan dashboard</td>
</tr>
<tr>
<td>• Getting started with Instance Scan</td>
<td>• Getting started with checks</td>
<td>• Implement the Instance Scan dashboard</td>
</tr>
<tr>
<td></td>
<td>• Create a check</td>
<td>• Progress status of a scan</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Reviewing of scans</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Learn</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Execute a point scan</td>
<td>• Instance Scan table cleanup policies</td>
</tr>
<tr>
<td>• Execute a full scan</td>
<td>• Quota rules</td>
</tr>
<tr>
<td>• Schedule a full scan</td>
<td></td>
</tr>
<tr>
<td>• Execute a test scan</td>
<td></td>
</tr>
<tr>
<td>• Execute a suite scan</td>
<td></td>
</tr>
<tr>
<td>• Schedule a suite scan</td>
<td></td>
</tr>
</tbody>
</table>
Getting started with Instance Scan

If you are new to Instance Scan, read this overview to learn what the tool can do. Follow the tutorial to create checks and execute scans that uses most basics of Instance Scan features.

ℹ️ **Note:** Instance Scan doesn’t fully support domain separation. Findings are visibly domain separated based on the domain of the source record. For more information see Domain separation.

### Instance Scan record and components

#### Checks

Checks are singular focused rules that detect anomalies or opportunities in an instance. These checks can run against tables, records, or metadata. Checks are defined to identify security, upgrade best practices, manageability, user experience and performance vulnerabilities. See Getting started with checks for more information.

#### Results

A Instance Scan result reports the status and type of the scan. See Results for more information.

#### Findings

A finding is a reference to a record that has violated a rule from a check on the instance. See Findings for more information.

#### Dashboard

The Instance Scan dashboard is a system-wide visual representation of the health of your instance. The dashboard helps you manage and analyze the full scan results against your instance. See Instance Scan dashboard for more information.

#### Quota rule

A quota rule determines the execution threshold of a scan. Quota rule prevents the instance from running long scans. For example, any scan running longer than the threshold set by the quota rule will result in a failure. See Quota rules for more information.

### Scan types

Instance Scan deals with the following types of scans.

- **Full scan**
Execute a scan for the entire instance by clicking **Execute Full Scan**. Implementing a full scan runs all the active checks present in your instance.

**Point scan**

Execute all applicable checks against a single record, update set, or an application by selecting **Run Point Scan**. For example, if you execute a point scan against a business rule, only the checks that are applicable to the business rule table run, and only that single target record is scanned. If you execute an update set scan or an application scan, all records related to that update set or application are scanned. See **Execute an app scan** and **Execute an update set scan** for more information.

**Test scan**

Execute a test scan to verify if the check works as expected. The test scan enables you to test a single check instead of a full scan by selecting a single check and clicking **Test Check** on the Check form.

**Roles**

Instance Scan has the following roles.

- **scan_user**
  
  The scan_user role can run different types of scans and view the findings and results.

- **scan_admin**

  The scan_admin role has access to everything in the Instance Scan instance. It can also create and modify checks except the default ones.

**Getting started with checks**

Checks are singular focused rules that detect anomalies or opportunities in an instance. These checks can run against tables, records, or metadata. Checks are defined to identify security, upgrade best practices, manageability, user experience and performance vulnerabilities.

**Check types**

You can create your check by selecting one of these types.

- **Table Check**
Create a check by selecting Create a new Table Check if you know which specific table and conditions you want to test. This check type is applied on only one table at a time. You can also include your own script for more complex capabilities by selecting the Advanced option on the form.

Column Type Check
Retrieve all records containing a specific column field type from all tables in an instance by selecting Create a new Column Type Check. The Column Type Check type implements the rule you created to iterate all records matching the target column field type.

Script Only Check
Create a check without specifying a table or a column type by selecting Create a new Script Only Check. You can verify meta data, configurations, and execute complex checks by writing your own script.

Linter Check
Create a linter check to identify any issues in a script. When a linter check is run on a record, an abstract syntax tree for its code is generated. You can use the abstract syntax tree to analyze issues with the code.

Create a check
Create your own checks by implementing the following procedure.

Before you begin
Role required: scan_admin

Procedure
1. Navigate to Instance Scan > Checks.
2. Select New from the Checks context menu. The Check Interceptor list appears.
3. Select one of the available types of checks. See Check types, for more information.

Note: If you want to update an existing check, the Version field increments itself. The new version provides you a change history. You can also know which particular version of the check ran with a given scan.
Create a table type check

Create a check by selecting **Create a new Table Check** if you know which specific table and conditions you want to test. This check type is applied on only one table at a time. You can also include your own script for more complex capabilities by selecting the **Advanced** option on the form.

**Before you begin**

Role required: scan_admin

Before performing this task you must complete **Create a check**.

**Procedure**

1. Select **Create a new Table Check**.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the check record.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that has the check record.</td>
</tr>
<tr>
<td>Category</td>
<td>Category of the check record.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority at which the findings should be resolved.</td>
</tr>
<tr>
<td>Version</td>
<td>Current version of the check record.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate this check record.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Mandatory description about the check records.</td>
</tr>
<tr>
<td>Description</td>
<td>Additional information about the check records.</td>
</tr>
<tr>
<td>Resolution Details</td>
<td>Guideline to avoid check to go off against one or more tables.</td>
</tr>
<tr>
<td>Table</td>
<td>Table queried for this check.</td>
</tr>
</tbody>
</table>

**Note:** If you want to update an already existing check, the **Version** field increments itself.
<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditions</td>
<td>Conditions that filter records on a table. Only the records that meet the criteria are scanned.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Option to execute the defined script against each record that matches the condition and control when a finding is generated if Advanced is true. If Advanced is false, a finding is generated for every record that matches the condition in the defined table.</td>
</tr>
<tr>
<td>Documentation URL</td>
<td>Documentation link for the check details.</td>
</tr>
<tr>
<td>Note:</td>
<td>A scan_user can’t edit the Documentation URL field.</td>
</tr>
<tr>
<td>Run Condition</td>
<td>Boolean field that determines if the check should be run.</td>
</tr>
<tr>
<td>Table</td>
<td>Table from which records will be scanned</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions that determine which records will run</td>
</tr>
<tr>
<td>Script</td>
<td>The script that executes against each record that matches the condition in the defined table.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field shows up only if the Advanced check box is selected.</td>
</tr>
</tbody>
</table>

Create a column type check

Retrieve all records containing a specific column field type from all tables in an instance by selecting **Create a new Column Type Check**. The **Column Type Check** type implements the rule you created to iterate all records matching the target column field type.

**Before you begin**
Role required: scan_admin
Before performing this task you must complete Create a check.

Procedure
1. Select Create a new Column Type Check.
   A New record form appears.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the check record.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that has the check record.</td>
</tr>
<tr>
<td>Category</td>
<td>Category of the check record.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority at which the findings should be resolved.</td>
</tr>
<tr>
<td>Version</td>
<td>Current version of the check record.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate this check record.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Mandatory description about the check records.</td>
</tr>
<tr>
<td>Description</td>
<td>Additional information about the check records.</td>
</tr>
<tr>
<td>Resolution Details</td>
<td>Guideline to avoid check to go off against one or more tables.</td>
</tr>
<tr>
<td>Column Type</td>
<td>Column type queried for this check.</td>
</tr>
<tr>
<td>Documentation URL</td>
<td>Documentation link for the check details.</td>
</tr>
</tbody>
</table>

Note: If you want to update an already existing check, the Version field increments itself.

Note: A scan_user can't edit the Documentation URL field.
### Create a script only check

Create a check without specifying a table or a column type by selecting **Create a new Script Only Check**. You can verify meta data, configurations, and execute complex checks by writing your own script.

**Before you begin**

Role required: scan_admin

Before performing this task you must complete Create a check.

**About this task**

The script only check runs only during a full scan and executes only once during a scan.

**Procedure**

1. Select **Create a new Script Only Check** from the Check Interceptor list.
2. On this form, fill in the fields.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the check record.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that has the check record.</td>
</tr>
<tr>
<td>Category</td>
<td>Category of the check record.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority at which the findings should be resolved.</td>
</tr>
<tr>
<td>Version</td>
<td>Current version of the check record.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate this check record.</td>
</tr>
</tbody>
</table>

**Note:** If you want to update an already existing check, the **Version** field increments itself.
### Fields

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>Mandatory description about the check records.</td>
</tr>
<tr>
<td>Description</td>
<td>Additional information about the check records.</td>
</tr>
<tr>
<td>Resolution Details</td>
<td>Guideline to avoid check to go off against one or more tables.</td>
</tr>
<tr>
<td>Documentation URL</td>
<td>Documentation link for the check details.</td>
</tr>
</tbody>
</table>

**Note:** A scan_user can't edit the Documentation URL field.

<table>
<thead>
<tr>
<th>Run Condition</th>
<th>Boolean field that determines if the check should be run.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script</td>
<td>Option to write a custom script to generate findings.</td>
</tr>
</tbody>
</table>

---

## Create a linter check

Create a linter check to identify any issues in a script. When a linter check is run on a record, an abstract syntax tree for its code is generated. You can use the abstract syntax tree to analyze issues with the code.

### Before you begin

**Role required:** scan_admin

Before performing this task you must complete Create a check.

### Procedure

1. Select **Create a new Linter Check**.
2. On the form, fill in the fields.

### Linter Check form

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the check record.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that has the check record.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Category</td>
<td>Category of the check record.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority at which the findings should be resolved.</td>
</tr>
<tr>
<td>Version</td>
<td>Current version of the check record.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: If you want to update an already existing check, the Version field increments itself.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate this check record.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Mandatory description about the check records.</td>
</tr>
<tr>
<td>Description</td>
<td>Additional information about the check records.</td>
</tr>
<tr>
<td>Resolution Details</td>
<td>Guideline to avoid check to go off against one or more tables.</td>
</tr>
<tr>
<td>Documentation URL</td>
<td>Documentation link for the check details.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: A scan_user can't edit the Documentation URL field.</td>
</tr>
<tr>
<td>Run Condition</td>
<td>Boolean field that determines if the check should be run.</td>
</tr>
<tr>
<td>Script</td>
<td>The script that executes against each record that matches the condition. By default, this field has an engine object to use. This engine object contains other objects like engine.finding which you can call engine.finding.increment() to manually increment the Count field on that specific finding. Another object is engine.current which is the</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>current GlideRecord that the check would be viewing when running.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** This is new to Quebec release, where previously you would call `finding` and `current` directly.

### Advanced linter check scripts

Linter check scripts helps you in writing checks that look for issues in scripts. When a linter check is run on a record, it provides an abstract syntax tree for its code. You can use this abstract syntax tree to analyze issues with the code such as too many nested if statements or usages of slow API in a while loop.

### Linter check usage

Linter checks have a unique object to use called `rootNode`. This is the root node of the parsed abstract syntax tree (AST) for the script of the current record. This object has many functions, but the `visit` function is the most important. The `visit` function takes a callback function as a parameter which gets called on every node of the tree. The callback function then takes a node as a parameter which represents the current node during its iteration. You can return false from the callback function to stop iterating the tree early, otherwise it keeps visiting every subnode in the tree of the node you called `visit` on.

For example, if you want to scan for a deprecated API called `badFunction()`. You can write a Linter Check with a script in the following example:

```javascript
(function(engine) {
  engine.rootNode.visit(function(node) {
    if (node.getTypeName() === "NAME" &&
        node.getNameIdentifier() === "badFunction" &&
        node.getParent().getTypeName() === "CALL") {
      engine.finding.incrementWithNode(node);
    }
  });
})(engine);
```

When you run a scan with this Linter Check, it checks every record in the scan with a script field. For example, if a record in that scan has a script that looks like the following, the scan picks up a finding for this record.

```javascript
/*
badFunction()
*/
```
Node functions
The following is a list of available functions to call on the node object.

- `getRootNode()`: Get the root node of the tree for this node
- `getParent()`: Get the parent of this node
- `getLineNo()`: Get the line number location for this node
- `getColumnNo()`: Get the column number location for this node
- `toSource()`: Get the source for this node. The source is based on this node and its children
- `getTypeName()`: Get the node type name of this node. For example, a function call in source is tokenized as a node with the type name of "CALL"
- `getNameIdentifier()`: If the node type of this node is "NAME", then return the identifier, which is the string value of the name itself. A "NAME" node represents a simple name that is not a keyword, like a function name or a variable name.

ℹ️ Note: If this node is not a NAME node, then the result is null.
- `getAbsolutePosition()`: Get the absolute position of this node. The absolute position is the number of characters from the start of the script to this node
- `compareTo(other)`: Compare this node with another node. The node with a greater absolute position and length will be the larger in comparison. `other` is a node to compare with this node
- `visit(callbackFunction)`: Visit each node in the subtree starting from this node and execute the given callback function on each node. `callbackFunction` is a function that will be executed on each node in the subtree of this node. This
callback function takes a LinterCheckAstNode as a parameter which is will be the node being visited

- `debugPrint()`: Returns a string representation of the abstract syntax tree, starting from this node. Each line contains information about a node, and the indentation represents the hierarchy relationship between the nodes. The information in each line is arranged as follows
  1. Absolute position
  2. Node type name
  3. Position relative to parent
  4. Length
  5. Name identifier (if a NAME node)

For more information, see LinterCheckAstNode API - Scoped, Global.

**Suites management**

A suite is a collection of individual checks and suites that can be used for a scan. Suites can be created for specific business needs. All child suites are executed when a parent suite is used in a scan.

Navigate to **Instance Scan > Suites**. Select one of the suites from the list. Click **Execute Suite Scan** to run a suite scan. See **Execute a suite scan** for more information.
Note: Some ServiceNow provided suites are protected suites and the checks in the suite are not modifiable. For example, if you have a suite from the app store, the suite is unmodifiable.

Note: You can't add a child suite to the unmodifiable suite. But you can add a parent suite because it doesn't affect the suite.

Create a check suite
Create a check suite to bundle a group of checks into a suite and execute it.

Before you begin
Role required: admin

Procedure
1. Navigate to Instance Scan > Suites. A list of suites shows up.
2. Click New to create a new suite.
3. Fill up the details on the new suite record.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the suite</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of the suite</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate this suite</td>
</tr>
<tr>
<td>Description</td>
<td>Information about the suite</td>
</tr>
</tbody>
</table>

4. Click Submit to create a new check suite.

Note: The suites that you create are completely modifiable. You can modify the checks in the suite and can also add child and parent suites.

Execution and scheduling of scans
Execute the different kinds of scans that Instance Scan offers to keep a check on the health of your instance. You can also schedule a full scan so you can ensure the health of your instance even without an active session.

Note: Instance Scan scans only customized records, but point scan scans all records including the default records.
**Execute a point scan**

Execute all applicable checks against a single record, update set or an application by selecting **Run Point Scan**.

**Before you begin**
Role required: admin

**About this task**
For example, if you execute a point scan against a business rule, only the checks that are applicable to the business rule table run, and only that single target record is scanned. If an update set scan or an application scan is executed, all records related to that update set or application are scanned.

**Procedure**

1. Navigate to **Instance Scan > Checks**.
2. Navigate to the record in a table applicable for point scan.
   - **Note:** The **Run Point Scan** related link appears in the UI only for applicable records.
3. Scroll down to the **Related Links** section.
4. Click the **Run Point Scan** related links.
   - **Note:** The **Run Point Scan** related link is available only if all the following conditions are true.
     - Available checks that are applicable to the record
     - The user has read access to the record
     - The record is on a table that extends sys_metadata
     - The role of the user must be scan_user
     - The system property `glide.scan.enable_point_scan_ui_action` must not be false

   The progress tracker appears showing the status of the scan.

5. Click **Go to Result**.
   The Scan Result record appears.
6. Click **Checks** related list to look at the findings.
   If you want to review the failure reasons, click **Failures** related list.

**Results**
A scan of all applicable checks against only a single record is executed.
Execute an update set scan

Use update set scan to execute applicable checks against records that are affected by the update set.

Before you begin
Role required: admin

Procedure
1. Navigate to System Update Sets > Local Update Sets.
2. Select the desired update set from the list.
3. Click Scan Update Set from the Related Links list.

Execute an app scan

Scan the installed files of an application as well as the application record itself with applicable checks by executing an application scan.

Before you begin
Role required: admin

About this task
For example, if the application installs a business rule, checks that are relevant to sys_script table are executed against that business rule. To trigger an application scan, go to the record of the application you desire to scan and select Scan Application form link UI action.

Procedure
1. Navigate to System Application > All Available Applications > All.
   A list of all available applications and plugins appears.
2. Click the menu icon of the desired application.
3. Select Go to application option from the menu icon.
   
   Note: The Go to application option appears only if the selected application is not a plugin.
4. Click Scan Application to run app scan.

Execute a test scan

Execute a test scan to verify if the check works as expected. The test scan enables you to test a single check instead of a full scan by selecting a single check and clicking Test Check on the Check form.
**Before you begin**  
Role required: admin

**Procedure**

1. Navigate to **Instance Scan > Checks**.  
   A list of checks appears.

2. Open the check record you want to test from the list.

3. To start the test, click **Test Check**.  
The status of the scan appears in the progress tracker. The **Findings** module in the application navigator shows the number of records found from running the check test.

**Execute a full scan**

Execute a scan for the entire instance by clicking **Execute Full Scan**. Implementing a full scan runs all the active checks present in your instance.

**Before you begin**  
Role required: admin

**Procedure**

1. Navigate to **Instance Scan > Checks**.

2. To run all the active checks in your instance, click **Execute Full Scan**. The progress tracker shows the status of the scan.

![Execute Full Scan](image)

**Note:** Running of multiple full scans simultaneously is not allowed. If two or more checks overlap during full scan execution, only the first check succeeds. The first check keeps running while the other overlapping checks fail immediately.

3. To find the **Result Number** and the number of checks that ran as part of the full scan, click **Go to Result**.
4. Optional: From the related list click **Checks** to view the list of all the checks that ran as a part of the full scan.

5. Optional: From the related list click **Errors** to review the errors encountered during the full scan.

**Results**
A scan of the whole instance is executed.

**Schedule a full scan**
Create a schedule to regularly trigger a full scan even when you don’t have an active session. A schedule creates an established baseline for the health of the instance and provides a comparison to configuration and instance health over time.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **Instance Scan > Checks**.
2. Click **Schedule Full Scan**.
3. On the Trigger full scan form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the check record.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to execute the scan at a scheduled time.</td>
</tr>
<tr>
<td>Application</td>
<td>Application where the job belongs.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Option to select conditions under which the scan runs.</td>
</tr>
<tr>
<td>Run</td>
<td>List used to select the scheduling of full scan.</td>
</tr>
<tr>
<td>Run this script</td>
<td>Selection to run the default script.</td>
</tr>
<tr>
<td>Update</td>
<td>The script that is updated for full scan.</td>
</tr>
<tr>
<td>Execute Now</td>
<td>The default script that is executed for full scan.</td>
</tr>
</tbody>
</table>
4. To run the full scan click **Execute Now**.
   A list of findings is displayed.

5. From the application navigator, select **Results**.
   The status of the execution is displayed along with the **Result Number**.

6. To display the list of findings, select the **Result Number**.

7. **Optional:** From the application navigator, select **Dashboard** to display data about the findings.

**Results**
A schedule to trigger a full scan regularly even without an active session is created.

**Execute a suite scan**
Execute suites of available checks against a specific target to have targeted scan results by clicking **Execute Suite Scan**.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **Instance Scan > Suites**.
   A list of all suites displays.

2. Select one of the suites from the list.
   The form for the selected suite displays.

3. Click **Execute Suite Scan**.
   The **Scan Suites Now** modal displays.

4. Select a target for the scan.
• **Full Instance**: Scans all the available records in the instance.
• **Scoped App**: Scans selected scoped apps. You can select multiple scoped apps.
• **Update Set**: Scans multiple update sets.

5. Click **Execute Scan**.

⚠ **Note**: If a record is inactive, the checks don’t generate any findings for that record.

**Schedule a suite scan**

Create a schedule to regularly trigger a suite scan even when you don’t have an active session.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **Instance Scan > Suites**.
   A list of suites displays.
2. Select a suite from the list to schedule a suite scan.
3. Click **Schedule related list**.
   A list of scheduled scans displays.
4. Click **New** to create a schedule for the suite scan. The **Schedule Suite Scan** modal displays.

5. Select a target for the scan.
   - **Full Instance**: Scans all the available records in the instance.
   - **Scoped App**: Scans selected scoped apps. You can select multiple scoped apps.
   - **Update Set**: Scans multiple update sets.

6. Click **Schedule**

   ![Schedule Suite Scan modal](image)

   ![Scheduled Scan form](image)

   **Note**: If a record is inactive, the checks don’t generate any findings for that record.

   The **Scheduled Scan** form displays.

7. On the form, fill in the fields.

   **Linter Check form**

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the scheduled scan.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that has the record.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Combo</td>
<td>References a record which has a list of sources and a list of targets to run the scan against.</td>
</tr>
</tbody>
</table>
| Run | Frequency at which the scan should be scheduled to run.  
  • Daily: Scan is scheduled to run daily.  
  ◦ Time: The time at which the scan is scheduled to start daily.  
  • Weekly: Scan is scheduled to run weekly.  
  ◦ Day: The day in the week on which the scan is scheduled to start weekly.  
  ◦ Time: The time at which the scan is scheduled to start.  
  • Monthly: Scan is scheduled to run monthly.  
  ◦ Day: The day in the month on which the scan is scheduled to start monthly.  
  ◦ Time: The time at which the scan is scheduled to start.  
  • Periodically: Scan is scheduled to run periodically.  
  ◦ Starting: Date and time at which the scan is scheduled to start.  
  ◦ Repeat interval: Date and time at which the scan has been scheduled to repeat.  
  • Once: Date and time at which the scan is scheduled to start.  
  • On Demand: Scan is not scheduled to run and runs only manually when **On Demand** option is chosen for the **Run** field. |
### Fields | Description
---|---
Business Calendar | Business calendar time of the user to schedule the scan run either at the beginning of that period or at the end, depending on their selection.
Active | Option to activate the record.
Conditional | Option to write your own script condition, which is always verified before scheduled scan runs.
Run as | User role used to run the scan.
Run as tz | Timezone used to run the scan.

8. Click **Submit**. The scan that has been scheduled displays under Schedule related list.

### Progress status of a scan
You can check the progress status of a scan by checking the progress tracker.

**Before you begin**
Role required: admin

**Procedure**

1. Navigate to Instance Scan > Checks. A list of checks appears.
2. Run the required scan. The progress tracker displays the status of the scan run. You can close the progress tracker and view it later without having to stay in the modal for the execution to complete. To see the status later, go to **Results** in the application navigator. Select the required scan results record to review its status.
3. To see the status of the scan, click **Go to Result**. If the scan completes, a list of findings is displayed. You can also find all the checks that ran as a part of the scan by clicking the Checks related list. If any of the checks fails, click Failures related list to review them. If the full scan takes some time to complete, you can check the status by selecting **Results** from the application navigator.
Execute a reactive scan

Execute a reactive scan to set up a scan that runs automatically on an execution tracker failure.

Before you begin
Role required: admin

About this task
For many failed processes on your instance, you can find a corresponding record on the execution tracker. The progress window shows the status of the test. If a process fails on an execution tracker, Instance Scan can watch for that failure on the progress status and run a scan automatically.
The **Trigger Type** in the Scan Trigger form should match the **Source Table** field on the sys_execution_tracker record of the failed process to enable the connection between the two. For example, if the failed test is in the Update Sets list, you can set up the **Trigger Type** as sys_update_set. This enables Instance Scan to be connected to the execution tracker test failure.

Procedure

1. Enter scan_trigger_list.do in the left navigation window.
   A list of scan triggers shows up.
2. Select the required trigger from the list to update it.

   Note: The **Trigger Type** is based out of table names. You can also create a custom trigger type in your codes.

![Scan Trigger](image)

The reactive scan is now set up to automatically scan the execution tracker of the failed process which appears on the scan results table.
Reviewing of scans

After the scans have been executed, you can review them with the findings and results components.

- **Results**: An Instance Scan result reports the status and type of scan. You can also see all the checks that ran as part of the scan and all other information related to the scan such as errors and scan logs. Use Scan Results dashboard to get detailed information about an executed scan.

- **Findings**: A finding is a reference to a record that has violated a check which was used in a scan. You can also mute a finding if you don’t want a finding to be reported in the next scan.

**Results**

An Instance Scan result reports the status and type of scan. You can also see all the checks that ran as part of the scan and all other information related to the scan such as errors and scan logs.

On clicking Go to Result from the progress tracker of a scan, the Scan Result is identified by a Result Number. Click Results Dashboard to view the scan results.

The Scan Type field states the type of scan that was executed. The Status field shows the status of the scan which can either be In progress, Complete or Failed. The Execution Time field shows the duration of the scan in milliseconds.

There are the following related lists in the Scan Result form.

- **Scan Findings**: The Scan Findings related list shows up all the findings encountered during the execution of the checks.

- **Suites**: The Suites related list shows up all the suites that ran as part of the scan.

- **Checks**: The Check related list shows all the checks that ran as part of the scan.

- **Failures**: The Failures related list shows all the checks that failed during the execution of the scan. It also shows up the reason of its failure in the form of an error message.

- **Scan Log**
The Scan Log related list shows up messages encountered during the entire scan.

**Scan Statistics**

The Scan Statistics related list shows up

**Target**

The Target related list shows all the targets against which the checks have executed.

**Scan results**

Scan Results dashboard helps you with an overview of all details of an executed scan.

Navigate to **Instance Scan > Results**. Select a scan result from the Scan Results list. Click Results Dashboard link on the Scan Result form.
Click **Rescan** to execute the same scan again. If you want to see all the findings grouped by checks, click **Findings** at the top right corner.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous Scan</td>
<td>Details about the previous scan.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Result number:</td>
<td>Link to the previous scan result record</td>
</tr>
<tr>
<td>• Outstanding</td>
<td>Findings: Total findings whose status has not been marked as Resolved.</td>
</tr>
<tr>
<td>• Resolved Findings</td>
<td>Total findings whose status has been marked as Resolved.</td>
</tr>
</tbody>
</table>

⚠️ **Note:** Not all findings that have been marked Resolved are fixed. If a finding has not been fixed and has been marked Resolved, it still adds to the count of total findings.

• Date: Date and time on which the previous scan started

• Duration: Total time needed to complete the previous scan

<table>
<thead>
<tr>
<th>Latest Scan</th>
<th>Details about the recent completed scan.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Result number:</td>
<td>Link to the latest scan result record</td>
</tr>
<tr>
<td>• Findings:</td>
<td>Total number of findings found in the latest scan</td>
</tr>
<tr>
<td>• Target:</td>
<td>Target against which the scan is executed</td>
</tr>
<tr>
<td>◦ Full Instance:</td>
<td>Scans all the available records in the instance</td>
</tr>
<tr>
<td>◦ Scoped App:</td>
<td>Scans selected scoped apps. You can select multiple scoped apps.</td>
</tr>
<tr>
<td>◦ Update Set:</td>
<td>Scans multiple update sets.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Date</td>
<td>• Date: Date and time on which the scan started</td>
</tr>
<tr>
<td></td>
<td>• Duration: Total time needed to complete the scan</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The states come from the states of the tasks associated with the findings.</td>
</tr>
<tr>
<td>Scan Tasks By Priority</td>
<td>Scan tasks sorted by priority. The priority comes from the checks to which these tasks belong.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The states come from the states of the tasks associated with the findings.</td>
</tr>
<tr>
<td>Average Findings Over Time</td>
<td>Reporting of the average number of findings in a day.</td>
</tr>
<tr>
<td>Category Breakdown</td>
<td>Category breakdown of the checks that have run as part of the scan</td>
</tr>
<tr>
<td>Product Breakdown</td>
<td>Product family of each of the scan findings records.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Incident records don't have product family.</td>
</tr>
<tr>
<td>Findings By Developer</td>
<td>Name of the user whose changes generated the findings.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Only the top 5 user names appear on the list. Click <strong>View All</strong> to view all the findings grouped by users.</td>
</tr>
</tbody>
</table>

If a scan is in progress and at least one of the checks fails, the following warning message shows up.

⚠️ You are viewing the results of a failed scan. Click **here** to review the details.

**Findings**

A finding is a reference to a record that has violated a rule from a check on the instance. You can find the source record and the number of times the record triggered rules of a given check.
Each finding is specific to a result and each result is specific to a scan that has been executed.

**Note:** When you run a scan, you definitely get a result of the scan but might not get any findings. There might be no findings encountered during the execution of the checks.

**Note:** If a record is inactive, the checks don't generate any findings for that record.

The Scan Finding gives information about the check that has been violated by a record. The **Source Table** and **Source** fields point to the record that has violated a rule from a check during the execution. You can find more information about the record by clicking the information icon. The **Count** field shows the number of times the record has violated the check rules. The finding also shows the version of the check that generated the finding. The **Product Family** field shows you the product family for each check. The **Task** field helps you to assign a task to an individual or a group. See [Creating scan tasks](#) for more information. If you want to avoid a finding from being generated from any future scans, use the **Mute Rule**.

**Note:** If you use the **Mute Rule**, you must also select a reason for muting the finding.

**Mute a finding**

Mute a finding on the Scan Finding form to avoid the finding from being reported in the later scan results.

**Before you begin**
Role required: admin

**Procedure**

1. Navigate to **Instance Scan > Results**. A list of Scan Results shows up.
2. Select the scan result you ran from the list. The Scan Result form for the scan shows up.
3. Select the Scan Findings related list. A list of findings for the scan shows up.
4. Use the information icon to open the finding you want to mute.
5. Click **Mute** to avoid the finding from being reported in the next scan.
Note: The Select Mute Reason modal shows up only if you click Mute on the Scan Finding form.

6. Select the reason for muting the finding and then click Mute on the modal.

Note: Click Unmute if you want the finding to be reported in the later scans. The Unmute button is visible only when you have muted a finding.

Creating scan tasks
Create a scan task to facilitate task assignments from the finding of a record.

Before you begin
Role required: scan_user

Procedure
1. In the navigation filter, enter scan_task_list.do.
2. Click New to create a new scan task.
   The Scan Task form appears.
3. Fill in the following fields in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Auto-generated task number</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Person responsible to work on the task</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group responsible to work on the task</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate task</td>
</tr>
<tr>
<td>State</td>
<td>State of the task.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• New</td>
<td></td>
</tr>
<tr>
<td>• In Progress</td>
<td></td>
</tr>
<tr>
<td>• On Hold</td>
<td></td>
</tr>
<tr>
<td>• Resolved</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Short description</th>
<th>Brief description about the task</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Description</th>
<th>Additional information about the task</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Work notes</th>
<th>Additional notes</th>
</tr>
</thead>
</table>

**Note:** The scan_user can assign the task only to a non-scan_user. The user to which the task has been assigned also gets the same privilege as the scan_user.

### Instance Scan dashboard

The Instance Scan dashboard is a system wide visual representation of the health of your instance. The dashboard helps you to manage and analyze the results of full scan against your instance.

The dashboard offers several options to filter your search results to find the exact check finding that might be causing some issues. The **Instance Scan Category** is the filter picker that shows all the categories of all the checks that were scanned. You can select the type of scan category that you want the dashboard to display as a part of the scan results. **Instance Scan Priority** helps you to select the priority level of the results to decide which scan results must be addressed first. This priority level is often referred to as the rating level of the scans.
Note: The dashboard is only applicable for full scans. The **Instance Scan Category** is only available if you have data or a finding in the result set that are applicable to the categories.

For example, you can use the dashboard to compare the results of the check findings. If you see a sudden change in the number of check findings, select the particular scan result from the Scan Results List.

You can review all the findings for the scan that generated an unexpected number of findings. This list displays all the findings that are related to one or more of all the scans.
You can also directly select the column with the required findings to display the related list for a particular scan.

The list also indicates the source from which the finding has been retrieved. You can export the list view data to an external source such as a .csv file or an .xlsx file for further performance comparison and analysis.

**Implement the Instance Scan dashboard**

Compare and analyze the results of the scans in your instance by representing it on the premium Performance Analytics (PA) dashboard.

**Before you begin**
You’ve created some checks to execute the full scan. See Create a check and Execute a full scan for more information.

Role required: admin.

**Procedure**

1. Navigate to **Instance Scan > Dashboard**.
2. Select an option from the **Instance Scan Category** or **Instance Scan Priority** list.

   **Note:** The dashboard is applicable only for full scans. The **Instance Scan Category** appears only if you have data or a finding in the result set that are applicable to the categories.

3. Select the scan result from the Scan Results list that generates an unexpected number of check findings.
   A related list of findings related to only that scan is expanded.
4. Optional: Select the scan column directly from the dashboard to display the related list of checks.
The related list of checks appears. The list also indicates the source that the finding has been retrieved from.

**Results**

A dashboard showing the results of scans is created.

**Instance Scan table cleanup policies**

Instance Scan offers table cleanup policies to erase previous scan results. The cleanup policies are based on the time that the scans are created. The timer starts when you run a scan. **Table Cleanup** is run against the Auto Flushes [sys_auto_flush] table and cleans up the previous scan results.

- If the result records are older than 90 days (**7,776,000** seconds), the first policy clears all scan result records and related records.
- If the following conditions are true, the second policy deletes all scan result records and related records.
  - The **Scan type** is **Test Scan**.
  - The records are older than 14 days, and **Age in seconds** is equal to or greater than **1,209,600** seconds.
You can also modify these policies by entering any customized time period. See Customize table cleanup policies, for more information.

**Customize table cleanup policies**

Clean up previous scan results at a regular interval by customizing the table cleanup time period.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **Instance Scan > Table Cleanup**.
2. Select one of the cleanup policies from the Auto Flushes list.
3. Customize the **Age in seconds** field as required.
4. To save the customized table cleanup policy, click **Update**.

**Timeout threshold**

A timeout determines the execution threshold of a scan from running long scans. For example, any scan running longer than the set time period results in a failure. If the scan or the check takes longer than the set time period set by the quota rule, an error message appears.

ℹ️ **Note:** By default the scans are limited to three hours and individual checks are limited to 10 minutes.

To learn how to configure these thresholds, see Implement a scan timeout threshold and Implement a check timeout threshold.

**Implement a scan timeout threshold**

Set the execution time of a single scan by implementing **Transaction Quota Rules**. Setting of a quota rule prevents your instance from running a long scan.
Before you begin
Role required: admin

Procedure
2. To set a definite execution time, select Scan timeout.
3. Enter the definite execution time in the Maximum Duration (seconds) field and click Update.

⚠️ Note: The minimum allowed timeout threshold is 5 seconds. If you set the timeout to anything less than 5 seconds, the system still considers it to be 5 seconds. By default, it has been set to 10,800 seconds.

The scan fails if the execution time exceeds the set timeout. For more information on the type of scan you want to run, see Execution and scheduling of scans for more information on the type of scan you want to run.

Implement a check timeout threshold
Set the execution time of an individual check by implementing timeout system property. Setting of a timeout threshold prevents your instance from running a long check.

Before you begin
Role required: admin

Procedure
1. In the navigation filter, enter sys_properties.list.
2. From the System Properties list, select glide.scan.process_check.time_out.

⚠️ Note: If glide.scan.process_check.time_out is not present in the list, see Create a new check timeout system property for more information.
3. In the Value field, set the execution time for the check in seconds.

⚠️ Note: The minimum allowed timeout threshold is 5 seconds. If you set the timeout to anything less than 5 seconds, the system still considers it to be 5 seconds. By default, it has been set to 10,800 seconds.

Results
A timeout threshold for a check is set by the user. Individual checks will be cancelled after the set time threshold exceeds.
Create a new check timeout system property

Create a new timeout threshold property for a check if the `glide.scan.process_check.time_out` system property is not present. Setting of a timeout threshold prevents your instance from running a long check.

Procedure

1. In the navigation filter, enter `sys_properties.list`.
2. Click **New** to create a new timeout system property.
3. In the **Name** field, enter `glide.scan.process_check.time_out`.
4. In the **Value** field, enter the check execution time in seconds.

   ✪ **Note:** The minimum allowed timeout threshold is 5 seconds. If you set the timeout to anything less than 5 seconds, the system still considers it to be 5 seconds. By default, it has been set to 10,800 seconds.

HTTP Response Headers

A response header is a simple name-value pair used in an HTTP response to provide additional information about page content or how the client should process it.

You can configure HTTP response headers for all, or specific types of pages, which include Service Portal, UI Page, or UX applications. The ability to configure and pass response headers enables special handling of the page content by a client, most typically a browser.

To learn more about what an HTTP header is, and about configuring the name-value pair for specific HTTP response headers, see:

- Configure HTTP response headers

When configuring response headers, you must look at the definition for the HTTP header to determine how the client would handle the page content.
• For example, you configure an HTTP header for a specific page or all the pages with a Content-Security-Policy: frame-ancestors ‘self’ https://www.servicenow.com.

• When you invoke the page in a browser such as Chrome, you can review it in the Response Headers section of Chrome Developer Tools.

To learn more about how browsers handle a page with frame-ancestors, see https://developer.mozilla.org/en-US/docs/Web/HTTP/Headers/Content-Security-Policy/frame-ancestors.

⚠️ **Warning:** When using URLs with custom name-value pairs, proceed with caution because there is a potential security risk when doing so. The signed security amendment to the Now Platform contract has implied security. You may potentially or accidentally override it when you use custom name-value pairs in the resulting URLs.

• If you want to entirely disable HTTP response header configuration functions, set the `glide.http.headers_config.enabled` property to `false`.

• Once you set it to false, Now Platform does not use any of the header configurations you defined in the `sys_response_header` table.

**Special handling of the Content-Security-Policy: frame-ancestor header**

Normally, the Now Platform automatically includes the X-Frame-Options: SAMEORIGIN header.

• It supports use of this header in all types of browsers, based on the setting of the `glide.set_x_frame_options` global property, which is enabled by default.

• When you configure a page with a Content-Security-Policy: frame-ancestor ‘self’ URL1 URL2 header, the Now Platform does not automatically include
the X-Frame-Options: SAMEORIGIN header. Excluding it prevents the browser from being confused, because Content-Security-Policy: frame-ancestor 'self' already has a similar effect.

**Special handling of Content-Security-Policy: frame-ancestor header for Internet Explorer**

Using the Content-Security-Policy: frame-ancestor 'self' URL1 URL2 header enables you to configure multiple URL sources to include the page from within an iFrame rendered from a third-party site. However, Internet Explorer does not support this type of header.

- Instead, the Internet Explorer only supports the X-Frame-Options: ALLOW-FROM URL (ALLOW-FROM) directive in this header, although the restriction is for a single host URL.
- If you configure the frame-ancestor 'self' URL1 URL2 header, and Internet Explorer is in use, the Now Platform automatically uses the X-Frame-Options: ALLOW-FROM URL (ALLOW-FROM) header instead.

If the Internet Explorer request includes the referrer URL header:

- It attempts to match it with the host URLs (full or wildcard http://*.example.com type URL format only) configured in the Content-Security-Policy: frame-ancestor 'self' URL1 URL2 header.
- If there is a match, include the matched URL as X-Frame-Options: ALLOW-FROM URL1.
- If there is no referrer header, it uses the first non-wildcard based host URLs configured in the Content-Security-Policy: frame-ancestor 'self' URL1 URL2 header.

**Note:** When configuring URLs, do not include a forward slash at the end of the URL.

- This example of an incorrect configuration that may not work properly with this special handling:
  
  Name: Content-Security-Policy
  
  Value: frame-ancestors 'self' https://microsoft.com/

- Use this correct syntax instead:
  
  Name: Content-Security-Policy
  
  Value: frame-ancestors 'self' https://microsoft.com
Related information

- Control request and response content type
- Cache-Control HTTP header value
- Content-Security-Policy: frame-ancestor 'self' URL1 URL2
- X-Frame-Options: SAMEORIGIN
- X-Frame-Options: ALLOW-FROM URL

Configure HTTP response headers

Configure standard name-value pairs for HTTP response headers. You designate if the configuration applies to all pages, or to specific types (Service Portal, UI Page, or UX application record).

Before you begin
Role required: An elevated access security_admin role is required to configure an All Pages type header. An admin role is required to configure a Specific Type header.

Procedure

1. In the Navigator pane, type sys_response_header.list.
2. Click New.
3. Fill in the fields on the form.

<table>
<thead>
<tr>
<th>HTTP Response Header</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check box that designates that this HTTP response header configuration is active.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for this record.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Type of record the HTTP response header configuration applies to.</td>
</tr>
<tr>
<td>Specific Type</td>
<td>HTTP response header configuration is for the specific type and record you select in the Type and Record fields.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>All Pages</strong></td>
<td>HTTP response header configuration is for all pages and record types.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Only users with an elevated access privilege security_admin role can configure HTTP response headers for the All Pages type header.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of record the HTTP response header configuration applies to.</td>
</tr>
<tr>
<td><strong>Service Portal [sp_portal]</strong></td>
<td>Records related to the Service Portal.</td>
</tr>
<tr>
<td><strong>UX Application [sys_ux_page_registry]</strong></td>
<td>Standard UX applications in the Now Platform.</td>
</tr>
<tr>
<td>Record</td>
<td>Specific record the HTTP response header configuration applies to. To select a record:</td>
</tr>
<tr>
<td><strong>a.</strong></td>
<td>Click the Search (🔍) icon to access the Select the document form.</td>
</tr>
<tr>
<td><strong>b.</strong></td>
<td>In the Table name field, the default is the type you selected in the Type field. Do not change it.</td>
</tr>
<tr>
<td><strong>c.</strong></td>
<td>In the Document field, select the record from the table.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Name | Name you want to assign to the name-value pair for the HTTP response header.
Value | Value you want to assign to the name-value pair for the HTTP response header.
Description | Detailed description for the HTTP response header.

**d. Click OK.**

You can only access this field if you selected **Specific Type** in the **Applies to** field.

4. **Click Submit.**

**HTTP header configuration for advanced users**

The HTTP response header table (sys_response_header) in the List view contains two additional columns - **Add by** and **Order**.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
</table>
| Order | Adds a default integer order value to a header configuration regardless of the type of header (**All Pages** or a **Specific page**).  
  - When a specific page request takes place, both of the header types are interleaved based on the **Order**.  
  - The net headers, regardless of the type, are sorted first, based on the **Order** and added to the response based on the ordered header list.  
| Add By | Contains the following values:
### Column Description

<table>
<thead>
<tr>
<th>Append</th>
<th>(Default value) This option is relevant when multiple headers with the same name are configured. In this case, they are both added to the HTTP response header.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overwrite</td>
<td>This option is relevant when the same header (a header with the same name) is attempting to add twice in the ordered header list (see Order description). The header with the higher order and with an Overwrite selection in Add By overwrites the same header trying to be set with a lower order.</td>
</tr>
</tbody>
</table>

You may have situations where a couple of similar All Pages type header configurations could overwrite a Specific Type type header configuration. An example of a Specific Type configuration would be one for a specific UI page. You can remedy this situation by adjusting the Add by and Order columns, as in the following examples.

### Append example

The Now Platform is trying to set headers in the following order, and Append is the default value for each in the Add By column.

In this example, the second (Header 2) and third (Header 3) response header configurations have the same name (Content-Security-Policy). In this case,
Header 3 is appended to Header 2. If a request is made for a specific page you configured with a Header 3 response, the net HTTP response headers are both Header 2 and Header 3.

Overwrite

The Now Platform is trying to set headers in the following order, and you've selected Overwrite in the Add By column for the third header.

In this example, the second (Header 2) and third (Header 3) response header configurations have the same name (Content-Security-Policy). In this case, Header 3 overwrites Header 2. If a request is made for a specific page you configured with a Header 3 response, the net HTTP response header is only Header 3.
Instance Data Replication

ServiceNow® Instance Data Replication (IDR) copies data updates from one instance, called the producer instance, to one or more other instances called the consumer instances. IDR enables you to maintain consistent data across different organizations in your company.

IDR provides a one-to-many replication, which enables one instance to propagate data across different departments and business units to keep data synchronized. With IDR, you can also modify data during replication. For example, you could localize the data during replication.

IDR also supports bidirectional replication. Bidirectional replication enables you to copy data from a producer instance to a consumer instance and from a consumer instance back to the producer instance.

Watch this video to learn how to set up IDR between multiple instances on the Now Platform. Create an Instance Data Replication.

Benefits

• Data is automatically replicated to one or more other instances.

• Data can be modified and mapped to any table and table column on other instances. For example, you can modify and map table columns to localize data for different locales.

• Data that is updated on consumer instances can be replicated to the producer instance.

Data, such as problem requests, can be copied to consumer instances for third parties to use. The third party can update the problem issue on the consumer instance. The data can then be updated on the producer instance.
• Business rules can trigger post-replication workflows, such as generating notifications or validating the replication.

• Data that is in transit during a crash is recoverable.

How Instance Data Replication works

You use the Instance Data Replication plugin (com.glide.idr) to replicate data updates on one instance, called the producer instance, to one or more other instances, called the consumer instances.

By configuring a producer replication set, you can specify the tables and table columns on the producer instance to replicate. When you configure a consumer data set, you can specify the tables and table columns on the consumer instances that receive the producer replication set data.

Next, you activate both producer and consumer replication sets to turn on the IDR functionality. The data that is updated in a producer replication set automatically updates the corresponding data in the consumer replication sets.

Syncing the producer and consumer replication sets requires that you do a one-time download (called seeding) of all the producer replication set data to the consumer instances.

You can initiate seeding requests on a consumer instance when you activate a consumer replication set. Beginning with the Rome release, you can use a filter criterion feature (called partial seeding) to restrict the number of records that are seeded. Use partial seeding to divide large jobs into smaller jobs when you have a large number of records to duplicate.

After seeding, replication involves data updates only. An audit trail contains a history of those record updates.

By default, the table data on a producer instance goes into the tables of the same name on consumer instances. Transformation is the process of replicating producer data in tables or table columns that have a different name on the consumer instances.

IDR adapters modify data before storing it on consumer instances. Adapters perform string and mathematical operations, such as converting one currency to another, or converting one time zone to another.
IDR overview

⚠️ Warning: IDR overwrites data on instances and can replicate sensitive data. Avoid potential data loss and data exposure, by testing your IDR implementation in a pre-production environment. See data privacy in IDR for more information.

Domain separation

IDR runs in ServiceNow datacenters only. It functions at the data level so IDR does not explicitly support domain separation. For a typical use case, data moves from a producer instance to a consumer instance and back without regard to which domain the instance is in. You can use IDR to filter data, enabling you to segregate specific data between instances. IDR does not support domain separation. If you must go beyond the IDR record-level filtering capability, you can use business rules to convert data from one domain to another. For more information, see Before Query business rules.

Producer and consumer instance data replication delays

After IDR has been set up on the producer instance, the IDRProducerJob job runs on producer instances to detect data updates. When there are updates to replicate, the producer instance sends the updates to consumer instances.

The IDRConsumerJob job runs on the consumer instances to detect the data updates from a producer. When the IDRConsumerJob job detects updates, it updates the data in consumer tables.
It takes some time for the data updates in a producer replication set to appear in consumer replication sets. You can look on the monitoring dashboard to see how long data updates take from a producer replication set to consumer replication sets. Look at the queue dashboard to see the replication record queue, message queue, and messages processed for all replications sets.

If you have significant data delays, contact Customer Service and Support.

**IDR limitations and when not to use IDR**

- Do not use IDR to clone instances.

  IDR does not replicate metadata tables, child metadata tables, and most user and system tables. IDR is designed to replicate data, not to clone instances.

- IDR seeding limitations:
  - Replication seeding must not take longer than seven days to complete.
  - Initial seeding of the tables must not exceed 3 million records per replication set.

перед

**Note:** To overcome these limitations, reduce the number of tables in the seeding request, reduce the size of the records, or use partial seeding.

**Request an Instance Data Replication (IDR) subscription**

The IDR plugin requires a separate subscription and must be activated by ServiceNow personnel.

**Before you begin**

Role required: admin
About this task

IDR is supported in the New York and later releases. The IDR plugin ID is com.glide.idr. When purchasing an IDR subscription, ServiceNow personnel also activate the following plugins that IDR depends upon:

- com.snc.db.data_replicate
- com.glide.transform
- com.glide.kmf

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization's production and subproduction instances, generally within a few days.

If you don’t have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps.

Procedure

1. Navigate to System Applications > All Available Applications > All.

2. On the All Applications page, click Request Plugin to open the Request form on HI.

3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.
4. On the form, fill in the fields.

**Activate Plugin request form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the <em>Reason/Comments</em> field.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**What to do next**

Create and activate a producer replication set.

**Related information**
Set up Instance Data Replication (IDR)

Determine which instance will be your producer instance, configure producer replication sets with consumer instances, and then modify records or mappings as necessary.

Before you begin
Role required: admin, idr_admin

Procedure
1. Request that ServiceNow install the IDR plugin.
2. Create a producer replication set.
   The producer replication set specifies the tables and table columns to replicate to one or more consumer instances.
3. Create one or more consumer replication sets and request data from the producer instance.
   A consumer replication set specifies the tables and table columns on consumer instances that receive producer data updates. The replicated data overwrites the corresponding consumer instance data. Consumers must initiate a request to the producer instance before they receive the replication data.
4. Approve the consumer replication set request.
   The producer instance must approve the request from the consumer instance to access replication data.
5. Optional: Map replicated data into different tables or table columns on consumer instances.
6. Optional: Modify records during replication.
   As an example, you might change time zone or currency records to make them appropriate for a different geographic region.
7. Optional: Set up bi-directional replication.
   (Optional) Bidirectional replication enables data to flow from a producer instance to a consumer instance and accept data from a consumer instance to flow back to the producer instance.
8. Set up discrete mapping.
   Adding discrete mapping to producer replication sets enables different consumer replications to be distinguishable.
Create a producer replication set in Instance Data Replication

A producer replication set specifies the tables and table columns to replicate on consumer instances. Creating the producer replication set is the first step of setting up Instance Data Replication.

Before you begin

- Verify that the producer and consumer instances belong to the same customer.
- Role required: idr_admin or admin

About this task

Seeding is the initial download of all the records in the producer replication set to the tables in the consumer replication set. After seeding, Instance Data Replication (IDR) only replicates data updates. The seeding limitations are:

- The maximum record size is 32 MB.
- The maximum seeding size is 3 million records.

Note: If your replication set contains more than 3 million records, seeding cannot start. To fix this situation, break the replication set into multiple replication sets with fewer records in each or use partial seeding.

- The maximum seeding time is 7 days.
Procedure

1. On the producer instance, navigate to **Instance Data Replication > Producer Replication Sets** and click **New**.
2. On the form, fill in the fields.

### Producer Replication Set form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Names can only contain alphanumeric characters and hyphens.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The consumer replication set must have the same name as the producer replication set, so the name should not be producer-specific.</td>
</tr>
<tr>
<td>Bi-Directional</td>
<td>Option to enable bi-directional replication on consumer instances. Bi-directional replication enables changes to records made on the consumer instance to propagate to the producer instance. If you want to set up a producer replication set with bi-direction for consumer instances, see <strong>Bidirectional replication</strong>.</td>
</tr>
<tr>
<td>Discrete</td>
<td>Option to enable discrete mapping from a producer replication set. This mapping distinguishes different consumer instances. For more information, see <strong>create discrete mappings for a producer replication set</strong>.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the replication set.</td>
</tr>
<tr>
<td>Entry Set</td>
<td>Set of outbound entries. If you imported an update set from another instance or you created one earlier on your instance, you can choose an existing entry set.</td>
</tr>
</tbody>
</table>
After you submit the Producer Replication Set form, the system auto-generates the producer ID. The **Producer ID** field identifies the producer instance in the system.

3. To add outbound entries to your producer replication set, click the **Outbound Entries** tab and click **New**.

4. On the form, fill in the fields.
   For each outbound entry, you must select a source table from the producer instance to replicate data records. You can also select associated table columns, include attachments to records, and set filter conditions for each source table.
Replication entry form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Table</td>
<td>Name of one of the tables on the producer instance to replicate. For example, .NET Application [cmdb_ci_dot_net].</td>
</tr>
<tr>
<td>Name</td>
<td>Filter criteria to control the records in the table that are being replicated. In the Filter section, click Add Filter Condition. For example, you might want to replicate only active records. In that case, select Active from the choose field list, Is from the oper list, and True from the value list. If you do not use a filter, all the fields in the producer replication set table appear in the Available column.</td>
</tr>
<tr>
<td>Include</td>
<td>Attachments Option to replicate the files associated with the records that you are replicating.</td>
</tr>
<tr>
<td>Included Fields</td>
<td>Fields to include. Move table fields into the Selected column to replicate them or into the Available column to prevent replicating them.</td>
</tr>
</tbody>
</table>

Note: The Available column contains the fields in the Source Table that you specified. That table might not contain the Active field.

Note: The system must replicate some fields, such as sys_id (Mandatory). The system cannot replicate some fields, such as Edge Encrypted and Password1. They do not appear in either column.

5. Click Submit.

Note: If the table that you add to the replication set has child tables, add the child tables to the replication set to maintain data integrity.

6. Repeat step 3 for each table that you want to include in the replication set. After you submit, the Activate button is added to the form.

7. Click Activate.

Replication can't happen until you link the producer replication set to one or more consumer replication sets. Activating the producer replication set makes the producer data available for replication to consumers.
8. Click the **Notification Configuration** related link and choose a tab to configure notification details:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When to send</td>
<td>Specify the conditions for sending a notification.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Record inserted or updated</strong>—You can send notifications when records are updated or inserted.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Event is fired</strong>—Specify the event type that sends the notification.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Triggered</strong>—A notification is sent when triggered by a ServiceNow® Flow Designer flow. For more information, see <a href="#">Flow Designer</a>.</td>
</tr>
<tr>
<td>Who will receive</td>
<td>Send notifications to users, groups, or user groups in fields on the ServiceNow record that generate the notification.</td>
</tr>
<tr>
<td>What it will contain</td>
<td>You can choose an email template to populate the Subject and Message HTML. You can also override the template and customize text as appropriate.</td>
</tr>
<tr>
<td>What Digest will contain</td>
<td>If you select Allow Digest, you can configure an email digest interval through the Digest Interval module in System Notification.</td>
</tr>
</tbody>
</table>

9. Click **Update**.

10. To see a preview of the notification, click **Preview Notification**.

11. To discard the Producer Replication Set, click **Delete**.

**Results**

The producer is ready to send the data that is specified in the replication set to one or more consumer instances.
What to do next

- Create and activate a consumer replication set.
- Grant access to replication data.

After creating a consumer replication set, you must ask for permission to receive the producer replication data. See Grant access to replication data to see how to grant or deny access.

- If you believe that a consumer set should no longer receive replication data, you can revoke the consumer set access.

Create a consumer replication set for Instance Data Replication

You can use a consumer replication set to specify the tables and columns on a consumer instance that receives the producer data. Creating the consumer replication set is the second step of setting up Instance Data Replication (IDR).

Before you begin

- Create and activate a producer replication set.
- Make sure that the producer and consumer instances are in the same geographic region and belong to the same customer.
- Role required: idr_admin or admin

About this task

Create a consumer replication set and link it to a producer replication set. IDR replicates data from the producer to the tables and table columns of the same name on the consumer instance. The administrator of the producer replication set must grant the consumer instance access to the replication data.

If the producer replication set administrator generates a new encryption key, the encryption key value that is stored in the consumer replication set might not automatically update. If it does not update, replication stops. To restore access, see Restore access to replication data.

Procedure

1. On a consumer instance, navigate to Instance Data Replication > Consumer Replication Sets.
2. Click New.
3. On the form, fill in the fields.
### Consumer Replication Set form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Producer Replication Set Name</td>
<td>Name of the consumer replication set. The name on the consumer must match the name on the producer. Obtain the name from the producer administrator.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the purpose of the replication.</td>
</tr>
</tbody>
</table>

4. **Click Submit.**
   The list of all consumer replication sets appears. The system sends a request to the producer replication set administrator to approve or deny your request for a shared encryption key.

⚠️ **Warning:** Do not change any of the values.

5. In the list of all consumer replications sets, click the replication set.
   The Consumer Replication Set displays the replication set information.
The Consumer Approval Status shows Approval Pending. The producer administrator must approve your request to be a consumer.

**Note:** If you receive an error saying that your encryption key does not work, contact Customer Service and Support.

6. Wait until the producer administrator approves the request.
   The Consumer Approval Status changes to Approved. For more information, see [Grant access to replication data](#).

7. Refresh the browser page.
   The system replaces the **Request Producer Approval** button with the **Activate** button.

8. To update the Consumer Replication Entries configuration on the consumer to match the configuration on the producer after you receive confirmation, click the **Synchronize Replication Entries** related link.
   If you do not see this option, refresh the page.
   A modal confirms the synchronization. The tables that you select for replication in the producer replication set are replicated in the consumer replication
set and appear on the Inbound Entries tab. The initial seeding of all the table data may take some time. After initial seeding, only data updates are replicated to consumer replication sets. For more information about seeding, see Seed a consumer instance.

9. To configure who receives replication notifications, click the Notification Configuration related link.

10. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When to send</td>
<td>Trigger for sending a notification.</td>
</tr>
<tr>
<td>Who will receive</td>
<td>Person who receives the notifications.</td>
</tr>
<tr>
<td>What it will contain</td>
<td>Notification content.</td>
</tr>
</tbody>
</table>

11. Click Update.

12. Activate the consumer replication set by selecting the replication set that you want to activate. Then, on the Inbound Entries tab, click Activate.

After some time, the Status is Active Replication, and the Partial Seeding and Full Seeding buttons are displayed. With both seeding options, IDR generates audit trails of all record updates. If you encounter an error during seeding, see Fix seeding errors. For more information about seeding, see Seed a consumer instance.

13. To discard your seeding request before clicking Activate:
   a. On the Seeding Requests tab, click a seeding request.
   b. On the Seeding Request form, click Cancel.

14. To modify the behavior of the consumer, click a source table name on the Inbound Entries tab.
   a. To add the name of a user to an Activities entry, select the Preserve Modified By option on the Inbound Entry form.

   Preserve Modified By preserves the name of the person who updated a field of the Activity type in a record. For example, the Work Notes field is an Activity type in change request records. When someone updates a change request, the work note moves into the Activities stream. If you do not select this option, the Activities entry updates the attributes to IDR in the consumer records. With the option selected, the person who updated the change request is identified in the entry and the system prepends IDR to their name.
b. To run business workflows after a replication, select the **Run Business Rule** option.

A business rule is a server-side script that is associated with a table. Use business rules to trigger workflows that are associated with replications, such as sending a notification or validating the replicated data. For more information, see **Trigger workflows after replication**.

c. To replicate the data from the producer tables into tables with different names on the consumer instance, click **Enable Transform**. For more information, see **Transform replication data**.

d. Click **Update**.

**What to do next**

The consumer instances contain, at a minimum, the current data in the producer replication set tables. The consumer instances are now ready to accept replicated data updates. By default, the data in the producer tables is replicated into tables and table columns of the same name on the consumer instances. For more information about how to map the data into different tables and table columns and how to modify the data as it is replicated, see **Transform replicated data**.

- Map the replication data to different tables on the consumer instance.
- Modify the values during replication.
- Set up business rules to trigger post-replication workflows.
Reconfigure a replication set in Instance Data Replication

If you must change or update your original replication set, reconfigure Instance Data Replication (IDR) replication sets on the producer instance.

Before you begin
Role required: idr_admin or admin

About this task
After activating a revised producer replication set, update the producer replication set name, shared key, producer ID, and producer set ID on each consumer instance.

Note: Make sure that a seeding request is not in progress before you reconfigure a producer instance. Check the consumer replication sets seeding requests status.

Procedure
1. Reconfigure a producer instance:

   a. On the producer instance, navigate to Instance Data Replication > Producer Replication Sets.

   b. Select a producer replication set and make one or more of the following changes to the set:

      • To add a table to the set, on the Replication Entries tab, click New.

      • On the Replication Entries tab, click a replication set. In the Replication Entry form, modify the columns that are included in the replication set, and click Update.

      • To remove the table from the replication set, on the Replication Entries tab, click a replication set and click Delete.

      • To change the shared encryption key, click Generate New Shared Key.

        Only generate new shared keys when you discover that they are compromised or if you want to stop sending data to a consumer. After changing the encryption key on the producer instance, consumers that have the Consumer Approved Status of Denied must reapply for access to the producer replication set. For more information, see Grant access to replication data.

        These changes stop replication and produce this status message on the consumer instance: Producer Replication Set configuration has been modified. On the consumer instance, click Synchronize Replication Entries and then click Activate.
2. To update consumers with the changes made on the producer, update each consumer instance. Navigate to **Instance Data Replication > Consumer Replication Sets** and click the consumer replication set that you want to update.

The status of the replication set is Replication Error. See the following table to learn what action to take according to the status message.

<table>
<thead>
<tr>
<th>Status Message</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval was denied by producer instance.</td>
<td>The producer changed the shared key and that revokes this consumer's access to the replication data. Replication stops. Click the <strong>Request shared key</strong> related link. The producer must approve your request. For more information, see <strong>Grant access to replication data</strong>. If the consumer's access is not revoked, replication continues. Do nothing on the consumer instance.</td>
</tr>
<tr>
<td>Producer Replication Set configuration has been modified.</td>
<td>The producer added or subtracted tables or table columns in the producer replication set. Replication stops. Click <strong>Synchronize Replication Entries</strong> and then click <strong>Activate</strong>. The system keeps the tables on the consumer instance that the producer is no longer replicating.</td>
</tr>
</tbody>
</table>

3. To discard the entire IDR configuration and start over, delete the replication set on the producer and the consumer.

   • To delete a producer replication set from the producer instance, navigate to **Instance Data Replication > Producer Replication Sets**. Click the producer replication set that you want to delete, and click **Delete**.

   • To delete a consumer replication set on a consumer instance, navigate to **Instance Data Replication > Consumer Replication Sets**. Click the consumer replication set that you want to delete, and click **Delete**.

**Deploy a producer or consumer replication configuration through an update set**

Package a replication set configuration from a producer or consumer instance to another instance and then deploy through an update set. For example, you copy a configuration from a test to a production environment.

**Before you begin**

Role required: admin, idr_admin

**Note:** To learn about access to update sets, see **update set administration**.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
About this task
After you deploy the update set, you must activate the producer replication set. You must also update the consumer replication set with the producer instance URL on each consumer instance.

Procedure
1. Export the update set from the instance where you created the replication set.
   To learn about update sets, see Get started with update sets.
2. Import the update set to the instance where you must set up the replication set.
   To learn about update sets, see Get started with update sets.
   
   Note: On a consumer instance, you must select track an update set. This enables the entries to reference the transformations that are configured. Also, if you are importing a bi-directional replication set, you must create an update set. IDR cannot automatically create an update set for bi-directional replication.
3. On the producer instance, navigate to Instance Data Replication > Producer Replication Sets and select the producer replication set that you imported.
4. Click Activate.
   Replication can't happen until you link the producer replication set to one or more consumer replication sets. Activation just makes the producer data available for replication.
5. On the consumer instance, navigate to Instance Data Replication > Consumer Replication Sets and select the consumer replication set that you imported.
   Update the consumer replication set with the producer instance URL on each consumer instance.
   
   Note: If the producer instance URL doesn't automatically retrieve the producer ID and the producer set ID, you must enter these IDs.

Grant access to the replicated data for Instance Data Replication (IDR)
Approve or deny a request to grant access to the replication data.

Before you begin
Role required: admin, idr_admin
About this task
You can review consumer access requests for all of your producer replication sets or for a specific producer replication set. The administrators of consumer sets must apply for access before they can receive the replication data.

Procedure
1. On the producer instance, navigate to **Instance Data Replication** > **Consumers Pending Approval**.
2. Select the option for each consumer replication set that you want to approve.
3. On the Actions on selected rows... list, select **Approve**. The approved consumer sets start receiving the replicated data.

   ❓ **Note:** You can change the Consumer Approval Status to Denied to prevent the consumer from receiving the replicated data.
4. To approve a consumer access request for a specific producer replication set:
   a. On the producer instance, navigate to **Instance Data Replication** > **Producer Replication Sets**.
   b. Select the producer replication set where you want to approve consumer access.
   c. Under Related Links, on the **Consumer Subscriptions** tab, select the option for the consumer replication set that you want to approve.
   d. On the Actions on selected rows... list, select **Approve**. The approved consumer set starts receiving replicated data.

   ❓ **Note:** You can change the Consumer Approval Status to Denied to prevent the consumer from receiving the replicated data.

Revoke access to replicated data for Instance Data Replication (IDR)
Revoke a consumer's access to replicated data if you believe that consumer instance should no longer receive that data.

**Before you begin**
Role required: admin, idr_admin

**About this task**
When you generate a new, shared encryption key, approved consumer sets automatically receive the new key and data replication is not interrupted. Any
Consumer set with a status of Denied or Pending Approval does not receive the new encryption key, and replication ceases.

Procedure

1. On the producer instance, navigate to **Instance Data Replication > Producer Replication Sets**.

2. Select the producer replication set that has consumers whose access needs to be revoked. The instance identifies the consumers under the **Consumer Subscriptions** tab.

3. On the **Consumer Subscriptions** tab, select the option for the consumer instance whose permissions you want to revoke.

4. In the Actions on selected rows... list, select **Revoke**. Instance Data Replication generates a new encryption key and shares it with all approved consumer sets. All other consumer sets stop receiving replication data. Admins of those consumer replication sets must **reapply to restore access to the replication data**.

**Restore access to replication data for Instance Data Replication**

Restore Instance Data Replication (IDR) access to replicated data by sending a request to the producer replication set admin.

**Before you begin**

Role required: admin

**About this task**

When the producer replication set administrator generates a new encryption key, consumer sets with a status of Approved automatically receive the new key and data replication is uninterrupted. Consumer sets with a status of Denied or Pending Approval do not receive the new encryption key and replication stops.
Procedure
1. On the consumer instance, navigate to **Instance Data Replication > Consumer Replication Sets**.
2. Select the consumer replication set to restore access to.
3. Click the **Request Shared Key** related link.
   The system sends a request to the producer replication set administrator. If you are granted access, the consumer Approval Status changes to Approved.
4. If the producer replication set has changed, click the **Synchronize Replication Entries** related link.
5. To get the latest data in the producer replication set, on the **Inbound Entries** tab, select all the tables and click **Activate**.

Transform replication data for Instance Data Replication (IDR)
Transform the producer instance data to tables or table columns that are named differently on consumer instances.

Before you begin
- Create and activate a producer replication set.
- Create, activate, and seed one or more consumer replication sets.
- Role required: idr_admin or admin

About this task
The replicated data from producer tables and table columns goes into tables and table columns of the same name on consumer instances. You can map the producer data into any table or table column on consumer instances. If existing tables or table columns have different names, you can replicate the data to a different table or table column. Adapters modify the data before storing it on consumer instances. For example, adapters can localize data from the producer instance before it is consumed by the consumer instance.

You can also use adapters to modify the producer data during replication. For example, you can localize the data or populate the data that has been labeled differently in consumer tables.

Transformations have the following limitations:
• sys_created, sys_created_by, sys_domain, sys_updated_by, sys_id, sys_mod_count, and other systems are automatically mapped to the consumer and can't be remapped.

No other sys_ fields can be replicated.

• Adapters can't operate on the sys_journal field type such as Comments or Worknotes columns in a Task table.

• Calculated fields won't be transformed.
  A calculated field, such as the name field from sys_user, will replicate but cannot be transformed. Allowing a transformation breaks the calculation for the resulting field.

   🔄 Note: Calculated fields will not show as an option to transform.

Procedure

1. Choose a producer or consumer instance and navigate to the replication set.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Consumer Instance</strong></td>
<td>Navigate to Instance Data Replication &gt; Consumer Replication Sets and click a consumer replication set.</td>
</tr>
<tr>
<td><strong>Producer instance</strong></td>
<td>Navigate to Instance Data Replication &gt; Producer Replication Sets and click a producer replication set.</td>
</tr>
</tbody>
</table>

2. Choose an inbound or outbound entry.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Consumer Instance</strong></td>
<td>On the Inbound Entries tab, click an inbound entry.</td>
</tr>
<tr>
<td><strong>Producer instance</strong></td>
<td>On the Outbound Entries tab, click an outbound entry.</td>
</tr>
</tbody>
</table>

An entry appears.
3. Select the **Enable Transform** option.

4. In the **Target Table Name** list, select the table into which you want to replicate the source table data and click **Update**.

5. On the **Inbound Entries** or the **Outbound Entries** tab, click the same entry.

6. Click the lock icon next to **Transform Map** to unlock it.

   The image shows a Transform Map, with the field names from the source table appearing in the left column. The middle column shows matching field names in the target table. All fields that do not have the same names in both tables appear in the – choose source field – or – choose target field – lists.

   ![Transform Map Image]

   **Note:** If a table in a producer replication set is not on a consumer instance, the consumer instance will fill the first column with the producer schema definition sent during synchronization.

7. Map a producer column to a consumer column that has a different name:
a. Click – choose source field – and select the source field that you want to map.

b. Click – choose target field –, select the target field into which you want to map the data, and then click Add.

c. If you want to remove a field from replicating the producer instance to the consumer instance, click the X at the end of the row to delete the field.

8. To modify the producer data before replicating it in the consumer instance, click Add Adapter.
The image shows the type of Adapter rules that you can create.

What kind of Adapter Rule do you want to create?

- Concatenate String Adapter Rule
- Replace Adapter Rule
- Split Adapter Rule
- Fixed-Width Format Adapter Rule
- Pattern Adapter Rule
- Task Number Adapter Rule
- Calculation Adapter Rule
- Map Adapter Rule
- Time Zone Conversion Adapter Rule

9. Click the adapter that you want to use and then configure it.
For more information about configuring adapters, see Adapter descriptions.

Note: Adapters do not modify the data on the producer instance.

Warning and error messages for schema validation in Instance Data Replication (IDR)
Understand error and warning messages relating to schema definitions. You can then troubleshoot or fix IDR replication issues.

Warning and Error Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The consumer instance does not recognize the [specified] table from the associated IDR schema.</td>
<td>Error</td>
<td>The replication entry cannot process any messages. Please enable a transformation with this table to receive updates</td>
</tr>
</tbody>
</table>
Warning and Error Messages (continued)

<table>
<thead>
<tr>
<th>Message</th>
<th>Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The consumer instance does not recognize the [specified] column from the associated IDR schema.</td>
<td>Warning</td>
<td>The replication entry cannot process any of the specified columns. Please enable a transformation with this table in order to receive updates from this column to the consumer instance.</td>
</tr>
<tr>
<td>The consumer instance does not recognize the column type or length from the associated IDR schema for these columns: [specified columns].</td>
<td>Warning</td>
<td>The consumer instance might lose data for those columns. Please enable a transformation with this table in order to receive updates from these table columns.</td>
</tr>
</tbody>
</table>

**Bidirectional replication for Instance Data Replication (IDR)**

Bidirectional replication enables data to flow from a producer instance to a consumer instance and accept data from a consumer instance to flow back to the producer instance.

By default, replicated data flows from a producer instance to a consumer instance. Bidirectional replication reverses that flow. For example, a company might outsource its networking issues. The third party receives the networking incident records from the consumer instance, fixes the networking issues, updates the records, and returns them to the consumer instance. Bidirectional replication then updates the incident records on the producer instance. Bidirectional replication only works for records that originated on the producer instance.

To make data flow bi-directionally on the consumer instance, the system creates a producer instance on the consumer instance and a consumer instance on the producer instance.
Choosing bidirectional replication creates producer and consumer instances

If you look at the replication sets on the original producer instance, you see the replication set name and the automatically generated consumer instance. It has the same name appended with the suffix, \(-<\text{long-number}>-\text{reverse}\), where \(<\text{long-number}>\) is a randomly generated number. For example, if Test is the producer replication set name, Test-2034802-reverse might be the name of the consumer replication set that automatically generates on the same instance. On the original consumer instance, you see the same names. Replication sets with the \text{reverse} suffix are read-only.

You can verify a consumer on a producer instance and a producer on a consumer instance by running https://<producer-instance-name>/xmlstats.do?include-idr and https://<consumer-instance-name>/xmlstats.do?include=dir on the producer and consumer instances. In the following image, the original producer instance is on the left and the original consumer instance is on the right.

Bidirectional replication has the following limitations:

- Auto-conflict resolution is unsupported.
- Merge conflicts happen if producer and consumer instances modify the same record at the same time.
The most recent update wins, which mean that the data on the consumer and producer tables might be different.

- Deleting data on a consumer instance does not delete the same data on the producer instance.
- Bidirectional replication supports the Number adapter but none of the other adapters.

If you must understand the implications of bi-direction and data transfer between instances, please see data privacy in IDR for more information.

Create a bidirectional replication for Instance Data Replication (IDR)

Replicate updated data on a consumer instance to the producer instance.

Before you begin
Role required: idr_admin or admin

Procedure

1. On the producer instance, navigate to Instance Data Replication > Producer Replication Sets:
   - Click New for a new replication set
   - Click on a producer replication set.
2. Check the Bi-Directional checkbox to enable bi-direction for your producer replication set.
   Bi-directional replication enables changes to records that are made on the consumer instance to propagate to the producer instance.
   
   Note: Bi-directional replication works for records that originate on the producer or consumer.
3. On a consumer instance, navigate to Instance Data Replication > Consumer Replication Sets and click a consumer replication set that is connected to the producer replication set.
4. On the Consumer Replication Set pane, click the Synchronize Replication Entries related link to update the Consumer Replication Entries configuration on the consumer to match the configuration on the producer.

Results
Data that is updated on this consumer instance automatically replicates on the producer instance, which then replicates the updates to its other consumer instances.
Discrete mapping in producer replication sets for Instance Data Replication (IDR)

Adding discrete mapping to producer replication sets enables different consumer replications to be distinguishable.

Every producer replication set has a unique relationship with each consumer subscription. One way of distinguishing this relationship is by mapping discrete field values for producer replication sets.

Once you enable discrete mapping, you can define for each outbound entry of a replication set a discrete value field. An administrator of the producer replication set can define the mapping of each consumer subscription by the setting this discrete value.

For example, you might have an ACME corporation as the producer instance, and have consumer subscribers of ACME US and ACME Europe. You could set a discrete value of region on the outbound replication entries for the incident table. While both of these entries reference the same company table, a rule set for the discrete value can display US for ACME US, and Europe for ACME Europe.

If you have bi-direction enabled with discrete mappings, different consumer subscriptions:

• Should never receive records sent from other consumer subscribers
• Should never receive records from a producer intended for other consumers subscribers

If you must understand the implications of discrete mappings and data transfer between instances, please see data privacy in IDR for more information.

Create a discrete producer replication set for Instance Data Replication (IDR)

Distinguish consumers for a producer replication set.

Before you begin
Role required: admin

Procedure
1. On the producer instance, navigate to Instance Data Replication > Producer Replication Sets:
   • Click New for a new replication set
   • Click on a producer replication set.
2. Check Discrete to enable discrete mappings for your producer replication set.
Once you enable discrete mapping, each outbound entry for a replication set has a discrete value column. You can define the mapping of each consumer subscription by setting a discrete value.

3. Navigate to **Outbound Entries** tab and click **New**.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Table Name</td>
<td>Select one of the tables on the producer instance to replicate. For example, .NET Application [cmdb_ci_dot_net]</td>
</tr>
<tr>
<td>Discrete Field</td>
<td>Choose a field that defines the mapping for each consumer subscription. For example, if you choose the <strong>Assigned To</strong> field in the Incident source table, you can distinguish user assignments for specific consumers.</td>
</tr>
<tr>
<td>[Optional] Filter</td>
<td>Within the <strong>Filter</strong> section, you can use the <strong>Add Filter Condition</strong> to select filter criteria to control the records in the table that are being replicated. For example, you might want to replicate only active records. In that case, select <strong>Active</strong> in the <strong>– choose field – list</strong>, <strong>Is</strong> in the <strong>– oper – list</strong>, and <strong>True</strong> in the <strong>– value – list</strong>. If you do not use a filter, all the fields in the producer replication set table appear in the Available column.</td>
</tr>
<tr>
<td>[Optional] Include Attachments</td>
<td>Select this option to replicate files that are associated with the records that are being replicated.</td>
</tr>
<tr>
<td>[Optional] Included Fields</td>
<td>In the Included Fields columns, use the arrows to move table fields into the Selected column to replicate them or into the Available column to prevent replicating them.</td>
</tr>
</tbody>
</table>

**Note:** The Available column contains the fields in the Source Table that you specified. That table may not contain the **Active** field.

**Note:** Some fields, such as **SYS ID (Mandatory)**, must be replicated. Other fields, such as **Edge Encrypted** and **Password1**, can’t be replicated and do not appear in either column.

4. Navigate to **Discrete Mappings** tab, click **New**, and fill in the form fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discrete Value</td>
<td>This field sets a rule for what displays for the selected consumer instance within the producer replication set. For example, an <strong>Assigned To</strong> discrete value gives choices from a designated table of a specific user to show assignments.</td>
</tr>
<tr>
<td>Outbound Replication Entry</td>
<td>Select an outbound replication entry that you configured with a source table for this producer replication set.</td>
</tr>
<tr>
<td>Replication Subscription</td>
<td>Choose the consumer instance that displays the discrete value assignment.</td>
</tr>
</tbody>
</table>

**Note:** For each consumer that subscribes to a producer replication set with discrete mapping enabled, they must have a discrete value set.

### Seed a consumer instance for Instance Data Replication

Seed all or some of the tables in your Instance Data Replication (IDR) replication sets depending on the needs of your consumer instance.

#### Before you begin

Role required: idr_admin or admin

#### About this task

You can initiate seeding requests on a consumer instance while you are activating a consumer replication set.

**Note:** Seeding continues even if errors occur on some consumer tables. You can restart seeding specifically on the tables that have errors or on all tables in a replication set.

#### Procedure

1. On the consumer instance, navigate to **Instance Data Replication > Consumer Replication Sets** and click a consumer replication set.
2. On the **Inbound Entries** tab, select the entry or entries that you want to initiate seeding for.
3. To initiate a full seeding, click **Full Seeding**. A modal opens stating that the system is requesting all matching records.
4. To configure a partial seeding, click **Partial Seeding**.
   a. If you selected more than one entry, select the Replication entry that you want to configure and select **Configure Seeding**.
   b. Configure one or more Custom Filter conditions, operators, and values.
   c. To download the current field values and to replicate the files that are associated with the records, select **Include Attachments**.
   d. To download the current field values and the history of all field updates, select **Include History**.
   e. In the Included Fields columns, use the arrows to move table fields into the Selected column to replicate them or into the Available column to prevent replicating them.
   f. Click **Save Configuration**.
   g. Configure other Replication entries as needed.
   h. When you are ready to initiate seeding, click **Request Partial Seeding**.

   **Note:** The Custom Filter determines which records to include in the partial seeding request.
   
   The system must replicate some fields, such as **SYS ID (Mandatory)**.
   The system cannot replicate some fields, such as **Edge Encrypted** and **Password**. They do not appear in either column.

5. To discard your seeding request before you click **Request Partial Seeding**, click **Cancel**.

   **Note:** If you encounter an error during seeding, see **Fix seeding errors**.

**Results**

In a successful seeding, all selected data on a producer instance is replicated on a consumer instance.

- After seeded, the consumer instance maintains a history of all field updates.
- Records that exist on the producer instance and not on the consumer instance are copied to the consumer instance.
- If the identical record exists on a consumer instance, the record on the consumer instance is not modified.
- The sys_id of the record identifies the record on both instances.
• If a replication set changes and no longer includes a table, IDR does not alter the records in the corresponding table on the consumer instances.

• The producer instance handles one seeding request at a time. When the producer instance is busy with a seeding request, subsequent seeding requests are queued and initiated in the order that they are received.

**Trigger workflows after replications for Instance Data Replication (IDR)**

Use platform business rules to trigger workflows after replications.

**Before you begin**
Role required: idr_admin or admin

**About this task**
A business rule is a server-side script that is associated with a table. Use business rules to trigger workflows that are associated with replications, such as sending a notification or validating the replicated data.
Business rules are part of the Now Platform. For more information, see Business rules.

**Procedure**
1. On a consumer instance, navigate to Instance Data Replication > Consumer Replication Sets and click a consumer replication set.
2. On the Inbound Entries tab, click a replication set table.
3. Select the Run Business Rule option.
4. Repeat this procedure for the other tables in the replication set.
5. Click Update.
IDR invokes the business rules that are associated with the specified table after replicating the data to the table.

**Data privacy in Instance Data Replication (IDR)**
The ability of replication sets to host multiple remote consumers in IDR means that there are potential data privacy issues to consider.

Replications sets in IDR serve multiple instances with multiple consumers. A replication set can have a single customer or can have multiple customers. A consumer could also be located within the same geographic region as the producer or located in a different geographical region.
Depending on how you configure your replication set, you can have data sharing internally, between offices of the same company, or externally, extending across multiple companies. You can also confine data sharing to a single location or region, or you can share data across all regions.

An active replication set occurs after the producer instance administrator approves a consumer subscription. An active replication set involves data transfer, which could include transfer of personal data, between geographical regions. The data transfer between different geographical regions could subject the data to differing personal data regulations.

During the approval process, if IDR determines that the consumer and producer instances are in different geographical regions, it alerts the producer before activation. This alert should make administrators aware of the potential for differing data transfer regulations between regions.

Once a replication set is active, a replication set with multiple consumers might have specific discrete rules which direct specific data to specific consumers. Any modification of a discrete rule on an active replication set which spans multiple consumers has the potential to expose data. This data exposure can include personal data, which might be viewable by unintended consumers that subscribe to the replication set.

If you set bi-direction between a producer and consumer instance, the consumer can originate data that shares back to the producer instance. This data can also potentially reach any other consumer that is part of the replication set.

**Instance Data Replication (IDR) monitoring dashboard**

With the IDR dashboard, you can monitor the status of active producer and consumer replication sets, scheduled jobs, seeding requests, and license or usage details.

**Accessing the IDR dashboard**

Users with the admin or idr_admin role can access the dashboard.

Navigate to the IDR dashboard in the following way:

- **Instance Data Replication > Monitoring Dashboard**

- Choose either: **IDR Overall Monitoring** or **IDR License and Usage Details** dashboard.

**IDR Overall Monitoring dashboard**

The IDR Overall Monitoring dashboard monitors the following:
- Active Producer Replication Sets
- Active Consumer Replications Sets
- IDR Scheduled Jobs
- Producer Seeding Requests Within Last 7 Days
- Consumer Seeding Requests Within Last 7 Days

### Active Producer Replication Sets

<table>
<thead>
<tr>
<th>Name</th>
<th>Replication Queue Reading Lag</th>
<th>Status</th>
<th>Status Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>cmdb-cisan-disk</td>
<td>00:00:39</td>
<td>active</td>
<td>Active Replication</td>
</tr>
<tr>
<td>cmdb-cisc-storage-device</td>
<td>00:00:39</td>
<td>active</td>
<td>Active Replication</td>
</tr>
<tr>
<td>id-incidentsync-up-bffa9f3d6b3443901d99</td>
<td>00:00:39</td>
<td>active</td>
<td>Active Replication</td>
</tr>
<tr>
<td>id-problem-sync-up</td>
<td>00:00:39</td>
<td>active</td>
<td>Active Replication</td>
</tr>
</tbody>
</table>

### Active Consumer Replication Sets

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Lag</th>
<th>Network Lag</th>
<th>Status</th>
<th>Status Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>id-incidentsync-up</td>
<td>00:00:43</td>
<td>00:00:04</td>
<td>active</td>
<td>Active Replication</td>
</tr>
<tr>
<td>id-problem-sync-up-137c1a74dbb0104313d44</td>
<td>00:00:00</td>
<td>active</td>
<td>Active Replication</td>
<td></td>
</tr>
<tr>
<td>interaction</td>
<td>00:00:43</td>
<td>00:00:04</td>
<td>active</td>
<td>Active Replication</td>
</tr>
<tr>
<td>label</td>
<td>00:00:43</td>
<td>00:00:04</td>
<td>active</td>
<td>Active Replication</td>
</tr>
</tbody>
</table>

**Active Producer Replication Sets**

The Active Producer Replication Sets monitors your producer replication set status and reports the data lag time between your instance and the replication queue.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the producer replication set.</td>
</tr>
<tr>
<td>Replication Queue Reading Lag</td>
<td>Time between a record change on the producer instance and the moment it is sent over the outbound replication queue.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of a replication set, either active or in error.</td>
</tr>
<tr>
<td>Status Message</td>
<td>Message that describes the error status.</td>
</tr>
</tbody>
</table>

**Active Consumer Replication Sets**

The Active Consumer Replication Sets monitors your consumer replication set status, reports the network lag time, and reports the data lag time between the producer and consumer instance.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the consumer replication set.</td>
</tr>
<tr>
<td>Data Lag</td>
<td>Time between a record change on the producer instance and the moment it is recorded in the consumer instance.</td>
</tr>
<tr>
<td>Network Lag</td>
<td>Time between a record change logs in the outbound replication queue and the moment it is recorded in the consumer instance.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of a replication set, either active or in error.</td>
</tr>
<tr>
<td>Status Message</td>
<td>Message that describes the error status.</td>
</tr>
</tbody>
</table>

**Suite of IDR Scheduled Jobs**
The suite of IDR scheduled jobs poll for data changes, requests, and check the health of your producer and consumer instances. You can monitor the following jobs:

<table>
<thead>
<tr>
<th>Jobs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IDRConsumerJob</td>
<td>Polls for record changes and seeding requests on the consumer instance in 15-second intervals.</td>
</tr>
<tr>
<td>IDRHeartBeatJob</td>
<td>Updates information about the health of every active producer or consumer set.</td>
</tr>
<tr>
<td>IDRMetadataConsumerJob</td>
<td>Polls for metadata record changes on the consumer instance in 15-second intervals.</td>
</tr>
<tr>
<td>IDRProducerJob</td>
<td>Polls for new, updated, or deleted records in the data replication queue for a producer instance in 15-second intervals.</td>
</tr>
<tr>
<td>IDRSeedingProducerJob</td>
<td>Checks for new seeding requests coming from consumer instances.</td>
</tr>
</tbody>
</table>

**Note:** You can set when your IDR scheduled jobs run and configure a periodic trigger that specifies how often the job runs.

### IDR Scheduled Jobs field types

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Scheduled job name.</td>
</tr>
<tr>
<td>Next Action</td>
<td>Date and time when the job next runs.</td>
</tr>
<tr>
<td>Trigger type</td>
<td>Job that you can configure to run daily, weekly, monthly, periodically, once, on-demand, or business calendar start or end</td>
</tr>
</tbody>
</table>
### IDR Scheduled Jobs field types (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>date</td>
<td>The trigger can repeat daily, hourly, by minute, or by second.</td>
</tr>
<tr>
<td>Job ID</td>
<td>ID of the scheduled job.</td>
</tr>
<tr>
<td>State</td>
<td>State of the job, for example, ready.</td>
</tr>
</tbody>
</table>

### Producer Seeding Request Within Last 7 Days

You can monitor the status of a producer seeding request within the last seven days.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replication Set</td>
<td>Producer set and the consumer set.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the seeding request. The status can be completed, in progress, or failed.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Time that the seeding begins.</td>
</tr>
<tr>
<td>End Time</td>
<td>Time that the seeding ends.</td>
</tr>
<tr>
<td>Percent Complete</td>
<td>Percentage of the seeding request job that is complete.</td>
</tr>
</tbody>
</table>

### Consumer Seeding Request Within Last 7 Days

You can monitor the status of a consumer seeding request within the last seven days.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replication Set</td>
<td>Corresponding consumer set.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the seeding request. The status can be completed, in progress, or failed.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Time that the seeding begins.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>End Time</td>
<td>Time that the seeding ends.</td>
</tr>
<tr>
<td>Percent Complete</td>
<td>Percentage of the seeding request job that is complete.</td>
</tr>
</tbody>
</table>

**IDR Dashboard Properties**

You can navigate to the IDR dashboard properties in the following way:

- **Instance Data Replication > Properties**

You can change the following properties on your dashboard:

<table>
<thead>
<tr>
<th>Property field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minutes of lag before the Data Lag field is highlighted in red on the IDR Monitoring Dashboard</td>
<td><strong>Data Lag</strong> field that is part of the Active Consumer Replication set. The field highlights if the actual lag time is greater than the time threshold that you set. The default is 15 minutes.</td>
</tr>
<tr>
<td>Minutes of lag before the Network Lag field is highlighted in red on the IDR Monitoring Dashboard</td>
<td><strong>Network Lag</strong> field that is part of the Active Consumer Replication set. The field highlights if the actual lag time is greater than the time threshold that you set. The default is 15 minutes.</td>
</tr>
<tr>
<td>Minutes of lag before the Replication Queue Reading Lag field is highlighted in red on the IDR Monitoring Dashboard</td>
<td><strong>Replication Queue Reading Lag</strong> field that is part of the Active Consumer Replication set. The field highlights if the actual lag time is greater than the time threshold that you set. The default is 15 minutes.</td>
</tr>
</tbody>
</table>

ℹ️ **Note:** You can set the colors on the fields through personalize list columns (`v_idr_dashboard_list.do`).

**IDR License and Usage Details**

The IDR License and Usage Details dashboard monitors the following:
• Subscriber Sent Messages
• Subscriber Received Messages
• IDR License Details
• IDR Messages Sent
• IDR Messages Received

**Subscriber Sent Messages**

The amount of messages each subscriber instance sent, by month.

![Subscriber Sent Messages Chart]

**Subscriber Received Messages**

The number of message each subscriber instance received, by month.

![Subscriber Received Messages Chart]

**IDR License Details**

You can monitor the status of a consumer seeding request within the last seven days.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the IDR license.</td>
</tr>
<tr>
<td>Type</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Category</td>
<td></td>
</tr>
<tr>
<td>Start date</td>
<td>Start of licensing period.</td>
</tr>
<tr>
<td>End date</td>
<td>End of licensing period.</td>
</tr>
<tr>
<td>Display only</td>
<td></td>
</tr>
<tr>
<td>Purchased</td>
<td>Number of purchased licenses.</td>
</tr>
<tr>
<td>Allocated</td>
<td>Number of allocated licenses.</td>
</tr>
</tbody>
</table>

**IDR Messages Sent**

The number of messages sent, per license, monthly.

**IDR Messages Received**

The number of messages received, per license, monthly.

**Instance Data Replication Queue dashboard**

Use the Instance Data Replication (IDR) Queue Dashboard to monitor the IDR replication record queue, message produced queue, message consumed queue, and messages processed for all replications sets.
Accessing the IDR Queue Dashboard

Users with the admin or idr_admin role can access the dashboard.
Access the IDR Queue Dashboard by navigating to Instance Data Replication > Queue Dashboard.

IDR Queue Dashboard

The IDR Queue Dashboard enables you to monitor the following:

• IDR Queued Producer Records which are hourly records queued for all tables over a 24-hour time period.
• Outbound Messages Remaining which are messages remaining in the replication queue that are not yet sent to the message queue.
• Outbound Messages Processed which are messages produced from this instance to the message queue.
• Inbound Messages Remaining which are messages remaining in the message queue, that have not yet been processed.
• Inbound Messages Processed which are messages consumed on this instance.

In any chart, select Last 24 Hours or Last 5 Days as the time period. For the 24-hour period, the number of messages is per hour. For the 5-day period, the number of messages is per day.
Select the legend link under the chart to exclude that data source.
IDR Queued Producer Records

With the IDR Queued Producer Records chart, you can see the number of records queued for each table over an hourly or daily period. It shows which tables account for the highest amount of traffic within IDR over time. Use this chart to identify activity spikes that cause predictable performance lags on the consumer instance.

For example, if you see that a large spike of activity occurs every day at 3:00 a.m. due to a business rule on a table, you should expect a performance lag to occur on the consumer around that time.

Select All Tables or a specific table. Position your cursor over a point in the chart to see the queue count and tables for that point.

Outbound Messages Remaining

With the Outbound Messages Remaining chart, you can determine whether a producer instance is catching up to real-time replication after a large spike in activity.

When replication is working correctly, the messages remaining count should be very low. If there is a spike in activity, you can expect a large value. For example, when a business rule is changing tens of thousands of records within a minute.
You can also expect messages remaining to decrease over time as the jobs process the messages.

If the messages remaining count continues to grow without resolution, it might indicate:

- An issue processing the messages. For example, the IDRProducerJob is not running, or cannot send messages to the message queue.
- The instance is recording changes faster than IDR can produce them.

Select All Sets or a specific set. Position your cursor over a point in the chart to see the message count and replication set name for that point.

**Outbound Messages Processed**

With the Outbound Messages Processed chart, you can see the flow of records from a producer instance to the message queue over time.

Trends for messages processed and the messages remaining over time indicates if replication is recovering from a lag or if there are issues sending data to the message queue.

Along with the Data Replication Queued Producer records chart, you can see if the instance is sending data. If your instance has queued records that are not being sent, it might indicate:

- The instance is not able to run the producer job. For example, due to other resource-intensive processes running on the instance and all worker threads being busy.
- There is an issue connecting to the message queue.

To see the message count and replication set name for a graph point, select All Sets or a specific set and position your cursor over a point in the chart.

**Inbound Messages Remaining**

With the Inbound Messages Remaining chart, you can determine whether a consumer instance is catching up to real-time replication after a large spike in activity.

You can expect a temporary large value when there is a spike in activity. The value normally decreases as the messages are processed.

If this value continues to grow without resolution, it might indicate:

- An issue processing the messages. For example, the IDRConsumerJob is not running, or cannot read messages from the message queue.
- The instance is recording changes faster than IDR can consume them.
Select **All Sets** or a specific set. Position your cursor over a point in the chart to see the message count and replication set name for that point.

**Inbound Messages Processed**

With the Inbound Messages Processed chart, you can see the flow of records for each consumer set over time.

Use the inbound messages chart to determine which replication sets have the most traffic and see trends for messages processed and the messages remaining.

If the producer is sending records to the message queue and the consumer is not processing them, it might indicate issues with the producer or the consumer instance.

Position your cursor over a point in the chart to see the message count and replication set name for that point.

**Resolve data replication errors for Instance Data Replication (IDR)**

Resolve errors and monitor status of IDR replication sets.

**Monitoring and troubleshooting checklist**

When you notice that data is not being replicated, you can use the troubleshooting checks to investigate a broken replication. To monitor the overall health of all replication sets, see **IDR monitoring dashboard**.

<table>
<thead>
<tr>
<th>IDR Check</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Monitor</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Check connectivity</strong></td>
<td>Test your IDR instance connectivity to determine the connectivity of your instance to the message queue.</td>
</tr>
<tr>
<td><strong>Check IDR monitoring dashboard to see if replication jobs are active</strong></td>
<td>For the dashboard to properly display replication set information, these IDR scheduled jobs must be available and running on your instance:</td>
</tr>
<tr>
<td></td>
<td>• IDRConsumerJob</td>
</tr>
<tr>
<td></td>
<td>• IDRHeartbeatJob</td>
</tr>
<tr>
<td></td>
<td>• IDRMetadataConsumerJob</td>
</tr>
</tbody>
</table>
### IDR (continued)

<table>
<thead>
<tr>
<th>Check</th>
<th>Description</th>
</tr>
</thead>
</table>
| • IDRProducerJob  
• IDRLockingProducerJob  
• IDRSeedingProducerJob |  
**Note:** If any of these jobs are missing or not running, contact Customer Service and Support. |

### Producer replication set

- **Check activation of producer replication set**
  - If the status of your producer replication set is In Draft, click **Activate**.

- **Check consumer subscription approval**
  - Review the consumer access requests for your producer replication sets. A consumer replication set must apply for access before they can receive replication data.

- **Check producer replication log errors**
  - Identify IDR errors by viewing the metadata for messages between producer and consumer instances, payload error logs, and message logs.

### Consumer replication set

- **Check activation status of consumer replication set**
  - If the status of your consumer replication set is In Draft, click **Activate**.

- **Check if you need to synchronize replication sets**
  - A synchronization issue occurs when a producer instance doesn't send data or a consumer instance doesn't receive data. Synchronization errors appear in the **Status** field on the consumer instance as **Replication Error**.

- **Check your consumer replication set status**
  - Review the status of your consumer replication set and what that means for your replication.

### Error and status messages
### Run Instance Data Replication (IDR) diagnostics

You can check IDR to verify whether the services and the connection between your instance and the message queue are set up and enabled.

**Before you begin**
Role required: admin or idr_admin

**Procedure**
1. Navigate to Instance Data Replication > Diagnostics.
2. Select the diagnostics to run:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configuration</strong></td>
<td>Choose Local or Remote to run diagnostics on a local or remote instance. For a remote instance, enter the URL of the remote instance, and a username and password for any of the following roles:</td>
</tr>
<tr>
<td></td>
<td>• idr_rest</td>
</tr>
<tr>
<td></td>
<td>• idr_read</td>
</tr>
<tr>
<td></td>
<td>• idr_admin</td>
</tr>
<tr>
<td><strong>Key Management Service</strong></td>
<td>Check the status and setup of your key management service.</td>
</tr>
</tbody>
</table>

**Note:** The local datacenter to your producer instance regional proximity is the default.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificate Management Service</td>
<td>Check the status and setup of your certificate management service.</td>
</tr>
<tr>
<td></td>
<td>Note: IDR requires a certificate management service to be up and running.</td>
</tr>
<tr>
<td>Message Queue System</td>
<td>Check the status and setup of your message queue system.</td>
</tr>
<tr>
<td></td>
<td>Note: IDR requires a key management service to be up and running.</td>
</tr>
</tbody>
</table>

3. Click **Run Diagnostics**. Results show for the diagnostic options that you select. The resulting messages validate enabled services or if messages read or write successfully.

**Review synchronization errors in Instance Data Replication**

Review the status field to check if synchronization is working correctly on the Instance Data Replication (IDR) consumer instance.

**Before you begin**

Before identifying synchronization errors, complete the tasks in **check for common issues**.

Role required: idr_admin or admin

**About this task**

Synchronization errors occur when a producer instance doesn’t send data or a consumer instance doesn’t receive data. Synchronization errors appear in the **Status** field on the consumer instance as **Replication Error**.

**Procedure**

1. Determine if the consumer successfully sent the synchronize request to the producer:

   a. On the consumer instance, navigate to **Instance Data Replication > Consumer Replication Sets**.

   b. Select a consumer replication set.
c. Click the Replication Metadata Logs related link.

d. Sort the logs in a descending order in the Log Sequence column.

e. Find the most recent payload with the REPL_SET_DETAIL_REQUEST type and open it.
   If you do not see this payload type, refresh the log until you see a payload with the REPL_SET_DETAIL_REQUEST type.

f. Verify that you see the correct producer instance ID in the To column.
   If the producer instance ID is incorrect, update the ID and click Activate.

g. Verify that you see Sent in the Status column.
   If you don't see Sent in the Status column, the producer didn't send any updates.

2. Determine if the producer received the synchronize request from the consumer:

   a. On the producer instance, navigate to Instance Data Replication > Producer Replication Sets.

   b. Select a producer replication set.

   c. Click the Replication Metadata Logs related link.

   d. Sort the logs in a descending order in the Log Sequence column.

   e. Find the most recent payload with the REPL_SET_DETAIL_REQUEST type and open it.
      If you don't see this payload type, refresh the log until you see the REPL_SET_DETAIL_REQUEST type.

   f. Verify that you see the correct consumer instance ID in the From column.
      If the consumer instance ID is incorrect, update the ID.

   g. Verify that you see Received in the Status column.

Discover replication delays in Instance Data Replication (IDR)

Monitor possible data replication issues by using the IDR Monitoring Dashboard.
Before you begin
Role required: admin

About this task

Procedure

1. To view the time lag on a producer instance, navigate to **Instance Data Replication > Monitoring Dashboard**, and check the Active Producer Replication Sets for the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the producer replication set.</td>
</tr>
<tr>
<td>Replication Queue Reading Lag</td>
<td>Time between a record change on the producer instance and the moment it is sent over the outbound replication queue.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of a replication set, either active or in error.</td>
</tr>
<tr>
<td>Status Message</td>
<td>Message that describes the error status.</td>
</tr>
</tbody>
</table>

To get additional information, view the producer instance xmlstats at [https://<producer-instance-name>/xmlstats.do?include=idr](https://<producer-instance-name>/xmlstats.do?include=idr).

The xmlstats shows:

- The **producer_last_run** indicates the last time that the replication job ran on the producer instance.
- The **last_message_sent_on** indicates the last time that the producer sent updated data to consumers.

ℹ️ Note: The timestamps are GMT.

2. To view the time lag on a consumer instance, navigate to **Instance Data Replication > Monitoring Dashboard** and check the Active Consumer Replication Sets for the following:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the consumer replication set.</td>
</tr>
<tr>
<td>Data Lag</td>
<td>Time between a record change on the producer instance and the moment it is recorded in the consumer instance.</td>
</tr>
<tr>
<td>Network Lag</td>
<td>Time between a record change logs in the outbound replication queue and the moment it is recorded in the consumer instance.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of a replication set, either active or in error.</td>
</tr>
<tr>
<td>Status Message</td>
<td>Message that describes the error status.</td>
</tr>
</tbody>
</table>

To get additional information, view the consumer instance xmlstats at https://<consumer-instance-name>/xmlstats.do?include=idr.

```xml
<xmlstats created="Thu Jun 11 13:26:50 PDT 2019" include="idr" version="2">...
</xmlstats>
```

The xmlstats shows:

- The `consumer_last_run` indicates the last time that the consumer job ran and received changes from the producer.
- The `last_heartbeat_received_on` shows the timestamp when the consumer last received a heartbeat from the producer instance.

⚠️ **Note:** The timestamps are GMT.

**Fix seeding errors in Instance Data Replication**

Retry Instance Data Replication (IDR) seeding on tables with seeding errors, which occur from network problems and failed inserts, so that you don't have to do a full seeding.
Before you begin
Role required: idr_admin or admin

About this task
The maximum for a retry reseeding request is 10,000 errors. If you have more errors, perform a full seeding.
Do not retry full seeding if you exceed any of the following limitations:

- Record size exceeds 32 MB.
- Seeding request exceeds 3 million records.
- Replication takes longer than seven days to complete.

Note: To avoid these limitations, reduce the number of tables in the seeding request, reduce the size of the records, or use partial seeding.

Procedure
1. On the consumer instance, navigate to Instance Data Replication > Consumer Replication Sets.
2. On the Seeding Requests tab of the Consumer Replication Set pane, click a seeding request that failed.
3. On the Seeding Request pane, click the Payload Errors tab and examine the values in the Message column.
4. Click Retry All Errors or select specific errors, and then click Retry Selected Errors.
The image shows areas where you can retry errors.

Find Instance Data Replication (IDR) errors
Identify IDR errors by viewing the metadata for messages between producer and consumer instances, payload error logs, and message logs.

Before you begin
Role required: idr_admin or admin

Procedure
1. View the producer or consumer metadata logs:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Producer</td>
<td>Navigate to Instance Data Replication &gt; Producer Replication Sets, select a producer replication set and click the Replication Metadata Logs related link.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Consumer</td>
<td>Navigate to Instance Data Replication &gt; Consumer Replication Sets, select a consumer replication set and click the Replication Metadata Logs related link.</td>
</tr>
</tbody>
</table>

2. On either the producer instance or the consumer instance, to view transformation errors and replications that failed to load:

   a. Navigate to Instance Data Replication > Replication Payload Error.
      If the Source value is Seeding, the error occurred during seeding. If the source value is different, the error occurred during a replication set update. If any column breaks during transformation, transformation for the entire table breaks and data is not replicated in the table.

   b. Select an error in the Created column.
      The Error Message field on the Payload Error pane describes the payload error.

3. View the replication log on either the producer instance or the consumer instance:

   a. Navigate to Instance Data Replication > Replication Log.

   b. Select an entry.
      The Instance Data Replication Log form shows the message and message level.

**Status messages and status errors for a consumer replication set in Instance Data Replication**

Review the status of your consumer replication set and research error messages to identify or fix Instance Data Replication (IDR) replication issues.

**Consumer replication set status and status message**

Navigate to Instance Data Replication > Consumer Replication Sets to access a consumer replication set, and view the status and status messages.
To use your consumer replication set, click **Activate**.

After you initiate an activation, you must wait for the producer instance to respond to your request. If the wait time is excessive, then check the replication log for errors.

The seeding job must complete before replication can resume.

The seeding job must resume before the seeding can continue.

Normal status.

Check the Status Messages in the following table for a specific message and associated fix.

The replication process must resume before the replication can continue.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Draft</td>
<td>To use your consumer replication set, click <strong>Activate</strong>.</td>
</tr>
<tr>
<td>Activation Requested</td>
<td>After you initiate an activation, you must wait for the producer instance to respond to your request. If the wait time is excessive, then check the replication log for errors.</td>
</tr>
<tr>
<td>Seeding</td>
<td>The seeding job must complete before replication can resume.</td>
</tr>
<tr>
<td>Seeding Paused</td>
<td>The seeding job must resume before the seeding can continue.</td>
</tr>
<tr>
<td>Active</td>
<td>Normal status.</td>
</tr>
<tr>
<td>Replication Stopped</td>
<td>Check the Status Messages in the following table for a specific message and associated fix.</td>
</tr>
<tr>
<td>Replication Paused</td>
<td>The replication process must resume before the replication can continue.</td>
</tr>
</tbody>
</table>
### Status (continued)

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replication Error</td>
<td>Check the Status Messages in the following table for a specific message and associated fix.</td>
</tr>
<tr>
<td>Replication Deactivated</td>
<td>Activate the producer and consumer instances.</td>
</tr>
<tr>
<td>Subscription Requested</td>
<td>Approve the request for a consumer subscription on the producer instance.</td>
</tr>
</tbody>
</table>

### Status Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Producer Replication Sets have been deactivated due to fatal replication error</td>
<td>All consumer replication sets are moved to the error state. Contact Customer Service and Support.</td>
</tr>
<tr>
<td>Error while seeding data. Please refer to the Replication Payload Error table for details</td>
<td>On the consumer instance, more than one record failed to seed. To recover, go to the Replication Payload Error table to find and fix the error, and then activate the replication set.</td>
</tr>
<tr>
<td>Error while seeding data. Please retry seeding this table</td>
<td>To recover, reseed the table.</td>
</tr>
<tr>
<td>Producer has encountered an error while seeding</td>
<td>To recover, contact the administrator of the producer instance to determine the cause of the problem.</td>
</tr>
<tr>
<td>Producer Replication Set configuration has been modified</td>
<td>To recover, activate the replication set on the consumer instance.</td>
</tr>
<tr>
<td>Producer Replication Set has been deactivated due to replication error</td>
<td>Contact Customer Service and Support.</td>
</tr>
<tr>
<td>Producer Replication Set has been deactivated</td>
<td>To recover, activate the producer replication set, and then activate the consumer replication.</td>
</tr>
<tr>
<td>Producer Replication Set has been deleted</td>
<td>To recover, delete the consumer replication set.</td>
</tr>
</tbody>
</table>
## Status Messages (continued)

<table>
<thead>
<tr>
<th>Message</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Producer Replication Set is inactive</td>
<td>To recover, <strong>activate the producer replication set</strong>, and then <strong>synchronize and activate the consumer replication set.</strong></td>
</tr>
<tr>
<td>Producer Replication Set not found</td>
<td>To recover, <strong>delete the consumer replication set.</strong></td>
</tr>
<tr>
<td>Replication Set Paused</td>
<td><strong>To recover, click Resume or Activate.</strong></td>
</tr>
<tr>
<td>Replication set was in pause/error/seeding pause state for more than 7 days</td>
<td>The consumer replication set has been in the pause state, error state, or seeding pause state for more than the timeout period. The replication set is put into the disabled state. <strong>To recover, check for seeding errors and activate the replication with seeding.</strong></td>
</tr>
<tr>
<td>Seeding has been terminated due to timeout</td>
<td><strong>To recover, retry the seeding request or contact Customer Service and Support.</strong></td>
</tr>
<tr>
<td>Seeding request for a Producer Replication Set containing more than X number of records is not supported</td>
<td><strong>To recover, change the filter criteria to reduce the number of records to be seeded or use partial seeding. The default limit is 10 million records. Contact Customer Service and Support to change the default limit.</strong></td>
</tr>
<tr>
<td>Seeding was cancelled by a consumer admin</td>
<td><strong>To recover, activate the replication set.</strong></td>
</tr>
<tr>
<td>Seeding was cancelled by a producer admin</td>
<td><strong>To recover, activate the consumer replication set.</strong> Only seeding requests in the queued, paused, or started states can be canceled. In this case, the consumer replication state is Replication Error.**</td>
</tr>
<tr>
<td>Shared key not matching</td>
<td>The producer and consumer replication sets have different shared keys. <strong>To recover, copy the shared encryption key on the producer</strong></td>
</tr>
</tbody>
</table>
Status Messages (continued)

<table>
<thead>
<tr>
<th>Message</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>replication set, paste it into the consumer replication set, and activate the replication set.</td>
<td></td>
</tr>
</tbody>
</table>

**Instance Data Replication (IDR) XML stats**

Extract IDR related data from your instance to monitor replication status.

**IDR XML Stats**

You can view key metrics from your IDR producer and consumer instances to monitor performance and the status of IDR processing.

In a browser where the instance is running, append the following text to the instance URL: `xmlstats.do?include=idr`. The following output is an example of the IDR XML stats.

```xml
<idr status="enabled">
  <producer producer_last_run="2020-11-06 13:45:30"
    replication_queue_position="data_replication_queue0001@2020-11-05T22:58:32Z,2732,0,1"
    replication_queue_reading_lag="00:01:00">
    <replset last_message_sent_on="2020-11-06 13:44:31"
      last_position="data_replication_queue0001@2020-11-05T22:58:32Z 2731,0,1"
      last_sent_message_id="f339a84ac81820105b07c7cf110d4135" name="N-2NormalStickyReplication" status="active" topic_name="d59f4226db6680504d2bac44d69619a0.570532d91b582010ef39fccc4cc4bcb4a1">
      <subscriber name="persistencetestingora9" remote="false"/>
    </replset>
  </producer>
  <consumer consumer_last_run="2020-11-11 14:22:36">
    <replset data_lag="00:02:22" last_heartbeat_received_on="2020-11-11 14:22:36"
      last_message_received_network_time="00:00:05"
      last_position="data_replication_queue0002@2020-11-11T18:50:47Z,212,0,1"
      name="N-2NormalTransformerReplication" producer_name="byungidrorlondoni6" remote="false" status="active"
      topic_name="d59f4226db6680504d2bac44d69619a0.6f0572d91b582010ef39fccc4cc4bcb01"/>
  </consumer>
</idr>
```
IDR Metrics

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>idr status</td>
<td>Shows whether IDR is enabled for your instance.</td>
</tr>
<tr>
<td>Producer instance</td>
<td></td>
</tr>
<tr>
<td>producer producer_last_run</td>
<td>The last time the IDRProducerJob ran (GMT).</td>
</tr>
<tr>
<td>producer replication_queue_position</td>
<td>Position of the cursor in the replication queue.</td>
</tr>
<tr>
<td>replication_queue_reading_lag</td>
<td>The time between when a change is made, and when IDRProducerJob sends that change to the network.</td>
</tr>
<tr>
<td>replset last_message_sent_on</td>
<td>The last time data was sent to the network from this replication set.</td>
</tr>
<tr>
<td>replset last_position</td>
<td>The cursor position in the data_replication_queue when the last message was sent for this replication set.</td>
</tr>
<tr>
<td>last_sent_message_id</td>
<td>The message ID of the last sent message from the data_replication_queue.</td>
</tr>
<tr>
<td>name</td>
<td>The name of the replication set.</td>
</tr>
<tr>
<td>status</td>
<td>The replication set status.</td>
</tr>
<tr>
<td>topic_name</td>
<td>The topic name in the message queue for this replication set.</td>
</tr>
<tr>
<td>Consumer instance</td>
<td></td>
</tr>
</tbody>
</table>
### IDR Metrics (continued)

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>consumer_last_run</td>
<td>The last time IDRConsumerJob ran (GMT).</td>
</tr>
<tr>
<td>replset data_lag</td>
<td>Time since the last heartbeat was received. Heartbeats should occur every minute for a replication set.</td>
</tr>
<tr>
<td>last_heartbeat_received_on</td>
<td>Time of the last heartbeat for this replication set</td>
</tr>
<tr>
<td>last_message_received_network_time</td>
<td>For the last received message, time difference between when it was sent to the message queue and when it was picked up by the consumer instance.</td>
</tr>
<tr>
<td>replset last_position</td>
<td>The cursor position in the data_replication_queue, at which the last message was sent for this replication set.</td>
</tr>
<tr>
<td>name</td>
<td>The name of the replication set.</td>
</tr>
<tr>
<td>status</td>
<td>The replication set status.</td>
</tr>
<tr>
<td>topic_name</td>
<td>The topic name in the message queue for this replication set.</td>
</tr>
</tbody>
</table>

### Adapter descriptions for Instance Data Replication (IDR)

During replication, adapters modify the producer data before inserting the data on consumer instances.

#### Adapter fields

Each adapter has **Name** and **Description** fields. The name appears in the Adapter column. Use the **Description** field to explain the purpose of the data conversion.

#### Calculation adapter

Use the calculation adapter on the producer data to specify the operation and the value that is used in the operation.
**Parameter examples**

<table>
<thead>
<tr>
<th>Parameter and value</th>
<th>Source data</th>
<th>Adapter output</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operation</strong>: Multiply</td>
<td>10</td>
<td>10.80</td>
</tr>
<tr>
<td><strong>Constant Value</strong>: 1.08</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Operation</strong>: Max</td>
<td>1020</td>
<td>1000</td>
</tr>
<tr>
<td><strong>Constant Value</strong>: 1000</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Operation</strong>: Floor</td>
<td>5.5</td>
<td>5</td>
</tr>
<tr>
<td><strong>Constant Value</strong>: 0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Max** specifies the highest and **Min** specifies the lowest possible values. Values above or below those limits are set to those limits. Value types such as **int** and **long** have maximum and minimum values. Values above or below those limits cause precision errors.

**Concatenate String adapter**
Use the concatenate string adapter to append a specified string to the source data.

**Parameter example**

<table>
<thead>
<tr>
<th>Parameter and value</th>
<th>Source data</th>
<th>Adapter output</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>String</strong>: _v2</td>
<td>Patch10236</td>
<td>Patch10236_v2</td>
</tr>
</tbody>
</table>

**Fixed-width format adapter**
Use the fixed-width format adapter to reformat fixed-width input data. Use # to represent any positive integer, @ to represent any character, and \ as the literal escape character.

**Parameter examples**

<table>
<thead>
<tr>
<th>Parameter and value</th>
<th>Source data</th>
<th>Adapter output</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Match</strong>: #########</td>
<td>7605551212</td>
<td>(760) 555-1212</td>
</tr>
<tr>
<td><strong>Output</strong>: (####) ####-#####</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Match</strong>: ######</td>
<td>10000</td>
<td>100.00</td>
</tr>
<tr>
<td><strong>Output</strong>: ###.,###</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Match</strong>: ##.,###</td>
<td>10,000</td>
<td>10000</td>
</tr>
</tbody>
</table>
**Parameter examples (continued)**

<table>
<thead>
<tr>
<th>Parameter and value</th>
<th>Source data</th>
<th>Adapter output</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Map</strong>: PRB=TASK, done=complete</td>
<td>PRB</td>
<td>TASK</td>
</tr>
<tr>
<td><strong>Map</strong>: PRB=TASK, done=complete</td>
<td>done</td>
<td>complete</td>
</tr>
<tr>
<td><strong>Map</strong>: PRB=TASK, done=complete</td>
<td>PRB1000</td>
<td>(no mapping)</td>
</tr>
</tbody>
</table>

**Map adapter**

Use the map adapter for comma-separated pairs of literals to map source-to-target conversions. Matches must be exact. For example, PRB=TASK would not convert PRB1000 to TASK1000.

**Pattern adapter**

Use the pattern adapter for regular expressions to identify input patterns. Use parentheses in the **Regex** to identify groups. In **Output Pattern**, use $\$0$ to specify groups. $\$1$ represents the entire input, $\$1$ represents the first group, $\$2$ represents the second group, and so on. You can also insert, prefix, and append literal characters, including spaces so they appear in the adapter output.

---

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
In the second example, the match is ABC followed by two letters, followed by ABC and two letters. $1$ of this input is ABCDE. $2$ of this input is ABCFG. $0$ is the entire input string. So $1$ $0$ is ABCDE ABCDEABCFG.

**Replace adapter**

Use the replace adapter to replace a specified input string or substring with a specified string. Use $ to replace only some of the occurrences of the string. $1$ replaces only the first occurrence; $2$ replaces only the second. Use curly braces to replace the first $N$ occurrences. For example, ${3}$ replaces the first three occurrences.

<table>
<thead>
<tr>
<th>Parameter and value</th>
<th>Source data</th>
<th>Adapter output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find: London</td>
<td>The product is London. The product is London.</td>
<td>The product is Madrid. The product is Madrid.</td>
</tr>
<tr>
<td>Replace: Madrid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Find: $2$ London</td>
<td>The product is London. The product is London.</td>
<td>The product is London. The product is London.</td>
</tr>
<tr>
<td>Replace: Madrid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Find: $(2)$ London</td>
<td>The product is London. The product is London.</td>
<td>The product is Madrid. The product is Madrid.</td>
</tr>
<tr>
<td>Replace: Madrid</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Split adapter**

Use the split adapter for a specified delimiter, such as a space, to break a string into two or more strings. In **Output Pattern**, use $ to specify groups. $0$ represents the entire input, $1$ represents the first group, $2$ represents the second group, and so on. You can repeat a group in an output pattern, for example, $2$, $1$, $1$. Multiple instances of a delimiter in source data create three or more groups.

<table>
<thead>
<tr>
<th>Parameter and value</th>
<th>Source data</th>
<th>Adapter output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delimiter: &quot; &quot;</td>
<td>John Smith</td>
<td>Smith, John</td>
</tr>
</tbody>
</table>
### Parameter examples (continued)

<table>
<thead>
<tr>
<th>Parameter and value</th>
<th>Source data</th>
<th>Adapter output</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Output Pattern:</strong> $2, $1</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Delimiter:</strong> &quot; &quot;</td>
<td>John Harry Smith</td>
<td>Harry, John, John</td>
</tr>
<tr>
<td><strong>Output Pattern:</strong> $2, $1, $1</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Delimiter:</strong> &quot; &quot;</td>
<td>John Harry Smith</td>
<td>Smith</td>
</tr>
<tr>
<td><strong>Output Pattern:</strong> $3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Task number adapter

Use the task number adapter to add a prefix or suffix to a task number or replace the task number's prefix.

#### Parameter examples

<table>
<thead>
<tr>
<th>Parameter and value</th>
<th>Source data</th>
<th>Adapter output</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Modification:</strong> Replace</td>
<td>PRB80899</td>
<td>STRY80899</td>
</tr>
<tr>
<td><strong>Number Prefix:</strong> PRB</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>New Number Prefix:</strong> STRY</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Modification:</strong> Add Prefix</td>
<td>08099</td>
<td>STRY80899</td>
</tr>
<tr>
<td><strong>Prefix:</strong> STRY</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Time zone conversion adapter

Use the time zone conversion adapter to convert one time zone to another.

#### Parameter example

<table>
<thead>
<tr>
<th>Parameter and value</th>
<th>Source data</th>
<th>Adapter output</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Output time zone:</strong> PDT</td>
<td>07:00:00 am GMT</td>
<td>00:00:00 am PDT</td>
</tr>
</tbody>
</table>

### Instance Data Replication (IDR) and tables on an exclusion list

Some tables can't be included in IDR replication sets. Child tables of tables on the exclusion list are also excluded.

#### Excluded tables

These tables are excluded from IDR:
• Tables with the prefixes V_PREFIX, SYSX_, sys, ts_, ua_, usageanalytics_, wf_, ecc_, clone_, jrobin_, rrd_, imp_, pf_, pfd_, idr_
  sys_domain is an exception.
• Rotated tables, including syslog, sys_querystat, ecc_queue, ecc_event, cmdb_metric, sysevent
• Tables without a sys_id
• sso_federation
• saml2_update1_properties
• sso_properties
• digest_properties
• Instance

IntegrationHub

Automate integration tasks using ServiceNow components for Flow Designer, or develop custom integrations. A separate subscription is required.

Capabilities

IntegrationHub enables execution of third-party APIs as a part of a flow when a specific event occurs in ServiceNow. These integrations, referred to as spokes, are easy to configure and enable you to quickly add powerful actions without the need to write a script. For example, you can post a message and incident details in a Slack channel when a high priority incident is created.

IntegrationHub provides the following functionality:

**Spokes for base system integrations**

Using IntegrationHub actions in Flow Designer, you can:

• Post messages and ServiceNow incident, problem, and change record details to Slack spoke v1.5.6, or Microsoft Teams spoke communications channels.
• Synchronize data across multiple production instances using IntegrationHub Remote Process Sync.

Create custom integrations

Build custom integrations with Action Designer using a REST step or a Script step.

Automate the administration of servers and applications in your network
Use custom actions to delegate Flow Designer processes to a MID Server in your network. For example, actions that use the PowerShell step or REST step.

Watch this video to learn how to send data to a third-party system using IntegrationHub.

Integrating data with third-party systems using the Slack Webhooks spoke.

**Connection and Credentials**

IntegrationHub takes advantage of aliases to manage connection information and credentials when integrating with external systems. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. IntegrationHub only requires an alias, which then resolves to use the correct credentials and connection information during runtime. Learn more about credentials, connections, and aliases.

**Benefits**

IntegrationHub provides process owners and developers these benefits.

- Consolidates multiple Now Platform automation capabilities into a single environment so process owners and developers can build and visualize business processes and integrations from a single interface.
- Extends Flow Designer content to integrate business processes with external systems.
- Promotes business process automation by enabling subject matter experts to develop and share spokes with flow designers.
- Provides natural-language-descriptions of integration logic to help non-technical users understand triggers, actions, inputs, and outputs.

**Development process**

When developing a custom integration, develop all actions for the integration within a scoped application. When deployed to a target instance, these actions are grouped as a spoke in Flow Designer. Brand the spoke by adding a custom icon to the application record. To learn more about application development, see Applications.

When developing spokes, flow and action designers typically perform these application development tasks.

1. Create a scoped application on a development instance to build spokes.
2. Publish a test version of the scoped application to the application repository.
3. Deploy the scoped application to a test instance from the application repository.

4. Test the scoped application on the test instance.

5. When working as expected, publish the scoped application in one of the following ways.
   - Publish to the application repository for deployment on production instances.
   - Publish to the ServiceNow Store as an application that customers can request for their environments.
   - Publish to ServiceNow Share to provide content to other customers in the ServiceNow community.

Review Flow Designer design considerations in the Architecture Overview.

**Request IntegrationHub**

ServiceNow® IntegrationHub lets you build reusable integrations with third-party systems and call them from anywhere in the Now Platform. For example, you can request IntegrationHub to call external systems using integration APIs from the Action Designer Script step, run the Script step on the ServiceNow® MID Server, and activate protocol steps like REST, SOAP, and PowerShell.

Flow Designer is a Now Platform feature that enables you to automate processes within a single instance. Without an IntegrationHub subscription, you can use base system actions or steps, including the Script step, to manipulate records, send emails, trigger notifications, and perform operations within the instance. Request IntegrationHub to automate and create integrations with external systems from the Flow Designer interface.

**IntegrationHub usage and subscription**

Choose an IntegrationHub subscription package to build reusable integrations with third-party systems. Review the usage dashboard to determine the number of transactions used within your current subscription, and to view transaction details.

**IntegrationHub subscription packages**

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Starter</th>
<th>Standard</th>
<th>Professional</th>
<th>Enterprise</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build your own integrations.</td>
<td>Automate developer operations.</td>
<td>Automate IT operations.</td>
<td>Automate human resources,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Starter</td>
<td>Standard</td>
<td>Professional</td>
<td>Enterprise</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------</td>
<td>----------</td>
<td>--------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td><strong>Maximum transactions</strong></td>
<td>1,000,000</td>
<td>1,500,000</td>
<td>3,000,000</td>
<td>6,000,000</td>
</tr>
<tr>
<td><strong>Spokes included</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>AI Search</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Calendly</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cisco Webex Meetings</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Continuous Integration and Continuous Delivery (CI/CD)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Google Cloud Load Balancer</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Google Cloud Pub Sub</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Google Hangouts</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>GoTo</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microsoft Azure Cosmos DB</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microsoft Teams</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Aha!</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Box</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>BMC Remedy</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Confluence Cloud</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Google Cloud Translator Service</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Google Calendar</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Google Directory</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Google Docs</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Google Drive</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Google Sheets</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Google Tasks</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Adobe Experience Platform</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Adobe Sign</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Amazon CloudWatch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Amazon Connect</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Amazon DynamoDB</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Amazon EC2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Amazon VPC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Amazon EBS</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Amazon RDS</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Amazon S3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Amazon SNS</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>AWS IAM</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## IntegrationHub subscription packages (continued)

<table>
<thead>
<tr>
<th></th>
<th>Starter</th>
<th>Standard</th>
<th>Professional</th>
<th>Enterprise</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Microsoft Teams Graph</td>
<td></td>
<td>• Gmail</td>
<td>• AWS Lambda</td>
</tr>
<tr>
<td></td>
<td>• Miro</td>
<td></td>
<td>• Microsoft Active Directory</td>
<td>• AWS Elastic Beanstalk</td>
</tr>
<tr>
<td></td>
<td>• monday.com</td>
<td></td>
<td>• Microsoft Azure Active</td>
<td>• AWS Elastic Load Balancing</td>
</tr>
<tr>
<td></td>
<td>• PagerDuty</td>
<td></td>
<td>Directory</td>
<td>• AWS CloudFormation</td>
</tr>
<tr>
<td></td>
<td>• Plivo</td>
<td></td>
<td>• Microsoft Exchange Online</td>
<td>• Amazon Route53</td>
</tr>
<tr>
<td></td>
<td>• ServiceNow ebonding</td>
<td></td>
<td>• Microsoft Exchange Server</td>
<td>• Automation Anywhere</td>
</tr>
<tr>
<td></td>
<td>• ServiceNow Remote Instance</td>
<td></td>
<td>• Microsoft OneDrive</td>
<td>• Azure Blob Storage</td>
</tr>
<tr>
<td></td>
<td>• Slack</td>
<td></td>
<td>• Microsoft SharePoint</td>
<td>• Azure Traffic Manager</td>
</tr>
<tr>
<td></td>
<td>• Slack Webhooks</td>
<td></td>
<td>• Microsoft Azure Resource</td>
<td>• BigFix Inventory</td>
</tr>
<tr>
<td></td>
<td>• Trello</td>
<td></td>
<td>Management</td>
<td>• Cornerstone</td>
</tr>
<tr>
<td></td>
<td>• Twilio</td>
<td></td>
<td>• Shodan</td>
<td>• Coupa</td>
</tr>
<tr>
<td></td>
<td>• Utility Actions</td>
<td></td>
<td>• Okta</td>
<td>• DocuSign</td>
</tr>
<tr>
<td></td>
<td>• Vonage</td>
<td></td>
<td>• Smartsheet</td>
<td>• First Advantage,</td>
</tr>
<tr>
<td></td>
<td>• Workplace from Facebook</td>
<td></td>
<td>• SurveyMonkey</td>
<td>• Google Cloud Functions</td>
</tr>
<tr>
<td></td>
<td>• Zoom</td>
<td></td>
<td></td>
<td>• Google Cloud Datastore</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Google Cloud Storage</td>
</tr>
</tbody>
</table>
## IntegrationHub subscription packages (continued)

<table>
<thead>
<tr>
<th></th>
<th>Starter</th>
<th>Standard</th>
<th>Professional</th>
<th>Enterprise</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Google Cloud SQL</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Google Cloud</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Virtual Network</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Google Cloud VPC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Google Compute</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Engine</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Google Identity</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>and Access</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Google Persistent</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Kronos</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Microsoft Azure</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Notification Hub</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Microsoft Azure</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Managed Storage</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Microsoft Azure</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Virtual Network</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Microsoft Azure</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SQL</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Microsoft Dynamics</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CRM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## IntegrationHub subscription packages (continued)

<table>
<thead>
<tr>
<th>Protocols included</th>
<th>Starter</th>
<th>Standard</th>
<th>Professional</th>
<th>Enterprise</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOAP step, REST step, Open API support</td>
<td>Starter package + JDBC step</td>
<td>Standard package + PowerShell step, SFTP step, SSH step</td>
<td>Professional package</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Entitlements included</th>
<th>Starter</th>
<th>Standard</th>
<th>Professional</th>
<th>Enterprise</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>None</td>
<td>Orchestration Activity Designer, Activity Packs, and all templates</td>
<td>All Orchestration features, Client Software Distribution, Password Reset</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Features included</th>
<th>Starter</th>
<th>Standard</th>
<th>Professional</th>
<th>Enterprise</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payload Builder step, Retry policies, Remote Tables</td>
<td>Starter package + JSON Parser + XML Parser</td>
<td>Standard package</td>
<td>Professional package + Data Stream actions,</td>
<td></td>
</tr>
</tbody>
</table>
IntegrationHub subscription packages (continued)

<table>
<thead>
<tr>
<th></th>
<th>Starter</th>
<th>Standard</th>
<th>Professional</th>
<th>Enterprise</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>introspection (dynamic inputs and dynamic outputs), and REST API trigger</td>
</tr>
</tbody>
</table>

IntegrationHub usage overview

Navigate to IntegrationHub > IntegrationHub Usage to view the current transaction count for your instance and feature usage.

Request an IntegrationHub plugin

IntegrationHub plugins require a separate subscription and must be activated by ServiceNow personnel.

About this task

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization's production and subproduction instances, generally within a few days.

If you don’t have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps.

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>this plugin to be enabled</td>
<td></td>
</tr>
</tbody>
</table>
### Field Description

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments. |

5. Click **Submit**.

**Related information**

List of plugins (Rome)

**IntegrationHub plugins**

Request IntegrationHub plugins included in your subscription.

<table>
<thead>
<tr>
<th><strong>ServiceNow IntegrationHub plugins</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Plugin</strong></td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Starter Pack Installer [com.glide.hub.integrations]</td>
</tr>
<tr>
<td>Plugin</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Professional Pack Installer</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Enterprise Pack Installer</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Content - Deprecated</td>
</tr>
<tr>
<td>Flow Designer Action Step - Payload Builder</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Action Step - JDBC</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Action Step - REST</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Action Step - PowerShell</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Action Step - SOAP</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Action Step - SSH</td>
</tr>
<tr>
<td>Plugin</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Action Step - XML Parser</td>
</tr>
<tr>
<td>[com.glide.hub.action_step.xmlparser]</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Action Template - Data Stream</td>
</tr>
<tr>
<td>[com.glide.hub.action_type.datastream]</td>
</tr>
<tr>
<td>HipChat Spoke for ServiceNow IntegrationHub [com.sn.hipchat.ah]</td>
</tr>
<tr>
<td>Slack Spoke for ServiceNow IntegrationHub [com.sn.slack.ahv2]</td>
</tr>
<tr>
<td>[com.sn.slack.ah]</td>
</tr>
<tr>
<td>Slack Webhooks Spoke for ServiceNow IntegrationHub [com.sn.slack.ah]</td>
</tr>
<tr>
<td>Microsoft SCCM Spoke for IntegrationHub [com.sn.sccm.spoke]</td>
</tr>
<tr>
<td>Microsoft Teams Spoke for ServiceNow IntegrationHub [com.sn.ms_teams.ah]</td>
</tr>
</tbody>
</table>
### ServiceNow IntegrationHub plugins (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft AD Spoke for IntegrationHub [com.sn.ad.spoke]</td>
<td>Create, delete, and manage objects in Microsoft Active Directory, such as users, groups, and computers.</td>
</tr>
<tr>
<td>Microsoft Azure AD Spoke for IntegrationHub [com.sn.azure_ad.spoke]</td>
<td>Manage users, security groups, and office groups. Apply licenses and provision users in Office 365.</td>
</tr>
<tr>
<td>ServiceNow eBonding Spoke for ServiceNow IntegrationHub [com.glide.sn.ebonding.ah]</td>
<td>The ServiceNow ebonding Spoke for the ServiceNow IntegrationHub provides Actions that enable process analysts to compose flows that help in ebonding with remote ServiceNow instances.</td>
</tr>
<tr>
<td>IntegrationHub Designer Core [com.glide.ihub.designer.core]</td>
<td>Enables automation of data imports through the IntegrationHub - Import environment. Installs with the ServiceNow IntegrationHub Action Template - Data Stream [com.glide.hub.action_type.datastream] plugin.</td>
</tr>
</tbody>
</table>

### Use the IntegrationHub Usage dashboard

This dashboard shows an overview of IntegrationHub usage metrics to show customers how their organization uses IntegrationHub and to support license compliance.

**Before you begin**
Role required: admin, flow designer, action_designer, or flow_operator

**Procedure**

1. To view the dashboard, navigate to **IntegrationHub > IntegrationHub Usage**. The IntegrationHub Usage dashboard displays. The tabs on the dashboard include All, Tx By Spoke, Tx by Calling Spoke, Feature Use by Spoke, and Feature Use By Calling Scope. Reports on these tabs include:
### Orchestration Usage Metrics

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AVG Tx a Month (Last 12 months)</strong></td>
<td>Average number of IntegrationHub transactions per month over the last 12 months.</td>
</tr>
<tr>
<td><strong>Max Tx a Month (Last 12 Months)</strong></td>
<td>Maximum number of IntegrationHub transaction per month over the last 12 months.</td>
</tr>
<tr>
<td><strong>Yearly Tx (Last 12 Months)</strong></td>
<td>Total number of IntegrationHub transactions over the last 12 months.</td>
</tr>
<tr>
<td><strong>Current Tx (Last 30 days)</strong></td>
<td>Total number of IntegrationHub transactions over the last 30 days.</td>
</tr>
<tr>
<td><strong>Transactions by Month for the Last 12 Months</strong></td>
<td>Number of IntegrationHub transactions per month over the last 12 months.</td>
</tr>
<tr>
<td><strong>Transactions by Month for Last 12 Months filtered by IntegrationHub Spoke</strong></td>
<td>Number of IntegrationHub transactions per month over the last 12 months for a selected spoke.</td>
</tr>
<tr>
<td><strong>Transactions by Month for Last 12 Months filtered by Calling Scope</strong></td>
<td>Number of IntegrationHub transactions per month over the last 12 months for a selected calling spoke.</td>
</tr>
<tr>
<td><strong>Usage by Month for Last 12 Months filtered by IntegrationHub Spoke</strong></td>
<td>Number of IntegrationHub license usages per month over the last 12 months for a selected spoke.</td>
</tr>
<tr>
<td><strong>Usage by Month for Last 12 Months filtered by Calling Scope</strong></td>
<td>Number of IntegrationHub license usages per month over the last 12 months for a selected calling spoke.</td>
</tr>
</tbody>
</table>

2. **Optional:** You can add more widgets to the dashboard by clicking the Add Content icon (++) in the upper right corner of the dashboard.

- **Note:** You should not modify the existing tabs in this Dashboard. If you want a different dashboard experience, add a tab and customize that with your usage reports.
IntegrationHub available spokes

Activate spokes to enhance your Flow Designer experience with integration-specific content. Use pre-built flows and actions to automate your integrations or create your own integration automation.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

ℹ️ Note: The IntegrationHub Standard spokes are available to new customers as part of an IntegrationHub Professional subscription. Existing customers can use the spokes as part of an IntegrationHub Standard subscription.

Spokes list and compatibility

<table>
<thead>
<tr>
<th>IntegrationHub subscription</th>
<th>Spoke name</th>
<th>Version</th>
<th>Tested against</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starter</td>
<td>AI Search spoke</td>
<td>• 2.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Rome</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Quebec</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Quebec</td>
<td></td>
</tr>
<tr>
<td>Calendly spoke</td>
<td>Introduced in Quebec</td>
<td></td>
<td>Calendly API v2</td>
</tr>
<tr>
<td>Cisco Webex Meetings spoke</td>
<td>• 1.0.1</td>
<td></td>
<td>Webex Meetings XML API</td>
</tr>
<tr>
<td></td>
<td>◦ Orlando</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cisco WebEx Teams spoke</td>
<td>Introduced in Paris</td>
<td>v1</td>
<td></td>
</tr>
<tr>
<td>Continuous Integration and</td>
<td>Introduced in Orlando</td>
<td></td>
<td>Continuous Integration</td>
</tr>
<tr>
<td>Continuous Delivery (CICD)</td>
<td></td>
<td></td>
<td>and Continuous Delivery (CICD)</td>
</tr>
<tr>
<td>Spoke</td>
<td></td>
<td></td>
<td>REST API version v1</td>
</tr>
<tr>
<td>IntegrationHub subscription</td>
<td>Spoke name</td>
<td>Version</td>
<td>Tested against</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------</td>
<td>---------</td>
<td>----------------</td>
</tr>
</tbody>
</table>
| Google Hangouts spoke v 1.0.2 | • 1.0.2  
  ◦ Orlando  
  ◦ Paris | API version v1 |
| GoTo spoke | Introduced in Quebec | LogMeIn Admin Center v5.29.0 |
| Microsoft Teams spoke | Introduced in Kingston | Microsoft teams API version v1 |
| Microsoft Teams Graph spoke v3.4.0 | • 2.0  
  ◦ Orlando  
  • 1.0.1  
  ◦ Orlando  
  ◦ New York  
  ◦ Madrid | Microsoft Graph REST API version v1.0 and Beta API |
| Miro spoke | Introduced in Quebec | Miro REST API |
| monday.com spoke | Introduced in Quebec | monday.com API v2 |
| PagerDuty spoke | Introduced in Quebec | PagerDuty v1.0.3 |
| Plivo spoke | Introduced in Orlando and Paris | API version v1 |
| ServiceNow Remote Instance spoke | Introduced in Orlando and Paris | Orlando and later |
| Slack spoke v1.5.6 | • 2  
  ◦ Paris  
  • 1.2 | Slack Web API |
### Spokes list and compatibility (continued)

<table>
<thead>
<tr>
<th>IntegrationHub subscription</th>
<th>Spoke name</th>
<th>Version</th>
<th>Tested against</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>◦ Orlando ◦ New York ◦ Madrid</td>
</tr>
<tr>
<td>Trello Spoke</td>
<td>Introduced in Quebec</td>
<td></td>
<td>Twilio base version 2010-04-01, Twilio Messaging version v1, and Twilio Notify version v1</td>
</tr>
<tr>
<td>Twilio spoke v1.1.2</td>
<td>• 1.0.0</td>
<td>◦ Orlando ◦ New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 1.0.0</td>
<td>◦ Orlando ◦ New York</td>
<td></td>
</tr>
<tr>
<td>Vonage spoke v1.0.1</td>
<td>Introduced in Orlando and Paris</td>
<td></td>
<td>• Messages API version v0.1 ◦ Voice API version v1</td>
</tr>
<tr>
<td>Workplace from Facebook v3.0.3</td>
<td>Introduced in Paris</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom spoke v2.0</td>
<td>• 1.0.3</td>
<td>◦ Orlando ◦ New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 1.0.2</td>
<td>◦ Orlando ◦ New York</td>
<td></td>
</tr>
<tr>
<td>Ansible spoke v1.0.2</td>
<td>Introduced in Orlando</td>
<td></td>
<td>Ansible Tower v2</td>
</tr>
<tr>
<td>Azure DevOps Boards spoke v1.6.3</td>
<td>Introduced in Orlando</td>
<td></td>
<td>Azure DevOps Boards REST API version 4.1 and TFS 2018 Update 3</td>
</tr>
<tr>
<td>IntegrationHub subscription</td>
<td>Spoke name</td>
<td>Version</td>
<td>Tested against</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------</td>
<td>--------------------------</td>
<td>---------------------------------</td>
</tr>
</tbody>
</table>
|                             | Docker spoke v1.0.3      | • 1.0.3                  | Docke...
<table>
<thead>
<tr>
<th>IntegrationHub subscription</th>
<th>Spoke name</th>
<th>Version</th>
<th>Tested against</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Jira spoke v3.0.4</td>
<td>• 2.6.7</td>
<td>Jira API version v2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Orlando</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Paris</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2.5.7</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Twitter spoke v1.1.1</td>
<td>• 1.0.1</td>
<td>Twitter API version v1.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Orlando</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ New York</td>
<td></td>
</tr>
<tr>
<td>Professional</td>
<td>Aha! Spoke</td>
<td>Introduced in Quebec</td>
<td></td>
</tr>
<tr>
<td></td>
<td>BMC Remedy spoke v1.1.3</td>
<td>Introduced in Orlando</td>
<td>BMC Remedy AR server version 19.08</td>
</tr>
<tr>
<td></td>
<td>Box spoke v3.0.1</td>
<td>• 2.0.2</td>
<td>Box API version v2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Orlando</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2.0.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Madrid</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1.3.8</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ London</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Confluence Cloud spoke v1.0.2</td>
<td>Introduced in Quebec</td>
<td>Confluence Cloud REST API</td>
</tr>
<tr>
<td></td>
<td>Dropbox Business spoke v1.0.2</td>
<td>Introduced in Orlando</td>
<td>API version v2</td>
</tr>
</tbody>
</table>
## Spokes list and compatibility (continued)

<table>
<thead>
<tr>
<th>IntegrationHub subscription</th>
<th>Spoke name</th>
<th>Version</th>
<th>Tested against</th>
</tr>
</thead>
</table>
|                             | Google Cloud Translator spoke | • 1.0.2  
  ◦ Orlando  
  ◦ New York | Google Translate API  
  version v3beta1 |
|                             | Google Drive spoke v1.3.0 | • 1.0.2  
  ◦ Orlando  
  ◦ Paris  
  ◦ 1.0.1  
  New York | REST API v3.0,  
  Google Drive Open API |
|                             | Gmail spoke | • 1.0.1  
  ◦ Orlando  
  ◦ New York | Gmail API v1.0 |
|                             | Google Calendar spoke v 1.0.3 | • 1.0.1  
  ◦ Orlando  
  ◦ Paris | API version v1 |
|                             | Google Docs spoke | Introduced in Orlando and Paris | API version v1 |
|                             | Google Directory spoke v1.1.0 | Introduced in Orlando | API version v1 |
|                             | Google Sheets spoke | Introduced in Orlando and Paris | API version v4 |
|                             | Google Tasks spoke | • 1.0.1  
  ◦ Orlando  
  ◦ New York | Google Tasks API v1.0 |
<p>|                             | Microsoft AD spoke | Introduced in London | Powershell version 5.0, Microsoft AD 2016 |</p>
<table>
<thead>
<tr>
<th>IntegrationHub subscription</th>
<th>Spoke name</th>
<th>Version</th>
<th>Tested against</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Microsoft Azure AD spoke</td>
<td>Introduced in London</td>
<td>Microsoft Azure API version v1</td>
</tr>
</tbody>
</table>
|                             | Microsoft Dynamics CRM spoke v1.3 | • 1.0.1  
  ◦ Orlando  
  ◦ 1.0.0  
  ◦ New York | Microsoft Dynamics API v9 |
|                             | Microsoft Exchange Online spoke v2.0.2 | • 1.0.0  
  ◦ Orlando  
  ◦ New York | Microsoft Graph REST API v1.0 |
|                             | Microsoft Exchange Server spoke v2.1.1 | • 1.0.3  
  ◦ Orlando  
|                             | Microsoft OneDrive spoke v2.1.0 | • 1.0.1  
  ◦ Orlando  
  ◦ 1.0.0  
  ◦ New York  
  ◦ Madrid | Microsoft Graph API 1.0 |
|                             | Shodan spoke                    | Introduced in Paris and Quebec | |
|                             | Microsoft Azure Resource Management spoke v1.0.5 | Introduced in Orlando | Azure SQL v12 |
|                             | Microsoft SharePoint spoke v2.0.2 | • 1.0.4  
  ◦ Orlando | Microsoft SharePoint Online API version v1 |
<table>
<thead>
<tr>
<th>IntegrationHub subscription</th>
<th>Spoke name</th>
<th>Version</th>
<th>Tested against</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Microsoft 365 Excel spoke</td>
<td>Introduced in Paris</td>
<td>v1.0</td>
</tr>
<tr>
<td></td>
<td>Okta spoke v 4.1.1</td>
<td>• 1.1.1&lt;br&gt;◦ Orlando</td>
<td>Okta API version v1</td>
</tr>
<tr>
<td></td>
<td>Smartsheet spoke</td>
<td>• 2.0.0&lt;br&gt;◦ Quebec&lt;br&gt;• 1.0.0&lt;br&gt;◦ Quebec</td>
<td>Smartsheet v1.0.1</td>
</tr>
<tr>
<td></td>
<td>SurveyMonkey spoke v2.0.2</td>
<td>Introduced in Orlando and Paris</td>
<td>API version v3</td>
</tr>
<tr>
<td>Enterprise</td>
<td>Adobe Experience Platform spoke v2</td>
<td>• 2.0.0&lt;br&gt;◦ Orlando&lt;br&gt;• 1.0.0&lt;br&gt;◦ Orlando&lt;br&gt;◦ New York</td>
<td>Adobe Experience Platform released on September 10, 2019</td>
</tr>
<tr>
<td></td>
<td>Adobe Sign spoke v2</td>
<td>• 1.1.1&lt;br&gt;◦ Orlando&lt;br&gt;◦ New York&lt;br&gt;◦ Madrid&lt;br&gt;• 1.0.2&lt;br&gt;◦ Orlando&lt;br&gt;◦ New York&lt;br&gt;◦ Madrid</td>
<td>Adobe Sign API version v6</td>
</tr>
<tr>
<td>IntegrationHub subscription</td>
<td>Spoke name</td>
<td>Version</td>
<td>Tested against</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------</td>
<td>--------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td></td>
<td>Amazon Connect spoke</td>
<td>Introduced in Paris and Quebec</td>
<td>API Version 2017-08-08</td>
</tr>
<tr>
<td></td>
<td>Amazon DynamoDB spoke</td>
<td>Introduced in Orlando</td>
<td>API version 2012-08-10</td>
</tr>
<tr>
<td></td>
<td>Amazon EBS spoke</td>
<td>Introduced in Orlando</td>
<td>API version 2016-11-15</td>
</tr>
<tr>
<td></td>
<td>Amazon RDS spoke v1.0.1</td>
<td>Introduced in Orlando</td>
<td>API version 2014-09-01 and 2014-10-31</td>
</tr>
<tr>
<td></td>
<td>Amazon S3 spoke v1.0.1</td>
<td>Introduced in Orlando</td>
<td>API version 2010-03-31</td>
</tr>
<tr>
<td></td>
<td>Amazon SNS spoke</td>
<td>• 1.0.0 ° Orlando</td>
<td>API version 2010-03-31</td>
</tr>
<tr>
<td></td>
<td>Amazon Elastic Container Service spoke v1.0.1</td>
<td>Introduced in Orlando and Paris</td>
<td>API version 2014-11-13</td>
</tr>
<tr>
<td></td>
<td>Automation Anywhere spoke v1.0.23</td>
<td>Introduced in Orlando and Paris</td>
<td></td>
</tr>
<tr>
<td></td>
<td>AWS CloudFormation spoke</td>
<td>Introduced in Orlando and Paris</td>
<td>API version 2010-05-15</td>
</tr>
<tr>
<td></td>
<td>AWS Elastic Beanstalk spoke</td>
<td>Introduced in Orlando</td>
<td>API version 2010-12-01</td>
</tr>
<tr>
<td></td>
<td>Amazon VPC spoke v1.0.1</td>
<td>Introduced in Orlando</td>
<td>API version 2016-11-15</td>
</tr>
<tr>
<td></td>
<td>AWS IAM spoke v1.0.2</td>
<td>Introduced in Orlando</td>
<td>API version 2010-05-08</td>
</tr>
<tr>
<td></td>
<td>AWS Elastic Load Balancing spoke</td>
<td>Introduced in Orlando and Paris</td>
<td>API version 2012-06-01</td>
</tr>
</tbody>
</table>
### Spokes List and Compatibility (continued)

<table>
<thead>
<tr>
<th>IntegrationHub subscription</th>
<th>Spoke name</th>
<th>Version</th>
<th>Tested against</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>AWS Lambda spoke v1.1.0</strong></td>
<td>Introduced in Orlando</td>
<td>API version 2010-05-08</td>
</tr>
<tr>
<td></td>
<td><strong>BigFix Inventory spoke v1.0.1</strong></td>
<td>Introduced in Orlando</td>
<td>IBM BigFix Inventory version 9.2.16.0</td>
</tr>
<tr>
<td></td>
<td><strong>Blue Prism spoke v1.0.1</strong></td>
<td>Introduced in Orlando</td>
<td>Blue Prism Process Dispatch Framework version 2.6</td>
</tr>
<tr>
<td></td>
<td><strong>Cornerstone spoke v1.2.1</strong></td>
<td>Introduced in Orlando</td>
<td>Cornerstone version v1</td>
</tr>
<tr>
<td></td>
<td><strong>Coupa spoke v3.0.1</strong></td>
<td></td>
<td>Coupa version stable_025.6.0</td>
</tr>
<tr>
<td></td>
<td><strong>DocuSign spoke v2.0.3</strong></td>
<td>• 1.2.2</td>
<td>DocuSign API version v2 or v2.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Orlando</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1.2.1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Orlando</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>First Advantage spoke v1.5.2</strong></td>
<td>1.0.1</td>
<td>First Advantage API version v1.1</td>
</tr>
<tr>
<td></td>
<td><strong>Google Cloud Datastore spoke</strong></td>
<td>Introduced in Orlando and Paris</td>
<td>API version v1</td>
</tr>
<tr>
<td></td>
<td><strong>Google Cloud DNS spoke</strong></td>
<td>Introduced in Orlando and Paris</td>
<td>API version v1</td>
</tr>
<tr>
<td>IntegrationHub subscription</td>
<td>Spoke name</td>
<td>Version</td>
<td>Tested against</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------</td>
<td>---------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Google Cloud Load Balancer spoke</td>
<td>Introduced in Orlando and Paris</td>
<td>API version v1</td>
</tr>
<tr>
<td></td>
<td>Google Cloud Pub Sub spoke</td>
<td>Introduced in Orlando and Paris</td>
<td>v1</td>
</tr>
<tr>
<td></td>
<td>Google Cloud SQL spoke</td>
<td>Introduced in Orlando and Paris</td>
<td>API version v1beta4</td>
</tr>
<tr>
<td></td>
<td>Google Cloud Storage spoke</td>
<td>Introduced in Orlando</td>
<td>API version v1</td>
</tr>
<tr>
<td></td>
<td>Google Cloud Virtual Network spoke</td>
<td>Introduced in Orlando</td>
<td>API version v1</td>
</tr>
<tr>
<td></td>
<td>Google Compute Engine spoke</td>
<td>Introduced in Orlando</td>
<td>API version v1</td>
</tr>
<tr>
<td></td>
<td>Google Cloud Functions spoke</td>
<td>Introduced in Orlando and Paris</td>
<td>API version v1</td>
</tr>
<tr>
<td></td>
<td>Google Identity and Access spoke</td>
<td>Introduced in Orlando</td>
<td>API version v2 only Folder Management category and API version v1 for other categories</td>
</tr>
<tr>
<td></td>
<td>Google Persistent Disk spoke</td>
<td>Introduced in Orlando</td>
<td>API version v1</td>
</tr>
<tr>
<td></td>
<td>Google Cloud VPC Access spoke</td>
<td>Introduced in Orlando and Paris</td>
<td>API version v1</td>
</tr>
<tr>
<td></td>
<td>UKG spoke v3.2.0</td>
<td>Introduced in Orlando</td>
<td>Kronos version v1</td>
</tr>
<tr>
<td></td>
<td>Microsoft Azure Blob Storage spoke v1.0.4</td>
<td>Introduced in Orlando</td>
<td>API version 2019-07-07</td>
</tr>
<tr>
<td>IntegrationHub subscription</td>
<td>Spoke name</td>
<td>Version</td>
<td>Tested against</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------</td>
<td>---------</td>
<td>----------------</td>
</tr>
<tr>
<td></td>
<td>Microsoft Azure Cosmos DB spoke</td>
<td>Introduced in Orlando and Paris</td>
<td>v1</td>
</tr>
<tr>
<td></td>
<td>Microsoft Azure Managed Storage spoke v1.0.6</td>
<td>Introduced in Orlando and Paris</td>
<td>API version 2019-07-01</td>
</tr>
<tr>
<td></td>
<td>Microsoft Azure Virtual Machine spoke v1.0.3</td>
<td>Introduced in Orlando and Paris</td>
<td>API version 2019-07-01</td>
</tr>
<tr>
<td></td>
<td>Microsoft SCCM spoke</td>
<td>Introduced in Madrid</td>
<td>Microsoft SCCM version 1802</td>
</tr>
<tr>
<td></td>
<td>Pluralsight spoke v1.1</td>
<td>Introduced in Quebec</td>
<td>Pluralsight GraphQL API version v1</td>
</tr>
<tr>
<td></td>
<td>Microsoft Azure SQL spoke v1.0.1</td>
<td>Introduced in Orlando</td>
<td>Azure SQL v12</td>
</tr>
</tbody>
</table>
|                             | Salesforce spoke v2.0.4 | • 2.0.1  
  ◦ Quebec  
  • 1.2  
  ◦ Paris  
  ◦ Orlando | API version v45.0 |
### Spokes list and compatibility (continued)

<table>
<thead>
<tr>
<th>IntegrationHub subscription</th>
<th>Spoke name</th>
<th>Version</th>
<th>Tested against</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Salesforce Marketing Cloud spoke</td>
<td>Introduced in Quebec</td>
<td>Salesforce Marketing Cloud Corporate Edition</td>
</tr>
<tr>
<td></td>
<td>SAP SuccessFactors spoke v3.0.0</td>
<td>Introduced in Orlando and Paris</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Unified Compliance Framework (UCF) spoke</td>
<td>Introduced in Orlando</td>
<td>UCF v2.0</td>
</tr>
<tr>
<td></td>
<td>Workday Financials spoke v1.2.2</td>
<td>Introduced in Orlando</td>
<td>SOAP API version v33.2</td>
</tr>
<tr>
<td></td>
<td>Workday HR spoke v1.5</td>
<td>Introduced in Orlando</td>
<td>SOAP API version v33.2 and REST API version v1</td>
</tr>
<tr>
<td></td>
<td>YouTube spoke</td>
<td>Introduced in Orlando and Paris</td>
<td>• Reporting API version v1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Data API version v3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Analytics API version v2</td>
</tr>
<tr>
<td></td>
<td>UiPath spoke v2.0.1</td>
<td>Introduced in Orlando</td>
<td>• Platform version 2019.4.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Cloud Platform version 2020.1.219</td>
</tr>
</tbody>
</table>

**Note:** The ServiceNow eBonding spoke is included by default in your instance and doesn't require an IntegrationHub or Orchestration subscription.
Adobe Experience Platform spoke v2
Automate the process of managing datasets and entities in Adobe Experience Platform from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Adobe Experience Platform released on September 10, 2019, but may be compatible with later versions.

Spoke requirements
• Registered Adobe ID account
• User with developer access
• Details such as API key and client secret

See the Adobe Experience Platform documentation for instructions on creating Adobe ID and adding developer.

Spoke actions
The Adobe Experience Platform spoke provides actions manage datasets and entities when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dataset Management</td>
<td>Get All Data Inlets</td>
<td>Retrieves the details of all data inlets.</td>
</tr>
<tr>
<td></td>
<td>Get All Datasets</td>
<td>Retrieves the details of all datasets.</td>
</tr>
<tr>
<td></td>
<td>Get All Union Schemas</td>
<td>Retrieves the list of all schemas that are part of unions.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entity Management</td>
<td>Get Entity Information</td>
<td>Retrieves the information of an entity as a dynamic object.</td>
</tr>
<tr>
<td></td>
<td>Load Entity Data</td>
<td>Ingest the information of an entity to Adobe Experience Platform.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get Metadata For All Attributes In A Schema</td>
<td>Retrieves all attributes for the selected union schema.</td>
</tr>
<tr>
<td></td>
<td>Get All Sandboxes</td>
<td>Retrieves information about all active sandboxes.</td>
</tr>
<tr>
<td></td>
<td>Get Metadata For All Data Inlets</td>
<td>Retrieves the metadata of all data inlets.</td>
</tr>
<tr>
<td></td>
<td>Get Metadata For All Datasets</td>
<td>Retrieves the metadata of all datasets.</td>
</tr>
<tr>
<td></td>
<td>Get Metadata For All Fields In A Union</td>
<td>Retrieves the metadata of all fields in the selected union.</td>
</tr>
<tr>
<td></td>
<td>Get Metadata For All Identity Fields</td>
<td>Retrieves the metadata of all identity fields or namespaces.</td>
</tr>
<tr>
<td></td>
<td>Get Metadata For All Union Schemas</td>
<td>Retrieves the list of all schemas that are part of unions.</td>
</tr>
<tr>
<td></td>
<td>Get Metadata For All Unions</td>
<td>Retrieves the metadata of all union views.</td>
</tr>
<tr>
<td></td>
<td>Get Metadata For Union Schema</td>
<td>Retrieves schema for the selected fields of a union.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.
Note: Two connection and credential alias records are needed for the Adobe Experience Platform spoke; one for data inlet management and batch ingestion, and other for data collection. Each alias should be associated with the respective Adobe Experience Platform API.

Set up Adobe Experience Platform spoke
Integrate your Adobe Experience Platform account with your ServiceNow instance. Create a custom OAuth application in Adobe Experience Platform and authenticate requests from ServiceNow.

Before you begin
• Request IntegrationHub subscription
• Activate Adobe Experience Platform spoke
• Role required: admin

About this task
The Adobe Experience Platform spoke can also be set up using the Connection & Credential configuration templates. However, using templates, only one set of alias records can be used at a time.

Attach a Java Key Store certificate to the Adobe Experience Platform spoke
Enable the JWT Bearer Grant token authentication by attaching a valid Java KeyStore (JKS) certificate to the Adobe Experience Platform spoke.

Before you begin
• Valid Java KeyStore certificate
• Role required: admin

Procedure
1. Navigate to System Definition > Certificates.
2. Click New.
3. On the form, fill in the fields.

X.509 Certificate form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, AEP Certificate.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Expiration notification</td>
<td>Option to send a notification when the certificate is about to expire.</td>
</tr>
<tr>
<td>Notify on expiration</td>
<td>Users to be notified when the certificate expires.</td>
</tr>
<tr>
<td>Warn in days to expire</td>
<td>Number of days to send a notification before the certificate expires.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the certificate.</td>
</tr>
<tr>
<td>Format</td>
<td>Certificate format. The instance supports the PEM and DER formats.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of certificate. Select <strong>Java Key Store</strong>.</td>
</tr>
<tr>
<td>Valid from</td>
<td>Date from which the certificate is valid.</td>
</tr>
<tr>
<td>Expires</td>
<td>Date on which the certificate expires.</td>
</tr>
<tr>
<td>Expires in days</td>
<td>Number of days until the certificate expires.</td>
</tr>
<tr>
<td>Key store password</td>
<td>Password associated with the certificate.</td>
</tr>
<tr>
<td>Short description</td>
<td>Summary about the certificate.</td>
</tr>
<tr>
<td>PEM Certificate</td>
<td>Contents of the X509 certificate.</td>
</tr>
</tbody>
</table>

4. Click the attachments icon ( modele) and attach a JKS certificate.

5. Click **Validate Stores/Certificates**.

**Results**
The JKS certificate is created and attached to the Adobe Experience Platform spoke.

**Create a JWT signing key for the Adobe Experience Platform spoke**
Create a JSON Web Token (JWT) signing key to assign to your Java KeyStore certificate.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **System OAuth > JWT Keys**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the JWT signing key. For example, AEP JWT Keys.</td>
</tr>
<tr>
<td>Signing Keystore</td>
<td>Valid JKS certificate attached in the previous task. For example, AEP Certificate.</td>
</tr>
<tr>
<td>Key Id</td>
<td>Key ID to identify which key is used when multiple keys are used to sign tokens.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record. Select Adobe Experience Platform spoke.</td>
</tr>
<tr>
<td>Signing Algorithm</td>
<td>Algorithm to sign with the JWT key.</td>
</tr>
<tr>
<td>Signing Key Password</td>
<td>Password associated with the signing key.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the certificate.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Results**
The JWT key is created and assigned to the JKS certificate.

**Create a JWT provider for the Adobe Experience Platform spoke**
Add a JSON Web Token (JWT) provider to your ServiceNow instance.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **System OAuth > JWT Providers**.
2. Click **New**.
3. On the form, fill in the fields.
### JWT Provider form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the JWT provider. For example, AEP JWT Provider.</td>
</tr>
<tr>
<td>Expiry Interval (sec)</td>
<td>Number in seconds to set the lifespan of JWT provider tokens.</td>
</tr>
<tr>
<td>Signing Configuration</td>
<td>JWT signing key from the previous step. For example, AEP JWT Keys.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**. The Standard Claims and Custom Claims related lists are displayed.

5. Enter values for **iss**, **sub**, and **aud** in the Standard Claims related list. See the Adobe Experience Platform documentation for instructions.

6. Enter these values in the Custom Claims related list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Claim Name</td>
<td><a href="https://ims-na1.adobelogin.com/s/entdataservices_sdk">https://ims-na1.adobelogin.com/s/entdataservices_sdk</a></td>
</tr>
<tr>
<td>Claim Value Type</td>
<td>true</td>
</tr>
<tr>
<td>Claim Value</td>
<td>true</td>
</tr>
</tbody>
</table>

7. Click **Update**.

**Results**

The JWT provider is added to your ServiceNow instance.

### Register Adobe Experience Platform as OAuth Provider

Use the information generated during Adobe ID account creation and configuration to register Adobe Experience Platform as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System OAuth > Application Registry**.

2. Click **New**.

   The system displays the message **What kind of OAuth application?**
3. Select **Connect to a third party OAuth Provider**. The system displays a blank Application Registries form.

4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter <strong>AEP OAuth</strong>.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Consumer key you generated during the Adobe ID account configuration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Consumer secret you generated during the Adobe ID account configuration.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Script to customize the request and response. Select <strong>OAuthUtilAEP</strong>.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Grant type used to establish the token. Select <strong>JWT Bearer</strong>.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>Time, in seconds, that the refresh token is valid. The default time is 8,640,0000 seconds.</td>
</tr>
<tr>
<td>PKCE required</td>
<td>Option to enable public clients to require PKCE for an authorization.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record. Select Adobe Experience Platform.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Application scope that this registry is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>This field should be left blank.</td>
</tr>
</tbody>
</table>

**Note:** You can use only **Authorization Code** as the **Default Grant type** when **PKCE** is enabled.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Token Revocation URL</td>
<td>This field should be left blank.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>This field should be left blank.</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use mutual authentication for token request and revocation. This option requires a mutual authentication profile to be specified.</td>
</tr>
<tr>
<td>Send Credentials</td>
<td>Client credentials in the request.</td>
</tr>
</tbody>
</table>

5. Right-click the form header, and click **Save**.
   - The system validates the OAuth credentials and populates the **Redirect URL**.
   - The system populates **OAuth Entity Profile** with **Grant Type** as **JWT Bearer**. For example, **OAuth Entity Profile** is created with default **Name**, **AEP default_profile**

6. Open the record of OAuth Entity Profile.

7. Select the JWT Provider record for **JWT Provider**. For example, **AEP JWT Provider**.

8. Click **Update**.

**Results**

The instance can request OAuth 2.0 tokens for the spoke.

ℹ️ **Note:** When an OAuth token expires, the spoke automatically regenerates a new token in most cases. If a token expires and is not regenerated, an administrator can regenerate the spoke OAuth token.

**Create Credential records for the Adobe Experience Platform**

Create Credential records to the Adobe ID account you created. The Adobe Experience Platform spoke connection and credential alias uses these credentials to authorize actions.

**Before you begin**

Role required: admin

**About this task**

You must create two credential records; one for data inlet management and batch ingestion, and other for data collection.
Procedure

1. Navigate to Connections & Credentials > Credentials.

2. Click New.
   The system displays the message What type of Credentials would you like to create?

3. Select OAuth 2.0 Credentials.
   The pop-up window displays a blank OAuth 2.0 Credentials form.

4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter AEP for data inlet management and batch ingestion, and AEP_Ingestion for data collection.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile you created when you registered the Salesforce connected app as an OAuth provider. For example, select AEP OAuth default_profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>This field isn't applicable.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Save the record.

6. Click the Get OAuth Token related link to generate the OAuth token.

Results
The credential records for the Adobe Experience Platform spoke is created.

Create Connection records for the Adobe Experience Platform spoke
Create Connection records to your Adobe ID account. The Adobe Experience Platform spoke connection and credential alias uses these connections to perform actions in Adobe Experience Platform.

Before you begin
Role required: admin

About this task
Two connection and credential alias records are available by default; one for data inlet management and batch ingestion, and other for data collection.
Perform these steps to associate each alias with the respective Adobe Experience Platform API.

**Procedure**

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open the required Adobe Experience Platform spoke record.

   🔄 **Note:** There are two connection and credential records: **AEP** and **AEP_Ingestion**. The **AEP** record is for data inlet management and batch ingestion, and **AEP_Ingestion** is for data collection.

3. From the **Connections** tab, click **New**.
   The system displays a blank HTTP(s) Connection form.

4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter <strong>AEP Platform</strong> for data inlet management and batch ingestion, and <strong>AEP dcs</strong> for data collection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Adobe Experience Platform. For example, select <strong>AEP</strong> and <strong>AEP_Ingestion</strong>.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td>🔄 <strong>Note:</strong> Do not select the check box.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to Adobe Experience Platform.</td>
</tr>
<tr>
<td></td>
<td>• If the connection record is for data inlet management and batch ingestion, enter <strong><a href="https://platform.adobe.io/">https://platform.adobe.io/</a></strong>.</td>
</tr>
<tr>
<td></td>
<td>• If the connection record is for data collection, enter <strong><a href="https://dcs.adobedc.net">https://dcs.adobedc.net</a></strong>.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>This field isn’t applicable.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

5. In the **Attributes** tab enter these values.
• Internal name of the sandbox in Sandbox.

  Note: Ensure that you provide the internal name of the required sandbox and not its label in Sandbox. To obtain the internal name of the required sandbox, use the Get All Sandboxes action.

• If the connection record is for data inlet management and batch ingestion, enter API Key and Organization ID.

• If the connection record is for streaming ingestion, enter Organization ID.

6. Right-click the form header and click Save.

Results
The Adobe Experience Platform spoke is set up and integrated with the ServiceNow instance.

Adobe Sign spoke v2
Automate the process of sending a legal document to an individual or list of recipients for digital signature using Adobe Sign. For example, automate employee onboarding and offboarding, or sending non-disclosure agreements, legal agreements, and statements of work for digital signature. Use ServiceNow data in document templates and enable users to upload documents for signature as needed.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Compatible versions
This spoke was built for Adobe Sign API version v6, but may be compatible with later versions.

Key features
Adobe Sign spoke enables a flow designer to:

• Automate the process of sending a legal document to an individual or list of recipients for digital signature.
• Copy and customize sample flows for sending transient documents or Adobe Sign library documents for digital signature.
• Discover and synchronize the Adobe Sign documents.
• Pause a flow until an agreement or document is signed. A scripted REST API webhook waits for the recipient to sign the document.
• Use values from a signed document in a flow.
• Manage the life cycle of documents in Adobe Sign from the ServiceNow instance.

Spoke requirements
• Adobe Sign account
• Adobe Sign account admin credentials to perform the required account specific tasks in Adobe Sign
• Adobe Sign group admin credentials to perform the required group specific tasks in Adobe Sign

Note: Account admin or group admin can add users to the groups. These users can access information specific to their group only.

• Adobe Sign application configured to integrate with ServiceNow
• Adobe Sign application details such as application ID and client secret.
• ServiceNow admin credentials to create and synchronise the required Adobe Sign groups with ServiceNow
Note:

- This is the default admin role that is created when the Adobe Sign spoke is activated.
- ServiceNow admin has access to information about all Adobe Sign groups synchronized with ServiceNow and all tables part of the Adobe Sign spoke.
- User role specific to the group is created in ServiceNow, when the group is created in the ServiceNow instance. Group users have access to information specific to their Adobe Sign groups only and can view only the group-specific data from the tables that are part of the Adobe Sign spoke.

• IntegrationHub subscription

See the Adobe Sign development documentation for instructions on creating and configuring custom applications.

Spoke flows

The Adobe Sign spoke provides sample flows to demonstrate automating the Adobe Sign tasks. To customize a sample flow, copy it to the required application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe Sign - Send NDA Demo</td>
<td>Sends a statement of work for digital signature using a Adobe Sign library document when a Service Catalog request is created by the Adobe Sign - Statement of Work Demo item. Before using this flow, activate the Adobe Sign - Statement of Work Demo catalog item.</td>
</tr>
<tr>
<td>Adobe Sign - Statement of Work Demo</td>
<td>Sends a non-disclosure agreement for digital signature using a Adobe Sign library document when a Service Catalog request is created by the Adobe Sign - Statement of Work Demo item. Before using this flow, activate the Adobe Sign - Statement of Work Demo catalog item.</td>
</tr>
</tbody>
</table>

The Adobe Sign spoke adds catalog items for use with the Adobe Sign spoke sample flows. Before triggering an Adobe Sign spoke sample flow, activate these catalog items.
## Catalog item

<table>
<thead>
<tr>
<th>Catalog Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe Sign - Send NDA Demo</td>
<td>Sends a non-disclosure agreement for digital signature using a Adobe Sign library document.</td>
</tr>
</tbody>
</table>

## Spoke subflows

The Adobe Sign spoke provides a sample subflow to demonstrate automating Adobe Sign tasks. To customize the sample subflow, copy it to a new application scope. Available sample subflow is, Get Documents Per Group. The subflow retrieves documents relevant to an Adobe Sign group and stores them in the AdobeSign Documents table.

## Spoke actions

The Adobe Sign spoke provides actions to automate Adobe Sign tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Management</td>
<td>Attach Adobe Sign Document To Agreement Record</td>
<td>Downloads an Adobe Sign document and attaches it to the relevant ServiceNow agreement record.</td>
</tr>
<tr>
<td></td>
<td>Convert Transient to Library Document</td>
<td>Converts a transient document to a library document. Ensures that the document is available in the library for more than the stipulated transient 7-day purging period.</td>
</tr>
<tr>
<td></td>
<td>Get Library Documents</td>
<td>Discovers the documents and document templates from Adobe Sign. Populates ServiceNow tables with the document names and descriptions.</td>
</tr>
</tbody>
</table>

**Note:** Access to the documents is based on the group user roles.

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lookup</td>
<td>Agreement ID</td>
<td>Retrieves the agreement ID from the ServiceNow Agreement table.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Look up Agreements Stream</td>
<td>Retrieves the list of agreements.</td>
<td></td>
</tr>
<tr>
<td>Look Up Library Document ID</td>
<td>Retrieves the library document ID from the ServiceNow Documents table.</td>
<td></td>
</tr>
<tr>
<td>Look up Library Documents Stream</td>
<td>Retrieves the list of library documents.</td>
<td></td>
</tr>
<tr>
<td>Set Agreement Field</td>
<td>Creates a list of fields for a draft agreement.</td>
<td></td>
</tr>
<tr>
<td>Upload Attachment As Transient Document</td>
<td>Uploads an attachment to Adobe Sign as a transient document. The transient document is available for a period of 7 days.</td>
<td></td>
</tr>
<tr>
<td>Signature Management</td>
<td>Add Participant to Agreement</td>
<td>Builds a participant list iteratively over time and adds a participants to the local ServiceNow agreement record.</td>
</tr>
<tr>
<td>Check Agreement Status</td>
<td>Retrieves the status of an agreement.</td>
<td></td>
</tr>
<tr>
<td>Create Draft Agreement</td>
<td>Creates an agreement in the draft state in Adobe Sign and draft record in the ServiceNow Agreement table.</td>
<td></td>
</tr>
<tr>
<td>Finalize Draft and Send Agreement</td>
<td>Sends a draft agreement to the participant list for signature.</td>
<td></td>
</tr>
<tr>
<td>Get Form Field Value From An Agreement</td>
<td>Retrieves value of the required field from an existing agreement in Adobe Sign.</td>
<td></td>
</tr>
<tr>
<td>Get Signing URL</td>
<td>Creates an embedded signing URL for in-person signing.</td>
<td></td>
</tr>
<tr>
<td>Cancel Agreement</td>
<td>Cancels an agreement that has been sent for signature.</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Wait For Signature From Adobe Sign</td>
<td>Waits for the Adobe Sign webhook until the participant has either signed or rejected the document. Updates the status in the ServiceNow Agreement table.</td>
</tr>
<tr>
<td></td>
<td>Look up Form Field Value from an Agreement</td>
<td>Retrieves value of the required field from an existing agreement in Adobe Sign.</td>
</tr>
<tr>
<td></td>
<td>Look up Signing URL</td>
<td>Retrieves an embedded signing URL. This is useful for scenarios involving in-person signing.</td>
</tr>
<tr>
<td></td>
<td>Send Agreement</td>
<td>Sends document for signature to one or more participants.</td>
</tr>
<tr>
<td>User Management</td>
<td>Activate A User</td>
<td>Activates an existing user in Adobe Sign.</td>
</tr>
<tr>
<td></td>
<td>Deactivate A User</td>
<td>Deactivates an existing user in Adobe Sign.</td>
</tr>
<tr>
<td></td>
<td>Lookup User ID by Email</td>
<td>Retrieves the user ID of an existing user in Adobe Sign.</td>
</tr>
<tr>
<td></td>
<td>Look up Users Stream</td>
<td>Retrieves the list of all users.</td>
</tr>
<tr>
<td>Webhook Management</td>
<td>Create Webhook</td>
<td>Creates a webhook to notify the signing events in Adobe Sign.</td>
</tr>
<tr>
<td></td>
<td>Remove Webhook</td>
<td>Removes a webhook from Adobe Sign.</td>
</tr>
<tr>
<td></td>
<td>Look up Webhooks Stream</td>
<td>Retrieves the list of webhooks.</td>
</tr>
<tr>
<td>MegaSigns Management</td>
<td>Cancel MegaSigns</td>
<td>Cancels the MegaSigns that are already out for signature.</td>
</tr>
<tr>
<td></td>
<td>Check MegaSigns Status</td>
<td>Checks the status of a MegaSigns record.</td>
</tr>
<tr>
<td></td>
<td>Create Draft MegaSigns</td>
<td>Creates a MegaSigns record in the draft state.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Download Participants and Merge Fields for Document</td>
<td>Download a sample CSV file for a given library document that contains information about the MegaSigns participants and form fields.</td>
<td></td>
</tr>
<tr>
<td>Look up MegaSigns Stream</td>
<td>Retrieves the list of all MegaSigns records.</td>
<td></td>
</tr>
<tr>
<td>Send MegaSigns</td>
<td>Finalises the draft and sends the MegaSigns attachment out for signature.</td>
<td></td>
</tr>
<tr>
<td>Wait for Signature of MegaSigns from Adobe Sign</td>
<td>Waits for the Adobe Sign webhook till all the participants sign or cancel the document.</td>
<td></td>
</tr>
</tbody>
</table>

**Spoke module**

The Adobe Sign spoke adds a Adobe Sign module to your ServiceNow instance. The Adobe Sign spoke synchronizes and stores information about groups, documents, and agreements in ServiceNow. The Adobe Sign spoke includes these tables.

- Agreements [sn_adobesign_spoke_agreement]
- Documents [sn_adobesign_spoke_adobe_sign_documents]
- Groups [sn_adobesign_spoke_adobesign_group_details]
- Client Details [sn_adobesign_spoke_client_details]

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Fields</th>
</tr>
</thead>
</table>
| Agreements     | Adobe Sign agreements from the synchronized Adobe Sign groups and accounts. Records in the Agreements table are updated with the signing status only when webhook is configured. | • Name  
• Agreement ID  
• Declined Reason  
• Status  
• Participants Info  
• Form Fields Info |
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Fields</th>
</tr>
</thead>
</table>
| **Documents** | Adobe Sign documents from the synchronized Adobe Sign groups and accounts. To synchronize accounts, see [Synchronize Adobe Sign with ServiceNow](#). The Get Documents Per Group subflow retrieves a list of documents in each Adobe Sign group. | • Next Signer  
• Group Name |
| **Groups**   | Adobe Sign groups that are synchronized with ServiceNow. Administrator creates groups in the ServiceNow instance and provides the required details to synchronize with Adobe Sign. | • Group Name  
• Group ID  
• Connection Alias |

### Note: Access to the documents is based on the group user roles.

### Note: User role is created when an Adobe Sign group is created in the ServiceNow instance. Users with the group-specific role can access the documents and agreements relevant to the Adobe Sign group.
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client Details</td>
<td>Credentials of the Adobe Sign groups that are synchronized with ServiceNow.</td>
<td>• Client ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Authentication Key</td>
</tr>
<tr>
<td>MegaSigns</td>
<td>Adobe Sign MegaSigns from the synchronized Adobe Sign groups and accounts.</td>
<td>• Status</td>
</tr>
<tr>
<td></td>
<td>Records in the MegaSigns table are updated with the signing status only when</td>
<td>• Signed Participants</td>
</tr>
<tr>
<td></td>
<td>webhook is configured for the Adobe Sign account.</td>
<td>• Number of Pending Signatures</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MegaSigns ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Group Name</td>
</tr>
</tbody>
</table>

### Groups and user roles

Create a group in your ServiceNow instance to synchronize the group with the corresponding group in Adobe Sign.

User role specific to the group is created in ServiceNow, when the group is created in the ServiceNow instance. For example, a HR group user role, sn_adobesign_spoke.HR, is created when the HR group is created in ServiceNow. ServiceNow admin can assign these group user roles to users and control access to the group-specific information such as:

- Documents and agreements
- Connection and credential aliases
- Credential records
- Application registries
- Data in tables of the Adobe Sign spoke

To run flows and subflows, group users must also have these roles:

- connection_admin
- credential_admin
- flow_designer
- oauth_admin
- script_debugger
- view_changer
Only ServiceNow admin has access to information about all Adobe Sign groups that are synchronised with the ServiceNow instance.

Adobe Sign account requirements
The Adobe Sign spoke requires creating a custom app on your Adobe Sign account to generate OAuth 2.0 tokens.

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Note: A connection and credential alias is specific to a group in Adobe Sign.

A sample connection and credential alias is provided for demonstration purpose. ServiceNow admin must create an alias for each Adobe Sign group to synchronize that group with the ServiceNow instance. For example, you can have different connection and credential alias records one for each BU in your organization such as HR, Legal, Finance and so on.

Synchronize Adobe Sign group with ServiceNow
Synchronize ServiceNow with the required group in Adobe Sign to access the group specific documents, and agreements from the Adobe Sign spoke.

Before you begin
- Request IntegrationHub subscription
- Activate the Adobe Sign spoke
- Role required: admin

About this task
These steps are performed to synchronize only one Adobe Sign group. To synchronize another Adobe Sign group, repeat this process.

Create custom OAuth application in Adobe Sign account
Create a custom OAuth application from your Adobe Sign account to enable OAuth 2.0 authentication with the Adobe Sign spoke.
Before you begin

- Adobe Sign account
- Adobe Sign admin credentials

About this task
Complete these steps from your Adobe Sign account. See the Adobe Sign development documentation for instructions on creating and configuring custom applications.

Procedure
1. From your Adobe Sign account, create an application.
2. Copy and record the Application ID and Application Secret for later use. These details are required to register the application as a third-party OAuth provider on your ServiceNow instance.

Results
The custom OAuth application from your Adobe Sign account is created and can be integrated with the ServiceNow instance.

Configure the webhook
Configure the webhook in your Adobe Sign application to enable Adobe Sign to send data to ServiceNow when a participant signs an agreement or document.

Before you begin
Role required: admin

About this task
If the scope of the Adobe Sign application is Account, use the same webhook for all the groups defined within the account scope. If the scope of the Adobe Sign application is Group, you must configure for each group.

Procedure
1. From your Adobe Sign account, create a webhook with these configurations.
   a. Enter the target URL in URL in this format: https://<instance-name>.service-now.com/api/sn_adobesign_spoke/adobesign_webhook.
   b. Enter Agreement all events and Mega Sign all events in Events.
c. Select all the required agreement events in **Notification Parameters**.
   See the Adobe Sign development documentation for more information about creating webhooks in your Adobe Sign account.

2. In your ServiceNow instance, add the client details.
   
a. Navigate to **Adobe Sign Spoke > Client Details**.
   
b. Open the record, **Adobe Sign Client ID**.
   
c. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication Key</td>
<td>Key to authenticate. Enter UB7E5BXCXY.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Application ID created during the Adobe Sign account configuration.</td>
</tr>
</tbody>
</table>

   
d. Click **Update**.

**Results**
Webhook is created in your Adobe Sign account and signing events in Adobe Sign are updated in the tables of the Adobe Sign spoke.

**Register Adobe Sign as OAuth provider**
Use the information generated during Adobe Sign account configuration to register Adobe Sign as an OAuth provider and allow the ServiceNow instance to request OAuth 2.0 tokens.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **System OAuth > Application Registry**.
2. Click **New**.
   The system displays the message What kind of OAuth application?
3. Select **Connect to a third party OAuth Provider**.
4. On the form, fill in the fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter Adobe Sign OAuth profile.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Application ID created during the Adobe Sign account configuration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Application Secret created during the Adobe Sign account configuration.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Optional script to customize the request and response.</td>
</tr>
<tr>
<td>Logo URL</td>
<td>URL that contains an image to use as the application logo.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Grant type used to establish the token. Select Authorization Code.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>Time, in seconds, that the refresh token is valid. The default time is 8,640,0000 seconds.</td>
</tr>
<tr>
<td>PKCE required</td>
<td>Option to enable public clients to require PKCE for an authorization.</td>
</tr>
<tr>
<td>Note: You can use only Authorization Code as the Default Grant type when PKCE is enabled.</td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record. Select Adobe Sign Spoke.</td>
</tr>
<tr>
<td>Note: You must ensure that the application scope is Adobe Sign Spoke.</td>
<td></td>
</tr>
<tr>
<td>Accessible from</td>
<td>Application scope that this registry is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>• Upon saving the record, the endpoint changes to <a href="https://secure.nal.echosign.com/oauth/refresh">https://secure.nal.echosign.com/oauth/refresh</a>.</td>
</tr>
<tr>
<td></td>
<td>• If the token is revoked from the Adobe Sign custom application, change the endpoint to <a href="https://secure.nal.echosign.com/oauth/token">https://secure.nal.echosign.com/oauth/token</a></td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>OAuth server token revocation endpoint.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint. System generates the URL upon saving the application registry.</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use mutual authentication for token request and revocation. This option requires a mutual authentication profile to be specified.</td>
</tr>
</tbody>
</table>

5. Insert records for group scope modifiers in the OAuth Entity Scopes related list in this format, `<scope>:<modifier>`.  

**Example**  
For example, if the user_read scope for the Group modifier is enabled in the Adobe Sign application, insert the following record in the OAuth Entity Scopes related list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>user_read:group</td>
<td>user_read:group</td>
</tr>
</tbody>
</table>

6. Right-click the form header, and click **Save**. The system validates the OAuth credentials and populates the **Redirect URL**.

7. Copy and record the **Redirect URL**.

8. Login to your Adobe Sign account and edit the configuration of your custom Adobe Sign application. See the Adobe Sign development documentation for instructions.

Results
The instance can request OAuth 2.0 tokens for the spoke and a refresh token is created to regenerate tokens.

Create Credential records for the Adobe Sign spoke
Authorize the Adobe Sign spoke actions by creating credential records for the application registered in Adobe Sign. The Adobe Sign spoke connection and credential alias uses these credentials to authorize actions.

Before you begin
Role required: admin

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?.
3. Select OAuth 2.0 Credentials.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Adobe Sign Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile created during the registration of Adobe Sign spoke as an OAuth provider. For example, select Adobe Sign OAuth profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the credentials are used. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click Save.
6. To generate the OAuth token, click the Get OAuth Token related link.

Results
The credential record for the Adobe Sign spoke is created.
Create Connection and Credential Alias for Adobe Sign group

Manage connection and credential information of an Adobe Sign group to authorize the group-specific actions by creating connection and credential alias for the Adobe Sign group.

Before you begin
Role required: admin

About this task
A sample connection and credential alias is provided for demonstration purpose. If you are using the sample alias, it is not necessary to create a connection and credential alias. However, admin must create an alias for every other Adobe Sign group to synchronize that group with the ServiceNow instance.

Procedure
1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the alias. For example, AdobeSign_Legal.</td>
</tr>
<tr>
<td>ID</td>
<td>System generated unique ID.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record. Select Adobe Sign Spoke.</td>
</tr>
<tr>
<td>Type</td>
<td>Alias type. Select Connection and Credential.</td>
</tr>
<tr>
<td>Connection type</td>
<td>Connection type. Select HTTP.</td>
</tr>
</tbody>
</table>
| Support Multiple Active Connections | Option to specify if the alias supports multiple active connections. | 4. Click Save.

Results
The connection and credential alias is created for the Adobe Sign group and the group can be synchronised with the ServiceNow instance.
Create Connection record and Connection Attributes for the Adobe Sign spoke

Perform actions in Adobe Sign by creating connection records and connection attributes for your Adobe Sign group. The Adobe Sign spoke connection and credential alias uses these connections to perform actions on Adobe Sign.

Before you begin
Role required: admin

Procedure
1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for Adobe Sign.
3. In the Connections related list, click New.
4. On the form, fill in the fields.

HTTP(s) Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Adobe Sign Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Adobe Sign spoke. For example, Adobe Sign Credentials.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td>Note: Do not select the check box.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Connection URL. For example, <a href="https://api.eu1.echosign.com/">https://api.eu1.echosign.com/</a>.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Server. If the check box is selected, define the fields in the Advanced MID Server Configuration related list.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

5. Click Submit.
6. In the Connections Attributes related list, click New.
7. On the form, fill in the fields.
Connection Attributes form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Connection attribute type. Select <strong>String</strong>.</td>
</tr>
<tr>
<td>Label</td>
<td>Name to identify the connection attribute. Enter <strong>Version</strong>.</td>
</tr>
<tr>
<td>Column name</td>
<td>System generated value that is based on the value entered in Label.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Ensure that the application scope is <strong>Adobe Sign Spoke</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection attribute.</td>
</tr>
<tr>
<td>Read only</td>
<td>Option to disable modifications to the connection attribute.</td>
</tr>
<tr>
<td></td>
<td>Enter <strong>false</strong>.</td>
</tr>
<tr>
<td>Default value</td>
<td>Default value of the connection attribute. Enter v6.</td>
</tr>
</tbody>
</table>

8. Click **Submit**.

**Results**
The connection record and connection attribute is created for the connection and credential alias.

**Configure Application Access to ServiceNow tables**
Allow Adobe Sign spoke to create group admin user role when an Adobe Sign group is synchronized with ServiceNow tables by configuring the application access of the required ServiceNow tables.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **System Definition > Tables**.
2. For each of the following tables, ensure that the **Can read**, **Can create**, and **Can update** options are selected in the Application Access related list.
3. Click **Update**.

**Results**
Application access of the required ServiceNow tables is configured.

**Create Adobe Sign group in ServiceNow**
Synchronize ServiceNow with the required group in Adobe Sign by creating a record in the AdobeSign Group Details [sn_adobesign_spoke_adobesign_group_details] table.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **Adobe Sign Spoke > Groups**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Name</td>
<td>Name to uniquely identify the Adobe Sign group. For example, Legal.</td>
</tr>
<tr>
<td>Group ID</td>
<td>Unique ID associated with the record.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection alias created to synchronize the Adobe Sign group with ServiceNow.</td>
</tr>
</tbody>
</table>
Results
The required Adobe Sign group is created in ServiceNow and can be managed from the Adobe Sign spoke.
User role specific to the group is created in ServiceNow, when the group is created in the ServiceNow instance. For example, a HR group user role, sn_adobesign_spoke.HR, is created when the HR group is created in ServiceNow. ServiceNow admin can assign these group user roles to users and control access to the group-specific information such as:

- Documents and agreements
- Connection and credential aliases
- Credential records
- Application registries
- Data in tables of the Adobe Sign spoke

To run flows and subflows, group users must also have these roles:

- connection_admin
- credential_admin
- flow_designer
- oauth_admin
- script_debugger
- view_changer

Only ServiceNow admin has access to information about all Adobe Sign groups that are synchronised with the ServiceNow instance.

Synchronize documents in Adobe Sign group with ServiceNow
Synchronize ServiceNow with the required group in Adobe Sign to access the documents and agreements that are specific to the group, from the Adobe Sign spoke.

Before you begin
Role required: admin

About this task
Ensure that the groups are setup and configured with their respective connection and credential aliases before synchronizing the group documents.
Procedure

2. Click the Get Documents related list.

Note:
- If you have logged in as an admin, you can synchronize the documents of all Adobe Sign groups.
- If you have logged in as a group admin, you can synchronize only those documents that are specific to your Adobe Sign groups.

Results
Details of all documents specific to the required Adobe Sign groups are synchronized with ServiceNow.

Activate Adobe Sign spoke catalog items
Trigger events in Adobe Sign when an item is requested in Service Catalog. For example, the Adobe Sign - Statement of Work Demo catalog item triggers a sample flow that sends a Adobe Sign document to a designated recipient.

Before you begin
- Synchronize Adobe Sign group with ServiceNow
- Role required: admin

About this task
The Adobe Sign spoke adds catalog items for use with the Adobe Sign spoke sample flows. Before triggering a sample flow, activate these catalog items.

<table>
<thead>
<tr>
<th>Catalog item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe Sign - Send NDA Demo</td>
<td>Sends a non-disclosure agreement for digital signature using an Adobe Sign library document.</td>
</tr>
</tbody>
</table>
Procedure
1. Navigate to Self-Service > Service Catalog.
2. Click the add content icon +.
4. Click Add here.
5. Search for and select Adobe Sign - Send NDA Demo.
6. Click Add here.

Results
When one of these items is requested in the Service Catalog, the associated Adobe Sign spoke sample flow is triggered and necessary actions are performed in Adobe Sign.

Aha! spoke
Manage Aha! accounts using your ServiceNow instance. Analyze data usage for Aha! and reclaim idle accounts.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

Spoke requirements
• Aha! admin role

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Aha! spoke provides actions to automate Aha! tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Management</td>
<td>Look up Users Stream</td>
<td>Retrieves details of all members in an account.</td>
</tr>
<tr>
<td></td>
<td>Deactivate User</td>
<td>Deactivates the specified user account.</td>
</tr>
</tbody>
</table>

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Create an Aha! OAuth2 application
Create an Aha! OAuth2 application to get access to Aha! API.

Before you begin
Aha! role required: admin

Procedure
1. Go to OAuth2 Authentication.
2. Log in to the Aha! site using your admin credentials.
3. On the Personal settings page, under the OAuth applications tab, click Register OAuth applications. The Register new OAuth application form appears.
4. Enter https://instance/oauth_redirect.do as the Redirect URI, where instance is the name of your ServiceNow instance.
5. Click Create. The OAuth applications tab shows Client ID and Client Secret keys.
6. Note down the values in the Client ID and Client Secret fields.
Set up ServiceNow instance for Aha!

Set up your ServiceNow instance to add the Aha! Client ID and Client Secret keys.

Before you begin
Role required: admin

Procedure
1. Log in to your ServiceNow instance.
   Connection & Credentials Aliases page appears and shows the list of apps.
3. Locate and open the Connection & Credentials record for Aha!
4. Click the Create New Connection & Credential related link.
   Create Connection and add Credential form appears.
5. On the form, fill in the details.

Create Connection and add Credential form

<table>
<thead>
<tr>
<th>Fields</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Name</td>
<td>Name of the integration profile.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Connection URL for Aha!</td>
</tr>
<tr>
<td>OAuth Client ID</td>
<td>OAuth2 key that you received while creating an OAuth2 authentication from the Aha! site.</td>
</tr>
<tr>
<td>OAuth Client Secret</td>
<td>OAuth Client Secret key that you received while creating an OAuth2 authentication from the Aha! site.</td>
</tr>
<tr>
<td>OAuth Redirect URL</td>
<td>ServiceNow redirect URL.</td>
</tr>
</tbody>
</table>

6. Click Configure and get OAuth Token and then click Authorize.

AI Search spoke
Store data from the required third-party application in the AI Search server through Flow Designer. Access data through the AI Search portal.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release
notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are activated:

- AI Search (com.glide.ais)
- AI Search Demo (com.glide.ais_demo)
- External Content for AI Search (com.glide.external_content)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The AI Search spoke provides actions to automate tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete By Query</td>
<td>Removes all the documents that match the given query from the search index.</td>
</tr>
<tr>
<td>Flush Ingestion</td>
<td>Flushes queued documents in the batcher and indexes them.</td>
</tr>
<tr>
<td>Get Max File Size</td>
<td>Retrieves the maximum file size which can be ingested into AI Search.</td>
</tr>
<tr>
<td>Ingest Data</td>
<td>Ingests properties of the specified document into the batcher.</td>
</tr>
<tr>
<td>Ingest Document Using Download URL</td>
<td>Downloads a document and ingests into the batcher.</td>
</tr>
</tbody>
</table>

Note:
- You must add the domain URL to the list of trusted domains before you specify the URL in this action.
- You must provide a pre-authenticated URL to the action input Download URL.
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initialize Batcher</td>
<td>Initializes a new batcher to queue documents for indexing.</td>
</tr>
<tr>
<td>Is AIS Available For Ingestion</td>
<td>Checks if AI Search is available for ingestion.</td>
</tr>
<tr>
<td>Look up Supported File Extensions</td>
<td>Retrieves file extensions supported by AI Search.</td>
</tr>
<tr>
<td>Purge All Documents</td>
<td>Removes all the documents under the external source from the search index.</td>
</tr>
<tr>
<td>Release Batcher</td>
<td>Releases a used batcher from pool.</td>
</tr>
<tr>
<td>Remove Document</td>
<td>Removes a document from the search index.</td>
</tr>
<tr>
<td>Update By Query</td>
<td>Updates all the documents that match the given query.</td>
</tr>
</tbody>
</table>

See [Set up the AI Search spoke](#) for information about setting up the AI Search spoke.

**Set up the AI Search spoke**

Configure the AI Search connection to store the data from the required third-party application.

**Before you begin**

- Request an IntegrationHub subscription
- Activate the AI Search spoke
- Role required: admin

**Procedure**

1. Set up the AI Search connection.
   
   a. Navigate to **AI Search > Connection**.
   
   b. Click **Enable AIS**.

   ![Note](https://via.placeholder.com/15) **Note:** Ensure that the **Global** scope is selected before you click **Enable AIS**.

   A connection record is created.
c. Open the created record.

d. Click the Test Connection related link to verify that the connection is established.

2. Create external content schema table.
   b. In the field, provide the name of your schema table. For example, AI Search table.
   c. Click Submit.

3. Create indexed sources.
   a. Navigate to AI Search > Indexed Sources.
   b. Click New.
   c. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to identify the record. For example, AI Search indexed source.</td>
</tr>
<tr>
<td>Source</td>
<td>Schema table that you had created. For example, AI Search table.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the record.</td>
</tr>
</tbody>
</table>

d. Click Submit.

i Note: Ensure that the Type of the indexed source is external.

You can now use the AI Search spoke actions.

4. Add the domain URL to the list of trusted domains.
   a. Navigate to AI Search Spoke > Trusted Domains.
   b. Click New.
c. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to identify the record</td>
</tr>
<tr>
<td>Domain</td>
<td>URL of the trusted domain.</td>
</tr>
</tbody>
</table>

5. Create search source.

a. Navigate to **Al Search > Search Experience > Search Sources**.

b. Click **New**.

c. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to identify the record. For example, <strong>AI Search source</strong>.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope. Select <strong>AI Search Spoke</strong>.</td>
</tr>
<tr>
<td>Indexed Source</td>
<td>Indexed source you had earlier created. For example, <strong>AI Search indexed source</strong>.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Filter conditions that must be met.</td>
</tr>
</tbody>
</table>

d. Click **Submit**.

6. Create search profile.

a. Navigate to **Al Search > Search Experience > Search Profiles**.

b. Click **New**.

c. Provide a value in **Label** to identify the record.

d. Right-click the form header and click **Save**.

e. In the **Search Sources** tab, click **Link Existing**.
f. In **Search Source**, select the source you had created. For example, **AIS Source**.

**g. Click Submit.**
The search profile you had created in displayed.

**h. Click Publish.**
You can search for the indexed sources by navigating to **AI Search > External Content > Testing UI**.

**Amazon Alexa spoke**
Manage intents, skills, vendors, and slots in your Amazon Alexa account from your ServiceNow instance.

**Request apps on the Store**
Visit the **ServiceNow Store** website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the **ServiceNow Store version history release notes**.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Professional subscription package. For more information, see **Request IntegrationHub**.

**Supported versions**
This spoke was built for Amazon Alexa API version v1, but may be compatible with later versions.

**Spoke requirements**
Admin access to **Amazon Developer Portal** and AWS Lambda.

**Important security considerations**
Be aware of these considerations to securely use Amazon Alexa:

- Amazon stores voice recordings of the Amazon Alexa smart assistant customers forever unless the Amazon Alexa account is configured to delete the recordings. For more information about deleting the voice recordings, see **Delete Alexa Voice Recordings Automatically**.

- To stop recording conversations, turn the microphone off on the Alexa enabled devices.
To ensure safety and protect privacy when using Alexa devices, take measures such as, choosing a strong password and using a pin for voice purchases.

Install or activate only the legitimate skills.

Ensure proper credential management in AWS Lambda when invoking the ServiceNow Rest API.

Ensure that your AWS Lambda function is accessible to only the required skills by adding the Alexa Skills Kit trigger to the required AWS Lambda function. Using these triggers, you can allow only the required skills to access your AWS Lambda function. For more information, see Configure the trigger for a Lambda function.

**Note:** Use the AWS Lambda function as an endpoint of your skill. If you are using custom web service, validate the skills. For more information, see Host a Custom Skill as a Web Service.

You can securely store your sensitive data in the AWS Lambda function using environment variables. For more information, see Using AWS Lambda environment variables.

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- **ServiceNow IntegrationHub Action Step - REST** (com.glide.hub.action_step.rest)
- **ServiceNow Flow Designer - Dynamic Inputs** (com.glide.hub.dynamic_inputs)
- **Complex Object** (com.glide.cobject)
- **ServiceNow IntegrationHub Runtime** (com.glide.hub.integration.runtime)

**Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke actions**

The Amazon Alexa spoke provides actions to automate tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intent Management</td>
<td>Create Intent</td>
<td>Creates an intent for the specified skill and locale.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Delete Intent</td>
<td>Deletes the specified intent from the specified skill.</td>
</tr>
<tr>
<td></td>
<td>Look up Intents</td>
<td>Lists available intents for the specified skill and locale.</td>
</tr>
<tr>
<td></td>
<td>Update Intent</td>
<td>Updates an intent for the specified skill and locale.</td>
</tr>
<tr>
<td>Interaction Model</td>
<td>Get Interaction Model</td>
<td>Gets the interaction model schema for the specified skill.</td>
</tr>
<tr>
<td>Management</td>
<td>Look up Interaction</td>
<td>Lists the available versions of the interaction model for the specified skill.</td>
</tr>
<tr>
<td></td>
<td>Model Versions</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Update Interaction</td>
<td>Updates the interaction model for the specified skill and locale.</td>
</tr>
<tr>
<td></td>
<td>Model</td>
<td></td>
</tr>
<tr>
<td>Skill Management</td>
<td>Create Skill</td>
<td>Submits a skill creation request for the specified Vendor ID.</td>
</tr>
<tr>
<td></td>
<td>Delete Skill</td>
<td>Deletes the specified skill.</td>
</tr>
<tr>
<td></td>
<td>Get Skill</td>
<td>Gets the details for the specified skill.</td>
</tr>
<tr>
<td></td>
<td>Get Skill Status</td>
<td>Gets the status for the specified skill.</td>
</tr>
<tr>
<td></td>
<td>Look up Skills</td>
<td>Lists the skills for the specified Vendor ID.</td>
</tr>
<tr>
<td></td>
<td>Update Skill</td>
<td>Submits a request to update a skill for the specified Vendor ID.</td>
</tr>
<tr>
<td>Slot Type Management</td>
<td>Create Slot Type</td>
<td>Creates a slot type for the specified skill in the specified locale.</td>
</tr>
<tr>
<td></td>
<td>Look up Slot Types</td>
<td>Lists available slot types for the specified skill and locale.</td>
</tr>
<tr>
<td></td>
<td>Update Slot Type</td>
<td>Updates the specified slot type for the specified skill and locale.</td>
</tr>
<tr>
<td>Vendor Management</td>
<td>Look up Vendors</td>
<td>Lists details of all the available vendors.</td>
</tr>
</tbody>
</table>
Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the Amazon Alexa spoke
Integrate the ServiceNow instance and Amazon Alexa account by creating a custom OAuth application in Amazon Alexa to authenticate ServiceNow requests.

Before you begin
• Request an IntegrationHub subscription.
• Activate Amazon Alexa spoke.
• Role required: admin

Create a security profile
Create and register a security profile through the Developer Console to use Login with Amazon on your ServiceNow instance.

Before you begin
Role required: admin

Procedure
1. Log in to Amazon Developer Portal with admin credentials.
2. Create a security profile. For information about creating a security profile, see Create an LwA Security Profile in Amazon Developer Documentation.
3. Copy and record the values of Client ID and Client Secret for later use.
4. Configure the security profile and specify these values in Web Settings:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allowed Origins</td>
<td>ServiceNow instance URL.</td>
</tr>
</tbody>
</table>
For more information about configuring the security policy, see Add your Website to your Security Profile in Amazon Developer Documentation.

Register Amazon Alexa as an OAuth provider

Use the information generated during the configuration of security profile to register Amazon Alexa as an OAuth provider and allow the ServiceNow instance to request OAuth 2.0 tokens.

Procedure

1. Navigate to System OAuth > Application Registry.
2. Open for the record, Amazon Alexa.
3. On the form, fill these values.

<table>
<thead>
<tr>
<th>Application Registries form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID created during the configuration of the security profile.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret created during the configuration of the security profile.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>OAuth authorization code endpoint. Enter: <a href="https://www.amazon.com/ap/oa">https://www.amazon.com/ap/oa</a></td>
</tr>
<tr>
<td>Token URL</td>
<td>OAuth server token endpoint. Enter: <a href="https://api.amazon.com/auth/o2/token">https://api.amazon.com/auth/o2/token</a></td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint in this format: https://&lt;instance&gt;.service-now.com/oauth_redirect.do</td>
</tr>
<tr>
<td>Default Grant Type</td>
<td>Grant type used to establish the token. Select Authorization Code.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click Save.
Create a credential record for the Amazon Alexa spoke

Create a credential record for the Amazon Alexa account. The Amazon Alexa spoke connection and credential alias uses these credentials to authorize actions.

Procedure

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
   The system displays this message: What type of Credentials would you like to create?
3. Select **OAuth 2.0 Credentials**.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Alexa Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile created during the registration of Amazon Alexa as an OAuth provider. For example, Amazon Alexa default_profile.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias associated with the spoke.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click **Submit**.
6. To generate the OAuth token, click the **Get OAuth Token** related link.
   You will be redirected to the Amazon portal.
7. Click **Allow**.
   You will be redirected back to ServiceNow instance.

Create a connection record for the Amazon Alexa spoke

Create a connection record for your Amazon Alexa account. The Amazon Alexa spoke connection and credential aliases use these connections to perform actions in Amazon Alexa.
Procedure

1. Navigate to Connections & Credentials > Connections & Credentials Aliases.
2. Open the alias record, AmazonAlexa.
3. From the Connections tab, click New.
4. On the form, fill these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Alexa Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Amazon Alexa spoke. For example, Alexa Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to Amazon Alexa. Enter: <a href="https://api.amazonalexa.com">https://api.amazonalexa.com</a></td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
</tbody>
</table>

5. In the Attributes tab, enter v1 for version.
6. Click Submit.

Setup webhook for the Amazon Alexa spoke

Authenticate the inbound requests from Amazon Alexa account to your ServiceNow instance by creating a webhook registry.

Before you begin

Procedure

1. In the filter navigator, enter token_verification.list.
   - Records in the Token Verifications [token_verification] table are displayed.
2. Click New.
3. On the form, fill these values.
4. Click **Submit**.

5. Navigate to **Alexa Webhooks > Alexa Webhook Registries**.

6. Click **New**.

7. On the form, fill these values.

### Alexa Webhook Registry form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Name      | Name to identify the webhook registry record. For example, *Alexa token*.
| Description | Brief description of the webhook registry record. |
| Token     | Token you have created. For example, *Alexa token*. |
| Path      | Scripted REST endpoint. A default endpoint is available. You can change the default value as per your requirement. |

8. Right-click the form header and click **Save**.

9. Click **Callback URL**.

   Webhook Callback URL is displayed in the confirmation message. Copy and record this value.

10. Log in to **AWS Management Console**.

11. In the AWS Lambda function, specify the Webhook Callback URL and save the changes.
12. Log in to Alexa Developer Console.

13. Navigate to Build > CUSTOM > Endpoint and specify ARN of the AWS Lambda function you had configured.

Amazon Cloudwatch spoke
Integrate ServiceNow instance with Amazon Cloudwatch. Manage and monitor your Amazon Web Services (AWS) resources and applications from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.
Supported versions
This spoke was built for Amazon Cloudwatch version 2010-08-01, but may be compatible with later versions.

Spoke requirements
• User with full access to Amazon Cloudwatch account.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• Complex Object (com.glide.cobject)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Amazon Cloudwatch Spoke provides actions to automate Amazon Web Services (AWS) resource and application monitoring tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Management</td>
<td>Create Composite Alarm</td>
<td>Creates a composite alarm.</td>
</tr>
<tr>
<td></td>
<td>Delete Composite Alarm</td>
<td>Deletes the specified alarms.</td>
</tr>
<tr>
<td></td>
<td>Look Up Alarm</td>
<td>Retrieves a list of specified alarms.</td>
</tr>
<tr>
<td></td>
<td>Set Alarm State</td>
<td>Assigns a temporary state to an alarm for testing.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Anomaly Management</td>
<td>Create Anomaly Detector</td>
<td>Creates an anomaly detection model for a CloudWatch metric.</td>
</tr>
<tr>
<td></td>
<td>Delete Anomaly Detector</td>
<td>Deletes the specified anomaly detection model from an account.</td>
</tr>
<tr>
<td>Metric Management</td>
<td>Delete Metric Alarm</td>
<td>Deletes the specified alarms.</td>
</tr>
<tr>
<td></td>
<td>Look up Metric Data</td>
<td>Retrieves different metrics in a single request.</td>
</tr>
<tr>
<td></td>
<td>Upsert Metrics Alarm</td>
<td>Create a new alarm or updates an alarm and associates the alarm with the specified metric, metric math expression, or an anomaly detection model.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

**Set up the Amazon Cloudwatch spoke**

Integrate the ServiceNow instance and Amazon Cloudwatch by using the AWS credentials to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub subscription.
- Activate Amazon Cloudwatch spoke.
- Role required: admin
Create a credential record for the Amazon Cloudwatch spoke

Create a credential record for the Amazon Cloudwatch account. The Amazon Cloudwatch Spoke connection and credential alias uses these credentials to authorize actions.

Procedure

1. Navigate to IntegrationHub > Connections & Credentials > Credentials.
2. Click New.
   
   The system displays this message: What type of Credentials would you like to create?
3. Select AWS Credentials.
4. On the form, fill these values.

AWS Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Amazon Cloudwatch Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID of your AWS account.</td>
</tr>
<tr>
<td></td>
<td>Access Key ID of the user with full access to Amazon Cloudwatch.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Secret Access Key of your AWS account.</td>
</tr>
<tr>
<td></td>
<td>Secret Access Key of the user with full access to Amazon Cloudwatch.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Custom authentication algorithm for outbound signing requests. Select AmazonCloudWatchAlgo.</td>
</tr>
<tr>
<td>Note:</td>
<td>Users are cautioned against directly modifying the default authentication algorithm.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias associated with the spoke. AWS_Cloud_Watch</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click Submit.
Amazon Connect spoke
Manage and provide customer service across voice, chat, and tasks using your Amazon Connect account from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Amazon Connect API Version 2017-08-08, but may be compatible with later versions.

Spoke requirements
• User with full access to Amazon Connect.
• Access Key ID and Secret Access Key of the user. Record these values for later use.

For more information about creating user in IAM and providing the required access, see Understanding and Getting Your Security Credentials page on the AWS Documentation site.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
• Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

### Spoke actions

The Amazon Connect spoke provides actions to automate Amazon Connect tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Flow Management</td>
<td>Create Contact Flow</td>
<td>Creates a contact flow for the specified Amazon Connect instance.</td>
</tr>
<tr>
<td></td>
<td>Get Contact Flow Details</td>
<td>Retrieves details of the specified contact flow.</td>
</tr>
<tr>
<td></td>
<td>Look up Contact Flows</td>
<td>Retrieves a list of contact flows.</td>
</tr>
<tr>
<td></td>
<td>Update Contact Flow Content</td>
<td>Updates content of the specified contact flow.</td>
</tr>
<tr>
<td></td>
<td>Update Contact Flow Name</td>
<td>Updates name of the specified contact flow.</td>
</tr>
<tr>
<td>Contact Management</td>
<td>Resume Contact Recording</td>
<td>Resumes recording the call when a contact is being recorded and the recording has been suspended using suspend contact recording. Only voice recordings are supported at this time.</td>
</tr>
<tr>
<td></td>
<td>Start Contact Recording</td>
<td>Starts recording the contact when an agent joins the call. Only voice recordings are supported at this time.</td>
</tr>
<tr>
<td></td>
<td>Start Outbound Voice Contact</td>
<td>Places an outbound call to a contact and initiates the contact flow.</td>
</tr>
<tr>
<td></td>
<td>Stop Contact</td>
<td>Ends the specified contact.</td>
</tr>
<tr>
<td></td>
<td>Stop Contact Recording</td>
<td>Stops recording the call. If you use stop contact recording to stop recording an ongoing call,</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>you can’t use restart the contact recording. Only voice recordings are supported at this time.</td>
</tr>
<tr>
<td></td>
<td>Suspend Contact Recording</td>
<td>Suspends recording the call when a contact is being recorded.</td>
</tr>
<tr>
<td><strong>Instance Management</strong></td>
<td>Create Instance</td>
<td>Initiates an Amazon Connect instance with all the supported channels enabled.</td>
</tr>
<tr>
<td></td>
<td>Delete Instance</td>
<td>Deletes the specified instance.</td>
</tr>
<tr>
<td></td>
<td>Get Instance Details</td>
<td>Retrieves details of the specified instance.</td>
</tr>
<tr>
<td></td>
<td>Look up Hours of Operations</td>
<td>Retrieves a list of hours of operations.</td>
</tr>
<tr>
<td></td>
<td>Look up Instances</td>
<td>Retrieves a list of instances.</td>
</tr>
<tr>
<td></td>
<td>Look up Phone Numbers</td>
<td>Retrieves a list of phone numbers.</td>
</tr>
<tr>
<td></td>
<td>Look up Prompts</td>
<td>Retrieves a list of prompts.</td>
</tr>
<tr>
<td></td>
<td>Look up Queues</td>
<td>Retrieves a list of queues.</td>
</tr>
<tr>
<td></td>
<td>Look up Security Profiles</td>
<td>Retrieves a list of security profiles.</td>
</tr>
<tr>
<td><strong>Metric Management</strong></td>
<td>Get Current Metrics Data</td>
<td>Retrieves the real-time metric data from the specified Amazon Connect instance.</td>
</tr>
<tr>
<td></td>
<td>Get Metrics Data</td>
<td>Retrieves historical metric data from the specified Amazon Connect instance.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Routing Policy Management</strong></td>
<td>Associate Routing Profile Queues</td>
<td>Associates a set of queues with a routing profile.</td>
</tr>
<tr>
<td></td>
<td>Create Routing Profile</td>
<td>Creates a routing profile.</td>
</tr>
<tr>
<td></td>
<td>Disassociate Routing Profile Queues</td>
<td>Disassociates the specified set of queues from a routing profile.</td>
</tr>
<tr>
<td></td>
<td>Get Routing Profile Details</td>
<td>Retrieves details of the specified routing profile.</td>
</tr>
<tr>
<td></td>
<td>Look up Routing Profile Queues</td>
<td>Retrieves a list of routing profile queues.</td>
</tr>
<tr>
<td></td>
<td>Look up Routing Profiles</td>
<td>Retrieves a list of routing profiles.</td>
</tr>
<tr>
<td></td>
<td>Update Routing Profile Concurrency</td>
<td>Updates the specified routing profile concurrency.</td>
</tr>
<tr>
<td></td>
<td>Update Routing Profile Default Outbound Queue</td>
<td>Updates the specified routing profile default outbound queue.</td>
</tr>
</tbody>
</table>

**Note:**
- The time must be specified using an interval of 5 minutes, such as 11:00, 11:05, and 11:10, and must be later than the start time timestamp.
- The time range between the start and end time must be less than 24 hours.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Update Routing Profile Name</td>
<td>Updates the specified routing profile name.</td>
</tr>
<tr>
<td></td>
<td>Update Routing Profile Queues</td>
<td>Updates the properties associated with a set of queues for a routing profile.</td>
</tr>
<tr>
<td>Tag Management</td>
<td>Add Tags to Resource</td>
<td>Associates a set of tags with the specified resource.</td>
</tr>
<tr>
<td></td>
<td>Look up Tags for Resource</td>
<td>Retrieves all tags that are associated with the specified resource.</td>
</tr>
<tr>
<td></td>
<td>Remove Tag from Resource</td>
<td>Removes the association of tag from resource.</td>
</tr>
<tr>
<td>User Management</td>
<td>Create User</td>
<td>Creates a user account for the specified Amazon Connect instance.</td>
</tr>
<tr>
<td></td>
<td>Delete User</td>
<td>Deletes the specified user.</td>
</tr>
<tr>
<td></td>
<td>Get User Details</td>
<td>Retrieves details of the specified user.</td>
</tr>
<tr>
<td></td>
<td>Get User Hierarchy Group</td>
<td>Retrieves details of the user hierarchy group.</td>
</tr>
<tr>
<td></td>
<td>Get User Hierarchy Structure</td>
<td>Retrieves details of the user hierarchy structure.</td>
</tr>
<tr>
<td></td>
<td>Look up User Hierarchy Groups</td>
<td>Retrieves a list of user hierarchy groups.</td>
</tr>
<tr>
<td></td>
<td>Look up Users</td>
<td>Retrieves the list of users.</td>
</tr>
<tr>
<td></td>
<td>Update User Hierarchy</td>
<td>Updates the specified user hierarchy.</td>
</tr>
<tr>
<td></td>
<td>Update User Identity Information</td>
<td>Updates the specified user identify information.</td>
</tr>
</tbody>
</table>
### Category | Action | Description
--- | --- | ---
Update User Phone Configuration | Updates details of the specified user phone configuration.
Update User Routing Profile | Updates the specified user routing profile.
Update User Security Profiles | Updates details of the specified user security profiles.

## Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

### Set up the Amazon Connect spoke
Integrate the ServiceNow instance and Amazon Connect account using AWS credential to authenticate ServiceNow requests.

**Before you begin**
- Request an IntegrationHub subscription
- Activate the Amazon Connect spoke
- Role required: admin

### Procedure
1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for Amazon Connect.
3. From the Credentials tab, click New. The system displays the message What type of Credentials would you like to create?.
4. Select AWS Credentials.
5. On the form, fill these values.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter Amazon Connect Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID of the user with full access to Amazon Connect.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Secret Access Key of the user with full access to Amazon Connect.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Associated credential record.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select Amazon Connect.</td>
</tr>
</tbody>
</table>

**Note:** Users are cautioned against directly modifying the default authentication algorithm.

6. Click **Submit**.

**Results**
The credential record the Amazon Connect spoke is created.

**Amazon DynamoDB spoke**
Manage streams, tables, and tags in your Amazon DynamoDB database from your ServiceNow instance.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Spoke dependencies**
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
• Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

⚠ Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported versions
This spoke was built for API version 2012-08-10, but may be compatible with later versions.

Spoke requirements
• User with full access to Amazon DynamoDB.
• Access Key ID and Secret Access Key of the user. Record these values for later use.

For more information about creating user in IAM and providing the required access, see Understanding and Getting Your Security Credentials page on the AWS Documentation site.

Spoke actions
The Amazon DynamoDB spoke provides actions to automate Amazon DynamoDB tasks when events occurs in the Now Platform. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stream Management</td>
<td>Disable Stream</td>
<td>Disables the stream for the specified table.</td>
</tr>
<tr>
<td></td>
<td>Enable Stream</td>
<td>Enables the stream for the specified table.</td>
</tr>
<tr>
<td></td>
<td>Get Shard Iterator</td>
<td>Returns a shard iterator. Use the shard iterator in a subsequent Get Records request to read the stream records from the shard.</td>
</tr>
<tr>
<td></td>
<td>Get Stream</td>
<td>Returns information about the specified stream.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up Records</td>
<td>Retrieves the stream records from a given shard.</td>
</tr>
<tr>
<td></td>
<td>Look up Streams</td>
<td>Returns the list of all the streams associated with the current account.</td>
</tr>
<tr>
<td>Table Management</td>
<td>Create Backup</td>
<td>Creates a backup for an existing table.</td>
</tr>
<tr>
<td></td>
<td>Create Table</td>
<td>Creates a table in the account.</td>
</tr>
<tr>
<td></td>
<td>Delete Backup</td>
<td>Deletes an existing backup of a table.</td>
</tr>
<tr>
<td></td>
<td>Delete Table</td>
<td>Deletes the specified table.</td>
</tr>
<tr>
<td></td>
<td>Get Backup</td>
<td>Retrieves the details of an existing backup.</td>
</tr>
<tr>
<td></td>
<td>Get Continuous Backup</td>
<td>Retrieves the status of continuous backups and point in time recovery of the specified table.</td>
</tr>
<tr>
<td></td>
<td>Get Table</td>
<td>Retrieves information about the table.</td>
</tr>
<tr>
<td></td>
<td>Look up Backups</td>
<td>Retrieves the list of all the backups associated with the account or backups of the specified table.</td>
</tr>
<tr>
<td></td>
<td>Look up Tables</td>
<td>Retrieves the list of table names.</td>
</tr>
<tr>
<td></td>
<td>Restore Table From Backup</td>
<td>Creates a table from an existing backup.</td>
</tr>
<tr>
<td></td>
<td>Restore Table To Point In Time</td>
<td>Restores the specified table to the specified point in time within Earliest Restorable Date Time and Latest Restorable Date Time.</td>
</tr>
<tr>
<td></td>
<td>Update Continuous Backup</td>
<td>Enables or disables point in time recovery for the specified table.</td>
</tr>
<tr>
<td></td>
<td>Update Table</td>
<td>Updates the specified table.</td>
</tr>
<tr>
<td>Tag Management</td>
<td>Add Tags To DynamoDB Resource</td>
<td>Adds tags to DynamoDB resource.</td>
</tr>
</tbody>
</table>
# Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

⚠️ **Note:** Two Credential aliases are available for the Amazon DynamoDB spoke.

## Set up the Amazon DynamoDB spoke

Integrate the ServiceNow instance and Amazon DynamoDB account using AWS credential to authenticate ServiceNow requests.

### Before you begin

- Request an IntegrationHub subscription
- Activate the Amazon DynamoDB spoke
- Role required: admin

## Create Credential records for the Amazon DynamoDB spoke

Create two Credential records for your Amazon DynamoDB account. The Amazon DynamoDB spoke connection and credential alias uses these credential records to perform actions in your Amazon DynamoDB account.

### Procedure

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open for the record for **Amazon DynamoDB**.
3. From the **Credentials** tab, click **New**.

---

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
The system displays the message *What type of Credentials would you like to create?*.

4. Select **AWS Credentials**.

5. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter Amazon DynamoDB Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID of the user with full access to Amazon DynamoDB.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Secret Access Key of the user with full access to Amazon DynamoDB.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Associated Amazon DynamoDB credential record.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select Amazon DynamoDB.</td>
</tr>
</tbody>
</table>

*Note:* Users are cautioned against directly modifying the default authentication algorithm.

6. Click **Submit**.

7. Navigate to **Connections & Credentials > Connection & Credential Aliases**.

8. Open for the record for **Amazon DynamoDB Streams**.

9. From the **Credentials** tab, click **New**.

   The system displays the message *What type of Credentials would you like to create?*.

10. Select **AWS Credentials**.

11. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter Amazon DynamoDB Streams Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID of the user with full access to Amazon DynamoDB.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Secret Access Key of the user with full access to Amazon DynamoDB.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Associated Amazon DynamoDB Streams credential record.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select Amazon DynamoDB Streams.</td>
</tr>
</tbody>
</table>

<i>Note: Users are cautioned against directly modifying the default authentication algorithm.</i>

12. Click **Submit**.

**Amazon EBS spoke**

Manage block level storage volumes and snapshots in Amazon EBS from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

⚠️ Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

**Supported version**
This spoke was built for API version 2016-11-15, but may be compatible with later versions.

⚠️ Note: If you use different API version, ensure that you change the API version in all spoke actions.

**Spoke requirements**
• User with full access to Amazon EC2.
• Access Key ID and Secret Access Key of the user. Record these values for later use.

For more information about creating user in IAM and providing the required access, see Understanding and Getting Your Security Credentials page on the AWS Documentation site.

**Spoke actions**
The Amazon EBS spoke provides actions to automate Amazon EBS tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elastic Block Store Management</td>
<td>Attach Volume</td>
<td>Attaches an EBS volume to a running or stopped instance.</td>
</tr>
<tr>
<td>Elastic Block Store Management</td>
<td>Create Snapshot</td>
<td>Creates a snapshot of an EBS volume.</td>
</tr>
<tr>
<td>Elastic Block Store Management</td>
<td>Create Volume</td>
<td>Creates an EBS volume that can be attached to an instance in the same Availability Zone.</td>
</tr>
<tr>
<td>Elastic Block Store Management</td>
<td>Delete Snapshot</td>
<td>Deletes the specified snapshot.</td>
</tr>
</tbody>
</table>
### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

### Set up the Amazon EBS spoke

Integrate the ServiceNow instance and Amazon EBS account using AWS credential to authenticate ServiceNow requests.

**Before you begin**
- Request an IntegrationHub subscription
- Activate the Amazon EBS spoke
- Role required: admin

### Create Credential record for the Amazon EBS spoke

Create Credential record for your Amazon EBS account. The Amazon EBS spoke connection and credential alias uses this credential to perform actions on Amazon EBS.

**Procedure**

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for Amazon EBS.
3. From the Credentials tab, click New. The system displays the message What type of Credentials would you like to create?.
4. Select AWS Credentials.
5. On the form, fill these values.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter EBS Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID of the user with full access to Amazon EC2.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Secret Access Key of the user with full access to Amazon EC2.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Associated credential record.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select AmazonEBSAuthAlgo.</td>
</tr>
</tbody>
</table>

**Note:** Users are cautioned against directly modifying the default authentication algorithm.

6. Click **Submit**.

**Results**
The credential record the Amazon EBS spoke is created.

**Amazon Elastic Container Service spoke v1.0.1**
Manage clusters, instances, services and so on, in Amazon Elastic Container Service account from your ServiceNow instance.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Supported versions**
This spoke was built for Amazon Elastic Container Service API version 2014-11-13, but may be compatible with later versions.
Spoke requirements

- User with full access to Amazon Elastic Container Service.
- Access Key ID and Secret Access Key of the user. Record these values for later use.

For more information about creating user in IAM and providing the required access, see Understanding and Getting Your Security Credentials page on the AWS Documentation site.

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Complex Object (com.glide.cobject)

ℹ️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions

The Amazon Elastic Container Service spoke provides actions to automate Amazon Elastic Container Service tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster Management</td>
<td>Create Cluster</td>
<td>Creates an Amazon ECS cluster.</td>
</tr>
<tr>
<td></td>
<td>Delete Cluster</td>
<td>Deletes the specified cluster.</td>
</tr>
<tr>
<td></td>
<td>Look up Cluster</td>
<td>Retrieves the specified cluster.</td>
</tr>
<tr>
<td></td>
<td>Look up Clusters</td>
<td>Retrieves the list of existing clusters.</td>
</tr>
<tr>
<td></td>
<td>Update Cluster Settings</td>
<td>Updates settings of the specified cluster.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Instance Management</td>
<td>Deregister Container Instance</td>
<td>Deregisters an Amazon ECS container instance from the specified cluster.</td>
</tr>
<tr>
<td></td>
<td>Look up Container Instances</td>
<td>Lists Amazon Elastic Container Service container instances.</td>
</tr>
<tr>
<td></td>
<td>Register Container Instance</td>
<td>Registers an EC2 instance into the specified cluster.</td>
</tr>
<tr>
<td>Service Management</td>
<td>Create Service</td>
<td>Runs and maintains the desired number of tasks from the specified task definition.</td>
</tr>
<tr>
<td></td>
<td>Delete Service</td>
<td>Deletes a specified service within a cluster.</td>
</tr>
<tr>
<td></td>
<td>Look up Service</td>
<td>Retrieves the specified service running in your cluster.</td>
</tr>
<tr>
<td></td>
<td>Look up Services</td>
<td>Retrieves the services that are running in a specified cluster.</td>
</tr>
<tr>
<td></td>
<td>Update Service</td>
<td>Updates the parameters of a service.</td>
</tr>
<tr>
<td>Task Definition</td>
<td>Deregister Task Definition</td>
<td>Deletes the specified task set within a service.</td>
</tr>
<tr>
<td>Management</td>
<td>Look up Task Definition</td>
<td>Deregisters the specified task definition by family and revision.</td>
</tr>
<tr>
<td></td>
<td>Look up Task Definitions</td>
<td>Deregisters the specified tasks definition by family and revision.</td>
</tr>
<tr>
<td></td>
<td>Register Task Definition</td>
<td>Creates a task set in the specified cluster and service.</td>
</tr>
<tr>
<td>Task Management</td>
<td>Create Task Set</td>
<td>Creates a task set in the specified cluster and service.</td>
</tr>
<tr>
<td></td>
<td>Delete Task Set</td>
<td>Deletes the specified task set within a service.</td>
</tr>
<tr>
<td></td>
<td>Look up Task Set</td>
<td>Lists the task sets in the specified cluster and service.</td>
</tr>
<tr>
<td></td>
<td>Run Task</td>
<td>Starts a task using the specified task definition.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Start Task</td>
<td>Starts a task from the specified task definition on the specified container instance or instances.</td>
</tr>
<tr>
<td></td>
<td>Stop Task</td>
<td>Stops the specified running task.</td>
</tr>
<tr>
<td></td>
<td>Update Task Set</td>
<td>Modifies the specifies task set.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the Amazon Elastic Container Service spoke**

Integrate the ServiceNow instance and Amazon Elastic Container Service account by using the AWS credentials to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub subscription.
- Activate Amazon Elastic Container Service spoke.
- Role required: admin

**Create a credential record for the Amazon Elastic Container Service spoke**

Create a credential record for the Amazon Elastic Container Service account. The Amazon Elastic Container Service spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   - The system displays this message: What type of Credentials would you like to create?
3. Select AWS Credentials.
4. On the form, fill these values.
AWS Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Amazon ECS Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID of the user with full access to Amazon Elastic Container Service.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Secret Access Key of the user with full access to Amazon Elastic Container Service.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select AmazonECSAuthAlgo.</td>
</tr>
<tr>
<td>Note:</td>
<td>Users are cautioned against directly modifying the default authentication algorithm.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias associated with the spoke.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Amazon EC2 spoke v1.1**

Integrate ServiceNow instance with Amazon Elastic Compute Cloud (EC2). Manage Amazon instances, Amazon Machine Images (AMIs), Key Pairs, and Tags from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• Complex Object (com.glide.cobject)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)

ℹ️ Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported Versions
This spoke was built for API version 2016-11-15, but may be compatible with later versions.

Spoke requirements
• User with full access to Amazon EC2.
• Access Key ID and Secret Access Key of the user. Record these values for later use.

Spoke flows and subflows
This spoke has no flows and subflows.

Spoke actions
The Amazon EC2 spoke provides actions to automate Amazon EC2 tasks when events occurs in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amazon Machine Image Management</td>
<td>Copy Image</td>
<td>Copies an Amazon Machine Image (AMI) from the specified source region to the current region.</td>
</tr>
<tr>
<td></td>
<td>Create Image</td>
<td>Creates an Amazon EBS supported AMI from an Amazon EBS supported instance that is either running or stopped.</td>
</tr>
</tbody>
</table>
### Spoke Actions (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Deregister Image</td>
<td>Deregisters the specified AMI.</td>
</tr>
<tr>
<td></td>
<td>List Image Attribute</td>
<td>Retrieves the specified AMI attribute.</td>
</tr>
<tr>
<td></td>
<td>List Images</td>
<td>Retrieves the specified AMIs.</td>
</tr>
<tr>
<td>Instance Management</td>
<td>Get Instance Attribute</td>
<td>Retrieves the specified attribute of the specified instance.</td>
</tr>
<tr>
<td></td>
<td>Get Instances Status</td>
<td>Retrieves the status of the specified instance.</td>
</tr>
<tr>
<td></td>
<td>Get Password Data</td>
<td>Retrieves the encrypted administrator password for an active Windows instance.</td>
</tr>
<tr>
<td></td>
<td>List Instance Types</td>
<td>Retrieves the list of all instance types in an AWS region.</td>
</tr>
<tr>
<td></td>
<td>List Instances</td>
<td>Retrieves a list of all instances.</td>
</tr>
<tr>
<td></td>
<td>Monitor Instances</td>
<td>Enables monitoring for all active instances.</td>
</tr>
<tr>
<td></td>
<td>Reboot Instances</td>
<td>Reboots the specified instances.</td>
</tr>
<tr>
<td></td>
<td>Run Instances</td>
<td>Launches the specified number of instances using an AMI.</td>
</tr>
<tr>
<td></td>
<td>Start Instances</td>
<td>Starts the specified instances.</td>
</tr>
<tr>
<td></td>
<td>Stops Instances</td>
<td>Stops the specified instances.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Terminating Actions</td>
<td>Terminate Instances</td>
<td>Shutdowns or terminates the specified instances.</td>
</tr>
<tr>
<td>Unmonitoring Actions</td>
<td>Unmonitor Instances</td>
<td>Disables monitoring for the specified running instances.</td>
</tr>
<tr>
<td>Updating Attribute</td>
<td>Update Instance Attribute</td>
<td>Updates the specified attribute for the specified instance.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> You can specify only one attribute at a time. Before you update an attribute, ensure that the instance is stopped.</td>
</tr>
<tr>
<td>Key Pair Management</td>
<td>Create Key Pair</td>
<td>Creates a 2048-bit SSH-2 RSA key pair.</td>
</tr>
<tr>
<td></td>
<td>Delete Key Pair</td>
<td>Deletes the specified key pair.</td>
</tr>
<tr>
<td></td>
<td>List Key Pair</td>
<td>Retrieves the specified key pair or a list of all key pairs.</td>
</tr>
<tr>
<td>Region and Availability Zone Management</td>
<td>Get Availability Zones</td>
<td>Retrieves the list of availability zones in the specified AWS region.</td>
</tr>
<tr>
<td></td>
<td>List Regions</td>
<td>Retrieves the list of all AWS regions.</td>
</tr>
<tr>
<td>Tag Management</td>
<td>Create Tags</td>
<td>Adds or overwrites the specified set of tags from the specified set of resources.</td>
</tr>
<tr>
<td></td>
<td>Delete Tags</td>
<td>Deletes the specified set of tags from</td>
</tr>
</tbody>
</table>
Spoke Actions (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>List Tags</td>
<td>Retrieves the list of tags for the specified region.</td>
</tr>
</tbody>
</table>

Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Setup the Amazon EC2 spoke

Integrate the ServiceNow instance and Amazon EC2 using AWS credentials to authenticate ServiceNow requests.

Before you begin

- Request an IntegrationHub Enterprise subscription
- Activate the Amazon EC2 spoke
- Role required: admin

Create Credentials record for the Amazon EC2 spoke

Create Credential records for the Amazon EC2 instance. The Amazon EC2 spoke connection and credential alias uses these credentials to authorize actions.

Before you begin

Role required: admin

Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open the record for AWS EC2.
3. From the Credentials tab, click New. The system displays the message: What type of Credentials would you like to create?.

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
4. Select **AWS Credentials**.

5. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter AWS Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID of the user with full access to EC2.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Secret Access Key of the user with full access to EC2.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Associated credential record.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select AmazonEC2AuthAlgo.</td>
</tr>
</tbody>
</table>

**Note:** Do not directly modify the default authentication algorithm.

6. Click **Submit**.

**Amazon RDS spoke v1.0.1**

Integrate ServiceNow instance with Amazon Relational Database Service (RDS). Manage the process of performing various operations like set up, operate, and scale on Amazon RDS using this spoke.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.
Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- Complex Object (com.glide.cobject)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)

⚠️ Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported Versions
This spoke was built for API version 2014-09-01 and 2014-10-31, but may be compatible with later versions.

Spoke Requirements
- User with full access to Amazon RDS.
- Access Key ID and Secret Access Key of the user. Record these values for later use.

Spoke flows and subflows
This spoke has no flows and subflows.

Spoke actions
The Amazon RDS spoke provides actions to automate Amazon RDS tasks when events occurs in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Spoke Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
</tr>
<tr>
<td>Account Management</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Category</td>
</tr>
<tr>
<td>--------------------------</td>
</tr>
<tr>
<td>DB Engines Management</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>DB Snapshots Management</td>
</tr>
</tbody>
</table>

**Note:** When you delete a DB instance, all the automated backups of that instance are also deleted and cannot be recovered.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Delete DB Snapshot</td>
<td>Deletes a snapshot of a DB instance.</td>
</tr>
<tr>
<td></td>
<td>List DB Snapshots</td>
<td>Retrieves the list of snapshots of a DB instance.</td>
</tr>
<tr>
<td></td>
<td>Update DB Snapshot</td>
<td>Updates a snapshot of a DB instance.</td>
</tr>
<tr>
<td>Event Management</td>
<td>Create Event Subscription</td>
<td>Creates an RDS event notification subscription.</td>
</tr>
<tr>
<td></td>
<td>Delete Event Subscription</td>
<td>Deletes an event notification subscription.</td>
</tr>
<tr>
<td></td>
<td>List Event Categories</td>
<td>Retrieves a list of categories for the specified or all event source types.</td>
</tr>
<tr>
<td></td>
<td>List Event Subscriptions</td>
<td>Retrieves a list of all subscription descriptions of a customer account.</td>
</tr>
<tr>
<td></td>
<td>List Events</td>
<td>Retrieves a list of events of the RDS resources.</td>
</tr>
<tr>
<td></td>
<td>Update Event Subscription</td>
<td>Updates an existing event notification subscription.</td>
</tr>
<tr>
<td>Groups Management</td>
<td>Create DB Parameter Group</td>
<td>Creates a DB parameter group.</td>
</tr>
<tr>
<td></td>
<td>Create DB Subnet Group</td>
<td>Creates a DB subnet group.</td>
</tr>
</tbody>
</table>
### Spoke Actions (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Note:</td>
<td>A DB subnet group must contain at least one subnet in at least two Availability Zones (AZ) in the Amazon Web Services (AWS) region.</td>
</tr>
<tr>
<td>Create Option Group</td>
<td></td>
<td>Creates an option group.</td>
</tr>
<tr>
<td>Delete DB Parameter Group</td>
<td></td>
<td>Deletes the specified DB parameter group.</td>
</tr>
<tr>
<td></td>
<td>Note:</td>
<td>Before deleting the DB parameter group, ensure that DB parameter group is not associated with any DB instances.</td>
</tr>
<tr>
<td>Delete DB Subnet Group</td>
<td></td>
<td>Deletes a DB subnet group.</td>
</tr>
<tr>
<td>Delete Option Group</td>
<td></td>
<td>Deletes an existing option group.</td>
</tr>
<tr>
<td>List DB Parameter Groups</td>
<td></td>
<td>Retrieves a list of DB parameter groups.</td>
</tr>
<tr>
<td>List DB Subnet Groups</td>
<td></td>
<td>Retrieves a list of DB subnet group descriptions.</td>
</tr>
<tr>
<td></td>
<td>Note:</td>
<td>If a DB subnet group name is specified, the list contains descriptions of only the specified DB subnet group.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>List Option Groups</td>
<td>Retrieves a list of option groups.</td>
</tr>
<tr>
<td></td>
<td>Reset DB Parameter Group</td>
<td>Modifies the parameters of a DB parameter group to the engine or system default values.</td>
</tr>
<tr>
<td></td>
<td>Update DB Parameter Group</td>
<td>Updates the parameters of the specified DB parameter group.</td>
</tr>
<tr>
<td></td>
<td>Update DB Subnet Group</td>
<td>Updates an existing DB subnet group.</td>
</tr>
<tr>
<td></td>
<td>Update Option Group</td>
<td>Updates an existing option group.</td>
</tr>
<tr>
<td>Logs Management</td>
<td>List DB Log Files</td>
<td>Retrieves a list of all the log files of a DB instance.</td>
</tr>
<tr>
<td></td>
<td>View DB Log File</td>
<td>Displays a part of or an entire specified log file.</td>
</tr>
<tr>
<td>Tags Management</td>
<td>Add Tags To RDS Resource</td>
<td>Adds tags to RDS resource.</td>
</tr>
<tr>
<td></td>
<td>List Tags For RDS Resource</td>
<td>Retrieves a list of tags of RDS resource.</td>
</tr>
</tbody>
</table>
Spoke Actions (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Remove Tags From RDS Resource</td>
<td>Removes the tags from an RDS resource.</td>
</tr>
</tbody>
</table>

Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the Amazon RDS spoke

Integrate the ServiceNow instance and Amazon RDS using AWS credentials to authenticate ServiceNow requests.

Before you begin

- Request an IntegrationHub Enterprise subscription
- Activate the Amazon RDS spoke
- Role required: admin

Create Credentials records for the Amazon RDS spoke

Create Credential records for the Amazon RDS instance. The Amazon RDS spoke connection and credential alias uses these credentials to authorize actions.

Before you begin

Role required: admin

Procedure

1. Navigate to Connections & Credentials > Connection & Credentials Aliases.
2. Open for the record for Amazon RDS.
3. From the Credentials tab, click New. The system displays the message What type of Credentials would you like to create?.
4. Select AWS Credentials.
5. On the form, fill these fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter AWS Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID of the user with full access to Amazon RDS.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Secret Access Key of the user with full access to Amazon RDS.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Associated credential record.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select Amazon RDS Auth Algorithm.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

**Amazon Route53 spoke**

Integrate ServiceNow instance with Amazon Route 53. Manage domain registrations, Domain Name System (DNS) routing, and health checking from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.
Supported versions
This spoke was built for Amazon Route 53 API version 2013-04-01, but may be compatible with later versions.

Spoke requirements
• User with full access to Amazon Route 53 account.
• Access Key ID and Secret Access Key of the user. Record these values for later use.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
• Complex Object (com.glide.cobject)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Amazon Route53 Spoke provides actions to automate Amazon Route 53 tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain Management</td>
<td>Check Domain Availability</td>
<td>Checks and returns the availability of a domain name.</td>
</tr>
</tbody>
</table>

⚠️ Note: If a domain name is in pending state, you must check the availability of the domain name again, until the status is processed.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Get Domain Details</td>
<td>Retrieves detailed information about a specified domain that is associated with the current AWS account.</td>
</tr>
<tr>
<td></td>
<td>Look up Domain Suggestions</td>
<td>Retrieves a list of suggested domain names.</td>
</tr>
<tr>
<td></td>
<td>Look up Domains</td>
<td>Retrieves all the domain names registered with Amazon Route 53 for the current AWS account.</td>
</tr>
<tr>
<td></td>
<td>View Billing</td>
<td>Retrieves all the domain related billing records for the current AWS account for a specified period.</td>
</tr>
<tr>
<td>Hosted Zone Management</td>
<td>Create Hosted Zone</td>
<td>Creates a new public or private hosted zone.</td>
</tr>
<tr>
<td></td>
<td>Delete Hosted Zone</td>
<td>Deletes a hosted zone.</td>
</tr>
<tr>
<td></td>
<td>Get Change</td>
<td>Retrieves the current status of a change batch request.</td>
</tr>
<tr>
<td></td>
<td>Get Hosted Zone</td>
<td>Retrieves information about a specified hosted zone.</td>
</tr>
<tr>
<td></td>
<td>Get Hosted Zone Count</td>
<td>Retrieves total number of hosted zones for the account.</td>
</tr>
<tr>
<td></td>
<td>Get Hosted Zone Limit</td>
<td>Retrieves the specified limit for a specified hosted zone.</td>
</tr>
<tr>
<td></td>
<td>Look up Hosted Zones</td>
<td>Retrieves a list of associated public and private hosted zones.</td>
</tr>
<tr>
<td></td>
<td>Look up Hosted Zones By Name</td>
<td>Retrieves a list of the hosted zones in alphabetical order.</td>
</tr>
<tr>
<td></td>
<td>Update Hosted Zone Comment</td>
<td>Updates the comment for a specified hosted zone.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Record Set Management</td>
<td>Delete GeoLocation Record Set</td>
<td>Deletes a GeoLocation resource record set that contains authoritative DNS information for a specified domain name or subdomain name.</td>
</tr>
<tr>
<td></td>
<td>Delete Simple Record Set</td>
<td>Deletes a simple resource record set that contains authoritative DNS information for a specified domain name or subdomain name.</td>
</tr>
<tr>
<td></td>
<td>Delete Weighted Record Set</td>
<td>Deletes a weighted resource record set that contains authoritative DNS information for a specified domain name or subdomain name.</td>
</tr>
<tr>
<td></td>
<td>Look up Record Sets</td>
<td>Retrieves a list of resource record sets in a specified hosted zone.</td>
</tr>
<tr>
<td></td>
<td>Test DNS Answer</td>
<td>Retrieves the value that Amazon Route 53 returns in response to a DNS request for a specified record name and type.</td>
</tr>
<tr>
<td></td>
<td>Upsert GeoLocation Record Set</td>
<td>Creates a GeoLocation resource record set or updates an existing GeoLocation resource record set that contains authoritative DNS information for a specified domain name or subdomain name.</td>
</tr>
<tr>
<td></td>
<td>Upsert Simple Record Set</td>
<td>Creates a simple record set or updates an existing simple resource record set that contains authoritative DNS information for a specified domain name or subdomain name.</td>
</tr>
<tr>
<td></td>
<td>Upsert Weighted Record Set</td>
<td>Creates a weighted resource record set or updates an existing weighted resource record set that contains authoritative DNS information for a specified domain name or subdomain name.</td>
</tr>
<tr>
<td>Tag Management</td>
<td>Add Tags For Domain</td>
<td>Assigns a set of tags to a domain.</td>
</tr>
<tr>
<td></td>
<td>Add Tags For Hosted Zone</td>
<td>Assigns a set of tags to a hosted zone.</td>
</tr>
<tr>
<td></td>
<td>Look up Tags For Domain</td>
<td>Retrieves a list of tags that are associated with the specified domain.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Look up Tags For Hosted Zone</td>
<td>Retrieves a list of tags that are associated to the specified domain.</td>
</tr>
<tr>
<td></td>
<td>Remove Tags From Domain</td>
<td>Removes tags that are associated to a domain.</td>
</tr>
<tr>
<td></td>
<td>Remove Tags From Hosted Zone</td>
<td>Removes tags that are associated to a hosted zone.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the Amazon Route53 spoke**

Integrate the ServiceNow instance and Amazon Route 53 by using the AWS credentials to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub subscription.
- Activate Amazon Route53 spoke
- Role required: admin

**Create a credential record for the Amazon Route53 spoke**

Create a credential record for the Amazon Route53 custom application. The Amazon Route53 spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to IntegrationHub > Connections & Credentials > Credentials.
2. Click New.

The system displays this message: What type of Credentials would you like to create?
3. Select **AWS Credentials**.
4. On the form, fill these values.

**AWS Credentials form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Amazon Route53 Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID of your AWS account.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Secret Access Key of your AWS account.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select <strong>Amazon Route53</strong>.</td>
</tr>
<tr>
<td>Note:</td>
<td>Users are cautioned against directly modifying the default authentication algorithm.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias associated with the spoke. <strong>sn_amzn_rout53_spk.AmazonRoute53</strong></td>
</tr>
</tbody>
</table>

5. Right-click the form header and click **Submit**.

**Amazon S3 spoke v1.0.1**

Integrate ServiceNow with Amazon S3. Manage buckets, objects, tags, and related ACLs in Amazon S3 from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Supported version**

This spoke was built for API version 2010-03-31, but may be compatible with later versions.
**Spoke requirements**

- User with full access to Amazon S3.
- Access Key ID and Secret Access Key of the user. Record these values for later use.

For information about creating and accessing keys, see the AWS Security Credentials documentation.

**Spoke actions**
The Amazon S3 spoke provides actions to automate Amazon S3 tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bucket Management</td>
<td>Create Bucket</td>
<td>Creates a bucket in Amazon S3.</td>
</tr>
<tr>
<td></td>
<td>Create ACL</td>
<td>Create new ACL for a bucket and delete the existing one.</td>
</tr>
<tr>
<td></td>
<td>Get Bucket ACLs</td>
<td>Retrieve the ACLs present on a bucket.</td>
</tr>
<tr>
<td></td>
<td>List Buckets</td>
<td>List Amazon S3 buckets.</td>
</tr>
<tr>
<td>Object Management</td>
<td>Copy Object</td>
<td>Copies object from source to destination.</td>
</tr>
<tr>
<td></td>
<td>Delete Object</td>
<td>Deletes specified object from a bucket.</td>
</tr>
<tr>
<td></td>
<td>Get ACL</td>
<td>Retrieves the ACL details for the requested resource.</td>
</tr>
<tr>
<td></td>
<td>List Objects By Bucket</td>
<td>Lists the objects in the specified Amazon S3 bucket.</td>
</tr>
<tr>
<td></td>
<td>List Tags</td>
<td>Lists tags of the specified Amazon S3 resource.</td>
</tr>
<tr>
<td></td>
<td>Update Tags</td>
<td>Updates the tags of the specified Amazon S3 resource.</td>
</tr>
<tr>
<td></td>
<td>Download S3 Object to ServiceNow Record</td>
<td>Downloads the requested object from Amazon S3 and attaches it to a record in ServiceNow.</td>
</tr>
<tr>
<td></td>
<td>Upload ServiceNow Attachment to S3</td>
<td>Uploads file from the System Attachment Table (sys_attachment) to a specified Amazon S3 bucket.</td>
</tr>
</tbody>
</table>
Note: Spoke actions can be used independently without subscribing to notifications from Amazon S3.

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the Amazon S3 spoke
Use Amazon S3 as file storage in place of attachments in ServiceNow. Adds Amazon S3 storage to your ServiceNow instance and enables users to reference Amazon S3 files in ServiceNow records.

Before you begin
• Request an IntegrationHub subscription
• Activate the Amazon S3 spoke
• Role required: admin

Create Credential record for the Amazon S3 spoke
Create Credential record for your AWS account. The Amazon S3 spoke uses this credential to perform actions on Amazon S3.

Procedure
1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for Amazon S3.
3. From the Credentials tab, click New.
   The system displays the message What type of Credentials would you like to create?.
4. Select AWS Credentials.
5. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter S3 Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Select Active to use the credential record.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID of your AWS account.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Secret Access Key of your AWS account.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>sn_amazon_s3_spoke Amazon S3</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select Amazon S3.</td>
</tr>
</tbody>
</table>

*i Note:* Users are cautioned against directly modifying the default authentication algorithm.

*i Note:* To create the Access key ID and secret access key, log into the AWS console. From your account menu, select *My Security Credentials.*

6. Click **Submit**.

**Results**
The credential record for the Amazon S3 spoke is created.

**Amazon SNS spoke**
Integrate ServiceNow with Amazon SNS. Manage topics and subscriptions, and delegate roles in Amazon SNS from your ServiceNow instance.

**Request apps on the Store**
Visit the *ServiceNow Store* website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the *ServiceNow Store version history release notes.*

**IntegrationHub subscription**
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see *Request IntegrationHub.*

**Supported version**
This spoke was built for API version 2010-03-31, but may be compatible with later versions.
**Spoke requirements**

- User with full access to Amazon SNS.
- Access Key ID and Secret Access Key of the user. Record these values for later use.

For information about creating and accessing keys, see the AWS Security Credentials documentation.

**Spoke subflows**

The Amazon SNS spoke provides a sample subflow to demonstrate automating Amazon SNS tasks. To customize the sample subflow, copy it to a new application scope. Available sample subflow is, Amazon SNS Subscription. The subflow receives three types of messages; Notification, Subscription Confirmation, and Unsubscribe Confirmation. This subflow is triggered when you configure your ServiceNow instance to receive events from Amazon SNS. For more information about the required configurations, see Receive events at your ServiceNow instance from Amazon SNS.

⚠️ Note: Spoke subflow can be used independently to subscribe for notifications from Amazon SNS. For more information about the configurations, see Receive events at your ServiceNow instance from Amazon SNS.

**Spoke actions**

The Amazon SNS spoke provides actions to automate Amazon SNS tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permission Management</td>
<td>Add Permission</td>
<td>Adds a statement to a topic's access control policy and grants access for the specified AWS accounts for the specified actions.</td>
</tr>
<tr>
<td></td>
<td>Remove Permission</td>
<td>Removes a statement from a topic's access control policy and revokes access for the specified AWS accounts for the specified actions.</td>
</tr>
<tr>
<td>Subscription Management</td>
<td>Confirm Subscription</td>
<td>Verifies intent of endpoint owner to receive messages by validating the token sent to the endpoint through an earlier Subscribe action.</td>
</tr>
<tr>
<td></td>
<td>Create Subscription</td>
<td>Creates a subscription on a topic.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Delete Subscription</td>
<td>Deletes a subscription on a topic.</td>
</tr>
<tr>
<td></td>
<td>Get Subscription Attributes</td>
<td>Retrieves all properties of a subscription.</td>
</tr>
<tr>
<td></td>
<td>List Subscriptions</td>
<td>Retrieves a list of all subscriptions to a specific region.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td></td>
<td>In your flow, use the Get Subscription Attributes action before this action to populate the required records.</td>
</tr>
<tr>
<td></td>
<td>List Subscriptions By Topic</td>
<td>Retrieves a list of the subscriptions to a specific topic.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td></td>
<td>In your flow, use the Get Subscription Attributes action before this action to populate the required records.</td>
</tr>
<tr>
<td></td>
<td>Set Subscription Attributes</td>
<td>Enables a subscription owner to set an attribute of the subscription to a new value.</td>
</tr>
<tr>
<td><strong>Topics Management</strong></td>
<td>Create Topic</td>
<td>Creates a topic for which notifications can be published.</td>
</tr>
<tr>
<td></td>
<td>Delete Topic</td>
<td>Deletes a topic and all its subscriptions.</td>
</tr>
<tr>
<td></td>
<td>Get Topic Attributes</td>
<td>Retrieves all properties of a topic. Topic properties retrieved may differ based on the authorization of the user.</td>
</tr>
<tr>
<td></td>
<td>List Topics</td>
<td>Retrieves a list of the requester's topics.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td></td>
<td>In your flow, use the Get Topic Attributes action before this action to populate the required records.</td>
</tr>
<tr>
<td></td>
<td>Set Topic Delivery Policy</td>
<td>Enables a topic owner to set a delivery policy of the topic to a new value.</td>
</tr>
<tr>
<td></td>
<td>Set Topic Display Name</td>
<td>Enables a topic owner to set a display name of the topic to a new value.</td>
</tr>
</tbody>
</table>
Note: Spoke actions can be used independently without subscribing to notifications from Amazon SNS.

Spoke module
The Amazon SNS spoke adds an AWS Configurations module to your ServiceNow instance. If you want receive events at your ServiceNow instance from Amazon SNS, you must specify the subflow internal name here. For more information about the required configurations, see Receive events at your ServiceNow instance from Amazon SNS.

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the Amazon SNS spoke
Integrate the ServiceNow instance and Amazon SNS using AWS credential to authenticate ServiceNow requests.

Before you begin
- Request anIntegrationHub subscription
- Activate the Amazon SNS spoke
- Role required: admin

About this task
To receive events at your ServiceNow instance from Amazon SNS, see Receive events at your ServiceNow instance from Amazon SNS. Spoke set up described here enables you to use spoke subflow and actions.

Create Credential record for the Amazon SNS spoke
Create Credential record for your AWS account. The Amazon SNS spoke uses this credential to perform actions on Amazon SNS.

Procedure
1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for Amazon SNS.
3. From the Credentials tab, click New.
The system displays the message What type of Credentials would you like to create?

4. Select AWS Credentials.

5. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter SNS Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID of your AWS account.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Secret Access Key of your AWS account.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Associated credential record.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select SNS Algorithm.</td>
</tr>
</tbody>
</table>

† Note: Users are cautioned against directly modifying the default authentication algorithm.

6. Click Submit.

Results
The credential record for the Amazon SNS spoke is created.

Receive events at your ServiceNow instance from Amazon SNS
Receive events (Notification, Subscription Confirmation, and Unsubscribe Confirmation) from Amazon SNS at your ServiceNow instance.

Before you begin
• Request an IntegrationHub subscription
• Activate the Amazon SNS spoke
• Role required: admin

About this task
You can receive events at your ServiceNow instance from Amazon SNS even without setting up the Amazon SNS spoke. To set up the Amazon SNS spoke and use the spoke actions, see Set up the Amazon SNS spoke.
Create secret for the Amazon SNS spoke
Create a client secret to authorize requests from Amazon SNS.

Procedure
1. Navigate to System Definition > Scripts - Background.
2. Enter this command in the Run script (JavaScript executed on server) text field:
   \[\text{gs.info(GlideSecureRandomUtil.getSecureRandomString(32));}\]
3. Click Run Script.
4. Copy and record the generated value for later use.

Create a record in AWS Configurations
Create a record in AWS Configurations to authorise requests from Amazon SNS spoke.

Procedure
1. Navigate to AWS Configuration > All Configurations.
2. Click New.
3. On the form, fill these values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property Value</td>
<td>Internal name of the Amazon SNS Subscription subflow. For example,</td>
</tr>
<tr>
<td></td>
<td>\text{amazon_sns_subscription.}</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Note:</td>
<td>The Amazon SNS Subscription subflow is a sample subflow. You must create a copy of this subflow and use it to customize event management as per your requirement. In this case, specify the internal name of the customized subflow.</td>
</tr>
<tr>
<td>Property Name</td>
<td>Name to identify the record.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret generated by the script. For information about generating Client Secret see, Create secret for the Amazon SNS spoke.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click **Save**.

5. Right-click the form header and click **Copy sys_id**. Record this value for later use.

**Record the Base API path of the Amazon SNS spoke**

Record the Base API path of the Amazon SNS spoke to authorise requests from Amazon SNS.

**Procedure**

1. Navigate to **System Web Services > Scripted Web Services > Scripted REST APIs**.

2. Open the record for **Amazon SNS**.

3. Copy and record the value of **Base API path** for later use.

**Create topic**

Use the Create Topic spoke action to create a topic in Amazon SNS for your ServiceNow instance.
Procedure

1. In Flow Designer, create a flow and include the Create Topic spoke action. For information about creating flows in Flow Designer, see Flows.

2. Customize flow to provide these values as inputs to the Create Topic spoke action:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td>AWS geographic area where the infrastructure is housed.</td>
</tr>
<tr>
<td>Topic Name</td>
<td>Name to identify the topic.</td>
</tr>
</tbody>
</table>

3. Test the flow and check the **Executions** tab to ensure that flow is executed as expected.

Create subscription

Use the Create Subscription spoke action to create subscription in Amazon SNS for your ServiceNow instance.

Procedure

1. In Flow Designer, create a flow and include the Create Subscription spoke action. For information about creating flows in Flow Designer, see Flows.

2. Customize flow to provide these values as inputs to the Create Subscription spoke action:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td>AWS geographic area where the infrastructure is housed.</td>
</tr>
<tr>
<td>Topic ARN</td>
<td>ARN to uniquely identify the required topic. Subscriptions are created for this topic.</td>
</tr>
<tr>
<td>Protocol</td>
<td>HTTPS</td>
</tr>
</tbody>
</table>

**Note:** For information about obtaining the required values, see Record the Base API path of the Amazon SNS spoke, Create a record in AWS Configurations, and Create secret for the Amazon SNS spoke.
3. Test the flow.
   The flow internally triggers the default Amazon SNS Subscription subflow.

4. In the Executions tab, open the record associated with the subflow execution.
   
   **Note:** Ensure that you check the execution details of the default Amazon SNS Subscription subflow, not the flow you had created.

5. In the Execution Details page, click **RUNTIME VALUE**.

6. Copy and record the value of Token for later use. This confirmation token is needed to Confirm subscription.

   ![RUNTIME VALUE](image)

   **Note:** Ensure that you use the confirmation token to Confirm subscription within its validity period.

**Results**

Subscription for the required topic in Amazon SNS for your ServiceNow instance is created.

**Confirm subscription**

Use the Confirm Subscription spoke action to confirm subscription in Amazon SNS for your ServiceNow instance.

**Procedure**

1. In Flow Designer, create a copy of the default Amazon SNS Subscription subflow. For information about using subflows in Flow Designer, see **Subflows**.

2. In Flow Designer, create a flow that includes the copy of the default subflow. For information about creating flows in Flow Designer, see **Flows**.

3. Customize the subflow to include the Confirm Subscription spoke action.
4. Customize subflow to provide these values as inputs to the Confirm Subscription spoke action:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td>AWS geographic area where the infrastructure is housed.</td>
</tr>
<tr>
<td>Topic ARN</td>
<td>ARN to uniquely identify the required topic. Subscriptions are created for this topic.</td>
</tr>
<tr>
<td>Token</td>
<td>Confirmation token generated after creating subscription. See Create subscription, for more information.</td>
</tr>
</tbody>
</table>

Note: Ensure that you use the confirmation token to confirm subscription within its validity period.

5. Test the flow and check the Executions tab to ensure that flow is executed as expected.

Results
The Amazon SNS subscription for your ServiceNow instance is confirmed.

Customize event management
Customize the management of events (Notification, Subscription Confirmation, and Unsubscribe Confirmation) you receive for your ServiceNow instance from Amazon SNS.

Procedure
1. In Flow Designer, create a copy of the default subflow, Amazon SNS Subscription and customize the subflow as per your requirement. For more information about creating subflows, see Subflows.

2. Copy and record the internal name of the customized subflow.

3. Navigate to AWS Configuration > All Configurations.

4. Open the record you had created to receive events. In this record, the internal name of the default Amazon SNS Subscription subflow is specified in Property Value.

5. Update this record by replacing the internal name of default subflow with the internal name of the customized subflow in Property Value.

Note: Use the same Client Secret.
Results
The event management is customized as per your requirement.

Amazon VPC spoke v1.0.1
Provision a logically isolated section of the AWS cloud using Amazon VPC and launch the required AWS resources in a virtual network, from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

⚠️ Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported version
This spoke was built for API version 2016-11-15, but may be compatible with later versions.

⚠️ Note: If you use different API version, ensure that you change the API version in all spoke actions.
Spoke requirements

- User with full access to Amazon VPC.
- Access Key ID and Secret Access Key of the user. Record these values for later use.

For more information about creating user in IAM and providing the required access, see Understanding and Getting Your Security Credentials page on the AWS Documentation site.

Spoke subflows

The Amazon VPC spoke provides sample subflows to demonstrate automating Amazon VPC tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Subnet</td>
<td>Deletes the specified subnet. Before you delete the subnet, you must terminate all the running instances in the subnet.</td>
</tr>
<tr>
<td>Delete VPC</td>
<td>Deletes the specified VPC. Before you delete the VPC, you must terminate all the associated instances.</td>
</tr>
</tbody>
</table>

Spoke actions

The Amazon VPC spoke provides actions to automate Amazon VPC tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network &amp; Security Group Management</td>
<td>Add Egress Rules To A Security Group</td>
<td>Adds the specified egress rules to a security group.</td>
</tr>
<tr>
<td></td>
<td>Add Ingress Rules To A Security Group</td>
<td>Adds the specified ingress rules to a security group.</td>
</tr>
<tr>
<td></td>
<td>Create Security Group</td>
<td>Creates a security group.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Delete Egress Rules From Security Group</td>
<td>Removes the specified egress rules from security group. Values must match the existing rule's values exactly.</td>
</tr>
<tr>
<td></td>
<td>Delete Ingress Rules From Security Group</td>
<td>Adds the specified ingress rules to a security group.</td>
</tr>
<tr>
<td></td>
<td>Delete Security Group</td>
<td>Deletes a security group.</td>
</tr>
<tr>
<td></td>
<td>List Security Groups</td>
<td>Lists the specified security groups or all of your security groups.</td>
</tr>
<tr>
<td></td>
<td>Lookup Security Group</td>
<td>Retrieves the specified security group.</td>
</tr>
<tr>
<td>Virtual Private Cloud Management</td>
<td>Create Subnet</td>
<td>Creates a subnet in an existing VPC.</td>
</tr>
<tr>
<td></td>
<td>Create VPC</td>
<td>Creates a VPC with the specified IPv4 CIDR block and can optionally request an IPv6 CIDR block for the VPC.</td>
</tr>
<tr>
<td></td>
<td>Delete NAT Gateway</td>
<td>Deletes the specified NAT gateway. Deleting a NAT gateway disassociates its Elastic IP address, but does not release it.</td>
</tr>
<tr>
<td></td>
<td>Delete Route Table</td>
<td>Deletes the specified route table. You must disassociate the route table from any subnets before you can delete it.</td>
</tr>
<tr>
<td></td>
<td>Delete Subnet</td>
<td>Deletes the specified subnet. You must terminate all running instances in the subnet before you can delete the subnet.</td>
</tr>
<tr>
<td></td>
<td>Delete VPC</td>
<td>Deletes the specified VPC. You must detach or delete all gateways and resources that are associated with the VPC before you can delete it or use Delete VPC subflow.</td>
</tr>
</tbody>
</table>
## Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

## Set up the Amazon VPC spoke

Integrate the ServiceNow instance and Amazon VPC using AWS credential to authenticate ServiceNow requests.
Before you begin

- Request an IntegrationHub subscription
- Activate the Amazon VPC spoke
- Role required: admin

Create Credential record for the Amazon VPC spoke

Create Credential record for your Amazon VPC account. The Amazon VPC spoke connection and credential alias uses this credential to perform actions on Amazon VPC.

Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for Amazon VPC.
3. From the Credentials tab, click New. The system displays the message What type of Credentials would you like to create?.
4. Select AWS Credentials.
5. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter VPC Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID of the user with full access to Amazon VPC.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Secret Access Key of the user with full access to Amazon VPC.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Associated credential record.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select AmazonVPCAuthAlgo.</td>
</tr>
</tbody>
</table>

Note: Users are cautioned against directly modifying the default authentication algorithm.

6. Click Submit.
Results
The credential record the Amazon VPC spoke is created.

Ansible spoke v1.0.2
Integrate your ServiceNow instance with Ansible Tower. Automate Ansible Tower tasks when events occur in ServiceNow.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.

Note: This spoke is available to new customers as part of an IntegrationHub Professional subscription. Existing customers can use this spoke as part of an IntegrationHub Standard subscription.

Supported version
This spoke was built for Ansible Tower v2, but may be compatible with later versions.

Spoke requirements
• Ansible Tower
• If you are using custom OAuth application:
  ◦ Ansible Tower administrator credentials to create a custom application
  ◦ Application information such as Client ID and Client Secret
• If you are using basic authentication, credentials of the user with System Administrator role to log in to Ansible Tower.

Spoke actions
The Ansible spoke provides actions to automate Ansible Tower tasks when events occur in ServiceNow. Available actions include:
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ansible Tower</td>
<td>Cancel Job</td>
<td>Cancels the required job in the Ansible Tower environment.</td>
</tr>
<tr>
<td></td>
<td>Create Job Template</td>
<td>Creates a job template in Ansible Tower.</td>
</tr>
<tr>
<td></td>
<td>Create User</td>
<td>Creates a user in the Ansible Tower environment.</td>
</tr>
<tr>
<td></td>
<td>Delete User</td>
<td>Deletes the required user in the Ansible Tower environment.</td>
</tr>
<tr>
<td></td>
<td>Get Job</td>
<td>Retrieves details of the required job in the Ansible Tower environment.</td>
</tr>
<tr>
<td></td>
<td>Get Status From Ad-Hoc Command</td>
<td>Retrieves the run status of an ad-hoc command.</td>
</tr>
<tr>
<td></td>
<td>Get User</td>
<td>Retrieves details of the required user in the Ansible Tower environment.</td>
</tr>
<tr>
<td></td>
<td>Launch Job Template</td>
<td>Launches a job template in the Ansible Tower environment.</td>
</tr>
<tr>
<td></td>
<td>List Hosts From Inventory</td>
<td>Retrieves list of hosts from an inventory in the Ansible Tower environment.</td>
</tr>
<tr>
<td></td>
<td>List Instance Groups From Inventory</td>
<td>Retrieves list of instance groups from an inventory in the Ansible Tower environment.</td>
</tr>
<tr>
<td></td>
<td>List Job Templates</td>
<td>Retrieves the list of job templates.</td>
</tr>
<tr>
<td></td>
<td>List Jobs</td>
<td>Retrieves the list of jobs.</td>
</tr>
<tr>
<td></td>
<td>List Users</td>
<td>Retrieves the list of users.</td>
</tr>
<tr>
<td></td>
<td>Relaunch Job</td>
<td>Relaunches job in the Ansible Tower environment.</td>
</tr>
<tr>
<td></td>
<td>Run An Ad-Hoc Command</td>
<td>Runs an ad hoc command on one or more target devices.</td>
</tr>
<tr>
<td></td>
<td>Schedule Job</td>
<td>Schedules a job in the Ansible Tower environment.</td>
</tr>
<tr>
<td></td>
<td>Update User</td>
<td>Updates details of the required user in the Ansible Tower environment.</td>
</tr>
</tbody>
</table>
### Metadata Retrieval

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Credentials</td>
<td>Get Inventories</td>
<td>Retrieves credentials in the Ansible Tower environment.</td>
</tr>
<tr>
<td>Get Inventories</td>
<td></td>
<td>Retrieves inventories in the Ansible Tower environment.</td>
</tr>
<tr>
<td>Get Projects</td>
<td></td>
<td>Retrieves projects in the Ansible Tower environment.</td>
</tr>
</tbody>
</table>

### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

### Set up the Ansible spoke

Integrate the ServiceNow instance and Ansible Tower by using the basic authentication or creating a custom OAuth application to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub subscription
- Activate the Ansible spoke
- Role required: admin

**About this task**

- If you want to connect to the Ansible Tower through a MID Server, set up the Ansible spoke using basic authentication. For instructions, see Set up the Ansible spoke using basic authentication.
- If you want to directly connect to the Ansible Tower, set up the Ansible spoke using a custom OAuth application. For instructions, see Set up the Ansible spoke.
Note: You can use only one authentication at a time.

If you have configured two connection records using basic authentication and custom OAuth application, you must deactivate one of the connections to use the other connection record.

Set up the Ansible spoke using basic authentication

Integrate the ServiceNow instance and Ansible Tower by using the basic authentication to authenticate ServiceNow requests.

Create Credential record for the Ansible spoke

Create Credential record for the Ansible Tower. The Ansible spoke connection and credential alias uses these credentials to authorize actions.

Procedure

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?.
3. Select Basic Auth Credentials.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter Ansible Basic Auth Cred.</td>
</tr>
<tr>
<td>User name</td>
<td>User name to log in to the Ansible Tower. Ensure that the Ansible user has the System Administrator role.</td>
</tr>
<tr>
<td>Password</td>
<td>Password to log in to the Ansible Tower.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
</tbody>
</table>
Create Connection record for the Ansible spoke

Create Connection record for the Ansible Tower. The Ansible spoke connection and credential alias uses these credentials to authorize actions.

Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open the record for Ansible.
3. From the Connections tab, click New.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter Ansible Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Ansible Tower. For example, select Ansible Basic Auth Cred.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL of the Ansible Tower instance.</td>
</tr>
</tbody>
</table>

5. In the Advanced MID Server Configuration tab, select the MID Server as per your requirement.

6. Click Submit.

Set up the Ansible spoke

Integrate the instance and Ansible Tower by creating a custom OAuth application to authenticate ServiceNow requests.

Before you begin

- Request an IntegrationHub subscription
- Activate the Ansible spoke
- Role required: admin
Create a custom application in Ansible Tower

Obtain OAuth 2 token by creating a custom application in Ansible Tower.

**Before you begin**
Role required: admin

**Procedure**

1. Create an application in Ansible Tower. See Ansible documentation for information on creating and configuring an application.
   a. Select **Authorization code** for Authorization Grant Type.
   b. Specify the ServiceNow instance URL in **Redirect URI** in this format, `https://<instance-name>.service-now.com/api/sn_ansible_spoke/ansible_oauth_redirect`. For more information on obtaining the Redirect URI, see Register Ansible Tower as OAuth provider.

2. Upon creating the application, access the application information.

3. Copy and record the Client ID and Client Secret for later use. These details are required to register the application as a third-party OAuth provider on your ServiceNow instance.

**Results**
The custom OAuth application from your Ansible Tower is created and can be integrated with the ServiceNow instance.

**Register Ansible Tower as OAuth provider**

Use the information generated during Ansible Tower application configuration to register Ansible Tower as an OAuth provider and allow the ServiceNow instance to request OAuth 2.0 tokens.

**Before you begin**
Role required: admin

**Procedure**

1. Navigate to **System OAuth > Application Registry**.
2. Open for the record for **Ansible**.
3. On the form, fill in the fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter Ansible Tower OAuth profile.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID of the application in Ansible Tower.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret of the application in Ansible Tower.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Optional script to customize the request and response.</td>
</tr>
<tr>
<td>Logo URL</td>
<td>URL that contains an image to use as the application logo.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Grant type used to establish the token. Select Authorization Code.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>Time, in seconds, that the refresh token is valid. The default time is 8,640,0000 seconds.</td>
</tr>
<tr>
<td>PKCE required</td>
<td>Option to enable public clients to require PKCE for an authorization.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can use only Authorization Code as the Default Grant type when PKCE is enabled.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record. Select Ansible Tower Spoke.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Application scope that this registry is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
<tr>
<td>Token URL</td>
<td>OAuth server token endpoint. For example, https://&lt;Ansible-Tower-Instance&gt;.com/api/o/token/.</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>OAuth server token revocation endpoint.</td>
</tr>
</tbody>
</table>
### Field | Value required
--- | ---
Use mutual authentication | Option to use mutual authentication for token request and revocation. This option requires a mutual authentication profile to be specified.

4. Right-click the form header, and click **Save**.

5. Paste the Redirect URL value into the Redirect URI for your custom Ansible Tower application. For example, paste `https://<instance-name>.service-now.com/api/sn_ansible_speak/ansible_oauth_redirect`.

**Results**
The instance can request OAuth 2.0 tokens for the spoke and a refresh token is created to regenerate tokens.

**Create Credential record for the Ansible spoke**
Create Credential records for your application in Ansible Tower. The Ansible spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**
1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open for the record for **Ansible**.
3. From the **Credentials** tab, click **New**.
   - The system displays the message **What type of Credentials would you like to create?**.
4. Select **OAuth 2.0 Credentials**.
5. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, <strong>Ansible Credentials</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile created during the registration of Ansible spoke as an OAuth provider. For example, select <strong>Ansible OAuth profile</strong>.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the credentials are used. For example, enter <strong>100</strong>.</td>
</tr>
</tbody>
</table>

6. Right-click the form header and click **Save**.
7. To generate the OAuth token, click the **Get OAuth Token** related link.

   **Note:** If you are setting up the spoke for the first time, you will be prompted to provide the ServiceNow instance credentials. Provide the credentials.

**Results**

The credential record the Ansible spoke spoke is created.

**Create Connection record for the Ansible spoke**

Create Connection record for your application in Ansible Tower. The Ansible spoke connection and credential alias uses these connections to perform actions in Ansible Tower.

**Procedure**

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open the record for **Ansible**.
3. From the **Connections** tab, click **New**.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter <strong>Ansible Connection</strong>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Ansible Tower. For example, select <strong>Ansible Credentials</strong>.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL of the Ansible Tower instance.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Automation Anywhere spoke v1.0.23**

Manage workflows and robotics processes in Automation Anywhere instance from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see [Request IntegrationHub](#).

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)

⚠️ **Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke actions**

The Automation Anywhere spoke provides actions to automate Automation Anywhere tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bot Management</td>
<td>Deploy Bot</td>
<td>Deploys a bot in the bot runner devices.</td>
</tr>
<tr>
<td></td>
<td>Get Bot</td>
<td>Retrieves details of the specific bot.</td>
</tr>
<tr>
<td></td>
<td>Look up Bots</td>
<td>Retrieves information about all the bots.</td>
</tr>
<tr>
<td>Device Management</td>
<td>Get Device Details</td>
<td>Retrieves details of the specific device.</td>
</tr>
<tr>
<td></td>
<td>Look up Devices</td>
<td>Retrieves details of all the devices.</td>
</tr>
<tr>
<td></td>
<td>Look up Pool</td>
<td>Retrieves details of the specified pool.</td>
</tr>
<tr>
<td>Folder Management</td>
<td>Get Folder</td>
<td>Retrieves details of the requested folder.</td>
</tr>
<tr>
<td></td>
<td>Look up Folders</td>
<td>Retrieves information about all the folders.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------</td>
<td>--------------------------------------------------------------</td>
</tr>
<tr>
<td>Queue Management</td>
<td>Look up Queues</td>
<td>Retrieves all queues for the Enterprise Control Room.</td>
</tr>
<tr>
<td></td>
<td>Look up Work Items in Queue</td>
<td>Retrieves details of all the work items in a queue.</td>
</tr>
<tr>
<td>User Management</td>
<td>Get User</td>
<td>Retrieves details of the requested user.</td>
</tr>
<tr>
<td></td>
<td>Look up Users</td>
<td>Retrieves details of all the users.</td>
</tr>
</tbody>
</table>

⚠️ **Note:** Only users with bot runner or admin role can execute the spoke actions.

**Spoke module**

The Automation Anywhere spoke adds the Automation Anywhere application to your instance and includes the Authentication module. In this module, you should provide details in the default credential record to authentication the ServiceNow requests. See [Create a Credential record for the Automation Anywhere spoke](#) for more information.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

**Set up the Automation Anywhere spoke**

Integrate ServiceNow and Automation Anywhere instances by using the Automation Anywhere credential record to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription.
- Activate Automation Anywhere spoke.
- Role required: admin

**Create a Credential record for the Automation Anywhere spoke**

Create a credential record for the Automation Anywhere instance. The Automation Anywhere spoke connection and credential alias uses these credentials to authorize actions.
Procedure

1. Navigate to Automation Anywhere > Authentications.
2. Open the record, Automation Anywhere Credential.
3. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Default name of the credential record.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Users are cautioned against modifying the default credential name.</td>
</tr>
<tr>
<td>User Name</td>
<td>Credentials to log in to your Automation Anywhere instance.</td>
</tr>
<tr>
<td>Password</td>
<td></td>
</tr>
<tr>
<td>Credential alias</td>
<td>Default credential alias available along with the Automation Anywhere spoke. For example, select sn_autoanywher_spk.Automation_Anywhere.</td>
</tr>
<tr>
<td>Authentication</td>
<td>Custom authentication algorithm for outbound signing requests. Select Automation Anywhere.</td>
</tr>
<tr>
<td>Algorithm</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Users are cautioned against directly modifying the default authentication algorithm.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL to connect to your Automation Anywhere instance.</td>
</tr>
<tr>
<td>Dedicated</td>
<td>Option to specify if you are using a dedicated user for the purpose of integrating Automation Anywhere and ServiceNow instances.</td>
</tr>
<tr>
<td>Integration User</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>- The dedicated user mentioned here, should be used only for the purpose of integrating Automation Anywhere with ServiceNow.</td>
</tr>
<tr>
<td></td>
<td>- If you aren’t using a dedicate user, the ServiceNow instance makes 2 or 3 API calls to execute an action.</td>
</tr>
<tr>
<td></td>
<td>- If you are using a dedicated user, the ServiceNow instance makes only one API call to execute an action.</td>
</tr>
</tbody>
</table>
4. Right-click the form header and click **Save**.

5. Click **Get Token**.

   **Note:** This step is applicable when you select the **Dedicated Integration User** check box.

   The confirmation message, **Token retrieval successful** is displayed.

**AWS Certificate Manager spoke**

Manage certificates in AWS Certificate Manager account from your ServiceNow instance.

**Request apps on the Store**

Visit the **ServiceNow Store** website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the **ServiceNow Store version history** release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see **Request IntegrationHub**.

**Supported versions**

This spoke was built for AWS Certificate Manager API version 2015-12-08, but may be compatible with later versions.

**Spoke requirements**

- User with full access to AWS Certificate Manager.
- Access Key ID and Secret Access Key of the user. Record these values for later use.

   For more information about creating user in IAM and providing the required access, see **Understanding and Getting Your Security Credentials** page on the **AWS Documentation** site.

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

⚠️ **Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke actions**

The AWS Certificate Manager spoke provides actions to automate AWS Certificate Manager tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificate Management</td>
<td>Delete Certificate</td>
<td>Deletes a certificate and its associated private key.</td>
</tr>
<tr>
<td></td>
<td>Get Certificate</td>
<td>Retrieves an Amazon-issued certificate and its certificate chain.</td>
</tr>
<tr>
<td></td>
<td>Get Certificate Details</td>
<td>Retrieves detailed metadata about the specified ACM certificate.</td>
</tr>
<tr>
<td></td>
<td>Import Certificate</td>
<td>Imports a certificate to AWS Certificate Manager (ACM) to use with services that are integrated with ACM.</td>
</tr>
<tr>
<td></td>
<td>Look up Certificates</td>
<td>Retrieves a list of certificate ARNs and domain names.</td>
</tr>
<tr>
<td></td>
<td>Request Certificate</td>
<td>Requests an ACM certificate for use with other AWS services.</td>
</tr>
<tr>
<td></td>
<td>Resend Validation Email</td>
<td>Resends the email that requests domain ownership validation.</td>
</tr>
</tbody>
</table>
### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

### Set up the AWS Certificate Manager spoke

Integrate the ServiceNow instance and AWS Certificate Manager by using the AWS credentials to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub subscription.
- Activate AWS Certificate Manager spoke.
- Role required: admin

**Create a credential record for the AWS Certificate Manager spoke**

Create a credential record for the AWS Certificate Manager account. The AWS Certificate Manager spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
The system displays this message: What type of Credentials would you like to create?

3. Select **AWS Credentials**.

4. On the form, fill these values.

**AWS Credentials form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID of the user with full access to AWS Certificate Manager.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Secret Access Key of the user with full access to AWS Certificate Manager.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select <strong>AWS Certificate Manager</strong>.</td>
</tr>
</tbody>
</table>

**Note:** Users are cautioned against directly modifying the default authentication algorithm.

| Credential alias | Credential alias associated with the spoke.                               |

5. Click **Save**.

**AWS CloudFormation spoke**

Model and provision AWS resources in your cloud environment using AWS CloudFormation from your ServiceNow instance.

**Request apps on the Store**

Visit the **ServiceNow Store** website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the **ServiceNow Store version history release notes**.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see **Request IntegrationHub**.
Supported versions
This spoke was built for AWS CloudFormation API version 2010-05-15, but may be compatible with later versions.

Spoke requirements
• User with full access to AWS CloudFormation.
• Access Key ID and Secret Access Key of the user. Record these values for later use.

For more information about creating user in IAM and providing the required access, see Understanding and Getting Your Security Credentials page on the AWS Documentation site.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The AWS CloudFormation spoke provides actions to automate AWS CloudFormation tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Set Management</td>
<td>Create Change Set</td>
<td>Creates a list of changes that will be applied to a stack so that you can review the changes before executing them.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Delete Change Set</td>
<td>Deletes the specified change set.</td>
</tr>
<tr>
<td></td>
<td>Execute Change Set</td>
<td>Updates the stack using the input information that was provided when the specified change set was created.</td>
</tr>
<tr>
<td></td>
<td>Get Change Set</td>
<td>Returns the details of the specified change set.</td>
</tr>
<tr>
<td></td>
<td>Look up Change Sets</td>
<td>Returns basic information of each active change set for a stack.</td>
</tr>
<tr>
<td>Stack Management</td>
<td>Cancel Update Stack</td>
<td>Cancels an update on the specified stack.</td>
</tr>
<tr>
<td></td>
<td>Continue Update Rollback</td>
<td>For the specified stack that is in the UPDATE_ROLLBACK_FAILED state, continues rolling the state back to the UPDATE_ROLLBACK_COMPLETE state.</td>
</tr>
<tr>
<td></td>
<td>Create Stack</td>
<td>Creates a stack as specified in the template.</td>
</tr>
<tr>
<td></td>
<td>Delete Stack</td>
<td>Deletes the specified stack.</td>
</tr>
<tr>
<td></td>
<td>Get Stack Policy</td>
<td>Returns the stack policy for a specified stack.</td>
</tr>
<tr>
<td></td>
<td>Get Template</td>
<td>Returns the template body for a specified stack.</td>
</tr>
<tr>
<td></td>
<td>Look up Stack Events</td>
<td>Returns all stack related events for a specified stack in reverse chronological order.</td>
</tr>
<tr>
<td></td>
<td>Look up Stack Resources</td>
<td>Returns details of all resources of the specified stack.</td>
</tr>
<tr>
<td></td>
<td>Look up Stacks</td>
<td>Returns the details for the specified stack.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set Stack Policy</td>
<td>Sets policy for the specified stack.</td>
<td></td>
</tr>
<tr>
<td>Update Stack</td>
<td>Updates the specified stack.</td>
<td></td>
</tr>
</tbody>
</table>

**Stack Set Management**

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Stack Instance</td>
<td>Creates stack instances for the specified accounts, within the specified regions.</td>
</tr>
<tr>
<td>Create Stack Set</td>
<td>Creates Stack set in the specified region.</td>
</tr>
<tr>
<td>Delete Stack Instance</td>
<td>Deletes stack instances for the specified accounts, in the specified regions.</td>
</tr>
<tr>
<td>Delete Stack Set</td>
<td>Deletes the specified Stack set.</td>
</tr>
<tr>
<td>Get Stack Set</td>
<td>Returns the details of the specified stack set.</td>
</tr>
<tr>
<td>Look up Stack Instances</td>
<td>Returns information about stack instances that are associated with the specified stack set.</td>
</tr>
<tr>
<td>Look up Stack Sets</td>
<td>Returns summary information about all the stack sets or the stack sets with the specified Status.</td>
</tr>
<tr>
<td>Update Stack Set</td>
<td>Updates the specified stack set and associated stack instances in the specified accounts and Regions.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the AWS CloudFormation spoke**

Integrate the ServiceNow instance and AWS CloudFormation using AWS credential to authenticate ServiceNow requests.
Before you begin

- Request an IntegrationHub subscription
- Activate the AWS CloudFormation spoke
- Role required: admin

Create Credential record for the AWS CloudFormation spoke

Create Credential record for your AWS CloudFormation account. The AWS CloudFormation spoke connection and credential alias uses this credential to perform actions in AWS CloudFormation.

Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open the record for Amazon VPC.
3. From the Credentials tab, click New.
   The system displays the message What type of Credentials would you like to create?.
4. Select AWS Credentials.
5. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter CloudFormation Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID of the user with full access to AWS CloudFormation.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Secret Access Key of the user with full access to AWS CloudFormation.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Associated credential record.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select AWS_CloudFormation.</td>
</tr>
</tbody>
</table>

**Note:** Users are cautioned against directly modifying the default authentication algorithm.

6. Click Submit.
Results
The credential record the AWS CloudFormation spoke is created.

AWS Elastic Beanstalk spoke
AWS Elastic Beanstalk enables you to quickly deploy and manage applications in the Amazon AWS Cloud. Elastic Beanstalk reduces management complexity without restricting choice or control. When you upload your application, Elastic Beanstalk automatically handles capacity provisioning, load balancing, scaling, and application health monitoring.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

Supported versions

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Management</td>
<td>Look Up Account Attributes</td>
<td>Retrieves attributes related to AWS Elastic Beanstalk that is associated with the calling AWS account.</td>
</tr>
<tr>
<td>Application Management</td>
<td>Check DNS Availability</td>
<td>Checks if the specified CNAME is available.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Create application</td>
<td>Creates an application that has one configuration template name default and no application versions.</td>
</tr>
<tr>
<td></td>
<td>Create Application Version</td>
<td>Creates an application version for the specified application.</td>
</tr>
<tr>
<td></td>
<td>Create Configuration Template</td>
<td>Creates an AWS Elastic Beanstalk configuration template, associated with a specific Elastic Beanstalk application.</td>
</tr>
<tr>
<td></td>
<td>Delete Application</td>
<td>Deletes the specified application along with all associated versions and configurations.</td>
</tr>
<tr>
<td></td>
<td>Delete Application Version</td>
<td>Deletes the specified version from the specified application.</td>
</tr>
<tr>
<td></td>
<td>Delete Configuration Template</td>
<td>Deletes the specified application along with all associated versions and configurations.</td>
</tr>
<tr>
<td></td>
<td>Look Up Application Versions</td>
<td>Retrieves the descriptions of existing applications.</td>
</tr>
<tr>
<td></td>
<td>Look up Applications</td>
<td>Retrieves the descriptions of existing applications.</td>
</tr>
<tr>
<td></td>
<td>Update Application</td>
<td>Updates the specified application to have the specified properties.</td>
</tr>
<tr>
<td></td>
<td>Update Application Version</td>
<td>Updates the specified application version to have the specified properties.</td>
</tr>
<tr>
<td></td>
<td>Update Configuration Template</td>
<td>Updates the specified configuration template to have the specified properties or configuration option values.</td>
</tr>
<tr>
<td>Environment Management</td>
<td>Create Environment</td>
<td>Launches an AWS Elastic Beanstalk environment for the specified application.</td>
</tr>
<tr>
<td></td>
<td>Create Storage Location</td>
<td>Creates a bucket in Amazon S3 to store application versions, logs, and other files used by Elastic Beanstalk environments.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Get Environment Health</td>
<td>Lists the overall health information of the specified environment.</td>
<td></td>
</tr>
<tr>
<td>Look up Available Solution Stacks</td>
<td>Lists the available solution stack names.</td>
<td></td>
</tr>
<tr>
<td>Look up Environment Resources</td>
<td>Lists AWS resources for the specified environment.</td>
<td></td>
</tr>
<tr>
<td>Look up Environments</td>
<td>Retrieves the information about the existing environments.</td>
<td></td>
</tr>
<tr>
<td>Look Up Instances Health</td>
<td>Retrieves the descriptions of existing applications.</td>
<td></td>
</tr>
<tr>
<td>Restart App Server</td>
<td>Restarts the application container server running on each Amazon EC2 instance in the environment.</td>
<td></td>
</tr>
<tr>
<td>Swap Environment CNAMEs</td>
<td>Swaps the CNAMEs of two environments.</td>
<td></td>
</tr>
<tr>
<td>Terminate Environment</td>
<td>Terminates the specified environment.</td>
<td></td>
</tr>
<tr>
<td>Update Environment</td>
<td>Updates the specified environment.</td>
<td></td>
</tr>
</tbody>
</table>

**AWS Elastic Beanstalk account requirements**

The AWS Elastic Beanstalk spoke requires a credential that you create in the Amazon Web Services Management Console.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.
Create Credential record for the AWS Elastic Beanstalk spoke

Create Credential records to integrate AWS Elastic Beanstalk with ServiceNow. The AWS Elastic Beanstalk connection and credential aliases use these credentials to authorize actions. Once connected, Elastic Beanstalk uses basic authentication to authenticate ServiceNow requests.

Before you begin
To set up the AWS Elastic Beanstalk spoke, you must be able to configure security credentials in Amazon Web Services and have a ServiceNow admin role.

- Role required: admin
- Request IntegrationHub subscription
- Activate AWS Elastic Beanstalk spoke

Procedure
2. From the menu under your user name, select My Security Credentials.
3. Click Create access key.
4. Copy the access key ID and the secret access key to a text file. You can only show the secret access key once, but you can delete and create keys if necessary.
5. Navigate to IntegrationHub > Connections & Credentials > Connection & Credential Aliases and click New.
7. Enter a unique name for the credential, for example, Elastic Beanstalk 01.
8. Enter the Access Key ID and Secret Access Key of the access key you created in the AWS console.
9. In the box labeled Credential alias, enter sn_aws_beanstk_spk.AWS_Elastic_Beanstalk.
10. In the box labeled Authentication Algorithm, enter AmazonElasticBeanstalkAuthAlgo.
11. Click Submit.

Results
The AWS Elastic Beanstalk spoke is set up and integrated with the ServiceNow instance.
AWS Elastic Load Balancing spoke
Manage load balancers, tags, and target groups in AWS account from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for AWS Elastic Load Balancing API version 2012-06-01.

Spoke requirements
• User with full access to AWS Elastic Load Balancing.
• Access Key ID and Secret Access Key of the user. Record these values for later use.

For more information about creating user in IAM and providing the required access, see Understanding and Getting Your Security Credentials page on the AWS Documentation site.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• Complex Object (com.glide.cobject)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• ServiceNow IntegrationHub Action Step - XML Parser (com.glide.hub.action_step.xmlparser)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.
**Spoke actions**

The AWS Elastic Load Balancing spoke provides actions to automate AWS Elastic Load Balancing tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elastic Load Balancer Management</td>
<td>Create Load Balancer</td>
<td>Creates an application load balancer or network load balancer.</td>
</tr>
<tr>
<td></td>
<td>Create Load Balancer Listener</td>
<td>Creates a listener for the specified application load balancer or network load balancer.</td>
</tr>
<tr>
<td></td>
<td>Delete Load Balancer</td>
<td>Deletes the specified application load balancer or network load balancer.</td>
</tr>
<tr>
<td></td>
<td>Delete Load Balancer Listener</td>
<td>Deletes the specified listener.</td>
</tr>
<tr>
<td></td>
<td>Get Account Limits</td>
<td>Lists the Elastic Load Balancing resource limits for the AWS account.</td>
</tr>
<tr>
<td></td>
<td>Get Load Balancer Attributes</td>
<td>Lists the attributes for the specified application load balancer or network load balancer.</td>
</tr>
<tr>
<td></td>
<td>Look up Listeners</td>
<td>Retrieves list of the specified listeners for the specified application load balancer or network load balancer.</td>
</tr>
<tr>
<td></td>
<td>Look up Load Balancers</td>
<td>Retrieves list of the specified load balancers or all the load balancers.</td>
</tr>
<tr>
<td></td>
<td>Look up SSL Policies</td>
<td>Lists all policies used for SSL negotiation.</td>
</tr>
<tr>
<td></td>
<td>Update Load Balancer Attributes</td>
<td>Updates the specified attributes of the specified application load balancer or network load balancer.</td>
</tr>
<tr>
<td>Tag Management</td>
<td>Add Tags</td>
<td>Adds the specified tags to the specified Elastic Load Balancing resource.</td>
</tr>
<tr>
<td></td>
<td>Delete Tags</td>
<td>Removes the specified tags from the specified Elastic Load Balancing resource.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Look up Tags</strong></td>
<td></td>
<td>Retrieves list of the tags for the specified resources.</td>
</tr>
<tr>
<td><strong>Create Target Group</strong></td>
<td></td>
<td>Creates a target group.</td>
</tr>
<tr>
<td><strong>Deregister Target</strong></td>
<td></td>
<td>Deregisters the specified targets from the specified target group.</td>
</tr>
<tr>
<td><strong>Get Target Group Attributes</strong></td>
<td></td>
<td>Lists the attributes for the specified target group.</td>
</tr>
<tr>
<td><strong>Get Target Health</strong></td>
<td></td>
<td>Lists the health of the targets.</td>
</tr>
<tr>
<td><strong>Look up Target Groups</strong></td>
<td></td>
<td>Retrieves details of the specified target groups or all of your target groups.</td>
</tr>
<tr>
<td><strong>Register Target</strong></td>
<td></td>
<td>Registers the specified targets with the specified target group.</td>
</tr>
<tr>
<td><strong>Update Target Group</strong></td>
<td></td>
<td>Updates the health checks used for evaluating the health state of the targets in the specified target group.</td>
</tr>
<tr>
<td><strong>Update Target Group Attribute</strong></td>
<td></td>
<td>Updates the specified attributes of the specified target group.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the AWS Elastic Load Balancing spoke**

Integrate the ServiceNow instance and AWS Elastic Load Balancing account using AWS credential to authenticate ServiceNow requests.
Before you begin

- Request an IntegrationHub subscription
- Activate the AWS Elastic Load Balancing spoke
- Role required: admin

Create Credential record for the AWS Elastic Load Balancing spoke

Create credential record for the AWS Elastic Load Balancing account. The AWS Elastic Load Balancing spoke connection and credential alias uses these credentials to authorize actions.

Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open the record, AWS_Elastic_Load_Balancing.
3. In the Credentials tab, click New.
   The system displays the message What type of Credentials would you like to create?.
4. Select AWS Credentials.
5. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter Elastic Load Balancing Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID of the user with full access to AWS Elastic Load Balancing.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Secret Access Key of the user with full access to AWS Elastic Load Balancing.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Associated credential record.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select AmazonElasticLoadBalancingAuthAlgo.</td>
</tr>
</tbody>
</table>

Note: Users are cautioned against directly modifying the default authentication algorithm.

6. Right-click the form header and click Submit.
AWS IAM spoke v1.0.2
Integrate ServiceNow instance with AWS IAM to manage access to AWS services and resources securely. Manage groups, policies, and roles in AWS IAM from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported version
This spoke was built for API version 2010-05-08, but may be compatible with later versions.

ℹ️ Note: If you use different API version, ensure that you change the API version in all spoke actions.

Spoke requirements
• User with full access to IAM.
• Access Key ID and Secret Access Key of the user. Record these values for later use.

For more information about creating user in IAM and providing the required access, see AWS Identity and Access Management Documentation site.

Spoke subflows
The Jenkins spoke provides sample subflows to demonstrate automating AWS IAM tasks. Available subflows are:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Group</td>
<td>Deletes the specified AWS IAM group.</td>
</tr>
<tr>
<td>Delete User</td>
<td>Deletes the specified AWS IAM user.</td>
</tr>
</tbody>
</table>
Subflow | Description
--- | ---
Delete Policy | Deletes the specified policy from the AWS IAM account.

**Spoke actions**
The AWS IAM spoke provides actions to automate AWS IAM tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Management</td>
<td>Add User To Group</td>
<td>Adds user to a group in AWS IAM.</td>
</tr>
<tr>
<td></td>
<td>Create Group</td>
<td>Creates a group in AWS IAM.</td>
</tr>
<tr>
<td></td>
<td>Delete Group</td>
<td>Deletes a group in AWS IAM.</td>
</tr>
<tr>
<td></td>
<td>Get Group</td>
<td>Searches for the required group in AWS IAM.</td>
</tr>
<tr>
<td></td>
<td>Get Group Users</td>
<td>Lists all the users in the required group.</td>
</tr>
<tr>
<td></td>
<td>Remove User From Group</td>
<td>Removes a user from a group in AWS IAM.</td>
</tr>
<tr>
<td>Group Policy Management</td>
<td>Attach Inline Policy In Group</td>
<td>Adds or updates an inline policy document embedded in the specified IAM group.</td>
</tr>
<tr>
<td></td>
<td>Attach Policy To Group</td>
<td>Attaches the specified managed policy to the required IAM group.</td>
</tr>
<tr>
<td></td>
<td>Detach Inline Policy From Group</td>
<td>Deletes the specified inline policy from the specified AWS IAM group</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Detach Policy From Group</td>
<td>Detaches the specified managed policy from the required IAM group.</td>
</tr>
<tr>
<td></td>
<td>List Attached Group Policies</td>
<td>Retrieves the list of all policies attached to the IAM group.</td>
</tr>
<tr>
<td></td>
<td>List Group Policies</td>
<td>Retrieves all the inline policies of the specified group. If none exists, the operation returns an empty list.</td>
</tr>
<tr>
<td>Policy Management</td>
<td>Create Policy</td>
<td>Creates managed policy in the specified IAM group.</td>
</tr>
<tr>
<td></td>
<td>Delete Policy</td>
<td>Deletes specified Policy from AWS IAM.</td>
</tr>
<tr>
<td></td>
<td>Detach Policy From Roles</td>
<td>Detaches the specified managed policy from the specified IAM Role.</td>
</tr>
<tr>
<td></td>
<td>List Entities For Policy</td>
<td>Lists all entities (Users, Group, and Roles) attached to this policy.</td>
</tr>
<tr>
<td>User Management</td>
<td>Create User</td>
<td>Creates a user in AWS IAM.</td>
</tr>
<tr>
<td></td>
<td>Deactivate MFA Device</td>
<td>Deactivates the required MFA device attached to a user.</td>
</tr>
<tr>
<td></td>
<td>Delete Access Key For User</td>
<td>Deletes the access key of the AWS IAM user.</td>
</tr>
<tr>
<td></td>
<td>Delete Login Profile</td>
<td>Deletes the password for the specified IAM user, which terminates the user's ability to access AWS services through the AWS Management Console.</td>
</tr>
<tr>
<td></td>
<td>Delete Service Specific Credential</td>
<td>Deletes the required service-specific credential.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Delete Signing Certificate</td>
<td>Deletes a signing certificate associated with the specified IAM user.</td>
<td></td>
</tr>
<tr>
<td>Delete SSH Public Key</td>
<td>Deletes the specified SSH public key.</td>
<td></td>
</tr>
<tr>
<td>Delete User</td>
<td>Deletes the required IAM User.</td>
<td></td>
</tr>
<tr>
<td>Delete Virtual MFA Device By User</td>
<td>Deletes the specified Virtual MFA device.</td>
<td></td>
</tr>
<tr>
<td>Detach Policy From User</td>
<td>Detaches the specified managed policy from the specified IAM role.</td>
<td></td>
</tr>
<tr>
<td>Get User</td>
<td>Searches for the required user in the AWS IAM.</td>
<td></td>
</tr>
<tr>
<td>List Access Keys By User</td>
<td>Lists the access key of the AWS IAM user.</td>
<td></td>
</tr>
<tr>
<td>List Groups For User</td>
<td>Retrieves the list of all the groups, a particular user belongs to.</td>
<td></td>
</tr>
<tr>
<td>List Inline User Policies</td>
<td>Retrieves all the inline policies of the specified IAM user. If none exists, the operation returns an empty list.</td>
<td></td>
</tr>
<tr>
<td>List MFA Devices By User</td>
<td>Retrieves information about the MFA services associated with the specified IAM user. If none exists, the operation returns an empty list.</td>
<td></td>
</tr>
<tr>
<td>List Service Specific Credentials</td>
<td>Retrieves information about the service-specific credentials associated with the specified IAM user.</td>
<td></td>
</tr>
<tr>
<td>List Signing Certificates By User</td>
<td>Retrieves information about the signing certificates associated with the specified IAM user. If none exists, the operation returns an empty list.</td>
<td></td>
</tr>
<tr>
<td>List SSH Public Keys By User</td>
<td>Retrieves information about the SSH public keys associated with the specified IAM user. If none exists, the operation returns an empty list.</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User Policy Management</td>
<td>Attach Policy To User</td>
<td>Attaches the specified managed policy to the specified user.</td>
</tr>
<tr>
<td></td>
<td>Delete Inline User Policy</td>
<td>Deletes an inline policy attached to the user.</td>
</tr>
<tr>
<td></td>
<td>List Attached User Policies</td>
<td>Retrieves all the attached policies of the user.</td>
</tr>
<tr>
<td>Role Management</td>
<td>List Roles</td>
<td>Retrieves list of all roles.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

**Set up the AWS IAM spoke**

Integrate the ServiceNow instance and AWS IAM using AWS credential to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub subscription
- Activate the AWS IAM spoke
- Role required: admin

**Create Credential record for the AWS IAM spoke**

Create Credential record for your AWS IAM account. The AWS IAM spoke connection and credential alias uses this credential to perform actions on AWS IAM.
Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for AWS IAM.
3. From the Credentials tab, click New.
   The system displays the message What type of Credentials would you like to create?.
4. Select AWS Credentials.
5. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter AWS Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID of the user with full access to IAM.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Secret Access Key of the user with full access to IAM.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Associated credential record.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select AWS IAM Auth Algo.</td>
</tr>
</tbody>
</table>

Note: Users are cautioned against directly modifying the default authentication algorithm.

6. Click Submit.

Results
The credential record the AWS IAM spoke is created.

AWS Lambda spoke v1.1.0
Manage alias and function in AWS Lambda from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- AWS IAM Spoke (sn_aws_iam_spoke)

⚠ **Note:** Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

**Supported version**

This spoke was built for API version 2010-05-08, but may be compatible with later versions.

⚠ **Note:** If you use different API version, ensure that you change the API version in all spoke actions.

**Spoke requirements**

- User with full access to Lambda.

⚠ **Note:** The AWSLambdaFullAccess IAM policy must be assigned to the user. See Identity-based IAM policies for AWS Lambda for more information about the IAM policy.

- Access Key ID and Secret Access Key of the user as obtained in the IAM Console. Record these values for later use.

For more information about creating user in IAM and providing the required access, see Understanding and Getting Your Security Credentials page on the AWS Documentation site.
### Spoke actions

The AWS Lambda spoke provides actions to automate AWS Lambda tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias Management</td>
<td>Create Function Alias</td>
<td>Creates an alias for the specified function.</td>
</tr>
<tr>
<td></td>
<td>Delete Function Alias</td>
<td>Deletes the specified alias of the function.</td>
</tr>
<tr>
<td></td>
<td>Get Function Alias Details</td>
<td>Retrieves the details of the specified function alias.</td>
</tr>
<tr>
<td></td>
<td>List Function Aliases</td>
<td>Retrieves the list of all aliases for the specified function.</td>
</tr>
<tr>
<td></td>
<td>Update Function Alias</td>
<td>Updates settings of the specified alias.</td>
</tr>
<tr>
<td>Function Management</td>
<td>Add Permission</td>
<td>Grants an AWS service or another account permission to use the specified AWS Lambda function.</td>
</tr>
<tr>
<td></td>
<td>Create Function</td>
<td>Creates a function in AWS Lambda.</td>
</tr>
<tr>
<td></td>
<td>Delete Function</td>
<td>Deletes the specified AWS Lambda function or function version.</td>
</tr>
<tr>
<td></td>
<td>Get Function Details</td>
<td>Retrieves details of the specified AWS Lambda function or function version.</td>
</tr>
<tr>
<td></td>
<td>Invoke Function</td>
<td>Invokes the specified AWS Lambda function.</td>
</tr>
<tr>
<td></td>
<td>List Functions</td>
<td>Retrieves list of all AWS Lambda functions in a region.</td>
</tr>
<tr>
<td></td>
<td>Update Function Code</td>
<td>Updates code of the specified AWS Lambda function.</td>
</tr>
<tr>
<td></td>
<td>Update Function Configuration</td>
<td>Updates configuration of the specified AWS Lambda function.</td>
</tr>
</tbody>
</table>
Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the AWS Lambda spoke

Integrate the ServiceNow instance and AWS Lambda account using AWS credential to authenticate ServiceNow requests.

Before you begin

- Request an IntegrationHub subscription
- Activate the AWS IAM spoke v1.0.2
- Activate the AWS Lambda spoke
- Role required: admin

Create Credential record for the AWS Lambda spoke

Create Credential record for your AWS Lambda account. The AWS Lambda spoke connection and credential alias uses this credential to perform actions on AWS Lambda.

Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for Amazon Lambda.
3. From the Credentials tab, click New.
   The system displays the message: What type of Credentials would you like to create?
4. Select AWS Credentials.
5. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter Lambda.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID of the user with full access to AWS Lambda.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Secret Access Key of the user with full access to AWS Lambda.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Associated credential records of the AWS IAM spoke and AWS Lambda spoke.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select AWS IAM Auth Algo.</td>
</tr>
</tbody>
</table>

**Note:** Users are cautioned against directly modifying the default authentication algorithm.

6. Click **Submit**.

**Results**
The credential record the AWS Lambda spoke is created.

**AWS OpsWorks spoke**
Manage elastic load balancers, instances, relational database services, and others in AWS OpsWorks account from the ServiceNow instance.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.
Supported versions
This spoke was built for AWS OpsWorks API version 2013-02-18, but may be compatible with later versions.

Spoke requirements
• User with full access to AWS OpsWorks
• Access Key ID and Secret Access Key of the user. Record these values for later use.

For more information about creating user in IAM and providing the required access, see Understanding and Getting Your Security Credentials page on the AWS Documentation site.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The AWS OpsWorks spoke provides actions to automate tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elastic Load Balancer Management</td>
<td>Attach Elastic Load Balancer</td>
<td>Attaches an Elastic Load Balancer to a specified layer.</td>
</tr>
<tr>
<td></td>
<td>Detach Elastic Load Balancer</td>
<td>Detaches a specified Elastic Load Balancing instance from its layer.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up Elastic Load Balancers</td>
<td>Retrieves information about Elastic Load Balancers of the specified stack ID.</td>
</tr>
<tr>
<td>Instance Management</td>
<td>Create Instance</td>
<td>Creates an instance in the specified stack.</td>
</tr>
<tr>
<td></td>
<td>Delete Instance</td>
<td>Deletes the specified instance.</td>
</tr>
<tr>
<td></td>
<td>Look up Instances</td>
<td>Retrieves the list of instances for the specified stack ID.</td>
</tr>
<tr>
<td></td>
<td>Start Instance</td>
<td>Starts the specified instance.</td>
</tr>
<tr>
<td></td>
<td>Start Stack Instances</td>
<td>Starts instances of the specified stack.</td>
</tr>
<tr>
<td></td>
<td>Stop Instance</td>
<td>Stops the specified instance.</td>
</tr>
<tr>
<td></td>
<td>Stop Stack Instances</td>
<td>Stops instances of the specified stack.</td>
</tr>
<tr>
<td>Relational Database Service Management</td>
<td>Deregister RDS DB Instance</td>
<td>Deregisters an Amazon RDS instance.</td>
</tr>
<tr>
<td></td>
<td>Look up RDS DB Instances</td>
<td>Retrieves the list of Amazon RDS instances.</td>
</tr>
<tr>
<td></td>
<td>Register RDS DB Instance</td>
<td>Registers an Amazon RDS instance with a stack.</td>
</tr>
<tr>
<td>Stack Management</td>
<td>Delete App</td>
<td>Deletes a specified app.</td>
</tr>
<tr>
<td></td>
<td>Delete Layer</td>
<td>Deletes the specified layer.</td>
</tr>
<tr>
<td></td>
<td>Get Stack Summary</td>
<td>Retrieves information of the specified stack ID.</td>
</tr>
<tr>
<td></td>
<td>Get User Profile</td>
<td>Retrieves information about the user profile.</td>
</tr>
<tr>
<td></td>
<td>Look up Apps</td>
<td>Retrieves information about the apps in the specified stack ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Deployments</td>
<td>Retrieves information about the deployments in the specified stack ID.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Look up Layers</td>
<td>Look up Layers</td>
<td>Retrieves list of the layers in the specified stack ID.</td>
</tr>
<tr>
<td>Look up</td>
<td>Look up</td>
<td>Retrieves information about the permissions for the specified stack ID or</td>
</tr>
<tr>
<td>Permissions</td>
<td>Permissions</td>
<td>IAM user.</td>
</tr>
<tr>
<td>Look up Stacks</td>
<td>Look up Stacks</td>
<td>Retrieves list of information of the specified stack ID.</td>
</tr>
</tbody>
</table>

**Tag Management**

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Tags</td>
<td>Adds tags for the specified resource.</td>
</tr>
<tr>
<td>Delete Tags</td>
<td>Deletes tags of the specified resource.</td>
</tr>
<tr>
<td>Look up Tags</td>
<td>Retrieves list of tags for the specified resource.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

**Set up the AWS OpsWorks spoke**

Integrate the ServiceNow instance and AWS OpsWorks account by using the AWS credentials to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub subscription.
- Activate AWS OpsWorks spoke.
- Role required: admin

**Create a credential record for the AWS OpsWorks spoke**

Create a credential record for the AWS OpsWorks account. The AWS OpsWorks spoke connection and credential alias uses these credentials to authorize actions.
Procedure

1. Navigate to Connections & Credentials > Credentials.

2. Click New.
   
The system displays this message: What type of Credentials would you like to create?

3. Select AWS Credentials.

4. On the form, fill these values.

   **AWS Credentials form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, AWS OpsWork Credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID of the user with full access to AWS OpsWorks.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Secret Access Key of the user with full access to AWS OpsWorks.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select AmazonOpsWorkAuthAlgo.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias associated with the AWS OpsWorks spoke.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click Submit.

**Azure Automation spoke v1.0.1**

Integrate ServiceNow instance with Azure Automation. Manage cloud-based automation and configuration services from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
**IntegrationHub subscription**

This spoke requires the IntegrationHub Professional subscription package. For more information, see [Request IntegrationHub](#).

**Supported versions**

This spoke was built for Azure Automation 2015-10-31, but may be compatible with later versions.

**Spoke requirements**

- Azure account

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- Complex Object (com.glide.cobject)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- Azure Resource Management spoke (sn_azure_rm_spoke) v 1.0.3

⚠️ **Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke actions**

The Azure Automation spoke provides actions to automate Azure Automation tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Management</td>
<td>Create Account</td>
<td>Creates an automation account.</td>
</tr>
<tr>
<td></td>
<td>Delete Account</td>
<td>Deletes an automation account.</td>
</tr>
<tr>
<td></td>
<td>Get Account</td>
<td>Retrieves the details of an automation account.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up Accounts By Resource Group</td>
<td>Retrieves the list of accounts in a resource group.</td>
</tr>
<tr>
<td></td>
<td>Look up Accounts By Subscription</td>
<td>Retrieve the list of accounts in a subscription.</td>
</tr>
<tr>
<td></td>
<td>Update Account</td>
<td>Updates the details of an automation account.</td>
</tr>
<tr>
<td>Job Management</td>
<td>Create Job</td>
<td>Creates a job of the runbook.</td>
</tr>
<tr>
<td></td>
<td>Get Job</td>
<td>Retrieves the details of a runbook job.</td>
</tr>
<tr>
<td></td>
<td>Get Job Output</td>
<td>Retrieves the details of an executed job output for the specified job ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Job By Automation Account</td>
<td>Retrieves the list of runbook jobs present in an automation account.</td>
</tr>
<tr>
<td></td>
<td>Resume Job</td>
<td>Resumes the job execution of the specified job.</td>
</tr>
<tr>
<td></td>
<td>Stop Job</td>
<td>Stops the job execution for the specified job.</td>
</tr>
<tr>
<td></td>
<td>Suspend Job</td>
<td>Suspends job execution for the specified job.</td>
</tr>
<tr>
<td>Job Schedule Management</td>
<td>Create Job Schedule</td>
<td>Creates an execution schedule for a job.</td>
</tr>
<tr>
<td></td>
<td>Delete Job Schedule</td>
<td>Deletes an execution schedule of a job.</td>
</tr>
<tr>
<td></td>
<td>Get Job Schedule</td>
<td>Retrieves the details of a job schedule.</td>
</tr>
<tr>
<td></td>
<td>Look up Job Schedules By Automation Account</td>
<td>Retrieves a list of job schedules within an automation account.</td>
</tr>
<tr>
<td>Runbook Management</td>
<td>Create Runbook</td>
<td>Creates a runbook.</td>
</tr>
<tr>
<td></td>
<td>Delete Runbook</td>
<td>Deletes a runbook.</td>
</tr>
<tr>
<td></td>
<td>Get Runbook</td>
<td>Retrieves details of the specified runbook.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Get Runbook Content</td>
<td>Retrieves content of the specified runbook.</td>
<td></td>
</tr>
<tr>
<td>Look up Runbook By Automation Account</td>
<td>Retrieves the list of runbooks within in an automation account.</td>
<td></td>
</tr>
<tr>
<td>Update Runbook</td>
<td>Updates the details of the specified runbook.</td>
<td></td>
</tr>
<tr>
<td>Schedule Management</td>
<td>Create Schedule</td>
<td>Creates a schedule for the specified subscription ID.</td>
</tr>
<tr>
<td></td>
<td>Delete Schedule</td>
<td>Deletes a schedule for the specified subscription ID.</td>
</tr>
<tr>
<td></td>
<td>Get Schedule</td>
<td>Retrieves the details of a schedule.</td>
</tr>
<tr>
<td></td>
<td>Look up Schedules By Automation Account</td>
<td>Retrieves the list of schedules within an automation account.</td>
</tr>
<tr>
<td></td>
<td>Update Schedule</td>
<td>Updates the details of a schedule.</td>
</tr>
<tr>
<td>Software Update Configuration Management</td>
<td>Create Windows/Linux Update</td>
<td>Creates a scheduled software update for Windows or Linux operating systems.</td>
</tr>
<tr>
<td></td>
<td>Delete Windows/Linux Update</td>
<td>Deletes software updates for Windows or Linux operating systems.</td>
</tr>
<tr>
<td></td>
<td>Get Software Update Configuration Runs By Id</td>
<td>Retrieves the details of a software update for the specified configuration.</td>
</tr>
<tr>
<td></td>
<td>Look up Software Update Configuration Machine Runs</td>
<td>Retrieves the list of software-update configuration-machine runs within in an automation account.</td>
</tr>
<tr>
<td></td>
<td>Look up Software Update Configuration Runs</td>
<td>Look up Software Update Configuration Runs</td>
</tr>
<tr>
<td></td>
<td>Look up Windows/Linux Update</td>
<td>Retrieves the list of Windows or Linux updates present in an account.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State Configuration Management</td>
<td>Compile DSC Configuration</td>
<td>Creates the Desired State Configuration (DSC) compilation job.</td>
</tr>
<tr>
<td></td>
<td>Create DSC Configuration</td>
<td>Creates the Desired State Configuration (DSC).</td>
</tr>
<tr>
<td></td>
<td>Get DSC Configuration</td>
<td>Retrieves the details of the Desired State Configuration (DSC).</td>
</tr>
<tr>
<td></td>
<td>Get DSC Configuration Content</td>
<td>Retrieves the content of the Desired State Configuration (DSC).</td>
</tr>
<tr>
<td></td>
<td>Look up Nodes By Automation Account</td>
<td>Retrieves a list of the Desired State Configuration nodes for the specified automation account.</td>
</tr>
<tr>
<td></td>
<td>Update DSC Configuration</td>
<td>Updates the Desired State Configuration (DSC).</td>
</tr>
<tr>
<td></td>
<td>Update Node DSC Configuration</td>
<td>Updates the details of Desired State Configuration (DSC) for the specified node (VM).</td>
</tr>
<tr>
<td>Watcher Management</td>
<td>Delete Watcher</td>
<td>Deletes a watcher.</td>
</tr>
<tr>
<td></td>
<td>Start Watcher</td>
<td>Resumes the watcher.</td>
</tr>
<tr>
<td></td>
<td>Stop Watcher</td>
<td>Pauses the watcher.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the Azure Automation spoke**

Integrate the ServiceNow instance and Azure Automation by creating a custom OAuth application in Azure portal to authenticate ServiceNow requests.
Before you begin

- Request an IntegrationHub subscription.
- Activate Azure Automation spoke.
- Role required: admin

Register Azure Automation as an OAuth provider

Register Azure Automation as the OAuth provider so that the ServiceNow instance can request OAuth 2.0 tokens.

Procedure

1. Navigate to **System OAuth > Application Registry**.
2. Open for the record for Azure Resource Management.
3. On the form, fill these values.

Application Registries form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter: Azure Automation OAuth</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID created during the Azure Automation application configuration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Secret ID created during the Azure Automation application configuration.</td>
</tr>
<tr>
<td>Token URL</td>
<td>OAuth server token endpoint. Enter: <a href="https://login.microsoftonline.com/">https://login.microsoftonline.com/</a>&lt;directory-id&gt;/oauth2/v2.0/token and replace &lt;directory-id&gt; with the Directory ID of your Azure Automation account.</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>OAuth server token revocation endpoint.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint in this format: https://&lt;instance&gt;.service-now.com/oauth_redirect.do</td>
</tr>
</tbody>
</table>
Create a credential record for the Azure Automation spoke

Create a credential record for the Azure Automation account. The Azure Automation spoke connection and credential alias uses these credentials to authorize actions.

Procedure

1. Navigate to IntegrationHub > Connections & Credentials > Credentials.
2. Open the Azure_Automation_Spoke record.
3. In the Credentials tab, click New.
   
   The system displays this message: What type of Credentials would you like to create?

4. Select OAuth 2.0 Credentials.
5. On the form, fill these values.

   OAuth 2.0 Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Azure Automation Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>The OAuth profile you created when you registered the custom Azure Automation application as an OAuth provider. Enter Azure Resource Management default_profile OAuth Profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Option to specify if the credential applies to all MID Servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use this credential in the MID servers field.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, 100.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias associated with the spoke. Click the lock icon and enter sn_azure_rm_spoke.Azure_Resource_Management</td>
</tr>
</tbody>
</table>

Note: Make sure that

sn_azure_auto_spke.Azure_Automation_Spoke
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>alias is already added.</td>
</tr>
</tbody>
</table>

6. Right-click the form header and click **Submit**.

7. To generate the OAuth token, click the **Get OAuth Token** related link.

**Azure DevOps Boards spoke v1.6.3**

Automate the process of managing work items in Azure DevOps Boards from your ServiceNow instance.

**Request apps on the Store**

Visit the **ServiceNow Store** website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the **ServiceNow Store version history release notes**.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Standard subscription package. For more information, see **Request IntegrationHub**.

> Note: This spoke is available to new customers as part of an IntegrationHub Professional subscription. Existing customers can use this spoke as part of an IntegrationHub Standard subscription.

**Supported versions**

This spoke was built for Azure DevOps Boards REST API version 4.1 and TFS 2018 Update 3, but may be compatible with later versions.

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

> Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.
**Spoke requirements**

- Azure DevOps instance
- Personal access tokens (PATs) to authenticate Azure DevOps

See Azure DevOps documentation for information about creating personal access token.

**Spoke actions**

The Azure DevOps Boards spoke provides actions to manage work items when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Core Process Management</td>
<td>Create Iteration</td>
<td>Creates an Azure DevOps iteration.</td>
</tr>
<tr>
<td></td>
<td>Delete Iteration</td>
<td>Deletes an Azure DevOps iteration by path.</td>
</tr>
<tr>
<td></td>
<td>Post Iteration to Team</td>
<td>Adds an Azure DevOps iteration to an Azure DevOps team.</td>
</tr>
<tr>
<td></td>
<td>Reporting Work Items Revisions</td>
<td>Adds reporting work-item revisions for batch processing.</td>
</tr>
<tr>
<td></td>
<td>Reporting Work Items Links</td>
<td>Adds reporting work-item links for batch processing.</td>
</tr>
<tr>
<td></td>
<td>Update Iteration</td>
<td>Updates the name, start date, and end date for an Azure DevOps iteration.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Delink Iterations From A Team</td>
<td>Delinks Azure DevOps iterations from a team.</td>
</tr>
<tr>
<td></td>
<td>Get Creatable Fields</td>
<td>Retrieves the list of all fields in a required Azure DevOps project.</td>
</tr>
<tr>
<td></td>
<td>Get Area Paths of a Team</td>
<td>Retrieves the details of all area paths related to a team.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Get Areas Path</td>
<td>Retrieves the details of all area paths in a project.</td>
</tr>
<tr>
<td></td>
<td>Get Backlog and Default Iterations</td>
<td>Retrieves the details of all backlog and default iterations related to a team.</td>
</tr>
<tr>
<td></td>
<td>Get Iteration Paths</td>
<td>Retrieves the details of all iteration paths in a project.</td>
</tr>
<tr>
<td></td>
<td>Get Iteration by Path</td>
<td>Retrieves an Azure DevOps iteration with the specified path.</td>
</tr>
<tr>
<td></td>
<td>Get Iteration Paths of a Team</td>
<td>Retrieves the details of all iteration paths of a team.</td>
</tr>
<tr>
<td></td>
<td>Get Teams</td>
<td>Retrieves the details of all teams in a project.</td>
</tr>
<tr>
<td></td>
<td>Get Processes</td>
<td>Retrieves the details of all processes.</td>
</tr>
<tr>
<td></td>
<td>Get Work Item Data By ID</td>
<td>Retrieves details of the required work item.</td>
</tr>
<tr>
<td></td>
<td>Get Editable Fields</td>
<td>Retrieves the list of all fields in a required Work Item for editing.</td>
</tr>
<tr>
<td></td>
<td>Get Projects</td>
<td>Retrieves the list of all Azure DevOps projects.</td>
</tr>
<tr>
<td></td>
<td>Get Work Item Relations</td>
<td>Retrieves all relations of a required Work Item.</td>
</tr>
<tr>
<td></td>
<td>Get Work Item Type Fields By Process</td>
<td>Retrieves the list of all Work Item Type fields in a required Azure DevOps process.</td>
</tr>
<tr>
<td></td>
<td>Get Work Item Types By Process</td>
<td>Retrieves the list of all Work Item types in a required Azure DevOps process.</td>
</tr>
<tr>
<td></td>
<td>Get Work Item Types</td>
<td>Retrieves the list of all Work Item types in a required Azure DevOps project.</td>
</tr>
<tr>
<td>Work Item Management</td>
<td>Create Child Link</td>
<td>Creates parent-child relationships between the required Work Items.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Create Work Item</td>
<td>Creates a Work Item in your Azure DevOps instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Work Item</td>
<td>Deletes the required Work Item in your Azure DevOps instance.</td>
</tr>
<tr>
<td></td>
<td>Delink Work Items</td>
<td>Delinks parent-child relationships between the required Work Items.</td>
</tr>
<tr>
<td></td>
<td>Update Work Item</td>
<td>Updates details of the required Work Item.</td>
</tr>
<tr>
<td></td>
<td>Add Attachment</td>
<td>Adds an attachment associated with a ServiceNow record to the required work item on the Azure DevOps instance.</td>
</tr>
<tr>
<td></td>
<td>Move To Project</td>
<td>Moves between projects in the same organization.</td>
</tr>
<tr>
<td></td>
<td>Register Service Hook</td>
<td>Registers webhooks for the required project.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

If you want to use different connections in your flow, subflows, and actions, create the child alias and select the default alias record as its parent. To configure the child alias, perform the same steps that are needed to configure the parent alias. Depending on your requirement and set up, you can choose either the parent alias or child alias in your flow, subflows, and actions.

You can also use multiple Azure DevOps accounts. In this case, you should provide the respective **Password** while configuring the credential record and specify the relevant **Connection URL** while configuring the connection record. For more information, see [Set up Azure DevOps Boards spoke](#).
Set up Azure DevOps Boards spoke

Integrate the ServiceNow instance and Azure DevOps Boards using basic authentication to authenticate ServiceNow requests.

Before you begin

• Request IntegrationHub subscription
• Activate Azure DevOps Boards spoke
• Role required: admin

About this task

If you want to use different connections in your flow, subflows, and actions, create the child alias and select the default alias record as its parent. To configure the child alias, perform the same steps that are needed to configure the parent alias. Depending on your requirement and set up, you can choose either the parent alias or child alias in your flow, subflows, and actions.

You can also use multiple Azure DevOps accounts. In this case, you should provide the respective Password while configuring the credential record and specify the relevant Connection URL while configuring the connection record.

Obtain the personal access token

Authenticate Azure DevOps Boards by using the personal access tokens.

Before you begin

Role required: admin

Procedure

1. Log in to your Azure DevOps portal as an admin.
2. Navigate to User Settings > Personal access tokens.
3. Click **New Token**.

4. On the form, fill the required fields.

5. Click **Create**.
The token is displayed.

6. Copy and record the value of token for later use.

Create Credential records for the Azure DevOps Boards spoke

Create Credential records for the Azure DevOps instance. The Azure DevOps Boards spoke connection and credential alias uses these credentials to authorize actions.

Procedure

1. Navigate to Connections & Credentials > Credentials.

2. Click New.

   The system displays the message What type of Credentials would you like to create?.

3. Select Basic Auth Credentials.

4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter Azure DevOps Boards Credentials.</td>
</tr>
<tr>
<td>User name</td>
<td>User name to log in to your Azure DevOps instance.</td>
</tr>
<tr>
<td>Password</td>
<td>Personal access token to authenticate Azure DevOps.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Create Connection records for the Azure DevOps Boards spoke

Create Connection records to your Azure DevOps instance. The Azure DevOps Boards spoke connection and credential alias uses these connections to perform actions in the Azure DevOps instance.

#### Procedure

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open for the record for **Azure DevOps Boards**.
3. From the **Connections** tab, click **New**.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter <strong>Azure DevOps Boards Connection</strong>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Azure DevOps Boards. For example, select <strong>Azure DevOps Boards Credentials</strong>.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL of the Azure DevOps instance. For example, <strong><a href="https://dev.azure.com/">https://dev.azure.com/</a>&lt;instance-name&gt;</strong>.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

### Azure Traffic Manager spoke v1.0.1

Integrate ServiceNow instance with Azure Traffic Manager. Manage DNS-based traffic distribution and load balancing from your ServiceNow instance.

### Request apps on the Store

Visit the **ServiceNow Store** website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the **ServiceNow Store version history release notes**.
IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Azure Traffic Manager 2018-04-01, but may be compatible with later versions.

Spoke requirements
• Client ID and Client Secret of the Azure Traffic Manager registered in the Azure portal.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• Microsoft Azure Resource Management Spoke 1.0.3 (sn_azure_rm_spoke)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Azure Traffic Manager Spoke provides actions to automate DNS-based traffic load balancing tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint Management</td>
<td>Create Endpoint</td>
<td>Creates a traffic manager endpoint.</td>
</tr>
<tr>
<td></td>
<td>Delete Endpoint</td>
<td>Deletes a traffic manager endpoint.</td>
</tr>
<tr>
<td></td>
<td>Get Endpoint</td>
<td>Retrieves the details of a traffic manager endpoint.</td>
</tr>
<tr>
<td></td>
<td>Update Endpoint</td>
<td>Updates the details of a traffic manager endpoint.</td>
</tr>
<tr>
<td>Profile Management</td>
<td>Check DNS Availability</td>
<td>Checks the availability of a traffic manager relative Domain Name System (DNS) name.</td>
</tr>
<tr>
<td></td>
<td>Create Profile</td>
<td>Creates a traffic manager profile.</td>
</tr>
<tr>
<td></td>
<td>Delete Profile</td>
<td>Deletes a traffic manager profile.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get Profile</td>
<td>Retrieves the details of a traffic manager profile.</td>
</tr>
<tr>
<td></td>
<td>Look up Profiles By Resource Group</td>
<td>Retrieves all traffic manager profiles within a resource group.</td>
</tr>
<tr>
<td></td>
<td>Look up Profiles By Subscription</td>
<td>Retrieves a list of traffic manager profiles within a subscription.</td>
</tr>
<tr>
<td></td>
<td>Update Profile</td>
<td>Updates the details of a traffic manager profile.</td>
</tr>
</tbody>
</table>

### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

### Set up the Azure Traffic Manager spoke

Integrate the ServiceNow instance and Azure Traffic Manager by creating a custom OAuth application in Azure Traffic Manager to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub subscription.
- Activate Azure Traffic Manager Spoke.
- Role required: admin

**Register Azure Traffic Manager as an OAuth provider**

Register Azure Traffic Manager as the OAuth provider so that the ServiceNow instance can request OAuth 2.0 tokens.

**Procedure**

1. Navigate to System OAuth > Application Registry.
3. On the form, fill these values.
## Application Registries form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Client ID created during the Azure Traffic Manager application configuration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Key Value created during the Azure Traffic Manager application configuration.</td>
</tr>
<tr>
<td>Token URL</td>
<td>OAuth server token endpoint. Enter: <a href="https://login.microsoftonline.com/">https://login.microsoftonline.com/</a>&lt;directory-id&gt;/oauth2/v2.0/token and replace &lt;directory-id&gt; with the Directory ID of your Azure Traffic Manager account.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint in this format: https://&lt;instance&gt;.service-now.com/oauth_redirect.do and replace &lt;instance&gt; with the name of your ServiceNow instance.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**.

### Create a credential record for the Azure Traffic Manager spoke

Create a credential record for the Azure Traffic Manager account. The Azure Traffic Manager connection and credential alias uses these credentials to authorize actions.

#### Procedure

1. Navigate to **IntegrationHub > Connections & Credentials > Connection & Credential Aliases**.
2. Open the **Azure_Traffic_Manager** record.
3. In the Credentials tab, click **New**.

   The system displays this message: What type of Credentials would you like to create?

4. Select **OAuth 2.0 Credentials**.
5. On the form, fill in these fields.
### OAuth 2.0 Credentials fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the credentials record. For example, enter Azure Traffic Manager.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to make the credential active.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>The OAuth profile you created when you registered the custom Azure Traffic Manager application as an OAuth provider. Enter Azure Resource Management default_profile</td>
</tr>
<tr>
<td>Applies to</td>
<td>Option to assign the credential to all MID servers, or only specified MID servers.</td>
</tr>
<tr>
<td>Order</td>
<td>The order to apply this credential. For example, enter 100.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>The credential alias of the dependant Azure Resource Management spoke. Click the lock icon and enter sn_azure_rm_spoke.Azure_Resource_Management</td>
</tr>
</tbody>
</table>

6. Right-click the form header and click **Save**.
7. To generate the OAuth token, click the **Get OAuth Token** related link.

### BigFix Inventory spoke v1.0.1

Manage hardware, software, and licenses in BigFix Inventory from your ServiceNow instance.

### Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Action Template - Data Streaming (com.glide.hub.action_type.datastream)

Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported versions
This spoke was built for BigFix Inventory version 9.2.16.0, but may be compatible with later versions.

Spoke requirements
• BigFix Inventory Management account

Spoke flows and subflows
This spoke has no flows and subflows.

Spoke actions
The BigFix Inventory spoke provides actions to automate BigFix Inventory tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware</td>
<td>List Hardware Inventory</td>
<td>Retrieves the list of hardware records from the BigFix Inventory.</td>
</tr>
</tbody>
</table>
### Spoke actions (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>List Shared Disks</td>
<td>Retrieves the list of shared disks from the BigFix Inventory.</td>
</tr>
<tr>
<td></td>
<td>Look Up BIOS Details By Computer ID</td>
<td>Retrieves the Basic Input-Output System (BIOS) details of the specified computer ID.</td>
</tr>
<tr>
<td></td>
<td>Look Up Computer Hardware Fields By Computer ID</td>
<td>Retrieves the list of logical partitions of the specified computer ID.</td>
</tr>
<tr>
<td></td>
<td>Look Up IP Addresses By Computer ID</td>
<td>Retrieves the list of Internet Protocol addresses (IP addresses) of the specified computer ID.</td>
</tr>
<tr>
<td></td>
<td>Look Up Logical Partitions By Computer ID</td>
<td>Retrieves the list of logical partitions of the specified computer ID.</td>
</tr>
<tr>
<td></td>
<td>Look Up Memory Details By Computer ID</td>
<td>Retrieves the memory details of the specified computer ID.</td>
</tr>
<tr>
<td></td>
<td>Look Up Network Adapters By Computer ID</td>
<td>Retrieves the list of network adapters of the specified computer ID.</td>
</tr>
<tr>
<td></td>
<td>Look Up Operating System Details By Computer ID</td>
<td>Retrieves the operating system details of the specified computer ID.</td>
</tr>
<tr>
<td></td>
<td>Look Up Physical Partition Details By Computer ID</td>
<td>Retrieves the physical partitions of the specified computer ID.</td>
</tr>
<tr>
<td></td>
<td>Look Up Processor Details By Computer ID</td>
<td>Retrieves the processor details of the specified computer ID.</td>
</tr>
</tbody>
</table>
Spoke actions (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Look Up Storage Devices By Computer ID</td>
<td>Retrieves the list of storage devices of the specified computer ID.</td>
<td></td>
</tr>
<tr>
<td>Licensing</td>
<td>List License Metric Utilization</td>
<td>Retrieves the list of license usage data from the BigFix Inventory.</td>
</tr>
<tr>
<td>Software</td>
<td>List Cluster Information</td>
<td>Retrieves a list of clusters from the BigFix Inventory.</td>
</tr>
<tr>
<td></td>
<td>List IBM Software Products</td>
<td>Retrieves the summary of IBM softwares in the BigFix Inventory.</td>
</tr>
<tr>
<td></td>
<td>List License Usage</td>
<td>Retrieves the highest license usage for the last 90 days.</td>
</tr>
<tr>
<td></td>
<td>List Software Components</td>
<td>Retrieves the list of software components in the BigFix Inventory.</td>
</tr>
<tr>
<td></td>
<td>List Software Inventory</td>
<td>Retrieves the list of installed softwares in the Bigfix Inventory.</td>
</tr>
<tr>
<td></td>
<td>List VM Managers</td>
<td>Retrieves the list of Virtual Machine (VM) managers.</td>
</tr>
<tr>
<td></td>
<td>Look Up IBM Product Release By Product ID</td>
<td>Retrieves the list of releases associated with an IBM software.</td>
</tr>
<tr>
<td></td>
<td>Look Up IBM Product Release Instances By Release ID</td>
<td>Retrieves the list of instances associated with an IBM software release.</td>
</tr>
</tbody>
</table>

Set up the BigFix Inventory spoke

Integrate the ServiceNow instance and BigFix Inventory using an API key for authenticating ServiceNow requests.
Before you begin
- Request IntegrationHub subscription
- Activate the BigFix Inventory spoke
- Role required: admin

Configure BigFix Inventory
Create a BigFix Inventory instance to generate an access token for API key authentication.

Before you begin
BigFix Inventory Requirements:
- BigFix Inventory account
- BigFix Inventory administrator credentials

Complete these steps from your BigFix Inventory environment. For more information on installation and configuration, see BigFix V9.5 Inventory Documentation.

Procedure
1. Generate an access token to interact with BigFix Inventory APIs.
2. Record the access token to create Credential records on your ServiceNow instance.

Create Credential records for the BigFix Inventory spoke
Create Credential records for the BigFix Inventory spoke. The BigFix Inventory spoke connection and credential aliases use these credentials to authorize ServiceNow actions.

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?.
3. Select API Key Credentials.
   A blank API Key Credentials form displays.
4. On the form, fill these fields:
### Create Connection records for the BigFix Inventory spoke

Create Connection records to your BigFix Inventory account. The BigFix Inventory spoke connection and credential aliases use these connections to perform actions in the BigFix Inventory.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open for the record for BigFix_Inventory.
3. From the **Connections** tab, click New.
   
   The system displays a blank HTTP(s) Connection form.
4. On the form, fill these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name to identify the record. For example, BigFix Inventory Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record of BigFix Inventory. For example, BigFix Inventory Credentials.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection. Default value is sn_bigfix_in_spoke.BigFix_Inventory.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Do not change the default value for this field.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to enable the connection as active.</td>
</tr>
<tr>
<td>Domain</td>
<td>Application scope of the connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td>Option to auto-generate the URL based on the inputs. Default is unchecked. When this option is selected, the <strong>Connection URL</strong> is disabled. If selected, define the associated fields.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL for creating the connection. For example, <a href="https://bigfixtestsserver.eastus.cloudapp.server.com:9081/api">https://bigfixtestsserver.eastus.cloudapp.server.com:9081/api</a></td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Server for this connection. If selected, define fields in the <strong>Advance MID Server Configuration</strong> section.</td>
</tr>
<tr>
<td>u_version</td>
<td>Version of the API. Default value is 2.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Blue Prism spokev1.0.1**

Manage jobs and processes in Blue Prism environment from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Outputs (com.glide.hub.dynamic_outputs)
- Complex Object (com.glide.cobject)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Action Step - SOAP (com.glide.hub.action_step.soap)
- ServiceNow IntegrationHub Action Step - XML Parser (com.glide.hub.action_step.xmlparser)

ℹ️ Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

**Supported Versions**
This spoke was built for Blue Prism Process Dispatch Framework version 2.6, but may be compatible with later versions.

**Spoke Requirements**
- Blue Prism account

**Spoke flows and subflows**
This spoke has no flows and subflows.

**Spoke actions**
The Blue Prism spoke provides actions to automate Blue Prism tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Management</td>
<td>Get Job Status</td>
<td>Retrieves the status of the specified job.</td>
</tr>
<tr>
<td></td>
<td>List Job Outputs</td>
<td>Retrieves the list of outputs of a job associated with the specified session ID.</td>
</tr>
</tbody>
</table>
Spoke actions (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Start Job</td>
<td>Executes a job with the specified inputs on the Blue Prism environment.</td>
</tr>
<tr>
<td>Process Management</td>
<td>Get Process Parameters</td>
<td>Retrieves the list of parameters for the specified process on the Blue Prism environment.</td>
</tr>
<tr>
<td></td>
<td>List Processes</td>
<td>Retrieves the list of processes on the Blue Prism environment.</td>
</tr>
<tr>
<td>Utilities</td>
<td>Generate Collection Inputs</td>
<td>Creates a formatted string of the collection type. This formatted string is used as input for the Start Job action.</td>
</tr>
</tbody>
</table>

**MID Server requirements**

These actions use REST calls, which run on MID Server. Use the connection record that is associated with the Blue Prism Inventory alias to configure where actions run as well as to set MID Server selection attributes. For more information, see [MID server](#).

**Set up the Blue Prism spoke**

Integrate the ServiceNow instance and Blue Prism environment to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription
- Role required: admin

**Configure Blue Prism application**

Configure the Dispatch Framework and Process info utilities in your Blue Prism environment to enable integration with ServiceNow.

**Before you begin**

Blue Prism Digital Exchange account
Procedure
1. Log in to Blue Prism Digital Exchange.
2. Click **Link to Asset** of **Dispatch Framework** utility.
   You are redirected to Dispatch Framework repository on GitHub.
4. Click **Link to Asset** of **Process Info** utility.
   You are redirected to Process Info repository on GitHub.
5. Complete the steps mentioned in the Blue Prism Process Info VBO User Guide.
   Your Blue Prism environment is ready for integration with your ServiceNow instance.

**Create Connection and Credential Alias for Blue Prism ProcessInfo**
Connection to Blue Prism ProcessInfo utility is required for integration.

Procedure
1. Navigate to **Connections & Credentials > Connection and Credential Aliases**.
2. Open the record for **BluePrismProcessInfo**.
3. From **Related Links** section, Click **Create New Connection & Credential**.
   The Create Connection and Credential modal appears.
4. On the form, fill these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Name</td>
<td>Name of the connection. Default value is Blue Prism Process Info Connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL used for creating connection to Blue Prism environment.</td>
</tr>
<tr>
<td>Database Credential Name</td>
<td>Credential name of the database. Default value is DB Read User.</td>
</tr>
<tr>
<td>Database Server Address</td>
<td>Database server address in Blue Prism environment.</td>
</tr>
<tr>
<td>Database Name</td>
<td>Name of the database. Default value is BluePrism.</td>
</tr>
<tr>
<td>Credential Name</td>
<td>Blue Prism Process Info Credentials.</td>
</tr>
</tbody>
</table>
Create Connection and Credential Alias for Blue Prism Process Dispatcher

Connection to Blue Prism Process Dispatcher utility is required for integration.

Procedure

1. Navigate to Connections & Credentials > Connection and Credential Aliases.
2. Open the record for BluePrismProcessDispatcher.
3. From Related Links section, Click Create New Connection & Credential. The Create Connection and Credential modal appears.
4. On the form, fill these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>User name.</td>
</tr>
<tr>
<td>Password</td>
<td>Password.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Name</td>
<td>Name of the connection. Default value is Blue Prism Process Dispatcher Connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL used for creating connection to Blue Prism environment.</td>
</tr>
<tr>
<td>Runtime Credential Name</td>
<td>Credential with runtime access configured in Blue Prism environment.</td>
</tr>
<tr>
<td>Credential Name</td>
<td>Blue Prism Process Dispatcher Credentials.</td>
</tr>
<tr>
<td>User Name</td>
<td>User name.</td>
</tr>
<tr>
<td>Password</td>
<td>Password.</td>
</tr>
</tbody>
</table>

5. Click Create.

A new record is added in the Connections tab.
6. Open the new record and enable **Use MID server**.

   **Note:** **Use MID server** value is disabled by default for a new record.

**BMC Remedy spoke v1.1.3**

Manage change requests, incidents, problems, and other records in BMC Remedy from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Complex Object (com.glide.cobject)

   **Note:** Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

**Supported versions**

This spoke was built for BMC Remedy AR server version 19.08, but may be compatible with later versions.

**Spoke flows**

The BMC Remedy spoke provides the Look up Record sample flow to demonstrate retrieving the details of records based on last modified date. To customize the sample flow, copy it to the required application scope.
**Spoke subflows**

The BMC Remedy spoke provides the Get Incident Request ID sample subflow to demonstrate retrieving the Request IDs of the specified incident numbers. To customize the sample subflow, copy it to the required application scope.

**Spoke actions**

The BMC Remedy spoke provides actions to perform BMC Remedy tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management</td>
<td>Create Change</td>
<td>Creates a change request in BMC Remedy.</td>
</tr>
<tr>
<td>CMDB Management</td>
<td>Get Class Attributes</td>
<td>Retrieves class attributes schema from BMC Remedy.</td>
</tr>
<tr>
<td>CMDB Management</td>
<td>Get Classes</td>
<td>Retrieves the list of all non-abstract classes in the BMC Remedy CMDB.</td>
</tr>
<tr>
<td>CMDB Management</td>
<td>Get Datasets</td>
<td>Retrieves the list of all datasets in BMC Remedy CMDB.</td>
</tr>
<tr>
<td>CMDB Management</td>
<td>Get Namespace</td>
<td>Retrieves the list of all namespaces in BMC Remedy CMDB.</td>
</tr>
<tr>
<td>Look up CMDB Data</td>
<td></td>
<td>Get All Incidents all CMDB data for specified dataset, namespace, and class from BMC Remedy.</td>
</tr>
<tr>
<td>Incident Management</td>
<td>Create Incident</td>
<td>Creates an incident in BMC Remedy.</td>
</tr>
<tr>
<td>Incident Management</td>
<td>Get All Incidents</td>
<td>Retrieves details of all incidents from BMC Remedy.</td>
</tr>
<tr>
<td>Incident Management</td>
<td>Update Attachment</td>
<td>Updates the attachment of the required incident in BMC Remedy.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get All Objects</td>
<td>Retrieves name and label of all objects in BMC Remedy.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Alias Selector</td>
<td>Get Change Form Fields</td>
<td>Validates the given alias specific to the BMC Remedy spoke and retrieves the alias if it is valid.</td>
</tr>
<tr>
<td></td>
<td>Get Change Status</td>
<td>Retrieves the list of all statuses in the BMC Remedy Change Management.</td>
</tr>
<tr>
<td></td>
<td>Get Change Timing</td>
<td>Retrieves the list of all change timings in BMC Remedy Change Management.</td>
</tr>
<tr>
<td></td>
<td>Get Creatable Fields</td>
<td>Retrieves the list of creatable fields in a required standard or custom BMC Remedy table.</td>
</tr>
<tr>
<td></td>
<td>Get Creatable Objects</td>
<td>Retrieves the list of creatable objects in BMC Remedy.</td>
</tr>
<tr>
<td></td>
<td>Get Impact</td>
<td>Retrieves the list of all impacts in the BMC Remedy.</td>
</tr>
<tr>
<td></td>
<td>Get Incident Form Fields</td>
<td>Retrieves the list of fields in the Incident Interface form table.</td>
</tr>
<tr>
<td></td>
<td>Get Incident Status</td>
<td>Retrieves the list of all statuses in BMC Remedy Incident Management.</td>
</tr>
<tr>
<td></td>
<td>Get Investigation Driver</td>
<td>Retrieves the list of all investigation drivers in BMC Remedy Problem Management.</td>
</tr>
<tr>
<td></td>
<td>Get Object Schema</td>
<td>Retrieves schema of the specified object in BMC Remedy.</td>
</tr>
<tr>
<td></td>
<td>Get Problem Form Fields</td>
<td>Retrieves the list of fields in the Problem Interface form table.</td>
</tr>
<tr>
<td></td>
<td>Get Problem Status</td>
<td>Retrieves the list of all statuses in BMC Remedy Problem Management.</td>
</tr>
<tr>
<td></td>
<td>Get Queryable Fields</td>
<td>Retrieves the list of updatable fields in a required standard or custom BMC Remedy table.</td>
</tr>
<tr>
<td></td>
<td>Get Reported Source</td>
<td>Retrieves the list of all reported sources in BMC Remedy Incident Management.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get Risk Level</td>
<td>Retrieves the list of all risk levels in BMC Remedy Change Management.</td>
</tr>
<tr>
<td></td>
<td>Get Service Type</td>
<td>Retrieves the list of all service types in BMC Remedy Incident object.</td>
</tr>
<tr>
<td></td>
<td>Get Token</td>
<td>Generates access token for BMC Remedy.</td>
</tr>
<tr>
<td></td>
<td>Get Updatable Fields</td>
<td>Retrieves the list of updatable fields in the required standard or custom BMC Remedy table.</td>
</tr>
<tr>
<td></td>
<td>Get Urgency</td>
<td>Retrieves the list of all urgencies in BMC Remedy.</td>
</tr>
<tr>
<td>Problem Management</td>
<td>Create Problem</td>
<td>Creates a problem in BMC Remedy.</td>
</tr>
<tr>
<td>Record Management</td>
<td>Create Record</td>
<td>Creates record of the required type in BMC Remedy.</td>
</tr>
<tr>
<td></td>
<td>Get Record Details By ID</td>
<td>Retrieves details of the specified record.</td>
</tr>
<tr>
<td></td>
<td>Look up Record</td>
<td>Looks up a record in BMC Remedy based on the query fields.</td>
</tr>
<tr>
<td></td>
<td>Update Record</td>
<td>Updates details of the specified record in BMC Remedy.</td>
</tr>
<tr>
<td>Service Request Management</td>
<td>Create Service Request</td>
<td>Creates a service request in BMC Remedy.</td>
</tr>
<tr>
<td></td>
<td>Get Service Request Form Fields</td>
<td>Retrieves the list of fields in the Service Request Interface form table.</td>
</tr>
<tr>
<td></td>
<td>Get Service Request Status</td>
<td>Retrieves the list of all status in the BMC Remedy Service Request management.</td>
</tr>
</tbody>
</table>

**Spoke modules**

The BMC Remedy spoke adds a BMC Remedy application to your instance and includes these modules:
<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credentials</td>
<td>Credential records for the BMC Remedy spoke can be accessed here.</td>
</tr>
<tr>
<td>Objects</td>
<td>Information about the objects in BMC Remedy can be accessed here. You can also create an object that can be used in your flows. See <a href="#">Create a BMC Remedy object in your ServiceNow instance</a> for information about creating an object.</td>
</tr>
</tbody>
</table>

**Spoke user roles**

The Remedy_Admin (sn_bmcremedy_spoke.Remedy_Admin) is available when the BMC Remedy spoke is installed. Users with role can view and create objects in the Objects module.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Two aliases are available when you install the BMC Remedy spoke; one alias is of the Connection and Credential type and the other alias is of the Credential type.

**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the BMC Remedy alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

**Set up the BMC Remedy spoke**

Integrate the ServiceNow instance and BMC Remedy by using Remedy credentials to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription.
- Activate the BMC Remedy spoke.
- Role required: admin.
Note: Ensure that you perform these steps in the BMC Remedy Spoke application scope only.

Create Credential record for the BMC Remedy spoke

Create Credential records for your BMC Remedy application. The BMC Remedy spoke connection and credential alias uses these credentials to authorize actions.

Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open the record for the BMC Remedy spoke whose Type is Credential. For example, BMCRemedy_Credential.
3. From the Credentials tab, click New.
   The system displays the message What type of Credentials would you like to create?
4. Select Remedy Credential.
5. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Remedy Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>User name</td>
<td>User name of the BMC Remedy user.</td>
</tr>
<tr>
<td>Note: Administrator user isn’t necessary. However, ensure that the BMC Remedy user has permissions to perform the required change, incident, and problem management actions.</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td>Password of the BMC Remedy user’s account.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias record associated with this record.</td>
</tr>
<tr>
<td>Token Status</td>
<td>Status of the BMC Remedy token. Select Active.</td>
</tr>
<tr>
<td>Applies to</td>
<td>MID Servers that can use this credential record.</td>
</tr>
<tr>
<td>MID servers</td>
<td>Specific MID Servers that can use this credential record.</td>
</tr>
</tbody>
</table>
6. Right-click the form header and click **Save**.

**Results**
The credential record the BMC Remedy spoke is created.

**Create Connection record for the BMC Remedy spoke**
Create Connection record for your BMC Remedy application. The BMC Remedy spoke connection and credential alias uses this connection to perform actions in BMC Remedy.

**Procedure**
1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open the record of **BMC Remedy spoke** whose **Type** is **Connection and Credential**. For example, **BMCRemedy**.
3. From the **Connections** tab, click **New**.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter <strong>BMC Remedy Connection</strong>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for BMC Remedy. For example, select <strong>Remedy Cred</strong>.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Connection alias associated with this record.</td>
</tr>
<tr>
<td>URL builder</td>
<td>Option to manually enter the connection URL or use system to build the URL based on the inputs.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL to launch the BMC Remedy application. For example, <strong>http://&lt;bmc-remedy-localhost&gt;:8008/api</strong></td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Server.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capability of the MID Server. This field appears only when the <strong>Use MID server</strong> option is selected.</td>
</tr>
</tbody>
</table>
Field | Value required
--- | ---
MID Application | Option to use a MID Server. This field appears only when the **Use MID server** option is selected.
Active | Option to actively use the connection record.
Domain | Domain that the action runs in.

5. Click **Submit**.

**Results**
The connection record the BMC Remedy spoke is created.

**Create a BMC Remedy object in your ServiceNow instance**
Manage other objects in BMC Remedy from your ServiceNow instance by creating the required object.

**Before you begin**
Role required: admin or Remedy_Admin

**About this task**
By default, the BMC Remedy spoke supports the change request, incident, and problem objects. To manage other objects, such as Product Catalog, create an object in your ServiceNow instance.

**Procedure**
1. Navigate to **BMC Remedy Spoke > Objects**.
2. Click **New**.
3. On the form, fill these fields.

**BMC Remedy Objects form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the required form. This value is unique to each object. For example, the form value for Product Catalog is <strong>PCT:Product Catalog</strong>.</td>
</tr>
<tr>
<td>Label</td>
<td>Label name to identify the record.</td>
</tr>
<tr>
<td>Creatable</td>
<td>Option to create records in the object. Select the option to create records and use the object in your flows.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
**Box spoke v3.0.1**
Move attachments to Box where they can be managed as shared documents.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Supported versions**
API version v2.

**Spoke flows**
The Box spoke provides sample flows in the draft state to demonstrate automating Box tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Attachment when created to Box</td>
<td>Moves attachment files from ServiceNow to Box when a new attachment record is added. Updates the trigger record with a shared link to the moved attachment file on Box.</td>
</tr>
<tr>
<td>On-boarding user</td>
<td>Creates a user in Box when you create a ServiceNow user in the Box User group.</td>
</tr>
</tbody>
</table>

**Spoke actions**
The Box spoke provides actions to automate Box tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Management</td>
<td>Add Metadata to File</td>
<td>Specifies custom data for a particular file or folder.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Attach Box File to Record</td>
<td>Copies a file from Box and attaches it to the specified ServiceNow record.</td>
</tr>
<tr>
<td></td>
<td>Lookup File ID</td>
<td>Retrieves the ID of the specified file in Box.</td>
</tr>
<tr>
<td></td>
<td>Move Owned Item</td>
<td>Moves all items owned by the specified user in Box to the specified folder.</td>
</tr>
<tr>
<td></td>
<td>Remove File</td>
<td>Removes the specified file from Box.</td>
</tr>
<tr>
<td></td>
<td>Search Content Stream</td>
<td>Searches for files, folders, web links, and shared files across the user's</td>
</tr>
<tr>
<td></td>
<td></td>
<td>content or across the entire enterprise.</td>
</tr>
<tr>
<td></td>
<td>Upload File</td>
<td>Uploads the specified file to Box.</td>
</tr>
<tr>
<td>Document Sharing</td>
<td>Add Collaborator</td>
<td>Grants a user or group a specified level of access to a particular file or</td>
</tr>
<tr>
<td></td>
<td></td>
<td>folder. Collaborators have one of these access levels.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Co-Owner</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Editor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Previewer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Preview Uploader</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Uploader</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Viewer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Viewer Uploader</td>
</tr>
<tr>
<td></td>
<td>Create Shared Link</td>
<td>Create a direct and read-only link to a file or folder in Box.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up Folder Collaborators By ID</td>
<td>Retrieves all the collaborators associated to the specified folder ID.</td>
</tr>
<tr>
<td>Folder Management</td>
<td>Remove Collaborator</td>
<td>Removes the specified collaboration from a file or folder in Box.</td>
</tr>
<tr>
<td></td>
<td>Create Folder</td>
<td>Creates a folder in Box on behalf of the specified Box user account.</td>
</tr>
<tr>
<td></td>
<td>Delete Folder</td>
<td>Deletes the specified folder in Box.</td>
</tr>
<tr>
<td></td>
<td>Lookup Folder ID</td>
<td>Retrieves the ID of the specified folder in Box.</td>
</tr>
<tr>
<td>Group Management</td>
<td>Create Group</td>
<td>Creates a group in Box with the specified invitation preferences.</td>
</tr>
<tr>
<td></td>
<td>Delete Group</td>
<td>Deletes the specified group in Box.</td>
</tr>
<tr>
<td></td>
<td>Update Group</td>
<td>Updates the specified group in Box with the specified preferences.</td>
</tr>
</tbody>
</table>

**Note:** Items added to Box require ten minutes to become accessible. For example, if one action creates a folder, a Lookup Folder ID action will not return results until after ten minutes have passed.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legal Hold Management</td>
<td>Assign Legal Hold Policy</td>
<td>Assigns a legal hold policy to a file, file version, folder, or user.</td>
</tr>
<tr>
<td></td>
<td>Create Legal Hold Policy</td>
<td>Creates a legal hold policy.</td>
</tr>
<tr>
<td></td>
<td>Look up All Legal Hold Policies Stream</td>
<td>Retrieves a list of legal hold policies of an enterprise.</td>
</tr>
<tr>
<td></td>
<td>Look up Legal Hold Policy Assignment by ID</td>
<td>Retrieves a legal hold policy assignment for the specified ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Legal Hold Policy Assignments Stream</td>
<td>Retrieves a list of items assigned to a legal hold policy.</td>
</tr>
<tr>
<td></td>
<td>Look up Legal Hold Policy by ID</td>
<td>Retrieves a legal hold policy for the specified ID.</td>
</tr>
<tr>
<td></td>
<td>Remove legal hold policy</td>
<td>Deletes an existing legal hold policy.</td>
</tr>
<tr>
<td></td>
<td>Unassign Legal Hold Policy</td>
<td>Removes the assignment of an item to a legal hold.</td>
</tr>
<tr>
<td></td>
<td>Update Legal Hold Policy</td>
<td>Updates a legal hold policy.</td>
</tr>
<tr>
<td>Metadata Management</td>
<td>Look up Metadata Instance on File By File ID</td>
<td>Retrieves the meta data instance of the file with the specified file ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Metadata Instance on File by Scope and Template Key</td>
<td>Retrieves the meta data instance of a folder with the specified scope and template key.</td>
</tr>
<tr>
<td></td>
<td>Look up Metadata Instance on Folder By Folder ID</td>
<td>Retrieves all the meta data of the folder with the specified folder ID.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="icon" alt="Note:" /> Do not use this action on a root folder which has folder ID value as zero.</td>
</tr>
<tr>
<td></td>
<td>Look up Metadata Instance on Folder by Scope and Template Key</td>
<td>Retrieves all the metadata of a folder with the specified scope and template key.</td>
</tr>
<tr>
<td></td>
<td>Query Files or Folders by Metadata Stream</td>
<td>Searches for files or folders using SQL-like syntax and returns the matching results.</td>
</tr>
<tr>
<td>Retention Policy</td>
<td>Assign Retention Policy</td>
<td>Assigns a retention policy to an item.</td>
</tr>
<tr>
<td>Management</td>
<td>Create Retention Policy</td>
<td>Creates a retention policy.</td>
</tr>
<tr>
<td></td>
<td>Look up Retention Policies</td>
<td>Retrieves all the retention policies of an enterprise.</td>
</tr>
<tr>
<td></td>
<td>Look up Retention Policy Assignment By ID</td>
<td>Retrieves the retention policy with the specified ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Retention Policy Assignments Stream</td>
<td>Returns a list of all retention policy assignments associated with a specified retention policy.</td>
</tr>
<tr>
<td></td>
<td>Look up Retention Policy by ID</td>
<td>Retrieves the retention policy with the specified ID.</td>
</tr>
<tr>
<td></td>
<td>Update Retention Policy</td>
<td>Updates a retention policy.</td>
</tr>
<tr>
<td>User Management</td>
<td>Add User to Group</td>
<td>Adds the specified user to the specified group in Box.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Create User</td>
<td>Creates a user account in Box.</td>
</tr>
<tr>
<td></td>
<td>Delete User</td>
<td>Deletes the specified user in Box.</td>
</tr>
<tr>
<td></td>
<td>Disable User</td>
<td>Sets the status of the specified user in Box to inactive.</td>
</tr>
<tr>
<td></td>
<td>Enable User</td>
<td>Sets the status of the specified user in Box to active.</td>
</tr>
<tr>
<td></td>
<td>Lookup User ID</td>
<td>Retrieves the ID of the specified user in Box.</td>
</tr>
<tr>
<td></td>
<td>Update User</td>
<td>Updates the specified user in Box with the specified role changes.</td>
</tr>
<tr>
<td>Webhook Management</td>
<td>Create Webhook</td>
<td>Creates a webhook.</td>
</tr>
<tr>
<td></td>
<td>Look up Webhook By ID</td>
<td>Retrieves the webhook with the specified ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Webhooks Stream</td>
<td>Retrieves all the defined webhooks for the specified application.</td>
</tr>
<tr>
<td></td>
<td>Remove Webhook</td>
<td>Removes a webhook.</td>
</tr>
<tr>
<td></td>
<td>Update Webhook</td>
<td>Updates a webhook.</td>
</tr>
</tbody>
</table>

**Box spoke module**

Bi-directional webhooks can be set up to be notified about the required events. Webhook registry defines the conditions that must be met to notify the ServiceNow app. These conditions are based on the events in Box that you want to be notified about. When the conditions are met, the specified trigger name triggers the associated subflow, which in turn automates the Box tasks.

Webhooks require separate setup and can be used independently without using the spoke actions. The Box spoke adds the Box Spoke application to your instance and includes the following modules.
Box module

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Box Webhook Registry</td>
<td>Create and view the Plivo webhooks in ServiceNow.</td>
</tr>
<tr>
<td>Legal Hold Policies</td>
<td>View the list of available Box legal policies.</td>
</tr>
<tr>
<td>Retention Policies</td>
<td>View the list of available Box retention policies.</td>
</tr>
</tbody>
</table>

**Box account requirements**

The Box spoke requires creating a custom app on your Box account to generate OAuth 2.0 tokens. See [Configure Box account](#).

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

This spoke uses these alias records to authorize actions.

<table>
<thead>
<tr>
<th>Connection &amp; Credential alias</th>
<th>Description</th>
<th>Connection alias requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Box</td>
<td>Connection to the Box Collaboration and File Management APIs.</td>
<td>• Connection type: HTTP</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Connection URL: <a href="https://api.box.com">https://api.box.com</a></td>
</tr>
<tr>
<td>Box Upload</td>
<td>Connection to the Box upload service.</td>
<td>• Connection type: HTTP</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Connection URL: <a href="https://upload.box.com">https://upload.box.com</a></td>
</tr>
</tbody>
</table>

To use the spoke connection aliases, create an associated Connection record and an associated Credential record for each alias.
Set up Box spoke
Integrate the ServiceNow instance and Box by creating a custom OAuth application in Box to authenticate ServiceNow requests.

Before you begin
- Request IntegrationHub subscription
- Activate the Box spoke
- Role required: admin

Configure Box account
Create a custom OAuth application from your Box account to enable OAuth 2.0 authentication with the Box spoke.

Before you begin
Box requirements:
- Box account
- Box administrator credentials

About this task
Complete these steps from your Box account. See the Box Developer Portal documentation for instructions on creating and configuring custom applications.

Procedure
1. From your Box account, create a custom OAuth application.
2. Select standard OAuth 2.0 user authentication as the application authentication method.
3. Record the application client ID and client secret to register the app as a third-party OAuth provider on your ServiceNow instance.
4. Enable the matching Box application scope permissions you want the app to support.

<table>
<thead>
<tr>
<th>Box application scope permission</th>
<th>Required for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read and write all files and folders stored in Box</td>
<td>Document management, document sharing, and folder management actions</td>
</tr>
<tr>
<td>Manage users</td>
<td>User management actions</td>
</tr>
</tbody>
</table>
Box application scope permission | Required for
---|---
Manage groups | Group management actions
Manage enterprise properties | Document sharing, group management, and user management actions

Register Box as OAuth provider
Use the information generated during Box account configuration to register Box as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Procedure
1. Navigate to **System OAuth > Application Registry**.
2. Click **New**.
   The system displays the message **What kind of OAuth application?**
3. Select **Connect to a third party OAuth Provider**.
   The system displays a blank Application Registries form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter <strong>Box OAuth</strong>.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Enter the Client ID you created during the Box account configuration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Client Secret you created during the Box account configuration.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select <strong>Authorization Code</strong>.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>Enter <strong><a href="https://account.box.com/api/oauth2/authorize">https://account.box.com/api/oauth2/authorize</a></strong>.</td>
</tr>
<tr>
<td>Token URL</td>
<td>Enter <strong><a href="https://api.box.com/oauth2/token">https://api.box.com/oauth2/token</a></strong>.</td>
</tr>
</tbody>
</table>

5. Right-click the form header, and click **Save**.
   The system validates the OAuth credentials and populates the **Redirect URL** and the **OAuth Entity Profiles** related list.
6. Copy the value from **Redirect URL**.
7. Login to your Box account to edit the configuration of your custom Box application.
See the Box Developer Documentation for instructions.

8. Paste the Redirect URL value into the OAuth 2.0 Redirect URI for your custom Box application.

   **Example**
   For example, paste https://instance.service-now.com/oauth_redirect.do.

**Results**
The instance can request OAuth 2.0 tokens for the spoke.

⚠️ **Note:** The spoke generates OAuth tokens that expire after 30 days. An administrator can regenerate the spoke OAuth token every 30 days.

**Create Credential records for the Box spoke**
Create Credential records to the Box custom OAuth application you created during Box account configuration. The Box spoke connection and credential aliases use these credentials to authorize actions.

**Procedure**

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
   The system displays the message **What type of Credentials would you like to create?**.
3. Select **OAuth 2.0 Credentials**.
   The pop-up window displays a blank OAuth 2.0 Credentials form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Box API Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Select the OAuth profile you created when you registered the custom Box application as an OAuth provider. For example, select <strong>Box OAuth default profile</strong>.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select <strong>All MID Servers</strong>.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.
6. Click **New**.
   The system displays the message *What type of Credentials would you like to create?*.

7. Select **OAuth 2.0 Credentials**.
   The pop-up window displays a blank OAuth 2.0 Credentials form.

8. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Box Upload Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Select the OAuth profile you created when you registered the custom Box application as an OAuth provider. For example, select <strong>Box OAuth default profile</strong>.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

9. Click **Submit**.

**Create Connection records for the Box spoke**

Create Connection records to your Box account and the Box APIs. The Box spoke connection and credential aliases use these connections to perform actions on Box.

**Procedure**

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open for the record for **Box**.
3. From the **Connections** tab, click **New**.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter Box API Connection.</td>
</tr>
</tbody>
</table>
**Field** | **Value required**
---|---
Credential | Select the Credential record you created for the Box API. For example, select **Box API Credentials**.

5. Click **Submit**.

6. Open for the record for **Box Upload**.

7. From the **Connections** tab, click **New**. The system displays a blank HTTP(s) Connection form.

8. Enter these values.

**Field** | **Value required**
---|---
Name | Enter any name to uniquely identify the connection record. For example, enter **Box Upload Connection**.
Credential | Select the Credential record you created for Box upload. For example, select **Box Upload Credentials**.

9. Click **Submit**.

**Regenerate Box OAuth token**

Regenerate the Box OAuth token when it expires. The Box spoke OAuth token expires every thirty days.

**Procedure**

1. Navigate to **Connections & Credentials > Credentials**.
2. Select the Box spoke OAuth Credential record.

   **Example**
   For example, select **Box API Credentials**.

3. From Related Links, click **Get OAuth Token**.

   **Results**
   The Box spoke receives a new OAuth access token good for 30 days.
Set up a bi-directional webhook for Box spoke
Configure a webhook to subscribe to Box with a ServiceNow callback URL.

Before you begin
Role required: admin

- Request an IntegrationHub Professional subscription
- Activate the Box spoke
- Role required: admin

Add an endpoint URL in Box account
Specify an endpoint URL in your Box account to create a webhook for Box spoke.

Before you begin
Role required: admin

Procedure
1. Log in to Box developer console.
2. Create an app according to your requirements.
   For more information about app creation, see Box Applications.
3. Generate a Primary Key and Secondary Key for your app and a record the key values.
4. Specify the Endpoint URL of the ServiceNow instance in the following format.
   https://<instance-name>.service-now.com/api/sn_box_spoke/
   box_spoke_webhook_endpoints/webhook_endpoint
5. Specify the callback parameters according to your requirement.

Results
The endpoint URL is added in your Box account. You can create webhook registries and subflows according to your requirements.

Register a Box webhook in ServiceNow
Create a Box webhook registry in ServiceNow to notify the ServiceNow app when certain events occur in your Box account.

Before you begin
Role required: admin
Procedure
1. Navigate to Box > Box Webhook Registry.
2. Click New.
3. On the form, fill in these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name to identify the webhook registry. For example, Box spoke webhook registry.</td>
</tr>
<tr>
<td>Secondary Key</td>
<td>Secondary key of your app in Box account.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the spoke.</td>
</tr>
<tr>
<td>Trigger</td>
<td>Box event that triggers the webhook.</td>
</tr>
<tr>
<td>Primary Key</td>
<td>Primary key of your app in Box account.</td>
</tr>
<tr>
<td>Flow Name</td>
<td>Flow to be triggered when the specified event occurs.</td>
</tr>
</tbody>
</table>

Results
The Box webhook is registered in your ServiceNow instance.

Calendly spoke
The Calendly spoke provides actions to view and analyze meaningful usage data for Calendly software subscriptions. Analyze usage for a Calendly account to determine which licenses are stale so that you can reclaim these licenses and realize your potential savings.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.
Spoke requirements

- Organization owner or admin role in Calendly
- LastPass Enterprise admin account

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions

The Calendly spoke provides actions to automate Calendly tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Management</td>
<td>Look up Scheduled Events Stream</td>
<td>Retrieves details about all scheduled events within an organization.</td>
</tr>
<tr>
<td>User Management</td>
<td>Look up Organization</td>
<td>Retrieves the URI of the organization that the authenticated user currently belongs to.</td>
</tr>
<tr>
<td></td>
<td>Look up Organization Members Stream</td>
<td>Retrieves details about all members within an organization.</td>
</tr>
<tr>
<td></td>
<td>Remove User from Organization</td>
<td>Deletes a user's organization membership.</td>
</tr>
</tbody>
</table>

Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any
actions that use the connection. For more information, see Connections and Credentials.

Set up the Calendly spoke
Integrate the ServiceNow instance and Calendly by registering a custom OAuth application in Calendly to authenticate ServiceNow requests.

Before you begin
• Request an IntegrationHub subscription.
• Activate Calendly spoke.
• Calendly role required: organization owner or admin
• LastPass role required: admin
• ServiceNow role required: admin

Register a public application with Calendly
Register a public application with the Calendly service so that you can access the Calendly API using OAuth 2.0.

Before you begin
The Calendly service uses the LastPass password manager and Vault to securely generate and store sensitive information, such as usernames, passwords, client IDs, and client secrets. To successfully authenticate to and access the Calendly API, you must use the LastPass Enterprise plan.

Calendly role required: organization owner or admin
LastPass role required: admin

Procedure
1. Generate Sharing Keys for your LastPass Vault.
   By generating Sharing Keys, you can safely share the sensitive information in your LastPass Vault with other users in your organization.

   You can generate and activate Sharing Keys through either the LastPass web browser extension or your LastPass Vault.

   • Generate Sharing Keys through the LastPass web browser extension:
     a. From a web browser, go to the LastPass downloads page.
     b. Under More ways to get LastPass, select the operating system of the device on which you want to use the LastPass web browser extension.
c. From the list of available extensions, click **Download** for the LastPass web browser extension that you want to use.

d. Follow the instructions to download and add the extension to your web browser.

e. After the extension is added, click the LastPass icon (●) on your web browser toolbar.

f. When prompted, log in to your LastPass admin account.

   Upon successful login, both the LastPass web browser extension and Sharing Keys are activated.

• Generate Sharing Keys through your LastPass Vault:

   a. From a web browser, open **LastPass**.

   b. Log in to your LastPass admin account.

       Your LastPass Vault opens.

   c. On the left navigation menu of your LastPass Vault, select **Advanced Options**.

   d. When prompted, select **Generate sharing keys**.

       The Generate Sharing Key dialog box opens.

   e. In the dialog box, click **Generate**.

       The dialog box closes and your Sharing Keys are generated.

   f. Log out of your LastPass admin account.

   g. Log back in to your LastPass admin account.

       Your Sharing Keys are activated.

2. Register a public application with the Calendly service.

   a. From a web browser, open the **Calendly application registration form**.

   b. Click **Get started**.

   c. Answer each question within the application registration form.

       After you complete the form, your application registers with the Calendly service. Calendly then assigns a Client ID and Client Secret to the application and automatically sends this information to your LastPass admin account.

3. Retrieve your Client ID and Client Secret from the LastPass Admin Console.

   a. From a web browser, open the **LastPass Admin Console**.

   b. Log in to your LastPass admin account.
The LastPass Admin Console opens.


d. On the left navigation menu of the advanced settings, select Keys. The Keys Management page opens.

e. In the OAuth section of the Keys Management page, click ENABLE.

f. Copy the values in the CLIENT ID and CLIENT SECRET fields. Save these in a secure location for later use.

Create a Calendly connection
Create a connection between your Calendly applications and your ServiceNow instance.

Before you begin
ServiceNow role required: admin

Procedure

2. Select the Connections tab.

3. Locate your Calendly connection and then click Add Connection. The Create Connection and Credential dialog box opens.

4. In the dialog box, fill in the fields.

<table>
<thead>
<tr>
<th>Create Connection and Credential dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>Connection Name</td>
</tr>
<tr>
<td>Connection URL</td>
</tr>
<tr>
<td>OAuth Client ID</td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>-----------------------</td>
</tr>
<tr>
<td>OAuth Client Secret</td>
</tr>
<tr>
<td>OAuth Redirect URL</td>
</tr>
</tbody>
</table>

5. Click **Create and Get OAuth Token**.

The Authorize App dialog box opens.

6. In the dialog box, log in to your Calendly account.

The OAuth access token becomes available for authorizing your Calendly connection.

**Cisco Webex Meetings spoke**

Manage users of the Cisco Webex Meetings application. Get a list of all users, view user activity, and deactivate user accounts.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

**Supported versions**

Webex Meetings XML API

**Spoke actions**

The Cisco Webex Meetings spoke provides actions to automate Webex tasks when events occurs in the Now Platform. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Management</td>
<td>Get Users</td>
<td>Gets a list of all Webex user subscriptions.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get User Activity</td>
<td>Gets the date of the most recent meeting hosted by each Webex user.</td>
</tr>
<tr>
<td></td>
<td>Remove User</td>
<td>Deactivates a Webex user account.</td>
</tr>
</tbody>
</table>

**Webex Meetings account requirements**

The Cisco Webex Meetings spoke requires creating a custom app in Cisco DevNet to generate OAuth 2.0 tokens. See [Create Webex OAuth app](#).

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

This spoke uses the Webex alias record to authorize actions.

**Set up Cisco Webex Meetings spoke**

Integrate your ServiceNow instance and the Cisco Webex Meetings application by creating a custom OAuth application in Cisco DevNet to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription
- Activate the Cisco Webex Meetings spoke
- Role required: admin

**Create Webex OAuth app**

Create a custom OAuth application in Cisco DevNet to enable OAuth 2.0 authentication with the Cisco Webex Meetings spoke.

**Before you begin**

Webex Meetings requirements:

- Webex Meetings account
- Webex Meetings administrator credentials
Procedure

1. Navigate to Cisco DevNet WebEx Integration. Log in using the Login with Webex Meetings option.
2. On the My App Information page, click Add App Information.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integration name</td>
<td>Name of your choice. For example, ServiceNow integration.</td>
</tr>
<tr>
<td>Redirect URI</td>
<td><a href="https://instance.service-now.com/oauth_redirect.do">https://instance.service-now.com/oauth_redirect.do</a>, where instance is the name of your ServiceNow instance</td>
</tr>
<tr>
<td>Scope</td>
<td>Webex Meetings application scope permissions you want the app to support.</td>
</tr>
</tbody>
</table>

Note: The read_all and modify_users scopes are required to use the actions provided with the spoke. The Get Users and Get User Activity actions require the read_all scope. The Remove User action requires the modify_users scope.

4. Record the client ID and client secret to register the app as a third-party OAuth provider on your ServiceNow instance.

Register Webex Meetings as OAuth provider

Use the information generated during OAuth app creation to register the Webex Meetings application as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Procedure

1. Navigate to System OAuth > Application Registry.
2. Click New.
3. Select Connect to a third party OAuth Provider.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Webex Meetings OAuth.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID you created during the Webex app configuration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret you created during the Webex app configuration.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Authorization Code.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.
   The system validates the OAuth credentials and populates the **Redirect URL** field and the OAuth Entity Profiles related list.

### Create Credential record for the Webex Meetings spoke

Create a Credential record for the Webex custom OAuth application you created in Cisco DevNet. The Cisco Webex Meetings spoke connection and credential alias uses the credential to authorize actions.

**Procedure**

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
3. Select **OAuth 2.0 Credentials**.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Webex Meetings Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Selected.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile you created when you registered the custom Webex application as an OAuth provider. For example, Webex Meetings OAuth default profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>MID Servers that can use this credential. For example, All MID Servers.</td>
</tr>
</tbody>
</table>
5. Click Submit.

Create Connection record for the Webex Meetings spoke

Create a Connection record for your Webex account. The Cisco Webex Meetings spoke connection and credential alias uses the connection to perform actions in Webex.

Procedure
1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for Webex.
3. From the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, Webex Meetings Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Webex Meetings. For example, Webex Meetings Credentials.</td>
</tr>
<tr>
<td>Connection URL</td>
<td><a href="https://site.webex.com/WBXService/XMLService">https://site.webex.com/WBXService/XMLService</a>, where site is the name of your Webex site.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Cisco Webex Teams Spoke

Manage Cisco Webex Teams from your ServiceNow instance.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
IntegrationHub subscription
This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Cisco Webex Teams v1, but may be compatible with later versions.

Spoke requirements
• Cisco Webex Teams account

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• Complex Object (com.glide.cobject)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Cisco Webex Teams Spoke provides actions to automate tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Membership Management</td>
<td>Create Membership</td>
<td>Creates membership and adds a member to a space using the specified email address. You can choose to make the member as the moderator of the space.</td>
</tr>
<tr>
<td></td>
<td>Delete Membership</td>
<td>Removes membership from a space for the specified member.</td>
</tr>
<tr>
<td></td>
<td>Get Membership</td>
<td>Retrieves details for a space membership.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>Look up Membership</td>
<td></td>
<td>Retrieves a list of all space memberships.</td>
</tr>
<tr>
<td>Update Membership</td>
<td></td>
<td>Updates details of a space membership.</td>
</tr>
<tr>
<td>Message Management</td>
<td>Delete Message</td>
<td>Deletes the specified message.</td>
</tr>
<tr>
<td>Get Message Details</td>
<td></td>
<td>Retrieves details of the specified message.</td>
</tr>
<tr>
<td>Look up Direct Messages</td>
<td></td>
<td>Retrieves a list of messages in a direct space.</td>
</tr>
<tr>
<td>Look up Messages</td>
<td></td>
<td>Retrieves all messages in a space.</td>
</tr>
<tr>
<td>Post Direct Message</td>
<td>Posts Direct Message</td>
<td>Posts a plain text or rich text message to a the specified email address. A file can be specified as an attachment to the message optionally.</td>
</tr>
<tr>
<td>Post Message to Space</td>
<td>Post Message to Space</td>
<td>Posts a plain text or rich text message to the specified space. A file can be specified as an attachment to the message optionally.</td>
</tr>
<tr>
<td>Space Management</td>
<td>Create Space</td>
<td>Creates a space.</td>
</tr>
<tr>
<td>Delete Space</td>
<td></td>
<td>Deletes the specified space.</td>
</tr>
<tr>
<td>Get Space Details</td>
<td></td>
<td>Retrieves details of the specified space.</td>
</tr>
<tr>
<td>Look up Spaces</td>
<td></td>
<td>Retrieves details of the spaces to which the authenticated user belongs.</td>
</tr>
<tr>
<td>Update Space</td>
<td></td>
<td>Updates details of the specified space.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the...
connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

You can use OAuth 2.0 or the custom Cisco Webex Credentials to authenticate requests.

Set up the Cisco Webex Teams Spoke
Integrate the ServiceNow instance and Cisco Webex Teams by creating a custom OAuth application in Cisco Webex Teams or using the custom Cisco Webex Credentials to authenticate ServiceNow requests.

Before you begin
• Request an IntegrationHub subscription.
• Activate Cisco Webex Teams Spoke.
• Role required: admin

You can choose to use either OAuth 2.0 or the custom credentials, Cisco Webex Credentials, for authentication.

Register Cisco Webex Teams as an OAuth provider
Use the information generated during the Cisco Webex Teams application configuration to register Cisco Webex Teams as an OAuth provider and allow the ServiceNow instance to request OAuth 2.0 tokens.

Procedure
1. Navigate to System OAuth > Application Registry.
2. Click New.
   The system displays this message: What kind of OAuth application?.
3. Select Connect to a third party OAuth Provider.
4. On the form, fill these values.

   Application Registries form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter: Cisco Webex Teams OAuth</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID created during the Cisco Webex Teams application configuration.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret created during the Cisco Webex Teams application configuration.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>OAuth authorization code endpoint. Enter: <a href="https://webexapis.com/v1/authorize">https://webexapis.com/v1/authorize</a></td>
</tr>
<tr>
<td>Token URL</td>
<td>OAuth server token endpoint. Enter: <a href="https://webexapis.com/v1/access_token">https://webexapis.com/v1/access_token</a></td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>OAuth server token revocation endpoint.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint in this format: https://&lt;instance&gt;.service-now.com/oauth_redirect.do</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Script to customize the request and response. Select OauthCiscoWebexTeamsUtils.</td>
</tr>
<tr>
<td>Logo URL</td>
<td>URL that contains an image to use as the application logo.</td>
</tr>
<tr>
<td>Default Grant Type</td>
<td>Grant type used to establish the token. Select Authorization Code.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>Time, in seconds, that the refresh token is valid. The default time is 8,640,0000 seconds.</td>
</tr>
<tr>
<td>PKCE required</td>
<td>Option to enable public clients to require PKCE for an authorization.</td>
</tr>
<tr>
<td>Note:</td>
<td>You can use only Authorization Code as the Default Grant type when PKCE is enabled.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Application scope that this registry is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use mutual authentication for token request and revocation. This option requires a mutual authentication profile to be specified.</td>
</tr>
</tbody>
</table>

5. Right-click the form header, and click Save.
Create a OAuth credential record for the Cisco Webex Teams Spoke

Create a credential record for the Cisco Webex Teams account. The Cisco Webex Teams Spoke connection and credential alias uses these credentials to authorize actions.

Procedure

1. Navigate to IntegrationHub > Connections & Credentials > Credentials.
2. Click New.

The system displays this message: What type of Credentials would you like to create?

3. Select OAuth 2.0 Credentials.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Cisco Webex Teams Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile created during the registration of Cisco Webex Teams as an OAuth provider. For example, Cisco Webex Teams OAuth Profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Option to specify if the credential applies to all MID Servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use this credential in the MID servers field.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, 100.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias associated with the spoke.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click Submit.
6. To generate the OAuth token, click the Get OAuth Token related link.

Create a connection and credential alias record for the Cisco Webex Teams Spoke

Create a credential record for the Cisco Webex Teams account. The Cisco Webex Teams Spoke connection and credential alias uses these credentials to authorize actions.
Procedure
1. Navigate to IntegrationHub > Connections & Credentials > Connection & Credential Aliases.
2. Open the CiscoWebexTeams record.
3. TBD
4. Right-click the form header and click Submit.

Create a custom credential record for the Cisco Webex Teams Spoke
Create a custom credential record for the Cisco Webex Teams account. The Cisco Webex Teams Spoke connection and credential alias uses these credentials to authorize actions.

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays this message: What type of Credentials would you like to create?
4. On the form, fill these values.

Cisco Webex Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Cisco Webex Teams Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Access Key ID generated in your Cisco Webex Teams account.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Bot's Access Token generated when you add a bot in your CiscoWebex account.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select Cisco Webex Teams.</td>
</tr>
</tbody>
</table>

ℹ️ Note: Do not directly modify the default authentication algorithm.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credential alias</td>
<td>Associated Cisco Webex Teams credential record.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click **Submit**.

**Confluence Cloud spoke v1.0.2**

The Confluence Cloud spoke provides actions to manage groups, group members, and search content in your Confluence Atlassian account.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Supported versions**

This spoke was built for the Confluence Cloud REST API.

**Spoke requirements**

- Atlassian site admin account
- OAuth 2.0 application and OAuth 2.0 token

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

**Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.
Spoke actions
The Confluence Cloud spoke provides actions to automate Confluence Cloud tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Management</td>
<td>Search Content</td>
<td>Retrieves the list of content based on the provided query.</td>
</tr>
<tr>
<td>Group Management</td>
<td>Look up Groups</td>
<td>Retrieves all groups in the Atlassian account, including default groups.</td>
</tr>
<tr>
<td></td>
<td>Look up Members By Group ID</td>
<td>Retrieves all active users within the specified group.</td>
</tr>
<tr>
<td></td>
<td>Remove Member From Group By Group ID</td>
<td>Removes a user from the specified group.</td>
</tr>
<tr>
<td>User Management</td>
<td>Look up Group Memberships For User</td>
<td>Retrieves information about the groups that the user is a member of.</td>
</tr>
</tbody>
</table>

Spoke module
The Confluence Cloud spoke adds the Confluence Cloud application to your instance and includes these modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confluence Groups</td>
<td>Enables you to specify the groups that have access to Confluence products. By specifying these groups, you can manage the users within only these groups using the Confluence Cloud spoke.</td>
</tr>
</tbody>
</table>

Data accessed through these spoke modules is stored in these tables:

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confluence Groups</td>
<td>Displays the list of groups that have access to Confluence products.</td>
<td>• Group Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Group ID</td>
</tr>
</tbody>
</table>
Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the Confluence Cloud spoke

Integrate the ServiceNow instance and Confluence Cloud by creating a custom OAuth 2.0 application in Confluence Cloud to authenticate ServiceNow requests.

Before you begin

- Request an IntegrationHub subscription.
- Activate Confluence Cloud spoke.
- Atlassian role required: site admin
- ServiceNow role required: admin

Create a Confluence Cloud OAuth 2.0 (3LO) application

Create a Confluence Cloud OAuth 2.0 (3LO) application to enable access to the Confluence Cloud API.

Before you begin

Atlassian role required: site admin

Procedure

1. From a web browser, open the Atlassian Developer portal.
2. Log in to your site admin account.
3. On the page header of the portal, click your profile icon and then select Developer console.
   The My apps page of the Atlassian Developer Console opens.
4. Click the Create app menu and then select OAuth 2.0 (3LO) integration.
   The Create a new OAuth 2.0 (3LO) integration page opens.
5. Enter a name for the OAuth 2.0 (3LO) application in the Name field.
6. Select the I agree to be bound by Atlassian's developer terms check box and then click Create.
   The overview and settings for your newly created app open.
7. Configure authorization settings for your application.

   a. From the left navigation pane, select Authorization.

   b. Click Configure for the OAuth 2.0 (3LO) authorization type.
      The OAuth 2.0 authorization code grants (3LO) for apps page opens.

   c. In the Callback URL field, enter the URL of the OAuth provider that users are
      redirected to after authentication.
      Enter https://instance.service-now.com/oauth_redirect.do, where <instance>
      is the name of your ServiceNow instance.

   d. Click Save changes.

8. Configure API scopes for your application.
   API scopes specify the level of access that the application has to the Atlassian
   APIs.

   a. From the left navigation pane, select Permissions.

   b. From the list of available APIs, locate the Confluence API and then click Add.
      The Add action button automatically changes to the Configure action button.

   c. Click Configure.
      The Confluence API page opens.

   d. Add the following scopes for the Confluence API:
      • Search Confluence content and space summaries
      • Read user groups
      • Create, remove and update user groups
      • Read user

9. Retrieve the client ID and client secret that are assigned to your application.

   a. From the left navigation pane, select Settings.

   b. In the Authentication details section, copy the values in the Client ID and
      Secret fields.
      Save them in a secure location for later use.
Create a Confluence Cloud connection

Create a connection between your Confluence Cloud applications and your ServiceNow instance.

**Before you begin**

ServiceNow role required: admin

**Procedure**

1. From your ServiceNow instance, navigate to **Process Automation > Flow Designer**.
   The Flow Designer launches in a new tab.

2. Select the **Connections** tab.

3. Click **View Details** for your Confluence Cloud connection.

4. From the list of available connections, locate Confluence Cloud and then click **Configure**.
   The Configure Connection dialog box opens.

5. In the dialog box, fill in the fields.

**Configure Connection dialog box**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection Information</strong></td>
<td></td>
</tr>
<tr>
<td>Connection Name</td>
<td>Name of the Confluence Cloud connection. This field populates automatically.</td>
</tr>
<tr>
<td><strong>Credential Information</strong></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Name of your Confluence Cloud credentials. This field populates automatically.</td>
</tr>
<tr>
<td>Site URL</td>
<td>URL of your Confluence Cloud site.</td>
</tr>
<tr>
<td>OAuth Client ID</td>
<td>Client ID that is assigned to your Confluence Cloud OAuth 2.0 (3LO) application.</td>
</tr>
<tr>
<td>OAuth Client Secret</td>
<td>Client secret that is assigned to your Confluence Cloud OAuth 2.0 (3LO) application.</td>
</tr>
<tr>
<td>OAuth Redirect URL</td>
<td>URL of the OAuth provider that users are redirected to after authentication. This field populates automatically based on the callback URL that you specified in Create a Confluence Cloud OAuth 2.0 (3LO) application.</td>
</tr>
</tbody>
</table>
6. Click **Configure and Get OAuth Token**.
   The Authorize App dialog box opens.

7. In the dialog box, click **Allow**.
   The OAuth token becomes available for authorizing your Confluence Cloud connection.

**Add Confluence groups**

Specify the groups that have access to Confluence products so that you can manage the users within only these groups using the Confluence Cloud spoke.

**Before you begin**

Atlassian role required: site admin  
ServiceNow role required: admin

**Procedure**

1. From a web browser, open the Atlassian Administration portal.
2. Log in to your site admin account.
3. Navigate to **SITE SETTINGS > Product access**.
4. In the Confluence section, view the list of groups that have access to Confluence products.
   Take note of this information for later use.
5. Return to your ServiceNow instance and navigate to **Confluence Cloud > Confluence Groups**.
6. On the Confluence Groups form, click the **Add Groups** related link.
   The Add Confluence Groups dialog box opens.
7. In the Available list, select the groups that have access to Confluence products.

   **Tip:** The Available list includes all groups that are associated with your Atlassian account. Select only the groups that have access to Confluence products.
8. Click the right arrow button to move the groups from the Available list to the Selected list.
9. Click **OK**.

**Continuous Integration and Continuous Delivery (CICD) Spoke**

Build a Continuous Integration and Continuation Delivery (CICD) pipeline for your ServiceNow instances. You can automate publishing and installing...
applications from an application repository, activating plugins, running ATF test suites, and running an instance HealthScan.

**CICD spoke application**
The CICD spoke application is installed by default from the Orlando upgrade onward.

**Supported versions**
Continuous Integration and Continuous Delivery (CICD) REST API version 1.0.0, which is a Now Platform feature active by default.

**Spoke flows**
This spoke has no sample flows.

**Spoke subflows**
The Continuous Integration and Continuous Delivery (CICD) Spoke provides sample subflows in the draft state to demonstrate automating CICD tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Plugin</td>
<td>Activate a plugin by ID on the specified instance URL.</td>
</tr>
<tr>
<td>Apply Changes From Source Control</td>
<td>Apply remote changes from source control to an application by its Sys ID.</td>
</tr>
<tr>
<td>With ID</td>
<td></td>
</tr>
<tr>
<td>Apply Changes From Source Control</td>
<td>Apply remote changes from source control to an application by its scope name.</td>
</tr>
<tr>
<td>With Scope</td>
<td></td>
</tr>
<tr>
<td>ATF Suite Start With ID</td>
<td>Start a test suite by its Sys ID on the specified instance URL. Return the test suite execution results.</td>
</tr>
<tr>
<td>ATF Suite Start With Name</td>
<td>Start a test suite by its name on the specified instance URL. Return the test suite execution results.</td>
</tr>
<tr>
<td>Batch Install</td>
<td>Given a Batch Plan in JSON format, install multiple packages (applications, customizations to store applications, and plugins) together in a single batch operation.</td>
</tr>
<tr>
<td>Subflow</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Batch Results</td>
<td>Given the sys_id of a result object, view the installation status of each package along with entire batch plan.</td>
</tr>
<tr>
<td>Batch Rollback</td>
<td>With a rollback ID, roll back the installation(s) of package(s) installed as a single batch.</td>
</tr>
<tr>
<td>Get Instance Scan Results</td>
<td>Return Instance Scan execution results by progress ID. Scan_results always return but scan_finding results display only if present.</td>
</tr>
<tr>
<td>Instance Scan Execute Full Scan</td>
<td>Start full Instance Scan on specified instance URL. Scan runs with all active checks.</td>
</tr>
<tr>
<td>Instance Scan Execute Point Scan</td>
<td>Start Instance Scan on specified instance starting from a particular table and record (the table and sys_ID). Target is scanned using all relevant and applicable checks.</td>
</tr>
<tr>
<td>Instance Scan Execute Suite Scan</td>
<td>Start full Instance Scan on specified instance URL using a specific suite of checks.</td>
</tr>
<tr>
<td>Instance Scan Execute Suite Scan on one or more scoped apps</td>
<td>Start Instance Scan on specified scoped apps using checks from a specified suite ID.</td>
</tr>
<tr>
<td>Instance Scan Execute Suite Scan on one or more update sets</td>
<td>Start Instance Scan on the specified update sets using checks from a specified suite ID.</td>
</tr>
<tr>
<td>Install Application With ID</td>
<td>Install an application by its Sys ID from the application repository.</td>
</tr>
<tr>
<td>Install Application With Scope</td>
<td>Install an application by its scope name from the application repository.</td>
</tr>
<tr>
<td>Publish Application With ID</td>
<td>Publish an application by its Sys ID to the application repository.</td>
</tr>
<tr>
<td>Publish Application With Scope</td>
<td>Publish an application by its scope name to the application repository.</td>
</tr>
<tr>
<td>Rollback Application With ID</td>
<td>Roll back an application by its Sys ID. Confirm the rollback version number matches the specified version number or produce an error.</td>
</tr>
<tr>
<td>Subflow</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rollback Application With Scope</td>
<td>Roll back an application by its scope name. Confirm the rollback version number matches the specified version number or produce an error.</td>
</tr>
<tr>
<td>Rollback Plugin</td>
<td>Roll back a plugin by ID on the specified instance URL to the last installed version.</td>
</tr>
<tr>
<td>Wait Until Tracker Completes</td>
<td>Wait for a tracker to complete its progress on the specified instance URL and return the results.</td>
</tr>
</tbody>
</table>

**Spoke actions**

The Continuous Integration and Continuous Delivery (CICD) Spoke provides actions to automate CICD tasks when events occurs in the Now Platform. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Repo</td>
<td>Install Application With ID</td>
<td>Install an application by its Sys ID from the application repository.</td>
</tr>
<tr>
<td></td>
<td>Install Application With Scope</td>
<td>Install an application by its scope name from the application repository.</td>
</tr>
<tr>
<td></td>
<td>Publish Application With ID</td>
<td>Publish an application by its Sys ID to the application repository.</td>
</tr>
<tr>
<td></td>
<td>Publish Application With Scope</td>
<td>Publish an application by its scope name to the application repository.</td>
</tr>
<tr>
<td></td>
<td>Rollback Application With ID</td>
<td>Rollback an application by its Sys ID. Confirm the rollback version number matches the specified version number or produce an error.</td>
</tr>
<tr>
<td></td>
<td>Rollback Application With Scope</td>
<td>Roll back an application by its scope name. Confirm the rollback version number matches the specified version number or produce an error.</td>
</tr>
<tr>
<td>ATF</td>
<td>ATF Get Suite Results</td>
<td>Return the test suite execution results by Sys ID.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>----------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get Execution Tracker Progress</td>
<td>Return tracker progress information by Sys ID.</td>
</tr>
<tr>
<td></td>
<td>Start ATF Suite With ID</td>
<td>Start a test suite by its Sys ID on the specified instance URL.</td>
</tr>
<tr>
<td></td>
<td>Start ATF Suite With Name</td>
<td>Start a test suite by its name on the specified instance URL.</td>
</tr>
<tr>
<td>Batch Install</td>
<td>Batch Install</td>
<td>Install multiple applications at once</td>
</tr>
<tr>
<td></td>
<td>Batch Results</td>
<td>View installation status of each package along with entire batch plan.</td>
</tr>
<tr>
<td></td>
<td>Batch Rollback</td>
<td>With a rollback ID, roll back the installation(s) of package(s) installed as a single batch.</td>
</tr>
<tr>
<td>Instance Scan</td>
<td>Get Instance Scan Results</td>
<td>Return Instance Scan execution results by progress ID. Scan_results always display but scan_finding results display only if present.</td>
</tr>
<tr>
<td></td>
<td>Instance Scan Execute Full Scan</td>
<td>Return Instance Scan execution results by progress ID. Scan_results always return but scan_finding results display only if present.</td>
</tr>
<tr>
<td></td>
<td>Instance Scan Execute Point Scan</td>
<td>Start full Instance Scan on specified instance URL. Scan runs with all active checks.</td>
</tr>
<tr>
<td></td>
<td>Instance Scan Execute Suite Scan</td>
<td>Start Instance Scan on specified instance starting from a particular table and record (the table and sys_ID). Target is scanned using all relevant and applicable checks.</td>
</tr>
<tr>
<td></td>
<td>Instance Scan Execute Suite Scan on one or more scoped apps</td>
<td>Start full Instance Scan on specified instance URL using a specific suite of checks.</td>
</tr>
<tr>
<td></td>
<td>Instance Scan Execute Suite Scan on one or more update sets</td>
<td>Start Instance Scan on specified scoped apps using checks from a specified suite ID.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Plugin</td>
<td>Activate Plugin</td>
<td>Activate a plugin by ID on the specified instance URL.</td>
</tr>
<tr>
<td></td>
<td>Rollback Plugin</td>
<td>Rollback a plugin by ID on the specified instance URL to the last installed version.</td>
</tr>
<tr>
<td>Source Control</td>
<td>Apply Changes From Source Control With ID</td>
<td>Apply remote changes from source control to an application by its Sys ID.</td>
</tr>
<tr>
<td></td>
<td>Apply Changes From Source Control With Scope</td>
<td>Apply remote changes from source control to an application by its scope name.</td>
</tr>
</tbody>
</table>

**CICD account requirements**

The Continuous Integration and Continuous Delivery (CICD) Spoke requires creating basic authorization credentials. The user credentials must have either the admin or sn_cicd.sys_ci_automation roles to authorize CICD actions and flows.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

This spoke uses the CICD alias record to authorize actions on local and remote instances.

**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the CICD alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

**Set up Continuous Integration and Continuous Delivery (CICD) Spoke**

Use basic authentication to authenticate CICD REST API calls on a ServiceNow instance.
Before you begin

• Request IntegrationHub subscription
• Activate Continuous Integration and Continuous Delivery (CICD) Spoke
• Role required: admin or sn_cicd.sys_ci_automation

Create Credential records for the Continuous Integration and Continuous Delivery (CICD) Spoke

Create Credential records to the ServiceNow instance. The Continuous Integration and Continuous Delivery (CICD) Spoke connection and credential alias uses these credentials to authorize actions.

Before you begin
Role required: admin

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?
3. Select Basic Auth Credentials.
   A blank Basic Auth Credentials form displays.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter CICD Credentials.</td>
</tr>
<tr>
<td>User name</td>
<td>The ServiceNow instance user name that authorizes and runs spoke actions and flows. This user must have either the admin or sn_cicd.sys_ci_automation roles.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for the ServiceNow instance user.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click Submit.
Create Connection records for the Continuous Integration and Continuous Delivery (CICD) Spoke

Create Connection records to your ServiceNow instance. The Continuous Integration and Continuous Delivery (CICD) spoke connection and credential alias uses these connections to perform actions on your ServiceNow instance.

Procedure
1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for CICD.
3. From the Connections tab, click New. The system displays a blank HTTP or HTTPS Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter CICD Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for CICD. For example, select CICD Credentials.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>The URL of the ServiceNow instance on which the spoke runs actions and flows.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Confluent Kafka REST Proxy spoke
Integrates your ServiceNow instances with the Kafka cluster through Confluent Kafka REST Proxy API.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.
Supported versions
This spoke was built for Confluent REST Proxy API v2.

Spoke dependencies
If you’re having trouble installing the app, ensure that the dependent plugin, ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime) is installed.

⚠️ Note: The plugin is a licensable feature and requires appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Confluent Kafka REST Proxy spoke provides actions to automate tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign Consumer Instance to Topic Partition</td>
<td>Assigns a list of partitions to this consumer manually.</td>
</tr>
<tr>
<td>Commit Consumer Offsets</td>
<td>Commits a list of offsets for the consumer. When the post body is empty, all the records that have been fetched by the consumer instance are committed.</td>
</tr>
<tr>
<td>Create a Consumer Instance within a Consumer Group</td>
<td>Creates a consumer instance within Kafka consumer group.</td>
</tr>
<tr>
<td>Delete Consumer Instance</td>
<td>Destroys the consumer instance.</td>
</tr>
<tr>
<td>Get Kafka Partition Details For A Topic</td>
<td>Retrieves partition details for a Kafka topic.</td>
</tr>
<tr>
<td>Get Messages</td>
<td>Retrieves messages from a Kafka topic.</td>
</tr>
<tr>
<td>Publish Message</td>
<td>Produces messages to a Kafka topic.</td>
</tr>
</tbody>
</table>

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any
actions that use the connection. For more information, see Connections and Credentials.

Set up the Confluent Kafka REST Proxy spoke
Integrate Confluent Kafka REST proxy with your ServiceNow instance using basic authentication.

Before you begin
• Request IntegrationHub subscription.
• Activate Confluent Kafka REST Proxy spoke.
• Role required: admin

⚠️ Note: This procedure outlines steps to set up Confluent Kafka REST Proxy spoke using basic authentication. However, based on your customisations, you can also set up the spoke using any other HTTP authentication mechanism that is currently supported by the ServiceNow Platform.

Procedure
1. Create a credential record for the Confluent Kafka REST Proxy spoke.
   a. Navigate to Connections & Credentials > Credentials.
   b. Click New.
      The system displays the message What type of Credentials would you like to create?.
   c. Select Basic Auth Credentials.
      A blank Basic Auth Credentials form displays.
   d. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter Kafka spoke Credentials.</td>
</tr>
<tr>
<td>User name</td>
<td>User name to connect to the Confluent Kafka REST Proxy API endpoint.</td>
</tr>
<tr>
<td>Password</td>
<td>Password to connect to the Confluent Kafka REST Proxy API endpoint.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the record.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

**e. Click Submit.**

2. Create a connection record for the Confluent Kafka REST Proxy spoke.

**a. Navigate to Connections & Credentials > Connection & Credential Aliases.**

**b. Open for the record, Kafka REST.**

**c. From the Connections tab, click New.**

The system displays a blank HTTP(s) Connection form.

**d. Enter these values.**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter Kafka spoke Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for the Confluent Kafka REST Proxy spoke. For example, select Kafka spoke Credentials.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL to connect to the Confluent Kafka REST Proxy API.</td>
</tr>
</tbody>
</table>

**e. Click Submit.**

**Cornerstone spoke v1.2.1**

Manage employee records, approvals, and employee learning in your Cornerstone instance from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Cornerstone version v1, but may be compatible with later versions.

Spoke dependencies
If you're having trouble installing the app, ensure that these dependent plugins are installed:

- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Spoke flows
The Cornerstone spoke provides a sample flow in the draft state to demonstrate automating the Cornerstone tasks. The sample flow, Cornerstone - Pull Todos Details, retrieves the list of Todos for the required user. Ensure that this user is added to your ServiceNow instance. The retrieved records can be accessed by navigating to the TO DO Lists module in the Cornerstone application of your instance.

To customize the sample flow, copy it to a new application scope.

Spoke subflows
The Cornerstone spoke provides sample subflows in the draft state to demonstrate automating Cornerstone tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cornerstone - Get Certificate</td>
<td>Retrieves the certificate information of the required employee.</td>
</tr>
<tr>
<td>Subflow</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Transcript Details</td>
<td>Cornersstone - Get Transcripts Retrieves the transcript information of the required employee.</td>
</tr>
<tr>
<td>Cornerstone - Remove Dangling To Do</td>
<td>Deletes the dangling Todo records. Some of the retrieved Certificate records may not have values set for the Status and Launch URL fields. The Cornerstone - Remove Dangling To Do action deletes such todo records.</td>
</tr>
</tbody>
</table>

**Spoke actions**

The Cornerstone spoke provides actions to automate Cornerstone tasks when events occurs in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Core Management</td>
<td>Look up Approval Details</td>
<td>Retrieves information about the pending approvals.</td>
</tr>
<tr>
<td></td>
<td>Look up Organizational Unit</td>
<td>Retrieves the list of organization units based on organization unit type.</td>
</tr>
<tr>
<td></td>
<td>Global Search</td>
<td>Searches for the required people, training, certification, and so on.</td>
</tr>
<tr>
<td>Employee Management</td>
<td>Create Employee</td>
<td>Creates an employee record and retrieves core employee data from Cornerstone.</td>
</tr>
<tr>
<td></td>
<td>Get Custom Fields For Employee</td>
<td>Retrieves custom fields for an employee from Cornerstone.</td>
</tr>
<tr>
<td></td>
<td>Look up Employees</td>
<td>Retrieves core data of the required employees in Cornerstone.</td>
</tr>
<tr>
<td></td>
<td>Update Employee</td>
<td>Updates details of the required employee in Cornerstone.</td>
</tr>
<tr>
<td>Learning Management</td>
<td>Look up Approvals</td>
<td>Retrieves the pending approvals of the manager or approver.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Look up</td>
<td>Assigned Trainings</td>
<td>Retrieves details of the trainings assigned to a user.</td>
</tr>
<tr>
<td>Look up Catalog Search</td>
<td></td>
<td>Retrieves details of the required training.</td>
</tr>
<tr>
<td>Look up Certification Transcripts</td>
<td></td>
<td>Retrieves certification transcript information of the required user.</td>
</tr>
<tr>
<td>Look up Certification From Reporting Data Stream</td>
<td></td>
<td>Retrieves the main view to get the certification data.</td>
</tr>
<tr>
<td>Look up Inbox Items</td>
<td></td>
<td>Retrieves all items in the required user’s inbox as shown on the welcome page.</td>
</tr>
<tr>
<td>Look up Learning Object</td>
<td></td>
<td>Retrieves the learning objects from Cornerstone. The supported learning object types are, Curriculum, Event, Session, Material, Test, Video, and Online Course.</td>
</tr>
<tr>
<td>Look up Sessions</td>
<td></td>
<td>Retrieves details of the upcoming sessions.</td>
</tr>
<tr>
<td>Look up Suggested Training</td>
<td></td>
<td>Retrieves details of the required and suggested learning objects that have been added to user’s transcripts.</td>
</tr>
<tr>
<td>Look up Tasks</td>
<td></td>
<td>Retrieves all the incomplete tasks assigned to the user.</td>
</tr>
<tr>
<td>Look up Transcripts</td>
<td></td>
<td>Retrieves the transcript records of the required user.</td>
</tr>
<tr>
<td>Create Assignment</td>
<td></td>
<td>Creates a standard assignment.</td>
</tr>
<tr>
<td>Look up Assignment Details</td>
<td></td>
<td>Looks up assignment details based on Assignment ID.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reporting on Learning Module Management</td>
<td>Look up Tasks From Reporting Data Stream</td>
<td>Retrieves the main view to get training form user tasks.</td>
</tr>
<tr>
<td></td>
<td>Look up Trainings From Reporting</td>
<td>Retrieves the main view to get training data.</td>
</tr>
<tr>
<td></td>
<td>Look up Transcripts From Reporting Data Stream</td>
<td>Retrieves the main view to get all user transcript related data.</td>
</tr>
<tr>
<td></td>
<td>Look up Training Local From Reporting Data Stream</td>
<td>Retrieves the main view to get the training's local data.</td>
</tr>
<tr>
<td></td>
<td>Look up Certifications From Reporting Data Stream</td>
<td>Retrieves the main view to get all user certifications related data.</td>
</tr>
</tbody>
</table>

**Spoke module**

The Cornerstone spoke adds a Cornerstone application to your ServiceNow instance. The Cornerstone application has the TO DO Lists module. List of Todos that the sample flow, Cornerstone - Pull Todos Details, retrieves for the specified user, can be accessed here.

**Cornerstone spoke account requirements**

If you want to use the default settings and permissions provided along with the spoke, you can install the ServiceNow tile on the Cornerstone Marketplace. For more information about registering an application, see [Getting started with an Integration](#) in Cornerstone OnDemand Help. Record the generated Client ID and Client Secret for later use.

If you want to configure and customise the spoke as per your requirement and provide additional permissions, register an OAuth 2.0 application in your Cornerstone account to generate OAuth 2.0 tokens for the Cornerstone spoke.
For more information about registering an application, see API Management in Cornerstone OnDemand Help. Record the generated Client ID and Client Secret for later use.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the Cornerstone spoke**

Integrate your Cornerstone application with your ServiceNow instance. Register an OAuth application in Cornerstone and authenticate requests from ServiceNow.

**Before you begin**

- Request IntegrationHub subscription
- Activate the Cornerstone spoke
- Role required: admin

**Register Cornerstone as an OAuth provider**

Use the information generated during the Cornerstone application creation and configuration to register Cornerstone as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System OAuth > Application Registry**.
2. Open the record for the Cornerstonespoke.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter Cornerstone OAuth profile.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID created during the application configuration in Cornerstone.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret created during the application configuration in Cornerstone.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Grant type used to establish the token. Select Client Credentials.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record. Select Cornerstone Spoke.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Application scope that this registry is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry. Select the option.</td>
</tr>
<tr>
<td>Token URL</td>
<td>OAuth server token endpoint. For example, https://&lt;Cornerstone-Instance&gt;.com/services/api/oauth2/token.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**.

5. In the **OAuth Entity Profiles** tab, click the default profile, **Cornerstone default_profile**.

6. Insert a record in the OAuth Entity Scope related list and select the default entity scope for the Cornerstone spoke. For example, **all**.

7. Click **Update**.

**Note:** Ensure that the value of **OAuth Provider** is **Cornerstone**.
Create Credential record for the Cornerstone spoke

Authorize the Cornerstone spoke actions by creating credential records for the application registered in Cornerstone. The Cornerstone spoke connection and credential alias uses these credentials to authorize actions.

Before you begin
Role required: admin

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?.
3. Select OAuth 2.0 Credentials.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Cornerstone Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record. Select the option.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Default OAuth entity profile of the Cornerstone spoke. For example, select Cornerstone default_profile.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the credentials are used. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click Save.
6. To generate the OAuth token, click the Get OAuth Token related link.

Create Connection record for the Cornerstone spoke

Create Connection records to your Cornerstone application. The Cornerstone spoke connection and credential alias uses these connections to perform actions in Cornerstone.

Before you begin
Role required: admin
Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open the record for the Cornerstone spoke.
3. From the Connections tab, click New.
4. On the form, fill these values.

HTTP(s) Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter Cornerstone Conn.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Cornerstone. For example, select Cornerstone Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td>Note: Do not select the check box.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL of the Cornerstone instance.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>This field isn’t applicable.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection. Select the option.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

5. In the Attributes tab, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>u_base_url</td>
<td>URL of the Cornerstone instance.</td>
</tr>
<tr>
<td>u_version</td>
<td>Cornerstone version of your instance. Enter v1.</td>
</tr>
</tbody>
</table>

6. Click Submit.

Coupa spoke v3.0.1

Manage business spend and automate approval, contract, inventory, purchase order, requisition, supplier, and user management in Coupa from your ServiceNow instance.
Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Coupa version stable_029.0.1, but may be compatible with later versions.

Spoke requirements
Create an API key in your Coupa instance and record the API key for later use. See Coupa documentation for information about creating API key.

Spoke user roles
The following user roles are available with the spoke:

• Coupa Admin (sn_coupa_spoke.Coupa Admin): Users with this role have access to both, My Current Approvals and Contracts modules.

• Coupa Approval User (sn_coupa_spoke.Coupa Approval User): Users with this role have access only to the My Current Approvals module

• Coupa Contract User (sn_coupa_spoke.Coupa Contract User): Users with this role have access only to the Contracts module.

Spoke module
The Coupa spoke adds a Coupa application to your ServiceNow instance. The Coupa application supports Coupa Approval User and Coupa Contract User roles. You can access the Coupa application from the ServiceNow instance on your Now Mobile app.

Note: Make sure that Coupa Login attribute and the user ID of ServiceNow instance match before using the My Current Approvals module.

The Coupa application has the following modules.
### My Current Approvals
Displays the list of approvals in Coupa for a user.

### Contracts
Displays a list of contracts in Coupa.

### Spoke actions
The Coupa spoke provides actions to automate approval, contract, inventory, invoice, catalog item, purchase order, requisition, supplier, and user management when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Management</td>
<td>Approve Approval Request</td>
<td>Approves an approval request in Coupa.</td>
</tr>
<tr>
<td></td>
<td>Get Approval Details</td>
<td>Retrieves the details of the required approval in Coupa.</td>
</tr>
<tr>
<td></td>
<td>Look Up Approval</td>
<td>Looks up an approval record in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Look Up Approval By Requisition ID</td>
<td>Looks up the required approval record in Coupa using its Requisition ID.</td>
</tr>
<tr>
<td></td>
<td>Look Up Approvals</td>
<td>Looks up the required approval records in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Reject Approval Request</td>
<td>Rejects a request for approval in Coupa.</td>
</tr>
<tr>
<td>Contract Management</td>
<td>Look Up Contracts</td>
<td>Looks up the required contract records in Coupa using the Coupa query.</td>
</tr>
<tr>
<td>Inventory Management</td>
<td>Create Receipt</td>
<td>Creates a receipt in Coupa.</td>
</tr>
<tr>
<td></td>
<td>Get Receipt Details</td>
<td>Retrieves the details of the required receipt in Coupa.</td>
</tr>
</tbody>
</table>

**Note:** Ensure that description has the exact item name. When you want to access the item name in a flow, use the description data pill.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Get Receipt Fields</td>
<td>Retrieves the list of fields in the Coupa Receipts table.</td>
</tr>
<tr>
<td></td>
<td>Get Advance Shipment Notices After Updated Date</td>
<td>Retrieves the details of the advance shipment notices after the updated date in Coupa.</td>
</tr>
<tr>
<td></td>
<td>Look Up Advance Shipment Notice By Purchase Order Line ID</td>
<td>Retrieves details of the required advance shipment notice using its Purchase Order Line ID.</td>
</tr>
<tr>
<td></td>
<td>Look Up Receipt</td>
<td>Looks up the required receipt in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Look Up Receipts</td>
<td>Looks up the required receipts in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Void Receipt</td>
<td>Makes the required receipt void.</td>
</tr>
<tr>
<td>Invoice Management</td>
<td>Look Up Invoice</td>
<td>Looks up an invoice in Coupa.</td>
</tr>
<tr>
<td></td>
<td>Void Invoice</td>
<td>Makes the required invoice void.</td>
</tr>
<tr>
<td>Item Management</td>
<td>Look Up Items</td>
<td>Looks up the required items in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Look up Item</td>
<td>Looks up the required item in Coupa using the Coupa query.</td>
</tr>
<tr>
<td>Purchase Order Management</td>
<td>Cancel Purchase Order</td>
<td>Cancels the required purchase order in Coupa.</td>
</tr>
<tr>
<td></td>
<td>Close Purchase Order</td>
<td>Closes the required purchase order in Coupa.</td>
</tr>
<tr>
<td></td>
<td>Get PO Line</td>
<td>Retrieves details of the required purchase order line in Coupa.</td>
</tr>
<tr>
<td></td>
<td>Look Up Purchase Order</td>
<td>Looks up the required purchase order in Coupa using the Coupa query.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Requisition Management</td>
<td>Look Up Purchase Orders</td>
<td>Looks up the required purchase orders in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Create Draft Requisition</td>
<td>Creates a requisition in Coupa with its status as Draft.</td>
</tr>
<tr>
<td></td>
<td>Create Requisition</td>
<td>Creates a requisition in Coupa with its status as Pending Approval or Pending Buyer Action.</td>
</tr>
<tr>
<td></td>
<td>Get Requisition Fields</td>
<td>Retrieves the list of fields in the Coupa Requisitions table.</td>
</tr>
<tr>
<td></td>
<td>Note:</td>
<td>This is a metadata action and doesn't make an API call to Coupa.</td>
</tr>
<tr>
<td></td>
<td>Look Up Requisition</td>
<td>Looks up the required requisition in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Look Up Requisitions</td>
<td>Looks up the required requisitions in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Update Requisition</td>
<td>Updates the details of the required requisition in Coupa.</td>
</tr>
<tr>
<td>Supplier Management</td>
<td>Look Up Supplier</td>
<td>Looks up the required supplier in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Look Up Supplier Items By Item ID</td>
<td>Looks up the required supplier in Coupa using the item ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Suppliers</td>
<td>Looks up for a list of suppliers in Coupa using the query.</td>
</tr>
<tr>
<td>User Management</td>
<td>Look Up User</td>
<td>Looks up the required user in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Look Up Users</td>
<td>Looks up the required users in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Reset User Password</td>
<td>Resets password of the required user in Coupa.</td>
</tr>
</tbody>
</table>
tight Note: Remote tables are created when the Coupa spoke is activated. Users are cautioned against directly modifying schema or inserting data in these tables.

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up Coupa spoke
Integrate the ServiceNow instance and your Coupa account using an API key to authenticate ServiceNow requests.

Before you begin
• Request IntegrationHub subscription
• Activate the Coupa spoke
• Configure the system properties:
  ◦ com.glide.transform.json.max-partial-length: Type as integer and Value as 16384000
  ◦ glide.pf.rest.response_payload_max_size: Type as integer and Value as 100000000
• Role required: admin

Create Credential records for the Coupa spoke
Create Credential records to the Coupa application you created. The Coupa spoke connection and credential alias uses these credentials to authorize actions.

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?.
3. Select API Key Credentials.
   A blank API Key Credentials form displays.
4. Enter these values.
### Create Connection records for the Coupa spoke

Create a Connection record to the Coupa API. The Coupa spoke connection and credential alias uses these connections to perform actions in Coupa.

**Procedure**

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open for the record for **Coupa**.
3. From the **Connections** tab, click **New**. The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter <strong>Coupa Connection</strong>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Coupa. For example, select <strong>Coupa Credentials</strong>.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Coupa organization URL. For example, <strong>https://&lt;instance-name&gt;.coupacloud.com</strong>.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

---

**Docker spoke v1.0.3**

Lookup Docker data from your ServiceNow instance. Automate changes in the Docker engine when an event occurs in ServiceNow.
Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.

⚠️ Note: This spoke is available to new customers as part of an IntegrationHub Professional subscription. Existing customers can use this spoke as part of an IntegrationHub Standard subscription.

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

⚠️ Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported versions

Community Edition version 18.09.0.

Spoke actions

The Docker spoke provides actions to automate Docker tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Images Management</td>
<td>Create An Image</td>
<td>Creates an image in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>List Images</td>
<td>Lists images from the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Remove An Image</td>
<td>Removes an image from the Docker instance.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Search Images</td>
<td></td>
<td>Searches for images on Docker Hub.</td>
</tr>
<tr>
<td>Services Management</td>
<td>Create A Service</td>
<td>Creates a service in the Docker instance. Services are tasks run on a swarm.</td>
</tr>
<tr>
<td></td>
<td>Delete A Service</td>
<td>Deletes a service from the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Inspect A Service</td>
<td>Returns detailed information about a service in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Update A Service</td>
<td>Updates a service to the swarm on the docker instance.</td>
</tr>
<tr>
<td></td>
<td>List Services</td>
<td>Returns a list of services from the Docker instance.</td>
</tr>
<tr>
<td>Containers Management</td>
<td>Create A Container</td>
<td>Creates a container in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Inspect A Container</td>
<td>Inspects a container in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Kill A Container</td>
<td>Kills a container in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>List Containers</td>
<td>Lists containers in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Pause A Container</td>
<td>Suspends all processes in a container on the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Remove A Container</td>
<td>Removes a container from the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Rename A Container</td>
<td>Renames a container in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Restart A Container</td>
<td>Restarts a container in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Start A Container</td>
<td>Starts a container in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Stop A Container</td>
<td>Stop a container in the Docker instance.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Unpause A Container</td>
<td>Unpauses a container in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Update A Container</td>
<td>Updates a container in the Docker instance with the provided values.</td>
</tr>
<tr>
<td></td>
<td>Wait for A Container</td>
<td>Blocks all processes until a container stops, then returns the exit code for the container on the Docker instance.</td>
</tr>
<tr>
<td>Executions Management</td>
<td>Create An Exec Instance</td>
<td>Creates an exec instance in Docker, through which you can run a new command in a running container. To execute a command in a container, create and start an exec instance.</td>
</tr>
<tr>
<td></td>
<td>Inspect An Exec Instance</td>
<td>Inspects an exec instance in Docker.</td>
</tr>
<tr>
<td></td>
<td>Start An Exec Instance</td>
<td>Starts an exec instance in Docker, through which you can run a new command in a running container.</td>
</tr>
<tr>
<td>Networks Management</td>
<td>Create A Network</td>
<td>Creates a network on the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Inspect A Network</td>
<td>Returns detailed information about a network in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>List Networks</td>
<td>Returns a list of networks from the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Remove A Network</td>
<td>Removes a network from the Docker instance.</td>
</tr>
<tr>
<td>Volumes Management</td>
<td>Create A Volume</td>
<td>Creates a volume in Docker.</td>
</tr>
<tr>
<td></td>
<td>Inspect A Volume</td>
<td>Returns detailed information about a volume in Docker.</td>
</tr>
<tr>
<td></td>
<td>List Volumes</td>
<td>Returns a list of volumes from Docker.</td>
</tr>
<tr>
<td></td>
<td>Remove A Volume</td>
<td>Removes a volume from the Docker instance.</td>
</tr>
</tbody>
</table>
### Swarm Management

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Delete A Node</td>
<td>Deletes a node from the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Initialize A New Swarm</td>
<td>Initializes a new Docker swarm. A swarm is a group of machines running Docker joined into a cluster.</td>
</tr>
<tr>
<td></td>
<td>Inspect Swarm</td>
<td>Returns detailed information about a Docker swarm.</td>
</tr>
<tr>
<td></td>
<td>Join An Existing Swarm</td>
<td>Joins a node to a swarm as a manager or worker node based on the Docker token.</td>
</tr>
<tr>
<td></td>
<td>Leave A Swarm</td>
<td>Removes a Docker instance from a swarm.</td>
</tr>
</tbody>
</table>

### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

This spoke uses the Docker alias record to authorize actions. To use the spoke connection alias, create an associated Connection record. This spoke does not require a credential record.

### MID Server requirements

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Docker alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

### Create Connection records for the Docker spoke

Create Connection records to the Docker engine. The Docker spoke connection and credential alias uses these connections to perform actions on Docker.
Before you begin

- Request IntegrationHub subscription
- Activate Docker spoke
- Role required: admin

Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for Docker.
3. From the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter Docker Connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>The IP address and port of the host machine where Docker is installed.</td>
</tr>
</tbody>
</table>

5. Click Submit.

DocuSign spoke v2.0.3

Automate the process of sending a document to an individual or list of recipients for digital signature using DocuSign. For example, automate employee onboarding and offboarding, or send non-disclosure agreements, legal agreements, and statements of work. Use ServiceNow data in document templates and enable users to upload documents for signature as needed.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.
**Spoke dependencies**
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)

⚠️ **Note:** Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

**Compatible versions**
This spoke was built for DocuSign API version v2 or v2.1, but may be compatible with later versions.

**Key features**
DocuSign spoke enables a flow designer to:

- Automate the process of sending a document from a ServiceNow attachment or DocuSign template to an individual or recipient list for digital signature.

- Discover and synchronize DocuSign accounts and templates in ServiceNow.
  - Retrieve a list of accounts and associated templates from DocuSign and then insert or update them as records in the Accounts [sn_docusign_spoke_accounts] and Templates [sn_docusign_spoke_docusign_templates] tables using the Get Accounts subflow.
  - Retrieve templates associated with a specified DocuSign account and then insert or update them as records in the Templates [sn_docusign_spoke_docusign_templates] table using the Get Templates Per Account subflow.

- Copy and customize sample flows for sending templates and on-demand document requests.

- Pause a flow until a document is signed. A scripted REST API webhook waits for the recipient to sign the document.

- Use values from a signed document in a flow.
• Attach a completed DocuSign document to a ServiceNow record for auditing purposes.
• Manage envelopes and users.

**Spoke requirements**

• DocuSign account
• DocuSign administrator credentials
• DocuSign application configured to integrate with ServiceNow
• DocuSign application details such as client ID, integrator key, secret keys, and RSA keypairs
• ServiceNow IntegrationHub subscription

>i Note: Ensure that you have activated the Flow Designer support for the Service Catalog (com.glideapp.servicecatalog.flow_designer) plugin.

See the DocuSign Developer Center documentation for instructions on creating and configuring custom applications.

**Spoke flows**

The DocuSign spoke provides sample flows to demonstrate automating DocuSign tasks. Use DocuSign spoke actions to automate any tasks desired by your organization. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send a Document for Digital Signature</td>
<td>Sends a document to DocuSign for a digital signature when a Service Catalog request is created by the Send a Document for Digital Signature item. Before using this flow, activate the Send a Document for Digital Signature catalog item.</td>
</tr>
<tr>
<td>Send employment offer to candidate using DocuSign template</td>
<td>Sends a DocuSign envelope to a user using a template. For example, use this flow to send a job offer to a candidate. Before using this flow, activate the Demonstrate Template - Send Job Offer to Candidate catalog item.</td>
</tr>
</tbody>
</table>

The DocuSign spoke adds catalog items for use with the DocuSign spoke sample flows. Before triggering a DocuSign spoke sample flow, activate these catalog items.
**Catalog item** | **Description**
--- | ---
Send a Document for Digital Signature | Sends a document for digital signature in DocuSign.
Demonstrate Template - Send Job Offer to Candidate | Sends a job offer using a DocuSign template.

**Spoke subflows**
The DocuSign spoke provides sample subflows to demonstrate automating DocuSign tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attach DocuSign Envelope To ServiceNow Record</td>
<td>Attaches all the documents in an envelope to a ServiceNow record.</td>
</tr>
<tr>
<td>Get &amp; Set DocuSign Field Data</td>
<td>Processes a list of catalog item variables and updates a draft envelope with each variable value.</td>
</tr>
<tr>
<td>Create User</td>
<td>Creates a user including the permission profile and group memberships.</td>
</tr>
<tr>
<td>Update User</td>
<td>Updates a user including the permission profile and group memberships.</td>
</tr>
</tbody>
</table>

**Spoke actions**
The DocuSign spoke provides actions to automate DocuSign tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Management</td>
<td>Get Accounts</td>
<td>Retrieves accounts associated with the spoke Connection and Credential alias record.</td>
</tr>
<tr>
<td></td>
<td>Get Role ID</td>
<td>Retrieves the roles ID for the specified role name.</td>
</tr>
<tr>
<td>Document Signature</td>
<td>Get Embedded Signing URL</td>
<td>Creates a signing URL that is embedded into an application. User can sign the document without leaving the application.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Note: Signing URL is active for 300 seconds and can be sent to one recipient at a time.</td>
<td></td>
</tr>
<tr>
<td>Document Management</td>
<td>Get Embedded Signing URL Inline</td>
<td>Retrieves a URL which enables you to embed the recipient view of the on DocuSign.</td>
</tr>
<tr>
<td>Add Document to Envelope</td>
<td>Add Document to Envelope</td>
<td>Adds documents to envelope.</td>
</tr>
<tr>
<td>Attach Combined Document To ServiceNow Record</td>
<td>Attach DocuSign Document to Record</td>
<td>Attaches DocuSign documents to a ServiceNow record.</td>
</tr>
<tr>
<td>Get Document ID by Name</td>
<td>Get Document ID by Name</td>
<td>Retrieves the document ID from an envelope using the specified document name.</td>
</tr>
<tr>
<td>Get Documents In An Envelope</td>
<td>Get Documents In An Envelope</td>
<td>Returns a list of documents with an ID and name in the given DocuSign envelope.</td>
</tr>
<tr>
<td>Replace Document In Envelope</td>
<td>Replace Document In Envelope</td>
<td>Replaces documents to envelope.</td>
</tr>
<tr>
<td>Envelope Management</td>
<td>Attach DocuSign Certificate To ServiceNow Record</td>
<td>Attaches a DocuSign certificate to a ServiceNow record.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Add Recipient to Envelope</td>
<td>Adds the specified recipient to the specified envelope.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Recipient ID used in this action is associated with the envelope and is different from the Recipient ID used in the Get All Template Fields action.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Administrator enters a numeric value for this Recipient ID.</td>
</tr>
<tr>
<td></td>
<td>Create Draft Envelope from Template</td>
<td>Creates a draft envelope from an existing DocuSign template.</td>
</tr>
<tr>
<td></td>
<td>Get Field ID</td>
<td>Retrieves the ID of the specified field from the specified draft envelope.</td>
</tr>
<tr>
<td></td>
<td>Get Field Value</td>
<td>Retrieves the value of the specified field from the specified envelope.</td>
</tr>
<tr>
<td></td>
<td>Get Recipient ID by Role Name</td>
<td>Retrieves the recipient ID of the specified role name from the specified envelope.</td>
</tr>
<tr>
<td></td>
<td>Get Recipients In An Envelope</td>
<td>Returns a list of recipients with a Recipient ID and Role Name in the given DocuSign envelope.</td>
</tr>
<tr>
<td></td>
<td>Remove Recipient From Envelope</td>
<td>Deletes a recipient from a DocuSign envelope.</td>
</tr>
<tr>
<td></td>
<td>Send Adhoc Signature Request to User</td>
<td>Sends a DocuSign document associated with the specified ServiceNow record to the specified recipient for signature.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Send Adhoc Signature Request to Users</td>
<td>Sends a DocuSign document associated with the specified ServiceNow record to the specified multiple recipients for signatures at a time. <strong>Note:</strong> When the Use Sequential Signing option is enabled, the DocuSign document is sent to multiple recipients in a sequential order. The Use Sequential Signing option controls the order in which the recipients receive and sign the documents.</td>
</tr>
<tr>
<td></td>
<td>Send Adhoc Signature Request To Users - Inline</td>
<td>Sends the uploaded document from a ServiceNow record to multiple recipients.</td>
</tr>
<tr>
<td></td>
<td>Send Envelope</td>
<td>Sends an envelope to the specified recipients. <strong>Note:</strong> All recipient details must be provided before sending an envelope.</td>
</tr>
<tr>
<td></td>
<td>Set Field Value</td>
<td>Sets the value of the specified field in the specified draft envelope.</td>
</tr>
<tr>
<td></td>
<td>Set Field Values</td>
<td>Assigns the values of multiple fields associated to a document in a draft envelope.</td>
</tr>
<tr>
<td></td>
<td>Wait for Signature from DocuSign</td>
<td>Pauses a flow until the specified document has been signed or rejected. Returns the status of the document to the flow for further processing.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get List Of Documents</td>
<td>Gets the list of all DocuSign documents in an envelope.</td>
</tr>
<tr>
<td></td>
<td>Get Group List (Metadata)</td>
<td>Retrieves metadata for a group list.</td>
</tr>
<tr>
<td></td>
<td>Get Roles</td>
<td>Retrieves a list of roles.</td>
</tr>
<tr>
<td></td>
<td>Get Roles (Metadata)</td>
<td>Retrieves metadata for a list of roles.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Group Management</td>
<td>Add User To Group</td>
<td>Adds user from a group.</td>
</tr>
<tr>
<td></td>
<td>Get Group ID</td>
<td>Retrieves a group ID for the specified role name.</td>
</tr>
<tr>
<td></td>
<td>Remove User From Group</td>
<td>Removes the specified user from a group.</td>
</tr>
<tr>
<td>Template Management</td>
<td>Get Templates Per Account</td>
<td>Retrieves the templates associated with the specified DocuSign account.</td>
</tr>
<tr>
<td></td>
<td>Get Template Fields</td>
<td>Retrieves all fields in a template that is defined for a recipient.</td>
</tr>
<tr>
<td></td>
<td>Get Template Recipients</td>
<td>Retrieves all recipients defined for a template.</td>
</tr>
<tr>
<td>User Management</td>
<td>Create User</td>
<td>Creates a DocuSign user with the specified user details.</td>
</tr>
<tr>
<td></td>
<td>Get User Detail</td>
<td>Retrieves details for a user.</td>
</tr>
<tr>
<td></td>
<td>Update User</td>
<td>Updates the specified user.</td>
</tr>
<tr>
<td></td>
<td>Delete User</td>
<td>Deletes the specified DocuSign user.</td>
</tr>
</tbody>
</table>

**Note:**
- Recipient ID used in this action is associated with the template and is different from the Recipient ID used in the Add Recipient to Envelope action.
- Value of the Recipient ID is a unique system-generated number.

**Spoke module**

The DocuSign spoke adds a DocuSign module to your ServiceNow instance. The DocuSign spoke synchronizes and stores templates and envelopes in ServiceNow. The DocuSign spoke includes these tables and records.
<table>
<thead>
<tr>
<th>Table/Record</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Aliases</td>
<td>The DocuSign connection alias.</td>
</tr>
<tr>
<td>Scheduled Job</td>
<td>The Get Accounts &amp; Templates scheduled job that synchronizes templates and envelopes with your DocuSign account.</td>
</tr>
<tr>
<td>Accounts</td>
<td>DocuSign accounts synchronized with your ServiceNow instance. To synchronize accounts, see <a href="#">Synchronize DocuSign with ServiceNow</a>. The Get Accounts subflow retrieves a list of accounts and associated templates from DocuSign and then inserts or updates them as records in the Accounts [sn_docusign_spoke_accounts] and Templates [sn_docusign_spoke_docusign_templates] tables.</td>
</tr>
<tr>
<td>Templates</td>
<td>DocuSign templates from synchronized DocuSign accounts. The Get Templates Per Account subflow retrieves templates associated with a specified DocuSign account and then inserts or updates them as records in the Templates [sn_docusign_spoke_docusign_templates] table.</td>
</tr>
<tr>
<td>Envelopes</td>
<td>DocuSign envelopes from synchronized DocuSign accounts. Records in the Envelopes table are updated only when webhook is configured for the DocuSign account.</td>
</tr>
</tbody>
</table>

The DocuSign spoke tables include these fields.

<table>
<thead>
<tr>
<th>Table</th>
<th>Fields</th>
</tr>
</thead>
</table>
| Accounts [sn_docusign_spoke_accounts] | • Account ID  
• Account Name  
• Description  
• Email  
• Alias  
• Display Name |
### Table

<table>
<thead>
<tr>
<th>Templates [sn_docsign_spoke_docsign_templates]</th>
<th>Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Account</td>
<td></td>
</tr>
<tr>
<td>• Template ID</td>
<td></td>
</tr>
<tr>
<td>• Name</td>
<td></td>
</tr>
<tr>
<td>• Description</td>
<td></td>
</tr>
<tr>
<td>• Last Modified</td>
<td></td>
</tr>
<tr>
<td>• Display Name</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Envelopes [sn_docsign_spoke_envelopes]</th>
<th>Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Account</td>
<td></td>
</tr>
<tr>
<td>• ID</td>
<td></td>
</tr>
<tr>
<td>• Status</td>
<td></td>
</tr>
<tr>
<td>• Signed Date</td>
<td></td>
</tr>
<tr>
<td>• Declined Reason</td>
<td></td>
</tr>
<tr>
<td>• Display name</td>
<td></td>
</tr>
<tr>
<td>• Embedded Signing</td>
<td></td>
</tr>
<tr>
<td>• Signed Date Time Zone</td>
<td></td>
</tr>
<tr>
<td>• Template</td>
<td></td>
</tr>
</tbody>
</table>

**DocuSign account requirements**

The DocuSign spoke requires configuring your DocuSign account to generate an OAuth 2.0 JWT Bearer Grant token.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

This spoke uses the DocuSign Connection & Credential Alias record to authorize actions.

**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the DocuSign alias to configure where...
actions run as well as set MID Server selection attributes. For more information, see MID server.

Create connection aliases for additional DocuSign accounts

If your DocuSign implementation includes multiple DocuSign accounts, create a connection alias for each account.

Before you begin
Role required: admin

About this task
Your company may have a DocuSign account for each department that uses DocuSign. To use multiple accounts with this spoke, create an alias for each account. At runtime, the system identifies the alias associated with the account and sends the correct connection and credential information in the request. If your company only has one account, you can use the default DocuSign alias provided with the spoke and proceed to Set up DocuSign spoke.

Procedure
1. Navigate to DocuSign > Connection Aliases.
2. Select New.
3. In the Name field, add a descriptive name for the account. For example, DocuSign HR account.
4. Save the record.

What to do next
Set up DocuSign spoke for each connection alias in your DocuSign implementation.

Set up DocuSign spoke
Integrate your DocuSign account with your ServiceNow instance. Create a custom OAuth application in DocuSign and authenticate requests from ServiceNow.

Before you begin
Role required: admin
- Request IntegrationHub subscription
- Activate DocuSign spoke
Configure DocuSign account
Create a custom OAuth application from your DocuSign account to enable OAuth 2.0 authentication with the DocuSign spoke.

Before you begin
DocuSign requirements:
• DocuSign account
• DocuSign administrator credentials
• DocuSign app configured to integrate with ServiceNow

About this task
Complete these steps from your DocuSign account. See the DocuSign Developer Center documentation for instructions on creating and configuring custom applications. DocuSign uses a scripted webhook to send signed document data to x. This enables flow designers to pause a flow until a document is signed, and use document data in the flow.

Procedure
1. From your DocuSign account, register your application.
   
   Note: Ensure that you select the Authorization Code Grant option for User Application.

2. Generate an integrator key.

3. Generate a secret key.

4. Record the integrator key and secret key to register the app as a third-party OAuth provider on your x instance.

5. Click ADD RSA KEYPAIR and record the Keypair ID, Public Key, and Private Key.

6. In Redirect URIs, add your xs instance URL in this format: https://{instance-name}.service-now.com/api/sn_docusign_spoke/docusign_webhook.

Generate the JKS certificate
Generate a JKS certificate for the JWT authentication of the DocuSign spoke.

Before you begin
Role required: admin
**Procedure**

1. Open the text editor for code such as, Sublime Text.
2. Create a new file.
3. Paste the Private Key you had earlier generated from your DocuSign integrator app. For more information, see [Configure DocuSign account](#).
   
   **Note:** Ensure that you include both beginning and ending of the private key.
4. Save the file with the .key extension. For example, `privatekey.key`.
5. Open terminal and navigate to the directory where you saved the file with the .key extension.
6. Create a CA signed certificate using your private key by executing the command:
   ```bash
   openssl req -new -x509 -key <file-name>.key -out <certificate-name>.pem -days 1095
   ```
   System prompts you to provide required details such as Country Name, Province Name and so on.
7. Enter the required details.
8. Create PKCS 12 file using your private key and CA signed certificate by executing the command:
   ```bash
   openssl pkcs12 -export -in <certificate-name>.pem -inkey <file-name>.key -certfile <certificate-name>.pem -out <PKCS-12-file-name>.p12
   ```
   System prompts you to provide a password.
9. Provide the export password.
10. Create the JKS file by executing this command:
    ```bash
        keytool -importkeystore -srckeystore <PKCS-12-file-name>.p12 -srcstoretype pkcs12
        -destkeystore <JKS-certificate-filename>.jks -deststoretype JKS
    ```
    System prompts you to provide a password.
11. Provide the destination and source keystore passwords.

**Attach a Java Key Store certificate to the DocuSign spoke**

Enable the JWT Bearer Grant token authentication by attaching a valid Java KeyStore (JKS) certificate to the DocuSign spoke.
Before you begin

- Ensure the availability of a valid Java KeyStore certificate
- Role required: admin

Procedure

1. Navigate to **System Definition > Certificates**.
2. Click **New**.
3. Complete the form.

### X.509 Certificate form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name to uniquely identify the record. For example, DocuSign Certificate.</td>
</tr>
<tr>
<td>Notify on expiration</td>
<td>Define users to be notified when the certificate expires.</td>
</tr>
<tr>
<td>Warn in days to expire</td>
<td>Enter the number of days to send a notification before the certificate expires.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>Type</td>
<td>Select <strong>Java Key Store</strong>.</td>
</tr>
<tr>
<td>Expires in days</td>
<td>Enter the number of days until the certificate expires.</td>
</tr>
<tr>
<td>Key store password</td>
<td>Enter a password associated with the certificate.</td>
</tr>
<tr>
<td>Short description</td>
<td>Enter a summary about the certificate.</td>
</tr>
</tbody>
</table>

4. Click the attachments icon ( ![ ] ) and attach a JKS certificate.
5. Click **Validate Stores/Certificates**.

Create a JWT signing key for the DocuSign spoke

Create a JSON Web Token (JWT) signing key to assign to your Java KeyStore certificate.
Procedure

1. Navigate to System OAuth > JWT Keys.
2. Click New.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name to uniquely identify the JWT signing key. For example, DocuSign JWT Keys.</td>
</tr>
<tr>
<td>Signing Keystore</td>
<td>Select the valid JKS certificate attached in the previous task. For example, DocuSign Certificate.</td>
</tr>
<tr>
<td>Key Id</td>
<td>Enter a key Id to identify which key is used when multiple keys are used to sign tokens.</td>
</tr>
<tr>
<td>Signing Algorithm</td>
<td>Select an algorithm to sign with the JWT key.</td>
</tr>
<tr>
<td>Signing Key Password</td>
<td>Enter a password associated with the signing key.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Create a JWT provider for the DocuSign spoke

Add a JSON Web Token (JWT) provider to your ServiceNow instance.

Procedure

1. Navigate to System OAuth > JWT Providers.
2. Click New.
3. On the JWT Provider form, fill the values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name to uniquely identify the JWT provider. For example, DocuSign JWT Provider.</td>
</tr>
<tr>
<td>Expiry Interval (sec)</td>
<td>Enter a number in seconds to set the lifespan of JWT provider tokens.</td>
</tr>
</tbody>
</table>
Select a JWT signing key. For example, DocuSign JWT Keys.

4. Right-click the form header, and click Save. The Standard Claims and Custom Claims related lists display.

5. Select the JWT provider created for the DocuSign spoke.

6. Enter values for iss, sub, and aud in the Standard Claims related list. See the DocuSign Developer Center for instructions.

7. Insert a record in the Custom Claims related list and complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Claim Name</td>
<td>scope</td>
</tr>
<tr>
<td>Claim Value Type</td>
<td>string</td>
</tr>
<tr>
<td>Claim Value</td>
<td>signature impersonation</td>
</tr>
</tbody>
</table>

8. Click Update.

Register DocuSign as OAuth Provider

Use the information generated during DocuSign account configuration to register DocuSign as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Procedure

1. Navigate to System OAuth > Application Registry.

2. Click New.
   The system displays the message What kind of OAuth application?

3. Select Connect to a third party OAuth Provider.
   The system displays a blank Application Registries form.

4. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter DocuSign OAuth.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Client ID</td>
<td>Enter the integrator key you generated during the DocuSign account configuration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the client secret you generated during the DocuSign account configuration.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select <strong>JWT Bearer</strong>.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>• For developer sandbox environment, enter <a href="https://account-d.docusign.com/oauth/auth">https://account-d.docusign.com/oauth/auth</a>.</td>
</tr>
<tr>
<td></td>
<td>• For live production system, enter <a href="https://account.docusign.com/oauth/auth">https://account.docusign.com/oauth/auth</a>.</td>
</tr>
<tr>
<td>Token URL</td>
<td>• For developer sandbox environment, enter <a href="https://account-d.docusign.com/oauth/token">https://account-d.docusign.com/oauth/token</a>.</td>
</tr>
<tr>
<td></td>
<td>• For live production system, enter <a href="https://account.docusign.com/oauth/token">https://account.docusign.com/oauth/token</a>. For more information see, Post Go-Live and User Info Endpoint Reference in the DocuSign Developer Center documentation.</td>
</tr>
</tbody>
</table>

5. Right-click the form header, and click Save.
   - The system validates the OAuth credentials and populates the **Redirect URL**.
   - The system populates **OAuth Entity Profile** with **Grant Type** as **JWT Bearer**. For example, **OAuth Entity Profile** is created with default **Name**, DocuSign OAuth default_profile.

6. Insert a record in the **OAuth Entity Scopes** related list and fill the values.

   **OAuth Entity Scopes related list fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>scope</td>
</tr>
<tr>
<td>OAuth Scope</td>
<td>signature impersonation</td>
</tr>
</tbody>
</table>

7. Copy the value from **Redirect URL**.
8. Click **Update**.
9. Login to your DocuSign account to edit the configuration of your custom DocuSign application. See the DocuSign Developer Center for instructions.


Results
The instance can request OAuth 2.0 tokens for the spoke.

Note: When an OAuth token expires, the spoke automatically regenerates a new token in most cases. If a token expires and is not regenerated, an administrator can regenerate the spoke OAuth token.

Obtain consent
Obtain explicit consent for the ServiceNow application from DocuSign.

Role required: admin

Obtain consent for individuals

1. Navigate to System OAuth > Application Registry.
2. Open the record you had created for the DocuSign spoke.
3. Insert a record in the OAuth Entity Profiles related list and fill the values.

<table>
<thead>
<tr>
<th>OAuth Entity Profiles related list fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Is default</td>
</tr>
<tr>
<td>Grant type</td>
</tr>
</tbody>
</table>

4. Click the created OAuth Entity Profile.
5. Insert a record in the OAuth Entity Scopes related list and fill the values.

<table>
<thead>
<tr>
<th>OAuth Entity Scopes related list fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>OAuth Scope</td>
</tr>
</tbody>
</table>
6. Create credential record associated with the OAuth Entity profile whose **Grant type** is **Authorization Code**.

   a. Navigate to **Connections & Credentials > Credentials**.

   b. Click **New**. The system displays the message **What type of Credentials would you like to create?**.

   c. Select **OAuth 2.0 Credentials**.

   d. Fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter <strong>DocuSign Credentials Auth Code</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Select the OAuth Entity profile you created with <strong>Grant type</strong> as <strong>Authorization Code</strong>. For example, select <strong>DocuSign OAuth default_profile_Auth_Code</strong>.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select <strong>All MID Servers</strong>.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter <strong>100</strong>.</td>
</tr>
</tbody>
</table>

   e. Save the record.

   f. Click the **Get OAuth Token** related link to generate the OAuth token.

   g. Enter your DocuSign user name and password to provide the consent.

7. Create another credential record associated with the OAuth Entity profile whose **Grant type** is **JWT Bearer**. See **Create Credential records for the DocuSign spoke** for the required information. After the credential record, click the **Get OAuth Token** related link to generate the OAuth token.

**Obtain consent for an organization administrator**

See **DocuSign Developer documentation (Admin consent for internal applications)** for instructions to obtain consent for an organization administrator.

**Create Credential records for the DocuSign spoke**

Create Credential records to the DocuSign custom OAuth application you created during DocuSign account configuration. The DocuSign spoke connection and credential alias uses these credentials to authorize actions.
Procedure

1. Navigate to Connections & Credentials > Credentials.

2. Click New.
   The system displays the message What type of Credentials would you like to create?

3. Select OAuth 2.0 Credentials.
   The pop-up window displays a blank OAuth 2.0 Credentials form.

4. Fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter DocuSign Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Select the OAuth profile you created when you registered the custom DocuSign application as an OAuth provider. For example, select DocuSign OAuth default_profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Save the record.

6. Click the Get OAuth Token related link to generate the OAuth token.

Create Connection records for the DocuSign spoke

Create Connection records to your DocuSign account. The DocuSign spoke connection and credential alias uses these connections to perform actions in DocuSign.

Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.

2. Open for the record for DocuSign.

3. From the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.

4. Enter these values.
### Field | Value required
--- | ---
Name | Enter any name to uniquely identify the connection record. For example, enter **DocuSign Connection**.
Credential | Select the Credential record you created for DocuSign. For example, select **DocuSign Credentials**.
Connection URL | • For demo environment, enter [https://demo.docusign.net](https://demo.docusign.net).
• For live production system, enter the Base URI such as na2.docusign.net or eu.docusign.net. For instructions on obtaining the base URI, see [Post Go-Live and User Info Endpoint Reference](https://developer.docusign.com/docs/EnvelopeMonitoring/PostGoLive) in the DocuSign Developer Center documentation.

5. Click **Submit**.

### What to do next
Synchronize ServiceNow with DocuSign to access DocuSign accounts, templates, and envelopes from the DocuSign spoke. See [Synchronize DocuSign with ServiceNow](https://developer.docusign.com/docs/EnvelopeMonitoring/PostGoLive).

**Configure DocuSign webhook**

Configure the webhook in your DocuSign account to enable DocuSign to send data to ServiceNow when a recipient signs a document.

**Before you begin**
Role required: admin

**Procedure**

1. Connect a custom configuration to enable your DocuSign application to share events and data with your ServiceNow instance.

2. Add your ServiceNow instance URL in this format: [https://{instance-name}.service-now.com/api/sn_docusign_spoke/docusign_webhook](https://{instance-name}.service-now.com/api/sn_docusign_spoke/docusign_webhook).

3. Include basic authorization in the header and add your x credentials.

4. Enable DocuSign to share envelope events with ServiceNow.
   - Envelope Sent
   - Envelope Delivered
   - Envelope Signed/Completed
Synchronize DocuSign with ServiceNow

Synchronize ServiceNow with DocuSign to access DocuSign accounts, templates, and envelopes from the DocuSign spoke.

Before you begin
Role required: admin
- Request IntegrationHub subscription
- Activate DocuSign spoke
- Set up DocuSign spoke

About this task
Schedule a job to synchronize DocuSign with your ServiceNow instance daily, or synchronize data as needed.

Procedure

1. **Required**: Schedule a job to synchronize DocuSign data with your ServiceNow instance.
   
   a. Navigate to DocuSign > Scheduled Job. The Get Accounts & Templates scheduled job opens.
   
   b. Select Active.

      The DocuSign spoke synchronizes accounts, templates, and envelopes daily.

2. **Required**: Synchronize DocuSign data as needed with a UI action.


   b. Click the Get Accounts related link.

   The system synchronizes all accounts linked through an OAuth Credential record and populates the Templates and Envelopes tables with DocuSign data. Use template and envelope records when constructing flows.
Activate DocuSign spoke catalog items

Trigger events in DocuSign when an item is requested in the Service Catalog. For example, the Send a Document for Digital Signature catalog item triggers a sample flow that sends a DocuSign document to a designated recipient.

Before you begin

- Request IntegrationHub subscription
- Activate DocuSign spoke
- Activate the Flow Designer support for the Service Catalog (com.glideapp.servicecatalog.flow_designer) plugin
- Role required: admin

About this task

The DocuSign spoke adds catalog items for use with the DocuSign spoke sample flows. Before triggering a DocuSign spoke sample flow, activate these catalog items.

<table>
<thead>
<tr>
<th>Catalog item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send a Document for Digital Signature</td>
<td>Sends a document for digital signature in DocuSign.</td>
</tr>
<tr>
<td>Demonstrate Template - Send Job Offer to Candidate</td>
<td>Sends a job offer using a DocuSign template.</td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to Service Catalog > Maintain Items.
2. Search for and select Send a Document for Digital Signature.
3. Click Activate.
4. Open the record, Send a Document for Digital Signature.
5. In the Process Engine tab, select Send a Document for Digital Signature for Flow.
6. Search for and select Demonstrate Template - Send Job Offer to Candidate.
7. Click Activate.
8. Open the record, Demonstrate Template - Send Job Offer to Candidate.
Results
When one of these items is requested in the Service Catalog, the associated DocuSign spoke sample flow triggers and performs actions in DocuSign.

Change the DocuSign API version
By default, the DocuSign spoke sends REST API requests to DocuSign API v2. For forward compatibility and to take advantage of DocuSign's newer API, you can update a connection attribute to send API requests to DocuSign API v2.1.

Before you begin
Role required: admin

About this task
To understand the difference between the two APIs, see the DocuSign Developer site.

Procedure
1. Navigate to DocuSign > Connection Aliases.
2. Open the connection alias that you want to update the version for. Only requests sent using this alias use the new API version. For example, if you want to update the API version for all requests and your implementation uses multiple connection aliases, you must update each connection alias.
3. In the Connection Attributes related list, add or edit the API Version record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>String</td>
</tr>
<tr>
<td>Label</td>
<td>API Version</td>
</tr>
<tr>
<td>Column name</td>
<td>api_version</td>
</tr>
<tr>
<td>Default value</td>
<td>v2.1</td>
</tr>
</tbody>
</table>

4. Save or submit the record.

Results
When the DocuSign spoke makes an API request, it uses the API version designated in the connection attribute Default value field.

How to automate on-demand signing requests
Send DocuSign on-demand signing requests using information in your ServiceNow instance by creating flows in Flow Designer.
Before you begin
Role required: admin
- Request IntegrationHub subscription
- Activate DocuSign spoke
- Set up DocuSign spoke

About this task
cci Note: Customize flows in Flow Designer based on your requirements.

Procedure
1. In Flow Designer, create a flow.
2. Specify TRIGGER to initiate the flow.
3. Specify the ACTIONS to be performed during the flow. The actions include one of the following:
   - Send Adhoc Signature Request To User
   - Send Adhoc Signature Request To Users
4. Optional: To pause the flow until the specified document is signed or rejected, select the Wait for Signature from DocuSign action.
5. Perform one of the following set of actions:
   - To send an embedded signing URL, select **Use Embedded Signing**, and **Embedded Signing Recipient [User]**.
   - To send a document for signing, provide details regarding DocuSign account, PDF document, recipient, email, and envelope expiry.
   - The selected document or Embedded Signing URL is sent to the recipients for signing. While signing the document, the recipient details are auto-populated.
   - An envelope record is created in the **Envelopes** table. The Envelope status and other details are updated.

How to automate signing requests using templates
Send DocuSign signing requests using DocuSign templates and information in your ServiceNow instance by creating flows in Flow Designer. For example, Send employee offer.

Before you begin
Role required: admin
• Request IntegrationHub subscription
• Activate DocuSign spoke
• Set up DocuSign spoke

About this task

Note: Customize flows based on your requirements.

Procedure

1. In DocuSign, create document templates and specify recipient roles. For example, Candidate and Manager. The system retrieves other recipient details such as name and email, when the flow is triggered.

2. In Flow Designer, create a new flow.

3. Specify TRIGGER to initiate the flow.

4. Specify the ACTIONS to be performed during the flow and provide recipient details. The actions include:
   • Create Draft Envelope from Template
   • Get Recipient ID by Role Name
   • Add Recipient to Envelope
   • Get Recipient ID by Role Name
   • Add Recipient to Envelope
   • Get Field ID
   • Set Field Value
   • Send Envelope
   • Get Field Value

5. Optional: To pause the flow until the specified document is signed or rejected, select the Wait for Signature from DocuSign action.
   • The selected document or Embedded Signing URL is sent to the recipients for signing. While signing the document, the recipient details are auto-populated.
   • An envelope record is created in the Envelopes table. The Envelope status and other details are updated.

How to separate DocuSign account data

Restrict access to DocuSign data based on a user's role. For example, your company may have one DocuSign account used by the HR team and another used by the Legal team. To keep the data separate between these two
accounts, you can create a role for each account and add it to the accounts record.

Before you begin
• Request IntegrationHub subscription
• Activate DocuSign spoke
• Create connection aliases for additional DocuSign accounts
• Set up DocuSign spoke

Procedure
1. Create a role for each DocuSign account that you want to restrict access to.
   b. In the Roles [sys_user_role] table, select New.
   c. Check that the value of the Application field is DocuSign Spoke. If a different scope is listed, change the scope to DocuSign Spoke.
   d. In the Suffix field, add a name to indicate the account that the role is for. For example, Legal.
   e. Save the record.
   f. Note the name of the role you just created. For example, sn_docusign_spoke.legal.
2. Add the role to the associated account in the accounts table.
   a. Navigate to DocuSign > Accounts.
   b. Open the account record that you want to restrict access to.
   c. In the Role field, add the associated role.
   d. Click Update.
3. Grant the role to the desired users.
   b. Open the record for the user you want to provide access.
   c. Add the role you created to the Roles related list.

Results
Only users with the designated role have access to DocuSign data associated with the account.
Dropbox Business spoke v1.0.2

Use Dropbox Business as file storage in place of attachments in ServiceNow. This spoke adds Dropbox storage to your ServiceNow instance and enables users to reference Dropbox files in ServiceNow records.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

Supported versions

API version v2.

Spoke subflows

The Dropbox Business spoke provides sample subflows in the draft state to demonstrate automating Dropbox tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process File Changes</td>
<td>Subflow to process file changes in Dropbox.</td>
</tr>
<tr>
<td>Process Team Member Changes</td>
<td>Subflow to process team member changes in Dropbox.</td>
</tr>
</tbody>
</table>

Spoke actions

The Dropbox Business spoke provides actions to perform Dropbox tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File and Folder</td>
<td>Copy Dropbox File To Attachment</td>
<td>Copies a Dropbox file and attaches it to a ServiceNow record. If a ServiceNow incident record is supplied as input, the specified record is attached to it.</td>
</tr>
<tr>
<td>Management</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Copy File or Folder</td>
<td>Creates a copy of the specified Dropbox file or folder in Dropbox.</td>
</tr>
<tr>
<td></td>
<td>Create Folder</td>
<td>Creates a folder at the specified path in Dropbox.</td>
</tr>
<tr>
<td></td>
<td>Delete File Or Folder</td>
<td>Deletes a file or folder at the specified path in Dropbox.</td>
</tr>
<tr>
<td></td>
<td>Get File Changes - Webhook</td>
<td>Retrieves the file changes noticed in Dropbox.</td>
</tr>
<tr>
<td></td>
<td>Look up Folder</td>
<td>Looks up the contents of a Dropbox folder and returns an object containing information about the folder</td>
</tr>
<tr>
<td></td>
<td>Update Latest Cursor</td>
<td>Updates the latest cursor value for the corresponding team in the Team Details table.</td>
</tr>
<tr>
<td></td>
<td>Upload Attachment to Dropbox</td>
<td>Copies a ServiceNow attachment to a Dropbox folder. It copies to the specified folder. To change the file name during the copy, use the optional file name.</td>
</tr>
<tr>
<td>User Management</td>
<td>Add Users To Group</td>
<td>Adds users to a specified group</td>
</tr>
<tr>
<td>User Management</td>
<td>Add Users To Team</td>
<td>Adds users to a specified team.</td>
</tr>
<tr>
<td>User Management</td>
<td>Get Admin Details</td>
<td>Retrieves details of the administrator account used to generate the access token.</td>
</tr>
<tr>
<td>User Management</td>
<td>Get Current Account</td>
<td>Retrieves information about the current account.</td>
</tr>
<tr>
<td>User Management</td>
<td>Get Team Members Info</td>
<td>Retrieves information on specified team members. Returns profile and role details.</td>
</tr>
<tr>
<td>User Management</td>
<td>Look up Groups in Team</td>
<td>Lists all the groups in the team. Output includes group IDs, number of members, group name, and the role of users who manage the group.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up Users in Group</td>
<td>Lists all the members in the specific group. Returns user profile data and role in the group.</td>
</tr>
<tr>
<td></td>
<td>Look up Users in Team</td>
<td>List all the members in the team. Returns user profile data, membership type, and role.</td>
</tr>
<tr>
<td></td>
<td>Remove User From Team</td>
<td>Removes user from a team. Options include user retains files, and access to team shares, keeps email account and unrestricted team shares, and to delete relevant data.</td>
</tr>
<tr>
<td></td>
<td>Remove Users From Group</td>
<td>Removes one or more users from an existing group.</td>
</tr>
</tbody>
</table>

**Dropbox Business account requirements**

The Dropbox Business spoke requires a custom app that you create in Dropbox Business.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Dropbox alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

**Set up Dropbox Business spoke**

Integrate a ServiceNow instance and Dropbox Business spoke by using Dropbox credentials to authenticate ServiceNow requests.
Before you begin

- Request IntegrationHub subscription.
- Activate the Dropbox Business spoke.
- Role required: admin

Setting up the Dropbox Business spoke includes actions in the Dropbox app console, in the Now Platform® user interface, and in the Flow Designer. Setup is easier if you keep each of these pages open in separate tabs.

Configure Dropbox Business applications

Create two custom OAuth applications from your Dropbox Professional account to enable OAuth 2.0 authentication with the Dropbox Business spoke.

Before you begin

Dropbox Business integration requirements:

- A Dropbox Business account and team admin credentials.

About this task

In this task, you create two apps using the Dropbox Business API (not the normal Dropbox API). The first is for Team member file access and the other is for Team member management. Complete these steps from your Dropbox Business account. See the Dropbox Business product documentation for instructions on creating and configuring custom applications.

Procedure

2. Click Create app.
3. Choose Dropbox Business API.
4. Under Choose the type of access you need, select Team member file access.
5. Name the app and click Create app.
6. On the next screen, you see the App key and App secret. Show the App secret and copy both values. You use these values to connect Dropbox Business to ServiceNow.
7. Enter the redirect URI. The form of the redirect URI is https://<your-instance>.service-now.com/oauth_redirect.do.
8. Go back to the Create app screen and create a **Team member Management** app following the same steps. Make sure to note which App key and App secret belong to each application.

**What to do next**

Create Connection and Credential records for the Dropbox Business Team Management alias

**Create Connection and Credential records for the Dropbox Business Team Management alias**

Create connection records to a Dropbox Business account. A connection alias resolves your Dropbox connection and credential at runtime. Only one connection is active per Connection Alias at a time.

**Before you begin**

The Dropbox Business spoke comes with three Connection and Credential aliases. Configure them in the following order:

1. DropboxBusinessTeamManagement
2. DropboxBusinessFileAccess
3. DropboxBusinessContent

You configure each alias with an App key and App secret that you generated in the Dropbox app console.

When you configure the DropboxBusinessTeamManagement alias, you navigate to the Flow Designer to get the team_member_id.

**Procedure**

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Select the DropboxBusinessTeamManagement alias.
3. Click the **Create New Connection and Credential** related link.
4. In the Create Connection and Credential pop-up, provide the following information. Some of the information displays automatically.

<table>
<thead>
<tr>
<th>Section</th>
<th>Information</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Name</td>
<td>Name</td>
<td>A relevant connection name such as <strong>Dropbox Business Team Management Connection</strong>.</td>
</tr>
<tr>
<td>Section</td>
<td>Information</td>
<td>Input</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Connection URL</td>
<td></td>
<td><a href="https://api.dropboxapi.com">https://api.dropboxapi.com</a></td>
</tr>
<tr>
<td>API Version</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>Credential Information</td>
<td>Credential Name</td>
<td>Enter a relevant connection name such as Dropbox Business Team Management Credential.</td>
</tr>
<tr>
<td></td>
<td>OAuth Entity Name</td>
<td>A relevant entity name such as Dropbox Business Team Management OAuth.</td>
</tr>
<tr>
<td></td>
<td>OAuth Client ID</td>
<td>Enter the App key generated when you created the Team Member Management application in the Dropbox app console.</td>
</tr>
<tr>
<td></td>
<td>OAuth Client Secret</td>
<td>Enter the App secret generated when you created the Team Member Management application in the Dropbox app console.</td>
</tr>
<tr>
<td></td>
<td>OAuth Redirect URL</td>
<td>Enter the redirect URI. The form of the redirect URI is https://&lt;your-instance&gt;.service-now.com/oauth_redirect.do.</td>
</tr>
</tbody>
</table>

5. Click **Create and Get OAuth Token**.

6. Once you successfully acquire the OAuth token, get the team member ID for the connection.

   a. Navigate to **Flow Designer > Designer** and select **Actions**.
   
   b. Open the Get Admin Details action for the Dropbox Business spoke.
   
   c. In the Action Outline screen, click **Test**. After the test executes, click the link to view the result.
   
   d. On the **Execution Details** tab, click the link in the **Runtime Value** column to view the output of the action.
   
   e. Copy the value for `team_member_id` from the Viewing admin_details pop-up to a text file. You add this value to all three credential alias configurations.


8. On the Connections tab, select the **Dropbox Business File Access Connection**.

9. On the **Attributes** tab, paste the value of the `team_member_id` in the **Member ID** box and click **Update**.
What to do next
Create Connection and Credential records for the Dropbox Business File Access alias

Create Connection and Credential records for the Dropbox Business File Access alias

Create connection records to a Dropbox Business account for the DropboxBusinessFileAccess alias. Connection aliases resolve your Dropbox connection and credential at runtime. Only one connection is active per Connection Alias at a time.

Before you begin
The Dropbox Business spoke comes with three Connection and Credential aliases. You have already configured the Team Management alias.

You configure each one with an App Key and App Secret that you generated in the Dropbox app console.

Procedure
1. Navigate to Connections & Credentials > Connection & Credential Aliases.
3. Click the Create New Connection and Credential related link.
4. In the Create Connection and Credential pop-up, provide the following information. Some of the information displays automatically.

<table>
<thead>
<tr>
<th>Section</th>
<th>Information</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Information</td>
<td>Connection Name</td>
<td>A relevant connection name such as Dropbox Business File Access Connection.</td>
</tr>
<tr>
<td></td>
<td>Connection URL</td>
<td><a href="https://api.dropboxapi.com">https://api.dropboxapi.com</a></td>
</tr>
<tr>
<td></td>
<td>API Version</td>
<td>2</td>
</tr>
<tr>
<td>Credential Information</td>
<td>Credential Name</td>
<td>Enter a relevant connection name such as Dropbox Business File Access Credential.</td>
</tr>
<tr>
<td></td>
<td>OAuth Entity Name</td>
<td>A relevant entity name such as Dropbox Business File Access OAuth.</td>
</tr>
<tr>
<td>Section</td>
<td>Information</td>
<td>Input</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>OAuth Client ID</td>
<td>Enter the App key generated when you created the Team Member File Access application in the Dropbox app console.</td>
<td></td>
</tr>
<tr>
<td>OAuth Client Secret</td>
<td>Enter the App secret generated when you created the Team Member File Access application in the Dropbox app console.</td>
<td></td>
</tr>
<tr>
<td>OAuth Redirect URL</td>
<td>Enter the <strong>redirect URI</strong>. The form of the redirect URI is <code>https://&lt;your-instance&gt;.service-now.com/oauth_redirect.do</code>.</td>
<td></td>
</tr>
</tbody>
</table>

5. Click **Create and Get OAuth Token**.


7. Paste the value of the `team_member_id` in the **Member ID** box and click **Update**. You generated the `team_member_id` when you configured the DropboxBusinessTeamManagement alias.

**What to do next**

Create Connection and Credential records for the Dropbox Business Content alias

Create Connection and Credential records for the Dropbox Business Content alias

Create connection records to a Dropbox Business account for the DropboxBusinessContent alias. Connection aliases resolve your Dropbox connection and credential at runtime. Only one connection is active per Connection Alias at a time.

**Before you begin**

The Dropbox Business spoke comes with three Connection and Credential aliases. You have already configured the Team Management and File Access aliases.

You configure each one with an App Key and App Secret that you generated in the Dropbox app console.

When you configure the DropboxBusinessContent alias, you navigate to the Flow Designer to get the `root_namespace_id`. In the Connection configuration, you paste this value into the **Folder ID** field.
Procedure

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Select the DropboxBusinessContent alias.
3. Click the **Create New Connection and Credential** related link.
4. In the Create Connection and Credential pop-up, provide the following information. Some of the information displays automatically.

<table>
<thead>
<tr>
<th>Section</th>
<th>Information</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Name</td>
<td>A relevant connection name such as Dropbox Business Content Connection.</td>
</tr>
<tr>
<td>Connection</td>
<td>URL</td>
<td><a href="https://content.dropboxapi.com">https://content.dropboxapi.com</a></td>
</tr>
<tr>
<td></td>
<td>API Version</td>
<td>2</td>
</tr>
<tr>
<td>Credential</td>
<td>Name</td>
<td>Enter a relevant connection name such as Dropbox Business Content Credential.</td>
</tr>
<tr>
<td></td>
<td>OAuth Entity Name</td>
<td>A relevant entity name such as Dropbox Business Content OAuth.</td>
</tr>
<tr>
<td></td>
<td>OAuth Client ID</td>
<td>Enter the App key generated when you created the Team Member File Access application in the Dropbox app console.</td>
</tr>
<tr>
<td></td>
<td>OAuth Client Secret</td>
<td>Enter the App secret generated when you created the Team Member File Access application in the Dropbox app console.</td>
</tr>
<tr>
<td></td>
<td>Redirect URL</td>
<td>Enter the <strong>redirect URL</strong>. The form of the redirect URI is <code>https://&lt;your-instance&gt;.service-now.com/oauth_redirect.do</code>.</td>
</tr>
</tbody>
</table>

5. Click **Create and Get OAuth Token**.
6. Once you successfully acquire the OAuth token, you acquire the root_namespace_id for the connection.
   a. In a different tab, navigate to **Flow Designer > Designer** and select **Actions**.
   b. Open the **Get Current Account** action for the Dropbox Business spoke.
   c. In the Action Outline screen, click **Test**. In the Test Action pop-up, click **Run Test**.
d. On the Execution Details tab, click the link under Runtime Value to view the output of the action.

e. Copy the value for root_namespace_id from the Account Details pop-up to a text file. You add this value to all three credential alias configurations.

7. Return to the Connection & Credential Aliases for the DropboxBusinessContent alias.

8. On the Connections tab, select the Dropbox Business Content Connection.

9. Paste the value of the root_namespace_id in the Folder ID box and click Update.

Results
The Dropbox Business spoke is set up and integrated with the ServiceNow instance.

F5 BIG-IP spoke
Manage servers and pools in the F5 BIG-IP system.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.

Note: This spoke is available to new customers as part of an IntegrationHub Professional subscription. Existing customers can use this spoke as part of an IntegrationHub Standard subscription.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.
**Supported version**
BIG-IP 13.1.0.

**Spoke flows**
The F5 BIG-IP spoke provides sample flows in the draft state to demonstrate automating F5 tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Traffic Management Using F5 Big-IP</td>
<td>Creates a virtual server, associates it to a pool, and adds pool member in the BIG-IP system from a ServiceNow Service Catalog request.</td>
</tr>
</tbody>
</table>

**Spoke subflows**
The F5 BIG-IP spoke provides sample subflows to demonstrate automating F5 tasks. Available sample subflows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F5 Server - Pool Management</td>
<td>Creates a pool in the BIG-IP system and manages it.</td>
</tr>
</tbody>
</table>

**Spoke actions**
The F5 BIG-IP spoke provides actions to automate F5 tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pool Management</td>
<td>Create Pool</td>
<td>Creates a pool in the BIG-IP system.</td>
</tr>
<tr>
<td></td>
<td>Add Pool Member</td>
<td>Creates a pool member in the BIG-IP system.</td>
</tr>
<tr>
<td></td>
<td>Check Pool</td>
<td>Checks pool health in BIG-IP system. Returns whether the pool is available, unavailable, offline, or if the status is unknown.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Delete Pool</td>
<td>Deletes a pool from the BIG-IP system.</td>
</tr>
<tr>
<td></td>
<td>Disable Pool Member</td>
<td>Disables a pool member in the BIG-IP system.</td>
</tr>
<tr>
<td></td>
<td>Enable Pool Member</td>
<td>Enables a pool member of a specified pool in the BIG-IP system.</td>
</tr>
<tr>
<td></td>
<td>Get Pool Members</td>
<td>Retrieves the list of members of a specified pool from the BIG-IP system.</td>
</tr>
<tr>
<td></td>
<td>Remove Pool Member</td>
<td>Deletes a pool member in the BIG-IP system.</td>
</tr>
<tr>
<td>Server Management</td>
<td>Add Profile to Virtual Server</td>
<td>Adds a profile to a virtual server in the BIG-IP system. Profiles enable you to control network traffic. For example, you can enable HTTP connections to the virtual server.</td>
</tr>
<tr>
<td></td>
<td>Create Virtual Server</td>
<td>Creates a virtual server in the BIG-IP system.</td>
</tr>
<tr>
<td></td>
<td>Delete Virtual Server</td>
<td>Deletes a virtual server from the BIG-IP system.</td>
</tr>
<tr>
<td></td>
<td>Update Virtual Server</td>
<td>Updates virtual server attributes in the BIG-IP system.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

This spoke uses this alias record to authorize actions.
<table>
<thead>
<tr>
<th>Connection &amp; Credential alias</th>
<th>Description</th>
<th>Connection alias requirements</th>
</tr>
</thead>
</table>
| F5_BIG_IP                    | Connection to the F5 BIG-IP system. | • Connection type: HTTP  
• Connection URL: URL of the host machine where the F5 server is installed. |

To use the spoke connection alias, create an associated Connection record and an associated Credential record.

**MID Server requirements**

These actions use REST calls, which can run on a MID Server. Use the connection record associated with the F5 BIG-IP alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

**Set up F5 BIG-IP spoke**

Integrate the ServiceNow instance and F5 using basic authentication to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription
- Activate F5 BIG-IP spoke
- Role required: admin

**Create Credential records for the F5 BIG-IP spoke**

Create Credential records to the F5 BIG-IP server. The F5 BIG-IP spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   - The system displays the message What type of Credentials would you like to create?.
3. Select Basic Auth Credentials.
   - A blank Basic Auth Credentials form displays.
4. Enter these values.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter F5 Credentials.</td>
</tr>
<tr>
<td>User name</td>
<td>Your F5 BIG-IP user name.</td>
</tr>
<tr>
<td>Password</td>
<td>Your F5 BIG-IP password.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Create Connection records for the F5 BIG-IP spoke**

Create Connection records to your F5 BIG-IP account. The F5 BIG-IP spoke connection and credential alias uses these connections to perform actions on the F5 BIG-IP server.

**Procedure**

1. Navigate to **Connections & Credentials** > **Connection & Credential Aliases**.
2. Open for the record for **F5_BIG_IP**.
3. From the **Connections** tab, click **New**.
   - The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter F5 Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for F5. For example, select <strong>F5 Credentials</strong>.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>The URL of the host machine where the F5 BIG-IP server is installed.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.
First Advantage spoke v1.5.2
Manage and track the background verifications of candidates using First Advantage from your ServiceNow instance. Manage users, accounts, candidates, invites, and orders in First Advantage from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for First Advantage API version v1.1, but may be compatible with later versions.

Spoke requirements
• First Advantage account
• API key

  Note: Contact the First Advantage team to obtain the API key.
• Account ID

  Note: Contact the First Advantage team to obtain the Account ID.

Spoke flows
The First Advantage spoke provides sample flows to demonstrate automating the First Advantage tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Advantage -</td>
<td>Initiates background check of the candidate using invite. Sends a request</td>
</tr>
<tr>
<td>Candidate Background</td>
<td>to the candidate to complete an application. For information about creating</td>
</tr>
<tr>
<td></td>
<td>a case, see Create a case in First Advantage from ServiceNow.</td>
</tr>
<tr>
<td>Flow</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Verification using Invite</td>
<td></td>
</tr>
<tr>
<td>First Advantage - Candidate Background Verification using Order</td>
<td>Initiates background check of the candidate using order. An order record is created and request to provide essential details is sent to the candidate. For information about creating a case, see Create a case in First Advantage from ServiceNow.</td>
</tr>
<tr>
<td>First Advantage - (Order As) Candidate Background Verification using Order</td>
<td>Initiates background check of the candidate using order and places order on behalf of the required user.</td>
</tr>
<tr>
<td>First Advantage - (Order As) Candidate Background Verification using Invite</td>
<td>Initiates background check of the candidate using invite and places order on behalf of the required user.</td>
</tr>
</tbody>
</table>

### Spoke subflows

The First Advantage spoke provides a sample subflow to demonstrate automating First Advantage tasks. To customize the sample subflow, copy it to a new application scope. Available sample subflow is, Get Packages. The subflow retrieves packages in First Advantage and stores the details in the Packages table.

### Spoke actions

The First Advantage spoke provides actions manage accounts, candidates, invites, orders, and users when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Management</td>
<td>Get Account Details</td>
<td>Retrieves details of the First Advantage account.</td>
</tr>
<tr>
<td></td>
<td>Get Account Packages</td>
<td>Retrieves the details of all the packages in an account.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------</td>
<td>--------------------------------------------------------------</td>
</tr>
<tr>
<td>Get Account Profiles</td>
<td>Retrieve the details of all profiles in an account.</td>
<td></td>
</tr>
<tr>
<td>Get Account Users</td>
<td>Retrieve the details of all users in an account.</td>
<td></td>
</tr>
<tr>
<td>Candidate Management</td>
<td>Create New Candidate</td>
<td>Creates a candidate profile for background verification.</td>
</tr>
<tr>
<td>Get Candidate By Candidate ID</td>
<td>Retrieve the details of the required candidate.</td>
<td></td>
</tr>
<tr>
<td>Get Documents For A Specific Candidate</td>
<td>Retrieve the documents associated with the required candidate.</td>
<td></td>
</tr>
<tr>
<td>Get Monitoring Product Details For A Specific Candidate</td>
<td>Retrieve the details of the monitoring product for the required candidate.</td>
<td></td>
</tr>
<tr>
<td>Update Candidate Details</td>
<td>Updates the details of a candidate profile.</td>
<td></td>
</tr>
<tr>
<td>Invite Management</td>
<td>Create Invite</td>
<td>Create an invite for the candidate to fill the application.</td>
</tr>
<tr>
<td>Get Invite Status By Applicant ID</td>
<td>Retrieve the latest status of the invite for the required applicant.</td>
<td></td>
</tr>
<tr>
<td>Get Invite View Link By Application ID</td>
<td>Retrieve a secure link to access the profile that the candidate must complete.</td>
<td></td>
</tr>
<tr>
<td>Order Management</td>
<td>Create Order</td>
<td>Creates a First Advantage screening order.</td>
</tr>
<tr>
<td>Get Order Report By Order ID</td>
<td>Retrieve the completed order report for the required order.</td>
<td></td>
</tr>
<tr>
<td>Get Order Status By Order ID</td>
<td>Retrieve the latest order status for the required order.</td>
<td></td>
</tr>
<tr>
<td>User Management</td>
<td>Activate User</td>
<td>Activates the required user.</td>
</tr>
<tr>
<td>Create User</td>
<td>Creates a user profile.</td>
<td></td>
</tr>
<tr>
<td>Deactivate User</td>
<td>Deactivates the required user.</td>
<td></td>
</tr>
<tr>
<td>Update User Password</td>
<td>Updates the password of the required user.</td>
<td></td>
</tr>
</tbody>
</table>
## Spoke module

The First Advantage spoke adds a First Advantage spoke module to your ServiceNow instance. The First Advantage spoke synchronizes and stores information about First Advantage cases, tasks, employee tasks, order tasks, and packages.

The First Advantage spoke includes these modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts</td>
<td>Enables you to view the details of all accounts available in First Advantage. To view the account details, you must set up the spoke and synchronise the accounts.</td>
</tr>
<tr>
<td>FADV Webhook Client Details</td>
<td>Enables you to set up First Advantage webhook by providing key for the First Advantage webhook client.</td>
</tr>
<tr>
<td>Create New First Advantage Case</td>
<td>Enables you to initiate the background check of the required candidate using invite or order from ServiceNow.</td>
</tr>
<tr>
<td>First Advantage Cases</td>
<td>Enables you to view list of all First Advantage cases created using invite and order.</td>
</tr>
<tr>
<td>Packages</td>
<td>Enables you to view the details of all packages available in First Advantage. To view the package details, you must set up the spoke and synchronise the packages.</td>
</tr>
<tr>
<td>Order Tasks</td>
<td>Enables you to view list of all First Advantage order records.</td>
</tr>
<tr>
<td>Employee Tasks</td>
<td>Enables you to view list of all First Advantage cases created using invite.</td>
</tr>
</tbody>
</table>

The First Advantage spoke includes the these tables:

- First Advantage Task [sn_fadv_spoke_first_advantage_task]
- First Advantage Employee Task [sn_fadv_spoke_first_advantage_employee_task_table]
• Packages [sn_fadv_spoke_packages]
• FADV Webhook Client Details [sn_fadv_spoke_webhook_client_details]

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Advantage Task</td>
<td>Details of all the First Advantage order records.</td>
</tr>
<tr>
<td>First Advantage Employee Task</td>
<td>Details of all the First Advantage invite records.</td>
</tr>
<tr>
<td>Packages</td>
<td>First Advantage packages that are synchronized with ServiceNow®.</td>
</tr>
<tr>
<td>FADV Webhook Client Details</td>
<td>Client details to set up the First Advantage webhook.</td>
</tr>
</tbody>
</table>

**Spoke user roles**
- First Advantage admin
- First Advantage user

Only users with the First Advantage admin role can view the **FADV Webhook Client Details** module.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

**Set up the First Advantage spoke**

Integrate the ServiceNow instance with your First Advantage account using an API key to authenticate ServiceNow requests.

**Before you begin**
- Request IntegrationHub subscription
- Activate the First Advantage spoke
- Role required: admin
Create Credential record for the First Advantage spoke

Create Credential records to the First Advantage spoke. The First Advantage spoke connection and credential alias uses these credentials to authorize actions.

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?
3. Select API Key Credentials.
   A blank API Key Credentials form displays.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter FADV Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>API Key</td>
<td>API key generated for your First Advantage instance.</td>
</tr>
<tr>
<td>Note:</td>
<td>Contact the First Advantage team to obtain the API key.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Create Connection record for the First Advantage spoke

Create a Connection record to the First Advantage API. The First Advantage spoke connection and credential alias uses these connections to perform actions in First Advantage.

Procedure
1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for First Advantage.
3. From the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter FADV Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for First Advantage. For example, select FADV Credentials.</td>
</tr>
</tbody>
</table>

5. In the **Attributes** tab, enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distribution Email</td>
<td>Distribution email of your organization.</td>
</tr>
<tr>
<td>u_version</td>
<td>v1.1</td>
</tr>
</tbody>
</table>

**Note:** If you are using any other version of First Advantage, specify the version number.

6. Click **Submit**.

7. Navigate to **Connections & Credentials > Connection & Credential Aliases**.

8. Open for the record for **First Advantage**.

9. Click the **Connection Attributes** tab.

10. Modify the default values of the connection attributes records as per your requirement.

<table>
<thead>
<tr>
<th>Connection Attributes record</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distribution Email</td>
<td>Distribution email of your organization.</td>
</tr>
<tr>
<td>Version</td>
<td>v1.1</td>
</tr>
</tbody>
</table>

**Note:** If you are using any other version of First Advantage, specify the version number.
Create First Advantage states in your ServiceNow instance

Create First Advantage states to be displayed in the State list in your ServiceNow instance.

Before you begin
Role required: admin

Create the Draft, Ready, and In Progress states
Create the Draft, Ready, and In Progress states in the Task [task] table.

Procedure
1. In the Filter navigator, enter sys_choice.list.
   The records in the Choice [sys_choice] table are displayed.
2. Click New.
3. On the form, fill these values and create three records for the Draft state.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Task [task]</td>
</tr>
<tr>
<td>Element</td>
<td>state</td>
</tr>
<tr>
<td>Label</td>
<td>Draft</td>
</tr>
<tr>
<td>Value</td>
<td>137</td>
</tr>
</tbody>
</table>

Note:
- Ensure that you provide the exact numbers in the Value field as mentioned here. The spoke flows will not be triggered if there is any change in these numbers.
- Ensure that the record is created in the Global application.

4. Click Submit.
5. Similarly, create records for the Ready and In Progress states.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Task [task]</td>
</tr>
<tr>
<td>Element</td>
<td>state</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Label</td>
<td>Ready</td>
</tr>
<tr>
<td>Value</td>
<td>173</td>
</tr>
</tbody>
</table>

Record 3 - In Progress state

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Task [task]</td>
</tr>
<tr>
<td>Element</td>
<td>state</td>
</tr>
<tr>
<td>Label</td>
<td>In Progress</td>
</tr>
<tr>
<td>Value</td>
<td>181</td>
</tr>
</tbody>
</table>

**Note:**
- Ensure that you provide the exact numbers in the Value field as mentioned here. The spoke flows will not be triggered if there is any change in these numbers.
- Ensure that the record is created in the Global application.

**Results**
The Draft, Ready, and In Progress states are created in the Task [task] table.

**Create the Complete and Cancelled states**
Create the Complete and Cancelled states in the First Advantage Task [sn_fadv_spoke_first_advantage_task] table.

**Procedure**
1. Navigate to First Advantage Spoke > Order Tasks.
2. Click New.
   - **Note:** Ensure that the record is created in the First Advantage application.
3. Right-click State and click Configure Choices.
4. Perform these steps to create the Cancelled state:
   a. Enter Cancelled in New item text.
   b. Enter 149 in Numeric value.
c. Click Add.

d. Click Save.

5. Perform these steps to create the Complete state:

a. Enter **Complete** in **New item text**.

b. Enter 127 in **Numeric value**.

   Note: Ensure that you provide the exact numbers in the **Numeric value** field as mentioned here. The spoke flows will not be triggered if there is any change in these numbers.

c. Click Add.

d. Click Save.

Results

The Complete and Cancelled states are created in the First Advantage Task [sn_fadv_spoke_first_advantage_task] table.

Create the Complete - Success and Complete - Deal Broken states

Create the Complete - Success and Complete - Deal Broken states in the First Advantage Employee Task [sn_fadv_spoke_first_advantage_employee_task_table] table.

Procedure

1. Navigate to **First Advantage Spoke > Employee Task**.

2. Click **New**.

   Note: Ensure that the record is created in the **First Advantage** application.

3. Right-click **State** and click **Configure Choices**.

4. Perform these steps to create the Cancelled state:
a. Enter **Complete - Success** in **New item text**.

b. Enter **161** in **Numeric value**.

   Note: Ensure that you provide the exact numbers in the **Numeric value** field as mentioned here. The spoke flows will not be triggered if there is any change in these numbers.

c. Click **Add**.

d. Click **Save**.

5. Perform these steps to create the Complete state:

a. Enter **Complete - Deal Broken** in **New item text**.

b. Enter **117** in **Numeric value**.

   Note: Ensure that you provide the exact numbers in the **Numeric value** field as mentioned here. The spoke flows will not be triggered if there is any change in these numbers.

c. Click **Add**.

d. Click **Save**.

Results
The Complete - Success and Complete - Deal Broken states are created in the First Advantage Employee Task [sn_fadv_spoke_first_advantage_employee_task_table] table.

Set up First Advantage webhooks
Receive invite and order event updates at your ServiceNow instance by setting up the webhooks.

Before you begin
Role required: admin

Provide key in your ServiceNow instance
Set up the First Advantage webhook by providing key for the First Advantage webhook client.
Before you begin
- Generate a secure key as per your requirement and record the value. For example, a base64 encoded key.
- Role required: admin

Procedure
1. Navigate to First Advantage Spoke > FADV Webhook Client Details.
2. Click New.
3. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record.</td>
</tr>
<tr>
<td>Authorization Key</td>
<td>Key you had generated as per your requirement.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Access API endpoints
Access the API endpoint for the invite and order events and share the required details with First Advantage to set up the webhooks.

Before you begin
Role required: admin

Procedure
1. Navigate to System Web Services > Scripted REST APIs.
2. Open the record for the First Advantage spoke. For example, First Advantage Webhook.
3. In the Resources tab:
   a. Open the record for the invite event. For example, Invite Status.
   b. Copy and record the path provided in Resource path. For example, /api/sn_fadv_spoke/fadv/invite_status.
   c. Open the record for the order event. For example, Order Status.
   d. Copy and record the path provided in Resource path. For example, /api/sn_fadv_spoke/fadv/order_status.
What to do next
Contact First Advantage to setup webhooks for your ServiceNow instance. For this, share these details with First Advantage:

• Custom header in this format: `fadvKey <authorization-key>`.

**Note:**

◦ Ensure that the custom header is in this format only. The spoke flows will not be triggered if there is any change.

◦ Provide the same key you had earlier provided in First Advantage Spoke > FADV Webhook Client Details.

◦ Use the same case as mentioned here: `fadvKey`.

• API endpoint for the invite events in this format: `<ServiceNow-instance-URL>/api/sn_fadv_spoke/fadv/invite_status`

• API endpoint for the order events in this format: `<ServiceNow-instance-URL>/api/sn_fadv_spoke/fadv/order_status`

Synchronise First Advantage accounts and packages with ServiceNow
Store the details of the First Advantage accounts and packages by synchronizing First Advantage accounts and packages with ServiceNow.

Before you begin
Role required: First Advantage admin

Procedure
1. Navigate to First Advantage Spoke > Accounts.
2. Click New.
3. On the form, fill in the values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Account</td>
<td>Option to specify that the account is a primary account. Select the check box.</td>
</tr>
<tr>
<td>Account ID</td>
<td>ID of the primary account.</td>
</tr>
<tr>
<td>Account Name</td>
<td>Name of the primary account.</td>
</tr>
</tbody>
</table>

4. Click Submit.
   The primary account is created and the record is displayed.
5. Navigate to **First Advantage Spoke > Accounts**.
6. Click the **Get Accounts** related list.
7. Navigate to **First Advantage Spoke > Packages**.
8. Click the **Get Packages** related link.

### Results

The First Advantage account and package details are retrieved.

ℹ️ **Note:** Only users with the FADV admin role can synchronize the account and package details. Users with FADV user role can only view the retrieved details.

### Create a case in First Advantage from ServiceNow

Initiate the background check of the required candidate using invite or order from ServiceNow.

### Before you begin

- Set up the First Advantage spoke
- Synchronise First Advantage accounts and packages with ServiceNow
- Create users in the User [sys_user] table. Background check can be performed only for these users.
- Role required: First Advantage admin or First Advantage user

### Procedure

1. Navigate to **First Advantage Spoke > Create New First Advantage Case**. Form to provide the First Advantage case details is displayed.
2. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Distribution Email for getting invite email from First Advantage</td>
<td>Option to send invitation email to all users in the distribution email.</td>
</tr>
<tr>
<td>Select User</td>
<td>User in the User [sys_user] table.</td>
</tr>
<tr>
<td>First Name</td>
<td>First name of the selected user. The value is auto-populated based on the user selected in <strong>Select User</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Last Name</td>
<td>Last name of the selected user. The value is auto-populated based on the user selected in <strong>Select User</strong>.</td>
</tr>
<tr>
<td>Email</td>
<td>Email address of the selected user. The value is auto-populated based on the user selected in <strong>Select User</strong>.</td>
</tr>
<tr>
<td>Select An Account</td>
<td>First Advantage account to perform the background check.</td>
</tr>
<tr>
<td>Select A Package</td>
<td>First Advantage package to perform the background check.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Brief description about the background check.</td>
</tr>
<tr>
<td>Agent Name</td>
<td>Agent to perform the background check.</td>
</tr>
<tr>
<td>Send Invite link</td>
<td>Option to send an invite email. When selected, a request to complete an application is sent to the candidate through an invite email. If this option isn’t selected, an order email is sent to the user. An order record is created and request to provide essential details is sent to the candidate.</td>
</tr>
<tr>
<td>Note:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• When the <strong>Send Invite link</strong> option is selected, an order is created only after the candidate has filled the application form.</td>
</tr>
<tr>
<td></td>
<td>• When the <strong>Send Invite link</strong> option isn’t selected, an order is immediately created.</td>
</tr>
<tr>
<td>Events updates</td>
<td>Can be accessed in your ServiceNow instance.</td>
</tr>
<tr>
<td>Use &quot;Order As&quot;</td>
<td>Option to place order on behalf of the required user.</td>
</tr>
<tr>
<td>Email (Order As)</td>
<td>Email ID of the required user. This field is available only when the <strong>Use &quot;Order As&quot;</strong> check box is selected.</td>
</tr>
<tr>
<td>Account ID (Order As)</td>
<td>Account ID of the required user. This field is available only when the <strong>Use &quot;Order As&quot;</strong> check box is selected.</td>
</tr>
<tr>
<td>User ID (Order As)</td>
<td>User ID of the required user. This field is available only when the <strong>Use &quot;Order As&quot;</strong> check box is selected.</td>
</tr>
</tbody>
</table>
3. Click Submit.
   A First Advantage task is created in your ServiceNow instance with State as Draft. The case can be accessed by navigating to First Advantage Spoke > First Advantage Cases.

Initiate background verification in First Advantage from ServiceNow using invite

Initiate background verification of the required candidate by sending a request to complete an application through an invite email.

Before you begin
• Create a case in First Advantage from ServiceNow
  
  Note: Ensure that the Send Invite link option is selected and the Use "Order As" option isn't selected.
• Role required: First Advantage admin or First Advantage user

Procedure
1. Navigate to First Advantage Spoke > First Advantage Cases.
2. Search for the required task.
3. Ensure that the Send Invite link option is selected and the Use "Order As" option isn't selected.
4. Change the State of the task from Draft to Ready.
   • The First Advantage - Candidate Background Verification using Invite flow is triggered.
   • State is changed to In Progress.
   • In the Employee Tasks tab, a record is created and its details such as Number, Invite ID and so on, are populated. Open the record to access details such as Invite URL, Candidate ID, and so on. Also, real-time updates are displayed here.

  Note: The Employee Tasks tab displays all the invite records created for the user.

   • In the Order History tab, a record is created and its details such as Number, Short Description and so on, are populated.

  Note: The Order History tab displays all the order records created for the user.

   • Real-time updates and System Administrator events are displayed in the Order Details tab.
Note: Order ID is populated only after the invite is executed successfully. For example, Order ID isn't populated if the candidate has declined to complete the application form.

- An invite email is sent to the candidate.

Results
After accessing the invite email, candidate can either complete the application form or decline. If candidate fills and submits the application form, First Advantage approves, cancels, or rejects the task after performing the background verification.

- The status and all other details can be accessed in real-time by navigating to First Advantage Spoke > Employee Tasks.
- Guest events are displayed in the respective First Advantage Employee Task record.

Note:
- You must set up the webhooks to receive the guest event updates. See Set up First Advantage webhooks for information on setting up the webhooks.
- If the candidate has declined the request for background verification, the Order record isn't created for the task.

Initiate background verification in First Advantage from ServiceNow using order
Initiate background verification of the required candidate by sending an email requesting for the essential information.

Before you begin
- Create a case in First Advantage from ServiceNow

Note: Ensure that the Send Invite link and Use "Order As" options aren't selected.
- Role required: First Advantage admin or First Advantage user

About this task
An order is initiated when First Advantage has all basic information about the candidate and requires only some essential sensitive information.
Procedure
1. Navigate to First Advantage Spoke > First Advantage Cases.
2. Search for the required task.
3. Ensure that the Send Invite link and Use "Order As" options aren't selected.
4. Change the State of the task from Draft to Ready.
   • The First Advantage - Candidate Background Verification using Order flow is triggered.
   • State is changed to In Progress.
   • In the Order History tab, a record is created and its details such as Order ID, Number, Short Description and so on, are populated.
   • Real-time updates and System Administrator events are displayed in the Order Details tab.

   Note: The Order History tab displays all the order records created for the user.
   • An order email is sent to the candidate.

Results
A mail is sent to candidate requesting only the sensitive information. Real-time updates and guest events are displayed in the Order Details tab. First Advantage approves, cancels, or rejects the task after performing the background verification.

Note: You must set up the webhooks to receive the guest event updates. See Set up First Advantage webhooks for information on setting up the webhooks.

Initiate background verification in First Advantage from ServiceNow using invite on behalf of another user
Initiate background verification of the required candidate by sending a request on behalf of another user to complete an application through an invite email.

Before you begin
• Create a case in First Advantage from ServiceNow

   Note: Ensure that the Send Invite link and Use "Order As" options are selected.
   • Role required: First Advantage admin or First Advantage user
Procedure
1. Navigate to First Advantage Spoke > First Advantage Cases.
2. Search for the required task.
3. Ensure that the Send Invite link and Use "Order As" options are selected.
4. Change the State of the task from Draft to Ready.
   • The First Advantage - Candidate Background Verification using Invite flow is triggered.
   • State is changed to In Progress.
   • In the Employee Tasks tab, a record is created and its details such as Number, Invite ID and so on, are populated. Open the record to access details such as Invite URL, Candidate ID, and so on. Also, real-time updates are displayed here.

   📌 Note: The Employee Tasks tab displays all the invite records created for the user.
   • In the Order History tab, a record is created and its details such as Number, Short Description and so on, are populated.

   📌 Note: The Order History tab displays all the order records created for the user.
   • Real-time updates and System Administrator events are displayed in the Order Details tab.

   📌 Note: Order ID is populated only after the invite is executed successfully. For example, Order ID isn't populated if the candidate has declined to complete the application form.
   • An invite email is sent to the candidate.

Results
After accessing the invite email, candidate can either complete the application form or decline. If candidate fills and submits the application form, First Advantage approves, cancels, or rejects the task after performing the background verification.

   • The status and all other details can be accessed in real-time by navigating to First Advantage Spoke > Employee Tasks.
   • Guest events are displayed in the respective First Advantage Employee Task record.
Note:
• You must set up the webhooks to receive the guest event updates. See Set up First Advantage webhooks for information on setting up the webhooks.
• If the candidate has declined the request for background verification, the Order record isn't created for the task.

Initiate background verification in First Advantage from ServiceNow using order
Initiate background verification of the required candidate by sending an email requesting for the essential information on behalf of the required user.

Before you begin
• Create a case in First Advantage from ServiceNow

Note: Ensure that the Send Invite link option isn't selected and the Use "Order As" option is selected.
• Role required: First Advantage admin or First Advantage user

About this task
An order is initiated when First Advantage has all basic information about the candidate and requires only some essential sensitive information.

Procedure
1. Navigate to First Advantage Spoke > First Advantage Cases.
2. Search for the required task.
3. Ensure the Send Invite link option isn't selected and the Use "Order As" option is selected.
4. Change the State of the task from Draft to Ready.
   • The First Advantage - Candidate Background Verification using Order flow is triggered.
   • State is changed to In Progress.
   • In the Order History tab, a record is created and its details such as Order ID, Number, Short Description and so on, are populated.
   • Real-time updates and System Administrator events are displayed in the Order Details tab.
Note: The Order History tab displays all the order records created for the user.

- An order email is sent to the candidate.

Results
A mail is sent to the candidate requesting only the sensitive information. Real-time updates and guest events are displayed in the Order Details tab. First Advantage approves, cancels, or rejects the task after performing the background verification.

Note: You must set up the webhooks to receive the guest event updates. See Set up First Advantage webhooks for information on setting up the webhooks.

GitHub spoke v2.0.4
Manage distributed version control and source code in GitHub from your ServiceNow instance. Create flows in ServiceNow to manage collaborative features such as tracking bugs, feature requests, tasks and so on, for projects in GitHub. View and analyze meaningful usage data for GitHub Enterprise Cloud and GitHub Enterprise Server software subscriptions so that you can reclaim stale licenses.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.

Note: This spoke is available to new customers as part of an IntegrationHub Professional subscription. Existing customers can use this spoke as part of an IntegrationHub Standard subscription.

Supported versions
This spoke was built for GitHub API version v3, but may be compatible with later versions.
**Spoke requirements**

- GitHub account
- User with admin credentials
- Token to authenticate the ServiceNow instance

See the [GitHub documentation](#) for instructions on creating GitHub account and generating token.

**GitHub Webhooks module**

Bi-directional webhooks can be setup to be notified about the required events. Routing policy defines conditions that must be met to notify the ServiceNow app. These conditions are based on the events in GitHub for which you wish to be notified about. When the conditions are met, routing policy triggers the associated subflow, which in turn automates the GitHub tasks.

The bi-directional webhooks requires separate setup and can be used independently without using the spoke actions. By default, the GitHub Webhooks application is available in the GitHub spoke and has the following modules:

- GitHub Webhook Registries
- GitHub WebHook Routing Policies

Use the GitHub Webhook Registries module to assign a token and provide the API path. You must generate Callback URL here and provide this URL in GitHub. A default routing policy is provided in the GitHub WebHook Routing Policies module. The default routing policy supports these GitHub fields:

<table>
<thead>
<tr>
<th>Supported GitHub fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
</tr>
<tr>
<td>Base Ref</td>
</tr>
<tr>
<td>Commit Comment Body</td>
</tr>
<tr>
<td>Commit Comment Created At</td>
</tr>
<tr>
<td>Commit Comment Path</td>
</tr>
<tr>
<td>Supported GitHub fields</td>
</tr>
<tr>
<td>-------------------------------------------------------------</td>
</tr>
<tr>
<td>Commit Comment Updated At</td>
</tr>
<tr>
<td>Commit Comment User</td>
</tr>
<tr>
<td>Force Push</td>
</tr>
<tr>
<td>GitHub Instance URL</td>
</tr>
<tr>
<td>Issue Assigned To</td>
</tr>
<tr>
<td>Issue Assignees</td>
</tr>
<tr>
<td>Issue Body</td>
</tr>
<tr>
<td>Issue Closed At</td>
</tr>
<tr>
<td>Issue Comment</td>
</tr>
<tr>
<td>Issue Comment Count</td>
</tr>
<tr>
<td>Issue Comment Created At</td>
</tr>
<tr>
<td>Issue Comment Updated At</td>
</tr>
<tr>
<td>Issue Created At</td>
</tr>
<tr>
<td>Issue Labeled To</td>
</tr>
<tr>
<td>Issue Labels</td>
</tr>
<tr>
<td>Issue Locked</td>
</tr>
<tr>
<td>Issue Milestone</td>
</tr>
<tr>
<td>Issue Previous Body</td>
</tr>
<tr>
<td>Issue Previous Comment</td>
</tr>
<tr>
<td>Issue Previous Milestone</td>
</tr>
<tr>
<td>Supported GitHub fields</td>
</tr>
<tr>
<td>-------------------------</td>
</tr>
<tr>
<td>Issue Previous Title</td>
</tr>
<tr>
<td>Issue Previously Assigned To</td>
</tr>
<tr>
<td>Issue Previously Labeled To</td>
</tr>
<tr>
<td>Issue State</td>
</tr>
<tr>
<td>Issue Title</td>
</tr>
<tr>
<td>Issue Updated At</td>
</tr>
<tr>
<td>Issue User</td>
</tr>
<tr>
<td>Milestone Closed At</td>
</tr>
<tr>
<td>Milestone Created At</td>
</tr>
<tr>
<td>Milestone Creator</td>
</tr>
<tr>
<td>Milestone Description</td>
</tr>
<tr>
<td>Milestone Due On</td>
</tr>
<tr>
<td>Milestone State</td>
</tr>
<tr>
<td>Milestone Title</td>
</tr>
<tr>
<td>Milestone Updated At</td>
</tr>
<tr>
<td>Organization Description</td>
</tr>
<tr>
<td>Organization Login</td>
</tr>
</tbody>
</table>
To use other conditions in the routing policy, create routing policy in the GitHub WebHook Routing Policies module and specify conditions as per your requirement. See [Set up bi-directional webhook for the GitHub spoke](#) for information regarding setting up and configuring the webhooks.

**Spoke subflows**

The GitHub spoke provides a sample subflow to handle various GitHub webhook events. Available sample subflows are:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
<th>Supported GitHub Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process GitHub Branch and Tag Webhook Events</td>
<td>Handles branch and tag webhook events.</td>
<td>Branch and Tag</td>
</tr>
<tr>
<td>Process GitHub Commit Webhook Events</td>
<td>Handles commit webhook events.</td>
<td>Commit</td>
</tr>
<tr>
<td>Process GitHub Issue Webhook Events</td>
<td>Handles issue webhook events.</td>
<td>Issue</td>
</tr>
<tr>
<td>Process GitHub Milestone Webhook Events</td>
<td>Handles milestone webhook events.</td>
<td>Milestone</td>
</tr>
</tbody>
</table>
Spoke subflows (continued)

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
<th>Supported GitHub Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process GitHub Project Webhook Events</td>
<td>Handles project webhook events.</td>
<td>Project</td>
</tr>
<tr>
<td>Process GitHub Pull Request Webhook Events</td>
<td>Handles pull request webhook events.</td>
<td>Pull Request</td>
</tr>
<tr>
<td>Process GitHub Push Webhook Events</td>
<td>Handles push request webhook events.</td>
<td>Push Request</td>
</tr>
<tr>
<td>Process GitHub Release Webhook Events</td>
<td>Handles release webhook events.</td>
<td>Release</td>
</tr>
<tr>
<td>Process GitHub Repository Webhook Events</td>
<td>Handles repository webhook events.</td>
<td>Repository</td>
</tr>
<tr>
<td>Process GitHub Security Webhook Events</td>
<td>Handles security webhook events.</td>
<td>Security</td>
</tr>
<tr>
<td>Process GitHub Webhook Events</td>
<td>Handles all GitHub webhook events.</td>
<td>Note: This subflow handles all GitHub events. You can customize this subflow to handle other GitHub webhook events that are not supported by default.</td>
</tr>
</tbody>
</table>

To create subflows to handle other GitHub webhook events or handle the supported GitHub webhook events differently, customize the Process GitHub
Webhook Events subflow. For this, you must create a copy of the subflow, parse the payload, and customize the subflow as per your requirement. Payload is one of the inputs to the subflow.

While customizing subflows, you must ensure that the subflows are configured to avoid infinite loops.

Note:
- You must configure webhooks to use the spoke subflow. See Set up bi-directional webhook for the GitHub spoke for information regarding setting up and configuring the webhook.
- The sample subflows run as a user by default. It can be configured to run as system.
- GitHub spoke supports application/json payload. Configure the GitHub webhook accordingly. See the GitHub Developer documentation for instructions on creating and configuring a webhook.

Spoke actions
The GitHub spoke provides actions manage branches, issues, repositories, and source code when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Branch Management</td>
<td>Create Branch</td>
<td>Creates a branch in GitHub based on a specific commit SHA.</td>
</tr>
<tr>
<td></td>
<td>Delete Branch</td>
<td>Deletes a branch from the GitHub repository.</td>
</tr>
<tr>
<td></td>
<td>Get Branch</td>
<td>Retrieves the details of a branch in the GitHub repository.</td>
</tr>
<tr>
<td></td>
<td>Get Branch Protection</td>
<td>Retrieves the restriction details of the required branch.</td>
</tr>
<tr>
<td></td>
<td>List Branches</td>
<td>Retrieves the list of all branches in a repository.</td>
</tr>
<tr>
<td></td>
<td>Remove Branch Protection</td>
<td>Removes protection on the required branch.</td>
</tr>
<tr>
<td></td>
<td>Update Branch Protection</td>
<td>Updates protection on the required branch.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Issue Management</td>
<td>Create Comment on Issue</td>
<td>Creates comment on a required issue.</td>
</tr>
<tr>
<td></td>
<td>Create Issue</td>
<td>Creates issue for the required repository.</td>
</tr>
<tr>
<td></td>
<td>Delete Comment on Issue</td>
<td>Deletes comment on a required issue.</td>
</tr>
<tr>
<td></td>
<td>Lock Issue</td>
<td>Locks the required issue. This limits the conversation to collaborators only.</td>
</tr>
<tr>
<td></td>
<td>Look Up Comments on Issue</td>
<td>Retrieves the list of comments on an issue.</td>
</tr>
<tr>
<td></td>
<td>Look Up Issues</td>
<td>Retrieves the list of issues for a repository.</td>
</tr>
<tr>
<td></td>
<td>Unlock Issue</td>
<td>Unlocks the required issue. This opens conversation to all users.</td>
</tr>
<tr>
<td></td>
<td>Update Comment on Issue</td>
<td>Updates a comment on an issue.</td>
</tr>
<tr>
<td></td>
<td>Update Issue</td>
<td>Updates the details of the required issue.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get Fields by Action</td>
<td>Retrieves the list of fields for an action filter in the GitHub Fields table.</td>
</tr>
<tr>
<td>Organization Management</td>
<td>Get Organization Plan</td>
<td>Retrieves the plan name of an organization.</td>
</tr>
<tr>
<td></td>
<td>List Organization Members</td>
<td>Retrieves the list of all members within an organization.</td>
</tr>
<tr>
<td></td>
<td>List Organization Repositories</td>
<td>Retrieves the list of all repositories within an organization.</td>
</tr>
<tr>
<td></td>
<td>Remove Organization Member</td>
<td>Removes a user from an organization.</td>
</tr>
<tr>
<td>Repository Management</td>
<td>Add Collaborator</td>
<td>Adds collaborator to the required repository.</td>
</tr>
<tr>
<td></td>
<td>Create Comment on Pull Request</td>
<td>Create review comments on a pull request.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Create Milestone</td>
<td>Creates milestone for the required repository.</td>
</tr>
<tr>
<td></td>
<td>Create Pull Request</td>
<td>Creates a pull request for a repository.</td>
</tr>
<tr>
<td></td>
<td>Create Reply on Pull Request Review Comment</td>
<td>Creates reply to a review comment for a pull request.</td>
</tr>
<tr>
<td></td>
<td>Create Repository</td>
<td>Creates a repository in GitHub.</td>
</tr>
<tr>
<td></td>
<td>Delete Comment on Pull Request</td>
<td>Deletes review comment on a pull request.</td>
</tr>
<tr>
<td></td>
<td>Delete Milestone</td>
<td>Deletes milestone from the required repository.</td>
</tr>
<tr>
<td></td>
<td>List Comments on Pull Request</td>
<td>Retrieves the list of all review comments on a pull request.</td>
</tr>
<tr>
<td></td>
<td>List Milestones</td>
<td>Retrieves the list of all milestones in a repository.</td>
</tr>
<tr>
<td></td>
<td>List Repository Events</td>
<td>Retrieves the list of events across a repository.</td>
</tr>
<tr>
<td></td>
<td>Look Up Pull Requests</td>
<td>Retrieves the details of pull requests for a repository.</td>
</tr>
<tr>
<td></td>
<td>Look Up Repositories</td>
<td>Retrieves the details of repositories based on a specific user or organization.</td>
</tr>
<tr>
<td></td>
<td>Merge Pull Request</td>
<td>Merges the pull request to a repository.</td>
</tr>
<tr>
<td></td>
<td>Remove Collaborator</td>
<td>Removes collaborator from a repository.</td>
</tr>
<tr>
<td></td>
<td>Update Comment on Pull Request</td>
<td>Updates review comment provided for a pull request.</td>
</tr>
<tr>
<td></td>
<td>Update Milestone</td>
<td>Updates the details of a milestone in a repository.</td>
</tr>
<tr>
<td></td>
<td>Update Pull Request</td>
<td>Updates the details of a pull request in a repository.</td>
</tr>
</tbody>
</table>
### Source Code Management

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Update Repository</td>
<td>Updates the details of a repository in GitHub.</td>
</tr>
<tr>
<td></td>
<td>Create Comment on Commit</td>
<td>Creates comment for the required commit using its SHA.</td>
</tr>
<tr>
<td></td>
<td>Create or update a file</td>
<td>Creates a file or updates an existing file in a repository.</td>
</tr>
<tr>
<td></td>
<td>Get Comments By Commit ID</td>
<td>Retrieves comments provided for a single commit.</td>
</tr>
<tr>
<td></td>
<td>Get Commit Information By ID</td>
<td>Retrieves the contents of the required commit reference.</td>
</tr>
<tr>
<td></td>
<td>Get File Content</td>
<td>Retrieves the contents of a file in a repository.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This action supports files with file size up to 1 MB.</td>
</tr>
<tr>
<td></td>
<td>List Commits on a Repository</td>
<td>Retrieves the details of all commits made on a repository.</td>
</tr>
</tbody>
</table>

#### User Management

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Get All Users for Enterprise Server</td>
<td>Retrieves the list of all GitHub Enterprise Server users.</td>
</tr>
<tr>
<td></td>
<td>List Organizations for the Authenticated User</td>
<td>Retrieves the list of organizations that the logged in user is a member of.</td>
</tr>
<tr>
<td></td>
<td>Suspend User</td>
<td>Suspends a GitHub user account.</td>
</tr>
</tbody>
</table>

### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

### Set up GitHub spoke

Integrate the ServiceNow instance and GitHub account using an API key to authenticate ServiceNow requests.
Before you begin

- Request IntegrationHub subscription
- Activate GitHub spoke
- Generate token and record the value
- Role required: admin

Create Credential record for the GitHub spoke

Create Credential records for the GitHub spoke. The GitHub spoke connection and credential aliases use these credentials to authorize actions.

Before you begin
Role required: admin

Procedure

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?.
3. Select API Key Credentials.
   A blank API Key Credentials form displays.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter GitHub Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>API Key</td>
<td>Token generated in GitHub.</td>
</tr>
<tr>
<td></td>
<td>See the GitHub documentation for instructions on creating GitHub account and generating token.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Note: This option is not applicable to this spoke.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click Submit.
Create Connection records for the GitHub spoke

Create Connection records for your GitHub account. The GitHub spoke connection and credential aliases use these connections to perform actions in GitHub.

Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for GitHub.
3. From the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter GitHub Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for GitHub. For example, select GitHub Credentials.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Connection URL. Enter <a href="https://api.github.com/">https://api.github.com/</a>.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Set up bi-directional webhook for the GitHub spoke

Configure webhook to subscribe to GitHub with a ServiceNow callback URL.

Before you begin

- Request IntegrationHub subscription
- Activate the GitHub spoke
- Role required: admin

Create secret for the GitHub spoke

Create secret to embedded in the GitHub webhook URL.

Before you begin

Role required: admin
Procedure

1. Navigate to System Definition > Scripts - Background.
2. Enter this command in the Run script (JavaScript executed on server) text field:
   gs.info(GlideSecureRandomUtil.getSecureRandomString(16));
3. Click Run Script.
4. Copy and record the generated secret for later use.

Register GitHub webhook in ServiceNow

Register a GitHub in ServiceNow to notify the ServiceNow app when certain events occur in GitHub.

Before you begin
Role required: admin

Procedure

1. Navigate to GitHub Webhooks > GitHub Webhook Registries.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name to identify the record. For example, GitHub webhook.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the record.</td>
</tr>
<tr>
<td>Secret</td>
<td>Secret you had generated using the Scripts - Background module.</td>
</tr>
<tr>
<td>Path</td>
<td>GitHub webhook path. By default, this is set to api/space/gitevent/wh_entry</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click Save.
5. Click Callback URL.
   The system displays the Webhook Callback URL.
6. Copy and record the Webhook Callback URL.

Results

The GitHub webhook is registered in your ServiceNow instance.
Add Callback URL in GitHub
Provide Webhook Callback URL in GitHub account to create webhook.

Before you begin
Role required: admin

Procedure
1. Log in to your GitHub account.
2. Create a webhook in your Atlassian account.
3. Enter Webhook Callback URL in Payload URL and Secret in Secret. See the GitHub Developer documentation for instructions on creating and configuring a webhook.

Note: GitHub spoke supports application/json payload. Configure the GitHub webhook accordingly. See the GitHub Developer documentation for instructions on creating and configuring a webhook.

Results
The Callback URL is added in the GitHub account. You can create routing policies and subflows as per your requirement. See Customize a bi-directional webhook for information regarding creating new routing policies and subflows.

Customize bi-directional webhook in the GitHub spoke
Create webhook routing policy and subflow as per your requirement in the GitHub spoke.

Before you begin
Role required: admin

About this task
The default routing policy in the GitHub WebHook Routing Policies modules triggers the relevant GitHub subflow and notifies the ServiceNow app when certain events occur in GitHub. See GitHub spoke v2.0.4 for information about the GitHub fields that the default routing policy supports and the GitHub events that the subflows support. To use any other fields in your custom subflow and customize conditions in the routing policy, perform these steps.

Procedure
1. Navigate to Flow Designer > Designer.
2. Click Subflows.
3. Create a copy of the required subflow.
4. Customize the required subflow as per your requirement and publish it. See Subflows for more information about creating and using subflows and GitHub spoke v2.0.4 for information about the GitHub fields that the default routing policy supports and the GitHub events that the subflows support.


6. Click New.

7. On the form, fill in the fields.

### Decision form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Unique label to identify the routing policy.</td>
</tr>
</tbody>
</table>
| Default answer    | Option to specify if this is the default answer. Default answer is applicable when the conditions are not met.  
  a. Click the Lookup icon.  
  b. Select the required subflow from the Document: list.  
  
  **Note:** Ensure that the Table name is `Flow [sys_hub_flow]`. |
| Condition         | Conditions to be met when the required events occur in GitHub.  
  See GitHub spoke v2.0.4 for information about the supported fields. |
| Answer            | Subflow that has to be triggered when the specified conditions are met.     |

8. Click Submit.

**Note:** These routing policies are saved in the Decision tables. Users are cautioned against directly updating or modifying data in these tables.

**Results**
Routing policy and subflow are created.

**GitLab spoke v1.0.4**
Manage the DevOps lifecycle in GitLab from your ServiceNow instance. Create flows in ServiceNow to manage branches, groups, issues, merge requests, projects, and source code in GitLab.
Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.

Compatible versions
This spoke was built for GitLab API version v4, but may be compatible with later versions.

Spoke requirements
• GitLab account
• An application in GitLab configured to integrate with ServiceNow
• Application ID and Secret of the GitLab application

See the GitLab documentation for instructions on creating and configuring applications.

Spoke actions
The GitLab spoke provides actions to automate GitLab tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Branch Management</td>
<td>Create Branch</td>
<td>Creates a branch in the required project.</td>
</tr>
<tr>
<td>Delete Branch</td>
<td>Deletes the required branch from a project.</td>
<td></td>
</tr>
<tr>
<td>Delete Merged Branches</td>
<td>Deletes the required merged branch from a project.</td>
<td></td>
</tr>
<tr>
<td>Get Branch</td>
<td>Retrieves the details of the required branch.</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>List Branches</td>
<td>Retrieves the list of branches in a required project.</td>
</tr>
<tr>
<td></td>
<td>Protect Branch</td>
<td>Protects a branch in a project with access levels.</td>
</tr>
<tr>
<td></td>
<td>Unprotect Branch</td>
<td>Unprotects a branch in a project with access levels.</td>
</tr>
<tr>
<td></td>
<td>Add User To A Group</td>
<td>Adds user to a GitLab group.</td>
</tr>
<tr>
<td></td>
<td>Remove User From A Group</td>
<td>Removes user from a GitLab group.</td>
</tr>
<tr>
<td></td>
<td>Create Issue</td>
<td>Creates an issue in the required project.</td>
</tr>
<tr>
<td></td>
<td>Create Issue Note</td>
<td>Creates an issue note for the required issue.</td>
</tr>
<tr>
<td></td>
<td>Delete Issue Note</td>
<td>Deletes an issue note for the required issue.</td>
</tr>
<tr>
<td></td>
<td>List Issue Notes</td>
<td>Retrieves the list of all issue notes for the required issue.</td>
</tr>
<tr>
<td></td>
<td>List Issues</td>
<td>Retrieves the list of the issues based on the input criteria.</td>
</tr>
<tr>
<td></td>
<td>Update Issue</td>
<td>Updates details of the required issue.</td>
</tr>
<tr>
<td></td>
<td>Update Issue Note</td>
<td>Updates an issue note in a project.</td>
</tr>
<tr>
<td></td>
<td>Accept Merge Request</td>
<td>Approves a merge request in GitLab.</td>
</tr>
<tr>
<td></td>
<td>Create Merge Request</td>
<td>Creates a merge request in GitLab.</td>
</tr>
<tr>
<td></td>
<td>Create Merge Request Note</td>
<td>Creates a note for the required merge request.</td>
</tr>
<tr>
<td></td>
<td>Delete Merge Request Note</td>
<td>Deletes a note for the required merge request.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>List All Merge Requests</td>
<td>Retrieves the list of merge requests in a project.</td>
</tr>
<tr>
<td></td>
<td>List Merge Request Notes</td>
<td>Retrieves the list of merge request notes in a project.</td>
</tr>
<tr>
<td></td>
<td>Update Merge Request</td>
<td>Updates details of the required merge request.</td>
</tr>
<tr>
<td></td>
<td>Update Merge Request Note</td>
<td>Updates details of the required merge request note.</td>
</tr>
<tr>
<td>Project Management</td>
<td>Add User To A Project</td>
<td>Adds user to a project in GitLab.</td>
</tr>
<tr>
<td></td>
<td>Archive Project</td>
<td>Archives a project in GitLab.</td>
</tr>
<tr>
<td></td>
<td>Create Milestone</td>
<td>Creates milestone in a GitLab project.</td>
</tr>
<tr>
<td></td>
<td>Create Project</td>
<td>Creates a project in GitLab.</td>
</tr>
<tr>
<td></td>
<td>Delete Milestone</td>
<td>Deletes milestone in a GitLab project.</td>
</tr>
<tr>
<td></td>
<td>Delete Project</td>
<td>Deletes a project in GitLab.</td>
</tr>
<tr>
<td></td>
<td>Get Project</td>
<td>Retrieves the details of the required project in GitLab.</td>
</tr>
<tr>
<td></td>
<td>List Milestones</td>
<td>Retrieves a list of milestones, along with their details.</td>
</tr>
<tr>
<td></td>
<td>Look Up Projects</td>
<td>Retrieves a list of projects, along with their details.</td>
</tr>
<tr>
<td></td>
<td>Remove User From A Project</td>
<td>Removes user from a project in GitLab.</td>
</tr>
<tr>
<td></td>
<td>Share Project With Group</td>
<td>Shares a project with a group in GitLab.</td>
</tr>
<tr>
<td></td>
<td>Unarchive Project</td>
<td>Unarchives a project in GitLab.</td>
</tr>
<tr>
<td></td>
<td>Unshare Project With Group</td>
<td>Unshares a project with a group in GitLab.</td>
</tr>
</tbody>
</table>
Spoke module
The GitLab spoke provides Gitlab Token Management application that includes the Gitlab Token Managements module. You should record here to authenticate requests from your ServiceNow instance.

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

MID Server requirements
These actions use REST calls, which can run on a MID Server. Use the connection record associated with the GitLab alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

Set up GitLab spoke
Integrate the ServiceNow instance and GitLab by creating a custom OAuth application in GitLab to authenticate ServiceNow requests.

Before you begin
- Request IntegrationHub subscription
- Activate the GitLab spoke
- Role required: admin

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Milestone</td>
<td>Updates details of a milestone in a project.</td>
<td></td>
</tr>
<tr>
<td>Update Project</td>
<td>Updates details of a project.</td>
<td></td>
</tr>
<tr>
<td>Source Code</td>
<td>Add New File To Repository</td>
<td>Adds a file to a repository in GitLab.</td>
</tr>
<tr>
<td>Management</td>
<td>Get Commit</td>
<td>Retrieves a details of a commit in GitLab.</td>
</tr>
</tbody>
</table>
Create OAuth application in GitLab account

Create a custom OAuth application from your GitLab account to enable OAuth 2.0 authentication with the GitLab spoke.

Before you begin

- GitLab account
- GitLab admin credentials

About this task

Complete these steps from your GitLab account. See the GitLab documentation for instructions on creating and configuring applications.

Procedure

1. From your GitLab account, create an application.
2. Enter ServiceNow instance URL in Redirect URI.
3. Copy and record the Application Id and Secret for later use. These details are required to register the application as a third-party OAuth provider on your ServiceNow instance.

Results

The custom OAuth application from your GitLab account is created and can be integrated with the ServiceNow instance.

Register GitLab as OAuth provider

Use the information generated during GitLab application configuration to register GitLab as an OAuth provider and allow the ServiceNow instance to request OAuth 2.0 tokens.

Before you begin

Role required: admin

Procedure

1. Navigate to System OAuth > Application Registry.
2. Open for the record for GitLab.
3. On the form, fill in the fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter GitLab OAuth profile.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Application ID created during the GitLab application configuration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Secret created during the GitLab application configuration.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Optional script to customize the request and response.</td>
</tr>
<tr>
<td>Logo URL</td>
<td>URL that contains an image to use as the application logo.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Grant type used to establish the token. Select Authorization Code.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>Time, in seconds, that the refresh token is valid. The default time is 8,640,0000 seconds.</td>
</tr>
<tr>
<td>PKCE required</td>
<td>Option to enable public clients to require PKCE for an authorization.</td>
</tr>
<tr>
<td></td>
<td>✨ Note: You can use only Authorization Code as the Default Grant type when PKCE is enabled.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record. Select GitLab Spoke.</td>
</tr>
<tr>
<td></td>
<td>✨ Note: You must ensure that the application scope is GitLab Spoke.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Application scope that this registry is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
<tr>
<td></td>
<td>✨ Note: If you have installed GitLab on an on-premise server, enter the URL in this format: https://&lt;gitlab-hosted-instance&gt;.com/oauth/authorize</td>
</tr>
<tr>
<td>Token URL</td>
<td>OAuth server token endpoint. For example, <a href="https://gitlab.com/oauth/token">https://gitlab.com/oauth/token</a>.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you have installed GitLab on an on-premise server, enter the URL in this format: https://&lt;gitlab-hosted-instance&gt;.com/oauth/token</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>OAuth server token revocation endpoint.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint. System generates the URL upon saving the application registry. Replace <code>&lt;Instance-Name&gt;</code> with the name of your ServiceNow instance. The format of the redirect URL is: https://&lt;instance-name&gt;.service-now.com/api/sn_gitlab_spoke/gitlab_oauth_redirect/oauth.</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use mutual authentication for token request and revocation. This option requires a mutual authentication profile to be specified.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**. The system validates the OAuth credentials and populates the **Redirect URL**.

5. Copy and record the **Redirect URL**.

6. Login to your GitLab application and edit the configuration of your GitLab application. See the GitLab documentation for instructions on creating and configuring applications.

7. Paste the **Redirect URL** value into the **Redirect URI** for your GitLab application.

**Results**
The instance can request OAuth 2.0 tokens for the spoke and a refresh token is created to regenerate tokens.

**Add GitLab token**
Add GitLab token to authenticate requests from your ServiceNow instance.

**Procedure**
1. Navigate to **GitLab Token Management > GitLab Token Managements**.
2. Click **New**.
3. On the form, fill these values.
Gitlab Token Management form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secret</td>
<td>Secret created during the GitLab application configuration.</td>
</tr>
<tr>
<td>Name</td>
<td>Name to identify the record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile created during the registration of GitLab spoke as an OAuth provider. For example, select <strong>GitLab OAuth profile</strong>.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

**Create Credential records for the GitLab spoke**

Authorize the GitLab spoke actions by creating credential records for the application registered in GitLab. The GitLab spoke connection and credential alias uses these credentials to authorize actions.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
   The system displays the message **What type of Credentials would you like to create?**.
3. Select **OAuth 2.0 Credentials**.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, <strong>GitLab Credentials</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile created during the registration of GitLab spoke as an OAuth provider. For example, select <strong>GitLab OAuth profile</strong>.</td>
</tr>
<tr>
<td>Applies to</td>
<td>MID Servers that can use this credential. For example, select <strong>All MID Servers</strong>.</td>
</tr>
</tbody>
</table>
5. Right-click the form header and click **Save**.

6. To generate the OAuth token, click the **Get OAuth Token** related link.

**Results**
The credential record for the GitLab spoke is created.

**Create Connection record for the GitLab spoke**
Create Connection records to your GitLab account. The GitLab spoke connection and credential alias uses these connections to perform actions in GitLab.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open for the record for **GitLab**.
3. From the **Connections** tab, click **New**.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter <strong>GitLab Connection</strong>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for GitLab. For example, select <strong>GitLab Credentials</strong>.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Enter <a href="https://gitlab.com/api">https://gitlab.com/api</a>.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you have installed GitLab on an on-premise server, enter the URL in this format: https://&lt;gitlab-hosted-instance&gt;.com/api</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Results**
The connection record is created for GitLab spoke.
Gmail spoke
Manage Gmail actions.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

Supported versions
API version v1.

Spoke subflows
The Gmail spoke provides sample subflows in the draft state to demonstrate automating Gmail tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move a ServiceNow attachment to Gmail</td>
<td>Copies an attachment from ServiceNow to Gmail.</td>
</tr>
</tbody>
</table>

Spoke actions
The Gmail spoke provides actions to automate Gmail tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label Management</td>
<td>Add Label to Email</td>
<td>Add a label to an email.</td>
</tr>
<tr>
<td></td>
<td>Create New Label</td>
<td>Create a label in your Gmail account.</td>
</tr>
<tr>
<td></td>
<td>Lookup Label ID By Name</td>
<td>Retrieve details of a specified Label ID.</td>
</tr>
<tr>
<td></td>
<td>Remove Label From Email</td>
<td>Remove the specified label from an email.</td>
</tr>
</tbody>
</table>
### Email Management

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Add Attachment To ServiceNow Record</td>
<td>Add an attachment from an email in your Gmail account to a ServiceNow record.</td>
</tr>
<tr>
<td></td>
<td>Get Email Details</td>
<td>Retrieve details of a specified email.</td>
</tr>
<tr>
<td></td>
<td>Look Up Emails</td>
<td>Retrieve details of specified emails.</td>
</tr>
<tr>
<td></td>
<td>Reply To Email</td>
<td>Send a reply to an email.</td>
</tr>
<tr>
<td></td>
<td>Send Email</td>
<td>Send email from your Gmail account to specified recipients.</td>
</tr>
<tr>
<td></td>
<td>Delete Email</td>
<td>Delete the specified email.</td>
</tr>
<tr>
<td></td>
<td>Undelete Email</td>
<td>Retrieve the specified email from the Bin.</td>
</tr>
</tbody>
</table>

**Gmail spoke account requirements**

The Gmail spoke requires a custom app that you create in the Google Developers Console.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Gmail alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

**Set up Gmail spoke**

Integrate the ServiceNow instance and Gmail spoke by using Google credentials to authenticate ServiceNow requests.

**Before you begin**

- Install the Gmail spoke.
- Request IntegrationHub subscription.
• Activate the Gmail spoke.
• Role required: admin.

Configure Gmail application

Create a custom OAuth application from your Gmail account to enable OAuth 2.0 authentication with the Gmail spoke.

Before you begin

Google Tasks integration requirements:
• A domain and an email address associated with the domain. For example, www.mydomain.com and jane-admin@mydomain.com. Note that you can only register one email address per domain in G Suite.
• A Google G Suite or Gmail login created with the domain.

About this task

Complete these steps from the Google Developers Console. See the G Suite product documentation for instructions on creating and configuring custom applications.

Procedure

1. Register a new custom application. Navigate to https://console.developers.google.com, create a project with your G Suite administrator credentials, and open the project.

2. From the APIs & Services menu, select OAuth consent screen, enter the application name, and specify the Authorized domain service-now.com. Click Save.

3. From the APIs & Services menu, select Credentials, and select Create OAuth client ID from the Create credentials list.

4. Select the application type Web application.

5. Enter the following Authorized redirect URI: https://<instance>.service-now.com/oauth_redirect.do and click Create. This redirect URI must match the Redirect URL you provide when you Register Gmail as an OAuth provider.

6. The OAuth client window shows your client ID and client secret. Copy these two values to a text file so that you can use them when you Register Gmail as an OAuth provider.

   The client ID and secret can always be accessed in the Google APIs & Services interface. Click Credentials and select the OAuth 2.0 client ID name.
Register Gmail as an OAuth provider

Use the information generated during Gmail application configuration to register the Gmail application as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Procedure
1. In ServiceNow, navigate to System OAuth > Application Registry.
2. Open the Gmail spoke.
3. Enter these values in the Application Registries form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Enter the Client ID of the Gmail application you created.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Client Secret of the Gmail application you created.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>Click the lock icon , enter https://&lt;instance&gt;.service-now.com/oauth_redirect.do, and then click the lock icon again.</td>
</tr>
</tbody>
</table>

4. In the OAuth Entity Scopes related list, add the scopes required by your application. The Gmail spoke supports these scopes:

<table>
<thead>
<tr>
<th>Name</th>
<th>OAuth scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>labels</td>
<td><a href="https://www.googleapis.com/auth/gmail.labels">https://www.googleapis.com/auth/gmail.labels</a></td>
</tr>
<tr>
<td>send</td>
<td><a href="https://www.googleapis.com/auth/gmail.send">https://www.googleapis.com/auth/gmail.send</a></td>
</tr>
<tr>
<td>readonly</td>
<td><a href="https://www.googleapis.com/auth/gmail.readonly">https://www.googleapis.com/auth/gmail.readonly</a></td>
</tr>
<tr>
<td>compose</td>
<td><a href="https://www.googleapis.com/auth/gmail.compose">https://www.googleapis.com/auth/gmail.compose</a></td>
</tr>
<tr>
<td>insert</td>
<td><a href="https://www.googleapis.com/auth/gmail.insert">https://www.googleapis.com/auth/gmail.insert</a></td>
</tr>
<tr>
<td>modify</td>
<td><a href="https://www.googleapis.com/auth/gmail.modify">https://www.googleapis.com/auth/gmail.modify</a></td>
</tr>
</tbody>
</table>
### Table: OAuth Scopes for Gmail

<table>
<thead>
<tr>
<th>Name</th>
<th>OAuth scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>metadata</td>
<td><a href="https://www.googleapis.com/auth/gmail.metadata">https://www.googleapis.com/auth/gmail.metadata</a></td>
</tr>
<tr>
<td>basic settings</td>
<td><a href="https://www.googleapis.com/auth/gmail.settings.basic">https://www.googleapis.com/auth/gmail.settings.basic</a></td>
</tr>
<tr>
<td>sharing settings</td>
<td><a href="https://www.googleapis.com/auth/gmail.settings.sharing">https://www.googleapis.com/auth/gmail.settings.sharing</a></td>
</tr>
<tr>
<td>mail</td>
<td><a href="https://mail.google.com">https://mail.google.com</a></td>
</tr>
</tbody>
</table>

ℹ️ **Note:** The mail scope provides full access to the account including permanent deletion of threads and messages.

Click **Insert a new row** and enter the name and the OAuth scope URL.

5. On the OAuth Entity Profiles tab, add at least one profile, set its **Is default** value to true, and select the **Grant type** Authorization Code. Click **Update**.

6. Open the form for this default profile, add the entity scopes to the profile, and click **Update**.

7. On the Application registries form, click **Update** again. The system validates the OAuth credentials.

**What to do next**

Create Credential record for the Gmail spoke.

**Create Credential record for the Gmail spoke**

Create Credential records to Gmail. The Gmail spoke connection and credential alias uses these credentials to authorize actions.
Before you begin

- Role required: admin.

Procedure

1. Navigate to IntegrationHub > Connections & Credentials > Credentials and click New.
2. Select OAuth 2.0 Credentials.
3. Enter a unique name for the credential, for example, Gmail Spoke Credential.
4. Click the OAuth Entity Profile search icon (🔍) and select the default Gmail profile.
5. Click Submit and reopen the credential.
7. Choose the Google account that the application is associated with and allow Google to access the spoke actions you specified.

What to do next
Create Connection record for the Gmail spoke.

Create Connection record for the Gmail spoke

Create Connection records to your Gmail account. The Gmail spoke connection and credential alias uses these connections to perform actions on Gmail.

Before you begin
Role required: admin

Procedure

1. Navigate to IntegrationHub > Connections & Credentials > Connection & Credential Aliases and select Gmail.
2. On the Connections related list, click New.
3. Select HTTP(s) Connection.
4. Provide this connection information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name gmail.</td>
</tr>
</tbody>
</table>
5. Click **Submit**.

**Results**
The Gmail spoke is set up and integrated with the ServiceNow instance.

**Google Calendar spoke v 1.0.3**
Use ServiceNow to create and update events and attendees in Google Calendar.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Supported versions**
API version v1.

**Spoke actions**
The Google Calendar spoke provides actions to perform Google Calendar tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attendees</td>
<td>Add Attendees To Event</td>
<td>Updates an event by adding to the list of attendees. Values you specify replace the existing values. Fields that you don’t specify in the request do not change.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Remove Attendees</td>
<td>Remove Attendees From</td>
<td>Updates an event by removing specified attendees. Values you specify replace the existing values. Fields that you don’t specify in the request do not change.</td>
</tr>
<tr>
<td>From Event</td>
<td>Event</td>
<td></td>
</tr>
<tr>
<td>Event Management</td>
<td>Create Event</td>
<td>Creates an event on the specified calendar.</td>
</tr>
<tr>
<td>Update Event</td>
<td>Update Event</td>
<td>Edit event information. Values you specify replace the existing values. Fields that you don’t specify in the request do not change.</td>
</tr>
<tr>
<td>Get Event By ID</td>
<td>Get Event By ID</td>
<td>Returns the specified event.</td>
</tr>
<tr>
<td>Delete Event</td>
<td>Delete Event</td>
<td>Removes a specified event from a calendar.</td>
</tr>
<tr>
<td>Look Up Events</td>
<td>Look Up Events Stream</td>
<td>Returns events on a specified calendar based on start time, end time, or search terms.</td>
</tr>
</tbody>
</table>

**Google Calendar Online account requirements**

The Google Calendar spoke requires a custom app that you create in Google G Suite.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Google Calendar alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

**Set up Google Calendar spoke**

Integrate a ServiceNow instance and Google Calendar by using G Suite credentials to authenticate ServiceNow requests.
Before you begin

- Request IntegrationHub subscription.
- Activate the Google Calendar spoke.
- Role required: admin

**Configure Google Calendar application**

Create a custom OAuth application from your G Suite account to enable OAuth 2.0 authentication with the Google Calendar spoke.

**Before you begin**

Google Calendar integration requirements:

- A domain and an email address associated with the domain. For example, www.mydomain.com and jane-admin@mydomain.com. Note that you can only register one email address per domain in G Suite.
- A Google G Suite or login created with the domain.

**About this task**

Complete these steps from your Google G Suite account. See the G Suite product documentation for instructions on creating and configuring custom applications.

**Procedure**

1. Register a new custom application. Navigate to https://console.developers.google.com, create a project with your G Suite administrator credentials, and open the project.

2. From the APIs & Services menu, select OAuth consent screen, enter the application name, and specify the Authorized domain service-now.com. Click Save.

3. Search for the Google Calendar API and enable it.

4. From the APIs & Services menu, select Credentials, and select Create OAuth client ID from the Create credentials list.

5. Select the application type Web application.

6. Enter the following Authorized redirect URI: https://<instance>.service-now.com/oauth_redirect.do and click Create.

This redirect URI must match the Redirect URL you provide when you Register Google Calendar as an OAuth provider.
7. The OAuth client window shows your client ID and client secret. Copy these two values to a text file so that you can use them when you Register Google Tasks as an OAuth provider.

The client ID and secret can always be accessed in the Google APIs & Services interface. Click Credentials and select the OAuth 2.0 client ID name.

Register Google Calendar as an OAuth provider

Use the information generated during Google Calendar account configuration to register the Google Calendar application as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Procedure

1. In ServiceNow, navigate to System OAuth > Application Registry.
2. Click New.
3. On the screen titled What kind of OAuth application, select Connect to a third-party OAuth Provider.
4. Enter these values in the Application Registries form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record, for example Google Calendar.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Enter the Client ID of the Google Calendar application you created in G Suite.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Client Secret you generated when you created the application in G Suite.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Click the search icon (🔍) and select OAuthGoogleRefreshTokenUtil</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select Authorization Code.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>Click the lock icon ( secreto), enter <a href="https://accounts.google.com/o/oauth2/auth">https://accounts.google.com/o/oauth2/auth</a>, and then click the lock icon again.</td>
</tr>
<tr>
<td>Token URL</td>
<td>Click the lock icon ( secreto), enter <a href="https://www.googleapis.com/oauth2/v4/token">https://www.googleapis.com/oauth2/v4/token</a>, and then click the lock icon again.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>Click the lock icon 🗝️, enter https://&lt;instance&gt;.servicenow.com/oauth_redirect.do, and then click the lock icon again.</td>
</tr>
</tbody>
</table>

5. **Optional:** In the OAuth Entity Scopes related list, add any scopes required by your application. The Google Calendar spoke includes these scopes by default:
   - Calendar
   - Events

6. Right-click the form header, and click **Save**. The system validates the OAuth credentials.

Create Credential record for the Google Calendar spoke

Create Credential records to connect the Google Calendar custom OAuth application you created during account configuration. The Google Calendar spoke connection and credential aliases use these credentials to authorize actions.

Procedure

1. Navigate to **IntegrationHub > Connections & Credentials > Credentials** and click **New**.
2. Select OAuth 2.0 Credentials.
3. Enter a unique name for the credential, for example, gCal Cred.
4. Click the OAuth Entity Profile search icon (🔍) and select the profile with the name of the OAuth application registry you created when you registered the Google Calendar service as an OAuth provider.
5. Click **Get Oauth Token**.

Create Connection record for the Google Calendar spoke

Create connection records to a Google Calendar account. A connection alias resolves your Google Calendar connection and credential at runtime. Only one connection is active per Connection Alias at a time.

About this task

You should provide a single Credential and Connection Alias for all G Suite service spokes.
Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Select the Google Calendar connection.
3. On the Connection Attributes related list, set the default value of the API version to v3.
   If there are no connection attributes, click New and create a connection attribute with this information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>API version</td>
</tr>
<tr>
<td>Column name</td>
<td>u_api_version</td>
</tr>
<tr>
<td>Mandatory</td>
<td>False</td>
</tr>
<tr>
<td>Read only</td>
<td>False</td>
</tr>
<tr>
<td>Type</td>
<td>String</td>
</tr>
<tr>
<td>Reference</td>
<td>(empty)</td>
</tr>
<tr>
<td>Default value</td>
<td>v3</td>
</tr>
</tbody>
</table>

4. In the Connections related list, select the Google Calendar Connection.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name Google Calendar Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential name you specified when you created the Credential record. The value used in the preceding steps is gCal Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Select the value sn_gcalendar_scope.Google_Calendar.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Enter the URL <a href="https://www.googleapis.com/">https://www.googleapis.com/</a></td>
</tr>
</tbody>
</table>

5. Return to IntegrationHub > Connections & Credentials > Credentials and select googlecalendar_cred.
6. From Related Links, click Get OAuth Token.
A confirmation message indicates that the OAuth token flow has completed successfully. Review the details if the flow is not successful.

Note: Ensure that you allow pop-up windows in your browser.

Results
The Google Calendar spoke is set up and integrated with the ServiceNow instance.

Google Cloud Datastore spoke v1.0.1
Manage the NoSQL database services in Google Cloud Datastore from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Google Cloud Datastore v1, but may be compatible with later versions.

Spoke requirements
• Google Cloud Datastore account

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• IntegrationHub (com.glide.hub.integrations)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.
Spoke actions

The Google Cloud Datastore spoke provides actions to automate Google Cloud Datastore tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entity Management</td>
<td>Entity Export</td>
<td>Exports a copy of all or a subset of entities from Google Cloud Datastore to another storage system.</td>
</tr>
<tr>
<td></td>
<td>Entity Import</td>
<td>Imports entities into Google Cloud Datastore.</td>
</tr>
<tr>
<td>Index Management</td>
<td>Create Index</td>
<td>Creates the specified index.</td>
</tr>
<tr>
<td></td>
<td>Delete Index</td>
<td>Deletes an existing index.</td>
</tr>
<tr>
<td></td>
<td>Get Index</td>
<td>Gets an index.</td>
</tr>
<tr>
<td></td>
<td>Look up Index</td>
<td>Retrieves the list of indexes that match the specified filters.</td>
</tr>
<tr>
<td>Operation Management</td>
<td>Cancel Operation</td>
<td>Starts asynchronous cancellation on a long-running operation.</td>
</tr>
<tr>
<td></td>
<td>Delete Operation</td>
<td>Deletes a long-running operation.</td>
</tr>
<tr>
<td></td>
<td>Get Operation</td>
<td>Gets the latest state of a long-running operation.</td>
</tr>
<tr>
<td></td>
<td>Look up Operation</td>
<td>Retrieves the list of operations that match the specified filter in the request.</td>
</tr>
</tbody>
</table>

Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.
**Set up the Google Cloud Datastore spoke**

Integrate the ServiceNow instance and Google Cloud Datastore spoke using Google Cloud Platform credentials to authenticate ServiceNow requests.

**Before you begin**
- Request IntegrationHub subscription.
- Activate Google Cloud Datastore spoke.
- Role required: admin

**Register Google Cloud Datastore as an OAuth provider**

Register G suite as the OAuth provider so that the ServiceNow instance can request OAuth 2.0 tokens.

**Procedure**

1. Navigate to System OAuth > Application Registry.
2. Click New.
   The system displays the message What kind of OAuth application?.
3. Select Connect to a third party OAuth Provider.
4. On the form, fill these values.

**Applied Registries form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record, for example Google Cloud Datastore.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID of the Google Directory application you created in G Suite.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret you generated when you created the application in G Suite.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Script to customize the request and response to the external OAuth provider.</td>
</tr>
<tr>
<td>Logo URL</td>
<td>The OAuth application logo URL.</td>
</tr>
<tr>
<td>Default Grant Type</td>
<td>The default grant type used to establish the token. Select Authorisation Code.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>Time, in seconds, that the refresh token is valid. The default time is 8,640,0000 seconds.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Option to make the app accessible from all application scopes or from this scope only.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to make the app active.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>The OAuth authorization code endpoint.</td>
</tr>
<tr>
<td>Token URL</td>
<td>The OAuth server token endpoint.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>The OAuth callback endpoint. If left blank, the instance auto-generates the URL.</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>The OAuth server token revocation endpoint.</td>
</tr>
</tbody>
</table>

5. Go to the related list on the record OAuth Entity Profiles to validate a system-generated default profile for the G Suite OAuth provider without any scope.

6. Go to the related list on the record OAuth Entity Scopes to define all available OAuth scopes for this OAuth provider.

7. Right-click the form header, and click **Save**. The system validates the OAuth credentials.

**Create Credential record for the Google Cloud Datastore spoke**

Create credential record for the Google Cloud Datastore application. The Google Cloud Datastore spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to **Connections & Credentials > Credentials**.

2. Click **New**.
   - The system displays the message **What type of Credentials would you like to create?**.

3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential. For example, Google Cloud Datastore credential.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Option to apply the credentials for all MID Servers, or specific MID servers.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Option to make this credential active.</td>
</tr>
<tr>
<td>Order</td>
<td>Sequence in which the credential is applied to devices.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Enter Google Cloud Datastore default_profile. This OAuth profile is a combination of a grant type and at least one scope.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>The credential alias you want to map to the OAuth 2.0 credential.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click **Submit**.

**Google Cloud Functions spoke**

Manage functions that are attached to events, using your Google Cloud Functions account from ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Supported versions**

This spoke was built for the Google Cloud Functions API version v1, but may be compatible with later versions.

**Google Cloud Functions spoke requirements**

The Google Cloud Functions spoke requires a custom app that you create in Google Cloud Platform.

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• Google Identity and Access spoke
• Google Cloud VPC Access spoke
• Google Cloud Storage spoke
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke actions**

The Google Cloud Functions spoke provides actions to automate Google Cloud Functions tasks when events occur in the Now Platform. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function Management</td>
<td>Create Function For Event</td>
<td>Creates a function for an event.</td>
</tr>
<tr>
<td></td>
<td>Create Function For HTTP</td>
<td>Create a function to process an HTTP request.</td>
</tr>
<tr>
<td></td>
<td>Delete Function</td>
<td>Deletes the specified function.</td>
</tr>
<tr>
<td>Generate Download URL</td>
<td>Generate Download URL</td>
<td>Retrieves details of a signed URL to download source code of the deployed function.</td>
</tr>
<tr>
<td>Generate Upload URL</td>
<td>Generate Upload URL</td>
<td>Retrieves details of a signed URL for uploading source code of the deployed function.</td>
</tr>
<tr>
<td></td>
<td>Get Function</td>
<td>Retrieves information about the specified function.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get IAM Policy</td>
<td>Retrieves details of IAM access control policy for a function.</td>
</tr>
<tr>
<td></td>
<td>Look up Functions</td>
<td>Retrieves a list of functions available in the specified location.</td>
</tr>
<tr>
<td></td>
<td>Set IAM Policy</td>
<td>Sets the IAM access control policy for the specified function.</td>
</tr>
<tr>
<td></td>
<td>Update Function</td>
<td>Updates details of the specified function.</td>
</tr>
<tr>
<td>Location Management</td>
<td>Look up Locations</td>
<td>Retrieves a list of locations available in the specified project.</td>
</tr>
<tr>
<td>Operation Management</td>
<td>Get Operation</td>
<td>Retrieves details of the specified operation.</td>
</tr>
<tr>
<td></td>
<td>Look up Operations</td>
<td>Retrieves the list of operations available in the specified project.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the Google Cloud Functions spoke**

Integrate the ServiceNow instance and Google Cloud Functions account by creating a custom OAuth application in Google Cloud Platform to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription.
- Activate Google Cloud Functions spoke.
- Role required: admin

**Configure the Google Cloud Functions application**

Create a custom OAuth application in your Google Cloud Platform account to enable OAuth 2.0 authentication with the Google Cloud Functions spoke.
About this task
Complete these steps from the Google Cloud Platform. See the Google Cloud Platform product documentation for instructions on creating and configuring custom applications.

Procedure

1. Register a new custom application. Navigate to https://console.cloud.google.com/, create a project with your administrator credentials, and open the project.

2. From the APIs & Services menu, select OAuth consent screen, enter the application name, and specify the Authorized domain service-now.com. Click Save.

3. From the APIs & Services menu, select Credentials, and select Create OAuth client ID from the Create credentials list.

4. Select the application type OAuth client ID.

5. Enter the following Authorized redirect URI: https://<instance>.service-now.com/oauth_redirect.do and click Create.

6. The OAuth client window shows your client ID and client secret. Copy these two values to a text file so that you can use them when you Register Google Cloud Functions as an OAuth provider.

   The client ID and secret can always be accessed in the Google APIs & Services interface. Click Credentials and select the OAuth 2.0 client ID name.

Register Google Cloud Functions as an OAuth provider

Use the information generated during the Google Cloud Functions application configuration to register Google Cloud Functions as an OAuth provider and allow the ServiceNow instance to request OAuth 2.0 tokens.

Procedure

1. Navigate to System OAuth > Application Registry.

2. Open for the record, Google Cloud Functions.

3. On the form, fill these values.

   Application Registries form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Client ID of the Google Cloud Functions application.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret of the Google Cloud Functions application.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint in this format: https://&lt;instance&gt;.service-now.com/oauth_redirect.do.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**.

**Create a credential record for the Google Cloud Functions spoke**

Create a credential record for the Google Cloud Functions application. The Google Cloud Functions spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to **Connections & Credentials > Connections & Credential Aliases**.
2. Open record for the Google Cloud Functions spoke. For example, `GoogleCloudFunctions`.
3. In the **Credentials** tab, click **New**.
4. Select **OAuth 2.0 Credentials**.
5. Enter a unique name for the credential, for example, `GFunctions_Cred`.
6. Click the **OAuth Entity Profile** search icon (🔍) and select the profile with the name of the OAuth application registry you configured when you registered the Google Cloud Functions service as an OAuth provider. See **Register Google Cloud Functions as an OAuth provider** for more information.
7. Right-click the form header and click **Save**.
8. Click **Get OAuth Token**.

**Google Cloud Load Balancer Spoke**

Manage load balancing of your external or internal Virtual Private Cloud (VPC) network from ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Google Cloud Load Balancer v1, but may be compatible with later versions.

Spoke requirements
- Google Cloud Platform (GCP) account with access to Google Compute Engine and Google Virtual Private Network

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- Complex Object (com.glide.cobject)
- Google Compute Engine spoke (sn_gcompute_spoke)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke subflows
The Google Cloud Load Balancer Spoke provides subflows to automate Google Cloud Load Balancer tasks when events occur in your ServiceNow instance. Available subflows include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTPS Load Balancer Management</td>
<td>Create HTTPS Load Balancer For A New Backend Service</td>
<td>Creates a HTTPS load balancer for a new backend service in the specified project.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Create HTTPS Load Balancer For An Existing Backend Service</td>
<td>Creates a HTTPS load balancer for an existing backend service in the specified project.</td>
</tr>
<tr>
<td></td>
<td>Delete HTTPS Load Balancer</td>
<td>Deletes the components of the specified load balancer.</td>
</tr>
<tr>
<td></td>
<td>Look up Components Of HTTPS Load Balancer</td>
<td>Retrieves a list of names of all the components associated with a HTTPS load balancer.</td>
</tr>
<tr>
<td>HTTP Load Balancer Management</td>
<td>Create A HTTP Load Balancer For A New Backend Service</td>
<td>Creates a HTTP load balancer for a new backend service in the specified project.</td>
</tr>
<tr>
<td></td>
<td>Create HTTP Load Balancer For An Existing Backend service</td>
<td>Creates a HTTP load balancer for an existing backend service in the specified project.</td>
</tr>
<tr>
<td></td>
<td>Delete HTTP Load Balancer</td>
<td>Deletes the components of a HTTP load balancer.</td>
</tr>
<tr>
<td></td>
<td>Look up Components Of HTTP Load Balancer</td>
<td>Retrieves a list of names of all the components associated with a HTTP load balancer.</td>
</tr>
</tbody>
</table>

**Spoke actions**

The Google Cloud Load Balancer Spoke provides actions to automate Google Cloud Load Balancer tasks when events occurs in your ServiceNow instance. Available actions include:
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backend Service Management</td>
<td>Create Backend Service</td>
<td>Creates a backend service.</td>
</tr>
<tr>
<td></td>
<td>Delete Backend Service</td>
<td>Deletes the specified backend service</td>
</tr>
<tr>
<td></td>
<td>Get Backend Service</td>
<td>Retrieves the details of the specified backend service.</td>
</tr>
<tr>
<td></td>
<td>Get Health Of Backend Service</td>
<td>Retrieves the health details of the specified backend service.</td>
</tr>
<tr>
<td></td>
<td>Look up Backend Services</td>
<td>Retrieves a list of all backend services.</td>
</tr>
<tr>
<td></td>
<td>Update Backend Service</td>
<td>Updates the details of the specified backend service.</td>
</tr>
<tr>
<td>Global Address Management</td>
<td>Create A Global Address</td>
<td>Creates a global address.</td>
</tr>
<tr>
<td></td>
<td>Delete A Global Address</td>
<td>Deletes the specified global address</td>
</tr>
<tr>
<td></td>
<td>Get Global Address</td>
<td>Retrieves the details of all the global addresses.</td>
</tr>
<tr>
<td></td>
<td>Look up Global Addresses</td>
<td>Retrieves a list of all global addresses.</td>
</tr>
<tr>
<td>Global Forwarding Rule Management</td>
<td>Create Global Forwarding Rule</td>
<td>Creates a global forwarding rule.</td>
</tr>
<tr>
<td></td>
<td>Delete Global Forwarding Rule</td>
<td>Deletes the specified global forwarding rule.</td>
</tr>
<tr>
<td></td>
<td>Get Global Forwarding Rule</td>
<td>Retrieves the details of a global forwarding rule.</td>
</tr>
<tr>
<td></td>
<td>Look up Global Forwarding Rules</td>
<td>Retrieves a list of all global forwarding rules.</td>
</tr>
</tbody>
</table>
### Spoke actions (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP Health Check Management</td>
<td>Set Target For Global</td>
<td>Assigns target information to the specified global forwarding rule.</td>
</tr>
<tr>
<td></td>
<td>Forwarding Rule</td>
<td></td>
</tr>
<tr>
<td>HTTP Load Balancer Management</td>
<td>Get Resource Name</td>
<td>Retrieves the name of the resource from a resource URL.</td>
</tr>
<tr>
<td>HTTPS Health Check Management</td>
<td>Create A HTTPS Health</td>
<td>Creates a HTTPS health check.</td>
</tr>
<tr>
<td></td>
<td>Check</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delete A HTTPS Health</td>
<td>Deletes the specified HTTPS health check.</td>
</tr>
<tr>
<td></td>
<td>Check</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Get HTTPS Health Check</td>
<td>Retrieves the details of the specified HTTPS health check.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Look up HTTPS Health</td>
<td>Retrieves a list of HTTPS health checks.</td>
</tr>
<tr>
<td></td>
<td>Checks</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Update A HTTPS Health</td>
<td>Updates the details of the specified HTTPS health check.</td>
</tr>
<tr>
<td></td>
<td>Check</td>
<td></td>
</tr>
<tr>
<td>Instance Group Manager Management</td>
<td>Create An Instance</td>
<td>Creates an instance group manager.</td>
</tr>
<tr>
<td></td>
<td>Group Manager</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Create Instance In Instance Manager Group</td>
<td>Creates an instance in the specified instance group manager.</td>
</tr>
<tr>
<td></td>
<td>Delete An Instance Group Manager</td>
<td>Deletes the specified instance group manager.</td>
</tr>
<tr>
<td></td>
<td>Get Instance Group Manager</td>
<td>Retrieves the details of a specified instance group manager.</td>
</tr>
<tr>
<td></td>
<td>Look up Instance Group Managers</td>
<td>Retrieves a list of managed instance groups.</td>
</tr>
<tr>
<td></td>
<td>Look up Managed Instances In An Instance Group Manager</td>
<td>Retrieves a list of managed instances in a specified managed instance group.</td>
</tr>
<tr>
<td></td>
<td>Resize An Instance Group Manager</td>
<td>Resizes the number of instances in a specified instance group manager.</td>
</tr>
<tr>
<td></td>
<td>Update Instance Template Of An Instance Group Manager</td>
<td>Assigns the details of instance template to the specified instance group manager.</td>
</tr>
<tr>
<td>Target HTTP Proxy Management</td>
<td>Create Target HTTP Proxy</td>
<td>Creates a target HTTP proxy.</td>
</tr>
<tr>
<td></td>
<td>Delete Target HTTP Proxy</td>
<td>Deletes the specified target HTTP proxy.</td>
</tr>
<tr>
<td></td>
<td>Get Target HTTP Proxy</td>
<td>Retrieves the details of the specified target HTTP proxy.</td>
</tr>
<tr>
<td></td>
<td>Look up Target HTTP Proxies</td>
<td>Retrieves a list of all target HTTP proxies.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Target HTTPS Proxy Management</td>
<td>Update URL Map Of Target HTTP Proxy</td>
<td>Assigns the URL map information to the specified target HTTP proxy.</td>
</tr>
<tr>
<td></td>
<td>Create Target HTTPS Proxy</td>
<td>Creates a target HTTPS proxy.</td>
</tr>
<tr>
<td></td>
<td>Delete Target HTTPS Proxy</td>
<td>Deletes the specified target HTTPS proxy.</td>
</tr>
<tr>
<td></td>
<td>Get Target HTTPS Proxy</td>
<td>Retrieves the details of the specified target HTTPS proxy.</td>
</tr>
<tr>
<td></td>
<td>Look up Target HTTPS Proxies</td>
<td>Retrieves a list of the target HTTPS proxies.</td>
</tr>
<tr>
<td></td>
<td>Set SSL Certificates To Target HTTPS Proxy</td>
<td>Assigns SSL certificates to the specified target HTTPS proxy.</td>
</tr>
<tr>
<td></td>
<td>Set URL Map To Target HTTPS Proxy</td>
<td>Assigns URL map information to the specified target HTTPS proxy.</td>
</tr>
<tr>
<td>URL Map Management</td>
<td>Create URL Map</td>
<td>Creates a URL map.</td>
</tr>
<tr>
<td></td>
<td>Delete URL Map</td>
<td>Deletes the specified URL map.</td>
</tr>
<tr>
<td></td>
<td>Get URL Map</td>
<td>Retrieves the details of the specified URL map.</td>
</tr>
<tr>
<td></td>
<td>Look up URL Maps</td>
<td>Retrieves the details of all URL maps.</td>
</tr>
<tr>
<td></td>
<td>Update URL Map</td>
<td>Updates the details of the URL map.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and
connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the Google Cloud Load Balancer Spoke**

Integrate the ServiceNow instance and Google Cloud Load Balancer by creating a custom OAuth application in Google Cloud Storage to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub subscription.
- Activate Google Cloud Load Balancer Spoke.
- Role required: admin

**Register Google Cloud Load Balancer as an OAuth provider**

Use the information generated during the Google Cloud Storage application configuration to register Google Cloud Load Balancer as an OAuth provider and allow the ServiceNow instance to request OAuth 2.0 tokens.

**Procedure**

1. Navigate to **System OAuth > Application Registry**.
2. Open for the record for Google Cloud Load Balancer.
3. On the form, fill these values.

<table>
<thead>
<tr>
<th>Application Registries form</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID created during the Google Cloud Storage application configuration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client secret created during the Google Cloud Storage or application configuration.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>OAuth authorization code endpoint. Enter: <a href="https://accounts.google.com/o/oauth2/auth">https://accounts.google.com/o/oauth2/auth</a></td>
</tr>
<tr>
<td>Token URL</td>
<td>OAuth server token endpoint. Enter: <a href="https://oauth2.googleapis.com/token">https://oauth2.googleapis.com/token</a></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc. in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Token Revocation URL</td>
<td>OAuth server token revocation endpoint.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint in this format: <code>https://&lt;instance&gt;.service-now.com/oauth_redirect.do</code></td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Script to customize the request and response. Select <code>OAuthGoogleCloudLoadBalancerUtil</code>.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**.

**Create a credential record for the Google Cloud Load Balancer Spoke**

Create a credential record for the Google Cloud Storage custom application. The Google Cloud Load Balancer Spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to **IntegrationHub > Connections & Credentials > Connection & Credential Aliases**.

2. Open the **Google_Cloud_Storage** record.

3. In the **Credentials** section, click **New**.

   The system displays this message: What type of Credentials would you like to create?

4. Select **OAuth 2.0 Credentials**.

5. On the form, fill these values.

**OAuth 2.0 Credentials form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Google Cloud Load Balancer OAuth Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile created during the registration of Google Cloud Storage as an OAuth provider. Find and select <code>GCP Cloud Storage default_profile</code>.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, 100.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>

6. Right-click the form header and click Submit.
7. To generate the OAuth token, click the Get OAuth Token related link.

**Google Cloud Pub Sub Spoke**
Manage Google Cloud Pub/Sub messaging service from your ServiceNow instance.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Supported versions**
This spoke was built for Google Cloud Pub Sub v1, but may be compatible with later versions.

**Spoke requirements**
- Google Cloud account

**Spoke dependencies**
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• Complex Object (com.glide.cobject)
• Google Identity And Access Spoke (sn_gcp_id_acc_spk)

ℹ️ **Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

### Spoke subflows

The Google Cloud Pub Sub Spoke provides sample subflows to demonstrate automating Google Cloud Pub/Sub tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Google PubSub Messages</td>
<td>Receives messages from a sub topic and displays the messages in logs.</td>
</tr>
</tbody>
</table>

### Spoke actions

The Google Cloud Pub Sub Spoke provides actions to automate tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>snapshot management</td>
<td>Create Snapshot</td>
<td>Creates a snapshot from the requested subscription.</td>
</tr>
<tr>
<td></td>
<td>Delete Snapshot</td>
<td>Removes the specified existing snapshot.</td>
</tr>
<tr>
<td></td>
<td>Get Snapshot IAM Policy</td>
<td>Retrieves the IAM policy of the snapshot.</td>
</tr>
<tr>
<td></td>
<td>Look up Snapshots</td>
<td>Retrieves a list of existing snapshots.</td>
</tr>
<tr>
<td></td>
<td>Set Snapshot IAM Policy</td>
<td>Assigns the access control policy to the specified snapshot.</td>
</tr>
<tr>
<td></td>
<td>Update Snapshot</td>
<td>Updates an existing snapshot.</td>
</tr>
<tr>
<td>subscription management</td>
<td>Acknowledge</td>
<td>Acknowledges the messages associated with the acknowledge IDs in the acknowledge request.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Acknowledge Deadline</td>
<td>Updates the acknowledge deadline in seconds for a specific message.</td>
</tr>
<tr>
<td></td>
<td>Create Pull Subscription</td>
<td>Creates a pull subscription to the specified topic.</td>
</tr>
<tr>
<td></td>
<td>Create Push Subscription</td>
<td>Creates a push subscription to the specified topic.</td>
</tr>
<tr>
<td></td>
<td>Delete Subscription</td>
<td>Deletes an existing subscription for the specified project.</td>
</tr>
<tr>
<td></td>
<td>Get Subscription</td>
<td>Retrieves the configuration details of the specified subscription.</td>
</tr>
<tr>
<td></td>
<td>Get Subscription IAM Policy</td>
<td>Retrieves the access control policy for the specified subscription.</td>
</tr>
<tr>
<td></td>
<td>Look up Subscriptions</td>
<td>Retrieves a list of subscriptions.</td>
</tr>
<tr>
<td></td>
<td>Pull Messages</td>
<td>Pulls message asynchronously for the specified project.</td>
</tr>
<tr>
<td></td>
<td>Seek Subscription</td>
<td>Seeks an existing subscription to a point in time or to a specified snapshot.</td>
</tr>
<tr>
<td></td>
<td>Set Subscription IAM Policy</td>
<td>Assigns the access control policy to the specified subscription.</td>
</tr>
<tr>
<td></td>
<td>Update Push Configuration</td>
<td>Updates the push configuration for the specified subscription.</td>
</tr>
<tr>
<td></td>
<td>Update Subscription</td>
<td>Updates the specified existing subscription.</td>
</tr>
<tr>
<td>Topic Management</td>
<td>Create Topic</td>
<td>Creates a topic with the specified name.</td>
</tr>
<tr>
<td></td>
<td>Delete Topic</td>
<td>Deletes the specified topic.</td>
</tr>
<tr>
<td></td>
<td>Get IAM Policy</td>
<td>Retrieves the specified access control policy of a resource.</td>
</tr>
<tr>
<td></td>
<td>Get Topic</td>
<td>Retrieves the configuration details of the specified topic.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up Topics</td>
<td>Retrieves a list of topics.</td>
</tr>
<tr>
<td></td>
<td>Publish Messages</td>
<td>Adds one or more messages to the specified topic.</td>
</tr>
<tr>
<td></td>
<td>Set IAM Policy</td>
<td>Assigns the access control policy to the specified resource.</td>
</tr>
<tr>
<td></td>
<td>Update Topic</td>
<td>Updates the specified topic.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**MID Server requirements**

**Set up the Google Cloud Pub Sub Spoke**

Integrate the ServiceNow instance and Google Cloud Pub Sub by creating a custom OAuth application in Google Cloud account to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub subscription.
- Activate Google Cloud Pub Sub Spoke.
- Role required: admin

**Register Google Cloud Pub Sub as an OAuth provider**

Use the information generated during the Google Cloud Pub Sub application configuration to register Google Cloud as an OAuth provider and allow the ServiceNow instance to request OAuth 2.0 tokens.

**Procedure**

1. Navigate to **System OAuth > Application Registry**.
2. Click **New**.
The system displays this message: What kind of OAuth application?

3. Select **Connect to a third party OAuth Provider**.
4. On the form, fill these values.

### Application Registries form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter: Google Cloud Pub Sub OAuth</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID created during the Google Cloud account configuration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret created during the Google Cloud account configuration.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>OAuth authorization code endpoint. Enter: <a href="https://oauth2.googleapis.com/o/oauth2/auth">https://oauth2.googleapis.com/o/oauth2/auth</a></td>
</tr>
<tr>
<td>Token URL</td>
<td>OAuth server token endpoint. Enter: <a href="https://oauth2.googleapis.com/token">https://oauth2.googleapis.com/token</a></td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>OAuth server token revocation endpoint.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint in this format: https://&lt;instance&gt;.service-now.com/oauth_redirect.do</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Script to customize the request and response.</td>
</tr>
<tr>
<td>Logo URL</td>
<td>URL that contains an image to use as the application logo.</td>
</tr>
<tr>
<td>Default Grant Type</td>
<td>Grant type used to establish the token. Select <strong>Authorization Code</strong>.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>Time, in seconds, that the refresh token is valid. The default time is 8,640,0000 seconds.</td>
</tr>
<tr>
<td>PKCE required</td>
<td>Option to enable public clients to require PKCE for an authorization.</td>
</tr>
</tbody>
</table>

⚠️ **Note:** You can use only **Authorization Code** as the **Default Grant type** when PKCE is enabled.

Application scope that contains this record.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessible from</td>
<td>Application scope that this registry is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use mutual authentication for token request and revocation. This option requires a mutual authentication profile to be specified.</td>
</tr>
</tbody>
</table>

5. Add OAuth Entity Profile.
6. Add OAuth Entity Scope.
7. Right-click the form header, and click **Save**.

**Create a credential record for the Google Cloud Pub Sub Spoke**

Create a credential record for the Google Cloud account. The Google Cloud Pub Sub Spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to **IntegrationHub > Connections & Credentials > Credentials**.
2. Click **New**.
   
   The system displays this message: **What type of Credentials would you like to create?**
3. **Select OAuth 2.0 Credentials**.
4. On the form, fill these values.

**OAuth 2.0 Credentials form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Google Cloud Pub Sub Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile created during the registration of Google Cloud Pub Sub as an OAuth provider. For example, Google Cloud Pub Sub OAuth Profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Option to specify if the credential applies to all MID Servers in your network, or to one or more <strong>Specific MID servers</strong>. Specify</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, 100.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias associated with the spoke.</td>
</tr>
</tbody>
</table>

6. Right-click the form header and click Submit.
7. To generate the OAuth token, click the Get OAuth Token related link.

**Create a credential record for the Google Cloud Pub Sub Spoke**

Create a credential record for the Google Cloud account. The Google Cloud Pub Sub Spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to IntegrationHub > Connections & Credentials > Connection & Credential Aliases.
2. Open the GoogleCloudPubSub record.
3. In the Credentials section, click New.
4. <TBD>.
5. Right-click the form header and click Submit.
6. To generate the OAuth token, click the Get OAuth Token related link.

**Google Cloud SQL spoke**

Manage provisioning of MySQL and PostgreSQL in Google Cloud SQL from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.
**Supported versions**
This spoke was built for Google Cloud SQL v1beta4, but may be compatible with later versions.

**Spoke requirements**
- Google Cloud Platform account
- Google Identity and Access spoke (sn_gcpcloudsql_spk)

**Spoke dependencies**
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Complex Object (com.glide.cobject)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke actions**
The Google Cloud SQL provides actions to automate tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
<th>Required Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back up Run Management:</td>
<td>Create Backup</td>
<td>Creates a backup.</td>
<td>cloudsql.backupRuns.create</td>
</tr>
<tr>
<td></td>
<td>Delete Backup</td>
<td>Deletes a backup.</td>
<td>cloudsql.backupRuns.delete</td>
</tr>
<tr>
<td></td>
<td>Run</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Get Backup Run</td>
<td>Retrieves details of the backup.</td>
<td>cloudsql.backupRuns.get</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
<td>Required Permission</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------</td>
<td>--------------------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Look up Backup Runs</td>
<td>Retrieves a list of the backup runs.</td>
<td>cloudsql.backupRuns.list</td>
<td></td>
</tr>
<tr>
<td>Database Management</td>
<td>Create Database</td>
<td>Creates a database.</td>
<td>cloudsql.databases.create</td>
</tr>
<tr>
<td></td>
<td>Delete Database</td>
<td>Deletes a database.</td>
<td>cloudsql.databases.delete</td>
</tr>
<tr>
<td></td>
<td>Get Database</td>
<td>Retrieves details of the instance.</td>
<td>cloudsql.databases.get</td>
</tr>
<tr>
<td></td>
<td>Look up Databases</td>
<td>Retrieves a list of the databases.</td>
<td>cloudsql.databases.list</td>
</tr>
<tr>
<td></td>
<td>Update Database</td>
<td>Updates a database.</td>
<td>cloudsql.databases.update</td>
</tr>
<tr>
<td>Instance Management</td>
<td>Clone Instance</td>
<td>Clones an instance.</td>
<td>cloudsql.instances.clone</td>
</tr>
<tr>
<td></td>
<td>Create Instance</td>
<td>Creates an instance.</td>
<td>cloudsql.instances.create</td>
</tr>
<tr>
<td></td>
<td>Delete Instance</td>
<td>Deletes an instance.</td>
<td>cloudsql.instances.delete</td>
</tr>
<tr>
<td></td>
<td>Get Instance</td>
<td>Retrieves details of the instance.</td>
<td>cloudsql.instances.get</td>
</tr>
<tr>
<td></td>
<td>Look up Instances</td>
<td>Retrieves a list of the instances.</td>
<td>cloudsql.instances.clone</td>
</tr>
<tr>
<td></td>
<td>Restart Instance</td>
<td>Restarts an instance.</td>
<td>cloudsql.instances.restart</td>
</tr>
<tr>
<td></td>
<td>Update Instance</td>
<td>Updates an instance.</td>
<td>cloudsql.instances.update</td>
</tr>
<tr>
<td>Operations</td>
<td>Get Operation</td>
<td>Retrieves details of the operation.</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>Look up Operations</td>
<td>Retrieves a list of the operations.</td>
<td>N/A</td>
</tr>
<tr>
<td>Tiers</td>
<td>Look up Tiers</td>
<td>Retrieves a list of the tiers.</td>
<td>N/A</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
<td>Required Permission</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------</td>
<td>------------------------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>User Management</td>
<td>Create User</td>
<td>Creates a user.</td>
<td>cloudsql.users.create</td>
</tr>
<tr>
<td></td>
<td>Delete User</td>
<td>Deletes a user.</td>
<td>cloudsql.users.delete</td>
</tr>
<tr>
<td></td>
<td>Look up User</td>
<td>Retrieves a list of the users.</td>
<td>cloudsql.users.list</td>
</tr>
<tr>
<td></td>
<td>Update User</td>
<td>Updates a user.</td>
<td>cloudsql.users.update</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the Google Cloud SQL spoke**

Integrate the ServiceNow instance and Google Cloud SQL spoke using Google Cloud Platform credentials to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription.
- Activate Google Cloud SQL spoke.
- Role required: admin

**Configure the Google Cloud SQL application**

Create a custom OAuth application from your Google Cloud Platform account to enable OAuth 2.0 authentication with the Google Cloud SQL spoke.

**Before you begin**

Google Identity and Access integration requirements:

- Google Cloud SQL account

**About this task**

Complete these steps from the Google Cloud Platform.
Procedure

1. Register a new custom application. Navigate to https://console.developers.google.com, create a project with your Google Cloud Platform administrator credentials, and open the project.

2. From the APIs & Services menu, select **OAuth consent screen**, enter the application name, and specify the Authorized domain service-now.com. Click **Save**.

3. From the APIs & Services menu, select **Credentials**, and select **Create OAuth client ID** from the **Create credentials** list.

4. Select the application type **Web application**.

5. Enter the following Authorized redirect URL: https://<instance>.service-now.com/oauth_redirect.do and click **Create**.

6. The OAuth client window shows your client ID and client secret. Copy these two values to a text file so that you can use them when you Register Google Identity and Access as an OAuth provider. The client ID and secret can always be accessed in the Google APIs & Services interface. Click **Credentials** and select the OAuth 2.0 client ID name.

**Register Google Cloud SQL as an OAuth provider**

Use the information generated during Google Cloud SQL account configuration to register the Google Cloud SQL application as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

**Procedure**

1. In ServiceNow instance, navigate to **System OAuth > Application Registry**.

2. Open the record for **Google Cloud SQL**.

3. On the form, fill these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record, for example Google Cloud SQL.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID of the Google Cloud SQL application.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret you generated when you create the application.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Script to customize the request and response. Select OAuthGCPSQLUtil.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Grant type used to establish the token. Select <strong>Authorization Code</strong>.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>URL of the ServiceNow instance in this format: https://&lt;instance&gt;.servicenow.com/oauth_redirect.do.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**. The system validates the OAuth credentials.

**Create Credential record for the Google Cloud SQL spoke**

Create Credential records to connect the Google Cloud SQL custom OAuth application you created during account configuration. The GoogleCloud SQL spoke connection and credential aliases use these credentials to authorize actions.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **IntegrationHub > Connections & Credentials > Credentials** and click **New**.
2. Select OAuth 2.0 Credentials.
3. Enter a unique name for the credential, for example, **GCSQL Cred**.
4. Click the **OAuth Entity Profile** search icon (🔍) and select the profile with the name of the OAuth application registry you created when you registered the Google Cloud SQL service as an OAuth provider.
5. Click **Get Oauth Token**.
Google Cloud Storage spoke
Manage storage and retrieval of data in Google Cloud from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Complex Object (com.glide.cobject)

⚠️ Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Google Cloud Storage account requirements
The Google Cloud Storage spoke requires a custom app that you create in Google Cloud Platform.s

Supported versions
This spoke was built for API version v1, but may be compatible with later versions.

Spoke subflows
The Google Cloud Storage spoke provides sample subflows to demonstrate automating Google Cloud Storage tasks. To customize the sample subflow, copy it to a new application scope. Available sample subflows include:
<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move An Object</td>
<td>Moves an object from the source bucket to destination bucket.</td>
</tr>
<tr>
<td>Rename An Object</td>
<td>Renames the specified object.</td>
</tr>
</tbody>
</table>

**Spoke actions**

The Google Cloud Storage spoke provides actions to automate Google Cloud Storage when events occur in ServiceNow. For the spoke actions to be performed, you must ensure that your project or organization in Google Cloud Platform has the mentioned permissions. Available spoke actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
<th>Permissions Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bucket Access Control Management</td>
<td>Create/Update Bucket Access Control</td>
<td>Creates or updates a bucket access control.</td>
<td>• storage.buckets.get</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• storage.buckets.getIamPolicy</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• storage.buckets.setIamPolicy</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• storage.buckets.update</td>
</tr>
<tr>
<td></td>
<td>Delete Bucket Access Control</td>
<td>Deletes the specified bucket access control.</td>
<td>• storage.buckets.get</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• storage.buckets.getIamPolicy</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• storage.buckets.setIamPolicy</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• storage.buckets.update</td>
</tr>
<tr>
<td></td>
<td>List All Bucket Access Controls</td>
<td>Retrieves the list of all bucket access controls.</td>
<td>• storage.buckets.get</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• storage.buckets.getIamPolicy</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bucket Management</td>
<td>Create Bucket</td>
<td>Creates a bucket in Google Cloud Storage.</td>
<td>storage.buckets.create</td>
</tr>
<tr>
<td></td>
<td>Delete A Bucket</td>
<td>Deletes the specified bucket in Google Cloud Storage.</td>
<td>storage.buckets.delete</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
<th>Permissions Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Bucket Details</td>
<td></td>
<td>Retrieves details of the specified bucket in Google Cloud Storage.</td>
<td>• storage.buckets.get</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• storage.buckets.getIamPolicy</td>
</tr>
<tr>
<td>Get Bucket Labels</td>
<td></td>
<td>Retrieves labels of the specified bucket in Google Cloud Storage.</td>
<td>• storage.buckets.get</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• storage.buckets.getIamPolicy</td>
</tr>
<tr>
<td>Get IAM Policy</td>
<td></td>
<td>Retrieves IAM policy of the specified bucket in Google Cloud Storage.</td>
<td>storage.buckets.getIamPolicy</td>
</tr>
<tr>
<td>List All Buckets</td>
<td></td>
<td>Retrieves details of all buckets in Google Cloud Storage.</td>
<td>• storage.buckets.list</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• storage.buckets.getIamPolicy</td>
</tr>
<tr>
<td>Update Bucket Details</td>
<td></td>
<td>Updates details of the specified bucket in Google Cloud Storage.</td>
<td>• storage.buckets.update</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• storage.buckets.setIamPolicy</td>
</tr>
<tr>
<td>Update Bucket IAM Policy</td>
<td></td>
<td>Updates IAM policy of the specified bucket in Google Cloud Storage.</td>
<td>storage.buckets.setIamPolicy</td>
</tr>
<tr>
<td>Object Access Control</td>
<td>Create/Update Object</td>
<td>Creates or updates a object access control.</td>
<td>• storage.objects.get</td>
</tr>
<tr>
<td>Management</td>
<td>Access Control</td>
<td></td>
<td>• storage.objects.getIamPolicy</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• storage.objects.setIamPolicy</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• storage.objects.update</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
<td>Permissions Required</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------</td>
<td>------------------------------------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>Delete Object Access Control</td>
<td>Delete</td>
<td>Deletes the specified object access control.</td>
<td>• storage.objects.get&lt;br&gt;• storage.objects.getIamPolicy&lt;br&gt;• storage.objects.setIamPolicy&lt;br&gt;• storage.objects.update</td>
</tr>
<tr>
<td></td>
<td>List All Object Access Controls</td>
<td>Retrieves the list of all object access controls.</td>
<td>• storage.objects.get&lt;br&gt;• storage.objects.getIamPolicy</td>
</tr>
<tr>
<td>Object Management</td>
<td>Copy Object</td>
<td>Copies an object from one bucket to another bucket.</td>
<td>• storage.objects.create (for the destination bucket)&lt;br&gt;• storage.objects.delete (for the destination bucket)&lt;br&gt;• storage.objects.get (for the source bucket)</td>
</tr>
<tr>
<td></td>
<td>Delete An Object</td>
<td>Deletes an object in a bucket.</td>
<td>storage.objects.delete</td>
</tr>
<tr>
<td></td>
<td>Download Object To ServiceNow</td>
<td>Downloads the specified object to ServiceNow.</td>
<td>• storage.objects.get&lt;br&gt;• storage.objects.getIamPolicy</td>
</tr>
<tr>
<td></td>
<td>Get Object Details</td>
<td>Retrieves the details of the specified object.</td>
<td>• storage.objects.get&lt;br&gt;• storage.objects.getIamPolicy</td>
</tr>
<tr>
<td></td>
<td>List All Objects</td>
<td>Retrieves list of all objects in the specified bucket.</td>
<td>• storage.objects.list&lt;br&gt;• storage.objects.getIamPolicy</td>
</tr>
</tbody>
</table>
### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

### Set up the Google Cloud Storage spoke

Integrate the ServiceNow instance and Google Cloud Storage spoke by using G Suite credentials to authenticate ServiceNow requests.

---

**Table: IAM Permissions Required**

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
<th>Permissions Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rewrite An Object</td>
<td>Rewrite an object</td>
<td>Rewrites an object from the source bucket to destination bucket.</td>
<td>• storage.objects.create (for the destination bucket)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• storage.objects.delete (for the destination bucket)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• storage.objects.get (for the source bucket)</td>
</tr>
<tr>
<td>Update Object Details In A Bucket</td>
<td>Updates details</td>
<td>Updates details of the specified object in a bucket.</td>
<td>• storage.objects.update</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• storage.objects.setIamPolicy</td>
</tr>
<tr>
<td>Update Object Storage Class</td>
<td>Updates storage class</td>
<td>Updates storage class of the specified object.</td>
<td>• storage.objects.update</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• storage.objects.setIamPolicy</td>
</tr>
<tr>
<td>Upload An Object</td>
<td>Uploads an object</td>
<td>Uploads an object to the specified bucket.</td>
<td>• storage.objects.create</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• storage.objects.delete</td>
</tr>
</tbody>
</table>

For more information about the required permissions, see IAM permissions reference.
Before you begin

- Request IntegrationHub subscription.
- Activate the Google Cloud Storage spoke.
- Access to Google Cloud Platform.
- Role required: admin.

Configure the Google Cloud Storage application

Create a custom OAuth application from your Google Cloud Platform account to enable OAuth 2.0 authentication with the Google Cloud Storage spoke.

About this task

Complete these steps from the Google Cloud Platform. See the Google Cloud Platform product documentation for instructions on creating and configuring custom applications.

Procedure

1. Register a new custom application. Navigate to https://console.cloud.google.com/, create a project with your administrator credentials, and open the project.

2. From the APIs & Services menu, select OAuth consent screen, enter the application name, and specify the Authorized domain service-now.com. Click Save.

3. From the APIs & Services menu, select Credentials, and select Create OAuth client ID from the Create credentials list.

4. Select the application type Web application.

5. Enter the following Authorized redirect URI: https://<instance>.service-now.com/oauth_redirect.do and click Create.

6. The OAuth client window shows your client ID and client secret. Copy these two values to a text file so that you can use them when you Register Google Cloud Storage as an OAuth provider.

The client ID and secret can always be accessed in the Google APIs & Services interface. Click Credentials and select the OAuth 2.0 client ID name.

Register Google Cloud Storage as an OAuth provider

Use the information generated during Google Cloud Storage account configuration to register the Google Cloud Storage application as an OAuth provider and allow the instance to request OAuth 2.0 tokens.
Procedure

1. In ServiceNow, navigate to System OAuth > Application Registry.
2. Open the record for Google Cloud Storage.
3. Enter these values in the Application Registries form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record, for example Google Cloud Storage.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID of the Google Cloud Storage application you created in G Suite.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret you generated when you created the application in G Suite.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Script to customize the request and response. Select OAuthGoogleCloudStorageUtils</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Grant type used to establish the token. Select Authorization Code.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>URL of the ServiceNow instance in this format: https://&lt;instance&gt;.service-now.com/oauth_redirect.do.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click Save. The system validates the OAuth credentials.

Create Credential record for the Google Cloud Storage spoke

Create Credential records to connect the Google Cloud Storage custom OAuth application you created during account configuration. The Google Cloud Storage spoke connection and credential aliases use these credentials to authorize actions.

Procedure

1. Navigate to IntegrationHub > Connections & Credentials > Credentials and click New.
2. Select OAuth 2.0 Credentials.
3. Enter a unique name for the credential, for example, GStorage_Cred.

4. Click the OAuth Entity Profile search icon (🔍) and select the profile with the name of the OAuth application registry you created when you registered the Google Cloud Storage service as an OAuth provider.

5. Click Get Oauth Token.

**Google Cloud Translator Service spoke**

Provides subflows and actions to dynamically translate the user-entered text, and to detect the language of the text using the Google translation service.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**Subscription**

This spoke requires one of the following subscriptions:

- Any ServiceNow subscription that is Professional or above, and includes Dynamic Translation.
- IntegrationHub Professional subscription package. For more information see, Request IntegrationHub.

**Supported versions**

Google Translate API version v3

**Scope of the spoke in the Dynamic Translation framework**

To use Google Cloud Translator Service spoke in the Dynamic Translation framework, ensure that the spoke is installed in ServiceNow Store and the Dynamic Translation plugin is active. For more information, see .

**Spoke flows**

This spoke has no sample flows.

**Spoke subflows**

The Google Cloud Translator Service spoke provides subflows in the Published state to integrate with the Google translation service. These subflows can be used as part of other subflows and flows.
### Spoke actions

The Google Cloud Translator Service spoke provides actions to integrate with the Google translation service. Available actions include:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detect Language</td>
<td>Detects the language of the input text.</td>
</tr>
<tr>
<td>Translate Text To Single Language</td>
<td>Translates the input text to a single language.</td>
</tr>
<tr>
<td>Translate Text To Multiple Languages</td>
<td>Translates the input text to multiple languages.</td>
</tr>
</tbody>
</table>

### Google account requirements

The Google Cloud Translator Service spoke requires configuring your Google Cloud account to generate an OAuth 2.0 JWT Bearer Grant token.

### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

This spoke uses the GoogleTranslation alias record (sn_google_trans.GoogleTranslation) to authorize actions.

### Set up Google Cloud Translator Service spoke

Integrate your Google account with your ServiceNow instance.
Before you begin

• Role required: admin

• Create a service account on Google Cloud, generate a service account key of JSON type and download it. For information on creating the service account key, see the Google documentation.

• Enable the Cloud Translation API service. For information on enabling a service, see the Google documentation.

Create a Java KeyStore certificate

Encrypt the security certificates obtained from Google by creating a Java KeyStore (JKS) file.

Before you begin

• Role required: admin

• Download a JSON file containing the service account key from Google. For information on downloading the JSON file, see the Google documentation. Following is a sample JSON file:

```json
{
    "type": "service_account",
    "project_id": "primeval-nectar-242610",
    "private_key_id": "0c6c7b1511f1c236c130c5933d528bbf45314e5",
    "private_key": "-----BEGIN PRIVATE KEY-----
    MIIEvQKBADANBgkqhkiG9w0BAQEFAASCBKcwggSjAgEAAoIBAQDg97zOxfOenyu2/nIxXC8ArQHaOgy27sJg3jXohUdhkawuX+nQLWZkIByZ1yXZm+cMjNfpUFpzeHRKpM/n5OQ2b7hJHCgCTVFcbToIKH+VkMP870L0+TFKW2TKWJHWO2Xv30bT7zhkSb4tT1ZsMc/nv/sf16dgJaoKo4yt1BwC7v1r2s8ngJdW945+9NVkEPm/G8drYJRTl1myfn
nD0GR/jpyKtHAC3zw/rCE5b/VZIKZkspRT/qXVWZsH5pW7aNDRb1z+YQ1GGOj1fNkXBE/nQCE5Gh1UIF+Xscf
dq30culFo1LO9xAk/4lyQ8zidR4r5H1Uf01jp4t6fLW3k2o/n0dSr+r+XAgMBAAECcgEAA03QIY9JsSwr6mE+Y
ys7GUbL9kbfw0zXMF0UtpB/n5e0BOEtEEmomuxX/NkmD7qmN8oUx3GkJUDEvUWn90SwbVPSVU8sSvOV7j
Szyv/nEvA1UkX/1/gMftEV34FecaG3QXY05Myq2q+ru3yvKcRsrzBN0TIAXe6uxUG8IaouoL/nYi17pVfxcNW50f5V
5AuMe8+0rgadvOEPu3JrthjauMvnpDKP5abKDaDCfTqdyJa/hMMy8+uhFCOZr2JtTgpc4UHgqGP72kAUvR2Yml
kqfBNGx0+3DBJKJd7pD9nxon/n7I18wqQ0k62kFcJshHkC4ZIuORabz1q1MF1VdxeiJQKgBqQD5r7J/MgN4LLekaim
E/n3T27KTA12aiqK10LORQhLbHZrevXDF41WoRqRqySSuVQKsLizWzWQlO/hptDRnuYh/l6WKVqlwtSLnVItLtu+8Ak2
mb3F/RlFpdt3RG7xWExeau1+c8+8N63ehFwA4/n7IxyDht05c3deXN7DrfRfnQKBEQGmdAqDkkFwau6
q+3SGFxpqcFq1XS+ghpQtK/nUPxe45aZdRuFUOUCWA9B1bN1vHuzDnQiplbBjTJc2s/vBWlZ2qjzZPbn1mKp/nq
q1FSts3dar826v0n1Wmepam1PfKvN7QopGD/Rto68BfsKsICfzGLtu3PxEMLgj/nRyZ5HUtwwKBGtCZ05zszsCt
BmM9aYpayNMXU7d/FOXjheEo40lT4saEHUwTfasA3y6/nThUGRf7qagG+o3uA4JQFP8tB1CIU5i6x8gBNmCLYXWvG
xyMB0WkxOHFVshyR8Sa/nbWhSmCpqyVPJyX0px+x5+hCGDyNyUaDn3RznY7I/sIUpYh4E2/pEQEJAcGAdUIyvMME
SNKd82DZ524w7k7ATPMaKxFydyQKVShjeg/qe/SKYO4e90UXiJFJeZSP2P/n8nrkpm43Ngd4c1GiAnQSeqq
9C887FSvmfazvca6dSIXWQe4+Btf/4ot2RRT/nHyRKjv2br8XMrYjXXiCC+wPTank9eLDd4V79D8CqYEAE6ywn
q115bVO5kaw9ygp/n0u5eleKMMYNdPs5qylwy1OPOyN9nx/1/YQ3m2FI7d2K7aBP0AXkLZQqVtbcQF2fvdO/nbm4eLI
```
Procedure

1. In the JSON file, perform the following for the `private_key` value.
   a. Unescape the `\n` characters.
   b. Store the private key in a file with .pem extension.

2. In the JSON file, perform the following for the `client_x509_cert_url` value.
   a. Open the link specified for `client_x509_cert_url`.
   b. Unescape the `\n` characters for the certificate associated with the `private_key_id` mentioned in the JSON file.
   c. Store the certificate value in a file with .pem extension.

3. Use the `openssl` command to create a PKCS 12 file using the recently created private key and certificate files.

   ```bash
   ```

   For example, if `certificate.pem` is the certificate and `privatekey.pem` is the private key:

   ```bash
   openssl pkcs12 -export -in certificate.pem -inkey privatekey.pem -certfile certificate.pem -out testkeystore.p12
   ```

   A PKCS 12 file, testkeystore.p12, is created.

4. Specify an export password or source keystore password.

   **Note:** You should specify this password when creating a JWT key for Google Cloud Translator Service spoke.

5. Use the `keytool` command to create a JKS file from the PKCS 12 file.
Note: testKeyStore.p12 is the PKCS 12 file and wso2carbon.jks is the JKS file.

6. Specify a destination keystore password.

Note: You should specify this password when attaching a JKS certificate to Google Cloud Translator Service spoke.

Attach a Java KeyStore certificate to Google Cloud Translator Service spoke
Enable the JWT client authentication by attaching a valid Java KeyStore (JKS) certificate to Google Cloud Translator Service spoke.

Before you begin
• Role required: admin
• Valid Java KeyStore certificate

Procedure
1. Navigate to System Definition > Certificates.
2. Click New.
3. On the form, fill in the fields.

X.509 Certificate form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Identifier of the certificate.</td>
</tr>
<tr>
<td>Notify on expiration</td>
<td>Users to be notified when the certificate expires.</td>
</tr>
<tr>
<td>Warn in days to expire</td>
<td>Number of days to send a notification before the certificate expires.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the certificate.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the certificate. Select Java Key Store.</td>
</tr>
<tr>
<td>Expires in days</td>
<td>Number of days until the certificate expires.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Key store password | Password to access the certificate. Use the destination keystore password specified when creating the JKS certificate. For more information on this password, see *Create a Java KeyStore certificate*.

#### Short description
Summary about the certificate.

4. Click the manage attachments icon (🔗) and attach a JKS certificate.
5. To validate the JKS certificate, click **Validate Stores/Certificates**.
6. Click **Submit**.

**Create a JWT signing key for Google Cloud Translator Service spoke**
Assign a JSON Web Token (JWT) signing key to your Java KeyStore certificate.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **System OAuth > JWT Keys**.
2. Click **New**.
3. On the form, fill in the fields.

#### JWT Keys form fields

### Field | Description
--- | ---
Name | Identifier of the JWT signing key.
Signing Keystore | Valid JKS certificate for which you want to assign the key.
Key Id | Key ID to identify which key is used when multiple keys are used to sign tokens.
Signing Algorithm | Algorithm to sign with the key.
Signing Key Password | Password associated with the key. Use the export password or the source keystore password specified when creating the JKS certificate. For more information on this password, see *Create a Java KeyStore certificate*. 
Field | Description
--- | ---
Active | Option to activate the key.

4. Click **Submit**.

Create a JWT provider for Google Cloud Translator Service spoke

Add a JSON Web Token (JWT) provider to Google Cloud Translator Service spoke.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System OAuth > JWT Providers**.
2. Click **New**.
3. On the form, fill in the fields.

**JWT Provider form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Identifier of the JWT provider.</td>
</tr>
<tr>
<td>Expiry Interval (sec)</td>
<td>Number of seconds that indicate the lifespan of the JWT provider token. Specify 3600.</td>
</tr>
<tr>
<td>Signing Configuration</td>
<td>JWT signing key.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**.
5. In the Standard Claims related list, enter the values for these claims.

**Claim**

<table>
<thead>
<tr>
<th>Claim name</th>
<th>Claim value</th>
</tr>
</thead>
<tbody>
<tr>
<td>aud</td>
<td><a href="https://www.googleapis.com/oauth2/v4/token">https://www.googleapis.com/oauth2/v4/token</a></td>
</tr>
<tr>
<td>iss</td>
<td>client_email value from the JSON file.</td>
</tr>
</tbody>
</table>

6. In the Custom Claims related list, create the **scope** claim and enter its value as https://www.googleapis.com/auth/cloud-translation.

7. Click **Update**.
Configure the credential for the GoogleTranslation alias

Authorize actions of Google Cloud Translator Service spoke by configuring the Google OAuth 2.0 credential.

Before you begin
Role required: admin

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Select the Google OAuth 2.0 credential.
3. Open the record specified in the OAuth Entity Profile field.
4. In the JWT Provider field, specify the JWT provider that you want to use.
5. Click Update.
6. To verify if an OAuth Access token is generated to connect to Google’s translation services, click the Get OAuth Token related link of the Google OAuth 2.0 credential.

Configure the connection attributes for the GoogleTranslation alias

Connect to the Google’s translation service by configuring the Google connection. Provide information that is used by HTTP(s) actions or activities to connect to that service.

Before you begin
Role required: connection_admin

Procedure
1. Navigate to Connections & Credentials > Connections.
2. Open for the record for Google.
3. In the Attributes related list of the HTTP(S) Connection form, fill in the fields.

<table>
<thead>
<tr>
<th>HTTP(S) Connection form fields</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>location</td>
</tr>
<tr>
<td>project_id</td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>---------</td>
</tr>
<tr>
<td>version</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click Save.

**Google Cloud Virtual Network spoke**

Manage firewall, network, subnetwork, and IP address in Google Cloud Virtual Network from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Complex Object (com.glide.cobject)
- Google Persistent Disk spoke (sn_gpdisk_spoke)
- Google Compute Engine spoke (sn_gcompute_spoke)

**Note:** Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.
Google Cloud Virtual Network account requirements

The Google Cloud Virtual Network spoke requires a custom app that you create in the Google Cloud Platform.

Supported versions

This spoke was built for API version v1, but may be compatible with later versions.

Spoke actions

The Google Cloud Virtual Network spoke provides actions to automate Google Cloud Virtual Network when events occur in ServiceNow. For the spoke actions to be performed, you must ensure that your project or organization in Google Cloud Platform has the mentioned permissions. Available spoke actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
<th>Permissions Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Management</td>
<td>Create IP Address For Region</td>
<td>Creates an address resource in the specified project by using the data included in the request.</td>
<td>compute.addresses.create</td>
</tr>
<tr>
<td></td>
<td>Delete IP Address</td>
<td>Deletes the specified address resource.</td>
<td>compute.addresses.delete</td>
</tr>
<tr>
<td></td>
<td>Get IP Address</td>
<td>Retrieves details of the specified address resource.</td>
<td>compute.addresses.get</td>
</tr>
<tr>
<td>Firewall Management</td>
<td>Create Firewall For Egress</td>
<td>Creates a firewall for egress rule in the</td>
<td>compute.firewalls.create</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
<td>Permissions Required</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td></td>
<td>Create Firewall For Ingress</td>
<td>Creates a firewall for ingress rule in the specified project.</td>
<td>compute.firewalls.create</td>
</tr>
<tr>
<td></td>
<td>Delete Firewall</td>
<td>Deletes the specified firewall.</td>
<td>compute.firewalls.delete</td>
</tr>
<tr>
<td></td>
<td>Get Firewall</td>
<td>Retrieves details of the specified firewall.</td>
<td>compute.firewalls.get</td>
</tr>
<tr>
<td></td>
<td>Update Firewall For Egress</td>
<td>Updates a firewall for the egress rule in the specified project.</td>
<td>compute.firewalls.update</td>
</tr>
<tr>
<td></td>
<td>Update Firewall For Ingress</td>
<td>Updates a firewall for the ingress rule in the specified project.</td>
<td>compute.firewalls.update</td>
</tr>
<tr>
<td>Metadata Retrieval Management</td>
<td>List Addresses</td>
<td>Retrieves a list of addresses contained within the specified region.</td>
<td>compute.addresses.list</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
<td>Permissions Required</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------</td>
<td>-------------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>List Firewalls</td>
<td>Retrieve</td>
<td>Retrieves a list of firewalls available to the specified project.</td>
<td>compute.firewalls.list</td>
</tr>
<tr>
<td>List Networks</td>
<td>Retrieve</td>
<td>Retrieves a list of networks available to the specified project.</td>
<td>compute.networks.list</td>
</tr>
<tr>
<td>List Subnetworks</td>
<td>Retrieve</td>
<td>Retrieves a list of subnetworks available to the specified project.</td>
<td>compute.subnetworks.list</td>
</tr>
<tr>
<td>Network Management</td>
<td>Create</td>
<td>Creates a network in the specified project.</td>
<td>compute.networks.create</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Deletes the specified network.</td>
<td>compute.networks.delete</td>
</tr>
<tr>
<td></td>
<td>Get</td>
<td>Retrieves details of the specified network.</td>
<td>compute.networks.get</td>
</tr>
<tr>
<td>Subnetwork Management</td>
<td>Create</td>
<td>Creates a subnetwork in the</td>
<td>compute.subnetworks.create</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
<td>Permissions Required</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>specified project.</td>
<td></td>
</tr>
<tr>
<td>Delete Subnetwork</td>
<td>Deletes the specified subnetwork.</td>
<td>compute.subnetworks.delete</td>
<td></td>
</tr>
<tr>
<td>Expand IP CIDR Range</td>
<td>Expands the IP CIDR range of the subnetwork to a specified value.</td>
<td>compute.subnetworks.expandIpCidrRange</td>
<td></td>
</tr>
<tr>
<td>Get IAM Policy</td>
<td>Retrieves details of the access control policy for a resource.</td>
<td>compute.subnetworks.getIAMPolicy</td>
<td></td>
</tr>
<tr>
<td>Get Subnetwork</td>
<td>Retrieves details of the specified subnetwork.</td>
<td>compute.subnetworks.get</td>
<td></td>
</tr>
<tr>
<td>Set IAM Policy</td>
<td>Sets the access control policy on the specified resource.</td>
<td>compute.subnetworks.setIAMPolicy</td>
<td></td>
</tr>
</tbody>
</table>

For more information about the required permissions, see [IAM permissions reference](#).
Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the Google Cloud Virtual Network spoke

Integrate the ServiceNow instance and Google Cloud Virtual Network spoke by using OAuth 2.0 credentials to authenticate ServiceNow requests.

Before you begin

• Request IntegrationHub subscription.
• Activate the Google Cloud Virtual Network spoke.
• Activate and set up the Google Compute Engine spoke.
• Role required: admin.

Procedure

1. Navigate to IntegrationHub > Connections & Credentials > Credentials.
2. Open record for the Google Compute Engine spoke. For example, Google Compute Cred.
3. For Credential alias, select the Connection and Credential alias record of the Google Cloud Virtual Network spoke.
4. Right-click the form header and click Save.
5. Click Get Oauth Token.

Google Cloud VPC Access spoke

Manage connector and operations in your Google Cloud VPC Access account from ServiceNow instance.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for the Google Cloud VPC Access API version v1, but may be compatible with later versions.

Google Cloud VPC Access spoke requirements
The Google Cloud VPC Access spoke requires a custom app that you create in Google Cloud Platform.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- Google Identity and Access spoke
- Google Cloud Virtual Network spoke
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Google Cloud VPC Access spoke provides actions to automate Google Cloud VPC Access tasks when events occurs in the Now Platform. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector Management</td>
<td>Create Connector</td>
<td>Creates a connector in the specified project.</td>
</tr>
<tr>
<td></td>
<td>Delete Connector</td>
<td>Deletes the specified VPC Access connector.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get Connector</td>
<td>Retrieves the specified VPC Access connector.</td>
</tr>
<tr>
<td></td>
<td>Look up Connectors</td>
<td>Retrieves the list of VPC Access connectors available in the specified location.</td>
</tr>
<tr>
<td>Location Management</td>
<td>Look up Locations</td>
<td>Retrieves the list of locations available in the specified project.</td>
</tr>
<tr>
<td>Operation Management</td>
<td>Get Operation</td>
<td>Retrieves details of the specified operation.</td>
</tr>
<tr>
<td></td>
<td>Look up Operations</td>
<td>Retrieves a list of operations available with in the specified location.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

**Set up the Google Cloud VPC Access spoke**

Integrate the ServiceNow instance and Google Cloud VPC Access account by creating a custom OAuth application in Google Cloud Platform to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription.
- Activate Google Cloud VPC Access spoke.
- Role required: admin

**Configure the Google Cloud VPC Access application**

Create a custom OAuth application in your Google Cloud Platform account to enable OAuth 2.0 authentication with the Google Cloud VPC Access spoke.

**About this task**

Complete these steps from the Google Cloud Platform. See the [Google Cloud Platform](#) product documentation for instructions on creating and configuring custom applications.
Procedure

1. Register a new custom application. Navigate to https://console.cloud.google.com/, create a project with your administrator credentials, and open the project.

2. From the APIs & Services menu, select OAuth consent screen, enter the application name, and specify the Authorized domain service-now.com. Click Save.

3. From the APIs & Services menu, select Credentials, and select Create OAuth client ID from the Create credentials list.

4. Select the application type OAuth client ID.

5. Enter the following Authorized redirect URL: https://<instance>.service-now.com/oauth_redirect.do and click Create.

6. The OAuth client window shows your client ID and client secret. Copy these two values to a text file so that you can use them when you Register Google Cloud VPC Access as an OAuth provider.

Register Google Cloud VPC Access as an OAuth provider

Use the information generated during the Google Cloud VPC Access application configuration to register Google Cloud VPC Access as an OAuth provider and allow the ServiceNow instance to request OAuth 2.0 tokens.

Procedure

1. Navigate to System OAuth > Application Registry.

2. Open the record, Google Cloud VPC Access.

3. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Client ID of the Google Cloud VPC Access application.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint in this format: https://&lt;instance&gt;.service-now.com/oauth_redirect.do.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click Save.
Create a credential record for the Google Cloud VPC Access spoke

Create a credential record for the Google Cloud VPC Access application. The Google Cloud VPC Access spoke connection and credential alias uses these credentials to authorize actions.

Procedure

1. Navigate to Connections & Credentials > Connections & Credential Aliases.
2. Open record for the Google Cloud VPC Access spoke. For example, GoogleCloudVPCAccess.
3. In the Credentials tab, click New.
4. Select OAuth 2.0 Credentials.
5. Enter a unique name for the credential, for example, GCloud_VPC_Cred.
6. Click the OAuth Entity Profile search icon (🔍) and select the profile with the name of the OAuth application registry you configured when you registered the Google Cloud VPC Access service as an OAuth provider. See Register Google Cloud VPC Access as an OAuth provider for more information.
7. Right-click the form header and click Save.
8. Click Get OAuth Token.

Google Compute Engine spoke

Launch and manage virtual machines in Google Compute Engine from your ServiceNow instance.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• Complex Object (com.glide.cobject)
• Google Persistent Disk spoke (sn_gpdisk_spoke)
• Google Cloud Virtual Network spoke (sn_gcp_vpc_spoke)

⚠ Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Google Compute Engine account requirements
The Google Compute Engine spoke requires a custom app that you create in Google Cloud Platform.

Supported versions
This spoke was built for API version v1, but may be compatible with later versions.

Spoke actions
The Google Compute Engine spoke provides actions to automate Google Compute Engine when events occur in ServiceNow. For the spoke actions to be performed, you must ensure that your project or organization in Google Cloud Platform has the mentioned permissions. Available spoke actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
<th>Permissions Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance Template</td>
<td>Create Instance Template</td>
<td>Creates an instance template.</td>
<td>compute.instanceTemplates.create</td>
</tr>
<tr>
<td>Management</td>
<td>Create Instance Template From Instance</td>
<td>Creates an instance template from instance.</td>
<td>compute.instanceTemplates.create</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
<th>Permissions Required</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Delete Instance Templates</td>
<td>Deletes the specified instance template.</td>
<td>compute.instanceTemplates.delete</td>
</tr>
<tr>
<td></td>
<td>Get Instance Template</td>
<td>Retrieves details of the specified instance template.</td>
<td>compute.instanceTemplates.get</td>
</tr>
<tr>
<td>Machine Types Management</td>
<td>Get Machine Type By Zone</td>
<td>Retrieves details of the specified machine type by zone.</td>
<td>compute.instanceTemplates.get</td>
</tr>
<tr>
<td>Metadata Retrieval Management</td>
<td>List Instance Templates</td>
<td>Retrieves a list of instance templates available to the specified project.</td>
<td>compute.instanceTemplates.list</td>
</tr>
<tr>
<td></td>
<td>List Machine Types By Zone</td>
<td>Retrieves a list of machine types available to the specified project.</td>
<td>compute.instanceTemplates.list</td>
</tr>
<tr>
<td></td>
<td>List Regions</td>
<td>Retrieves a list of regions available to the specified project.</td>
<td>compute.instanceTemplates.list</td>
</tr>
<tr>
<td></td>
<td>List VM Instances By Zone</td>
<td>Retrieves a list of VM instances available to the specified project.</td>
<td>compute.instanceTemplates.list</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
<td>Permissions Required</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td></td>
<td>List Zones</td>
<td>Retrieves a list of zones available to the specified project.</td>
<td>compute.zones.list</td>
</tr>
<tr>
<td>Region Management</td>
<td>Get Region</td>
<td>Retrieves the specified region resource.</td>
<td>compute.regions.get</td>
</tr>
<tr>
<td>VM Instance Management</td>
<td>Attach Disk</td>
<td>Attaches an existing Disk resource to an instance.</td>
<td>compute.instances.attachDisk</td>
</tr>
<tr>
<td></td>
<td>Create Instance</td>
<td>Creates an instance resource in the specified project.</td>
<td>compute.instances.create</td>
</tr>
<tr>
<td></td>
<td>Delete Instance</td>
<td>Deletes the specified instance.</td>
<td>compute.instances.delete</td>
</tr>
<tr>
<td></td>
<td>Detach Disk</td>
<td>Detaches a disk from an instance.</td>
<td>compute.instances.detachDisk</td>
</tr>
<tr>
<td></td>
<td>Get IAM Policy</td>
<td>Retrieves the access control policy for a resource.</td>
<td>compute.instances.getIamPolicy</td>
</tr>
<tr>
<td></td>
<td>Get Instance By Zone</td>
<td>Retrieves the specified Instance by zone.</td>
<td>compute.instances.get</td>
</tr>
<tr>
<td></td>
<td>Reset Instance</td>
<td>Performs a reset on instance.</td>
<td>compute.instances.reset</td>
</tr>
<tr>
<td></td>
<td>Set IAM Policy</td>
<td>Sets the access</td>
<td>compute.instances.setIamPolicy</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
<td>Permissions Required</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------------</td>
<td>--------------------------------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>control policy on the specified resource.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Set Labels On Instance</strong></td>
<td>Sets labels on an instance.</td>
<td>compute.instances.setLabels</td>
</tr>
<tr>
<td></td>
<td><strong>Set Tags On Instance</strong></td>
<td>Sets tags for the specified instance.</td>
<td>compute.instances.setTags</td>
</tr>
<tr>
<td></td>
<td><strong>Start Instance</strong></td>
<td>Starts an instance.</td>
<td>compute.instances.start</td>
</tr>
<tr>
<td></td>
<td><strong>Stop Instance</strong></td>
<td>Stops an instance.</td>
<td>compute.instances.stop</td>
</tr>
<tr>
<td>Zone Management</td>
<td><strong>Get Zone</strong></td>
<td>Retrieves information about the specified zone.</td>
<td>compute.zones.get</td>
</tr>
</tbody>
</table>

For more information about the required permissions, see IAM permissions reference.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the Google Compute Engine spoke**

Integrate the ServiceNow instance and Google Compute Engine spoke by using OAuth 2.0 credentials to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription.
- Activate the Google Compute Engine spoke.
• Access to Google Cloud Platform.
• Role required: admin.

Note: This procedure outlines steps to configure the custom app using OAuth. You can also configure the custom app using Service Account associated with JWT tokens. For more information about setting up the spoke using JWT tokens, see Choosing an Authentication Method - Service accounts and Set up OAuth provider with JWT Bearer grant type.

Configure the Google Compute Engine application
Create a custom OAuth application from your Google Cloud Platform account to enable OAuth 2.0 authentication with the Google Compute Engine spoke.

About this task
Complete these steps from the Google Cloud Platform. See the Google Cloud Platform product documentation for instructions on creating and configuring custom applications.

Procedure
1. Register a new custom application. Navigate to https://console.cloud.google.com/, create a project with your administrator credentials, and open the project.
2. From the APIs & Services menu, select OAuth consent screen, enter the application name, and specify the Authorized domain service-now.com. Click Save.
3. From the APIs & Services menu, select Credentials, and select Create OAuth client ID from the Create credentials list.
4. Select the application type Web application.
5. Enter the following Authorized redirect URI: https://<instance>.service-now.com/oauth_redirect.do and click Create.
6. The OAuth client window shows your client ID and client secret. Copy these two values to a text file so that you can use them when you Register Google Compute Engine as an OAuth provider.
   The client ID and secret can always be accessed in the Google APIs & Services interface. Click Credentials and select the OAuth 2.0 client ID name.

Register Google Compute Engine as an OAuth provider
Use the information generated during Google Compute Engine account configuration to register the Google Compute Engine application as an OAuth provider and allow the instance to request OAuth 2.0 tokens.
Procedure

1. In ServiceNow, navigate to **System OAuth > Application Registry**.
2. Open the record for **Google Compute Engine**.
3. Fill these values in the Application Registries form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record, for example Google Compute Engine.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID of the Google Compute Engine application you created in G Suite.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret you generated when you created the application in G Suite.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Script to customize the request and response. Select OAuthGoogleComputeUtil</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Grant type used to establish the token. Select <strong>Authorization Code</strong>.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>URL of the ServiceNow instance in this format: https://&lt;instance&gt;.service-now.com/oauth_redirect.do.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**. The system validates the OAuth credentials.

**Create Credential record for the Google Compute Engine spoke**

Create Credential records to connect the Google Compute Engine custom OAuth application you created during account configuration. The Google Compute Engine spoke connection and credential aliases use these credentials to authorize actions.

Procedure

1. Navigate to **IntegrationHub > Connections & Credentials**.
2. Open record for the Google Compute Engine spoke. For example, **Google Compute**.
3. In the **Credentials** tab, click **New**.

4. Select **OAuth 2.0 Credentials**.

5. Enter a unique name for the credential, for example, **Google Compute Cred**.

6. Click the **OAuth Entity Profile** search icon (🔍) and select the profile with the name of the OAuth application registry you created when you registered the Google Compute Engine service as an OAuth provider.

7. Right-click the form header and click **Save**.

8. Click **Get Oauth Token**.

### Google Directory spoke v1.1.0

Manage groups, members, and users in Google Directory from your ServiceNow instance.

### Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

### IntegrationHub subscription

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

### Spoke dependencies

If you're having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Complex Object (com.glide.cobject)

⚠ **Note:** Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.
Google Directory account requirements

The Google Directory spoke requires a custom app that you create in the Google Developers Console.

Supported versions

This spoke was built for API version v1, but may be compatible with later versions.

Spoke actions

The Google Directory spoke provides actions to automate Google Directory when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Management</td>
<td>Create Group</td>
<td>Creates a group.</td>
</tr>
<tr>
<td></td>
<td>Delete Group</td>
<td>Deletes a group.</td>
</tr>
<tr>
<td></td>
<td>Get Group Details</td>
<td>Retrieves the details of the specified group.</td>
</tr>
<tr>
<td></td>
<td>List All Groups</td>
<td>Retrieves the details of all groups.</td>
</tr>
<tr>
<td></td>
<td>Look Up Groups</td>
<td>Searches for the required groups.</td>
</tr>
<tr>
<td></td>
<td>Update Group Details</td>
<td>Updates details of the specified group.</td>
</tr>
<tr>
<td>Member Management</td>
<td>Add Member To A Group</td>
<td>Adds member to the specified group.</td>
</tr>
<tr>
<td></td>
<td>Delete Member From A Group</td>
<td>Deletes a member from the group.</td>
</tr>
<tr>
<td></td>
<td>Get Member Details From A Group</td>
<td>Retrieves details of a member from the specified group.</td>
</tr>
<tr>
<td></td>
<td>List Members Of A Group</td>
<td>Retrieves list of members in a group.</td>
</tr>
<tr>
<td></td>
<td>Member Of A Group</td>
<td>Checks if a member is part of the specified group.</td>
</tr>
<tr>
<td></td>
<td>Update Member</td>
<td>Updates details of the specified member.</td>
</tr>
<tr>
<td>User Management</td>
<td>Create User</td>
<td>Creates a user.</td>
</tr>
<tr>
<td></td>
<td>Delete User</td>
<td>Deletes the specified user.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get User Details</td>
<td>Retrieves the details of the specified user.</td>
</tr>
<tr>
<td></td>
<td>Grant Admin To User</td>
<td>Grants admin privileges to the specified user.</td>
</tr>
<tr>
<td></td>
<td>List All Users</td>
<td>Retrieves the list of all users.</td>
</tr>
<tr>
<td></td>
<td>Look Up Users</td>
<td>Searches for the required users.</td>
</tr>
<tr>
<td>Reactivate User</td>
<td></td>
<td>Reactivates the specified user.</td>
</tr>
<tr>
<td></td>
<td>Note:</td>
<td>Exercise caution while using this action, as it may affect other user's</td>
</tr>
<tr>
<td></td>
<td></td>
<td>account.</td>
</tr>
<tr>
<td></td>
<td>Reset User Password</td>
<td>Resets the password of the user.</td>
</tr>
<tr>
<td></td>
<td>Note:</td>
<td>Exercise caution while using this action, as it may affect other user's</td>
</tr>
<tr>
<td></td>
<td></td>
<td>account.</td>
</tr>
<tr>
<td></td>
<td>Revoke Admin From User</td>
<td>Revokes the admin privileges of the specified user.</td>
</tr>
<tr>
<td></td>
<td>Suspend User</td>
<td>Suspends the specified user.</td>
</tr>
<tr>
<td></td>
<td>Note:</td>
<td>Exercise caution while using this action, as it may affect other user's</td>
</tr>
<tr>
<td>Update User Details</td>
<td></td>
<td>account.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

**Set up the Google Directory spoke**

Integrate the ServiceNow instance and Google Directory spoke by using G Suite credentials to authenticate ServiceNow requests.
Before you begin

- Request IntegrationHub subscription.
- Activate the Google Directory spoke.
- Role required: admin.

Configure the Google Directory application

Create a custom OAuth application from your Google G Suit account to enable OAuth 2.0 authentication with the Google Directory spoke.

Before you begin

Google Directory integration requirements:

- A domain and an email address associated with the domain. For example, www.mydomain.com and jane-admin@mydomain.com. Note that you can only register one email address per domain in G Suite.
- A Google G Suite or login created with the domain.

About this task

Complete these steps from the Google Developers Console. See the G Suite product documentation for instructions on creating and configuring custom applications.

Procedure

1. Register a new custom application. Navigate to https://console.developers.google.com, create a project with your G Suite administrator credentials, and open the project.
2. From the APIs & Services menu, select OAuth consent screen, enter the application name, and specify the Authorized domain service-now.com. Click Save.
3. From the APIs & Services menu, select Credentials, and select Create OAuth client ID from the Create credentials list.
4. Select the application type Web application.
5. Enter the following Authorized redirect URI: https://<instance>.service-now.com/oauth_redirect.do and click Create.
6. The OAuth client window shows your client ID and client secret. Copy these two values to a text file so that you can use them when you Register Google Directory as an OAuth provider.

The client ID and secret can always be accessed in the Google APIs & Services interface. Click Credentials and select the OAuth 2.0 client ID name.
Register Google Directory as an OAuth provider

Use the information generated during Google Directory account configuration to register the Google Directory application as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Procedure

1. In ServiceNow, navigate to System OAuth > Application Registry.
2. Open the record for Google Directory.
3. Enter these values in the Application Registries form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record, for example Google Directory.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID of the Google Directory application you created in G Suite.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret you generated when you created the application in G Suite.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Script to customize the request and response. Select OAuthGoogleDirectoryUtils</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Grant type used to establish the token. Select Authorization Code.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>URL of the ServiceNow instance in this format: https://&lt;instance&gt;.service-now.com/oauth_redirect.do.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click Save. The system validates the OAuth credentials.

Create Credential record for the Google Directory spoke

Create Credential records to connect the Google Directory custom OAuth application you created during account configuration. The Google Directory spoke connection and credential aliases use these credentials to authorize actions.
Procedure

1. Navigate to IntegrationHub > Connections & Credentials > Credentials and click New.
2. Select OAuth 2.0 Credentials.
3. Enter a unique name for the credential, for example, GDirectory Cred.
4. Click the OAuth Entity Profile search icon (🔍) and select the profile with the name of the OAuth application registry you created when you registered the Google Directory service as an OAuth provider.
5. Click Get Oauth Token.

Google Cloud DNS spoke

Manage public zones and private managed DNS zones in using Google Cloud DNS account from your ServiceNow instance.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions

This spoke was built for Google Cloud DNS API version v1, but may be compatible with later versions.

Spoke requirements

The Google Cloud DNS spoke requires a custom app that you create in Google Cloud Platform.

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
• Google Cloud Virtual Network spoke
• Google Identity and Access spoke

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke actions**
The Google Cloud DNS spoke provides actions to automate tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management</td>
<td>Create Change</td>
<td>Updates the resource record set collection.</td>
</tr>
<tr>
<td></td>
<td>Get Change</td>
<td>Retrieves the details of an existing change.</td>
</tr>
<tr>
<td></td>
<td>Look up Changes</td>
<td>Retrieves list of changes to a resource record set collection available with in the specified managed zone.</td>
</tr>
<tr>
<td>DNS Key Management</td>
<td>Get DNS Key</td>
<td>Retrieves details about an existing DNS key.</td>
</tr>
<tr>
<td></td>
<td>Look up DNS Keys</td>
<td>Retrieves list of DNS keys to a resource record set collection available with in the specified managed zone.</td>
</tr>
<tr>
<td>Managed Zone Management</td>
<td>Create Managed Zone For Private</td>
<td>Creates a managed private zone with private DNS records.</td>
</tr>
<tr>
<td></td>
<td>Create Managed Zone For Public</td>
<td>Creates a managed public zone.</td>
</tr>
<tr>
<td></td>
<td>Delete Managed Zone</td>
<td>Deletes the specified existing managed zone.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Get Managed Zone</td>
<td>Retrieves the details of the specified managed zone.</td>
</tr>
<tr>
<td></td>
<td>Look up Managed Zones</td>
<td>Retrieves list of managed zones available in the specified project.</td>
</tr>
<tr>
<td></td>
<td>Update Managed Zone For Private</td>
<td>Updates the details of the specified managed zone.</td>
</tr>
<tr>
<td></td>
<td>Update Managed Zone For Public</td>
<td>Updates the details of the specified managed zone.</td>
</tr>
<tr>
<td>Operation Management</td>
<td>Get Operation</td>
<td>Retrieves the details of an existing operation.</td>
</tr>
<tr>
<td></td>
<td>Look up Operations</td>
<td>Retrieves list of operations available within the specified managed zone.</td>
</tr>
<tr>
<td>Policy Management</td>
<td>Create Policy</td>
<td>Creates a policy.</td>
</tr>
<tr>
<td></td>
<td>Delete Policy</td>
<td>Deletes the specified policy.</td>
</tr>
<tr>
<td></td>
<td>Get Policy</td>
<td>Retrieves the details about the specified policy.</td>
</tr>
<tr>
<td></td>
<td>Look up Policies</td>
<td>Retrieves list of policies available within the specified project.</td>
</tr>
<tr>
<td></td>
<td>Update Policy</td>
<td>Updates details of the specified policy.</td>
</tr>
<tr>
<td>Project Management</td>
<td>Get Project</td>
<td>Retrieves the details about the specified project.</td>
</tr>
<tr>
<td>Resource Record Set Management</td>
<td>Look up Resource Record Sets</td>
<td>Retrieves list of resource record set collections available within the specified managed zone.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any...
actions that use the connection. For more information, see Connections and Credentials.

Set up the Google Cloud DNS spoke
Integrate the ServiceNow instance and Google Cloud DNS account by creating a custom OAuth application in Google Cloud Platform to authenticate ServiceNow requests.

Before you begin
- Request an IntegrationHub subscription.
- Activate Google Cloud DNS spoke.
- Role required: admin

Configure the Google Cloud Functions application
Create a custom OAuth application in your Google Cloud Platform account to enable OAuth 2.0 authentication with the Google Cloud DNS spoke.

About this task
Complete these steps from the Google Cloud Platform. See the Google Cloud Platform product documentation for instructions on creating and configuring custom applications.

Procedure
1. Register a new custom application. Navigate to https://console.cloud.google.com/, create a project with your administrator credentials, and open the project.
2. From the APIs & Services menu, select OAuth consent screen, enter the application name, and specify the Authorized domain service-now.com. Click Save.
3. From the APIs & Services menu, select Credentials, and select Create OAuth client ID from the Create credentials list.
4. Select the application type OAuth client ID.
5. Enter the following Authorized redirect URI: https://<instance>.service-now.com/oauth_redirect.do and click Create.
6. The OAuth client window shows your client ID and client secret. Copy these two values to a text file so that you can use them when you Register Google Cloud Functions as an OAuth provider. The client ID and secret can always be accessed in the Google APIs & Services interface. Click Credentials and select the OAuth 2.0 client ID name.
Register Google Cloud DNS as an OAuth provider

Use the information generated during the Google Cloud DNS application configuration to register Google Cloud Functions as an OAuth provider and allow the ServiceNow instance to request OAuth 2.0 tokens.

Procedure
1. Navigate to System OAuth > Application Registry.
2. Open for the record, Google Cloud DNS.
3. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Client ID of the Google Cloud Functions application.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret of the Google Cloud Functions application.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint in this format: https://&lt;instance&gt;.service-now.com/oauth_redirect.do</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click Save.

Create a credential record for the Google Cloud DNS spoke

Create a credential record for the Google Cloud Functions application. The Google Cloud Functions spoke connection and credential alias uses these credentials to authorize actions.

Procedure
1. Navigate to Connections & Credentials > Connections & Credential Aliases.
2. Open record for the Google Cloud DNS spoke. For example, GoogleCloudDNS.
3. In the Credentials tab, click New.
4. Select OAuth 2.0 Credentials.
5. Enter a unique name for the credential, for example, GCloud_DNS_Cred.
6. Click the OAuth Entity Profile search icon (🔍) and select the profile with the name of the OAuth application registry you configured when you registered the Google Cloud Functions service as an OAuth provider. See Register Google Cloud Functions as an OAuth provider for more information.
7. Right-click the form header and click Save.
8. Click Get OAuth Token.

**Google Docs spoke**
Manage documents in Google Docs from your ServiceNow instance.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Supported versions**
This spoke was built for Google Docs v1, but may be compatible with later versions.

**Spoke requirements**
Google Cloud account

**Spoke dependencies**
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

⚠️ **Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke actions**
The Google Docs spoke provides actions to automate Google Docs tasks when events occurs in your ServiceNow instance. Available actions include:
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Create Footer</td>
<td>Creates a footer in the specified document.</td>
</tr>
<tr>
<td></td>
<td>Create Header</td>
<td>Creates a header in the specified document.</td>
</tr>
<tr>
<td></td>
<td>Get Document Details</td>
<td>Retrieves the structure of the specified document as a JSON object.</td>
</tr>
<tr>
<td></td>
<td>Search Text in Document</td>
<td>Searches for the required document based on the search text or content.</td>
</tr>
<tr>
<td></td>
<td>Update Document</td>
<td>Updates the content of a document with the provided HTML content.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

**Set up the Google Docs**

Integrate the ServiceNow instance and Google Docs by creating a custom OAuth application in G Suite credentials to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription.
- Activate Google Docs spoke.
- Role required: admin

**Register Google Docs as an OAuth provider**

Register G Suite as the OAuth provider so that the ServiceNow instance can request OAuth 2.0 tokens.
Procedure

1. Navigate to System OAuth > Application Registry.

2. Click New.
   The system displays the message what kind of OAuth application?.

3. Select Connect to a third party OAuth Provider.

4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record, for example Google Docs.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID of the Google Directory application you created in G Suite.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret you generated when you created the application in G Suite.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Script to customize the request and response to the external OAuth provider.</td>
</tr>
<tr>
<td>Logo URL</td>
<td>The OAuth application logo URL.</td>
</tr>
<tr>
<td>Default Grant Type</td>
<td>The default grant type used to establish the token. Select Authorisation Code.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>Time, in seconds, that the refresh token is valid. The default time is 8,640,0000 seconds.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Option to make the app accessible from all application scopes or from this scope only.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to make the app active.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>The OAuth authorization code endpoint.</td>
</tr>
<tr>
<td>Token URL</td>
<td>The OAuth server token endpoint.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>The OAuth callback endpoint. If left blank, the instance auto-generates the URL.</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>The OAuth server token revocation endpoint.</td>
</tr>
</tbody>
</table>

5. Go to the related list on the record OAuth Entity Profiles to validate a system-generated default profile for the G Suite OAuth provider without any scope.
6. Go to the related list on the record OAuth Entity Scopes to define all available OAuth scopes for this OAuth provider.

7. Right-click the form header, and click **Save**. The system validates the OAuth credentials.

**Create Credential record for the Google Docs**

Create credential record for the Google Docs custom application. The Google Docs connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to **Connections & Credentials > Credentials**.

2. Click **New**. The system displays the message **What type of Credentials would you like to create?**.

3. Select **OAuth 2.0 Credentials**

4. Enter a unique name for the credential, for example **Google Docs Credential**.

5. Click the **OAuth Entity Profile** search icon (🔍) and select the profile with the name of the OAuth application registry you created when you registered the Google Docs service as an OAuth provider.

6. Click **Get OAuth Token**.

**Google Drive spoke v1.3.0**

Use Google Drive as file storage in place of attachments in ServiceNow. Adds Google Drive storage to your ServiceNow instance and enables users to reference Google Drive files in ServiceNow records.

**Request apps on the Store**

Visit the **ServiceNow Store** website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the **ServiceNow Store version history release notes**.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Professional subscription package. For more information, see **Request IntegrationHub**.
Supported versions
API version v1.

Spoke subflows
The Google Drive spoke provides sample subflows in the draft state to demonstrate automating Google Drive tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move a ServiceNow attachment to Google Drive</td>
<td>Copies an attachment from ServiceNow to Google Drive, records the new location of the attachment, and deletes the attachment from the ServiceNow attachment table.</td>
</tr>
</tbody>
</table>

Spoke actions
The Google Drive spoke provides actions to perform Google Drive tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File and Folder Management</td>
<td>Copy Attachment to Drive</td>
<td>Copies a ServiceNow attachment to a Google Drive folder. It either copies to the root drive of the current account or to the specified folder. To change the file name during the copy, use the optional file name.</td>
</tr>
<tr>
<td></td>
<td>Copy Doc File To Attachment</td>
<td>Copies a file Google Drive and attaches it to a ServiceNow record.</td>
</tr>
<tr>
<td></td>
<td>Copy Drive File</td>
<td>Creates a copy of a Google Drive File and applies any metadata updates like a change in file name, file description, parent folder location, if file is starred, or shared by users with writer permissions.</td>
</tr>
<tr>
<td></td>
<td>Copy Drive File To Attachment</td>
<td>Copies a drive file to a ServiceNow attachment. If a ServiceNow record is supplied as input, the record should be attached to it.</td>
</tr>
<tr>
<td></td>
<td>Create Folder</td>
<td>Creates a Google Drive folder that can be nested within other folders.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Delete Drive File Or Folder</td>
<td>Permanently deletes a drive file or folder owned by the Google Drive account user without moving it to the trash. To delete folders the user must be the owner of folder and its contents</td>
</tr>
<tr>
<td></td>
<td>Look up Files and Folders Stream</td>
<td>Retrieves the list of files and folders.</td>
</tr>
<tr>
<td></td>
<td>Look Up Folders</td>
<td>Returns a list of Google Drive folder IDs based on given search parameters.</td>
</tr>
<tr>
<td></td>
<td>Update Attachment To Drive</td>
<td>Updates the contents of a file, but maintains the previous versions and metadata. This action only updates the content of the Google Drive file. It does not update metadata.</td>
</tr>
<tr>
<td></td>
<td>Update File Or Folder Metadata</td>
<td>Updates the metadata on a file or folder. This can be a file name change, change to the file description, a move to a new parent folder, a change in starred status, or a change to sharing permissions.</td>
</tr>
<tr>
<td>Permission</td>
<td>Create File or Folder Permission</td>
<td>Adds a permission to a given user, group, domain, or anyone for a file or folder. If User or Group is selected, the email address is required for those users and groups. If Domain is selected, the domain name is required. If Anyone is selected, then anyone has permissions to the file or folder.</td>
</tr>
<tr>
<td>Management</td>
<td>Delete File Or Folder Permission</td>
<td>Removes a permission to a given user, group, domain, or anyone for a file or folder.</td>
</tr>
<tr>
<td></td>
<td>Look Up File Or Folder Permissions By ID</td>
<td>Returns the list of permissions associated with a particular file or folder.</td>
</tr>
<tr>
<td></td>
<td>Look up Permissions Stream</td>
<td>Retrieves the list of files or shared drives permissions.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Transfer Ownership Of All User Data</td>
<td>Transfers the ownership of data from one user to another within a domain. All previous permissions of old owner are removed and new owner permissions are created for new user.</td>
</tr>
<tr>
<td></td>
<td>Update File Or Folder Permission</td>
<td>Updates a given permission by updating the role.</td>
</tr>
</tbody>
</table>

**Google Drive Online account requirements**

The Google Drive spoke requires a custom app that you create in Google Drive Enterprise or Google G Suite.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Google Drive alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

**Set up Google Drive spoke**

Integrate a ServiceNow instance and Google Drive spoke by using Google Drive credentials to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription.
- Activate the Google Drive spoke.
- Role required: admin

**Configure Google Drive application**

Create a custom OAuth application from your Google Drive account to enable OAuth 2.0 authentication with the Google Drive spoke.
Before you begin
Google Drive integration requirements:

• A domain and an email address associated with the domain. For example, www.mydomain.com and jane-admin@mydomain.com. Note that you can only register one email address per domain in GSuite or Google Drive.

• A Google G Suite or Google Drive login created with the domain.

• A Google Drive account.

About this task
Complete these steps from your Google G Suite or Google Drive account. See the G Suite product documentation for instructions on creating and configuring custom applications.

Procedure


2. Enter your business name, the number of employees, and your country, and click Next.

3. Enter the administrator contact name, email address and business phone number, and click Next.

4. Enter the domain associated with this spoke.

5. Provide the user name and password for your domain.

6. Add users to the G Suite account.

7. Verify your domain and email address.
   Users must create their own logins by navigating to the Google documentation.


9. Search for the Google Drive API and enable it.

10. Create a Credentials application and save the Client ID and Client secret. The Client Secret is only displayed in plain text for a short time. Copy the Client ID and the Client Secret to a text file so that you can use them when you Register Google Drive as an OAuth provider.
Register Google Drive as an OAuth provider

Use the information generated during Google Drive account configuration to register the Google Drive application as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Procedure

1. In ServiceNow, navigate to System OAuth > Application Registry.
2. Click New.
3. On the screen titled What kind of OAuth application, select Connect to a third-party OAuth Provider.
4. Enter these values in the Application Registries form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record, for example GoogleDrive.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Enter the Client ID of the Google Drive application you created in G Suite.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Client Secret you generated when you created the application in G Suite.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Click the search icon (🔍) and select OAuthUtilGoogleDrive.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select Authorization Code.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>Click the lock icon (🔒), enter <a href="https://accounts.google.com/o/oauth2/auth">https://accounts.google.com/o/oauth2/auth</a>, and then click the lock icon again.</td>
</tr>
<tr>
<td>Token URL</td>
<td>Click the lock icon (🔒), enter <a href="https://www.googleapis.com/oauth2/v4/token">https://www.googleapis.com/oauth2/v4/token</a>, and then click the lock icon again.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>Click the lock icon (🔒), enter https://&lt;instance&gt;.service-now.com/oauth_redirect.do, and then click the lock icon again.</td>
</tr>
</tbody>
</table>

5. Optional: In the OAuth Entity Scopes related list, add any scopes required by your application. The Google Drive spoke includes these scopes by default:
   - appdata
   - drive
• drivereadonly
• file
• filetransfer
• metadata
• metadatapersonal
• photosreadonly
• scripts
• user

Click **Insert a new row** and enter the name and the OAuth scope of the permission. The name and the OAuth scope are often the same.

---

<table>
<thead>
<tr>
<th>OAuth Entity Scopes</th>
<th>OAuth scope</th>
</tr>
</thead>
</table>
| ![Icon](
<table>
<thead>
<tr>
<th>Name</th>
<th>OAuth scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendars.ReadWrite</td>
<td>Calendars.ReadWrite</td>
</tr>
<tr>
<td>Calendars.ReadWrite.Shared</td>
<td>Calendars.ReadWrite.Shared</td>
</tr>
<tr>
<td>email</td>
<td>email</td>
</tr>
<tr>
<td>Files.Read</td>
<td>Files.Read</td>
</tr>
<tr>
<td>Files.Read.All</td>
<td>Files.Read.All</td>
</tr>
</tbody>
</table>

---

6. Right-click the form header, and click **Save**. The system validates the OAuth credentials.

Create Credential record for the Google Drive spoke

Create Credential records to connect the Google Drive custom OAuth application you created during Google Drive account configuration. The Google Drive spoke connection and credential aliases use these credentials to authorize actions.

Procedure

1. Navigate to **IntegrationHub > Connections & Credentials > Credentials** and click **New**.
2. Select **OAuth 2.0 Credentials**.
3. Enter a unique name for the credential, for example, `gDrive Cred`.

4. Click the OAuth Entity Profile search icon (🔍) and select the profile with the name of the OAuth application registry you created when you registered the Google Drive service as an OAuth provider.

5. Click Get OAuth Token.

**Create Connection record for the Google Drive spoke**

Create connection records to a Google Drive account. A connection alias resolves your Google Drive connection and credential at runtime. Only one connection is active per Connection Alias at a time.

**Procedure**

1. Navigate to Connections & Credentials > Connection & Credential Aliases.

2. Select the Google Drive connection.

3. On the Connection Attributes related list, set the default value of the API version to `v3`.
   If there are no connection attributes, click **New** and create a connection attribute with this information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>API version</td>
</tr>
<tr>
<td>Column name</td>
<td>u_api_version</td>
</tr>
<tr>
<td>Mandatory</td>
<td>False</td>
</tr>
<tr>
<td>Read only</td>
<td>False</td>
</tr>
<tr>
<td>Type</td>
<td>String</td>
</tr>
<tr>
<td>Reference</td>
<td>(empty)</td>
</tr>
<tr>
<td>Default value</td>
<td>v3</td>
</tr>
</tbody>
</table>

4. In the Connections related list, select **gDrive Connection**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name gDrive Connection.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential name you specified when you created the Credential record. The value used in the steps above is gDrive Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Select the value sn_googledrive_spoke.Google_Drive</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Enter the URL <a href="https://www.googleapis.com/">https://www.googleapis.com/</a>.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select Client Credentials.</td>
</tr>
</tbody>
</table>

5. Return to IntegrationHub > Connections & Credentials > Credentials and select googledrive_cred.

6. From Related Links, click Get OAuth Token.
   A confirmation message indicates that the OAuth token flow has completed successfully. Review the details if the flow is not successful.

   Note: Ensure that you allow pop-up windows in your browser.

Results
The Google Drive spoke is set up and integrated with the ServiceNow instance.

Google Hangouts spoke v 1.0.2
Use ServiceNow to create and update events and attendees in Google Hangouts.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.
Supported versions
API version v1.

Spoke actions
The Google Hangouts spoke provides actions to perform Google Hangouts tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attendees</td>
<td>Add Attendees To Hangout</td>
<td>Updates a hangout by adding to the list of attendees. Values you specify replace the existing values. Fields that you don’t specify in the request do not change.</td>
</tr>
<tr>
<td></td>
<td>Remove Attendees From Hangout</td>
<td>Updates a hangout by removing specified attendees. Values you specify replace the existing values. Fields that you don’t specify in the request do not change.</td>
</tr>
<tr>
<td>Event Management</td>
<td>Create Hangout</td>
<td>Creates a hangout on the specified calendar.</td>
</tr>
<tr>
<td></td>
<td>Update Hangout</td>
<td>Edit hangout information. Values you specify replace the existing values. Fields that you don’t specify in the request do not change.</td>
</tr>
<tr>
<td></td>
<td>Get Hangout By ID</td>
<td>Returns the specified hangout.</td>
</tr>
<tr>
<td></td>
<td>Delete Hangout</td>
<td>Removes a specified hangout from a calendar.</td>
</tr>
</tbody>
</table>

Google Hangouts Online account requirements
The Google Hangouts spoke requires a custom app that you create in Google G Suite.

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.
**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Google Hangouts alias to configure where actions run as well as set MID Server selection attributes. For more information, see [MID server](#).

**Set up Google Hangouts spoke**

Integrate a ServiceNow instance and Google Hangouts by using G Suite credentials to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription.
- Activate the Google Hangouts spoke.
- Role required: admin

**Configure Google Hangouts application**

Create a custom OAuth application from your G Suite account to enable OAuth 2.0 authentication with the Google Hangouts spoke.

**Before you begin**

Google Hangouts integration requirements:

- A domain and an email address associated with the domain. For example, www.mydomain.com and jane-admin@mydomain.com. Note that you can only register one email address per domain in G Suite.
- A Google G Suite or login created with the domain.

**About this task**

Complete these steps from your Google G Suite account. See the G Suite product documentation for instructions on creating and configuring custom applications.

**Procedure**

1. Register a new custom application. Navigate to [https://console.developers.google.com](https://console.developers.google.com), create a project with your G Suite administrator credentials, and open the project.

2. From the APIs & Services menu, select **OAuth consent screen**, enter the application name, and specify the Authorized domain service-now.com. Click **Save**.

3. Search for the Google Hangouts API and enable it.
4. From the APIs & Services menu, select **Credentials**, and select **Create OAuth client ID** from the **Create credentials** list.

5. Select the application type **Web application**.

6. Enter the following Authorized redirect URI: `https://<instance>.service-now.com/oauth_redirect.do` and click **Create**.
   This redirect URI must match the **Redirect URL** you provide when you **Register Google Hangouts as an OAuth provider**.

7. The OAuth client window shows your client ID and client secret. Copy these two values to a text file so that you can use them when you **Register Google Tasks as an OAuth provider**.
   The client ID and secret can always be accessed in the Google APIs & Services interface. Click **Credentials** and select the OAuth 2.0 client ID name.

**Register Google Hangouts as an OAuth provider**

Use the information generated during Google Hangouts account configuration to register the Google Hangouts application as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

**Procedure**

1. In ServiceNow, navigate to **System OAuth > Application Registry**.

2. Click **New**.

3. On the screen titled **What kind of OAuth application**, select **Connect to a third-party OAuth Provider**.

4. Enter these values in the Application Registries form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record, for example Google Hangouts.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Enter the Client ID of the Google Hangouts application you created in G Suite.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Client Secret you generated when you created the application in G Suite.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Click the search icon (🔍) and select OAuthHangoutsRefreshTokenUtil</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select <strong>Authorization Code</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>Click the lock icon ☰️, enter <a href="https://accounts.google.com/o/oauth2/auth">https://accounts.google.com/o/oauth2/auth</a>, and then click the lock icon again.</td>
</tr>
<tr>
<td>Token URL</td>
<td>Click the lock icon ☰️, enter <a href="https://www.googleapis.com/oauth2/v4/token">https://www.googleapis.com/oauth2/v4/token</a>, and then click the lock icon again.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>Click the lock icon ☰️, enter https://&lt;instance&gt;.service-now.com/oauth_redirect.do, and then click the lock icon again.</td>
</tr>
</tbody>
</table>

5. **Optional:** In the **OAuth Entity Scopes** related list, add any scopes required by your application. The Google Hangouts spoke includes these scopes by default:

<table>
<thead>
<tr>
<th>Name</th>
<th>OAuth Scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar</td>
<td><a href="https://www.googleapis.com/auth/calendar">https://www.googleapis.com/auth/calendar</a></td>
</tr>
<tr>
<td>Events</td>
<td><a href="https://www.googleapis.com/auth/calendar.events">https://www.googleapis.com/auth/calendar.events</a></td>
</tr>
</tbody>
</table>

6. Right-click the form header, and click **Save**.
The system validates the OAuth credentials.

**Create Credential record for the Google Hangouts spoke**

Create Credential records to connect the Google Hangouts custom OAuth application you created during account configuration. The Google Hangouts spoke connection and credential aliases use these credentials to authorize actions.

**Procedure**

1. Navigate to **IntegrationHub > Connections & Credentials > Credentials** and click **New**.
2. Select OAuth 2.0 Credentials.
3. Enter a unique name for the credential, for example, **Hangout Cred**.
4. Click the OAuth Entity Profile search icon (🔍) and select the profile with the name of the OAuth application registry you created when you registered the Google Hangouts service as an OAuth provider.

5. Click Get OAuth Token.

Create Connection record for the Google Hangouts spoke

Create connection records to a Google Hangouts account. A connection alias resolves your Google Hangouts connection and credential at runtime. Only one connection is active per Connection Alias at a time.

About this task
You should provide a single Credential and Connection Alias for all G Suite service spokes.

Procedure
1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Select the Google Hangouts connection.
3. On the Connection Attributes related list, set the default value of the API version to v3.
   If there are no connection attributes, click New and create a connection attribute with this information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>API version</td>
</tr>
<tr>
<td>Column name</td>
<td>u_api_version</td>
</tr>
<tr>
<td>Mandatory</td>
<td>False</td>
</tr>
<tr>
<td>Read only</td>
<td>False</td>
</tr>
<tr>
<td>Type</td>
<td>String</td>
</tr>
<tr>
<td>Reference</td>
<td>(empty)</td>
</tr>
<tr>
<td>Default value</td>
<td>v3</td>
</tr>
</tbody>
</table>

4. In the Connections related list, select the Google Hangouts Connection.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name Google Hangouts Connection.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential name you specified when you created the Credential record. The value used in the preceding steps is Hangouts Cred.</td>
</tr>
<tr>
<td>Connection</td>
<td>alias</td>
</tr>
<tr>
<td>Connection</td>
<td>URL</td>
</tr>
<tr>
<td></td>
<td>Enter the URL <a href="https://www.googleapis.com/">https://www.googleapis.com/</a></td>
</tr>
</tbody>
</table>

5. Return to IntegrationHub > Connections & Credentials > Credentials and select googlehangouts_cred.

6. From Related Links, click Get OAuth Token.
   A confirmation message indicates that the OAuth token flow has completed successfully. Review the details if the flow is not successful.

   ⚠️ Note: Ensure that you allow pop-up windows in your browser.

Results
The Google Hangouts spoke is set up and integrated with the ServiceNow instance.

Google Identity and Access spoke
Manage folders, projects, roles, and service accounts in Google Identity and Access Management and Google Resource Manager.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow IntegrationHub Action Step - REST
  (com.glide.hub.action_step.rest)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• Complex Object (com.glide.cobject)

⚠️ Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported Versions
This spoke was built for API version v2 only Folder Management category and v1 for other categories, but may be compatible with later versions.

Spoke requirements
• Google Cloud Platform account

Spoke flows and subflows
This spoke has no flows and subflows.

Spoke actions
The Google Identity and Access spoke provides actions to automate Google Identity and Access Management and Google Resource Manager tasks when events occur in ServiceNow. For the spoke actions to be performed, you must ensure that your project or organization in Google Cloud Platform has the mentioned permissions. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
<th>Required Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder Management</td>
<td>Create Folder</td>
<td>Creates a folder.</td>
<td>resourcemanager.folders.create</td>
</tr>
<tr>
<td></td>
<td>Delete Folder</td>
<td>Deletes a folder.</td>
<td>resourcemanager.folders.delete</td>
</tr>
<tr>
<td></td>
<td>Get Child Folder</td>
<td>Retrieves the information of a child folder.</td>
<td>resourcemanager.folders.get</td>
</tr>
<tr>
<td></td>
<td>List Folders</td>
<td>Retrieves the list of folders.</td>
<td>resourcemanager.folders.list</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
<td>Required Permission</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------</td>
<td>----------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Rename Folder</td>
<td>Rename Folder</td>
<td>Renames the specified folder.</td>
<td>resourcemanager.folders.update</td>
</tr>
<tr>
<td>Restore Folder</td>
<td>Restore Folder</td>
<td>Restores the specified folder.</td>
<td>resourcemanager.folders.undelete</td>
</tr>
<tr>
<td>Organization Management</td>
<td>Get Organization</td>
<td>Retrieves details of the specified organization.</td>
<td>resourcemanager.organizations.get</td>
</tr>
<tr>
<td>Project Management</td>
<td>Create Project</td>
<td>Creates a project.</td>
<td>resourcemanager.projects.create</td>
</tr>
<tr>
<td></td>
<td>Delete Project</td>
<td>Deletes the specified project.</td>
<td>resourcemanager.projects.delete</td>
</tr>
<tr>
<td></td>
<td>Get Project</td>
<td>Retrieves details of the specified project.</td>
<td>resourcemanager.projects.get</td>
</tr>
<tr>
<td></td>
<td>List Projects</td>
<td>Retrieves the list of projects.</td>
<td>resourcemanager.projects.list</td>
</tr>
<tr>
<td></td>
<td>Rename Project</td>
<td>Renames the specified project.</td>
<td>resourcemanager.projects.update</td>
</tr>
<tr>
<td></td>
<td>Restore Project</td>
<td>Restores the specified project.</td>
<td>resourcemanager.projects.undelete</td>
</tr>
<tr>
<td>Role Management</td>
<td>Create Role For Organization</td>
<td>Creates a custom role for an organization.</td>
<td>iam.roles.create</td>
</tr>
<tr>
<td></td>
<td>Create Role For Project</td>
<td>Creates a custom role for the specified project.</td>
<td>iam.roles.create</td>
</tr>
<tr>
<td></td>
<td>Delete Role For Organization</td>
<td>Deletes a custom role for the specified organization.</td>
<td>iam.roles.delete</td>
</tr>
<tr>
<td></td>
<td>Delete Role For Project</td>
<td>Deletes a custom role for the specified project.</td>
<td>iam.roles.delete</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
<td>Required Permission</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------</td>
<td>-----------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get Role For Organization</td>
<td>Retrieves details of the custom role for the specified organization.</td>
<td>iam.roles.get</td>
</tr>
<tr>
<td></td>
<td>Get Role For Project</td>
<td>Retrieves details of the custom role for the specified project.</td>
<td>iam.roles.get</td>
</tr>
<tr>
<td></td>
<td>List Roles In Organization</td>
<td>Retrieves the list of custom roles for the specified organization.</td>
<td>iam.roles.list</td>
</tr>
<tr>
<td></td>
<td>List Roles In Project</td>
<td>Retrieves the list of custom roles for the specified project.</td>
<td>iam.roles.list</td>
</tr>
<tr>
<td></td>
<td>Restore Role For Organization</td>
<td>Restores the specified custom role for an organization.</td>
<td>iam.roles.undelete</td>
</tr>
<tr>
<td></td>
<td>Restore Role For Project</td>
<td>Restores the specified custom role for a project.</td>
<td>iam.roles.undelete</td>
</tr>
<tr>
<td>Service Account</td>
<td>Get Service Account</td>
<td>Retrieves the details of the specified service account.</td>
<td>iam.serviceAccounts.get</td>
</tr>
<tr>
<td>Management</td>
<td>List Service Accounts</td>
<td>Retrieves the list of service accounts in a project.</td>
<td>iam.serviceAccounts.list</td>
</tr>
</tbody>
</table>

For more information about the required permissions, see IAM permissions reference.
Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the Google Identity and Access Spoke

Integrate the ServiceNow instance and Google Identity and Access spoke by using Google Cloud Platform credentials to authenticate ServiceNow requests.

Before you begin
- Request IntegrationHub subscription
- Activate the Google Identity and Access spoke
- Role required: admin

Configure the Google Identity and Access application

Create a custom OAuth application from your Google Cloud Platform account to enable OAuth 2.0 authentication with the Google Identity and Access spoke.

Before you begin
- Google Identity and Access integration requirements:
  - Google Cloud Platform account

About this task
Complete these steps from the Google Cloud Platform.

Procedure

1. Register a new custom application. Navigate to https://console.developers.google.com, create a project with your Google Cloud Platform administrator credentials, and open the project.

2. From the APIs & Services menu, select OAuth consent screen, enter the application name, and specify the Authorized domain service-now.com. Click Save.

3. From the APIs & Services menu, select Credentials, and select Create OAuth client ID from the Create credentials list.

4. Select the application type Web application.
5. Enter the following Authorized redirect URI: `https://<instance>.service-now.com/oauth_redirect.do` and click Create.

6. The OAuth client window shows your client ID and client secret. Copy these two values to a text file so that you can use them when you Register Google Identity and Access as an OAuth provider.

The client ID and secret can always be accessed in the Google APIs & Services interface. Click Credentials and select the OAuth 2.0 client ID name.

Register Google Identity and Access as an OAuth provider

Use the information generated during Google Identity and Access account configuration to register the Google Identity and Access application as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Procedure

1. In ServiceNow instance, navigate to System OAuth > Application Registry.
2. Open the record for Google Identity and Access.
3. On the form, fill these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record, for example Google Identity and Access.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID of the Google Identity and Access application.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret you generated when you create the application.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Script to customize the request and response. Select OAuthGoogleIAMUtil.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Grant type used to establish the token. Select Authorization Code.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>URL of the ServiceNow instance in this format: https://&lt;instance&gt;.service-now.com/oauth_redirect.do</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**. The system validates the OAuth credentials.

**Create Credential record for the Google Identity and Access spoke**

Create Credential records to connect the Google Identity and Access custom OAuth application you created during account configuration. The Google Identity and Access spoke connection and credential aliases use these credentials to authorize actions.

**Procedure**

1. Navigate to **IntegrationHub > Connections & Credentials > Credentials** and click **New**.
2. Select OAuth 2.0 Credentials.
3. Enter a unique name for the credential, for example, **GCPIAM Cred**.
4. Click the **OAuth Entity Profile** search icon (🔍) and select the profile with the name of the OAuth application registry you created when you registered the Google Identity and Access service as an OAuth provider.
5. Click **Get Oauth Token**.

**Google Persistent Disk spoke**

Manage disks, snapshots, and images in Google Persistent Disk from your ServiceNow instance.

**Request apps on the Store**

Visit the **ServiceNow Store** website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the **ServiceNow Store version history release notes**.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see **Request IntegrationHub**.
Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Complex Object (com.glide.cobject)
- Google Cloud Virtual Network spoke (sn_gcp_vpc_spoke)
- Google Compute Engine spoke (sn_gcompute_spoke)

⚠️ Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Google Persistent Disk account requirements
The Google Persistent Disk spoke requires a custom app that you create in the Google Cloud Platform.

Supported versions
This spoke was built for API version v1, but may be compatible with later versions.

Spoke actions
The Google Persistent Disk spoke provides actions to automate Google Persistent Disk when events occur in ServiceNow. For the spoke actions to be performed, you must ensure that your project or organization in Google Cloud Platform has the mentioned permissions. Available spoke actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
<th>Permissions Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk Management</td>
<td>Create Disk</td>
<td>Creates a persistent disk in the specified project.</td>
<td>compute.disks.create</td>
</tr>
<tr>
<td></td>
<td>Delete Disk</td>
<td>Deletes the specified persistent disk.</td>
<td>compute.disks.delete</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
<td>Permissions Required</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get Disk</td>
<td>Retrieves details of the specified persistent disk.</td>
<td>compute.disks.get</td>
</tr>
<tr>
<td></td>
<td>Get Disk Type by Zone</td>
<td>Retrieves the details of the specified disk type by zone.</td>
<td>compute.diskTypes.get</td>
</tr>
<tr>
<td></td>
<td>Resize Disk</td>
<td>Resizes the specified persistent disk.</td>
<td>compute.disks.resize</td>
</tr>
<tr>
<td></td>
<td>Image Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Create Image for Disk</td>
<td>Creates an image in the specified project.</td>
<td>compute.images.create</td>
</tr>
<tr>
<td></td>
<td>Create Image for Image</td>
<td>Creates an image in the specified project.</td>
<td>compute.images.create</td>
</tr>
<tr>
<td></td>
<td>Create Image for Snapshot</td>
<td>Creates an image in the specified project.</td>
<td>compute.images.create</td>
</tr>
<tr>
<td></td>
<td>Delete Image</td>
<td>Deletes the specified image.</td>
<td>compute.images.delete</td>
</tr>
<tr>
<td></td>
<td>Get Image</td>
<td>Retrieves details of the specified image.</td>
<td>compute.images.get</td>
</tr>
<tr>
<td></td>
<td>Metadata Retrieval Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>List Disk Types by Zone</td>
<td>Retrieves a list of disk types available to the specified project.</td>
<td>compute.diskTypes.list</td>
</tr>
<tr>
<td></td>
<td>List Disks</td>
<td>Retrieves a list of persistent disks contained within the specified zone.</td>
<td>compute.disks.list</td>
</tr>
<tr>
<td></td>
<td>List Images</td>
<td>Retrieves the list of images available to the specified project.</td>
<td>compute.images.list</td>
</tr>
<tr>
<td></td>
<td>List Snapshots</td>
<td>Retrieves the list of snapshot resources</td>
<td>compute.snapshots.list</td>
</tr>
</tbody>
</table>

(continued)
(continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
<th>Permissions Required</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>contained within the specified project.</td>
<td></td>
</tr>
<tr>
<td>Snapshot Management</td>
<td>Create Snapshot</td>
<td>Creates a snapshot of a specified persistent disk.</td>
<td>compute.snapshots.create</td>
</tr>
<tr>
<td></td>
<td>Delete Snapshot</td>
<td>Deletes the specified snapshot resource.</td>
<td>compute.snapshots.delete</td>
</tr>
<tr>
<td></td>
<td>Get Snapshot</td>
<td>Retrieves details of the specified snapshot.</td>
<td>compute.snapshots.get</td>
</tr>
</tbody>
</table>

For more information about the required permissions, see IAM permissions reference.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the Google Persistent Disk spoke**

Integrate the ServiceNow instance and Google Persistent Disk spoke by using G Suite credentials to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription.
- Activate the Google Persistent Disk spoke.
- Activate and set up the Google Compute Engine spoke.
- Role required: admin.

**Procedure**

1. Navigate to IntegrationHub > Connections & Credentials > Credentials.
2. Open record for the Google Compute Engine spoke. For example, Google Compute Cred.
3. For **Credential alias**, select the Connection and Credential alias record of the Google Persistent Disk spoke.

4. Right-click the form header and click **Save**.

5. Click **Get Oauth Token**.

**Google Sheets spoke v1.0.3**
Manage spreadsheets in Google Sheets from your ServiceNow instance.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Spoke dependencies**
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

⚠️ **Note:** Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

**Supported versions**
This spoke was built for Google Sheets v4, but may be compatible with later versions.

**Spoke requirements**
- Google Cloud Platform account
**Spoke actions**

The Google Sheets spoke provides actions to automate Google Sheets tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sheet Management</td>
<td>Add Row</td>
<td>Adds a row with the specified values to a sheet.</td>
</tr>
<tr>
<td></td>
<td>Clear Cells</td>
<td>Clears the values in the sheet for the specified range.</td>
</tr>
<tr>
<td></td>
<td>Copy Sheet</td>
<td>Copies a sheet from a spreadsheet to another spreadsheet.</td>
</tr>
<tr>
<td></td>
<td>Create Sheet</td>
<td>Creates a sheet in the specified spreadsheet.</td>
</tr>
<tr>
<td></td>
<td>Delete Sheet</td>
<td>Deletes a sheet in the spreadsheet.</td>
</tr>
<tr>
<td></td>
<td>Get Cell Values</td>
<td>Retrieves the values in the sheet for the specified range.</td>
</tr>
<tr>
<td></td>
<td>Update Cells</td>
<td>Updates a range of cell values in a sheet.</td>
</tr>
<tr>
<td>Spreadsheet Management</td>
<td>Get Spreadsheet</td>
<td>Retrieves details about the specified spreadsheet.</td>
</tr>
<tr>
<td></td>
<td>Details</td>
<td></td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the Google Sheets spoke**

Integrate the ServiceNow instance and Google Sheets by creating a custom OAuth application in Google API Console to authenticate ServiceNow requests.
Before you begin
• Request IntegrationHub subscription.
• Activate Google Sheets spoke.
• Role required: admin

Create a Connection and Credential Alias for Google Sheets spoke
Create Connection records to your Google Sheets account. The Google Sheets spoke connection and credential aliases use these connections to perform actions in the Google Sheets.

Before you begin
• Register your application using Google API Console and record the client ID and client secret. For more information, see Google Authorize Requests.
• Role required: admin

Procedure
1. Navigate to IntegrationHub > Connections & Credentials > Connection & Credential Aliases.
2. Open the GoogleSheets record.
3. Under Related Links section, click Create New Connection & Credential record.
4. On the Create Connection and Credential, fill in these fields.

Create Connection and Credential fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Name</td>
<td>Name of the connection. This field is automatically set to Google Sheets Spoke Connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>The URL used for connecting to Google Sheets APIs. This field is automatically set to <a href="https://sheets.googleapis.com/v4/spreadsheets">https://sheets.googleapis.com/v4/spreadsheets</a>.</td>
</tr>
<tr>
<td>Credential Name</td>
<td>Name of the credential. This field is automatically set to Google Sheets Spoke Credential.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>OAuth Entity Name</td>
<td>Name of the OAuth entity profile. This field is automatically set to Google Sheets Spoke OAuth.</td>
</tr>
<tr>
<td>OAuth Client ID</td>
<td>Client ID of the Google Sheets application you registered in G Suite.</td>
</tr>
<tr>
<td>OAuth Client Secret</td>
<td>Client Secret generated when you registered the application in Google API Console.</td>
</tr>
<tr>
<td>OAuth Redirect URL</td>
<td>The redirect URL. The format of the URL is https://&lt;your-instance&gt;.service-now.com/oauth_redirect.do</td>
</tr>
</tbody>
</table>

5. Click **Create and Get OAuth Token**.

**Google Tasks spoke**
Manage Google Task actions.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Supported versions**
API version v1.

**Spoke subflows**
The Google Tasks spoke provides sample subflows in the draft state to demonstrate automating Google Tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:
### Spoke actions

The Google Tasks spoke provides actions to automate Google Tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Management</td>
<td>Complete Task</td>
<td>Mark a task complete in a task list.</td>
</tr>
<tr>
<td></td>
<td>Create Task</td>
<td>Create a task in a task list.</td>
</tr>
<tr>
<td></td>
<td>Delete Task</td>
<td>Delete a task from a task list.</td>
</tr>
<tr>
<td></td>
<td>Get Task</td>
<td>Retrieve details of a specified task from a task list.</td>
</tr>
<tr>
<td></td>
<td>Look Up Tasks</td>
<td>Retrieve details of specified tasks from a task list.</td>
</tr>
<tr>
<td></td>
<td>Update Task</td>
<td>Update details of the specified task in a task list.</td>
</tr>
<tr>
<td>Task List Management</td>
<td>Create Task List</td>
<td>Create a task list in your Google Tasks account.</td>
</tr>
<tr>
<td></td>
<td>Delete Task List</td>
<td>Delete the specified task list.</td>
</tr>
<tr>
<td></td>
<td>Get All Task Lists</td>
<td>Retrieve the details of all task lists in your Google Tasks account.</td>
</tr>
<tr>
<td></td>
<td>Get Task List</td>
<td>Retrieve details of a specified task list.</td>
</tr>
<tr>
<td></td>
<td>Update Task List</td>
<td>Update details of a specified task list.</td>
</tr>
</tbody>
</table>

### Google Tasks account requirements

The Google Tasks spoke requires a custom app that you create in the Google Developers Console.
Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

MID Server requirements

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Google Tasks alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

Set up Google Tasks spoke

Integrate the ServiceNow instance and Google Tasks spoke by using G Suite credentials to authenticate ServiceNow requests.

Before you begin

- Install the Google Tasks spoke.
- Request IntegrationHub subscription.
- Activate the Google Tasks spoke.
- Role required: admin.

Configure Google Tasks application

Create a custom OAuth application from your Gmail account to enable OAuth 2.0 authentication with the Google Tasks spoke.

Before you begin

Google Tasks integration requirements:

- A domain and an email address associated with the domain. For example, www.mydomain.com and jane-admin@mydomain.com. Note that you can only register one email address per domain in G Suite.
- A Google G Suite or Gmail login created with the domain.

About this task

Complete these steps from the Google Developers Console. See the G Suite product documentation for instructions on creating and configuring custom applications.
Procedure

1. Register a new custom application. Navigate to https://console.developers.google.com, create a project with your G Suite administrator credentials, and open the project.

2. From the APIs & Services menu, select OAuth consent screen, enter the application name, and specify the Authorized domain service-now.com. Click Save.

3. From the APIs & Services menu, select Credentials, and select Create OAuth client ID from the Create credentials list.

4. Select the application type Web application.

5. Enter the following Authorized redirect URL: https://<instance>.service-now.com/oauth_redirect.do and click Create.

6. The OAuth client window shows your client ID and client secret. Copy these two values to a text file so that you can use them when you Register Google Tasks as an OAuth provider.

   The client ID and secret can always be accessed in the Google APIs & Services interface. Click Credentials and select the OAuth 2.0 client ID name.

Register Google Tasks as an OAuth provider

Use the information generated during Google Tasks application configuration to register the Google Tasks application as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Procedure

1. In ServiceNow, navigate to System OAuth > Application Registry.

2. Open the Google Tasks spoke.

3. Enter these values in the Application Registries form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Enter the Client ID of the Google Tasks application you created.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Client Secret of the Google Tasks application you created.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>Click the lock icon , enter https://&lt;instance&gt;.service-now.com/oauth_redirect.do, and then click the lock icon again.</td>
</tr>
</tbody>
</table>

4. In the OAuth Entity Scopes related list, add the scopes required by your application. The Google Tasks spoke supports two scopes:
<table>
<thead>
<tr>
<th>Name</th>
<th>OAuth scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>tasks</td>
<td><a href="https://www.googleapis.com/auth/tasks">https://www.googleapis.com/auth/tasks</a></td>
</tr>
<tr>
<td>readonly</td>
<td><a href="https://www.googleapis.com/auth/tasks.readonly">https://www.googleapis.com/auth/tasks.readonly</a></td>
</tr>
</tbody>
</table>

Click **Insert a new row** and enter a name for the scope and the OAuth scope URL.

5. On the **OAuth Entity Profiles** tab, add at least one profile, set its **Is default** value to true, and select the **Grant type** Authorization Code. Click **Update**.

6. Open the form for this default profile, add the entity scopes to the profile, and click **Update**.

7. On the Application registries form, click **Update** again. The system validates the OAuth credentials.

**What to do next**

Create Credential record for the Google Tasks spoke.

**Create Credential record for the Google Tasks spoke**

Create Credential records to Google. The Google Tasks spoke connection and credential alias uses these credentials to authorize actions.

**Before you begin**

Role required: admin.

**Procedure**

1. Navigate to **IntegrationHub > Connections & Credentials > Credentials** and click **New**.

2. Select **OAuth 2.0 Credentials**.
3. Enter a unique name for the credential, for example, Google Tasks Spoke Credential.

4. Click the OAuth Entity Profile search icon (🔍) and select the default Google Task profile.

5. Click Submit and reopen the credential.


   Choose the Google account that the application is associated with and allow Google to access the spoke actions you specified.

What to do next
Create Connection record for the Google Tasks spoke.

Create Connection record for the Google Tasks spoke
Create Connection records to your Google account. The Google Tasks spoke connection and credential alias uses these connections to perform actions in Google tasks.

Before you begin
Role required: admin

Procedure

1. Navigate to IntegrationHub > Connections & Credentials > Connection & Credential Aliases and select Google Tasks.

2. On the Connections related list, click New.

3. Select HTTP(s) Connection.

4. Provide this connection information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name GTask.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the name of the credential you created in Create Credential record for the Google Tasks spoke.</td>
</tr>
<tr>
<td></td>
<td>Note: Make sure that you don’t include spaces before or after this URL. If there are spaces, the connection fails.</td>
</tr>
</tbody>
</table>

5. Click Submit.
Results
The Google Tasks spoke is set up and integrated with the ServiceNow instance.

GoTo spoke
The GoTo spoke provides actions to view and analyze meaningful usage data for GoTo software subscriptions. Analyze usage for GoToMeeting and GoToWebinar to determine which licenses are stale so that you can reclaim these licenses and realize your potential savings.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for LogMeIn Admin Center v5.29.0, but may be compatible with later versions.

Spoke requirements
• GoTo admin account

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.
**Spoke actions**

The GoTo spoke provides actions to automate GoTo tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Management</td>
<td>Look Up Licenses</td>
<td>Retrieves a list of all product licenses within a GoTo account.</td>
</tr>
<tr>
<td></td>
<td>Remove User License</td>
<td>Removes a user from a specified product license.</td>
</tr>
<tr>
<td>Meeting Management</td>
<td>Get Historical Meeting Report</td>
<td>Reports the meeting history of all organizers within a GoTo account during a given date range.</td>
</tr>
<tr>
<td></td>
<td>Get Upcoming Meeting Report</td>
<td>Reports meetings that are scheduled for all organizers within a GoTo account during a given date range.</td>
</tr>
<tr>
<td>User Management</td>
<td>Delete User</td>
<td>Deletes a user from a GoTo account.</td>
</tr>
<tr>
<td></td>
<td>Get Account Key</td>
<td>Retrieves the account key for the authenticated GoTo account.</td>
</tr>
<tr>
<td></td>
<td>Look up Users</td>
<td>Retrieves a list of all users within a GoTo account.</td>
</tr>
<tr>
<td>Webinar Management</td>
<td>Get Webinars</td>
<td>Retrieves a list of all webinars for a GoTo account.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the GoTo spoke**

Integrate the ServiceNow instance and GoTo by creating a custom OAuth client in GoTo to authenticate ServiceNow requests.
Before you begin

• Request an IntegrationHub subscription.
• Activate GoTo spoke.
• GoTo role required: user with a LogMeIn developer account and admin account
• ServiceNow role required: admin

Create a GoTo OAuth client
Create an OAuth client for authenticating GoTo API requests.

Before you begin
GoTo role required: user with a LogMeIn developer account and admin account

Procedure

1. From a web browser, open the GoTo Developer Center.
2. Sign in using your LogMeIn developer account.
   If you have not already set up a LogMeIn developer account, see How to login or create a developer account for detailed instructions.
3. From the LogMeIn Developers home page, select the OAuth Clients tab.
4. Click Create a client.
   The Create client form opens.
5. On the Details tab, fill in the client details.

   Details tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client name</td>
<td>Name of the OAuth client.</td>
</tr>
<tr>
<td>Description</td>
<td>Optional description for the OAuth client.</td>
</tr>
<tr>
<td>Redirect URLs</td>
<td>Redirect URL of the ServiceNow instance on which you are integrating your GoTo applications. Enter https://&lt;instance-url&gt;/oauth_redirect.do, where &lt;instance-url&gt; is the URL of your ServiceNow instance.</td>
</tr>
</tbody>
</table>

6. Click Next.
7. On the Scopes tab, specify the level of access that the OAuth client has to your GoTo users and applications.
### Scopes tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile</strong></td>
<td>OAuth scopes for getting and modifying user information for your authenticated users. The <strong>Get user information</strong> scope is enabled automatically. Select the check box to enable the <strong>Modify user details</strong> scope.</td>
</tr>
<tr>
<td><strong>GoToMeeting, GoToWebinar, or GoToTraining</strong></td>
<td>OAuth scope for creating, starting, and modifying sessions for your GoToMeeting, GoToWebinar, and GoToTraining applications. Select the check box to enable this scope.</td>
</tr>
<tr>
<td><strong>GoToAssist Remote Support or Service Desk</strong></td>
<td>OAuth scope for creating, starting, and modifying sessions for the GoToAssist Remote Support and Service Desk applications. Leave this check box unselected.</td>
</tr>
<tr>
<td><strong>SCIM</strong></td>
<td>OAuth scope for automating user management using the System for Cross-domain Identity Management (SCIM) protocol. Leave this check box unselected.</td>
</tr>
<tr>
<td><strong>Admin Center</strong></td>
<td>OAuth scope for managing LogMeIn users through the GoTo Admin Center. Select the check box to enable this scope.</td>
</tr>
<tr>
<td><strong>GoToConnect</strong></td>
<td>OAuth scope for initiating phone calls and other telephone services using GoToConnect. Leave this check box unselected.</td>
</tr>
</tbody>
</table>

8. Click **Save**.

9. On the Credentials tab, copy the values in the **Client ID** and **Client secret** fields.
   Save them in a secure location for later use.

10. Select the check box to verify that you have stored the client secret.

11. Click **Done**.
Create a GoTo connection

Create a connection between your GoTo applications and your ServiceNow instance.

Before you begin
ServiceNow role required: admin

Procedure

1. From your ServiceNow instance, navigate to Process Automation > Flow Designer.
   The Flow Designer launches in a new tab.

2. Select the Connections tab.

3. Click View Details for your GoTo connection.

4. From the list of available connections, locate GoTo and then click Configure.
   The Configure Connection dialog box opens.

5. In the dialog box, fill in the fields.

   **Configure Connection dialog box**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Name</td>
<td>Name of the GoTo connection. This field populates automatically.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of your GoTo credentials. This field populates automatically.</td>
</tr>
<tr>
<td>OAuth Client ID</td>
<td>Client ID that is assigned to your GoTo OAuth client.</td>
</tr>
<tr>
<td>OAuth Client Secret</td>
<td>Client secret that is assigned to your GoTo OAuth client.</td>
</tr>
<tr>
<td>OAuth Redirect URL</td>
<td>Redirect URL of the ServiceNow instance on which you are integrating your GoTo applications. This field populates automatically.</td>
</tr>
</tbody>
</table>

6. Click Configure and Get OAuth Token.
   The Authorize App dialog box opens.

7. On the dialog box, click Allow.
   The OAuth access token becomes available for authorizing your GoTo connection.
Gremlin spoke v1.0.2
Simulate outages and manage attacks using Gremlin instance from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.

Note: This spoke is available to new customers as part of an IntegrationHub Professional subscription. Existing customers can use this spoke as part of an IntegrationHub Standard subscription.

Supported versions
This spoke was built for Gremlin version v1, but may be compatible with later versions.

Spoke requirements
• Set up clients as per your requirement.
• Admin access to the Gremlin dashboard.
• Team in your Gremlin account for integration with ServiceNow instance. For more information about creating teams, see Teams.
• Team ID and API Key of the team. Copy and record these value for later use. For more information about accessing these values, see the Signature-based Authentication section.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• Complex Object (com.glide.cobject)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Gremlin spoke provides actions to automate Gremlin tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attack Management</td>
<td>Create Attack</td>
<td>Creates an attack on the Gremlin platform.</td>
</tr>
<tr>
<td></td>
<td>Get Attack Details</td>
<td>Retrieves details about an attack.</td>
</tr>
<tr>
<td></td>
<td>Get Attack Executions</td>
<td>Retrieves a list of executions associated with an attack.</td>
</tr>
<tr>
<td></td>
<td>Halt All Attacks</td>
<td>Idempotently halts all active attacks across the Gremlin platform.</td>
</tr>
<tr>
<td>Look up Attacks</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Attack Schedule</td>
<td>Create Attack Schedule</td>
<td>Creates an attack schedule on the Gremlin platform.</td>
</tr>
<tr>
<td>Schedule Management</td>
<td>Delete Attack Schedule</td>
<td>Deletes the specified attack schedule.</td>
</tr>
</tbody>
</table>

Note:
- By default, this action can retrieve data up to 5 MB. You can configure the `glide.pf.rest.response_payload_max_size` property to retrieve data up to 10 MB. If the data in the response is more 10 MB, an error is displayed.
- As data up to 10 MB only can be retrieved, you can also specify number of records that should be retrieved in the input field, **Number of records to return**.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get</td>
<td>Attack Schedule Details</td>
<td>Retrieves details about the specified attack schedule.</td>
</tr>
<tr>
<td>Look up</td>
<td>Active Attack Schedules</td>
<td>Lists all the attack schedules on the Gremlin platform.</td>
</tr>
</tbody>
</table>

**Note:**

- Time zone that is considered in the spoke actions, is same as the time zone of your ServiceNow instance.
- Based on your Gremlin license, if you don’t have access to certain Gremlin functionality, you can’t use the associated spoke actions in your ServiceNow instance as well.
- For some arguments that take True or False as input, the actual value that the Gremlin platform considers, might be different from the value you have provided.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**Create Connection and Credential record for the Gremlin spoke**

Authorize the Gremlin spoke actions by creating connection and credential record for the application registered in Gremlin. The Gremlin spoke connection and credential alias uses these connections and credentials to authorize actions.

**Before you begin**

Role required: admin
Procedure

1. Navigate to **Connection & Credentials > Connection & Credential Alias**.
2. Open the record, Gremlin.
3. Click the **Create New Connection & Credential** related link.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection Name</strong></td>
<td>Name to identify the connection record. By default, this is Gremlin Connection. You may change it as per your requirement.</td>
</tr>
<tr>
<td><strong>Connection URL</strong></td>
<td>URL to connect to Gremlin. By default, this is <a href="https://api.gremlin.com">https://api.gremlin.com</a>.</td>
</tr>
<tr>
<td><strong>API Version</strong></td>
<td>API version of the Gremlin platform. By default, this is v1.</td>
</tr>
<tr>
<td><strong>Team ID</strong></td>
<td>Team ID of your team.</td>
</tr>
<tr>
<td><strong>API Key</strong></td>
<td>API Key of your team.</td>
</tr>
<tr>
<td><strong>Credential Name</strong></td>
<td>Name to identify the credential record. By default, this is Gremlin Credentials. You may change it as per your requirement.</td>
</tr>
</tbody>
</table>

5. Click **Create**.

Infoblox spoke v2.0

Automate network management tasks in Infoblox from your ServiceNow instance. For example, register or delete IP addresses on an Infoblox server.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.
**Note:** This spoke is available to new customers as part of an IntegrationHub Professional subscription. Existing customers can use this spoke as part of an IntegrationHub Standard subscription.

**Supported version**
Infoblox versions 2.7, 2.11 and may be compatible with other future API versions.

**Spoke dependencies**
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow Flow Designer - Dynamic Outputs (com.glide.hub.dynamic_outputs)
- Remote Tables plugin (com.glide.script.vtable)

**Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke flows**
The Infoblox spoke provides sample flows in the draft state to automate allocating IP addresses in the Infoblox grid server. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Infoblox Register or Reserve IP in IPAM</td>
<td>Registers or reserves an IP address in Infoblox based on a Service Catalog item request.</td>
</tr>
</tbody>
</table>

**Spoke subflows**
The Infoblox spoke provides sample subflows to register and reserve IP addresses.
### Flow

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register AName Record and Get Network Details</td>
<td>Registers an AName record type in the DNS server and retrieves network details such as network options and ID.</td>
</tr>
<tr>
<td>Process Inbound Notifications from Infoblox</td>
<td>Receives the inbound notifications from Infoblox and logs the details.</td>
</tr>
</tbody>
</table>

**Spoke module**

The Infoblox spoke adds the Infoblox application to your instance and includes these modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CName Records</td>
<td>Lists all the CName records.</td>
</tr>
<tr>
<td>Webhook Registry</td>
<td>Lists all the webhook registries for the spoke.</td>
</tr>
</tbody>
</table>

**Spoke actions**

The Infoblox spoke provides actions to manage IP addresses and networks in Infoblox from your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP Management</td>
<td>Delete IP Reservation</td>
<td>Deletes IP address range from an Infoblox server.</td>
</tr>
<tr>
<td></td>
<td>Look up IP Address Reservation</td>
<td>Lists IP address reservation in the DHCP server for a given Infoblox network view.</td>
</tr>
<tr>
<td></td>
<td>Reserve IP Address Range</td>
<td>Reserves an IP address range in the Infoblox server.</td>
</tr>
<tr>
<td>DNS Management</td>
<td>Add IPs to Host Record</td>
<td>Adds the specified list of IPs to the existing server.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>IP addresses in the specified host record.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Change IPs of Host Record</td>
<td>Replaces the IP addresses of the specified host record with the new list of IPs.</td>
</tr>
<tr>
<td></td>
<td>Create Host Record</td>
<td>Creates a host record in Infoblox.</td>
</tr>
<tr>
<td></td>
<td>Delete DNS Record</td>
<td>Deletes a DNS record in the Grid Server.</td>
</tr>
<tr>
<td></td>
<td>Look up CName Records</td>
<td>Lists CName records present in the Infoblox server.</td>
</tr>
<tr>
<td></td>
<td>Look up DNS Records</td>
<td>Lists DNS records present in the Infoblox server.</td>
</tr>
<tr>
<td></td>
<td>Look up Host Record by Reference</td>
<td>Retrieves the details of the specified host record.</td>
</tr>
<tr>
<td></td>
<td>Look up Host Records Stream</td>
<td>Retrieves the details of all host records.</td>
</tr>
<tr>
<td></td>
<td>Register AName Record</td>
<td>Registers an AName record type in DNS server. An AName record stores mapping between the fully qualified domain name and the IP address.</td>
</tr>
<tr>
<td></td>
<td>Register CName Record</td>
<td>Registers a CName record in the Infoblox DNS Server. A CName record is an alias to the fully qualified domain name.</td>
</tr>
<tr>
<td></td>
<td>Update AName Record</td>
<td>Updates the properties of the specified AName record.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update CName Record</td>
<td>Updates the properties</td>
<td>of the specified CName record.</td>
</tr>
<tr>
<td>Update Host Record</td>
<td>Updates the properties</td>
<td>of specified host record.</td>
</tr>
<tr>
<td><strong>Generic</strong></td>
<td>Create Record</td>
<td>Creates a record in Infoblox for the specified object.</td>
</tr>
<tr>
<td></td>
<td>Delete Record</td>
<td>Deletes the specified record.</td>
</tr>
<tr>
<td></td>
<td>Look up Record by Reference</td>
<td>Retrieves the details of the specified record.</td>
</tr>
<tr>
<td></td>
<td>Look up Records by Criteria Stream</td>
<td>Retrieves the details of all records for the specified schema object.</td>
</tr>
<tr>
<td></td>
<td>Look up Records Stream</td>
<td>Retrieves the details of all records of the specified object type.</td>
</tr>
<tr>
<td></td>
<td>Update Record</td>
<td>Updates a record in Infoblox for the specified object.</td>
</tr>
<tr>
<td><strong>IPAM Management</strong></td>
<td>Delete IPAM IP Address</td>
<td>Deletes an IPAM IP address Reservation in Infoblox.</td>
</tr>
<tr>
<td></td>
<td>Reservation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Look up IPAM Reservations</td>
<td>Lists the IP addresses within a given Infoblox Server.</td>
</tr>
<tr>
<td></td>
<td>Register IPAM IP Address</td>
<td>Registers the IP addresses within a given Infoblox Server.</td>
</tr>
<tr>
<td></td>
<td>Addresses</td>
<td>Reserves the IP addresses within a given Infoblox Server.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Look up Definition of Extensible Attributes</td>
<td>Retrieves the definitions of the extensible attributes.</td>
</tr>
<tr>
<td></td>
<td>Look up Object Metadata</td>
<td>Retrieves the list of all supported fields for a given operation for the specified schema object.</td>
</tr>
<tr>
<td></td>
<td>Look up Overall WAPI Metadata</td>
<td>Retrieves the list of all supported objects in the configured API version.</td>
</tr>
<tr>
<td>Network Management</td>
<td>Create Network</td>
<td>Creates a network within a given Infoblox Server.</td>
</tr>
<tr>
<td></td>
<td>Delete Network</td>
<td>Deletes a network within a given Infoblox Server.</td>
</tr>
<tr>
<td></td>
<td>Look up Network Details</td>
<td>Retrieves the network details within a given InfoBlox Server.</td>
</tr>
<tr>
<td></td>
<td>Update Network</td>
<td>Updates the network within a given Infoblox Server.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

This spoke uses the Infoblox alias record to authorize actions.
To use the spoke connection alias, create an associated Connection record and an associated Credential record.

### MID Server requirements

These actions use REST calls, which must run on a MID Server. Use the connection record associated with the Infoblox alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

### Set up Infoblox spoke

Integrate the ServiceNow instance and Infoblox using basic authentication to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription.
- Activate the Infoblox spoke.
- Role required: admin

### Create a Connection and Credential Alias for Infoblox spoke

Create Connection records to your Infoblox account. The Infoblox spoke connection and credential aliases use these connections to perform actions in Infoblox.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to IntegrationHub > Connections & Credentials > Connection & Credential Aliases.
2. Open the Infoblox record.
3. From the Related Links section, click Create New Connection & Credential.
4. On the form, fill in these fields:

<table>
<thead>
<tr>
<th>Connection &amp; Credential alias</th>
<th>Description</th>
<th>Connection alias requirements</th>
</tr>
</thead>
</table>
| Infoblox                      | Connection to Infoblox server | • Connection type: HTTP  
• Connection URL: URL of the host machine where the Infoblox server is installed. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Name</td>
<td>Unique name to identify the connection. For example, Infoblox Spoke Connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Host URL to connect to your Infoblox account.</td>
</tr>
<tr>
<td>API Version</td>
<td>API version of Infoblox. This field is auto-populated to v2.11</td>
</tr>
<tr>
<td>User Name</td>
<td>User name of your Infoblox account.</td>
</tr>
<tr>
<td>Password</td>
<td>Password of your Infoblox account.</td>
</tr>
</tbody>
</table>
5. Click **Create**.

**Set up bi-directional webhook for Infoblox spoke**

Configure a webhook to subscribe to Infoblox with a ServiceNow callback URL.
Before you begin

- Request an IntegrationHub Standard subscription
- Activate the Infoblox spoke
- Role required: admin

Register a Infoblox webhook

Register a Infoblox webhook in a ServiceNow instance to notify the ServiceNow application when certain events occur in Infoblox.

Before you begin
Role required: admin

Procedure

1. Navigate to **Infoblox spoke > Webhook Registry**.
2. Click **New**.
3. On the form, fill in these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Note: The name must be only Infoblox Webhook Authentication.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to identify the webhook registry.</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>Username specified in the Infoblox outbound endpoint configuration.</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td>Password specified in the Infoblox outbound endpoint configuration.</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Description of the webhook registry.</td>
<td></td>
</tr>
<tr>
<td>Path</td>
<td>Infoblox webhook path. This is field is auto-populated with api/sn_infoblox_spoke/infoblox_webhook.</td>
<td></td>
</tr>
</tbody>
</table>

4. Right-click the form header and click **Save**.
5. Click **Callback URL**.
The system displays the webhook callback URL.

6. Copy and record the webhook callback URL.

**Add callback URL in Infoblox**

Specify a webhook callback URL in Infoblox account to create a webhook.

**Before you begin**

- Register a Infoblox webhook
- Download Infoblox outbound templates from the KB article: KB0966373
- Role required: admin

**Procedure**

1. Log in to your Infoblox account.
2. Create a webhook in your Infoblox account. For more information, see KB0966373.
3. Configure a outbound endpoint for your ServiceNow instance. For more information about configuring Infoblox outbound endpoints, see About Outbound Templates.
4. Configure templates by uploading the templates from the KB0966373 article.

<table>
<thead>
<tr>
<th>Template name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host_Address_IPv4_Insert.txt</td>
<td>Template to configure notifications when a new IPv4 address is added to a host.</td>
</tr>
<tr>
<td>Range_IPv4_Insert.txt</td>
<td>Template to configure notifications when a new IPv4 range is added.</td>
</tr>
<tr>
<td>Network_Insert.txt</td>
<td>Template to configure notifications when a new IPv4 network is added.</td>
</tr>
<tr>
<td>Host_Address_IPv6_Insert.txt</td>
<td>Template to configure notifications when a new IPv6 address is added to a host.</td>
</tr>
</tbody>
</table>

5. Configure notifications rules using the Notification Wizard.
Jenkins v2 spoke v1.0.3
Manage builds, users, settings, and jobs on the Jenkins server. Retrieve Jenkins data to use in a flow.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.

Note: This spoke is available to new customers as part of an IntegrationHub Professional subscription. Existing customers can use this spoke as part of an IntegrationHub Standard subscription.

Spoke dependencies
If you're having trouble installing the app, ensure that these dependent plugins are installed:

• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Spoke requirements
The Jenkins v2 spoke v2 requires generating an API token. See Security Hardening: New API token system in Jenkins 2.129+ for more information about the API tokens.

Supported versions
All versions between 2.176.2 to 2.222.1.

Spoke modules
You can configure the Jenkins v2 spoke v2 to receive updates from Jenkins at your ServiceNow instance. In the routing policies, conditions that must be met to receive updates at your ServiceNow instance are defined. When the conditions
are met, routing policy triggers the associated subflow, which in turn automates the Jenkins tasks. This requires separate setup and can be used independently without using the spoke actions. See Set up a webhook for information regarding setting up and configuring the webhooks. To use other conditions in the routing policy or customize the default subflows, see Customize a webhook.

Routing policies and subflows support these fields:

- Keywords
- Build Number
- Job Name
- Job Path
- Show Related Fields

By default, the Jenkins v2 application is available in the Jenkins v2 spoke and has these modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Webhook Answer Subflows</td>
<td>Details of the webhook authorization key to authorise requests from Jenkins.</td>
</tr>
<tr>
<td>Webhook Client Detail</td>
<td>Details about the subflows in Jenkins v2 spoke.</td>
</tr>
</tbody>
</table>

The Jenkins v2 spoke v2 includes these tables:

- Jenkins v2 Webhook Answer Subflow [sn_jenkinsv2_spoke_webhook_answer_subflow]
- Jenkins Webhook Client Details [sn_jenkinsv2_spoke_webhook_client_details]

**Spoke subflows**

The Jenkins v2 spoke provides sample subflows to demonstrate automating Jenkins tasks. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build Jenkins Job</td>
<td>Receives updates from Jenkins at the ServiceNow instance.</td>
</tr>
</tbody>
</table>
Subflow | Description
---|---
Jenkins Webhook Answer Subflow: Process build information | Builds Jenkins Job and retrieves the information. To customize this subflow, create a copy of the subflow and change it as per your requirement.

**Spoke actions**
The Jenkins v2 spoke provides actions to automate Jenkins tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build Management</td>
<td>Delete Build</td>
<td>Deletes a build from a Jenkins server job.</td>
</tr>
<tr>
<td></td>
<td>Get Build ID</td>
<td>Retrieves the Build ID of an executed job from the Jenkins server.</td>
</tr>
<tr>
<td></td>
<td>Get Build Timestamp</td>
<td>Retrieves build timestamp of a given job from the Jenkins server.</td>
</tr>
<tr>
<td></td>
<td>Get Console Output</td>
<td>Retrieves build console output for a given job from Jenkins Server.</td>
</tr>
<tr>
<td></td>
<td>List Builds</td>
<td>Retrieves all the builds for a given job from the Jenkins server.</td>
</tr>
<tr>
<td></td>
<td>Perform Build with Parameters</td>
<td>Executes a job with parameters on the Jenkins server.</td>
</tr>
<tr>
<td></td>
<td>Get Build History</td>
<td>Retrieves a range of build history for a given job from Jenkins Server.</td>
</tr>
<tr>
<td></td>
<td>Get Build Information</td>
<td>Retrieves the build timestamp, build status, and complete build information of a given job from the Jenkins server.</td>
</tr>
<tr>
<td></td>
<td>Get Build Number</td>
<td>Retrieves the build number for a Jenkins server job based on a pre-defined build filter, such as last successful build.</td>
</tr>
<tr>
<td></td>
<td>Perform Build</td>
<td>Executes a job on the Jenkins server.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Configuration</td>
<td>Create Node</td>
<td>Creates a node that you can launch with Java Web Start software. A node is a machine that is part of the Jenkins environment and capable of executing jobs.</td>
</tr>
<tr>
<td></td>
<td>Delete Node</td>
<td>Deletes a node from the Jenkins server.</td>
</tr>
<tr>
<td></td>
<td>Get Version</td>
<td>Retrieves the Jenkins server version.</td>
</tr>
<tr>
<td></td>
<td>Restart Jenkins</td>
<td>Restarts the Jenkins server.</td>
</tr>
<tr>
<td></td>
<td>Test Connection</td>
<td>Tests the connection to the Jenkins server.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Copy Job</td>
<td>Creates a job by copying an existing Jenkins server job.</td>
</tr>
<tr>
<td>Job Management</td>
<td>Create Folder</td>
<td>Creates a Jenkins server folder to organize jobs.</td>
</tr>
<tr>
<td></td>
<td>Create Job</td>
<td>Creates a Jenkins server job from an XML file.</td>
</tr>
<tr>
<td></td>
<td>Delete Folder</td>
<td>Deletes an existing Jenkins server folder.</td>
</tr>
<tr>
<td></td>
<td>Delete Job</td>
<td>Deletes a Jenkins server job.</td>
</tr>
<tr>
<td></td>
<td>List Jobs By Folder</td>
<td>Retrieves all the jobs for a given folder from the Jenkins server.</td>
</tr>
<tr>
<td></td>
<td>Get Job Configuration</td>
<td>Retrieves the XML configuration for a Jenkins server job.</td>
</tr>
<tr>
<td></td>
<td>Reload Job</td>
<td>Reloads a Jenkins server job.</td>
</tr>
<tr>
<td></td>
<td>Rename Job</td>
<td>Renames a Jenkins server job.</td>
</tr>
<tr>
<td>User Management</td>
<td>Create User</td>
<td>Creates a Jenkins server user.</td>
</tr>
<tr>
<td></td>
<td>Delete User</td>
<td>Deletes an existing Jenkins server user.</td>
</tr>
<tr>
<td>View Management</td>
<td>Add Job To View</td>
<td>Adds a job to the Jenkins server view. Views are containers to organize jobs. As a Jenkins instance grows, you can create views for appropriate groups and categories. For example, you may...</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Create View</td>
<td>Creates a Jenkins server view.</td>
</tr>
<tr>
<td></td>
<td>Delete View</td>
<td>Deletes a Jenkins server view.</td>
</tr>
<tr>
<td></td>
<td>List Jobs By View</td>
<td>Retrieves all jobs from a view on the Jenkins server.</td>
</tr>
<tr>
<td></td>
<td>Remove Job From View</td>
<td>Removes a job from a Jenkins server view.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>want to create a Build view, which only displays build-specific jobs.</td>
</tr>
</tbody>
</table>

**Connection and credential requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

This spoke uses the Jenkins v2 Connection & Credential Alias record to authorize actions. To use the spoke connection alias, create an associated Connection record and an associated Credential record.

**MID Server requirements**

These actions use REST calls, which run on a MID Server. Use the connection record associated with the Jenkins alias to configure where actions run as well as set MID Server selection attributes. For more information, see [MID server](#).

**Set up the Jenkins spoke**

Integrate the ServiceNow instance and Jenkins using basic authentication to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription
- Activate Jenkins spoke
  - Role required: admin

**Create Credential records for the Jenkins spoke**

Create Credential records to the Jenkins server. The Jenkins spoke connection and credential alias uses these credentials to authorize actions.
Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?
3. Select Basic Auth Credentials.
   A blank Basic Auth Credentials form displays.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter Jenkins Credentials.</td>
</tr>
<tr>
<td>User name</td>
<td>Jenkins user name.</td>
</tr>
<tr>
<td>Password</td>
<td>API token.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Create Connection records for the Jenkins spoke
Create Connection records to your Jenkins account. The Jenkins spoke connection and credential alias uses these connections to perform actions on Jenkins.

Procedure
1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for Jenkins v2.
3. From the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter Jenkins Connection.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Jenkins. For example, select Jenkins Credentials.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL of the host machine where Jenkins is installed.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Set up a webhook**

Set up webhook application to receive the required updates from Jenkins at your ServiceNow instance.

**Before you begin**

Role required: admin

**Create authorization key for the Jenkins v2 spoke**

Create a authorization key to authorise requests from Jenkins.

**Procedure**

1. Navigate to **System Definition > Scripts - Background**.
2. Enter this command in the **Run script (JavaScript executed on server)** text field:
   
   ```
   gs.info(GlideSecureRandomUtil.getSecureRandomString(32));
   ```

3. Click **Run Script**.

4. Copy and record the generated value for later use.

   ![Script output]

   [0:00:00.241] Script completed in scope x_snc_sap_ecc_rfc: script

   **Script execution history and recovery available here**

   **x_snc_sap_ecc_rfc**: r2983icyHMMZAs06veZvyxBF48K06s14

**Provide authorization key for webhook**

Authorise requests from Jenkins by providing authorization key for webhook in your ServiceNow instance.

**Procedure**

1. Navigate to **Jenkins v2 > Webhook Client Details**.
2. Click **New**.
3. On the form, fill these values:
Jenkins Webhook Client Details form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authorization Key</td>
<td>Authorization key you had generated. See Create authorization key for the Jenkins v2 spoke for more information.</td>
</tr>
<tr>
<td>Name</td>
<td>Name to identify the webhook client record.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Provide authorization key in Jenkins**

Receive updates from Jenkins by providing the authorization key in Jenkins.

**Procedure**

1. Log in to your Jenkins account.
2. Click and open the job for which you want to configure your webhook.
3. Click **Configure**.
4. In the **Bindings** tab, click **Add** and select **Jenkins**. For more information about the using the plugin, see **Credentials Binding**.

5. On the Jenkins Credential Provider form, fill these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kind</td>
<td>Select <strong>Secret text</strong>.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Secret | Enter authorization key. See Create authorization key for the Jenkins v2 spoke for more information.
ID | Provide unique identifier to identify the record.

6. Click **Add**.

7. In the **Post-build Actions** tab, configure task and specify script to receive updates at your ServiceNow instance.

- **Sample Windows Script:**
  ```bash
  curl "https://<instance-name>.service-now.com/api/sn_jenkinsv2_spoke/jenkins_v2_webhook/build_status" -X POST -H "content-type:application/json" -H "jenkinsKey: %<ID>%" -d "{"Job_Name": "%JOB_NAME%", "Job_Path": "%JOB_URL%", "Build_Number": "%BUILD_NUMBER%"}"
  ```

- **Sample Shell Script:**
  ```bash
  curl "https://<instance-name>.service-now.com/api/sn_jenkinsv2_spoke/jenkins_v2_webhook/build_status" -X POST -H "content-type:application/json" -H "jenkinsKey: ${<ID>}" -d "{"Job_Name": "${JOB_NAME}", "Job_Path": "${JOB_URL}", "Build_Number": "${BUILD_NUMBER}"}"
  ```

⚠ **Note:** ID in the script is the ID you had provided in the Jenkins Credential Provider form.

For more information about the using the plugin, see **Post build task**.

8. Click **Apply**.

**Provide description to subflow**

Provide user friendly descriptions to the subflows in the Jenkins v2 spoke.

**Procedure**

1. Navigate to **Jenkins v2 > Webhook Answer Subflows**.
2. Click **New**.
3. On the form, fill these values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Description about the subflow.</td>
</tr>
<tr>
<td>Subflow</td>
<td>Required subflow in the Jenkins v2 spoke.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
Provide answers to the decision table

Provide subflows as answers to the conditions mentioned in the decision table. When the specified conditions are met, the associated subflow is triggered.

Procedure
1. Navigate to System Definition > Decision Tables.
2. Open the record for the Jenkins v2 spoke.
3. In the Decisions tab, click New.
4. On the form, fill these values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Unique label to identify the routing policy.</td>
</tr>
<tr>
<td>Default answer</td>
<td>Option to specify if this is the default answer. The default answer is applicable when the conditions are not met.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions to be met when the required events occur in Jenkins. See Jenkins v2 spoke v1.0.3 for information about the supported fields.</td>
</tr>
<tr>
<td>Answer</td>
<td>Subflow that must be triggered when the specified conditions are met.</td>
</tr>
<tr>
<td></td>
<td>a. Click the Lookup icon (🔍).</td>
</tr>
<tr>
<td></td>
<td>b. Select the required subflow from the Document list.</td>
</tr>
<tr>
<td></td>
<td>Note: Ensure that the Table name is Jenkins v2 Webhook Answer Subflow [sn_jenkinsv2_spoke_webhook_answer_subflow].</td>
</tr>
</tbody>
</table>

5. Click Submit.

Customize a webhook

Create a webhook routing policy and customize subflow as per your requirement.

Procedure
1. Navigate to Flow Designer > Designer.
2. Click Subflows.
3. Create a copy of the required default subflow.

4. Customize the Jenkins Webhook Answer Subflow: Process build information subflow as per your requirement and publish it. See Subflows for more information about creating and using subflows and Jenkins v2 spoke v1.0.3 for information about the fields that the routing policies and subflows support.

5. Navigate to Jenkins v2 > WebHook Answer Subflows.
6. Click New.
7. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Description about the subflow.</td>
</tr>
<tr>
<td>Subflow</td>
<td>Required subflow in the Jenkins v2 spoke.</td>
</tr>
</tbody>
</table>

8. Click Submit.

Note: These routing policies are saved in the Decision tables. Users are cautioned against directly updating or modifying data in these tables.

10. Open the record for the Jenkins v2 spoke.
11. In the Decisions tab, click New.
12. On the form, fill these fields:

<table>
<thead>
<tr>
<th>Decision form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Label</td>
</tr>
<tr>
<td>Default answer</td>
</tr>
<tr>
<td>Condition</td>
</tr>
<tr>
<td>Answer</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a.</td>
<td>Click the Lookup icon (🔍).</td>
</tr>
<tr>
<td>b.</td>
<td>Select the required subflow from the Document list.</td>
</tr>
</tbody>
</table>

**Note:** Ensure that the **Table name** is Jenkins v2 Webhook Answer Subflow [sn_jenkinsv2_spoke_webhook_answer_subflow].

---

13. Click **Submit**.

**Jira spoke v3.0.4**

Manage issues, users, stories, and groups in Jira. Retrieve Jira data to use in a flow. Use bi-directional webhooks and subscribe to Jira with a ServiceNow callback URL.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.

**Note:** This spoke is available to new customers as part of an IntegrationHub Professional subscription. Existing customers can use this spoke as part of an IntegrationHub Standard subscription.

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Integrations - External Authentication Framework (com.glide.external.app)

**Note:** Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.
**Supported versions**
This spoke was built for API version v2, but may be compatible with later versions.

> Note:

- If your Jira instance supports another API version, specify the API version in **API Version** under the Attributes related list. By default, the **API Version** is 2. See [Create connection records for the Jira spoke](#) for information about creating a Connection record.
- Jira Service Desk is not supported by the spoke.

**Spoke requirements**
Activate the Integrations - External Authentication Framework (com.glide.external.app) plugin.

**Jira Webhooks module**
Bi-directional webhooks can be set up to be notified about the required events. Routing policy defines conditions that must be met to notify the ServiceNow app. These conditions are based on the events in Jira that you want to be notified about. When the conditions are met, routing policy triggers the associated subflow, which in turn automates the Jira tasks.

The bi-directional webhooks require separate setup and can be used independently without using the spoke actions. By default, the Jira Webhooks application is available in the Jira spoke and has the following modules:

- Jira Webhook Registries
- Jira WebHook Routing Policies

Use the Jira Webhook Registries module to assign a token and provide the API path. You must generate a Callback URL here and provide this URL in Jira. A default routing policy is provided in the Jira WebHook Routing Policies module. The default routing policy supports these fields:

<table>
<thead>
<tr>
<th>Category</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue</td>
<td>• Jira Instance URL</td>
</tr>
<tr>
<td></td>
<td>• Webhook Event</td>
</tr>
<tr>
<td></td>
<td>• Issue Description</td>
</tr>
<tr>
<td></td>
<td>• Created</td>
</tr>
<tr>
<td></td>
<td>• Updated</td>
</tr>
<tr>
<td>Category</td>
<td>Field</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• Issue Resolution</td>
</tr>
<tr>
<td></td>
<td>• Previous Issue Resolution</td>
</tr>
<tr>
<td></td>
<td>• Issue Summary</td>
</tr>
<tr>
<td></td>
<td>• Issue Type</td>
</tr>
<tr>
<td></td>
<td>• Previous Issue Type</td>
</tr>
<tr>
<td></td>
<td>• Issue Priority</td>
</tr>
<tr>
<td></td>
<td>• Previous Issue Priority</td>
</tr>
<tr>
<td></td>
<td>• Issue Status</td>
</tr>
<tr>
<td></td>
<td>• Previous Issue Status</td>
</tr>
<tr>
<td></td>
<td>• Issue Status Category</td>
</tr>
<tr>
<td></td>
<td>• Previous Issue Status Category</td>
</tr>
<tr>
<td></td>
<td>• Project</td>
</tr>
<tr>
<td>Comment</td>
<td>• Jira Instance URL</td>
</tr>
<tr>
<td></td>
<td>• Webhook Event</td>
</tr>
<tr>
<td></td>
<td>• Comment</td>
</tr>
<tr>
<td></td>
<td>• Created</td>
</tr>
<tr>
<td></td>
<td>• Updated</td>
</tr>
<tr>
<td></td>
<td>• Issue Summary</td>
</tr>
<tr>
<td></td>
<td>• Issue Type</td>
</tr>
<tr>
<td></td>
<td>• Issue Priority</td>
</tr>
<tr>
<td></td>
<td>• Issue Status</td>
</tr>
<tr>
<td></td>
<td>• Issue Status Category</td>
</tr>
<tr>
<td></td>
<td>• Project</td>
</tr>
<tr>
<td>Worklog</td>
<td>• Jira Instance URL</td>
</tr>
<tr>
<td></td>
<td>• Webhook Event</td>
</tr>
<tr>
<td></td>
<td>• Worklog Time Spent</td>
</tr>
<tr>
<td></td>
<td>• Created</td>
</tr>
<tr>
<td></td>
<td>• Updated</td>
</tr>
<tr>
<td>Category</td>
<td>Field</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Attachment</td>
<td>• Jira Instance URL</td>
</tr>
<tr>
<td></td>
<td>• Webhook Event</td>
</tr>
<tr>
<td></td>
<td>• Created</td>
</tr>
<tr>
<td></td>
<td>• Attachment File Name</td>
</tr>
<tr>
<td></td>
<td>• Attachment Size</td>
</tr>
<tr>
<td></td>
<td>• Attachment Mime Type</td>
</tr>
<tr>
<td>Project</td>
<td>• Jira Instance URL</td>
</tr>
<tr>
<td></td>
<td>• Webhook Event</td>
</tr>
<tr>
<td></td>
<td>• Project</td>
</tr>
<tr>
<td>Version</td>
<td>• Jira Instance URL</td>
</tr>
<tr>
<td></td>
<td>• Webhook Event</td>
</tr>
<tr>
<td></td>
<td>• Version</td>
</tr>
<tr>
<td></td>
<td>• Version Description</td>
</tr>
<tr>
<td></td>
<td>• Merged To Version</td>
</tr>
<tr>
<td></td>
<td>• Merged To Version Description</td>
</tr>
</tbody>
</table>

To use other conditions in the routing policy, create routing policy in the Jira WebHook Routing Policies module and specify conditions as per your requirement. See [Set up a bi-directional webhook](#) for information regarding setting up and configuring the webhooks.

**Spoke subflow**

The Jira spoke provides a sample subflow to handle various Jira webhook events. The available sample subflow is Process Jira Webhooks. The Process Jira Webhooks subflow supports these fields:

<table>
<thead>
<tr>
<th>Category</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue</td>
<td>• User</td>
</tr>
<tr>
<td></td>
<td>• Issue</td>
</tr>
<tr>
<td></td>
<td>• Attachments</td>
</tr>
</tbody>
</table>
To customize the default subflow, you must create a copy of the sample subflow, parse the payload, and customize the subflow as per your requirement. Payload is one of the inputs to the subflow.

While customizing subflows, you must ensure that the subflows are configured to avoid infinite loops.

**Note:**
- You must configure webhooks to use the spoke subflow. See [Set up a bi-directional webhook](#) for information regarding setting up and configuring the webhook.
- The sample subflow runs as a user by default. The subflow can be configured to run as system.

**Spoke actions**

Use actions in the Jira spoke in Flow Designer to automate Jira tasks when an event occurs in the Now Platform. Available actions include:
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue Management</td>
<td>Copy Attachment</td>
<td>Copies the required attachment associated with the ServiceNow record to the required issue in Jira.</td>
</tr>
<tr>
<td></td>
<td>Delete Attachment</td>
<td>Deletes the required attachment in Jira.</td>
</tr>
<tr>
<td></td>
<td>Add Comment</td>
<td>Adds a comment to the specified issue in Jira.</td>
</tr>
<tr>
<td></td>
<td>Assign Issue</td>
<td>Assigns the issue in Jira to the user. You can use the Look up Latest Comment on Issue action to verify and validate the latest comment of an issue in Jira.</td>
</tr>
<tr>
<td></td>
<td>Create Issue</td>
<td>Creates an issue in Jira. Depending on how your organization is using Jira, an issue could represent a software bug, a project task, a help desk ticket, or more. An issue in Jira represents a task in the Now Platform.</td>
</tr>
<tr>
<td></td>
<td>Delete Issue</td>
<td>Deletes an issue in Jira.</td>
</tr>
<tr>
<td></td>
<td>Do Transition</td>
<td>Transitions an issue in Jira from one state to another.</td>
</tr>
<tr>
<td></td>
<td>Get Issue By ID</td>
<td>Retrieves the JSON object of the required issue.</td>
</tr>
<tr>
<td></td>
<td>Get Statuses By Project</td>
<td>Retrieves the status of the required project.</td>
</tr>
<tr>
<td></td>
<td>Look up Fields</td>
<td>Retrieves the fields in the required project.</td>
</tr>
<tr>
<td></td>
<td>Look up Issue Priorities</td>
<td>Retrieves the list of issue priorities and details for individual issue priorities.</td>
</tr>
<tr>
<td></td>
<td>Look up Records by JQL Stream</td>
<td>Retrieves the list of the required records by providing a JQL query.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look Up Transitions</td>
<td>Retrieves information about all Transitions in JSON format for a given Issue ID.</td>
</tr>
<tr>
<td></td>
<td>Update Issue</td>
<td>Updates a set number of fields of an issue in Jira with values passed as input.</td>
</tr>
<tr>
<td></td>
<td>Get Issues</td>
<td>Gets a list of Jira issues.</td>
</tr>
<tr>
<td></td>
<td>Get Issues for Sprint</td>
<td>Retrieves the details of all issues for the given sprint.</td>
</tr>
<tr>
<td></td>
<td>Get All Projects</td>
<td>Retrieves information in JSON format for all projects visible to the currently logged in user. A project in Jira is a collection of issues, and is defined according to your organization's requirements.</td>
</tr>
<tr>
<td>SDLC Management</td>
<td>Create Story</td>
<td>Creates a story in Jira, similar to a story in Now Platform Agile Development.</td>
</tr>
<tr>
<td></td>
<td>Look Up Stories</td>
<td>Retrieves information in JSON format for all stories within a specified date range.</td>
</tr>
<tr>
<td></td>
<td>Update Story</td>
<td>Updates a set number of fields of a story in Jira with values passed as input.</td>
</tr>
<tr>
<td></td>
<td>Look Up Users</td>
<td>Fetches a list in JSON format of all active Jira users.</td>
</tr>
<tr>
<td></td>
<td>Create User</td>
<td>Creates a new user in Jira.</td>
</tr>
<tr>
<td></td>
<td>Remove User</td>
<td>Removes a user from Jira.</td>
</tr>
<tr>
<td></td>
<td>Get Jira Users</td>
<td>Gets all Jira user subscriptions.</td>
</tr>
<tr>
<td></td>
<td>Look up Audit Logs Stream</td>
<td>Retrieves the login activity of the Atlassian Jira user subscriptions.</td>
</tr>
<tr>
<td></td>
<td>Look up Authenticated User</td>
<td>Retrieves details of the authenticated user account.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up Group Memberships for User</td>
<td>Retrieves details of all groups of an Atlassian user.</td>
</tr>
<tr>
<td>Group Management</td>
<td>Add User to Group</td>
<td>Adds given user to a group in Jira.</td>
</tr>
<tr>
<td></td>
<td>Create Group</td>
<td>Creates a group in Jira.</td>
</tr>
<tr>
<td></td>
<td>Look up Groups Stream</td>
<td>Retrieves all groups in the Atlassian account, including the default groups.</td>
</tr>
<tr>
<td></td>
<td>Look up Users by Group Name Stream</td>
<td>Retrieves details of all members in an Atlassian group.</td>
</tr>
<tr>
<td></td>
<td>Remove Group</td>
<td>Removes the given group from Jira.</td>
</tr>
<tr>
<td></td>
<td>Remove User from Group</td>
<td>Removes the given user from a group in Jira.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get Creatable Fields</td>
<td>Retrieves the list of all fields in a required Jira project.</td>
</tr>
<tr>
<td></td>
<td>Get Editable Fields</td>
<td>Retrieves the list of all editable fields in a required Jira issue.</td>
</tr>
<tr>
<td></td>
<td>Get Issue Types</td>
<td>Retrieves the list of all issue types in a required Jira project.</td>
</tr>
<tr>
<td></td>
<td>Get Projects for Metadata</td>
<td>Retrieves the list of all Jira projects.</td>
</tr>
<tr>
<td></td>
<td>Get All Boards</td>
<td>Retrieves the details of all boards in Jira.</td>
</tr>
<tr>
<td>Sprint Management</td>
<td>Create Sprint</td>
<td>Creates a sprint in Jira.</td>
</tr>
<tr>
<td></td>
<td>Delete Sprint</td>
<td>Deletes a sprint in Jira.</td>
</tr>
<tr>
<td></td>
<td>Get All Sprints By Board</td>
<td>Retrieves the details of all sprints in the required board.</td>
</tr>
<tr>
<td></td>
<td>Get Sprint By ID</td>
<td>Retrieves the details of the required sprint as a JSON object.</td>
</tr>
<tr>
<td></td>
<td>Update Sprint</td>
<td>Updates the details of a sprint in Jira.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Utility Actions</td>
<td>Copy Issue Attachment to Record</td>
<td>Copies Attachment from Jira to any record in ServiceNow instance. When you use this action in a subflow, make sure that the Content URL data pill is specified in the Attachment URL field.</td>
</tr>
<tr>
<td></td>
<td>Look up Fields</td>
<td>Retrieves the internal name and other details of the required field label in Jira.</td>
</tr>
<tr>
<td></td>
<td>Look up Issue from Comment</td>
<td>Retrieves the details of the issue by parsing the payload for the specified comment. You can use this action in the Process Jira Webhook subflow for Jira on-prem server when only comment related information is specified without any details about the Jira issue. For example, when only comment information is specified, this action parses the payload and extracts the issue details.</td>
</tr>
<tr>
<td></td>
<td>Look up Latest Attachment on Issue</td>
<td>Retrieves the latest attachment for the specified issue from Jira. You can use this action in a flow or subflow for validation. For example, a subflow adds an additional attachment only when the latest attachment of an issue in Jira is not as the same specified attachment.</td>
</tr>
<tr>
<td></td>
<td>Look up Latest Comment on Issue</td>
<td>Retrieves the latest comment for the specified issue from Jira. You can use this action in a flow or subflow for validation. For example, a subflow adds an additional attachment only when the latest attachment of an issue in Jira is not as the same specified comment.</td>
</tr>
<tr>
<td>Webhook Management</td>
<td>Look up Webhooks</td>
<td>Retrieves details of all registered webhooks from the Jira instance.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Subscribe Webhook</td>
<td>Registers a webhook in the Jira instance.</td>
</tr>
<tr>
<td></td>
<td>Unsubscribe Webhook</td>
<td>Deleted the registered webhook in the Jira instance.</td>
</tr>
<tr>
<td></td>
<td>Update Webhook</td>
<td>Updates details of the required webhook in the Jira instance.</td>
</tr>
</tbody>
</table>

**Jira account requirements**

The Jira spoke requires generating an API token for Jira using your Atlassian account.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

This spoke uses the Jira alias record. To use these actions, you must create a connection record and a credential record and associate them with the Jira alias record.

These actions use REST calls, which can run on an instance. Use the connection record associated with the Jira alias to configure the endpoint against which the actions run.

**Set up the Jira spoke v3.0.4**

Integrate the ServiceNow instance and Jira using an API key to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub Standard subscription
- Activate the Jira spoke v3.0.4
- Role required: admin

**About this task**

You can integrate a ServiceNow instance with multiple Jira instances. For this integration, create a connection and credential alias record and a connection record for each Jira instance.
Generate a Jira account API token

Before you begin
Jira requirements:

• Atlassian account
• Atlassian administrator credentials

About this task
Complete these steps from your Atlassian account. See the Atlassian Developer portal documentation for instructions on generating your API token.

Procedure
1. From your Atlassian account, generate an access token to interact with Jira APIs.
2. Copy and record the access token to create credential records on your ServiceNow instance.

Create credential records for the Jira spoke
Create a credential record for the Jira account. The Jira spoke connection and credential alias uses this credential to authorize actions.

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?
3. Select Basic Auth Credentials.
   The pop-up window displays a blank Basic Auth Credentials form.
4. Enter these values, then click Submit.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Jira Credentials.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the email address of the user.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the API token you generated for Jira.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Search for and select the Jira credential alias.</td>
</tr>
</tbody>
</table>

**Results**
The credential record for the Jira spoke is created.

**Create connection records for the Jira spoke**
Create a connection record for the Jira account. The Jira spoke connection and credential alias uses this connection to perform actions in Jira.

**Procedure**
1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open the alias record for **Jira** that shipped with the spoke.
3. On the **Connections** tab, click **New**.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values and click **Submit**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter <strong>Jira Connection</strong>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record created for Jira. For example, select <strong>Jira Credentials</strong>.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Search for and select the Jira alias.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Enter the URL of your Jira instance.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
</tbody>
</table>

5. **Optional**: If you create a credential record to integrate your ServiceNow instance with another Jira instance, ensure that **api_version** in the Attributes related list in the associated connection record is set to 2 and specify the type...
of Jira subscription in server_type, that is, if the subscription is on-premise or cloud.

1 Note: If your Jira instance supports another API version, specify the API version in API Version in the Attributes related list. By default, API Version is 2.

Results
The Jira spoke is set up and integrated with the ServiceNow® instance.

Set up a bi-directional webhook
Configure a webhook to subscribe to Jira with a ServiceNow callback URL.

Before you begin
• Request an IntegrationHub Standard subscription
• Activate the Jira spoke v3.0.4
• Role required: admin

Create a token
Create a token to embed in the Jira webhook URL.

Before you begin
Role required: admin

Procedure
1. In the navigation filter, enter token_verification.list.
   The system displays records in the Token Verifications table.
2. Click New.
3. On the form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name to identify the token. For example, Jira token.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the token.</td>
</tr>
<tr>
<td>Token</td>
<td>Authentication token. This token is encrypted and embedded in the URL.</td>
</tr>
</tbody>
</table>
Results
The token is created to be embedded in the Jira webhook URL.

Register a Jira webhook in ServiceNow
Register a Jira webhook in ServiceNow to notify the ServiceNow app when certain events occur in Jira.

Before you begin
Role required: admin

Procedure
1. Navigate to Jira Webhooks > Jira Webhook Registries.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Jira Webhook Registry form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td>Token</td>
</tr>
<tr>
<td>Path</td>
</tr>
</tbody>
</table>
4. Right-click the form header and click Save.
5. Click Callback URL.
   The system displays the webhook callback URL.
6. Copy and record the webhook callback URL.

Results
The Jira webhook is registered in your ServiceNow instance.

Add a callback URL in Jira
Provide a webhook callback URL in your Jira Atlassian account to create a webhook.

Before you begin
Role required: admin
Procedure
1. Log in to your Jira Atlassian account.
2. Create a webhook in your Atlassian account.
3. Enter the webhook callback URL in the URL field. See the Atlassian Developer portal documentation for instructions on creating a webhook.

Results
The callback URL is added in your Jira Atlassian account. You can create routing policies and subflows as per your requirement. See Customize a bi-directional webhook for information regarding the creation of new routing policies and subflows.

Customize a bi-directional webhook
Create a webhook routing policy and subflow as per your requirement.

Before you begin
Role required: admin

About this task
The default routing policy in the Jira WebHook Routing Policies module triggers the Process Jira Webhooks subflow and notifies the ServiceNow app when certain events occur in Jira. See Jira spoke v3.0.4 for information about the fields that the default routing policy and subflows support. To use any other fields in your custom subflow and customize conditions in the routing policy, perform these steps.

Procedure
1. Navigate to Flow Designer > Designer.
2. Click Subflows.
3. Create a copy of the default subflow, Process Jira Webhooks.
4. Customize the subflow as per your requirement and publish it. See Subflows for more information about creating and using subflows and Jira spoke v3.0.4 for information about the fields that the default routing policy and subflows support.
6. Click New.
7. On the form, fill in the fields.
**Decision form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Unique label to identify the routing policy.</td>
</tr>
<tr>
<td>Default answer</td>
<td>Option to specify if this is the default answer. The default answer is applicable when the conditions are not met.</td>
</tr>
<tr>
<td>a.</td>
<td>Click the lookup icon ( ).</td>
</tr>
<tr>
<td>b.</td>
<td>Select the required subflow from the Document list.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions to be met when the required events occur in Jira. See Jira webhooks for information about the supported fields.</td>
</tr>
<tr>
<td>Answer</td>
<td>Subflow that must be triggered when the specified conditions are met.</td>
</tr>
</tbody>
</table>

8. Click **Submit**.

**Note:** These routing policies are saved in the Decision tables. Users are cautioned against directly updating or modifying data in these tables.

**Results**
The routing policy and subflow are created.

**Kubernetes spoke**
Automate changes in Kubernetes when an event occurs in ServiceNow.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.

**Note:** This spoke is available to new customers as part of an IntegrationHub Professional subscription. Existing customers can use this spoke as part of an IntegrationHub Standard subscription.
Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported versions

API version v1.

Spoke actions

The Kubernetes spoke provides actions to automate Kubernetes tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint Management</td>
<td>Create Endpoints</td>
<td>Creates an endpoint in the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Endpoints</td>
<td>Deletes an endpoint from the Kubernetes instance.</td>
</tr>
<tr>
<td>Namespace Management</td>
<td>Create Namespace</td>
<td>Creates a namespace in the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Namespace</td>
<td>Deletes a namespace from the Kubernetes instance.</td>
</tr>
<tr>
<td>Node Management</td>
<td>Create Node</td>
<td>Creates a node in the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Node</td>
<td>Deletes a node in the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Inspect Node</td>
<td>Inspects a specified node in the Kubernetes instance and returns node information and status.</td>
</tr>
<tr>
<td>Pod Management</td>
<td>Create Pod</td>
<td>Creates a Pod in the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Pod</td>
<td>Deletes a pod from the Kubernetes instance.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Inspect Pod</td>
<td>Inspects the specified pod in the Kubernetes instance and returns pod information and status.</td>
</tr>
<tr>
<td>Secret Management</td>
<td>Create Docker Hub Secret</td>
<td>Creates a secret in the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Docker Hub Secret</td>
<td>Deletes a Secret from the Kubernetes instance.</td>
</tr>
<tr>
<td>Service Management</td>
<td>Create Service</td>
<td>Creates a service on a Kubernetes server.</td>
</tr>
<tr>
<td></td>
<td>Delete Service</td>
<td>Deletes a service from the Kubernetes server.</td>
</tr>
<tr>
<td>Volume Management</td>
<td>Create Persistent Volume</td>
<td>Creates a persistent volume in the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Create Persistent Volume Claim</td>
<td>Creates a Persistent Volume Claim in a Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Persistent Volume</td>
<td>Deletes a persistent volume from the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Persistent Volume Claim</td>
<td>Deletes a persistent volume claim from the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Inspect Persistent Volume Claim</td>
<td>Inspects a persistent volume claim in a Kubernetes instance and returns claim information and status.</td>
</tr>
</tbody>
</table>

**Kubernetes account requirements**

The Kubernetes spoke requires generating and configuring your Kubernetes account to use a web API key.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any
actions that use the connection. For more information, see Connections and Credentials.

This spoke uses the Kubernetes alias record to authorize actions. To use the spoke connection alias, create an associated Connection record and an associated Credential record.

**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Kubernetes alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

**Set up Kubernetes spoke**

Integrate the ServiceNow instance and Kubernetes using an API key and certificate to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription
- Activate the Kubernetes spoke
- Role required: admin

**Generate Kubernetes API token and certificate**

Generate an access token and a certificate from your Kubernetes account for API key authentication.

**Before you begin**

Kubernetes requirements:

- Kubernetes account
- Administrator credentials on the host machine where Kubernetes is installed

**About this task**

Complete these steps from your Kubernetes host machine. See Kubernetes documentation for instructions on generating your API token and client certificate.
Procedure

1. From your Kubernetes host machine, generate an access token to interact with Kubernetes APIs. This token does not expire.

2. Copy and record the access token to create Credential records on your ServiceNow instance.

3. Generate a client certificate to upload to your ServiceNow instance.

Upload Kubernetes client certificate

Upload the Kubernetes client certificate to your ServiceNow instance to authenticate API requests to the Kubernetes host machine.

Procedure

1. Navigate to System LDAP > Certificates.

2. Click New.

3. Complete the form and enter the certificate in the PEM Certificate field.
   For more information about uploading certificates, see Upload a certificate to an instance.

4. Click Submit.

Create Credential records for the Kubernetes spoke

Create Credential records to your Kubernetes account. The Kubernetes spoke connection and credential alias uses these credentials to authorize actions.

Procedure

1. Navigate to Connections & Credentials > Credentials.

2. Click New.
   The system displays the message What type of Credentials would you like to create?.

3. Select API Key Credentials.
   A blank API Key Credentials form displays.

4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Kubernetes Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
</tbody>
</table>
Field | Value required
---|---
APISKey | Enter Bearer followed by the access token you obtained from Kubernetes. For example, Bearer {access token}.
Applies to | Select the MID Servers that can use this credential. For example, select All MID Servers.
Order | Select the order to apply this credential. For example, enter 100.

5. Click Submit.

Create Connection records for the Kubernetes spoke

Create Connection records to the Kubernetes engine. The Kubernetes spoke connection and credential alias uses these connections to perform actions in Kubernetes.

**Procedure**

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for Kubernetes.
3. From the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter Kubernetes Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for Kubernetes. For example, select Kubernetes Credentials.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>The IP address and port of the host machine where Kubernetes is installed.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Turn off remote SSL host verification

A system property prevents the Kubernetes spoke from processing Kubernetes responses. Set the com.glide.communications.httpclient.verify_hostname system property to false to enable the integration.
Procedure

1. Enter `sys_properties.list` in the application navigator. The System Properties [sys_properties] table opens.

2. Search for the `com.glide.communications.httpclient.verify_hostname` system property.

3. Set the value to false.

Microsoft AD spoke
Create, delete, and manage objects in Microsoft Active Directory, such as users, groups, and computers.

IntegrationHub subscription
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

Spoke requirements
Ensure that Active Directory Web Services (ADWS) is deployed in the same server where Microsoft AD is installed. See Microsoft documentation for information about deploying ADWS.

In the MID Server and Microsoft AD server, run these PowerShell commands to install the Active Directory module:

```
PS> Import-Module ServerManager
PS> Install-WindowsFeature -Name RSAT-AD-PowerShell
```

Spoke flows
The Microsoft AD spoke provides sample flows in the draft state to demonstrate automating Active Directory tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Offboarding</td>
<td>Enables an AD user account and removes the user from any AD groups when a ServiceNow user record is deactivated.</td>
</tr>
<tr>
<td>User Onboarding</td>
<td>Creates and enables an AD user account when a ServiceNow user record is activated.</td>
</tr>
</tbody>
</table>

Spoke subflows
This spoke has no sample subflows.
Spoke actions

The Microsoft AD spoke provides actions to automate Microsoft Active Directory tasks when events occur in the Now Platform. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Delete Computer</td>
<td>Deletes a computer from Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Disable Computer</td>
<td>Disables a computer account in Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Enable Computer</td>
<td>Enables a computer account in Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Get Computer OU</td>
<td>Gets the Organizational Unit (OU) of a Computer Account.</td>
</tr>
<tr>
<td></td>
<td>Is Computer Enabled</td>
<td>Checks the status of the specified computer account in Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Move Computer to OU</td>
<td>Changes the Organizational Unit (OU) of a Computer Account in Active Directory.</td>
</tr>
<tr>
<td>Group Management</td>
<td>Add User To Group</td>
<td>Adds an existing Active Directory user to an Active Directory group.</td>
</tr>
<tr>
<td></td>
<td>Create Group</td>
<td>Creates a group in Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Delete Group</td>
<td>Deletes a group from Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Is User In Group</td>
<td>Checks if an existing Active Directory user is a member of an Active Directory group.</td>
</tr>
<tr>
<td></td>
<td>Lookup Group</td>
<td>Gets the details of a given group in Active Directory, including the group category, scope, and distinguished name.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Remove User From Group</td>
<td>Remove User From Group</td>
<td>Removes an existing user from a group in Active Directory.</td>
</tr>
<tr>
<td>Password Management</td>
<td>Change User Password</td>
<td>Changes the user password in AD. The password input must comply with AD password requirements.</td>
</tr>
<tr>
<td></td>
<td>Is User Account Locked</td>
<td>Checks the locked status of the specified user account in AD.</td>
</tr>
<tr>
<td></td>
<td>Reset AD User Password</td>
<td>Resets a user's password in AD.</td>
</tr>
<tr>
<td>User Management</td>
<td>Create User</td>
<td>Creates a user with no password in AD. To enable a user to set a password, log in to AD, create a default password for the user, and enable password reset.</td>
</tr>
<tr>
<td></td>
<td>Delete User</td>
<td>Deletes a user from AD.</td>
</tr>
<tr>
<td></td>
<td>Disable User</td>
<td>Disables a user account in AD.</td>
</tr>
<tr>
<td></td>
<td>Enable User</td>
<td>Enables a user account in AD.</td>
</tr>
<tr>
<td></td>
<td>Is User Enabled</td>
<td>Checks the status of a user account in AD.</td>
</tr>
<tr>
<td></td>
<td>Lookup User</td>
<td>Gets the details of a given user in AD.</td>
</tr>
<tr>
<td></td>
<td>Unlock AD Account</td>
<td>Unlocks a user account in AD.</td>
</tr>
<tr>
<td></td>
<td>Update User</td>
<td>Updates user attributes in AD.</td>
</tr>
<tr>
<td></td>
<td>Update User Home Location</td>
<td>Updates the Home Directory for a User in AD.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Object Management</td>
<td>Create AD Object</td>
<td>Creates an object of any type supported in Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Delete AD Object</td>
<td>Deletes an object of any type from Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Query AD</td>
<td>Queries AD for objects specified by a search filter.</td>
</tr>
<tr>
<td></td>
<td>Update AD Object OU</td>
<td>Changes the Organizational Unit (OU) of an object in Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Update AD Object Expiration</td>
<td>Update the account expiration date of an object in Active Directory.</td>
</tr>
</tbody>
</table>

**MID server requirements**

To use these actions, your instance must have a MID Server set up and configured to use PowerShell. For more information about running actions on the MID Server, see Integration steps. For information, see MID Server.

⚠️ **Note:** MID and Microsoft AD must be installed on different servers.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection information and OAuth credentials. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you do not need to update any actions that use the connection.

This spoke uses the AD alias record to authorize actions in Microsoft Active Directory.

<table>
<thead>
<tr>
<th>Connection alias</th>
<th>Description</th>
<th>Connection URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>AD</td>
<td>Connection to Microsoft Active Directory.</td>
<td>The URL of the host machine where Microsoft Active Directory is installed.</td>
</tr>
</tbody>
</table>
Set up Microsoft AD spoke

Integrate the ServiceNow instance and your Microsoft AD account using Windows credentials to authenticate ServiceNow requests.

Before you begin

- Request IntegrationHub subscription
- Role required: admin

Create Credential record for the Microsoft AD spoke

Create a Credential record for the Microsoft Active Directory host. The Microsoft AD spoke connection and credential alias uses this credential to authorize actions.

Before you begin

- Request IntegrationHub subscription
- Role required: admin

Procedure

1. Navigate to Connections & Credentials > Credentials.

2. Click New.
   The system displays the message What type of Credentials would you like to create?.

   A blank Windows Credentials form displays.

4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter AD_Credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>User name</td>
<td>Enter a user name with access to the target Windows host. For more information about Windows permissions, see Windows credentials.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password for the account.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID servers.</td>
</tr>
</tbody>
</table>
Create Connection record for the Microsoft AD spoke

Create a Connection record to your Microsoft Active Directory host machine. The Microsoft AD spoke connection and credential alias uses this connection to perform actions in Microsoft Active Directory.

**Before you begin**

- Request IntegrationHub subscription
- Create Credential record for the Microsoft AD spoke
- Role required: admin

**Procedure**

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open for the record for **AD**.
3. From the **Connections** tab, click **New**.
   - The system displays a blank Basic Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter AD Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for Windows Active Directory. For example, select AD Credential.</td>
</tr>
<tr>
<td>Host</td>
<td>Enter the fully qualified domain name of the target host where Microsoft Active Directory is installed. For example, &lt;host&gt;.&lt;domain&gt;.com.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Enable</td>
</tr>
<tr>
<td>Override default port</td>
<td>Enter the target port used by the connection. If blank, the system uses the default port.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.
Microsoft AD v3 spoke
Create, delete, and manage objects in Microsoft Active Directory, such as users, groups, and computers.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Microsoft Active Directory.

Spoke requirements
• Ensure that Active Directory Web Services (ADWS) is deployed in the same server where Microsoft AD is installed. For more information about ADWS deployment, see Microsoft documentation.

In the MID Server and Microsoft AD server, run the following PowerShell commands to install the Active Directory module:

```
PS> Import-Module ServerManager
PS> Install-WindowsFeature -Name RSAT-AD-PowerShell
```

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• IHUB Spoke Util Pack (com.snc.ihub_spoke_util_pack)
• ServiceNow IntegrationHub Action Step - PowerShell (com.glide.hub.action_step.powershell)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.
**Spoke actions**

The Microsoft AD v2 spoke provides actions to automate tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Group Membership</strong></td>
<td>Add User to Group</td>
<td>Adds an existing user to a group in Active Directory (AD).</td>
</tr>
<tr>
<td></td>
<td>Is User in Group</td>
<td>Checks if an existing user is already a member of a group in Active Directory (AD).</td>
</tr>
<tr>
<td></td>
<td>Remove User from Group</td>
<td>Removes an existing user from a group in Active Directory (AD).</td>
</tr>
<tr>
<td></td>
<td>Look up Group Membership Stream</td>
<td>Retrieves list of groups for the specified user as a complex object.</td>
</tr>
<tr>
<td><strong>User Authentication</strong></td>
<td>Change User Password</td>
<td>Changes the user’s password in Active Directory (AD). The specified password has to match the AD password requirements.</td>
</tr>
<tr>
<td></td>
<td>Generate Random Password</td>
<td>Generates the random password according to the Active Directory (AD) password policy.</td>
</tr>
<tr>
<td></td>
<td>Is User Locked</td>
<td>Checks the locked status of the specified user account in Active Directory (AD).</td>
</tr>
<tr>
<td></td>
<td>Reset User Password</td>
<td>Resets the password of the specified user in Active Directory (AD).</td>
</tr>
<tr>
<td></td>
<td>Unlock User</td>
<td>Unlocks the specified user account in Active Directory (AD).</td>
</tr>
<tr>
<td><strong>User Management</strong></td>
<td>Delete User</td>
<td>Deletes the specified user from Active Directory (AD).</td>
</tr>
<tr>
<td></td>
<td>Disable User</td>
<td>Disables a user account in Active Directory (AD).</td>
</tr>
<tr>
<td></td>
<td>Does User Exist</td>
<td>Checks whether the specified user account exists in Active Directory (AD).</td>
</tr>
<tr>
<td></td>
<td>Enable User</td>
<td>Enables an user account in Active Directory (AD).</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Is User Disabled</td>
<td>Checks if the specified user account is disabled in AD</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**MID Server requirements**

To use these actions, your instance must have a MID Server set up and configured to use PowerShell. For more information about running actions on the MID Server, see Integration steps. For information, see MID Server.

ℹ️ **Note:** MID and Microsoft AD must be installed on different servers.

**Set up the Microsoft AD v2 spoke**

Integrate the ServiceNow instance and Microsoft AD v2 spoke by using the Windows credentials to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub subscription.
- Activate Microsoft AD v2 spoke.
- Role required: admin

**Create a connection record for the Microsoft AD v2 spoke**

Create a connection record for your Microsoft Active Directory host. The Microsoft AD v2 spoke connection and credential aliases use these connections to perform actions in Microsoft Active Directory.

**Procedure**

1. Navigate to Connections & Credentials > Connections & Credentials Aliases.
2. Open the alias record for AD_v2.
3. From the Connections tab, click New.
4. On the form, fill these fields.
Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Microsoft AD v2 Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Microsoft AD v2 spoke. For example, Microsoft AD v2 Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection. This field is auto-populated with sn_ms_ad_v2_spoke.AD_v2.</td>
</tr>
<tr>
<td>Host</td>
<td>Fully qualified domain name of the target host where the Microsoft AD v2 spoke server is installed. For example, &lt;host&gt;.&lt;domain&gt;.com.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to. Enter:</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
<tr>
<td>Override default port</td>
<td>Target port used by the connection. If blank, the system uses the default port.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Servers for this connection. If the check box is selected, define the fields in the Advanced MID Server Configuration related list.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Create a credential record for the Microsoft AD v2 spoke

Create a credential record for the Microsoft Active Directory host. The Microsoft AD v2 spoke connection and credential alias uses these credentials to authorize actions.

Procedure

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   
   The system displays this message: What type of Credentials would you like to create?
4. On the form, fill these values.
## Windows Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Name to uniquely identify the record. For example, Microsoft AD v2 Cred.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td><strong>User name</strong></td>
<td>User name with access to the target Windows host.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>Password for the account.</td>
</tr>
<tr>
<td><strong>Applies to</strong></td>
<td>Option to specify if the credential applies to all MID Servers in your network, or to one or more <strong>Specific MID servers</strong>. Specify the MID Servers that should use this credential in the <strong>MID servers</strong> field.</td>
</tr>
<tr>
<td><strong>Order</strong></td>
<td>Order to apply this credential. For example, <strong>100</strong>.</td>
</tr>
<tr>
<td><strong>Credential alias</strong></td>
<td>Credential alias associated with the spoke.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click **Submit**.

### Microsoft Azure AD spoke

Manage users, security groups, and office groups. Apply licenses and provision users in Office 365.

### IntegrationHub subscription

This spoke requires the IntegrationHub Professional subscription package. For more information, see **Request IntegrationHub**.

### Spoke flows

The Microsoft Azure AD spoke provides sample flows in the draft state to demonstrate automating Azure Active Directory tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Offboarding</strong></td>
<td>Disables an Azure AD user account and removes the user from any Azure AD groups when a ServiceNow user record is deactivated.</td>
</tr>
</tbody>
</table>
### Flow

| User Onboarding | Creates and enables an Azure AD user account when a ServiceNow user record is activated. |

### Spoke subflows

The Microsoft Azure AD spoke provides sample subflows in the draft state to demonstrate automating Azure Active Directory tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add User to Group</td>
<td>Looks up the groups that a ServiceNow User record belongs to, and adds the associated Azure AD user account to the same Azure AD groups.</td>
</tr>
</tbody>
</table>

### Spoke actions

The Microsoft Azure AD spoke provides actions to automate Azure Active Directory tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Management</td>
<td>Add Owner To Group</td>
<td>Adds an owner to an existing group in Azure AD.</td>
</tr>
<tr>
<td>Create Office 365 Group</td>
<td>Adds an existing user to a group in Azure AD.</td>
<td></td>
</tr>
<tr>
<td>Create Security Group</td>
<td>Creates an Office 365 Group in Azure AD.</td>
<td></td>
</tr>
<tr>
<td>Look Up Group ID</td>
<td>Create a Security Group in Azure AD.</td>
<td></td>
</tr>
<tr>
<td>Look Up Group Membership</td>
<td>Returns the first Group ID found based on provided search criteria.</td>
<td></td>
</tr>
<tr>
<td>Look Up Group Membership</td>
<td>Retrieves a list of groups for the given user as a JSON string.</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Remove Owner From Group</td>
<td>Removes the owner from a group in Azure AD.</td>
</tr>
<tr>
<td></td>
<td>Remove User From Group</td>
<td>Removes an existing user from a group in Azure AD.</td>
</tr>
<tr>
<td>License Management</td>
<td>Assign User License</td>
<td>Assigns a license to an existing user in Azure AD and defines access to Office 365 services. For example, if the license includes access to Microsoft Exchange, the user is provisioned a mailbox and login rights.</td>
</tr>
<tr>
<td></td>
<td>Remove User License</td>
<td>Removes a license from a user in Azure AD.</td>
</tr>
<tr>
<td>Password Management</td>
<td>Reset User Password</td>
<td>Resets the password of the specified Azure AD user account.</td>
</tr>
<tr>
<td>User Management</td>
<td>Create User</td>
<td>Creates an Azure AD user account using the specified account details.</td>
</tr>
<tr>
<td></td>
<td>Delete User</td>
<td>Deletes a user from Azure AD.</td>
</tr>
<tr>
<td></td>
<td>Disable User</td>
<td>Disables a user in Azure AD.</td>
</tr>
<tr>
<td></td>
<td>Enable User</td>
<td>Enables a user in Azure AD.</td>
</tr>
<tr>
<td></td>
<td>Is User Enabled</td>
<td>Checks whether the specified user account is enabled in Azure AD.</td>
</tr>
<tr>
<td></td>
<td>Is User In Group</td>
<td>Checks whether the specified user account is a member of the specified group in Azure AD.</td>
</tr>
<tr>
<td></td>
<td>Look Up User ID</td>
<td>Returns the first User ID found based on the provided search criteria.</td>
</tr>
<tr>
<td></td>
<td>Update User</td>
<td>Updates user properties in Azure AD with the provided details.</td>
</tr>
</tbody>
</table>

⚠️ **Note:** Azure AD does not allow updating values to null. Null or empty values are discarded in Azure AD when passed as input.
Microsoft Azure AD account requirements

The Microsoft Azure AD spoke requires creating a custom app on your Azure AD account to generate OAuth 2.0 tokens. See: Create an Azure AD application.

Connection and credential alias requirements

IntegrationHub uses aliases to manage connection information and OAuth credentials. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you do not need to update any actions that use the connection.

This spoke uses the AzureAD alias record to authorize actions on Microsoft Azure AD.

<table>
<thead>
<tr>
<th>Connection alias</th>
<th>Description</th>
<th>Connection URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>AzureAD</td>
<td>Connection to Microsoft Azure AD.</td>
<td><a href="https://graph.microsoft.com">https://graph.microsoft.com</a></td>
</tr>
</tbody>
</table>

Set up Microsoft Azure AD spoke

Integrate the ServiceNow instance and your Microsoft Azure AD account by creating a custom OAuth application in Microsoft Azure AD to authenticate ServiceNow requests.

Before you begin

- Request IntegrationHub subscription
- Role required: admin

Create an Azure AD application

Create a custom app using your Azure portal to enable OAuth 2.0 authentication with the Azure AD spoke.

Before you begin

- Request IntegrationHub subscription.
- Activate Azure AD spoke.
- Azure AD requirements:
  - Azure AD account
  - Azure AD administrator credentials
- Role required: admin
About this task
Complete these steps from your Azure portal. See the Azure Active Directory for developers documentation for instructions on creating and configuring custom applications.

Procedure
1. From your Azure portal, access Azure Active Directory.
2. Create an Azure AD application.
   a. In Redirect URI, enter your ServiceNow instance URL in this format: https://<Instance-Name>.service-now.com/oauth_redirect.do. See Create an Azure Active Directory application for instructions on registering and configuring an application.
   b. Record the Directory ID to register the app as a third-party OAuth provider on your ServiceNow instance.
   c. Create a Client Secret and record the value to register the app as a third-party OAuth provider on your ServiceNow instance.
   d. Add permissions to access the APIs. Ensure that you provide these permissions:

<table>
<thead>
<tr>
<th>Permission</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directory.AccessAsUser.All</td>
<td>Delegated</td>
</tr>
<tr>
<td>Directory.Read.All</td>
<td>Delegated</td>
</tr>
<tr>
<td>Directory.ReadWrite.All</td>
<td>Delegated</td>
</tr>
<tr>
<td>User.Read</td>
<td>Delegated</td>
</tr>
<tr>
<td>offline_access</td>
<td>Delegated</td>
</tr>
<tr>
<td>Directory.Read.All</td>
<td>Application</td>
</tr>
<tr>
<td>Directory.ReadWrite.All</td>
<td>Application</td>
</tr>
</tbody>
</table>

   See Add permissions to access web APIs for more information.
   e. Grant admin consent to your application. See Understanding API permissions and admin consent UI for more information.
What to do next
Register Azure AD as OAuth provider

Register Azure AD as OAuth provider

Use the information generated during Azure Active Directory account configuration to register Azure AD as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Procedure

1. Navigate to **System OAuth > Application Registry**.
2. Click **New**.
   The system displays the message **What kind of OAuth application?**
3. Select **Connect to a third party OAuth Provider**.
   The system displays a blank Application Registries form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Azure AD OAuth.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Enter the Client ID you created during the Azure AD application registration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Key value you created during the Azure AD application registration.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select <strong>Authorization Code</strong>.</td>
</tr>
</tbody>
</table>

5. In the **OAuth Entity Scopes** related list, create these entries

<table>
<thead>
<tr>
<th>Name</th>
<th>OAuth Scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter a unique name for the record, such as auth code.</td>
<td>Enter <code>offline_access</code>.</td>
</tr>
</tbody>
</table>
6. Right-click the form header, and click Save.
   The system validates the OAuth credentials and populates the Redirect URL and the OAuth Entity Profiles related list.

7. In the OAuth Entity Profiles related list, open the default profile record.

8. Verify that the openid entity scope record created in previous steps appears in the OAuth Entity Profile Scopes related list. If it does not appear, add the record.

Create Credential records for the Azure AD spoke

Create Credential records to the Azure AD custom app registration you created. The Azure AD spoke connection and credential aliases use these credentials to authorize actions.

Procedure

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?.
3. Select OAuth 2.0 Credentials.
   The pop-up window displays a blank OAuth 2.0 Credentials form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Azure AD Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Select the OAuth profile you created when you registered the custom Azure AD application as an OAuth provider. For example, select Azure OAuth default_profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
</tbody>
</table>
Create Connection records for the Azure AD spoke

Create Connection records to your Azure AD account. The Azure AD spoke connection and credential aliases use these connections to perform actions in Azure AD.

**Procedure**

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open the **AzureAD** record.
3. Click the **New** button in the **Connections** related list.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter Azure AD Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for Azure AD. For example, select Azure AD Credentials.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

Regenerate Azure AD OAuth token

Regenerate the Azure AD OAuth token when it expires.

**Procedure**

1. Navigate to **Connections & Credentials > Credentials**.
2. Select the Azure AD spoke OAuth Credential record.

**Example**

For example, select **Azure AD Credentials**.

3. From Related Links, click **Get OAuth Token**.
Microsoft Azure AD spoke action reference

Manage users, security groups, and office groups. Apply licenses and provision users in Office 365.

The Azure AD spoke is an available integration through IntegrationHub.

This spoke uses the Azure AD Connection & Credential Alias record. To use these actions, you must create a Connection record and a Credential record and associate them with the Azure AD Connection & Credential Alias record. To learn more about connections and credentials, see Introduction to credentials, connections, and aliases.

These actions use REST calls, which can run on an instance or MID Server. To determine when to run REST from the instance or a MID Server, see the design considerations in Integration steps. To learn more about the MID Server, see MID Server.

Add Owner To Group

Adds an owner to an existing group in Azure AD.

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group ID</td>
<td>ID of the group to add an owner to. If the Group ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
<tr>
<td>User ID</td>
<td>ID of the user to make owner of the group. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

Add User To Group

Adds an existing user to a group in Azure AD.
Create Office 365 Group
Creates an Office 365 Group in Azure AD.

Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Name to display in the address book for the group.</td>
</tr>
<tr>
<td>Group Email Alias</td>
<td>Alias configured for an email account. A single email account can have more than one alias.</td>
</tr>
<tr>
<td>Email Enable List</td>
<td>Group email address or distribution list associated with the group. By default set to true.</td>
</tr>
<tr>
<td>Description</td>
<td>Additional information about the group in Azure AD.</td>
</tr>
</tbody>
</table>

Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
</tbody>
</table>
Outputs (continued)

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group ID</td>
<td>ID of group created in Azure AD. Only populated if Status is Success.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

Create Security Group

Create a Security Group in Azure AD.

Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Name to display in the address book for the group.</td>
</tr>
<tr>
<td>Group Email Alias</td>
<td>Alias configured for an email account. A single email account can have more than one alias.</td>
</tr>
<tr>
<td>Description</td>
<td>Additional information about the group in Azure AD.</td>
</tr>
</tbody>
</table>

Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Group ID</td>
<td>ID of group created in Azure AD. Only populated if Status is Success.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

Is User In Group

Check if an existing user is a member of a group in Azure Active Directory (Azure AD).

Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group ID</td>
<td>Group ID in which you wish to check the membership of the user.</td>
</tr>
</tbody>
</table>
### Inputs (continued)

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>User ID or User Principal Name of the Azure AD user.</td>
</tr>
</tbody>
</table>

### Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Will be set to Success if the request succeeds or Error if a failure in Azure AD occurs</td>
</tr>
<tr>
<td>Answer</td>
<td>True if the user is a member of the group. False if the user is not a member of the group. Populated only if Status is Success.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

### Look Up Group ID

Returns the first Group ID found based on provided search criteria.

### Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Mail ID</td>
<td>Group email address or distribution list associated with the group.</td>
</tr>
<tr>
<td>Display Name</td>
<td>Name to display in the address book for the group.</td>
</tr>
<tr>
<td>Group Email Alias</td>
<td>Alias configured for an email account. A single email account can have more than one alias.</td>
</tr>
</tbody>
</table>

### Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Group ID</td>
<td>First group found with matching criteria in Azure AD.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>
Look Up Group Membership
Retrieves a list of groups for the given user as a JSON string.

**Inputs**

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>ID of the users to retrieve the group for. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
</tbody>
</table>

**Outputs**

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>
| Groups List             | List of groups in JSON format. For example, 
{Group ID1, Group Name1}, {Group ID2, Group Name2}. If the user is not part of any group, an empty string is returned. |
| Number of Groups Found  | Total number of groups the user is a member of.                              |

Remove Owner From Group
Removes the owner from a group in Azure AD.

**Inputs**

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group ID</td>
<td>ID of the group to remove the owner from. If the Group ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
<tr>
<td>User ID</td>
<td>ID of the user to remove as owner of the group. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
</tbody>
</table>

**Outputs**

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
</tbody>
</table>
## Remove User From Group
Removes an existing user from a group in Azure AD.

### Inputs
<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group ID</td>
<td>ID of the group to remove the user from. If the Group ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
<tr>
<td>User ID</td>
<td>ID of the user to remove from the group. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
</tbody>
</table>

### Outputs
<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

## Assign User License
Assigns a license to an existing user in Azure AD and defines access to Office 365 services. For example, if the license includes access to Microsoft Exchange, the user is provisioned a mailbox and login rights.

### Inputs
<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>ID of the user to assign a license to. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
<tr>
<td>SKU ID</td>
<td>Licensing plan for your organization using the syntax <code>&lt;CompanyName&gt;:&lt;LicensingPlan&gt;</code>. If the SKU ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
</tbody>
</table>
**Outputs**

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

**Remove User License**

Removes a license from a user in Azure AD.

**Inputs**

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>ID of the user to remove the license from. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
<tr>
<td>SKU ID</td>
<td>Licensing plan for your organization using the syntax <code>&lt;CompanyName&gt;:&lt;LicensingPlan&gt;</code>. If the SKU ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
</tbody>
</table>

**Outputs**

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

**Delete User**

Deletes a user from Azure AD.

**Inputs**

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>ID of the user to delete. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
<tr>
<td>Output</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

### Disable User
Disables a user in Azure AD.

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>ID of the user to disable. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

### Enable User
Enables a user in Azure AD.

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>ID of the user to enable. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
</tbody>
</table>
Outputs (continued)

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

**Look Up User ID**

Returns the first User ID found based on the provided search criteria.

**Inputs**

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>First name of the user.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Last name of the user.</td>
</tr>
<tr>
<td>Display Name</td>
<td>Name displayed in the address book for the user.</td>
</tr>
<tr>
<td>User Login ID</td>
<td>Login User ID is same as User Principal Name (UPN). For example, <a href="mailto:johndoe@snc.com">johndoe@snc.com</a>.</td>
</tr>
<tr>
<td>Email Alias</td>
<td>Alias configured for an email account. A single email account can have more than one alias.</td>
</tr>
</tbody>
</table>

**Outputs**

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>User ID</td>
<td>First user found with matching criteria in Azure AD.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

**Update User**

Updates user properties in Azure AD with the provided details.

**Note:** Azure AD does not allow updating values to null. Null or empty values are discarded in Azure AD when passed as input.
## Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Name to display in the address book for the user.</td>
</tr>
<tr>
<td>Email Alias</td>
<td>Alias configured for an email account. A single email account can have more than one alias.</td>
</tr>
<tr>
<td>User Login ID</td>
<td>Login User ID is same as User Principal Name (UPN). For example, <a href="mailto:johndoe@snc.com">johndoe@snc.com</a>. This field is mandatory</td>
</tr>
<tr>
<td>First Name</td>
<td>First name of the user.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Last name of the user.</td>
</tr>
<tr>
<td>City</td>
<td>City of the user.</td>
</tr>
<tr>
<td>Country</td>
<td>Country of the user.</td>
</tr>
<tr>
<td>Department</td>
<td>Name of the department the user belongs to.</td>
</tr>
<tr>
<td>Mobile</td>
<td>Mobile phone number for the user.</td>
</tr>
<tr>
<td>Job Title</td>
<td>User job title.</td>
</tr>
<tr>
<td>Physical Delivery</td>
<td>Office location of the user.</td>
</tr>
<tr>
<td>Office Name</td>
<td></td>
</tr>
<tr>
<td>Postal Code</td>
<td>Postal code for the user.</td>
</tr>
<tr>
<td>Preferred Language</td>
<td>Preferred language for the user.</td>
</tr>
<tr>
<td>State</td>
<td>State for the user.</td>
</tr>
<tr>
<td>Street Address</td>
<td>Street address for the user.</td>
</tr>
<tr>
<td>Telephone Number</td>
<td>Telephone number for the user.</td>
</tr>
<tr>
<td>Usage Location</td>
<td>Some Microsoft services are not available in all locations. This property must be defined for the user in Azure AD before a license can be assigned to them.</td>
</tr>
</tbody>
</table>
Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

**Microsoft Azure Application Insights spoke**

Manage queries, events, and metrics in Microsoft Azure Application Insights account from your ServiceNow instance.

**Request apps on the Store**

Visit the [ServiceNow Store](https://service-now.com/store) website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the [ServiceNow Store version history](https://service-now.com/store/release_notes).

**IntegrationHub subscription**

This spoke requires the IntegrationHub Professional subscription package. For more information, see [Request IntegrationHub](https://service-now.com/store/integrationhub).

**Supported versions**

This spoke was built for Microsoft Azure Application Insights API version v1, but may be compatible with later versions.

**Spoke requirements**

- Register the application in the Microsoft Azure portal and record the access keys and directory IDs. For more information, see [Azure Application Insights Search API](https://azure.microsoft.com/en-us/services/app-insights/) in [Azure Application Insights REST API documentation](https://docs.microsoft.com/en-us/microsoft-azure/app-insights/api-rest).

- Add your the redirect URL of your ServiceNow instance in your registered application. The redirect URL must be in this format: `https://<instance>.service-now.com/oauth_redirect.do`. For more information, see [Authentication and authorization for Azure Time Series Insights API](https://docs.microsoft.com/en-us/azure/insights/doc/authentication) in [Microsoft Docs](https://docs.microsoft.com).

- Create an API key and record the values of API Key and App ID. These values are needed as inputs to the spoke actions. For more information, see [Getting your API key and Application ID](https://docs.microsoft.com/en-us/microsoft-azure/app-insights/api-rest) in [Azure Application Insights REST API documentation](https://docs.microsoft.com/en-us/microsoft-azure/app-insights/api-rest).
Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Complex Object (com.glide.cobject)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Microsoft Azure Application Insights spoke provides actions to automate tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Management</td>
<td>Get By Type</td>
<td>Executes an OData query for event.</td>
</tr>
<tr>
<td></td>
<td>Get Event</td>
<td>Retrieves the data of the required event in JSON format.</td>
</tr>
<tr>
<td></td>
<td>Get Odata Metadata</td>
<td>Retrieves the OData EDMX metadata that describes the event data model.</td>
</tr>
<tr>
<td>Metric Management</td>
<td>Get Metadata</td>
<td>Retrieves metadata describing the available metrics.</td>
</tr>
<tr>
<td></td>
<td>Get Metrics</td>
<td>Retrieves metric values for a single metric.</td>
</tr>
<tr>
<td></td>
<td>Get Multiple</td>
<td>Retrieves metric values for multiple metrics.</td>
</tr>
<tr>
<td>Query Management</td>
<td>Execute Query</td>
<td>Executes the specified analytics query.</td>
</tr>
<tr>
<td></td>
<td>Get Query</td>
<td></td>
</tr>
</tbody>
</table>

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and
connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the Microsoft Azure Application Insights spoke

Integrate the ServiceNow instance and Microsoft Azure Application Insights account by creating a custom OAuth application in Microsoft Azure Application Insights to authenticate ServiceNow requests.

Before you begin

- Request an IntegrationHub subscription.
- Activate Microsoft Azure Application Insights spoke.
- Role required: admin

Register Microsoft Azure Application Insights as an OAuth provider

Use the information generated during the Microsoft Azure Application Insights account configuration to register Microsoft Azure Application Insights as an OAuth provider and allow the ServiceNow instance to request OAuth 2.0 tokens.

Procedure

1. Navigate to **System OAuth > Application Registry**.
2. Open for the record, **Azure Application Insights**.
3. On the form, fill these values.

### Application Registries form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Client ID created during the Microsoft Azure Application Insights application registration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret created during the Microsoft Azure Application Insights application registration.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>OAuth authorization code endpoint. Enter: <a href="https://login.microsoftonline.com/">https://login.microsoftonline.com/</a>&lt;directory-id&gt;/oauth2/v2.0/authorize Replace &lt;directory-id&gt; with the directory ID of your Azure Application Insights account.</td>
</tr>
<tr>
<td>Token URL</td>
<td>OAuth server token endpoint. Enter: //login.microsoftonline.com/&lt;directory-id&gt;/oauth2/v2.0/token</td>
</tr>
</tbody>
</table>
Replace `<directory-id>` with the directory ID of your Azure Application Insights account.

Redirect URL

OAuth callback endpoint in this format: `https://<instance>.service-now.com/oauth_redirect.do`

4. Right-click the form header, and click **Save**.

Create a credential record for the Microsoft Azure Application Insights spoke

Create a credential record for the Microsoft Azure Application Insights account. The Microsoft Azure Application Insights spoke connection and credential alias uses these credentials to authorize actions.

Procedure

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
   
   The system displays this message: What type of Credentials would you like to create?
3. Select **OAuth 2.0 Credentials**.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>OAuth 2.0 Credentials form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter <code>Azure Application Insight OAuth</code></td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Entity profile of Azure Resource Management spoke. Azure Application Insights default_profile</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential Alias of the dependant Azure Resource Management spoke. <code>x_snc_app_ins.Azure_Application_Insights</code></td>
</tr>
</tbody>
</table>
5. Right-click the form header and click Submit.

6. To generate the OAuth token, click the Get OAuth Token related link.

**Microsoft Azure Artifacts spoke**

Manage Microsoft Azure Artifacts from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.

**Supported versions**

This spoke was built for Microsoft Azure Artifacts 6.0-preview.1, but may be compatible with later versions.

**Spoke requirements**

- Azure Devops Account

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- Complex Object (com.glide.cobject)

**Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.
**Spoke actions**

The Microsoft Azure Artifacts spoke provides actions to automate Microsoft Azure Artifacts tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Artifact Management</td>
<td>Get Package Details</td>
<td>Retrieves details of the specified package.</td>
</tr>
<tr>
<td></td>
<td>Get Package Version Details</td>
<td>Retrieves version details of the specified package.</td>
</tr>
<tr>
<td></td>
<td>Look up Package Versions</td>
<td>Retrieves a list of package versions.</td>
</tr>
<tr>
<td></td>
<td>Look up Packages</td>
<td>Retrieves a list of packages.</td>
</tr>
<tr>
<td>Change Tracking Management</td>
<td>Get Feed Change</td>
<td>Retrieves details of the current state of a feed.</td>
</tr>
<tr>
<td></td>
<td>Look up Feed Changes</td>
<td>Retrieves a list of changes of a feed.</td>
</tr>
<tr>
<td></td>
<td>Look up Package Changes</td>
<td>Retrieves a list of packages that changed in a feed.</td>
</tr>
<tr>
<td>Feed Management</td>
<td>Create Feed</td>
<td>Creates a feed to handle various package types.</td>
</tr>
<tr>
<td></td>
<td>Delete Feed</td>
<td>Removes the feed and all the related packages.</td>
</tr>
<tr>
<td></td>
<td>Get Feed Details</td>
<td>Retrieves the details of the feed.</td>
</tr>
<tr>
<td></td>
<td>Look up Feeds</td>
<td>Retrieves a list of feeds.</td>
</tr>
<tr>
<td></td>
<td>Update Feed</td>
<td>Updates the specified feed.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Look up Package IDs</td>
<td>Retrieves the metadata of a list of package IDs.</td>
</tr>
<tr>
<td></td>
<td>Look up Package Version IDs</td>
<td>Retrieves the metadata of a list of package version IDs.</td>
</tr>
<tr>
<td></td>
<td>Look up Projects</td>
<td>Retrieves a list of all project within an organization.</td>
</tr>
</tbody>
</table>
Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the Microsoft Azure Artifacts spoke

Integrate the ServiceNow instance and Microsoft Azure Artifacts using Basic Authentication to authenticate ServiceNow requests.

Before you begin

- Request an IntegrationHub subscription.
- Activate Microsoft Azure Artifacts spoke.
- Create a Personal Access Token in your Azure DevOps account and record it for later use.
- Role required: admin

Create a credential record for the Microsoft Azure Artifacts spoke

Create a credential record for the Azure DevOps portal account. The Microsoft Azure Artifacts spoke connection and credential alias uses these credentials to authorize actions.

Procedure

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
3. Select Basic Auth Credentials.
4. On the form, fill these values.

Basic Auth Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Azure Artifacts Cred.</td>
</tr>
</tbody>
</table>
Create a connection record for the Microsoft Azure Artifacts spoke

Create a connection record for your Azure Devops account. The Microsoft Azure Artifacts spoke connection and credential aliases use these connections to perform actions in Microsoft Azure Artifacts.

**Procedure**

1. Navigate to **Connections & Credentials > Connections & Credentials Aliases**.
2. Open the alias record for **Microsoft Azure Artifacts**.
3. From the **Connections** tab, click **New**.
4. On the form, fill these fields.

## Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, <strong>Azure Artifacts Connection</strong>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Microsoft Azure Artifacts spoke. For example, <strong>Azure Artifacts Cred</strong>.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection. The auto-populated value is <strong>sn_ms_artfcts_spke.Microsoft_Azure_Artifacts</strong></td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to <strong>Azure Devops</strong>. Enter: <code>https://feeds.dev.azure.com/</code></td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain</td>
<td>Domain that the action runs in. The auto-populated value is global.</td>
</tr>
<tr>
<td>Override default port</td>
<td>Target port used by the connection. If blank, the system uses the default port.</td>
</tr>
</tbody>
</table>

ℹ️ **Note:** Make sure that the **Version** field in the **Attributes** is 6.0-preview.1

5. Click **Submit**.

**Microsoft Azure Blob Storage spoke v1.0.4**

Manage Azure blobs and containers from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Spoke dependencies**

Microsoft Azure Resource Management spoke

**Supported versions**

This spoke was built for API version 2019-07-07, but may be compatible with later versions.
Spoke requirements

- Storage account in your Microsoft Azure portal for integration with your ServiceNow instance.

**Note:** Ensure that the user has the Storage Blob Data Owner role. To assign the role:

1. Log in to your storage account and navigate to Access Control (IAM).
2. Click the Add a role assignment and select Storage Blob Data Owner role.
3. Assign access to the required Azure AD user, group, or service principle option. For this, select the email address of the Azure account and save the changes.

### Add role assignment

Select **Storage Blob Data Owner**

Assign access to **Azure AD user, group, or service principal**

For more information, see Use the Azure portal to assign an Azure role for access to blob and queue data.

- Record and save the access keys and Directory ID for later use.

Spoke subflows

The Azure Blob Storage spoke provides sample subflows to demonstrate automating the Azure Blob Storage tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Blob</td>
<td>Moves a blob from source container to destination container.</td>
</tr>
<tr>
<td>Rename Blob</td>
<td>Renames the specified blob.</td>
</tr>
</tbody>
</table>
Spoke actions

The Azure Blob Storage spoke provides actions to automate Azure Blob Storage tasks when events occur in the Now Platform. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blob Management</td>
<td>Attach Blob To ServiceNow Record</td>
<td>Attaches a blob to ServiceNow record.</td>
</tr>
<tr>
<td></td>
<td>Copy Blob</td>
<td>Copies a blob from one container to another container.</td>
</tr>
<tr>
<td></td>
<td>Delete Blob</td>
<td>Deletes the specified blob.</td>
</tr>
<tr>
<td></td>
<td>Get Blob Details</td>
<td>Retrieves details of the specified blob.</td>
</tr>
<tr>
<td></td>
<td>Lease Blob</td>
<td>Creates a lock on a blob for write and delete operations.</td>
</tr>
<tr>
<td></td>
<td>Look up Blob</td>
<td>Retrieves details of all blobs in a container.</td>
</tr>
<tr>
<td></td>
<td>Release Lease On Blob</td>
<td>Releases a lock on a blob.</td>
</tr>
<tr>
<td></td>
<td>Snapshot Blob</td>
<td>Creates a snapshot for the specified blob.</td>
</tr>
<tr>
<td></td>
<td>Upload ServiceNow Attachment To Container</td>
<td>Uploads a blob to the specified container.</td>
</tr>
<tr>
<td>Container Management</td>
<td>Create Container</td>
<td>Creates a container.</td>
</tr>
<tr>
<td></td>
<td>Delete Container</td>
<td>Deletes the specified container.</td>
</tr>
<tr>
<td></td>
<td>Get Container Details</td>
<td>Retrieves details of the specified container.</td>
</tr>
<tr>
<td></td>
<td>Lease Container</td>
<td>Creates a lock on the container for delete operations.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up Container</td>
<td>Retrieves details of all containers.</td>
</tr>
<tr>
<td></td>
<td>Release Lease On Container</td>
<td>Releases a lock on a container.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

⚠️ **Note:** Two Credential aliases are available for the Azure Blob Storage spoke.

**Set up the Azure Blob Storage spoke**

Integrate the ServiceNow instance and your Azure Blob Storage account by creating a custom OAuth application in Azure to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription.
- Activate the Azure Blob Storage spoke.
- User with the Storage Blob Data Owner role
Note:
To assign the role:

1. Log in to your storage account and navigate to Access Control (IAM).
2. Click the Add a role assignment and select Storage Blob Data Owner role.
3. Assign access to the required Azure AD user, group, or service principle option. For this, select the email address of the Azure account and save the changes.

Add role assignment

Role
Storage Blob Data Owner

Assign access to
Azure AD user, group, or service principal

Select

For more information, see Use the Azure portal to assign an Azure role for access to blob and queue data.

- Role required: admin

Register Azure Blob Storage as OAuth provider
Use the information generated during Azure Blob Storage account configuration to register your Azure Blob Storage as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Procedure
1. Navigate to System OAuth > Application Registry.
2. Open the record, Azure Blob Storage Spoke.
   The system displays the Application Registries form.
3. Enter these values.
Field | Value required
--- | ---
Client ID | Client ID you created during the Azure Blob Storage account registration.
Client Secret | Key value you created during the Azure Blob Storage account registration.
Token URL | Token URL in this format: https://login.microsoftonline.com/<directory-id>/oauth2/v2.0/token. Replace <directory-id> with the Directory ID of your Azure Blob Storage account.
Redirect URL | Redirect URI in this format: https://<instance>.service-now.com/oauth_redirect.do. Replace <instance> with the name of your ServiceNow instance.

4. Right-click the form header, and click Save.

Create Credential records for the Azure Blob Storage spoke

Create two Credential records for your Azure Blob Storage account. The Azure Blob Storage spoke connection and credential alias uses these credential records to perform actions in your Azure Blob Storage account.

Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record, Azure_Blob_Storage.
3. From the Credentials tab, click New.
   The system displays the message What type of Credentials would you like to create?.
4. Select OAuth 2.0 Credentials.
5. On the form, fill these values.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Active</strong></td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td><strong>OAuth Entity Profile</strong></td>
<td>Default OAuth Entity Profile. For example, Azure Blob Storage Spoke default_profile.</td>
</tr>
<tr>
<td><strong>Credential alias</strong></td>
<td>Credential record associated with <strong>Azure_Blob_Storage</strong>.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

7. Navigate to **Connections & Credentials > Connection & Credential Aliases**.

8. Open for the record, **Azure_Blob_Storage_SAS**.

9. From the **Credentials** tab, click **New**.
   The system displays the message **What type of Credentials would you like to create?**.

10. Select **Azure Shared Access Signature**.

11. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Name to uniquely identify the connection record. For example, enter Azure Blob Storage SAS Cred.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td><strong>Shared Access Key Name</strong></td>
<td>Name to identify the Shared Access Key record.</td>
</tr>
<tr>
<td><strong>Shared Access Key</strong></td>
<td>Shared Access Key of your Azure Blob Storage account.</td>
</tr>
<tr>
<td><strong>Credential alias</strong></td>
<td>Credential record associated with <strong>Azure_Blob_Storage_SAS</strong>.</td>
</tr>
<tr>
<td><strong>Authentication For</strong></td>
<td>Azure product for which this credential record is used. Select <strong>Blob Storage</strong>.</td>
</tr>
<tr>
<td><strong>Authentication Algorithm</strong></td>
<td>Custom authentication algorithm for outbound signing requests. Select <strong>AzureSASAlgo</strong>.</td>
</tr>
</tbody>
</table>

   ⚠ **Note:** Users are cautioned against directly modifying the default authentication algorithm.

12. Click **Submit**.
**Microsoft Azure Cosmos DB spoke v1.0.1**
Manage Microsoft Azure Cosmos DB from your ServiceNow instance.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Supported versions**
This spoke was built for Microsoft Azure Cosmos DB v1, but may be compatible with later versions.

**Spoke requirements**
- Microsoft Azure Portal account

**Spoke dependencies**
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- Complex Object (com.glide.cobject)
- Microsoft Azure Resource Management spoke (com.sn.ms.azure.resource.mgmt.spoke)

ℹ️ **Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke actions**
The Microsoft Azure Cosmos DB Spoke provides actions to automate Microsoft Azure Cosmos DB tasks when events occurs in your ServiceNow instance. Available actions include:
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cassandra Database</td>
<td>Create Cassandan Keyspace</td>
<td>Creates a Cassandra keyspace.</td>
</tr>
<tr>
<td>Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delete Cassandan Keyspace</td>
<td>Deletes the specified Cassandra keyspace.</td>
</tr>
<tr>
<td></td>
<td>Get Cassandan Keyspace Information</td>
<td>Retrieves information about the specified Cassandra keyspace information.</td>
</tr>
<tr>
<td></td>
<td>Look up Cassandan Keyspaces</td>
<td>Retrieves a list of Cassandra keyspaces in the specified Subscription ID.</td>
</tr>
<tr>
<td></td>
<td>Update Cassandan Keyspace</td>
<td>Updates Request Units (RUs) per second of a Cassandra keyspace.</td>
</tr>
<tr>
<td>Core SQL Database</td>
<td>Create Database</td>
<td>Creates a database in the specified database account.</td>
</tr>
<tr>
<td>Management</td>
<td>Create Permission</td>
<td>Creates a permission in the specified database.</td>
</tr>
<tr>
<td></td>
<td>Create User</td>
<td>Creates a user in the specified database.</td>
</tr>
<tr>
<td></td>
<td>Delete Database</td>
<td>Deletes the specified database.</td>
</tr>
<tr>
<td></td>
<td>Delete Permission</td>
<td>Deletes the specified permission in a database.</td>
</tr>
<tr>
<td></td>
<td>Delete User</td>
<td>Deletes the specified user.</td>
</tr>
<tr>
<td></td>
<td>Get Database Information</td>
<td>Retrieves the specified database information.</td>
</tr>
<tr>
<td></td>
<td>Get Permission Information</td>
<td>Retrieves the specified permission information.</td>
</tr>
<tr>
<td></td>
<td>Get User Information</td>
<td>Retrieves the specified user information.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Look up Databases</td>
<td></td>
<td>Retrieves a list of databases in the specified database account.</td>
</tr>
<tr>
<td>Look up Permissions</td>
<td></td>
<td>Retrieves a list of permissions of the specified database.</td>
</tr>
<tr>
<td>Look up Users</td>
<td></td>
<td>Retrieves a list of all the users in the database.</td>
</tr>
<tr>
<td>Replace Permission</td>
<td></td>
<td>Replaces the specified permission for the specified user.</td>
</tr>
<tr>
<td>Replace User</td>
<td></td>
<td>Replaces the specified user name in the specified database.</td>
</tr>
<tr>
<td>Database Account Management</td>
<td>Create DB Account</td>
<td>Creates an account in Azure Cosmos DB.</td>
</tr>
<tr>
<td></td>
<td>Delete DB Account</td>
<td>Deletes the specified Cosmos DB account.</td>
</tr>
<tr>
<td></td>
<td>Enable/Disable Options On DB</td>
<td>Enables or disables options of the specified database account.</td>
</tr>
<tr>
<td></td>
<td>Account</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Get DB Account Information</td>
<td>Retrieves information about the specified account in the specified resource group.</td>
</tr>
<tr>
<td></td>
<td>Look up Connection Strings</td>
<td>Retrieves a list of all connections strings in the specified Azure Cosmos DB account.</td>
</tr>
<tr>
<td></td>
<td>Look up DB Account By Resource Group</td>
<td>Retrieves a list of all Azure Cosmos DB database accounts in the specified resource group.</td>
</tr>
<tr>
<td></td>
<td>Look up DB Account By Subscription ID</td>
<td>Retrieves a list of Azure Cosmos DB accounts in the specified subscription ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Keys</td>
<td>Retrieves a list of all access keys in the specified Azure Cosmos DB database account.</td>
</tr>
<tr>
<td></td>
<td>Look up Usages</td>
<td>Retrieves the most recent data in the specified database account.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Regenerate Key</td>
<td>Regenerates an access key for the specified Azure Cosmos DB account.</td>
</tr>
<tr>
<td></td>
<td>Update Failover Priority</td>
<td>Updates the failover property of the specified Azure Cosmos DB account.</td>
</tr>
<tr>
<td>Mongo Database Management</td>
<td>Create MongoDB Database</td>
<td>Creates a MongoDB database.</td>
</tr>
<tr>
<td></td>
<td>Delete MongoDB Database</td>
<td>Deletes the specified MongoDB database.</td>
</tr>
<tr>
<td></td>
<td>Get MongoDB Database Information</td>
<td>Retrieves the specified MongoDB database information in the specified database account.</td>
</tr>
<tr>
<td></td>
<td>Look up MongoDB Database</td>
<td>Retrieves a list of all MongoDB databases in the specified subscription ID.</td>
</tr>
<tr>
<td></td>
<td>Update MongoDB Database</td>
<td>Updates Request Units (RUs) per second of a MongoDB database.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

**Set up the Microsoft Azure Cosmos DB spoke**

Integrate the ServiceNow instance and Microsoft Azure Cosmos DB by creating a custom OAuth application in Microsoft Azure Portal to authenticate ServiceNow requests.
Before you begin

- Request an IntegrationHub subscription.
- Activate Microsoft Azure Cosmos DB Spoke.
- Role required: admin

Register Microsoft Azure Cosmos DB as an OAuth provider

Use the information generated during the Azure Portal account configuration to register Microsoft Azure Cosmos DB as an OAuth provider and allow the ServiceNow instance to request OAuth 2.0 tokens.

Procedure

1. Navigate to System OAuth > Application Registry.
2. Open for the record for Azure Resource Management.
3. On the form, fill these values.

Application Registries form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID created during the Azure Portal account configuration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret created during the Azure Portal account configuration.</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>OAuth server token revocation endpoint.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint in this format: https://&lt;instance&gt;.service-now.com/oauth_redirect.do</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**.

**Create a credential record for the Microsoft Azure Cosmos DB spoke**

Create a credential record for the Microsoft Azure Cosmos DB account. The Microsoft Azure Cosmos DB Spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to **IntegrationHub > Connections & Credentials > Credentials**.
2. Click **New**.
   
   The system displays this message: **What type of Credentials would you like to create?**
3. Select **OAuth 2.0 Credentials**.
4. On the form, fill these values.

#### OAuth 2.0 Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Azure Cosmos DB OAuth Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile created during the registration of Microsoft Azure Cosmos DB Spoke as an OAuth provider. For example, Azure Cosmos DB OAuth Profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Option to specify if the credential applies to all MID Servers in your network, or to one or more <strong>Specific MID servers</strong>. Specify the MID Servers that should use this credential in the <strong>MID servers</strong> field.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, 100.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias associated with the spoke.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click **Submit**.
6. To generate the OAuth token, click the **Get OAuth Token** related link.
Microsoft Azure Managed Storage spoke v1.0.6
Manage Microsoft Azure managed disks from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• Complex Object (com.glide.cobject)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• Microsoft Azure Resource Management spoke (com.sn.ms.azure.resource.mgmt.spoke)

⚠️ Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported Versions
This spoke was built for API version 2019-07-01, but may be compatible with later versions.

Spoke requirements
• User account with full access to Microsoft Azure managed disks.
• Microsoft Azure Resource Management spoke

Spoke flows and subflows
This spoke has no flows and subflows.
Spoke actions

The Microsoft Azure Managed Storage spoke provides actions to automate Microsoft Azure disks and disk snapshots when events occur in ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk Management</td>
<td>Create Managed Disk</td>
<td>Creates a disk with the specified disk size in gigabytes (GB).</td>
</tr>
<tr>
<td></td>
<td>Create Managed Disk From Snapshot</td>
<td>Creates a disk using a snapshot.</td>
</tr>
<tr>
<td></td>
<td>Create Managed Upload Disk</td>
<td>Creates a disk with the specified upload size.</td>
</tr>
<tr>
<td></td>
<td>Delete Disk</td>
<td>Deletes the specified disk.</td>
</tr>
<tr>
<td></td>
<td>Get Disk Information</td>
<td>Retrieves the specified disk information in a specified resource group.</td>
</tr>
<tr>
<td></td>
<td>Grant Access To Disk Data</td>
<td>Grants access to the specified disk.</td>
</tr>
<tr>
<td></td>
<td>Look up Disks By Resource Group</td>
<td>Retrieves a list of disks for the specified resource group.</td>
</tr>
<tr>
<td></td>
<td>Look up Disks By Subscription</td>
<td>Retrieves a list of disks in a subscription.</td>
</tr>
<tr>
<td></td>
<td>Revoke Access From Disk Data</td>
<td>Revokes access to the specified disk.</td>
</tr>
<tr>
<td></td>
<td>Set Disk Tags</td>
<td>Assigns tags to the specified disk.</td>
</tr>
<tr>
<td></td>
<td>Update Disk Size</td>
<td>Updates the size of the specified disk.</td>
</tr>
<tr>
<td></td>
<td>Update Disk Storage Account</td>
<td>Updates the details of the storage account.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Disk Snapshot Management</td>
<td>Create Snapshot</td>
<td>Creates a snapshot of the disk.</td>
</tr>
<tr>
<td></td>
<td>Delete Snapshot</td>
<td>Deletes the specified snapshot.</td>
</tr>
<tr>
<td></td>
<td>Get Snapshot Information</td>
<td>Retrieves information about the specified snapshot.</td>
</tr>
<tr>
<td></td>
<td>Grant Access to Disk Snapshot</td>
<td>Grants access to the specified snapshot.</td>
</tr>
<tr>
<td></td>
<td>Look up Snapshot By Resource Group</td>
<td>Retrieves a list of snapshots in a resource group.</td>
</tr>
<tr>
<td></td>
<td>Look up Snapshot By Subscription</td>
<td>Retrieves a list of snapshots in a subscription.</td>
</tr>
<tr>
<td></td>
<td>Revoke Access From Snapshot</td>
<td>Revokes access to the specified snapshot.</td>
</tr>
<tr>
<td></td>
<td>Set Snapshot Tags</td>
<td>Assigns tags of the specified snapshot.</td>
</tr>
<tr>
<td></td>
<td>Update Snapshot Size</td>
<td>Updates the disk size of the specified snapshot.</td>
</tr>
<tr>
<td></td>
<td>Update Snapshot Storage Account</td>
<td>Updates the details of the storage account associated with the specified snapshot.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any
actions that use the connection. For more information, see Connections and Credentials.

**Set up Microsoft Azure Managed Storage spoke**
Integrate the ServiceNow instance and Azure Managed Storage using OAuth credentials to authenticate ServiceNow requests.

**Before you begin**
- Request an IntegrationHub Enterprise subscription
- Activate the Microsoft Azure Managed Storage spoke
- Role required: admin

**Configure app registration for Microsoft Azure Managed Storage spoke**
Configure app registration from your Azure account to add redirect URIs, credentials, and permissions to access web APIs for your application. For more information, see Quickstart: Configure a client application to access web APIs

**Before you begin**
- Azure account with admin privileges

**Procedure**

1. Sign into Azure portal.
2. Register your app with the following platform settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter Web app/API.</td>
</tr>
<tr>
<td>Supported account types</td>
<td>Specify the account types who can use the application.</td>
</tr>
<tr>
<td>Redirect URI</td>
<td>Specify the URI in this format: https://&lt;instance&gt;.service-now.com/</td>
</tr>
<tr>
<td></td>
<td>oauth_redirect.doReplace &lt;instance&gt; with the name of your ServiceNow</td>
</tr>
</tbody>
</table>

3. Record the client ID and client secret of the app which are used for authentication.
Register Azure Managed Storage as OAuth provider

Use the authentication information from Azure account configuration to register Azure Managed Storage as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Procedure

1. Navigate to **System OAuth > Application Registry**.
2. Open the Azure Resource Management application registry record.
3. On the form, fill the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Client ID created during Azure virtual account registration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Key value created during Azure virtual account registration.</td>
</tr>
<tr>
<td>Token URL</td>
<td>The URL used for OAuth tokens. The format of the URL is \<a href="https://login.microsoftonline.com/">https://login.microsoftonline.com/</a>&lt;Directory ID&gt;/oauth2/v2.0/token. Replace &lt;Directory ID&gt; with the directory ID in your Azure configuration properties.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>The URL of the instance used for redirection. The format of the URL is \https://&lt;instance&gt;.servicenow.com/oauth_redirect.do. Replace &lt;instance&gt; with the name of your ServiceNow instance.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**.
Create Credential records for the Microsoft Azure Managed Storage spoke

Create Credential records to the Azure Managed Storage app registration you created. The Microsoft Azure Managed Storage spoke connection and credential aliases uses these credentials to authorise actions.

Before you begin
Role required: admin

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?
3. Select OAuth 2.0 Credentials.
4. On the form, fill these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the credentials record. For example, enter Azure Managed Storage.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>The OAuth profile you created when you registered the custom Azure Managed Storage application as an OAuth provider. Enter Azure Resource Management default_profile</td>
</tr>
<tr>
<td>Credential alias</td>
<td>The credential alias you created when you registered the custom Azure Managed Storage application. Click the lock icon and enter, sn_azure_ms_spoke.Azure_Managed_Storage, sn_azure_rm_spoke.Azure_Resource_Management, sn_azure_vm_spoke.Azure_Virtual_Machine, sn_azure_vn_spoke.Azure_Virtual_Network</td>
</tr>
</tbody>
</table>

5. Click Submit.

Regenerate OAuth token for Microsoft Azure Managed Storage spoke

Regenerate an OAuth token when it expires.
Before you begin
Role required: admin

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Select the Azure Managed Storage OAuth Credential record. For example, select Azure Managed Storage credentials.
3. From Related Links section, click Get OAuth Token.

Microsoft Azure Notification Hub spoke v1.01
Integrate ServiceNow instance with Microsoft Azure Notification Hub. Manage Azure notification hubs from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Azure Notification Hub version 2016-03-01, but may be compatible with later versions.

Spoke requirements
• Storage account in your Microsoft Azure portal for integration with your ServiceNow instance.
• Register the application in Microsoft Azure portal and record the access keys and directory IDs.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• Flow Designer Action Step - Payload Builder
  (com.glide.hub.action_step.payload)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• Complex Object (com.glide.cobject)

**Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke actions**

The Microsoft Azure Notification Hub Spoke provides actions to automate Azure Notification Hub tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation</td>
<td>Delete Installation</td>
<td>Deletes an installation</td>
</tr>
<tr>
<td>Management</td>
<td>Get Installation</td>
<td>Retrieves an installation for the specified installation ID</td>
</tr>
<tr>
<td></td>
<td>Update Installation</td>
<td>Updates the installation partially using the JSON patch.</td>
</tr>
<tr>
<td></td>
<td>Upsert Installation</td>
<td>Creates a new installation or updates an existing installation.</td>
</tr>
<tr>
<td>Namespace</td>
<td>Delete Namespace</td>
<td>Deletes an existing namespace and all the associated notification hubs under the namespace.</td>
</tr>
<tr>
<td>Management</td>
<td>Get Namespace</td>
<td>Retrieves the description of the specified namespace.</td>
</tr>
<tr>
<td></td>
<td>Look up Namespaces By Resource Group</td>
<td>Retrieves a list of available namespaces within a resource group.</td>
</tr>
<tr>
<td></td>
<td>Look up Namespaces By Subscription ID</td>
<td>Retrieves a list of available namespaces within the specified subscription.</td>
</tr>
<tr>
<td></td>
<td>Update Namespace</td>
<td>Updates an existing namespace.</td>
</tr>
<tr>
<td></td>
<td>Upsert Namespace</td>
<td>Creates a new namespace or updates an existing namespace.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Notification Hub Management</td>
<td>Delete Notification Hub</td>
<td>Deletes a notification hub associated with a namespace.</td>
</tr>
<tr>
<td></td>
<td>Get Notification Hub</td>
<td>Retrieves a notification hub associated with a namespace.</td>
</tr>
<tr>
<td></td>
<td>Look up Notification Hubs</td>
<td>Retrieves a list of notification hubs associated with a namespace.</td>
</tr>
<tr>
<td></td>
<td>Send APNS Native Notification</td>
<td>Sends an Apple Push Notification Service (APNS) native notification through a notification hub.</td>
</tr>
<tr>
<td></td>
<td>Send GCM Native Notification</td>
<td>Sends a Google Cloud Messaging(GCM) native notification through a notification hub.</td>
</tr>
<tr>
<td></td>
<td>Send Notification to Device Handle</td>
<td>Sends a notification directly to a device handle in the form a token.</td>
</tr>
<tr>
<td></td>
<td>Upsert Notification Hub</td>
<td>Creates a new notification hub or updates an existing notification hub in a namespace.</td>
</tr>
<tr>
<td>Registration Management</td>
<td>Create APNS Registration</td>
<td>Creates a registration for an Apple Push Notification Service (APNS) device.</td>
</tr>
<tr>
<td></td>
<td>Create GCM Registration</td>
<td>Creates a registration for a Google Cloud Messaging (GCM) device.</td>
</tr>
<tr>
<td></td>
<td>Create Registration ID</td>
<td>Retrieves a registration ID without creating a registration.</td>
</tr>
<tr>
<td></td>
<td>Delete Registration</td>
<td>Deletes a registration.</td>
</tr>
<tr>
<td></td>
<td>Get Registration</td>
<td>Retrieves the description and other information for the specified registration ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Registrations</td>
<td>Retrieves a list of registrations.</td>
</tr>
<tr>
<td></td>
<td>Update APNS Registration</td>
<td>Updates an existing Apple Push Notification Service (APNS) registration.</td>
</tr>
<tr>
<td></td>
<td>Update GCM Registration</td>
<td>Updates an existing Google Cloud Messaging (GCM) registration.</td>
</tr>
</tbody>
</table>
Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the Microsoft Azure Notification Hub spoke

Integrate the ServiceNow instance and Microsoft Azure Notification Hub by creating a custom OAuth application in Microsoft Azure Notification Hub to authenticate ServiceNow requests.

Before you begin

- Request an IntegrationHub subscription.
- Activate Microsoft Azure Notification Hub Spoke.
- Role required: admin

Register Microsoft Azure Notification Hub as an OAuth provider

Use the information generated during the Microsoft Azure Notification Hub account configuration to register Microsoft Azure Notification Hub as an OAuth provider and allow the ServiceNow instance to request OAuth 2.0 tokens.

Procedure

1. Navigate to System OAuth > Application Registry.
2. Click New.
   - The system displays this message: What kind of OAuth application?.
3. Select Connect to a third party OAuth Provider.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter: Microsoft Azure Notification Hub OAuth</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID created during the Microsoft Azure Notification Hub application registration.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret created during the Microsoft Azure Notification Hub application registration.</td>
</tr>
<tr>
<td>Token URL</td>
<td>OAuth server token endpoint. Enter: //login.microsoftonline.com/&lt;directory-id&gt;/oauth2/v2.0/token Replace &lt;directory-id&gt; with the directory ID of your Azure Notification Hub account.</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>OAuth server token revocation endpoint.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint in this format: https://&lt;instance&gt;.service-now.com/oauth_redirect.do</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Application scope that this registry is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use mutual authentication for token request and revocation. This option requires a mutual authentication profile to be specified.</td>
</tr>
</tbody>
</table>

5. Right-click the form header, and click **Save**.

Create a credential record for the Microsoft Azure Notification Hub spoke

Create a credential record for the Microsoft Azure Notification Hub account. The Microsoft Azure Notification Hub Spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to **IntegrationHub > Connections & Credentials > Credentials & Credential Aliases**.

2. Open the **Azure_Resource_Management** record.

3. From the **Credentials** tab, click **New**.
The system displays this message: What type of Credentials would you like to create?

4. Select **OAuth 2.0 Credentials**.
5. On the form, fill these values.

### OAuth 2.0 Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter Azure Notification Hub OAuth.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
</tbody>
</table>

6. Right-click the form header and click **Submit**.
7. Navigate to **IntegrationHub > Connections & Credentials > Credentials & Credential Aliases**
8. Open the **Azure_Resource_Management** record.
9. From the **Credentials** tab, click **New**.
   The system displays this message: What type of Credentials would you like to create?
10. Select **Azure Shared Access Signature**.
11. On the form, fill these values.

### Azure Shared Access Signature form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Microsoft Azure Notification Hub Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Shared Access Key Name</td>
<td>Name to identify the Shared Access Key record.</td>
</tr>
<tr>
<td>Shared Access Key</td>
<td>Shared Access Key of your Azure Notification Hub account.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias associated with the spoke.</td>
</tr>
<tr>
<td>Authentication For</td>
<td>Azure product for which this credential record is used.</td>
</tr>
<tr>
<td>Authentication For</td>
<td>Select Notification Hub</td>
</tr>
<tr>
<td>Authentication For</td>
<td>Custom authentication algorithm for outbound signing requests. Select AzureSASAlgo.</td>
</tr>
</tbody>
</table>

**Note:** Do not modify the authentication algorithm directly.

12. Click **Submit**.

**Microsoft Azure Resource Management spoke v1.0.5**

Azure Resource Management enables you to create, update, and delete resources in your Azure subscription from within ServiceNow.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub. This spoke is installed automatically when you install the MicrosoftAzure SQL spoke v1.0.1.

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Spoke actions
The Azure Resource Management spoke provides actions to automate resource management tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Management</td>
<td>Get Databases</td>
<td>Retrieves a list of databases in a server.</td>
</tr>
<tr>
<td></td>
<td>Get Elasticpools</td>
<td>Retrieves a list of elastic pools in Azure.</td>
</tr>
<tr>
<td></td>
<td>Get Resources</td>
<td>Retrieves a list of resource groups.</td>
</tr>
<tr>
<td></td>
<td>Get SQL Servers</td>
<td>Retrieves a list of servers in a resource group.</td>
</tr>
<tr>
<td></td>
<td>Get Location</td>
<td>Retrieves a list of locations.</td>
</tr>
<tr>
<td></td>
<td>Get Operational</td>
<td>Generates the operational status of the resource (Virtual Machine, Network,</td>
</tr>
<tr>
<td>Status of Resource</td>
<td>Status of Resource</td>
<td>Disk, and so on) that is created or updated.</td>
</tr>
</tbody>
</table>

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.
Set up the Microsoft Azure Resource Management spoke

Integrate the ServiceNow instance and your Azure Resource Management account by creating a custom OAuth application in Azure to authenticate ServiceNow requests.

Before you begin

- Request IntegrationHub subscription.
- Activate the Microsoft Azure Resource Management spoke.
- Role required: admin

Register Azure Resource Management as an OAuth provider

Use the information generated during application configuration in Azure portal to register Azure Resource Management as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Procedure

1. Navigate to System OAuth > Application Registry.
2. Open the record, Azure Resource Management.
   The system displays the Application Registries form.
3. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Enter the Client ID you created during the Azure Resource Management application registration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Key value you created during the Azure Resource Management application registration.</td>
</tr>
</tbody>
</table>
**Field** | **Value required**
--- | ---
On the Azure page for the app registration, click Endpoints. The Authorization URL is labeled **OAuth 2.0 token endpoint (v2)**. You can copy the URL there.

**Redirect URL** | The format of the Redirect URI is https://<instance>.service-now.com/oauth_redirect.do. Replace <instance> with the name of your ServiceNow instance.

4. Right-click the form header, and click **Save**.

**Create Credential record for the Azure Resource Management spoke**

Create Credential record to the Azure Resource Management custom app registration you created. The Azure Resource Management spoke connection and credential aliases use these credentials to authorize actions.

**Procedure**

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.

2. Open for the record, **Azure_Resource_Management**.

3. From the **Credentials** tab, click **New**.
   - The system displays the message **What type of Credentials would you like to create?**.

4. Select **OAuth 2.0 Credentials**.

5. On the form, fill these values.

**Field** | **Value required**
--- | ---
**Name** | Name to uniquely identify the connection record. For example, enter **Azure_RM_Cred**.

**Active** | Option to actively use the credential record.

**OAuth Entity Profile** | Default OAuth Entity Profile. For example, **Azure Resource Management default_profile**.

**Credential alias** | Credential record associated with **Azure_Resource_Management**.

6. Click **Submit**.
Microsoft Azure SQL spoke v1.0.1

Configure and manage Microsoft Azure SQL databases from within ServiceNow. When you install the Azure SQL spoke, you also get the Microsoft Azure Resource Management spoke. Azure Resource Manager provides a management layer that enables you to create, update, and delete resources in your Azure subscription.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported version

This spoke is built for Azure SQL v12, but may be compatible with later versions.

Spoke requirements

• User with full access to Microsoft Azure Cloud Computing.

Spoke actions

The Azure SQL spoke provides actions to automate Microsoft Azure SQL tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Database</td>
<td>Create Database - Generic</td>
<td>Creates a generic database in Azure.</td>
</tr>
<tr>
<td></td>
<td>Create Database - Hyperscale</td>
<td>Creates a Hyperscale database in Azure.</td>
</tr>
<tr>
<td></td>
<td>Create Database - vCore</td>
<td>Creates a vCore database in Azure.</td>
</tr>
<tr>
<td>Database Management</td>
<td>Delete Database - vCore</td>
<td>Deletes the specified database from a server.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Get Database</td>
<td>Retrives details of a database.</td>
<td></td>
</tr>
<tr>
<td>List By Elastic Pool</td>
<td>Retrieves a list of databases in an elastic pool.</td>
<td></td>
</tr>
<tr>
<td>List By Server</td>
<td>Retrieves a list of databases on a server.</td>
<td></td>
</tr>
<tr>
<td>Operational Status</td>
<td>Generates the operational status of a database that is created or updated.</td>
<td></td>
</tr>
<tr>
<td>Rename Database</td>
<td>Renames a database.</td>
<td></td>
</tr>
<tr>
<td>Update Database</td>
<td>Updates SKU or Properties for existing database.</td>
<td></td>
</tr>
</tbody>
</table>

**Set up Microsoft Azure SQL spoke**

Integrate the ServiceNow instance and your Microsoft Azure SQL databases by creating a custom OAuth application in Azure to authenticate ServiceNow requests.

**Before you begin**

- Role required: admin
- Request IntegrationHub subscription.
- Activate Azure SQL spoke.

**Configure an app registration for Azure SQL**

Create a custom app from your Azure account to enable OAuth 2.0 authentication with the Azure SQL spoke.

**Before you begin**

Azure SQL requirements:

- Azure SQL account
- Azure SQL administrator credentials

**About this task**

Complete these steps from your Azure account. See the Azure SQL Database documentation for instructions on creating and configuring custom applications.
Procedure

1. From your Azure account, navigate to Home > App registrations > Register an application.
2. Create an app registration in your Azure Active Directory.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter Web app/API.</td>
</tr>
<tr>
<td>Supported account types</td>
<td>Specify who can use the application.</td>
</tr>
<tr>
<td>Redirect URI</td>
<td>The format of the Redirect URI is https://&lt;instance&gt;.service-now.com/oauth_redirect.do. Replace &lt;instance&gt; with the name of your ServiceNow instance.</td>
</tr>
</tbody>
</table>

3. Click Register.
4. Copy the Application (client) ID. You use this ID when you Register Azure SQL as an OAuth provider.
5. Select Manage > Certificates & secrets and click New client secret.
6. Give the client secret a description, select when it expires, and click Add. Copy the client secret value for use when you Register Azure SQL as an OAuth provider. It will not be available after you leave the Certificates & secrets page.

What to do next
Register Azure SQL as an OAuth provider.

Register Azure SQL as an OAuth provider

Use the information generated during Azure account configuration to register Azure SQL as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Procedure

1. Navigate to System OAuth > Application Registry.
2. Click New. The system displays the message What kind of OAuth application?
3. Select Connect to a third-party OAuth Provider. The system displays a blank Application Registries form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Azure SQL OAuth.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Enter the Client ID you created during the Azure SQL application registration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Key value you created during the Azure SQL application registration.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td></td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select Authorization Code.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>The format of the Redirect URI is https://&lt;instance&gt;.service-now.com/oauth_redirect.do. Replace &lt;instance&gt; with the name of your ServiceNow instance.</td>
</tr>
</tbody>
</table>

5. Right-click the form header, and click Save.
   The system validates the OAuth credentials and populates the Redirect URL and the OAuth Entity Profiles related list.

6. In the OAuth Entity Profiles related list, open the default profile record.

7. Verify that the openid entity scope record created in previous steps appears in the OAuth Entity Profile Scopes related list. If it does not appear, add the record.
Create Credential records for the Azure SQL spoke

Create Credential records to the Azure SQL custom app registration you created. The Microsoft Azure SQL spoke connection and credential aliases use these credentials to authorize actions.

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?
3. Select OAuth 2.0 Credentials.
   The pop-up window displays a blank OAuth 2.0 Credentials form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Azure SQL Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Select the OAuth profile you created when you registered the custom Azure SQL application as an OAuth provider. For example, select Azure OAuth default_profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Click the lock icon, enter sn Azure_sql_spoke.Azure_database, and click the lock icon again.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Create Connection records for the Microsoft Azure SQL spoke

Create Connection records to your Azure account. The Azure SQL spoke connection and credential aliases use these connections to perform actions in Azure SQL.
Before you begin

Procedure
1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open the **Azure_database** record.
3. Select the **Type** Connection and Credential
4. In the **Connections** related list, click **New**.
5. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter Azure SQL Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for Azure SQL. For example, select Azure SQL Credentials.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

**Regenerate Azure SQL OAuth token**
Regenerate the Azure SQL OAuth token when it expires.

Before you begin

Procedure
1. Navigate to **Connections & Credentials > Credentials**.
2. Select the Azure SQL spoke OAuth Credential record.

**Example**
For example, select Azure SQL Credentials.

3. From Related Links, click **Get OAuth Token**.

**Microsoft Azure Virtual Machine spoke v1.0.3**
Manage Microsoft Azure Virtual Machine (VM) from your ServiceNow instance.
Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Complex Object (com.glide.cobject)

Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported Versions
This spoke was built for API version 2019-07-01, but may be compatible with later versions.

Spoke requirements
- Microsoft Azure Resource Management spoke (com.sn.ms.azure.resource.mgmt.spoke)
- Microsoft Azure Virtual Network spoke (com.sn.ms.azure.virtual.network.spoke)
- Microsoft Azure Managed Storage spoke (com.sn.ms.azure.managed.storage.spoke)

Spoke flows and subflows
This spoke has no flows and subflows.
**Spoke actions**

The Microsoft Azure Virtual Machine spoke provides actions to automate Microsoft Azure Virtual Machine tasks when events occur in ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Management</td>
<td>Create Image From Instance</td>
<td>Creates an image from an existing instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Image</td>
<td>Deletes an image.</td>
</tr>
<tr>
<td></td>
<td>Get Image Information</td>
<td>Retrieves information of an image from a specified resource group.</td>
</tr>
<tr>
<td></td>
<td>Look Up Images By Resource Group</td>
<td>Retrieves the list of images from a specified resource group.</td>
</tr>
<tr>
<td></td>
<td>Look Up Images By Subscription ID</td>
<td>Retrieves the list of images with the specified subscription ID.</td>
</tr>
<tr>
<td></td>
<td>Set Tags On Image</td>
<td>Assigns tags to an image.</td>
</tr>
<tr>
<td></td>
<td>Look Up Offers</td>
<td>Retrieves a list of virtual machine images offers for the specified Azure location and publisher name.</td>
</tr>
<tr>
<td></td>
<td>Look Up Publishers</td>
<td>Retrieves a list of virtual machine image publishers for the specified Azure location.</td>
</tr>
<tr>
<td></td>
<td>Look Up SKUs</td>
<td>Retrieves a list of virtual machine image SKUs for the specified Azure location.</td>
</tr>
</tbody>
</table>
### Spoke actions (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>location, publisher, and offer.</td>
<td>Look Up Versions</td>
<td>Retrieves a list of virtual machine image versions for the specified Azure location, publisher, offer, and SKU.</td>
</tr>
<tr>
<td>Instance Management</td>
<td>Attach Disk</td>
<td>Attaches the data disk to an instance.</td>
</tr>
<tr>
<td></td>
<td>Create Virtual Machine</td>
<td>Creates a virtual machine.</td>
</tr>
<tr>
<td></td>
<td>Create Virtual Machine From Image</td>
<td>Creates a virtual machine from an image.</td>
</tr>
<tr>
<td></td>
<td>Deallocate Instance</td>
<td>Shuts down the virtual machine and releases the related resources.</td>
</tr>
<tr>
<td></td>
<td>Delete Instance</td>
<td>Deletes a virtual machine.</td>
</tr>
<tr>
<td></td>
<td>Detach Disk</td>
<td>Detaches the data disk from an instance.</td>
</tr>
<tr>
<td></td>
<td>Generalize Instance</td>
<td>Assigns the generalised OS state to the virtual machine for an instance.</td>
</tr>
<tr>
<td></td>
<td>Get VM Instance Details</td>
<td>Retrieves the instance view or model view of a virtual machine.</td>
</tr>
<tr>
<td></td>
<td>Get VM Runtime Details</td>
<td>Retrieves the VM runtime state of an instance.</td>
</tr>
<tr>
<td></td>
<td>Look Up Disks By Instance</td>
<td>Retrieves a list of disks in the specified virtual machine.</td>
</tr>
<tr>
<td></td>
<td>Look Up Instances By Resource Group</td>
<td>Retrieves a list of virtual machines in the specified resource group.</td>
</tr>
</tbody>
</table>
### Spoke actions (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>the specified resource group.</td>
</tr>
<tr>
<td></td>
<td>Look Up Instances By Subscription ID</td>
<td>Retrieves a list of virtual machines in the specified subscription ID.</td>
</tr>
<tr>
<td></td>
<td>Power Off Instance</td>
<td>Shuts down the specified virtual machine.</td>
</tr>
<tr>
<td></td>
<td>Redeploy Instance</td>
<td>Shuts down the virtual machine, moves it to a new node, and powers it back on.</td>
</tr>
<tr>
<td></td>
<td>Resize Instance</td>
<td>Resizes the specified virtual machine. This process requires some time to complete.</td>
</tr>
<tr>
<td></td>
<td>Restart Instance</td>
<td>Restarts a virtual machine.</td>
</tr>
<tr>
<td></td>
<td>Start Instance</td>
<td>Starts a virtual machine.</td>
</tr>
<tr>
<td>VM Size Management</td>
<td>Look Up Sizes By Availability Set</td>
<td>Retrieves a list of virtual machine sizes for the specified availability set.</td>
</tr>
<tr>
<td></td>
<td>Look Up Sizes By Instance</td>
<td>Retrieves the list of virtual machine sizes for the specified virtual machine.</td>
</tr>
<tr>
<td></td>
<td>Look Up Sizes By Location</td>
<td>Retrieves a list of virtual machine sizes for the specified Azure location.</td>
</tr>
</tbody>
</table>

### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any
actions that use the connection. For more information, see Connections and Credentials.

**Set up Microsoft Azure Virtual Machine spoke**

Integrate the ServiceNow instance and Azure Virtual Machine using OAuth credentials to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub Enterprise subscription
- Activate the Microsoft Azure Virtual Machine spoke
- Role required: admin

**Configure app registration for Microsoft Azure Virtual Machine spoke**

Configure app registration from your Azure account to add redirect URIs, credentials, and permissions to access web APIs for your application. For more information, see Quickstart: Configure a client application to access web APIs.

**Before you begin**

- Azure account with admin privileges

**Procedure**

1. Sign into Azure portal.
2. Register your app with the following platform settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter Web app/API.</td>
</tr>
<tr>
<td>Supported account types</td>
<td>Specify the account types who can use the application.</td>
</tr>
<tr>
<td>Redirect URI</td>
<td>Specify the URI in this format: https://&lt;instance&gt;.service-now.com/oauth_redirect.do Replace &lt;instance&gt; with the name of your ServiceNow instance.</td>
</tr>
</tbody>
</table>

3. Record the client ID and client secret of the app which are used for authentication.
Register Azure Virtual Machine as OAuth provider

Use the authentication information from Azure account configuration to register Azure Virtual Machine as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Procedure

1. Navigate to **System OAuth > Application Registry**.
2. Open the Azure Resource Management application registry record.
3. On the form, fill the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Client ID created during Azure virtual account registration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Key value crated during Azure virtual account registration.</td>
</tr>
<tr>
<td>Token URL</td>
<td>The URL used for OAuth tokens. The format of the URL is <code>https://login.microsoftonline.com/&lt;Directory ID&gt;/oauth2/v2.0/token</code>. Replace <code>&lt;Directory ID&gt;</code> with the directory ID in your Azure configuration properties.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>The URL of the instance used for redirection. The format of the URL is <code>https://&lt;instance&gt;.service-now.com/oauth_redirect.do</code>. Replace <code>&lt;instance&gt;</code> with the name of your ServiceNow instance.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**.
Create Credential records for the Microsoft Azure Virtual Machine spoke

Create Credential records to the Azure Virtual Machine app registration you created. The Microsoft Azure Virtual Machine spoke connection and credential aliases uses these credentials to authorise actions.

Before you begin
Role required: admin

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?
3. Select OAuth 2.0 Credentials.
4. On the form, fill these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the credentials record. For example, enter Azure Virtual Machine.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>The OAuth profile you created when you registered the custom Azure Virtual Machine application as an OAuth provider. Enter Azure Resource Management default_profile.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>The credential alias you created when you registered the custom Azure Virtual Machine application. Click the lock icon and enter, sn_azure_ms_spoke.Azure_Managed_Storage, sn_azure_rm_spoke.Azure_Resource_Mangement, sn_azure_vm_spoke.Azure_Virtual_Machine, sn_azure_vn_spoke.Azure_Virtual_Network</td>
</tr>
</tbody>
</table>

5. Click Submit.

Regenerate OAuth token for Microsoft Azure Virtual Machine spoke

Regenerate an OAuth token when it expires.
Before you begin
Role required: admin

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Select the Azure Virtual Machine OAuth Credential record.
   For example, select Azure Virtual Machine credentials.
3. From Related Links section, click Get OAuth Token.

Microsoft Azure Virtual Network spoke v1.0.4
Manage Microsoft Azure Virtual Network (VNet) from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Complex Object (com.glide.cobject)

Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported Versions
This spoke was built for API version 2019-07-01 for List Network Interface Names by ResourceGroup and Look Up Network Interfaces By Resource Group, 2019-11-01 for other actions but may be compatible with later versions.
Spoke requirements
- Microsoft Azure Resource Management spoke
  (com.sn.ms.azure.resource.mgmt.spoke)
- Microsoft Azure subscription with access to Azure Virtual Network service

Spoke flows and subflows
This spoke has no flows and subflows.

Spoke actions
The Microsoft Azure Virtual Network spoke provides actions to automate Microsoft Azure Virtual Network tasks when events occur in ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Interface Management</td>
<td>Create Network Interface</td>
<td>Creates a network interface.</td>
</tr>
<tr>
<td></td>
<td>Delete Network Interface</td>
<td>Deletes the specified network interface.</td>
</tr>
<tr>
<td></td>
<td>Get Network Interface Information</td>
<td>Retrieves the specified network interface information in a specified resource group.</td>
</tr>
<tr>
<td></td>
<td>Look Up Network Interfaces By Resource Group</td>
<td>Retrieves a list of network interfaces in the specified resource group.</td>
</tr>
<tr>
<td></td>
<td>Look Up Network Interfaces By Subscription ID</td>
<td>Retrieves a list of network interfaces in the specified subscription ID.</td>
</tr>
<tr>
<td></td>
<td>Set Network Interface Tags</td>
<td>Assigns tags to the specified network interface.</td>
</tr>
<tr>
<td>Public IP Address Management</td>
<td>Create Public IP Address</td>
<td>Creates a public IP address.</td>
</tr>
</tbody>
</table>
### Spoke actions (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Delete Public IP Address</td>
<td>Deletes a specified public IP address.</td>
</tr>
<tr>
<td></td>
<td>Get Public IP Address Information</td>
<td>Retrieves the specified public IP address information in a specified resource group.</td>
</tr>
<tr>
<td></td>
<td>Look Up Public IPs By Resource Group</td>
<td>Retrieves a list of public IP addresses in the specified resource group.</td>
</tr>
<tr>
<td></td>
<td>Look Up Public IPs By Subscription ID</td>
<td>Retrieves a list of public IP addresses in the specified subscription ID.</td>
</tr>
<tr>
<td></td>
<td>Set Public IP Tags</td>
<td>Assigns tags on public IP addresses.</td>
</tr>
<tr>
<td><strong>Subnet Management</strong></td>
<td>Create Subnet</td>
<td>Creates a subnet in the specified virtual network.</td>
</tr>
<tr>
<td></td>
<td>Delete Subnet</td>
<td>Deletes a specified subnet.</td>
</tr>
<tr>
<td></td>
<td>Get Subnet Information</td>
<td>Retrieves the specified subnet information in a specified virtual network and resource group.</td>
</tr>
<tr>
<td></td>
<td>Look Up Subnets</td>
<td>Retrieves a list of subnets in the specified virtual network.</td>
</tr>
<tr>
<td><strong>Virtual Network Management</strong></td>
<td>Create Virtual Network</td>
<td>Creates a virtual network in the specified resource group.</td>
</tr>
<tr>
<td></td>
<td>Create Virtual Network With Subnet</td>
<td>Creates a virtual network in the specified resource group with subnet.</td>
</tr>
<tr>
<td></td>
<td>Delete Virtual Network</td>
<td>Deletes a specified virtual network.</td>
</tr>
</tbody>
</table>
Spoke actions (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Get Virtual Network Information</td>
<td>Retrieves the specified subnet information in a specified resource group.</td>
</tr>
<tr>
<td></td>
<td>Get Virtual Network Usage Status</td>
<td>Retrieves virtual network usage status in a specified resource group.</td>
</tr>
<tr>
<td></td>
<td>Look Up Virtual Networks By Resource Group</td>
<td>Retrieves a list of virtual networks in the specified resource group.</td>
</tr>
<tr>
<td></td>
<td>Look Up Virtual Networks By Subscription ID</td>
<td>Retrieves a list of virtual network in the specified resource group.</td>
</tr>
<tr>
<td></td>
<td>Set Virtual Network Tags</td>
<td>Assigns tags on virtual network.</td>
</tr>
</tbody>
</table>

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up Microsoft Azure Virtual Network spoke
Integrate the ServiceNow instance and Azure Virtual Network using OAuth credentials to authenticate ServiceNow requests.

Before you begin
- Request an IntegrationHub Enterprise subscription
- Activate the Microsoft Azure Virtual Network
- Role required: admin
Configure app registration for Microsoft Azure Virtual Network spoke

Configure app registration from your Azure account to add redirect URIs, credentials, and permissions to access web APIs for your application. For more information, see Quickstart: Configure a client application to access web APIs.

Before you begin
Azure account with admin privileges

Procedure
1. Sign into Azure portal.
2. Register your app with the following platform settings.

Registration Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter Web app/API.</td>
</tr>
<tr>
<td>Supported account types</td>
<td>Specify the account types who can use the application.</td>
</tr>
<tr>
<td>Redirect URI</td>
<td>Specify the URI in this format: https://&lt;instance&gt;.service-now.com/</td>
</tr>
<tr>
<td></td>
<td>oauth_redirect.doReplace &lt;instance&gt; with the name of your ServiceNow instance.</td>
</tr>
</tbody>
</table>

3. Record the client ID and client secret of the app which are used for authentication.

Register Azure Virtual Network as OAuth provider

Use the authentication information from Azure account configuration to register Azure Virtual Network as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Procedure
1. Navigate to System OAuth > Application Registry.
2. Open the Azure Resource Management application registry record.
3. On the form, fill the fields:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Client ID created during Azure virtual account registration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Key value created during Azure virtual account registration.</td>
</tr>
<tr>
<td>Token URL</td>
<td>The URL used for OAuth tokens. The format of the URL is <a href="https://login.microsoftonline.com/">https://login.microsoftonline.com/</a>&lt;Directory ID&gt;/oauth2/v2.0/token. Replace &lt;Directory ID&gt; with the directory ID in your Azure configuration properties.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>The URL of the instance used for redirection. The format of the URL is https://&lt;instance&gt;.service-now.com/oauth_redirect.do. Replace &lt;instance&gt; with the name of your ServiceNow instance.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**.

**Create Credential records for the Microsoft Azure Virtual Network spoke**

Create Credential records to the Azure Managed Storage app registration you created. The Microsoft Azure Virtual Network spoke connection and credential aliases uses these credentials to authorise actions.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
The system displays the message **What type of Credentials would you like to create?**

3. Select **OAuth 2.0 Credentials**.

4. On the form, fill these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the credentials record. For example, enter Azure Virtual Network.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>The OAuth profile you created when you registered the custom Azure Virtual Network application as an OAuth provider. Enter Azure Resource Management default_profile</td>
</tr>
<tr>
<td>Credential alias</td>
<td>The credential alias you created when you registered the custom Azure Virtual Network application. Click the lock icon and enter, sn_azure_ms_spoke.Azure_Managed_Storage, sn_azure_rm_spoke.Azure_Resource_Management, sn_azure_vm_spoke.Azure_Virtual_Machine, sn_azure_vn_spoke.Azure_Virtual_Network</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Regenerate OAuth token for Microsoft Azure Virtual Network spoke**

Regenerate an OAuth token when it expires.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **Connections & Credentials > Credentials**.

2. Select the Azure Virtual Network OAuth Credential record.
   For example, select Azure Virtual Network credentials.

3. From Related Links section, click **Get OAuth Token**.

4. Right-click the form header, and click **Save**.
Microsoft Dynamics CRM spoke v1.3
Provide the baseline actions to interact with Microsoft Dynamic Entities through introspection.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- Complex Object (com.glide.cobject)
- ServiceNow Flow Designer - Dynamic Outputs (com.glide.hub.dynamic_outputs)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke flows
The Infoblox spoke provides sample flows to create an opportunity in Dynamics CRM.

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Opportunity in Dynamics CRM</td>
<td>Creates an opportunity in Dynamics CRM and updates the opportunity record in your ServiceNow instance.</td>
</tr>
</tbody>
</table>

Spoke subflows
This spoke ships with the following subflows.
### Subflow

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Dynamics CRM Webhook</td>
<td>Receives the Dynamic CRM webhook notification and converts it into an array of objects and logs the details.</td>
</tr>
<tr>
<td>Process Dynamics CRM Webhook for Opportunity</td>
<td>Receives the Dynamic CRM webhook notification and updates the opportunity table record.</td>
</tr>
</tbody>
</table>

### Spoke actions

The Microsoft Dynamics CRM spoke provides the baseline actions to interact with Microsoft Dynamic Entities through introspection.

### Available Microsoft Dynamics CRM spoke actions

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Management</td>
<td>Create Account</td>
<td>Create an account in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Look up Account Details by Account ID</td>
<td>Retrieve the details of the required account in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td>Case Management</td>
<td>Create Case</td>
<td>Create case in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Look up Case Details by Case ID</td>
<td>Retrieve details of the specified case in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td>Contact Management</td>
<td>Create Contact</td>
<td>Create contact in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Look up Contact Details by Contact ID</td>
<td>Retrieve details of the required contact in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td>Lead Management</td>
<td>Create Lead</td>
<td>Create lead in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Look up Lead Details by Lead ID</td>
<td>Retrieve details of the required lead in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Look up Entities</td>
<td>Retrieve all the entities and their logical names in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up Entity Metadata</td>
<td>Retrieve all the metadata available for the required entity type in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Look up Entity URL</td>
<td>Retrieve all the entities and its entity set name (public URL name) available in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Look up Field Choice List</td>
<td>Retrieve all the choice lists for the fields that are in the name and label pair format.</td>
</tr>
<tr>
<td>Opportunity Management</td>
<td>Create Opportunity</td>
<td>Create an opportunity in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Look up Opportunity Details by Opportunity ID</td>
<td>Retrieve the details of the required opportunity in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td>Record Management</td>
<td>Create Record</td>
<td>Create a record in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Delete Record</td>
<td>Deletes a record in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Look up Primary Attributes and Logical Name</td>
<td>Retrieve primary attributes and logical name for the specified entity.</td>
</tr>
<tr>
<td></td>
<td>Look up Record by Record ID</td>
<td>Retrieve information of the specified record in an Entity.</td>
</tr>
<tr>
<td></td>
<td>Look up Record by Search Query</td>
<td>Retrieve record based on the search query and entity selected from the choice list.</td>
</tr>
<tr>
<td></td>
<td>Look Up Records (Before Paris Version)</td>
<td>Retrieve records based on the search query and specific entity.</td>
</tr>
<tr>
<td></td>
<td>Look up Records Stream</td>
<td>Retrieve records based on the search query and specific entity.</td>
</tr>
<tr>
<td></td>
<td>Subflow Helper Action</td>
<td>Parses the JSON input and converts it into an array object. This can action can be used for creating subflows.</td>
</tr>
</tbody>
</table>
Available Microsoft Dynamics CRM spoke actions (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Update Record</td>
<td>Update a record in Microsoft Dynamics CRM.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

This spoke uses the Microsoft_Dynamics_CRM alias record to authorize actions.

<table>
<thead>
<tr>
<th>Connection alias</th>
<th>Description</th>
<th>Connection URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft_Dynamics_CRM</td>
<td>Connection to Microsoft Dynamics CRM</td>
<td>URL configured when you create your application in Azure. This URL ends with dynamics.com.</td>
</tr>
</tbody>
</table>

**Set up Microsoft Dynamics CRM spoke**

Integrate the ServiceNow instance and Microsoft Dynamics CRM by using the Windows credentials to authenticate ServiceNow requests.

**Before you begin**

- Install Microsoft AD
- Request IntegrationHub subscription.
- Activate the Microsoft Dynamics CRM spoke.
- Role required: admin.

**About this task**

- Perform these steps to use all Microsoft Dynamics CRM spoke actions.

**Configure Microsoft Dynamics CRM application**

Create a custom OAuth application from your Microsoft Dynamics CRM account to enable OAuth 2.0 authentication with the Microsoft Dynamics CRM.
Before you begin
Microsoft Dynamics CRM requirements:

- Microsoft Dynamics CRM account
- Microsoft Azure account
- Microsoft Dynamics CRM credentials

About this task
Complete these steps from your Azure Developer account. See the Azure product documentation for instructions on creating and configuring custom applications.

Procedure

1. Log in to the Microsoft Azure App registration portal with your organization credentials.

2. Register a new custom application. Fill in the application name, the supported account type, and the redirect URI, and then click Register. An overview of the application's basic information is shown.

3. Copy the application ID to a text file. You will use this ID and the client secret generated in the next step to register the app as a third-party OAuth provider on your ServiceNow instance. You use the application ID as the client ID when you connect the application to ServiceNow.

4. Add a client secret.

   a. In Microsoft Azure, navigate to Manage > Certificates & secrets.

   b. Provide a description and an expiration date and click Add.

   i Note: The client secret is only displayed in plain text for a short time. You use the client secret when you connect the application to ServiceNow.

5. Enable the permissions you want the application to support. For more information, see the Microsoft Graph permissions reference.

   a. In Microsoft Azure, navigate to Manage > API permissions.

   b. Click the Microsoft Graph tile.

   c. Select the Delegated or Application permissions that the application supports.
Delegated permissions enable the application to access the API as a signed-in user. Application permissions enable the application to run as a background service or daemon without a signed-in user.

d. Click **Add permissions**.

What to do next
Register Microsoft Dynamics CRM as OAuth provider.

Register Microsoft Dynamics CRM as OAuth provider
Use the information generated during Microsoft Dynamics CRM account configuration to register Microsoft Dynamics CRM as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Before you begin
- Request IntegrationHub subscription.
- Activate Microsoft Dynamics CRM.
- Create a Microsoft Dynamics CRM application.

Role required: admin.

Procedure
1. In ServiceNow, navigate to **System OAuth > Application Registry**.
2. Click **New**.
3. On the screen titled **What kind of OAuth application**, select **Connect to a third-party OAuth Provider**.
4. Enter these values in the Application Registries form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record, for example Dynamics CRM OAuth profile.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Enter the Application ID of the Microsoft Dynamics CRM application you created in Azure.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Client Secret you generated when you created the application in Azure.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select Authorization Code.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>Click the lock icon (🔒), enter <a href="https://login.microsoftonline.com/common/oauth2/v2.0/authorize">https://login.microsoftonline.com/common/oauth2/v2.0/authorize</a> followed by a question mark and the resource attribute of your instance, and then click the lock icon again. The resource attribute of the URL. For example, ?resource=<a href="https://mycompany.crm.dynamics.com">https://mycompany.crm.dynamics.com</a>. This attribute is the URL of your Microsoft application.</td>
</tr>
<tr>
<td>Token URL</td>
<td>Click the lock icon (🔒), enter <a href="https://login.microsoftonline.com/common/oauth2/v2.0/token">https://login.microsoftonline.com/common/oauth2/v2.0/token</a>, and then click the lock icon again.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>Click the lock icon (🔒), enter https://&lt;instance&gt;.servicenow.com/oauth_redirect.do, and then click the lock icon again.</td>
</tr>
</tbody>
</table>

5. In the **OAuth Entity Scopes** related list, edit the provided entity scope to include the URL of your Microsoft Dynamics CRM application. The name and the OAuth scope are often the same string.

6. Right-click the form header, and click **Save**. The system validates the OAuth credentials.

**What to do next**
Create credential record for Microsoft Dynamics CRM.

**Create Credential records for the Microsoft Dynamics CRM spoke**
Create Credential records for the Microsoft Dynamics CRM custom OAuth application you created during Microsoft Dynamics CRM account configuration. The Microsoft Dynamics CRM spoke connection and credential aliases use these credentials to authorize actions.
Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New. The system displays the message What type of Credentials would you like to create?
3. Select OAuth 2.0 Credentials. The pop-up window displays a blank OAuth 2.0 Credentials form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Dynamics Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>OAuth Entity</td>
<td>Select the OAuth profile you created when you registered the custom Microsoft Dynamics CRM application as an OAuth provider. For example, select Dynamics OAuth profile.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>
5. Save the record.
6. From Related Links, click Get OAuth Token. The system displays a confirmation message that the OAuth token flow is completed successfully. Review the details if the flow is not completed successfully.

⚠ Note: Ensure that you allow pop-up windows in your browser.

Create Connection records for the Microsoft Dynamics CRM spoke
Create Connection records to your Microsoft Azure account. The Microsoft Dynamics CRM spoke connection and credential alias uses these connections to perform actions on Microsoft Dynamics CRM.

Procedure
1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open the connection and credential alias for the Microsoft Dynamics CRM application.
3. On the Connections tab, click New. The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter MS Dynamics CRM Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for Microsoft Dynamics CRM. For example, select MS Dynamics Credentials.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Select the Connection alias record you created for Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Enter the root Dynamics URL. For example, https://&lt;SiteName&gt;.dynamics.com.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Configure Microsoft Dynamics CRM webhook details

Register Microsoft Dynamics CRM webhook in ServiceNow to notify the ServiceNow application when certain events occur in Microsoft Dynamics CRM.

Before you begin
Role required: admin

- Microsoft Dynamics CRM requires registration through the Windows Plugin Registration Tool. To install the Windows Plugin Registration Tool, see the Microsoft document Download tools from NuGet.

- The Endpoint URL is the ServiceNow instance URL to which event information is posted. For example, https://<instance-name>.service-now.com/api/sn_ms_crm_spoke/dynamics_webhook_callbacks.

- The key-value pair you use to register the webhook in the Plugin Registration Tool is the same as the Name and Authorization Key in Dynamics CRM Webhook Details.

Procedure

1. Navigate to Dynamics CRM Webhook Details > Client Details.
2. Click New.
3. In the Name field, enter the webhook's plugin key. In the Authorization Key field, enter the value from the webhook's key-value pair.
Configure Microsoft Dynamics CRM webhook decision policy
Create webhook routing policy and subflow according to your requirements.

Procedure
1. Navigate to Flow Designer > Designer
2. Click Subflows.
3. Create a copy of the default subflow, Process Dynamics CRM Webhook.
4. Customize the subflow according to your requirement and publish it. See for more information about creating and using subflows.
5. Navigate to Dynamics CRM Webhook Details > Decision Policy.
7. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Decision form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Label</td>
</tr>
<tr>
<td>Answer</td>
</tr>
<tr>
<td>a.</td>
</tr>
<tr>
<td>b.</td>
</tr>
</tbody>
</table>

| Note: Ensure that the Table name is Dynamics CRM Webhook Answer Subflow [sn_ms_crm_spoke_dynamic_crm_webhook_answer_subflow]. |
| Condition | Conditions to be met when the required events occur in Microsoft Dynamics CRM. |

8. Click Submit.

Note: These routing policies are saved in the Decision tables. Users are cautioned against directly updating or modifying data in these tables.

Results
Decision policy and subflow are created.
Microsoft Exchange Online spoke v2.0.2

The Microsoft Exchange Online spoke creates and manages calendar and mail in Microsoft Exchange Online. To create, manage, or delete users and groups, use the Microsoft Azure AD spoke.

Note: User and group management can be done using Microsoft Azure AD only and not Microsoft Exchange Online spoke.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- Remote Tables (com.glide.script.vtable)
- System Import Data Source (com.glide.system_import_data_source)
- iHub Spoke Util Pack (com.snc.ihub_spoke_util_pack)

Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported version

Microsoft Graph REST API v1.0
**Spoke module**
The Microsoft Exchange Online spoke adds the Microsoft Exchange Online application to your instance and includes these modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Events</td>
<td>Displays the list of events in Microsoft Exchange Online.</td>
</tr>
<tr>
<td>Subscriptions</td>
<td>Displays the list of subscriptions in Microsoft Exchange Online.</td>
</tr>
<tr>
<td>Webhook Registry</td>
<td>Displays the list of webhook registries of Microsoft Exchange Online.</td>
</tr>
<tr>
<td>Calendars</td>
<td>Displays a list of calendars in Microsoft Exchange Online.</td>
</tr>
<tr>
<td>Calendar Events Transform Data</td>
<td>Displays the list of records from the data source.</td>
</tr>
</tbody>
</table>

**Spoke flows**
The Microsoft Exchange Online spoke provides sample flows in the published state to demonstrate automating renewing subscriptions. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Renew Subscriptions</td>
<td>Retrieves all the subscription records and renews the subscriptions if a renewal is required, based on the expiration time. If any subscription has its status marked as 'Being deleted', then its record is deleted and is not considered for renewal.</td>
</tr>
</tbody>
</table>

**Spoke subflows**
The spoke provides subflows in the Published state to integrate with Microsoft Exchange Online service. These subflows can be used as part of other subflows and flows.
<table>
<thead>
<tr>
<th>Category</th>
<th>Subflows</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Webhook management</td>
<td>Check Event Subscription</td>
<td>Checks if a webhook subscription with specified event resource, notification URL and change type exists.</td>
</tr>
<tr>
<td></td>
<td>Create or Update Subscription</td>
<td>Checks if the specified subscription record exists in Microsoft Exchange Online and updates the subscription record if it exists. If the subscription record does not exist, a new subscription record is created.</td>
</tr>
<tr>
<td></td>
<td>Delete Subscription</td>
<td>Deletes the specified subscription when the specified subscription is associated only with the specified application.</td>
</tr>
<tr>
<td></td>
<td>Recreate Removed Subscription</td>
<td>Recreates a removed webhook subscription using the details from the associated subscription record.</td>
</tr>
<tr>
<td></td>
<td>Subscription Lifecycle</td>
<td>Manages the lifecycle of a webhook subscription.</td>
</tr>
<tr>
<td>Calendar Management</td>
<td>Calendar Synchronization</td>
<td>Synchronizes the calendar by retrieving events from Exchange Online Calendar Events Transformed Data table and adding the retrieved events to Microsoft Exchange Online Events table. Also, creates a subscription if a valid subscription does not exist.</td>
</tr>
<tr>
<td>Category</td>
<td>Subflows</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>not exist for the user's specified calendar.</td>
</tr>
<tr>
<td>Delete Calendar</td>
<td>Scheduling Event</td>
<td>Deletes the specified event in Microsoft Exchange Online and the related records from events tables, associated attachments, associated records from event attendees and event to subscription m2m tables.</td>
</tr>
<tr>
<td>Delete Event Record</td>
<td></td>
<td>Deletes the specified event record from events tables and the related attachments, related records from event attendees and event to subscription m2m tables.</td>
</tr>
<tr>
<td>Event Lifecycle Management</td>
<td></td>
<td>Retrieves the event details and updates the records in event, attendees, event to subscription m2m tables accordingly.</td>
</tr>
<tr>
<td>Sync up Events</td>
<td></td>
<td>Syncs the calendar view based on the data from Exchange Online Calendar Events Transformed Data table.</td>
</tr>
<tr>
<td>Update Calendar</td>
<td>Scheduling Event</td>
<td>Updates the properties of an event object in Microsoft Exchange Online and the related record in the events table.</td>
</tr>
</tbody>
</table>
Note:

- Use the Microsoft Exchange Online Webhook Registry table to generate a callback URL and store secret value (Client state) for webhook subscriptions.
- Make sure that webhook subscription is stored in the Microsoft Exchange Online Subscriptions table with the Status field set to Active.

Spoke actions
The Microsoft Exchange Online spoke provides actions to automate calendar and mail tasks when an incident is created in the ServiceNow instance.

Microsoft Exchange Online spoke actions

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar Management</td>
<td>Copy Attachment to Calendar Event</td>
<td>Copies a ServiceNow attachment to an Exchange calendar event.</td>
</tr>
<tr>
<td></td>
<td>Create Calendar Event</td>
<td>Creates an event in the user's default calendar and specifies the time zone for the start and end times of the event.</td>
</tr>
<tr>
<td></td>
<td>Create Recurring Calendar Events</td>
<td>Creates a recurring event in the user's default calendar and specifies the time zone for the start and end times of the event.</td>
</tr>
<tr>
<td></td>
<td>Delete Attachment</td>
<td>Deletes the specified attachment in the specified event.</td>
</tr>
<tr>
<td></td>
<td>Delete Calendar Event</td>
<td>Deletes a calendar event.</td>
</tr>
<tr>
<td></td>
<td>Find Meeting Times</td>
<td>Retrieves meeting times and locations based on the availability of the meeting organizer and attendees for the specified time and locations.</td>
</tr>
<tr>
<td></td>
<td>Look up Attachments by Event ID</td>
<td>Retrieves all the attachments in the specified event.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Look up Calendar by ID</td>
<td>Retrieves the calendar details for the specified ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Calendar Events by User ID</td>
<td>Retrieves the list of event objects in the user’s mailbox.</td>
</tr>
<tr>
<td></td>
<td>Look up Calendar View Stream</td>
<td>Retrieves the list of meeting entries for the specified User ID for the specified time period.</td>
</tr>
<tr>
<td></td>
<td>Look up Calendars Stream</td>
<td>Retrieves details of calendars of all the users.</td>
</tr>
<tr>
<td></td>
<td>Look up Event by ID</td>
<td>Retrieves the calendar event details for the specified ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Schedules</td>
<td>Retrieves the list of schedules.</td>
</tr>
<tr>
<td></td>
<td>Look up Time Zones</td>
<td>Retrieves details of all the available time zones.</td>
</tr>
<tr>
<td></td>
<td>Update Calendar Event</td>
<td>Updates the properties of an event object.</td>
</tr>
<tr>
<td>Mail Management</td>
<td>Delete Message</td>
<td>Deletes the message in user's inbox or from a custom folder.</td>
</tr>
<tr>
<td></td>
<td>Look Up Mail Folders by User ID</td>
<td>Retrieves all the mail folders for a specified User ID.</td>
</tr>
<tr>
<td></td>
<td>Look Up Messages by Mail Folder ID</td>
<td>Retrieves all the messages in a mail folder.</td>
</tr>
<tr>
<td></td>
<td>Look Up Messages by User ID</td>
<td>Retrieves all the messages in the inbox folder of the user.</td>
</tr>
</tbody>
</table>
### Microsoft Exchange Online spoke actions (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Send Mail</td>
<td>Sends an email with the message subject and message body to the specified list of recipients.</td>
</tr>
<tr>
<td></td>
<td>Set Mailbox Auto Reply</td>
<td>Sets the user’s auto-reply message for the given time period.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Look up Time Zones Metadata</td>
<td>Retrieves the metadata of all available time zones.</td>
</tr>
<tr>
<td></td>
<td>Look up Rooms Metadata</td>
<td>Retrieves the metadata of rooms.</td>
</tr>
<tr>
<td></td>
<td>Look up Rooms Stream - Room Management</td>
<td>Retrieves the metadata of the rooms stream.</td>
</tr>
<tr>
<td>Webhook Management</td>
<td>Look up Subscription by ID</td>
<td>Retrieves details of the webhook subscription for the specified ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Subscriptions Stream</td>
<td>Retrieves details of all webhook subscriptions.</td>
</tr>
<tr>
<td></td>
<td>Renew Webhook Subscription</td>
<td>Renews the subscription of the specified webhook.</td>
</tr>
<tr>
<td></td>
<td>Subscribe Webhook</td>
<td>Creates a webhook subscription for the specified resource.</td>
</tr>
<tr>
<td></td>
<td>Unsubscribe Webhook</td>
<td>Deletes the specified webhook subscription.</td>
</tr>
</tbody>
</table>

### Microsoft account requirements

The Microsoft Exchange Online spoke requires registering an application using the Microsoft Azure portal to generate OAuth 2.0 tokens.
Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up Microsoft Exchange Online spoke
Integrate the ServiceNow instance and Microsoft Exchange Online account by creating a custom OAuth application in Microsoft Exchange Online to authenticate ServiceNow requests.

Before you begin
• Request IntegrationHub Professional subscription
• Activate the Microsoft Exchange Online spoke
• Role required: admin

Register an application using the Microsoft Azure portal
Provide authorization to the ServiceNow instance by registering an application with Azure AD.

Before you begin
Role required: Azure Active Directory admin

About this task
Complete these steps from the Microsoft Azure portal. For instructions on registering an application, see the Microsoft Azure documentation.

Procedure
1. In the Microsoft Azure portal, add the Redirect URIs in this format: https://<instance-name>.service-now.com/oauth_redirect.do
2. For the Required Permissions, select Microsoft Graph.
3. Record the **Client Secret** for use in later configurations.

**Results**
The ServiceNow application is created with Microsoft Azure AD.

**Register Microsoft Exchange Online as the OAuth provider**

Register Microsoft Exchange Online as the OAuth provider so that the ServiceNow instance can request OAuth 2.0 tokens.

**About this task**
Use the information generated during the registration of the application in the Microsoft Azure portal.

**Procedure**

1. Navigate to **System OAuth > Application Registry**.
2. Open the record, **Microsoft Exchange Online**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Application Registries form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>-----------------------</td>
</tr>
<tr>
<td>Client ID</td>
</tr>
<tr>
<td>Client Secret</td>
</tr>
<tr>
<td>OAuth API Script</td>
</tr>
<tr>
<td>Logo URL</td>
</tr>
<tr>
<td>Default Grant Type</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
</tr>
<tr>
<td>PKCE required</td>
</tr>
</tbody>
</table>

**Note:** You can use only **Authorization Code** as the **Default Grant type** when PKCE is enabled.

<table>
<thead>
<tr>
<th>Application</th>
<th>Application scope that contains this record.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessible from</td>
<td>Application scope that this registry is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>OAuth server token revocation endpoint.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint. Enter https://&lt;instance-name&gt;.service-now.com/oauth_redirect.do</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use mutual authentication for token request and revocation. This option requires a mutual authentication profile to be specified.</td>
</tr>
<tr>
<td>Send Credentials</td>
<td>Client credentials in the request.</td>
</tr>
</tbody>
</table>
4. Right-click the form header, and click **Save**.
   A system-generated OAuth entity profile is created and displayed in the OAuth Entity Profiles related list. For example, **Microsoft Exchange Online default_profile**.

5. Navigate to **System OAuth > Application Registry**.

6. Open the record, **Microsoft Exchange Online_clientCredentials**.

7. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Application Registries form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Client ID</td>
</tr>
<tr>
<td>Client Secret</td>
</tr>
<tr>
<td>Default Grant Type</td>
</tr>
<tr>
<td>Redirect URL</td>
</tr>
</tbody>
</table>

8. Right-click the form header, and click **Save**.
   A system-generated OAuth entity profile is created and displayed in the OAuth Entity Profiles related list. For example, **Microsoft Exchange Online_clientCredentials default_profile**.

---

**Create Credential records for the Microsoft Exchange Online spoke**

Authorize the Microsoft Exchange Online spoke actions by creating credential records for the application registered in the Microsoft Azure portal. The Microsoft Exchange Online connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
   The system displays the message, **What type of Credentials would you like to create?**
3. Select OAuth 2.0 Credentials.

4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>OAuth 2.0 Credentials form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Name to uniquely identify the record. For example, Exchange_Online_Credentials.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td><strong>OAuth Entity Profile</strong></td>
<td>OAuth profile created during the registration of Microsoft Exchange Online spoke as an OAuth provider with Default Grant Type as Authorization Code. For example, Microsoft Exchange Online.</td>
</tr>
<tr>
<td><strong>Applies to</strong></td>
<td>MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td><strong>Order</strong></td>
<td>Order that the credentials are used. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click **Save**.

6. To generate the OAuth token, click the **Get OAuth Token** related link.

7. Navigate to **Connections & Credentials > Credentials**.

8. Click **New**.

   The system displays the message, What type of Credentials would you like to create?

9. Select **OAuth 2.0 Credentials**.

10. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>OAuth 2.0 Credentials form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Name to uniquely identify the record. For example, Exchange_Online_Credentials_clientCred.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td><strong>OAuth Entity Profile</strong></td>
<td>OAuth profile created during the registration of Microsoft Exchange Online spoke as an OAuth provider with Default Grant Type as Client Credentials. For example, Microsoft Exchange Online_clientCredentials default_profile.</td>
</tr>
<tr>
<td><strong>Applies to</strong></td>
<td>MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
</tbody>
</table>
11. Right-click the form header and click **Save**.

12. To generate the OAuth token, click the **Get OAuth Token** related link.

**Results**
The credential records for the Microsoft Exchange Online spoke are created.

**Create Connection records for the Microsoft Exchange Online spoke**
Perform actions in Microsoft Exchange Online by creating connection records for your Microsoft Exchange Online account. The Microsoft Exchange Online spoke connection and credential alias uses these connections to perform actions.

**Procedure**
1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open the record, **Microsoft_Exchange_Online**.
3. In the Connections related list, click **New**.
4. On the form, fill in the fields.

### HTTP(s) Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Exchange_Online_Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Microsoft Exchange Online. For example, Exchange_Online_Credentials.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td><strong>Note:</strong> Do not select the check box.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Server. If the check box is selected, define the fields in the Advanced MID Server Configuration related list.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>
5. Click **Update**.
6. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
7. Open the record, **Microsoft_Exchange_Online_clientCred**.
8. In the Connections related list, click **New**.

### HTTP(s) Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Exchange_Online_Connection_clientCred.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Microsoft Exchange Online. For example, Exchange_Online_Credentials_clientCred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td>Note: Do not select the check box.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Server. If the check box is selected, define the fields in the Advanced MID Server Configuration related list.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

10. Click **Update**.

**Results**
The Microsoft Exchange Online spoke is set up and integrated with the ServiceNow instance.

**Regenerate the Microsoft Exchange Online OAuth token**
Authorize the Microsoft Exchange Online spoke by regenerating the Microsoft Exchange Online OAuth token after it expires.

**Before you begin**
Role required: admin
Procedure
1. Navigate to **Connections & Credentials > Credentials**.
2. Select the Microsoft Exchange Online spoke OAuth Credential record.
3. To regenerate the OAuth token, click the **Get OAuth Token** related link.

Results
The Microsoft Exchange Online spoke receives a new OAuth access token.

**Microsoft Exchange Server spoke v2.1.1**
The Microsoft Exchange Server spoke creates and manages address list, mailbox, and calendar events in Microsoft Exchange mail system.

**Request apps on the Store**
Visit the [ServiceNow Store](https://store.servicenow.com) website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the [ServiceNow Store version history release notes](https://store.servicenow.com/v2.1.1).

The Microsoft Exchange Server spoke requires an IntegrationHub subscription.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Professional subscription package. For more information, see [Request IntegrationHub](https://store.servicenow.com/v2.1.1).

**Spoke dependencies**
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - PowerShell (com.glide.hub.action_step.powershell)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

⚠ **Note:** Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.
Supported versions

- Exchange Server 2016 installed on Windows Server 2016

Note: The Create Calendar Event For User and Lookup Room Availability actions are supported only on Exchange Server 2013.

- Exchange Server 2013 installed on Windows Server 2012 R2

This spoke may be compatible with the earlier versions of Microsoft Exchange Server.

Spoke requirements

Powershell remoting must be enabled on the target Exchange Server. For more information about the Microsoft Exchange Server, see Exchange Server documentation.

Spoke flows

The Exchange Server spoke provides sample flows to demonstrate automating the Exchange Server tasks. To customize a sample flow, copy it to the required application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pull From Subscriptions</td>
<td>Uses the Look up Items From Subscription ID subflow to periodically retrieve the modified items in an active subscription and saves the details in the ServiceNow instance.</td>
</tr>
<tr>
<td>Look up Calendar Item from Item ID Flow</td>
<td>Uses the Look up Items From Subscription ID subflow to display the details of the modified items in a subscription in the Subscription to Events Mapping module.</td>
</tr>
<tr>
<td>Renew Subscription</td>
<td>Uses the Renew Subscription subflow to renew subscription.</td>
</tr>
</tbody>
</table>

Note: Subscriptions are valid for 24 hours and flows renew the subscriptions periodically. If there are failures with the third-party applications, subscriptions will not be renewed. That is, Active is set to False. In the event of failure, you should use the create subscription flow to create a subscription.
**Spoke subflows**
The Exchange Server spoke provides sample subflows to demonstrate automating the Exchange Server tasks. To customize a sample subflow, copy it to the required application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Look up Items From Subscription ID</td>
<td>Saves the details of the modified items in a subscription to the Event to Subscription Mapping table.</td>
</tr>
<tr>
<td>Create Subscription</td>
<td>Creates a subscription for the specified mailbox and adds it to the Subscription table. If the subscription already exists, the subflow adds the application details to the subscription record.</td>
</tr>
<tr>
<td>Renew Subscription</td>
<td>Renews a subscription for the given mailbox.</td>
</tr>
</tbody>
</table>

**Spoke actions**
The Microsoft Exchange Server spoke provides actions to automate address list, mailbox, and calendar event tasks.

**Microsoft Exchange Server spoke actions**

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address List Management</td>
<td>Create Address List Using Included Recipients</td>
<td>Creates a new address list in Exchange Server using the <strong>Included Recipients</strong> field.</td>
</tr>
<tr>
<td></td>
<td>Create Address List Using Recipient Filter</td>
<td>Creates a new address list in Exchange Server using the <strong>Recipient</strong> field.</td>
</tr>
<tr>
<td></td>
<td>Delete Address List</td>
<td>Deletes the required address list on a required Exchange Server.</td>
</tr>
<tr>
<td></td>
<td>Get Address List Details</td>
<td>Retrieves the details of a required address list on a required Exchange Server.</td>
</tr>
</tbody>
</table>
Microsoft Exchange Server spoke actions (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Look Up Address List</td>
<td>Look Up Address List</td>
<td>Retrieves the address list details on a required Exchange Server using a search query.</td>
</tr>
<tr>
<td></td>
<td>Look up Address List Details</td>
<td>Retrieves details of the specified address list by identity.</td>
</tr>
<tr>
<td></td>
<td>Move Address List</td>
<td>Moves an address list to another location in the address hierarchy.</td>
</tr>
<tr>
<td></td>
<td>Synchronize Address List</td>
<td>Refreshes email clients with the latest details, for a required address list in Exchange Server.</td>
</tr>
<tr>
<td></td>
<td>Update Address List Using Included Recipients</td>
<td>Updates details and recipients of a required address list using a the Included Recipients field.</td>
</tr>
<tr>
<td></td>
<td>Update Address List Using Recipient Filter</td>
<td>Updates details and recipients of a required address list details using the Recipient Filter field.</td>
</tr>
<tr>
<td>Mailbox Management</td>
<td>Create Calendar Event For User</td>
<td>Creates a calendar event in Exchange Server. Calendar event can be either a meeting or appointment.</td>
</tr>
<tr>
<td></td>
<td>Create Mailbox</td>
<td>Creates mailboxes and user accounts simultaneously.</td>
</tr>
<tr>
<td></td>
<td>Delete Mailbox</td>
<td>Deletes a mailbox in Exchange Server.</td>
</tr>
</tbody>
</table>

**Note:**
- This action is supported only on Exchange Server 2013.
- This action uses the Exchange_https connection and credential alias.
Microsoft Exchange Server spoke actions (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Mailbox</td>
<td>Disables Mailbox</td>
<td>Disables a mailbox in Exchange Server.</td>
</tr>
<tr>
<td>Enable Mailbox</td>
<td>Enable Mailbox</td>
<td>Enables a mailbox in Exchange Server.</td>
</tr>
<tr>
<td>Look up Calendar by Event ID</td>
<td>Look up Calendar by Event ID</td>
<td>Retrieves the list of calendar events.</td>
</tr>
<tr>
<td>Look up Mailbox</td>
<td>Look up Mailbox</td>
<td>Retrieves mailbox properties for a given mailbox in Exchange Server.</td>
</tr>
<tr>
<td>Look up Room Availability</td>
<td>Look up Room Availability</td>
<td>Retrieves the availability response for a given array of room objects.</td>
</tr>
<tr>
<td>Update Mailbox</td>
<td>Update Mailbox</td>
<td>Updates the properties of a mailbox in Exchange Server.</td>
</tr>
<tr>
<td>Set Mailbox Auto Reply</td>
<td>Set Mailbox Auto Reply</td>
<td>Schedules the auto-reply for a given mailbox in Exchange Server.</td>
</tr>
<tr>
<td>Lookup Room Mailboxes</td>
<td>Lookup Room Mailboxes</td>
<td>Retrieves all the room mailboxes in Exchange Server.</td>
</tr>
<tr>
<td>Meeting Management</td>
<td>Look up Meeting Suggestions</td>
<td>Retrieves the meeting suggestions for the specified mailboxes.</td>
</tr>
<tr>
<td></td>
<td>Look up User Availabilities</td>
<td>Retrieves the availability response for a given mailbox.</td>
</tr>
<tr>
<td>Subscription Management</td>
<td>Create Subscription</td>
<td>Creates a new subscription for given mailbox.</td>
</tr>
<tr>
<td></td>
<td>Look up Calendar Item from Item ID</td>
<td>Look up Calendar Item from Item ID</td>
</tr>
<tr>
<td></td>
<td>Look up Events by Subscription ID</td>
<td>Retrieves the calendar information for the given calendar ID.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Retrieves the latest changes in the calendar folder for the subscription since the last watermark.</td>
</tr>
</tbody>
</table>

**Note:** The Exchange Server spoke supports the calendar events only.
Microsoft Exchange Server spoke actions (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment Management</td>
<td>Copy Attachment to Event Record</td>
<td>Copies an calendar event’s attachment to the specified record in the ServiceNow instance.</td>
</tr>
<tr>
<td></td>
<td>Create Attachment</td>
<td>Adds attachment to an event.</td>
</tr>
<tr>
<td></td>
<td>Delete Attachment</td>
<td>Deletes an attachment associated with the provided Attachment ID.</td>
</tr>
<tr>
<td></td>
<td>Delete Attachments from Event Record</td>
<td>Deletes one or more attachments associated with the specified event record.</td>
</tr>
<tr>
<td></td>
<td>Look up Attachment by Attachment ID</td>
<td>Retrieves the specified attachment.</td>
</tr>
</tbody>
</table>

Spoke modules
The Exchange Server spoke adds a Microsoft Exchange Server Spoke module to your ServiceNow instance. Data is these modules is populated when the associated flows are executed:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscriptions</td>
<td>Displays details of the subscriptions in Exchange Server. Data is populated in this module when the Create Subscriptions and Renew Subscriptions subflows are executed.</td>
</tr>
<tr>
<td>Events</td>
<td>Displays details of the events in Exchange Server. Data is populated in this module when the Look up Calendar Item from Item ID flow is executed.</td>
</tr>
<tr>
<td>Event Attendees</td>
<td>Displays details of the event attendees in the events. Data is populated in this module when the Look up Calendar Item from Item ID flow is executed.</td>
</tr>
<tr>
<td>Module</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>module when the Look up Calendar Item from Item ID flow is executed.</td>
<td></td>
</tr>
<tr>
<td>Subscription to Events Mapping</td>
<td>Displays details of the subscriptions and events. Data is populated in this module when the Look up Items From Subscription ID subflow is executed.</td>
</tr>
</tbody>
</table>

### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Two connection and credential aliases are created when the Microsoft Exchange Server spoke is activated, Exchange and Exchange_https.

ℹ️ Note:

- The Exchange_https alias is supported only on Exchange Server 2013.
- The Exchange_https alias is required to use the Create Calendar Event For User and Lookup Room Availability actions.

### MID Server requirements

Your instance must have a MID Server set up and configured to run PowerShell 2.0. Use the connection record associated with the Microsoft Exchange alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

### Set up Microsoft Exchange Server spoke

Integrate the ServiceNow instance and Exchange Server by using the Windows credentials to authenticate ServiceNow requests.

### Before you begin

- Request IntegrationHub subscription
- Activate the Microsoft Exchange Server spoke
- Role required: admin
About this task

- Perform these steps to use all Microsoft Exchange Server spoke actions except the Create Calendar Event For User and Lookup Room Availability actions.

- To use the Create Calendar Event For User and Lookup Room Availability actions, perform the same steps again for the Exchange https connection and credential alias. MID Server is not necessary to perform this action.

Note:

- The Create Calendar Event For User and Lookup Room Availability actions are supported only on Exchange Server 2013.

- Ensure that the user details provided in the credential record, has the application impersonation role.

Create Credential record for Microsoft Exchange Server spoke

Authorize the Microsoft Exchange Server spoke actions by creating Windows credential record for the Exchange Server host. The Microsoft Exchange Server spoke connection and credential alias uses these credentials to authorize actions.

About this task
Create two credential records, one for each connection and credential alias.

Procedure

1. Navigate to Connections & Credentials > Credentials.

2. Click New.

   The system displays the message, What type of Credentials would you like to create?


4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, MSEExchangeCredentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>User name</td>
<td>User name with access to the target Windows host. For more information about Windows permissions, see Windows credentials.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Password</td>
<td>Password for the account.</td>
</tr>
<tr>
<td>Applies to</td>
<td>MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the credentials are used. For example, enter 100.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Advanced selection criteria for the credential.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Results**
The Windows credential record for the Microsoft Exchange Server spoke is created.

**Create Connection record for Microsoft Exchange Server spoke**
Perform actions in Microsoft Exchange Server spoke by creating connection records. The Microsoft Exchange Server spoke connection and credential alias uses these connections to perform actions.

**Procedure**
1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open the Microsoft Exchange Server spoke record.
3. In the Connections related list, click **New**.
4. On the form, fill in the fields.

**Connection form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Exchange Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for the Microsoft Exchange Server spoke. For example, MSExchangeCredentials.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Host</td>
<td>Fully qualified domain name or IP address of the target host where Exchange Server is installed.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
<tr>
<td>Override default port</td>
<td>Target port that the connection uses.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Server. If the check box is selected, define the fields in the Advanced MID Server Configuration related list.</td>
</tr>
</tbody>
</table>

**Note:** MID Server is necessary for all the Microsoft Exchange Server spoke actions except the Create Calendar Event For User action.

5. Click **Submit**.

**Results**
The Microsoft Exchange Server spoke is set up and integrated with the ServiceNow instance.

**Microsoft Intune spoke**
Manage devices and applications in Microsoft Intune account from your ServiceNow instance.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Supported versions**
This spoke was built for Microsoft Intune API version v1, but may be compatible with later versions.

**Spoke dependencies**
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions

The Microsoft Intune spoke provides actions to automate tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Management</td>
<td>Get Managed Application</td>
<td>Retrieves details of the specified application.</td>
</tr>
<tr>
<td></td>
<td>Look up Managed Applications</td>
<td>Retrieves a list of all the applications.</td>
</tr>
<tr>
<td>Device Management</td>
<td>Delete Managed Device</td>
<td>Deletes the specified managed device.</td>
</tr>
<tr>
<td></td>
<td>Get Managed Device</td>
<td>Retrieves details of the specified managed device.</td>
</tr>
<tr>
<td></td>
<td>Look up Managed Devices</td>
<td>Retrieves details of the specified managed device.</td>
</tr>
<tr>
<td></td>
<td>Look up Managed Devices By Application</td>
<td>Retrieves details of the managed device within the specified application.</td>
</tr>
<tr>
<td></td>
<td>Look up Managed Devices By User</td>
<td>Retrieves details of managed device for a specific user.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Update Managed Device</td>
<td>Updates details of the specified managed device.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Look up Application ID</td>
<td>Returns the Application ID for the dynamic input of the Look up Managed Devices By Application action.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the Microsoft Intune spoke**

Integrate the ServiceNow instance and Microsoft Intune account by creating a custom OAuth application in Microsoft Intune to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub subscription.
- Activate Microsoft Intune spoke.
- Role required: admin

**Register an application using the Microsoft Azure portal**

Provide authorization to the ServiceNow instance by registering an application with Azure AD.

**Before you begin**

Role required: Azure Active Directory admin

**About this task**

Complete these steps from the Microsoft Azure portal.
Procedure

1. Register an application in the Microsoft Azure portal. For instructions on registering an application, see Tutorial: Register an app with Azure Active Directory in the Microsoft Azure documentation.

2. Add the Redirect URIs in this format: https://<instance-name>.service-now.com/oauth_redirect.do. For more information, see Authentication and authorization for Azure Time Series Insights API in Microsoft Docs.

3. For the Required Permissions, ensure that you provide these permissions:

<table>
<thead>
<tr>
<th>API / Permissions name</th>
<th>Type</th>
<th>Description</th>
<th>Admin consent required</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Graph (1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DeviceManagementApps.Req.</td>
<td>Delegated</td>
<td>Read and write Microsoft Intune apps</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>DeviceManagementApps.Managed.</td>
<td>Delegated</td>
<td>Perform user-impacting remote actions on Microsoft Intune devices</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>DeviceManagementApps.Managed.</td>
<td>Delegated</td>
<td>Read and write Microsoft Intune devices</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>offline access</td>
<td>Delegated</td>
<td>Maintain access to data you have given it access to</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>aop sidelined</td>
<td>Delegated</td>
<td>Sign users in</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>profile</td>
<td>Delegated</td>
<td>View users' basic profile</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>User.Read</td>
<td>Delegated</td>
<td>Sign in and read user profile</td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

Other permissions granted for contentspokes

These permissions have been granted for contentspokes but aren’t in the configured permissions list. If your application requires these permissions, you should consider adding them to the configured permissions list. Learn more

<table>
<thead>
<tr>
<th>API / Permissions name</th>
<th>Type</th>
<th>Description</th>
<th>Admin consent required</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Graph (1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User.Read/Write.UL</td>
<td>Delegated</td>
<td>Read and write all users’ full profiles</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

For more information, see Quickstart: Configure a client application to access a web API in Microsoft Docs.

4. Create a client secret and record the value of Client Secret for use in later configurations. For more information, see the Option 2: Create a new application secret section in Microsoft Docs.

Results

The ServiceNow application is created with Microsoft Azure AD.

Register Microsoft Intune as an OAuth provider

Use the information generated during the application configuration in Microsoft Azure portal to register Microsoft Intune as the OAuth provider so that the ServiceNow instance can request OAuth 2.0 tokens.
**Procedure**

1. Navigate to **System OAuth > Application Registry**.
2. Open for the record, **Microsoft Intune**.
3. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Application ID created during application registration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client secret created during application registration.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>OAuth server token revocation endpoint.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**.

**Create a credential record for the Microsoft Intune spoke**

Authorize the Microsoft Intune spoke actions by creating credential records for the application registered in the Microsoft Azure portal. The Microsoft Intune connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.

   The system displays this message: **What type of Credentials would you like to create?**

3. Select **OAuth 2.0 Credentials**.
4. On the form, fill in the fields.
### OAuth 2.0 Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, MS Intune Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile created during the registration of Microsoft Intune as an OAuth provider. For example, Microsoft Intune default_profile.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click **Submit**.

6. To generate the OAuth token, click the **Get OAuth Token** related link.

### Create a connection record for the Microsoft Intune spoke

Perform actions in Microsoft Intune by creating connection records for your Microsoft Intune account. The Microsoft Intune connection and credential alias uses these connections to perform actions.

#### Procedure

1. Navigate to **Connections & Credentials** > **Connections & Credentials Aliases**.
2. Open the alias record, **Microsoft_Intune**.
3. From the **Connections** tab, click **New**.
4. On the form, fill in the fields.

### HTTP(s) Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, MS Intune Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Microsoft Intune spoke. For example, MS Intune Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td><strong>Note:</strong> Do not select the check box.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Connection URL. Enter <a href="https://graph.microsoft.com">https://graph.microsoft.com</a>.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

5. In the **Attributes** tab, specify *v1.0* for **u_version**.

6. Click **Submit**.

**Results**
The Microsoft Intune spoke is set up and Microsoft Intune is integrated with the ServiceNow instance.

**Microsoft OneDrive spoke v2.1.0**
Automate file and folder management and collaboration in Microsoft OneDrive. Adds Microsoft OneDrive data to your ServiceNow instance.

**Request apps on the Store**
Visit the [ServiceNow Store](https://www.servicenow.com) website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the [ServiceNow Store version history release notes](https://www.servicenow.com/store).

**IntegrationHub subscription**
This spoke requires the IntegrationHub Professional subscription package. For more information, see [Request IntegrationHub](https://www.servicenow.com/store).

**Spoke dependencies**
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

**Note**: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

**Supported versions**
API version v1.
Spoke flows

The Microsoft OneDrive spoke provides sample flows in the draft state to demonstrate automating Microsoft OneDrive tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Renew Subscriptions</td>
<td>Renews the expired subscriptions by updating the expiration date of the subscription.</td>
</tr>
</tbody>
</table>

Spoke subflows

The Microsoft OneDrive spoke provides sample subflows in the draft state to demonstrate automating Microsoft OneDrive tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download New OneDrive File to Servicenow</td>
<td>Downloads the new files uploaded in a resource to a ServiceNow record</td>
</tr>
<tr>
<td>Subscribe to Webhook</td>
<td>Subscribes a listener application to receive notifications when data changes.</td>
</tr>
<tr>
<td>Sync Changes</td>
<td>Tracks changes to a drive and its children over time.</td>
</tr>
</tbody>
</table>

Spoke actions

The Microsoft OneDrive spoke provides actions to automate Microsoft OneDrive tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive Management</td>
<td>Look up Drive Info</td>
<td>Gets the metadata of a specific Microsoft OneDrive drive</td>
</tr>
<tr>
<td></td>
<td>Look up Drives (Deprecated)</td>
<td>Retrieves all the available drives associated with a target User, Group, or Site. If you don't provide a User, Group, or Site, then a list of root drives associated with the authenticated user is returned.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Folder Management</td>
<td>Move File Or Folder Item</td>
<td>Moves a file or folder in Microsoft OneDrive to the target location.</td>
</tr>
<tr>
<td></td>
<td>Create Folder</td>
<td>Creates a folder in Microsoft OneDrive.</td>
</tr>
<tr>
<td></td>
<td>Update File Or Folder Name</td>
<td>Updates the name for a file or folder item by ID.</td>
</tr>
<tr>
<td></td>
<td>Delete File Or Folder Item</td>
<td>Deletes a file or folder from Microsoft OneDrive.</td>
</tr>
<tr>
<td>File Management</td>
<td>Check In File</td>
<td>Checks in a drive item and sends a sharing invitation. When you check in a file, other users can access the checked-in file.</td>
</tr>
<tr>
<td></td>
<td>Check Out File</td>
<td>Checks out a drive item from OneDrive. When you check out a drive item, other users cannot edit the document. Other users also cannot see the changes that you made in the document until you check in the document.</td>
</tr>
<tr>
<td></td>
<td>Copy OneDrive File to Attachment</td>
<td>Copies a file in Microsoft OneDrive to an attachment in a record in a ServiceNow record.</td>
</tr>
<tr>
<td></td>
<td>Copy Attachment to OneDrive</td>
<td>Copies an attachment record in ServiceNow to Microsoft OneDrive</td>
</tr>
<tr>
<td></td>
<td>Copy File Or Folder Item</td>
<td>Asynchronously creates a copy of a Microsoft OneDrive item (including children), under a new parent item or with a new name.</td>
</tr>
<tr>
<td></td>
<td>Look up Items</td>
<td>Retrieves a list of drive items from a path or the source and source ID of a drive item.</td>
</tr>
<tr>
<td></td>
<td>Look up File Or Folder Item Info By ID</td>
<td>Gets file metadata information from the file or folder ID in Microsoft OneDrive.</td>
</tr>
<tr>
<td></td>
<td>Look up File Or Folder Item Info By Path</td>
<td>Gets file metadata information from the file path in Microsoft OneDrive.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Copy Attachment To OneDrive Using Path</td>
<td>Copies an attachment record in ServiceNow to OneDrive.</td>
</tr>
<tr>
<td></td>
<td>Copy OneDrive File To Attachment Using File Path</td>
<td>Copies a file using its path in OneDrive to an attachment in a record in ServiceNow.</td>
</tr>
<tr>
<td></td>
<td>Copy OneDrive File Version To Attachment</td>
<td>Copies a file in OneDrive to an attachment in a record in ServiceNow.</td>
</tr>
<tr>
<td></td>
<td>Delete Version of a File</td>
<td>Deletes the specified version of a file from OneDrive.</td>
</tr>
<tr>
<td></td>
<td>Look up All Versions of a File</td>
<td>Retrieves all the versions a file in OneDrive.</td>
</tr>
<tr>
<td></td>
<td>Restore File Version</td>
<td>Restores the specified file version and make this version the latest.</td>
</tr>
<tr>
<td></td>
<td>Upload and Replace File</td>
<td>Uploads the updated version of an existing file or replaces the existing file with a new file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> The maximum size of the file cannot exceed 4 MB.</td>
</tr>
<tr>
<td>Search Documents</td>
<td>Search Files or Folder Items</td>
<td>Searches the drive items (files or folders) based on metadata attributes such as the item name.</td>
</tr>
<tr>
<td>Document Sharing</td>
<td>Add Collaborator</td>
<td>Adds a collaborator and their permissions to a file or a folder. You can identify the collaborator by their Azure AD Alias or an Object ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Collaborators</td>
<td>Lists all the collaborator details associated with a file or folder in Microsoft OneDrive.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Permission Management</td>
<td>Remove Collaborator</td>
<td>Removes a collaborator from a file or folder in Microsoft OneDrive.</td>
</tr>
<tr>
<td></td>
<td>Add Permission</td>
<td>Sends a sharing invitation for a drive item. A sharing invitation allows the recipients to access the drive item and optionally sends them an email with a sharing link.</td>
</tr>
<tr>
<td></td>
<td>Create Sharing Link</td>
<td>Creates a sharing link which allows you to share a drive item with other users.</td>
</tr>
<tr>
<td></td>
<td>Delete Permission</td>
<td>Removes access to a drive item.</td>
</tr>
<tr>
<td></td>
<td>Look up Permissions</td>
<td>Retrieves the sharing permissions of a drive item.</td>
</tr>
<tr>
<td></td>
<td>Update Permission</td>
<td>Updates the expiration date of the subscription.</td>
</tr>
<tr>
<td>Webhook Management</td>
<td>Subscribe Webhook</td>
<td>Creates a subscription that sends notifications when data changes.</td>
</tr>
<tr>
<td></td>
<td>Unsubscribe Webhook</td>
<td>Deletes the specified subscription ID.</td>
</tr>
<tr>
<td></td>
<td>Get SyncToken for Subscription</td>
<td>Retrieves the latest sync token for the specified subscription ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Subscriptions</td>
<td>Retrieves the list of active subscriptions.</td>
</tr>
<tr>
<td></td>
<td>Renew Subscription</td>
<td>Updates the expiration date of the subscription.</td>
</tr>
<tr>
<td></td>
<td>Sync Changes</td>
<td>Tracks changes to a drive and drive's children over time.</td>
</tr>
</tbody>
</table>

**Spoke module**

Bi-directional webhooks can be set up to get notifications about the required events. Routing policy defines conditions that must be met to notify the ServiceNow app. These conditions are based on the events in OneDrive that you want to be notified about. When the conditions are met, a routing policy triggers the associated subflow, which in turn automates the OneDrive tasks.
The bi-directional webhooks require separate setup and can be used independently without using the spoke actions. By default, the Jira Webhooks application is available in the Jira spoke and has the following modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OneDrive SyncToken</td>
<td>Allows you to view SyncTokens of OneDrive.</td>
</tr>
<tr>
<td>OneDrive Webhook Registries</td>
<td>Allows you to create and view the OneDrive webhooks in ServiceNow.</td>
</tr>
<tr>
<td>OneDrive Webhook Routing Policy</td>
<td>Allows you to create and view the routing policies for the OneDrive webhooks in ServiceNow. You can also customize the conditions in the routing policies as per your requirement.</td>
</tr>
</tbody>
</table>

**OneDrive Online account requirements**

The Microsoft OneDrive spoke requires a custom app that you create in Microsoft Azure.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**Single tenant**

The OneDrive spoke includes the OneDrive alias record to authorize actions on Microsoft OneDrive. Select this alias in the Tenant record to authorize changes in Microsoft OneDrive for a single tenant.

**Multiple tenants**

The OneDrive spoke includes the OneDrive alias record to authorize actions on Microsoft OneDrive. Create a connection and credential alias record for each additional tenant site you wish to support. Select the correct alias in the Tenant record to authorize changes in Microsoft SharePoint. See Create aliases for multiple tenants.
MID Server requirements

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the MicrosoftSharepointOnline alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

Set up Microsoft OneDrive spoke

Integrate the ServiceNow instance and Microsoft OneDrive spoke by using Windows credentials to authenticate ServiceNow requests.

Before you begin

• Install Microsoft AD.
• Install the Microsoft OneDrive spoke.
• Request IntegrationHub subscription.
• Activate the Microsoft OneDrive spoke.
• Role required: admin

Configure Microsoft OneDrive application

Create a custom OAuth application from your Microsoft OneDrive account to enable OAuth 2.0 authentication with the Microsoft OneDrive spoke.

Before you begin

Microsoft OneDrive requirements:

• Microsoft OneDrive account
• Microsoft Azure account
• Microsoft OneDrive tenant administrator credentials

About this task

Complete these steps from your Azure Developer account. See the Azure product documentation for instructions on creating and configuring custom applications.

Procedure

1. Log in to the Microsoft Azure App registration portal with your organization credentials.
2. Register a new custom application. Fill in the application name, the supported account type, and the redirect URI, and then click Register.
   An overview of the application’s basic information is shown.
Note: Ensure that you enter the redirect URI in this format: https://<instance>.service-now.com/oauth_redirect.do.

3. Copy the application ID to a text file.
You will use this ID and the client secret generated in the next step to register the app as a third-party OAuth provider on your ServiceNow instance. You use the application ID as the client ID when you connect the application to ServiceNow.

4. Add a client secret.

   a. In Microsoft Azure, navigate to Manage > Certificates & secrets.

   b. Provide a description and an expiration date and click Add.

   Note: The client secret is only displayed in plain text for a short time. You use the client secret when you connect the application to ServiceNow.

5. Enable the permissions you want the application to support. For more information, see the Microsoft Graph permissions reference.

   a. In Microsoft Azure, navigate to Manage > API permissions.

   b. Click the Microsoft Graph tile.

   c. Select the Delegated or Application permissions that the application supports.
Delegated permissions enable the application to access the API as a signed-in user. Application permissions enable the application to run as a background service or daemon without a signed-in user. You must mention these API permissions in the OAuth Entity scopes tab while configuring the application registry.
Note: You must ensure that these API permissions are provided for your custom app.

<table>
<thead>
<tr>
<th>Name</th>
<th>OAuth scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendars.ReadWrite</td>
<td>Calendars.ReadWrite</td>
</tr>
<tr>
<td>Calendars.ReadWrite.Shared</td>
<td>Calendars.ReadWrite.Shared</td>
</tr>
<tr>
<td>email</td>
<td>email</td>
</tr>
<tr>
<td>Files.Read</td>
<td>Files.Read</td>
</tr>
<tr>
<td>Files.Read.All</td>
<td>Files.Read.All</td>
</tr>
<tr>
<td>offline_access</td>
<td>offline_access</td>
</tr>
</tbody>
</table>

d. Click Add permissions.

What to do next
Register Microsoft OneDrive as OAuth provider.

Register Microsoft OneDrive as OAuth provider
Use the information generated during Microsoft OneDrive account configuration to register Microsoft OneDrive as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Before you begin
• Request IntegrationHub subscription.
• Activate Microsoft OneDrive spoke.
• Create Microsoft OneDrive application.

Role required: admin

Procedure
1. In ServiceNow, navigate to System OAuth > Application Registry.
2. Click New.
3. On the screen titled What kind of OAuth application, select Connect to a third-party OAuth Provider.
4. Enter these values in the Application Registries form:
<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record, for example OneDrive OAuth profile.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Enter the Application ID of the OneDrive application you created in Azure.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Client Secret you generated when you created the application in Azure.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select Authorization Code.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>Click the lock icon, enter <a href="https://login.microsoftonline.com/common/oauth2/v2.0/authorize">https://login.microsoftonline.com/common/oauth2/v2.0/authorize</a>, and then click the lock icon again.</td>
</tr>
<tr>
<td>Token URL</td>
<td>Click the lock icon, enter <a href="https://login.microsoftonline.com/common/oauth2/v2.0/token">https://login.microsoftonline.com/common/oauth2/v2.0/token</a>, and then click the lock icon again.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>Click the lock icon, enter https://&lt;instance&gt;.servicenow.com/oauth_redirect.do, and then click the lock icon again.</td>
</tr>
</tbody>
</table>

5. In the OAuth Entity Scopes related list, add scopes to match the permissions you defined when you configured the Microsoft OneDrive application. Click Insert a new row and enter the name and the OAuth scope of the permission. The name and the OAuth scope are often the same string. Ensure that these scopes are provided.

<table>
<thead>
<tr>
<th>Name</th>
<th>OAuth scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendars.ReadWrite</td>
<td>Calendars.ReadWrite</td>
</tr>
<tr>
<td>Calendars.ReadWrite.Shared</td>
<td>Calendars.ReadWrite.Shared</td>
</tr>
<tr>
<td>email</td>
<td>email</td>
</tr>
<tr>
<td>Files.Read</td>
<td>Files.Read</td>
</tr>
<tr>
<td>Files.Read.All</td>
<td>Files.Read.All</td>
</tr>
<tr>
<td>offline_access</td>
<td>offline_access</td>
</tr>
</tbody>
</table>
**Note:** The scopes mentioned here must be same as the API permissions provided during the custom app configuration.

6. Right-click the form header, and click **Save**.
   The system validates the OAuth credentials.

**What to do next**

**Create Connection and Credential Alias for Microsoft OneDrive spoke**

Create Connection records to your Microsoft OneDrive account. The Microsoft OneDrive spoke connection and credential aliases use these connections to perform actions in the Microsoft OneDrive.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **IntegrationHub > Connections & Credentials > OneDrive**.
2. From **Related Links**, click **Create New Connection & Credential**.
3. On the form, fill in these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Name</td>
<td>Name to identify the connection. This field is automatically set to Microsoft OneDrive Spoke Connection</td>
</tr>
<tr>
<td>Connection URL</td>
<td>The URL to make connection to the spoke. This field is automatically set to <a href="https://graph.microsoft.com">https://graph.microsoft.com</a></td>
</tr>
<tr>
<td>OAuth Entity Name</td>
<td>Name of the OAuth entity profile. This field is automatically set to Microsoft OneDrive Spoke Auth.</td>
</tr>
<tr>
<td>OAuth Client ID</td>
<td>Client ID of the OneDrive application you registered in Microsoft Azure App registration portal.</td>
</tr>
<tr>
<td>OAuth Client Secret</td>
<td>Client Secret generated when you registered the application in Microsoft Azure portal.</td>
</tr>
</tbody>
</table>
Field | Value required
---|---
OAuth Redirect URL | The redirect URL. The format of the URL is https://<your-instance>.service-now.com/oauth_redirect.do

4. Click Create and Get OAuth Token.

Results
The Microsoft OneDrive spoke is set up and integrated with the ServiceNow instance.

Set up a bi-directional webhook
Configure a webhook to subscribe to OneDrive with a ServiceNow callback URL.

Before you begin
- IntegrationHub Professional subscription
- Activate OneDrive v1.6 spoke
- Role required: admin

Register a OneDrive webhook in ServiceNow
Register a OneDrive webhook in ServiceNow to notify the ServiceNow app when certain events occur in OneDrive.

Before you begin
Role required: admin

Procedure
1. Navigate to Microsoft OneDrive Spoke > OneDrive Webhook Registries.
2. Click New.
3. On the form, fill in the fields.

Microsoft OneDrive Webhook Registries

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name to identify the record. For example, OneDrive webhook.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the record.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Path</td>
<td>OneDrive path. By default, this path is set to api/sn_onedrive_spoke/onedrive/subscription</td>
</tr>
<tr>
<td>Secret Key</td>
<td>Secret key for accessing OneDrive webhook.</td>
</tr>
</tbody>
</table>

**Note:** The Secret Key field value is auto-populated when the webhook registry record is saved.

4. Right-click the form header and click **Save**.

5. Click **Callback URL**.
   The system displays the webhook callback URL.

6. Copy and record the webhook callback URL.

**Customize OneDrive bi-directional webhook**

Create a webhook routing policy and subflow according to your requirement.

**Before you begin**

Role required: admin

**About this task**

Routing policies in the OneDrive Webhook Routing Policy module triggers the subflows and notifies the ServiceNow instance when certain events occur in your OneDrive account. See OneDrive spoke for information about the fields that the routing policy and subflows support.

**Procedure**

1. Navigate to **Flow Designer > Designer**.

2. Click **Subflows**.

3. Create a copy of any of the default subflows. For example, Sync Changes.

4. Customize the subflow according to your requirement and publish it. See **Subflows** for more information about creating and using subflows, and **OneDrive spoke v1.6** for information about the supported subflows.

5. Navigate to **Microsoft OneDrive Spoke > OneDrive Webhook Routing Policy**.

6. Click **New**.

7. On the form, fill in the fields.
Decision form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Unique label to identify the routing policy.</td>
</tr>
<tr>
<td>Default answer</td>
<td>Option to specify if this is the default answer. The default answer is applicable when the conditions are not met.</td>
</tr>
<tr>
<td></td>
<td><strong>a.</strong> Click the lookup icon (🔍).</td>
</tr>
<tr>
<td></td>
<td><strong>b.</strong> Select the required subflow from the Document list.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions to be met when the required events occur in OneDrive.</td>
</tr>
<tr>
<td>Answer</td>
<td>Subflow which is triggered when the specified conditions are met.</td>
</tr>
</tbody>
</table>

8. Click **Submit**.

Results
The routing policy and subflow are created.

**Microsoft SCCM spoke**
Automate management of user collections, device collections, and application deployments on a Microsoft System Center Configuration Management (SCCM) server.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see [Request IntegrationHub](#).

**Spoke flows & subflows**
This spoke has no sample flows or subflows.
Spoke actions

The Microsoft System Center Configuration Management (SCCM) spoke provides actions to automate SCCM tasks when events occur in the Now Platform. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Management</td>
<td>Get Applications</td>
<td>Retrieves the application data from the SCCM server.</td>
</tr>
<tr>
<td>Deployment Management</td>
<td>Get Deployments</td>
<td>Retrieves deployment data from the SCCM server.</td>
</tr>
<tr>
<td>Device Management</td>
<td>Add to Device Collection</td>
<td>Adds a device to a collection in SCCM.</td>
</tr>
<tr>
<td></td>
<td>Get Device Collections</td>
<td>Retrieves device collection data from the SCCM server.</td>
</tr>
<tr>
<td></td>
<td>Is Device In Collection</td>
<td>Checks if a specified device exists in a device collection.</td>
</tr>
<tr>
<td></td>
<td>Remove From Device Collection</td>
<td>Removes a device from an existing device collection.</td>
</tr>
<tr>
<td>User Management</td>
<td>Add to User Collection</td>
<td>Adds a user to a collection in SCCM.</td>
</tr>
<tr>
<td></td>
<td>Get User Collections</td>
<td>Retrieves user collection data from the SCCM Server.</td>
</tr>
<tr>
<td></td>
<td>Is User In Collection</td>
<td>Checks if a specified user exists in a user collection.</td>
</tr>
<tr>
<td></td>
<td>Remove From User Collection</td>
<td>Removes a user from a user collection.</td>
</tr>
</tbody>
</table>

To see inputs and outputs for these activities, see SCCM activity pack.

MID server requirements

To use these actions, your instance must have a MID Server set up and configured to use PowerShell. For more information about running actions on the MID Server, see Integration steps. For information, see MID Server.
Connection and credential alias requirements

IntegrationHub uses aliases to manage connection information and OAuth credentials. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you do not need to update any actions that use the connection.

This spoke uses the SCCM alias record to authorize actions on a Microsoft System Center Configuration Management (SCCM) server.

<table>
<thead>
<tr>
<th>Connection alias</th>
<th>Description</th>
<th>Connection URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCCM</td>
<td>Connection to the SCCM server.</td>
<td>The URL of the host machine where the SCCM server is installed.</td>
</tr>
</tbody>
</table>

Set up SCCM spoke

Integrate the ServiceNow instance and SCCM using Windows credentials to authenticate ServiceNow requests.

Before you begin

- Request IntegrationHub subscription
- Role required: admin
- Configure the MID Server for SCCM activities

Create Credential record for the SCCM spoke

Create a Credential record to the SCCM server. The SCCM spoke connection and credential alias uses this credential to authorize actions.

Before you begin

- Request IntegrationHub subscription
- Role required: admin
- Configure the MID Server for SCCM activities

Procedure

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
   A blank Windows Credentials form displays.

4. Enter these values, then click Submit.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter SCCM Credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>User name</td>
<td>Enter a user name with access to the target Windows host. For more information about Windows permissions, see Windows credentials.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password for the account.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

Create Connection record for the SCCM spoke

Create a Connection record to your SCCM host machine. The SCCM spoke connection and credential alias uses this connection to perform actions in SCCM.

Before you begin
- Request IntegrationHub subscription
- Create Credential record for the SCCM spoke
- Role required: admin

Procedure
1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for SCCM.
3. From the Connections tab, click New.
   The system displays a blank Basic Connection form.
4. Enter these values, then click Submit.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter SCCM Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for Windows. For example, select SCCM Credential.</td>
</tr>
<tr>
<td>Host</td>
<td>Enter the fully qualified domain name of the target host where the SCCM server is installed. For example, &lt;host&gt;.&lt;domain&gt;.com.</td>
</tr>
<tr>
<td>Use MiD server</td>
<td>Enable</td>
</tr>
<tr>
<td>Override default port</td>
<td>Enter the target port used by the connection. If blank, the system uses the default port.</td>
</tr>
</tbody>
</table>

**What to do next**

Configure MiD Server as WinRM trusted host

**Microsoft SCCM Usage Metering spoke**

Manage the process of fetching software usage data from a Microsoft System Center Configuration Management (SCCM) Usage Metering server. Get data about software usage metering and when the software was last used using this spoke.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Supported Versions**

This spoke was built for Microsoft SCCM version 1602, but may be compatible with later versions.
Spoke Requirements

- Microsoft System Center Configuration Management Usage Metering Server version 2012 R2 with software metering enabled. For more information about software metering, see Software metering in Configuration Manager

  Note: Ensure that metering rules are configured in SCCM for the required software.

- Microsoft SQL Server 2014

Spoke flows and subflows

This spoke has no flows and subflows.

Spoke actions

The Microsoft SCCM Usage Metering spoke provides actions to retrieve software usage data from a Microsoft System Center Configuration Management Usage Metering server. Available actions include:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Software Last Used Data</td>
<td>Retrieves the last usage data of the required software from the Microsoft SCCM server.</td>
</tr>
<tr>
<td>Get Software Usage Data</td>
<td>Retrieves usage metering of the required software from the Microsoft SCCM server.</td>
</tr>
</tbody>
</table>

Note:

The spoke actions support a maximum payload of 10 MB from the SCCM server for the JDBC step.

Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.
**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record that is associated with the Microsoft SCCM Usage Metering alias to configure where actions run as well as to set MID Server selection attributes. For more information, see MID server.

**Set up the Microsoft SCCM Usage Metering spoke**

Integrate the ServiceNow instance and SCCM using Java Database Connectivity (JDBC) credentials to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription
- Activate the Microsoft SCCM Usage Metering spoke
- Role required: admin

**Create Connection records for the Microsoft SCCM Usage Metering spoke**

Create Connection records to the SCCM server. The SCCM Usage Metering spoke connection and credential aliases use these connections to perform actions in SCCM.

**Procedure**

1. Navigate to **Credentials & Connections > Connections**.
2. Click **New** and select **JDBC Connection**.
3. On the form, fill in the fields.
   The database selection in the **Format** field determines which fields are available.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the JDBC connection. For example, JDBC MySQLProd.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential for the JDBC provider. Enter the user name and password of the database.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with the connection.</td>
</tr>
<tr>
<td>Query timeout</td>
<td>Maximum elapsed time the JDBC query allowed to run without a response.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Connection timeout</td>
<td>Maximum elapsed time for the JDBC activity to wait while attempting to connect to the target database.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to make the connection active.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain for the table. By default, the JDBC Connection [jdbc_connection] table runs in the global domain.</td>
</tr>
<tr>
<td>Format</td>
<td>Database type for the connection. The choices are:</td>
</tr>
<tr>
<td></td>
<td>- MySQL</td>
</tr>
<tr>
<td></td>
<td>- Oracle</td>
</tr>
<tr>
<td></td>
<td>- SQLServer</td>
</tr>
<tr>
<td></td>
<td>- None</td>
</tr>
<tr>
<td>Host</td>
<td>Host name or IP address of the database server.</td>
</tr>
<tr>
<td>Oracle port</td>
<td>Port that the Oracle database is using. The default value is 1521.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available when Oracle is selected from the Format list.</td>
</tr>
<tr>
<td>Oracle sid</td>
<td>Oracle database site identifier. The default value is orcl.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available when Oracle is selected from the Format list.</td>
</tr>
<tr>
<td>Database name</td>
<td>Name of the database.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available when MySQL or SQLServer is selected from the Format list.</td>
</tr>
<tr>
<td>Override default port</td>
<td>Port that the selected database is using.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available when MySQL or SQLServer is selected from the Format list.</td>
</tr>
<tr>
<td>Instance name</td>
<td>Instance name for the selected SQLServer.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available when SQLServer is selected from the Format list.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Connection URL | URL that MID Server uses to connect to the specified database. The URL is created automatically when you save the form, and is read-only for the default databases. For example, `jdbc:<database>://<hostname>;selectMethods=cursor;databaseName=<database_name>`. **Note:** If the format selected is not one of the default databases, you must create the connection URL manually. So that the MID Server can create the connection.
Use MID server | Option to use a MID Server for the action. If selected, define fields in the Advanced MID Server Configuration section.
Capabilities | Capabilities that the MID Server must support to be eligible for selection. Only displays if Use MID server is selected. To learn more about how a MID Server is selected during runtime, see MID Server selection.
MID Application | Application that the MID Server must support to be eligible for selection. Only displays if Use MID server is selected. To learn more about how a MID Server is selected during runtime, see MID Server selection.

## Create Credential records for the Microsoft SCCM Usage Metering spoke
Create Credential records to the SCCM server. The Microsoft SCCM Usage Metering spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
3. Select JDBC Credentials.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the credential.</td>
</tr>
</tbody>
</table>
**Field** | **Description**
--- | ---
Active | Option to use the credentials.
Applies to | Option to verify if the credentials apply to All MID servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use these credentials in the MID servers field.
Order | Order to apply this credential. For example, enter 100.
User name | User name to access the database.
Password | Password to access the database.
Credential alias | Credential alias associated with the spoke.

5. Click **Submit**.

**Microsoft Security Response Center spoke**

Integrate the Microsoft Security Response Center API with your ServiceNow instance to investigate all reports of security vulnerabilities affecting the Microsoft products and services, and gather information to manage security risks and keep the system protected.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Supported versions**

This spoke was built for Microsoft Security Response Center API version 2020, but may be compatible with later versions.
**Spoke dependencies**
If you're having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

ℹ️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke actions**
The Microsoft Security Response Center spoke provides actions to automate tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abuse Management</td>
<td>Submit Abuse Report</td>
<td>Submits report to the Microsoft Computer Emergency Response Team using the Common Abuse Reporting system (CARS).</td>
</tr>
<tr>
<td>Security Management</td>
<td>Get Security Update Details</td>
<td>Retrieves information about the specific CVRF ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Security Updates</td>
<td>Retrieves the list of all Microsoft security updates.</td>
</tr>
<tr>
<td></td>
<td>Look up Security Updates By Key</td>
<td>Retrieves the list of security updates based on the provided ID, CVE, or year.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.
Set up the Microsoft Security Response Center spoke

Integrate the ServiceNow instance and Microsoft Security Response Center account using the API key credentials to authenticate ServiceNow requests.

Before you begin

- Admin access to the Microsoft Security Update API
- Role required: admin

Procedure

1. Log in to the Microsoft Security Update API with admin credentials and copy and record the value of the API key.

2. Create a credential record for the Microsoft Security Response Center spoke in your ServiceNow instance.

   a. Navigate to Connections & Credentials > Credentials.

   b. Click New.

   The system displays the message What type of Credentials would you like to create?.

   c. Select API Key Credentials.

   d. On the form, fill these values.

      | Field   | Value required                                      |
      |---------|-----------------------------------------------------|
      | Name    | Name to uniquely identify the record. For example, enter MSRC Credentials. |
      | Active  | Option to actively use the credential record.       |
      | API Key | API key copied from the Microsoft Security Update API page. |
      | Order   | Select the order to apply this credential. For example, enter 100.   |

   e. Click Submit.

3. Create a connection record for the Microsoft Security Response Center spoke in your ServiceNow instance.

b. Open the record for Microsoft Security Response Center.

c. From the Connections tab, click New.

d. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter MSRC Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Microsoft Security Response Center. For example, select MSRC Credentials.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Connection URL to connect to the Microsoft Security Response Center API. For example, <a href="https://api.msrc.microsoft.com">https://api.msrc.microsoft.com</a>.</td>
</tr>
</tbody>
</table>

e. In the Attributes tab, specify the Microsoft Security Response Center API version in api-version. For example, 2020.

f. Click Submit.

Microsoft SharePoint spoke v2.0.2
Manages sites, folders, files, groups, lists, and users in Microsoft SharePoint. Adds Microsoft SharePoint data to your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.
Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported versions
API version v1.

Spoke flows
The Microsoft SharePoint spoke provides sample flows in the draft state to demonstrate automating Microsoft SharePoint tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Attachment on Record creates folder,</td>
<td>Creates a Microsoft SharePoint folder with an attachment when the attachment is added to a Knowledge article in ServiceNow.</td>
</tr>
<tr>
<td>and copies attachment</td>
<td></td>
</tr>
<tr>
<td>Create Site For Knowledge Base</td>
<td>Creates a Microsoft SharePoint site when a Knowledge Base is created in ServiceNow.</td>
</tr>
</tbody>
</table>

Note:
- If the single sign-on is setup, configure your flows to retrieve the user details from Microsoft SharePoint using the spoke action, Look Up User Information By Login Name, to verify if the user is authorised to perform the required actions.
- Flow designers and action designers must ensure that user authorisation checks are performed, before the flow or action is executed.

Spoke subflows
The Microsoft SharePoint spoke provides sample subflows in the draft state to demonstrate automating Microsoft SharePoint tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:
Remove Then Add A User To A Group

Removes a previous owner from a Microsoft SharePoint group and adds the new owner.

**Note:** Flow designers and action designers must ensure that user authorisation checks are performed, before the flow or action is executed.

### Spoke actions

The Microsoft SharePoint spoke provides actions to automate Microsoft SharePoint tasks when events occur in ServiceNow. The spoke actions use of the three alias records that are available along with the spoke.

These actions use the Sharepoint Online connection and credential alias record:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Management</td>
<td>Create Site</td>
<td>Creates a site or subsite in Microsoft SharePoint.</td>
</tr>
<tr>
<td></td>
<td>Delete Site</td>
<td>Removes a site or subsite from Microsoft SharePoint.</td>
</tr>
<tr>
<td></td>
<td>Look up Changes For Site</td>
<td>Retrieves the changes for a given site based on the query conditions.</td>
</tr>
<tr>
<td></td>
<td>Look Up Site Collection ID</td>
<td>Looks up a specific site ID.</td>
</tr>
<tr>
<td></td>
<td>Look Up Sites</td>
<td>Looks up the sites in a given Microsoft SharePoint site.</td>
</tr>
<tr>
<td></td>
<td>Look Up Subsite Details</td>
<td>Looks up information about a subsite.</td>
</tr>
<tr>
<td></td>
<td>Update Site Information</td>
<td>Updates a Microsoft SharePoint site.</td>
</tr>
<tr>
<td>Folder Management</td>
<td>Create Folder</td>
<td>Creates a folder in a document library on a Microsoft SharePoint site.</td>
</tr>
<tr>
<td></td>
<td>Delete Folder</td>
<td>Deletes a folder in Microsoft SharePoint.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>List Files In A Folder</td>
<td>Gets a list of files in a folder.</td>
</tr>
<tr>
<td></td>
<td>List Folders In A Folder</td>
<td>Gets a list of folders in a folder.</td>
</tr>
<tr>
<td></td>
<td>Look Up Folder</td>
<td>Looks up a folder in Microsoft SharePoint and returns folder properties. For example, use this action to return the relative URL to enter as input in the Rename A Folder action.</td>
</tr>
<tr>
<td></td>
<td>Rename A Folder</td>
<td>Renames a folder in Microsoft SharePoint.</td>
</tr>
<tr>
<td></td>
<td>Share Folder With Group</td>
<td>Shares a folder with a group in Microsoft SharePoint. The group must belong to the Microsoft SharePoint tenant account.</td>
</tr>
<tr>
<td></td>
<td>Share Folder With User</td>
<td>Shares a folder with a user in Microsoft SharePoint. The user must belong to the Microsoft SharePoint tenant account.</td>
</tr>
<tr>
<td></td>
<td>Unshare Folder With Group</td>
<td>Unshares a folder with a group. The group must belong to the Microsoft SharePoint tenant account.</td>
</tr>
<tr>
<td></td>
<td>Unshare Folder With User</td>
<td>Unshares a folder with a user. The user must belong to the Microsoft SharePoint tenant account.</td>
</tr>
<tr>
<td>File Management</td>
<td>Attach Sharepoint File To A Record</td>
<td>Attaches a Microsoft SharePoint file to a ServiceNow record.</td>
</tr>
<tr>
<td></td>
<td>Check-in File</td>
<td>Checks in a file to Microsoft SharePoint using the Application Service user.</td>
</tr>
<tr>
<td></td>
<td>Check-out File</td>
<td>Checks a file out of Microsoft SharePoint using the Application Service user.</td>
</tr>
<tr>
<td></td>
<td>Copy Attachment To Folder</td>
<td>Copies a ServiceNow attachment to a Microsoft SharePoint folder.</td>
</tr>
<tr>
<td></td>
<td>Copy File</td>
<td>Copies a file with a new name.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Create A Text File</td>
<td>Uploads a text file to Microsoft SharePoint.</td>
</tr>
<tr>
<td></td>
<td>Delete File</td>
<td>Deletes a file in Microsoft SharePoint.</td>
</tr>
<tr>
<td></td>
<td>Look Up File Details</td>
<td>Looks up file details in Microsoft SharePoint.</td>
</tr>
<tr>
<td></td>
<td>Move File</td>
<td>Moves a file to another location in Microsoft SharePoint.</td>
</tr>
<tr>
<td></td>
<td>Share File With Group</td>
<td>Shares a file with a group in Microsoft SharePoint. The group must belong to the Microsoft SharePoint tenant account.</td>
</tr>
<tr>
<td></td>
<td>Share File With User</td>
<td>Shares a file with a Microsoft SharePoint user. The user must belong to the Microsoft SharePoint tenant account.</td>
</tr>
<tr>
<td></td>
<td>Unshare File With Group</td>
<td>Unshares a file with a Microsoft SharePoint group. The group must belong to the Microsoft SharePoint tenant account.</td>
</tr>
<tr>
<td></td>
<td>Unshare File With User</td>
<td>Unshares a file with a Microsoft SharePoint user. The user must belong to the Microsoft SharePoint tenant account.</td>
</tr>
<tr>
<td>User Management</td>
<td>Look Up User Information By Login Name</td>
<td>Searches the Microsoft SharePoint site for a given user and returns information about the user account.</td>
</tr>
<tr>
<td></td>
<td>Look Up User's Sharepoint Groups</td>
<td>Searches the Microsoft SharePoint site for a given user and returns the user's Microsoft SharePoint groups regardless of which site or subsite the group is a part of.</td>
</tr>
<tr>
<td>Group Management</td>
<td>Add Role To Site</td>
<td>Adds a role to a Microsoft SharePoint site.</td>
</tr>
<tr>
<td></td>
<td>Add User To Group</td>
<td>Adds a User to a Microsoft SharePoint site group.</td>
</tr>
<tr>
<td></td>
<td>Create Group</td>
<td>Creates a group in a Microsoft SharePoint site.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Delete Group</td>
<td>Delete Group</td>
<td>Deletes a group on a Microsoft SharePoint site.</td>
</tr>
<tr>
<td>Look Up Group By</td>
<td>Look Up Group By Name</td>
<td>Looks up a group by name in the specified site location. If no site location is specified, the spoke searches the tenant root site.</td>
</tr>
<tr>
<td>Remove Role From</td>
<td>Remove Role From Site</td>
<td>Removes permissions from a group or user.</td>
</tr>
<tr>
<td>Remove User From</td>
<td>Remove User From Group</td>
<td>Removes a user from a Microsoft SharePoint site group.</td>
</tr>
<tr>
<td>Update</td>
<td>Update Group Owner (User)</td>
<td>Updates a group owner.</td>
</tr>
<tr>
<td>List Management</td>
<td>Create List Item</td>
<td>Creates a list item in a list.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete List By ID</td>
<td>Deletes a list in a Microsoft SharePoint site.</td>
</tr>
<tr>
<td>Look Up List</td>
<td>Look Up List Item By ID</td>
<td>Retrieves a list item with both the List ID and List Item ID.</td>
</tr>
<tr>
<td>Items In A List</td>
<td>Look Up List Items In A List</td>
<td>Retrieves a list of items in the specified list in various useful formats.</td>
</tr>
<tr>
<td>Update</td>
<td>Update List Item By ID</td>
<td>Updates the list item title with the specified ID.</td>
</tr>
<tr>
<td>List Item</td>
<td>Create List</td>
<td>Creates list in a site with the specified title and description.</td>
</tr>
<tr>
<td>Management</td>
<td>Look Up List Details By ID</td>
<td>Retrieves details of the specified list in a site.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete List By ID</td>
<td>Deletes the specified list in a site.</td>
</tr>
</tbody>
</table>
### Look Up List ID By Title
Retrieves details of the specified list in a site, based on the list title.

### Renew List Subscription
Renews a webhook subscription for a list.

### Update List Details
Updates details of the specified list.

**Note:** Flow designers and action designers must ensure that user authorisation checks are performed, before the flow or action is executed.

These actions use the SharePoint Graph connection and credential alias record:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management</td>
<td>Get Change Query Properties</td>
<td>Retrieves the change query properties which are used to define a query that is performed against the change log.</td>
</tr>
<tr>
<td></td>
<td>Get Delta Link Token For Drive</td>
<td>Retrieves the latest delta link token for a drive.</td>
</tr>
<tr>
<td></td>
<td>Get Next Token</td>
<td>Retrieves the next link token from the SharePoint Resource Next Link Token table.</td>
</tr>
<tr>
<td>File Management</td>
<td>Get File Download Link</td>
<td>Retrieves the download URL of the file from SharePoint.</td>
</tr>
<tr>
<td></td>
<td>Look up Files</td>
<td>Retrieves all the files in a drive.</td>
</tr>
<tr>
<td>List Management</td>
<td>Create List Subscription</td>
<td>Creates a webhook subscription for a list.</td>
</tr>
<tr>
<td></td>
<td>Delete List Subscription</td>
<td>Deletes the webhook subscription for a list.</td>
</tr>
<tr>
<td></td>
<td>Get List</td>
<td>Retrieves the details of a list from SharePoint tenant.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Look up Drives</td>
<td></td>
<td>Retrieves all the drives for a site.</td>
</tr>
<tr>
<td>Site Management</td>
<td>Get Site</td>
<td>Retrieves details of the required site.</td>
</tr>
<tr>
<td></td>
<td>Look up Site Collections</td>
<td>Retrieves all the site collections.</td>
</tr>
<tr>
<td></td>
<td>Look up Subsites</td>
<td>Retrieves details of all the subsites in a site.</td>
</tr>
</tbody>
</table>

The Create Root Site Subscription action uses the SharePoint Graph Root Site Subscription connection and credential alias record. The action can be used to create a webhook subscription for root site.

**SharePoint Online account requirements**

The Microsoft SharePoint spoke requires creating a custom app on your SharePoint Online account to generate OAuth 2.0 tokens. See Configure Microsoft SharePoint account.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**Single tenant**

This spoke includes the MicrosoftSharepointOnline alias record to authorize actions on Microsoft Sharepoint Online. Select this alias in the Tenant record to authorize changes in Microsoft SharePoint for a single tenant.

**Multiple tenants**

This spoke includes the MicrosoftSharepointOnline alias record to authorize actions on Microsoft Sharepoint Online. Create a connection and credential alias record for each additional tenant site you wish to support. Select the correct alias in the Tenant record to authorize changes in Microsoft SharePoint. See Create aliases for multiple tenants.
**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the MicrosoftSharepointOnline alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

**Configure Microsoft SharePoint account**

Create a custom OAuth application from your Microsoft SharePoint online or onprem accounts to enable OAuth 2.0 authentication with the Microsoft SharePoint spoke.

**About this task**

- If you want to set up the integration using tenant permissions, see Configure Microsoft SharePoint account with tenant permissions.

- If you want to set up the integration using site collection permissions, see Configure Microsoft SharePoint account with site collection permissions.

After configuring the Microsoft SharePoint account, perform the other spoke setup tasks.

**Configure Microsoft SharePoint account with tenant permissions**

Create a custom OAuth application from your Microsoft SharePoint online or onprem accounts to enable OAuth 2.0 authentication with tenant permissions.

**Before you begin**

Microsoft SharePoint requirements:

- Microsoft SharePoint Online account or Microsoft SharePoint Onprem account
- Microsoft SharePoint tenant administrator credentials

**About this task**

Complete these steps from your Microsoft SharePoint account. See the SharePoint development documentation for instructions on creating and configuring custom applications.

**Procedure**

1. Select Microsoft SharePoint Online account or Microsoft SharePoint Onprem account.

   - For SharePoint Online account, work with your Azure AD administrator to retrieve the Directory ID for the Azure AD Directory that is supporting the Microsoft SharePoint tenant you want to connect to. Record the Directory ID
to use as the Tenant ID when creating a Tenant record in your ServiceNow instance.

- For SharePoint Onprem account, download and run the Hybrid Configuration wizard from the Admin Center. For more information, see Hybrid Configuration wizard.

2. Log in the Azure AD portal as a global administrator.

3. Navigate to **Azure Active Directory** > **Overview**. Record the value of the **Tenant ID**.

4. Identify the root URL for your Microsoft SharePoint tenant. For example, 
   https://<site-name>.sharepoint.com

5. Create an application add-in or app that the Microsoft SharePoint can use to identify the integration connection from the ServiceNow instance.

   a. Open a new tab in your browser and navigate to: https://<site-name>/sharepoint.com/_layouts/15/appregnew.aspx. Replace <site-name> with the site name you had identified earlier.

   b. Fill these details:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Unique client ID. Click <strong>Generate</strong> to generate a unique client ID.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Unique client secret. Click <strong>Generate</strong> to generate a unique client secret.</td>
</tr>
<tr>
<td>Title</td>
<td>Name to identify the app.</td>
</tr>
<tr>
<td>App Domain</td>
<td>ServiceNow domain URL.</td>
</tr>
<tr>
<td>Redirect URI</td>
<td>ServiceNow instance redirect URL.</td>
</tr>
</tbody>
</table>
c. Record the application client ID and client secret to register the app as a third-party OAuth provider on your ServiceNow instance.

6. Provide required permissions to the app.


b. In **AppId**, provide the value of the client ID and click **Lookup**. Values in the other fields are auto-populated.

c. In **Permissions**, enter this XML.

```xml
<AppPermissionRequests AllowAppOnlyPolicy="true">
  <AppPermissionRequest
    Scope="http://sharepoint/content/tenant"
    Right="FullControl" />
</AppPermissionRequests>
```
d. Click Trust It.

7. To use the Graph and Graph Root Site Subscription alias records that are available along with the spoke, perform these configurations:

a. In the Azure AD portal, navigate to App Registrations.

b. In the All Applications tab or Owned Applications tab, identify and open the app you had created.

c. Under Authentication, provide the ServiceNow redirect URL in the Web section. Enter https://<servicenow-instance>/oauth_redirect.do and click Save.

d. Under API Permissions, perform these:
   i. Click Add a permission.
   ii. Select Microsoft Graph.
   iii. Select Delegated Permissions.
   iv. Select the Sites.ReadWrite.All permission from the Sites list and User.Read permission from the Users list.
Configure Microsoft SharePoint account with site collection permissions

Create a custom OAuth application from your Microsoft SharePoint online or onprem accounts to enable OAuth 2.0 authentication with site collection permissions.

Before you begin
Microsoft SharePoint requirements:

- Microsoft SharePoint Online account or Microsoft SharePoint Onprem account
- Microsoft SharePoint site collection administrator credentials

About this task
Complete these steps from your Microsoft SharePoint account. See the SharePoint development documentation for instructions on creating and configuring custom applications.

Procedure

1. Select Microsoft SharePoint Online account or Microsoft SharePoint Onprem account.
   - For SharePoint Online account, work with your Azure AD administrator to retrieve the Directory ID for the Azure AD Directory that is supporting the Microsoft SharePoint tenant you want to connect to. Record the Directory ID to use as the Tenant ID when creating a Tenant record in your ServiceNow instance.
   - For SharePoint Onprem account, download and run the Hybrid Configuration wizard from the Admin Center. For more information, see Hybrid Configuration wizard.

2. Log in to the Azure AD portal as a global administrator.

3. Navigate to Azure Active Directory > Overview. Record the value of the Tenant ID.

4. Identify the root URL for your Microsoft SharePoint tenant. For example, https://<site-name>.sharepoint.com

5. Create an application addin or app that the Microsoft SharePoint can use to identify the integration connection from the ServiceNow instance.

   a. Open a new tab in your browser and navigate to: https://<site-name>.sharepoint.com/sites/<site-collection-name>/_layouts/15/appregnew.aspx. Replace <site-name> with the site name you had identified earlier.
b. Fill these details:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Unique client ID. Click Generate to generate a unique client ID.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Unique client secret. Click Generate to generate a unique client secret.</td>
</tr>
<tr>
<td>Title</td>
<td>Name to identify the app.</td>
</tr>
<tr>
<td>App Domain</td>
<td>ServiceNow domain URL.</td>
</tr>
<tr>
<td>Redirect URI</td>
<td>ServiceNow instance redirect URL.</td>
</tr>
</tbody>
</table>

c. Click Create.

d. Record the application client ID and client secret to register the app as a third-party OAuth provider on your ServiceNow instance.

6. Provide required permissions to the app.


b. In Appld, provide the value of the client ID and click Lookup. Values in the other fields are auto-populated.

c. In Permissions, enter this XML.
<AppPermissionRequests AllowAppOnlyPolicy="true">
  <AppPermissionRequest Scope="http://sharepoint/content/sitecollection"
      Right="FullControl" />
</AppPermissionRequests>
d. Click **Trust It**.

7. To use the Graph and Graph Root Site Subscription alias records that are available along with the spoke, perform these configurations:

**a. In the Azure AD portal, navigate to App Registrations.**

**b. In the All Applications tab or Owned Applications tab, identify and open the app you had created.**

**c. Under Authentication, provide the ServiceNow redirect URL in the Web section.** Enter **https://<servicenow-instance>/oauth_redirect.do** and click **Save**.

**d. Under API Permissions, perform these:**

  i. Click **Add a permission**.

  ii. Select **Microsoft Graph**.

  iii. Select **Delegated Permissions**.

  iv. Select the **Sites.ReadWrite.All** permission from the **Sites** list and **User.Read** permission from the **Users** list.
Create aliases for multiple tenants

Create a connection and credential alias record for each additional tenant site you wish to support. Select the correct alias in the Tenant record to authorize changes in Microsoft SharePoint. If configuring an integration for a single tenant, use the existing MicrosoftSharepointOnline alias record.

Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.

2. Click New.

A blank Connection & Credential Alias record opens

3. On the Connection & Credential Aliases form, fill the following values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>&lt;unique-name&gt;</td>
</tr>
<tr>
<td>Type</td>
<td>Connection and Credential</td>
</tr>
<tr>
<td>Connection type</td>
<td>HTTP</td>
</tr>
</tbody>
</table>

4. Click Submit.

What to do next

Associate a Credential record and a Connection record with the alias to authorize actions on the SharePoint tenant site. Create an alias record and associated connection and credential records for each tenant you want to support.

Define Microsoft SharePoint tenants

Define a profile for your Microsoft SharePoint tenant site. The Microsoft SharePoint spoke uses the tenant record and associated Connection and Credential alias to perform actions on Microsoft SharePoint.

Procedure

1. Navigate to Microsoft SharePoint Online > Tenants.

2. Click New.

3. Complete the form.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the tenant.</td>
</tr>
<tr>
<td>Alias</td>
<td>Select a connection and credential alias. If configuring the integration for a single tenant, select the <strong>MicrosoftSharepointOnline</strong> alias. If configuring the integration for multiple tenants, select the desired alias.</td>
</tr>
<tr>
<td>Sharepoint Root URL</td>
<td>Enter the root SharePoint URL without the https:// prefix. For example, <code>&lt;SiteName&gt;.sharepoint.com</code></td>
</tr>
<tr>
<td>Tenant Id</td>
<td>Enter the Tenant ID. This is the Directory ID for the Azure AD Directory that is supporting the Microsoft SharePoint tenant you want to connect to. See <a href="#">Configure Microsoft SharePoint account</a>.</td>
</tr>
<tr>
<td>Resource Id</td>
<td>Auto-populated with <code>00000003-0000-0ff1-ce00-000000000000</code>.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**What to do next**
If configuring an integration with multiple Microsoft SharePoint tenants, create additional tenant profiles as needed.

Configure the SharePoint Online connection and credential alias record
Integrate the ServiceNow instance and Microsoft SharePoint by creating a custom OAuth application in Microsoft SharePoint to authenticate ServiceNow requests.

**Before you begin**
- Request IntegrationHub subscription
- Activate Microsoft SharePoint spoke
- Role required: admin

**Register Microsoft SharePoint as OAuth provider**
Use the information generated during Microsoft SharePoint account configuration to register Microsoft SharePoint as an OAuth provider and allow the instance to request OAuth 2.0 tokens.
Procedure

1. Navigate to System OAuth > Application Registry.

2. Click New.
   The system displays the message What kind of OAuth application?

3. Select Connect to a third party OAuth Provider.
   The system displays a blank Application Registries form.

4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter SharePoint OAuth profile.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID in this format: &lt;ClientID&gt;@&lt;TenantID&gt;.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret you created during the Microsoft SharePoint account configuration.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Select OAuthUtilSPOnline.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select Client Credentials.</td>
</tr>
<tr>
<td>Token URL</td>
<td>Token URL in this format: <a href="https://accounts.accesscontrol.windows.net/">https://accounts.accesscontrol.windows.net/</a>&lt;TenantID&gt;/tokens/OAuth/2. Replace &lt;TenantID&gt; with your Tenant ID.</td>
</tr>
</tbody>
</table>

5. Right-click the form header, and click Save.
   The system validates the OAuth credentials and populates the Redirect URL and the OAuth Entity Profiles related list.

6. Copy the value from Redirect URL.

7. Login to your Microsoft SharePoint account to edit the configuration of your custom SharePoint application.
   For information on how to configure your custom SharePoint application, see Configure Microsoft SharePoint account.

8. Paste the Redirect URL value into the OAuth 2.0 Redirect URI for your custom Microsoft SharePoint application.

Example
   For example, paste https://instance.service-now.com/oauth_redirect.do.
Results
The instance can request OAuth 2.0 tokens for the spoke.

Create Credential records for the Microsoft SharePoint spoke
Create Credential records to the Microsoft SharePoint custom OAuth application you created during Microsoft SharePoint account configuration. The Microsoft SharePoint spoke connection and credential aliases use these credentials to authorize actions.

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?.
3. Select OAuth 2.0 Credentials.
   The pop-up window displays a blank OAuth 2.0 Credentials form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter SharePoint Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Select the OAuth profile you created when you registered the custom Microsoft SharePoint application as an OAuth provider. For example, select SharePoint OAuth profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Save the record.
6. From Related Links, click Get OAuth Token.
   The system displays a confirmation message that the OAuth token flow is completed successfully. Review the details if the flow is not completed successfully.

⚠️ Note: Ensure that you allow pop-up windows in your browser.
Create Connection records for the Microsoft SharePoint spoke

Create Connection records to your Microsoft SharePoint account. The Microsoft SharePoint spoke connection and credential alias uses these connections to perform actions on Microsoft SharePoint.

Procedure

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open the connection and credential alias used in the Tenant record. See Define Microsoft SharePoint tenants and Create aliases for multiple tenants.
3. From the **Connections** tab, click **New**.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter <strong>SharePoint Connection</strong>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for Microsoft SharePoint. For example, select <strong>SharePoint Credentials</strong>.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Select the Connection alias record you created for Microsoft SharePoint.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Enter the root SharePoint URL. For example, https://&lt;SiteName&gt;.sharepoint.com.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.
   The Microsoft SharePoint account is integrated with your ServiceNow instance and the spoke is ready to be used.

⚠️ **Note:** If the single sign-on is setup, configure your flows to retrieve the user details from Microsoft SharePoint using the spoke action, Look Up User Information By Login Name, to verify if the user is authorised to perform the required actions.

Configure the SharePoint Graph connection and credential alias record

Integrate the ServiceNow instance and Microsoft SharePoint by creating a custom OAuth application in Microsoft SharePoint to authenticate ServiceNow requests.
Before you begin

- Request IntegrationHub subscription
- Activate Microsoft SharePoint spoke
- Role required: admin

Procedure

1. Navigate to Connections & Credentials > Connections & Credential Aliases.
2. Open the record, MicrosoftSharePointGraph.
3. Click the Create New Connection & Credential related link.
4. On the form, fill these details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OAuth Entity Name</td>
<td>Name to identify the OAuth application registry record.</td>
</tr>
<tr>
<td>OAuth Client ID</td>
<td>Client ID in this format: &lt;ClientID&gt;@&lt;TenantID&gt;.</td>
</tr>
<tr>
<td>OAuth Client Secret</td>
<td>Client Secret you created during the Microsoft SharePoint account configuration.</td>
</tr>
<tr>
<td>OAuth Token URL</td>
<td>Token URL in this format: <a href="https://login.microsoftonline.com/">https://login.microsoftonline.com/</a>&lt;tenant-id&gt;/oauth2/v2.0/token</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>Token revocation URL in this format: <a href="https://login.microsoftonline.com/">https://login.microsoftonline.com/</a> &lt;tenant-id&gt;/oauth2/v2.0/token.</td>
</tr>
<tr>
<td>OAuth Redirect URL</td>
<td>ServiceNow redirect URL in this format: <a href="https://empipaas.servicenow.com/oauth_redirect.do">https://empipaas.servicenow.com/oauth_redirect.do</a></td>
</tr>
</tbody>
</table>

Note: You may change default values as per your requirement.

5. Click Create and Get OAuth Token.
Configure the SharePoint Graph Root Site Subscription connection and credential alias record

Integrate the ServiceNow instance and Microsoft SharePoint by creating a custom OAuth application in Microsoft SharePoint to authenticate ServiceNow requests.

Before you begin

- Request IntegrationHub subscription
- Activate Microsoft SharePoint spoke
- Role required: admin

Procedure

1. Navigate to Connections & Credentials > Connections & Credential Aliases.
2. Open the record, SharePointGraphRootSiteSubscription.
3. Click the Create New Connection & Credential related link.
4. On the form, fill these details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OAuth Entity Name</td>
<td>Name to identify the OAuth application registry record.</td>
</tr>
<tr>
<td>OAuth Client ID</td>
<td>Client ID in this format: &lt;ClientID&gt;@&lt;TenantID&gt;.</td>
</tr>
<tr>
<td>OAuth Client Secret</td>
<td>Client Secret you created during the Microsoft SharePoint account configuration.</td>
</tr>
<tr>
<td>OAuth Token URL</td>
<td>Token URL in this format: <a href="https://login.microsoftonline.com/">https://login.microsoftonline.com/</a>&lt;tenant-id&gt;/oauth2/v2.0/token</td>
</tr>
</tbody>
</table>

Note: You may change default values as per your requirement.

5. Click Create and Get OAuth Token.

Microsoft Teams spoke

The Microsoft Teams spoke provides actions which post messages and ServiceNow incident, problem, and change record details to Microsoft Teams channels.
IntegrationHub subscription
This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Microsoft Teams actions
The Microsoft Teams spoke is an available integration through IntegrationHub. You can specify the following Microsoft Teams actions within a flow:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post a Message</td>
<td>Send a message to a Microsoft Teams channel using a Webhook Connector. Specify the Webhook URL, Title, and Message to send.</td>
</tr>
<tr>
<td>Post Change Details</td>
<td>Send details about a ServiceNow change record to a Microsoft Teams channel using a Webhook Connector. Specify the Webhook URL and Change record to send.</td>
</tr>
<tr>
<td>Post Incident Details</td>
<td>Send details about a ServiceNow incident record to a Microsoft Teams channel using a Webhook Connector. Specify the Webhook URL and Incident record to send.</td>
</tr>
<tr>
<td>Post Problem Details</td>
<td>Send details about a ServiceNow problem record to a Microsoft Teams channel using a Webhook Connector. Specify the Webhook URL and Problem record to send.</td>
</tr>
</tbody>
</table>

Microsoft Teams Inputs
The following inputs are common to the Microsoft Teams actions:

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Required] Webhook URL</td>
<td>The Microsoft Teams webhook for sending a message. Set up the webhook before configuring this</td>
</tr>
</tbody>
</table>
(continued)

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>action. Refer to the custom incoming</td>
<td>webhook for Microsoft Teams documentation.</td>
</tr>
<tr>
<td>[Optional] Title</td>
<td>Title of the message.</td>
</tr>
<tr>
<td>[Optional] Additional Message</td>
<td>Add a message before the record details.</td>
</tr>
<tr>
<td>[Optional] Override Default Fields</td>
<td>You can provide a comma-separated list of field names to send instead of the default fields. Default fields are Short Description, Category, State, Priority, and Assignment Group.</td>
</tr>
<tr>
<td>[Optional] Theme Color (Hex)</td>
<td>Hex code value of color to highlight the message.</td>
</tr>
</tbody>
</table>

**Example**
You can add a Microsoft Teams Post Incident Details action to a flow which identifies newly created high priority incidents and a specified theme color.
Microsoft Teams Communications spoke v1.1.1

Manage groups calls and meetings in Microsoft Teams Communications account from your ServiceNow instance.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Supported versions

This spoke was built for Microsoft Teams Communications API version v1 and beta version, but may be compatible with later versions.
Note: The Create Online Meeting and Mute Participants spoke actions use the beta API version. All the remaining actions use the API version v1.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Microsoft Teams Communications spoke provides actions to automate tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Management</td>
<td>Delete Group Call</td>
<td>Deletes the specified active group call.</td>
</tr>
<tr>
<td></td>
<td>Get Group Call Details</td>
<td>Retrieves details of the specified active group call.</td>
</tr>
<tr>
<td></td>
<td>Get Group Call Participant Details</td>
<td>Retrieves the properties and relationships of a participant object or list of participant objects from Microsoft Graph API.</td>
</tr>
<tr>
<td></td>
<td>Invite Participants to Group Call</td>
<td>Invites participants to the specified active group call.</td>
</tr>
<tr>
<td></td>
<td>Keep Group Call Alive</td>
<td>Keeps a group call alive if the keep alive request is made within 45 minutes of the previous request. If the request is not made within 45 minutes, the group call is considered as an inactive call.</td>
</tr>
<tr>
<td></td>
<td>Mute Participants in Group Call</td>
<td>Mutes one or more participants in an active group call.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Start Group Call</td>
<td>Initiates a group call.</td>
</tr>
<tr>
<td>Meeting Management</td>
<td>Create Online Meeting</td>
<td>Creates an online meeting using the Microsoft Graph API.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

**Set up the Microsoft Teams Communications spoke**

Integrate the ServiceNow instance and Microsoft Teams Communications account by creating a custom OAuth application in Microsoft Teams Communications to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub subscription.
- Activate Microsoft Teams Communications spoke.
- Role required: admin

**Register a custom application using the Microsoft Azure portal**

Provide authorization to the ServiceNow instance by registering a custom application with Azure AD.

**Before you begin**

- Admin access to Microsoft Teams App Studio
- Role required: Azure Active Directory admin
Procedure

1. Create a custom app in the App Studio. For more information about creating the app, see Tutorial: Extend to Microsoft Teams in the Bot Framework Solutions Documentation site.

2. Create a bot and configure it as per your requirement. For more information about creating and setting up the bot, see Create your app manifest and package in Microsoft Teams admin documentation.
   Update bot endpoint address to point to your bot.

3. Log in the Microsoft Azure portal.

4. From App Registrations, open your custom app.

5. Copy and record the value of Application (client) ID and Directory (tenant) ID.

6. Create a client secret and record the value of Client Secret for use in later configurations. For more information, see the Option 2: Create a new application secret section in Microsoft Docs.

7. Ensure that these permissions are provided to your custom app:
   - User.ReadWrite.All
   - OnlineMeetings.ReadWrite
   - Calls.AccessMedia.All
   - Calls.InitiateGroupCall.All
   - Calls.JoinGroupCall.All
   For more information about the API permissions, see Add permissions to access your web API in Microsoft Docs.

Register Microsoft Teams Communications as an OAuth provider

Use the information generated during the application configuration in Microsoft Azure portal to register Microsoft Teams Communications as the OAuth provider so that the ServiceNow instance can request OAuth 2.0 tokens.

Procedure

1. Navigate to System OAuth > Application Registry.

2. Click New.
   The system displays this message: What kind of OAuth application?.

3. Select Connect to a third party OAuth Provider.

4. On the form, fill these values.
## Application Registries form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Application ID created during application registration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client secret created during application registration.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>OAuth server token revocation endpoint.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Grant type used to establish the token. Select <strong>Client Credentials</strong>.</td>
</tr>
</tbody>
</table>

5. Right-click the form header, and click **Save**.

6. In the **OAuth Entity Profiles** tab, insert a row and fill these values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to identify the entity profile record. For example, <strong>MS Teams Comm OAuth Prof</strong>.</td>
</tr>
<tr>
<td>Is default</td>
<td>Specifies if the record is the default entity profile.</td>
</tr>
<tr>
<td>Grant type</td>
<td>Grant type used to establish the token. Select <strong>Client Credentials</strong>.</td>
</tr>
</tbody>
</table>

7. In the **OAuth Entity Scopes** tab, insert a row and fill these values:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, MS Teams Comm Cred.</td>
</tr>
<tr>
<td>OAuth scope</td>
<td>OAuth entity scope. Enter .default.</td>
</tr>
</tbody>
</table>

8. Right-click the form header, and click **Save**.

9. In the **OAuth Entity Profiles** tab, open the entity profile record you had created.

10. In the **OAuth Entity Scopes** tab, insert a record.

11. Search and select the OAuth entity scope you had created.

12. Click **Update**.

**Create a credential record for the Microsoft Teams Communications**

Authorize the Microsoft Teams Communications spoke actions by creating credential records for the application registered in the Microsoft Azure portal. The Microsoft Teams Communications connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to **Connections & Credentials > Connections & Credentials Aliases**.
2. Open the alias record, **MSTeamsCommunicationsSpoke**.
3. From the **Credentials** tab, click **New**.
   
The system displays this message: **What type of Credentials would you like to create?**
4. Select **OAuth 2.0 Credentials**.

5. On the form, fill in the fields.

**OAuth 2.0 Credentials form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, MS Teams Comm Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
</tbody>
</table>
6. Right-click the form header and click Submit.

7. To generate the OAuth token, click the Get OAuth Token related link.

**Microsoft Teams Graph spoke v3.4.0**

The Microsoft Teams Graph spoke creates and manages teams and channels in Microsoft Teams. To create, manage, or delete users and groups, use the Microsoft Azure AD spoke.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**Note:**

- Teams in the Microsoft Teams Graph spoke are created from the groups in Microsoft Azure AD. To create a team using the Microsoft Teams Graph spoke, the associated group must be present in Microsoft Azure AD.
- User and group management can be done using Microsoft Azure AD only and not Microsoft Teams Graph spoke.
- Teams can be created from the Microsoft Office 365 group only.
- The team ID in Microsoft Teams is the same as the group ID of the associated group in Microsoft Azure AD.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

**Supported version**

Microsoft Graph REST API v1.0 and Beta API

**Note:** The Notification Management actions use Beta API.
**Spoke actions**
The Microsoft Teams Graph spoke provides actions to automate team and channel tasks when an incident is created in the ServiceNow instance.

### Microsoft Teams Graph spoke actions

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Team Management</td>
<td>Create Team</td>
<td>Creates a team from an existing Microsoft Office 365 group.</td>
</tr>
<tr>
<td></td>
<td>Update Team</td>
<td>Updates the properties of a team.</td>
</tr>
<tr>
<td></td>
<td>Get Team</td>
<td>Retrieves the properties and relationships of a team.</td>
</tr>
<tr>
<td></td>
<td>Archive Team</td>
<td>Archives a team. Members cannot send messages on the channels of the team. However, members can be added to the group and can search the team content.</td>
</tr>
<tr>
<td></td>
<td>List Teams</td>
<td>Lists teams the specified user is part of.</td>
</tr>
<tr>
<td></td>
<td>Unarchive Team</td>
<td>Restores an archived team. Members can send messages on the channels of the team.</td>
</tr>
<tr>
<td>Channel Management</td>
<td>Create Channel in a Team</td>
<td>Creates a channel in a team.</td>
</tr>
<tr>
<td></td>
<td>Get Channel Metadata</td>
<td>Retrieves the properties and relationships of a channel.</td>
</tr>
<tr>
<td></td>
<td>Get Messages From Channel</td>
<td>Retrieves the list of messages in a channel of a team.</td>
</tr>
</tbody>
</table>
### Microsoft Teams Graph spoke actions (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat Management</td>
<td>Get Messages From Chat</td>
<td>Retrieves the list of messages in a chat.</td>
</tr>
<tr>
<td></td>
<td>Look up Chats</td>
<td>Retrieves the list of chats of a user.</td>
</tr>
<tr>
<td>Notification Management</td>
<td>Post Change Details</td>
<td>Posts details of the required change to a channel.</td>
</tr>
<tr>
<td></td>
<td>Post Incident Details</td>
<td>Posts details of the required incident to a channel.</td>
</tr>
<tr>
<td></td>
<td>Post Message</td>
<td>Posts message to a channel.</td>
</tr>
<tr>
<td></td>
<td>Post Problem Details</td>
<td>Posts details of the required problem to a channel.</td>
</tr>
<tr>
<td>Application Management</td>
<td>Get User App Installation</td>
<td>Verifies if the specific application is installed for the given user and retrieves the installation status.</td>
</tr>
</tbody>
</table>

**Note:**
Currently, these actions use Beta API. Hence, when you create the connection record, `api_version` in the Attributes tab is set to `beta` by default.

When Microsoft Teams supports these actions in another API version, you must update `api_version` in the Attributes tab and specify the new API version to use these actions.
**Microsoft Teams Graph spoke actions (continued)**

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Install Application to User</td>
<td>Installs the specified application for the given user and retrieves the installation status.</td>
</tr>
</tbody>
</table>

**Note:** Some of the spoke actions require the channel ID, group ID, or team ID as one of the inputs. To learn these details, log in to Microsoft Teams, navigate to **Teams**, and click **Get link to channel** for the required channel. The channel link contains the required details. For example, if the channel link is https://teams.microsoft.com/l/channel/19%3a1aa3730712e245a0af31e4095d66d613%40thread.skype/2520channel%2520in%2520team?groupId=7fb91938-5e8c-4968-bf7d-3987df7716f3&tenantId=a46df9b7-2c9b-49d5-8c9f-d1b3de4ba59f, the group ID and team ID are 7fb91938-5e8c-4968-bf7d-3987df7716f3, and the channel ID is 19:1aa3730712e245a0af31e4095d66d613@thread.skype or 1aa3730712e245a0af31e4095d66d613.

For more information about accessing the channel ID and group ID through Microsoft Teams, see [Microsoft Teams documentation](https://docs.microsoft.com/en-us/microsoftteams/platform/graph/teams-graph-api-overview).

**Microsoft Teams Graph spoke action permissions**

The Microsoft Teams Graph spoke should have the following permissions to perform the relevant actions.

<table>
<thead>
<tr>
<th>Action</th>
<th>Permission type</th>
<th>Permissions (from least to most privileged)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Team</td>
<td>Delegated (work or school account)</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td></td>
<td>Delegated (personal Microsoft account)</td>
<td>Not supported</td>
</tr>
<tr>
<td>Update Team</td>
<td>Delegated (work or school account)</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td></td>
<td>Delegated (personal Microsoft account)</td>
<td>Not supported</td>
</tr>
<tr>
<td>Action</td>
<td>Permission type</td>
<td>Permissions (from least to most privileged)</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Get Team</td>
<td>Application</td>
<td>Group.Read.All, Group.ReadWrite.All</td>
</tr>
<tr>
<td></td>
<td>Delegated (work or school account)</td>
<td>Group.Read.All, Group.ReadWrite.All</td>
</tr>
<tr>
<td></td>
<td>Delegated (personal Microsoft account)</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Application</td>
<td>Group.Read.All, Group.ReadWrite.All</td>
</tr>
<tr>
<td>Archive Team</td>
<td>Delegated (work or school account)</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td></td>
<td>Delegated (personal Microsoft account)</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Application</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td>Unarchive Team</td>
<td>Delegated (work or school account)</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td></td>
<td>Delegated (personal Microsoft account)</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Application</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td>Create Channel in a Team</td>
<td>Delegated (work or school account)</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td></td>
<td>Delegated (personal Microsoft account)</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Application</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td>Get Channel Metadata</td>
<td>Delegated (work or school account)</td>
<td>Group.Read.All, Group.ReadWrite.All</td>
</tr>
<tr>
<td></td>
<td>Delegated (personal Microsoft account)</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Application</td>
<td>Group.Read.All, Group.ReadWrite.All</td>
</tr>
<tr>
<td>Get Channel ID by Name</td>
<td>Delegated (work or school account)</td>
<td>Group.Read.All, Group.ReadWrite.All</td>
</tr>
<tr>
<td>Action</td>
<td>Permission type</td>
<td>Permissions (from least to most privileged)</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Delegated (personal Microsoft account)</td>
<td>Not supported</td>
</tr>
<tr>
<td>Delete Channel</td>
<td>Application</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td></td>
<td>Delegated (work or school account)</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td></td>
<td>Delegated (personal Microsoft account)</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Application</td>
<td>Group.ReadWrite.All</td>
</tr>
</tbody>
</table>

For more information about the required permissions, see Microsoft Teams documentation.

**Microsoft account requirements**

The Microsoft Teams Graph spoke requires registering an application using the Microsoft Azure portal to generate OAuth 2.0 tokens.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**MID Server requirements**

The Microsoft Teams Graph spoke actions use REST calls, which can run on an instance or a MID Server. Use the connection record associated with the Microsoft alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

**Set up Microsoft Teams Graph spoke**

Integrate the ServiceNow instance and Microsoft Teams account by creating a custom OAuth application in Microsoft Teams to authenticate ServiceNow requests.
Before you begin
- Request IntegrationHub subscription
- Activate the Microsoft Teams Graph spoke
- Role required: admin

Register an application using the Microsoft Azure portal
Provide authorization to the ServiceNow instance by registering an application with Azure AD.

Before you begin
Role required: Azure Active Directory admin

About this task
Complete these steps from the Microsoft Azure portal.

Procedure

1. In the Microsoft Azure portal, copy and record the **Directory ID** for later use. For more information, see [Get tenant and app ID values for signing in](https://<instance-name>.service-now.com/) in Microsoft Azure documentation.

2. Register your application in Azure portal. For instructions on registering an application, see [Tutorial: Register an app with Azure Active Directory](https://docs.microsoft.com/) in the Microsoft Docs.

3. Copy and record the **Application ID** for later use.

4. Add the **Reply URLs** in this format: `https://<instance-name>.service-now.com/oauth_redirect.do`. For more information, see [Authentication and authorization for Azure Time Series Insights API](https://docs.microsoft.com/) in Microsoft Docs.

5. For the **Required Permissions**, select **Microsoft Graph**. For more information, see [Permissions and consent in the Microsoft identity platform](https://docs.microsoft.com/) in Microsoft Docs. In **Delegated permissions**, provide these permissions in the Azure portal. You can provide more permissions as per your requirement. For more information, see [Microsoft Graph REST API v1.0 reference](https://docs.microsoft.com/) in Microsoft Docs.
6. Record the **Client Secret** for use in later configurations.

Results
The ServiceNow application is created with Microsoft Azure AD.

Register Microsoft Teams as the OAuth provider
Register Microsoft Teams as the OAuth provider so that the ServiceNow instance can request OAuth 2.0 tokens.

About this task
Use the information generated during the registration of the application in the Microsoft Azure portal.

Procedure
1. Navigate to **System OAuth > Application Registry**.
2. Click **New**.
   The system displays the message, **What kind of OAuth application?**
3. Select **Connect to a third party OAuth Provider**.
4. On the form, fill in the fields.

### Application Registries form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, <strong>MS Teams</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Client ID</td>
<td>Application ID created during application registration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client secret created during application registration.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Optional script to customize the request and response.</td>
</tr>
<tr>
<td>Logo URL</td>
<td>URL that contains an image to use as the application logo.</td>
</tr>
<tr>
<td>Default Grant Type</td>
<td>Grant type used to establish the token. Select <strong>Authorization Code</strong>.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>Time, in seconds, that the refresh token is valid. The default time is 8,640,0000 seconds.</td>
</tr>
<tr>
<td>PKCE required</td>
<td>Option to enable public clients to require PKCE for an authorization.</td>
</tr>
<tr>
<td>Note:</td>
<td>You can use only <strong>Authorization Code</strong> as the Default Grant type when PKCE is enabled.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Application scope that this registry is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>OAuth server token revocation endpoint.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint. Enter <code>https://&lt;instance-name&gt;.service-now.com/oauth_redirect.do</code></td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use mutual authentication for token request and revocation. This option requires a mutual authentication profile to be specified.</td>
</tr>
<tr>
<td>Send Credentials</td>
<td>Client credentials in the request.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
5. Insert the following records in the OAuth Entity Scopes related list.

<table>
<thead>
<tr>
<th>Record 1 in the OAuth Entity Scopes related list</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>OAuth scope</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Record 2 in the OAuth Entity Scopes related list</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>OAuth scope</td>
</tr>
</tbody>
</table>

6. Right-click the form header, and click **Save**. A system-generated OAuth entity profile is created and displayed in the OAuth Entity Profiles related list. For example, *MS Teams default_profile*.

**Create Credential records for the Microsoft Teams Graph spoke**

Authorize the Microsoft Teams Graph spoke actions by creating credential records for the application registered in the Microsoft Azure portal. The Microsoft Teams Graph spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**. The system displays the message, *What type of Credentials would you like to create?*
3. Select **OAuth 2.0 Credentials**.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>OAuth 2.0 Credentials form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Active</td>
</tr>
</tbody>
</table>
5. Right-click the form header and click **Save**.

6. To generate the OAuth token, click the **Get OAuth Token** related link.

**Results**

The credential record for the Microsoft Teams Graph spoke is created.

**Create Connection records for the Microsoft Teams Graph spoke**

Perform actions in Microsoft Teams by creating connection records for your Microsoft Teams account. The Microsoft Teams Graph spoke connection and credential alias uses these connections to perform actions.

**Procedure**

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open the Microsoft Teams Graph spoke record.
3. In the Connections related list, click **New**.
4. On the form, fill in the fields.

**HTTP(s) Connection form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, MSTeamsConnection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Microsoft Teams. For example, MSTeamsCredentials.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td><strong>Note:</strong> Do not select the check box.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Server. If the check box is selected, define the fields in the Advanced MID Server Configuration related list.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

**Note:**
Currently, the Notification Management actions use Beta API. Hence, api_version in the Attributes tab is set to beta by default.

When Microsoft Teams supports the Notification Management actions in another API version, you must update api_version in the Attributes tab and specify the new API version.

5. Click **Update**.

**Results**
The Microsoft Teams Graph spoke is set up and integrated with the ServiceNow instance.

**Regenerate the Microsoft Teams OAuth token**
Authorize the Microsoft Teams Graph spoke by regenerating the Microsoft Teams OAuth token after it expires.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **Connections & Credentials > Credentials**.
2. Select the Microsoft Teams Graph spoke OAuth Credential record.
3. To regenerate the OAuth token, click the **Get OAuth Token** related link.

**Results**
The Microsoft Teams Graph spoke receives a new OAuth access token.

**Microsoft 365 Excel spoke v1.0.1**
Manage Microsoft Office 365 Excel workbooks stored in Microsoft OneDrive from your ServiceNow instance.
Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Microsoft Office 365 Excel v1.0, but may be compatible with later versions.

Spoke requirements
• Microsoft Azure Portal account
• Client ID and Client Secret of the application registered in Azure Portal

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• Complex Object (com.glide.cobject)

⚠ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Microsoft 365 Excel Spoke provides actions to automate tasks when events occurs in your ServiceNow instance. Available actions include:
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell and Range Management</td>
<td>Get Cell Details</td>
<td>Retrieves the properties of the specified cell.</td>
</tr>
<tr>
<td></td>
<td>Get Cells</td>
<td>Retrieves the properties of the selected range of cells.</td>
</tr>
<tr>
<td></td>
<td>Update Cells</td>
<td>Updates the properties of the selected range of cells.</td>
</tr>
<tr>
<td>Table Management</td>
<td>Add Rows</td>
<td>Adds one or more rows to the given table.</td>
</tr>
<tr>
<td></td>
<td>Create Table</td>
<td>Adds a table to the worksheet.</td>
</tr>
<tr>
<td></td>
<td>Get Table Cells</td>
<td>Retrieves the properties of the selected range of table cells.</td>
</tr>
<tr>
<td></td>
<td>Get Table Details</td>
<td>Retrieves the properties of the specified table.</td>
</tr>
<tr>
<td></td>
<td>Look up Table Columns</td>
<td>Lists the details of the specified range columns from the selected table.</td>
</tr>
<tr>
<td></td>
<td>Look up Table Rows</td>
<td>Lists the details of the specified range of rows from the selected table.</td>
</tr>
<tr>
<td>Workbook Management</td>
<td>Look up Workbooks</td>
<td>Lists all the workbooks in the specified folder.</td>
</tr>
<tr>
<td>Worksheet Management</td>
<td>Add Worksheet</td>
<td>Adds a worksheet to a workbook.</td>
</tr>
<tr>
<td></td>
<td>Get Used Cells</td>
<td>Retrieves the properties of the specified range of cells in the worksheet.</td>
</tr>
<tr>
<td></td>
<td>Get Worksheet Details</td>
<td>Retrieves the properties of the worksheet.</td>
</tr>
<tr>
<td></td>
<td>Look up Worksheets</td>
<td>Lists all the worksheets in the workbook.</td>
</tr>
<tr>
<td></td>
<td>Update Worksheet</td>
<td>Updates a worksheet of a workbook.</td>
</tr>
</tbody>
</table>

⚠️ **Note:** You must specify the input values for **Update Cells** and **Add Row** actions as shown in the following examples.
Add Row action: The action input, Value 1 corresponds to the first row in your table. The values Hello and 100 correspond to the values of the first and second column respectively.

Update Cells action: The action input, Value 1 corresponds to the first row in your range. The values Hello and 100 correspond to the values of the first and second column respectively.

must provide values in the same format for the action inputs: Formulas, Formulas R1C1, Formulas Local, and Number Format. For more information, see Add Row.

Update Rage.

Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the Microsoft 365 Excel spoke

Integrate the ServiceNow instance and Microsoft 365 Excels by using the OAuth credentials to authenticate ServiceNow requests.
Before you begin

• Request an IntegrationHub subscription.
• Activate Microsoft 365 Excel Spoke.
• Role required: admin

Create a credential record for the Microsoft 365 Excel spoke

Create a credential record for the Microsoft Azure Portal account. The Microsoft 365 Excel Spoke connection and credential alias uses these credentials to authorize actions.

Before you begin

• Register your ServiceNow instance in Microsoft Azure Portal and record the client ID and client secret. Also, add the offline_access, Files.ReadWrite.All, and Files.ReadWrite scopes in the API permissions for the application. For more information, see Quickstart: Register an application with the Microsoft identity platform.

Note: Ensure that the Redirect URI of the instance is in the https://<instance>.service-now.com/oauth_redirect.do format.

Procedure

1. Navigate to IntegrationHub > Connections & Credentials > Connection and Credential Aliases.
2. Open the Microsoft_365_Excel record.
3. Click the Create New Connection & Credential related link.
4. On the form, fill these values.

Connection and Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Name</td>
<td>Name of the connection. This field is automatically set to Microsoft 365 Excel Spoke Connection Cred.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>The URL used for connecting to Microsoft Office 365 Excel. This field is automatically set to <a href="https://graph.microsoft.com/v1.0">https://graph.microsoft.com/v1.0</a></td>
</tr>
<tr>
<td>Credential Name</td>
<td>Name of the credential. This field is automatically set to Microsoft 365 Excel Spoke Credential</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>OAuth Entity Name</td>
<td>Name of the OAuth entity profile. This field is automatically set to Microsoft 365 Excel Spoke OAuth.</td>
</tr>
<tr>
<td>OAuth Client ID</td>
<td>Client ID of the Microsoft Office 365 Excel application you registered in Azure Portal.</td>
</tr>
<tr>
<td>OAuth Client Secret</td>
<td>Client Secret that you request for the registered application in Azure Portal.</td>
</tr>
<tr>
<td>OAuth Redirect URL</td>
<td>The redirect URL. The format of the URL is https://&lt;instance&gt;.service-now.com/oauth_redirect.do</td>
</tr>
</tbody>
</table>

5. Click **Create and Get OAuth Token**.

**Miro spoke**

The Miro spoke provides actions to view and analyze meaningful usage data for Miro software subscriptions. Analyze usage for your Miro Enterprise account to determine which licenses are stale so that you can reclaim these licenses and realize your potential savings.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

**Spoke requirements**

- Miro Company Admin account
- SSO/SAML enabled on your Miro account

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Miro spoke provides actions to automate Miro tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Management</td>
<td>Deactivate User</td>
<td>Deactivates a Miro user account.</td>
</tr>
<tr>
<td></td>
<td>Delete User</td>
<td>Deletes a user from a Miro account.</td>
</tr>
<tr>
<td></td>
<td>Look up Organization ID</td>
<td>Retrieves the organization ID of the authenticated user account.</td>
</tr>
<tr>
<td></td>
<td>Look up Organization Members</td>
<td>Retrieves information about the members within an enterprise organization.</td>
</tr>
</tbody>
</table>

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the Miro spoke
Integrate the ServiceNow instance and Miro by creating a custom OAuth application in Miro to authenticate ServiceNow requests.

Before you begin
• Request an IntegrationHub subscription.
• Activate Miro spoke.
Create a Miro Enterprise OAuth 2.0 application

Create a Miro Enterprise OAuth 2.0 application to enable access to the Miro API.

Before you begin
Miro role required: Company Admin

Procedure
1. From a web browser, open the Miro Platform.
2. If you have not created any teams within your organization or you want to build and test the OAuth 2.0 application using fake data, get a developer team.
3. On the page header of the Miro Platform, click Your Apps.
   The sign up page opens.
4. Sign in using your Company Admin credentials.
   Your default organization profile opens.
5. At the top of the left navigation pane, click the organization profile icon to select the organization that you want to build the OAuth 2.0 application for.
   The profile for the selected organization opens.
6. On the left navigation pane, click Profile settings.
7. Select the API, SDK & Embed tab of your profile settings.
8. In the Your apps section, select the I agree to the Terms and Conditions check box and then click Create new app.
   The Create new app dialog box opens.
9. On the dialog box, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>App name</td>
<td>Name of the OAuth 2.0 application.</td>
</tr>
<tr>
<td>Description</td>
<td>Brief description of the OAuth 2.0 application.</td>
</tr>
</tbody>
</table>

10. Select the team that you want to build the OAuth 2.0 application for.
11. Click Create app.
   The settings for your newly created app open.
12. In the Your app <app-name> section, copy the values in the **Client id** and **Client secret** fields. Save them in a secure location for later use.

13. In the Redirect URLs section, enter the URL of the OAuth provider that users are redirected to after authentication and then click **Add**. Enter https://<instance>.service-now.com/oauth_redirect.do, where <instance> is the name of your ServiceNow instance.

14. In the OAuth scopes section, enable the **organizations:read** OAuth scope. OAuth scopes specify the level of access that the application has to your protected resources. The organizations:read OAuth scope enables your application to read information about your organizations and organization members.

**What to do next**
Keep your organization profile open so that you can enable SCIM (System for Cross-domain Identity Management) on your Miro Enterprise account.

**Enable SCIM on your Miro Enterprise account**
Enable SCIM (System for Cross-domain Identity Management) on your Miro Enterprise account so that you can generate an API access token for authenticating your Miro API requests.

**Before you begin**
Miro role required: Company Admin

**Procedure**
1. On the left navigation pane of your Miro organization profile, click **Security**.
2. On the Security page, select the option to **Enable SSO/SAML**.
3. After SSO/SAML is enabled, select the option to enable **SCIM Provisioning**. Miro automatically generates and displays your API access token in the **Api Token** field.
4. **Optional**: Select the **Send email notifications to users provisioned by SCIM** check box to allow Miro to send email notifications to all users that have been provisioned using SCIM.
5. Copy the API access token in the **Api Token** field. Save it in a secure location for later use.

**Create a Miro Enterprise connection**
Create a connection between your Miro Enterprise applications and your ServiceNow instance.
Before you begin
ServiceNow role required: admin

Procedure
1. From your ServiceNow instance, navigate to Process Automation > Flow Designer.
   The Flow Designer launches in a new tab.
2. Select the Connections tab.
3. Click View Details for your Miro Enterprise connection.
4. From your Miro Enterprise connection details, click Add Connection.
   The Create Connection dialog box opens.
5. On the dialog box, fill in the fields.

<table>
<thead>
<tr>
<th>Create Connection dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>---------------------------</td>
</tr>
<tr>
<td>Connection Information</td>
</tr>
<tr>
<td>Connection Name</td>
</tr>
<tr>
<td>Credential Information</td>
</tr>
<tr>
<td>OAuth Client ID</td>
</tr>
<tr>
<td>OAuth Client Secret</td>
</tr>
<tr>
<td>OAuth Redirect URL</td>
</tr>
</tbody>
</table>

6. Click Create and Get OAuth Token.
   The Miro OAuth authorization dialog box opens.
7. On the dialog box, locate the team that you built the Miro Enterprise OAuth 2.0 application for and then click Install.
   The OAuth access token becomes available for authorizing your Miro Enterprise connection.
Create a Miro Enterprise SCIM connection

Create a connection between the Miro Enterprise SCIM and your ServiceNow instance.

Before you begin
ServiceNow role required: admin

Procedure

1. From your ServiceNow instance, navigate to Process Automation > Flow Designer.
   The Flow Designer launches in a new tab.
2. Select the Connections tab.
3. Click View Details for your Miro Enterprise SCIM connection.
4. From your Miro Enterprise SCIM connection details, click Add Connection.
   The Create Connection dialog box opens.
5. On the dialog box, fill in the fields.

    Create Connection dialog box

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Information</td>
<td></td>
</tr>
<tr>
<td>Connection Name</td>
<td>Name of the Miro Enterprise SCIM connection. This field populates automatically.</td>
</tr>
<tr>
<td>Credential Information</td>
<td></td>
</tr>
<tr>
<td>API Token</td>
<td>API access token for authenticating Miro API requests. Enter the same API access token that you generated and copied in Enable SCIM on your Miro Enterprise account.</td>
</tr>
</tbody>
</table>

6. Click Create Connection.

monday.com spoke

The monday.com spoke provides actions to view and analyze meaningful usage data for monday.com software subscriptions. Analyze usage for a monday.com account to determine which licenses are stale so that you can reclaim these licenses and realize your potential savings.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release
notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Spoke requirements
- monday.com admin account

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The monday.com spoke provides actions to automate monday.com tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Board Management</td>
<td>Look up Board Activities</td>
<td>Retrieves the list of activities on your monday.com boards.</td>
</tr>
<tr>
<td></td>
<td>Look up Boards</td>
<td>Retrieves the list of monday.com boards.</td>
</tr>
<tr>
<td></td>
<td>Look up Updates</td>
<td>Retrieves the list of updates to your monday.com boards.</td>
</tr>
<tr>
<td>User Management</td>
<td>Look up Users</td>
<td>Retrieves the list of monday.com users.</td>
</tr>
</tbody>
</table>

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and
connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the monday.com spoke**

Integrate the ServiceNow instance and monday.com by creating a custom OAuth application in monday.com to authenticate ServiceNow requests.

**Before you begin**
- Request an IntegrationHub subscription.
- Activate monday.com spoke.
- monday.com role required: admin
- ServiceNow role required: admin

**Create a monday OAuth2 application**

Create a monday OAuth2 application to authorize access to the monday.com API.

**Before you begin**
- monday.com role required: admin

**About this task**

A monday application enables you to build workflows, user experiences, and products on top of the existing monday.com work operating system (Work OS). When you configure a monday application to use OAuth2, it is granted access to the monday.com API so that it can read and modify user data.

**Procedure**

1. From a web browser, go to monday.com.
2. Log in using your admin credentials.
3. At the bottom of the left navigation menu, click your profile icon and then select Developers.
   The My Apps page opens.
4. Click Create App.
   The Basic Information page for the new application opens.
5. In the Display Information section, fill in the fields.
6. **Optional:** In the same section, add your own application icon by clicking the auto-generated icon and then selecting an icon image. You can also change the icon color by clicking **App Color** and then selecting either a preset or custom color. If you do not add your own application icon or select an icon color, the application uses the auto-generated icon and default icon color.

7. In the App Credentials section, copy the values in the **Client ID** and **Client Secret** fields. Save them in a secure location for later use.

8. Click **Save App**.

9. From the left navigation menu of the new application, navigate to **General > OAuth**. The **Scopes** tab of the OAuth & Permissions page opens.

10. In the Scopes section, specify how the application can access or use different types of user data by selecting the checkbox for the following OAuth scopes:
   - **me**:read
   - **boards**:read
   - **users**:read
   - **updates**:read

11. Click **Save Feature**.

12. Select the **Redirect URLs** tab of the OAuth & Permissions page.

13. In the Redirect URLs section, enter the URL of the OAuth provider that users are redirected to after authentication. Enter `https://instance.service-now.com/oauth_redirect.do`, where `<instance>` is the name of your ServiceNow instance.

14. Click **Save Feature**.

   **Create a monday connection**
   Create a connection between your monday applications and your ServiceNow instance.
Before you begin
ServiceNow role required: admin

Procedure
1. From your ServiceNow instance, navigate to Process Automation > Flow Designer.
   The Flow Designer launches in a new tab.
2. Select the Connections tab.
3. Locate your monday connection and then click Add Connection.
   The Create Connection and Credential dialog box opens.
4. In the dialog box, fill in the fields.

Create Connection and Credential dialog box

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Name</td>
<td>Name of the connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL for the monday.com API. This field is automatically set to <a href="https://api.monday.com/v2">https://api.monday.com/v2</a>.</td>
</tr>
<tr>
<td>OAuth Client ID</td>
<td>Client ID that is assigned to your monday application.</td>
</tr>
<tr>
<td>OAuth Client Secret</td>
<td>Client secret that is assigned to your monday application.</td>
</tr>
<tr>
<td>OAuth Redirect URL</td>
<td>URL of the OAuth provider that users are redirected to after authentication. This field populates automatically based on the redirect URL that you specified in Create a monday OAuth2 application.</td>
</tr>
</tbody>
</table>

5. Click Create and Get OAuth Token.
   The Authorize App dialog box opens.
6. In the dialog box, sign in using the same monday.com credentials that you used to create your monday application.
7. Click Allow.
   The OAuth access token becomes available for authorizing your monday connection.
Okta spoke v 4.1.1
Use Okta to manage users, passwords, and groups.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• com.glide.cobject.sys.com.glide.script.vtable
• com.snc.remote_directory_sync
• XML Parser for ServiceNow IntegrationHub (com.glide.hub.action_step.xmlparser)
• Flow Designer Designer Model (com.glide.hub.designer_backend.model)
• Complex Object (com.glide.cobject)

⚠ Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported versions
API version v1.
Spoke flows

The Okta spoke provides sample flows in the draft state to demonstrate automating user and group management tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add User to Okta Group</td>
<td>When a user is created, adds the user to the specified group.</td>
</tr>
<tr>
<td>Onboard User in Okta</td>
<td>When a user is created in ServiceNow, creates and activates the user in Okta.</td>
</tr>
<tr>
<td>Remove Okta Group Membership on Deactivation</td>
<td>When a user is deactivated, removes the user from all Okta groups.</td>
</tr>
</tbody>
</table>

⚠️ **Note:** Okta has the ServiceNow_UD application to provision users in ServiceNow. ServiceNow can also be configured to provision users in Okta. Hence, ServiceNow administrators must ensure that circular user creation does not occur.

Spoke subflows

The Okta spoke provides sample subflows to demonstrate automating Okta tasks. Available subflows are:

<table>
<thead>
<tr>
<th>Subflow category</th>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Webhook management</td>
<td>Check Activate Application Event Hook</td>
<td>Verifies if an event hook for the application-lifecycle-activate exists in Okta.</td>
</tr>
<tr>
<td></td>
<td>Inbound Integration from Okta to ServiceNow</td>
<td>Allows inbound integration from Okta to a ServiceNow instance. Verifies if an event hook already exists for an application. If the event hook does not exist, a new event hook is created.</td>
</tr>
</tbody>
</table>
Subflow category | Subflow | Description
--- | --- | ---
| | | **Note:** Make sure that **Configuration URI** field value is in this format: https://<instance-name>.service-now.com/api/sn_okta_spoke/oktawebhook

| Group Management | Get Groups | Updates an existing group or creates a group in Okta.
| Application Management | Create or Update Okta Applications Record | Creates a Okta application record or updates an existing Okta application record.

**Spoke module**
The Okta spoke adds the Okta application to your ServiceNow instance and includes these modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Okta Applications</td>
<td>Shows the list of applications.</td>
</tr>
<tr>
<td>Okta groups</td>
<td>Shows the list of user groups in Okta.</td>
</tr>
<tr>
<td>Okta Users</td>
<td>Shows the list of users in Okta.</td>
</tr>
<tr>
<td>Okta Webhook Registry</td>
<td>Shows the list of webhook registries.</td>
</tr>
</tbody>
</table>

**Spoke actions**
The Okta spoke provides actions to authenticate and manage users and groups. Available actions include:
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Management</td>
<td>Activate User</td>
<td>Starts the process of activating a user in Okta by enabling new or returning users to configure their Okta account from an activation URL. This action can either have Okta send the activation URL to the user as an email, or it can return the activation URL as a data pill for use in a later action to send an email or notification.</td>
</tr>
<tr>
<td></td>
<td>Clear User Session</td>
<td>Clears all active sessions the specified user has with Okta, which forces the user to log back in the next time they use Okta.</td>
</tr>
<tr>
<td></td>
<td>Create User</td>
<td>Creates the specified user in Okta with the specified standard, optional, and mandatory field values.</td>
</tr>
<tr>
<td></td>
<td>(deprecated)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Deactivate User</td>
<td>Deactivates the specified user in Okta, which removes the user's groups and application assignments, and changes the user status to DEACTIVATED. This action is commonly used when a user departs the company indefinitely.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: Do not perform this action on users with a DEPROVISIONED status.</td>
</tr>
<tr>
<td></td>
<td>Delete User</td>
<td>Deletes the specified user within Okta, which completely removes the user. This action is commonly used to clean up your user base after compliance regulations have been met.</td>
</tr>
<tr>
<td></td>
<td>Is User Account</td>
<td>Determines if a user account is locked.</td>
</tr>
<tr>
<td></td>
<td>Locked</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lookup Okta User</td>
<td>Retrieves the Okta user ID for the specified Okta login ID or login short name.</td>
</tr>
<tr>
<td></td>
<td>ID</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Password Management</td>
<td>Change User's Password</td>
<td>Changes the specified user's password after validating the user's current password.</td>
</tr>
<tr>
<td></td>
<td>Expire User Password</td>
<td>Expires the specified user's password within Okta. This action is commonly used as a reaction to stop breaching attempts.</td>
</tr>
<tr>
<td></td>
<td>Reset to Temporary Password</td>
<td>Resets the specified user's password within Okta to a temporary password. This action is commonly used to get a user logged in who has forgotten their password.</td>
</tr>
<tr>
<td></td>
<td>Look up Users Stream</td>
<td>Retrieves users from Okta based on the filter value.</td>
</tr>
<tr>
<td></td>
<td>Suspend User</td>
<td>Suspends the specified user within Okta by changing the user status from ACTIVE to SUSPENDED. For example, use this action to suspend access for users who are on temporary leave. To reactivate a suspended user, use the Unsuspend action.</td>
</tr>
<tr>
<td></td>
<td>Restart User Activation</td>
<td>Restarts the specified user's activation within Okta. Use this action if the user did not complete their activation with the activation code or link provided by the Activate User Action.</td>
</tr>
<tr>
<td></td>
<td>Update User Profile (deprecated)</td>
<td>Updates the user profile details for the specified user in Okta.</td>
</tr>
<tr>
<td></td>
<td>Unsuspend User</td>
<td>Unsuspends the specified user in Okta.</td>
</tr>
<tr>
<td></td>
<td>Lookup User Account Details by User ID</td>
<td>Retrieves user details for the specified Okta user ID.</td>
</tr>
<tr>
<td></td>
<td>Lookup User Profile by User ID</td>
<td>Retrieves user profile details for the specified Okta user ID.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Reset User Factors</td>
<td>Resets all of the multi-factor access devices for the specified user within Okta. This action is commonly used when a user loses their multi-factor authentication device or method.</td>
</tr>
<tr>
<td></td>
<td>Set User Password</td>
<td>Sets the specified user's password in Okta.</td>
</tr>
<tr>
<td></td>
<td>Unlock User</td>
<td>Unlocks the specified user in Okta.</td>
</tr>
<tr>
<td>Group Management</td>
<td>Add User To Group</td>
<td>Adds the specified user to the specified group in Okta.</td>
</tr>
<tr>
<td></td>
<td>Create Group</td>
<td>Creates the specified group in Okta.</td>
</tr>
<tr>
<td></td>
<td>Get Groups</td>
<td>Retrieves all new and updated groups in Okta.</td>
</tr>
<tr>
<td></td>
<td>Is User In Group</td>
<td>Determines if the specified user is a member of the specified group in Okta.</td>
</tr>
<tr>
<td></td>
<td>Lookup Group Details by Group ID</td>
<td>Retrieves group details for the specified Okta group ID.</td>
</tr>
<tr>
<td></td>
<td>Lookup Group ID By Name</td>
<td>Retrieves group details and group ID for the specified Okta group name.</td>
</tr>
<tr>
<td></td>
<td>Remove User From Group (deprecated)</td>
<td>Removes the specified user from the specified Okta group ID.</td>
</tr>
<tr>
<td></td>
<td>Update Group</td>
<td>Updates the group details for the specified Okta group ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Groups Stream</td>
<td>Retrieves groups from Okta, based on the filter criteria.</td>
</tr>
<tr>
<td>Group Membership Management</td>
<td>Look up Group Members Stream</td>
<td>Retrieves users from the specified Okta group.</td>
</tr>
<tr>
<td></td>
<td>Look up User Groups Stream</td>
<td>Retrieves the group information from Okta to which the user belongs to.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Application Access Management</td>
<td>Look up Users by Application ID Stream</td>
<td>Retrieves users who have access to the specified application.</td>
</tr>
<tr>
<td></td>
<td>Look up Groups by Application ID Stream</td>
<td>Retrieves groups who have access to the specified application.</td>
</tr>
<tr>
<td></td>
<td>Revoke User Application Access</td>
<td>Revokes access to an application for the required user.</td>
</tr>
<tr>
<td>Application Management</td>
<td>Look up Applications Stream</td>
<td>Retrieves applications from Okta, based on the filter criteria. For more information about the criteria you can specify in the Filter input, see List applications in Okta Developer Documentation.</td>
</tr>
<tr>
<td></td>
<td>Look up Application by Application ID</td>
<td>Retrieves details of the specified application ID in Okta.</td>
</tr>
<tr>
<td>Logs Management</td>
<td>Look up Okta Logs Stream</td>
<td>Retrieves the logs in Okta that are filtered by the given filter value and within the specified time duration. For more information about the event types and system logs, see Event Types in Okta Developer Documentation.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Look up Additional Fields for User</td>
<td>Retrieves the metadata of the additional fields for a user in Okta.</td>
</tr>
<tr>
<td></td>
<td>Look up Applications Metadata</td>
<td>Retrieves the metadata of applications in Okta.</td>
</tr>
<tr>
<td></td>
<td>Look up Event Hooks Metadata</td>
<td>Retrieves the metadata of the event hooks in Okta.</td>
</tr>
</tbody>
</table>

**Note:** Make sure that you use this action along with the actions that use Event Hook ID as a dynamic input.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Webhook Management</td>
<td>Look up Groups Metadata</td>
<td>Retrieves the metadata details of the groups in Okta.</td>
</tr>
<tr>
<td></td>
<td>Activate Event Hook</td>
<td>Changes the status of the specified event hook to active in Okta.</td>
</tr>
<tr>
<td></td>
<td>Create Event Hook</td>
<td>Creates an active event hook in Okta.</td>
</tr>
<tr>
<td></td>
<td>Note: Make sure that <strong>Configuration URI</strong> field value is in this format: <code>https://&lt;instance-name&gt;.service-now.com/api/sn_okta_spoke/oktawebhook</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Deactivate Event Hook</td>
<td>Sets the status of the specified Okta event hook to inactive.</td>
</tr>
<tr>
<td></td>
<td>Look up Event Hook by ID</td>
<td>Retrieves details of the Okta event hook for the specified ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Event Hooks</td>
<td>Retrieves details of all the event hooks in Okta.</td>
</tr>
<tr>
<td></td>
<td>Update Event Hook</td>
<td>Updates the specified event hook in Okta.</td>
</tr>
<tr>
<td></td>
<td>Note: Make sure that <strong>Configuration URI</strong> field value is in this format: <code>https://&lt;instance-name&gt;.service-now.com/api/sn_okta_spoke/oktawebhook</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Verify Event Hook</td>
<td>Verifies and retrieves an external service endpoint configured for an event hook in Okta.</td>
</tr>
</tbody>
</table>

**Okta account requirements**

The Okta spoke requires generating and configuring your Okta account to use a web API key.

**Credential and connection alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).
This spoke uses the Okta Connection & Credential Alias record to authorize actions.

**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Okta alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

**Set up Okta spoke**

Integrate the ServiceNow instance and your Okta account using an API key or OAuth credentials to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription
- Activate the Okta spoke
- Role required: admin

**About this task**

Depending on your requirement, you set up the spoke using API key or OAuth credentials. However, you can use only one alias at a time for a ServiceNow domain.

**Set up Okta spoke using API Key**

Integrate the ServiceNow instance and your Okta account using an API key to authenticate ServiceNow requests.

**Generate Okta account API token**

Configure your Okta account to generate an access token for API key authentication.

**Before you begin**

Okta requirements:

- Okta organization or developer account
- Okta administrator credentials

**About this task**

Complete these steps from your Okta organization or developer account. See the Okta for developers documentation for instructions on creating and configuring your account.
Procedure
1. Generate an access token to interact with Okta APIs.
2. Record the access token to create Credential records on your ServiceNow instance.

Create Credential records for the Okta spoke
Create Credential records to the Okta application you created. The Okta spoke connection and credential alias uses these credentials to authorize actions.

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?.
3. Select API Key Credentials.
   A blank API Key Credentials form displays.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Okta Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>API Key</td>
<td>Enter ssWS followed by the access token you obtained from Okta. For example, ssWS {access token}.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Create Connection records for the Okta spoke v1.1.1
Create a Connection record to the Okta API. The Okta spoke connection and credential alias uses these connections to perform actions in Okta.
Procedure

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.

2. Open for the record for **Okta**.

3. From the **Connections** tab, click **New**.
   The system displays a blank HTTP(s) Connection form.

4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter Okta Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for Okta. For example, select Okta Credentials.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Enter your Okta organization URL. For example, <a href="https://dev-418994.oktapreview.com">https://dev-418994.oktapreview.com</a>.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Set up Okta spoke using OAuth credentials**

Integrate the ServiceNow instance and your Okta account by creating a custom OAuth application in Okta to authenticate ServiceNow requests.

**Before you begin**

- Access Okta Developer Console
- Role required: admin

**Configure Okta app**

Create a custom OAuth application in Okta account to enable OAuth 2.0 authentication with the Okta spoke.

**Before you begin**

Role required: admin

**Procedure**

1. Create an application in the Okta Developer Console. For more information, see *Create an OAuth 2.0 app in Okta* in *Okta Developer Documentation*.

2. In the Okta API Scopes tab, ensure that you provide these permissions:
okta.users.manage
okta.apps.manage
okta.logs.read
okta.groups.read
okta.groups.manage
okta.users.read
okta.apps.read

For more information about the API scopes, see Define allowed scopes in Okta Developer Documentation.

3. From the General tab:

a. Ensure that you select these Allowed grant types:
   • Authorization Code
   • Refresh Token
   • Implicit (Hybrid)
     ◦ Allow ID Token with implicit grant type
     ◦ Allow access token with implicit gran type

b. In Login redirect URIs and Logout redirect URIs, add the ServiceNow instance in this format: https://<servicenow-instance-name>.service-now.com/oauth_redirect.do

c. Copy and record the values of Client ID and Client secret.

Add Okta connection in ServiceNow instance
Add the Okta connection in Flow Designer to configure the Okta spoke.

Procedure
1. Navigate to Flow Designer > Designer.
2. Click Connections.
3. On the Okta spoke tile, click View Details.
4. In the Connections page, click Configure.
   The pop-up window displays a blank Configure Connection form.
5. On the form, fill these values.
### Configure Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection URL</td>
<td>URL to connect to the Okta instance. In the Connection URL field, enter <code>https://&lt;yourOktaDomain&gt;.com</code>, where <code>&lt;yourOktaDomain&gt;</code> is your organization domain name.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The authorization URL, token URL, and token revocation URL generate automatically based on the connection URL that you specify.</td>
</tr>
<tr>
<td>OAuth Client ID</td>
<td>Client ID of your Okta app.</td>
</tr>
<tr>
<td>OAuth Client Secret</td>
<td>Client secret of your Okta app.</td>
</tr>
<tr>
<td>OAuth Redirect URL</td>
<td>Redirect URL of the ServiceNow instance in this format: <code>https://&lt;servicenow-instance-name&gt;.service-now.com/oauth_redirect.do</code>.</td>
</tr>
</tbody>
</table>

6. Click **Configure and Get OAuth Token**.  
The OAuth Access token is generated for the Okta spoke.

### Fetch Okta groups

Fetch Okta groups into your instance so that you can assign them to different users. You can fetch the groups on an as-needed or scheduled basis.

**Before you begin**  
Role required: okta.admin

**Procedure**

1. To fetch Okta groups on an as-needed basis.
   
   **a.** Navigate to **Okta spoke > Okta groups**.
   
   **b.** Click **Fetch Okta groups**.
   
   **c.** From the Okta groups list, you can review the following:
<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the Okta group.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the Okta group.</td>
</tr>
<tr>
<td>Group ID</td>
<td>Group ID of the Okta group.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the Okta group.</td>
</tr>
<tr>
<td>Group creation date</td>
<td>Date when Okta group was created.</td>
</tr>
<tr>
<td>Group last updated date</td>
<td>Date when Okta group was last updated.</td>
</tr>
<tr>
<td>Created</td>
<td>Date when Okta group was first synchronized with your ServiceNow instance.</td>
</tr>
<tr>
<td>Updated</td>
<td>Date when Okta group was last synchronized with your ServiceNow instance.</td>
</tr>
</tbody>
</table>

2. To fetch Okta groups on a scheduled basis.

   a. Navigate to **System Definition > Scheduled Jobs**.

   b. Open the **Fetch Okta Groups** record.

   c. Update the fields, as needed.

      🔄 **Note:** Make sure that the **Active** option is selected so that the scheduled job is activated for use.

   d. Click **Update**.

**Set up a bi-directional webhook for Okta spoke**

Configure a webhook to subscribe to Okta with a ServiceNow callback URL.

**Before you begin**

- Request an IntegrationHub <> subscription
- Activate the Okta spoke
- Role required: admin
Register Okta webhook
Register a Okta webhook in your ServiceNow instance to notify the ServiceNow app when certain events occur in Okta.

Before you begin
Role required: admin

Procedure
1. Navigate to Okta Spoke > Okta Webhook Registry.
2. Click New.
3. On the form, fill in these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name to identify the webhook registry.</td>
</tr>
<tr>
<td></td>
<td>Note: The name must be only Okta Webhook Authentication.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of the webhook registry.</td>
</tr>
<tr>
<td>Authentication Key</td>
<td>Authentication key used for connecting to Okta webhook.</td>
</tr>
<tr>
<td>Authentication Value</td>
<td>Authentication value used for connecting to Okta webhook.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Oracle Autonomous DB spoke v1.0.2
Manage the Oracle Autonomous Database operations from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
IntegrationHub subscription
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Oracle Autonomous DB 20160918, but may be compatible with later versions.

Spoke requirements
- Oracle Autonomous DB account

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Complex Object (com.glide.cobject)
- Oracle Cloud IAM spoke (com.sn.oci.iam.spoke)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Oracle Autonomous DB spoke provides actions to automate Oracle Autonomous DB tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Backup Management</td>
<td>Create Database Backup</td>
<td>Creates an Autonomous Database backup for the specified database based on the specified request parameters.</td>
</tr>
<tr>
<td></td>
<td>Get Database Backup</td>
<td>Retrieves the details of the specified Autonomous Database backup.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Look up</td>
<td>Database Backups</td>
<td>Retrieves a list of Autonomous Database backups based on the specified database ID or compartment ID.</td>
</tr>
<tr>
<td>Create Database</td>
<td></td>
<td>Creates an Autonomous Database.</td>
</tr>
<tr>
<td>Create Database</td>
<td>by Cloning</td>
<td>Creates a clone of the existing Autonomous Database.</td>
</tr>
<tr>
<td>Delete Database</td>
<td></td>
<td>Deletes the specified Autonomous Database.</td>
</tr>
<tr>
<td>Deregister</td>
<td>Database Data Safe</td>
<td>Deregisters the specified Autonomous Database asynchronously with data safe.</td>
</tr>
<tr>
<td>Failover</td>
<td>Database</td>
<td>Initiates a failover database of the specified Autonomous Database to a standby.</td>
</tr>
<tr>
<td>Get Database</td>
<td></td>
<td>Retrieves details of the specified Autonomous Database.</td>
</tr>
<tr>
<td>Look up Databases</td>
<td></td>
<td>Retrieves a list of Autonomous Databases.</td>
</tr>
<tr>
<td>Register</td>
<td>Database Data Safe</td>
<td>Registers the specified Autonomous Database asynchronously with data safe.</td>
</tr>
<tr>
<td>Restart Database</td>
<td></td>
<td>Restarts the specified Autonomous Database.</td>
</tr>
<tr>
<td>Start Database</td>
<td></td>
<td>Starts the specified Autonomous Database.</td>
</tr>
<tr>
<td>Stop Database</td>
<td></td>
<td>Stops the specified Autonomous Database.</td>
</tr>
<tr>
<td>Update Database</td>
<td></td>
<td>Updates the specified Autonomous Database.</td>
</tr>
<tr>
<td>Look up</td>
<td>Database Versions</td>
<td>Retrieves the list of supported Autonomous Database versions.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the Oracle Autonomous DB spoke
Integrate the ServiceNow instance and Oracle Autonomous DB by using the credentials to authenticate ServiceNow requests.

Before you begin
• Request an IntegrationHub subscription.
• Activate Oracle Autonomous DB spoke.
• Install the Oracle Cloud IAM spoke before installing the Oracle Autonomous DB spoke
• Role required: admin

Create a credential record for the Oracle Cloud IAM spoke
Create a credential record for the Oracle Cloud IAM account. The Oracle Cloud IAM spoke connection and credential alias uses these credentials to authorize actions.

Before you begin
Use the public key from the Java Keystore (JKS) file and generate a fingerprint from your Oracle Cloud account. For more information about fingerprint, see Required Keys and OCIDs.

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays this message: What type of Credentials would you like to create?
3. Select OCI SHA256WithRSA Signature.
4. On the form, fill these values.
### OCI SHA256WithRSA Signature Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Oracle IAM Cloud Cred.</td>
</tr>
<tr>
<td>Certificate Sys ID</td>
<td>Sys ID of the OCI Signing Certificate.</td>
</tr>
<tr>
<td>Alias</td>
<td>Alias of the KeyStore.</td>
</tr>
<tr>
<td>Alias Password</td>
<td>Alias password of the KeyStore.</td>
</tr>
<tr>
<td>Key ID</td>
<td>Key ID helps identify which key is used when multiple keys are used to sign tokens. The Key ID must be slash (/) separated values of Tenancy OCID, User OCID, and Fingerprint in this format: ocid1.tenancy.oc1..&lt;unique_ID&gt;/ocid1.user.oc1..&lt;unique_ID&gt;/key_fingerprint.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Option to specify if the credential applies to all MID Servers in the network.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select OCI SHA256RSA Signing Algorithm</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click **Submit**.

### Create a connection record for the Oracle Cloud IAM spoke

Create a connection record for your Oracle Cloud IAM account. The Oracle Cloud IAM spoke connection and credential aliases use these connections to perform actions in Oracle Cloud IAM.

**Procedure**

1. Navigate to **Connections & Credentials > Connections & Credentials Aliases**.
2. Open the alias record for **OracleIAM_credentialANDconnecton**.
3. From the **Connections** tab, click **New**.
4. On the form, fill these fields.
### Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Oracle IAM conn.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Oracle Autonomous DB spoke. For example, Oracle IAM Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection. Search and select sn_oci_iam_spoke.OracleIAM_credentialAN</td>
</tr>
<tr>
<td>Host</td>
<td>Fully qualified domain name of the target host where the Oracle Cloud IAM server is hosted. For example, database.ap-mumbai-1.oraclecloud.com.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to Oracle Cloud IAM. For example, <a href="https://database.ap-mumbai-1.oraclecloud.com">https://database.ap-mumbai-1.oraclecloud.com</a>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
<tr>
<td>Override default port</td>
<td>Target port used by the connection. If blank, the system uses the default port.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Servers for this connection. If the check box is selected, define the fields in the Advanced MID Server Configuration related list.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Create a credential record for the Oracle Autonomous DB spoke**

Create a credential record for the Oracle Autonomous DB account. The Oracle Autonomous DB spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to **Connections & Credentials > Credentials**.

2. Click **New**.

   The system displays this message: What type of Credentials would you like to create?

3. Select **OCI SHA256WithRSA Signature**.

4. On the form, fill these values.
OCI SHA256WithRSA Signature Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Oracle IAM Cloud Cred.</td>
</tr>
<tr>
<td>Certificate Sys ID</td>
<td>Sys ID of the OCI Signing Certificate.</td>
</tr>
<tr>
<td>Alias</td>
<td>Alias of the KeyStore.</td>
</tr>
<tr>
<td>Alias Password</td>
<td>Alias password of the KeyStore.</td>
</tr>
<tr>
<td>Key ID</td>
<td>Key ID (kid) helps identify which key is used when multiple keys are used to sign tokens. The Key ID must be slash (/) separated values of Tenancy OCID, User OCID, and Fingerprint in this format: ocid1.tenancy.oc1..&lt;unique_ID&gt;/ocid1.user.oc1..&lt;unique_ID&gt;/&lt;key_fingerprint&gt;.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Option to specify if the credential applies to all MID Servers in the network.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Associated credential record. If you have already created a credential alias, search and select the record.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select OCI SHA256RSA Signing Algorithm</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click **Submit**.

Create a connection record for the Oracle Autonomous DB spoke

Create a connection record for your Oracle Autonomous DB account. The Oracle Autonomous DB spoke connection and credential aliases use these connections to perform actions in Oracle Autonomous DB.

**Procedure**

1. Navigate to **Connections & Credentials > Connections & Credentials Aliases**.
2. Open the alias record for **Oracle Autonomous Database**.
3. From the **Connections** tab, click **New**.
4. On the form, fill these fields.
Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Oracle Auto DB Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Oracle Autonomous DB spoke. For example, Oracle ADB Creds.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection. Search and select sn oci adb spoke Oracle Autonomous Database</td>
</tr>
<tr>
<td>Host</td>
<td>Fully qualified domain name of the target host where the Oracle Autonomous DB server is hosted. For example, database.ap-mumbai-1.oraclecloud.com.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to Oracle Autonomous DB. For example, <a href="https://database.ap-mumbai-1.oraclecloud.com">https://database.ap-mumbai-1.oraclecloud.com</a>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
<tr>
<td>Override default port</td>
<td>Target port used by the connection. If blank, the system uses the default port.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Servers for this connection. If the check box is selected, define the fields in the Advanced MID Server Configuration related list.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Oracle Block Storage spoke v1.0.1**

Manage block storage and volumes in the Oracle Block Storage account from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.
Supported versions
This spoke was built for Oracle Block Storage API version 20160918, but may be compatible with later versions.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

• Oracle Cloud IAM spoke v1.0.4
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Oracle Block Storage spoke provides actions to automate Oracle Block Storage tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume Backup</td>
<td>Change Volume Backup</td>
<td>Moves a volume backup into a different compartment within the same tenancy.</td>
</tr>
<tr>
<td>Management</td>
<td>Compartment</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Create Volume Backup</td>
<td>Creates a new backup of the specified volume.</td>
</tr>
<tr>
<td></td>
<td>Delete Volume Backup</td>
<td>Deletes a volume backup.</td>
</tr>
<tr>
<td></td>
<td>Get Volume Backup</td>
<td>Retrieves information about the specified volume backup.</td>
</tr>
<tr>
<td></td>
<td>Look up Volume Backups</td>
<td>Retrieves list of the volume backups in the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Update Volume Backup</td>
<td>Updates the specified volume backup.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Volume Backup Policy Management</td>
<td>Create Volume Backup Policy</td>
<td>Creates a user defined backup policy.</td>
</tr>
<tr>
<td></td>
<td>Delete Volume Backup Policy</td>
<td>Deletes a user defined backup policy.</td>
</tr>
<tr>
<td></td>
<td>Look up Volume Backup Policies</td>
<td>Retrieves list of the volume backup policies in the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Update Volume Backup Policy</td>
<td>Updates a user defined backup policy.</td>
</tr>
<tr>
<td>Volume Group Backup Management</td>
<td>Change Volume Group Backup Compartment</td>
<td>Moves a volume group backup into a different compartment within the same tenancy.</td>
</tr>
<tr>
<td></td>
<td>Create Volume Group Backup</td>
<td>Creates a new backup volume group of the specified volume group.</td>
</tr>
<tr>
<td></td>
<td>Delete Volume Group Backup</td>
<td>Deletes the specified volume group backup.</td>
</tr>
<tr>
<td></td>
<td>Get Volume Group Backup</td>
<td>Retrieves details of the specified volume group backup.</td>
</tr>
<tr>
<td></td>
<td>Look up Volume Group Backups</td>
<td>Retrieves list of the volume group backups in the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Update Volume Group Backup</td>
<td>Updates the specified volume group backup.</td>
</tr>
<tr>
<td>Volume Group Management</td>
<td>Change Volume Group Compartment</td>
<td>Moves a volume group into a different compartment within the same tenancy.</td>
</tr>
<tr>
<td></td>
<td>Create Volume Group</td>
<td>Creates a new volume group in the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Delete Volume Group</td>
<td>Deletes the specified volume group.</td>
</tr>
<tr>
<td></td>
<td>Get Volume Group</td>
<td>Retrieves details of the specified volume group.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Volume Management</td>
<td>Look up Volume Groups</td>
<td>Retrieves list of the volume groups in the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Update Volume Group</td>
<td>Updates the specified volume group.</td>
</tr>
<tr>
<td></td>
<td>Attach Volume</td>
<td>Attaches the specified storage volume to the specified instance.</td>
</tr>
<tr>
<td></td>
<td>Change Volume Compartment</td>
<td>Moves a volume into a different compartment within the same tenancy.</td>
</tr>
<tr>
<td></td>
<td>Create Volume</td>
<td>Creates a new volume in the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Delete Volume</td>
<td>Deletes the specified volume.</td>
</tr>
<tr>
<td></td>
<td>Detach Volume</td>
<td>Detaches a storage volume from an instance.</td>
</tr>
<tr>
<td></td>
<td>Get Volume</td>
<td>Retrieves details of the specified volume.</td>
</tr>
<tr>
<td></td>
<td>Get Volume Attachment</td>
<td>Retrieves information about the specified volume attachment.</td>
</tr>
<tr>
<td></td>
<td>Look up Volume Attachments</td>
<td>Retrieves list of the volume attachments in the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Look up Volumes</td>
<td>Retrieves list of the volume in the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Update Volume</td>
<td>Updates the specified volume in the specified compartment.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).
Set up the Oracle Block Storage spoke

Integrate the ServiceNow instance and Oracle Block Storage account by using the OCI SHA256WithRSA Signature credentials to authenticate ServiceNow requests.

Before you begin

• Activate and set up the Oracle Cloud IAM spoke v1.0.4
• Role required: admin

Procedure

1. Optional: Create a JKS certificate. You can create a JKS certificate for the Oracle Block Storage spoke or use the certificate created for the Oracle Cloud IAM spoke. For information about creating the JKS Certificate, see Create a Java KeyStore (JKS) certificate.

2. Optional: Create X.509 certificate. You can create a X.509 certificate for the Oracle Block Storage spoke or use the certificate created for the Oracle Cloud IAM spoke. For information about creating a X.509 certificate, see Create X.509 certificate for the Oracle Cloud IAM spoke.

3. Create a child alias in the Oracle Cloud IAM spoke connection and credential alias.


   b. Click New.

   c. On the form, fill these values:

      | Field          | Description                                                      |
      |----------------|------------------------------------------------------------------|
      | Name           | Name to identify the alias record. For example, Oracle Block Storage Alias. |
      | Parent Alias   | Connection and credential alias record of the Oracle Cloud IAM spoke. For example, sn oci iam spoke.OracleIAM_credentialANDconnection |

   d. Right-click the form header and click Save.
4. Create credential record for the Oracle Block Storage spoke.

a. Navigate to Connections & Credentials > Credentials.

b. Click New.
   The system displays this message: What type of Credentials would you like to create?

c. Select OCI SHA256WithRSA Signature.

d. On the form, fill these values.
   
   Note: You can specify details of the certificates you created specifically for the Oracle Block Storage spoke or specify details of the existing certificates you had created for the Oracle Cloud IAM spoke.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Oracle Block Storage Cred.</td>
</tr>
<tr>
<td>Certificate Sys ID</td>
<td>Sys ID of the Signing Certificate.</td>
</tr>
<tr>
<td>Alias</td>
<td>Alias of the KeyStore.</td>
</tr>
<tr>
<td>Alias Password</td>
<td>Alias password of the KeyStore.</td>
</tr>
<tr>
<td>Key ID</td>
<td>Key ID helps identify which key is used when multiple keys are used to sign tokens. The Key ID must be slash (/) separated values of Tenancy OCID, User OCID, and Fingerprint in this format: ocid1.tenancy.oc1..&lt;unique_ID&gt;/ocid1.user.oc1..&lt;unique_ID&gt;/&lt;key_fingerprint&gt;.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Option to specify if the credential applies to all MID Servers in the network.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select OCI_SHA256RSA Signing Algorithm</td>
</tr>
</tbody>
</table>

e. Right-click the form header and click Submit.

5. Create connection record for the Oracle Block Storage spoke.

b. Open the child alias record you had created. For example, Oracle Obj Storage Alias.

c. From the Connections tab, click New.

d. On the form, fill these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Oracle Block Storage conn.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Oracle Block Storage spoke. For example, Oracle Block Storage Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to Oracle Block Storage. For example, <a href="https://iaas.ap-mumbai-1.oraclecloud.com">https://iaas.ap-mumbai-1.oraclecloud.com</a>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
</tbody>
</table>

e. Click Submit.

The ServiceNow instance and Oracle Block Storage account are integrated. You can use the spoke actions to build flows and automate tasks as required.

**Oracle Boot Volume spoke v1.0.2**

Manage boot volumes, backups, and KMS keys in Oracle Boot Volume account from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
IntegrationHub subscription
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Oracle Boot Volume API version 20160918, but may be compatible with later versions.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- Oracle Cloud IAM spoke v1.0.4
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Oracle Boot Volume spoke provides actions to automate tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Boot Volume Backup     | Change Boot Volume Backup Compartment       | Moves a boot volume backup to a different compartment within the same tenancy.
<p>|                        | Copy Boot Volume Backup                     | Creates a boot volume backup copy in specified region.                      |
|                        | Create Boot Volume Backup                   | Creates a boot volume backup of the specified boot volume.                  |
|                        | Delete Boot Volume Backup                   | Deletes a boot volume backup.                                               |
|                        | Get Boot Volume Backup                      | Gets information for the specified boot volume backup.                      |</p>
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Look up Boot Volume Backups</td>
<td></td>
<td>Lists the boot volumes backup in the specified compartment.</td>
</tr>
<tr>
<td>Update Boot Volume Backup</td>
<td></td>
<td>Updates specified boot volume backup.</td>
</tr>
<tr>
<td>Get Boot Volume KMS Key</td>
<td></td>
<td>Gets the Key Management encryption key assigned to the specified boot volume.</td>
</tr>
<tr>
<td>Update Boot Volume KMS Key</td>
<td></td>
<td>Updates the specified volume with a new Key Management encryption key.</td>
</tr>
<tr>
<td>Attach Boot Volume</td>
<td></td>
<td>Attaches the specified boot volume to the specified instance.</td>
</tr>
<tr>
<td>Change Boot Volume Compartment</td>
<td></td>
<td>Moves a boot volume to a different compartment within the same tenancy.</td>
</tr>
<tr>
<td>Create Boot Volume</td>
<td></td>
<td>Creates a boot volume in the specified compartment.</td>
</tr>
<tr>
<td>Delete Boot Volume</td>
<td></td>
<td>Deletes the specified boot volume.</td>
</tr>
<tr>
<td>Detach Boot Volume</td>
<td></td>
<td>Detaches a boot volume from an instance.</td>
</tr>
<tr>
<td>Get Boot Volume</td>
<td></td>
<td>Gets information for the specified boot volume.</td>
</tr>
<tr>
<td>Get Boot Volume Attachment</td>
<td></td>
<td>Gets information about the specified boot volume attachment.</td>
</tr>
<tr>
<td>Look up Boot Volume Attachments</td>
<td></td>
<td>Lists the boot volume attachments in the specified compartment.</td>
</tr>
<tr>
<td>Look up Boot Volumes</td>
<td></td>
<td>Lists the boot volumes in the specified compartment.</td>
</tr>
<tr>
<td>Update Boot Volume</td>
<td></td>
<td>Updates the specified boot volume.</td>
</tr>
</tbody>
</table>
Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the Oracle Boot Volume spoke

Integrate the ServiceNow instance and Oracle Boot Volume account by using the OCI SHA256WithRSA Signature credentials to authenticate ServiceNow requests.

Before you begin

• Activate and set up the Oracle Cloud IAM spoke v1.0.4
• Role required: admin

Procedure

1. Optional: Create a JKS certificate. You can create a JKS certificate for the Oracle Boot Volume spoke or use the certificate created for the Oracle Cloud IAM spoke. For information about creating the JKS Certificate, see Create a Java KeyStore (JKS) certificate.

2. Optional: Create X.509 certificate. You can create a X.509 certificate for the Oracle Boot Volume spoke or use the certificate created for the Oracle Cloud IAM spoke. For information about creating a X.509 certificate, see Create X.509 certificate for the Oracle Cloud IAM spoke.

3. Create credential record for the Oracle Boot Volume spoke.

   a. Navigate to Connections & Credentials > Credentials.

   b. Click New.

      The system displays this message: What type of Credentials would you like to create?

   c. Select OCI SHA256WithRSA Signature.

   d. On the form, fill these values.
Note: You can specify details of the certificates you created specifically for the Oracle Boot Volume spoke or specify details of the existing certificates you had created for the Oracle Cloud IAM spoke.

OCI SHA256WithRSA Signature Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Oracle Boot Vol Cred.</td>
</tr>
<tr>
<td>Certificate Sys ID</td>
<td>Sys ID of the Signing Certificate.</td>
</tr>
<tr>
<td>Alias</td>
<td>Alias of the KeyStore.</td>
</tr>
<tr>
<td>Alias Password</td>
<td>Alias password of the KeyStore.</td>
</tr>
<tr>
<td>Key ID</td>
<td>Key ID helps identify which key is used when multiple keys are used to sign tokens. The Key ID must be slash (/) separated values of Tenancy OCID, User OCID, and Fingerprint in this format: <code>ocid1.tenancy.oc1.&lt;unique_ID&gt;/ocid1.user.oc1.&lt;unique_ID&gt;/&lt;key_fingerprint&gt;</code>.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Option to specify if the credential applies to all MID Servers in the network.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select OCI SHA256RSA Signing Algorithm</td>
</tr>
</tbody>
</table>

e. Right-click the form header and click Submit.

4. Create connection record for the Oracle Boot Volume spoke.


b. Open the alias record of the Oracle Boot Volume spoke. For example, Oracle_Boot_Volume_Connection.

c. From the Connections tab, click New.

d. On the form, fill these fields.
Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Oracle Boot Volume Conn.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Oracle Boot Volume spoke. For example, Oracle Boot Vol Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to Oracle Boot Volume. For example,</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
</tbody>
</table>

e. Click Submit.

The ServiceNow instance and Oracle Boot Volume account are integrated. You can use the spoke actions to build flows and automate tasks as required.

Oracle Cloud IAM spoke v1.0.4

Manage user identities and user access in Oracle Infrastructure Identity and Access Management (IAM) from your ServiceNow instance.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

Supported versions

This spoke was built for Oracle Cloud IAM 20160918, but may be compatible with later versions.
Spoke requirements

- Oracle Cloud account

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- Complex Object (com.glide.cobject)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions

The Oracle Cloud IAM spoke provides actions to automate Oracle Cloud IAM tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compartment Management</td>
<td>Bulk Delete Resources</td>
<td>Deletes multiple resources from the specified compartment in a batch.</td>
</tr>
<tr>
<td></td>
<td>Bulk Move Resources</td>
<td>Moves multiple resources from one compartment to another in a batch.</td>
</tr>
<tr>
<td></td>
<td>Create Compartment</td>
<td>Creates a child compartment in the specified parent compartment.</td>
</tr>
<tr>
<td></td>
<td>Get Compartment</td>
<td>Retrieves details of the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Look up Compartments</td>
<td>Retrieves a list of compartments in the specified tenancy.</td>
</tr>
<tr>
<td></td>
<td>Move Compartment</td>
<td>Moves the specified child compartment to a different parent compartment.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>Recover Compartment</td>
<td>Recover Compartment</td>
<td>Recovers a deleted compartment and changes its state to active.</td>
</tr>
<tr>
<td></td>
<td>Update Compartment</td>
<td>Updates the specified compartment.</td>
</tr>
<tr>
<td>Group Management</td>
<td>Create Group</td>
<td>Creates a group in the specified tenancy.</td>
</tr>
<tr>
<td></td>
<td>Delete Group</td>
<td>Deletes the specified group.</td>
</tr>
<tr>
<td></td>
<td>Get Group</td>
<td>Retrieves information about the specified group.</td>
</tr>
<tr>
<td></td>
<td>Look up Groups</td>
<td>Retrieves a list of groups in the specified tenancy.</td>
</tr>
<tr>
<td></td>
<td>Update Group</td>
<td>Updates the specified group.</td>
</tr>
<tr>
<td>OCI Metadata</td>
<td>Get Tenancy</td>
<td>Retrieves information about the specified tenancy.</td>
</tr>
<tr>
<td></td>
<td>Look up Available Domains</td>
<td>Retrieves a list of availability domains in the specified tenancy.</td>
</tr>
<tr>
<td></td>
<td>Look up Regions</td>
<td>Retrieves a list of all the regions offered by Oracle Cloud Infrastructure.</td>
</tr>
<tr>
<td>Policy Management</td>
<td>Create Policy</td>
<td>Create a policy in the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Delete Policy</td>
<td>Deletes the specified policy.</td>
</tr>
<tr>
<td></td>
<td>Get Policy</td>
<td>Retrieves information of the specified policy.</td>
</tr>
<tr>
<td></td>
<td>Look up Policies</td>
<td>Retrieves a list of policies in the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Update Policy</td>
<td>Updates the specified policy.</td>
</tr>
<tr>
<td>User Management</td>
<td>Add User to Group</td>
<td>Adds the specified user to the specified group.</td>
</tr>
<tr>
<td></td>
<td>Create User</td>
<td>Creates a user.</td>
</tr>
<tr>
<td></td>
<td>Delete User</td>
<td>Deletes the specified user.</td>
</tr>
<tr>
<td></td>
<td>Get User</td>
<td>Retrieves the details of the specified user.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up User Group</td>
<td>Retrieves a list of the user group memberships in the specified tenancy.</td>
</tr>
<tr>
<td></td>
<td>Membership</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Look up Users</td>
<td>Retrieves a list of the users in the specified tenancy.</td>
</tr>
<tr>
<td></td>
<td>Remove User from Group</td>
<td>Removes a user from a group by deleting the corresponding user group membership.</td>
</tr>
<tr>
<td></td>
<td>Update User</td>
<td>Updates details of the specified user.</td>
</tr>
<tr>
<td></td>
<td>Update User Capabilities</td>
<td>Updates capabilities of the specified user.</td>
</tr>
<tr>
<td></td>
<td>Update User State</td>
<td>Unblocks the specified user.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the Oracle Cloud IAM spoke**
Integrate the ServiceNow instance and Oracle Cloud IAM by using the OCI SHA256WithRSA Signature credentials to authenticate ServiceNow requests.

**Before you begin**
- Request an IntegrationHub subscription.
- Activate Oracle Cloud IAM spoke.
- Role required: admin

**Create a Java KeyStore (JKS) certificate**
Use the keytool utility to generate, import, and export certificates.

**Before you begin**
Make sure that the keytool utility is installed on your computer.
**Procedure**

1. Change to the directory where the certificate is to be saved. By default, keytool creates a keystore file in the directory where the keystore commands are run.

2. Enter the following keytool command to generate the certificate in the keystore file, keystore.jks:
   
   ```
   keytool -genkey -alias <alias> -keyalg RSA -keypass <keypass> -storepass <storepass> -keystore keystore.jks
   ```

   **Note:** Replace the placeholders `<alias>`, `<keypass>`, and `<storepass>` with your alias, key password, and store password in all the sample commands.

3. Enter your first name and last name, organization, and other details in the keytool prompt. These details are required for generating the certificate.

4. Enter the following commands in the following sequence.
   
   ```
   keytool -export -alias sample -storepass <storepass> -file server.cer -keystore keystore.jks
   keytool -import -v -trustcacerts -alias sample -file server.cer -keystore cacerts.jks
   keytool -export -alias sample -keystore keystore.jks -rfc -file public.cert
   keytool -export -alias sample -keystore keystore.jks -rfc -file certificate.pem
   keytool -list -rfc -keystore keystore.jks -alias sample -storepass <storepass>
   keytool -importkeystore -srckeystore keystore.jks -destkeystore keystore.p12
   -deststoretype PKCS12 -srcalias <alias> -deststorepass <storepass> -destkeypass <keypass>
   openssl pkcs12 -in keystore.p12 -nokeys -out cert.pem
   openssl pkcs12 -in keystore.p12 -nodes -nocerts -out PrivateKey.pem
   openssl rsa -in key.pem -pubout -out PublicKey.pem
   keytool -list -v -keystore keystore.p12 -storetype PKCS12 -storepass <storepass>
   ```

   Verify the generated keystore.jks file in the target directory.

5. Enter the following command to extract public key from the Java Keystore file.
   
   ```
   openssl x509 -pubkey -noout -in cert.pem > publickey.pem
   ```

**Create X.509 certificate for the Oracle Cloud IAM spoke**

You must create a X.509 certificate and attach the Java Keystore file to it. This certificate is used for connecting to Oracle Cloud IAM.

**Before you begin**

Role required: admin
Procedure
1. Navigate to System Definition > Certificates.
2. Click New.
3. In the form, fill in these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name to identify the certificate. For example, OCI IAM certificate</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the certificate. Select Java Key Store.</td>
</tr>
<tr>
<td>Notify on expiration</td>
<td>List of persons who are to be notified when a certificate is about to expire.</td>
</tr>
<tr>
<td>Keystore password</td>
<td>Password of the keystore.</td>
</tr>
<tr>
<td>Warn in days to expire</td>
<td>Number of days when a warning is sent to the user before the certificate expires.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to make the certificate active.</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description for the keystore.</td>
</tr>
</tbody>
</table>

4. Click the attachments icon and upload the keystore.jks file.

Create a credential record for the Oracle Cloud IAM spoke
Create a credential record for the Oracle Cloud IAM account. The Oracle Cloud IAM spoke connection and credential alias uses these credentials to authorize actions.

Before you begin
Use the public key from the Java Keystore (JKS) file and generate a fingerprint from your Oracle Cloud account. For more information about fingerprint, see Required Keys and OCIDs.

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
The system displays this message: What type of Credentials would you like to create?

3. Select OCI SHA256WithRSA Signature.

4. On the form, fill these values.

### OCI SHA256WithRSA Signature Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Oracle IAM Cloud Cred.</td>
</tr>
<tr>
<td>Certificate Sys ID</td>
<td>Sys ID of the OCI Signing Certificate.</td>
</tr>
<tr>
<td>Alias</td>
<td>Alias of the KeyStore.</td>
</tr>
<tr>
<td>Alias Password</td>
<td>Alias password of the KeyStore.</td>
</tr>
<tr>
<td>Key ID</td>
<td>Key ID helps identify which key is used when multiple keys are used to sign tokens. The Key ID must be slash (/) separated values of Tenancy OCID, User OCID, and Fingerprint in this format: ocid1.tenancy.oc1..&lt;unique_ID&gt;/ocid1.user.oc1..&lt;unique_ID&gt;/&lt;key_fingerprint&gt;.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Option to specify if the credential applies to all MID Servers in the network.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select OCI SHA256RSA Signing Algorithm</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click Submit.

Create a connection record for the Oracle Cloud IAM spoke

Create a connection record for your Oracle Cloud IAM account. The Oracle Cloud IAM spoke connection and credential aliases use these connections to perform actions in Oracle Cloud IAM.

**Procedure**

1. Navigate to Connections & Credentials > Connections & Credentials Aliases.
2. Open the alias record for OracleIAM_credentialANDconnection.
3. From the Connections tab, click New.
4. On the form, fill these fields.
### Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Oracle IAM conn.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Oracle Autonomous DB spoke. For example, Oracle IAM Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection. Search and select sn_oc_iam_spoke.OracleIAM_credentialAN</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to Oracle Cloud IAM. For example, <a href="https://database.ap-mumbai-1.oraclecloud.com">https://database.ap-mumbai-1.oraclecloud.com</a>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Oracle Compute Engine spoke v1.0.1**

Manage images and instance in the Oracle Compute Engine account from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Supported versions**

This spoke was built for Oracle Compute Engine API version 20160918, but may be compatible with later versions.

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:
Spoke actions

The Oracle Compute Engine spoke provides actions to automate Oracle Compute Engine tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Image Management</td>
<td>Change Image Compartement</td>
<td>Moves an Image into a different compartment within the same tenancy.</td>
</tr>
<tr>
<td></td>
<td>Create Image</td>
<td>Creates a custom image in the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Delete Image</td>
<td>Deletes the specified custom image.</td>
</tr>
<tr>
<td></td>
<td>Export Image</td>
<td>Exports the specified image to the Oracle Cloud Infrastructure Object Storage service.</td>
</tr>
<tr>
<td></td>
<td>Get Image</td>
<td>Retrieves a specified custom image.</td>
</tr>
<tr>
<td></td>
<td>Look up Images</td>
<td>Retrieves a list of available images in the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Update Image</td>
<td>Updates details of the specified custom image.</td>
</tr>
<tr>
<td>Image Shape Compatibility</td>
<td>Add Image Shape Compatibility</td>
<td>Adds a shape to the compatible shapes list for the image.</td>
</tr>
</tbody>
</table>

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Delete Image Shape Compatibility</td>
<td>Deletes an image shape compatibility entry.</td>
</tr>
<tr>
<td></td>
<td>Get Image Shape Compatibility</td>
<td>Retrieves a specified image shape compatibility entry.</td>
</tr>
<tr>
<td></td>
<td>Look up Image Shape Compatibilities</td>
<td>Retrieves a list of all the compatible shapes for the specified image.</td>
</tr>
<tr>
<td>Instance Configuration Management</td>
<td>Change Instance Configuration Compartment</td>
<td>Moves an Instance Configuration into a different compartment within the same tenancy.</td>
</tr>
<tr>
<td></td>
<td>Create Instance Configuration</td>
<td>Creates an instance configuration.</td>
</tr>
<tr>
<td></td>
<td>Delete Instance Configuration</td>
<td>Deletes the specified instance configuration.</td>
</tr>
<tr>
<td></td>
<td>Get Instance Configuration</td>
<td>Gets the specified instance configuration.</td>
</tr>
<tr>
<td></td>
<td>Look up Instance Configurations</td>
<td>Retrieves a list of instance configurations in the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Update Instance Configuration</td>
<td>Updates details of the specified instance configuration.</td>
</tr>
<tr>
<td>Instance Management</td>
<td>Change Instance Compartment</td>
<td>Moves an Instance into a different compartment within the same tenancy.</td>
</tr>
<tr>
<td></td>
<td>Create Instance</td>
<td>Creates an instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Instance</td>
<td>Deletes a specified instance.</td>
</tr>
<tr>
<td></td>
<td>Get Instance</td>
<td>Retrieves information about the specified instance.</td>
</tr>
<tr>
<td></td>
<td>Instance Action</td>
<td>Performs a specified power action on an instance.</td>
</tr>
<tr>
<td></td>
<td>Look up Instances</td>
<td>Retrieves a list of instances in the specified compartment.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Update Instance</td>
<td>Updates details of the specified instance.</td>
</tr>
</tbody>
</table>

### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

### Set up the Oracle Compute Engine spoke

Integrate the ServiceNow instance and Oracle Compute Engine account by using the OCI SHA256WithRSA Signature credentials to authenticate ServiceNow requests.

#### Before you begin

- Activate and set up the Oracle Cloud IAM spoke v1.0.4
- Activate and set up the Oracle Object Storage Management spoke v1.0.1
- Role required: admin

#### Procedure

1. **Optional:** Create a JKS certificate. You can create a JKS certificate for the Oracle Compute Engine spoke or use the certificate created for the Oracle Cloud IAM spoke. For information about creating the JKS Certificate, see Create a Java KeyStore (JKS) certificate.

2. **Optional:** Create X.509 certificate. You can create a X.509 certificate for the Oracle Compute Engine spoke or use the certificate created for the Oracle Cloud IAM spoke. For information about creating a X.509 certificate, see Create X.509 certificate for the Oracle Cloud IAM spoke.

3. Create credential record for the Oracle Compute Engine spoke.
   
   a. Navigate to Connections & Credentials > Credentials.

   b. Click New.

      The system displays this message: What type of Credentials would you like to create?
c. Select **OCI SHA256WithRSA Signature**.

d. On the form, fill these values.

**Note:** You can specify details of the certificates you created specifically for the Oracle Compute Engine spoke or specify details of the existing certificates you had created for the Oracle Cloud IAM spoke.

### OCI SHA256WithRSA Signature Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Oracle CE Cred.</td>
</tr>
<tr>
<td>Certificate Sys ID</td>
<td>Sys ID of the Signing Certificate.</td>
</tr>
<tr>
<td>Alias</td>
<td>Alias of the KeyStore.</td>
</tr>
<tr>
<td>Alias Password</td>
<td>Alias password of the KeyStore.</td>
</tr>
<tr>
<td>Key ID</td>
<td>Key ID helps identify which key is used when multiple keys are used to sign tokens. The Key ID must be slash (/) separated values of Tenancy OCID, User OCID, and Fingerprint in this format: ocid1.tenancy.oc1..&lt;unique_ID&gt;/ocid1.user.oc1..&lt;unique_ID&gt;/&lt;key_fingerprint&gt;.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Option to specify if the credential applies to all MID Servers in the network.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Authentication Algorithm</td>
<td>Custom authentication algorithm for outbound signing requests. Select <strong>OCI SHA256RSA Signing Algorithm</strong></td>
</tr>
</tbody>
</table>

e. Right-click the form header and click **Submit**.

4. Create connection record for the Oracle Compute Engine spoke.

   a. Navigate to **Connections & Credentials > Connections & Credentials Aliases**.

   b. Open the alias record of the Oracle Boot Volume spoke. For example, **Oracle_Compute_Engine**.
c. From the Connections tab, click New.

d. On the form, fill these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Oracle CE Conn.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Oracle Boot Volume spoke. For example, Oracle CE Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to Oracle Compute Engine. For example, <a href="https://iaas.ap-mumbai-1.oraclecloud.com">https://iaas.ap-mumbai-1.oraclecloud.com</a>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
</tbody>
</table>

e. Click Submit.

The ServiceNow instance and Oracle Compute Engine account are integrated. You can use the spoke actions to build flows and automate tasks as required.

**Oracle EBS spoke v1.3**

Manage sales orders, procurement, finance, customers, ledgers, and so on, in the Oracle EBS instance from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**Note:** The packages should be redeployed when you are upgrading to the Oracle EBS spoke v1.1 from Oracle EBS spoke v1. For more information, see Set up the Oracle EBS spoke.
IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for these versions, but may be compatible with later versions.

- Operating system version: Oracle Linux 7
- Oracle database version: 19.6.0.0.0
- Oracle E-Business Suite application tier version: 12.2.9
- Oracle WebLogic Server version: 10.3.6.0.171017 PSU
- Oracle WebTier version: 11.1.1.9
- Oracle Forms and Reports: 10.1.2.3

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- Complex Object (com.glide.cobject)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke flows
The Oracle EBS spoke provides a sample flow, Look up Daily Rates to demonstrate automating tasks. The flow runs daily and retrieves the Daily Currency Exchange Rates from Oracle EBS for the current date and saves the details in your ServiceNow instance.

Spoke subflows
The Oracle EBS spoke provides sample subflows to demonstrate automating tasks. To customize a sample subflow, copy it to the required application scope. Available sample subflows include:
<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AP Invoices - Create Interface Entries</td>
<td>Creates interface entries of AP Invoices in Oracle EBS.</td>
</tr>
<tr>
<td>AP Invoices - Get Processing Details</td>
<td>Retrieves the concurrent program status and other details from Oracle EBS.</td>
</tr>
<tr>
<td>Fixed Assets - Create Interface Entries</td>
<td>Creates interface entries of fixed assets in Oracle EBS.</td>
</tr>
<tr>
<td>Fixed Assets - Get Processing Details</td>
<td>Retrieves the concurrent program status and other details from Oracle EBS.</td>
</tr>
<tr>
<td>Get Journal Posted Status</td>
<td>Retrieves the current status of a GL journal header.</td>
</tr>
<tr>
<td>Goods Receipts - Create Interface Entries</td>
<td>Creates interface entries of Goods Receipts in Oracle EBS.</td>
</tr>
<tr>
<td>Goods Receipts - Get Processing Details</td>
<td>Retrieves the concurrent program status and other details from Oracle EBS.</td>
</tr>
<tr>
<td>Purchase Orders - Create Interface Entries</td>
<td>Creates interface entries of purchase orders in Oracle EBS.</td>
</tr>
<tr>
<td>Purchase Orders - Get Processing Details</td>
<td>Retrieves the concurrent program status and other details from Oracle EBS.</td>
</tr>
</tbody>
</table>

**Spoke actions**

The Oracle EBS spoke provides actions to automate tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer</td>
<td>Look up Customer Accounts</td>
<td>Retrieves details of the customer accounts.</td>
</tr>
<tr>
<td></td>
<td>Look up Customer Contacts</td>
<td></td>
</tr>
<tr>
<td>Finance</td>
<td>Create AP Invoice</td>
<td>Creates an AP invoice.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Look up AR Invoices</td>
<td>Retrieves details of the AR invoices.</td>
<td></td>
</tr>
<tr>
<td>Create AP Invoice - Run Concurrent Program</td>
<td>Runs the concurrent program that imports invoice data from the interface table to the base table of Oracle EBS.</td>
<td></td>
</tr>
<tr>
<td>Create Fixed Assets</td>
<td>Creates a fixed asset.</td>
<td></td>
</tr>
<tr>
<td>Create Vendor</td>
<td>Creates a vendor.</td>
<td></td>
</tr>
<tr>
<td>Create Vendor Site</td>
<td>Creates a vendor site.</td>
<td></td>
</tr>
<tr>
<td>Get AP Invoice</td>
<td>Retrieves details of the required AP invoice.</td>
<td></td>
</tr>
<tr>
<td>Get Fixed Asset</td>
<td>Retrieves details of the required fixed asset.</td>
<td></td>
</tr>
<tr>
<td>Get Ship To Location</td>
<td>Retrieves details of the required shipped location.</td>
<td></td>
</tr>
<tr>
<td>Get Vendor</td>
<td>Retrieves details of the required vendor.</td>
<td></td>
</tr>
<tr>
<td>Get Vendor Site</td>
<td>Retrieves details of the required vendor site.</td>
<td></td>
</tr>
<tr>
<td>Import Fixed Asset - Run Concurrent Program</td>
<td>Runs the concurrent program that imports the fixed asset data from the interface table to base table of Oracle EBS.</td>
<td></td>
</tr>
<tr>
<td>Look up AP Invoices</td>
<td>Retrieves details of the required AP invoices based on criteria specified in the query.</td>
<td></td>
</tr>
<tr>
<td>Look up Daily Rate</td>
<td>Retrieves details of the specified daily rate based on the input criteria.</td>
<td></td>
</tr>
<tr>
<td>Look up Daily Rates</td>
<td>Retrieves details of all the daily rate.</td>
<td></td>
</tr>
<tr>
<td>Look up Fixed Assets</td>
<td>Retrieves details of the required fixed assets based on the input criteria.</td>
<td></td>
</tr>
<tr>
<td>Look up Legal Entities</td>
<td>Retrieves details about the legal entities.</td>
<td></td>
</tr>
<tr>
<td>Look up Ship To Locations</td>
<td>Retrieves details of the required shipped locations based on the input criteria.</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Look up Vendor Sites</td>
<td>Retrieves details of the required vendor sites based on the input criteria.</td>
<td></td>
</tr>
<tr>
<td>Look up Vendors</td>
<td>Retrieves details of the required vendors based on the input criteria.</td>
<td></td>
</tr>
<tr>
<td>Journal Ledger</td>
<td>Create Journals</td>
<td>Creates a journal.</td>
</tr>
<tr>
<td></td>
<td>Get GL Journal Batch</td>
<td>Retrieves details of the required GL journal batch.</td>
</tr>
<tr>
<td></td>
<td>Get GL Journal Header</td>
<td>Retrieves details of the required GL journal header.</td>
</tr>
<tr>
<td></td>
<td>Get GL Ledger</td>
<td>Retrieves details of the required GL ledger.</td>
</tr>
<tr>
<td></td>
<td>Get GL Subledger Account</td>
<td>Retrieves details of the required GL subledger account.</td>
</tr>
<tr>
<td></td>
<td>Import Journals - Run Concurrent Program</td>
<td>Runs the concurrent program that imports journals data from the interface table to the base table of Oracle EBS.</td>
</tr>
<tr>
<td></td>
<td>Look up GL Balance</td>
<td>Retrieves details of the required GL balance based on the input criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up GL Balances</td>
<td>Retrieves details of the required GL balance based on the input query.</td>
</tr>
<tr>
<td></td>
<td>Look up GL Code Combinations</td>
<td>Retrieves details of the required GL code combinations based on the input query.</td>
</tr>
<tr>
<td></td>
<td>Look up GL Journals</td>
<td>Retrieves details of the required GL journals based on the input criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up GL Ledgers</td>
<td>Retrieves details of the required GL ledgers based on the input criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up GL Subledger Accounts</td>
<td>Retrieves details of the required GL subledger accounts based on the input criteria.</td>
</tr>
<tr>
<td></td>
<td>Post Journals - Run Concurrent Program</td>
<td>Runs the concurrent program that posts the unposted journals.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Reverse Journals - Run Concurrent Program</td>
<td>Runs the concurrent program that reverses the posted journals.</td>
</tr>
<tr>
<td>Master</td>
<td>Create Item</td>
<td>Creates an item.</td>
</tr>
<tr>
<td></td>
<td>Get Records</td>
<td>Retrieves data from any Oracle EBS module using an SQL query.</td>
</tr>
<tr>
<td></td>
<td>Look up Cost Center</td>
<td>Retrieves details about the required cost center.</td>
</tr>
<tr>
<td></td>
<td>Look up Cost Centers</td>
<td>Retrieves details about the multiple cost centers based on the input query.</td>
</tr>
<tr>
<td></td>
<td>Look up Item</td>
<td>Retrieves details about the required item.</td>
</tr>
<tr>
<td></td>
<td>Look up Item Categories</td>
<td>Retrieves details about the required item categories.</td>
</tr>
<tr>
<td></td>
<td>Look up Item Category</td>
<td>Retrieves details about the required item category.</td>
</tr>
<tr>
<td></td>
<td>Look up Items</td>
<td>Retrieves details of multiple items based on the input criteria.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get Additional EBS Fields</td>
<td>Retrieves the additional Oracle EBS fields.</td>
</tr>
<tr>
<td>Procurement</td>
<td>Cancel Purchase Order</td>
<td>Cancels the specified purchase order.</td>
</tr>
<tr>
<td></td>
<td>Create Goods Receipt - Run Concurrent Program</td>
<td>Runs the concurrent program that imports the receipt data from interface table to base table of Oracle EBS.</td>
</tr>
<tr>
<td></td>
<td>Create Goods Receipts</td>
<td>Creates a goods receipt.</td>
</tr>
<tr>
<td></td>
<td>Create Purchase Order</td>
<td>Creates a purchase order.</td>
</tr>
<tr>
<td></td>
<td>Create Purchase Order - Run Concurrent Program</td>
<td>Runs the concurrent program that imports the purchase order data from the interface table to the base table of Oracle EBS.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get Advance Shipment Notice</td>
<td>Retrieves details of the required advance shipment notice.</td>
</tr>
<tr>
<td></td>
<td>Look up Advance Shipment Notices</td>
<td>Retrieves details of multiple advance shipment notices based on the input query.</td>
</tr>
<tr>
<td></td>
<td>Update Purchase Order</td>
<td>Updates the specified purchase order.</td>
</tr>
<tr>
<td>Sales Order</td>
<td>Look up Sales Order Status</td>
<td>Retrieves the status of the required sales order and other relevant details.</td>
</tr>
<tr>
<td></td>
<td>Look up Sales Orders</td>
<td>Retrieves details of multiple sales orders based on the input query.</td>
</tr>
<tr>
<td>Bills and Payments</td>
<td>Look up Bill Details</td>
<td>Retrieves details of the required bills.</td>
</tr>
<tr>
<td></td>
<td>Look up Outstanding Balances</td>
<td>Retrieves details of the required outstanding balances.</td>
</tr>
<tr>
<td></td>
<td>Look up Payment Details</td>
<td>Retrieves details of the required payments.</td>
</tr>
<tr>
<td></td>
<td>Look up Payment Status</td>
<td>Retrieves status of the required payments.</td>
</tr>
<tr>
<td>Customer</td>
<td>Create Customer Account</td>
<td>Creates a customer account.</td>
</tr>
<tr>
<td></td>
<td>Create Customer Account Role</td>
<td>Creates a customer account role.</td>
</tr>
<tr>
<td></td>
<td>Create Customer Contact</td>
<td>Creates a customer account contact.</td>
</tr>
<tr>
<td></td>
<td>Create Customer Relation</td>
<td>Creates a customer relation record.</td>
</tr>
<tr>
<td></td>
<td>Create Person</td>
<td>Creates a person record.</td>
</tr>
<tr>
<td></td>
<td>Look up Customer Accounts</td>
<td>Retrieves details of the required customer accounts.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up Customer Contacts</td>
<td>Retrieves the required customer contacts.</td>
</tr>
<tr>
<td></td>
<td>Update Customer Account</td>
<td>Updates details of the required customer account.</td>
</tr>
<tr>
<td></td>
<td>Update Customer Contact</td>
<td>Updates details of the required customer contact.</td>
</tr>
<tr>
<td>Sales Order</td>
<td>Look up Sales Order Status Stream</td>
<td>Retrieves status details of the required sales orders.</td>
</tr>
<tr>
<td></td>
<td>Look up Sales Order Stream</td>
<td>Retrieves details of the required sales orders.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Oracle EBS alias to configure where actions run as well as set MID Server selection attributes. For more information about running actions on the MID Server, see Integration steps.

ℹ️ **Note:** If your Oracle EBS instance is only accessible on a private network, you must use MID Server.

**Set up the Oracle EBS spoke**

Integrate the ServiceNow instance and your Oracle EBS instance using a basic authentication to authenticate the ServiceNow requests.
Before you begin

- Request IntegrationHub subscription.
- Activate the Oracle EBS spoke.
- Admin access to the Oracle EBS account.
- Role required: admin

Procedure

1. From the ServiceNow® Store download the project file, Oracle_e-business_suite spoke_dependencies.zip and save it in the required local folder.
2. Unzip the contents of the Oracle_e-business_suite spoke_dependencies.zip file.
3. In SQL Developer or an SQL client, compile all the PKB and PLS files in the APPS schema.
4. In Oracle EBS server, deploy the Oracle EBS REST API. For steps to enable the REST API per extension, see Administering Custom Integration Interfaces and Services.
   
   You must perform these steps for every PLS file. While deploying each PLS file, you must provide the relevant values. Here, the procedure is outlined using XXSN_CREATE_PO_PKG.pls as an example.
a. Copy and upload the compiled package .pls files to these respective directories:

- `$PO_TOP/patch/115/sql/tmp/
- `$PO_TOP/patch/115/sql/

**Note:** Ensure that you replace the `$PO_TOP` with the module the package belongs to such as, `$AP_TOP`, `$PO_TOP`, and so on.

b. Log in to PuTTY of your Oracle EBS server and execute the Integration Repository Parser.

i. To generate an iLDT (*.ildt) file, execute the Integration Repository Parser using this syntax:

```
$IAS_ORACLE_HOME/perl/bin/perl $FND_TOP/bin/irep_parser.pl -g -v -username=sysadmin
po:patch/115/sql:XXSN_CREATE_PO_PKG.pls:12.0=$PO_TOP/patch/115/sql/tmp/XXSN_CREATE_PO_PKG.pls
```

ii. If you aren’t generating .ildt file for the XXSN_CREATE_PO_PKG.pls file, replace `po` and `$PO_TOP` with required Top.

iii. If you aren’t generating .ildt file for the XXSN_CREATE_PO_PKG.pls file, replace `XXSN_CREATE_PO_PKG.pls` with the required package name.

```
# Interface Repository Annotation Processor, 12.0.0
#
# Generating annotation output.
# Processing file 'XXSN_CREATE_PO_PKG.pls'.
# Using YAPP-based parser.
# Found a package-level annotation for 'XXSN_CREATE_PO_PKG'.
# Found a detail-level annotation...
# Found a procedure named 'CREATE_PURCHASE_ORDER'.
# Found a detail-level annotation...
# Found a procedure named 'SUBMIT_PURCHASE_ORDER_CC'.
# Found a detail-level annotation...
# Found a procedure named 'CANCEL_PO'.
# Done all files.
```

c. Upload the generated iLDT file to Integration repository by executing this command:

```
$fnd_top/bin/fndload apps/apps 0 Y UPLOAD $fnd_top/patch/115/import/wfirep.lct
XXSN_CREATE_PO_PKG_pls.ildt
```

**Note:** Replace `XXSN_CREATE_PO_PKG` with the required package name.
d. Log in to your Oracle E-Business Suite instance as system administrator.

e. Switch to the Integrated SOA Gateway responsibility and select Integration Repository.

f. Search for the web service with the internal name, XXSN_CREATE_PO_PKG.

g. Click the link in the search result to access the list of available methods in the interface package.
Note: In the PL/SQL interface type, both SOAP and REST web services are available. However, this procedure focuses on the REST web service.

h. Click the REST Web Service tab.

i. Set an alias for this service. For example, hr.

ii. Click Deploy.

i. To view the Create PO method, click the REST Web Service tab.
j. Enter the unique service alias name, select the **Create PO** method, and click **Deploy**.
A confirmation message is displayed that the service is successfully deployed.

**k.** Click **View WADL** to access the physical location of the service endpoint where the service is hosted.

**l.** Open the **Grants** tab, select **Create PO**, and click **Create Grant**.

**m.** Select a grantee type, enter the user name to whom you want to give the grant access to use the web service, and click **Create Grant**.
A confirmation message is displayed mentioning that the grant has been successfully created.

**Note:** To revoke grant, click **Revoke Grants** in the **Grants** tab and select the required users.

Perform the above steps for all the required actions and ensure that you use the same names (associated with the respective action) as mentioned in the Resource Path column of the following table:
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Category</th>
<th>Resource Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel Purchase Order</td>
<td>Procurement</td>
<td>webservices/rest/create_purchase_order/cancel_poi/</td>
</tr>
<tr>
<td>Create AP Invoice</td>
<td>Finance</td>
<td>webservices/rest/create_ap_invoice/create_ap_invoice/</td>
</tr>
<tr>
<td>Create AP Invoice - Run Concurrent Program</td>
<td>Finance</td>
<td>webservices/rest/create_ap_invoice/submit_ap_invoice/cce/</td>
</tr>
<tr>
<td>Create Customer Account</td>
<td>Customer</td>
<td>webservices/rest/create_customer_account/create_customer_account/</td>
</tr>
<tr>
<td>Create Customer Account Role</td>
<td>Customer</td>
<td>webservices/rest/create_customer_account_role/create_customer_account_role/</td>
</tr>
<tr>
<td>Create Customer Contact</td>
<td>Customer</td>
<td>webservices/rest/create_customer_contact/create_customer_contact/</td>
</tr>
<tr>
<td>Create Customer Relation</td>
<td>Customer</td>
<td>webservices/rest/create_customer_relation/create_customer_relation/</td>
</tr>
<tr>
<td>Create Fixed Assets</td>
<td>Finance</td>
<td>webservices/rest/create_fa_mass/create_fa_entries/</td>
</tr>
<tr>
<td>Create Goods Receipt - Run Concurrent Program</td>
<td>Procurement</td>
<td>webservices/rest/create_po_gr/submit_rcv_order/receipts/cce/</td>
</tr>
<tr>
<td>Create Goods Receipts</td>
<td>Procurement</td>
<td>webservices/rest/create_supplier/receipts/cce/</td>
</tr>
<tr>
<td>Create Item</td>
<td>Master</td>
<td>webservices/rest/item/process_item/</td>
</tr>
<tr>
<td>Create Journals</td>
<td>Journal Ledger</td>
<td>webservices/rest/create_jl/create_journals/</td>
</tr>
<tr>
<td>Create Person</td>
<td>Customer</td>
<td>webservices/rest/create_person/create_person/</td>
</tr>
<tr>
<td>Create Purchase Order</td>
<td>Procurement</td>
<td>webservices/rest/create_purchase_order/create_purchase_order/</td>
</tr>
<tr>
<td>Create Purchase Order - Run Concurrent Program</td>
<td>Procurement</td>
<td>webservices/rest/create_purchase_order/submit_purchase_order/cce/</td>
</tr>
<tr>
<td>Create Vendor</td>
<td>Finance</td>
<td>webservices/rest/supplier/create_vendor/</td>
</tr>
<tr>
<td>Create Vendor Site</td>
<td>Finance</td>
<td>webservices/rest/supplier/create_vendor_site/</td>
</tr>
<tr>
<td>Generate Input Payload With Crossreference</td>
<td>Utility Actions</td>
<td>N/A</td>
</tr>
<tr>
<td>Get Additional EIS Fields</td>
<td>Utility Actions</td>
<td>N/A</td>
</tr>
<tr>
<td>Get Advance Shipment Notice</td>
<td>Procurement</td>
<td>webservices/rest/get_adv_ship_notice_info/get_ship_notice_info/</td>
</tr>
<tr>
<td>Get AP Invoice</td>
<td>Finance</td>
<td>webservices/rest/get_inv_info/get_invoice_info/</td>
</tr>
<tr>
<td>Get Fixed Asset</td>
<td>Finance</td>
<td>webservices/rest/get_fa_inv_info/get_fixed_asset_info/</td>
</tr>
<tr>
<td>Get GL Journal Batch</td>
<td>Journal Ledger</td>
<td>webservices/rest/get_gl_journals/gl_journals_info/</td>
</tr>
<tr>
<td>Get GL Journal Header</td>
<td>Journal Ledger</td>
<td>webservices/rest/get_gl_journals/gl_journals_info/</td>
</tr>
<tr>
<td>Get GL Ledger</td>
<td>Journal Ledger</td>
<td>webservices/rest/get_gl_ledger/gl_ledgers_info/</td>
</tr>
<tr>
<td>Get GL Subledger Account</td>
<td>Journal Ledger</td>
<td>webservices/rest/get_gl_subledger/subledger_info/</td>
</tr>
<tr>
<td>Get OEBs Processed Records</td>
<td>Utility Actions</td>
<td>webservices/rest/get_oeb_processed_records/</td>
</tr>
<tr>
<td>Get Records</td>
<td>Utility Actions</td>
<td>webservices/rest/get_records/</td>
</tr>
<tr>
<td>Get Ship To Location</td>
<td>Finance</td>
<td>webservices/rest/get_ship_to_location/</td>
</tr>
<tr>
<td>Get Vendor</td>
<td>Finance</td>
<td>webservices/rest/get_vendor_info/get_vendor_info/</td>
</tr>
<tr>
<td>Get Vendor Site</td>
<td>Finance</td>
<td>webservices/rest/get_vendor_site/get_vendor_site/</td>
</tr>
<tr>
<td>Import Fixed Asset - Run Concurrent Program</td>
<td>Finance</td>
<td>webservices/rest/import_fixed_asset/</td>
</tr>
<tr>
<td>Import Journals - Run Concurrent Program</td>
<td>Journal Ledger</td>
<td>webservices/rest/import_journals/import_journals/</td>
</tr>
<tr>
<td>Look up Advance Shipment Notices</td>
<td>Procurement</td>
<td>webservices/rest/get_adv_ship_notice_info/get_shipment_info/</td>
</tr>
<tr>
<td>Look up AP Invoices</td>
<td>Finance</td>
<td>webservices/rest/get_ap_inv_info/get_ap_inv_info/</td>
</tr>
<tr>
<td>Look up AR Invoices</td>
<td>Finance</td>
<td>webservices/rest/get_ar_inv_info/get_ar_inv_info/</td>
</tr>
<tr>
<td>Look up Bill Details</td>
<td>Bills and Payment</td>
<td>webservices/rest/get_bill_detail_info/get_bill_detail_info/</td>
</tr>
<tr>
<td>Look up Cost Center</td>
<td>Master</td>
<td>webservices/rest/get_cost_center_info/get_cost_center_info/</td>
</tr>
<tr>
<td>Look up Cost Centers</td>
<td>Master</td>
<td>webservices/rest/get_cost_center_info/get_cost_center_info/</td>
</tr>
<tr>
<td>Look up Customer Accounts</td>
<td>Customer</td>
<td>webservices/rest/get_customer_account/customer_accounts/</td>
</tr>
<tr>
<td>Look up Customer Contacts</td>
<td>Customer</td>
<td>webservices/rest/get_customer_contact/customer_contacts/</td>
</tr>
<tr>
<td>Look up Daily Rate</td>
<td>Finance</td>
<td>webservices/rest/get_daily_rate/get_daily_rate_info/</td>
</tr>
<tr>
<td>Look up Daily Rates</td>
<td>Finance</td>
<td>webservices/rest/get_daily_rate/get_daily_rate_info/</td>
</tr>
<tr>
<td>Look up GL Balance</td>
<td>Journal Ledger</td>
<td>webservices/rest/get_gl_balances/gl_balances_info/</td>
</tr>
<tr>
<td>Look up GL Balances</td>
<td>Journal Ledger</td>
<td>webservices/rest/get_gl_balances/gl_balances_info/</td>
</tr>
<tr>
<td>Look up GL Code Combinations</td>
<td>Journal Ledger</td>
<td>webservices/rest/get_code_combinations/get_code_combinations/</td>
</tr>
<tr>
<td>Look up GL Journals</td>
<td>Journal Ledger</td>
<td>webservices/rest/get_gl_journals/gl_journals_info/</td>
</tr>
<tr>
<td>Look up GL Ledgers</td>
<td>Journal Ledger</td>
<td>webservices/rest/get_gl_ledgers/gl_ledgers_info/</td>
</tr>
<tr>
<td>Look up GL Subledger Accounts</td>
<td>Journal Ledger</td>
<td>webservices/rest/get_gl_subledger/subledger_accounts/</td>
</tr>
<tr>
<td>Look up Item</td>
<td>Master</td>
<td>webservices/rest/get_item_info/get_item_info/</td>
</tr>
<tr>
<td>Look up Item Categories</td>
<td>Master</td>
<td>webservices/rest/get_item_categories/item_categories/</td>
</tr>
<tr>
<td>Look up Item Category</td>
<td>Master</td>
<td>webservices/rest/get_item_categories/item_categories/</td>
</tr>
<tr>
<td>Look up Items</td>
<td>Master</td>
<td>webservices/rest/get_items_info/item_info/</td>
</tr>
<tr>
<td>Look up Legal Entity</td>
<td>Finance</td>
<td>webservices/rest/get_legal_entity_info/get_legal_entity_info/</td>
</tr>
<tr>
<td>Look up Legal Entity</td>
<td>Finance</td>
<td>webservices/rest/get_legal_entity_info/get_legal_entity_info/</td>
</tr>
<tr>
<td>Look up Outstanding Balances</td>
<td>Bills and Payment</td>
<td>webservices/rest/get_outstanding_bills_info/get_outstanding_bills_info/</td>
</tr>
<tr>
<td>Look up Payment Details</td>
<td>Bills and Payment</td>
<td>webservices/rest/get_payment_info/get_payment_details_info/</td>
</tr>
<tr>
<td>Look up Payment Status</td>
<td>Bills and Payment</td>
<td>webservices/rest/get_payment_info/get_payment_details_info/</td>
</tr>
<tr>
<td>Look up Sales Order Status</td>
<td>Sales Orders</td>
<td>webservices/rest/get_sales_orders_info/get_sales_orders_info/</td>
</tr>
<tr>
<td>Look up Sales Orders</td>
<td>Sales Orders</td>
<td>webservices/rest/get_sales_orders_info/get_sales_orders_info/</td>
</tr>
<tr>
<td>Look up Ship To Locations</td>
<td>Finance</td>
<td>webservices/rest/get_ship_to_location/</td>
</tr>
<tr>
<td>Look up Vendor Sites</td>
<td>Finance</td>
<td>webservices/rest/vendor_sites/vendor_sites_info/</td>
</tr>
<tr>
<td>Look up Vendors</td>
<td>Finance</td>
<td>webservices/rest/vendor_info/vendor_info/</td>
</tr>
<tr>
<td>Parse OEBs Record Details</td>
<td>Utility Actions</td>
<td>N/A</td>
</tr>
<tr>
<td>Post Journals - Run Concurrent Program</td>
<td>Journal Ledger</td>
<td>webservices/rest/post_journals/post_journals/</td>
</tr>
<tr>
<td>Reverse Journals - Run Concurrent Program</td>
<td>Journal Ledger</td>
<td>webservices/rest/reverse_journals/reverse_journals/</td>
</tr>
<tr>
<td>Update Customer Account</td>
<td>Customer</td>
<td>webservices/rest/update_customer_account/update_customer_account/</td>
</tr>
<tr>
<td>Update Customer Contact</td>
<td>Customer</td>
<td>webservices/rest/update_customer_contact/update_customer_contact/</td>
</tr>
<tr>
<td>Update Purchase Order</td>
<td>Procurement</td>
<td>webservices/rest/update_purchase_order/update_purchase_order/</td>
</tr>
</tbody>
</table>
o. Restart the server and using PuTTY, perform these steps up on logging in to the Oracle EBS server.

i. Execute the commands: `cd $ADMIN_SCRIPTS_HOME` and `./adadminsrvctl.sh stop`.

ii. Enter the WebLogic password and EBS password.

iii. Execute the command, `./adadminsrvctl.sh start`.

iv. Enter the WebLogic password and EBS password.

v. To check the status, execute the command, `./adadminsrvctl.sh status`.

5. Create a credential record for the Oracle EBS spoke.

a. Navigate to Connections & Credentials > Credentials.

b. Click New.
   The system displays the message What type of Credentials would you like to create?.

c. Select Basic Auth Credentials.

d. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the credential record. For example, OEBS Cred.</td>
</tr>
<tr>
<td>User name</td>
<td>User name to log in to the Oracle EBS instance.</td>
</tr>
<tr>
<td>Password</td>
<td>Password to log in to the Oracle EBS instance.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
</tbody>
</table>

e. Click Submit.

6. Create a connection record for the Oracle EBS spoke.

b. Open the record for the Oracle EBS spoke.

c. From the Connections tab, click New.

d. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, OEBS Conn.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for the Oracle EBS spoke.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Connection URL to connect to your Oracle EBS instance.</td>
</tr>
</tbody>
</table>

e. Click Submit.

**Oracle Financial Cloud spoke v1.0.3**

Manage invoices, ledger, and records in Oracle Financial Cloud instance from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Supported versions**

This spoke was built for Oracle Financial Cloud API version 11.13.18.05, but may be compatible with later versions.
Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- Utility Actions spoke v1.0.1
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- ServiceNow Flow Designer - Dynamic Outputs (com.glide.hub.dynamic_outputs)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke flows
The Oracle Financial Cloud spoke provides sample flows to demonstrate automating the Oracle Financial Cloud tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Accounted AP Invoices</td>
<td>Retrieves information about the accounted AP invoices. This flow triggers the Get Accounted AP Invoice subflow and includes the Look up Record Details action.</td>
</tr>
<tr>
<td>Import Journals</td>
<td>Imports the journal records from your ServiceNow instance to Oracle Financial Cloud system. To import the journal records, you must create the required records in the GL Interface module.</td>
</tr>
<tr>
<td>Import AP Invoices</td>
<td>Imports accounts payable invoice line and accounts payable invoice records from your ServiceNow instance to Oracle Financial Cloud system. To import the accounts payable invoice line and accounts payable invoice records, you must create the required records in the AP Invoices Interface and AP Invoices Lines Interface modules respectively.</td>
</tr>
</tbody>
</table>
Note: The success message displayed after flow executions during the data imports from ServiceNow instance to Oracle Financial Cloud system, only indicates that data has been successfully pushed to Oracle Financial Cloud system. You must verify that the data import is successfully completed by accessing the Oracle Financial Cloud system.

Spoke subflows
The Oracle Financial Cloud spoke provides sample subflow, Get Accounted AP Invoice, to demonstrate automating Oracle Financial Cloud tasks. The subflow retrieves the accounted AP invoice records and is used in the Get Accounted AP Invoices flow. To customize the sample subflow, copy it to a new application scope.

Spoke actions
The Oracle Financial Cloud spoke provides actions to automate Oracle Financial Cloud tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Record Management</td>
<td>Create Record</td>
<td>Creates an object.</td>
</tr>
<tr>
<td></td>
<td>Look up Record Details</td>
<td>Retrieves record details in an object.</td>
</tr>
<tr>
<td></td>
<td>Look up Record Details By ID</td>
<td>Retrieves details of the specified record in an object.</td>
</tr>
<tr>
<td></td>
<td>Import AP Invoices</td>
<td>Imports the actionable payment invoices.</td>
</tr>
<tr>
<td></td>
<td>Look up AP Invoice Lines</td>
<td>Retrieves information about the accounts payable invoice lines.</td>
</tr>
<tr>
<td></td>
<td>Look up AP Invoices</td>
<td>Retrieves information about the actionable payment invoices.</td>
</tr>
<tr>
<td>Currency Conversion</td>
<td>Look up Currency Rates</td>
<td>Retrieves information about the currency rates.</td>
</tr>
<tr>
<td>General Ledger</td>
<td>Get Code Combinations Details</td>
<td>Retrieves information about the code combinations.</td>
</tr>
<tr>
<td></td>
<td>Get Subledger Balances</td>
<td>Retrieves information about the subledger balances.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Import Journals</td>
<td>Imports details about the journals.</td>
</tr>
<tr>
<td></td>
<td>Look up Ledger Balance</td>
<td>Retrieves information about the ledger balances.</td>
</tr>
<tr>
<td>Supplier Record Management</td>
<td>Look up Suppliers</td>
<td>Retrieves information about the suppliers.</td>
</tr>
</tbody>
</table>

**Spoke modules**

The Oracle Financial Cloud spoke adds the Oracle Financial Cloud application to your instance and includes these modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounted AP Invoices</td>
<td>Displays information about the accounted AP invoices. This information is retrieved when the Get Accounted AP Invoices flow is triggered.</td>
</tr>
<tr>
<td>AP Invoices Interface</td>
<td>Displays the accounts payable invoice records. Admin must create these records in the ServiceNow instance in this module. The Import AP Invoices flow imports these invoices from your ServiceNow instance to Oracle Financial Cloud system.</td>
</tr>
<tr>
<td>AP Invoices Lines Interface</td>
<td>Displays the accounts payable invoice line records. Admin must create these records in the ServiceNow instance in this module. The Import AP Invoices flow imports these invoices from your ServiceNow instance to Oracle Financial Cloud system.</td>
</tr>
<tr>
<td>BI Report Paths</td>
<td>Displays information about the folder path where the required report is saved. The Get Subledger Balances and Get Code Combinations Details actions retrieve the subledger balances from these folder paths. Admin must create two records for the two actions and specify the folder path in this module.</td>
</tr>
<tr>
<td>Module</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Get Currency Rates</td>
<td>Displays information about the currency rates. The currency rates are retrieved from the remote table, Get Currency Rates [sn_ofc_spoke_st_get_currency_rates]. You can use the remote table as reference and create another remote table for currency rates as per your requirement.</td>
</tr>
<tr>
<td>GL Interface</td>
<td>Displays the journal records. The Import Journals flow imports these records from your ServiceNow instance to Oracle Financial Cloud system. Admin must create the required journal records in this module.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

Two connection and credential records are available along with the spoke. You must configure these alias record to use the spoke. See [Set up the Oracle Financial Cloud spoke](#) for more information.

**Note:** Depending on the Oracle Financial Cloud policies and account settings, you may have to change or refresh the credentials in your credential record periodically.

**Set up the Oracle Financial Cloud spoke**

Integrate the ServiceNow instance and Oracle Financial Cloud instance by using the basic auth credentials to authenticate ServiceNow requests.
Before you begin

- Request an IntegrationHub subscription.
- Activate Oracle Financial Cloud spoke.
- Role required: admin

Create a credential record for the Oracle Financial Cloud spoke

Create a credential record for your Oracle Financial Cloud server. The Oracle Financial Cloud spoke connection and credential alias uses these credentials to authorize actions.

Procedure

1. Navigate to Connections & Credentials > Credentials.

2. Click New.

   The system displays this message: What type of Credentials would you like to create?

3. Select Basic Auth Credentials.

4. On the form, fill these values.

   Basic Auth Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, OFC Cred.</td>
</tr>
<tr>
<td>User name</td>
<td>User name to log in to your Oracle Financial Cloud server.</td>
</tr>
<tr>
<td>Password</td>
<td>Password to authenticate and log in to your Oracle Financial Cloud server.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, 100.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias associated with the spoke.</td>
</tr>
</tbody>
</table>

Note: Depending on the Oracle Financial Cloud policies and account settings, you may have to change or refresh the credentials in your credential record periodically.

5. Click Submit.
Create a connection record for the Oracle Financial Cloud spoke

Create a connection record for your Oracle Financial Cloud server. The Oracle Financial Cloud spoke connection and credential aliases use these connections to perform actions in Oracle Financial Cloud.

Procedure
1. Navigate to Connections & Credentials > Connections & Credentials Aliases.
2. Open the alias record, OracleCloudFinancials.
3. From the Connections tab, click New.
4. On the form, fill these fields.

Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, OFC Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Oracle Financial Cloud spoke. For example, OFC Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to the server on which Oracle Financial Cloud is installed.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
</tbody>
</table>

5. Click Submit.
7. Open the alias record, OracleCloudFinancialsReport.
8. From the Connections tab, click New. This connection record is required to generate and import custom reports using the public report service.
9. On the form, fill these fields.

Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, OFC Reports Conn.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record is not required for this connection.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to the Oracle Financial Cloud public report service. Enter the URL in this format, <code>https://&lt;oracle-financial-cloud-host&gt;/xmlpserver/services/PublicReportService</code></td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
</tbody>
</table>

10. In the **Attributes** tab, provide these values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td>Password to authenticate and log in to your Oracle Financial Cloud account.</td>
</tr>
<tr>
<td>User Name</td>
<td>User name with permission to access the public report service, to log in to your Oracle Financial Cloud account.</td>
</tr>
</tbody>
</table>

11. Click **Submit**.

**What to do next**
Create the required records in these spoke modules:

- AP Invoices Interface
- AP Invoices Lines Interface
- BI Report Paths
- GL Interface

**Oracle HCM Cloud spoke v2.1**
Manage workstructures and human capital in Oracle HCM Cloud instance from your ServiceNow instance.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Oracle HCM Cloud API version 11.13.18.05, but may be compatible with later versions.

Spoke requirements
• Oracle HCM Cloud subscription

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
• ServiceNow Flow Designer - Dynamic Outputs (com.glide.hub.dynamic_outputs)
• ServiceNow IntegrationHub Action Step - SOAP (com.glide.hub.action_step.soap)
• Large JSON and XML Payload Builder API (com.glide.streaming_builder)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke subflows
The Oracle HCM spoke provides sample subflows to demonstrate automating Oracle HCM Cloud tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:
### Subflow

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Active</td>
<td>Retrieves the active Department information by calling the <strong>Look up Departments</strong> action.</td>
</tr>
</tbody>
</table>

### Spoke actions

The Oracle HCM spoke provides actions to automate tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Record Management</td>
<td>Look up Record Details</td>
<td>Retrieves all record details.</td>
</tr>
<tr>
<td></td>
<td>Look up Benefit Enrollments</td>
<td>Retrieves the benefit enrollment details of an employee.</td>
</tr>
<tr>
<td>Compensation Management</td>
<td>Get Total Rewards</td>
<td>Retrieves the total rewards details of the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Look up Individual Compensation</td>
<td>Retrieves the individual compensation details of an employee.</td>
</tr>
<tr>
<td>Employee Atom Feeds</td>
<td>Look up Atom Feeds Employees Assignments Stream</td>
<td>Retrieves the changes made in employees assignments information.</td>
</tr>
<tr>
<td></td>
<td>Look up Atom Feeds Employees Newhire Stream</td>
<td>Retrieves the new hire employees information.</td>
</tr>
<tr>
<td></td>
<td>Look up Atom Feeds Employees Termination Stream</td>
<td>Retrieves the employees termination information.</td>
</tr>
<tr>
<td></td>
<td>Look up Atom Feeds Employees Update Stream</td>
<td>Retrieves the employees update information.</td>
</tr>
<tr>
<td>Human Capital Management</td>
<td>Look up Departments Stream</td>
<td>Retrieves information about departments.</td>
</tr>
<tr>
<td></td>
<td>Look up Employee Assignments</td>
<td>Retrieves information about employees assignments.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up Employees Stream</td>
<td>Retrieves information about the employees.</td>
</tr>
<tr>
<td></td>
<td>Look up Holiday Calendar</td>
<td>Retrieves holiday information for the specified year in the specified country.</td>
</tr>
<tr>
<td></td>
<td>Look up Jobs Stream</td>
<td>Retrieves information about jobs.</td>
</tr>
<tr>
<td></td>
<td>Look up Locations Stream</td>
<td>Retrieves information about locations.</td>
</tr>
<tr>
<td></td>
<td>Look up Positions Stream</td>
<td>Retrieves information about the positions.</td>
</tr>
<tr>
<td></td>
<td>Look up Workers Stream</td>
<td>Retrieves information about the workers.</td>
</tr>
<tr>
<td></td>
<td>Get Oracle Cloud HCM Object Metadata</td>
<td>Retrieves information about Oracle Cloud HCM object metadata.</td>
</tr>
<tr>
<td></td>
<td>Get Oracle Cloud HCM Objects</td>
<td>Retrieves information Oracle Cloud HCM Objects.</td>
</tr>
<tr>
<td>Payroll Management</td>
<td>Look up External Bank Accounts</td>
<td>Retrieves external bank account information for employees.</td>
</tr>
<tr>
<td></td>
<td>Look up Payroll</td>
<td>Retrieves payroll information of an employee.</td>
</tr>
<tr>
<td></td>
<td>Look up Payroll Elements</td>
<td>Retrieves payroll element information of employees.</td>
</tr>
<tr>
<td>Workstructures Atom Feeds</td>
<td>Look up Atom Feeds Jobs Stream</td>
<td>Retrieves the changes made in jobs.</td>
</tr>
<tr>
<td></td>
<td>Look up Atom Feeds Locations Stream</td>
<td>Retrieves the changes made in locations.</td>
</tr>
<tr>
<td></td>
<td>Look up Atom Feeds Organizations Stream</td>
<td>Retrieves the changes made in organizations.</td>
</tr>
<tr>
<td></td>
<td>Look up Atom Feeds Positions Stream</td>
<td>Retrieves the changes made in positions.</td>
</tr>
</tbody>
</table>
Spoke module
The Oracle HCM spoke adds the Oracle HCM Cloud application to your instance and includes these modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BI Report Paths</td>
<td>Lists the BI report paths for the actions.</td>
</tr>
<tr>
<td>Look up Holiday Calendars</td>
<td>Lists the holiday calendars.</td>
</tr>
<tr>
<td>New Positions</td>
<td>Lists the available new positions.</td>
</tr>
</tbody>
</table>

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the Oracle HCM Cloud spoke
Integrate the ServiceNow instance and Oracle HCM Cloud instance by using the basic auth credentials to authenticate ServiceNow requests.

Before you begin
- Request an IntegrationHub subscription.
- Activate Oracle HCM Cloud spoke.
- Role required: admin

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   - The system displays this message: What type of Credentials would you like to create?
3. Select Basic Auth Credentials.
4. On the form, fill these values.
### Basic Auth Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Oracle HCM Cred.</td>
</tr>
<tr>
<td>User name</td>
<td>User name to log in to your target host on which Oracle HCM Cloud is installed.</td>
</tr>
<tr>
<td>Password</td>
<td>Password to authenticate and log in to your target host on which Oracle HCM Cloud is installed.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, 100.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias associated with the spoke.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

6. Navigate to **Connections & Credentials > Connection & Credential Aliases**.

7. Open the alias record, **OracleCloudHCM**.

8. From the **Connections** tab, click **New**.

9. On the form, fill these fields.

### Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Oracle HCM Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Oracle Financial Cloud spoke. For example, Oracle HCM Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL to connect to the server on which Oracle HCM Cloud is installed in this format: https://&lt;hostname&gt;.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
</tbody>
</table>

10. Click **Submit**.
Create BI report paths for Oracle HCM Cloud spoke

Create BI reports paths to specify the folder paths where the reports are saved.

**Before you begin**
Role required: admin

**Procedure**
2. Click **New**.
3. On the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Name</td>
<td>Name of the BI report.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Name of the action.</td>
</tr>
<tr>
<td>Folder Path</td>
<td>Folder path of Oracle HCM Cloud.</td>
</tr>
</tbody>
</table>

**Sample BI Report Paths**

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Action Name</th>
<th>Folder Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Holiday Calendar Report.xdo</td>
<td>Look up Holiday Calendar</td>
<td>/Custom/Human Capital Management/</td>
</tr>
<tr>
<td>Legislative datagroup Report.xdo</td>
<td>Get Legislative Group ID</td>
<td>/Custom/Human Capital Management/</td>
</tr>
<tr>
<td>USOnlinePayslip.xdo</td>
<td>Look up Payroll</td>
<td>/Human Capital Management/Payroll/</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Payment Distribution/US/</td>
</tr>
<tr>
<td>Element Screen Entry Values.xdo</td>
<td>Look up Payroll Elements</td>
<td>/Custom/Human Capital Management/</td>
</tr>
<tr>
<td>Individual Compensation Report.xdo</td>
<td>Look up Individual Compensation</td>
<td>/Custom/Human Capital Management/</td>
</tr>
</tbody>
</table>

**Note:** Report Name and Folder Path may vary based on the Oracle HCM Cloud instance.
Oracle Object Storage Management spoke v1.0.1
Manage objects, buckets, and namespace in the Oracle Object Storage Management account from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Oracle Object Storage Management API version 20160918, but may be compatible with later versions.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- Oracle Cloud IAM spoke v1.0.4
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- Complex Object (com.glide.cobject)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Oracle Object Storage Management spoke provides actions to automate Oracle Object Storage Management tasks when events occurs in your ServiceNow instance. Available actions include:
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bucket Management</td>
<td>Create Bucket</td>
<td>Creates a bucket in the specified Oracle Cloud Namespace.</td>
</tr>
<tr>
<td></td>
<td>Delete Bucket</td>
<td>Deletes the specified bucket.</td>
</tr>
<tr>
<td></td>
<td>Get Bucket</td>
<td>Retrieves details of the specified bucket.</td>
</tr>
<tr>
<td></td>
<td>Look up Buckets</td>
<td>Retrieves a list of buckets in the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Re-encrypt Bucket</td>
<td>Re-encrypts the specified bucket.</td>
</tr>
<tr>
<td></td>
<td>Update Bucket</td>
<td>Updates details of the specified bucket.</td>
</tr>
<tr>
<td>Namespace Metadata</td>
<td>Get Namespace</td>
<td>Retrieves the name of the Object Storage namespace for the user.</td>
</tr>
<tr>
<td>Object Management</td>
<td>Copy Object</td>
<td>Creates a request to copy an object within a region or to another region.</td>
</tr>
<tr>
<td></td>
<td>Create or Update Object</td>
<td>Creates a new object or overwrites an existing object with the same name</td>
</tr>
<tr>
<td></td>
<td>Delete Object</td>
<td>Deletes the specified object.</td>
</tr>
<tr>
<td></td>
<td>Get Object</td>
<td>Retrieves the specified object.</td>
</tr>
<tr>
<td></td>
<td>Look up Objects</td>
<td>Retrieves a list of objects in the specified bucket.</td>
</tr>
<tr>
<td></td>
<td>Re-encrypt Object</td>
<td>Re-encrypts the specified object.</td>
</tr>
<tr>
<td></td>
<td>Rename Object</td>
<td>Renames the specified object.</td>
</tr>
<tr>
<td></td>
<td>Restore Object</td>
<td>Restores the specified object.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).
Set up the Oracle Object Storage Management spoke

Integrate the ServiceNow instance and Oracle Object Storage Management account by using the OCI SHA256WithRSA Signature credentials to authenticate ServiceNow requests.

Before you begin

- Activate and set up the Oracle Cloud IAM spoke v1.0.4
- Role required: admin

Procedure

1. **Optional:** Create a JKS certificate. You can create a JKS certificate for the Oracle Object Storage Management spoke or use the certificate created for the Oracle Cloud IAM spoke. For information about creating the JKS Certificate, see Create a Java KeyStore (JKS) certificate.

2. **Optional:** Create X.509 certificate. You can create a X.509 certificate for the Oracle Object Storage Management spoke or use the certificate created for the Oracle Cloud IAM spoke. For information about creating a X.509 certificate, see Create X.509 certificate for the Oracle Cloud IAM spoke.

3. Create a child alias in the Oracle Cloud IAM spoke connection and credential alias.


   b. Click New.

   c. On the form, fill these values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to identify the alias record. For example, Oracle Obj Storage Alias.</td>
</tr>
<tr>
<td>Parent Alias</td>
<td>Connection and credential alias record of the Oracle Cloud IAM spoke. For example, sn_oci_iam_spoke.OracleIAM_credentialANDconnection</td>
</tr>
</tbody>
</table>

   d. Right-click the form header and click Save.
4. Create credential record for the Oracle Object Storage Management spoke.

a. Navigate to **Connections & Credentials > Credentials**.

b. Click **New**.

   The system displays this message: **What type of Credentials would you like to create?**

c. Select **OCI SHA256WithRSA Signature**.

d. On the form, fill these values.

   - **Note:** You can specify details of the certificates you created specifically for the Oracle Object Storage Management spoke or specify details of the existing certificates you had created for the Oracle Cloud IAM spoke.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, <strong>OCI Obj Cred</strong>.</td>
</tr>
<tr>
<td>Certificate Sys ID</td>
<td>Sys ID of the Signing Certificate.</td>
</tr>
<tr>
<td>Alias</td>
<td>Alias of the KeyStore.</td>
</tr>
<tr>
<td>Alias Password</td>
<td>Alias password of the KeyStore.</td>
</tr>
</tbody>
</table>
   | Key ID              | Key ID helps identify which key is used when multiple keys are used to sign tokens. The Key ID must be slash (/) separated values of Tenancy OCID, User OCID, and Fingerprint in this format: `ocid1.tenancy.oc1..<unique_ID>/ocid1.user.oc1..<unique_ID>/<key_fingerprint>`.
   | Applies to          | Option to specify if the credential applies to all MID Servers in the network. |
   | Active              | Option to actively use the credential record. |
   | Authentication Algorithm | Custom authentication algorithm for outbound signing requests. Select **OCI SHA256RSA Signing Algorithm** |

  e. Right-click the form header and click **Submit**.
5. Create connection record for the Oracle Object Storage Management spoke.

a. Navigate to **Connections & Credentials > Connections & Credentials Aliases**.

b. Open the child alias record you had created. For example, **Oracle Obj Storage Alias**.

c. From the **Connections** tab, click **New**.

d. On the form, fill these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Oracle Obj Storage conn.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Oracle Object Storage Management spoke. For example, OCI Obj Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to Oracle Object Storage Management. For example, <a href="https://objectstorage.ap-mumbai-1.oraclecloud.com">https://objectstorage.ap-mumbai-1.oraclecloud.com</a>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
</tbody>
</table>

e. Click **Submit**.

The ServiceNow instance and Oracle Object Storage Management account are integrated. You can use the spoke actions to build flows and automate tasks as required.

**Oracle Peoplesoft Financial spoke v1.0.3**

Manage finances and procurement in the Oracle Peoplesoft Financial instance from your ServiceNow instance.
Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
• PeopleSoft FSCM 9.2 Update Image 37
• PeopleTools 8.58.05
• Oracle Database 19.3.0.0
• Elasticsearch 7.0.0
• Kibana 7.0.0
• Oracle Linux 7.8x
• Oracle Database version above 12.2.0.0
• PeopleTools above 8.56

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• Remote Tables (com.glide.script.vtable)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• ServiceNow Flow Designer - Dynamic Outputs (com.glide.hub.dynamic_outputs)
• ServiceNow IntegrationHub Action Step - SOAP (com.glide.hub.action_step.soap)
• ServiceNow IntegrationHub Action Step - XML Parser (com.glide.hub.action_step.xmlparser)
Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke flows
The Oracle Peoplesoft Financial spoke provides a sample flow, Create PO, to demonstrate automating the PO creation. To customize the sample flow, copy it to the required application scope.

Spoke subflows
The Oracle Peoplesoft Financial spoke provides sample subflows to demonstrate automating tasks. To customize a sample subflow, copy it to the required application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BU and Vendor Validation</td>
<td>Validates if a vendor or business unit exists in Oracle Peoplesoft Financial.</td>
</tr>
<tr>
<td>Create PO After BU Validation</td>
<td>Validates a business unit before creating a purchase order using that business unit.</td>
</tr>
<tr>
<td>Polling Suppliers</td>
<td>Retrieves details of the daily suppliers based on the mentioned polling frequency and creates or updates records in PSFT data table based on Vendor ID.</td>
</tr>
</tbody>
</table>

Spoke actions
The Oracle Peoplesoft Financial spoke provides actions to automate tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finance</td>
<td>Create Bulk Journals</td>
<td>Creates bulk journals.</td>
</tr>
<tr>
<td></td>
<td>Create Invoice</td>
<td>Creates an invoice in Oracle Peoplesoft Financial.</td>
</tr>
<tr>
<td></td>
<td>Get Business Unit By Business Unit ID</td>
<td>Retrieves details of the specified business unit.</td>
</tr>
<tr>
<td></td>
<td>Get Department By Department ID</td>
<td>Retrieves the department cost center details of the specified department.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get GI Account Details</td>
<td>Retrieves details of the specified GI account.</td>
</tr>
<tr>
<td></td>
<td>Get Item Details</td>
<td>Retrieves details of the items, based on the input criteria.</td>
</tr>
<tr>
<td></td>
<td>Lookup AP Invoice Line</td>
<td>Retrieves the AP invoice line details of the specified voucher.</td>
</tr>
<tr>
<td></td>
<td>Lookup AP Invoice Header</td>
<td>Retrieves details of the AP invoice headers, based on the input criteria.</td>
</tr>
<tr>
<td></td>
<td>Lookup Business Units</td>
<td>Retrieves details of the business units, based on the input criteria.</td>
</tr>
<tr>
<td></td>
<td>Lookup Currency Rate</td>
<td>Retrieves details of the currency market rate, based on the input criteria.</td>
</tr>
<tr>
<td></td>
<td>Lookup Departments</td>
<td>Retrieves details of the departments, based on the input criteria.</td>
</tr>
<tr>
<td></td>
<td>Lookup GI Balance</td>
<td>Retrieves details of the GI balance, based on the input criteria.</td>
</tr>
<tr>
<td></td>
<td>Lookup Invoice Payment Status</td>
<td>Retrieves the list of invoice statuses, based on the input criteria.</td>
</tr>
<tr>
<td>Procurement</td>
<td>Cancel PO</td>
<td>Cancels the specified PO.</td>
</tr>
<tr>
<td></td>
<td>Create Bid Event</td>
<td>Creates a bid event in the specified business unit.</td>
</tr>
<tr>
<td></td>
<td>Create Bulk Assets</td>
<td>Creates assets with the provided details.</td>
</tr>
<tr>
<td></td>
<td>Create Bulk Goods Receipts</td>
<td>Creates good receipts with the provided details.</td>
</tr>
<tr>
<td></td>
<td>Create PO</td>
<td>Creates a PO with the provided details.</td>
</tr>
<tr>
<td></td>
<td>Create Vendor</td>
<td>Creates a vendor with the provided details.</td>
</tr>
<tr>
<td></td>
<td>Get Ship To Location By Ship To ID</td>
<td>Retrieves all the ship to locations details, based on the input Ship to ID.</td>
</tr>
<tr>
<td></td>
<td>Get Supplier By Vendor ID</td>
<td>Retrieves the supplier details based on the input Vendor ID.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------</td>
<td>---------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Lookup Fixed Assets</td>
<td>Retrieves details of all the fixed assets, based on the input criteria.</td>
</tr>
<tr>
<td></td>
<td>Lookup Advance</td>
<td>Retrieves details of the advance shipment receipts, based on the input criteria.</td>
</tr>
<tr>
<td></td>
<td>Shipment Receipts</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lookup Bid Event</td>
<td>Retrieves details of all the bid events, based on the input criteria.</td>
</tr>
<tr>
<td></td>
<td>Lookup PO Header</td>
<td>Retrieves details of the PO header, based on the input criteria.</td>
</tr>
<tr>
<td></td>
<td>Lookup PO Line</td>
<td>Retrieves details of the PO line, based on the input criteria.</td>
</tr>
<tr>
<td></td>
<td>Lookup Ship To Locations</td>
<td>Retrieves list of all the ship to locations, based on the input criteria.</td>
</tr>
<tr>
<td></td>
<td>Lookup Suppliers</td>
<td>Retrieves details of all the suppliers, based on the input criteria.</td>
</tr>
<tr>
<td></td>
<td>Update PO</td>
<td>Updates details of the PO.</td>
</tr>
<tr>
<td>Utility</td>
<td>Process Trigger</td>
<td>Triggers the specified process.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the Oracle Peoplesoft Financial spoke**

Integrate the Oracle Peoplesoft Financial and ServiceNow instances, and authenticate the requests using the basic authentication.

**Before you begin**

- Request an IntegrationHub subscription.
- Activate the Oracle Peoplesoft Financial spoke.
- Ensure that you have access to Oracle Peoplesoft Application Designer.
- Roles required: ServiceNow admin and Oracle Peoplesoft Financial System Admin

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Procedure

1. In the Application Designer, import the Oracle Peoplesoft Financial project.

   a. From the ServiceNow® Store download the project file, SN_PS_FSCM_INTEGRATION.zip and save it in the required local folder.

   b. Import the Oracle Peoplesoft Financial project to the target environment that is, Oracle Peoplesoft Application Designer.

   c. Navigate to **Copy Project > From File** and select the project file.

   ![Image showing the Copy From File dialog box]

   d. Click **Copy** to copy the definition types.
e. Verify that the project has all the objects: Application packages, Records, Services, and Service Operations.

f. Build the project by navigating to **Build > Project**.

g. Select **Create Tables**, **Create Views**, and **Execute and build script** options.
The required tables are created in the target Oracle Peoplesoft Financial database.

2. Enable the required web services on your Oracle Peoplesoft Financial instance.

   a. Log in to your Oracle Peoplesoft Financial instance as an System Admin.

   b. Navigate to **Navigator > People Tools > Integration Broker > Web Services > Provide Web Service**.

   c. In the Search Criteria, specify `sn_` for **Service Name** and click **Search**.
d. Select the check box against the required web services and click Next.
Note: Ensure that you select 24 ServiceNow web services.

<table>
<thead>
<tr>
<th>Service</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SN_AP_INV_PYMNT_STATUS</td>
<td>AP Invoice Payment Status</td>
</tr>
<tr>
<td>SN_AP_INV_VOUCHER_ADD_WS</td>
<td>ServiceNow Voucher Add</td>
</tr>
<tr>
<td>SN_ASSET_LOAD_WS</td>
<td>Asset Load</td>
</tr>
<tr>
<td>SN_BILL_GET_INV</td>
<td>Get Invoice</td>
</tr>
<tr>
<td>SN_CREATE_VENDOR_CI</td>
<td>Create Vendor</td>
</tr>
<tr>
<td>SN_EXECUTEQUERY</td>
<td>ServiceNow - QAS</td>
</tr>
<tr>
<td>SN_GET_AP_INVOICE_DTL</td>
<td>AP Invoice Detail</td>
</tr>
<tr>
<td>SN_GET ASR</td>
<td>Advance Shipment Receipt</td>
</tr>
<tr>
<td>SN_GET ASSET</td>
<td>SN_GET ASSET</td>
</tr>
<tr>
<td>SN_GET_BID_EVENT</td>
<td>ServiceNow Bid Event</td>
</tr>
<tr>
<td>SN_GET_CC</td>
<td>Get Const centres</td>
</tr>
<tr>
<td>SN_GET_CURRENCY_RATES</td>
<td>Get Currency Rates</td>
</tr>
<tr>
<td>SN_GET_GL_ACCOUNT</td>
<td>Get GI Accounts</td>
</tr>
<tr>
<td>SN_GET_GL_BALANCE</td>
<td>Ledger Data</td>
</tr>
<tr>
<td>SN_GET_GL_BU</td>
<td>Get GL BU</td>
</tr>
<tr>
<td>SN_GET_ITEM_MASTER</td>
<td>Item Master</td>
</tr>
<tr>
<td>SN_GET_POHDR</td>
<td>PO Header</td>
</tr>
<tr>
<td>SN_GET_POLN</td>
<td>Get PO Line</td>
</tr>
<tr>
<td>SN_GET_SHIPTO_LOCATIONS</td>
<td>Get Ship to Locations</td>
</tr>
<tr>
<td>SN_GET_SUPPLIERS</td>
<td>Get Suppliers/Vendors</td>
</tr>
<tr>
<td>SN_JOURNAL_LOAD</td>
<td>ServiceNow Journal Load</td>
</tr>
<tr>
<td>SN_MANAGE PROCESSES</td>
<td>ServiceNow Process webservice</td>
</tr>
<tr>
<td>SN_PO_CANCEL</td>
<td>SN PO CANCEL</td>
</tr>
<tr>
<td>SN_RECPT_LOAD</td>
<td>Receipt frm SN</td>
</tr>
</tbody>
</table>
e. Under Operations, select the check box against the required web service and click Next.

f. Click View WSDL to view the WSDL file and click Next.

g. In Specify Publishing Options, click Finish.
   Generated WSDL URL is displayed in this format: <Base-URL>/<webservice-endpoint>.wsdl

h. Navigate to Navigator > People Tools > Integration Broker > Web Services > CI-Based Services.

i. Perform the same steps that you had earlier performed for the webservices.

   Note: Configure the webservices as per your requirement.

3. Provide the required permissions to the web services.

   a. Log in to your Oracle Peoplesoft Financial instance as a System Admin.

   b. Navigate to Navigator > People Tools > Integration Broker > Web Services > Service Utilities > Service Operation Permissions.

   c. Select Service option, specify the service name in Service, and click Search.
d. Select the check box against the required web service and click **Set Security**.
e. In **Web Service Access**, provide access as per your requirement and click **Save**.

**Web Service Access**

**Operation:** SN_GET_ASSET_SO

**Permission**

**Permission List**

**Access**

![Permission List Image]

**Save** **Return to Search**

4. Using SQL Developer or Data Mover in Oracle Peoplesoft Application Designer, connect to the database and run these scripts to ensure that the journal entry, SN_ACCT_ENTRY is built.

```sql
SET DEFINE OFF;

Insert into PS_SOURCE_TBL
VALUES
('SHARE','SN',to_date('01-JAN-00','DD-MON-RR'),'A','ServiceNow','R','R','R','D','D','R','D','D','N','D','D',' ',' ',' ',' ',' ','D',' ');

Insert into PS_JRNLGEN_DEFN
VALUES
('SHARE','SNOW_PSFT','ServiceNow Accounting Entries','SN_ACCT_ENTRY','SN_ACCT_ENTRY','ACCOUNTING_DT', 'MONETARY_AMOUNT', 'FOREIGN_AMOUNT', 'STATISTIC_AMOUNT', 'LINE_DESCR', 'ACCOUNTING_DT', 'DTTM_STAMP', 'GOT', 'OT', 'JGEN_ACCTG_DRILL', 'Y', '1', 'V', 1', ' ');
```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Insert into PS_JRNLGEN_DEFNV
(SETID,ACCTG_DEF_NAME,FIELD_SEQUENCE,FIELDNAME,CHARTFIELD,CF_SUMMARIZE_OPT) values
('SHARE','SNOW_PSFT',1,'ACCOUNT','ACCOUNT','Y');
Insert into PS_JRNLGEN_DEFNV
(SETID,ACCTG_DEF_NAME,FIELD_SEQUENCE,FIELDNAME,CHARTFIELD,CF_SUMMARIZE_OPT) values
('SHARE','SNOW_PSFT',2,'ALTACCT','ALTACCT','Y');
Insert into PS_JRNLGEN_DEFNV
(SETID,ACCTG_DEF_NAME,FIELD_SEQUENCE,FIELDNAME,CHARTFIELD,CF_SUMMARIZE_OPT) values
('SHARE','SNOW_PSFT',3,'OPERATING_UNIT','OPERATING_UNIT','Y');
Insert into PS_JRNLGEN_DEFNV
(SETID,ACCTG_DEF_NAME,FIELD_SEQUENCE,FIELDNAME,CHARTFIELD,CF_SUMMARIZE_OPT) values
('SHARE','SNOW_PSFT',4,'DEPTID','DEPTID','Y');
Insert into PS_JRNLGEN_DEFNV
(SETID,ACCTG_DEF_NAME,FIELD_SEQUENCE,FIELDNAME,CHARTFIELD,CF_SUMMARIZE_OPT) values
('SHARE','SNOW_PSFT',5,'PRODUCT','PRODUCT','Y');
Insert into PS_JRNLGEN_DEFNV
(SETID,ACCTG_DEF_NAME,FIELD_SEQUENCE,FIELDNAME,CHARTFIELD,CF_SUMMARIZE_OPT) values
('SHARE','SNOW_PSFT',6,'PROJECT_ID','PROJECT_ID','Y');
Insert into PS_JRNLGEN_DEFNV
(SETID,ACCTG_DEF_NAME,FIELD_SEQUENCE,FIELDNAME,CHARTFIELD,CF_SUMMARIZE_OPT) values
('SHARE','SNOW_PSFT',7,'AFFILIATE','AFFILIATE','Y');
Insert into PS_JRNLGEN_DEFNV
(SETID,ACCTG_DEF_NAME,FIELD_SEQUENCE,FIELDNAME,CHARTFIELD,CF_SUMMARIZE_OPT) values
('SHARE','SNOW_PSFT',8,'STATISTICS_CODE','STATISTICS_CODE','Y');

Insert into PS_JRNLGEN_DEFMB (SETID,ACCTG_DEF_NAME,FIELD_SEQUENCE,FIELDNAME) values
('SHARE','SNOW_PSFT',1,'BUSINESS_UNIT');
Insert into PS_JRNLGEN_DEFMB (SETID,ACCTG_DEF_NAME,FIELD_SEQUENCE,FIELDNAME) values
('SHARE','SNOW_PSFT',2,'TRANSACTION_ID');
Insert into PS_JRNLGEN_DEFMB (SETID,ACCTG_DEF_NAME,FIELD_SEQUENCE,FIELDNAME) values
('SHARE','SNOW_PSFT',3,'LEDGER_GROUP');

Insert into PS_JRNLGEN_TGRP (SETID,ACCTG_DEF_NAME,FIELD_SEQUENCE,FIELDNAME,FIELD_VALUE1) values
('SHARE','SNOW_PSFT',1,'BUSINESS_UNIT', '');
Insert into PS_JRNLGEN_TGRP (SETID,ACCTG_DEF_NAME,FIELD_SEQUENCE,FIELDNAME,FIELD_VALUE1) values
('SHARE','SNOW_PSFT',2,'TRANSACTION_ID', '');

Insert into PS_JRNLGEN_APPL_ID
(SETID,APPL_JRNL_ID,EFFDT,EFF_STATUS,DESCR,JOURNAL_ID_MASK,JRNL_DT_OPTN,JRNL_DT_ALT_OPTN ,JOURNAL_DATE,STAY_IN_PERIOD,SOURCE,CURR_EFFDT_FLG,JRNL_DESCR,LINE_DESCR,TRANS_REF_NUM,JR NNL_LN_REF,HOW_SPECIFY,ACCOUNT_SPECIFY,DEFAULT_SPECIFY,TREE_NAME,TREE_LEVEL,REVERSAL_CD,EN TRY.Sync,BUS_UNIT_OPTN,DOC_TYPE) values
('SHARE','SNOW_PSFT',to_date('01-JAN-00','DD-MON-RR'),'A','ServiceNow Journal Template','SN','A','BF',null,'N','SN','J','ServiceNow External Journals','ServiceNow Journal Template',' ',' ','D','1','D','' ',' ','N','Y','A','GN-JG');
5. Create a credential record for the Oracle Peoplesoft Financial spoke.

a. Log in to the ServiceNow instance as an admin.

b. Navigate to Connections & Credentials > Credentials.

c. Click New.
   The system displays the message What type of Credentials would you like to create?.

d. Select Basic Auth Credentials.

e. On the form, fill these values.

<table>
<thead>
<tr>
<th>Name</th>
<th>Name to identify the credential record. For example, Peoplesoft Cred.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>Username with the required permissions to log in to the Oracle Peoplesoft Financial instance.</td>
</tr>
<tr>
<td>Password</td>
<td>Password to log in to the Oracle Peoplesoft Financial instance.</td>
</tr>
</tbody>
</table>
Active | Option to actively use the credential record.
---|---

f. Click **Submit**.

6. Create a connection record for the Oracle Peoplesoft Financial spoke.
   
a. Log in to the ServiceNow instance as an admin.
   
b. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
   
c. Open for the record for the Oracle Peoplesoft Financial spoke.
   
d. From the **Connections** tab, click **New**.
   
e. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter <strong>Peoplesoft Connection</strong>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Jenkins. For example, select <strong>Peoplesoft Cred</strong>.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL obtained from the generated WSDL URL.</td>
</tr>
</tbody>
</table>

f. Click **Submit**.

7. Provide Oracle Peoplesoft Financial credentials to use the Process Trigger action.
   
a. Log in to the ServiceNow instance as an admin.
   
b. Navigate to **Oracle Peoplesoft Credentials > Oracle Peoplesoft Credentials**.
   
c. Click **New**.
   
d. On the form, enter the username and password of user with the required permissions.
   
e. Click **Submit**.

8. Retrieve details of the daily suppliers up to the required date.
a. Log in to the ServiceNow instance as an admin.

b. Navigate to **PSFT Flow Execution > PSFT Flow Executions**.

c. Click **New**.

d. Select the date up to which you want to retrieve the daily suppliers data in **Last Successfull Execution**.

e. Click **Submit**.

Based on the trigger you have configured in the Polling Suppliers subflow, data is retrieved periodically. To view the data, navigate to **PSFT > PSFT Data**.

---

**Oracle Virtual Cloud Network spoke v1.0.1**

Manage networks, route tables, security lists, and subnets in Oracle Virtual Cloud Network account from your ServiceNow instance.

---

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

---

**IntegrationHub subscription**

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

---

**Supported versions**

This spoke was built for Oracle Virtual Cloud Network API version 20160918, but may be compatible with later versions.

---

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- **Oracle Cloud IAM spoke v1.0.4**
- **ServiceNow IntegrationHub Action Step - REST** (com.glide.hub.action_step.rest)
- **ServiceNow Flow Designer - Dynamic Inputs** (com.glide.hub.dynamic_inputs)
- **Complex Object** (com.glide.cobject)
- **ServiceNow IntegrationHub Runtime** (com.glide.hub.integration.runtime)
**Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke actions**

The Oracle Virtual Cloud Network spoke provides actions to automate Oracle Virtual Cloud Network tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Management</td>
<td>Change Network Compartment</td>
<td>Moves the specified VCN to a different compartment within the same tenancy.</td>
</tr>
<tr>
<td></td>
<td>Create Network</td>
<td>Creates a virtual cloud network.</td>
</tr>
<tr>
<td></td>
<td>Delete Network</td>
<td>Delete the specified VCN.</td>
</tr>
<tr>
<td></td>
<td>Get Network</td>
<td>Retrieves details of the required VCN.</td>
</tr>
<tr>
<td></td>
<td>Look up Networks</td>
<td>Lists the VCNs in the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Update Network</td>
<td>Updates details of the specified VCN.</td>
</tr>
<tr>
<td>Route Table Management</td>
<td>Change Route Table Compartment</td>
<td>Moves a route table to different compartment within the same tenancy.</td>
</tr>
<tr>
<td></td>
<td>Create Route Table</td>
<td>Creates a route table for the specified VCN.</td>
</tr>
<tr>
<td></td>
<td>Delete Route Table</td>
<td>Delete the specified route table.</td>
</tr>
<tr>
<td></td>
<td>Get Route Table</td>
<td>Retrieves the specified route table details.</td>
</tr>
<tr>
<td></td>
<td>Look up Route Tables</td>
<td>Lists the route table in the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Update Route Table</td>
<td>Updates details of the specified route table.</td>
</tr>
<tr>
<td>Security List Management</td>
<td>Change Security List Compartment</td>
<td>Moves the specified security list to different compartment within the same tenancy.</td>
</tr>
<tr>
<td></td>
<td>Create Security List</td>
<td>Creates a security list for the specified VCN.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Delete Security List</td>
<td>Deletes the specified security list.</td>
</tr>
<tr>
<td></td>
<td>Get Security List</td>
<td>Retrieves specified security list's information.</td>
</tr>
<tr>
<td></td>
<td>Look up Security Lists</td>
<td>Lists the security lists in the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Update Security List</td>
<td>Updates display name or rules of the specified security list.</td>
</tr>
<tr>
<td>Subnet Management</td>
<td>Change Subnet Compartment</td>
<td>Moves the specified subnet to a different compartment within the same tenancy.</td>
</tr>
<tr>
<td></td>
<td>Create Subnet</td>
<td>Creates a subnet in the specified VCN.</td>
</tr>
<tr>
<td></td>
<td>Delete Subnet</td>
<td>Deletes the specified subnet.</td>
</tr>
<tr>
<td></td>
<td>Get Subnet</td>
<td>Retrieves details of the specified subnet.</td>
</tr>
<tr>
<td></td>
<td>Look up Subnets</td>
<td>Lists the subnets in the specified compartment.</td>
</tr>
<tr>
<td></td>
<td>Update Subnet</td>
<td>Updates subnet in the specified VCN.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the Oracle Virtual Cloud Network spoke**

Integrate the ServiceNow instance and Oracle Virtual Cloud Network account by using the OCI SHA256WithRSA Signature credentials to authenticate ServiceNow requests.

**Before you begin**

- Activate and set up the Oracle Cloud IAM spoke v1.0.4
- Role required: admin
Procedure

1. **Optional:** Create a JKS certificate. You can create a JKS certificate for the Oracle Virtual Cloud Network spoke or use the certificate created for the Oracle Cloud IAM spoke. For information about creating the JKS Certificate, see Create a Java KeyStore (JKS) certificate.

2. **Optional:** Create X.509 certificate. You can create a X.509 certificate for the Oracle Virtual Cloud Network spoke or use the certificate created for the Oracle Cloud IAM spoke. For information about creating a X.509 certificate, see Create X.509 certificate for the Oracle Cloud IAM spoke.

3. Create credential record for the Oracle Virtual Cloud Network spoke.

   a. Navigate to **Connections & Credentials > Credentials**.

   b. Click **New**.

      The system displays this message: **What type of Credentials would you like to create?**

   c. Select **OCI SHA256WithRSA Signature**.

   d. On the form, fill these values.

      **Note:** You can specify details of the certificates you created specifically for the Oracle Virtual Cloud Network spoke or specify details of the existing certificates you had created for the Oracle Cloud IAM spoke.

### OCI SHA256WithRSA Signature Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Oracle Virtual Cloud Network Cred.</td>
</tr>
<tr>
<td>Certificate Sys ID</td>
<td>Sys ID of the Signing Certificate.</td>
</tr>
<tr>
<td>Alias</td>
<td>Alias of the KeyStore.</td>
</tr>
<tr>
<td>Alias Password</td>
<td>Alias password of the KeyStore.</td>
</tr>
<tr>
<td>Key ID</td>
<td>Key ID helps identify which key is used when multiple keys are used to sign tokens. The Key ID must be slash (/) separated values of Tenancy OCID, User OCID, and</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Fingerprint in this format:</td>
<td>ocid1.tenancy.oc1..&lt;unique_ID&gt;/ocid1.user.oc1..&lt;unique_ID&gt;/&lt;key_fingerprint&gt;.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Option to specify if the credential applies to all MID Servers in the network.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Authentication</td>
<td>Custom authentication algorithm for outbound signing requests. Select <strong>OCI SHA256RSA Signing Algorithm</strong></td>
</tr>
</tbody>
</table>

**e.** Right-click the form header and click **Submit**.

4. Create connection record for the Oracle Virtual Cloud Network spoke.

**a.** Navigate to **Connections & Credentials > Connections & Credentials Aliases**.

**b.** Open the alias record of the Oracle Virtual Cloud Network spoke. For example, **Oracle_VCN_Connection**.

**c.** From the **Connections** tab, click **New**.

**d.** On the form, fill these fields.

---

**Connection form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, <strong>Oracle_VCN_Conn</strong>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Oracle Virtual Cloud Network spoke. For example, <strong>Oracle Virtual Cloud Network Cred</strong></td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to Oracle Virtual Cloud Network. For example, <strong><a href="https://iaas.ap-mumbai-1.oraclecloud.com">https://iaas.ap-mumbai-1.oraclecloud.com</a></strong></td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
</tbody>
</table>

e. Click **Submit**.

The ServiceNow instance and Oracle Virtual Cloud Network account are integrated. You can use the spoke actions to build flows and automate tasks as required.

**Qualtrics spoke**
Integrate ServiceNow instance with Qualtrics. Manage web-based survey distribution in Qualtrics from your ServiceNow instance.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Supported versions**
This spoke was built for Qualtrics v3, but may be compatible with later versions.

**Spoke requirements**
- Qualtrics account

**Spoke dependencies**
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- Complex Object (com.glide.cobject)

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke flows**

The Qualtrics spoke provides sample flows to demonstrate automating the Qualtrics tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create distribution when incident is closed</td>
<td>Creates a distribution for a survey and sends the survey to the incident caller, when an incident is closed.</td>
</tr>
</tbody>
</table>

**Spoke subflows**

The Qualtrics spoke provides sample subflows to demonstrate automating Qualtrics tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Look up Contact in Mailing List</td>
<td>Retrieves the look up ID of the specified contact.</td>
</tr>
<tr>
<td>Look up Mailing List by Name</td>
<td>Retrieves ID of the mailing list for the specified name.</td>
</tr>
<tr>
<td>Look up Message by Name</td>
<td>Retrieves ID of the message for the specified name.</td>
</tr>
<tr>
<td>Look up Survey by Name</td>
<td>Retrieves ID of the survey with the specified name.</td>
</tr>
</tbody>
</table>

**Spoke actions**

The Qualtrics spoke provides actions to automate Qualtrics tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Management</td>
<td>Create Contact</td>
<td>Creates a contact in the specified directory.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up Contact Distribution</td>
<td>Retrieves the distribution email history for the specified contact in a directory.</td>
</tr>
<tr>
<td></td>
<td>Email History</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Look up Contact Distribution</td>
<td>Retrieves a list of distribution response history for a specified contact in a directory.</td>
</tr>
<tr>
<td></td>
<td>Response History</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Look up Contacts</td>
<td>Retrieves a list of contacts from a directory.</td>
</tr>
<tr>
<td></td>
<td>by Email</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Update Contact</td>
<td>Updates the specified contact details in the specified directory.</td>
</tr>
<tr>
<td>Distribution</td>
<td>Management</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Create Distribution</td>
<td>Creates a distribution for a survey.</td>
</tr>
<tr>
<td></td>
<td>Look up Distribution Links</td>
<td>Retrieves a list of distribution links for an existing distribution of the specified survey.</td>
</tr>
<tr>
<td>Library</td>
<td>Management</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Look up Library Messages</td>
<td>Retrieves a list of messages in a library.</td>
</tr>
<tr>
<td>Mailing List</td>
<td>Management</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Create Contact in Mailing List</td>
<td>Creates a directory contact in a specified mailing list.</td>
</tr>
<tr>
<td></td>
<td>Get Contact in Mailing List</td>
<td>Retrieves a contact from a mailing list in the specified directory.</td>
</tr>
<tr>
<td></td>
<td>Look up Mailing Lists</td>
<td>Retrieves a list of mailing lists in a directory.</td>
</tr>
<tr>
<td></td>
<td>Remove Contact from Mailing List</td>
<td>Removes a contact from the specified mailing list.</td>
</tr>
<tr>
<td>Metadata</td>
<td>Retrieval</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Metadata - Look up Directories</td>
<td>Retrieves the metadata of a list of directories within a brand.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Ensure that this action is always used along with relevant actions that use dynamic inputs.</td>
</tr>
<tr>
<td></td>
<td>Metadata - Look up Libraries</td>
<td>Retrieves a list of libraries.</td>
</tr>
</tbody>
</table>
**Category** | **Action** | **Description**  
--- | --- | ---  
Survey Management | Look up Surveys | Retrieves a list of surveys available to the user.

### Note:
Ensure that this action is always used along with relevant actions that use dynamic inputs.

### Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

### Set up the Qualtrics spoke
Integrate the ServiceNow instance and Qualtrics by registering Qualtrics as an OAuth provider to authenticate ServiceNow requests.

#### Before you begin
- Request an IntegrationHub subscription.
- Activate Qualtrics spoke.
- Register your ServiceNow instance in Qualtrics and record the Client ID and Client secret for authentication.
- Role required: admin

#### Register Qualtrics as an OAuth provider
Register Qualtrics as the OAuth provider so that the ServiceNow instance can request OAuth 2.0 tokens.

#### Procedure
1. Navigate to System OAuth > Application Registry.
2. Click New.
   The system displays this message: What kind of OAuth application?.
3. Select Connect to a third party OAuth Provider.
4. On the form, fill these values.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter: Qualtrics OAuth</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID created during the Qualtrics account configuration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret created during the Qualtrics account configuration.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>OAuth authorization code endpoint.</td>
</tr>
<tr>
<td>Token URL</td>
<td>OAuth server token endpoint. Enter: https://&lt;your_data_center&gt;.qualtrics.com/oauth2/token</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>OAuth server token revocation endpoint.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint in this format: https://&lt;instance&gt;.service-now.com/oauth_redirect.do</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Script to customize the request and response.</td>
</tr>
<tr>
<td>Logo URL</td>
<td>URL that contains an image to use as the application logo.</td>
</tr>
<tr>
<td>Default Grant Type</td>
<td>Grant type used to establish the token. Select <strong>Client Credentials</strong> or <strong>Authorization Code</strong> based on your Qualtrics account configuration.</td>
</tr>
<tr>
<td>Refresh Token</td>
<td>Time, in seconds, that the refresh token is valid. The default time is 8,640,0000 seconds.</td>
</tr>
<tr>
<td>Lifespan</td>
<td></td>
</tr>
<tr>
<td>PKCE required</td>
<td>Option to enable public clients to require PKCE for an authorization.</td>
</tr>
<tr>
<td>Note:</td>
<td>You can use only <strong>Authorization Code</strong> as the <strong>Default Grant type</strong> when PKCE is enabled.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Application scope that this registry is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use mutual authentication for token request and revocation. This option requires a mutual authentication profile to be specified.</td>
</tr>
</tbody>
</table>

5. Right-click the form header, and click **Save**.

6. In the **OAuth Entity Scopes** tab, insert one record for each OAuth scope and provide **Name** to identify the OAuth scope record. You can provide OAuth scopes as per your requirement. For more information about the scopes, see **OAuth 2.0 Scopes** in Qualtrics API Docs.

7. Right-click the form header, and click **Save**.

8. In the **OAuth Entity Profiles** tab, open the default record. For example, **Qualtrics app registry default_profile**.

9. In the **OAuth Entity Profile Scopes** tab, insert a row; one for each OAuth scope and select the OAuth scope records.
10. Right-click the form header, and click **Save**.

### Create a credential record for the Qualtrics spoke

Create a credential record for the Qualtrics account. The Qualtrics spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.

   The system displays this message: **What type of Credentials would you like to create?**

3. Select **OAuth 2.0 Credentials**.
4. On the form, fill these values.

   **OAuth 2.0 Credentials form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Qualtrics Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile created during the registration of Qualtrics as an OAuth provider. For example, Qualtrics OAuth Profile.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, 100.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click **Submit**.

6. To generate the OAuth token, click the **Get OAuth Token** related link.
Create a connection record for the Qualtrics spoke

Create a connection record for your Qualtrics account. The Qualtrics spoke connection and credential aliases use these connections to perform actions in Qualtrics.

**Procedure**

1. Navigate to Connections & Credentials > Connections & Credentials Aliases.
2. Open the alias record for Qualtrics.
3. From the Connections tab, click New.
4. On the form, fill these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Qualtrics Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Qualtrics spoke.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection. Default alias is sn_qualtrics_spoke.Qualtrics</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to Qualtrics. Enter: https:&lt;your_data_center&gt;.qualtrics.com/API/v3</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**PagerDuty spoke**

The PagerDuty spoke provides actions to view and analyze meaningful usage data for PagerDuty software subscriptions. Analyze on-call users to determine which licenses are stale so that you can reclaim these licenses and realize your potential savings.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
IntegrationHub subscription
This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for PagerDuty v1.0.3, but may be compatible with later versions.

Spoke requirements
• PagerDuty global admin account

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke subflows
The PagerDuty spoke provides sample subflows to demonstrate automating PagerDuty tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PagerDuty Download Subscriptions</td>
<td>Downloads user subscriptions from the PagerDuty portal.</td>
</tr>
<tr>
<td></td>
<td>To use this subflow, perform the steps outlined in Integrating with PagerDuty.</td>
</tr>
<tr>
<td>PagerDuty Reclaim Subscription</td>
<td>Deactivates user accounts in PagerDuty.</td>
</tr>
<tr>
<td></td>
<td>To use this subflow, perform the steps outlined in Integrating with PagerDuty.</td>
</tr>
<tr>
<td>PagerDuty Update User Activity</td>
<td>Retrieves the activity of users who are on an on-call schedule.</td>
</tr>
</tbody>
</table>
### Spoke actions

The PagerDuty spoke provides actions to automate PagerDuty tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Management</td>
<td>Look Up Users</td>
<td>Retrieves all PagerDuty user subscriptions. To use this action, perform the steps outlined in Integrating with PagerDuty.</td>
</tr>
<tr>
<td></td>
<td>Look Up On Call Users</td>
<td>Retrieves information about the last time that a user was on an on-call schedule. To use this action, perform the steps outlined in Integrating with PagerDuty.</td>
</tr>
<tr>
<td></td>
<td>Remove User</td>
<td>Deactivates a user account in PagerDuty. To use this action, perform the steps outlined in Integrating with PagerDuty.</td>
</tr>
</tbody>
</table>

### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

### Plivo spoke

Enable communications with your customers using the Plivo platform from your ServiceNow instance.

### Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
IntegrationHub subscription
This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Plivo API version v1, but may be compatible with later versions.

Spoke requirements
• Admin access to the Plivo console.
• AUTH ID and AUTH TOKEN. You can find these values in the dashboard of your Plivo account. For more information, see Authentication in the Plivo documentation.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke subflows
The Plivo spoke provides sample subflows to demonstrate automating the Plivo tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plivo Call Handler</td>
<td>Manages calls associated with the Plivo account.</td>
</tr>
<tr>
<td>Plivo SMS Handler</td>
<td>Manages SMS associated with the Plivo account.</td>
</tr>
</tbody>
</table>

While customizing subflows, you must ensure that the subflows are configured to avoid infinite loops.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Note:

- You must configure webhooks to use the spoke subflow. See Set up a webhook for the Plivo spoke for information regarding setting up and configuring the webhook.
- The sample subflow runs as a user by default. The subflow can be configured to run as system.

**Spoke actions**

The Plivo spoke provides actions to automate the Plivo tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Management</td>
<td>Create Application</td>
<td>Creates an application.</td>
</tr>
<tr>
<td></td>
<td>Delete Application</td>
<td>Deletes an application.</td>
</tr>
<tr>
<td></td>
<td>Get Application</td>
<td>Retrieves details of an application.</td>
</tr>
<tr>
<td></td>
<td>Look up Applications</td>
<td>Retrieves list of all application IDs.</td>
</tr>
<tr>
<td></td>
<td>Update Application</td>
<td>Updates details of an application.</td>
</tr>
<tr>
<td>Call Management</td>
<td>Get Call</td>
<td>Retrieves Call Detail Record (CDR) of the call.</td>
</tr>
<tr>
<td></td>
<td>Hang Up Call</td>
<td>Ends an ongoing call or cancel a queued outbound call.</td>
</tr>
<tr>
<td></td>
<td>Look up Call</td>
<td>Retrieves details of the specified call.</td>
</tr>
<tr>
<td></td>
<td>Make Call</td>
<td>Initiates an outbound call.</td>
</tr>
<tr>
<td></td>
<td>Start Recording Call</td>
<td>Starts recording an ongoing outbound call.</td>
</tr>
<tr>
<td></td>
<td>Stop Recording Call</td>
<td>Stops all the ongoing recordings for the specified call UUID.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Conference Management</td>
<td>Get Conference</td>
<td>Gets details of a conference.</td>
</tr>
<tr>
<td></td>
<td>Hang Up Conference</td>
<td>Hangs up all ongoing conferences in your account.</td>
</tr>
<tr>
<td></td>
<td>Hang Up Member</td>
<td>Hangs up a member in a conference.</td>
</tr>
<tr>
<td></td>
<td>Kick Member</td>
<td>Disconnects a member in a conference.</td>
</tr>
<tr>
<td></td>
<td>Look up Conferences</td>
<td>Retrieves a list of all conferences that are ongoing on your account.</td>
</tr>
<tr>
<td></td>
<td>Mute Member</td>
<td>Mutes members in a conference.</td>
</tr>
<tr>
<td></td>
<td>Unmute Member</td>
<td>Unmutes members in a conference.</td>
</tr>
<tr>
<td>SMS Management</td>
<td>Get Message</td>
<td>Retrieves the details of the specified message.</td>
</tr>
<tr>
<td></td>
<td>Look up Message</td>
<td>Retrieves the details of the messages.</td>
</tr>
<tr>
<td></td>
<td>Send Bulk SMS</td>
<td>Sends SMS to the multiple numbers.</td>
</tr>
<tr>
<td></td>
<td>Send SMS</td>
<td>Sends the SMS to the specified number.</td>
</tr>
</tbody>
</table>

**Spoke module**

Webhooks can be set up to be notified about the required events. Routing policy defines conditions that must be met to notify the ServiceNow instance. These conditions are based on the events in Plivo that you want to be notified about. When the conditions are met, routing policy triggers the associated subflow, which in turn automates the Plivo tasks.

Webhooks require separate setup and can be used independently without using the spoke actions. The Plivo spoke adds the Plivo Spoke application to your instance and includes these modules:
<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plivo Webhook Registries</td>
<td>Create and view the Plivo webhooks in ServiceNow.</td>
</tr>
<tr>
<td>Plivo Webhook Routing Policy</td>
<td>Create and view the routing policies for the Plivo webhooks in ServiceNow. You can also customise the conditions in the routing policies as per your requirement.</td>
</tr>
</tbody>
</table>

Use the Plivo Webhook Registries module to register a Plivo webhook. You must generate a Callback URL and provide this URL in your Plivo account.

Routing policies and subflows support these Plivo fields:
- Keywords
- Call Event
- Caller Name
- Event Type
- SMS Text
- To Number
- Show Related Fields

Create routing policy in the Plivo WebHook Routing Policies module and specify conditions as per your requirement. See Set up a webhook for the Plivo spoke for information regarding setting up and configuring the webhooks.

**Spoke user roles**

The Plivo spoke provides a Plivo Admin (sn_plivo_spoke.Plivo_Admin) role.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.
Set up the Plivo spoke

Integrate the ServiceNow instance and Plivo account by using the basic authentication to authenticate ServiceNow requests.

Before you begin

- Request IntegrationHub subscription.
- Activate Plivo spoke.
- Role required: admin

Create Credential record for the Plivo spoke

Create credential record for the Plivo account. The Plivo spoke connection and credential alias uses these credentials to authorize actions.

Procedure

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?.
3. Select Basic Auth Credentials.
4. On the Basic Auth Credentials form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter Plivo Credential.</td>
</tr>
<tr>
<td>User name</td>
<td>Auth ID of your Plivo account.</td>
</tr>
<tr>
<td>Password</td>
<td>Auth token of your Plivo account.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click Submit.

Create Connection record for the Plivo spoke

Create connection record for your Plivo account. The Plivo spoke connection and credential aliases use these connections to perform actions in Plivo.
Procedure

1. Navigate to Connections & Credentials > Connections & Credentials Aliases.
2. Open the alias record, Plivo.
3. From the Connections tab, click New.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter Plivo Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Plivo. For example, select Plivo Credential.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to Plivo. Enter <a href="https://api.plivo.com">https://api.plivo.com</a>.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>This field isn't applicable.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

5. In the Attributes tab, enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auth ID</td>
<td>Auth ID of your Plivo account.</td>
</tr>
<tr>
<td>API version</td>
<td>API version of your Plivo account. Enter v1.</td>
</tr>
</tbody>
</table>

6. Click Submit.

Set up a webhook for the Plivo spoke

Configure a webhook to subscribe to your Plivo account with a ServiceNow callback URL.
Before you begin
- Request IntegrationHub subscription
- Activate the Plivo spoke
- Role required: sn_plivo_spoke.Plivo_Admin and decision_table_admin

Register a Plivo webhook in ServiceNow
Register a Plivo webhook in your ServiceNow instance to notify the ServiceNow app when certain events occur in Plivo.

Before you begin
Role required: sn_plivo_spoke.Plivo_Admin and decision_table_admin

Procedure
1. Navigate to Plivo Spoke > Plivo Webhook Registries.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name to identify the record. For example, Plivo webhook.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the record.</td>
</tr>
<tr>
<td>Path</td>
<td>Plivo webhook path. By default, this path is set to api/</td>
</tr>
<tr>
<td></td>
<td>sn_plivo_spoke/plivo_webhook_handler/wh_entry.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click Save.
5. Click Callback URL.
   The system displays the webhook callback URL.
6. Copy and record the webhook callback URL.

Results
The Plivo webhook is registered in your ServiceNow instance.

Add a callback URL in Plivo
Provide a webhook callback URL in your Plivo account to create a webhook.

Before you begin
Role required: sn_plivo_spoke.Plivo_Admin and decision_table_admin
Procedure
1. Log in to your Plivo console.
2. Create an application in the Plivo console as per your requirement. For more information about creating an application in the Plivo console, see the Create an Application section in the Make your first Outbound Call page of the Plivo documentation. You can also refer to the Plivo Application documentation for more information about creating and updating an application using Plivo APIs.
3. Enter the webhook callback URL in MESSAGE URL and ANSWER URL, and configure the application as per your requirement.

Results
The callback URL is added in your Plivo account. You can create routing policies and subflows as per your requirement. See Create routing policy and customize webhook for information regarding the creation of new routing policies and subflows.

Create routing policy and customize webhook
Create a webhook routing policy and subflow as per your requirement.

Before you begin
Role required: sn_plivo_spoke.Plivo_Admin and decision_table_admin

About this task
Routing policy in the Plivo WebHook Routing Policy module triggers the subflows and notifies the ServiceNow instance when certain events occur in your Plivo account. See Plivo spoke for information about the fields that the routing policy and subflows support.

Procedure
1. Navigate to Flow Designer > Designer.
2. Click Subflows.
3. Create a copy of the default subflow. Two subflows are available along with Plivo spoke; Plivo Call Handler and Plivo SMS Handler. You can create a copy of either of these subflows as per your requirement.
4. Customize the subflow as per your requirement and publish it. See Subflows for more information about creating and using subflows, and Plivo spoke for information about the supported fields.
6. Click **New**.
7. On the form, fill in the fields.

### Decision form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Unique label to identify the routing policy.</td>
</tr>
<tr>
<td>Default answer</td>
<td>Option to specify if this is the default answer. The default answer is applicable when the conditions are not met.</td>
</tr>
<tr>
<td></td>
<td><strong>a.</strong> Click the lookup icon (🔍).</td>
</tr>
<tr>
<td></td>
<td><strong>b.</strong> Select the required subflow from the Document list.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Ensure that the <strong>Table name</strong> is <code>Flow [sys_hub_flow]</code>.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions to be met when the required events occur in Plivo.</td>
</tr>
<tr>
<td>Answer</td>
<td>Subflow that must be triggered when the specified conditions are met.</td>
</tr>
</tbody>
</table>

Routing policies and subflows support these Plivo fields:

- Keywords
- Call Event
- Caller Name
- Event Type
- SMS Text
- To Number
- Show Related Fields

8. Click **Submit**.

**Note:** These routing policies are saved in the Decision tables. Users are cautioned against directly updating or modifying data in these tables.

**Results**
The routing policy and subflow are created.

**Pluralsight spoke v1.1**
Manage users, learning, courses, and so on in the Pluralsight Skills account from your ServiceNow instance.
Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions

This spoke was built for Pluralsight GraphQL API version v1, but may be compatible with other future API versions.

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

• Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions

The Pluralsight spoke provides actions to automate Pluralsight tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Course Management</td>
<td>Look up Courses</td>
<td>Retrieves details of the specified Pluralsight courses.</td>
</tr>
<tr>
<td>Learning Management</td>
<td>Look up Learning Status for Course</td>
<td>Retrieves the learning status of the specified Pluralsight course.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up Learning Status for User</td>
<td>Retrieves the learning status for the specified Pluralsight user.</td>
</tr>
<tr>
<td></td>
<td>Look up Learning Status Data Stream</td>
<td>Retrieves the learning status of the specified course in Pluralsight.</td>
</tr>
<tr>
<td>Skill Management</td>
<td>Look up Skill Assessment Results</td>
<td>Retrieves the skill assessment results in Pluralsight.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Look up Skill Assessments</td>
<td>Retrieves the list of all available skill assessments in Pluralsight that can be taken by a user.</td>
</tr>
<tr>
<td></td>
<td>Look up Skill IQ Summary</td>
<td>Retrieves the skill IQ summary in Pluralsight.</td>
</tr>
<tr>
<td>User Management</td>
<td>Create User</td>
<td>Creates a user in Pluralsight.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Deactivate User</td>
<td>Removes a user's license from plan in Pluralsight.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Invite User</td>
<td>Invites the specified user to a plan in Pluralsight.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Look up Users</td>
<td>Retrieves details of the users in Pluralsight.</td>
</tr>
</tbody>
</table>

**Note:**
- Pluralsight Enterprise Plan is required to use this action.
- The action output, **Attempt Number** starts with 0 and this value is synchronised with value from Pluralsight.
See **Set up the Pluralsight spoke** for information about setting up the Pluralsight spoke.

**Set up the Pluralsight spoke**
Integrate the ServiceNow instance and your Pluralsight Skills account using an API key to authenticate the ServiceNow requests.

**Before you begin**
- Request IntegrationHub subscription.
- Activate the Pluralsight spoke.
- Admin access to the Pluralsight Skills account.
- Role required: admin

**Procedure**
1. Create an API key in your Pluralsight Skills account.
   
   a. Log in to your **Pluralsight Skill account** as an admin.
   
   b. Navigate to **Account** and click the **Integrations** tab.
   
   c. Click the **Pluralsight Developer Portal** link.

   ![Pluralsight Developer Portal](image)

   d. In the **Pluralsight Developer Portal**, click the **Manage Keys** tab.

   e. Click **Add Api Key**.
f. On the form, fill the fields and provide write permissions to the API Key.
g. Copy the API Key for later use.

2. Create a credential record for the Pluralsight spoke.
   a. Navigate to Connections & Credentials > Credentials.

   b. Click New.
      The system displays the message What type of Credentials would you like to create?.

   c. Select API Key Credentials.

   d. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the credential record. For example, Pluralsight Cred.</td>
</tr>
<tr>
<td>API Key</td>
<td>Value of the API key you created in the Pluralsight Skills account.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
</tbody>
</table>

   e. Click Submit.

3. Create a connection record for the Pluralsight spoke.

   b. Open the record for the Pluralsight spoke.
c. From the **Connections** tab, click **New**.

d. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, Pluralsight Conn.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for the Pluralsight spoke.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Connection URL to connect to your Pluralsight account. Enter <code>https://paas-api.pluralsight.com</code>.</td>
</tr>
</tbody>
</table>

e. Click **Submit**.

**Salesforce spoke v2.0.4**

The Salesforce spoke is built by Bristelcone, Inc. Access and manage data in the Account, Contact, Case, Lead, Opportunity, Order, and User objects of your Salesforce instance from the ServiceNow instance.

**Request apps on the Store**

Visit the **ServiceNow Store** website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the **ServiceNow Store version history release notes**.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see **Request IntegrationHub**.

**Supported version**

This spoke was built for the Salesforce API version v45.0, but may be compatible with later versions.
Spoke requirements

- Salesforce account
- Salesforce admin credentials
- Salesforce connected app configured to integrate with ServiceNow
- Salesforce connected app details such as, consumer key and consumer secret.
- IntegrationHub subscription

**Note:** For users who have installed Salesforce spoke v1, you can't upgrade from Salesforce spoke v1 to Salesforce spoke v1.2 directly. To upgrade, you must uninstall the Salesforce spoke v1 and then, install the Salesforce spoke v1.2.

You must also note that, Salesforce spoke v1 is certified on New York and Salesforce spoke v1.2 is certified on Orlando and Paris.

Spoke subflows

The Salesforce spoke provides subflows to access and manage data in the Salesforce Account, Case, Contract, and Opportunity objects.

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Subflow</td>
<td>Processes data in the account object when the Salesforce webhook is triggered.</td>
</tr>
<tr>
<td>Case Subflow</td>
<td>Processes data in the case object when the Salesforce webhook is triggered.</td>
</tr>
<tr>
<td>Contract Subflow</td>
<td>Processes data in the contract object when the Salesforce webhook is triggered.</td>
</tr>
<tr>
<td>Opportunity Subflow</td>
<td>Processes data in the opportunity object when the Salesforce webhook is triggered.</td>
</tr>
<tr>
<td>Salesforce Subflow</td>
<td>Processes data in any Salesforce object when the Salesforce webhook is triggered.</td>
</tr>
</tbody>
</table>

Spoke actions

The Salesforce spoke provides actions to access and manage data in the Salesforce, Account, Contact, Case, Lead, Opportunity, Order, and User objects.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Management</td>
<td>Create Account</td>
<td>Creates an account in Salesforce.</td>
</tr>
<tr>
<td></td>
<td>Look up Accounts</td>
<td>Retrieves all the account details based on the specified SOQL query.</td>
</tr>
<tr>
<td></td>
<td>Look up Records for Account</td>
<td>Retrieves all the records for an account based on the given relationship name.</td>
</tr>
<tr>
<td>Record Management</td>
<td>Create Record</td>
<td>Creates a record in Salesforce.</td>
</tr>
<tr>
<td></td>
<td>Delete Record</td>
<td>Deletes a record in Salesforce.</td>
</tr>
<tr>
<td></td>
<td>Get Record Details</td>
<td>Retrieves the specific record in Salesforce by Record ID.</td>
</tr>
<tr>
<td></td>
<td>Get Record Details Copy</td>
<td>Retrieves the record for the selected object name and for the given Record ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Attachment For Records</td>
<td>Retrieves an attachment for a record.</td>
</tr>
<tr>
<td></td>
<td>Look up Contracts</td>
<td>Retrieves the contract details based on the specified SOQL query.</td>
</tr>
<tr>
<td></td>
<td>Look up Related Records</td>
<td>Retrieves all the records for the specified object name associated with their given relationship name.</td>
</tr>
<tr>
<td></td>
<td>Subflow Helper Action</td>
<td>Parses the subflow's JSON input and generates an array of object.</td>
</tr>
<tr>
<td></td>
<td>Update Record</td>
<td>Updates a record in Salesforce.</td>
</tr>
<tr>
<td>Case Management</td>
<td>Create Case</td>
<td>Creates a case in Salesforce.</td>
</tr>
</tbody>
</table>

**Note:** Ensure that you use relevant actions to create records for Account, Contact, Case, Lead, Opportunity, Order, and User.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lead Management</td>
<td>Create Lead</td>
<td>Creates a lead in Salesforce.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Metadata - Check Service Cloud Feature</td>
<td>Checks whether Salesforce Service Cloud is enabled on the target Salesforce instance. To use this action, perform the steps outlined in the Create a Salesforce CRM integration profile section in Integrating with Salesforce CRM.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Metadata - Get Account Types</td>
<td>Retrieves all the available account types in Salesforce.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Metadata - Get Creatable Fields</td>
<td>Retrieves a list of creatable fields in a required standard or custom Salesforce table.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Metadata - Get Creatable Objects</td>
<td>Retrieves a list of creatable objects in Salesforce.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Metadata - Get Deletable Objects</td>
<td>Retrieves a list of deletable objects in Salesforce.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Metadata - Get Updatable Fields</td>
<td>Retrieves a list of updatable fields in a required standard or custom Salesforce table.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Metadata - Get Updatable Objects</td>
<td>Retrieves a list of updatable objects in Salesforce.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Metadata - Get Account Fields</td>
<td>Retrieves a list of fields in the Salesforce Account object.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Metadata - Get Case</td>
<td>Retrieves a list of case origins in Salesforce. The value field of the case origin from the Salesforce</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Origin Values</td>
<td>response body is mapped to the name field in JSON output.</td>
<td></td>
</tr>
<tr>
<td>Metadata - Get Case Priorities</td>
<td>Retrieves a list of case priorities in Salesforce. The value field of the case priority from the Salesforce response body is mapped to the name field in JSON output.</td>
<td></td>
</tr>
<tr>
<td>Metadata - Get Case Reasons</td>
<td>Retrieves a list of case reasons in Salesforce. The value field of the case reason from the Salesforce response body is mapped to the name field in JSON output.</td>
<td></td>
</tr>
<tr>
<td>Metadata - Get Case Status</td>
<td>Retrieves a list of case status values in Salesforce. The value field of the case status from the Salesforce response body is mapped to the name field in JSON output.</td>
<td></td>
</tr>
<tr>
<td>Metadata - Get Industries for Accounts</td>
<td>Retrieves all the industries available for accounts in Salesforce.</td>
<td></td>
</tr>
<tr>
<td>Metadata - Get Industries for Lead</td>
<td>Retrieves a list of industries in the Salesforce Lead object. The value field of the industry from the Salesforce response body is mapped to the name field in JSON output.</td>
<td></td>
</tr>
<tr>
<td>Metadata - Get Lead Status</td>
<td>Retrieves a list of lead status values in Salesforce. The value field of the lead status from the Salesforce response body is mapped to the name field in JSON output.</td>
<td></td>
</tr>
<tr>
<td>Metadata - Get Objects</td>
<td>Retrieves all the available object names in Salesforce.</td>
<td></td>
</tr>
<tr>
<td>Metadata - Get Opportunity Stages</td>
<td>Retrieves a list of opportunity stages in Salesforce. The value field of the opportunity stage from the Salesforce response body is mapped to the name field in JSON output.</td>
<td></td>
</tr>
<tr>
<td>Metadata - Get Opportunity Types</td>
<td>Retrieves a list of opportunity types in Salesforce. The value field of the opportunity type from the Salesforce response body is mapped to the name field in JSON output.</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Metadata</td>
<td>- Get Order Status Values</td>
<td>Retrieves a list of order status values in Salesforce. The value field of the order status from the Salesforce response body is mapped to the name field in JSON output.</td>
</tr>
<tr>
<td></td>
<td>- Get Organization Type</td>
<td>Retrieves the organization type of the Salesforce instance. To use this action, perform the steps outlined in the Create a Salesforce integration profile section in Integrating with Salesforce.</td>
</tr>
<tr>
<td></td>
<td>- Get Record Fields</td>
<td>Retrieves all the record fields for the specified table name.</td>
</tr>
<tr>
<td></td>
<td>- Get Relationship Fields</td>
<td>Retrieves all the relationship fields for the specified object name.</td>
</tr>
<tr>
<td></td>
<td>- Get Relationship Names</td>
<td>Retrieves all the relationship names for the specified object name.</td>
</tr>
<tr>
<td></td>
<td>- Get User Email Encodings</td>
<td>Retrieves a list of email encodings in the Salesforce User object. The value field of the email encoding from the Salesforce response body is mapped to the name field in JSON output.</td>
</tr>
<tr>
<td></td>
<td>- Get User Languages</td>
<td>Retrieves a list of languages in the Salesforce User object. The value field of the user language from the Salesforce response body is mapped to the name field in JSON output.</td>
</tr>
<tr>
<td></td>
<td>- Get User Locales</td>
<td>Retrieves a list of locales in the Salesforce User object. The value field of the user locale from the Salesforce response body is mapped to the name field in JSON output.</td>
</tr>
<tr>
<td></td>
<td>- Get User Time Zones</td>
<td>Retrieves list of time zones in the Salesforce User object. The value field of the time zone from the Salesforce response body is mapped to the name field in JSON output.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Opportunity</td>
<td>Create Opportunity</td>
<td>Creates an opportunity in Salesforce.</td>
</tr>
<tr>
<td>Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Order</td>
<td>Create Order</td>
<td>Creates an order in Salesforce.</td>
</tr>
<tr>
<td>Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User</td>
<td>Create User</td>
<td>Creates a user in Salesforce.</td>
</tr>
<tr>
<td>Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Look up User Profiles</td>
<td></td>
<td>Retrieves a list of user profiles in Salesforce. The name and ID fields of</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the user profiles from the Salesforce response body are mapped to the label</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and name fields respectively in the JSON output.</td>
</tr>
<tr>
<td>Look up User Roles</td>
<td></td>
<td>Retrieves a list of user roles in Salesforce. The name and ID fields of the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>user profiles from the Salesforce response body are mapped to the label and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>name fields respectively in the JSON output.</td>
</tr>
<tr>
<td>Look up Users</td>
<td></td>
<td>Retrieves user attributes for Salesforce users. To use this action, perform</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the steps outlined in the Create a Salesforce CRM integration profile section</td>
</tr>
<tr>
<td></td>
<td></td>
<td>in Integrating with Salesforce CRM.</td>
</tr>
<tr>
<td>Remove User</td>
<td></td>
<td>Reclaims a user account in Salesforce. To use this action, perform the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>steps outlined in the Create a Salesforce CRM integration profile section</td>
</tr>
<tr>
<td></td>
<td></td>
<td>in Integrating with Salesforce CRM.</td>
</tr>
</tbody>
</table>

**Salesforce account requirements**

The Salesforce spoke requires configuring your Salesforce account to generate an OAuth 2.0 JWT Bearer Grant token.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.
**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Salesforce alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

**Set up the Salesforce spoke**

Integrate your Salesforce account with your ServiceNow instance. Create a custom OAuth application in Salesforce and authenticate requests from ServiceNow.

**Before you begin**

- Request an IntegrationHub subscription
- Activate Salesforce spoke
- Role required: admin

**Create a connected app in Salesforce**

Create a connected app in your Salesforce account to enable OAuth 2.0 authentication with the Salesforce spoke.

**Before you begin**

- Salesforce account
- Role required: Salesforce admin

**About this task**

Complete these steps from your Salesforce account. See Create a Connected App in Salesforce Trailblazer forum documentation for instructions on creating and configuring connected apps.

**Procedure**

1. From your Salesforce account, create a connected app.
2. Configure the connected app to enable your Salesforce application to share data with your ServiceNow instance.
   
   a. Select **Enable OAuth Settings** and configure the authentication settings.
   b. Select **Use Digital Signatures** and upload a Java KeyStore (JKS) certificate.
   c. Select the OAuth scopes:
• Access and manage your data (api)
• Perform requests on your behalf at any time (refresh_token, offline_access)

d. Specify ServiceNow instance URL in Callback URL in this format: https://<instance-name>.service-now.com/oauth_redirect.do

e. After creating the connected app, under OAuth Policies on the Edit Policies page, set these values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permitted Users</td>
<td>Admin approved users are pre-authorized</td>
</tr>
<tr>
<td>IP Restrictions</td>
<td>Relax IP Restrictions</td>
</tr>
</tbody>
</table>

f. Configure user provisioning for the connected app as per your requirement.

3. Record the values of Consumer Key and Consumer Secret.

Results
The connected app is created in Salesforce.

Attach a Java Key Store certificate to the Salesforce spoke
Enable the JSON Web Token (JWT) Bearer Grant token authentication by attaching a valid Java KeyStore (JKS) certificate to the Salesforce spoke.

Before you begin
• Valid Java KeyStore certificate
• Role required: admin

Procedure
1. Navigate to System Definition > Certificates.
2. Click New.
3. On the form, fill in the fields.
**X.509 Certificate form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Salesforce Certificate.</td>
</tr>
<tr>
<td>Expiration notification</td>
<td>Option to send a notification when the certificate is about to expire.</td>
</tr>
<tr>
<td>Notify on expiration</td>
<td>Users that are notified when the certificate expires.</td>
</tr>
<tr>
<td>Warn in days to expire</td>
<td>Number of days to send a notification before the certificate expires.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the certificate.</td>
</tr>
<tr>
<td>Format</td>
<td>Certificate format. The instance supports the PEM and DER formats.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of certificate. Select <strong>Java Key Store</strong>.</td>
</tr>
<tr>
<td>Valid from</td>
<td>Date from which the certificate is valid.</td>
</tr>
<tr>
<td>Expires</td>
<td>Date on which the certificate expires.</td>
</tr>
<tr>
<td>Expires in days</td>
<td>Number of days until the certificate expires.</td>
</tr>
<tr>
<td>Key store password</td>
<td>Password associated with the certificate.</td>
</tr>
<tr>
<td>Short description</td>
<td>Summary about the certificate.</td>
</tr>
<tr>
<td>PEM Certificate</td>
<td>Contents of the X509 certificate.</td>
</tr>
</tbody>
</table>

4. Click the attachments icon (_attach) and attach a JKS certificate.

5. Click **Validate Stores/Certificates**.

**Results**
The JKS certificate is created and attached to the Salesforce spoke.

**Create a JWT signing key for the Salesforce spoke**
Create a JSON Web Token (JWT) signing key to assign to your Java KeyStore certificate.

**Before you begin**
Role required: admin
Procedure

1. Navigate to **System OAuth > JWT Keys**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the JWT signing key. For example, <em>Salesforce JWT Keys</em>.*</td>
</tr>
<tr>
<td>Signing Keystore</td>
<td>Valid JKS certificate attached in the previous task. For example, <em>Salesforce Certificate</em>.*</td>
</tr>
<tr>
<td>Key Id</td>
<td>Key ID to identify which key is used when multiple keys are used to sign tokens.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record. Select <em>Salesforce spoke</em>.</td>
</tr>
<tr>
<td>Signing Algorithm</td>
<td>Algorithm to sign with the JWT key.</td>
</tr>
<tr>
<td>Signing Key Password</td>
<td>Password associated with the signing key.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the certificate.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Results**
The JWT key is created and assigned to the JKS certificate.

Create a JWT provider for the Salesforce spoke

Add a JSON Web Token (JWT) provider to your ServiceNow instance.

**Before you begin**
Role required: admin

**Procedure**

1. Navigate to **System OAuth > JWT Providers**.
2. Click **New**.
3. On the form, fill in the fields.
**JWT Provider form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the JWT provider. For example, Salesforce JWT Provider.</td>
</tr>
<tr>
<td>Expiry Interval (sec)</td>
<td>Number, in seconds, to set the lifespan of JWT provider tokens.</td>
</tr>
<tr>
<td>Signing Configuration</td>
<td>JWT signing key from the previous step. For example, Salesforce JWT Keys.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**.
The Standard Claims and Custom Claims related lists are displayed.

5. In the **Standard Claims** related list, enter values for **iss**, **sub**, and **aud**. See [OAuth 2.0 JWT Bearer Flow for Server-to-Server Integration in Salesforce Trailblazer forum documentation](#) for instructions.

6. Click **Update**.

**Results**
The JWT provider is added to your ServiceNow instance.

**Register Salesforce as an OAuth Provider**

Use the information generated during Salesforce connected app configuration to register Salesforce as an OAuth provider and enable the instance to request OAuth 2.0 tokens.

**Before you begin**
Role required: admin

**Procedure**

1. Navigate to **System OAuth > Application Registry**.
2. Click **New**.
The system displays the message **What kind of OAuth application?**
3. Select **Connect to a third party OAuth Provider**.
The system displays a blank Application Registrries form.
4. On the form, fill in the fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter Salesforce OAuth.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Consumer key that you generated during the Salesforce connected app configuration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Consumer secret that you generated during the Salesforce connected app configuration.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Optional script to customize the request and response.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Grant type used to establish the token. Select JWT Bearer.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>Time, in seconds, that the refresh token is valid. The default time is 8,640,0000 seconds.</td>
</tr>
<tr>
<td>PKCE required</td>
<td>Option to enable public clients to require PKCE for an authorization.</td>
</tr>
<tr>
<td>Note: You can use only Authorization Code as the Default Grant type when PKCE is enabled.</td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record. Select Salesforce.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Application scope that this registry is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>This field should be left blank.</td>
</tr>
<tr>
<td>Token URL</td>
<td>OAuth server token endpoint.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>This field should be left blank.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>This field should be left blank.</td>
</tr>
<tr>
<td>Field Value required</td>
<td>• For production instance, enter <a href="https://login.salesforce.com/services/oauth2/token">https://login.salesforce.com/services/oauth2/token</a>.</td>
</tr>
<tr>
<td></td>
<td>• For sandbox instance, enter <a href="https://test.salesforce.com/services/oauth2/token">https://test.salesforce.com/services/oauth2/token</a>.</td>
</tr>
</tbody>
</table>

5. Right-click the form header, and click **Save**.

• The system validates the OAuth credentials and populates the **Redirect URL** field.

• The system populates **OAuth Entity Profile** with **Grant Type** as **JWT Bearer**. For example, **OAuth Entity Profile** is created with default **Name**, **Salesforce JWT provider default_profile**.

6. Copy the value from the **Redirect URL** field.

7. Click **Update**.

8. Log in to your Salesforce account to edit the configuration of your connected app. See the Salesforce Trailblazer forum documentation for instructions.

9. Paste the Redirect URL value into the Callback URL of your Salesforce connected app. For example, paste https://<instance-name>.service-now.com/oauth_redirect.do.

**Results**
The instance can request OAuth 2.0 tokens for the Salesforce spoke.

**Note:** When an OAuth token expires, the spoke automatically regenerates a new token in most cases. If a token expires and is not regenerated, a user with the admin role can regenerate the spoke OAuth token.

**Create credential records for the Salesforce spoke**
Create Credential records for the Salesforce connected app that you created. The Salesforce spoke connection and credential alias use these credentials to authorize actions.

**Before you begin**
Role required: admin
Procedure

1. Navigate to Connections & Credentials > Credentials.

2. Click New.
   The system displays the message What type of Credentials would you like to create?.

3. Select OAuth 2.0 Credentials.
   The pop-up window displays a blank OAuth 2.0 Credentials form.

4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter Salesforce Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile that you created when you registered the Salesforce connected app as an OAuth provider. For example, select Salesforce OAuth default_profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Save the record.

6. Click the Get OAuth Token related link to generate the OAuth token.

Results
The credential record for the Salesforce spoke is created.

Create connection records for the Salesforce spoke
Create connection records for your Salesforce account. The Salesforce spoke connection and credential alias use these connections to perform actions in Salesforce.

Before you begin
Role required: admin

Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.

2. Open for the record for Salesforce.
3. On the **Connections** tab, click **New**.
   The system displays a blank HTTP(s) Connection form.

4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter <em>Salesforce Connection</em>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you that created for Salesforce. For example, select <em>Salesforce Credentials</em>.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td><strong>Note:</strong> Do not select the check box.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to your Salesforce instance. Enter <em><a href="https://ap8.salesforce.com">https://ap8.salesforce.com</a></em>.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Server. If you select this check box, define the fields in the Advanced MID Server Configuration related list.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click **Save**.

6. Ensure that **api_version** is set to **v45.0** in the Attributes related list.

**Results**
The Salesforce spoke is set up and integrated with the ServiceNow instance.

**Set up a bi-directional webhook**
Configure a webhook to subscribe to Salesforce events with a ServiceNow callback URL.

**Before you begin**
- Set up the Salesforce spoke
- Role required: admin
Procedure

1. Log in as an administrator to your Salesforce instance.

2. Obtain the Salesforce instance details. For more information, see the View instance information for your Salesforce Organization knowledge article in Salesforce Trailblazer forum.
   
a. If you don't have Salesforce custom domains, obtain the Salesforce instance name from the Company Information page.

b. If you have custom domains, navigate to Domain Management > My Domain and copy the domain name. For example, if the complete domain name on the page is newdomain-customdomain.my.salesforce.com, copy and record the value newdomain-customdomain.

3. Obtain the 18-digit Organization ID of your Salesforce instance.
   
a. Navigate to the Developer Console in your Salesforce instance and run this query:

   Select Id from Organization

   b. Copy and record the value of the 18-digit Organization ID.

4. Log in to your ServiceNow instance.

5. Create a webhook registry.

   a. Navigate to Salesforce Webhook Registry > Salesforce Webhook Registries.

   b. Click New.

   c. On the form, fill these values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization ID</td>
<td>18-digit Organization ID of your Salesforce instance.</td>
</tr>
<tr>
<td>Instance Name</td>
<td>Name of the Salesforce instance obtained from the Company Information page or custom domain of the Salesforce instance obtained</td>
</tr>
</tbody>
</table>
6. Obtain the resource path from your ServiceNow instance.

   a. Navigate to System Web Services > Scripted Web Services > Scripted REST APIs.

   b. Open the record, Salesforce Webhook Callbacks.

   c. In the Resources tab, click the Default Callback record.

   d. Copy and record the value of Resource path. The required ServiceNow endpoint URL is: https://<instance-name>.service-now.com/<resource-path>

7. Configure the default subflows or create subflows as per your requirement. These subflows are triggered when the required events occur in Salesforce instance. For more information, see Subflows.

8. Configure the webhook routing policy.

   a. Navigate to System Definition > Decision Tables.

   b. Open the record, Salesforce Decision Webhook Policy.

   c. In the Decisions tab, click New.

   d. On the form, fill these values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Unique label to identify the routing policy.</td>
</tr>
<tr>
<td>Answer</td>
<td>Subflow that must be triggered when the specified conditions are met.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default Answer</td>
<td>Option to specify if this is the default answer.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions to be met when the required events occur in Salesforce.</td>
</tr>
</tbody>
</table>

**Note:** By default, these Salesforce objects are supported in the webhook routing policies:

- Account
- Case
- Contract
- Opportunity

You can configure the default decision table to support other Salesforce objects as per your requirement.

e. Click **Save**.

9. From your Salesforce instance, create outbound message. For information about creating the outbound message, see [Outbound Message Actions](#) in Salesforce Trailblazer forum.

   In the **Endpoint URL**, enter the ServiceNow endpoint URL in this format: https://<instance-name>.service-now.com/<resource-path>.

10. From your Salesforce instance, create a workflow rule and configure it to trigger the outbound message you had earlier created. For information about creating the workflow rule, see [Create a Workflow Rule](#) in Salesforce Trailblazer forum.

**Salesforce Marketing Cloud spoke**

The Salesforce Marketing Cloud spoke is built by Bristlecone, Inc. This spoke provides actions to retrieve records from your Salesforce Marketing Cloud data extensions and retrieve and update user information.

**Request apps on the Store**

Visit the [ServiceNow Store](#) website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the [ServiceNow Store version history release notes](#).
IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Salesforce Marketing Cloud Corporate Edition.

Spoke requirements
• Admin user with privileges to create new users and roles in Salesforce Marketing Cloud

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow IntegrationHub Action Step - SOAP (com.glide.hub.action_step.soap)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

<i>Note:</i> Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Salesforce Marketing Cloud spoke provides actions to automate Salesforce Marketing Cloud tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Extension Management</td>
<td>Look up Data Extension Attributes</td>
<td>Retrieves records from data extensions with less than 2500 records.</td>
</tr>
<tr>
<td></td>
<td>Look up Data Extension Attributes for Bulk Records Stream</td>
<td>Retrieves bulk records from data extensions.</td>
</tr>
</tbody>
</table>
### Look up Users Stream
Retrieves user properties for your Salesforce Marketing Cloud users based on the specified user properties and associated filters.

### Update User by User ID
Updates user properties based on the user ID.

## Spoke tables
The Salesforce Marketing Cloud spoke adds the following table:

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configurations</td>
<td>Displays the list of Salesforce Marketing Cloud configurations, such as data extensions.</td>
<td>• Configuration Type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Configuration Value</td>
</tr>
</tbody>
</table>

## Connection and credential alias requirements
The Salesforce Marketing Cloud spoke uses a Connection & Credential alias for the connection setup and the user profile that is attached to the SOAP security policies for the credential setup. If you are connecting to multiple Salesforce Marketing Cloud environments, you must use the same credential information in each environment.

## Set up the Salesforce Marketing Cloud spoke
Integrate the ServiceNow instance and Salesforce Marketing Cloud by using Salesforce Marketing Cloud credentials to authenticate ServiceNow requests.

### Before you begin
- Request an IntegrationHub subscription.
- Activate Salesforce Marketing Cloud spoke.
- Salesforce Marketing Cloud role required: admin user with privileges to create new users and roles
- ServiceNow role required: admin
Create a user for accessing the Salesforce Marketing Cloud SOAP API

Create a user with which you can access the Salesforce Marketing Cloud SOAP API. The SOAP API enables you to retrieve records from your Salesforce Marketing Cloud data extensions and get information about your Salesforce Marketing Cloud users.

Before you begin
Salesforce Marketing Cloud role required: admin user with privileges to create new users and roles

Procedure
1. From a web browser, go to your Salesforce Marketing Cloud instance.
2. Log in using your admin credentials.
3. On the page header of your instance, click your profile icon and then select Setup.
The Setup page opens.
4. Create a Salesforce Marketing Cloud user.

a. Navigate to Administration > Users > Users and then click Create.
The New User form opens.

b. In the General Settings form section, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the user.</td>
</tr>
<tr>
<td>Reply Email Address</td>
<td>Email address that you want to send and reply to email messages from. Salesforce Marketing Cloud also sends forgotten password requests to this email address. After you enter an email address, click Verify to verify the email address.</td>
</tr>
<tr>
<td>Add to From Name Dropdown</td>
<td>Option to send the reply email address through a domain verification process before the email address populates in an email.</td>
</tr>
<tr>
<td>Notification Email Address</td>
<td>Email address that you want to send Salesforce Marketing Cloud notifications to.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Username</td>
<td>Username for the user.</td>
</tr>
<tr>
<td>External Key</td>
<td>Key that uniquely identifies the user during API calls.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Time zone in which the user is located.</td>
</tr>
<tr>
<td>Culture Code</td>
<td>Language that is used on the Salesforce Marketing Cloud user interface for this user.</td>
</tr>
<tr>
<td>API User</td>
<td>Option indicating whether the user can access the Salesforce Marketing Cloud APIs. Select the check box to enable this option.</td>
</tr>
<tr>
<td>Temporary Password</td>
<td>Temporary password with which the user can log in for the first time. The user is prompted to change this password on the first login.</td>
</tr>
<tr>
<td>Verify Password</td>
<td>Field to verify the temporary password.</td>
</tr>
</tbody>
</table>

**c. Click Save.**

**5. Create a user role that enables assigned users to access the Salesforce Marketing Cloud SOAP API and also manage users and data extensions.**

**a. Navigate to Administration > Users > Roles and then click Create.**
The New Role form opens.

**b. In the Properties form section, fill in the fields.**

<table>
<thead>
<tr>
<th>Properties</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the user role.</td>
</tr>
<tr>
<td>External Key</td>
<td>Key that uniquely identifies the user role.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the user role.</td>
</tr>
</tbody>
</table>

**c. In the Permissions form section, expand the Email > Subscribers > Data Extension permission category and then select the Allow check box for the View and Manage Data access permissions.**
d. Expand the Email > Admin > API Access permission category and then select the Allow check box for the WebService API access permission.

e. Expand the Administration > Users permission category and then select the Allow check box for the following access permissions:
   • View
   • Update
   • Disable
   • Manage Business Units

f. Click Save.

6. Assign the user role to your Salesforce Marketing Cloud user.

   a. Navigate to Administration > Users > Users.

   b. From the list of available users, select the check box for the user that you created in step 4.

   c. Click Manage Roles.
      The Roles form for the selected user opens.

   d. In the Roles form section, click Edit Roles.

   e. When the list of available roles appears, select the check box for the user role that you created in step 5.

   f. Click Save.

Create a connection and credential for Salesforce Marketing Cloud

Create a connection and credential for Salesforce Marketing Cloud so that you can connect your ServiceNow instance with the Salesforce Marketing Cloud SOAP API.

Before you begin
ServiceNow role required: admin
**Procedure**

1. From your ServiceNow instance, navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. From the list of available connection and credential aliases, select **SalesforceMarketingCloud**.
3. On the Connection & Credential Aliases form, click the **Create New Connection & Credential** related link.
   The Create Connection and Credential dialog box opens.
4. In the dialog box, fill in the fields.

Create Connection and Credential dialog box

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Please Enter the Connection Information</td>
<td></td>
</tr>
<tr>
<td>Connection Name</td>
<td>Name of the connection.</td>
</tr>
<tr>
<td>SOAP Connection URL</td>
<td>URL of your SOAPConnection endpoint. Enter https://&lt;subdomain&gt;.soap.marketingcloudapis.com/Service.asmx, where &lt;subdomain&gt; is your Salesforce Marketing Cloud subdomain.</td>
</tr>
<tr>
<td>Please Enter the Credential Information</td>
<td></td>
</tr>
<tr>
<td>Username Profile Name</td>
<td>Name of your credentials.</td>
</tr>
<tr>
<td>Username</td>
<td>Username of the user that you can access the Salesforce Marketing Cloud SOAP API with. Enter the username of the user that you created in Create a user for accessing the Salesforce Marketing Cloud SOAP API.</td>
</tr>
<tr>
<td>Password</td>
<td>Password of the user that you can access the Salesforce Marketing Cloud SOAP API with. Enter the password of the user that you created in Create a user for accessing the Salesforce Marketing Cloud SOAP API.</td>
</tr>
</tbody>
</table>

5. Click **Create**.

**SAP Ariba spoke v1.0.3**

Manage the master and transactional data of buying and sourcing suites in SAP Ariba instance from your ServiceNow instance.
**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Spoke requirements**

- Enable ITK by creating a shared secret. Copy and record the integration password for later use.

  **Note:** If you want to create two shared secrets, one for sourcing suite and another for buying suite, you must provide the same shared secret.
  - To create shared secret for sourcing suite, navigate to Administration in your SAP Ariba solution.
  - To create shared secret for buying suite, navigate to Core Administration in your SAP Ariba solution.

  For more information, see Shared secret-based authentication in SAP Help Portal.

- Copy and record the realm of your SAP Ariba instance.

- In Administration, create an inbound endpoint in End Point Configuration under Integration Manager. Copy and record the login password you have provided under HTTP Authentication. For information about creating an endpoint, see Create New Integration End-Point in SAP Help Portal.
  
  Enable SOAP service of the Import Sourcing Project task for your inbound endpoint in Integration Configuration under Integration Manager.
  
  - Copy and record the URL in the Integration Task URL field.
  
  - Open the WSDL file. Copy and record the value of the targetNamespace parameter.
  
  For information about Integration Task URL and targetNamespace, see Enable an Integration Task in SAP Help Portal.

- In Core Administration, create an inbound endpoint in End Point Configuration under Integration Manager. Copy and record the login password you have provided under HTTP Authentication. For information about creating an endpoint, see Create New Integration End-Point in SAP Help Portal.
Enable SOAP service of the Import Suppliers task for your inbound endpoint in **Integration Configuration** under **Integration Manager**.

- Copy and record the URL in the Integration Task **URL** field.
- Open the WSDL file. Copy and record the value of the `targetNamespace` parameter.

For information about Integration Task **URL** and `targetNamespace`, see Enable an Integration Task in SAP Help Portal.

**Spoke dependencies**
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Action Step - SOAP (com.glide.hub.action_step.soap)
- Complex Object (com.glide.cobject)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- Flow Designer Action Step - Script on MID (com.glide.hub.action_step.script_mid)
- Utility Actions spoke v1.0.1

⚠ **Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke flows**
The SAP Ariba spoke provides sample flows to demonstrate automating the SAP Ariba tasks. To customize a sample flow, copy it to the required application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITK Import Supplier Organizations Buyer</td>
<td>Imports supplier organizations to the buying suite of your SAP Ariba instance.</td>
</tr>
<tr>
<td>ITK Import Supplier Organizations Sourcing</td>
<td>Imports supplier organizations to the sourcing suite of your SAP Ariba instance.</td>
</tr>
</tbody>
</table>
**Spoke actions**

The SAP Ariba spoke provides actions to automate SAP Ariba tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metadata Retrieval</td>
<td>Get Ariba Additional Fields</td>
<td>Retrieves additional input fields for the specified action.</td>
</tr>
<tr>
<td>SAP Ariba ITK Export</td>
<td>Copy Ariba File To Data Source</td>
<td>Takes sys ID of the source record and transfers the attachment to the target data source.</td>
</tr>
<tr>
<td></td>
<td>Execute Ariba Export Task</td>
<td>Executes the Ariba export task event where a file is received as response and stored to the Ariba task execution table records.</td>
</tr>
<tr>
<td>SAP Ariba ITK Import</td>
<td>Execute Ariba Import Task</td>
<td>Triggers the SAP Ariba import task for the specified operation.</td>
</tr>
<tr>
<td>Sourcing Project</td>
<td>Create Sourcing Project</td>
<td>Creates a sourcing project in SAP Ariba.</td>
</tr>
<tr>
<td></td>
<td>Update Sourcing Project</td>
<td>Updates the project header fields of the specified sourcing project.</td>
</tr>
<tr>
<td>Supplier</td>
<td>Create Suppliers</td>
<td>Creates suppliers in the SAP Ariba buying suite.</td>
</tr>
</tbody>
</table>

**Spoke module**

The SAP Ariba spoke adds the SAP Ariba Spoke application to your instance and includes these modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ariba Export Configuration Definition</td>
<td>Displays the list of available export configurations. By default, 33 export configurations are available along with the spoke. You can modify the default export configuration or create export configurations, as per requirements.</td>
</tr>
<tr>
<td>Module</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ariba Export Task Execution</td>
<td>Displays the CSV files generated when data is exported from your SAP Ariba instance to ServiceNow instance. You must copy these records to data source. Else, the records are deleted after the time period mentioned in the Ariba Export Task Scheduler scheduled script has lapsed.</td>
</tr>
<tr>
<td>Ariba Import Configuration</td>
<td>Displays the list of available import configurations. By default, two import configurations are available along with the spoke. You must use Execute Ariba Import Task action in your flow to create the required records.</td>
</tr>
<tr>
<td></td>
<td>• If you have selected the <strong>MasterDataBatchPull</strong> task in the Execute Ariba Import Task action, the master data records for the sourcing suite are created or updated in your SAP Ariba instance.</td>
</tr>
<tr>
<td></td>
<td>• If you have selected the <strong>CombinedDataPull</strong> task in the Execute Ariba Import Task action, the master data records for the buying suite are created or updated in your SAP Ariba instance.</td>
</tr>
<tr>
<td>Supplier IDs Buyer</td>
<td>Displays information about the suppliers in the buying suite. Admin must create the supplier records here.</td>
</tr>
<tr>
<td></td>
<td>The Look Up Supplier IDs Buyer Records action in the ITK Import Supplier</td>
</tr>
</tbody>
</table>

For example, if you have used the Execute Ariba Export Task action in your flow to export receipts, data is retrieved from your SAP Ariba instance to ServiceNow instance. You must copy these records to data source. Else, the records are deleted after the time period mentioned in the Ariba Export Task Scheduler scheduled script has lapsed. You can use the Copy Ariba File To Data Source action in your flow to copy the record to your data source.
<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organizations Buyer sample flow</td>
<td>Organizations Buyer sample flow uses these records to run the flow.</td>
</tr>
<tr>
<td>Supplier IDs Sourcing</td>
<td>Displays information about the suppliers in the sourcing suite. Admin must create the supplier records here. The Look Up Supplier IDs Sourcing Records action in the ITK Import Supplier Organizations Sourcing sample flow uses these records to run the flow.</td>
</tr>
<tr>
<td>Supplier Organizations Buyer</td>
<td>Displays information about the supplier organizations in the buying suite. Admin must create records here. The Look Up Supplier Organizations Buyer Records action in the ITK Import Supplier Organizations Buyer sample flow uses these records to run the flow.</td>
</tr>
<tr>
<td>Supplier Organizations Sourcing</td>
<td>Displays information about the supplier organizations in the sourcing suite. Admin must create records here. The Look Up Supplier Organizations Sourcing Records action in the ITK Import Supplier Organizations Sourcing sample flow uses these records to run the flow.</td>
</tr>
</tbody>
</table>

Data accessed through these spoke modules is stored in these tables:

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ariba Export Configuration Definition</td>
<td>Stores information about the export configurations.</td>
</tr>
<tr>
<td>[sn_sap_ariba_spoke_ariba_file_definition]</td>
<td></td>
</tr>
<tr>
<td>Ariba Import Configuration Definition</td>
<td>Stores information about the import configurations.</td>
</tr>
<tr>
<td>[sn_sap_ariba_spoke_ariba_import_configuration_definition]</td>
<td></td>
</tr>
<tr>
<td>Ariba Export Task Execution</td>
<td>Stores information.</td>
</tr>
<tr>
<td>[sn_sap_ariba_spoke_ariba_task_execution]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Supplier Organizations Sourcing</td>
<td>Stores information about the supplier organizations in the sourcing suite. Admin must create these records in the Supplier Organizations Sourcing module.</td>
</tr>
<tr>
<td>[sn_sap_ariba_spoke_import_supplier_organizations_csv]</td>
<td></td>
</tr>
<tr>
<td>Supplier IDs Sourcing [sn_sap_ariba_spoke_supplier_ids]</td>
<td>Stores information about the suppliers in the sourcing suite. Admin must create these records in the Supplier IDs Sourcing module.</td>
</tr>
<tr>
<td>Supplier IDs Buyer [sn_sap_ariba_spoke_supplier_ids_buyer]</td>
<td>Stores information about the suppliers in the buying suite. Admin must create these records in the Supplier IDs Buyer module.</td>
</tr>
</tbody>
</table>
### Table

<table>
<thead>
<tr>
<th>Supplier Organizations Buyer [sn_sap_ariba_spoke_supplier_organizations]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stores information about the supplier organizations in the buying suite. Admin must create these records in the Supplier Organizations Buyer module.</td>
<td></td>
</tr>
</tbody>
</table>

### Spoke scheduled script and system property

A scheduled script, Ariba Export Task Scheduler, and system property, `sn_sap_ariba_spoke.ariba.export.task.scheduler`, are available along with the spoke. The system property defines the number of days by which all the records older than this will be purged. The script uses this value to purge the records that have not been copied to data source.

- To view the scheduled script, enter `sysauto_script_list.do` in the filter navigator and search for the script, Ariba Export Task Scheduler.

- To view the system property, navigate to System Properties > All Properties and search for the system property, `sn_sap_ariba_spoke.ariba.export.task.scheduler`.

You can configure the scheduled script and system property as per your requirement.

### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

Four connection and credential alias records are available along with the spoke:

- SAP_Ariba_Import
- SAP_Ariba_ITK
• SAP_Ariba_Sourcing
• SAP_Ariba_Suppliers

**MID Server requirements**
These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the SAP Ariba alias to configure where actions run as well as set MID Server selection attributes. For more information about running actions on the MID Server, see Integration steps

⚠️ **Note:** You must set up MID Server to use the Execute Ariba Export Task action.

**Set up the SAP Ariba**
Integrate the ServiceNow instance and SAP Ariba by using the Basic Auth and API Key credentials to authenticate ServiceNow requests.

**Before you begin**
• Request an IntegrationHub subscription.
• Activate SAP Ariba spoke.
• Role required: admin

**Create credential records for the SAP Ariba**
Create credential records for the SAP Ariba instance. The SAP Ariba connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Create credential record for the SAP Ariba ITK Export actions.

   a. Navigate to Connections & Credentials > Credentials.

   b. Click New.
      
      The system displays this message: What type of Credentials would you like to create?

   c. Select API Key Credentials.

   d. On the form, fill these values.
API Key Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, ITK Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>API Key</td>
<td>Integration password provided for shared secret-based authentication. For more information, see Shared secret-based authentication in SAP Help Portal.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Option to specify if the credential applies to all MID Servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use this credential in the MID servers field.</td>
</tr>
<tr>
<td></td>
<td>Note: You must set up MID Server to use the Execute Ariba Export Task action.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, 100.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias associated with the spoke.</td>
</tr>
</tbody>
</table>

**e. Click Submit.**

2. Create credential record for the Sourcing Project actions.

**a. Navigate to Connections & Credentials > Credentials.**

**b. Click New.**

The system displays this message: What type of Credentials would you like to create?

**c. Select Basic Auth Credentials.**

**d. On the form, fill these values.**

Basic Auth Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Ariba_Sourcing Cred.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User name</td>
<td>User name to log in to your SAP Ariba instance.</td>
</tr>
<tr>
<td>Password</td>
<td>Login password provided under HTTP Authentication when you created an inbound endpoint in Administration. For information about creating an endpoint, see Create New Integration End-Point in SAP Help Portal.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, 100.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias associated with the spoke.</td>
</tr>
</tbody>
</table>

**e. Click Submit.**

**3. Create credential record for the Supplier action.**

**a. Navigate to Connections & Credentials > Credentials.**

**b. Click New.**

The system displays this message: What type of Credentials would you like to create?

**c. Select Basic Auth Credentials.**

**d. On the form, fill these values.**

**Basic Auth Credentials form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Ariba_Supplier Cred.</td>
</tr>
<tr>
<td>User name</td>
<td>User name to log in to your SAP Ariba instance.</td>
</tr>
<tr>
<td>Password</td>
<td>Login password provided under HTTP Authentication when you created an inbound endpoint in Core Administration. For information about creating an endpoint, see Create New Integration End-Point in SAP Help Portal.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, 100.</td>
</tr>
</tbody>
</table>
Create connection records for the SAP Ariba

Create connection records for your SAP Ariba instance. The SAP Ariba connection and credential aliases use these connections to perform actions in SAP Ariba.

Procedure

1. Create connection record for the SAP Ariba Export ITK actions.
   b. Open the alias record, SAP_Ariba_ITK.
   c. From the Connections tab, click New.
   d. On the form, fill these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, ITK Exp Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for ITK. For example, ITK Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to SAP Ariba instance. Enter: <a href="https://sl.ariba.com">https://sl.ariba.com</a></td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
</tbody>
</table>
| Use MID server         | Option to use a MID Servers for this connection. Select the checkbox and define the fields in the Advanced MID Server Configuration related list.

e. Click Submit.
e. In the **Attributes** tab, enter the value of realm of your SAP Ariba instance in **Realm**.

f. Click **Submit**.

2. Create connection record for SAP Ariba ITK Import actions.
   
a. Navigate to **Connections & Credentials > Connections & Credentials Aliases**.

b. Open the alias record, **Ariba_Import**.

c. From the **Connections** tab, click **New**.

d. On the form, fill these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Name to uniquely identify the record. For example, <strong>ITK Imp Connection</strong>.</td>
</tr>
<tr>
<td><strong>Credential</strong></td>
<td>Credential record is not necessary for this connection record.</td>
</tr>
<tr>
<td><strong>Connection alias</strong></td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td><strong>Connection URL</strong></td>
<td>Base URL to connect to SAP Ariba instance. Enter: <strong><a href="https://sl.ariba.com">https://sl.ariba.com</a></strong></td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td><strong>Domain</strong></td>
<td>Domain that the action runs in.</td>
</tr>
</tbody>
</table>

e. In the **Attributes** tab, provide these values:
f. Click **Submit**.

3. Create connection record for the Sourcing Project actions.

   a. Navigate to **Connections & Credentials > Connections & Credentials Aliases**.

   b. Open the alias record, **SAP_Ariba_Sourcing**.

   c. From the **Connections** tab, click **New**.

   d. On the form, fill these fields.

   **Connection form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, <em>Ariba Sourcing Connection</em></td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for ITK. For example, <em>Ariba_Sourcing Cred</em></td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Integration Task <strong>URL</strong> created when you enabled SOAP service of the Import Sourcing Project task for the inbound endpoint in <strong>Administration</strong>. For information about Integration Task <strong>URL</strong> and <strong>targetNamespace</strong>, see <strong>Enable an Integration Task in SAP Help Portal</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
</tbody>
</table>
e. In the **Attributes** tab, for **Target Namespace**, provide the value of the `targetNamespace` parameter in WSDL file created in **Administration**. For information about Integration Task **URL** and `targetNamespace`, see Enable an Integration Task in SAP Help Portal.

f. Click **Submit**.

4. Create connection record for the Supplier action.

   a. Navigate to **Connections & Credentials > Connections & Credentials Aliases**.

   b. Open the alias record, **SAP_Ariba_Suppliers**.

   c. From the **Connections** tab, click **New**.

   d. On the form, fill these fields.

<table>
<thead>
<tr>
<th>Connection form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, <strong>Ariba Supplier Connection</strong>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for ITK. For example, <strong>Ariba_Supplier Cred</strong>.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Integration Task <strong>URL</strong> created when you enabled SOAP service of the Import Suppliers task for the inbound endpoint in <strong>Core Administration</strong>. For information about Integration Task <strong>URL</strong> and <code>targetNamespace</code>, see Enable an Integration Task in SAP Help Portal.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
</tbody>
</table>

   e. In the **Attributes** tab, for **Target Namespace**, provide the value of the `targetNamespace` parameter in WSDL file created in **Core Administration**. For
information about Integration Task URL and targetNamespace, see Enable an Integration Task in SAP Help Portal.

f. Click Submit.

What to do next
Create buyer and supplier records in these spoke modules:

• Supplier IDs Buyer
• Supplier IDs Sourcing
• Supplier Organizations Buyer
• Supplier Organizations Sourcing

Actions in the sample flows require these records.

SAP ECC IDoc spoke v1.2
Manage finance, items, and procurement in SAP ECC IDoc account from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for these SAP ECC IDoc versions, but may be compatible with later versions:

• SAP application version: SAP ECC6 (Spoke is developed on Ehp8.)
• NetWeaver Version: SAP NW 7.5
• SAP JCo:3.0.20
Spoke requirements

• Contact the admin of your SAP ECC IDoc account and obtain these SAP proprietary JAR files and other required files:
  ◦ sapidoc3.jar and sapjco3.jar.
  ◦ libsapjco3.so: If your MID Server is installed on a Linux machine, obtain this file.
  ◦ sapjco3.dll: If your MID Server is installed on a Windows machine, obtain this file.
  
A JAR file, sapConnector-1.0.jar is available along with the spoke to provide a custom interface between SAP ECC IDoc account and ServiceNow instance. The JAR file is installed as part of the spoke in your ServiceNow instance.

• Copy and record the client value of the target host where the SAP ECC IDoc server is installed.

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• Complex Object (com.glide.cobject)
• Flow Designer Action Step - Script on MID (com.glide.hub.action_step.script_mid)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions

The SAP ECC IDoc spoke provides actions to automate SAP ECC IDoc tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finance</td>
<td>Create Fixed Assets</td>
<td>Creates fixed asset in your SAP ECC IDoc account.</td>
</tr>
<tr>
<td></td>
<td>Create GL Account</td>
<td>Creates a GL account in your SAP ECC IDoc account.</td>
</tr>
<tr>
<td></td>
<td>Create Invoice</td>
<td>Creates an invoice document in your SAP ECC IDoc account.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Post Journal Entry</td>
<td>Posts a journal entry in your SAP ECC IDoc account.</td>
</tr>
<tr>
<td></td>
<td>Update Fixed Assets</td>
<td>Updates details of the fixed assets in your SAP ECC IDoc account.</td>
</tr>
<tr>
<td></td>
<td>Update GL Account</td>
<td>Updates details of the specified GL account in your SAP ECC IDoc account.</td>
</tr>
<tr>
<td>Items</td>
<td>Create Material</td>
<td>Creates a material (item) in your SAP ECC IDoc account.</td>
</tr>
<tr>
<td></td>
<td>Update Material</td>
<td>Updates details of the specified material (item) in your SAP ECC IDoc account.</td>
</tr>
<tr>
<td>Procurement</td>
<td>Create Goods Receipt</td>
<td>Creates a goods receipt in your SAP ECC IDoc account.</td>
</tr>
<tr>
<td></td>
<td>Create Purchase Order</td>
<td>Creates a purchase order in your SAP ECC IDoc account.</td>
</tr>
<tr>
<td></td>
<td>Create Vendor</td>
<td>Creates a vendor in your SAP ECC IDoc account.</td>
</tr>
<tr>
<td></td>
<td>Update Purchase Order</td>
<td>Updates details of the specified purchase order in your SAP ECC IDoc account.</td>
</tr>
<tr>
<td>Customer</td>
<td>Create Customer</td>
<td>Creates a customer account in SAP ECC IDoc.</td>
</tr>
<tr>
<td></td>
<td>Update Customer</td>
<td>Update details of the required customer account in SAP ECC IDoc.</td>
</tr>
</tbody>
</table>

### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see [Connections and Credentials](#).
**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the SAP ECC IDoc alias to configure where actions run as well as set MID Server selection attributes. For more information about running actions on the MID Server, see Integration steps.

**Set up the SAP ECC IDoc spoke**

Integrate the ServiceNow instance and SAP ECC IDoc spoke by using the Basic Auth credentials to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub subscription.
- Activate SAP ECC IDoc spoke.
- Role required: admin

**Configure MID Server for the SAP ECC IDoc spoke**

Configure MID Server using the SAP proprietary JAR files to integrate SAP ECC IDoc account with your ServiceNow instance.

**Procedure**

1. **Optional:** Navigate to System Properties > Security.
   
   ![Note](image)
   
   **Note:** This is applicable only if your MID Server is installed on a Linux machine

2. **Optional:** Disable the MIME type validation for file attachments.
   
   ![Note](image)
   
   **Note:** This is applicable only if your MID Server is installed on a Linux machine

3. Navigate to MID Server > JAR Files.

4. Upload the required SAP proprietary files (JAR, SO, or DLL) obtained after contacting your SAP ECC IDoc admin. For more information, see Synchronize a JAR file to MID Servers.

**What to do next**

Ensure that the files are synchronised in the `<MID-Server-root-directory>/agent/extlib` directory. If the files aren’t synchronised, restart the MID Server.
Create a credential record for the SAP ECC IDoc spoke

Create a credential record for the SAP ECC IDoc account. The SAP ECC IDoc spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
   
The system displays this message: What type of Credentials would you like to create?
3. Select **Basic Auth Credentials**.
4. On the form, fill these values.

### Basic Auth Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, <em>SAP ECC IDoc Cred.</em></td>
</tr>
<tr>
<td>User name</td>
<td>User name to log in to your SAP ECC IDoc account.</td>
</tr>
<tr>
<td>Password</td>
<td>Password to authenticate and log in to your SAP ECC IDoc account.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, <em>100.</em></td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias associated with the spoke.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

Create a connection record for the SAP ECC IDoc spoke

Create a connection record for your SAP ECC IDoc account. The SAP ECC IDoc spoke connection and credential aliases use these connections to perform actions in SAP ECC IDoc.

**Procedure**

1. Navigate to **Connections & Credentials > Connections & Credentials Aliases**.
2. Open the alias record for SAP ECC IDoc.
3. From the **Connections** tab, click **New**.
4. On the form, fill these fields.

**Connection form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, SAP ECC IDoc Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for SAP ECC IDoc spoke. For example, SAP ECC IDoc Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Host</td>
<td>Fully qualified domain name of the target host where the SAP ECC IDoc server is installed.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
<tr>
<td>Override default port</td>
<td>Target port used by the connection. If blank, the system uses the default port.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Server for this connection. Select the check box and define the fields in the Advanced MID Server Configuration tab.</td>
</tr>
</tbody>
</table>

5. In the **Advanced MID Server Configuration** tab, provide these details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capabilities</td>
<td>Capabilities the MID Server must support to be eligible for selection. The system runs the action or activity from a MID Server that supports the selected capabilities. Required capabilities determine which MID Server is selected at runtime. To learn more about how a MID Server is selected during runtime, see MID Server selection.</td>
</tr>
<tr>
<td>MID Application</td>
<td>Application the MID Server must support to be eligible for selection. The system runs the action from a MID Server that supports the selected application. To learn more about how a MID Server is selected during runtime, see MID Server selection.</td>
</tr>
</tbody>
</table>

6. In the **Attributes** tab, provide these details.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client</td>
<td>Client value of the target host where the SAP ECC IDoc server is installed.</td>
</tr>
<tr>
<td>u_system_number</td>
<td>System number of the target host where the SAP ECC IDoc server is installed.</td>
</tr>
<tr>
<td>u_lang</td>
<td>Language selected in the target host where the SAP ECC IDoc server is installed.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.

**SAP Commerce Cloud**
Retrieve shopping cart content, order details, and order history for a selected customer.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Supported versions**
This spoke was built for SAP Commerce Cloud Version:
2011.4-2011-20210310.1-32b1627-2011- spartacus (Major Version: 201, but may be compatible with later versions.

**Spoke requirements**
- SAP Commerce Cloud subscription

**Spoke dependencies**
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub action Step - REST (com.glide.hub.action_step.rest)
• Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The SAP Commerce Cloud provides actions to automate tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order Management</td>
<td>Look Up Order Details</td>
<td>Retrieves order details of the specified order.</td>
</tr>
<tr>
<td></td>
<td>Look Up Orders</td>
<td>Retrieves the order history for the specified user ID.</td>
</tr>
<tr>
<td>Shopping Cart</td>
<td>Look Up Shopping Cart</td>
<td>Retrieves the shopping cart content for the specified user ID.</td>
</tr>
</tbody>
</table>

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the SAP Commerce Cloud
Integrate the ServiceNow instance and SAP Commerce Cloud by creating a custom OAuth application in SAP Commerce Cloud to authenticate ServiceNow requests.

Before you begin
• Request an IntegrationHub subscription.
• Activate SAP Commerce Cloud.
• Role required: admin
Create a credential record for the SAP Commerce Cloud

Integrate the ServiceNow instance and SAP Commerce Cloud spoke by creating a custom OAuth application in SAP Commerce Cloud to authenticate ServiceNow requests.

Before you begin

- Request an IntegrationHub subscription.
- Activate SAP Commerce Cloud.
- Role required: admin

Procedure

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   - The system displays the message What type of Credentials would you like to create?.
3. Select OAuth 2.0 Credentials.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>OAuth 2.0 Credentials form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, SAP Commerce Cloud cred Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile created during the registration of SAP Commerce Cloud as an OAuth provider. For example, SAP Commerce Cloud default_profile OAuth Profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Option to specify if the credential applies to all MID Servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use this credential in the MID servers field.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, 100.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias associated with the spoke.</td>
</tr>
</tbody>
</table>
Create a connection record for the SAP Commerce Cloud

Create a connection record for your SAP Commerce Cloud account. The SAP Commerce Cloud connection and credential aliases use these connections to perform actions in SAP Commerce Cloud.

Procedure

1. Navigate to Connections & Credentials > Connections & Credentials Aliases.
2. Open the alias record for SAP Commerce Cloud.
3. From the Connections tab, click New.
4. On the form, fill these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, SAP Commerce Cloud Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for SAP Commerce Cloud spoke. For example, SAP Commerce Cloud Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Host</td>
<td>IP address of the target host where the SAP Commerce Cloud server is installed.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
<tr>
<td>Override default port</td>
<td>Target port used by the connection. If blank, the system uses the default port.</td>
</tr>
</tbody>
</table>

5. Click Submit.

SAP ECC RFC spoke v1.2.1

Manage items, journals, procurements, and others, in SAP ECC RFC account from your ServiceNow® instance.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release
notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for these SAP ECC RFC versions, but may be compatible with later versions:

- SAP application version: SAP ECC6 (Spoke is developed on EHp8.)
- NetWeaver Version: SAP NW 7.5
- SAP JCo:3.0.20

Spoke requirements

- Contact the admin of your SAP ECC RFC account and obtain these SAP proprietary JAR files and other required files:
  - sapjco3.jar.
  - libsapjco3.so: If your MID Server is installed on a Linux machine, obtain this file.
  - sapjco3.dll: If your MID Server is installed on a Windows machine, obtain this file.

A JAR file, sapConnector-1.0.jar, is available along with the spoke to provide custom interface to interact and execute RFCs and IDocs in the SAP ECC RFC account. The JAR file is installed as part of the spoke in your ServiceNow instance.

- Copy and record the client value of the target host where the SAP ECC RFC server is installed.

- Configure the values of these system properties:
  - com.snc.process_flow.reporting.serialized.val_size_limit: This property serializes JSON objects and ensures that the data is in the required format. Specify the number of bytes as per your requirement. For more information, see Flow Designer system properties.
  - glide.rest.max_content_length: This property specifies the payload size. Specify the maximum payload size you want to use in your flows. The maximum value you can specify for this property is, 25 MB.
Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow Flow Designer - Dynamic Outputs (com.glide.hub.dynamic_outputs)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke flows
The SAP ECC RFC spoke provides sample flows to demonstrate automating the SAP ECC RFC tasks. To customize a sample flow, copy it to the required application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve Users By Role</td>
<td>Retrieves details of the SAP ECC RFC users with the specified role. The user details can be accessed by navigating to <a href="#">SAP ECC RFC Spoke &gt; SAP ECC Users</a>.</td>
</tr>
<tr>
<td>Retrieve Incoming Invoice</td>
<td>Retrieves details of the incoming SAP ECC RFC invoices. The invoice details can be accessed by navigating to <a href="#">SAP ECC RFC Spoke &gt; SAP ECC Invoices Data</a>.</td>
</tr>
<tr>
<td>Create Sales Order and Look up Status</td>
<td>Creates a sales order and retrieves the status information.</td>
</tr>
</tbody>
</table>

Spoke actions
The SAP ECC RFC spoke provides actions to automate SAP ECC RFC tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>Look up Material Groups</td>
<td>Retrieves the list of material groups from your SAP ECC RFC account.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Lookups</td>
<td>Look up Materials By Plant</td>
<td>Retrieves the list of materials (items) based on plant selection criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Materials by Storage Location</td>
<td>Retrieves the list of materials (items) based on the storage location selection criteria.</td>
</tr>
<tr>
<td>Journals</td>
<td>Post Journal Entry</td>
<td>Posts a journal entry to a GL account in your SAP ECC RFC account.</td>
</tr>
<tr>
<td></td>
<td>Reverse Journal Entry</td>
<td>Reverses a journal entry in a GL account in your SAP ECC RFC account.</td>
</tr>
<tr>
<td>Lookups</td>
<td>Look up Cost Centers by Controlling Area</td>
<td>Retrieves cost centers based on the controlling area from your SAP ECC RFC account.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get RFC Input Schema</td>
<td>Retrieves the input schema for the RFC, from SAP ECC RFC dynamically.</td>
</tr>
<tr>
<td></td>
<td>Get RFC Output Schema</td>
<td>Retrieves the output schema from SAP ECC RFC dynamically, for the selected RFC.</td>
</tr>
<tr>
<td>Procurement</td>
<td>Create Fixed Asset</td>
<td>Create a fixed asset in SAP ECC RFC.</td>
</tr>
<tr>
<td></td>
<td>Create Goods Receipt</td>
<td>Creates a goods receipt document in SAP ECC RFC.</td>
</tr>
<tr>
<td></td>
<td>Create Invoice</td>
<td>Creates an invoice in SAP ECC RFC.</td>
</tr>
<tr>
<td></td>
<td>Create Purchase Order</td>
<td>Creates a purchase order in SAP ECC RFC.</td>
</tr>
<tr>
<td></td>
<td>Look up Invoices By Date</td>
<td>Retrieves invoices from SAP ECC RFC based on the provided date.</td>
</tr>
<tr>
<td></td>
<td>Update Purchase Order</td>
<td>Updates an existing purchase order in SAP ECC RFC.</td>
</tr>
<tr>
<td>Records Management</td>
<td>Execute RFC</td>
<td>Executes an RFC from the available list.</td>
</tr>
<tr>
<td>Bills and Payment</td>
<td>Look Up Bill Details By ID</td>
<td>Retrieves bills based on sales order from SAP ECC RFC.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Customer</td>
<td>Look Up Outstanding Balance</td>
<td>Retrieves outstanding balance of a customer from SAP ECC RFC.</td>
</tr>
<tr>
<td></td>
<td>Look Up Payments</td>
<td>Retrieves pending payments of the customer from SAP ECC RFC.</td>
</tr>
<tr>
<td></td>
<td>Look Up Customer Info</td>
<td>Retrieves customer information based on company code and customer from SAP ECC RFC.</td>
</tr>
<tr>
<td></td>
<td>Look Up Inventory of Parts</td>
<td>Retrieves inventory for the plant and material from SAP ECC RFC.</td>
</tr>
<tr>
<td>Sales Order</td>
<td>Create Sales Order</td>
<td>Creates a sales order in SAP ECC RFC.</td>
</tr>
<tr>
<td></td>
<td>Look Up Sales Order</td>
<td>Retrieves sales order details from SAP ECC RFC.</td>
</tr>
<tr>
<td></td>
<td>Look Up Sales Orders</td>
<td>Retrieves sales orders based on customer from SAP ECC RFC.</td>
</tr>
<tr>
<td></td>
<td>Update Sales Order</td>
<td>Updates details of the required sales order in SAP ECC RFC.</td>
</tr>
</tbody>
</table>

**Spoke modules**

The SAP ECC RFC spoke adds the SAP ECC RFC Spoke application to your instance and includes these modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP ECC Flow Executions</td>
<td>Displays the last successful execution date of the Retrieve Incoming Invoice flow. Before the first flow execution, you must create a record in this module to specify the date from which the incoming invoice details should be fetched.</td>
</tr>
<tr>
<td>SAP ECC Invoices Data</td>
<td>Displays the records retrieved by the Retrieve Incoming Invoice flow.</td>
</tr>
<tr>
<td>SAP ECC RFCs</td>
<td>Displays the list of BAPIs. The Execute RFC action uses this as input.</td>
</tr>
<tr>
<td>Module</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SAP ECC Users</td>
<td>Displays details of the SAP ECC RFC users. The Retrieve Users By Role flow retrieves details of the users with the specified role.</td>
</tr>
</tbody>
</table>

**Spoke user roles**

The SAP ECC RFC spoke provides the `sn_sap_ecc_rfc_spo.SAP_ECC_RFC_Spoke_Admin` user role to control access to data. Users with the `sn_sap_ecc_rfc_spo.SAP_ECC_RFC_Spoke_Admin` role have access to the spoke tables.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the SAP ECC RFC spoke alias to configure where actions run as well as set MID Server selection attributes. For more information about running actions on the MID Server, see Integration steps.

ℹ️ **Note:**

- If the MID Server is installed on a Linux machine, perform the configurations as outlined in Configure MID Server for the SAP ECC RFC spoke.
- If the MID Server is installed on a Windows machine, no configurations are needed.

**Set up the SAP ECC RFC spoke**

Integrate the ServiceNow instance and SAP ECC RFC account by using the Basic Auth credentials to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub subscription.
- Activate SAP ECC IDoc spoke.
- Role required: admin
Configure MID Server for the SAP ECC RFC spoke

Configure MID Server using the SAP proprietary JAR files to integrate SAP ECC RFC account with your ServiceNow® instance.

Procedure

1. **Optional:** Navigate to **System Properties > Security.**
   - **Note:** This is applicable only if your MID Server is installed on a Linux machine

2. **Optional:** Disable the MIME type validation for file attachments.
   - **Note:** This is applicable only if your MID Server is installed on a Linux machine

3. Navigate to **MID Server > JAR Files.**

4. Upload the required SAP proprietary files (JAR, SO, or DLL) obtained after contacting your SAP ECC RFC admin. For more information, see Synchronize a JAR file to MID Servers.

**What to do next**

Ensure that the files are synchronised in the `<MID-Server-root-directory>/agent/extlib` directory. If the files aren't synchronised, restart the MID Server.

Create a credential record for the SAP ECC RFC spoke

Create a credential record for the SAP ECC RFC account. The SAP ECC RFC spoke connection and credential alias uses these credentials to authorize actions.

Procedure

1. Navigate to **Connections & Credentials > Credentials.**
2. Click **New.**
   - The system displays this message: What type of Credentials would you like to create?
3. Select **Basic Auth Credentials.**
4. On the form, fill these values.
Basic Auth Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, SAP ECC RFC Cred.</td>
</tr>
<tr>
<td>User name</td>
<td>User name to log in to your SAP ECC RFC account.</td>
</tr>
<tr>
<td>Password</td>
<td>Password to authenticate and log in to your SAP ECC RFC account.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, 100.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias associated with the spoke.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

Create a connection record for the SAP ECC RFC spoke

Create a connection record for your SAP ECC RFC account. The SAP ECC RFC spoke connection and credential aliases use these connections to perform actions in SAP ECC RFC.

Procedure
1. Navigate to **Connections & Credentials > Connections & Credentials Aliases**.
2. Open the alias record for SAP ECC RFC.
3. From the **Connections** tab, click **New**.
4. On the form, fill these fields.

Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, SAP ECC RFC Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for SAP ECC RFC spoke. For example, SAP ECC RFC Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Host</strong></td>
<td>IP address of the target host where the SAP ECC RFC server is installed.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td><strong>Domain</strong></td>
<td>Domain that the action runs in.</td>
</tr>
<tr>
<td><strong>Override default port</strong></td>
<td>Target port used by the connection. If blank, the system uses the default port.</td>
</tr>
<tr>
<td><strong>Use MID server</strong></td>
<td>Option to use a MID Server for this connection. Select the check box and define the fields in the Advanced MID Server Configuration tab.</td>
</tr>
</tbody>
</table>

5. In the **Advanced MID Server Configuration** tab, provide these details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Capabilities</strong></td>
<td>Capabilities the MID Server must support to be eligible for selection. The system runs the action or activity from a MID Server that supports the selected capabilities. Required capabilities determine which MID Server is selected at runtime. To learn more about how a MID Server is selected during runtime, see MID Server selection.</td>
</tr>
<tr>
<td><strong>MID Application</strong></td>
<td>Application the MID Server must support to be eligible for selection. The system runs the action from a MID Server that supports the selected application. To learn more about how a MID Server is selected during runtime, see MID Server selection.</td>
</tr>
</tbody>
</table>

6. In the **Attributes** tab, provide these details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Client</strong></td>
<td>Client value of the target host where the SAP ECC RFC server is installed.</td>
</tr>
<tr>
<td><strong>System Number</strong></td>
<td>System number of the target host where the SAP ECC RFC server is installed.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Language | Language selected in the target host where the SAP ECC RFC server is installed.

7. Click **Submit**.

**SAP Fieldglass spoke v1.0.1**
Manage job postings, workers, timesheets and expenses, and approvals in SAP Fieldglass account from your ServiceNow instance.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Supported versions**
This spoke was built for SAP Fieldglass 2020.05, but may be compatible with later versions.

**Note:** SAP Fieldglass APIs doesn’t support JSON by default. You must reach out to the SAP Fieldglass support to enable JSON support for the APIs.

**Spoke requirements**
- Copy and record the API Key. Contact the SAP Fieldglass support team if you don’t have the value.
- By default, all APIs are not enabled. Contact the SAP Fieldglass support team to enable these APIs and enable JSON support for these APIs:

<table>
<thead>
<tr>
<th>API Type</th>
<th>API</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Posting</td>
<td>Job Posting Upload</td>
</tr>
<tr>
<td></td>
<td>Job Posting Update Upload</td>
</tr>
<tr>
<td></td>
<td>Job Posting Redistribution Upload</td>
</tr>
<tr>
<td></td>
<td>Job Posting Cost Center Allocation Upload</td>
</tr>
<tr>
<td>API Type</td>
<td>API</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>API Type</td>
<td>Standard Job Posting Qualification Upload</td>
</tr>
<tr>
<td></td>
<td>Job Posting Close Upload</td>
</tr>
<tr>
<td></td>
<td>Job Seeker Reject Upload</td>
</tr>
<tr>
<td>Supplier Job Posting</td>
<td>Get Job Posting</td>
</tr>
<tr>
<td></td>
<td>Submit Job Seeker</td>
</tr>
<tr>
<td>Work Order Management</td>
<td>Work Order Upload</td>
</tr>
<tr>
<td></td>
<td>Work Order Revision Upload</td>
</tr>
<tr>
<td></td>
<td>Work Order Close Upload</td>
</tr>
<tr>
<td>Supplier - Work Order</td>
<td>Get Work Order Offer</td>
</tr>
<tr>
<td></td>
<td>Accept Work Order Offer</td>
</tr>
<tr>
<td></td>
<td>Accept Work Order Multiple Rate</td>
</tr>
<tr>
<td></td>
<td>Decline Work Order Offer</td>
</tr>
<tr>
<td></td>
<td>Accept Work Order Revision</td>
</tr>
<tr>
<td></td>
<td>Decline Work Order Revision</td>
</tr>
<tr>
<td>Workers</td>
<td>Active Worker Delta Single Line Download (LastRundate)</td>
</tr>
<tr>
<td></td>
<td>Active Worker Download</td>
</tr>
<tr>
<td>Time Sheet and Expense</td>
<td>Time Sheet Upload</td>
</tr>
<tr>
<td></td>
<td>Expense sheet Upload</td>
</tr>
<tr>
<td></td>
<td>Approved Expense sheet download (LastRundate)</td>
</tr>
<tr>
<td></td>
<td>Approved Timesheet Fixed Format Download (LastRundate)</td>
</tr>
<tr>
<td></td>
<td>Time Sheet Rejection Upload</td>
</tr>
<tr>
<td>Approvals and Rejection</td>
<td>approvals</td>
</tr>
<tr>
<td>Master Data</td>
<td>Supplier Download</td>
</tr>
<tr>
<td></td>
<td>Reason Code Download</td>
</tr>
<tr>
<td></td>
<td>Business unit Download</td>
</tr>
<tr>
<td>API Type</td>
<td>API</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Cost center Download</td>
<td></td>
</tr>
<tr>
<td>Legal Entity Download</td>
<td></td>
</tr>
<tr>
<td>Shift Download</td>
<td></td>
</tr>
<tr>
<td>Rate Schedule Download</td>
<td></td>
</tr>
<tr>
<td>Site Details Download</td>
<td></td>
</tr>
</tbody>
</table>

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- Complex Object (com.glide.cobject)
- ServiceNow Flow Designer - Dynamic Outputs (com.glide.hub.dynamic_outputs)

**Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke flows**

The SAP Fieldglass spoke provides sample flows to demonstrate automating the tasks. To customize a sample flow, copy it to the required application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Look up Approval and Metadata Flow</td>
<td>Approves the pending approvals in SAP Fieldglass.</td>
</tr>
<tr>
<td>Sample Look up Flow</td>
<td>Retrieves or downloads data related to currently active workers and data related to workers who had revisions since the last successful run date of the connector.</td>
</tr>
</tbody>
</table>
Spoke actions

The SAP Fieldglass spoke provides actions to automate tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buyer - Approvals and Rejection</td>
<td>Approve</td>
<td>Approves the pending approvals in SAP Fieldglass.</td>
</tr>
<tr>
<td></td>
<td>Look up Pending Approvals</td>
<td>Retrieves the list of pending approvals.</td>
</tr>
<tr>
<td></td>
<td>Look up Reject Reasons</td>
<td>Retrieves the list of available reject reasons.</td>
</tr>
<tr>
<td></td>
<td>Reject</td>
<td>Rejects the pending approvals in SAP Fieldglass.</td>
</tr>
<tr>
<td>Buyer - Job Posting</td>
<td>Close Job Posting</td>
<td>Closes the specified job posting in SAP Fieldglass.</td>
</tr>
<tr>
<td></td>
<td>Close Job Posting Bulk</td>
<td>Closes multiple job postings in SAP Fieldglass.</td>
</tr>
<tr>
<td></td>
<td>Create Job Posting</td>
<td>Creates a job posting in SAP Fieldglass.</td>
</tr>
<tr>
<td></td>
<td>Reject Job Seeker</td>
<td>Rejects the specified job seeker in SAP Fieldglass.</td>
</tr>
<tr>
<td></td>
<td>Reject Job Seeker Bulk</td>
<td>Rejects multiple job seekers in SAP Fieldglass.</td>
</tr>
<tr>
<td></td>
<td>Update Job Posting</td>
<td>Updates details of the required job posting.</td>
</tr>
<tr>
<td></td>
<td>Update Job Posting Cost Center Allocation</td>
<td>Updates the cost center code for the existing job posting.</td>
</tr>
<tr>
<td></td>
<td>Update Job Posting Cost Center Allocation Bulk</td>
<td>Updates the cost center code for multiple existing job postings.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Update Job Posting Distribution</td>
<td>Distributes single or bulk job posting to the suppliers.</td>
</tr>
<tr>
<td>Update Job Posting Distribution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update Job Posting Qualification</td>
<td></td>
<td>Updates or uploads one or more job posting templates or qualifications data for the required job posting.</td>
</tr>
<tr>
<td>Buyer - Time Sheet and Expense</td>
<td>Look up Approved Expense Sheets</td>
<td>Retrieves details of the approved expense sheets.</td>
</tr>
<tr>
<td>Look up Approved Expense Sheets</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Look up Approved Time Sheets</td>
<td></td>
<td>Retrieves details of the approved time sheet.</td>
</tr>
<tr>
<td>Reject Time Sheet Bulk</td>
<td></td>
<td>Rejects single or bulk time sheet.</td>
</tr>
<tr>
<td>Upload Expense Sheet</td>
<td></td>
<td>Uploads expense sheet in SAP Fieldglass.</td>
</tr>
<tr>
<td>Upload Time Sheets</td>
<td></td>
<td>Uploads time sheets in SAP Fieldglass.</td>
</tr>
<tr>
<td>Buyer - Work Order Management</td>
<td>Close Work Order</td>
<td>Closes a work order if workers have not been on-boarded.</td>
</tr>
<tr>
<td>Close Work Order</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revise Work Order</td>
<td></td>
<td>Revises the specified work order in SAP Fieldglass.</td>
</tr>
<tr>
<td>Upload Work Order</td>
<td></td>
<td>Uploads work order to SAP Fieldglass.</td>
</tr>
<tr>
<td>Buyer - Workers</td>
<td>Look up Active Workers</td>
<td>Retrieves or downloads data related to currently active workers.</td>
</tr>
<tr>
<td>Look up Active Workers</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Look up Active Workers Delta</td>
<td></td>
<td>Retrieves or downloads data related to workers who had revisions since the last successful run date of the connector.</td>
</tr>
<tr>
<td>Upload SOW Worker</td>
<td></td>
<td>Uploads or creates an SOW Worker for the existing Statement Of Work.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get Buyer Token</td>
<td>Generates access token for SAP Fieldglass buyer.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get Supplier Token</td>
<td>Generates access token for the SAP Fieldglass supplier.</td>
</tr>
<tr>
<td></td>
<td>Last Run Date</td>
<td>Retrieves the required data after the last run date.</td>
</tr>
<tr>
<td></td>
<td>Look up Business Units</td>
<td>Retrieves list of the available business units.</td>
</tr>
<tr>
<td></td>
<td>Look up Cost Centers</td>
<td>Retrieves list of the available Cost Centers.</td>
</tr>
<tr>
<td></td>
<td>Look up Legal Entities</td>
<td>Retrieves list of the available legal entities.</td>
</tr>
<tr>
<td></td>
<td>Look up Rate Schedules</td>
<td>Retrieves list of the available rate schedules.</td>
</tr>
<tr>
<td></td>
<td>Look up Reason Codes</td>
<td>Retrieves list of the available reason codes.</td>
</tr>
<tr>
<td></td>
<td>Look up Shift Details</td>
<td>Retrieves list of the available shifts.</td>
</tr>
<tr>
<td></td>
<td>Look up Site Details</td>
<td>Retrieves list of the available sites.</td>
</tr>
<tr>
<td></td>
<td>Look up Suppliers</td>
<td>Retrieves list of the available suppliers.</td>
</tr>
<tr>
<td></td>
<td>Sample JSON Parser Action</td>
<td>Parses the JSON object and converts it to an array of objects.</td>
</tr>
<tr>
<td>Supplier - Job Posting</td>
<td>Get Job Posting</td>
<td>Retrieves details of the required job posting.</td>
</tr>
<tr>
<td></td>
<td>Submit Job Seeker</td>
<td>Submits a job seeker in SAP Fieldglass.</td>
</tr>
<tr>
<td>Supplier - Work Order</td>
<td>Accept Work Order Multiple Rates</td>
<td>Accepts work order multiple rates in SAP Fieldglass.</td>
</tr>
<tr>
<td></td>
<td>Accept Work Order Offer</td>
<td>Accepts work order in SAP Fieldglass.</td>
</tr>
<tr>
<td></td>
<td>Accept Work Order Revision</td>
<td>Accepts the revised work order in SAP Fieldglass.</td>
</tr>
</tbody>
</table>
### Spoke modules

The SAP Fieldglass spoke adds the SAP Fieldglass Spoke application to your instance and includes these modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Worker Downloads</td>
<td>Displays details of the active workers. Data is retrieved when you run the Look up Active Workers spoke action.</td>
</tr>
<tr>
<td>Create Job Postings</td>
<td>Displays details about the job postings. Data is retrieved from the SAP Fieldglass instance after you set up the webhook. For more information, see <a href="#">Set up webhook for the SAP Fieldglass spoke</a>.</td>
</tr>
<tr>
<td>SAP Fieldglass Buyer Credentials</td>
<td>Displays the buyer credential records.</td>
</tr>
<tr>
<td>SAP Fieldglass Modules</td>
<td>Displays details about the modules. The spoke actions internally use these modules during flow execution. You can manage the modules as per your requirement.</td>
</tr>
<tr>
<td>SAP Fieldglass Supplier Credentials</td>
<td>Displays the supplier credential records.</td>
</tr>
<tr>
<td>SAP Fieldglass Webhook Registries</td>
<td>Displays the webhook registries. You can create webhook registry for an event as per your requirement. For more information, see <a href="#">Set up webhook for the SAP Fieldglass spoke</a>.</td>
</tr>
</tbody>
</table>
Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Two connection and credential aliases are available along with spoke: one record for supplier and another record for buyer.

Set up the SAP Fieldglass spoke
Integrate the ServiceNow instance and SAP Fieldglass account using API keys to authenticate ServiceNow requests.

Before you begin
• Request an IntegrationHub subscription.
• Activate SAP Fieldglass spoke.
• Role required: admin

Procedure
1. Create a credential record for the SAP Fieldglass buyer instance.
   a. Navigate to Connections & Credentials > Credentials.
   b. Click New.
      The system displays this message: What type of Credentials would you like to create?
   c. Select SAP Fieldglass Buyer Credentials.
   d. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to identify the record. For example, SAP FG Buyer Creds.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>User name</td>
<td>User name to log in to your SAP Fieldglass buyer instance.</td>
</tr>
<tr>
<td>Password</td>
<td>Password to log in to your SAP Fieldglass buyer instance.</td>
</tr>
<tr>
<td>API Key</td>
<td>API key of your SAP Fieldglass buyer instance.</td>
</tr>
<tr>
<td>Access Token</td>
<td>Leave this field empty.</td>
</tr>
<tr>
<td>Token Status</td>
<td>Don’t change the default value.</td>
</tr>
<tr>
<td>Expiry</td>
<td>Leave this field empty.</td>
</tr>
</tbody>
</table>

**e. Click Submit.**

**2. Create a connection record the SAP Fieldglass buyer instance.**

**a. Navigate to Connections & Credentials > Connections & Credentials Aliases.**

**b. Open the record, SAPFieldGlassBuyer.**

**c. From the Connections tab, click New.**

**d. On the form, fill these fields.**

**Connection form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to identify the connection record. For example, SAP FG Buyer Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Associated credential record. For example, SAP FG Buyer Creds.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL of the SAP Fieldglass buyer instance.</td>
</tr>
</tbody>
</table>
e. Click Submit.

3. Create a credential record for the SAP Fieldglass supplier instance.

a. Navigate to **Connections & Credentials > Credentials**.

b. Click **New**.

The system displays this message: What type of Credentials would you like to create?

c. Select **SAP Fieldglass Supplier Credentials**.

d. On the form, fill these values:

<table>
<thead>
<tr>
<th>SAP Fieldglass Buyer Credentials form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Name</td>
<td>Name to identify the record. For example, SAP FG Supplier Creds.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>User name</td>
<td>User name to log in to your SAP Fieldglass supplier instance.</td>
</tr>
<tr>
<td>Password</td>
<td>Password to log in to your SAP Fieldglass supplier instance.</td>
</tr>
<tr>
<td>API Key</td>
<td>API key of your SAP Fieldglass supplier instance.</td>
</tr>
<tr>
<td>Access Token</td>
<td>Leave this field empty.</td>
</tr>
<tr>
<td>Token Status</td>
<td>Don't change the default value.</td>
</tr>
<tr>
<td>Expiry</td>
<td>Leave this field empty.</td>
</tr>
</tbody>
</table>

e. Click **Submit**.

4. Create a connection record the SAP Fieldglass supplier instance.

b. Open the record, SAPFieldGlassSupplier.

c. From the Connections tab, click New.

d. On the form, fill these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to identify the connection record. For example, SAP FG Supplier Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Associated credential record. For example, SAP FG Buyer Creds.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL of the SAP Fieldglass supplier instance.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
</tbody>
</table>

e. Click Submit.

5. Create flow to generate buyer token.


b. Create a flow and include the Get Buyer Token spoke action. For more information about creating flows, see Flows.

c. Select the buyer credential record for Credentials [SAP Fieldglass Buyer Credentials].
d. Test the flow.
After successful execution, these fields are auto-populated in the SAP Fieldglass Buyer credential record:

- **Access Token**: Access token is generated.
- **Token Status**: Status is set to **Active**.
- **Expiry**: Expiry date and time of the access token is displayed.

6. Create flow to generate supplier token.

a. Navigate to **Flow Designer > Designer**.

b. Create a flow and include the Get Supplier Token spoke action. For more information about creating flows, see **Flows**.

c. Select the supplier credential record for **Credentials [SAP Fieldglass Supplier Credentials]**.

d. Test the flow.
After successful execution, these fields are auto-populated in the SAP Fieldglass Supplier credential record:

- **Access Token**: Access token is generated.
- **Token Status**: Status is set to **Active**.
- **Expiry**: Expiry date and time of the access token is displayed.

**Set up webhook for the SAP Fieldglass spoke**

Retrieve the required information from SAP Fieldglass instance to your ServiceNow instance by setting up webhook to authenticate the requests.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **SAP Fieldglass Spoke > SAP Fieldglass Webhook Registries**.
2. Click **New**.
3. On the form, fill these values:
## SAP Fieldglass Webhook Registry form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Fieldglass Event</td>
<td>Event for which you want to set up the webhook. For example, <em>Create job posting.</em></td>
</tr>
<tr>
<td>User name</td>
<td>Leave this field empty.</td>
</tr>
<tr>
<td>Password</td>
<td>Leave this field empty.</td>
</tr>
<tr>
<td>SAP Fieldglass Instance</td>
<td>URL of your SAP Fieldglass instance.</td>
</tr>
</tbody>
</table>

4. Click **Generate UserName and Password**. **UserName** and **Password** are displayed.

5. Copy and record the values.

6. Contact the SAP Fieldglass team to configure the webhook endpoint. Also, share the user name and password combination with the SAP Fieldglass team.

## SAP S4 HANA RFC spoke v1.0.2

Manage procurement, records, journals, and others, in SAP S4 HANA RFC account from your ServiceNow® instance.

### Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

### IntegrationHub subscription

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

### Supported versions

This spoke was built for these SAP S4 HANA RFC versions, but may be compatible with later versions:

- SAP application version: SAP S4 HANA 1909
- NetWeaver Version: SAP NW 7.5
- SAP JCo:3.0.20
Spoke requirements

- Contact the admin of your SAP S4 HANA RFC account and obtain these SAP proprietary JAR files and other required files:
  - sapjco3.jar.
  - libsapjco3.so: If your MID Server is installed on a Linux machine, obtain this file.
  - sapjco3.dll: If your MID Server is installed on a Windows machine, obtain this file.

A JAR file, sapConnector-1.0.jar, is available along with the spoke to provide custom interface to interact and execute RFCs and IDocs in the SAP S4 HANA RFC account. The JAR file is installed as part of the spoke in your ServiceNow instance.

- Copy and record the client value of the target host where the SAP S4 HANA RFC server is installed.

- Configure the values of these system properties:
  - `com.snc.process_flow.reportingserialized.val_size_limit`: This property serializes JSON objects and ensures that the data is in the required format. Specify the number of bytes as per your requirement. For more information, see Flow Designer system properties.
  - `glide.rest.maxcontent_length`: This property specifies the payload size. Specify the maximum payload size you want to use in your flows. The maximum value you can specify for this property is 25 MB.

⚠️ Note: To retrieve information for authorization purposes, use the Execute RFC spoke action.

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow Flow Designer - Dynamic Outputs (com.glide.hub.dynamic_outputs)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.
Spoke flows

The SAP S/4 HANA RFC spoke provides sample flows to demonstrate automating the SAP S4 HANA RFC tasks. To customize a sample flow, copy it to the required application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve Incoming Invoice</td>
<td>Retrieves the invoice data periodically. This data is displayed in the SAP S/4HANA Invoice Data module.</td>
</tr>
<tr>
<td>Retrieve Users by Role</td>
<td>Retrieves details of the users, based on the provided user role. This data is displayed in the SAP S/4HANA Users Records module.</td>
</tr>
</tbody>
</table>

Spoke actions

The SAP S/4 HANA RFC spoke provides actions to automate SAP S4 HANA RFC tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>Look up Material Groups</td>
<td>Retrieves details of the material groups.</td>
</tr>
<tr>
<td></td>
<td>Look up Materials by Plant</td>
<td>Retrieves details of the materials (items) based on plant selection criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Materials by Storage Locations</td>
<td>Retrieves details of the materials (items) based on storage location selection criteria.</td>
</tr>
<tr>
<td>Journals</td>
<td>Post Journal Entry</td>
<td>Posts a journal entry to a GL Account in SAP S4 HANA RFC.</td>
</tr>
<tr>
<td></td>
<td>Reverse Journal Entry</td>
<td>Reverses a journal entry in a GL Account in SAP S4 HANA RFC.</td>
</tr>
<tr>
<td>Lookups</td>
<td>Look up Cost Centers by Controlling Area</td>
<td>Retrieves details of the cost centers based on the controlling area.</td>
</tr>
<tr>
<td>Metadata</td>
<td>Get RFC Input Schema</td>
<td>Dynamically retrieves the input schema for the RFC.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>Get RFC Output Schema</td>
<td>Schema</td>
<td>Dynamically retrieves the output schema for the RFC.</td>
</tr>
<tr>
<td>Procurement</td>
<td>Create Fixed Asset</td>
<td>Creates a fixed asset in SAP S4 HANA RFC.</td>
</tr>
<tr>
<td></td>
<td>Create Goods Receipt</td>
<td>Creates a goods receipt document in SAP S4 HANA RFC.</td>
</tr>
<tr>
<td></td>
<td>Create Invoice</td>
<td>Creates an invoice document in SAP S4 HANA RFC.</td>
</tr>
<tr>
<td></td>
<td>Create Purchase Order</td>
<td>Creates a purchase order in SAP S4 HANA RFC.</td>
</tr>
<tr>
<td></td>
<td>Look up Invoices by Date</td>
<td>Retrieves details of the invoices based on entry date.</td>
</tr>
<tr>
<td></td>
<td>Update Purchase Order</td>
<td>Updates details of the specified purchase order.</td>
</tr>
<tr>
<td>Records Management</td>
<td>Execute RFC</td>
<td>Executes an RFC from the available list.</td>
</tr>
</tbody>
</table>

**Spoke module**

The SAP S/4 HANA RFC spoke adds the SAP S4 HANA RFC Spoke application to your instance and includes these modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP S/4 HANA - RFCs</td>
<td>Displays the list RFCs. Some RFCs are provided along with spoke. You can create additional RFCs as per your requirement. The Execute RFC action uses these records as an input.</td>
</tr>
<tr>
<td>SAP S/4 HANA Flow Executions</td>
<td>Displays the dates on which the Retrieve Incoming Invoice flow is executed. After you set up the SAP S4 HANA RFC spoke, create a record to specify the date up to which you want to retrieve the invoice data. For more information, see <a href="#">Set up the SAP S4 HANA RFC spoke</a>.</td>
</tr>
<tr>
<td>SAP S/4 HANA Invoice Data</td>
<td>Displays details of the invoice data. Customize and execute the default flow, Retrieve Incoming Invoice to retrieve the invoice data.</td>
</tr>
<tr>
<td>Module</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SAP S/4 HANA Users</td>
<td>Displays details of the users, based on their user role. Customize and execute the default flow, Retrieve Users by Role to retrieve the user information.</td>
</tr>
</tbody>
</table>

### Spoke user roles

The SAP S4 HANA RFC provides the sn_sap_s4_hana_rfc.SAP_S4_HANA_RFC_Spoke_Admin user role to control access to data. Users with the sn_sap_s4_hana_rfc.SAP_S4_HANA_RFC_Spoke_Admin role have access to the spoke tables.

### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

### MID Server requirements

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with SAP S4 HANA RFC spoke alias to configure where actions run as well as set MID Server selection attributes. For more information about running actions on the MID Server, see Integration steps.

#### Note:

- If the MID Server is installed on a Linux machine, perform the configurations as outlined in Set up the SAP S4 HANA RFC spoke.
- If the MID Server is installed on a Windows machine, no configurations are needed.

### Set up the SAP S4 HANA RFC spoke

Integrate the ServiceNow instance and SAP S4 HANA RFC spoke by using the Basic Auth credentials to authenticate ServiceNow requests.
Before you begin

• Request an IntegrationHub subscription.
• Activate SAP S4 HANA RFC spoke.
• Role required: admin

ℹ️ Note: To retrieve information for authorization purposes, use the Execute RFC spoke action.

Procedure

1. Configure MID Server using the SAP proprietary JAR files.

   a. Optional: Navigate to **System Properties > Security**.

      ℹ️ Note: This is applicable only if your MID Server is installed on a Linux machine

   b. Optional: Disable the MIME type validation for file attachments.

      ℹ️ Note: This is applicable only if your MID Server is installed on a Linux machine.

   c. Navigate to **MID Server > JAR Files**.

   d. Upload the required SAP proprietary files (JAR, SO, or DLL) obtained after contacting your SAP S4 HANA RFC admin. For more information, see [Synchronize a JAR file to MID Servers](#).

      ℹ️ Note: Ensure that the files are synchronised in the `<MID-Server-root-directory>/agent/extlib` directory. If the files aren't synchronised, restart the MID Server.

2. Create a credential record for the SAP S4 HANA RFC account.

   a. Navigate to **Connections & Credentials > Credentials**.

   b. Click **New**.

      The system displays this message: *What type of Credentials would you like to create?*
c. Select **Basic Auth Credentials**.
d
d. On the form, fill these values.

<table>
<thead>
<tr>
<th>Basic Auth Credentials form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>User name</td>
</tr>
<tr>
<td>Password</td>
</tr>
<tr>
<td>Active</td>
</tr>
<tr>
<td>Order</td>
</tr>
<tr>
<td>Credential alias</td>
</tr>
</tbody>
</table>

e. Click **Submit**.

3. Create a connection record for your SAP S4 HANA RFC account.

a. Navigate to **Connections & Credentials > Connections & Credentials Aliases**.

b. Open the alias record for SAP S4 HANA RFC.

c. From the **Connections** tab, click **New**.

d. On the form, fill these fields.

<table>
<thead>
<tr>
<th>Connection form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Credential</td>
</tr>
<tr>
<td>Connection alias</td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>-----------------------</td>
</tr>
<tr>
<td>Host</td>
</tr>
<tr>
<td>Active</td>
</tr>
<tr>
<td>Domain</td>
</tr>
<tr>
<td>Override default port</td>
</tr>
<tr>
<td>Use MID server</td>
</tr>
</tbody>
</table>

e. In the **Advanced MID Server Configuration** tab, provide these details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Selection</td>
<td>Option to select MID Server as required. This field is available when Define Connection Inline is selected from the Source Connection list.</td>
</tr>
<tr>
<td>MID Application</td>
<td>Option to use a MID Server to run the SFTP step. This field is available when Define Connection Inline is selected from the Source Connection list and Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capability of the MID Server. Select SSH. This field is available when Define Connection Inline is selected from the Source Connection list and Auto-Select MID Server is selected from the MID Selection list.</td>
</tr>
<tr>
<td></td>
<td>Required capabilities determine which MID Server is selected at runtime. To learn more about how a MID Server is selected during runtime, see MID Server selection.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Data pill of the required MID Server. This field is available when Define Connection Inline is selected from the Source Connection list and Specific MID Server is selected from the MID Selection list.</td>
</tr>
</tbody>
</table>
f. In the Attributes tab, provide these details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>u_client</td>
<td>Client value of the target host where the SAP S4 HANA RFC server is installed.</td>
</tr>
<tr>
<td>u_system_number</td>
<td>System number of the target host where the SAP S4 HANA RFC server is installed.</td>
</tr>
<tr>
<td>u_lang</td>
<td>Language selected in the target host where the SAP S4 HANA RFC server is installed.</td>
</tr>
</tbody>
</table>

g. Click Submit.

4. Create a record in the SAP S/4HANA Flow Executions module to specify date up to which you want to retrieve the invoice data.


b. Click New.

c. In Last Successful Execution, specify the date up to which you want to retrieve the invoice data.

d. Click Submit.

The Retrieve Incoming Invoice flow takes this date as an input and retrieves the invoice data. Depending on the configured flow trigger, the Retrieve Incoming Invoice flow periodically retrieves the invoice data. To view the invoice data, navigate to SAP S/4HANA - RFC Spoke > SAP S/4HANA Invoice Data.

SAP SuccessFactors spoke v3.0.0
Manage data and entities in SAP SuccessFactors from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
IntegrationHub subscription

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Action Step - SOAP (com.glide.hub.action_step.soap)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- ServiceNow IntegrationHub Action Step - XML Parser (com.glide.hub.action_step.xmlparser)
- ServiceNow Flow Designer - Dynamic Outputs (com.glide.hub.dynamic_outputs)
- Remote Tables (com.glide.script.vtable)

Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Spoke flows

The SAP SuccessFactors spoke provides sample flows in the draft state to demonstrate automating the SAP SuccessFactors tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Todo</td>
<td>Creates a todo record in SAP SuccessFactors.</td>
</tr>
<tr>
<td>Update Todo</td>
<td>Updates details of the specified todo record in SAP SuccessFactors.</td>
</tr>
<tr>
<td>Run SuccessFactors Integration Flow</td>
<td>Retrieves entire data or only updates made after the last refresh, for</td>
</tr>
</tbody>
</table>
**Flow** | **Description**
---|---
| the selected entities, from SAP SuccessFactors to your ServiceNow instance. By default, you can retrieves data from these entities in SAP SuccessFactors:
| - Department
| - Location
| - Job Profile
| - Workers Profile
| - Effective Workers Profile
| - Job History Including Secondary Assignments
| - Todo

**Note:** The Create Todo and Update Todo flows demonstrate the todo record management when events occur in ServiceNow. You can customize these flows as per your requirement to manage records of other entities from your ServiceNow instance.

**Spoke subflows**

The SAP SuccessFactors spoke provides sample subflows in the draft state to demonstrate automating the SAP SuccessFactors tasks. To customize a sample subflow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve Departments</td>
<td>Retrieves the department data from SAP SuccessFactors and stores it in SuccessFactors Departments Staging Table.</td>
</tr>
<tr>
<td>Retrieve Effective Worker Profiles</td>
<td>Retrieves the Effective Worker Profiles data from SAP SuccessFactors and stores it in SuccessFactors Worker Profiles Staging Table.</td>
</tr>
<tr>
<td>Retrieve Job History Including Secondary Assignments</td>
<td>Retrieves the job history data, including secondary assignments, from SAP SuccessFactors and stores it</td>
</tr>
</tbody>
</table>
Subflow | Description
--- | ---
Retrieve Job Profiles | Retrieves the job profile data from SAP SuccessFactors and stores it in SuccessFactors Job Profile Staging Table.
Retrieve Locations | Retrieves the location data from SAP SuccessFactors and stores it in SuccessFactors Locations Staging Table.
Retrieve Todos | Retrieves the todo data from SAP SuccessFactors and stores it in SuccessFactors Inbound Todos Staging Table.
Retrieve Worker Profiles | Retrieves the Worker Profiles data from SAP SuccessFactors and stores it in SuccessFactors Worker Profiles Staging Table.
Run SuccessFactors Service | Retrieves entire data or only updates made from the last successful runtime, for the selected entities.
Process SuccessFactors Webhooks | Processes the SAP SuccessFactors webhook event. For more information about setting up the webhooks, see Set up webhook for the SAP SuccessFactors spoke.

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Management</td>
<td>Employee Address Information</td>
<td>Retrieves the address information of the specified employee.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>----------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Employee Annual Compensation</td>
<td></td>
<td>Retrieves the annual compensation details of the specified employee.</td>
</tr>
<tr>
<td>Employee Compensation Details</td>
<td></td>
<td>Retrieves compensation details of the specified employee.</td>
</tr>
<tr>
<td>Employee Documents</td>
<td></td>
<td>Retrieves all the viewable documents of the specified employee.</td>
</tr>
<tr>
<td>Employee Payment Method Details</td>
<td></td>
<td>Retrieves the details about payment method of the specified employee.</td>
</tr>
<tr>
<td>Employee Time Off</td>
<td></td>
<td>Retrieves the time offs taken by the specified employee.</td>
</tr>
<tr>
<td>Employee Time Off Balances</td>
<td></td>
<td>Retrieves the time off balance details of the specified employee.</td>
</tr>
<tr>
<td>My TimeCard Details</td>
<td></td>
<td>Retrieves the time sheet details of the specified employee.</td>
</tr>
<tr>
<td>Change User Roles</td>
<td></td>
<td>Adds user to the given permission group.</td>
</tr>
<tr>
<td>Employee All Payment Methods Details</td>
<td></td>
<td>Retrieves details of all the payment methods of the specified employee.</td>
</tr>
<tr>
<td>Employee Recurring Compensations</td>
<td></td>
<td>Manages the recurring component of a specified employee’s compensation.</td>
</tr>
<tr>
<td>Get Employee Benefit Enrollments</td>
<td></td>
<td>Retrieves details of the benefit enrollments of the specified employee during a specific time period.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Offboard an Employee</td>
<td>Triggers the termination process of the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Org Change</td>
<td>Changes the organisation related information of the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Report No Shows</td>
<td>Reports no show for the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Reporting Structure</td>
<td>Retrieves the reporting structure of the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Request Time Off</td>
<td>Applies a time off request for the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Update Employee Address</td>
<td>Updates the address of the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Update Employee Personal Information</td>
<td>Updates the personal information of the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Update Employee Personal Information - Global</td>
<td>Updates the global information of the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Update Employee Start Dates</td>
<td>Updates the start date of employment of the specified employee.</td>
</tr>
<tr>
<td>HR Foundational Data</td>
<td>Login into SuccessFactors</td>
<td>Logs in to SAP SuccessFactors and retrieves the Session ID.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Current Employment Information</td>
<td>Retrieves the current employment information from SAP SuccessFactors.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Departments</td>
<td>Retrieves the department data from SAP SuccessFactors.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Retrieve Effective Worker Profiles</td>
<td>Retrieves the Effective Worker Profiles data from SAP SuccessFactors.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Job History Including Secondary Assignments</td>
<td>Retrieves the job history data including secondary assignments from SAP SuccessFactors.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Job Profiles</td>
<td>Retrieves the job profile data from SAP SuccessFactors.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Locations</td>
<td>Retrieves the location data from SAP SuccessFactors.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Worker Profiles</td>
<td>Retrieves the Worker Profiles data from SAP SuccessFactors.</td>
</tr>
<tr>
<td></td>
<td>Get Holiday Calendar</td>
<td>Retrieves holiday calendar for a country.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get Dynamic Output Fields</td>
<td>Creates a dynamic output structure for mapping of fields in response for the given entity.</td>
</tr>
<tr>
<td></td>
<td>Get Entities - Creatable</td>
<td>Retrieves the entities for which the create operation is supported.</td>
</tr>
<tr>
<td></td>
<td>Get Entities - Deletable</td>
<td>Retrieves the entities for which the delete operation is supported.</td>
</tr>
<tr>
<td></td>
<td>Get Entities - Updatable</td>
<td>Retrieves entities for which the update operation is supported.</td>
</tr>
<tr>
<td></td>
<td>Get Entities List</td>
<td>Retrieves the list of all entities.</td>
</tr>
<tr>
<td></td>
<td>Get Fields -Creatable</td>
<td>Retrieves all the creatable non-</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Get Fields - Updatable</td>
<td>Retrieves all the updatable non-navigation fields in an entity.</td>
</tr>
<tr>
<td></td>
<td>Get Key Fields</td>
<td>Retrieves all the key fields in the specified entity.</td>
</tr>
<tr>
<td></td>
<td>Get Required Fields - Creatable</td>
<td>Retrieves all the required insertable fields in the specified entity.</td>
</tr>
<tr>
<td></td>
<td>Get Updatable Todo Fields</td>
<td>Retrieves the list of updatable fields in the Outbound Todos Staging Table.</td>
</tr>
<tr>
<td></td>
<td>Get Available Positions</td>
<td>Retrieves all the available positions for given company and location code.</td>
</tr>
<tr>
<td></td>
<td>Get Business Units</td>
<td>Retrieves all the available business units in SAP SuccessFactors.</td>
</tr>
<tr>
<td></td>
<td>Get Companies</td>
<td>Retrieves all the available active companies in SAP SuccessFactors.</td>
</tr>
<tr>
<td></td>
<td>Get Countries</td>
<td>Retrieves all the available countries in SAP SuccessFactors.</td>
</tr>
<tr>
<td></td>
<td>Get Country Code</td>
<td>Retrieves country code of a country.</td>
</tr>
<tr>
<td></td>
<td>Get Dynamic Permission Groups</td>
<td>Retrieves all the available dynamic permission groups.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Get Event Reasons By Event ID</td>
<td></td>
<td>Retrieves all the event reasons for the specified Event ID.</td>
</tr>
<tr>
<td>Get Global Information By Entity</td>
<td></td>
<td>Retrieves metadata of the entity specified to fetch the global information.</td>
</tr>
<tr>
<td>Get Global Personal Information Supported Countries</td>
<td></td>
<td>Retrieves details of the countries that support the creation and modification of the personal global information.</td>
</tr>
<tr>
<td>Get Locations By Company Code</td>
<td></td>
<td>Retrieves all the active locations from SAP SuccessFactors for the specified company code.</td>
</tr>
<tr>
<td>Get People Pools By Group ID</td>
<td></td>
<td>Retrieves all people pools with only user name category for the specified group.</td>
</tr>
<tr>
<td>Get Pick List Options</td>
<td></td>
<td>Retrieves all the available pick list options for the specified pick list ID.</td>
</tr>
<tr>
<td>Get Pick List Options By Country</td>
<td></td>
<td>Retrieves the pick list options of the specified country.</td>
</tr>
<tr>
<td>Get Recurring Pay Components Defined for Employee</td>
<td></td>
<td>Retrieves recurring pay components and relevant information for the specified employee.</td>
</tr>
<tr>
<td>Get Required Fields - Creatable</td>
<td></td>
<td>Retrieves all the required insertable fields in the specified entity.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get Time Types By User ID</td>
<td>Retrieves all the available time types of the specified employee in SAP SuccessFactors.</td>
</tr>
<tr>
<td></td>
<td>Get Updatable Todo Fields</td>
<td>Retrieves the list of updatable fields in the SuccessFactors Outbound Todos Staging table.</td>
</tr>
<tr>
<td>Record Management</td>
<td>Create Record</td>
<td>Creates a record in SAP SuccessFactors.</td>
</tr>
<tr>
<td></td>
<td>Delete Record</td>
<td>Deletes the specified record in SAP SuccessFactors.</td>
</tr>
<tr>
<td></td>
<td>Execute Entity By URL</td>
<td>Takes navigation URL as input and provides the response for that navigation URL.</td>
</tr>
<tr>
<td></td>
<td>Get Record</td>
<td>Retrieves the record for the selected entity and for the given key fields.</td>
</tr>
<tr>
<td></td>
<td>Update Record</td>
<td>Updates details of the specified record.</td>
</tr>
<tr>
<td>Todos</td>
<td>Create Todo</td>
<td>Create a todo record in SAP SuccessFactors.</td>
</tr>
<tr>
<td></td>
<td>Get Todo By ID</td>
<td>Get details of a todo from SAP SuccessFactors.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Todos</td>
<td>Retrieves the todo data from SAP SuccessFactors, except those with Category ID as 57.</td>
</tr>
<tr>
<td></td>
<td>Update Todo</td>
<td>Updates details of the specified todo record.</td>
</tr>
<tr>
<td>User Management</td>
<td>Look up User Activity</td>
<td>Retrieves the last activity time of your SAP SuccessFactors users.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Look up User Activity SFTP</td>
<td>Retrieves the last activity time of your SAP SuccessFactors users by fetching the report published on an SSH File Transfer Protocol (SFTP) location.</td>
<td></td>
</tr>
<tr>
<td>Look up Users</td>
<td>Retrieves the list of SAP SuccessFactors users.</td>
<td></td>
</tr>
<tr>
<td>Suspend User</td>
<td>Suspends a user account.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Utility Category</td>
<td>Call A SuccessFactors Subflow</td>
<td>Executes the specified SAP SuccessFactors spoke subflow synchronously.</td>
</tr>
<tr>
<td></td>
<td>Call Run SuccessFactors Service Subflow</td>
<td>Executes the Run SuccessFactors Service subflow asynchronously.</td>
</tr>
<tr>
<td></td>
<td>Check Flow Status</td>
<td>Checks if the context of flow is currently running.</td>
</tr>
<tr>
<td></td>
<td>Get Last Run Date</td>
<td>Retrieves the last run date and time of the flow.</td>
</tr>
<tr>
<td></td>
<td>Update Record In Outbound Todos Staging Table</td>
<td>Updates details of the specified todo record in SuccessFactors Outbound Todos Staging Table.</td>
</tr>
</tbody>
</table>

**Note:** If a spoke action requires date or time as an input, ensure that you provide the value in GMT time zone only.

**Spoke modules**
The SAP SuccessFactors spoke adds a SuccessFactors application to your ServiceNow instance. The SuccessFactors application has these modules.
<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department Staging Table</td>
<td>Displays the department data retrieved from SAP SuccessFactors.</td>
</tr>
<tr>
<td>Locations Staging Table</td>
<td>Displays the location data retrieved from SAP SuccessFactors.</td>
</tr>
<tr>
<td>Job Profile Staging Table</td>
<td>Displays the job profile data retrieved from SAP SuccessFactors.</td>
</tr>
<tr>
<td>Worker Profiles Staging Table</td>
<td>Displays the worker profile data retrieved from SAP SuccessFactors.</td>
</tr>
<tr>
<td>Inbound Todos Staging Table</td>
<td>Displays the todo records retrieved from SAP SuccessFactors.</td>
</tr>
<tr>
<td>Outbound Todos Staging Table</td>
<td>Displays the todo records created in ServiceNow.</td>
</tr>
<tr>
<td></td>
<td>When a todo record is created or updated in ServiceNow, the Create Todo or</td>
</tr>
<tr>
<td></td>
<td>Update Todo flow is triggered and the same record is created or updated in</td>
</tr>
<tr>
<td></td>
<td>SAP SuccessFactors. All the associated record details, are retrieved from</td>
</tr>
<tr>
<td></td>
<td>SAP SuccessFactors and saved in this staging table. If the flow fails to</td>
</tr>
<tr>
<td></td>
<td>create or update record in SAP SuccessFactors, the associated record or</td>
</tr>
<tr>
<td></td>
<td>updates in ServiceNow is also deleted.</td>
</tr>
<tr>
<td>Employee Job Information And History</td>
<td>Displays the job information and job history of all users.</td>
</tr>
<tr>
<td>View My Time Off Balance</td>
<td>Displays the time off balance of the logged in user.</td>
</tr>
<tr>
<td>View My Time Off Details</td>
<td>Displays details of the time off requests of the logged in user.</td>
</tr>
<tr>
<td>Module</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Webhook Registry</td>
<td>Displays the list of webhook registries. Admin must create webhook registry here. For more information, see <a href="#">Set up webhook for the SAP SuccessFactors spoke</a>.</td>
</tr>
<tr>
<td>View My Time Card Details For Past 1 Month</td>
<td>Displays time card details of the previous one month for the logged in user.</td>
</tr>
<tr>
<td>View My Worker Profile</td>
<td>Displays the worker profile details of the logged in user.</td>
</tr>
<tr>
<td>View My Holiday Calendar</td>
<td>Displays the holiday calendar applicable to the logged in user.</td>
</tr>
<tr>
<td>View My Reporting Structure</td>
<td>Displays the reporting structure details of the logged in user.</td>
</tr>
<tr>
<td>View My Direct Deposit Information</td>
<td>Displays the direct deposit details of the logged in user.</td>
</tr>
<tr>
<td>View My Total Rewards</td>
<td>Displays the total rewards of the logged in user.</td>
</tr>
</tbody>
</table>

To retrieve the data, run Run SuccessFactors Integration Flow. The data in the staging tables is available for 7 days. During this time period, you must use transform maps to save this data in the required target ServiceNow tables as per your requirement.

**Spoke transform maps**

The SAP SuccessFactors spoke provides sample transform maps in inactive state and associated sample target tables to demonstrate using transform maps to save SAP SuccessFactors data in your ServiceNow tables. You can use these sample transform maps and target tables as reference to create transform maps as per your requirement.

For more information, see [Transform maps](#).
Spoke user roles
These user roles are available along with the spoke:

- **SuccessFactors Admin (sn_successfactors.SuccessFactors Admin):** Users with this role have access to all spoke modules and tables.

- **SuccessFactors Private Data (sn_successfactors.SuccessFactors Private Data):** Users with this role have access to data in these spoke modules:
  - View My Direct Deposit Information
  - View My Total Rewards

- **SuccessFactors Public Data (sn_successfactors.SuccessFactors Public Data):** Users with this role have access to data in these spoke modules:
  - View My Time Off Balance
  - View My Time Off Details
  - View My Time Card Details For Past 1 Month
  - View My Worker Profile
  - View My Holiday Calendar
  - View My Reporting Structure

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Two connection and credential aliases are available with the SAP SuccessFactors spoke; one for the SOAP API and other for the OData API.

Set up the SAP SuccessFactors spoke
Integrate the ServiceNow instance with your SAP SuccessFactors instance using basic credentials.

Before you begin
- Request IntegrationHub subscription
- Activate the SAP SuccessFactors spoke
- Enable these system properties:
• glide.pf.rest.response_payload_max_size: The maximum value is, 10240.
• com.snc.process_flow.reportingserialized.val_size_limit: The maximum value is, 16384.
• com.glide.transform.json.max-partial-length: The maximum value is, 65536.

• Role required: admin

Create Credential record for the OData API
Create Credential record for the OData APIs in SAP SuccessFactors. The SAP SuccessFactors spoke connection and credential alias uses these credentials to authorize actions using the OData API.

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?.
3. Select Basic Auth Credentials.
   A blank Basic Auth Credentials form displays.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter SAPSF OData Credentials.</td>
</tr>
<tr>
<td>User name</td>
<td>User name with the OData API permission in this format: &lt;username&gt;@&lt;SAP-SuccessFactors-CompanyID&gt;.</td>
</tr>
<tr>
<td>Password</td>
<td>Associated password.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Results
The credential record to authorize actions using the OData API is created.
Create Credential record for the SOAP API

Create Credential record for the SOAP APIs in SAP SuccessFactors. The SAP SuccessFactors spoke connection and credential alias uses these credentials to authorize actions using the SOAP APIs.

Procedure

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?
   A blank SuccessFactors SOAP Credentials form displays.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter SAPSF Comp Emp Credentials.</td>
</tr>
<tr>
<td>User name</td>
<td>User name with the SOAP API permission.</td>
</tr>
<tr>
<td>Password</td>
<td>Associated password.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Results

The credential record to authorize actions using the SOAP API is created.

Create Connection record for the OData API

Create a Connection record for the OData API in SAP SuccessFactors. The SAP SuccessFactors spoke connection and credential alias uses these connections to perform actions in SAP SuccessFactors.

Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for SuccessFactors OData API. For example, SuccessFactors_OData.
3. From the Connections tab, click New.
The system displays a blank HTTP(s) Connection form.

4. On the form, fill these values.

<table>
<thead>
<tr>
<th>HTTP(s) Connection form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, SF_REST.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for the OData API. For example, SAPSF OData Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Results
The connection record for the OData API in SAP SuccessFactors is created.

Create Connection record for the SOAP API
Create a Connection record for the SOAP API in SAP SuccessFactors. The SAP SuccessFactors spoke connection and credential alias uses these connections to perform actions in SAP SuccessFactors.

Procedure
1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for SuccessFactors SOAP API. For example, SuccessFactors_Comp_Emp.
3. From the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.
4. On the form, fill these values.
HTTP(s) Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, SF_REST.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for the SOAP API. For example, SAPSF Comp Emp Credentials.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>SAP SuccessFactors connection URL. For example, <a href="https://salesdemo4.successfactors.com/sfapi/v1/soap">https://salesdemo4.successfactors.com/sfapi/v1/soap</a>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
</tbody>
</table>

5. In the **Attributes** tab, provide these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company Id</td>
<td>Immutable Company ID of your SAP SuccessFactors instance.</td>
</tr>
<tr>
<td>Flow Timeout (seconds)</td>
<td>Maximum time in seconds up to which data can be received from SAP SuccessFactors during the flow execution. If the time taken to retrieve data from SuccessFactors exceeds the timeout duration, the flow or subflow is cancelled. Default value is, 30.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

**Results**
The connection record for the SOAP API in SAP SuccessFactors is created.

**Synchronise data between SAP SuccessFactors and ServiceNow**
Customise the sample flows as per your requirement to synchronise data between your SAP SuccessFactors and ServiceNow instances.

**Todo entity**
The SAP SuccessFactors spoke provides sample flows to synchronise data bi-directionally for the todo entity. The sample flow, Run SuccessFactors Integration Flow can customised to retrieve data from SAP SuccessFactors, while the Create Todo and Update Todo flows creates or updates the todo records in SAP
SuccessFactors when events occur in ServiceNow. While customising the sample flows, ensure that you provide appropriate triggers to retrieve and save future updates using transform maps.

**Other default entities**
For these entities, the sample flow, Run SuccessFactors Integration Flow, can be customised to retrieve data from SAP SuccessFactors:

- Department
- Location
- Job Profile
- Workers Profile
- Effective Workers Profile
- Job History Including Secondary Assignments

To create or update records in SAP SuccessFactors for these entities when events occur in ServiceNow:

- Create flows or subflows as per your choice or customise the sample flows and subflows.
- Use Metadata Retrieval and Record Management actions in your flows.
- Ensure that you provide appropriate triggers to retrieve and save future updates using transform maps.

**Other SAP SuccessFactors entities**
Depending on the SAP SuccessFactors permissions and configurations, you can also synchronise data of other entities as per your requirement.

**Set up webhook for the SAP SuccessFactors spoke**
Configure a webhook to subscribe to your SAP SuccessFactors account with a ServiceNow callback URL.

**Before you begin**

- Set up the SAP SuccessFactors spoke
- Role required: admin
Procedure

1. Configure the default decision table.

   a. Navigate to System Definition > Decision Tables.

   b. Search for the record, Successfactors Webhook and open it.

   c. In the Decision Inputs tab, open the Webhook Event record.

   d. In the Choices tab, create record for the event for which you want to subscribe. For example, enter Employee Time Off in Label and Name to subscribe to the Employee Time Off events.

   e. Navigate back to the Successfactors Webhook record.

   f. In the Decisions tab, open the Default Decision record.

   g. Select the required webhook event in Condition and select the subflow in Answer.

      When the specified webhook event occurs, the associated subflow is triggered.

      ❖ Note: You can customise the default subflow or create a subflow as per your requirement.

2. Create a webhook registry.

   a. Navigate to SuccessFactors Spoke > Webhook Registry.

   b. Click New.

   c. On the form, enter SuccessFactors Webhook Authentication for Name and provide Description.

      ❖ Note: The Name of the webhook registry must be SuccessFactors Webhook Authentication.

   d. Click Generate Username and Password.

      Username and Password are generated and the values are displayed.

   e. Copy and record the values of the generated values for later use.
3. Copy and record the value of **Resource path**.
   a. Navigate to **System Web Services > Scripted REST APIs**.
   b. Search for the record, *SuccessfactorsWebhook* and open it.
   c. In the **Resources** tab, click the **processWebhook** record.
   d. Copy and record the value provided in **Resource path**.

4. Configure events in your SAP SuccessFactors instance.
   a. Log in to your SAP SuccessFactors instance and navigate to **Admin Center > Event Notification Subscription**.
   b. In the **External Event** tab, provide these values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint URL</td>
<td>ServiceNow instance endpoint URL in this format: https://&lt;servicenow-instance&gt;.com/&lt;resource-path&gt;</td>
</tr>
<tr>
<td>Authentication</td>
<td>Select <em>Basic</em>.</td>
</tr>
<tr>
<td>User</td>
<td>User name generated when the webhook registry is created.</td>
</tr>
<tr>
<td>Password</td>
<td>Password when the webhook registry is created.</td>
</tr>
</tbody>
</table>

   c. Configure the subscriber in the **Subscriber** tab as per your requirement.
   d. Select the required **Service Event Bus Topic** in the **SEB External Event** tab as per your requirement and select the events for which you want to receive notifications. For example, Employee Time Off.

**Secureworks CTP spoke**

Integrate ServiceNow instance with Secureworks Counter Threat Platform (CTP). Manage events and tickets in Secureworks Counter Threat Platform from your ServiceNow instance.

**Request apps on the Store**

Visit the **ServiceNow Store** website to view all the available apps and for information about submitting requests to the store. For cumulative release
notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Supported versions**
This spoke was built for Secureworks CTP V4, but may be compatible with later versions.

**Spoke requirements**
- Secureworks portal account

**Spoke dependencies**
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

**Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke actions**
The Secureworks CTP spoke provides actions to automate Secureworks CTP tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Management</td>
<td>Get Event Details</td>
<td>Retrieves the details of a specific event.</td>
</tr>
<tr>
<td></td>
<td>Get Recent Events</td>
<td>Retrieves details of a list of recent events.</td>
</tr>
<tr>
<td>Ticket Management</td>
<td>Assign Ticket To Secureworks SOC</td>
<td>Assigns a ticket to the Secureworks Security Operations Centers (SOC) Team.</td>
</tr>
<tr>
<td></td>
<td>Close Secureworks Ticket</td>
<td>Closes the specified Secureworks ticket.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Get Ticket Details</td>
<td>Retrieves the details of the specified Secureworks ticket.</td>
</tr>
<tr>
<td></td>
<td>Look up Tickets</td>
<td>Retrieves a list of tickets from Secureworks.</td>
</tr>
<tr>
<td></td>
<td>Post Worklog to Secureworks Ticket</td>
<td>Adds a worklog to the Secureworks ticket.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the Secureworks CTP spoke**

Integrate the ServiceNow instance and Secureworks CTP by registering a custom application in Secureworks Portal to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub subscription.
- Activate Secureworks CTP spoke.
- Create an API password from the Account Management section of your Secureworks CTP account.
- Role required: admin

**Create a credential record for the Secureworks CTP spoke**

Create a credential record for the Secureworks CTP account. The Secureworks CTP spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   
   The system displays this message: What type of Credentials would you like to create?
3. Select API Key Credentials.
4. On the form, fill these fields.

API Key Credentials

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter Secureworks Cred</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>API Key</td>
<td>API key generated in your Secureworks account. Enter the API key in this format: APIKEY username:password</td>
</tr>
<tr>
<td>Applies to</td>
<td>MID Servers that can use this credential.</td>
</tr>
<tr>
<td>Order</td>
<td>Sequence in which the credential is applied.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Alias to use the credential. Click the padlock icon and enter sn_sw_ctp_spoke.Secureworks</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click Submit.

Create a connection record for the Secureworks CTP spoke

Create a connection record for your Secureworks account. The Secureworks CTP spoke connection and credential aliases use these connections to perform API actions in Secureworks portal.

Procedure

1. Navigate to Connections & Credentials > Connections & Credentials Aliases.
2. Open the alias record for Secureworks.
3. From the Connections tab, click New.
4. On the form, fill these fields.
Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Secureworks Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Secureworks CTP spoke. Enter the credential you created. For example Secureworks Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection. The default alias is sn_sw_ctp_spoke.Secureworks.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to Secureworks. Enter: <a href="https://api.secureworks.com">https://api.secureworks.com</a></td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
</tbody>
</table>

5. Click Submit.

ServiceNow Kafka Consumer
Integrates your ServiceNow instance with Kafka Consumer and stores data in the ServiceNow tables.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Confluent REST Proxy API v2.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
The plugins mentioned include:

- Confluent Kafka REST Proxy spoke
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Step - RTE (com.glide.hub.action_step.rte)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

ServiceNow Kafka Consumer uses the connection and credential alias of the Confluent Kafka REST Proxy spoke.

### Configure ServiceNow Kafka Consumer

Retrieve events pertaining to the specified topics and store it in the required ServiceNow tables.

**Before you begin**

- Request IntegrationHub subscription.
- Activate and set up the Confluent Kafka REST Proxy spoke.
- Activate ServiceNow Kafka Consumer.
- Define entities and mapping between entities. For information, see Robust Import Set Transformers.
- Role required: import_admin

**Procedure**

1. Navigate to Process Automation > Kafka Consumer.
2. Click New.
3. On the form, fill these values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to identify the record.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Broker Connection Alias</td>
<td>Connection alias of the Confluent Kafka REST Proxy spoke.</td>
</tr>
<tr>
<td>Topic</td>
<td>Topic from which you want to retrieve the events.</td>
</tr>
<tr>
<td>Robust Transformer Definition</td>
<td>Robust Transformer Definition that is used for the event transformation and data storage in ServiceNow tables. For information, see Robust Import Set Transformers.</td>
</tr>
<tr>
<td>Offset Starting Point</td>
<td>Value of the Kafka Consumer auto.offset.reset. This specifies what the Kafka Consumer should do when there is no initial offset or if the current offset does not exist any more on the server. See the Kafka 2.7 documentation for more information.</td>
</tr>
<tr>
<td>Partitions per group</td>
<td>Number of partitions per consumer thread.</td>
</tr>
<tr>
<td>Page size (bytes)</td>
<td>Maximum size of a request.</td>
</tr>
<tr>
<td>Page limit</td>
<td>Maximum number of requests per iteration.</td>
</tr>
<tr>
<td>Embedded Format</td>
<td>Format of the Kafka message for the topic.</td>
</tr>
<tr>
<td>Request timeout (ms)</td>
<td>Value of the Kafka Consumer consumer.request.timeout.ms. This specified the maximum amount of time the client waits for the response of a request. See the Kafka 2.7 documentation for more information.</td>
</tr>
<tr>
<td>Stop Upon Transform Errors</td>
<td>Option to stop listening when transformation errors are encountered.</td>
</tr>
<tr>
<td>Verbose transformation</td>
<td>Option to log all the imported events to import set and produce additional debug logs for transformation.</td>
</tr>
</tbody>
</table>
Note: You must create one Kafka Consumer record for each topic.

4. Click the Start Sink Listener related link. The Kafka Partition Group Listener States table is populated with the topic partition data.

5. Optional: If you want to stop listening, click the Start Sink Listener related link.


7. Open the record, Kafka Consumer Trigger.

8. From the Trigger Type list, select Interval.

9. Click Update.

ServiceNow Remote Instance spoke v2.1.2
Integrate your local and remote ServiceNow instances to export, import, and manage records from your local instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for the Orlando version and later.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- Complex Object (com.glide.cobject)
- ServiceNow Flow Designer - Dynamic Outputs (com.glide.hub.dynamic_outputs)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)

⚠ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke requirements
Ensure that the spoke users have only the required minimum permissions to access data in ServiceNow tables. Do not assign elevated privilege roles to users of this spoke unless very much required. This practice ensures controlled access to data.

Spoke actions
The ServiceNow Remote Instance spoke provides actions to export, import, and manage records when events occur in your local ServiceNow instance. Available actions include:

⚠ Note: The terms remote instance and local instance are used in these contexts:
• Local instance: This is the ServiceNow instance from which the communication is initiated and established.
• Remote instance: This is the ServiceNow instance with which the local instance communicates.

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change request Management</td>
<td>Export Change Request Record</td>
<td>Exports a change request record to a remote instance from the local instance.</td>
</tr>
<tr>
<td></td>
<td>Import Change Request Record</td>
<td>Imports a record from the Change Request table of the remote instance to the local instance.</td>
</tr>
<tr>
<td>Incident Management</td>
<td>Export Incident Record</td>
<td>Exports an Incident record to a remote instance from the local instance.</td>
</tr>
<tr>
<td></td>
<td>Import Incident Record</td>
<td>Imports a record from Incident table of the remote instance to the local instance.</td>
</tr>
<tr>
<td>Problem Management</td>
<td>Export Problem Record</td>
<td>Exports a Problem record to a remote instance from the local instance.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Table Management</td>
<td>Import Problem Record</td>
<td>Imports a record from Problem table of the remote instance to the local instance.</td>
</tr>
<tr>
<td>Table Management</td>
<td>Look Up Fields By Remote Table</td>
<td>Retrieves all the fields from the given remote table.</td>
</tr>
<tr>
<td>Table Management</td>
<td>Look Up Local Import Set Tables</td>
<td>Retrieves information about the given local import set table.</td>
</tr>
<tr>
<td>Table Management</td>
<td>Look Up Remote Import Set Tables</td>
<td>Retrieves information about the given remote import table.</td>
</tr>
<tr>
<td>Table Management</td>
<td>Look Up Remote Tables</td>
<td>Retrieves information about the given remote table.</td>
</tr>
<tr>
<td>Attachment Management</td>
<td>Copy Attachment From Remote Instance</td>
<td>Copies the required attachment from the remote instance.</td>
</tr>
<tr>
<td>Attachment Management</td>
<td>Copy Attachment To Remote Instance</td>
<td>Copies the required attachment to the remote instance.</td>
</tr>
<tr>
<td>Attachment Management</td>
<td>Look Up Local Attachments Names</td>
<td>Retrieves name of the required attachment.</td>
</tr>
<tr>
<td>Case Management</td>
<td>Export Case as Incident</td>
<td>Exports a case record as an incident record to a remote instance from the local instance.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Import Case as Incident</td>
<td>Imports a record from the case table of the remote instance as an incident record to the local instance.</td>
</tr>
<tr>
<td></td>
<td>Import Case Record</td>
<td>Imports a record from the Case table of the remote instance to the local instance.</td>
</tr>
<tr>
<td></td>
<td>Import Case Task Record</td>
<td>Imports a record from the Task table of the remote instance to the local instance.</td>
</tr>
<tr>
<td></td>
<td>Import Incident as Case</td>
<td>Imports a record from the Incident table of the remote instance as a case record to the local instance.</td>
</tr>
<tr>
<td>Record Management</td>
<td>Create or Update Remote Record</td>
<td>Creates a record or updates an existing record in the remote instance.</td>
</tr>
<tr>
<td></td>
<td>Create or Update Remote Record Using Import Set</td>
<td>Creates a record in the remote import set.</td>
</tr>
<tr>
<td></td>
<td>Create Remote Record</td>
<td>Creates record in remote instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Remote Record</td>
<td>Deletes record in remote instance.</td>
</tr>
<tr>
<td></td>
<td>Export Record Using Import Set</td>
<td>Exports a record from the selected local table to a remote instance.</td>
</tr>
<tr>
<td></td>
<td>Get Remote Record</td>
<td>Retrieves the required record information from the remote instance.</td>
</tr>
<tr>
<td></td>
<td>Import Record Using Import Set</td>
<td>Imports a record from table in the remote instance to the local instance.</td>
</tr>
<tr>
<td></td>
<td>Look Up Remote Record</td>
<td>Retrieves the required record from the remote instance.</td>
</tr>
<tr>
<td></td>
<td>Look Up Remote Records</td>
<td>Retrieves multiple records from the remote instance table.</td>
</tr>
<tr>
<td></td>
<td>Update Remote Record</td>
<td>Updates the required record in the remote instance.</td>
</tr>
</tbody>
</table>
Note: The Company field is required to import or export records using the default transform maps. However, users can modify the transform maps as per their requirement. Also, use the import sets when working with integration involving data transfer.

Spoke transform maps
The ServiceNow Remote Instance spoke provides sample transform maps in active state and associated sample target tables to demonstrate using transform maps to save the remote ServiceNow instance data in your local ServiceNow tables. You can use these sample transform maps and target tables as reference to create transform maps as per your requirement.

For more information, see Transform maps.

Note:
• By default, the sample transform maps uses sys_id as the coalesce field. You can customise the transform map script as per your requirement to change the coalesce field.
• By default, the export and import actions use the spoke tables. You can change this to use different import sets.
• The time zones may be different in your ServiceNow instances. Ensure that you customise flows accordingly.

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Two connection and credential aliases are required for this spoke; one for the local instance and other for the remote instance.

Set up the ServiceNow Remote Instance spoke
Integrate the local and remote ServiceNow instances by creating an OAuth API endpoint in the remote ServiceNow instance to authenticate requests.

Before you begin
• Request IntegrationHub subscription.
• Activate ServiceNow Remote Instance spoke in remote and local ServiceNow instances.
Role required: admin

⚠️ Note: Admin role is required to only set up the spoke.

To use the spoke, ensure that the spoke users have only the required minimum permissions to access data in ServiceNow tables. Do not assign elevated privilege roles to users of this spoke unless very much required. This practice ensures controlled access to data.

Register remote ServiceNow instance as an OAuth provider

Register remote ServiceNow instance as an OAuth provider so that the local ServiceNow instance can request OAuth 2.0 tokens.

Before you begin

• In the remote ServiceNow instance:
  ◦ Create an OAuth API endpoint for external clients. In Redirect URL, specify the URL of the local ServiceNow instance in this format: https://<instance-name>.service-now.com/oauth_redirect.do. For more information, see Create an endpoint for clients to access the instance.
  ◦ Copy and record the values of Client ID and Client Secret.

• Role required: admin

Procedure

1. Navigate to System OAuth > Application Registry.
2. Open for the record, RemoteSpoke.
3. On the form, fill these values.

Application Registry form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Client ID created in the remote ServiceNow instance.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret created in the remote ServiceNow instance.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>URL of the remote ServiceNow instance in this format: https://&lt;instance-name&gt;.service-now.com/oauth_auth.do.</td>
</tr>
<tr>
<td>Token URL</td>
<td>URL of the remote ServiceNow instance in this format: https://&lt;instance-name&gt;.service-now.com/oauth_token.do.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>URL of the local ServiceNow instance in this format: https://&lt;instance-name&gt;.service-now.com/oauth_redirect.do.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Grant Type</td>
<td>Grant type used to establish the token. Select <strong>Authorization Code</strong>.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>Time, in seconds, that the refresh token is valid. The default time is 8,640,0000 seconds.</td>
</tr>
<tr>
<td>PKCE required</td>
<td>Option to enable public clients to require PKCE for an authorization.</td>
</tr>
<tr>
<td>Note:</td>
<td>You can use only <strong>Authorization Code</strong> as the Default Grant type when <strong>PKCE</strong> is enabled.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Application scope that this registry is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**.

**Create Credential record for the remote ServiceNow instance**

Create credential record for the remote ServiceNow instance. The ServiceNow Remote Instance spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to **Connections & Credentials > Credentials**.

2. Click **New**.
   - The system displays the message **What type of Credentials would you like to create?**.

3. Select **OAuth 2.0 Credentials**.

4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, <strong>Remote Credentials</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
</tbody>
</table>
### Create Connection record for the remote ServiceNow instance

Create Connection record for your remote ServiceNow instance. The ServiceNow Remote Instance spoke connection and credential aliases use these connections to perform actions.

**Procedure**

1. Navigate to **Connections & Credentials > Connections & Credentials Aliases**.
2. Open the alias record, **ServiceNowRemoteInstance**.
3. From the **Connections** tab, click **New**.
4. On the form, fill in the fields.

**HTTP(s) Connection form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Remote Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for remote ServiceNow instance. For example, Remote Credentials.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td><strong>Note:</strong> Do not select the check box.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL of the remote ServiceNow instance. For example, https://&lt;remote-instance-name&gt;service-now.com/.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.
Create Credential record for the local ServiceNow instance

Create credential record for the local ServiceNow instance. The ServiceNow Remote Instance spoke connection and credential alias uses these credentials to authorize actions.

Procedure
1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
   - The system displays the message **What type of Credentials would you like to create?**.
3. Select **Basic Auth Credentials**.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Local Credentials.</td>
</tr>
<tr>
<td>Username</td>
<td>Username to log in to the local ServiceNow instance.</td>
</tr>
<tr>
<td>Password</td>
<td>Password to log in to the local ServiceNow instance.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click **Submit**.

Create Connection record for the local ServiceNow instance

Create Connection record for your local ServiceNow instance. The ServiceNow Remote Instance spoke connection and credential aliases use these connections to perform actions.

Procedure
1. Navigate to **Connections & Credentials > Connections & Credentials Aliases**.
2. Open the alias record, **ServiceNowRemoteInstanceLocalAlias**.
3. From the **Connections** tab, click **New**.
4. On the form, fill in the fields.
HTTP(s) Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Local Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for local ServiceNow instance. For example, Local Credentials.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL of the local ServiceNow instance. For example, https://&lt;local-instance-name&gt;service-now.com/.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Shodan spoke**
Manage exploits, alerts, hosts, and others, in Shodan account from your ServiceNow® instance.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Spoke dependencies**
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke actions**

The Shodan spoke provides actions to automate Shodan tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exploit Management</td>
<td>Exploit Search</td>
<td>Searches for exploits from vulnerability data sources.</td>
</tr>
<tr>
<td></td>
<td>Get Exploit Count</td>
<td>Retrieves the number of exploits for a specific query.</td>
</tr>
<tr>
<td>Network Alert Management</td>
<td>Get Alert Details</td>
<td>Retrieves details of the specific network alert.</td>
</tr>
<tr>
<td></td>
<td>Look up Alerts</td>
<td>Retrieves the list of network alerts.</td>
</tr>
<tr>
<td>Search Management</td>
<td>Get Host Details</td>
<td>Retrieves details of all services that are associated with specified host IP.</td>
</tr>
<tr>
<td></td>
<td>Get Host Count</td>
<td>Retrieves the total number of hosts that match the provided query and requested facet information.</td>
</tr>
<tr>
<td></td>
<td>Search Shodan</td>
<td>Retrieves details from a Shodan search.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.
Two connection and credential alias records are available along with the Shodan spoke.

**Set up the Shodan spoke**

Integrate the Shodan account and your ServiceNow® instance using the API keys.

**Before you begin**

- Request an IntegrationHub subscription.
- Activate Shodan spoke.
- API key of your Shodan account.
- Role required: admin

**Procedure**

1. Navigate to Connections & Credentials > Connections & Credentials Aliases.
2. Open the alias record, Shodan.
3. From the Connections tab, click New.
4. On the form, fill these fields.

**Connection form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Shodan Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>✂ Note: Credential record isn't required.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Host</td>
<td>Fully qualified domain name of the target host. Enter api.shodan.io.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Server for this connection. Select the check box and define the fields in the Advanced MID Server Configuration tab.</td>
</tr>
</tbody>
</table>

5. In the Attributes tab, for Key, specify the API key of your Shodan account.
6. Click Submit.

8. Open the alias record, Shodan Exploit.

9. From the Connections tab, click New.

10. On the form, fill these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Shodan Exploit Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>🔔 Note: Credential record isn't required.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Host</td>
<td>Fully qualified domain name of the target host. Enter exploits.shodan.io.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action runs in.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Server for this connection. Select the check box and define the fields in the Advanced MID Server Configuration tab.</td>
</tr>
</tbody>
</table>

11. In the Attributes tab, for Key, specify the API key of your Shodan account.

12. Click Submit.

**Slack spoke v1.5.6**

Use Slack to post messages and manage access to channels.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

**Slack account requirements**

The Slack spoke requires creating a workspace and custom app on your Slack account to generate OAuth 2.0 tokens for the Slack spoke. See Configure Slack app.
Note: The spoke set up procedure outlined here requires bot user tokens only. You can’t use the Create User and Deactivate User actions while using the bot token scopes. To use these actions, you must obtain user token from your Slack account and set up the Slack spoke as outlined in Set up Slack spoke.

Spoke subflows
The Slack spoke provides a sample subflow to demonstrate automating Slack workspace tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Slack User Details by Member ID</td>
<td>Inserts details of the required user in the Slack User Cache module, based on the Member ID.</td>
</tr>
<tr>
<td>Insert Slack User Details by User ID</td>
<td>Inserts details of the required user in the Slack User Cache module, based on the User ID.</td>
</tr>
<tr>
<td>Post Actionable Message</td>
<td>Posts an actionable message to a Slack channel.</td>
</tr>
<tr>
<td>Note: This subflow requires an outbound configuration as an input. Customise the default outbound configurations or create outbound configuration as per your requirement. For more information, see Configure outbound configurations in ServiceNow instance.</td>
<td></td>
</tr>
<tr>
<td>Post Approval Message</td>
<td>Posts an approval message to a Slack channel.</td>
</tr>
<tr>
<td>Note: This subflow requires an outbound configuration as an input. Customise the default outbound configurations or create outbound configuration as per your requirement. For more information, see Configure outbound configurations in ServiceNow instance.</td>
<td></td>
</tr>
<tr>
<td>Respond to Slack Approval Message</td>
<td>Posts an acknowledgement message on a Slack channel.</td>
</tr>
<tr>
<td>Respond to Slack Command</td>
<td>Posts a response to command on a Slack channel.</td>
</tr>
<tr>
<td>Respond to Slack Message Action</td>
<td>Posts a notification on a Slack channel.</td>
</tr>
</tbody>
</table>
While customizing subflows, you must ensure that the subflows are configured to avoid infinite loops.

**Spoke actions**

The Slack spoke provides actions to automate Slack workspace tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Management</td>
<td>Add User to Channel</td>
<td>Adds an existing user to the specified channel in a Slack workspace.</td>
</tr>
<tr>
<td></td>
<td>Archive Channel</td>
<td>Archives the specified channel in a Slack workspace.</td>
</tr>
<tr>
<td></td>
<td>Conversation Rename</td>
<td>Renames the specified conversation.</td>
</tr>
<tr>
<td></td>
<td>Conversation Info</td>
<td>Retrieves information about a conversation.</td>
</tr>
<tr>
<td></td>
<td>Create Channel</td>
<td>Creates the specified channel in a Slack workspace.</td>
</tr>
<tr>
<td></td>
<td>Look Up Attachments By Conversation / Member ID</td>
<td>Retrieves attachments associated with the relevant channel, member, or bot user.</td>
</tr>
<tr>
<td></td>
<td>Look Up Channel History</td>
<td>Retrieves history of the specified channel.</td>
</tr>
<tr>
<td></td>
<td>Look Up Conversation</td>
<td>Retrieves the conversation messages for a particular thread from the specified channel.</td>
</tr>
<tr>
<td></td>
<td>Look Up Conversation IDs By Member ID</td>
<td>Retrieves details of the Conversation IDs associated with the specified member on Slack.</td>
</tr>
<tr>
<td></td>
<td>Set Topic For Channel</td>
<td>Sets the topic for a Slack channel.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Remove User from Channel</td>
<td>Removes a user from the specified channel in the Slack workspace.</td>
</tr>
<tr>
<td>Notification Management</td>
<td>Post Actionable Message</td>
<td>Posts an actionable message to a Slack channel.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: This action requires an outbound configuration as an input. Customise the default outbound configurations or create outbound configuration as per your requirement. For more information, see <a href="#">Configure outbound configurations in ServiceNow instance</a>.</td>
</tr>
<tr>
<td>Post Approval Message</td>
<td>Post Approval Message</td>
<td>Posts an approval message to a Slack channel.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: This action requires an outbound configuration as an input. Customise the default outbound configurations or create outbound configuration as per your requirement. For more information, see <a href="#">Configure outbound configurations in ServiceNow instance</a>.</td>
</tr>
<tr>
<td></td>
<td>Post Change Details</td>
<td>Posts Change record details to the specified channel.</td>
</tr>
<tr>
<td></td>
<td>Post Incident Details</td>
<td>Posts Incident record details to the specified channel.</td>
</tr>
<tr>
<td></td>
<td>Post Message</td>
<td>Posts a message to a Slack Channel.</td>
</tr>
<tr>
<td></td>
<td>Post Response to Slack</td>
<td>Posts a response message to Slack.</td>
</tr>
<tr>
<td></td>
<td>Update Approval Record</td>
<td>Updates the specified approval record.</td>
</tr>
<tr>
<td></td>
<td>Post Problem Details</td>
<td>Posts Problem record details to the specified channel.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User Management</td>
<td>Create User</td>
<td>Creates a user in the specified Slack workspace.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• This action requires user token from your Slack account. If you have bot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>user tokens, you can’t use this action.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The procedure outlined here requires bot user tokens only. To use this</td>
</tr>
<tr>
<td></td>
<td></td>
<td>action, obtain user token and set up the Slack spoke as outlined in Set up</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Slack spoke.</td>
</tr>
<tr>
<td></td>
<td>Deactivate User</td>
<td>Deactivates the specified user from a Slack workspace.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• This action requires user token from your Slack account. If you have bot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>user tokens, you can’t use this action.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The procedure outlined here requires bot user tokens only. To use this</td>
</tr>
<tr>
<td></td>
<td></td>
<td>action, obtain user token and set up the Slack spoke as outlined in Set up</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Slack spoke.</td>
</tr>
<tr>
<td></td>
<td>Lookup User</td>
<td>Returns information about the specified user or bot. The information can</td>
</tr>
<tr>
<td></td>
<td></td>
<td>be name, time zone, workspace admin rights, and team ownership of a user or</td>
</tr>
<tr>
<td></td>
<td></td>
<td>bot.</td>
</tr>
<tr>
<td></td>
<td>Deactivate</td>
<td>Deactivates a user subscription in Slack. To use this action, perform the</td>
</tr>
<tr>
<td>Subscription</td>
<td>Subscription</td>
<td>steps outlined in the Create a Slack Enterprise Grid application and Create</td>
</tr>
<tr>
<td></td>
<td></td>
<td>a Slack Enterprise connection sections in Integrating with Slack.</td>
</tr>
<tr>
<td></td>
<td>Get Access Logs</td>
<td>Retrieves access logs for all users since the provided oldest date. To use</td>
</tr>
<tr>
<td></td>
<td></td>
<td>this action, perform the steps outlined in the Create a Slack workspace</td>
</tr>
<tr>
<td></td>
<td></td>
<td>application and Create a Slack workspace connection sections in Integrating</td>
</tr>
<tr>
<td></td>
<td></td>
<td>with Slack.</td>
</tr>
<tr>
<td></td>
<td>Get Users</td>
<td>Retrieves all users in the Slack Enterprise grid. To use this action,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>perform the steps outlined in the</td>
</tr>
</tbody>
</table>
Create a Slack Enterprise Grid application and
Create a Slack Enterprise connection sections in
Integrating with Slack.

Note:

• Create User and Deactivate User actions require the admin scope. The
 spoke set up procedure outlined here requires bot user tokens only. You
 can’t use the Create User and Deactivate User actions while using the
 bot token scopes. To use these actions, you must obtain user token from
 your Slack account and set up the Slack spoke as outlined in Set up Slack
 spoke.

• The admin scope is available to Slack workspace owners only.

Spoke modules
The Slack spoke adds the Slack application to your ServiceNow instance. The
Slack application includes these modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slack Modal</td>
<td>Create modals and specify fields that should be displayed in your Slack modal.</td>
</tr>
<tr>
<td>Configuration</td>
<td></td>
</tr>
<tr>
<td>Slack User Cache</td>
<td>Access information about users who have performed actions on the Slack channel that needed updates in ServiceNow instance or response from ServiceNow instance.</td>
</tr>
<tr>
<td>Slack Channel Cache</td>
<td>Access information about the channels on which actions are performed that needed updates in ServiceNow instance or response from ServiceNow instance.</td>
</tr>
<tr>
<td>Inbound Decisions</td>
<td>Specify events in your Slack application for which actions must be performed in ServiceNow instance.</td>
</tr>
</tbody>
</table>

For example, you can specify inbound decisions to update the task details in your ServiceNow instance when an approver approves the task on the relevant Slack channel. Five sample inbound decisions are available for your reference. Customise these decisions or create inbound decisions as per your requirement.

When conditions mentioned in the inbound decisions are met, the associated subflow is triggered and record
<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slack Outbound Choices</td>
<td>Choices that should be displayed as a list on the Slack channels.</td>
</tr>
<tr>
<td>Inbound Slack Message</td>
<td>Access information about the inbound messages to your ServiceNow instance from the Slack application.</td>
</tr>
<tr>
<td>Outbound Configurations</td>
<td>Specify events in ServiceNow instance for which actions must be performed on your Slack application. For example, you can specify outbound configurations to send a message on the relevant Slack channel asking for approval when a task is created in your ServiceNow instance. Three sample outbound configurations are available for your reference. Customise these configurations or create outbound configurations as per your requirement. The outbound configurations also provide a template to the Post Actionable Message and Post Approval Message actions. For example, you can configure the outbound configurations to display the <strong>Approve</strong> and <strong>Reject</strong> buttons in the approval message that is sent on the relevant Slack channel. When configurations mentioned in the outbound configurations are met, the relevant subflow is triggered to perform actions in the Slack application.</td>
</tr>
<tr>
<td>Slack Configurations</td>
<td>Provide information about the Slack app and Signing Key.</td>
</tr>
</tbody>
</table>

Data in these modules is populated from these spoke tables:

<table>
<thead>
<tr>
<th>Table</th>
<th>Fields</th>
</tr>
</thead>
</table>
| Slack Channel Cache [sn_slack_ah_v2_slack_channel_cache] | • Channel ID  
  • Channel Link  
  • Channel Name  
  • Creator  
  • Document ID |
<table>
<thead>
<tr>
<th>Table</th>
<th>Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is Archived</td>
<td></td>
</tr>
<tr>
<td>Is Private</td>
<td></td>
</tr>
<tr>
<td>Source table</td>
<td></td>
</tr>
<tr>
<td>Slack Configurations [sn_slack_ah_v2_slack_configurations]</td>
<td>• Client Secret</td>
</tr>
<tr>
<td></td>
<td>• Connection Alias</td>
</tr>
<tr>
<td></td>
<td>• Property Name</td>
</tr>
<tr>
<td></td>
<td>• Slack App</td>
</tr>
<tr>
<td>Slack Credential [sn_slack_ah_v2_slack_credential]</td>
<td>• Authentication Key</td>
</tr>
<tr>
<td></td>
<td>• Active</td>
</tr>
<tr>
<td></td>
<td>• Context Name</td>
</tr>
<tr>
<td></td>
<td>• Domain Name</td>
</tr>
<tr>
<td></td>
<td>• Privacy Key</td>
</tr>
<tr>
<td>Slack Outbound Choices [sn_slack_ah_v2_slack_outbound_choices]</td>
<td>• Name</td>
</tr>
<tr>
<td></td>
<td>• Active</td>
</tr>
<tr>
<td></td>
<td>• Language</td>
</tr>
<tr>
<td></td>
<td>• Sequence</td>
</tr>
<tr>
<td></td>
<td>• Domain</td>
</tr>
<tr>
<td></td>
<td>• Value</td>
</tr>
<tr>
<td>Slack User Cache [sn_slack_ah_v2_slack_user_details]</td>
<td>• Display Name</td>
</tr>
<tr>
<td></td>
<td>• Slack Member ID</td>
</tr>
<tr>
<td></td>
<td>• Team ID</td>
</tr>
<tr>
<td></td>
<td>• User</td>
</tr>
<tr>
<td>Slack Workspace Tokens [sn_slack_ah_v2_slack_workspace_tokens]</td>
<td>• Connection Alias</td>
</tr>
<tr>
<td></td>
<td>• Slack App</td>
</tr>
<tr>
<td></td>
<td>• Workspace Name</td>
</tr>
<tr>
<td>Slack Modal Configuration [sn_slack_ah_v2_slack_modal_configuration]</td>
<td>• Modal Title</td>
</tr>
<tr>
<td></td>
<td>• Name</td>
</tr>
<tr>
<td>Table</td>
<td>Fields</td>
</tr>
<tr>
<td>-------</td>
<td>--------</td>
</tr>
</tbody>
</table>
|       | • Script Validation  
|       | • Custom Modal |

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection information and OAuth credentials. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you do not need to update any actions that use the connection.

**Set up Slack spoke**

Integrate the ServiceNow instance and your Slack account by creating a custom OAuth application in Slack to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription.
- Activate Slack spoke.
- Slack account.
- Add Slack users to the User [sys_user] table of your ServiceNow instance, with Email being the unique identifier.
- Role required: admin

**About this task**

The spoke set up procedure outlined here requires bot user tokens only. You can't use the Create User and Deactivate User actions while using the bot token scopes. To use these actions, you must obtain user token from your Slack account and set up the Slack spoke as outlined in Set up Slack spoke.

**Configure Slack app**

Create a custom OAuth application on your Slack workspace to enable OAuth 2.0 authentication with the Slack spoke.

**About this task**

Complete these steps from your Slack account. You can create an app or configure an existing app as per the configurations outlines here.
Procedure

1. Create a Slack workspace. For more information about creating a Slack workspace, see Create a Slack workspace.

2. Navigate to the Slack API console and create an app. For more information, see the Create a Slack App step.

3. From the Basic Information page, copy and record the values of Client ID, Client Secret, and Signing Secret of your Slack app. For more information, see the Get Client ID and Secret for later step.

4. On the OAuth & Permissions page:

   a. Specify the ServiceNow instance URL in Redirect URLs in this format: https://<instance-name>.service-now.com/oauth_redirect.do.

   b. Add these bot token scopes:

      - channels:history
      - channels:manage
      - channels:read
      - chat:write
      - chat:write.customize
      - groups:read
      - im:read
      - mpim:read
      - groups:history
      - groups:write
      - im:history
      - im:write
      - mpim:history
      - mpim:write
      - users:read
      - users:read.email
      - files:read
For more information, see Scopes and permissions.

⚠️ **Note:** The spoke set up procedure outlined here requires bot user tokens only. You can’t use the Create User and Deactivate User actions while using the bot token scopes. To use these actions, you must obtain user token from your Slack account and set up the Slack spoke as outlined in Set up Slack spoke.

5. On the Slash Commands page, create a command. Specify these values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
<td>/now</td>
</tr>
<tr>
<td>Request URL</td>
<td>https://&lt;instance-name&gt;.service-now.com/api/sn_slack_ah_v2/</td>
</tr>
<tr>
<td></td>
<td>command_service/&lt;slack-app-name&gt;</td>
</tr>
<tr>
<td>Short Description</td>
<td>Description about the command.</td>
</tr>
<tr>
<td>Usage Hint</td>
<td>List of parameters than can be passed. For example,</td>
</tr>
<tr>
<td></td>
<td>[operation] [table].</td>
</tr>
</tbody>
</table>

For more information, see the Creating a Slash command step.

6. On the Interactivity & Shortcuts page:

   a. Enable **Interactivity** and specify the ServiceNow instance URL in **Request URL** in this format: https://<instance-name>.service-now.com/api/sn_slack_ah_v2/slack/<slack-app-name>/interactivepayload. For more information, see the Preparing your app for user interactions section.

   b. Create a shortcut that appears on messages and enter the value, post_message_now for **Callback ID**. For more information, see the Creating a shortcut section.

7. Create a Slack bot. Add the bot to your Slack app and required channels. For more information, see Create a bot for your workspace.

**Add Slack connection in ServiceNow instance**

Add the Slack connection in Flow Designer to configure the Slack spoke.

**Before you begin**

Role required: admin
Procedure
1. Navigate to **Flow Designer > Designer**.
2. Click **Connections**.

   Note: You can add multiple connections for your Slack spoke; one for each Slack workspace.
3. On the Slack spoke tile, click **View Details**.
4. In the Connections page, click **Configure**.
   The pop-up window displays a blank Configure Connection form.
5. On the form, fill these values.

   **Configure Connection form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection URL</td>
<td>URL to connect to Slack. Enter <a href="https://slack.com">https://slack.com</a>.</td>
</tr>
<tr>
<td>Credential Name</td>
<td>Name to identify the credential record. For example, Slack Cred.</td>
</tr>
<tr>
<td>OAuth Name</td>
<td>Name to identify the OAuth record. For example, Slack OAuth.</td>
</tr>
<tr>
<td>OAuth Client ID</td>
<td>Client ID of your Slack app.</td>
</tr>
<tr>
<td>OAuth Client Secret</td>
<td>Client Secret of your Slack app.</td>
</tr>
<tr>
<td>OAuth Redirect URL</td>
<td>Redirect URL provided in your Slack app. This value is auto-populated.</td>
</tr>
</tbody>
</table>

6. Click **Configure and Get OAuth Token**.
7. In the pop-up window, click **Allow**.
   The OAuth Access token is generated for the Slack spoke.

**Provide Signing Key in ServiceNow instance**

Provide Slack app details and Signing Key in your ServiceNow instance for authenticating requests from ServiceNow.

**Before you begin**

Role required: admin
Procedure

1. Navigate to Slack > Slack Configurations.
2. Open the default record. You can also create new record to provide other signing keys.
3. On the form, fill these values.

<table>
<thead>
<tr>
<th>Slack Configuration form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Slack App</td>
</tr>
<tr>
<td>Connection Alias</td>
</tr>
<tr>
<td>Property Name</td>
</tr>
<tr>
<td>Client Secret</td>
</tr>
</tbody>
</table>

4. Click Update.

Configure outbound configurations in ServiceNow instance

Specify events in ServiceNow instance for which actions must be performed on your Slack spoke application.

Before you begin

Role required: admin

About this task

The outbound configurations provide a template to the Post Actionable Message and Post Approval Message actions and subflows. You can customise the default outbound configurations or create outbound configuration as per your requirement.

Procedure

1. Navigate to Slack > Outbound Configurations.
2. Click New to create a outbound configuration template or click the default outbound configuration to configure it.
3. On the Outbound Configuration form, fill these values.
Outbound Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to identify the outbound configuration record.</td>
</tr>
<tr>
<td>Message Title</td>
<td>Title of message that is posted in the Slack spoke channel. For example, Pending approvals for {0}.</td>
</tr>
<tr>
<td>Target Table</td>
<td>ServiceNow table from which the record details are retrieved.</td>
</tr>
<tr>
<td>Fields</td>
<td>Fields from the ServiceNow table whose values must be displayed in the message that is posted in the Slack spoke channel.</td>
</tr>
<tr>
<td>Buttons</td>
<td>Buttons for the relevant users to take action in the Slack spoke channel. For example, Approve or Reject a request. For more information about buttons and their styling, see Button element.</td>
</tr>
</tbody>
</table>

⚠️ Note: Users must have the required permissions to perform the necessary actions. For example, user must have the required permissions to approve or reject a request. These permissions are based on user roles assigned to users in your ServiceNow instance.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choice List</td>
<td>Slack outbound choices such as, Reject. These options are displayed as a list in the Slack channel.</td>
</tr>
<tr>
<td>Action ID</td>
<td>Unique identifier of the outbound configuration.</td>
</tr>
</tbody>
</table>

⚠️ Note: Action ID of the outbound configuration must be used in the relevant inbound decision to complete the flow. For example, Action ID of the Approval Message outbound configuration is provided in the Approval Decision inbound decision. This ensures that upon the request approval or rejection, update is made to the relevant record in your ServiceNow instance.

4. Click Submit.

Configure inbound decisions in ServiceNow instance

Specify events in your Slack spoke application for which actions must be performed in ServiceNow instance.

Before you begin
Role required: admin
Procedure

1. Navigate to Slack > Inbound Decisions.
2. Click New.
4. On the Decision form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Name to identify the inbound decision.</td>
</tr>
<tr>
<td>Answer</td>
<td>Subflow that must be triggered when the specified conditions are met.</td>
</tr>
<tr>
<td>Default Answer</td>
<td>Option to specify if this is the default answer. The default answer is applicable when the conditions are not met.</td>
</tr>
<tr>
<td>a.</td>
<td>Click the lookup icon (🔍).</td>
</tr>
<tr>
<td>b.</td>
<td>Select the required subflow from the Document list.</td>
</tr>
</tbody>
</table>

**Note:** Ensure that the Table name is Flow [sys_hub_flow].

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Conditions to be met in your Slack application for which actions must be performed in ServiceNow instance. For updating relevant record in your ServiceNow instance, specify the Action ID value you had provided while configuring outbound configurations in the condition.</td>
</tr>
</tbody>
</table>

**Note:** Action ID of the outbound configuration must be used in the relevant inbound decision to complete the flow. For example, Action ID of the Approval Message outbound configuration is provided in the Approval Decision inbound decision. This ensures that upon the request approval or rejection, update is made to the relevant record in your ServiceNow instance.

5. Click Submit.

When events meet conditions specified in the policy, the associated subflow is triggered.
Note: These inbound decisions are saved in the Decision tables. Users are cautioned against directly updating or modifying data in these tables.

If you want to display modals in Slack, see Configure Slack modals in ServiceNow instance.

Configure Slack modals in ServiceNow instance
Create modal and specify fields that should be displayed in your Slack modal. Modal UI can be generated in two ways: automatically using a ServiceNow table and manually using a custom View Payload.

Before you begin
Role required: admin

About this task
For example, if you want to create incident using modal in Slack, the Create Incident modal requires Priority, Category, and Short Description fields.

Note: Modals can be triggered from these interactive Slack components:
- Command,
- Block action,
- Global shortcut, and
- Message shortcut.

Procedure
1. To create a modal with UI that is automatically generated using a ServiceNow table:

a. Navigate to Slack > Slack Modal Configuration.

b. Click New.

   c. On the Slack Modal Configuration form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to identify the record. For example, Modal to create incident.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Modal Title</td>
<td>Modal title that is displayed on Slack. For example, Create Incident.</td>
</tr>
<tr>
<td>Table</td>
<td>ServiceNow table corresponding to the modal fields. For example, Incident [incident].</td>
</tr>
<tr>
<td>Custom Modal</td>
<td>Option to configure a custom modal. Do not select this check box.</td>
</tr>
<tr>
<td>Input Fields</td>
<td>Inputs fields that should be displayed on Slack. For example, select Priority, Category, and Short Description. Ensure that these modal fields correspond to the selected ServiceNow table. For example, you can't display task related fields on a modal that creates an incident.</td>
</tr>
<tr>
<td>Note: Only the string, date, and choice field types are supported.</td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the record.</td>
</tr>
<tr>
<td>Script Validation</td>
<td>Script to validate inputs provided by the user in the modal. To validate the user-provided inputs, ensure that you are aware of the format in which values are retrieved from the modal and parse the response from Slack. The sample payload when user provides values for the Priority, Category, and Short Description fields in the Create Incident modal is:</td>
</tr>
<tr>
<td></td>
<td>{&quot;priority&quot;:{&quot;4gk&quot;:{&quot;type&quot;:&quot;static_select&quot;,&quot;selected_option&quot;:{&quot;text&quot;:{&quot;text&quot;:&quot;1 - Critical&quot;,&quot;emoji&quot;:true},&quot;value&quot;:&quot;1&quot;}}},&quot;category&quot;:{&quot;iV7&quot;:{&quot;type&quot;:&quot;static_select&quot;,&quot;selected_option&quot;:{&quot;text&quot;:{&quot;text&quot;:&quot;Software&quot;,&quot;emoji&quot;:true},&quot;value&quot;:&quot;software&quot;}}},&quot;short_description&quot;:{&quot;XS/Q-&quot;:{&quot;type&quot;:&quot;plain_text_input&quot;,&quot;value&quot;:&quot;hemanth&quot;}}}</td>
</tr>
<tr>
<td></td>
<td>To display validation errors in the modal, configure the script to return an object keys, status, and errorObject. errorObject should have a value of object that will be displayed on Slack. The object should have response_action and error. Also, configure the script to return an object with keys of status and statusMessage when there are no</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>validation errors. statusMessage is optional and you can configure it as per your requirement.</td>
</tr>
</tbody>
</table>

```javascript
var data = JSON.parse(payload);
var key = object.keys(data.short_description);
var shortdesc = data.short_description[key[0]].value;
var result = new Object();
if (shortdesc.length > 10) {
  var obj = {
    response_action: "errors",
    errors: {
      short_description: "You have reached your maximum limit of characters allowed"
    }
  };
  result = {
    status: "error",
    errorObject: obj
  };
  return result;
}
else {
  result = {
    status: "success",
    statusMessage: "Request submitted successfully."
  };
  return result;
}
```

**d.** Right-click the form header and click **Save**. The Create Incident modal is created in Slack.

![Create Incident modal in Slack](image)

**2.** To create a modal with UI that is manually generated using a custom View Payload:

**a.** Navigate to **Slack > Slack Modal Configuration**.

**b.** Click **New**.
c. On the Slack Modal Configuration form, fill these values.

**Slack Modal Configuration form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to identify the record. For example, <em>Modal to create incident</em>.</td>
</tr>
<tr>
<td>Custom Modal</td>
<td>Option to configure a custom modal. Select this check box.</td>
</tr>
<tr>
<td>View Payload</td>
<td>Payload generated by Slack Block Kit Builder that defines the modal UI. For more information, see <a href="https://www.service-now.com/builder/">Block Kit</a> and <a href="https://www.service-now.com/builder/build-modal.html">Building with Block Kit</a>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the record.</td>
</tr>
</tbody>
</table>
| Script Validation | Script to validate inputs provided by the user in the modal. To validate the user-provided inputs, ensure that you are aware of the format in which values are retrieved from the modal and parse the response from Slack. The sample payload when user provides values for the *Priority*, *Category*, and *Short Description* fields in the Create Incident modal is:  

```json
{"priority": {"4gk": {"type": "static_select", "selected_option": {"text": {"type": "plain_text", "text": "1 - Critical"}, "emoji": true}, "value": "1"}}, "category": {"iV7": {"type": "static_select", "selected_option": {"text": {"type": "plain_text", "text": "Software"}, "emoji": true}, "value": "software"}}, "short_description": {"XS/Q": {"type": "plain_text_input", "value": "hemanth"}}}
```

To display validation errors in the modal, configure the script to return an object keys, status, and errorObject. errorObject should have a value of object that will be displayed on Slack. The object should have response_action and error.

Also, configure the script to return an object with keys of status and statusMessage when there are no validation errors. statusMessage is optional and you can configure it as per your requirement.
d. Right-click the form header and click **Save**.  
The Create Incident modal is created in Slack.

3. Specify conditions to define when the modals should be displayed:

   a. Select **Slack Inbound Policy For Modals**.

   b. On the Decision form, fill these values.

```
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Name to identify the inbound modal decision.</td>
</tr>
<tr>
<td>Answer</td>
<td>Modal that must be displayed when the specified conditions are met. Ensure that you select the required record from the Slack Modal Configuration [sn_slack_ah_v2_slack_modal_configuration] table.</td>
</tr>
<tr>
<td>Default</td>
<td>Option to specify if this is the default modal. The default modal is applicable when the conditions are not met.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions to be met in your Slack application to display the modal.</td>
</tr>
</tbody>
</table>
```
Note:

- Copy and record the value of sys_id. You can use this sys_id as the unique value in **Callback ID** while configuring the shortcut or message shortcut in your Slack app.

To display modals for the required shortcut, in **Condition**, provide the sys_id of the modal's inbound policy record.

- To display modals for the required Slack commands, in **Condition**, provide the required command for which the modal should be displayed.
c. Click Submit.
   When events in Slack meet conditions specified in the policy, the associated modal is displayed.

   ![Note:](image) These inbound decisions are saved in the Decision tables. Users are cautioned against directly updating or modifying data in these tables.

4. Specify tasks to be performed when user provides values in the modals by creating an inbound policy:

   a. Navigate to Slack > Inbound Decisions.

   b. Click New.

   c. Select Slack Inbound Policy For Subflows.

   d. On the Decision form, fill these values.

### Decision form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Name to identify the inbound decision.</td>
</tr>
<tr>
<td>Answer</td>
<td>Subflow that must be triggered when the specified conditions are met.</td>
</tr>
<tr>
<td>Default Answer</td>
<td>Option to specify if this is the default answer. The default answer is applicable:</td>
</tr>
<tr>
<td>i.</td>
<td>Click the lookup icon (🔍).</td>
</tr>
<tr>
<td>ii.</td>
<td>Select the required subflow from the Document list.</td>
</tr>
</tbody>
</table>

   ![Note:](image) Ensure that the Table name is `Flow [sys_hub_flow]`. Ensure that you have configured the subflow to process the response payload.

| Condition      | Conditions to be met to perform tasks in ServiceNow instance. Specify the modal record in the condition. |
### Automate and customize Slack tasks

Automate Slack tasks as per your requirement, using the sample these scenarios as a reference.

You can use the default outbound configurations, inbound decisions, and subflows as reference to customize tasks as per your requirement.

#### Example: Automate Slack commands

Perform these steps to automate events such as, create incident records, based on the Slack commands:

1. Configure the Slack commands on the Slash Commands page of your custom application. For more information, see Configure Slack app.

2. In Flow Designer, create a subflow configure to create the incident records as per your requirement or create a copy of the default subflow, Respond to Slack Command, and configure it.

   - **Note:** Create an action and use the payload in the subflow input as per your requirement.
3. Configure inbound decisions in ServiceNow instance.

   a. In the **Condition**, ensure that you specify the value of **command** as `/now` and specify the required parameters.

   🔄 **Note**: You can specify up to 2 parameters in your condition to trigger the required subflow.

   ![Decision condition diagram]

   b. In **Answer**, select the subflow you had configured.

   When a Slack user enters the command, `/now create incident <text>`, the condition specified in inbound decision is met and the associated subflow is triggered. Similarly, you can customize subflows and inbound decisions to configure more Slack commands such as:

   - `/now list incidents` to list all active incidents assigned to the logged in user.
   - `/now help` to display all available commands and their describe usage.
   - `/now note [note]` to add notes to the required incident.
   - `/now create incident [short description] > [optional: urgency] > [optional: impact]` to create an incident with specified short description, urgency, and impact. For example, `/now create incident Email is not working > 3 > 2`.

**Example: Automate message actions**

1. In your Slack custom application, create a shortcut that appears on messages and enter the value, `post_message_now` for **Callback ID**. For more information, see Configure Slack app.

2. In Flow Designer, create a subflow configure to create the incident records as per your requirement or create a copy of the default subflow, Respond to Slack Message Action, and configure it.
Note: Create an action and use the payload in the subflow input as per your requirement.

3. Configure inbound decisions in ServiceNow instance.
   a. In the Condition, ensure that you specify the value of **callback_id** as **post_message_now** and specify the required parameters.

   ![Condition Image]

   b. In **Answer**, select the subflow you had configured.

**Example: Post an approval message**
Perform these steps to automate posting an approval message on a Slack channel.

1. In Flow Designer, create a copy of the default subflow, Respond to Slack Approval Action, and configure it as per your requirement.
   
   Note: Create an action and use the payload in the subflow input as per your requirement.

2. Configure outbound configurations in ServiceNow instance.
   a. Open the default outbound configuration, **Approval Message**.
   b. In **Action ID**, specify the unique identifier for automating the task of posting an acknowledgement message. For example, value of **Action ID** can be **approval_request**.

3. Configure inbound decisions in ServiceNow instance.
a. In the **Condition**, ensure that you specify the value of **Action ID** as `approval_request`. You can specify other conditions as per your requirement.

b. In **Answer**, select the subflow you had configured.

When the Slack events match the relevant the action ID, the associated subflow, that is, the Respond to Slack Approval Action subflow is triggered. This subflow contains the logic to update the required record and send the relevant acknowledgement message on Slack channel.

**Example:** **Assign request based on acknowledgement**

Perform these steps to automate assigning request:

1. In Flow Designer, create a copy of the default subflow, On-Call Assign by Acknowledgement, and configure it as per your requirement.

   **Note:** Create an action and use the payload in the subflow input as per your requirement.

2. **Configure outbound configurations in ServiceNow instance.**
   
   a. Open the default outbound configuration, **On Call: Assign by Acknowledgement**.
   
   b. In **Action ID**, specify the unique identifier for automating the task of posting an acknowledgement message. For example, value of **Action ID** can be `on_call_assign_by_acknowledgement`.

3. **Configure inbound decisions in ServiceNow instance.**
   
   a. In the **Condition**, ensure that you specify the value of **Action ID** as `on_call_assign_by_acknowledgement`. You can specify other conditions as per your requirement.
   
   b. In **Answer**, select the subflow you had configured.

**Example:** **Post an actionable message**

Perform these steps to automate posting an actionable message:
1. Configure outbound configurations in ServiceNow instance.
   a. Open the default outbound configuration, **On Call: Assign by Acknowledgement**.
   b. Select **Target Table** and **Fields** as per your requirement. For example, `short_description` and `priority` from the `Task [task]` table.
   c. Select **Buttons** as per your requirement. For example, **Accept** and **Reject**.
   d. In **Action ID**, specify the unique identifier for automating the task of posting an acknowledgement message. For example, value of **Action ID** can be `on_call_assign_by_acknowledgement`.

2. In Flow Designer, create a copy of the default subflow, Post Actionable Message, and configure it as per your requirement.

   - **Note:** Create an action and use the payload in the subflow input as per your requirement.

   a. In the **Record Sys.ID** input, provide the sys ID of the required record. For example, specify the sys ID of the task record.
   b. In the **Template** input, select template you had created in the outbound configurations.

3. Configure inbound decisions in ServiceNow instance.
   a. In the **Condition**, ensure that you specify the value of **Action ID** as `on_call_assign_by_acknowledgement`. You can specify other conditions as per your requirement.
   b. In **Answer**, select the subflow you had configured.

**Smartsheet spoke**

The Smartsheet spoke provides actions to view and analyze Smartsheet software subscriptions.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.
**Supported versions**

This spoke was built for Smartsheet v1.0.1, but may be compatible with later versions.

**Spoke requirements**

• Smartsheet admin account

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

⚠️ **Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke subflows**

The Smartsheet spoke provides sample subflows to demonstrate automating Smartsheet tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smartsheet Download Subscriptions</td>
<td>Downloads user subscriptions from the Smartsheet portal.</td>
</tr>
<tr>
<td></td>
<td>To use this subflow, perform the steps outlined in Integrating with Smartsheet.</td>
</tr>
<tr>
<td>Smartsheet Update User Activity</td>
<td>Retrieves Smartsheet user activity.</td>
</tr>
<tr>
<td></td>
<td>To use this subflow, perform the steps outlined in Integrating with Smartsheet.</td>
</tr>
<tr>
<td>Smartsheet Reclaim Subscription</td>
<td>Deactivates user accounts in Smartsheet.</td>
</tr>
<tr>
<td></td>
<td>To use this subflow, perform the steps outlined in Integrating with Smartsheet.</td>
</tr>
</tbody>
</table>
Spoke actions

The Smartsheet spoke provides actions to automate Smartsheet tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Management</td>
<td>Check Event Reporting</td>
<td>Checks whether you have the Event Reporting add-on in Smartsheet. To use this action, perform the steps outlined in Integrating with Smartsheet.</td>
</tr>
<tr>
<td></td>
<td>Get Admin User</td>
<td>Retrieves the admin user that generated the Smartsheet API access token. To use this action, perform the steps outlined in Integrating with Smartsheet.</td>
</tr>
<tr>
<td></td>
<td>Get User Activity</td>
<td>Retrieves meaningful Smartsheet user activity. To use this action, perform the steps outlined in Integrating with Smartsheet.</td>
</tr>
<tr>
<td></td>
<td>Look Up Users</td>
<td>Retrieves all Smartsheet user subscriptions. To use this action, perform the steps outlined in Integrating with Smartsheet.</td>
</tr>
<tr>
<td></td>
<td>Remove User</td>
<td>Deactivates a user account in Smartsheet. To use this action, perform the steps outlined in Integrating with Smartsheet.</td>
</tr>
</tbody>
</table>

Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

SurveyMonkey spoke v2.0.2

Manage surveys, responses, collectors, and so on in the SurveyMonkey account from your ServiceNow instance.
Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

Supported versions

This spoke was built for SurveyMonkey API version v3, but may be compatible with later versions.

Spoke requirements

Admin access to SurveyMonkey API Developer Portal.

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions

The SurveyMonkey spoke provides actions to automate SurveyMonkey tasks when events occurs in your ServiceNow instance. Available actions include:
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collector Management</td>
<td>Create Collector</td>
<td>Creates a collector for the given survey. Public app users need access to the Create/Modify Collectors scope.</td>
</tr>
<tr>
<td></td>
<td>Delete Collector</td>
<td>Deletes the specified collector. Public app users need access to the Create/Modify Collectors scope.</td>
</tr>
<tr>
<td></td>
<td>Get Collector Details</td>
<td>Retrieves details of the specified collector. Public app users need access to the View Collectors scope.</td>
</tr>
<tr>
<td></td>
<td>Look up Collectors Stream</td>
<td>Retrieves details of collectors in the specified survey.</td>
</tr>
<tr>
<td>Contact Management</td>
<td>Add Contacts to Contact List</td>
<td>Creates multiple contacts in a contact list. Public app users need access to the Create/Modify Contacts scope.</td>
</tr>
<tr>
<td></td>
<td>Create Contact List</td>
<td>Creates a contact list. Public app users need access to the Create/Modify Contacts scope.</td>
</tr>
<tr>
<td></td>
<td>Delete Contact List</td>
<td>Deletes the specified contact list. Public app users need access to the Create/Modify Contacts scope.</td>
</tr>
<tr>
<td></td>
<td>Look up Contact Lists</td>
<td>Retrieves all contact lists. Public app users need access to the View Contacts scope.</td>
</tr>
<tr>
<td></td>
<td>Look up Contacts in Contact List</td>
<td>Retrieves all contacts in a contact list. Public app users need access to the View Contacts scope.</td>
</tr>
<tr>
<td></td>
<td>Update Contact List</td>
<td>Modifies a contact list. Public app users need access to the Create/Modify Contacts scope.</td>
</tr>
<tr>
<td>Folder Management</td>
<td>Create Folder</td>
<td>Creates a folder.</td>
</tr>
<tr>
<td></td>
<td>Look up Folders</td>
<td>Retrieves the available folders.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Response Management</td>
<td>Look up Survey Responses</td>
<td>Retrieves a list of responses. Public app users need access to the View Responses scope.</td>
</tr>
<tr>
<td></td>
<td>Look up Survey Trends</td>
<td>Retrieves the answer counts within the specified time period. Public app users need access to the View Response Details scope.</td>
</tr>
<tr>
<td>Survey and Question Management</td>
<td>Create Question</td>
<td>Creates a question on the survey page. Public app users need access to the Create/Modify Surveys scope.</td>
</tr>
<tr>
<td></td>
<td>Create Survey</td>
<td>Creates an empty survey. Public app users need access to the Create/Modify Surveys scope.</td>
</tr>
<tr>
<td></td>
<td>Delete Question</td>
<td>Deletes the specified question. Public app users need access to the Create/Modify Surveys scope.</td>
</tr>
<tr>
<td></td>
<td>Delete Survey</td>
<td>Deletes the specified survey. Public app users need access to the Create/Modify Surveys scope.</td>
</tr>
<tr>
<td></td>
<td>Get Survey Details</td>
<td>Retrieves a list of full responses, including answers to all questions. Public app users need access to the View Response Details scope.</td>
</tr>
<tr>
<td></td>
<td>Look up Questions</td>
<td>Retrieves all questions in the specified survey.</td>
</tr>
<tr>
<td></td>
<td>Look up Survey Pages</td>
<td>Retrieves details of the page. Public app users need access to the View Surveys scope.</td>
</tr>
<tr>
<td></td>
<td>Look up Surveys</td>
<td>Retrieves a list of surveys owned by or shared with the authenticated user. Public app users need access to the View Surveys scope.</td>
</tr>
<tr>
<td></td>
<td>Update Question</td>
<td>Updates details of the specified question. Public app users need access to the Create/Modify Surveys scope.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Update Survey</td>
<td>Modifies title, nickname, or language of the specified survey. Public app users need access to the Create/Modify Surveys scope.</td>
</tr>
<tr>
<td>Team Management</td>
<td>Look up Team Activity Stream</td>
<td>Retrieves activity data for the specified team.</td>
</tr>
<tr>
<td></td>
<td>Look up Team Member Details</td>
<td>Retrieves details of the specified team member.</td>
</tr>
<tr>
<td></td>
<td>Look up Team Members Stream</td>
<td>Retrieves details of all members in the specified team.</td>
</tr>
<tr>
<td></td>
<td>Look up Teams Stream</td>
<td>Retrieves details of all teams that the authenticated user account belongs to.</td>
</tr>
<tr>
<td>User Management</td>
<td>Get User Details</td>
<td>Retrieves the current user’s account details including their plan. Public app users need access to the View Users scope.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

**Set up the SurveyMonkey spoke**

Integrate the ServiceNow instance and SurveyMonkey account by creating a custom OAuth application in SurveyMonkey API Developer Portal to authenticate ServiceNow requests.

**Before you begin**

Role required: admin
Procedure

1. Log in to SurveyMonkey API Developer Portal as an admin and add an app.
   a. In OAuth Redirect URL, enter the ServiceNow instance URL in this format:
   b. Copy and record the values of Client ID and Secret.
   c. Provide these scopes for the app:
      • Create/Modify Surveys
      • Create/Modify Collectors
      • Create/Modify Responses
      • View Response Details
      • View Contacts
      • Create/Modify Webhooks
      • View Library Assets
      • View Surveys
      • View Collectors
      • View Responses
      • Create/Modify Contacts
      • View Users
      • View Webhook

   i Note: If you provide any additional scopes, ensure that you add these scopes in the OAuth Entity Scopes tab of the default application registry available in your ServiceNow instance.

2. Configure the default application registry.
   a. Navigate to System OAuth > Application Registry.
   b. Open the record, Survey Monkey.
   c. On the form, fill these values:
### Field | Description
--- | ---
Client ID | Client ID of the app created in SurveyMonkey API Developer Portal.
Client Secret | Secret of the app created in SurveyMonkey API Developer Portal.
Redirect URL | ServiceNow instance URL in this format: https://<instance-name>.service-now.com/oauth_redirect.do. Replace <instance-name> with your instance name.

⚠ **Note:** If you have provided additional scopes, create records for those scopes in the OAuth Entity Scopes tab.

3. **Create a credential record.**

   a. **Navigate to Connections & Credentials > Credentials.**
   
   b. **Click New.**
   
      The system displays the message *What type of Credentials would you like to create?*.
   
   c. **Select OAuth 2.0 Credentials.**
   
   d. **On the form, fill in the fields.**

### Field | Value required
--- | ---
Name | Name to uniquely identify the record. Enter SurveyMonkey Credentials.
Active | Option to actively use the credential record.
OAuth Entity Profile | OAuth profile you created when you registered the SurveyMonkey app as an OAuth provider. Select Survey Monkey default_profile.
Applies to | MID Servers that can use this credential. Select All MID Servers.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Order to apply this credential. Enter 100.</td>
</tr>
</tbody>
</table>

4. Create a connection record.


   b. Open for the record for SurveyMonkey.

   c. From the Connections tab, click New.

   The system displays a blank HTTP(s) Connection form.

   d. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. Enter SurveyMonkey Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Zoom. Select SurveyMonkey Credentials.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to your SurveyMonkey account. Enter <a href="https://api.surveymonkey.net">https://api.surveymonkey.net</a>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

e. Optional: In the Attributes tab, the default value of API Version is v3. If you are using different SurveyMonkey API version, specify the version number.

f. Click Submit.

The ServiceNow instance and SurveyMonkey account are integrated.
Trello spoke

Manage Trello Enterprise subscriptions using your ServiceNow instance. Analyze data usage for Trello enterprise and reclaim idle subscriptions.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Spoke requirements

- Trello Enterprise admin access
- Ensure that your Trello subscription is linked to Atlassian account.
- Ensure that your authorized account has both Trello Enterprise admin and Atlassian account admin access.

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

⚠ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions

The Trello provides actions to automate Trello tasks when events occur in your ServiceNow instance. Available actions include:
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Management</td>
<td>Look up Enterprise ID</td>
<td>Retrieves the organization ID of the authenticated user account.</td>
</tr>
<tr>
<td></td>
<td>Look up Enterprise Members Stream</td>
<td>Retrieves details of all members in an enterprise organization.</td>
</tr>
<tr>
<td></td>
<td>Update Enterprise Member’s Active Status</td>
<td>Updates the active status of the specified member in an enterprise.</td>
</tr>
<tr>
<td></td>
<td>Update Enterprise Member’s License Status</td>
<td>Updates whether the provided member should use one of the enterprise’s available licenses or not.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

**Generate Trello API key and token**

Generate a Trello API key and token to get access to the Trello portal.

**Before you begin**

Trello role required: admin

Ensure that you have a managed user account and Atlassian admin access.

**Procedure**

1. Go to [Trello](#).
2. Log in as an enterprise admin.
3. Go to [Developer API Keys](#).
4. Click **Show API Key**.
   - The Developer API key shows an API key.
5. Copy the API key from the Developer API key.
6. In the following link, replace `{YourAPIKey}` with the API key that you copied in the last step and open the link.
https://trello.com/1/authorize?
expiration=never&scope=read,write,account&response_type=token&name=ServerToken&key={YourAPIKey}
For example, if your API key is 123xyz, then open
the following link- https://trello.com/1/authorize?
expiration=never&scope=read,write,account&response_type=token&name=ServerToken&key=123xyz
MyPersonalToken page appears and asks if you want to give access to your account.

7. Click Allow.
An API token is generated. Copy this API token and store it securely.

Set up your ServiceNow instance for Trello
Set up your ServiceNow instance to add the Trello API key and API token.

Before you begin
ServiceNow role required: admin

Procedure
1. Log in to your ServiceNow instance.
The Connection & Credentials Aliases page appears and shows the list of apps.
3. Locate and open the Connection & Credentials record for Trello.
The Trello Connection & Credentials Aliases form appears.
The Trello Credentials form appears.
5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Trello Credentials form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Any name of your choice. For example, Trello integration.</td>
</tr>
<tr>
<td>API Key</td>
<td>The API Key that you copied from the Trello portal.</td>
</tr>
<tr>
<td>API Token</td>
<td>The API token that you copied from the Trello portal.</td>
</tr>
</tbody>
</table>
6. Click Submit.
Twilio spoke v1.1.2

Use the Twilio spoke to send SMS, make voice calls, create conference calls, manage calls, manage short codes, notify services, and messaging services.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Supported versions

This spoke was built for Twilio Base version 2010-04-01, Twilio Messaging version v1, and Twilio Notify version v1, but may be compatible with later versions.

Spoke requirements

- Twilio account.
- **AccountSid** and **AuthToken** of the account to create a Basic Auth credential.
- Activate these plugins:
  - ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
  - ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
  - ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

See Twilio documentation for instructions on creating an account.

Spoke actions

The Twilio spoke provides actions to automate sending SMS, making voice calls, and creating conference calls when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Management</td>
<td>Create Application</td>
<td>Creates an application resource in a Twilio account.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Delete Application</td>
<td>Deletes an application resource from a Twilio account.</td>
</tr>
<tr>
<td></td>
<td>Get Application</td>
<td>Retrieves the required application resource.</td>
</tr>
<tr>
<td></td>
<td>Look Up Accounts</td>
<td>Retrieves the account resources in a Twilio account. The list includes the account and its sub-account resources.</td>
</tr>
<tr>
<td></td>
<td>Look Up Applications</td>
<td>Retrieves the application resources in a Twilio account.</td>
</tr>
<tr>
<td></td>
<td>Update Application</td>
<td>Updates properties of an application resource in a Twilio account.</td>
</tr>
<tr>
<td>Call Management</td>
<td>Dequeue Call</td>
<td>Removes a call from a queue.</td>
</tr>
<tr>
<td></td>
<td>Get Call</td>
<td>Retrieves the required call resource.</td>
</tr>
<tr>
<td></td>
<td>Get Incoming Phone Number</td>
<td>Retrieves the incoming phone number resource.</td>
</tr>
<tr>
<td></td>
<td>Hang Up Call</td>
<td>Ends a call in progress.</td>
</tr>
<tr>
<td></td>
<td>Look Up Incoming Phone Numbers</td>
<td>Retrieves the incoming phone number resources in a Twilio account.</td>
</tr>
<tr>
<td></td>
<td>Make a Call With Recording</td>
<td>Places a call to a phone number and records the call.</td>
</tr>
<tr>
<td></td>
<td>Make a Call Without Recording</td>
<td>Places a call to a phone number and doesn't record the call.</td>
</tr>
<tr>
<td></td>
<td>Modify Call</td>
<td>Modifies a call in progress.</td>
</tr>
<tr>
<td></td>
<td>Mute Or Unmute Participant</td>
<td>Mutes or unmutes a participant resource in a conference call.</td>
</tr>
<tr>
<td></td>
<td>Remove Participant From Call</td>
<td>Removes a participant resource from a conference call.</td>
</tr>
<tr>
<td></td>
<td>Update Incoming Phone Number</td>
<td>Updates properties of an incoming phone number resource in a Twilio account.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Messaging Service</td>
<td>Add Phone Number To Messaging Service</td>
<td>Adds a phone number resource to the messaging service.</td>
</tr>
<tr>
<td>Management</td>
<td>Add Short Code To Messaging Service</td>
<td>Adds a short code resource to the messaging service.</td>
</tr>
<tr>
<td></td>
<td>Create Messaging Service</td>
<td>Creates a new messaging service resource in a Twilio account.</td>
</tr>
<tr>
<td></td>
<td>Delete Messaging Service</td>
<td>Deletes a messaging service resource from a Twilio account.</td>
</tr>
<tr>
<td></td>
<td>Look Up Messaging Service Phone Numbers</td>
<td>Retrieves the phone number resources in a messaging service.</td>
</tr>
<tr>
<td></td>
<td>Look Up Messaging Service Short Codes</td>
<td>Retrieves the short code resources associated with a messaging service.</td>
</tr>
<tr>
<td></td>
<td>Look Up Messaging Services</td>
<td>Retrieves the messaging service resources in a Twilio account.</td>
</tr>
<tr>
<td></td>
<td>Remove Phone Number From Messaging Service</td>
<td>Removes a phone number resource from a messaging service.</td>
</tr>
<tr>
<td></td>
<td>Remove Short Code From Messaging Service</td>
<td>Removes a short code resource from a messaging service.</td>
</tr>
<tr>
<td>Notification Service</td>
<td>Create Notify Service</td>
<td>Creates a new notify service resource in a Twilio account.</td>
</tr>
<tr>
<td>Management</td>
<td>Delete Notify Service</td>
<td>Deletes a notify service resource from Twilio account.</td>
</tr>
<tr>
<td></td>
<td>Look Up Notify Services</td>
<td>Retrieves the notify service resources in a Twilio account.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Short Code Management</td>
<td>Get Short Code</td>
<td>Retrieves a short code resource.</td>
</tr>
<tr>
<td></td>
<td>Look Up Short Codes</td>
<td>Retrieves the short code resources of a Twilio account.</td>
</tr>
<tr>
<td></td>
<td>Reset Short Code</td>
<td>Resets the short code resource.</td>
</tr>
<tr>
<td></td>
<td>Update Short Code</td>
<td>Updates properties of a short code resource in a Twilio account.</td>
</tr>
<tr>
<td>Text Messaging</td>
<td>Send Bulk SMS</td>
<td>Sends an SMS to multiple phone numbers.</td>
</tr>
<tr>
<td></td>
<td>Send SMS</td>
<td>Sends an SMS to a phone number.</td>
</tr>
</tbody>
</table>

⚠️ **Note:** To receive information about Status Callbacks, you must configure webhooks in Twilio. See [Twilio documentation](https://www.twilio.com/docs/sms) for instructions on creating and configuring webhooks.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](https://service.now.com/docs/).  

⚠️ **Note:** Three connection and credential alias records are needed for the Twilio spoke; one each for Twilio Base, Twilio Notify, and Twilio Messaging. Each alias should be associated with the respective Twilio API.

**Set up Twilio spoke**

Integrate the ServiceNow instance and Twilio using basic authentication to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription
- Activate Twilio spoke
- Role required: admin

**Create Credential records for the Twilio spoke**

Create Credential records to the Twilio server. The Twilio spoke connection and credential alias uses these credentials to authorize actions.
**About this task**
Create three credential records for the Twilio spoke; one each for Twilio Base, Twilio Notify, and Twilio Messaging. Each credential should be associated with the respective Twilio API.

**Procedure**
1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
   The system displays the message *What type of Credentials would you like to create?*
3. Select **Basic Auth Credentials**.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter Twilio Base, Twilio Notify, or Twilio Messaging.</td>
</tr>
<tr>
<td>User name</td>
<td>Twilio Account SID.</td>
</tr>
<tr>
<td>Password</td>
<td>Twilio AuthToken.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Results**
The three required credential records are created for Twilio Base, Twilio Notify, and Twilio Messaging.

**Create Connection records for the Twilio spoke**
Create Connection records to your Twilio account. The Twilio spoke connection and credential alias uses these connections to perform actions on Twilio.

**About this task**
Create three connection records for the Twilio spoke; one each for Twilio Base, Twilio Notify, and Twilio Messaging. Each connection record should be associated with the respective Twilio API.
Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open record of the Twilio spoke.
3. From the Connections tab, click New.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter Twilio Base Connection, Twilio Notify Connection, or Twilio Messaging Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Twilio. For example, select Twilio Base for Twilio Base Connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Connection URL.</td>
</tr>
<tr>
<td></td>
<td>• If the connection record is for Twilio Base, enter <a href="https://api.twilio.com/">https://api.twilio.com/</a>.</td>
</tr>
<tr>
<td></td>
<td>• If the connection record is for Twilio Notify, enter <a href="https://notify.twilio.com/">https://notify.twilio.com/</a>.</td>
</tr>
<tr>
<td></td>
<td>• If the connection record is for Twilio Messaging, enter <a href="https://messaging.twilio.com/">https://messaging.twilio.com/</a>.</td>
</tr>
</tbody>
</table>

5. In the Attributes related list:
   • For the connection record of Twilio Base, enter Account SID.
   • Enter Page size.
   • Don't modify the default value of the Version.

6. Click Submit.

Results
The three connection records are created. The ServiceNow instance and Twilio are integrated.

Twitter spoke v1.1.1
Use the Twitter spoke to automatically tweet messages or media in your Twitter account from your ServiceNow instance.
Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.

⚠️ Note: This spoke is available to new customers as part of an IntegrationHub Professional subscription. Existing customers can use this spoke as part of an IntegrationHub Standard subscription.

Supported versions

API version v1.1.

Spoke requirements

• Twitter developer account
• Twitter developer app to access the Twitter APIs
• Access token and secret of your Twitter developer app
• Consumer key and secret from your Twitter developer app

See the Twitter Developers documentation for instructions on creating the developer application and gathering the required details.

Spoke actions

The Twitter spoke provides actions to automate tweeting when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tweet</td>
<td>Tweets a message or media. Messages and media are tweeted as per Twitter limits.</td>
</tr>
</tbody>
</table>

⚠️ Note: If you wish to tweet media, use the Look Up Attachment Records action before this action in your custom flow to retrieve the required media.
Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

Note: Two connection and credential alias records are needed for the Twitter spoke; one for tweeting messages and other for tweeting media. Each alias should be associated with the respective Twitter API.

Create Credential records for the Twitter spoke

Authorize the Twitter spoke actions by creating credential records for the application registered in the Twitter developer account. The Twitter spoke connection and credential alias uses these credentials to authorize actions.

About this task
You must create two credential records; one for tweeting messages and other for tweeting media.

Procedure

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message, What type of Credentials would you like to create?
3. Select Twitter Credentials.
4. On the form, fill in the fields.

Twitter Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, TwitterCredentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Consumer Key</td>
<td>Consumer key of your Twitter developer app.</td>
</tr>
<tr>
<td>Consumer Secret</td>
<td>Consumer secret of your Twitter developer app.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Access Token</td>
<td>Access token of your Twitter developer app.</td>
</tr>
<tr>
<td>Access Token Secret</td>
<td>Access token secret of your Twitter developer app.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias record associated with this credential.</td>
</tr>
</tbody>
</table>

**Note:**
- If the credential record is created for tweeting messages, select the credential alias that is associated with the Twitter messaging API.
- If the credential record is created for tweeting media, select the credential alias that is associated with the Twitter media API.

5. Right-click the form header and click **Save**.

**Results**
The credential record for the Twitter spoke is created.

**Create Connection records for the Twitter spoke**
Perform actions in Twitter by creating connection records for your Twitter account. The Twitter spoke connection and credential alias uses these connections to perform actions.

**About this task**
Two connection and credential alias records are available by default; one for tweeting messages and other for tweeting media. Perform these steps to associate each alias with the respective Twitter API.

**Procedure**
1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open the required Twitter spoke record.

    **Note:** There are two connection and credential records: **Twitter** and **Twitter_Media**. The **Twitter** record is for tweeting messages and **Twitter_Media** is for tweeting media.
3. In the Connections related list of the required record, click **New**.
4. On the form, fill in the fields.
HTTP(s) Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Twitter Base Or Twitter Media.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Twitter spoke. For example, Twitter.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td>Note: Do not select the check box.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Connection URL.</td>
</tr>
<tr>
<td></td>
<td>• If the connection record is for tweeting messages, enter <a href="https://api.twitter.com">https://api.twitter.com</a>.</td>
</tr>
<tr>
<td></td>
<td>• If the connection record is for tweeting media, enter <a href="https://upload.twitter.com">https://upload.twitter.com</a>.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Server. If the check box is selected, define the fields in the Advanced MID Server Configuration related list.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

5. Click **Update**.

**Results**
The Twitter spoke is set up and integrated with the ServiceNow instance.

**Udemy spoke**
Manage learnings, courses, and so on, in the Udemy instance from your ServiceNow instance.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Udemy API version v2, but may be compatible with later versions.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Udemy spoke provides actions to automate tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Look up Courses Stream</td>
<td>Retrieves details of the courses in Udemy.</td>
</tr>
<tr>
<td>Learning Management</td>
<td>Look up Course Synchronization Stream</td>
<td>Retrieves details of the required courses.</td>
</tr>
<tr>
<td></td>
<td>Look up Course Synchronization Token</td>
<td>Retrieves the synchronization token to fetch the next set of updated or created course.</td>
</tr>
</tbody>
</table>
### Category

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Look up User</td>
<td>Retrieves the course progress data.</td>
</tr>
<tr>
<td>Course Activity Stream</td>
<td></td>
</tr>
</tbody>
</table>

### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

### Set up the Udemy spoke

Integrate the ServiceNow instance and your Udemy instance using an API key to authenticate the ServiceNow requests.

### Before you begin

- Request IntegrationHub subscription.
- Activate the Udemy spoke.
- Admin access to the Udemy instance.
- Role required: admin
Procedure

1. Generate API key from your Udemy instance.

   a. Log in to your Udemy instance and obtain the values of **Client ID** and **Client Secret**.

   b. Provide the values of **Client ID** and **Client Secret** in `GET /api-2.0/organizations/{organization_id}/courses/list/`. 
The API key is generated and displayed in **Authorization**. Copy and record the value for later use.

2. Create a credential record for the Udemy spoke.

   a. Navigate to **Connections & Credentials > Credentials**.

   b. Click **New**.

   The system displays the message *What type of Credentials would you like to create?*.

   c. Select **API Key Credentials**.

   d. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the credential record. For example, Udemy Cred.</td>
</tr>
<tr>
<td>API Key</td>
<td>Value of the API key you created in the Udemy instance.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
</tbody>
</table>

**e. Click Submit.**

3. Create a connection record for the Udemy spoke.

**a. Navigate to Connections & Credentials > Connection & Credential Aliases.**

**b. Open the record for the Udemy spoke.**

**c. From the Connections tab, click New.**

**d. On the form, fill these values.**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, Udemy Conn.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for the Udemy spoke.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Connection URL to connect to your Udemy instance.</td>
</tr>
</tbody>
</table>

**e. Right-click the form header and click Save.**

**f. In the Attributes tab, fill these details.**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>domain_id</td>
<td>Domain ID of your Udemy instance.</td>
</tr>
<tr>
<td>domain_name</td>
<td>Domain name of your Udemy instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Udemy API version. The default value is, api-2.0.</td>
</tr>
</tbody>
</table>

**g. Right-click the form header and click Save.**
**UiPath spoke v2.0.1**

Automate business processes in UiPath from your ServiceNow® instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Supported version**

This spoke was built for these UiPath versions, but may be compatible with later versions.

- Platform version 2020.4.1
- Cloud Platform version 2020.4.3

**Spoke requirements**

Ensure that you have UiPath account information before you Set up the UiPath spoke.

- If you are using the UiPath Cloud Platform:
  - Token URL
  - Client Id
  - Account Logical Name
  - Tenant Logical Name
  - User Key
- If you are using the UiPath Platform installed on private or public cloud:
  - Tenant Name
  - Credentials to authenticate the UiPath Orchestrator API

See the UiPath documentation for more information about obtaining the required details.
Spoke actions
The UiPath spoke provides actions to manage environments, jobs, machines, processes, robots, and so on, when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environment Management</td>
<td>Get Environment By ID</td>
<td>Retrieves the details of the required environment.</td>
</tr>
<tr>
<td></td>
<td>Lookup Environments</td>
<td>Retrieves the details of the required environments. The environments are retrieved based on the filter query.</td>
</tr>
<tr>
<td>Job Management</td>
<td>Get Job By ID</td>
<td>Retrieves the details of the required job.</td>
</tr>
<tr>
<td></td>
<td>Lookup Jobs</td>
<td>Retrieves the details of the required jobs. The jobs are retrieved based on the filter query.</td>
</tr>
<tr>
<td></td>
<td>Start Jobs</td>
<td>Starts the jobs to execute the required process.</td>
</tr>
<tr>
<td>Machine Management</td>
<td>Get Machine By ID</td>
<td>Retrieves the details of the required machine.</td>
</tr>
<tr>
<td></td>
<td>Lookup Machines</td>
<td>Retrieves the details of the required machines. The machines are retrieved based on the filter query.</td>
</tr>
<tr>
<td>Process Management</td>
<td>Lookup Processes</td>
<td>Retrieves the details of the required processes. The processes are retrieved based on the filter query.</td>
</tr>
<tr>
<td>Queue Management</td>
<td>Add Item To Queue</td>
<td>Adds a new item to a the specified queue.</td>
</tr>
<tr>
<td></td>
<td>Create Queue</td>
<td>Creates a queue with the specified configuration.</td>
</tr>
<tr>
<td></td>
<td>Delete Queue</td>
<td>Deletes the specified queue.</td>
</tr>
<tr>
<td></td>
<td>Delete Queue Item</td>
<td>Deletes the specified queue item.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Lookup</td>
<td>Queue Items</td>
<td>Retrieves a list of queue item definition records.</td>
</tr>
<tr>
<td>Lookup</td>
<td>Queues</td>
<td>Retrieves the details of the required queue definition records. The queues are retrieved based on the filter query.</td>
</tr>
<tr>
<td>Release Management</td>
<td>Get Release By ID</td>
<td>Retrieves the details of the required release.</td>
</tr>
<tr>
<td>Release Management</td>
<td>Lookup Releases</td>
<td>Retrieves the details of the required releases. The releases are retrieved based on the filter query.</td>
</tr>
<tr>
<td>Robot Management</td>
<td>Create Robot</td>
<td>Creates a robot in UiPath.</td>
</tr>
<tr>
<td>Robot Management</td>
<td>Delete Robot</td>
<td>Deletes a robot in UiPath.</td>
</tr>
<tr>
<td>Robot Management</td>
<td>Get Robot By ID</td>
<td>Retrieves the details of the required robot.</td>
</tr>
<tr>
<td>Robot Management</td>
<td>Lookup Robots</td>
<td>Retrieves the details of the required robots. The robots are retrieved based on the filter query.</td>
</tr>
<tr>
<td>Session Management</td>
<td>Lookup Sessions</td>
<td>Retrieves the details of the required sessions. The sessions are retrieved based on the filter query.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Salesforce alias to configure where actions run as well as set MID Server selection attributes. For more information, see [MID server](#).
Set up the UiPath spoke
Integrate the ServiceNow instance with your UiPath account using to authenticate ServiceNow requests.

Before you begin
• Request IntegrationHub subscription
• Activate the UiPath spoke
• Role required: admin

Procedure
1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open the record for UiPath.
3. Select Configuration Template as per your requirement.
4. Click the Create New Connection & Credential related link.
5. On the form, fill these fields.
   • If you have selected UiPath Configuration Template - UiPath Cloud for Configuration Template, fill these fields.

Create Connection and Credential form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Name</td>
<td>Name to identify the connection record. For example, UiPath Connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Connection URL in this format: <a href="https://platform.uipath.com/">https://platform.uipath.com/</a></td>
</tr>
<tr>
<td></td>
<td>&lt;account-logical-name&gt;/&lt;instance-logical-name&gt;</td>
</tr>
<tr>
<td>Credential Name</td>
<td>Name to identify the credential record. For example, UiPath Credential.</td>
</tr>
<tr>
<td>Token URL</td>
<td>Location of the token endpoint that the instance uses to retrieve and refresh tokens. For example, <a href="https://account.uipath.com/oauth/token">https://account.uipath.com/oauth/token</a>.</td>
</tr>
<tr>
<td>Client Id</td>
<td>Client ID specific to the UiPath Orchestrator application.</td>
</tr>
<tr>
<td>Account Logical Name</td>
<td>Unique URL of the UiPath site.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Tenant Logical Name</td>
<td>Logical name of the service.</td>
</tr>
<tr>
<td>User Key</td>
<td>Unique login key you had generated.</td>
</tr>
</tbody>
</table>

- If you have selected **UiPath Configuration Template - Private/Public Cloud** for **Configuration Template**, fill these fields.

### Create Connection and Credential form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Name</td>
<td>Name to identify the connection record. For example, UiPath Connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>UiPath instance URL.</td>
</tr>
<tr>
<td>Credential Name</td>
<td>Name to identify the credential record. For example, UiPath Credential.</td>
</tr>
<tr>
<td>Token URL</td>
<td>Location of the token endpoint that the instance uses to retrieve and refresh tokens in this format: <code>http://&lt;instance-URL&gt;/api/account/authenticate</code></td>
</tr>
<tr>
<td>Tenant Name</td>
<td>Tenant logical name.</td>
</tr>
<tr>
<td>Username or email</td>
<td>Username or email address to authenticate the UiPath Orchestrator API.</td>
</tr>
<tr>
<td>Password</td>
<td>Associated password.</td>
</tr>
</tbody>
</table>

**Note:** You must enable **Use MID server** option in the connection record and create a SSL certificate from a trusted authority for on-prem support.

6. Click **Create**.

7. Click **Submit**.  
A Connection and Credential is created.

8. Open the UiPath Connection record, from the **Connections** tab.

9. Select a value for the **Orchestrator Feature Enabled** field.
Results
The Connection and Credential alias is configured and the UiPath spoke is set up.

UKG spoke v3.2.0
Manage time off requests in Kronos from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Kronos version v1, but may be compatible with later versions.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

• Complex Object (com.glide.cobject)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

⚠️ Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Spoke flows
The UKG spoke provides sample flows to demonstrate automating the Kronos tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:
<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kronos - Create Manager Time Off Request</td>
<td>Creates the time of request for a manager or employee.</td>
</tr>
<tr>
<td>Kronos - Get New Refresh And Access Token</td>
<td>Retrieves access token for Kronos and generates a new refresh token periodically.</td>
</tr>
<tr>
<td>Kronos - Refresh The Access Token</td>
<td>Refreshes the access token for Kronos.</td>
</tr>
<tr>
<td>Kronos - Retrieve And Update Manager Time Off Request Status</td>
<td>Retrieves status of the time off request status and updates the details of the associated request item.</td>
</tr>
<tr>
<td>Kronos - Time Off Details House Keeping</td>
<td>Deletes the time off requests based on the provided criteria. By default, the flow deletes time off requests that have been approved 7 days ago.</td>
</tr>
</tbody>
</table>

Every flow triggers an associated subflow.

**Spoke subflows**

The Kronos spoke provides sample subflows to demonstrate automating Kronos tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kronos - Get Kronos Token</td>
<td>Uses the details provided during spoke setup to retrieve a valid refresh token from Kronos.</td>
</tr>
<tr>
<td>Kronos - Create Manager Time Off Request</td>
<td>Creates the time off request and saves the information in your ServiceNow instance.</td>
</tr>
<tr>
<td>Kronos - Manager Time Off Request</td>
<td>Creates the time off request for a manager or employee.</td>
</tr>
<tr>
<td>Kronos - Retrieve Manager Time Off Request Status Update</td>
<td>Retrieves status of the time off request status and updates the details of the associated request item.</td>
</tr>
<tr>
<td>Subflow</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Kronos - Time Off Request Housekeeping</td>
<td>Deletes the time off requests based on the provided criteria. By default, the subflow deletes time off requests that have been approved 7 days ago.</td>
</tr>
<tr>
<td>Kronos - Report Missed Punches as Employee</td>
<td>This subflow creates a task which allows the employee’s manager to punch the employee's missing entry.</td>
</tr>
</tbody>
</table>

**Spoke actions**

The UKG spoke provides actions to automate Kronos tasks when events occurs in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication Management</td>
<td>Get Kronos Refresh Token</td>
<td>Retrieves the Refresh Token for Kronos.</td>
</tr>
<tr>
<td></td>
<td>Get Kronos Token</td>
<td>Retrieves the Token for Kronos.</td>
</tr>
<tr>
<td>Persons</td>
<td>Create Persons</td>
<td>Creates records for one or more persons.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Person by ID</td>
<td>Retrieves the details of a person for the specified record ID.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Persons</td>
<td>Retries the record details of a list of persons based on the search criteria.</td>
</tr>
<tr>
<td></td>
<td>Update Persons</td>
<td>Updates the records of one or more persons.</td>
</tr>
<tr>
<td>Scheduling</td>
<td>Retrieve Employee Schedule</td>
<td>Retrieves the schedule of an employee.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Retrieve Manager</td>
<td>Schedule</td>
<td>Retrieves the schedule of a list of employees.</td>
</tr>
<tr>
<td>Default</td>
<td>Add Timestamp</td>
<td>Adds or records a timestamp for a punch transaction of an employee.</td>
</tr>
<tr>
<td></td>
<td>Approve Timecard Employee</td>
<td>Approves the employee timecard for the specified range of dates.</td>
</tr>
<tr>
<td></td>
<td>Approve Timecard Manager</td>
<td>Adds manager approval for the specified employee’s timecard.</td>
</tr>
<tr>
<td></td>
<td>Look up Shift Cover Requests as Manager</td>
<td>Retrieves one or more shift cover requests matching specified search criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Open Shift Requests Manager</td>
<td>Retrieves a list of Open Shift Requests based on the Employee ID or Person Number.</td>
</tr>
<tr>
<td></td>
<td>Look up Self Schedule Requests Manager</td>
<td>Retrieves a list of Self Schedule requests based on the Employee ID or Person Number.</td>
</tr>
<tr>
<td></td>
<td>Look up Shift Swap Requests Manager</td>
<td>Retrieves a list of swap requests based on the Employee ID or Person Number.</td>
</tr>
<tr>
<td></td>
<td>Look up Manager Availability Requests</td>
<td>Retrieves all availability requests for the given criteria.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Employee Timecard Request</td>
<td>Retrieves the timecard details of the specified employee.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Retrieve Employee Timecards Request</td>
<td>Retrieves the details of a list of timecards for the specified employees or for the specified Hyperfind details.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Manager Timecard</td>
<td>Retrieves the timecard of the specified manager.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Manager Timecards</td>
<td>Retrieves the details of a list of timecards for the specified managers or the specified Hyperfind details.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Timecard Approvals Employee</td>
<td>Retrieves a list of employee timecard approvals for the specified date range.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Timecard Approvals Manager</td>
<td>Returns a list of manager timecard approvals for the specified date range.</td>
</tr>
<tr>
<td></td>
<td>Update Timecard</td>
<td>Updates the timecard of the specified employee.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get Accrual Codes</td>
<td>Retrieves a list of accrual code types according to the user's access rights.</td>
</tr>
<tr>
<td></td>
<td>Look Up Cost Centers</td>
<td>Retrieves a list of available cost centers.</td>
</tr>
<tr>
<td></td>
<td>Look Up Jobs</td>
<td>Retrieves a list of available jobs.</td>
</tr>
<tr>
<td></td>
<td>Look Up Labor Categories</td>
<td>Retrieves a list of available categories.</td>
</tr>
<tr>
<td></td>
<td>Look Up Labor Category Entries</td>
<td>Retrieves a list of available labor category entries.</td>
</tr>
<tr>
<td></td>
<td>Look Up Work Rules</td>
<td>Retrieves a list of available work rules.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Retrieve</td>
<td>Hyperfind Queries</td>
<td>Retrieves a list of Hyperfind queries.</td>
</tr>
<tr>
<td>Retrieve</td>
<td>Licenses</td>
<td>Retrieves a list of licenses.</td>
</tr>
<tr>
<td>Retrieve</td>
<td>Pay Rules</td>
<td>Retrieves a list of pay rules.</td>
</tr>
<tr>
<td>Retrieve</td>
<td>Symbolic Period ID</td>
<td>Retrieves the specified symbolic period.</td>
</tr>
<tr>
<td>Retrieve</td>
<td>All Pay Codes</td>
<td>Retrieves all the play code in Kronos.</td>
</tr>
<tr>
<td>Retrieve</td>
<td>Employee Request Subtype</td>
<td>Retrieves a list of request subtypes associated with the required Person Number.</td>
</tr>
<tr>
<td>Retrieve</td>
<td>Manager Request Subtype By Employee ID</td>
<td>Retrieves a list of request subtypes associated with the required Employee ID.</td>
</tr>
<tr>
<td>Retrieve</td>
<td>Manager Request Subtype By Person Number</td>
<td>Retrieves a list of request subtypes associated with the required Person Number. The action output is necessary for subsequent actions such as, the Retrieve Employee Accrual Balance action from manager's perspective.</td>
</tr>
<tr>
<td>Retrieve</td>
<td>Manager Symbolic Amount Qualifiers By Employee ID</td>
<td>Retrieves different types of Retrieve Manager Symbolic Amount Qualifiers By Employee ID, such as half day, full day, and so on, based on Employee ID.</td>
</tr>
<tr>
<td>Retrieve</td>
<td>Manager Symbolic Amount</td>
<td>Retrieves different types of Retrieve Manager Symbolic Amount Qualifiers By Employee ID, such as half day, full day, and so on, based on Person Number.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Qualifiers</td>
<td>Retrieve Symbolic Periods</td>
<td>Retrieves all the symbolic periods.</td>
</tr>
<tr>
<td>Scheduling</td>
<td>Create Employee Time Off Request</td>
<td>Creates a time off request based on the provided inputs.</td>
</tr>
<tr>
<td>Management</td>
<td>Create Manager Time Off Requests</td>
<td>Creates a time off request based on the provided inputs.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Employee Accrual Balance</td>
<td>Retrieves details of the different types of employee accrual balance, such as PTO, sick days, and so on.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Employee Time Off Requests</td>
<td>Retrieves details of the time off requests based on the specified search criteria.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Manager Accrual Balance By Employee ID</td>
<td>Retrieves details of the different types of manager accrual balance using Employee ID.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Manager Accrual Balance By Person Number</td>
<td>Retrieves details of the different types of manager accrual balance using Person Number.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Manager Time Off</td>
<td>Retrieves details of the time off requests based on the specified search criteria and Employee ID.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Requests By Employee ID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Retrieve Manager Time Off Requests By Person Number</td>
<td>Retrieves details of the time off requests based on the specified search criteria and Person Number.</td>
</tr>
<tr>
<td></td>
<td>Update Employee Time Off Request</td>
<td>Updates the state of an employee time off request.</td>
</tr>
<tr>
<td></td>
<td>Update Manager Time Off Requests</td>
<td>Updates the state of a manager time off request.</td>
</tr>
<tr>
<td></td>
<td>Get Employee Accruals by Person Number</td>
<td>Retrieves different types of employee accrual balances.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Timecard Approvals Manager</td>
<td>Retrieves a list of timecard approvals within the specified date range.</td>
</tr>
</tbody>
</table>

**Spoke module**

The Kronos spoke adds a Kronos application to your ServiceNow instance. The Kronos application has these modules.

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credentials</td>
<td>Details of the Kronos users with permissions to perform the required actions.</td>
</tr>
<tr>
<td>Time Off Request Details</td>
<td>Details of the time off requests, along with the status.</td>
</tr>
<tr>
<td>Time Off Request Details</td>
<td>Details of the time off requests from the staging tables.</td>
</tr>
<tr>
<td>Staging Tables</td>
<td></td>
</tr>
</tbody>
</table>
**Kronos spoke account requirements**

The Kronos spoke requires registering an OAuth 2.0 application in your Kronos account to generate OAuth 2.0 tokens for the Kronos spoke. Record the generated Client ID, Client Secret, and Application key for later use.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see *Connections and Credentials*.

**Set up the UKG spoke**

Integrate your Kronos application with your ServiceNow instance. Register an OAuth application in Kronos and authenticate requests from ServiceNow.

**Before you begin**

- Request IntegrationHub subscription
- Activate the UKG spoke
- Kronos manager user or superuser credentials
- Role required: admin

<i>Note: Make sure that the application registry, connections, and credentials are within the application scope.</i>

**Register Kronos as an OAuth provider**

Use the information generated during the Kronos application creation and configuration to register Kronos as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

**Procedure**

1. Navigate to *System OAuth > Application Registry*.
2. Open the record for the Kronos spoke.
3. On the form, fill in the fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter Kronos OAuth profile.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID created during the application configuration in Kronos.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret created during the application configuration in Kronos.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Grant type used to establish the token. Select Resource Owner Password Credentials.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record. Select Kronos Spoke.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Application scope that this registry is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry. Select the option.</td>
</tr>
<tr>
<td>Token URL</td>
<td>OAuth server token endpoint. For example, https://&lt;Kronos-Instance&gt;.com/api/authentication/access_token.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint. For example, https://&lt;ServiceNow-Instance&gt;.com/oauth_redirect.do.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**.

5. In the **OAuth Entity Scopes** tab, insert a row and provide these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Kronos</td>
</tr>
<tr>
<td>OAuth scope</td>
<td>givenName mail nonce openid profile sn uid</td>
</tr>
</tbody>
</table>

6. Click **Update**.

7. In the **OAuth Entity Profile** tab, click the default profile, **Kronos OAuth default_profile**.

8. Insert a record in the OAuth Entity Scope related list and select the default entity scope for the Kronos spoke. For example, **Kronos**.

9. Click **Update**.
Create Credential record for the Kronos spoke

Authorize the Kronos spoke actions by creating credential records for the application registered in Kronos. The Kronos spoke connection and credential alias uses these credentials to authorize actions.

Procedure

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?.
3. Select OAuth 2.0 Credentials.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Kronos Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record. Select the option.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Default OAuth entity profile of the Kronos spoke. For example, select Kronos oAuth default_profile.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the credentials are used. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click Save.

Provide Kronos user credentials

Create a record to provide details and credentials of the required Kronos user. The Kronos spoke uses these user credentials to perform actions in Kronos.

About this task

Ensure that you provide credentials of a manager user or Kronos superuser. With these credentials, time off requests of both employee and manager can be managed.

Procedure

1. Navigate to Kronos > Credentials.
2. Click New.
3. On the form, fill these values.
Kronos Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record.</td>
</tr>
<tr>
<td>Application Key</td>
<td>Application Key of the Kronos user.</td>
</tr>
<tr>
<td>User name</td>
<td>User name to log in to the user's account in Kronos.</td>
</tr>
<tr>
<td>Password</td>
<td>Password of the Kronos user account.</td>
</tr>
<tr>
<td>Connection &amp; Credential Alias</td>
<td>Default alias record associated with the Kronos spoke.</td>
</tr>
<tr>
<td>Refresh Token Expires</td>
<td>Date and time by when the Kronos refresh token expires. The Kronos spoke generates a new refresh token periodically, before the current refresh token expires.</td>
</tr>
</tbody>
</table>

4. Click Submit.

5. To generate the Kronos token, click the Get Kronos Token related link.

Results
The Kronos - Get Kronos Token subflow is triggered. The subflow uses the details provided during spoke setup to retrieve a valid refresh token from Kronos. The subflow then, updates the value of Refresh Token Expires.

Note: To access more details about the Kronos refresh token, navigate to System OAuth > Manage Tokens. Here, a record is created for each refresh token.

Create Connection record for the Kronos spoke
Create Connection records to your Kronos application. The Kronos spoke connection and credential alias uses these connections to perform actions in Kronos.

Procedure
1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open the record for the Kronos spoke.
3. From the Connections tab, click New.
4. On the form, fill these values.
HTTP(s) Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter Kronos Conn.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Kronos. For example, select Kronos Cred. See Create Credential record for the Kronos spoke for more information.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td>Note: Do not select the check box.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL of the Kronos instance.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>This field isn't applicable.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection. Select the option.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

5. In the Attributes tab, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>u_app_key</td>
<td>Application Key of the Kronos user.</td>
</tr>
<tr>
<td>u_version</td>
<td>Kronos version of your instance. Enter v1.</td>
</tr>
</tbody>
</table>

6. Click Submit.

Create request as manager using the Kronos catalog item

Trigger events in Kronos when an item is requested in the Service Catalog.

Before you begin
- Set up the UKG spoke
- Role required: admin

About this task
The Kronos spoke adds a catalog item for use with the Kronos spoke sample flows.
Procedure

1. Navigate to Self-Service > Service Catalog.
2. Click Kronos.
3. Click Kronos - Create Time Off Request As Manager (Super Access).
4. Provide details of the time off request.

   Note: After you have provided a valid Employee ID or Person Number(Qualifier), the system may take some time to populate the values in the Subtype Name using Employee ID and Symbolic Amount Qualifier By Employee ID, or Subtype Name using Person Number and Symbolic Amount Qualifier By Person Number lists.

5. Click Order Now.
   A request item is generated and its generated number is displayed.
6. Click the request number and change the value of Approval to Requested, Approved, or Rejected.
7. Click Update.

Results

- The Kronos - Create Manager Time Off Request flow is triggered.
- A record is created in the Time Off Request Details module. The status of the time off request is updated when the Kronos - Retrieve And Update Manager Time Off Status flow is triggered.

Utility Actions spoke v1.0.1
Create file attachments and zip attachments in your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke is compatible with ServiceNow instance of Rome and later versions.
Spoke dependencies
If you're having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

⚠️ **Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions
The Utility Actions spoke provides actions to automate tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add File to Zip</td>
<td>Adds the file to list of files to be zipped.</td>
</tr>
<tr>
<td>Append to Delimited File</td>
<td>Creates a file line record, corresponding to a row in the delimited file.</td>
</tr>
<tr>
<td>Append to File</td>
<td>Creates a file line record, corresponding to a line in the file to be created.</td>
</tr>
<tr>
<td>Begin File</td>
<td>Creates a file record, to which the actual file would be attached.</td>
</tr>
<tr>
<td>Begin Zip</td>
<td>Creates a file set record, to which the zip file would be attached.</td>
</tr>
<tr>
<td>Build File</td>
<td>Generates the file and attaches it to the file record specified.</td>
</tr>
<tr>
<td>Build Zip</td>
<td>Generates the zip file and attaches it to the file set record specified.</td>
</tr>
</tbody>
</table>

⚠️ **Note:** This action requires at least one MID Server with the IntegrationHub Utilities capability.

Spoke module and tables
The Utility Actions spoke includes these tables:
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Fields</th>
</tr>
</thead>
</table>
| File [sn_utility_spoke_file] | Information about every file that has been created. The associated file is attached to the record. | • File Name  
• File Type  
• Schema |
| **Note:** You must specify Schema if you specify Delimited File for File Type. |
| File Line [sn_utility_spoke_file_line] | Information about each row in delimited file. | • File  
• Line Content |
| File Mapping [sn_utility_spoke_file_mapping] | Information about files mapped to a ZIP file. For example, if four files are zipped to a ZIP file, four records are created in this table for each file. | • File  
• File Set |
| File Schema [sn_utility_spoke_file_schema] | Information regarding the delimited files. | • Schema Name  
• Columns  
• Delimiter  
• Has Header  
• Quoted |
| File Set [sn_utility_spoke_file_set] | Information about the zip files. The associated ZIP file is attached to the record. | Zip File Name |

The Utility Actions spoke adds the IntegrationHub Utilities application to your instance and includes the File Schemas module. The module displays records from the File Schema table.

Auto Flush data retention policies are available for the File and File Set tables. By default, the system retains data in the spoke tables, except the File Schema table, up to 7 days.
Note:

- Auto Flush data retention policies don’t apply to records in the File Schema table.
- When the file records in the File table are deleted, the corresponding file line records in the File Line table are also deleted.
- When the file set records in the File Set table are deleted, the corresponding file mapping records in the File Mapping table are also deleted.

To modify the data retention policy, change the value of **Age in seconds** in the Auto Flush form of the required table. For more information, see **Autoflush form**.

**Connection and credential alias requirements**

This spoke doesn’t require configuration of connection and credential alias.

**MID Server requirements**

These actions use REST calls, which can run on a MID Server. For more information, see **MID server**.

Note:

- The Build Zip action in the spoke requires at least one MID Server with the capability IntegrationHub Utilities or ALL. To set up and configure the MID Server, user must have the role sn_utility_spoke.utility_actions_admin role.
- Create a MID Server property with **Value** as `*.service-now.com`.

**Create schema**

Create schema to create delimited files in your ServiceNow instance.

**Before you begin**

Role required: sn_utility_spoke.utility_actions_admin

**Procedure**

1. Navigate to **IntegrationHub Utilities > File Builder > File Schemas**.
2. Click **New**.
3. On the form, fill these values.
### File Schema form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Schema Name</strong></td>
<td>Name to identify the schema record. For example, <em>Incident Schema</em>.</td>
</tr>
<tr>
<td><strong>Delimiter</strong></td>
<td>Delimiter in the file. For example, <code>,</code> and \t. The default value is comma.</td>
</tr>
<tr>
<td><strong>Has Header</strong></td>
<td>Option to specify if the schema has header.</td>
</tr>
<tr>
<td><strong>Quoted</strong></td>
<td>Option to escape the delimiters and surround all values with quotation marks.</td>
</tr>
<tr>
<td><strong>Columns</strong></td>
<td>Columns of the schema as a JSON array. For each column, specify column name and data type. For example,</td>
</tr>
</tbody>
</table>

```json
[
  {
    "name" : "Number",
    "type" : "string"
  },
  {
    "name" : "Caller First Name",
    "type" : "string"
  },
  {
    "name" : "Caller Last Name",
    "type" : "string"
  },
  {
    "name" : "Short Description",
    "type" : "string"
  },
  {
    "name" : "State",
    "type" : "choice",
    "choices" : [
      {
        "label" : "New",
        "value" : "New"
      },
      {
        "label" : "In Progress",
```
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&quot;value&quot; : &quot;In Progress&quot;</td>
</tr>
<tr>
<td></td>
<td>},</td>
</tr>
<tr>
<td></td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>&quot;label&quot; : &quot;On Hold&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;value&quot; : &quot;On Hold&quot;</td>
</tr>
<tr>
<td></td>
<td>},</td>
</tr>
<tr>
<td></td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>&quot;label&quot; : &quot;Resolved&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;value&quot; : &quot;resolved&quot;</td>
</tr>
<tr>
<td></td>
<td>},</td>
</tr>
<tr>
<td></td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>&quot;label&quot; : &quot;Closed&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;value&quot; : &quot;closed&quot;</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
</tbody>
</table>

. For more information, see Create a data gathering action for a dynamic template.

Note: Ensure that you surround the key and value with quotation marks.

4. Click Submit.

Build a flow using the Utility Actions spoke actions
Create a flow in Flow Designer using the Utility Actions spoke actions to create two files; one for incident records and other for user records, and zip these two files.

About this task
This sample flow demonstrates using the Utility Actions spoke actions to create files. You can configure the flow as per your requirement.

Procedure
1. Navigate to Flow Designer > Designer.
2. Create a flow. See Flows for more information about creating flows.
3. In the flow, add these spoke actions or flow logics:

a. Look Up Incident Records action to retrieve the incident records.

b. Begin File action to create a file that will contain the incident records.

c. For Each flow logic to apply the Append to Delimited File action to the list of incident records.

d. Build File action to add rows. Each incident record is added as a row in the file.

e. Perform similar steps to retrieve records from the User [sys_user] table.
f. Begin Zip action to build the ZIP file for the incident and user records.

g. Add File To Zip action to add file containing the incident records to the ZIP file.

h. Add File To Zip action to add file containing the user records to the ZIP file.
1. Build Zip action to create the ZIP file containing the incident and user records.
4. Save, test, and publish the flow to use it.
**Actions**

1. Look Up Incident Records

2. Begin File

3. For Each Item in 1→Incident Records
   3.1 Append to Delimited File

4. Build File

5. Look Up User Records

6. Begin File

7. For Each Item in 5→User Records
   7.1 Append to Delimited File

8. Build File

9. Begin Zip

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Unified Compliance Framework (UCF) spoke
Manage processes to collect and coordinate the compliance requirements applicable to your organization from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Complex Object (com.glide.cobject)

Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported version
This spoke was built for UCF v2.0, but may be compatible with later versions.

Spoke requirements
- Common Control Hub (CCH) account
- CCH administrator credentials

Spoke actions
The UCF spoke provides actions to automate UCF tasks when events occur in ServiceNow. Available actions include:
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Record</td>
<td>Get Authority Documents</td>
<td>Retrieves authority documents that are downloaded from the UCF Common Controls Hub.</td>
</tr>
<tr>
<td>Management</td>
<td>Get Citation Control Objective Mapping</td>
<td>Retrieves the Citation and Control objective mapping information.</td>
</tr>
<tr>
<td></td>
<td>Get Citation Documents</td>
<td>Retrieves the citations that are downloaded from the UCF Common Controls Hub.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get Control Objective Documents</td>
<td>Retrieves the citation to controls that are downloaded from the UCF Common Controls Hub.</td>
</tr>
<tr>
<td></td>
<td>Get Authority Document List</td>
<td>Retrieves the current user's authority document lists.</td>
</tr>
</tbody>
</table>

### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

### Set up the UCF spoke

Integrate the ServiceNow instance and UCF by creating a custom OAuth application in UCF to authenticate ServiceNow requests.

#### Before you begin

- Request IntegrationHub subscription
- Activate the UCF spoke
- Role required: admin

#### Create application in UCF

Create application in Common Controls Hub (CCH) to enable OAuth 2.0 authentication with the UCF spoke.
Before you begin
Role required: CCH administrator

Procedure
1. Create application in UCF. For information about creating an application using your CCH account, see the CCH Support documentation.
2. While creating the application, ensure that you provide this information:
   - **Redirect URL**: ServiceNow instance URL in the format, https://<Instance-Name>.service-now.com/oauth_redirect.do
   - **Authorization URL**: Location on your website to which CCH redirects the interested users.
3. Copy and record the **Client ID** and **Client Secret** for later use.

Results
The application is created in CCH to enable OAuth 2.0 authentication with the UCF spoke.

Register UCF as OAuth provider
Use the information generated during the application configuration in CCH, to register UCF as an OAuth provider and allow the ServiceNow instance to request OAuth 2.0 tokens.

Before you begin
Role required: admin

Procedure
1. Navigate to System OAuth > Application Registry.
2. Open for the record for UCF.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter <strong>UCF OAuth profile</strong>.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID created during the application configuration in CCH.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret created during the application configuration in CCH.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Optional script to customize the request and response.</td>
</tr>
<tr>
<td>Logo URL</td>
<td>URL that contains an image to use as the application logo.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Grant type used to establish the token. Select Authorization Code.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>Time, in seconds, that the refresh token is valid. The default time is 8,640,0000 seconds.</td>
</tr>
<tr>
<td>PKCE required</td>
<td>Option to enable public clients to require PKCE for an authorization.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can use only Authorization Code as the Default Grant type when PKCE is enabled.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record. Select UCF Spoke.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You must ensure that the application scope is UCF Spoke.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Application scope that this registry is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>OAuth authorization code endpoint. For example, <a href="https://auth.unifiedcompliance.com/authorize">https://auth.unifiedcompliance.com/authorize</a>.</td>
</tr>
<tr>
<td>Token URL</td>
<td>OAuth server token endpoint. For example, <a href="https://auth.unifiedcompliance.com/token">https://auth.unifiedcompliance.com/token</a>.</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>OAuth server token revocation endpoint.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint. System generates the URL upon saving the application registry. This is the URL of the ServiceNow instance in this format: https://&lt;Instance-Name&gt;/service-now.com/oauth_redirect.do</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use mutual authentication for token request and revocation.</td>
</tr>
<tr>
<td></td>
<td>This option requires a mutual authentication profile to be specified.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**.
The system validates the OAuth credentials and populates the Redirect URL.

5. Insert a row in the OAuth Entity Profiles tab and provide these values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>UCF OAuth</td>
</tr>
<tr>
<td>Is default</td>
<td>true</td>
</tr>
<tr>
<td>Grant type</td>
<td>Authorization Code</td>
</tr>
</tbody>
</table>

6. Insert a row in the OAuth Entity Scopes tab and provide these values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>read</td>
</tr>
<tr>
<td>OAuth scope</td>
<td>read</td>
</tr>
<tr>
<td>Application</td>
<td>UCF Spoke</td>
</tr>
<tr>
<td>In default profile</td>
<td>true</td>
</tr>
</tbody>
</table>

7. Right-click the form header, and click Save.

8. Open the record in the OAuth Entity Scopes tab. For example, open the UCF OAuth record. Details of the OAuth Entity Profile record is displayed.

9. In the OAuth Entity Scopes tab, select the OAuth Entity Scope you had earlier created. For example, select read.

10. Right-click the form header, and click Save.

Results
The instance can request OAuth 2.0 tokens for the spoke and a refresh token is created to regenerate tokens.

Create Credential records for the UCF spoke
Authorize the UCF spoke actions by creating credential records for the application registered in UCF. The UCF spoke connection and credential alias uses these credentials to authorize actions.
Before you begin
Role required: admin

Procedure

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
   The system displays the message *What type of Credentials would you like to create?*.
3. Select **OAuth 2.0 Credentials**.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, <strong>UCF Credentials</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile created during the registration of UCF spoke as an OAuth provider. For example, select <strong>UCF OAuth profile</strong>.</td>
</tr>
<tr>
<td>Applies to</td>
<td>MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the credentials are used. For example, enter <strong>100</strong>.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click **Save**.
6. To generate the OAuth token, click the **Get OAuth Token** related link.

Results
The credential record for the UCF spoke is created.

Create Connection record for the UCF spoke
Create Connection records to your UCF account. The UCF spoke connection and credential alias uses these connections to perform actions in UCF.

Before you begin
Role required: admin
Procedure

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for UCF.
3. From the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter UCF Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for UCF. For example, select UCF Credentials.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Enter <a href="https://api.unifiedcompliance.com/">https://api.unifiedcompliance.com/</a>.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Results
The connection record is created for UCF spoke.

Workday Financials spoke v1.2.2
The Workday Financials spoke is built by Bristelcone, Inc. Manage resources, business units, journals, cost centers, and so on, in Workday Financials application from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Workday Financials SOAP API version v33.2, but may be compatible with later versions.

© 2021 ServiceNow, Inc. All rights reserved.
**Spoke requirements**
To set up the integration, perform these:

1. Register Integration System User.

   - **Note:** While filling account information details, ensure that you select the **Do Not Allow UI Sessions** check box.

2. Create a security group and assign it to the integration system user.
   a. In **Action**, navigate to **Security Group > Maintain Domain Permissions for Security Group** and provide these permissions:

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Only</td>
<td>Set Up: Worktags - Business Units</td>
<td></td>
<td>Common Financial Management Worktags</td>
</tr>
<tr>
<td>Get Only</td>
<td>Set Up: Ledger and Book</td>
<td></td>
<td>Common Financial Management</td>
</tr>
<tr>
<td>Get and Put</td>
<td>Process: Journals - Core</td>
<td></td>
<td>Financial Accounting</td>
</tr>
<tr>
<td>Get Only</td>
<td>Process: Journals - View</td>
<td></td>
<td>Financial Accounting</td>
</tr>
<tr>
<td>Get and Put</td>
<td>Process: Purchase Order - Cancel</td>
<td></td>
<td>Procurement</td>
</tr>
<tr>
<td>Get Only</td>
<td>Process: Advance Ship Notice - View</td>
<td></td>
<td>Procurement</td>
</tr>
<tr>
<td>Get Only</td>
<td>Process: Supplier Invoice - New</td>
<td></td>
<td>Supplier Accounts</td>
</tr>
<tr>
<td>Get Only</td>
<td>Process: Request for Quotes - View</td>
<td></td>
<td>Procurement</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>Get Only</td>
<td>Set Up: Accounts</td>
<td></td>
<td>Common Financial Management</td>
</tr>
<tr>
<td>Get Only</td>
<td>Create: Cost Center</td>
<td></td>
<td>Organizations and Roles</td>
</tr>
<tr>
<td>Get Only</td>
<td>Set Up: Currency Rates</td>
<td></td>
<td>Common Financial Management</td>
</tr>
<tr>
<td>Get Only</td>
<td>Set Up: Currency (Compensation functional area)</td>
<td></td>
<td>Core Compensation</td>
</tr>
<tr>
<td>Get Only</td>
<td>Integration Build</td>
<td></td>
<td>Integration</td>
</tr>
<tr>
<td>Get Only</td>
<td>Process: Business Assets</td>
<td></td>
<td>Business Asset Tracking</td>
</tr>
<tr>
<td>Get Only</td>
<td>Set Up: Expense Item</td>
<td></td>
<td>Expenses</td>
</tr>
<tr>
<td>Get Only</td>
<td>Set Up: Purchase Item</td>
<td></td>
<td>Procurement</td>
</tr>
<tr>
<td>Get Only</td>
<td>Reports: Supplier</td>
<td></td>
<td>Supplier</td>
</tr>
<tr>
<td>View Only</td>
<td>Process: Purchase Order - Reporting</td>
<td></td>
<td>Procurement</td>
</tr>
<tr>
<td>Get and Put</td>
<td>Integration Event</td>
<td></td>
<td>Integration</td>
</tr>
<tr>
<td>View Only</td>
<td>Integration Security</td>
<td></td>
<td>Integration</td>
</tr>
</tbody>
</table>

**Note:** Ensure that the domain security policies are activated for the security group.
b. Configure the business process policies of your security group and provide these permissions:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Business Process Type</th>
<th>Functional Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initiate (Register Asset (Web Service))</td>
<td>Asset Registration Event</td>
<td>• Business Asset Accounting</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Business Asset Tracking</td>
</tr>
<tr>
<td>Initiate (Submit Purchase Order Change Order (Web Service))</td>
<td>Change Order</td>
<td>Procurement</td>
</tr>
<tr>
<td>Initiate (Submit Purchase Order (Web Service))</td>
<td>Purchase Order Event</td>
<td>Procurement</td>
</tr>
<tr>
<td>Initiate (Submit Receipt (Web Service))</td>
<td>Receipt</td>
<td>Procurement</td>
</tr>
<tr>
<td>Initiate (Submit Supplier (Web Service))</td>
<td>Supplier Event</td>
<td>Supplier</td>
</tr>
<tr>
<td>Initiate (Submit Supplier Invoice (Web Service))</td>
<td>Supplier Invoice Event</td>
<td>Supplier Accounts</td>
</tr>
</tbody>
</table>

**Note:** Ensure that the business process security policies are activated for the security group.

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - SOAP (com.glide.hub.action_step.soap)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
• ServiceNow Flow Designer - Dynamic Outputs (com.glide.hub.dynamic_outputs)
• Complex Object (com.glide.cobject)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Authentication
Workday provides an open SOAP API for programmatic access to on-demand business management services. Workday SOAP APIs require basic authentication; that is, user name and password are required.

Note: This spokes doesn’t require you to set up the connection and credential alias.

Spoke subflows
The Workday Financials spoke provides sample subflows to demonstrate automating Workday Financials tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create PO</td>
<td>Creates a purchase order record in the Purchase Order table. To use the subflow, Set up webhook for your Workday Financials spoke.</td>
</tr>
<tr>
<td>Get Supplier Invoice Details</td>
<td>Retrieves details of the specified supplier invoice.</td>
</tr>
</tbody>
</table>

Spoke actions
The Workday Financials spoke provides actions to automate tasks when events occurs in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Management</td>
<td>Get Account Set By ID</td>
<td>Retrieves details of the specified account set.</td>
</tr>
<tr>
<td></td>
<td>Get Business Unit By ID</td>
<td>Retrieves details of the specified business unit.</td>
</tr>
<tr>
<td></td>
<td>Get Cost Center By ID</td>
<td>Retrieves details of the specified cost center.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get Ledger By ID</td>
<td>Retrieves details of the specified ledger record.</td>
</tr>
<tr>
<td></td>
<td>Look up Account Sets</td>
<td>Retrieves details of the required account sets, based on the provided filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Business Units</td>
<td>Retrieves details of the required business units, based on the provided filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Cost Centers</td>
<td>Retrieves details of the required cost centers, based on the provided filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Fx Rates</td>
<td>Retrieves details of the required Fx rates, based on the provided filter criteria.</td>
</tr>
<tr>
<td>Journal Entry Management</td>
<td>Create Accounting Journal</td>
<td>Creates an accounting journal.</td>
</tr>
<tr>
<td></td>
<td>Look up Journals</td>
<td>Retrieves details of the required journal records, based on the provided filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Post Accounting Journal</td>
<td>Posts an accounting journal record.</td>
</tr>
<tr>
<td></td>
<td>Reverse Accounting Journal</td>
<td>Reverses the specified accounting journal.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get Additional Fields For Workday Finance</td>
<td>Retrieves additional fields for each action.</td>
</tr>
<tr>
<td></td>
<td>Get Reference ID List</td>
<td>Retrieves values of the Reference ID based on the specified reference type.</td>
</tr>
<tr>
<td>Resource Management</td>
<td>Cancel Purchase Order</td>
<td>Cancels the specified purchase order.</td>
</tr>
<tr>
<td></td>
<td>Create Fixed Asset Shell</td>
<td>Creates a fixed asset shell.</td>
</tr>
<tr>
<td></td>
<td>Create Supplier</td>
<td>Creates a supplier with the provided details.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Create Supplier Invoice</td>
<td>Creates a supplier invoice with the provided details.</td>
</tr>
<tr>
<td></td>
<td>Get Advanced Shipment Notice By Number</td>
<td>Retrieves details of the specified advance shipment notice.</td>
</tr>
<tr>
<td></td>
<td>Get Supplier By ID</td>
<td>Retrieves details of the specified supplier.</td>
</tr>
<tr>
<td></td>
<td>Get Supplier Invoice By ID</td>
<td>Retrieves details of the specified supplier invoice.</td>
</tr>
<tr>
<td></td>
<td>Look up Advanced Shipment Notices</td>
<td>Retrieves details of the required advance shipment notices, based on the provided filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Expense Items</td>
<td>Retrieves details of the required expense items, based on the provided filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Fixed Asset Details</td>
<td>Retrieves details of the required fixed assets, based on the provided filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Purchase Items</td>
<td>Retrieves details of the required purchase items, based on the provided filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Request For Quotes</td>
<td>Retrieves details of the required request for quotes records, based on the provided filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Supplier Invoices</td>
<td>Retrieves details of the required supplier invoices, based on the provided filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Suppliers</td>
<td>Retrieves details of the required suppliers, based on the provided filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Submit Purchase Order</td>
<td>Submits the specified purchase order.</td>
</tr>
<tr>
<td></td>
<td>Submit Purchase Order Change Order</td>
<td>Submits change order associated with the specified purchase order.</td>
</tr>
<tr>
<td></td>
<td>Submit Receipt</td>
<td>Submits the specified receipt.</td>
</tr>
</tbody>
</table>

### Spoke module

The Workday Financials spoke adds the Workday Finance application to your instance and includes these modules:
<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Details</td>
<td>Contains information about the base URL of the Workday instance or tenant, and API version.</td>
</tr>
<tr>
<td>Get Business Units</td>
<td>Displays information about the business units. Admin should configure the sample remote table as per their requirement.</td>
</tr>
<tr>
<td>Purchase Orders</td>
<td>Displays information about the purchase orders whenever they are created in the Workday application. To retrieve this information to the ServiceNow instance, you must Set up webhook for your Workday Financials spoke.</td>
</tr>
<tr>
<td>Webhook Registries</td>
<td>Contains records of webhooks registries. Admin should create record here Set up webhook for your Workday Financials spoke for the required Workday event.</td>
</tr>
</tbody>
</table>

**Set up the Workday Financials spoke**

Integrate the ServiceNow instance Workday instance by using the WS-Security Username Profile to authenticate ServiceNow requests.

**Before you begin**

- Request an IntegrationHub subscription.
- Activate Workday Financials spoke.
- Role required: admin

**Provide the Workday Financials base URL**

Provide the base URL of your Workday Financials instance in the Connection Details [connection_details] table. Spoke actions based on the SOAP API, use these details for the action execution.

**Procedure**

1. Navigate to **System Definition > Tables**.
2. Filter and search for the Connection Details table.
3. Click the **Show List** related list.
4. Click **New**.
5. On the form, fill these values.
Connection Details form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base URL</td>
<td>Base URL of the Workday instance or tenant name.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the API. For example, enter v33.2.</td>
</tr>
</tbody>
</table>

6. Click **Save**.

Create a WS-Security Username Profile for the Workday Financials spoke

Create a WS-Security Username Profile to provide your Workday credentials to authenticate requests from ServiceNow.

Procedure

1. Navigate to **IntegrationHub > SOAP Integrations > WS-Security Username Profiles**.
2. Click **New**.
3. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify this credential. For example, enter WorkdayFinancials User.</td>
</tr>
<tr>
<td>Application</td>
<td>Application in which the record is applicable. Select <strong>Workday Financials Spoke</strong>.</td>
</tr>
<tr>
<td>Username</td>
<td>Workday user who has integration rights using Workday Web Services.</td>
</tr>
<tr>
<td>Password</td>
<td>Password of the Workday user.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

Configure the SOAP security policy for the Workday Financials spoke

Configure the SOAP security profile by adding the security user name profile you had created to authenticate requests from ServiceNow.
Procedure

1. Navigate to IntegrationHub > SOAP Integrations > SOAP Security Policies.
2. Open the record, WorkdayFinancials.
3. For WS-Security Username Profile, select the security username profile you had created for the Workday Financials spoke. See Create a WS-Security Username Profile for the Workday Financials spoke for more information.
4. Do not provide value in WS-Security X.509 Profile.
5. Right-click the form header and click Save.

Set up webhook for your Workday Financials spoke

Retrieve details of an onboarded employee in the Workday application to your ServiceNow instance by setting up the webhooks.

Before you begin

- Set up the Workday Financials spoke
- Role required: admin

Generate user name and password in your ServiceNow instance

Generate user name and password in your ServiceNow instance to authenticate requests and retrieve the required data from the Workday application.

Procedure

1. Navigate to System Definition > Table.
2. Filter and search for the Workday Financials spoke webhook registry table. For example, WorkdayFin Webhook Registry.
3. Click the Show List related list.
4. Click New.
5. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Description of the webhook registry record. Enter Workday event and authentication for Create PO.</td>
</tr>
<tr>
<td>UserName</td>
<td>Workday user who has integration rights using Workday Web Services.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Password</td>
<td>Password of the Workday user.</td>
</tr>
<tr>
<td>Workday Event</td>
<td>Event for which the webhook is set up. Enter CreatePO.</td>
</tr>
<tr>
<td>Workday Instance</td>
<td>Base URL of the Workday instance or tenant name.</td>
</tr>
</tbody>
</table>

6. Right-click the form header and click **Save**.

7. Click **Generate UserName And Password**.
   Copy and record the values of user name and password. These values must be specified in the Workday instance to authenticate the webhook requests.

**Retrieve the resource path from your ServiceNow instance**

Retrieve the resource path from your ServiceNow instance for later use to authenticate requests and retrieve the required data from the Workday application.

**Procedure**

1. Navigate to **System Web Services > Scripted Web Services > Scripted REST APIs**.
2. Open the record for the Workday Financials spoke.
3. In the **Resources** tab, click the **Callback** record.
4. Record and save the value of **Resource path** for later use.

**Import CLAR file to your Workday instance**

Import CLAR file available at ServiceNow Store to set up webhooks and authenticate requests from ServiceNow instance.

**Before you begin**

- Workday Studio should be installed.
- Access to custom report creation policy.
Create custom report in Workday based on the Purchase_order_report structure and share the report with ISU user.

Ensure that you select all companies in company prompt in report.

- Access to edit business process definition.
- Access to create and edit integration system.
- Role required: admin

⚠️ Note: Except integration name, report field XPath (if required), and Workday instance header, users are cautioned against modifying the values of fields or properties in the CLAR file.

**Procedure**

1. From the Workday Financials spoke page on ServiceNow Store, download the Workday-Finance-Webhook-Studio-Sample file from Supporting Links and Docs.
2. Unzip the sample file to obtain the CLAR file.
3. Import the CLAR file to Workday Studio.
4. In the Properties tab of the StartHere component, navigate to Services and select the RAAS report created for this webhook.
5. Choose the environment where your report exists such as, implementation or sandbox, and configure the report as per your requirement.

6. Provide a report name and select the required report.

7. Provide the alias name of the report.
8. After the report alias is added, add the selected path of report in **Extra Path** that is used to run the report based on prompt.

9. In the **Set Headers** component, provide your Workday instance for the **WorkdayInstance** header.

10. In the properties of **HttpOut**, fill in these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint</td>
<td>REST endpoint</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> See Retrieve the resource path from your ServiceNow instance for more information.</td>
</tr>
</tbody>
</table>
11. Save the changes.

12. In the project explorer, select the integration and deploy it in your Workday system.

13. Log in to your Workday instance and navigate to **Integration > Integration System > Configure Integration Attributes**.

14. Provide user name and password in **Configure Integration Attributes** that you have generated in **Generate user name and password in your ServiceNow instance**.
15. Modify a business process and add this integration in your business process.
   
a. Edit definition of the business process.

b. Search for Purchase Order business process in Workday. If within one customer environment there are more than one purchase order business processes, all the business processes should be configured to enable this webhook for all purchase orders.

c. Select the effective date and click Ok.

d. Click the + sign and add a new business process step in BP.

e. Select an order, which is after the completion step of business process.

f. Select **Type** as Integration.
g. Provide ISU username in **Run as User** and click **Ok**.

h. Click **Configure Integration** on the newly added business process step in hire BP.

i. On the Configuration Integration Step page, click **Ok**.

j. In integration criteria, select value type as **Determine value at runtime** and select value as **PO Number**.

Selected **PO Number** should be as shown below.
k. Click Ok.

l. Create a report for the webhook with these details:

Purchase Order report definition:

Column labels:

Filter:
Workday HR spoke v1.5
The Workday HR spoke is built by Bristelcone, Inc. Manage staffing, resources, payroll, benefits and so on, in Workday HR system from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Workday HR SOAP API version v33.2 and REST API version v1, but may be compatible with later versions.

Spoke requirements
To set up the integration, perform these:

1. Register an Integration System User.
   
   Note: While filling account information details, ensure that you select the Do Not Allow UI Sessions check box.

2. Create a security group and assign it to the integration system user.
a. In **Action**, navigate to **Security Group** > **Maintain Domain Permissions for Security Group** and provide these permissions:

**Domain security policy permissions**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>View Only</td>
<td>Reports: Manager</td>
<td></td>
<td>Staffing</td>
</tr>
<tr>
<td>View Only</td>
<td>Reports: Matrix Manager</td>
<td></td>
<td>Staffing</td>
</tr>
<tr>
<td>View and Modify</td>
<td>Business Process Administration</td>
<td>Business Process Delegation</td>
<td>System</td>
</tr>
<tr>
<td>View Only</td>
<td>Worker Data: Benefits</td>
<td>• Worker Data: Beneficiaries and Dependents</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Benefit Annual Credit</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Benefit Eligibility</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Benefits Annual Rate</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Court Order Details</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Retirement Details</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Wellness</td>
<td></td>
</tr>
<tr>
<td>View Only</td>
<td>Reports: Learning Record</td>
<td></td>
<td>Learning Core</td>
</tr>
<tr>
<td>View Only</td>
<td>Worker Data: Funded Plan Assignments</td>
<td></td>
<td>Advanced</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Compensation</td>
</tr>
<tr>
<td>View Only</td>
<td>Business Process Reporting</td>
<td></td>
<td>System</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------</td>
<td>-----------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>View Only</td>
<td>Workday Accounts</td>
<td></td>
<td>System</td>
</tr>
<tr>
<td>View Only</td>
<td>Person Data: Gender</td>
<td></td>
<td>Personal Data</td>
</tr>
<tr>
<td>View Only</td>
<td>Manage: Organization Roles</td>
<td></td>
<td>Organizations and Roles</td>
</tr>
<tr>
<td>View Only</td>
<td>Person Data: Work Address</td>
<td></td>
<td>Contact Information</td>
</tr>
<tr>
<td>View Only</td>
<td>Person Data: Home Phone</td>
<td></td>
<td>Contact Information</td>
</tr>
<tr>
<td>View Only</td>
<td>Person Data: Work Phone</td>
<td></td>
<td>Contact Information</td>
</tr>
<tr>
<td>Get and Put</td>
<td>Manage: Payment Election</td>
<td></td>
<td>Expenses</td>
</tr>
<tr>
<td>Get and Put</td>
<td>Person Data: Personal Data</td>
<td>• Person Data: Ethnicity Visual Survey</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Person Data: Licenses</td>
<td></td>
<td>Personal Data</td>
</tr>
<tr>
<td></td>
<td>• Person Data: Other IDs</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Person Data: Passports and Visas</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Worker Data: Tobacco Use</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Get and Put</td>
<td>Worker Data: Payroll (Payment Elections)</td>
<td></td>
<td>Core Payroll</td>
</tr>
<tr>
<td>Get and Put</td>
<td>Worker Data: Payroll Interface (Payment Elections)</td>
<td></td>
<td>Payroll Interface</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------</td>
<td>-----------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Get and Put</td>
<td>Worker Data: Beneficiaries</td>
<td>• Worker Data: Beneficiary Additional Address</td>
<td>Benefits</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Beneficiary Additional Email</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Beneficiary Additional Instant Messenger</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Beneficiary Additional Phone</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Beneficiary Additional Web Address</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Beneficiary Date of Birth</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Beneficiary Gender</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Beneficiary Government IDs</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Beneficiary National IDs</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Beneficiary Other IDs</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Beneficiary Primary Address</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Beneficiary Primary Email</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------</td>
</tr>
</tbody>
</table>
| Get and Put | Process: Import Time Blocks | • Worker Data: Beneficiary Primary Instant Messenger  
• Worker Data: Beneficiary Primary Phone  
• Worker Data: Beneficiary Primary Web Address | • Time Tracking  
• Time Tracking Hub |
<p>| Get Only    | Worker Data: Current Staffing Information                  |                                                                                                           | Staffing                          |
| Get Only    | Set Up: Calendar                                            |                                                                                                           | System                            |
| Get Only    | Job Information                                             |                                                                                                           | Jobs &amp; Profile                    |
| Get Only    | Worker Data: Payroll (Income Withholding Orders)            |                                                                                                           | Core Payroll                      |
| Get Only    | Worker Data: Payroll (Income Withholding Orders) - CAN      |                                                                                                           | CAN Payroll                       |
| Get Only    | Worker Data: Payroll (Company Specific) - USA               |                                                                                                           | USA Payroll                       |</p>
<table>
<thead>
<tr>
<th>Get Only</th>
<th>Manage: Location</th>
<th>Location: View</th>
<th>Organizations and Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Only</td>
<td>Worker Data: Benefits</td>
<td>• Worker Data: Beneficiaries and Dependents</td>
<td>• Benefits</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Benefit Annual Credit</td>
<td>• Personal Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Benefit Eligibility</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Benefits Annual Rate</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Court Order Details</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Retirement Savings</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Worker Data: Wellness</td>
<td></td>
</tr>
<tr>
<td>Get Only</td>
<td>Worker Data: Project Timesheet and Worksheet</td>
<td>Project Tracking</td>
<td></td>
</tr>
<tr>
<td>Get Only</td>
<td>Worker Data: Public Worker Reports</td>
<td>Staffing</td>
<td>Payroll Interface</td>
</tr>
<tr>
<td>Get Only</td>
<td>Payroll Interface</td>
<td></td>
<td>Core Payroll</td>
</tr>
<tr>
<td>Get Only</td>
<td>Reports: Pay Calculation Results for Worker</td>
<td>• Reports: Pay Calculation Results for Worker (Audits)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Reports: Pay Calculation Results for Worker (Payslips)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Reports: Pay Calculation Results for Worker (Results)</td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------------------</td>
<td>-----------------------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Get Only</td>
<td>Manage: Organization Integration</td>
<td></td>
<td>Organizations and Roles</td>
</tr>
<tr>
<td>Get Only</td>
<td>Worker Data: Benefit Elections</td>
<td></td>
<td>• Benefits</td>
</tr>
<tr>
<td>Get Only</td>
<td>Person Data: Emergency Contacts</td>
<td></td>
<td>• Personal Data</td>
</tr>
<tr>
<td>Get Only</td>
<td>Worker Data: Edit and Delete Worker Documents</td>
<td></td>
<td>Personal Data</td>
</tr>
<tr>
<td>Get Only</td>
<td>Worker Data: Compensation by Organization</td>
<td></td>
<td>Core Compensation</td>
</tr>
<tr>
<td>Get Only</td>
<td>Integration Build</td>
<td></td>
<td>Integration</td>
</tr>
<tr>
<td>Get Only</td>
<td>Worker Data: Time Off (Time Off Balances)</td>
<td></td>
<td>Time Off and Leave</td>
</tr>
<tr>
<td>Get Only</td>
<td>Person Data: Personal Information</td>
<td></td>
<td>Personal Data</td>
</tr>
<tr>
<td>View Only</td>
<td>Worker Data: Public Worker Reports</td>
<td></td>
<td>Staffing</td>
</tr>
<tr>
<td>View Only</td>
<td>Integration Security</td>
<td></td>
<td>Integration</td>
</tr>
<tr>
<td>Get and Put</td>
<td>Integration Event</td>
<td></td>
<td>Integration</td>
</tr>
</tbody>
</table>

**Note:** Ensure that the domain security policies are activated for the security group.
b. Configure the business process policies of your security group and provide these permissions:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Business Process Type</th>
<th>Functional Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initiate (Assign Roles (Web Service))</td>
<td>Assign Roles</td>
<td>Organizations and Roles</td>
</tr>
<tr>
<td>Initiate (Change Organization Assignments (Web Service))</td>
<td>Change Organization Assignments for Worker</td>
<td>Organizations and Roles</td>
</tr>
<tr>
<td>Initiate (Maintain Contact Information (Web Service))</td>
<td>Contact Change</td>
<td>Contact Information</td>
</tr>
<tr>
<td>Initiate (Add Dependent (Web Service))</td>
<td>Dependent Event</td>
<td>• Benefits</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Personal Data</td>
</tr>
<tr>
<td>Initiate (Edit Worker Additional Data (Web Service))</td>
<td>Edit Worker Additional Data Event</td>
<td>Staffing</td>
</tr>
<tr>
<td>Initiate (Change Legal Name (Web Service))</td>
<td>Legal Name Change</td>
<td>Contact Information</td>
</tr>
<tr>
<td>Initiate (No Show (Web Service))</td>
<td>No Show</td>
<td>Staffing</td>
</tr>
<tr>
<td>Initiate (Change Personal Information (Web Service))</td>
<td>Personal Information Change</td>
<td>Personal Data</td>
</tr>
<tr>
<td>Initiate (Request Leave of Absence (Web Service))</td>
<td>Request Leave of Absence</td>
<td>Time Off and Leave</td>
</tr>
<tr>
<td>Initiate (Enter Time off (Web Service))</td>
<td>Request Time Off</td>
<td>Time Off and Leave</td>
</tr>
</tbody>
</table>
### Operation | Business Process Type | Functional Area
--- | --- | ---
Initiate (Terminate Employee (Web Service)) | Termination | Staffing

**Note:** Ensure that the business process security policies are activated for the security group.

**Note:** If you have installed Workday HR spoke v1, uninstall it and install the Workday HR spoke v1.1.

Workday REST and Report-as-a-Service (RAAS) API works with OAuth 2.0 to authorize access to resources in your Workday tenant. To use OAuth 2.0, you must register your client in the tenant, using the Register API Client task.

Record and save these values while registering your client:

- Client ID
- Client Secret
- Workday REST API Endpoint
- Token Endpoint
- Authorization Endpoint

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - SOAP (com.glide.hub.action_step.soap)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow Flow Designer - Dynamic Outputs (com.glide.hub.dynamic_outputs)
- Complex Object (com.glide.cobject)
- System Import Data Source (glide.system_import_data_source)

**Note:** Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.
Spoke flows
The Workday HR spoke provides a sample flow, Verify User Sample Flow that demonstrates automating the Workday HR tasks. This flow calls the subflow with the same name to verify if the user who raised request is a valid user in Workday system. To customize a sample flow, copy it to a new application scope.

Spoke subflows
The Workday HR spoke provides sample subflows to demonstrate automating Workday HR tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify User Subflow</td>
<td>Verifies if the user who raised request is a valid user in Workday system.</td>
</tr>
<tr>
<td>Get WID For Worker</td>
<td>Retrieves WID details of the employee using the Look up Worker Profile action.</td>
</tr>
<tr>
<td>Create User</td>
<td>Creates a user in the ServiceNow when the user is onboarded in the Workday system. To use this subflow, you should Set up webhook for your Workday HR spoke.</td>
</tr>
</tbody>
</table>

Spoke actions
The Workday HR spoke provides actions to automate Workday tasks when events occurs in your ServiceNow instance. Available actions include:
Note: These spoke actions use the Workday REST API and require you to perform the configurations mentioned in Configurations to use Workday REST API:

- Get My Reporting Structure
- Look up Object Custom Fields
- Update Object Custom Fields
- Look up Payslip
- Look up Total Rewards Using Report
- Look up Custom Reports
- Look up Inbox Items
- Look up Merit And Benefit Plan Details Of An Employee
- Look up Holiday Calendars Reference WID Of An Employee
- Look up Schedule Calendars Reference WID Of An Employee
- Look up Holiday Calendars Of An Employee

All other actions use the Workday SOAP web services and require you to perform the configurations mentioned in Configurations to use Workday SOAP web services.

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absence Management</td>
<td>Get Time off Balances By Employee ID</td>
<td>Retrieves details of the time off plan balance for the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Look up Time Off Balance</td>
<td>Retrieves details of the time off balance, based on the provided filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Request Leave Of Absence</td>
<td>Creates a long leave absence request or updates an existing request.</td>
</tr>
<tr>
<td></td>
<td>Request Time Off</td>
<td>Creates a short term leave request.</td>
</tr>
<tr>
<td>Benefits Administration</td>
<td>Add Dependent</td>
<td>Adds a dependent to the specified worker.</td>
</tr>
<tr>
<td></td>
<td>Change Beneficiaries</td>
<td>Updates beneficiary details of the specified worker.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cash Management</td>
<td>Update Direct Deposit Information</td>
<td>Updates details of the current payment elections.</td>
</tr>
<tr>
<td>Custom Actions</td>
<td>Look up Object Custom Fields</td>
<td>Retrieves data relevant to the specified custom object.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To use these action,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>you must create a record in the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Workday Custom Objects</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[x_snc_sn_workday_s_workday_custom_objects]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Look up Custom Reports</td>
<td>Retrieves the custom reports.</td>
</tr>
<tr>
<td></td>
<td>Update Object Custom Fields</td>
<td>Updates fields in the specified custom object.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This action uses the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Workday REST API and requires you</td>
<td></td>
</tr>
<tr>
<td></td>
<td>to perform the configurations</td>
<td></td>
</tr>
<tr>
<td></td>
<td>mentioned in Configurations to use Workday REST API.</td>
<td></td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get Additional Workday Fields</td>
<td>Retrieves all additional fields for each action.</td>
</tr>
<tr>
<td></td>
<td>Get Custom Dynamic Input Fields</td>
<td>Retrieves all custom dynamic input fields.</td>
</tr>
<tr>
<td></td>
<td>Get Custom Dynamic Output Fields</td>
<td>Retrieves all custom dynamic output fields.</td>
</tr>
<tr>
<td></td>
<td>Get Object For Custom Dynamic Fields</td>
<td>Retrieves object for the specified custom dynamic field.</td>
</tr>
<tr>
<td></td>
<td>Get Parent Object For</td>
<td>Retrieves parent object for the specified custom dynamic field.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Custom Dynamic Fields</td>
<td>Get Reference ID List</td>
<td>Retrieves values of the Reference ID, based on its reference type.</td>
</tr>
<tr>
<td></td>
<td>Get References WID</td>
<td>Retrieves reference IDs for the specified reference type.</td>
</tr>
<tr>
<td>Payroll Management</td>
<td>Get My Tax Withholding Information Canada By Employee ID</td>
<td>Retrieves all types of income withholding orders from Canada for the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Get My Tax Withholding Information US By Employee ID</td>
<td>Retrieves all types of income withholding orders from US for the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Get Payroll Federal W4 Tax Elections By Employee ID</td>
<td>Retrieves federal W-4 tax election data for the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Get Payroll Payee FUTAs By Employee ID</td>
<td>Retrieves FUTA tax election data for the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Get Payroll USA And Local Tax Elections By Employee ID</td>
<td>Retrieves information about the tax elections for state and local tax authorities, for the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Look up Direct Deposit Information Details</td>
<td>Retrieves information about the specified payee, who belong to an external pay group.</td>
</tr>
<tr>
<td></td>
<td>Look up Payroll Federal W4 Tax Elections</td>
<td>Retrieves the federal W-4 tax election details for the required employees, based on the provided filter criteria.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up Payroll Payee FUTAs Details</td>
<td>Retrieves the payroll payee FUTA details for the required employees, based on the provided filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Payroll Results</td>
<td>Retrieves payroll results for the required employees, based on the provided filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Payroll USA And Local Tax Elections</td>
<td>Retrieves details of worker tax elections for state and local tax authorities for the required employees, based on the provided filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Tax Elections Ongoing Work Jurisdiction Details</td>
<td>Retrieves details of the ongoing work jurisdiction tax election for the required employees, based on the provided filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Tax Withholding Information Details Canada</td>
<td>Retrieves all types of income withholding orders from Canada for the required employees, based on the provided filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Payslip</td>
<td>Retrieves payslip details of the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Look up Tax Withholding Information Details US</td>
<td>Retrieves all types of income withholding orders from US for the required employees, based on the provided filter criteria.</td>
</tr>
<tr>
<td>Resource Management</td>
<td>Change Legal Name</td>
<td>Changes or sets the legal name for the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Change Personal Information</td>
<td>Changes the personal information of the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Get Employee Documents By Employee ID</td>
<td>Retrieves documents of the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Get My Compensation</td>
<td>Retrieves the compensation details of the specified employee.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Details By Employee ID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Get My Contact Details By Employee ID</td>
<td>Retrieves contact information of the specified employee such as, address, phone number, email address, and beneficiaries.</td>
</tr>
<tr>
<td></td>
<td>Get My Org Structure By Employee ID</td>
<td>Retrieves details of the org structure for the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Get My Reporting Structure</td>
<td>Retrieves details of the reporting structure for the specified employee.</td>
</tr>
<tr>
<td>Note:</td>
<td></td>
<td>This action uses the Workday REST API and requires you to perform the configurations mentioned in Configurations to use Workday REST API.</td>
</tr>
<tr>
<td></td>
<td>Get Total Benefit Enrollments By Employee ID</td>
<td>Retrieves details of the benefit enrollments for the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Get Total Rewards By Employee ID</td>
<td>Retrieves details of the total rewards for the specified employee.</td>
</tr>
<tr>
<td></td>
<td>Look up Compensation Details</td>
<td>Retrieves compensation details for the required employees, based on filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Contact Details</td>
<td>Retrieves contact details for the required employees such as, address, phone number, email address, and beneficiaries, based on filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Employee Documents</td>
<td>Retrieves documents of the required employees, based on the filter criteria.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up Holiday Calendars</td>
<td>Retrieves the details of the holiday calendars.</td>
</tr>
<tr>
<td></td>
<td>Look up Holiday Calendars Of An Employee</td>
<td>Retrieves details of the holiday calendar for the specified employee.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This action uses the Workday REST API and requires you to perform the configurations mentioned in Configurations to use Workday REST API.</td>
</tr>
<tr>
<td></td>
<td>Look up Holiday Calendars Reference WID Of An Employee</td>
<td>Retrieves details of the holiday calendar WID for the specified employee.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This action uses the Workday REST API and requires you to perform the configurations mentioned in Configurations to use Workday REST API.</td>
</tr>
<tr>
<td></td>
<td>Look up Inbox Items</td>
<td>Retrieves inbox items from Workday for the specified date range.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This action uses the Workday REST API and requires you to perform the configurations mentioned in Configurations to use Workday REST API.</td>
</tr>
<tr>
<td></td>
<td>Look up Job Profiles</td>
<td>Retrieves details of the job profile, based on the specified criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Location Details</td>
<td>Retrieves location details, based on the specified criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Merit And Benefit Plan Details Of An Employee</td>
<td>Retrieves details of merit and benefit plan for the required employees, based on the provided filter criteria.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Look up Organizations</td>
<td>Retrieves details of the organizations, based on the provided filter criteria.</td>
<td></td>
</tr>
</tbody>
</table>
| Look up Schedule Calendars Reference WID Of An Employee | Retrieves work schedule calendars for the required employees.  

**Note:** This action uses the Workday REST API and requires you to perform the configurations mentioned in Configurations to use Workday REST API. |
<p>| Look up Timesheet Details | Retrieves details of the timesheets, based on the provided filter criteria. |
| Look up Total Benefit Enrollments | Retrieves details of the benefit enrollments, based on the provided filter criteria. |
| Look up Total Rewards | Retrieves details of the employee rewards, based on the provided filter criteria. |
| Look up Total Rewards using Report | Retrieves the total rewards for the specified report owner and report. |
| Look up Work Schedule Calendars | Retrieves details of the work schedule calendars. |
| Look up Worker Profile | Retrieves details of the employee profiles, based on worker type. |
| Look up Workers | Retrieves details such as, first name, last name, address, phone number, |</p>
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>email address, instant messenger, worker position, and management chain, based on the provided filter criteria.</td>
</tr>
<tr>
<td>Look up Workers</td>
<td>Employment Data</td>
<td>Retrieves details such as, position, position organizations, position management chains and worker status, based on the provided filter criteria.</td>
</tr>
<tr>
<td>Update My Address</td>
<td></td>
<td>Updates employees details such as, address, phone number, email address, instant messenger, and web address.</td>
</tr>
<tr>
<td>Staffing</td>
<td>Change Organization</td>
<td>Assigns values for company, cost center, region and so on that are configured for staffing usage to a filled position.</td>
</tr>
<tr>
<td></td>
<td>Change Roles</td>
<td>Changes roles of the specified employee.</td>
</tr>
<tr>
<td></td>
<td>No Show</td>
<td>Rescinds the hiring process if a hired employee doesn’t show on joining date.</td>
</tr>
<tr>
<td></td>
<td>Offboard Employee</td>
<td>Offboards the specified employee.</td>
</tr>
<tr>
<td>Time Tracking</td>
<td>Update Reported Time Blocks</td>
<td>Updates details of reported time blocks.</td>
</tr>
</tbody>
</table>

**Spoke modules**

The Workday HR spoke adds the Workday application to your instance and includes these modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Details</td>
<td>Contains information about the base URL of the Workday instance or tenant, and API version.</td>
</tr>
<tr>
<td>Module</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Custom Objects</td>
<td>To use the custom actions, create a record in the Custom Objects module and provide these details:</td>
</tr>
<tr>
<td></td>
<td>• Parent Object WS Alias</td>
</tr>
<tr>
<td></td>
<td>• Extension Object WS Alias</td>
</tr>
<tr>
<td></td>
<td>• Extension Object Fields</td>
</tr>
<tr>
<td></td>
<td>• Extension Object Field Data Type</td>
</tr>
<tr>
<td></td>
<td>• Field Type</td>
</tr>
<tr>
<td>Get My Holiday Calendar</td>
<td>Sample remote table that you should customise to retrieve details of the holiday calendar for the logged in employee. From the Get My Holiday Calendar remote table definition, the Get My Holiday Calendar action is called to retrieve the data.</td>
</tr>
<tr>
<td>Get Payroll Results</td>
<td>Sample remote table that you should customise to retrieve the payroll information. From the Get Payroll Results remote table definition, the Look up Payroll Results action is called to retrieve the data.</td>
</tr>
<tr>
<td>RAAS Report Access Details</td>
<td>To use actions based on Workday Report as a Service API, create a record in the RAAS Report Access Details module and provide details of the ServiceNow user along with the Workday report owner name and Workday report name. Ensure that the user is entitled to access these reports. Create a record and fill in these values:</td>
</tr>
<tr>
<td></td>
<td>• <strong>User ID</strong>: User ID of the ServiceNow user, who is entitled to access the required reports.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Report Name</strong>: Name of the RAAS API while configuring it in Workday system.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Report Owner Username</strong>: Username of the RAAS owner.</td>
</tr>
<tr>
<td>Remote Table Configurations</td>
<td>An entry of column and table name that consists of Workday employee ID of the logged in user should be made into this table. For example, Employee Number column of the User Table. That is, <strong>Table Name</strong> is <code>sys_user</code> and <strong>Field Name</strong> is <code>employee_number</code>.</td>
</tr>
</tbody>
</table>
Module | Description
---|---
View My Direct Deposit Information | Sample remote table that you should customise to retrieve the direct deposit information. From the View My Direct Deposit Information remote table definition, the Look up Direct Deposit Information Details action is called to retrieve the data.
View My Total Rewards | Sample remote table that you should customise to retrieve the total rewards for a logged in employee. From the View My Total Rewards remote table definition, the Look up Total Rewards action is called to retrieve the data.
View Time Off Balance | Sample remote table that you should customise to retrieve the time off balance for a logged in employee. From the View Time Off Balance remote table definition, the Look up Time Off Balance action is called to retrieve the data.
Webhook Registry | Contains records of webhooks registries. Admin should create record here to Set up webhook for your Workday HR spoke for the required Workday HR event.

Note: Ensure that you provide the internal name of the table and field.

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the Workday HR spoke
Integrate the ServiceNow instance Workday instance by using the OAuth 2.0 to authenticate ServiceNow requests.

Before you begin
- Request an IntegrationHub subscription.
- Activate Workday HR spoke.
- Role required: admin
Configurations to use Workday SOAP web services

Configure your ServiceNow instance to perform actions that use the Workday SOAP web services.

About this task
Most actions use the Workday SOAP web services and require you to perform the configurations mentioned in this section. You don’t need to configure Workday REST API, unless you intend to use these spoke actions:

- Get My Reporting Structure
- Look up Object Custom Fields
- Update Object Custom Fields
- Look up Payslip
- Look up Total Rewards Using Report
- Look up Custom Reports
- Look up Inbox Items
- Look up Merit And Benefit Plan Details Of An Employee
- Look up Holiday Calendars Reference WID Of An Employee
- Look up Schedule Calendars Reference WID Of An Employee
- Look up Holiday Calendars Of An Employee

Provide the Workday HR base URL

Provide the base URL of your Workday HR instance in the Connection Details [connection_details] table. Spoke actions based on the SOAP API, use these details for the action execution.

Procedure

1. Navigate to System Definition > Tables.
2. Filter and search for the Connection Details table.
3. Click the Show List related list.
4. Click New.
5. On the form, fill these values.
Connection Details form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base URL</td>
<td>Base URL of the Workday instance or tenant name.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the API. For example, enter v33.2.</td>
</tr>
<tr>
<td>Webservice Type</td>
<td>Type of web service. Select SOAP.</td>
</tr>
</tbody>
</table>

6. Click Save.

Create a WS-Security Username Profile for the Workday HR spoke

Create a WS-Security Username Profile to provide your Workday credentials to authenticate requests from ServiceNow.

Procedure

1. Navigate to IntegrationHub > SOAP Integrations > WS-Security Username Profiles.
2. Click New.
3. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify this credential. For example, enter WorkdayHR User.</td>
</tr>
<tr>
<td>Application</td>
<td>Application in which the record is applicable. Select Workday HR Spoke.</td>
</tr>
<tr>
<td>Username</td>
<td>Workday user who has integration rights using Workday Web Services.</td>
</tr>
<tr>
<td>Password</td>
<td>Password of the Workday user.</td>
</tr>
</tbody>
</table>

4. Click Save.

Configure the SOAP security policy for the Workday HR spoke

Configure the SOAP security profile by adding the security user name profile you had created to authenticate requests from ServiceNow.
Procedure

1. Navigate to IntegrationHub > SOAP Integrations > SOAP Security Policies.

2. Open the record for the Workday HR spoke. For example, WorkdayHR.

   **Note:** If you intend to use another SOAP security policy record and not the default record, you must ensure that you select that record in all the actions that use Workday SOAP web services.

   ![Image showing SOAP security policy settings]

   Except these listed actions, all other actions use Workday SOAP web services:
   - Get My Reporting Structure
   - Look up Object Custom Fields
   - Update Object Custom Fields
   - Look up Payslip
   - Look up Total Rewards Using Report
   - Look up Custom Reports
   - Look up Inbox Items
   - Look up Merit And Benefit Plan Details Of An Employee
   - Look up Holiday Calendars Reference WID Of An Employee
   - Look up Schedule Calendars Reference WID Of An Employee
   - Look up Holiday Calendars Of An Employee

3. For **WS-Security Username Profile**, select the security username profile you had created for the Workday HR spoke. See [Create a WS-Security Username Profile for the Workday HR spoke](#) for more information.

4. Do not provide value in **WS-Security X.509 Profile**.

5. Right-click the form header and click **Save**.
Configurations to use Workday REST API

Configure your ServiceNow instance to perform actions that use the Workday REST API.

About this task
Configure your ServiceNow instance to use the Workday REST API only if you need to use these actions:

• Get My Reporting Structure
• Look up Object Custom Fields
• Update Object Custom Fields
• Look up Payslip
• Look up Total Rewards Using Report
• Look up Custom Reports
• Look up Inbox Items
• Look up Merit And Benefit Plan Details Of An Employee
• Look up Holiday Calendars Reference WID Of An Employee
• Look up Schedule Calendars Reference WID Of An Employee
• Look up Holiday Calendars Of An Employee

Register Workday HR as an OAuth provider
Register the Workday HR instance as the OAuth provider so that the ServiceNow instance can request OAuth 2.0 tokens.

Procedure
1. Navigate to System OAuth > Application Registry.
2. Click New.
   The system displays this message: What kind of OAuth application?.
3. Select Connect to a third party OAuth Provider.
4. On the form, fill these values.

   Application Registries form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter: Workday HR OAuth</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Application</td>
<td>Application in which the record is applicable. Select <strong>Workday HR Spoke</strong>.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID generated while registering your client.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client secret generated while registering your client.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>Authorization endpoint generated while registering your client.</td>
</tr>
<tr>
<td>Token URL</td>
<td>Token endpoint generated while registering your client.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint in this format: https://&lt;instance&gt;.service-now.com/oauth_redirect.do</td>
</tr>
<tr>
<td>Default Grant Type</td>
<td>Grant type used to establish the token. Select <strong>Authorization Code</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
</tbody>
</table>

5. Right-click the form header, and click **Save**. An OAuth entity profile is created.

**Create a credential record for the Workday HR spoke**

Create a credential record for the Workday HR instance. The Workday HR spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to **Connections & Credentials > Credentials**.

2. Click **New**.

The system displays this message: What type of Credentials would you like to create?

3. Select **OAuth 2.0 Credentials**.

4. On the form, fill these values.

**OAuth 2.0 Credentials form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Workday HR Cred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
OAuth Entity Profile | OAuth entity profile created during the registration of Workday HR as an OAuth provider. For example, OAuth Profile.

5. Right-click the form header and click **Submit**.

6. To generate the OAuth token, click the **Get OAuth Token** related link.

### Create a connection record for the Workday HR spoke

Create a connection record for your Workday HR instance. The Workday HR spoke connection and credential aliases use these connections to perform actions in Workday HR.

**Procedure**

1. Navigate to **Connections & Credentials > Connections & Credentials Aliases**.
2. Open the alias record, **WorkdayHR**.
3. From the **Connections** tab, click **New**.
4. On the form, fill these fields.

   **Note:** Ensure that you create the connection record in the **Workday HR Spoke** application.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, <strong>Workday HR Connection</strong>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Workday HR spoke. For example, <strong>Workday HR Cred</strong>.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL to connect to your Workday HR instance.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection record.</td>
</tr>
</tbody>
</table>

5. In the **Attributes** tab, fill in these values.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Set up webhook for your Workday HR spoke

Retrieve details the required employees in the Workday HR application to your ServiceNow instance by setting up the webhooks.

Before you begin
- Set up the Workday HR spoke
- Role required: admin

Generate user name and password in your ServiceNow instance

Generate user name and password in your ServiceNow instance to authenticate requests and retrieve the required data from the Workday application.

Procedure

1. Navigate to System Definition > Table.
2. Filter and search for the Workday HR spoke webhook registry table. For example, Workday Webhook Registry.
3. Click the Show List related list.
4. Click New.
5. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Description of the webhook registry record. Enter Workday event and authentication for Create User.</td>
</tr>
<tr>
<td>UserName</td>
<td>Workday user who has integration rights using Workday Web Services.</td>
</tr>
<tr>
<td>Password</td>
<td>Password of the Workday user.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Workday Event</td>
<td>Event for which the webhook is set up. Enter CreateUser.</td>
</tr>
<tr>
<td>Workday Instance</td>
<td>Base URL of the Workday instance or tenant name.</td>
</tr>
</tbody>
</table>

6. Right-click the form header and click **Save**.

7. Click **Generate UserName And Password**.

Copy and record the values of username and password. These values must be specified in the Workday instance to authenticate the webhook requests.

**Retrieve the resource path from your ServiceNow instance**

Retrieve the resource path from your ServiceNow instance for later use to authenticate requests and retrieve the required data from the Workday application.

**Procedure**

1. Navigate to **System Web Services > Scripted Web Services > Scripted REST APIs**.
2. Open the record for the Workday HR spoke.
3. In the **Resources** tab, click the **Callback** record.
4. Record and save the value of **Resource path** for later use.

**Import CLAR file to your Workday instance**

Import CLAR file available at ServiceNow Store to set up webhooks and authenticate requests from ServiceNow instance.

**Before you begin**

- Workday Studio should be installed.
- Access to custom report creation policy.
  Create custom report in workday based on the New_Hire_record report structure and share the report with ISU user.
- Access to edit business process definition.
- Access to create and edit integration system.
- Role required: admin
Note: Except integration name, report field XPath (if required), and Workday instance header, users are cautioned against modifying the values of fields or properties in the CLAR file.

Procedure
1. From the Workday HR spoke page on ServiceNow Store, download the Workday-HR-Webhook-Studio-Sample file from Supporting Links and Docs.
2. Unzip the sample file to obtain the CLAR file.
3. Import the CLAR file to Workday Studio.
4. In the Properties tab of the StartHere component, navigate to Services and select the RAAS report created for this webhook.
5. Choose the environment where your report exists such as, implementation or sandbox and configure the report as per your requirement.
6. Provide a report name and select the required report.
7. Provide the alias name of the report.

8. After the report alias is added, add the selected path of report in **Extra Path** that is used to run the report based on prompt.
9. In the **Set Headers** component, provide your Workday instance for the **WorkdayInstance** header.

10. In the properties of **HttpOut**, fill in these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint</td>
<td>REST endpoint</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>See Retrieve the resource path from your ServiceNow instance for more information.</td>
</tr>
<tr>
<td>Http Method</td>
<td>POST</td>
</tr>
</tbody>
</table>

11. Save the changes.
12. In the project explorer, select the integration and deploy it in your Workday system.

13. Log in to your Workday instance and navigate to **Integration > Integration System > Configure Integration Attributes**.

14. Provide user name and password in **Configure Integration Attributes** that you have generated in **Generate user name and password in your ServiceNow instance**.

15. Modify a business process and add this integration in your business process.
a. Edit definition of the business process.

b. Select the effective date and click Ok.

c. Click the + sign and add a new business process step in BP.

d. Select an order, which is after the completion step of business process.

e. Add the business process and select Type as Integration.

f. Provide ISU username in Run as User and click Ok.

g. Click Configure Integration on the newly added business process step in Hire BP.
h. In integration criteria, select value type as **Determine value at runtime** and select value as **Employee ID**.

Selected **Employee ID** field in value is displayed.

i. Click **Ok**.

j. Create a report for the webhook with these details:

   Report definition:
### Report Definition: New_Hire_record

<table>
<thead>
<tr>
<th>Report Name</th>
<th>New_Hire_record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Type</td>
<td>Advanced</td>
</tr>
<tr>
<td>Data Source</td>
<td>All Workers</td>
</tr>
<tr>
<td>Data Source Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Primary Business Object</td>
<td>Worker</td>
</tr>
</tbody>
</table>

### Column labels:

<table>
<thead>
<tr>
<th>Business Object</th>
<th>Field</th>
<th>Column Heading</th>
<th>Column Heading Overside XML Alias</th>
<th>Format</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worker</td>
<td>Employee ID</td>
<td>Employee_ID</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>First Name</td>
<td>First_Name</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>Middle Name</td>
<td>Middle_Name</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>Last Name</td>
<td>last_Name</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>Gender</td>
<td>Gender</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>Email - Work</td>
<td>Email</td>
<td>Email_Work</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>Preferred Language</td>
<td>Language</td>
<td>Language</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>Supervisory Organization</td>
<td>Department</td>
<td>Department</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>Business Title</td>
<td>Business_Title</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>Organization Roles</td>
<td>Organization_Roles</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>Manager - Level 01</td>
<td>Manager</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>Company</td>
<td>Company</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>Location</td>
<td>Location</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>Work Address - City</td>
<td>City</td>
<td>City</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Primary Work Address</td>
<td>City</td>
<td>City</td>
<td>Country</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>CF_Street</td>
<td>Street</td>
<td>Street</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>Primary Address - State/Province</td>
<td>State</td>
<td>State</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>Work Address - Postal Code</td>
<td>Postal Code</td>
<td>Work_Address - _Postal_Code</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>Mobile Phone Number</td>
<td>Mobile_Phone_Number</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>Phone - Primary Work</td>
<td>Phone</td>
<td>Business_Phone</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>User Name</td>
<td>User_Name</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Worker</td>
<td>Termination History - Approved</td>
<td>Termination_History - _Approved</td>
<td>effective</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Calculated field details:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Business Object</th>
<th>Calculation</th>
<th>Additional Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>CF_Street</td>
<td>Worker</td>
<td>Concatenates a series of text fields together.</td>
<td></td>
</tr>
</tbody>
</table>

Field Name:
- Work Address - Formatted Line
- Work Address - Formatted Line 2
Filter and prompt details:

Workplace from Facebook v3.0.3
Manage users, groups, and notifications in Workplace from Facebook account from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Note: Workplace from Facebook is compatible with ServiceNow version, Paris with Patch 3 and later.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

⚠️ Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Spoke subflows
The Workplace from Facebook spoke provides a sample subflow, Fetch Workplace from Facebook Groups that demonstrates automating group management tasks. To customize the sample flow, copy it to the required application scope.

Spoke actions
The Workplace from Facebook spoke provides actions to manage users, groups, and notifications. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Management</td>
<td>Add User To Group</td>
<td>Adds a user to a group in Workplace from Facebook.</td>
</tr>
<tr>
<td></td>
<td>Create Group</td>
<td>Creates a group in Workplace from Facebook.</td>
</tr>
<tr>
<td></td>
<td>Deactivate Groups</td>
<td>Deactivates groups that have not been updated during the last execution of the Fetch Workplace from Facebook Groups subflow.</td>
</tr>
<tr>
<td></td>
<td>Lookup Group ID</td>
<td>Retrieves the group ID for a given group name in Workplace from Facebook.</td>
</tr>
<tr>
<td></td>
<td>Lookup Groups</td>
<td>List all groups in Workplace from Facebook.</td>
</tr>
<tr>
<td></td>
<td>Remove User From Group</td>
<td>Removes a user from a group in Workplace from Facebook.</td>
</tr>
<tr>
<td>Group Post Management</td>
<td>Post Message</td>
<td>Posts a message to a Workplace from Facebook group.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Post Picture</td>
<td>Posts an image and message to a Workplace from Facebook group.</td>
</tr>
<tr>
<td></td>
<td>Post Change</td>
<td>Posts change request details in a Workplace from Facebook group.</td>
</tr>
<tr>
<td></td>
<td>Incident Details</td>
<td>Posts incident details in a Workplace from Facebook group.</td>
</tr>
<tr>
<td></td>
<td>Problem Details</td>
<td>Posts problem details in a Workplace from Facebook group.</td>
</tr>
<tr>
<td>User Management</td>
<td>Lookup User ID</td>
<td>Retrieves the user ID from a registered email in Workplace from Facebook.</td>
</tr>
<tr>
<td>Message Management</td>
<td>Send Change</td>
<td>Sends change details to user in a Workplace from Facebook group.</td>
</tr>
<tr>
<td></td>
<td>Image</td>
<td>Sends an image or file to users in Workplace from Facebook.</td>
</tr>
<tr>
<td></td>
<td>Incident Details</td>
<td>Sends incident details to user in a Workplace from Facebook group.</td>
</tr>
<tr>
<td></td>
<td>Message</td>
<td>Sends messages to users in Workplace from Facebook.</td>
</tr>
<tr>
<td></td>
<td>Problem Details</td>
<td>Sends problem details to user in a Workplace from Facebook group.</td>
</tr>
</tbody>
</table>

**Spoke modules**

The Workplace from Facebook spoke adds a Workplace from Facebook application to your ServiceNow instance and includes these modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credentials</td>
<td>Displays the credentials records created for the Workplace from Facebook spoke. You can create credential records as per</td>
</tr>
<tr>
<td>Module</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>your requirement. For example, a credential record for each Workplace from Facebook instance.</td>
<td></td>
</tr>
<tr>
<td>Install on your Workplace</td>
<td>Displays the default credential record to set up the Workplace from Facebook spoke. For more information, see Set up Workplace from Facebook spoke.</td>
</tr>
<tr>
<td>Groups Cache</td>
<td>Displays details of the groups in Workplace from Facebook. When you click Synchronise Cache, the Fetch Workplace from Facebook Groups subflow is triggered and the groups details are retrieved.</td>
</tr>
</tbody>
</table>

**Set up Workplace from Facebook spoke**

Integrate the ServiceNow instance and your Workplace from Facebook account using the Workplace from Facebook credentials to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription
- Activate the Workplace from Facebook spoke
- Role required: admin

**Procedure**

1. Navigate to **Workplace from Facebook > Install on your Workplace**.
2. Click **Install on your Workplace**.
   
   You will redirected to the **Workplace sign-up/sign-in page**.
3. Log in to your Workplace from Facebook account using your credentials.
   
   Add ServiceNow Spoke to Workplace pop-up window is displayed.
4. Click **Add to Workplace**.
The ServiceNow spoke is added to Workplace account and a confirmation message is displayed.

Successfully installed ServiceNow Spoke on your Workplace.
5. Click **Done**.
   You will be redirected back to your ServiceNow instance and the relevant fields are updated.

**Results**
The Workplace from Facebook account is integrated with your ServiceNow instance.

**Wrike spoke**
Manage approvals, attachments, folders, projects, and so on, in the Wrike account from your ServiceNow instance.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**
This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Supported versions**
This spoke was built for Wrike API version v4, but may be compatible with later versions.

ℹ️ **Note:** You must have the Wrike Enterprise account to create an app and obtain values of Client ID and Client Secret from the Wrike account.

**Spoke dependencies**
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
† Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke actions**

The Wrike spoke provides actions to automate Wrike tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approvals Management</td>
<td>Create Approval for Folder</td>
<td>Creates an approval for the specified folder or project.</td>
</tr>
<tr>
<td></td>
<td>Create Approval for Task</td>
<td>Creates an approval for the specified folder task.</td>
</tr>
<tr>
<td></td>
<td>Delete Approval</td>
<td>Cancels the specified approval.</td>
</tr>
<tr>
<td></td>
<td>Look up Approvals</td>
<td>Retrieves details of the approvals based on the filter criteria.</td>
</tr>
<tr>
<td></td>
<td>Look up Approvals by Folder</td>
<td>Retrieves all approvals on the specified folder or project.</td>
</tr>
<tr>
<td></td>
<td>Look up Approvals by Task</td>
<td>Retrieves all approvals on the specified task.</td>
</tr>
<tr>
<td></td>
<td>Update Approval</td>
<td>Updates details of the specified approval.</td>
</tr>
<tr>
<td>Attachment Management</td>
<td>Delete Attachment</td>
<td>Deletes the specified attachment.</td>
</tr>
<tr>
<td></td>
<td>Download Attachment to ServiceNow</td>
<td>Downloads attachment to the specified ServiceNow record.</td>
</tr>
<tr>
<td></td>
<td>Look up Attachments</td>
<td>Retrieves list of attachments.</td>
</tr>
<tr>
<td></td>
<td>Update Attachment</td>
<td>Updates a previously uploaded attachment with the new version.</td>
</tr>
<tr>
<td></td>
<td>Update Attachment to Folder</td>
<td>Uploads an attachment to the specified folder.</td>
</tr>
<tr>
<td></td>
<td>Update Attachment to Task</td>
<td>Adds an attachment to a task record.</td>
</tr>
<tr>
<td>Comment Management</td>
<td>Create Comment in Folder</td>
<td>Creates a comment in the folder.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Create Comment in Task</td>
<td>Creates comment in task.</td>
</tr>
<tr>
<td></td>
<td>Delete Comment</td>
<td>Deletes the specified comment.</td>
</tr>
<tr>
<td></td>
<td>Look up Comments by Folder ID</td>
<td>Retrieves the folder comments.</td>
</tr>
<tr>
<td></td>
<td>Look up Comments by Task ID</td>
<td>Retrieves the task comments.</td>
</tr>
<tr>
<td></td>
<td>Update Comment</td>
<td>Updates the specified comment.</td>
</tr>
<tr>
<td>Folder and Project</td>
<td>Create Folder</td>
<td>Creates a folder within a folder.</td>
</tr>
<tr>
<td>Management</td>
<td>Create Project</td>
<td>Creates a project within a folder.</td>
</tr>
<tr>
<td></td>
<td>Delete Folder or Project</td>
<td>Moves folder, project and all descendant folders and tasks to Recycle Bin unless they have parents outside of deletion scope.</td>
</tr>
<tr>
<td></td>
<td>Look up Folders</td>
<td>Retrieves the list of entries required to build a folder tree for the current account.</td>
</tr>
<tr>
<td></td>
<td>Update Folder</td>
<td>Updates details of the folder.</td>
</tr>
<tr>
<td></td>
<td>Update Project</td>
<td>Updates details of the project.</td>
</tr>
<tr>
<td>Group Management</td>
<td>Create Group</td>
<td>Creates group in account.</td>
</tr>
<tr>
<td></td>
<td>Delete Group</td>
<td>Deletes the specified group.</td>
</tr>
<tr>
<td></td>
<td>Look up Groups</td>
<td>Retrieves all groups in the account.</td>
</tr>
<tr>
<td></td>
<td>Update Group</td>
<td>Updates details of the specified group.</td>
</tr>
<tr>
<td>Task Management</td>
<td>Create Task</td>
<td>Creates a task in folder.</td>
</tr>
<tr>
<td></td>
<td>Delete Task</td>
<td>Deletes the specified task.</td>
</tr>
<tr>
<td></td>
<td>Look up Tasks</td>
<td>Retrieves details of all tasks in current account.</td>
</tr>
<tr>
<td></td>
<td>Update Task</td>
<td>Updates details of the specified task.</td>
</tr>
<tr>
<td>User Management</td>
<td>Get User Details</td>
<td>Retrieves information about the specified user.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up Contacts</td>
<td>Retrieves contacts of all users and user groups in the current account.</td>
</tr>
<tr>
<td></td>
<td>Update User Details</td>
<td>Updates details of the specified user.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Connections and Credentials](#).

**Set up the Wrike spoke**

Integrate the ServiceNow instance and Wrike account by creating a custom OAuth application in Wrike API Developer Portal to authenticate ServiceNow requests.

**Before you begin**

Role required: admin

**Procedure**

1. Log in to [Wrike account](#) as an admin and add an app. For more information about creating an app, see [OAuth 2.0 Authorization](#). Copy and record the values of **Client ID** and **Client Secret** for later use.

   - **Note:** You must have the Wrike Enterprise account to create an app and obtain values of Client ID and Client Secret from the Wrike account.

2. Configure the default application registry.

   a. Navigate to [System OAuth > Application Registry](#).

   b. Open the record, **Wrike**.

   c. On the form, fill these values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Client ID of the app created in <a href="#">Wrike</a> account.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client secret of the app created in Wrike account.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>ServiceNow instance URL in this format: https://&lt;instance-name&gt;.service-now.com/oauth_redirect.do. Replace &lt;instance-name&gt; with your instance name.</td>
</tr>
</tbody>
</table>

**Note:** If you have provided additional scopes, create records for those scopes in the **OAuth Entity Scopes** tab. Enter the scopes separated by comma (,).

3. Create a credential record.

   a. Navigate to **Connections & Credentials > Credentials**.

   b. Click **New**.

      The system displays the message **What type of Credentials would you like to create?**.

   c. Select **OAuth 2.0 Credentials**.

   d. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. Enter Wrike Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
</tbody>
</table>
e. Right-click the form header and click Save.

4. Create a connection record.


b. Open for the record for Wrike.

c. From the Connections tab, click New. The system displays a blank HTTP(s) Connection form.

d. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. Enter Wrike Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Zoom. Select Wrike Credentials.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to your Wrike account. Enter <a href="https://www.wrike.com/api">https://www.wrike.com/api</a>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
e. Optional: In the Attributes tab, the default value of API Version is v4. If you are using different Wrike API version, specify the version number.

f. Click Submit.

The ServiceNow instance and Wrike account are integrated.

Vonage spoke v1.0.1
Manage communications through calls, SMS, and WhatsApp by using the Vonage account from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history.

IntegrationHub subscription
This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Supported versions
This spoke was built for Vonage for these versions, but may be compatible with later versions:
• Messages API version v0.1
• Voice API version v1

Spoke requirements
• Admin access to Vonage account and Vonage API Dashboard.
• Record the values of API key and API Secret. You can access these values from the Vonage API Dashboard. For more information, see the Authentication page in the Vonage API Developer documentation site.
• Record and save the value of the Signature Secret. You can access this value in the Account Settings in Vonage API Dashboard. For more information, see the Authentication page in the Vonage API Developer documentation site.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:
• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
• Complex Object (com.glide.cobject)
• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke subflows**

The Vonage spoke provides sample subflows to demonstrate automating Vonage tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vonage SMS Webhook</td>
<td>Processes the SMS requests from Vonage.</td>
</tr>
<tr>
<td>Vonage Voice Webhook</td>
<td>Processes the voice requests from Vonage.</td>
</tr>
<tr>
<td>Vonage WhatsApp Webhook</td>
<td>Processes the WhatsApp requests from Vonage.</td>
</tr>
</tbody>
</table>

To customize the default subflow, you must create a copy of the sample subflow and customize the subflow as per your requirement. While customizing subflows, you must ensure that the subflows are configured to avoid infinite loops.

**Spoke actions**

The Vonage spoke provides actions to automate Vonage tasks when events occur in your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Management</td>
<td>Get Account Balance</td>
<td>Retrieves the current balance of the Vonage account.</td>
</tr>
<tr>
<td>Call Management</td>
<td>Play DTMF tone into Call</td>
<td>Plays DTMF (Dual-tone multi-frequency) tones into an active call</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Attach Recording To ServiceNow</td>
<td>Attaches a call recording to the target ServiceNow record.</td>
</tr>
<tr>
<td></td>
<td>Record</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Create Outbound Call</td>
<td>Creates an outbound call to a phone number.</td>
</tr>
<tr>
<td></td>
<td>Generate NCCO</td>
<td>Constructs a Nexmo Call Control Objects (NCCO) that is used in Create an Outbound Call action.</td>
</tr>
<tr>
<td></td>
<td>Get Call Details</td>
<td>Retrieves the details of the specified call.</td>
</tr>
<tr>
<td></td>
<td>Look up Calls</td>
<td>Retrieves details of the specified calls.</td>
</tr>
<tr>
<td></td>
<td>Play Audio into Call</td>
<td>Plays an audio file into an active call.</td>
</tr>
<tr>
<td></td>
<td>Play Text to Speech into Call</td>
<td>Plays text-to-speech into an active call.</td>
</tr>
<tr>
<td></td>
<td>Stop Playing Audio into Call</td>
<td>Stops playing an audio file into an active call.</td>
</tr>
<tr>
<td></td>
<td>Stop Text to Speech In Call</td>
<td>Stops text-to-speech into an active call.</td>
</tr>
<tr>
<td></td>
<td>Update Call</td>
<td>Updates the status of an active call.</td>
</tr>
<tr>
<td>Number Management</td>
<td>Look up Your Own Numbers</td>
<td>Retrieves all the inbound numbers associated with the Vonage account.</td>
</tr>
<tr>
<td>SMS Management</td>
<td>Send SMS</td>
<td>Sends an SMS (Short Message Service) to a phone number.</td>
</tr>
<tr>
<td>WhatsApp Management</td>
<td>Send Contacts</td>
<td>Sends contacts to a WhatsApp number.</td>
</tr>
<tr>
<td></td>
<td>Send Location</td>
<td>Sends geographic coordinates of a location to a WhatsApp number.</td>
</tr>
<tr>
<td></td>
<td>Send Media Message</td>
<td>Sends a media message to a WhatsApp number.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Send Text Message</td>
<td>Sends a text message to a WhatsApp number.</td>
</tr>
<tr>
<td></td>
<td>Send Text Message Using Template</td>
<td>Sends a text message using the template to a WhatsApp number.</td>
</tr>
</tbody>
</table>

**Spoke module**

Bi-directional webhooks can be set up to be notified about the required events. Routing policy defines conditions that must be met to notify the ServiceNow instance. These conditions are based on the events in Vonage that you want to be notified about. When the conditions are met, routing policy triggers the associated subflow, which in turn automates the Vonage tasks. By default, the Vonage Spoke application is available and has the following modules:

- Vonage Webhook Registries
- Vonage WebHook Routing Policies

Use the Vonage Webhook Registries module to assign a token and provide the API path. You must generate a Callback URL here and provide this URL in Vonage. Default routing policies are provided as a reference in the Vonage WebHook Routing Policies module. Customize these routing policies as per your requirement. The routing policy supports these fields:

- Keywords
- Call Direction
- Call Status
- Event Type
- From
- SMS Status
- SMS Text
- To
- WhatsApp Message Status
- WhatsApp Text
- Show Related Fields

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the
connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Connections and Credentials.

Two connection and credential aliases are available along with the Vonage spoke:

<table>
<thead>
<tr>
<th>Vonage alias</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VonagePrimary</td>
<td>Required for the actions that manage SMS, number, and account.</td>
</tr>
<tr>
<td>Vonage</td>
<td>Required for the actions that manage calls and WhatsApp.</td>
</tr>
</tbody>
</table>

**Set up the Vonage spoke**

Integrate the ServiceNow instance and Vonage instance by using the API credentials to authenticate ServiceNow requests.

**Before you begin**

- Request IntegrationHub subscription.
- Activate Vonage spoke.
- Role required: admin

**Configure the default connection and credential alias records**

Configure the default alias records for your Vonage account. The Vonage spoke connection and credential aliases use these connections to perform the actions in Vonage account.

**Procedure**

1. **Navigate to** Connections & Credentials > Connections & CredentialsAliases.
2. **Open the alias record**, VonagePrimary.
3. **Click the Create New Connection & Credential** related link.
4. **On the form, fill these fields.**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Vonage Primary Connection.</td>
</tr>
</tbody>
</table>
5. Click Create.

**Note:** Credential record isn’t required for the VonagePrimary alias.


7. Open the alias record, Vonage.

8. Click the Create New Connection & Credential related link.

9. On the form, fill these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Vonage Connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to your Vonage account. Enter: <a href="https://api.nexmo.com">https://api.nexmo.com</a></td>
</tr>
<tr>
<td>Message API Version</td>
<td>Version of the message API. Enter v0.1.</td>
</tr>
<tr>
<td>Voice API Version</td>
<td>Version of the voice API. Enter v1.</td>
</tr>
<tr>
<td>Credential Name</td>
<td>Name to uniquely identify the record. For example, Vonage Credential.</td>
</tr>
<tr>
<td>Application Name</td>
<td>Name to uniquely identify the application in your Vonage account.</td>
</tr>
<tr>
<td>API Key</td>
<td>API key of your Vonage account. You can access this value from the Vonage API Dashboard. For more information,</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>see the Authentication page in the Vonage API Developer documentation site.</td>
</tr>
<tr>
<td>API Secret</td>
<td>API secret of your Vonage account. You can access this value from the Vonage API Dashboard. For more information, see the Authentication page in the Vonage API Developer documentation site.</td>
</tr>
<tr>
<td>Signature Secret</td>
<td>Signature secret of your Vonage account for signed webhook requests. You can access this value in the Account Settings in Vonage API Dashboard. For more information, see the Authentication page in the Vonage API Developer documentation site.</td>
</tr>
</tbody>
</table>

10. Click **Create**.

- An application with the provided name is created in your Vonage account. You can access this application by logging in to Vonage API Dashboard and navigating to Your applications.

- A credential record with the name as **Vonage Credential** is created for Vonage alias.

- Application ID and private key are retrieved from the Vonage account and saved in the **Vonage Credential** record.

- JWT token is generated for the **Vonage Credential** record.

  **Note:** If you generate another private key, ensure that you update the private key in the **Vonage Credential** record and click **Generate Jwt Token**. It might take sometime, that is 20 minutes approximately, for the new private key to be synchronised.

- Voice and message webhooks are set up and configured in the **Vonage spoke > Vonage webhook Registries**.

  - In the Applications Edit page in Vonage API Dashboard, under **Capabilities**, these voice and message URLs are configured to integrate with your ServiceNow instance:
    - Event URL
    - Answer URL
    - Inbound URL
    - Status URL

  For more information, see the Overview page in the Vonage API Developer documentation site.
Create webhook for SMS management

Create webhook to manage SMS.

Procedure

1. Navigate to Vonage spoke > Vonage webhook Registries.
2. Click New.
3. On the form, fill in these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the webhook record.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the webhook record.</td>
</tr>
<tr>
<td>Event Type</td>
<td>Type of event for which the webhook is set up.</td>
</tr>
<tr>
<td></td>
<td>Select SMS.</td>
</tr>
<tr>
<td>Secret Key</td>
<td>Secret key to authenticate the webhook requests.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click Save.

5. Click Callback URL.
   The system displays the webhook callback URL.

6. Copy and record the webhook callback URL.

7. Log in to the Vonage API Dashboard and navigate to the account settings.

8. Under Default SMS Setting, fill these values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery receipts</td>
<td>Webhook callback URL</td>
</tr>
<tr>
<td>Inbound messages</td>
<td>Webhook callback URL</td>
</tr>
<tr>
<td>HTTP Method</td>
<td>POST-JSON</td>
</tr>
</tbody>
</table>

9. Click Save changes.
   SMS settings for the application are saved.

10. Optional: To configure the SMS settings for a particular number:

   a. Log in to the Vonage API Dashboard and navigate to Numbers.

   b. Click Your Numbers.
c. Click the Manage icon for the required number.

d. Enter the webhook callback URL in **Inbound Webhook URL** and **Event Webhook URL**.

⚠️ Note: These URLs override the SMS settings specified for the application.

**Customize webhooks and routing policies**

Customise the webhook routing policy and subflow as per your requirement.

**Before you begin**
Role required: admin

**Procedure**

1. Navigate to **Flow Designer > Designer**.
2. Click **Subflows**.
3. Create a copy of the required default subflow.
4. Customize the subflow as per your requirement and publish it. See **Subflows** for more information about creating and using subflows and **Vonage spoke v1.0.1** for information about the fields that the default routing policy and subflows support.
5. Navigate to **Vonage Spoke > Vonage WebHook Routing Policy**.
6. Click **New**.
7. On the form, fill in the fields.

**Decision form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Unique label to identify the routing policy.</td>
</tr>
<tr>
<td>Default answer</td>
<td>Option to specify if this is the default answer. The default answer is applicable when the conditions are not met.</td>
</tr>
</tbody>
</table>

a. Click the lookup icon (👇).  

b. Select the required subflow from the Document list.

⚠️ Note: Ensure that the **Table name** is **Flow [sys_hub_flow]**.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Conditions to be met when the required events occur in Vonage. The supported Vonage fields are:</td>
</tr>
<tr>
<td></td>
<td>• Keywords</td>
</tr>
<tr>
<td></td>
<td>• Call Direction</td>
</tr>
<tr>
<td></td>
<td>• Call Status</td>
</tr>
<tr>
<td></td>
<td>• Event Type</td>
</tr>
<tr>
<td></td>
<td>• From</td>
</tr>
<tr>
<td></td>
<td>• SMS Status</td>
</tr>
<tr>
<td></td>
<td>• SMS Text</td>
</tr>
<tr>
<td></td>
<td>• To</td>
</tr>
<tr>
<td></td>
<td>• WhatsApp Message Status</td>
</tr>
<tr>
<td></td>
<td>• WhatsApp Text</td>
</tr>
<tr>
<td></td>
<td>• Show Related Fields</td>
</tr>
<tr>
<td>Answer</td>
<td>Subflow that must be triggered when the specified conditions are met.</td>
</tr>
</tbody>
</table>

8. Click Submit.

ℹ️ Note: These routing policies are saved in the Decision tables. Users are cautioned against directly updating or modifying data in these tables.

**YouTube spoke**

Manage your videos, channels, subscriptions, and playlists in YouTube account, and access analytics and statistics from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.
**Supported versions**
This spoke was built for these YouTube versions, but may be compatible with later versions.

- Reporting API version v1
- Data API version v3
- Analytics API version v2

**YouTube spoke requirements**
The YouTube spoke requires a custom app that you create in Google Cloud Platform.

**Spoke dependencies**
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

⚠️ Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

**Spoke actions**
The YouTube spoke provides actions to automate YouTube tasks when events occurs in the Now Platform. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analytics</td>
<td>Audience Retention Stats</td>
<td>Retrieves information about the audience retention statistics.</td>
</tr>
<tr>
<td></td>
<td>Basic Statistics</td>
<td>Retrieves information about the basic statistics.</td>
</tr>
<tr>
<td></td>
<td>Demographics</td>
<td>Retrieves information about the demographics. That is, details about the age, gender, and geographical location of your audience.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Device/OS Statistics</td>
<td>Retrieves information about the devices from which your audience access your content.</td>
<td></td>
</tr>
<tr>
<td>Get Country Codes (Metadata)</td>
<td>Retrieves details of countries and their ISO codes. Note: This is a metadata action.</td>
<td></td>
</tr>
<tr>
<td>Traffic Source Statistics</td>
<td>Retrieves information about the various traffic sources.</td>
<td></td>
</tr>
<tr>
<td>Captions</td>
<td>Delete Caption</td>
<td>Deletes captions on a video.</td>
</tr>
<tr>
<td></td>
<td>Look up Captions</td>
<td>Retrieves information about the captions on a video.</td>
</tr>
<tr>
<td>Comments</td>
<td>Delete Comment</td>
<td>Delete the specified comment on a video.</td>
</tr>
<tr>
<td></td>
<td>Look up Comments</td>
<td>Retrieves details about the top level comments in a comment thread.</td>
</tr>
<tr>
<td></td>
<td>Post Comment</td>
<td>Posts a top level comment on a video.</td>
</tr>
<tr>
<td></td>
<td>Reply to Comment</td>
<td>Posts a reply to a top level comment on a video.</td>
</tr>
<tr>
<td>Groups</td>
<td>Create Groups</td>
<td>Creates a group for videos, channels, or playlists.</td>
</tr>
<tr>
<td></td>
<td>Delete Group</td>
<td>Deletes the specified group.</td>
</tr>
<tr>
<td></td>
<td>Delete Group Item</td>
<td>Deletes the specified group item.</td>
</tr>
<tr>
<td></td>
<td>Insert Item into Group</td>
<td>Inserts an item in the specified group.</td>
</tr>
<tr>
<td></td>
<td>Look up Group-Items</td>
<td>Retrieves information about all items in a group.</td>
</tr>
<tr>
<td></td>
<td>Look up Groups</td>
<td>Retrieves information about the specified groups.</td>
</tr>
<tr>
<td>Playlist</td>
<td>Create Playlist</td>
<td>Creates a playlist in your YouTube account.</td>
</tr>
<tr>
<td></td>
<td>Delete Playlist</td>
<td>Deletes a playlist from your YouTube account.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Delete Playlist Item</td>
<td>Deletes the specified playlist item.</td>
</tr>
<tr>
<td></td>
<td>Insert into Playlist</td>
<td>Inserts an item in the specified playlist.</td>
</tr>
<tr>
<td>Reports</td>
<td>Create Report Job</td>
<td>Creates a report job in YouTube account. YouTube generates the requested report within 24 hours.</td>
</tr>
<tr>
<td></td>
<td>Get Report Types Choice (Metadata)</td>
<td>Retrieves information about the Report Types choice list.</td>
</tr>
<tr>
<td></td>
<td>Look up Reports</td>
<td>Retrieves information about the reports generated for a job.</td>
</tr>
<tr>
<td></td>
<td>View Report</td>
<td>Retrieves data in a report in CSV format.</td>
</tr>
<tr>
<td>Subscriptions</td>
<td>Look up Subscriptions</td>
<td>Retrieves information about the specified subscriptions.</td>
</tr>
<tr>
<td></td>
<td>Subscribe Channel</td>
<td>Subscribes to the required channel.</td>
</tr>
<tr>
<td></td>
<td>Unsubscribe Channel</td>
<td>Unsubscribes to the required channel.</td>
</tr>
<tr>
<td>Video</td>
<td>Delete Video</td>
<td>Deletes an uploaded video.</td>
</tr>
<tr>
<td></td>
<td>Look up Video</td>
<td>Retrieves information about the specified video.</td>
</tr>
<tr>
<td></td>
<td>Look up Videos</td>
<td>Retrieves information about the specified multiple videos.</td>
</tr>
<tr>
<td></td>
<td>Rate/Unrate Video</td>
<td>Likes or dislikes the specified video. Also, removes the previous rating for a video.</td>
</tr>
<tr>
<td></td>
<td>Search</td>
<td>Searches for the required video, channel, or playlist.</td>
</tr>
<tr>
<td></td>
<td>Set Thumbnail to Video</td>
<td>Sets a thumbnail image for an uploaded video.</td>
</tr>
<tr>
<td></td>
<td>Set Video Metadata</td>
<td>Sets the metadata of a video.</td>
</tr>
<tr>
<td></td>
<td>Upload Video</td>
<td>Uploads a video to your channel in YouTube.</td>
</tr>
</tbody>
</table>
Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

Set up the YouTube spoke
Integrate the ServiceNow instance and YouTube account by creating a custom OAuth application in Google Cloud Platform to authenticate ServiceNow requests.

Before you begin
• Request IntegrationHub subscription.
• Activate YouTube spoke.
• Role required: admin

Configure the YouTube application
Create a custom OAuth application in your Google Cloud Platform account to enable OAuth 2.0 authentication with the YouTube spoke.

About this task
Complete these steps from the Google Cloud Platform. See the Google Cloud Platform product documentation for instructions on creating and configuring custom applications.

Procedure
1. Register a new custom application. Navigate to https://console.cloud.google.com/, create a project with your administrator credentials, and open the project.
2. From the APIs & Services menu, select OAuth consent screen, enter the application name, and specify the Authorized domain service-now.com. Click Save.
3. From the APIs & Services menu, select Credentials, and select Create OAuth client ID from the Create credentials list.
4. Select the application type OAuth client ID.
5. Enter the following Authorized redirect URI: https://<instance>.service-now.com/oauth_redirect.do and click Create.
6. The OAuth client window shows your client ID and client secret. Copy these two values to a text file so that you can use them when you Register YouTube as an OAuth provider.

The client ID and secret can always be accessed in the Google APIs & Services interface. Click Credentials and select the OAuth 2.0 client ID name.

Register YouTube as an OAuth provider

Use the information generated during the YouTube application configuration to register YouTube as an OAuth provider and allow the ServiceNow instance to request OAuth 2.0 tokens.

Procedure

1. Navigate to System OAuth > Application Registry.
2. Open for the record, Youtube.
3. On the form, fill these values.

**Application Registries form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Client ID of the YouTube application.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client Secret of the YouTube application.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint in this format: https://&lt;instance&gt;.service-now.com/oauth_redirect.do.</td>
</tr>
</tbody>
</table>

4. Ensure that these scopes are available in the OAuth Entity Scopes tab.

<table>
<thead>
<tr>
<th>Name</th>
<th>OAuth scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>YouTube Partner</td>
<td><a href="https://www.googleapis.com/auth/youtubepartner">https://www.googleapis.com/auth/youtubepartner</a></td>
</tr>
<tr>
<td>YouTube Reporting S1</td>
<td><a href="https://www.googleapis.com/auth/yt-analytics.readonly">https://www.googleapis.com/auth/yt-analytics.readonly</a></td>
</tr>
<tr>
<td>YouTube Reporting S2</td>
<td><a href="https://www.googleapis.com/auth/yt-analytics-monetary.readonly">https://www.googleapis.com/auth/yt-analytics-monetary.readonly</a></td>
</tr>
<tr>
<td>YouTube Scope</td>
<td><a href="https://www.googleapis.com/auth/youtube">https://www.googleapis.com/auth/youtube</a></td>
</tr>
<tr>
<td>Name</td>
<td>OAuth scope</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>YouTube Scope Force SSL</td>
<td><a href="https://www.googleapis.com/auth/youtube.force-ssl">https://www.googleapis.com/auth/youtube.force-ssl</a></td>
</tr>
</tbody>
</table>

5. Right-click the form header, and click **Save**.

**Create a credential record for the YouTube spoke**

Create a credential record for the YouTube application. The YouTube spoke connection and credential alias uses these credentials to authorize actions.

**Procedure**

1. Navigate to **Connections & Credentials > Connections & Credential Aliases**.
2. Open record for the YouTube spoke. For example, **YouTube**.
3. In the **Credentials** tab, click **New**.
4. Select **OAuth 2.0 Credentials**.
5. Enter a unique name for the credential, for example, **Youtube_Cred**.
6. Click the **OAuth Entity Profile** search icon (🔍) and select the profile with the name of the OAuth application registry you configured when you registered the YouTube service as an OAuth provider. See **Register YouTube as an OAuth provider** for more information.
7. Right-click the form header and click **Save**.
8. Click **Get OAuth Token**.

**Zoom spoke v2.0**

The Zoom spoke helps you create and manage meetings. Add participants, retrieve details, end or delete a meeting. Use the spoke to fetch the participant details of a conference.

**Request apps on the Store**

Visit the **ServiceNow Store** website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the **ServiceNow Store version history release notes**.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Starter subscription package. For more information, see **Request IntegrationHub**.
Supported versions
Zoom API version v2.0.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Key Management Framework (com.glide.kmf.global)
- NOW Platform Encryption (com.glide.now.platform.encryption)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- Complex Object (com.glide.cobject)

Spoke flows
This spoke has no sample flows.

Spoke subflows
This spoke has no sample subflows.

Spoke modules
The Zoom spoke adds the Zoom application to your instance and includes these modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone Numbers</td>
<td>Displays a list of Zoom phone numbers.</td>
</tr>
<tr>
<td>Zoom Webhook Registries</td>
<td>Displays a list of webhook registries associated to Zoom.</td>
</tr>
</tbody>
</table>

Spoke actions
The Zoom spoke provides actions to automate Zoom tasks when events occur in the Now Platform. Available actions include:
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloud Recording Management</td>
<td>Get Meeting Recording Settings</td>
<td>Retrieve the settings of the meeting’s cloud recordings.</td>
</tr>
<tr>
<td></td>
<td>Get Meeting Recordings</td>
<td>Retrieves all the recorded meeting for the specified meeting ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Recordings</td>
<td>Lists all the recorded meetings of the specified user.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Note:</em> Meeting password is retrieved and displayed as plain text.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phone Management</td>
<td>Assign Calling Plan To User</td>
<td>Assigns a calling plan to a user.</td>
</tr>
<tr>
<td></td>
<td>Assign Phone Number To User</td>
<td>Assigns a phone number to a user who has already enabled Zoom Phone.</td>
</tr>
<tr>
<td></td>
<td>Look up Account Call Logs</td>
<td>Retrieve the call logs for an account.</td>
</tr>
<tr>
<td></td>
<td>Look up Calling Plans</td>
<td>Retrieves a list of calling plans.</td>
</tr>
<tr>
<td></td>
<td>Look up Phone Number Details</td>
<td>Retrieves the details of a specified phone number in a Zoom account.</td>
</tr>
<tr>
<td></td>
<td>Look up Phone Numbers</td>
<td>Retrieves the list of phone numbers.</td>
</tr>
<tr>
<td></td>
<td>Look up Phone Users</td>
<td>Retrieves all the users associated to an account who have assigned Zoom Phone licenses.</td>
</tr>
<tr>
<td></td>
<td>Look up User Call Logs</td>
<td>Retrieves the call logs of a user’s Zoom phone.</td>
</tr>
<tr>
<td></td>
<td>Look up User Profile</td>
<td>Retrieves a Zoom Phone user’s profile.</td>
</tr>
<tr>
<td></td>
<td>Look up User Recordings</td>
<td>Retrieves a Zoom phone user’s recordings.</td>
</tr>
<tr>
<td></td>
<td>Look up User Settings</td>
<td>Retrieve a user’s zoom phone profile.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up User Voicemails</td>
<td>Retrieve a Zoom phone user’s voicemails.</td>
</tr>
<tr>
<td></td>
<td>Unassign User Calling Plan</td>
<td>Unassigns a calling plan to a user who has enabled Zoom Phone.</td>
</tr>
<tr>
<td></td>
<td>Unassign User Phone Number</td>
<td>Unassigns a phone number to a user who has enabled Zoom Phone.</td>
</tr>
<tr>
<td></td>
<td>Update Main Company Number</td>
<td>Update the main company number of an account.</td>
</tr>
<tr>
<td></td>
<td>Update User Profile</td>
<td>Update a user’s Zoom Phone profile.</td>
</tr>
<tr>
<td>Meeting Management</td>
<td>Add Meeting Registrant</td>
<td>Register a participant for a specific meeting.</td>
</tr>
<tr>
<td></td>
<td>Create Meeting</td>
<td>Create a meeting for a user using their Zoom user ID or the email address.</td>
</tr>
<tr>
<td></td>
<td>Delete Meeting</td>
<td>Delete a specific meeting by using its meeting ID</td>
</tr>
<tr>
<td></td>
<td>End Meeting</td>
<td>Ends an ongoing meeting.</td>
</tr>
<tr>
<td></td>
<td>Get Meeting Details</td>
<td>Get details of a specific meeting by its meeting ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Ended Meeting Instances</td>
<td>Lists all the meeting instances that were ended.</td>
</tr>
<tr>
<td></td>
<td>Look Up Live Meetings by User</td>
<td>Lists all the live or ongoing meetings for a specific user.</td>
</tr>
<tr>
<td>User Management</td>
<td>Get User Details</td>
<td>Get details of a specific user on your account with their user ID.</td>
</tr>
<tr>
<td></td>
<td>Look Up Users</td>
<td>Retrieves all the users associated to your account.</td>
</tr>
</tbody>
</table>

**Zoom account requirements**

The Zoom spoke requires configuring your Zoom account to generate an OAuth 2.0 token.
Zoom spoke requirements
These actions use REST calls, which can run on an instance or Zoom spoke. Use the connection record associated with the Zoom alias to configure where actions run as well as set Zoom spoke selection attributes.

Connection and credential alias requirements
IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Connections and Credentials.

This spoke uses the Zoom Connection & Credential Alias record to authorize actions.

Setup Zoom spoke
Integrate your Zoom account with your ServiceNow instance. Create a custom OAuth application in Zoom and authenticate requests from ServiceNow.

Before you begin
Role required: admin
  - Request IntegrationHub subscription
  - Activate Zoom spoke

Create a connected app in Zoom
Create a connected app in your Zoom account to enable OAuth 2.0 authentication with the Zoom spoke

Before you begin
1. Zoom account
2. Role required: Zoom admin

About this task
Complete the following steps from your Zoom account to enable OAuth 2.0 authentication with the Zoom spoke.

Procedure
1. Login to Zoom marketplace
2. Navigate to Develop > Build App
3. Choose OAuth card from the available cards.

4. Use the toggle button to disable the option: Would you like to publish this app on Zoom App Marketplace?

5. Click Create.

6. Name the app and choose the app type as Account-level app. Account level apps must be installed by admin and can manage all users in the account.

7. Optionally, in the subsequent screens, enter the details as appropriate. For example, basic information, description and so on.

8. In the Add Scopes screen, add the actions in the scope as in the screenshot.

### Add scopes

- Meeting
  - Webinar
  - Recording
  - User
  - Account
  - Billing
  - Contacts
  - Dashboard
  - Group
  - Devices (H323)

- View and manage sub account's user meetings
  - meeting:master

- View all user meetings
  - meeting:read:admin

- View and manage all user meetings
  - meeting:write:admin
Note: The next step is to register Zoom as an OAuth provider. However, ServiceNow ships Zoom as a registered OAuth provider in the Application Registry.

What to do next
Record the Client ID and the Client Secret from the App credentials screen to use them for the application registry.
Related information

Register Zoom as OAuth provider

Register Zoom as OAuth provider

Use the information generated during Zoom account configuration to register Zoom spoke as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Before you begin
Role required: admin

Procedure
1. Navigate to System OAuth > Application Registry.
2. Click Zoom.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Client ID created during application registration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client secret created during application registration.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>Time, in seconds, that the refresh token is valid. This is set to 473,040,000 seconds.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint. Enter https://&lt;instance-name&gt;.service-now.com/oauth_redirect.do</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use mutual authentication for token request and revocation. Specify the profile for the mutual authentication.</td>
</tr>
<tr>
<td>Send Credentials</td>
<td>Client credentials in the request.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click Save.

Results
The instance can request OAuth 2.0 tokens for the spoke.

Create credential records for the Zoom spoke
Create Credential records for the Zoom connected app you created. The Zoom spoke connection and credential alias uses these credentials to authorize actions.
Before you begin
Role required: admin, Zoom admin

Procedure
1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?
3. Select OAuth 2.0 Credentials.
   The pop-up window displays a blank OAuth 2.0 Credentials form.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. Enter Zoom Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile you created when you registered the Zoom connected app as an OAuth provider. Select Zoom default_profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>MID Servers that can use this credential. Select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. Enter 100.</td>
</tr>
</tbody>
</table>

5. Save the record.
6. Click the Get OAuth Token related link to generate the OAuth token.

Create connection records for the Zoom spoke
Create Connection records to your Zoom account. The Zoom spoke connection and credential alias uses these connections to perform actions in Zoom.

Before you begin
Role required: admin

Procedure
1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for Zoom.
3. From the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. Enter Zoom Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Zoom. Select Zoom Credentials.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td>Note: Do not select the check box.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to your Zoom instance. Enter <a href="https://api.zoom.us">https://api.zoom.us</a></td>
</tr>
<tr>
<td>Use MID Server</td>
<td>Option to use a MID Server. Define the fields in the Advanced MID Server Configuration related list if you select this option.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click **Save**.

**Set up a bi-directional webhook for Zoom spoke**

Configure a webhook to subscribe to Zoom with a ServiceNow callback URL.

**Before you begin**

- Request an IntegrationHub Starter subscription package
- Activate the Zoom spoke
- Role required: admin

**Add an endpoint URL in Zoom account**

Specify an endpoint URL in your Zoom account to create a webhook for Zoom spoke.

**Before you begin**

Role required: admin
Procedure

1. Log in to Zoom account.
2. Create a webhook app according to your requirements.
   For more information about Zoom webhook only app, see Create a Webhook-only App.
3. Generate a verification token and record it.
4. Enable Event Subscriptions and enter the Event notification endpoint URL in the following format.
   https://<instance-name>.service-now.com/api/sn_zoom_spoke/zoom_webhook_endpoint/webhook
5. Specify the Event Types according to your requirement.

Results
The endpoint URL is added in your Zoom account. You can create webhook registries and subflows according to your requirements.

Register a Zoom webhook in ServiceNow
Register a Zoom webhook in ServiceNow to notify the ServiceNow app when certain events occur in Zoom.

Before you begin
Role required: admin

Procedure
1. Navigate to Zoom Spoke > Zoom Webhook Registries.
2. Click New.
3. On the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger Type</td>
<td>Type of the Zoom event that triggers the subflow.</td>
</tr>
<tr>
<td>Token</td>
<td>Verification token from your Zoom account used for validating event notification.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subflow Name</td>
<td>Subflow which is to be triggered when the specified conditions are met.</td>
</tr>
<tr>
<td>Input</td>
<td>Input for the webhook registry.</td>
</tr>
<tr>
<td>Trigger Object</td>
<td>Zoom object which is used to trigger the subflow.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the webhook registry.</td>
</tr>
</tbody>
</table>

## IntegrationHub - Import

Automate data import tasks from a new design environment that consolidates several legacy forms into a single modern interface. Define external data sources, specify target tables, map how source data becomes target data, and schedule regular imports.

Managing imports through IntegrationHub simplifies the process of importing data from external sources and transforming it to ServiceNow tables. You can configure, run, and schedule your data imports all through a single interface.

⚠ **Note:** Imports in IntegrationHub require the ServiceNow IntegrationHub Action Template - Data Stream [com.glide.hub.action_type.datastream] plugin. For more information, see Request IntegrationHub.

### Benefits

Managing your imports through IntegrationHub provides these benefits.

- Consolidates multiple data integration capabilities into a single environment, eliminating the need to create and manage several forms throughout the platform.
- Enables you to manage multiple integrations through a single interface.
- Guides you through the configuration of data sources and target tables.
- Enables you to map and transform data from a single simplified interface.
- Enables you to schedule data imports or manually import data on demand.
- Provides usage information about data imports run and details about imported rows, updates, and errors.

### Overview of the import process

There are three steps to importing data.

1. **Configure a data source.**
The data source specifies how and where to get the data to import. In IntegrationHub, the data source uses a Data Stream action to get data from an external source. A Data Stream action sends a REST, SOAP, or JDBC request to an API and returns a stream of data.

2. Map the data to a target table.

The target table is the table you want to transform the data to. Once you’ve selected a target table, you can specify how the source data should be transformed to it. Creating a data map outlines how to transform the data, the data isn’t transformed until you run the import.

3. Run or schedule the import.

After you’ve configured the data source and determined the data mapping, you can run the import. You can also schedule the import to run later. When the import runs, data is gathered from the source, moved to a staging table, then transformed to the target table according to the specifications in your mapping.

For more details about how importing data works, see Import sets.

IntegrationHub import environment

The IntegrationHub import environment consists of the following interfaces.

• Landing page
• Source configuration
• Map to target
• Schedule imports
• Execution details

The following sections explain each interface in greater detail. Each section includes a screenshot of the interface. The screenshots are from an integration that uses the Cornerstone spoke to retrieve employee data and transform it to a ServiceNow table.

Landing page

Create and access integrations through the landing page.
The landing page has these components.

1. **List of integrations**
   Integrations created through the IntegrationHub import interface are accessible here.

2. **Create new integration button**
   Button to start building a new integration.

**Source configuration**
Define a data source for an import through the source configuration page. The data source must be from a data stream action.

The source configuration section has these components.

1. **Data Stream action section**
Section where you can select the Data Stream action for the data source. Choose a Data Stream action from the list.

2. Data Stream action information

Icon to click for more information about the selected Data Stream action. Clicking this icon opens the Data Stream action's configuration page in Flow Designer.

3. Data Stream action inputs section

Section to enter the inputs for the selected Data Stream action. This section only displays after you select a Data Stream action, and only if the Data Stream action has inputs. Data Stream actions with inputs have unique inputs, so the fields that appear here depend on which Data Stream action you select and its configuration.

Map to target

Select the target table and determine how the source data is mapped to it. Map data by dragging data pills from the source to the target or by using the pill picker. Transform the data in the target table by applying transform functions.

The Map to target section has two parts. In the first part, select the target table. In the second part, map the data to the target table.

Table selection user interface

The table selection section has these components.

1. Target table card

Card with the name and description of the target table. Click the card to open the data-mapping interface and begin mapping the data.

2. Properties button

Button to view or edit the name of the integration and its description.

3. Add a target table

Button to add a target table. There is one target table per integration.
The data-mapping section has these components.

1. **Target table name**
   Name of the target table. There is one target table per integration.

2. **Source data section**
   Section that displays the source data as data pills. To map the data, drag the data pills to the target table data section. You can also use the pill picker.

3. **Target table data section**
   Section that displays how each field in the target table maps to the source data.

4. **Match toggle switch**
   Toggle switch to specify fields where the system should check for matching data and, if found, update existing records instead of creating new ones. In this image, the **Match** toggle switch is turned on for the **user id** field. If a record in the source data has a user id that matches the user id for a record in the target table, the system will update the existing record in the target table instead of creating a new one.

5. **Table Properties button**
   Button to view or edit the options to run the table's business rules when importing and to run the import synchronously.
6. Data pill picker

Button to open the data pill picker. You can use the pill picker to map source data pills to field values in the target table.

7. Transform function icon

Button to open the list of available transform functions. Use transform functions to change or modify your data. For example, the Trim transform function removes white space from the beginning and end of an input string.

Schedule imports

Run an import immediately, or schedule it to run at a specific time, at regular intervals, or after a parent import. Schedule large imports to run concurrently to reduce processing time.

Schedule imports section user interface

The schedule imports section has these components.

1. Schedule an import button

Button to create an import schedule.

2. Scheduled imports

List of import schedules. Each import schedule appears in its own button.

3. Executions section

Section with information about executed imports. Includes links to execution records, execution context records, and scheduled import records. This section only appears after an import is run.

4. Execution records
List of execution records. Each execution record provides information about an execution, including the imported rows, errors, and log messages.

5. Execution context records

List of execution context records. Each execution context record specifies the next scheduled import to use when processing a hierarchical scheduled import.

6. Scheduled import records

List of scheduled import records. Each record provides the name, data source, schedule, and partition method for the scheduled import.

Execution details

View details for each import, such as the execution time and date, and execution context. Open the import’s execution records to view the import state and the imported rows, errors, and logs.

 Execution details section user interface

The execution details section has these components.

1. Execution information
Section providing the number of the execution record, the name of the scheduled import, the import set number, and the date it was updated.

2. Execution Details

Section with cards displaying the total number of rows imported, processed, pending, or skipped, and the number of errors that occurred. If the import is processed concurrently, this section also includes the Partitions card. For more information, see Concurrent imports.

You can click the cards to filter the results. Filtered results display in the Import Set Rows tab toward the bottom of the page. For example, clicking the Pending card displays the pending rows. Clicking Total rows imported or Clear Selection clears the filters.

⚠️ Note: Card filtering is only available for import set rows. To see the filtered list, make sure you’re on the Import Set Rows tab.

3. Partitions card

Graphical view of the import set partitions. The partitions card only appears for concurrent import sets. You can click a partition to view its details. You can also use the Execution Details cards for additional filtering. When you combine the partition filter with the card filters, the system uses an AND operation for filtering. For example, if you click a partition, then click the Errors card, the Import Set Rows tab displays only the errors for that partition.

4. Partitions list view

Option to view the details for each partition, including the import set number, and the type and state for each import set job. The partitions list view only appears for concurrent import sets. The partitions list view provides the same filtering capabilities as the Partitions card, so you can use either to filter a partition.

5. Import details

Section detailing the import set rows, outbound HTTP requests, action execution history, import logs, and errors for each execution record.

IntegrationHub import terms
Imports in IntegrationHub have these components.

Data source
A data source is a configuration record that defines the type of data to import and the endpoint where your instance can get it.

**Data Stream action**

A *Data Stream action* is an action that sends REST, SOAP, or JDBC requests from Flow Designer to APIs. It returns either a stream of response data larger than 10 MB, or paginated results.

**Target table**

A *target table* is the table you want your source data to be transformed to.

**Transform function**

A *transform function* is a function that changes or modifies your data. For example, a function that transforms an input string to all uppercase characters.

**Execution**

An *execution* is a run-time record that contains the execution details for a single import. Each execution provides import details for a specific target, including rows imported, log messages, and errors.

**Execution context**

An *execution context* is a record that specifies the next scheduled import to use when processing a hierarchical scheduled import.

**Import set**

An *import set* is a set of run-time records that contain the raw data imported from a data source. The system stores imported records in an Import Set staging table.

**Design considerations**

Follow these guidelines to achieve the benefits offered by IntegrationHub imports.

**Create all IntegrationHub imports from within IntegrationHub**

Only integrations created in the IntegrationHub import environment are accessible there. For example, you can't configure a data source and mapping through platform forms, but then schedule the import from within IntegrationHub. Only integrations created in IntegrationHub appear on the landing page.

**Don't alter configuration records outside of IntegrationHub**

Alteration configuration records directly might change if and how data is imported and mapped. If you need to change the
configuration of the data source, mapping, or import schedule, do so from within the IntegrationHub import interface.

**Avoid modifying Data Stream actions used in data sources**

Modifying Data Stream actions used as data sources might change the mapping from source to target. When the output for a Data Stream action changes, the Map to target page displays a warning that the complex object schema has changed. You might need to reconfigure the mapping.

**Configure a data source**

Start importing data with IntegrationHub by creating a data source. A data source specifies how and where to get the data you want to import.

**Before you begin**

- Imports in IntegrationHub require the ServiceNow IntegrationHub Action Template - Data Stream [com.glide.hub.action_type.datastream] plugin. For more information, see Request IntegrationHub.

- Data sources in IntegrationHub use Data Stream actions to collect and load the data. Data Stream actions have unique inputs, so make sure to familiarize yourself with the one you plan to use. To learn more, see Data Stream actions and pagination. Data Stream actions with dynamic inputs or outputs are not supported.

- Role required: admin or ih_import.

**About this task**

Configuring a data source is the first step to importing data in IntegrationHub. After you set up the data source, you can select a target table, determine how data is transformed to the target table, and run and schedule the import.

**Procedure**

1. Navigate to IntegrationHub > IntegrationHub - Import.
2. Click Create new integration.
3. On the New Integration screen, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify your integration.</td>
</tr>
<tr>
<td>Short description</td>
<td>Description of your integration.</td>
</tr>
</tbody>
</table>

4. Click Save & Continue.
5. Under Data Source, select a Data Stream action. When you select a Data Stream action, the form automatically saves. If the Data Stream action has inputs, a Data Stream action inputs section appears. Data Stream actions with inputs have unique inputs, so the fields in this section depend on which Data Stream action you select and its configuration. You can view the details of the Data Stream action by clicking the information icon (i) next to it. Clicking the icon opens the Data Stream action's configuration in Flow Designer.

6. In the Data Stream action input form, fill in the fields.

7. Click Save.

What to do next
Map source data to a target table.

Map source data to a target table
Specify how source data is transformed to your target table.

Before you begin
Configure a data source.

Role required: admin or ih_import.

Procedure
1. Navigate to IntegrationHub > IntegrationHub - Import.
2. On the landing page, select your integration.
3. On the left navigation panel, click Map to Target.
4. On the Target table page, click Add a target table.
5. In the Select Target Table form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target table</td>
<td>Name of the table to transform your data to. You can select one table per integration.</td>
</tr>
<tr>
<td>Run table's business rules when importing</td>
<td>Option to run the target table’s business rules when you import the data.</td>
</tr>
<tr>
<td>Run the import synchronously</td>
<td>Option to run the import synchronously. If checked, it ensures there's only one record with a unique match field value by synchronizing record inserts.</td>
</tr>
</tbody>
</table>
6. Click Save.

7. Click the button with your target table name to begin mapping your data. The left side of the page shows the source data. The right side shows the target table. To map the data, drag the data pills from the source to the Value column on the target. You can also map data by using the pill picker ( ) on the right side of the target table. You can enter more than one value in the Value column, you can also enter text.

8. Optional: Use the Match toggle switch to specify fields where the system should check for matching data and, if found, update existing records instead of creating new ones.

(Optional) For example, if a target table has an Order number field and a record with an order number of 743, there are two options for handling potential matches.

• If the Match toggle switch for the Order number field is on, the system checks for matching data. If the source data has a record with the same order number, the system updates the existing record in the target table.

• If the Match toggle switch for the Order number field is off, the system doesn’t check for matching data. If the source data has a record with the same order number, the system creates a new record in the target table. In this case, the target table will have two records, both with an order number of 743.

9. Optional: For choice and reference fields, specify what to do if the choice or reference doesn’t exist in the target table.

a. Click the gear icon ( ).

b. Select one of the following options.

• Create a new choice/record: Creates the choice or record in the target table.

• Ignore this field: Ignores only the field in the target table.

• Skip this record: Skips the entire record in the target table.

c. Click Done.

10. Optional: Change or modify your data by applying transform functions. For example, you can use the Uppercase transform function to change an input string to all uppercase characters. For more information, see the Flow Designer documentation on Transform functions.
Note: Not all of the transform functions available in Flow Designer are available in IntegrationHub - Import.

a. Click the transform function icon (fx).

b. Select a transform function from the menu, then click OK.

c. To apply additional transform functions, click Add a new transform. Transform functions are applied in the order they are selected.

d. After you’ve selected all your transform functions, click Done.

11. When you’re done with your mapping, click Save.

What to do next
Run or schedule a data import.

Run or schedule a data import
Specify when to run a data import by creating a schedule. Schedule an import to run at a specific time, at regular intervals, or after a parent import. You can also run your import immediately.

Before you begin
Configure a data source, then Map source data to a target table.
Role required: admin or ih_import.

Procedure
1. Navigate to IntegrationHub > IntegrationHub - Import.
2. On the landing page, select your integration.
3. On the left navigation panel, click Schedule imports.
4. On the Run and schedule imports page, click Schedule an import.
5. On the New schedule form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled Data Import</td>
<td>Name to uniquely identify the import schedule.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Data source</td>
<td>Data source for the import. This field is automatically set to the name of your integration.</td>
</tr>
<tr>
<td>Run as</td>
<td>Name of the user or user role the import executes with. For example, the import may run as the System Administrator, or it may run with the roles of a specified user.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for the import schedule. Global is the default.</td>
</tr>
<tr>
<td>Run</td>
<td>Option to specify when the import runs. Select one of the following.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Daily</strong>: Runs every day.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Weekly</strong>: Runs every week.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Monthly</strong>: Runs every month.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Periodically</strong>: Runs at regular intervals.</td>
</tr>
<tr>
<td></td>
<td>• <strong>After Parent Runs</strong>: Runs after another import.</td>
</tr>
<tr>
<td>Day</td>
<td>Day of the week or month to run the import. Entered as a number. This field appears only when <strong>Weekly</strong> or <strong>Monthly</strong> is selected from Run.</td>
</tr>
<tr>
<td>Repeat interval</td>
<td>Amount of time to wait between imports. Entered in days, hours, minutes, and seconds. This field appears only when <strong>Periodically</strong> is selected from Run.</td>
</tr>
<tr>
<td>Parent</td>
<td>Name of the parent import. The parent import must finish before the current import begins. This field appears only when <strong>After Parent Runs</strong> is selected from Run.</td>
</tr>
<tr>
<td>Time</td>
<td>Time of day to run the import. Entered in hours, minutes, and seconds.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to make the import schedule active.</td>
</tr>
<tr>
<td>Advanced</td>
<td></td>
</tr>
<tr>
<td>Concurrent import</td>
<td>Option to divide the data into multiple import sets and process them concurrently.</td>
</tr>
<tr>
<td>Partition Method</td>
<td>Option to specify how to partition the data. Select one of the following.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Custom size</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Round Robin</strong></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Partition Size</td>
<td>Number of records for the partition size. Must be greater than or equal to 1000. This field appears only when <strong>Custom size</strong> is selected from <strong>Partition Method</strong>.</td>
</tr>
</tbody>
</table>

6. Click **Save**.

7. **Optional:** To add a prescript or postscript, click the more options icon ( ⋯ ) and select **Advanced setup**. This option opens the form for the scheduled data import, where you can add a script to run before or after your import.

8. **Optional:** Run your scheduled import right away by clicking the more options icon ( ⋯ ) and selecting **Execute Now**. After you run the import, refresh the Executions list to view the execution record.

What to do next
Your import will run at the scheduled time. After it runs, an Executions section appears on the Run and schedule imports page. The Execution section has execution records where you can view details about your import, including its runtime, the number of imported rows, and any errors or log messages.

Connections dashboard
View and configure your connection and credential aliases through a simplified interface. Add new connections, edit existing connections, and view connection details.

Benefits
The Connections dashboard provides these benefits:

- Enables connection admins to manage multiple connections through a single interface.
- Provides simplified processes for adding, editing, and configuring connections.
- Displays details about an alias and all associated child connections in a single location.

Landing page
The dashboard landing page displays all the connection and credential aliases available on your instance. You can search for an alias by name, sort aliases by date created, or sort them alphabetically in ascending or descending order.

Each alias is displayed in a card format. Cards display the following:
• The application’s icon.
• The name and scope of the parent alias.
• A short description of the application associated with the alias. This option only appears when there are no connections.
• The total number of connections.
• A list of all the connections associated with the alias. The first connection is the default parent connection.
• A View Details option that displays specific information about the alias and any child connections.
• An Advanced Setup option. This option only appears when an alias doesn’t have a configuration template.
• An Add Connection option. This option is only available when an alias has a configuration template.

Each page of the Connections dashboard displays a maximum of 12 aliases. Page through to see additional aliases.

Detailed view
View details about an alias and any child connections by clicking the View Details option on the alias card. The details page has two columns. The first column displays:
• The application’s icon.
• The name and scope of the parent alias.
• An option to View connection alias, which opens the associated Connection & Credential Aliases record.

The second column of the detailed view displays:
• An Add Connection or Advanced Setup option, depending on whether the alias has a configuration template.
• The number of connections associated with the alias.
• A list of connections associated with the alias. The default connection is marked.

Connections that are not configured have a Configure option. Connections that are configured have an Edit option. Each configured connection displays the connection name, endpoint, credential name, and credential type.
If an alias uses an OAuth credential, the OAuth access or refresh token status is displayed with each connection. For connections that require a new token, you can request one by clicking **Get OAuth Token.**

**Configuration templates**

Configuration templates enable you to set up complex integrations using a single form. For example, an OAuth integration requires registering an OAuth provider, generating a token, and creating several connection and credential records. But if you use a configuration template to set up an OAuth integration, you only need to fill in one form. The system creates the associated records. To learn more about templates, see **Connection and Credential configuration templates.**

To add, edit, or configure connections directly through the dashboard, an alias must have a configuration template. Not all aliases have templates. Templates were first introduced in the Orlando release, so aliases from previous versions may not have them yet. An alias without a template displays an **Advanced Setup** option on both its dashboard and detailed view. Clicking **Advanced Setup** opens the alias’s connection and credential record, where you can set up the alias. For more information about working with aliases that don’t have templates, see **Create a Connection and Credential alias.**

**Unconfigured connections**

When you transfer an alias or promote it to production, its underlying connection information doesn’t get transferred with it. In this situation, the connection is in an unconfigured state and must be reconfigured before you can use it. You can reestablish the underlying connections either through the dashboard or through the platform user interface.

- If the alias has a template, you can configure the connection through the dashboard.
- If it doesn’t have a template, configure it through the platform user interface. For more information about configuring a connection without a template, see **Getting started with connections.**

**Roles**

To access the Connections dashboard, you must have the connection_admin or admin role.

**Add a connection**

Add a connection through the Connections dashboard.
Before you begin
Role required: connection_admin or admin

Procedure

1. Navigate to Process Automation > Flow Designer and click the Connections tab.
2. Locate the alias you want to add a connection to and select Add Connection.
   If there isn’t an Add Connection option, the alias doesn’t have a configuration template. To add a connection through the dashboard, the parent alias must have a template. Not all aliases have templates. Templates were first introduced in the Orlando release, so aliases from previous versions may not have them yet. If yours doesn’t, you can set up your alias through the platform user interface instead. Select the Advanced Setup option to get started. For more information, see Create a Connection and Credential alias. To learn more about templates, see Connection and Credential configuration templates.
3. On the form, fill in the fields.
   The fields that appear on the form depend on which configuration template the parent alias has. For details on each specific template, visit Connection and Credential configuration templates.
4. To submit the form, click Create Connection.

Results
The alias card displays the new connection under the Connections list.

Configure a connection
Configure a connection through the Connections dashboard.

Before you begin
Role required: connection_admin or admin

About this task
When you transfer an alias or promote it to production, its underlying connection information doesn’t get transferred with it. In this situation, the connection is in an unconfigured state and must be reconfigured before you can use it.

Procedure
1. Navigate to Process Automation > Flow Designer > and click the Connections tab.
2. Locate the alias that you want to add a connection to and click View Details.
3. In the detailed view, locate the connection that you want to configure and click **Configure**.

4. On the Configure Connection form, fill in the fields. The fields that appear on the form depend on which configuration template the parent alias has. For details on each specific template, see [Connection and Credential configuration templates](#).

   Configuring a connection through the dashboard requires the parent alias to have a configuration template. If yours doesn’t, clicking **Configure** opens the Connection and Credential Alias record for your alias instead of the Configure Connection form. For more information about configuring your connection in the Connection and Credential Alias record, see [Create a Connection and Credential alias](#).

5. To submit the form, click **Configure**.

**Results**
The detailed view displays the new connection in the Connections list.

### Domain separation and IntegrationHub

Domain separation is supported for IntegrationHub. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: Standard**
The support level is Standard but has some exceptions or special conditions.

- Includes **Basic** level
- Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.

- The instance owner must be able to configure minimum viable product (MVP) business logic and data parameters. This configuration is done per tenant, as expected for the specific application.

Use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see [Application support for domain separation](#).
Overview
In general, IntegrationHub inherits the domain separation features of Flow Designer. As each spoke (application) can have its own domain separation relationship, there is no one specific support level to associate with IntegrationHub. To learn more, see Domain separation and Flow Designer.

Related information
Domain separation for service providers

Support multiple connections
Support several connections to a single integration provider. Select connections for flows, subflows, and actions directly from a flow.

Benefits
Multiple connections support offers these benefits.

• Have more than one connection to the same integration provider. For example, you can establish connections to several different Jira environments.

• Select which connection you want to use in a flow. Override preset connections for flows, subflows, and actions directly through Flow Designer.

• When a flow is promoted to production, reestablish a connection to each account without needing to modify the flow.

To learn more about connections, see Connections and Credentials.

Create connections
There are two ways to add a child connection to a parent alias.

Through the Connections dashboard
The Connections dashboard provides a simplified way to add a connection to an alias. For more information about the Connections dashboard, including how to add a connection, see Connections dashboard.

Through the platform user interface
Manually create a child connection by setting up connection and credential records. To create a connection with this method, see Create a Connection and Credential alias.

Flow-level connection selection
You can choose a connection for a flow or subflow directly from the flow’s main page. When you select a new connection, it overrides any preconfigured
connection for that flow. To choose a connection, click the More Actions menu icon (⋮), and select the **Configure connections** option. This option opens the Configure Connections window, where you can select the connections for your flow. The Configure Connections window displays:

- All the aliases used in the flow.
- The icon and name for each alias.
- A list of the configured connections for each alias. The default connection is listed first. Other connections are listed alphabetically.
- An information icon for each alias. Clicking the icon opens the Connection & Credential Aliases record for the default connection shown in the list.
- A **Manage Connections** option that opens the connections dashboard.
- Options to **Cancel** connection selection or **Update** your connection choice.

Each alias has one entry in the Configure Connections window, regardless of how many actions or subflows may use that alias. When you select a connection at the flow level, the new connection applies to all the actions and subflows using that alias. For example, if a flow has several actions that use a Slack service, changing the connection for the Slack service changes the connection for all the Slack service actions within the flow.

You can see which parts of a flow a connection change affects by matching the alias icons in the flow to the ones in the Configure Connections window. An action that impacts a Slack service has a Slack icon next to the action in the flow. The Slack icon also appears next to the alias name in the Configure Connections window.

The Configure Connections window is automatically updated whenever you add or delete a flow component that has connections. When you add an action or subflow to a flow, the Configure Connections window displays the connections for the action or subflow that you just added. If you remove an action or subflow, the connection information is removed from the Configure Connections window.

You can choose whether to display the **Configure connections** option with the `sn_flow_designer.connections_override_enabled` system property. Setting the property to **true** displays the **Configure connections** option, while setting it to **false** hides it. If you delete the system property or it doesn’t exist, the **Configure connections** option is displayed by default.

View which connection your flow ran with by examining the Step Configuration section of the flow’s execution details. The connection alias listed in the **CONFIGURATION** column is the alias that the flow was originally designed to
run with. The alias listed in the RUNTIME VALUE column is the one that the flow actually ran with.

Execution details page

Action-level connection selection

You can select connections for individual actions within a flow. This functionality is useful if a flow must interact with multiple configurations of the same provider. For example, downloading a file from one configuration of a file storage provider then uploading the file to a different configuration of the same file storage provider.

To select a connection for an individual action in a flow or subflow, click Advanced Options. This option shows the name of the alias that the action uses and a list of all the alias’s associated connections. The first connection on the list is the default connection. Other connections are listed alphabetically. Selecting a connection from the list overrides the connection for that action and for any dynamic inputs inside the action.

You can enable or disable action-level overrides by clicking the More actions icon (⋯) and selecting Flow Preferences. The Configurations window has a Show advanced connection options option. This option is disabled by default, so actions don’t show the Advanced Options button. When enabled, the option is available if the action has a connection alias that can be overridden.

Dynamic inputs

You can select connections for flows and subflows containing actions with dynamic inputs. When a connection override is specified at the flow level, the dynamic action uses the flow-level override. For example, in a flow with a data-gathering action, the action uses the flow’s override connection for the data-gathering step rather than the action’s default connection. If an override is specified at the action level, the dynamic action uses the action-level override.

Multiple overrides within a flow

When there is more than one override in a flow, they’re applied according to the following rules:
• Action-level overrides always apply.
• Subflow-level overrides always apply to the subflow. The override also applies to actions within the subflow that don’t have their own overrides configured.
• Flow-level overrides apply to subflows and actions that don’t have their own overrides configured.

Flow promotion
When you move a flow to a production instance, the alias information is transferred with it, but the underlying connection information is not. An alias functions as a type of container for connections. The container moves with the flow, but the specific connection information doesn’t. Any connections associated with the alias become unconfigured and must be reconfigured before you can use them in the new environment.

You can configure connections without having to modify the flow because you already have the base alias set up. To configure a connection:

• If the alias has a template, configure the connection through the Connections dashboard. See Configure a connection for instructions.

• If an alias doesn’t have a template, configure it through the platform user interface. For more information about configuring a connection without a template, see Getting started with connections.

Additional considerations
To add a connection through the Connections dashboard, the parent alias must have a configuration template. Templates first became available in the Orlando release, so aliases from previous releases may not have templates yet. For more information about configuration templates, see Connection and Credential configuration templates.

Override a connection in a flow
Override a connection for a flow, subflow, or action.

Before you begin
For details about flow overrides, including how they affect actions with dynamic inputs and how multiple overrides are applied, see Support multiple connections.

Role required: flow_designer or admin
Procedure

1. Navigate to **Process Automation > Flow Designer**.
2. Select the flow or subflow that has the connection you want to modify.
3. Click the More actions icon (Ξ), and select **Configure connections**.
4. In the Configure Connections window, identify the alias associated with the connection that you want to override and select a new connection from the list.
5. Click **Update**.

   **Note:** If the option is enabled, you can also override a connection at the action level. Click **Advanced Options** below the action. Choose the new connection from the list, then click **Done**. This option is only available if the action has an overridable connection.

What to do next
Test the flow.

Data Stream actions and pagination

Send REST, SOAP, or JDBC requests from Flow Designer to APIs that return a stream of response data larger than 10 MB, or that return paginated results. Parse stream data into a series of complex object outputs and use the data pills in other actions in a flow.

For example, create a Data Stream action to import a large quantity of employee data from a third-party HR site. The Data Stream action sends a REST request to the third-party site and processes the response to populate records in the User [sys_user] table.

Benefits

Data Stream actions offer these benefits.

- Parse and format a stream of response data larger than 10 MB.
- Automatically send multiple requests to APIs that paginate results, if applicable.
- Enable flow designers to process large requests without complex coding or configuration.
- Enable flow designers to process each object within a data stream using **For each** flow logic. For example, you might create a Data Stream action that imports document data from a third-party site. When you add the action to
a flow, Flow Designer automatically adds the action to a **For each** flow logic block, enabling flow designers to easily create a record in ServiceNow for each object in the data stream. See [Use a Data Stream action in a flow](#).

- Enable flow designers to reuse Data Stream actions in multiple flows, using the same source of data in multiple ways.

### Running a Data Stream action

There are two ways to run a Data Stream action.

**From a flow**

You can process each object within a data stream using **For each** flow logic. For example, you might create a Data Stream action that imports document data from a third-party site. When you add the action to a flow, Flow Designer automatically adds the action to a **For each** flow logic block, enabling flow designers to easily create a record in ServiceNow for each object in the data stream. See [Use a Data Stream action in a flow](#).

**From a script**

You can start a Data Stream using the `executeDataStreamAction()` method in the FlowAPI class. For more information, see [FlowAPI](#).

### Action outline

Data Stream actions follow a set structure. Follow prompts to add and remove steps from the action outline. You cannot manually add steps to a Data Stream action.
**Note:** Clearing an option in a configuration page removes the step from the Data Stream outline and deletes all data associated with the step.

**Action Preprocessing**

Use the Action Preprocessing category to run a preprocessing script before the action sends the initial API request. For example, validate action inputs or...
set default values. Preprocessing executes once per action, before the first API request.

Selecting this option adds a script step to the Data Stream action. For more information, see Script step.

This is an optional Data Stream action component that runs on either the instance or a MID Server.

**Request**

Use the Request category to configure how the action sends API requests. The Request section executes once per page of results. Request components provide these configuration options.

**Pagination Setup step**

Request results in batches. Once one page of data is processed, the Data Stream action runs the request section again to return the next set of results. Use the pagination setup step to set up pagination options required by the API. Configure the Pagination Setup step manually, or select a pre-built template to apply common configurations. For example, apply the Limit / Offset template to specify the number of items you want returned per page (limit), and the starting number for the first item (offset). After applying a template, update the values to ensure that the configuration complies with the API's requirements.

**Note:** For licensing purposes, each request counts as one transaction, including each request for the next page of results.

The value of the reserved, read-only **getNextPage** variable determines whether to request another page of results. As long as the **getNextPage** variable is true and the previous page contains data, the action continues to send requests for the next page.

**Note:** You must explicitly set the value to true in the script or it will default to false.

This is an optional Request component that only runs on the instance.

**Note:** Pagination isn't applicable to the JDBC step.

**Script step**
Run a script before every request for the next page of results. Use this script for data validation and transformation when calling a paginated API. For example, generate a JSON payload for the next page request. Selecting this option adds a script step to the Data Stream action. For more information, see Script step.

This is an optional Request component that runs on either the instance or a MID Server.

REST or SOAP step

Send a REST or SOAP request to a third-party API. Select a data format to add an associated step to the Data Stream action. For more information, see REST step and SOAP step.

This is a mandatory Request component that runs on either the instance or a MID Server.

JDBC step

Send a JDBC request to a third-party API. Use transform script to format data and add an associated step to the Data Stream action. For more information, see JDBC step and Test JDBC step. All data is retrieved and pagination is not needed.

This is a mandatory Request component that runs on either the instance or a MID Server.

Parsing in REST and SOAP steps

Use the Parsing category to configure how the action separates data stream elements into complex data objects. Use the Splitter step to identify and separate items from an XML or JSON stream, and use the Script Parser step to transform each item into a complex object. The Parsing section executes once per item in the stream. You can access outputs from previous steps in your data stream action using the \texttt{fd\_data} object, excluding:

- REST or SOAP step Response Body, Stream, or Error Message outputs
- Splitter step outputs
For more information about complex data, see Complex data. Parsing components provide these configuration options.

**Splitter step**

Identify the parent node in the response stream to map to a complex object. For example, identify a user element in an XML payload to create a complex object for each user in the response stream.

Select a splitter type to identify and separate repeated items in an XML or JSON data stream.

- **JSON**: Identifies objects in a stream of JSON data.
- **XML**: Identifies objects in an XML document.

This is a mandatory Parsing component that only runs on the instance.

**Script Parser step**

Use JavaScript and ServiceNow APIs to map items in the response stream to a complex object output represented by the `targetObject` global object. For example, map incident record elements identified in the splitter step to a complex object containing incident fields. If the data stream includes siblings to the item...
identified in the splitter step that you do not want mapped to a complex object, include conditions to exclude those items. This is a mandatory Parsing component that only runs on the instance.

REST and SOAP Data Stream action overview

Transform script in JDBC step

JDBC data stream action doesn’t require pagination. Also, splitter and parser steps aren’t required.

The JDBC step generates a complex object for each of the retrieved record. Hence, action preprocessing and transform script in the JDBC data stream action are optional. When using the transform script, action designer must specify the internal name of the table columns in the transform script.
Data Stream outputs in SOAP and REST steps
When designing a Data Stream action, you must create a single output of type Object or Dynamic Object. The Script Parser step maps items in the stream to this object using the `targetObject` global object.

At runtime, the system splits and parses the stream of response data according to the Data Stream configuration. Each item in the stream maps to the complex object structure defined by the Script Parser step and the object output, resulting in a large series of complex objects. For more information about complex data, see Complex data.

Data Stream outputs in JDBC step
The output of JDBC steps is a complex object stream. Entire data is retrieved in one request only.
Note:

• You can only retrieve data and can’t update or delete records using the JDBC data stream action.

• The fields, **Maximum Row** and **Maximum Payload Size (KB)** that are available in JDBC step aren’t available in the JDBC data stream action.

**Execution details in REST and SOAP steps**

View the configuration and runtime results for each item processed by a Data Stream action. Select a record number to see its configuration and runtime details. By default, the execution details include requests for the last 1000 items. To change the number of items in the execution details, update the `com.snc.process_flow.reporting.datastream.item.lastn` system property.
Data stream summary

View an overview of the execution that includes this information.

- **Page count**: Number of pages returned by a paginated API.
- **Total item count**: Number of items in the response stream mapped to complex object outputs.
- **Error count**: Number of errors encountered.

Page details
View runtime data for each step within the Data Stream action. Select a page to view runtime details for each request to a paginated API. By default, the execution details include requests for the last five pages. To change the number of requests in the execution details, update the `com.snc.process_flow.page.reporting.lastn` system property. Set the value to 0 to remove pages from the execution details and -1 to include all pages.

**Note:** Including all pages can affect performance and is not recommended.

### Execution details in JDBC step

Construction of the output complex object schema isn’t needed for the JDBC data stream action. You can test the query and see
the query result. See Test JDBC step for more information. Configure
the MID Server properties `mid.jdbc.datastream.max.record.size` and
`mid.jdbc.datastream.fail.when.attachment.limit.exceeded` to retrieve data as
per your requirement. See MID Server properties for more information.

Data Stream action design considerations
Follow these considerations when creating a Data Stream action and when
adding a Data Stream action to a flow to prevent errors and performance
issues.

Considerations when creating a Data Stream action
Create Data Stream actions with these considerations in mind.

Write pagination logic according to third-party requirements
Evaluate and understand the format required by your third-party
endpoint. For example, you may need to write a script that sets the
built-in `getNextPage` variable to true as long as there is a `nextPage`
token in the response. If the response does not contain the token,
then set the variable to false. Access variables in script using
bracket or dot notation. For example, `variables['getNextPage']`. This
variable only accepts the Boolean data type. The default value is
false.

Convert pagination variable data types to perform math operations
Pagination variables only support the string data type. To perform
math operations, you must convert the value to an integer, perform
any required operations, then convert it back to a string.

```javascript
variables['offset'] = (parseInt(variables['offset']) +
parseInt(variables['limit'])).toString();
```

Ensure that the pagination script has an end condition
Avoid infinite loops in pagination requests by creating a condition
that sets the `getNextPage` variable to false. Cancel any long-running
flows. Always test Data Stream actions before using them in
production.

Clear configuration page options carefully
Clearing an option in a configuration page removes the step from
the Data Stream outline and deletes all data associated with the
step.

Consider the size of each page returned
When configuring pagination options, try to ensure that the size of each page returned is under one GB. This ensures that flow designers who use the action won’t encounter size limit issues when retrieving data from a MID Server. If the action returns more than one GB of data per page, the flow designer may need to increase the attachment size limit. For more information, see MID Server support for Data Stream actions.

**Note:**

- Nesting Data Stream actions is not supported.
- When using the retry policy, ensure that you are aware of these considerations:
  - Only a fixed time interval strategy is honoured for the data stream actions.
  - The total delay (count multiplied by the interval) can’t exceed 30 seconds. For example, if you want retry for a maximum of 3 times, the maximum delay for each retry is 10 seconds.
  - Data stream step doesn’t go into the waiting state during retry.

**Considerations when adding a Data Stream action to a flow**

Add a Data Stream action to a flow with these considerations in mind.

**Do not add actions with wait conditions to a Data Stream For Each logic block**

You cannot add an action that pauses the flow to a Data Stream For Each flow logic block. Data Stream actions require a constant connection to the response stream. For example, you cannot use the Ask for Approval or Wait for Condition actions within Data Stream For Each flow logic.

Some actions and steps always pause a flow and cannot be added to Data Stream For Each flow logic blocks. However, some actions and steps may pause the flow depending on how they are configured. Check the action configuration to ensure it does not pause the flow at runtime.

<table>
<thead>
<tr>
<th>Always pauses the flow (unsupported with Data Stream actions)</th>
<th>Ask for Approval action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Ask for Approval step</td>
</tr>
<tr>
<td></td>
<td>Wait for Condition action</td>
</tr>
<tr>
<td></td>
<td>Wait for Condition step</td>
</tr>
</tbody>
</table>
May pause the flow depending on configuration

Create Catalog Task action
Create Task action
Create Task step

Do not add actions that run on the MID Server to a Data Stream For Each logic block

Some actions and steps always run on a MID Server and cannot be added to Data Stream For Each flow logic blocks. However, some actions and steps may run on a MID Server depending on how they are configured. Check the action configuration to ensure it does not run on the MID Server at runtime.

<table>
<thead>
<tr>
<th>Always runs on a MID Server (unsupported with Data Stream actions)</th>
<th>JDBC step</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PowerShell step</td>
</tr>
<tr>
<td></td>
<td>SSH step</td>
</tr>
<tr>
<td>May run on a MID Server depending on configuration</td>
<td>REST step</td>
</tr>
<tr>
<td></td>
<td>Script step</td>
</tr>
<tr>
<td></td>
<td>SOAP step</td>
</tr>
</tbody>
</table>

Turn off reporting when consuming a large number of records in the For Each logic block

Iterating over a large number of records can be resource intensive, especially when the For Each logic block includes complex actions for each iteration. To avoid performance issues, turn off reporting using the com.snc.process_flow.reporting.level system property. For more information, see Flow Designer system properties.

MID Server support for Data Stream actions

Get data through a ServiceNow® MID Server when running a Data Stream action.

When selected, the MID Server retrieves the data and sends each page to the instance as an attachment to process.

⚠️ Important: When running the Data Stream action within flow, the actions in the For Each block always run on the instance.

These steps can run on either the MID Server or the instance:
• Action Preprocessing Script
• Request Script step
• REST or SOAP step

Note: Avoid shifting the execution environment between the instance and the MID Server multiple times. For example, you might configure the Request Script step to run on the MID Server, but the REST step to run on the instance. In this case, the system shifts environments between the instance and MID Server for every page of data, which may degrade performance.

To learn more about running a step on a MID Server, see Integration steps.

Size limits
If your system encounters a timeout or size limit issue, try making one of these adjustments:

Increase the REST transaction quota rule

If the connection between the instance and the MID Server slows down, you may encounter a timeout while waiting for a response from the REST step. Increase the default timeout by updating the REST Attachment API request timeout transaction quota rule.

• Default: 60 seconds
• Maximum: 300 seconds

Increase the instance timeout

By default, the instance waits for 600 seconds to retrieve a single page of data from a MID Server. If you encounter a timeout when running a Data Stream action through a MID Server, change this default by increasing the datastream_alternative_env_fetch_page_timeout_seconds system property.

• Default: 600 seconds
• Maximum: 7200 seconds

Increase attachment size

The MID Server sends each page of data to the instance as an attachment. If a page of data is large, it may exceed the allowed attachment size. Increase the allowed size by updating the com.glide.attachment.max_size system property.
Create a Data Stream action

Create a reusable action to process a stream of response data within a flow.

**Before you begin**

- Set up an application in Guided Application Creator to store Flow Designer content.
- Disable any conflicting business rules or workflows before creating an action.
- Role required: action_designer or admin

**About this task**

Creating a custom application to contain your Flow Designer content enables you to deploy it using the application repository or the ServiceNow Store.

**Note:** Clearing an option in a configuration page removes the step from the Data Stream outline and deletes all data associated with the step.

**Procedure**

1. Navigate to Flow Designer > Designer.
2. Click the Actions tab and select Data Stream.
3. Fill in the Action Properties and click Submit.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of action.</td>
</tr>
<tr>
<td>Accessible From</td>
<td>Accessible from all application scoped or only within the specified application scope.</td>
</tr>
<tr>
<td>Category</td>
<td>Defined category within the application scope for an action.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the action.</td>
</tr>
<tr>
<td>Protection</td>
<td>Select whether the action is read-only. You can only select a value when you create the action in an application scope you own. The default value is None.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the action.</td>
</tr>
</tbody>
</table>
An empty Data Stream action opens.

4. Define action inputs to make data available to the action steps.

   a. Select + Create Input and complete the fields. For more information about action inputs, see Action Designer. Inputs are represented as data pills in the right-hand pane. You can add inputs to steps and outputs in the flow by dragging and dropping data pills.

5. Click Action Preprocessing in the Data Stream outline and configure the desired options.

   a. Select Enable preprocessing script to run a preprocessing script before the action sends the initial API request. For example, validate action inputs or set default values. Preprocessing executes once per action, before the first API request.

      Selecting this option adds a script step to the Data Stream action. For more information, see Script step.

      This section can run on either the MID Server or the instance. The environment is determined by the script step's Required Runtime field.

6. Click Request in the Data Stream outline and configure the desired options.

   a. In the How will you get data field, select REST Step, SOAP Step, or JDBC Step. Selecting an option adds the associated step to the Data Stream action. For more information, see REST step, SOAP step, and JDBC step.

      This section can run on either the MID Server or the instance. The environment is determined by the Use MID server field in the associated Connection [sys_connection] record.

   Note:
   - If you are using the JDBC step, you must test it. Upon successful execution, you can use the result to create the step output and data stream action output.
   - If you are using the REST step or SOAP step, you must manually create the data stream action output.
b. Select **Enable pagination** to request results in batches. Once one page of data is processed, the Data Stream action runs the request section again to return the next set of results. This option adds a Pagination Setup step to the Data Stream outline.

⚠ **Note:** For a JDBC step, pagination is not applicable. Each page can retrieve up to 1 GB data and one request can retrieve up to 8 GB data.

c. Select **Run a script before each request** to run a script before every request for the next page when calling a paginated API. For example, write a script to transform variable data types from the initial response before sending a request for the next page. Selecting this option adds a script step to the Data Stream action. For more information, see **Script step**.

⚠ **Note:** For a JDBC step, this is not applicable.

This section can run on either the MID Server or the instance. The environment is determined by the script step's **Required Runtime** field.

⚠ **CAUTION:** Avoid shifting the execution environment between the instance and the MID Server multiple times. For example, you might configure the Request Script step to run on the MID Server, but the REST step to run on the instance. In this case, the system shifts environments between the instance and MID Server for every page of data, which may degrade performance.

7. **Optional:** If pagination is enabled, configure the Pagination Setup step. Configure the Pagination Setup step manually, or select a pre-built template to apply common configurations. For example, apply the **Limit / Offset** template to specify the number of items you want returned per page (limit), and the starting number for the first item (offset). After applying a template, update the values to ensure that the configuration complies with the API's requirements.

a. Create pagination variables. For example, if the third-party API takes a limit parameter in the request, create the limit variable and set the initial value to limit the number of results per page. The initial value is only used in the first request. The getNextPage variable is a reserved, read-only variable. As long as the getNextPage variable is true and the previous page contains data, the action continues to send requests for the next page.

b. In the **Next Value From** field, define how pagination variables receive a value for subsequent requests.
(Optional) Choose from:

- **Script**: Write a Pagination Variables Script to define how variables are populated. Pagination variables only support the string data type. To perform math operations, you must convert the value to an integer, perform any required operations, then convert it back to a string.

- **Response Body**: Use a value in the response from the previous request to populate the variable. If the response is JSON format, set Extract value using to JSONPath Expression and provide the path to the value in the Expression field. If the response is XML format, set Extract value using to XPath Expression and provide the path to the value.

**Example**
In this example, the `getNextPage` variable is true until the `nextOffset` variable reaches the total count value returned in the API response header. As long as the `getNextPage` variable is true and the previous page contains data, the action continues to send requests for the next page. This example includes a common limit/offset pagination configuration. The third-party APIs that your Data Stream action interacts with may use a page token or other method.
1. **Pagination Setup step**

**Pagination Variables**

<table>
<thead>
<tr>
<th>Name</th>
<th>Initial Value</th>
<th>Next Value From</th>
</tr>
</thead>
<tbody>
<tr>
<td>getNextPage</td>
<td>false</td>
<td>Script</td>
</tr>
<tr>
<td>limit</td>
<td>100</td>
<td>Script</td>
</tr>
<tr>
<td>offset</td>
<td>0</td>
<td>Script</td>
</tr>
</tbody>
</table>

**Pagination Variables Script**

```javascript
function paginate(variables, pageResponse) {
  var limit = parseInt(variables.limit);
  var totalCount = parseInt(pageResponse.response.headers['X-Total-Count']);
  var currentOffset = parseInt(variables.offset);
  var nextOffset = currentOffset + limit;
  if (nextOffset < totalCount) {
    variables.getNextPage = true;
    variables.offset = nextOffset.toString();
  } else {
    variables.getNextPage = false;
  }
}
```

**Important:** Avoid infinite loops in pagination requests by creating a condition that sets the `getNextPage` variable to false. Cancel any long-running flows. Always test Data Stream actions before using them in production.

8. Click **Parsing** in the Data Stream outline and configure the desired options.

**Note:** For a JDBC step, this is not applicable.

a. In the **How will you identify each record** field, select **JSON/XML Splitter**. This adds a Splitter step to the Data Stream outline.

b. In the **How will you parse each item into an object** field, select **Script Parser**. This adds a Script Parser step to the Data Stream outline.

9. Configure the Splitter step. This step identifies the parent node in the response stream to map to a complex object. For example, identify a user element in an XML payload to create a complex object for each user in the response stream.
Note: For a JDBC step, this is not applicable.

a. In the Source Format field, select the format returned by the Request section.
   - JSON: Identifies objects in a stream of JSON data.

b. In the Item Path field, define the absolute path to the object. For example, use $.result in JSON or /result in XML to separate a result object.

   Note: The system ignores XML namespaces.

Example
If the REST step returns the following JSON content, you would enter $response.result.companies as the item path to process each company object.

```json
{
    "response": {
        "result": {
            "companies": [
                {
                    "name": "company1"
                },
                {
                    "name": "company2"
                },
                {
                    "name": "company3"
                }
            ],
            "metadata": {
                "token": 1558666526
            }
        }
    }
}
```

Example
If the REST step returns the following XML document, you would enter /response/result/companies/company as the item path to process each company object.
10. In the Script Parser step, use JavaScript and ServiceNow APIs to map items in the response stream to a complex object output represented by the `targetObject` global object. For example, map incident record elements identified in the splitter step to a complex object containing incident fields. If the data stream includes siblings to the item identified in the splitter step that you do not want mapped to a complex object, include conditions to exclude those items.

**Note:** For a JDBC step, this is not applicable.

You can access outputs from previous steps in your data stream action using the `fd_data` object, excluding:

- REST or SOAP step Response Body, Stream, or Error Message outputs
- Splitter step outputs

**Example**
An example script that parses a JSON response.

```javascript
(function parse(inputs, outputs) {
  var record = JSON.parse(inputs.sourceItem);
  outputs.targetObject.id=record.number;
});
```
Example
An example script that parses an XML response.

```
(function parse(inputs, outputs) {
    var xmlDoc = new XMLDocument(inputs.sourceItem, false);
    outputs.targetObject.id = xmlDoc.getNodeText("/result/number");
    outputs.targetObject.name = xmlDoc.getNodeText("/result/short_description");
})(inputs, outputs)
```

11. Optional: If you selected the JDBC step, click Transform. After successfully testing the JDBC step, click Use Result to create the step output and data stream action output. You can use this result or customize it using the transform script.

   a. Select the Enable Transform Script check box to transform and customize the default data stream output.

12. Create a complex object output.

   ![Note](https://via.placeholder.com/15)
   Note: For a JDBC step, this is not applicable.

   a. Select Outputs in the Action Outline and click + to create an output.

   b. Update the Label field to represent the object. For example, if the action parses a stream of company records, add the Company label.

   c. Update the Type field to Object. This is the complex object output represented by the targetObject global object in the Script Parser step.

   d. Add child fields to the complex object using the + icon.

   e. Make the name of each child field more user-friendly so that you can meaningfully refer to it in script. The value in the Name field is the internal name used in the Script Parser step. For example, to refer to the City output in the Script Parser step, you would use outputs.targetObject.city.
13. Click **Save**.
   Action Designer saves a draft of the action.

**What to do next**

**Test a Data Stream action.**

**Test a Data Stream action**

Test your Data Stream action to ensure that it works the way you expect before you add it to a flow.

**Before you begin**

- Create a Data Stream action
- Role required: action_designer or admin

**About this task**

Testing a Data Stream action returns the first 20 items by default. To change this value, add the `com.glide.hub.action_type.datastream.test_max_iterations` system property with a value between one and 50.

**Procedure**

1. Open the Data Stream action you want to test.
   a. Navigate to **Flow Designer > Designer**.
   b. Select the Actions tab.
   c. Select the row for the Data Stream action you want to test.

2. Select **Test**.
   The system displays the Test Action dialog. The contents of the Test Action dialog depend on the Data Stream action inputs.

3. In the Test Action dialog, provide values for any action inputs and select **Run Test**.
4. Open the Execution Details to ensure that the action executed as expected. The Execution Details **Runtime Value** returns the first 20 items returned by the Data Stream action.

**What to do next**
Use a Data Stream action in a flow.

**Use a Data Stream action in a flow**
Data Stream actions use the **For each** flow logic option to process stream data in a flow. For example, suppose that you want to use a Data Stream action that imports document data from a third-party site. When added to a flow, the action appears as a **For each** flow logic block, enabling flow designers to easily create a record in ServiceNow for each object in the data stream.

**Before you begin**
Role required: flow_designer or admin

**Procedure**
1. Open the flow you want to add the Data Stream action to.
2. Add the Data Stream action to the flow.
   The action appears as a **For Each** flow logic block.

3. Add a child action within the **For Each** flow logic block. This action runs on each object within the data stream.

**Note:** You cannot add an action that pauses the flow to a Data Stream For Each flow logic block. Data Stream actions require a constant connection to the response stream. For example, you cannot use the Ask for Approval or Wait for Condition actions within Data Stream For Each flow logic. For more information, see [Data Stream action design considerations](#).
4. Click **Save**.
   Flow Designer saves a draft of the flow, trigger, and actions.

**What to do next**
Test the flow until it is ready to be activated.

**Note:** The system only triggers active flows.

**REST API trigger**
Start a flow from an inbound API call or webhook from an external system.
Configure the trigger start conditions without having to write or maintain custom code.

For example, you can create a flow that starts when a third-party IT ticket tracking system sends an inbound request to the instance. You can then parse the data from the inbound REST request into a complex data object and use the values to open an Incident on your instance.

Once you activate the flow, the endpoint that you created appears in the API explorer under the namespace you created. You can use this page to help define the webhook in your third-party system and to test your flow.

To learn more about flow triggers, see [Flow trigger types](#).

**Note:** Use the REST API Trigger to start flows from REST calls from external systems. To start a flow from a script or API call from the same instance, use a subflow, code snippet, or Flow Designer API. See [API access to Flow Designer](#) and [Create code snippets for flows, sub-flows, and actions](#).

**Available data pills**
Depending on how you configure the endpoint, flow designers have access to these data pills from the trigger:

**Path Parameters**
An object containing path parameters in the inbound request.

**Query Parameters**
An object containing query parameters in the inbound request.

**Request Headers**
An object containing headers in the inbound request.

**Request Body**
Complex data object that defines the body structure of the inbound request. For more information on complex objects, see [Complex data](#).

When setting up the trigger, define what the inbound data will look like. You can then use the associated data pills within the actions in your flow. When the system receives an inbound request that starts the flow, it uses the runtime values sent in the request.

### Create a flow using the REST API trigger
Create a flow that starts when a third-party system sends a REST request to your instance.

**Before you begin**
Role required: flow_designer or admin

> **Note:** This feature requires an IntegrationHub Enterprise subscription. For more information, see [Request IntegrationHub](#).

**Procedure**

1. Open Flow Designer and create a flow. See [Create a flow](#).
   
   Keep in mind that the scope of your flow is included in the REST endpoint you create.

2. In the TRIGGER section, select the **REST API - Asynchronous** trigger.

3. In the **HTTP Method** field, set the HTTP method for the endpoint.
   
   Options include:
   
   - POST
   - GET
   - DELETE
   - PUT
   - PATCH

4. Create any path parameters required for the endpoint and add them to the relative path in the Path field.
   
   The relative path to the endpoint is in the format `/api/<flow-application-scope>/<flow-name>/<path-parameters>`.
You can click **Copy** to copy the full path to the endpoint. Use this path when configuring the endpoint for the REST call in your third-party system.
a. Create variables in the **Path Parameters** section.

b. Drag the data pill that represents the path parameter into the empty input in the **Path** field. This field only accepts data pills from the **Path Parameters** section.

5. Select **Requires authentication** to require authentication headers in the inbound REST request.

6. If **Requires authentication** is selected, add the roles required to authorize the request in the **Requires roles** field.

7. In the **Body** field under the **Request Content** section, create a complex data object that defines the body structure of the inbound request. For more information on building a complex object, see **Complex data**.

**Note:** The **Request Content** section only appears when the **HTTP Method** is POST, PUT, or PATCH.

This example body finds the Description field in an inbound payload that contains ticket information from a third-party ticket-tracking system.
8. In the **Headers** field, define the headers to be sent in the inbound request. Select **Required** to require that the inbound request include them.

9. In the **Query Parameters** field, define the query parameters to be sent in the inbound request. Select **Required** to require that the inbound request include them.

10. Add actions to your flow that execute when the endpoint is called. You can use the data pills from the REST API trigger in your flow actions. This action creates an Incident record and maps the Description and Assignment Group fields from the incoming payload to the Incident.

11. Test and activate the flow. For more information, see **Test a flow** and **Activate a flow**.
Once activated, the endpoint displays in the REST API Explorer. You can use this page to further test your endpoint, or configure the request from your third-party system.

12. Configure the REST request from your third-party system.

**Example**

For example, you can send this cURL request to trigger the flow defined in previous steps.

```bash
curl 
"https://your-instance.servicenow.com/api/now/create_incident_from_external_event/assignment_group/287ebd7da9fe198100f92cc8d1d2154e" 
--request POST 
--header "Accept:application/json" 
--header "Content-Type:application/json" 
--data "{
  fields: {
    description: "Major outage with data loss"
  }
}"
--user 'username':'password'
```

**Results**

The flow executes and the REST request returns the execution ID.
What to do next

Copy the execution ID in the result and navigate to the Executions tab in Flow Designer. You can filter by execution ID to locate the execution details and view the status of the execution.

To troubleshoot issues, you can debug the REST query or check the flow execution details. See and Flow execution details.

Integration steps

Enable custom actions to integrate with external systems by activating IntegrationHub, which adds integration steps to the Action Designer interface.

Integration steps can run on the instance or a MID Server. A MID Server is required to communicate with or move data between a ServiceNow instance and external applications, data sources, and services in your network.

Note: Only Flow Designer admin and Connection admin can execute flows using IntegrationHub.

Steps that perform operations on record data run on the instance, while steps that integrate with systems in your network run on a MID Server. If a step requires a MID Server to run, the instance delegates flow processing to the appropriate
MID Server by sending the process plan in a REST call. The MID Server executes the action or step in the process plan and returns results. View log messages and execution status from the instance or the MID Server.

**Available integration steps**

These integration steps are available from Action Designer.

<table>
<thead>
<tr>
<th>Integration step</th>
<th>Description</th>
<th>Step runs from</th>
</tr>
</thead>
<tbody>
<tr>
<td>JDBC step</td>
<td>Create a reusable action to send SQL commands to a relational database.</td>
<td>MID Server</td>
</tr>
<tr>
<td>Payload Builder step</td>
<td>Enable action designers to easily create name-value pairs in JSON and XML payloads using dynamic data.</td>
<td>• Instance</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MID Server</td>
</tr>
<tr>
<td>PowerShell step</td>
<td>Run PowerShell scripts on remote machines from your ServiceNow instance through a MID Server.</td>
<td>MID Server</td>
</tr>
<tr>
<td>REST step</td>
<td>Send an outbound REST web service request to an external system.</td>
<td>• Instance</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MID Server</td>
</tr>
<tr>
<td>SOAP step</td>
<td>Enable action designers to send outbound SOAP web service requests to external systems.</td>
<td>• Instance</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MID Server</td>
</tr>
<tr>
<td>SSH step</td>
<td>The SSH step executes SSH commands on an external *nix system through a ServiceNow® MID Server. The step also stores scripts and commands for the *nix systems.</td>
<td>MID Server</td>
</tr>
<tr>
<td>XML parser step</td>
<td>Identify structured data from an XML payload without having to write.</td>
<td>• Instance</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MID Server</td>
</tr>
<tr>
<td>Integration step</td>
<td>Description</td>
<td>Step runs from</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
<td>----------------</td>
</tr>
<tr>
<td></td>
<td>script. Map incoming XML elements to a complex object output that you can use in other steps or actions. At runtime, values from an XML payload populate the complex object output.</td>
<td></td>
</tr>
</tbody>
</table>

**Training**

Complete a step-by-step training on using the REST step in the REST in IntegrationHub developer training.

**Connection attributes**

Define connection-specific variables that you can use in IntegrationHub integration steps. When using an integration step, you must establish a connection with an external system. Use a Connection & Credential alias instead of defining the connection inline. An alias enables you to update the connection details once without having to reconfigure every action. Any action step that uses an alias inherits the attributes associated with it. Flow Designer displays attributes as data pills that you can drag into your action step. For example, you can create a page size attribute that becomes a REST step query parameter. For more information about connection attributes, see Create connection attributes for IntegrationHub.

**MID Server connection aliases**

Action designers can set MID Server selection attributes using a connection record associated with an alias and associate the alias with an integration step. When the flow runs, the system uses the attributes to determine which MID Server runs the step. Learn more about connection and credential aliases.

**MID Server selection**

Flow designers should avoid shifting the execution environment between MID Servers when a flow runs. Either configure your MID Servers to perform operations on multiple endpoints, or provide multiple capabilities to the MID Servers in your network. You may need a user with the connection_admin role to update the connection records associated with an action, or a network administrator to update the MID Server network configuration. To learn more about how a MID Server is selected during runtime, see MID Server selection.
Design considerations

Design integration steps using the following guidelines.

• Avoid shifting the execution environment between the instance and the MID Server multiple times. Where possible, group similar action steps. For example, group core steps that perform record operations and integration steps that run on the MID Server.

• When creating a spoke that uses an integration step, include a Connection and Credential alias record with the appropriate connection type. Before anyone can use the spoke, a user with the connection_admin role must associate the alias record to a connection record that supports the connection type. If defining the connection inline, use inputs to enable the process analyst to define the connection information when adding the action to a flow.

• The MID Server does not have access to all the values in a GlideRecord object, it only has access to the sys_id reference. Inputs of type Reference do not work on a MID Server. Instead, create action inputs that contain the necessary GlideRecord values.

Roles

To create integration steps, a user must have the action_designer or admin roles. If running steps on a MID Server, the MID Server user must have the connection_admin and credential_admin roles to access the connection and credential information associated with the step.

Federal Information Processing Standards (FIPS) support for outbound integrations

ServiceNow National Security Cloud (NSC) is designed for U.S. federal, state, and local government customers. NSC is authorized and compliant with the Federal Risk and Authorization Management Program (FedRAMP) High and Department of Defense (DoD) Impact Level 5 (IL-5) requirements.

FedRAMP

FedRAMP provides a standardized approach to security and risk assessment for cloud technologies and U.S. federal agencies. For more information about FedRAMP, visit https://www.fedramp.gov/

The FIPS 140-2 standard specifies the security requirements for cryptographic modules that include hardware, software, and firmware for U.S. federal agencies. For more information about FIPS 140-2 standards, see https://csrc.nist.gov/publications/detail/fips/140/2/final.
The FIPS 140-2 standard has security requirements that cover 11 areas that are related to design and implementation of a cryptographic module. Four security levels are specified for each of the 11 areas. Each security level offers increased security over the preceding level. Each module defines its own security policy (which means the accurate specification of the security rules under which it operates) and employs approved cryptographic algorithms, cryptographic key management, and authentication techniques.

The Bouncy Castle (BC) FIPS Java APIs are a suite of FIPS approved algorithms that are implemented in Java. For more information about Bouncy Castle, see [https://www.bouncycastle.org/documentation.html](https://www.bouncycastle.org/documentation.html).

**Enabling the FIPS approved mode**

By using the `org.bouncycastle.fips.approved_only` system property, you can enable the FIPS approved mode. For assistance on how to enable the FIPS approved mode, contact Now Support.

When the FIPS approved mode is enabled, FIPS-compliant ciphers and random generators are used for data-in-transit, and Transport Layer Security (TLS) protocols are used for data-in-rest.

- For outbound HTTPS calls, only TLS v1.2 and v1.3 protocols are supported. You can use any action or step that has a **Connection** field to specify a connection to a URL endpoint, such as the **REST step**, **SOAP step**, **PowerShell step**, and **Data Stream Actions**.
- Only **ServiceNow SSH step** is supported.

⚠️ **Note**: The FIPS approved mode can be enabled only for National Security Cloud (NSC) DoD IL-5 environments.

For the non-FIPS mode, the `org.bouncycastle.fips.approved_only` system property is set to false by default.

**JDBC step**

Create a reusable action to send SQL commands to a relational database.
Note:

• The JDBC step is not available in the base system and requires the subscription to IntegrationHub Standard Pack Installer (com.glide.hub.integrations.standard) or later. For more information about the ServiceNow® IntegrationHub subscription packages, see IntegrationHub usage and subscription. After the required plugin is activated, the step is visible under Integrations.

• The JDBC step runs only on a ServiceNow® MID Server with JDBC step capabilities. Activate the plugin, IntegrationHub Standard Pack Installer (com.glide.hub.integrations.standard) or later to use the JDBC capability for the MID Server.

Roles and availability
The JDBC step is available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Sanitizing inputs
Escape all user inputs to eliminate the possibility of a malicious user from executing malicious SQL statements that can result in SQL injection on your target database. When you use data pills in JDBC step SQL statements, sanitize them first using Sanitize SQL transform functions. This transform function category automatically appears when a data pill is dropped into the SQL Statement input.

SQL operations inclusion list
By default, you can run the following SQL operations.

• SELECT
• INSERT
• UPDATE
• DELETE
• SHOW
• DESCRIBE

To enable only some of these SQL operations that the JDBC step can perform, create a MID Server property, mid.property.jdbc_operations and enter the SQL operations, separated by comma. To learn more about MID Server properties, see MID Server properties.
## Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection Details</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Connection</strong></td>
<td>Type of connection to use.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Define Connection Inline</strong>: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Connection Alias</strong>: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action.</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see credentials, connections, and aliases.</td>
</tr>
<tr>
<td><strong>Connection Alias</strong></td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when <strong>Use Connection Alias</strong> is selected from the Connection list.</td>
</tr>
<tr>
<td><strong>Credential Alias</strong></td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>pill on the data panel. This field is available when Define Connection Inline is selected from the Connection list.</td>
<td></td>
</tr>
</tbody>
</table>
| Database Type       | Database type for this connection. The choices are:  
  • MySQL  
  • Oracle  
  • SQLServer  
  • Custom  
  The default choice is Custom. This field is available when Define Connection Inline is selected from the Connection list. |
<p>| JDBC Driver         | Driver to use for this connection when it's not a default database type such as DB2 Universal and Sybase. The database Type is Custom. This field is available when Define Connection Inline is selected from the Connection list and Custom is selected from the Database Type list. |
| Connection URL      | URL that the MID Server uses to connect to the specified database. The URL is created automatically when you save the form, and is read-only for the default databases. This field is available when Define Connection Inline is selected from the Connection list and Custom is selected from the Database Type list. |
| MID Application     | Application that the MID Server must support to be eligible for selection. This field is available when Define Connection Inline is selected from the Connection list. |
| Capabilities        | Capability of the MID Server. Select JDBC. This field is available when Define Connection Inline is selected from the Connection list. |
| Connection Timeout  | Maximum elapsed time, in seconds, for the activity to wait while attempting to connect to the target database. This field is available when Define Connection Inline is selected from the Connection list. |
| Query Timeout       | Maximum elapsed time, in seconds, that the query is allowed to run without a response. This field is available when Define Connection Inline is selected from the Connection list. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JDBC Configuration</td>
<td>SQL statement that the step executes.</td>
</tr>
<tr>
<td>SQL Statement</td>
<td>SQL statement that the step executes.</td>
</tr>
<tr>
<td>Note:</td>
<td>When you use data pills in step SQL statements, sanitize them first using a preprocessing <strong>Script step</strong>. For more information, see <strong>Sanitizing inputs using the escape functions</strong>.</td>
</tr>
<tr>
<td>Maximum Rows</td>
<td>Maximum number of rows to be returned from the SQL statement. The default value is <strong>1000</strong>.</td>
</tr>
<tr>
<td>Maximum Payload Size (KB)</td>
<td>Maximum allowable payload size, in KB, to be returned from the SQL statement. The default payload size is <strong>5120 KB</strong>. The maximum payload size is <strong>5 MB</strong>.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Option to enable the retry policy. For more information, see <strong>Retry policy</strong>.</td>
</tr>
<tr>
<td>Enable Retry Policy</td>
<td>Option to enable the retry policy. For more information, see <strong>Retry policy</strong>.</td>
</tr>
<tr>
<td>Override Default Policy for Alias</td>
<td>Option to override the default retry policy. This option is not applicable when <strong>Define Connection Inline</strong> is selected from the Connection list.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Default retry policy associated with <strong>Connection Alias</strong>. If <strong>Override Default Policy for Alias</strong> is selected, you can override the default retry policy and select another existing retry policy based on your requirement.</td>
</tr>
</tbody>
</table>

**Test JDBC step**

Test the JDBC step before testing or publishing an action that contains the JDBC step.

**About this task**

It is mandatory that you test the JDBC step before testing the action. Testing ensures that the relevant complex object output schema is created from table columns, which can be used as data pills in subsequent steps.

**Procedure**

1. Navigate to **Process Automation > Flow Designer**.
2. Create an action with a JDBC step.
3. Click **Test JDBC Step**.
   The **Test JDBC Step** pop-up window is displayed.
4. If the JDBC step takes an action input or output of the previous step as its input, provide required input values in the **Step input pills** field to test the JDBC step.

   - **Note:** Input values in the **Step input pills** fields are not needed when records are updated, inserted, or deleted.

5. Click **Run Test**.

   - When a SELECT query is executed, **Sample Result** is displayed in the **Test JDBC Step** pop-up window. **Sample Result** includes column names, columns types, and the values of the first row.
   - When an UPDATE, INSERT, or DELETE query is executed, a message is displayed mentioning the number of rows affected.

6. To use the sample result as the JDBC step output, click **Use Result**.

   - **Note:** **Use Result** is not displayed when records are updated, inserted, or deleted.

7. To retrieve schema of a different table when a SELECT query is executed in the JDBC step, enter the required value in the **Step input pills** field and click **Run Test**.

**Results**

When a SELECT query is executed in the JDBC step, **ResultSet** is displayed under **Outputs**. The relevant complex object output is populated. To learn more about complex objects, see **Complex data**.

**What to do next**

Test and publish the action.

**JSON parser step**

Identify structured data from a JSON payload without having to write a script. Map incoming JSON content to a complex object output that you can use in other steps or actions. At runtime, values from a JSON payload populate the complex object output.

To learn more about complex objects, see **Complex data**.

- **Note:** The JSON parser step is not available in the base system and requires the IntegrationHub Standard Pack Installer. After the required plugin is activated, the step is visible under Integrations.
Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Payload size limit

At runtime, JSON parser step supports payloads up to 10 MB. For larger payloads, create a Data Stream action. For more information on Data Stream actions, see Data Stream actions and pagination.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Source              | In the **Source data** field, select or drag a data pill that contains the source JSON payload. For example, a REST step **Response Body** data pill. At runtime, values from the data source populate the complex object output. Under **Source data** and in the scripting window, enter an example payload to generate your complex object. For example, if parsing the response from a REST step that returns a list of users, enter the expected JSON object for a single user. You can create any example JSON payload with the following limitations:  
  - Multidimensional arrays are not supported.  
  - Hyphens, periods, spaces, double colons, and the @ symbol in JSON keys are not supported.  
  - Your example payload can't exceed 2 MB. |
<p>| Structured Payload View | View your example payload as regular JSON, or toggle <strong>Structured Payload View</strong> to view the payload in a structured node tree. Select a node in the tree to copy the element's JSONPath. If you add new elements in the <strong>Target</strong> field manually, you can paste this JSONPath under an element's advanced options. |
| Generate Target     | Select <strong>Generate Target</strong> to create the step's output structure from your example payload. Your output data structure appears in the <strong>Target</strong> field. Child elements for each object are automatically generated as type String. Alternatively, you can manually create your target complex object by adding elements in the <strong>Target</strong> field. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Target  | View or edit the JSON payload's output structure. Create a structured output by clicking **Generate Target**, or manually add elements. Each element contains the following information in the Edit Object view:  
  - **Label**: Data pill label. By default, the system uses the JSON key name.  
  - **Name**: Internal name for the output element.  
    - **Note**: Exclamation marks, double colons, the @ symbol, or numbers only aren't valid values for an element's name.  
  - **Type**: Data type, which must be String, Object, Array.String, or Array.Object. The top-level element must be an Object.  
  - **Mandatory**: Toggle to make the element required. This only applies to elements of type String.  
  - **Add child item**: Select the add child item icon (➕) to add a nested child element.  
  
Elements of type Object contain the **Save as Template** advanced option, which allows you to save your object's structure as a complex object template. You can then use this template to define the schema of an Object output for your action.  
For elements of type String, you can also add a max length, hint, and default value as advanced options.  
In the Target header, select **Exit Edit Mode** when you're done making changes to your output's structure. You can then select the toggle advanced inputs icon (🔧) to view the following options for each element:  
  - **JSONPath**: Path to the element. Modify the JSONPath to change how your source data elements map to elements in your output. If manually adding elements, you can copy the JSONPath from a node in your example payload and paste it under an element's advanced options.  

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
JSON parser step example

This example tracks newly created problems from a production instance as defects in a test instance. First, create a new action named **Parse Problems from Production**. Add a REST step to retrieve a list of problems from the production instance. Then, add the JSON parser step to parse the REST step’s **Response Body** and provide a complex object output that represents the Problem [problem] table’s schema. Finally, create an action output of type Object named **Problems from Production**. Drop the root data pill from the JSON parser step into this output’s value field.

Next, create a new flow named **Sync New Problems**, which is triggered daily at midnight. The first action in the flow is the **Parse Problems from Production** action. Then, add a **For Each** flow logic block and drop the **Problems from Production > response** data pill into the **Item** field. Within the **For Each** block, add an **If** flow logic block that checks if each problem’s state is new, then creates a defect record in the test instance whose assignment group and short description is mapped to each new problem from the production instance.
Sync New Problems flow

Payload Builder step

Enable action designers to easily create name-value pairs in JSON and XML payloads using dynamic data.

Roles and availability

• Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name Value Pairs</td>
<td>The name-value pairs to include in the payload. Click the plus icon to add name-value pairs. Drag data pills into either field to produce dynamic payloads. The Name becomes a key in JSON and an element in XML. For example, suppose you create this name-value pair.</td>
</tr>
<tr>
<td></td>
<td>• Name: short_description</td>
</tr>
<tr>
<td></td>
<td>• Value: [action]-&gt;[short_description]</td>
</tr>
</tbody>
</table>

When the system formats the name-value pair as JSON:

`"short_description": "[action]->[short_description]"`

When the system formats the name-value pair as XML:
<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Omit if empty</td>
<td>The option to exclude a name-value pair if the value is empty or null.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field is only visible after clicking the down arrow to display advanced options.</td>
</tr>
<tr>
<td>Output Format</td>
<td>The payload file format.</td>
</tr>
<tr>
<td></td>
<td>• <strong>JSON</strong>: Select to format the payload as a JSON document.</td>
</tr>
<tr>
<td></td>
<td>• <strong>XML</strong>: Select to format the payload as an XML document.</td>
</tr>
<tr>
<td>Namespace</td>
<td>The XML namespace to apply to each element. For example, when the namespace is set to <code>incident</code>:</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field is only visible when the <strong>Output Format</strong> is set to <strong>XML</strong>.</td>
</tr>
<tr>
<td>Include Outer Structure</td>
<td>The option to include or exclude a top level container appropriate to the output format. When the <strong>Output Format</strong> is JSON, curly braces contain the name-value pairs. When the <strong>Output Format</strong> is XML, a specified XML element contains the name-value pairs.</td>
</tr>
<tr>
<td></td>
<td>For example, when the system formats the name-value pair as JSON:</td>
</tr>
<tr>
<td></td>
<td><code>{   &quot;short_description&quot;: &quot;[action]-&gt;[short_description]&quot; }</code></td>
</tr>
<tr>
<td></td>
<td>When the system formats the name-value pair as XML:</td>
</tr>
<tr>
<td></td>
<td><code>&lt;xml&gt;   &lt;short_description&gt;[action]-&gt;[short_description]&lt;/short_description&gt; &lt;/xml&gt;</code></td>
</tr>
<tr>
<td>Send Empty Structure</td>
<td>The option to send valid JSON or XML structures when the payload is empty. Enable this option to include JSON or XML structural text in the payload.</td>
</tr>
<tr>
<td></td>
<td>For example, when the system formats an empty structure as JSON:</td>
</tr>
<tr>
<td></td>
<td><code>{ }</code></td>
</tr>
<tr>
<td></td>
<td><code>&lt;xml&gt;   &lt;short_description&gt;&lt;/short_description&gt; &lt;/xml&gt;</code></td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| {} | When the system formats an empty structure as XML:  
<xml></xml>  
Disable this option to produce an empty payload.  
Empty payloads can occur when you select the **Omit if empty** option for every name-value pair, and all name-value pairs in the payload produce empty values. |
| Parent Node | The name of the XML element that contains the name-value pairs. The default parent node element is `xml`.  
**Note:** This field is only visible when the **Output Format** is set to **XML** and the option to **Include Outer Structure** is enabled. |
| Preview | The read-only payload the step produces. |

**PowerShell step**

Run PowerShell scripts on remote machines from your ServiceNow instance through a MID Server.

PowerShell is built on the Windows .NET Framework and is designed to control and automate the administration of Windows machines and applications. ServiceNow supports PowerShell 3.0 to 5.1. PowerShell 3.0 does not support Windows 2003 Server.

**Note:** PowerShell step is not available in the base system and requires the ServiceNow® IntegrationHub subscription. After the required plugin is activated, the step is visible under Integrations.

**Roles and availability**

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Type of connection to use.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• <strong>Define Connection Inline</strong>: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Connection Alias</strong>: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action.</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see credentials, connections, and aliases.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel.</td>
</tr>
<tr>
<td></td>
<td>✨ Note: This field is available when <strong>Use Connection Alias</strong> is selected from the Connection list.</td>
</tr>
<tr>
<td>Credential Alias</td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Host</td>
<td>Specify the fully-qualified domain name of the target host where the system runs the action step. For example, host.domain.com. <strong>Note:</strong> This field is only visible when the <strong>Connection</strong> is <strong>Define Connection Inline</strong>.</td>
</tr>
<tr>
<td>Port</td>
<td>Specify the communications port on which the target host listens for connections. For example, 5985. Leave blank to use the default port. <strong>Note:</strong> This field is only visible when the <strong>Connection</strong> is <strong>Define Connection Inline</strong>.</td>
</tr>
<tr>
<td>MID Selection</td>
<td>Option to select MID Server as required. This field is available when <strong>Define Connection Inline</strong> is selected from the Source Connection list.</td>
</tr>
<tr>
<td>MID Application</td>
<td>Specify the application the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected application. If you use a data pill for this field, the pill must reference the MID Application’s name, not the MID Application record. <strong>Note:</strong> This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list and <strong>Auto-Select MID Server</strong> is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capabilities the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected capabilities. <strong>Note:</strong> This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list and <strong>Auto-Select MID Server</strong> is selected from the MID Selection list.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Data pill of the required MID Server. <strong>Note:</strong> This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list and <strong>Specific MID Server</strong> is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Remoting Type</td>
<td>The location where the PowerShell script runs such as the MID or a remote server.</td>
</tr>
</tbody>
</table>
### Field Description

- **Explicit Remoting (Most Common):** Establish a connection with and run the script on a remote server.

- **Implicit Remoting (Advanced):** Run a script on a MID Server while importing necessary modules from a remote server. If selected, define the **Remote name prefix** and **Modules to import** fields. For optimal performance, only import modules necessary to the step. If blank, all available modules are imported from the server.

- **Run on a MID Server or have your script establish a remote session:** Run a script directly on a MID Server, or define remoting specifications within the script. This value is the default.

  **Note:** To invoke a function in a PowerShell script command or PowerShell script file, the command must define the function param block if the function has input parameters. This requirement applies to explicit and implicit remoting. For additional information on param block, see Microsoft's documentation on Windows Powershell parameters at [https://technet.microsoft.com/](https://technet.microsoft.com/).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote name prefix</td>
<td>The file path, excluding file names, to the modules to load from the remote server.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only visible when the Remoting Type is Implicit Remoting (Advanced).</td>
</tr>
<tr>
<td>Modules to import</td>
<td>The comma-separated list of modules to import from the remote server at the defined file path.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only visible when the Remoting Type is Explicit Remoting (Most Common) or Implicit Remoting (Advanced).</td>
</tr>
<tr>
<td>Script type</td>
<td>The type of script to run on the PowerShell host.</td>
</tr>
<tr>
<td></td>
<td><strong>Inline script:</strong> Enter the script to run in the Command field of the step.</td>
</tr>
<tr>
<td></td>
<td><strong>MID Server Script File:</strong> Select the PowerShell script to run from the MID Server Script Files [ecc_agent_script_file]</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>This is the default value and separates scripting logic from the action, enabling you to update the script without having to modify and redeploy the action.</td>
</tr>
<tr>
<td>MID Server Script</td>
<td>Pre-defined PowerShell script from the MID Server Script Files table [ecc_agent_script_file].</td>
</tr>
<tr>
<td></td>
<td>⚠ Note: This field is only available if the Script type is MID Server Script File.</td>
</tr>
<tr>
<td>Script path</td>
<td>Read-only path to the selected MID Server script.</td>
</tr>
<tr>
<td></td>
<td>⚠ Note: This field is only visible when the Script type is MID Server Script File.</td>
</tr>
<tr>
<td>Input variables</td>
<td>The optional name-value pairs that represent the values of PowerShell script variables. You can use action inputs and data from other steps within the PowerShell script. Define the following fields for each variable:</td>
</tr>
<tr>
<td></td>
<td>• Name: The name of the script variable to pass a value to. The name cannot match a reserved or prohibited PowerShell variable. Some variable names are reserved for internal processing and should not be used as input variables. See Reserved variables in PowerShell scripting variables.</td>
</tr>
<tr>
<td></td>
<td>• Type: The type of PowerShell variable. Select plain text, encrypted, or boolean. If encrypted is selected, the value appears in plain text in this field and is only encrypted when it passes to the ECC Queue.</td>
</tr>
<tr>
<td></td>
<td>• Value: The value to map to the variable. Manually enter a value, or drag a data pill into the field.</td>
</tr>
<tr>
<td>Command</td>
<td>The inline PowerShell script to run on the target host.</td>
</tr>
<tr>
<td></td>
<td>⚠ Note: This field is only visible when the Script type is Inline script.</td>
</tr>
</tbody>
</table>

**PowerShell scripting variables**

To access input variables from the Command field, you must call them using special syntax. The syntax you use depends on the value of a system property. If the Remoting Type is Run on a MID Server or have your script establish a remote session, some reserved variables are available in addition to input variables.
Input variable syntax

By default, prefix variable names with a $ character. For example, if an input variable is named `message`, use `$message` to access the variable in script.

If the `mid.powershell.command.script.parameter_passing` parameter is set to false, prefix the variable name with `$env:SNC_`. For example, if an input variable is named `message`, use `$env:SNC_message` to access the variable in script. To learn more about the `mid.powershell.command.script.parameter_passing` parameter, see MID Server parameters.

Reserved variables

When the Remoting Type is Run on a MID Server or have your script establish a remote session, the following variables are available for use in script. Reserved variables cannot be used as custom input variable names.

<table>
<thead>
<tr>
<th>Reserved variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>$computer</code></td>
<td>Host IP address defined in the Connection alias record.</td>
</tr>
<tr>
<td><code>$cred</code></td>
<td>Credential object that contains the credentials defined in the connection record. Use this variable with any PowerShell cmdlet that supports the credential parameter. For example, <code>New-PSSession -credential $cred</code>.</td>
</tr>
<tr>
<td><code>$log_info</code></td>
<td>If the <code>mid.property.powershell.log_info</code> property is set to true, adds logging information to a PowerShell script.</td>
</tr>
</tbody>
</table>

The following variable names are reserved for internal processing and should not be used as input variables.

- `script`
- `useCred`
- `isMid`
- `isDiscovery`
- `debug`
- `user`
REST step
Send an outbound REST web service request to an external system.

Note: REST step is not available in the base system and requires the ServiceNow® IntegrationHub subscription. After the required plugin is activated, the step is visible under Integrations.

Outbound REST web service is a platform feature that enables you to retrieve, create, update, or delete data on a web services server that supports the REST architecture.

Roles and availability
- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Type of connection to use.</td>
</tr>
<tr>
<td></td>
<td>• Define Connection Inline: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• Use Connection Alias: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action.</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see credentials, connections, and aliases.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field is available when Use Connection Alias is selected from the Connection list.</td>
</tr>
<tr>
<td>Credential Alias</td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Use MID</td>
<td>Option to use a ServiceNow® MID Server to run the REST step. Select this check box to display the MID Application and Capabilities fields.</td>
</tr>
<tr>
<td>Note:</td>
<td>The system doesn’t log REST request, response, and parameter runtime data sent via a MID server in the same way that outbound web services logging occurs. Instead, you can view this data in the flow execution details.</td>
</tr>
<tr>
<td>Base URL</td>
<td>Base URL for the REST request. If Use Connection Alias is selected, this field is read-only and displays</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>the base URL</td>
<td>the base URL associated with alias. If <strong>Define Connection Inline</strong> is selected, enter a base URL for the connection.</td>
</tr>
<tr>
<td>Number of milliseconds the system waits for a successful host connection. If the step does not make a successful connection during this time, the connection request times out. If <strong>Define Connection Inline</strong> is selected, enter a timeout value for the connection. Leave this field empty to use the system default connection timeout value.</td>
<td></td>
</tr>
<tr>
<td>Option to select MID Server as required. This field is available when <strong>Define Connection Inline</strong> is selected from the Source Connection list.</td>
<td></td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capabilities the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected capabilities. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list, <strong>Use MID</strong> check box is enabled, and <strong>Auto-Select MID Server</strong> is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Data pill of the required MID Server. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list, <strong>Use MID</strong> check box is enabled, and <strong>Specific MID Server</strong> is selected from the MID Selection list.</td>
<td></td>
</tr>
<tr>
<td>Option to create the request manually, or import an OpenAPI Specification.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Manually</strong></td>
<td>Create action inputs and complete the REST step form manually.</td>
</tr>
<tr>
<td><strong>From OpenAPI specification</strong></td>
<td>Import an OpenAPI Specification to generate action inputs and complete the REST step form. For more information, see OpenAPI support in the REST step.</td>
</tr>
<tr>
<td>API Source</td>
<td>Option to select an OpenAPI Specification used to construct the request, or select Import OpenAPI to import a new OpenAPI Specification. You can import specifications by providing a URL to the YAML or JSON, or copying and pasting content.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available when you select From OpenAPI specification from the Build Request list.</td>
</tr>
<tr>
<td>API Operation</td>
<td>Option to select an operation from the list. Available operations are provided by the OpenAPI Specification in the API Source field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available when you select From OpenAPI specification from the Build Request list.</td>
</tr>
<tr>
<td>Resource Path</td>
<td>Path for the resource.</td>
</tr>
<tr>
<td>HTTP Method</td>
<td>HTTP method used to process the request.</td>
</tr>
<tr>
<td></td>
<td>• GET</td>
</tr>
<tr>
<td></td>
<td>• POST</td>
</tr>
<tr>
<td></td>
<td>• PUT</td>
</tr>
<tr>
<td></td>
<td>• PATCH</td>
</tr>
<tr>
<td></td>
<td>• DELETE</td>
</tr>
</tbody>
</table>
| Query Parameters      | Name-value pairs to pass to the REST endpoint. You can create these parameters manually, or drag input variables into the parameter fields, and then assign a value. | Support REST step requests that contain duplicate query parameter names. If you create a REST request that contains duplicate query parameter names,
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flow Designer</td>
<td>Flow Designer adds the query parameters to the request in the same order as you defined them.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When importing an OpenAPI Specification, the system adds all parameters and headers present in the specification to the REST step. Review the final REST step values and remove parameters you do not want to send in the request. For example, if the API accepts content type headers for both JSON and XML, the system adds both headers to the REST step. Remove one of the headers depending on the content type you want to receive in the response.</td>
</tr>
<tr>
<td>Headers</td>
<td>Headers to send with the request. You can create headers manually, or drag input variables into the parameter fields, and then assign a value.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When importing an OpenAPI Specification, the system adds all parameters and headers present in the specification to the REST step. Review the final REST step values and remove parameters you do not want to send in the request. For example, if the API accepts content type headers for both JSON and XML, the system adds both headers to the REST step. Remove one of the headers depending on the content type you want to receive in the response.</td>
</tr>
<tr>
<td>Request Type</td>
<td>Format of the request. Options include.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Text:</strong> A request in JSON, XML, or other text format.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Binary:</strong> A request in a binary file format.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Multipart:</strong> A request consisting of multiple content types.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Form URL-Encoded:</strong> A request in a URL-encoded query.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is editable when the HTTP Method is POST, PUT, PATCH, or DELETE.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Request Body [Text]         | Body of the request in JSON or XML format. The flow execution details display the response body as either a link to the embedded text viewer or the sys_id of the attachment record containing the response.  
**Note:** This field is editable if you select **Text** from the Request Type list. |
| Attachment                  | Attachment record containing the request. You can look up or create this record in a prior step and define it as an input variable. Create it using the JSONStreamingBuilder and XMLStreamingBuilder APIs in the Script step.                                                            
**Note:** This field is available when you select **Binary** from the Request Type list. |
| Name, Type, Value           | Content of a multiple part request. For each request part, specify its name, content type, and value. The name can be any valid string and the type can be any valid type. The value must match the content type.  
For attachments, specify:  
• **Type:** attachment.  
• **Value:** The sys_id of the Attachment record containing the content. You can look up this record in a prior step or define it as an input variable.  
**Note:** These fields are available when you select **Multipart** from the Request Type list. |
| Name, Value                 | Content of a form URL-encoded request. Specify each part of the URL-encoded request with a name-value pair.  
**Note:** This field is available when you select **Form URL-Encoded** from the Request Type list.                                                                                                                                |
<p>| Enable Retry Policy         | Option to enable the retry policy. For more information, see <strong>Retry policy</strong>.                                                                                                                                                                                                 |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Override Default Policy for Alias</td>
<td>Option to override the default retry policy. This check box is not applicable when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Default retry policy associated with Connection Alias. If Override Default Policy for Alias is selected, you can override the default retry policy and select another existing retry policy based on your requirement.</td>
</tr>
<tr>
<td>Save As Attachment</td>
<td>Option to specify whether to save the response as a record in the Attachment [sys_attachment] table.</td>
</tr>
<tr>
<td>Attachment File Name</td>
<td>Name of the attachment created by the REST response. For example, rest-response.txt.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available when Save As Attachment is selected.</td>
</tr>
<tr>
<td>Attachment File Record</td>
<td>Target record to which the attachment is associated. The target record must be a data pill of type Record. For example, a specific incident record. You can look up this record in a prior step or define it as an input variable. The flow execution details display the sys_id of the associated record.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available when Save As Attachment is selected.</td>
</tr>
</tbody>
</table>

**REST response size limits**

By default, the system limits the size of REST responses that are not saved as attachments to 5 MB. Direct REST responses that exceed this limit generate an error. To support larger response sizes, either save the response as an attachment or increase the response size limit with the glide.pf.rest.response_payload_max_size system property. This system property supports a maximum value of 10 MB.

**OpenAPI support in the REST step**

Populate REST step fields and action inputs with information imported from an OpenAPI Specification. Import specifications by providing a URL to the YAML or JSON, or copying and pasting content.
Benefits
OpenAPI support in the REST step offers these benefits.

- Use information imported from an OpenAPI Specification to configure REST step operations, HTTP methods, parameters, request body, path, and headers.
- Review available API operations without leaving the Flow Designer interface.
- Generate inputs required for the REST step to send valid requests to an OpenAPI service and add them to the REST step in the correct location.

Note: Always review REST step values imported from an OpenAPI Specification before sending a request. Remove parameters, headers, and inputs that the API does not require.

Generated inputs
When you import an OpenAPI Specification, the system creates any required inputs and adds them to the REST step form where appropriate. At runtime, the system sends a REST request that contains input values provided to the action. For example, if an API requires a name parameter passed in the request, the system creates a name input and adds it to the REST step. When you add the action to the flow, name becomes an input to the action.

The system maps OpenAPI data types to Flow Designer data types. For example, if the OpenAPI Specification requires a user object, then the system creates a complex data object as input. For more information, see Complex data.

Specification size limit
By default, the system can import OpenAPI Specifications up to 10 MB. To increase the import size, update the glide.rest.openapi.max_request_size system property. The maximum value is 100 MB.

Specification management
Import an OpenAPI Specification by selecting options in the REST step. For more information, see REST step. Importing an OpenAPI Specification creates a record in the OpenAPIs [sys_openapi] table. You can view or delete specification records directly from this table. To update a specification, delete it and import it again.

Design considerations
Create a REST step from an OpenAPI Specification with these considerations in mind.

- Remove unnecessary REST step parameters
When importing an OpenAPI Specification, the system adds all parameters and headers present in the specification to the REST step. Review the final REST step values and remove parameters you do not want to send in the request. For example, if the API accepts content type headers for both JSON and XML, the system adds both headers to the REST step. Remove one of the headers depending on the content type you want to receive in the response.

**Make input labels user-friendly**

Ensure that input labels required for the REST step are clear and understandable. Clear labels enable flow designers to easily understand the required inputs when using the action in a flow.

**Remove inputs that do not require flow designer configuration**

When importing an OpenAPI Specification, the system adds all inputs present in the specification to the action input section. Remove any inputs that do not require a flow designer to configure. For example, if a REST step variable receives a value from another step in the action, an action input is not required.

**Avoid changing the API operation**

Changing the value of the API Operation field removes all values dependent on that operation. If you configure the OpenAPI Specification values in the REST step form, then change the operation, the system does not save your configuration. Values that are entered manually by a user are not affected.

**Limitations**

Create a REST step from an OpenAPI Specification with these limitations.

**Request body media types**

The request body only supports JSON and XML-based media types. If the selected operation from the imported OpenAPI Specification contains a request body with a different media type, the system adds a data pill of type String to the Request body field.

**OpenAPI 3.0 components**

OpenAPI 3.0 adds new components to Swagger 2.0 to describe an API in further detail. OpenAPI support in the REST step supports some, but not all of these components. The REST step does not currently support these components.

- Schema Object: oneOf, anyOf properties
- Discriminator Object
• Info object: termsOfService, contact, license fields
• Example Object
• Link Object
• Callback Object
• Security Scheme Object
• Security Requirements Object
• Tag Object
• External Documentation Object
• Server Object
• Specification extensions
• Recursive references

More information on these components is available in the OpenAPI documentation. See OpenAPI Specification.

**SOAP step**

Enable action designers to send outbound SOAP web service requests to external systems.

⚠ **Note:** SOAP step is not available in the base system and requires the ServiceNow® IntegrationHub subscription. After the required plugin is activated, the step is visible under Integrations.

**Roles and availability**

• Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

• Action designers need the web_service_admin role to perform these web services tasks.
  ◦ Select WSDL
  ◦ Load new WSDL
  ◦ Select a WS-Security policy

• The ServiceNow® MID Server doesn’t support WS-Security policies
## Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection Details</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Connection</strong></td>
<td>The type of connection to use.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Define Connection Inline</strong>: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Connection Alias</strong>: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action.</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see <a href="#">credentials, connections, and aliases</a>.</td>
</tr>
<tr>
<td><strong>Connection Alias</strong></td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action. To learn more about connections and credentials, see <a href="#">credentials, connections, and aliases</a>. The credential value is displayed as a</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Credential Alias</td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. Note: This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Connection Timeout</td>
<td>Number of milliseconds the system waits for a successful host connection. If the step does not make a successful connection during this time, the connection request times out. If Define Connection Inline is selected, enter a timeout value for the connection. Leave this field empty to use the system default connection timeout value.</td>
</tr>
<tr>
<td>Use MID</td>
<td>Option to use a MID Server to run the SOAP step. Select this check box</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Field</td>
<td>to display the MID Application and Capabilities fields.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>The URL endpoint for the SOAP request. If Use Connection Alias is selected, this field is read-only and displays the endpoint URL associated with alias. If Define Connection Inline is selected, enter an endpoint URL for the connection.</td>
</tr>
<tr>
<td>Request Details</td>
<td></td>
</tr>
<tr>
<td>Build Envelope</td>
<td>The method to use when building the SOAP envelope.</td>
</tr>
<tr>
<td></td>
<td>• From WSDL: Select this option to display the Select a WSDL and Operation fields.</td>
</tr>
<tr>
<td></td>
<td>• Manually: Select this option to manually enter or paste WSDL text.</td>
</tr>
<tr>
<td>Select a WSDL</td>
<td>The WSDL to use to build the SOAP envelope. Select an existing WSDL record or click Load New WSDL to download or manually enter a WSDL file. The selected WSDL populates the values of the Operation, SOAP action, and SOAP Envelope fields.</td>
</tr>
<tr>
<td></td>
<td>Note: This field is available when you select From WSDL from the Build Envelope list.</td>
</tr>
<tr>
<td>Load New WSDL</td>
<td>Option to download or manually enter a WSDL file.</td>
</tr>
<tr>
<td>Operation</td>
<td>The operation to run from the selected WSDL. Each WSDL has its own list of available operations.</td>
</tr>
<tr>
<td>SOAP Action</td>
<td>The URL to run the SOAP action. If Build Envelope is set to From WSDL, this field is read-only and displays the URL to run SOAP action. If Build Envelope is set to</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Manually</td>
<td>Manually, enter a URL to run the SOAP action.</td>
</tr>
<tr>
<td>Request Type</td>
<td>Format of the request. Options include.</td>
</tr>
<tr>
<td>Text</td>
<td>A request in JSON, XML, or other text format.</td>
</tr>
<tr>
<td>Binary</td>
<td>A request in a binary file format.</td>
</tr>
</tbody>
</table>
| SOAP Envelope          | The XML text sent to the endpoint. If Build Envelope is set to From WSDL, the system adds the necessary XML for the Operation that you select. If Build Envelope is set to Manually, enter the XML text that you want to use. Enter record values in the appropriate SOAP envelope elements. For example, enter an incident short description in the `<short_description>` element.  
> Note: This field is available when the Request Type is Text. |
| Attachment             | Attachment record containing the request. You can look up or create this record in a prior step and define it as an input variable. Create it using the JSONStreamingBuilder and XMLStreamingBuilder APIs in the Script step.  
> Note: This field is available when the Request Type is Binary. |
| Reset Envelope         | Option to discard all manual changes that you made to the SOAP envelope. Select this check box to revert the SOAP envelope to its original state.  
> Note: This field is available when you select From WSDL from the Build Envelope list. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New WSDL</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>The name of the WSDL record you want to create.</td>
</tr>
<tr>
<td>Import Method</td>
<td>The method to enter WSDL.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Download from URL</strong>: Select to display the <strong>WSDL URL</strong>, <strong>User name</strong>, and <strong>Password</strong> fields to retrieve the WSDL from an external source, typically the web service provider.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Manually Populate WSDL Content</strong>: Select to display the <strong>WSDL Content</strong> field to manually enter or paste WSDL text.</td>
</tr>
<tr>
<td>WSDL URL</td>
<td>The URL to the SOAP web service.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is available when you select <strong>Download from URL</strong> from the Import Method list.</td>
</tr>
<tr>
<td>User name</td>
<td>The user name to authenticate with the SOAP web service.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is available when you select <strong>Download from URL</strong> from the Import Method list.</td>
</tr>
<tr>
<td>Password</td>
<td>The password to authenticate with the SOAP web service.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is available when you select <strong>Download from URL</strong> from the Import Method list.</td>
</tr>
<tr>
<td>WSDL Content</td>
<td>The XML document describing the SOAP web service and its operations.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field is available when you select <strong>Manually Populate WSDL Content</strong> from the Import Method list.</td>
</tr>
<tr>
<td>Import</td>
<td>Option to add the SOAP web service WSDL to the instance.</td>
</tr>
<tr>
<td>WS-Security</td>
<td></td>
</tr>
<tr>
<td>Enable WS-Security Policy</td>
<td>Option to restrict the SOAP web service to a security policy. Select this check box to display the <strong>Policy</strong> field.</td>
</tr>
<tr>
<td>Policy</td>
<td>The policy record that you want to use to restrict web service connections. Select an existing policy record.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td></td>
</tr>
<tr>
<td>Enable Retry Policy</td>
<td>Option to enable the retry policy. For more information, see <strong>Retry policy</strong>.</td>
</tr>
<tr>
<td>Override Default Policy for Alias</td>
<td>Option to override the default retry policy. This check box is not applicable when <strong>Define Connection Inline</strong> is selected from the Connection list.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Default retry policy associated with <strong>Connection Alias</strong>. If <strong>Override Default Policy for Alias</strong> is selected, you can override the default retry policy and select another existing retry policy based on your requirement.</td>
</tr>
<tr>
<td>Advanced Options</td>
<td></td>
</tr>
<tr>
<td>Headers</td>
<td>The name-value pairs to include in the SOAP message as HTTP headers. Click the plus icon ☰ to add headers. Add a <strong>Name</strong> and <strong>Value</strong> for each HTTP header.</td>
</tr>
<tr>
<td>Omit if empty</td>
<td>Option to exclude a name-value pair if the value is empty or null.</td>
</tr>
</tbody>
</table>
**SOAP response size limit**

The system limits the size of SOAP responses to 5 MB. Direct SOAP responses that exceed this limit generate an error. To support larger response sizes, increase the response size limit with the `glide.pf.soap.response_payload_max_size` system property. This system property supports a maximum value of 10 MB.

**SSH step**

The SSH step executes SSH commands on an external *nix system through a ServiceNow® MID Server. The step also stores scripts and commands for the *nix systems.

*Note:*

- The SSH step is not available in the base system. The step requires the subscription to ServiceNow® IntegrationHub and activation of IntegrationHub Professional Pack Installer (com.glide.hub.integrations.professional) or later. For more information about the IntegrationHub subscription packages, see IntegrationHub usage and subscription. After you activate the required plugin, the step is visible under Integrations.
- IntegrationHub supports ServiceNow SSH only.

**Roles and availability**

The SSH step is available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

**Sanitizing inputs**

Escape all user inputs to eliminate the possibility of a malicious user executing arbitrary commands on your target server. Escape and validate data pills before the command field uses them by sanitizing arguments using Sanitize shell arguments transform functions. This transform function category automatically appears when a data pill is dropped into the Command input.
## Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Details</td>
<td>Type of connection to use.</td>
</tr>
<tr>
<td>Connection</td>
<td>• <strong>Define Connection Inline</strong>: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Connection Alias</strong>: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action.</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see credentials, connections, and aliases.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection &amp; Credential alias record that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Credential Alias</td>
<td>Credential alias that the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don’t need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data panel. This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Host</td>
<td>Host name or IP address of the target server. This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Port</td>
<td>Port number to communicate with the server. This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>MID Selection</td>
<td>Option to select MID Server as required. This field is available when Define Connection Inline is selected from the Source Connection list.</td>
</tr>
<tr>
<td>MID Application</td>
<td>Option to use a MID Server to run the SSH step. This field is available when Define Connection Inline is selected from the Connection list and Auto-</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><strong>Select MID Server</strong> is selected from the MID Selection list.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capability of the MID Server. Select <strong>SSH</strong>. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list and <strong>Auto-Select MID Server</strong> is selected from the MID Selection list.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Data pill of the required MID Server. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list and <strong>Specific MID Server</strong> is selected from the MID Selection list.</td>
</tr>
<tr>
<td></td>
<td><strong>SSH Configuration</strong></td>
</tr>
<tr>
<td>Working Directory</td>
<td>Optional target directory on the target host where the command is run.</td>
</tr>
<tr>
<td>Command</td>
<td>Command that runs on the target directory. The command can also include MID Serverscripts. See <strong>Advanced SSH script options</strong> for more information.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Escape and validate data pills before the command field uses them by sanitizing arguments using a preprocessing <strong>Script step</strong>. For more information, see <strong>Sanitizing arguments using the escape class and function</strong>.</td>
</tr>
<tr>
<td>Long Running</td>
<td>Option to disable the SSH connection timeout for commands that might take longer than the default time of 120 seconds to run. When selected, the engine detaches from the execution thread until completion.</td>
</tr>
<tr>
<td>Sudo Mode</td>
<td>Option to elevate privileges to execute the script.</td>
</tr>
</tbody>
</table>
For more information, see SSH credentials.

**Advanced SSH script options**

To run a MID Server script on the target host, specify the script type and pass the name of the script into the `${syncFile()}` parameter. The system uses this parameter to locate the named script in the MID Server Script File [ecc_agent_script_file] table and run it on the target host. For example, a bash script can be expressed as:

```bash
bash ${syncFile("<MID script name>")} argument1 argument2 argument3
```

A base script (`main_script.bash`) can reference another script (`my_include.bash`) as well as a separate file (`.my_profile`) located on the target host. Both scripts and the file referenced must be synced to the MID Server, using the `${syncFile()}` parameter, to execute properly.

```bash
source ${syncFile(".my_profile")}
cp ${syncFile("my_include.bash")} /usr/ssmith/my_include.bash
bash ${syncFile("main_script.bash")} one two three four five six
rm /usr/ssmith/my_include.bash
```

A Python example with inline comments might look like this:

```python
set $LIB_DIR=/usr/bin;
# Sync a file that is referenced inside myF5CreateLBPool.py
cp ${syncFile("specialFunctions.py")} ~/specialFunctions.py
# set up environment variables
source ${syncFile(".python_profile")}
# call script that sets up dependencies on the box from remote package repos
python ${syncFile("setupPythonDependencies.py")} pycontrol
# call a script that requires functions from the package as well as a function from
# myIncludedFile
python ${syncFile("myF5CreateLBPool.py")} snow_pool myActualValue
# user is responsible for their own cleanup
rm ~/specialFunctions.py
```

To see the list of available MID Server scripts, navigate to **MID Server > Script Files**.

**XML parser step**

Identify structured data from an XML payload without having to write script. Map incoming XML elements to a complex object output that you can use in other steps or actions. At runtime, values from an XML payload populate the complex object output.

To learn more about complex objects, see **Complex data**.
Note: The XML parser step is not available in the base system and requires the IntegrationHub Standard Pack Installer. After the required plugin is activated, the step is visible under Integrations.

Roles and availability

• Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Payload size limit

At runtime, XML parser step supports payloads up to 10 MB. For larger payloads, create a Data Stream action. For more information, see Data Stream actions and pagination.

At design time, XML parser step supports sample payloads up to 64,000 characters.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Source  | In the **Source data** field, select or drag a data pill that contains the source XML data. For example, a REST step **Response Body** data pill. At runtime, values from the data source populate the complex object output. Under Source data and in the scripting window, enter an example payload to generate a complex object. For example, if parsing the response from a REST API step that returns a list of users, enter the expected XML for a single user. This field accepts XML with the following limitations:

• XML namespaces are not applied to the complex object. More than one namespace in an XML file is not supported and generates an error message.

• Multidimensional arrays are not supported.

• Some special characters are not supported, such as hyphen and period. Double colons (::) are not supported in attribute values.

• Payloads larger than 2 MB cannot be saved and generate an error message. However, if working with a large example, you can generate the complex object and delete the example payload before saving the step. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structured Payload View</td>
<td>Select a view for the example payload.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Raw (edit mode):</strong> Displays editable XML.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Structured:</strong> Displays XML in a tree view. Click an element in the tree to copy the element XPath. If creating complex data in the <strong>Target</strong> field manually, you can paste the XPath into the target XPath field.</td>
</tr>
<tr>
<td>Generate Target</td>
<td>Select <strong>Generate Target</strong> to create the step’s output structure from your example payload. Your output data structure appears in the <strong>Target</strong> field. Child elements for each object are automatically generated as type String. Alternatively, you can manually create your target complex object by adding elements in the <strong>Target</strong> field.</td>
</tr>
<tr>
<td>Target</td>
<td>View or edit the XML payload’s output structure. Create a structured output by clicking <strong>Generate Target</strong>, or manually add elements.</td>
</tr>
<tr>
<td></td>
<td>Each element contains the following information in the <strong>Edit Object</strong> view:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Label:</strong> Data pill label. By default, the system uses the XML element’s name.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Name:</strong> Internal name for the output element.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Note:</strong> Exclamation marks, double colons, the @ symbol, or numbers only aren’t valid values for an element’s name.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Data type, which must be String, Object, Array.String, or Array.Object. The top-level element must be an Object.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Mandatory:</strong> Toggle to make the element required. This only applies to elements of type String.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Add child item:</strong> Select the add child item icon (+) to add a nested child element.</td>
</tr>
<tr>
<td></td>
<td>Elements of type Object contain the <strong>Save as Template</strong> advanced option, which allows you to save your object’s structure as a complex object template. You can then use this template to define the schema of an Object output for your action.</td>
</tr>
</tbody>
</table>
Field | Description
---|---
| For elements of type String, you can also add a max length, hint, and default value as advanced options. In the Target header, select **Exit Edit Mode** when you’re done making changes to your output’s structure. You can then select the toggle advanced inputs icon (idores) to view the following options for each element:
  - **XPath**: Path to the element. Modify the XPath to change how source data elements map to complex data variables. If manually adding complex data variables, you can copy the XPath from the **Payload view** field and paste it in a complex data variable XPath field to ensure the correct hierarchy. Conditional XPath expressions are not supported.

### IntegrationHub Remote Process Sync

IntegrationHub Remote Process Sync enables you to set up one-way or bidirectional integrations among multiple ServiceNow® instances so that your process flows stay in sync.

**Note:** IntegrationHub Remote Process Sync requires a subscription to the IntegrationHub Enterprise package. For more information, see Request IntegrationHub.

An IntegrationHub Remote Process Sync integration lets you span automated workflows for your business process across multiple ServiceNow instances. As a service provider, keep multiple customer instances in sync automatically, using Flow Designer subflows to automate your process’s workflows for all of your customers.
Benefits
IntegrationHub Process Sync provides you with these benefits:

• Automate cross-enterprise automated processes that span multiple instances, keeping various process stakeholders up-to-date

• Manage how to synchronize and correlate your record, attachment, and journal field data across multiple instances

• Ensure order delivery for data updates in remote instances, using a standalone correlation engine and queueing system

• Manage and troubleshoot errors and outages in your automated multi-instance processes with Flow Designer’s built-in execution engine

Roles
By default, Remote Process Sync provides the following roles that you can assign to users:
# Role Users with this role can

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>ih_process_sync</code></td>
<td>Create, update, or delete process sync definitions and related records.</td>
</tr>
<tr>
<td><code>ih_process_sync_api</code></td>
<td>Access Remote Process Sync APIs only.</td>
</tr>
<tr>
<td><code>ih_process_sync_run_as</code></td>
<td>Run outbound and inbound flows associated with a process sync definition. This user must have access to the tables for which any records are created or updated in the flow.</td>
</tr>
</tbody>
</table>

## Domain separation

You can use Remote Process Sync to synchronize process flows among multiple domain-separated instances. In a domain-separated environment, the following conditions apply:

1. **When building your integration**
   - Configuration tables have a `sys_domain`, and data is domain separated.
   - Configuration tables are meant to be in the same domain as the parent configuration record.
   - Subflows may be chosen from the current or any parent domain.
   - No tables have `sys_overrides`, and thus cannot override business rules or UI actions from parent domains.

2. **When your integration runs**
   - Only records from the configuration domain and associated child domains are captured.
   - Queue tables have a `sys_domain`. The outbound record is stored in the same domain as the captured source record. The inbound record is stored in the same domain as the Inbound API user in the Remote System record.
   - The outbound subflow runs in the same domain as the queued record.
   - The inbound subflow runs in the same domain as the user specified in the Remote System record's Run Inbound Flows as field.

## Getting started

Before deciding to move forward with Remote Process Sync as your integration framework, consider how this framework compares to other multi-instance Now Platform® integrations. While solutions such as Instance Data Replication and the Remote Instance spoke support simple multi-instance integrations, Remote
Process Sync supports more complex multi-instance integration use cases, focusing on integrating instances by high-level business processes.

Comparison of Instance Data Replication, Remote Instance spoke, and Remote Process Sync

<table>
<thead>
<tr>
<th>Instance Data Replication</th>
<th>Remote Instance spoke</th>
<th>Remote Process Sync</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Is optimized for replicating an entire table from one instance to another instance</td>
<td>• Supports ad-hoc integrations in Flow Designer</td>
<td>• Is process-oriented</td>
</tr>
<tr>
<td>• Supports syncing of data in bulk to build foundation for your integration</td>
<td>• Export, import, and manage data in a single environment</td>
<td>• Supports data transformations and mapping via Flow Designer</td>
</tr>
<tr>
<td>• Business rules can trigger post-replication workflows, such as send notifications or updating records</td>
<td>• Queries data from remote instances on-demand</td>
<td>• Focuses on executing cross-instance workflows</td>
</tr>
<tr>
<td>• Data that is in transit during a crash is recoverable</td>
<td>• Interacts with standard Platform APIs, such as:</td>
<td>• Has a standalone correlation framework that supports multi-record and multi-instance correlation</td>
</tr>
<tr>
<td>• Supports data transformations and mapping</td>
<td>• Import Set</td>
<td>• Supports domain separation</td>
</tr>
</tbody>
</table>

When you're ready to start building and managing a Remote Process Sync integration, learn the basics of Getting started with Remote Process Sync.

Getting started with Remote Process Sync

Learn the basics of setting up a Remote Process Sync integration in order to link the automated processes among two or more ServiceNow® instances together.

Note: IntegrationHub Remote Process Sync requires a subscription to the IntegrationHub Enterprise package. For more information, see Request IntegrationHub.

Before getting started with your Remote Process Sync integration

Before deciding to move forward with Remote Process Sync as your integration framework, consider how this framework compares to other multi-instance Now Platform® integrations. While solutions such as Instance Data Replication and the Remote Instance spoke support simple multi-instance integrations, Remote Process Sync supports more complex multi-instance integration use cases, focusing on integrating instances by high-level business processes.
Comparison of Instance Data Replication, Remote Instance spoke, and Remote Process Sync

<table>
<thead>
<tr>
<th>Instance Data Replication</th>
<th>Remote Instance spoke</th>
<th>Remote Process Sync</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is optimized for replicating an entire table from one instance to another instance</td>
<td>Supports ad-hoc integrations in Flow Designer</td>
<td>Is process-oriented</td>
</tr>
<tr>
<td>Supports syncing of data in bulk to build foundation for your integration</td>
<td>Export, import, and manage data in a single environment</td>
<td>Supports data transformations and mapping via Flow Designer</td>
</tr>
<tr>
<td>Business rules can trigger post-replication workflows, such as send notifications or updating records</td>
<td>Queries data from remote instances on-demand</td>
<td>Focuses on executing cross-instance workflows</td>
</tr>
<tr>
<td>Data that is in transit during a crash is recoverable</td>
<td>Interacts with standard Platform APIs, such as: Import Set, Table, Attachment</td>
<td>Has a standalone correlation framework that supports multi-record and multi-instance correlation</td>
</tr>
<tr>
<td>Supports data transformations and mapping</td>
<td>Requires full privileges when local and remote instances connect</td>
<td>Supports domain separation</td>
</tr>
</tbody>
</table>

If you choose to use Remote Process Sync as your multi-instance integration framework, the next step is to learn about the difference between:

1. Building your integration, and
2. Managing your integration

*Building your integration* involves creating and configuring a process sync definition and its related records. For more information on how to get started with building your Remote Process Sync integration, either step through an example of how to *Build your first Remote Process Sync integration*, or learn about *Process sync definitions*. 
Managing your integration involves monitoring the outbound and inbound queues and checking for errors related to any triggered process sync definitions. For more information on how to monitor and check for errors with your Remote Process Sync integration, see Outbound queues and inbound queues and Monitoring and troubleshooting your integration. You may also want to periodically evaluate the outbound and inbound flows that run automatically for your integration and determine whether to make any changes to these flows in Flow Designer.
Note: Both building and managing a Remote Process Sync integration on your instance also requires that you collaborate effectively with users of the remote instance, or remote instances. Be sure to meet with the stakeholders involved in your integration regularly to plan, manage, and continually improve the automated business processes that your multi-instance integration handles.

Managing your Remote Process Sync integration

**Process sync definitions**

A *process sync definition* contains all of the configurations for your Remote Process Sync integration. Start by creating a new Process Sync Definition record for your integration. Navigate to **IntegrationHub > Remote Process Sync > Process Sync Definitions**, and then click **New**. In the Process Sync Definition form, fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name that accurately describes which part of your business process your instance handles. For example, if users on your instance...</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>Optionally, describe which part of your business process that this process sync definition handles.</td>
</tr>
<tr>
<td>Application</td>
<td>Automatically set to your current application scope.</td>
</tr>
<tr>
<td>Domain</td>
<td>If your process relates to a specific domain, choose a domain other than global. For more information, see .</td>
</tr>
</tbody>
</table>

Click **Submit**, and then you can see your newly created Process Sync Definition record in the list. Next, select the Process Sync Definition record that you just created. You can see that your Process Sync Definition record has the following related lists:

- Capture Definitions
- Process Events
- Remote Systems
- Outbound Flows
- Inbound Flows

Refer to the following sections to learn how to set the configurations for each of these related items.

**Capture definitions**

A **capture definition** specifies when your instance should send data to a remote instance and what data your instance should send. A capture definition contains the configurations for your process sync definition's **trigger** and **captured fields**. The trigger specifies what record operation, such as creating, updating, or deleting a record, causes your instance to send data to a remote instance. When a Capture Definition is triggered, it creates an object from a source record, which contains captured fields. Then, the outbound flow starts running and correlates the captured fields from the source record to fields in a related record on the remote system.

A Capture Definition record has the following fields:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Event</td>
<td>In the Capture Definition form, use the lookup using list icon (🔍) to choose the Process Event record that you want to associate with this capture definition. If no process event exists yet, enter a name for your process event, and the system automatically creates a Process Event record and associates the record with your capture definition. For more information, see Process Events.</td>
</tr>
<tr>
<td>State</td>
<td>Choose Active to activate this capture definition so that the parent process sync definition triggers when the conditions you set in this form's Trigger section are met.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter a value for the order in which you want your capture definition to trigger relative to other capture definitions. Lower order values are honored before higher order values.</td>
</tr>
<tr>
<td>Application</td>
<td>Automatically set to your current application scope.</td>
</tr>
<tr>
<td>Domain</td>
<td>If your process relates to a specific domain, choose a domain other than global. For more information, see .</td>
</tr>
</tbody>
</table>

In the Trigger section, choose an authorized source table whose records you want to trigger your process sync definition. You can also add field conditions that, when met, cause your process sync definition to trigger. When the conditions are met for the trigger specified in your capture definition, any outbound flows associated with your process sync definition start running. For more information, see Outbound flows and inbound flows.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Table Name</td>
<td>Choose an authorized table whose records will trigger your process sync</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Filter</td>
<td>Use the condition builder to add conditions that, when met, will trigger your process sync definition. For example, selecting <code>[State] &gt; [is] &gt; [Work In Progress]</code> causes your process sync definition to trigger every time a record in your selected table’s State is updated to Work In Progress.</td>
</tr>
</tbody>
</table>

Lastly, in the Capture section, add fields to the Selected list that you want to include in the payload for your outbound flow.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include fields</td>
<td>Add fields to the Selected list which you want to sync with fields in the remote instance every time your process sync definition triggers. Use the add item icon () to add fields from the Available list to the Selected list.</td>
</tr>
</tbody>
</table>

**Note:**
- When your integration runs, the outbound payload that is sent to remote instances always contains these captured fields, regardless of whether they were updated or not.
- You can map these captured fields to fields in the remote instance by configuring mappings in the remote instance's inbound flow that is associated with the same process event. For more information, see Outbound flows and inbound flows.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Attachments</td>
<td>If selected, any attachments that are associated with triggering records on your local instance will sync with attachments in correlated records on the remote instance. For more information, see Note: Only interactive session changes are captured by Capture Definitions. Non-interactive session changes, such as flows or business rules updating records, do not trigger a Process Sync Definition.</td>
</tr>
</tbody>
</table>

**Process events**

A process event specifies which part of your business process begins in your local instance and ends in the remote instance. The Process Event record in your local instance and in the remote instance should have the same name because the process event signifies the link between these instances that allows them to share parts of the same business process. A Process Event record has the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name that describes the part of your business process that begins in your local instance and ends in the remote instance. For example, if users in your instance request software that will be provisioned in the remote instance, you can name the process event <strong>User requests software</strong>. Note: An administrator for the remote instance, or remote instances, must also create a process event with the same name that you use here. Creating these process events in separate instances creates the logical link that allows you to integrate data among multiple instances.</td>
</tr>
</tbody>
</table>
Remote systems

A remote system contains the configurations for the outbound and inbound connections related to another ServiceNow instance. A Remote System record has the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name that describes the remote instance. For example, if the instance is managed by one of your customers, Customer A, enter Customer A's Instance in the name field.</td>
</tr>
<tr>
<td>Description</td>
<td>Optionally, enter more details that describe the remote instance's general purpose in your business process.</td>
</tr>
<tr>
<td>External ID</td>
<td>Enter the Sys ID for the Remote System record that shares the same process event with your instance. To get a record's Sys ID, select Copy sys_id from the context menu (≡) in the record's form view. For example, if your Remote Process Sync integration spans two instances, Instance A and Instance B, use the Sys ID from Instance A's Remote System record as the External ID in Instance B and vice-versa. Connecting the Sys IDs and External IDs in this way helps multiple instances know which instance to connect to when the automated outbound and inbound flows run.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Application</td>
<td>Automatically set to your current application scope.</td>
</tr>
<tr>
<td>Domain</td>
<td>If your process relates to a specific domain, choose a domain other than global. For more information, see.</td>
</tr>
<tr>
<td>Error Subflow</td>
<td>Select the lookup using list icon ( ) to find and choose a subflow that you want to run when the connection to the remote instance fails. The subflow that you select will run whenever your local instance can’t connect to the remote instance after your process sync definition triggers. You can view remote systems that your instance fails to connect to by navigating to IntegrationHub &gt; Remote Process Sync &gt; Remote Systems - With Errors.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Select the lookup using list icon ( ) to find and choose a Connection &amp; Credential Alias record that you want to use to authenticate with the remote instance. If you haven’t set up a Connection &amp; Credential Alias record for this purpose yet, create a new record with Connection and Credential in the Type field. For more information, see Create a Connection and Credential alias.</td>
</tr>
<tr>
<td>Outbound State</td>
<td>Set to Disabled by default. You can change this field’s value to Active by selecting the Validate and Activate Remote System related link in this Remote System record’s form view after you finish creating the record.</td>
</tr>
<tr>
<td>Inbound API User</td>
<td>User who can connect to the remote instance. This user must have credentials that match those of the</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Run Inbound Flows as</td>
<td>Select the lookup using list icon to find and choose a user that you want to run the inbound flow for the associated process event. Use this option to specify if the flow runs as system user or the user who initiates the session. Select the user who initiates the session option when updates should come from the user who triggered the flow. For example, when you want incident record comments to come from the current user, or approval emails to originate from the approver. Settings for the Run as option in a flow don’t apply to child subflows.</td>
</tr>
<tr>
<td>Inbound State</td>
<td>Set to Disabled by default. You can change this field’s value to Active by selecting the Validate and Activate Remote System related link in this Remote System record’s form view after you finish creating the record.</td>
</tr>
</tbody>
</table>

**Note:** After creating a Remote System record with the appropriate fields filled in, you must then click the Validate and Activate Remote System related link. Clicking this link checks that you can successfully connect to the remote instance and then activates the outbound and inbound connections.

After creating a Process Event record and a Remote System record, you can then associate Flow Designer subflows with these records so that automated actions run whenever your process sync definition triggers.

**Outbound flows and inbound flows**
An outbound flow specifies which Flow Designer subflow your instance uses to:
1. Process local data, as fields captured in the capture definition, that will be sent to the remote instance
2. Correlate this data with data on the remote instance
3. Send this data to the remote instance

An Outbound Flow record has the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Event</td>
<td>Select the lookup using list icon (🔍) to find and choose the Process Event record that you want to associate with this outbound flow. The process event that you select should logically relate to the automated actions that the outbound flow will run when your process sync definition triggers. For example, if your outbound flow maps fields from a Service Catalog Item Request record submitted by users in your local instance to related fields in the remote instance, then choose a process event related to users making Service Catalog item requests.</td>
</tr>
<tr>
<td>Outbound Subflow</td>
<td>Select the lookup using list icon (🔍) to find and choose the Flow Designer subflow that you want to run whenever your process sync definition triggers. Your instance provides you with a Remote Process Sync Outbound Flow Template - Basic subflow that you can use as a template in any Outbound Flow record. However, you can customize the Remote Process Sync Outbound Flow Template - Basic subflow so that it meets the needs of your business process. You can customize this subflow using the Remote Process Auto-Start feature.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><strong>Remote System</strong></td>
</tr>
<tr>
<td></td>
<td>Select the lookup using list icon (🔍) to find and choose the Remote System record that you want to connect to when your outbound flow runs automated actions that require authenticating with the remote instance. The Remote System record you choose should be the remote instance that handles the inbound part of your Remote Process Sync integration.</td>
</tr>
<tr>
<td></td>
<td><strong>Application</strong></td>
</tr>
<tr>
<td></td>
<td>Automatically set to your current application scope.</td>
</tr>
<tr>
<td></td>
<td><strong>Domain</strong></td>
</tr>
<tr>
<td></td>
<td>If your process relates to a specific domain, choose a domain other than global. For more information, see .</td>
</tr>
</tbody>
</table>

An inbound flow specifies which Flow Designer subflow your instance uses to:

1. Correlate data on the local instance with the data sent from the remote instance
2. Map fields sent from the remote instance to fields on the local instance
3. Process data sent from the remote instance to the local instance

An Inbound Flow record has the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Event</td>
<td>Select the lookup using list icon (🔍) to find and choose the Process Event record that you want to associate with this inbound flow. The process event that you select should logically relate to the automated actions that the inbound flow will run when your local instance is ready to handle the</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>payload sent by the remote instance. For example, if your inbound flow maps fields from a Service Catalog Item Request record that users in the remote instance submitted to related fields in your local instance, then choose a process event related to users making Service Catalog item requests.</td>
</tr>
<tr>
<td>Inbound Subflow</td>
<td>Select the lookup using list icon ( ) to find and choose the Flow Designer subflow that you want to run whenever your instance handles data sent by a remote instance. Your instance provides you with a Remote Process Sync Inbound Flow Template - Basic subflow that you can use as a template in any Inbound Flow record. However, you can customize the Remote Process Sync Inbound Flow Template - Basic subflow so that it meets the needs of your business process. You can customize this subflow using the Remote Process Sync inbound actions. For more information, see .</td>
</tr>
<tr>
<td>Remote System</td>
<td>Select the lookup using list icon ( ) to find and choose the Remote System record that you want to connect to when your inbound flow runs automated actions that require authenticating with the remote instance. The Remote System record you choose should be the remote instance that handles the outbound part of your Remote Process Sync integration.</td>
</tr>
<tr>
<td>Application</td>
<td>Automatically set to your current application scope.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Domain</td>
<td>If your process relates to a specific domain, choose a domain other than global. For more information, see .</td>
</tr>
</tbody>
</table>

⚠️ **Note:** Each outbound flow and inbound flow must always be associated with one process event and one remote system only.

Before simply choosing the system-provided Remote Process Sync Outbound Flow Template - Basic or Remote Process Sync Inbound Flow Template - Basic subflows for your process sync definition, you may want to customize these subflows in Flow Designer. For an example of how to customize these template subflows, see .

### Syncing attachments

You can choose to send attachments associated with your local record by using the Include Attachments option in your capture definition. However, Remote Process Sync handles attachments differently from other data in your integration due to security and attachment file size issues:

- The first time that a record in your integration syncs, all attachments are sent in the outbound payload. Subsequent syncs can send either changes to attachments or all attachments.

- Attachment metadata is always sent with the outbound payload. This metadata includes an encrypted synthetic key, hash, file name, content type, and size.

- The remote instance decides which attachments to receive by comparing each hash and file name from the inbound payload to those on the instance. Then, the following process occurs:
  1. The originating system validates the key and pushes attachments to the correlation record.
  2. The originating system notifies the remote system that the attachments are complete.
  3. The remote system moves the attachments from the correlation record to the target record.

### Syncing comments and work notes

In your integration, comments are work notes are synced among instances only when changes occur to those journal fields. Change metadata is included in payloads so that remote systems can identify which user created the comment or work note and when it was created.
Outbound queues and inbound queues

After building your Remote Process Sync integration by creating and configuring the records mentioned in the previous sections, you can then manage your integration by monitoring the outbound queue and inbound queue in your instance.

An outbound queue contains the status, error information, retry data, and flow context information for outbound subflows that ran for data that was sent out of your instance. To view the records in your outbound queue, navigate to IntegrationHub > Remote Process Sync > Outbound Queue State.

An Outbound Queue State record has the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created</td>
<td>Date that the automated action in your integration occurred</td>
</tr>
<tr>
<td>Error info</td>
<td>Status message for the outbound payload</td>
</tr>
<tr>
<td>Process Event</td>
<td>Process event</td>
</tr>
<tr>
<td>Remote System</td>
<td>Remote System</td>
</tr>
<tr>
<td>Retry metadata</td>
<td>Metadata for any retry policies configured for your outbound payload</td>
</tr>
<tr>
<td>Status</td>
<td>Processing status of the payload in the outbound queue. Options include:</td>
</tr>
<tr>
<td></td>
<td>• Ready</td>
</tr>
<tr>
<td></td>
<td>• Processed</td>
</tr>
<tr>
<td></td>
<td>• Error</td>
</tr>
<tr>
<td></td>
<td>• Skipped</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain in which the automated action for your integration ran</td>
</tr>
<tr>
<td>Outbound Subflow Context</td>
<td>Sys ID of the execution record for the outbound flow that processed the payload</td>
</tr>
</tbody>
</table>

Note: You can get more detailed troubleshooting information for outbound payloads in associated Outbound Queue records. To access these records, navigate to IntegrationHub > Remote Process Sync > Outbound Queue.
An inbound queue contains the status, processing sequence, and correlation information for inbound subflows that ran for data that was sent from a remote instance to your local instance. To view the records in your inbound queue, navigate to IntegrationHub > Remote Process Sync > Inbound Queue.

An Inbound Queue record has the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence</td>
<td>Order in the queue. A lower number is processed before a higher number.</td>
</tr>
<tr>
<td>Status</td>
<td>Processing status of the payload in the inbound queue. Options include:</td>
</tr>
<tr>
<td></td>
<td>• Ready</td>
</tr>
<tr>
<td></td>
<td>• Processed</td>
</tr>
<tr>
<td></td>
<td>• Error</td>
</tr>
<tr>
<td></td>
<td>• Skipped</td>
</tr>
<tr>
<td>Note:</td>
<td>If an Inbound Queue record has an Error status, change the status to Ready to retry processing the inbound payload.</td>
</tr>
<tr>
<td>Process Event</td>
<td>Process event associated with the integration action</td>
</tr>
<tr>
<td>Operation</td>
<td>Type of record operation that the remote instance performed, which caused the remote instance to trigger and send data. Options include:</td>
</tr>
<tr>
<td></td>
<td>• Create</td>
</tr>
<tr>
<td></td>
<td>• Update</td>
</tr>
<tr>
<td></td>
<td>• Delete</td>
</tr>
<tr>
<td>Transform Context</td>
<td>Sys ID of the execution record for the inbound flow that processed the payload</td>
</tr>
<tr>
<td>Local Correlation ID</td>
<td>Correlation ID on the local instance</td>
</tr>
<tr>
<td>Remote Correlation ID</td>
<td>Correlation ID on the remote instance</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote System</td>
<td>Remote System record associated with the instance that sent the data</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain in which the automated action for your integration ran</td>
</tr>
<tr>
<td>Payload</td>
<td>String as JSON payload for inbound data</td>
</tr>
</tbody>
</table>

**Note:** Both the Outbound Queue and Inbound Queue tables are maintained by table cleaners that remove records from these tables every 30 days.

### Monitoring and troubleshooting your integration

You can use the following tables to monitor your Remote Process Sync integration, once it is built and running:

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XML Stats</td>
<td>View the <code>process_sync_queue</code> section for information about the outbound and inbound queues for your integration, including the size of the queue as well as error and processing rates.</td>
</tr>
<tr>
<td>Outbound Queue</td>
<td>View the capture data for records that are staged to be sent out of your instance.</td>
</tr>
<tr>
<td>Outbound Queue State</td>
<td>View the state of records in the Outbound Queue table.</td>
</tr>
<tr>
<td>Inbound Queue</td>
<td>View the combined inbound queue and record table.</td>
</tr>
<tr>
<td>Logs</td>
<td>Start by turning on debugging by setting the <code>glide.ih.process.sync.debug</code> system property to <code>true</code>. Then, scan the Logs for error messages beginning with <code>OutboundQueueDao</code> and <code>InboundQueueDao</code> to find log messages with more...</td>
</tr>
</tbody>
</table>
If an error occurs with your Remote Process Sync integration, begin by confirming whether the error is a connection error or a data processing error:

**Connection errors**

Outbound connection errors automatically retry several times before setting the Remote System record's Outbound State to Error. If errors keep occurring for an outbound connection, confirm that nothing has changed with the Remote System's Inbound API User, such as a change in the user's credentials. Then, validate and activate the Remote System record again.

**Data processing errors**

Data processing errors typically occur as a result of errors in an outbound flow or inbound flow. To troubleshoot these errors, you can add error handling actions to your flow, such as a Log action or Send Email action, when the flow's State changes to Error. You can also add actions that reprocess or skip processing of records in the Outbound Queue or Inbound Queue tables if an error with the flow occurs.

**Build your first Remote Process Sync integration**

Step through an example of how to build a Remote Process Sync integration in order to link the automated processes of two ServiceNow® instances together.

**Before you begin**

- Activate Remote Process Sync on each instance in your integration by purchasing the IntegrationHub Enterprise package. For more information, see Request IntegrationHub.
- Activate the explicit roles security feature on each instance in your integration. For more information, see Explicit Role plugin.
- Learn about how to build and manage an IntegrationHub Remote Process Sync integration by checking out Getting started with Remote Process Sync.
- Confirm the instances that you'll link together in the following example are not production instances. It is recommended to test this example on sub-production instances only in order to avoid overwriting any important data on either instance. You might also want to use a Personal Developer Instance for testing this example integration.
• Confirm that you do not have any existing business rules, workflows, or Flow Designer flows whose logic will conflict with the flows we'll create in the following example.

• Role required: admin

About this task
In the following example, you'll step through how to link two ServiceNow instances' automated processes together. The use case for this example is that a customer creates requests for hardware that are fulfilled by a vendor. We'll refer to the customer's instance as Instance A, and the vendor's instance as Instance B. We'll start by setting up credentials in each instance that can access the remote instance. We'll also create a user in each instance that can run the outbound and inbound flows.

Procedure
1. In Instance A, ensure that your domain is set to global, and then navigate to System Security > Users and Groups > Users.

2. Select New to open a new User form view, and then fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>Enter rps.api.instance.a</td>
</tr>
<tr>
<td>First name</td>
<td>Enter RPS API User for Instance A</td>
</tr>
<tr>
<td>Password</td>
<td>Enter rpsdemoa</td>
</tr>
</tbody>
</table>

Finally, select Submit to finish creating the User record.

3. From the list, select the User record that you just created.

   a. Navigate to and select the Roles related list.

   b. Select Edit... to configure the user's roles.

   c. In the search window above Collection, enter ih_process_sync_api.

   d. Select ih_process_sync_api and snc_external from the Collection list, and then select the add button ( ) to add these roles to the Roles List.
Note: The snc_external role restricts the access of external users to only the resources they have been explicitly granted access to.

e. Select Save.

4. Select New to open a new User form view, and then fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>Enter rps.run.as</td>
</tr>
<tr>
<td>First name</td>
<td>Enter RPS Run as User</td>
</tr>
<tr>
<td>Password</td>
<td>Enter rpsdemoa</td>
</tr>
</tbody>
</table>

Finally, select Submit to finish creating the User record.

5. From the list, select the User record that you just created.
   a. Navigate to and select the Roles related list.
   b. Select Edit... to configure the user’s roles.
   c. In the search window above Collection, enter ih_process_sync_run_as.
   d. Select ih_process_sync_run_as from the Collection list, and then select the add button ( ) to add that role to the Roles List.
   e. select Save.

6. In Instance B, ensure that your domain is set to global, and then navigate to System Security > Users and Groups > Users.

7. Select New to open a new User form view, and then fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>Enter rps.api.instance.b</td>
</tr>
<tr>
<td>First name</td>
<td>Enter RPS API User for Instance B</td>
</tr>
<tr>
<td>Password</td>
<td>Enter rpsdemob</td>
</tr>
</tbody>
</table>

Finally, select Submit to finish creating the User record.

8. From the list, select the User record that you just created.
a. Navigate to and select the Roles related list.

b. Select Edit... to configure the user's roles.

c. In the search window above Collection, enter `ih_process_sync_api`.

d. Select `ih_process_sync_api` and `snc_external` from the Collection list, and then select the add button (>) to add these roles to the Roles List.

Note: The `snc_external` role restricts the access of external users to only the resources they have been explicitly granted access to.

e. Select Save.

9. Select New to open a new User form view, and then fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>Enter rps.run.as</td>
</tr>
<tr>
<td>First name</td>
<td>Enter RPS Run as User</td>
</tr>
<tr>
<td>Password</td>
<td>Enter rpsdemob</td>
</tr>
</tbody>
</table>

Finally, select Submit to finish creating the User record.

10. From the list, select the User record that you just created.

a. Navigate to and select the Roles related list.

b. Select Edit... to configure the user's roles.

c. In the search window above Collection, enter `ih_process_sync_run_as`.

d. Select `ih_process_sync_run_as` from the Collection list, and then select the add button (>) to add that role to the Roles List.

e. Select Save.

11. In Instance A, navigate to IntegrationHub > Connections & Credentials > Credentials, and then select New.

a. From the list of connection options, select Basic Auth Credentials.

b. In the form, fill in the following fields:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter RPS Vendor Credentials</td>
</tr>
<tr>
<td>User name</td>
<td>Enter rps.api.instance.b</td>
</tr>
<tr>
<td>Password</td>
<td>Enter rpsdemob</td>
</tr>
</tbody>
</table>

Note: The credentials you enter must match the credentials for the RPS API User that you created in Instance B.

c. Select Submit.

12. While still in Instance A, navigate to IntegrationHub > Connections & Credentials > Connection & Credential Aliases, and then select New.

a. In the Name field, enter RPS Vendor Demo.
   Leave all other fields as they are, and then select Submit.

b. From the list, select the RPS Vendor Demo record that you just created.

c. In the Connections related list, select New.

d. In the form, fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter RPS Vendor.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the lookup using list icon ( ), and then select the RPS Vendor Credentials record from the list.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Enter the base URL of Instance B. The URL should begin with https:// and end with .service-now.com/</td>
</tr>
</tbody>
</table>

e. Leave all other fields as they are, and then select Submit.

13. In Instance B, navigate to IntegrationHub > Connections & Credentials > Credentials, and then select New.
a. From the list of connection options, select **Basic Auth Credentials**.

b. In the form, fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter <strong>RPS Customer Credentials</strong></td>
</tr>
<tr>
<td>User name</td>
<td>Enter <strong>rps.api.instance.a</strong></td>
</tr>
<tr>
<td>Password</td>
<td>Enter <strong>rpsdemoa</strong></td>
</tr>
</tbody>
</table>

**Note:** The credentials you enter must match the credentials for the RPS API User that you created in Instance A.

c. Select **Submit**.

14. While still in Instance B, navigate to **IntegrationHub > Connections & Credentials > Connection & Credential Aliases**, and then select **New**.

a. In the Name field, enter **RPS Customer Demo**. Leave all other fields as they are, and then select **Submit**.

b. From the list, select the **RPS Customer Demo** record that you just created.

c. In the Connections related list, select **New**.

d. In the form, fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter <strong>RPS Customer</strong></td>
</tr>
<tr>
<td>Credential</td>
<td>Select the lookup using list icon ( ), and then select the <strong>RPS Customer Credentials</strong> record from the list.</td>
</tr>
</tbody>
</table>
e. Leave all other fields as they are, and then select Submit.

We’ve successfully created credentials that can be used to access each remote instance. Now, let’s ensure that we can send and receive data between instances by configuring the Remote System record for a Process Sync Definition in each instance.

15. In Instance A, navigate to IntegrationHub > Remote Process Sync > Process Sync Definitions, and then select New.

a. In the form, fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter Hardware Request Process</td>
</tr>
<tr>
<td>Description</td>
<td>Enter Process for requesting hardware and handling fulfilled hardware requests</td>
</tr>
</tbody>
</table>

b. Leave all other fields as they are, and then select Submit.

c. From the list, select the Hardware Request Process record that you just created.


a. In the form, fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter Vendor Instance - Instance B</td>
</tr>
<tr>
<td>Description</td>
<td>Enter Vendor instance that fulfills hardware requests</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Select the lookup using list icon ( ), and then select the RPS API</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>User for Instance A</td>
<td>Record from the list.</td>
</tr>
<tr>
<td>Inbound API User</td>
<td>Select the lookup using list icon ( ), and then select the RPS Vendor record from the list.</td>
</tr>
<tr>
<td>Run as</td>
<td>Select the lookup using list icon ( ), and then select the RPS Run as User record from the list.</td>
</tr>
</tbody>
</table>

b. In the context header, select the additional actions icon ( ) and then select **Copy sys id**.
You'll need this Sys ID as the value for the External ID field of the Remote System record in Instance B.

c. Leave all other fields as they are, and then select **Submit**.

17. In Instance B, navigate to **IntegrationHub** > **Remote Process Sync** > **Process Sync Definitions**, and then select **New**.

a. In the form, fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter Hardware Fulfillment Process</td>
</tr>
<tr>
<td>Description</td>
<td>Enter Process for fulfilling hardware requests</td>
</tr>
</tbody>
</table>

b. Leave all other fields as they are, and then select **Submit**.

c. From the list, select the **Hardware Fulfillment Process** record that you just created.

18. In the Remote Systems related list, select **New**.
a. In the form, fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter Customer Instance - Instance A</td>
</tr>
<tr>
<td>Description</td>
<td>Enter Customer instance that requests hardware</td>
</tr>
<tr>
<td>External ID</td>
<td>Paste the value of the Sys ID that you copied from the Remote System record in Instance A.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Select the lookup using list icon ( ), and then select the RPS API User for Instance B record from the list.</td>
</tr>
<tr>
<td>Inbound API User</td>
<td>Select the lookup using list icon ( ), and then select the RPS Customer record from the list.</td>
</tr>
<tr>
<td>Run as</td>
<td>Select the lookup using list icon ( ), and then select the RPS Run as User record from the list.</td>
</tr>
</tbody>
</table>

b. Leave all other fields as they are, and then select Submit.

c. From the Remote Systems related list, select the Customer Instance - Instance A record.

d. In the Related links section, select Validate and Activate Remote System. You should see a message that displays Remote system validated and activated successfully. If you see an error message instead, go back and check the configuration for the Remote System record.

e. In the context header, select the additional actions icon ( ) and then select Copy sys_id. You'll need this Sys ID as the value for the External ID field of the Remote System record in Instance A.
19. In Instance A, navigate to IntegrationHub > Remote Process Sync > Remote Systems - All, and then select the Vendor Instance - Instance B record from the list.

   a. In the External ID field, paste the value of the Sys ID that you copied from the Remote System record in Instance B.

   b. Select Update to save your changes to the record.

   c. From the list, select the Customer Instance - Instance A record.

   d. In the Related links section, select Validate and Activate Remote System. You should see a message that displays Remote system validated and activated successfully. If you see an error message instead, go back and check the configuration for the Remote System record.

We’ve successfully connected Instance A and Instance B together so that they can share data across their process workflows. Now, we’ll define how our integration will trigger and run automatically, as well as which fields we want to capture and sync between instances.

20. In Instance A, navigate to IntegrationHub > Remote Process Sync > Process Sync Definitions, and then select the Hardware Request Process record from the list.


   a. In the Name field, enter Request Hardware.

   b. Leave all other fields as they are, and then select Submit.

22. In the Process Events related list, select New.

   a. In the Name field, enter Hardware Request Fulfilled.

   b. Leave all other fields as they are, and then select Submit.

23. In the Capture Definitions related list, select New.

   a. In the form, fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Event</td>
<td>select the lookup using list icon ( ), and then select the Request Hardware record from the list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State</td>
<td>Select <strong>Active</strong></td>
</tr>
<tr>
<td>Source Table Name</td>
<td>Select <strong>Incident [incident]</strong></td>
</tr>
<tr>
<td>Filter</td>
<td>In the condition builder, select <strong>Assignment Group &gt; is</strong> and then select the lookup using list icon (⠣). Choose the <strong>Hardware</strong> record from the list.</td>
</tr>
<tr>
<td>Include fields</td>
<td>Select the following fields and then select the add item button (⠣) to add them to the Selected list:</td>
</tr>
<tr>
<td></td>
<td>• Number</td>
</tr>
<tr>
<td></td>
<td>• Short description</td>
</tr>
<tr>
<td></td>
<td>• Assignment group</td>
</tr>
<tr>
<td></td>
<td>• Severity</td>
</tr>
<tr>
<td></td>
<td>• State</td>
</tr>
<tr>
<td>Note:</td>
<td>Sys ID is already included in the Selected list. Leave this field in the Selected list as well.</td>
</tr>
</tbody>
</table>

**b.** Leave all other fields as they are, and then select **Submit**.

24. In the Outbound Flows related list, select **New**.

**a.** In the form, fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Event</td>
<td>From the list, select <strong>Request Hardware</strong>.</td>
</tr>
<tr>
<td>Outbound Subflow</td>
<td>Select the lookup using list icon (⠣), and then select the <strong>Remote Process Sync Outbound Flow Template - Basic</strong> record from the list. This template subflow handles the correlation of local and remote</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>records and sends the captured payload to the remote instance.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** When building your own integration, you can add Remote Process Sync actions to personalize this template subflow to your needs. To edit this template subflow in Flow Designer, select the Configure Subflow icon ( ).

Remote System  
Select the lookup using list icon ( ), and then select the Vendor Instance - Instance B record from the list.

b. Leave all other fields as they are, and then select Submit.

25. In Instance B, navigate to IntegrationHub > Remote Process Sync > Process Sync Definitions, and then select the Hardware Fulfillment Process record from the list.

26. In the Process Events related list, select New.
   a. In the Name field, enter Request Hardware.
   b. Leave all other fields as they are, and then select Submit.

27. In the Process Events related list, select New.
   a. In the Name field, enter Hardware Request Fulfilled.
   b. Leave all other fields as they are, and then select Submit.

**Note:** It is recommended to create Process Event records in both instances with names that match. This will help you keep track of the linked process workflows between instances.

28. In the Capture Definitions related list, select New.
a. In the form, fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Event</td>
<td>select the lookup using list icon (🔍), and then select the Hardware Request Fulfilled record from the list.</td>
</tr>
<tr>
<td>State</td>
<td>Select Active</td>
</tr>
<tr>
<td>Source Table Name</td>
<td>Select Incident [incident]</td>
</tr>
<tr>
<td>Filter</td>
<td>In the condition builder, select Assignment Group &gt; is and then select the lookup using list icon (🔍). Choose the Hardware record from the list. Then, select AND to add another condition and select Incident state &gt; is &gt; Resolved.</td>
</tr>
</tbody>
</table>
| Include fields       | Select the following fields and then select the add item button (▶) to add them to the Selected list:  
  • Number  
  • State  
  • Resolved by  
  • Resolution notes  

⚠️ Note: Sys ID is already included in the Selected list. Leave this field in the Selected list as well.

b. Leave all other fields as they are, and then select Submit.

29. In the Outbound Flows related list, select New.
a. In the form, fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Event</td>
<td>From the list, select <strong>Hardware Request Fulfilled</strong>.</td>
</tr>
<tr>
<td>Outbound Subflow</td>
<td>Select the lookup using list icon (🔍), and then select the <strong>Remote Process Sync Outbound Flow Template - Basic</strong> record from the list. This template subflow handles the correlation of local and remote records and sends the captured payload to the remote instance.</td>
</tr>
<tr>
<td>Remote System</td>
<td>Select the lookup using list icon (🔍), and then select the <strong>Vendor Instance - Instance B</strong> record from the list.</td>
</tr>
</tbody>
</table>

**Note:** When building your own integration, you can add **Remote Process Sync actions** to personalize this template subflow to your needs. To edit this template subflow in Flow Designer, select the **Configure Subflow icon (🔍).**

b. Leave all other fields as they are, and then select **Submit**.

We’ve successfully set up how our Remote Process Sync integration will trigger and which fields will be captured and sent to either remote instance. In this final section, we’ll customize the inbound flows in Flow Designer so that they properly transform inbound data.

30. In Instance B, navigate to **IntegrationHub > Remote Process Sync > Process Sync Definitions**, and then select the **Hardware Fulfillment Process** record from the list.

31. In the Inbound Flows related list, select **New**.
a. In the form, fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Event</td>
<td>From the list, select <strong>Request Hardware</strong>.</td>
</tr>
<tr>
<td>Inbound Subflow</td>
<td>Select the lookup using list icon (🔍), and then select the <strong>Remote Process Sync Inbound Flow Template - Basic</strong> record from the list. We'll customize this template subflow in the next step.</td>
</tr>
<tr>
<td>Remote System</td>
<td>Select the lookup using list icon (🔍), and then select the <strong>Customer Instance - Instance A</strong> record from the list.</td>
</tr>
</tbody>
</table>

b. Leave all other fields as they are, and then select **Submit**.

c. In the Inbound Flows related list, select the **Request Hardware** record that you just created.

d. Next to the Inbound Subflow field, select the Configure Subflow icon (🔍). The subflow opens in the Flow Designer design environment.

32. Expand the **Transform Payload from Inbound Sample** action.

a. In the Sample Payload field, enter the following sample payload:

```json
{"capture_metadata":{"changed_by":"admin","timestamp":"2020-09-24 19:26:59"},
"changed_fields":{
  "display_value":"","value":"incident","key":"sys_class_name"},
  "display_value":"","value":"552c48888c033300964f4932b03eb092","key":"sys_id"},
  "display_value":"","value":"INC0040015","key":"number"},
  "display_value":"","value":"","key":"short_description"},
  "display_value":"Hardware","value":"9f5b572d9cd82010f877a5cfd1fdce30","key":"assignment_group"},
```
Note: This payload is a complex object that represents the captured metadata and fields that are sent from Instance A to Instance B.

b. Select Done.

33. Select Add an Action, Flow Logic, or Subflow, and then select Action. In the action picker, search for and then select the Look Up Correlation By Active Correlation ID action.

a. Add the following action inputs:

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote System</td>
<td>Select the data pill picker icon ( ), Dot-walk to and then select Subflow - Inputs &gt; Remote System.</td>
</tr>
<tr>
<td>Local Correlation</td>
<td>Select the data pill picker icon ( ), Dot-walk to and then select Subflow - Inputs &gt; Local Correlation ID.</td>
</tr>
</tbody>
</table>

b. Select Done.

34. Select Add an Action, Flow Logic, or Subflow, and then select Action. In the action picker, search for and then select the Look Up Record action.

a. Add the following action inputs:

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select Incident [incident].</td>
</tr>
<tr>
<td>Conditions</td>
<td>In the condition builder, select Sys ID &gt; is, and then select the data pill picker icon ( ). Dot-walk to and then select 2 - Look Up</td>
</tr>
</tbody>
</table>
**b. Select Done.**

35. Select **Add an Action, Flow Logic, or Subflow**, and then select **Flow Logic**. From the list, select the **If** flow logic.

**a. Add the following inputs:**

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Enter local record doesn't exist.</td>
</tr>
<tr>
<td>Condition 1</td>
<td>In the condition builder, select the data pill picker icon ( ). Dot-walk to and then select 3 - Look Up Record &gt; Status. Then, select is &gt; Error.</td>
</tr>
</tbody>
</table>

**b. Select Done.**

36. Under the **If** flow logic that you just created, next to **then**, select the plus icon ( ) and then select **Action**.

In the action picker, search for and then select the **Create Record** action.

**a. In the Table input, select Incident [incident].**

**b. In the Fields input, add the following fields and associated values:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Select the data pill picker icon ( ). Dot-walk to and then select 1 - Transform Payload from Inbound Sample &gt; Changed Fields &gt; short_description.</td>
</tr>
<tr>
<td>Description</td>
<td>Select the data pill picker icon ( ). Dot-walk to and then select 1 -</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Transform Payload from Inbound Sample &gt; Changed Fields &gt; short_description.</td>
<td></td>
</tr>
<tr>
<td>Assignment group</td>
<td>Select the data pill picker icon (eventName). Dot-walk to and then select 1 - Transform Payload from Inbound Sample &gt; Changed Fields &gt; assignment_group.</td>
</tr>
<tr>
<td>Urgency</td>
<td>Select the data pill picker icon (eventName). Dot-walk to and then select 1 - Transform Payload from Inbound Sample &gt; Changed Fields &gt; severity.</td>
</tr>
<tr>
<td>State</td>
<td>Select the data pill picker icon (eventName). Dot-walk to and then select 1 - Transform Payload from Inbound Sample &gt; Changed Fields &gt; state.</td>
</tr>
</tbody>
</table>

**c. Select Done.**

37. Under the **Update Record** action that you just created, within the same **If** flow logic block, select the plus icon ((eventName)) and then select **Action**. In the action picker, search for and then select the **Create Correlation** action.

**a. Add the following action inputs:**

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Correlation ID</td>
<td>Select the data pill picker icon (eventName). Dot-walk to and then select <strong>Subflow - Inputs &gt; Remote Correlation ID</strong>.</td>
</tr>
<tr>
<td>Local Correlation ID</td>
<td>Select the data pill picker icon (eventName). Dot-walk to and then select <strong>Subflow - Inputs &gt; Local Correlation ID</strong>.</td>
</tr>
</tbody>
</table>
### Input | Description
--- | ---
Remote System | Select the data pill picker icon (estruction). Dot-walk to and then select **Subflow** - **Inputs** > **Remote System**.

Local Record | Select the data pill picker icon (estruction). Dot-walk to and then select **5** - **Create Record** > **Incident Record**.

---

b. **Select Done.**

38. Select **Add an Action, Flow Logic, or Subflow**, and then select **Flow Logic**.
From the list, select the **Else** flow logic.

39. Under the **Else** flow logic that you just created, select the plus icon (estruction) and then select **Action**.
In the action picker, search for and then select the **Update Record** action.

a. In the **Record** input, select the data pill picker icon (estruction). Dot-walk to and then select **3 - Look Up Record** > **Incident Record**.
This automatically populates the Table input with the value **Incident [incident]**.

b. In the **Fields** input, add the following fields and associated values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Select the data pill picker icon (estruction). Dot-walk to and then select <strong>1 - Transform Payload from Inbound Sample</strong> &gt; <strong>Changed Fields</strong> &gt; <strong>short_description</strong>.</td>
</tr>
<tr>
<td>Description</td>
<td>Select the data pill picker icon (estruction). Dot-walk to and then select <strong>1 - Transform Payload from Inbound Sample</strong> &gt; <strong>Changed Fields</strong> &gt; <strong>short_description</strong>.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Select the data pill picker icon (estruction). Dot-walk to and then select **1 - **</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><strong>Transform Payload from Inbound Sample &gt; Changed Fields &gt; assignment_group.</strong></td>
</tr>
<tr>
<td>Urgency</td>
<td>Select the data pill picker icon ( Респект). Dot-walk to and then select <strong>1 - Transform Payload from Inbound Sample &gt; Changed Fields &gt; severity.</strong></td>
</tr>
<tr>
<td>State</td>
<td>Select the data pill picker icon ( Респект). Dot-walk to and then select <strong>1 - Transform Payload from Inbound Sample &gt; Changed Fields &gt; state.</strong></td>
</tr>
</tbody>
</table>

**c. Select Done.**

40. In the main header, select **Save** to save the changes to the flow.

41. In Instance A, navigate to **IntegrationHub > Remote Process Sync > Process Sync Definitions**, and then select the **Hardware Request Process** record from the list.

42. In the Inbound Flows related list, select **New**.

  **a. In the form, fill in the following fields:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Event</td>
<td>From the list, select <strong>Hardware Request Fulfilled.</strong></td>
</tr>
<tr>
<td>Inbound Subflow</td>
<td>Select the lookup using list icon ()، and then select the <strong>Remote Process Sync Inbound Flow Template - Basic</strong> record from the list. We'll customize this template subflow in the next step.</td>
</tr>
<tr>
<td>Remote System</td>
<td>Select the lookup using list icon ()، and then select the <strong>Vendor Instance - Instance B</strong> record from the list.</td>
</tr>
</tbody>
</table>
b. Leave all other fields as they are, and then select **Submit**.

c. In the Inbound Flows related list, select the **Hardware Request Fulfilled** record that you just created.

d. Next to the Inbound Subflow field, select the **Configure Subflow icon ( )**.

The subflow opens in the Flow Designer design environment.

43. Expand the **Transform Payload from Inbound Sample action**.

a. In the Sample Payload field, enter the following sample payload:

```json
{"capture_metadata":{"changed_by":"admin","timestamp":"2020-10-26 14:18:45"},
"changed_fields":{
  "display_value":"","value":"incident","key":"sys_class_name"},
  "display_value":"","value":"d4cdfe8db4c2410cfe4d9595e96197b","key":"sys_id"},
  "display_value":","value":"INC0040014","key":"number"},
  "display_value":","value":"101","key":"state"},
  "display_value":"System Administrator","value":"6816f79cc0a8016401c5a33be04be441","key":"resolved_by"},
  "display_value":","value":",key":"close_notes"}}
```

> **Note:** This payload is a complex object that represents the captured metadata and fields that are sent from Instance B to Instance A.

b. Select **Done**.

44. Select **Add an Action, Flow Logic, or Subflow**, and then select **Action**.

In the action picker, search for and then select the **Look Up Correlation By Active Correlation ID** action.

a. Add the following action inputs:

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote System</td>
<td>Select the data pill picker icon ( ). Dot-walk to and then select <strong>Subflow</strong> - Inputs &gt; Remote System.</td>
</tr>
<tr>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Local Correlation</td>
<td>Select the data pill picker icon ( ). Dot-walk to and then select <strong>Subflow</strong> - <strong>Inputs</strong> &gt; <strong>Local Correlation ID</strong>.</td>
</tr>
</tbody>
</table>

**b. Select Done.**

**45. Select Add an Action, Flow Logic, or Subflow**, and then select **Action**.
In the action picker, search for and then select the **Look Up Record** action.

**a. Add the following action inputs:**

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select <strong>Incident [incident]</strong>.</td>
</tr>
<tr>
<td>Conditions</td>
<td>In the condition builder, select <strong>Sys ID &gt; is</strong>, and then select the data pill picker icon ( ). Dot-walk to and then select <strong>3 - Look Up Correlation By Active Correlation ID &gt; Correlation Detail &gt; Local Record</strong>.</td>
</tr>
</tbody>
</table>

**b. Select Done.**

**46. Select Add an Action, Flow Logic, or Subflow**, and then select **Flow Logic**.
From the list, select the **If** flow logic.

**a. Add the following inputs:**

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Enter <strong>local record exists</strong>.</td>
</tr>
<tr>
<td>Condition 1</td>
<td>In the condition builder, select the data pill picker icon ( ). Dot-walk to and then select <strong>4 - Look Up Record &gt; Status</strong>. Then, select <strong>is &gt; Success</strong>.</td>
</tr>
</tbody>
</table>

**b. Select Done.**
47. Under the **if** flow logic that you just created, select the plus icon (➕) and then select **Action**. In the action picker, search for and then select the **Update Record** action.

a. In the **Record** input, select the data pill picker icon (🔍). Dot-walk to and then select **4 - Look Up Record > Incident Record**. This automatically populates the **Table** input with the value `Incident[incident]`.

b. In the **Fields** input, add the following fields and associated values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Select the data pill picker icon (🔍). Dot-walk to and then select <strong>1 - Transform Payload from Inbound Sample &gt; Changed Fields &gt; state</strong>.</td>
</tr>
<tr>
<td>Resolved by</td>
<td>Select the data pill picker icon (🔍). Dot-walk to and then select <strong>1 - Transform Payload from Inbound Sample &gt; Changed Fields &gt; resolved_by</strong>.</td>
</tr>
<tr>
<td>Resolution notes</td>
<td>Select the data pill picker icon (🔍). Dot-walk to and then select <strong>1 - Transform Payload from Inbound Sample &gt; Changed Fields &gt; close_notes</strong>.</td>
</tr>
</tbody>
</table>

c. Select **Done**.

We've finished building our Remote Process Sync integration. The integration will now trigger whenever a user creates an Incident record with the Hardware assignment group in Incident A. When this happens:
• The fields specified in Instance A’s Capture Definition are captured and stored in a local record.
• The local record is correlated with a remote record in Instance B.
• The captured fields are mapped to the fields we specified in Instance B’s Inbound Flow.

Then, when a user resolves the correlated Incident record in Instance B:
• The fields specified in Instance B’s Capture Definition are captured and stored in a local record.
• The local record is correlated with the remote record in Instance A.
• The captured fields are mapped to the fields we specified in Instance A’s Inbound Flow.

What to do next
Test out your Remote Process Sync integration by creating an Incident record in Instance A with the Hardware assignment group. Then, resolve the correlated Incident record in Instance B. If your correlated records don’t sync as expected, check your Inbound API User’s credentials and Process Sync Definition configuration in each Instance. If you continue to experience issues with your example integration, refer to Monitoring and troubleshooting your integration.

Remote Process Sync actions
Learn how to use actions in outbound and inbound flows for your IntegrationHub Remote Process Sync integration.

Remote Process Sync provides you with a collection of Flow Designer actions that you can use to customize the default outbound and inbound flow templates. These actions let you:
• Create correlations between records on local and remote instances
• Manage attachments between local and remote instances
• Send captured payloads to a remote instance
• Transform inbound payloads to complex objects

Remote Process Sync action dependencies
Certain Remote Process Sync actions are dependent upon other actions, and thus are generally intended for you to use together. The following use cases describe situations in which you might consider using dependent Remote Process Sync actions in your outbound and inbound flows.

Correlate a record with a captured payload
Use these actions in the following order to automatically correlate a record with a captured payload to be sent to a remote system:

1. **Look Up Correlation By Local Correlation ID** - Use this action to determine if a correlated record exists between your staged local record and a record on the remote system.

2. **Send Captured Payload to Remote System** - Use the Correlation Detail output data pill from the **Look Up Correlation By Local Correlation ID** record as the value for the Correlation Detail input in this action. This enables you to correlate the local record containing the outbound payload to a record on the remote system.

**Note:** The Remote Process Sync Outbound Flow Template – Basic provides you with these two actions so that you don’t need to set up this correlation yourself.

**Identify and request missing attachments from a remote system**

Use these actions in the following order to automatically look up and request attachments from a remote system that don’t exist in your local system:

1. **Identify New Attachments** - Use this action to look up any attachments that exist on the remote system but don’t exist on your local system for correlated records.

2. **Request Attachments from Remote System** - Use this action to request the transfer of identified attachments from the remote system to your local system.

**Create Correlation action**

Create a correlation between a record on the local instance and a record on a remote instance. A correlation identifies a remote system and a local record to synchronize. Each instance maintains a copy of the correlation, which contains a set of shared correlation identifiers. Remote Process Sync actions and flows use the correlation identifiers to synchronize records.

**Roles and availability**

Available as a ServiceNow Core Remote Process Sync action.

**Subscription requirements**

This action requires an IntegrationHub Enterprise subscription. For more information, see Request IntegrationHub.

**Role requirements**
This action requires roles granted by delegated development or assigned to the user. For more information, see User access to Flow Designer.

**Inputs**

Provide a value for each input that your action needs. To add dynamic values, you can also drag and drop pills from the Data panel or select them from the pill picker.

**Remote Correlation ID**

*Data type: String*

Globally unique ID of a correlation on a remote instance you are synchronizing processes with. This ID uniquely identifies the correlation for outbound transactions.

**Local Correlation ID**

*Data type: String*

Globally unique ID of a correlation on the local instance you are synchronizing processes with. This ID uniquely identifies the correlation for inbound transactions.

**Remote System**

*Data type: Record*

Reference to the Process Sync Remote System record for the remote instance you are synchronizing processes with. This record identifies the instance that receives outbound synchronization changes or that sent inbound synchronization changes.

**Local Record**

*Data type: Record*

Reference to a record on the local instance you are synchronizing with another instance. The data pill contains all the field values for the specified record. For example, a case record on the local instance.

**Outputs**

These outputs appear in the Data panel. You can use them as inputs elsewhere in your flow.

**Correlation Detail**

*Data type: Object*
Object containing correlation information about a record. The object identifies the local and remote correlation IDs associated with a local record.

**Status**

Data type: *String*

Status code returned by the action.

**Error**

Data type: *String*

Error returned by the action.

**Get Attachment Metadata for Local Record action**

Get the list of attachments associated with a specified local record. Use the output of this action to synchronize the attachments of a local record with the attachments of a remote record.

**Roles and availability**

Available as a ServiceNow Core Remote Process Sync action.

**Subscription requirements**

This action requires an IntegrationHub Enterprise subscription. For more information, see Request IntegrationHub.

**Role requirements**

This action requires roles granted by delegated development or assigned to the user. For more information, see User access to Flow Designer.

**Inputs**

Provide a value for each input that your action needs. To add dynamic values, you can also drag pills from the Data panel or select them from the pill picker.

**Local Record**

Data type: *Record*

Reference to a record on the local instance you are synchronizing with another instance. The data pill contains all the field values for the specified record. For example, a case record on the local instance.

**Strategy**

Data type: *Choice*
Level of attachment detail to gather. The available options are All or Deltas. Use the All option to gather all synchronized attachments. Use the Deltas option to gather only attachments that have changed since the last synchronization.

**Remote System**

Data type: **Record**

Reference to the Process Sync Remote System record for the remote instance you are synchronizing processes with. This record identifies the instance that receives outbound synchronization changes or that sent inbound synchronization changes.

**Correlation Detail**

Data type: **Object**

Object containing correlation information about a synchronized record. The object identifies the local and remote correlation IDs associated with a local record.

**Attachments**

Data type: **Array of Objects**

Array containing a list of attachment objects to evaluate.

**Outputs**

These outputs appear in the Data panel. You can use them as inputs elsewhere in your flow.

**Attachments**

Data type: **Array of Objects**

Array containing information about the attachments to synchronize.

**Identify New Attachments action**

Identify the attachments a local record already has to determine which remote attachments need synchronization. Use the output of this action to request missing attachments from a remote system.

**Roles and availability**

Available as a ServiceNow Core Remote Process Sync action.

**Subscription requirements**

This action requires an IntegrationHub Enterprise subscription. For more information, see Request IntegrationHub.

**Role requirements**
This action requires roles granted by delegated development or assigned to the user. For more information, see User access to Flow Designer.

**Inputs**

Provide a value for each input that your action needs. To add dynamic values, you can also drag and drop pills from the Data panel or select them from the pill picker.

**Attachments**

Data type: **Array of Objects**

Array containing a list of attachment objects to evaluate.

**Local Record**

Data type: **Record**

Reference to a record on the local instance you are synchronizing with another instance. The data pill contains all the field values for the specified record. For example, a case record on the local instance.

**Outputs**

These outputs appear in the Data panel. You can use them as inputs elsewhere in your flow.

**Attachments**

Data type: **Array of Objects**

Array containing information about the attachments to synchronize.

**Count**

Data type: **Integer**

Number of attachments identified.

**Look Up Correlation by Local Correlation ID action**

Look up an active correlation by a specified local correlation ID. The local correlation ID identifies the correlation on the local instance. Remote Process Sync actions and flows use the returned correlation to synchronize a local record with a record on a remote system.

**Roles and availability**

Available as a ServiceNow Core Remote Process Sync action.

**Subscription requirements**
This action requires an IntegrationHub Enterprise subscription. For more information, see Request IntegrationHub.

**Role requirements**

This action requires roles granted by delegated development or assigned to the user. For more information, see User access to Flow Designer.

**Inputs**

Provide a value for each input that your action needs. To add dynamic values, you can also drag pills from the Data panel or select them from the pill picker.

**Remote System**

Data type: Record

Reference to the Process Sync Remote System record for the remote instance you are synchronizing processes with. This record identifies the instance that receives outbound synchronization changes or that sent inbound synchronization changes.

**Local Correlation ID**

Data type: String

Globally unique ID of a correlation on the local instance you are synchronizing processes with. This ID uniquely identifies the correlation for inbound transactions.

**Outputs**

These outputs appear in the Data panel. You can use them as inputs elsewhere in your flow.

**Correlation Detail**

Data type: Object

Object containing correlation information about a record. The object identifies the local and remote correlation IDs associated with a local record.

**Status**

Data type: String

Status code returned by the action.

**Look Up Correlation by Local Record action**

Look up an active correlation by a specified local record sys_id. The local record is the record the correlation synchronizes on the local instance.
Sync actions and flows use the returned correlation to synchronize a local record with a record on a remote system.

**Roles and availability**

Available as a ServiceNow Core Remote Process Sync action.

**Subscription requirements**

This action requires an IntegrationHub Enterprise subscription. For more information, see [Request IntegrationHub](#).

**Role requirements**

This action requires roles granted by delegated development or assigned to the user. For more information, see [User access to Flow Designer](#).

**Inputs**

Provide a value for each input that your action needs. To add dynamic values, you can also drag pills from the Data panel or select them from the pill picker.

**Remote System**

Data type: **Record**

Reference to the Process Sync Remote System record for the remote instance you are synchronizing processes with. This record identifies the instance that receives outbound synchronization changes or that sent inbound synchronization changes.

**Local Record**

Data type: **Record**

Reference to a record on the local instance you are synchronizing with another instance. The data pill contains all the field values for the specified record. For example, a case record on the local instance.

**Outputs**

These outputs appear in the Data panel. You can use them as inputs elsewhere in your flow.

**Correlation Detail**

Data type: **Object**

Object containing correlation information about a record. The object identifies the local and remote correlation IDs associated with a local record.
Status
Data type: String
Status code returned by the action.

Move Attachments action
Move attachments from a correlation record to the local record it synchronizes. This action looks up the correlation record by its sys_id.

Roles and availability
Available as a ServiceNow Core Remote Process Sync action.

Subscription requirements
This action requires an IntegrationHub Enterprise subscription. For more information, see Request IntegrationHub.

Role requirements
This action requires roles granted by delegated development or assigned to the user. For more information, see User access to Flow Designer.

Inputs
Provide a value for each input that your action needs. To add dynamic values, you can also drag pills from the Data panel or select them from the pill picker.

Correlation ID
Data type: String
Globally unique ID of a correlation record on the local instance.

Outputs
This action has no outputs.

Request Attachments from Remote System action
Request the transfer of the identified attachments using the specified correlation. The system moves attachments associated with the record on the remote system to the local system.

Roles and availability
Available as a ServiceNow Core Remote Process Sync action.

Subscription requirements
This action requires an IntegrationHub Enterprise subscription. For more information, see Request IntegrationHub.

**Role requirements**

This action requires roles granted by delegated development or assigned to the user. For more information, see User access to Flow Designer.

**Inputs**

Provide a value for each input that your action needs. To add dynamic values, you can also drag pills from the Data panel or select them from the pill picker.

**Attachments**

Data type: **Array of Objects**

Array containing a list of attachment objects to evaluate.

**Remote System**

Data type: **Record**

Reference to the Process Sync Remote System record for the remote instance you are synchronizing processes with. This record identifies the instance that receives outbound synchronization changes or that sent inbound synchronization changes.

**Correlation Detail**

Data type: **Object**

Object containing correlation information about a synchronized record. The object identifies the local and remote correlation IDs associated with a local record.

**Outputs**

These outputs appear in the Data panel. You can use them as inputs elsewhere in your flow.

**Status**

Data type: **String**

Status code returned by the action.

**Send Captured Payload to Remote System**

Generate a captured payload, and send it to a remote system. This action should follow a Look Up Correlation action. Remote Process Sync flows use the returned correlation to check if a new correlation should be created.
Roles and availability
Available as a ServiceNow Core Remote Process Sync action.

Subscription requirements
This action requires an IntegrationHub Enterprise subscription. For more information, see Request IntegrationHub.

Role requirements
This action requires roles granted by delegated development or assigned to the user. For more information, see User access to Flow Designer.

Inputs
Provide a value for each input that your action needs. To add dynamic values, you can also drag pills from the Data panel or select them from the pill picker.

Remote System
Data type: Record
Reference to the Process Sync Remote System record for the remote instance you are synchronizing processes with. This record identifies the instance that receives outbound synchronization changes or that sent inbound synchronization changes.

CRUD Operation
Data type: Choice
Database operation that triggered the process event. The available options are Create, Update, or Delete.

Process Event
Data type: String
Name of the process event to run. The name is the same on each instance that participates in process synchronization. For example, case-to-incident.

Payload
Data type: Object
Object containing changes generated by a capture definition. For example, a list of field changes for a case record on the local instance. The system transforms this object to a JSON string to send it to a remote instance.

Correlation Detail
Data type: Object
Object containing correlation information about a synchronized record. The object identifies the local and remote correlation IDs associated with a local record.

**Outputs**
These outputs appear in the Data panel. You can use them as inputs elsewhere in your flow.

**Status**
Data type: String
Status code returned by the action.

**Error Message**
Data type: String
Error returned by the action.

**Local Correlation ID**
Data type: String
Globally unique ID of a correlation on the local instance you are synchronizing processes with. This ID uniquely identifies the correlation for inbound transactions.

**Remote Correlation ID**
Data type: String
Globally unique ID of a correlation on a remote instance you are synchronizing processes with. This ID uniquely identifies the correlation for outbound transactions.

**Transform Payload from Inbound Sample action**
Transform a Remote Process Sync payload from a JSON string to a complex object. Generate the object structure from a sample of the inbound payload.

**Roles and availability**
Available as a ServiceNow Core Remote Process Sync action.

**Subscription requirements**
This action requires an IntegrationHub Enterprise subscription. For more information, see Request IntegrationHub.

**Role requirements**
This action requires roles granted by delegated development or assigned to the user. For more information, see User access to Flow Designer.

**Inputs**

Provide a value for each input that your action needs. To add dynamic values, you can also drag pills from the Data panel or select them from the pill picker.

**Payload**

- **Data type:** String
- JSON string containing changes generated on a remote instance. For example, a list of field changes for a case record from a remote instance. The system transforms this JSON string to an object on the local instance.

**Sample Payload**

- **Data type:** String
- Portion of a JSON payload you want to use to generate an object structure. Select the elements of the JSON structure you want to map to elements of an object structure.

**Outputs**

These outputs appear in the Data panel. You can use them as inputs elsewhere in your flow.

**Capture Metadata**

- **Data type:** Object
- Object containing information about the capture definition that created the payload.

**Changed Fields**

- **Data type:** Dynamic Object
- Object containing information about the field value changes. The system uses these changes to synchronize correlation and local records.

**Attachment Metadata**

- **Data type:** Array of Object
- Array containing information about the attachments to synchronize.

**Error Message**

- **Data type:** String
Error returned by the action.

**Update Correlation State action**

Enable or disable synchronization of records by the specified correlation. Set an active correlation to inactive to disable synchronization of records. Set an inactive correlation to active to resume synchronization of records.

**Roles and availability**

Available as a ServiceNow Core Remote Process Sync action.

- **Subscription requirements**
  
  This action requires an IntegrationHub Enterprise subscription. For more information, see [Request IntegrationHub](#).

- **Role requirements**
  
  This action requires roles granted by delegated development or assigned to the user. For more information, see [User access to Flow Designer](#).

**Inputs**

Provide a value for each input that your action needs. To add dynamic values, you can also drag pills from the Data panel or select them from the pill picker.

- **Correlation Detail**
  
  Data type: **Object**
  
  Object containing correlation information about a synchronized record. The object identifies the local and remote correlation IDs associated with a local record.

- **State**
  
  Data type: **Choice**
  
  Synchronization state of records. The available options are Active or Inactive. Active records are being synchronized. Inactive records are not synchronized.

**Outputs**

These outputs appear in the Data panel. You can use them as inputs elsewhere in your flow.

- **Correlation Detail**
  
  Data type: **Object**
Object containing correlation information about a record. The object identifies the local and remote correlation IDs associated with a local record.

**Status**

Data type: **Choice**

Synchronization state of records. The available options are Active or Inactive. Active records are being synchronized. Inactive records are not synchronized.

**Error**

Data type: **String**

Error returned by the action.

**Remote Process Sync sample subflows**

Copy and configure the sample subflows to synchronize processes between multiple instances. Use an inbound subflow to parse incoming record data. Use an outbound subflow to send record data to a remote instance.

Remote Process Sync provides you with sample inbound and outbound subflows for you to use as templates. These subflows let you:

- Receive record data from a remote instance and process it as incidents
- Send incident record data to a remote instance for processing

**Remote Process Sync Inbound Flow Template - Basic**

A sample Remote Process Sync subflow to process incoming payloads received from a remote instance. This subflow creates a correlation between a remote record and a local incident record. Copy this subflow and edit the actions that refer to the Incident table.

**Roles and availability**

Available as a Global Remote Process Sync subflow.

**Subscription requirements**

This action requires an IntegrationHub Enterprise subscription. For more information, see Request IntegrationHub.

**Role requirements**

This action requires roles granted by delegated development or assigned to the user. For more information, see User access to Flow Designer.
Inputs

Provide a value for each input that your action needs. To add dynamic values, you can also drag pills from the Data panel or select them from the pill picker.

**Wait for Completion**

Data type: True/False

Option to require the parent flow to wait for the subflow to complete. If enabled, the parent flow cannot proceed to the next action until the subflow completes.

**Remote System**

Data type: Record

Reference to the Process Sync Remote System record for the remote instance you are synchronizing processes with. This record identifies the instance that receives outbound synchronization changes or that sent inbound synchronization changes.

**Remote Correlation ID**

Data type: String

Globally unique ID of a correlation on a remote instance you are synchronizing processes with. This ID uniquely identifies the correlation for outbound transactions.

**Local Correlation ID**

Data type: String

Globally unique ID of a correlation on the local instance you are synchronizing processes with. This ID uniquely identifies the correlation for inbound transactions.

**Process Event**

Data type: String

Name of the process event to run. The name is the same on each instance that participates in process synchronization. For example, case-to-incident.

**Payload**

Data type: String

JSON string containing changes generated on a remote instance. For example, a list of field changes for a case record from a remote instance. The system transforms this JSON string to an object on the local instance.

**CRUD Operation**
Data type: **Choice**

Database operation that triggered the process event. The available options are Create, Update, or Delete.

**Outputs**

These outputs appear in the Data panel. You can use them as inputs elsewhere in your flow.

**Error Message**

Data type: **String**

Error returned by the action.

**Status**

Data type: **Choice**

Synchronization state of records. The available options are Active or Inactive. Active records are being synchronized. Inactive records are not synchronized.

**Remote Process Sync Outbound Flow Template - Basic**

A sample Remote Process Sync subflow to send outgoing payloads to a remote instance. This subflow creates a correlation between a remote record and a local incident record. Copy this subflow and edit the input for the local record to the table of your choice.

**Roles and availability**

Available as a Global Remote Process Sync subflow.

**Subscription requirements**

This action requires an IntegrationHub Enterprise subscription. For more information, see Request IntegrationHub.

**Role requirements**

This action requires roles granted by delegated development or assigned to the user. For more information, see User access to Flow Designer.

**Inputs**

Provide a value for each input that your action needs. To add dynamic values, you can also drag pills from the Data panel or select them from the pill picker.

**Wait for Completion**

Data type: **True/False**
Option to require the parent flow to wait for the subflow to complete. If enabled, the parent flow cannot proceed to the next action until the subflow completes.

**Local Record**

Data type: `Record`

Reference to a record on the local instance you are synchronizing with another instance. The data pill contains all the field values for the specified record. For example, a case record on the local instance.

**Remote System**

Data type: `Record`

Reference to the Process Sync Remote System record for the remote instance you are synchronizing processes with. This record identifies the instance that receives outbound synchronization changes or that sent inbound synchronization changes.

**CRUD Operation**

Data type: `Choice`

Database operation that triggered the process event. The available options are Create, Update, or Delete.

**Trigger/Capture Definition**

Data type: `Record`

Reference to the Capture Definition record that the system uses to create an outbound payload. The data pill contains all the field values for the specified record. For example, a capture definition for case records.

**Process Event**

Data type: `String`

Name of the process event to run. The name is the same on each instance that participates in process synchronization. For example, case-to-incident.

**Payload**

Data type: `Object`

Object containing changes generated by a capture definition. For example, a list of field changes for a case record on the local instance. The system transforms this object to a JSON string to send it to a remote instance.
Outputs
These outputs appear in the Data panel. You can use them as inputs elsewhere in your flow.

Status
Data type: Choice
Synchronization state of records. The available options are Active or Inactive. Active records are being synchronized. Inactive records are not synchronized.

Error Message
Data type: String
Error returned by the action.

Correlation
Establish a synchronization relationship between records that reside on separate instances.

A correlation identifies record data from a remote instance you want to use on a local instance. An integration can use data from a correlated remote record to update a local record. Typically, integrations correlate records to synchronize them and ensure that record changes propagate across instances.

There are two types of correlation available.
- Classic correlation field
- IntegrationHub Correlation records

Classic correlation field
Prior to IntegrationHub Remote Process Sync, you could only create correlations with a limited set of record types that had a Correlation ID field. By default, the Correlation ID field is only available to Configuration Item, Service, and Task records. The Correlation ID field stores the globally unique ID of a matching remote record. The Correlation ID identifies the remote record whose data values should be used to update the local record. For example, suppose incident record INC100001 correlates to problem record PRB123456 on a remote instance. Whenever changes are made to fields in remote problem PRB123456, the system uses the Correlation ID to identify that local incident INC100001 receives the same field updates.

A classic correlation creates a one-to-one relationship between a record on the local system and a record on a remote system. One local record can only ever correlate to one remote record. The correlation provides no information...
about the remote system nor the current state of the correlation. Administrators manually manage classic correlations from the records being updated.

Sample classic correlation field

<table>
<thead>
<tr>
<th>Local Instance</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number</strong></td>
<td>INC100001</td>
<td><strong>Short Description</strong></td>
<td>Cannot connect to network</td>
<td><strong>State</strong></td>
</tr>
<tr>
<td><strong>Correlation ID</strong></td>
<td>sys_id of PRB123456</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Remote Instance</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number</strong></td>
<td>PRB123456</td>
<td><strong>Short Description</strong></td>
<td>Cannot connect to network</td>
<td><strong>State</strong></td>
</tr>
<tr>
<td><strong>Correlation ID</strong></td>
<td>sys_id of INC100001</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

IntegrationHub Correlation records

IntegrationHub Remote Process Sync extends the functionality of classic correlation with the introduction of dedicated Correlation [ih_sync_correlation] records.

A Correlation record contains these fields.

**Local Correlation ID**

The globally unique ID that identifies the correlation on the local system. By default, IntegrationHub Remote Process Sync generates a unique sys_id value for this field. The distinct sys_id acts as an alias which prevents the correlation from breaking due to changes in the local record. When IntegrationHub Remote Process Sync sends this ID value to a remote system, the receiving instance uses it as the Remote Correlation ID.

**Remote Correlation ID**

The globally unique ID that identifies the correlation on the remote system. By default, IntegrationHub Remote Process Sync generates a unique sys_id value for this field. The distinct sys_id acts as an alias which prevents the correlation from breaking due to changes in the remote record. When IntegrationHub Remote Process Sync sends this ID value to a remote system, the receiving instance uses it as the Local Correlation ID.

**Local Table**

The table where the correlation creates or updates records. An IntegrationHub Remote Process Sync capture definition monitors this table for record changes. IntegrationHub Remote Process Sync uses this field to find correlations by table name.
Local Record

The record created or updated by a correlation. This field stores the same value as the Correlation ID field from a classic correlation. When other business logic makes changes to this record, the changes do not overwrite the correlation.

Remote System

The remote instance where IntegrationHub Remote Process Sync sends and receives record changes. Each correlation record can only refer to one remote instance. To correlate the same local record to multiple remote systems simultaneously, you can create multiple correlation records.

State

The synchronization state of the correlation. Active correlations receive additions and updates. Inactive correlations do not produce additions or updates, but can be queried for auditing purposes and reactivated as needed.

⚠️ CAUTION: IntegrationHub Remote Process Sync manages correlation records for you. Directly editing correlation records may prevent synchronization of records, and may result in data loss.

Sample IntegrationHub Correlation record

<table>
<thead>
<tr>
<th>Customer</th>
<th>Local Correlation ID</th>
<th>Remote Correlation ID</th>
<th>Local Table</th>
<th>Local Record</th>
<th>Remote System</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>COR1</td>
<td>COR5</td>
<td>Incident</td>
<td>INC1</td>
<td>Vendor</td>
<td></td>
<td>Active</td>
</tr>
<tr>
<td>COR2</td>
<td>COR6</td>
<td>Incident</td>
<td>INC1</td>
<td>Vendor</td>
<td></td>
<td>Active</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Local Correlation ID</th>
<th>Remote Correlation ID</th>
<th>Local Table</th>
<th>Local Record</th>
<th>Remote System</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>COR5</td>
<td>COR1</td>
<td>Problem</td>
<td>PRB1</td>
<td>Customer</td>
<td></td>
<td>Active</td>
</tr>
<tr>
<td>COR6</td>
<td>COR2</td>
<td>Problem</td>
<td>PRB2</td>
<td>Customer</td>
<td></td>
<td>Active</td>
</tr>
</tbody>
</table>

Correlation records offer several advantages over a single correlation field.

- Allow management of correlations by Remote Process Sync
- Identify the remote system associated with a correlation
- Provide separate Correlation ID values for the local and remote systems
- Allow correlation of a single local record with multiple remote systems
- Allow correlations to be deactivated and reactivated as needed
- Allow Correlation ID values to be distinct from the sys_id of a remote record

**Remote Process Sync system properties**

Refer to the list of system properties for Remote Process Sync to learn how to manage your process-oriented, multi-instance integration.

Adjust the values for the following properties at **System Properties > All Properties** to manage your Remote Process Sync integration:

<table>
<thead>
<tr>
<th>System Property</th>
<th>Description</th>
<th>Default value</th>
<th>Minimum value</th>
<th>Maximum value</th>
</tr>
</thead>
</table>
| glide.hub.process.sync.jobs.outbound.context_reporting | outbound scheduled jobs:  
  • Use the standard FlowAPI instead of the quick API (default)  
  • Write flow contexts to the outbound queue  
  • Write outbound records to the Outbound Queue States [ih_sync_outbound_record] table | | Not applicable | Not applicable |
<p>| glide.hub.process.sync.jobs.inbound.context_reporting | inbound scheduled jobs: | | Not applicable | Not applicable |</p>
<table>
<thead>
<tr>
<th>System Property</th>
<th>Description</th>
<th>Default value</th>
<th>Minimum value</th>
<th>Maximum value</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Use the standard FlowAPI instead of the quick API (default)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Write flow contexts to the inbound queue</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Write inbound records to the Inbound Records [ih_sync_inbound_record] table</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>glide.hub.processsync.jobs.outbound.process_maxtime</td>
<td>Maximum time, in seconds, that an outbound scheduled job runs before timing out</td>
<td>300</td>
<td>60</td>
<td>1800</td>
</tr>
<tr>
<td>glide.hub.processsync.jobs.inbound.process_maxtime</td>
<td>Maximum time, in seconds, that an inbound scheduled job runs before timing out</td>
<td>300</td>
<td>60</td>
<td>1800</td>
</tr>
<tr>
<td>glide.hub.processsync.jobs.outbound.subflow.execution_timeout</td>
<td>Time, in milliseconds, that an outbound subflow runs before timing out</td>
<td>30000</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>System Property</td>
<td>Description</td>
<td>Default value</td>
<td>Minimum value</td>
<td>Maximum value</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>---------------</td>
<td>---------------</td>
</tr>
<tr>
<td>glide.hub.process.sync.jobs.inbound.subflow.execution.timeout</td>
<td>Time, in milliseconds, that an inbound subflow runs before timing out.</td>
<td>30000</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>glide.ih.process.sync.retry.times</td>
<td>Number of times to retry processing of an outbound or inbound queue before setting the queue's state to Error.</td>
<td>0</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td>glide.ih.process.sync.retry.interval.seconds</td>
<td>Time interval, in seconds, between each retry attempt to process an outbound or inbound queue.</td>
<td>60</td>
<td>0</td>
<td>300</td>
</tr>
<tr>
<td>glide.ih.process.sync.debug</td>
<td>If set to true, log entries will be created in System Logs &gt; System Log &gt; All for Remote Process Sync tables.</td>
<td>false</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>glide.hub.process.sync.record.successful.status</td>
<td>If set to true, the Status field for outbound queues will be updated to Success when there</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>System Property</td>
<td>Description</td>
<td>Default value</td>
<td>Minimum value</td>
<td>Maximum value</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
<td>---------------</td>
<td>---------------</td>
<td>---------------</td>
</tr>
<tr>
<td>glide.process_sync.inbound_queue.error.ttl.seconds</td>
<td>Number of seconds that records in the error state can exist in the inbound queue before they expire. The system purges expired records from the queue once a day.</td>
<td>2592000 (30 days)</td>
<td>0</td>
<td>5184000 (60 days)</td>
</tr>
</tbody>
</table>
### Important:
Records in the error state have not been processed. Review and fix the process definition and its related records. To reprocess records in the inbound queue, set the state to Ready. To ignore these records, set the state to skipped.

<table>
<thead>
<tr>
<th>System Property</th>
<th>Description</th>
<th>Default value</th>
<th>Minimum value</th>
<th>Maximum value</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.process_sync.inbound_queue.processed.ttl.seconds</td>
<td>Number of seconds that records in the processed state can exist in the inbound queue before they expire. The system purges expired.</td>
<td>604800 (7 days)</td>
<td>0</td>
<td>5184000 (60 days)</td>
</tr>
<tr>
<td>System Property</td>
<td>Description</td>
<td>Default value</td>
<td>Minimum value</td>
<td>Maximum value</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
<td>---------------</td>
<td>---------------</td>
<td>---------------</td>
</tr>
<tr>
<td>glide.process_sync.inbound_queue.ready.ttl.seconds</td>
<td>Number of seconds that records in the ready state can exist in the inbound queue before they expire. The system purges expired records from the queue once a day.</td>
<td>2592000 (30 days)</td>
<td>0</td>
<td>5184000 (60 days)</td>
</tr>
</tbody>
</table>

**Important:**
Records in the ready state have not been processed. Review the system batch size settings to ensure that it can process all incoming records before they expire.
<table>
<thead>
<tr>
<th>System Property</th>
<th>Description</th>
<th>Default value</th>
<th>Minimum value</th>
<th>Maximum value</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.process_sync.inbound_queue.skipped.ttl.seconds</td>
<td>Number of seconds that records in the skipped state can exist in the inbound queue before they expire. The system purges expired records from the queue once a day.</td>
<td>604800 (7 days)</td>
<td>0</td>
<td>5184000 (60 days)</td>
</tr>
<tr>
<td>System Property</td>
<td>Description</td>
<td>Default value</td>
<td>Minimum value</td>
<td>Maximum value</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
<td>---------------</td>
<td>---------------</td>
<td>---------------</td>
</tr>
<tr>
<td>glide.process_sync.inbound_queue_table_cleaner_batch_size</td>
<td>Number of inbound queue records to process per batch when purging expired records.</td>
<td>10000</td>
<td>1000</td>
<td>500000</td>
</tr>
<tr>
<td>System Property</td>
<td>Description</td>
<td>Default value</td>
<td>Minimum value</td>
<td>Maximum value</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>---------------</td>
<td>---------------</td>
</tr>
<tr>
<td>glide.process_sync.outbound_queue.error.ttl.seconds</td>
<td>Number of seconds that records in the error state can exist in the outbound queue before they expire. The system purges expired records from the queue once a day.</td>
<td>2592000 (30 days)</td>
<td>0</td>
<td>5184000 (60 days)</td>
</tr>
</tbody>
</table>
### Important:
Records in the error state have not been processed. Review and fix the process definition and its related records. To reprocess records in the outbound queue, set the state to Ready. To ignore these records, set the state to skipped.

<table>
<thead>
<tr>
<th>System Property</th>
<th>Description</th>
<th>Default Value</th>
<th>Minimum Value</th>
<th>Maximum Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>glide.process_sync.outbound_queue.processed.ttl_seconds</strong></td>
<td>Number of seconds that records in the processed state can exist in the outbound queue before they expire. The system purges</td>
<td>5184000 (60 days)</td>
<td>0</td>
<td>5184000 (60 days)</td>
</tr>
<tr>
<td>System Property</td>
<td>Description</td>
<td>Default value</td>
<td>Minimum value</td>
<td>Maximum value</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
<td>---------------</td>
<td>---------------</td>
<td>---------------</td>
</tr>
<tr>
<td>glide.process_sync.outbound_queue.ready.ttl.seconds</td>
<td>Number of seconds that records in the ready state can exist in the outbound queue before they expire. The system purges expired records from the queue once a day.</td>
<td>2592000 (30 days)</td>
<td>0</td>
<td>5184000 (60 days)</td>
</tr>
</tbody>
</table>
## System Property

<table>
<thead>
<tr>
<th>System Property</th>
<th>Description</th>
<th>Default value</th>
<th>Minimum value</th>
<th>Maximum value</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.process_sync.outbound_queue.skipped.ttl.seconds</td>
<td>Number of seconds that records in the skipped state can exist in the outbound queue before they expire. The system purges expired records from the queue once a day.</td>
<td>384600 (7 days)</td>
<td>0</td>
<td>5184000 (60 days)</td>
</tr>
</tbody>
</table>

**Important:**

Records in the ready state have not been processed. Review the system batch size settings to ensure that it can process all outgoing records before they expire.
<table>
<thead>
<tr>
<th>System Property</th>
<th>Description</th>
<th>Default value</th>
<th>Minimum value</th>
<th>Maximum value</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.process_sync.outbound_queue.table_cleaner_batch_size</td>
<td>Number of outbound queue records to process per batch when purging expired records.</td>
<td>10000</td>
<td>1000</td>
<td>500000</td>
</tr>
</tbody>
</table>

**Important:**
Records in the skipped state will not be processed. Review and fix the process definition and its related records. To reprocess records in the outbound queue, set the state to Ready. To ignore these records, leave the state as skipped.
Password reset using IntegrationHub

Create subflows in IntegrationHub to automate and customize the password reset process for users managed by third-party applications such as Okta or Microsoft Azure AD.

Create subflows in IntegrationHub to automate password reset processes. Use the Password Reset application to enable an end user to use a self-service process to reset or change the password. Alternatively, your organization can implement a process that requires a service desk agent to reset passwords for end users. See Customize password reset processes and integrate third-party credential services for more information.

Password reset IntegrationHub usage overview

Navigate to Password Reset > Usage Overview view the count of password reset transactions performed using IntegrationHub for your instance.

⚠️ Note: Admin must activate the Password Reset - Orchestration Add-on (com.glideapp.password_reset.addon.orchestration) plugin to view the dashboard.

Client Software Distribution using IntegrationHub

Use Client Software Distribution (CSD) to distribute software from the Service Catalog using third-party management systems.

Create all the records necessary to deploy software from Service Catalog requests, including software models and catalog items. You can use the CSD application to automate the deployment and revocation of software from an SCCM host using the Microsoft SCCM spoke. You can define lease periods for software distributed from the Service Catalog and allow lease extensions in some cases, pending approvals. Deployment is accomplished using IntegrationHub flows, subflows, and actions.

Integrates with Software Asset Management to manage license counts for deployed software.
Request client software distribution

Client software distribution requires the Orchestration - Client Software Distribution plugin (com.snc.orchestration.client_sf_distribution), which is available by request with a subscription to IntegrationHub.

Before you begin
Role required: admin

About this task
The Client Software Distribution plugin activates the System Center Configuration Manager plugin that contains the Microsoft SCCM spoke actions to deploy or revoke software using an SCCM server. For additional plugin dependencies, see Plugins installed with client software distribution.

Note: The Client Software Distribution plugin runs in its own application scope.

Procedure
1. Navigate to System Definition > Plugins.
2. Click Request Plugin.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>Date and time that must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>
Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments.

4. Click Submit.

Components installed with client software distribution
Several types of components are installed with client software distribution (CSD).

Tables installed
These tables are installed with the Client Software Distribution plugin (com.snc.orchestration.client_sf_distribution).

Client software distribution tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client Software Distribution Catalog Item [sn_client_sf_dist_cat_item]</td>
<td>Contains all catalog items created for client software distribution. This table extends the Catalog Item [sc_cat_item] table.</td>
</tr>
<tr>
<td>Client Software Distribution Software Request [sn_client_sf_dist_req_software]</td>
<td>Contains all requested software, and their statuses.</td>
</tr>
<tr>
<td>Client Software Distribution Application [sn_client_sf_dist_application]</td>
<td>Contains all discovered CSD applications.</td>
</tr>
<tr>
<td>Client Software Distribution Provider [sn_client_sf_dist_provider]</td>
<td>Contains all software distribution providers.</td>
</tr>
</tbody>
</table>
## Client software distribution tables (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client Software Distribution Extension Key [sn_client_sf_dist_extension_key]</td>
<td>Contains the predefined CSD extension keys.</td>
</tr>
<tr>
<td>Client Software Distribution Extension Point [sn_client_sf_dist_extension_point]</td>
<td>Contains the customization script for the extension keys.</td>
</tr>
<tr>
<td>Client Software Distribution Software Configuration [sn_client_sf_dist_software_config]</td>
<td>Base table for all software provider configurations.</td>
</tr>
<tr>
<td>SCCM Server Instance [sn_client_sf_dist_cmdb_ci_sccm_server]</td>
<td>Contains all SCCM server instances. This table extends the Configuration Item [cmdb_ci] table.</td>
</tr>
<tr>
<td>SCCM Application [sn_client_sf_dist_sccm_application]</td>
<td>Contains all discovered SCCM applications. This table extends the Client Software Distribution Application [sn_client_sf_dist_application] table.</td>
</tr>
<tr>
<td>SCCM Application Catalog Item [sn_client_sf_dist_sccm_app_cat_item]</td>
<td>Contains all catalog items created for SCCM applications. This table extends the Client Software Distribution Catalog Item [sn_client_sf_dist_cat_item] table.</td>
</tr>
<tr>
<td>SCCM Collection [sn_client_sf_dist_sccm_collection]</td>
<td>Contains all discovered SCCM collections. Contains all discovered SCCM collections.</td>
</tr>
<tr>
<td>SCCM Deployment [sn_client_sf_dist_sccm_deployment]</td>
<td>Contains all discovered SCCM deployments. Contains all discovered SCCM deployments.</td>
</tr>
<tr>
<td>SCCM Configuration [sn_client_sf_dist_sccm_config]</td>
<td>Contains the SCCM application, install and uninstall collections, and Discovery model. This table extends the Client Software Distribution Software Configuration [sn_client_sf_dist_software_config]</td>
</tr>
</tbody>
</table>
Plugins installed

These plugins are installed with the Client Software Distribution plugin, if they are not already active.

For instructions on requesting activation of Client Software Distribution (CSD) see Request client software distribution.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orchestration - System Center Configuration Manager</td>
<td>Installs the custom SCCM Orchestration activities that do work on the SCCM target host.</td>
</tr>
<tr>
<td>Orchestration - Asset Lease Management</td>
<td>Installs the lease functionality for software distributed through the Service Catalog. This includes starting, stopping, and extending leases.</td>
</tr>
<tr>
<td>Service Catalog Scoped API</td>
<td>Installs the API to support application creation in the Service Catalog.</td>
</tr>
<tr>
<td>Software Asset Management Core</td>
<td>Provides the base tables for software asset management. Includes software installations, usages, suite calculations, and discovery models.</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Runtime</td>
<td>Enables execution of IntegrationHub actions and flows.</td>
</tr>
<tr>
<td>Flow Designer support for the Service Catalog</td>
<td>Provides support for Flow Designer in Service Catalog.</td>
</tr>
<tr>
<td>Microsoft SCCM Spoke for IntegrationHub</td>
<td>Provides actions in Flow Designer that a Process Analyst can use to automate.</td>
</tr>
</tbody>
</table>
Plugins for IntegrationHub - Client Software Distribution (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Asset Management Spoke (com.sn_sam_spoke)</td>
<td>Provides actions in Flow Designer for Software Asset Management activities.</td>
</tr>
<tr>
<td>Responsive Dashboards (com.glideapp.dashboard)</td>
<td>Creates, modifies, and shares dashboards using responsive and dynamic widget layouts.</td>
</tr>
<tr>
<td>Outbound Tracking (com.glide.outbound_tracking)</td>
<td>Tracks outbound requests.</td>
</tr>
</tbody>
</table>

Roles installed

These roles are installed with the Client Software Distribution plugin.

Roles for IntegrationHub - Client Software Distribution

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains Roles</th>
</tr>
</thead>
</table>
| Client software distribution admin [sn_client_sf_dist.csd_admin] | Administrator role for managing client software distribution application. | • sam
• agent_admin
• report_admin
• catalog_admin
• itil
• workflow_admin |

Script includes installed

These script includes are installed with the Client Software Distribution plugin.
### Script Includes for Client Software Distribution

<table>
<thead>
<tr>
<th>Script Include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSDExtensionPoint</td>
<td>Execute the CSD provider’s specific code</td>
</tr>
<tr>
<td>CSDUtil</td>
<td>Utility functions for the CSD application.</td>
</tr>
<tr>
<td>RefQualsCSD</td>
<td>Reference qualifier filter. This script provides the filter functions for the CSD providers, devices, SCCM application, install collections, and uninstall collections.</td>
</tr>
<tr>
<td>SCCMCatItemHandler</td>
<td>Sets the field values of specific SCCM catalog items. These values are the SCCM catalog item table name, catalog item name, SCCM provider, and SCCM software configuration.</td>
</tr>
<tr>
<td>SoftwareCatItemCreator</td>
<td>Creates software catalog items.</td>
</tr>
<tr>
<td>CSDCatItemHandler</td>
<td>Base class for CSD catalog item creation. This script is used by the Create Catalog Item UI action to create and application catalog.</td>
</tr>
<tr>
<td>CSDDemoDataUtil</td>
<td>Populates demo data.</td>
</tr>
<tr>
<td>CSDDemoDataUtilAjax</td>
<td>Populates demo data.</td>
</tr>
</tbody>
</table>

### Properties installed

Properties for client software distribution (CSD) manage the installation status of requested software deployments and configure scheduled Discoveries.

To access CSD properties, navigate to **Client Software Distribution > Properties**. The following properties are available:

#### Client software distribution properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status check expiration interval</td>
<td>sn_client_sf_dist.softwareInstallExpDays</td>
<td>Controls how many days the system waits before ignoring the software installation status. The default time limit for installing software is 30 days before the system</td>
</tr>
</tbody>
</table>
### Client software distribution properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>stops checking the installation status of a deployment. Installation statuses are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Not installed:</strong> User has not installed requested software prior to the expiration of the configured time limit.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Installed:</strong> Software was installed within the configured time limit.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Status check expired:</strong> Time limit has expired for the user to install the requested software. The system no longer checks the status of this deployment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Revoked:</strong> Software was revoked by the administrator.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Default value:</strong> 30</td>
</tr>
</tbody>
</table>

| Reconcile software installation status | sn_client_sf_dist.softwareInstallIntervalHour | Determines when the scheduled job runs that determines the installation status. By default, the system |
## Client software distribution properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>interval (hours)</td>
<td></td>
<td>checks the installation status every hour.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Default value</strong>: 24</td>
</tr>
<tr>
<td>Set scheduled application</td>
<td>sn_client_sf_dist.discoveryExeDay</td>
<td>Sets the repeat interval for the scheduled job that runs application Discovery. By default, Discovery runs at midnight on the day set with this value.</td>
</tr>
<tr>
<td>Discovery interval (days)</td>
<td></td>
<td>• <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Default value</strong>: 5</td>
</tr>
<tr>
<td>Set lease execution schedule</td>
<td>sn_client_sf_dist.lease_execution_interval</td>
<td>Interval in which the CSD Lease Schedule scheduled job checks for requested software leases to start, stop, or extend.</td>
</tr>
<tr>
<td>job interval (minutes)</td>
<td></td>
<td>• <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Default value</strong>: 1</td>
</tr>
<tr>
<td>Set time prior to lease end</td>
<td>sn_client_sf_dist.lease_end_notification</td>
<td>Determines how many days prior to the end of a software lease to notify the requester. If lease extensions are allowed, ensure that this period provides enough time for the approval process to complete before the lease expires.</td>
</tr>
<tr>
<td>to notify requester (days)</td>
<td></td>
<td>• <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Default value</strong>: 5</td>
</tr>
</tbody>
</table>
**Flows and subflows installed**

These flows and subflows are installed with the Client Software Distribution plugin.

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order Client Software</td>
<td>Schedules the installation of an ordered application on the selected device. The request requires approvals based on the user input in the catalog item configuration.</td>
</tr>
<tr>
<td>Deploy Client Software</td>
<td>Deploys a software by executing provider-specific subflow. Creates catalog tasks if there is a failure in the execution of the provider subflow.</td>
</tr>
</tbody>
</table>

**Subflows installed with client software distribution**

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discover And Store SCCM Data</td>
<td>Retrieves lists of applications, collections, and deployments from SCCM servers using Microsoft SCCM spoke actions. An administrator runs this subflow from a UI action in a SCCM Server Instance record.</td>
</tr>
<tr>
<td>Deploy SCCM Application</td>
<td>Triggered by the Order Client Software flow to deploy software through SCCM server. This subflow adds either the user or the device into the SCCM collection.</td>
</tr>
<tr>
<td>Revoke Client Software</td>
<td>Begins the software revocation process for software deployed by an external provider. Administrators run this subflow from a UI action on the Requested Software record and the Installed Software Not Entitled record. This subflow triggers the appropriate provider subflow that performs the actual revocation. For example, this subflow triggers the Revoke SCCM Application subflow for applications in SCCM uninstall collections.</td>
</tr>
<tr>
<td>Revoke SCCM Application</td>
<td>Revokes SCCM applications that are members of an uninstall collection. The Revoke Client Software subflow triggers this subflow to revoke software deployed by an SCCM server. This subflow moves either the user or the device from the SCCM collection into the appropriate uninstall collection.</td>
</tr>
<tr>
<td>CSD Lease End Notification</td>
<td>Notifies user about the lease end date of the software and send link to extend lease end date.</td>
</tr>
</tbody>
</table>
### Subflows installed with client software distribution (continued)

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSD Deploy Software Post Processing</td>
<td>Performs post processing after the software deployment is successful. The Deploy Client Software flow triggers this subflow.</td>
</tr>
<tr>
<td>CSD Lease End Notification</td>
<td>Notifies user about the lease end date of the software and sends link to extend lease end date.</td>
</tr>
<tr>
<td>Prepare Revocation Data</td>
<td>Prepare data required for the revocation flow.</td>
</tr>
</tbody>
</table>

### Create licenses and counters for distributed software

Licenses and software counters are associated with the software model and must be created if you want to track the license for software deployed by client software distribution (CSD).

**Before you begin**

Role required: sam or admin

You can create software licenses and counters in Software Asset Management for software items deployed from the service catalog by CSD. CSD depends on the software counter result to determine if the license is available for the requested software. If the license **Valuation** is greater than 0, and the license type is **Not allocated**, CSD assumes that the license is available for the software.

**Procedure**

1. Navigate to **Software Asset > Software Licenses**.
2. Add a new software license for the software model you used in CSD.
3. Navigate to **Software Asset > Reconciliation > Software Counters**.
4. Create a software counter for the software model you created.
5. Run the counter to retrieve the software license information.

**Client software distribution ordering process**

Software deployed by Client Software Distribution (CSD) can be ordered from the service catalog by individual users or by approved users on behalf of others.
Client Software Distribution catalog items have different options, depending on how ordering is configured.

**Lease start and end dates**

All software deployed by CSD requires users to specify the beginning date for the lease. This is enforced by the Asset Lease Management plugin that is activated automatically with CSD. The system pre-populates the **Lease start** field with the current date and time.

If the catalog item is configured for revocation (uninstall), the form displays the **Lease end** field, which allows the requester to define an end date and time for the lease. The system validates user input in these fields to ensure that the dates selected define a future window. The **Lease end** field is not mandatory and can be left blank to order software with no end date.

ℹ️ **Note:** For systems deploying software from Microsoft System Center Configuration Management (SCCM), the **Lease end** field is only available if the **SCCM configuration** specifies an uninstall collection.

**Software offered only to the logged in user**

If the software catalog item is configured with the **Order on behalf of** check box cleared, the **User** field does not appear on the order form. The logged in user selects the device on which to deploy the software from the **Device to install this software on** field. Only those devices assigned to the logged in user appear in the list.

In this example, a user has logged into the service catalog to order Firefox for a computer that is assigned to her. She selects the machine from a list of devices she owns and selects the date and time the lease should begin. This software is deployed through Microsoft System Center Configuration Management (SCCM), but does not have an uninstall collection configured and cannot be revoked automatically by the system. As a result, the **Lease end** field is not available.
Software ordered on behalf of another user

If the software catalog item is configured with the Order on behalf of check box selected, the User field appears on the form. The logged in user can select any user from this field. The Device to install this software on field only lists the devices assigned to the user selected in the User field. If an approval is required for software ordered on behalf of another user, the system automatically sends an approval request to the manager of the user receiving the software. The approval is skipped if the requester is the named user's manager.

In this example, a manager is ordering Google Chrome for a contractor. The manager selects the contractor from the User field and then chooses a computer from the list of devices assigned to the contractor. This software has an SCCM uninstall collection configured, which allows the manager to select an end date for the lease that coincides with the end of the user's contract. When the lease expires, SCCM automatically uninstalls the software from the device.
Extend a software lease

Users of software deployed by Client Software Distribution (CSD) can request the extension of a lease window, if the software is revocable by a software distribution system.

Before you begin
Role required: Any system user

About this task
If your software has a lease end date defined, and the software status is Installed, you can request an extension of the lease, pending any approvals your organization requires.

Procedure
1. Navigate to Service Catalog > My Requested Software.
   The list shows only the software you have requested from the service catalog.
2. Select the record for the installed software whose lease you want to extend.
3. Under Related Links click Extend Lease.
4. In the dialog box that appears, select a new lease end date in the calendar and click OK.
You must select a date later than the current date.

If the lease extension is subject to manager approval, you are notified of the decision. If the request is approved, a notification shows the new lease end date. If the new end date is within 5 days (the default notification period) of the date when you made the request, CSD sends an immediate end-of-lease notification.

**Important:** If lease extensions in your organization require approval, make sure the approver is available and has enough time to process your extension request. If the extension cannot be approved before the original end date expires, the software is revoked.

**Client software distribution from SCCM**

Use Client Software Distribution (CSD) to deploy and revoke software deployments from Microsoft System Center Configuration Management (SCCM) and manage distributions on SCCM hosts.

The Microsoft SCCM spoke contains actions that CSD uses to deploy software from a service catalog request and manage user and device collections on SCCM servers. In addition, CSD can manage license counts for deployed software using ServiceNow Software Asset Management, revoke software deployed by SCCM without user interaction, and manage lease periods.
Configuring SCCM

Follow the SCCM configuration procedures in the order shown.

Configure the Application Administrator role on the SCCM server

To deploy software using ServiceNow Client Software Distribution (CSD), ensure that an SCCM administrative user has the correct permissions to deploy software and that PowerShell is properly configured.

Before you begin

SCCM role required: Application Administrator

About this task

These instructions are for Microsoft 2012 R2 Server.

Procedure

1. In the System Center Configuration Manager console, navigate to Administration > Security > Administrative Users.
2. Right-click the user to whom you want to grant the Application Administrator role.
3. Select Properties from the drop-down menu.
4. In the Properties dialog box, select the Security Roles tab.
5. Ensure that the user has the Application Administrator role.
6. If the user does not already have this role, click Add, select this role from the list, and click OK.
7. Log into SCCM as the user with the Application Administrator role.

8. Open the menu from the upper left corner of the console and select **Connect via Windows PowerShell**.
Connect to PowerShell

9. Ensure that the user can access the CM console. This action establishes the environment path to PowerShell for the logged in Application Administrator user.

Update the SCCM cmdlet libraries

Ensure that the System Center Configuration Manager SCCM Cmdlet Library is up-to-date.

Before you begin

SCCM role required: Either current user or system administrator, depending on settings.

About this task

The System Center Configuration Manager SCCM Cmdlet Library installs and updates the Windows PowerShell module for SCCM. SCCM checks for library updates on a daily basis. Out-of-date libraries can cause Discovery of the SCCM server to fail, because the system cannot parse the SCCM activity output. This warning message appears in the ECC queue input records for the SCCM GET activities:

WARNING: An update to the System Center 2012 Configuration Manager Cmdlet Library is available. Please go to 'http://go.microsoft.com/fwlink/?LinkId=528947' to download the latest version.

Running cmdlet version: 5.0.8231.1004 Latest cmdlet version: 5.0.8328.1155

If you elect to use an earlier version library, use this procedure to disable the CM update check, which allows Discovery to proceed without issues.

**Procedure**

1. Log into the SCCM console as an administrator.
2. Open the menu from the upper left corner of the console.
3. Select **Connect via Windows PowerShell**.
4. Run one of these commands to disable the update check:
   - **Per-user**: `Set-CMCmdletUpdateCheck -CurrentUser -IsUpdateCheckEnabled 0`
   - **Per-system**: `Set-CMCmdletUpdateCheck -System -IsUpdateCheckEnabled 0`

```
Important: The per-system cmdlet must run in an elevated Windows PowerShell session.
```
5. Run the `Get-CMCmdletUpdateCheck` command to refresh the console and check the settings.
6. Ensure that the value of the `IsEnabled` configuration variable has changed to `False`.
   This indicates that the warning for an out of date cmdlet library is disabled for the users specified.
7. To re-enable the update check, run the `-IsUpdateCheckEnabled 1` command for either the current user or for the system.

**Configure the MID Server for SCCM activities**

To use a MID Server with Microsoft System Center Configuration Management (SCCM) activities, configure it to communicate with the SCCM server.

**Before you begin**

Role required: admin

**Procedure**

1. In the navigation filter, enter `cmdb_ci_dns_name.list`.
2. Click **New**.
3. Enter the fully-qualified domain name (FQDN) of the SCCM server in the **Name** field.
4. Right-click in the form header and select **Save**.
5. In the **IP Address** related list, click **New**.
6. In the **IP Address** field, enter the IP address of the SCCM server.
7. In the **Nic** field, select **eth0** or your preferred network interface controller.
8. Leave the **Netmask** field blank.
9. Click **Submit**.

**Create Connection and Credential alias for SCCM deployments**

Microsoft System Center Configuration Manager (SCCM) requires the appropriate credentials to deploy applications using the Client Software Distribution application.

**Before you begin**
Role required: sn_client_sf_dist.csd_admin or admin

**About this task**
Client software distribution requires Windows credentials that have administrative rights on the SCCM server.

**Procedure**
1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Click **New**.
3. On the form, fill in the fields.

**Connection & Credential Aliases form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the alias. For example, CSD Alias.</td>
</tr>
<tr>
<td>ID</td>
<td>System generated unique ID.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record.</td>
</tr>
<tr>
<td>Type</td>
<td>Alias type. Select <strong>Connection and Credential</strong>.</td>
</tr>
<tr>
<td>Connection type</td>
<td>Connection type. Select <strong>Basic</strong>.</td>
</tr>
<tr>
<td>Support Multiple Active Connections</td>
<td>Option to specify if the alias supports multiple active connections.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default Retry Policy</td>
<td>Default retry policy associated with <strong>Connection Alias</strong>.</td>
</tr>
<tr>
<td>Configuration Template</td>
<td>Template that defines the inputs required to set up the spoke.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**.

5. Click the **Create New Connection & Credential** related link.

6. On the form, fill in the fields.

**Create Connection and Credential form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCCM Server Instance Name</td>
<td>Name to uniquely identify the SCCM server.</td>
</tr>
<tr>
<td>Host</td>
<td>Fully qualified domain name of the target host where the SCCM server is installed.</td>
</tr>
<tr>
<td>Credential Name</td>
<td>Credential record associated with the connection and credential alias.</td>
</tr>
<tr>
<td>User Name</td>
<td>User name with access to the target Windows host.</td>
</tr>
<tr>
<td>Password</td>
<td>Password for the account.</td>
</tr>
</tbody>
</table>

7. Click **Create**.

**Results**

Connection record and SCCM Server Instance are created and associated with the connection and credential alias.

**Retrieve SCCM data for client software distribution**

Retrieve the collections and the list of applications available for deployment from your SCCM servers.

**Before you begin**

**Role required:** sn_client_sf_dist.csd_admin or admin

Before starting this procedure:
• Set up your Microsoft System Center Configuration Manager (SCCM) server, create the applications and collections, and configure the deployments you need. For information, see your SCCM documentation.

• **Configure a user** with the Application Deployment Manager role on the SCCM server.

• Set up the MID Server to communicate with the SCCM server.

• Add Powershell credentials to the ServiceNow Credentials [discovery_credentials] table for the SCCM user who has the Application Deployment Manager role.

**About this task**
To populate the Client Software Distribution application with SCCM data:

**Procedure**

1. Navigate to **Client Software Distribution > SCCM > SCCM Server Instance**.
2. Click **New**.
3. In the SCCM Server Instance form, identify the server by name and select the connection and credential alias.

   - **Note:** Leave the **Fully qualified domain name** field empty.
4. Click **Submit**.
   The new SCCM server appears in the list.
5. Open the new SCCM record and click **Discover now** under **Related links**.
   The system runs the Discover SCCM flow that retrieves the application, collection, and deployment data from the SCCM server.
SCCM server Discovery for client software distribution

Discovery flow populates ServiceNow tables with collection, application, and deployment data retrieved from SCCM servers.

Users run the **Discover SCCM** flow from an **SCCM Server Instance** record to populate the following ServiceNow tables:

### SCCM data populated in ServiceNow tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCCM Application [sn_client_sf_dist_sccm_application]</td>
<td>• name</td>
</tr>
<tr>
<td></td>
<td>• publisher</td>
</tr>
<tr>
<td></td>
<td>• version</td>
</tr>
<tr>
<td></td>
<td>• model</td>
</tr>
<tr>
<td></td>
<td>• sccm_server</td>
</tr>
<tr>
<td>SCCM Collection [sn_client_sf_dist_sccm_collection]</td>
<td>• name</td>
</tr>
<tr>
<td></td>
<td>• type</td>
</tr>
<tr>
<td></td>
<td>• sccm_server</td>
</tr>
<tr>
<td>SCCM Deployment [sn_client_sf_dist_sccm_deployment]</td>
<td>• application</td>
</tr>
<tr>
<td></td>
<td>• collection</td>
</tr>
<tr>
<td></td>
<td>• type</td>
</tr>
</tbody>
</table>

⚠️ **Note:** For details about the actions used in this flow to extract data from an SCCM server, see Microsoft SCCM spoke.

### Set up a software model for an SCCM application

Using the applications discovered on the SCCM server, set up a software model used by the Software Asset Management application to manage licenses.

**Before you begin**

Role required: sn_client_sf_dist.csd_admin or admin

Before creating software models, you must discover the applications available for deployment on the SCCM server. See Retrieve SCCM data for client software distribution for details.
About this task
You can link an SCCM application to an existing software model or create a new model.

Procedure
1. Navigate to Client Software Distribution > SCCM > SCCM Applications. A list of applications discovered on the SCCM server appears.
2. Open an SCCM application record.
3. To link to an existing model, click the magnifying glass icon in the Model field and select a model from the list.

4. To create a model, click Create Software Model under Related Links.
   a. Complete the software model fields. See for details.
   b. Click Submit. The view returns to the SCCM Applications form.

Define an SCCM configuration
To create catalog items for SCCM software deployment or to configure your instance to revoke software through SCCM, you must first associate that software with a collection through an SCCM configuration.

Before you begin
Before you create an SCCM configuration record, make sure you have discovered the SCCM applications, collections, and deployments and set up the necessary software models.

Role required: sn_client_sf_dist.csd_admin or admin
About this task
The SCCM configuration process associates software with SCCM collections. To deploy software from an SCCM server, the user or device must be a member of an SCCM collection associated with an install deployment. Client Software Distribution (CSD) allows you to revoke unentitled software using an SCCM server when that software can be removed using an uninstall collection. Users requesting revokable software from the Service Catalog also have the ability to define lease start and stop dates and request lease extensions.

SCCM table references

Procedure
1. Navigate to Client Software Distribution > SCCM > SCCM Applications.
2. Open an application that has a configured software model.
3. Under Related Links, click Create Software Configuration.
4. Complete the form, using the fields in the table.
### SCCM configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Recognizable name for this SCCM software configuration.</td>
</tr>
<tr>
<td>SCCM application</td>
<td>Name of an application hosted on the SCCM server.</td>
</tr>
<tr>
<td>SCCM collection</td>
<td>Name of the collection associated with the <strong>install</strong> deployment for the selected application on the SCCM server. Only those collections associated with the application are available for selection.</td>
</tr>
<tr>
<td>SCCM uninstall collection</td>
<td>Name of the collection associated with the <strong>uninstall</strong> deployment for the selected application on the SCCM server. You must specify an uninstall collection to:</td>
</tr>
<tr>
<td></td>
<td>- Define a lease end date for deployed software.</td>
</tr>
<tr>
<td></td>
<td>- Allow lease extensions.</td>
</tr>
<tr>
<td></td>
<td>- Revoke software from a user’s machine.</td>
</tr>
<tr>
<td>Discovery model</td>
<td>Discovery model that links the unentitled software installation with the SCCM configuration. From the SCCM configuration record, Client Software Distribution can determine</td>
</tr>
</tbody>
</table>
Field | Description
---|---
| which collection to use to revoke the software. Unentitled software is software found on the user's machine that the user is not entitled to use.

Create a catalog item for an SCCM application

Create a catalog item for an application you want to offer for distribution from the service catalog using the applications discovered on the SCCM server.

**Before you begin**

Role required: sn_client_sf_dist.csd_admin or admin

Before creating a catalog item, you must link the application to a software model and create at least one software configuration.

**Procedure**

1. Navigate to **Client Software Distribution > SCCM > SCCM Applications**. A list of applications discovered on the SCCM server appears.
2. Open a record for an SCCM application.
3. Under **Related Links**, click **Create Catalog Item**. A new SCCM Application Catalog Item record appears with preconfigured information.
4. Add price information and complete the following fields added to the Client Software Distribution Catalog Item \[sn_client_sf_dist_cat_item\] table by the Client Software Distribution plugin:

### SCCM fields in the catalog item form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skip approval (skip_approval)</td>
<td>Check box that allows skipping approval for this item by the requester's manager when a user orders it from the service catalog. Use this field in conjunction with the <strong>Order on behalf of</strong> field to ensure that software ordered by a logged in user on behalf of another user is subject to approval. By default, this check box is cleared, requiring manager approval for all new catalog items.</td>
</tr>
<tr>
<td>Note:</td>
<td>There are two levels of approval possible. By default, all category items require group approval for items in excess of $1000. If that approval is given or skipped, the system evaluates the <strong>Skip approval</strong> check box to determine if the software item requires approval by the requester's manager.</td>
</tr>
<tr>
<td>Check license compliance (check_license_compliance)</td>
<td>Check box that forces the system to determine if deploying this item is allowed under the current license.</td>
</tr>
<tr>
<td>Order on behalf of</td>
<td>Check box that allows the logged-in user to order this software from the service catalog for another user. This permits service desk personnel to order SCCM deployments for other users in the system. By default, this feature is enabled. To prevent unauthorized users from ordering software, ensure that approvals are required for this type of deployment by clearing the <strong>Skip approval</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>If an approval is required for software ordered on behalf of a user, the system automatically sends an approval request to the manager of the user receiving the software. The approval</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>is skipped if the requestor is the named user's manager.</td>
<td></td>
</tr>
<tr>
<td>Software items requested from the service catalog on behalf of a different user require the following information:</td>
<td></td>
</tr>
<tr>
<td>• <strong>User</strong>: User selected for deployment. This field is automatically populated with the name of the logged in user. You can select another user from the list.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Device to install this software on</strong>: Device belonging to the selected user on which to deploy the software. Only devices belonging to that user appear in the choice list.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Lease start</strong>: Date and time to deploy the software. This is the start time for the lease. A lease can be open-ended or have a lease end time.</td>
<td></td>
</tr>
<tr>
<td>SCCM configuration</td>
<td>Name of the SCCM configuration record for this application. This record defines the collection and uninstall collection for this application. This configuration is required for all deployments, revocations, and leases performed by the SCCM server.</td>
</tr>
</tbody>
</table>

5. If the catalog item requires approval because of cost, be sure to configure an approval group in the **Approved By Group** related list. By default, the Service Catalog Request flow runs when an item costing more than $1000 is ordered and looks for an appropriate approval group. If no approval group is configured for the item, this flow skips approval altogether and ends. The system then runs the Order Client Software flow, which evaluates the **Skip approval** check box to determine if approval by the requester's manager is required.

6. Click **Update**.
   The view returns to the SCCM Applications list.

7. To see all client software distribution (CSD) catalog items, navigate to **Client Software Distribution > Maintain Items > Software Items**.
SCCM deployment process

Order an SCCM application from a client software distribution (CSD) catalog item in the service catalog triggers the Order Client Software flow.

This process deploys an SCCM application to a user or device through a service catalog order:

1. If the **Skip approval** check box is cleared in the software catalog item, the Order Client Software flow sends the catalog request to the requesting user's manager for approval.

2. If the **Check license compliance** check box is selected in the software catalog item, the flow performs a software license check. If there is no license available, the flow creates a catalog task to procure more licenses and assigns the task to the CSD Administrators group.

3. The Order Client Software flow triggers the Deploy SCCM Application flow as a subflow. This subflow adds either the user or the device to the SCCM collection using the Add to User Collection or Add to Device Collection actions in the Microsoft SCCM spoke.

4. If the software configuration specifies **SCCM uninstall collection** in the software catalog item, the Deploy SCCM Application subflow checks if the user or device exists in the uninstall collection. The flow uses the Is Device in Collection or Is User in Collection in the Microsoft SCCM spoke. If the user or device exists in the uninstall collection, the flow removes the device or user. The subflow uses the Remove from Device Collection or Remove from User Collection action in the Microsoft SCCM spoke before adding it to the SCCM install collection.

Client software distribution validation process

After SCCM deploys software to a target computer, client software distribution (CSD) detects the installation and validates its status.

Client software distribution uses the following methods for detecting software installed on the target machine:

- **Discovery**: CSD is configured to leverage Discovery to detect software installations. You can run Discovery manually at any time, or by a scheduled job.

- **Microsoft SCCM Integration**: You can import SCCM data into the CMDB using the features in the Integration - Microsoft SCCM plugin if Discovery is not active on the instance.
The instance uses the data gathered by Discovery or the SCCM integration plugin to populate the Software Installation [cmdb_sam_sw_install] table. To validate installations using this data, CSD runs a scheduled job called Reconcile Requested Software that uses CSD property settings. This process reconciles the software installation data accumulated in the CMDB and makes these status updates:

- **Not installed** to **Installed**: The user has installed the requested software within the time limit configured in the `sn_client_sf_dist.softwareInstallExpDays` property.
- **Not installed** to **Status check expired**: The time limit has expired for the user to install the requested software. The system stops checking for installation when the time limit expires.

**SCCM software revocation**

Revoke software without any user interaction using Microsoft System Center Configuration Manager (SCCM) if the software configuration specifies an SCCM uninstall collection, even if the software was installed by some other process or user.

**Revoke software deployed through the service catalog**

Software deployed by SCCM can be revoked, but only when the status of software is **Installed** and the application associated with the software configuration has an uninstall collection configured.

**Before you begin**

- Create an **SCCM configuration record** for the application that names an appropriate uninstall collection.
- Associate the **CSD catalog item** for the application with the SCCM configuration that specifies the uninstall collection.

Role required: `sn_client_sf_dist.csd_admin` or `admin`

A subflow called **Revoke SCCM Application** moves either the user or the device from its respective collection and adds it to the appropriate uninstall collection. When SCCM performs an internal policy check and finds the user or device in the uninstall collection, SCCM removes the related software package from the client computer.

**Procedure**

1. Navigate to **Client Software Distribution > Reports > Requested Software**.
2. Open the record for the SCCM software package you want to revoke.
The package must have a **Status** of **Installed** to be revocable.

3. **Under Related Links**, click **Revoke software**.

This action runs the Revoke Client Software flow, which triggers the Revoke SCCM Application subflow that moves the user or device from the install collection to the uninstall collection. When SCCM performs an internal policy check and finds the user or device in the uninstall collection, SCCM removes the related software package from the client computer.

**Revoke unentitled software**

Revoke software using Microsoft System Center Configuration Manager (SCCM) that a user is not entitled to use even if the software was installed by some other process or user.

**Before you begin**

To revoke software using SCCM, you must create an **SCCM configuration record** for the application, in which the appropriate software Discovery model is defined. See **Software discovery models**.

**Role required**: sn_client_sf_dist.csd_admin or admin

Client Software Distribution (CSD) uses **Software Asset Management** to identify unentitled software installations. Discovery detects the software on the user's machine, and SAM determines if the user or device is entitled to use that software. This might include software that was not installed through a catalog request or software that the user installed without approval. If the software installation's Discovery model is associated with an SCCM software configuration that has an uninstall collection defined, then an administrator can use CSD to revoke that software from the user's machine without involving the user.

**Procedure**

1. **Navigate to Client Software Distribution > Reports > Installed Software Not Entitled**.
2. Select the record for the installation that has unentitled users.
3. **Under Related Links**, click **Revoke software**.

This action runs the Revoke Client Software flow, which triggers the Revoke SCCM Application subflow that moves the user or device from the install collection to the uninstall collection. When SCCM performs an internal policy check and finds the user or device in the uninstall collection, SCCM removes the related software package from the client computer.
check and finds the user or device in the uninstall collection, SCCM removes the related software package from the client computer.

**SCCM software revocation flow**

The Revoke SCCM Application flow moves a user or device from an install collection to an uninstall collection to revoke software installed from Microsoft System Center Configuration Manager (SCCM).

For the revocation subflow to run, the software package must have a status of Installed and must be pre-configured for an appropriate uninstall collection. See [Revoke software deployed through the service catalog](#) for configuration instructions. When an administrator initiates the revocation process, the system launches the Revoke SCCM Application subflow to move the user or device collection associated with installation to the appropriate SCCM uninstall collection. When the SCCM server performs a policy check, it finds the additions to the user or device uninstall collection and revokes the software package associated with that collection.

The subflow employs two custom actions in the Microsoft SCCM spoke, Remove from User Collection and Remove from Device Collection, to remove either the user or the device from its original collection. The subflow then adds the user or device to the appropriate uninstall collection on the SCCM server with the Add to User Collection or Add to Device Collection activity.

ℹ️ **Note:** This subflow is triggered by the Revoke Client Software subflow.
Client software distribution dashboard

The CSD dashboard provides a collection of visual reports for the Client Software Distribution application.

CSD dashboard

To access the CSD dashboard, navigate to Client Software Distribution > Requested Software > Dashboard.

Sample report from CSD dashboard

Client software distribution reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Tasks</td>
<td>Displays all open tasks grouped by the requested item's stage value.</td>
</tr>
<tr>
<td></td>
<td>• Type: List reports</td>
</tr>
<tr>
<td></td>
<td>• Table: Catalog Task [sc_task]</td>
</tr>
<tr>
<td>Top 10 Applications Installed</td>
<td>Displays the top 10 applications installed by request count.</td>
</tr>
<tr>
<td></td>
<td>• Type: Bar chart</td>
</tr>
<tr>
<td></td>
<td>• Table: Requested Software [sn_client_sf_dist_req_software]</td>
</tr>
<tr>
<td>Total Software Request Item</td>
<td>Displays the total software items requested each month.</td>
</tr>
<tr>
<td>Item Over Time</td>
<td>• Type: Line chart</td>
</tr>
<tr>
<td></td>
<td>• Table: Requested Software [sn_client_sf_dist_req_software]</td>
</tr>
</tbody>
</table>
Client software distribution reports (continued)

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requests Completed Report</td>
<td>Displays the total of software requests completed each month.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Line chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Requested Software [sn_client_sf_dist_req_software]</td>
</tr>
<tr>
<td>Installed Software Not Entitled</td>
<td>Displays installed software that users or devices are not entitled to use. This can be software deployed through CSD or by another process that does not comply with licensing. This report is on a Software Asset Management table.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: List reports</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Software Installation [cmdb_sam_sw_install]</td>
</tr>
<tr>
<td>Software Installation Status Report</td>
<td>Displays the count of requested software, grouped by installation status, for each month.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Line chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Requested Software [sn_client_sf_dist_req_software]</td>
</tr>
<tr>
<td>Software Requested Item Stage Report</td>
<td>Displays the sum of all requested items, grouped by the requested item’s stage, for each month.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Line chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Requested Software [sn_client_sf_dist_req_software]</td>
</tr>
<tr>
<td>License Counts Available</td>
<td>Displays the license counts for all available applications.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: List reports</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: SCCM Application Catalog Item [sn_client_sf_dist_sccm_app_cat_item]</td>
</tr>
</tbody>
</table>

Usage Overview dashboard

Navigate to **Client Software Distribution > Usage Overview** to view the current transaction count for your instance.

Client software distribution extension framework

Client software distribution (CSD) provides built-in extension points for integrating a ServiceNow instance with client software distribution providers, such as Casper, Altiris, or LANDesk.
CAUTION: The use of CSD extension points is an advanced procedure intended for use by experienced Now Platform developers only. Instructions for customizing your instance to deploy and revoke software from a software distribution provider can be found in the CSD Extension Implementation Guide.

Configure client software distribution providers

Identify the provider and specify the flows, subflows, and extension points for a customized software distribution process.

Before you begin

Perform the development tasks described in the CSD Extension Implementation Guide before attempting this procedure.

Role required: sn_client_sf_dist.csd_admin, admin

Procedure

1. Navigate to **Client Software Distribution > Extensions > Providers**.
2. Click **New**.
3. Complete the form using the fields in the table.

![Client Software Distribution Provider - Casper](image)

Client software distribution provider fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name of the provider.</td>
</tr>
<tr>
<td>Provider server</td>
<td>Table name of the provider server. You must create this table as an extension of the Configuration Item [cmdb_ci] table. For example, you might call your table Casper Server Instance [cmdb_ci_casper_server_instance].</td>
</tr>
<tr>
<td>Discover And Store SCCM Data subflow</td>
<td>Subflow that discovers the provider server and returns the data from that server back to the instance. This is</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Software configuration</td>
<td>Table name of the software configuration for this provider. You create this table as an extension of the Client Software Distribution Software Configuration [sn_client_sf_dist_software_config] table. For example, you might create a table called Casper Software Configuration [sn_client_sf_dist_casper_sf_config].</td>
</tr>
<tr>
<td>Deployment extension key</td>
<td>The <strong>SetDeploymentData</strong> key provided with CSD. This key sets up the data for the software ordering and deployment flow.</td>
</tr>
<tr>
<td>Deploy Client Software flow</td>
<td>Flow that deploys software from the provider server. This is the flow you created with custom activities that tells the provider where to deploy an application requested from the service catalog.</td>
</tr>
<tr>
<td>Revocation extension key</td>
<td>The <strong>SetRevocationData</strong> key provided with CSD. This key sets up the data for installation revocation.</td>
</tr>
<tr>
<td>Revoke SCCM Application subflow</td>
<td>Subflow that revokes an installation from a provider server. This is the subflow you created with custom activities that tells the provider which application to remove from a device.</td>
</tr>
</tbody>
</table>

**Client software distribution extension keys**

Client software distribution (CSD) extension keys allow you to customize the deployment and revocation of software from distribution providers.

These pre-defined keys allow you to generate input variables for flows that deploy and revoke software from external distribution providers:
• **SetDeploymentData**: Sets the software order information and generates the input variables for the deployment flow.

• **SetRevocationData**: Generates the input variables for the revocation flow.

• **CheckRevocable**: Specifies the conditions that determine if an installation can be revoked. If the software configuration associated with the installed software allows uninstallation, the installed software can be revoked.

**Client software distribution extension points**

The client software distribution (CSD) extension points create the customization code for the specific provider and the extension keys.

The purpose of the extension points is to associate extension keys with a specific provider, and then create a script that sets input variables for your custom deployment and revocation flows. Another extension point script tells CSD if the provider has the capability to revoke software. If this is the case, CSD enables the UI action that triggers revocation from the provider.

**SetDeploymentData**

The script associated with this extension key must set the `csdExtensionResult` object with these attributes:

- **deploymentWorkflowInputs**: Object that specifies the deployment flow input variables.
- **softwareModel**: Software model sys_id.
- **deploymentType**: An integer. Use 1 for deployment to a user and 2 for deployment to a device.
- **softwareApplication**: Software application sys_id.

**CheckRevocable**

The script associated with this extension key gets the input parameter `csdExtensionInputs.softwareConfiguration`, which is a Client Software Distribution record in the Software Configuration [sn_client_sf_dist_software_config] table. All providers' software configurations are extended from this table, but may have different attributes.

This script must set the `csdExtensionResult` object to **true** or **false**, depending on whether the software configuration specifies uninstallation.

**SetRevocationData**

The script associated with this extension key gets the input parameter `csdExtensionInputs.softwareConfiguration`, which is a Client Software Distribution
record in the Software Configuration [sn_client_sf_dist_software_config] table. All providers' software configurations are extended from this table, but may have different attributes.

The script must set the `csdExtensionResult` object with these attributes:

- **revocationWorkflowInput**: Object that specifies the revocation flow input variables.
- **softwareModel**: Software model sys_id.
- **deploymentType**: An integer. Use 1 for deployment to a user and 2 for deployment to a device.

### Interaction Management

Interactions are a centralized location for all communication channels in the platform. Each interaction represents a request for assistance through a given channel, for example, a call or a chat.

The Now Platform offers several forms of queueing and communication management, but each system is tightly coupled to the specific area. Interactions offer an alternative, flexible, and more extensible option so that each product area can use the same framework.

### Activate the interaction management system

An administrator can activate the Interaction Logging, Routing, and Queueing plugin (com.glide.interaction) to access the functionality.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the Interaction Logging, Routing, and Queueing plugin plugin (com.glide.interaction) using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   ! **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

### Components installed with Interaction Management

Several types of components are installed with activation of the Interaction Logging, Routing, and Queueing plugin, including tables and user roles.

   ! **Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

#### Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interaction Administrator [interaction_admin]</td>
<td>Configure interactions for users.</td>
<td>• interaction_agent</td>
</tr>
<tr>
<td>Interaction Agent [interaction_agent]</td>
<td>Create and edit interactions. Transfer interactions to different agents or queues.</td>
<td>None</td>
</tr>
</tbody>
</table>

#### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interaction [interaction]</td>
<td>Table for all interaction records.</td>
</tr>
<tr>
<td>Interaction JSON blob [interaction_json_blob]</td>
<td>List of records that store context information for each interaction.</td>
</tr>
<tr>
<td>Interaction related record [interaction_related_record]</td>
<td>List of related records that have been associated with an interaction.</td>
</tr>
</tbody>
</table>
Interaction configuration overview

Configure the behavior of an interaction by determining the routine behavior for each state that the interaction goes through during the life cycle.

Interaction framework

Configure each of the following interaction components to determine the behavior and life cycle.

- Lists: Configure the interaction list view. You can also extend the interaction table.
- Forms: Configure the form view to tailor interactions for each application.

Interaction states

States determine the behavior for interactions. For each state of the interaction life cycle, you determine which routine actions to perform. For example, the on Created state would have a script that creates an interaction and then adds the end user as the 'opened for'. The script then sends a message to the end user to let them know that the interaction has been opened.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>An interaction is inserted into the interaction table.</td>
</tr>
<tr>
<td>On Hold</td>
<td>The interaction is waiting for assignment.</td>
</tr>
<tr>
<td>Work In Progress</td>
<td>An agent accepts an unassigned interaction.</td>
</tr>
<tr>
<td>Wrap Up</td>
<td>This state indicates that the agent has completed a conversation with a customer and is wrapping up the interaction.</td>
</tr>
<tr>
<td></td>
<td>This state is available if an interaction wrap up configuration has been created for the specific type of interaction and that configuration is active.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Interaction wrap up.</td>
</tr>
<tr>
<td>Closed Complete</td>
<td>The agent or consumer intentionally closes the interaction.</td>
</tr>
<tr>
<td>Closed Abandoned</td>
<td>The interaction is closed because the consumer disconnects or is unresponsive.</td>
</tr>
</tbody>
</table>
Interaction context and channel metadata

Context and channel metadata are document ID fields included as part of interactions. Both types of records store information about the interaction.

**Context**

Context for an interaction tracks the information for an interaction, such as the initial question, asset tagging, or device location. Context records are stored on the interaction_json_blob table by default, however you can use any table to store a context record.

**Channel metadata**

Channel metadata contains the information needed to interact with the channel on which communication is happening on, for example, the chat or phone channels. Channel metadata can be free-form JSON or a reference to another record.

Create an interaction

Most interaction creation takes place in other applications as interactions are merely a method of controlling channels. However, if needed you can create an interaction from the Interaction application.

**Before you begin**

Role required: interaction_agent

**Procedure**

1. Navigate to Interaction > All.
2. Click New.
3. In the Type field, enter the way the interaction began. For example, chat, phone, or walk-up.
4. In the Opened for field, type the name of the user starting the interaction.
5. Include any additional information in the short description and the work notes fields.
6. Click Submit.

**What to do next**

View any incidents opened by the same user by clicking the Use the Incidents by Same Caller related list.
Associate a record with an interaction

As an agent, you might need to create a record on another table to work on an interaction. You can associate the record with the interaction.

Before you begin
Role required: interaction_agent

Procedure
1. Navigate to Interaction > Assigned to me.
2. Open the interaction you want to associate with another record.
3. In the form header, click Associate Record.
4. In the ID of related record field, click the search icon.
5. From the Document Table list, select the table you want to associate a record from.
6. From the Document field, click the search icon.
7. Select an existing record from the list, or click New to create a record.
8. Click OK.
9. Click Submit.

Results
The associated record appears in the Related Tasks related list for the interaction.

Interaction wrap up

Interaction wrap up provides agents with a brief wrap-up period at the end of customer conversations. Agents can use this time to complete their work before moving on to assist other customers.

Interaction wrap up is a feature available for all types of interactions. When enabled, an interaction record moves from the Work In Progress to the Wrap Up state at the end of a customer conversation. This brief, configurable period enables agents to complete tasks such as posting work notes and updating record information before moving on to other work items.

While in the Wrap Up state, an agent’s capacity is not reduced until the state of the interaction moves to Closed Complete.

Note: The interaction wrap up feature works with multiple types of communication channels. This feature supports a chat and messaging interactions base system.
Configuring interaction wrap up

Users with the system administrator role create an interaction wrap up configuration for the desired communication channel. Creating a configuration automatically enables the feature and the Wrap Up state for interactions that match the configuration settings.

The interaction wrap up configuration includes the following information:

- The selected communication channel.
- Additional conditions that apply to the interaction records included in the configuration.
- Whether wrap up is automatically ended by the system and, if automatically ended the duration of the wrap up period.
- Whether a countdown timer that displays the wrap up duration is shown to agents in CSM Configurable Workspace.

The interaction wrap up configuration adds the Wrap Up state to the State field on the Interaction record. For more information about the wrap up state, see Interaction states.

Starting wrap up

The wrap up period begins when either the agent or the customer ends a conversation. The system then does the following:

- Moves the state of the interaction from Work in Progress to Wrap Up.
- Starts a countdown timer for the wrap up duration period.

Manually ending wrap up

Ending the wrap up period can be performed manually by the agent or automatically by the system.

Agents can end the wrap up by clicking End Wrap Up on the Interaction record, which moves the interaction from Wrap Up to Closed Complete.

Agents can also end the wrap up period by closing the interaction record tab.

- If the interaction is in the Wrap Up state, closing the tab ends the wrap up period and moves the interaction to Closed Complete. The system displays a message to the user about ending the wrap up period.
- If the interaction is in the Work in Progress state, closing the tab skips the wrap up period and moves the interaction to Closed Complete.
Automatically ending wrap up
If an agent has not already ended wrap up, the system can automatically end
the wrap up period after a set period of. Automatic wrap up must be enabled in
the interaction wrap up configuration.

• The system starts the wrap up duration timer when the wrap up period starts.
• When the wrap up duration timer reaches zero, the system ends wrap up and
changes the state from Wrap Up to Closed Complete.
• The system sets the System wrap up field on the Interaction record to True.

⚠️ Note: Agents can manually end the wrap up period even if automatic
wrap up is enabled.

Interaction form
The Interaction form displays information about a customer interaction.

The interaction form includes the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically assigned interaction number.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of customer interaction, such as a chat or phone call.</td>
</tr>
<tr>
<td>Account</td>
<td>The name of the customer contact's company. This field is filled in</td>
</tr>
<tr>
<td></td>
<td>automatically if the information is available in the contact record.</td>
</tr>
<tr>
<td>Contact</td>
<td>The name of the customer contact.</td>
</tr>
<tr>
<td>Consumer</td>
<td>The name of the consumer.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the interaction. For more information, see Interaction</td>
</tr>
<tr>
<td></td>
<td>states.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The name of the assigned user.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the customer issue.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Work notes</td>
<td>Records information about the interaction and the work being done to resolve the customer issue.</td>
</tr>
</tbody>
</table>
| Wrap up duration      | If using the Interaction wrap up feature, the system administrator can configure the Interaction form and add the **Wrap up duration** field. This field records the length of time that the Interaction record spends in the Wrap Up state. This is a read-only field. If a duration is not calculated, this field is set to 0. Duration is calculated as the time an interaction is in the Wrap Up state before moving to either Closed Complete or Closed Abandoned.  

  **Note:** If an agent closes the tab and ends the interaction, the wrap up duration is recorded as 0 seconds. |
| System wrap up        | If using the Interaction wrap up feature, the system administrator can configure the Interaction form and add the **System wrap up** field.  

The system determines if the interaction wrap up was performed manually by an agent (by clicking **End Wrap Up**) or automatically by the system and sets this field accordingly.  

- **Set to True** when automatic wrap up is enabled and the system moves an interaction from the Wrap Up state to either Closed Complete or Closed Abandoned at the end of the wrap up duration.  
- **Set to False** when an agent manually wraps up an interaction. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The default value for this field is false.</td>
</tr>
</tbody>
</table>

**Interaction wrap up timer**

The interaction wrap up timer displays a countdown of the wrap up duration period in CSM Configurable Workspace.

The system administrator can configure the display of the wrap up timer by enabling the **Show duration to agent** field on the Interaction Wrap Up Configuration form.

The read-only timer appears in an interaction record's secondary values. Depending on the configuration of the secondary values, these values can be displayed either in the form header or in the contextual side panel.

**Note:** The interaction wrap up timer works in both CSM Configurable Workspace and CSM Agent Workspace but the timer display is only available in CSM Configurable Workspace.

The timer counts down the amount of time specified in the **Duration in seconds** field on the Interaction Wrap Up Configuration form. The background color of the timer changes as it counts down the duration.

<table>
<thead>
<tr>
<th>Timer color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Time remaining is between 100% to 50% of duration.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Time remaining is between 50% and 25% of duration.</td>
</tr>
<tr>
<td>Orange</td>
<td>Time remaining is between 25% and 0% of duration.</td>
</tr>
<tr>
<td>Red</td>
<td>When the timer reaches 0.00, the display turns red and then disappears. The system updates the state of the interaction record to Closed Complete.</td>
</tr>
</tbody>
</table>

**Interaction wrap up scheduled job**

The interaction wrap up feature includes a scheduled job to close any interactions in the Wrap Up state that were not closed either manually by an agent or automatically by the system.

Ending the wrap up period is typically performed in the following ways:
• Manually by the agent.
• Automatically by the system, if the Enforce wrap up duration setting is enabled in the interaction wrap up configuration.
• By closing the workspace tab.

While most interaction records are automatically closed when the configured wrap up period ends, the interaction wrap up feature also includes a scheduled job to close any remaining records. For example, if the Enforce wrap up duration setting is not enabled in the configuration and agents close interactions by closing the browser, these interactions can remain in the Wrap Up state.

The Fallback Timeout for Interactions in Wrap Up scheduled job functions as a fail-safe method for closing interaction records that remain in the Wrap Up state. This scheduled job:

• Evaluates interaction records in the Wrap Up state.
• Closes those records that have been in the Wrap Up state longer than the time specified in the Max Wrap Up system property.

The Max Wrap Up system property (com.glide.interaction.max_wrapup_duration) defines the length of time that an interaction record can be in the Wrap Up state. The default value for this property is 15 minutes.

The time value set in the Max Wrap Up system property must be greater than the time value set in the Enforce wrap up duration field on the Interaction Wrap Up Configuration form.

The default run interval for this scheduled job is five minutes. The system administrator can configure this time interval.

⚠️ Note: This scheduled job is inactive by default.

Create an interaction wrap up configuration

Create a configuration for each type of interaction that uses the interaction wrap up feature.

Before you begin
Role required: admin

About this task
Creating a configuration automatically enables the interaction wrap up feature and adds the Wrap Up state for interactions that match the configuration settings.
The Interaction > Wrap Up module includes a list of wrap up configuration records. These configurations are stored in the Interaction Wrap Up Configuration (interaction_wrap_up_configuration) table.

Procedure
2. Click New.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the interaction wrap up configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates whether the configuration is active. The default value is true.</td>
</tr>
<tr>
<td>Table</td>
<td>Read only. The table that stores the interaction records to which this configuration applies.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Use the condition builder to select the conditions that apply to the interaction records included in this configuration.</td>
</tr>
<tr>
<td>Enforce wrap up duration</td>
<td>Enables the system to automatically end the wrap up period. The default value is false. If enabled, the system automatically ends the wrap up period at the end of the wrap up duration (set in the Duration in seconds field) and moves the state of the interaction record from Wrap Up to Closed Complete.</td>
</tr>
<tr>
<td>Duration in seconds</td>
<td>The duration of the wrap up period. The system displays this field when you enable the Enforce wrap up duration field.</td>
</tr>
</tbody>
</table>

• The default value is 60 seconds.
• The value must be greater than 0.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show duration to agent</td>
<td>Enables a duration countdown timer for the agent. The default value is false. The system displays this field when you enable the Enforce wrap up duration field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The interaction wrap up timer works in both CSM Configurable Workspace and CSM Agent Workspace but the timer display is only available in CSM Configurable Workspace.</td>
</tr>
<tr>
<td>Order</td>
<td>The order of the configuration, which is used in evaluation processing of wrap up configuration records. If there are multiple records, the lower order number takes precedence over higher numbers. The default value is 100.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Knowledge Management**

The ServiceNow® Knowledge Management (KM) application enables the sharing of information in knowledge bases. These knowledge bases contain articles that provide users with information such as self-help, troubleshooting, and task resolution.

Knowledge Management has significantly changed with Knowledge v3, which is enabled by default for all instances starting with the Fuji release.

The Knowledge Management Service Portal enables users to access a portal view of knowledge bases and articles. It is available by default for new customers on the Madrid and later releases. If required, existing and upgrade customers can activate the Knowledge Management Service Portal plugin.

Knowledge Management supports processes for creating, categorizing, reviewing, and approving articles. Users can search and browse articles as well as provide feedback.
To support multiple groups, knowledge bases can be assigned to individual managers. Separate workflows can be used for publishing and retiring articles, and separate access controls can be used to control reading and contributing.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Upgrade to Rome</td>
<td>• Video: Getting Started with Knowledge Management v3</td>
<td>• Select user criteria for a knowledge base</td>
</tr>
<tr>
<td>• Knowledge Management v3</td>
<td>• Knowledge Management setup guide for admins</td>
<td>• Video: How to Control Knowledge Access Through User Criteria</td>
</tr>
<tr>
<td>• Knowledge Management v3 homepage</td>
<td>• Knowledge base setup guide for knowledge admins and managers</td>
<td>• Blog: Article Security and Filtering in Knowledge v3</td>
</tr>
<tr>
<td>• Search using Knowledge Management v3</td>
<td>• Domain separation</td>
<td>• Define a knowledge article category</td>
</tr>
<tr>
<td>• Translation management</td>
<td>• Translation management</td>
<td>• Add a knowledge article to featured content</td>
</tr>
<tr>
<td>• Knowledge demand insights</td>
<td>• Knowledge article authoring in Microsoft Word</td>
<td>• Configure Knowledge Management</td>
</tr>
<tr>
<td>• Self-Service Analytics</td>
<td>• Machine learning solutions for Knowledge Management</td>
<td></td>
</tr>
<tr>
<td>• Knowledge article authoring in Microsoft Word</td>
<td>• Migrate to Knowledge Management v3</td>
<td></td>
</tr>
<tr>
<td>• Machine learning solutions for Knowledge Management</td>
<td>• Video: Migrating from Knowledge Management v2 to v3</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Migrate</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Knowledge Management roles</td>
<td>• Video: Migrating from Knowledge Management v2 to v3</td>
<td>• Knowledge Management FAQs</td>
</tr>
<tr>
<td>• Knowledge Management guide for users</td>
<td>• Video: Managing Article-Level Access Controls During Migration from KM v2 to v3</td>
<td>• Search the Known Error Portal for known error articles</td>
</tr>
<tr>
<td>• Use knowledge on mobile devices</td>
<td>• Blog: All things Upgrade considered on Knowledge v2 to v3</td>
<td>• Duplicate knowledge article numbers</td>
</tr>
<tr>
<td>• Article versioning</td>
<td></td>
<td>• Ask or answer questions in the Knowledge Management community</td>
</tr>
<tr>
<td>• Article subscriptions</td>
<td></td>
<td>• Contact Customer Service and Support</td>
</tr>
<tr>
<td>• Knowledge Management Service Portal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Now Mobile for Knowledge Management</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Additional plugins for Knowledge Management

After Knowledge Management is activated, you can activate additional plugins that provide access to various additional Knowledge Management features.

You must have the admin role to activate these additional plugins. For details, see Activate a plugin.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Management Core [com.glideapp.knowledge]</td>
<td>Installs the core Knowledge Management items used to allow other Knowledge-related plugins to work, such as Knowledge V3, Knowledge Advanced, and Knowledge Service Portal. This plugin is activated by default.</td>
</tr>
<tr>
<td>Knowledge Management Advanced Installer [com.snc.knowledge_advanced.installer]</td>
<td>Installs the Knowledge Management Advanced plugin. Activating/upgrading to this plugin validates the knowledge articles and knowledge bases to make sure that the Knowledge Advanced plugin can be successfully installed. If validation fails, check the Plugin Activation logs and follow instructions given to fix any errors. Once you fix all the issues, re-run this plugin.</td>
</tr>
<tr>
<td>Knowledge Management Advanced [com.snc.knowledge_advanced]</td>
<td>Adds advanced features to Knowledge Management such as version control and subscriptions. This plugin requires that all knowledge bases are version Knowledge V3. Use the Knowledge Management Advanced Installer plugin to activate this plugin.</td>
</tr>
<tr>
<td>Predictive Intelligence for Knowledge Management [com.snc.knowledge_ml]</td>
<td>Provides various Knowledge Management capabilities driven by machine-learning solutions. For example, capabilities such as similar articles and knowledge demand insights. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
</tr>
<tr>
<td>Plugin</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Performance Analytics - Content Pack - Knowledge Management</td>
<td>Enables the Performance Analytics content pack for the Analytics and Reporting Knowledge Management Solution. Activation of this plugin on production instances might require a separate Performance Analytics license. Contact ServiceNow for details.</td>
</tr>
<tr>
<td>[com.snc.pa.knowledge_v2]</td>
<td></td>
</tr>
<tr>
<td>Knowledge Management V3</td>
<td>Enables support for Knowledge Management V3. Activate this plugin when you upgrade from Eureka or earlier versions.</td>
</tr>
<tr>
<td>[com.snc.knowledge3]</td>
<td></td>
</tr>
<tr>
<td>I18N: Knowledge Management Internationalization Plugin v2</td>
<td>Helps create and maintain translations of an article in various languages in a way that is easy to manage translations while authoring as well as viewing articles. Activating internationalization plugins for any of the available languages automatically activates this plugin.</td>
</tr>
<tr>
<td>[com.glideapp.knowledge.i18n2]</td>
<td></td>
</tr>
<tr>
<td>Knowledge Document</td>
<td>Adds knowledge-based functionalities to the Managed Documents plugin. You can create a knowledge article from a document or update a knowledge document to a newer revision.</td>
</tr>
<tr>
<td>[com.snc.knowledge_document]</td>
<td></td>
</tr>
<tr>
<td>Knowledge Management - External Content Integration</td>
<td>Adds external content search capabilities to the Knowledge Management application. Once configured, this feature creates a copy of the external content on ServiceNow as knowledge articles, and then indexes the articles through Zing Search. You must have appropriate reuse and copy privileges before you configure an external source to be searchable using this feature.</td>
</tr>
<tr>
<td>[com.snc.knowledge.external_integration]</td>
<td></td>
</tr>
<tr>
<td>Knowledge Management Wiki Support</td>
<td>Enables support for wiki type Knowledge articles.</td>
</tr>
</tbody>
</table>

**Note:** When you install and activate the Predictive Intelligence for Knowledge Management plugin (com.snc.knowledge_ml), the Predictive Intelligence for Contextual Search plugin (com.snc.contextual_search_ml) is also activated.
### Components installed with Knowledge Management Core

Several types of components are installed with activation of the Knowledge Management Core plugin (com.glideapp.knowledge) including user roles and tables.

ℹ️ **Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available.

#### Roles installed

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge [knowledge]</td>
<td>Users with the knowledge role can contribute to the default knowledge base and access the Knowledge application menu. The knowledge role is a fulfiller role and not a requester role.</td>
<td>None.</td>
</tr>
<tr>
<td>Knowledge administrator [knowledge_admin]</td>
<td>Knowledge administrator can create new knowledge bases and manage all knowledge bases.</td>
<td>Knowledge administrator contains the knowledge base</td>
</tr>
</tbody>
</table>
### Role Description

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge manager</td>
<td>Knowledge managers perform administrative functions for knowledge bases they manage such as defining categories, pinning important articles, and approving changes to articles. Users selected as managers of a knowledge base receive this role automatically.</td>
<td>Knowledge manager role.</td>
</tr>
</tbody>
</table>

**Tables installed**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSM Table Map</td>
<td>Stores information about the mapping source and target table. For example, while creating a knowledge article from a customer service case, the source table would be customer service case [sn_customerservice_case] and the target table would be Knowledge [kb_knowledge].</td>
</tr>
<tr>
<td>CSM Field Map</td>
<td>Stores information about the fields that are mapped from the source table to the target table in a given table map (CSM Table Map). For example, when creating a knowledge article from a customer service case [sn_customerservice_case], the source field value would be case.short description and the target field value would be knowledge.short description.</td>
</tr>
<tr>
<td>Related Articles</td>
<td>Stores information about related knowledge articles.</td>
</tr>
<tr>
<td>Related Catalog Items</td>
<td>Stores information about related catalog items.</td>
</tr>
<tr>
<td>Knowledge Category</td>
<td>Stores the category of a knowledge article.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>[kb_category]</td>
<td>Knowledge Feedback Task [kb_feedback_task] Stores information about the feedback task on a knowledge article.</td>
</tr>
<tr>
<td>[kb_feedback]</td>
<td>Knowledge Feedback [kb_feedback] Stores information about flagged comments on a knowledge article.</td>
</tr>
<tr>
<td>[kb_keyword]</td>
<td>Knowledge Keyword [kb_keyword] Stores information about keywords associated with the featured knowledge articles on the homepage of the Knowledge Management Service Portal.</td>
</tr>
<tr>
<td>[kb_knowledge_keyword]</td>
<td>Knowledge keyword [kb_knowledge_keyword] Stores information related to mapping between knowledge articles and keywords.</td>
</tr>
<tr>
<td>[kb_knowledge]</td>
<td>Knowledge [kb_knowledge] Stores knowledge articles organized by knowledge base and category, as well as featured content and popular articles.</td>
</tr>
<tr>
<td>[kb_uc_can_contribute_mtom]</td>
<td>Who Can Contribute To Knowledge Base [kb_uc_can_contribute_mtom] Stores information about who can read and write to a knowledge base.</td>
</tr>
<tr>
<td>[kb_uc_can_read_mtom]</td>
<td>Who Can Read Knowledge Base [kb_uc_can_read_mtom] Stores information about who can read a knowledge base.</td>
</tr>
<tr>
<td>[kb_use]</td>
<td>Knowledge Use [kb_use] Stores information about the number of times articles are viewed and the number of times knowledge articles are used in an incident, problem, or case.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Knowledge Related to Products [m2m_kb_ci]</td>
<td>Stores information about the products related to knowledge articles.</td>
</tr>
<tr>
<td>Knowledge Comment Likes [m2m_kb_feedback_likes]</td>
<td>Stores information about users who like a comment in knowledge feedback.</td>
</tr>
<tr>
<td>Knowledge Applied to Tasks [m2m_kb_task]</td>
<td>Stores information about articles attached to tasks (incident, case, or problem).</td>
</tr>
</tbody>
</table>

**Knowledge Management roles**

Certain roles are required to use Knowledge Management functionality.

<table>
<thead>
<tr>
<th>Knowledge Management roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Role</strong></td>
<td>**Description</td>
</tr>
<tr>
<td>knowledge</td>
<td>Users with the knowledge role can contribute to the default knowledge base and access the Knowledge application menu.</td>
</tr>
<tr>
<td></td>
<td>The knowledge role is fulfiller role and not a requester role.</td>
</tr>
<tr>
<td>knowledge_manager</td>
<td>Knowledge managers perform administrative functions for knowledge bases they manage such as defining categories, pinning important articles, and approving changes to articles. Users selected as managers of a knowledge base receive this role automatically.</td>
</tr>
<tr>
<td>knowledge_admin</td>
<td>Knowledge administrators can create new knowledge bases and manage all knowledge bases.</td>
</tr>
<tr>
<td>knowledge_coach</td>
<td>Knowledge coaches can perform AQI surveys on articles, write, edit and review knowledge articles, and coach the team on best practices.</td>
</tr>
<tr>
<td>knowledge_domain_expert</td>
<td>Knowledge domain experts perform AQI surveys on articles and can write, edit and review knowledge management articles. A knowledge domain expert can create new knowledge bases.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc. in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
## Knowledge Management roles (continued)

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>domain expert</td>
<td>keeps track of the health of knowledge base.</td>
</tr>
<tr>
<td>admin</td>
<td>administrators can configure knowledge workflows, set knowledge properties, and manage knowledge forms and homepages.</td>
</tr>
<tr>
<td>knowledge_group_manager</td>
<td>Knowledge group managers can add or remove members in ownership groups managed by them. They cannot change the manager assigned in their groups. The manager can only be reassigned by the knowledge administrator. Knowledge group managers are assigned feedback tasks by default. They can reassign tasks to another group member, or group members can assign a feedback task to themselves.</td>
</tr>
<tr>
<td>knowledge_group_member</td>
<td>Knowledge group members are part of an ownership group that can be associated to knowledge articles. They can approve knowledge articles, assign feedback tasks to themselves and work on them as well as edit any knowledge articles that their ownership group is assigned to.</td>
</tr>
<tr>
<td>kcs_candidate</td>
<td>KCS candidates understand the basics of KCS.</td>
</tr>
<tr>
<td>kcs_contributor</td>
<td>KCS contributors have the capability and authority to create or validate knowledge articles in their product areas without being reviewed by a knowledge coach.</td>
</tr>
<tr>
<td>kcs_publisher</td>
<td>KCS publishers are authors who are well versed in KCS standards and create more external-facing articles.</td>
</tr>
</tbody>
</table>

The kcs_candidate, kcs_contributor, and kcs_publisher roles also include the knowledge role. For more information about these KCS-related roles, see [KCS v6 Practices Guide](#).
Knowledge Management properties

As an administrator, you can configure the look and functionality of many knowledge base features with Knowledge Management properties.

You can access Knowledge Management properties by navigating to Knowledge > Administration > Properties.

Knowledge portal properties

Knowledge portal properties control the look and functionality of the legacy portal page. This portal page lists recent knowledge articles and their publishing dates, organized by topic.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of columns on Knowledge portal pages</td>
<td>Set the number of columns for arranging topics on the knowledge portal.</td>
</tr>
<tr>
<td>(glide.knowman.columns)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note: This property applies only to Knowledge Management v2 pages. This property is not supported on Knowledge Management v3 pages.</td>
</tr>
<tr>
<td>Maximum number of articles per content block on the home page (glide.knowman.content_block_limit)</td>
<td>Enter the maximum number of articles to display in the Most Useful and Most Viewed sections of the knowledge homepage.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Note:</strong> This property applies only to Knowledge Management v2 pages. This property is not supported on Knowledge Management v3 pages.</td>
<td></td>
</tr>
</tbody>
</table>

Omit empty Knowledge topics and categories ([glide.knowman.show_only_populated])

Select the check box to display topic sections only if there are articles for the topic. Clear the check box to show all topic sections, even those with no assigned articles.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> This property does not apply to the New category. This property applies only to the default knowledge base and the legacy knowledge portal. Knowledge Management v3 articles do not specify a topic. Therefore, this property applies only to Knowledge v2 pages. This property is not supported on Knowledge Management v3 pages.</td>
<td></td>
</tr>
</tbody>
</table>
| Show Knowledge section descriptions (**glide.knowman.show_descriptions**) | Select the check box to display topic descriptions in the knowledge portal. To enter these descriptions:  
1. Edit an existing knowledge article.  
2. Right-click the Topic field label |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>and choose Show Choice List.</td>
<td>3. Open the record for the topic name and enter the description into the Hint field.</td>
</tr>
<tr>
<td>Clear the check box to omit</td>
<td>section descriptions from the knowledge portal.</td>
</tr>
<tr>
<td>Note: This property applies</td>
<td>only to Knowledge Management v2 pages. This property is not supported on Knowledge Management v3 pages.</td>
</tr>
<tr>
<td>Number of Knowledge Base</td>
<td>Set the maximum number of articles per topic for the knowledge portal. The specific articles shown depends on the Knowledge section sort field property setting.</td>
</tr>
<tr>
<td>items to preview in a section</td>
<td>(glide.knowman.section_limit)</td>
</tr>
<tr>
<td>© 2021 ServiceNow, Inc. All</td>
<td>rights reserved.</td>
</tr>
<tr>
<td>rights reserved.</td>
<td>ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Note:</strong> This property applies only to Knowledge Management v2 pages. This property is not supported on Knowledge Management v3 pages.</td>
<td></td>
</tr>
</tbody>
</table>

Knowledge section sort field (**glide.knowman.section_sort**)  
Select the default order for articles within each topic section on the knowledge portal.

- **Published:** uses the date published.
- **View count:** uses the number of times articles have been viewed during the period specified in the Number of days used when summing article views property (applicable only in Knowledge Management v2.)
- **Alphabetically:** uses the first letter of the article title (Short description field).
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> This property applies only to Knowledge Management v2 pages. This property is not supported on Knowledge Management v3 pages.</td>
<td></td>
</tr>
<tr>
<td>Knowledge Base section sort direction (<a href="#">glide.knowman.section_sort_direction</a>)</td>
<td>Select the order, ascending or descending, in which articles are listed within each topic section on the knowledge portal. The value used for sorting is set in the Knowledge section sort field property. <strong>Note:</strong> This property applies only to Knowledge Management v2 pages. This property is not supported on Knowledge Management v3 pages.</td>
</tr>
<tr>
<td>Show unpublished articles in Knowledge Base portal and topic lists (<a href="#">glide.knowman.show_unpublished</a>)</td>
<td>Select the check box to allow users to see unpublished articles in the knowledge portal and knowledge</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>search results. Use the subsequent List of roles... properties to designated which users can see articles in various unpublished states. If this is not selected, users with appropriate roles can access unpublished articles through other modules of the Knowledge Base application.</td>
<td>List of roles (comma separated) that can see articles in the Review workflow state in the Knowledge portal and Topic list (glide.knowman.section.view_roles.review) Enter role names exactly as they appear in User Administration &gt; Roles. If Show unpublished articles in Knowledge Base portal and topic lists is selected, users with these roles see articles in the Review workflow state in the knowledge portal, in the topic list that appears when they click a topic title on the portal, and in knowledge search results.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>List of roles (comma separated) that can see articles in the Draft workflow state in the Knowledge portal and Topic list (glide.knowman.section.view_roles.draft)</td>
<td>Enter role names exactly as they appear in User Administration &gt; Roles. If Show unpublished articles in Knowledge Base portal and topic lists is selected, users with these roles see articles in the Draft workflow state in the knowledge portal, in the topic list that appears when they click a topic title on the portal, and in knowledge search results.</td>
</tr>
<tr>
<td>Define roles that can view articles in other/custom workflow states (glide.knowman.section.view_roles.stagesAndRoles)</td>
<td>Enter role names exactly as they appear in User Administration &gt; Roles. If Show unpublished articles in Knowledge Base portal and topic lists is selected, define the custom field and role as workflow state: [roles];. The users with these roles see articles in the custom workflow state on the knowledge portal.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The property is not applicable to the retired knowledge articles. Only users with the knowledge_admin role can view retired articles.</td>
<td></td>
</tr>
<tr>
<td>The number of articles that are asynchronously loaded when scrolling down in the new search results page <em>(glide.knowman.search.articles_per_page)</em></td>
<td>Enter the number of articles to be displayed during a search.</td>
</tr>
<tr>
<td>Note: This property applies only to Knowledge Management v3 pages. This property is not supported on Knowledge Management v2 pages.</td>
<td></td>
</tr>
<tr>
<td>Show only Knowledge topic titles on portal page (no article links) <em>(glide.knowman.home_titlesonly)</em></td>
<td>Select the check box to omit all article titles from the knowledge portal and show only the topic names. Users can click the topic title to see the list of related articles.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Number of days (integer, default 30) used when summing article views <em>(glide.knowman.view_age.days)</em></td>
<td>Enter a number of days to consider when calculating view count. The View count field in the Knowledge form will be updated periodically to reflect the view count based on this property. For example, if you enter 60, the view count is the total number of views in the past 60 days. Enter 0 to have ServiceNow consider all views, regardless of date.</td>
</tr>
</tbody>
</table>

*Note: This property applies only to Knowledge Management v2 pages. This property is not supported on Knowledge Management v3 pages.*
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>

**Note:** If you edit this property, run the Count Knowledge Use scheduled job to see the changes immediately. By default, the Count Knowledge Use scheduled job runs daily and updates the view counts on the knowledge articles. To view the scheduled job, navigate to **System Scheduler > Scheduled Jobs > Scheduled Jobs**.

New customers as of the Paris release will not have access to the View count property and Count Knowledge scheduled job. Existing customers prior to the Paris release can
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>continue to use the property and scheduled job.</td>
<td></td>
</tr>
<tr>
<td>If you set the property value to 0:</td>
<td></td>
</tr>
<tr>
<td>• The Count Knowledge scheduled job does not run.</td>
<td></td>
</tr>
<tr>
<td>• The View count of an article contains the accumulated value of total count.</td>
<td></td>
</tr>
<tr>
<td>Automatically place cursor in Knowledge portal search box (<code>glide.knowman.portal_search_focus</code>)</td>
<td>Select the check box to have ServiceNow place the cursor in the search field when a user opens the knowledge portal. Clear the check box to have users click in the search field before entering a search term.</td>
</tr>
</tbody>
</table>

**Note:** This property applies only to Knowledge Management v2 pages. This property is not supported on Knowledge Management v3 pages.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Session level cache in &quot;Most useful article&quot;.</td>
<td>Set the property to True to enable session level cache in 'Most useful Articles' portal widget.</td>
</tr>
<tr>
<td><code>glide.knowman.use_session_cache_for_most_useful_articles</code></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties</td>
</tr>
</tbody>
</table>

**Knowledge search properties**

Knowledge search properties give you control over the search options available to users and the presentation of search results.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge search result order</td>
<td>Select the order for displaying search results:</td>
</tr>
<tr>
<td><code>glide.knowman.order.search</code></td>
<td>• <strong>Number of Views</strong>: orders search results based on the <strong>Number of days used when summing article views</strong> property.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Relevancy</strong>: orders search results based on content that is similar to the search term.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Last Modified</strong>: orders search results based on modification date.</td>
</tr>
<tr>
<td></td>
<td>This property is applicable for search within the Knowledge Management application and not the Now Platform global search.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search method used when searching Knowledge from a task or directly in the Knowledge Base</td>
<td>Select the search approach to use when the search term includes multiple words.</td>
</tr>
<tr>
<td><code>glide.knowman.search.operator</code></td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>OR query</td>
<td>returns articles that contain one word from the search term.</td>
</tr>
<tr>
<td>AND then OR query</td>
<td>first searches for articles that include all words in the search term (an AND query). If no matches are found, an OR query is performed.</td>
</tr>
<tr>
<td>Show author in knowledge search results</td>
<td>Select the check box to include the author of each article in knowledge search results. If the article versioning feature is enabled, articles with a version number less than or equal to 1.0 display Authored by &lt;name&gt; and articles with a version number greater than 1.0 display Revised by &lt;name&gt;.</td>
</tr>
<tr>
<td>Show last modified date and time in knowledge search results</td>
<td>Select the check box to include the date and time each article was last edited in knowledge search results.</td>
</tr>
<tr>
<td>Show publish date in knowledge search results</td>
<td>Select the check box to include the date each article was published in knowledge search results.</td>
</tr>
<tr>
<td>Show category in knowledge search results</td>
<td>Select the check box to include the category breadcrumbs of each article in knowledge search results.</td>
</tr>
<tr>
<td>Show number of views in knowledge search results</td>
<td>Select the check box to include the number of times each article was viewed in knowledge search results.</td>
</tr>
<tr>
<td>How to display attachments in Knowledge Search Results</td>
<td>Select the behavior of how the attachment is shown in the search results:</td>
</tr>
<tr>
<td>Show relevancy in knowledge search results</td>
<td>Select the check box to show how relevant each search result is based on the search string.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Relevancy value is only shown when knowledge block search result order property is set to Relevancy.</td>
<td>Define how many search results can be displayed when a knowledge block is searched for. By default, the minimum value is 6 and the maximum is 25.</td>
</tr>
<tr>
<td>Show number of knowledge blocks in the knowledge block search results when creating or updating a knowledge article (glide.knowman.add_blocks.search_results)</td>
<td>Select the check box to enable instant search for search results. The default is No.</td>
</tr>
<tr>
<td>Enable instant search results for knowledge (glide.knowman.search.instant_results)</td>
<td>Select the check box to display the knowledge base to which the knowledge base article belongs. For example, IT.</td>
</tr>
<tr>
<td>Show Knowledge Base name in Knowledge search results (glide.knowman.search.show_knowledgebase)</td>
<td>Select the check box to display the average star ratings for knowledge base articles. This property is applicable to the search results for knowledge articles that appear on the Knowledge Management Service Portal results page and service portal widgets such as Knowledge Featured Articles and Knowledge Most Viewed Articles. For more information, see Knowledge Management Service Portal results page features and Configure the page widget instance options.</td>
</tr>
<tr>
<td>Show average rating from knowledge search results (glide.knowman.search.show_rating)</td>
<td>Select the check box to display the article number for each article in the search result. If the article versioning feature is enabled, the article number and the version number are displayed for each article in the search results.</td>
</tr>
<tr>
<td>Show article number in knowledge search results (glide.knowman.search.show_article_number)</td>
<td>Set the property to the desired default language for searching articles.</td>
</tr>
<tr>
<td>Specify default language for searching articles (glide.knowman.search.default_language)</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable multi-language search</td>
<td>Set the property to <strong>True</strong> to enable search for multiple languages simultaneously.</td>
</tr>
</tbody>
</table>
| **(glide.knowman.enable_multi_language_search)**          | • Type: true | false  
• Default value: false  
• Location: System Properties  

**Note:** If this property is set to **True**, it overrides the setting for the **glide.knowman.search.default_language** property. |

| Maximum character limit for meta description used for SEO | Set the maximum number of characters used as meta description for SEO.                                                                                                                                 |
| **(glide.knowman.seo.pages.meta_description.length)**    | • Type: Integer  
• Default value: 100  
• Location: System Properties  

When you change the character limit, the meta description with the updated limit is only applied to articles published after the change was made. To apply the change to all existing published articles, run the **Populate Meta Description on KB Articles** fix script. |

**Knowledge article view properties**

Article view properties give you control over the meta data and rating options that appear with articles. They also enable you to grant access to individual feedback options based on user role.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show tasks to which an article has been recently attached</td>
<td>Select the check box to have article view include a list of tasks associated with the article. The list of associated tasks appears on the Most Recent Tasks widget on the article view page. The widget appears only when a task is attached to the article and this property is set to Yes. Knowledge articles can be attached to a task by clicking the <strong>Attach to Task</strong> button after searching from a form.</td>
</tr>
<tr>
<td>(glide.knowman.recent_tasks.display)</td>
<td></td>
</tr>
<tr>
<td>Number of attached tasks to display when viewing an article</td>
<td>Specify the maximum number of tasks to list in article view.</td>
</tr>
<tr>
<td>(glide.knowman.recent_tasks)</td>
<td></td>
</tr>
<tr>
<td>Show article rating section, which may optionally include yes/no rating,</td>
<td>Select the check box to display the rating options for users with specific roles. Clear this check box to omit the rating section for all users, regardless of role. The <strong>Feedback</strong> field is always displayed for all users.</td>
</tr>
<tr>
<td>star rating, and flagging options</td>
<td></td>
</tr>
<tr>
<td>(glide.knowman.show_rating_options)</td>
<td></td>
</tr>
<tr>
<td>List of roles (comma separated) that can see an article’s rating section</td>
<td>Enter role names exactly as they appear in <strong>User Administration &gt; Roles</strong>. If <strong>Show article rating section</strong> is selected, users with the roles listed here see the yes/no rating, star rating, and flagging options, according to related property settings. Be sure to include all roles that should be permitted to see any of these rating options. Separate properties enable you to identify specific roles for each option separately. All roles in those</td>
</tr>
<tr>
<td>which may optionally include yes/no rating, star rating, and flagging</td>
<td></td>
</tr>
<tr>
<td>option (glide.knowman.show_rating_options.roles)</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show the &quot;Was this article helpful?&quot; yes/no rating option.</td>
<td>Select the check box to display the &quot;Was this article helpful?&quot; rating to users with roles set in the associated property. This appears only if the Show article rating section property is selected.</td>
</tr>
<tr>
<td>(glide.knowman.show_yn_rating)</td>
<td></td>
</tr>
<tr>
<td>List of roles (comma separated) that can see yes/no &quot;Was this article</td>
<td>Enter role names exactly as they appear in User Administration &gt; Roles. If both Show article rating section and Show the &quot;Was this article helpful?&quot; properties are selected, users with the roles listed here see the &quot;Was this article helpful?&quot; rating in article view.</td>
</tr>
<tr>
<td>helpful?&quot; rating option.</td>
<td>All roles listed here must also be listed in the List of roles that can see an article’s rating section property.</td>
</tr>
<tr>
<td>(glide.knowman.show_yn_rating.roles)</td>
<td></td>
</tr>
<tr>
<td>Show &quot;Create Incident&quot; link</td>
<td>Select the Yes check box to display the Create Incident link.</td>
</tr>
<tr>
<td>(glide.knowman.create_incident_link.display)</td>
<td></td>
</tr>
<tr>
<td>URL used for the &quot;Create Incident&quot; link</td>
<td>Enter the URL for the page where users can create an incident only if the Show &quot;Create Incident&quot; link property is selected.</td>
</tr>
<tr>
<td>(glide.knowman.create_incident_link)</td>
<td>To find the URL, open the appropriate page, then right-click the header bar and choose Copy URL. Highlight the URL that appears and use the browser’s copy and paste feature to place it into this property field.</td>
</tr>
<tr>
<td>Show five-star rating option</td>
<td>Select the check box to display the five-star rating to users with roles set in the associated property. This appears only if the Show article rating section property is selected.</td>
</tr>
<tr>
<td>(glide.knowman.show_star_rating)</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>List of roles (comma separated) that can see five-star rating option</td>
<td>Enter role names exactly as they appear in User Administration &gt; Roles. If both Show article rating section and Show five-star rating option properties are selected, users with the roles listed here see the five-star rating option in article view. All roles listed here must also be listed in the List of roles that can see an article's rating section property.</td>
</tr>
<tr>
<td>glide.knowman.show_star_rating.roles</td>
<td></td>
</tr>
<tr>
<td>Show &quot;Flag Article&quot; option to identify incomplete/inaccurate articles</td>
<td>Select the check box to display the flag article option to users with roles set in the associated property. This appears only if the Show article rating section property is selected.</td>
</tr>
<tr>
<td>glide.knowman.show_flag</td>
<td></td>
</tr>
<tr>
<td>List of roles (comma separated) that can flag incomplete/inaccurate articles</td>
<td>Enter role names exactly as they appear in User Administration &gt; Roles. If both the Show article rating section and Show &quot;Flag Article&quot; option properties are selected, users with the roles listed here see the flag article option in article view. All roles listed here must also be listed in the List of roles that can see an article's rating section property.</td>
</tr>
<tr>
<td>glide.knowman.show_flag.roles</td>
<td></td>
</tr>
<tr>
<td>Show user comments on knowledge articles (glide.knowman.show_user_feedback)</td>
<td>Select an option for showing user comments When article loads.</td>
</tr>
<tr>
<td>glide.knowman.show_user_feedback</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>When user clicks link to show comments, or Never for users with roles set in the associated property.</td>
<td>List of roles (comma separated) that can see user comments on an article <em>(glide.knowman.show_user_feedback.roles)</em> Enter role names exactly as they appear in User Administration &gt; Roles. If the Show user comments on knowledge articles property is selected, users with the roles listed here see user comments in article view.</td>
</tr>
<tr>
<td>Enter role names exactly as they appear in User Administration &gt; Roles.</td>
<td>Maximum number of user comments displayed on a knowledge article <em>(glide.knowman.feedback.display_threshold)</em> Set the maximum number of user comments to display. If no value is set, all comments are displayed. This property does not apply to live feed comments on the article view page.</td>
</tr>
<tr>
<td>Set the property to True to use live feed to manage and display feedback on knowledge articles.</td>
<td>Use Live Feed for Knowledge feedback <em>(glide.knowman.use_live_feed)</em> Type: true</td>
</tr>
</tbody>
</table>

### Knowledge homepage properties

Knowledge homepage properties control the featured content on the knowledge homepage.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display or hide the count of articles and questions in the Knowledge Homepage <em>(glide.knowman.show_number_on_homepage)</em></td>
<td>Select to display or hide the count of knowledge articles and questions on the Knowledge homepage.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Table title (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default keyword for getting pinned articles</td>
<td>Enter a default keyword for pinned articles. Articles pinned with the specified keyword appear in the Featured Content section of the knowledge homepage.</td>
</tr>
<tr>
<td>(glide.knowman.default_keyword)</td>
<td></td>
</tr>
<tr>
<td>Display or hide the count of articles and questions in the category and child categories</td>
<td>Select to display the count of articles and questions within each category, including subcategories, when browsing or searching knowledge bases.</td>
</tr>
<tr>
<td>(glide.knowman.show_number_on_categories)</td>
<td></td>
</tr>
<tr>
<td>Show Knowledge Home page when user has access to only one Knowledge Base</td>
<td>Select to display the Knowledge homepage when the current user has access to only one knowledge base.</td>
</tr>
<tr>
<td>(glide.knowman.show_home_if_one_kb)</td>
<td></td>
</tr>
<tr>
<td>Default header title for the pinned articles section on knowledge home pages</td>
<td>Enter a title for the Featured Content section of the knowledge homepage.</td>
</tr>
<tr>
<td>(glide.knowman.default_pinned_section_header_title)</td>
<td></td>
</tr>
</tbody>
</table>

### Other knowledge properties

Other knowledge properties let you control general knowledge management features.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When attaching an article to an incident, copy the content into this field (glide.knowman.attach.fields)</td>
<td>When a user searches knowledge as an incident, problem, or change to Task button for an article, the system copies the article number and content into the field specified in the Value column here. This field is generally Comments or Work notes.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use dot walking to copy the article content into related records.</td>
<td>If a specified field does not exist, that field is ignored. If the property has no value, comments is used.</td>
</tr>
</tbody>
</table>
| Displays a read-only article view page when articles are viewed from   | Displays a read-only article view page when knowledge articles are viewed from contextual search.  
| contextual search (glide.knowman.contextual_search.show_read_only_article) | • Type: true | false  
| • Default value: true                                                                                                         |
| Note: The glide.knowman.contextual_search.show_read_only_article property is activated by default. If the property isn’t available, add it manually and set its value to true to display read-only knowledge articles accessed from the contextual search. For more information, see Add a system property. |
| Knowledge Management logo to display if running out of the ServiceNow  | Click the reference lookup tool to be displayed on knowledge pages of the ServiceNow application from logo image selected here appears in a Management System site that includes knowledge pages. 
<p>| frames (glide.knowman.frameless_logo)                                   | You can also enter the Name of an image stored in the database to use that image.                                                                                                                            |
| Note: This property applies only to Knowledge v2 pages. This property is not supported on Knowledge v3 pages.                     |
| Hide the ‘Import’ functionality (button and drag-n-drop) for all users   | Select Yes to hide the Import Articles button to prevent users from importing articles to knowledge bases.                                                                                                     |
| (glide.knowman.import.hide_import_functionality)                        | If you have not yet migrated to Knowledge v3 and are using legacy Knowledge v2, you can configure the visibility of the Import Articles button to prevent users from importing articles to knowledge bases. |
| Show publish check box on the knowledge import pop-up                   | Select No to remove the Publish check box on the knowledge import form so that an article cannot be published as part of the import process.                                                                |
| (glide.knowman.import.show_publish_checkbox)                           | Select the Yes check box to use the submission workflow instead of the standard knowledge workflow. If this option is selected, each time |
| Use submission workflow (glide.knowman.submission.workflow)             | a new article is submitted, it goes through the specified submission workflow rather than the standard knowledge workflow.                                                                                  |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>from an incident or problem, the content is placed into a submission record instead of a draft article. Transforming knowledge submissions into articles follows a specific workflow.</td>
<td></td>
</tr>
<tr>
<td>The sys_id of the knowledge base when creating knowledge from task records (<a href="#">glide.knowman.task_kb</a>)</td>
<td>Enter the sys_id of the knowledge base to put new knowledge articles created from tasks in.</td>
</tr>
<tr>
<td>Before displaying the text of the article in search results or the article view, check field-level ACLs on appropriate field: kb_knowledge.text (HTML article) or kb_knowledge.wiki (wiki text article) (<a href="#">glide.knowman.text.check_can_read</a>)</td>
<td>Select this check box if users must have permission to view text fields on the <a href="#">kb_knowledge</a> table to read articles in search results.</td>
</tr>
<tr>
<td>Defines the number of results to be considered when building the search filters (<a href="#">glide.knowman.search.facet_depth</a>)</td>
<td>Define maximum number of knowledge considered from search results for:</td>
</tr>
<tr>
<td>• Type: string</td>
<td></td>
</tr>
<tr>
<td>• Default value: 300</td>
<td></td>
</tr>
<tr>
<td>• Location: System Properties</td>
<td></td>
</tr>
<tr>
<td>Send notification to approvers and authors in article approval workflow (<a href="#">glide.knowman.enable_approval_notification</a>)</td>
<td>Select this check box to send approval email notifications. By default, the property is enabled.</td>
</tr>
<tr>
<td>Allow articles in the global domain to be checked out or edited by users in another domain (<a href="#">glide.knowman.allow_edit_global_articles</a>)</td>
<td>Enter the value as true to enable checking out and editing global articles for users from a domain other than the global domain.</td>
</tr>
<tr>
<td>When showing a list of articles through the Knowledge portal (using the kb_list UI Page), remove articles the user cannot see before building the list (<a href="#">glide.knowman.list.filter</a>)</td>
<td>Enter the value as true to enable removal of articles that user cannot see before building the list in the knowledge portal.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create translation task when an article is published</td>
<td>Enter the value as <code>true</code> to enable translation tasks.</td>
</tr>
<tr>
<td>(<code>glide.knowman.translation.enable_translation_task</code>)</td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties</td>
</tr>
<tr>
<td>Note: When you enable this property, you can’t modify the knowledge base of existing articles.</td>
<td></td>
</tr>
<tr>
<td>Deny access to a knowledge base when either Can Read or Can Contribute user criteria list for the knowledge base isn’t specified</td>
<td>Enter the value as <code>true</code> to deny contribute access to a knowledge base when Can Contribute isn’t set and read access when Can Read isn’t set.</td>
</tr>
<tr>
<td>(<code>glide.knowman.block_access_with_no_user_criteria</code>)</td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties</td>
</tr>
<tr>
<td>Override contribute access based on Can Read and Cannot Read user criteria at article level</td>
<td>Enter the value as <code>true</code> to override contribute access to a knowledge article based on Can Read and Cannot Read user criteria at the article level.</td>
</tr>
<tr>
<td>(<code>glide.knowman.apply_article_read_criteria</code>)</td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties</td>
</tr>
<tr>
<td>Send email notifications on the first day of each month for articles expiring in the next month</td>
<td>Enter the value as <code>true</code> to send email notifications to a list of recipients about articles expiring each month. The recipients list depends on the ownership group and article versioning features.</td>
</tr>
<tr>
<td>(<code>glide.knowman.enable_article_expiry_notification</code>)</td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties</td>
</tr>
<tr>
<td>Determines whether to apply ACLs on the search results</td>
<td>Enter the value as <code>true</code> to apply knowledge article search results.</td>
</tr>
<tr>
<td>(<code>glide.knowman.search.apply_acls</code>)</td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Comma separated list of all domains of office365 online sites, in which the Knowledge management Word add-in will be available (<code>sn_km_word.glide.knowman.word.xframe</code>)</td>
<td>Enter a list of all the parent domains in the Microsoft Word Online application in which Knowledge Management - Add-in for Microsoft Word is embedded. Separate the domains with commas.</td>
</tr>
<tr>
<td>Download the original Word document from the article view page in a portal and Workspace. Enabling the property might affect the search relevancy of the article (<code>sn_km_word.glide.knowman.enable_document_download</code>)</td>
<td>Enter the value as <code>true</code> to download the original Word document from the knowledge article view page in a portal and Workspace.</td>
</tr>
<tr>
<td>Determines the duration required to capture the metrics (Article Views, Portal page views, and Portal searches). (<code>glide.knowman.usage_metrics_duration</code>)</td>
<td>Enter the value to change the duration to capture the knowledge usage metrics.</td>
</tr>
</tbody>
</table>

### Article versioning properties

The knowledge administrator can set knowledge properties that enable users to edit specific fields on published articles without creating new versions.

The article versioning feature requires the Knowledge Management Advanced plugin (com.snc.knowledge_advanced). For more information, see *Activate the Knowledge Management Advanced plugin*.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable article versioning feature (glide.knowman.versioning.enabled)</td>
<td>Select the check box to enable the article versioning feature.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: Knowledge &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td>Enable minor edits to a published article without creating a new version (glide.knowman.versioning.enable_minor_edits)</td>
<td>Select the check box to enable minor edits to published articles and associated attachments without creating a new version.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: Knowledge &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td>Note: This feature is available for the following users: the knowledge administrator, the knowledge base manager, and the knowledge base owner.</td>
<td></td>
</tr>
<tr>
<td>A comma-separated list of fields that can be edited on published articles without creating a new version (glide.knowman.versioning.minor_edit_fields)</td>
<td>Enter the fields in a comma-separated list that can be edited on published articles without creating a new version.</td>
</tr>
<tr>
<td></td>
<td>• Type: String</td>
</tr>
<tr>
<td></td>
<td>• Default value: valid_to</td>
</tr>
<tr>
<td></td>
<td>• Location: Knowledge &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td>You can also enter the property value attachments to add or remove any attachments associated with a knowledge article.</td>
<td></td>
</tr>
</tbody>
</table>
Knowledge subscription properties

The knowledge administrator can set configuration properties that enable users to subscribe to knowledge bases and knowledge articles.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable subscribe feature for KM (glide.knowman.enable_km_subscription)</td>
<td>Select the check box to enable the Knowledge subscription feature.</td>
</tr>
<tr>
<td>List of roles (comma-separated) who can have subscription feature (glide.knowman.enable_km_subscription.roles)</td>
<td>Enter the roles in a comma-separated list that can use the Knowledge subscription feature.</td>
</tr>
<tr>
<td>List of workflow states (comma-separated) that can have subscription feature (glide.knowman.enable_km_subscription.workflow_state)</td>
<td>Enter the workflow states for knowledge articles in a comma-separated list that users can subscribe to.</td>
</tr>
</tbody>
</table>
### Article quality index properties

The knowledge administrator can set the pass score for AQI reviews using the knowledge properties page.

**Properties for Article Quality Index**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Pass score for AQI reviews (glide.knowman.aqi_pass_score) | Set the pass score for AQI reviews.  
  - Type: Integer  
  - Default value: 70  
  - Range of values possible: 1-100 |
| List of article workflow states to perform AQI reviews (glide.knowman.aqi.article_workflow_states) | Enter the article workflow states, in a comma-separated list, where users can perform AQI reviews.  
  - Type: String  
  - Default value: draft, review, published |

### External Content Integration Properties

Administrators can configure the properties to add allowed content types and change the UI label for the external content integration feature.
## Properties for External Content Integration

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Maximum limit for total size of external content in Knowledge Management (in GB) (sn_km_intg.glide.knowman.external.max_content_size) | • Type: Integer  
• Default value: 2  
**Note:** This is a read-only field.                                                                                                                   |
| Maximum size of an external article including its attachments (in MB) (sn_km_intg.glide.knowman.external.max_article_size) | • Type: Integer  
• Default value: 8  
**Note:** This is a read-only field.                                                                                                                   |
| An editable, comma-separated list of allowed content types to be processed from the source system (sn_km_intg.glide.knowman.external.allow_content_types) | • Type: Comma separated  
• Default value: application/msword,application/vnd.openxmlformats-officedocument.wordprocessingml.document,application/vnd.ms-excel,application/vnd.openxmlformats-officedocument.spreadsheetml.sheet,application/vnd.ms-powerpoint,application/vnd.openxmlformats-officedocument.presentationml.presentation,application/pdf,text/plain,text/html,image/gif,image/jpeg,image/png  
• Other possible values: application/xml, video/mp4, audio/mpeg                                                                                     |
| List of content types not allowed to be processed from the source system (sn_km_intg.glide.knowman.external.reject_content_types) | • Type: Comma-separated  
• Default value: application/octet-stream,application/x-apple-diskimage,application/vnd.microsoft.portable-executable                                                                 |
| UI Label for indicating external articles in Search Results and Article View Pages (sn_km_intg.glide.knowman.external.ui_label_for_external_content) | • Type: String  
• Default value: External                                                                                                                          |

## Actionable Knowledge Feedback Properties

The Knowledge administrator can set configuration properties that would create actionable feedback tasks.
### Properties for Actionable Knowledge Feedback

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create actionable feedback task when an article is flagged.</td>
<td>Select the check box to enable actionable feedback task generation when an article is flagged for incorrect or inappropriate content.</td>
</tr>
</tbody>
</table>
| (glide.knowman.feedback.enable_actionable_feedback_for_flag)             | • Type: true | false  
• Default value: true  
• Location: Knowledge > Administration > Properties                                                                                                                                                        |
| Create actionable feedback task when an article is marked as not helpful | Select the check box to enable actionable feedback task generation when an article is marked as not helpful.                                                                                                  |
| (glide.knowman.feedback.enable_actionable_feedback_for_helpful)          | • Type: true | false  
• Default value: false  
• Location: Knowledge > Administration > Properties                                                                                                                                                        |
### Properties for Actionable Knowledge Feedback (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Create actionable feedback task when an article is rated at or lower than this value. 0 or no value indicates that actionable feedback tasks are not enabled for Rating type feedback *(glide.knowman.feedback.enable_actionable_feedback_for_rating)* | An actionable feedback task is created when an article is rated at or lower than this value. The article is rated on a scale of 1-5.  
- **Type:** Integer  
- **Default value:** none  
- **Location:** Knowledge > Administration > Properties |

### Group ownership properties

The knowledge administrator can set group ownership properties that enable the use of ownership groups for knowledge articles and decide who can edit and approve a published knowledge article.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable ownership group for Knowledge articles <em>(glide.knowman.ownership_group.enabled)</em></td>
<td>Select the check box to enable associating ownership groups with knowledge articles.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Retain contribute access for author or reviser of knowledge article linked to ownership group (glide.knowman.ownership_group.override)</td>
<td>Select the check box to enable the author and reviser of a knowledge article to retain contribute access to the article even when an ownership group is associated with the article.</td>
</tr>
</tbody>
</table>

**Note:** Once you have set this property to **true**, try not to change it to **false**. Before setting this property back to **false**, manually reassign all knowledge articles associated with any ownership group, close all article approvals sent to ownership groups, and resolve all open feedback tasks assigned to ownership groups.

- Type: true | false
- Default value: false
- Location: **Knowledge > Administration > Properties**
### Property

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow approval of self-authored article as ownership group member</td>
<td>Select the check box to allow ownership group members to approve self-authored articles for publication.</td>
</tr>
<tr>
<td>(glide.knowman.ownership_group.enable_self_approval)</td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: Knowledge &gt; Administration &gt; Properties</td>
</tr>
</tbody>
</table>

---

**Scoped knowledge bases**

To protect knowledge bases containing sensitive articles, use a scoped knowledge base. Even system administrators and knowledge administrators can’t administer scoped knowledge bases unless explicitly authorized through user criteria.

For example, say you have a knowledge article with sensitive payroll information that should be seen only by the Payroll department and not by a system administrator or knowledge administrator. You could create a knowledge article with the sensitive information in a scoped knowledge base within the Human Resources: Core application.

Only users with the admin role of an application and the knowledge_admin role can administer a scoped knowledge base. You control access to knowledge bases of an application with application administration enabled, such as HR, through the ACLs of the knowledge tables in the application instead of global ACLs. To define access to a scoped knowledge base, specify appropriate user criteria for users, including system administrators and knowledge administrators.

You can’t modify the scope of existing knowledge bases. They remain in the global scope. However, you can create a scoped knowledge base to protect sensitive knowledge articles.

To create a scoped knowledge base for an application, in addition to the knowledge_admin or admin role, you must have access to view and select that application in the application picker (see Application picker). For example, before you create a knowledge base in the Human Resources: Core application, you must select the Human Resources: Core application in the application picker, and then create the knowledge base. Then, when you create a knowledge base, on the Knowledge base form, the application scope of the knowledge base is set in the Application field.
Related information

- Create a knowledge base
- Select an application from the application picker
- Application administration
- Control access at the knowledge base level through user criteria

Knowledge Management setup guide for admins

Before users in your organization can start creating knowledge bases and knowledge articles, you must set up Knowledge Management. Work with stakeholders to define requirements for setting up Knowledge Management effectively to meet the needs of users.

Requirements

Role required: admin

Before you begin

Meet with the stakeholders

<table>
<thead>
<tr>
<th>Stakeholder</th>
<th>Responsibilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge manager</td>
<td>Defines and oversees the knowledge management processes for day-to-day operations related to content publishing and usage.</td>
</tr>
<tr>
<td>Knowledge admin</td>
<td>Configures advanced settings for specific Knowledge Management features</td>
</tr>
<tr>
<td>Knowledge coach</td>
<td>Enables users to adhere to content standards.</td>
</tr>
<tr>
<td>Knowledge domain expert</td>
<td>Provides domain knowledge expertise.</td>
</tr>
<tr>
<td>Version author</td>
<td>Contributor to a particular version of an article.</td>
</tr>
<tr>
<td>Content creators and reviewers</td>
<td>Create, review, and update articles in the knowledge bases.</td>
</tr>
<tr>
<td>Stakeholder</td>
<td>Responsibilities</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Community managers</td>
<td>Focus on the creation and curating of social content.</td>
</tr>
<tr>
<td>Line managers</td>
<td>Manage teams that create and use knowledge articles</td>
</tr>
</tbody>
</table>

With stakeholders, determine the following requirements

- Who are the consumers of the content in the knowledge bases?
- Who are the writers, editors, and managers for the knowledge base articles?
- What are the required workflows to publish and retire articles?
- What are the unique behaviors required for your knowledge management implementation? For example, should attachments appear in search results?
- Do you want to translate knowledge articles into other languages?

What to do

**Assign knowledge roles to users and groups**

Determine which Knowledge Management roles are appropriate for each user, and then assign those roles.

**Create custom Knowledge workflows**

If the default knowledge workflows for publishing and retiring knowledge articles are not appropriate for your knowledge bases, create custom workflows for those knowledge bases.

**Configure Knowledge properties**

If the default knowledge properties do not fulfill the requirements of users, reconfigure the properties as necessary.

**Activate support for other languages besides English**

If languages other than English must be supported, activate the Knowledge Management Internationalization plugins.

**Coordinate with knowledge managers for knowledge base setup**

Let knowledge managers and administrators know that they can start configuring their knowledge bases. For details, refer them to the Knowledge base setup guide for knowledge admins and managers.
Next steps
Depending on any other requirements for the knowledge bases, you may be asked to help with additional tasks, such as configuring knowledge homepages.

Using guided setup to implement Knowledge Management
Knowledge Management guided setup provides a sequence of tasks that help you configure Knowledge Management on your instance. To open Knowledge Management guided setup, navigate to Knowledge > Administration > Guided Setup.

For more information about using the guided setup interface, see Using guided setup.

Domain separation and Knowledge Management
Domain separation is supported in Knowledge Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Standard
• Includes Basic level support.
• Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
• The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see Application support for domain separation.

Overview
Domain separation works differently at different access levels of an application. In Knowledge Management, data, requester, and fulfiller access to knowledge bases are domain separated.

How domain separation works in Knowledge Management
In Knowledge Management, the following rules apply:
Data: At the data level of domain separation, data visibility is separated from one domain to another. Knowledge bases, user criteria, articles, categories, article feedback, article versions, article templates, and external sources are domain separated in the base system.

**Note:** The data in one domain cannot be seen in any other domain. For example, if you create a Knowledge Management article in a domain A using an article template which is not in domain A, the article will not be visible in domain A. Similarly, if you create a Knowledge Management article in the global domain using a template that is not in global, the article might not be visible in all the domains.

Requester: Requester activities are supported within tenant domains. Users can search, view, comment; and rate articles of their domain, any child domain, and global domains, if feedback is enabled and the knowledge base settings grant them read access to articles.

- Users in the global domain can access articles in all the domains if read access is granted at knowledge base and/or article level.
- Users in the parent domain can access articles in that domain, global, and all its child domains if read access is granted at knowledge base and/or article level.
- Users in the child domain can access articles in that domain and the global domain if read access is granted at knowledge base and/or article level.

Fulfiller: The application can be used by the Fulfiller within the tenant domains as a tenant domain-owned application. Users are allowed to author articles in knowledge bases of their domain, any child domain, and the global domain if the knowledge base has user criteria set up to grant contribute access.

- Articles are automatically saved to the user’s current domain when the article is created.
- If the `glide.knowman.allow_edit_global_articles` system property is enabled, users from a domain other than the global domain can check out and edit global articles. Otherwise, system administrators and users from a domain other than the global domain cannot check out global articles and are shown a warning message to that effect. Depending on their access, users can change their domain to the global domain to check out and edit the global articles.
- Domains of versioned articles will be maintained as per the latest article version’s domain. This includes updating the domain for `kb_version`, `kb_knowledge`, `kb_feedback`, and `sys_attachment` tables.

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• If domains contain another domain: If Domain A contains Domain B, users with access to Domain A can author articles in Domain B by toggling the domain scope. To learn more about toggling domain scope, see Visibility domains and Contains domains.

See Managing access to knowledge bases and knowledge articles to learn how to control contribute and read access to knowledge bases and knowledge articles.

Use cases
This image demonstrates a basic domain hierarchy that is available in the base system.

Requester use cases

<table>
<thead>
<tr>
<th>User domain</th>
<th>Knowledge base domain</th>
<th>Read user criteria domain</th>
<th>Article domain</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
<td>Global</td>
<td>Global</td>
<td>Global</td>
<td>Can view, comment, rate articles.</td>
</tr>
<tr>
<td>Parent domain (TOP)</td>
<td>Parent domain (TOP)</td>
<td>Parent domain (TOP)</td>
<td>Parent domain (TOP)</td>
<td></td>
</tr>
<tr>
<td>Child domain (TOP/ACME)</td>
<td>Child domain (TOP/ACME)</td>
<td>Child domain (TOP/ACME)</td>
<td>Child domain (TOP/ACME)</td>
<td></td>
</tr>
</tbody>
</table>
### Fulfiller use cases

<table>
<thead>
<tr>
<th>User domain</th>
<th>Knowledge base domain</th>
<th>Contribute user criteria domain</th>
<th>Article domain</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
<td>Global</td>
<td>Global</td>
<td>Global</td>
<td>Can author, update, view, comment, rate articles.</td>
</tr>
<tr>
<td>Parent domain (TOP)</td>
<td>Parent domain (TOP)</td>
<td>Parent domain (TOP)</td>
<td>Parent domain (TOP)</td>
<td></td>
</tr>
<tr>
<td>Child domain (TOP/ACME)</td>
<td>Child domain (TOP/ACME)</td>
<td>Child domain (TOP/ACME)</td>
<td>Child domain (TOP/ACME)</td>
<td></td>
</tr>
<tr>
<td>MSP domain (TOP/MSP)</td>
<td>MSP domain (TOP/MSP)</td>
<td>MSP domain (TOP/MSP)</td>
<td>MSP domain (TOP/MSP)</td>
<td></td>
</tr>
</tbody>
</table>
### Known Issues

- The following AQI tables are not domain separated:
  - AQI Checklist [kb_quality_checklist]
  - Checklist Question [kb_checklist_question]
  - Article Checklist Answer [kb_article_checklist_answer]

  **Note:** The Article Checklist Answer table does not contain the Order field. The application shows the list in a random order.

- Comment provided by a user on an article is stored in article’s domain instead of user domain.

### Related information

**Domain separation for service providers**

### Knowledge base setup guide for knowledge admins and managers

After basic Knowledge Management setup is completed, you can set up a knowledge base for users to create and publish knowledge articles.

Create multiple knowledge bases for different groups within your organization to share information within and between those groups. Create scoped knowledge bases to enable only application administrators to administer the knowledge bases and restrict unauthorized access to application-specific data.
Administrators create knowledge bases, and assign them to individual managers responsible for controlling the behavior and organization scheme of each knowledge base.

Each knowledge base contains knowledge articles that provide information for users, such as policy, release notes, or instructions for a task. Each knowledge base can also use a separate workflow for publishing and retiring articles.

**Requirements**

Role required: knowledge_administrator, knowledge_manager, or admin

**Before you begin**

Determine the following requirements for each knowledge base that you want to set up:

- Whether to create a scoped knowledge base? For more information, see [Scoped knowledge bases](#).
- Who are the knowledge base managers that are responsible for approving articles?
- Who are the users and contributors for that knowledge base? Access for these users is defined through user criteria.
- What are the categories to be used to classify articles? Will users be able to create categories?
- Will users of the knowledge base be able to create new content?

**What to do**

**Set up the knowledge base**

1. Create the knowledge base.
2. Set up which users can read, create, or edit knowledge articles by selecting user criteria for the knowledge base.
3. Define the approval process for articles using workflows.
4. Define the knowledge categories that are needed for organizing articles in the knowledge base.
5. If you want a custom knowledge homepage, ask your ServiceNow administrator to create it.
**Next steps**

Let users in your organization know that they can start creating and searching articles in the knowledge base. For details, refer users to the Knowledge Management guide for users.

If you have the knowledge_manager role, there are many other tasks that you can perform to maintain the knowledge base. You can pin articles so they are featured prominently in the search results and on homepages. You can also assign other users as managers of a knowledge base. For details, see Knowledge manager.

**Quick start tests for Knowledge Management**

Validate that Knowledge Management still works after you make any configuration change, such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Knowledge Management quick start tests require activating the Knowledge Management Core plugin (com.glideapp.knowledge), the Knowledge Management Advanced Installer plugin (com.snc.knowledge_advanced.installer), the Knowledge Blocks plugin (com.snc.knowledge_blocks), and the Customer Service Management Demo Data plugin (com.snc.customerservice.demo).

<table>
<thead>
<tr>
<th>KM: Knowledge Management test suite</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Test</strong></td>
</tr>
<tr>
<td>KM : Create KCS Template Article with Approval Publish workflow</td>
</tr>
<tr>
<td><strong>Note:</strong> Requires the Knowledge Management Advanced Installer plugin.</td>
</tr>
<tr>
<td>KM: Create MultiVersioned standard Article with approval publish workflow</td>
</tr>
</tbody>
</table>
## KM: Knowledge Management test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>KM: Article level subscription</td>
<td>Verify that users can subscribe to a knowledge article.</td>
<td>New York</td>
</tr>
<tr>
<td>KM: User criteria covering canRead and canContribute for KnowledgeBase and canRead at Article level</td>
<td>Verify the creation of canRead and canContribute user criteria for knowledge base and canRead user criteria for article.</td>
<td>Madrid</td>
</tr>
<tr>
<td>KM: Create a KCS article from a case</td>
<td>Verify the creation of a KCS article from a case.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

*Note: Requires the Knowledge Management Advanced Installer plugin.*
**KM: Knowledge Management test suite (continued)**

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>KM: Knowledge Base Level Subscriptions</td>
<td>Verify that users can subscribe to a Knowledge Base.</td>
<td>New York</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires the Knowledge Management Advanced Installer plugin.</td>
<td></td>
</tr>
<tr>
<td>KM: AQI</td>
<td>Verify the creation, assignment, and review of an AQI checklist.</td>
<td>New York</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires the Knowledge Management Advanced Installer plugin.</td>
<td></td>
</tr>
<tr>
<td>KM: Requestor performs search, view the article, provide feedback (Helpful No with Feedback Task)</td>
<td>Verify the search request, review, provision of feedback as not helpful, and creation of a feedback task for an article on the Knowledge Management Service Portal.</td>
<td>New York</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires the Knowledge Management Advanced Installer plugin.</td>
<td></td>
</tr>
<tr>
<td>KM: Create and edit an article from Feedback Task form</td>
<td>Confirm the availability of the <strong>Create Article</strong> and <strong>Edit Article</strong> buttons on a Knowledge Feedback Task form.</td>
<td>New York</td>
</tr>
</tbody>
</table>
### KM: Knowledge Management test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>KM: Search for pinned articles and checking the highest click rank</td>
<td>Verify the search request and that the click rank value of a pinned article was added to the Knowledge Searches (ts_query_kb) table. Note: Requires the Knowledge Management Advanced Installer plugin.</td>
<td>New York</td>
</tr>
<tr>
<td>KM: Create an Ownership Group and check edit permissions and subscriptions</td>
<td>Verify the assignment of an article to an ownership group, that all members of the ownership group are subscribed to the article, and have permission to edit. Note: Requires the Knowledge Management Advanced Installer plugin.</td>
<td>New York</td>
</tr>
<tr>
<td>KM: Create, search for, and view knowledge articles with knowledge blocks</td>
<td>Verify the creation of a knowledge block and its addition to a knowledge article. Also, verify that the knowledge block content is searchable.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>KM: Validate the Knowledge - Approval Retire workflow</td>
<td>Verify the success of Knowledge - Approval Retire workflow by retiring a published knowledge article.</td>
<td>Orlando</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires the Knowledge Blocks plugin.</td>
<td></td>
</tr>
<tr>
<td>KM: Validate feedback task assignment to the ownership group manager</td>
<td>Verify the assignment of a feedback task to the ownership group manager of a knowledge article.</td>
<td>Orlando</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires the Knowledge Management Advanced Installer plugin.</td>
<td></td>
</tr>
<tr>
<td>KM: Validate that the article template selector includes knowledge bases and article templates</td>
<td>Verify that the article template selector includes all knowledge bases with contribute access and article templates applicable to each knowledge base.</td>
<td>Orlando</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Knowledge Management Advanced Installer.</td>
<td></td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>KM: Validate the Knowledge - Approval Publish workflow</td>
<td>Verify the success of a Knowledge - Approval Publish workflow by recalling, rejecting, and then approving a knowledge article through the approval process.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires the Knowledge Management Advanced Installer plugin.</td>
<td>Orlando</td>
</tr>
<tr>
<td>KM: Make an outdated version of an article the latest version</td>
<td>Verify that an outdated version of a knowledge article is made the latest version.</td>
<td>Orlando</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires the Knowledge Management Advanced Installer plugin.</td>
<td></td>
</tr>
<tr>
<td>KM: Validate that the mapped related articles appear in the Related articles widget</td>
<td>Verify that the related articles mapped to a knowledge article appear in the Related articles widget on the knowledge article view page.</td>
<td>Orlando</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires the Knowledge Management Advanced Installer plugin.</td>
<td></td>
</tr>
<tr>
<td>KM: Validate that the mapped related catalog</td>
<td>Verify that the related catalog items mapped</td>
<td>Orlando</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>---------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>items appear in the Related items widget</td>
<td>to a knowledge article appear in the Related items widget on the knowledge article view page.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires the Knowledge Management Advanced Installer plugin.</td>
<td></td>
</tr>
<tr>
<td>KM: Validate that a versioned article is created, published, checked out, and retired</td>
<td>Verify the success of UI actions on a versioned knowledge article by creating, publishing, updating, and retiring the knowledge article in Agent Workspace.</td>
<td>Quebec</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires the Knowledge Management Advanced Installer plugin.</td>
<td></td>
</tr>
<tr>
<td>KM: Verify the scheduled publish feature for knowledge articles</td>
<td>Verify the scheduled publish feature for knowledge articles by creating an article in approval publish workflow, putting it for scheduled for publish and observing the change in workflow state from the <strong>Scheduled for publish</strong> state to the <strong>Published</strong> state.</td>
<td>Quebec</td>
</tr>
</tbody>
</table>
### KM: Knowledge Management test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>KM: Validate the Knowledge - Approval Publish workflow in Agent Workspace</td>
<td>Verify the success of a Knowledge - Approval Publish workflow by recalling and then approving a knowledge article through the approval process in Agent Workspace.</td>
<td>Quebec</td>
</tr>
</tbody>
</table>

**Note:** Requires the Knowledge Management Advanced Installer plugin.

### Related information

**Quick start tests**

### Configure Knowledge Management

Configure various aspects of Knowledge Management based on the specific requirements of your organization.

The following podcast offers additional information on using Knowledge Management.

Knowledge Base Application Podcast

You can also use Knowledge Management capabilities within a website built on Adobe Experience Manager (AEM). For more information, see Integration with Adobe Experience Manager.

### Related information

**Knowledge Management FAQs**
Create a knowledge base

Create a knowledge base to provide a self-service platform for users to store, share, and manage content. Configure knowledge bases into product or service categories and manage user access based on permissions. Customize workflows for publishing and retiring articles in the knowledge base.

Before you begin

Understand the requirements for setting up a knowledge base.

Role required: knowledge_admin or admin

Procedure

1. Navigate to Knowledge > Administration > Knowledge bases.
2. In the Knowledge Bases list, click New.
3. On the Knowledge base form, fill in the following fields as appropriate:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Unique name for the knowledge base.</td>
</tr>
<tr>
<td>Article Validity</td>
<td>Number of default days articles will be valid for after their created date.</td>
</tr>
</tbody>
</table>

Note: The Article Validity field is configured to set the Valid to date for an article. The Valid to date is the date this knowledge article expires. When you create an article within a knowledge base, the date value in the Valid to field of the article is calculated as follows: Created (sys_created_on) + Article Validity (in days). An article author or editor can select whether to keep or change the Valid to date (see Create a knowledge article). If the Article Validity field is blank, the date in the Valid to field date is set to January 1, 2100.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icon</td>
<td>An image that provides a visual reference to describe the knowledge base. This image is displayed next to all articles from this knowledge base in the article search results page.</td>
</tr>
<tr>
<td>Disable commenting</td>
<td>Option to disable commenting. If selected, users cannot comment on articles in the knowledge base.</td>
</tr>
<tr>
<td>Disable suggesting</td>
<td>Option to disable edit suggestions. If selected, users cannot suggest edits to articles in the knowledge base.</td>
</tr>
<tr>
<td>Disable category editing</td>
<td>Option to disable editing of knowledge categories. If selected, only knowledge managers can add or edit knowledge categories for the knowledge base.</td>
</tr>
<tr>
<td>Enable blocks</td>
<td>Option to enable the knowledge blocks feature. If selected, you can create knowledge blocks to add to knowledge articles within a knowledge base.</td>
</tr>
<tr>
<td>Checklist</td>
<td>Checklist to evaluate the quality of articles in the knowledge base.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the knowledge base.</td>
</tr>
<tr>
<td>Note: This field is automatically set to the application selected in the application picker. For information about a scoped knowledge base, see Scoped knowledge bases.</td>
<td></td>
</tr>
<tr>
<td>Owner</td>
<td>The user responsible for the knowledge base. A knowledge base owner can assign other roles to the knowledge base.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Managers</td>
<td>Users who perform administrative functions on the knowledge base.</td>
</tr>
<tr>
<td>Publish workflow</td>
<td>The workflow for publishing the articles in the knowledge base.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Knowledge - Instant Publish</strong>: publishes articles in the knowledge base without requiring an approval.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Knowledge - Approval Publish</strong>: requests approval from the manager of the knowledge base before moving the articles to the published state.</td>
</tr>
<tr>
<td>Retire workflow</td>
<td>The workflow for retiring the articles in the knowledge base.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Knowledge - Instant Retire</strong>: retires articles in the knowledge base without requiring an approval.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Knowledge - Approval Retire</strong>: requests approval from the manager of the knowledge base before moving the articles to the retired state.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to indicate that the knowledge base is active. If not selected, only users with the admin role or knowledge administrators can create, search for, or view its articles.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description to describe the knowledge base.</td>
</tr>
<tr>
<td>Set default knowledge field values</td>
<td>Default configuration settings for the knowledge base.</td>
</tr>
<tr>
<td>Related products</td>
<td>List of products related to the knowledge base content.</td>
</tr>
<tr>
<td>Auto-create translation tasks</td>
<td>Option to enable creating translation tasks automatically after an article is published. If this option is selected,</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Field</td>
<td>when a knowledge article is published in this knowledge base, translation tasks are automatically created for the configured languages. This field appears only when the translation management feature and glide.knowman.translation.enable_translation_task property are enabled. For more information, see Translation management and Knowledge Management properties.</td>
</tr>
<tr>
<td>Languages</td>
<td>Languages enabled for the knowledge articles in this knowledge base. If your system has more languages, use this option to select only those languages in which you want to translate knowledge articles in this knowledge base. You can add more languages later. However, you can remove languages only when no knowledge articles exist in that language. This field appears only when the translation management feature and glide.knowman.translation.enable_translation_task property are enabled. For more information, see Translation management and Knowledge Management properties.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click **Save**.

5. In the related list section, view or configure the following items related to the knowledge base:
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge</td>
<td>List of knowledge articles stored in this knowledge base.</td>
</tr>
<tr>
<td>Can Read</td>
<td>List of user criteria that grants read access and enables user matching the criteria to read articles in a knowledge base.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> It is recommended to assign appropriate user criteria to secure read access. See, Select user criteria for a knowledge base.</td>
</tr>
<tr>
<td>Can Contribute</td>
<td>List of user criteria that grants contribute access and enables user matching the criteria to create and modify articles in a knowledge base.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> It is recommended to assign appropriate user criteria to secure contribute access. See, Select user criteria for a knowledge base.</td>
</tr>
<tr>
<td>Article Templates</td>
<td>If you have activated the Knowledge Management Advanced (com.snc.knowledge_advanced) plugin, the <strong>Article Templates</strong> related list is displayed. If there are article templates in the related list, articles in that knowledge base can only be created using one of the article templates listed. If the <strong>Article Templates</strong> related list is empty, articles can be created using any article template. Click <strong>Edit</strong> to map article templates to the knowledge base.</td>
</tr>
</tbody>
</table>
### Name | Description
--- | ---
| **Note:** Admins, knowledge admins, and knowledge managers can edit the article templates for the knowledge base. |  
| Featured Content | List of knowledge articles that appear in the homepage **Featured Content** section based on the corresponding keyword search set for each article.  
| Knowledge Categories | List of knowledge categories associated with this knowledge base.  

6. Click **Submit**.

**Related reference**
- Knowledge workflows
- Knowledge Management properties

**Related information**
- Control access at the knowledge base level through user criteria
- Explicit roles
- Create a custom knowledge homepage
- I18N - Knowledge internationalization

**Create a custom knowledge homepage**

As a system administrator, you can create a module allowing users to open a knowledge homepage for a specific knowledge base or category.

**Before you begin**
Role required: admin

**Procedure**

1. In the application navigator, point to the application name and click the edit application icon (�建).  
2. In the **Modules** related list click **New**.  
3. Enter a **Title** for the module.  
4. In the **Link type** field, select **URL (from Arguments)**.
5. In the **Arguments** field, append one or more of the following values to `$_knowledge.do#/search?`.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sysparm_kb=&lt;knowledge base sys_id&gt;</code></td>
<td>Enter the sys_id of a knowledge base to show knowledge articles from that knowledge base by default. If the specified knowledge base does not exist, the default knowledge homepage appears when accessing the custom homepage module.</td>
</tr>
<tr>
<td><code>sysparm_category=&lt;knowledge category sys_id&gt;</code></td>
<td>Enter the sys_id of a knowledge category to show knowledge articles from that category by default. If the specified category does not exist, the default category for the selected knowledge base appears when accessing the custom homepage module.</td>
</tr>
<tr>
<td><code>sysparm_order=&lt;view_count, last_modified, or relevancy&gt;</code></td>
<td>Enter the default sort order for articles to appear in.</td>
</tr>
</tbody>
</table>

**Example:**
To create a homepage for a *Facilities* knowledge base with a **sys_id** of `d582764047022100158b949b6c9a7145` and sorting by last modified date, enter `$knowledge.do#/search?sysparm_kb=d582764047022100158b949b6c9a7145&sysparm_order=last_modified` in the **Arguments** field on the Module form.

**Knowledge workflows**
The publishing and retirement processes for a knowledge article are controlled by workflows defined for the knowledge base that the article belongs to.

You can assign different workflows to each Knowledge Base.
You can use one of the default workflows, or create your own workflows to define custom publishing and retirement processes for different types of knowledge.

For the workflows that require approval, you can configure which users can approve or reject by editing the `getApprovers()` function in the `KBWorkflow` script include.

### Default knowledge workflows

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge - Approval Publish</td>
<td>Requests approval from a manager of the knowledge base. Articles in approval are In Review state before moving to Published state once approved or to Scheduled for publish if set to publish later. If the manager rejects the request, the workflow is canceled and the article remains in Draft state.  &lt;br&gt;  If ownership groups is enabled, email notifications with a link to the article are sent to the ownership group members for approval.  &lt;br&gt;  If ownership groups is not enabled, email notifications with a link to the article are sent to knowledge base managers for approval.  &lt;br&gt;  A notification is also sent to authors or revisers of articles to inform them that their article has been approved or rejected.  &lt;br&gt;  To turn on approval email notifications, set the <code>glide.knowman.enable_approval_notification</code> property to <code>true</code>.</td>
</tr>
<tr>
<td>Knowledge - Approval Retire</td>
<td>Requests approval from a manager of the knowledge base before moving the article to the retired state. The workflow is canceled and the article</td>
</tr>
</tbody>
</table>
Default knowledge workflows (continued)

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>remains in the published state if any manager rejects the request.</td>
</tr>
<tr>
<td></td>
<td>If ownership groups is enabled, email notifications with a link to the article are sent to the ownership group members for approval.</td>
</tr>
<tr>
<td></td>
<td>If ownership groups is not enabled, email notifications with a link to the article are sent to knowledge base managers for approval.</td>
</tr>
<tr>
<td>Knowledge - Instant Publish</td>
<td>Immediately publishes a draft article without requiring an approval, or publishes on the scheduled publish date if set to publish later.</td>
</tr>
<tr>
<td>Knowledge - Instant Retire</td>
<td>Immediately retires a published article without requiring an approval.</td>
</tr>
<tr>
<td>Knowledge - Publish Knowledge</td>
<td>A subflow that moves the knowledge article to the published state. You can use this subflow when defining your own workflow.</td>
</tr>
<tr>
<td>Knowledge - Retire Knowledge</td>
<td>A subflow that moves the knowledge article to the retired state. You can use this subflow when defining your own workflow.</td>
</tr>
</tbody>
</table>

**Note:**

- Retired knowledge articles are not available to users except for administrators and knowledge administrators who can view them. To reuse a retired article, administrators and knowledge administrators can republish the article. For more information, see Republish a retired article.
- An article and its translations have a parent-child relationship. Retiring a parent article does not automatically retire all its translated child articles.

**Email notifications for approval workflows**
You can send email notifications for approval workflows.
• Notify approvers about knowledge articles submitted for their approvals.
• Notify authors about the approval status of their knowledge articles.

To send email notifications for approval workflows, enable the **Send notification to approvers and authors in article approval workflow** property (`glide.knowman.enable_approval_notification`). Beginning with New York, the property is enabled by default. Existing customers on release versions prior to New York can enable this property to send email notifications. Disable any custom notifications for article approvals before enabling this property. If the `glide.knowman.enable_approval_notification` property is not available, an administrator can create the property and set its value to `true`. For more information, see Knowledge Management properties.

**Related information**
- Knowledge article states
- Approve an article that is being reviewed
- Retire a versioned article

**Activate the Knowledge Management Advanced plugin**

Activate the Knowledge Management Advanced plugin (com.snc.knowledge_advanced) to enable advanced features for Knowledge Management.

**Before you begin**
Role required: admin

**About this task**
The Knowledge Management Advanced plugin includes feature code and demo data.
The Knowledge Management Advanced Installer plugin (com.snc.knowledge_advanced.installer) is used to activate the Knowledge Management Advanced plugin.

ℹ️ **Note:** The Knowledge Management Advanced plugin is not automatically activated with the Knowledge Management v3 application.

The Knowledge Management Advanced Installer plugin performs two validation steps prior to activation.
• Determines if there are any active Knowledge Management v2 knowledge bases.

• Determines if there is a unique database index on the **Number** field. If a unique constraint has been added to the **Number** field, the plugin activation fails. Follow the instructions listed in KB0634959 to perform corrective steps to resolve the issue.

You need access to **HI** to be able to view KB articles.

The Knowledge Management Advanced plugin activates the following features:

• Article versioning: Enables maintaining multiple versions of a knowledge article. For more information, see Article versioning.

  **Note:** Migrate to Knowledge Management v3 completely to use article versioning.

• Article subscriptions: Enables managing knowledge base and knowledge article subscriptions. For more information, see Knowledge subscriptions.

  **Note:** The Knowledge Management Advanced plugin activates the Subscriptions and Activity Feed Framework plugin (com.snc.activity_subscriptions).

• Article quality index: Enables maintaining consistent quality of knowledge articles within a knowledge base where articles are written by various authors. For more information, see Article quality index for knowledge management.

• Article templates: Enables creating article templates for consistent structure of knowledge articles. For more information, see Knowledge article templates.

• Ownership group: Enables creating ownership groups for knowledge articles. For more information, see Ownership groups.

• In-context article creation: Enables creating a knowledge article from a customer service case. For more information, see Enable creating an article from a customer service case.

• Translation management: Enables managing translation tasks created for published knowledge articles. For more information, see Translation management.

Demo data is included as part of the Knowledge Management Advanced plugin. If the validation step performed by the Knowledge Management Advanced Installer plugin completes successfully, the Knowledge Management Advanced plugin is activated automatically. However, the demo data is not included in this activation. To load the demo data, go to the Knowledge...
Management Advanced plugin page, click the **Load Demo Data Only** related link, and then click **OK**.

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears:
   
   Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

**Knowledge article templates**

Article templates have pre-defined fields structured in a specific order. These templates help create a consistent structure for knowledge articles.

Using the Knowledge Article Templates feature, as a knowledge administrator (a user with knowledge_admin role), you can create article templates, add or customize fields in a template, and activate or deactivate a template.

As a security administrator (a user with security_admin role), you can configure field-level security in any template to make it visible to specific users.

As an author, you can create articles using pre-defined article templates or any newly created article templates.

**Pre-defined knowledge article templates**

Use either the standard template or one of the pre-defined How To, What Is, FAQ or KCS article templates.
Note:

When you upgrade Knowledge Management to Kingston or later releases, all the existing articles from the earlier version automatically use the standard template of the upgraded version. For example, if you upgrade Knowledge Management from Jakarta to Kingston, all existing articles use the standard template available in the Kingston version.

All pre-defined templates are inactive by default. If you do not activate a template, the articles automatically use the standard template. As a knowledge admin, you can activate a template by navigating to Knowledge > Administration > Article Templates. Then in the article template list, set the Active field to true for one or more templates you would like to activate.

The table below lists the fields available in each template and the name of the template table.

<table>
<thead>
<tr>
<th>Template name</th>
<th>Template fields</th>
<th>Maps to table</th>
<th>SEO Description Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAQ</td>
<td>• Question • Answer</td>
<td>FAQ [kb_template_faq]</td>
<td>Question</td>
</tr>
<tr>
<td>How To</td>
<td>• Introduction • Instructions</td>
<td>How To [kb_template_how_to]</td>
<td>Introduction</td>
</tr>
<tr>
<td>What Is</td>
<td>• Introduction • Explanation</td>
<td>What Is [kb_template_what_is]</td>
<td>Introduction</td>
</tr>
<tr>
<td>KCS Article</td>
<td>• Issue • Environment • Cause • Resolution</td>
<td>KCS Article [kb_template_kcs_article]</td>
<td>Issue</td>
</tr>
<tr>
<td>Standard</td>
<td>Text</td>
<td>kb_knowledge</td>
<td>Text</td>
</tr>
</tbody>
</table>

Activating knowledge article templates

The Knowledge Article Templates feature is activated with the Knowledge Management Advanced (com.snc.knowledge_advanced) plugin. For details, see Activate the Knowledge Management Advanced plugin.
Deactivating knowledge article templates

You cannot delete an article template because article templates have an associated child table. Deleting a template would also require deleting the child table. Due to the limitations on dropping tables, article templates and template columns are explicitly made non-deletable. Instead, you can disable the Knowledge Article Templates feature by clearing the Active check box on the Article Template form.

Note: The Standard template is available by default and can’t be made inactive.

Create an article template and use it to create a knowledge article

Create new article templates in addition to the pre-defined templates. Add new fields based on how you want to customize and display your content.

Before you begin
Role required: knowledge_admin or admin

About this task
For each new article template, a child table of the Knowledge [kb_knowledge] table is created. When you add a new field to the template, a new column is added to that table created for the template.

Procedure
1. Navigate to Knowledge > Administration > Article Templates, and click New.
2. On the Article Template form, fill in fields.

<table>
<thead>
<tr>
<th>Article Template form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Description</td>
</tr>
</tbody>
</table>

The Active check box is selected by default making the template available for use.

3. Right-click the form header and click Save.
4. In the Article Templates Field related list, add fields to the template.
**a. Click New.**

**b. On the Article Template Field form, fill in the fields.**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Name</td>
<td>Title to display on the template form.</td>
</tr>
</tbody>
</table>
| Field Type         | Available field types:  
  - HTML  
  - String  
  - Integer  
  - Date  
  - Date and time |
| Order              | Position of the field in the article page view and the article edit view. |
| Article Template   | (Read-only) Name of the article template associated with this field. |
| Template Table     | (Read-only) Name of the table for this template. |
| Template Field     | (Read-only) Name of the template column associated with this field. |
| Mandatory          | Option to make this field as mandatory. When selected, this field is required to be filled. |
| Expand/Collapse    | Defines whether the template field displays as collapsed or expanded by default. |
| Active             | Option to display the field on the template. |
| Heading style      | CSS formats applied to the template header. For example, to display the background of the template header in red, with a 24-px font size, Arial font family, and white |
c. Click Submit.

The field is added to the template.

5. Optional: In the SEO Description Tag field, search for and add article template field name.

The content in this field is used as meta description tags to search for articles created using this article template.

6. Configure the Knowledge form to display the fields that you added to the template.

   Note: You must have the admin role to configure the form layout. If the field is not available in the form layout, use the form designer to configure the fields.

   a. Navigate to Knowledge > Articles > Create New.
   b. Select a knowledge base, and then the newly added article template.
   c. Right-click the header and select Configure > Form Layout.
   d. Select and move the fields you added to the article template from the Available column to the Selected column.
e. Click the up or down icon to arrange the fields in the order in which you want them to appear in the Knowledge form.

f. Click Save.

Note: Authors who started a session before a template was created or activated will see the newly added template upon their next login.

What to do next
If you want to search for duplicate articles when creating an article from a new template, you must configure the article template table for contextual search. On the Table Configuration form, the Search context field must be set to Knowledge ML Search. For more information, see Configure table for a contextual search.

Restrict access to fields in an article template
Use encryption context to set field-level security in article templates and display the fields based on role permissions.

Before you begin
Activate the Encryption Support plugin to enable field-level security using an encryption context.

Role required: security_admin

Procedure
1. Create an encryption context for the article template field to be encrypted.


   b. On the Encryption Context form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the encryption context.</td>
</tr>
<tr>
<td>Encryption key</td>
<td>Key used to encrypt the data. Leave blank to generate a key randomly. Based on the desired type of encryption, enter the exact number of characters:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
|          | • 16 characters for AES 128-bit  
|          | • 32 characters for AES 256-bit  
|          | **Warning:** You cannot retrieve this key from the instance. If you need access to the key, save it elsewhere before clicking **Submit**. |

**Application**

Defaults to **Global** and cannot be changed.

**Type**

Type of encryption used to encrypt your data:

• **AES 128-bit**: Advanced Encryption Standard  
• **AES 256-bit**: Advanced Encryption Standard using 256-bit encryption

---

**c. Click Submit.**

2. Associate the article template field with the encryption context.

a. Navigate to **System Security > Field Encryption > Encryption Field Configurations** and click **New**.

b. On the Encrypted Field Configuration form, fill in the fields.

**Encrypted Field Configuration form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table associated with the article template fields. For example, for the How to article template fields, select <strong>How To [kb_template_how_to]</strong>.</td>
</tr>
</tbody>
</table>
| Column    | Article template field to be encrypted. Only String, Date, Date/Time, and URL fields are supported.  
|           | **String and URL fields**: You can add a new encryption configuration to either a parent table or a child table.  
<p>|           | <strong>Date and Date/Time fields</strong>: You can create encrypted field configurations to encrypt existing Date and Date/Time fields. You can add a new encryption configuration to a parent table. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>table only. You cannot add a new encryption configuration to a child table.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Depending on the number of records affected by the Date and Date/Time fields you are encrypting, it may take up to a few minutes to create the encryption configuration. Make sure that you create the encryption configuration for Date and Date/Time fields when transaction volume on the instance is low.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Encryption context</th>
<th>Encryption context you created for the article template field.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Method</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Single Encryption Context</strong>: Enables data to be encrypted with a single encryption context only. The field is encrypted with the encryption context defined in the Encryption context field. Users that do not have the encryption context cannot view or update field values.</td>
<td></td>
</tr>
<tr>
<td><strong>Multiple Encryption Contexts</strong>: Enables data to be encrypted with more than one encryption context. The field is encrypted by the encryption context of the first user to enter data. If the user has multiple encryption contexts, the context defined in the encryption context selector is used. Because the encryption context is set on a per record basis, fields in a list can have different encryption contexts. However, within a single record, the field can be encrypted by only one context.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Mass encryption is not available when using the Multiple Encryption Contexts method.</td>
</tr>
</tbody>
</table>

After a configuration is created using the single encryption context method, you can update the record to use multiple encryption contexts. However, you cannot change a field using multiple encryption contexts to use a single encryption context.

c. Click **Submit**.

3. Define role permissions for the encrypted field.
a. Navigate to **User Administration > Roles**.

b. In the **Name** column, click the link to the role you want to allow to view this field.

c. In the **Encrypted context** field, search for and select the name of the encryption context for the article template field to apply for the selected role.

   **Note:** You may need to configure the Role form to add the **Encrypted context** field.

d. Click **Update**.

**Results**
Depending on their role permissions defined for the encrypted field, users can view the field on the article template.

**Related information**
- **Encryption support**

**Generate SEO information for articles using article templates**

Improve the searchability of knowledge articles by using the content in an article template field to generate SEO tags for articles created using that template. Search Engine Optimization (SEO) optimise searches in public search engine.

**Before you begin**
Role required: knowledge_admin or admin

**About this task**

   **Note:** If you are using the **Standard** article template, the content of the Text field is used to generate the tags.

You can define the number of characters to be used as tags in the `glide.knowman.seo.pages.meta_description.length` system property.

**Procedure**

1. Navigate to **Knowledge > Article Templates**.
2. Select an article template.
3. In the **SEO Description Tag** field, search for and select an article template field.

4. Click **Update**.

   Note: You can change which article template field is used for generating SEO. Changes are applied only to knowledge articles created or updated after the change was made. To apply the update to all existing published articles created using this template, run the `Populate Meta Description on KB Articles` fix script.

**Article versioning**

Use the Knowledge Management article versioning feature to create and maintain multiple versions of a knowledge article.

Knowledge contributors can create a new version of a knowledge article from an existing published version. This existing version can be either the latest published version or an older outdated version. All changes are stored in the new version of the article and the information in the existing article remains the same.

If you import published knowledge articles from a ServiceNow instance that does not support article versioning, you must run the `Initialize Versions on Articles` fix script to enable article checkout and editing.

With the article versioning feature, a knowledge user can:

- Check out a published article and create another version.

  Note: Only an author (who checks out an article for revision), knowledge base owner, and user with knowledge_admin role can edit an article in the draft state.

- Select a previously published (outdated) version of an article and make it current.
- Recall an article that is being reviewed or scheduled for publication.
- Retire the latest published version of an article.

  Note: Only an author (who checks out an article for revision), knowledge base owner, and user with knowledge_admin role can edit an article in the draft state.

There are two types of article revisions: major and minor. Minor revisions include updates to an article that has not yet been published. Major revisions include updates to an article that has been published and is available to customers.
To track the different revisions, the article versioning feature introduces version numbering.

With the article versioning feature, the knowledge article number also includes the version number. All references to knowledge articles use this number format. For example, KB0010003 v2.0.

**Activation information**

The article versioning feature requires the Knowledge Management Advanced plugin (com.snc.knowledge_advanced) to be activated and the glide.knowman.versioning.enabled property to be set to true (default value). For more information, see Activate the Knowledge Management Advanced plugin and Article versioning properties.

**Related information**

Knowledge Management FAQs

**Manually update customized files**

If you have customized any of the files that are updated as part of the Knowledge Management Advanced Installer plugin, these files are skipped during plugin activation and must be updated manually.

Manually update your customization to include the article versioning-related changes.

- Add the **Version** field to the Knowledge form layout and the Knowledge list view, if it is not already present.
- Add the **outdated** choice to the **Workflow** choice list field on the Knowledge form, if it is not already present. Keep the value as **outdated** because of dependencies that article versioning functionalities have on this choice.
- Update the **Knowledge > My Flagged** and **Self-Service > My Knowledge Articles** modules to include the following condition in the **Filter** field, if these modules do not already reflect this change: **Revised by is (dynamic) me**.

If you have customized any of the Knowledge Management Overview dashboard reports, these files are also skipped during plugin activation and must be updated manually.

**Article versioning changes**

Article versioning introduces new actions that allow knowledge users to create and revise versions of existing articles. It also introduces new fields and related
New user actions
As part of creating article versions, users can:

• Check out a published article and create another version by clicking **Checkout** on the Knowledge form.

  ❗ **Note:** Only the author, knowledge base owner, and users with the knowledge_admin role can edit an article in the Draft state.

• Recall an article that is being reviewed or scheduled for publish by clicking **Recall** on the Knowledge form.

• Select a previously published article in the Outdated state and make it the current published version by clicking **Make this current** in the Knowledge form header.

  ❗ **Note:** To edit a published article without having to create a new version, make sure the `glide.knowman.versioning.enable_minor_edits` property is enabled.

Changes to the Knowledge list
The article versioning feature adds the following to the Knowledge list:

• The **Version** column displays the article version number. The Knowledge list displays multiple versions of an article.

• The **Workflow** column includes the new **Outdated** state.

Changes to the Knowledge form
The article versioning feature adds the following to the Knowledge form:

• The **Version** field displays the article version number.

• The **Display number** field displays a combination of the article number and the version number. For example, KB0010004 v1.02. All references to a knowledge article use this display number.

• The **Base Version** field displays the knowledge article number and version on which the current article is based.

• The **Revised By** field displays the name of the user who checked out a published article and created a new version.

• The **Article Versions** related list displays a list of all versions for an article. From this list, you can:
Click the **Version** to view a specific version of an article.
Click the **View Article** related link to see the article page view.

**Note:** If necessary, configure the form to display the fields and the related list.

**Changes to Knowledge modules**
The article versioning feature introduces the following Knowledge module changes:

- **My Knowledge Articles**
  - For a knowledge user, this module includes records for the articles authored by the user as well as records for each article revised by the user.
  - For a knowledge reviser, this module includes records for the articles published by the user as well as records for each article revised by the user.

- **My Flagged**
  - For a knowledge user, this module includes records for each revision made to articles authored by the user.
  - For a knowledge reviser, this module includes records for each article revised by the user.

**Note:** Users that have customized these modules do not see these changes.

**Changes to Knowledge Management dashboard reports**
The Knowledge Management Overview dashboard reports have been updated to include article versioning-related changes when the Knowledge Management Advanced plugin is activated.

- Articles Flagged in the Last 30 Days
- Articles Marked Not Useful in the Last 30 Days
- Articles Used per Month
- Knowledge use
- Knowledge view
- Knowledge updated in past 30 days
- Knowledge flagged in past 30 days
- Knowledge by Workflow state
- Knowledge created by Author
- Knowledge created in past 30 days
• New Knowledge Articles Created in the Last 30 Days
• Knowledge Ratings for past 30 days

Versioning information available in the Knowledge Management Service Portal

Knowledge search results show the article number and the version number for each article.

Note:

To display the article version number next to the article number in the search results, enable the `glide.knowman.search.show_article_number` property in the Knowledge Search Properties section of the Knowledge Management Properties page.

If you are accessing an article from the base system or knowledge service portals using the URL to a KB article, you must also include the article version number in the URL. For example, to access the KB0000005 knowledge article, instead of using the `https://<instance name>/sp?id=kb_article&sys_id=KB0000005` as the URL, you must use `https://<instance name>/sp?id=kb_article&sys_id=KB0000005%20V1.0` to view the article.

The article view page shows a version history section for articles that have been updated. This section includes the version numbers, date updated, and the name of the author or reviser.

• Click Latest version or the version number and current state to expand the version history section.
• Click the version number to open that particular version of the article.
• When viewing an outdated article, a message informs the user that a newer updated version is available. The message includes a link to the latest version.

Feedback on article versions

With the article versioning feature, users can view and contribute to feedback on the current versions of knowledge articles.

For more information about feedback options, see Knowledge feedback.

<table>
<thead>
<tr>
<th>Feedback option</th>
<th>How this option works with article versioning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rating an article</td>
<td>The average rating for an article is carried over to the checked out version. The average rating calculation up-</td>
</tr>
<tr>
<td>Feedback option</td>
<td>How this option works with article versioning</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Marking an article as helpful</td>
<td>The helpfulness percentage of a previous version of an article is also considered for a new version when displayed in the helpfulness column on the homepage.</td>
</tr>
<tr>
<td>Comments</td>
<td>The Comments section at the bottom of an article displays comments from previous versions unless Live Feed is enabled. Live Feed only shows comments for the current version.</td>
</tr>
<tr>
<td>Flagging an article</td>
<td>Checking out an article or setting a previous version to the current version resets the flagged value to false.</td>
</tr>
<tr>
<td>View count</td>
<td>The view count is carried over to the checked out article. Any view of a version of an article increments the view count of all subsequent versions. Views to a newer version of an article do not affect the view count of previous versions.</td>
</tr>
<tr>
<td>Use count</td>
<td>The use count is carried over to the checked out article. Any use of a version of an article increments the use count of all subsequent versions. Any use of a newer version of an article does not affect the use count of previous versions.</td>
</tr>
</tbody>
</table>

**Knowledge article version numbers**

Knowledge article version numbers follow a specific pattern. Increments to the version number depend on the revision type.

Article version numbers follow this pattern: `<major release number.minor release number>`

The type of revision being made to an article determines the increment. A minor revision increments the version number by 0.01. A major revision, such
as publishing an article, increments the version to the next whole number, for example, from version 2.02 to 3.0.

The following example illustrates the life cycle of a versioned article and the changes to the version number.

<table>
<thead>
<tr>
<th>User action</th>
<th>Article state</th>
<th>Version number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge author creates a new article</td>
<td>Draft</td>
<td>0.01</td>
</tr>
<tr>
<td>Knowledge author makes a change and updates the article.</td>
<td>Draft</td>
<td>0.01</td>
</tr>
<tr>
<td>Knowledge author submits the article for review.</td>
<td>Review</td>
<td>0.02</td>
</tr>
<tr>
<td>Knowledge author recalls the article to make another change.</td>
<td>Draft</td>
<td>0.03</td>
</tr>
<tr>
<td>Knowledge article submits the article for review</td>
<td>Review</td>
<td>0.04</td>
</tr>
<tr>
<td>Approver rejects the article and requests a change.</td>
<td>Draft</td>
<td>0.05</td>
</tr>
<tr>
<td>Knowledge author makes the change and submits the article for review.</td>
<td>Review</td>
<td>0.06</td>
</tr>
<tr>
<td>Approver approves the article</td>
<td>Scheduled for publish</td>
<td>0.07</td>
</tr>
<tr>
<td>Article is published</td>
<td>Published</td>
<td>1.0</td>
</tr>
<tr>
<td>Knowledge author checks out the published article.</td>
<td>Draft</td>
<td>1.01</td>
</tr>
<tr>
<td>Knowledge author submits the article for review.</td>
<td>Review</td>
<td>1.02</td>
</tr>
<tr>
<td>User action</td>
<td>Article state</td>
<td>Version number</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>--------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Approver approves the article</td>
<td>Scheduled for publish</td>
<td>1.03</td>
</tr>
<tr>
<td>Article is published</td>
<td>Published</td>
<td>2.0</td>
</tr>
<tr>
<td>When the version 2.0 article is published, the state of the version 1.0 article changes to Outdated.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Any change to the state of an article results in a version increment, except to and from the **Pending retirement**, **Retired**, and **Outdated** states.

**Knowledge article version information**

Users can view version information for a knowledge article from the Knowledge view page.

The knowledge article number and the version number appear at the top of the article, just below the title. Clicking the version number expands the version history section, which includes a list of the available article versions. User roles determine what is included in this list:

- Users with read access to a knowledge base can see the latest published version and previous major versions.
- Users with read and contribute access to a knowledge base can see the latest published version, previous major versions, and any draft or review versions.

You can view any of the previous versions of an article by clicking the version number in the list. When you view a previous version, a message at the top of the article indicates that an updated version is available.

At the bottom of a knowledge article, you can see additional information about an article, including the name of the author or revisor and the date that the article was last modified.

**Knowledge article states**

Knowledge article versions can be in one of several states as it progresses through the creation cycle.
<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>The article is in the process of being created.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> A versioned knowledge article in the <strong>Draft</strong> state can be</td>
</tr>
<tr>
<td></td>
<td>modified only by the author or reviser with the contribute access</td>
</tr>
<tr>
<td></td>
<td>to the knowledge base, owner of a knowledge base, users with the admin and</td>
</tr>
<tr>
<td></td>
<td>knowledge_admin role, and ownership group members, if ownership group is</td>
</tr>
<tr>
<td></td>
<td>added to the article.</td>
</tr>
<tr>
<td>Review</td>
<td>The draft version of the article is sent to reviewers to approve or reject.</td>
</tr>
<tr>
<td>Scheduled for publish</td>
<td>The draft version of a knowledge article is scheduled for publishing on a</td>
</tr>
<tr>
<td></td>
<td>future date.</td>
</tr>
<tr>
<td>Published</td>
<td>The article is approved and published. When the state of an article changes</td>
</tr>
<tr>
<td></td>
<td>to <strong>Published</strong>, the state of any previous published versions of that article changes to <strong>Outdated</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> After a knowledge article with an ownership group is approved,</td>
</tr>
<tr>
<td></td>
<td>only the owner of a knowledge base and ownership group members have</td>
</tr>
<tr>
<td></td>
<td>contribute access to the article.</td>
</tr>
<tr>
<td>Pending retirement</td>
<td>The published article is selected for retirement, pending approval.</td>
</tr>
<tr>
<td>Retired</td>
<td>The published article is retired.</td>
</tr>
<tr>
<td></td>
<td>Retired knowledge articles cannot be searched for by external users or</td>
</tr>
<tr>
<td></td>
<td>customers. To reuse a retired article, create a new article with the same</td>
</tr>
<tr>
<td>State</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>content, which is published once approved.</td>
</tr>
<tr>
<td>Outdated</td>
<td>A more recent version of the article has been published. End users can read published articles as well as the outdated versions.</td>
</tr>
</tbody>
</table>

**Related information**

**Knowledge access controls**

**Check out a published article and create a new version**

Create a new version of a knowledge article by checking out the latest published version.

**About this task**

Users with canContribute permissions, including the knowledge owner, knowledge manager, and knowledge administrator, can check out a published article unless there is already a checked out version. If a version has been checked out, the Checkout button does not appear on the Knowledge form header.

When you check out an article, the default value of Valid to field of the article is derived from the Article Validity field configured for the knowledge base (see Create a knowledge base). If the Article Validity field is blank, the date in the Valid to field date is set to January 1, 2100. An article author or editor can select whether to keep or change the default Valid to date.

When you check out an article, attachments from the article's base version are copied into the new article version and relative paths to these attachments are also updated.

⚠️ **Note:** For article versions that were created in the previous releases, the relative paths to the attachments may not be updated. To update them, activate and run the Fix attachment links on article versions fix script.

**Procedure**

1. Navigate to Knowledge > Articles > Published.
2. Select the desired article from the list.
3. Click Checkout in the Knowledge form header.
The system creates a new version of the knowledge article and displays a message to the user. The article number for the new version remains the same, the version number is increased by 0.01, and the state changes to Draft. The new version of the article is added to the Knowledge list and to the Article Versions related list on the Knowledge form.

Revert an outdated article to the current state
Use an outdated version of an article to create a new version.

Before you begin
Roles required: knowledge base owner, knowledge_manager, knowledge_admin

About this task
This action is available for earlier published version that have a state of Outdated and only when there is no checked out version. If a version has been checked out, the Make this current button does not appear on the Knowledge form header.

Procedure
1. Navigate to Knowledge > Articles > All.
2. Open an article in the Outdated state.
3. Click Make this current in the Knowledge form header.
   The system displays the Knowledge form. The version number increments to the latest version number plus 0.01 and the state changes to Draft. For example, if the latest published version of an article is 3.0 and you select the outdated 1.0 version to become the current version, the version number increments to 3.01.

View all versions of an article
View a list of all available versions for a selected knowledge article and then view the selected version in a new tab.

About this task
The list of all available versions for a selected knowledge article is displayed in the Article Versions related list on the Knowledge form. Users with read access can see major versions. Users with contribute access can see major and minor versions.
Procedure
1. Navigate to Knowledge > Articles > All.
2. Open the desired article.
3. Click the Article Versions tab to display the related list.
4. Click Version to display the desired article version in a new tab.
5. If desired, click the View Version related link to see the article view page.

Compare two versions of an article
Select and compare two versions of a knowledge article.

Before you begin
Role required: knowledge_manager, knowledge_admin

Procedure
1. Navigate to a Knowledge > Articles > All.
2. In the Name column, click the link to a knowledge article with multiple versions.
3. In the Article Versions related list, select the check boxes for the two versions of the article to compare.
4. Scroll down to the Actions on related rows menu and choose Compare. The Compare versions page opens and lists the fields for the selected article versions in a side-by-side format. Differences between the two article versions are highlighted.

5. When you are finished comparing the two versions, click Done to return to the Knowledge form.
Retire a versioned article

You can retire the latest published version of a knowledge article. Retiring a knowledge article does not create a new version. It simply marks the article as Retired.

About this task
This action is available only when there is no checked out version. If a version has been checked out, the Retire button does not appear on the Knowledge form header.

Note: For the Knowledge - Approval Retire workflow, this happens only when the retire request is approved.

In addition to the knowledge administrator and the knowledge manager, the following users can retire a versioned article:

• knowledge owner
• latest publisher of the versioned knowledge article

Users can still access outdated articles that have been attached to incidents by navigating to the article view page with the sys_id of the article. Outdated articles include a message that an updated article is available.

If versioning is disabled, only the latest version of the article is shown in search results and list views.

Retired knowledge articles cannot be searched for by external users or customers. To reuse a retired article, create a new article with the same content, which is published once approved.

Procedure
1. Navigate to Knowledge > Articles > Published.
2. Open the desired article.
3. Click Retire in the Knowledge form header.
   The system returns to the Knowledge list. The state of the article changes to Pending retirement and the state of previously published versions change to Outdated.

Note: You cannot check out or edit a retired article.

Disable the article versioning feature
Users with the system administrator role can disable the article versioning feature by setting a property.
Before you begin
Role required: admin

About this task
The **Enable article versioning feature** property controls the article versioning feature. Setting this property to **false** disables the article versioning feature. Once disabled:

- The **Version** field is removed from the Knowledge form. The **Version** column remains on the Knowledge list and can be removed manually.
- The **Article Versions** related list is removed from the Knowledge form.
- The **Recall**, **Checkout**, and **Make this current** buttons are removed from the Knowledge form.
- Outdated articles are removed from Knowledge list views.
- The version history does not appear on the article view page.

Articles continue to be versioned in the background. Minor versions are incremented until an article is published and then the version number is increased to the next major version.

Users can still access outdated articles that have been attached to incidents. Outdated articles include a message that an updated article is available.

Procedure
1. Navigate to **Knowledge > Administration > Properties**.
2. Locate the **Enable article versioning feature** property in the Article Versioning Properties section.
3. Click the check box to disable the property.
4. Click **Save**.

Knowledge manager
Having multiple knowledge bases allows an organization to spread management responsibilities across multiple users, known as knowledge managers.

As a knowledge manager, you can assign other managers, define category structures, configure which users can read and contribute articles, move and pin articles, and modify most fields on the Knowledge Base form. You can also approve the publishing or retiring of knowledge articles in those knowledge bases.
The primary manager of a knowledge base is the owner of that knowledge base. Each knowledge base must have one owner. There may be any number of additional managers for each knowledge base. The owner and all managers of a knowledge base automatically receive the knowledge_manager role. If the knowledge base is made inactive later, the knowledge_manager role is not automatically removed for these users.

Related information
- Configure Knowledge Management
- Migrate to Knowledge Management v3

Add a knowledge article to featured content
Add a knowledge article to appear in the Featured content section of the knowledge homepage and at the top of knowledge search results page.

Before you begin
Role required: knowledge_manager, knowledge_admin, or admin

About this task
Adding an article to featured content requires associating an article to specific keywords. You can search a keyword in the knowledge service portal or search results page to display articles in the Featured content section or at the top of the knowledge search results list.

Note: The articles added to the Featured content section do not appear in the global search results and Virtual Agent conversations.

• To display articles in the Featured content section, add a default keyword in the glide.knowman.default_keyword property Value field and add the same keyword to all articles you want to display in that section.
• To display articles at the top of the knowledge search results list, add a list of keywords to each article you want to display at the top of the list.

Procedure
1. Navigate to Knowledge > Knowledge Bases.
2. Select a knowledge base.
3. In the Featured content related list, click New.
4. In the Knowledge field, search for and select the desired article.
   If you know the article number, you can search for the article directly.
5. In the Keywords field, click the lock/unlock toggle icon.
6. Click the lookup icon to open the Knowledge keywords list.
7. Select the keyword to add for this article.
   • Add the default keyword to display this article in the Featured content section during search.
   • Add all related keywords for the article to display it at the top of the knowledge search results page during search.

   Note: You can create knowledge keywords, if it does not already exist in the list, and then add it to the article.

8. Click the lock/unlock toggle icon to add the keywords to the article.
9. Click Submit.

Define a knowledge article category
Each knowledge base has a hierarchy of categories that organizes the articles.

Before you begin
You must have CanContribute access to the knowledge base or have a knowledge_admin or admin role.

About this task
Define a hierarchy for categories by creating parent-child relationships. Each hierarchy consists of a top-level category and a structure of subcategories, which are also named the child categories. The category hierarchy is saved in the Full category field in the Knowledge Category [kb_category] table.

You can create and edit categories separately for each knowledge base.

Procedure
1. Navigate to Knowledge > Administration > Knowledge Bases.
2. Select a knowledge base you manage.
3. Create a top-level category.
   a. In the Knowledge Categories related list, click New.
   b. On the Knowledge Category form, fill in the fields.
### Knowledge Category form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Label for the category. The label appears as the name of the category.</td>
</tr>
<tr>
<td>Value</td>
<td>Value for the category you use when referencing the category in scripts.</td>
</tr>
<tr>
<td>Parent ID</td>
<td>Top-level component associated with the category. This field is automatically set to the top-level component ID.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to enable the category.</td>
</tr>
</tbody>
</table>

4. **Optional:** Create a child category.
   a. Expand an existing category and click **New** within the expanded section.
   b. Fill in the **Knowledge Category form**.
   c. Click **Submit**.

### What to do next
In addition to using categories defined by a knowledge manager, knowledge contributors can add and edit categories when editing an article.

### Related information
- Select a knowledge article category

### Assign a knowledge base manager
You can assign users as managers of a knowledge base.

**Before you begin**
Role required: knowledge_admin, or admin

**Procedure**
1. Navigate to **Knowledge > Knowledge Bases**.
2. Select a knowledge base you manage.
3. In the **Managers** field, click the unlock icon.
4. Add one or more users.
5. Click **Update**.
   After you save the knowledge base record, users selected as managers automatically receive the knowledge_manager role if they do not have it already.

**What to do next**
You can remove a knowledge base manager by removing that user from the **Managers** field. If the user is not a manager of any other knowledge base, the knowledge_manager role is removed from that user.

**Managing access to knowledge bases and knowledge articles**
Determine whether certain users or categories of users can access knowledge bases and knowledge articles by controlling contribute and read access.

As a knowledge administrator, manager of a knowledge base, or owner of a knowledge base, you can assign user criteria to control contribute and read access at the knowledge base level, where:

- Read access determines the ability to view knowledge articles in a knowledge base.
- Contribute access determines the ability to create, modify, and retire knowledge articles in a knowledge base.

As a knowledge administrator, manager of a knowledge base, or owner of a knowledge base, you can assign user criteria and roles, or both, to control read access at the knowledge article level.

Try to use only user criteria, which were introduced in Knowledge Management v3, to control access to knowledge articles. Roles were used for this purpose in Knowledge Management v2.

ℹ️ **Note:** By default, when contribute access isn’t provided for a knowledge base, a user must meet both roles and user criteria conditions for read access. However, you can override roles set for a knowledge article and provide access through user criteria only by setting the `glide.knowman.search.apply_role_based_security` system property to `false`. Because this property isn’t available by default, you must add it. For more information, see [Add a system property](#).

**User criteria for knowledge access**
As a knowledge administrator, manager of a knowledge base, or owner of a knowledge base, you control access to knowledge bases or knowledge articles for a user through user criteria, which are described in the following table.
### User criteria definitions

<table>
<thead>
<tr>
<th>User criteria</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot Contribute</td>
<td>Cannot contribute (that is can't create, modify, or retire) knowledge articles within a knowledge base. The Cannot Contribute user criteria is available only for knowledge bases.</td>
</tr>
<tr>
<td>Can Contribute</td>
<td>Can contribute (that is can view, create, modify, or retire) knowledge articles within a knowledge base. The Can Contribute user criteria is available only for knowledge bases.</td>
</tr>
<tr>
<td>Cannot Read</td>
<td>At the knowledge base level, cannot view knowledge articles within a knowledge base. At the knowledge article level, cannot view a knowledge article.</td>
</tr>
<tr>
<td>Can Read</td>
<td>At the knowledge base level, can view knowledge articles within a knowledge base. At the knowledge article level, can view a knowledge article.</td>
</tr>
</tbody>
</table>

The access to knowledge base and its articles are defined based on the user criteria status for a user as described in the following table.

### Combining knowledge base and knowledge article user criteria

<table>
<thead>
<tr>
<th>Status</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>The user matches both Can Contribute and Cannot Contribute at the knowledge base level</td>
<td>The user is denied contribute access to the knowledge base and its articles.</td>
</tr>
<tr>
<td>The user matches both Can Read and Cannot Read at the knowledge base level</td>
<td>The user is denied read access to the knowledge base and its articles.</td>
</tr>
<tr>
<td>The user matches Can Read at the knowledge base level and Cannot Read at the knowledge article level</td>
<td>The user is denied read access to the knowledge article.</td>
</tr>
<tr>
<td>The user matches Cannot Read and Can Read at the knowledge article level</td>
<td>The user is denied read access to the knowledge article.</td>
</tr>
</tbody>
</table>
Users with special knowledge privileges

Users with special knowledge privileges aren’t evaluated based on user criteria and have knowledge bases and knowledge articles access as described in the following table.

### Access of users with special privileges to knowledge bases and knowledge articles

<table>
<thead>
<tr>
<th>User</th>
<th>Access</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge administrator</td>
<td>• Contribute to and read all knowledge bases and their articles.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Modify the definition of all knowledge bases and assign user criteria to them.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This access doesn’t apply to scoped knowledge bases. For more information, see <a href="#">Scoped knowledge bases</a>.</td>
<td></td>
</tr>
<tr>
<td>Owner of a knowledge base</td>
<td>• Contribute to and read that knowledge base.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Modify the definition of that knowledge base and assign user criteria to it.</td>
<td></td>
</tr>
<tr>
<td>Manager of a knowledge base</td>
<td>• Contribute to and read that knowledge base.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Modify the definition of that knowledge base and assign user criteria to it.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the article versioning feature is enabled, the manager of a knowledge base can’t modify knowledge articles of other authors that are in the <strong>Draft</strong> state. For more information, see <a href="#">Article versioning</a>.</td>
<td></td>
</tr>
<tr>
<td>Members of an ownership group associated with a knowledge article</td>
<td>Read, modify, approve, and retire that knowledge article (see <a href="#">Ownership groups</a>).</td>
<td></td>
</tr>
</tbody>
</table>

### Explicit roles and user criteria

Explicit roles (snc_external and snc_internal) are added to your instance when your administrator installs a plugin, such as the Customer Service plugin (com.sn_customerservice), that also activates the Explicit Roles plugin.
If you create a knowledge base with the Explicit Roles plugin (com.glide.explicit_roles) activated, the application automatically adds the following predefined user criteria at the knowledge base level:

- **Users with 'snc_internal' role** – Added to the Can Read user criteria enabling only users with the snc_internal role have read access to the knowledge base.
- **Users with snc_internal' and another role** – Added to the Can Contribute user criteria enabling only users with the snc_internal role and at least one additional role have contribute access to the knowledge base.

When you upgrade to product versions that offer the Explicit Roles plugin (com.glide.explicit_roles), the predefined user criteria **Users with 'snc_internal' role** and **Users with 'snc_internal' and another role** aren't automatically added to any existing knowledge bases created prior to the activation of the Explicit Roles plugin. To add these predefined user criteria to an existing knowledge base, run the **Fix unsecured knowledge bases** fix script. For more information about explicit roles and fix scripts, see **Explicit Roles** and **Fix scripts**.

**Determining contribute access to a knowledge base and its articles using user criteria**
The flowchart in this section illustrates the user criteria checks that determine contribute access at the knowledge base and article levels.

ℹ️ **Note:** In order for an unauthenticated user to view knowledge articles within the knowledge base, ensure that the audience for the Knowledge Management Service Portal pages is set to public; that is, the page can be accessed without the need for authentication. For more information, see **Create and edit a page using the Service Portal Designer**.
Contribute access to a knowledge base and its article flowchart

<table>
<thead>
<tr>
<th>Property value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>No user has contribute access to the knowledge base except <strong>users with special knowledge privileges</strong>.</td>
</tr>
<tr>
<td>false</td>
<td>All users, including unauthenticated users, with at least one role can contribute to the knowledge base. If the Explicit Roles plugin (com.glide.explicit_roles) is activated, users who have at least one role other than snc_internal can contribute to the knowledge base. To check knowledge bases accessible to unauthenticated users, use the User Criteria Diagnostics feature. For more information, see <strong>Configure access to knowledge bases for unauthenticated users</strong>.</td>
</tr>
</tbody>
</table>
When a user has contribute access to a knowledge base, the `glide.knowman.apply_article_read_criteria` property is evaluated to determine contribute access to an article in the knowledge base, as explained in the following table.

<table>
<thead>
<tr>
<th>Property value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>Article-level read access overrides the default contribute permission granted by contribute access at the knowledge base level.</td>
</tr>
<tr>
<td>false</td>
<td>Contribute access at the knowledge base level takes precedence over article-level user criteria and the user has contribute access to every article in the knowledge base.</td>
</tr>
</tbody>
</table>

**Determining read access to articles in a knowledge base using user criteria**

The following flowchart illustrates the user criteria checks that determine read access to a knowledge article.
When either Cannot Read isn’t set or a user doesn’t match Cannot Read and additionally Can Read is not set, the `glide.knowman.block_access_with_no_user_criteria` property value is further evaluated to determine read access, as explained in the following table.

### Read access when user criteria for a knowledge base aren’t set

<table>
<thead>
<tr>
<th>Property value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>No user has read access except users with special knowledge privileges and users who have contribute access to the knowledge base.</td>
</tr>
</tbody>
</table>
| false          | All users, including unauthenticated users, have read access to the knowledge base and the article-level user criteria are further evaluated.

To check knowledge bases accessible to unauthenticated users, use the User Criteria Diagnostics feature. For more information, see Configure access to knowledge bases for unauthenticated users.
When a user has contribute access to a knowledge base, the `glide.knowman.apply_article_read_criteria` property is evaluated to determine read access to an article in the knowledge base, as explained in the following table.

<table>
<thead>
<tr>
<th>Property value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>Article-level read access overrides the default read permission granted by contribute access at the knowledge base level.</td>
</tr>
<tr>
<td>false</td>
<td>Contribute access at the knowledge base level takes precedence over article-level user criteria and the user has read access to every article in the knowledge base.</td>
</tr>
</tbody>
</table>

**Important:** After you add user criteria, you can use the user criteria diagnostics feature to verify the access that users have to a knowledge base or a knowledge article. For more information, see User criteria diagnostics for Knowledge Management.

**Related reference**

- Knowledge Management properties

**Related information**

- Knowledge manager
- Knowledge Management FAQs

**Create user criteria for controlling access to knowledge bases and articles**

Control access to knowledge bases and articles by creating user criteria.

**Before you begin**

Role required: user_criteria_admin

**Note:** To create a user criteria record from the Knowledge module, you must have the user_criteria_admin role in addition to the knowledge role. For more information about access, see Managing access to knowledge bases and knowledge articles.

**Procedure**

1. Navigate to **Knowledge > Administration > User Criteria**.
2. Click **New**.
3. On the User Criteria form, fill in the fields.
## User Criteria form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the user criteria.</td>
</tr>
<tr>
<td>Users</td>
<td>Users that must match the user criteria.</td>
</tr>
<tr>
<td>Groups</td>
<td>Groups that must match the user criteria.</td>
</tr>
<tr>
<td>Roles</td>
<td>Roles to match the user criteria.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Option to display or hide the advanced option that includes the Script field on the User Criteria form.</td>
</tr>
<tr>
<td>Script</td>
<td>Script to define any additional user criteria that returns true or false. This field is available when the Advanced option is selected on the User Criteria form.</td>
</tr>
</tbody>
</table>

### Note:

- Because the evaluation of a role is cached in the session, any change in the role requires you to log in again.
- User criteria are not applicable for elevated privilege roles.

- A script is evaluated in the scope that the user criteria is created in.
- The evaluation of a script is cached in the session, so any change in the evaluation requires you to log in again. If a scripted user criteria is defined for a knowledge base, user access to knowledge bases is evaluated once per session. If the script results in changes after a session cache is built, the result takes effect in the next session.
- Do not use `gs.getUser()` or other session APIs because they cause conflicts when used in diagnostic tools. Use the predefined `user_id` variable available in the script to get the user ID of the user being used to evaluate the script.
- Scripts are evaluated dynamically. Therefore, including scripts in a user criteria can impact performance.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Option to activate or deactivate the user criteria.</td>
</tr>
<tr>
<td>Companies</td>
<td>Companies that the user record must match.</td>
</tr>
<tr>
<td>Locations</td>
<td>Locations that the user record must match.</td>
</tr>
<tr>
<td>Departments</td>
<td>Departments that the user record must match.</td>
</tr>
<tr>
<td>Match All</td>
<td>Option to determine whether all elements from each populated user criteria field must match. If selected, only users who match all user criteria are given access. If cleared, the user must meet one or more of the set user criteria to be given access. By default, this check box is cleared so that any condition met provides a match. For example, consider a user criteria record for the following: • Locations A or B • Company C or D With <strong>Match All</strong> selected, only users meeting all these conditions are matched. For example, a user with a location A and a company C. If <strong>Match All</strong> is not selected, users meeting any of these conditions are matched. For example, a user with a location B. <strong>Note:</strong> If you select <strong>Match All</strong>, ensure that you don’t create contradictory conditions that can never be met. For example, if all users in location A work for company G, the conditions in this example can never be met.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Related information**

- Control access at the knowledge base level through user criteria
- Control access at the knowledge article level through user criteria

**Control access at the knowledge base level through user criteria**

You specify user criteria for a knowledge base to control which users are granted access to read and contribute knowledge articles to that knowledge base.
Before you begin
Role required: knowledge_manager, knowledge_admin, or admin

⚠️ Note: To administer a scoped knowledge base, you must have the application-specific admin role in addition to the knowledge_admin or admin role. For more information, see Scoped knowledge bases.

About this task
You can assign user criteria to control read or contribute access. For example, you could enable all users in your Support department to have contribute access to a knowledge base by creating a user criteria record with the required department set to Support, and then including the user criteria record in the Can Contribute user criteria. For more information, see Managing access to knowledge bases and knowledge articles. Try to use only user criteria, which were introduced in Knowledge Management v3, to control access to knowledge bases. Roles were used for this purpose in Knowledge Management v2.

Procedure
1. Navigate to Knowledge > Administration > Knowledge Bases.
2. Click the link to knowledge base you manage.
3. Add user criteria to the knowledge base.
   a. Depending on the user criteria you want to set, select one or more of the relevant related lists.

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can Read</td>
<td>Users can read knowledge articles in the knowledge base.</td>
</tr>
<tr>
<td>Cannot Read</td>
<td>Users can’t read knowledge articles in the knowledge base.</td>
</tr>
<tr>
<td>Can Contribute</td>
<td>Users can create, modify, and retire knowledge articles in a knowledge base. Contribute access to a knowledge base also provides read access to all articles in the knowledge base.</td>
</tr>
</tbody>
</table>
**Related list** | **Description**
--- | ---
Cannot Contribute | Users can't create, modify, retire, or read knowledge articles in the knowledge base.

Note: If the related lists aren't visible, configure the Knowledge form to display them. For more information, see Add a related list to a form.

b. In the selected related list, add the required user criteria.

- As a user with the admin role, to add a new user criteria record, click New, specify the required fields, and then click Submit.

- As a user with the knowledge_manager, knowledge_admin, or admin role, to add an existing user criteria record, click Edit, move the required user criteria from the Collection column to the Knowledge column, and then click Save.

4. On the Knowledge Base form, click **Update**.

**What to do next**

After you add user criteria, you can use the user criteria diagnostics feature to verify the access that users have to a knowledge base or a knowledge article. For more information, see User criteria diagnostics for Knowledge Management.

**Important:** After making user criteria additions or changes, you may need to log out and log back in to clear the prior configuration.

**Related information**

- Create a knowledge base
- Create user criteria for controlling access to knowledge bases and articles
- Control access at the knowledge article level through user criteria

**Control access at the knowledge article level through user criteria**

You specify user criteria for a knowledge article to control which users are granted read access to the knowledge article.

**Before you begin**

Role required: Users who have Contribute access to the knowledge article

Note: You may need to configure the form to add Can Read and Cannot Read fields.
About this task
Try to use only user criteria, which were introduced in Knowledge Management v3, to control access to knowledge articles. Roles were used for this purpose in Knowledge Management v2. For more information, see Managing access to knowledge bases and knowledge articles.

Procedure
1. Open a knowledge article.

   Note: You can update only the latest version of the knowledge article.

2. Assign access based on user criteria.

<table>
<thead>
<tr>
<th>Access</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow read access</td>
<td>In the Can Read field, search for and add user criteria. For example, to allow read access to a user, search for a user criteria that the user matches and add it to this field.</td>
</tr>
<tr>
<td>Deny read access</td>
<td>In the Cannot Read field, search for and add user criteria. For example, to deny read access to a user, search for a user criteria that user matches and add it to this field.</td>
</tr>
</tbody>
</table>

Note:
- If users have contribute access to the knowledge base, they also have read access to the knowledge article regardless of the Cannot Read setting.
- Users who meet both Can Read and Cannot Read user criteria are denied read access to the knowledge article. The Cannot Read setting overrides the Can Read setting for the knowledge article.
Note: If the Can Read and Cannot Read fields aren't visible, configure the Knowledge form to display them. For more information, see Configuring the form layout.

3. On the Knowledge form, click Update, and then click Publish to apply the changes.

What to do next
After you add user criteria, you can use the user criteria diagnostics feature to verify the access users have to a knowledge base or a knowledge article. For more information, see User criteria diagnostics for Knowledge Management.

Important: After making user criteria additions or changes, you may need to log out and log back in to clear the prior configuration.

Related information
- Create user criteria for controlling access to knowledge bases and articles
- Control access at the knowledge base level through user criteria

User criteria diagnostics for Knowledge Management
Manage user access to a knowledge base or an article using user criteria diagnostics. Understand what access users have to a knowledge base or an article and determine which user criteria define those permissions.

User access to a knowledge base or an article can be restricted based on:
- Domain separation
- Access control list (ACL) rules
- Knowledge workflows
- User criteria set for a knowledge base or an article

This feature considers domain separation and user criteria to determine the user access to knowledge bases and articles.

Activation information
The user criteria diagnostics feature is activated with the Knowledge Management v3 plugin (com.snc.knowledge3). For more information, see Activate a plugin.

Diagnose user access to a knowledge base
Identify which users have access to a knowledge base and what enables that access.
Before you begin
Role required: knowledge_manager, knowledge_admin, or admin

Procedure
1. Access the User Criteria Diagnostics landing page using one of these options:

<table>
<thead>
<tr>
<th>To access</th>
<th>Navigate to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the application</td>
<td>Knowledge &gt; Administration &gt; User Criteria Diagnostics</td>
</tr>
<tr>
<td>navigator</td>
<td></td>
</tr>
<tr>
<td>From a knowledge base</td>
<td>a. Knowledge &gt; Administration &gt; Knowledge Bases.</td>
</tr>
<tr>
<td></td>
<td>b. Select the knowledge base to diagnose user access.</td>
</tr>
<tr>
<td></td>
<td>c. In the Related Links section, click Run User Criteria Diagnostics.</td>
</tr>
</tbody>
</table>

The User Criteria Diagnostics landing page appears with the Select knowledge base field pre-populated.

2. To diagnose user access:
   a. In the Select user field, select a user.
   b. From the Select record type choice list, select Knowledge base.
   c. In the Select knowledge base field, select a knowledge base.
      Every time you select a different user, record type, or knowledge base, the page refreshes and displays data for the selected user.
   d. Click Diagnose.
      The page displays these details:
      • Whether the user has access to the knowledge base based on their domain. Only system administrators can view domain information and change the domain to give access to a user.
      • Which user criteria provides read or read and contribute access for this user to the knowledge base and what type of user criteria definition enables this access.
• Whether a role that the user has (knowledge_manager, knowledge_admin, or owner of the knowledge base) enables this access.

• For a user with no access to this knowledge base, which user criteria may be modified to grant the access.

Example:
The following image shows an example of a diagnosis where the user Alene Reback does not have access to the IT knowledge base.

Alena can get access to the knowledge base if:

• Alena is added to one of the existing user criteria defined in the knowledge base.

• Alena is added to a new user criteria that is defined and added to the knowledge base.

Click the IT knowledge base link and provide the access by adding Alena to a user criteria for this knowledge base.
Diagnose user access to an article

Identify which users have access to an article and what enables that access.

Before you begin
Role required: knowledge_manager, knowledge_admin, or admin

Procedure
1. Access the User Criteria Diagnostics landing page using one of these options:

<table>
<thead>
<tr>
<th>To access</th>
<th>Navigate to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the application navigator</td>
<td>Knowledge &gt; Administration &gt; User Criteria Diagnostics.</td>
</tr>
</tbody>
</table>
To access | Navigate to
--- | ---
From an article | a. Knowledge > Administration > Knowledge Bases.  
b. Select the knowledge base that has the article to diagnose for user access.  
c. In the Knowledge related list, select the article.  
d. In the Related Links section, click Run User Criteria Diagnostics.  
   The User Criteria Diagnostics landing page appears with the Select article field pre-populated.

2. To diagnose user access:

   a. In the Select user field, select a user.

   b. From the Select record type choice list, select Article.

   c. In the Select article field, select an article.  
      Every time you select a different user, record type, or knowledge base, the page refreshes and displays data for the selected user.

   d. Click Diagnose.  
      The page displays these details:

      • Whether or not the user has access to the knowledge article based on their domain. Only system administrators can view domain information and change the domain to give access to a user.

      • Which user criteria provides read or read and contribute access for this user to the article and what type of user criteria definition enables this access.

      • Whether a role of the user has (knowledge_manager, knowledge_admin, or owner of the knowledge base) enables this access.

      • For a user with no access to this article, which user criteria may be modified to grant the access.

   i Note: Members of an ownership group are automatically given Can Contribute access to knowledge articles that their ownership group is associated with.
Example:
The following image shows an example of a diagnosis where the user Adela Cervantsz has read access to the KB article, KB0000001 v5.0, in the IT knowledge base because Adela belongs to one of the Can Read user criteria defined in the knowledge base.

Configure access to knowledge bases for unauthenticated users
Identify knowledge bases accessible to unauthenticated users based on the user criteria and the system property settings.

Before you begin
Role required: knowledge_manager, knowledge_admin, or admin

Procedure
1. Navigate to Knowledge > Administration > User Criteria Diagnostics.
2. Click the View knowledge bases accessible to unauthenticated users related link.
3. Review knowledge bases accessible to unauthenticated users.
4. **Optional:** Restrict unauthenticated users to access a knowledge base by selecting the knowledge base and configuring its access settings.
   - Use user criteria to determine access to the knowledge base for unauthenticated users.
     
     (Optional) For more information, see Managing access to knowledge bases and knowledge articles.

   - If no user criteria is specified for the knowledge base, as an administrator, you can set the value of the `glide.knowman.block_access_with_no_user_criteria` system property to `true`.
     
     For more information, see Knowledge Management properties.

**Collect knowledge usage metrics**

Capture metrics such as article views, page views, and portal searches to track aggregated knowledge usage by users.

**Before you begin**

Set the duration over which the metrics are aggregated through the `glide.knowman.usage_metrics_duration` property. For more information, see Other knowledge properties. By default, the property value is set to 60 minutes.

Role required: admin

**About this task**

Monitor the knowledge usage metrics to improve the overall effectiveness of the knowledge usage across the portals.

**Procedure**

1. Navigate to **System Definition > Scheduled Jobs**.

2. Search and open the **Knowledge Usage Metrics** scheduled job.

3. In the **Knowledge Usage Metrics** form, select the **Active** check box to activate the scheduled job.
   
   The scheduled job is inactive by default.

4. In the **Run** field, select **Periodically** as the frequency of the scheduled job.
   
   See the Scheduled jobs topic for other frequency options.

5. In the **Repeat Interval** field, enter the repeated time interval at which the scheduled job should run.
   
   By default, the duration is set to 60 minutes.

6. Click **Update**.
What to do next
Modify the data retention policy for knowledge usage metrics to remove unwanted and older data from the knowledge usage metrics [kb_usage_metrics] table.

Modify the data retention policy for knowledge usage metrics
Remove unwanted and older data from the knowledge usage metrics [kb_usage_metrics] table through the data retention policy.

Before you begin
Role required: admin

About this task
Activating the data retention policy for the kb_usage_metrics table deletes records that you no longer need.

Procedure
1. Navigate to System Maintenance > Table Cleanup.
2. In the Tablename column, search for kb_usage_metrics and click the kb_usage_metrics link.
3. On the Auto Flush form, activate the kb_usage_metrics table cleanup job by selecting the Active check box.
4. Optional: Adjust the duration the system waits before deleting the records by modifying the value in the Age in seconds field. By default, the Age in seconds field value is set to 2,592,000 seconds (equivalent to 30 days). For more information, see Autoflush form.
5. Click Update.

I18N - Knowledge internationalization
Organizations with knowledge users who speak multiple languages can activate the optional knowledge internationalization features.

Activating internationalization plugins for any of the available languages automatically activates the I18N: Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2).

When active, knowledge internationalization enables the knowledge management team to create language-specific knowledge articles and keep translations of the same article related to each other so they are easy to manage. Users can view and search within their own language while still being able to view articles in other languages when necessary.
Note: To set the default language for searching articles to a language different from the logged in language of the user, specify the desired language in the `glide.knowman.search.default_language` system property. For example, if you are logged in using the French language and would like the default language for searched articles to be English, specify English in the system property. You can then switch to French from within the UI to see French articles. If no language is specified in the system property, articles default to the logged in language of the user.

To enable search for different languages simultaneously, navigate to Knowledge Administration > Knowledge Search > Properties > Enable multi language search. Select the Yes check box to enable the feature.

Note: If you do not enable this property, you can search in one language at a time. If the property is enabled, you can search for multiple languages simultaneously.

Refer to Search using Knowledge Management v3 for information on performing a search on all available languages simultaneously.

Activate the knowledge management internationalization plugin

To enable translation of knowledge articles, you must activate multiple plugins.

- I18N:Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2). For more information, see Activate a plugin.

- Internationalization plugins for each appropriate language. For more information, see Activate a language

Note: Activating internationalization plugins for any of the available languages automatically activates the I18N: Internationalization plugin (com.glide.i18n) that instead activates the I18N: Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2).

Installed components

The I18N:Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2) installs the following components:

- A relationship named Translated Versions that creates a related list on the Knowledge form showing other articles that have the same parent article.

- A business rule named knowledge query that automatically filters the knowledge portal and search results based on the user’s selected language.
• A UI macro named \textit{kb languages}.

• Two fields, named \textit{Language} and \textit{Parent}, in the Knowledge [kb_knowledge] table and the Knowledge form.

\textbf{Knowledge form changes}

The I18N:Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2) adds the following fields to the Knowledge form:

• \textit{Language}: Language in which you are creating the knowledge article. The list is populated based on the languages enabled for the selected knowledge base.

• \textit{Parent}: Number of the article that represents the base language article. This setting keeps translations of the same article related to each other. Consider choosing the same language consistently for the parent article.

\textbf{i} \textbf{Note}: The \textit{Parent} field is used for keeping track of translations of articles.

Additionally, the Translated Versions related list is automatically added to the Knowledge form after you save an article.

\textbf{Related information}

Configure Knowledge Management

\textbf{Ownership groups}

Configure ownership groups and associate them with knowledge articles to maintain article quality, manage approvals, and for timely resolution of feedback.

For the ease of maintenance of knowledge articles, you can assign an ownership group to a knowledge article and shift the ownership of an article from a single person to a group. An ownership group consists of a group of members and a manager who are responsible for knowledge articles. Responsibilities include: approving knowledge articles, performing AQI checks to ensuring article quality, and managing feedback tasks for knowledge articles.

When a knowledge article is assigned to an ownership group:
• Only ownership group members have contribute access to the article even if they don't have contribute access to the knowledge base of the article. They can edit, approve, publish, and retire the knowledge article with which they are associated.

• Users who aren't a member of the ownership group can't contribute to the article even if they have contribute access to the knowledge base of the article.

When creating or editing a knowledge article, you may need to configure the Knowledge form to add the Ownership Group field.

Activation information
To enable the use of ownership groups, enable the glide.knowman.ownership_group.enabled property. This property is available when the Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated. By default, the property is disabled.

Note: If you use ownership groups, try not to disable the glide.knowman.ownership_group.enabled property later. If you must disable the property later, ensure that you manually reassign all knowledge articles associated with any ownership group, close all article approvals sent to ownership groups, and resolve all open feedback tasks assigned to ownership groups.

Contribute access to published articles
If an ownership group is associated with a knowledge article, the author or reviser of the article can't contribute to the article after the article is published. You can override this behavior by enabling the glide.knowman.ownership_group.override property. When the property is set to true, the authors or revisers of knowledge articles associated with ownership groups retain contribute access to their published articles. By default, the property is set to false.

Approval of self-authored articles for ownership group members
With an ownership group associated with a knowledge article, ownership group members can approve self-authored articles for publication. You can override this behavior by disabling the glide.knowman.ownership_group.enable_self_approval property. By default, the property is set to true. When the property is set to false, ownership group members can't approve self-authored knowledge articles.
Related reference

Knowledge Management properties

Manage ownership groups
Create ownership groups and associate them to knowledge articles. Knowledge group managers or knowledge administrators can edit ownership groups.

Before you begin
The Knowledge Management Advanced plugin (com.snc.knowledge_advanced) must be activated.
Role required: Users with the knowledge_domain_expert or knowledge_admin roles can create ownership groups.
Users with the knowledge_group_manager or knowledge_admin roles can edit ownership groups.

About this task
Create an ownership group by adding members and a manager. Knowledge administrators approve ownership groups.
When knowledge articles are created, ownership groups can be associated to them. Ownership groups manage article approvals and feedback and can edit and retire knowledge articles that they are associated with.
Knowledge group managers can edit ownership groups managed by them by adding or removing members without the need for approval. They cannot change the manager assigned in their groups. Only knowledge administrators can reassign managers.

Procedure
1. Navigate to Knowledge > Ownership Groups > Manage Group.
2. To create an ownership group, from the Request Type list, select Create Ownership Group.
   Note: To edit an existing ownership group, from the Request Type list, select Edit Ownership Group.
3. Fill in the fields on the form.

Manage Knowledge Ownership Group form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the ownership group.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Group email| An email address for the ownership group. Emails are sent to group members in these cases.  
  • Activity on articles they are associated with, for example, comments.  
  • Article quality checks (AQI) performed on articles they are associated with.  
  If no group email is defined, emails are sent to individual group member emails. |
| Description| Description that defines the ownership group.                                                                                                                                                        |
| Manager    | Manager for the ownership group.                                                                                                                                                                     |
| Group members | Members of the ownership group.                                                                                                                                                                      |

4. Click **Order Now**.  
The ownership group is sent to the knowledge administrator for approval. Once approved, the ownership group is ready to use and associate to a knowledge article.

> **Note:** You can also create an ownership group from an existing group.  
  a. Navigate to **System Security > Users and Groups > Groups**.  
  b. Click a group.  
  c. In the **Type** field, enter **Knowledge**.

> **Note:** If the **Type** field does not appear on the form, configure the form layout to add it.

  d. In the **Manager** field, enter a manager and add the role **knowledge_group_manager**.  
  e. In the Roles related list, click **Edit** and add the role **knowledge_group_member** to the group.

**Configure the Knowledge Management Service Portal**

The Knowledge Management Service Portal enables users to perform the same operations that are available with the Knowledge Management V3 plugin. From the portal, users can view knowledge bases and articles, search for information, sort and filter search results, and provide feedback.
• For new customers on the Madrid and later releases, the Knowledge Management Service Portal plugin (com.snc.knowledge_serviceportal) is active by default.

• For existing customers on release versions prior to Madrid, activate the plugin, if required.

• Configure the Knowledge Management Service Portal properties, including the property that directs users to the Knowledge Management homepage in the Knowledge Management Service Portal.

• Navigate to Service Portal > Portals and click Knowledge Portal. See Service Portal for more information about creating a custom interface.

• System administrators can configure portal pages and configure widgets for searching, sorting, and filtering knowledge base information. To configure widget instance options and configure search, sort, and filter features, see Knowledge Management Service Portal widgets

• To add knowledge bases to the Knowledge Service Portal, complete the following steps.
  1. Navigate to Service Portal > Portals and click Knowledge Portal.
  2. Click the Knowledge Bases related list.
  3. Click Edit to map one or more knowledge bases to the portal.

  Note: If no knowledge bases are added, all knowledge bases are available in the portal.

  If knowledge bases are mapped, only those knowledge bases are available in the portal. All search results and all widgets display results from the mapped knowledge bases only.

Section 508 compliance features

Users can view and interact with the Knowledge Management article view page in the Knowledge Management Service Portal using Section 508 compliance features. See Enabling accessibility features for more information.

Related information

  Knowledge Management FAQs

Enable external or public users to view knowledge articles from the Knowledge Management Service Portal

Enable knowledge articles on the Knowledge Management Service Portal to be visible to external or public users.
Before you begin
The Knowledge Management Service Portal plugin (com.snc.knowledge_serviceportal) must be enabled.
Role required: admin

About this task
If you are using Knowledge Management within the Customer Service Management (CSM) application, you can automatically make knowledge articles public by activating and running the Make KM Service Portal Pages Public fix script after you install the Customer Service Management plugin (com.sn_customerservice).

If you are using Knowledge Management as a standalone application, perform the steps in this procedure.

Procedure

1. Navigate to Service Portal > Pages.

2. In the Pages list, search for and select kb_home.

   Note: If the application scope isn’t set to Knowledge Management - Service Portal, you cannot edit the form and a warning message appears. To make the form editable, click the word here at the end of the message.

3. Enable public or external users to view knowledge articles from the Knowledge Management Service Portal.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Make knowledge service portal pages visible to public users | a. On the Page form, select the Public check box.  
b. Click Update. |
| Make knowledge service portal pages visible to external users | a. On the Page form, in the Roles field, click the edit user roles icon.  
b. On the Roles form, move snc_external from the available roles in the Available column to the Selected column.  
c. On the Roles form, click Done.  
d. On the Page form, click Update. |
4. Repeat the steps 2 and 3 for **kb_article_view** and **kb_search** pages.

5. Manage access to the articles for the Knowledge Management Service Portal pages.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable access to the knowledge base for public.</td>
<td>After you set the page to public as described in step 3, ensure that the Cannot Read and Can Read user criteria are not set and the glide.knowman.block_access_with_no_user_criteria property is set to false for the knowledge bases you want to give access to public users.</td>
</tr>
<tr>
<td>Enable access to the knowledge base for external users.</td>
<td>After you add the snc_external role to the page as described in step 3, ensure that external users have read access to the knowledge bases for which you want to give access.</td>
</tr>
</tbody>
</table>

For more information about providing access to knowledge bases, see **Managing access to knowledge bases and knowledge articles**.

**Knowledge Management Service Portal properties**

Knowledge Management Service Portal properties determine how information is displayed on the Knowledge portal. You must have the admin role to set configuration properties.

The following system properties are set to direct users to the Knowledge Management Service Portal homepage, and to specify the URL suffix for the homepage.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_km_portal.glide.knowman.serviceportal.enable_redirect</td>
<td>Directs users to the desired Knowledge homepage.</td>
</tr>
<tr>
<td>• Type: true</td>
<td>false</td>
</tr>
<tr>
<td>• Default value: false</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>sn_km_portal.glide.knowman.serviceportal.portal_url</td>
<td>The URL suffix for the Knowledge Management Service Portal. The default is kb.</td>
</tr>
</tbody>
</table>

The Knowledge Management Service Portal supports the Knowledge Management V3 properties. Configuring widget instance options on the portal pages can override these properties.

**Knowledge Management Service Portal widgets**

The Knowledge Management Service Portal uses a number of widgets to enable searches, display search results, and display articles, related articles, and related items.

In the Knowledge Management Service Portal, the Knowledge Management homepage, search results page, and article view page honor the Knowledge Management V3 system properties. If configured, widget instance options can override the system properties.
Users with the knowledge_admin or admin role can configure the widget instance options used on the Knowledge Management Service Portal pages. Use the control + right-click menu to access the widget instance options and configure a widget instance. For more information, see Configure widget instance options.

⚠️ Note: Before configuring widget instance options, switch to the Knowledge Management - Service Portal scope.

Homepage widgets:

- **Knowledge Homepage Search**
  Customize search features for the homepage.
- **Knowledge Bases Browse**
  Displays knowledge base tiles in the homepage.
- **Knowledge Featured Articles**
  Displays a list of featured articles in the homepage.
- **Knowledge Most Useful Articles**
  Displays a list of most useful articles in the homepage.
- **Knowledge Most Viewed Articles**
  Displays a list of most viewed articles in the homepage.

Search results page widgets:

- **Knowledge Breadcrumbs**
  Displays navigation path to the current page and a search box for users to search the knowledge base.
- **Knowledge Search**
- **Knowledge Facet Header**
  Displays the title for the filter facets.
- **Knowledge Field Facet**
  Display search results filtered by knowledge base, knowledge category, and author.
- **Knowledge Tags Facet**
  Display search results filtered by article tags.
- **Knowledge Resource Facet**
  Display search results filtered by article resource.
• Knowledge Query Facet
  Display search results filtered by article rating, number of article views, and last modified.

• Knowledge Result Sort
  Displays search results filtered by sort options for returned results.

• Knowledge Selected Filter
  Displays the selected facet filters and allows you to clear the selections.

• Knowledge Result
  Displays search results filtered by returned results.

Article view page widgets:

• Knowledge Breadcrumbs
  Displays navigation path to the current page.

• Knowledge Article Content
  Customize what information users can view and what actions they can perform in the article view page.

• Knowledge Article Helpful
  Enables users to mark the article as helpful.

• Knowledge Article Comments
  Enables users to add comments for the article.

• Knowledge Attachments
  Displays article attachments if the Display Attachment field for the article is enabled.

  Note: You must add the Knowledge Attachments widget to any page in addition to Knowledge Article Content widget. After upgrade, if this widget does not get added automatically, you must add it manually.

• Related Catalog Item
  Displays a list of catalog items mapped to the article. The widget appears only when the related catalog items are available for the selected article.

• Knowledge Related Articles
  Displays a list of related articles with information similar to the selected article. The related articles are manually mapped, automatically predicted, or both. The manually mapped articles appear first in the widget. The widget appears only when the related articles are available for the selected article.
• Affected Products

Displays the products related to the knowledge articles available in the **Affected Products** related list for the article. The widget appears only when the affected products are available for the selected article.

• Most Recent Tasks

Displays the tasks attached to the articles available in the **Attached Tasks** related list for that article. The widget appears only when the related tasks are available for the selected article.

• Most Useful

Displays a list of knowledge articles that users found most useful.

### Activate the Knowledge Management Service Portal plugin

The Knowledge Management - Service Portal plugin (com.snc.knowledge_serviceportal) is active by default for customers on Madrid and later releases. Existing customers on release versions prior to Madrid can activate the plugin, if required.

**Before you begin**

Role required: admin

**About this task**

This plugin requires the following plugins:

• Knowledge Management V3 (com.snc.knowledge3)

• Service Portal for Enterprise Service Management (com.glide.service-portal.esm)

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.

2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Configure search widget instance options**

Configure widget instance options for the search widgets on the Knowledge Management Service Portal homepage and search results page.

**Before you begin**

Role required: sp_admin or admin

**About this task**

The homepage uses the Knowledge Homepage Search widget and the search results page uses the Knowledge Search widget. Use the widget instance options to customize the search feature for these pages.

**Procedure**

1. Navigate to the Knowledge Management Service Portal homepage or search results page.
2. Control + right-click the search bar.
3. Click **Instance Options**.
4. Configure the search widgets settings.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Page(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Knowledge Management Service Portal homepage</td>
<td>The title of the search widget. The default for the homepage is Welcome to Knowledge.</td>
</tr>
<tr>
<td>Search Placeholder</td>
<td>Knowledge Management Service Portal homepage</td>
<td>Default text that appears in the search bar.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Search result page</td>
<td>The color of the search widget.</td>
</tr>
<tr>
<td>Instance option</td>
<td>Page(s)</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bootstrap size</td>
<td>Search result page</td>
<td>The size of the search widget.</td>
</tr>
<tr>
<td>Allow Empty Search</td>
<td>Search result page</td>
<td>Allow empty knowledge base searches. The default for the homepage uses the system property. The default for the search results page is Yes.</td>
</tr>
<tr>
<td>Allow Instant Search On Keypress</td>
<td>Search result page</td>
<td>Enables instant search results as you type a search term. The default for the search results page uses the system property.</td>
</tr>
<tr>
<td>Wait time (ms) between searches, if instant search is enabled</td>
<td>Search result page</td>
<td>The time, in milliseconds, to wait between searches if the instant search feature is enabled. The default wait time is 500 ms.</td>
</tr>
<tr>
<td>Alternate URL Parameters for Search</td>
<td>Search result page</td>
<td>Alternate parameters that appear in the search results URL. By default these parameters include keyword and query.</td>
</tr>
<tr>
<td>Alternate URL Parameters for Language</td>
<td>Search result page</td>
<td>Alternate parameters that appear in the URL denoting the selected language.</td>
</tr>
<tr>
<td>Minimum Number of Characters for Search</td>
<td>Both</td>
<td>The minimum number of characters required to generate a search.</td>
</tr>
<tr>
<td>Glyph</td>
<td>Both</td>
<td>An icon that appears in the search bar.</td>
</tr>
<tr>
<td>CSS</td>
<td>Both</td>
<td>Custom configurations that determine the look</td>
</tr>
</tbody>
</table>
5. Click **Save**.

### Configure knowledge base tile widget instance options

Configure widget instance options for the knowledge base tile widgets on the Knowledge Management Service Portal homepage.

**Before you begin**

Role required: sp_admin or admin

**About this task**

The homepage uses the Knowledge Bases Browse widget to display knowledge base tiles.

**Procedure**

1. Navigate to the Knowledge Management Service Portal homepage.
2. Control + right-click a knowledge base tile.
3. Click **Instance Options**.
4. Configure the desired settings for the knowledge base tile widgets.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The title that appears above the knowledge base tiles. The default is <strong>Explore our Knowledge Bases</strong>.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>The color of the widget.</td>
</tr>
<tr>
<td>CSS</td>
<td>Custom configurations that determine the look and feel of the elements in the widget. For more information, see Service Portal SCSS Primer.</td>
</tr>
<tr>
<td>Order By</td>
<td>The order in which the knowledge base tiles appear on the homepage. Use any field on the Knowledge</td>
</tr>
</tbody>
</table>
Configure the home page widget instance options

Configure widget instance options for the widgets used to display popular articles on the Knowledge Management Service Portal homepage.

Before you begin
Role required: sp_admin or admin

About this task
The homepage displays links to the featured, most viewed, and most useful articles using several widgets. The featured articles are displayed based on the keywords associated with the articles. For information on displaying articles in the Featured content section, see Pin a knowledge article. Most viewed and most useful articles are displayed based on the highest view and use count of the articles.

Procedure
1. Navigate to the Knowledge Management Service Portal homepage.
2. Control + right-click one of the widgets.

5. Click Save.
3. Click **Instance Options**.
4. Configure the desired settings for the widget.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The title of the widget.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>The color of the widget.</td>
</tr>
<tr>
<td>Glyph</td>
<td>An icon that appears in the widget.</td>
</tr>
<tr>
<td>CSS</td>
<td>Custom configurations that determine the look and feel of the elements in the widget. For more information, see Service Portal SCSS Primer.</td>
</tr>
<tr>
<td>Table</td>
<td>The table that contains the <strong>Source Field</strong> used to provide the featured, most viewed, and most useful articles widget options. The default table is Knowledge (kb_knowledge).</td>
</tr>
<tr>
<td>Display Field</td>
<td>The title displayed for each article in the list. By default, this is the article short description.</td>
</tr>
<tr>
<td>Secondary Fields</td>
<td>Additional information displayed for each article in the list below the title. By default, this information includes the author, view count, the date that the article was last modified, and the article rating.</td>
</tr>
<tr>
<td>Max number of records to show</td>
<td>The maximum number of articles to include in the list.</td>
</tr>
<tr>
<td>Show even when empty</td>
<td>Enable this check box to display the widget even if there are no articles in the list.</td>
</tr>
<tr>
<td>Show Secondary Fields Label</td>
<td>Enable this check box to display the field labels for the additional information displayed for each article.</td>
</tr>
</tbody>
</table>
Configure sort widget instance options

Configure widget instance options for the knowledge sort widget on the Knowledge Management Service Portal search results page.

**Before you begin**

Role required: sp_admin or admin

**About this task**

The search results page uses the Knowledge Result Sort widget to provide sort options for the returned list of results. Use the widget instance options to customize the sort options.

**Procedure**

1. Navigate to the Knowledge Management Service Portal search results page.
2. Control + right-click the sort options at the top of the results list.
3. Click **Instance Options**.
4. Configure the desired settings for the sort widget.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Base</td>
<td>To restrict the articles that appear in this list to a specific knowledge base, select the knowledge base from the knowledge base list.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>The color of the search widget.</td>
</tr>
<tr>
<td>CSS</td>
<td>Custom configurations that determine the look and feel of the elements in the widget. For more information, see Service Portal SCSS Primer.</td>
</tr>
<tr>
<td>Hide Relevancy</td>
<td>Removes the relevancy sort option.</td>
</tr>
<tr>
<td>Table</td>
<td>The table that contains the fields used to sort the list of knowledge items. The default table is Knowledge.</td>
</tr>
</tbody>
</table>
Configure article list widget instance options

Configure widget instance options for the article lists on the Knowledge Management Service Portal homepage.

Before you begin
Role required: sp_admin or admin

About this task
The homepage uses the Article List widget to display different lists of articles, including Featured, Most Useful, and Most Viewed.

Procedure
1. Navigate to the Knowledge Management Service Portal homepage.
2. Control + right-click one of the article list headers.
3. Click Instance Options.
4. Configure the desired settings for the article list widget.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort Fields</td>
<td>The fields used for sorting the list of knowledge items.</td>
</tr>
<tr>
<td>Sort Field Labels</td>
<td>The labels for the fields that appear in the sort options. The default is Views:desc, Newest:desc, Alphabetical. The sort order for the sort field labels is ascending. To use a descending order, denote :desc.</td>
</tr>
<tr>
<td>Title</td>
<td>The title of the article list.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>The color of the widget.</td>
</tr>
<tr>
<td>Glyph</td>
<td>An icon that appears in the widget.</td>
</tr>
<tr>
<td>CSS</td>
<td>Custom configurations that determine the look and feel of the elements in the widget. For more</td>
</tr>
</tbody>
</table>

5. Click Save.
<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The table that stores the list articles.</td>
</tr>
<tr>
<td>Display Field</td>
<td>The title displayed for each article in the list. By default, this is the article short description.</td>
</tr>
<tr>
<td>Secondary Fields</td>
<td>Additional information displayed for each article in the list below the title. By default, this information includes the author, view count, the date that the article was last modified, and the article rating.</td>
</tr>
<tr>
<td>Max number of records to show</td>
<td>The maximum number of articles to include in the list.</td>
</tr>
<tr>
<td>Show even when empty</td>
<td>Enable this check box to display the article list even if it does not contain any articles.</td>
</tr>
<tr>
<td>Show Secondary Fields Label</td>
<td>Enable this check box to display the field labels for the additional information displayed for each article.</td>
</tr>
<tr>
<td>Knowledge Base</td>
<td>To restrict the articles that appear in this list to a specific knowledge base, select the knowledge base from the knowledge base list.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

**Configure search results list widget instance options**

Configure widget instance options for the results list widget on the Knowledge Management Service Portal search results page.

**Before you begin**

Role required: sp_admin or admin
About this task
The search results page uses the Knowledge Result widget to provide display options for the returned list of results. Use the widget instance options to customize the display options.

Procedure
1. Navigate to the Knowledge Management Service Portal search results page.
2. Control + right-click the list of returned search results.
3. Click Instance Options.
4. Configure the desired settings for the results list widget.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Glyph</td>
<td>An icon that appears in the search bar.</td>
</tr>
<tr>
<td>CSS</td>
<td>Custom configurations that determine the look and feel of the elements in</td>
</tr>
<tr>
<td></td>
<td>the widget. For more information, see Service Portal SCSS Primer.</td>
</tr>
<tr>
<td>Show Relevancy Score</td>
<td>Shows how relevant each search result is based on the search term. The</td>
</tr>
<tr>
<td></td>
<td>default setting uses the system property.</td>
</tr>
<tr>
<td>Breadcrumb: Hide Categories</td>
<td>Hides the category in the breadcrumb that appears below the article short</td>
</tr>
<tr>
<td></td>
<td>description in the results list. The default setting uses the system</td>
</tr>
<tr>
<td></td>
<td>property.</td>
</tr>
<tr>
<td>Breadcrumb: Knowledge Base</td>
<td>The character used as a separator between the knowledge base and the</td>
</tr>
<tr>
<td>Separator</td>
<td>category in the breadcrumb.</td>
</tr>
<tr>
<td>Breadcrumb: Category Separator</td>
<td>The character used as a separator between categories in the breadcrumb.</td>
</tr>
<tr>
<td>Default Sort Order</td>
<td>The default sort order for the list of returned results. The default sort</td>
</tr>
<tr>
<td></td>
<td>order is sys_view_count:desc, which sorts</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to Display Attachments in Knowledge Search Results</td>
<td>How attachments are shown in the list of returned results. The default uses the system property.</td>
</tr>
<tr>
<td>Label for Show Pinned Articles Link</td>
<td>The text used for the pinned articles link.</td>
</tr>
<tr>
<td>Table</td>
<td>The table that stores the information returned in the search results.</td>
</tr>
<tr>
<td>Knowledge Secondary Fields</td>
<td>Fields that display additional information for each article in the search results.</td>
</tr>
<tr>
<td>Show Secondary Fields Label</td>
<td>Enable this check box to display the field labels for the additional information displayed for each result.</td>
</tr>
<tr>
<td>Pagination Type</td>
<td>Controls how additional knowledge article search results are displayed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Standard Pagination</strong>: displays the search results in multiple pages.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Infinite Scroll</strong>: displays the search results while scrolling.</td>
</tr>
<tr>
<td></td>
<td>The default pagination type is set to <strong>Infinite Scroll</strong>.</td>
</tr>
<tr>
<td>Maximum no. of articles displayed per page with standard pagination</td>
<td>The maximum number of items included in a page when the search results list is displayed using standard pagination.</td>
</tr>
<tr>
<td>Maximum no. of articles displayed after first fetch during infinite scroll</td>
<td>The maximum number of items included when the search results list is first displayed using infinite scroll.</td>
</tr>
<tr>
<td>Maximum no. of articles displayed at subsequent fetches during infinite scroll</td>
<td>The maximum number of items included when the search results list updates as the user scrolls to the bottom.</td>
</tr>
</tbody>
</table>
Configure filter facet widget instance options

Configure widget instance options for the filter facet widgets on the Knowledge Management Service Portal search results page.

Before you begin
Role required: sp_admin or admin

About this task
The homepage uses several widgets to filter the items in the search results list. There are two types of facet widgets:

• Simple field facets based on the Knowledge table fields
• Advanced query facets based on custom queries of the Knowledge table

Use the widget instance options to customize these facet widgets:

• Knowledge Field Facet (for filtering by knowledge base, knowledge category, and author)
• Knowledge Tags Facet (for filtering by tag)
• Knowledge Resource Facet (for filtering by resource, such as articles)
• Knowledge Query Facet (for filtering by rating, last modified, and number of views)

Note: Query facets are displayed when there's at least one knowledge field facet added to the page.

Procedure
1. Navigate to the Knowledge Management Service Portal search results page.
2. Control + right-click a filter facet widget.
3. Click Instance Options.
4. Configure the desired settings for the selected type of facet widget.

5. Click Save.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. of links in pagination bar</td>
<td>The number of links displayed in the pagination bar.</td>
</tr>
<tr>
<td>Instance option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Title</td>
<td>Title of the filter facet widget.</td>
</tr>
<tr>
<td>Glyph</td>
<td>Icon that appears to the left of the title.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the filter facet widgets appear on the left side of the search results page. If empty, the filter facet widgets sort alphabetically.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color of the filter facet widget header.</td>
</tr>
<tr>
<td>CSS</td>
<td>Custom configurations that determine the look and feel of the elements in the widget. For more information, see Service Portal SCSS Primer.</td>
</tr>
<tr>
<td>Source Table</td>
<td>Table that contains the Source Field used to provide the filter facet widget options. The default table is Knowledge (kb_knowledge).</td>
</tr>
<tr>
<td>Source Field</td>
<td>Field in the Source Table that provides the filter facet widget options. Field types that can be used as a source field include string, choice, glide list, integer, reference, and boolean.</td>
</tr>
<tr>
<td>Facet Identifier</td>
<td>Unique name for the custom query facet that can be used in script code.</td>
</tr>
</tbody>
</table>
| Facet Template  | Template that determines the type of facet interaction. Knowledge Field Facet widget templates:
<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Single Select</strong>:</td>
<td>users can select only one filter from this widget.</td>
</tr>
<tr>
<td><strong>Multi Select</strong>:</td>
<td>users can select more than one filter from this widget.</td>
</tr>
<tr>
<td><strong>Dropdown Select</strong>:</td>
<td>users can select more than one filter from a dropdown menu.</td>
</tr>
<tr>
<td>Knowledge Query Facet widget</td>
<td>templates</td>
</tr>
<tr>
<td><strong>Simple Query</strong>:</td>
<td>shows a label for each facet value.</td>
</tr>
<tr>
<td><strong>Rating</strong>:</td>
<td>shows rating stars.</td>
</tr>
<tr>
<td>Custom Template</td>
<td>Custom template that determines facet interaction and value selection.</td>
</tr>
<tr>
<td>Facet Options</td>
<td>Custom query in JSON format for the label, ID, order, and query for each facet value. Includes the table, value (encoded query), and display value (encoded query).</td>
</tr>
<tr>
<td>Order by</td>
<td>Order of the filter options within the facet widget. The default order is label, which sorts the options in alphabetical order. For reference fields, you can also state an order from the reference field table.</td>
</tr>
<tr>
<td>Minimum results for showing filter search bar</td>
<td>Minimum number of results required to display a search bar at the top of the filter facet widget.</td>
</tr>
<tr>
<td>Minimum results for showing scroll bar</td>
<td>Minimum number of results required to display a scroll bar in the filter facet widget.</td>
</tr>
<tr>
<td>Maximum length for string field</td>
<td>Maximum field length. Only fields whose length is less than this value are allowed to be added as a filter facet.</td>
</tr>
<tr>
<td>Instance option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Alternate URL Parameters</td>
<td>Names of the URL parameters used to initialize this filter facet, if used in the URL as a search parameter.</td>
</tr>
<tr>
<td>Fetch Maximum Values</td>
<td>Option to fetch filter values from all knowledge articles in the search results. Selecting the Fetch Maximum Values option might impact the load time for search results. If this option is disabled, the load time improves based on the glide.knowman.search.facet_depth property value. If the glide.knowman.search.apply_acls property is set to true, a filter value can appear in a filter facet even when there are no search results for that filter value. For example, a knowledge base without any articles might appear as a value in the knowledge base filter facet.</td>
</tr>
<tr>
<td>Show Empty Value</td>
<td>If enabled, shows an empty filter facet option that users can select to filter for articles that do not have this field set. For example, if an article does not have an assigned category, clicking the empty option lists all articles with no assigned category.</td>
</tr>
<tr>
<td>Show Only Facet Values Matching Results</td>
<td>Creates a dynamic filter facet widget that displays only those filter values that match the search results rather than showing all values. If you disable this instance option, the time needed to load the filter facet data is reduced.</td>
</tr>
</tbody>
</table>
| Show category hierarchy (valid for kb_category only)      | If enabled, shows categories with their hierarchy list up to the fourth-
<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>level. When you enable this option, you can select only one category at a time. Any articles that are included in the subcategories beyond the fourth-level also appear in the fourth-level of category. The search results filtered on a selected parent category include articles within that category and all the associated child categories.</td>
</tr>
</tbody>
</table>

**Note:** If the number of knowledge articles returned in search results is greater than the search facet depth, all categories are displayed in this facet. Therefore, some categories shown in this facet might not be associated with any knowledge articles in the search results. By default, the facet depth is set to 300 and configured by an administrator in the `glide.knowman.search.facet_depth` property.

5. Click **Save**.

**Related reference**

Knowledge Management properties

**Configure a user action for the article view page**

Configure a user action for the Knowledge Management article view page in the Knowledge Management Service Portal.

**Before you begin**

Role required: sp_admin or admin

**About this task**

The article view page uses the Knowledge Article Content widget to provide user actions. Use the widget instance options to customize these actions.
Ensure that the application scope on the Now Platform is set to Knowledge Management Service Portal.

User actions available for the article view page appear in a menu after clicking the overflow icon (…) in the article header. These actions enable users to flag an article, edit an article, or create an incident for an article.

**Procedure**

1. Navigate to the Knowledge Management Service Portal article view page.
2. Control + right-click the article header.
3. Click **Instance Options**.
4. Configure the desired settings for the Knowledge Article Content widget.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>The color of the widget header.</td>
</tr>
<tr>
<td>CSS</td>
<td>Custom configurations that determine the look and feel of the elements in the widget. For more information, see Service Portal SCSS Primer.</td>
</tr>
<tr>
<td>Hide All Actions</td>
<td>Hides the user actions in the article header including the <strong>Subscribe/Unsubscribe</strong> button and the overflow icon.</td>
</tr>
<tr>
<td>Show Version Information</td>
<td>Displays version information for the selected article. Requires the Knowledge Management Advanced plugin (com.snc.knowledge_advanced).</td>
</tr>
<tr>
<td>Show Create Incident Action</td>
<td>Displays the <strong>Create Incident</strong> user action when a user clicks the overflow icon in the article header.</td>
</tr>
<tr>
<td>Create Incident Action Label</td>
<td>The label for the user action that appears in the overflow icon menu. The default is <strong>Create Incident</strong>.</td>
</tr>
<tr>
<td>Create Incident Action URL</td>
<td>The target URL for the <strong>Create Incident</strong> user action.</td>
</tr>
</tbody>
</table>
Configure article helpful widget instance options

Configure the Knowledge Article Helpful widget instance options for the Knowledge Management article view page in the Knowledge Management Service Portal.

**Before you begin**
Role required: sp_admin or admin

**About this task**
The article view page uses the Knowledge Article Helpful widget to allow users to provide feedback on the helpfulness of the article, display a confirmation message after a feedback is provided, and display the percentage of users who found the article to be useful. Use the widget instance options to customize these actions.

**Procedure**
1. Navigate to the Knowledge Management article view page in the Knowledge Management Service Portal.
2. Control + right-click Helpful?
3. Click Instance Options.
4. Configure the desired settings for the Knowledge Article Helpful widget.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>The color of the widget header.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

If no URL is specified, the system uses the URL in the `glide.knowman.create_incident_link` system property.

Redirects the article view page to the latest accessible version of the article, if available. Disable the **Show Version Information** option to hide the version information on the article view page because any version link will redirect to the latest version only.
## Configure article comments instance options

Configure the Knowledge Article Comments widget instance options for the Knowledge Management article view page in the Knowledge Management Service Portal.

### Before you begin

**Role required:** sp_admin or admin

### About this task

The article view page uses the Knowledge Article Comments widget to allow users to rate an article, add a comment, or view existing comments for the article. Use the widget instance options to customize these actions.

### Procedure

1. Navigate to the Knowledge Management article view page in the Knowledge Management Service Portal.
2. Control + right-click the comments section.
3. Click **Instance Options**.
4. Configure the desired settings for the Knowledge Article Comments widget.

### Instance option and Description

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSS</td>
<td>Custom configurations that determine the look and feel of the elements in the widget. For more information, see Service Portal SCSS Primer.</td>
</tr>
<tr>
<td>Show helpful percentage information</td>
<td>Check box to enable the display of percentage of users who found this article to be helpful.</td>
</tr>
<tr>
<td>Helpful Action Label</td>
<td>Label for marking this article as helpful or not.</td>
</tr>
<tr>
<td>Feedback Message</td>
<td>Text that displays when the user marks the article as helpful or not.</td>
</tr>
</tbody>
</table>

5. Click **Save**.
<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSS</td>
<td>Custom configurations that determine the look and feel of the elements in the widget. For more information, see Service Portal SCSS Primer.</td>
</tr>
</tbody>
</table>

**Other Options**

<table>
<thead>
<tr>
<th>Show User Comments</th>
<th>Displays the field for users to enter comments.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available options:</td>
<td></td>
</tr>
<tr>
<td>• Yes - displays the field that enables users to enter comments for the article.</td>
<td></td>
</tr>
<tr>
<td>• No - hides the field that enables users to enter comments for the article.</td>
<td></td>
</tr>
<tr>
<td>• Use system property - display or hide the comments field using article view properties.</td>
<td></td>
</tr>
</tbody>
</table>

| Add Comment Label                      | Label for the field to add comments.                                                                                                                                 |

| Maximum number of attachments that can be attached to a comment | Maximum number of attachments that can be attached to a comment included for a knowledge article. |

| Maximum attachment file size in MB that can be attached to a comment | Maximum attachment file size in MB that can be attached to a comment included for a knowledge article. |

5. Click **Save**.

**Configure related catalog item widget instance options**

Configure the Related Catalog Item widget instance options for the Knowledge Management article view page in the Knowledge Management Service Portal. These options relate to the list of catalog items mapped to an article.

**Before you begin**

Role required: sp_admin or admin
About this task
The knowledge article view page displays the Related Items section when an article has related catalog items. Use the widget instance options to customize the Related Items section on the article view page.

Procedure
1. Navigate to the Knowledge Management homepage in the Knowledge Management Service Portal by adding /kb to the end of your instance URL.

   Note: Your administrator might have changed this default navigation.

2. Search for and click the article for which you want to modify the instance options for the Related Catalog Item widget.

3. Press Control and right-click the Related Items section.

4. Click Instance Options.

5. Configure settings for the Related Catalog Item widget.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Table</td>
<td>Source table containing related catalog items. The source table specified in the base system is Related Catalog Items (kb_2_sc).</td>
</tr>
<tr>
<td>Source Column</td>
<td>Field in the source table referring to the source record. The source column specified in the base system is Knowledge article (kb_knowledge).</td>
</tr>
<tr>
<td>Title</td>
<td>Title that appears on the widget header. The default title is Related Items.</td>
</tr>
<tr>
<td>Max Number</td>
<td>Maximum number of catalog items to include in the Related Items section on the article view page. The maximum number specified in the base system is 5.</td>
</tr>
<tr>
<td>Use Full Width</td>
<td>Option for displaying the widget in a 12-column grid at 100% of the available width. If you clear the check box, the widget displays at 75% of the available width.</td>
</tr>
</tbody>
</table>
## Instance option | Description
--- | ---
Target Column | Field in the source table referring to the target record. The target column specified in the base system is Catalog item (sc_cat_item).
Source Id | URL parameter containing the unique record identifier (sys_id) of the source record. For the article view page, the URL parameter containing the source ID is sys_kb_id.

6. Click **Save**.

### Related information

**Map catalog items related to an article**

**Configure knowledge related articles widget instance options**

Configure the Knowledge Related Articles widget instance options for the Knowledge Management article view page in the Knowledge Management Service Portal. These options relate to the list of related articles mapped to an article.

**Before you begin**

Role required: sp_admin or admin

**About this task**

The knowledge article view page displays the Related Articles section when an article has related articles. Use the widget instance options to customize the Related Articles section on the article view page.

**Procedure**

1. Navigate to the Knowledge Management homepage in the Knowledge Management Service Portal by adding `/kb` to the end of the URL for your instance.

   ![Note]
   You can change the default navigation by configuring the property `sn_km_portal.glide.knowman.serviceportal.portal_url`.

2. Search for and click the article for which you want to modify the instance options for the Knowledge Related Articles widget.

3. Press Control and right-click the Related Articles section.

4. Click **Instance Options**.
5. Configure settings for the Knowledge Related Articles widget.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title that appears on the widget header. The default title is Related Articles.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme of the widget header. Select a color for your widget from a list of common bootstrap colors.</td>
</tr>
<tr>
<td>Glyph</td>
<td>Icon that appears beside each list item displayed in the widget. To skip this field, select the empty glyph.</td>
</tr>
<tr>
<td>CSS</td>
<td>Custom configurations that determine the look and feel of the elements in the widget. For more information, see Service Portal SCSS Primer.</td>
</tr>
<tr>
<td>Use Full Width</td>
<td>Option for displaying the widget in a 12-column grid at 100% of the available width. If you clear the check box, the widget displays at 75% of the available width.</td>
</tr>
<tr>
<td>Table</td>
<td>The table that contains the knowledge articles associated with the Display Fields and Secondary Fields. By default, the table is Knowledge (kb_knowledge).</td>
</tr>
<tr>
<td>Display Field</td>
<td>The title displayed for each article in the related articles list. The display field specified in the base system is the article short description.</td>
</tr>
<tr>
<td>Secondary Fields</td>
<td>Additional information displayed for each article in the list below the title. The secondary fields specified in the base system are author, view count, the last modified date of the article, and the article rating.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max number of records to show</td>
<td>The maximum number of articles to include in the Related Articles section on the article view page. The maximum number specified in the base system is 5.</td>
</tr>
<tr>
<td>Show even when empty</td>
<td>Option for displaying the widget even if no articles are in the list.</td>
</tr>
<tr>
<td>Show Secondary Fields Label</td>
<td>Options for displaying the field labels for the additional information displayed for each article.</td>
</tr>
<tr>
<td>Knowledge Base</td>
<td>To restrict the articles that appear in this list to a specific knowledge base, select the knowledge base from the knowledge base list.</td>
</tr>
<tr>
<td>Source Table</td>
<td>Source table containing related articles. The source table specified in the base system is Knowledge (kb_2_kb).</td>
</tr>
<tr>
<td>Source Column</td>
<td>Field in the source table referring to the source record. The source column specified in the base system is Knowledge article (kb_knowledge).</td>
</tr>
<tr>
<td>Target Column</td>
<td>Field in the source table referring to the target record. The target column specified in the base system is Knowledge article (kb_knowledge).</td>
</tr>
<tr>
<td>Source Id</td>
<td>URL parameter containing the unique record identifier (sys_id) of the source record. For the article view page, the URL parameter containing the source ID is sys_kb_id.</td>
</tr>
</tbody>
</table>

6. Click **Save**.

Related reference

Knowledge Management Service Portal properties

Related information

Map related articles
Search using the Knowledge Management Service Portal

Enter one or more words in the search bar on the Knowledge Management Service Portal homepage to view all search results.

Search results include items in which the short description, content, or attached files include the search term. By default, knowledge search results include articles, pinned articles, and social Q&A.

You can also filter the search results.

Enable multi-language search

The multi-language search facet is available when more than one supported language is enabled. All available languages are displayed in the facet and you can select which languages you want your search results to appear in. Your selection is maintained per session, but not across logins.

1. To enable different languages, activate the I18N: Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2) or activate one of the internationalization plugins for the language you require.

   Note: Activating internationalization plugins for any of the available languages automatically activates the I18N: Knowledge Management Internationalization Plugin v2 plugin.

2. Navigate to Knowledge > Administration > Knowledge Search Properties > Enable multi language search.

3. Select the Yes check box to enable the feature.

   Note: If this property is not enabled, you can only search for one language at a time.

Search auto-correct feature

The Knowledge Management Service Portal homepage search tool also includes an auto-correct feature. When enabled, users can auto-correct a typing error in a search term by clicking one of the suggestions.

When a search term contains a misspelling, the search tool displays the search results page and includes one or more suggested terms at the top of the page under the heading Did you mean. Clicking one of these suggestions shows all the search results that match the selected term.

Users with the system administrator role can enable this feature.

1. Navigate to System Properties > Text Search.

2. Set the following properties to true:
- Suggest alternate search spellings for knowledge or global search (glide.ts.dym.enable_spell_correct).
- Suggest related searches for knowledge or global search (glide.ts.dym.enable_chain_suggest).

3. Click **Save**.

**Integrating Knowledge Management features with the Service Portal**

To create a consistent user experience for Knowledge Management, integrate Knowledge Management Service Portal in your end-user facing Service Portal. The Knowledge Management Service Portal includes the following features:

- Multiple knowledge bases
- A Knowledge Management article view page with feedback options
- A Knowledge Management search results page with options to filter and sort search results
- A number of widgets to enable searches, display search results, display knowledge articles, and so on

By default, all knowledge articles in the Service Portal are redirected to the Knowledge Management article view page using the **Knowledge Article View** page route map. If upgrading from a previous release, a system administrator can activate the **Knowledge Article View** page route map to take advantage of the features of the Knowledge Management article view page. For more information, see **Activate the Knowledge Article View page on upgrade**.

System administrators perform the following tasks to integrate the Knowledge Management Service Portal features with the Service Portal:

- Integrate the Knowledge Management homepage with the Service Portal homepage.
- Integrate the Knowledge Management search results page with the Service Portal search results page.
- Add the Knowledge Management Service Portal widgets to quickly access knowledge articles from the Service Portal homepage (Optional).

**Note:** These configurations apply to the base system pages within the Service Portal only.
Related information

Service Portal pages
Knowledge Management Service Portal homepage features
Knowledge Management Service Portal search results page features
Knowledge Management Service Portal article view page features

Integrate the Knowledge Management homepage with the Service Portal homepage

Use a page route map to access the enhanced Knowledge Management homepage from the Service Portal homepage.

Before you begin

The Knowledge Management - Service Portal plugin (com.snc.knowledge_serviceportal) is activated.

Note: This plugin is activated by default for customers on Madrid and later releases. Existing customers on release versions prior to Madrid must activate the plugin to perform this configuration task. For more information, see Activate the Knowledge Management Service Portal plugin.

Role required: admin

About this task

The Knowledge Management homepage displays knowledge articles organized by knowledge base and category, featured content, and popular articles. You use a page route map to access the Knowledge Management homepage from the Service Portal homepage.

Procedure

1. Navigate to Service Portal > Page Route Maps.
2. Click New.
3. On the Page Route Map form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal(s)</td>
<td>Service Portal</td>
</tr>
<tr>
<td>Route from</td>
<td>kb_view2</td>
</tr>
<tr>
<td>Route to</td>
<td>kb_home</td>
</tr>
<tr>
<td>Active</td>
<td>Selected</td>
</tr>
</tbody>
</table>
Note: On the Page Route Map form, you can fill in the **Short Description** and **Order** fields as appropriate.

4. Click **Submit**.

**Results**

You can now open the Knowledge Management homepage from the Service Portal homepage by clicking the Knowledge link or Knowledge Base icon link.

**Integrate the Knowledge Management search results page with the Service Portal search results page**

Use a custom knowledge search widget to access the enhanced Knowledge Management search results page from the Service Portal search results page.

**Before you begin**

Role required: admin

**About this task**

The Knowledge Management search results page in the Knowledge Management Service Portal includes options to filter and sort search results and a number of widgets to enable searches, display search results, display articles, and so on. In this procedure, to access the Knowledge Management search results page from the Service Portal search results page, you create a custom knowledge search widget named Search Within and add it to the Service Portal search results page.

**Procedure**

1. Create a custom knowledge search widget named Search Within.

   a. Navigate to **Service Portal > Service Portal Configuration**.

   b. On the Service Portal page, click **Widget Editor**.

   c. Click **Create a new widget**.

   d. In the Add a Widget dialog box, in the **Widget Name** field, enter **Search Within**. The **Widget ID** field is automatically populated based on the widget name.

   e. Click **Submit**.

   The widget HTML template, client script, and server script display in the widget editor.
f. In the widget editor, enter the following field values to replace any existing text.

- In the **HTML Template** field, enter the following code to add a link to the Knowledge Management search results page in the Search Within widget from the Service Portal.

```html
<div role="list" class="list-group">
    <span class="list-group-item active">${Search Within}</span>
    <a role="link" class="list-group-item" ng-href="{{data.url}}">${Knowledge}</a>
</div>
```

- In the **Server Script** field, enter the following code to set the URL parameters for the Knowledge Management search results page:

```javascript
(function()
    var q = encodeURIComponent($sp.getParameter('q'));
    var kb = $sp.getValue('kb_knowledge_base') || "";
    data.url = '/sp?id=kb_search';
    if(q)
        data.url += "&keyword="+q;
    if(kb)
        data.url += "&kb_knowledge_base="+kb;
})();
```

**Note:** For more information about these fields, see [Widget developer guide](#).

g. Click **Save**.

2. Add the custom knowledge search widget to the Service Portal search results page.

   a. Navigate to **Service Portal > Service Portal Configuration**.

   b. Click **Designer**.

   c. In the **Filter by title or Id** field, enter `sp_search`, the ID for the Service Portal search results page, and then select **Search**.

   d. In the **Filter Widget** field, search for the Search Within widget and drag it onto the container where you want the widget to appear on the Service Portal search results page.
Tip: To verify the location and appearance of the newly added Search Within widget on the Service Portal search results page, click the Preview tab.

The Search Within knowledge search widget is added to the Service Portal search results page. Clicking Knowledge in the widget and searching for a keyword will redirect you to the Knowledge Management search results page in the Knowledge Management Service Portal.

Add widgets to access knowledge articles from the Service Portal homepage

Add the Knowledge Management Service Portal widgets Featured Articles, Most Useful Articles, and Most Rated Articles to the Service Portal homepage to quickly access knowledge articles.

Before you begin
Role required: admin

About this task
For more information about Knowledge Management Service Portal widgets, see Knowledge Management Service Portal widgets.

Procedure
1. Navigate to Service Portal > Service Portal Configuration.
2. Click Designer.
3. Select the Service Portal homepage.
4. In the Filter by title or Id field, enter index, the ID for the Service Portal homepage, and then select Service Portal.
5. In the Filter Widget field, search for the following Knowledge Management Service Portal widgets, and then drag them onto the container where you want them to appear on the Service Portal homepage.

<table>
<thead>
<tr>
<th>Widget Name</th>
<th>Widget Display Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Featured Articles</td>
<td>Featured Articles</td>
</tr>
<tr>
<td>Widget Name</td>
<td>Widget Display Name</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Knowledge MostUseful Articles</td>
<td>Most Useful Articles</td>
</tr>
<tr>
<td>Knowledge MostViewed Articles</td>
<td>Most Viewed Articles</td>
</tr>
</tbody>
</table>

**Tip:** To verify the location and appearance of the added widgets on the Service Portal, click the Preview tab.

**Results**

Clicking a knowledge article link from one of the added widgets on the Service Portal homepage opens the Knowledge Management article view page in the Knowledge Management Service Portal.

**Knowledge Management v3 homepage and Knowledge Management Service Portal comparison**

A comparison of the features available on the Knowledge Management v3 homepage and the Knowledge Management Service Portal.

<table>
<thead>
<tr>
<th>Page</th>
<th>Component</th>
<th>V3 Homepage</th>
<th>Knowledge Management Service Portal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home page</td>
<td>Create an article</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Import an article</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Knowledge bases</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Featured content</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Most useful</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Most viewed</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Language selection menu</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Search text box</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Page</td>
<td>Component</td>
<td>V3 Homepage</td>
<td>Knowledge Management Service Portal</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------------------</td>
<td>-------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Search results page</td>
<td>Create an article</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Import an article</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Search box with language selection</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Sort by</td>
<td>Relevancy</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Last updated (newest)</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Views</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Alphabetical</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td>Filter by</td>
<td>Knowledge bases</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Categories</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Authors</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Tags</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Resource</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Rating</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>View count</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td>Article meta data</td>
<td>Authored by</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Article number</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Last modified</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Category</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Number of views</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Star rating</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Page</td>
<td>Component</td>
<td>V3 Homepage</td>
<td>Knowledge Management Service Portal</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------</td>
<td>-------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Article view page</td>
<td>Back button</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Article view page</td>
<td>Create Favorite icon</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Article view page</td>
<td>Navigation hierarchy path</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Article view page</td>
<td>Article meta data</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Article view page</td>
<td>• Article number</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Article view page</td>
<td>• Article version</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Article view page</td>
<td>• Authored by</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Article view page</td>
<td>• Last modified</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Article view page</td>
<td>• Number of views</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Article view page</td>
<td>• Star rating</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Article view page</td>
<td>Subscribe option</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Article view page</td>
<td>Flag article option</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Article view page</td>
<td>Create incident option</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Article view page</td>
<td>Edit option</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Article view page</td>
<td>Article language</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Page</td>
<td>Component</td>
<td>V3 Homepage</td>
<td>Knowledge Management Service Portal</td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
<td>-------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td></td>
<td>selection option</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Helpful yes/no option</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Star rating</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Text box for comments</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Live feed comment</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Copy permalink</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Most Recent Tasks widget</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Affected Products widget</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Most Viewed widget</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Most Useful widget</td>
<td>N</td>
<td>Y</td>
</tr>
</tbody>
</table>

The `sn_km_portal.glide.knowman.serviceportal.enable_redirect` property is not honored for the following use cases:

- Contextual search in the Incident form
- Connect

Configure custom SEO tags for canonical URLs and localized knowledge articles

Discover relevant knowledge articles through search engines by adding custom SEO tags for canonical URLs and `hreflang` tags to the knowledge article view page.

**Before you begin**

Role required: admin
**About this task**

Update the `SPSEOHeaderTagsArticleView` script include to add canonical URLs and `hreflang` tags to the knowledge article view page. You can also add custom header tags to the knowledge article view page by implementing the `generateCustomTagsForSEO` function.

**Note:** The tags are added to the Knowledge Article View [kb_article_view] page only when audience is set to public; that is, the page can be accessed without the need for authentication. For more information, see Create and edit a page using the Service Portal Designer.

For information about the default behavior of canonical URLs and `hreflang` tags for the knowledge article view page, see SEO for canonical URLs and localized versions of knowledge articles.

**Procedure**

1. Navigate to **System Definitions > Script Includes**.
2. Search for `SPSEOHeaderTagsArticleView`.
3. In the **Name** column, click the `SPSEOHeaderTagsArticleView` link.
4. On the Script Include form, modify the functions for knowledge articles.

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Implementation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return a canonical URL for a knowledge article</td>
<td>Modify the <code>generateCanonicalURL</code> function to return the fully qualified canonical URL of a knowledge article as a string. For example, use the following URL format for a knowledge article in the customer service portal: &quot;https://&lt;instance name&gt;.servicenow-com/csp?id=kb_article_view&amp;sysparm_article=&lt;article number&gt;&quot;</td>
</tr>
<tr>
<td>Return an <code>hreflang</code> tag for translated versions of a knowledge article</td>
<td>Modify the <code>generateHrefLangArray</code> function to return an <code>hreflang</code> array for the current language and the available translations for a knowledge article. For example, use the following format for a knowledge article translated in French in the customer service portal: <code>[{locale:'fr', href: 'https://&lt;instance name&gt;.servicenow-com/csp/fr?id=kb_article_view&amp;sysparm_article=&lt;article number&gt;'}]</code></td>
</tr>
<tr>
<td>Return a custom header for a knowledge article</td>
<td>Modify the <code>generateCustomTagsForSEO</code> function to return any custom header tags as an array of strings used for the knowledge article view page.</td>
</tr>
</tbody>
</table>
## Functionality

| knowledge article | For example, use the following format for a custom tag for a knowledge article: ['<meta custom-tag="" property="og:title" content="Service Portal">'] |

For more information about configuring script includes, see [Script includes](#).

5. Click **Update**.

### SEO for canonical URLs and localized versions of knowledge articles

Improve the searchability of knowledge articles by adding tags for canonical URLs and **hreflang** tags for translated knowledge articles.

You can add the default tags for canonical URLs and **hreflang** tags by selecting the **Use SEO script** check box on the Knowledge Article View [kb_article_view] page record. For more information, see [Enable SEO for canonical URLs and localized versions of a portal page](#).

When the **Use SEO script** option is selected:

- The canonical URLs for a knowledge article are added to the knowledge article view page.

  Example canonical URL: `https://<instance name>.servicenow-com/csp?id=kb_article_view&sysparm_article=<article number>`

- The **hreflang** tags for the translated versions of a knowledge article are added to the knowledge article view page.

  Example URL with an **hreflang** tag: `<link rel="alternate" href="https://<instance name>.servicenow-com/csp/fr?id=kb_article_view&sysparm_article=<article number>" hreflang="fr"/>

  **Note:** A self-referencing **hreflang** URL is also added for the language of current knowledge article.

  For example, an English knowledge article is viewed by visiting a URL with the following format:

  `https://<instance name>.servicenow-com/csp/?id=kb_article_view&sys_kb_id=<sys_id>`

  In addition to the **hreflang** tags added for translations, the English language self-referencing **hreflang** tag is added:

  `<link rel="alternate" href="https://<instance name>.servicenow-com/csp/?id=kb_article_view&sys_kb_id=<sys_id>" hreflang="en"/>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**Script includes for canonical URLs and hreflang tags**

By default, the knowledge article view page uses the `SPSEOHeaderTagsArticleViewSNC` script include to add the SEO tags for canonical URLs and **hreflang** tags.

The following table describes the script includes for adding canonical URLs and **hreflang** tags to Service Portal pages, including the knowledge article view page.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>SPSEOHeaderTagsSNC</code></td>
<td>Includes the default implementation for the canonical URLs and <strong>hreflang</strong> tags for Service Portal pages.</td>
</tr>
<tr>
<td></td>
<td>This script include is read-only.</td>
</tr>
<tr>
<td></td>
<td>For more information, see <a href="#">Enable SEO for canonical URLs and localized versions of a portal page</a>.</td>
</tr>
<tr>
<td><code>SPSEOHeaderTags</code></td>
<td>Facilitates overriding the default implementation in the <code>SPSEOHeaderTagsSNC</code> script include for Service Portal pages.</td>
</tr>
<tr>
<td></td>
<td>The <code>SPSEOHeaderTags</code> script include extends the <code>#SPSEOHeaderTagsArticleViewSNC</code> script include.</td>
</tr>
<tr>
<td><code>#SPSEOHeaderTagsArticleViewSNC</code></td>
<td>Overrides the <code>generateHrefLangArray</code> and <code>generateCanonicalURL</code> functions for the knowledge article view page configured in the <code>SPSEOHeaderTags</code> script include.</td>
</tr>
<tr>
<td></td>
<td>The <code>SPSEOHeaderTagsArticleViewSNC</code> script include is read-only and extends the <code>#SPSEOHeaderTagsArticleViewSNC</code> script include.</td>
</tr>
<tr>
<td><code>SPSEOHeaderTagsArticleView</code></td>
<td>Facilitates overriding the default implementation in the <code>SPSEOHeaderTagsArticleViewSNC</code> script include for the knowledge article view page.</td>
</tr>
<tr>
<td></td>
<td>The <code>SPSEOHeaderTagsArticleView</code> script include extends the <code>#SPSEOHeaderTagsArticleViewSNC</code> script include.</td>
</tr>
</tbody>
</table>
As an administrator, you can add canonical URLs, hreflang tags, and any custom headers for knowledge articles by updating the SPSEOHeaderTagsArticleView script include. For more information, see Configure custom SEO tags for canonical URLs and localized knowledge articles.

**Configure knowledge bases for a portal**

Select which knowledge bases are displayed in a portal to view the associated knowledge articles. If no knowledge bases are configured, users can view articles from all knowledge bases in the portal.

**Before you begin**
Role required: admin

**Procedure**

1. Navigate to Service Portal > Portals.
2. Select the portal for which you want to enable search for the desired knowledge bases.
3. In the Knowledge Bases related list, click Edit.
4. On the Edit Members form, move the desired knowledge bases from the available items in the Collection column to the Knowledge Bases List column.
5. Click Save.

**Related information**

Create a knowledge base

**Configure knowledge subscriptions**

Configure knowledge subscriptions by activating the Knowledge Management Advanced plugin and setting the subscription properties.

**Before you begin**
Ensure that the Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated.

⚠️ **Note:** The Knowledge Management Advanced plugin activates the Subscriptions and Activity Feed Framework plugin (com.snc.activity_subscriptions).

Role required: knowledge_admin or admin
**Procedure**

1. Navigate to **Knowledge > Administration > Properties**.

2. In the **KM Subscription Properties** section, configure the following properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable subscribe feature for KM [glide.knowman.enable_km_subscription]</td>
<td>Enables or disables the Knowledge Management knowledge subscriptions feature.</td>
</tr>
<tr>
<td>List of roles (comma-separated) who can have subscription feature [glide.knowman.enable_km_subscription.roles]</td>
<td>A comma-separated list of the roles that can use the knowledge subscriptions feature and subscribe to knowledge bases and articles.</td>
</tr>
<tr>
<td>List of workflow states (comma-separated) that can have subscription feature [glide.knowman.enable_km_subscription.workflow_state]</td>
<td>A comma-separated list of the article states for which the knowledge subscription feature is available. The default states include Draft, Review, and Published.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

**Knowledge subscription email notification templates**

The knowledge subscription feature uses email notification templates to send subscription notifications to knowledge users.

<table>
<thead>
<tr>
<th>Email template</th>
<th>Subscription type</th>
</tr>
</thead>
<tbody>
<tr>
<td>KM Subscription: Article created</td>
<td>Knowledge base</td>
</tr>
<tr>
<td>KM Subscription: Article revised in KB</td>
<td>Knowledge base</td>
</tr>
<tr>
<td>KM Subscription: Article checked out</td>
<td>Knowledge article</td>
</tr>
<tr>
<td>KM Subscription: Article revised</td>
<td>Knowledge article</td>
</tr>
<tr>
<td>KM Subscription: Article commented</td>
<td>Knowledge article</td>
</tr>
</tbody>
</table>

Users with the admin or knowledge_admin role can customize these email notification templates. To locate the template, navigate to **System Notifications > Email > Notifications**. For more information about customizing a template, see **Create an email notification**.
Subscription notifications include a link at the bottom of the email to the user's Notification Preferences page.

**Knowledge Management Analytics and Reporting Solutions**

Analytics and Reporting Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

**Analytics and Reporting Solutions**

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With Analytics and Reporting Solutions, you can get value from Performance Analytics for your application with minimal setup. You can always create your own objects as well.

**Important:** Set up and test Analytics and Reporting Solutions on a non-production instance before enabling them in production.

**Note:** Analytics and Reporting Solutions provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see Configure Analytics and Reporting Solutions.

To enable the solution for Knowledge Management, an admin can navigate to **Performance Analytics > Guided Setup.** Click **Get Started** then scroll to the section for Knowledge Management. The guided setup takes you through the entire setup and configuration process.

**Domain separation and 'Run As' user**

By default, System Administrator is the *Run As* user for data collection jobs in the Analytics and Reporting Solutions. Verify that this user exists on the instance, and whether this user has the appropriate level of access. An inappropriate *Run As* user can cause errors or limit the data that is collected. This setting only has an effect if domain separation is enabled.

**New and deprecated versions of this solution**

In London, this Solution was replaced with a new version, `com.snc.pa.knowledge_v2`. If you activated an earlier version of the Solution and then upgraded your instance, you still have and can still use the earlier Solution. You can also activate the newer version without losing data from existing indicators and breakdowns. If you activate the newer version, run a historical data collection job to populate any new indicators and breakdowns.
Add Self-Service Analytics to Knowledge Management dashboards

If you have Self-Service Analytics activated on an instance, you can add Self-Service analytics widgets to your Performance Analytics dashboards or a Service Portal. To obtain a ready-made set of indicators and breakdowns, activate the Self-Service Analytics PA (com.snc.pa.self_service_analytics) plugin. Find the Self-Service indicators through the Performance Analytics Admin Console, then create widgets and add them to your dashboard or portal. Also activate the [SSA] Self-Service Analytics data collection job.

Related information

Analytics and Reporting Solutions
Activate your Performance Analytics subscription

Knowledge Management dashboard

The Knowledge Management dashboard helps knowledge content owners and managers to determine the usage and quality of their knowledge content and confirm that the proper processes and procedures are being followed for content creation.

⚠️ Note: This documentation refers to the Performance Analytics Content Pack for Knowledge Management v2, introduced in London. It does not refer to the older, deprecated version.
Knowledge Management dashboard - Content Governance tab

- **Average Time to Publish**
  - 1.00 days (Jul 17)

- **% Knowledge Articles Published**
  - 96.63% (Jul 17)

Knowledge Management dashboard - Content Quality tab

- **Article Quality Index**
  - 70.11 (Jul 2018)
  - ▲ 3.82 (5.8%) (Jun 2018-Aug 2018)

- **% Knowledge Articles Flagged**
  - 0.31% (Jul 17)

- **Monthly Avg. Article Rating**
  - 3.44 (Jul 2018)
  - ▲ 0.44 (11.4%) (Jun 2018-Jun 2018)
End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Manager: Needs to identify areas of concern and direct resources optimally.</td>
<td>knowledge_manager</td>
<td>Can review the velocity of content publication and see what content customers are searching for, to direct the efforts of content owners more efficiently.</td>
</tr>
<tr>
<td>Knowledge Administrator: Needs clear visibility into the usage and quality of knowledge content.</td>
<td>knowledge_admin</td>
<td>Can plan and direct content creation.</td>
</tr>
<tr>
<td>Content creator: Needs to see the usage of content they own and areas for improvement</td>
<td>pa_viewer</td>
<td>Can see what content in their subject area that customers are looking for.</td>
</tr>
</tbody>
</table>

CSM Knowledge Management dashboard indicators

The CSM Knowledge Management dashboard provides three views, into content usage, content governance, and content quality.

The Knowledge Management dashboard presents the following key performance indicators:

% of Knowledge Articles Published
A daily calculation using the formula \[
\frac{\text{[Number of knowledge articles published]}}{\text{[Number of knowledge articles active]}}
\]

Monthly Average Article Rating
A monthly calculation of the sum of all article ratings for the month divided by the number of knowledge articles rated for the month.

Average Click Rank
A monthly calculation using the formula \[
\frac{\text{[Sum of knowledge search ranks]}}{\text{Number of knowledge searches with rank}}
\]

Click Through Rate
A monthly calculation using the formula \[
\frac{\text{Number of knowledge searches with rank}}{\text{[Number of knowledge searches]}}
\]
Average Time to Publish

The average time to publish is recalculated daily, as a number of
days. The goal of the indicator is for scores to minimize.

Number of Active Users Who Performed Searches - Monthly

The number of authenticated users who performed at least one
search of the knowledge base in the preceding month. The goal is
for the number to maximize.

Number of Active Users Who Viewed Articles - Monthly

The number of authenticated users who viewed at least one
knowledge article in the preceding month. The goal is for the
number to maximize.

Number of Knowledge Searches with Rank - Monthly

The number of knowledge searches in a month where the Highest
Click Rank has a value higher than zero. The goal is for the number
to maximize.

Number of Knowledge Searches - Monthly

The number of knowledge searches in a month. The goal is for the
number to maximize.

Number of Knowledge Articles Rated - Monthly

The number of knowledge feedback records created in a month,
excluding records where the Rating field is empty. The goal is for the
number to maximize.

Number of Knowledge Articles Published

A daily count of the total number of knowledge articles that have
entered the Published state. The goal is for the number to maximize.

Number of Knowledge Articles Active

A daily count of the number of active knowledge articles with up-
to-date workflows. The goal is for the number to maximize.

Sum of Knowledge Article Rating - Monthly

The monthly sum of all knowledge article ratings. This indicator is
used only to calculate the average monthly article rating.

Sum of Knowledge Search Ranks - Monthly

The sum of feedback rankings of knowledge searches made in a
month, excluding empty Highest Click Rank values. The goal is for
the number to maximize.

Average Click Rank for Unauthenticated Users
A monthly calculation of the average click rank for the unauthenticated user activity. The score is calculated according to the formula \[
\frac{\text{Sum of Knowledge Search Ranks by Unauthenticated Users - Monthly}}{\text{Number of Knowledge Searches by Unauthenticated user with Rank - Monthly}}\]. A lower value is better.

**Click Through Rate for Unauthenticated Users**

A monthly calculation of the percentage of click through rate for the unauthenticated user activity. The score is calculated according to the formula \[
\frac{\text{Number of Knowledge Searches by Unauthenticated user with Rank - Monthly}}{\text{Number of Knowledge Searches by Unauthenticated user - Monthly}} \times 100\]. A higher value is better.

**Number of Knowledge Searches by Unauthenticated Users - Monthly**

A monthly count of the knowledge searches by unauthenticated users.

**Number of Article Views by Unauthenticated Users - Monthly**

A monthly count of the knowledge articles viewed by unauthenticated users.

**Sum of Knowledge Search Ranks by Unauthenticated Users - Monthly**

A monthly sum of the knowledge search ranks for the unauthenticated user activity.

**Number of Knowledge Searches with Rank for Unauthenticated Users - Monthly**

A monthly count of the knowledge searches with click rank for the unauthenticated user activity.

**Breakdowns**

The following breakdowns apply to the indicators on the dashboard:

- Time to Publish Groups
- Knowledge Base
- Knowledge Category

**Reports**

The dashboards include the following reports:
<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Articles with Inactive Authors</td>
<td>Column</td>
<td>Active = true and Author.Active = False</td>
</tr>
<tr>
<td>Invalid Articles</td>
<td>Column</td>
<td>Active = true and Workflow is one of Draft, Review, Published, or Pending Retirement and Valid to is before today and latest = true</td>
</tr>
<tr>
<td>Articles Created Over 1 Year</td>
<td>Column</td>
<td>Active = true and Created = before 1 year ago</td>
</tr>
<tr>
<td>Articles not Published</td>
<td>Column</td>
<td>Active = true and Workflow is Draft or Review</td>
</tr>
</tbody>
</table>

**Related information**

**Dashboards**

**View knowledge logs**

Knowledge logs display information about which users have viewed knowledge articles, what they looked for, and where.

**Before you begin**

Role required: knowledge_admin, knowledge_manager

**About this task**

Knowledge logs capture information from all the available sources where users can access knowledge articles, such as Customer Service Portal, Knowledge Management Service Portal, Now Mobile, Agent Workspace, and Knowledge Management v3.

**Procedure**

1. Navigate to **Knowledge > Administration > Search Log** or **View Log**.
2. View the Search or View logs.
Knowledge logs

<table>
<thead>
<tr>
<th>Log</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Log</td>
<td>View records of the search source, search terms, the highest click rank, and the number of search results of knowledge searches from all the available sources where users can access knowledge articles. The Search log displays data from the Knowledge Searches [ts_query_kb] table. For more information about the search source, see View the source of a knowledge article search.</td>
</tr>
<tr>
<td>View Log</td>
<td>View records showing who has viewed which knowledge articles, who has attached a knowledge article to a task and when, and identify final search terms when the type-ahead search suggestions feature is enabled. The View log displays data from the Knowledge Use [kb_use] table.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• An administrator can activate the kb_use table cleanup job to delete any older records from the Knowledge Use [kb_use] table and improve the table performance. For more information, see Modify the data retention policy for View logs.</td>
</tr>
<tr>
<td></td>
<td>• The View log record doesn't display information for a knowledge article accessed and viewed from the global search results.</td>
</tr>
</tbody>
</table>

View the source of a knowledge article search

Analyze knowledge searches by finding the source used for searching a knowledge article.

**Before you begin**

Role required: knowledge_admin, knowledge_manager

**Procedure**

1. Navigate to Knowledge > Administration > Search Log.
2. View the following data for a search record in the corresponding column of the Search log.
Search source details

<table>
<thead>
<tr>
<th>Column</th>
<th>Search record data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Doc</td>
<td>Source record in the source table.</td>
</tr>
<tr>
<td></td>
<td>For example, Problem: problem_number, Case: case_number, Incident: incident_number, Service Portal: Customer Support</td>
</tr>
<tr>
<td>Source Table</td>
<td>Label and name of the source table.</td>
</tr>
<tr>
<td></td>
<td>For example, Knowledge [kb_knowledge], Service Portal [sp_portal], Case [sn_customerservice_case], Incident [incident], Problem [problem], KCS Article [kb_template_kcs_article]</td>
</tr>
<tr>
<td>Source Type</td>
<td>Application where the knowledge article search was performed.</td>
</tr>
<tr>
<td></td>
<td>The Source Type column is set to one of the following values:</td>
</tr>
<tr>
<td></td>
<td>• Portal: Service Portal application</td>
</tr>
<tr>
<td></td>
<td>• Classic: Now Platform application</td>
</tr>
<tr>
<td></td>
<td>• Workspace: Agent assist in Workspace</td>
</tr>
<tr>
<td></td>
<td>• Knowledge Classic: Knowledge Management v3 or v2</td>
</tr>
<tr>
<td></td>
<td>• Other: Unidentifiable source</td>
</tr>
<tr>
<td>Source URL</td>
<td>URL of the searched text query.</td>
</tr>
</tbody>
</table>

Related information

- View knowledge logs

Modify the data retention policy for View logs

Remove unwanted and older data from the Knowledge Use [kb_use] table through the data retention policy.

Before you begin
Role required: admin

About this task
The View log displays data from the Knowledge Use [kb_use] table. By default, all the records in the Knowledge Use [kb_use] table are retained. Activating the data retention policy for the kb_use table deletes records that you no longer need. The deleted data is not visible on the reports used in dashboards such as Self-Service Analytics for customer service and Knowledge Management dashboards.
Procedure

1. Navigate to **System Maintenance > Table Cleanup**.

2. In the **Tablename** column, search for `kb_use` and click the `kb_use` link.

3. On the Auto Flush form, activate the `kb_user` table cleanup job by selecting the **Active** check box.

4. **Optional:** Adjust the amount of time the system waits before deleting the records by modifying the value in the **Age in seconds** field. By default, the **Age in seconds** field value is set to 31,536,000 seconds (equivalent to 365 days). For more information, see **Autoflush form**. If the `glide.knowman.view_age.days` property, which sets the number of days used when summing article views, is active, the **Age in seconds** field value must be larger than that property's value. For more information, see **Knowledge Management properties**.

5. Click **Update**.

Integration with external knowledge sources

Use the external content integration feature to integrate content from various external sources and enable unified knowledge search results.

Users store and manage knowledge using various external sources and search each source separately for relevant results. External content integration enables acquiring and searching all WebDAV-compliant source content from a single location. This provides users with a seamless search experience across multiple knowledge sources and drives more usage to the platform.

Using this feature, knowledge administrators can define the external content to be imported into a knowledge base and periodically run a job to import the content. Knowledge users have a seamless user experience searching for relevant content across multiple knowledge sources.

Activate the External Content Integration plugin

The External Content Integration feature is activated with the Knowledge Management - External Content Integration plugin (com.snc.knowledge.external_integration).

**Before you begin**
- **Role required:** admin
- The Knowledge Management - External Content Integration plugin is not active by default.

The following plugins are automatically activated when the Knowledge Management - External Content Integration plugin is activated:
• Centralized Connection and Credentials plugin (com.snc.core.automation.connection_credential)
• Knowledge Management V3 plugin (com.snc.knowledge3)
• Knowledge Management Advanced Installer plugin (com.snc.knowledge_advanced.installer)

The Knowledge > Administration module displays the External Knowledge Sources and External Knowledge Jobs sub-modules when the Knowledge Management - External Content Integration plugin is activated.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.
   - Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Define an external knowledge source
Before you import content, create and configure the connection between the a Web Distributed Authoring and Versioning (WebDAV) - compliant external knowledge source and the ServiceNow knowledge base into which you want to import content. Define import parameters for the external knowledge source.

Before you begin
Define basic authentication credentials and create an HTTP connection to the external source.

⚠️ CAUTION: This feature expects that the external source endpoint is a publicly accessible endpoint. Mid-server configuration is not supported.

Role required: admin
About this task
Only basic authentication is supported for the external content integration feature.

Procedure
1. Define the connection from the external source and the target knowledge base.

   a. Navigate to Knowledge > Administration > External Knowledge Sources.

   b. Click New.

   c. Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Instruction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter unique name for the external source.</td>
</tr>
<tr>
<td>Target Knowledge Base</td>
<td>Select the knowledge base in which you want to create articles for the external content.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Select the connection alias to connect to the external source.</td>
</tr>
</tbody>
</table>

   d. Right-click the form header and click Save.

2. Set import parameters for the external content.

   a. In the Parameter related list, click New.

   b. In the Name field, select the name of the parameter from the drop-down list.

   c. In the Value field, enter the desired value for the parameter.

   The table below lists the parameters and the corresponding values that can be set for the external source.
<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum size limit (in MB) for this source</td>
<td>Set maximum allowed content size for this source. Once this limit is reached, no further content is processed. Default value is 400 MB.</td>
</tr>
<tr>
<td>Maximum size limit (in KB) per file/content in this source</td>
<td>Set maximum allowed size limit for each file from this external source. If a file exceeds this limit, that file is not processed. Default value is 4000 KB.</td>
</tr>
<tr>
<td>Open search results in the original source system</td>
<td>Set value to <strong>true</strong> to open search results in the external source system. Set value to <strong>false</strong> to open search results in the target knowledge base. Default value is set to <strong>false</strong>.</td>
</tr>
<tr>
<td>Include folders with names that match these regex patterns</td>
<td>Enter a comma-separated list of regular expressions for folder names that need to be included from this external source.</td>
</tr>
<tr>
<td>Exclude folders with names that match these regex patterns</td>
<td>Enter a comma-separated list of regular expressions for folder names that need to be excluded from this external source.</td>
</tr>
<tr>
<td>Create articles when file names match these regex patterns</td>
<td>Enter a comma-separated list of regular expressions for file names that need to be included to create articles.</td>
</tr>
<tr>
<td>Do not create articles when file names match these regex patterns</td>
<td>Enter a comma-separated list of regular expressions for file names that need to be excluded to create articles.</td>
</tr>
<tr>
<td>Maximum retry limit</td>
<td>Maximum number of retries to send request to the external source.</td>
</tr>
</tbody>
</table>

*d. Click **Submit**.*
Import content from an external knowledge source
Run an import job manually or set up a schedule to process the integrated external content.

Before you begin
Role required: admin or knowledge_admin

About this task
Each external source is associated with two handlers: the Acquire handler and the Process handler, for running the import job. The acquire handler uses a WebDAV client to acquire external content to create articles. You can customize the process handler to assign categories to articles or populate additional metadata for the knowledge articles.

Procedure
1. Navigate to Knowledge > Administration > External Knowledge Sources.
2. Select the external knowledge source from which you would like to import content.
3. In the Handler tab, set a schedule to run the acquire and process handlers.
4. In the Related Links section, click Run Scheduled Job.
5. To view all jobs scheduled to run to import content for the external source, click the Jobs.
   You can open the most recent job to monitor the status.

Results
For each file in the external content source, a blank knowledge article is created and the external file is added as an attachment to the article. The short description of the article is derived from the file name of the external content source.

Note: If the externally imported content is infected, a notification about each infected file is sent to the users with the knowledge_admin role and Knowledge Base owners. The notified users can then take required actions on the infected files.

Open knowledge search results in source system
While search results are aggregated within your instance, your users can also utilize features available in the source system (being able to edit in Microsoft SharePoint, for example). To open knowledge search results in a host system, configure the URL to the external source system to open articles from search results directly in the source system.
Before you begin
Make sure the Open search results in the original source system import parameter for the external knowledge source is set to true.

You can follow this procedure when you have a file as a knowledge article in Microsoft SharePoint, for example.

Role required: admin

Procedure

1. Navigate to System Definition > Script Includes.
2. Open KBWebDAVContentHandler.
3. In the Script window, override the function `getFileURL` using script shown below.

The `getFileURL` function is shown below.

```
//fileObj.getName() - Returns name of the file
//fileObj.getPath() - Returns path to the file from root folder
//fileObj.getAbsolutePath() - Returns Absolute WebDAV URL of the file
//fileObj.getCreationDate() - Returns creation date of the file as GlideDateTime object
//fileObj.getModifiedDate() - Returns last modified date of the file as GlideDateTime object
//fileObj.getContentType() - Returns content type of the file as GlideDateTime object
//fileObj.getSize() - Returns size of the file

getFileURL: function(fileObj) {
   //write your logic here
},
```

4. Click Update.

Sample configuration for integrating external knowledge content

You can integrate content from multiple external sources so your users can acquire and search knowledge from a single location. Use this sample configuration to create a connection to your external account, configure external knowledge sources, and import content to enable search results for unified content.

Requirements for integrating external content

Make sure the Knowledge Management -- External Content Integration plugin (com.snc.knowledge.external_integration) is enabled and your external source is WebDAV- compliant.
Integrate external knowledge sources into the Knowledge Management application

Create authentication credentials and a connection alias to connect your external knowledge source to the ServiceNow Knowledge Management application. Define import parameters for your external source to import integrated content.

Before you begin
Role required: admin

Procedure
1. Enable basic authentication on your external account.
   
   Note: Your external account password is not affected when you enable basic authentication.

2. Create the connection to your external account using the basic authentication credentials.
   
   a. Navigate to Connections and Credentials > Credentials.
   
   b. Click New.
   
   c. Click Basic Auth Credentials. Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the credential. For example, Demo_Auth.</td>
</tr>
<tr>
<td>User name</td>
<td>The external account user name created for basic authentication.</td>
</tr>
<tr>
<td>Password</td>
<td>The external account password for the user name.</td>
</tr>
</tbody>
</table>

   d. Click Submit.

3. Create an HTTP connection to your external account.
   
   
   b. Select New.
c. In the **Name** field, enter the name of the connection alias.

**Example**
For example, `Demo_Account`.

d. Right-click the form header and click **Save**.

e. In the **Connections** related list, click **New**.
   Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the HTTP connection. For example, <code>Demo_Connection</code>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential created to connect to the external account. For example, <code>Demo_Auth</code>.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>WebDAV URL to your external account. This is the WebDAV end point of your external account.</td>
</tr>
</tbody>
</table>

**Note:** You can also import contents from a specific folder by appending the folder path to the URL. For example, `https://<web link to your external_account>/KnowledgeIT`.

f. Click **Submit**.

4. Configure the external knowledge source for importing content.

   a. Navigate to **Knowledge > Administration > External Knowledge Sources**.

   b. Click **New** and fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the external source. For example, <code>Demo_knowledge</code>.</td>
</tr>
<tr>
<td>Target Knowledge Base</td>
<td>Knowledge base in which you want to create articles for the external content. For example, <code>IT</code>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection alias to connect to the external source. For example, Demo_Account.</td>
</tr>
</tbody>
</table>

c. Right-click the form header and select **Save**.

d. In the Parameter related list, click **New**.

e. On the Parameter form, select the name of the import parameter that you want to configure for your external source and then set the value for the parameter.

The table below lists the parameters and the corresponding values that can be set for the external source.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum size limit (in MB) for this source</td>
<td>Maximum allowable content size to import from your external source. For example, 250 MB.</td>
</tr>
<tr>
<td>Maximum size limit (in KB) per file/content in this source</td>
<td>Maximum allowable size for each article, including attachments, that you can import from this external source. For example, 2000 KB.</td>
</tr>
<tr>
<td>Open search results in the original source system</td>
<td>Opens search results in the external source system if this value is set to true.</td>
</tr>
<tr>
<td>Include folders with names that match these regex patterns</td>
<td>Comma-separated list of regular expressions for folder names to include from this external source. For example, to include all folders names that start with the letters a and b, enter a.<em>,b.</em>.</td>
</tr>
<tr>
<td>Exclude folders with names that match these regex patterns</td>
<td>Comma-separated list of regular expressions for folder names to exclude from this external source. For example, to exclude all folders names that start with the letters a and b, enter a.<em>,b.</em>.</td>
</tr>
<tr>
<td>Parameter name</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Create articles when file names match these regex patterns</td>
<td>Comma-separated list of regular expressions for file names that to include when creating articles. For example, to include all file names have <code>.docx</code> and <code>.pdfextensions</code>, enter <code>.*\.docx,.*\.pdf</code>.</td>
</tr>
<tr>
<td>Do not create articles when file names match these regex patterns</td>
<td>Comma-separated list of regular expressions for file names to exclude when creating articles. For example, to exclude file names have <code>.docx</code> and <code>.pdfextensions</code>, enter <code>.*\.docx,.*\.pdf</code>.</td>
</tr>
<tr>
<td>Maximum retry limit</td>
<td>Maximum limit for the number of times a connection request can be sent to the external source. For example, 5.</td>
</tr>
</tbody>
</table>

**What to do next**

Import content from an external knowledge source.

**Related information**

- Open knowledge search results in source system
- Knowledge Management Service portal search results page

**Use extension points for Knowledge Management**

Use UI extension points to add knowledge article headers and footers to knowledge articles and to customize the email template for notifications when a knowledge article is commented on. Use scripted extension points to customize the feedback object used in the email template for notifications when a knowledge article is commented on.

**Before you begin**

The Knowledge Management Advanced plugin (com.snc.knowledge_advanced) must be activated to view the KMFeedbackNotification UI extension point and the KMFeedbackObject scripted extension point. These notifications are part of the Subscriptions feature, which is activated with this plugin.

Role required: admin
About this task
Using extension points makes it easier to integrate customizations without actually altering the base code. You can extend standard base functionality using customized scripts.

To use UI extension points in Knowledge Management, create an implementation and change the data as required. You can create multiple implementations per extension point, but for these scenarios, the use is limited to one implementation only. Example code is provided in the extension point, which can be edited, as required.

An implementation is delivered in the base system for scripted extension points. You can change the data and add additional fields, as required.

Procedure
1. To use UI extension points to customize headers and footers in knowledge articles, and the email notification that is sent when a knowledge article is commented on:
   
   
   b. Click the UI extension point you want to use.
   
      Note:
   
      • Use the KMArticleViewFooter and KMArticleViewHeader UI extension points to add knowledge article headers and footers to the knowledge article view pages (kb_view.do) in Knowledge Management v3.
      
      • Use the KMFeedbackNotification UI extension point to customize the email template for notifications when a knowledge article is commented on.
   
   c. Click Create Implementation.
   
   d. Change the data as required.
   
   e. Click Update.

2. To use scripted extension points to update the feedback object used in the email template for notifications when a knowledge article is commented on:
a. Navigate to **System Extension Points > Scripted Extension Points**.

   > **Note:** Use the KMFeedbackObject scripted extension point to customize the feedback object used in the email template for notifications when a knowledge article is commented on.

b. In the **API Name** column, click `global.KMFeedbackObject`.

c. In the **Implementations** related list, click the `KMFeedbackObjectBaseImpl` class.

d. Change the data and add additional fields, as required.

e. Click **Update**.

**Related information**

- Using extension points to extend application functionality
- Using scripted extension points in server-side scripts
- Using UI extension points in server-side UI macros
- Using client extension points in client-side UI scripting

**Duplicate knowledge article numbers**

Importing knowledge articles into an instance can create articles with duplicate numbers.

The Knowledge **Number** field is auto-generated and is incremented every time you create a new article in an instance. The initial value for the **Number** field is 10,000. To customize this number:

1. Navigate to **System Definition > Number Maintenance**.
2. In the **Table** column, search for and select **Knowledge**.
3. In the Controls related list, in the **Number** field, enter a new number.
4. Click **Update**.

Importing knowledge articles from another instance or as part of the demo data for another application may introduce an article with a number that is already in use. Because the Knowledge **Number** field is not uniquely indexed, the import completes without error.
With duplicate knowledge article numbers present, links to article view pages that use the knowledge number can behave inconsistently. For example, if there are two articles with the same Knowledge number KB0000033, the following link may open either of these two articles randomly: `kb_view.do?sysparm_article=KB0000033`. This can happen in Knowledge search results where clicking on a result opens a different article instead of the article displayed in the search results.

**Avoiding duplicate Knowledge article numbers**

To avoid inserting Knowledge articles with duplicate numbers into a production environment:

- Do not import demo data articles in production environment.
- Verify the numbers of the articles to be inserted to make sure they are not already in use.
- Create a before insert business rule on the Knowledge table (kb_knowledge) to ensure the new number is not already in use.

You can also update the initial value for the Knowledge **Number** field so that newly created articles do not conflict with existing articles.

1. Navigate to **System Definition > Number Maintenance**.
2. In the **Table** column, search for and select **Knowledge**.
3. In the Controls related list, in the **Number** field, update the count to a number greater than the largest value already in the system.
4. Click **Update**.

**Configure Knowledge Management - Add-in for Microsoft Word**

Configure the Knowledge Management - Add-in for Microsoft Word to author and access knowledge articles in Microsoft Word.

**Before you begin**

Complete the following tasks to use the Knowledge Management - Add-in for Microsoft Word.

**Procedure**

1. **Activate Knowledge Management - Add-in for Microsoft Word.**
2. **Deploy Knowledge Management - Add-in for Microsoft Word.**
3. **Configure the security for Knowledge Management add-in for Microsoft Word.**
4. **Optional:** Enable downloading of the source Microsoft Word document for a knowledge article.
Related information

Knowledge article authoring in Microsoft Word

Activate Knowledge Management - Add-in for Microsoft Word

Activate the Knowledge Management - Add-in for Microsoft Word plugin (com.snc.knowledge.ms_word) if you have the admin role. This plugin activates related plugins if they are not already installed.

Before you begin
Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Deploy Knowledge Management - Add-in for Microsoft Word

Deploy the Knowledge Management - Add-in for Microsoft Word for authoring knowledge articles from within the Microsoft Word.

Before you begin
In addition to having one of the following roles on the ServiceNow instance, you must be an Office365 administrator to deploy the Knowledge Management - Add-in for Microsoft Word.

Role required: admin, sn_outlook_addin.outlook_addin_setup

Procedure
1. Navigate to ServiceNow Add-Ins for Office > Office Add-In-Manifests.
2. In the Add-In Name column, click Knowledge Management.
3. Click Download Manifest to download the add-in manifest file to your desktop.
4. Deploy the Knowledge Management - Add-in for Microsoft Word. For more information, see Publish Office Add-ins using Centralized Deployment via the Office 365 admin center.

Configure the security for Knowledge Management add-in for Microsoft Word

Use the `sn_km_word.glide.knowman.word.xframe` property to specify all the parent domains in the Microsoft Word Online application in which Knowledge Management - Add-in for Microsoft Word is embedded.

Before you begin

Ensure that you have activated the Knowledge Management - Add-in for Microsoft Word plugin and the application scope is set to Knowledge Management - Add-in for Microsoft Word.

Role required: admin

About this task

The domains you specify for the Microsoft Word application in the `sn_km_word.glide.knowman.word.xframe` property are used for setting the `x-frame-options` and `content-security-policy` headers. These settings securely display the Knowledge Management add-in for Microsoft Word in the online version of Microsoft Word documents.

Note: If you don’t set the `sn_km_word.glide.knowman.word.xframe` correctly, the Knowledge Management - Add-in for Microsoft Word fails to load in the Word document. For more information about resolving such errors, see the Knowledge Word Office Manifest fails validation [KB0860916] article in the HI knowledge base.

Procedure

1. In the navigation filter, enter `sys_properties.list`.
2. Search for the `sn_km_word.glide.knowman.word.xframe` property.
3. In the **Value** field, enter a domain.
   - For multiple entries, separate the domains with commas.

4. Click Update.

Enable downloading of the source Microsoft Word document for a knowledge article

Set the `sn_km_word.glide.knowman.enable_document_download` property to enable users to download the source Microsoft Word document of a knowledge article from the knowledge article view page in a portal or workspace.

Before you begin
Role required: admin

About this task
When a knowledge article is created using Microsoft Word, users accessing the knowledge article view page in a portal or workspace can download the source Microsoft Word document when the `sn_km_word.glide.knowman.enable_document_download` property is set to true.

Note: After you enable the `sn_km_word.glide.knowman.enable_document_download` property, the Microsoft Word source document of a knowledge article also might appear in search results as an attachment to the article. Therefore, enabling this property might affect the search relevancy of a knowledge article.

Procedure
1. In the navigation filter, enter `sys_properties.list`.
2. Search for the `sn_km_word.glide.knowman.enable_document_download` property.
3. In the Value field, enter `true`.
4. Click Update.

Automating feedback management to improve content

Manage high volumes of article feedback by enabling task generation for negative feedback. When an article is rated poorly or marked as unhelpful, a feedback task is generated.

If an ownership group is assigned to the article, the feedback task is assigned to the manager of the ownership group. Ownership group managers can reassign
tasks to another group member, or group members can assign a feedback task to themselves.

If no ownership group is assigned to the article, the feedback task is assigned to the author or reviser of the article.

The task assignee can update the article, create a new article, request additional feedback, or reassign the task and receives notification after the feedback is updated or resolved.

 tanggal: The actionable feedback feature is available in the Knowledge Management Service Portal and Agent Workspace. To use the actionable feedback feature in other service portals, you can activate the Knowledge Article View page route map.

Beginning with New York, the Knowledge Article View page route map is activated by default. Existing customers on release versions prior to New York can activate the Knowledge Article View page route map. For more information, see Activate the Knowledge Article View page on upgrade.

Enable actionable knowledge feedback

The actionable knowledge feedback feature is available when the Knowledge Management Service Portal (com.snc.knowledge_serviceportal) plugin is activated and the actionable knowledge feedback properties are enabled.

Before you begin
Role required: admin

About this task
The actionable feedback feature is available in the Knowledge Management Service Portal and Agent Workspace. To use the actionable feedback feature in other service portals, you can activate the Knowledge Article View page route map. For new customers, the Knowledge Article View page route map is activated by default.

A feedback task is created for an article when the article is flagged. For generating feedback tasks when an article is marked as not helpful or rated below a set value, you must set the following associated properties.

Procedure
1. Navigate to Knowledge > Administration > Properties.
2. In the Actionable Feedback Properties section, configure the following properties:
<table>
<thead>
<tr>
<th>Property</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create actionable feedback task when an article is flagged</td>
<td>By default, the property is set to <strong>Yes</strong> and feedback tasks are created when the article is flagged.</td>
</tr>
<tr>
<td>Create actionable feedback task when an article is marked as not helpful</td>
<td><strong>Select Yes.</strong></td>
</tr>
</tbody>
</table>
| Create actionable feedback task when an article is rated at or lower than this value. 0 or no value indicates that actionable feedback tasks are not enabled for Rating type feedback | **Enter a value from 1 to 5 to specify the rating threshold for generating a feedback task.**  
For example, if you set this value to 3, a feedback task is generated when a user selects three or less stars to rate an article. **Note:** If you enter '0', a negative article feedback does not generate a feedback task. |

3. Click **Save**.

**Related reference**

*Actionable Knowledge Feedback Properties*

**Work on a feedback task**

You can change the state of a task and resolve or reassign tasks generated by article feedback.

**Before you begin**

Role required: knowledge

**About this task**

- If no ownership group is assigned to the article, the feedback task is available to you as the author or reviser of the article.

- If an ownership group is assigned to the article, a feedback task is assigned to you as an ownership group manager. As a manager, you can reassign the task to another group member. All group members see the feedback task in **All Open Tasks**. As a group member, you can reassign the task to yourself to appear in **My Assigned Tasks**.
Procedure

1. Navigate to Knowledge > Feedback Management > My Assigned Tasks.
2. Select a feedback task.
3. Review the feedback given by the submitter.
   When a feedback task is generated, the information in the article feedback form is copied to the feedback task form as follows:

<table>
<thead>
<tr>
<th>Feedback task form field</th>
<th>Information from article feedback form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason</td>
<td>The selected reason for the feedback.</td>
</tr>
<tr>
<td>Description</td>
<td>Text in the Details field.</td>
</tr>
</tbody>
</table>

**Note:** If feedback is negative and the Details field is left blank, this field indicates whether the article was not helpful or rated poorly.

4. To work on the feedback task:

<table>
<thead>
<tr>
<th>Change the feedback task state to</th>
<th>If you want to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work in progress</td>
<td>Start working on the feedback task.</td>
</tr>
<tr>
<td></td>
<td>You can save the feedback task and edit the article or create a new article if the information in the existing article is irrelevant or obsolete.</td>
</tr>
<tr>
<td>Awaiting information</td>
<td>Request clarification from the feedback submitter.</td>
</tr>
<tr>
<td></td>
<td>In the Additional Comments field, enter information you need from the submitter and click Update. This triggers an email notification for the feedback task submitter.</td>
</tr>
<tr>
<td>Resolved</td>
<td>Resolve the feedback task.</td>
</tr>
<tr>
<td></td>
<td>In the Resolution Code field, select the code for resolving the article. In the Resolution notes field, enter the reason for the resolution and click Update. An email notification is sent to the feedback submitter. The email...</td>
</tr>
<tr>
<td>Change the feedback task state to</td>
<td>If you want to</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Closed</td>
<td>notification includes the portal URL for the article from where the feedback submitter can accept or reject the feedback.</td>
</tr>
<tr>
<td></td>
<td>Close the feedback task without the submitter having to accept the feedback resolution.</td>
</tr>
</tbody>
</table>

**Note:** If the submitter accepts the feedback resolution, the state for the feedback task is automatically set to **Closed**. You can view all closed feedback tasks in your queue by navigating to Knowledge > Feedback Management > My Closed Tasks.

**Track the progress on a feedback task**
Monitor open and closed feedback tasks and track the duration of time a feedback task remains in each state.

**Before you begin**
Role required: Owner of the knowledge base, knowledge_manager, knowledge_admin, or admin

**Procedure**
1. Navigate to the open or closed tasks you want to track.

<table>
<thead>
<tr>
<th>To</th>
<th>Navigate to</th>
</tr>
</thead>
<tbody>
<tr>
<td>View open feedback tasks</td>
<td><strong>Knowledge &gt; Feedback Management &gt; All Open Tasks</strong> and select a feedback task.</td>
</tr>
<tr>
<td>View closed feedback tasks</td>
<td><strong>Knowledge &gt; Feedback Management &gt; All Closed Tasks</strong> and select a feedback task.</td>
</tr>
</tbody>
</table>
2. In the **Knowledge Feedback Task Metrics** related list section, select a feedback task metric to view the start and end time and the duration of the feedback task.

**Note:** If you are a knowledge administrator, you can view the feedback tasks and task metrics of articles in the knowledge bases. If you are a knowledge owner or knowledge manager, you can view feedback tasks and task metrics of all articles in the knowledge bases you own or manage.

**Knowledge-Centered Service configuration**

Knowledge-Centered Service (KCS) is a method for the creation and continuous improvement of knowledge based on the experience of agents and the patterns observed by knowledge reuse.

ServiceNow Knowledge Management is a KCS (V6) verified product. As a KCS (V6) verified product, Knowledge Management provides features to improve knowledge, such as article quality reviews, in-context knowledge capture, and feedback management.

**Article quality index for knowledge management**

Assess the quality of knowledge articles with the article quality index (AQI). The AQI helps maintain consistent quality of knowledge articles attached to a knowledge base where articles are written by various authors.

Using AQI feature, a knowledge administrator (a user with knowledge_admin role) creates a checklist and adds a set of true or false questions to the checklist to assess the quality of knowledge articles. For each question, the knowledge_administrator assigns a weight based on its importance to the quality measurement and then attaches the checklist to a knowledge base.

A knowledge reviewer (a user with knowledge_coach and knowledge_domain_expert role) performs AQI review on knowledge articles attached to the knowledge base by answering the true or false questions in the checklist. The article quality is then scored based on the cumulative weight of all answers set to true in the checklist.

The average AQI scoring is displayed on the Content Quality tab of the Knowledge Management dashboard (see Knowledge Management dashboard).
Activating article quality index

The article quality index feature is activated with the Knowledge Management Advanced (com.snc.knowledge_advanced) plugin. For details see, Activate the Knowledge Management Advanced plugin.

Create an AQI checklist

Create a checklist of questions that reviewers can use to evaluate the quality of knowledge articles.

Before you begin

Role required: knowledge_admin or admin

Procedure

1. Navigate to Knowledge > Article Quality Index > AQI checklists, and click New.

2. Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checklist</td>
<td>Name for the checklist.</td>
</tr>
<tr>
<td>Description</td>
<td>Description for the checklist.</td>
</tr>
</tbody>
</table>

3. Right-click the form header and click Save.

4. In the Checklist Questions related list, add questions to the checklist.
   Add questions and adjust the weight of the questions until the combined weight of all questions is equal to 100. The weight defines the score that is added to the total AQI review score of the article when the answer for that question is set to true. The maximum score that can be applied to an article in an AQI review is 100.

   Note: The default AQI pass score is 70. You can change the pass score in the Article Quality Index properties.

To add a question:

a. Click New.

b. Fill in the following fields:
## Checklist Question form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question</td>
<td>Text for the question to evaluate articles.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description for the question.</td>
</tr>
<tr>
<td>Order</td>
<td>Value for the display order of questions in the checklist. The lower the value in the Order field, the higher the question displays in the checklist.</td>
</tr>
</tbody>
</table>

⚠️ **Note:** Before you assign a value for the display order, think about how many questions you would create for the checklist. For example, if you have five questions in a checklist, you can assign the value in increments of 20. This ensures that you have enough values to assign if you add questions to the checklist later.

<p>| Weight | A value for the question to score the article quality. This value is added to the AQI score when the answer for the question is set to true. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Note: | • The combined weight of all questions cannot exceed 100.  
• The sum of weights of all questions in a checklist must be equal to 100 to be assigned to a knowledge base. |

c. Click **Submit**.

5. After you finish adding questions to the checklist, click **Update** on the AQI Checklist form.

**What to do next**

After you create a checklist, **assign it to a knowledge base**.

**Assign an AQI checklist to a knowledge base**

Before a knowledge reviewer can start performing the AQI review, you must assign an AQI checklist to a knowledge base.

**Before you begin**

You can only assign a checklist to a knowledge base when the weight of all questions in the checklist is equal to 100. Each knowledge base can have one assigned checklist. However, a checklist can be assigned to more than one knowledge base.

Role required: knowledge_admin or admin

**About this task**

**Procedure**

1. Navigate to **Knowledge > Administration > Knowledge Bases**.

2. Click a knowledge base to which you want to assign a checklist.

3. On the Knowledge Base form, click the search icon in the **Checklist** field and select the AQI checklist to apply.

4. Click **Update**.
What to do next
After you assign an AQI checklist to a knowledge base, you can start performing AQI reviews.

Remove an AQI checklist from a knowledge base
Before you can edit a checklist that is assigned to a knowledge base, you must remove it from the knowledge base.

Before you begin
A checklist with pending AQI reviews cannot be removed from the knowledge base until all AQI reviews associated with the checklist are complete.
Role required: knowledge_admin or admin

Procedure
1. Navigate to Knowledge > Administration > Knowledge Bases.
2. Click a knowledge base from which you want to remove a checklist.
3. On the Knowledge Base form, delete the name of the AQI checklist from the Checklist field.
4. Click Update.

Delete questions from an AQI checklist
Deleting a question in a checklist deletes the text in the question of previously performed AQI reviews that use the checklist. Deleting an AQI question from a checklist will not affect the score of the previously performed AQI reviews. However, the text of the question will not be displayed in the checklist.

Before you begin
You can delete questions from a checklist if the following conditions are met:

• The checklist is not attached to a knowledge base. For more information, see Remove an AQI checklist from a knowledge base.
• There are no AQI reviews using the checklist in progress.

Role required: admin

Procedure
1. Navigate to Knowledge > Article Quality Index > AQI checklists.
2. Click the AQI checklist from which you want to delete one or more questions.
3. In the Checklist Questions related list, select the check box next to the questions that you want to delete.
4. From the Actions on Selected Rows choice list, select Delete.
5. In the Confirmation window, click Delete.

Perform an AQI review

Perform the AQI review to evaluate the quality of the article.

Before you begin
The knowledge base must have an assigned AQI checklist.
Role required: knowledge_domain_expert, knowledge_coach, knowledge_admin, or admin

About this task
Configure the glide.knowman.aqi.article_workflow_states property to set the article workflow states where you could perform AQI reviews. You can perform several AQI reviews for an article. If you perform several AQI reviews for the same version of the article, the latest AQI score appears in the Latest AQI field in the article.

Procedure
1. Navigate to Knowledge > Articles and click Published.
2. Click an article link.
   
   Note: To read the article and perform the AQI review simultaneously, open the article in two separate tabs or window in your browser. You can then read the article from one tab or window and perform the AQI from another tab or window.
3. Perform the AQI review.

<table>
<thead>
<tr>
<th>Option</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The AQI review is not yet started.</td>
<td>Click <strong>Perform AQI</strong> in the form header.</td>
</tr>
<tr>
<td>The AQI review was started and is pending.</td>
<td>Click <strong>Continue AQI</strong> in the form header.</td>
</tr>
</tbody>
</table>
4. In the Article Checklist Answers related list, read the questions and evaluate which ones are true. Double-click the Answer cell for each question that is true, select **true**, and click the green check mark.
Note: The associated **Weighted Score** is applied to the AQI score when the answer is set to **true**.

5. Perform one of the following actions:

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
</tr>
</thead>
</table>
| **Submit the completed AQI review.** | Click **Submit**. The form refreshes and the total score of the AQI review is displayed in the **AQI score** field. The system sends an email notification as follows:  
- If the AQI review was performed on the first version of the article, the system sends an email notification to the author of the article.  
- If the AQI review was performed on subsequent versions of the article, the system sends an email notification to the author and creator of the article versions. |
| **Save the pending review to complete later.** | Click **Update** and return to the **Article Checklist Summaries** list. |

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The checklist with pending reviews is added to the <strong>My Pending AQI Checklists</strong> queue. When you want to complete the AQI reviews, navigate to <strong>Knowledge &gt; My Pending AQI Checklists</strong> and complete the reviews.</td>
</tr>
</tbody>
</table>

**What to do next**

To view all the AQI reviews you completed, navigate to **Knowledge > My Completed AQI Checklists**.

**View all pending and completed AQI reviews**

View checklists of all users to monitor the pending and completed reviews.

**Before you begin**

Role required: knowledge_admin or admin

**Procedure**

1. Navigate to **Knowledge > Article Quality Index**
2. Do one of the following:
   - To view all completed AQI checklists, select **All Completed AQI Checklists**.
   - To view all pending AQI checklists, select **All Pending AQI Checklists**.

**Delete AQI reviews**

Delete an AQI review that was created by mistake or is no longer required.

**Before you begin**

Roles required:
- To delete an AQI in a submitted state: admin or knowledge admin
- To delete an AQI not in a submitted state: knowledge admin or the reviewer who initiated the AQI
Procedure
1. Navigate to **Knowledge > Articles > My Pending AQI Checklists**.
2. Select all checklist reviews you would like to delete.
3. Click **Delete**.

**Activate Knowledge Management KCS Capabilities**
You can activate the Knowledge Management KCS Capabilities plugin (com.snc.knowledge_kcs_capabilities) to enable the use of certain KCS roles and KCS article states.

**Before you begin**
Role required: admin

Procedure
1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Managing KCS article states**
Manage the readiness of KCS articles and comply with regulated information using KCS article states.
For information about the KCS article states, see **KCS v6 Practices Guide**.

**Activation information**
Activate the Knowledge Management KCS Capabilities plugin (com.snc.knowledge_kcs_capabilities) to enable the use of KCS roles (kcs_contributor, kcs_publisher, and kcs_candidate) and metadata fields for the KCS article state (governance and confidence). For more information, see **Activate Knowledge Management KCS Capabilities**.
**Article confidence**

The confidence state of an article indicates where the article is in its life cycle. Only users with the knowledge_coach, knowledge_admin, kcs_contributor or kcs_publisher role can modify the value of the Confidence field.

For articles existing before the Knowledge Management KCS Capabilities plugin (com.snc.knowledge_kcs_capabilities) was activated, the Confidence field is automatically set to None.

If an article is created after the Knowledge Management KCS Capabilities plugin (com.snc.knowledge_kcs_capabilities) is activated, the Confidence field is automatically set based on the workflow state of the article.

<table>
<thead>
<tr>
<th>Workflow state</th>
<th>Confidence field value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft, Review, or Scheduled for publish</td>
<td>Work in Progress</td>
</tr>
</tbody>
</table>
| Published                       | • Validated: For articles published by users with the knowledge_coach, kcs_contributor, or kcs_publisher role.  
                                       • Not Validated: For articles published by users with a role other than knowledge_coach, kcs_contributor, or kcs_publisher. |
| Pending retirement or Outdated  | Same as in the Published workflow state.      |
| Retired                         | Archived                                      |

**Article governance**

The governance state of an article indicates which users can manage articles specific to a regulatory requirement, either experience based or compliance based. Users with contribute access to a knowledge article can modify the value of the Governance field.

**Related information**

Create a knowledge article
Create a knowledge article in Agent Workspace
Enable creating an article from a customer service case

You can enable authors to reuse information in a case by copying case details into an article template. Use the pre-defined customer service source case table to article template target table configuration or create custom configurations between the two tables to copy information from a case to an article.

Before you begin

• The Knowledge Management Advanced plugin must be active.
• The KCS for Customer Services Management property must be enabled
• The pre-defined KCS article template or a newly created article template must be active.

Note: You can do one of the following to create an article from a case:

◦ Use the pre-defined Case KCS Article mapping as is or modify the field mappings between the case source table and article template target table.

◦ Create a new article template target table and map it to the case source table and customize the field mappings between them. For information on creating article templates, refer to Create an article template.

• Knowledge users use the Create Knowledge button in a case form to create an article from a case and must have "can contribute" permission for at least one active knowledge base to create an article from a case. For information on user permissions, see Knowledge Management roles.

Role required: sn_customerservice.customer_admin or admin

About this task

The pre-defined Case KCS Article mapping is stored in the CSM Table Map [csm_table_map] table. This configuration has the sn_customerservice_case source case table configured to the kb_template_kcs_article target article template table with the four field mappings pre-configured between the tables. You can customize the existing field mappings or map additional fields between the tables.

Procedure

1. In the application filter navigator, type csm_table_map.list.
2. Click Case KCS Article.
3. From the **Target Table** list, use the pre-defined KCS article template table or select the newly created article template table.

4. Map each customer service case field that must be used to create knowledge articles.

a. In the **Basic Field Mapping** related list, click **New**. To map fields, fill in the following fields:

<table>
<thead>
<tr>
<th>Customer service case table to article template target table field mapping</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Source Field</td>
</tr>
<tr>
<td>Target Field</td>
</tr>
</tbody>
</table>

b. Click **Submit**.

c. To map fields using advanced scripts, select the **Advanced Field Mapping** check box and then map the fields between the source and the target table using advanced scripts in the **Advanced Field Mapping** tab.

ℹ️ **Note:**

If the same source or target field is configured in both the basic and advanced field mappings, the advanced field mapping overrides the basic field mapping.

If the fields configured in the basic and advanced field mapping are different, the field configurations in the advanced field mapping are appended to the field configurations in the basic field mapping.
d. To customize when and how the Create Knowledge button is displayed, use the condition builder in the Condition tab or select Use Advanced Condition check box and configure using advanced scripts.

ℹ️ Note: If you change the target table in the Case KCS Article mapping, also update the scripts with the configuration changes for display of this button.

5. Click Update.

Enable creating a knowledge article from an incident
Enable users to quickly and easily reuse information from an incident in a knowledge article.

Before you begin
Role required: admin
Perform the following steps to enable creating a knowledge article from an incident. You can also create a knowledge article from an incident using an article template. For more information, see Create a knowledge article from an incident using an article template.

ℹ️ Note: Once you have performed the configuration steps, knowledge users can select the Knowledge check box on the Incident form to create an article from an incident. They must have Can Contribute access to at least one active knowledge base to create an article.

Create field mapping from an incident to a knowledge article
Copy information from an incident into a knowledge article by creating custom mapping between the Incident table and the KCS article table.

Before you begin
Role required: admin

- Ensure that the Knowledge Advanced plugin (com.snc.knowledge_advanced) is active.
- Ensure that the KCS Article template is active.

1. Navigate to Knowledge > Administration > Article Templates.
2. Set the Active field to true for the KCS Article template.
Procedure

1. In the filter navigator, type `csm_table_map.list`.
2. Click **New**.
3. In the **Mapping Name** field, enter **Incident KCS Article**.
4. In the **Source Table** field, enter **Incident**.
5. In the **Target Table** field, enter **KCS Article**.
6. Right-click the form header and **Save**.
7. In the **Basic Field Mapping** related list, click **New**.
8. Create mappings for the following fields.

<table>
<thead>
<tr>
<th>Source Field</th>
<th>Target Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sys ID</td>
<td>Source Task</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Resolution notes</td>
<td>Resolution</td>
</tr>
</tbody>
</table>

**Note**: You can create field mappings for more fields, as required.

- In the **Source** field, select the field in the source Incident table that contains the information to be copied to the field in the article template target table.
- In the **Target** field, select the field in the article template target table to which you need information copied from the field in the source Incident table.

9. To customize when and how the **Knowledge** check box is displayed, click the **Condition** tab.

10. To map fields using advanced scripts, select the **Advanced Field Mapping** check box.

11. On the **Advanced field Mapping** tab, paste in the following code.

```javascript
(function (source,target) {
    // Get the first comments from incident and use it as Issue description for article
    var notes = source.comments.getJournalEntry(-1);
    var entries = notes.split("\n\n");
    var comment = "";
    if(entries[entries.length-2]){
        comment = entries[entries.length-2];
        var part = comment.toString().indexOf("\n");
```
if (part != -1) {
    comment = comment.toString().substring(part + 2).replaceAll("\r\n", "<br/>"));
}
}if (comment)
    target.kb_issue = comment;
}
)(source, target);

The first comment on an incident is mapped to the **Issue Description** field in the knowledge article.

⚠️ **Note:** If the same source or target field is configured in both the basic and advanced field mappings, the advanced field mapping overrides the basic field mapping.

If the fields configured in the basic and advanced field mapping are different, the field configurations in the advanced field mapping are appended to the field configurations in the basic field mapping.

**Add a property to enable creating knowledge article from incidents**

Add a property, which is required to allow users to create a knowledge article from an incident.

**Before you begin**

Role required: admin

**Procedure**

1. In the Filter navigator, enter `sys_properties.list`.
2. Click **New**.
3. Fill in the following fields.

**System Property form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td><code>enable_kcs_incident</code></td>
</tr>
<tr>
<td>Description</td>
<td>Enable Knowledge Centered Services (KCS) for Incident Management.</td>
</tr>
<tr>
<td>Type</td>
<td>`true</td>
</tr>
<tr>
<td>Value</td>
<td><code>true</code></td>
</tr>
</tbody>
</table>

4. Click **Submit**.
Create a UI action to enable creating knowledge articles from incidents
Create a UI action to add the Knowledge check box to the Incident form.

Before you begin
Role required: admin

Procedure
1. Navigate to System UI > UI Actions.
2. Click New.
3. Fill in the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Create Knowledge</td>
</tr>
<tr>
<td>Table</td>
<td>Incident</td>
</tr>
<tr>
<td>Action name</td>
<td>create_knowledge</td>
</tr>
</tbody>
</table>

4. Select the Client check box.
5. Select the List v3 Compatible check box.
6. Select the Form button check box.
7. In the Onclick field, enter createKnowledgeClient().
8. In the Condition field, enter gs.getProperty("enable_kcs_incident") == 'true' && new global.CSMTableMapUtil(current).findMapByName("incident_kcs_article") && new global.KBKnowledge().canCreate().
9. In the Script field, enter the following code.

```javascript
function createKnowledgeClient() {
  if (g_form.modified) {
    alert(new GwtMessage().getMessage('You have unsaved changes. Please save them to continue.'));
  } else{
    //Call the UI Action again but skip the 'onclick' function
    gsftSubmit(null, g_form.getFormElement(), 'create_knowledge');
    //MUST call the 'Action name' set in this UI Action
  }
}
```

//Code that runs without 'onclick'
Enable creating a knowledge article from an HR case

Enable users to quickly and easily reuse information from an HR case in a knowledge article.

Before you begin
Role required: admin

• Ensure that the Human Resources Scoped App: Core (com.sn_hr_core) plugin is active.

• Ensure that the Developer Application is set to Human Resources: Core.

Note: To check, navigate to the Settings icon and then Developer > Application.

Perform the following steps to enable creating a knowledge article from an HR case.

Note: Once you have performed the configuration steps, knowledge users can select the Knowledge check box on the HR Case form to create an article from an HR case. They must have Can Contribute access to at least one active knowledge base to create an article.

Create field mapping from an HR case to a knowledge article

Copy information from an HR case into a knowledge article by creating custom mapping between the HR case table and the KCS article table.

Before you begin
Role required: admin
• Ensure that the Knowledge Advanced plugin (com.snc.knowledge_advanced) is active.
• Ensure that the Developer Application is set to Human Resources: Core.
• Ensure that the KCS Article template is active.

1. Navigate to Knowledge > Administration > Article Templates.
2. Set the Active field to true for the KCS Article template.

Procedure
1. In the filter navigator, type csm_table_map.list.
2. Click New.
3. In the Mapping Name field, enter HR Case KCS Article.
4. In the Source Table field, enter HR Case.
5. In the Target Table field, enter KCS Article.
6. Right-click the form header and Save.
7. In the Basic Field Mapping related list, click New.
8. Create mappings for the following fields.

<table>
<thead>
<tr>
<th>Source Field</th>
<th>Target Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sys ID</td>
<td>Source Task</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Close notes</td>
<td>Resolution</td>
</tr>
<tr>
<td>Description</td>
<td>Cause</td>
</tr>
</tbody>
</table>

ℹ️ Note: You can create field mappings for more fields, as required.
- In the Source field, select the field in the source HR Case table that contains the information to be copied to the field in the article template target table.
- In the Target field, select the field in the article template target table to which you need information copied to from the field in the source Incident table.

9. To customize when and how the Knowledge check box is displayed, click the Condition tab.
10. To map fields using advanced scripts, select the Advanced Field Mapping check box.
11. On the **Advanced field Mapping** tab, paste in the following code.

```
(function (source) {
    // Get the first comments from HR case and use it as Issue description for article
    target.short_description = source.short_description + "";
    target.kb_resolution = source.close_notes + "";
    target.kb_cause = source.description + "";
    var notes = source.comments.getJournalEntry(-1);
    var entries = notes.split("\n\n");
    var comment = "";
    if(entries[entries.length-2]) {
        comment = entries[entries.length-2];
        var part = comment.toString().indexOf("\") + 1;
        if(part != -1) {
            comment = comment.toString().substring(part).replaceAll("\r\n", "\n") + "<br/>");
        }
    }
    if(comment)
        target.kb_issue = comment;

    //Only if selected article type is active
    var tem = new GlideRecord("kb_article_template");
    tem.addQuery("child_table", "kb_template_kcs_article");
    tem.addActiveQuery();
    tem.query();
    if(!tem.hasNext())
        return false;

    //Do not allow to create the knowledge again
    var now_GR = new GlideRecord("kb_knowledge");
    gr.addQuery("source", source.sys_id);
    gr.query();
    if(gr.next())
        return false;

    return true;
})(source);
```
The first comment on an HR case is mapped to the **Issue Description** field in the knowledge article.

**Note:** If the same source or target field is configured in both the basic and advanced field mappings, the advanced field mapping overrides the basic field mapping.

If the fields configured in the basic and advanced field mapping are different, the field configurations in the advanced field mapping are appended to the field configurations in the basic field mapping.

**Add a property to enable creating knowledge articles from HR cases**

Add a property, which is required to allow users to create a knowledge article from an HR case.

**Before you begin**

Role required: admin
Ensure that the Developer Application is set to **Human Resources: Core**.

**Procedure**

1. In the Filter navigator, enter `sys_properties.list`.
2. Click **New**.
3. Fill in the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td><code>enable_kcs_hr</code></td>
</tr>
<tr>
<td>Description</td>
<td>Enable Knowledge Centered Services (KCS) for HR Service Delivery.</td>
</tr>
<tr>
<td>Type</td>
<td>true</td>
</tr>
<tr>
<td>Value</td>
<td>true</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Create a UI action to enable creating knowledge articles from HR cases**

Create a UI action to add the Knowledge check box to the HR case form.

**Before you begin**

Role required: admin
Ensure that the Developer Application is set to **Human Resources: Core**.
Procedure
1. Navigate to System UI > UI Actions.
2. Click New.
3. Fill in the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Create Knowledge</td>
</tr>
<tr>
<td>Table</td>
<td>HR Case</td>
</tr>
<tr>
<td>Action name</td>
<td>create_knowledge</td>
</tr>
</tbody>
</table>

4. Select the Client check box.
5. Select the List v3 Compatible check box.
6. Select the Form button check box.
7. In the Onclick field, enter createKnowledgeClient().
8. In the Condition field, enter gs.getProperty("sn_hr_core.enable_kcs_hr") == 'true' && new global.CSMTTableMapUtil
   (current).findMapByName("sn_hr_core.hr_case_kcs_article") && new
   global.KBKnowledge().canCreate().
9. In the Script field, enter the following code.

```javascript
function createKnowledgeClient() {
    if (g_form.modified) {
        alert(new GwtMessage().getMessage('You have unsaved changes. Please save them to
    continue.'));
    }else{
        //Call the UI Action again but skip the 'onclick' function
        gsftSubmit(null, g_form.getFormElement(), 'create_knowledge');
        //MUST call the 'Action name' set in this UI Action
    }
}

//Code that runs without 'onclick'
//Ensure call to server-side function with no browser errors
if (typeof window == 'undefined')
    CreateKnowledgeServer();

function CreateKnowledgeServer(){
    current.update();
}
```
var map = new global.CSMTableMapUtil (current);
map.findMapByName("sn_hr_core.hr_case_kcs_article");
var targetURL = map.getTargetURL();
var referenceLink =
"&sysparm_collection=sn_hr_core_case&sysparm_collectionID="+current.sys_id+
"&sysparm_collection_key=task&sysparm_link_collection=m2m_kb_task&sysparm_collection_related_field=kb_knowledge&sysparm_referring_url=sn_hr_core_case.do%3fsys_id%3d"+current.sys_id;
if(targetURL)
    action.setRedirectURL(targetURL[0]+referenceLink);
}

10. Click **Submit**.

**Use Knowledge Management**

Share your ideas and experience by creating a knowledge article. Search and find information such as self-help, troubleshooting, and task resolution in knowledge bases. Review, provide feedback on knowledge articles, and resolve issues yourselves rather than contacting customer service or an internal helpdesk.

**Before you begin**
Role required: none

**Procedure**
Use Knowledge Management in one or more of the following ways.

**Related information**
Knowledge Management FAQs

**Knowledge Management guide for users**
After knowledge bases are set up, you can start searching and creating articles.

**Requirements**
Role required

All users can read knowledge articles. Users with the knowledge or any other fulfiller role, such as sn_customerservice_agent, can create and edit knowledge articles in a knowledge base, unless the knowledge manager has restricted access to the knowledge base or knowledge articles.

If you need these permissions, contact the knowledge manager or knowledge administrator for the knowledge base.
What to do

Create knowledge articles

If you have the required permissions for a knowledge base, you can create articles for it. You can create articles from the Self-Service application menu or by importing Word documents.

You can also create knowledge articles from incidents and problems.

Search for knowledge articles

From the Knowledge homepage, you can select a knowledge base to search for articles and answers. You can view only the knowledge bases to which you have access.

Access to knowledge using your mobile device is supported.

Next steps

After articles are created, you can perform the following tasks to make sure that articles are organized in the right knowledge bases and retired when appropriate. If existing knowledge bases do not fit your needs, you can request a new knowledge base.

• Move a knowledge article
• Retire a knowledge article
• Request a knowledge base

Knowledge Management Service Portal homepage features

The Knowledge Management Service Portal homepage displays knowledge articles organized by knowledge base and category, as well as featured content and popular articles. Learn how to navigate the homepage to search for and find useful and relevant information quickly.

To use the Knowledge Management Service Portal, the Knowledge Management — Service Portal plugin (com.snc.knowledge_serviceportal) must be activated.

Note: It is active by default for customers on the Madrid and later releases. Existing or upgrade customers must activate the plugin and enable the glide.knowman.serviceportal.enable_redirect property.

Your organization can customize the homepage, so it may look different to the following image. You must be logged in to view the knowledge homepage.
## Knowledge Management Service Portal homepage features

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge profile menu</td>
<td>Click your profile photo to either view your knowledge profile or logout.</td>
</tr>
<tr>
<td>Search</td>
<td>Enter a search term to search knowledge bases.</td>
</tr>
<tr>
<td>Counters</td>
<td>Displays the number of available knowledge bases and the total number of knowledge articles.</td>
</tr>
<tr>
<td>Ask a question</td>
<td>This action is available to logged in users with the knowledge role. Click <strong>Ask a Question</strong>, which opens a question page. Fill in the <strong>Question</strong> and <strong>Question details</strong> fields, and click <strong>Post question</strong> to post the question.</td>
</tr>
<tr>
<td>Overflow icon</td>
<td>Click the Overflow icon and select <strong>Create Article</strong> to create a knowledge article.</td>
</tr>
<tr>
<td>Browse knowledge bases</td>
<td>Click a knowledge base to view knowledge articles and questions stored in it. View counters of how many articles and questions are stored in the knowledge base. Click <strong>Show All</strong> to view up to eight available knowledge bases.</td>
</tr>
<tr>
<td>Subscribe</td>
<td>Click <strong>Subscribe</strong> to subscribe to that knowledge base. Unsubscribe by clicking <strong>Unsubscribe</strong>.</td>
</tr>
<tr>
<td>Featured</td>
<td>Lists any knowledge articles that were pinned. For more information, see <strong>Add a knowledge article to featured content</strong>.</td>
</tr>
<tr>
<td>Most Useful</td>
<td>Lists the top five articles that were marked as helpful.</td>
</tr>
<tr>
<td>Most Viewed</td>
<td>Lists the top five articles with the most views.</td>
</tr>
</tbody>
</table>

### Note:
The Knowledge Management Service Portal homepage is mobile responsive.

## Knowledge Management Service Portal search results page features

View a list of search results as well as options for sorting and filtering the items in the list. You can also use knowledge search in other Service Portals.
Note: When you perform a new search, the filters you selected earlier on the Knowledge Management search results page are not saved. You must reselect the filters that you want to apply for every search.

Knowledge Management Service Portal search results page

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search bar</td>
<td>Use the search bar at the top of the page to search for additional information.</td>
</tr>
<tr>
<td>Sort</td>
<td>Sort the items in a knowledge base or search results list using the Sort by options at the top of the list.</td>
</tr>
<tr>
<td></td>
<td>• Views: sorts by number of article views.</td>
</tr>
<tr>
<td></td>
<td>• Newest: sorts by the date created or updated.</td>
</tr>
<tr>
<td></td>
<td>• Alphabetical: sorts alphabetically by the article Short description field.</td>
</tr>
<tr>
<td></td>
<td>• Relevancy: sorts by relevance to the search term.</td>
</tr>
<tr>
<td></td>
<td>The header displays the number of search results, which updates as the user selects and de-selects filters.</td>
</tr>
<tr>
<td></td>
<td>When you navigate away from the search results page and then return, your last sort selection is retained.</td>
</tr>
<tr>
<td>Search results list</td>
<td>View knowledge articles and pinned articles.</td>
</tr>
<tr>
<td></td>
<td>Knowledge article search results include articles in which the short description, text content, or attached file content includes the search term.</td>
</tr>
<tr>
<td></td>
<td>View the knowledge article short description, the knowledge base in which the article is stored, author name, number of views, and rating information.</td>
</tr>
<tr>
<td>Language filter facet widget</td>
<td>Language: lists the languages that have been activated. Select one or more languages to display search results in. Your selection is maintained across logins. If multi-language search is enabled, you can search for multiple languages simultaneously.</td>
</tr>
<tr>
<td>Knowledge base filter facet</td>
<td>Knowledge Base: lists the available knowledge bases</td>
</tr>
<tr>
<td>widget</td>
<td></td>
</tr>
<tr>
<td>UI component</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Category filter facet widget</td>
<td>Category: lists the available knowledge categories.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Shows a hierarchy of categories if the administrator configured the Show category hierarchy (valid for kb_category only) instance option for the facet widget.</td>
</tr>
<tr>
<td>Other filter facet widgets</td>
<td>Use filter facets to refine your search results.</td>
</tr>
<tr>
<td></td>
<td>The selections you make filter the items displayed in the search results list. The search results list updates to display only those items that match your selections. Deleting a selection from the filter facet or breadcrumb reverses the filtering in the list.</td>
</tr>
<tr>
<td></td>
<td>Clear selected filter options by:</td>
</tr>
<tr>
<td></td>
<td>• Deleting a single option from the search results list header.</td>
</tr>
<tr>
<td></td>
<td>• Clicking Clear all in the search results list header.</td>
</tr>
<tr>
<td></td>
<td>• Clicking Clear in the filter facet widget header.</td>
</tr>
<tr>
<td></td>
<td>• Author: lists the names of the authors for the knowledge articles included in the search results list</td>
</tr>
<tr>
<td></td>
<td>• Tags: lists the available knowledge tags</td>
</tr>
<tr>
<td></td>
<td>• Resource: lists the types of items available, such as knowledge articles</td>
</tr>
<tr>
<td></td>
<td>• Rating: lists article ratings from 0-5 stars (clicking a rating displays articles that have the selected rating and higher)</td>
</tr>
<tr>
<td></td>
<td>• Last Modified: lists selections based on the timing of knowledge item modifications such as Past Month or Past Week</td>
</tr>
<tr>
<td></td>
<td>• View Count: lists the knowledge item view counts such as More Than 50 or Less Than 10. Set the number of days to consider when calculating view count using the glide.knowman.view_age.days property. For more information on this property, see Knowledge portal properties.</td>
</tr>
<tr>
<td>View additional search results</td>
<td>Depending on the system setup, view additional search results using one of these options:</td>
</tr>
</tbody>
</table>
Knowledge Management Service Portal search results page (continued)

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
</table>
|              | • Standard Pagination: displays the search results in multiple pages.  
|              | • Infinite Scroll: displays the search results while scrolling. |

Note: If a custom widget on the knowledge search results page uses the `KnowledgeSearchService` angular service, you must add the `sn.knowledgeApplication` dependency to enable the functionality of the custom widget.

1. Navigate to Service Portal > Dependencies.
2. In the Name field, search for the `sn.knowledgeApplication` dependency.
3. If a message appears, click here to edit.
   You have to be in the Knowledge Management - Service Portal application to edit.
4. Click Update.

The search functionality in Knowledge Management Service Portal pages uses the Knowledge Base Search search context to fetch results. As an administrator, you must not update the definition of this search context because it may impact the search behavior. For more information about contextual search, see Contextual search concepts.

Knowledge Management Service Portal article view page features

The knowledge article view page in Knowledge Management Service Portal displays the knowledge article details, including the article number, short description, and article content. You can also give feedback or comment on an article.

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breadcrumb</td>
<td>View which knowledge base the knowledge article is in.</td>
</tr>
<tr>
<td>Header</td>
<td>View the knowledge article number.</td>
</tr>
</tbody>
</table>
| Subscribed   | Click Subscribe to subscribe to the knowledge article.  
|              | Unsubscribe by clicking Unsubscribe. |
**Knowledge article view page in Knowledge Management Service Portal (continued)**

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
</table>
| More icon            | Edit the knowledge article or flag an article that contains incorrect or inappropriate content. To edit the article, you must have contribute access to the knowledge article.  
If the article was created using Microsoft Word, download the article as a Microsoft Word document to your computer by clicking **Download as Word**. This option appears only when the article was originally created using Microsoft Word and the system administrator has enabled the `sn_km_word.glide.knowman.enable_document_download` property. |
| Article title        | View the short description of the article as the title of the article.                                                                                                                                                         |
| Language list        | Select a language for the selected article. This field appears if the translations of the knowledge article in other languages are available.                                                                                |
| Knowledge article content | View the text and images of the knowledge article.  
View who authored the article and when as well as the number of views the article has.                                                                                                                                 |
| Copy Permalink       | Click **Copy Permalink** to copy the URL of the latest article version to the clipboard.                                                                                                                                       |
| Helpful?             | Provide feedback on an article by marking it as helpful or not. View a percentage value of how many other users found the article helpful.                                                                                     |
| Rate this article    | Rate a knowledge article.                                                                                                                                                                                                     |
| Click here to comment to this article | Add a comment to an article                                                                                                                                                                                               |
| Attachments          | View a list of article attachments if the **Display Attachment** field for the article is enabled.                                                                                                                             |
| Related Items        | View a list of catalog items mapped to the article. The section appears only when the related catalog items are available for the selected article.                                                                            |
| Related Articles     | View a list of related articles with information similar to the selected article. The related articles are manually mapped,                                                                                                   |
Knowledge article view page in Knowledge Management Service Portal (continued)

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>automatically predicted, or both. The manually mapped articles appear first in the section. The section appears only when the related articles are available for the selected article.</td>
<td></td>
</tr>
<tr>
<td>Affected Products</td>
<td>View a list of which products were affected.</td>
</tr>
<tr>
<td>Most Recent tasks</td>
<td>View a list of tasks, such as incidents, cases, problems, and so on, recently associated with the article.</td>
</tr>
<tr>
<td>Most Useful</td>
<td>View a list of knowledge articles that users found most useful.</td>
</tr>
<tr>
<td>Search bar</td>
<td>Use the search bar to start a new search. The search is executed in the current portal where you are viewing the article.</td>
</tr>
</tbody>
</table>

Note:

- If enabled, users can subscribe to articles, view article versions, and create feedback for articles that are rated as not helpful.
- The dynamic titles don’t apply to the knowledge article view page in the Knowledge Management Service Portal.

Knowledge article URL parameters

You can add parameters to an article URL to view the latest version and an existing translation.

Knowledge article URL structure

The knowledge article URL appears in the following structures:

- **Accessed from Service Portal:** `https://<instance-name>.service-now.com/kb?id=kb_article_view&sysparm_article=<article number>&sysparm_language=<language code>`
  
  For example, the URL `https://yourbusiness.service-now.com/kb?id=kb_article_view&sysparm_article=KB0010053&sysparm_language=EN` returns the article with the most recent version in the selected language, if the translation for the selected language exists.

- **Accessed from Knowledge Base View (kb_view) UI page:** `kb_view.do?sysparm_article=<article number>&sysparm_language=<language code>’
For example, the URL `https://yourbusiness.service-now.com/kb_view.do?sysparm_article=KB0010044&sysparm_language=en` returns the article with the most recent version in the selected language, if the translation for the selected language exists.

**Note:** The listed parameters can include the `sys_id` in the `url` parameter.

### Parameters

The following parameters are available for knowledge article URLs.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sysparm_article</code></td>
<td>Returns the most recent article version. For example, <code>https://yourbusiness.service-now.com/kb?id=kb_article_view&amp;sysparm_article=KB0010053</code>.</td>
</tr>
<tr>
<td><code>sysparm_language</code></td>
<td>Returns the most recent article version in the input language if a translation exists. For example, <code>https://yourbusiness.service-now.com/kb?id=kb_article_view&amp;sysparm_language=EN</code>.</td>
</tr>
</tbody>
</table>

### Knowledge article validity

Knowledge article validity is the date a knowledge article expires and is no longer available to the users. Articles do not appear in search results after the `Valid to` date or if the `Valid to` date is blank.

Decide when to expire a knowledge article by using the `Valid to` field in the Knowledge form. The Knowledge form is available when creating or editing a knowledge article.

When you create or edit a knowledge article, a default value appears in the `Valid to` field. As an article author or editor, you can select whether to keep or change the default `Valid to` date.

**Note:** If the system date format or user preferences is set to use `yy` year format, you might face issues when the `Valid to` date is set to the default date. Contact your system administrator or modify the user preferences to use a date format with the `yyyy` year format. For more information, see Global date and time field format and Personalize the system date format topics.
Default article validity when creating a knowledge article

The default value of the **Valid to** field is derived from the **Article Validity** field configured for the knowledge base (see Create a knowledge base). The **Valid to** date starts from the date the article was created until the number of days specified in the **Article Validity** field. If the **Article Validity** field is blank, the default date in the **Valid to** field for the knowledge article is set to January 1, 2100.

Default article validity when editing a knowledge article

If the article versioning feature is enabled, the default value of the **Valid to** date in the updated article version is automatically set as described in the following table.

<table>
<thead>
<tr>
<th>Article Validity value in the associated knowledge base</th>
<th>Valid to default value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank</td>
<td>Earlier version Valid to date value</td>
<td>If the <strong>Article Validity</strong> field in the knowledge base associated with the article is blank, the <strong>Valid to</strong> date value from the earlier version of the article is retained.</td>
</tr>
<tr>
<td>Is not blank</td>
<td>Article updated date + article validity</td>
<td>If the <strong>Article Validity</strong> field in the knowledge base associated with the article is not blank, the <strong>Valid to</strong> date is automatically updated to start from the date the article was updated until the number of days specified in the <strong>Article Validity</strong> field.</td>
</tr>
</tbody>
</table>

If you move a knowledge article to another knowledge base, the default value of the **Valid to** date in the updated article is automatically set as described in the following table.
Valid to date when moving a knowledge article to another knowledge base

<table>
<thead>
<tr>
<th>Article Validity value in the updated knowledge base</th>
<th>Valid to default value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank</td>
<td>Earlier Valid to date value</td>
<td>If the Article Validity field in the selected knowledge base is blank, the earlier Valid to date value is retained for the knowledge article.</td>
</tr>
<tr>
<td>Is not blank</td>
<td>Article updated date + article validity</td>
<td>If the Article Validity field in the selected knowledge base isn’t blank, the Valid to date is automatically updated to start from the date the article was updated until the number of days specified in the Article Validity field.</td>
</tr>
</tbody>
</table>

⚠️ Note: If the dictionary value of the Valid to field is modified, this dictionary value overrides the default value of the Valid to field calculated according to the Article Validity field.

Email notifications for expiring knowledge articles

On the first day of each month, the application sends an email notification to a list of authorized recipients to remind them about articles that are about to expire in the next month. The recipient can then extend the Valid to date to continue using the article. For more information, see Knowledge Management email notifications.

Create a knowledge article

Knowledge contributors can create and edit knowledge articles within a knowledge base to share information across your organization.

Before you begin
You must have contribute access to at least one active knowledge base. To view an article template, you must activate the article templates feature and enable the desired templates.
About this task

Users with at least one role can create and edit knowledge articles. These users are known as knowledge contributors. Users without any role can read articles and submit feedback, but cannot create or edit articles.

Some knowledge bases may allow only certain users to contribute. For example, a member of the IT department can create knowledge articles in the IT knowledge base, such as desktop support information or articles describing company IT processes.

Procedure

1. There are three ways of creating knowledge articles.
   - Navigate to Self-Service > Knowledge and click the Create an Article icon.
   - Navigate to Knowledge > Articles > Create New.
   - From the Knowledge Management homepage, click the more icon (…) and then select Create Article.

2. On the Create new article page, select a knowledge base.
   The list of article templates to select in the next step is filtered according to the article templates available for the selected knowledge base.

   Note:
   On the Create new article page, you can select to Switch to older version of this page or Switch to updated version of this page (recommended).

3. Select an article template.

4. Click Next.
   The Knowledge form is displayed based on the article template selected.

5. On the Knowledge form, fill in the fields.

   Knowledge form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Number of the article. This field is automatically set to a number. For more information see Duplicate knowledge article numbers.</td>
</tr>
<tr>
<td>Knowledge Base</td>
<td>The knowledge base selected for this article.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Note</td>
<td>An article can only be associated with one knowledge base. You can change the knowledge base, but only if the selected article template is available in the knowledge base.</td>
</tr>
<tr>
<td>Category</td>
<td>The category for this article. Select a <strong>Knowledge Base</strong> before you can select a category. Articles without a category appear on the knowledge homepage in the (empty) category.</td>
</tr>
<tr>
<td>Note</td>
<td>If no ownership group is assigned, the article automatically goes to the knowledge administrator and knowledge manager for approval.</td>
</tr>
<tr>
<td>Ownership Group</td>
<td>The ownership group for this knowledge article. An ownership group consists of a group of members and a manager who are responsible for approvals, ensuring article quality, and feedback tasks. Ownership groups can publish, edit, and retire knowledge articles that they are associated with.</td>
</tr>
<tr>
<td>Language</td>
<td>Language in which you are creating the article. The list is populated based on the languages enabled for the selected knowledge base.</td>
</tr>
<tr>
<td>Schedule publish date</td>
<td>Date in future when the article is published automatically. If approvals are enabled, the approval process must be completed before this date.</td>
</tr>
<tr>
<td>Valid to</td>
<td>The date this knowledge article expires. Articles do not appear in search results after the <strong>Valid to</strong> date or if the <strong>Valid to</strong> date is blank. The default value of the <strong>Valid to</strong> field is derived from the <strong>Article Validity</strong> field configured for the knowledge base (see Create a knowledge base). The <strong>Valid to</strong> date starts from the date the article was created until the number of days specified in the <strong>Article Validity</strong> field. If the <strong>Article Validity</strong> field is blank, the default date in the <strong>Valid to</strong> field for the knowledge article is set to January 1, 2100. An article author or editor can select whether to keep or change the default <strong>Valid to</strong> date. For more information, see Knowledge article validity.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>On the first day of each month, the application sends an email notification to a list of authorized recipients to remind them about articles that are about to expire in the next month. The recipient can then extend the <strong>Valid to</strong> date to continue using the article. For more information, see Knowledge Management email notifications.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the system date format or user preferences is set to use <strong>yy</strong> year format, you might face issues when the <strong>Valid to</strong> date is set to the default date. Contact your system administrator or modify the user preferences to use a date format with the <strong>yyyy</strong> year format. For more information, see Global date and time field format and Personalize the system date format topics.</td>
</tr>
<tr>
<td>Confidence</td>
<td>Maturity of an article based on its completeness and reusability.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the article. This field appears only when the article versioning feature is enabled. For more information, see Article versioning.</td>
</tr>
<tr>
<td>Parent</td>
<td>Number of the article that represents the base language article. This setting keeps translations of the same article related to each other. Consider choosing the same language consistently for the parent article. This field appears only when the I18N:Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2) is activated. For more information, see I18N - Knowledge internationalization.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The <strong>Parent</strong> field contains the first version of the parent article only. This field is used by the translation management feature to maintain the relationship between the source article and its translations.</td>
</tr>
<tr>
<td>Article type</td>
<td>The type of article, either HTML or wiki.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only visible in the standard template.</td>
</tr>
<tr>
<td>Workflow</td>
<td>[Read-Only] The publication state of the article, such as <strong>Draft</strong>, <strong>In Review</strong>, or <strong>Published</strong>. When inserting a new article from an existing article, the state of the new article is reset to <strong>Draft</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source</td>
<td>The task this knowledge article was created in response to, if any. This field is set automatically when you create the knowledge article from a task record.</td>
</tr>
<tr>
<td>Attachment link</td>
<td>Option for downloading an attached file automatically when a user accesses the article, instead of opening the article view. Add one or more attachments to the article to use this option.</td>
</tr>
<tr>
<td></td>
<td>✋ <strong>Note:</strong> You may attach multiple files, but most web browsers permit users to download only the first one. To ensure download of all the files, bundle them into an archive, such as with WinZip, and attach the archive. The Attachment link option applies to articles accessed from search links only. Articles accessed from links within other knowledge articles will not automatically download an attached file.</td>
</tr>
<tr>
<td>Display attachments</td>
<td>Option for displaying attachments to users viewing this knowledge article. Attachments appear below the article text. Add one or more attachments to the article to use this option.</td>
</tr>
<tr>
<td>Governance</td>
<td>An attribute of an article that allows you to control sensitive, critical, or regulated information. Not all articles have the same requirement for compliance reviews. Some articles are based on the collective experience of those who use the articles (experience-based). Other articles have policy or legal information that require tight control (compliance-based).</td>
</tr>
<tr>
<td>Short description</td>
<td>The title of the article. This title appears when browsing and searching for knowledge article, and at the top of the article. You can enter up to 100 characters in this field.</td>
</tr>
<tr>
<td></td>
<td>✋ <strong>Note:</strong> If contextual search is enabled, the knowledge articles similar to the entered short description text appear in the Knowledge results section.</td>
</tr>
<tr>
<td>Article body</td>
<td>Content for the article. A preview of the content appears when browsing and searching for knowledge article. Use the editing functions in the HTML editor to create content. For more information, see Editing functions for knowledge articles in the HTML editor.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Meta</td>
<td>Tags for optimizing search from external search engines. Separate each multiple entries by commas. You may need to configure the form to add this field. For more information, see Configuring the form layout.</td>
</tr>
</tbody>
</table>

Note: If AI Search is enabled for the Knowledge Management Service Portal, the tags you add to the Meta field aren’t indexed. To fine-tune AI Search results, your administrator can configure result improvement rules. For more information, see AI Search in Service Portal.

| Note: The Confidence and Governance fields appear when the Knowledge Management KCS Capabilities plugin (com.snc.knowledge_kcs_capabilities) is activated. For more information, see Managing KCS article states. |

6. Optional: To search for similar articles, enter the text in the Related Search field or continue with the default text in the Knowledge results section. If the Knowledge results section is not displayed on the Knowledge form, a system administrator can configure the form layout to add the Contextual Search Results field to the form.

- To find knowledge articles that have high text similarity with the entered search text, choose Similar Articles (ML).

  Note: This option is available only when the Predictive Intelligence feature is enabled and your system administrator has trained the similarity solution for Knowledge Management. For more information, see Train the similarity solution for Knowledge Management to find related articles.

- To find knowledge articles that match the entered search text, choose Search Articles.

7. Optional: To view the entire article in a pop-up window, click the link to the article title.

8. Click Submit to create the article.

9. Optional: Either add to or modify the article details or publish the article.

- Add to or modify the article details.
  (Optional) For more information, see Edit a knowledge article.

- Publish the article by clicking Publish.
A knowledge article is published depending on the workflow setting of its knowledge base:

- **Knowledge - Instant Publish**: The knowledge article is immediately published unless it is scheduled to be published at a later date.
- **Knowledge - Approval Publish**: The knowledge article is published on approval completion unless it is scheduled to be published at a later date.

**Note**: With an ownership group associated with a knowledge article, ownership group members can approve self-authored articles for publication. An administrator can override this behavior by disabling the `glide.knowman.ownership_group.enable_self_approval` property. For more information, see Ownership groups.

For more information, see Schedule a knowledge article for publishing.

When published, the knowledge article appears in the Published and All lists. To view the Published list, navigate to Knowledge > Articles > Published. To view the All list, navigate to Knowledge > Articles > All.

If the article versioning feature is enabled, the version number of the knowledge article increments to the next whole number (for example, from 2.02 to 3.0). For more information, see Knowledge article version numbers.

**What to do next**

After saving the article record, you can add tags to further organize the article. After you create and publish a knowledge article, you can perform the following actions related to the article:

- Request translations for the knowledge article. For more information, see Request missing translations for available languages.
- Retire the knowledge article. Click Retire to enable the retirement workflow. For more information, see Retire a knowledge article.
- Translate the knowledge article directly from the knowledge article. For more information, see Translate a knowledge article.
- Delete the published knowledge article. Click Delete. If the Delete button isn't displayed, click the more actions icon (…), and then click Delete.

**Note**: Only users with the admin role can delete a published knowledge article.


Related information
- Map related articles
- Predictive Intelligence for Knowledge Management

**Edit a knowledge article**

Edit knowledge articles within a knowledge base to update information shared across your organization.

**Before you begin**
Role required: knowledge

**About this task**

Users with at least one role can edit knowledge. These users are known as knowledge contributors. Users without any role can read articles and submit feedback, but cannot edit articles.

However, knowledge managers can configure User Criteria to restrict access to certain knowledge bases. For example, only members of the IT department can create or edit knowledge articles in the IT knowledge base, such as desktop support information or articles describing company IT processes.

**Note:**

- If the article versioning feature is enabled, only the knowledge administrator, and author can edit the checked-out version of an article. If the feature is disabled, any users with contribute access to an article can edit the draft version of the article. An administrator can disable the article versioning feature by setting the `glide.knowman.versioning.enabled` property (from the System Property [sys_properties] table) to `false`.

- If an ownership group is associated with a knowledge article, the author or reviser of the article can't contribute to the article after the article is published. An administrator can override this behavior by enabling the `glide.knowman.ownership_group.override` property. For more information, see Ownership groups.

- If the `glide.knowman.translation.enable_translation_task` property is enabled, you can't modify the knowledge base of existing articles.

**Procedure**

1. Navigate to Knowledge > Articles.
2. Select an article from the Published or Unpublished category.
3. On the Knowledge form, click Edit.
Note: If the knowledge article was created using Microsoft Word, you can edit the article only in Microsoft Word. In this case, click **Open in Word** to open the article in Word Online. For more information, see Edit a knowledge article in Microsoft Word.

If you want to edit the article using the HTML editor, you can unlink the article from Word. For more information, see Unlink knowledge articles from linked Microsoft Word documents.

4. If the article versioning feature is enabled, click **Checkout** for a published knowledge article.
   You can only edit the latest version of a knowledge article.

5. Click **Update**.
   When you edit a knowledge article, a default value appears in the **Valid to** field. You can select whether to keep or change the default **Valid to** date.

Note: If the article versioning feature is enabled, the default value of the **Valid to** date in the updated article version is automatically set based on the following criteria:

- If the **Article Validity** field in the knowledge base associated with the article is blank, the **Valid to** date value from the earlier version of the article is retained.

- If the **Article Validity** field in the knowledge base associated with the article is not blank, the **Valid to** date is automatically updated to start from the date the article was updated until the number of days specified in the **Article Validity** field (Article updated date + article validity).

If you move a knowledge article to another knowledge base, the default value of the **Valid to** date in the updated article is automatically set based on the following criteria:

- If the **Article Validity** field in the selected knowledge base is blank, the earlier **Valid to** date value is retained for the knowledge article.

- If the **Article Validity** field in the selected knowledge base isn’t blank, the **Valid to** date is automatically updated to start from the date the article was updated until the number of days specified in the **Article Validity** field (Article updated date + article validity).

If the dictionary value of the **Valid to** field is modified, this dictionary value overrides the default value of the **Valid to** field calculated according to the **Article Validity** field. For more information, see Knowledge article validity.
The article is saved. If the article versioning feature is enabled, the version of the knowledge article is incremented by 0.01. For more information, see Knowledge article version numbers

6. **Optional:** Publish the article by clicking **Publish**. The knowledge article is published depending on the workflow setting of its knowledge base:

   • **Knowledge - Instant Publish:** The knowledge article is immediately published unless it is scheduled to be published at a later date.

   • **Knowledge - Approval Publish:** The knowledge article is published on approval completion unless it is scheduled to be published at a later date.

   **Note:** With an ownership group associated with a knowledge article, ownership group members can approve self-authored articles for publication. An administrator can override this behavior by disabling the `glide.knowman.ownership_group.enable_self_approval` property. For more information, see Ownership groups.

For more information, see Schedule a knowledge article for publishing.

When published, the knowledge article appears in the Published and All lists. To view the Published list, navigate to Knowledge > Articles > Published. To view the All list, navigate to Knowledge > Articles > All.

If the article versioning feature is enabled, the version number of the knowledge article increments to the next whole number (for example, from 2.02 to 3.0). For more information, see Knowledge article version numbers.

**Related information**

Article versioning changes

**Editing functions for knowledge articles in the HTML editor**

Improve the readability and usefulness of knowledge articles by formatting the article text using the HTML editor.

The HTML editor available in knowledge articles uses the built-in TinyMCE editor. The text formatting is preserved when the content is displayed on a portal.

The HTML toolbar within the HTML editor contains an array of icons that enable you to edit and format the body text of your knowledge article. You can also use the HTML Editor to add images, links, audio, and video to the knowledge article.

**Note:** Your administrator can configure the HTML toolbar within the HTML editor. For more information, see Customize TinyMCE attributes.
You can perform the following functions using the HTML editor:

- Spell check as you type in the Article body section of a knowledge article. The HTML editor automatically checks spelling as you type and underlines spelling and grammar mistakes in red.
- View the style applied to the selected text and the word count from the bottom pane of the HTML editor.
- Apply formatting.
- Paste without formatting.
- Insert tables and modify cells, rows and columns of a table.
- Include HTML content.
- Insert or edit a code snippet.
- Insert a basic table of contents at the cursor’s current position.
- Find and replace text.
- Revert changes that you have made during the current session of content editing.

**Managing HTML content in knowledge articles**

You can manage HTML content in knowledge articles by using the HTML editor. You can perform the following functions for HTML content in knowledge articles:

- Insert a hyperlink by using the insert/edit link icon (🔗) available on the HTML toolbar. For more information, see *Link to a website in HTML fields*.
- Insert an image by using the insert/edit image icon (🏞️) available on the HTML toolbar. For more information, see *Embed images in HTML fields*.
- Embed a video from the video library, an attachment, or URL by using the insert/edit video icon (🎬) available on the HTML toolbar. You can also add videos to the video library. For more information, see *Embed videos in HTML fields*.
- Copy content from external sources and paste them as simple text into the editor. For more information, see *Paste content into the HTML editor*.
- View and edit the HTML source code by using the source code icon (<textarea>) available on the HTML toolbar. For more information, see *Extended functions*.
Note: To insert or edit a code snippet, see Format a code snippet automatically in knowledge articles.

- Expand the HTML field to use the full form view for easier editing by using the fullscreen icon (fullscreen). For more information, see Extended functions.

### Formatting options for knowledge articles

You can apply formatting to a knowledge article using the HTML editor.

You can use the icons on the HTML toolbar to apply the following formatting in knowledge article text:

- Change the font or font size of knowledge articles.
- Format text as bold, italicized, underlined, or strikethrough.
- Change the text color and text background color.
- Create bulleted and numbered lists.
- Change paragraph indentation.
- Apply styles to text.

For more information, see Formatting icons for HTML fields.

### Paste content without formatting into the knowledge article

Paste content into the body of a knowledge article without copying the content formatting.

#### Before you begin

Open the knowledge article in which you want to use the HTML editor.

#### About this task

You can also use the HTML editor when creating or editing a knowledge article using the Knowledge Management application in the Now Platform interface or in Agent Workspace. To create or edit a knowledge article in the Now Platform interface, see Create a knowledge article or Edit a knowledge article. To create or edit a knowledge in Agent Workspace, see Create a knowledge article in Agent Workspace or Edit a knowledge article in Agent Workspace.

#### Procedure

1. Copy your text from a content source.
2. Click the paste as text icon (paste as text) on the HTML toolbar.
3. In the Article body section, place your cursor at the point where you want to paste the content, right-click, and select Paste from the context menu.
Adding tables to knowledge articles

You can insert tables and modify the cells, rows, and columns of a table in a knowledge article.

You can add tables to your knowledge articles by clicking the table icon (​) on the HTML toolbar and selecting your desired table options. For example, you can adjust the height and width of rows and columns, the spacing between cell text and cell borders, and change the colors of cells.

For more information, see Add a table to the HTML field.

Format a code snippet automatically in knowledge articles

Add syntax highlighting to a code snippet in knowledge articles using the HTML editor.

Before you begin
Open the knowledge article in which you want to use the HTML editor.

About this task
You can also use the HTML editor when creating or editing a knowledge article using the Knowledge Management application in the Now Platform interface or in Agent Workspace. To create or edit a knowledge article in the Now Platform interface, see Create a knowledge article or Edit a knowledge article. To create or edit a knowledge in Agent Workspace, see Create a knowledge article in Agent Workspace or Edit a knowledge article in Agent Workspace.

Procedure
1. In the Article body section, place the cursor where you want to insert the code snippet.
2. Click the insert/edit code sample icon (​) on the HTML toolbar.
3. In the Insert/Edit code sample dialog box, select a markup or programming language from the Language list.
4. In the text box after the Language list, enter your code. Alternatively, you can copy the code from an external source and paste it.
5. Click Ok.
6. Optional: Edit the code by clicking the code snippet, and then clicking the insert/edit code sample icon (​).

Insert a table of contents in knowledge articles

Insert a hierarchical table of contents (toc) based on the headings in your knowledge article.
Before you begin
Open the knowledge article in which you want to use the HTML editor.

About this task
You can also use the HTML editor when creating or editing a knowledge article using the Knowledge Management application in the Now Platform interface or in Agent Workspace. To create or edit a knowledge article in the Now Platform interface, see Create a knowledge article or Edit a knowledge article. To create or edit a knowledge in Agent Workspace, see Create a knowledge article in Agent Workspace or Edit a knowledge article in Agent Workspace.

You can generate a table of contents only if your article uses heading levels from Heading 1 to Heading 3 and is a standard article.

Procedure
1. In the Article body section, place the cursor where you want to insert the table of contents.
2. Click the table of contents icon ( ) on the HTML toolbar.
   If you do not see the table of contents icon on the toolbar, add it using steps available in Customize TinyMCE attributes.
3. Optional: Update an existing table of contents by selecting it and then clicking the update icon ( ) on the HTML toolbar.

Results
The HTML editor searches for the headings in your content including their levels (such as Heading 2 or Heading 3). It then automatically generates a table of contents that contains links to the heading levels from Heading 1 to Heading 3 only. The links to heading levels are indented to show the heading hierarchy.

Find and replace text in knowledge articles
Make global changes to the content of a knowledge article by finding and replacing specific text using the HTML editor.

Before you begin
Open the knowledge article in which you want to use the HTML editor.

About this task
You can also use the HTML editor when creating or editing a knowledge article using the Knowledge Management application in the Now Platform interface or in Agent Workspace. To create or edit a knowledge article in the Now Platform interface, see Create a knowledge article or Edit a knowledge article. To create or edit a knowledge in Agent Workspace, see Create a knowledge article in Agent Workspace or Edit a knowledge article in Agent Workspace.

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Procedure

1. In the Article body section, place the cursor anywhere.

2. Click the find and replace icon (i) on the HTML toolbar.

3. In the Find and Replace dialog box, in the Find field, enter the search term you want to find.

4. Enter replacement text for the search term in the Replace with field. If you want to delete repeated occurrences of the search text, leave the Replace with field blank.

5. Optional: Refine the scope of the search.
   • To limit the search to text that exactly matches the case of the search term, select the Match case check box.
   • To limit the search to text that matches one or more complete words only, select the Whole words check box.

6. Find or replace the search term.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find instances of the search text</td>
<td>Click Find.</td>
</tr>
<tr>
<td>Replace individual instances of the found text with the replacement text entered in the Replace with field</td>
<td>Click Replace. Use the Prev and Next buttons to navigate to the previous and next instance of the search term, respectively.</td>
</tr>
<tr>
<td>Replace all instances of the search text automatically</td>
<td>Click Replace all.</td>
</tr>
</tbody>
</table>

Results
When no more occurrences of the term can be found or if the search term is not found at all in the content, a message appears indicating that the specified string wasn't found.

Undo or redo typing actions or formatting while authoring knowledge articles
Quickly revert typing actions or formatting that you made during the current session of editing a knowledge article using the HTML editor.

Before you begin
Open the knowledge article in which you want to use the HTML editor.
About this task

You can also use the HTML editor when creating or editing a knowledge article using the Knowledge Management application in the Now Platform interface or in Agent Workspace. To create or edit a knowledge article in the Now Platform interface, see Create a knowledge article or Edit a knowledge article. To create or edit a knowledge in Agent Workspace, see Create a knowledge article in Agent Workspace or Edit a knowledge article in Agent Workspace.

Procedure

1. Place the cursor in the Article body section.
2. Undo or redo a typing action or format change.
   • To undo the previous change, click the undo icon (_undo_icon_).
   • To redo a change that has been undone, click the redo icon (redo_icon).

Note: The undo (_undo_icon_) and redo (_redo_icon_) icons are available based on the number of actions that are saved to be undone or certain actions that can’t be undone.

Map related articles

Discover similar information across articles on a topic while viewing an article. You can manually map related articles or have the application automatically present related articles using machine learning (ML) algorithms.

Before you begin

Role required: knowledge
To edit the article, you must have knowledge contributor access for the associated Knowledge Base.

About this task

If you have manually mapped related articles when editing an article, those articles are listed in the Related Articles section on the knowledge article view page before the related articles that are predicted thorough the Knowledge Management similarity solution.

Note: An administrator can train the solution definition for Knowledge Management within the Predictive Intelligence feature to find related articles. For more information, see Train the similarity solution for Knowledge Management to find related articles.

This task provides steps to manually map related articles when editing an article.
Procedure

1. On the Now Platform, open the knowledge article for which you want to map related articles.
2. On the Knowledge form, click the Related Articles related list.
3. Click Edit.
4. On the Edit Members form, move the desired articles from the available articles in the Collection column to the Related Articles List column.
5. Click the up or down icon to arrange the articles in the order in which you want them to appear in the Related Articles section on the article view page, and then click Save.

Note: Knowledge administrators can configure the number of articles shown in the Related Articles section using the instance options.

Related information

Edit a knowledge article
Train the similarity solution for Knowledge Management to find related articles
Configure knowledge related articles widget instance options

Map catalog items related to an article

Manually map catalog items related to a knowledge article to enable employees to request the related product or service.

Before you begin
Role required: knowledge
To edit the article, you must have knowledge contributor access for the associated Knowledge Base.

Procedure

1. On the Now Platform, open the knowledge article for which you want to map related catalog items.
2. On the Knowledge form, click the Related Catalog Items related list.
3. Click Edit.
4. On the Edit Members form, move the desired catalog items from the available catalog items in the Collection column to the Related Catalog Items List column.
5. Click the up or down icon to arrange the articles in the order in which you want them to appear in the Related Items section on the article view page, and then click Save.

⚠️ Note: Knowledge administrators can configure the number of catalog items shown in the Related Items section using the instance options.

Related information
- Edit a knowledge article
- Service catalog items
- Configure related catalog item widget instance options

Schedule a knowledge article for publishing
Set a specific time and day for a knowledge article to be published automatically.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article you want to schedule for publishing. Ensure that the system administrator verifies the following settings:

- Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated. For more information, see Activate the Knowledge Management Advanced plugin.
- The article versioning feature is enabled. For more information, see Article versioning.

Role required: knowledge

Procedure
1. Navigate to Knowledge > Articles and click Unpublished.
2. Click an article link.
3. In the Scheduled publish date field, click the select date and time icon 📆.
4. Select any future date from the calendar.
5. In the Time field, enter a time in the format hh:mm:ss.
6. Click the save (enter) icon ✅.
7. Click Publish to enable the publishing workflow.
The article is available in the All list. Go to Knowledge > Articles > All.

Tip: If you want to cancel an article’s scheduled publication and move the article back to the Draft state, click Recall.

Results
The knowledge article is published on the scheduled publish date depending on the following workflow settings of its knowledge base:

- If the knowledge base workflow is set to Knowledge - Instant Publish, the knowledge article is automatically published on the scheduled publish date. The Workflow field on the Knowledge form of the article is updated to Scheduled for publish.

- If the knowledge base workflow is set to Knowledge - Approval Publish, the knowledge article is published on approval completion. The Workflow field on the Knowledge form of the article is updated to Review. The approval completion affects the scheduled publishing as follows:
  ◦ If the approvals are completed before the scheduled publish date, the Workflow field on the Knowledge form of the article is updated to Scheduled for publish and the article is published on the scheduled publish date.
  ◦ If the approvals are completed after the scheduled publish date, the article is published immediately on the approval completion.

Related information
Edit a knowledge article

Recall an article that is being reviewed
Recall an article that is being reviewed to make additional changes.

About this task
If ownership groups is not enabled, only the author of the article, knowledge administrators, or system administrators can recall the article.

If ownership groups is enabled, the author of the article, the ownership group manager, ownership group members, knowledge administrators, or system administrators can recall an article.

Recalling an article in the Review state results in a minor version increment.

When a revised article is in Review state, only the corresponding versions reviser can recall the article to make additional changes.
Procedure
1. Navigate to Knowledge > Articles > All.
2. Open an article in the Review state.
3. Click Recall in the Knowledge form header.
   The system returns the state of the article to Draft, increments the version number by 0.01, and displays a message to the user.

Approve an article that is being reviewed
Approve an article that is being reviewed and create a new published version.

About this task
When an article is in the Review state, only those users who are included in the Approvals related list can modify the article.

Procedure
1. Navigate to Knowledge > Articles > Unpublished.
2. Open an article in the Review state and review the text.
3. In the Approvals related list, click Requested in the State column to display the Approval form for the article.
4. Click Approve.

Results
The system displays the Knowledge form. The version number of the article increments to the next whole number (for example, from 2.02 to 3.0) and the state changes to Published. The new published version of the article is added to the Knowledge list and to the Article Versions related list on the Knowledge form.

Retire a knowledge article
You can initiate the retirement workflow to retire a knowledge article. Only administrators and knowledge administrators can view articles after they are retired.

A knowledge article has an associated retirement workflow, similar to the publishing workflow. This allows administrators to configure these workflows, defining an approval and review process for retiring knowledge if appropriate.

When editing an article, click Retire to launch the retirement workflow associated with that article. If the article requires approval prior to retirement,
the article goes to a pending approval state, and the workflow either finishes upon approval or cancels if rejected by a required approver. The article number associated with the retired article is not available for reuse.

**Note:**

- Retired knowledge articles are not available to users except for administrators and knowledge administrators who can view them. To reuse a retired article, administrators and knowledge administrators can republish the article. For more information, see Republish a retired article.
- An article and its translations have a parent-child relationship. Retiring a parent article does not automatically retire all its translated child articles.

**Instant retire and Approval retire workflows**

**Republish a retired article**

Instantly republish a retired article.
Before you begin
Role required: admin or knowledge admin

Note: User also need a scoped admin role to republish a retired article in the Scoped knowledge bases.

About this task
There may be cases where you'll need to republish a retired article. For example, an admin may want to temporarily retire an article when its information doesn't currently apply, but will at a later date. An administrator or knowledge administrator who can view retired articles can instantly republish these without having to go through an approval workflow.

Procedure
1. Navigate to Knowledge > Articles > Retired.
2. Select a retired article and click Republish.

Results
The article is instantly published as the previous last published version.

Move a knowledge article
You can move articles between knowledge bases.

Before you begin
Role required: User must have contributor access to the knowledge base.

Note: When versioning is enabled, and you move an article from one knowledge base to another, the latest version of an article is moved to the new knowledge base. However, the previous versions of the article remain in the old knowledge base. It is recommended to retire the article from the old knowledge base. For more information, see Retire a knowledge article.

Procedure
1. Edit a knowledge article.
2. Change the Knowledge Base field value.
   After moving an article, the Apply Default Values dialog box prompts you to populate certain fields in the article with default values from the new knowledge base. If the new knowledge base has no default values, the dialog box does not appear.
3. Click OK to overwrite fields with the default values, or Cancel to leave all fields unchanged.
A knowledge manager can define default values for articles in knowledge bases you manage using the **Set default knowledge field values** field on the Knowledge Base form.

4. Click **Update**.

**Comment on a knowledge article**

Comment on a knowledge article or reply to a comment.

**Before you begin**

Role required: Admin

**Procedure**

1. Navigate to the Knowledge Management Service Portal.
2. Click the article you want to comment or reply to a comment on.
3. Click **Click here to comment on this article** or **Reply**.
4. Enter your comment or reply and add links, images, and attachments as required.

⚠️ **Note:** Attachments to comments posted in the Knowledge Management Service Portal are not displayed in the Live Feed. If attachments to comments are posted in Live Feed, they are displayed in the Knowledge Management Service Portal.

If antivirus protection is enabled, all attachments are automatically scanned for viruses once the comment is posted. Attachments are only displayed once the scan is finished and successful.

If you are the author of the comment, you can delete it. All comments and replies underneath are automatically deleted.

5. Click **Submit**.

⚠️ **Note:** You can only view comments in the Live Feed if the Use Live Feed for Knowledge feedback property is active. It is inactive by default.

Comments posted in Live Feed before upgrading to release version New York are not shown hierarchically in the Knowledge Management Service Portal. Comments posted in Live Feed after upgrading to release version New York are shown hierarchically in the Knowledge Service Portal.

The following table illustrates how comments and replies to comments are displayed depending on where you are viewing them.
Create knowledge from incident or problem

Create a knowledge article, so the next time the issue comes up the resolution is easy to find.

About this task
Depending on the value of the glide.knowman.submission.workflow property, knowledge created from an incident or problem may require additional approval. When this property is true, a submission record is created instead of a knowledge article. A user with the knowledge role must approve the submission to create a knowledge article. To create a knowledge article from a case, see Enable creating an article from a customer service case.

Procedure
1. Open a resolved incident or problem.
2. Select the Knowledge check box on the form.
3. Close the incident or problem.
   A new draft knowledge article is created.
4. If additional approval is required, navigate to Knowledge > Open Submissions.
5. Select a submission record.
6. Review the submission to ensure the content and settings are correct.
7. Click Create Article.
   A new draft knowledge article is created. Articles created this way are added to the knowledge base specified in the property glide.knowman.task_kb.
Knowledge feedback
You can view and contribute to feedback on knowledge articles.

Feedback options
You can submit feedback for knowledge articles in these ways:

• Flag an article as incorrect or inappropriate.
• Provide a rating value for the article.
• Mark an article as helpful or not helpful.
• View comments, add a new comment, or reply to existing comments.

Users can view comments directly on the article. Knowledge managers can view the other types of feedback by navigating to Knowledge > Feedback. Administrators and knowledge managers can disable some feedback options using fields on the Knowledge Base form. Administrators can configure feedback options using properties.

Flagging articles
You can flag an article for incorrect or inappropriate content. Click Flag Article in the article header to open a new window, allowing you to enter suggested changes.

• Flagged comments do not appear on the Article View page. Users with the admin, knowledge_admin, and knowledge_manager roles can access flagged articles by navigating to Knowledge > Articles > All Flagged. Users with the knowledge role can access their flagged articles by navigating to Knowledge > Articles > My Flagged.

• If disabled, the author of the article and users with the admin, knowledge_admin, and knowledge_manager roles can see all flagged comments. Other users can see only their own flagged comments.

Note: You cannot disable flagging for an article until you have disabled the flagging for all feedback comments for that article.

Flagged comments are stored in the Knowledge Feedback (kb_feedback) table but not the Live Feed Messages (live_message) table.

Rating articles
The five stars below the article title allow you to indicate the article's effectiveness on a scale of 1 to 5.
Marking articles

The question Helpful? at the bottom of the article allows you to indicate the usefulness of the article with a simple Yes or No answer. The Yes and No options are always available on the knowledge article view page even when you had selected an option earlier.

Comments

Knowledge comments at the bottom of the article use live feed to enable a conversation around a knowledge article. For example, you can post replies to comments, add attachments, or Like comments. The glide.knowman.use_live_feed property controls the display of knowledge article comments. If enabled, the system uses live feed to manage and display feedback on knowledge articles.

Note: Unauthenticated users and users with only the snc_external role can’t add or view attachments for comments.

Related information

Knowledge Management
Automating feedback management to improve content
Request a knowledge base
Create a knowledge article

Import a Word document to a knowledge base

Import a Word document to create a knowledge article.

Before you begin

You must have Can Contribute access to at least one active knowledge base.

Role required: knowledge

About this task

Beginning with Madrid, the Import a Word document feature is enabled by default and the Import Articles module is displayed in the application navigator. The Import a Word document feature isn’t enabled automatically for the existing customers who can continue using the Import Articles option on the Knowledge Management v3 homepage. To enable the Import a Word document feature for existing customers prior to Madrid, an administrator must first disable the Import Articles option on the Knowledge Management v3 homepage by setting the glide.knowman.import.hide_import_functionality property to true and adding the Import Articles module to the application navigator.
These styles and elements are preserved when importing a .doc or .docx file into a knowledge base. Styles and elements not included in this list may not be preserved when importing a document.

- Titles
- Headings

  Note: Only default heading settings are supported. For any headings and subheadings with numbers, the numbers are not imported.

- Images

  Note: Images may not be aligned exactly as in the Word document you import.

- Links
- Bold text
- Italic text
- Underlined text
- Ordered and unordered lists

  Note: After import, the bullets in an unordered list are replaced with dots.

- Tables

  Note: Only default heading settings are supported. Custom heading styles are imported using the default settings for those styles. Table styling and borders are not supported.

Procedure

1. Navigate to Knowledge > Articles > Import Articles.
2. Enter the knowledge base to add the article to.
3. Optional: Select a Category from within the knowledge base.

  Note: Use the category picker to add a category. The picker does not differentiate between the different category levels. You can select a category or sub category and add it to the Category field.

4. Optional: Select the Publish check box to start the publishing workflow for each imported article immediately after the import finishes.
5. Select one or more Word files to import.

6. Click Import.
   An article is created in the selected knowledge base and category using the content from the uploaded document.
   • If you uploaded multiple documents, one article is created for each.
   • If you use knowledge internationalization, the language of the article is set to the system language selected.
   • When the upload completes, a pop-up window displays the number and short description of the articles. Click an article to view the full record.
   • If any errors occur during the upload, a pop-up window displays the error.
   • If the Publish check box is activated, knowledge articles go into Review or Published state, depending on the workflow attached to the knowledge base.
   • If the Publish check box is not activated, the knowledge articles go into Draft state and are then reviewed before publishing.

Related information
Import a Word document to a knowledge base using Knowledge Management V3

Create an article version by importing a Word document
Import a Word document to a knowledge article to create a new version.

Before you begin
• Ensure that the Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is installed.
• You can only upload new versions to articles that are in Draft or Published state.
• You cannot upload new versions to articles that are created using an article template or if the article type is Wiki.

Role required: admin
Procedure
1. Navigate to Knowledge > Articles.
2. Click an article.
3. Click the Upload New Version related link.

   Note: Any text written in TinyMCE is overwritten once the file is imported.
4. Add the file you want to import.
5. Optional: Select the Copy Attachments check box to copy all attachments to the knowledge article.

   Note: If the article is published, the attachments are added to a new article version. If the article is in draft, the attachments are added to the existing knowledge article. The draft article does not appear in the knowledge base (KB) for users until it is reviewed and published.
6. Click Import.
   A draft version is created and sent to approvers to approve or reject. Once the article is approved, it is displayed in the Article Versions related list.

Knowledge article authoring in Workspace
Complete your job efficiently by creating, editing, and publishing knowledge articles in Agent Workspace.

Knowledge Management features specific to agents and authors are available in Workspace. Perform any knowledge administration-related tasks such as creating a knowledge base, managing access to knowledge articles, enabling an article template, and so on using the Now Platform interface.

You can perform the following Knowledge-related tasks in Workspace:
- Create a knowledge article using a default or custom article template.
- Manage all unpublished and published knowledge articles authored by you.
- Address feedback tasks assigned to you.
- Compare two knowledge article versions.
- Request translations for published untranslated knowledge articles.
- Complete translation tasks assigned to you.
- Map related articles and related catalog items to a knowledge article.
- Add affected products to a knowledge article.
- Use Agent assist to avoid creating knowledge articles with duplicate content.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
The authoring experience for knowledge articles in Workspace is similar to the one in Now Platform with the following exceptions:

- Knowledge blocks can't be created or associated with knowledge articles. However, you can view articles containing knowledge blocks.
- Knowledge articles of type Wiki aren't supported.
- Knowledge article categories can't be created.

**Activation Information**

The Knowledge list in Workspace is available with the activation of the Agent Workspace plugin (com.glide.core-ui-components). When you install and activate the Agent Workspace plugin, the sn-component-workspace-knowledge plugin for using Knowledge Management in Workspace is also installed and activated.

**Related information**

- View a knowledge article in Agent Workspace
- Create a knowledge article in Agent Workspace
- Edit a knowledge article in Agent Workspace
- Schedule a knowledge article for publishing in Agent Workspace
- Work on a feedback task in Agent Workspace
- Compare knowledge article versions in Agent Workspace
- Request translations for missing languages in Agent Workspace

**View a knowledge article in Agent Workspace**

View a knowledge article in Agent Workspace, including the article number, short description, and article content.

**Before you begin**

You must have read access to the knowledge article. Role required: agent_workspace_user

**Procedure**

1. Navigate to **Agent Workspace > Agent Workspace Home**.
2. View knowledge articles authored by you or by other people.
   - View all articles by navigating to **Lists > Knowledge > All Articles**.
   - View articles authored by you by navigating to either **Lists > Knowledge > My Articles - Published** or **Lists > Knowledge > My Articles - Unpublished**.
3. Click the link to the knowledge article that you want to view.

4. **Optional:** View the knowledge article in another language by selecting a language in the Language list.
   
   ⚠️ **Note:** The Language list is populated based on the available translated versions of the article.

5. **Optional:** Copy the link to the knowledge article to your clipboard by clicking the more actions icon (…) and then clicking **Copy link**.

6. **Optional:** Download the article as a Microsoft Word document to your computer by clicking the more actions icon (…) and then clicking **Download as Word**.
   
   ⚠️ **Note:** This option appears only when the article was originally created using Microsoft Word and the system administrator has enabled the `sn_km_word.glide.knowman.enable_document_download` property.

7. **Optional:** View another version of the knowledge article by selecting the version of the knowledge article in the Version list.
   
   ⚠️ **Note:** The Version list appears only when the article versioning feature is enabled.

**Results**

The selected version of the article opens in a knowledge article view page displayed in another tab within Agent Workspace. The tab name includes the knowledge article number and its version number.

**Related information**

- Viewing knowledge article details in Agent Workspace
- Managing access to knowledge bases and knowledge articles
- Provide feedback for a knowledge article in Agent Workspace
- Edit a knowledge article in Agent Workspace

**Viewing knowledge article details in Agent Workspace**

View the details of a knowledge article in Agent Workspace.

The knowledge article view page in Agent Workspace provides several details about a displayed article.
Sample knowledge article view page in Agent Workspace

Details

Knowledge base
Knowledge base that stores the knowledge article and the article category. In the figure, IT is the knowledge base and Announcements is the knowledge article category.

Read time
Average time to read the knowledge article, which can help you can decide whether you have time to read the article.
### Article information displayed on the knowledge article view page in Agent Workspace (continued)

<table>
<thead>
<tr>
<th>Details</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td></td>
<td>The read time is calculated based on an average reading speed of 200 words per minute. For articles in languages such as Chinese, Japanese, and Korean, the read time is calculated based on an average speed of 500 characters per minute. If images are present in an article, the read time is calculated using the following rules:</td>
</tr>
<tr>
<td></td>
<td>• For the first image add 12 seconds, for the second image add 11 seconds, and so on.</td>
</tr>
<tr>
<td></td>
<td>• If there are more than 10 images, after the tenth image add 3 seconds for each image.</td>
</tr>
<tr>
<td>Last updated time</td>
<td>Last time the knowledge article was updated in number of days for the current week, number of weeks, or number of years.</td>
</tr>
<tr>
<td>Number of views</td>
<td>Number of times the knowledge article was viewed in the past number of days set by your system administrator in the glide.knowman.view_age.days property. For more information on this property, see Knowledge portal properties.</td>
</tr>
<tr>
<td>Average rating</td>
<td>Result of the weighted average rating of the knowledge article based on numeric 1 through 5 ratings. The average rating is carried on the next version of the article.</td>
</tr>
<tr>
<td>Knowledge article content</td>
<td>Text and images of the knowledge article.</td>
</tr>
<tr>
<td>Authored by</td>
<td>Author of the knowledge article. This field appears only in the first version of a knowledge article.</td>
</tr>
<tr>
<td>Revised by</td>
<td>User who revised the article. This field appears if a knowledge article was later edited.</td>
</tr>
<tr>
<td>Article number</td>
<td>Unique number automatically assigned to the knowledge article. In the figure, KB0010090 is the article number.</td>
</tr>
<tr>
<td>Version</td>
<td>Selected version of the knowledge article. This field appears when the article versioning feature is enabled. In the figure, 1.01 is the selected version of the article.</td>
</tr>
</tbody>
</table>
### Article information displayed on the knowledge article view page in Agent Workspace (continued)

<table>
<thead>
<tr>
<th>Details</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Language of the selected article. This field appears if the translations of the knowledge article in other languages are available.</td>
</tr>
<tr>
<td>Attachments</td>
<td>List of article attachments. This field appears if the knowledge administrator has enabled it to be displayed on the knowledge article view page.</td>
</tr>
</tbody>
</table>

### Related information

- View a knowledge article in Agent Workspace  
- Create a knowledge article in Agent Workspace  
- Edit a knowledge article in Agent Workspace  
- Publish a knowledge article in Agent Workspace  

Provide feedback for a knowledge article in Agent Workspace

Provide feedback on a knowledge article by rating the article, marking the article as helpful or not helpful, and posting and replying to comments for the article in Agent Workspace.

**Before you begin**

You must have read access to the knowledge article.  
Role required: agent_workspace_user

**Procedure**

1. Navigate to Agent Workspace > Agent Workspace Home.  
2. Go to Lists > Knowledge > All articles.  
3. Click the link to the knowledge article that you want to view.  
4. Provide feedback for the article.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark an article as helpful or unhelpful</td>
<td>For the <strong>Helpful</strong> field, click <strong>Yes</strong> or <strong>No</strong>. If you mark the article as not helpful, a dialog box is displayed where you can select a reason for your feedback and enter additional details.</td>
</tr>
<tr>
<td>To</td>
<td>Do this</td>
</tr>
<tr>
<td>----</td>
<td>---------</td>
</tr>
<tr>
<td>If actionable knowledge feedback is enabled, a feedback task is automatically created for the article and assigned to the author or ownership group. For more information, see Enable actionable knowledge feedback.</td>
<td>After you enter your feedback, a percentage value of how many other users found the article helpful is displayed.</td>
</tr>
<tr>
<td><strong>Flag the article</strong></td>
<td>Click the more actions icon (…) and then click <strong>Flag Article</strong> to report an article that contains incorrect or inappropriate content. A dialog box is displayed in which you can provide the reason for the flag. A feedback task is automatically created for the article and assigned to the author or ownership group, as configured.</td>
</tr>
<tr>
<td><strong>Rate the article</strong></td>
<td>Click the star icons displayed on the article to indicate its effectiveness on a scale from 1 through 5. Administrators can configure the <code>glide.knowman.feedback.enable_actionable_feedback</code> property to ensure that feedback tasks are automatically created and assigned when a lower rating is posted. For more information, see Knowledge Management properties.</td>
</tr>
<tr>
<td><strong>Enter your comment</strong></td>
<td>In the <strong>Type your comment here</strong> text box, enter a comment and click <strong>Post Comment</strong>.</td>
</tr>
<tr>
<td><strong>View all comments and replies posted for the knowledge article</strong></td>
<td>Scroll down to the Comments section. To view or hide replies added to a comment, click <strong>Show replies</strong> or <strong>Hide replies</strong>, respectively. To view replies</td>
</tr>
</tbody>
</table>
To | Do this
---|---
| added to all comments, click **Show all replies**.
| **Like a comment on the knowledge article** | Underneath the comment, click the like icon (○).
| **Reply to a comment on the article** | Underneath the comment, click the reply icon (✍), enter your comment in the text box that appears, and then click **Submit**.
| **Delete any previous comments or replies** | Go to a comment or reply and then click the delete icon (🗑). If a message appears, click **Yes, delete**.

**Note:** Only users who have posted the comment, knowledge administrators, and knowledge owners can delete a comment.

**Related information**
- View a knowledge article in Agent Workspace
- Work on a feedback task in Agent Workspace

**Create a knowledge article in Agent Workspace**
Create a knowledge article in Agent Workspace to share information across your organization.

**Before you begin**
You must have contribute access to the knowledge base within which you want to create the knowledge article.
Role required: agent_workspace_user

**About this task**
You can also create a knowledge article when adding a knowledge block. For more information, see Add a knowledge block to a knowledge article in Agent Workspace.
**Procedure**

1. **Navigate to Agent Workspace > Agent Workspace Home.**

2. **Optional:** Check whether a knowledge article on this subject is already available by going to Lists > Knowledge > All Articles and setting a filter to search for possible matching articles.

3. **Click New.**

4. Create the knowledge article by either selecting an article template or using the default template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Selected article template** | Select an article template to create a knowledge article using defined fields and values.  
In the Create Article dialog box:  
  a. From the Knowledge Base list, select a knowledge base.  
  b. From the Article Template list, select the desired article template.  
  ⚠️ **Note:** The Article Template list is populated based on the article templates configured for the selected knowledge base.  
  c. Click Create Article.  
  The Create Article dialog box is available if the article versioning and the Knowledge Article Templates features are enabled. For more information, see Article versioning and Knowledge article templates. |
| **Default Standard template** | Create a knowledge article using the default Standard template. |

5. On the Knowledge form, fill in the fields.

⚠️ **Note:** If you are using an article template, the fields that are available will vary.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge base</td>
<td>Knowledge base in which the knowledge article is stored. You can associate a knowledge article with one knowledge base only. If you are using an article template, you can modify this value only if the template is available in the other knowledge base.</td>
</tr>
<tr>
<td>Category</td>
<td>Category for the knowledge article. This value helps users find the article within a selected category. You can select only categories available within the selected knowledge base. Articles without a category appear in the (empty) category.</td>
</tr>
<tr>
<td>Ownership Group</td>
<td>Ownership group for the knowledge article. An ownership group consists of a group of members and a manager who are responsible for approvals and feedback tasks. Ownership groups can publish, edit, and retire knowledge articles that they are associated with.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is available only if the <code>glide.knowman.ownership_group.enabled</code> property is enabled. If no ownership group is assigned and approvals are required to publish a knowledge article, it is automatically submitted for approval to the knowledge administrator and knowledge manager. For more information, see Ownership groups.</td>
</tr>
<tr>
<td>Version</td>
<td>Automatically generated article version number. This number is incremented when changes are made to a published article.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is available if the article versioning feature has been enabled.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Publishing workflow state of the knowledge article, such as Draft, In Review, or Published. For a new article, the workflow state is set to Draft.</td>
</tr>
<tr>
<td>Language</td>
<td>Language in which you are creating the knowledge article. The list is populated based on the languages enabled for the selected knowledge base. This field appears only when the I18N:Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2) is activated. For more information, see I18N - Knowledge internationalization.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Short description</td>
<td>Title of the knowledge article. This title appears when browsing and searching for knowledge article, and at the top of the article. You can enter up to 100 characters in this field. <strong>Note:</strong> Knowledge articles similar to the entered short description text will appear in Agent assist.</td>
</tr>
<tr>
<td>Article body</td>
<td>Content for the knowledge article. Use the editing functions in the HTML editor to create content. For more information, see Editing functions for knowledge articles in the HTML editor.</td>
</tr>
<tr>
<td>Source Task</td>
<td>Task this knowledge article was created from. This field is set automatically when you create the knowledge article from a task, such as an incident or a customer service case, or from a submission record.</td>
</tr>
<tr>
<td>Scheduled publish date</td>
<td>Future date when the knowledge article will be published automatically. For more information, see Schedule a knowledge article for publishing in Agent Workspace.</td>
</tr>
<tr>
<td>Valid to</td>
<td>The date this knowledge article expires. Articles do not appear in search results after the Valid to date or if the Valid to date is blank. The default value of the Valid to field is derived from the Article Validity field configured for the knowledge base (see Create a knowledge base). The Valid to date starts from the date the article was created until the number of days specified in the Article Validity field. If the Article Validity field is blank, the default date in the Valid to field for the knowledge article is set to January 1, 2100. An article author or editor can select whether to keep or change the default Valid to date. For more information, see Knowledge article validity. On the first day of each month, the application sends an email notification to a list of authorized recipients to remind them about articles that are about to expire in the next month. The recipient can then extend the Valid to date to continue using the article. For more information, see Knowledge Management email notifications.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Confidence</td>
<td>Maturity of an article based on its completeness and reusability.</td>
</tr>
<tr>
<td>Article type</td>
<td>Type of the article, which is automatically set to HTML. This field is available in the Standard template only.</td>
</tr>
<tr>
<td>Display</td>
<td>Option to display attachments in the knowledge article. If the article has attachments, they are listed below the text of a knowledge article on the knowledge article view page.</td>
</tr>
<tr>
<td>attachments</td>
<td>Option to automatically download an attached article when a user access an article instead of opening the article. The Attachment link option applies to articles accessed from search links only. Articles accessed from links within other knowledge articles will not automatically download an attached file.</td>
</tr>
<tr>
<td>Attachment link</td>
<td>Option to automatically download an attached article when a user access an article instead of opening the article. The Attachment link option applies to articles accessed from search links only. Articles accessed from links within other knowledge articles will not automatically download an attached file.</td>
</tr>
<tr>
<td>Governance</td>
<td>An attribute of an article that allows you to control sensitive, critical, or regulated information. Not all articles have the same requirement for compliance reviews. Some articles are based on the collective experience of those who use the articles (experience-based). Other articles have policy or legal information that require tight control (compliance-based).</td>
</tr>
<tr>
<td>Issue</td>
<td>Brief description about an issue.</td>
</tr>
</tbody>
</table>

**Note:** Although you may attach multiple files, most web browsers permit users to download only the first attachment. To ensure download of all the files, bundle them into an archive and attach the archive.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environment</td>
<td>Details of the environment in place when the issue occurred.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available in the KCS Article template only.</td>
</tr>
<tr>
<td>Cause</td>
<td>The cause of the issue.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available in the KCS Article template only.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Method used to resolve the issue.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available in the KCS Article template only.</td>
</tr>
<tr>
<td>Question</td>
<td>Text to display as a question.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available in the FAQ template only.</td>
</tr>
<tr>
<td>Answer</td>
<td>Text to display as an answer to an included question.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available in the FAQ template only.</td>
</tr>
<tr>
<td>Introduction</td>
<td>Introduction to the topic.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available in the How To and What Is templates only.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Instructions for a how-to topic.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available in the How To template only.</td>
</tr>
<tr>
<td>Explanation</td>
<td>Explanation of a what-is topic.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available in the What Is template only.</td>
</tr>
</tbody>
</table>

**Note:** The **Confidence** and **Governance** fields appear when the Knowledge Management KCS Capabilities plugin (com.snc.knowledge_kcs_capabilities) is activated. For more information, see [Managing the KCS article state](#).

6. **Optional:** Research for content related to knowledge article you’re authoring using Agent assist.

   a. In the contextual side panel, click the Agent Assist icon (💡). The search results in Agent assist display default content based on the text-based search.
b. Click the select a search resource icon (🔍), and then select a search resource.
   For example, to view knowledge articles, select Knowledge Articles.

c. Optional: In the search results, you can click a resource item, such as a knowledge article, to view its content in Agent assist.

   ❓ Tip: For better readability, you can resize the contextual side panel for Agent assist. For a full view of the selected resource item content, click Full View. The resource item content opens in another tab within the Agent Workspace.

7. Optional: Check whether your content matches content in an existing article.

   a. Enter search text in the text box available in Agent assist or retain the default text, which is the short description of the knowledge article.

   b. Click the lookup icon (🔍).

   c. Select a search resource by clicking the Select a search resource icon (🔍).

      • To find knowledge articles that have high text similarity with the entered search text, choose Similar Articles (ML).

         ❗ Note: This option is available only when the Predictive Intelligence feature is enabled and your system administrator has trained the similarity solution for Knowledge Management. For more information, see Train the similarity solution for Knowledge Management to find related articles.

      • To find knowledge articles that match the entered search text, choose Knowledge Articles.

8. Optional: Attach a file with supporting information by clicking the attachments icon (첨부) in the contextual side panel and selecting the file.

9. Optional: Add a knowledge block. For more information, see Add a knowledge block to a knowledge article in Agent Workspace.

10. Click Save.
    The article is saved and appears in the My Articles - Unpublished list and additional functionality becomes available on the form.

11. Optional: Either add to or modify the article details or publish the article.
• Add to or modify the article details.
  (Optional) For more information, see Edit a knowledge article in Agent Workspace.

• Publish the article by clicking Publish.
  A knowledge article is published depending on the workflow setting of its knowledge base:
  
  ◦ **Knowledge - Instant Publish**: The knowledge article is immediately published unless it is scheduled to be published at a later date.
  ◦ **Knowledge - Approval Publish**: The knowledge article is published on approval completion unless it is scheduled to be published at a later date.

  Note: With an ownership group associated with a knowledge article, ownership group members can approve self-authored articles for publication. An administrator can override this behavior by disabling the glide.knowman.ownership_group.enable_self_approval property. For more information, see Ownership groups.

  For more information, see Schedule a knowledge article for publishing in Agent Workspace.

  When published, your knowledge article appears in the My Articles - Published and All Articles lists. If the article versioning feature is enabled, the version number of the knowledge article is updated. For more information, see Knowledge article version numbers.

What to do next
After you create and publish a knowledge article, you can perform the following actions related to the article:

• Request translations for the knowledge article. For more information, see Request translations for missing languages in Agent Workspace.

• Retire the knowledge article. Click Retire to enable the retirement workflow. For more information, see Retire a knowledge article.

• Translate the knowledge article directly from the knowledge article. For more information, see Translate a knowledge article in Agent Workspace.

• Delete the published knowledge article. Click Delete. If the Delete button isn’t displayed, click the more actions icon (…), and then click Delete.

  Note: Only users with the admin role can delete a published knowledge article.
Related reference
  Knowledge workflows
Related information
  View a knowledge article in Agent Workspace
  Edit a knowledge article in Agent Workspace
  Work on a feedback task in Agent Workspace
  Provide feedback for a knowledge article in Agent Workspace
  Managing access to knowledge bases and knowledge articles
  Knowledge article templates
  Using Agent Assist in Agent Workspace
  Create knowledge from incident or problem

Publish a knowledge article in Agent Workspace
Publish a knowledge article to make it available to users.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article you want to publish.
Role required: agent_workspace_user

Procedure
1. Navigate to Agent Workspace > Agent Workspace Home.
2. Go to Lists > Knowledge > My Articles - Unpublished.
3. Click a knowledge article link.
4. On the Knowledge form, click Publish.

Results
A knowledge article is published depending on the workflow setting of its knowledge base:
• **Knowledge - Instant Publish**: The knowledge article is immediately published unless it is scheduled to be published at a later date.

• **Knowledge - Approval Publish**: The knowledge article is published on approval completion unless it is scheduled to be published at a later date.

**Note:** With an ownership group associated with a knowledge article, ownership group members can approve self-authored articles for publication. An administrator can override this behavior by disabling the `glide.knowman.ownership_group.enable_self_approval` property. For more information, see [Ownership groups](#).

For more information, see Schedule a knowledge article for publishing in Agent Workspace.

When published, your knowledge article appears in the My Articles - Published and All Articles lists. If the article versioning feature is enabled, the version of the article is incremented based on the version number pattern.

**Related reference**
- Knowledge workflows

**Related information**
- Create a knowledge article in Agent Workspace
- Edit a knowledge article in Agent Workspace

**Edit a knowledge article in Agent Workspace**

Edit knowledge articles within a knowledge base in Agent Workspace to update information shared across your organization.

**Before you begin**

You must have contribute access to the knowledge base that stores the knowledge article you want to edit.
Note:

- If the article versioning feature is enabled, only the knowledge administrator, knowledge managers, and author can edit the checked-out version of an article. If the feature is disabled, any users with contribute access to an article can edit the draft version of the article. An administrator can disable the article versioning feature by setting the glide.knowman.versioning.enabled property (from the System Property [sys_properties] table) to false.

- If an ownership group is associated with a knowledge article, the author or reviser of the article can’t contribute to the article after the article is published. An administrator can override this behavior by enabling the glide.knowman.ownership_group.override property. For more information, see Ownership groups.

- If the glide.knowman.translation.enable_translation_task property is enabled, you can’t modify the knowledge base of existing articles.

Role required: agent_workspace_user

Procedure

1. Navigate to Agent Workspace > Agent Workspace Home.
2. Go to Lists > Knowledge > All Articles.
3. Click a knowledge article link.
4. On the Knowledge form, click Edit.

Note: If the knowledge article was created using Microsoft Word, you can edit the article only in Microsoft Word. In this case, click Open in Word to open the article in Word Online. For more information, see Edit a knowledge article in Microsoft Word.

If you want to edit the article using the HTML editor, you can unlink the article from Word. For more information, see Unlink knowledge articles from linked Microsoft Word documents.

5. If the article versioning feature is enabled, click Checkout for a published knowledge article.
   You can only edit the latest version of a knowledge article.
6. Access the relevant related lists to modify the information.
## Knowledge form related lists

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>Knowledge article content and its metadata.</td>
</tr>
</tbody>
</table>

**Note:** If the article versioning feature is enabled, the default value of the **Valid to** date in the updated article version is automatically set based on the following criteria:

- If the **Article Validity** field in the knowledge base associated with the article is blank, the **Valid to** date value from the earlier version of the article is retained.

- If the **Article Validity** field in the knowledge base associated with the article is not blank, the **Valid to** date is automatically updated to start from the date the article was updated until the number of days specified in the **Article Validity** field (Article updated date + article validity).

If you move a knowledge article to another knowledge base, the default value of the **Valid to** date in the updated article is automatically set based on the following criteria:

- If the **Article Validity** field in the selected knowledge base is blank, the earlier **Valid to** date value is retained for the knowledge article.

- If the **Article Validity** field in the selected knowledge base isn't blank, the **Valid to** date is automatically updated to start from the date the article was updated until the number of days specified in the **Article Validity** field (Article updated date + article validity).

If the dictionary value of the **Valid to** field is modified, this dictionary value overrides the default value of the **Valid to** field calculated according to the **Article Validity** field. For more information, see Knowledge article validity.

<p>| Feedback Tasks | Details about the feedback task created for a knowledge article version. |
| Feedback       | Feedback received on the published versions of the article. To view more details about the feedback, in the <strong>Comments</strong> column, click a link for the desired version of an article. |
| Approvals      | Approval history of the knowledge article. |</p>
<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Article Versions</td>
<td>Version history of the knowledge article.</td>
</tr>
</tbody>
</table>
| Translated Versions | Translated versions of the knowledge article.  
This related list appears only when the translation management feature is enabled. To translate a knowledge article, click **New**. The **New** button on this related list appears when the `glide.knowman.translation.enable_translation_task` property is disabled. |
| Translation Tasks | Tasks submitted for translating the article.  
This related list appears when the Translation Management feature and the `glide.knowman.translation.enable_translation_task` property to enable creation of translation tasks are enabled. For more information, see Knowledge Management properties. |
| Related Articles   | Related articles mapped to the knowledge article. For more information, see Map a related article in Agent Workspace. |
| Related Catalog Items | Related catalog items mapped to the knowledge article. For more information, see Map a related item in Agent Workspace. |
| Affected Products  | Products mapped to the knowledge article. For more information, see Add an affected product to a knowledge article in Agent Workspace. |

**7. Optional:** Research for content related to knowledge article you’re authoring using Agent assist.

- **a.** In the contextual side panel, click the Agent Assist icon (🔍).  
The search results in Agent assist display default content based on the text-based search.

- **b.** Click the select a search resource icon (🔍), and then select a search resource.  
For example, to view knowledge articles, select **Knowledge Articles**.
c. **Optional:** In the search results, you can click a resource item, such as a knowledge article, to view its content in Agent assist.

**Tip:** For better readability, you can resize the contextual side panel for Agent assist. For a full view of the selected resource item content, click **Full View.** The resource item content opens in another tab within the Agent Workspace.

8. **Optional:** Check whether your content matches content in an existing article.

a. Enter search text in the text box available in Agent assist or retain the default text, which is the short description of the knowledge article.

b. Click the lookup icon (смотрите).

c. Select a search resource by clicking the Select a search resource icon (смотрите).

   • To find knowledge articles that have high text similarity with the entered search text, choose **Similar Articles (ML).**

   **Note:** This option is available only when the Predictive Intelligence feature is enabled and your system administrator has trained the similarity solution for Knowledge Management. For more information, see **Train the similarity solution for Knowledge Management to find related articles.**

   • To find knowledge articles that match the entered search text, choose **Knowledge Articles.**

9. **Optional:** Work with attachments.

   • Attach a file with supporting information by clicking the attachments icon (смотрите) in the contextual side panel and selecting the file.

   • Download, remove, or rename an existing attachment by clicking the menu icon (смотрите) displayed for the attachment.

10. **Click Save.**

    The article is saved and appears in the My Articles - Unpublished list. If the article versioning feature is enabled, the version of the knowledge article is incremented by 0.01. For more information, see **Knowledge article version numbers.**

11. **Optional:** Publish the article by clicking **Publish.**

    The knowledge article is published depending on the workflow setting of its knowledge base:
• **Knowledge - Instant Publish:** The knowledge article is immediately published unless it is scheduled to be published at a later date.

• **Knowledge - Approval Publish:** The knowledge article is published on approval completion unless it is scheduled to be published at a later date.

**Note:** With an ownership group associated with a knowledge article, ownership group members can approve self-authored articles for publication. An administrator can override this behavior by disabling the `glide.knowman.ownership_group.enable_self_approval` property. For more information, see [Ownership groups](#).

For more information, see [Schedule a knowledge article for publishing in Agent Workspace](#).

When published, the knowledge article appears in the My Articles - Published and All Articles lists. If the article versioning feature is enabled, the version number of the knowledge article increments to the next whole number (for example, from 2.02 to 3.0). For more information, see [Knowledge article version numbers](#).

### Related information
- Create a knowledge article in Agent Workspace
- View a knowledge article in Agent Workspace
- Using Agent Assist in Agent Workspace
- Create knowledge from incident or problem
- Map a related article in Agent Workspace

Discover similar information across articles on a topic while viewing a knowledge article. You can manually map related articles or have the application automatically present related articles using machine learning (ML) algorithms.

**Before you begin**
You must have contribute access to the knowledge base that stores the knowledge article for which you want to add related articles.

Role required: agent_workspace_user

**About this task**
If you have manually mapped related articles when editing an article in Agent Workspace, those articles are listed in the Related Articles section on the knowledge article view page in the Knowledge Management Service Portal before the related articles that are predicted thorough the Knowledge Management similarity solution.
Note: An administrator can train the solution definition for Knowledge Management within the Predictive Intelligence feature to find related articles. For more information, see Train the similarity solution for Knowledge Management to find related articles.

This task provides steps to manually map related articles when editing an article in Agent Workspace. You can also manually map related articles when editing an article from the Knowledge Management application in the Now Platform interface. For more information, see Map related articles.

Procedure

1. Navigate to Agent Workspace > Agent Workspace Home.
2. Go to Lists > Knowledge > All Articles.
3. Click the link to the knowledge article for which you want to map related articles.
4. In the Related Articles related list, click New.
5. On the Related Articles form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Option to enable the mapping to the related knowledge article.</td>
</tr>
<tr>
<td>Related knowledge article</td>
<td>Knowledge article that contains related information.</td>
</tr>
<tr>
<td></td>
<td>You can click the search for record icon (Q), to access the list of available knowledge articles.</td>
</tr>
<tr>
<td>Knowledge article</td>
<td>Number of the knowledge article for which you are adding the related knowledge article.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which you want the article to appear in the Related Articles section on the Knowledge Management article view page.</td>
</tr>
<tr>
<td></td>
<td>A lower value means that a knowledge article has the greater priority to appear in the Related Articles section. The default value is 100.</td>
</tr>
</tbody>
</table>

6. Click Save.
Results
The mapped articles are available in the Related Articles section on the Knowledge Management article view page in the Knowledge Management Service Portal. See Knowledge Management Service Portal article view page features.

⚠️ Note: Because system administrators can configure the number of knowledge articles shown in the Related Articles section, not all mapped related articles might appear in the Related Articles section. For more information, see Configure knowledge related articles widget instance options.

Related information
Edit a knowledge article in Agent Workspace

Map a related item in Agent Workspace
Manually map catalog items related to a knowledge article in Agent Workspace to enable employees to request the related catalog item.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article for which you want to add related articles.
Role required: agent_workspace_user

About this task
This task provides steps to map related catalog items when editing an article in Agent Workspace. You can also map related catalog items when editing an article from the Knowledge Management application in the Now Platform interface. For more information, see Map catalog items related to an article.

Procedure
1. Navigate to Agent Workspace > Agent Workspace Home.
2. Go to Lists > Knowledge > Published for a published article or Lists > Knowledge > Unpublished for an unpublished article.
3. Click the link to the knowledge article for which you want to map a related item.
4. On the Knowledge form, click the Related Catalog Items related list.
5. Click New.
6. On the Related Catalog Items form, fill in the fields.
Related Items form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Option to enable the mapping to the related catalog item.</td>
</tr>
<tr>
<td>Catalog item</td>
<td>Catalog item related to the knowledge article. You can click the search for record icon (🔍) to access a list of available catalog items.</td>
</tr>
<tr>
<td>Knowledge article</td>
<td>Number of the knowledge article for which you are adding the related catalog item.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which you want the catalog item to appear in the Related Items section on the Knowledge Management article view page. A lower value means that a catalog item has the greater priority to appear in the Related Items section. The default value is 100.</td>
</tr>
</tbody>
</table>

7. Click **Save**.

**Results**

The mapped catalog items are listed in the Related Items section on the Knowledge Management article view page in Knowledge Management Service Portal.

**Note:** Because system administrators can configure the number of catalog items shown in the Related Items section, not all mapped related catalog items might appear in the Related Items section. For more information, see Configure related catalog item widget instance options.

**Related information**

- **Edit a knowledge article in Agent Workspace**
- **Service catalog items**

**Add an affected product to a knowledge article in Agent Workspace**

Add affected products to a knowledge article to view the products associated with the knowledge article.

**Before you begin**

The Knowledge Product Entitlements plugin (com.snc.kb_product_entitlements) must be activated to use the Knowledge Product Entitlements application.
Installing this plugin adds the Affected Products related list to the Knowledge form. For more information, see Knowledge product entitlements.

You must have contribute access to the knowledge base that stores the knowledge article for which you want to add affected products.

Role required: agent_workspace_user

About this task
This task provides steps to add affected products to a knowledge article in Agent Workspace. You can also add affected products to a knowledge article using the Knowledge Management application in the Now Platform interface. For more information, see Add a related product to a knowledge base or knowledge article.

Procedure
1. Navigate to Agent Workspace > Agent Workspace Home.
2. Go to Lists > Knowledge > All Articles.
3. Click the link to the knowledge article for which you want to add a related product.
4. On the Knowledge form, in the Affected Products related list, click New.
5. On the Knowledge Related to Products form, in the Configuration item field, click the search for record icon (🔍).
6. In the Configuration item dialog box, click the related product.
7. Click Save.

Related information
Edit a knowledge article in Agent Workspace

Schedule a knowledge article for publishing in Agent Workspace
Set a specific time and day for a knowledge article to be published in Agent Workspace automatically.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article you want to schedule for publishing.
Ensure that the system administrator verifies the following settings:
• Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated. For more information, see Activate the Knowledge Management Advanced plugin.

• The article versioning feature is enabled. For more information, see Article versioning.

Note: You can also schedule a knowledge article for publishing from the Knowledge Management application in the Now Platform interface. For more information, see Schedule a knowledge article for publishing.

Role required: agent_workspace_user

Procedure
1. Navigate to Agent Workspace > Agent Workspace Home.
2. Go to Lists > Knowledge > My Articles - Unpublished Articles.
3. Click an article link.
4. In the Scheduled publish date field, click the show calendar icon (📅).
5. Select any future date in the calendar.
6. In the Select Time field, enter a time in the format hh:mm:ss.
7. Click OK.
8. Click Publish to enable the publishing workflow.

Tip: If you want to cancel an article’s scheduled publication and move the article back to the Draft state, click Recall.

Results
The knowledge article is published on the scheduled publish date depending on the following workflow settings of its knowledge base:

• If the knowledge base workflow is set to Knowledge - Instant Publish, the knowledge article is automatically published on the scheduled publish date. The Workflow field on the Knowledge form of the article is updated to Scheduled for publish.

• If the knowledge base workflow is set to Knowledge - Approval Publish, the knowledge article is published on approval completion. The Workflow field on the Knowledge form of the article is updated to Review.

The approval completion affects the scheduled publishing as follows:
If the approvals are completed before the scheduled publish date, the **Workflow** field on the Knowledge form of the article is updated to **Scheduled for publish** and the article is published on the scheduled publish date.

If the approvals are completed after the scheduled publish date, the article is published immediately on the approval completion.

**Related reference**

Knowledge workflows  

**Related information**

Edit a knowledge article in Agent Workspace

**Work on a feedback task in Agent Workspace**

Start working on a feedback task, request clarifications, and resolve or close the feedback task in Agent Workspace. You can view all feedback tasks assigned to you or your ownership group.

**Before you begin**

You must have contribute access to the knowledge base that stores the knowledge article you want to work on.  
Role required: agent_workspace_user

**About this task**

A feedback task is created based on the following types of feedback sources.

<table>
<thead>
<tr>
<th>Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User feedback</td>
<td>Knowledge article was marked as not helpful or given low ratings.</td>
</tr>
<tr>
<td>Internal feedback</td>
<td>Knowledge article was flagged.</td>
</tr>
<tr>
<td>Knowledge gap</td>
<td>Knowledge gap feedback task was created for one or more tasks using the Knowledge Demand Insights feature.</td>
</tr>
<tr>
<td>Knowledge gap - manual</td>
<td>Knowledge gap feedback task was created manually from a task, such as a customer service case or an incident.</td>
</tr>
<tr>
<td>Unsuccessful search</td>
<td>Knowledge gap feedback task was created from the Unsuccessful Searches report in the Self-Service Analytics for Customer Service dashboard.</td>
</tr>
<tr>
<td>Other</td>
<td>Feedback for a knowledge article from other sources.</td>
</tr>
<tr>
<td>Source</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Note:</td>
<td>When you upgrade your instance, for any existing records that don’t have any feedback task type set or don’t match with supported types, the feedback task type is automatically set to Other.</td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to **Agent Workspace > Agent Workspace Home**.
2. Click **Lists > Knowledge > My Tasks - Feedback**.
3. Click the link to a feedback task number.
4. On the Knowledge Feedback Task form, review the feedback given by the submitter.
5. Work on the feedback task.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start working on the feedback task</td>
<td>From the State list, select <strong>Work in progress</strong>. You can save the feedback task, edit the knowledge article for which the feedback task was added, or create another knowledge article from a feedback task if the information in the existing article is irrelevant or obsolete. For more information, see Create a knowledge article from a feedback task in Agent Workspace and Edit a knowledge article from a feedback task in Agent Workspace.</td>
</tr>
</tbody>
</table>
| Request clarification from the feedback submitter | a. From the State list, select **Awaiting information**.  
   b. In the **Additional comments** field, enter the information you need from the submitter of the feedback task.  
   When you save the feedback task form, an email notification is sent to the feedback task submitter. |
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Resolve the feedback task</strong></td>
<td></td>
</tr>
</tbody>
</table>
- a. From the State list, select **Resolved**.  
- b. From the Resolution Code list, select a code for resolving the feedback task.  
- c. In the **Resolution notes** field, enter the reason for the resolution.  

When you save the feedback task form, an email notification is sent to the feedback submitter to accept or reject the feedback.  

Note: If the submitter accepts the feedback resolution, the state for the feedback task is automatically set to **Closed**. |
| **Close the feedback task without the submitter having to accept the feedback resolution** |  
- From the State list, select **Closed**. |
| 6. **Optional:** | In the Compose section, enter comments, which all viewers can see, or work notes, which only internal users can see. |
| 7. **Optional:** | Track the time spent on each state for a feedback task by clicking the **Knowledge Feedback Task Metrics** tab and then clicking a link to the state in the **Value** column. |
| 8. **Click Save.** |  

**Results**  
The feedback task is updated.  

**Related information**  
- View a knowledge article in Agent Workspace  

**Create a knowledge article from a feedback task in Agent Workspace**  
When working on a knowledge article feedback task, if the current knowledge article doesn’t address the issue, you can create another knowledge article from within the task. A feedback task is created for a knowledge article when the article is flagged, marked as not helpful, or rated low, or a knowledge gap feedback task is created on a topic.
Before you begin
You must have contribute access to the knowledge base that stores the knowledge article.
Role required: agent_workspace_user

About this task
A feedback task is created in the following ways:

- When a user provides a feedback for the knowledge article. For more information, see Provide feedback for a knowledge article in Agent Workspace.
- When knowledge gap feedback tasks are created on a topic from a demand insights dashboard. For more information, see Analyze knowledge gaps from a demand insights dashboard and create knowledge gap feedback tasks.

Procedure
1. Navigate to Agent Workspace > Agent Workspace Home.
2. Go to your tasks list.
   - For feedback tasks created through knowledge gaps or if a knowledge article was marked as not helpful or rated low, go to Knowledge > My Tasks - Feedback.
   - For tasks created when an article was flagged, go to Knowledge > My Tasks - Flagged.
3. In the Number column, click the link to a feedback task assigned to you or your ownership group.
4. Click Create Article.
5. Create the knowledge article by either selecting an article template or using the default template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected article template</td>
<td>Select an article template to create a knowledge article using defined fields and values. In the Create Article dialog box:</td>
</tr>
<tr>
<td></td>
<td>a. From the Knowledge Base list, select a knowledge base.</td>
</tr>
<tr>
<td></td>
<td>b. From the Article Template list, select the desired article template.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Option Description</td>
<td><strong>Note:</strong> The Article Template list is populated based on the article templates configured for the selected knowledge base.</td>
</tr>
<tr>
<td>c. Click <strong>Create Article</strong></td>
<td>The Create Article dialog box is available if the article versioning and the Knowledge Article Templates features are enabled. For more information, see Article versioning and Knowledge article templates.</td>
</tr>
<tr>
<td>Default Standard template</td>
<td>Create a knowledge article using the default Standard template.</td>
</tr>
</tbody>
</table>

6. On the Knowledge form, fill in the fields.

**Note:** If you are using an article template, the fields that are available will vary.

<table>
<thead>
<tr>
<th>Knowledge form</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Knowledge base</td>
<td>Knowledge base in which the knowledge article is stored. You can associate a knowledge article with one knowledge base only. If you are using an article template, you can modify this value only if the template is available in the other knowledge base.</td>
</tr>
<tr>
<td></td>
<td>Category</td>
<td>Category for the knowledge article. This value helps users find the article within a selected category. You can select only categories available within the selected knowledge base. Articles without a category appear in the (empty) category.</td>
</tr>
<tr>
<td></td>
<td>Ownership Group</td>
<td>Ownership group for the knowledge article. An ownership group consists of a group of members and a manager who are responsible for approvals and feedback tasks. Ownership groups can publish, edit, and retire knowledge articles that they are associated with.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available only if the glide.knowman.ownership_group.enabled property is enabled. If no ownership group is assigned and approvals are required to publish a knowledge article, it is automatically submitted for approval to the knowledge administrator and knowledge manager. For more information, see Ownership groups.</td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td>Automatically generated article version number. This number is incremented when changes are made to a published article.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available if the article versioning feature has been enabled.</td>
<td></td>
</tr>
<tr>
<td>Workflow</td>
<td>Publishing workflow state of the knowledge article, such as <strong>Draft</strong>, <strong>In Review</strong>, or <strong>Published</strong>. For a new article, the workflow state is set to <strong>Draft</strong>.</td>
<td></td>
</tr>
<tr>
<td>Language</td>
<td>Language in which you are creating the knowledge article. The list is populated based on the languages enabled for the selected knowledge base. This field appears only when the I18N:Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2) is activated. For more information, see I18N - Knowledge internationalization.</td>
<td></td>
</tr>
<tr>
<td>Short description</td>
<td>Title of the knowledge article. This title appears when browsing and searching for knowledge article, and at the top of the article.   You can enter up to 100 characters in this field.  <strong>Note:</strong> Knowledge articles similar to the entered short description text will appear in Agent assist.</td>
<td></td>
</tr>
<tr>
<td>Article body</td>
<td>Content for the knowledge article. Use the editing functions in the HTML editor to create content. For more information, see Editing functions for knowledge articles in the HTML editor.</td>
<td></td>
</tr>
<tr>
<td>Source Task</td>
<td>Task this knowledge article was created from. This field is set automatically when you create the knowledge article from a task, such as an incident or a customer service case, or from a submission record.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Scheduled publish date</td>
<td>Future date when the knowledge article will be published automatically. For more information, see Schedule a knowledge article for publishing in Agent Workspace.</td>
<td></td>
</tr>
<tr>
<td>Valid to</td>
<td>The date this knowledge article expires. Articles do not appear in search results after the Valid to date or if the Valid to date is blank.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The default value of the Valid to field is derived from the Article Validity field configured for the knowledge base (see Create a knowledge base). The Valid to date starts from the date the article was created until the number of days specified in the Article Validity field. If the Article Validity field is blank, the default date in the Valid to field for the knowledge article is set to January 1, 2100.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>An article author or editor can select whether to keep or change the default Valid to date. For more information, see Knowledge article validity.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>On the first day of each month, the application sends an email notification to a list of authorized recipients to remind them about articles that are about to expire in the next month. The recipient can then extend the Valid to date to continue using the article. For more information, see Knowledge Management email notifications.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note: If the system date format or user preferences is set to use yy year format, you might face issues when the Valid to date is set to the default date. Contact your system administrator or modify the user preferences to use a date format with the yyyy year format. For more information, see Global date and time field format and Personalize the system date format topics.</td>
<td></td>
</tr>
<tr>
<td>Confidence</td>
<td>Maturity of an article based on its completeness and reusability.</td>
<td></td>
</tr>
<tr>
<td>Article type</td>
<td>Type of the article, which is automatically set to HTML. This field is available in the Standard template only.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note: The Wiki article type isn’t supported in Agent Workspace.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Note</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display attachments</td>
<td>Option to display attachments in the knowledge article. If the article has attachments, they are listed below the text of a knowledge article on the knowledge article view page.</td>
<td>Although you may attach multiple files, most web browsers permit users to download only the first attachment. To ensure download of all the files, bundle them into an archive and attach the archive.</td>
</tr>
<tr>
<td>Attachment link</td>
<td>Option to automatically download an attached article when a user access an article instead of opening the article. The Attachment link option applies to articles accessed from search links only. Articles accessed from links within other knowledge articles will not automatically download an attached file.</td>
<td></td>
</tr>
<tr>
<td>Governance</td>
<td>An attribute of an article that allows you to control sensitive, critical, or regulated information. Not all articles have the same requirement for compliance reviews. Some articles are based on the collective experience of those who use the articles (experience-based). Other articles have policy or legal information that require tight control (compliance-based).</td>
<td></td>
</tr>
<tr>
<td>Issue</td>
<td>Brief description about an issue.</td>
<td>This field is available in the KCS Article template only.</td>
</tr>
<tr>
<td>Environment</td>
<td>Details of the environment in place when the issue occurred.</td>
<td>This field is available in the KCS Article template only.</td>
</tr>
<tr>
<td>Cause</td>
<td>The cause of the issue.</td>
<td>This field is available in the KCS Article template only.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Method used to resolve the issue.</td>
<td>This field is available in the KCS Article template only.</td>
</tr>
<tr>
<td>Question</td>
<td>Text to display as a question.</td>
<td>This field is available in the FAQ template only.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Answer</td>
<td>Text to display as an answer to an included question.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note: This field is available in the FAQ template only.</td>
<td></td>
</tr>
<tr>
<td>Introduction</td>
<td>Introduction to the topic.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note: This field is available in the How To and What Is templates only.</td>
<td></td>
</tr>
<tr>
<td>Instructions</td>
<td>Instructions for a how-to topic.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note: This field is available in the How To template only.</td>
<td></td>
</tr>
<tr>
<td>Explanation</td>
<td>Explanation of a what-is topic.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note: This field is available in the What Is template only.</td>
<td></td>
</tr>
</tbody>
</table>

Note: The **Confidence** and **Governance** fields appear when the Knowledge Management KCS Capabilities plugin (com.snc.knowledge_kcs_capabilities) is activated. For more information, see Managing the KCS article state.

7. Optional: Research for content related to knowledge article you’re authoring using Agent assist.

   a. In the contextual side panel, click the Agent Assist icon (🔍).
      The search results in Agent assist display default content based on the text-based search.

   b. Click the select a search resource icon (🔍), and then select a search resource.
      For example, to view knowledge articles, select **Knowledge Articles**.

   c. Optional: In the search results, you can click a resource item, such as a knowledge article, to view its content in Agent assist.

   ⚫ Tip: For better readability, you can resize the contextual side panel for Agent assist. For a full view of the selected resource item content, click **Full View**. The resource item content opens in another tab within the Agent Workspace.

8. Optional: Check whether your content matches content in an existing article.
a. Enter search text in the text box available in Agent assist or retain the default text, which is the short description of the knowledge article.

b. Click the lookup icon (🔍).

c. Select a search resource by clicking the Select a search resource icon (🔍).
   - To find knowledge articles that have high text similarity with the entered search text, choose Similar Articles (ML).

   **Note:** This option is available only when the Predictive Intelligence feature is enabled and your system administrator has trained the similarity solution for Knowledge Management. For more information, see Train the similarity solution for Knowledge Management to find related articles.

   - To find knowledge articles that match the entered search text, choose Knowledge Articles.

9. Click **Save**.
   The article is saved and appears in the My Articles - Unpublished list and additional functionality becomes available on the form.

10. **Optional:** Either add to or modify the article details or publish the article.
    - Add to or modify the article details.
      (Optional) For more information, see Edit a knowledge article in Agent Workspace.
    - Publish the article by clicking **Publish**.
      A knowledge article is published depending on the workflow setting of its knowledge base:
      - **Knowledge - Instant Publish:** The knowledge article is immediately published unless it is scheduled to be published at a later date.
      - **Knowledge - Approval Publish:** The knowledge article is published on approval completion unless it is scheduled to be published at a later date.

   **Note:** With an ownership group associated with a knowledge article, ownership group members can approve self-authored articles for publication. An administrator can override this behavior by disabling the glide.knowman.ownership_group.enable_self_approval property. For more information, see Ownership groups.

   For more information, see Schedule a knowledge article for publishing in Agent Workspace.
When published, your knowledge article appears in the My Articles - Published and All Articles lists. If the article versioning feature is enabled, the version number of the knowledge article is updated. For more information, see Knowledge article version numbers.

**What to do next**
After you create and publish a knowledge article, you can perform the following actions related to the article:

- Request translations for the knowledge article. For more information, see Request translations for missing languages in Agent Workspace.
- Retire the knowledge article. Click **Retire** to enable the retirement workflow. For more information, see Retire a knowledge article.
- Translate the knowledge article directly from the knowledge article. For more information, see Translate a knowledge article in Agent Workspace.
- Delete the published knowledge article. Click **Delete**. If the **Delete** button isn't displayed, click the more actions icon (⋯), and then click **Delete**.

⚠ **Note:** Only users with the admin role can delete a published knowledge article.

**Related information**
- View a knowledge article in Agent Workspace
- Using Agent Assist in Agent Workspace
- Edit a knowledge article from a feedback task in Agent Workspace

When working on a knowledge article task, you can edit the knowledge article from within the task. A feedback task is created for a knowledge article when the article is flagged, marked as not helpful, or rated low, or a knowledge gap feedback task is created on a topic.

**Before you begin**
Role required: You must have contribute access to the knowledge base that stores the knowledge article.

⚠ **Note:** If the article versioning feature is enabled, only the knowledge administrator, knowledge managers, and author can edit the checked-out version of an article. If the feature is disabled, any users with contribute access to an article can edit the draft version of the article. An administrator can disable the article versioning feature by setting the `glide.knowman.versioning.enabled` property (from the System Property [sys_properties] table) to `false`. 
Role required: agent_workspace_user

Procedure
1. Navigate to **Agent Workspace** > **Agent Workspace Home**.
2. Go to your tasks list.
   - For feedback tasks created through knowledge gaps or if a knowledge article was marked as not helpful or rated low, go to **Knowledge** > **My Tasks** - **Feedback**.
   - For tasks created when an article was flagged, go to **Knowledge** > **My Tasks** - **Flagged**.
3. In the **Number** column, click the link to a feedback task assigned to you or your ownership group.
4. Click **Edit Article**.
5. If the article versioning feature is enabled, click **Checkout** for a published knowledge article.
   You can only edit the latest version of a knowledge article.
6. Access the relevant related lists to modify the information.

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>Knowledge article content and its metadata.</td>
</tr>
</tbody>
</table>
**Note:** If the article versioning feature is enabled, the default value of the **Valid to** date in the updated article version is automatically set based on the following criteria:

- If the **Article Validity** field in the knowledge base associated with the article is blank, the **Valid to** date value from the earlier version of the article is retained.

- If the **Article Validity** field in the knowledge base associated with the article is not blank, the **Valid to** date is automatically updated to start from the date the article was updated until the number of days specified in the **Article Validity** field (Article updated date + article validity).

If you move a knowledge article to another knowledge base, the default value of the **Valid to** date in the updated article is automatically set based on the following criteria:

- If the **Article Validity** field in the selected knowledge base is blank, the earlier **Valid to** date value is retained for the knowledge article.

- If the **Article Validity** field in the selected knowledge base isn't blank, the **Valid to** date is automatically updated to start from the date the article was updated until the number of days specified in the **Article Validity** field (Article updated date + article validity).

If the dictionary value of the **Valid to** field is modified, this dictionary value overrides the default value of the **Valid to** field calculated according to the **Article Validity** field. For more information, see Knowledge article validity.

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feedback</td>
<td>Feedback received on the published versions of the article. To view more details about the feedback, in the <strong>Comments</strong> column, click a link for the desired version of an article.</td>
</tr>
<tr>
<td>Feedback Tasks</td>
<td>Details about the feedback task created for a knowledge article version.</td>
</tr>
<tr>
<td>Approvals</td>
<td>Approval history of the knowledge article.</td>
</tr>
<tr>
<td>Article Versions</td>
<td>Version history of the knowledge article.</td>
</tr>
<tr>
<td>Translated Versions</td>
<td>Translated versions of the knowledge article.</td>
</tr>
<tr>
<td>Related list</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>This related list appears only when the translation management feature is enabled. To translate a knowledge article, click New. The New button on this related list appears when the glide.knowman.translation.enable_translation_task property is disabled.</td>
<td></td>
</tr>
<tr>
<td>Translation Tasks</td>
<td>Tasks submitted for translating the article. This related list appears when the Translation Management feature and the glide.knowman.translation.enable_translation_task property to enable creation of translation tasks are enabled. For more information, see Knowledge Management properties.</td>
</tr>
<tr>
<td>Related Articles</td>
<td>Related articles mapped to the knowledge article. For more information, see Map a related article in Agent Workspace.</td>
</tr>
<tr>
<td>Related Catalog Items</td>
<td>Related catalog items mapped to the knowledge article. For more information, see Map a related item in Agent Workspace.</td>
</tr>
<tr>
<td>Affected Products</td>
<td>Products mapped to the knowledge article. For more information, see Add an affected product to a knowledge article in Agent Workspace.</td>
</tr>
</tbody>
</table>

7. **Optional:** Research for content related to knowledge article you’re authoring using Agent assist.

   a. In the contextual side panel, click the Agent Assist icon (🔍).
   The search results in Agent assist display default content based on the text-based search.

   b. Click the select a search resource icon (🔍), and then select a search resource.
   For example, to view knowledge articles, select Knowledge Articles.

   c. **Optional:** In the search results, you can click a resource item, such as a knowledge article, to view its content in Agent assist.

   ✨ **Tip:** For better readability, you can resize the contextual side panel for Agent assist. For a full view of the selected resource item content, click Full View. The resource item content opens in another tab within the Agent Workspace.

8. **Optional:** Check whether your content matches content in an existing article.

© 2021 ServiceNow, Inc. All rights reserved.
a. Enter search text in the text box available in Agent assist or retain the default text, which is the short description of the knowledge article.

b. Click the lookup icon (🔍).

c. Select a search resource by clicking the Select a search resource icon (🔍).

• To find knowledge articles that have high text similarity with the entered search text, choose Similar Articles (ML).

  Note: This option is available only when the Predictive Intelligence feature is enabled and your system administrator has trained the similarity solution for Knowledge Management. For more information, see Train the similarity solution for Knowledge Management to find related articles.

• To find knowledge articles that match the entered search text, choose Knowledge Articles.

9. Click Save.
The article is saved and appears in the My Articles - Unpublished list. If the article versioning feature is enabled, the version of the knowledge article is incremented by 0.01. For more information, see Knowledge article version numbers.

10. Optional: Publish the article by clicking Publish.
The knowledge article is published depending on the workflow setting of its knowledge base:

• Knowledge - Instant Publish: The knowledge article is immediately published unless it is scheduled to be published at a later date.

• Knowledge - Approval Publish: The knowledge article is published on approval completion unless it is scheduled to be published at a later date.

  Note: With an ownership group associated with a knowledge article, ownership group members can approve self-authored articles for publication. An administrator can override this behavior by disabling the glide.knowman.ownership_group.enable_self_approval property. For more information, see Ownership groups.

For more information, see Schedule a knowledge article for publishing in Agent Workspace.

When published, the knowledge article appears in the My Articles - Published and All Articles lists. If the article versioning feature is enabled, the version
number of the knowledge article increments to the next whole number (for example, from 2.02 to 3.0). For more information, see Knowledge article version numbers.

Related information

- Work on a feedback task in Agent Workspace
- Create a knowledge article from a feedback task in Agent Workspace
- View a knowledge article in Agent Workspace
- Provide feedback for a knowledge article in Agent Workspace
- Using Agent Assist in Agent Workspace

Compare knowledge article versions in Agent Workspace

Select and compare two versions of a knowledge article in Agent Workspace to view the differences between them.

Before you begin

You must have contribute access to the knowledge base that stores the knowledge article.

Role required: agent_workspace_user

Procedure

1. Navigate to Agent Workspace > Agent Workspace Home.
2. Click Lists > Knowledge > All Articles.
3. Click the link to a knowledge article for which you want to compare two versions.
4. Click Edit to open the Knowledge article form.
5. In the Article Versions related list, select the two versions of the article to compare.
6. Click Compare.

Results

The Compare versions tab opens within Agent Workspace and lists the fields for the selected versions in a side-by-side format. Any differences between the two versions are highlighted as shown in the following example image.
Example: Compare article versions

Recall an article that is being reviewed in Agent Workspace

Recall an article that is being reviewed to stop the approval process.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article you want to recall.
Ensure that the article versioning feature is enabled. For more information, see Article versioning.

Role required: agent_workspace_user

About this task
The author of a knowledge article, knowledge administrators, and system administrators can recall the article. If an ownership group is assigned to a knowledge article, the ownership group manager and ownership group members can also recall the knowledge article.

If a version of a knowledge article is in the Review workflow state, you can recall only the corresponding version to make additional changes. Recalling the article results in a minor version increment.
Procedure
1. Navigate to Agent Workspace > Agent Workspace Home.
2. Go to Lists > Knowledge > All Articles.
3. Click the link to the article in Review workflow state that you want to recall.
4. On the Knowledge form, click Recall.

Results
The article opens in edit mode and the workflow state of the article is changed to Draft. The version number of the article increments by 0.01.

Related reference
Related information
Knowledge workflows
Edit a knowledge article in Agent Workspace

Approve a knowledge article in Agent Workspace
Approve a knowledge article that is awaiting your review in Agent Workspace.

Before you begin
Role required: agent_workspace_user

About this task
If the article versioning feature is enabled, only users who are assigned as approvers can modify a knowledge article that is in the Review state. If you are not an approver but need to modify the article, consider recalling the article. For more information, see Recall an article that is being reviewed in Agent Workspace.

Procedure
1. Navigate to Agent Workspace > Agent Workspace Home.
2. Go to Lists > Knowledge > My Articles - Unpublished.
3. Click an article link in Review workflow state.
4. Click Edit.
5. In the Approvals related list, in the State column, click Requested.
   The Approval form opens in another tab within Agent Workspace.
6. From the State list, select Approved.
7. Click Save.
The approved knowledge article is published immediately or on the scheduled publish date, if the article is scheduled for publishing. If the article versioning feature is enabled, the version number of the knowledge article increments to the next whole number (for example, from 2.02 to 3.0). On the Knowledge form of the article, the workflow state changes to Published. The new published version of the article is added to the Article Versions related list on the Knowledge form. The version is also available in the All Articles list in Agent Workspace, go to Knowledge > All Articles.

Related information
View a knowledge article in Agent Workspace

Request translations for missing languages in Agent Workspace
Request to translate a published knowledge article in available languages by creating a translation task in Agent Workspace.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article.
Ensure that the system administrator verifies the following settings:

• Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated.
• I18N: Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2) is activated.

⚠️ Note: The I18N: Internationalization plugin (com.glide.i18n) activates the I18N: Knowledge Management Internationalization Plugin v2 plugin.

• The glide.knowman.translation.enable_translation_task property is set to true in the Now Platform interface. For more information, see Knowledge Management properties.

Role required: agent_workspace_user

Procedure
1. Navigate to Agent Workspace > Agent Workspace Home.
2. Click Lists > Knowledge > All Articles.
3. Click the link to a knowledge article for which you want to create a translation task.
4. On the Knowledge form, click Edit.
5. Click Request translations.
6. In the Request translation dialog box, select one or more available languages in the Select languages list. If a language appears grayed out, a translation is already in progress or has been completed for that language. Some languages might not be available if the system administrator has configured only specific languages for the knowledge base in which the article is contained.

7. Click **Submit**.

**Results**
The translation task is created for the article in the selected languages and assigned to a group or user based on assignment rules, if configured.

**Related information**
- Create translation assignments
- Translate a knowledge article from a translation task in Agent Workspace

**Translate a knowledge article in Agent Workspace**
Translate published knowledge articles to make them available in other languages.

**Before you begin**
You must have contribute access to the knowledge base that stores the knowledge article.
Ensure that the system administrator verifies the following settings:

- Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated.
- I18N: Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2) is activated.

**Note:** The I18N: Internationalization plugin (com.glide.i18n) activates the I18N: Knowledge Management Internationalization Plugin v2 plugin.
• The `glide.knowman.translation.enable_translation_task` property is set to `true` in the Now Platform interface. For more information, see Knowledge Management properties.

<i>Note:</i> When the `glide.knowman.translation.enable_translation_task` property is set to `false`, translate the knowledge article by clicking <b>New</b> in the Translated version related list of a Knowledge form. The Knowledge form that is displayed to translate the article is based on the article template of the source knowledge article. You can enter your translation content in the Knowledge form. For more information about the Knowledge form, see <a>Create a knowledge article in Agent Workspace</a>.

Role required: agent_workspace_user

**About this task**
If you have contribute access to a knowledge article, you can translate a knowledge article directly from the knowledge form. If your system administrator has configured languages for the knowledge base, you can translate into those languages only. For more information, see <a>Create a knowledge base</a>.

<i>Note:</i> The translation management feature isn't available for knowledge blocks in Agent Workspace.

**Procedure**
1. Navigate to <b>Agent Workspace > Agent Workspace Home</b>.
2. Click <b>Lists > Knowledge > All Articles</b>.
3. In the <b>Number</b> column, click the link to a knowledge article that you want to translate.
4. Click <b>Edit</b>.
5. Click <b>Translate</b>.

<i>Note:</i> The <b>Translate</b> button is not available if the `glide.knowman.translation.enable_translation_task` property is disabled, translations of the knowledge article are available in all available languages, or a translation task has already been created for all the available languages.

The Original language and Translated language sections appear side by side for easy viewing, as shown in the following figure. The text in the Translated language section still appears in the original language content.
6. Provide the translation in the Translated language section.

- If dynamic translation is enabled, click **Machine translate** to automatically replace the draft content in the Translated language section with machine-translated content in the targeted language.

  Note: A default translator configuration should be available. For configuring the translation API, see **Dynamic Translation**.

  When you click **Machine translate**, any draft content in the Translated language section is automatically replaced with the machine-translated content.

- If dynamic translation is not available, replace the draft content in the Translated language section with your translated text.

7. Click **Create draft article** to create a draft version of the translated article.

8. Click **Publish**.

**Results**

When the translated version of the knowledge article is published, a new knowledge number is assigned to the translated version. The translated version is available in the All Articles list in Agent Workspace. Also, the Translated Versions related list on the Knowledge form of the original and translated knowledge article is updated with all the translated versions.

**Related information**

- Request translations for missing languages in Agent Workspace
- Translation management
Translate a knowledge article from a translation task in Agent Workspace

Translate a published knowledge article for which you have been assigned a translation task.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article.
Ensure that the system administrator verifies the following settings:

• Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated.
• I18N: Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2) is activated.

ℹ️ Note: The I18N: Internationalization plugin (com.glide.i18n) activates the I18N: Knowledge Management Internationalization Plugin v2 plugin.
• The `glide.knowman.translation.enable_translation_task` property is set to `true` in the Now Platform interface. For more information, see Knowledge Management properties.

Role required: agent_workspace_user

About this task
A translation task is created for a knowledge article when a request for translation is submitted or its knowledge base is configured to automatically create translation tasks. For more information, see Request translations for missing languages in Agent Workspace and Create a knowledge base.

ℹ️ Note: The translation management feature isn’t available for knowledge blocks in Agent Workspace.

Procedure
1. Navigate to Agent Workspace > Agent Workspace Home.
2. Click Lists > Knowledge > My Tasks - Translation.
3. In the Number column, click the link to a translation task.
4. Click Translate.

ℹ️ Note: The Translate button is not available if the `glide.knowman.translation.enable_translation_task` property is disabled, translations of the knowledge article are available in all available languages, or a translation task has already been created for all the available languages.
The Original language and Translated language sections appear side by side for easy viewing, as shown in the following figure. By default, the Translated language section includes the original language content.

5. Provide the translation in the Translated language section.
   - If dynamic translation is enabled, click **Machine translate** to automatically replace the draft content in the Translated language section with machine-translated content in the targeted language.

   ![Image showing Translate Article](image)

   **Note:** A default translator configuration should be available. For configuring the translation API, see **Dynamic Translation**.

   When you click **Machine translate**, any draft content in the Translated language section is automatically replaced with the machine-translated content.

   - If dynamic translation is not available, replace the draft content in the Translated language section with your translated text.

6. Click **Create draft article** to create a draft version of the translated article.
7. Click **Publish**.

**Results**

When the translated version of the knowledge article is published, a new knowledge number is assigned to the translated version. The translated version is available in the All Articles list in Agent Workspace. Also, the Translated Versions related list on the Knowledge form of the original and translated knowledge article is updated with all the translated versions.
Related information

- Request translations for missing languages in Agent Workspace
- Translation management

Knowledge article authoring in Microsoft Word

You can author and access knowledge articles in Microsoft Word by deploying the Knowledge Management - Add-in for Microsoft Word.

As a user with contribute access to a knowledge base, you can open, create, edit, publish, and search for knowledge articles from within the Knowledge Management pane in Microsoft Word. A user with read access to a knowledge base, can view the article in Microsoft Word. The Knowledge Management - Add-in for Microsoft Word is available in the online version of Microsoft Word only.

The Knowledge Management - Add-in for Microsoft Word is supported for use only in applications integrated with the online version of Microsoft Word such as Microsoft SharePoint and Microsoft OneDrive.

Note the following points when using the Knowledge Management - Add-in for Microsoft Word to maintain knowledge articles:

- The Knowledge Management - Add-in for Microsoft Word is supported in the Word Online application and not in the Word Desktop app.
- The URL is automatically generated for Word documents created in Microsoft SharePoint and Microsoft OneDrive with business accounts only.

For other applications and account types, you must manually enter the URL in the Document URL field. You enter the document URL in the Document URL field on the Knowledge form in Microsoft Word. For more information, see Create a knowledge article in Microsoft Word.

- The time taken to convert a knowledge article from a Word document is proportional to the document size.
- Headers and footers corresponding to pages in the Word document appear as-is in the knowledge article.

You can remove headers and footers from the pages in the Word document so that they don't appear in the knowledge article.

Activation information

The Knowledge Management - Add-in for Microsoft Word (com.snc.knowledge.ms_word) is required to enable you to interact with knowledge articles from within the Word Online application. For more information, see Activate Knowledge Management - Add-in for Microsoft Word.
Related information

- View a knowledge article in Microsoft Word
- Create a knowledge article in Microsoft Word
- Edit a knowledge article in Microsoft Word
- Publish a knowledge article in Microsoft Word
- Configure Knowledge Management - Add-in for Microsoft Word

Log in to your ServiceNow instance for authoring knowledge articles in Microsoft Word

Author and collaborate on knowledge articles in Microsoft Word by logging in to your ServiceNow instance from the Word Online application.

Before you begin
You must have contribute access to the knowledge base within which you want to create the knowledge article.
The system administrator and Office 365 administrator have configured the Knowledge Management - Add-in for Microsoft Word. (For more information, see Configure Knowledge Management - Add-in for Microsoft Word.)

About this task
You need to authenticate with your ServiceNow instance credentials for accessing and creating knowledge articles using Microsoft Word. You might also need to re-authenticate if your session has expired.

Procedure
1. Sign in to your Office 365 account.
2. From the Microsoft 365 app launcher, select the icon to launch the Microsoft Word app.
   For more information, see Use the Office 365 app launcher.
3. In the New section, click New blank document, or open any existing Microsoft Word document.
4. On the Home tab, click the Knowledge icon ( ).
5. In the Knowledge Management pane of the Word document, click Log in to ServiceNow.
   The ServiceNow login page opens in a separate tab of your browser.
6. On the ServiceNow login page, enter your ServiceNow credentials.
Results
After successful authentication, the ServiceNow instance browser tab closes and you are redirected to the Microsoft Word browser tab. On the Microsoft Word document, the Knowledge Management pane displays the welcome screen.

View a knowledge article in Microsoft Word
View a knowledge article in Microsoft Word, including the article number, short description, and article content.

Before you begin

• Ensure that the system administrator has configured the Knowledge Management - Add-in for Microsoft Word. (For more information, see Configure Knowledge Management - Add-in for Microsoft Word.)

• You must have logged in to your ServiceNow instance from the Word Online application. For more information, see Log in to your ServiceNow instance for authoring knowledge articles in Microsoft Word.

• You must have read access to the knowledge article.

• You must have signed in to your Office 365 account.

Procedure
1. From the Microsoft 365 app launcher, select the icon to launch the Microsoft Word app. For more information, see Use the Office 365 app launcher.

2. In the New section, click New blank document, or open any existing Microsoft Word document.

3. On the Home tab of the Word document, click the Knowledge icon ( )

4. Access the article in the Knowledge Management pane of the Word document.
   • In the Knowledge Management pane, in the Search box, enter the knowledge article number or description.
   • In the Knowledge Management pane, click a knowledge base to view a list of knowledge articles within the knowledge base. All knowledge bases and associated knowledge articles for which you have contribute or read access appear in the Knowledge Management pane.
5. In the Knowledge Management pane, click the link to the knowledge article that you want to view.

**Tip:** To go back to the previous view in the Knowledge Management pane, click the left caret icon (←). To go back to the landing screen, click the home icon (🏠).

**Results**

If a knowledge article was created from the Knowledge Management application in the Now Platform interface, the article content appears in the Document pane and the article details appear in the Knowledge Management pane of the Microsoft Word document.

If a knowledge article was created using another Word document, the document opens in a new browser tab with the content in the Document pane and the article details in the Knowledge Management pane of that document.

**Note:** If the article uses a template, the article opens in the Now Platform interface in a new browser tab. You can’t edit articles with templates in Microsoft Word.

The following article details appear in the Knowledge Management pane.

### Knowledge form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated knowledge article number.</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>Knowledge base in which the knowledge article is stored. You can associate a knowledge article with one knowledge base only.</td>
</tr>
<tr>
<td>Category</td>
<td>Category for the knowledge article. This value helps users find the article within a selected category. You can select only categories available within the selected knowledge base. Articles without a category appear in the (empty) category.</td>
</tr>
<tr>
<td>Ownership Group</td>
<td>Ownership group for the knowledge article. An ownership group consists of a group of members and a manager who are responsible for approvals and feedback tasks. Ownership groups can publish, edit, and retire knowledge articles that they are associated with.</td>
</tr>
</tbody>
</table>
Knowledge form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>This field is available only if the <code>glide.knowman.ownership_group.enabled</code> property is enabled. If no ownership group is assigned and approvals are required to publish a knowledge article, it is automatically submitted for approval to the knowledge administrator and knowledge manager. For more information, see Ownership groups.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Publishing workflow state of the knowledge article, such as Draft, In Review, or Published. For a new article, the workflow state is set to Draft.</td>
</tr>
<tr>
<td>Short description</td>
<td>Title of the knowledge article. This title appears when browsing and searching for knowledge article, and at the top of the article. You can enter up to 100 characters in this field.</td>
</tr>
<tr>
<td>Document URL</td>
<td>URL of the article for accessing the online version in Microsoft Word. The URL is automatically generated for Word documents created in Microsoft SharePoint and Microsoft OneDrive with business accounts only. For other applications and account types, you must manually enter the URL in the Document URL field.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Avoid copy-pasting the browser URL, because it might not always work. Depending on the collaboration tool for your Word document use the URL generated specifically for sharing with other users.</td>
</tr>
<tr>
<td></td>
<td>When manually entering the URL:</td>
</tr>
<tr>
<td></td>
<td>• For Microsoft SharePoint, use the URL generated by the Word Online application for specific users you want to have access to the document.</td>
</tr>
<tr>
<td></td>
<td>• For Box, use the Box Shared Link. For more information, see Creating Shared Links.</td>
</tr>
<tr>
<td>Version</td>
<td>Automatically generated article version number. This number is incremented when changes are made to a published article.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field is available if the article versioning feature has been enabled.</td>
</tr>
</tbody>
</table>
**Knowledge form (continued)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Valid to</strong></td>
<td>The date this knowledge article expires. Articles do not appear in search results after the <strong>Valid to</strong> date or if the <strong>Valid to</strong> date is blank. The default value of the <strong>Valid to</strong> field is derived from the <strong>Article Validity</strong> field configured for the knowledge base (see Create a knowledge base). The <strong>Valid to</strong> date starts from the date the article was created until the number of days specified in the <strong>Article Validity</strong> field. If the <strong>Article Validity</strong> field is blank, the default date in the <strong>Valid to</strong> field for the knowledge article is set to January 1, 2100. An article author or editor can select whether to keep or change the default <strong>Valid to</strong> date. On the first day of each month, the application sends an email notification to a list of authorized recipients to remind them about articles that are about to expire in the next month. The recipient can then extend the <strong>Valid to</strong> date to continue using the article. For more information, see Knowledge Management email notifications.</td>
</tr>
<tr>
<td><strong>Scheduled publish date</strong></td>
<td>Future date when the knowledge article will be published automatically. For more information, see Schedule a knowledge article for publishing in Microsoft Word.</td>
</tr>
</tbody>
</table>

**Note:** If the system date format or user preferences are set to use the *yy* year format, you might face issues when the **Valid to** date is set to the default date. Contact your system administrator or modify the user preferences to use a date format with the *yyyy* year format. For more information, see Global date and time field format and Personalize the system date format topics.

**Related information**

- Create a knowledge article in Microsoft Word
- Edit a knowledge article in Microsoft Word

**Create a knowledge article in Microsoft Word**

Create a knowledge article in Microsoft Word to author and collaborate on content using Word.
Before you begin

• Ensure that the system administrator has configured the Knowledge Management - Add-in for Microsoft Word. (For more information, see Configure Knowledge Management - Add-in for Microsoft Word.)

• You must have logged in to your ServiceNow instance from the Word Online application. For more information, see Log in to your ServiceNow instance for authoring knowledge articles in Microsoft Word.

• You must have contribute access to the knowledge base within which you want to create the knowledge article.

• You must have signed in to your Office 365 account.

Procedure

1. From the Microsoft 365 app launcher, select the icon to launch the Microsoft Word app from your Office 365 account and open a Word document. For more information, see Use the Office 365 app launcher.

2. In the New section, click New blank document, or open any existing Microsoft Word document.

3. On the Home tab of the Word document, click the Knowledge icon (Knowledge).

4. In the Knowledge Management pane of the Word document, click Create Article.

5. On the Knowledge form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated knowledge article number.</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>Knowledge base in which the knowledge article is stored. You can associate a knowledge article with one knowledge base only.</td>
</tr>
<tr>
<td>Category</td>
<td>Category for the knowledge article. This value helps users find the article within a selected category. You can select only categories available within the selected knowledge base. Articles without a category appear in the (empty) category.</td>
</tr>
<tr>
<td>Ownership Group</td>
<td>Ownership group for the knowledge article. An ownership group consists of a group of members and a manager who are responsible for approvals and feedback tasks. Ownership</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>groups can publish, edit, and retire knowledge articles that they are associated with.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field is available only if the glide.knownman.ownership_group.enabled property is enabled. If no ownership group is assigned and approvals are required to publish a knowledge article, it is automatically submitted for approval to the knowledge administrator and knowledge manager. For more information, see Ownership groups.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Publishing workflow state of the knowledge article, such as Draft, In Review, or Published. For a new article, the workflow state is set to Draft.</td>
</tr>
<tr>
<td>Short</td>
<td>Title of the knowledge article. This title appears when browsing and searching for knowledge article, and at the top of the article.</td>
</tr>
<tr>
<td>description</td>
<td>You can enter up to 100 characters in this field.</td>
</tr>
<tr>
<td>Document</td>
<td>URL of the article for accessing the online version in Microsoft Word. The URL is automatically generated for Word documents created in Microsoft SharePoint and Microsoft OneDrive with business accounts only. For other applications and account types, you must manually enter the URL in the Document URL field.</td>
</tr>
<tr>
<td>URL</td>
<td><strong>Note:</strong> Avoid copy-pasting the browser URL, because it might not always work. Depending on the collaboration tool for your Word document use the URL generated specifically for sharing with other users. When manually entering the URL:</td>
</tr>
<tr>
<td>Version</td>
<td>Automatically generated article version number. This number is incremented when changes are made to a published article.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Valid to</strong></td>
<td>The date this knowledge article expires. Articles do not appear in search results after the <strong>Valid to</strong> date or if the <strong>Valid to</strong> date is blank. The default value of the <strong>Valid to</strong> field is derived from the Article Validity field configured for the knowledge base (see Create a knowledge base). The <strong>Valid to</strong> date starts from the date the article was created until the number of days specified in the Article Validity field. If the Article Validity field is blank, the default date in the <strong>Valid to</strong> field for the knowledge article is set to January 1, 2100. An article author or editor can select whether to keep or change the default <strong>Valid to</strong> date. On the first day of each month, the application sends an email notification to a list of authorized recipients to remind them about articles that are about to expire in the next month. The recipient can then extend the <strong>Valid to</strong> date to continue using the article. For more information, see Knowledge Management email notifications. <strong>Note:</strong> If the system date format or user preferences are set to use the <strong>yy</strong> year format, you might face issues when the <strong>Valid to</strong> date is set to the default date. Contact your system administrator or modify the user preferences to use a date format with the <strong>yyyy</strong> year format. For more information, see Global date and time field format and Personalize the system date format topics.</td>
</tr>
<tr>
<td><strong>Scheduled publish date</strong></td>
<td>Future date when the knowledge article will be published automatically. For more information, see Schedule a knowledge article for publishing in Microsoft Word.</td>
</tr>
</tbody>
</table>

6. In the Document pane of the Word document, enter the article content.
7. In the Knowledge Management pane of the Word document, click **Submit**.
8. **Optional:** Publish the article by clicking **Publish**.
   (Optional) A knowledge article is published depending on the workflow setting of its knowledge base:
• **Knowledge - Instant Publish**: The knowledge article is immediately published unless it is scheduled to be published at a later date.

• **Knowledge - Approval Publish**: The knowledge article is published on approval completion unless it is scheduled to be published at a later date.

For more information, see [Schedule a knowledge article for publishing in Microsoft Word](#).

If the article versioning feature is enabled, the version number of the knowledge article is updated. For more information, see [Knowledge article version numbers](#).

**What to do next**

You can share the document URL so that users can co-author the document. For more information, see [Document collaboration and co-authoring](#).

**Edit a knowledge article in Microsoft Word**

Use Microsoft Word to edit a knowledge article originally created in Microsoft Word.

**Before you begin**

• Ensure that the system administrator has configured the Knowledge Management - Add-in for Microsoft Word. (For more information, see [Configure Knowledge Management - Add-in for Microsoft Word](#).)

• You must have logged in to your ServiceNow instance from the Word Online application. For more information, see [Log in to your ServiceNow instance for authoring knowledge articles in Microsoft Word](#).

• You must have contribute access to the knowledge article.

• You must have signed in to your Office 365 account.

**About this task**

ℹ️ **Note**: You can’t edit a knowledge article that uses an article template in Word.

**Procedure**

1. From the Microsoft 365 app launcher, select the icon to launch the Microsoft Word app.
   For more information, see [Use the Office 365 app launcher](#).

2. In the New section, click **New blank document**, or open any existing Microsoft Word document.
3. On the Home tab of the Word document, click the Knowledge icon ().

4. Access the article in the Knowledge Management pane of the Word document.
   - In the Knowledge Management pane, in the Search box, enter the knowledge article number or description.
   - In the Knowledge Management pane, click a knowledge base to view a list of knowledge articles within the knowledge base. All knowledge bases and associated knowledge articles for which you have contribute or read access appear in the Knowledge Management pane. However, you can edit knowledge articles for which you have contribute access.

5. In the Knowledge Management pane, click the link to the knowledge article that you want to edit.

6. If the Document pane of the Word document contains any content, retain or replace the content.
   - To overwrite the existing content in the Word document with content from the article you selected, click Replace.
   - To keep the existing content in the Word document, click Retain.

   ✟ Note: When you save the article, the Word document content will replace the article content.

7. If the article versioning feature is enabled, click Checkout for a published knowledge article.
   You can edit only the latest version of a knowledge article.

8. Edit the content of the article in Microsoft Word.
   - Edit the article content online using Microsoft Word in your browser.
   - Edit the article content using the Word Desktop app on your computer. In this case, after you complete editing the desktop version of the article content, you must return to the online version in your browser to save the article content in your ServiceNow instance.

   ✟ Tip: If multiple people with contribute access to the knowledge article need to co-author the same document, you can share the document URL. For more information, see Document collaboration and co-authoring.

9. In the Knowledge Management pane, click Save.

10. Optional: Publish the article by clicking Publish in the Knowledge Management pane.
    The knowledge article is published depending on the workflow setting of its knowledge base.
• **Knowledge - Instant Publish**: The knowledge article is immediately published unless it is scheduled to be published at a later date.

• **Knowledge - Approval Publish**: The knowledge article is published on approval completion unless it is scheduled to be published at a later date.

For more information, see [Schedule a knowledge article for publishing in Microsoft Word](#).

If the article versioning feature is enabled, the version number of the knowledge article increments to the next whole number (for example, from 2.02 to 3.0). For more information, see [Knowledge article version numbers](#).

**Unlink knowledge articles from linked Microsoft Word documents**

Unlink a knowledge article from a linked Microsoft Word document to edit the article directly from the Knowledge form in the Now Platform.

**Before you begin**

Ensure that the article was created using the Knowledge Management - Add-in for Microsoft Word.

Role required: admin

**About this task**

If a knowledge article is created using the Knowledge Management - Add-in for Microsoft Word, you can edit the article using only the linked Word document in the Word Online application. However, if you delete or move the linked Word document, the URL to the Word document and article is broken. Therefore, you will no longer be able to edit the article using the linked Word document. To continue editing such articles:

• Manually enter the new document URL for the Word document in the **Document URL** field on the Knowledge form in Microsoft Word. For more information about the field, see [Create a knowledge article in Microsoft Word](#).

• Unlink the article from its linked Word document by following the steps in this procedure.

**Procedure**

1. Navigate to **Knowledge > Articles**.
2. Select an article from the **Published** or **Unpublished** category.
3. On the Knowledge form, click the **Unlink from Word** related link.
Publish a knowledge article in Microsoft Word

Use the Word Online application to publish a knowledge article originally created in Microsoft Word to make it available to users.

Before you begin

- Ensure that the system administrator has configured the Knowledge Management - Add-in for Microsoft Word. (For more information, see Configure Knowledge Management - Add-in for Microsoft Word.)
- You must have logged in to your ServiceNow instance from the Word Online application. For more information, see Log in to your ServiceNow instance for authoring knowledge articles in Microsoft Word.
- You must have contribute access to the knowledge base within which you want to publish the knowledge article.
- You must have signed in to your Office 365 account.

Procedure

1. From the Microsoft 365 app launcher, select the icon to launch the Microsoft Word app. For more information, see Use the Office 365 app launcher.
2. In the New section, click New blank document, or open any existing Microsoft Word document.
3. On the Home tab of the Word document, click the Knowledge icon (ناقش).
4. Access the article in the Knowledge Management pane of the Word document.
   - In the Knowledge Management pane, in the Search box, enter the knowledge article number or description.
   - In the Knowledge Management pane, click the knowledge base to view a list of knowledge articles within the knowledge base.
5. In the Knowledge Management pane, click the link to the knowledge article that you want to publish.
6. On the Knowledge form, click Publish.

Results
A knowledge article is published depending on the workflow setting of its knowledge base:
• **Knowledge - Instant Publish**: The knowledge article is immediately published unless it is scheduled to be published at a later date.

• **Knowledge - Approval Publish**: The knowledge article is published on approval completion unless it is scheduled to be published at a later date.

For more information, see Schedule a knowledge article for publishing in Microsoft Word.

If the article versioning feature is enabled, the version of the article is incremented based on the version number pattern.

**Schedule a knowledge article for publishing in Microsoft Word**

Set a specific time and day for the draft version of a knowledge article created in Microsoft Word to be published automatically.

**Before you begin**

- You must have contribute access to the knowledge base that stores the knowledge article you want to schedule for publishing.

- You must have logged in to your ServiceNow instance from the Word Online application. For more information, see Log in to your ServiceNow instance for authoring knowledge articles in Microsoft Word.

- You must have signed in to your Office 365 account.

Ensure that the system administrator verifies the following settings:

- Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated. For more information, see Activate the Knowledge Management Advanced plugin.

- The article versioning feature is enabled. For more information, see Article versioning.

- The Knowledge Management - Add-in for Microsoft Word is enabled. (For more information, see Configure Knowledge Management - Add-in for Microsoft Word.)

**Procedure**

1. From the Microsoft 365 app launcher, select the icon to launch the Microsoft Word app. For more information, see Use the Office 365 app launcher.

2. In the New section, click **New blank document**, or open any existing Microsoft Word document.
3. On the Home tab of the Word document, click the Knowledge icon (❑).

4. In the Knowledge Management pane of the Word document, in the Search box, enter the knowledge article short description.

5. Click the link to the knowledge article in the Draft state that you want to schedule for publishing.

   Note: The knowledge article must have been originally created using Microsoft Word.

6. In the Scheduled publish date field, click the show calendar icon (❑).

7. Select any future date from the calendar.

8. In the Select Time field, enter a time in the format hh:mm:ss.

9. Click OK.

10. Click Publish to enable the publishing workflow.

   Tip: If you want to cancel an article’s scheduled publication and move the article back to the Draft state, click Recall.

Results
If approvals are disabled, the state of the knowledge article is changed to Scheduled for Publish and the article is automatically published on the scheduled publish date.

If approvals are enabled, the state of the knowledge article is changed to Review. If the article is approved, the state of the article is changed to Scheduled for Publish. If the article was approved after the scheduled publish date, the article is published immediately.

The version number of the knowledge article increments based on the publishing workflow. For more information, see Knowledge article version numbers.

Related reference
   Knowledge workflows

Related information
   Approve an article that is being reviewed

Recall an article that is being reviewed in Microsoft Word
Recall a knowledge article that is being reviewed and created using Microsoft Word to stop the approval process.
Before you begin

• You must have contribute access to the knowledge base that stores the
  knowledge article you want to recall.

• You must have logged in to your ServiceNow instance from the Word Online
  application. For more information, see Log in to your ServiceNow instance for
  authoring knowledge articles in Microsoft Word.

• You must have signed in to your Office 365 account.

Ensure that the system administrator verifies the following settings:

• Knowledge Management Advanced plugin (com.snc.knowledge_advanced)
  is activated. For more information, see Activate the Knowledge Management
  Advanced plugin.

• The article versioning feature is enabled. For more information, see Article
  versioning.

• The Knowledge Management - Add-in for Microsoft Word is enabled. (For
  more information, see Configure Knowledge Management - Add-in for
  Microsoft Word.)

About this task
The author of a knowledge article, knowledge administrators, and system
administrators can recall an article. If an ownership group is assigned to a
knowledge article, the ownership group manager and ownership group
members can also recall the knowledge article.
If a version of a knowledge article is in the Review state, you can recall only the
 corresponding version to make additional changes. Recalling the article results
in a minor version increment.

Procedure

1. From the Microsoft 365 app launcher, select the icon to launch the Microsoft
   Word app.
   For more information, see Use the Office 365 app launcher.

2. In the New section, click New blank document, or open any existing Microsoft
   Word document.

3. On the Home tab of the Word document, click the Knowledge icon (KeyId). 

4. In the Knowledge Management pane of the Word document, in the Search
   box, enter the knowledge article title or description.

5. Click the link to the article in Review state that you want to recall.

6. On the Knowledge form, click Recall.
Results
The article opens in edit mode and the state of the article is changed to Draft. The version number of the article increments by 0.01.

Knowledge Management email notifications
Reminders enable relevant users to review knowledge articles and complete tasks associated with them.

By default, the Knowledge Management application includes the following types of email notifications:

- Email notifications for knowledge article feedback tasks.
- Email notifications for knowledge subscriptions.
- Email notifications for knowledge article approval publishing workflow.
- Email notifications for translation tasks.
- Email notifications for expiring knowledge articles.
- Email notifications for article quality index (AQI) reviews.

You can decide if you must receive any knowledge notifications by setting notification preferences. For more information, see Set knowledge notification preferences.

Email notifications for knowledge article feedback tasks
The email notifications for knowledge article feedback tasks are available when your administrator activates the Knowledge Management Core plugin (com.glideapp.knowledge).

The following table describes the recipient list of notifications for knowledge article feedback tasks and the associated conditions when a notification is sent.

<table>
<thead>
<tr>
<th>Recipient list of the email notification for knowledge article feedback tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Notification</strong></td>
</tr>
<tr>
<td>KM Feedback Task: Commented</td>
</tr>
<tr>
<td>KM Feedback Task: Created</td>
</tr>
</tbody>
</table>
### Recipient list of the email notification for knowledge article feedback tasks (continued)

<table>
<thead>
<tr>
<th>Notification</th>
<th>Condition</th>
<th>Recipients</th>
</tr>
</thead>
<tbody>
<tr>
<td>KM Feedback Task: Info from Submitter</td>
<td>More information was requested from the submitter of a user feedback task.</td>
<td>User who submitted the feedback task</td>
</tr>
<tr>
<td>KM Feedback Task: Reassigned</td>
<td>A user feedback task was reassigned.</td>
<td>User who was reassigned the feedback task</td>
</tr>
<tr>
<td>KM Feedback Task: Resolution Accepted</td>
<td>A resolution described in a user feedback task was accepted.</td>
<td>User who was assigned the feedback task</td>
</tr>
<tr>
<td>KM Feedback Task: Resolution Rejected</td>
<td>A resolution described in a user feedback task was rejected.</td>
<td>User who was assigned the feedback task</td>
</tr>
<tr>
<td>KM Feedback Task: Resolved</td>
<td>A user feedback task was set as resolved.</td>
<td>User who submitted the feedback task</td>
</tr>
</tbody>
</table>

### Email notifications for knowledge subscriptions

The email notifications for knowledge subscriptions are available when your administrator activates the Knowledge Management Core plugin (com.glideapp.knowledge). For notifications associated with ownership groups, your administrator must also activate the Knowledge Management Advanced plugin (com.snc.knowledge_advanced).

The following table describes the recipient list of notifications for knowledge subscriptions and the associated conditions when a notification is sent.

### Recipient list of the email notification for knowledge subscriptions

<table>
<thead>
<tr>
<th>Notification</th>
<th>Condition</th>
<th>Recipients</th>
</tr>
</thead>
</table>
| KM Subscription Group: Article checkout | A subscribed knowledge article was checked out with the ownership group feature enabled. | • Author  
• Revisers  
• Ownership group  
An email notification is sent to the ownership group alias comprising the ownership group manager and members. |
### Recipient list of the email notification for knowledge subscriptions (continued)

<table>
<thead>
<tr>
<th>Notification</th>
<th>Condition</th>
<th>Recipients</th>
</tr>
</thead>
<tbody>
<tr>
<td>KM Subscription: Article commented</td>
<td>A comment was added to a subscribed knowledge article with the ownership group feature enabled.</td>
<td>Ownership group manager and members</td>
</tr>
</tbody>
</table>
| KM Subscription: Article checkout | A subscribed knowledge article was checked out with the ownership group feature disabled. | • Author  
• Revisers |
| KM Subscription: Article commented | A comment was added to a subscribed knowledge article with the ownership group feature enabled. | • Author  
• Revisers |
| KM Subscription: Article published | A knowledge article was published in a subscribed knowledge base. | • Knowledge base owner  
• Knowledge base subscribers |
| KM Subscription: Article revised | A subscribed knowledge article was edited. | • Knowledge base owner  
• Knowledge article subscribers  
• Author  
• Revisers |
| KM Subscription: Article revised in KB | A knowledge article in a subscribed knowledge base was edited. | • Knowledge base owner  
• Knowledge article subscribers  
• Author  
• Revisers |

**Note:** An email notification is sent to a reviser of a knowledge article when the article versioning feature is enabled.

### Email notifications for knowledge article approval publishing workflow

The email notifications for knowledge article approval publishing workflow are available when your administrator activates the Knowledge Management Core plugin (com.glideapp.knowledge).
The following table describes the recipient list of notifications for the knowledge article approval publishing workflow and the associated conditions when a notification is sent.

<table>
<thead>
<tr>
<th>Notification</th>
<th>Condition</th>
<th>Recipients</th>
</tr>
</thead>
<tbody>
<tr>
<td>KM: Approve article for publishing</td>
<td>A knowledge article was approved for publishing with the ownership group feature disabled.</td>
<td>Knowledge base owner and managers</td>
</tr>
<tr>
<td></td>
<td>A knowledge article was approved for publishing with the ownership group feature enabled.</td>
<td>Ownership group manager and members</td>
</tr>
<tr>
<td>KM: Article approved for publish</td>
<td>A knowledge article was approved for publication.</td>
<td>User (author or reviser) who submitted the article for approval</td>
</tr>
<tr>
<td>KM: Article rejected for publish</td>
<td>A knowledge article was rejected for publication.</td>
<td>User (author or reviser) who submitted the article for approval</td>
</tr>
</tbody>
</table>

**Note:** An email notification is sent to a reviser of a knowledge article when the article versioning feature is enabled.

### Email notifications for translation tasks

The email notifications for translation tasks are available when your administrator activates the Knowledge Management Advanced plugin (com.snc.knowledge_advanced) and I18N: Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2). The I18N: Internationalization plugin (com.glide.i18n) activates the I18N: Knowledge Management Internationalization Plugin v2 plugin.

The following table describes the recipient list of notifications for translation tasks on knowledge articles and the associated conditions when a notification is sent.

<table>
<thead>
<tr>
<th>Notification</th>
<th>Condition</th>
<th>Recipients</th>
</tr>
</thead>
<tbody>
<tr>
<td>KM Translation Task: Assigned to me</td>
<td>A translation task was assigned.</td>
<td>User who was assigned the translation task</td>
</tr>
</tbody>
</table>
Recipient list of the email notification for translation tasks (continued)

<table>
<thead>
<tr>
<th>Notification</th>
<th>Condition</th>
<th>Recipients</th>
</tr>
</thead>
<tbody>
<tr>
<td>KM Translation Task: Closed</td>
<td>A translation task was closed after the translated version of the knowledge article was published.</td>
<td>• User who was assigned the translation task</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• User who submitted the translation task</td>
</tr>
</tbody>
</table>

Email notifications for expiring knowledge articles

The email notifications for expiring knowledge articles are available when your administrator activates the Knowledge Management Core plugin (com.glideapp.knowledge) and sets the value of the glide.knowman.enable_article_expiry_notification property to true. By default, the property value is set to false.

Knowledge articles have an expiration date set using the Valid to field when creating the article. Articles do not appear in search results after the Valid to date.

On the first day of each month, the application sends an email notification to a list of authorized recipients to remind them about articles that are scheduled to expire in the next month. The user can then determine whether to extend the Valid to date to continue providing access to the article.

The content of the email notification is determined by the number of articles expiring in the coming month.

• Up to 10 – The email notification includes a list of article links displayed in a tabular format and arranged in ascending order by their Valid to date. Clicking a link opens the article in Now Platform.

• More than 10 – The email notification includes a View the list of expiring articles link, which when accessed opens a list in Now Platform of all articles expiring in the next month.

The following table describes the recipient list of notifications for expiring knowledge articles and the associated conditions when a notification is sent.
Recipient list of the email notification for expiring knowledge articles

<table>
<thead>
<tr>
<th>Notification</th>
<th>Condition</th>
<th>Recipients</th>
</tr>
</thead>
<tbody>
<tr>
<td>KM: Article Expiry Warning</td>
<td>An article is scheduled to expire in the next month with the ownership group feature disabled.</td>
<td>• Author&lt;br&gt;• Knowledge base owner and managers&lt;br&gt;• Reviser for the updated and checked-out versions</td>
</tr>
<tr>
<td></td>
<td>An article is scheduled to expire in the next month with the ownership group feature enabled.</td>
<td>• Author&lt;br&gt;• Knowledge base owner and managers&lt;br&gt;• Reviser for the updated and checked-out versions&lt;br&gt;• Ownership group manager and members</td>
</tr>
</tbody>
</table>

**Note:** An email notification is sent to a reviser of a knowledge article when the article versioning feature is enabled.

**Email notifications for article quality index (AQI) reviews**

The email notifications for an article quality index review on knowledge articles are available when your administrator activates the Knowledge Management Advanced plugin (com.snc.knowledge_advanced).

The following table describes the recipient list of notifications for an AQI review on knowledge articles and the associated conditions when a notification is sent.
Recipient list of the email notification for AQI reviews

<table>
<thead>
<tr>
<th>Notification</th>
<th>Condition</th>
<th>Recipients</th>
</tr>
</thead>
<tbody>
<tr>
<td>KM: AQI on Article</td>
<td>An AQI was performed and submitted on a knowledge article with the ownership group feature disabled.</td>
<td>• User (author or reviser) who last updated the article</td>
</tr>
<tr>
<td>KM: AQI on Ownership Group Article</td>
<td>An AQI was performed and submitted on a knowledge article with the ownership group feature enabled.</td>
<td>• User (author or reviser) who last updated the article</td>
</tr>
</tbody>
</table>

Note: An email notification is sent to a reviser of a knowledge article when the article versioning feature is enabled.

Related reference

Additional plugins for Knowledge Management

Related information

- Activate the Knowledge Management Advanced plugin
- Ownership groups
- Knowledge article validity
- Knowledge subscriptions

Set knowledge notification preferences

Set notification preferences for knowledge bases and knowledge articles.

Before you begin

Role required: knowledge

About this task

Users can set notification preferences from the Knowledge menu or from the Knowledge Management Service Portal.
**Procedure**

1. Navigate to the Notification Settings page.

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Knowledge application</td>
<td>Click the Notification Settings module.</td>
</tr>
<tr>
<td>From the Knowledge Management Service Portal</td>
<td>Click the user name in the portal header and then click Notification Settings.</td>
</tr>
</tbody>
</table>

2. Click the Notification Preferences tab.

3. Click **Knowledge Base** and enable or disable the knowledge base notification options.

4. Click **Knowledge Articles** and enable or disable the knowledge article notification options.

**Knowledge subscriptions**

Subscribe to knowledge bases and knowledge articles and receive email notifications about new articles and article revisions or comments.

- **Subscribed to a knowledge base:**
  - Knowledge base owners are auto-subscribed to all articles in the knowledge bases they own. They receive email notifications when new articles are created or revised (published) in the knowledge base.
  - Users who subscribe to a knowledge base receive email notifications when new articles are created in the knowledge base or if the existing articles are revised (published).

- **Subscribed to a knowledge article:**
  - Knowledge authors are auto-subscribed to the articles they create. They receive email notifications when the articles they created are checked out or revised (published) by other authors, and if the articles receive user comments.
  - Users who subscribe to an article receive email notifications when the article is revised (published).

Users can set their Knowledge notification preferences using **System Settings**.

For more information, see **Knowledge Management email notifications** and **Set knowledge notification preferences**.
The knowledge subscription feature is available for both the Knowledge Management v3 user interface and the Knowledge Management Service Portal.

If the article versioning feature is enabled, the following notifications are also sent:

- An article is checked out
- An article is revised
- A new version of an article is published

**Activation information**

The knowledge subscriptions feature requires the Knowledge Management Advanced plugin (com.snc.knowledge_advanced). For more information, see Configure knowledge subscriptions.

**Related information**

- Knowledge article version numbers
- Article versioning

**Subscribe to a knowledge base**

Subscribe to a knowledge base and receive notifications when articles are added to that knowledge base.

**Before you begin**

Role required: knowledge

**About this task**

Users can subscribe to a knowledge base from either the Knowledge Management v3 user interface or the Knowledge Management Service Portal.

**Procedure**

1. Navigate to Knowledge > Homepage.
2. Click the Subscribe link on the knowledge base tile.
   - The link changes to Subscribed and includes a check mark.

**Unsubscribe from a knowledge base**

Unsubscribe from a knowledge base.

**Before you begin**

Role required: knowledge
About this task
Users can unsubscribe from a knowledge base from either the Knowledge Management v3 user interface or the Knowledge Management Service Portal.

⚠️ Note: If you subscribe to an article and then subscribe to the knowledge base, unsubscribing from the knowledge base also unsubscribes you from the article.

Procedure
1. Navigate to Knowledge > Homepage.
2. Point to and click the Subscribed link on the knowledge base tile, which toggles to Unsubscribe.
   After unsubscribing you from the knowledge base, the link toggles to Subscribe.

Subscribe to a knowledge article
Subscribe to a knowledge article within a knowledge base.

Before you begin
Role required: knowledge

About this task
Users can subscribe to a knowledge article from either the Knowledge Management V3 user interface or the Knowledge Management Service Portal.

⚠️ Note:
Users who are already subscribed to a knowledge base are also subscribed to the articles within that knowledge base.

To subscribe to articles from the base service portal (https://<instance name>/sp?), you must navigate to the Knowledge Management Service Portal pages (for example, https://<instance name>/sp?id=kb_home) from the base service portal.

Procedure
1. Navigate to Knowledge > Homepage.
2. Click Subscribe at the top of the knowledge article.
   The system shows an information message about the article subscription and the button toggles to Subscribed. If the email notification contains an article link, the link points to the Knowledge Management Service Portal. The email notification for a subscribed article includes the knowledge article ID, short description, and link to the article.
Unsubscribe from a knowledge article

Unsubscribe from a knowledge article.

Before you begin
Role required: knowledge

About this task
Users can unsubscribe from a knowledge article from either the Knowledge Management v3 user interface or the Knowledge Management Service Portal.

Note: If you are subscribed to a knowledge base and you unsubscribe from an article in that knowledge base, you must also unsubscribe from the parent knowledge base.

Procedure
1. Navigate to Knowledge > Homepage.
2. Point to and click Subscribed, which toggles to Unsubscribe.
   If you are subscribed to the knowledge article, this action results in an information message that the article subscription has been removed. If you are also subscribed to the parent knowledge base, proceed to the next step.
3. If you are subscribed to the parent knowledge base, click Yes on the Unsubscribe pop-up window.
   This action results in an information message that the knowledge base subscription has been removed.

Manage knowledge subscriptions

Manage knowledge base and knowledge article subscriptions from the Notification Settings page.

Before you begin
Role required: knowledge

About this task
Users can manage knowledge subscriptions from the Knowledge application or from the Knowledge Management Service Portal.
Procedure

1. Navigate to the Notification Settings page.

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Knowledge application</td>
<td>Click the Notification Settings module.</td>
</tr>
<tr>
<td>From the Knowledge Management Service Portal</td>
<td>Click the user name in the portal header and then click Notification Settings.</td>
</tr>
</tbody>
</table>

2. Click the Subscriptions tab.

3. Click Knowledge Base or Knowledge Articles to see a list of current subscriptions.

4. To unsubscribe from a knowledge base or knowledge article, click Subscribed. The link toggles to Unsubscribed.

Knowledge blocks

Simplify knowledge authoring for writers and knowledge consumption for readers with knowledge blocks. Knowledge blocks are reusable pieces of content secured by user criteria that you can add to knowledge articles in a knowledge base. The user criteria controls which users can read or not read the block content in an article or search, enabling users to more easily view content that is relevant to them.

Knowledge blocks are available for use in Now Platform only.

How to use knowledge blocks

To use knowledge blocks, a knowledge administrator or manager must enable the knowledge blocks feature for each knowledge base in which the blocks will be used.

- Enable knowledge blocks for each knowledge base

Knowledge contributors can create knowledge blocks and insert them into articles in a knowledge base:

- Create a knowledge block
- Add knowledge blocks to a knowledge article
- Preview a knowledge article with knowledge blocks by user or date

Note: Knowledge blocks are not supported in articles of type wiki.
Knowledge block content can be read or not read in an article or search based on user criteria set at the knowledge base and knowledge block level. See Select user criteria for a knowledge block for more information.

Example: Holiday calendar with location-specific knowledge block content

You are part of an enterprise HR organization that maintains a company knowledge base. You want to create a holiday calendar so that employees know which days of the year are company holidays. Since the company has multiple locations and holiday dates vary based on where the employee is located, there are several ways that you could create the knowledge article.

One way is that you could create a knowledge article for each location, with an article for Location A, Location B, and so on.

- **Pros:** simplified consumption. Employees have a single article to search for and read.
- **Cons:** more work for HR. HR has multiple articles to manage and update for each location where the company has employees.

Another way is that you could create a single knowledge article that includes sections for each location.

- **Pros:** simplified authoring. HR has a single article to manage and update.
- **Cons:** more work for employees. Employee must scroll through and disregard extraneous content to find the section in the article that pertains to them.

With knowledge blocks, you can create a single knowledge article with location-specific block content secured by user criteria. This approach helps to reduce the workload for both HR and employees. As an HR agent, you have a single article to manage and update. Employees have a single article to search for and read, with the user criteria ensuring that they only view content that is relevant to them.

**If you are using a custom search or knowledge article viewer**

If you are using a custom search or knowledge article viewer with your application, you should integrate it with the appropriate knowledge or knowledge blocks API. (Integration is only necessary if you are using a custom search or knowledge article viewer.)

- **Integrating a custom search or knowledge article viewer with knowledge blocks**
Activation information

To use knowledge blocks in your application, you must activate knowledge blocks. For information on what components are installed with the feature, see Components installed with knowledge blocks.

⚠️ Note: Activating knowledge blocks automatically activates Knowledge Management Advanced, which enables advanced features such as article versioning. Knowledge blocks can be used with or without the article versioning feature. To disable the feature, see Disable the article versioning feature.

Activate knowledge blocks

You can activate knowledge blocks [com.snc.knowledge_blocks] if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

About this task

Knowledge blocks activates these related plugins if they are not already active.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Management Advanced</td>
<td>Enables advanced features for Knowledge Management, such as article versioning. For a full list of features, see activate the Knowledge Management Advanced plugin.</td>
</tr>
<tr>
<td>[com.snc.knowledge_advanced]</td>
<td></td>
</tr>
</tbody>
</table>

⚠️ Note: Knowledge blocks can be used with or without the article versioning feature. To disable the feature, see Disable the article versioning feature.

Procedure

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

⚠️ **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

### Components installed with knowledge blocks

Several types of components are installed with activation of the knowledge blocks plugin, including tables.

⚠️ **Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see **Find components installed with an application**.

Demo data is available for this feature.

#### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Block [kb_knowledge_block]</td>
<td>Knowledge blocks table.</td>
</tr>
<tr>
<td></td>
<td>⚠️ <strong>Note:</strong> This table extends the Knowledge [kb_knowledge] table.</td>
</tr>
<tr>
<td>KB Knowledge to Block [m2m_kb_knowledge_to_block]</td>
<td>KB knowledge to block table.</td>
</tr>
<tr>
<td>KB Knowledge to Block History [m2m_kb_to_block_history]</td>
<td>KB knowledge to block history table.</td>
</tr>
</tbody>
</table>

For further information on table administration and how to manage data, see **Table administration**.

### Enable knowledge blocks for each knowledge base

Enable the knowledge blocks feature for each knowledge base where you plan to use the blocks. Once enabled, you can create knowledge blocks to add to knowledge articles within a knowledge base.
Before you begin
Make sure that the knowledge blocks [com.snc.knowledge_blocks] plugin is activated.
Role required: knowledge_admin or knowledge_manager

Procedure
1. Navigate to Knowledge > Administration > Knowledge Bases.
2. Open the knowledge base record.
3. In the Knowledge Base form, select the Enable blocks check box.

   Note: If the Enable blocks check box is not visible, you can add the field to the form by right-clicking the form header and navigating to Configure > Form Layout.

4. Click Update.

   Note: If you decide to later disable the knowledge blocks feature, all knowledge blocks within the knowledge base must be deleted before you can clear the box.

What to do next
Create knowledge blocks to use within the enabled knowledge base.

Create a knowledge block
Create or modify a knowledge block to define a reusable piece of content that can be inserted into knowledge articles in a knowledge base. The knowledge
block is secured by user criteria, which controls what users, groups, roles, companies, locations, or departments can read or not read the content in an article or search, enabling users to more easily view content that is relevant to them.

**Before you begin**
Role required: user must have contributor access to the knowledge base.

**Procedure**

1. Navigate to **Knowledge > Knowledge Blocks > Create New**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>This field is automatically set to a knowledge block number.</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>Name of the knowledge base. The knowledge blocks feature must be enabled for each knowledge base that you plan to create blocks. See Enable knowledge blocks for each knowledge base.</td>
</tr>
<tr>
<td>Category</td>
<td>Name of the knowledge category or subcategory.</td>
</tr>
<tr>
<td>Ownership Group</td>
<td>Ownership group for the knowledge block. This field appears when the ownership groups feature is enabled. Knowledge blocks can be used with or without the ownership groups feature. To learn more about ownership groups, including how to enable the feature, see Ownership groups.</td>
</tr>
<tr>
<td>Can read</td>
<td>User criteria to apply for read access at the knowledge block level.</td>
</tr>
<tr>
<td></td>
<td>User criteria set at the knowledge base and knowledge block level controls which users can read or not read block content within an article. To learn more about selecting user criteria for a knowledge block, see Select user criteria for a knowledge block.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cannot read</td>
<td>User criteria to apply for cannot read access at the knowledge block level. User criteria set at the knowledge base and knowledge block level controls which users can read or not read block content within an article. To learn more about selecting user criteria for a knowledge block, see <a href="#">Select user criteria for a knowledge block</a>.</td>
</tr>
</tbody>
</table>
| Valid to      | Date that the knowledge block expires. After the valid to date:  
|               | • Knowledge article viewer will no longer display expired knowledge block content in the associated knowledge article.  
|               | • Search will no longer return knowledge articles if the keywords are contained in the expired blocks. |
| Short Description | Description of the knowledge block.                                                                                                                                 |
| Text          | Text of the knowledge block.                                                                                                                                 |
| Version       | This field is automatically set to a version number when the article versioning feature is enabled.  
|               | Knowledge blocks can be used with or without the article versioning feature. To learn more about article versioning, including how to disable the feature, see [Article versioning](#). |
| Article type  | This field is automatically set to HTML.                                                                                                                                 |
|               | **Note:** Knowledge blocks are only supported with HTML knowledge articles.                                                                                                                                 |
| Workflow      | This field is automatically set to the publication state of the block, such as Draft, Published, or Retired. |
| Source task   | Not applicable.                                                                                                                                 |

4. Click **Save** or **Update** to create or update the block.
5. Click **Publish** to publish the block.

 ¡ **Note:** Any additional steps required to publish the knowledge block, such as approvals, depend on the publishing workflow for the knowledge base. See **Knowledge workflows** for more information.

**What to do next**
After the knowledge block is published, you can add the block to an article within the knowledge base.

**Select user criteria for a knowledge block**
Control which users can read or not read knowledge block content within an article in a knowledge base by setting user criteria at the knowledge base and knowledge block level. As a knowledge contributor, you can apply user criteria at the knowledge block level.

**Before you begin**
Role required: user must have contributor access to the knowledge base.

**Procedure**
1. Navigate to **Knowledge > Knowledge Blocks > All**.
2. Open a knowledge block.
3. Apply the desired user criteria for the **Can Read** and **Cannot Read** fields.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can Read</td>
<td>User criteria to apply for read access at the knowledge block level.</td>
</tr>
<tr>
<td>Cannot Read</td>
<td>User criteria to apply for cannot read access at the knowledge block level.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Note:

• You can use existing or create new user criteria records. To create a new record, see Create a user criteria record in Knowledge Management.

• If a user meets any Can Contribute criteria at the knowledge base level, they can read all knowledge block content, regardless of the Can read and Cannot read criteria set at the knowledge block level.

• If a user meets any Cannot read criteria at the knowledge block level, they cannot read the block content, regardless of the Can read criteria set at the knowledge block level.
4. Right-click the form header and click **Save**.

**What to do next**

- To finish and publish the block, see **Create a knowledge block**.
- To add the block to an article, as well as preview the article by impersonating different users, see **Add knowledge blocks to a knowledge article**.
Retire a knowledge block
You can retire a published knowledge block so that it is no longer available for users to view or search. A knowledge block can only be retired if it is not being used in any knowledge articles.

Before you begin
Role required: user must have contributor access to the knowledge base.

Procedure
1. Navigate to Knowledge > Knowledge Blocks > Published.
2. Open the applicable record.
3. In the Articles related list, verify that the knowledge block is not being used in any knowledge articles.
   A knowledge block can only be retired or deleted if it is not being used in any knowledge article, including any retired article or previous version of an article.
4. Click Retire to retire the knowledge block.

   Note: Any additional steps required to retire the knowledge block, such as approvals, depend on the workflow for the knowledge base. See Knowledge workflows for more information.

Add knowledge blocks to a knowledge article
You can insert one or more knowledge blocks into a knowledge article within a knowledge base. Each knowledge block is secured by user criteria, which controls who can read or not read the content in an article.

Before you begin
Role required: user must have contributor access to the knowledge base.

Procedure
1. Navigate to Self-Service > My Knowledge Articles.
2. Click New or open a record.
   On clicking New, you are provided options to select an article template. The article templates appear when you activate them in the Knowledge > Article templates.
3. Select an article template.

   Note: You can add or remove knowledge blocks in more than one HTML field of any article template including custom templates.
4. Fill in the fields on the form, as appropriate.
   For further details on creating a knowledge article, see Create a knowledge article.

   **Note:** Knowledge blocks are only supported with HTML knowledge articles. Make sure that the **Article type** field is set to **HTML**.

5. In the article body, click where a block needs to be inserted and then click **Add Blocks**.
   If the **Add Blocks** button is not visible, make sure that the knowledge blocks feature is enabled for the knowledge base that the article is in. See Enable knowledge blocks for each knowledge base for more information.
   In the **Add Blocks** side panel, you can search for, do an advanced search, view, and insert knowledge blocks into the article. To use condition builder with advanced search, see Condition builder. You can also create blocks directly from the side panel.
   
   • You can configure the number of search results displayed in the **Add Blocks** side panel using the `glide.knowman.add_blocks.search_results` property. By default, the minimum number of search results displayed is 6 and the maximum number of search results displayed is 25. See Knowledge properties for more information.

   • If there are knowledge blocks you cannot find, make sure that the blocks are published, in the same language, and in the same knowledge base as an article.

6. **Optional:** Rearrange knowledge block in the article body.
<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you are using a mouse</td>
<td>a. Click the block to select it.</td>
</tr>
<tr>
<td></td>
<td>b. Drag and drop the block within the article.</td>
</tr>
<tr>
<td>If you are using a keyboard</td>
<td>a. Place your cursor to the left of the block.</td>
</tr>
<tr>
<td></td>
<td>b. Press the right arrow key to select the block.</td>
</tr>
<tr>
<td></td>
<td>c. Use Ctrl+x and Ctrl+v to cut and paste the block within the article.</td>
</tr>
</tbody>
</table>

**Example**

(Optional) The following GIF shows an example of a user moving a knowledge block within an article using a keyboard.

7. Click **Save** or **Update** to create or update the article.
8. Click **Publish** to publish the article.

**Note:** Any additional steps required to publish the knowledge article, such as approvals, depend on the publishing workflow for the knowledge base. See Knowledge workflows for more information.

**Preview a knowledge article with knowledge blocks**

Preview a knowledge article with knowledge blocks by user or, if published, by date. For an unpublished article, you can preview the article by user by impersonating different users to see how the article displays or hides block content (based on the user criteria set at the knowledge base and knowledge block level). For published articles, you can preview the article by both user and date to see how the article appears in past versions for different users.

**Before you begin**

Role required: user must have contributor access to the knowledge base.

**Procedure**

1. Navigate to **Knowledge > Articles**, and open one of the modules, such as **Unpublished** or **Published**.
2. Open the knowledge article with knowledge blocks.
3. In the **Related Links** section, click **Preview Article with Blocks**.
4. Preview the article as one of the following.

<table>
<thead>
<tr>
<th>Option</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unpublished article</strong></td>
<td>Preview the article by user. In the <strong>View As</strong> field, you can search for and impersonate different users to see how the article appears based on the can and cannot read access of the user.</td>
</tr>
<tr>
<td><strong>Published article</strong></td>
<td>Preview the article by user and date:</td>
</tr>
<tr>
<td></td>
<td>• In the <strong>View As</strong> field, you can search for and impersonate different users to see how the article appears based on the can and cannot read access of the user.</td>
</tr>
<tr>
<td></td>
<td>• In the <strong>View on date</strong> field, you can select different dates to see how the article appears in past versions.</td>
</tr>
</tbody>
</table>

**Knowledge blocks authoring in Agent Workspace**

Reuse content by creating, editing, and publishing knowledge blocks in Agent Workspace.
You can perform the following knowledge blocks-related tasks in Agent Workspace:

- Create a knowledge block for a knowledge base.
- Manage all unpublished and published knowledge blocks authored by you.
- Add knowledge blocks to a knowledge article.
  When adding a knowledge block to a knowledge article, you can also add knowledge blocks to any fields associated with an article template if used for an article.
- Retire a knowledge block not used in any knowledge articles.

View a knowledge block in Agent Workspace

View a knowledge block in Agent Workspace, including the block number, short description, and block content.

Before you begin

You must have read access to the knowledge base that stores the knowledge block you want to view.
Role required: agent_workspace_user and knowledge

Procedure

1. Navigate to Agent Workspace > Agent Workspace Home.
2. View knowledge blocks authored by you or by other people.
   - View all blocks by navigating to Lists > Knowledge Blocks > All.
   - View blocks authored by you by navigating to either Lists > Knowledge Blocks > Published or Lists > Knowledge Blocks > Unpublished.
3. Click the link to the knowledge block that you want to view.
4. Optional: View another version of the knowledge block by selecting the version in the Version list.

  Note: The Version list appears only when the article versioning feature is enabled. For more information, see Article versioning.

Results

The selected version of the knowledge block opens within Agent Workspace. Any earlier version of the knowledge block is indicated as outdated. When viewing an earlier version, click the version number of the knowledge block to view a list of all versions.
Related reference

Knowledge block details displayed in Agent Workspace

Related information

Create a knowledge block in Agent Workspace
Edit a knowledge block in Agent Workspace
Publish a knowledge block in Agent Workspace

Knowledge block details displayed in Agent Workspace

View the details of a knowledge block in Agent Workspace.

The knowledge block view page in Agent Workspace provides several details about a displayed block.

Sample knowledge block view page in Agent Workspace

![Sample knowledge block view page in Agent Workspace](image)

- **Details**
- **Knowledge base**
- **Read time**

Knowledge base that stores the knowledge article and the article category. In the figure, Knowledge is the knowledge base and Policies is the knowledge block category.

Average time to read the knowledge block, which can help you decide whether you have time to read the block.

Article information displayed on the knowledge block view page in Agent Workspace

<table>
<thead>
<tr>
<th>Details</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge base</td>
<td>Knowledge base that stores the knowledge article and the article category. In the figure, Knowledge is the knowledge base and Policies is the knowledge block category.</td>
</tr>
<tr>
<td>Read time</td>
<td>Average time to read the knowledge block, which can help you decide whether you have time to read the block.</td>
</tr>
</tbody>
</table>
Article information displayed on the knowledge block view page in Agent Workspace (continued)

<table>
<thead>
<tr>
<th>Details</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The read time is calculated</td>
<td>The read time is calculated based on an average reading speed of 200 words per minute. For blocks in languages such as Chinese, Japanese, and Korean, the read time is calculated based on an average speed of 500 characters per minute. If images are present in an article, the read time is calculated using the following rules:</td>
</tr>
<tr>
<td>block number</td>
<td>The read time is calculated based on an average reading speed of 200 words per minute. For blocks in languages such as Chinese, Japanese, and Korean, the read time is calculated based on an average speed of 500 characters per minute. If images are present in an article, the read time is calculated using the following rules:</td>
</tr>
<tr>
<td>Knowledge block content</td>
<td>Text and images in the knowledge block.</td>
</tr>
<tr>
<td>Authored by</td>
<td>Author of the knowledge block. This field appears only in the first version of a knowledge block.</td>
</tr>
<tr>
<td>Revised by</td>
<td>User who revised the knowledge block. This field appears if a knowledge block was later edited.</td>
</tr>
<tr>
<td>Knowledge block number</td>
<td>Unique number automatically assigned to the knowledge block. In the figure, KBB0000101 is the block number.</td>
</tr>
<tr>
<td>Version</td>
<td>Selected version of the knowledge block. This field appears when the article versioning feature is enabled. In the figure, 2.0 is the selected version of the knowledge block.</td>
</tr>
</tbody>
</table>

Related information

- View a knowledge block in Agent Workspace
- Create a knowledge block in Agent Workspace
- Edit a knowledge block in Agent Workspace
- Publish a knowledge block in Agent Workspace
Create a knowledge block in Agent Workspace

Create a knowledge block for a knowledge base in Agent Workspace to reuse a piece of content in knowledge articles in that knowledge base.

Before you begin

- Enable the knowledge blocks feature for the knowledge base where you plan to create blocks. For more information, see Enable knowledge blocks for each knowledge base.
- You must have contribute access to the knowledge base within which you want to create the knowledge block.

Role required: agent_workspace_user and knowledge

About this task

You can also create blocks when accessing an article panel. For more information, see Add a knowledge block to a knowledge article in Agent Workspace.

Procedure

1. Navigate to Agent Workspace > Agent Workspace Home.
2. Optional: Check whether a knowledge block on this subject is already available.

   a. Navigate to Lists > Knowledge Blocks > All.

   b. Set a filter to search for possible matching knowledge blocks.

      • Click a column header. Based on the data type included in the column, in the Filter section, select the filter options or enter the filter conditions you want to apply. For example, for the Workflow column, you can select the following states:

         ◦ Draft
         ◦ Review
         ◦ Scheduled for publish
         ◦ Published
         ◦ Pending retirement
- Retired
- Outdated

- Click the show filter panel icon (), and click Advanced view. In the Advanced view dialog box, specify conditions in the All of these conditions must be met field and click Update.

3. Click New in a Knowledge Blocks list.
4. On the Knowledge Block form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique number for identifying the knowledge block. This field is automatically populated.</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>Name of the knowledge base to which you are adding the knowledge block.</td>
</tr>
<tr>
<td>Category</td>
<td>Name of the knowledge category or subcategory associated with the knowledge base.</td>
</tr>
<tr>
<td>Ownership Group</td>
<td>Ownership group for the knowledge block. This field appears when the ownership groups feature is enabled (see Ownership groups).</td>
</tr>
</tbody>
</table>

**Note:** Knowledge blocks can be used without the ownership groups feature.

<table>
<thead>
<tr>
<th>Can Read</th>
<th>User criteria to apply for read access at the knowledge block level.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>User criteria set at the knowledge base and knowledge block level control which users can read block content within an article. (For more information, see Select user criteria for a knowledge block.)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cannot Read</th>
<th>User criteria to apply for cannot read access at the knowledge block level.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>User criteria set at the knowledge base and knowledge block level controls which users can read block content within an article. (For more information, see Select user criteria for a knowledge block.)</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Valid to     | Date that the knowledge block expires. Once the valid to date has passed:  
• The Knowledge article view page no longer displays expired knowledge block content in the associated knowledge article.  
• Knowledge article searches no longer return knowledge articles if the keywords are contained only in the expired blocks. |
| Short description | Description of the knowledge block.                                                                                                           |
| Article body | Content of the knowledge block.                                                                                                               |
| Version      | Version number of the knowledge block. This field is automatically set to a version number when the article versioning feature is enabled.  
*Note:* Knowledge blocks can be used without the article versioning feature. To learn more about article versioning, including how to disable the feature, see Article versioning. |
| Article type | Markup language used for formatting the block. This field is automatically set to HTML because knowledge blocks are supported only with HTML knowledge articles. |
| Workflow     | Publication state of the block. This field is automatically set to the publication state of the block, such as Draft, Published, or Retired. |

*Note:* You can ignore the Source Task field, which is not used.

5. Click **Save**.
   The knowledge block is saved and appears in the Unpublished list of Knowledge Blocks in Agent Workspace and additional functionality becomes available on the form.

6. **Optional:** Publish the block by clicking **Publish**.
   (Optional) A knowledge block is published depending on the workflow setting of its knowledge base.
• **Knowledge - Instant Publish:** The knowledge block is immediately published.

• **Knowledge - Approval Publish:** The knowledge block is published on approval completion.

When published, your knowledge block appears in the Published and All lists under Knowledge Blocks in Agent Workspace. If the article versioning feature is enabled, the version number of the knowledge block is incremented.

**Related information**

**Edit a knowledge block in Agent Workspace**

**Edit a knowledge block in Agent Workspace**

Edit knowledge blocks within a knowledge base in Agent Workspace to update the reused content across articles within the knowledge base.

**Before you begin**

You must have contribute access to the knowledge base that stores the knowledge block you want to edit.

Role required: agent_workspace_user and knowledge

**Procedure**

1. Navigate to **Agent Workspace > Agent Workspace Home**.

2. Go to **Lists > Knowledge Blocks > All**.

3. Click a knowledge block link.

4. Modify the fields on the Knowledge Block form.

   • For an unpublished knowledge block, the Knowledge Block form opens when you select the article.

   • For a published knowledge block, click **Edit** to access the Knowledge Block form.

   ![Note](https://example.com) **Note:** If the article versioning feature is enabled, you can edit only the latest version of a knowledge block. Click **Checkout** after you click **Edit**.

5. Click **Save**.

   The knowledge block is saved and appears in the Unpublished list under Knowledge Blocks. If the article versioning feature is enabled, the version of the knowledge block is incremented by 0.01.

6. **Optional:** Publish the knowledge block by clicking **Publish**.

   The knowledge block is published depending on the workflow setting of its knowledge base.
• **Knowledge - Instant Publish**: The knowledge block is immediately published.
• **Knowledge - Approval Publish**: The knowledge block is published on approval completion.

When published, your knowledge block appears in the Published and All lists under Knowledge Blocks in Agent Workspace. If the article versioning feature is enabled, the version number of the knowledge block is updated to the next whole number (for example, from 2.02 to 3.0).

**Publish a knowledge block in Agent Workspace**

Publish a knowledge block to make it available to add to knowledge articles.

**Before you begin**
You must have contribute access to the knowledge base that stores the knowledge block you want to publish.
Role required: agent_workspace_user and knowledge

**Procedure**
1. Navigate to Agent Workspace > Agent Workspace Home.
2. Go to Lists > Knowledge Blocks > Unpublished.
3. Click a knowledge block link.
4. On the Knowledge Block form, click **Publish**.

**Results**
A knowledge block is published depending on the workflow setting of its knowledge base.

• **Knowledge - Instant Publish**: The knowledge block is immediately published.
• **Knowledge - Approval Publish**: The knowledge block is published on approval completion.

When published, your knowledge block appears in the Published and All lists under Knowledge Blocks in Agent Workspace. If the article versioning feature is enabled, the version of the block is incremented.

**Related information**
- [View a knowledge block in Agent Workspace](#)
- [Approve a knowledge block in Agent Workspace](#)

Approve a knowledge block that is awaiting your review in Agent Workspace.
Before you begin
Role required: agent_workspace_user and knowledge

Procedure
1. Navigate to Agent Workspace > Agent Workspace Home.
2. Go to Lists > Knowledge Blocks > Unpublished.
3. Click a knowledge block link that is in the Review workflow state.
4. Click Edit.
5. In the Approvals related list, in the State column, click Requested.
   The Approval form opens in another tab within Agent Workspace.
6. From the State list, select Approved.
7. Click Save.

Results
The approved knowledge block is published immediately. If the article versioning feature is enabled, the version number of the knowledge block increments to the next whole number (for example, from 2.02 to 3.0). On the Knowledge Block form, the workflow state changes to Published. The new published version of the knowledge block is added to the Block Versions related list on the Knowledge Block form. The version is also available in the All list under Knowledge Blocks in Agent Workspace, go to Knowledge Blocks > All.

Add a knowledge block to a knowledge article in Agent Workspace
Add a knowledge block to a knowledge article in Agent Workspace.

Before you begin
• Both the knowledge article and the knowledge block must be in the same knowledge base.
• You must have contribute access to the knowledge base.
• Ensure that the knowledge blocks feature is enabled for the knowledge base that the article is in. For more information, see Enable knowledge blocks for each knowledge base.

Role required: agent_workspace_user and knowledge

Procedure
1. Navigate to Agent Workspace > Agent Workspace Home.
2. Go to Lists > Knowledge Articles > All.
3. Click an existing article link.  
   For more information, see Edit a knowledge article in Agent Workspace.

   Note:  
   • Knowledge blocks are supported only with HTML knowledge articles. Make sure that the Article type field is set to HTML.
   • If a knowledge article uses an article template, you can add knowledge blocks to any fields associated with the article template.

4. In the contextual side panel, click the add blocks icon (＋).

5. Search for the article to which you want to add the knowledge block. To use condition builder with advanced search, see Condition builder.

6. Click Insert to add the knowledge block to the article. If there are no knowledge blocks, click Create New Block and follow the procedure to create another block. For more information, see Create a knowledge block in Agent Workspace.

7. Click Update to save your changes.

   Note: You can preview the article with the blocks. For more information, see Preview a knowledge article with knowledge blocks in Agent Workspace.

8. Click Publish to publish the article.

   The knowledge article is published depending on the workflow setting of its knowledge base. For more information, see Publish a knowledge article in Agent Workspace.

Preview a knowledge article with knowledge blocks in Agent Workspace

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article.
Role required: agent_workspace_user and knowledge

Procedure
1. Navigate to Agent Workspace > Agent Workspace Home.
2. Go to Lists > Knowledge Articles > All.
3. Select the article in which you want to preview a knowledge block and click Edit.
4. Click Preview with Blocks.
The article edit page refreshes to show options for previewing a knowledge block.

5. Optional: Click Show Blocks to highlight the knowledge blocks added to the article.

6. Click OK.

### Retire a knowledge block in Agent Workspace

Retire a published knowledge block if you no longer want it to be available for users to view or search.

#### Before you begin
You must have contribute access to the knowledge base that stores the knowledge block you want to retire.

Role required: agent_workspace_user and knowledge

#### About this task
You can retire knowledge blocks only if they are not used in any knowledge articles.

#### Procedure
1. Navigate to **Agent Workspace > Agent Workspace Home**.
2. Go to **Lists > Knowledge Articles > Published**.
3. Select the knowledge block you want to retire.
4. Click **Edit**.
5. Click **Retire**.

#### Results
The knowledge block is retired depending on the workflow setting of its knowledge base.

- **Knowledge - Instant Retire**: The knowledge block is immediately retired.
- **Knowledge - Approval Retire**: The knowledge block is retired on approval completion.

When retired, your knowledge block no longer appears in the Published list under Knowledge Blocks in Agent Workspace.

#### Integrating a custom search or knowledge article viewer with knowledge blocks

If you are using a custom search or knowledge article viewer with your application, you can integrate that custom search or viewer with the appropriate knowledge or knowledge blocks API.
Note: Integration is only necessary if you are using a custom search or knowledge article viewer.

KBPortalServiceImpl - Global

The KBPortalServiceImpl API is included with Knowledge Management V3 [com.snc.knowledge3] as a script include. It provides methods to use with knowledge, such as integration with a custom search.

KBPortalServiceImpl - KBPortalServiceImpl()

Instantiates a KBPortalServiceImpl object in a global application.

### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

KBPortalServiceImpl - getResultData(Object request)

Returns search results based on keywords from the knowledge article and from relevant knowledge block content that the user has access to read.

If you have activated the knowledge blocks feature and are using a custom search for knowledge with your application, your search may not return relevant articles when keywords are contained in the blocks. To return search results based on keywords from the article and from relevant block content that the user has access to read, you must call the `getResultData()` method inside your custom search.

### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>request</td>
<td>Object</td>
<td>JSON object to refine the search.</td>
</tr>
</tbody>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Array of search results in JSON format based on keywords from the knowledge article and from relevant knowledge block content that the user has access to read.</td>
</tr>
</tbody>
</table>
Example: Integrating a custom search with knowledge blocks

function doKeywordSearch(queryText, count, queryLocation) {
    var results = [];

    // To set up the request.
    var request = {
        keyword: queryText,
        language: "",

        // To pass data to filter on different metadata.
        variables: {
            kb_knowledge_base: ['Knowledge'],
            kb_category: '',
            author: ['']
        },

        // Provide the following.
        context: gs.getProperty('glide.knowman.sp.search_context', 'Knowledge Search'),
        resource: 'Knowledge',
        order: "relevancy,true",

        // Provide the pagination variables.
        start: queryLocation,
        end: queryLocation+count,

        attachment: false,

        // Provide any additional metadata you want to include in your results.
        knowledge_fields: [
            "number",
            "sys_id",
            "published"
        ]
    };

    // To execute the search.
    var response = new KBPortalServiceImpl();
    response.getResultData(request);

    // To send the search results back to the UI or to store results in your object.
    for (var i = 0; i < response.results.length; i++) {
        result = response.results[i];
        var article = {
            // Additional metadata
        }
    }
KBBlock - Global

The KBBlock API is included with knowledge blocks [com.snc.knowledge_blocks] as a script include. It provides methods to use with the knowledge blocks feature, such as integration with a custom knowledge article viewer.

KBBlock - KBBlock()

Instantiates a KBBlock object in a global application.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

KBBlock - getArticleContent(GlideRecord knowledgeRecord)

Gets knowledge articles with relevant knowledge block content that a user has access to read.

If you have activated the knowledge blocks feature and are using a custom knowledge article viewer with your application, your viewer may not display articles that expand the relevant block content. To expand block content that a user has access to read, you must call the getArticleContent() method inside your custom viewer.
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>knowledgeRecord</td>
<td>GlideRecord</td>
<td>GlideRecord of the knowledge article to display.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Knowledge article with relevant knowledge block content that a user has access to read.</td>
</tr>
</tbody>
</table>

Example: Integrating a custom knowledge article viewer with knowledge blocks

```javascript
// This function returns the article text with expanded block content.
function getArticleText(kbSysId) {
    var knowledgeRecord = new GlideRecord('kb_knowledge');
    var kbText='';
    if(knowledgeRecord.get(kbSysId)) {
        if(new GlidePluginManager().isActive('com.snc.knowledge_blocks')) {
            kbText = new KBBlock();
            kbText.getArticleContent(knowledgeRecord);
        } else {
            kbText = knowledgeRecord.getValue('text');
        }
    }
    return kbText;
}

// This is an example of how to call the function defined above.
var kbText = getArticleText('01alca5b6710130038876c3b5685efd3');
```

Knowledge Management v3 homepage

The Knowledge Management v3 homepage displays knowledge articles organized by knowledge base and category, as well as featured content and popular articles.

To view the default knowledge homepage, navigate to Self-Service > Knowledge.
Note:

The knowledge homepage is not compatible with Internet Explorer 9 or earlier. Using one of these browsers will cause you to be redirected to the legacy knowledge portal.

The Knowledge v3 home page is not customizable. Use the Knowledge Management Service Portal for an easily configurable user experience.

If you access knowledge from a service management application, the knowledge homepage for the associate application opens.

Only published and not yet expired knowledge articles (that is the valid do date not yet reached) appear on the homepage.

From the homepage, you can import a Word document to a knowledge base by clicking **Import Articles**.

Note: From Madrid, you can import a word document from the Import Articles module available in the Application Navigator. This feature is active by default for customers on Madrid and later releases. Existing customers on release versions prior to Madrid use the Word import functionality on the Knowledge V3 homepage. Upgrade customers use the Word import functionality on the Knowledge V3 homepage by default. If required, add the Import Articles module to the Application Navigator. If you add the module, the **Import Articles** button does not appear on the Knowledge v3 homepage.

You can also create a new article using the **Create An Article** button.

- Import a Word document
- Create an article

Note: You must have contribute access to at least one active knowledge base, otherwise these buttons do not appear. See **Migrate to Knowledge Management v3** and **Knowledge manager**.

You can select a knowledge base to browse articles within that knowledge base. You can view only knowledge bases you can access.

Articles are organized by category or by tag. Categories are listed alphabetically. You can sort content by most recent update or by number of views.

You can comment on an article. There is no HTML formatting available for comments on the Knowledge V3 homepage.

Existing customers on release versions prior to New York can view knowledge article feedback comments in the following ways.
• On the Knowledge v3 homepage.

• If the Knowledge Management — Service Portal plugin (com.snc.knowledge_serviceportal) is installed, on the Knowledge Service Portal.

• If the Use Live Feed for knowledge feedback property is active, in the Live Feed.

For new customers on New York and later releases, comments can only be viewed in the Knowledge Service Portal.

An administrator can configure the knowledge homepage to display the number of articles within each category. This count includes articles from subcategories. To display the article count, set the glide.knowman.show_number_on_categories property to true.

Related information

Knowledge Management
Define a knowledge article category
Import a Word document to a knowledge base using Knowledge Management v3
Import a Word document to a knowledge base

Search using Knowledge Management v3

Search for knowledge articles from the knowledge homepage using the search bar on the Knowledge Management v3 homepage.

Search results include only articles and questions you are authorized to read. The search results count do not take into consideration any security rules set for the articles. The number of articles you can access may be lower than the count displayed in the search results page. Documents that are attached to articles are also listed in the search results.

Note: To change how the attachments are displayed in the search results, set the How to display attachments in Knowledge Search Results glide.knowman.search.attachment property. Attachments can be displayed with a snippet, link only, or not at all.

To use wildcards in your search, navigate to Contextual Search > Search Contexts > Knowledge Base Search and select Enable wildcard searches.

Sort knowledge content by relevancy, most recent update, or number of views.
Filter results using the check boxes that appear. Filtering options appear depending on the search text. Knowledge homepage; browsing and searching for articles; viewing articles, providing feedback; posting questions; importing/creating articles

Filtering options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Bases</td>
<td>Select a knowledge base to search. You can select only knowledge bases you can access. If you do not select a specific knowledge base, search results include articles and questions from all knowledge bases that you can access. You can also select a knowledge base from the choice list in the search bar. For pinned articles, only those in the selected knowledge base in the corresponding language appear.</td>
</tr>
<tr>
<td>Categories</td>
<td>Select one or more knowledge categories. Categories are listed alphabetically.</td>
</tr>
<tr>
<td>Authors</td>
<td>Select one or more authors.</td>
</tr>
</tbody>
</table>
| Language        | The multi-language search feature is available when more than one supported language is enabled.  

1. To enable multi-languages, activate the I18N: Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2) or activate one of the internationalization plugins for the language you require. 

<i>Note:</i> Activating internationalization plugins for any of the available languages automatically activates the I18N: Knowledge Management Internationalization Plugin v2 plugin. 

2. To display search results in all available languages simultaneously, enable the glide.knowman.enable_multi_language_search property.
Filtering options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. Navigate to Knowledge &gt; Administration &gt; Properties &gt; Knowledge Search Properties &gt; Enable multi language search and select the Yes check box.</td>
<td></td>
</tr>
<tr>
<td>b. Enter <code>sys_properties.list</code> in the filter navigator, search for the property to configure, and in the Value field, enter <code>true</code>.</td>
<td></td>
</tr>
</tbody>
</table>

Note: By default, the `glide.knowman.enable_multi_language_search` property is not enabled. Search results are displayed based on the language you select in the language filter on the Search page.

Related reference

Knowledge Management properties

Import a Word document to a knowledge base using Knowledge Management v3

Import a Microsoft Word document using Knowledge Management v3 homepage to create a knowledge article.

Before you begin

You must have contribute access for at least one active knowledge base. The Import Articles button does not appear in the following conditions:

• The Import Articles module is available in the application navigator.

Note: Beginning with Madrid, the Import a Word document feature is enabled by default and the Import Articles module is displayed in the application navigator. The Import a Word document feature isn’t enabled automatically for the existing customers who can continue using the Import Articles option on the Knowledge Management v3 page. For more information, see Import a Word document to a knowledge base.

• You cannot contribute to any knowledge base.

Note: An administrator can control the visibility of the Import Articles button by setting the other knowledge property Hide the 'Import' functionality (button and drag-n-drop) for all users (`glide.knowman.import.hide_import_functionality`) to true.
Role required: None

About this task
You can import Microsoft Word documents in the .doc and .docx file formats.

ℹ️ Note: The file extension must be lowercase.

When you import a document, text content from the document is used to create the knowledge article. The articles support all editing functions supported by the TinyMCE editor. All HTML supported by TinyMCE such as tables, lists, and links, as well as styling such as bold and italics, are preserved. Images from the document are added as attachments to the knowledge article and embedded in the article body.

ℹ️ Note:
You can import multiple files at a time. Closing the browser or navigating away cancels any in-progress uploads but does not delete articles created from completed imports.

You cannot import documents to knowledge from mobile devices.

The following styles and elements are preserved when importing a .doc or .docx file into a knowledge base. Styles and elements not included in this list may not be preserved when importing a document.

- Titles
- Headings

ℹ️ Note: Only default heading settings are supported. For any headings and subheadings with numbers, the numbers are not imported.

- Images

ℹ️ Note: Images may not be aligned exactly as in the Word document you import.

- Links
- Bold text
- Italic text
- Underlined text
- Ordered and unordered lists

ℹ️ Note: After import, the bullets in an unordered list are replaced with dots.
• Tables

⚠️ Note: Only default heading settings are supported. Custom heading styles are imported using the default settings for those styles. Table styling and borders are not supported.

Procedure

1. Navigate to Self-Service > Knowledge.

2. Perform one of the following actions.
   • Click Import Articles and select one or more document files.
   • Drag one or more document files onto the knowledge homepage.

3. Select the Knowledge base to add the new article to.
   You can select only knowledge bases you can contribute to.

4. Optional: Select a Category from within that knowledge base.

   ⚠️ Note: Use the category picker to add a category. The picker does not differentiate between the different category levels. You can select a category or sub category and add it to the Category field.

5. Optional: Select the Publish check box to start the publishing workflow for each imported article immediately after the import finishes.
   This check box applies only when importing to v3 knowledge bases and only if the Show publish checkbox on the knowledge import pop-up property is set to Yes on the Knowledge Management properties form. You cannot automatically publish articles imported to v2 knowledge bases.
   Knowledge v2 articles go into Draft state. Knowledge v3 articles go into Review or Published state, depending on the workflow attached to the knowledge base (Approval Publish or Instant Publish).

6. Click Import.

   A new article is created in the selected knowledge base and category using the content from the uploaded document. If you uploaded multiple documents, one article is created for each. If you use knowledge internationalization, the language of the new article is set to the currently selected system language.

   After the upload completes, a popup window appears displaying the number and short description of the newly-created articles. Click an article to view the full record.

   If any errors occur during the upload, a popup window appears to display the error.
Related information

Import a Word document to a knowledge base

Associate a knowledge article with a taxonomy category

Associate a knowledge article with a taxonomy category to create a uniform classification structure across different kinds of content.

Before you begin
You must have contribute access to the knowledge base that contains the knowledge article.
Role required: knowledge

About this task
The taxonomy feature enables you to link an article to one or more topics from multiple taxonomies. It helps you maintain a unified content categorization across content types such as catalog items, knowledge articles, and community posts.

Note: You can associate only articles in the Draft, Review, or Published state.

Procedure
1. Navigate to Knowledge > Articles.
2. On the article page, click the article you want to associate to a taxonomy topic.
3. In the Assigned Topics related list, click Add.
4. Select a Taxonomy category from the list in the topic picker dialog box.
5. Select a topic from a topic picker list and click OK.

Results
The selected article is associated with a taxonomy category for better content browsing.

Select a knowledge article category

Knowledge articles within a knowledge base are grouped by category. These groups can help you define the knowledge base taxonomy, and can help users find articles within that knowledge base.
About this task
As a knowledge contributor, when editing a knowledge article you can select categories using the Category picker, and add or edit categories if enabled for the knowledge base.

Procedure
1. Click the reference lookup icon beside the Category field.
2. Select an existing category, or click the add category icon (+) to add a new category.
   After you select a category, you can click the pen icon to rename that category. Press the enter key or click outside the selected category to save the change.
   ❓ Note: Clicking Cancel while selecting a category cancels selecting a new category, but does not revert any changes you make to the categories such as renaming or adding new categories.
3. Fill in the fields on the form, as appropriate.
4. Optional: Select or add a subcategory.
5. Click OK.

Create a knowledge article from a customer service case
Reuse information from a customer service case by creating knowledge articles from cases.

Before you begin
Your administrator must enable creation of articles from customer service cases.
Role required: sn_customerservice_agent or knowledge

Procedure
1. Navigate to Customer Service > Cases > All.
2. Select a case from which you want to create a knowledge article.
3. Click Create Knowledge.
   The relevant fields are automatically copied from the case to the record that opens.
4. In the Knowledge base field, enter the name of the knowledge base in which you want this article to display.
5. Click Submit.
Request a knowledge base

If existing knowledge bases do not fit your needs, you can request a new knowledge base through the service catalog. If the request is approved, you are added as the owner of the new knowledge base.

Before you begin
Role required: none

About this task
If no knowledge base exists that fit your needs, all users can request a new knowledge base.

Procedure
1. Navigate to Self-Service > Service Catalog.
2. Select Can We Help You?.
3. Select the Request Knowledge Base catalog item.
4. Enter the reason you want the knowledge base, and a name for the knowledge base.
5. Click Submit.

What to do next
You are notified when the request is approved or rejected. If the request is approved, you are added as the owner of the new knowledge base. You can then assign managers and manage articles in the new knowledge base.

Knowledge bases created through this request process are inactive by default, so you must activate the knowledge base to make it available for users.

Related information
- Assign a knowledge base manager
- Add a knowledge article to featured content
- Create a knowledge article

Use knowledge on mobile devices
All users can access knowledge from mobile devices to search for and view knowledge articles.

Browse knowledge on mobile devices
You can browse knowledge bases using a mobile device.
Navigate to **SELF-SERVICE > Knowledge Base.**

Browse Knowledge by tapping on a category and browsing articles or subcategories.
Mobile Knowledge Categories

Select the desired category and click the close icon (×) for the selected category to reflect in the search results.

View knowledge articles on mobile devices

You can read knowledge content using a mobile device.

Tap a title to view the article.

(×) Note: You cannot edit or add comments to knowledge articles on the mobile interface.
Mobile Knowledge Article View

SAP troubleshooting techniques

1. Using transaction SE11, create a table (ZTABLE) with the same fields as the table in the external database, make sure that the type and lengths of the fields are identical.
2. Using transaction SE11, create a view (ZTABLE_VIEW, projection view) using BASIS table ZTABLE
3. Using SVRMGR>

create dblink REMOTE_DB as connect to remote_user identified by password; (database link created)
drop table ZTABLE; (table dropped)
create synonym ZTABLE for ZTABLE@REMOTE_DB; (synonym created)

- Using transaction SE16, type in ZTABLE_VIEW and hit RETURN
- Enter value in key fields and hit execute

Search knowledge on mobile devices

Find a specific article by searching on a particular term.
Mobile Knowledge Search

Machine learning solutions for Knowledge Management

Machine learning in Knowledge Management helps improve knowledge governance and quality of your knowledge base.

Machine learning in Knowledge Management has the following benefits:

• Improves the quality of your knowledge base by avoiding duplicate articles and makes the knowledge base more Knowledge-Centred Service (KCS) compliant.
• Suggests related articles to help you solve an issue or resolve a question.
• Identifies knowledge gaps and improves content of your knowledge base using the Knowledge Demand Insights feature.

Predictive Intelligence for Knowledge Management

The Predictive Intelligence for Knowledge Management capability uses machine-learning algorithms to provide various Knowledge Management capabilities, such as similar articles and knowledge demand insights.

Solution definitions for Predictive Intelligence for Knowledge Management

The solution definitions for Predictive Intelligence for Knowledge Management capability are available in the Predictive Intelligence for Knowledge
Management plugin (com.snc.knowledge_ml). For more information about the plugin, see Additional plugins for Knowledge Management.

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Similar Articles</td>
<td>Similarity</td>
<td>Suggests related articles based on the short description of articles. You can see the results in the following places:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The Knowledge results section on the Knowledge form when creating an article in the Knowledge Management Service Portal.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The Related Articles section on the knowledge article view page in the Knowledge Management Service Portal and Now Mobile applications.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The Agent assist in Agent Workspace</td>
</tr>
</tbody>
</table>

Note: This solution definition is available as a template on instances where both the Predictive Intelligence for Contextual Search plugin (com.snc.contextual_search_ml) and Predictive Intelligence for Knowledge Management plugin (com.snc.knowledge_ml) are activated.
### Solution definition and solution type (continued)

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand Insights: Case Clusters Need Knowledge</td>
<td>Clustering</td>
<td>Populates collections of closed and resolved customer service cases on the Demand Insights for Cases dashboard.</td>
</tr>
<tr>
<td>Demand Insights: Incident Clusters Need Knowledge</td>
<td>Clustering</td>
<td>Populates collections of closed and resolved incidents on the Demand Insights for Incidents dashboard.</td>
</tr>
<tr>
<td>Demand Insights: Similar Cases and Knowledge</td>
<td>Similarity</td>
<td>Compares similarity of incidents with knowledge bases and identifies similar closed and resolved customer service cases as candidate knowledge gaps.</td>
</tr>
<tr>
<td>Demand Insights: Similar Incidents and Knowledge</td>
<td>Similarity</td>
<td>Compares similarity of incidents with knowledge bases and identifies similar closed and resolved incidents as candidate knowledge gaps.</td>
</tr>
</tbody>
</table>

### Related information

- Train the similarity solution for Knowledge Management to find related articles
- Create a knowledge article in Agent Workspace
- Knowledge demand insights
- Demand Insights for Cases dashboard
Train the similarity solution for Knowledge Management to find related articles

Train the Knowledge Similar Articles solution definition included within the Predictive Intelligence for Knowledge Management capability to find related knowledge articles when creating or viewing a knowledge article.

Before you begin

Ensure that the Predictive Intelligence for Contextual Search plugin (com.snc.contextual_search_ml) and Predictive Intelligence for Knowledge Management plugin (com.snc.knowledge_ml) are activated.

Role required: admin

Procedure

1. Navigate to Predictive Intelligence > Similarity > Solution Definitions.
2. In the Similarity Definitions list, search for and select the Knowledge Similar Articles solution definition (ml_sn_global_knowledge_similar_articles).
3. On the Similarity Definition form, verify the default field values for knowledge articles. For more information about the Similarity Definition form fields, see .

   Note: If the application scope isn’t set to Knowledge Management - Machine Learning, you cannot edit the form and a warning message appears. To make the form editable, click the word here at the end of the message.

4. Click Update & Retrain.
5. Open the Similarity Definition form for the Knowledge Similar Articles solution definition (ml_sn_global_knowledge_similar_articles).
6. In the ML Solutions related list, view the training solution progress in the Progress column.
   When Progress is 100%, in the ML Solutions related list, you can include more useful related articles by reviewing the similarity examples based on the similarity score and updating the similarity score threshold value.
7. Optional: Update the similarity score threshold.
   a. In the Active column, click the link for the solution.
   b. Review the similarity examples by clicking the Similarity Examples related link on the ML Solution form.
      For more information, see Review solution similarity examples.
c. In the Solution Statistics related list on the ML Solution form, enter the required value in the **Similarity Score Threshold** field, right-click the ML Solution form, and then click **Save**. For more information, see Update your similarity score threshold.

**Results**
When the solution is complete, the related knowledge articles appear in the Knowledge results section on the Knowledge form in the Now Platform, in the Related Articles section on the knowledge article view page in the Knowledge Management Service Portal, and in Agent assist when the **Similar Articles (ML)** option is selected.

**Related information**
- Predictive Intelligence for Knowledge Management
- Knowledge Management Service Portal article view page features
- Create a knowledge article
- Create a knowledge article in Agent Workspace
- Now Mobile for Knowledge Management

**Knowledge demand insights**
Identify knowledge gaps and improve content of your knowledge base using the Knowledge Demand Insights feature.

The Knowledge Demand Insights feature automates the discovery of knowledge gaps in your knowledge bases. Knowledge gaps are topics on which knowledge bases are missing knowledge articles.

Addressing knowledge gaps has the following benefits:

- Improve effectiveness of self-service: Self-service users get more relevant information for research, troubleshooting, and how to queries.
- Increase case or incident resolutions: Having relevant information available helps you deflect future cases.
- Improved case resolution: Agents can find more relevant knowledge articles to solve cases, incidents, problems, and so on.

**Activation information**
The Knowledge Demand Insights feature requires the Predictive Intelligence for Knowledge Management plugin (com.snc.knowledge_ml). For more
Demand insights dashboards

You can use a demand insights dashboard for your tasks to analyze candidate knowledge gaps and create knowledge gap feedback tasks. By default, the Knowledge Demand Insights feature includes Demand Insights for Incidents, Demand Insights for Cases, and Demand Insights: Similar HR Cases and Knowledge dashboards for incidents, customer service cases, and HR cases, respectively. For other tasks, you can create a dashboard. To access a demand insights dashboard, you must have read access to the tasks and the sn_km_ml.knowledge_curation_user role. For more information, see Analyze knowledge gaps from a demand insights dashboard and create knowledge gap feedback tasks.

Related information
- Demand Insights for Cases dashboard
- Demand Insights for Incidents dashboard
- Demand Insights for HR Cases dashboard

Configure Knowledge Demand Insights

Configure the Knowledge Demand Insights feature to identify which topics are missing knowledge articles and creating actionable knowledge gaps for missing topics.

Before you begin

Activate the Predictive Intelligence for Knowledge Management plugin (com.snc.knowledge_ml). For more information, see Predictive Intelligence for Knowledge Management and Additional plugins for Knowledge Management.

About this task

To configure the Knowledge Demand Insights feature, use the Knowledge Management guided setup. The guided setup takes you through the entire setup and configuration process.

This task provides general steps to configure the Knowledge Demand Insights feature. For more information about the feature, see Knowledge demand insights.
Procedure

1. Configure similarity and clustering solution definitions to enable comparing knowledge bases with a task type.

2. Configure the combination of the task table and similarity and clustering solution definitions that are processed in a scheduled job for a task type.

3. Configure scheduled jobs for each task.

4. Configure assignment rules to automatically assign feedback tasks of type Knowledge gap.

⚠️ Note: If no assignment rules are configured, a knowledge admin or knowledge manager can later use the Feedback Management feature in the Knowledge module to manually assign a feedback task.

Related information

Analyze knowledge gaps from a demand insights dashboard and create knowledge gap feedback tasks

Configure solution definitions to find gaps in a knowledge base

The Knowledge Demand Insights feature finds knowledge gaps by comparing knowledge bases with existing tasks. To enable comparing knowledge bases with a task type, you must first configure similarity and clustering solution definitions.

Before you begin

This task describes the process for configuring a solution definition. Instead of doing the configuration through this procedure, consider using a guided setup. Navigate to Knowledge > Administration > Guided Setup, click Get Started, and then scroll to the Knowledge Demand Insights section.

Role required: admin

About this task

Configure one similarity type and one clustering type solution definitions for each task type: incidents, customer service cases, or other tasks. A similarity solution definition collects and compares your existing records to new similar records. A clustering solution definition groups similar records into clusters so you can address them collectively or identify patterns.
Procedure

1. Navigate to **Knowledge Demand Insights > Solution Definitions**.

2. In the Solution Definitions (ML view) list, search for and select the similarity solution definition for the task type.
   - For customer service cases, select **Demand Insights: Similar Cases and Knowledge (ml_sn_global_similar_cases_and_kbs)**.
   - For incidents, select **Demand Insights: Similar Incidents and Knowledge (ml_sn_global_similar_incidents_and_kbs)**.
   - For HR cases, select **Demand Insights: Similar HR Cases and Knowledge (ml_x_sn_hr_core_global_demand_insights_similar_hr_cases_and_knowledge)**.
   - For tasks other than customer service cases, incidents, and HR cases, click **New** to create another similarity solution definition.

3. On the Similarity Definition form, verify the default field values for customer service cases or incidents, or fill in the values for a custom configuration.

**Note:** If the application scope isn’t set to Knowledge Management - Machine Learning, you cannot edit the form and a warning message appears. To make the form editable, click the word **here** at the end of the message.

**Similarity Definition form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Unique name for your similarity solution.</td>
</tr>
<tr>
<td>Word Corpus</td>
<td>Defines which knowledge articles and tasks are selected for knowledge gap analysis.</td>
</tr>
<tr>
<td></td>
<td>If you don’t have a relevant word corpus, follow the steps in Create a word corpus.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that contains the knowledge article records. Set the value to Knowledge [kb_knowledge] unless you use a different table for storing knowledge articles.</td>
</tr>
<tr>
<td></td>
<td>After you assign a table value, the number of records that match the filter conditions is displayed as a link.</td>
</tr>
<tr>
<td>Fields</td>
<td>Fields from the Knowledge table selected for knowledge gap analysis.</td>
</tr>
<tr>
<td>Filter</td>
<td>Filter conditions applied on the Knowledge table to filter knowledge article records for knowledge gap analysis.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Test Table</td>
<td>Table that contains the task records that you want to compare with knowledge article records.</td>
</tr>
<tr>
<td>Test Fields</td>
<td>Fields from the task table selected for knowledge gap analysis.</td>
</tr>
<tr>
<td>Processing Language</td>
<td>Dominant language of the dataset you’re training on the solution definition. By default, English processing is applied to all datasets. For example, if you select Italian, the system processes the data in both English and Italian. Note: The term processing indicates some of the language-specific steps used as part of training a solution. These steps might include tokenizing words, removing stop words, and stemming.</td>
</tr>
<tr>
<td>Stopwords</td>
<td>Common terms in the processing language that are excluded from the search, for example, prepositions. When you select your processing language, the system automatically adds a Stopwords list that uses the same language. For example, if your processing language is Italian, the Default Italian Stopwords list appears. The Default English Stopwords list also appears in your selection as well.</td>
</tr>
<tr>
<td>Training Frequency</td>
<td>Frequency with which the model for similarity solution definition must be retrained.</td>
</tr>
<tr>
<td>Update Frequency</td>
<td>Frequency with which to include new records in the model for the similarity solution definition.</td>
</tr>
</tbody>
</table>

4. Submit and train the solution definition.
   - For a new solution definition record, click **Submit & Train**.
   - For an existing solution definition record, click **Update & Retrain**.

5. Optional: Include more useful related articles by reviewing the similarity examples based on the similarity score and updating the similarity score threshold value. For more information, see Review solution similarity examples and Update your similarity score threshold.

6. In the Solution Definitions (ML view) list, search for and select the clustering solution definition for the task type.
• For customer service cases, select Demand Insights: Case Clusters Need Knowledge (ml_sn_global_cases_need_knowledge_cluster).

• For incidents, select Demand Insights: Incident Clusters Need Knowledge (ml_sn_global_incidents_need_knowledge_cluster).

• For HR cases, select Demand Insights: HR case clusters need knowledge (ml_x_sn_hr_core_global_demand_insights_hr_case_clusters_need_knowledge).

• For tasks other than customer service cases and incidents, click New to create another clustering solution definition.

7. On the Clustering Definition form, verify the default field values for customer service cases or incidents, or fill in the values for a custom configuration.

Note: If the application scope isn’t set to Knowledge Management - Machine Learning, you cannot edit the form and a warning message appears. To make the form editable, click the word here at the end of the message.

### Clustering Definition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Unique name for your clustering solution.</td>
</tr>
<tr>
<td>Word Corpus</td>
<td>Which tasks are selected for collections.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that contains the filtered tasks that require knowledge articles. Set the value to Task knowledge coverage [kb_task_knowledge_coverage] unless you use a different table for storing filtered tasks. After you assign a table value, the number of records that match the filter conditions is displayed as a link.</td>
</tr>
<tr>
<td>Fields</td>
<td>Fields from the Task knowledge coverage table selected for knowledge gap analysis.</td>
</tr>
<tr>
<td>Filter</td>
<td>Filter conditions applied on the Task knowledge coverage table to filter knowledge article records for knowledge gap analysis.</td>
</tr>
<tr>
<td>Processing Language</td>
<td>Dominant language of the dataset you’re training on the solution definition. By default, English processing is applied to all datasets. For example, if you select Italian, the system processes the data in both English and Italian.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The term processing indicates some of the language-specific steps used as part of training a solution. These steps might include tokenizing words, removing stop words, and stemming.</td>
</tr>
<tr>
<td>Stopwords</td>
<td>Common terms in the processing language that are excluded from the search, for example, prepositions. When you select your processing language, the system automatically adds a Stopwords list that uses the same language. For example, if your processing language is Italian, the Default Italian Stopwords list appears. The Default English Stopwords list also appears in your selection as well.</td>
</tr>
<tr>
<td>Update Frequency</td>
<td>Frequency with which to include new and updated records in the model for the clustering solution definition.</td>
</tr>
<tr>
<td>Training Frequency</td>
<td>Frequency with which the model for clustering solution definition must be retrained.</td>
</tr>
</tbody>
</table>

8. Submit and train the solution definition.
   - For a new solution definition record, click **Submit & Train**.
   - For an existing solution definition record, click **Update & Retrain**.

**What to do next**

Complete the KB curation configuration form to define the scheduled jobs for demand insights. For more information, see Configure the mapping of solution definitions with task tables.

**Related information**

- Predictive Intelligence for Knowledge Management
- Create and train a similarity solution
- Create and train a clustering solution
- Analyze knowledge gaps from a demand insights dashboard and create knowledge gap feedback tasks

**Configure the mapping of solution definitions with task tables**

Configure the combination of the task table and similarity and clustering solution definitions that are processed in a scheduled job for a task type. You can create another demand insights configuration or modify an existing configuration to define a scheduled job for demand insights.
Before you begin
This task describes the process for configuring a scheduled job. Instead of doing the configuration through this procedure, consider using a guided setup. Navigate to Knowledge > Administration > Guided Setup, click Get Started, and then scroll to the Knowledge Demand Insights section.

Ensure that you have configured a similarity type and clustering type solution definitions for a task type. For more information, see Configure solution definitions to find gaps in a knowledge base.

Role required: admin

About this task
A scheduled job for each task type runs business rules and then executes the similarity and clustering solution definitions. In the Demand Insights Configuration module, you configure the combination of the task table and similarity and clustering solution definitions that are processed in a scheduled job for a task type. This configuration is optional for customer service cases and incidents.

Note: For task types other than customer service cases and incidents, a user with the admin role must also perform the following tasks:

• Assign the sn_km_ml.knowledge_curation_user role and the appropriate roles for the task type to the users performing the knowledge gap analysis. To assign roles, perform the Assign knowledge curator roles guided setup task, which are available in the Knowledge Demand Insights section of the Knowledge Management guided setup.

• Create a demand insights dashboard for the task type. To create a dashboard, see Create or configure a responsive dashboard.

Procedure
1. Navigate to Knowledge Demand Insights > Demand Insights Configuration.

2. Configure the combination of the task table and similarity and clustering solution definitions that are processed in a scheduled job.

• For customer service cases, select sn_customerservice_case.

• For incidents, select incident.

• For HR cases, select sn_hr_core_case.

• For tasks other than customer service cases, incidents, and HR cases, click New to create another combination.

3. On the KB curation configuration form, verify the default field values for customer service cases or incidents or fill in the values for a custom configuration.
## KB curation configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curation table</td>
<td>Name of the table you want the data to pull information from. For example, for customer service cases, select Case [sn_customerservice_case] and for incidents select Incident [incident].</td>
</tr>
<tr>
<td>Fields</td>
<td>Fields in the curation table that include the ID of knowledge articles, for example, the knowledge article ID KB07276660 in the field resolution notes.</td>
</tr>
<tr>
<td>Query condition</td>
<td>Conditions for filtering the number of tasks from the curation table. You can create conditions using the condition builder (see Condition builder).</td>
</tr>
<tr>
<td>Similarity solution definition</td>
<td>Similarity solution definition for your task type. For example, for customer service cases, select Demand Insights: Similar Cases and Knowledge.</td>
</tr>
<tr>
<td>Clustering solution definition</td>
<td>Clustering solution definition for your task type. For example, for customer service cases, select Demand Insights: Case Clusters Need Knowledge.</td>
</tr>
</tbody>
</table>

4. Click **Update** for incidents or customer service cases or **Submit** to save a custom configuration.

### What to do next

Set the frequency of the scheduled job for your task. For more information, see Set the frequency of knowledge gap analysis.

### Related information

Configure solution definitions to find gaps in a knowledge base

### Set the frequency of knowledge gap analysis

Set the frequency of the scheduled job for your task to automatically run knowledge gap analysis.

### Before you begin

This task describes the process for setting the frequency of knowledge gap analysis.

Instead of doing the configuration through this procedure, consider using a guided setup. Navigate to Knowledge > Administration > Guided Setup, click Get Started, and then scroll to the Knowledge Demand Insights section.
Role required: admin

**Procedure**

1. Navigate to **Knowledge Demand Insights > Scheduled Jobs**.

2. In the Scheduled Jobs list, select the scheduled job for your tasks in the **Name** column.
   - For customer service cases, select **[Knowledge Curation]: Generate Case Clusters**.
   - For incidents, select **[Knowledge Curation]: Generate Incident Clusters**.
   - For HR cases, select **[Knowledge Curation]: Generate HR Case Clusters**.
   - For tasks other than customer service cases, incidents, and HR cases, create another scheduled job. For more information, see **Create a scheduled job**.

3. On the Scheduled Script Execution form, either accept the default value of running the analysis once a quarter (every 90 days) or change the frequency.
   
   1. **Note:** For best performance results, try not to perform knowledge gap analysis more frequently than once a month.

4. Click **Update**.
   
   1. **Note:** If the application scope is not set to Knowledge Management - Machine Learning, a warning message appears and the **Update** button is not available. Click the word **here** at the end of the message to change the scope and click **Update**.

5. **Optional:** To run the job immediately, click **Execute Now**.

**Results**

The knowledge gap analysis is repeatedly run at the duration as configured in the scheduled job.

**What to do next**

Create assignment rules to assign knowledge gap feedback tasks. For more information, see **Assign knowledge gap feedback tasks to content authors**.

**Related information**

- **Analyze knowledge gaps from a demand insights dashboard and create knowledge gap feedback tasks**

**Assign knowledge gap feedback tasks to content authors**

Create assignment rules to assign knowledge gap feedback tasks to authors or groups of content creators.
Before you begin
Role required: admin or assignment_rule_admin

About this task
Knowledge gap feedback tasks created through the Knowledge Demand Insights feature create feedback tasks of type Knowledge gap.

Procedure
1. Navigate to Knowledge Demand Insights > Knowledge Gap Assignment.
2. In the Assignment Rules list, click New.
3. On the Assignment rule form, fill in the fields.

Assignment rule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name for the assignment rule.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the assignment rule. Only active assignment rules take effect.</td>
</tr>
</tbody>
</table>
| Applies to tab Table | Table to store the feedback tasks on knowledge articles. This field is automatically set to [Knowledge Feedback Task 
[kb_feedback_task]](kb_feedback_task). |
| Conditions  | Conditions for assigning feedback tasks of the Knowledge gap type. This field is automatically set to [Feedback Task Type] [is] [Knowledge gap]. You can add more conditions as appropriate. |
| Assign to tab User | User assigned the feedback task type of knowledge gap.                   |
|             | Group Ownership group assigned the feedback task type of knowledge gap.    |
| Script tab  | Script Script you can use to specify more complex conditions for assignment rules using dynamic variables and loops. |

4. Click Submit.
Related information

Create an assignment rule
Analyze knowledge gaps from a demand insights dashboard and create knowledge gap feedback tasks

Analyze knowledge gaps from a demand insights dashboard and create knowledge gap feedback tasks
Use the demand insights dashboard for your tasks to analyze candidate knowledge gaps and create knowledge gap feedback tasks.

Before you begin
You must have read access to the tasks that you want to analyze and the sn_km_ml.knowledge_curation_user role.

About this task
A demand insights dashboard displays tasks as topics for which your knowledge bases do not have adequate knowledge coverage. You can create and assign knowledge gap feedback tasks for a topic so your knowledge bases can better be used to solve and deflect any issues described in a task. Tasks represent customer service cases, incidents, problems, and so on.

Procedure

1. Navigate to Knowledge Demand Insights and select the demand insights dashboard for your tasks, or navigate to Self-Service > Dashboards.
   - For customer service cases, select Demand Insights for Cases.
   - For incidents, select Demand Insights for Incidents.
   - For HR cases, select Demand Insights for HR cases.

   Note: For tasks other than customer service cases, incidents, and HR cases, you can create another dashboard or update an existing dashboard. For more information, see Create and use dashboards.

2. To view similar tasks grouped together, click a bar in the Pareto chart. Each bar represents a collection of similar tasks grouped together because they are likely to be on the same topic. The bars covering the largest number of tasks start from the left in a descending order. The blue line indicates how many bars you must analyze to cover 80% of all tasks that don’t have good knowledge coverage. For more information, see Pareto chart for Knowledge Demand Insights.

3. Optional: To generate a representative sample to see a smaller list, in the Knowledge Curation Tasks list, click Generate Representative Sample.
If the Knowledge Curation Tasks list is large, you can generate a representative sample subset of a Knowledge Curation Tasks list. This smaller list aims to accurately reflect the characteristics of the tasks included in the main list.

4. Analyze the sample to create a knowledge gap feedback task or ignore the tasks within a collection.

<table>
<thead>
<tr>
<th>Action</th>
<th>Procedure</th>
</tr>
</thead>
</table>
| **Report a knowledge gap to create a feedback task** | a. In the Knowledge Curation Tasks list, select tasks for which you want to create a knowledge gap.  

**Note:** Any selected tasks already reported as knowledge gaps are automatically skipped.  
b. Click **Report Knowledge Gap**.  
c. In the **Description** field, describe the knowledge gap.  
The **Description** field is automatically populated with frequently appearing words in the associated collection. You can overwrite the default description and enter a summary of your analysis so that knowledge authors have the necessary information to create an article from the feedback task.  
d. Click **Submit**. |

| Ignore a collection to avoid its tasks from being reported as knowledge gaps | a. In the Knowledge Curation Tasks list, click **Ignore Collection**.  
b. Click **OK** in the warning message that appears. |

**Results**

If tasks within a collection are reported as knowledge gaps, a common feedback task for all the selected tasks is created and appears in the Knowledge Management application. You can use the assignment rules to assign a feedback task to an ownership group or author. In the Knowledge |
Curation Tasks list, the **Is knowledge gap created** column value for the selected tasks is set to **true**.

If you select an ignored collection from the demand insights dashboard, you can no longer report tasks within the collection as knowledge gaps.

**Related information**

- Demand Insights for Cases dashboard
- Demand Insights for Incidents dashboard

**Pareto chart for Knowledge Demand Insights**

The Pareto chart for Knowledge Demand Insights enables you to visualize candidate knowledge gaps and prioritize the order in which knowledge gaps should be resolved.

The following information is available in the Pareto chart for Knowledge Demand Insights:

- The left Y axis is the count of tasks with no or insufficient knowledge coverage.
- The right Y axis is the cumulative percentage of the total number of tasks evaluated.
- Each bar represents a collection of similar tasks that don’t have good knowledge coverage. The bars are arranged in a descending order such that the collection with most number of tasks appears in the left. This order enables you to resolve the largest collection first. When you point to a bar, you view the number of tasks included within the bar and the cumulative percentage.
- The line graph shows the cumulative percentage of tasks that are included in each collection.
- The blue line indicates the 80% of total number of tasks that have no or insufficient knowledge coverage. The intersection of the blue line and the line graph indicates the minimum number of collections that need to be resolved so that 80% of tasks can be covered.

**Example: Pareto chart for demand insights**

The following figure displays a Pareto chart for identifying candidate knowledge gaps for incidents.
The Demand Insights for Cases dashboard enables you as a customer service case manager to identify which cases have no or insufficient knowledge coverage. You can then create feedback tasks for knowledge gaps to deflect such cases.

The Predictive Intelligence for Knowledge Management plugin (com.snc.knowledge_ml) includes the Demand Insights for Cases dashboard. For more information, see Predictive Intelligence for Knowledge Management and Additional plugins for Knowledge Management.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer service case manager: Needs to identify which cases don't have good knowledge coverage.</td>
<td>sn_km_ml.knowledge_curation_user and sn_customerservice_manager</td>
</tr>
</tbody>
</table>

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Candidate Knowledge Gaps for Case</td>
<td>Pareto Chart</td>
<td>Displays data from the Knowledge Curation Task [kb_curation_task_cluster] table with the following conditions: Curation configuration = sn_customerservice_case AND Solution.Active = true</td>
</tr>
</tbody>
</table>

Related information

Pareto chart for Knowledge Demand Insights
Knowledge demand insights
Demand Insights for Incidents dashboard

The Demand Insights for Incidents dashboard enables you as an incident manager to identify which incidents have no or insufficient knowledge coverage. You can then create feedback tasks for knowledge gaps to deflect such incidents.

The Predictive Intelligence for Knowledge Management plugin (com.snc.knowledge_ml) includes the Demand Insights for Incidents dashboard. For more information, see Predictive Intelligence for Knowledge Management and Additional plugins for Knowledge Management.

### End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident manager: Needs to identify which incidents don't have good knowledge coverage.</td>
<td>sn_km_ml.knowledge_curation_user and incident_manager</td>
</tr>
</tbody>
</table>

### Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Candidate Knowledge Gaps for Incident</td>
<td>Pareto Chart</td>
<td>Displays data from the Knowledge Curation Task [kb_curation_task_cluster]</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>table with the following conditions: Curation configuration = incident AND Solution.Active = true</td>
</tr>
</tbody>
</table>

**Related information**

- Pareto chart for Knowledge Demand Insights
- Knowledge demand insights

**Demand Insights for HR Cases dashboard**

The Demand Insights for HR cases dashboard enables you as an HR agent to identify which HR cases have no or insufficient knowledge coverage. You can then create feedback tasks for knowledge gaps to deflect such HR cases.

⚠️ **Note:** For Demand Insights for HR cases dashboard, activate the Human Resources Scoped App: Core plugin [com.sn_hr_core] and Predictive Intelligence for Knowledge Management plugin [com.snc.knowledge_ml].
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR agent: Needs to identify which HR cases don’t have good knowledge coverage.</td>
<td>sn_km_ml.knowledge_curation_user and sn_hr_core.admin</td>
</tr>
</tbody>
</table>

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Candidate Knowledge Gaps for HR cases</td>
<td>Pareto Chart</td>
<td>Candidate Knowledge Gaps for HR cases.</td>
</tr>
</tbody>
</table>

Self-Service Analytics

The Self-Service Analytics framework enables you to gather information about user activities and deflection outcomes related to those activities.

Display the effectiveness of self-service channels by using reports and dashboards based on the data generated by the Self-Service Analytics framework. This Self-Service Analytics data is used by the Self-Service Analytics dashboard for customer service. You can also use the Self-Service Analytics framework in dashboards of other applications that use the Subscriptions and Activity Feed Framework. For more information, see Self-Service Analytics dashboard for customer service.

Analyzing self-service deflection metrics has the following benefits:

- Measure self-service effectiveness through self-service KPIs.
- Quantify successful self-service engagements to take corrective actions.
- Define custom self-service KPIs tailored to your organization.

Activation information

The Self-Service Analytics framework requires the Self-Service Analytics Core plugin (com.snc.self_service_analytics_core). For more information, see Activate Self-Service Analytics.

Note: The data for the Communities and Virtual Agent channels are generated when the Communities plugin (com.sn_communities) and Glide Virtual Agent plugin (com.glide.cs.chatbot) are activated respectively.
Related information

Self-Service Analytics concepts

Analytics and Reporting Solutions for Self-Service Analytics for Customer Service

Self-Service Analytics concepts

You can quantify your self-service effectiveness by measuring case deflections. The Self-Service Analytics framework enables you to measure case deflection by defining user activity patterns for a deflection outcome. A case deflection is when you are able to provide a resolution using one of the self-service channels, such as Knowledge, Communities, Catalog, and Virtual Agent, to a user who intended to create a case and as a result, no case is created.

By default, the Self-Service Analytics framework is used by the Self-Service Analytics dashboard for customer service. The framework can also be used in dashboards of other applications that use the Subscriptions and Activity Feed Framework.

The system includes predefined configurations for the Self-Service Analytics framework components associated with consumers and customer contacts. You can also configure these components for other user entities.

Self-service analytics components

Self-service analytics is based on the activity pattern associated with a deflection outcome. It consists of the following main components:

- Activity pattern (see Activity pattern components)
- Deflection outcome (see Deflection outcome components)

Activity pattern components

Activity pattern

A combination of pattern element, pattern element group, or both for a user entity such as consumers or customer contacts that is linked to an outcome. Each pattern element or pattern element group is implemented as regular expressions.

Example: The activity pattern Contacts: Case: Confirmed Deflection is a combination of pattern element groups Self-Service: Helpful and Self-service actions: Optionally Many.

Deflection outcome

An activity pattern can lead to a deflection outcome. See Deflection outcome components.
Primary activity

The final activity that determines the outcome associated with an activity pattern based on whether it happens or not.

Example: For the primary activity Customer created a case if the system does not find a match (that is a case was not created), the outcome Confirmed deflection is associated with the activity pattern Contacts: Case: Confirmed Deflection.

Pattern element group

A logical combination of two pattern elements, pattern element group, or both and how many times the combination occurs. For more information, see Pattern element group components.

The following figure illustrates the components of the activity pattern Contacts: Case: Confirmed Deflection.

Pattern element group components

Pattern element group

A logical combination of two pattern elements, pattern element group, or both and how many times the combination occurs. Each pattern element group is implemented as regular expressions.
The occurrence of the logical combination result is one of the following types:

- Once
- Optionally Once
- Optionally Many
- At Least Once
- Range

Example 1: In the following table, the Knowledge engagements once pattern element group is true when it occurs only once and either Article viewed once is true or Article marked with positive feedback once is true.

<table>
<thead>
<tr>
<th>Pattern element group</th>
<th>First Element</th>
<th>Second Element</th>
<th>Operator</th>
<th>Occurrence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge engagements</td>
<td>Article viewed once</td>
<td>Article marked with positive feedback once</td>
<td>Or</td>
<td>Once</td>
</tr>
</tbody>
</table>

Example 2: In the following table, the Self-service engagements optionally many pattern group is true when engagements either have not occurred or have occurred multiple times and either the Knowledge or catalog engagements once is true or the Communities or virtual agent engagements once is true.

<table>
<thead>
<tr>
<th>Pattern element group</th>
<th>First Element</th>
<th>Second Element</th>
<th>Operator</th>
<th>Occurrence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge or catalog</td>
<td>Knowledge engagements</td>
<td>Catalog engagements</td>
<td>Or</td>
<td>Once</td>
</tr>
<tr>
<td>engagements once</td>
<td>once</td>
<td>once</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Communities or virtual</td>
<td>Communities</td>
<td>Virtual agent engagements</td>
<td>Or</td>
<td>Once</td>
</tr>
<tr>
<td>agent once</td>
<td>once</td>
<td>once</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Pattern element group example 2 (continued)

<table>
<thead>
<tr>
<th>Pattern element group</th>
<th>First Element</th>
<th>Second Element</th>
<th>Operator</th>
<th>Occurrence</th>
</tr>
</thead>
<tbody>
<tr>
<td>engagements once</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Self-service engagements optionally many</td>
<td>Knowledge or catalog engagements once</td>
<td>Communities or virtual agent engagements once</td>
<td>Or</td>
<td>Optionally Many</td>
</tr>
</tbody>
</table>

**Pattern element**

Denotes a single activity type and how many times it occurs. Each pattern element is implemented as regular expressions.

Example: The pattern element Article viewed once denotes that the activity Viewed a knowledge article must occur once.

**Activity type**

An action that a user (consumer or customer contact) performs.

Example: The activity type Viewed knowledge article occurs when a user views a knowledge article.

The following figure illustrates the components of the pattern element group Knowledge engagements once.
Activity context components

**Activity context**

A collection of activity groups a user might perform such as Catalog, Knowledge, Case, Communities, and Virtual Agent.

Example: The activity context Contact is a collection of activity groups Catalog, Knowledge, Case, Communities, and Virtual Agent associated with the customer contact.

**Activity group**

A logical grouping of activity types performed on the same object type such as a knowledge article, community answer, or customer service case.

Example: The activity group Knowledge is a logical grouping of the activities Viewed knowledge article and Marked the article helpful performed on a knowledge article.

**Activity context group**

An activity group that has been added to a context.
The following figure illustrates the components of the activity context Contact.

**Deflection outcome components**

**Deflection outcome**

In the context of deflection, an activity pattern can lead to one of the following three outcomes:

- **Confirmed deflection**
  
  The self-service content definitely prevented a case from getting created.

- **Potential deflection**
  
  The self-service content was viewed and no case was created, but it’s unclear whether the content is the factor that prevented the case from getting created.

- **No deflection**
  
  A case was created after the self-service content was viewed.

**Deflection configuration**

Associates a window (duration) with an activity context. The window defines how long a system will wait for a case to be created to match with a deflection pattern.

Example: To track the create case activity for a consumer within a day, set the window as 1 day.

- If the consumer created a case within that window, the deflection pattern matched is a No deflection.
- If the consumer did not create a case within that window, the deflection pattern matched is a Potential deflection.
• If the consumer did not create a case and the last activity is submitted positive feedback for any self-service channel content within that window, the deflection pattern matched is a Confirmed deflection.

**Deflection metrics**

A transactional table that stores the outcome of matched patterns. By default, the scheduled job for Self-Service Analytics captures data and stores the generated data in the Deflection Metric [ssa_deflection_metric] table.

**Deflection pattern**

Associates deflection configuration with an activity pattern. A deflection pattern is implemented as a table.

**Related information**

Configure Self-Service Analytics

**Configure Self-Service Analytics**

Configure the Self-Service Analytics framework so you can use the generated metrics in a dashboard.

**Before you begin**

Role required: admin

**About this task**

Complete the following tasks to use the metrics generated by the Self-Service Analytics framework in a dashboard of an application:

**Procedure**

1. Activate Self-Service Analytics.
2. Configure activity contexts for Self-Service Analytics.
3. Configure pattern elements for Self-Service Analytics.
4. Configure pattern element groups for Self-Service Analytics.
5. Configure activity patterns for Self-Service Analytics.
6. Set up the deflection configuration for Self-Service Analytics.
7. Configure scheduled jobs for Self-Service Analytics.
Activate the Self-Service Analytics Core plugin (com.snc.self_service_analytics_core) if you have the admin role. This plugin activates related plugins if they are not already active.

**Before you begin**
Role required: admin

**About this task**
The Self-Service Analytics Core plugin provides the Self-Service Analytics framework for configuring deflection contexts and activity patterns to collect the case reduction (deflection) metrics. The metrics are used in the Self-Service Analytics dashboard. The Self-Service Analytics Core plugin activates these related plugins if they are not already active.

**Plugins for Self-Service Analytics Core**

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscriptions and Activity Feed Framework</td>
<td>Provides a generic set of artifacts to handle subscriptions for any defined subscribable object. Any entity can be defined as a subscribable object and a set of subscribers can subscribe to the objects. When a event occurs related to the subscribable object, activities can be tracked and subscribers can be notified.</td>
</tr>
</tbody>
</table>

**Note:** The Self-Service Analytics Core plugin is also installed when you activate the Analytics and Reporting Solution for Self-Service Analytics for Customer Service. For more information, see Activate the Analytics and Reporting Solution for Self-Service Analytics for Customer Service.

**Procedure**

1. Navigate to [System Applications > All Available Applications > All](#).
2. Find the plugin using the filter criteria and search bar.
You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click Install, and then in the Activate Plugin dialog box, click Activate.

⚠️ Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Configure activity contexts for Self-Service Analytics

Define the type of activities you want to collect as Self-Service Analytics data for a user entity such as consumers and customer contacts.

Before you begin
Role required: self_service_manager

About this task
The activity types you add to an activity context are already predefined for use in applications that use the Subscriptions and Activity Feed Framework. This framework is available when you install the Subscriptions and Activity Feed Framework plugin (com.snc.activity_subscriptions). The plugin is activated when you activate the Self-Service Analytics Core plugin (com.snc.self_service-analytics_core).

Procedure
1. Navigate to Self-Service Analytics > Configuration > Activity Context.
2. In the Activity Contexts list, search for and select the activity context for your user entity.
   - For consumers, select Consumer.
   - For customer contacts, select Contact.
   - For user entities other than consumers and customer contacts, click New to create another activity context.
3. On the Activity Context form, verify the default field values for consumers and customer contacts, or fill in the values for a custom configuration.
### Activity Context form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for your activity context.</td>
</tr>
<tr>
<td>Context Table</td>
<td>Table that includes the user entity whose actions need to be tracked and displayed on the Self-Service Analytics dashboard. For example, if you want to track all actions for a customer contact, select the Contact [customer_contact] table. Similarly, if you want to track all actions for a consumer, select the Consumer [csm_consumer] table.</td>
</tr>
<tr>
<td>Module</td>
<td>Module associated with the application that stores the activities data.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of the application. This field is automatically set based on the application scope selected in the application picker.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain in which the activities records exist.</td>
</tr>
</tbody>
</table>

4. If you are creating a new activity context, click **Submit** and then select the newly created activity context link from the Activity Contexts list.

5. In the Activity Context Groups related list, map an activity context with activity groups.
   - For consumers and customer contacts, verify the default field values for an existing configuration.
   - For user entities other than consumers and customer contacts, click **New** to create another activity group or map with an existing activity group. For a new activity group mapping, on the Activity Group form, fill in the fields and click **Submit**. In the Activity Context Groups related list, you then have to select the newly created activity group and add available activity types to the activity group.

### Activity Group form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Context</td>
<td>Activity context associated with the activity group.</td>
</tr>
<tr>
<td>Activity Group</td>
<td>Option to search for and select an activity group.</td>
</tr>
</tbody>
</table>
6. In the Activity Context Types related list, map an activity context with an activity type.

- For consumers and customer contacts, verify the default field values for an existing configuration.

- For user entities other than consumers and customer contacts, click **New** to create another mapping or use an existing configuration.

For a new activity type mapping, on the Activity Source Context Mapping form, fill in the fields and click **Submit**.

### Activity Source Context Mapping form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Context</td>
<td>Activity context associated with the activity source.</td>
</tr>
<tr>
<td>Context Table</td>
<td>Table that includes the user entity whose actions need to be tracked and displayed on the Self-Service Analytics dashboard. This field is auto-populated based on the selected activity context.</td>
</tr>
<tr>
<td>Activity Type</td>
<td>Activity type you want to associate with the activity context.</td>
</tr>
<tr>
<td>Source Table</td>
<td>Table from which the data for the activity context is populated.</td>
</tr>
<tr>
<td>Filter Criteria</td>
<td>Filter conditions applied on the source table.</td>
</tr>
<tr>
<td>Advanced Mapping</td>
<td>Option to enable advanced mapping of activity source and activity context. You enter a script in the <strong>Advanced Mapping Script</strong> field.</td>
</tr>
<tr>
<td>Advanced Mapping Script</td>
<td>Script to use if the source and context mapping is not sufficient. This field appears only when the <strong>Advanced Mapping</strong> option is selected.</td>
</tr>
<tr>
<td>Module</td>
<td>Module associated with the application that stores the activities data.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of the application that contains the user entity. This field is automatically set based on the application scope selected in the application picker.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain in which the activities records exist.</td>
</tr>
<tr>
<td>Fetch from Activities</td>
<td>Option to enable a business rule defined for an activity type.</td>
</tr>
</tbody>
</table>

7. On the Activity Context form, click **Update**.

**What to do next**
Configure pattern elements for Self-Service Analytics.

**Configure pattern elements for Self-Service Analytics**
Configure a pattern element to specify a single activity type and how many times it occurs. Each pattern element is implemented as regular expressions.

**Before you begin**
Configure activity contexts for Self-Service Analytics.

Role required: self_service_manager

**About this task**
By default, the system includes pattern elements for analyzing activity patterns within Knowledge, Catalog, Communities, or Virtual Agent self-service channels.

**Procedure**

1. Navigate to **Self-Service Analytics > Configuration > Pattern Element**.
2. In the Pattern Elements list, modify an existing pattern element or click **New** to create another pattern element.
3. On the Pattern Element form, fill in the fields.

**Pattern Element form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to identify the pattern element.</td>
</tr>
<tr>
<td>Activity Type</td>
<td>Activity type you want to associate with the pattern element.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of the application that contains the user entity. This field is automatically set based on the application scope selected in the application picker.</td>
</tr>
<tr>
<td>Occurrence</td>
<td>Frequency with which an activity should occur. An activity occurrence is one of the following types:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Once</strong>: An activity must have occurred only once. For example, an article was marked with positive feedback only once.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Optionally Once</strong>: An activity might not have occurred, but if it has, then it has occurred only once. For example, either no catalog request was created or only one was created.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Optionally Many</strong>: An activity might not have occurred but if it has, then it has occurred multiple times. For example, either no catalog request has been created or multiple requests have been created.</td>
</tr>
<tr>
<td></td>
<td>• <strong>At Least Once</strong>: An activity has occurred at least once. For example, a community blog was viewed one or more times.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Range</strong>: An activity has occurred as many times as is specified in a range. You specify a range using the <strong>Minimum</strong> and <strong>Maximum</strong> fields. For example, if you specify a range of 2 to 4 Virtual Agent interactions, only 2, 3, or 4 interactions can have occurred.</td>
</tr>
<tr>
<td>Minimum</td>
<td>Minimum occurrence of an activity. This field appears only when <strong>Range</strong> is selected from the Occurrence list.</td>
</tr>
<tr>
<td>Maximum</td>
<td>Maximum occurrence of an activity. This field appears only when <strong>Range</strong> is selected from the Occurrence list.</td>
</tr>
</tbody>
</table>

4. Submit or update the pattern element.

- Click **Submit** if you created a new pattern element.
- Click **Update** if you modified an existing pattern element.

**What to do next**
Configure pattern element groups for Self-Service Analytics.
Configure pattern element groups for Self-Service Analytics

Define a logical combination of two pattern elements, pattern element group, or both and how many times the combination occurs. Each pattern element group is implemented as regular expressions.

Before you begin
Configure pattern elements for Self-Service Analytics.

Role required: self_service_manager

About this task
By default, the system includes pattern element groups for analyzing activity patterns within the Knowledge, Catalog, Communities, and Virtual Agent self-service channels.

Procedure

1. Navigate to Self-Service Analytics > Configuration > Pattern Element Group.

2. Either configure an existing group or create a new group.
   - Select an existing group in the Pattern Element Groups list.
   - Create a new group by clicking New.

3. On the Pattern Element Group form, fill in the fields.

Pattern Element Group form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to identify the pattern element group.</td>
</tr>
<tr>
<td>First Element</td>
<td>Conditional regular expression consisting of a pattern element or pattern element group.</td>
</tr>
<tr>
<td>Second Element</td>
<td>Another conditional regular expression consisting of a pattern element or pattern element group.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of the application that contains the user entity. This field is automatically set based on the application scope selected in the application picker.</td>
</tr>
<tr>
<td>Operator</td>
<td>Logical operator that returns the result of the combination of the first and second elements. Valid values are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>And</strong>: Both the first and second elements are true.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Or</strong>: Either the first or second element is true.</td>
</tr>
</tbody>
</table>
### Field | Description
---|---
Occurrence | Frequency with which a pattern element or pattern element group must occur. An occurrence is one of the following types:  
• **Once**: Must have occurred only once.  
• **Optionally Once**: Might not have occurred but if it has, then it has occurred only once.  
• **Optionally Many**: Might not have occurred but if it has, then it has occurred multiple times.  
• **At Least Once**: Has occurred at least once.  
• **Range**: Has occurred within a range. You specify a range using the Minimum and Maximum fields.
Minimum | Minimum occurrence of the result of the logical combination of the first and second elements. This field appears only when Occurrence is set to Range.
Maximum | Maximum occurrence of the result of the logical combination of the first and second elements. This field appears only when Occurrence is set to Range.

4. Save the pattern element group settings.  
   • Save a new pattern element group by clicking **Submit**.  
   • Save the changes to an existing pattern element group by clicking **Update**.

**What to do next**  
Configure activity patterns for Self-Service Analytics.

**Configure activity patterns for Self-Service Analytics**

Configure an activity pattern to combine the pattern element, pattern element group, or both for a user entity and link them to an outcome.

**Before you begin**  
Configure pattern element groups for Self-Service Analytics.

Role required: self_service_manager

**About this task**  
By default, the system includes activity patterns for the activities Consumer created a case and Customer created a case.
Procedure

1. Navigate to Self-Service Analytics > Configuration > Activity Pattern.

2. Either configure an existing activity pattern for your user entity or create a new one.
   - Select an existing activity pattern in the Activity Patterns list.
   - Create a new activity pattern by clicking New.

3. On the Activity Pattern form, verify the default field values for an existing activity pattern or fill in the values for a custom configuration.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to identify the activity pattern.</td>
</tr>
<tr>
<td>Description</td>
<td>Summary of the activity pattern.</td>
</tr>
<tr>
<td>Primary Activity</td>
<td>Activity to be tracked in the activity sequence after a pattern matches with an outcome using the pattern recognition. An activity sequence is a stream of activities a user performs.</td>
</tr>
<tr>
<td>Outcome</td>
<td>Result of an activity pattern.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of the application that contains the user entity. This field is automatically set based on the application scope selected in the application picker.</td>
</tr>
<tr>
<td>Match If</td>
<td>Pattern recognition using the Match If function to associate the pattern with an outcome. For example, you can indicate that if the activity Consumer created a case is not found, you want to match it with the Confirmed Deflection outcome.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain in which the activities records exist.</td>
</tr>
</tbody>
</table>

4. Click Submit and then select the newly created activity pattern link from the Activity Patterns list.

5. In the Elements related list, select elements to map with the primary activity and use the Order column to decide the order of each element mapping.
   - To use an existing element, select an element, modify the fields and click Update.
   - To create another pattern element or pattern element group, click New and select the type of element, fill in the fields on the form, and then click Submit.
An element can be a pattern element or pattern element group. For more information, see Configure pattern elements for Self-Service Analytics and Configure pattern element groups for Self-Service Analytics.

In the **Order** column, the following conditions apply:

- If there is only one matching table map, the system uses that map.
- If there are multiple matching table maps with the same order, the system uses the map with the older created date.
- If there are multiple matching table maps with different orders, the system uses the map with the highest order.

6. On the Activity Pattern form, click **Update**.

**What to do next**

Set up the deflection configuration for Self-Service Analytics.

**Set up the deflection configuration for Self-Service Analytics**

Associate a period of time with an activity context that defines how long a system will wait for a case to be created to match a deflection pattern.

**Before you begin**

Configure activity patterns for Self-Service Analytics.

Role required: self_service_manager

**Procedure**

1. Navigate to **Self-Service Analytics > Configuration > Deflection Configuration**.
2. In the Deflection Configurations list, search for and select the deflection configuration for your activity context.
   - For customer contacts, select **Contact Case Deflection Configuration**.
   - For consumers, select **Consumer Case Deflection Configuration**.
   - For user entities other than consumers and customer contacts, click **New** to create another deflection configuration or modify an existing configuration.
3. On the Deflection Configuration form, verify the default field values for an existing configuration or fill in the values for a custom configuration.

### Deflection Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for your deflection configuration.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------------------------</td>
</tr>
<tr>
<td>Activity Context</td>
<td>Type of activities for which you want to collect data. For more information, see <a href="#">Configure activity contexts for Self-Service Analytics</a>.</td>
</tr>
<tr>
<td>Description</td>
<td>Summary of the configuration.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of the application that contains the user entity. This field is automatically set based on the application scope selected in the application picker.</td>
</tr>
</tbody>
</table>
| Window            | Activity context window (duration) for tracking activities that match a deflection pattern.  
Example: To track the create case activity for a consumer within a day, set the window as 1 day.  
- If the consumer created a case within that window, the deflection pattern matched is not a deflection.  
- If the consumer did not create a case within that window, the deflection pattern matched is a potential deflection.  
- If the consumer did not create a case and the last activity is submitted positive feedback for any self-service channel content within that window, the deflection pattern matched is a confirmed deflection. |

4. In the Deflection Patterns related list, add or modify existing deflection patterns to associate them with the deflection configuration or add a new pattern.  
This related list appears only if a deflection configuration exists.

5. In the Deflection Metrics related list, add or modify an existing deflection metric table that stores the deflection data for an activity pattern associated with a deflection type.  
This related list appears only if a deflection configuration exists. Alternatively, you can also configure a deflection metric table by navigating to [Self-Service Analytics > Deflection Metric](#).

6. On the Deflection Configuration form, click **Update**.

**What to do next**

Configure scheduled jobs for Self-Service Analytics.
Configure scheduled jobs for Self-Service Analytics

Schedule when to run the deflection configuration to generate the activities that match an activity pattern within an activity window.

Before you begin
Set up the deflection configuration for Self-Service Analytics.
Role required: admin

About this task
You configure the duration of processing the deflection configuration for a user entity. This configuration is optional for consumers and customer contacts. The scheduled job captures data for Self-Service Analytics and stores the generated data in the Deflection Metric [ssa_deflection_metric] table.

Procedure
1. Navigate to System Definition > Scheduled Jobs.
2. Configure the scheduled script processed for a user entity in a scheduled job.
   - For consumers, select Deflection Analytics for Consumers.
   - For customer contacts, select Deflection Analytics for Contacts.
   - For user entities other than consumers and customer contacts, click New and select Automatically run a script of your choosing to create another scheduled job or modify an existing schedule job.
3. On the Scheduled Script Execution form, verify the default field values for consumers and customer contacts or fill in the values for a custom configuration.

Scheduled Script Execution form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to identify the scheduled script execution.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the script at the scheduled date and time. By default the job is inactive.</td>
</tr>
<tr>
<td>Run</td>
<td>Type of schedule to execute the script on. Choices are:</td>
</tr>
<tr>
<td></td>
<td>• Daily</td>
</tr>
<tr>
<td></td>
<td>• Weekly</td>
</tr>
<tr>
<td></td>
<td>• Monthly</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• Periodically</td>
</tr>
<tr>
<td></td>
<td>• Once</td>
</tr>
<tr>
<td>Day</td>
<td>• If you select <strong>Weekly</strong> as the <strong>Run</strong> value, the day of the week.</td>
</tr>
<tr>
<td></td>
<td>• If you select <strong>Monthly</strong> as the <strong>Run</strong> value, the day of the month.</td>
</tr>
<tr>
<td>Repeat Interval</td>
<td>If you select <strong>Periodically</strong> as the <strong>Run</strong> value, the duration</td>
</tr>
<tr>
<td></td>
<td>between each script execution.</td>
</tr>
</tbody>
</table>

**Note:** This setting does not account for Daylight Savings Time changes. For example, if you select a period of one day, this adds 24 hours to the starting time of the job. If the start time was configured during a period with Daylight Savings Time, the job executes with a one hour offset on days when that time zone is not in Daylight Savings Time.

| Time        | If you select **Daily**, **Weekly**, or **Monthly** as the **Run** value, the |
|            | time of day, based on a 24-hour clock.                                      |
| Starting    | Date and time of the first scheduled script execution.                      |
| Application | Application that contains the script.                                       |
| Conditional | Option to run a scheduled job if certain conditions are met in the          |
|             | associated script.                                                         |
| Condition   | Conditional script that determines whether a scheduled job must run. The    |
|             | last expression of the script should evaluate to a Boolean (true or false)  |
|             | value. This field appears only when the **Condition** check box is selected.|
| Run this    | Script to run at the scheduled date and time.                               |
| script      | For a new scheduled script, copy the script from the existing script (Deflection Analytics for Consumers or Deflection Analytics for Contacts) and modify the `deflectionAnalyticsService.captureDeflectionAnalytics('sys_ID')` field value to include the `sys_id` of your deflection configuration record. For information about identifying the `sys_id`, see [The unique record identifier (sys_id)](https:// servicenow .com/). |

4. Click **Update** for consumers and customer contacts or **Submit** to save a custom configuration.
Translation management

Translation management enables you to manage translation tasks created for published knowledge articles. You can manage multi-language knowledge bases by using automated translation tasks and translation APIs. You can also configure required languages for a knowledge base and ensure users can create articles only in the configured languages.

You can choose a default language when you log in to an instance. The list of languages are listed based on the internationalization language plugins you have installed.

The translation management feature enables you to perform the following translation activities:

• Translate published knowledge articles that are missing translations manually or use the machine translation option to automatically translate them
• Create translation tasks automatically for the languages you have specified
• Configure assignment rules and auto-assign tasks for a language, knowledge base, or category to a translator or a group of translators

The translation management feature is available only if you have installed required plugins and set a system property.

The required plugins are:

• Knowledge Management Advanced plugin
• I18N:Knowledge Management Internationalization Plugin v2 or Internationalization language plugins

Enable the glide.knowman.translation.enable_translation_task property for using the translation management feature which displays the following menu options:

• All Open Tasks
• My Assigned Tasks
• Translator Mapping

Related information

Translate a knowledge article
I18N - Knowledge internationalization
Activate the knowledge management internationalization plugin
Enable languages for a knowledge base

You can select the languages you want enabled at a knowledge base level. Users can then create articles only for selected languages.

Before you begin
Role required: knowledge_admin or admin

Procedure
1. Navigate to Knowledge > Administration > Knowledge Bases.
2. Click New to create a knowledge base or select an existing knowledge base.
3. Click the lock icon to unlock the Languages field.
4. Select the languages from the list.

   Note:
   You can also remove languages from the list if you decide that you do not want to create a translation task in that language.

5. Click Submit or Update.

Create translation assignments

Assign knowledge articles to language experts to ensure accurate translations. Identify the language experts and create assignment rules to automatically assign translation tasks to language experts and groups.

Before you begin
Role required: knowledge_admin or admin

About this task
Assignment rules are applied only if the task is not already assigned to another user or group.

Procedure
1. Navigate to Knowledge > Translation Management > Translator Mapping.
2. Click New to create a new assignment rule or select an existing rule to modify.
3. Enter a name for the assignment rule in the Name field.
4. In the Applies To tab, perform the following.
a. Select a table from the Table dropdown for example, Knowledge Translation Task [kb_translation_task].

b. Specify the conditions that must be met before the task is assigned to the user or group.

5. Click the Assign To tab and select the user or group you want to assign the task to.
   An email notification is sent to the translator with a link to the translation task and source article.

6. Click the Script tab to enter a script to further customize the assignment rule.

7. Click Submit.

   Note: To cancel a task, add an appropriate reason for cancellation in the Cancellation notes field and click Cancel.

Auto-create translation tasks

Manage multi-language knowledge bases by using automated translation tasks and translation APIs. Translate published knowledge articles in languages configured for the knowledge base containing the articles.

Before you begin
Role required: knowledge_admin or admin

About this task
You can auto-create translation tasks in specified languages. The available languages are determined by the language plugins that have been installed on your instance.

Procedure
1. Navigate to Knowledge > Administration > Knowledge Bases.

2. Click New and fill out the Knowledge Base form to create a knowledge base or select an existing knowledge base.

3. Unlock the Languages field and select the languages for which you want to create tasks from the dropdown.

   Note: Unlocking the Languages field displays the languages you have installed.

   If Auto-create translation tasks is not selected, you would have to create the tasks manually after the article is published.
5. Click **Submit** or **Update**.

**Note:**
- Open a knowledge article and click **Knowledge Translation Tasks** related list to view the associated translation tasks.
- To cancel a task, add an appropriate reason for cancellation in the **Cancellation notes** field and click **Cancel**.

**Translate a knowledge article**

You can start translating articles once they are published and assigned to you for translation.

**Before you begin**

Role required: admin, knowledge_admin, or knowledge admin

**Procedure**

1. Navigate to **Knowledge > Translation Management > My Assigned Tasks**.

2. In the Knowledge Translation Tasks page, select one of the listed translation tasks assigned to you.

3. Click **Translate**.

**Note:** If you want to do a translation directly from an article, use the **Translate** related link on the article page.

The **Translate from** and **Translate to** panes are side-by-side for easy viewing, as shown in the following figure.
4. Click **Machine translate**, which automatically translates to the targeted languages.

   **Note:** A default translator configuration should be available. For information about how admins configure the translation API, see **Dynamic Translation**.

5. Click **Create draft article** to create a draft version of the translated article. If a translated article is already present for that language, a new draft version overwrites the existing translated content.

6. Click **Publish**. The newly created draft is listed in the **Translated Versions** tab.

**Translate knowledge blocks within an article**

If a selected article indicates that a knowledge block is missing a translation, you must translate the knowledge block before you can translate the article.

**Before you begin**

Role required: translator

**Procedure**

1. Navigate to **Knowledge > Translation Management > My Assigned Tasks**.

2. In the Knowledge Translation Task page, select a translation task and click **Translate**.

   **Note:** A message stating that the knowledge article contains one or more knowledge blocks that have missing translations is displayed.

3. Click on the link in the message to view the list of blocks that require translation.

4. Click the block that requires translation and click **Translate**. The newly translated blocks appears in the **Translated Block Versions** related list.

**Related information**

- Add knowledge blocks to a knowledge article

**Request missing translations for available languages**

If a translation task does not have tasks created for all the languages you have configured, you can manually create tasks for the missing languages.
Before you begin
Role required: admin
Verify that the glide.knowman.translation.enable_translation_task property is set to true.

Procedure
1. Navigate to Knowledge > Articles > Published.
2. Select an article from the list of published articles.
3. Click Request translations in Related Links.
4. Select the languages from the list that are unselected and do not have associated translation tasks.
5. Click Submit.

Note: If a task is already open for a particular language, you cannot select the same language again.

The translation tasks for the languages are created and listed in the Knowledge Translation Tasks tab.

Now Mobile for Knowledge Management
Access knowledge articles from anywhere using the Information applet on the Now Mobile app. You can view recently viewed and most popular articles, search for articles, browse articles by category, and provide feedback for articles.

To access articles from the Information applet on the Now Mobile app, you must first download the ServiceNow mobile application on an iOS platform from the Apple App Store or on an Android platform from the Google Play Store.
Make sure your administrator has activated the Now Mobile app. For more information, see Now Mobile app.

After you access an article, you can view the author, published date, number of views, and the overall rating details of the article. In addition, you can respond to and evaluate articles and view related items, related articles, and attachments.

**Activation information**

The Information applet is available on the Now Mobile app. The ServiceNow Mobile Request - Knowledge Management Screens and Applet Launcher plugin (com.glideapp.knowledge.mobile_requestor) activates the Information applet. The Information applet is activated by default for both new and upgrade customers.

**Related information**

- Configure knowledge bases
- Now Mobile app
View the most popular or recently viewed articles in the Now Mobile Information applet

View an article in the Now Mobile Information applet

Provide feedback for a knowledge article in the Now Mobile Information applet

**View the most popular or recently viewed articles in the Now Mobile Information applet**

The Information applet on the Now Mobile app enables you to access knowledge articles from a mobile device.

**Before you begin**
You can specify user criteria for an article to control which users can read the article. If no user criteria is defined for an article, all users can read the article.

**Procedure**
1. Access your instance using the mobile application.
2. On the Now Mobile app, tap **Information**.
3. Access your recently viewed or the most popular knowledge articles

<table>
<thead>
<tr>
<th>Information applet article views</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recently Viewed</td>
<td>Up to five of the articles you viewed within the last 30 days.</td>
</tr>
<tr>
<td>Popular</td>
<td>Up to five of the most popular knowledge articles. The Now Mobile app homepage includes a similar section that displays up to three of the most popular articles.</td>
</tr>
</tbody>
</table>

**Note:** Tap **See All** to view the complete list of articles within the selected section.
Related information

- Browse articles in the Now Mobile Information applet
- Search for an article in the Now Mobile Information applet
- Control access at the knowledge article level through user criteria

**Browse articles in the Now Mobile Information applet**

You can browse articles within a category in the Now Mobile Information applet to see articles related to a particular subject or grouping.

**Before you begin**

You can specify user criteria for an article to control which users can read the article. If no user criteria is defined for an article, all users can read the article.

**Procedure**

1. Access your instance using the mobile application.
2. On the Now Mobile app, tap **Information**.
3. In the Browse section, tap a category from the categories list to view articles and child categories associated with the selected category.

   ✉️ **Note:** Tap **See All** to view the complete categories list.

4. Tap further categories until you view the articles list associated with the desired category.
   The articles associated with a parent category are grouped under a dummy child category labeled as **Other**.

5. To view an article, tap the article in the articles list.

**Related information**

- View an article in the Now Mobile Information applet
- Control access at the knowledge article level through user criteria
Search for an article in the Now Mobile Information applet

You can search for an article in the Now Mobile Information applet.

Before you begin

You can specify user criteria for an article to control which users can read the article. If no user criteria is defined for an article, all users can read the article.

Procedure

1. On the Now Mobile app, tap Information.

2. Tap Search for Services, Articles or People, and enter a search term related to the article.

3. Tap the search icon on your app keyboard.
   The app displays search results.

4. Tap Articles to view only articles in the search results.

5. Tap an article in the search results to view the article content.

Related information

View an article in the Now Mobile Information applet

Control access at the knowledge article level through user criteria

View an article in the Now Mobile Information applet

You can view the author, published date, number of views, and the overall rating details of the article in the Now Mobile Information applet. In addition, you can respond to and evaluate articles and view related items and related articles.

Before you begin

You can specify user criteria for an article to control which users can read the article. If no user criteria is defined for an article, all users can read the article.

Procedure

1. On the Now Mobile app, tap Information.

2. Search for or select the desired article from the sections available in the Information applet.
   The article page displays the content and associated information for the selected article such as author, published date, number of views, and the overall rating. The page also displays the following sections:
<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related Articles</td>
<td>Up to five related articles that are manually mapped, automatically predicted, or both. The manually mapped articles appear first in the Related Articles section. This section appears only when related articles are available for the selected article.</td>
</tr>
<tr>
<td>Related Items</td>
<td>Up to five related items that are manually mapped. This section appears only when related items are available for the selected article.</td>
</tr>
<tr>
<td>Attachments</td>
<td>Files attached to an article. This section appears only when the attachments are available for the selected article. To view a file, tap the file name. If an article contains more than two attachments, tap the number of attachments indicator and then tap the file name.</td>
</tr>
</tbody>
</table>

**Note:** Tap **See All** to view the complete list of articles within the Related Articles or Related Items section.

**3. Optional:** Respond to and evaluate the article.

**Related information**

Provide feedback for a knowledge article in the Now Mobile Information applet

Control access at the knowledge article level through user criteria

**Provide feedback for a knowledge article in the Now Mobile Information applet**

You can contribute to feedback on knowledge articles by rating an article, marking an article as helpful or not helpful, and posting and replying to comments for an article in the Now Mobile Information applet.
**Before you begin**

You can specify user criteria for an article to control which users can read the article. If no user criteria is defined for an article, all users can read the article.

**Procedure**

1. On the Now Mobile app, tap **Information**.
2. Select the desired article.
3. Contribute to the article feedback by rating it, marking it as helpful or not helpful, or leaving a comment.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate the article</td>
<td>Tap the star icons displayed on the article to indicate its effectiveness on a scale of 1 to 5. For ratings between 1 to 3 stars, a feedback task is automatically created for the article and assigned to the author or ownership group, as configured.</td>
</tr>
<tr>
<td>Mark an article as helpful or unhelpful</td>
<td>Tap the helpful icon (👍) or the not helpful icon (👎).</td>
</tr>
<tr>
<td>Enter your comment</td>
<td>Enter a comment in the <strong>Type your comment here</strong> box and tap <strong>Submit</strong>.</td>
</tr>
<tr>
<td>View all comments and replies posted for the article</td>
<td>Scroll down to the Comments section.</td>
</tr>
<tr>
<td>Like a comment on the article</td>
<td>Underneath a comment, tap the like icon (👍).</td>
</tr>
<tr>
<td>Reply to a comment on the article</td>
<td>Underneath a comment, tap the reply icon (💬), enter your comment in the text box that appears, and then tap <strong>Submit</strong>.</td>
</tr>
<tr>
<td>Delete any previous comments or replies you posted earlier</td>
<td>Go to a comment or reply, and then tap the delete icon (🗑️). If a message appears, tap <strong>OK</strong>. Only users who have posted the comment, knowledge administrators, and knowledge owners can delete a comment.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>View an attachment to a comment</td>
<td>View files, if available, attached to a comment. To view a file, tap the file name. If a comment contains more than two attachments, tap the number of attachments indicator and then tap the file name.</td>
</tr>
</tbody>
</table>

**Related information**

- View an article in the Now Mobile Information applet
- Control access at the knowledge article level through user criteria

**Migrate to Knowledge Management v3**

Knowledge Management has significantly changed with the introduction of knowledge v3 starting with the Fuji release.

Knowledge Management v3 has several key differences from Knowledge Management v2, the version of Knowledge Management that was available until Eureka release. The knowledge v3 plugin is activated by default starting with the Fuji release.

The following podcast provides more information on what is new in Knowledge Management v3.

**Episode 26: Knowledge Management Version 3**

When upgrading from Eureka or earlier versions, if you intend to use the new features available in knowledge v3, you have to migrate legacy knowledge content and any customizations you have made to the Knowledge Base applications.

The following video provides more information on how to migrate from Knowledge Management v2 to v3.

**Migrating from Knowledge Management v2 to v3**

**Key differences**

<table>
<thead>
<tr>
<th>Legacy Knowledge</th>
<th>Knowledge v3</th>
</tr>
</thead>
<tbody>
<tr>
<td>One knowledge base.</td>
<td>Multiple knowledge bases.</td>
</tr>
<tr>
<td>A single lifecycle workflow shared by all articles.</td>
<td>Separate, customizable workflows available for each knowledge base.</td>
</tr>
</tbody>
</table>
# Key differences (continued)

<table>
<thead>
<tr>
<th>Legacy Knowledge</th>
<th>Knowledge v3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two-level organizational structure with <strong>Topic</strong> and <strong>Category</strong>. A single</td>
<td>Category structure with any number of levels. Each knowledge base has</td>
</tr>
<tr>
<td>organizational taxonomy shared by all articles.</td>
<td>a unique category taxonomy.</td>
</tr>
<tr>
<td>Permissions defined per article using roles and ACLs.</td>
<td>Permissions defined per knowledge base or article using user criteria.</td>
</tr>
</tbody>
</table>

## Knowledge Management v3 migration process

When you upgrade from Eureka or earlier, consider a multi-step migration process. This process ensures you can access existing knowledge content and allows you to fully migrate at your own pace.

Review automatic changes before upgrading. These changes are applied immediately when upgrading and may impact existing functionality.

1. Migrate knowledge functionality to use your customized functionality with the Knowledge Management v3 enhancements.
2. Migrate knowledge content to use the Knowledge Management v3 enhancements with your existing knowledge articles.

## After migration to Knowledge Management v3

These items are relevant to getting the full range of new functionality after you migrate.

- You must configure knowledge access controls based on user criteria to ensure that users can access existing knowledge content. Since access control in knowledge v3 is intended to be based on user criteria alone, users may be unable to access v2 or v3 knowledge articles, or have restricted access, with preexisting ACLs.
- If the home page was customized in knowledge v2, custom layout and links are not saved in knowledge v3.
- Images added using the **Image** field in a knowledge article form do not display in the Knowledge v3 or Knowledge Service Portal pages. The article search results page displays the knowledge base icon next to all articles from the knowledge base.
Automatic changes after Knowledge Management v3 migration

Upgrading to Knowledge Management v3 automatically changes knowledge functionality including the knowledge user interface and security model.

Default knowledge base

When you upgrade from Eureka or earlier, a default knowledge base is created, titled Knowledge, that contains all knowledge articles from the previous version.

After the upgrade, you can add and edit articles in this knowledge base.

Articles in the default knowledge base continue to use legacy functionality, such as role-based access controls. Any customizations you made to knowledge functionality before the upgrade are preserved in the default knowledge base.

Knowledge search changes

By default, the legacy knowledge portal uses knowledge v3 search with limited filtering options.

You can filter results only by knowledge base. Search results include only those articles the current user can view based on user criteria. ACLs do not restrict search results.

Knowledge security changes

Knowledge v3 manages access to articles with user criteria rather than roles and ACLs.

Existing ACLs on the Knowledge [kb_knowledge] table are preserved, but with the following changes.

• A version of 3 indicates that a knowledge base uses the knowledge v3 functionality.
• A version of 2 indicates that a knowledge base uses legacy functionality.

New ACLs introduced by knowledge v3, such as field-level controls, apply to all knowledge bases.

When you upgrade from Eureka or earlier, any custom ACLs you implemented for the Knowledge table still apply to any knowledge records in the default knowledge base. Knowledge v3 updates ACLs that exist before upgrade so they only apply to Knowledge [kb_knowledge] records where this field value is 2.
Note: These changes affect the default knowledge base. Even if you are not using the new knowledge functionality, the legacy knowledge behavior may change if you have made customizations to ACLs on the Knowledge [kb_knowledge] table. Ensure you configure knowledge access controls after upgrading to prevent unexpected behavior.

To control access to knowledge articles, try to use user criteria, which were introduced in Knowledge Management v3. For more information, see Managing access to knowledge bases and knowledge articles.

Knowledge article view changes
The Knowledge application uses the kb_view UI page to display knowledge articles.

UI page
The following changes apply automatically when you upgrade from Eureka or earlier:

• The existing kb_view page is renamed to kb_view_customer. The kb_view_customer page is used to display articles in the default knowledge base, preserving the legacy user experience.

  Note: By default, the kb_view_customer page is publicly accessible. As an administrator, you can change this behavior by modifying the sys_public table record for this page and clearing the Active field in the record.

• A new kb_view page is used. This becomes the primary page used to display articles that are not in the default knowledge base.

You should review all customizations introduced around the legacy kb_view UI page.

• URLs should not be updated as the new kb_view page redirects to the correct page depending on the article.

• Customizations made to the kb_view UI page are automatically copied to the kb_view_customer page on upgrade.

• Other customizations that affect kb_view may need to be copied or modified to apply to kb_view_customer. For example, an ACL defined for kb_view may need to be duplicated to provide security coverage for kb_view_customer.

Feedback
Legacy feedback functionality is retained for knowledge articles displayed in the legacy article view. Users can continue to use the feedback options to view,
add, and reply to comments on these legacy articles. Legacy comments are retained in the Knowledge Feedback [kb_feedback] table.

To retain the legacy comment functionality with new knowledge articles, set the Use Live Feed for Knowledge feedback property (glide.knowman.use_live_feed) to false. This property is set to false by default.

**Related information**

Make UI pages public or private

**Knowledge portal changes**

While the legacy knowledge portal, kb_home, has not changed in Knowledge v3, we strongly recommend that you consider moving to the new Knowledge v3 home page, $knowledge.do.

**UI page**

You can search articles from the knowledge portal and filter search results by knowledge base, and by language if the instance uses knowledge management internationalization. This portal also appears for users on older browsers, such as Internet Explorer 9, instead of the knowledge homepage.

Navigation add-ons are available in the legacy knowledge portal. Navigation add-ons of the Link type appear in the top-right of the portal. To add navigation add-ons of the Search type, you must customize the kb_home UI page.

**Search**

By default, the legacy knowledge portal uses knowledge v3 search with limited filtering options. You can filter results only by knowledge base. Search results include only those articles the current user can view.

**Knowledge submissions**

Knowledge submissions created from tasks continue to work in knowledge v3 with minor changes.

By default, the Topic and Category fields no longer appear on the Submission form due to the knowledge v3 category changes.

The property glide.knowman.submission.workflow no longer appears on the knowledge properties UI page. To enable knowledge submissions, set this property to true on the System Properties [sys_properties] table.

See creating knowledge from incidents and problems for instructions on using knowledge submission in knowledge v3.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Migrating Knowledge access controls

Access to knowledge articles is controlled based on the user criteria for the knowledge base.

**Important:** If you do not migrate existing knowledge ACLs to user criteria, users may be unable to access knowledge articles, or may be able to access restricted articles.

User criteria records, rather than ACLs, control basic create, read, update, and delete operations for knowledge articles as well as which search results appear. This may lead to unexpected behavior if your configuration depends on ACLs to control access.

To ensure users are able to access the correct knowledge articles, migrate any ACL-based security settings to user criteria. This process may include creating additional knowledge bases and moving existing content to these knowledge bases, depending on your security model. For a detailed explanation and migration examples, refer to KB0550924 Understanding User Criteria and ACLs in Knowledge v3.

This video demonstrates how to manage article-level access controls during migration from Knowledge Management v2 to v3.

Managing Article-Level Access Controls During Migration from KM v2 to v3

**Related reference**

Knowledge functionality migration

**Knowledge functionality migration**

You can migrate knowledge functionality to use your customized functionality with the knowledge v3 enhancements.

**Replaced knowledge modules**

When you are ready to migrate to knowledge v3, you can activate the v3 modules and deactivate the legacy modules.

Use the tables below to identify which knowledge v3 modules to activate and which legacy modules to deactivate. When activating a knowledge v3 module, deactivate the knowledge v2 module with the same name to ensure users access the correct module.

You can use the `enablev3anddisablev2menus.txt` backup script to enable knowledge v3 menus and disable knowledge v2 menus.
### Knowledge v3 modules

<table>
<thead>
<tr>
<th>Title</th>
<th>Order</th>
<th>Link type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Homepage</td>
<td>100</td>
<td>URL (from Arguments:)</td>
</tr>
<tr>
<td>Articles</td>
<td>200</td>
<td>Separator</td>
</tr>
<tr>
<td>Create New</td>
<td>300</td>
<td>New Record</td>
</tr>
<tr>
<td>Unpublished</td>
<td>400</td>
<td>List of Records</td>
</tr>
<tr>
<td>Published</td>
<td>500</td>
<td>List of Records</td>
</tr>
<tr>
<td>Retired</td>
<td>600</td>
<td>List of Records</td>
</tr>
<tr>
<td>Flagged</td>
<td>800</td>
<td>List of Records</td>
</tr>
<tr>
<td>All</td>
<td>900</td>
<td>List of Records</td>
</tr>
<tr>
<td>Open Submissions</td>
<td>960</td>
<td>List of Records</td>
</tr>
<tr>
<td>Administration</td>
<td>1000</td>
<td>Separator</td>
</tr>
<tr>
<td>Knowledge Bases</td>
<td>1100</td>
<td>List of Records</td>
</tr>
<tr>
<td>Feedback</td>
<td>1300</td>
<td>List of Records</td>
</tr>
<tr>
<td>Ratings</td>
<td>1500</td>
<td>List of Records</td>
</tr>
<tr>
<td>Search Log</td>
<td>1600</td>
<td>List of Records</td>
</tr>
<tr>
<td>Navigation Add-ons</td>
<td>1700</td>
<td>List of Records</td>
</tr>
<tr>
<td>Messages</td>
<td>1800</td>
<td>List of Records</td>
</tr>
<tr>
<td>Properties</td>
<td>1900</td>
<td>URL (from Arguments:)</td>
</tr>
<tr>
<td>Overview</td>
<td>2000</td>
<td>URL (from Arguments:)</td>
</tr>
<tr>
<td>User Criteria</td>
<td>2100</td>
<td>List of Records</td>
</tr>
</tbody>
</table>

### Legacy modules

<table>
<thead>
<tr>
<th>Title</th>
<th>Order</th>
<th>Link type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create New</td>
<td>100</td>
<td>New Record</td>
</tr>
<tr>
<td>Published</td>
<td>190</td>
<td>List of Records</td>
</tr>
<tr>
<td>Edit</td>
<td>200</td>
<td>List of Records</td>
</tr>
<tr>
<td>Retired</td>
<td>240</td>
<td>List of Records</td>
</tr>
</tbody>
</table>
Knowledge article publish and retire workflows

With knowledge v3, article state is controlled by workflows.

In the legacy knowledge base, article state was controlled by UI actions. UI actions from previous versions are available only in the default knowledge base.

To preserve your article publishing and retirement process in new knowledge bases, create workflows that follow these processes. To create these workflows, copy the default workflow that best matches your process and modify that copy. After creating workflows that use your article publishing and retirement processes, use these workflows as the Publish workflow and Retire workflow for the new knowledge bases.

Knowledge article category structure

With knowledge v3, all knowledge articles are organized by category and subcategory within knowledge bases.
The default knowledge base uses the legacy category structure; knowledge articles are organized by topics and categories.

Before you migrate articles, create a category structure for these articles in the destination knowledge bases. This structure can reproduce your legacy topic and category structure or can be extended to take advantage of the knowledge v3 category functionality.

### Knowledge content migration

To use the new functionality available in knowledge v3 with legacy articles, you must migrate these articles out of the default knowledge base.

To migrate knowledge content, move articles out of the default knowledge base by changing the **Knowledge Base** value for each article. The state of the article remains unchanged when moving articles. After selecting a new knowledge base, assign a category to each article using the category structure defined in the new knowledge base.

After you migrate a knowledge article, the legacy feedback functionality is automatically replaced with the new knowledge feedback mechanisms. Legacy feedback is copied to the Live Feed Message [live_message] table to ensure previously submitted feedback is available for knowledge v3 articles.

### Legacy: Chat

Chat is deprecated in the Istanbul release.

> **Note:** The **Connect** feature provides an updated instant messaging platform, which is activated by default for new instances. The legacy chat and Connect features should not be used concurrently. There is no migration path from legacy chat to Connect.

Chat a provides real-time communication via instant messaging between users in a ServiceNow instance. Features include:

- One-to-one chats (instant messaging) between users.
- Chat rooms for conversations with multiple users. Chat rooms may be public (any user can join) or private (only invited users can join).
- Chat rooms linked to task records. Users can work together to solve issues, and conversation history can be shared by everyone who needs to reference it.
- Help desk chat. End users can access live support via instant messaging. Service desk staff can resolve basic issues in real-time or create incidents directly from chat requests for more extensive issues.
Legacy: Get started with Chat

Get started with legacy chat.

Before you begin
Role required: admin

Procedure

1. Establish use guidelines. Social media can improve communication and aid productivity. To get the most out of these tools, establish clear and simple social media guidelines that foster information sharing and a comfortable work environment.

2. Activate the Chat plugin to enable the legacy chat and legacy Help Desk Chat features.

3. Configure security settings. Users must log in to use the legacy chat features in the base system. The standard system security settings and Social IT-specific security settings are available. To learn more about setting up these features, refer to the plugin activation pages.
Chat rooms may be Public (any user can join) or Private (only invited users can join).

Administrators can limit who can read chat messages on tasks and who can create chat rooms.

**Legacy: Installed with Chat**

What components are installed with legacy chat.

Demo data is available for legacy chat. The demo data creates a chat queue called Help Desk Chat that is supported by the assignment group Chat Support. Additionally, the Help Desk Chat link is added to the header of the Employee Self-Service portal. To learn more, see [Set Up Chat Queues for Help Desk Chat](#).

**Other:**

- Event: A new event called `chat.invite` is registered to trigger an email notification when users are invited into a chat room.
- Email Notification: An email notification called Chat Room Invite is added to send when users are invited to a chat room.

**Legacy: Fields installed with legacy chat**

Legacy chat adds fields.

<table>
<thead>
<tr>
<th>Display name [Table name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header [content_block_header]</td>
<td>Adds the Help Desk Chat link to the ESS portal page.</td>
</tr>
</tbody>
</table>

**Legacy: Properties installed with legacy chat**

Legacy chat adds properties.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.chat.invite_fields</td>
<td>Comma-separated list of fields used to generate the invites when creating a chat room from a task. The user is presented with check boxes for each of the specified</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>fields to select the invites for the chat room. The fields should be references or glide_lists of sys_user or sys_user_group.</td>
</tr>
</tbody>
</table>
|                                                        | • **Type**: string  
|                                                        | • **Default value**: assignment_group, watch_list  
|                                                        | • **Location**: Social IT > Chat Administration > Properties                                                                                                                                                |
| glide.chat.show_emoticons                               | Setting that determines whether to display emoticons in conversations.                                                                                                                                       |
|                                                        | • **Type**: true | false  
|                                                        | • **Default value**: true  
|                                                        | • **Location**: Social IT > Chat Administration > Properties                                                                                                                                               |
| glide.chat.sound.message_received.mp3                  | Sound played when a message is received in chat (mp3).                                                                                                                                                     |
|                                                        | • **Type**: string  
|                                                        | • **Default value**: media/rcvmsg.mp3x  
|                                                        | • **Location**: Social IT > Chat Administration > Properties                                                                                                                                               |
| glide.chat.sound.message_received.ogg                   | Sound played when a message is received in chat (ogg).                                                                                                                                                      |
|                                                        | • **Type**: string  
|                                                        | • **Default value**: media/rcvmsg.oggx  
<p>|                                                        | • <strong>Location</strong>: Social IT &gt; Chat Administration &gt; Properties                                                                                                                                               |
| glide.chat.sound.queue_beep.mp3                        | Sound played when a new user enters the chat queue (mp3). Both this property and glide.chat.sound.queue_beep.ogg must be defined for either property to work.                                               |</p>
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.chat.sound.queue_beep.ogg</td>
<td>Sound played when a new user enters the chat queue (ogg).</td>
</tr>
<tr>
<td>• <strong>Type</strong>: string</td>
<td></td>
</tr>
<tr>
<td>• <strong>Default value</strong>: media/button_toggle_on.mp3x</td>
<td></td>
</tr>
<tr>
<td>• <strong>Location</strong>: Social IT &gt; Chat Administration &gt; Properties</td>
<td></td>
</tr>
<tr>
<td>glide.chat_room.create_roles</td>
<td>Comma-separated list of roles that are allowed to create chat rooms.</td>
</tr>
<tr>
<td>• <strong>Type</strong>: string</td>
<td></td>
</tr>
<tr>
<td>• <strong>Default value</strong>: itil</td>
<td></td>
</tr>
<tr>
<td>• <strong>Location</strong>: Social IT &gt; Chat Administration &gt; Properties</td>
<td></td>
</tr>
<tr>
<td>glide.short_poll_delay</td>
<td>Short polling delay for XMPP requests. Enter a value in milliseconds. The minimum value is 250. With short polling, the browser sends a request to the server in fixed intervals defined by the property. To minimize performance impact, it is recommended that this value is set greater than or equal to the default value.</td>
</tr>
<tr>
<td>• <strong>Type</strong>: integer</td>
<td></td>
</tr>
<tr>
<td>• <strong>Default value</strong>: 1000 (one second)</td>
<td></td>
</tr>
<tr>
<td>• <strong>Location</strong>: Social IT &gt; Chat Administration &gt; Properties</td>
<td></td>
</tr>
</tbody>
</table>
Legacy: Script includes installed with legacy chat
Legacy chat adds script includes.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ChatUtils</td>
<td>Provides utilities for chat conversations.</td>
</tr>
</tbody>
</table>

Legacy: Tables installed with legacy chat
Legacy chat adds tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat Actions [chat_actions]</td>
<td>Defines additional chat window menu items. Access at Social IT &gt; Chat Administration &gt; Actions (administrator and chat_admin).</td>
</tr>
<tr>
<td>Chat Channel [chat_channel]</td>
<td>Stores chat channels, which are chats between members. This table is extended by Chat thread [chat_thread] (a one-to-one chat) and chat_room (a multi-user chat). Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Chat Channel Member [chat_channel_member]</td>
<td>Relationship table that associates channels and members. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Chat Message [chat_message]</td>
<td>Stores instant messages sent from any chat window. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Chat Presence [chat_presence]</td>
<td>Stores presence (status) information for a user. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Chat Queue [chat_queue]</td>
<td>Stores the groups and schedules for providing support via instant message. Defined at Social IT &gt; Chat Administration &gt; Queues (administrator and chat_admin).</td>
</tr>
<tr>
<td>Chat Queue Entry [chat_queue_entry]</td>
<td>Stores user requests for live support. Extends Task [task]. On a chat queue record, the Chat queue entries related list displays the entries that are associated with that chat queue. Extending or modifying data in this table is not recommended.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat Room [chat_room]</td>
<td>Stores chat rooms (multi-user chat). Extends Chat channel [chat_channel]. Can be modified if necessary (such as to change a chat room from public to private), but should almost always be managed by system functionality.</td>
</tr>
<tr>
<td>Chat Roster [chat_roster]</td>
<td>Maintains users that are associated with a user’s My Friends list. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Chat Roster Member [chat_roster_member]</td>
<td>Tracks users that are members of a chat room. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Chat Thread [chat_thread]</td>
<td>Stores one-to-one chats. Extends Chat channel [chat_channel]. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Live Headline [live_headline]</td>
<td>Sends system messages. For example, the system may send a message when a user enters or leaves a chat room. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Live Poll Message [sys_live_message]</td>
<td>System table that stores and manages chat messages. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Live User [sys_live_user]</td>
<td>System table that stores and maintains chat users. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Stores the last live sequence number [sys_live_last_sequence]</td>
<td>Stores the last sequence ID. Extending or modifying data in this table is not recommended.</td>
</tr>
</tbody>
</table>

**Legacy: Business rules installed with legacy chat**

Legacy chat adds business rules.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat Queue</td>
<td>Chat Queue Entry [chat_queue_entry]</td>
<td>Sets the chat queue entry Action field to Waiting when the action changes.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>[Task.active] Updater</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNC - Chat Queue Average Wait Time</td>
<td>Chat Queue Entry [chat_queue_entry]</td>
<td>When a chat queue entry is accepted, calculates the average wait time for the queue by averaging the last 20 chat queue entries.</td>
</tr>
</tbody>
</table>

Legacy: Chat use

Legacy chat allows you to interact and collaborate through real-time instant messages with other users in an instance.

Use legacy chat to:
- Initiate or participate in chat conversations with one or multiple users.
- Initiate or participate in chat conversations that are attached to task records (such as an incident).
- See when other users are available to chat.

To open the chat desktop, navigate to Social IT > Chat.

💡 Note: Service desk staff may also provide live support to other users via help desk chat.
Legacy: Update your profile

Your profile identifies your contributions to legacy chat conversations.

About this task

Your profile identifies your contributions to conversations. It is created automatically the first time you use chat and consists of:

<table>
<thead>
<tr>
<th>Profile</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>From your user account in ServiceNow. Your name appears on your messages and in the member list of any chat room you join.</td>
</tr>
<tr>
<td>Picture</td>
<td>Select any picture. Your picture appears beside your name in other users' favorites list and at the top of your favorites list.</td>
</tr>
</tbody>
</table>

To update your profile picture:
**Procedure**

1. Click your picture in the top of the favorites list.
2. Browse to the desired picture file and click **Open**.

   **Note:** Changes to your profile picture affect legacy chat and live feed if the Live Feed plugin is activated.

### Chat profile picture

![Chat profile picture](image)

**Legacy: Update your status**

In legacy chat, your status lets other users know whether you are available to chat.

**About this task**

Your status lets other users know whether you are available to chat. Your current status is indicated by the color of the icon in the upper right of your favorites list, beside your name. View the status of other users in your favorites list.

To change your status:

**Procedure**

1. Click the status icon beside your name.
2. Select a status (see table).
### Change status

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
<th>Appears to others</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Online</strong></td>
<td>Indicates that you are available to chat.</td>
<td>Green icon:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="Chat available" /></td>
</tr>
<tr>
<td><strong>Away</strong></td>
<td>Indicates that you are not available because you are away.</td>
<td>Red icon:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="Chat away" /></td>
</tr>
<tr>
<td><strong>Away with a message</strong></td>
<td>Indicates that you are not available and gives a reason:</td>
<td>Red icon and message:</td>
</tr>
<tr>
<td></td>
<td>• In a meeting</td>
<td><img src="image" alt="Chat away msg" /></td>
</tr>
<tr>
<td></td>
<td>• On the phone</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Out to lunch</td>
<td></td>
</tr>
<tr>
<td></td>
<td>You cannot create a custom message from the chat desktop.</td>
<td></td>
</tr>
<tr>
<td><strong>Invisible</strong></td>
<td>Indicates that you are not available. You can send and receive messages when your status is <em>Invisible</em>. You appear as <em>Offline</em> to other users.</td>
<td>Black icon:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="Chat offline" /></td>
</tr>
<tr>
<td><strong>Offline</strong></td>
<td>Indicates that you are not available. You cannot send or receive messages when your status is <em>Offline</em>. Users that are not logged in appear as <em>Offline</em>.</td>
<td>Black icon:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="Chat offline" /></td>
</tr>
</tbody>
</table>
Legacy: Use your favorites list

In legacy chat, your favorites list appears on your chat desktop and provides certain functions.

**Favorites list**

### My stuff

- **Users:**
  - Add another user in the system to your favorites list.
  - See if your favorite users are available to chat. Users are organized alphabetically and in sections by status.
  - Start a conversation by double-clicking a name.
  - Expand or collapse a section by clicking **Online** or **Offline**.

- **Rooms:**
  - See the list of your favorite chat rooms.
  - Join a chat room by double-clicking its name.

- **Favorites list toolbar:**
  - Options (Chat window menu)
    - access a menu with options to add a favorite user, view online users, create a chat room, and view chat rooms.
  - Add User (Add friend)
    - add a favorite user.
  - Create Room (Add room)
    - create a chat room.
  - Invitations (}
To expand or collapse a section in the favorites list, click the section header or click the arrows (â†œ) on the section header.

Legacy: Add a favorite user
How to add a user to your favorite users list in legacy chat.

Procedure
1. Click the Add User button.

2. Begin typing a user name and select a user from the list, or click the reference lookup and select a user from the table.

3. Click OK.

Legacy: Remove a favorite user
How to remove a favorite user in legacy chat.

Procedure
To remove a user from your favorite users list, right-click the user's name and select Remove From List.

Legacy: View an online user
How to view a list of all users who are available to chat (status of Online) in legacy chat.
Procedure
1. Right-click the Users section header or click Options on the toolbar.

Chat window menu

2. Select Show Online Users.
   • Start a one-to-one chat with a user on the list by double-clicking a name.
   • Send Message or Add To Friend List by right-clicking a name.

Legacy: View a room
How to view a list of all public chat rooms in legacy chat.

Procedure
1. Right-click the Rooms section header or click Options on the toolbar.

Chat window menu

2. Select Public Rooms.
• To join a room, double-click a name or right-click and select **Join Room.** See **Joining Chat Rooms.**

<table>
<thead>
<tr>
<th>Rooms</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Public Rooms</strong></td>
</tr>
<tr>
<td>Search:</td>
</tr>
<tr>
<td>Chat Room for INC00000047</td>
</tr>
<tr>
<td>Issue with email</td>
</tr>
<tr>
<td>Emergency CAB meeting</td>
</tr>
<tr>
<td>Review change that fixes voicemail error</td>
</tr>
</tbody>
</table>

Showing 2 of 2 matches.

**Legacy: Start a one-to-one chat**

How to start a one-to-one chat in legacy chat.

**Procedure**

- To start a chat with one user in your favorites list, double-click the user's name or right-click and select **Send Message.**
- To start a chat with one available user, double-click the user’s name on the online users list. See **Viewing Online Users.**

Send a message to start a conversation.

**Legacy: Create a chat room**

How to start a chat with multiple users from the legacy chat desktop.

**About this task**

To start a chat with multiple users from the chat desktop (requires access rights):

**Procedure**

1. Click **Create Room** on the favorites list toolbar.
2. Enter the room details (see table).

3. Click **Create Room**. An invitation appears in the favorites list of all invited users and a new chat window opens on your chat desktop.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room name</td>
<td>Enter a name to appear on the chat window header or click the <strong>Generate a unique room name</strong> button (Room name generator) to use a system-generated name. The default name for a room created from a task is Chat Room for &lt;Task Number&gt;.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a room description that appears under the name in the rooms list. The default description for a room created from a task is &lt;Short Description&gt;.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter a password, if desired. If a password is specified, only users with the password can join the chat room.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Room avatar</td>
<td>Upload an image that appears beside the room name in the list of rooms. Click the picture and browse to the desired image file.</td>
</tr>
<tr>
<td>Features</td>
<td>Select all applicable check boxes:</td>
</tr>
<tr>
<td></td>
<td>• Public if all users can see the room in the rooms lists.</td>
</tr>
<tr>
<td></td>
<td>• Members Only if only invited users can join the room.</td>
</tr>
<tr>
<td></td>
<td>• Temporary if the room is not saved once all participants have left. This feature is not available for rooms created from tasks; task chat rooms are always available on the task record.</td>
</tr>
<tr>
<td>Invite</td>
<td>Add invited users by using the glide list. For a room created from a task, you can also select all applicable check boxes:</td>
</tr>
<tr>
<td></td>
<td>• Assignment group: invite all users in the assignment group for the task.</td>
</tr>
<tr>
<td></td>
<td>• Watch list: invite all users on the watch list for the task.</td>
</tr>
</tbody>
</table>

**Legacy: Create a chat room for a task**

How to start a legacy chat with multiple users from a task record.

**About this task**

ℹ️ **Note:** This procedure is not possible if the Connect feature is enabled.

**Procedure**

1. Open the record (example, an incident on which you are working).

2. Click the **Create or Join Chat Room** related link.
3. If a chat room already exists, click a name to join the existing chat room. If no chat room exists, continue to the next step to create a new room.

4. Click the create link at the bottom of the window.

5. Enter the room details as you would for a chat room.

6. Click Create Room. An email notification is sent and appears in the favorites list for all invited users (the assignment group and the watch list, if selected, and additional invited users).

7. In the New Room Created message, click Join Room.
   • A new chat window opens on your chat desktop.
   • All invited users are listed in the chat member list. Invited users that are not currently participating in the chat are listed in gray.

Legacy: Join one-to-one chats
In legacy chat, when another user starts a chat by sending a message to you, a chat window opens on your chat desktop. To join the chat, click the window.

Legacy: Join a chat room
How to join a chat room in legacy chat.

Procedure
1. If another user invites you to join a chat room, an invitation appears in your favorites list.
2. To respond, click the invitation. A window opens that displays the room name, room description, and the name of the user who invited you.

- To join the chat, click Join. When the chat window opens on your chat desktop, click the window.
- To ignore the invitation, click Decline.

View Invitations

To rejoin a favorite chat room that you have left, click the chat room name in the Rooms section of the favorites list.

To join a public chat room without an invitation, right-click the Rooms section header and select Public Rooms. Double-click a room name on the list.

 Legacy: Join a chat room for a task

In legacy chat, if another user invites you to join a chat room from a task record, you receive an email notification.

Procedure
1. Click the link in the email notification.
2. If a prompt for a password appears, enter the password listed in the email notification.
3. When the chat window opens on your chat desktop, click the window.

 Legacy: Join a chat room from a task record without an invitation

How to join a chat room in legacy chat without an invitation.

About this task

Note: This procedure is not possible if the Connect feature is enabled.
Procedure

1. Open the task record.
2. Click the **Create or Join Chat Room** related link.
3. Click a chat room name.
4. If a prompt for a password appears, contact the person who created the chat room for the password.
   
   If a chat room has a password, only users with the password can join the chat.
5. When the chat window opens on your chat desktop, click the window.

Legacy: Chat windows

In legacy chat, a chat window appears on your chat desktop for each chat conversation that you start or join.

Legacy: Send messages in legacy chat

How to send messages in legacy chat.
To chat with other users that have joined the conversation, enter your message in the text field at the bottom of the window and press Enter. The message appears in the other users' chat windows.

To send a link, type the full URL (example, http://www.service-now.com). When the message is sent, the text appears blue and any user in the conversation can click it to follow the link.

To send a smiley face, type a colon followed by a close parentheses (:)'). When the message is sent, a smiley face (😊) appears in place of the text. For more emoticons, see Sending Emoticons in Messages (Smileys).

Chat activity is indicated with the following alerts:

- When a new message is posted to an inactive browser tab, the tab name blinks.
- When a new message is posted to an inactive chat window, the window header appears in yellow and blinks.
- When a user joins or leaves a room, a message appears in the other room members' chat windows.

Legacy: Send emoticons in legacy chat messages (smileys)

How to send emoticons (smileys) in legacy chat.

To send an emoticon (smiley), type text from the following table. When your message is sent, the emoticon appears in place of the text. For example, enter colon followed by a close parentheses (:)') and a smiley face (😊) appears in your message.

<table>
<thead>
<tr>
<th>Emoticons</th>
<th>Text</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smiley</td>
<td>:) :-D</td>
<td>Smiley 😊</td>
</tr>
<tr>
<td>Shades</td>
<td>B) B-) BD B-D</td>
<td>Shades 😎</td>
</tr>
<tr>
<td>Big smile</td>
<td>:D :-D</td>
<td>Big smile 😊</td>
</tr>
<tr>
<td>Kiss</td>
<td>.* :-*</td>
<td>Kiss 😘</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Emoticons (continued)

<table>
<thead>
<tr>
<th>Text</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>:-(</td>
<td>Frown 😞</td>
</tr>
<tr>
<td>&lt;3</td>
<td>Heart ❤</td>
</tr>
<tr>
<td>:-)</td>
<td>Wink 😃</td>
</tr>
<tr>
<td>:P :-P</td>
<td>Playful 😏</td>
</tr>
<tr>
<td>:O :-O</td>
<td>Surprise 😨</td>
</tr>
<tr>
<td>X( X-{</td>
<td>Angry 😞</td>
</tr>
<tr>
<td>;( ;&gt;</td>
<td>Blush 😳</td>
</tr>
<tr>
<td>:(( :{</td>
<td>Crying 😥</td>
</tr>
<tr>
<td>(A)</td>
<td>Halo 😌</td>
</tr>
<tr>
<td>:? :-?</td>
<td>Undecided 😞</td>
</tr>
</tbody>
</table>

#### Legacy: Change the display

How to change the display of legacy chat.

To view the chat window menu, click the gear button (🔧)

**Chat window menu**

🔧
• To show or hide timestamps, select **Show Timestamps** from the chat window menu or press **F2**.

• To show or hide the chat member list, select **Show Members** from the chat window menu or press **F4**.

To resize the window, point to the lower corner (left or right). When the pointer changes shape, drag the window to the desired size.

To move the window, point to the header. When the pointer changes shape, drag the window anywhere on your chat desktop.

To close a chat window, click the **X** in the upper right corner.

**Legacy: Invite a user into a chat**

How to invite another user into a chat in legacy chat.

**Procedure**

1. Select **Invite User** from the chat window menu.

   Chat window menu

   🌐

2. Begin typing a user name and select a user from the list, or click the reference lookup and select a user from the table.

   Search icon

   🔍

3. Click **OK**.

   An invitation is sent to the selected user. One-to-one chats are automatically converted into temporary chat rooms.

**Legacy: Add a favorite room**

How to add a favorite room in legacy chat.

**Procedure**

To add a room to your favorites, click the chat window and select **Add To Favorites** from the chat window menu.
Legacy: Remove a favorite room

How to remove a favorite room in legacy chat.

Procedure

To remove a room from your favorites, right-click the room name and select Remove From List.

Legacy: Set your chat preferences

Use the Chat Window Preferences to set audio notifications and default chat window display options in legacy chat.

Use the Chat Window Preferences to set audio notifications and default chat window display options. The default display options control how a chat window looks when you first open it. You can still control the display options for an individual window as described in Changing the Display.

To view your chat preferences, click your name in the upper left corner of the chat desktop and select Chat Preferences.

![Chat Window Preferences](image)

To set your preferences, select or clear the check boxes next to the options, then click Update.

**Preferences**

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>Turn audio notifications on or off.</td>
</tr>
<tr>
<td>Conversation Windows</td>
<td>Set default options for showing timestamps and members in one-to-one chats.</td>
</tr>
</tbody>
</table>
**Preferences (continued)**

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Chat</td>
<td>Set default options for showing timestamps members in chat rooms.</td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
</tbody>
</table>

**Legacy: Delete a chat room**

You can delete chat rooms in legacy chat.

**Before you begin**
Role required: chat_admin

**About this task**
Note that when you delete a chat room, the system also deletes the records for any chat members and messages.

**Procedure**
1. In the application navigator filter, enter `chat_room.list`.
2. Delete multiple chat rooms from the list or open a chat room record and click **Delete**.

**Legacy chat administration**

Users with the chat_admin role can administer various aspects of legacy chat.

**Define chat room access rights**

Control the access rights for creating a chat room so that not all users can create a chat room.

**Before you begin**
Role required: chat_admin

**About this task**
To define the access rights for creating chat rooms:
**Procedure**

1. Navigate to Social IT > Chat Administration > Properties.
2. Locate the property **Comma-separated list of roles that are allowed to create chat rooms.**
3. Enter user roles. A user must have one of the specified roles to create a chat room.

**Change chat room message read access**

In legacy chat, you can associate a chat room with a record, such as an incident, and add the chat messages to a **Chat Activity** journal field on the form.

**Before you begin**

Role required: admin

**About this task**

By default, a user can read the chat messages for a room if either of the following is true:

- The room is public
- The user is a member of the room

To change chat room message read access:

**Procedure**

Modify the Chat message access control rule or create a new rule.

Read access to the messages displayed is handled by the access control list security operation `chat_messages_read` on the Chat room `[chat_room]` table.

**View a legacy chat message as a journal field**

You can view all chat messages in one place by viewing them as a journal field.

**About this task**

Chat rooms can be linked to any task record in the following ways:

- Create a room from the record.
- Create a record from a chat room, such as creating an incident from a Help Desk Chat.

To view the chat messages as a journal field:
**Procedure**

Configure the task record form to select the **Chat Activity** field. The maximum number of chat messages that are displayed by this field is 1000.

**Example:**

```
<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>2011-01-21</td>
<td>13:48</td>
<td>Chat Room for INC0010010 - I can't access the shared server</td>
</tr>
<tr>
<td>2011-01-12</td>
<td>15:11</td>
<td>Help Desk Chat - rachel user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[2011-01-12 23:12:05] rachel user: I can't access the shared server</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[2011-01-12 23:12:05] Help Desk Chat: Thank you for contacting support. Your pr agent will be with you shortly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[2011-01-12 23:12:49] Fred Luddy: Where are you?</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[2011-01-12 23:12:56] rachel user: I'm at home on the VPN</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[2011-01-12 23:13:38] Fred Luddy: I'll open an incident for you to get the update</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[2011-01-12 23:14:03] rachel user: Great, thanks!</td>
</tr>
</tbody>
</table>
```

**Chat actions**

Chat actions are additional items that appear in the chat window menu (requires the Chat plugin). Administrators and users with the chat_admin role can define chat actions.
Add actions to the legacy chat window menu
You can create new actions and add them to the chat window menu.

Procedure
1. Navigate to Social IT > Chat Administration > Actions.
2. Select an action to edit or click New.
3. Enter the chat action details and click Update or Submit.

Example:
The following example demonstrates how to add a chat action that appears only on windows where the user is a Help Desk Agent. The action appears on the menu as Show User Type and opens a popup window that indicates a current user of queue_agent.

• **Action Name**: Show User Type
• **Active**: Select the check box.
• **Order**: 100
• **Client Show Condition**:

```java
answer = g_chat.getChatType() == 'queue_agent';
```

• **OnClick Action Script**:

```javascript
alert('The current user is: ' + g_chat.getChatType());
```
Chat action details
You can define a chat action name and the script that runs when the action is selected.

Chat action details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Name</td>
<td>Enter a label for the action as it appears in the menu.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to activate or clear the check box to deactivate the action. Only active actions may appear in the menu.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter the order in which the action appears in the menu. Standard menu items (such as Show Timestamps) always appear at the top of the chat menu, followed by chat actions in order.</td>
</tr>
<tr>
<td>Client Show Condition</td>
<td>Define the conditions under which this menu option appears. The show condition must set the pre-defined answer variable to a boolean value.</td>
</tr>
<tr>
<td>OnClick Action Script</td>
<td>Enter the JavaScript code that runs when the menu item is selected.</td>
</tr>
</tbody>
</table>

**Available methods associated with the g_chat variable**

The g_chat variable is a legacy chat window object that is available in the Client Show Condition and OnClick Action Script of a chat action definition.

**Method Summary**

The following table defines the available methods associated with this object.

<table>
<thead>
<tr>
<th>Return Object</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array</td>
<td><code>getActiveUsers()</code>&lt;br&gt;Returns the active users.&lt;br&gt;Returns:&lt;br&gt;Array - Returns the active users.</td>
</tr>
<tr>
<td>String</td>
<td><code>getChannelJID()</code>&lt;br&gt;Returns the channel JID, which is a sys_id for a record chat_channel table.&lt;br&gt;Returns:&lt;br&gt;String - Returns the channel JID.</td>
</tr>
<tr>
<td>String</td>
<td><code>getChatType()</code>&lt;br&gt;Determines the chat window type.</td>
</tr>
<tr>
<td>Return Object</td>
<td>Details</td>
</tr>
<tr>
<td>---------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td>Returns: String - Returns one of the following values that specifies the type of user:</td>
</tr>
<tr>
<td></td>
<td>• queue_agent: Help Desk Chat support agent</td>
</tr>
<tr>
<td></td>
<td>• queue_user: Help Desk Chat end user</td>
</tr>
<tr>
<td></td>
<td>• group_chat: The individual is a member of a chat room (multiple users)</td>
</tr>
<tr>
<td></td>
<td>• conversation: The individual is a member in a private chat with another user</td>
</tr>
</tbody>
</table>

### String getChatQueueAgent()
Returns the sys_id for agent that is administering this thread.
Returns:
String - Returns the sys_id of the chat queue agent.

### String getChatQueueUser()
Returns the sys_id for end user of the chat queue.
Returns:
String - Returns the sys_id of the chat queue user.

### String getThreadID()
Returns the thread ID. This returns the same value as g_chat.getChannelJID().getID().
Returns:
String - Returns the thread ID.

**Legacy: Help desk chat**

Communicate with service desk staff using instant messaging.

**Note:** The Connect Support feature provides an updated messaging platform similar to help desk chat. The help desk chat and Connect Support features should not be used concurrently. There is no migration path from help desk chat to Connect Support.
Users can communicate directly with service desk staff using instant messaging in a ServiceNow instance (requires the Chat plugin.)

- Users access live support from the Employee Self-Service portal.
- Service desk staff provide support from the chat desktop.

**Legacy: Use help desk chat to get support**

You can contact service desk staff.

**Procedure**

2. Log in to your ServiceNow account. Only logged in users can use chat.
3. In the upper right, click the **Service Desk Chat** button. A chat window opens.
4. Enter your question in the text field at the bottom of the window and press **Enter**.
   - A message confirms that you have entered the chat queue and indicates your position and estimated wait time.
   - When a service desk staff member accepts your chat and begins working on your question, another message appears.
5. Chat with your service desk agent via instant messaging.
   - Service desk staff may lead you through troubleshooting, ask clarifying questions, or create an incident record to address your question.

**Results**

**Note:** Administrators can configure Service Desk Chat to be accessible on content management (CMS) pages.
Legacy: Use help desk chat to provide support

Staff who are assigned to chat support can provide live support via instant messaging. Administrators and users with the chat_admin role can assign chat support staff (see Set Up Chat Queues for Help Desk Chat).

About this task
To provide users with live support using chat:

Procedure
1. Navigate to Social IT > Chat to open your chat desktop.
   - A chat queue agent window appears on your chat desktop for each chat queue you are assigned to. If no agent windows appear, ask an administrator to add you as a member of the assignment group for a chat queue.
   - The chat queue agent window displays the number of users in the queue and how long they have been waiting.
   - Every member of the assignment group sees the associated chat queue agent window.

2. Click Answer Next User to answer the next user or click Answer beside a specific user in the queue. A chat window opens.
   - Only the agent and the user can see the chat window.

Results
Provide support via instant messaging. Chat queue agents can access additional support functions in the chat window menu:
• **Invite User**: invite another expert to assist with a support chat. An invitation appears in the favorites list of an invited user.

• **Create Incident from Chat**: create a new incident record with the initial question as the short description and the support chat as a linked chat room (accessible from the Create or Join Chat Room related link on the Incident form).

  ➤ **Note**: Administrators can edit this action or add additional actions to the chat window menu.

### Chat Queue Agent

Legacy: Set up chat queues for help desk chat

Help desk chat allows users to communicate directly with Service Desk staff via instant messaging in an instance.

Chat queues define the schedules, staff, and system messages for help desk chat. Administrators and users with the chat_admin role can set up chat queues.

Define a chat queue for legacy chat

How to define a chat queue for legacy chat.

About this task

➤ **Note**: The Chat Queue [chat_queue] table is also used by Connect Support. Legacy chat and Connect Support should not be used concurrently.
Procedure
1. Navigate to Social IT > Chat Administration > Queues.
2. Select a chat queue to edit or click New.
3. Enter the chat queue details and click Update or Submit.

Chat queue details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name that end users see as a title for the queue.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to activate or clear the check box to deactivate the chat queue.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Select the group that contains the support staff for the chat queue. Every agent sees the chat queue on their chat desktop and can answer any user that is waiting in the queue. To assign staff members to the group, see Assign Service Desk Staff to a Chat Queue.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Select a schedule that defines when a queue is available (see Use Schedules). If the queue is always available, clear the field.</td>
</tr>
<tr>
<td>Question</td>
<td>Enter the initial question that end users see when they open a new Help Desk Chat. For example, How can I help you?</td>
</tr>
<tr>
<td>Confirm problem</td>
<td>(Optional) Enter the confirmation message that end users see when they enter an initial question. For example, Thank you for contacting support. Your problem has been submitted and an agent will be with you shortly.</td>
</tr>
<tr>
<td>Initial agent response</td>
<td>(Optional) Enter the message that end users see when an agent accepts their chat. For example, Thank you for waiting. I am looking into your question now and will be with you shortly.</td>
</tr>
<tr>
<td>Not available</td>
<td>Enter the message that end users see when a Help Desk Chat request is not accepted because the queue is outside its scheduled availability (defined by the Schedule field).</td>
</tr>
</tbody>
</table>

Assign service desk staff to a chat queue

Chat queue agents are Service Desk staff that are members of a chat queue’s assignment group.

About this task
To assign agents to a chat queue:
Procedure
1. Navigate to User Administration > Groups.
2. Select an existing assignment group or click New.
3. Enter or modify the group details (see Create a Group).
4. Right-click the header and select Save.
5. In the Group members related list, click Edit.
6. Using the slushbucket, add support staff to the group.
7. Navigate to Social IT > Chat Administration > Queues.
8. Select the chat queue for which the group provides support.
9. In the Assignment Group field, select the group.

Make help desk chat accessible to an end user
Users access live support from the Employee Self-Service Portal (ESS Portal).

About this task
Users access live support from the Employee Self-Service Portal (ESS Portal). To make a Help Desk Chat queue accessible to end users, add a link to the ESS Portal (requires the Content Management Plugin).
To change the default link in the ESS header:
Procedure
1. Navigate to Content Management > Headers.
2. Open Portal - Header.
3. In the Chat queue field, enter the chat queue that users access by clicking the link in the ESS header. Clear the field to remove the chat queue link.
4. Click Update.

Add a custom link elsewhere on the ESS portal
How to add a custom help desk chat link on the ESS portal.

Procedure
1. Navigate to Content Management > Static HTML.
2. Click New.
3. Enter a Name.
4. In the Static content field, click Toggle HTML Source to edit the field in HTML source mode.
5. Create a link to the desired Help Desk Chat queue (see Link Syntax).
6. Click Submit.
7. Add the new content block to the desired location on the portal (see Adding Content to the Page).
Link syntax
To open a Help Desk Chat queue from a custom link on the ESS Portal, you must
call the CustomEvent.fire method using appropriate arguments.
To open a Help Desk Chat queue from a custom link on the ESS Portal, you must
call the CustomEvent.fire method using appropriate arguments. Details of the
API call and an example that generates an anchor link are provided below.
API Call:
CustomEvent.fire(LiveEvents.LIVE_EVENT, LiveEvents.LIVE_WINDOW_JOIN_QUEUE_QUERY,
CHAT_QUEUE_SYS_ID, CHAT_QUEUE_SYS_NAME);

where the variables are:
• CHAT_QUEUE_SYS_ID: Specifies the sys_id for the chat queue.
• CHAT_QUEUE_SYS_NAME: Specifies the name of the chat queue (must match
the value the Name field of the chat queue record).
Example: This example creates an anchor link that opens the Help Desk Chat
queue.
<a href="#" onclick="CustomEvent.fire(LiveEvents.LIVE_EVENT,
LiveEvents.LIVE_WINDOW_JOIN_QUEUE_QUERY,
'c54f0abf0a0a0b452db84664f409c79c',
'Help Desk Chat'); return false;">
Help Desk Chat
</a>

Monitor chat queues
Chat queues can yield useful Key Performance Indicators (KPI) for evaluating
support effectiveness.
• Queue Wait Time: amount of time a user waits in the queue before a help
desk agent accepts the request.
• Percentage of Chats Abandoned: users that exit the queue before an agent
responds (user stopped waiting).
• Percentage of Chats Accepted: requests that are answered by an agent.
Note: This information is not calculated automatically. Administrators may
calculate these values based on data collected by chat queues.

4372

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.


Monitor help desk chat tasks

Help Desk Chat requests are tracked in the Chat queue entries table, which appears as a related list on the associated chat queue record.

Help Desk Chat requests are tracked in the Chat queue entries table, which appears as a related list on the associated chat queue record. Because this table extends the Task table, administrators can take advantage of core task functionality. For example, administrators can attach Service Level Agreements (SLAs) to chat queue entries to evaluate the response time of Help Desk Chat support.

Legacy Notify

Legacy Notify enables organizations with a Twilio account to send notifications using text and voice messages.

ℹ️ Note: This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

Legacy Notify also allows conference calls between ServiceNow users to enable quick communications.

When Legacy Notify is active, you can configure ServiceNow to automatically generate and send notifications to selected contacts, for instance when a new incident communication plan is raised in the incident communications management process.

Users with the notifynow_admin role can set properties and monitor message and conference call activities.

Legacy Notify has been implemented for use within Incident Communications Management. Refer to the Notify API documentation for details on how to implement Legacy Notify for use within other ServiceNow applications.

Working with Legacy Notify

Follow this process to enable and use Notify.

About this task

This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.
**Procedure**

1. Set up a Twilio account to provide phone connectivity for Notify.
2. Activate Notify.
3. Configure Notify to use Twilio.
4. Begin using Notify immediately within Incident Communications Management.
5. Use the Notify API with other ServiceNow applications to provide SMS, voicemail, email, and conference calls for those applications.

**View a Legacy Notify question**

Questions contain a response action and a set of response choices. Use these questions to simplify communications. Then, you can monitor the resulting communication thread.

**Before you begin**

Role required: notifynow_admin

**About this task**

This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

For example, the process can be used to ask members of a specific on-call group to acknowledge or reject an incident. Depending on the answer from the first team member, the incident is assigned to that person or an SMS question is sent to the next on-call member. In this example, the questions are used as part of a workflow.

To see a list of predefined questions both Notify and On-Call Scheduling need to be active.

**Procedure**

1. Navigate to Notify > Questions.
2. Click the question **On-Call responsibility Accept/Reject** to see the question details.
3. Click the **Notify Response Choices** related list to view or edit the choices. The person who receives the SMS question can either choose to accept or reject the assignment. If the assignment is accepted, the **Response action** can be that the incident is actually assigned to that person. The response action is a script that you can modify or replace. If the assignment is rejected, an SMS question may be sent to the next person in the escalation chain, and so on. You can combine questions with a workflow to automate a process like on-call scheduling escalation.

**Create a question in Legacy Notify**

Define a question that can be sent to users.

**Before you begin**

Role required: notifynow_admin

**About this task**

This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

**Procedure**

1. Navigate to **Notify > Questions**.
2. Click **New**.
3. Fill in the fields, as appropriate.
### Notify New Question form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a description of the question.</td>
</tr>
<tr>
<td>Question</td>
<td>Enter the question you want to send. You can enter variables in the question with the <code>{ }</code> tags, for example, <code>{0}</code>. When using more than one variable, use consecutive numbering. When using multiple variables, reference them by specifying their position in the parameter list, starting from <code>{0}</code>. The variable is picked up by the script and translated into, for example, an incident or a problem number.</td>
</tr>
<tr>
<td>Params</td>
<td>Enter parameters which map to the fields on the record that the workflow was triggered for. This enables the message to show dynamic data. Multiple parameters should be separated by a comma. For example, <code>number</code>, shows the incident number in case the workflow was triggered from an incident. A second parameter could be, for example <code>short_description</code>.</td>
</tr>
<tr>
<td>Response Action</td>
<td>Select the action that must be taken. This is a script that can be modified, or you can create a new script by clicking the search button and selecting New. Several examples of scripts are shown. Write your own script and click Submit.</td>
</tr>
</tbody>
</table>

4. Click Submit.

### Create a new response choice in Legacy Notify

Create a new response choice to allow users to select that response for a Notify question.

**Before you begin**
Role required: notifynow_admin

**About this task**
This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

**Procedure**
1. Navigate to Notify > Questions.
2. Open the notify question you have just created.
3. Click New to create a new notify response choice.
4. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Notify New Response Choice form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Code</td>
</tr>
<tr>
<td>Text</td>
</tr>
<tr>
<td>Order</td>
</tr>
</tbody>
</table>

5. Click Submit.

**View Legacy Notify messages**

Applications implementing Notify, such as Incident Communications Management, can send Short Message Service (SMS) text messages to relevant contacts under predefined conditions, such as when a new incident communication plan has been created.

**Before you begin**
Role required: notifynow_admin

**About this task**
This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.
Procedure

1. Navigate to Notify > Messages.
2. Click a message to see the message details.

**View Legacy Notify conversations**

The Notify Conversation [notifynow_conversation] table tracks bi-directional communications and adds the ability to have more than one active conversation with the same phone number at the same time.

**Before you begin**
Role required: notifynow_admin

**About this task**
This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

The thread number is combined with the phone number to link the SMS or email response to the correct conversation. Conversations remain active until a response is received or until they are automatically deactivated after the thread release time runs out. The default thread release time is 10 days. To change this value, add the `nn.thread.release.age` property.

**Procedure**

1. Navigate to Notify > Conversations.
2. Click a conversation record to see the conversation details.
The State of the conversation can have one of the following values:

### Notify Conversation State Descriptions

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ended</td>
<td>The conversation has been completed.</td>
</tr>
<tr>
<td>Failed</td>
<td>The conversation has failed.</td>
</tr>
<tr>
<td>Pending</td>
<td>The SMS or email is waiting to be sent.</td>
</tr>
<tr>
<td>Sent</td>
<td>The SMS or email has been sent.</td>
</tr>
<tr>
<td>Unanswered</td>
<td>The SMS or email has not been answered.</td>
</tr>
</tbody>
</table>

**Note:** The mode of conversation cannot be changed during one conversation thread. For example, you cannot switch between SMS and email during one conversation.

### View Legacy Notify conference calls

Applications that use Notify, such as Incident Communications Management, can launch and maintain conference calls between involved parties.

**Before you begin**
Role required: notifynow_admin

**About this task**
This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.
Procedure

1. Navigate to Notify > Conference Calls. You can also access conference call information from the relevant record, such as the Conference Calls related list in an incident communication plan record.

2. Click a conference call in the list to view details.

3. Click the arrow beside the check box to expand a Participant entry. This shows participant session information, including details of the conference calls that the participant has been involved in.

4. Click a Participant name to see more detailed information about that participant.

Related information

Manage Legacy Notify conference call participants

Legacy public conference calls

A Notify conference call can be public.
The **Private** field on the conference call record indicates if a call is private (selected) or public (not selected). By default, all calls created automatically, such as those created through Incident Communications Management, are public. You can create private calls using the Notify API initiateConferenceCall method.

When created, public conference calls generate an associated **Code** which is sent via SMS to all invited participants. These participants can distribute the code to allow other users to join the public call. An administrator can control the format of the code using the property glide.notifynow.conference_call.code.pattern. Anyone with the code can connect to a public conference call using one of these methods:

- By calling the Twilio phone number and entering the code for that conference call.
- By sending the code in an SMS message to the Twilio phone number. Participants that join a public call this way are considered ad-hoc participants, indicated on the participant record.

**Administering Legacy Notify**

An administrator can set up Notify, manage Notify properties and conference call participants.

**Note:** This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

**Configuring legacy Notify to use the Twilio service**

Each ServiceNow instance using Notify requires a valid Twilio account and telephone number. Refer to the Twilio documentation for detailed instructions.

**Note:** This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

After the Twilio account is set up, perform the following to use that account with Notify:
• Associate the account with Notify
• Configure Twilio with ServiceNow endpoints

**Associate a Twilio account with Legacy Notify**

Associate a Twilio account with your instance to use that account for legacy Notify.

**Before you begin**
Role required: notifynow_admin

**About this task**
This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.
Procedure

1. Navigate to Notify > Administration > Properties.

Notify Properties

<table>
<thead>
<tr>
<th>Account Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your Twilio AccountSID or AuthToken are not valid.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Twilio AccountSID.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Twilio AuthToken.</th>
</tr>
</thead>
<tbody>
<tr>
<td>........</td>
</tr>
</tbody>
</table>

Twilio SMS and voice enabled phone number.

<table>
<thead>
<tr>
<th>Number of frequent conference call participants to be displayed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
</tr>
</tbody>
</table>

The voice used for Notify communications.

<table>
<thead>
<tr>
<th>Voice Analytics</th>
</tr>
</thead>
<tbody>
<tr>
<td>alice</td>
</tr>
</tbody>
</table>

2. Enter the AccountSID, AuthToken and phone number values. These values can be obtained from the Twilio dashboard:

Twilio Dashboard

When the Twilio account details are entered in the Notify Properties page, the account status is updated.
3. [Optional] To use Notify on multiple ServiceNow instances, activate Notify on each instance and create a separate Twilio account and telephone number for each instance.

**Note:** Some telephone numbers are voice capable, but not SMS capable. This is shown in the Notify properties with relevant messages. Two methods are available to check this: `isSMSCapable` and `isVoiceCapable`.

**Configuring the Twilio service with endpoints in legacy Notify**

In order for the Twilio service to receive Notify commands, the **Request URL** field value for every Twilio telephone number must point to the ServiceNow instance that uses Notify with that Twilio telephone number.

**Note:** This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

To set these values, do one of the following:

- Define them manually in the Twilio service dashboard.
- Ensure the fields are blank in the Twilio service dashboard, then open the Notify Properties page. Notify automatically configures the correct endpoints if the **Request URL** fields are blank.

Set these values from within the Twilio service dashboard.
The notifyusa values underlined in the image should be replaced with your ServiceNow instance name, for:

- **Voice Request URL**: https://notifyusa.service-now.com/NotifyNowCallProcessor.do
- **Status Callback URL**: https://notifyusa.service-now.com/NotifyNowCallStatusProcessor.do
- **Messaging Request URL**: https://notifyusa.service-now.com/NotifyNowSmsProcessor.do

**View and edit legacy Notify properties**

You can view and edit Notify properties.
Before you begin
Role required: notifynow_admin

About this task
This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

Procedure
1. Navigate to Notify > Administration > Properties.

2. Fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Status</td>
<td>Information showing the status of the associated Twilio account.</td>
</tr>
<tr>
<td>Twilio AccountSID</td>
<td></td>
</tr>
<tr>
<td>Twilio AuthToken</td>
<td></td>
</tr>
<tr>
<td>Twilio SMS and voice enabled phone number.</td>
<td></td>
</tr>
<tr>
<td>Number of frequent conference call participants to be displayed.</td>
<td>10</td>
</tr>
<tr>
<td>The voice used for Notify communications.</td>
<td>alice</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Twilio AccountSID</td>
<td>The Twilio account AccountSID, acting as the user name for that account.</td>
</tr>
<tr>
<td>Twilio AuthToken</td>
<td>The Twilio account AuthToken, acting as the password for that account. See Associating a Twilio Account.</td>
</tr>
<tr>
<td>Twilio SMS and voice enabled phone number</td>
<td>The Twilio number that Notify will use. Telephone numbers must be entered in the E.164 format and need to exist under the Twilio account. See Associating a Twilio Account.</td>
</tr>
<tr>
<td>Number of frequent conference call</td>
<td>The number of people to display in the frequently called list.</td>
</tr>
<tr>
<td>participants to be displayed</td>
<td></td>
</tr>
<tr>
<td>Voice</td>
<td>The voice used for Notify communications. Select woman or man to provide female or male voice support for English, Spanish, French, German, and Italian. Select alice to provide female voice support for a wider range of languages.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**Legacy Notify account status messages**

Account status messages are visible on the Notify Properties page.

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your account is ready for use</td>
<td>Notify is correctly configured and ready for use.</td>
</tr>
<tr>
<td>Your Twilio AccountSID or AuthToken are not valid</td>
<td>An incorrect value has been entered in the AccountSID or AuthToken fields in the Notify properties.</td>
</tr>
<tr>
<td>Your Twilio phone number is not valid</td>
<td>Incorrect telephone number information is defined in the Notify properties.</td>
</tr>
<tr>
<td>Message</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Your Twilio phone number does not have properly configured endpoints</td>
<td>The Request URL endpoint settings have not been properly configured.</td>
</tr>
<tr>
<td>Your Twilio account is not configured properly</td>
<td>One or more of your Twilio account settings is incorrect. Open the Twilio dashboard and check the settings.</td>
</tr>
</tbody>
</table>

Manage Legacy Notify conference call participants

As a Notify administrator, you can mute, unmute, and kick participants on a conference call.

**Before you begin**
Role required: notifynow_admin

**About this task**
This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

Muting a participant prevents that person from speaking on the conference call but does not notify any participants, including the muted participant. Kicking a participant removes that person from the conference call and sets the **Response** field for the participant session to kicked.

**Procedure**

1. Navigate to **Notify > Conference Calls**.
2. Select an active conference call.
3. In the **Notify Conference Call Participants** related list, select a participant.
4. Click the button for the action you want to perform, such as **Mute** to mute the participant.

You can perform these actions for multiple participants as a single operation using the **Actions on selected rows** choice list on the **Notify Conference Call Participants** related list.

**Related information**

View Legacy Notify conference calls
Installed with Legacy Notify

Activating the Notify plugin adds or modifies tables, user roles, script includes, and other components.

⚠️ **Note:** This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

Tables

Notify adds or modifies the following tables.

<table>
<thead>
<tr>
<th>Display Name [Table Name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Answer [notifynow_answer]</td>
<td>Information for possible answers to the SMS question sent.</td>
</tr>
<tr>
<td>Conversation [notifynow_conversation]</td>
<td>Information for the conversation thread.</td>
</tr>
<tr>
<td>NotifyNow Conference Call [notifynow_conference_call]</td>
<td>Information for conference call records.</td>
</tr>
<tr>
<td>NotifyNow Participant Session [notifynow_participant_session]</td>
<td>Information regarding conference call sessions for individual conference call participants.</td>
</tr>
<tr>
<td>Participant [notifynow_participant]</td>
<td>Information regarding individual conference call participants.</td>
</tr>
<tr>
<td>Question [notifynow_question]</td>
<td>Information for the possible questions in the SMS.</td>
</tr>
<tr>
<td>Response_action [notifynow_response_action]</td>
<td>Information for the notify response action associated with the question.</td>
</tr>
<tr>
<td>Response_choice [notifynow_response_choice]</td>
<td>Information for the notify response choice associated with the question.</td>
</tr>
<tr>
<td>SMS Messages [notifynow_message]</td>
<td>Information for the actual SMS messages sent.</td>
</tr>
</tbody>
</table>

Properties

Notify adds the following system properties.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.notifynow.frequent_participant_count</td>
<td>The number of frequent conference call participants to be displayed.</td>
</tr>
<tr>
<td>glide.notifynow.voice</td>
<td>The voice used for Notify communications.</td>
</tr>
<tr>
<td>glide.notifynow.twilio.accountsid</td>
<td>The Twilio account AccountSID.</td>
</tr>
<tr>
<td>glide.notifynow.twilio.token</td>
<td>The Twilio account AuthToken.</td>
</tr>
<tr>
<td>glide.notifynow.twilio.phonenumber</td>
<td>The Twilio number that Notify will use.</td>
</tr>
<tr>
<td>glide.notifynow.twilio.answering_machine_detection</td>
<td>A boolean flag to enable or disable answering machine detection. Set to true to use answering machine detection. Set to false to continue the call.</td>
</tr>
<tr>
<td>nn.thread.release.age</td>
<td>The number of days after which the conversation thread release time runs out. Defaults to 10 days.</td>
</tr>
<tr>
<td>glide.notifynow.conference_call.code.pattern</td>
<td>The pattern used to generate a conference call code for public conference calls. Number signs (#) in the pattern are replaced with random numbers when a code is generated.</td>
</tr>
<tr>
<td>glide.notifynow.fix_invalid_phone_number</td>
<td>A boolean flag to enable or disable</td>
</tr>
</tbody>
</table>
Properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>automatic correction of invalid phone numbers. Twilio might incorrectly prefix non-US phone numbers with 1. When this property is true, the instance automatically removes the 1 for non-US calls. When this property is false, you might be incorrectly identified when reconnecting to a call using SMS.</td>
<td></td>
</tr>
</tbody>
</table>

**User Roles**

Notify adds the following user roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains Roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>notifynow_admin</td>
<td>None</td>
<td>Administrator with privileges for Notify functionality.</td>
</tr>
</tbody>
</table>

**UI Actions**

Notify adds the following UI actions.

<table>
<thead>
<tr>
<th>UI Action</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initiate Conference Call</td>
<td>Incident Communication Plan [incident_alert]</td>
<td>Adds a link to the Incident Communication Plan form, if that plugin is activated, which displays a dialog box for starting a conference call with selected participants.</td>
</tr>
</tbody>
</table>
UI Actions (continued)

<table>
<thead>
<tr>
<th>UI Action</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invite to Conference Call</td>
<td>NotifyNow Conference Call [notifynow_conference_call]</td>
<td>Adds a link to the Notify Conference Call form which displays a dialog box for adding more users to an active conference call.</td>
</tr>
</tbody>
</table>

Script Includes

Notify adds the following script includes.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IncidentAlertConferenceCall</td>
<td>A utility JavaScript Prototype class allowing users to initiate the conference call and add other users to the conference call. Should be used in conjunction with the slushbucket UI page (notifynow_participant).</td>
</tr>
</tbody>
</table>

Business Rules

Notify adds the following business rules.

<table>
<thead>
<tr>
<th>Business Rule Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMS on new Incident Communication Plan</td>
<td>Incident Communication Plan [incident_alert]</td>
<td>Sends an SMS to any default contacts added when an incident communication plan record is created.</td>
</tr>
<tr>
<td>Conference Call Allowed</td>
<td>Incident Communication Plan [incident_alert]</td>
<td>Displays or hides the initiate conference call UI action by storing true or false in g_scratchpad.conferenceCallAllowed.</td>
</tr>
<tr>
<td>Update Conference</td>
<td>NotifyNow Conference Call [notifynow_conference_call]</td>
<td>Logs when a conference call started by writing to an</td>
</tr>
</tbody>
</table>
### Business Rules (continued)

<table>
<thead>
<tr>
<th>Business Rule Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Started IA Activity</td>
<td>Activity</td>
<td>incident communication plan's comment field if the source record is from the incident_alert table.</td>
</tr>
<tr>
<td>Update Conference Call Finished IA Activity</td>
<td>NotifyNow Conference Call [notifynow_conference_call]</td>
<td>Logs when a conference call ended and what actions the conference call participants took by writing to an incident communication plan's comment field if the source record is from the incident_alert table.</td>
</tr>
</tbody>
</table>

### Workflow Activities

Notify adds the following workflow activities.

#### Workflow Activities

<table>
<thead>
<tr>
<th>Activity Name</th>
<th>Activity Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Notify SMS</td>
<td>Notify</td>
<td>Sends an SMS message (maximum 1600 Characters) to an E.164 compliant mobile phone number of the selected recipients and/or groups.</td>
</tr>
<tr>
<td>Send Notify SMS Question</td>
<td>Notify</td>
<td>Sends predefined SMS Question message (maximum 1600 Characters) to an E.164 compliant mobile phone number of the selected recipients and/or groups. This is one of two main activities for workflow On-Call Assign by Acknowledgement. In a predefined message, the recipient is asked to assign himself to a newly created incident. The same message also contains predefined answers.</td>
</tr>
<tr>
<td>Send Email Question</td>
<td>Notify</td>
<td>Sends email generated from email template containing notification that recipient is the current On-call resource for a newly created task. This is one of two main activities for the workflow On-Call Assign by Acknowledgement. In a predefined message, the recipient is asked to assign himself to a newly created incident. The email contains two links that enable the user to accept or reject assignment.</td>
</tr>
</tbody>
</table>
NotifyNow API (Legacy) - Global

The legacy NotifyNow API provides functionality for sending emails, sending SMS messages, and setting up conference calls.

Use this when you want to use Notify functionality with applications on your system.

⚠️ Note: This API is included with the legacy Notify functionality. For APIs included in the current Notify feature, see the Notify, NotifyAction, NotifyPhoneNumber, and NotifyClient APIs.

NotifyNow - getReadyState()

Indicates whether Notify is set up correctly or not.

This method can only be accessed by administrators or users with the notifynow_admin role. Users with all other roles get the message False when trying to run the function in a script.

### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>True if Notify is set up correctly, otherwise false.</td>
</tr>
</tbody>
</table>

```javascript
var nn = new SNC.NotifyNow();
gs.log(((nn.getReadyState()) ? "OK" : "NOT OK"));
```

NotifyNow - getStatus()

Returns the current status of Notify configuration.

This method can only be accessed by administrators or users with the notifynow_admin role. Users with all other roles get the message Unauthorized when trying to run the function in a script.
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>One of the possible status messages.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NO_NUMBER_MESSAGE</td>
<td>The account does not have a telephone number set up. Ensure that you set up the telephone number for the account.</td>
</tr>
<tr>
<td>NO_ENDPOINTS_MESSAGE</td>
<td>The account does not have its endpoints set up correctly. Ensure that you set up the endpoints for the account.</td>
</tr>
<tr>
<td>ACCOUNT_OK_MESSAGE</td>
<td>The account is active and ready for use.</td>
</tr>
<tr>
<td>ACCOUNT_NO_AUTH</td>
<td>The Twilio AuthToken is not valid.</td>
</tr>
<tr>
<td>ACCOUNT_NOT_CONFIGURED</td>
<td>The Twilio AccountSID or AuthToken is not valid.</td>
</tr>
</tbody>
</table>

```javascript
var nn = new SNC.NotifyNow();
gs.log(nn.getStatus());
```

**NotifyNow - initiateConferenceCall(String[] conferenceCallParticipants, String conferenceCallTitle)**

Initiate a new conference call.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>conferenceCallParticipants</td>
<td>String</td>
<td>One or more users, conference call participants, identified by the sys_ids from the sys_user table or E.164-compliant phone numbers.</td>
</tr>
<tr>
<td>conferenceCallTitle</td>
<td>String</td>
<td>Title of the conference call. This parameter has a maximum length of 40 characters.</td>
</tr>
</tbody>
</table>
Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GlideRecord</td>
<td>The conference call record, or null if there was an error.</td>
</tr>
</tbody>
</table>

This initiates a conference call with E.164-compliant phone numbers for participants, without the optional source record parameter and and does not send any conference call details via SMS or email.

```javascript
var participants = ['+31205655548', '+31205655552', '+31652825393'];
// set up conference call
var nn = new SNC.NotifyNow();
var conferenceCall = nn.initiateConferenceCall(participants, "testing12");
gs.log('started conference call: ' + conferenceCall.getUniqueValue());
```

**NotifyNow - initiateConferenceCall(String[] conferenceCallParticipants, String conferenceCallTitle, GlideRecord sourceRecord, Boolean private)**

Initiate a new conference call.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>conferenceCallParticipants</td>
<td>String</td>
<td>One or more users, conference call participants, identified by the sys_ids from the sys_user table or E.164-compliant phone numbers.</td>
</tr>
<tr>
<td>conferenceCallTitle</td>
<td>String</td>
<td>Title of the conference call. This parameter has a maximum length of 40 characters.</td>
</tr>
<tr>
<td>sourceRecord</td>
<td>GlideRecord</td>
<td>Source record to associate to the conference call such as an incident or problem number.</td>
</tr>
<tr>
<td>private</td>
<td>Boolean</td>
<td>Value to control if a conference call is private. This value defaults to false.</td>
</tr>
</tbody>
</table>
This initiates a conference call with participants that have a E.164-compliant phone number and participants from the sys_user table and sends conference call details via SMS and email to all participants.

```javascript
// define phone number participants
var participants = ['$+31205655548', '+31205655552', '+31652825393'];

// we also want to add two Dutch sys_user participants
var user = new GlideRecord('sys_user');
user.addNotNullQuery('mobile_phone');
user.addQuery('mobile_phone', 'STARTSWITH', '+316');
user.setLimit(2);
user.query();

// add users to the participant array
while (user.hasNext() && user.next()) {
    gs.log('adding user ' + user.getValue('name') + ' with phone number ' +
           user.getValue('mobile_phone') + ' to the participant array');
    participants.push(user.getUniqueValue());
}

// define a source record to associate with the conference call
var source = new GlideRecord("cmdb_ci");
source.query("asset_tag", "P1000167");
if (source.hasNext() && source.next()) {
    // set up conference call
    var nn = new SNC.NotifyNow();
    var conferenceCall = nn.initiateConferenceCall(participants, "testing 1 2", source);

    // check if the conference call was successfully created
    if (conferenceCall != null) {
        gs.log('started conference call: ' + conferenceCall.getUniqueValue());
    } else {
        gs.log('could not start the conference call :(');
    }
}
```
**NotifyNow - isCallable(String participant)**

Determines whether a user is callable or not.

A user must have a valid phone number to be callable. A user who is already in an active session is not callable.

<table>
<thead>
<tr>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
</tr>
<tr>
<td>participant</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Returns</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>boolean</td>
</tr>
</tbody>
</table>

```javascript
var nn = new SNC.NotifyNow();
gs.log('by number: ' + nn.isCallable('+31612345678'));

var user = GlideRecord('sys_user');
user.query('sys_id', '13d39544eb5201003cf587b9d106fea9');
if (user.hasNext() && user.next())
gs.log('by user: ' + nn.isCallable(user));

var participant = GlideRecord('notifynow_participant');
participant.query('sys_id', '33b11430eb1201003cf587b9d106feb9');
if (participant.hasNext() && participant.next())
gs.log('by participant: ' + nn.isCallable(participant));
```

**NotifyNow - isSMSCapable()**

Checks if the telephone number associated with the Twilio account is capable of sending SMS messages.

<table>
<thead>
<tr>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
</tr>
<tr>
<td>None</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
## Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>Whether the telephone number associated with the Twilio account is capable of sending SMS messages.</td>
</tr>
</tbody>
</table>

```javascript
gs.log('The twilio number is SMS capable: ' + ((new SNC.NotifyNow().isSMSCapable()) ? 'yes' : 'no'));
```

### NotifyNow - isSMSCapable(String userID)

Checks if a user is able to send SMS messages.

#### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>userID</td>
<td>String</td>
<td>The sys_id of the user you want to check for an SMS-capable phone number.</td>
</tr>
</tbody>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>If the user can send SMS messages.</td>
</tr>
</tbody>
</table>

```javascript
gs.log('the user is able to send SMS messages (e.g. has a SMS device): ' + (new SNC.NotifyNow().isSMSCapable('<user sys_id>') ? 'yes' : 'no'));
```

### NotifyNow - isVoiceCapable()

Checks if the telephone number associated with the Twilio account is capable of setting up phone calls.

#### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>Whether the telephone number associated with the Twilio account is capable of setting up phone calls.</td>
</tr>
</tbody>
</table>

```javascript
gs.log('the Twilio number is Voice capable: ' + ((new SNC.NotifyNow().isVoiceCapable()) ? 'yes' : 'no'));
```

**NotifyNow - isVoiceCapable(String userID)**

Checks if a user is able to make voice calls.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>userID</td>
<td>String</td>
<td>The sys_id of the user you want to check for a voice-call capable phone number.</td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>boolean</td>
<td>Whether the user has a voice-call capable phone number.</td>
</tr>
</tbody>
</table>

```javascript
gs.log('the user is able to send SMS messages (e.g. has a SMS device): ' +
((new SNC.NotifyNow().isVoiceCapable('someuserid')) ? 'yes' : 'no'));
```

**NotifyNow - kick(GlideRecord participant)**

Removes a participant from a conference call.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>participant</td>
<td>GlideRecord</td>
<td>The conference call participant to remove from the call.</td>
</tr>
</tbody>
</table>
### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>True if the participant was removed, otherwise false.</td>
</tr>
</tbody>
</table>

```javascript
var participantId = "<participant sys_id>";
var participant = new GlideRecord('notifynow_participant');
participant.get(participantId);
if (participant.isValid()) {
    // kick participant
    result = new SNC.NotifyNow().kick(participant);
    gs.log('participant kicked: ' + result);
}
```

### NotifyNow - mute(GlideRecord participant)

Mutes a participant on a conference call.

#### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>participant</td>
<td>GlideRecord</td>
<td>The conference call participant to mute.</td>
</tr>
</tbody>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>True if the participant was muted, otherwise false.</td>
</tr>
</tbody>
</table>

```javascript
var participantId = "<participant sys_id>";
var participant = new GlideRecord('notifynow_participant');
participant.get(participantId);
if (participant.isValid()) {
    // mute participant
    result = new SNC.NotifyNow().mute(participant);
    gs.log('participant muted: ' + result);
}
```
**NotifyNow - umute(GlideRecord participant)**

Unmutes a participant on a conference call.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>participant</td>
<td>GlideRecord</td>
<td>The muted conference call participant to unmute.</td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>True if the participant was unmuted, otherwise false.</td>
</tr>
</tbody>
</table>

```javascript
var participantId = "<participant sys_id>";
var participant = new GlideRecord('notifynow_participant');
participant.get(participantId);
if (participant.isValid()) {
    // unmute participant
    result = new SNC.NotifyNow().unmute(participant);
    gs.log('participant unmuted: ' + result);
}
```

**NotifyNow - sendEmailQuestion(String emailAddress, String question, GlideRecord sourceRecord, String emailSubject)**

Send an email question to an email address.

The sendEmailQuestion method produces a question body and requires users to click a link to indicate their choice.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>emailAddress</td>
<td>String</td>
<td>Email address to send the question to.</td>
</tr>
<tr>
<td>question</td>
<td>String or GlideRecord</td>
<td>The question record to send or the sys_id of a question record.</td>
</tr>
<tr>
<td>sourceRecord</td>
<td>GlideRecord</td>
<td>An optional source record to associate to the SMS question, such as an incident.</td>
</tr>
</tbody>
</table>
Parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>emailSubject</td>
<td>String</td>
<td>Optional text to override the default email subject.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The conversation sys_id.</td>
</tr>
</tbody>
</table>

This example demonstrates using the default email subject.

```javascript
var user = GlideRecord("sys_user");
user.get("email", "someone@somedomain.com");

new SNC.NotifyNow().sendEmailQuestion(user.getValue('email'),
    "b6b34500bf3111003cf585ce2c0739ce", user);
```

This example uses dot-walking and specifies a source record and email subject.

```javascript
new SNC.NotifyNow().sendEmailQuestion("someone@somedomain.com",
    "b6071733bf1111003cf585ce2c07390f", current,
    "Please answer this question");
```

This example uses dot-walking and specifies an email subject but no source record.

```javascript
new SNC.NotifyNow().sendEmailQuestion("someone@somedomain.com",
    "b6071733bf1111003cf585ce2c07390f",
    "Please answer this question");
```

**NotifyNow - sendSMS(String phoneNumber, String smsBody)**

Sends an SMS message to an E.164-compliant mobile phone number.

Notify supports international numbers. Using this method with a number that does not support sending SMS messages results in an error being logged.
### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>phoneNumber</td>
<td>String</td>
<td>The E.164-compliant phone number to send the message to.</td>
</tr>
<tr>
<td>smsBody</td>
<td>String</td>
<td>The message to send, maximum 1600 characters.</td>
</tr>
</tbody>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

```java
new SNC.NotifyNow().sendSMS("+31612345678", "This is a message without source record");
```

### NotifyNow - sendSMS(String phoneNumber, String smsBody, GlideRecord source)

Sends an SMS message to an E.164-compliant mobile phone number.

Notify supports international numbers. Using this method with a number that does not support sending SMS messages results in an error being logged.

### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>phoneNumber</td>
<td>String</td>
<td>The E.164-compliant phone number to send the message to.</td>
</tr>
<tr>
<td>smsBody</td>
<td>String</td>
<td>The message to send, maximum 1600 characters.</td>
</tr>
<tr>
<td>source</td>
<td>GlideRecord</td>
<td>The source record to associate with this SMS message.</td>
</tr>
</tbody>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>
```javascript
var source = new GlideRecord("my_table");
source.query("my_field", "my_value");

if (source.hasNext() && source.next()) {
    // send a text message
    var nn = new SNC.NotifyNow();
    var message = "this is just a test";
    var number = "+31612345678";
    nn.sendSMS(number, message, source);
}
```

This example uses dot-walking and the current record as the source record.

```javascript
new SNC.NotifyNow().sendSMS("+31612345678", "this is a test", current);
```

### NotifyNow - sendSMSQuestion(String phoneNumber, String question, GlideRecord sourceRecord)

Sends an SMS question.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>phoneNumber</td>
<td>An E.164-compliant phone number to send the message to.</td>
<td></td>
</tr>
<tr>
<td>question</td>
<td>String or GlideRecord</td>
<td>The question record to send or the sys_id of a question record.</td>
</tr>
<tr>
<td>sourceRecord</td>
<td>An optional source record to associate to the SMS question, such as an incident.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The conversation sys_id, or null if the SMS was not sent successfully.</td>
</tr>
</tbody>
</table>

```javascript
var question = new GlideRecord("notifynow_question");
question.query();

// get the first question
if (question.hasNext() && question.next()) {
```
// send the sms question
var number = "+31612345678";
var nn = new SNC.NotifyNow();
nn.sendSMSQuestion(number, question.getUniqueValue(), current);
}

NotifyNow - addConferenceCallParticipant(String conferenceCall, String participant)

Adds ad-hoc users to an ongoing conference call.

When the method is called with a phone number for the participant parameter and there is exactly one sys_user record that matches the phone number, that sys_user record will be related to the participant. The participant's phone number field will be left blank because the phone number is in the sys_user record. If there are several sys_user records that match the phone number, or if there are no results, the participant's phone number field will be filled in, and there will be no stored reference to sys_user because the user is not known.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>conferenceCall</td>
<td>String or GlideRecord</td>
<td>The sys_id or GlideRecord of an active conference call.</td>
</tr>
<tr>
<td>participant</td>
<td>String or GlideRecord</td>
<td>The sys_id or GlideRecord of a user with an E.164-compliant phone number, or an E.164-compliant phone number.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GlideRecord</td>
<td>The participant record of the new participant that was added to the conference call.</td>
</tr>
</tbody>
</table>

// add a new participant by conference call sys_id (string) and phone number (string)
var nn = new SNC.NotifyNow();
gs.log(nn.addConferenceCallParticipant('d193b242eb020100a04d4910f206fe39', '+31612345678'));
// add a new participant by conference call sys_id (string) and user record (GlideRecord)
var user = new GlideRecord('sys_user');
user.query('user_name', 'myUserName');
if (user.hasNext() && user.next()) {
    var nn = new SNC.NotifyNow();
    gs.log(nn.addConferenceCallParticipant('d193b242eb020100a04d4910f206fe39', user));
    // you could have added the user by sys_id as well:
    // nn.addConferenceCallParticipant('d193b242eb020100a04d4910f206fe39',
    // user.getValue('sys_id'));
} else {
    gs.log('no such user');
}

// add a new participant by conference call record (GlideRecord) and phone number (string)
var conferenceCall = new GlideRecord('notifynow_conference_call');
conferenceCall.query('title', 'IA0001001');
if (conferenceCall.hasNext() && conferenceCall.next()) {
    var nn = new SNC.NotifyNow();
    gs.log(nn.addConferenceCallParticipant(conferenceCall, '+31612345678'));
} else {
    gs.log('no such conference call');
}

NotifyNow - convertLocalPhoneNumberToE164(String userID, String phoneNumber)

Converts a local phone number to an E.164-compliant phone number based on a user's location.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>userID</td>
<td>String</td>
<td>The sys_id of a sys_user record to get location information from.</td>
</tr>
<tr>
<td>phoneNumber</td>
<td>String</td>
<td>The phone number.</td>
</tr>
</tbody>
</table>
Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The E.164-compliant phone number.</td>
</tr>
</tbody>
</table>

```javascript
var localPhoneNumber = '01784 221600';
var userName = 'Heath Vanalphen';

var user = new GlideRecord('sys_user');
user.set('name', userName);
var E164Number = new SNC.NotifyNow().convertLocalPhoneNumberToE164(user.getUniqueValue(),
localPhoneNumber);
gs.log('converted: ' + localPhoneNumber + ' to ' + E164Number + ' based on ' +
user.getValue('name') + '
' + user.getValue('location')) + '+');
```

NotifyNow - getConferenceCallParticipants(String conferenceCallId, Boolean isCallable)

Returns all participants for a conference call.

### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>conferenceCallId</td>
<td>String</td>
<td>The ID of the conference call.</td>
</tr>
<tr>
<td>isCallable</td>
<td>Boolean</td>
<td>An optional flag to return either only the users you can call (true) or those you cannot call (false).</td>
</tr>
</tbody>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GlideRecord</td>
<td>The participants</td>
</tr>
</tbody>
</table>

```javascript
var nn = new SNC.NotifyNow();
var user = nn.getConferenceCallParticipants('c2e91710eb120100f34087b9d106fe37');

while (user.hasNext() && user.next()) {
    if (user.getValue('participant')) {
        gs.log('user: ' + user.getValue('sys_id')) +
    }
};
```
var nn = new SNC.NotifyNow();
var user = nn.getConferenceCallParticipants('c2e91710eb120100f34087b9d106fe37', true);

while (user.hasNext() && user.next()) {
    if (user.getValue('participant')) {
        gs.log('user: ' + user.getValue('sys_id'));
    } else {
        gs.log('phone number: ' + user.getValue('phone_number'));
    }
}

var conferenceCallId = '32b11430eb1201003cf587b9d106feb8';

// get all participants
gs.log('all conference call participants:');
var nn = new SNC.NotifyNow();
var user = nn.getConferenceCallParticipants(conferenceCallId);
gs.log(user);

// get all callable participants
gs.log('all conference call participants we can call:');
user = nn.getConferenceCallParticipants(conferenceCallId, true);
gs.log(user);

// get all un callable participants
gs.log('all conference call participants that are already in an active session and whom we cannot call:');
user = nn.getConferenceCallParticipants(conferenceCallId, false);
gs.log(user);

**NotifyNow - getFrequentlyCalledUsers(Number limit)**

Returns a number of frequently-called users, up to the limit parameter, in alphabetical order.
### NotifyNow - getFrequentlyCalledUsers(10)

Returns the frequently called users in alphabetical order.

```javascript
var nn = new SNC.NotifyNow();
var fc = nn.getFrequentlyCalledUsers(10);
while (fc.hasNext() && fc.next()) {
    gs.log("got user " + fc.getValue('name') + ' - ' + fc.getValue('sys_id'));
}
```

### NotifyNow - getPreferredE164VoiceNumber(GlideRecord user)

Returns a user's preferred E.164-compliant phone number for voice calls.

#### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user</td>
<td>GlideRecord or String</td>
<td>The user record or the sys_id of a user to get the E.164-compliant phone number from.</td>
</tr>
</tbody>
</table>

```javascript
var userID = "<user sys_id>";
var E164Number = new SNC.NotifyNow().getPreferredE164VoiceNumber(userID);
gs.log('the preferred phone number for setting up voice calls is ' + E164Number + ' for user with id: ' + userID);
```
NotifyNow - getPreferredE164SMSNumber(GlideRecord user)

Returns a user's preferred E.164-compliant phone number for SMS messages.

### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user</td>
<td>GlideRecord or String</td>
<td>The user record or the sys_id of a user to get the E.164-compliant phone number from.</td>
</tr>
</tbody>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The E.164-compliant phone number or null.</td>
</tr>
</tbody>
</table>

```javascript
var userID = "<user sys_id>";
var E164Number = new SNC.NotifyNow().getPreferredE164SMSNumber(userID);
gs.log('the preferred phone number for sending SMS notifications is ' + E164Number + ' for user with id: ' + userID);
```

NotifyNow - getPreferredEmailAddress(GlideRecord user)

Returns a user's preferred email address

### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user</td>
<td>GlideRecord or String</td>
<td>The user record or the sys_id of a user to get the email address from.</td>
</tr>
</tbody>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The email address or null.</td>
</tr>
</tbody>
</table>

```javascript
var userID = "some user sys id";
var email = new SNC.NotifyNow().getPreferredEmailAddress(userID);
gs.log('the preferred email address for sending email notifications is ' + email + ' for user with id: ' + userID);
```
Live Feed

Live Feed is a social IT application that provides a place to post and share content in a ServiceNow instance.

Live Feed content forms a searchable knowledge source for sharing information within an organization. Main features include the following:

- Users can post, reply to, and rate messages, including links and images.
- Administrators can set up automatic messages that are generated when specific records are updated throughout the system.
- Users can subscribe to receive email notifications when new messages are posted.
- Users who take advantage of the accessibility options in the platform can tab through a live feed to navigate.

Live feed includes different types of feeds.

![My Live Feeds](image)

**Note:** Live Feed v2 is active for all new instances by default. If you are upgrading from an earlier version of ServiceNow, you need to activate live feed v2 to use these features.
Live feed can be domain separated at the data level only. For more information on live feed and domain separation, see Domain separation in Live Feed.

**Live Feed browser support**

The Live Feed v2 plugin does not support Internet Explorer 7 through 9.

Users who access the instance from those browser versions can use Live Feed v1 functionality. Users who access the instance from browsers that are compatible with HTML5 can use Live Feed v2 functionality.

**Activate Live Feed**

Live Feed is active for all instances. An administrator can activate the Live Feed plugin if it is not already active.

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Administer live feed**

Administrators and users with the live_feed_admin role can configure live feed security and provide access to live feed from content management pages. Administrators can also set up live feed table notifications.

**Document feeds**

A document feed is a live feed group that is associated with a record, such as an incident or change.
Document feeds allow users to work on tasks and other records through the live feed interface. Users can post messages in live feed that are automatically maintained as comments or work notes on the record, if the record has these journal fields.

The benefits of using document feeds include the following.

- Improving communication between users working on the same record.
- Improving visibility into progress for end users.
- Providing a single place to see updates on multiple records.
- Saving conversation history in the record so that knowledge is not lost in an email chain.

To use document feeds, activate the Live Feed Document plugin, which is active by default in new instances. See Use live feed to work on records to learn how to use this feature.

The system automatically creates a document group for the feed when a user follows or shows a record on live feed. The system also creates a document group when a user creates a new record on a table that has live feed enabled.

The following list describes features of the document feed group.

- Is unlisted; it does not appear when users view all groups on live feed.
- Automatically approves membership for every user who can access the record.
- Uses the record number as the group name.
- Uses the record short description as a group description.
- Maintains all messages posted to live feed on the record, if the record has a journal field for comments. If the record has a standard text field for comments, each live post overwrites the field value.
- Maintains all messages posted on the record in live feed if the record has a journal field for comments. When the group is created, existing messages are added to the document feed.

A user who participates in live feed becomes a member of the group.

Related information

Activate a plugin

Add a live feed UI action on a table

You can add UI actions on a table to allow users to follow records in live feed.
Before you begin
Role required: ui_action_admin or admin

Procedure
1. Navigate to System Definition > UI Actions.
2. Open one of the live feed UI actions, for example, the Follow on Live Feed list UI action.
3. In the Table field, select the table name.
4. Right-click the header and select Insert to create a copy of the UI action for the desired table.
5. Repeat steps 1 – 4 for all live feed UI actions.

Configure document feeds
You can configure a table to support document feeds.

Before you begin
Role required: personalize_dictionary or admin

About this task
Configuring a table to support document feeds includes the following steps:

Procedure
1. Add live feed to a form header.
2. Add Follow on Live Feed and Show Live Feed as list and form UI actions.

Security configuration for document feeds
Document feeds honor the access control rules (ACLs) for the associated record. Users can only view messages on the document feed if they have access to the same information on the record.

Consider the following examples.
• If an ACL allows a user to read and create comments on an incident, then the user can view and add messages posted as comments on the incident feed.
• If an ACL restricts a user from reading work notes, then the user cannot view messages posted as work notes on the incident feed.
Note: Access control rules are only checked when a user first accesses the document feed. After users view the feed, an administrator must remove them manually to change their access.

Disable a record feed
You can disable live feed functionality from the form of any table.

Before you begin
Role required: personalize_dictionary or admin

Procedure
1. Navigate to System Definition > Dictionary.
2. Open the dictionary entry for the table.
3. Add live_feed=false in the Attributes field.
4. Click Update.

Note: If the Collaboration feature is activated, you can remove the show live feed icon (️) from all form headers. Set the glide.live_feed.task_header_button property to collaboration.

Disable a document feed
You can disable a document feed from the form of any table.

Before you begin
Role required: personalize_dictionary or admin

Procedure
1. Navigate to System Definition > Tables.
2. Open the table record.
3. Clear the Live feed check box.
4. Click Update.

Business rule installed with Live Feed Document
This business rule is installed with Live Feed Document. There are no tables, roles, or notifications installed with it.
### Record feeds

A record feed is a live feed group that is associated with a record, such as an incident or change.

Record feeds allow users to work on tasks and other records through the live feed interface. Users can post messages in live feed that are automatically maintained as comments or work notes on the record if the record has these journal fields.

You can use record feeds to:

- Improve communication between users working on the same record.
- Improve visibility into progress for end users.
- Provide a single place to see updates on multiple records.
- Save feed history in the record so that knowledge is not lost in an email chain.

### Live Feed integration

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Live Feed integration</td>
<td>Writes journal comments to the live feed if there is a group for this record.</td>
</tr>
</tbody>
</table>

**Note:** Many of these features are part of live feed v2.

### Activate live feed document

The Live Feed Document plugin is active by default.
About this task
Administrators can enable record feeds in an instance by activating the Live Feed Document plugin, which activates the Live Feed plugin, if it is not active. For upgrades, administrators must activate the plugin.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Configure record feeds
Configure a table to support record feeds. You can add the Show Live Feed button in the form header and add the UI actions Follow on Live Feed and Show Live Feed as List and Form.

By default, the Show Live Feed icon appears on the form header for all tables that extend task, including the Incident, Change Request, and Problem tables, and in the list and form context menus for all task tables.

Add live feed to a form header
Add the Live Feed button in the form header for a table.

Procedure
1. Type sys_properties.list in the Application Navigator.
2. Open the record for glide.live_feed.task_header_button.
3. In the Value field, change the value to both.
Note: By default, the value is `collaboration` so that the property is supported in the Collaboration (com.glide.collaboration) plugin. Changing the value to `both` allows the system property to be supported in Collaboration and Live Feed.

4. Click Update.

5. Navigate to System Definition > Tables.

6. Open the table record.

7. If the Live feed check box does not appear on the form, configure the form layout to add the Live feed field.

8. On the form, select the Live feed check box.

9. Click Update. Alternatively, you can add `live_feed=true` to the Attributes field in the dictionary entry for the table.

Results
The Live Feed button appears on the overflow menu of the form header.

Add live feed to a context menu
Add live feed UI actions on a table.

Procedure
1. Navigate to System Definition > UI Actions.
2. Open one of the live feed UI action, for example, Follow on Live Feed.
3. In the Table field, select the table name.
4. Right-click the header and select **Insert** to create a copy of the UI action for the desired table.

5. Repeat steps 1 – 4 for all live feed UI actions.

### Disable a record feed

You can disable live feed functionality from the form of any table.

**Before you begin**

Role required: personalize_dictionary or admin

**Procedure**

1. Navigate to **System Definition > Dictionary**.
2. Open the dictionary entry for the table.
3. Add `live_feed=false` in the **Attributes** field.
4. Click **Update**.

⚠️ **Note:** If the Collaboration feature is activated, you can remove the show live feed icon ( Emblem ) from all form headers. Set the `glide.live_feed.task_header_button` property to **collaboration**.

### Configure security

Record feeds honor the access control rules (ACLs) for the associated record. Users can only view messages on the record feed if they have access to the same information on the record. For example:

- If an ACL allows a user to read and create comments on an incident, then the user can view and add messages posted as comments on the incident feed.
- If an ACL restricts a user from reading work notes, then the user cannot view messages posted as work notes on the incident feed.

⚠️ **Note:** Access control rules are only checked when a user first accesses the record feed. After users view the feed, an administrator must remove them manually to change their access.

### Live feed table notifications

Live feed table notifications generate automatic live feed messages. The Live Feed plugin must be activated to use table notifications.
When a record is inserted or updated on a specific task table and the notification conditions are met, a message is generated and posted to the specified group or to the company feed. Table notifications are supported for all task tables and all task types by default.

Administrators and users with the live_feed_admin or chat_admin roles can set up table notifications for any table in an instance.

**Set up table notifications for task tables**
You can set up a table notification for a task table to enable automatic live feed messages.

**Before you begin**
Role required: live_feed_admin or chat_admin

**Procedure**
1. Navigate to **Live Feed > Feed Administration > Table Notifications**.
2. Click **New** or select a notification to open it.
3. Complete the form.

<table>
<thead>
<tr>
<th>Live Table Notification fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Table</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Post to chat rooms</td>
</tr>
<tr>
<td>Post to live feed</td>
</tr>
<tr>
<td>Record Feeds</td>
</tr>
<tr>
<td>Application</td>
</tr>
<tr>
<td>Active</td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td>Insert</td>
</tr>
<tr>
<td>Update</td>
</tr>
<tr>
<td>Feed</td>
</tr>
<tr>
<td>Conditions</td>
</tr>
<tr>
<td>Description</td>
</tr>
</tbody>
</table>
| Message   | Construct the automatic message you want to generate. You can include field values as variables and a link to the record. To add a variable, position the cursor in the text and then click the field name in the Select variables field. To add a link to the record, enter `${URI}` in the message text as shown in the following example.  

```plaintext
High priority incident opened: ${URI}  
Short description: ${short_description}
```

⚠️ **Note:** For security reasons, any HTML code is automatically stripped out of a message before it is posted. |
| Before script | Create a script that runs before a notification is generated. The script runs only if the condition evaluates to true or is empty. The following variables are available in the script.  

- `current`: the GlideRecord object that triggered the notification.  
- `changedFields`: an ArrayList of fields changed on submit. Use `changedFields.contains('fieldname')` to check for change.  
- `answer`: set answer to false to cancel the notification. |
### Field Description

- **profileSource**: set to a valid GlideRecord object to define the profile that is posting the message.
- **profileID**: set to a live_profile sys_id to define the profile that is posting the message; by default it is the current record. Overrides profileSource if both are specified.

Any custom variable created in the script is also exposed to the message in the form of `${myVariableName}`.

4. Click **Submit** or **Update**.

---

### Set up table notifications for non-task tables

Table notifications are supported for all task tables by default, and you can set up a table notification for any other table.

#### Before you begin

**Role required**: live_feed_admin or chat_admin

#### Procedure

1. Navigate to **System Definition > Business Rules**.

2. Open the **live feed events** business rule.

3. In the Advanced section, select and copy the text in the **Script** field.

4. Click the back arrow on the top, left to exit the record and return to the Business Rules list.

5. Click **New**.

6. Enter the following values at the top of the form.
   - **Name**: Enter a name, such as `live feed events for my table`.
   - **Table**: Select the table for which you are setting up a notification.
   - **Active** and **Advanced**: Select these check boxes.

7. In the **When to run** section, enter the following values.
   - **When**: Select `before`.
   - **Insert, Update, and Delete**: Select the check boxes.

8. In the **Advanced** section, paste the script from the **live feed events** business rule into the script box.

9. Click **Submit**.
The `live feed events` business rule runs on the non-task table. It fires the `live_feed.update` event, which is associated with the `Live Feed Update` script action. The script action sets up variables and processes the table notifications.

**What to do next**
After saving the business rule, create a `live feed table notification record` for the new table as you would for a task table.

**Live feed table notification examples**
The following examples demonstrate how to set up different types of table notifications that are useful for live feed.

**Workaround posted**
This example demonstrates a table notification that generates an automatic message on live feed whenever a workaround is added to an open problem.

- **Table**: Problem [problem]
- **Active**: Select the check box.
- **Update**: Select the check box.
- **Post to live feed**: Select the check box.
- **Conditions**: [State] [is] [Open]
- **Description**: Workaround Posted
- **Message**:

  ```
  ${sys_updated_by} posted a workaround for ${URI}.
  Short description: ${short_description}
  ```

- **Before script**:
// only post to live feed when the Workaround field changes
answer = changedFields.contains("work_around");

Example workaround message

Related information
Live feed table notifications

Problem resolved (advanced)
This advanced example demonstrates a table notification that generates an automatic message on live feed whenever a problem is closed.

It also adds a message about the assigned user and posts the message from the assignment group profile instead of the problem record.

- **Table:** Problem [problem]
- **Active:** Select the check box.
- **Update:** Select the check box.
- **Post to live feed:** Select the check box.
- **Conditions:** [Problem State] [is] [Closed/Resolved]
- **Description:** Problem Resolved
- **Message:**

```plaintext
Problem ${number} - ${short_description} has been resolved. ${fixedByMsg}
```

- **Before script:**

```plaintext
//cancel if we didn't just change the problem state if (!changedFields.contains("problem_state") )
```
answer = false;

//if we have an assigned_to value add a comment about who it was //create a new variable fixedByMsg that we can access from the message
fixedByMsg = "" ; if ( !current. assigned_to. nil() )
fixedByMsg = "Thank you " + current. assigned_to. getDisplayValue() ;

//make the message appear to come from the assignment group if we have one if (( !current. assignment_group. nil() )
profileSource = current. assignment_group. getRefRecord() ; //need GlideRecord object

Example problem resolved message

Related information

Live feed table notifications

Opportunity won (non-task)

This example demonstrates a table notification on a non-task table. It generates an automatic message on live feed whenever a sales opportunity is won, if you have activated the Sales Force Automation plugin.

Create a business rule on the Opportunity [sales_opportunity] table that matches the live feed events business rule on the task table.

Create a table notification with the following values:
• **Table:** Opportunity [sales_opportunity]
• **Active:** Select the check box.
• **Update:** Select the check box.
• **Post to live feed:** Select the check box.
• **Conditions:** [State] [is] [Closed Won]
• **Description:** Opportunity won
• **Message:**

```plaintext
${owner} closed a sale with ${account}!
```

• **Before script:**

```plaintext
//make the message appear to come from the assigned salesperson if there is one if
(!current. owner. nil ( ));
profileSource = current. owner. getRefRecord (); //need GlideRecord object
```

---

**Example opportunity won message**

---

**Related information**

**Live feed table notifications**

**Related feeds table notification**

This example demonstrates table notifications to be sent out to related feeds.

For this example, whenever the status of a story changes to **Complete**, a table notification message is sent to the related sprint, release, or epic. Messages are posted only if the related feed already exists; this notification does not create a new feed.
• **Table:** Story [rm_story]
• **Active:** Select the check box.
• **Update:** Select the check box.
• **Post to live feed:** Select the check box.
• **Record feeds:** Move Sprint, Release, and Epic to the Selected column.
• **Conditions:** [State] [changes to] [Complete]
• **Description:** Story is done; message to Epic, Release, and Sprint
• **Message:**

```python
${URI} status changed to ${state}
```

**Live feed security and table access**

By default, administrators and users with the live_feed_admin role can configure live feed security and view all live feed tables.

You can also modify the following live feed tables.

• **Live Table Notification [live_table_notification]:** set up automatic messages that are generated when specific records are updated throughout the system.

• **Live Feed Message [live_message]:** modify only if necessary, such as to delete an inappropriate message or restore a message that a user accidentally deleted. This table is typically managed by system functionality.

Extending or modifying data in any live feed chat table is not recommended.

**Domain separation in Live Feed**

This is an overview of domain separation and Live Feed. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Overview**

**Support: Level 2**

Parent and child domains define the live feed content that can be viewed and shared with other users.
• A user in a parent domain can see users and content within their domain and within all child domains that are lower in the domain hierarchy.

• A user in a child domain can see users and content within their domain but cannot see the parent domain or other child domains at the same level in the domain hierarchy.

Enable domain separation for live feed

Domain separation for the Live Feed application is available starting with the Eureka release. For users upgrading to Eureka, a sys_domain column is added to existing live feed-related database tables. For existing database records, the value of the sys_domain field is set to empty (global). This allows the domain separation feature to work with existing live feed records.

Show or hide the live feed application for a domain

The administrator can live feed visibility for a domain. This includes:

• Displaying live feed in the application navigator.

• Following a document feed for a record.

• Viewing live feed from a record.

Use live feed with domain separation

All of the live feed features are available to users within a domain and work the same way, with some exceptions to visibility.

• Posting and sharing content
  ◦ Users in a child domain can interact with other users in the same domain. This includes posting and replying to messages, deleting messages, attaching files and links, and rating content.
  ◦ Users in a parent domain can interact with other users in the same domain and with users in any child domains. Messages that are added to child threads by parent users are given the visibility of the child domain, not the parent domain.

• Viewing content
• Users in a child domain can view content that resides within their domain. This includes filtering by feed, sorting, searching, and viewing older messages.
• Users in a parent domain can view content that resides within their domain and within any child domains.
• My Feed shows messages, teams, and hashtags based on the user's domain. Showing another user's feed only shows posts visible in the current user's domain.

• Using hashtags
  • Hashtags are separated by domain. Users in a child domain can use all of the hashtag functions within their domain. This includes tagging messages, viewing available hashtags, changing hashtag names, and searching and filtering by hashtag.
  • Users in a parent domain can use all of the hashtag functions within their domain and can see hashtags in any child domains.

• Using teams
  • Teams are separated across domains. Users in a child domain can join and follow teams within their domain, and can invite other users within their domain to join teams.
  • Users in a parent domain can join and follow teams that belong to their domain or to any child domains.

• Exceptions to teams
  • New teams are created in the user's domain. However, if the team has a record associated with it, the team is created in record's domain.
  • New threads in an existing team are created in the domain of the existing team.
  • When a user is creating a new team from a document, if the document domain is not empty or global, the team domain needs to be changed to be the document's domain.
  • For a document-generated team, when the domain of the document changes, the domain of all related live feed records changes as well.

• Subscribing to email notifications
  • Users can subscribe to email notifications from users and teams within their domain only.
Related reference
Live feed security and table access
Live feed team security
Restrict hashtag renaming

Related information
Limit live feed access by role
Manage live feed message content
Domain separation

Limit live feed access by role
All active users in the instance have access to live feed by default.

Before you begin
live_feed_admin and admin

Procedure
1. Complete the following steps to define the roles that allow users to see the Live Feed module.
   a. Perform the appropriate action for your version of the UI:
      • UI16: Navigate to System Definition > Application Menus > Live Feed and select Live Feed.
      • UI15: Right-click the icon beside the Live Feed module and select Edit Module.
   b. Enter the roles that have access in the Roles field.
   c. Click Update.
2. Complete the following steps to define the roles that allow users to see live feed from a mobile device.
   a. Navigate to System Definition > Applications (Mobile).
   b. Click Live Feed.
   c. Enter the roles that have access in the Roles field.
   d. Click Update.
3. Use the following settings in the Access Control form to create access control rules to limit who can view the live_feed pages.
• **Type**: ui page
• **Operation**: read
• **Name**: create one access control rule record for each of the following pages
  ◦ live_feed
  ◦ live_feed_small
  ◦ $live_feed
  ◦ $live_feed_small
• **Requires role**: in this related list, add roles to define who can access the live feed pages. Users who do not have these roles cannot access live feed.

**Manage live feed message content**

Users can remove their own messages from feeds. If necessary, administrators can remove inappropriate messages that are posted by any user.

**Before you begin**
live_feed_admin and admin

**About this task**
For security reasons, any HTML code is automatically stripped out of a message before it is posted. This measure ensures that users cannot modify any page settings by posting a message.

**Procedure**
1. Navigate to **Live Feed > Feed Administration > Messages**.
2. Open the message to be removed.
3. In the **State** field, select **deleted**. You may need to configure the form to add this field.
4. Click **Update**.

**Live feed team security**
You can restrict who can create teams by modifying an access control rule.

Modify the following access control rule.
• **Table**: Live Group Profile [live_group_profile]
• **Operation**: create
Restrict hashtag renaming
You can restrict who can rename hashtags.

You restrict hashtag rename by modifying the following access control rule:
• **Table**: Live Tag [live_tag]
• **Operation**: write

Provide access to live feed from CMS pages
You can provide access to live feed from pages built in the Content Management System (CMS). For example, allow an end user to access your company feed via the ESS portal.

**Before you begin**
Role required: content_admin or admin

**About this task**
The ESS Portal template includes the **Portal - Live page** and **Live Feed** dynamic blocks. To provide access to live feed from CMS pages, add the Live Feed dynamic block to a CMS page or include **Portal - Live page** in a site.

**Procedure**
1. Navigate to **Content Management > iFrames**.
2. Click **New**.
3. Enter the iFrame block details.

### iFrame block fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name such as <em>Live Frame</em>.</td>
</tr>
<tr>
<td>Frame Name</td>
<td>Enter a frame name, such as <em>live_frame</em>.</td>
</tr>
<tr>
<td>URL</td>
<td><a href="https://INSTANCE/live_feed.do?sysparm_doctype=true">https://INSTANCE/live_feed.do?sysparm_doctype=true</a> where INSTANCE is your instance URL (example, [instance name].service-now.com)</td>
</tr>
<tr>
<td>Application</td>
<td>Displays scoping information.</td>
</tr>
</tbody>
</table>
**Field** | **Description**
---|---
Sizing | Select **Fixed Size** and enter height and width pixel dimensions according to the page where you plan to display the feed (for example, width of 1024 and height of 768).

4. Click **Submit**.
5. Add the block to a page.

**Related information**
- Administer live feed
- Content Management System

**Components installed with live feed**
Several types of components are installed with Live Feed.
Demo data is available with Live Feed.

**Tables installed with live feed**
Live Feed plugin installs the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link attachments</td>
<td>Stores links and attachments that are added to messages.</td>
</tr>
<tr>
<td>[live_link]</td>
<td></td>
</tr>
<tr>
<td>Live Favorite</td>
<td>Stores the favorite conversations, user groups, and messages.</td>
</tr>
<tr>
<td>[live_favorite]</td>
<td></td>
</tr>
<tr>
<td>Live Feed Searches</td>
<td>Stores live feed text searches. Access at Live Feed &gt; Feed Administration &gt; Search Log.</td>
</tr>
<tr>
<td>[live_feed_search]</td>
<td></td>
</tr>
<tr>
<td>Live Follows</td>
<td>Maintains users' follow preferences for user feeds.</td>
</tr>
<tr>
<td>[live_follow]</td>
<td></td>
</tr>
<tr>
<td>Live Group Profile</td>
<td>Stores conversation properties, including name, description, and public status. Also stored are user group properties, such as name, description, and public status.</td>
</tr>
<tr>
<td>[live_group_profile]</td>
<td></td>
</tr>
<tr>
<td>Live Group Member</td>
<td>Maintains the member lists for conversation and user group.</td>
</tr>
<tr>
<td>[live_group_member]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Live Mention [live_mention]</td>
<td>Stores the profiles mentioned in a message. References sys_user table.</td>
</tr>
<tr>
<td>Live Message Tag [live_message_tag]</td>
<td>Stores messages associated with user-created tags. Appears as a related list on Live Tag records.</td>
</tr>
<tr>
<td>Live Messages [live_message]</td>
<td>Stores messages. References sys_user table. Access at <strong>Live Feed &gt; Feed Administration &gt; Messages</strong>.</td>
</tr>
<tr>
<td>Live Poll [live_poll]</td>
<td>Stores a poll question.</td>
</tr>
<tr>
<td>Live Poll Cast [live_poll_cast]</td>
<td>Stores profiles of users who voted for a particular option in a poll.</td>
</tr>
<tr>
<td>Live Poll Options [live_poll_option]</td>
<td>Stores poll options.</td>
</tr>
<tr>
<td>Live Profiles [live_profile]</td>
<td>Stores user live feed profiles. References sys_user table. Access at <strong>Live Feed &gt; Feed Administration &gt; Profiles</strong>.</td>
</tr>
<tr>
<td>Live Table Notification [live_table_notification]</td>
<td>Generates automatic table notifications, such as when a user reads live feed for the first time and when a high priority incident is opened. Access at <strong>Live Feed &gt; Feed Administration &gt; Table Notifications</strong>.</td>
</tr>
<tr>
<td>Live Tag [live_tag]</td>
<td>Maintains user-created tags. Access at <strong>Live Feed &gt; Feed Administration &gt; Tags</strong>.</td>
</tr>
<tr>
<td>Messages Liked by [live_message_like]</td>
<td>Maintains like ratings for posts. Access at <strong>Live Feed &gt; Feed Administration &gt; Likes</strong>.</td>
</tr>
</tbody>
</table>

**User roles installed with Live Feed**

Live Feed plugin installs the following user roles.
### Role and Description

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>live_feed_admin</td>
<td>Can manage live feed functions. For example, users with the live_feed_admin role can:</td>
</tr>
<tr>
<td></td>
<td>• Set up table notifications for task tables.</td>
</tr>
<tr>
<td></td>
<td>• Set up table notifications for non-task tables.</td>
</tr>
<tr>
<td></td>
<td>• Limit live feed access by role.</td>
</tr>
<tr>
<td></td>
<td>• Manage live feed message content.</td>
</tr>
<tr>
<td>chat_admin</td>
<td>Can manage chat functions (if the Chat plugin is activated).</td>
</tr>
<tr>
<td></td>
<td>For example, users with the chat_admin role can:</td>
</tr>
<tr>
<td></td>
<td>• Change chat room message read access.</td>
</tr>
<tr>
<td></td>
<td>• Define chat room access rights.</td>
</tr>
</tbody>
</table>

### Script includes installed with Live Feed

Live Feed plugin installs the following script includes.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LiveMsgUtil</td>
<td>Provides helper functions for working with live_message records.</td>
</tr>
<tr>
<td>LiveFeedFilter</td>
<td>Queries filters for working with live_feed records.</td>
</tr>
<tr>
<td>LiveFeedUtil</td>
<td>Provides helper functions for working with live_feed records.</td>
</tr>
</tbody>
</table>

### Business rules installed with Live Feed

Live Feed plugin installs the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feed Group Creator Becomes Admin</td>
<td>Live Group Profile</td>
<td>Designates the group creator as the group administrator.</td>
</tr>
<tr>
<td></td>
<td>[live_group_profile]</td>
<td></td>
</tr>
<tr>
<td>live feed events</td>
<td>Task</td>
<td>Runs on task insert, update, and delete. Triggers event associated with the Live Feed Update Script action</td>
</tr>
<tr>
<td></td>
<td>[task]</td>
<td></td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Live feed member update events</td>
<td>Live Group Member</td>
<td>Generates a notification event when member state changes (invited, accepted,</td>
</tr>
<tr>
<td></td>
<td>[live_group_member]</td>
<td>declined, left, rejected, request, request_accepted).</td>
</tr>
<tr>
<td>Live feed integration</td>
<td>Journal Entry [sys_journal_field]</td>
<td>Writes journal comments to the live feed if there is a group for this record.</td>
</tr>
<tr>
<td>Live feed new member events</td>
<td>Live Group Member</td>
<td>Generates a notification event when new members are added.</td>
</tr>
<tr>
<td></td>
<td>[live_group_member]</td>
<td></td>
</tr>
<tr>
<td>Live feed profile events</td>
<td>Live Profile [live_profile]</td>
<td>Runs on live_profile insert/update/delete, triggers event associated with</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the Live Feed Update script action that processes Live Table Notifications</td>
</tr>
<tr>
<td></td>
<td></td>
<td>to auto-generate live feed messages.</td>
</tr>
<tr>
<td>Live Feed message events</td>
<td>Live Feed Message</td>
<td>Runs on live_message, notification event trigger for new live messages.</td>
</tr>
<tr>
<td></td>
<td>[live_message]</td>
<td></td>
</tr>
<tr>
<td>Live message like events</td>
<td>Message Liked by [live_message_like]</td>
<td>Runs on live_message_like, notification event trigger for new like records.</td>
</tr>
<tr>
<td>LiveFeed Group Member Visibility 2.0</td>
<td>Live Group Member</td>
<td>Ensures users can only see the members list for public groups and groups the user belongs to.</td>
</tr>
<tr>
<td></td>
<td>[live_group_member]</td>
<td></td>
</tr>
<tr>
<td>LiveFeed Group Profile Validation</td>
<td>Live Group Profile</td>
<td>Ensures that a public group is visible.</td>
</tr>
<tr>
<td></td>
<td>[live_group_profile]</td>
<td></td>
</tr>
<tr>
<td>LiveFeed Group Profile Visibility 2.0</td>
<td>Live Group Profile</td>
<td>Ensures that the list of all groups only displays public groups, private groups that are visible, and groups the user belongs to.</td>
</tr>
<tr>
<td></td>
<td>[live_group_profile]</td>
<td></td>
</tr>
</tbody>
</table>
## Business rule

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LiveFeed Membership Changes</td>
<td>Live Group Member [live_group_member]</td>
<td>Enforces that only the group administrator and users with live_feed_admin role can manage membership for a group.</td>
</tr>
<tr>
<td>LiveFeed Single Group Membership</td>
<td>Live Group Member [live_group_member]</td>
<td>Ensures that a user is not added multiple times to the same group.</td>
</tr>
<tr>
<td>Live Message Likes</td>
<td>Live Message Like [live_message_like]</td>
<td>Updates the number of likes for a message.</td>
</tr>
<tr>
<td>LiveFeed Join Group Check</td>
<td>Live Group Member [live_group_member]</td>
<td>Ensures that users can not automatically join private visible groups.</td>
</tr>
<tr>
<td>Update Follow/Follower Counts</td>
<td>Live Follow [live_follow]</td>
<td>Updates the following/followers counts.</td>
</tr>
<tr>
<td>Live Feed Group</td>
<td>Assessable Record [asmt_assessable_record]</td>
<td>Creates/Deletes a live feed group for an assessable record</td>
</tr>
<tr>
<td>Live Feed Message Visibility</td>
<td>Live Feed Message [live_message]</td>
<td>Ensures user's access to live feed messages</td>
</tr>
</tbody>
</table>

### Email notifications installed with Live Feed

Live Feed plugin installs the following email notifications.

<table>
<thead>
<tr>
<th>Email notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Live Feed Feed Member Accepted</td>
<td>Sends an email to the administrator when a user has accepted to join the feed.</td>
</tr>
<tr>
<td>Live Feed Feed Member Declined</td>
<td>Sends an email to the administrator when a user has declined to join the feed.</td>
</tr>
<tr>
<td>Live Feed Feed Member Invited</td>
<td>Sends an email to a user when they have been invited to join a feed.</td>
</tr>
<tr>
<td>Email notification</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Live Feed Feed Member Left</td>
<td>Sends an email to the administrators when a user has left the feed.</td>
</tr>
<tr>
<td>Live Feed Feed Member Removed</td>
<td>Sends an email to user when they have been removed from the feed.</td>
</tr>
<tr>
<td>Live Feed Feed Member Request</td>
<td>Sends an email to administrators when an user requests to join a feed.</td>
</tr>
<tr>
<td>Live Feed Feed Member Request Accepted</td>
<td>Sends an email to the user when their request to join a feed is accepted.</td>
</tr>
<tr>
<td>Live Feed Feed Request Rejected</td>
<td>Sends an email to the user when their request to join a feed has been rejected by an administrator.</td>
</tr>
<tr>
<td>Live Feed MsgReply Subscription</td>
<td>Sends an email when a reply or reply_to_reply message is inserted into the thread of a message in a feed.</td>
</tr>
<tr>
<td>Live Feed Team Member Accepted</td>
<td>Sends an email to administrators when a user accepts an invitation to join a team.</td>
</tr>
<tr>
<td>Live Feed Team Member Declined</td>
<td>Sends an email to administrators when a user declines an invitation to join a team.</td>
</tr>
<tr>
<td>Live Feed Team Member Invited</td>
<td>Sends an email when a user is invited to join a team.</td>
</tr>
<tr>
<td>Live Feed Team Member Left</td>
<td>Sends an email when a user leaves a team.</td>
</tr>
<tr>
<td>Live Feed Team Member Removed</td>
<td>Sends an email when an administrator has removed a user from a team.</td>
</tr>
<tr>
<td>Live Feed Team Member Request</td>
<td>Sends an email when a user requests to join a team.</td>
</tr>
<tr>
<td>Live Feed Team Member Request Accepted</td>
<td>Sends an email when a user's request to join a team is accepted.</td>
</tr>
<tr>
<td>Live Team Member Request Rejected</td>
<td>Sends an email when a user's request to join a team is rejected.</td>
</tr>
<tr>
<td>Live Message All Subscription</td>
<td>Sends an email to subscribed users when any message (new or reply) is posted.</td>
</tr>
</tbody>
</table>
### Use Live Feed

Live Feed provides many methods you can use to share content with others in your organization.

Depending on your role, there are several different types of feeds you can access, teams you can join and share information with, and hashtags you can use for categorizing messages.

<table>
<thead>
<tr>
<th>Email notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Live Message Feed Subscription</td>
<td>Sends an email when a new message is inserted into a feed.</td>
</tr>
<tr>
<td>Live Message Liked</td>
<td>Sends an email to the creator of a message when another user likes the message.</td>
</tr>
<tr>
<td>Live Message Mention</td>
<td>Sends an email to a user when that user is mentioned in a message.</td>
</tr>
<tr>
<td>Live Message New Posts Subscription</td>
<td>Sends an email to subscribed users when a new (not reply) message is posted.</td>
</tr>
<tr>
<td>Live Message Reply</td>
<td>Sends an email to all users in a feed thread when a user posts a reply (live_message.replied event).</td>
</tr>
</tbody>
</table>

#### Example image

**Company Feed**

- **System Administrator**
  - Shared message: "We're considering using Live Feed to replace #Lync for collaboration. Thoughts?"
  - Hashtags: #Applicatio... #IT support...
  - Attachments: Solution set.xlsx
  - Links: Check out the Wiki article!

**Feed Summary**

- **Users**
  - System Administrator
  - People
  - Teams

- **Hashtags**
  - MacBook
  - SSO
  - Email
  - SAP

- **Record Feeds**
  - People
  - Teams

- **Group Feeds**

- **My Live Feeds**
  - System Administrator
  - Company Feed
  - Group Feeds

- **Hashtags**
  - #MacBook
  - #SSO

- **System Administrator**
  - Shared message: "Now it is working fine."
  - Hashtags: #Copy Link #Hashtags (1) #Comment

- **System Administrator**
  - Shared message: "It's working fine."
  - Hashtags: #Copy Link #Comment
Note: Live Feed v2 is active for all new instances by default. If you are upgrading from an earlier version of ServiceNow, you need to activate Live Feed v2 to use these features.

Use hashtags in Live Feed

Hashtags are words marked with a hash symbol (#) in messages. Hashtags are a way to categorize messages by keyword or topic for improved search results.

For example, to identify messages associated with VPN questions, add the hashtag #VPN in the message text.

Note: Many of these features are part of live feed v2. If you are using live feed v1, or have not activated live feed v2, see Legacy Live Feed.

Tag messages

To tag a keyword or topic in a message, enter a # symbol before the word. A link to the hashtag is added beneath the message and all feed users can search and filter by the hashtag to find the message.

Tips for using hashtags effectively include:

• Limit the number of hashtags per message (no more than 3 is a good guideline).

• Use hashtags only in messages that are relevant to the tagged topic.

• Write a message first, and then add hashtags only if they add value. Answer the question, "What are you working on?", rather than "What hashtags apply to what you are working on?"

• Use camel case to create a hashtag that is more than one word long. For camel case, remove the space and use an uppercase letter to start each word. For example, to create a topic about the service desk, use #ServiceDesk.
View an available hashtag
View a hashtag from any feed.

Procedure

1. Navigate to Live Feed > Live Feed.
2. Click Hashtags in the sidebar.
   Any hashtags already defined are displayed. Up to 36 hashtags can be displayed, and options are available for searching and sorting the hashtags. When searching, you do not need to include the hash symbol (#).

3. Click a hashtag to view all messages containing that hashtag.

Change a hashtag name and merge a hashtag
Over time, users may create many hashtags with similar names, such as competitive, competitor, and competition. To combine hashtags for better searching and filtering, change the names of similar hashtags to a standard name.
About this task
Administrators can restrict who can rename hashtags.

Procedure

1. Navigate to Live Feed > Live Feed.
2. Click Hashtags in the sidebar to reveal the currently defined hashtags.
3. Turn off the filter to show all hashtags.
4. Point to the hashtag you want to change. If you have the rights to edit hashtags, an edit tag (📝) appears.
5. Click the edit tag icon.

6. Enter a new hashtag name.
7. Press Enter.

• If the new name is different than the other hashtags, the new hashtag name replaces the old hashtag name on the list and in the text of any messages that include the hashtag.

• If the name is the same as one of the existing hashtags, the hashtags will be merged. For example, if you have two hashtags called Competitive and Competitors, and you change the name of Competitors to Competitive, all of the messages previously tagged Competitors are changed to Competitive and the Competitors hashtag is removed.

Note: If a hashtag is removed from the message, renaming that hashtag does not change the message text.

Add an image to a hashtag
You can add an image at the domain level of already defined hashtags if you have the admin role.
Procedure
1. Click Hashtags in the sidebar.
2. Select the appropriate hashtag.

3. Do one of the following:
   - Locate the image in your file system, and then drag-and-drop the image onto the add an image icon ((icon).
   - Click the add an image icon (icon), select the image file, and click Open.

4. To change the image, simply drag-and-drop a new image onto the old one, or click on the existing one and select a new image.
   When you view a message that contains a hashtag with an image, that image appears in the hashtag heading bar.

Follow and unfollow a hashtag
You can view all postings assigned a specific hashtag by following the hashtag. You can also unfollow the hashtag if you no longer want to view those postings.
Procedure
1. Navigate to Live Feed > Live Feed.
2. Click Hashtags in the sidebar.
3. Select the hashtag you want to follow.
4. Click Follow.

Follow tag

A confirmation message appears.
5. Click X to dismiss the message.
   To unfollow a hashtag, repeat the same steps and click Unfollow.

Bookmark hashtags

The live feed interface uses the standard bookmarking functionality for hashtags.
In UI15, the live feed interface uses the standard bookmarking functionality for hashtags. You can drag-and-drop group feeds and hashtags from the Feed Summary section to the Edge for quick access.
Remove a hashtag from a posted message

As a participant in a conversation, you can remove hashtags from messages that have already been posted.

Procedure

1. Navigate to the posted message.
2. Click Hashtags in the message posting.

Hashtag in post

Pat Hoshaw #Lync is more difficult to use. We need Live Feed for easier tagging and following. Plus, groups in Live Feed rock! Thanks IT!
2 years ago • Like • Reply • Hashtags (1)

The hashtags associated with the message are displayed, along with the removal icon.

Remove tag

Pat Hoshaw #Lync is more difficult to use. We need Live Feed for easier tagging and following. Plus, groups in Live Feed rock! Thanks IT!
2 years ago • Like • Reply • Share • Tags (1)

3. Click the removal icon.

Use teams in Live Feed

Users can be combined into teams for the purpose of subscribing to specifically-focused feeds.
Teams can be created based on any criteria that makes sense for your organization. For example, you can create a team called IT Developers and subscribe the team to feeds such as Coding Standards, AngularJS Development, and ServiceNow Customization Best Practices. When a new developer is added to the IT Developers team, that user automatically has rights to participate in all of the feeds followed by the team.

Create a live feed team
When you create a team, you become the team administrator.

About this task
As team administrator, you can:

• Modify team properties
• Accept or reject membership requests
• Remove members from the team
• Delete the team

Procedure
1. Navigate to Live Feed > Teams.
2. In the sidebar, click your profile picture, then select the Teams tab.

3. Click Create Team.
4. Enter a **Name** to appear at the top of the feed and in messages posted to the team. This name links to the team feed.

5. Enter a **Description** to appear at the top of the feed and under the team name in the list of all teams.

6. Select the access level for the team:

   - **Public Team**: In the list of all teams, any user can see the name of this team. Any user can also see the feed and join the team. Messages in a public team appear in the Company Feed with a link to the team feed.

   - **Private Team**: In the list of all teams, any user can see the name of this team, but not the feed. Messages in private teams do not appear on the Company Feed.

   When **Private Team** is selected, the **Show this team for anyone to find and request to join** check box is displayed. Select this check box to allow any user to search for this team and request to join it. Clear the check box to allow only invited users to see the feed and join the team.

7. Click **Create**.
   The team is created with you as the team administrator.
A team administrator can create one or more group feeds specifically for the members of this team by clicking the Group Feeds tab and Create Group Feed. Additionally, the team can be invited to join a feed. Having multiple feeds for the team facilitates focused discussions on topics of interest to the team and allows the team to selectively invite other teams and members to collaborate on specific feeds.

Automatic team creation
If you create a record on a table that has live feed enabled, such as the Incident table, and click Follow/Show Live Feed for the record, a record feed is created for the record.

The record feed name is based on the table name.

Join a team
You can join a public team, accept an invitation, or request access to a team.

About this task
As a team member, you can:

- View messages posted to the team (team feed). Non-members can also view the feed for a public team.
- View a list of team members.
- Invite another team to join the team.
• Subscribe to team email notifications.
• Leave the team.

Procedure
1. Navigate to Live Feed > Live Feed.
2. Click Teams and click All Teams.
   • If you received an invitation, click Accept. You can Decline the invitation if you do not want to join the team.
   • If the team is public, click Join.
   • If the team is private, click Request. The team administrator receives an email notification and must accept your request before you can join the team.

View a team feed
View a team feed to see messages belonging to that team.

Procedure
1. Navigate to Live Feed > Live Feed.
2. In the sidebar, click your profile picture, then select the Teams tab.
   • To view a team you belong to, select the team name.
   • To view a public team you do not belong to, select All Teams and then click the team name.
     You must be a member to view the feed for a private team.

View a team member
View a list of members belonging to a live feed team.

Procedure
1. Navigate to Live Feed > Live Feed.
2. In the sidebar, click your profile picture, then select the Teams tab.
3. From the team list, select the team name.
   You must be a member of the team to view the members.
4. Click **Members**.
   The list of team members appears, organized by team administrators and team members.

**Invite a new member**

You can invite another user to join a team.

**Procedure**

1. Navigate to **Live Feed > Live Feed**.
2. In the sidebar, click your profile picture, then select the **Teams** tab.
3. From the team list, select the team name.
4. Click the **Pending members** tab.
5. In the **Add User** field, enter the name of the user you want to invite. The invited member's picture appears.

**Remove a member**

If you are team administrator, you can remove any member from the team.
Procedure

1. Navigate to Live Feed > Live Feed.
2. In the sidebar, click your profile picture, then select the Teams tab.
3. From the team list, select the team name.
4. Click the Members tab.

5. Click Remove below the member name.
6. Click Remove again in the confirmation box that opens.

Note: You can remove members regardless of their current state. That is, you can remove members who have already joined the team or whose membership is pending.

Subscribe to team and email notification

Users can subscribe and unsubscribe to receive email notifications generated by feeds the team participates in.

About this task

Email notifications are generated whenever actions such as posting messages, replies, likes, polls, and @mentions are performed.

All notifications related to a top-level message, such as replies, mentions, and likes, are sent out with the same subject. The subject line defaults to Live Feed followed by the beginning of the subject line from the top-level message. For example, if the subject of the feed is IT Support, the email notification's subject will be Live Feed IT Support.
Procedure

1. Navigate to **Live Feed > Live Feed**.
2. Click **Teams** and select the team name.
3. Click the subscribe icon ( ).
   
   You can click the unsubscribe icon ( ) to stop receiving email notifications.

Subscribe a team to feed notification

A team administrator can subscribe a team to specific feeds so the members of the team receive email notifications.

Procedure

1. Navigate to **Live Feed > Live Feed**.
2. Click **Teams** and select the team name. You can use the advanced search to locate team of which you are the administrator.
3. Click **Feeds**.
4. Click the subscribe icon ( ) beside the feed name.
   
   You can click the unsubscribe icon ( ) to stop receiving email notifications.

Reply to email notifications using email

After receiving an email about a posted message or a reply, you can reply to live feed with your email client.

The body of the reply email becomes a reply to the live feed message. Any attachments included in your reply email are included in the live feed reply.

Leave a team

You can give up membership to a team by leaving that team.

Procedure

1. Navigate to **Live Feed > Live Feed**.
2. In the sidebar, click your profile picture, then select the **Teams** tab.
3. Click **Leave** beside the team name.
Modify a team
If you are team administrator, you can modify an existing team.

Procedure
1. Navigate to Live Feed > Live Feed.
2. In the sidebar, click your profile picture, then select the Teams tab.
3. From the team list, select the team name.
4. Click the edit icon (Edit).
5. Modify the team properties as needed.
6. Click Save.

Manage a membership request
When a user requests membership to a private team, the team administrator receives an email.

About this task
If you are the team administrator, you can manage membership requests.

Procedure
1. Navigate to Live Feed > Live Feed.
2. Click Teams and select the team name.
   If one or more users have been invited to the team, the Pending members tab shows the number of invitations sent.

Pending members

Finance
Select members of finance group to discuss confidential information

<table>
<thead>
<tr>
<th>Members</th>
<th>Pending members</th>
<th>Feeds</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Administrators

System Administrators
3. Click **Pending members**.
This shows the users who have received invitations, but who have not yet accepted.

3. Click **Pending members**.
This shows the users who have received invitations, but who have not yet accepted.

4. You can cancel a user's invitation by clicking **Remove**.

5. You can invite another user to the team by entering their name in the **Add user** field and clicking the Invite member (➕) button.

**Delete a team**
If you are the team administrator, you can delete a team.

**Procedure**
1. Navigate to **Live Feed > Live Feed**.
2. In the sidebar, click your profile picture, then select the **Teams** tab.
3. From the team list, select the team name.
4. Click the edit icon (📝).

5. Click **Delete**.

6. Click **Yes** to confirm deletion.
The team is deleted from live feed. Messages posted to a private team are deleted; messages posted to a public team remain on the company feed without a team link.

If you delete a team that is associated with an active record, such as an incident that has not yet been closed, the team becomes active again when any user modifies that record or follows the record on live feed. The first user who modifies the record becomes the team administrator. The previous messages that existed as part of the record feed are not deleted.

**Use live feed to work on records**

A record feed is associated with a record, such as an incident or change. Record feeds help users collaborate on records by providing a place for anyone who can access the record to share messages and post attachments specific to that record.

With record feeds, users can:

- Follow record feeds and post messages in live feed. These messages can also be automatically maintained in the comments or work notes journal fields on records.
- View live feed from records.
- Work on multiple records from **My Feed**.
- Access live feed team functions, such as sending invitations and subscribing to email notifications.

Any users with access to the record can also use the record feed. By default, record feeds are available on the incident, change, and problem tables. Administrators can configure record feeds for additional tables.
How Document Feeds Work
The Live Feed application creates a document group for each document feed. The document group:

• Automatically approves membership for every user who can access the record.
• Uses the record number as the group name.
• Uses the record short description as a group description.
• Maintains all messages posted on the record in live feed (if the record has a journal field for comments). When the group is created, existing messages are added to the document feed.
• Lists the group when users select View all groups on their live feed interface, unless the record associated with the document feed has been closed. When the state of the record is closed, the live feed group becomes inactive and unlisted.
• Automatically adds users to the document group when they view the record.

Document Group Creation
When a user follows or shows a record on live feed, a live feed group is automatically created and associated to the record (if one does not already exist). The user becomes a member of the group and can use live feed to work on the record. If the user can access work notes on the record, the user also becomes a group administrator.
A live feed group is also automatically created when a user creates a record on a table that uses document feeds, such as the Incident table. The user who creates the record becomes the administrator of the group, and any other user who modifies the same record automatically joins the group.

Add Live Feed to a homepage

Add live feed to a homepage so it is the first thing you see when you log in.

Procedure

1. Click Add content at the top of the homepage.
2. Select Live Feed in the left panel.
3. On the bottom of the window, click Add here in the appropriate layout position, then close the window.

Note: Administrators can add live feed to a global homepage to make it available for all homepage users by default. By default, users with any role can add live feed to their homepage. Administrators can restrict this ability.
Modifying and deleting document feeds

The user who creates a record feed becomes the group administrator, which allows the user to modify the following record feed properties.

- **Name**: default value is the record number.
- **Description**: default value is the record short description.
- **Picture**: default value is a thumbnail image of the record.

Feed administrators can also delete the feed. When deleted, the feed is removed from live feed but messages remain in the journal field of the associated record.

Viewing Live Feed from records

Interact with the record feed in any form that has live feed enabled.

The record feed appears in a pop-up window. The record feed also appears on the record form's activity formatter if the administrator enables the record feed system property (glide.ui.show_live_feed_activity).

To access a record feed from the form, do one of the following:

- Click the **Show Live Feed** button in the form header. This displays the live feed pop-up.
- Right-click the form header and select **Show Live Feed**. This also displays the live feed pop-up.
- Scroll down to the activity formatter area on the form. Click one of the following tabs:
Live Feed: click to show a text box to type in the feed.

Activity: click to show the activity summary. The activity filter determines the content in the activity summary.

Live Feed Popup

If the activity formatter or the Live Feed and Activity tabs are not visible, administrators can do the following:

- Configure the form layout and add Activities (filtered) to the form. This adds the activity formatter.
- Personalize the form layout and add Activities (filtered) to the form. This adds the activity formatter.
- Go to System Definition > Tables, access the table associated with the record, and verify that the live_feed dictionary attribute is set to true on the form. This adds live feed to the activity formatter.
- Go to Live Feed > Feed Administration > Properties and enable the following property: Toggle the display of the live feed tab in the activity formatter.
Working with record feeds

When a user follows a record, the user becomes a member of a private group for the record.

Team members can:

• View the record feed from live feed.
• View a list of group members (other users who are following the record).
• Invite another user to join the group. Only users who have access to the record have access to the record feed.
• Subscribe to email notifications.
• Leave the team to stop following the record.

Follow a record feed from a form

You can follow records that have a record feed associated with them from within the record form.

Procedure

1. Navigate to the record in a list or form.
2. Click the **Show on Live Feed** icon in the header.
**Follow a record feed from a list**

You can follow records that have a record feed associated with them when viewing a list of records. This method allows you to select multiple records to follow.

**Procedure**

1. Navigate to a list of records (for example, *Assigned to me*).
2. Select the **Action** check box beside each record to follow.
3. In the **Actions** choice list, select **Follow on Live Feed**.

---

**Follow My Tasks**

<table>
<thead>
<tr>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC0000008</td>
<td>Joe Employee</td>
</tr>
<tr>
<td>INC0000007</td>
<td>Joe Employee</td>
</tr>
<tr>
<td>INC0000006</td>
<td>Joe Employee</td>
</tr>
<tr>
<td>INC0000005</td>
<td>Alejandro Mascal</td>
</tr>
</tbody>
</table>

---

**Post a message to a record feed**

Use live feed to post a message to a record feed.

**Procedure**

1. Open the record feed in one of the following ways:
   - From your homepage (must already be following the record)
   - As a team in live feed (must already be following the record)
   - From My Live Feed (must already be following the record)
   - From the **Live Feed** pop-up window
• From the **Live Feed** tab on the activity formatter

• Click the **Show Live Feed** button ( ) in the form header.

2. Compose the message and add images and links.

3. [My Live Feed only] In the To list, select the record where you want to post the message.

4. [Optional] Select the **Work Notes** check box to post the message as a work note. Only users with access to work notes on the record can post and see work notes. This option is only available for records that have a journal field.

5. Click **Post**.

   **Note:** If the record has journal fields for comments or work notes, your message is automatically added to the appropriate field on the record. If the record has a standard text field for comments on the activity formatter, each live post overwrites the field value. Comments added through live feed start with #LiveFeed on the activity formatter.

### Use feeds in Live Feed

Feeds allow users to create focused discussions in Live Feed.

Live feed includes different types of feeds. The user who creates a group or record feed becomes the feed administrator. This user configures the access level for the feed:

• **Public:** any user can see the name on the list of all feeds, view the feed, and join it. Messages appear on the company feed with a link to the public feed.

• **Private:** any user can see the name on the list of all feeds, but only invited members can view the feed and join. Messages do not appear on the company feed.

**Note:** The concept of groups has changed in live feed v2 (starting with the Fuji release).

### Create a group feed

Group feeds are created by users so that members with similar interests can find that information in one place. Individual users or teams can join group feeds.
Procedure

1. Navigate to **Live Feed > Live Feed**.
2. Click **Group Feeds** and click **All Feeds**.
3. Click **Create Group Feed**.

![Create group feed](image)

4. Enter the feed name and description. These will appear in the list of group feeds.

5. Indicate how members can join the feed:
   - **Public Feed**: Select this to allow anyone to view and join the group feed.
   - **Private Feed**: Select this to restrict membership to only members invited by the administrator.

   When **Private Feed** is selected, the **Show this feed for anyone to find and request to join** check box is displayed. If it is selected, any user can search for this group feed and join it. If the check box is not selected, only users who are invited can see the feed and join the group feed.

6. Click **Create**.

**Create record feeds**

When a user views a record on a table that has live feed enabled, such as the **Incident [incident]** table, the user can click the **Show live feed** button at the top of the form to automatically create a record feed.

When a user who has write access to a record's **work_notes** journal field clicks the **Show live feed** button, that user becomes the record feed administrator. If, for example, a customer calls technical support to report an incident and the customer clicks **Show live feed** on a record, a record feed is created, but the customer is not the record feed administrator. When a support representative
later opens the incident and participates in the record feed, the user becomes
the feed administrator.

Record feeds are, by default, private unlisted. That is, only invited members can
see the name of the record feed in the list of feeds, and join it. Record feed
administrators, however, have the ability to change the access level at any
time. This can be helpful if, for example, a user is working on a sales opportunity
and wants customers to be able to participate in a record feed without granting
them access to the records.

**Control how live feed is enabled for records**

A property called `glide.ui.show_live-feed_activity` controls whether live feed is
automatically enabled for all records.

This glide record is disabled by default. If the property is enabled, a record feed
is automatically created whenever a record is viewed, and you become a
member of that feed.

A second property, `glide.live-feed.auto_join_document_group`, enables
automatic membership to a record feed whenever the associated document is
visited and the user clicks **Show Live Feed**.

**View the activity stream in record feeds**

When you view record feeds, live feed displays the activity stream for the
document.

For example, for an incident feed, the screen displays recent activity for the
incident. The activity stream is updated whenever anything is changed in the
associated record.
Live feed activity stream

INCO0000003 - Wireless access not available on floor 3

Note: The information in the activity stream is subject to the same ACL rules as those for viewing the underlying document.

Participate in a feed
When you join a feed, you become a feed member.

About this task
Feed members can:

• View messages posted to the feed. Non-members can also view the messages for a public feed.
• View a list of feed members.
• Invite another user to join the feed.
• Subscribe to feed email notifications.
• Leave the feed.

Procedure
1. Navigate to Live Feed > Live Feed.
2. Click either Group Feeds or Record Feeds, and then click All Feeds.
• If you received an invitation, click **Accept**. You can **Decline** the invitation if you do not want to join the feed.

• If the feed is public, click **Join**.

• If the feed is private, click **Request**. The feed administrator receives an email notification and must accept your request before you can join the feed.

**Mark a feed as a favorite**

Top-level messages in feeds can be marked as favorites on a per user basis only.

**About this task**

You can also search for messages marked as favorites, and remove the favorite designation as needed.

**Procedure**

1. Navigate to **Live Feed > Live Feed**.
2. Click either **Group Feeds** or **Record Feeds**, and then click **All Feeds**.
3. In the list of feeds, click the star icon (⭐️) adjacent to the feed name you want to mark as a favorite.

To unfavorite a message, click the star icon (⭐️) of a message that is already a favorite.

View a feed
You have several options for viewing a feed.

Procedure
1. Navigate to Live Feed > Live Feed.
2. Click either Group Feeds or Record Feeds.
   This displays a list of feeds you belong to and an option to view all feeds.
   • To view a feed you belong to, select the feed name.
   • To view a public feed you do not belong to, select Show All and then click the feed name. You must be a member to view the feed for a private feed.

   ☀️ Note: If you navigate away from the live feed application and then back again, the system displays the feed you last visited if you are a member of it.

View a feed member
View a specific member of a group feed.

Procedure
1. Navigate to Live Feed > Live Feed.
2. Click either Group Feeds or Record Feeds.
   This displays a list of feeds you belong to and an option to view all feeds.
3. Click the feed name.
   The list of feed members appears, organized by feed administrators and members.

Invite a new member to a group feed
The feed administrator can invite another user or a group to join a feed.
About this task
When a team is added to a feed, all members of the team also indirectly become members of the feed. Only users, and not teams, can be the feed administrators. A team member who is following a feed can become administrator by directly inviting another user to the feed.

Procedure
1. Navigate to Live Feed > Live Feed.
2. Click either Group Feeds or Record Feeds, and then select the feed name.
3. Click the Pending members tab.
4. In the Add user or team field, begin entering a user or team name and select a user or team from the suggestion list. The invited user or team members receive an email notification.

Invite a new member to a record feed
The feed administrator can invite another user or a team to join a record feed.

About this task
When a team is added, each of the individual members of the team become members of the feed. That is, if Team ABC is added to a feed, the feed does not show that Team ABC is a member. Instead, the feed shows each of the individual members of Team ABC as members of the feed.

When users are invited, their membership state is initially Invited. When they accept the invitation, the system checks their access to the work_notes journal field. If they have write access, they become administrator members; otherwise, they become active members.

Procedure
1. Navigate to Live Feed > Live Feed.
2. Click Record Feeds and select the record feed name.
3. Click the Pending members tab.
4. In the Add user or team field, begin entering a user or team name and select a user or team from the suggestion list.
   If you invite a team, the individual members of the team are invited.
   The invited users receive an email notification.
Remove a member from a feed
The feed administrator can remove any member from the feed.

Procedure
1. Navigate to Live Feed > Live Feed.
2. Click either Group Feeds or Record Feeds, and then select the feed name.
3. Click the Members tab.
4. Locate the member you want to remove and click Remove.

Note: You can remove members regardless of their current state. That is, you can remove members who have already joined the feed or whose membership is pending.

Subscribe to a feed
Direct members of a feed can subscribe and unsubscribe to the feed in order to receive email notifications whenever any activity in the feed occurs, such as new messages being posted, replies, likes, polls, and @mentions.

About this task
Individual indirect members—that is, members of a team that is participating in a feed—cannot subscribe or unsubscribe from a feed directly. If the team administrator subscribes the team to a feed, the individual members receive an email notification for activities in the feed such as new messages being posted, replies, likes, polls and @mentions.

All notifications related to a top-level message, such as replies, mentions, and likes, are sent out with the same subject. The subject line defaults to Live Feed followed by the beginning of the subject line from the top-level message.
example, if the subject of the feed is **IT Support**, the email notification's subject will be **Live Feed IT Support**.

**Procedure**

1. Navigate to **Live Feed > Live Feed**.
2. Click either **Group Feeds** or **Record Feeds**, and then select the feed name.
3. Click the subscribe icon ((mail icon)).
   
   You can click the unsubscribe icon (unmail icon) to stop receiving email notifications.

   ≥ **Note:** If a team is subscribed to receive email notifications for a feed, but a member of the team did not subscribe to the team, that member does not receive the email notifications.

**Navigate between live feed and other modules**

If you are participating in a feed and navigate to another module, when you return to live feed it displays the feed you were previously viewing if it is public or if it is a private feed that you are a member of.

For example, assume you are viewing a public feed and then navigate to a particular incident record. Upon returning to live feed, the feed you were previously viewing opens. If you were last viewing a private feed that you are not a member of, returning to live feed opens the Company Feed.

**Leave a feed**

Members can choose to leave a group feed.

**Procedure**

1. Navigate to **Live Feed > Live Feed**.
2. Click either **Group Feeds** or **Record Feeds**, and then select the feed name.
3. Click **Leave**.

   ≥ **Note:** If you leave a feed associated with a record, such as an incident, you automatically rejoin that feed if you modify the associated record again.

**Delete a feed**

If you are a feed administrator, you can delete the feed.
Procedure

1. Navigate to Live Feed > Live Feed.
2. Click either Group Feeds or Record Feeds, and then select the feed name.
3. Click Delete.
4. Click Yes to confirm deletion.
   The feed is deleted from live feed. Messages posted to a private feed are deleted. Messages posted to a public feed remain on the Company Feed without a feed link.

Live Feed UI overview

The Live Feed user interface provides many methods you can use to share content with others in your organization.

Update your Live Feed profile

Your profile information includes a photo or image, and tabs for different types of information including messages, feeds, teams, followers, and those who are following you. You can update your profile information and picture at any time.

About this task

ℹ️ Note: The functionality described here applies to HTML5-compliant browsers, such as Chrome, Firefox, Safari and IE10 and above.

Procedure

1. Navigate to Live Feed > Live Feed.
2. Click your name or title displayed below your picture.

The profile record opens.
3. Click the pencil icon next to **About Me** and type a short description about yourself that you want to share with others who view your profile. This is text that you might not necessarily want to change on a regular basis.

4. You can change your profile photo using either of the following two methods:

   • Locate the photo file you want to use, and drag-and-drop it over the existing photo.

   • Hover over the existing picture (or tap the photo in the case of the smartphone or tablet interface) to display the **Upload a picture** link. Click the link, navigate to the location of the photo you want to use, and click **Open**.

   

   ![Upload a picture](image)

   

   **Note:** Your profile picture is used by the Connect and legacy chat features as well if they are activated.
Work with Live Feed messages

This portion of the UI gives the user access to various types of messages and tools for grouping and categorizing messages. Also included are methods for identifying which user feeds you are following and which users are following you.

Tools for working with live feed messages

<table>
<thead>
<tr>
<th>Menu section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Live Feeds</td>
<td>These are custom feeds that allow you to customize live feed to view the content that is most important to you.</td>
</tr>
<tr>
<td>Company Feed</td>
<td>This feed displays all posts, except those posted to private or unlisted groups.</td>
</tr>
<tr>
<td>Group Feeds</td>
<td>These feeds are created by users. Record Feeds: These feeds are associated with a record, such as an incident or change.</td>
</tr>
<tr>
<td>Record feeds</td>
<td>These feeds help users collaborate on records by providing a place for anyone who can access the record to share messages and post attachments specific to that record.</td>
</tr>
<tr>
<td>People</td>
<td>This option displays people who are following the current user and people the current user is following.</td>
</tr>
<tr>
<td>Teams</td>
<td>This option is used to combine users into groups for the purpose of subscribing to specifically-focused conversations.</td>
</tr>
<tr>
<td>Hashtags</td>
<td>Hashtags are words marked with a hash (#) symbol in messages. Hashtags are used to categorize messages by keyword or topic for improved search results messages filtered from all conversations that include specific hashtags.</td>
</tr>
</tbody>
</table>

View another Live Feed user

When a requester user, one that has no ServiceNow role, is viewing a feed and points to another user’s picture, information for the user appears from the Business Card view of the User [sys_user] table.

About this task

You can customize ACLs to increase the amount of information you want displayed for users with different roles.
If you click a user's name or title, the user's profile appears. Click the tabs to view different types of information for the user.

**Profile tabs**

Follow other Live Feed users

As you use Live Feed, you can follow the message threads of other users.
Procedure

1. Navigate to a thread that the user you want to follow is engaged in.
2. Click that user’s name or point to the user’s picture.
   - A Follow link appears in the user’s profile.
3. Click Follow.
4. To stop following the user, navigate to People > Following.
5. Click **Unfollow**.

6. To view people who are following you, navigate to **People > Followers**.

**Select feeds**

A feed is a stream of related messages. You can use the feed selector to switch between feed types and to view specific group feeds and record feeds.

**Procedure**

1. Use the **Search** field to locate any type of feed. As you type in the **Search** field, the results are dynamically displayed. For example, if you type `INC`, records that are incidents are forced to the top of the results list.

2. You can also select the following types of feed information.
### Feeds types

<table>
<thead>
<tr>
<th>Feed</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Live Feeds</td>
<td>Displays the following posts:</td>
</tr>
<tr>
<td></td>
<td>• messages from users you follow</td>
</tr>
<tr>
<td></td>
<td>• messages with hashtags you follow</td>
</tr>
<tr>
<td>Company Feed</td>
<td>Displays all posts, except those posted to private or unlisted groups.</td>
</tr>
<tr>
<td>Add Group Feed</td>
<td>Allows you to add a group feed.</td>
</tr>
</tbody>
</table>

### Follow feeds

You can view users who are following you or other users you are following.

**About this task**

To view users who are following you or other users you are following, click **People** in the sidebar.

The system shows 10 most recent followers or users you are following.

**People**

- **Following**
  - **@Pat Hoshaw**
    - Follows you
    - Unfollow
  - **Annie Approver**
    - Unfollow

If either list contains more than 10 users, a Show More link appears.
Note: If you are following a particular user whose profile changes, that user moves to the front of the Following list. This alerts you to changes in the profile of a user you are following.

**Bookmark feeds and hashtags**
The live feed interface uses the standard bookmarking functionality for feeds and hashtags.

**About this task**
In UI15, you can drag-and-drop group feeds and hashtags from the Feed Summary section to the Edge for quick access.

### Bookmark a hashtag

![Diagram of bookmarking a hashtag]

**Add Live Feed to your homepage**
You can add Live Feed to your own homepage or to a global homepage.

**Procedure**
1. Navigate to a homepage.
2. Click the add content icon (+) in the top left corner of the homepage.
3. Select Live Feed in the left panel.
4. On the bottom of the window, click **Add here** in the appropriate layout position, then close the window.
**Note:** Administrators can add live feed to a global homepage to make it available for all homepage users by default. Users with any role can add live feed to their homepage; however, administrators can restrict this ability.

### Post content in Live Feed

In Live Feed, you can post new messages and replies to existing messages for all users in the feed. You can also send a reply message to a team or record.

#### Post a live feed message

You can post a message to open a new feed.

**Procedure**

1. Navigate to **Live Feed > Live Feed**.
2. Click the feed to which you want to post your message, for example My Live Feed, Company Feed, and so on.
3. Enter a message in the **Share your thoughts** field. Use hashtags, if you want.
4. As needed, click [poll], [attachment], or [screenshot] to add a poll, attachment, or screenshot image, respectively.

5. Click Post.

Reply to a live feed message
To participate in an existing thread of a feed, you can compose and submit a reply message. By default, the message is visible to all members of the feed.

Procedure
1. Navigate to Live Feed > Live Feed.
2. Locate the message you want to reply to.
3. Type your reply in the message box and click Reply.
   - As needed, you can add hashtags, attachments, links, or knowledge base articles.
4. To limit who can view the reply to a single individual, select a user from the To choice list.
5. Click Reply.
6. By default, 7 replies are visible for each message. To view additional replies, click Show all replies. Any reply to a reply includes a Threads link.
7. Click **Threads** to view all of the replies within the selected reply in reverse chronological order within the **Message Thread** pop-up window, similar to an email thread.

**Message thread**

![Message thread screenshot]

**Attach files, links, images, and knowledge articles to messages**

In addition to entering text, you can attach files, such as images, documents, and spreadsheet files in any ServiceNow supported file type to live feed messages.

Administrators can manage attachment file settings, such as supported file types and maximum attachment file size, by editing system properties.

You can also include links to user-defined URLs and knowledge articles contained in your instance’s knowledge base.

**Note:** The functionality described here applies to HTML5-compliant browsers, such as Chrome, Firefox, Safari and Internet Explorer 10 and above. Significant differences while using different browsers are highlighted.
Attach a file to a post or reply

You can attach files to a post by dragging a file into a post or pasting an image from the clipboard.

About this task

Use the paperclip icon (.attachment) to drag files into a post. Additionally, you can paste images into a post or reply from the clipboard.

Procedure

1. Do one of the following:

   • While composing a post or reply (see Reply to a Message), locate one or more images or other supported types of files, and drag them into the message box.

   • Click the paperclip icon (attachment) in the message box, navigate to the location of the files you want to attach, select them, and click Open.

2. To add more files, drag-and-drop additional files into the text box below the displayed files or images, or click the plus sign.
3. If you want to delete an attachment before posting the message, click the trashcan icon adjacent to the attachment.

4. Enter a comment to share your thoughts about the image.

   🔄 **Note:** The **Post** button is enabled only after you add the comment.

5. Click **Post** or **Reply**.

6. If you added files that do not contain previews and then posted the message, they will be listed in the message box with a **Download** link.

7. Click the link to download the files.

**Copy an image from the clipboard**

In addition to adding files to a message, you can also copy images to the clipboard and paste them into a message or reply.
Procedure

1. Click into the **Comment** box and add a comment.

   **Copy paste**

   Here is how to drag-and-drop tags in order to bookmark them.

   ![Comment box](Image)

2. Click the **Add an image** button. The **Screenshots** dialog box opens.

3. Right-click the **Paste an image here** box and select **Paste** to paste the image from the clipboard.

   **Copy pasted**

   ![Screenshot](Image)

4. To add another image, repeat the previous steps.

5. When you finish pasting images into the message, click **Done**.

6. To change the link text, click **Pasted Image** and enter a new label.

7. When you finish, click **Post** or **Reply**.
8. To remove an image, click the trash can icon adjacent to the link.

9. To make changes to an existing image, click the edit icon ( 🗑️).

ℹ️ **Note:** The copy/paste functionality is supported in Chrome, Firefox, and Internet Explorer 11.

**Add a link to a post or reply**

Add or modify a link to a live feed post.

**Procedure**

1. Click into the **Comment** box.
   
   The **Add a link** button appears.

2. Click the **Add a link** button.
   
   The **URL** and **Link text** fields appear.

![Add a URL](image)

3. Enter the URL and the text you want to appear as the link.

4. To add another link, click the link icon under the **URL** field.

5. When you have finished entering your message, click **Post** or **Reply**.
To remove a link, click the trash can icon adjacent to the link. To make changes to an existing link, click the edit (✏️) icon.

**Add a knowledge article link to a post or reply**

Use the ID of a knowledge article to post it as a reply to a live feed conversation.

**Procedure**

1. While composing a post or reply, type the ID of the knowledge article you want to link to. You do not need to identify the knowledge article ID as a hyperlink; live feed recognizes it as such and automatically converts it into a link when the message is posted.

2. When you are finished entering your message, click **Post** or **Reply**.

**Add a poll to a message**

When you are posting a message, you have the option of creating a poll in order to record your viewers’ opinions. As users take the poll, their feedback statistics are displayed within the feed.
Procedure

1. Open the feed where you want to create a message with a poll.
2. Enter the message with an invitation to take the poll in the Share your thoughts box.
3. Click the poll (_poll) icon.

4. In the **Question** field, enter the question on which you are soliciting opinions.
5. In the **Option** fields, enter possible responses to the query.
6. To add more response options, click **Add more options**.
7. Click **Post**.

After the poll is posted, users who view the message can vote. After they vote, their pictures appear next to their response, with others who have voted for the same option.

ℹ️ **Note:** Only the poll creator can view results without casting a vote. Other members can see results only after casting a vote or if the poll is closed.
An email notification with the poll result is sent to all participants of the poll informing them that the poll is closed.

**Add mentions to a message**

An @mention is any posted update that contains @username anywhere in the body of the message.

**About this task**

The user’s name, with a link to that user’s feed, is inserted into the message. Additionally, the mentioned user receives an email notification about the mention. This is a great way of bringing attention to other members in a conversation. All @mentions are included in the logged-in user’s My Feed.

⚠️ **Note:** If an @mention is used by a member of a team, only members of that team appear in the auto-suggest list.

**Procedure**

1. While entering a message or reply in a conversation, type @username anywhere in the message. As you type, an auto-suggest list appears with names and pictures of users that match your entries. For example, if you type @t, the auto-
suggest list shows the pictures and names of all users with names that start with T.

2. Click the user you want to add.
That user's name is inserted into the @mention in the body of the message.

![Screenshot of suggest list](image)

Note: My Feed displays @mentions of you and the teams you are a member of. Profile feeds for another user display only @mentions of that user.

Like a message
Like a message to provide feedback to the author.

Procedure
1. Navigate to Live Feed > Live Feed.
2. Click Feeds.
3. Locate the feed that contains the message you want to like.
4. Under the message title, click Like.
   If the message has previously been liked, the number of likes for a message displays next to the Like link.
   For a top-level message, the profile pictures of the first 5 users who liked a message are displayed. Any additional users who liked the message can be viewed by hovering over the # more link. If the logged-in user has liked the message, that user's image will appear first, followed by the image of the user who last liked the message.
For a reply, you must hover your mouse pointer over the count link to view the users who liked the message.

Note: After a message has been liked, it cannot be unliked.

Delete a message

Users can delete any of their own posts or replies. A conversation administrator can also delete messages.

Procedure

1. Hover over the message you want to delete.
2. Click the trash can icon in the upper-right-hand corner of the message box.
3. Click Delete in the confirmation box.
   The message disappears from the feed.

MetricBase

The MetricBase application stores time-series data, which is data that is sampled at regular intervals. You can graph the stored data or use it with triggers to execute Flow Designer flows. MetricBase helps developers working with IoT-based applications that monitor or act on large amounts of machine-generated data.

How MetricBase works

You use MetricBase to deal with large amounts of data by using a smaller summary of that data that is stored in the MetricBase database. For example, an instance might store CPU usage. With MetricBase, you might summarize that data by storing the average CPU usage for every five-minute interval. You can graph the data or you can use it with Flow Designer to trigger flows.

MetricBase works with:

- An instance that stores machine-generated data
- A server that has the MetricBase application and database

On a very high level, when using MetricBase, you can:
1. Define the sampling rate for the data (float) on an instance. For example, you can sample the machine-generated data that is stored on an instance once every five minutes. This sampling rate is called the time-series definition.

2. Use a MetricBase API to send data from the instance to the MetricBase database at the rate that is prescribed by the time-series definition. If you send the data to MetricBase at a different rate, you get an error.

3. Use the Reporting application to graph the time-series data that is stored in MetricBase, or create triggers that execute Flow Designer flows. The time-series data remains in the MetricBase database for a prescribed amount of time, after which MetricBase deletes the data.

This figure shows that machine-generated data is sampled every 4 seconds. You send the average of the values in each sampling period to the MetricBase database, which stores the data until its expiration date.

Benefits
- MetricBase integrates seamlessly with ServiceNow IoT-based applications that monitor or act on large amounts of machine-generated data.
- MetricBase collects, retains, analyzes, graphs, and acts on time-series data.
- MetricBase works with Flow Designer to trigger flows and with Reporting to generate reports.

Use cases
- Create graphs about metrics, such as about CPU usage over time.
- Generate an email if the average CPU usage is more than 85% in the last 5 minutes.
• Train a machine language model to detect anomalies and execute a Flow Designer trigger when an anomaly is detected.

• If MetricBase detects a gap in data submitted for 10 minutes or more, generate an email.

• If the average of the collected data is less than 10 or greater than 500 in the last 5 minutes, generate an alert.

• If memory usage is likely to exceed 90% in the next 10 minutes, generate an alert.

**MetricBase demo**

Use the MetricBase Demo plugin to familiarize yourself with MetricBase. The demo contains sample metrics, triggers, and a scheduled job that collects and stores data. Use the demo to explore MetricBase before you set it up. The Data Explorer, which comes with the demo plugin, provides a place to experiment with MetricBase JavaScript APIs. The demo plugin is separate from the MetricBase plugin. Make sure to request both.

**Next**

Request the installation of the MetricBase and MetricBase Demo plugins.

**Requesting the MetricBase product**

The MetricBase plugin [com.snc.clotho] requires a separate subscription and must be activated by ServiceNow personnel. Be sure to also request the MetricBase Demo plugin [com.snc.clotho.demo], which includes sample tables, metrics, triggers, and data.

**Before you begin**

Role required: none

**About this task**

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization’s production and subproduction instances, generally within a few days.

When ServiceNow personnel install the MetricBase Demo plugin, they also connect your instance to the server that contains the MetricBase database. A MetricBase database can connect with only one other instance. For example, a clone of the original instance can’t talk to the same database as the original instance.
What to do next

- Play with MetricBase to get familiar with it.
- Define and collect MetricBase data.

Getting familiar with MetricBase

After ServiceNow personnel install the MetricBase and MetricBase Demo plugins, you can use the demo to get familiar with MetricBase.

Prerequisites

- MetricBase and the MetricBase demo plugins must be installed by ServiceNow personnel.
- Role required: admin

MetricBase Demo

With the MetricBase Demo plugin, you can experiment with MetricBase without configuring it or knowing much about it. The plugin includes sample time-series data and triggers in your MetricBase database to help you visualize the data and see how triggers operate. The demo also includes scheduled time-series data updates, as if they had been received from an instance, so you can test the functionality of the included triggers.

In the demo, a fictional fleet of drones has been outfitted with sensors that broadcast their metrics, including their speed, altitude, and battery life over time.

1. Navigate to MetricBase Demo > Drones to see the name, model, length, width, altitude, and speed for all drones in the fleet.

2. Click MetricBase Demo > Metrics to see how the metrics are defined. In the Time Series Metrics list, the column values specify the table where the drone’s time-series metrics are stored, the names of all the metrics that are stored for each drone, and the retention policy for each metric. The retention policy
specifies how frequently measurements are taken, and how long MetricBase retains that data.

Now that you've seen the drone data and learned how to find it, let's see how the data was collected using a retention policy.

3. Click a retention policy. The Retention Policy form shows the definition for the policy. In the following example, this metric is measured once a minute for the first 8 days, then once every 10 minutes for the following 94 days, and then once an hour for the following 397 days. After that, the system discards the data.

For more information on retention policies, see Define and collect time-series data.

4. To see how the data is aggregated during the Retention Durations, click the left arrow (<) at the top of the Retention Policy Schedules window to return to the Time Series Metrics list.

5. Click a table name. The Time Series Metric definition shows the Retention policy aggregator. This aggregator summarizes the data as, for example, the average, maximum, or minimum value in the aggregation period. In the following example, the admin clicked the table for the speed metric. The
result is that MetricBase stores the speed averages during each sampling period in the MetricBase database.

Now that you understand how the data was collected using retention policies, let's see how to display the data in lists and graphs.

6. Notice the parameter fields that start with **Display**. In this example, they mean that the speed values that are displayed in the list view of drones are the last speeds recorded in every hour interval for each drone. These **Display** fields control what appears in the list view of the drones only. They have nothing to do with the retention policy.

7. Display the list view of a table by entering `<table-name>.list` in the **Field navigator** field. For example, `mb_demo_drone.list`. All drone data appears. In the example from the previous step, the speed column would contain the **Last** value of the sampling period.

8. Click **MetricBase Demo > Drones** and look at the speed (kph) column. From the previous step, you know that these values are the last speeds recorded for each drone up to an hour ago. The values are the same as you would get by using the `.list` command.

9. Click the speed value of the first drone. The following graph shows the speed of the drone that was measured hourly.
Note: You might need to select a different Time Span field value to get a clearer graph. For example, try 1 Day. The speed is a sine wave because it’s artificially generated. Hover over the sine wave to see the actual measurements.

10. Click the left arrow (<) to return to the list of drone metrics, right click on one drone type (Model column), and select Show Matching. Only the drones of the selected type appear.

11. Click the menu icon (Ξ) next to the Altitude column heading and select Time Series Chart. You see a graph that shows the altitude measurements of the Warbler-T7-type drones.

You might like to change the Time Span value for a clearer graph.
12. In the **Transform** field, select **Envelope**. You see a graph that shows the minimum and maximum (envelope) altitudes for the fleet of Warbler T7 drones over time.

![Graph showing drone altitude over time](image)

13. Click the left arrow (<) to return to the list of drone metrics.

14. Click the menu icon (Ξ) next to the Altitude column heading and select **Time Series Chart Designer** to see another way of visualizing the data.

![Chart Designer interface](image)

15. In the Create a Report page that displays in the Reporting application, vary with the graph parameters.

**Note:** In the following steps, to stay on the same page, click **Run**. To advance to the next page when designing the graph, click **Next**.
a. Change the Last value to one day and click Next.

b. In the Style pane, change the Chart color value and click Run.

c. Click Type, select the kind of graph to display, and click Run.

d. Click Configure, select a transform to run on the data from the Transform list, and click Run.

e. Edit the report title, which is above the graph, and click Run.
f. Click **Configure**. In **Time range**, select the time line to display on the graph.

**Note:** **Relative** uses the **Last** timespan relative to the present time. For example, if **Last** is 1 hour, the time line in the graph always spans the previous hour. You can add this report to your dashboard to show the metrics in the previous hour.

You've displayed drone data in lists and graphs. Now, let's define a trigger that executes when data that you monitor reaches a threshold value.

16. Click **MetricBase Demo > Trigger Definitions**. The MetricBase Trigger Definitions list, shows the name (**Name**) of the trigger, the metric (**Metric**) the trigger monitors, the table (**Table name**) the metric that it is in, the trigger description, and whether the trigger is active. Triggers kick off flows when metrics meet trigger thresholds. An example is when a drone flies too low. For more information about triggers, see **Trigger Workflows**.

17. Click **Low-Battery Drone**. The MetricBase Linear Predictor trigger form displays the definition of the Low-Battery Drone trigger.
In this example, the trigger monitors the Remaining Battery (%) metric (Metric) in the Drone table (Table name) every 10 minutes (Window). If the battery life is trending downward (Trend) and is 80% likely (Confidence Level) to reach 20% (Threshold) within 20 minutes (under Window for Level 1), the trigger executes. Although it fires, nothing happens until you associate this trigger with a flow. The flow defines the actions to take.

19. Click + New > New flow to associate a trigger that is defined in the system to a flow.

20. In the Name field, name the flow and click Submit.

21. Click Click to add a Trigger and select MetricBase in the list.
22. In **MetricBase Trigger**, select a trigger that already exists and click **Done**. Alternately, you could click the plus sign to the right of **MetricBase Trigger** to create a new trigger.

23. Click **Click to add an Action, Flow Logic, or Subflow**.

24. Click **Action** to specify the actions to take when the trigger fires. The Action modal appears.

25. Select a domain of actions from the left column and the specific action to take in the right column.

26. Click **Save** and **Activate**. The flow doesn't execute unless it is activated. For more information about Flow Designer, see **Flow Designer**.
The following table summarizes the modules in the MetricBase demo.

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drones</td>
<td>Table that keeps metrics on drones, such as speed and altitude. Each record is a different drone. You can add records.</td>
</tr>
<tr>
<td>Fleets</td>
<td>Table that maintains metrics about groups of drones. Each record is a different fleet. You can add records.</td>
</tr>
<tr>
<td>Data Generators</td>
<td>Table that defines how data is created for the drone records. This field is provided for informational purposes. You cannot change or add records.</td>
</tr>
<tr>
<td>Metrics</td>
<td>List of metrics that are defined in the system. This list is the same table as MetricBase &gt; Time Series Metrics. You can add metric fields.</td>
</tr>
<tr>
<td>Scheduled Jobs</td>
<td>Scheduled job that is created for the demonstration application. The job runs every five minutes to add data to the demo tables in the MetricBase database. You can change the schedule.</td>
</tr>
<tr>
<td>Trigger Definitions</td>
<td>List of triggers that are defined in the demo. This list is the same table as MetricBase &gt; MetricBase Triggers &gt; Trigger Definitions. You can create additional triggers.</td>
</tr>
<tr>
<td>Anomaly Logs</td>
<td>List of logs that result from triggers firing. The Low-Flying Drone trigger creates the anomaly logs.</td>
</tr>
<tr>
<td>Data Explorer</td>
<td>Widget that enables you to experiment with MetricBase JavaScript APIs using the demonstration application data. See Get Familiar with MetricBase APIs for more information.</td>
</tr>
</tbody>
</table>

**Next topics**
- Set up MetricBase.
- Explore the MetricBase JavaScripts APIs.

**Define and collect MetricBase data**

MetricBase stores time-series summaries of much larger data collections. In MetricBase, you specify the metric that you want to store and how often
to collect it. You can also determine how long to store it in the MetricBase database. Then, you send the data from an instance to the MetricBase server at the rate that you define using MetricBase REST or JavaScript APIs. In this way, you can monitor a much larger data collection with MetricBase summaries of it.

**Before you begin**
- **Install MetricBase**
- **Role required**: clotho_admin

**About this task**
MetricBase collects the metrics of how often you send data and what the aggregation of that data is, for example, maximum, minimum, average, or last. This data is called *time-series data*. For example, if you collect drone speeds on an instance, you can send the average drone speed for every two minutes to the MetricBase database. You can also collect altitude and battery life. MetricBase stores each metric as a column in its database.

![Sending information from an instance to a MetricBase server](image)

Retention policy schedules specify how long MetricBase stores the time-series data in the MetricBase database. You can create, edit, and delete retention policy schedules. To create, edit, or delete retention policy schedules, navigate to **MetricBase > Retention Policy Schedules**.

Retention policies include multiple retention schedules with coarser granularity the longer that the data is kept. For example, the Coarse retention policy stores sampled data every:
• Hour for one week (7 Days per 1-hour interval)
• Two hours for one month (31 days per 2-hour interval)
• Day for 13 months (397 Days per 1-day interval)

In this policy, the specified metric is measured every hour for the first 7 days. It is then measured every other hour for the next 31 days, and once a day for the next 397 days. MetricBase deletes data that is older than 435 days.

To see the list of all supported retention policies, navigate to MetricBase > Retention Policies.

**Procedure**

1. Navigate to MetricBase > Time Series Metrics and click **New** to create a time-series definition.
2. On the form, fill in the fields.

### Time series metric form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Intuitive name for the <strong>Metric field name</strong>. For example, altitude could be the label for the metric field name, mb-altitude.</td>
</tr>
<tr>
<td>Table name</td>
<td>Name of the table to add the metric to in the MetricBase database. For example, in the MetricBase Demo, the mb_drone table stores the drone data. Each column in the table is a different metric, for example, altitude, length, and speed.</td>
</tr>
<tr>
<td>Metric field name</td>
<td>Name of the time-series metric that records. For example, mb-altitude. You can think of it as the name of a column in the MetricBase database table.</td>
</tr>
<tr>
<td>Retention policy</td>
<td>Sampling frequency and how long MetricBase keeps the values in the database. You cannot customize the value. For a definition of the values, click the magnifying glass and then a policy. The coarser the sampling rate, the less data that stores. Use the coarsest sampling rate that works for your dataset. For example, do not collect data every minute if collecting it once an hour suffices. See MetricBase retention policies for a description of the policies you can select.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Retention policy aggregator</td>
<td>Operator that aggregates the data in a sampling period. For example, last, minimum, maximum, and average.</td>
</tr>
<tr>
<td>Display value aggregator</td>
<td>The aggregation method in use when using <code>&lt;table-name&gt;.list</code> where <code>&lt;table-name&gt;</code> is a table in the MetricBase database. This value is unrelated to the retention policy. For a definition of the options, see MetricBase transforms.</td>
</tr>
<tr>
<td>Display value aggregate duration</td>
<td>Duration that is used to calculate the aggregation only when using the list view. For example, <code>&lt;table-name&gt;.list</code> where <code>&lt;table-name&gt;</code> is a table in the MetricBase database. This value is unrelated to the retention policy.</td>
</tr>
<tr>
<td>Subject field</td>
<td>You can select a unique table column as your subject for the metric. The unique column must be designated on the table before you select it. For example, if your metric tracks temperatures in different houses, you can make the house address column the subject of your metric. The house address column on your table must be unique before you set the subject field.</td>
</tr>
<tr>
<td></td>
<td>✨ Note: The sys_id column is the default unique column.</td>
</tr>
<tr>
<td>Data Type</td>
<td>You can specify the data type of the subject field.</td>
</tr>
</tbody>
</table>

You’ve created a time-series specification for a metric that you want to track.

3. **Click Submit.**

4. Sample the data according to the time-series specification and send it from an instance to the MetricBase database server. There are many ways to send the data to the MetricBase database. The following example shows how to use REST and JavaScript APIs. For information about the MetricBase REST APIs, see the Clotho Time Series API. For information on the MetricBase JavaScript APIs, see Client, Data, DataBuilder, Transformer, TransformPart, TransformResult.
Note: Send the data at the rate that the time-series definition prescribes. If you send the data at a different rate or for a different duration, you receive an error. Make sure to aggregate the data according to the time-series metric definition. Also, the MetricBase database only stores values of data type float.

You can gain experience with the APIs by using the Data Explorer. For more information, see Get familiar with MetricBase APIs.

Example: Store time-series data using REST and JavaScript APIs

The following examples store time-series data in the MetricBase database using REST and JavaScript APIs. The following example uses REST.

```
curl -X POST -H "Content-Type: application/json" -H "Accepts: application/json"
   "https://<your_instance.servicenow.com>/api/now/v1/clotho/put?align_time"
-d
   
   
   "metric": "<metric-name>", "start": "<start-time-of-data>",
   "values": [0.0, 1.4, 1.1, 1.0, 0.9]] -u username:passwd
```

- **sys_id-of-data-source**—Sys ID of the object that generates the metric. For example, in the MetricBase Demo, this entry would be the sys_id of a drone.
- **metricbase-table**—Name of the table in the MB database that stores the time-series data.
- **metric-name**—Metric field name of the metric that is recorded in the database.
- **start-time-of-data**—Time that the data was sampled from the instance, for example, 2019-04-02T03:00:00Z.

Note: Line returns were introduced into the curl statement to make it fit on the page. To use the code, remove the line returns.

If you prefer to use a JavaScript API to store the time-series data in the MetricBase database, here’s a similar example:

```
var count = 60 * 48; //2 days of data
var values = [];
for (var i =0; i < count; i++) {
   values.push(Math.random());
}
var now_GR = new GlideRecord('<metricbase-table>');
```
gr.get('<sys_id-of-data-source>');

var start = new GlideDateTime();
start.addSeconds(-1 * 60 * count);

var dataBuilder = new sn_clotho.DataBuilder(gr, '<metric-name>').add(start, values);
new sn_clotho.Client().put(dataBuilder);

• **sys_id-of-data-source**—Sys ID of the object generating the metric. For example, in the MetricBase Demo, this would be the sys_id of a drone.

• **metricbase-table**—Name of the table in the MB database that stores the time-series data.

• **metric-name**—Metric field name of the metric that is recorded in the database.

**What to do next**

• If you use a predictive model to detect anomalies, create a predictive model. To see how, refer to [Detect anomalies using predictive models](#).

• View the metrics that are stored in the MetricBase database. To see how, refer to [View the metrics](#).

• Set up triggers that execute Flow Designer flows. To see how, refer to [Set up triggers](#).

**MetricBase retention policies**

The retention policies you can choose when retaining your data in MetricBase.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coarse</td>
<td>This policy stores data with 1 week at 1-hour interval, 1 month at 2-hour interval and 13 months at 1-day interval. This policy is suitable for metrics that change less often or metrics that do not require high resolution such as disk usage.</td>
</tr>
<tr>
<td>Dense</td>
<td>This policy stores data with 1-minute increments for 8 days then 10-minute increments for 94 days then</td>
</tr>
</tbody>
</table>
### MetricBase Retention Policies (continued)

<table>
<thead>
<tr>
<th>Policy</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1-hour increments for 13 months. It is suitable for metrics that require higher resolution for longer terms.</td>
</tr>
<tr>
<td>High</td>
<td>This policy stores data for 1 week at 1-minute interval, 1 month at 10-minute interval and 13 months at 1-hour interval. It is suitable for metrics that require higher resolution for longer terms.</td>
</tr>
<tr>
<td>Medium</td>
<td>This Medium Series policy stores data with 1 week at 10-minute interval, 1 month at 30-minute interval and 13 months at 2-hour interval. This policy is suitable for metrics that change less often such as job processing throughput.</td>
</tr>
<tr>
<td>Medium High</td>
<td>This policy stores data with 13 months at 1-hour interval.</td>
</tr>
<tr>
<td>Operational Intelligence</td>
<td>This policy stores data with 1-minute increments for 8 days then 10-minute increments for 94 days then 1-hour increments for 13 months.</td>
</tr>
<tr>
<td>Sparse</td>
<td>This policy stores data with 13 months at 1-day interval.</td>
</tr>
<tr>
<td>Ultra Dense</td>
<td>This policy stores data with 1 day at 10-second interval, 3 months at 1-minute interval and 1 year at 1-hour interval.</td>
</tr>
</tbody>
</table>

### Detect anomalies in MetricBase data using predictive models

Use statistical models to determine significant anomalies in real-time using MetricBase triggers. You will need to train a model using representative data that has already been stored in MetricBase.
Before you begin
Role required: admin

About this task
MetricBase creates a model by training a representative sample of your time series data to determine the model parameters. The training process determines the model parameters that best fit your data, to distinguish normal data from anomalous data. MetricBase supports the following model types:

- Probabilistic Exponentially Weighted Moving Average (PEWMA), a moving average algorithm that uses a probability factor to determine how it reacts to change in data
- Autoregressive Integrated Moving Average (ARIMA), a moving average algorithm that factors in previous errors and values
- Seasonal Trend decomposition using Loess (STL), a seasonal algorithm for decomposing time series data into seasonal and trend components
- Holt-Winters (HW), a seasonal algorithm that decomposes the trend and seasonal components to determine the level

† Note: MetricBase selects the most appropriate model type when you select Find Best Fit Model from the model class list.

After you have a model trained from your data, you can trigger flows when new data is significantly different than the trained data.

Procedure
1. Navigate to MetricBase > MetricBase Models and click New.
2. On the form, fill in the fields.

Model New Record form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model name</td>
<td>Name of the model. The name can be any combination of alphanumeric characters. This model name is not the same as the model class. In general, the name relates to the value in Group by.</td>
</tr>
<tr>
<td>Table name</td>
<td>Name of the table that contains the training data.</td>
</tr>
<tr>
<td>Metric</td>
<td>Name of the metric that you use to train the model. The metric must belong to the table.</td>
</tr>
<tr>
<td>Created</td>
<td>Date that you trained the model.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Filter</td>
<td>Filters that you use to exclude some of the data in the dataset.</td>
</tr>
<tr>
<td></td>
<td>✉ Note: When choosing data to train your model, try to select data that demonstrates an expected behavior to reduce anomalies in the training set.</td>
</tr>
<tr>
<td>Group by</td>
<td>You can use <strong>Group by</strong> as a discriminator field for your model data. For example, if you want to create a data model over a group of production servers whose performance differs by role (such as database or application server roles) then you would choose role as the <strong>Group by</strong> field. The training process creates one model per role in the group of records selected by the filter. You do not have to manually create a model for each role.</td>
</tr>
<tr>
<td>Model Class</td>
<td>The algorithm to use when training data. Select a moving average algorithm (PEWMA, ARIMA), a seasonal algorithm (STL, HW), or choose <strong>Find Best Fit Model</strong>. The default is <strong>Find Best Fit Model</strong>, which tries each algorithm and selects the one which appears to have the best fit over the training set.</td>
</tr>
<tr>
<td>Training Dataset Start Date</td>
<td>MetricBase time series data for the metric starting with this date.</td>
</tr>
<tr>
<td>Training Dataset End Date</td>
<td>MetricBase time series data for the metric ending with this date.</td>
</tr>
<tr>
<td>Valid until</td>
<td>Date that serves as a reminder to consider retraining the model. If the model is performing well, there's no need to retrain it. The model can continue working past this date.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to use the trained model. Once the model is active it becomes available for use as a Flow Designer trigger.</td>
</tr>
</tbody>
</table>

3. Click **Submit and Train**. MetricBase trains the model. When complete, the model appears on the **MetricBase Model Instances** tab.

4. Click the model name. The modeling data appears as does the model string with the parameters optimized by the training.
5. Optional: Click the model name and then click Set Model to change the model parameters. You can edit the model parameters when you want to override the settings for training your model. The graph does not update, you are saving the revised model string.

What to do next
You can create a Flow Designer trigger for this model. For more information, see Create a model trigger.
**Access MetricBase data**

Access the time-series data that you sent to the MetricBase database in the way that is convenient to you.

**Before you begin**
Role required: admin

**About this task**
You can access and visualize time-series data in the MetricBase database by using:

- **Reporting application**
  You can generate reports and graphs from the time-series data that is stored in the MetricBase database. For more information, see [Create reports from MetricBase time-series data](#).

- **Table lists using the `.list` command**
  For more information, see [View MetricBase data using the list command](#).

- **REST or JavaScript APIs**
  For more information, see [View MetricBase data using REST and JavaScript](#).

**Access MetricBase data using the list command**

Use the list command on a table in the MetricBase database to view time-series data. The data reveals the behavior of the entity that supplies the data.

**Before you begin**
Role required: admin

**Procedure**

1. On the MetricBase instance, in the **application navigator**, type `<table-name>.list`, and press the Enter key.
   
   `<table-name>` is the name of the table in the MetricBase database that contains the metric you want to view.

2. Click the menu icon (☰) above the metric column, and select **Time Series Chart**.

3. Change the **Time Span** and **Transform** fields to evaluate the data.

4. **Optional:** Adjust the data:
a. Select one of the transforms: **Add**, **Multiply**, or **Divide**.

b. In the **Value** field, enter the number to add, multiply, or divide the metric data by and click **Submit**.

**Note:** The adjusted data is not saved in the MetricBase database.

**Retrieving MetricBase data using REST and JavaScript**

Use JavaScript or REST APIs to retrieve time-series data from the MetricBase database and to run transforms on the data. The transformations enable you to visualize time-series data in a variety of ways.

For more information about MetricBase time-series data transformations, see **MetricBase transforms**.

**Using REST**

For information about the MetricBase REST APIs that return time-series data from the MetricBase database, see:

- **Clotho Time Series API**, which inserts, retrieves, and transforms data in the MetricBase database.
- **MetricBase Data Explorer** that comes with the MetricBase Demo, and enables you to experiment with the APIs.

**Using JavaScript**

For information about the MetricBase JavaScript APIs that return time-series data from the MetricBase database, see:

- **Client** — Execute transforms on the MetricBase database and receive the results.
- **Data** — Return the object that contains the result of a transform.
- **DataBuilder** — Create a series of data points for a metric.
- **Transformer** — Manipulate time-series data to prepare the data for evaluation and analysis.
- **TransformPart** — Specify details of the transform to be done.
- **TransformResult** — Return the object that contains the result of the transformation.
Example: Analyze time series data with JavaScript APIs

This example returns the average CPU usage over the specified time for each XYZ computer.

```javascript
// Query the cmdb_ci_computer table for the records for
var now_GR = new GlideRecord('cmdb_ci_computer');
gr.addEncodedQuery('manufacturer=xyz');
gr.query();

// Create a DataSelector object and specify the metric (cpu_percentage),
// the transform (avg), and label (avg cpu)
var transform = new sn_clotho.Transformer(now_GR).addMetric('cpu_percentage').avg()
    .label('avg-cpu-percentage');

// Run the transform between startTime and endTime.
// startTime and endTime are GlideDateTime
var data = transform.execute(startTime, endTime);
var values = data['avg-cpu-percentage'].getValues();
```

Example: Filter data

Developers can use SQL WHERE clauses in transformation scripts to filter data in report visualizations. Transformations in clotho aggregations apply mathematical functions on metric records. Use SQL WHERE clauses in transformation scripts to filter data. In the following example, the WHERE clause filters out all results except those results where mb_demo_mt_speed equals 100.

```javascript
var eqCon = new sn_clotho.Condition().eq(100);
var builder = new sn_clotho.Transformer(drones);
var fit = builder.metric("mb_demo_mt_speed").where(eqCon);
```

MetricBase triggers

Time-series data that is stored in the MetricBase database can trigger Flow Designer flows. These triggers can log incidents, send emails, and create other alerts.

You use MetricBase to define a trigger on an instance. When you associate the trigger with a Flow Designer flow, the trigger definition transfers from your instance to the MetricBase server. When you make the trigger and flow active, the trigger monitors the time-series data that is stored in the MetricBase database. When data meets the triggering conditions, MetricBase adds the trigger alert to the Trigger queue. The instance regularly polls that queue. When the polling finds a trigger waiting in the queue, the Flow Designer flow executes on the instance.
For more information about time-series policies, see Define and collect MetricBase data.

### High-level overview of implementing triggers

1. Define one or more of the following triggers on an instance:
   - **Band trigger**—Triggers when a metric value falls within a range of values.
   - **Linear Predictor trigger**—Triggers when a series of values trend toward and are expected to reach a specified value.
   - **Gap trigger**—Triggers when values are not received for a period of time.
   - **Model trigger**—Triggers when a trained model detects anomalous behavior.

2. Create a **trigger condition** to add additional requirements for a trigger to execute a flow.
   
   For example, data often fluctuates over time. Small fluctuations can cause unwanted, duplicate triggering events. A Condition Script can prevent that erroneous duplication.

3. **Associate the trigger with the flow it executes** using Flow Designer.

4. **Test the trigger and workflow.**

5. **Activate the trigger.**
Deleting triggers
You can't delete a trigger in MetricBase if it is associated with a Flow Designer. To delete a trigger, you must first delete the flow in Flow Designer and then you can delete the trigger in MetricBase.

Legacy triggers
Legacy triggers are deprecated. You can't create new ones; you can only carry forward ones that already exist. To see them, navigate to Legacy triggers.

Create a MetricBase band trigger
Create a MetricBase band trigger that detects when a metric value falls within a range of values.

Before you begin
Role required: admin

About this task
Band triggers execute when metrics fall outside of or within a range of values.

Procedure
2. On the MetricBase Trigger Creation form, click Band Trigger - Detects and takes action when metric value meet certain threshold or is within a range.
   On the MetricBase Band Trigger form, you can see the table and tracked metric but not the band trigger parameters.
3. On the form, fill in the fields.
MetricBase Band Trigger form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the band trigger.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table in the MetricBase database that contains the metric that you want to monitor. The only tables that appear when you click the search icon are the tables that you specified in the time-series metrics. If you select a metric before you select a table, only tables that have that metric appear in the Table name modal.</td>
</tr>
<tr>
<td>Metric</td>
<td>Table metric that you want to monitor that is specified by the Table name. The only metrics that appear when you click the search icon are the metrics in that table. If you select a metric before you specify a Table name, the metrics in all your time-series metrics appear. After you select a metric, only the tables that contain that metric appear when you click the search icon that is next to the Table name.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the trigger.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the trigger.</td>
</tr>
<tr>
<td>Aggregator</td>
<td>Aggregation value that you select: None, Max, Min, or Average. None means that you use the last value in the collection interval.</td>
</tr>
</tbody>
</table>

4. Click Save.

5. In the MetricBase Band Trigger Levels area, double-click each cell to add values that specify trigger parameters.
### MetricBase Band Trigger Levels

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level</td>
<td>Numbers that indicate increasing severity. For example, you might define the CPU usage for level 1 to be above 85% and the CPU usage for level 2 above 90%. Each level should trigger a different flow. <strong>Level</strong> is often used in <em>Conditional Scripts</em>.</td>
</tr>
<tr>
<td>Function</td>
<td>Function that makes the <strong>Value</strong> the maximum or minimum value of the lower end of the band and defines whether trigger values are inside or outside of the band. For example, if the <strong>Function</strong> is <strong>Less than</strong>, the trigger executes when the metric goes below band.</td>
</tr>
<tr>
<td>Value</td>
<td>Lower end of the band. See the following image.</td>
</tr>
<tr>
<td>Band Function</td>
<td>Function that makes the <strong>Band Value</strong> the maximum or minimum value of the upper end of the band and defines whether trigger values are inside or outside of the band. For example, if the <strong>Band Function</strong> is <strong>Greater than</strong>, the trigger executes when the metric goes above the band. See the following image.</td>
</tr>
<tr>
<td>Band Value</td>
<td>Upper end of the band. See the following image.</td>
</tr>
<tr>
<td>Tolerance</td>
<td>Tolerance range, plus or minus the <strong>Value</strong> and <strong>Band Value</strong>. Select a tolerance to prevent repeatedly executing a trigger for small fluctuations in the data. Once a trigger executes, the data must exceed the tolerance to execute</td>
</tr>
</tbody>
</table>
For example, if the **Function** is **Less than**, the **Value** is 100, the **Band Function** is **Greater than**, the **Band Value** is 200, and the **Tolerance** is 0, the trigger executes for all values that are less than 100 and greater than 200.

6. **Optional:** Add additional rows in the table to create multi-layered triggering behavior.
   Typically, each additional row indicates a more severe condition and the Flow Designer flow that is associated with the level warns with increasing severity.
   For example, level 1 might define the band from 100 through 200. Level 2 might define the level from 50 through 250.

7. Click **Update**.

8. **Optional:** Add a triggering condition that determines whether or not a trigger executes a Flow Designer flow.
   For more information, see [Create a triggering condition](#).

**What to do next**
Associate this trigger with a Flow Designer flow. For more information, see [Assign a trigger to a flow](#).

**Create a MetricBase linear predictor trigger**
Create a MetricBase linear predictor trigger to detect when a metric is likely to cross a specified threshold within a specified period of time.

**Before you begin**
Role required: admin
About this task

The linear predictor trigger uses past data to generate a line that predicts future values. When MetricBase predicts that the linear value will reach a threshold, the trigger executes.

If the most recent data point reaches the threshold, the trigger executes regardless of the linear prediction.

Trigger parameters include how much past data to use in the calculation of the prediction, how far ahead to look, and the level of confidence that you accept.

Procedure

2. Click Linear Predictor Trigger - Predicts and takes action when a metric follows an upward or downward trend and is expected to reach a given threshold in the future.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>MetricBase Linear Predictor Trigger form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Table name</td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>--------------</td>
</tr>
<tr>
<td>Metric</td>
</tr>
<tr>
<td>Active</td>
</tr>
<tr>
<td>Window</td>
</tr>
<tr>
<td>Confidence Level (%)</td>
</tr>
<tr>
<td>Trend</td>
</tr>
</tbody>
</table>
**Field** | **Description**
---|---
**Threshold** | Target value that the metric is expected to reach before the trigger executes.
**Description** | Description of the trigger.

4. **Click Save.**
   In the MetricBase Linear Predictor Trigger Levels form, you can create multiple trigger levels of increasing severity. For example, you can configure the battery level to be 80% for level one and at 90% for level two.

5. In the MetricBase Linear Predictor Trigger Levels area, double-click each cell to add values that specify trigger parameters.

| **MetricBase Linear Predictor Trigger Levels** |
|---|---|
| **Field** | **Description** |
| Level | Numbers that indicate increasing severity. For example, you might define level 1 to be CPU use is predicted to reach 85%. Level 2 might be CPU use is predicted to reach 90%. Each level can trigger a different Flow Designer flow. |
| Function | Function to use on the value. For example, **Less than or is**. |
| Window | How far into the future that you want the linear predictor to look to see if the metric is predicted to cross the threshold. Do not confuse this value with the **Window** value in the trigger definition form. That value specifies how much data to use (measured in time) to calculate the slope of the predictor line. |

6. **Click Update.**

7. **Optional:** Add a triggering condition that determines whether or not a trigger executes a Flow Designer flow.
   For more information, see Create a triggering condition.

**What to do next**
Associate this trigger with a Flow Designer flow. For more information, see Assign a trigger to a flow.
**Create a MetricBase gap trigger**

Create a MetricBase gap trigger to alert you when MetricBase stops receiving data.

**Before you begin**
Role required: admin

**About this task**

Gap triggers execute when MetricBase stops receiving data for a specified period.

![Graph showing amount of data over time with gaps]

You can define multiple trigger levels to indicate different severities. For example, you can set a gap of 15 minutes as level 1, a gap of 30 minutes as level 2, and so on. Each level should trigger a different Flow Designer flow. The difference between gap durations on different levels must be at least 10 minutes. For example, if you set level 1 to a gap of 15 minutes, you must set level 2 to a gap of 25 minutes or more.

**Note:** If you make the gap durations between levels less than 10 minutes, MetricBase displays an error message and deletes the level that you added.

MetricBase calculates how often to poll data by taking the difference between gap durations on different levels and dividing them by 2. For example, if level 1 triggers after 20 minutes of missing data and level 2 triggers after 40 minutes of missing data, the polling frequency is \((40-20)/2 = 10\) minutes. The maximum polling frequency is every 5 minutes, and the minimum frequency is every 30 minutes. If a trigger has only one level, the polling frequency is 30 minutes.

MetricBase searches through the data that is stored in the MetricBase database, not through incoming data. For that reason, a gap trigger might execute after the gap when data is missing. For example, if MetricBase polls the database every 10 minutes and the gap is 30 minutes of missing data, the trigger might execute as late as 40 minutes after the data was last received.
Procedure


2. In the MetricBase Trigger Creation form, click Gap Trigger - Detects and takes action when no data is received for a metric.

3. On the form, fill in the fields.

**MetricBase gap trigger form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the trigger.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table in the MetricBase database that contains the metric that you want to monitor. The only tables that appear when you click the search icon are the tables that you specified in the time-series metrics. If you select a metric before you select a table, only tables that have that metric appear in the Table name modal.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the trigger.</td>
</tr>
<tr>
<td>Metric</td>
<td>Value the trigger monitors in the MetricBase database.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the trigger.</td>
</tr>
</tbody>
</table>

4. Click Save.

5. In the MetricBase Gap Trigger Levels area, double-click each cell to add values that specify trigger parameters.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level</td>
<td>Numbers that indicate increasing severity. For example, you might define level 1 to be no data for 1 minute. Level 2 might be no data for 5 minutes. Each level should trigger a different flow.</td>
</tr>
<tr>
<td>Function</td>
<td>Function, <strong>Greater than or is</strong>, which means that this trigger executes when the gap in received data is greater than the value that you specify in the Window field.</td>
</tr>
<tr>
<td>Window</td>
<td>Length of time that no data has been received that executes the trigger. The format is</td>
</tr>
</tbody>
</table>
Field | Description
---|---
| | hours:minutes:seconds. For example, 00:20:00 means that this trigger executes after 20 minutes of missing data.

6. Click **Update**.

7. **Optional:** Add a triggering condition that determines whether or not a trigger executes a Flow Designer flow. For more information, see [Create a triggering condition](#).

**What to do next**
Associate this trigger with a Flow Designer flow. For more information, see [Assign a trigger to a flow](#).

**Create a MetricBase model trigger**
Model triggers execute when the time-series data deviates from expected values.

**Before you begin**
Role required: admin

**About this task**
Probabilistic exponentially-weighted moving average (PEWMA) is the only model type supported. MetricBase uses this model to create a definition of expected, normal values.

**Procedure**
1. Click **MetricBase > Flow Designer > Trigger Definitions** and click **New**.
2. Click **Model Trigger - Detects and takes action when a metric value deviates from the trained model**.
   The MetricBase Model Trigger form specifies the table and metric used to train the model.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name the model trigger.</td>
</tr>
<tr>
<td>Model</td>
<td><strong>Trained model</strong> this trigger uses.</td>
</tr>
<tr>
<td>Metric</td>
<td>Automatically filled in based on the model.</td>
</tr>
<tr>
<td>Table name</td>
<td>Automatically filled in based on the model.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the trigger.</td>
</tr>
<tr>
<td>Description</td>
<td>Explanation of the trigger.</td>
</tr>
<tr>
<td>Spike Direction</td>
<td>Trigger execution criteria. Specify whether you want to trigger only on anomalies that occur above predicted values, only on anomalies that occur below predicted values, or both.</td>
</tr>
<tr>
<td>Window</td>
<td>Amount of data to use when calculating the moving, weighted average; the longer the window, the more data. The recommendation is 30 times the sampling interval. For example, if the time-series data is sampled every minute, make this value 30 minutes. Values must be multiples of the sampling interval.</td>
</tr>
<tr>
<td>Active</td>
<td>Turns on the trigger.</td>
</tr>
</tbody>
</table>
**Note:** For the Window value, very short durations make the weighted average move with the data itself and fail to detect anomalies. Very long durations make the weighted average unresponsive to current trends in the data and may cause false triggers.

4. Click **Save**.

5. In the MetricBase Model Trigger Levels area, double-click each cell to add values that specify trigger parameters.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level</td>
<td>Numbers that indicate increasing severity. For example, you might define level 1 to be 3 standard deviations from the mean. Level 2 might be 5 standard deviations. Each level should trigger a different Flow Designer flow. Level is often used in Conditional Scripts.</td>
</tr>
<tr>
<td>Function</td>
<td><strong>Always Greater than or is</strong>, meaning that in order to trigger, the time-series metric must be greater than or equal to the number of standard deviations from the mean specified in <strong>Number of Standard Deviations</strong>.</td>
</tr>
<tr>
<td>Number of Standard Deviation</td>
<td>Float value specifying the number of standard deviations the time-series metric must be away from the mean to trigger an alert at this level.</td>
</tr>
</tbody>
</table>

6. **Optional:** Add additional rows in the table to create multi-layered triggering behavior. Each successive row should indicate a more severe condition.

7. Click **Update**. The MetricBase Trigger Definitions page displays the list of defined triggers.

8. Test your model and trigger on real data before deploying to production.

9. **Optional:** Add a triggering condition that determines whether or not a trigger executes a Flow Designer flow. For more information, see Create a triggering condition.

**What to do next**
Associate this trigger with a Flow Designer flow. For more information, see Assign a trigger to a flow.
**Execute triggers conditionally**

MetricBase triggers execute based on a single metric. Condition Scripts impose additional requirements that determine whether a trigger kicks off a flow.

**Before you begin**
Role required: admin

**About this task**
Condition Scripts execute when conditions for a trigger are met but before the trigger executes a Flow Designer flow. In that way, Condition Scripts can prevent triggers from executing flows even when trigger conditions are met. For example, data often fluctuates over time. Small fluctuations can cause unwanted, duplicate triggering events. A Condition Script can prevent that erroneous duplication.

Condition Scripts always return True (trigger) or False (do not trigger). To learn how to write these scripts, see Scripting in ServiceNow Fundamentals. To experiment with scripts, see Get familiar with MetricBase APIs.

You can create and save Condition Scripts in MetricBase but you associate them with triggers using Flow Designer.

**Procedure**

1. Click **MetricBase > MetricBase Triggers > Trigger Condition Script > New**.

2. On the Additional MetricBase Trigger Filtering Condition New Record form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the Condition Script.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of the Condition Script. The value, Global, means that the action applies to all applications.</td>
</tr>
<tr>
<td>Description</td>
<td>Explanation of what the Condition Script does.</td>
</tr>
<tr>
<td>Script</td>
<td>Field to enter the JavaScript. Make it returns True to execute a flow. See the next step.</td>
</tr>
</tbody>
</table>

3. Write the Condition Script.
   The key part of these scripts is the conditional statements. If all evaluate true, the script returns True and the flow executes, otherwise it does not. The following example script triggers a flow when a drone is traveling too fast at a low altitude (defined by level 1). The example shows a typical approach to writing a Condition Script.
a. Get the trigger definition.

b. Get the record (current) that is causing the triggering event.

c. Get the time from the record that the trigger conditions were satisfied.

d. Get the trigger level, which defines the trigger parameters.

e. Use these parameters to return True if the level 1 trigger conditions are met and travel_state equals traveling or speeding.

```javascript
function filter(/*GlideRecord*/ triggerDefinition, /*GlideRecord*/ current, /*GlideDateTime*/ start, /*int*/ level) {
    // retrieve current travel state of drone
    var travel_state = String(current.travel_state);

    // the drone is traveling at a significant speed, and the altitude just went below
    // the threshold
    if (((travel_state === 'traveling') || (travel_state === 'speeding')) && (level === 1)) {
        return true; // process this trigger
    }

    return false; // don't process this trigger
}
```

⚠️ **Note:** Condition Scripts must execute quickly.

4. Click **Submit**.

**What to do next**

Use Flow Designer to **associate a flow with a trigger**. When configuring a flow, you can select a Condition Script you created.
Assign a trigger to a flow

Now that you created a trigger, use Flow Designer to specify the flow a trigger executes. The flows provide alerts for unexpected behavior.

Before you begin
Role required: admin

About this task
Triggers, by themselves, execute nothing. After defining a trigger in MetricBase, you use Flow Designer to associate the trigger with a flow.

Procedure
1. Navigate to **MetricBase > Flow Designer**.
   Flow Designer displays a list of triggers associated with Flow Designer flows.

2. Click **New > New Flow**.

   Note: If the list contains triggers, click **+New** and then **New Flow** in the list.
3. Enter values for the modal fields and click Submit.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the flow to execute. The system computes the internal name of the flow from the name.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope to create your flow in. Global is the default.</td>
</tr>
<tr>
<td>Protection</td>
<td>Option to make the flow read-only. Selecting read-only prevents users who do not own the application scope from making changes to the flow. You can only select a value when you create the flow in an application scope you own.</td>
</tr>
<tr>
<td>Description</td>
<td>Explanation of why you are associating this flow with the trigger.</td>
</tr>
<tr>
<td>Run As</td>
<td>Choose whether the flow runs as System User or the user who initiates the session. Use the user who initiates the session option when the update should come from the user who triggered the flow. For example, comments to incident records that should come from the current user, or approval emails that should originate from the approver. Settings on a flow do not apply to child subflows. When run as the user who initiates the session, flow actions are limited by the user's ACL restrictions. Flows run by the initiating user respect user-specific settings like date/time format.</td>
</tr>
</tbody>
</table>

**Note:** When choosing the option to run as the user who initiates the session, ensure that security restrictions do not prevent users who will trigger the flow from performing the flow actions.

A tab opens and the tab name is the value for Name.

4. Click Click to add a trigger to specify the trigger that kicks off this flow. A modal displays that enables you to find and select a trigger type.

5. Scroll and select MetricBase for the trigger type. The Flow Designer form displays.
6. Under **TRIGGER**, fill in the form to define the trigger to associate with this flow.

   a. Beside **MetricBase Trigger**, click the magnifying glass to select an existing trigger or click the plus sign (+) to define a new trigger.

   b. Optionally, add requirements for the flow to execute by clicking **Add Filter** and adding filter conditions, for example, **flight-status is-not landed**.

   c. Optionally, beside **Condition Script**, click the magnifying glass to select a condition script or click the plus (+) to **create a script**. Condition scripts add additional requirements for a trigger to execute a flow.

7. Under **ACTIONS**, click **Click to add an Action, Flow Logic, or Subflow** and select a category in the first column and a flow action in the second column.
8. Click **Done**.

9. Test the flow.

   a. Navigate to **Flow Designer > Designer**, and double-click the flow.

   b. Click **Test**.
      The Test flow dialog box displays. The contents of the Test flow dialog depend on the type of trigger: Data or Schedule. If the trigger is a Data trigger, the dialog asks for a record to use for the test.

   c. Select a record in the dialog box and click **Submit**.

      ✋ Note: When you test a flow, the system does not execute the trigger, and therefore does not create a new record. By selecting a record in the Test flow dialog box, the system acts as if that record was just created. For more information, see Test a flow.

10. Click **Activate** to activate the trigger.
    The flow will not execute unless you activate it.
Maintain MetricBase

View the status of MetricBase and debug its triggers.

View MetricBase status and statistics

You can view the status of the MetricBase database.

Before you begin

Role required: admin

Procedure

1. View the status of the MetricBase instance.

   a. Navigate to System Diagnostics > Stats > Stats

   b. Scroll down to find MetricBase Statistics

2. View the metrics monitored by MetricBase and statistics about them.

   a. Click MetricBase > MetricBase Status

   The MetricBase Status page displays all of the metrics tracked in MB.
b. Click the gear icon. The Personalize List Columns modal displays.

c. Select and move metrics from the Available column to the Selected column to display the metric and click OK.
The metrics display on the MetricBase Status page.

<table>
<thead>
<tr>
<th>Name</th>
<th>s/bx</th>
<th>tv/s</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Anatomy#cleanupSelectors</td>
<td>0.0000</td>
<td></td>
</tr>
<tr>
<td>Anatomy#createShard</td>
<td>0.0000</td>
<td></td>
</tr>
<tr>
<td>Archive#append</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Archive#delete</td>
<td>0.0000</td>
<td></td>
</tr>
<tr>
<td>Archive#get.0</td>
<td>0.0009</td>
<td>0.4000</td>
</tr>
<tr>
<td>Archive#get.1</td>
<td>0.0000</td>
<td></td>
</tr>
<tr>
<td>Archive#get.2+</td>
<td>0.0000</td>
<td></td>
</tr>
<tr>
<td>Archive#initialize</td>
<td>0.0000</td>
<td></td>
</tr>
<tr>
<td>Archive#put.0</td>
<td>0.0000</td>
<td></td>
</tr>
</tbody>
</table>

View trigger logs
Trigger logs show different levels of trigger malfunctions.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to MetricBase > MetricBase Triggers > Trigger logs.
2. Click one of the trigger logs.
4. **Optional:** Change the default values in the Enter parameters for log file entries to browse form to select the log entries to view and click Submit.

Debug MetricBase
You can display the results of debugging scripts in MetricBase.

**Before you begin**
Role required: admin
Procedure

1. Navigate to System Diagnostics > Session Debug > Debug MetricBase.
   When the page you are on submits queries to MetricBase, you see the
   transforms and how long they took on the bottom of the page. Submitting a
   lot of MetricBase queries may slow down the page load time significantly.

2. To view a history of the debug script's execution, click available here.

3. Click Update.
   Session debug tracking for MetricBase activities starts and the MetricBase
   Status page displays.

Get familiar with MetricBase APIs

Experiment with MetricBase APIs using Data Explorer that is part of the
MetricBase Demo application. Data Explorer uses the data installed with the
MetricBase Demo application.

Before you begin
Role required: clotho_admin

About this task
Data Explorer is a playground where you can see and edit example scripts that
visualize data included with the MetricBase Demo application. The example
scripts use the MetricBase JavaScript APIs. For information on the MetricBase
JavaScript APIs, see Client, Data, DataBuilder, Transformer, TransformPart,
TransformResult.

Example scripts use either:

• Transforms, which use the Transformer method.
• Machine Language, trained models that predict expected behavior. All the
  scripts without "Transform" in their title use Machine Language.

Procedure

1. Navigate to MetricBase Demo > Data Explorer.
   The Data Explorer displays.
When you run a script, the data visualization appears under **Data Explorer Script Result Display**.

2. Select one of the sample scripts to run in the **Example Script** menu.

3. Click **Load Example**.

4. Click **Run**.
The script displays the data visualization under **Data Explorer Script Result Display**.

5. **Optional:** Change the values or statements in the script or write an entirely new script and click **Run**.

   ✨ Note: If you want to save the changes you made in the script, click **Save**.

6. Under **Server Output**, look at the server's response that might include error information.

**Example:**

**Example scripts**

<table>
<thead>
<tr>
<th>Example script</th>
<th>Definition and visualization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple Transform</td>
<td>Uses the transformer API to display a single time-series metric, the average speed of the drones: transformer.metric('mb_demo_mt_speed').avg().</td>
</tr>
</tbody>
</table>
| Simple Transform with Grouping  | Uses the transformer API to display a group of time-series metrics, the average altitude of the fleet of the drones: 

```plaintext
transformer.groupBy("fleet").metric("mb_demo_mt_altitude")
  .avg().label('avg - %g: fleet:')
```
<table>
<thead>
<tr>
<th>Example script</th>
<th>Definition and visualization</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Normal Model</strong></td>
<td>Models normal data, which approximates a bell-shaped or Gaussian curve for distributed values.</td>
</tr>
<tr>
<td><strong>Linear Model</strong></td>
<td>Creates a line to summarize the current data and predict future values. This example, about the remaining charge in drone batteries, graphs both the trained model values and the average of the values.</td>
</tr>
</tbody>
</table>

```
var builder = new sn_clotho.Transformer(drones);
var fit =
    builder.metric("mb_demo_nt_rem_battery").resample(100).
    fit({model:"linear"}).label("Fitted");
builder.metric("nb_demp_mt_rem_battery").avg().label("Original")
```
Example scripts (continued)

<table>
<thead>
<tr>
<th>Example script</th>
<th>Definition and visualization</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Seasonal Trend Decomposition Model</strong></td>
<td>Uses a seasonal trend model so that data can be subtracted to reveal non-seasonal trends. This model is similar in purpose to the Holt Winters model but arrives at the result using different algorithms.</td>
</tr>
<tr>
<td></td>
<td>var builder = new sn_clotho.Transformer(drones);</td>
</tr>
<tr>
<td></td>
<td>var metric = &quot;nb_demo_mt_rem_battery&quot;;</td>
</tr>
<tr>
<td></td>
<td>var fit =</td>
</tr>
<tr>
<td></td>
<td>builder.metric(metric).fit({model:&quot;STL&quot;, periodicity:&quot;PT2H&quot;, innerCycles:1, outerCycles:10})</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Holt Winters Model</strong></th>
<th>Uses the Holt Winters, seasonal trend model so that data can be subtracted to reveal non-</th>
</tr>
</thead>
</table>
### Example scripts (continued)

<table>
<thead>
<tr>
<th>Example script</th>
<th>Definition and visualization</th>
</tr>
</thead>
<tbody>
<tr>
<td>seasonal trends. This model is similar in purpose to the Seasonal Trend Decomposition model but arrives at the result using different algorithms.</td>
<td></td>
</tr>
<tr>
<td><strong>ARIMA Model</strong></td>
<td>The most general class of models for predicting time-series data that has no trend, meaning all the data has the same value or the values fluctuate sinusoidally around the mean.</td>
</tr>
<tr>
<td><strong>Deviation Model</strong></td>
<td>Uses chisquare model to show the differences between the real data and the model's prediction.</td>
</tr>
</tbody>
</table>

```javascript
var metric = 'nb_demo_mt_rem_battery';
builder.metric(metric).deviation(model, 'chiSquare');
```

---

### Domain separation and MetricBase

Domain separation is supported in the MetricBase application. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: Basic**
• Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.

• The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.

Related information

Domain separation for service providers

MID Server

The Management, Instrumentation, and Discovery (MID) Server is a Java application that runs as a Windows service or UNIX daemon on a server in your local network. The ServiceNow® MID Server enables communication and the movement of data between a ServiceNow instance and external applications, data sources, and services.

The MID Server initiates all communications with the ServiceNow® instance. This communication is recorded as records in the ECC Queue, which acts as the communication log between the instance and the MID Server. The MID Server picks up any work it has to do from the ECC Queue and returns the results of that work to the queue.

This video gives you an overview of the MID Server:

<table>
<thead>
<tr>
<th>MID Server overview</th>
</tr>
</thead>
</table>
Setting up the MID server

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

This documentation provides detailed instructions for setting up a functioning MID Server for use with ITOM applications. Click the icons to go to each task’s portal page. These procedures help you prepare your system, download and run the installer, and configure MID Servers to run in your environment. After you get a valid MID Server up and running, you can add security and encryption to protect your data.

At the bottom of each page is a link to the reference materials you need, such as MID Server system requirements, configuration parameters, and instructions for monitoring your MID Server. Use the additional links at the bottom to move through the content within a specific category or return to the MID Server setup to access a different portal.

If you are new to the MID Server or an experienced user who wants to set up a MID Server quickly, you can use the MID Server Guided Setup. This wizard walks you through the process of installing and configuring a MID Server with default settings in just a few steps.
Upgrading the MID Server

The MID Server checks with the instance periodically to see if an upgrade is necessary. If the MID Server detects that a new version is available for upgrade, it downloads the installer from install.service-now.com and runs the package automatically. You can also elect to upgrade the MID Server manually. See MID Server upgrades for details.

Resolving MID Server issues

You can search the HI Knowledge Base for troubleshooting articles or monitor the MID Server status and track active issues from within the instance. Many articles on resolved MID Server issues have been collected on Servicenow MID Server Landing page [KB0960404]. For more information about common resolution procedures, see Resolving MID Server issues.

ServiceNow applications that use the MID Server

- Discovery
- Orchestration
- Service Mapping
- Event Management
- Operational Intelligence
- Cloud Management
- IntegrationHub
- Cloud Insights

External applications that use the MID Server

- Import Sets
- Microsoft SMS/SCCM
- LANDesk Maintenance Suite
- Microsoft System Center Operations Manager (SCOM)
- Microsoft MIIS

MID Server version compatibility

The version of the MID Server must be compatible with the version of the instance. Otherwise, the MID Server cannot process commands or communicate with the instance.

The instance determines which version of the MID Server is allowed. The MID Server version must at a minimum belong to the same major release, such as
Madrid. If the MID Server version belongs to the same major release, it can, but does not have to, belong to the same minor version, such as Madrid Patch 1. In this case, communication with the instance might still be possible, but it is always suggested that you upgrade to the latest version.

⚠️ **CAUTION:** You can pin the MID Server to a specific version, but you should be aware that the version might become out of date.

### Configure MID Server network connectivity

Prepare the network for MID Servers to connect with the instance and access the download site. The network must be prepared before installing or configuring the MID Server. If computers or devices have additional security measures, that security may interfere with MID Servers on those systems.

**Before you begin**

Role required: admin

---

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Ensure that the MID Server can connect to elements inside and outside your network
3. Configure MID Server security
4. Configure your MID Server
5. Download and install the MID Server on a Linux or Windows host
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

**Prerequisites:** Make sure that the host machine meets the requirements specified in the MID Server system requirements.

**About this task**
The MID Server host computer must have access to the ServiceNow download site at install.service-now.com to upgrade automatically. If you have a self-
hosted ServiceNow environment that blocks access to the download site, you must import the MID Server installer package into your MID Server hosts manually. For instructions, see KB0760123 in the Self-Hosted knowledge base.

Firewalls and proxy configurations may block calls to the OCSP Entrust server, which prevents the MID Server from working. You may need to change your firewall permissions so the OCSP traffic to go through properly. For more information and resolutions, see the HI Knowledge Base article [KB0813636].

The host machine must have these network privileges:

- Firewall access: Configure any firewalls between the MID Server and the target devices to allow a connection. If your network uses a DMZ, and if your network security protocols limit port access from within the network to the DMZ, you might have to deploy a MID Server to a machine within the DMZ to probe the devices there.

- Network access: Configure target devices to allow the MID Server probe to connect. If network security prevents you from configuring new machines that can connect to the targets, install the MID Server on an existing machine with connection privileges.

- Network account: Install the MID Server with the proper account, either local or domain administrator.

Additionally, for the MID Server to access your ServiceNow instance, satisfy these prerequisites:

- Network access to the ServiceNow instance: Configure the network that the MID Server uses to allow traffic over TCP port 443.

- A MID user: Create a ServiceNow user record for the MID Server to use. This user record must have the mid_server and import_admin roles.

⚠ Note: Verify that the baseline public page InstanceInfo is active for the MID Server to connect to the instance.

Procedure

1. Configure the network to allow MID Server network connectivity to the ServiceNow instance over TCP port 443.

2. Configure basic authentication for SOAP communications with the ServiceNow instance.

3. Navigate to System Web Services > Scripted Web Services > Scripted SOAP Services.

4. Confirm that the following web services are active:
5. Type `sys_public.list` in the navigation search field and press Enter. The Public Pages record list appears.

6. Verify that the `InstanceInfo` public page is active, to allow the MID Server to validate its version.

7. Ensure that the MID Server host computer can access the download site at `install.service-now.com`.

What to do next
After the network is prepared, proceed to Installing the MID Server.

Prepare network connections for MID Servers
Before you install the MID Server, perform the necessary prerequisites that it needs to connect to elements inside and outside your network. This includes network privileges and security considerations.

Security considerations
Sometimes computers or devices have additional security measures configured, and these measures may interfere with the MID Server's ability to run commands or queries on those systems.

For example, a Linux server might be configured to allow only certain IP address to connect to it via SSH. Similarly, a network router might be configured to allow only certain IP address to query SNMP on it. To allow access in such cases, use one of the following methods:

- Update the configuration of those computers or devices to allow the desired MID Server to run commands or query them. For example, a network router may be configured to only allow the network management systems to query SNMP on it. In that case, add the MID Server as though it were another network management system.
• Install a MID Server on a computer that already has access to the computers or network devices with such restrictions. For example, to use Discovery within a DMZ (where communication from outside the DMZ will be severely restricted), install a MID Server on a computer that is already in the DMZ.

**External connectivity requirements**

These requirements are specifically for the use of MID Servers with the ServiceNow® Discovery and Orchestration products.

The MID Server communicates securely on port 443 to the instance and requires no inbound connections. In some cases, it might be necessary to allow this communication through the firewall if the MID Server fails to register on the instance. To determine if the application or a network security restriction is to blame for connection failure, attempt to telnet to the instance on port 443 from the server that is hosting the MID Server application. If this connection fails, then the problem could be a web proxy (since 443 is an https connection) or a Firewall rule preventing external TCP connections from that host. Contact network security personnel for the proxy information to add to the config.xml file, or request that the firewall be configured to allow access using one of the following syntaxes:

- `<source IP> to <any>`
- `<source IP> to <ServiceNow> any established`
- `<source IP> to <instance_name.service-now.com> 443`

**Important:** The MID Server host computer must have access to the ServiceNow download site at install.service-now.com to upgrade automatically. If you have a self-hosted ServiceNow environment that blocks access to the download site, you must import the MID Server installer package into your MID Server hosts manually. For instructions, see KB0760123 in the Self-Hosted knowledge base.

**Internal connectivity requirements**

These methods are used for discovering various devices on a network and are specifically for the use of MID Servers with the Discovery and Orchestration products.

- **SSH**: For UNIX-like machines, Discovery and Orchestration use SSH protocol, version 2 to access target machines. SSH is a network protocol that allows data to be exchanged using a secure channel between two networked devices. SSH communicates on port 22 within an encrypted datastream and requires a login to access the targets using two available methods of authentication: a user name and password combination and a user name and shared private key. Specify SSH authentication information and type
in the **Credentials** module. If multiple credentials are entered, the platform tries one after the other until a successful connection is established or all are ultimately denied. To provide for application relationships a limited number of SUDO commands must be available to be run. Additional details to these requirements can be found in UNIX/Linux commands requiring root privileges for Discovery and Orchestration.

- **WMI**: For Windows machines, Discovery uses the Windows Management Instrumentation (WMI) interface to query devices. Due to security restrictions for WMI, the MID Server application executing the WMI queries must run as a domain user with local (target) administrator privileges. When Discovery detects activity on port 135, it launches a WMI query. The response from the Windows device is sent over a Distributed Component Object Model (DCOM) port configured for WMI on Windows machines. This can be any port. Ensure that the MID Server application host machine has access to the targets on all ports due to the unique nature of the WMI requirements.

- **Windows PowerShell**: PowerShell is built on the Windows .NET Framework and is designed to control and automate the administration of Windows machines and applications. Orchestration uses PowerShell to run Workflow activities on Windows machines. PowerShell must be installed on any MID Server that executes these activities. MID Servers using PowerShell must be installed on a supported Windows operating system. ServiceNow supports PowerShell 3.0 to 5.1. Orchestration activities for PowerShell require a credentials **Type** of Windows.

- **SNMP - Network**: For network devices, Discovery uses an SNMP scan to get device specific MIBs and OIDs. SNMP is a common protocol used on most routers, switches, printers, load balancers and various other network enabled devices. Use a **community string** (password) for authentication when scanning a device via SNMP. Many devices have a default community string of **public** which Discovery uses by default when querying a target. Define additional community strings in the **SNMP credentials** form which are tried in succession, along with **public**, until a successful query returns. In addition to the credentials, the platform also requires the ability to make SNMP requests on port 161 from the MID Server to the target. If Access Control Lists (ACLs) are in place to control the IP addresses that can make these queries, ensure that the IP address of the MID Server is in the ACL. Discovery supports SNMP versions 1, 2c, and 3.

- **WBEM**: Web-Based Enterprise Management (WBEM) defines a particular implementation of the Common Information Model (CIM), including protocols for discovering and accessing each CIM implementation. WBEM requires either of two ports, 5989 or 5988 and uses the HTTP transport protocol. WBEM supports SSL encryption and uses CIM user name/password credentials.
Discovery launches a WBEM port probe to detect activity on the target ports and to append gathered data to a classification probe that explores CIM Servers.

## Installing the MID Server

Download and install the MID Server on the host machine, test the connection, and then validate the MID Server. Use the manual procedures or the guided setup. Set up multiple MID Servers for load balancing and domain separation. These procedures prepare it for use with any application.

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

**Prerequisites:** Ensure the MID Server system requirements and MID Server connection prerequisites are met before you install the MID Server manually or use the guided setup utility.

**MID Server manual installation**

The manual process requires these setup tasks, performed in the order shown here:

1. Create the MID Server user account and grant the appropriate role to this user.
2. Download the installer file for the host machine.
3. Install the MID Server on a Linux or Windows host.
4. **Validate the MID Server** to ensure that it is trusted to access credentials used by the instance for automations.

5. **Test connectivity** between the MID Server and the instance for automatic upgrades.

6. Optionally, **deploy multiple MID Servers** in your network for load balancing or when domain separation is enabled.

**MID Server guided setup**

Alternatively, the MID Server Guided Setup streamlines the process and allows you to set up a basic MID Server quickly.

**Create the MID Server user and grant the role**

To communicate with the instance, MID Servers need a user ID and the appropriate role. Create the user ID for a MID Server and grant the ID the `mid_server` role. To prevent MID Server validation failure, the system runs business rules to monitor the settings selected for MID Server users.

**Before you begin**

Role required: admin

---

1. **Ensure that the MID Server can connect to elements inside and outside your network**

2. **Download and install the MID Server on a Linux or Windows host**

3. **Configure your MID Server**

4. **Configure MID Server security**

5. **Ensure that the MID Server can connect to elements inside and outside your network**

6. **Download and install the MID Server on a Linux or Windows host**

7. **Configure your MID Server**

8. **Configure MID Server security**
About this task
The MID Server connects to an instance by using the SOAP web service. To allow authentication with the instance, create a separate user account for each MID Server or share the same account across multiple MID Servers. Grant each MID Server user the mid_server role, which is required for the MID Server user on any instance on which basic authentication is enabled. The mid_server role allows the MID Server to access protected tables when strict SOAP security is in place. The system adds the necessary SOAP roles automatically with this role.

⚠️ Note: The strict SOAP security feature, enabled by default for any instance that uses basic authentication, protects all tables with Access Control Lists (ACL).

Procedure
1. From the instance, navigate to User Administration > Users.
2. Click New.
3. Complete the fields in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>User name for the MID Server user. This name is specified in the mid.instance.username parameter of the configuration file that the MID Server installer creates. For details, see MID Server parameters.</td>
</tr>
<tr>
<td>First name</td>
<td>The user's first name.</td>
</tr>
<tr>
<td>Last name</td>
<td>The user's last name.</td>
</tr>
<tr>
<td>Password</td>
<td>Password for the MID Server user. This password is specified in the mid.instance.password parameter of the configuration file that the MID Server installer creates.</td>
</tr>
</tbody>
</table>

4. Right-click the header and select Save.
5. Under the Roles related list, click Edit.
6. Select the mid_server role for this user. Each MID Server account must have this role to access protected tables.
7. Click Save.
8. Confirm that the MID Server account was created successfully and the account has connectivity to the instance.

   a. On the host machine where you intend to install the MID Server, open a browser and navigate to the instance.

   b. Use your new MID Server user credentials to log in. If the login is successful, then any MID Servers you install on that host will be able to connect to the instance.

**MID Server role validation**

Real-time system validation of MID Server role assignments prevents incompatible settings.

To prevent MID Server validation failure and ensure that your MID Server is configured correctly, the system runs several business rules that monitor the roles and settings you select for your MID Server user. The instance displays a warning and blocks the change when you attempt to save an incompatible configuration.

**Elevated privileges not permitted**

The mid_server role cannot be configured for elevated privileges. The **Invalid MID Server settings** business rule runs on the Role [sys_user_role] table and prevents the *elevated_privileges* field from being set to true for the mid_server role.

**Warning for elevated privileges on the mid_server role**

![Warning for elevated privileges on the mid_server role](image)

**Relationship table protection**

The User Role [sys_user_has_role] table creates the relationship between the User [sys_user] and the Role [sys_user_role] tables.
• **Incompatible role**
  The mid_server and security_admin roles are incompatible and cannot be assigned to the same user. The system determines the user's current role and runs the **Security Admin incompatible with MID** business rule on the User Role [sys_user_has_role] table. This rule prevents an administrator from adding the security_admin role for a user who currently has the mid_server role.

<table>
<thead>
<tr>
<th>User</th>
<th>Tyree Courrege</th>
</tr>
</thead>
<tbody>
<tr>
<td>A user cannot be granted both the mid_server and security_admin roles</td>
<td></td>
</tr>
<tr>
<td>'security_admin' role assignment rejected</td>
<td></td>
</tr>
</tbody>
</table>

• **Incompatible user role and user record settings**
  The **Incompatible MID Server user role** business rule runs on the User Role [sys_user_has_role] table to protect its data from incompatible configurations. Validation for this related table ensures that an administrator cannot assign the mid_server role to a user who already holds the security_admin role.

**What to do next**

Download the MID Server files for your operating system.

**Download the MID Server files**

Download the MID Server installer package through the instance and make it available for installation on the host. Allow the local network to access the authorized IP addresses to ensure that you can download the installation package and receive automatic upgrades.

**Before you begin**

Role required: admin
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

About this task
The IP address of the MID Server download site (install.service-now.com) can change without notice. To ensure that you can download the MID Server installation package and receive automatic MID Server upgrades, allow local network access to these IP addresses:

- 149.96.5.98
- 149.96.6.98

⚠️ Note: Download the MID Server first and then enable Discovery, Orchestration, or any integration that requires the use of the MID Server.

Procedure
1. On the ServiceNow instance, navigate to **Mid Server > Downloads**.
2. Select and download the MID Server for the appropriate operating system. For the best performance, install the 64-bit MID Server for your operating system.
Note: ServiceNow no longer supports new installations of 32-bit MID Servers or upgrades to version Rome. New MID Server installation are blocked through RPM and MSI installer on the following operating systems:

- CentOS 6
- Windows server 2008
- Windows server 2008 R2
- Windows 8
- Windows 10

Unsupported MID Servers auto-upgrading to Rome create an issue record in MID Server Issues (ecc_agent_issue). For more information, see Supported platform changes for MID Server [KB0863694].

MID Server downloads

3. Save the download file to a temporary file on the local drive.
4. Move the file into the designated MID Server folder you create for your operating system and run the installer from that location.

What to do next
You can manually verify the signature of an installation package with the jarsigner tool to ensure its authenticity. For more information about verifying the signature, see the MID Server upgrades section on manual verification.

Install the MID Server on the host computer.

- Linux
- Windows
Install a MID Server on Linux

Install MID Servers with the MID Server installer and verify it is active. The package includes an installer that automatically configures JRE to run in the environment. The MID Server can use an existing JRE rather than the provided JRE. Uninstall the MID Server to redeploy it.

Before you begin
Verify that the host computer satisfies the MID Server system requirements.
Role required: admin, mid_server

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

About this task
To install Linux on MID Server, the RedHat/CentOS systems require RPM while Debian (Ubuntu) systems require DEB. The default installation location is /opt/servicenow/mid. Installing DEB in user defined directories is not supported.

To improve security, this procedure installs the MID Server as a non-root user. A non-root user can manage a service only if they have the required permissions. For more details, see PolicyKit issues with Linux MID Servers using non-admin accounts [KB0815542].
Note: ServiceNow no longer supports new installations of 32-bit MID Servers or upgrades to version Rome. New MID Server installation are blocked through RPM and MSI installer on the following operating systems:

- CentOS 6
- Windows server 2008
- Windows server 2008 R2
- Windows 8
- Windows 10

Unsupported MID Servers auto-upgrading to Rome create an issue record in MID Server Issues (ecc_agent_issue). For more information, see Supported platform changes for MID Server [KB0863694].

Java 11 is bundled with the MID Server installer package and is installed on the host for all new MID Servers. The installer automatically configures Java 11 to run in your environment. No additional configuration is required. This version supports both 64-bit and 32-bit Windows MID Servers, and 64-bit Linux MID Servers. For the best performance, install the 64-bit MID Server for your operating system. The MID Server requires a minimum JRE version 1.8.0_161, and recommended version 11.0.8. If you are using a lower version than 1.8.0_161, you may see encryption related issues.

Note: Linux MID Servers require glibc version 2.17. The library must be updated for JRE 11. On 64-bit Linux systems, you must install the 32-bit GNU C library (glibc). The installation command for CentOS is: yum install glibc.i686

Testing showed that the MID Server works as expected with Oracle Java 11 version 11.0.5 and Oracle JRE 8 version 1.8.0_231. However, Oracle JRE 8 version 1.8.0.231 requires the workaround described in the HI Knowledge Base article MID Server running Oracle JRE version 8 [KB0784442]. If you need to upgrade the JRE to a different version, then coordinate with the appropriate account representative for support.
Procedure

1. On the instance, navigate to MID Server > Download and download either the MID Server installer RPM file for RedHat/CentOS or the DEB file for Debian (Ubuntu) systems.

   ![Download screen](image)

   **Note:** Use the copy link button to copy the download link and use the following `wget` command to directly download the installers in Linux machines.

   ```
   wget <copied link of the installer>
   ```

2. **Optional:** Manually verify the authenticity and integrity of the downloaded file.

   a. Download the signature ZIP files for RPM/DEB.

   b. Run the following commands for either RPM or DEB.

   (Optional) **RPM**

   - Extract the public key, `ServiceNow_Digicert_DGST.pem`, and signature file from the downloaded signature zip file.

   - Run the following command to verify the signature of the RPM file.

   ```
   openssl dgst -sha256 -verify <Extracted .pem file> -signature <Extracted bin file path> <RPM file path>
   ```

   **DEB**

   - Extract the public key, `ServiceNow_Digicert_Public.gpg`, from the downloaded signature zip files.

   - Import the public key and verify the signature of the DEB file with the following commands.

   ```
   gpg --import <public key>
   dpkg-sig --verify <DEB file path>
   ```

3. Use the following commands to install either the RPM or DEB installer:
RPM

• Install the RPM package for RedHat systems with the following command:

  ```bash
  sudo rpm -ivh --nodeps package_name.rpm.
  ```

• Install the RPM package for RedHat systems in a user defined location with the following command:

  ```bash
  sudo rpm -ivh --nodeps package_name.rpm --prefix=/path/to/user/directory.
  ```

DEB

• Install the DEB package for Debian systems with the following command:

  ```bash
  sudo dpkg -I package_name.deb.
  ```

4. To configure the MID Server service, run the following command from the agent/bin folder as root and provide the required inputs.

  ```bash
  ./installer.sh
  ```

5. The `installer.sh` script takes the following inputs.

   **Instance URL**
   Enter the full URL of your instance, for example: `https://mycompanyinstance.service-now.com`

   **MID-Server Username**
   Enter the user name of the MID Server user that you already created. The MID Server user must have the mid_server role.

   **MID-Server Password**
   Set the password for the current MID Server user.

   **MID-Server Name**
Set the name of the MID Server.

Proxy Server Information (optional)

**mid.proxy.use_proxy**
Enables the MID Server to use a web proxy to access the ServiceNow instance.

**mid.proxy.host**
Set this parameter to define the web proxy's host.

**mid.proxy.port**
Set this parameter to define the web proxy's port.

**mid.proxy.username**
If the web proxy requires a user name, set this parameter to define that username.

**mid.proxy.password**
If the web proxy requires a password, set this parameter to define that password.

To run a MID Server as a daemon service, the following properties are also required.

**app_name**
Set a unique name for the current MID Server.

**app_long_name**
Set a unique long name for the MID Server.

**run_as_user**
Set the username to run the service as a non-root user.

**Results**
Once all the inputs are entered, the MID Server automatically runs as a daemon service and starts the service.

**Linux MID Server silent installation**
Silently installing the MID Server uses predefined parameters and requires no user input after it is initiated. You can use silent installation on several machines at once to quickly set up a network and to ensure all MID Servers have the same installation settings.

To perform a silent installation with the Linux installer, run the following command:
The following fields can be passed through the command line:

**INSTANCE URL**

Enter the URL of your instance, for example: https://mycompanyinstance.service-now.com

**MUTUAL_AUTH**

Set this value to Y to use mutual authentication instead of basic authentication. Otherwise, set it to N.

*Note:* If MUTUAL_AUTH = Y then provide the path to the certificate with CERTIFICATE_PATH.

**CERTIFICATE_PATH**

If mutual authentication is enabled, provide the path to the certificate.

**MID_USERNAME**

Enter the user name of the MID Server user that you already created. The MID Server user must have the mid_server role.

**MID_PASSWORD**

Enter the password for the user.

**USE_PROXY**

Set this value to Y if your MID Server communicates through a proxy to connect to the instance.

*Note:* If USE_PROXY = N then skip the other proxy details.

**PROXY_HOST**

Enter the proxy server host name or IP address. Do not include the protocol in the host name. For example: proxyserver.domain.com is correct, but https://proxyserver.domain.com is incorrect.

**PROXY_PORT**

Enter the port the proxy server uses to communicate. If this value is blank, the installer uses the proxy server’s default port number.

**PROXY_USERNAME**

Enter the username that has administrator rights to the proxy server.
**PROXY_PASSWORD**

Enter the password for the username.

**MID_NAME**

Enter the MID Server name.

**APP_NAME**

Provide the service name. It must be unique for the current MID Server.

**APP_LONG_NAME**

Provide the service long name.

**NON_ROOT_USER**

Provide the username to run the service as a non-root user.

The following is an example command for a MID Server which uses a proxy and mutual authentication:

```
./installer.sh -silent -INSTANCE_URL https://instance_name.service-now.com MUTUAL_AUTH
Y -CERTIFICATE_PATH <path-to-certificate> -USE_PROXY Y -PROXY_HOST <ip> -PROXY_PORT
(port) -PROXY_USERNAME <username> -PROXY_PASSWORD <password> -MID_NAME proxymid -APP_NAME
proxymid -APP_LONG_NAME servicenow_proxy_mid -NON_ROOT_USER nonrootuser
```

⚠️ **Note:** To reconfigure the MID Server, run the installer.sh command again. Reconfiguring the MID Server deletes the old configuration.

---

**Run Linux MID Servers as non-root users**

Run MID Servers as non-root user on a Linux machine to improve security. Multiple MID Server can be installed as services so they can start by themselves after system reboots.

**Before you begin**

Role required: root

This process is only applicable if you installed the MID Server manually using the ZIP file. If you installed the MID Server with the procedure in Install a MID Server on Linux, then the MID Server is already running as a non-root user.

Supported versions for this procedure are Linux Red Hat 6 or newer, Ubuntu 1404 or newer, and CentOS 6 or newer.
Procedure

1. Stop any MID Server running on the host with the command `bin/mid.sh stop`.
2. Remove any MID Servers on the host with the command `bin/mid.sh remove`.
3. Edit the file `mid.shconf_override`.

```
# To put any changes into effect, re-install the service using the commands
# bin/mid.sh stop then bin/mid.sh remove followed by bin/mid.sh install

# Uncomment the lines below and set some name for the current MID server.
# This allows multiple MID Servers to run as a service on the same host.
#APP_NAME=“this_mid_app_name”
#APP_LONG_NAME=“this_mid_long_app_name”

# Put a username here to run the service as a non-root user.
# The specified user will be the owner of the entire agent directory.
# If left empty, the owner is unchanged.
RUN_AS_USER=

# Put a group name here that will be the group owner of the entire agent directory.
# If left empty, the group is unchanged.
GROUP_NAME=

# Set a flag to control whether the script will prompt for confirmation before
# changing the owner or group of the agent directory
PROMPT_BEFORE_OWNERSHIP_CHANGE=true
```

4. Add the MID Server's name using the lines `APP_NAME=` and `APP_LONG_NAME=` to run it as a service.
   To prevent errors, the `APP_NAME` of each MID Server must be unique.

5. **Optional:** To run multiple MID Servers as services on the same host, add an `APP_NAME` and `APP_LONG_NAME` for each instance.
6. Add the name of the non-root user to operate the account using the line `RUN_AS_USER=`.

7. Optional: Add the name of the group to own the entire agent directory using the line `GROUP_NAME=`.

8. Set the line `PROMPT_BEFORE_OWNERSHIP_CHANGE=` to `true` to prompt the user for confirmation before any changes to file permissions are applied. The file permission change is applied to the entire agent folder and everything inside recursively. The changes include blocking other users’ access to the entire agent folder, changing the owner to `$RUN_AS_USER` if specified, and changing the group to `$GROUP_NAME` if specified.

9. Reinstall the MID Server with the command `bin/mid.sh install`.

*NNote:*
To prevent errors, make sure to stop and remove any existing MID Server services before starting new ones. During the first installation, a root user is required to call `bin/mid.sh install`. Reinstalling the MID Server applies the changes in `mid.shconf_override`. Then the non-root user specified in `mid.shconf_override` is able to start/stop/restart the service without elevated privileges.

**What to do next**
For more information about managing the allow list and file permission enforcement, see [File permission enforcement for Windows MID Servers](#). Running a Linux MID Server with a non-root account may result in issues with PolicyKit in some systems. See [PolicyKit issues with Linux MID Servers using non-root accounts](#) for more information.

**Configure a Linux MID Server to use an existing JRE**
You can choose to use an existing JRE for your MID Server rather than the OpenJDK provided with the MID Server installer.

**Before you begin**
Ensure that your JRE version is supported. See [MID Server system requirements](#) for details.
Role required: admin

About this task
By electing to use your own JRE, you are responsible for upgrading it as necessary. For a detailed procedure and cautions regarding changing the JRE, see KB0778272.

Procedure
1. Navigate to this file in the MID Server installation directory:
   agent/conf/wrapper-override.conf
2. To specify the existing Java executable that you want to use, add this line to the file:
   wrapper.java.command={your_java_executable}
   For more information, see the Java service wrapper property documentation.
3. Save the file.

Uninstall a Linux MID Server
The MID Server runs as a stand-alone service. You can remove a stand-alone MID Server service to accommodate such tasks as redeploying the MID Server to another host machine or changing the unique name of a MID Server when deploying multiple MID Servers.

Before you begin
Role required: admin

Procedure
Run the uninstall.sh script in the agent folder to remove the service and uninstall the RPM/DEB.

```
[centos761810:/opt/servicenow/mid-agent]# ./uninstall.sh
Uninstalling MID Server RPM package : agent-19.itomqcopper.0.268-172.el7.x86_64
Preparing packages...
Running 'mid.sh remove' to uninstall MID server
Detected RHEL or Fedora:
Stopping servicenow_mid_server_silentMId...
Waiting for servicenow_mid_server_silentMId to exit...
Stopped servicenow_mid_server_silentMId.
Removing servicenow_mid_server_silentMId daemon from systemd...
Removed symlink /etc/systemd/system/multi-user.target.wants/silentMId.service.
agent-19.itomqcopper.0.268-172.el7.x86_64
[centos761810:/opt/servicenow/mid-agent]# 
```

Results
The MID Server service is uninstalled.
What to do next

Validate the MID Server to prepare it for use.

Install a MID Server on Windows

Install MID Servers with the MID Server guided Windows installation package. The package includes an installer that automatically configures OpenJDK to run in the environment. The MID Server can use an existing JRE rather than the provided OpenJDK. Uninstall the MID Server to redeploy it.

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

- Verify that the host computer satisfies the MID Server system requirements.
- The MID Server requires the minimum PowerShell version 3.0 and supports versions up to PowerShell 5.1.
- Ensure that the Microsoft Application Experience Lookup Service is enabled on the MID Server host. If this service is disabled, the MID Server auto-upgrade might fail, causing the MID Server to go down. For information on managing issues with the Application Experience service, see KB0597552.

Java 11 is bundled with the MID Server installer package and is installed on the host for all new MID Servers. The installer automatically configures Java 11 to run in your environment. No additional configuration is required. This version supports both 64-bit and 32-bit Windows MID Servers, and 64-bit Linux MID Servers. For the best performance, install the 64-bit MID Server for your operating system. The
MID Server requires a minimum JRE version 1.8.0_161, and recommended version 11.0.8. If you are using a lower version than 1.8.0_161, you may see encryption related issues.

抬注: ServiceNow no longer supports new installations of 32-bit MID Servers or upgrades to version Rome. New MID Server installation are blocked through RPM and MSI installer on the following operating systems:

- CentOS 6
- Windows server 2008
- Windows server 2008 R2
- Windows 8
- Windows 10

Unsupported MID Servers auto-upgrading to Rome create an issue record in MID Server Issues (ecc_agent_issue). For more information, see Supported platform changes for MID Server [KB0863694].

Testing showed that the MID Server works as expected with Oracle Java 11 version 11.0.5 and Oracle JRE 8 version 1.8.0_231. However, Oracle JRE 8 version 1.8.0_231 requires the workaround described in the HI Knowledge Base article MID Server running Oracle JRE version 8 [KB0784442]. If you need to upgrade the JRE to a different version, then coordinate with the appropriate account representative for support.

Upgraded MID Servers might use different Java versions depending on their operating system versions.

- MID Servers upgraded from earlier versions use the OpenJDK provided with the MID Server installer. This version of the OpenJDK was tested and certified for use with these MID Servers.
- The JRE version is not upgraded when upgrading 32-bit Linux MID Servers or Linux with glibc versions lower than 2.17. The MID Server will continue to use earlier the earlier version of JRE, such as 1.8.0_231.
- MID Servers upgraded on any other operating system versions also automatically upgrade the JRE to the version provided with the installation package.

Install a MID Server on Windows with guided installation

Install MID Servers with the MID Server guided Windows installation package. The package includes an installer that automatically configures OpenJDK to run in the environment.
Before you begin
Role required: admin or mid_server

About this task
The MID Server guided native Windows installer will configure the MID Server with provided settings. The installer creates the MID Server Service and assigns it to the provided user. The installer sets the file permissions on the MID Server Install folder. The installer allows for the configuration of proxy settings. Optionally, the installer can start the MID Server automatically.

Procedure
1. On the instance, download the MID Server installation .msi file from MID Server > Download.
2. Log in to the Windows host machine where you want to install the MID Server.
3. Place the installer .msi on the desired MID Server host.
4. Open the installer with Administrator level privileges.
5. Use the installer to enter the following information.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication Type</td>
<td><strong>Basic</strong> Username and password based authentication.</td>
</tr>
<tr>
<td></td>
<td><strong>Mutual</strong> Client certificate based authentication. See MID Server unified key store for more information on mutual authentication.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Selecting mutual authentication disables the MID Server username and password fields. The disabled fields are not written to config.xml.</td>
</tr>
<tr>
<td>ServiceNow instance URL</td>
<td>Enter the full URL of your instance, for example:</td>
</tr>
<tr>
<td></td>
<td><a href="https://mycompanyinstance.service-now.com">https://mycompanyinstance.service-now.com</a></td>
</tr>
<tr>
<td>ServiceNow MID Server username</td>
<td>Enter the name of the MID Server user that you already created. The MID Server user must have the mid_server role.</td>
</tr>
<tr>
<td>ServiceNow MID Server password</td>
<td>Enter the password for the user in the ServiceNow MID Server username.</td>
</tr>
<tr>
<td>Use proxy</td>
<td>Select this check box if your MID Server communicates through a proxy to connect to the instance.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Your proxy server must use Basic Authentication for the MID server to connect to the instance.</td>
</tr>
<tr>
<td>Proxy host</td>
<td>Enter the proxy server host name or IP address. Do not include the protocol in the host name. For example, enter</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Proxy port</td>
<td>Enter the port through which the proxy server communicates. If you leave this field blank, it should use the proxy server's default port number.</td>
</tr>
<tr>
<td>Proxy username</td>
<td>Enter the user name that has administrator rights to the proxy server.</td>
</tr>
<tr>
<td>Proxy password</td>
<td>Enter the password for the user name.</td>
</tr>
</tbody>
</table>

6. Click **Test your connection** to validate the credentials and instance information. If you encounter any errors, verify the information that you input.

7. Click **Next**.

8. Configure the MID Server name and Service Account parameters (see table).
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server name</td>
<td>Enter a MID Server name.</td>
</tr>
<tr>
<td></td>
<td><strong>CAUTION:</strong> MID Server names cannot begin with <code>mid.server</code>.</td>
</tr>
<tr>
<td>Service Account Name</td>
<td>Username of the service account that will be used to run the MID Server service. For information on creating service accounts, see Create a Windows service account with &quot;Log on as Service&quot; [KB0867669]. The name can follow 3 formats.</td>
</tr>
<tr>
<td></td>
<td><strong>a.</strong> If the service account is local to the computer, you can give just the name.</td>
</tr>
<tr>
<td></td>
<td>• Example: <code>My_Local_Service_Account</code></td>
</tr>
<tr>
<td></td>
<td><strong>b.</strong> If the service account is local to the computer, you can provide &quot;.&quot; as the domain name for the account.</td>
</tr>
<tr>
<td></td>
<td>• Example: <code>.\My_Local_Service_Account</code></td>
</tr>
<tr>
<td></td>
<td><strong>c.</strong> Any account can follow the format <code>{domain}\{username}</code>.</td>
</tr>
<tr>
<td></td>
<td>• Example: <code>MY-COMPUTER-DOMAIN\My_Domain_Service_Account</code></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Note:</td>
<td>The provided service account credentials must meet the following requirements in addition to being a valid account.</td>
</tr>
<tr>
<td></td>
<td>• The user cannot be a local system or an administrator level account (local admin, domain admin, etc.)</td>
</tr>
<tr>
<td></td>
<td>• The service account provided has the <code>log on as service</code> right, which is required for an account to be used as the <code>log on user</code> for a service.</td>
</tr>
<tr>
<td>Service Account Password</td>
<td>Password of the service account that will be used to run the MID Server service.</td>
</tr>
<tr>
<td>Set Service Name Manually</td>
<td>Select this check box if you want to manual set the service name and display name for your MID Server.</td>
</tr>
<tr>
<td></td>
<td>Note: Your proxy server must use Basic Authentication for the MID server to connect to the instance.</td>
</tr>
<tr>
<td>MID Service wrapper name</td>
<td>Modify this field if necessary. It is populated automatically by prefixing <code>snc_mid_</code> to the MID Server name. In most cases, you do not need to modify this.</td>
</tr>
<tr>
<td>MID Server wrapper display name</td>
<td>Modify this field if necessary. It is populated automatically by prefixing <code>ServiceNow MID Server_</code> to the MID Server name. In most cases, you do not need to modify this.</td>
</tr>
</tbody>
</table>

9. Click **Next** and select a destination folder for the installation.
Users can manually enter an existing, valid file path, or use the “Change” button to open up a browsing page where they can choose the install location.

10. Click **Next** to view the summary.

![Review MID Server Configuration](image)

Select **Start MID Server after installation** if you want to start the MID Server immediately after installation. If you wish to make additional configuration changes, before starting the MID server, leave this box unchecked. If mutual authentication was selected, the MID Server username and password fields are removed.

![Review MID Server Configuration](image)

**Note:** If the MID Server fails to start, the cause might be a duplicate name or multiple services that point to the same executable path. This can happen when you have MID servers previously not installed through the installer. See [MID Server fails to start](#) for details.

11. Click **Mid Servers List Page.**

The installer opens the MID Server list from your instance.

12. Select the MID Server name from the list.

**Note:** It may take a few seconds for the MID Server time to establish a connection with your instance.
The system displays the MID Server record.

13. From Related Links, click Validate. The MID Server Validated changes to Yes.

What to do next
To upgrade the MID Server, see MID Server upgrades for procedures and requirements.

Uninstall a Windows MID Server with the guided installer
The MID Server guided native Windows installer also supports guided uninstallation of the MID Server.

Before you begin
Role required: admin
There are three ways to uninstall a MID Server after installing it with the guided native Windows installer.

Procedure
1. On the MID Server host, navigate to the Control Panel > Programs > Programs and Features > Uninstall a program.
   a. Uninstall the program with the MID Server's name.

2. Optional: Alternatively, navigate to Settings > Apps
   a. Uninstall the program with the MID Server's name.

3. Optional: The MID Server can also be uninstalled with the silent uninstall script. This is useful for uninstalling multiple MID Servers. For more information, see Windows MID Server silent installation and uninstallation

Configure Windows MID Server service credentials
MID Server service credentials are required to manage the MID Server service on the host machine, including its ability to successfully auto-upgrade.

About this task
If you installed the MID Server using the native installer, you will not need to complete this procedure. However, to change the service user after the installation for any reason, use this procedure.

Windows service credentials control the level of privilege on the device. The user should not be a local system or an administrator level account (local admin, domain admin, etc.) The service account provided should have the log on as
service right, which is a requirement for an account to be used as the log on user for a service.

Note:
Windows service credentials are not the same as the MID Server user credentials, which allow communication between the MID Server and the instance. You must configure both of these credentials separately. See Create the MID Server user and grant the role for instructions on MID Server user credentials.

Procedure
1. Open the Windows Services console.
2. Double-click the ServiceNow <MID Server name> service for each MID Server.
3. Select the Log On tab.
4. Choose a non-admin user and provide the password for that user.
5. In the General tab, set the Startup type. The field is set to Automatic by default.
6. Click OK.
7. Restart the ServiceNow <MID Server name> service, and make sure that ServiceNow\<MID Server name>\agent\logs\agent0.log does not have error messages. If the MID Server does not start, see the ServiceNow knowledge article Review the agent log for MID Server errors (article KB0535148).
8. On the instance to which this MID Server is connected, navigate to MID Server > Servers. If Discovery is installed, alternately navigate to Discovery > MID Servers.

All MID Servers connected to this instance are listed.
9. Make sure that the Status of the MID Server you just installed is Up.

Windows MID Server silent installation and uninstallation
Silently installing the MID Server uses predefined parameters and requires no user input after it is initiated. You can use silent installation on several machines at once to quickly set up a network and to ensure all MID Servers have the same installation settings.

MID Server silent installation

Note: All silent install/uninstall commands must be run with administrator level privileges.
To silently install the MID Server on a Windows system, download the script attached to the Knowledge Base article Windows MID Server silent installation and uninstallation. Place the file on the target MID Server host machine and run the following command from the command prompt. You can also run the script directly from powershell.

```
powershell -command ".\SilentInstall.ps1 -<parameter_name1> '<value for parameter1>' -<parameter_name2> '<value for parameter2>' etc..."
```

The script checks the following mandatory parameters:

- **MSI_FILE_NAME**: the name of the MSI file used for the installation.
- **INSTALL_LOCATION**: the location to install the MID Server.
- **MID_INSTANCE_URL**: the target ServiceNow instance the MID Server will connect to.
- **MID_USERNAME**: the instance account name.
- **MID_PASSWORD**: the instance account password.
- **MID_NAME**: the name of the MID Server.
- **SERVICE_ACCOUNT_NAME**: the name of the service account.
- **SERVICE_ACCOUNT_PASSWORD**: the password of the service account.

The following parameters are optional:

- **LOG_NAME**: enables logging and puts logs into the file named by this parameter.
- **START_MID**: sets the MID Server to start automatically after the installation finishes.
- **USE_PROXY**: enables the use of a proxy. If you choose this command, the following parameters become mandatory:
  - **PROXY_HOST**: the name of the proxy host.
  - **PROXY_PORT**: the port number of the proxy.
  - **PROXY_USERNAME**: the proxy username. If there is no username, input "".
  - **PROXY_PASSWORD**: the proxy password. If there is no password, input "".
- **MANUAL_SERVICE_NAME**: the service name. If you choose this command, the following parameters become mandatory:
  - **SERVICE_NAME**: the service name.
  - **SERVICE_DISPLAY_NAME**: the service display name.
- **MUTUAL_AUTH**: enables mutual authentication. If this switch is enabled, **MID_USERNAME** and **MID_PASSWORD** are not required. See MID Server unified key store for more information.
Note: The parameters START_MID, USE_PROXY, MUTUAL_AUTH, and MANUAL_SERVICE_NAME are switches. They use the format -<switch_param_name> and are not followed by a value.

After the script runs, verify the MID Server files, service, and entry in Programs and Features are installed. If you enabled logging, verify the log info in the file specified by the LOG_NAME parameter.

An example MID Server silent installation command:
```powershell
powershell -command ".\SilentInstall.ps1 -MSI_FILE_NAME 'MID-Installer.msi' -INSTALL_LOCATION 'C:\Users\Administrator' -INSTANCE_URL 'https://my-instance-name.service-now.com' -MID_USERNAME 'mid_server' -MID_PASSWORD 'mid_password' -MID_NAME 'Silent_Install_MID' -SERVICE_ACCOUNT_NAME 'DOMAIN\My_Service_Account' -SERVICE_ACCOUNT_PASSWORD 'Service_Account_Password' -LOG_NAME 'Silent_Install_Log.txt'"
```

An example command using the START_MID switch:
```powershell
powershell -command ".\SilentInstall.ps1 -MSI_FILE_NAME 'MID-Installer-Wix.msi' -INSTALL_LOCATION 'C:\Users\Administrator' -INSTANCE_URL 'https://my-instance-name.service-now.com' -MID_USERNAME 'DOMAIN\My_Service_Account' -MID_PASSWORD 'mid_password' -MID_NAME 'Silent_Install_MID' -SERVICE_ACCOUNT_NAME 'DOMAIN\My_Service_Account' -SERVICE_ACCOUNT_PASSWORD 'Service_Account_Password' -LOG_NAME 'Silent_Install_Log.txt' -START_MID"
```

MID Server silent uninstallation
To silently uninstall the MID Server on a Windows system, download the script attached to the Knowledge Base article Windows MID Server silent installation and uninstallation. Then run the script using the command prompt. It can also be run directly from powershell.
```powershell
powershell -command " SilentUninstall.ps1 -MID_NAME '<value for MID_NAME>' -LOG_NAME '<value for LOG_NAME>'"
```

The script requires the mandatory parameter:

• **MID_NAME**: the name of the MID Server you want to uninstall.

The following parameter is optional:

• **LOG_NAME**: enables logging of the uninstallation and puts logs into the file named by this parameter.
After the script runs, verify the MID Server files, service, and entry in Programs and Features are uninstalled. If you enabled logging, verify the log info in the file specified by the **LOG_NAME** parameter.

An example MID Server silent uninstall command:

```
powershell -command ".\SilentUninstall.ps1 -MID_NAME 'silent_install_cmd' -LOG_NAME 'uninstall.txt'
```

**Manually install a MID Server on Windows**

Install MID Servers with the ZIP file installation package and verify it is active.

**Before you begin**

Role required: admin or mid_server

**About this task**

Click this link to view the installation video: Installing the MID Server on Linux

**Procedure**

1. Log in to the Windows host machine where you want to install the MID Server.
2. Create a folder for the MID Server on the top level of the drive such as `ServiceNow\MID Server1`.
3. Download the MID archive file into the new folder.
4. Right-click the archive and select **Extract All**.
5. Navigate to the `service-now\<mid server name>\agent` folder that was created when the file was extracted.
6. To configure the MID Server manually, edit the `config.xml` file with a text editor such as WordPad:

   a. Find the element `<parameter name="url" value="https://YOUR_INSTANCE.service-now.com" />` element and change the value to the URL of your instance.

   b. Enter the MID user credentials in the `mid.instance.username` and `mid.instance.password` parameters.

   By default, the MID Server, uses basic authentication for SOAP messages. The password value is also encrypted authentication.
c. Optional: Find the `<parameter name="name" value="YOUR_MIDSERVER_NAME_GOES_HERE" />` element and change the value for the MID Server name.

d. Optional: Enter connection information for the proxy server. Remove the appropriate comment tags from the proxy configuration information.

Example
For example, you can configure these parameters:

- `mid.proxy.use_proxy`
- `mid.proxy.host`
- `mid.proxy.port`
- `mid.proxy.username`
- `mid.proxy.password`

7. Run `start.bat` to start the MID Server.

8. On the instance, in the Related Links, select Validate. The MID Server Validated changes to Yes.

Run a Windows MID Server as a non-admin after manual installation

MID Servers can be configured to run using non-administrative accounts. Using non-admin accounts in conjunction with file permission enforcement can improve security by restricting access to MID Server files.

Before you begin
Role required: admin

Note: In a future release, non-admin accounts will be mandatory for the MID Server, and support for using an administrative account will be deprecated.

This procedure is only for users who install the MID Server using the ZIP file. The Windows MID Server installer already requires the MID Server run as a non-admin user. As part of the MID Server installer’s installation process, the access control lists for the MID Server folder are restricted to the following users and groups.

- System
- Administrator
- The configured service account
When installing using the ZIP file, install the MID Server on a Windows machine using an administrator account. Create a Windows user account without administrative privileges.

Running a MID Server with a non-admin account has limitations and changes the behavior of other applications. The following behavior changes can occur:

- The MID Server account needs appropriate credentials to run a Discovery schedule. If the credentials are insufficient, the MID Server falls back to the user account's privileges. A non-admin user account may not have the necessary privileges to access the Discovery target.
- Enhanced Application Dependency Mapping (ADME) and File Based Discovery (FBD) may not work by default. To correct this issue, non-admin users need to be given permission to read/write to the Admin Share folder.
- Non-admin accounts cannot initiate upgrade services in versions prior to the Orlando release.

**Procedure**

1. Run the MID Server service as LocalSystem or as a user with admin rights.
2. Add the non-admin account name to the MID Server parameter `mid.windows_host.file_permissions.allow_list` in the MID Server host's `config.xml` file.
   This step adds the non-admin account to the allow list.
   See [MID Server parameters](#) for more information about `mid.windows_host.file_permissions.allow_list` as well as instructions for adding a parameter to the `config.xml` file.
3. Restart the MID Server.
   The new file permission enforcement rules take effect when the MID Server starts.
4. Switch the MID Server to the non-admin service account.
5. Restart the MID Server.

**What to do next**
For more information about managing the allow list and file permission enforcement, see [File permission enforcement for Windows MID Servers](#).

**Uninstall a Windows MID Server after manual installation**
The MID Server runs as a stand-alone service. You can remove a stand-alone MID Server service to accommodate such tasks as redeploying the MID Server to another host machine or changing the unique name of a MID Server when deploying multiple MID Servers.
Before you begin
Role required: admin
This procedure is only for users who install the MID Server using the ZIP file.

Procedure
1. Stop the running MID Server service, using either of these procedures:
   - **Windows command line**: From the MID Server home (agent) directory, run `stop.bat`.
   - **Windows Services console**: From the Windows Services console, right-click the ServiceNow MID Server name and then select stop.
2. From a command prompt, go to the `\agent\bin` directory in the MID Server installation directory and double-click the `UninstallMID-NT.bat` file.

What to do next
Validate the MID Server to prepare it for use.

Configure a MID Server on Windows to use an existing JRE
You can choose to use an existing JRE for your MID Server rather than the OpenJDK provided with the MID Server installer.

Before you begin
Ensure that your JRE version is supported. See MID Server system requirements for details.

Role required: admin

About this task
By electing to use your own JRE, you are responsible for upgrading it as necessary. For a detailed procedure and cautions regarding changing the JRE, see KB0778272.

Procedure
1. Navigate to this file in the MID Server installation directory:
   `agent/conf/wrapper-override.conf`
2. To specify the existing Java executable that you want to use, add this line to the file:
   `wrapper.java.command={your_java_executable}`
   For more information, see the Java service wrapper property documentation.
3. Save the file.
Validate the MID Server

You must manually validate the MID Server after it is installed to enable it to execute automation tasks. You can invalidate a MID Server you suspect has been compromised to prevent it from accessing automation credentials in the instance or executing outbound ECC probes.

Before you begin
Role required: agent_admin, admin

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

Make sure that the MID Server version is compatible with the instance.

About this task
Validation restricts access to automation credentials to trusted MID servers only. When you validate a MID Server, you specify the capabilities it can use, the applications that use it, and the IP ranges it is allowed to explore. You will be prompted to set the initial selection criteria when you validate MID Servers that do not already have capabilities, applications, or IP ranges already configured. You do not have to set the initial selection criteria to actually validate the MID Server. See MID Server selection for more information on capabilities, applications, and IP ranges.
Note: When you upgrade, MID Servers that are already configured in your instance are automatically validated. This prevents the interruption of automation tasks that MID Servers might be performing. See MID Server upgrades for more information.

Procedure

1. Navigate to MID Server > Servers.
2. Open the new MID Server you created from the list of MID Servers.
3. Under Related Links click Validate.
   The Set Initial Selection Criteria window appears if there are no records in the Supported Applications, IP Ranges, or Capabilities related lists.
4. On the Set Initial Selection Criteria window, use the switches to enable or disable selection criteria for this MID Server:
   • Allow ALL capabilities: Allow all capabilities for Orchestration and Event Management to use this MID Server.
     Note: Service Mapping and Event Management alert aggregation and RCA, which used capabilities in previous releases, rely on the application for MID Server selection.
   • Allow ALL applications: Allow all applications that use MID Servers to use this MID Server.
   • Allow ALL IP ranges: Make all IP ranges valid for this MID Server, meaning that it can target any IP address.

Setting initial selection criteria

Selected MID Server(s) are now being validated.
Approve setting the initial selection criteria for each MID Server.

Allow ALL applications
Allow ALL capabilities
Allow ALL IP ranges

Note that any previous criteria will be overwritten.

Cancel OK
If you click **Cancel**, the validation continues but none of the capabilities, applications, or IP ranges are added.

5. Click **OK**.
   
The **Validated** field on the dashboard is set to **Validating**, and then set to **Yes** after the validation completes.

6. To invalidate a MID Server, open the record for the MID Server you suspect has a security issue.

7. Under **Related Links**, click **Invalidate**.
   
   Invalidating a MID Server forces it to clear its memory and restart. The MID Server generates a new keypair on restart.

**What to do next**

Test network connectivity to ensure that the MID Server can upgrade automatically.

**Related information**

Rekey a MID Server

**Test MID Server connectivity**

Confirm that the MID Server host is able to communicate with the instance. Resolve any issues with the network connectivity such as conflicts with firewalls, access control lists, and routing errors. Successful communication is necessary for automatic upgrades.

**Before you begin**

Role required: admin
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

About this task
The computer that hosts the MID Server must be able to access one of these URLs to upgrade automatically:

- HTTPS: https://install.service-now.com on the default HTTPS port (443)
- HTTP: http://install.service-now.com on the default HTTPS port (80)

Procedure
1. Use PING to test connectivity with the host on the network (ping<host IP>).
2. If no ping response is returned, use TRACEROUTE to see where traffic might be stopped (traceroute<host>).
3. Use TELNET to connect to any of the TCP ports (telnet<host> <port>).
4. Use an SNMP scanning tool to determine if a potential network device is responsive.
5. Resolve the most likely issues around network connectivity:
   - Routing: Confirm that the MID Server host has network access to the IP ranges you are attempting to discover.
   - Firewalls: Confirm access to the physical firewalls that protect a large environment such as the Data Center. Confirm access to any logical firewalls that protect an individual computer. MID Server communications
are initiated inside the firewall and therefore do not require any special firewall rules or VPNs.

- **Access Control Lists (ACL):** Confirm that ACLs contain the IP addresses based list on SNMP network devices that allows communication to a particular target.

- **Resolve all issues with your network teams to better understand your topology.** Deploy additional MID Servers if necessary to help keep your network secure. Configure access from your existing MID Server host to networking components.

6. Verify that the MID Server service is running on the host:
   - **Windows:** In the Windows Services console, locate the **ServiceNow [MID Server name]** and confirm that each MID Server has the **Started Status** value.
   - **Linux:** Ensure that the **agent0.log.0.lck** appears in the **/servicenow/ MID Server name]/agent** folder.

7. After each MID Server restart, open the **agent0.log.0** and address all error messages.

8. From the ServiceNow instance, navigate to **MID Server > Servers**.

9. Review and verify that all MID Servers that are connected to the instance are listed.

10. Verify that the **Status** is **Up** for the MID Servers.

**What to do next**

This concludes the installation of a single MID Server. If necessary, continue to deploy multiple MID Servers from a single host in your network. Otherwise, begin configuring your MID Server.

**Install multiple MID Servers on a single system**

Install multiple MID Servers on the same host computer. Multiple MID Servers can support each other with load balancing, as well as use domain separation. The number of MID Servers required is determined by factors like network policies, security restraints, and the reliability of the host computer.

**Before you begin**

Role required: admin, mid_server
1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
You can install multiple MID Servers on a Linux or Windows host or on a virtual machine. Installing multiple MID Servers may involve other setup steps depending on your network configuration.

Important: Only one MID Server service can be a daemon on a Linux host. This is a limitation of the Tanuki wrapper service.

Procedure
1. Log in to the host system or virtual machine where you want to install multiple MID Servers.

2. Create a directory for each MID Server on the top level of the drive.
   Make sure you create a unique and descriptive name for each MID Server, such as MIDServer_SMS_Int or MIDServer_Disc1.

3. Extract the downloaded MID Server archive file into each MID Server directory. When the extract completes, there should be a directory path similar to the following for each MID Server: ServiceNow\<MID Server name>\agent.

4. For each MID Server, run the installer appropriate to the host's operating system.
### MID Server installers

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Installer path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>/agent/start.bat</td>
</tr>
<tr>
<td>Linux</td>
<td>/agent/installer.sh</td>
</tr>
</tbody>
</table>

5. Use the installer to enter the following information.

- URL to your instance
- User credentials to run the MID Server
- Proxy server connection details
- MID server name
- MID server service wrapper name and display name (Windows systems only)

**Note:** The MID Server user must have the `mid_server` role.

6. From the installer, click **Start MID Server**.
The local host starts the MID Server.

7. Click **Mid Servers List Page**.
   The installer opens the MID Server list from your instance.

8. Select the MID Server name from the list.

   **Note:** It may take a few seconds for the MID Server time to establish a connection with your instance.

   The system displays the MID Server record.

9. From **Related Links**, click **Validate**.
   The MID Server **Validated** changes to **Yes**.

**What to do next**
All MID Server installation procedures are complete. Proceed to **configure your MID Server**.

**Multiple MID Server deployments**
Depending upon how you use the MID Server (for an external integration, Discovery, Service Mapping, or Orchestration) and the load placed on it, you might find it necessary to deploy multiple MID Servers in your network.

Factors determining the number of MID Servers your network will require to support external applications that integrate with ServiceNow include the following:
- The security constraints in your network.
- Your network policies.
- The amount of traffic between ServiceNow and the integrations.
- The reliability of the MID Server machines.

**Network policies and security**
Security policies in your network (firewalls between network segments, for example) might make direct communication impossible between your instance and an integration's data source (JDBC, LDAP, etc.). To retrieve data for the instance, you can install a MID Server that has access to both the data source and the instance.

These network policies can determine if you need to install multiple MID Servers in your environment:
• **Access control lists (ACL):** If your security policy controls access to network devices (e.g. switches and routers) with an ACL, it might be necessary to install one or more MID Servers on a machine in the network that is already on the ACL.

• **DMZ:** Your network policy might require you to install one or more MID Servers in your DMZ to probe the devices there. This is common in networks that tightly regulate the ports that are opened on the inside firewall.

• **Probe types:** If you are conducting probes of different operating systems, your network policy might require a separate MID Server for each type of probe (e.g., one MID server for Windows WMI probes and another for SSH probes on UNIX).

**Load balancing**
Deploy multiple MID Servers where capacity is an issue, as when Discovery has to gather information about thousands of configuration items quickly. In a high volume environment, it might be necessary to deploy multiple MID Servers as load balancers for certain transactions. For example, JDBC data transfers can tie up the resources of a MID Server, making it unable to respond to other requests. The following operations between an integration might require separate MID Servers in a busy network:

- File exports
- Running scripts
- JDBC data sources
- Reading files

**High availability model**
Avoid installing MID Servers for critical integrations on a machine that might experience any type of planned outage or an outage caused by overloaded processes. If necessary for reliability, consider deploying these types of MID Servers to dedicated machines for high reliability.

⚠️ **Note:** Do not integrate with an external application on a MID Server provisioned for ServiceNow Discovery or Orchestration.

**Wide area network (WAN)**
When determining where to deploy MID Servers in a WAN, consider the bandwidth available between your local area networks. In most cases, install a MID Server on each LAN to probe devices locally, rather than deploying MID Servers that must probe devices across slow WAN connections. An alternative to this type of deployment is to install MID Servers that probe other LANs via VPN connections that take advantage of fast Internet connections. If the bandwidth
of your WAN connections is comparable to that of your Internet connection, then there is no performance impact in running MID Server probes across WAN connections.

**Domain separation**

In deployments where domain separation is enabled and domains are configured to form a hierarchy, place the MID Servers at the lowest domain level.

**Deploying MID Servers with domain separation**

Use **MID Server guided setup**

MID Server guided setup provides a sequence of tasks that help you install a MID Server with the proper user account and validate the MID Server. If you are setting up a MID Server for the first time, this is a good way to get one up and running in your environment quickly.

**Before you begin**

Role required: admin
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

About this task
You are guided through a series of configuration activities that create a fully qualified MID Server. A progress indicator on each screen allows you to monitor your progress on each task. Each configuration activity provides the following resources to help you:

- Contextual embedded help.
- Links to comprehensive documentation on the ServiceNow product documentation site.

Important: You must complete MID Server configuration before you can launch any other IT Operations Management guided setup.

Procedure
2. Take one of the following actions:
   - If none of the MID Server installation and configuration tasks are complete, click Get Started.
   - If you have completed any of the MID Server installation and configuration tasks, click Continue to return to the task list.
Select the MID Server icon in the progress bar on the left side of the category screen to display the MID Server category pane at any time.

3. Click **Continue**.
The IT Operations Management Guided Setup category screen appears. The controls for starting the MID Server tasks are at the top of the list. These task must be completed before you can set up the other applications that rely on the MID Server.

4. In the MID Server pane, click **Get Started**.
The MID Server task list appears with a description of each task.
5. Click **Configure** to create the MID Server user and follow the instructions in the help pane that appears on the right side of the screen.

**Attention:** If you configured MID Servers manually prior to starting Guided Setup, select from that information to complete each specific task.

6. When you have provided the requested information for the MID Server user, click **Submit**, and then click **Mark as Complete** at the bottom of the help pane.

The view returns to the task list. Notice that the circular progress indicator for the category shows 33% of the MID Server configuration complete.

The progress indicator on the left side of the screen shows the completion percentage for all the IT Operations Management tasks.
7. Click **Configure** for the next task, **Download & Install MID**.

Java 11 is bundled with the MID Server installer package and is installed on the host for all new MID Servers. The installer automatically configures Java 11 to run in your environment. No additional configuration is required. This version supports both 64-bit and 32-bit Windows MID Servers, and 64-bit Linux MID Servers. For the best performance, install the 64-bit MID Server for your operating system. The MID Server requires a minimum JRE version 1.8.0_161, and recommended version 11.0.8. If you are using a lower version than 1.8.0_161, you may see encryption related issues.

8. Validate your new MID Server.

**What to do next**
If necessary, **deploy multiple MID Servers from a single host** in your network. Otherwise, proceed to **configure your MID Server**.

**Configuring MID Servers**
After installing and validating your MID Servers, ensure that they have access to sufficient system resources, probe the proper targets, and communicate with the instance as expected. Configure MID Server selection criteria, create clusters for failover protection, and set up MID Servers in different domains to protect data.
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

Some of these configuration procedures rely on data found in the MID Server references home page. See that page for links to the parameters, properties, and privileged commands you need to fine tune the behavior of your MID Servers. You can apply controls to individual MID Servers or to all the MID Servers in your environment. Remember to restart the MID Server after any configuration change for those changes to take effect.

**MID Server selection**

MID Servers are selected for use based on three criteria: applications, IP address or range, and capabilities. You can designate specific applications for a given MID Server, such as Discovery or Orchestration. You can specify an IP address or a range that a MID Server is allowed to work within. Some applications require specific capabilities, and so are restricted to MID Servers with those capabilities.

**MID Server selection**
Configure the way your instance selects a MID Server, either by application, IP address ranges, network capability, or behavior.

**MID Server capabilities**
Create capabilities that define the specific functions of a MID Server within an IP address range.

**MID Server IP range auto-assignment**
Configure the system to automatically assign a qualified MID Server to a subnet by that subnet's IP address range.

**Map an IP address to a DNS name**

Map host server DNS names to IP addresses if your MID Server manages resources within defined IP ranges.

**Configure MID Server as WinRM trusted host**

Add servers, which are part of WinRM, as trusted hosts on all MID Servers that Discovery or Service Mapping use for discovery.

**File permission enforcement for Windows MID Servers**

To improve security, Windows MID Servers will enforce Windows file permission restrictions. This will prevent compromised accounts from accessing unauthorized files by restricting their permissions to the minimum necessary for their role.

**MID Server clusters**

MID Server clusters are groups of MID Servers which provide support to each other in the forms of load balancing and fail-over protection. Work sent to a MID Server that is part of a cluster is automatically balanced between all the MID Servers in that cluster. MID Servers in a fail-over cluster each have a configured order that the platform uses to determine which MID Server to use next in case of failure.

**Create a MID Server cluster**

Create a MID Server cluster for load balancing and fail-over protection.

**Set thread use**

Set the number of threads your MID Server uses for the desired MID Server speed, based on hardware capabilities and competing applications running on the host.

**Domain separation**

Domain separation segregates MID Servers based on the records they can access. The credentials configured in a MID Server's config.xml file determine which records that MID Server can read, update, or create. You can specify MID Server policy records that only MID Servers from the same domain can use.

**MID Server domain separation**

Set up your MID Servers in different domains to restrict the records and credentials that a MID Server can access.

**Synchronize a JAR file to MID Servers**
Upload a JAR file to an instance and synchronize it to all MID Servers connected to that instance. Use JAR file synchronization to create policies that only a MID Server from the same domain can use.

**MID Servers used for credential-less Discovery**
MID Servers that are used for credential-less Discovery require special configuration to run Network Mapper (Nmap) commands on target computers.

**Install and uninstall Nmap on a MID Server**
You must install Nmap on each MID Server running on a Windows host. When given the proper capability, those MID Servers can discover some basic information about CIs in your network if normal authentication fails.

**MID Server extensions**

- **vCenter event collector**
  The vCenter event collector listens for vCenter-related events and updates the CMDB accordingly. The event collector allows the CMDB to be updated with changes to virtual machines (VMs), in addition to the updates detected by Discovery. A change to a VM is sent as an event from the vCenter server to the vCenter event collector. When an event is received, the CMDB is updated accordingly. Full vCenter Discovery does not need to rerun. For some events, such as powered on and powered off events, Discovery does not need to run again at all. For most events, Discovery runs only on the necessary vCenter resource.

- **SNMP trap collector extension**
  The SNMP trap collector is a MID Server extension that listens for SNMP traps from the devices on your network. Upon receiving a trap, the MID Server sends the trap to the instance for further processing by Event Management. If Event Management is not active, traps are not processed and are discarded by the instance.

**MID Server selection**
You can configure MID Server selection by application, IP address ranges, network capability, or behavior. Specific MID Servers can be assigned to particular tasks, or the MID Server can be selected automatically. MID Servers can use domain separation to limit the scope of discoveries and event management.
1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

**MID Server criteria**

MID Servers offer these types of criteria that help an application determine which MID Server to use:

- **Application**: The application that you specify on the MID Server. You can designate these applications for a specific MID Server:
  - Discovery
  - Orchestration
  - Service Mapping
  - Event Management
  - Operational Intelligence
  - Cloud Management
  An **ALL** application option is also available. By default, this option includes all applications. You can **configure which applications** are included in the **ALL** designation.

- **IP address or range**: The IP address or the IP ranges that the MID Server is allowed to work within. You can specify an IP address or IP range in the application, such as on a Discovery schedule or an Orchestration activity, and for the MID Server. If the IP configured in the application matches the IP address or falls within the allowable IP range configured on the MID Server, a match is possible, and that MID Server passes this criteria. To have the instance
automatically assign IP ranges (subnets) to available MID Servers, see Using MID Server IP range auto-assignment.

- **Capabilities**: The network capability an application needs to use, such as the PowerShell Orchestration activity or the Flow Designer PowerShell step. Some applications, like Cloud Management, require a specific capability.

  Note: Discovery and Service Mapping can also use behaviors, which determine the type of port probes used during the port scan phase of Discovery. Both Discovery and Service Mapping use a behavior to discover load balancers running on Linux. Other applications do not use behaviors. Behaviors are not used for auto-selection, default MID Servers, or specific MID Servers as described below. See Discovery behaviors for more information.

### How an application selects a MID Server

If you do not specify a specific MID Server for an application to use, the application tries to select one. Each application relies on different criteria to select an appropriate MID Server.

<table>
<thead>
<tr>
<th>Application</th>
<th>Supported Application on the MID Server</th>
<th>IP address range</th>
<th>Capability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovery</td>
<td>The Discovery or ALL application must be specified on the MID Server.</td>
<td>Discovery uses IP ranges that you configure on the Discovery Schedule form to see if they fall within the IP ranges that you configure on the MID Server, or the ALL IP ranges option must be selected on the MID Server.</td>
<td>N/A</td>
</tr>
<tr>
<td>Orchestration</td>
<td>The Orchestration or ALL application must be specified on the MID Server.</td>
<td>The target IP address that you configure in an Orchestration activity must fall within the IP ranges that you configure on the MID Server.</td>
<td>The capability that is required for an Orchestration activity must match the capabilities you configure on the</td>
</tr>
<tr>
<td>Application</td>
<td>Supported Application on the MID Server</td>
<td>IP address range</td>
<td>Capability</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------</td>
<td>------------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>MID Server, or the MID Server capability must be set to <strong>ALL</strong>.</td>
</tr>
<tr>
<td>Service Mapping</td>
<td>The <strong>Service Mapping</strong> or <strong>ALL</strong> application must be specified on the MID Server.</td>
<td>The endpoint IP address must fall within the IP range that you configure on the MID Server, or the <strong>ALL</strong> option must be selected on the MID Server.</td>
<td>One of the supported Service Mapping capabilities (for new installs) must be configured on the MID Server, or the MID Server capability must be set to <strong>ALL</strong>.</td>
</tr>
<tr>
<td>Event Management</td>
<td>The <strong>Event Management</strong> or <strong>ALL</strong> application must be specified on the MID Server.</td>
<td>The IP configured in the event connector instances, such as HPOM, must fall within the IP range configured on the MID Server.</td>
<td></td>
</tr>
<tr>
<td>Cloud Management</td>
<td>N/A</td>
<td>N/A</td>
<td>The <strong>Cloud Management</strong> or <strong>ALL</strong> capability must be added.</td>
</tr>
</tbody>
</table>

**Using a specific MID Server**

Discovery and Event Management can use a MID Server that you specifically call out.

⚠️ **Note:** Selecting a specific MID Server is not the same as specifying the default MID Server for an application. A specific MID Server is always used. If it is **Down** or not validated, the application does not execute commands against the MID Server. A default MID Server is fallback that is used when the auto-selection of MID Servers does not find any eligible MID Server.
### Application

<table>
<thead>
<tr>
<th>Application</th>
<th>How you specify a specific MID Server</th>
<th>Criteria that the default MID Server must meet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovery</td>
<td>Choose the MID Server on the Discovery schedule.</td>
<td>If you select a MID Server without the <strong>Discovery</strong> or <strong>ALL</strong> application, it automatically adds the <strong>Discovery</strong> application.</td>
</tr>
<tr>
<td>Orchestration</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Service Mapping</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Event Management</td>
<td>Choose one or more MID Servers on the connector instance event collection, such as HPOM.</td>
<td>N/A</td>
</tr>
<tr>
<td>Cloud Management</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Note:** If a MID Server manages resources within defined IP ranges for Orchestration, you must map the fully-qualified domain name (FQDN) of a server with its IP address to run certain activities, such as Exchange activities.

### Domain separation

If you are using domain separation, you can configure MID Servers to be in separate domains. The domain that the MID Server is in affects how the application selects the domain:

- **Discovery and Service Mapping:** On the Discovery schedule, the MID Servers and clusters that available for selection are limited to the same domain of the user who is configuring the schedule. This also applies to the auto-selection option: only MID Servers in the same domain as the user can be automatically selected.

### MID Server selection test

If Service Mapping is active, you can preview which MID Server that Service Mapping uses for a specific target device or computer. To do this, navigate to **Service Mapping > MID Servers** and click **MID Selection Test**. Enter the IP address and an optional application and capability, and then click **OK**. The name of the MID Server that Service Mapping will use appears in the window.
Configure a default MID Server for each application

You can configure a default MID Server that an application can use if all other possible MID Servers are unavailable. You can narrow down the list of applications that are included in the definition of ALL.

Before you begin
Role required: agent_admin or admin

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

About this task
Applications are only available when their respective plugins are activated. The default MID Server is used when applications fail to find a suitable MID Server that matches configured criteria during auto-select. The default MID Server for the ALL application is used if the default MID Server for the specific application is not available. Some applications also offer a property to set the default MID Server.

Important: If you configure a MID Server for ALL IP ranges (type Include) and also create an IP range of type: Exclude for the same MID Server, the system ignores the excluded IP range for that MID Server.

The default MID Server does not need to meet any criteria (application, IP range, behavior, or capability) to be used. Specifying a default MID Server
is optional, and you can use a MID Server as the default for more than one application.

<table>
<thead>
<tr>
<th>Application</th>
<th>Additional notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovery</td>
<td>Discovery attempts to use the default MID Server when the Discovery schedule specifies <strong>Auto-Select MID Server</strong> and Discovery cannot find any MID Servers with the correct application and IP range.</td>
</tr>
<tr>
<td>Orchestration</td>
<td>Orchestration attempts to use the default MID Server when it cannot find any MID Servers with the capabilities that you define in the Orchestration activity. You can also specify a default MID Server. The value in that property automatically synchronizes with the default MID Server you select in the Orchestration application.</td>
</tr>
<tr>
<td>Alert aggregation and RCA</td>
<td>Not applicable. The MID Server is selected if it has the RCA capability. Route to right MID by domain.</td>
</tr>
<tr>
<td>Service Mapping</td>
<td>If there are no MID Servers with matching application, capability, or IP range, Service Mapping uses the default MID Server.</td>
</tr>
<tr>
<td>Event Management</td>
<td>You can specify a default MID Server for Event Management using the mid.server.connector_default system property. Event Management does not use the default MID Server in the application record.</td>
</tr>
<tr>
<td>Cloud Management</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to **MID Server > Applications**. The list of installed applications that can use MID Servers appears.
2. Click the name of an installed application.
3. Select a MID Server from the list in the **Default MID Server** field.
4. To select additional MID Servers for this application, click **Edit** in the **MID Servers** related list and select alternate MID Servers that this application is allowed to use.
5. Click **Update**.
**Select applications to include in the definition of ALL for a MID Server**

You can narrow down the list of applications that are included in the definition of ALL.

**Before you begin**
Role required: agent_admin or admin

**About this task**
You can specify the ALL application for a MID Server, which means that the MID Server is allowed to work with any of the applications that require MID Servers, such as Discovery, Event Management, Service Mapping, and so on. But you might not want all applications to be included in the definition of ALL. For example, you might want to exclude Service Mapping from the ALL definition if you already have a dedicated MID Server to work with Service Mapping.

**Procedure**

1. Navigate to **MID Server > Applications**.
   The list of installed applications that can use MID Servers appear.

2. If you do not see the **Included in application ALL** column, you can personalize the list and add it.

3. For each application, double-click the value in the **Included in application ALL** column.

4. Change the value to **true** (to include) or **false** (to exclude).

**Configure an IP address range for the MID Server**

You can manually configure an IP address range for the MID Server to explore.

**Before you begin**
Role required: agent_admin or admin
About this task
Applications, such as Discovery and Orchestration, can specify an IP range or the specific IP address of a target. When the application looks for a MID Server to use during auto-selection, it chooses a MID Server whose IP range includes the application’s range or specific IP address. Applications also use other criteria, such as the MID Server’s supported application or capability. See MID Server selection for more information.

Note: This is a manual configuration procedure. To learn how the system can assign IP address ranges to selected MID Servers automatically, see Using MID Server IP range auto-assignment.

These applications use IP ranges as follows:

• **Orchestration**: Use the IP address of the target machine (together with the capability) to select the correct MID Server for Orchestration activities. See the procedure in this topic to configure the IP address.

• **Service Mapping**: Select the MID Server whose IP address range matches the IP in the discovery request. See MID Server configuration for Service Mapping for more information.

• **Discovery**: Can select an IP address range using the same criteria as Service Mapping. Discovery can also use a quick IP range that you specify in the Discovery schedule.
Tip: You can also use the ALL IP range, which allows the MID Server to be used with any range of IP addresses that an application specifies. This only allows the MID Server to access IP ranges, it does not mean that the MID Server can actually reach all of the IP ranges. To function with an application, the MID server must have access to the IP ranges that the application needs.

Valid IP address ranges can be as follows:

- An IP address in dotted decimal or hexadecimal format. The hexadecimal format can be explicitly prefixed with 0x, this is not mandatory. Here are examples:
  - 10.11.144.155
  - 0x0A0B909B
  - 0A0B909B

- An IP address range in dotted decimal or hexadecimal format. Here are examples:
  - 10.11.144.150-10.11.144.160
  - 0x0A0B9096-0x0A0B90A0
  - 10.11.144.150-0x0A0B90A0

- An IP network address with the net mask specified after a slash (/) in regular notation (0-32 inclusive) or in IP address notation. Here are examples:
  - 10.11.144.0/24 10.11.144.0/255.255.255.0
  - 10.11.144.0/0xFFFFFFFF
  - 0x0A0B9000/24
  - 0x0A0B9000/0xFFFFFFFF

Procedure
1. Navigate to MID Server > IP Ranges.
2. Click New.
3. Complete the form, using the fields in the table.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for this IP range. The default is <strong>Global</strong>.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of range:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Include</strong>: Include the specified IP range.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Exclude</strong>: Exclude the IP address range.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: If a MID Server is configured for <strong>ALL</strong> applications, any IP</td>
</tr>
<tr>
<td></td>
<td>addresses configured for exclusion are ignored by the system. If your goal</td>
</tr>
<tr>
<td></td>
<td>is to configure default MID Servers for separate applications in your</td>
</tr>
<tr>
<td></td>
<td>system, see <strong>Configure a default MID Server for each application</strong>.</td>
</tr>
<tr>
<td>Range</td>
<td>Enter the range in a valid format.</td>
</tr>
</tbody>
</table>

**Related list**

| MID Servers | The MID Servers that can use this IP address range. |
4. Click **Save**.

**Important:** IP ranges assigned manually prior to using auto-assignment in the Discovery Quick Start are affected as follows:

- Individual IP ranges are retained and appended to the ranges assigned automatically by the system for the designated MID Server.
- If the MID Server was configured with the **ALL** ranges selection, the auto-assignment feature overwrites that designation with the ranges it finds.

**What to do next**

Open the **ALL** IP range record and configure the MID Servers that you want to use with any set of IP addresses.

**Override the MID Server selection filter**

You can use the override feature to write your own filter condition that overrides the normal MID Server selection criteria for an application. An override has precedent over the default filter and can be defined for a specific selection condition.

**Before you begin**

Before attempting to create an override filter, be sure you understand the criteria the platform uses to select MID Servers. See **MID Server selection** for details.

Role required: admin
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

About this task

Note: The override feature is intended for Cloud Management and Cloud Discovery only. The Override by capability filter is provided by default.

There are four MID Server selection filters included in the base ServiceNow system. These filters are applied to all MID Servers in order until the system finds a matching condition:

- Status Filter
- App Filter
- Capability Filter
- IP Filter

Important: The override feature allows multiple filter types but only one override filter for each filter type. The Override selector filter type overrides all other filters and takes complete control of the MID Server selection. If this type is active, it is the only filter applied.

Procedure

1. Navigate to **MID Server > Mid Selector Override**.
   The list of MID Server overrides appears.
2. Click **New** to create a new filter.
3. Complete these fields:
   - **Name**: Unique name for this override. Ensure that you can identify the override type by the name.
   - **Script**: Condition for this filter. Create the MID Server selection logic for your override in this field, using the directions provided in the function template. Look at the **Override by capability** filter as an example before starting to create your filter.
   - **Type**: Type of override being configured. Select one of the four default filters to override with your condition, or select **Override selector** to create a filter that overrides all the others.

4. Click **Submit**.

### Using MID Server IP range auto-assignment

Discovery Quick Start can automatically assign ranges of IP addresses, called subnets, to qualified MID Servers. This subnet auto-assignment requires SNMP credentials for read-only access to routers Discovery uses. The Automation Status Set form shows summary details of subnet Discoveries and the IP range assignments for associated MID Servers.
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

To be automatically assigned to a subnet, a MID Server must be:

• In a running (Up) state.
• Successfully validated.
• Able to access one or more subnets in your network.

The subnet assignments that the instance makes for your MID Servers are stored in the Automation Status Set [automation_status_set] table. For details about MID Server auto-assignment, see Discovery Quick Start.

**Important:** You must auto-assign at least one MID Server to create a schedule automatically.

**Required SNMP OIDs for MID Server IP range auto-assignment**

Customers who use network service providers must request specific SNMP access to use MID Server IP range auto-assignment.

IP range auto-assignment requires SNMP credentials for read-only access to all routers that Discovery uses to identify subnets. In addition, your service provider must grant the following SNMPWALK access:
View automation status sets and IP range assignments

The Automation Status Set form shows summary details of a subnet Discovery and the subsequent IP range assignments for MID Servers selected for automatic subnet assignment.

Before you begin
Role required: admin

Procedure
1. Navigate to MID Server > Automation Status Sets.
2. Select a status record for a subnet Discovery you want to view.
   The form contains read-only status information about the selected Discovery, the subnets found, and the range assignment process for the MID Servers you selected for auto assignment.

Important: IP ranges assigned manually prior to using auto-assignment in the Discovery Quick Start are affected as follows:
- Individual IP ranges are retained and appended to the ranges assigned automatically by the system for the designated MID Server.
- If the MID Server was configured with the ALL ranges selection, the auto-assignment feature overwrites that designation with the ranges it finds.
3. Select the **Subnets Discovered** related list to view the list of subnets available for assignment.

4. Select the **IP Range Assignments** related list to view the IP ranges that were assigned to a MID Server.
CAUTION: IP ranges identified by Discovery are stored in the IP collection [ip_address_collection] table, which is only used for MID Server IP range auto-assignment in the Jakarta release. This table is intended for future development and should not be used in any customizations, including column additions, business rules, or scripting actions.

File permission enforcement for Windows MID Servers

To improve security, Windows MID Servers enforce Windows file permission restrictions. The enforcement limits access to the MID Server files to a restricted allow list of users and groups.

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

File permission enforcement for Windows MID Servers goes into effect on the MID Server on start up in Orlando. By default the agent folder is locked to four user accounts and groups: the local admin group, the system account,
creator owner, and the user account the Windows MID Server is using. The list of permitted user accounts is managed by an allow list, which is controlled by the MID Server parameter `mid.windows_host.file_permissions.allow_list`. This parameter takes a string of comma separated group names, user names, and security identifiers (SID). Group and user names must follow SAM account naming requirements. Domain accounts must be specified by using the SID.

**Roll back file permission changes**

Changes to the file permissions are recorded, and the last used settings are saved in the `/etc` folder as a backup. The file is `fileperm.aclsave`. Open a command prompt and run the command `icacls <agent_folder> /restore <agent_folder>/etc/fileperm.aclsave` where `<agent_folder>` is name of your agent folder.

**Run a MID Server as a non-admin**

To run a MID Server as a non-admin user, it must first be installed using an admin account. Then add the non-admin user to allow list and restart the MID Server. Once the new enforcement rules run, the MID Server can be switched to the non-admin service account. See [Run a Windows MID Server as a non-admin after manual installation](#) for more information on setting up non-admin Windows MID Servers, or [Run Linux MID Servers as non-root users](#) for Linux MID Servers.

**Map an IP address to a DNS name**

Associate the IP address to a DNS name to ensure the appropriate MID Server is selected. The IP Address range configuration determines which MID Server is selected. If the MID Server manages resources within defined IP ranges, all host servers must have their DNS names mapped to an IP address.

**Before you begin**

Role required: admin
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

The association of an IP address to a DNS name ensures that the appropriate MID Server is selected based on the IP Address range configuration. If this is not done, Orchestration reverts to the default MID Server.

If Discovery cannot discover the server and resolve the DNS name to an IP address, you must create the mapping manually.

**Important:** The platform does not map localhost to 127.0.0.1 automatically. You must create that mapping using this procedure.

**Procedure**

1. Enter `cmdb_ci_dns_name.list` in the navigation filter.
   A list of DNS names appears.
2. Check the list for your host server.
   If the server does not appear in the list, continue with this procedure.
3. Click **New**.
4. Enter the fully-qualified domain name (FQDN) of the host server in the **Name** field.
5. Right-click in the form header and select **Save** from the context menu.
6. In the **IP Address** related list, click **New**.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
7. In the IP Address field, enter the IP address of your host server.
8. In the Nic field, select eth0 or your preferred network interface controller.
9. Leave the Netmask field blank.
10. Click Submit.

Configure MID Server capabilities

MID Server capabilities define the specific functions of a MID Server within an IP address range, allowing an application to select the most appropriate MID Server. Configure capabilities on MID Servers for applications like Orchestration, Cloud Management, and Service Mapping.

Before you begin
Role required: admin or sm_admin

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

About this task
Several applications use capabilities, IP ranges, and MID Server selection to narrow the pool of MID Servers the applications need.

Note: At least one capability is required for each MID Server used by Orchestration. See MID Servers for Orchestration for more information.
The following capabilities are available by default with Discovery:

<table>
<thead>
<tr>
<th>Capability</th>
<th>IBM</th>
<th>Resolve DNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ansible</td>
<td>JDBC</td>
<td>REST</td>
</tr>
<tr>
<td>AWS</td>
<td>NetApp</td>
<td>SNMP</td>
</tr>
<tr>
<td>Azure</td>
<td>Nmap</td>
<td>SOAP</td>
</tr>
<tr>
<td>Chef</td>
<td>OpenStack</td>
<td>SSH</td>
</tr>
<tr>
<td>Cloud Management</td>
<td>PowerShell</td>
<td>VMware</td>
</tr>
<tr>
<td>Google</td>
<td>RCA</td>
<td>WMI</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to **MID Server > Capabilities**.
2. Select an existing capability. You can also select **ALL** to include all capabilities.

**Note:** Ensure that each IP address range has MID Servers with the necessary capabilities to complete the Orchestration activities on that network segment.

3. Create a new capability:
   a. Click **New**.
   b. Configure the value for a custom capability.

   **Example**
   An example is a capability for **DOMAIN**, with a value of **service-now**.

   c. Click **Submit**.

4. Click **Edit** in the MID Servers related list to add MID Servers to the capability.
5. Select one or more MID Servers for this capability from the **Available** list.
6. Click **Save**.

   The capability defined here also appears in the primary record for this MID Server.

**MID Server capabilities**

MID Server capabilities define the specific functions of a MID Server within an IP address range.
Nmap capability

The Nmap capability is only assigned to MID Servers for which the Network Mapper (Nmap) scanner has been installed for credential-less Discovery. This capability cannot be added to or removed from any MID Server manually. For instructions on installing or uninstalling Nmap, see Install and uninstall Nmap on a MID Server.

MID Server capability values

Capabilities provided in the base system do not have a defined value string. The capability value can be blank, a single value, or a * (wildcard). A MID Server configured to use a capability that has no value can locate any device using that capability's protocol. If a capability has a defined value, the MID Server using that capability finds only those devices using that protocol that match the value string exactly. The exception to this is the Resolve DNS capability, which is configured to resolve any DNS name into an IP address using a partial string match. The * (wildcard) will match a request capability specifying any non-blank value.

Starting with the Madrid release, the [capability name]:[value] combination appears in the slushbucket when you add a capability to a MID Server. This combination allows you to see all the capabilities that have different values, even if the capability name is the same. For example, if you are using the Cloud Management capability, and you use the value field to specify the us-west logical datacenter on one of the capability records, you can see the combination in the Collection list.
**MID Server selection**

The MID Server is selected using an algorithm based on the capabilities available. The selector produces a list of suitable MIDs using filters in the following order: server status > applications > IP range > capabilities. The algorithm searches the capabilities in the following sequence and, if a step finds at least one MID server, the remaining steps are skipped:

1. **Exact value match:** Find each MID Server containing capabilities with name/value pairs with an exact match to all requested capability name/value pairs. Blank is a valid value. * (wildcard) values are ignored.

2. **Wildcard value match:** The same as an exact value match, but also allows a non-blank request value to match MID server capability records containing value *.

3. **Special capability name ALL:** Find each MID Server containing the special capability name ALL, ignoring capability's value field.

**Note:** If the requested capability name does not exist in the ecc_agent_capability table, BadArgumentException is thrown rather than falling back to the ALL capability.

**Scripted MID Server capability value matching**

You can use value tests to create capabilities that find devices using values without requiring exact string matching. Action on these values is controlled by a user-defined script.

The Resolve DNS capability is provided in the base system and is configured to resolve DNS names into IP addresses for devices whose names end with a specified domain name. The capability Value entered is automatically prefaced with a dot during processing to match domain syntax. This value can contain one or more sub-domains, but must include the end of the domain string. Matching devices must end with the identical syntax. The script for the Resolve DNS capability determines if a device name matches the criteria defined by Value. If a match exists, the platform performs the address resolution automatically. For example, if the value for the Resolve DNS capability is service-now.com, the MID Server with this capability finds lnxlab01.sandiego.service-now.com and dbsrv101.sanjose.service-now.com. If the value is changed to sandiego.service-now.com, then the MID Server finds only lnxlab01.

**Note:** If Value in the Resolve DNS capability is blank, then all domains match.

To view the script for evaluating this capability, navigate to MID Server > Capability Value Tests and select Resolve DNS from the list.
Configure a MID Server cluster

Group multiple MID Servers to form clusters, then configure clusters for fail-over protection or load balancing. Load-balancing clusters automatically balance work between each MID Server to improve stability and performance. Fail-over clusters have a configured order used to determine which MID Server to use next if a failure occurs.

Before you begin

Ensure that each MID Server in the cluster has the appropriate capabilities for the job. A MID Server in a fail-over cluster must have the same capabilities (or expanded capabilities) as the MID Server it is expected to replace.

Role required: admin
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

About this task
You can select a MID Server cluster from the Discovery Schedule form.

Procedure
1. Navigate to MID Server > Clusters.
2. Click New.
3. Name the cluster and select the cluster type: Failover or Load Balance.
4. Right click in the header bar and select Save from the context menu.
5. Click Edit in the Includes MID Servers Related List.
6. Select appropriate MID Servers for this cluster from the slushbucket.

MID Server clusters
MID Server clusters enable multiple MID Servers with the appropriate capabilities to be grouped together for load balancing and fail-over protection.

External data sources
For performance and reliability reasons, these data sources should not be used with MID Server clusters. These external data sources should only be used with dedicated MID Servers.
• LDAP
• Export sets
• JDBC data sources

⚠️ **Note:** If a MID Server in a cluster fails, the fail-over MID Server starts over at the beginning of the ECC queue task even if much of the information from the JDBC data source was already returned. This can result in duplicate data. For more details, see the Using MID Server clusters for JDBC data sources can cause duplicate and out-of-date data [KB0727739] article in the HI Knowledge Base.

### How clusters work

MID Servers in clusters must be able to connect to the instance and to all the devices with which they are expected to communicate. If all MID Servers in a cluster are down, the discovery is canceled. Make sure all the MID Servers are added to any Access Control List (ACL) in use. MID Server clusters are managed by a business rule called MID Server Cluster Management, which checks to see if the MID Server assigned to a job in the ECC Queue belongs to a cluster.

#### Load balancing

If the cluster business rule determines that a MID Server is part of a load balancing cluster, the application using the MID Server automatically balances the work between the MID Servers in that cluster. It is good practice to put MID Servers with the same capabilities in a load balancing cluster.

#### Fail-over protection

MID Servers in a fail-over cluster each have a configured order that the platform uses to determine which MID Server to use next in case of failure. MID Servers in a fail-over cluster work independently and do not load balance with other MID Servers in that cluster (although they might also be members of load balancing clusters). When a MID Server fails, the MID Server Cluster Management business rule selects the highest available MID Server in the order to take over the work. The selected MID Server checks the ECC Queue and starts with jobs that are either Processing or Ready.

⚠️ **Note:** MID Server clustering does not support the ECC queue topics Command or SystemCommand. If these commands are received, the clustered MID Servers do not redirect the ECC queue to another MID Server. The ECC queue records stay on the ECC queue without being processed.
Configure a fail-over MID Server with at least the same capabilities as the MID Server it is intended to relieve.

**Note:** If a MID Server fails while the Shazzam probe is running and auto-selection is configured, failover is not available. The Shazzam discovery stops. Discovery does not automatically choose another MID Server.

**MID Server cluster event**

The following event is triggered when the platform cannot find a MID Server with the appropriate capabilities to replace a MID Server in a fail-over cluster. Use this event to create an email to notify appropriate users that the cluster has failed.

<table>
<thead>
<tr>
<th>Event</th>
<th>Table</th>
<th>Description</th>
<th>Business Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>mid_server.cluster.down</td>
<td>MID Server Cluster</td>
<td>A MID Server cluster has failed</td>
<td>MID Server Cluster Management</td>
</tr>
</tbody>
</table>

**Combining clusters**

A MID Server can be added to both types of clusters at the same time. This diagram shows a scenario in which a MID Server from a load balancing cluster (MID Server D) is also present in a fail-over cluster. If MID Server D fails, MID Server E in the failover cluster is available to the load balancing cluster to perform the tasks previously assigned to MID Server D.

![Diagram of combining clusters](image)

**Specifying a specific MID Server cluster**

You can specify a specific MID Server cluster for a Discovery schedule. The discovery process uses that cluster only. You cannot chain clusters or specify a single MID Server that belongs to multiple clusters.
Distributed MID Server clusters for Operational Intelligence

The distributed MID Server cluster type is used exclusively in Operational Intelligence, which analyzes Event Management events and generates anomaly alerts. These MID Servers communicate with one another to distribute and balance the workload. For details, see MID Server distributed clusters for Operational Intelligence.

Set MID Server thread use

The three parameters: threads.interactive.max, threads.expedited.max, and threads.max define the maximum numbers of worker threads that can run simultaneously in each pool. Change the number of threads used by the MID Server according to performance requirements. MID Servers which compete with other programs for CPU time can use fewer threads than the default. MID Servers which need more speed, and have a host computer powerful enough, can use more threads.

Before you begin
Role required: admin

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

About this task
Changing the thread parameters can affect the MID Server performance. The interactive thread pool is designed for executing interactive messages including system commands and heartbeats. They are typically lightweight,
so usually there is no need to change the default value. The expedited thread pool is designed for executing messages that have higher priority than the standard ones but less than interactive ones. Unless you have applications that produce a lot of expedited messages, there is no need to change the default value for threads.expedited.max. The standard thread pool is the busiest pool. Most probes are using it and they can take a lot of system resources such as CPU, memory, and so on. You can set the MID Server to use as few as five threads without issue. To increase the speed of the MID Server if the host is powerful enough or lightly loaded with other programs, you can increase the threads setting. The threads setting depends on the limitation of the CPU speed, memory, and operating system of the host machine. You might have to experiment to find the optimal threads count that works best when the MID Server is busy so it does not exhaust the host machine’s hardware limitations. This means you may have to refine the thread count to best meet your situation. The following general observations may be useful:

- PowerShell is resource intensive and threads may not scale linearly.
- Most MID Server tasks require file handles to do their job.
  - Windows: On the Windows operating system, file handles are available in a fixed quantity. If you configure too many MID Server threads on a Windows host, the MID Server can consume all the file handles before approaching maximum CPU usage. This situation appears as an Out of file handles error in the MID Server log and indicates that the MID Server is trying to use too many threads.
  - UNIX and Linux: UNIX and Linux hosts have a much different scheme for allocating file handles. Generally, you can increase MID Server thread use on these operating systems until the CPU of the host is overloaded. See your OS documentation for monitoring CPU usage.
- Each thread on the MID Server requires some memory. Exactly how much memory varies considerably from task to task and depends on the equipment being discovered. To increase the number of threads, you might have to increase the amount of memory that Java uses. If you configure insufficient memory, an Out of memory error appears in the MID Server log.
- You can set threads.max as high as 200, however, this setting may need to be changed depending on the OS. For example, Windows-based MID Servers running Discovery uses Powershell which is resource intensive. In this case, you may exhaust the CPU power of the host machine with just 50 threads count.

Follow the steps below to change the config.XML file. Alternatively, use the threads.max connection parameter. See MID Server Connection parameters for more details.
Procedure
1. Open the \agent\config.xml file using any text editor.
2. Locate the following lines:

   <!-- MID Server Threads -->
   <parameter name="threads.max" value="25"/>

3. Edit the value. Keep in mind the cautions described above.
4. Save the record.
5. Restart the MID Server service.

Install and uninstall Nmap on a MID Server
If you decide to use credential-less Discovery in your network, you must install Nmap on each Windows MID Server that you want to use for this purpose. Self-hosted customers whose network security does not permit downloads from install.service-now.com must use a specific manual process to install and configure Nmap.

Before you begin
Role required: mid_admin

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security
• Assign MID Server IP ranges to all deployed MID Servers. The quickest and most reliable way to do this is with the Using MID Server IP range auto-assignment feature available in the Discovery Quick Start wizard. This method ensures that the set of MID Servers configured to access an IP address range is comprehensive.

• Identify the IP ranges you want to explore with credential-less Discovery. Ensure that these ranges can only be accessed by MID Servers with Nmap installed, running on supported Windows hosts.

• Use the All option for selecting IP ranges and observe these requirements:
  ◦ Restrict the use of this feature to Windows MID Servers only.
  ◦ Ensure that Nmap is installed on each of these MID Servers.
  ◦ Ensure that the MID Servers can access the entire customer network.

• When you create a Discovery schedule with Nmap enabled, observe these requirements for the MID Server selection options:
  ◦ Specific MID Cluster: Verify that Nmap is installed on all MID Servers in the cluster, where each MID Server in the cluster is configured to access the same set of IP ranges.
  ◦ Auto-Select Mid Server: When running horizontal Discovery, verify that Nmap is installed on at least one of the MID Servers that can access the Discovery schedule's configured MID Server IP ranges.
  ◦ Specific MID Server: Verify that Nmap is installed on each MID Server that can access the schedule’s configured MID Server IP Ranges.

⚠️ Note: To use credential-less Discovery for Service Mapping, install Nmap on all MID Servers that can access the Discovery schedule's configured MID Server IP ranges.

Role required: agent_admin

About this task
The Discovery - IP Based [com.snc.discovery.ip_based] plugin provides connection to the installer for Nmap and the programming elements that allow a Windows MID Server to run approved scripts on target CIs for credential-less Discovery. MID Servers on which Nmap is installed can execute an Nmap command configured to perform reverse DNS name resolution, discover MAC addresses, or gather OS information on target CIs without using credentials. The Discovery - IP Based plugin is activated automatically when the Discovery [com.snc.discovery] or Event Management and Service Mapping Core [com.snc.service-watch] plugins are activated.

Service Mapping and Nmap
Service Mapping does not check for the presence of the **Nmap** capability and selects the MID Server based on the IP address only. To ensure that Service Mapping does not select a MID Server without the **Nmap** capability, install Nmap on all MID Servers assigned to the IP address ranges for which you want credential-less Discovery to be available. If Service Mapping selects a MID Server for credential-less Discovery that does not have Nmap capabilities, this error message appears in the map at the site of the CI being discovered: `Nmap is not installed on MID Server. Verify all MIDs configured to handle selected IP Address have Nmap Capability. Nmap root directory path does not exist: <path>`

**Amazon Web Service AWS**

Running Nmap scans to or from any resource within the Amazon Web Service AWS environment is tightly regulated and requires the permission of AWS through the **AWS Vulnerability/Penetration Testing Request** form. AWS only permits testing of EC2 and RDS instances that you own. Tests against any other AWS services or AWS-owned resources are prohibited. In addition, any Nmap scan of a permitted instance must be performed within an approved time window. For these reasons, credential-less Discovery within an AWS environment is not appropriate, and if a violation of their policy occurs, could result in expulsion from the service.

**Supported operating systems**

Nmap is supported on all editions of these operating systems, including virtual machines and 64 bit systems:

- Windows 2008
- Windows 2012
- Windows 2016

**MID Server requirements**

Nmap can be installed on MID Servers that meet these requirements:

- Status is **Up**.
- MID Server is validated.
- MID Server does not already have the **Nmap** capability.
⚠️ **Warning:** The MID Server installation path must not contain the following characters:

- `()`
- `{}`
- `[]`

The Nmap installer replaces these characters with spaces. This prevents the installer from finding the correct path, and the installation fails. An example of a path that will fail is `C:\MIDServers\MID(1)\agent`.

**Procedure**

1. Navigate to **MID Server > Servers**.
2. Open the desired MID Server record.
3. Under **Related Links**, select **Enable Credential-less Discovery**.
   A confirmation dialog box appears.

4. Click **Yes** to continue with the installation.
   The instance runs the Nmap installer from `https://install.service-now.com`, a site within a ServiceNow datacenter that contains installers for the platform. This progress notice appears during installation:

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
The **Logs** tab in the MID Server record shows the message: Running system command: installNmap.

5. Click **OK** if you want to hide the dialog box while the installer continues to run in the background. Installing Nmap also installs Npcap on the host, if it is not already installed. Npcap is Nmap's packet capture library for Windows that allows Nmap to perform port scans quickly and to identify the family of the operating system running on the target. Npcap is installed once on the host and can be used by any other application that requires it, such as Wireshark.

**Note:** If a more recent version of Npcap is already installed on the Windows MID Server host, Nmap is installed without Npcap. If an older version of Npcap is installed on the host, the Nmap installer upgrades it to the newer version.

The installation process has either of these outcomes:

- **Success**: These conditions indicate a successful installation:
  - The version of Nmap that is installed appears in the **Nmap version** field in the MID Server record.
  - The **Related Link** changes to **Disable Credential-less Discovery**.
  - The **Nmap** capability is assigned to the MID Server and appears in the **Capabilities** tab of the MID Server record.

- **Failure**: If the installation fails, an error message is logged to the MID Server Issue [ecc_agent_issue] table. If you run the installer again with success, the issue is marked as **Resolved**.

6. To uninstall Nmap for a selected MID Server, select **Disable Credential-less Discovery** under **Related Links** in the MID Server record. This dialog appears during the uninstallation process:
The **Logs** tab in the MID Server record shows the message: Running system command: uninstallNmap.

⚠️ **Attention:** Because Npcap can be used by other applications, uninstalling Nmap does not automatically uninstall Npcap. You must uninstall Npcap manually, after determining that no other dependencies exist.

**Related information**

**Credential-less Discovery**

**Install Nmap on a self-hosted system**

Use this procedure to install Nmap on MID Server host machines in a self-hosted environment that does not allow network access to the ServiceNow® install.service-now.com download site.

**Before you begin**

Role required: admin, maint

**About this task**

You must install Nmap manually on each MID Server host, and then configure the instance to execute credential-less Discovery.

ℹ️ **Note:** This procedure does not apply to self-hosted customers whose MID Server hosts can access install.service-now.com from within their network.

**Procedure**

1. Navigate to **MID Server > Properties** (MID Server Property [ecc_agent_property] table) and open the record for the mid.nmap.version property.
   This property contains the version of Nmap that you must install. Record the version number.

2. Download the correct installer executable from one of these URLs:
   - **https://nmap.org/dist/**: If the Nmap version in the property is 7.50, the executable you need is https://nmap.org/dist/nmap-7.50-setup.exe.
   - **https://install.service-now.com/glide/distribution/builds/package/thirdparty/nmap/nmap-setup-xxx-windows.exe**: If the Nmap version in the property is 7.50, the executable you need is https://install.service-now.com/glide/distribution/builds/package/thirdparty/nmap/nmap-setup-7.50-windows.exe

3. Create a folder called nmap in the MID Server agent folder of every MID Server you want to use for credential-less Discovery.
4. Copy the Nmap installer file that you downloaded to the `nmap` folder and rename it to `nmapInstaller.exe`.

5. Run the `agent\scripts\PowerShell\NmapInstallation.ps1` script and pass it the following parameters in the order in which they appear. This script runs the `nmapInstaller.exe` file.

   a. `$operation`: Task that `NmapInstallations.ps1` will process. To install Nmap, the task is `install`.

   b. `$nmap_root_path`: Complete path for the `nmap` folder that you create in step 4.

   c. `$nmap_self_installer`: Complete path for `nmapInstaller.exe` file that you copied in step 5.

   d. `$nmap_command`: Complete path for the Nmap install command. The `NmapInstallations.ps1` script installs Nmap in the `nmap` folder created in step 4. This parameter is `$nmap_root_path\nmap.exe`.
e. `$nmap_uninstall_command`: Complete path for the Nmap uninstall command. This command is `$nmap_root_path\Uninstall.exe`.

f. `$nmap_npcap_version`: The Npcap version installed with Nmap. This value must be the same as the value of the `mid.nmap.npcap.version` property in the MID Server Property [ecc_agent_property] table.

g. `$nmap_safe_scripts`: List of safe scripts that Nmap uses. You can retrieve this list from the `mid.nmap.safe.scripts` property in the MID Server Property [ecc_agent_property] table.

6. Set up the parameters in the `NmapInstallation.ps1` script in this order:

   ```powershell
   .\NmapInstallation.ps1 $operation $nmap_root_path $nmap_self_installer $nmap_command $nmap_uninstall_command $nmap npcap_version $nmap_safe_scripts
   ```

   For example, the script might look like this:

   ```powershell
   PS C:\MidServers\mid1\agent\scripts\PowerShell> .\NmapInstallation.ps1 "install"
   "C:\MidServers\mid1\agent\map" "C:\MidServers\mid1\agent\nmap\nmapInstaller.exe"
   "C:\MidServers\mid1\agent\nmap\unmap.exe" "0.91"
   "allseeingeye-info.nse,amqp-info.nse,db2-das-info.nse,drda-info.nse,freelancer-info.nse,
   ike-version.nse,mcafee-epo-agent.nse,mqtt-subscribe.nse,openlookup-info.nse,oracle-tns-ve
   rsion.nse,
   quake1-info.nse,quake3-info.nse,rfc868-time.nse,rpcinfo.nse,snmp-info.nse,ventrilo-info.n
   se,
   weblogic-t3-info.nse,xmpp-info.nse"
   ```

7. After installation is complete, add the **Nmap** capability to each MID Server you want to use for credential-less Discovery.

   **Attention:** Only a `maint` user can add the **Nmap** capability to a MID Server. Contact Customer Service and Support to request temporary `maint` access to your instance.

   a. On the instance, open the MID Server record.

   b. Select the **Capabilities** related list.

   c. Click **Edit**.
d. Select **Nmap** from the list of available capabilities and click **Save**.

![Image of Nmap capabilities in ServiceNow](image)

**Uninstall Nmap on a self-hosted system**

Use this procedure to uninstall Nmap in a self-hosted environment that does not allow network access to the ServiceNow `install.service-now.com` download site.

**Before you begin**

Role required: admin, maint

**About this task**

Nmap must be manually uninstalled from each MID Server host machine and then disabled on the ServiceNow instance.

**Procedure**

1. Run `Uninstall.exe` in the `nmap` folder on each MID Server host configured for credential-less Discovery.
2. After uninstallation is complete, delete the `nmap` folder from the `agent` folder.
3. Remove the **Nmap** capability from each MID Server record.

⚠️ **Attention:** Only a **maint** user can remove the **Nmap** capability from a MID Server. Contact Customer Service and Support to request temporary **maint** access to your instance.

a. On the instance, open the MID Server record.

b. Select the **Capabilities** related list.

c. Click **Edit**.

d. Remove **Nmap** from the active capabilities list and click **Save**.
Configure MID Server as WinRM trusted host

In environments using Windows Remote Management (WinRM), Discovery or Service Mapping can discover servers using the WinRM protocol. Add servers, which are part of WinRM, as trusted hosts on all MID Servers that Discovery or Service Mapping use for discovery.

Before you begin
Role required: mid_admin

Procedure

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

About this task
MID Server cannot access servers using the WinRM protocol unless these servers are configured as trusted hosts for this MID Server.

Perform this procedure on each MID Server used by Service Mapping or Discovery.

Procedure

1. On the MID Server, open the command-line shell.
2. To add all servers to the TrustedHosts lists, run the following command:

   ```shell
   winrm s winrm/config/client @{TrustedHosts="*"}
   ```
3. To add specific servers to the TrustedHosts list, run the command with the comma-separated hosts instead of the asterisk (*), for example:

```
winrm s winrm/config/client @{TrustedHosts="serverA,serverB,serverC"}
```

**MID Server domain separation**

Use the MID Server user role to configure MID Servers to access separate domains. The credentials in the `config.xml` file of a MID Server determine which domains it can access. Specific MID Server policy records can be restricted for use only by MID Server from the same domain.

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

The records that can be read, updated, or created by a MID Server are determined by the credentials configured for that MID Server in the `config.xml` file. These are the user credentials that a MID Server uses to access the instance and specify which domain's records that MID Server can access.

You can create versions of these specific MID Server policy records that only a MID Server from the same domain can use. This process separation is supported for records in tables that extend MID Server Synchronized Files [ecc_agent_sync_file]:
• MID Server MIB File [ecc_agent_mib]
• MID Server JAR File [ecc_agent_jar]
• MID Server Script File [ecc_agent_script_files]

⚠️ Note: Attachments on MIB or JAR file records might not appear as they did in a non-domain separated environment. The attachments do not appear because the Attachments [sys_attachment] table is data separated. When data is separated between domains, a record in a child domain cannot access records in a parent domain.

Set up domain separation for MID servers

Set up domain separation through the MID server user role and the MID Server configuration file.

Before you begin
Role required: admin, agent_admin

Procedure

1. Configure a MID Server user within a specified domain with the proper mid_server role.

2. Specify this user within the MID Server config.xml file. When you set the MID Server user credentials in the config.xml file, make sure they are in the proper domain.

What to do next

If you must change the MID Server domain:

1. Stop the MID Server and delete the ecc_agent record.

2. Update the MID Server config.xml with the new user in the new domain and restart the MID Server service.

If you need to create versions of specific MID Server files that only MID Servers in your domain can use:

1. Open or create a record in one of these MID Server modules:
   - SNMP MIBs
   - JAR Files
   - Script Files
2. Update an existing domain policy or submit a new record.

Note: Attachments on MIB or JAR file records might not appear as they did in a non-domain separated environment. The attachments do not appear because the Attachments [sys_attachment] table is data separated. When data is separated between domains, a record in a child domain cannot access records in a parent domain.

Configure a multi-domain MID Server

You can create a MID Server in the global domain that can explore targets in other domains.

Before you begin

Before configuring a multi-domain MID Server:

- Ensure that your instance is domain separated.

Role required: admin

Procedure

1. Type sys_properties.list in the navigation filter and press Enter.
2. Locate the glide.ecc.enable_multidomain_mid property.
3. Set the value of the property to true.

Note: Enabling this property has no effect on existing MID Servers. MID Servers in a domain prior to setting this property, remain in that domain.

4. Create a MID Server in the global domain.

A MID Server created in the global domain after this property is set to true can explore any domain for which it has the credentials. However, this MID Server is restricted to trying only the credentials for the target domains requested by ECC Queue inputs.

CAUTION: If you reset the glide.ecc.enable_multidomain_mid property to false after creating a multi-domain MID Server in the global domain, that MID Server writes all the data it receives to the global domain and not to the correct domains.
Synchronize a JAR file to MID Servers

You can upload a JAR file to an instance and synchronize it to all MID Servers, or write custom probes that use the synchronized JAR file.

Before you begin

Role required: admin, agent_admin

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

The MID Server JAR File [ecc_agent_jar] table is domain separated. You can create versions of these policies that only a MID Server from the same domain can use. For instructions, see Set up domain separation for MID servers.

⚠️ CAUTION: Synchronizing a JAR file with this procedure causes all MID Servers connected to the instance to restart automatically.

Procedure

1. Navigate to MID Server > JAR Files.
2. Click New.
3. Complete the following fields:
   - Name: A unique and descriptive name for identifying the file in the instance.
   - Version: A version number for the file, if one is available.
**Source:** Location of the JAR file for reference purposes. Source information is not used by the system.

**Description:** Short description of the JAR file and its purpose in the instance.

4. Click the paper clip icon in the banner.

![Attach a file](image)

5. In the Attachments dialog box, click **Browse** and select the file you want to attach.

The platform attaches the JAR file to the record and restarts the MID Servers to synchronize the file. It is not necessary to update the record to attach the file.

**vCenter event collector**

The vCenter event collector is a MID Server extension that listens for vCenter-related events and updates the CMDB accordingly.
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

The event collector allows the CMDB to be updated with changes to virtual machines (VMs), in addition to the updates detected by Discovery. A change to a VM is sent as an event from the vCenter server to the vCenter event collector. When an event is received, the CMDB is updated accordingly. Full vCenter Discovery does not need to rerun. For some events, such as powered on and powered off events, Discovery does not need to run again at all. For most events, Discovery runs only on the necessary vCenter resource.

For example, if a VM is turned off, the vCenter server sends the event `VmPoweredOffEvent`. The vCenter event collector receives and processes the event and the CMDB is updated to reflect that the state of the corresponding VM is set to off.

**Important:** With this extension, Discovery can only modify the state of a VM which exists in the CMDB. When an event with "CreatedEvent" occurs in its name, such as `VmCreatedEvent`, Discovery scans that VM and then creates the CI using the data it collects. When a new event occurs involving that CI, Discovery can update the existing record without launching another scan.

**Note:**

vCenter event collector supports domain separation by inheriting the domain of the specified Mid Server in the event collector context. However, it does not support multi-domain Mid Server configuration.
See Discovery for VMware vCenter for supported versions of vCenter.

**How vCenter events are processed**
The MID Server listens for the vCenter events configured in the vCenter Event Collector form. When one of these events is returned from vCenter, the instance parses the payload with a business rule that converts the vCenter event into a system event (sysevent). The instance then uses that sysevent to perform tasks, such as email notification.

⚠️ **Note:** If the MID server is paused when a vCenter event occurs, the MID server still processes the event. In this case, it is possible for the event collector to display a status of **Started**.

The resulting sysevents contain these values:

- **Name:** Name of the system event created from the vCenter event. This value is always `automation.vcenter`.
- **Parm1:** vCenter event that was returned. This event must be associated with an event collector record.
- **Parm2:** Event data provided by vCenter, in JSON format.

### Log entries for vCenter events
![Log entries for vCenter events](image)

### Supported vCenter events
The following events are the only vCenter events handled by the base system when Discovery is activated. If you have upgraded your instance from an earlier version, you might not have the default events added with later releases. To use the missing events, manually add them.

#### vCenter events

<table>
<thead>
<tr>
<th>Event name</th>
<th>Description</th>
<th>Launches probe</th>
</tr>
</thead>
<tbody>
<tr>
<td>VM events</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Event name</th>
<th>Description</th>
<th>Launches probe</th>
</tr>
</thead>
<tbody>
<tr>
<td>VmPoweredOnEvent</td>
<td>The VM has been powered on from the powered off state or resumed from the suspended state. This event is sent when the VM is powered on. It does not account for the time it may take to boot the host operating system.</td>
<td>None</td>
</tr>
<tr>
<td>DrsVmPoweredOnEvent</td>
<td>The VM has been powered on by a distributed resource schedule (DRS), which balances workload between available resources.</td>
<td>None</td>
</tr>
<tr>
<td>VmRestartedOnAlternateHostEvent</td>
<td>The VM was restarted on another host because the original host failed.</td>
<td>None</td>
</tr>
<tr>
<td>VmPoweredOffEvent</td>
<td>The VM has been powered off. If the host OS is shut down, this event is sent after the host OS shuts down and the VM enters the powered off state.</td>
<td>None</td>
</tr>
<tr>
<td>VmPowerOffOnIsolationEvent</td>
<td>The VM has been powered off on an isolated host in an HA cluster.</td>
<td>None</td>
</tr>
<tr>
<td>VmShutdownOnIsolationEvent</td>
<td>The VM has been shut down on an isolated host in an HA cluster.</td>
<td>None</td>
</tr>
<tr>
<td>VmSuspendedEvent</td>
<td>The VM is suspended. This event is sent after</td>
<td>None</td>
</tr>
</tbody>
</table>
### vCenter events (continued)

<table>
<thead>
<tr>
<th>Event name</th>
<th>Description</th>
<th>Launches probe</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>VmCreatedEvent</strong></td>
<td>The VM was successfully created.</td>
<td><strong>VMWare - vCenter VMs</strong></td>
</tr>
<tr>
<td><strong>VmDeployedEvent</strong></td>
<td>The VM was deployed successfully.</td>
<td><strong>VMWare - vCenter VMs</strong></td>
</tr>
<tr>
<td><strong>VmDiscoveredEvent</strong></td>
<td>The vCenter successfully discovers the VM.</td>
<td><strong>VMWare - vCenter VMs</strong></td>
</tr>
<tr>
<td><strong>VmMigratedEvent</strong></td>
<td>One or both of the following occurs:</td>
<td><strong>None</strong></td>
</tr>
<tr>
<td></td>
<td>• The VM has been hot-migrated, with vMotion, to another ESX server.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The storage for the VM has been hot migrated.</td>
<td></td>
</tr>
<tr>
<td><strong>VmRelocatedEvent</strong></td>
<td>The VM has been relocated while offline (either suspended or powered off). A VM migration of the VM to a different host, or the migration of any storage used by the VM triggers the event.</td>
<td><strong>None</strong></td>
</tr>
<tr>
<td><strong>VmRemovedEvent</strong></td>
<td>The VM instance has been deleted from vCenter.</td>
<td><strong>None</strong></td>
</tr>
<tr>
<td><strong>VmClonedEvent</strong></td>
<td>The VM was cloned successfully.</td>
<td><strong>VMWare - vCenter VMs</strong></td>
</tr>
<tr>
<td><strong>DrsVmMigratedEvent</strong></td>
<td>Migration of a VM recommended by a DRS.</td>
<td><strong>None</strong></td>
</tr>
</tbody>
</table>
**vCenter events (continued)**

<table>
<thead>
<tr>
<th>Event name</th>
<th>Description</th>
<th>Launches probe</th>
</tr>
</thead>
<tbody>
<tr>
<td>VmRegisteredEvent</td>
<td>The VM was successfully registered.</td>
<td>VMWare - vCenter VMs</td>
</tr>
<tr>
<td>VmReconfiguredEvent</td>
<td>The VM was reconfigured.</td>
<td>VMWare - vCenter VMs</td>
</tr>
<tr>
<td>VmInstanceUuidAssignedEvent</td>
<td>A new instance UUID was assigned to the VM.</td>
<td>None</td>
</tr>
<tr>
<td>VmRenamedEvent</td>
<td>The VM was successfully renamed.</td>
<td>None</td>
</tr>
<tr>
<td>VmUuidAssignedEvent</td>
<td>A new BIOS UUID was assigned to the VM.</td>
<td>None</td>
</tr>
<tr>
<td>VmMacAssignedEvent</td>
<td>A new MAC address was assigned to the VM.</td>
<td>VMWare - vCenter VM NICs</td>
</tr>
<tr>
<td>VmMacChangedEvent</td>
<td>The MAC address of a VM was changed.</td>
<td>VMWare - vCenter VM NICs</td>
</tr>
<tr>
<td>VmGuestShutdownEvent*</td>
<td>The guest VM shut-down.</td>
<td>None</td>
</tr>
<tr>
<td>VmStoppingEvent</td>
<td>The VM stopped.</td>
<td>None</td>
</tr>
<tr>
<td>VmResettingEvent</td>
<td>The VM reset.</td>
<td>None</td>
</tr>
</tbody>
</table>

**Cluster events**

<table>
<thead>
<tr>
<th>Event name</th>
<th>Description</th>
<th>Launches probe</th>
</tr>
</thead>
<tbody>
<tr>
<td>ClusterCreatedEvent</td>
<td>A cluster was created.</td>
<td>VMWare - vCenter Clusters</td>
</tr>
<tr>
<td>ClusterReconfiguredEvent</td>
<td>A cluster was reconfigured.</td>
<td>VMWare - vCenter Clusters</td>
</tr>
<tr>
<td>ClusterDestroyedEvent</td>
<td>A cluster was destroyed.</td>
<td>None</td>
</tr>
</tbody>
</table>

**Datastore events**

<table>
<thead>
<tr>
<th>Event name</th>
<th>Description</th>
<th>Launches probe</th>
</tr>
</thead>
<tbody>
<tr>
<td>DatastoreRenamedEvent</td>
<td>A datastore was renamed.</td>
<td>None</td>
</tr>
<tr>
<td>VMFSDatastoreCreatedEvent</td>
<td>A VM File System (VMFS) datastore was created.</td>
<td>VMWare - vCenter Datastores</td>
</tr>
<tr>
<td>DatastoreDiscoveredEvent</td>
<td>A host was added to VirtualCenter and</td>
<td>VMWare - vCenter Datastores</td>
</tr>
</tbody>
</table>
**vCenter events (continued)**

<table>
<thead>
<tr>
<th>Event name</th>
<th>Description</th>
<th>Launches probe</th>
</tr>
</thead>
<tbody>
<tr>
<td>NASDatastoreCreatedEvent</td>
<td>An Network Attached Storage (NAS) datastore was created.</td>
<td>VMWare - vCenter Datastores</td>
</tr>
<tr>
<td>LocalDatastoreCreatedEvent</td>
<td>A local datastore was created.</td>
<td>VMWare - vCenter Datastores</td>
</tr>
<tr>
<td>VMFSDatastoreExpandedEvent</td>
<td>A datastore was expanded.</td>
<td>VMWare - vCenter Datastores</td>
</tr>
<tr>
<td>DatastoreDestroyedEvent</td>
<td>A datastore was removed from VirtualCenter.</td>
<td>None</td>
</tr>
</tbody>
</table>

**Network events**

<table>
<thead>
<tr>
<th>Event name</th>
<th>Description</th>
<th>Launches probe</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVPortgroupCreatedEvent</td>
<td>A port group was created.</td>
<td>VMWare - vCenter Networks</td>
</tr>
<tr>
<td>DVPortgroupRenamedEvent</td>
<td>A port group was renamed.</td>
<td>None</td>
</tr>
<tr>
<td>DVPortgroupDestroyedEvent</td>
<td>A port group was destroyed.</td>
<td>None</td>
</tr>
</tbody>
</table>

**Resourcepool events**

<table>
<thead>
<tr>
<th>Event name</th>
<th>Description</th>
<th>Launches probe</th>
</tr>
</thead>
<tbody>
<tr>
<td>ResourcePoolDestroyedEvent</td>
<td>A resource pool was destroyed.</td>
<td>None</td>
</tr>
<tr>
<td>ResourcePoolCreatedEvent</td>
<td>A resource pool was created.</td>
<td>VMWare - vCenter Clusters</td>
</tr>
<tr>
<td>ResourcePoolMovedEvent</td>
<td>A resource pool was moved.</td>
<td>VMWare - vCenter Clusters</td>
</tr>
<tr>
<td>ResourcePoolReconfiguredEvent</td>
<td>A resource pool was reconfigured.</td>
<td>VMWare - vCenter Clusters</td>
</tr>
</tbody>
</table>

**DVS events**

<table>
<thead>
<tr>
<th>Event name</th>
<th>Description</th>
<th>Launches probe</th>
</tr>
</thead>
<tbody>
<tr>
<td>DvsCreatedEvent</td>
<td>A distributed virtual switch was created.</td>
<td>VMWare - vCenter Networks</td>
</tr>
</tbody>
</table>
vCenter events (continued)

<table>
<thead>
<tr>
<th>Event name</th>
<th>Description</th>
<th>Launches probe</th>
</tr>
</thead>
<tbody>
<tr>
<td>DvsRenamedEvent</td>
<td>A distributed virtual switch was renamed.</td>
<td>None</td>
</tr>
<tr>
<td>DvsDestroyedEvent</td>
<td>A distributed virtual switch was destroyed.</td>
<td>None</td>
</tr>
</tbody>
</table>

**Datacenter events**

<table>
<thead>
<tr>
<th>Event name</th>
<th>Description</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>DatacenterCreatedEvent</td>
<td>A datacenter was created.</td>
<td>VMWare - vCenter Datacenters</td>
</tr>
<tr>
<td>DatacenterRenamedEvent</td>
<td>A datacenter was renamed.</td>
<td>None</td>
</tr>
</tbody>
</table>

Configure and run the vCenter event collector extension

Configure the vCenter event collector extension in the MID Server module, and then add or remove supported events.

**Before you begin**

Before configuring event collectors, perform these tasks:

- Deploy and start a MID Server.
- Ensure that the MID Server has access to the vCenter.
- Run discovery on the vCenter.

Role required: agent_admin, admin

**About this task**

Multiple MID Servers can listen to the same vCenter instance, and you can add multiple Event Collectors for different vCenters to a single MID Server. Make sure you configure the events on the event collector record that specify the correct MID Server.

**Note:** You can add events to the vCenter event collector. However, not every event is supported by the base system event handlers. If you want to handle events other than those supported in the base Discovery system, you must create a script action to process the events. For instructions, see . As a reference, the instance processes the vCenter events in the base system with a script action called **Discovery: Process vCenter events**. Do not edit or delete this script action.
To configure the vCenter event processor extension:

Procedure

1. Navigate to MID Server > Extensions > vCenter Event Collectors.
2. Click New or open an existing extension.
3. Fill in the fields, as appropriate from the table.
4. Right-click in the header bar and click Save in the context menu.
   The vCenter Event related list appears, containing the default events that the system is configured to handle.
5. To select a different vCenter event, click Edit in the vCenter Event related list and browse for the event.
   The slushbucket does not display all the available events in the opening list. Use the filter to browse for events not displayed.
6. Under Related Links click Start to save the events in this collection and start the collector.
   The Related Links in this form work as follows:

<table>
<thead>
<tr>
<th>Related Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Starts the collector if it is not running. The extension connects to the specified vCenter server by enumerating the VMware credentials in the credential set until a connection can be made. Next, the extension tells the vCenter server to supply the events specified in the Collector Context.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops the running collector on the configured MID Server. No action is taken if the extension is not running.</td>
</tr>
<tr>
<td>Restart</td>
<td>Stops, then starts the collector on the configured MID Server.</td>
</tr>
<tr>
<td>Test</td>
<td>Tests the parameters for validity. If the IP address, hostname, and the set of events is valid then the test returns a successful status. If any of the parameters are incorrect, an error is shown. Running a test does not affect any extensions that are currently running.</td>
</tr>
<tr>
<td>Update parameters</td>
<td>Sends updated parameters to the collector. Any changes you make to the collector while the MID Server is running do not take effect immediately when they are saved. If you click this control when the collector is not running, no update is made.</td>
</tr>
</tbody>
</table>
In the case of the vCenter extension, the collector first tests the parameters for validity. If the parameters are valid, the extension disconnects from the vCenter server and reconnects with the new parameters.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for this vCenter event collector extension for easy identification.</td>
</tr>
<tr>
<td>Short description</td>
<td>A description of this collector.</td>
</tr>
<tr>
<td>Extension</td>
<td>[Read-Only] The collector type is automatically set to vCenterExtension.</td>
</tr>
<tr>
<td>Status</td>
<td>This field auto-populates with the status of the collector. This field is blank until the collector is started. After issuing a command to the</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>collector</td>
<td>The MID Server continues to process vCenter events, even if it is paused. The status of the event collector may show as Started.</td>
</tr>
</tbody>
</table>
| Status        | • **Started**: The collector is running.  
• **Stopped**: The collector is not running.  
• **Offline**: The MID Server is down.  
• **Error**: The collector failed with an error.                                                                                                    |
| Error Message | Message describing any error that causes a command, such as Start or Stop, to fail. This field only appears when the value in the Status field is Error.                                                      |
| Execute on    | Location for running this collection. The possible options are Specific MID Server or Specific MID Server Cluster.                                                                                           |
| MID Server    | The name of the designated MID Server if you selected Specific MID Server in the Execute on field. The name of the designated MID Server cluster if you selected Specific MID Server Cluster. If you selected the MID Server cluster option, an algorithm determines which server in the cluster runs the collector. |
| vCenter       | The IP address or hostname of the vCenter server.                                                                                                                                                           |
| Executing on  | [Read-Only] The name of the MID Server on which the collector is running. This field shows the name of...
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>the MID Server even if the MID Server is down. If the collector is stopped by the user, this field is empty.</td>
</tr>
</tbody>
</table>

**Related information**

VMware discovery

**SNMP trap collector extension**

The SNMP trap collector is a MID Server extension that listens for SNMP traps from the devices on your network.

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

Upon receiving a trap, the MID Server sends the trap to the instance for further processing by Event Management. If Event Management is not active, traps are not processed and are discarded by the instance.

For the SNMP trap collector extension to receive traps from network devices, each device must designate the MID Server that runs the SNMP trap collector extension as a recipient of the trap. See the documentation for the network device to configure your hardware to do this. Generally, the SNMP trap collector extension should run on only one MID Server per VLAN. Multiple MID Server recipients on the same VLAN causes duplicate data in the CMDB. If network
devices are separated by VLANs, multiple MID Servers may have trap collectors installed.

To configure multiple SNMP trap collector extensions, configure each in a separate record, with a unique name, and a designated MID Server.

**Configure the SNMP Trap Collector Extension**

For the SNMP trap collector extension to receive traps from network devices, each device must designate the MID Server that runs the SNMP trap collector extension as a recipient of the trap.

**Before you begin**
Role required: admin

**Procedure**

1. Navigate to **MID Server > Extensions. > MID SNMP Trap Listener**
2. Click **New** or open an existing extension.
3. Fill in the fields from the table, as appropriate.
4. Click **Submit** or **Update**.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for this SNMP trap collector extension for easy identification.</td>
</tr>
<tr>
<td>Short description</td>
<td>A description of the MID Server extension, if more description than the Name is necessary.</td>
</tr>
<tr>
<td>Extension</td>
<td>[Read-Only] The extension type is automatically set to TrapExtension.</td>
</tr>
</tbody>
</table>
| UDP port      | The port number that your network hardware uses when sending a trap to the designated MID Server. Port numbers 1024 and above are recommended. Port numbers 1023 and lower may
<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Status     | [Read-Only] The status of the trap collector extension. This field is blank until the extension is run. After it is run, the value may be:  
  • **Started**: The extension is running.  
  • **Stopped**: The extension is not running.  
  • **Offline**: The MID Server is down.  
  • **Error**: The extension failed with an error. |
| Execute on | The location for running this extension: a **Specific MID Server** or a **Specific MID Server Cluster**. The recommended setting is **Specific MID Server**. Network hardware typically has to be configured to send to a specific IP address. If the listener moved to a different MID Server in the cluster, the trap would not be received. |
| MID Server | The name of the designated MID Server if you selected **Specific MID Server** in the **Execute on** field. The name of the designated MID Server cluster if you selected **Specific MID Server Cluster** in the **Execute on** field. If you selected **Specific MID Server Cluster**, a ServiceNow algorithm determines which server in the cluster runs the extension. |
| Executing on | [Read-Only] The name of the MID Server on which the extension is running. This field shows the name of the MID Server even if the MID Server is down. If the extension is stopped by the user, this field is empty. |

5. In **Related Links**, run any of the following actions against the SNMP trap collector extension:

<table>
<thead>
<tr>
<th>Related Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Starts the extension if it is currently not running. The extension is started on the configured MID Server and port number.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops the running extension on the configured MID Server. No action is taken if the extension is not running.</td>
</tr>
<tr>
<td>Restart</td>
<td>Stops, then starts the extension on the configured MID Server and port number.</td>
</tr>
<tr>
<td>Related Link</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Test</td>
<td>Verifies that the configured MID Server can run the SNMP trap collector extension on the specified port. Running a test does not affect any extensions that are currently running.</td>
</tr>
<tr>
<td>Update parameters</td>
<td>If you make changes to the extension configuration, use this option to update the parameters of the currently running extension. First, the parameters are tested for validity. If the parameters are valid, the extension disconnects and reconnects with the new parameters.</td>
</tr>
</tbody>
</table>

**MID Server Resource Reservation**

This feature allows resources to be reserved before a task is assigned to a thread. If the resources the task needs aren’t available, then that task waits in the MID Server work queue while other tasks are assigned to the thread.

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

For Discovery, the MID Server tasks are the probes or patterns it executes. While probes are waiting to be executed on the MID Server, they provide resource requirements (CPU, memory, and so on) and if they cannot be met, the probe waits in the work queue until the resources are available.
Note: MID Server Resource Reservation delays probe execution until resources are available. This is based on extremely flexible criteria. The MID Server Resource Reservation feature is for advanced users and should not be configured until a problem is identified. This configuration depends entirely on the problem details.

Using the MID Server Resource Reservation allows for better use of threads since the threads are not assigned a task it cannot complete.

Features:

- Resource reservations apply to a single MID Server only
- Resources can depend on system or MID Server properties
- Resources can depend on probe parameters, allowing you to limit the number of active probes and patterns against a given IP
- Reports resource usage
- Extensible (the customer defines their own resources)
- Scriptable

Benefits:

- Keeps PowerShell probes from impacting execution of other probes
- Can be used to limit the impact Discovery has on a target system
- Can be used to limit the number of "large" probes being executed by a MID Server at the same time
- Can be used to throttle Discovery (to minimize impact on the instance)

Use MID Server Resource Reservation

A resource is just a name and a count. Define the name of the resource, which probes use it, and how many of the resources those probes should use.

Before you begin

Role required: admin

- Make sure the MID Server property `mid.probe.wait.resources` is set to true to enable MID Server Resource Reservation. Changing this property requires restarting the MID Server.
- Choose a resource name. Anything in `{ }` in the name is replaced by the probe parameter with that name. This name is typically used for per-host resources, for example, `ssh{source}` means a separate resource named “ssh” is available on every host being discovered. (“source” is the name of the probe parameter that contains the IP address being probed.)
• Decide how to specify the number of the resource used by probes or patterns.
  ◦ Every probe uses a constant number of the resource: Create a "simple value" resource.
  ◦ The number of resources used depends on a system property: Create an "expanding" resource.
  ◦ The number depends on multiple factors: Create a "scripted" resource.
  ◦ Expanding: Anything in {} is replaced by the system or MID Server property with that name. Logical operators are allowed, for example, 
    `{mid.windows.management_protocol}`.toLowerCase() == "winrm" ? 1:0
  ◦ Scripted: the script is evaluated. The return value is expanded.

Procedure

1. Create a new resource.
   a. Navigate to Discovery Definition > Limited Resources > Simple Value and click New.
   b. Enter a resource name.
   c. Enter the number of resources used. Click Save.

2. Define which probes use the resource. Navigate to the desired tab and select from the list.
   • Used by Topic tab: Includes all probes with that topic. Click Invert Topic to include all probes without that topic. For example: SSHCommand with Invert Topic, means all probes except for SSH. Heartbeat and queue messages are always excluded.
   • Used by probes tab: Includes a list of probes. Click Invert Probes List to include all probes without that probe. Horizontal Discovery probe means apply to all patterns.
   • Used by patterns tab: Includes a list of patterns. You can also click Invert Pattern list.

3. Define availability on the MID Server. Navigate to Discovery Definition > Limited Resources > MID Resources.
   • Resource: This is the reference to the resource.
   • Available: Number available. Anything inside brackets, is replaced by the system or MID Server property.
   • MID Server: MID Server to apply this to. (Empty) means all.

4. Set the resource order.
a. Click in the **Order** field of each resource.

b. Type in the number.

c. Click the check mark to Save.

**Note:** Less valuable resources should have a lower order – these resources are reserved and held until higher order resources can be obtained. For example, both the total PowerShell sessions (resource is “PowerShell”) and the number of simultaneous sessions to any host (resource is “PowerShell{host}”) are limited. Therefore, PowerShell{host} resource should have a lower order. Obtaining PowerShell first would impact all other PowerShell probes. Obtaining “PowerShell{host}” first only impacts other PowerShell probes to that host.

5. Review the Resource State that you have set up.

a. Run a Discovery.

b. Observe Resource State. Click **Get resource state** from the MID Server page or view in an ECC input payload.

Result of Get resource state:

- PowerShell{source} has additional entries for every {source} with a current allocation.
- “Reserved by” may show multiple resources if the probe requires more than one resource.

Result of ECC input payload:

- resource_wait attribute only exists if the probe had to wait for a resource.
- The time displayed is in milliseconds.
- The probe may have waited on multiple resources, with different wait time for each.

**How MID Server Resource Reservation works**

In addition to the work queue, the MID Server contains a waiting queue. When picking a task for execution, the waiting queue is always checked first. If no task in the waiting queue can execute, then the work queue is tried. Probes and patterns in the waiting queue reserve all necessary resources until they’re able to execute.

The first probe or pattern in the queue is offered available resources. It takes any of the lowest order resource that is available. After getting the required number of lowest order resources, the probe or pattern goes to the next lowest order.
resources, and so on. The order allows the user to configure which resources are more or less important. Lowest order resources are gathered first because holding these resources has less impact on execution of other probes and patterns.

**Tables**

**mid_limited_resource**
- Defines the resources used by a probe or pattern.
- Extended by `mid_limited_resource_value`, `mid_limited_resource_expanded`, and `mid_limited_resource_script` each containing a single additional field.
  - `mid_limited_resource_value` adds a single field named “value” to the base table.
  - `mid_limited_resource_expanding` adds a field named “expanding.”
  - `mid_limited_resource_script` adds a field named “script”.

**mid_resource**
- Sets the resources available on a MID Server.
- Values from this table are copied to `ecc_agent_property`.
- A business rule on this table creates the corresponding MID Server properties.
- It has a reference to a resource and the number available. If the number available is inside `{ }` then it’s the name of a system property, MID Server config, or MID Server property (all three places are checked). So `{mid.powershell_api.session_pool.max_size}` is the value of that MID Server config that sets the size of the PowerShell session pool.

**Base: mid_limited_resource table**

<table>
<thead>
<tr>
<th>Label</th>
<th>Column</th>
<th>Type</th>
<th>Size</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Name</td>
<td>name</td>
<td>String</td>
<td>100</td>
<td>Unexpanded name of the resource</td>
</tr>
<tr>
<td>Active</td>
<td>active</td>
<td>Boolean</td>
<td></td>
<td>Allows temporary disable</td>
</tr>
<tr>
<td>Invert Topic</td>
<td>invert_topic</td>
<td>Boolean</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Invert Probe List</td>
<td>invert_probe_list</td>
<td>Boolean</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Base: mid_limited_resource table (continued)

<table>
<thead>
<tr>
<th>Label</th>
<th>Column</th>
<th>Type</th>
<th>Size</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invert Pattern</td>
<td>invert_pattern_list</td>
<td>Boolean</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** There are m2m tables that associate a mid_limited_resource record with topics, probes, and patterns. The “invert_” fields change the list from inclusion to exclusion.

### Extensions: mid_limited_resource_value, mid_limited_resource_expanding, and mid_limited_resource_script tables

<table>
<thead>
<tr>
<th>Label</th>
<th>Column</th>
<th>Type</th>
<th>Size</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>value</td>
<td>Integer</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Expanding   | expanding | String   | 1000  | A slightly extended version of the availability number because it accepts logical and ternary operations, for example, 
  
  `{mid.windows.management_protocol} == "WinRM" ? 1 : 0. If the management protocol is WinRM this evaluates to 1, otherwise it’s 0. |
| Script      | script    | String   | 4000  | The script is evaluated. If the result is a string, then it’s expanded      |
### mid_resource table

<table>
<thead>
<tr>
<th>Label</th>
<th>Column</th>
<th>Type</th>
<th>Size</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>active</td>
<td>Boolean</td>
<td></td>
<td>Allows temporary disable</td>
</tr>
<tr>
<td>Available</td>
<td>available</td>
<td>String</td>
<td>255</td>
<td>Number of this resource available on MID Server</td>
</tr>
<tr>
<td>MID Server</td>
<td>ecc_egent</td>
<td>Reference</td>
<td></td>
<td>Reference to MID Server or empty for all</td>
</tr>
<tr>
<td>Order</td>
<td>order</td>
<td>Integer</td>
<td></td>
<td>Order in which resources are allocated</td>
</tr>
<tr>
<td>Resource</td>
<td>resource</td>
<td>Reference</td>
<td></td>
<td>Reference to the resource</td>
</tr>
</tbody>
</table>

### Containerized MID Server

Containerized MID Server uses a Docker image of the MID Server that allows you to quickly deploy MID Servers at scale. MID Servers are deployed using orchestration tools like Docker Swarm, Kubernetes or OpenShift. Orchestration tools can automate their deployment and maintenance and add new containers on demand or replace failed containers automatically.
To use Containerized MID Servers, you can download Docker recipes for Windows and Linux from the MID Server download page. Use the recipes to build the Docker images for the current release. The recipes are zipped and signed.

**Containerized MID Server system requirements**

- CentOS 7 and Windows Server 2019 are supported.
- The recipes cannot be used to build images for previous MID Server versions.
• Discovery of NMAP and CyberArk are not supported.

• Other applications such as Orchestration and Integration Hub are not certified.

Once the Docker images are available, you can create new MID Server containers and configure them with configuration parameters passed through environment variables or secret files. Docker and Kubernetes secrets are supported. The MID Server application inside the container is run as a process by a non-admin user.

When a containerized MID Server record is first created on the instance, a random UUID is created and set to the `container_id` column. During the start-up sequence, this value is replaced by the actual container ID. The container ID can be used to differentiate between containerized and regular MID Servers. Non-containerized MID Servers’ container ID have a null or empty value.

In order to automatically clean up the down MID Servers on Instance, a scheduled job called Purge Orphaned Containerized MID Servers is scheduled to run daily. This job removes orphaned containerized MID Servers if they are down longer than the value set by the `max_retention_days` property. The job also creates a warning MID Server issue each day before the removal day, if there are equal to or less than the value of `warn_days` remaining. The default values for `max_retention_days` and `warn_days` are 30 and 7, respectively.

**Auto-upgrade**

Auto-upgrade works the same way for containerized MID Servers as it does for regular MID Servers.

**HealthCheck**

A HEALTHCHECK rule is implemented to check MID Server health status based on heartbeat every 5 minutes. If there was no heartbeat activity in last 30 minutes, it is considered a failure. After 3 consecutive failures, it becomes unhealthy in the `docker ps` command output.

To see more HealthCheck details, run the following `docker inspect` command:

```
docker inspect --format='{{json .State.Health}}' <container-id>
```

**Basic Container Operations**

Basic operations are supported on container side. For example, you can stop, start, or restart a running container using Docker commands.

```
docker stop <container_id>
```

This command shuts down the containerized MID Server.
docker start <container_id>
This command starts a containerized MID Server if it is stopped.

docker restart <container_id>
This command shuts down a MID Server and restarts it.

Build MID Server Docker Image for Windows

Deploy Containerized MID Servers on Windows by creating a Docker image with the provided recipes. Containerized MID Server uses a Docker image of the MID Server that allows you to quickly deploy MID Servers at scale.

Before you begin
Role required: admin

Prerequisites

- Windows hosts must use Windows Server 2019, 64 bit architecture.
- The host must use Docker engine and command-line interface (CLI) 20.10.4 or later.

Note: Check docker availability by running the docker version command as administrator. See the docker version command documentation for more information.

Procedure

1. Download the Windows Docker recipe ZIP file from the MID Server download page and verify its signature.
   For more information about the MID Server download page and signature verification, see Download MID Server files.
2. Unzip the ZIP file to a folder.
3. Optional: You can change the current directory to the new folder.
4. To build an image, run the build command: docker build <path-to-docker-recipe> [--tag <docker-tag>]
   For more information on the build command, see the Docker build command documentation. The path to the docker recipe can be a relative path or simply a dot (.) if the recipe folder is the current directory. Setting an image tag is optional but recommended. The default tag is provided in the .env file in the recipe folder. Use the ‘type’ command to get the value (without DOCKER_TAG=) and replace the <docker-tag> placeholder in the command above.
The build command takes the following build arguments:

**MID_INSTALLATION_URL**

This parameter gives the link to download the MID installation file. By default, it is set to the download link for the Windows 64 bit Installation ZIP file provided on the MID Server download page.

**MID_INSTALLATION_FILE**

This parameter gives the name of a local MID installation file. The default value is empty. If this parameter is not empty, the recipe will use the local file instead of downloading from remote. Please note that this parameter is supposed to give the file name only, not the full path. Before the build, the local file needs to be copied to the asset subfolder of the recipe folder.

**MID_SIGNATURE_VERIFICATION**

This parameter specifies whether the signature of the MID installation file must be verified. The default value is TRUE. If it is TRUE, the build process always verifies the digital signature of the MID installation file whether it is downloaded from remote or a local file.

**Note:** To use a different build argument value than the default, you can add the `--build-arg` option to the build command. The resulting image may not work if the build parameters are changed for a non-default MID Server version. Windows MID versions before Rome release are not supported. Also note that the recipes only work with the MID Server installation ZIP files.

5. To see a list of available images, run the `docker image ls` command:

```
   docker image ls
```

For more information, see the `docker image ls` command documentation.

**Build MID Server Docker Image for Linux**

Deploy Containerized MID Servers on Linux by creating a Docker image with the provided recipes. Containerized MID Server uses a Docker image of the MID Server that allows you to quickly deploy MID Servers at scale.

**Before you begin**

Role required: admin

**Prerequisites**
• Linux hosts must use CentOS distribution 64 bit architecture, and CentOS distro is recommended.

• The host must use Docker engine and command-line interface (CLI) 20.10.4 or later.

Note: Check docker availability by running the docker version command as administrator. See the docker version command documentation for more information.

Procedure
1. Download the Linux Docker recipe ZIP file from the MID Server download page and verify its signature. For more information about the MID Server download page and signature verification, see Download MID Server files.

2. Unzip the ZIP file to a folder.

3. Optional: You can change the current directory to the new folder.

4. To build an image, run the build command: > docker build <path-to-docker-recipe> [ --tag <docker-tag> ]

For more information on the command, see the Docker build command documentation. The path to the Docker file can be a relative path or the current directory if the file is in the Docker recipe directory.

The default image tag is provided out-of-the-box in the .env file with the DOCKER_TAG parameter. You can export this parameter before executing any docker command by running the command: > export $(grep DOCKER_TAG .env). You can replace <docker-tag> with the DOCKER_TAG value in all the following commands.

The build command takes the following build arguments:

**MID_INSTALLATION_URL**

This parameter gives the link to download the MID installation file. By default, it is set to the download link for the Linux 64 bit Installation ZIP file provided on the MID Server download page.

**MID_INSTALLATION_FILE**

This parameter gives the name of a local MID Server installation file. The default value is empty. If this parameter is not empty, the recipe uses the local file instead of downloading from the installation server. This parameter uses the file name only, not the full path. Before the build, the local file must be copied to the
mid_installation_file=<mid.installation.file.name>) --tag <docker-tag>

MID_SIGNATURE_VERIFICATION

This parameter specifies whether the signature of the MID Server installation file must be verified. The default value is TRUE. If it is TRUE, the build process always verifies the digital signature of the MID Server installation file whether it is downloaded from the remote server or a local file. Otherwise, the signature verification will be skipped.

For example: > docker build <path-to-dockerfile> --build-arg MID_SIGNATURE_VERIFICATION=false --tag <docker-tag>

USER_ID and GROUP_ID

These two parameters run the containerized MID Server as current host user. By default, when no user is specified, Docker creates a MID Server user with user id = 1001 and group id = 1001. You may assign a host user by passing its user id and group id into container by using the USER_ID and GROUP_ID build arguments. Docker creates a container user for the MID Server with the provided user id and group id. Any files generated by the container MID Server are owned by this host user.

For example: > docker build <path-to-dockerfile> --build-arg USER_ID=1234 --build-arg GROUP_ID=1234 --tag <docker-tag>

5. Optional: After the image is built successfully, you can list the image built with command: > docker image ls

Launch Containerized MID Server

Containerized MID Server uses a Docker image of the MID Server that allows you to quickly deploy MID Servers at scale. MID Servers are deployed using orchestration tools like Docker Swarm, Kubernetes or OpenShift.

Before you begin
Role required: admin

Prerequisites
• Windows hosts must use Windows Server 2019, 64 bit architecture.

• Linux hosts must use CentOS distribution 64 bit architecture, and CentOS distro is recommended.

• The host must use Docker engine and command-line interface (CLI) 20.10.4 or later.

**Note:** Check docker availability by running the `docker version` command as administrator. See the the `docker version` command documentation for more information.

**Procedure**

1. Once the image is available, launch the new MID Server using the `docker run` command and specify an env file or env variable options: `docker run --env-file <env_file_name_here> <docker_tag_or_image_id>

**Note:** Do not pass sensitive data using this command, as there may be security vulnerabilities. To pass sensitive data, use the procedures Pass sensitive data to a containerized MID Server with Docker Secrets and Pass sensitive data to a containerized MID Server with Kubernetes Secrets.

For more information, see the Docker documentation pages for the `docker image ls` command, the `docker run` command, and specifying an env file or env variable options. The env file is a simple text file using the name=value format. If a variable is specified in both env file and in the `--env` option, the variable defined in the command line takes precedence.

When the container is first started, the initialization script will take the environment variables and configure the MID Server application using the following environment variables:

**MID_INSTANCE_URL**
This variable sets the 'url' config parameter.

**MID_INSTANCE_USERNAME**
This variable sets the 'mid.instance.username' config parameter.

**MID_INSTANCE_PASSWORD**
This variable sets the 'mid.instance.password' config parameter.

**MID_SERVER_NAME**
This variable sets the 'name' config parameter.
**MID_PROXY_HOST**

This variable sets the 'mid.proxy.host' config parameter. This variable is not mandatory and is only necessary when a proxy is set up.

**MID_PROXY_PORT**

This variable sets the 'mid.proxy.port' config parameter.

**MID_PROXY_USERNAME**

This variable sets the 'mid.proxy.username' config parameter.

**MID_PROXY_PASSWORD**

This variable sets the 'mid.proxy.password' config parameter.

**MID_SECRETS_FILE**

This variable specifies the full secret filename that contains sensitive data like passwords or certificate.

**MID_MUTUAL_AUTH_PEM_FILE**

This variable specifies the full filename of the client certificate file used for auto validation setup.

2. **Optional:** To see a list of containers, run the docker container ls command:

```
docker container ls [-a]
```

Pass sensitive data to a containerized MID Server with Docker Secrets

You can configure containerized MID Servers with configuration parameters passed through environment variables or secret files.

**Before you begin**

Role required: admin

**About this task**

You can pass sensitive data, such as passwords or certificates, into a containerized MID Server using Docker Secret. Setup and start Docker Swarm before using this procedure.

If certificate based authentication is enabled on the instance, the MID Server can be configured to auto-validate using a mutual authentication client certificate (PEM file). This can be done via setting the full path to the PEM certificate file inside container with the `MID_MUTUAL_AUTH_PEM_FILE` environment variable. For example, you can update variable to `MID_MUTUAL_AUTH_PEM_FILE= /run/secrets/certificate.pem` in the `mid.env` file.

You can pass the PEM certificate file into a container using Docker or Kubernetes secret. The following is an example command to pass the PEM...
certificate file into a container: `docker service create --name mid-service --secret mid-secrets.properties --secret <certificate-secret-name> --env-file mid.env <docker-tag or image-id>

When creating deployments, ensure that the replicas are kept to 1.

The mutual PEM certificate is installed on the MID Server during initialization. MID Server then connects to the instance and auto-validates. When the MID Server connects to the instance with mutual authentication successfully enabled, you might observe some of the following entries in the MID agent log:

• Installed custom certificate into the MID keystore
• Configured MID to use mutual authentication

Procedure

1. Place the sensitive data in `mid-secrets.properties`

2. Create a docker secret using the docker secret create command: `docker secret create mid-secrets.properties mid-secrets.properties`  
   The first `mid-secrets.properties` represents the secret file inside the container, while the second `mid-secrets.properties` parameter represents the file path to read the secret on the host machine's filesystem. You can list all created secrets by running the command `docker secret ls`.  
   For more information on the docker secret command, see the docker secret documentation.

3. Update the `MID_SECRETS_FILE` environment variable with the path to the secret file inside the container.  
   The default path for Docker Swarm secrets on Linux is `/run/secrets/mid-secrets.properties`. On Windows the default path is `C:\ProgramData\Docker\secrets\mid-secrets.properties`.

4. Deploy the MID Server Image Container to Swarm using the docker service create command: `docker service create --name mid-service --secret mid-secrets.properties --env-file mid.env <docker-tag or image-id>`  
   Make sure that the `--secret` flag is provided for the container service to associate with the specified secrets.

Pass sensitive data to a containerized MID Server with Kubernetes Secrets

You can configure containerized MID Servers with configuration parameters passed through environment variables or secret files.
Before you begin
Role required: admin

Prerequisites:
Setup and start Kubernetes cluster before using this procedure. For more information on Kubernetes Secrets, see the Kubernetes secrets documentation.

Note: Kubernetes doesn’t work directly with a local image. Upload the MID Server image to a public registry or setup a local registry. See the official Docker instruction on building a docker registry.

If certificate based authentication is enabled on the instance, the MID Server can be configured to auto-validate using a mutual authentication client certificate (PEM file). This can be done via setting the full path to the PEM certificate file inside container with the MID_MUTUAL_AUTH_PEM_FILE environment variable. For example, you can update variable to MID_MUTUAL_AUTH_PEM_FILE= /run/secrets/certificate.pem in the mid.env file.

You can pass the PEM certificate file into a container using Docker or Kubernetes secret. The following is an example command to pass the PEM certificate file into a container: docker service create --name mid-service --secret mid-secrets.properties --secret <certificate-secret-name> --env-file mid.env <docker-tag or image-id>

When creating deployments, ensure that the replicas are kept to 1.

The mutual PEM certificate is installed on the MID Server during initialization. MID Server then connects to the instance and auto-validates. When the MID Server connects to the instance with mutual authentication successfully enabled, you might observe some of the following entries in the MID agent log:

- Installed custom certificate into the MID keystore
- Configured MID to use mutual authentication

Procedure
1. Place the sensitive data in mid-secrets.properties accordingly.
2. Create a Kubernetes secret with the command: kubectl create secret generic mid-secret --from-file=mid-secrets.properties
3. Optional: You can list all created secrets by running the command: kubectl get secrets
4. Update the MID_SECRET_FILE environment variable with the path to the secret file inside container.
The path is defined in data field when creating a configuration file for a Secret.

5. Create a deployment with the following sample YML content:

```yaml
apiVersion: apps/v1
kind: Deployment
metadata:
  name: mid-deployment
spec:
  selector:
    matchLabels:
      app: mid
  replicas: 1
template:
  metadata:
    labels:
      app: mid
      name: mid
spec:
  containers:
  - name: mid-service
    imagePullPolicy: Retry
    image: <image tag>
    volumeMounts:
    - name: mymount
      mountPath: "/etc/secret"
      readOnly: true
    env:
    - name: MID_INSTANCE_URL
      value: ""
    - name: MID_INSTANCE_USERNAME
      value: ""
    - name: MID_INSTANCE_PASSWORD
      value: ""
    - name: MID_SECRETS_FILE
      value: "/etc/secret/mid-secrets.properties"
    - name: MID_SERVER_NAME
      value: ""
    - name: MID_PROXY_HOST
      value: ""
    - name: MID_PROXY_PORT
      value: ""
    - name: MID_PROXY_USERNAME
      value: ""
```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
- name: MID_PROXY_PASSWORD
  value: ""
- name: MID_MUTUAL_AUTH_PEM_FILE
  value: ""

volumes:
- name: mymount
  secret:
  secretName: mid-secret

**Note:** There are many ways to create a deployment or pod. For more information, see the Kubernetes deployment instructions.

6. Deploy the containerized MID Server to the pod with the deployment.yml and run the command: `kubectl create -f deployment.yml`

**Securing and encrypting MID Server data**

After configuring your MID Server, you can add security by encrypting MID Server parameter values in the `config.xml` file. Encryption protects data that the MID Server returns to the ECC Queue. Other available security options include the authorization of SOAP requests, restricting access to the MID Server configuration file, and establishing secure socket layer (SSL) connections.

1. **Ensure that the MID Server can connect to elements inside and outside your network**

2. **Download and install the MID Server on a Linux or Windows host**

3. **Configure your MID Server**

4. **Configure MID Server security**

5. **Ensure that the MID Server can connect to elements inside and outside your network**

6. **Download and install the MID Server on a Linux or Windows host**

7. **Configure your MID Server**

8. **Configure MID Server security**
How MID Server password encryption works

The **username** and **password** are initially set in the `config.xml` file on the MID Server. When the MID Server retrieves the credentials, it replaces the clear-text password with an encrypted password automatically, using an AES128 encryption algorithm. In continued efforts to improve MID Server security, the encryption algorithm has been enhanced. The MID Server also maintains an encryption key that is generated each time it starts and remains in memory and not on the hard disk. When credentials need to be sent from the instance to the MID Server, the following process takes place:

1. The instance retrieves the encrypted **password** and the unencrypted **username** from the instance database table.

2. The instance decrypts the encrypted **password**, and then re-encrypts it using the MID Server encryption key.

3. The **username** and re-encrypted **password** are sent to the MID Server through the encrypted TLS session was already established between the MID server and the instance.

4. The MID Server receives the credentials and decrypts the **password** in memory before using the credentials for remote operations. At no point is the credential password stored on the disk in an unencrypted format.

| Note: | In the Orlando release, the MID Server requires a minimum JRE version 1.8.0_161, and recommended version 1.8.0_181. If you are using a lower version than 1.8.0_161, you may see encryption related issues. |

**Security options**

The MID Server provides built-in security options for other content in the configuration file, such as the default encryptor, Windows Data Protection API, and options for custom encryption.

**MID Server certificate check policies**

Control the MID Server with the certificate check policies table to secure external traffic.

**Encrypt or decrypt MID Server configuration file values**

You can encrypt and decrypt any value in the MID Server `config.xml` file.

**ECC queue data encryption with the automation API**

Use the automation API to encrypt sensitive probe data that is sent from an instance to the MID Server through the ECC Queue.

**MID Server configuration file security**
Protect sensitive MID Server configuration data in the config.xml file using internal and external data encryption and external data storage.

**MID Server authentication credentials and SOAP requests**

Set basic authentication credentials to update the web service invocation data and enforce basic authentication on each incoming SOAP request to the MID Server.

**MID Server unified key store**

The MID Server unified key store allows all products on the MID Server to use a common certificates and key pairs.

**MID Server command audit log**

The command audit log records the commands run by the MID Server for the Discovery application.

**Rekey a MID Server**

Rekey a MID Server to force it to restart and generate a new private key. Typically, this process is only necessary if the MID Server keystore is compromised.

**Add SSL certificates for the MID Server**

Add certificates to the MID Server to communicate over SSL.

**MID Server SSH cryptographic algorithms**

The MID Server utilizes SSH clients to perform many discovery actions. The MID Server automatically determines the best cryptographic algorithm to use.

**MID Server authentication credentials and SOAP requests**

For added security, enforce basic authentication on each incoming SOAP request to the MID Server.

**Attach a script file to a file synchronized MID Server**

Attach a script file and synchronize it to a MID Server to prevent Windows enhanced security from blocking MID Server download files it determines are dangerous.

**MID Server certificate check policies**

MID Server uses three kinds of security checks to secure external traffic. The security checks use TLS/SSL certificate validation, hostname validation, and OCSP validation to improve security. Control these security checks with the MID Server certificate check policies table.
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

**TLS/SSL certificate validation**

TLS/SSL encryption security uses asymmetric encryption, also called public-key encryption. This encryption uses two cryptographic keys: the public key and the private key. The public key is used for encryption of data and is publicly visible. The private key is used for decryption of data and its security is essential to verifying authenticity. For more information about preparing your network, see MID Server TLS/SSL certificate check policy Quebec upgrade information [KB0867397].

In TLS/SSL certificate validation, the MID Server attempts to connect to a web server secured with a TLS or SSL certificate. The web server sends a copy of its TLS/SSL certificate to the MID Server. The MID Server checks the authenticity of the certificate and sends a message to the webserver. The webserver responds with a digitally signed acceptance for initiating an TLS/SSL encrypted session. After which the MID Server can begin encrypted communication with the web server.

**Hostname validation**

Hostname verification is a part of HTTPS that involves a server identity check to ensure that the client is talking to the correct server. This check prevents sending information to a server after being redirected by a man in the middle attack.
The check involves verifying that the `dnsName` of the certificate sent by the server matches the URL used to make the request. According to RFC 6125, hostname verification should be done against the certificate's `subjectAlternativeName`'s `dNSName` field. In some legacy implementations, the check is done against the certificate's `commonName` field. If the names don't match, the connection is terminated.

**Note:** Hostname validation derives the hostname from the validated certificate presented by the server. Therefore, TLS certificate validation is a pre-requisite for hostname validation.

**Online Certificate Status Protocol (OCSP)**

OCSP involves contacting the remote certificate authority server and verifying the certificate before the MID Server communicates further with the target server. Compromised certificates can be a security vulnerability, especially if those certificates have the ability to sign other certificates. If certificates have been broken or forged, then a certificate authority can inform a client which certificates are invalid and should not be used.

An OCSP responder (a server typically run by the certificate issuer) returns a signed response that the certificate is 'good', 'revoked', or 'unknown'. If it cannot process the request, it may return an error code.

The certificate's issuer may delegate another authority to be the OCSP responder. This creates a chain of certificates that must be verified. The responder's certificate must be issued by the issuer of the certificate in question. The responder's certificate must include a certain extension that marks it as an OCSP signing authority.

**Note:** OCSP checks are secondary HTTP calls made to an OCSP responder. The primary call may discontinue the connection based on the response from the OCSP responder.

**MID Server security policy**

MID Server security policies control all HTTPS traffic originating from the MID Server. This includes HTTPS connections from the MID Server to an internet endpoint, ServiceNow URLs, intranet endpoints, as well as cloud endpoints.
These connections can be further classified into 4 security policies:

**ServiceNow endpoint policy**

This policy is the system default exclusively for ServiceNow URLs. On the MID Server `config.xml`, there are bootstrap properties which are only used to make first connection to the instance and will get updated with the `system_default` policy.

**Internet policy**

These policies cover all HTTPS connections initiated from MID Server to any endpoint on the internet.

**Intranet policy**

These policies cover the reserved IP subnets, such as self-hosted networks.

**Overridden policy**

You can override specific endpoints or URLs with this policy definition. Overridden policies take the highest order of precedence during operation.

Both tables are editable to include or exclude IP ranges, as well as control what kind of certificate validation checks need to be done. Enable all certificate validation checks to maximize security. The Quebec version has all policies and checks turned on by default for fresh installations.

For upgrading customers, the intranet policy has the certificate validation checks disabled by default. To improve security, configure and enable the policy for endpoints within the internal network.

Note: Internal endpoints or URLs need to possess a valid CA signed certificate for a successful connection.

For endpoints that host a self-signed certificate, either import the certificate to the MID Server truststore or disable the policy checks which validate that host.
For more information about adding certificates, see Add SSL certificates for the MID Server.

After upgrading to Quebec, go to the certificate check policies table and make changes to policy configuration if necessary. Once the MID Server starts up and connects to the instance, any subsequent HTTPS connection originating from the MID server will start applying these certificate checks at runtime. Insecure connections are broken with appropriate error messages.

Encrypt or decrypt MID Server configuration file values

The value of any MID Server parameter in the `config.xml` file can be encrypted. The attributes for all encrypted values are managed from within the configuration file, including the security attribute of the login password.

**Before you begin**

Role required: admin

---

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

---

**Procedure**

1. Navigate to the `agent` directory that was created when the MID Server was installed and open the `config.xml` file using a text editor such as WordPad.

2. Locate or add the parameter you want to encrypt.
   
   For example, you might want to protect your proxy server passwords by configuring this parameter:
3. Add the encryption attribute `secure="true"`.

```xml
<parameter name="mid.proxy.password" secure="true" value="securepassw0rd"/>
```

4. Restart the MID Server.

5. Open the `config.xml` file. The encrypted password appears as follows:

```xml
<parameter name="mid.proxy.password" secure="true" value="encrypted:rhrfUNYRzZAI8/BkTtZmNA=="/>
```

6. To decrypt this or any other value in the `config.xml` file and display the value in clear text:
   a. Stop the MID Server.
   b. Set the `secure="true"` attribute to `false`.
   c. Replace the encrypted value with the clear text value.
   d. Restart the MID Server.

**ECC queue data encryption with the automation API**

The automation API encrypts sensitive probe data that is sent from an instance to the MID Server through the ECC Queue.
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

You can use the automation API to encrypt data that you send from a custom application to the ECC queue and prevent that data from appearing in clear text. For example, you can encrypt a password used by a MID Server to authenticate on a REST endpoint.

**Methods**

The API provides these methods:

- `encrypt()`
- `isEncrypted()`

The following example shows how you might call these methods:

```javascript
var automation_api = new sn_automation.AutomationAPI();
var password = 'xyz';
var encrypted_password;
if (automation_api.isEncrypted(password))
    encrypted_password = password;
else
    encrypted_password = automation_api.encrypt(password);
```

The `encrypted_password` value can then be passed safely to the ECC Queue and on to the desired MID Server.
MID Server configuration file security

Sensitive MID Server configuration data can be protected using several different schemes, including internal and external data encryption and external data storage.

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

The MID Server provides the following built-in security options for content in the config.xml file:

- **Default security provider**: Secures the data in the config.xml file by encryption. When the MID Server is restarted, any unencrypted data is encrypted and written to the config.xml file. The default security provider offers these encryption options:
  - **Default encryptor**: Default process for encrypting data in the MID Server config.xml file. See Encrypt or decrypt MID Server configuration file values for details.
  - **Windows Data Protection API (DPAPI)**: The operating system performs the data encryption, rather than the MID Server. DPAPI encryption is based on the logged in user's account. When this scheme is used, the data can only be decrypted by the same user account. If the account changes, the data must be re-encrypted.
  - **Custom encryption**: Implement the IMidServerEncrypter interface to create your own custom encryption scheme to manage sensitive config.xml data.
**CyberArk**: Data security is provided by CyberArk’s Privileged Account Security system, which moves sensitive data from the `config.xml` file to a secure CyberArk vault. This solution does not encrypt the data.

**Custom external storage**: Implement the `ISecuredConfigProvider` interface to create your own custom external storage system to manage sensitive `config.xml` data.

### Secured content and encryption schemes

![Diagram showing encryption schemes]

**Encrypt MID Server configuration data with DPAPI**

Windows Data Protection API (DPAPI) encrypts sensitive data from the `config.xml` file, based on the MID Server user account.

**Before you begin**

Role required: admin

**About this task**

DPAPI encryption provides another level of security for data such as credentials, IP addresses, and URLs in the MID Server `config.xml` file. The operating system performs the data encryption, rather than the MID Server. DPAPI encryption is based on the logged in user's account. When this scheme is used, the data can...
only be decrypted by the same user account. If the account changes, the data must be re-encrypted.

**Procedure**

1. Open the `config.xml` file in a text editor. This file is located in the `/agent` folder in your MID Server installation path.
2. Enable this parameter and value:
   ```xml
   <parameter name="mid.secure_encrypter" value="com.service_now.mid.services.config.WindowsDPAPIEncrypter"/>
   ```
3. Save the configuration file.
4. Restart the MID Server. Any values in clear text in the `config.xml` file are encrypted by the operating system.
5. Follow this procedure if you need to change the MID Server user account that is used for encryption.
   a. Stop the MID Server service.
   b. Open the `config.xml` file in a text editor. This file is located in the `/agent` folder in your MID Server installation path.
   c. Re-enter all the encrypted values in clear text.
   d. Make the changes to the MID Server user account in the ServiceNow® instance.
   e. Restart the MID Server service. The data is re-encrypted by the operating system, based the new MID Server user account.

**Use CyberArk as a secure configuration provider**

You can use a CyberArk vault to secure any sensitive data from the MID Server `config.xml` file.

**Before you begin**
Role required: admin
About this task
CyberArk is commonly used to secure credentials in its external vault. However, a MID Server parameter in the config.xml file enables you to store other types of data in CyberArk.

Procedure
1. Open the config.xml file in a text editor. This file is located in the /agent folder in your MID Server installation path.
2. Enable this parameter and value:
   ```xml
   <parameter name="mid.secure_config.provider" value="com.service_now.mid.services.config.CyberArkSecuredConfigProvider"/>
   ```
3. Configure specific data to secure in the CyberArk vault, as shown in these examples.
   a. Secure the MID Server credentials by setting this parameter to match the ID and Type for that data in your CyberArk configuration.
      ```xml
      <parameter name="mid.instance.username" secure="true" value="cyberark: id=<CyberArk ID>, type=<CyberArk type>"/>
      <parameter name="mid.instance.password" secure="true" value="cyberark: id=<CyberArk ID>, type=<CyberArk type>"/>
      ```
   b. Secure the URL of the instance by setting this parameter to match the ID and Type for that data in your CyberArk configuration.
      ```xml
      <parameter name="url" secure="true" value="cyberark: id=<CyberArk ID>, type=<CyberArk type>"/>
      ```
4. Save the configuration file.
5. Restart the MID Server.

Change MID Server configuration file security schemes
The MID Server provides several schemes for securing sensitive data in the config.xml file and allows you to switch between these options to suit your security requirements.

Before you begin
Role required: admin

Procedure
1. Stop the MID Server service.
2. Open the config.xml file in a text editor.
This file is located in the /agent folder in your MID Server installation path.

3. Re-enter all the encrypted values in clear text.

4. Disable the previous security scheme and configure the MID Server to use the new provider.

5. Restart the MID Server service.
   The data is re-secured or encrypted, based on the security scheme you have selected.

**MID Server ISecuredConfigProvider interface**

Use the methods in this interface to create custom providers that manage secured parameter values in the MID Server config.xml file.

*Note:* These methods are contained in the snc-automation-api.jar file, located in the MID Server installation folder.

**initialize**

This method initializes the provider with additional configuration parameters and does not return a value.

**Example**

```java
void initialize(java.util.Properties properties,
   IMidServerEncrypter encrypter)
   throws java.lang.Exception
```

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>properties</td>
<td>Initialization properties.</td>
</tr>
<tr>
<td>encrypter</td>
<td>Encrypter to use if the provider is encryption based.</td>
</tr>
</tbody>
</table>

**Exception**

`java.lang.Exception`
**isParameterValueSecured**
This method checks to see if the parameter value has been secured or not. This method returns a **boolean** type value.

**Example**

```java
boolean isParameterValueSecured(java.lang.String paramValue)
```

**Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>paramValue</td>
<td>The parameter value.</td>
</tr>
</tbody>
</table>

**Returns**

The parameter returns **true** if the parameter value is secured.

**secureParameterValue**
This method secures the parameter value if it has not been secured. This method returns a **string** type value.

**Example**

```java
java.lang.String secureParameterValue(java.lang.String unsecuredParameterValue)
    throws java.lang.Exception
```

**Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>unsecuredParameterValue</td>
<td>The unsecured parameter value.</td>
</tr>
</tbody>
</table>

**Returns**

This method returns the unsecured parameter value.
**Exception**

java.lang.Exception

**unsecuredParameterValue**
This method returns the unsecured value of the parameter. This method returns a **string** type value.

**Example**

```java
java.lang.String unsecuredParameterValue(java.lang.String parameterName)
    throws java.lang.Exception
```

**Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>parameterName</td>
<td>The parameter name.</td>
</tr>
</tbody>
</table>

**Returns**

This parameter returns the unsecured value.

**Exception**

java.lang.Exception

**MID Server IMidServerEncrypter interface**

Use the methods in this interface to create a custom external encrypter for the MID Server `config.xml` file.

⚠ **Note:** These methods are contained in the `snc-automation-api.jar` file, located in the MID Server installation folder.

**initialize**
This method initializes the encrypter with additional configuration parameters and does not return a value.
Example

```java
void initialize(java.util.Properties properties)
    throws java.lang.Exception
```

Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>properties</td>
<td>Initialization properties.</td>
</tr>
</tbody>
</table>

Exception

`java.lang.Exception`

**encrypt**

This method encrypts the unencrypted data and returns a `byte[]` type value.

Example

```java
byte[] encrypt(byte[] unencryptedData)
    throws java.lang.Exception
```

Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>unencryptedData</td>
<td>The data unencrypted.</td>
</tr>
</tbody>
</table>

Returns

Encrypted data

Exception

`java.lang.Exception`
decrypt
This method decrypts encrypted data and returns a `byte[]` type value.

Example

```java
byte[] decrypt(byte[] encryptedData)
    throws java.lang.Exception
```

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>encryptedData</td>
<td>The data decrypted.</td>
</tr>
</tbody>
</table>

Returns
Decrypted data.

Exception
`java.lang.Exception`

**MID Server authentication credentials and SOAP requests**
Set basic authentication credentials to update the web service invocation data. For added security, you can enforce basic authentication on each incoming SOAP request to the MID Server.
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

**Basic authentication credentials and SOAP requests**

You can enforce basic authentication on each request. The MID Server is not able to communicate through a proxy server if the proxy server supports only NTLM authentication. You can use basic authentication with a proxy server or create an exception for the MID server host.

Supplying basic authentication information, regardless of whether it is required, has an added advantage. The web service invocation creates or updates data using the supplied credentials. For example, when you create an incident record, the journal fields have the user id of the basic authenticated user instead of the default Guest user. This behavior allows you to identify data added by a specific MID Server.

You can set basic authentication credentials for SOAP requests. Each SOAP request contains an Authorization header as specified in the Basic Authentication protocol.

⚠️ **Note:** The setting for enforcing strict security controls how the instance uses the credentials you provide for the MID Server. When the setting is enabled, you must provide a user ID with access to the tables the MID Server is trying to access. When the setting is disabled, any valid user ID allows the MID Server to access to all tables.
Note: To learn more about properties that affect SOAP request processing, see Basic auth: SOAP requests in Instance Security Hardening Settings.

**Require basic authorization for incoming SOAP requests**

Enforce basic authentication on each incoming SOAP request to the MID Server.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to System Properties > Web Services.
2. Select the check box for Require basic authorization for incoming SOAP requests.
3. Click Save.
4. To provide basic authentication credentials for a MID Server, navigate to C:\Program Files\ServiceNow\<MID Server name>\agent and edit the config.xml file, as follows:
   
   **a.** Find the element `<parameter name="mid.instance.username" value=""/>` and enter the instance administrator user name as the value.
   
   **Example**
   For example, you might enter `<parameter name="mid.instance.username" value="admin"/>`.

   **b.** Find the element `<parameter name="mid.instance.password" value=""/>` and enter the configured password for this instance as the value.
   
   **Example**
   For example, you might enter `<parameter name="mid.instance.password" value="abc123"/>`.

**MID Server unified key store**

The MID Server unified key store allows all products on the MID Server to use a common certificates and key pairs. This feature allows applications to use the same secure communication channel to the MID Server that the MID Server uses to connect to the instance.
1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

When the MID Server starts, the common name (CN) of the certificate is inspected to identify if a custom certificate has been installed. If a custom certificate is detected, the creation of the certificate/keypair will be skipped and an attribute is set on the ecc_agent record to indicate the usage of a custom certificate.

When a custom certificate is used, the **Re-key** UI-action is disabled on the instance for the MID Server. A new UI action called **Remove custom certificate** is available to switch back to using a self-signed certificate. Using this action will cause the MID Server to remove the custom certificate and generate a new self-signed certificate, similar to the re-key option.

When a MID is upgraded, any custom certificates that were installed will be retained.

**PEM bundle support**

MID Server unified key store supports PEM bundle certificate and key pairs.

**Sample PEM bundle**

<table>
<thead>
<tr>
<th>Bag Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>friendlyName: epic1016883</td>
</tr>
<tr>
<td>localKeyId: 54 69 6D 65 20 31 35 39 35 34 32 30 38 30 35 31</td>
</tr>
</tbody>
</table>
Install custom certificates in the MID Server unified key store

Install custom certificates to unify the security channels for various applications.

**Before you begin**

**Role required:** admin

When installing the certificate on a MID hosted from a headless virtual machine, the available entropy must be higher than 2000. Check the entropy with the following command.

```
cat /proc/sys/kernel/random/entropy_avail
```
If the entropy is below the required amount, install the Haveged package. For more information about installing Haveged for CentOS and Ubuntu, see How to Setup Additional Entropy for Cloud Servers Using Haveged.

Procedure
1. If the MID Server is running, stop the MID Server.
2. Create a PEM bundle certificate and keypair by running one of the following commands in the MID Server install folder.
   - Create a key store and a self signed cert using the command:
     ```
     keytool -keystore <myCustomCert>.jks -genkeypair -alias <myCustomCert> -dname 'CN=<myCustomCert>,L=Santa Clara,ST=CA,C=US' -keysize 2048 -keyalg RSA
     ```
   - Convert the key store to PKCS format using the command:
     ```
     keytool -importkeystore -srckeystore <myCustomCert>.jks -destkeystore <myCustomCert>.p12 -srcstoretype jks -deststoretype pkcs12
     ```
   - Export the key store to a PEM bundle using the command:
     ```
     openssl pkcs12 -in <myCustomCert>.p12 -nodes -out <myCustomCert>.pem
     ```
   - Install the certificate and private key for Windows hosts using the command:
     ```
     bin/scripts/install-certificate.bat [file path to PEM bundle]
     ```
   - Install the certificate and private key for Linux hosts using the command:
     ```
     bin/scripts/install-certificate.sh [file path to PEM bundle]
     ```
3. Start the MID Server.
4. Validate the MID Server with the instance.
5. Optional: To revert the MID Server to use a self-generated certificate, select the MID Server in the instance and use the UI action Remove custom certificate.
   - Note: The MID Server can also be reverted using the Invalidate UI action. Invalidating a MID Server removes any custom certificates that are installed and creates a new self-signed certificate for the MID Server.

Enable MID Server mutual authentication
Configure the MID Server to use a client certificate for authenticating to the instance. This avoids the need to create a basic authentication credentials in the Key Store for the MID Server’s configuration.
Before you begin
Role required: admin

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

About this task
MID Server mutual authentication removes the MID Server user name and password and provides a client certificate for authentication. Whenever a server requests authentication, this certificate is sent instead. To use mutual authentication, certificate-based authentication must be enabled. See Set up Certificate-based authentication for the procedure.

If a new MID Server is created with mutual authentication, it does not add capabilities automatically. An administrator must add capabilities to its record on the instance. However, existing MID Servers using basic authentication with capabilities are preserved when switching to mutual authentication.

A MID Server using mutual authentication cannot be re-keyed or validated as a UI action on the instance.

In the Quebec release, a MID Server using the Health Log Analytic application cannot be configured with mutual authentication.
Procedure

1. Contact ServiceNow support to request mutual authentication on the MID Server.

2. Obtain a certificate and private key from a respected certificate authority.

   Note: MID Server mutual authentication only supports the PEM bundle format.

3. On the instance, navigate to `sys_user_certificate.list`.

4. Create a new record.

   Note: The record must have the MID Server's name and the User Role must be MID Server.

5. Attach the certificate to the record.

   Note: Ensure that the attached file contains only the certificate.

6. Optional: If the MID Server is running, stop the MID Server.

7. On the MID Server host machine, run the following command to install the certificate and private key.

   • For Windows hosts, use the command:

   ```
   bin/scripts/install-certificate.bat [file path to PEM bundle] --useMutualAuth
   ```

   • For Linux hosts, use the command:

   ```
   bin/scripts/install-certificate.sh [file path to PEM bundle] --useMutualAuth
   ```

8. Start the MID Server.

9. Optional: To remove mutual authentication,
a. Stop the MID Server.

b. Run the following command on the MID Server host machine to remove mutual authentication and create a basic authentication username and password.

- For Windows hosts, use the command:
  
  bin/scripts/remove-certificate.bat --removeMutualAuth [myUserName] [myPassword]

- For Linux hosts, use the command:

  bin/scripts/remove-certificate.sh --removeMutualAuth [myUserName] [myPassword]

  **Note:** If you do not provide a username and password with this command, a username and password must be added to the config.xml file manually.

c. Start the MID Server and validate it.

**MID Server command audit log**

The command audit log records the commands run by the MID Server for the Discovery application. Review the commands to check for anomalies or errors.

---

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security
The MID Server command audit log is a record of the commands the MID Server runs during discovery. For example, executing one pattern may run many separate commands. The MID Server command audit log supports Powershell commands for WMI and WinRM. For SSH commands, the audit log supports SSNC but not J2SSH. In Quebec, the command audit log only supports recording the commands run during discovery.

Enable the command audit log

The MID Server audit log is enabled with the MID Server property `mid.log.command_audit.enable`, which is set to false by default. Add the property in the MID Server Properties table [ecc_agent_property_list.do]. Once enabled, the MID Server command audit logs are accessed in the instance by navigating to MID Server > Command Audit Logs [ecc_agent_command_audit_log_list.do]. To see or change this table, the user must have the role agent_security_admin.

Data recorded in the command audit logs

The MID Server command audit log records the name of the command and the command hash. If, for example, during discovery a probe does not run a command but instead runs a script then the script name is recorded. The command hash is calculated based on the content of the script, regardless of the name. Therefore, changing the name does not affect the command hash.

When a probe, such as a WMIRunner, runs a command with multiple WMI fields then WMI creates one script to query those fields. The script is created temporarily on the MID Server host in the temp folder. After the script is run, it is removed from the temp folder. The script is given a name based on the fields and a random number. However, the hash key is always the same given the same contents.
The command audit log reports the execution status as either a success or failure. The record entry is a success if the command was run, or a failure if it was unable to run. The command audit log does not consider the result of the command being run. For example, a command which runs but fails gather data is still listed in the execution status as a success.

Discovery supports JEA profiles for WinRM. The MID Server command audit log records the JEA profile of the discovery command, if it is available. See Microsoft Just Enough Administration (JEA) for Discovery for more information on JEA profiles.

By default, the table is rotated every seven days. For more information, see Table Rotation.

**Rekey a MID Server**

Rekey a MID Server to generate a new private key. Private keys are used to decrypt automation credentials, so that MID Servers can transmit information securely. Key pairs are initially generated when a MID Server is validated, and MID Servers should be rekeyed periodically to meet security requirements.

**Before you begin**

Role required: admin

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security
About this task
When the MID Server comes back online, the system automatically validates the new key, and the MID Server resumes processing automation tasks. Automation credentials are secured by encrypting them in the instance with the MID Server’s trusted public key prior to transmission. When the MID Server is created, it generates a keypair, consisting of a public and private key. After the MID Server is validated, it can use the private key to decrypt automation credentials. You should occasionally rekey the MID Server to meet your organizations security requirements.

Procedure
1. Navigate to MID Server > Servers.
2. Open the MID Server whose keypairs you want to rotate.

Related information
  Validate the MID Server

Add SSL certificates for the MID Server
Configure the MID Server to connect to a source over SSL.

Before you begin
Role required: admin
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

About this task
You can add certificates to the MID Server to communicate over SSL/TLS in one of two ways:

• Add certificates directly to the bundled JRE TrustStore file, using the following procedure.
• Specify a different TrustStore file for the MID Server to use. For more information, see Specify an external TrustStore for the MID Server.

Review both methods to evaluate which best meets your needs. During MID upgrade the bundled TrustStore is overwritten. The MID Server attempts to migrate certificates from the existing TrustStore to the incoming one. To be migrated, certificates must meet the following criteria:

**Quebec (backported to Orlando Patch 10 and Paris Patch 4)**

• X.509 v3 certificates
• Basic Constraints Extension evaluates to false (or is not present)

**Rome (backported to Paris Patch 7 and Quebec Patch 2)**
• X.509 certificates
• Any certificate present in the source, but not the destination TrustStore

Certificates that do not meet the criteria are overwritten. Alternatively, you can specify an external TrustStore file which is unaffected by MID Server upgrades. For more information, see Specify an external TrustStore for the MID Server.

In Rome and later families, the migration strategy utilized during upgrade is configurable via the MID Server configuration parameter `mid.truststore.migration.strategy`. It can take the following values:

• `migrate_delta`: the default strategy (outlined above for Rome)
• `migrate_non_ca`: a strategy matching the one outlined above for the Quebec family
• `do_not_migrate`: disables the TrustStore migration during upgrade, though a backup of the original TrustStore is made in the event of overwrite

During this migration process, a backup of the original and upgrade TrustStores are made and stored in the agent’s work directory: `...\agent\work\truststore_migration\<time epoch seconds>\`. The original TrustStore is renamed to `cacerts_before` and the upgrade TrustStore is renamed to `cacerts_from_upgrade`.

**Procedure**

1. Open a command prompt and navigate to the folder containing the JRE `keytool`. This is the location of the JRE you installed. An example path might be: C:\Program Files\Java\jre1.8.0_161\bin
2. Import a certificate into the MID Server's cacerts keystore, using this command:

   keytool -import -alias <certificate alias> -file "<path to certificate>" -keystore "<path to the JRE>\lib\security\cacerts"

   For example, you might enter: keytool -import -alias MyCA -file "C:\myca.cer" -keystore "C:\Program Files\Java\jre1.8.0_161\lib\security\cacerts"
Note: The keytool prompts you for a certificate password. If the certificate is for a CA, the keytool also asks whether to trust the certificate authority. To add a certificate to an instance, see Upload a certificate to an instance.

3. Optional: Display a list of the current certificates by running the command:
   keytool.exe -list -keystore "C:\Mid Server\agent\jre\lib\security\cacerts"

Specify an external TrustStore for the MID Server

The MID Server JVM can utilize a TrustStore external to the MID installation directory so any certificates added to the TrustStore are not overwritten during an upgrade. It is important that this TrustStore file reside outside of the MID installation directory, and the Truststore location can be specified by adding additional parameters to the MID Server’s wrapper-override.conf file.

Before you begin
Role required: admin

Procedure

1. In the MID Server host, navigate to the wrapper-override.conf file.
2. Specify an external TrustStore by appending a custom parameter to the end of your MID’s wrapper-override.conf file.
   For example, on a Windows MID with an external TrustStore found at C:\external_truststore\cacerts, the end of the file would appear similar to:

```
# Add additional custom parameters below

wrapper.java.additional.3=-Djavax.net.ssl.trustStore=C:\external_truststore\cacerts
wrapper.java.additional.4=-Djavax.net.ssl.trustStorePassword=<truststore’s password>
```

Note: If you have specified other additional parameters in this file then the numerical identifier, in this case 3 and 4, may differ.

MID Server SSH cryptographic algorithms

The MID Server utilizes SSH clients to perform many discovery actions. During the SSH handshake, both the client and server first determine which algorithms both parties support, then client picks the highest priority algorithm. For the Host Key Algorithm, the client picks highest priority algorithm which both parties support that matches the key type.
1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

Default supported SSH algorithms by priority

Key Exchange Algorithm

1. ecdh-sha2-nistp256
2. ecdh-sha2-nistp384
3. ecdh-sha2-nistp521
4. diffie-hellman-group-exchange-sha256
5. diffie-hellman-group14-sha256
6. diffie-hellman-group16-sha512
7. diffie-hellman-group14-sha1
8. diffie-hellman-group1-sha1
9. diffie-hellman-group-exchange-sha1

Host Key Algorithm (used for public key signature during authentication)

1. ecdsa-sha2-nistp256
2. ecdsa-sha2-nistp384
3. ecdsa-sha2-nistp521
4. rsa-sha2-256
5. rsa-sha2-512
6. ssh-rsa
7. ssh-dss

Cipher Algorithm
1. aes128-ctr
2. aes192-ctr
3. aes256-ctr
4. 3des-ctr
5. aes128-cbc
6. aes192-cbc
7. aes256-cbc
8. 3des-cbc

MAC Algorithm
1. hmac-sha2-256
2. hmac-sha1
3. hmac-sha2-512
4. hmac-sha1-96
5. hmac-md5-96
6. hmac-md5

Customize the SSH algorithms priority list
The MID Server SSH algorithm priorities can be customized based on security needs. Each algorithm is controlled by one of the following MID Server properties.

Note: Glide Import on the instance uses the default algorithm list. The four MID Server properties do not affect Glide Import because it is not run on the MID server. SNCSSH is used for Glide Import on instance for SFTP and SCP.

- Key Exchange algorithms: mid.ssh.algorithms.kex
- Host Key algorithms: mid.ssh.algorithms.host_key

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• Cipher algorithms: `mid.ssh.algorithms.cipher`

• MAC algorithms: `mid.ssh.algorithms.mac`

The properties accept comma separated lists with operators. The first name in the list is highest priority, last name in list is lowest priority. Adding a comma separated list without any operators replaces the default algorithm list. The following operators are based on the OpenSSH standard syntax and modify the algorithm priority list.

• The `+` operator appends the comma separated list of algorithms to the default algorithm list.

• The `-` operator removes the comma separated list of algorithms from the default algorithm list.

• The `^` operator places the comma separated list of algorithms at the front of the default algorithm list.

<table>
<thead>
<tr>
<th>Property</th>
<th>Algorithms</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>mid.ssh.algorithms.cipher</code></td>
<td>aes128-ctr</td>
</tr>
<tr>
<td><code>mid.ssh.algorithms.host_key</code></td>
<td>ssh-rsa</td>
</tr>
<tr>
<td><code>mid.ssh.algorithms.key</code></td>
<td>diffie-hellman-group1-sha1, diffie-hellm...</td>
</tr>
<tr>
<td><code>mid.ssh.algorithms.mac</code></td>
<td><code>^</code>hmac-md5</td>
</tr>
</tbody>
</table>

**Attach a script file to a file synchronized MID Server**

You can attach a script file to synchronize to a connected MID Server. Windows Internet Explorer enhanced security blocks downloaded files that it determines are potentially dangerous. However synchronizing the files avoids this security problem.

**Before you begin**

Role required: **admin**
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

**About this task**

Enhanced security in Windows browsers, such as Internet Explorer, blocks downloaded files that it determines are potentially dangerous. This would block files downloaded for use by the MID Server. You would need to unblock each file manually through the browser.

To get around this issue, use file synchronization. File synchronization requires you to proactively take script files from your instance and save them on the MID Server. The files on the instance and the MID server stay synchronized, but there is no longer any need for the MID Server to download the whole file. File synchronization also protects any updates you make in those script files from being overwritten during the upgrade of an instance.

You can attach multiple files, but the last attached file gets synchronized to the MID Server. If you delete the attachment, the script file becomes inactive, and the synchronized file is deleted from the MID Server.

**Procedure**

1. Navigate to **MID Server > Script Files**.
2. Open the file to which you would like to attach the script file, or click **New** to create a new file.
3. Select **Use attachment**, and then click the paperclip icon to add the attachment.
When **Use attachment** is checked, an attached script file overrides the script contained in the **Script** field. If this check box is cleared, the script in the **Script** field is used instead of the attachment.

The script file attachment name must match the MID Server script file name, since the record can contain other attachments.

4. Click **Update** to initiate the synchronization process. Ensure that the file name matches the script name. If you receive the error message: *File type not permitted or mime type does not match the file content*, request that your administrator turn off mime type validation on attachments. The system property `glide.security.file.mime_type.validation` controls this setting.

**Enable script file synchronization for Windows enhanced security**

Windows Internet Explorer enhanced security blocks downloaded files that it determines are potentially dangerous.

Script files synchronized with the MID Server are stored on the instance in the MID Server Script File [ecc_agent_script_file] table, which you can access in the MID Server > Script Files module.

When the MID Server first connects to the instance, the instance creates a directory called \scripts in the MID Server root. The instance then creates a parent directory in the path \scripts\<parent name> using definitions from the ecc_agent_script_file table. Finally, the instance creates the script files themselves inside the parent directory using the records from the ecc_agent_script_file table.

The record for the parent directory looks like this:
The instance creates each script file in the parent directory on the MID Server using the record Name from the ecc_agent_script_file table as the file name and the Script field payload as the file contents. A script file record looks like this:

The synchronization of the script file continues to work as if the script was manually added to the form.

See Attach a script file to a file synchronized MID Server for instructions on how to attach a script file.

**Note:** The MID Server Script File [ecc_agent_script_file] table is domain separated. You can create versions of these policies that only a MID Server from the same domain can use. For instructions, see Set up domain separation for MID servers.

**MID Server FIPS Enforced Mode**

The MID Server supports the National Security Cloud (NSC) IL-5 environment, which requires all utilized cryptography to be FIPS validated. The MID server can be run in FIPS Enforced Mode, where only cryptographic algorithms which are FIPS validated are utilized.
1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

The Federal Information Processing Standards are a group of standards compiled by the National Institute of Standards and Technology for use in computer systems. There are many FIPS publications, but for the sake of this discussion we are specifically referring to FIPS 140-2: Security Requirements for Cryptographic Modules. Cryptographic algorithms can proceed through a validation process specified by the NIST. For the purposes of our new secure cloud environment, the MID server will be utilizing algorithms that have been validated by such process.

Only MID Servers of the Rome release family or later with a JRE version of 11.0.9+11 or later can be set to run in FIPS Enforced Mode.

FIPS Enforced Mode

The following algorithms are not available for use in these SSH functions by the MID in FIPS Enforced Mode.

Key Exchange:

- diffie-hellman-group1-sha1

Mac:

- hmac-md5
- hmac-md5-96
The following restrictions are now in place for SNMP for use by the MID in FIPS Enforced Mode.

- SNMP v1 and v2 are completely disabled.
- For SNMP v3, the following protocol uses are not permitted by the MID in FIPS Enforced Mode:
  - auth protocol: none or MD5
  - privacy protocol: none or DES

Other functionality that utilizes the MID may be impacted when run in FIPS Enforced Mode. Please refer to that functionality's specific documentation for details.

Enable MID Server FIPS Enforced Mode

The MID server can be run in FIPS Enforced Mode, where only cryptographic algorithms which are FIPS validated are utilized.

Before you begin
Role required: admin

Procedure
1. Deploy a new MID Server or upgrade existing MID Servers to the Rome family release or later.
2. Shut down the MID Server.
3. Execute the following bundled script provided to convert the MID to run in FIPS Enforced Mode:
   - For Windows hosts: `> <MID install directory>/agent/bin/scripts/set-fips-enforced-mode.bat on`
   - For Linux hosts: `$ <MID install directory>/agent/bin/scripts/set-fips-enforced-mode.sh on`
   Success will be logged to the console including the location of modified files and any backups generated during the conversion process. If invoked programmatically, success will be indicated by a 0 return code.
4. Start the MID Server.

What to do next
The mode the MID is running in can be confirmed via two methods:
1. Check the agent logs after start-up and look for the following log line: \textbf{Running in FIPS Enforced mode}

2. Check the \texttt{ecc\_agent} table on the instance and look for the value of the \textbf{FIPS Enforced} boolean column.

\textbf{Manually convert the MID Server to FIPS Enforced Mode}

The MID server can be run in FIPS Enforced Mode, where only cryptographic algorithms which are FIPS validated are utilized.

\textbf{Before you begin}
Role required: admin

\textbf{About this task}
To manually convert the MID Server to FIPS Enforced Mode while using an external JRE, you must perform the following steps while the MID Server is shut down:

- Convert the JRE's TrustStore to BCFKS type.
- Set the JRE's default KeyStore type to be BCFKS.
- Set the FIPS Enforced Mode flag in the MID Server's configuration file.

\textbf{Procedure}
1. Convert the JRE's cacerts file type to BCFKS by using the \texttt{Java Keytool} with a command similar to:

\begin{verbatim}
$ keytool -importkeystore -srckeystore <source keystore path> -srcstoretype <source keystore type> -srcstorepass changeit -destkeystore <destination keystore path> -deststoretype BCFKS -deststorepass changeit -provider org.bouncycastle.jcajce.provider.BouncyCastleFipsProvider -providerpath <BouncyCastle FIPS jar path>
\end{verbatim}

\textbf{Note:} Rome and later MID installations contain a BouncyCastle jar suitable for this purpose. It can be found at: \texttt{.../agent/lib/bc-fips.jar}

2. The JRE's default KeyStore type can be set in the <JRE installation directory> \texttt{\conf\security\java.security} file.

3. In that file find the \texttt{keystore.type} line and set its value as follows:

\begin{verbatim}
keystore.type=bcfks
\end{verbatim}

4. In the MID Server's \texttt{.../agent/conf/wrapper-override.conf} file, uncomment the FIPS line and set its value to true.

The line should read:

\begin{verbatim}
wrapper.java.additional.106=-Dorg.bouncycastle.fips.approved_only=true
\end{verbatim}
MID Server upgrades

Upgrade MID Servers manually, or automatically through the instance. MID Server automatic upgrade is triggered when the instance upgrades and the MID Server no longer has the same version. The new MID Server package is downloaded from install.service-now.com, replaces the old one, and the MID Server starts with the new version.

⚠️ Warning: The MID Server cannot auto-upgrade on a Windows host if the Windows Application Experience service is disabled. For information on the error that is displayed and instructions for re-enabling this service, see KB0597552.

MID Server Upgrade Requirements

Access to the MID Server download site

The MID Server host computer must have access to the ServiceNow download site at install.service-now.com to upgrade automatically. If you have a self-hosted ServiceNow environment that blocks access to the download site, you must import the MID Server installer package into your MID Server hosts manually. For instructions, see KB0760123 in the Self-Hosted knowledge base.

MID Server access to OCSP blocked

Firewalls and proxy configurations may block calls to the OCSP Entrust server, which prevents the MID Server from working. You may need to change your firewall permissions so the OCSP traffic to go through properly. For more information and resolutions, see the HI Knowledge Base article [KB0813636].

MID Server operating system compatibility

Upgrading Windows or Linux MID Servers with 32-bit operating systems is not supported. For more information refer to [KB0863694].

The MID Server cannot upgrade on a Windows host if the Windows Application Experience service is disabled. For information on the error that is displayed and instructions for re-enabling this service, see KB0597552.

The MID Server upgrade is blocked by some antiviruses running on Windows hosts. For information on the errors and list of these antiviruses see KB0870329.

Any Linux MID Server upgrade whose service is installed under system in Madrid or lower needs to re-install the service after upgrade. If you didn’t manually reinstall the service in previous upgrades and your MID Server service is still installed on Madrid or lower versions, during upgrade the MID Server automatically re-installs the service. To re-install the service MID Server needs to
run as an admin user. If your MID Server upgrade needs to re-install the service, make sure that the MID Server user is admin, or you can manually re-install the service before upgrade. For manually re-install the service, see KB0821436.

When does the MID Server need to Upgrade?

Any MID Server with a version different from the instance version needs to upgrade. The following two system properties control the version of all MID Servers:

- **mid.buildstamp**: Identifies the MID Server version with an identifier based on the date of the build. This property uses the format of **mm-dd-yyyy-hhmm**. The MID Server checks for version information hourly. If no override version is configured, the MID Server looks at the **mid.buildstamp** property for the version to use. This property resets itself to the default version (the version that matches your instance version) when the instance is restarted or upgraded, so any user changes are lost at that time. The system appends the release name and patch information to the date and time format.

  **Warning:** This property is not visible by default and should not be configured.

- **mid.version.override**: Sets an override condition for the current version for all MID Servers in your environment. This action pins the MID Servers to a single version and disables the automatic upgrade feature. This property is not visible in the base system and must be added to the System Property [sys_properties] table when it is set. For details, see Add a system property.

When the MID Servers check the version each hour, they look at the **mid.version.override** property first. If this property is empty, the MID Servers get their version information from the **mid.buildstamp** property. If an override version is configured, the MID Servers use this value and ignore the version information in the **mid.buildstamp** property. This override value remains when the instance is restarted and is passed to the MID Servers. The value in the **mid.version.override** property is cleared during an upgrade, which forces the MID Server to reset itself to the version in the **mid.buildstamp** property.

In addition to **mid.version.override**, the MID Server version can also be controlled with the configuration parameter **mid.pinned.version** which pins the MID Server to a specific version. To pin a MID Servers, set the **mid.pinned.version** parameter with the name of that version in the **config.xml** file of each MID Server. Use the format **<version>-mm-dd-yyyy**. This setting overrides the property setting for the pinned MID Server version. For instructions, see Add a MID Server parameter. The value set in this parameter is not affected by an upgrade.
Warning: Using `mid.version.override` and `mid.pinned.version` is not recommended. The different versions on the MID Server and instance can cause outage issues on the MID Server.

Upgrade methods

Automatic

Automatic upgrade can be triggered by the instance or the MID Server itself. This functionality is available by default. Automatic upgrade occurs:

- When the instance is upgraded and the MID Server for that version is different than the version currently on the MID Server. The instance sends `autoUpgrade` system command to the connected MID servers.
- Every hour, the MID Server checks with the instance to see if there is a different version available for upgrade. You cannot modify this time period.

Manual

Manually start the upgrade by clicking a related link on the MID Server record. Use this method when you do not want to wait until the next hourly automatic update or if your upgrade failed and you want to force an upgrade. See Upgrade the MID Server manually for instructions.

The Upgrade Process

1. **Pre-upgrade Check:** Before starting the actual MID Server upgrade process, the MID Server runs a set of tests to make sure that the host machine meets the minimum requirements. Any errors encountered during this automatic test prevent the upgrade from occurring until the issues are resolved. The pre-upgrade test is enabled by default but can be disabled by adding and setting a system property. See MID Server pre-upgrade check for more information.

2. **Download the packages:** The MID Server downloads upgrade packages from install.service-now.com. These packages are in zip format and are downloaded to the agent folder in the `package/incoming` folder.

   Digital Signature Verification

   After downloading every package, MID Server verifies the digital signature of the package. It throws an exception if the verification fails. The error will be recorded in the agent log and the MID Server issue table.
If the packages are downloaded and replaced manually you can verify the signature manually. To manually verify the signature of an installation or upgrade package, use the jarsigner tool which is available for free with JDK. The following is the jarsigner command to initiate the verification: Jarsigner -verify -verbose -certs -strict <zip-file>

The output should be similar to the following example:

```
- Signed by "CN=ServiceNow Inc., O=ServiceNow Inc., L=Santa Clara, ST=California, C=US"
  Digest algorithm: SHA-256
  Signature algorithm: SHA256withRSA, 2048-bit key
  Timestamp digest algorithm: SHA-256
  Timestamp signature algorithm: SHA256withRSA, 2048-bit key

jar verified.
```

The signer certificate will expire on 2021-08-09.
The timestamp will expire on 2029-03-22.

3. Extracting Zip Files: After downloading all required packages, the MID Server extracts the zip files.

- **Before Rome:** The zip files are extracted in a folder under the operating system defined temporary folder. The folder name is a randomly generated number. The operating system temporary folder is specified by system property `java.io.tmpdir`. On a UNIX host, the value for this property is typically `/tmp` or `/var/tmp`.

- **From Rome onward:** The MID Server avoids using operating system defined temporary folders during MID Server upgrade. The zip files are extracted in a folder in the `work/upgrade_temp` folder under the agent folder. The folder name format is a randomly generated number. If you want to switch to the previous behavior and use an operating system defined temporary folder you can add `mid.upgrade.use_os_temp_folder` to MID Server's `config.xml` file and set it to true. To switch the behavior for all MID Servers, you can add it to the MID Server property [ecc_agent_property] with MID Server field blank.
4. **Replace old packages with the upgraded packages:** After downloading and extracting the upgrade packages, the MID Server replaces old files with the new files and starts with the new version. To replace the packages, the MID Server starts a process named *ServiceNow Platform Distribution Upgrade* and shuts down. ServiceNow Platform Distribution Upgrade waits for the MID Server to shut down properly, then replaces the required files as follows:

- **Before Rome:** The process deletes all files and folders in the bin, lib and jre folders and copies the new files into those folders.

- **From Rome onward:** The process replaces the files in the bin, lib and jre only if the new version of the file is different from the old version. *ServiceNow Platform Distribution Upgrade* does not clean the upgrade files and the unchanged files are kept.

If the reinstalling service was required as a part of MID Server upgrade, *ServiceNow Platform Distribution Upgrade* reinstalls the service before starting the MID Server. For more information refer to **KB0821436**.

**Note:**

If the MID Server upgrade fails in this step the MID Server stays “Down”. There are some anti-viruses block replacing files in this step. For more information refer to **KB0870329**.

5. **Start the MID Server:** After replacing all required files with the new version, ServiceNow Platform Distribution Upgrade starts the MID Server. When the MID Server comes up with the new version, it cleans up all temporary folder used to extract the upgrade files.

**Upgrade Log messages**

The MID Server log messages are available in the following log files:

- Pre-upgrade check log messages are available in agent.log file under agent/logs folder. The message **Performing pre-upgrade validation tests**, indicates that the pre-upgrade check has started. If all mandatory tests are passed **Pre-upgrade validation tests successful. Continuing with upgrade process** indicates the end of the pre-upgrade check.
• Downloading Missing files log messages are also available in agent.log. Every package download starts with **Downloading package to PACKAGENAME.ZIP from https://install.servicenow.com/ PACKAGEINFO** message. The download progress and the size of downloaded file is monitored in the log. After download every package, **Package was successfully downloaded from https://install.servicenow.com/ PACKAGEINFO** indicates the successful download.

• Extracting the zip files is the last step available in the **agent.log**. The message **Upgrading MID server** indicates the start of this step, and the message **Extracting package PACKAGE.ZIP to EXTRACT_TMP_FOLDER** is shown for every package extraction. When all required zip files are successfully extracted, the MID Server starts the ServiceNow Platform Distribution Upgrade process and the message **Stopping MID server. Bootstrapping upgrade** shows the end of this step before MID Server goes Down.

• ServiceNow Platform Distribution Upgrade logs include log messages for the process start up and for replacing files during the MID Server upgrade. The upgrade log messages are placed between the messages

    ***********UPGRADE MAIN LOGIN START*********** and ***********UPGRADE MAIN LOGIN END***********. ServiceNow Platform Distribution Upgrade log messages can be found in the following log files:

    ▪ In **glide-dist-upgrade.log** file under temp extract folder. This file is available in upgrade-wrapper/logs folder under temp extract folder. This log file includes process log messages and upgrade log messages.

    ▪ In **dist-upgrade.log** in **agent\logs** folder. This file only includes the upgrade portion of log messages. If there was some issue with the process startup you need to look at **glide-dist-upgrade.log**.

    ▪ In **wrapper.log** under **agent\logs** folder. After replacing files, ServiceNow Platform Distribution Upgrade append **glide-dist-upgrade.log** to wrapper.log file.

### MID Server states

#### Upgrading

The MID Server status is changed to Upgrading while the upgrade is running. The **Upgrading** state is similar to the **Paused** state. This is avoids potential miscommunication between the new version of the instance and the previous version of the MID Server during upgrade. While in the **Upgrading** state, you cannot resume or restart the MID Server. However, you can perform the same actions that you can when the MID Server is in the **Paused** state.
Note: If you are using an Istanbul instance but you are upgrading a pre-Istanbul MID Server to Istanbul, these upgrade states are not available. They are only available for MID Servers that are already on Istanbul.

Upgrade Failed

If the upgrade failed in pre-upgrade check step or download/extract packages step, failed upgrades are handled differently based on the version you are upgrading.

- Upgrade to another major release (such as Istanbul to the next full release): the status changes to Upgrade Failed.
- Upgrade from a minor version within a release (such as Jakarta patch 1 to patch 2): the MID Server continues using the version it is currently running. It does not perform the upgrade and the status eventually changes to Up, assuming the MID Server was already functioning properly.
- If the upgrade failed in last step, replacing old version of packages with the new version of packages, the MID Server stays Down.

MID Server Upgrade History

Use the MID Server Upgrade History module for troubleshooting problems with MID Server upgrades. The module contains a record of each instance upgrade. Those records provide step-by-step status details for each MID Server's upgrade process. If an error occurs, it is noted in the step and a message is dynamically generated with further details. The table cleanup job automatically deletes issues that haven't been detected for 30 days, regardless of their state. For further information, see MID Server Upgrade History.

JRE TrustStore certificate migration during JRE updates

For JRE updates after upgrading to Quebec, the MID Server migrates existing self-signed certificates in the JRE TrustStore to the new JRE version's TrustStore. When these certificates are migrated, their aliases are prepended with the string "snc_".

In order for a certificate to be migrated it must be:

- an X509 certificate
- certificate standard v3
- have the basic constraint extension set to false (i.e. it is not CA issued)
The MID Server identifies when a JRE upgrade is about to take place and begins the migration process. Before the migration, the MID Server creates a backup of the original TrustStore as a fall-back in the event of failure. If there is a failure, the backup TrustStore can be manually restored.

**MID Server pre-upgrade check**

Prior to an upgrade, the MID Server runs tests to identify issues that could cause the upgrade process to fail or result in a MID Server outage.

Each MID Server contains an AutoUpgrade monitor that compares the MID Server version with that of the instance to determine if the MID Server needs to upgrade. If the AutoUpgrade monitor discovers that the MID Server version is out of date, the monitor runs pre-upgrade validation tests for that MID Server. If an issue is detected, a message is logged to the MID Server Issue [ecc_agent_issue] table, and the upgrade is blocked. The AutoUpgrade monitor continues to run every hour, until all the tests pass. If there are no blocking issues, the MID Server downloads the appropriate upgrade package and begins the upgrade process. The MID Server pre-upgrade check also runs for the upgrades triggered by the instance when the instance was upgraded, as well as for manual upgrades.

**Pre-upgrade tests**

The pre-upgrade runs two sets of tests: Mandatory tests and Alert tests. Every mandatory test is required to pass to start MID Server upgrade. If a mandatory test was not passed, the test is recorded in the agent log and a MID Server active issue is created in the MID Server issue [ecc_agent_issue] table. These errors are published before the actual MID Server upgrade occurs and must be resolved before the upgrade can continue. MID Server stops the Upgrade process and changes the status based on MID Server states. If any alert test was not passed, a message is added in the agent log and MID Server issue table, but the pre-upgrade check continues and MID Upgrade doesn’t stop.

Pre-upgrade validation tests check the following mandatory tests:

- At least 1 GB of free disk space
- Access to the download site at install.service-now.com
- Verify the digital signature of a sample downloaded file
- Permission to execute, which involves the following:
  - Extract a Zip archiver to a temp folder
  - Copy file from temp folder to the agent folder
Read a text file and validate the content
Delete the pre-upgrade check contents

- MID Server host machine is not a 32 bit system
- On Linux MID Servers, the glibc version is at least 2.17

On Windows MID Servers, the pre-upgrade validation runs the following alert tests:

- Any MID Server Upgrade blocker services is running on the host machine
- Status of Application Experience on the host machine
- Ensure that the Log On As user for the Windows service is either LocalSystem or a user that is part of the local Administrator group. By default, domain administrators are added to the local Administrator group when joining a computer to a domain.

Errors that block the upgrade
These messages describe failing a mandatory test and are published to the MID Server Issue [ecc_agent_issue] table. Failure of any of these tests blocks the upgrade.

- Not enough free disk space. The system reports <n> bytes free
  This message is displayed when less than 1 GB of free disk space is detected on the MID Server host. This error is also written to the MID Server agent log.

- Unable to download updates from the install server
  This message indicates that either the MID Server host does not have permission to download the installation package from install.service-now.com, or network problems prevent connection. This error is also written to the MID Server agent log.

- Signature verification failed:<message>
  This message indicates that a Verification Exception has occurred when pre-upgrade check tries to verify the digital signature of the downloaded check file.

- Unable to verify digital signature:<message>
  This message indicates that the verification signature process was interrupted by an exception.

- Unable to extract contents of pre upgrade check zip
This message indicates that the service account on the MID Server host does not have permission to extract the pre-upgrade ZIP archive to the temporary folder.

**Unable to create folder <upgrade check file path>**

This message indicates that the MID Server service account does not have permission to create the upgradeCheck folder for the pre-upgrade checking files in the agent/package path.

**Unable to verify file permissions: <message>**

This message indicates an exception has occurred when checking file permissions, such as a file that does not exist or access failure.

**MID Server Windows Service is not running as LocalSystem or a local Administrator**

This message warns that the Windows service is not running with the desired permissions.

**Upgrade Failure: The host machine does not meet the minimum system requirements to upgrade the MID server.**

MID upgrade is not supported on 32-bit host. Please refer to KB0863694 for more information.

**Upgrade Failure: Host does not meet the minimum system requirements to upgrade the MID server. Please refer to MID Server product documentation on GlibC library for more information**

This error can only occur for Linux MID Servers. Refer to Java version support for more information.

**Non-blocking warnings**

These warnings are displayed in the MID Server Issue [ecc_agent_issue] table and do not prevent a Windows MID Server from upgrading:

**Unable to parse $logOnAsUser**

This message warns that the Log On As User value for the Windows service is not in either of these expected formats:

- user@domain.company.com
- domain\user

**Unable to look up Log On As user’s groups**

When the instance attempts to look up the logged on user’s group memberships, it executes the **net user <username>** command. The instance expects a certain output structure by the Windows service
from this command and issues this warning if the expected output
does not match the actual output.

These PowerShell warnings are written only to the MID Server agent
log. Because PowerShell is not required to use a MID Server, these
configuration issues do not prevent a Windows MID Server from
upgrading. However, these warnings might indicate issues in your
environment that require attention.

Skipping PowerShell upgrade checks since PowerShell is not usable

PowerShell 3.0 (at a minimum) is not installed or powershell.exe is not
available to the MID Server service user.

Skipping Powershell test: Target folder has not been initialized

Skipping Powershell test: Unable to detect the service name

Service CiscoAMP running on the MID Server host machine is identified as a
MID Server upgrade blocker

For more information, refer to KB0870329.

The Application Experience is disabled on the MID Server host, which can
cause the auto-upgrade process to fail and the MID Server to go down.
Enable the service on the host to ensure successful auto-upgrade

For more information, refer to KB0597552.

Continuing with upgrade, but the following issue was encountered during
upgradeCheck: <exception message>

This message indicates that there was an issue running the
PowerShell portion of the pre-upgrade tests.

Disabling the pre-upgrade check

A MID Server configuration parameter called mid.upgrade.run_precheck is
set to true by default, which allows the automatic pre-upgrade test to run.
To disable these tests for a single MID Server, add this parameter to that MID
Server’s config.xml file and set it to false. To disable these tests for all MID Servers,
add a new record to the MID Server Property [ecc_agent_property] table called
mid.upgrade.run_precheck. Set the value of this property to false and leave the
MID Server field blank.

Pinning a MID Server to a specific version

You can pin all the MID Servers in your environment to a specific version by
setting a system property, or you can configure specific versions for individual
MID Servers.
Note: Under most circumstances, do not pin the MID Server to a specific version. Pinning the MID server can make it out of sync with the instance, and lead to broken functionality. Instead, let the instance determine which MID Server version to use.

Version control properties
These system properties control the version for all MID Servers:

- **mid.buildstamp**: Identifies the MID Server version with an identifier based on the date of the build. This property uses the format of *mm-dd-yyyy-hhmm*. The MID Server checks for version information hourly. If no override version is configured, the MID Server looks at the *mid.buildstamp* property for the version to use. This property resets itself to the default version (the version that matches your instance version) when the instance is restarted or upgraded, so any user changes are lost at that time. The system appends the release name and patch information to the date and time format.

  **CAUTION**: This property is not visible by default and should not be configured.

- **mid.version.override**: Sets an override condition for the current version for all MID Servers in your environment. This action pins the MID Servers to a single version and disables the automatic upgrade feature. This property is not visible in the base system and must be added to the System Property [sys_properties] table when it is set. For details, see Add a system property.

  When the MID Servers check the version each hour, they look at the *mid.version.override* property first. If this property is empty, the MID Servers get their version information from the *mid.buildstamp* property. If an override version is configured, the MID Servers use this value and ignore the version information in the *mid.buildstamp* property. This override value remains when the instance is restarted and is passed to the MID Servers.

  **Attention**: The value in the *mid.version.override* property is cleared during an upgrade, which forces the MID Server to reset itself to the version in the *mid.buildstamp* property.

Version control configuration parameter
To pin specific MID Servers on a desired version, set the **mid.pinned.version** parameter with the name of that version in the *config.xml* file of each MID Server. Use the format `<version>-mm-dd-yyyy`. This setting overrides the property setting for the pinned MID Server version. For instructions, see Add a MID Server parameter.

Note: The value set in this parameter is not affected by an upgrade.
Upgrade the MID Server manually
You can manually upgrade MID Servers at any time if you do not want to wait for the automatic upgrade.

Before you begin
Role required: mid_server or admin
For the upgrade to run, MID servers must be in the Up state and must be validated. The MID Server automatically runs the pre-upgrade test before upgrading. Any errors encountered during this test must be resolved for the upgrade to proceed.

About this task
The MID Server is upgraded to the version specified by build stamp on the instance, or by the upgrade property that you specify.

Procedure
1. Navigate to Discovery > MID Servers or Orchestration > MID Server Configuration > MID Servers.
2. Open the record of the MID Server that you want to upgrade.
3. Click Upgrade MID under Related Links.
4. Confirm that you want to perform the upgrade.

Resolving MID Server issues
Troubleshoot problems with the MID Server to find solutions. Monitor the MID Server to receive alerts about issues as they occur. Troubleshooting procedures exist to resolve specific problems with the MID Server. The Knowledge Base on Hi contains several articles to help you troubleshoot MID Server issues.

Monitor the MID Server
Monitoring a MID Server involves verifying entries in log files, confirming network connectivity, and checking MID server status.

• If the MID Server is on a Windows host, navigate to the Windows Services console, locate the service name that matches the name that appears from the wrapper-override.conf file. If the MID Server process is the only Java process running on the host, monitor the memory used by java.exe and alert on less than the maximum configured memory defined in the ~\agent\conf \wrapper-override.conf folder.
• Ensure that the `agent0.log.0.lck` file appears in the `~\agent\logs` folder to confirm that the MID Server running and logging system activity in the `agent0.log.0` file.

• Review the following logs for warning, critical, and severe errors: `~\agent\logs\agent0.log.0\agent\logs\wrapper.txt` See Manage ECC Queue content for a MID Server to see how to open log entries from the instance.

• Test MID Server connectivity to confirm that the MID Server host is able to communicate with the instance. Resolve any issues with the network connectivity such as conflicts with firewalls, access control lists, and routing errors.

• From the MID Server instance, navigate to the MID Servers page, and review the status of the MID Server. For additional information, click a Name.

• Set up email, SMS, and push notifications to alert you when issues occur with MID servers. The MID Server Down notification is enabled by default. See Notifications for details.

Troubleshooting procedures

The following procedures provide information on resolving specific problems with the MID Server. Knowledge Base articles also cover a wide range of issues. If you are encountering problems which are not covered in these procedures, search the Knowledge Base for related articles. For instance, if you are experiencing symptoms such as the MID Server going down or not responding, or CIs being duplicated during discovery, see KB0597571 for information and recommended solutions.

MID Server active issues

The ServiceNow® instance has a dedicated table that publishes active issues with MID Servers and alerts administrators when a MID Server is in danger of exceeding its resources.

Active MID Server post-cloning credential issues

The system provides automatic processes to detect and notify you of possible MID Server credential issues after instance cloning.

MID Server resource threshold alerts

The instance displays warnings when a MID Server breaches its resource thresholds for CPU and JVM memory usage, enabling users to create email notifications or custom scripts when a breach occurs.
**MID Server user connectivity issues**

The instance writes issues involving MID Server user logins and network connectivity to the MID Server Issue [ecc_agent_issue] table and creates events you can use in custom scripts or to send email notifications.

**Interpreting MID Server user debugging output**

Debugging output from the system log is available in either a summary or detailed view for MID Server user issues, but must be enabled manually.

**MID Server Upgrade History**

Use this module to troubleshoot errors that occur during the MID Server upgrade process. The MID Server Upgrade Histories table contains a record of each instance upgrade. The MID Server Upgrade Stages table shows the status of each MID Server and its upgrade progress, including any errors encountered.

**MID Server active issues**

The ServiceNow® instance has a dedicated table that publishes active issues with MID Servers and alerts administrators when a MID Server is in danger of exceeding its resources.

The MID Server Issue [ecc_agent_issue] table displays a number of common issues that a MID Server can experience, as they occur. Error checking processes attempt to pinpoint the most likely cause of the issue. Informative error messages name the affected MID Server and explain the possible cause of the issue. The ecc_agent_issue table retains its records for 30 days.

To access records in this table, navigate to **MID Server > Server Issues**.

**Supported MID Server active issues:**

- Bad user credentials after instance cloning.
- Unsupported Java Runtime Environment (JRE) on the MID Server host.
- Approaching resource thresholds for CPU usage and JVM memory.
- Errors detected during pre-upgrade testing.
- User authentication and authorization failures.
- Network connectivity interruptions and role configuration errors.
MID Server fails to start
When a newly installed MID Server fails to start or shuts down prematurely, improper configuration could be to blame.

Duplicate MID Server names
When the MID Server service starts, it verifies that it is the only active (not down) MID Server with that name. If the MID Server discovers another active MID Server with the same name, the starting MID Server waits 5 minutes and sends another query. The MID Server repeats this query three times and logs each attempt in the agent log. If the MID Server still detects a duplicate after this cycle, it creates a record in the MID Server Issue [ecc_agent_issue] table and shuts down.

Note: The record in the MID Server Issue [ecc_agent_issue] table cannot be resolved automatically by the instance. Close this record manually for accounting purposes. Either mark the issue Resolved or delete it.

Upgraded MID Servers running multiple services
Beginning with the New York release, a batch file in the MID Server installer package ensures that only one Windows MID Server service is configured for an executable path (MID Server installation folder). Previous versions have not checked for this configuration. Upgraded MID Servers that run multiple services with the same executable path are prevented from starting. If you experience this issue, follow this procedure to reconfigure the MID Server to use only one service:
1. Delete the unwanted Windows service by running `sc.exe delete <service name>` from the command line.

2. Open the `wrapper-override.conf` file in the MID Server installation folder.

3. Change the `wrapper.name` and `wrapper.displayname` parameters to the service name that you want to keep.

4. Restart the MID Server.

**Active MID Server post-cloning credential issues**

The system provides automatic processes to detect and notify you of possible MID Server credential issues after instance cloning.

During an instance clone, the MID Server `[ecc_agent]` table is not copied from the source instance, but the User `[sys_user]` table is copied. As a result, the source MID Server user credentials copied into the target instance might not match those used by the existing set of MID Servers used by the target. Bad credentials can cause those MID Servers to be down for the target instance. Processes on the instance notify you if a MID Server is down from suspected bad credentials following an instance clone.

**Table for post-cloning credential issues**

The MID Server Issue `[ecc_agent_issue]` table stores active MID Server issues after an instance clone. Records in this table show a MID Server's current state, evaluation times, and the **Issue source**. For cases in which a MID Server for a cloned instance is down because of possible bad credentials, the **Issue source** is `InstanceClone`. Data from the MID Server Issue `[ecc_agent_issue]` table are displayed in a related list on a MID Server record. Records in this table are removed if they have not been detected for 30 days. Ongoing issues reappear as they occur.

**Post-cloning cleanup script and scheduled jobs**

A cleanup script called `Bad MID Server credentials after clone` runs on the target instance after cloning and calls a script include called `BadMIDCredentialAfterClone`. This script include schedules the execution of the following jobs on the Schedule Item `[sys_trigger]` table:

- `BadMIDCredentialAfterClone-1`: Runs 15 minutes after clone execution.
- `BadMIDCredentialAfterClone-2`: Runs 75 minutes after clone execution.

These jobs log to the MID Server Issue `[ecc_agent_issue]` table any MID Servers that existed on the target instance prior to the clone that are in the **Down** state. These MID Servers are not ready for normal processing and might be down due...
to invalid credentials resulting from the cloning process. The state of MID Servers added to the target instance after the clone is not evaluated.

⚠️ Note: The MID Server log shows that the MID Server user associated with the target instance could not be authenticated or was missing the proper role.

**Business rule that checks for bad credentials**

The **Check for bad MID credential after clone** business rule monitors the MID Server [ecc_agent] table for MID Servers that are transitioning from **Down** to **Up**. If the business rule finds a MID Server making that transition, the rule attempts to find a matching MID Server in the MID Server Issue [ecc_agent_issue] table that has an issue source of **InstanceClone** and a state other than **Resolved**. If a match is found, the business rule updates the state of the MID Server in the [ecc_agent_issue] table to **Resolved**.

**Resolving MID Server issues**

The error message in the MID Server Issue [ecc_agent_issue] table names the affected MID Server user. This message appears each time the business rule runs and finds a MID Server that is down from suspected bad credentials:

MID Server not operational (status: Down), possibly due to recent clone. Verify credentials for logged in User 'local-midserver'.

Attempt to resolve the issue first by comparing the user's credentials with the credentials that the affected MID Server is expecting. If the credentials are incorrect, fix the problem and check the MID Server status again. If the credentials are correct, but the MID Server remains down, check the Knowledge Base for other possible causes.

**MID Server resource threshold alerts**

The instance displays warnings when a MID Server breaches its resource thresholds for CPU and JVM memory usage, enabling users to create email notifications or custom scripts when a breach occurs.

The MID Server Issue [ecc_agent_issue] table warns users when a MID Server exceeds configured thresholds of its allocated CPU and memory resources. These warnings are published before the MID Server experiences performance degradation or an out-of-memory error, enabling the administrator to increase resources and avoid downtime. Administrators can use a registered event to send email notification to selected recipients, advising them of any threshold breaches, or to create a custom script to do some other type of work. The instance continues to update the MID Server Issue [ecc_agent_issue] table to keep unresolved issues current.
By default, CPU and memory threshold alerts are disabled and no alerts are published to the MID Server Issue [ecc_agent_issue] table. To enable both types of alerting, add these properties to the System Property [sys_properties] table, and then set their values to true:

• mid.threshold.resource.breach.enable.cpu.alerts
• mid.threshold.resource.breach.enable.memory.alerts

For details on adding system properties to the platform, see Add a property using sys_properties.list.

**Evaluation process**
This processing occurs whether or not alerting is enabled:

1. Every 10 minutes, each MID Server transmits its CPU and memory consumption metrics to the instance. The instance inserts CPU metrics into the **Mean CPU used %** field of the ECC Agent Scalar Metrics [ecc_agent_scalar_metric] table and memory metrics into the **Max memory used %** field of the ECC Agent Memory Metrics [ecc_agent_memory_metric] table.

2. After a successful insert, the following business rules run on each table, invoking a script include that calls an appropriate function. Each function takes an average of the metric sets inserted into the tables, based on the configured sampling intervals.

   - **Update cpu mean on MID Server Status**: Calls the MIDResourceThresholdBreach.checkCpuUsage() script include.
   - **Update max memory on MID Server Status**: Calls the MIDResourceThresholdBreach.checkMemoryUsage script include.

Each function takes an average of the metric sets inserted into the tables, based on the configured thresholds and sampling intervals. The instance first looks at each MID Server for configuration parameters that set custom threshold values or sampling intervals for that MID Server. If no configuration parameters for these attributes are found, the instance looks in the System Properties [sys_properties] table for custom values to use. If no properties are found, the instance uses the default threshold and interval values from the code.

**Note**: Both the threshold percentages and the sampling intervals are configurable. See Configuring thresholds and sampling intervals for details.

**Alerting process**
When alerting for CPU or memory thresholds is enabled, this processing occurs:
1. If the aggregated average metric value equals or exceeds the configured percent threshold, the instance triggers the mid.threshold.resource.breach event. Administrators can use this event to create email notifications for threshold breach alerts or to create a custom script.

2. The instance inserts a record of the breach into the MID Server Issue [ecc_agent_issue] table with a State value of New and a Count of 1, and then publishes a message containing all the pertinent details of the breach. An example of this message is Mean CPU used % has exceeded threshold (96>=91) for a 40 minute interval span, occurring after start date 2017-01-11 14:25:19. This message appears in the Short description field of the MID Server Issue form and in the event. You can copy any part of the message into your email notifications.

**MID Server issue states**

When the administrator first examines an issue in the MID Server Issue [ecc_agent_issue] table, the administrator can change the State of the issue to Acknowledged to indicate that the issue is being addressed. Each time the instance detects a breach, it attempts to match the breach with an existing issue. If a MID Server already has an issue record for that breach in a State of New or Acknowledged, the instance updates the Last Detected field with the current date/time and increments the Count field in the existing record. This prevents the creation of duplicate records in the MID Server Issue [ecc_agent_issue] table and records the number of times after the initial incident that the breach reoccurred. The administrator can increase MID Server resources gradually and watch the effect on the Count field. When the counter stops incrementing, the administrator knows that the MID Server has adequate resources. When the MID Server resource have been adjusted appropriately, the administrator sets the State to Resolved. If a new threshold breach is logged that matches a MID Server issue with a State of Resolved, the instance creates a new issue record.

⚠ **Note:** Any record in the MID Server Issue [ecc_agent_issue] table that has not been updated in 30 days is deleted, regardless of its state.

**Recommendations for resolving resource issues**

Administrators have the opportunity to resolve any resource issues with a MID Server when they receive notification of the event. Follow these recommendations for reducing the strain on MID Server resources:
• JVM memory:
  ◦ Allocate more max memory to the MID Server. For more information, see Set the MID Server JVM memory size.
  ◦ Add additional MID Servers to share the workload. For more information, see MID Server clusters.
  ◦ Reduce the amount of concurrent processing for the MID Server. This includes segmenting IP Address ranges into smaller segments for a Discovery schedule or loading smaller segments of data within an import job.

• CPU: Reduce the activity on the host or migrate the MID Server to a new host with more available resources.

ℹ️ Note: MID Server can create a resource usage spike during Discovery, especially discovering against a large number of targets or executing multiple Power Shell sessions concurrently. The MID Server host’s resource utilization automatically returns to normal after the Discovery execution successfully stops. To decrease CPU utilization, host the MID Server on a dedicated machine. If you encounter resource usage issues, make sure only one MID Server is run on each dedicated host machine. If the MID Server is hosted on a public cloud, add more CPU resources and avoid the noisy neighbor issue. For more information, see High CPU Usage on Host with MID Server(s) [KB0597639].

Tables used for resource threshold evaluation

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server Issue [ecc_agent_issue]</td>
<td>Stores data on various types of MID Server issues, including breaches of configured CPU and memory thresholds. Fields used for resource threshold breaches are:</td>
</tr>
<tr>
<td></td>
<td>• count: Number of times a previously reported threshold breach occurs, if the event is not marked Resolved.</td>
</tr>
<tr>
<td></td>
<td>• last_detected: Current date and time a threshold breach is detected. This field is updated each time a previously detected breach is found, if it is not marked Resolved.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>• <strong>message</strong>: Descriptive message summarizing the conditions that triggered the threshold breach event. This message includes the actual percentage of CPU and memory calculated and the configured thresholds that were breached.</td>
<td></td>
</tr>
<tr>
<td>• <strong>mid_server</strong>: Name of the MID Server experiencing the resource threshold breach.</td>
<td></td>
</tr>
<tr>
<td>• <strong>source</strong>: The issue source for the breach. These are the possible sources:</td>
<td></td>
</tr>
<tr>
<td>◦ <strong>CpuMIDResourceThresholdBreach</strong>: CPU threshold issue sources.</td>
<td></td>
</tr>
<tr>
<td>◦ <strong>MemoryMIDResourceThresholdBreach</strong>: Memory threshold issue sources.</td>
<td></td>
</tr>
<tr>
<td>MID Server Status [ecc_agent_status]</td>
<td>Stores the percentages used for the CPU and memory resources, averaged over configurable intervals for each resource. The fields used are:</td>
</tr>
<tr>
<td></td>
<td>• Mean CPU used %</td>
</tr>
<tr>
<td></td>
<td>• Max Memory used %</td>
</tr>
<tr>
<td>ECC Agent Scalar Metric [ecc_agent_scalar_metric]</td>
<td>Stores the CPU usage data inserted by each MID Server every 10 minutes. The table field used by resource threshold alerting is <strong>mean</strong>.</td>
</tr>
<tr>
<td>ECC Agent Memory Metric [ecc_agent_memory_metric]</td>
<td>Stores the memory usage data inserted by each MID Server every 10 minutes. The table field used by resource threshold alerting is <strong>max_used_pct</strong>.</td>
</tr>
</tbody>
</table>
Business rules that check for threshold breaches

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update cpu mean on MID Server Status</td>
<td>Runs after the MID Server inserts a record into the ECC Agent Scalar Metric [ecc_agent_scalar_metric] table. This business rule triggers the MIDResourceThresholdBreach script include function that evaluates threshold settings to determine if the MID Server has breached its configured CPU resource thresholds.</td>
</tr>
<tr>
<td>Update max memory on MID Server Status</td>
<td>Runs after the MID Server inserts a record into the ECC Agent Memory Metric [ecc_agent_memory_metric] table. This business rule triggers the MIDResourceThresholdBreach script include function that evaluates threshold settings to determine if the MID Server has breached its configured memory resource thresholds.</td>
</tr>
</tbody>
</table>

Configuring thresholds and sampling intervals
You can use the default threshold percentages and sampling intervals or configure custom values using either of these methods:

- Add system properties to the instance and change the default values for all MID Servers.
- Add configuration parameters to change the default resource values for individual MID Servers.

The system properties and the configuration parameters use the same names.

<table>
<thead>
<tr>
<th>Property/configuration parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mid.threshold.mean_cpu.aggregate_interval_span</td>
<td>10 minute units in the interval for sampling CPU usage data. The default interval is 30 minutes (3 x 10 min.)</td>
</tr>
</tbody>
</table>

Default: 3
<table>
<thead>
<tr>
<th>Property/configuration parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| mid.threshold.mean_cpu.percent  | Usage percentage of the total CPU resources that initiates a threshold breach alert.  
**Default:** 95 |
| mid.threshold.mean_max_memory.aggregate_interval_span | Number of 10 minute units in the interval for sampling memory usage data. The default interval is 30 minutes (3 x 10 min.)  
**Default:** 3 |
| mid.threshold.mean_max_memory.percent | Usage percentage of the total memory resources that initiates a threshold breach alert.  
**Default:** 95 |

**MID Server resource reporting**

The **MID Server dashboard** contains two reports that give you views into the consumption of CPU and JVM memory resources. These reports show usage over the previous 30 days.

- **Avg Percentage of CPU Used**: Trending the daily average on CPU usage helps illustrate the amount of CPU processing that the MID Server host consumes. MID Servers deployed on the same host will report the same CPU usage.

- **Avg Percentage of Max Memory Used**: The maximum used percentage *(max_used_pct)* is a useful metric for determining if the MID Server has enough memory resources. This metric is a percentage of the max used memory over the total available memory. Trending this over time provides a visualization of how much memory is needed by the MID Server.

**MID Server user connectivity issues**

The instance writes issues involving MID Server user logins and network connectivity to the MID Server Issue [ecc_agent_issue] table and creates events you can use in custom scripts or to send email notifications.

Records in the MID Server Issue [ecc_agent_issue] table can provide insight into why your MID Server user cannot log in or why a MID Server cannot connect to the instance. The system displays records for connectivity problems in this table that include informative error messages suggesting possible causes. By default, a scheduled job called MIDUserConnectivity runs every four hours and launches...
the MIDUserConnectivity script include to evaluate MID Server connection activity. Records in the MID Server Issue [ecc_agent_issue] table reflect the status of MID Server login attempts and connectivity at the time the scheduled job runs.

From the perspective of the instance, the MID Server is **Down** when:

- User authentication fails
- User authorization fails.
- Network issues prevent MID Server from establishing a TCP/IP connection.

**Note:** To associate a user with a MID Server, navigate to the servicenow/ `<mid server name>/agent/config.xml` file and enter the user credentials in the `mid.instance.username` and `mid.instance.password` parameters. Make sure to restart the MID Server to activate your changes.

**How issues are logged**

User authentication failures and authorization issues are logged automatically to the MID Server agent log file. The message for both is the same: **User cannot be authenticated or is missing the proper roles.** If the issue is related to authorization, the `agent.log` file shows the list of missing roles.

When debugging is enabled, MID Server issues are logged to the system log (syslog) and are available for display in either a **summary or a detailed format**. You can also change the sampling interval from the default 4 hours to something shorter for tracking your remediation efforts. For instructions on enabling and configuring debugging for MID Server user issues, see Test remediation efforts for MID Server user connectivity issues.

**Data provided**

When the instance encounters user connectivity issues, it opens a record in the MID Server Issue [ecc_agent_issue] table.
The MID Server Issue table contains these fields:

### MID Server issue fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last detected</td>
<td>Date and time the issue was last detected.</td>
</tr>
<tr>
<td>Short description</td>
<td>Contents of the generated message that specifies a possible issue with the named user or the MID Server.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Empty in the Jakarta release.</td>
</tr>
<tr>
<td>Issue source</td>
<td>The process that identified the issue. For all issues with MID Server user connectivity, the source is MIDUserConnectivity.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the issue. Possible states are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>New</strong>: Starting state when the instance creates the issue.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Acknowledged</strong>: State set when the administrator first examines the issue.</td>
</tr>
</tbody>
</table>
**User authentication failure**

The credentials that the instance uses to authenticate a MID Server user are configured in the MID Server Configuration Parameters [ecc_agent_config] table. If the MID Server user attempts to log into the instance with invalid credentials, the instance rejects the connection, and writes the `login.failed` event to the Events [sysevents] table for the user. Administrators can use this event in a custom script or in email notifications for authentication failure.

⚠ **Note:** If user authentication fails, user authorization is not attempted.

**User accounts associated with a MID Server**

Either of the following messages in the MID Server Issue [ecc_agent_issue] table indicate authentication failure for user accounts that are associated with a MID Server:

- Login authentication failure for User `<user name>` associated with 1 down MID Server. Check password on MID server.

- Login authentication failure for User `<user name>` associated with `<n>` down MID Servers. Check password on MID servers.

The necessary conditions for these messages to appear are:
• The Status field in the MID Servers [ecc_agent] table that is associated with the MID Server indicates that the MID Server is **Down**.

• The user identified in the MID Server Configuration Parameters [ecc_agent_config] table is the user that one or more MID Servers is configured to use for authentication and authorization when connecting to the instance. The record in the [ecc_agent_config] table must have these values:
  ◦ Parameter name [param_name] field set to **mid.instance.username**.
  ◦ Value [value] field set to the user’s name, corresponding to the User ID [user_name] field in Users [sys_user] table.

• The Events [sysevent] table contains posts showing that the last login attempt associated with the user failed during the scheduled time period. The record created in the [sysevent] table contains these field values:
  ◦ Event Name [name] field is set to **login.failed**.
  ◦ Parm1 [parm1] field is set to the user’s name.

⚠ **Note:** The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is empty (=NULL).

**User accounts with the mid-server role not associated with a MID Server**

The following message appears when a user with the mid_server role who is not associated with a MID Server fails to authenticate: **Login authentication failure for User **<user name>** with mid_server role not associated with a MID Server.**

The necessary conditions for this message to appear are:

• The User Roles [sys_user_has_role] table contains a record linking the sys_id associated with the user record stored in the [sys_user] table, with the sys_id associated with the mid_server role record stored in the [sys_user_role] table.

• The user is not identified in the MID Server Configuration Parameters [ecc_agent_config] table as the user whom one or more MID Servers are configured to use for authentication and authorization when connecting to the instance.

• The Events [sysevent] table contains posts showing that the last login attempt associated with the user failed during the scheduled time period:
  ◦ The [sysevent] table contains a record with the Event Name [name] field set to **login.failed**.
  ◦ The Parm1 [parm1] field is set to the user’s name, corresponding to the User ID [user_name] field in Users [sys_user] table.
Note: The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is empty (=NULL).

User authorization failure

The user authorization check occurs after the MID Server has successfully authenticated on the instance. In this step, the system ensures that the user account associated with a MID Server is granted the minimum roles required. A SOAP web service called MIDServerCheck performs the role checking on the instance. If the MID Server user has the proper roles, the connection is allowed and a login event is written to the Events [sysevents] table. If the user does not have the proper roles, the instance writes a login.authorization.failed event to the Events [sysevents] table. This event provides a comma separated list of the user's missing roles. Administrators can use this event in custom scripts or in email notifications for authorization failure.

Authorization can fail if a user is missing the mid_server role or any of the important SOAP roles, as in these cases:

- If the user has the soap_script role, the MIDServerCheck SOAP web service runs to check for the appropriate MID Server roles. If the user lacks the mid_server role or any of the other SOAP roles, authorization fails, and the login.authorization.failed event is created.

- If the user is missing the soap_script role, that user is not authorized to launch the MIDServerCheck SOAP web service, which checks for all required MID Server roles. Authorization fails, but the login.authorization.failed event is not created. When this occurs, the instance displays this message: Connectivity of MID Server user <user name> cannot be detected by the instance.

Users associated with one or more down MID Servers

Either of the following messages in the MID Server Issue [ecc_agent_issue] table indicate authorization failure for user accounts that are associated with a MID Server that is Down:

- Login authorization failure for User <user name> associated with 1 down MID Server. Re-assign mid_server role to grant all required roles.

- Login authorization failure for User <user name> associated with <n> down MID Servers. Re-assign mid_server role to grant all required roles.

The MIDUserConnectivity script includes identifies active users associated with one or more down MID Servers whose last login attempt within the reporting period failed user authorization. This message is generated when user authorization failures are detected and reported by the MIDServerCheck scripted web service. However, user authorization failures are not reported for
users who are not assigned the soap_script role. Should this occur, problems with the user are reported by the network connectivity message.

This message appears in the MID Server Issue [ecc_agent_issue] table when:

- The user may or may not have the mid_server role.
- The user is identified in the MID Server Configuration Parameters [ecc_agent_config] table as the user whom one or more MID Servers are configured to use for authentication and authorization when connecting to the instance.
- The Events [sysevent] table contains posts showing that the last login attempt associated with the user failed during the scheduled time period. The [sysevent] table contains a record with these settings:
  - Event Name [name] field set to login.authorization.failed.
  - Parm1 [parm1] field set to the user’s name, corresponding to the User ID [user_name] field in Users [sys_user] table.

Note: The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is empty (=NULL).

Users with the proper role not associated with a MID Server

The following message appears when a user with the mid_server role who is not associated with a MID Server fails authorization: **Login authorization failure for User <user name> with mid_server role not associated with a MID Server.**

This message is generated when user authorization failures are detected in which the user account, with the mid_server role, is not identified as a configured MID Server user in the [ecc_agent_config] table. It is possible that the user account was associated with a MID Server at the time of the failure.

This message appears in the MID Server Issue [ecc_agent_issue] table when:

- The user has the mid_server role. The User Roles [sys_user_has_role] table has a record linking the sys_id associated with the user record stored in the [sys_user] table, with the sys_id associated with the mid_server role record stored in the [sys_user_role] table.
- The user is not identified in the MID Server Configuration Parameters [ecc_agent_config] table as the user whom one or more MID Servers are configured to use for authentication and authorization when connecting to the instance.
- The Events [sysevent] table contains posts showing that the last login attempt associated with the user failed during the scheduled time period. The [sysevent] table contains a record with these settings:
Event Name [name] field set to login.authorization.failed.

Parm1 [parm1] field set to the user’s name, corresponding to the User ID [user_name] field in Users [sys_user] table.

Note: The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is empty (=NULL).

Network issues

A network issue can prevent the MID Server from connecting to the instance’s TCP/IP server to begin a session. In this case, the instance marks the MID Server as Down, because the instance failed to receive the MID Server heartbeat within the prescribed 5 minute interval.

Users associated with down MID Servers who have not attempted to log in

Either of the following messages in the MID Server Issue [ecc_agent_issue] table name users associated with MID Servers who have not attempted to log in during the reporting period:

• User <user name> is associated with 1 down MID Server. No login attempts within reporting period.
• User <user name> is associated with <n> down MID Servers. No login attempts within reporting period.

The MIDUserConnectivity script include reports active users associated with down MID Servers where network connectivity cannot be detected by the instance.

This message appears in the MID Server Issue [ecc_agent_issue] table when:

• The user may or may not have the mid_server role.
• The user is identified in the MID Server Configuration Parameters [ecc_agent_config] table as the user which one or more MID Servers are configured to use for authentication and authorization when connecting to the instance.
• There are no login attempts, either failed or successful, recorded in the Events [sysevent] table for the user during the scheduled reporting period.

Note: The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is empty (=NULL).

Users not associated with MID Servers who have not attempted to log in

The following message appears when a user with the mid_server role who is not associated with a MID Server has not attempted to login during the configured
reporting interval: **User <user name> with mid_server role is not associated with a MID Server. No login attempts within reporting period.**

The MIDUserConnectivity script include reports active users with the mid_server role not associated with a MID Server, where connectivity cannot be detected by the instance.

This message appears in the MID Server Issue [ecc_agent_issue] table when:

- The user has the mid_server role. The User Roles [sys_user_has_role] table has a record linking the sys_id associated with the user record stored in the [sys_user] table, with the sys_id associated with the mid_server role record stored in the [sys_user_role] table.
- The user is not identified in the MID Server Configuration Parameters [ecc_agent_config] table as the user whom one or more MID Servers are configured to use for authentication and authorization when connecting to the instance.
- There are no login attempts, either failed or successful, recorded in the Events [sysevent] table for the user during the scheduled reporting period.

**Note:** The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is empty (=NULL).

**Configuration issues**

Any of the following messages, discussed above, can indicate a configuration issue:

- **Login authentication failure for User <user name> with mid_server role not associated with a MID Server.**

- **Login authorization failure for User <user name> with mid_server role not associated with a MID Server.**

- **User <user name> with mid_server role is not associated with a MID Server. No login attempts within reporting period.**

These are some common configuration errors:

- An administrator neglected to associate the user record with the MID Server record as shown in the MID Server Configuration Parameters [ecc_agent_config] table. This table is read-only and cannot be updated directly. To associate a user with a MID Server, configure the user name and password in the MID Server’s config.xml file and restart the MID Server.
During the process of reconfiguring a MID Server to use a different account for TCP/IP connection, the administrator has not yet removed the mid_server role from the account or deleted the account.

A multipurpose user account was created and granted a large number of roles, including the mid_server role, although this account was never intended to be used as a MID Server account.

**User who successfully authenticates and authorizes but might not need mid_server role**

The following message appears when a user with the mid_server role who is not associated with a MID Server successfully logs in: **User <user name> with mid_server role successfully connected but not associated with a MID Server.**

The mid_server role should be reserved for MID Server use only.

The MIDUserConnectivity script include reports active users with the mid_server role who are not identified as a configured MID Server user, and whose last login attempt was successful during the scheduled time period. This message suggests that the user’s credentials are being used by a system administrator or a process that is not running on a MID Server. The assumption here is that the mid_server role should only be used for applications deployed to a MID Server. The presence of this message reminds the system administrator to remove extraneous mid_server roles from user accounts that do not require them.

This message appears in the MID Server Issue [ecc_agent_issue] table when:

- The user has the mid_server role.
- The user is not identified in the MID Server Configuration Parameters [ecc_agent_config] table as the user whom one or more MID Servers are configured to use for authentication and authorization when connecting to the instance.
- The Events [sysevent] table contains posts showing that the last login attempt associated with the user succeeded during the scheduled time period. The [sysevent] table contains a record with these settings:
  - Event Name [name] field set to login.
  - Parm1 [parm1] field set to the user’s name, corresponding to the User ID [user_name] field in Users [sys_user] table.

**Note:** The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is empty (=NULL).
Test remediation efforts for MID Server user connectivity issues

After attempting to resolve a user connectivity issue that appears in the MID Server Issue [ecc_agent_issue] table, you can test your remediation efforts without having to wait until the next scheduled reporting period by shortening the sampling interval.

Before you begin
Role required: admin

About this task
Reconfigure the sampling interval using this procedure and then examine the results in the MID Server Issue [ecc_agent_issue] table. You can set any time span for the sample, but you should define a window of not less than 5 minutes, since this is the default interval of the MID Server heartbeat that reports its status. The recommended method for configuring a shorter sampling interval is to copy and modify the code from the MIDUserConnectivity scheduled job, and then run it manually in the background script utility.

CAUTION: Avoid editing the script in the MIDUserConnectivity schedule record. If you make any change to this record, it will not be updated when you upgrade the instance.

Procedure
1. Navigate to System Definition > Scheduled Jobs.
2. Open the MIDUserConnectivity scheduled job.
3. Copy this line from the Run this script field:
   MIDUserConnectivity(0).checkConnectivity(4 * (60 * 60 * 1000));
   This code sets the 4 hour sampling interval in milliseconds and turns debugging off with the MIDUserConnectivity(0) value.
4. Navigate to System Definition > Scripts - Background.
5. Paste the code from the scheduled job into the Run script field.
6. Set the sampling interval to 5 minutes by changing the time calculation to (5 * 60 *1000).
   The modified command looks like this:
   MIDUserConnectivity(0).checkConnectivity (5 * 60 *1000);
7. Click Run script.
8. Open the record of the MID Server that had the issue and select the MID Server Issues related list.
   The issue is updated as follows:
• If the issue persists, the **Count** column is incremented, and the **Last detected** column shows the current date and time.

• If the issue no longer exists, the system changes the **State** to **Resolved**.

9. Optionally, you can enable debugging by selecting a level, and then run the script again to see the breakdown for each condition evaluated. Use these settings to select a debugging level:

• For a summary view, enter `MIDUserConnectivity(1)`.

• For a detailed view, enter `MIDUserConnectivity(2)`.

For details about the type of debugging information provided, see **Interpreting MID Server user debugging output**.

**Interpreting MID Server user debugging output**

Debugging output from the system log is available in either a summary or detailed view for MID Server user issues, but must be enabled manually.

To enable debugging and display all connectivity issues in either of the available formats, you must run a method manually on your instance. For instructions on enabling debugging, see **Test remediation efforts for MID Server user connectivity issues**. For information about each error condition and how records are created in the MID Server Issue `[ecc_agent_issue]` table, see **MID Server user connectivity issues**.

**Available formats**

You can configure the instance to generate a simple summary of the issue or a detailed output that identifies users and MID Servers. Summaries provide a quick look at the issue conditions, by count, while the detailed view allows you to examine roles, MID Server associations, and login activity by named users.

In this summary example of an authorization issue, the instance evaluates each condition and indicates how many users met that condition. You can see that a MID Server is down and that one of two users configured for a MID Server failed authorization. Because this is a summary, neither the MID Server nor the users are named.

**Sample summary debug output**

```bash
[0:00:00.014]: Script completed in scope global: script
** Script: Log Object: MIDUserConnectivity JobSchedulerDateTime 2017-02-21 17:31:08
** Script: Log Object: MIDUserConnectivity JobSchedulerDateTime (current users display format and timezone) 2017-02-21 17:31:08
** Script: MIDUserConnectivity found (1) user(s) with the mid_server role defined
** Script: MIDUserConnectivity found (1) user(s) with the mid_server role defined
** Script: MIDUserConnectivity found (2) configured MID Server UsersID
** Script: MIDUserConnectivity found (1) user(s) with the MID Server role MID_ServersUser defined
** Script: MIDUserConnectivity found (2) configured MID Server UsersID
** Script: MIDUserConnectivity found (1) user(s) whose most recent login attempt during the reporting period failed
** Script: MIDUserConnectivity found (1) user(s) whose most recent login attempt during the reporting period failed
** Script: MIDUserConnectivity found (1) user(s) whose most recent login attempt during the reporting period succeeded
** Script: MIDUserConnectivity found (2) configured MID Server Users where connectivity to the MID by the instance can not be detected
** Script: MIDUserConnectivity found (1) new message(s) skipped by the auto-resolve
** Script: MIDUserConnectivity: processing completed
```
Authentcation failure
When a MID Server user cannot authenticate on the instance, the system displays these error messages in the detailed output:

- Login authentication failure for User <user name> associated with 1 down MID Server. Check password on MID server.
- Login authentication failure for User <user name> associated with <n> down MID Servers. Check password on MID servers.
- Login authentication failure for User <user name> with mid_server role not associated with a MID Server.

In this example, three users with the mid_server role, midserv2, local-midserver, and ardis.maison, failed to authenticate. Two of these users were configured for MID Servers that were Down, and the other user was not configured for any MID Servers. Each of these users has an authentication failure and is named in the appropriate error message.

Detailed debugging log for authentication failure

MID Server ID map
The debugging output lists all MID Servers that are marked as Down and maps them to their user accounts by the MID Server sys_id. This map includes all user
accounts that have the mid_server role, whether or not they are associated with a MID Server. If there are no Down MID Servers, the map is not displayed in the debugging output.

The map is presented in three sections:

- User accounts not associated with any MID Servers.
- User accounts associated with Down MID Servers, identified by their sys_id.
- The sys_id of each Down MID Server, identified by name.

**MID Server ID map**

![Map of MID Server IDs]

**Authorization failure**

If a user is missing any of the required roles, the instance generates these authorization failure messages:

- Login authorization failure for User `<user name>` associated with 1 down MID Server. Re-assign mid_server role to grant all required roles.
- Login authorization failure for User `<user name>` associated with `<n>` down MID Servers. Re-assign mid_server role to grant all required roles.
- Login authorization failure for User `<user name>` with mid_server role not associated with a MID Server.

In this example, three users with the mid_server role, `midserver2`, `local-midserver`, and `ardis.maison` have failed authorization. One user is not associated with any MID Server, but the other two users are. The system has logged an authorization failure, indicating that the user is missing at least one critical role. To see what roles are missing, look at the comma separated list in the Parm2 field in the `login.authorization.failed` event record. This record is the most recent login attempt in the Event [sysevent] table for the user account within the reporting period.
Detailed debugging log for authorization failure

**Network issues**

Network issues may exist for these users who are associated with MID Servers, but who have not attempted to log in during the reporting period:

- **User <user name>** is associated with 1 down MID Server. No login attempts within reporting period.

- **User <user name>** is associated with <n> down MID Servers. No login attempts within reporting period.

Network issues may also exist for these users who are NOT associated with MID Servers, and who have not attempted to log in during the reporting period: **User <user name>** with mid_server role is not associated with a MID Server. No login attempts within reporting period.

In this example, no login attempts have been detected for midserver2, local-midserver, and ardis.maison, all of whom have the mid_server role. Two of those users are associated with MID Servers that are marked Down. The other user is not associated with any MID Server. None of these users has attempted to log in to the system within the configured reporting interval. The system assumes that these users would make an attempt to log in unless network issues prevented them from doing so.

**Note:** By default, the sampling period is 4 hours. However, during debugging or remediation, the sampling period can be reset to a value that matches the MID Server heartbeat interval of 5 minutes, or greater.
Detailed debugging log for network connection issues

**Script: Log Object: MIDUserConnectivity: activeUserIDsWithMIDServerRole**

Array of 3 elements
- [0]: string = adisa.maison
- [1]: string = midserver2
- [2]: string = local-midserver

**Script: Log Object: MIDUserConnectivity: downMIDServerConfiguredUserIDs**

Array of 2 elements
- [0]: string = midserver2
- [1]: string = local-midserver

**Script: Log Object: MIDUserConnectivity: userMIDServerMap**

Object
- adisa.maison: Object
  - sys_domain: string = global
  - mid_server: Array of 0 elements
  - midserver2: Object
    - sys_domain: string = global
    - mid_server: Array of 2 elements
      - [0]: string = f0a68f154b0b2320f7b30d3b237069e9
      - [1]: string = db2ced3e721300f7b30d3b237069e9

Any of the following messages can indicate a user configuration issue:

- Login authentication failure for User <user name> with mid_server role not associated with a MID Server.
- Login authorization failure for User <user name> with mid_server role not associated with a MID Server.
- User <user name> with mid_server role successfully connected but not associated with a MID Server. The mid-server role should be reserved for MID Server use only.
- User <user name> with mid_server role is not associated with a MID Server. No login attempts within reporting period.

In this example, a user with the mid_server role has logged in successfully within the configured sampling interval. However, this user is not configured for a MID Server and might have the role in error.
Detailed debugging log for MID Server user account login

**Detailed debugging log for MID Server user account login**

Use this module to troubleshoot errors that occur during the MID Server upgrade process. The MID Server Upgrade Histories table contains a record of each instance upgrade. The MID Server Upgrade Stages table shows the status of each MID Server and its upgrade progress, including any errors encountered.

**MID Server Upgrade History**

Use this module to troubleshoot errors that occur during the MID Server upgrade process. The MID Server Upgrade Histories table contains a record of each instance upgrade. The MID Server Upgrade Stages table shows the status of each MID Server and its upgrade progress, including any errors encountered.

**MID Server Upgrade Histories**

Users with admin or agent-admin roles can find detailed information for any MID Server upgrade in the Upgrade History module for MID Server. Whenever an instance is upgraded, all MID Servers in the Up state are upgraded automatically. The Upgrade History module uses the MID Server Upgrade Histories table [ecc_agent_upgrade_history]. This table shows the following information:

- The old instance version.
- The new version.
- The number of successfully upgraded MID Servers.
- The number of MID Servers with pending upgrades. MID Servers have pending upgrades if the upgrade has failed or is in progress.

**MID Server Upgrade Stages**

Select an instance record to see more details about the MID Servers upgraded with that instance. The Pending Upgrades and Complete Upgrade Details related lists use the MID Server Upgrade Stages table [ecc_agent_upgrade_history_stage]. MID Servers pinned to a specific version generate an entry with a blank MID Upgrade History on the MID Server Upgrade Stages table [ecc_agent_upgrade_history_stage].
### MID Upgrade History

<table>
<thead>
<tr>
<th>MID Upgrade History</th>
<th>Refers to a corresponding record in the [ecc_agent_upgrade_history] table.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stage</td>
<td>Shows the progress of the MID Server through each stage of the upgrade process.</td>
</tr>
<tr>
<td>State</td>
<td>Shows the status of each stage.</td>
</tr>
<tr>
<td>Message</td>
<td>Displays dynamically generated messages about the upgrade stages, such as the file path to download directories or extract folders. It also displays information about any errors encountered, even if those errors do not block the upgrade.</td>
</tr>
</tbody>
</table>

### MID Server reference information

MID Server reference information includes system requirements and other information you need to configure a MID Server for your specific needs.

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

### System clones and the MID server

See KB0547597 for information on what to do with MID Servers when you are cloning your instance.
Reference topics

System requirements
Use the minimum system requirements to allocate resources for computers hosting MID Servers.

ECC Queue
Learn about the External Communication Channel (ECC) Queue, which is the connection point between the MID Server and the instance. Jobs that the MID Server needs to perform are saved in this queue until the MID Server is ready to handle them.

MID Server Dashboard
Use the reports and gauges in the MID Server dashboard to monitor ongoing operations.

MID Server properties
Use MID Server properties to control the behavior of all MID Servers or a particular MID Server.

MID Server parameters
Use MID Server parameters to control the behavior of a particular MID Server.

MID Server protected records and reserved characters
Some MID Server records cannot be altered. Certain special characters are pre-defined in XML and cannot be used in passwords.

MID Server privileged commands
To discover certain information on a host server, the MID Server must run SSH commands with higher privileges. The platform provides default privileged commands for the MID Server to use and the ability to add additional commands to the system.

MIDSystem methods
MIDSystem variables (referred to by the variable name ms.) provide a variety of methods to get information about the MID Server.

MID Server heartbeat
Configure the interval that the instance uses when it checks the "heartbeat" of MID Server. By default, the instance checks the MID Server for a response every 5 minutes.

Set JVM memory size
Modify the JVM setting for your MID Server from the default size to suit the amount of work your MID Server does in your network.

**Pause the MID Server**

Pause the MID Server to temporarily prevent it from polling the ECC Queue for work or sending Discovery results back to the instance.

**MID Server system requirements**

Use these minimum system requirements to allocate resources for computers hosting MID Servers.

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

**MID Server supported systems**

**Windows server**

To discover Windows-based servers, run Service Mapping patterns, or execute Orchestration commands on Windows devices, the MID Server must be installed on a Windows server. The MID Server supports these Windows operating systems, including virtual machines and 64-bit systems:

- Windows Server 2012
- Windows Server 2016
- Windows Server 2019

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**Note:** .NET Framework version 3.5, 4.0, 4.5, 4.6, or 4.7 is required for Service Mapping support and for Windows pattern-based discovery.

**Linux**

The MID Server is supported on these Linux versions for virtual machines and 64-bit systems:

- Linux Red Hat 6 and above
- Ubuntu 1404 (Ubuntu 14) and above
- CentOS 6 and above

**Note:** ServiceNow no longer supports new installations of 32-bit MID Servers or upgrades to version Rome. New MID Server installation are blocked through RPM and MSI installer on the following operating systems:

- CentOS 6
- Windows server 2008
- Windows server 2008 R2
- Windows 8
- Windows 10

Unsupported MID Servers auto-upgrading to Rome create an issue record in MID Server Issues (ecc_agent_issue). For more information, see Supported platform changes for MID Server [KB0863694].

**Security requirements**

To meet high security standards, the MID Server performs x.509 certificate validation on HTTPS traffic when connecting to ServiceNow®. If a network appliance or proxy exists between the MID Server and the instance, that appliance needs to present a digital certificate signed by a trusted CA. If you are using a self-signed certificate or a certificate signed by an internal CA, please import the certificate to the MID Server truststore. For more information on adding SSL certificates, see Add SSL certificates for the MID Server.

**OCSP connectivity requirements**

The Online Certificate Status Protocol (OCSP) is the protocol used to determine the revocation status of SSL/TLS certificates. When certificates are exchanged and validated, the MID Server needs to determine if the certificate has been revoked and shouldn't be trusted.
OCSP works by using a client, such as a MID Server, to receive a certificate from an HTTP website. The client sends a request to an OCSP responder: a server operated by the certificate authority (CA) that issued the certificate. The OCSP responder’s response to the client indicates whether the certificate is valid or has been revoked.

In order to connect, the MID Server requires access to:

- servicenow.com
- install.service-now.com
- ocsp.entrust.net (or other OCSP CA)

While SSL/TLS certificates are always issued with an expiration date, there are certain circumstances in which a certificate must be revoked before it expires (for example, if its associated private key may have been compromised). Therefore, the current validity of a website’s certificate must always be checked by clients regardless of its expiry date.

Clients fail a connection when they can’t check the revocation status of a certificate. Firewalls and proxy configurations may block calls to the OCSP Entrust server, which prevents the MID Server from working. You may need to change your firewall permissions so the OCSP traffic to go through properly. For more information and resolutions, see the HI Knowledge Base article [KB0813636].

**PowerShell requirements**

The MID Server requires the minimum PowerShell version 3.0 and supports versions up to PowerShell 5.1. To find your current PowerShell version using the instance, go to `ecc_agent_list.do`. Using the Update Personalize List gear icon, add Host PowerShell Version to the Selected column. Then sort the list of MID Servers by their PowerShell version to find outdated MID Servers. Alternatively, you can find the PowerShell version on the host machine by using the command `$Host.Version` in the host's PowerShell console. The PowerShell version is listed as PSVersion.

**Java version support**

Java 11 is bundled with the MID Server installer package and is installed on the host for all new MID Servers. The installer automatically configures Java 11 to run in your environment. No additional configuration is required. This version supports both 64-bit and 32-bit Windows MID Servers, and 64-bit Linux MID Servers. For the best performance, install the 64-bit MID Server for your operating system. The MID Server requires a minimum JRE version 1.8.0_161, and recommended version...
11.0.8. If you are using a lower version than 1.8.0_161, you may see encryption related issues.

Testing showed that the MID Server works as expected with Oracle Java 11 version 11.0.5 and Oracle JRE 8 version 1.8.0_231. However, Oracle JRE 8 version 1.8.0_231 requires the workaround described in the HI Knowledge Base article MID Server running Oracle JRE version 8 [KB0784442]. If you need to upgrade the JRE to a different version, then coordinate with the appropriate account representative for support.

Upgraded MID Servers might use different Java versions depending on their operating system versions.

• MID Servers upgraded from earlier versions use the OpenJDK provided with the MID Server installer. This version of the OpenJDK was tested and certified for use with these MID Servers.

• The JRE version is not upgraded when upgrading 32-bit Linux MID Servers or Linux with glibc versions lower than 2.17. The MID Server will continue to use earlier the earlier version of JRE, such as 1.8.0_231.

• MID Servers upgraded on any other operating system versions also automatically upgrade the JRE to the version provided with the installation package.

⚠️ Note: Linux MID Servers require glibc version 2.17. The library must be updated for JRE 11. On 64-bit Linux systems, you must install the 32-bit GNU C library (glibc). The installation command for CentOS is: `yum install glibc.i686`

**MID Server JRE downgrade support**

If the ServiceNow® instance is downgraded from Quebec, then the MID Server is also downgraded. However, the JRE may not be downgraded unless the instance is downgraded to one of the following patches.

• New York Patch 12
• Orlando Patch 9
• Paris Patch 3

If the MID Server is downgraded from Quebec to a different patch than specified, follow the instructions in Install Java 11 on MID Servers [KB0752451].

**Java Service Wrapper**

The MID Server installer includes the Tanuki Software Java Service Wrapper, version 3.5.40.
Setting the JVM Memory size

The MID Server installs with 1 GB of JVM memory. If the suggested memory size for your product is greater than 1 GB, see Set the MID Server JVM memory size for the procedure to override the default setting.

Deployment types

System requirements for your instance are determined by the needs of the individual products you use that require a MID Server. Some applications, such as Health Log Analytics, have additional system requirements listed in their documentation.

Standard deployments

The following products are considered "standard" because their MID Servers share the same minimum disk space and memory requirements:

- Discovery
- Event Management
- Integrations
- Orchestration
- Service Mapping

The minimum standard requirements pertain to both a single product and a combined product deployment. You can deploy a single MID Server for multiple standard products without significantly increasing the disk or memory requirements.

High resource deployments

Cloud Management Platform (CMP) and Operational Intelligence are processing intensive and require more resources for each MID Server than the standard products. Install MID Servers for these products on dedicated hosts that do not support MID Servers for other products.

Recommended MID Server minimum requirements

MID Server performance and system requirement are driven by multiple factors including but not limited to:

- The size of the customer infrastructure and specific function (Capability) MID Server is configured to perform.
- The number of MID Servers installed on the host.
- The number of threads per MID Server.
• The number and nature of other applications running on MID Server host.

• Architectural and design enhancements over ServiceNow releases. For example, using PowerShell for Windows Discovery in Orlando or changing default Java Garbage Collection policy in Quebec.

As a result, there is no one size requirement that fits for all MID Server deployments. The following documented sizing guidelines can be a starting point for deployments. However, customers need to monitor MID Server performance and resource utilization continuously, then tune and scale up their MID Servers as needed.

**MID Server minimum system requirements**

The minimum CPU configuration required for a MID Server is a quad core processor with a speed of 2+ GHz for a Windows Server 2012 R2 host with a single MID Server deployed and with standard configuration of 25 concurrent threads.

**MID Server CPU utilization**

Most of the MID Server applications, such as Discovery, are designed for maximizing their performance which results in maximizing the resource utilization for the MID Server. As a result, some customers might observe very high CPU utilization segments in the range of 90-100% while the MID Server is running Discovery schedules or similar applications.

The very high CPU utilization segments should not be a cause for concern because it aligns with architectural design of maximizing the throughput and does not have any negative impact on the Discovery performance. The MID Server host’s resource utilization automatically returns to normal after the Discovery execution successfully stops.

Customers who notice frequent and long very high CPU utilization segments should avoid:

• Running more than one MID Server on same host when these MID Servers are expected to process active workloads at the same time, such as overlapping Discovery schedules.

• Sharing the MID Server host with other applications.

• Configuring performance alerts, which are purely based on CPU utilization, on MID server host. If required, these alerts need to be used in conjunction with other performance monitors.

**Configuring additional performance monitoring on MID Server host**
While CPU utilization on MID server is a good indicator of load on the host, it gives only limited visibility. Additional monitoring with System Processor Queue Length on Windows Operating Systems and Load Averages on UNIX Operating Systems is crucial.

- **Processor Queue Length (Windows OS):** the number of threads that are ready but currently unable to run on the processor due to another active thread. A bottleneck on the processor may occur where the number of threads in the queue is more than twice the number of processor cores over a continuous period.

- **Load Averages (Unix OS):** the average system load on a Linux server for a defined period. It is the CPU demand on a server that includes sum of the running and the waiting threads. Typically, the top or the uptime command provides the load average of the server with output.

### MID Server CPU Performance Case Studies

**The impact of modifying number of MAX threads on MID Server CPU utilization**

Based on internal benchmarking, the following is sample data for MID Server CPU utilization while running Cloud Discovery for 10,000 servers.

In these tests, the maximum CPU utilization was observed to be 100% independent of number of threads and OS. The average CPU utilization was observed to be proportional to number of threads. Increasing number of threads did not necessarily result in immediate CPU pressure. Increasing the number of threads from the default 25 to 50 did not create additional CPU pressure, as shown by the max processor queue length. However, increasing the max threads value to 100 caused a significant increase in processor queue length, indicating CPU pressure.

**The impact of sharing MID Server with other applications or MID Servers on CPU utilization**
Running Discovery is a CPU intensive operation for MID Server. Deploying other applications or MID Servers on same host creates additional CPU pressure on the host. This pressure results in a performance impact for running applications, including the MID Server. The following examples are sample CPU utilization data points for MID Server with different load patterns:

**Dedicated host for a single MID Server:** the average CPU usage is 48%.

**Host shared between a MID Server and another application with moderate load:** the average CPU usage is 77%.

**Host shared between a MID Server and another application with heavy load:** the average CPU usage is 97%.
Scaling up MID Server and its impact on MID Server CPU resource utilization

When the MID Server is heavily constrained on CPU resources, scaling up the MID Server host, by adding more CPUs, helps ease resource pressure. However, this may not necessarily eliminate the very high CPU usage segments. MID Server applications like Discovery, which are designed for maximizing the performance, will continue to use additional available CPU resources. The following examples are sample CPU utilization data points for a 4 CPU MID Server host and an 8 CPU MID Server host running same Discovery schedules:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>4 CPU</th>
<th>8 CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average CPU%</td>
<td>48%</td>
<td>28%</td>
</tr>
<tr>
<td>Max CPU %</td>
<td>98%</td>
<td>98%</td>
</tr>
</tbody>
</table>

MID Server CPU utilization when deployed on a 4 CPU host:
Monitoring performance
To ensure that the MID Server resource allocations are sufficient for your environment, monitor performance during peak periods of product execution from the MID Server dashboard.

MID Server ECC Queue
The External Communication Channel (ECC) Queue is a connection point between an instance and the MID Server. Jobs that the MID Server needs to perform are saved in this queue until the MID Server is ready to handle them.

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security
Asynchronous Message Bus

The MID Server subscribes to messages published by the Asynchronous Message Bus (AMB), which notifies the MID Server that it has pending tasks in the ECC Queue. If a job exists in the ECC Queue for that MID Server, the MID Server sets the status to "I'm working on it." When finished working on a requested job, the MID Server reports back to the ECC queue with the results.

The MID Server opens a persistent connection to the instance through the AMBClient and listens on the /mid/server/<mid_sys_id> AMB channel. When an output record is inserted into the Queue [ecc_queue] table, an AMB message is sent to the MID Server's channel. The MID Server receives this message and immediately polls the ecc_queue table for work.

The MID Server polls the ECC queue on the regular interval defined in the mid.poll.time configuration parameter, regardless of AMB message activity. The default polling interval is set to 40 seconds, but can be reconfigured. This polling of the ECC queue at a regular interval is done in case the AMB connection is dropped.

MID Server ECC queue polling process
**Note:** The AMB client on the MID Server does not work in all environments and might need to be disabled to avoid performance issues. To disable AMB in your environment, set the `mid.disable_amb` parameter to `true`. When you disable AMB, the MID Server reverts to a default polling interval of 5 seconds, unless the `mid.poll.time` parameter is set to a different value.

**ECC Queue information**

You can access the ECC Queue by navigating any of these paths:

- Discovery > Output and Artifacts > ECC Queue
- Discovery > Discovery Schedules > `{schedule name}` > `{Discovery status record}`
- ECC > Queue
- `{Discovery Status record}` > ECC Queue

An ECC Queue provides the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent</td>
<td>The name of the external system that this messages is either from or to. If the message is from or to a MID Server, the agent name is in the form <code>mid.server.xxx</code>, where <code>xxx</code> is the name of a particular MID Server.</td>
</tr>
<tr>
<td>Topic</td>
<td>The name of the probe the MID server ran. If you are using a pattern for discovery, the Horizontal Pattern probe appears.</td>
</tr>
<tr>
<td>Name</td>
<td>The actual command the probe ran. For example, if <strong>Topic</strong> is SSHCommand, then the <strong>Name</strong> field contains the actual shell command to run. If you are using a pattern for discovery, the following appears:</td>
</tr>
<tr>
<td></td>
<td><strong>Pattern Launcher:</strong> followed by the name of the pattern and the multipage number.</td>
</tr>
<tr>
<td>Source</td>
<td>The IP address that the discovery is to run against. A few probes run against multiple IP addresses; in those cases, this field contains a human-readable description.</td>
</tr>
<tr>
<td>Response to</td>
<td>This optional field contains a reference (sys_id) to the ECC Queue message that this message is in response to. Discovery makes extensive use of this field to track the hierarchy of messages that result from a given scheduled Discovery. Click the record icon for the value in this field to open the ECC Queue record for the activity that spawned the current probe or sensor record.</td>
</tr>
<tr>
<td>Field</td>
<td>Input value</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Queue</td>
<td>An indicator of whether this message was an input message or an output message.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the current ECC queue record. States update automatically.</td>
</tr>
<tr>
<td>Processed</td>
<td>The time when this message was processed.</td>
</tr>
<tr>
<td>Created</td>
<td>The time when this message was created.</td>
</tr>
<tr>
<td>Sequence</td>
<td>The unique sequence number for this message. This value is automatically generated when an ECC Queue record is inserted. Its use is deprecated.</td>
</tr>
<tr>
<td>Error string</td>
<td>An error message, if an error occurred during processing. This field is hidden on the standard form unless there was an error.</td>
</tr>
<tr>
<td>Payload</td>
<td>The body of the message in XML format. The returned XML has a root tag of <code>&lt;results&gt;</code> containing one or more <code>&lt;result&gt;</code> tags and a single <code>&lt;parameters&gt;</code> tag. The parameters are simply an echo of those sent to the MID server in the probe; they vary from probe to probe, but in general they tell the probe the details of what it is to do and how it should behave. The result tags are the most interesting ones: they contain the actual data generated by the probe.</td>
</tr>
</tbody>
</table>

**ECC queue controls**

The ECC Queue form contains these related links:

<table>
<thead>
<tr>
<th>Related link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run again</td>
<td>Runs the probe again. You can re-run probes when you encounter a failed discovery or other unexpected results.</td>
</tr>
<tr>
<td>Go to CMDB item</td>
<td>Open the CI record for the CI that was updated during the discovery.</td>
</tr>
<tr>
<td>Go to Sensor</td>
<td>Open the record for the associated sensor.</td>
</tr>
</tbody>
</table>

**Manage ECC Queue content for a MID Server**

The ECC Queue allows you to create ECC Queue messages, access MID Server log entries, and retrieve statistics from an individual MID Server record.
Before you begin
Role required: admin, mid_server

Procedure

1. Send remote commands through a MID Server to a hosting device directly from the ECC Queue without running Discovery.

   a. Navigate to the ECC Queue and click New.

   b. Create a message with these settings:
      • **Agent**: The name of the MID Server that executes the command.
      • **Topic**: Command
      • **Name**: The actual command that you want to process. For Windows, this is expressed in a DOS command line structure. For Linux, the structure could be a bash command line entry.
      • **Queue**: Output
      • **Payload**: With proper XML tags, you can specify the command here instead of in the **Name** field. The advantage to this is that the command is not restricted by the **Name** field length of 120 characters. Use the following XML format for the command:

        ```xml
        <parameters>
          <parameter name="name" value="ACTUAL_COMMAND_LINE"/>
        </parameters>
        ```

2. Access entries in the ECC Queue that show **agent0.log.0** logs and **wrapper.log** logs for an individual MID Server.

   a. Open a MID Server record.

   b. Under **Related Links**, click **Grab MID Logs**.

      ECC queue records appear in the list using the following filter:
      • [Topic] [is] [SystemCommand]
      • [Source] [is] [grabLog]
      • [Agent] [is] [your MID Server]

      Only **agent0.log.0** and **wrapper.log** entries appear. These logs are also accessible in the `~\agent\logs\` file path.

   c. To open a log entry, click the link under the **Created** column.
3. Access the queue.stats topic for useful information about individual MID Servers, such as memory and CPU usage data.

   a. Open a MID Server record.

   b. Under Related Links, click MID Statistics. ECC queue records appear in the list using the following filter:
      - [Topic] [is] [queue.stats]
      - [Agent] [is] [your MID Server]

**MID Server dashboard**

The MID Server dashboard is a central place for MID Server users to monitor ongoing operations. The dashboard consists of reports and gauges that display information from the MID Server Status table.

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

The MID Server Dashboard is available from the MID Server > Dashboard module.

**MID Server status gauge**

The MID Server Status gauge on the dashboard displays basic information about each MID Server. This information comes from the MID Server Status [ecc_agent_status] table.
If the version is not compatible, the MID Server status is not changed to **Down** in the MID Server dashboard. So it might still appear to be processing commands when it actually is not doing so. You must check the MID Server **Version** on the dashboard.

See [KB0535181](#) for additional MID Server troubleshooting information.

The icons in the **Version** column indicates the following:

- **Red**: Incompatible. The MID Server and instance do not belong to the same release. You must [upgrade the MID Server](#) and verify that it is not pinned to an older version with the `mid.version.override` property. The MID Server will not be upgraded until the parameter is cleared.

- **Yellow**: Compatible, but an upgrade is recommended. This indicates that the MID Server version belongs to the same family as the instance, but not the same version.

- **Green**: Compatible. No upgrade necessary.

- **Gray**: Incompatible. The instance cannot detect the version.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the MID Server.</td>
</tr>
<tr>
<td>Host name</td>
<td>The name of the system that hosts the MID Server.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the MID Server.</td>
</tr>
<tr>
<td>Validated</td>
<td>Whether or not the MID Server was validated.</td>
</tr>
<tr>
<td>Max memory used %</td>
<td>The highest percent usage of memory on the system that hosts the MID Server, in the configured sampling interval. The default interval is 30 minutes, but this value is user configurable. See <a href="#">MID Server resource threshold alerts</a> for details.</td>
</tr>
<tr>
<td>Mean CPU used %</td>
<td>The average percent usage of CPU on the system that hosts the MID Server, in the configured sampling interval. The default interval is 30 minutes, but this value is user configurable. See <a href="#">MID Server resource threshold alerts</a> for details.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pending jobs</td>
<td>Number of pending ECC queue jobs for that MID Server.</td>
</tr>
<tr>
<td>Processing jobs</td>
<td>Number of processing ECC queue jobs for that MID Server.</td>
</tr>
<tr>
<td>Version</td>
<td>The version of the MID Server. An icon indicates the validity of the MID Server:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Red</strong>: Incompatible. The MID Server and instance do not belong to the same release. You must upgrade the MID Server and verify that it is not pinned to an older version with the mid.version.override property. The MID Server will not be upgraded until the parameter is cleared.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Yellow</strong>: Compatible, but an upgrade is recommended. This indicates that the MID Server version belongs to the same family as the instance, but not the same version.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Green</strong>: Compatible. No upgrade necessary.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Gray</strong>: Incompatible. The instance cannot detect the version.</td>
</tr>
<tr>
<td>User</td>
<td>The login name of the user. An icon indicates the validity of the user:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Red</strong>: Incompatible. The user does not have the mid_server role or the user does not match the value in the mid.instance.username parameter (in the config.xml configuration file). Reconfigure the MID Server user and verify that it works.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Green</strong>: Compatible. The user has the mid_server role and matches the user in the configuration file.</td>
</tr>
</tbody>
</table>

**Note:** The user can also have any of the SOAP roles that the mid_server role inherits.

**CPU and maximum memory usage**
This graph shows the average percentage of CPU usage on all the systems that host MID Servers in the last 30 days.
This graph shows the average percentage of maximum memory used by all the systems that host MID Servers in the last 30 days.
MID Server properties

Properties control the behavior of all MID Servers or a particular MID Server.
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

The MID Server properties are in the MID Server Property [ecc_agent_property] table and can be accessed by navigating to MID Server > Properties. To set these properties, you must add them, if they are not already present.

**MID Server properties**

**alias_filtering_behavior**

Sets the behavior of Discovery aliases. Behaviors define how strictly the system enforces the use of credential aliases in Discovery schedules.

The choices for behaviors are:

- **strict**: Aliases defined for the credential must match the aliases configured for the probe.
- **loose**: The probe’s credential is used if it contains all the aliases specified in the schedule.

- Type: string
- Default value: loose

**com.glide.closure_max_rows_per_table**

Sets the maximum number of rows allowed in a table. This property is not visible by default and must be added.
concurrent.dist.download

Sets the number of concurrent MID Server auto-upgrades permitted by the instance. The default value of this property is 2, which allows the MID Server to use 2 of the 4 semaphores available on the instance for upgrading. If your instance has more than 4 INT semaphores, you can increase the value in this property to allow more concurrent upgrades.

• Type: integer
• Default value: 2

glide.stored_proc.data_type.validation

Stops validation of data types in stored procedure parameters. Use this property if you use Orchestration to run a stored procedure on MySQL, Oracle DB, and MS-SQL databases and you want to avoid performing data type validation. Restart the MID Server service after you change the value of this property.

• Type: true | false
• Default value: false

max_ci_count_per_page

Defines the maximum CI count per page.

• Type: integer (bytes)
• Default value: 500

You can also configure this as a configuration parameter on a individual MID Server.

mid.aws.sts.assume_role.disable_credential_caching

Set this property to true to prevent the caching of temporary credentials for Cloud Discovery. For more information, see Access setup for AWS service accounts.

• Type: true | false
• Default: false

mid.aws.sts.assume_role.credential_ttl_minutes
Set the number of minutes you want to cache temporary credentials for Cloud Discovery. For more information, see Access setup for AWS service accounts.

- Type: integer
- Default: 60

mid.ca.certificate.api.request.retry.count
Indicates how many times the Certificate Import query will retry after the rate limit has occurred.

- Type: integer
- Default: 3

mid.ca.certificate.api.request.retry.interval
Used to delay Certificate import from CAs when the rate limit has occurred.

- Type: integer
- Default: 30000

mid.discovery.max_pattern_payload_size
Defines the maximum overall payload size for the payload of results that come from patterns.

- Type: integer (bytes)
- Default value: 300000

You can also configure this as a configuration parameter on an individual MID Server.

mid.discovery.max_payload_size
Specifies the maximum string length of Discovery results that the MID Server sends to the instance. If the Discovery probe results exceed the limit, the MID Server discards them and returns a warning message.

For probes, this applies only to those probes where the Used by Discovery field is true. For patterns, this applies to the Horizontal Pattern probe.

Set the value to any negative number to disable the payload limit and allow payloads of any size to be sent to the instance. For example, -1.
• Type: integer (bytes)
• Default value: 5000000

You can also configure this as a configuration parameter on an individual MID Server.

mid.discovery.multiprobe.skip_others_on_error

Prevents probes in a multi-probe from iterating through available credentials when another member probe has already failed or timed out. If this property is set to false, each probe in the multi-probe attempts to connect to the target with the same invalid credentials. This condition results in longer probe execution times on the MID Server.

This property is not visible by default and must be added to the sys_properties table to change the value.

• Type: true | false
• Default value: true

mid.eccq.max_payload_size

Specifies the maximum string length of a payload that the MID Server sends to the instance. The MID Server verifies the size of the payload before sending it to the instance. If the payload size exceeds the limit, the MID Server discards it and returns an error message in the payload.

• Type: integer (bytes)
• Default value: 20000000

You can also configure this as a configuration parameter on an individual MID Server.

mid.jdbc.datastream.max.record.size

Specifies the maximum record size in KB.

• Type: integer
• Default value: 64
• Maximum value: 128

mid.jdbc.datastream.fail.when.attachment.limit.exceeded

Specifies if the data up to 4GB (four attachments, each of size 1GB) can be retrieved from the RDBMS. By default, a flow or action fails
with an error, when there is data of more than 4GB to be retrieved. Set value to false to retrieve data of size 4GB without an error.

- Type: string
- Default: true

**mid.log.command_audit.enable**

Enables the MID Server command audit log.

- Type: string
- Default value: false

**mid.powershell.target_base_dir**

Specifies the location of the target base folder used for Discovery using WMI. If another network share is mounted on each Window’s target, the folder may be changed by updating this property.

- Type: string
- Default value: admin$\temp

**mid.probe.collect_debug_info**

An optional property to collect debug information. If this property is set to true, the probe collects credential debug information when it runs and puts that information in the payload of ECC input message. It doesn’t affect how Discovery works.

- Type: true | false
- Default value: false

**mid.probe.use_legacy_forward_dns**

Enables the legacy DNSNameResolver probe and disables the default DNSNameResolver probe. See Probes used by Orchestration for more information.

- Type: true | false
- Default value: false

**mid.probe.use_legacy_reverse_dns**

Enables the legacy DNS probe and disables the default DNS probe. If you experience problems with the features of the default DNS probe, use this property to disable those features. The default DNS probe's features include being lightweight and faster due to
executing in parallel, while the legacy probe is throttled by the MID Server because it executes in serial. The default probe utilizes DNS lookup by the MID Server host OS to make use of the OS maintained DNS cache, while the legacy probe does not. Consequently, after a DNS lookup by the default probe fails in Windows systems, the OS also tries looking up by NETBIOS name.

- Type: true | false
- Default value: false

**mid.process_flow.log_listener.max_size**

Sets the maximum size in bytes of memory available to save log messages for Flow Designer actions running on a MID Server. The MID Server stores up to the limit in memory and discards additional log messages, then sends the messages back to the instance along with the execution plan.

- Type: integer (bytes)
- Default value: 10485760

**mid.property.jdbc_operations**

Tells the JDBCOrchestrationProbe what JDBC operations it is allowed to execute. Edit this property value to allow JDBC Orchestration activities to perform more operations. All operations are comma separated. Select a MID Server in the **MID server** field to define specific operations for that MID Server, or leave the field empty to apply the list of operations to all MID Servers. This property requires the Orchestration plugin.

- Type: string
- Default value: select, update, insert, delete, show, create, describe, begin, if, end, not, exists

**mid.property.jms.command.allowed_factory_names**

Comma delimited list of Java Messaging Service (JMS) connection factories that the MID Server requires for a custom JMS activity or action. This property requires the Orchestration plugin.

- Type: string
- Default value: connectionFactory, queueConnectionFactory, topicConnectionFactory

**mid.property.ssh.use_snc**
Enables the use of the SNCSSH client for Discovery and Orchestration. Change this property to false to use J2SSH. This property applies to all MID Servers connected to the instance.

- Type: true | false
- Default value: true

**mid.sa.prefer_powershell**

Enables MID Server to use PowerShell Remoting.

**Note:** It is not recommended to change this property as it is being deprecated.

- Type: True | False
- Default value: true

**mid.sa.ssh.use_sncssh**

Toggles SSH between non-interactive and interactive modes. True corresponds to non-interactive mode and allows probes to open sessions with the device without waiting for a prompt. False corresponds to interactive mode, which requires interactive sessions with the device for network devices and servers.

- Type: True | False
- Default value: true

**mid.servicewatch.max_concurrent_connections**

Defines the maximum number of concurrent tasks sent to an individual host by a single MID Server.

- Type: integer
- Default value: 7

**mid.shazzam.regulator.interval_ms**

Sets the interval, in milliseconds, in which Shazzam can launch packets.

- Type: integer
- Default value: 1

**mid.shazzam.regulator.packets_per_interval**
Sets the number of packets that Shazzam can launch in the time interval specified by the `mid.shazzam.regulator.interval_ms` property.

- Type: integer
- Default value: 1

**mid.shazzam.threads**

Specifies the number of concurrent threads that Shazzam uses. Setting this or the `mid.shazzam.max_scanners_per_thread` parameter to 0 disables Shazzam multi-thread optimization.

- Type: Integer
- Default value: 5

**mid.shazzam.max_scanners_per_thread**

Specifies the number of concurrent scanners processed by each Shazzam thread. Setting this or the `mid.shazzam.threads` parameter to 0 disables Shazzam optimization.

- Type: Integer
- Default value: 100

**mid.sm.discolog.max_log_size**

Limits the length of the log statements in the Horizontal Discovery Log. If the results are truncated, the **Command results** reports, "Result is larger than [value] characters and was truncated by the logger."

- Type: integer (characters)
- Default value: 1000

**mid.sm.discolog.max_object_size**

Limits the length of the object in the Horizontal Discovery Log. Objects in the log statement are truncated to the number of characters set by this property’s value. This property only affects the object character size in the Horizontal Discovery Log. The following message appears if an object is limited by this property "The max object size reached the maximum limit of [value]. To adjust this use the mid property mid.sm.discolog.max_object_size."

- Type: integer (characters)
- Default value: 1000
**mid.snmp.use_getbulk**

Specifies whether to use GETBULK to receive a large amount of data in batches. This can be used to globally configure all MID servers.

- Type: true | false
- Default value: true

GETBULK can also be set at the probe level or for an individual MID Server. Settings are listed in the order of precedence:

- SNMP probe parameter
- MID Server configuration parameter
- MID Server properties

**mid.ssh.algorithms.kex**

Modifies the Key Exchange SSH algorithm priority list. The property accepts a comma separated lists with operators. The first name in the list is highest priority, last name in list is lowest priority. Adding a comma separated list without any operators replaces the default algorithm list. For more information, see [MID Server SSH cryptographic algorithms](#).

- Type: string

**mid.ssh.algorithms.host_key**

Modifies the Host Key SSH algorithm priority list. The properties accept comma separated lists with operators. The first name in the list is highest priority, last name in list is lowest priority. Adding a comma separated list without any operators replaces the default algorithm list. For more information, see [MID Server SSH cryptographic algorithms](#).

- Type: string
Modifies the Cipher SSH algorithm priority list. The properties accept comma separated lists with operators. The first name in the list is highest priority, last name in list is lowest priority. Adding a comma separated list without any operators replaces the default algorithm list. For more information, see MID Server SSH cryptographic algorithms.

- Type: string
- Default value: aes128-ctr,aes192-ctr,aes256-ctr,3des-ctr,aes128-cbc,aes192-cbc,aes256-cbc,3des-cbc

mid.ssh.algorithms.mac

Modifies the MAC SSH algorithm priority list. The properties accept comma separated lists with operators. The first name in the list is highest priority, last name in list is lowest priority. Adding a comma separated list without any operators replaces the default algorithm list. For more information, see MID Server SSH cryptographic algorithms.

- Type: string
- Default value: hmac-sha2-256,hmac-sha1,hmac-sha2-512,hmac-sha1-96,mac-md5-96,hmac-md5

shazzam.chunk_size

Maximum number of IP addresses Shazzam can scan in parallel. This property primarily controls outbound port consumption.

- Type: integer
- Default value: 100

mid.use_net_tools

Enables or disables the use of net-tools commands during discovery of devices running on the Linux operating system. Starting from Quebec, ITOM Visibility supports the iproute2 commands for discovery. By default, ITOM Visibility and discovery patterns first use net-tools commands, and only then, as a fallback, may use iproute2 commands. If all Linux-based devices and applications in your IT network use iproute2 commands, disable net-tools commands to make the discovery process more efficient.

- Type: true | false
- Default value: true
**mid.servicewatch.use_full_linux_netstat_path**

Controls if the `netstat` command is executed with its full installation path. This command lists open ports on Linux servers during the process detection phase of the top-down discovery.

- **Type:** true | false  
- **Default value:** true

**mid.servicewatch.num_paths_linux_netstat_to_check**

Define the maximum number of installation paths to use during discovery of Linux servers. This property is relevant when you run the top-down discovery on Linux servers with several netstat installation paths, and the `mid.servicewatch.use_full_linux_netstat_path` property is set to true.

The top-down discovery attempts to execute the `netstat` command using each of these installation paths. The result of the first successful execution is used to determine the list of open ports.

- **Type:** true | integer  
- **Default value:** 5

**mid.servicewatch.use_full_linux_ss_path**

Controls if the `ss` command is executed with its full installation path. This command lists open ports on Linux servers during the process detection phase of the top-down discovery.

- **Type:** true | false  
- **Default value:** false

**mid.servicewatch.num_paths_linux_ss_to_check**

Define the maximum number of installation paths to use during discovery of Linux servers. This property is relevant when you run the top-down discovery on Linux servers with several ss installation paths, and the `mid.servicewatch.use_full_linux_netstat_path` property is set to true.

The top-down discovery attempts to execute the `ss` command using each of these installation paths. The result of the first successful execution is used to determine the list of open ports.

- **Type:** true | integer  
- **Default value:** 5
Create a MID Server property

Use a MID Server property to control either the behavior of all MID Servers or a particular MID Server.

Before you begin
Role required: admin

About this task
You set MID Server properties to override MID Server parameters. Configure MID Server properties in the MID Server plugin. Do not configure MID Server properties in the glide.properties file that is located in the properties folder of the agent. The glide.properties file gets overwritten during the upgrade process.

Procedure
1. Navigate to MID Server > Properties.
2. Click New.
3. Fill in the fields, as appropriate (see table).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the property name.</td>
</tr>
<tr>
<td>Value</td>
<td>You can enter the value you want the property to have.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Leave this field blank to set a MID Server property that affects all MID Servers. To set a MID Server property for a particular MID Server, select the MID Server.</td>
</tr>
</tbody>
</table>

Note: If you are amending JDBC operations through the mid.property.jdbc_operations properties, you can enter verbs like BEGIN, END, IF, or common PL/SQL block statements. This will assist in being able to run CREATE or ALTER statements. You might have to restart the MID server before running some of the statements.

4. After setting any MID Server properties, restart the MID Server to ensure the properties sync with the instance.

MID Server parameters
Parameters control the behavior of a particular MID Server and have lower precedence than MID Server properties.
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

To add a parameter to a MID Server, see Add a MID Server parameter.

**Important:** Changes to parameters only take effect when the MID Server is started (or restarted).

**Note:** The value of any MID Server parameter in the config.xml file can be encrypted. See Encrypt or decrypt MID Server configuration file values for more information.

### Required parameters

**Note:** Using special characters in an XML configuration file requires you to encode them.

#### url

Specifies the URL to the associated instance. Normally the URL is similar to https://instance.service-now.com, where you replace instance with the instance name. If you host your own instance, use the URL set by your organization.

- Type: string
- Default value: none

#### mid_sys_id
Records the MID Server record’s unique identifier. This parameter should be empty when you initially configure a MID Server. Do not change the value.

- Type: string
- Default value: automatically set (GUID)

name

Use this parameter to supply a name that is meaningful for you. If you do not supply this parameter, the MID Server uses the default value. A set of business rules synchronizes the name in the configuration file with the name in the MID Server record. The business rules ensure that changing the name in one location also changes the name in the other location.

- Type: string
- Default value: YOUR_MIDSERVER_NAME_GOES_HERE

mid.instance.username or glide.glidesoap.username

If the ServiceNow instance has authentication enabled, as it is by default, set this parameter to define the user name the MID Server should use to log in to the instance. This user should have the mid_server role on the ServiceNow instance in order to access necessary tables and fields. You can use this parameter to define user names with special characters.

- Type: string
- Default value: none

mid.instance.password or glide.glidesoap.password

If your ServiceNow instance has authentication enabled, as it is by default, set this parameter to define the password the MID Server should use to log in to the instance. You can use this parameter to define passwords with special characters.

- Type: string
- Default value: none

CIM parameters

mid.cim.batch.size

Specifies the maximum number of messages sent at once to a CIM server.
mid.cim.request.interval

Specifies the number of milliseconds to wait between requests to the same Common Information Model Object Manager (CIMOM).

- Type: integer
- Default value: 1

mid.cim.host.connection.limit

Specifies the maximum number of simultaneous connections to each CIMOM. A value of zero disables simultaneous connections.

- Type: integer
- Default value: 0

Connection parameters

glide.mid.fast.responses

Instructs the MID Server to try sending messages to the instance as soon as they are ready. Normally the MID Servers end messages to the ServiceNow instance serially (that is, one message at a time). Since many probes can be run in parallel, there can be multiple messages transmitted simultaneously to the instance. Setting this parameter to true may decrease the time between a probe's completion and its response arriving at the instance. However, the multiple simultaneous messages consume resources, decreasing the overall instance responsiveness. If there are communications problems, this parameter's value can also cause a logjam on the MID Server, as threads normally used for running probes may become consumed for sending messages. Generally, leave this parameter out of your configuration. Setting it to true is meaningful only under very special circumstances.

- Type: true | false
- Default value: false

glide.mid.max.sender.queue.size

Places an upper limit on how large the queue is allowed to get. The MID Server starts deleting queued messages if this limit is exceeded. When the MID Server generates messages to the ServiceNow
instance faster than it can send them, it queues them temporarily on the file system of the MID Server's host. This queue is normally quite small, and is completely emptied as soon as the MID Server processing slows for a short period. However, this queue can grow in size when there are communication problems between the MID Server and the instance, and especially if there is an integration running on the MID Server. The parameter is of the form \{number\}{multiplier}, where \{number\} is any positive decimal number including non-integers, and the optional multiplier is any spelling of bytes, kilobytes, megabytes, gigabytes, or terabytes (only the first character is tested, and the test is case-insensitive). The default multiplier is bytes. White space is liberally tolerated. The following strings all represent valid parameters: "1000000000", "0.5m", "5 GB", "7.67gigas", "145.69392 meg", and "1.1 terra".

- Type: string  
- Default value: 0.5 GB

**instance.date.format**

Specifies the format the instance uses for dates and times. The primary impact of setting this parameter is to allow the MID Server to correctly refresh its start and stop times on the MID Server record in ServiceNow. The format of this date/time string is identical to that used by the Java SimpleDateFormat class.

- Type: string (Date format)  
- Default value: yyyy-MM-dd HH:mm:ss

**mid.disable_amb**

Disables the Asynchronous Message Bus (AMB) Client. When AMB is enabled, the MID Server uses a default polling interval of 40 seconds. When the AMB client is disabled, the default polling interval switches to 5 seconds. If you set a polling interval with the **mid.poll.time** parameter, the MID Server uses that value whether or not the AMB client is enabled.

- Type: true | false  
- Default value: false

**mid.https.truststore.password**

Sets the trustStore password that is required for HTTPS connections with the Asynchronous Message Bus (AMB) Client.
mid.https.truststore.path

Path to the trustStore to be used by the MID Server for TLS transactions (Asynchronous Message Bus (AMB) Client). Add this parameter only if you want to change the default path.

- Type: string
- Default value: none

mid.instance.skip_basic_auth

Allows the MID Server to connect to an instance using cookies instead of basic authentication credentials. When set to true, it uses cookies first. However, if the connection fails, the MID Server will try to connect again using basic authentication credentials.

- Type: true | false
- Default value: true

mid.jmx.enabled

Enables a JMX server on the MID Server, which exposes some management information to JMX consoles. Implementing JMX requires additional configuration of the Java runtime environment. Setting this parameter to true is only recommended for those with detailed knowledge of the Java security architecture and a specific need for JMX.

- Type: true | false
- Default value: false

mid.poll.time

Sets the default MID Server polling interval (in seconds). The polling interval is the amount of time the MID Server waits before checking the ECC queue for work when the ECC queue is not busy. The MID Server polls the ECC queue using this interval if the AMB client connection is dropped.

- Type: string
- Default value: none
Note: The default polling interval resets to 5 seconds when the AMB client is disabled. If you configure the mid.poll.time parameter, the MID Server uses this polling interval whether or not the AMB client is connected.

- Type: integer (seconds)
- Default value: 40

mid.probe.wait.resources
Indicates whether probe execution is delayed until resources are available. Used to enable MID Server Resource Reservation.

Note: Requires MID Server restart.

- Type: true | false
- Default value: true

mid.property.long_runner
Identifies the name of a script include that manages long running commands.

Note: This property is applicable till the Rome version only. If your instance is of version sandiego or later, you must configure the system property, glide.eccprobe.longrunner.class.

- Type: string
- Default value: LongRunner

threads.interactive.max
Sets the maximum number of interactive worker threads that can run simultaneously in the interactive thread pool. See Set MID Server Thread Use.

- Type: integer
- Default value: 10

threads.expedited.max
Sets the maximum number of expedited worker threads that can run simultaneously in the expedited thread pool. See Set MID Server Thread Use.
threads.max

Sets the maximum number of standard worker threads that can run simultaneously in the standard thread pool. This parameter provides direct control over what CPU resources the MID Server consumes on the computer that hosts it. See Set MID Server Thread Use.

• Type: integer
• Default value: 20

Important: You can set threads.max as high as 200, however, this setting may need to be changed depending on the OS. For example, Windows-based MID Servers running Discovery uses Powershell which is resource intensive. In this case, you may exhaust the CPU power of the host machine with just 50 threads count.

Credentials parameters

mid.aws.instance_profile_name

Name of the AWS IAM role configured on the EC2 instance. When configured, the MID Server uses the temporary credentials granted to this role by the AWS instance profile to Discover cloud resources.

• Type: string
• Default value: None (User must provide a non-blank value)

mid.credentials.provider

Specifies the Java class name of the credentials provider.

• Type: string
• Default value: com.service_now.mid.creds.standard.StandardCredentialsProvider

mid.secure_credentials.key_pairs.provider

Class that the MID Server uses to generate secure key pairs.

• Type: string
• Default value: com.service_now.mid.keypairs.provider.standard.StandardKeyPairsProvider
Debug parameters

debbug.logging

[Deprecated] Specifies whether to enable logging of MID Server events and messages (both sent and received). Normally this parameter is only used by developers, but it is occasionally useful when troubleshooting a problem. Be aware that setting this parameter to true causes intensive logging on the MID Server, potentially using considerable disk space.

• Type: true | false
• Default value: false

This parameter has been replaced by the mid.log.level parameter.

debbug

[Deprecated] Specifies whether to enable debug logging on the MID Server. Normally this parameter is only used by developers, but it is occasionally useful when troubleshooting a problem. Be aware that setting this parameter to true causes intensive logging on the MID Server, potentially using considerable disk space.

• Type: true | false
• Default value: false

This parameter has been replaced by the mid.log.level parameter.

citmap.template.debug

Specifies whether to debug file probe templates.

• Type: true | false
• Default: false

citmap.debug

Specifies whether to enable debug logging for CIM, WBEM, SLP, or SMI-S.

• Type: true | false
• Default value: false

mid.ssh.debug

Enables SSH debug information in the log file. The parameter usage depends on whether the ServiceNow SSH client is enabled.
When the ServiceNow SSH client is enabled, the parameter functions as follows:

- Type: string
- Default value: false

The following string values are valid for the ServiceNow SSH client:

- true: Enables SSH debug information in the log file.
- false: Disables SSH debug information in the log file.
- <IP Addresses>: Specify which IP ranges to enable SSH debug information in the log file. You can enter IP addresses in the following formats:
  - An IP range defined by a slash and the number of bits in the subnetwork. For example, the string 10.10.10.0/24 scans 24 bits of IP addresses from 10.10.10.0 to 10.10.10.254.
  - An IP range defined by a dash. For example, the string 10.10.11.0-10.10.11.165 scans the IP addresses from 10.10.11.0 to 10.10.11.165.
  - A comma-separated list of specific IP addresses. For example the string 10.10.11.200,10.10.11.235 scans the IP addresses 10.10.11.200 and 10.10.11.235.
- deferred: Logs SSH debug information in memory unless an error or warning occurs. If an error or warning occurs, the platform publishes the debug information to the log file. This ensures that only the part of the log file pertaining to the error or warning is recorded. If no error or warning is detected, the platform deletes the unused log data from memory when the session closes. Each session stores up to 1000 log messages. If the session exceeds 1000 log messages, the deferred log discards the oldest log message to make room for the newest log message.

When the ServiceNow SSH client is disabled, the parameter enables or disables SSH debug information in the log file:

- Type: true | false
- Default value: false
Note: The MID Server parameter `mid.ssh.debug` only affects SNCSSH and J2SSH. To enable Maverick client debug logging, set the MID Server configuration parameter `mid.log.level` to `debug, com.maverick=debug`.

`mid.log.level`
Specifies the logging level for the MID Server. Possible values are:
- `debug`
- `info`
- `warn`
- `error`

Note: Values are case insensitive.

- Type: string
- Default value: `info`

`mid.http.idle_connection_monitor.debug`
Enables debug logging for the Idle Connection Monitor.

- Type: `true | false`
- Default value: `false`

DNS parameters
`mid.dns_scan.regulator.interval_ms`
Specifies the interval between DNS scans in milliseconds.

- Type: integer
- Default value: `10`

`mid.dns_scan.regulator.packets_per_interval`
Specifies the number of regulator packets per DNS scan.

- Type: integer
- Default value: `1`

`mid.dns_scan.default_name_servers`
Specifies the host names or IP addresses of the default name servers.
mid.dns_scan.default_name_servers
Specifies the host names or IP addresses of the default name servers.
  • Type: string
  • Default value: none

mid.dns_scan.additional_name_servers
Specifies the host names or IP addresses of any additional name servers.
  • Type: string
  • Default value: none

mid.dns_scan.load_balancing_enable
Specifies whether to enable load balancing of name servers.
  • Type: true | false
  • Default value: false

mid.probe.use_legacy_forward_dns
Enables the legacy DNSNameResolver probe and disables the default DNSNameResolver probe. See Probes used by Orchestration for more information.
  • Type: true | false
  • Default value: false

mid.probe.use_legacy_reverse_dns
Enables the legacy DNS probe and disables the default DNS probe. If you experience problems with the features of the default DNS probe, use this parameter to disable those features. The default DNS probe's features include being lightweight and faster due to executing in parallel, while the legacy probe is throttled by the MID Server because it executes in serial. The default probe utilizes DNS lookup by the MID Server host OS to make use of the OS maintained DNS cache, while the legacy probe does not. Consequently, after
a DNS lookup by the default probe fails in Windows systems, the OS also tries looking up by NETBIOS name.

- Type: true | false
- Default value: false

**Event Management parameters**

**mid.probe.event.bulk_size**

Specifies the maximum size of an event payload, in MB.

- Type: integer
- Default value: 120

**mid.probe.event.wait_time**

Waiting period on an empty queue for sending events.

- Type: integer
- Default value: 1000

**mid.probe.event.send.enabled**

Enables or disables the sending of events.

- Type: true | false
- Default value: true

**mid.probe.event.queue.max_size**

Specifies the maximum size permitted for the event queue before incoming events are rejected.

- Type: integer
- Default value: 100,000

**mid.probe.event.max.retry_time**

The maximum number of seconds MID retries sending events.

- Type: integer
- Default: 1800

**mid.probe.event.queue.use_bulk**

Specifies whether events are sent to the server singly or in bulk. If this parameter evaluates to true then events are sent to the server in bulk.
mid.probe.event.suppress.whitespaces

Allows line breaks in description fields for multi-line events. Apply this parameter to each MID Server used with event connector instances. Choices are:

- all
  This setting removes all whitespaces.
- leave_as_is
  This setting keeps all whitespaces.
- keep_newline
  This setting keeps only new_line and removes all other whitespaces.

mid.em.metric.metric_to_ci_map_limit

Specifies the maximum number of active metrics allowed per CI map.

- Type: integer
- Default value: 200,000

mid.em.metric_binding_timeout_seconds

Specifies the number of seconds to wait before resending unhandled events

- Type: integer
- Default value: 300

mid.em.metric_binding_timeout_max_seconds

Specifies the maximum number of seconds to wait before resending unhandled events.

- Type: integer
- Default value: 10800
mid.em.metric_max_elapsed_time_before_refresh
Specifies the maximum number of seconds before the metric source type cache is refreshed in memory.

• Type: integer
• Default value: 60

mid.em.metric_max_sql_string_length_for_types
Specifies the maximum length of the string (composed of types) used for an SQL command

• Type: integer
• Default value: 30000

mid.em.statistics_report_periodon_sec
Specifies the period, in seconds, between statistics reports to the instance. Use 0 to disable reporting. This parameter requires a restart.

• Type: integer
• Default value: 60

mid.em.metric_connector_max_run_time_seconds
Specifies the maximum number of seconds to collect metrics in every cycle.

• Type: integer
• Default value: 300

mid.em.metric_connector_history_min
Specifies the number of minutes to go back in history to retrieve metrics.

• Type: integer
• Default value: 180

mid.em.metric_event_logging
Specifies the level of metric and event logging. Choices are:

• none
• all
• events
• metrics
• metrics:<filter>
• events:<filter>

• Type: string
• Default value: none

mid.em.metric_connector_late_arrivals_delay
Specifies the number of seconds to delay when collecting metrics.
• Type: integer
• Default value: 30

FTP connection parameters
mid.ftp.max_pool_size
Specifies the maximum size of the FTP Connection Pool, in megabytes.
• Type: integer
• Default value: 25

mid.ftp.max_per_target
Specifies the maximum number of the FTP connections per target.
• Type: integer
• Default value: 5

mid.ftp.max_conn_idle_time
Specifies the maximum amount of time, in milliseconds, that an FTP connection can sit idle in the pool.
• Type: integer
• Default value: 300000

mid.filesystem.max.ls
Specifies the maximum number of files that can be returned in the filesystem list directory command.
• Type: integer
• Default value: 10000
Logging parameters

**disable_monitors**

Specifies whether to disable the MID Server from actively checking for monitors on the instance.

- Type: true | false
- Default value: true

**mid.show.queries**

Instructs the MID Server whether to log details about every query it makes to the ServiceNow instance. Typically this parameter is only used by developers, but it is occasionally useful when troubleshooting a problem. Be aware that setting this parameter to **true** causes intensive logging on the MID Server, potentially using considerable disk space.

- Type: true | false
- Default value: false

**disable.remote.logging**

Prevents the MID Server from logging any information to the MID Server log on the instance. Relatively little information is logged on the instance in any case, but setting this parameter to **true** eliminates all logging to the instance.

- Type: true | false
- Default value: false

**disable.status**

Prevents the MID Server from sending a status report to the instance every 10 minutes.

- Type: true | false
- Default value: false

Pattern parameters

**mid.parsing.max_field_size**

Sets the maximum character length of strings stored as temporary variables while patterns are run. Strings longer than this parameter's value are truncated to equal the value. Use the parameter to increase the limit when parsing longer strings.
**Warning:** Exceeding the max field size limits of the SQL database implementation cause errors.

- Type: integer
- Default value: 1024

**mid.sa.discovery.pattern_string_attributes.deduplicate**

Reduces memory consumption for pattern execution context attributes by eliminating duplicate strings.

- Type: true | false
- Default: true

**Proxy server parameters**

**mid.instance.use_proxy or mid.proxy.use_proxy**

If your MID Server must go through a web proxy to access the ServiceNow instance, set this parameter to true to instruct the MID Server to use the proxy. You must also set the proxy server’s host and port, and perhaps the user name and password as well.

- Type: true | false
- Default value: false

**mid.proxy.host**

If your MID Server must go through a web proxy to access the ServiceNow instance, set this parameter to define the proxy’s host.

- Type: string
- Default value: none

**mid.proxy.password**

If your MID Server must go through a web proxy to access the ServiceNow instance, and your proxy requires a password, set this parameter to define that password.

- Type: string
- Default value: none

**mid.proxy.port**

If your MID Server must go through a web proxy to access the ServiceNow instance, set this parameter to define the proxy’s port.
mid.proxy.username

If the MID Server must go through a web proxy to access the ServiceNow instance, and the proxy requires a user name, set this parameter to define that user name.

• Type: string
• Default value: none

Request timeout override parameters

mid.sa.cloud.request_timeout

Sets the timeout in milliseconds for cloud requests. This parameter overrides the glide.http.timeout system property, which specifies the maximum number of milliseconds to wait before an outbound REST transaction times out.

• Type: integer
• Default value: 30000

mid.http_classy.request_timeout

Sets the timeout in milliseconds for HTTP classification requests with the HTTP - Classify probe. This parameter overrides the glide.http.timeout system property, which specifies the maximum number of milliseconds to wait before an outbound transaction times out.

• Type: integer
• Default value: 30000

Security parameters

mid.windows_host.file_permissions.allow_list

Sets an inclusion list for Windows file permissions enforcement to improve security. The parameter takes a string of comma separated group names, user names, and SIDs. Group and user names must follow SAM account naming requirements. Domain accounts can be specified by using the SID.

• Type: string (comma separated group and user names)
• Default value: None
**mid.windows_host.file_permissions.enforce**

Enables the MID Server to use Windows file permissions enforcement to improve security. Setting this parameter to false will prevent the MID Server from updating the file permissions inclusion list, but will not revert the file permissions.

- Type: true | false
- Default value: true

**Shazzam parameters**

**mid.shazzam.regulator.interval_ms**

Sets the interval, in milliseconds, in which Shazzam can launch packets. This parameter works with the mid.shazzam.regulator.packets_per_interval parameter to set the number of packets allowed in this interval. By default, Shazzam launches one packet each millisecond.

- Type: integer
- Default value: 1

**mid.shazzam.regulator.packets_per_interval**

Sets the number of packets that Shazzam can launch in the configured time interval. This parameter works with the mid.shazzam.regulator.interval_ms parameter, which sets that interval. By default, Shazzam launches one packet each millisecond.

- Type: integer
- Default value: 1

**mid.shazzam.chunk_size**

Specifies the maximum number of IP addresses that Shazzam scans in parallel. This parameter primarily controls outbound port consumption.

- Type: integer
- Default value: 100

**mid.shazzam.threads**

Specifies the number of concurrent threads that Shazzam uses. Setting this or the mid.shazzam.max_scanners_per_thread parameter to 0 disables Shazzam multi-thread optimization.
• Type: integer
• Default value: 5

mid.shazzam.max_scanners_per_thread

Specifies the number of concurrent scanners processed by each Shazzam thread. Setting this or the mid.shazzam.threads parameter to 0 disables Shazzam multi-thread optimization.

• Type: integer
• Default value: 500

SNMP configuration parameters

mid.snmp.enable_auto_public

Specifies whether to use the SNMP public community string automatically if no other SNMP credentials were successful.

• Type: true | false
• Default value: true

mid.snmp.request.timeout

Specifies the timeout value for the first OID request, in milliseconds. For subsequent requests (for example, table OIDs), the mid.snmp.session.timeout configuration parameter (see below) takes effect.

Note: You can override this parameter with the timeout SNMP probe parameter.

• Type: integer
• Default value: 1500

mid.snmp.session.timeout

Specifies the timeout value for subsequent OID request, in milliseconds. SNMP communication is stateless and does not have a session or connection in the normal sense. The system regards a positive response from the first OID request as a sign that it should expect prompt responses to subsequent requests. While the default is short, it may be useful to increase this parameter value to the same value as that used for mid.snmp.request.timeout.
Note: You can override this parameter with the `establish_session_timeout` SNMP probe parameter.

- Type: integer
- Default value: 500

**mid.snmp.use_getbulk**

Specifies whether to use GETBULK to receive a large amount of data in batches. This can be used to configure an individual MID Server.

- Type: true | false
- Default value: True

GETBULK can also be set at the probe level or globally for all MID servers. Settings are listed in the order of precedence:

- SNMP probe parameter
- MID Server configuration parameter
- MID Server properties

**mid.snmp.use_snmp4j**

Use the Snmp4j library for SNMP communication. This is a strict requirement for SNMPv3. This parameter should only be set to `false` based on advice from Customer Service and Support.

- Type: true | false
- Default value: true

**mid.snmp.use_snmp_v1_v2c**

Use the Snmp4j library for SNMP communication. This is a strict requirement for SNMPv3. This parameter should only be set to `false` based on advice from Customer Service and Support.

- Type: true | false
- Default value: true

**mid.snmp.use_snmp_v3**

Attempt communication using the SNMPv3 protocol version. Requires configuration of SNMPv3 credentials.
SSH Discovery parameters
By default, the MID Server is configured to search for SSH commands in the following paths and the logged-on user's default paths:

- /usr/sbin
- /usr/bin
- /bin
- /sbin

**mid.connection_cache**
Specifies whether to cache connections. Set to **false** to disable connection caching. This parameter applies to SSH connections only.

- Type: true  |  false
- Default value: true

**mid.ssh.set_path**
Specifies whether to set the PATH environment variable for SSH commands.

- Type: true  |  false
- Default value: true

**mid.ssh.local**
Specifies whether to execute commands for the MID Server host machine (localhost) via SSH rather than from a console. This allows long-running commands to execute properly. This parameter applies to the legacy SSH client only.

- Type: true  |  false
- Default value: false

**mid.ssh_connections_per_host**
Controls the number of concurrent probes the MID Server can run against a given host. Lowering the number of concurrent connections can slow Discovery.
• Type: integer
• Default value:
  ◦ 7 for the ServiceNow client
  ◦ 3 for the legacy SSH client

**mid.ssh.sudo_preserve_environment**

Specifies whether to use sudo to preserve the environment for SSH.

• Type: true | false
• Default value: false

**mid.ssh.path_override**

Overides the default paths set before executing a command. Enter one or more override paths delimited by a colon (:). The default path is /usr/sbin: /usr/bin: /bin: /sbin.

The ServiceNow SSH client accepts the following prefixes in front of the path_overide value.

• **append**: Appends the override path to the end of the host’s path. This is the default behavior.
• **replace**: Replaces the host path with the path_overide value.
• **prepend**: Appends the override path to the front of the host path.

• Type: string (a colon-separated list of directories)
• Default value: None

**mid.ssh.use_snc**

Enables the ServiceNow SSH client (SNCSSH) on individual MID Servers. SNCSSH is a ServiceNow implementation of an SSH client and is active by default for all MID Servers on new instances, via a MID Server property. Enabling the ServiceNow SSH client disables the legacy J2SSH client.

**Important**: Mixing SSH client types for MID Servers connected to the same instance is not a good practice.

• Type: true | false
• Default value: false
**mid.ssh.max_retries**

Specifies the maximum amount of times to retry an SSH operation after a time-out. The system sleeps two seconds between each connection attempt. By default, the MID Server retries once only. Set the parameter to 0 to disable retries.

- Type: integer
- Default value: 1

**mid.ssh.alt_rm**

Sets a different SSH remove file command.

- Type: string
- Default value: none

**mid.ssh.initial_delay_ms**

Delays sending any SSH probe commands to a server after connecting to the target for the time specified, in milliseconds. This parameter applies to the legacy SSH client only.

- Type: integer (milliseconds)
- Default value: 0

**mid.ssh.suppress_history**

Suppresses the generation of the SSH history file. This parameter applies to the legacy SSH client only.

- Type: true | false
- Default value: false

**mid.ssh.socket_timeout**

Specifies the timeout value for the SSH socket to prevent issues created by a socket timeout. Some devices, such as systems with embedded controllers like UPSs and PDUs, that have SSH enabled require more time to respond to an authentication request. The default value of 2 minutes ensures such requests do not timeout prematurely.

- Type: integer (milliseconds)
- Default value: 120000 (2 minutes)

**mid.ssh.channel_timeout**
Specifies the amount of time that the MID Server waits for activity on the SSH socket before closing the connection. If there has been no activity on the SSH socket for the specified timeout value, the MID Server closes the connection. Some devices, such as systems with embedded controllers like UPSs and PDUs, that have SSH enabled may require more time to respond to an authentication request.

- Type: integer (milliseconds)
- Default value: 120000 (2 minutes)

**mid.ssh.session_timeout**

Specifies the amount of time that a cached session remains in memory after last use. Excessively small values tend to decrease performance. This parameter applies to the ServiceNow SSH client only.

- Type: integer (milliseconds)
- Default value: 300000 (5 minutes)

**mid.ssh.command_timeout_ms**

The timeout duration, in milliseconds, for the execution of an SSH command.

- Type: integer (milliseconds)
- Default value: 300000 (5 minutes)

**mid.ssh.use_keyboard_interactive**

Uses the keyboard interactive authentication mode in SSH daemons on which it is activated.

- Type: true | false
- Default value: false

⚠️ CAUTION: An issue exists in Mac OS X Sierra and later with the authentication order of the **password** and **keyboard-interactive** modes that can cause Discovery to fail. For details about this issue and the configuration required for proper SSH authentication, see KB0623600.

**mid.ssh.dh_group_length_min**

Specifies the minimum group length in bits used for generating a "shared secret" key in Diffie-Hillman key exchange. The larger
the key the more secure the SSH connection is but at the cost of performance.

- Type: integer (bits)
- Default value: 1024

**mid.ssh.dh_group_length_max**

Specifies the maximum group length in bits used for generating a "shared secret" key in Diffie-Hillman key exchange. The larger the key the more secure the SSH connection is but at the cost of performance.

- Type: integer (bits)
- Default value: 2048

**mid.ssh.shells_supported**

Defines the bourne-compatible shells supported by the MID Server. This value is a comma-separated list of supported shells, such as `ksh`, `dsh`, `bash` and `sh`.

- Type: string
- Default value: `ksh,bash,sh`

**mid.ssh.discard_lrc_error**

Discard long running command error output, emulating legacy behavior.

- Type: string
- Default value: `j2ssh - true, sncssh - false`

**mid.ssh.pool_thread_ratio**

Ratio of the SSH session pool capacity to the configured MID Server thread number (threads.max), expressed as a percentage. The number of permitted pool capacity sessions is set in this parameter. Regardless of the value set in this parameter, the system never permits the pool capacity to fall below 25 sessions.

- Type: integer
- Default value: 150

**mid.ssh.disable_privilege_check**
This parameter has no effect if the target is using a privileged command other than sudo. For more information, see MID Server privileged commands.

The remainder of this section only applies to targets which run sudo. When this parameter is set to true, the MID Server assumes that the user configured in the credential has the privilege to run the given command using sudo. The MID Server assumes the target user can run any command string following sudo on the target. When this parameter is set to false, the MID Server runs "sudo -l" on the target to verify the command which follows sudo has permission to run on the target. Regardless of this parameter's value, the MID Server always validates that sudo by itself can be run on the target.

Some releases do not show this parameter in the MID Configuration Parameters pull down list. In this case, you may optionally add this parameter in MID Properties.

- Type: true | false
- Default value: false

### Upgrade parameters

#### mid.pinned.version

Name of the version to which this MID Server is pinned.

- Type: string
- Default value: MID buildstamp

⚠️ Note: To see the MID buildstamp for your instance, type stats.do in the navigation filter.

An example of the buildstamp format is london-06-27-2018_patch3-10-24-2018_11-11-2018_0542.

#### mid.upgrade.use_proxy

If your MID Server must go through a web proxy to access the upgrade URL, set this parameter to true to instruct the MID Server to use the proxy. You must also set the proxy server's host and port. If the instance proxy user name and password are set, they are used for the upgrade proxy as well.

⚠️ Note: This parameter is not intended to control proxy details configured with glide.mid.autoupgrade.proxy* parameters.
• Type: true | false
• Default value: true

**glide.mid.autoupgrade.proxy_host or glide.glidesoap.proxy_host**
If your MID Server must go through a web proxy to access the upgrade URL, define the proxy's host here.

• Type: string (URL)
• Default value: none

**glide.mid.autoupgrade.proxy_port or glide.glidesoap.proxy_port**
If your MID Server must go through a web proxy to access the upgrade URL, define the proxy's port here.

• Type: integer (0-65535)
• Default value: 80

**glide.mid.autoupgrade.proxy_user**
If your MID Server must go through a web proxy to access the upgrade URL, define the proxy's user name here.

• Type: string (URL)
• Default value: none

**glide.mid.autoupgrade.proxy_password**
If your MID Server must go through a web proxy to access the upgrade URL, define the proxy's password here.

• Type: string
• Default value: none

**Windows Discovery parameters**

**mid.powershell_api.session_pool.max_size**
Specifies the maximum number of sessions allowed in the session pool.

*Note: Setting or changing this parameter requires restarting the MID Server.*

• Type: integer
• Default value: 25
**mid.powershell_api.session_pool.target.max_size**

Specifies the maximum number of sessions allowed in the pool per target host.

**Note:** Setting or changing this parameter requires restarting the MID Server.

- Type: integer
- Default value: 2

**mid.sa.prefer_powershell**

Enables MID Server to use PowerShell Remoting.

- Type: true | false
- Default value: false

**mid.powershell_api.winrm.use_ssl**

Requires the use of SSL certificates for HTTPS connections using WinRM.

- Type: true | false
- Default value: false

**mid.powershell_api.winrm.additional_pssesion_options**

Controls advanced options for a PSSession. For more information about advanced PSSession options, see https://docs.microsoft.com/en-us/powershell/module/microsoft.powershell.core/new-pssessionoption?view=powershell-6.

**mid.powershell_api.winrm.remote_https_port**

Configures the port for connecting to Windows servers using PowerShell over HTTPS.

- Type: integer
- Default value: 5986

**mid.powershell_api.winrm.remote_port**

Configures the port for connecting to Windows servers using PowerShell over HTTP.

- Type: integer
- Default value: 5985
**mid.powershell_api.winrm.skip_ssl_cert_check**

Skips the SSL certificate check when using WinRM for HTTPS connections.

- **Type:** true | false
- **Default value:** false

**mid.powershell_api.winrm.skip_ssl_cert_check_options**

Skips specific SSL certificate checks when using WinRM for HTTPS connections. Configure the MID Server to skip checks for certificates from a Certification Authority (CA), from the Common Name (CN) that identifies the host associated with the certificate, and for revoked certificates.

- **Type:** string
- **Default value:** -SkipCACheck -SkipCNCheck -SkipRevocationCheck

**mid.powershell.use_credentials**

Determines the credentials to use for Discovery with PowerShell. A setting of **true** directs the MID Server to run probes with the Windows credentials from the credentials table. To run probes with the credentials of the user for the MID Server service, set this parameter to **false**.

- **Type:** true | false
- **Default value:** true

**mid.powershell.path**

Enables an administrator to point to a specific PowerShell on a MID Server in cases where more than one PowerShell is installed. Supply the path to the folder containing the PowerShell executable, for example, C:\mypowershell or C:\mypowershell. ServiceNow automatically appends the string powershell.exe to the path. Configure this parameter when both a 32-bit and 64-bit PowerShells are active on the same MID Server, and it becomes necessary to launch the correct PowerShell for the context. 64-bit Windows employs file system redirection and the MID Server runs as a 32-bit application. If trying to specify a path in %WinDir%\System32, Windows automatically redirects to %WinDir%\SysWOW64. To avoid redirection, specify the path as %WinDir%\Sysnative. For example,
instead of C:\WINDOWS\system32\WindowsPowerShell\v1.0\,
specify C:\\WINDOWS\sysnative\WindowsPowerShell\v1.0\.

⚠️ **Note:** On a 64-bit version of Windows XP, a Microsoft hotfix may be required to enable this.

To discover applications running on a 64-bit Windows machine, the MID Server must be running on a 64-bit Windows host machine.

- Type: string (path)
- Default value: none

**mid.powershell.enforce_utf8**

Enable this parameter to force commands on a target Windows system to return UTF-8 encoded output. Disabling it allows the target system to use its default encoding. This parameter is only valid when PowerShell is enabled.

Setting this value to **false** may result in incorrect values in the CMDB when non-ASCII characters are returned by a probe.

- Type: true | false
- Default value: true

**mid.powershell.local_mid_service_credential_fallback**

Enables automatically falling back to MID Server service credentials if all other credentials fail.

- Type: true | false
- Default value: true

**mid.powershell_api.idle_session_timeout**

Specifies the timeout value of idle PowerShell sessions in seconds.

⚠️ **Note:** Setting or changing this parameter requires restarting the MID Server.

- Type: integer
- Default value: 60

**mid.powershell.command.parameter_passing**
Enable this parameter to allow passing PowerShell parameters from the command line.
• Type: true | false
• Default value: false

`mid.powershell.command.script.parameter_passing`
Enable this parameter to allow passing PowerShell scripts from the command line.
• Type: true | false
• Default value: true

`mid.windows.management_protocol`
Enables administrators to select the Windows management protocol used for device and process classification. Options include: WMI and WinRM.
• Type: string
• Default value: WMI

`mid.windows.probe_timeout`
Sets the timeout interval for all Windows probes on a specific MID Server. This value is overridden by the values configured for individual probes with the `wmi_timeout` probe parameter.
• Type: integer
• Default value: 300

`mid.powershell.jea.append_username`
Specifies whether user name of the current user will be appended to the JEA endpoint.
• Type: true | false
• Default value: False

`mid.powershell.jea.endpoint`
JEA configuration name (endpoint) on remote servers that the MID Server will connect to. Set to `JEADISCO_BASIC`.
• Type: string
• Default value: ""
Add a MID Server parameter

Use a MID Server parameter to control the behavior of a particular MID Server.

Before you begin

Role required: admin

Procedure

1. Navigate to MID Server > Servers.
2. From the list of MID Servers, select a MID Server to configure.
3. Select the Configuration Parameters related list.

   This shows all the parameters currently in the MID Server's configuration file. If there are any passwords, they are displayed in asterisks for security reasons. See MID Server parameters for a list of available parameters.

   ![Configuration Parameters](image)

4. To add parameters, click New, and then complete the form.

   After the form is submitted, the configuration file for that MID Server is modified to include the new parameter. Changes to existing parameters are reflected in the MID Server configuration file as well. Changes made to the MID Server configuration file do not take place immediately, but rather the next time the MID Server is restarted. The MID Server form has a related link for restarting the MID Server.

   **Note:** ServiceNow prevents you from saving changes, such as modifying or deleting parameters, that would cause the MID Server to lose communications with the instance. For example, you cannot change the url parameter. Any changes to these protected parameters must be made directly in the config.xml file for that MID Server.
5. (Optional) Set parameters in the config.xml file. MID Server configuration is controlled by an XML file called config.xml. This file is located in the /agent directory, in the MID Server installation directory. You can edit this file directly to make any configuration changes to protected parameters. Many configuration changes, such as those that do not disrupt communication between the MID Server and the ServiceNow instance, may also be made from the instance.

The structure of the config.xml file is simply an outer parameters tag and a series of inner parameter tags. Each parameter tag has name and value attributes.

- To change the value of a parameter, edit the value attribute.
- To add a parameter, add another parameter tag with its name and value.
- To delete a parameter, delete the entire parameter tag.

The order of the parameters within the file is not important. Notice the green comment sections in the sample. Use these elements to add useful comments to the configuration file.

Note: When configuring the MID Server for use with a proxy server, be sure to remove the comment tags around the proxy sections that you configure.
MID Server config.xml file

```xml
<parameters>
</!-- MID Server Configuration -->
  <parameter name="url" value="https://example.service-now.com"/>
  <parameter name="refresh_rate" value="65"/>
  <parameter name="name" value="Super Duper MID Server #1"/>
  <parameter name="mid_sys_id" value=""/>
</!-- MID Server Threads -->
  <parameter name="threads.max" value="25"/>
</!-- MID Server proxy configuration -->
  <parameter name="mid.proxy.host" value=""/>
  <parameter name="mid.proxy.port" value=""/>
  <parameter name="mid.proxy.username" value=""/>
  <parameter name="mid.proxy.password" value=""/>
</parameters>

MID Server to instance configuration options
  mid.instance.use_proxy
  - when talking to instance, should we use the proxy config?
  mid.instance.username
  mid.instance.password
  - supply username and password if instance has basic authentication enabled

MID Server upgrade options
  mid.upgrade.use_proxy
  - when talking to upgrade server, should we use the proxy config?
  mid.upgrade.branch
  - define a branch our MID server is pinned to

Note: The sample file here is from a Firefox browser. Conventional text editors, such as Notepad, WordPad, or TextEdit, do not display colors and variable fonts.

MID Server protected records and reserved characters

Some MID Server records cannot be altered. Certain special characters are pre-defined in XML and cannot be used in passwords.
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

**MID Server Records that cannot be altered**
These records cannot be modified or deleted.

<table>
<thead>
<tr>
<th>Table</th>
<th>Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public Page [sys_public]</td>
<td>InstanceInfo</td>
</tr>
<tr>
<td>Scripted Web Service [sys_web_service]</td>
<td>• InstanceInfo</td>
</tr>
<tr>
<td></td>
<td>• GetMIDInfo</td>
</tr>
<tr>
<td></td>
<td>• MIDAssignedPackages</td>
</tr>
<tr>
<td></td>
<td>• MIDFieldForFileProvider</td>
</tr>
<tr>
<td></td>
<td>• MIDFileSyncSnapshot</td>
</tr>
<tr>
<td></td>
<td>• MIDServerCheck</td>
</tr>
<tr>
<td></td>
<td>• MIDServerFileProvider</td>
</tr>
</tbody>
</table>

**Using special characters in an XML file**
The XML specification defines five predefined entities that represent special characters, and requires that all XML processors honor them. If these characters are used in a password, you will experience unexpected results.

The following characters represent the five pre-defined entities:
If you use the pre-defined entity characters in an XML file, such as the MID Server configuration file, you need to encode them. To encode pre-defined entities into an XML document:

- replace " with &quot;
- replace & with &amp;
- replace ' with &apos;
- replace < with &lt;
- replace > with &gt;

For example, to specify the password as test& in the MID Server config.xml file:

```
<parameter encrypt="true" name="mid.instance.password" value="test&amp;"/>
```

**MID Server privileged commands**

To discover certain information on a host server, the MID Server must run SSH commands with higher privileges. The platform provides default privileged commands for the MID Server to use and the ability to add additional commands to the system.
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

An example of information that requires elevated privileges is information about storage disks on a host server, retrieved with the `fdisk -l` command. If your system cannot use sudo commands, you must configure the hosts in your network to use one of the other privileged commands. You can configure different privileged commands for different hosts. However, Discovery supports only one privileged command per host.

**Important:** You can edit supported privileged commands, but do not delete them.

For a list of possible SSH commands requiring root privileges, see [SSH credentials](#).

**SSH privileged escalation command requirements**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| sudo    | • Host must support the `sudo -S -p <password>` command and return the correct list of allowed SSH commands.  
• Credentials provided for Discovery must be able to run the command `sudo -S -p <password> <commands>`. |
| pbrun   | • Host must support the `pbrun -v` command and return the correct version of PowerBroker.  
• Credentials provided for Discovery must be able to run `pbrun <commands>`.
### SSH privileged escalation command requirements (continued)

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| • Discovery does not support any other `pbrun` - options, such as a password prompt.  
• The instance must be able to reach the target host via SSH. | |
| `pfexec` | • Host must support the `pfexec id -a` command and return the correct ID.  
• Credentials provided for Discovery must be able to run `pfexec <commands>`.  
• Discovery does not support any other `pfexec` - options, such as a password prompt. | |
| `dzdo` | • Host must support the `command -v dzdo` command and return the path to dzdo in standard output.  
• Credentials provided for Discovery must be able to run `dzdo <commands>`.  
• Discovery does not support any other `dzdo` - options, but Discovery supports password authentication for `dzdo`. | |

### Long-running commands with sudo

Configure J2SSH and ServiceNow SSH to prevent long running commands using sudo from failing when the MID Server disconnects.

ServiceNow SSH allows probes to run sudo against individual commands or an entire, long-running script. This is also supported for the `pbrun` and `pfexec` privileged commands.

### Sudo for individual commands

You can run sudo against individual commands within a probe, but only if all the following sudoer configurations are performed on the target:

• The `!requiretty` option is required.

• Allow individual commands to be run by the user in the provided credential with `NOPASSWD` configured.

• The target specifies an individual sudo call in the command or referenced scripts. For example, set sudo as "`sudo fdisk -I" or "$\{sudo:fdisk -I\}" rather than "must_sudo" for the entire script."
Note: Running sudo against individual commands with ServiceNow SSH produces detailed and useful entries in the sudo logs on the target computer.

Running sudo on an entire script
If any of the required sudoer configuration requirements for individual commands is not in place, Discovery applies sudo to the initial and complete probes, and does not execute sudo remotely inside the command. This condition can be forced by setting `must_sudo` on the probe and eliminating any sudo commands within the probe.

This approach prevents long running commands from failing when the probe disconnects, but cannot specify individual commands in the sudoers configuration.

Logging
The logs from ServiceNow SSH sudo activity run against an entire script show cryptic entries, such as `/tmp/.run.aef13123fe124123`, which prevent administrators from controlling permissible commands and knowing the exact command that was run. Sudo run against individual commands produces more detailed log entries, such as `/sbin/fdisk -l`.

Add a new privileged command for use by the MID Server
Add a new privileged command to the Privileged Command [privileged_command] table that is available to your MID Servers.

Before you begin
Role required: admin

About this task
⚠️ Important: Do not delete any of the supported commands.

Procedure
1. Navigate to MID Server > Privileged Command and click New.
2. Complete these fields:
   • Command: The name of the privileged command.
   • Password Prompt: The password prompt displayed to the user for this privileged command, or a regular expression that matches this password.
prompt. If this field is empty, no password is required for this privileged command, and no prompt is displayed. SUDO commands do not require a password prompt.

3. Click Submit.

Configure the MID Server to use specific privileged commands
You can configure the MID Server to use specific commands in a defined order.

Before you begin
Role required: admin

Procedure
1. Navigate to the list of MID Servers using one of the following paths:
   - MID Server > Servers
   - Discovery > MID Servers
   - Orchestration > MID Servers
2. Select the MID Server you want to configure.
3. Click the menu icon in the header bar and select View > Advanced from the context menu.

Selecting the Advanced view
4. In the Privileged Command related list, click **Edit**.

5. Select the command you want this MID Server to use and click **Save**. The default order of privileged commands is 100, but you can change the order as necessary. The privileged command with the smallest order number is tried first.

---

**List of privileged commands to use for a MID Server**

Create a **pbrun** profile privileged command

You can create a special configuration for the **pbrun** privileged command that allows it to run as a profile.

**Before you begin**

Role required: discovery_admin, admin

**About this task**

Of all the privileged commands, only the **pbrun** command can be configured to run as a profile, and only one of these special **pbrun** configurations can function on a MID Server.

**Important:** Edit the existing **pbrun** record for this purpose. The system ignores any additional commands you create for **pbrun**.

**Procedure**

1. Navigate to **MID Server > Privileged Command**.

2. Select **pbrun** from the list.

3. In the Privileged Command record, edit the value in the **Command** field to use the format `pbrun -u <profile>`. For example, you can set `pbrun -u admin` as a command to run with an admin profile.

4. Click **Update**.
What to do next
Return to Configuring MID Servers.

MIDSystem methods

MIDSystem variables (referred to by the variable name ms.) provide a variety of methods to get information about the MID Server.

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

<table>
<thead>
<tr>
<th>Method summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>log(String message)</td>
<td>Logs the given message with a standard prefix to indicate that the message was generated by JavaScript.</td>
</tr>
<tr>
<td>getConfigParameter(String parameter name)</td>
<td>Returns the value of the named configuration parameter.</td>
</tr>
<tr>
<td>include(String script include)</td>
<td>Include the MID Server script include with the given name into the current context.</td>
</tr>
<tr>
<td>getName()</td>
<td>Returns the name of the MID Server.</td>
</tr>
<tr>
<td>getSysID()</td>
<td>Returns the sys_id of the MID Server.</td>
</tr>
<tr>
<td>toJavaScript(Object)</td>
<td>Converts the given Java object into the equivalent JavaScript object.</td>
</tr>
</tbody>
</table>
This example writes a message to the log:

```javascript
ms.log('Attempting to log in with user: ' + this.getParameter('user'));
```

**Manually start, stop, and restart a MID Server**

If you did not start the MID Server at the end of the installation procedure, you can manually start the MID Server.

**Before you begin**

Requires a MID Server Service account user or a Windows Admin account. This procedure is only for users who install the MID Server using the ZIP file. The Windows MID Server installer completes the installation automatically.

**Procedure**

1. Open the agent directory in the directory you created for the MID Server installation files. For example, the path might be `C:\ServiceNow\MID Server1\agent`.
2. Start the MID Server by executing the `start.bat` file.
3. To stop the MID Server, execute the `stop.bat` file.
4. To restart a stopped MID Server, either:
   - If the MID Server is stopped, execute the `start.bat` file.
   - If the MID Server is running, execute the `restart.bat` file.

**MID Server heartbeat**

The instance checks the MID Server for a response every 5 minutes, using a synthetic transaction monitoring system.
Checking for a heartbeat

ServiceNow instances send a synthetic transaction via the Heartbeat probe to every MID Server every 5 minutes. The Heartbeat probe functions exactly as a normal probe does and is sent by writing an output record to the ECC queue. A MID Server retrieves the record when it queries the ECC queue for work. The MID Server processes the probe just as it would any other probe and responds back to the instance. If the instance does not detect a response from a MID Server, the instance marks that MID Server as **Down**. If the MID Server responds, the instance considers the MID Server to be functioning and communicating properly with the instance.

⚠️ **Note:** Make sure that your MID Server can communicate on port **443**. See Configure MID Server network connectivity and MID Server system requirements for more information.

System events

When a MID Server transitions from one state to another, one of these events is triggered:

- **mid_server.up**: The MID Server goes from a status of **Down**, **Paused**, or **Upgrading** to a status of **Up**.
- **mid_server.down**: The MID Server goes from a status of **Up** to a status of **Down**.
• **mid_server.paused**: The MID Server is paused.

• **mid_server.upgrading**: The MID Server is being automatically upgraded because the instance is being upgraded.

You can use these events to send notifications or trigger actions that you specify in scripts.

**Scheduled job**
To change the trigger interval for the Heartbeat probe, navigate to **System Scheduler > Scheduled Jobs > Scheduled Jobs**. Open the **MID Server Monitor** record and edit the interval.

**MID Server heartbeat trigger interval**

![MID Server heartbeat trigger interval](image)

**Set the MID Server JVM memory size**
The MID Server starts with a default JVM memory allocation, but you can modify this setting in the configuration file.

**Before you begin**
Role required: admin
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

About this task
In the base ServiceNow system, the MID Server JVM memory is set to 1024 MB, which is configured in the `\agent\conf\wrapper-override.conf` file in the MID Server installation directory. This setting might not be appropriate for the way your organization uses the MID Server. If you want the MID Server to work harder, allocate more resources to it. If the MID Server is located in a small branch office and runs in an environment where memory allocation is shared between a print server, mail server, or web proxy server, the allocation might have to be reduced.

ℹ️ Note: For a complete list of minimum MID Server requirements, see MID Server system requirements.

Procedure
1. Open the `\ServiceNow\<MID Server name>\agent\conf\wrapper-override.conf` file in a text editor.
   For more information about this file, see Installing Multiple MID Servers on a Single System.
2. Locate the following lines in the file:
   ```
   # OPTIONAL: Maximum Java Heap Size (in MB)
   wrapper.java.maxmemory=1024
   ```
3. Edit the memory allocation.
4. Remove the comment tag (#) from the memory allocation parameter.
5. Save the file.
6. Restart the MID Server service.

**Pause the MID Server**

Pause the MID Server to temporarily prevent it from polling the ECC Queue for work or sending Discovery results back to the instance.

**Before you begin**
Role required: agent_admin

---

1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

**About this task**

You can only pause validated MID Servers. You might want to pause the MID Server when your network infrastructure is undergoing changes. This prevents applications like Discovery from throwing errors during a particular maintenance window.

A paused MID Server continues processing commands that it had already retrieved before it was paused. When you resume the MID Server, the MID Server starts retrieving new commands to process.

**Note:** Discovery continues to assign jobs to MID Servers that are **Paused**. MID Servers that are **Down** are not assigned jobs.
Procedure
1. Open the MID Server record.
2. Select a running MID Server that has been validated.
3. On the MID Server form, select **Pause MID** under **Related Links**. The state of the MID Server changes to **Paused**.

A paused MID Server

- **Name**: MidServer1
- **Version**: Version
- **Host name**: MidServer1hostname.com
- **Status**: Paused
- **Validated**: Yes

4. To resume MID Server processing, select **Resume MID** under **Related Links**.

**MID Server pause**
The MID server can be put into a **Paused** state to temporarily prevent it from polling the ECC Queue for work or sending Discovery results back to the instance.

Unlike stopping the MID Server from the Windows or Linux server command line on the MID Server machine, pausing the MID server is something that you can do from the instance. The MID Server pause feature is available starting with the Istanbul release.

**Note:** You can only pause **validated MID Servers**.

You can still perform these actions when the MID Server is paused:

- **Access the MID Server logs** and delete log entries.
- **View MID server statistics**. While the MID Server is in the **Paused** state it stops generating statistics. But you can still view the statistics generated before you paused the MID Server.
- **Retrieve the MID Server thread dump**.
- **Make and save configuration changes** and property changes to the server. The changes take effect after the MID Server is resumed.
- **Clear the ECC queue**.

The **MID server heartbeat** continues to function while the MID Server is in the **Paused** state. If the MID Server is upgraded while it is in the **Paused** state, the MID Server state automatically changes to **Up** after successful upgrade. It does not return to the **Paused** state.
During **MID Server selection**, paused MID Servers can still be selected but are prioritized below MID Servers that are not paused.

**Events that occur during MID Server pause**

The **vCenter** and **SNMP** event collectors, continue to run and process events when you pause the MID Server. These events are not part of the normal synchronous communication that the MID Server has with the instance that you see in the ECC queue. Events are still relayed to the instance and can even trigger actions on records in the instance, such as a CI update. For example, if vCenter detects that a virtual machine goes down or is deleted, a vCenter event makes a change to the status of the corresponding CI record for that virtual machine.

To prevent these events from being processed, stop the extensions from running. For more information, see:

- Configure and run the vCenter event collector extension
- Configure the SNMP Trap Collector Extension

**Notifications**

Use ServiceNow® Notifications to manage system email, create system notifications, and configure how your system responds to inbound email.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Email</th>
<th>Push Notifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Upgrade to Rome</td>
<td>• Basic email setup</td>
<td>• Push notifications</td>
</tr>
<tr>
<td>• Domain separation and Notifications</td>
<td>• Advanced email setup</td>
<td>• Push notification setup with the ServiceNow Classic mobile app</td>
</tr>
<tr>
<td>• Developer training</td>
<td>• Create an email notification</td>
<td>• Push notification setup with a custom push application for ServiceNow Classic mobile apps</td>
</tr>
</tbody>
</table>

**Subscription-based notifications**

- Create notification channels
- Modify notification channels
- Create personal notifications

**Notifications in messaging applications**

- Setup
- Configure message content
- Create a messaging notification

**Provider notification**

- Create a provider notification
- Create and add additional recipients
- Create common content for a notification
Email setup

All email notifications use the email properties that you define for your instance and the email accounts that you set up. Your email service can also affect the successful transmission of incoming and outgoing email.

Email accounts

Email administrators set up email accounts to allow the system to connect to external mail services such as POP3, SMTP, or IMAP servers. You can use the ServiceNow-provided email accounts or create your own accounts for your own email services.

Email properties

Use Email Properties to configure settings for inbound and outbound email. Email properties apply to all email accounts.

Email service size restrictions

Your email service, whether you are using a standard ServiceNow email configuration or an alternate email configuration, determines the successful transmission of incoming or outgoing emails based on a maximum email size. An email configuration consists of your instance, email server, and email client.

- Standard email configurations – For instances that use the standard email configuration, the ServiceNow mail servers cannot send or receive emails
larger than approximately 50 MB (before encoding), including the email header, body text, and attachments. Email messages are encoded by an email client, which increases total email message size. The maximum ServiceNow mail server size restriction is 75 MB (after encoding). The maximum email size limit is enforced regardless of any configured attachment size limits.

- **Alternate email configurations** – If your email service uses a company-owned or third-party server, the approximate size restriction of 50 MB (including the email header, body text, and attachments) may still apply. However, your service might support different maximum total file sizes for inbound and outbound emails. Check with the email administrator of your email service to verify email size limits.

For details on how encoding can affect email message size and email transmission, see KB0521772.

**Email service availability**

Email service is intentionally shut down on instance clones to prevent resending already delivered email. Upgrades no longer require an extended interruption of email service. Instances continue to process email during an upgrade. For a possible explanation for undelivered emails, see this blog post by a ServiceNow Technical Support Engineer in the Now Community.

For instructions on creating and sending custom emails when events on the instance occur, see the tasks in Email and SMS notifications.

**Instance-to-instance communication via email**

Use to communicate between two instances.

**Designate untrusted and trusted email domains**

Using Instance Security Center, you can monitor the blocked and allowed incoming email metrics for your instance. For more information, see Designate untrusted and trusted email domains.

**Next steps after enabling email**

After enabling email on your instance, consider performing several of these important tasks.

- Test the email configuration by routing all email to a single user (set the glide.email.test.user property).
- Review the baseline notification categories, email notifications, and templates to determine if they meet your business needs.
• Review the baseline inbound email actions to determine if they meet your business needs.

• Determine if you want to use email layouts to add consistent content elements.

• Determine if you want to use email filters to restrict the email the instance receives.

• Determine if you want to implement a retention policy to archive and destroy email at certain intervals.

• Determine what kind of watermarks outbound email uses to associate records with email messages.

• Determine if you want to create users when the instance receives an email from an unrecognized user.

• Set the precedence of outgoing mail. By default, the instance sends email with a precedence of bulk (set the glide.smtp.precedence_bulk property).

• Consider preventing untrusted users from triggering inbound actions to prevent unwanted email from affecting your instance.

• Implement a spam filter to restrict unwanted messages sent to your custom email addresses.

Basic email setup

All production instances can send and receive email using ServiceNow-provided resources. The instance has an email address of instance@service-now.com.
Basic email services and features

- Mail servers maintained by ServiceNow.
  - Encrypt mail with opportunistic TLS (Transport Layer Security) if supported by your mail servers.
    - If your internal mail servers send and receive messages via a TLS-encrypted channel, ServiceNow mail servers support that communication.
  - Provide a dedicated mailbox for your instance.
- Pre-configured email accounts to connect to ServiceNow mail servers.
An SMTP account sends email to your primary Mail Exchange (MX) server from your instance email address of instance@service-now.com.

A POP3 account receives email sent to your instance email address of instance@service-now.com.

- High availability features from ServiceNow datacenters.
- Spam detection for incoming email.

Administrators who want to use basic email services can do so by enabling the email properties for sending and receiving email.

**Enable basic email**

Enable basic email to use ServiceNow-provided email servers and accounts.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Properties > Email**.
2. Configure these email properties and click **Save**.

<table>
<thead>
<tr>
<th>Email property descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Property section</strong></td>
</tr>
<tr>
<td>Outbound Email Configuration</td>
</tr>
<tr>
<td>Inbound Email Configuration</td>
</tr>
</tbody>
</table>

**Advanced email setup**

With an advanced email setup, you can use your own SMTP server, POP3 server, or both.

Setting up your own email environment can be useful if you want to use existing filtering, retention, or compliance aspects of your internal email architecture.

You can set up email in several ways:

- Use your own SMTP server to forward email to ServiceNow servers.
- Use your own SMTP server to send email.
• Use your own POP3 server to receive email.
• Use your own SMTP and POP3 servers to send and receive email.
• Use an OAuth 2.0-enabled SMTP server to send email from a third-party service.
• Use an OAuth 2.0-enabled IMAP server to receive email from a third-party service.

The following procedures assume that you enabled basic email properties.

Enable using your own SMTP server
Enable using your own SMTP server so that you can leverage the existing filtering, retention, or compliance aspects of your own SMTP server while also using the ServiceNow POP3 server.

Before you begin
• Role required: admin
• Email server required: SMTP
• Basic email properties: enabled

About this task
You can combine your own internal email architecture with the ServiceNow email architecture to handle email. The following diagram demonstrates how you would use your own SMTP server alongside the ServiceNow POP3 server.
Procedure

1. Navigate to **System Mailboxes > Administration > Email Accounts**. The system displays the list of available email accounts.

2. Locate the record for **ServiceNow SMTP** and change **Active** to **false**.
3. Click **New**.

4. Create an email account record for your SMTP server where the **Type** is **SMTP**.

5. From **Related Links**, click **Test Connection**.
   If the email account is valid, the system returns a success message.

**What to do next**
Configure the SMTP server in your internal email architecture to forward email from the custom email address to the instance email address. Implement a spam filter on the custom email address.

**Related information**

Configure an email account

Enable using your own POP3 server
You can use your own POP3 server to store and receive email for the instance.
Before you begin

- Role required: admin
- Email server required: POP3
- Basic email properties: enabled

Procedure

1. On your POP3 server, create a mailbox for your instance that has a custom email address. For example, create a mailbox for service-desk@company.com.

2. Navigate to System Mailboxes > Administration > Email Accounts. The system displays the list of available email accounts.

3. Optional: If you do not want to receive email sent to the instance@service-now.com mailbox, locate the record for ServiceNow POP3 and change Active to false.

   An instance can receive email from multiple POP3 accounts at the same time. Leaving the ServiceNow POP3 account active allows the instance to receive email sent to the instance default email address.

4. Click New. The system displays a blank Email Account form.

5. Create an email account record for your POP3 server where the Type is POP3.

6. From Related Links, click Test Connection.
If the email account is valid, the system returns a success message.

Connection Test

Connection Successful

Close
Enable using your own SMTP and POP3 servers

You can use your own SMTP and POP3 servers to send email from the instance and to store and receive email for the instance.
Before you begin

- Role required: admin
- Email servers required:
  - SMTP
  - POP3
- Basic email properties: enabled

Procedure

1. On your POP3 server, create a mailbox for your instance. For example, create a mailbox for service-desk@company.com.

2. Navigate to System Mailboxes > Administration > Email Accounts. The system displays the list of available email accounts.

3. Locate the record for ServiceNow SMTP and change Active to false.

4. Optional: If you do not want to receive email sent to the instance@service-now.com mailbox, locate the record for ServiceNow POP3 and change Active to false.

An instance can receive email from multiple POP3 accounts at the same time. Leaving the ServiceNow POP3 account active means that the instance receives email sent to its default email address.
5. Click **New**.
The system displays a blank Email Account form.

6. Create an email account record for your SMTP server where the **Type** is **SMTP**.

7. From **Related Links**, click **Test Connection**.
   If the email account is valid, the system returns a success message.

8. Click **New**.
The system displays a blank Email Account form.

9. Create an email account record for your POP3 server where the **Type** is **POP3**.

10. From **Related Links**, click **Test Connection**.
If the email account is valid, the system returns a success message.
Example:

Using your own SMTP and POP3 servers

OAuth email authentication

OAuth enables your instance to receive and send email through a third-party email account.

Open Authentication (OAuth) is an open standard for authorization that provides administrators with an authorization method when connecting to incoming IMAP and outgoing SMTP servers. OAuth enables an instance to...
receive and send email from a third-party account, such as Gmail, without having to enter the credentials for that account.

The OAuth 2.0 implementation requires you to obtain an access and refresh token from your third-party email provider for each third-party email account. The tokens are automatically saved to the instance database. They provide authorization for all email communication between the instance and the authorized third-party account. A scheduled job regularly checks to see if email access tokens are valid. If the access token is not valid, but the refresh token is, the instance automatically regenerates a new access token.

OAuth 2.0 support is available starting with the Geneva release. The OAuth implementation supports IMAP and SMTP accounts only. POP3 is not supported. OAuth 1.0 is no longer supported.

⚠️ Note: Customer email accounts configured to use OAuth 1.0 authentication with Gmail cease to function as of April 20, 2015. See KB0546976 for more information.

Activating the Email - OAuth support for IMAP and SMTP plugin allows you to use OAuth with email. If you upgrade to Geneva or later instances and are already using OAuth 1.0, activate the plugin again.

See for an example of using an OAuth 2.0 profile to authenticate an outbound REST message with Google to retrieve contact information. Also see for more information on OAuth 2.0 support in the instance.

Activate the OAuth email authentication plugin

OAuth email authentication requires the Email - OAuth support for IMAP and SMTP plugin.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

---

**Enable OAuth 2.0 for email**

Setting up OAuth 2.0 for email requires you to obtain access and refresh tokens from your email provider.

**Before you begin**

- Role required: admin
- Plugin required: Email - OAUTH support for IMAP and SMTP

**Procedure**

1. Log in to your third-party email account, such as Gmail, and enable OAuth 2.0.

2. Obtain the following from your third-party email account:
   - client ID
   - client secret
   - authorization URL
   - token URL
   - redirect URL
   - token revocation URL

3. Navigate to **System OAuth > Application Registry**.

4. Click **New**.

5. Click **Connect to a third party OAuth Provider** to create an application registry record that email uses.

6. Use the information you obtained from your third-party email account to fill in the fields on the form. See for instructions. Create the OAuth application registry record and its associated OAuth Entity Profile and OAuth Entity Scope records.

7. Click **Submit**.

8. Navigate to **System Mailboxes > Administration > Email Accounts**.
The system displays the list of available email accounts.

9. Optional: If you do not want to receive email sent to the default instance email address, locate the record for ServiceNow POP3 and change Active to false.

The system can receive email from multiple POP3 and IMAP email accounts.

10. Locate the records for ServiceNow SMTP and change Active to false.

11. Click New.

The system displays a blank Email Account form.

12. Create an email account record for your OAuth 2.0 SMTP server where the Type is SMTP.

13. For Authentication, select OAuth 2.0.

14. For OAuth Profile, select the application registry record you created.

15. Click Authorize Email Account Access to obtain the access and refresh tokens.

Another browser window opens asking you to authorize the account access on the third-party email account.

16. Authorize the access.

After the authorization is successful and the tokens are saved to the instance, the Authorize Email Account Access button no longer appears on the Email Account form.

17. Click New.

The system displays a blank Email Account form.

18. Create an email account record for your OAuth 2.0 IMAP server where the Type is IMAP.

Use the same Authentication and OAuth profile settings as the OAuth SMTP email account.
System address filters

Prevent your system from communicating with untrusted domains and email addresses.

System address filters control who can communicate with your instance via email. You can improve email security by filtering domains and email addresses that you find suspicious.

For example, you might identify example.com as a suspicious domain. You can stop receiving emails from example.com by specifying the domain in a system address filter. You can also use another system address filter to prevent your system from sending emails to example.com.

There are two types of system address filters:

- **Outbound**
  - Controls which domains and email addresses can receive email from your instance.

- **Inbound**
  - Controls which domains and email addresses can send email to your instance.

When setting up system address filters, you can create one default outbound filter and one default inbound filter. A default outbound filter applies to all active SMTP email accounts automatically. A default inbound filter applies to all active IMAP or POP3 email accounts automatically.

To control senders and recipients for a specific email account, create a non-default filter and then apply it to the account.

**Before setup**

Before you set up system address filters, consider doing the following:

- Monitor your email to identify suspicious domains and email addresses.
  - Using Instance Security Center, you can monitor the blocked and allowed incoming email metrics for your instance. For more information, see Designate untrusted and trusted email domains.
- Designate someone to set up system address filters by assigning them the email_account_admin role.

**Setting up system address filters**

To set up system address filters for your instance, complete the following tasks:

1. **Set email address filters**
   - Specify which domains and email addresses are allowed or disallowed.
2. Create a system address filter

   Define how email address filters apply to inbound and outbound email.

Next steps

After you set up system address filters, configure email filters for an added layer of security. Email filters enable you to ignore an inbound email or move it to a particular mailbox. For more information on configuring email filters, see Email filters.

Set email address filters

Specify which domains and email addresses are allowed or disallowed.

Before you begin

Role required: email_account_admin

About this task

You can specify two types of email address filters:

- Allow List: A list of allowed domains and email addresses
- Deny List: A list of disallowed domains and email addresses

You can also specify exceptions to the allowed or disallowed domains and email addresses.

Procedure

1. Navigate to System Mailboxes > Administration > Email Address Filters, and then click New.

2. Enter the Name of the address filter.

3. Select the filter Type:
   - Allow List: Allow all specified domains. All other domains are disallowed.
   - Deny List: Disallow all specified domains. All domains that do not match the denied list domains are allowed.

4. In the Domains field:
   a. Click the lock icon to unlock it and access the domains controlled by this filter.
   b. Select an existing domain or enter a new domain:
• If the filter **Type** is Allow List, click the Search icon. Select the domains for which all email addresses are allowed. To add a new domain, click **New**, enter the **Domain**, and click **Submit**.

• If the filter **Type** is Deny List, click the Search icon. Select the domains for which all email addresses are disallowed. To add a new domain, click **New**, enter the **Domain**, and click **Submit**.

**Note:** You can specify a wildcard (*) in the domain name, for example *.com*. If you create an email configuration that has multiple email address filters, all the filters evaluate the given email addresses. The filters determine whether the addresses are valid and the message can be sent as outbound email.

By default, the maximum number of domains that you can associate with an email address filter is 100. You can reconfigure this limit by setting the `glide.email_address_filter.max_domains` property.

c. Click the lock icon to lock the **Domains** field.

5. Specify any email addresses that are **Exceptions** to the domains specified in Step 4.

   a. Click the lock icon to open the Email Address Filter Exceptions [sys_email_address_filt_except] table.

   b. Click the search icon to choose an existing email address. To add a new email address, click **New**, enter the email address exception, and click **Submit**.

   **Note:** You can specify a wildcard (*) in an email address exception.

By default, the maximum number of exceptions that you can associate with an email address filter is 1000. You can reconfigure this limit by setting the `glide.email_address_filter.max_exceptions` property.

c. Click the lock icon to lock the **Exceptions** field.

   The exception is added to the Email Address Filter Exceptions [sys_email_address_filt_except] table.

6. Click **Submit**.

   The email address filter is added to the Email Address Filters [sys_email_address_filter] table.
Example:

**Email address filter — allowed exception example**

**Email address filter — disallowed exception example**

### What to do next

Apply the email address filters to a system address filter. For more information, see Create a system address filter.

### Create a system address filter

Define how email address filters apply to inbound and outbound email.

### Before you begin

Complete the steps in Set email address filters.

Role required: email_account_admin

### About this task

You can use a combination of allowed list and denied list email address filters in a system address filter.

A system address filter blocks a domain or address that appears only on denied lists and never on allowed lists. To ensure that a system address filter effectively blocks a certain domain or address, check for the following:

- The domain or address is included in at least one denied list
- The domain or address is not included in any allowed list
**Procedure**

1. Navigate to **System Mailboxes > Administration > System Address Filters**, and then click **New**.

2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the system address filter.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the system address filter.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of system address filter. Select one of the following:</td>
</tr>
<tr>
<td></td>
<td><strong>Outbound</strong></td>
</tr>
<tr>
<td></td>
<td>Control which domains and email addresses can receive email from your instance. Select this option if you plan to use the system address filter for an SMTP server.</td>
</tr>
<tr>
<td></td>
<td><strong>Inbound</strong></td>
</tr>
<tr>
<td></td>
<td>Control which domains and email addresses can send email to your instance. Select this option if you plan to use the system address filter for an IMAP or POP3 server.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the system address filter.</td>
</tr>
<tr>
<td>Default</td>
<td>Option to use this system address filter as the default inbound or outbound filter.</td>
</tr>
<tr>
<td></td>
<td>To control senders and recipients for a specific email account, leave this field cleared.</td>
</tr>
<tr>
<td>Short description</td>
<td>Description of the system address filter.</td>
</tr>
<tr>
<td>Email Address Filters</td>
<td>Email address filters to apply to the system address filter.</td>
</tr>
<tr>
<td></td>
<td>By default, the maximum number of email address filters that you can associate with a single system address filter is 100. You can reconfigure this limit by setting the <code>glide.email_system_address_filter.max_address_filters</code> property.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
Results
A default outbound filter applies to all active SMTP email accounts automatically. A default inbound filter applies to all active IMAP or POP3 email accounts automatically.

For a non-default filter, the next step is to apply the filter to an email account manually. For more information on applying a filter to an email account, see Configure an email account.

Email accounts
Email accounts store the connection details and credentials the system uses to access external email servers and services.

By default, instances come with email accounts for ServiceNow-managed SMTP and POP3 servers to send and receive email. These accounts cannot be modified, but can be deactivated if you do not want to use them. To connect to other email servers and services you must create email accounts for them. You can create email accounts for servers and services that use these protocols:

- SMTP
- POP3
- IMAP

Note: The system only allows one SMTP email account to be active at a time and sends all email through this account. You can however receive email from multiple POP3 or IMAP accounts.

The system stores individual email accounts in the `sys_email_account` table. Create separate email accounts to send and receive email. Use email properties to define how the system processes email for all email accounts.

By default, the ServiceNow POP3 server provides each instance with its own mailbox at the address instance@service-now.com. Likewise, the ServiceNow SMTP server sends email from the address instance@service-now.com. To create another mailbox, provision your own POP3 or IMAP server and create an email account to the server on the instance. To change the sent from email address, update the address in the email account you use for sending email.

Emails received via a POP3 or IMAP server account are stored in the Email [sys_email] table and then deleted from the account.

Note: ServiceNow has exclusive access to an account you configure. After a mail is read from a POP or IMAP account that you have configured, ServiceNow deletes the email from the server.
A ServiceNow configured email account

Configure an email account

You can create email accounts in addition to the accounts provisioned for you.

Before you begin

- Role required: admin
- Email server: a compatible email server
  - SMTP
  - POP3
  - IMAP

⚠️ Warning: An SMTP server that uses a localhost or loopback (127.0.0.1) IP address is not accepted as a compatible email server. For more information, see KB0724199.
Procedure

1. Navigate to System Mailboxes > Administration > Email Accounts, and then click New.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the email account.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of mail server. You can select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• POP3</td>
</tr>
<tr>
<td></td>
<td>• IMAP</td>
</tr>
<tr>
<td></td>
<td>• SMTP</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The system can use only one active SMTP account at a time.</td>
</tr>
<tr>
<td>Authentication</td>
<td>Type of authentication used for the email account to connect to the email server. You can select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• --- None --</td>
</tr>
<tr>
<td></td>
<td>• Password</td>
</tr>
<tr>
<td></td>
<td>• OAUTH</td>
</tr>
<tr>
<td></td>
<td>• OAUTH 2.0</td>
</tr>
<tr>
<td></td>
<td>The Email - OAUTH support for IMAP and SMTP (com.glide.email.oauth) plugin must be active for the OAuth options to be visible.</td>
</tr>
<tr>
<td>OAuth Provider</td>
<td>OAuth application registry record for this account. This field appears if you selected OAUTH 2.0.</td>
</tr>
<tr>
<td>Server</td>
<td>Remote server to which this account connects. To activate a server for an on-premise installation, enter the full address (FQDN) of the node (for example, node.customerdomain).</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the email account.</td>
</tr>
<tr>
<td>ServiceNow Configured</td>
<td>Identifier of whether this account is provisioned by ServiceNow. If you create an account, this option is not selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable debug output</td>
<td>Option to create node logs for the raw data that is exchanged with the email server. You can review the node logs by navigating to <strong>System Logs &gt; Utilities &gt; Node Log File Browser</strong>. You can enable this field temporarily to diagnose issues related to receiving or sending email.</td>
</tr>
<tr>
<td>Email user label</td>
<td>Display value used for outgoing messages. This field is for SMTP type accounts only.</td>
</tr>
<tr>
<td>User name</td>
<td>User name or ID to authenticate an email address. The value in this field is also the <strong>From</strong> address when the instance sends email. If you are using SMTP, this must be a full email address. The value in the <strong>From</strong> field can override this (for SMTP accounts).</td>
</tr>
<tr>
<td></td>
<td>✪ <strong>Note:</strong> The address in the <strong>From</strong> field on the Notification [sysevent_email_action] form takes precedence over this field.</td>
</tr>
<tr>
<td>Password</td>
<td>Password when the <strong>Authentication</strong> type is <strong>Password</strong>.</td>
</tr>
<tr>
<td></td>
<td>✪ <strong>Note:</strong> You may need to increase the size of this field to accommodate longer passwords. By default, this field has a size of 40 characters.</td>
</tr>
<tr>
<td>From</td>
<td>(SMTP only) The From address used for notifications sent with this account. This address takes precedence over the <strong>User name</strong> field. If nothing is present in this field, the User name is used as the return address for notifications sent from the instance.</td>
</tr>
<tr>
<td>Connection Security</td>
<td>Type of secure connection. Choose a setting:</td>
</tr>
<tr>
<td></td>
<td><strong>None</strong></td>
</tr>
</tbody>
</table>
### Field Description

**Connect to an SSL/TLS encrypted port to secure the connection. Email is encrypted between the ServiceNow instance and your mail server.**

**Warning:** Selecting a less secure protocol like STARTTLS or None may expose your data. To better ensure the security of data in your email server, select SSL/TLS.

**Port**
- Connection TCP port.

**System Address Filter**
- System address filter to apply to the email account. If left blank, the system uses the default system address filter for inbound or outbound email.

For more information, see System address filters.

---

3. Click **Submit**.

4. Click the test connection link at the bottom to test the SMTP, POP3, or IMAP account.

   The system displays a pop-up window with the results of the connection test.
If the test succeeds, click **Close** to return to the email account record. If the test fails, click **View Logs** to display more information about the test results.

**Results**
The system uses the email account to send or receive email.

**What to do next**
Enable the system to send or receive email.

**Multiple email readers**
Organize POP3/IMAP email accounts into email account groups (subsets of email accounts) that can be processed by multiple email reader jobs. To improve the performance of inbound email account processing, you can incrementally add email account groups and if needed, email reader jobs to process email account groups concurrently.

**How email account group processing works**
By default, the email reader job processes POP3/IMAP email accounts serially, which can result in longer processing times when you have many email accounts. It can also be difficult to identify any problematic email accounts that might contribute to slower processing times.

To reduce email account processing time, you can create one or more email account groups that contain subsets of your email accounts. Organizing your email accounts into groups enables the default email reader job to process each email account group separately. After creating one or more email account groups, you can then add another email reader job to process account groups concurrently.

Use the `glide.email.inbound.account_group_processing` system property to activate email account group processing.

During email account group processing:
The system stores the email accounts in the Email Account Groups [sys_email_account_group] table.

The default email reader job runs every two minutes. The email reader chooses the account group to be processed based on the account group processing state and the date and time that the group was last processed.

- Claimed state: If an account group has a claimed state, the email reader is processing the account group. If you defined other email reader jobs, no other email reader job can claim the group for processing.
- Unclaimed state: If an account group is unclaimed, the account group is available for processing by the email reader.

The email reader job processes the email accounts contained in the selected account group.

The email reader job chooses the next available account group for processing and continues processing that account group.

You can monitor the processing of each email account group by using the Email Account Groups [sys_email_account_group] table. Each account group record includes the processing duration (how long it takes for the email reader to process all the accounts in the group).

After you review the processing times for your email account groups, determine whether to make further adjustments in email account group processing. For example, you can create another email account group or create another email reader job to process your email account groups in parallel. You define additional email reader jobs using the Schedule [sys_trigger] table.

**Set up email account group processing**

To set up email account group processing, you must have the email_account_admin or admin role.

1. **Create email account groups.**

   Define one or more email account groups that contain a subset of your POP3/IMAP email accounts. Your base system includes a default email account group. Any POP3/IMAP accounts not contained in an email account group are processed as part of the default email account group.

2. **Enable email account group processing**

   Navigate to sys_properties.list and locate the glide.email.inbound.account_group_processing system property. Set the Value to true. The email reader job starts processing the email account groups that you created.
3. **Monitor email account group processing.**

   Check the status of your email account groups to see if processing time has been reduced. Determine whether the additional groups sufficiently reduce account processing time or consider adding another email reader job to further reduce processing time.

4. **Create an email reader job.**

   As part of fine-tuning email account group processing, create an email reader job to process email account groups concurrently, in addition to the default email reader job.

---

### Create email account groups

Define an email account group that contains a subset of your POP3/IMAP email accounts. The email reader job automatically processes each email account group as scheduled.

#### Before you begin

**Role required:** admin or email_account_admin

#### Procedure

1. Navigate to System Mailboxes > Administration > Email Account Groups and click New.

2. Fill in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the account group.</td>
</tr>
<tr>
<td>Email Accounts</td>
<td>A subset of POP3/IMAP email accounts. Select the email accounts that make up the group.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When you add an email account to a group, it cannot be reused in other account groups.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that enables the email account group for processing. New account groups are active by default.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Default | Read only. Check box that indicates the account is the default email account.
Status | Read only. Processing state of the email account group: Unclaimed or Claimed.
Claimed by | Read only. ID of the email reader job currently in progress.
Last Processed | Read only. The last time that the email reader job processed this group.
Processing Duration | Read only. The length of time taken by an email reader job to process the account group.

3. **Click Create.**
   The system updates the Email Account Group [sys_email_account_group] table with the new account group. Use this table to monitor email account group processing.

**What to do next**
- Review email account group processing.
- Determine if you want to continue fine-tuning email account processing. You could add another email account group or another email reader job to process email account groups concurrently.

**Enable email account group processing**
Enable the email reader job to start processing your email account groups so that you can reduce the time it takes to process inbound email accounts.

**Before you begin**
Create email account groups.
Role required: admin

**Procedure**
Add a system property with the following settings:
• Name: glide.email.inbound.account_group_processing
• Type: true | false
• Value: true

What to do next
Check the status of your email account groups to see if processing time has been reduced. For more information, see Monitor email account groups.

To further reduce processing time, consider creating another email reader job to process inbound email accounts. For more information, see Create an email reader job.

Monitor email account groups
Use the Email Account Groups [sys_email_account] table to check the status of email account groups processed by email reader jobs.

Before you begin
1. Create email account groups.
2. Enable email account group processing.

Role required: email_account_admin or admin

Procedure
1. Navigate to System Mailboxes > Administration > Email Account Groups.
2. Review the processing details for each account group:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the email account group.</td>
</tr>
<tr>
<td>Active</td>
<td>The operational state of the email account group. The value true indicates</td>
</tr>
<tr>
<td></td>
<td>that the account is enabled for email account processing.</td>
</tr>
<tr>
<td>Claimed by</td>
<td>The ID of the email reader job if the job is running on the account group.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default</td>
<td>The default indicator. The value true indicates that the email account group is the default.</td>
</tr>
<tr>
<td>Email Accounts</td>
<td>The names of the email accounts contained in the email account group.</td>
</tr>
<tr>
<td>Last Processed</td>
<td>The day and time that the email reader job last processed this account group.</td>
</tr>
<tr>
<td>Processing Duration</td>
<td>The length of time (in hours, minutes, seconds) to process the account group.</td>
</tr>
<tr>
<td>Status</td>
<td>Processing state of the email account group:</td>
</tr>
<tr>
<td></td>
<td>• Unclaimed: The account group is available for processing by the next email reader job.</td>
</tr>
<tr>
<td></td>
<td>• Claimed: An email reader job is processing the current account group.</td>
</tr>
</tbody>
</table>

**Example:**

**Email account group — unclaimed processing state**

![Image of email account group table with columns for Name, Active, Claimed By, Default, Email Accounts, Last Processed, Processing Duration, Status, showing an example account group with unclaimed processing state.](image)
What to do next
If fine-tuning email accounts, consider doing one of the following:

• Create another email account group.
• Create another email reader job to process email account groups concurrently.

Create an email reader job
If you created email account groups to fine-tune inbound email account processing, you can create an email reader job to process those account groups concurrently, in addition to the default email reader job.

Before you begin
1. Create email account groups.
2. Enable email account group processing

Role required: email_account_admin or admin

Procedure
1. In the Navigation filter, type sys_trigger.list.
2. In the sys_trigger table, select the Email Reader job record.
3. In the Email Reader job form:
   a. Enter a unique name for the email reader job to be added so that you can differentiate it from the default email reader job.
   b. If needed, change the time interval for this email reader job.
4. From the form context menu, click Insert.
   Another email reader job is created. This job runs concurrently with the default email reader job to process email account groups.

What to do next
Monitor email account group processing and determine if the additional reader job reduces processing time. If needed, you can continue fine-tuning email
account processing. For example, you might consider adding another email account group.

**Email properties**

The Email Properties page is where you can configure settings for inbound and outbound email.

Email properties are available from either of these modules:

- **System Mailboxes > Email Properties**
- **System Properties > Email Properties**

Troubleshooting steps to take when a ServiceNow instance does not receive email

Email accounts are configured in the **System Mailboxes > Administration > Email Accounts** module. For more information and instructions, see [Configure an email account](#).

Email diagnostics are available from the **System Mailboxes > Email Diagnostics** module.
Note: To learn more about the security properties that affect email processing, see and in Instance Security Hardening Settings.

Outbound mail configuration

The Outbound Mail Configuration section of the Email Properties page contains properties for sending email.
Outbound email configuration

Outbound Email Configuration

- Email sending enabled
  - Yes | No

- Send all email to this test email address (non-production testing)

- Append timezone to dates and times in sent email
  - Yes | No

- Create visible watermark in sent email. If false, create invisible watermark via hidden div tag.
  - Yes | No

- Resend email if server returns these SMTP error codes
  - 421,450,451,452

- Do not resend email if server returns these SMTP error codes
  - 500,501,502,503,504,550,551,552,553,554

- Resend email when server returns unknown SMTP error codes
  - Yes | No

- Roles that can view email in the Activity formatter when including "Sent/Received Emails"
  - itil

- Number of journal entries (Additional comments, Work notes, etc.) included in email notifications (-1 means all)
  - 3
<table>
<thead>
<tr>
<th>Property</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.email.smtp.active | Email sending enabled                           | Specifies whether to enable or disable the outgoing mail server.  
  • Type: true | false  
  • Default value: true |
| glide.email.test.user  | Send all email to this test email address       | Specifies the comma-separated list of email addresses to which the instance sends all email messages. Typically used in non-production instances for testing purposes.  
  • Type: string  
  • Default value: none |
| glide.email.append.timezone | Append time zone to dates and times in sent mail | Specifies whether to append the system time zone to date and date/time values in outbound emails. For example, 2010-07-02 04:01:14 PST.  
  • Type: true | false  
  • Default value: true |
| glide.email.watermark.visible | Create visible watermark in sent mail. If false, create invisible watermark via hidden div tag. | Indicates whether the watermark in email notifications is visible (true) or wrapped in a hidden div tag (false).  
  • Type: true | false  
  • Default value: false |
| glide.smtp.defer_retry_ids | Resend email if server returns these SMTP error codes | Specifies the comma-separated list of SMTP error codes that force the instance to resend email.  
  • Type: string  
  • Default value: 421,450,451,452 |
<table>
<thead>
<tr>
<th>Property</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.smtp.fail_message_ids</td>
<td>Do not resend email if server returns these SMTP error codes</td>
<td>Specifies the comma-separated list of SMTP error codes that prevent the instance from resending email.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 500,501,502,503,504,550,551,552,553,554</td>
</tr>
<tr>
<td>glide.smtp.default_retry</td>
<td>Resend email when server returns unknown SMTP error codes</td>
<td>Enables (true) or disables (false) resending email when an unknown SMTP error code is encountered. The instance only recognizes the SMTP error codes defined in the glide.smtp.defer_retry_ids property.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td>glide.ui.activity.email_roles</td>
<td>Roles that can view email in the Activity formatter when including &quot;Sent/Received Emails&quot;</td>
<td>Specifies the comma-separated list of roles that can view email in the activity formatter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: itil</td>
</tr>
<tr>
<td>glide.email.journal.lines</td>
<td>Number of journal entries (Additional comments, Work notes, etc.) included in email notifications (-1 means all).</td>
<td>Specifies the number of entries from a journal field, such as Additional comments or Work notes, included in email notifications. A value of -1 includes all journal entries.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Learn More: Restrict the Number of Entries Sent in a Notification</td>
</tr>
</tbody>
</table>
Inbound mail configuration

The **Inbound Mail Configuration** section of the Email Properties page contains properties to control inbound email.

**Inbound Email Configuration**

**Email receiving enabled**  
Yes | No

Identify email as a reply by these subject prefixes

re:, aw:, r:, Accepted:, Tentative:, Declined:

Identify email as a forward by these subject prefixes

fw:, fwd:

Discard everything below this text if found in a reply body (comma separated, case sensitive)

Original Message-----

Automatically create users for incoming emails from trusted domains

Yes | No

Default password for users created from email sent from trusted domains. (must reset upon login)

Password:

Trusted domains when creating new users from incoming email (ignore email from untrusted domains unless from an existing user; use * for all domains)

servicenow.com
### Inbound email properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.email.read.active</td>
<td>Email receiving enabled</td>
<td>Specifies whether to enable or disable the inbound mail server.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
<td>false</td>
</tr>
<tr>
<td>glide.email.reply_subject_prefix</td>
<td>Identify email as a reply by these subject prefixes</td>
<td>Specifies the comma-separated list of prefixes in the subject line that identify an email reply.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
<td>• Default value: re:, aw:, r:, Accepted:, Tentative:, Declined:</td>
</tr>
<tr>
<td></td>
<td>Note: The case of the reply prefix in the email, for example RE:, must exactly match the case of the prefixes defined in this property. If, for example, an email contains the Re: prefix and only RE: is defined in the property, the email will not be recognized as a reply. Therefore, it is a best practice to define multiple versions of the prefix, including mixed-case versions, such as RE:, Re:, and so on.</td>
<td></td>
</tr>
<tr>
<td>glide.email.forward_subject_prefix</td>
<td>Identify email as a forward by these subject prefixes</td>
<td>Specifies the comma-separated list of prefixes in the subject line that identify a forwarded email.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
<td>• Default value: fw:, fwd:</td>
</tr>
</tbody>
</table>
Inbound email properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.pop3readerjob.create_caller | Automatically create users for incoming emails from trusted domains | Controls the behavior when an instance receives an email from an email address not associated with a user record. If this property is set to **true**, the instance creates a new user record for the email address and places that new user in the **Caller** field of any tickets created. If the property is set to **false**, the instance places **Guest** in the **Caller** field of any tickets created.  
  • **Type:** true | false  
  • **Default value:** false  
  • **Learn More:** Enabling Automatic User Creation |
| glide.user.default_password | Default password for users created from email sent from trusted domains. (must reset upon login) | Specifies the password for new users created from incoming email. Users must reset the password at first login.  
  • **Type:** string  
  • **Default value:** password  
  • **Learn More:** Enabling Automatic User Creation |
| glide.user.trusted_domain | Trusted domains when for which the instance automatically creates a user based on incoming email | Comma-separated list of trusted domains for which the instance automatically creates a user based on incoming email. |

⚠ **Note:** The case of the forward prefix in the email, for example `fw:` must exactly match the case of the prefixes defined in this property. If, for example, an email contains the `Fwd:` prefix and only `fwd:` is defined in the property, the email will not be recognized as a forward. Therefore, it is a best practice to define multiple versions of the prefix, including mixed-case versions, such as `FWD:`, `Fwd:`, and so on.
Inbound email properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>creating users from incoming email.</td>
<td>Use an asterisk (*) to trust all domains. If an email is not from a trusted domain, the instance processes the inbound email “guest user” but it does not create a guest user in the instance.</td>
</tr>
</tbody>
</table>

• Type: string
• Default value: asterisk (*)
• Learn More: Enabling Automatic User Creation

Note: To learn more about the security properties that affect email processing, see in Instance Security Hardening Settings.

Email image filtering properties

Use email image filtering properties to control how inbound email images attach to a target record.

When a user sends an email to the system, email images (such as logos or email signatures) attach to the target record by default. These images are also visible in the activity stream of the target record. The system then replicates these images, which can cause duplicate image attachments to the target record and also duplicate images in the activity stream.

To filter images from emails and reduce duplicate image attachments to target records, configure the following properties in the System Properties [sys_properties] table. Use these properties to:

• Specify the email image sizes eligible for filtering.
• Choose an action that controls image attachment behavior and image visibility in the activity stream.

Note: These properties do not delete attachments. You can verify attachment records in the Attachments [sys_attachment] table.

Email image filtering properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.email.inbound.image_sys_attachment.filter.minimum_bytes</td>
<td>Set the minimum image size in bytes for inbound email images</td>
</tr>
</tbody>
</table>
Email image filtering properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.email.inbound.image_sys_attachment.filter.action</td>
<td>Specifies the image filtering behavior.</td>
</tr>
</tbody>
</table>

Note: Regardless of the action you select, the image is visible when you choose to Preview HTML Email or Show Email Details in the activity formatter.

- **Type:** Choice list
  - AttachTarget - Associate the image to the target record. The image is visible in the activity formatter and in the attachment to the target record.
  - AttachEmail - Attach the image to the email record. The image is not visible in the activity formatter of the target record nor in the attachment to the target record.
  - AttachNone - Do not attach the image to a record. You can select this option to attach the image manually at a later time.

- **Default value:** AttachEmail
Related information

Add a system property

Email digest properties

Several properties are available to manage digest intervals for email digests.

The following properties are available for the email digest feature.

Note: To open the System Properties [sys_properties] table, enter sys_properties.list in the navigation filter.

Properties for email digest intervals

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.email.digest.default_interval</td>
<td>The sys_id of the default email digest interval available to users.</td>
</tr>
<tr>
<td>• Type</td>
<td>string</td>
</tr>
<tr>
<td>• Default value:</td>
<td>28d157e07f1332007f005212bd9a9116</td>
</tr>
<tr>
<td>• Location:</td>
<td>System Property [sys_properties] table</td>
</tr>
<tr>
<td>glide.email.digest.max_intervals</td>
<td>The maximum number of email digest intervals that can be defined.</td>
</tr>
<tr>
<td>• Type</td>
<td>integer</td>
</tr>
<tr>
<td>• Default value:</td>
<td>100</td>
</tr>
<tr>
<td>• Location:</td>
<td>System Property [sys_properties] table</td>
</tr>
<tr>
<td>• Learn more:</td>
<td>For details on digest intervals, see Create or modify email digest intervals.</td>
</tr>
</tbody>
</table>

Advanced email properties

Use advanced email properties to fine-tune the way your instance sends or receives email.

Add these properties to the System Property [sys_properties] table before they can be used to overwrite the defaults. To learn more about properties that affect email processing, see in Instance Security Hardening Settings.
com.glide.email.max_read

Specifies the maximum number of emails a POP3 reader should process concurrently.

- Type: integer
- Default value: 20

com.snc.on_call_rotation.reminders.showtz

Specifies whether to show a user's time zone.

- Type: true | false
- Default value: false

glide.cms.use_email_override_url

Forces the system to use the glide.email.override.url property, rather than the glide.servlet.uri property, when a notification has a link to a CMS page in an instance.

- Type: true | false
- Default value: false
- Location: System Property [sys_properties] table

glide.email_address_filter.max_domains

Sets the maximum number of domains that can be associated with a single email address filter.

- Type: integer
- Default value: 100

glide.email_address_filter.max_exceptions

Sets the maximum number of exceptions that can be associated with a single email address filter.

- Type: integer
- Default value: 1000

glide.email.allow_duplicate_message_ids

Allows storing of emails with duplicate message IDs and adds error message "Duplicate message-id encountered, prevented loop."

- Type: true | false
- Default value: false
**glide.email.append.timezone**

Appends the user time zone to all date and time values in outbound email messages (for example, 2018-07-02 04:01:14 PST). The time zone does not show if the system property **glide.sys.time_format** does not have a "z" value. For more information on configuring the time zone in email notifications, see **Time zone for email notifications**.

- Type: true | false
- Default: false

**glide.email.email_client.check_attachment_availability**

Enables a system scan of each file that a user attaches to an email draft in the email client. If a file is found to be infected with a virus, the user can't send the email with the attached file. The user must remove the attachment to send the email.

- Type: true | false
- Default value: true

**glide.email.email_with_no_target_visible_to_all**

Email that is missing a target record or whose target record is the email are made visible to any user regardless of their roles. By turning this property to false, the user is restricted unless they sent in the record or have an admin role.

- Type: true | false
- Value: false

**glide.email.inbound.calendar_behavior**

Specifies how the system stores calendar data, such as an invitation or an invitation response. Enter one of these options (not case sensitive):

- Attach: Store the calendar data as an attachment on the associated record, such as the incident or change that triggers an invitation.
- Ignore: Discard the calendar data.
- Inline: Store the calendar data as text in the email Body field.
- Type: string
- Default value: Attach
glide.email.inbound.check_attachment_availability

Prevents users from downloading and using virus-infected files that are attached to inbound emails.

The system detects infected files in an email by checking the ServiceNow virus header. If there are multiple email attachments, the system scans the files via Antivirus Scanning. All attachments that are found to be infected are made unavailable for use.

- Type: true | false
- Default value: true

---

glide.email.inbound.convert_html-inline_attachment_references

Specifies whether to convert inbound email HTML so email images appear in the email HTML body preview. The system displays broken cid (content ID) links in place of images received when this property is disabled. The format in which the system displays an email image depends on the property setting at the time the email is received, not the current property setting.

- Type: true | false
- Default value: true

---

glide.email.inbound.generate.missing.html.part

Enables the system to generate HTML text for inbound emails that contain only a plain text message.

- Type: true | false
- Default value: true

---

glide.email.inbound.generate.missing.text.part

Enables the system to generate plain text for inbound emails that contain only an HTML message.

- Type: true | false
- Default value: true

---

glide.email.inbound.max_attachment_count

Sets the maximum number of attachments allowed per inbound email.
• Type: integer
• Default value: 30
• Location: System Property [sys_properties] table

glide.email.inbound.max_body_chars
Sets the maximum body size in characters allowed per inbound email.
• Type: integer
• Default value: 524288

glide.email.inbound.max.total_attachment_size_bytes
Sets the maximum total attachment size in bytes allowed per inbound email.
• Type: integer
• Default value: 18874368
• Location: System Property [sys_properties] table

glide.email.mail_to
Specifies the email address for sending notifications that use the ${mailto:} variable.
• Type: string
• Default value: SMTP email address that is active by default

glide.email.name_split
Specifies the delimiter used between first and last names in an email address. For example, a delimiter of "." (period) in the email address john.smith@company.com tells the system to look for a user record for John Smith.
• Type: string
• Default value: period (.)

glide.email.notification.save_when_no_recipients
Controls whether a notification-generated sys_mail record is saved even if there are no recipients. Used along with other notification recipient logging properties, this property enables investigating problems with notifications.
• Type: true | false
• Default value: false

**glide.email.outbound.check_attachment_availability**

Prevents users from sending emails that contain virus-infected files. If an outbound email contains an attachment that was previously marked as infected via *Antivirus Scanning*, then the system doesn’t send the email. An event is created to indicate that the email attachment is not available for use.

• Type: true | false
• Default value: true

**glide.email.outbound.header.auto_submitted**

Stores the value used in the "Auto-submitted" outbound email header. Clear the property value to remove the "Auto-submitted" header from all outbound emails. Some spam filters flag auto-generated email as spam.

• Type: string
• Default value: auto-generated

**glide.email.outbound.max_attachment_count**

Sets the maximum number of attachments allowed per outbound email.

• Type: integer
• Default value: 30
• Location: System Property [sys_properties] table

**glide.email.outbound.max_body_chars**

Sets the maximum body size in characters allowed per outbound email.

• Type: integer
• Default value: 524288

**glide.email.outbound.max_total_attachment_size_bytes**

Sets the maximum total attachment size in bytes allowed per outbound email.
• Type: integer
• Default value: 18874368
• Location: System Property [sys_properties] table

glide.email.override.url
Sets the URL to use in emailed links in place of the instance URL. The URL should end with nav_to.do. An example value is https://servicenow.customerdomain.com/production.nav_to.do. This property is suitable for customers who use custom redirect URLs for their instances.
• Type: string
• Default value: instance URL

glide.email.remove_illegal_address_quotes
Removes invalid quotation marks from an inbound email address, thus allowing the inbound email address to be accepted as valid. For example, when you set the property to true, the address "john.doe@example.com" is changed to john.doe@example.com. However, only addresses that are formatted as John Doe <john.doe@example.com> are removed entirely.
• Type: true | false
• Default: false

glide.email.smtp.max_recipients
Specifies the maximum number of recipients the instance can list in the To: line for a single email notification. Notifications that would exceed this limit instead create duplicate email notifications addressed to a subset of the recipient list. Each email notification has the same maximum number of recipients.
• Type: integer
• Default value: 100

glide.email.smtp.max_send
Specifies how many emails to send through each new SMTP connection. If there are more emails to send than the specified value, the instance establishes a new SMTP connection.
• Type: integer
• Default value: 100

**glide.email_system_address_filter.max_address_filters**

Sets the maximum number of email filters that can be associated with a single system address filter.

• Type: integer
• Default value: 100

**glide.email.text_plain.strip_xhtml**

Converts the XML of both outbound and inbound emails that are shown in comments to plain text. If false, the system preserves the XML.

• Type: true | false
• Default value: true

**glide.notification.recipient.exclude_logging**

Enables or disables logging all reasons a recipient was excluded. If set to true, the subsequent properties dealing with the exclusion of logging are enabled. If false, the properties are disabled. This property cannot suppress log messages generated by the **glide.email.test.user** property.

• Type: true | false
• Default value: true

**glide.notification.recipient.exclude_logging.device_inactive**

Logs recipients who are excluded because their chosen notification device record is marked as inactive.

• Type: true | false
• Default value: true

**glide.notification.recipient.exclude_logging.device_schedule**

Logs recipients who are excluded based on the **Schedule** field on the Notification Device [cmnnotif_device] record for their chosen notification device.

• Type: true | false
• Default value: true
glide.notification.recipient.exclude_logging.event_creator
Logs recipients who are excluded because they initiated the notification event, such as updating an incident record. The Send to Event Creator check box is then cleared on the notification record.

- Type: true | false
- Default value: true

glide.notification.recipient.exclude_logging.invalid_email
Logs recipients who are excluded because the email address for that user is invalid, for example the @ is missing, or empty.

- Type: true | false
- Default value: true

glide.notification.recipient.exclude_logging.user_calendar_integration_disabled
Logs recipients of calendar invitations who are excluded. Recipients are excluded because the Calendar Integration field is set to None on the user record.

- Type: true | false
- Default value: true

glide.notification.recipient.exclude_logging.user_inactive
Logs recipients who are excluded because the Active check box is cleared on the user record.

- Type: true | false
- Default value: true

glide.notification.recipient.exclude_logging.user_notification_disabled
Logs recipients who are excluded because the Notification field is set to Disabled on the user record.

- Type: true | false
- Default value: true

glide.notification.recipient.include_logging
Enables or disables logging all reasons a recipient was included. If set to true, the subsequent properties dealing with the inclusion of logging are enabled. If false, the properties are disabled.
• Type: true | false
• Default value: true

glide.notification.recipient.include_logging.delegate

Logs recipients who are included because they are delegates of another user.

• Type: true | false
• Default value: true

glide.notification.recipient.include_logging.event_parm

Logs recipients who are included because they are in the parm1 or parm2 fields of the event record.

• Type: true | false
• Default value: true

glide.notification.recipient.include_logging.recipient_fields

Logs recipients who are specified in the Users/Groups in Field field for the notification record. The recipient_fields are fields in the target record that contain a recipient to add. For example, to include an incident assignee as a recipient, set the Users/Groups in Field field to Assigned to.

• Type: true | false
• Default value: true

glide.notification.recipient.include_logging.recipient_groups.group_email

Logs users who are included in a notification that is sent to a group. The property also logs users in the event parm1 or parm2 field.

• Type: true | false
• Default value: true

glide.notification.recipient.include_logging.recipient_groups.manager

Logs recipients who manage a recipient group. The property also logs users in the event parm1 or parm2 field.

• Type: true | false
• Default value: true

glide.notification.recipient.include_logging.recipient_groups.membership

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Logs recipients who are part of a notification recipient group. The property also logs users in the event `parm1` or `parm2` field.

- Type: true | false
- Default value: true

`glide.notification.recipient.include_logging.recipient_users`
Logs recipients who are included via notification record's Users field (recipient_users).

- Type: true | false
- Default value: true

`glide.notification.recipient.include_logging.subscription`
Logs recipients because they are subscribed via the user notification preferences.

- Type: true | false
- Default value: true

`glide.pop3.parse_start`
Specifies the text that indicates the beginning of the email body section. The instance parses name:value pairs within this section to set or update field values when processing inbound email actions.

- Type: string
- Default value: none

`glide.pop3.parse_end`
Text indicating the end of the email body section where the instance should parse name:value pairs to update field values when processing inbound email actions.

- Type: string
- Default value: none

`glide.smtp.dateformat`
Specify the date format to use for outgoing email notifications.

- Type: string
- Default value: date format listed in email sender's user record
  `[sys_user.date_format]`
glide.smtp.precedence_bulk

Specifies whether outbound email includes the header “Precedence: bulk”. Some spam filters flag bulk email as spam. Set the value to **false** to remove this header from outbound email.

- Type: true | false
- Default value: true

glide.smtp.send_partial

Splits outgoing email between valid and invalid recipients. The email is sent only to the valid recipients. A new email containing the invalid recipients is created in the **send-ready** state and attempts to send again.

- Type: true | false
- Default value: false

glide.smtp.timeformat

Specify the time format to use for outgoing email notifications.

- Type: string
- Default value: time format listed in email sender's user record [sys_user.time_format]

glide.ui.activity.email.use_display

Specifies whether to display email addresses or user IDs (display value from the User table) in email headers. If true, the instance searches for a user record with a matching email address. If it cannot find a matching user record, it displays the email address.

- Type: true | false
- Default value: false

glide.ui.email_client.email_address.disambiguator

Sets the columns from the User [sys_user] table that the autocomplete list displays. Separate each column name with a semicolon character (;).

- Type: string
- Default value: name

glide.ui.incident_activity.max_addresses
Specifies the maximum number of addresses to list in an email audit record. If the number of addresses exceeds this limit, the instance truncates the list after the maximum value and displays an ellipsis character (...).

- Type: string
- Default value: 5

**NotifyAffectedCI.max_rel_level**

Sets a value that is used by the **Affected ci notifications** business rule. The business rule notifies subscribers when tasks affect configuration items (CIs). The business rule generates notifications for parent CIs up to the level defined by this property. You can adjust the property value according to the complexity and depth of your CI relationships.

- Type: integer
- Default value: 5

**Email size limits**

To prevent issues with large email messages, the system enforces configured limits on the maximum allowed email body size, total attachment file size, and number of attachments per email.

An email or attachment that exceeds the system capacity may not be processed as expected. To ensure that your emails and attachments are processed as expected, you can configure properties that limit the size of emails and attachments.

**Message body size limit properties**

Add properties to control the maximum email body size allowed for inbound and outbound email messages.

**Properties**

By default, the system processes up to 524,000 characters in the email **body** and **body_text** fields (524 KB each).

You can add and configure system properties `glide.email.inbound.max_body_chars` and `glide.email.outbound.max_body_chars` to increase or decrease the email body size limits. The system truncates the email body when it exceeds the configured limit. For example, if you configure the body size limit of `glide.email.inbound.max_body_chars` to 1,000 characters but
receive an inbound email that is 2,000 characters, then the system truncates the email body at 1,000 characters.

Also note that the system cannot process email body or body text larger than 16 MB.

### Message body size limit properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>glide.email.inbound.max_body_chars</strong></td>
<td>Sets the maximum body size in characters allowed per inbound email.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 524288</td>
</tr>
<tr>
<td><strong>glide.email.outbound.max_body_chars</strong></td>
<td>Sets the maximum body size in characters allowed per outbound email.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 524288</td>
</tr>
</tbody>
</table>

**Note:** A different property, `com.glide.attachment.max_size`, sets the maximum file size allowed for any attachment in the system and overrides any larger values of `glide.email.inbound.max_total_attachment_size_bytes` and `glide.email.outbound.max_total_attachment_size_bytes`.

### Inbound email body processing

For inbound emails, the system enforces the maximum body size as set by the `glide.email.inbound.max_body_chars` property. When the body size exceeds the configured value:

- The system does not run inbound email actions that would otherwise be triggered by the email.
- The system truncates the Body text on the Email form.
- The system logs a warning and sets the Error string field on the Email form. The log message for such an email might look like this:

  ```
  Email set to receive-ignored because its size exceeds the value set in `glide.email.inbound.max_body_chars`. 1995 character(s) were truncated from the body field.
  ```

### Outbound email body processing

For outbound emails, the system enforces the maximum body size as set by the `glide.email.outbound.max_body_chars` property. When the body size exceeds the configured value:
• The system does not send the email.

• The system truncates the Body text on the Email form.

• The system logs a warning and sets the Error string field on the Email form. The log message for such an email might look like this:

```
Email set to send-ignored because its size exceeds the value set in
glide.email.outbound.max_body_chars. 1337 character(s) were truncated from
the body field.
```

**Related reference**

- Advanced email properties

**Attachment limit properties**

Several properties control email attachment limits.

To see the status of all email attachments, go to the Email Attachments [sys_email_attachment] table.

**Properties**

All the properties are located in the System Property [sys_properties] table. Setting any of the following properties to an excessively large value may cause performance issues.

**Attachment limit properties**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.email.inbound.max_attachment_count</td>
<td>Sets the maximum number of attachments allowed per inbound email.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 30</td>
</tr>
<tr>
<td></td>
<td>• <strong>Learn more</strong>: Inbound Email Attachment Processing</td>
</tr>
<tr>
<td>glide.email.inbound.max_total_attachment_size_bytes</td>
<td>Sets the maximum total attachment size in bytes allowed per inbound email.</td>
</tr>
</tbody>
</table>
## Attachment limit properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
|                                                           | • **Type**: integer  
|                                                           | • **Default value**: 18874368  
|                                                           | • **Learn more**: Inbound Email Attachment Processing  
| glide.email.outbound.max_attachment_count                 | Sets the maximum number of attachments allowed per outbound email.  
|                                                           | • **Type**: integer  
|                                                           | • **Default value**: 30  
|                                                           | • **Learn more**: Outbound Email Attachment Processing  
| glide.email.outbound.max_total_attachment_size_bytes     | Sets the maximum total attachment size in bytes allowed per outbound email. To send an email, the system must encode the contents of the email. This process may significantly increase the size of the email, including any attachments. It is best to set this property to a value well below the maximum email size.  
|                                                           | • **Type**: integer  
|                                                           | • **Default value**: 18874368  

Attachment limit properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Learn more:</td>
<td>Outbound Email Attachment Processing</td>
</tr>
</tbody>
</table>

Note: A different property, `com.glide.attachment.max_size`, sets the maximum file size allowed for any attachment in the system and overrides any larger values of `glide.email.inbound.max_total_attachment_size_bytes` and `glide.email.outbound.max_total_attachment_size_bytes`.

Inbound email attachment processing

For inbound emails, the system enforces the maximum number and size of attachments as set by the `glide.email.inbound.max_attachment_count` and `glide.email.inbound.max_total_attachment_size_bytes` properties. When an attachment for an inbound email exceeds either value, the attachment is discarded. A record is created in the Email Attachments [sys_email_attachment] table containing the discarded file name and the reason it was discarded. The discarded file remains in the Email [sys_email] record. The order in which the system processes the attachments determines which attachments are discarded. This order may not be consistent from email to email.

When an inbound email attachment is discarded, the system also fires the `inbound.email_attachments.discarded` event. You can use the event to trigger a notification that alerts the email sender. For an example of a notification that can be triggered by the event, see the inactive "Demo Email Attachment(s) Discarded" notification.

Inbound email attachments are prevented from attaching to the target record if an identical attachment exists.

Outbound email attachment processing

For outbound emails, the system enforces the maximum number and size of attachments as set by the `glide.email.outbound.max_attachment_count` and `glide.email.outbound.max_total_attachment_size_bytes` properties. Email records are created from various sources and may exceed the configured attachment limits.

Emails that are ready to be sent from the Email [sys_email] table are subject to the outbound attachment limits. Emails that exceed either limit trigger a warning in the email system log and are sent with attachments up to the maximum number or total file size.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
The log message for such an email might look like this: Maximum combined attachment size exceeded. (max:15728640 bytes). One or more attachment records ignored.

Emails for notifications, scheduled reports, and exported tables

Notifications can be set to include all the attachments from the record that triggers the notification. If the attachments exceed either of the outbound email attachment limits, the system excludes the excess attachments from the email and logs a warning message.

Reports can be scheduled for email distribution as attachments. Large reports may exceed the outbound attachment size limit. In this case, the system sends the scheduled report email without the report attached and logs a warning message. To avoid the issue, send links to large reports instead of sending the reports as attachments.

If a user attempts to export numerous records from a list that exceeds a configured warning threshold, a dialog box offers the option to email the exported records as an attachment. If the attachment exceeds the outbound attachment size limit, the system sends the email without the exported record list attached and logs a warning message.

System mailboxes

Email messages can be seen in the System Mailboxes menu, which gives you access to the system Inbox, Outbox, and Sent mail box.

Each provides a filtered view of emails to let you see only what you need to at any given time, including list fields applicable to each. The system mailboxes menu shows your current POP and SMTP status.

The System Mailbox is hosted by ServiceNow, who have sole access to the mailboxes. By default, once the instance pulls an email message, it is deleted from the mail server and stored in the application on the Email [sys_email] table.

For information about the fields that are shown in the System Mailbox, see System email log and mailboxes. You can configure the layout of a system mailbox to show any of the email log fields, not only the ones that are shown by default.

- Inbound emails: All inbound mail is placed into the Inbox until it is processed. After it is cleared, the email moves to the Received state. If the email message matches the criteria in an inbound email action, the email is changed to Processed. If not, it is changed to Ready. If the system is restarted for any reason (such as during a system upgrade), all inbound mail waits on the external mail server until the system can request delivery.
• **Outbound emails:** All outbound mail is placed into the Outbox until it is processed. Once cleared, it is moved to Sent (if sent) or Skipped (not sent, as in the case of no valid recipients). If the system is restarted for any reason (such as during a system upgrade), all outbound mail waits in the instance database until the system comes online, and the scheduler looks for mail to deliver.

**Email filters**
Specify which inbound emails to ignore or move to a particular mailbox.

When an email is ignored, the email is saved to your instance but is not processed. You can access an ignored email by viewing its Email [sys_email] record.

The Email Filters (com.glide.email_filter) plugin is active by default.

**Default email filters**
By default, the following filters are available from the **System Mailboxes > Filters** module:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore VCAL</td>
<td>Ignores all email containing vCalendar requests. This filter prevents inbound email actions from creating unnecessary incident records when the instance receives a response to sent email. vCalendar requests in email responses are identified by the EmailUtils script include.</td>
</tr>
<tr>
<td>Ignore header</td>
<td>Ignores email that contains specific headers. This filter overrides the glide.pop3.ignore_headers property.</td>
</tr>
<tr>
<td>Ignore sender</td>
<td>Ignores email from specific senders. This filter overrides the glide.pop3.ignore_senders property.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> To ignore emails from untrusted domains and addresses, consider setting up a system address filter instead. For more information, see System address filters.</td>
</tr>
<tr>
<td>Ignore subject</td>
<td>Ignores email with specific terms or phrases in the subject line. This filter overrides the glide.pop3.ignore_subjects property. This filter might not apply to emails arriving from unknown users. Unknown users can be locked out.</td>
</tr>
</tbody>
</table>
Default email filters (continued)

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move spam to junk folder</td>
<td>Moves email identified as spam to the Junk folder. This filter checks for the value of the ServiceNow spam header. If the header is x-ServiceNow-Spam-Status:Yes, the filter moves the email to the Junk folder.</td>
</tr>
</tbody>
</table>

ℹ️ **Note:** To learn more about enabling spam scoring and filtering, see in Instance Security Hardening Settings.

**Email filter script include**

Email filters use a script include called `EmailUtils` that contains a simple utility function to determine if vCalendar is in the body of the response email. The results of this query are used in a condition script in the Ignore VCAL email filter.

**Spam scoring and virus scanning**

Every message sent through email servers is assessed for the likelihood of being spam. Based on this assessment, the instance adds headers to each message that can be used for filtering within the customer instance using the Email Filters plugin.

The system also adds the `X-ServiceNow-Virus:INFECTED` header to an email that contains one or more virus-infected attachments. The system ignores the email.

Spam scoring and virus scanning are available only for instances that use the ServiceNow email infrastructure. For more information on spam scoring and filtering, see KB0549426.

**Activate email filters**

Administrators can activate the Email Filters plugin (com.glide.email_filter).

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

> **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: *Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.*

### Create an email filter

You can create email filters to apply a custom action script or filter actions when email matches your filter's conditions.

#### Before you begin

**Role required:** admin

#### Procedure

1. Navigate to **System Mailboxes > Administration > Filters**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the email filter.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the email filter.</td>
</tr>
<tr>
<td>Order</td>
<td>Priority that the email filter takes over other filters for the same table. To give the filter higher priority over other filters, enter a lower number.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the email filter.</td>
</tr>
<tr>
<td>Short description</td>
<td>Description of what the filter does.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions to define which emails to filter. Note that conditions are case sensitive.</td>
</tr>
<tr>
<td>Condition script</td>
<td>Script to define which emails to filter. Use this script to access other tables, variables, or methods. For example, the condition script for the Ignore VCAL filter looks for the results of the EmailUtils script include, which detects vCalendar attachments.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Action script</td>
<td>Script to define additional behavior to be performed when the filter condition evaluates to true. This might include an email action not included in the default filter actions. In the base system, the action script is used to produce the error string that is published to the email log (System Logs &gt; Email).</td>
</tr>
</tbody>
</table>

4. Right-click in the header bar and select **Save** from the context menu.

The **Filter Actions** related list appears.

5. Click **New** in the related list.

6. Select how the system should react when the conditions of this filter evaluate to true.

   The two choices in the base system are: **Mark as Ignored** and **Move to Junk**.

   You can use the **Action script** to perform additional email tasks.

   **Note:** Before creating additional email actions with a script, see **Inbound Email Actions**. Like business rules, inbound email actions use both conditions and scripts and can provide a number of useful actions on emails the instance receives.

**Email Service**

Email Service installs the Email API on the instance.

By default, Email Service only allows admin users to access the **Email API**. Administrators can **grant access to the Email API** by:

1. Adding an access control for creating records in the Email [sys_email] table linked to the email_api_send role.
2. Assigning the email_api_send role to the non-admin user.
3. Verifying the non-admin user has read access to the notification target table. For example, an email notification for an incident, requires read access to the Incident table.

   Non-admin users with the email_api_send role can access the Email API from the **REST API Explorer**.

**Activate Email Service**

Users with the admin role can activate the Email Service plugin (com.glide.email.service) to enable the Email API.
Before you begin
Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.
   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related information
List of plugins (Rome)

Grant access to the Email API
To grant non-admin users access to the Email API, administrators must create an access control and assign a special role.

Before you begin
Role required: admin

About this task
For additional details, see Email API.

Procedure
1. Elevate privileges to security_admin.
3. Click New.
4. Create an access control for the Email [sys_email] table.

Access control values

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>record</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Operation</td>
<td>create</td>
</tr>
<tr>
<td>Admin overrides</td>
<td>Selected</td>
</tr>
<tr>
<td>Name</td>
<td>sys_email</td>
</tr>
<tr>
<td>Requires role</td>
<td>email_api_send</td>
</tr>
</tbody>
</table>

5. Assign the email_api_send role to the non-admin user.

6. Verify the non-admin user either has read access to all records in the notification target table or has read access to a specific record in the table. For example, to work with incident notifications the non-admin user needs access to the Incident table. You can provide record access by:

- Granting the user an appropriate role, such as the itil role.
- Selecting a specific incident that was opened on behalf of the user.

**System notifications**

Set up notifications to alert users of record changes that may concern them. You can notify users via email, SMS text message, push notification, or messaging app.

**Email and SMS notifications**

Use email notifications to send selected users email or SMS notifications about specific activities in the system, such as updates to incidents or change requests.

Email notifications allow administrators to specify:

- When to send the notification
- Who receives the notification
- What content is in the notification
- Whether the notification can be delivered in an email digest and if so, the digest content

Additional email notification options are available. Users can subscribe to notifications, and administrators can make some notifications mandatory.

Administrators also have the option of converting existing email notifications to a rich HTML format. This format provides several advantages, including:

- Raw HTML content is converted into a WYSIWYG format.
- The content can be edited in a feature-rich HTML editor.
• Mail scripts are condensed into a single, easy-to-read line that can be reused in multiple email notifications.

• To prevent broken links, items like images and incidents, that are linked with URLs relative to an instance are converted to absolute links. For example, if an incident is linked using a relative URL, the link is converted to an absolute link.

⚠️ Note: The rich HTML format is the default for all new email notifications.

⚠️ Note: Instances cannot send or receive encrypted email messages. The system strips out the body of the encrypted email because it cannot process the encrypted content in plain text or HTML.

An email notification can also send as an SMS notification if the recipient has subscribed to the notification on an SMS channel. The system uses the subject line of the email notification and converts it to an SMS message. If the administrator doesn’t want to use the email notification subject for the SMS notification, they can define an alternate SMS message in the email template form or email notification form. For more information, see Create an email notification.

For more information on creating an SMS channel, see Create notification channels.

If you want to change how the instance processes incoming email, see Inbound email actions. See System email log and mailboxes for examples of messages the system displays when notifications or inbound email actions are not processed.

Create notification categories

You can create notification categories to identify and group related notifications that are listed in the notification settings for your users.

Before you begin
Role required: admin

About this task
Before adding new categories, review the base system notification categories in the Notification Categories [sys_notification_category] table to determine if you need a new category.

Procedure
1. Navigate to System Notification > Email > Notification Categories.
2. Click New.
3. Enter the **Name** of the category to identify the family of notifications. Provide a category name that is meaningful to your users, so that they can easily find their notifications under the appropriate category in their notification settings.

4. Enter a **Short description** to identify the category.

5. Click **Submit**.

**Results**
The system adds the new category to the Notification Categories [sys_notification_category] table. After you create at least one, active notification that uses the new category, the category and notification are listed in the notification settings for users (**Notifications** tab in the System Settings window).

**Create an email notification**
Creating an email notification involves specifying when to send it, who receives it, what it contains, and if it can be delivered in an email digest.

**Before you begin**
Role required: admin
Consider the following items when you create or update a notification:

- Your notification recipients must be active users and have a valid email address defined.

  ServiceNow users or members of groups must be defined as active users in the User [sys_user] table. They must also have a valid email address defined for their primary channel (device) in the Notification Device [cmn_notif_device] table. If users do not have an active profile and a valid email address, they will not receive notifications.

- Your notification recipients must have the appropriate notification preferences enabled.

  If the notification is subscribable, each ServiceNow user or group member must have the notification and channels (devices) for the notification enabled in their notification preferences. Admins can impersonate users to review and configure their notification preferences.

- To have your email notification also send as an SMS notification, recipients must subscribe to the notification on an SMS channel. For more information on creating an SMS channel, see **Create notification channels**.
• After you create or update the notification, use the **Preview Notification** option to examine it. For example, you can test links that you may have added and verify the notification recipients. For details, see **Preview email notifications**.

**About this task**

Use the following tabs in the Notification form to configure an email notification:

• **When to send** — Conditions required to send the notification.
• **Who will receive** — Recipients of the notification.
• **What it will contain** — Contents of the notification.
• **What Digest will contain** — Contents of the email digest if the notification can be delivered in a digest.

⚠️ **Note:** If you do not see all the fields on the form, switch to the **Advanced** view.

Watch this six-minute video to learn about the actions that the instance can take in response to messages from users and shows how to create or modify email notifications to users. In the video, skip to 3:29 for details on configuring email notifications.

**Configuring inbound email actions and email notifications**

**Procedure**

1. Navigate to **System Notification > Email > Notifications**.
2. Click **New**.
3. Fill in the fields at the top of the Notification form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the email notification. Descriptive names help identify the purpose of the email notification. For example, Incident Opened &amp; Unassigned.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the database table to link the notification to, for example Incident [incident].</td>
</tr>
<tr>
<td></td>
<td><strong>Attention:</strong> Do not select the Task [task] table. This table is for extending other tables. Notifications that run on the Task table directly are not supported.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Only tables and database views that are in the same application scope appear in the list.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of notification you are creating: EMAIL or Meeting Invitation.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to enable the email notification.</td>
</tr>
<tr>
<td>Category</td>
<td>Select the category to which this notification belongs. A category identifies and groups related notifications. This notification, if active and subscribable, is listed in the selected Category in the notification preferences for each user (Notifications tab in the System Settings window).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Do not leave the category as Uncategorized, as users may not be able to find the notification in their list of notifications.</td>
</tr>
<tr>
<td></td>
<td>If you need a new category, see Create notification categories.</td>
</tr>
<tr>
<td>Allow Digest</td>
<td>Select the check box if an email digest is to be created for the notification. If selected, the What Digest will contain tab is displayed for creating the digest content.</td>
</tr>
<tr>
<td>Description</td>
<td>Type a description for this notification.</td>
</tr>
</tbody>
</table>

4. Fill in the fields on the When to send tab.
Note: If the same trigger generates multiple notifications, the system only sends one notification. The system considers all other notifications, even if they have a different subject and body, as duplicates. The Ignore Duplicates business rule controls this functionality.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Send when | Select under what condition the notification is sent:  
- When a record is inserted or updated  
- When a particular event is fired  
- When triggered as an action step in Flow Designer |
| Weight | [Required] Set a numerical value for the notification priority relative to duplicate notifications.  
Notifications that have the same target table and recipients are considered duplicates if the weights are different. If weights are same, an additional evaluation is done to check if the subject and the body (excluding watermark) are same to qualify as duplicate notification. When there are duplicate notifications, the system only sends the notification with the highest weight. All other notifications are moved from the Outbox to the Skipped mailbox. The default value 0 causes the system to always send the notification (assuming the conditions are met). |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>For example, suppose that a service desk agent adds a comment to an incident and shortly thereafter closes it. By default, these actions trigger both the Incident commented and Incident Closed notifications. However, both notifications are from the Incident table and also notify the incident caller. The system only sends the notification with the highest weight, which in this case is the Incident Closed notification.</td>
</tr>
<tr>
<td>Field</td>
<td><strong>Note:</strong> The SMTP Sender scheduled job determines how often to send email. By default, this job runs every minute.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Use the condition builder to select the conditions under which this notification is sent. For example, select <em>Priority &gt; greater than &gt; 3 - Moderate</em> to send the notification only for High and Critical priority incidents.</td>
</tr>
<tr>
<td>Inserted</td>
<td>Select the check box to enable email notification when a record is inserted. This field appears when you set the <em>Send when</em> field to <em>Record inserted or updated.</em></td>
</tr>
<tr>
<td>Updated</td>
<td>Select the check box to enable email notification when a record is updated. This field appears when you set the <em>Send when</em> field to <em>Record inserted or updated.</em></td>
</tr>
<tr>
<td>Event name</td>
<td>Select the event that triggers this notification. This field appears when you set the <em>Send when</em> field to <em>Event is fired.</em></td>
</tr>
<tr>
<td>Advanced</td>
<td>Create a script to perform certain actions, like sending a notification based on the current email record, changing field values, or changing system properties.</td>
</tr>
<tr>
<td>condition</td>
<td><strong>The advanced condition script must return true or set a global answer variable to true to send the notification.</strong></td>
</tr>
<tr>
<td></td>
<td>The advanced condition script uses the following global variables:</td>
</tr>
<tr>
<td></td>
<td>• <em>current</em>: Contains the current record from the table to which the notification is linked.</td>
</tr>
<tr>
<td></td>
<td>• <em>event</em>: Contains the event that triggered the notification.</td>
</tr>
</tbody>
</table>
5. Fill in the fields on the **Who will receive** tab.

The following example shows the default view of the tab. The advanced view contains additional fields (see table).

**Tip:** Consider limiting the recipient list of any notification to 1000 users. By default, if a notification has more than 100 intended recipients, the system creates multiple notification messages with up to 100 recipients each. If you want to change the recipient limit, set the system property `glide.email.smtp.max_recipients`.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>Select the users you want to receive the email notification. You can search for users with the reference lookup icon or manually add their email addresses. This list of users is static.</td>
</tr>
<tr>
<td>Users/groups in fields</td>
<td>Select fields from the target record that reference the User [sys_user] or Group [sys_user_group] tables. The system sends the notification to users or groups in each field that you select. For example, if a notification uses the Incident [incident] table, you can select the <strong>Opened by</strong> field to send the notification to users or groups who opened the incident. This list of users or groups is variable and depends upon the values of the associated task record. You can also select a field that includes an email address string to send a notification to that address.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>You can dot-walk to values in reference fields by clicking the plus sign in the field selector and then selecting the related field.</td>
</tr>
<tr>
<td></td>
<td>If you address the notification to a user with an inactive record in the User [sys_user] table, the system does not send the notification to that user.</td>
</tr>
<tr>
<td>Groups</td>
<td>Select the groups you want to receive the email notification. You can search for groups with the reference lookup icon or by manually entering the group name. This list of groups is static.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Group members receive individual notifications only if Include members is selected in the group record.</td>
</tr>
<tr>
<td>Exclude delegates</td>
<td>Select this option to prevent the instance from sending email notifications to delegates of the users and members of the groups you selected.</td>
</tr>
<tr>
<td>Send to event creator</td>
<td>Select this check box to send the notification to the person who performed the action that started the notification process if the person is also a recipient. If the event creator is not specified in one of the recipient fields, the event creator does not receive a notification regardless of the setting in this field. For new notifications, this option is selected by default. If you want to know why you may not be receiving certain email notifications, see the blog post Troubleshooting email notifications - Send to the Event Creator by a ServiceNow Technical Support Engineer in the Now Community.</td>
</tr>
<tr>
<td>Event parm 1 contains recipient</td>
<td>Select this check box if the event parameter 1 contains one or more notification recipients (in a comma separated-list). This field is visible only when the <strong>Send when</strong> field is set to <strong>Event is fired</strong>.</td>
</tr>
<tr>
<td>Event parm 2 contains recipient</td>
<td>Select this check box if the event parameter 2 contains one or more notification recipients (in a comma-separated list). This field is visible only when the <strong>Send when</strong> field is set to <strong>Event is fired</strong>.</td>
</tr>
<tr>
<td>Subscribable</td>
<td>Select this check box to allow all users to subscribe to this notification. See <strong>Subscription-based notifications</strong> for more information.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the record contains sensitive or protected data, consider restricting the recipient list only to those users and groups who normally have access to it, and do not enable the <strong>Subscribable</strong> option. You can also configure your notification content so that private or sensitive data is not exposed. For example, you could insert a link back to the associated record, so that details are not revealed in the notification.</td>
</tr>
</tbody>
</table>

The system does not exclude recipients based on access controls. Recipients can receive email about records that they cannot normally access from the user interface. For example, requesters can receive email about incidents and catalog requests opened on their behalf even though they normally do not have access to these records. If a notification includes record details, verify that all recipients need these details.

**Note:** By default, the system does not send email notifications to itself. For example, an email notification from instanceABC@service-now.com does not send to instanceABC@service-now.com. The system prevents this behavior to avoid looping.

6. Fill in the fields on the **What it will contain** tab.
   The following example shows the default view of the tab. The advanced view contains additional fields (see table).
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Email template      | If you want to reuse existing content, select an email template to add content to the email notification. You can only select an email template that meets one of the following conditions:  
  • shares the same scope and table as the notification  
  • shares the same scope but has no specified table  
  • shares the same table and is in the global scope |
| Subject             | Enter the subject line for the email message. The subject can include variables from the **Select variables** column.  
  If empty, the system uses the **Subject** value from the **Email template**. If you enter a value in this field, it overrides the template value.  
  If your recipients subscribe to the email notification on an SMS channel, then the system sends the email notification subject as an SMS message. To send a different SMS message, fill in the **SMS alternate** field on the email template form or the email notification form. |
| Message HTML        | Enter the content of the email notification message. The message can include variables from the **Select variables** column.  
  Variables map to column names available from the notification table, its parent tables, and reference tables. Use variables to include values from a record in the table such as an incident short description or comments and work notes.  
  The **Message HTML** field is visible only if you set the content type to **HTML and plain text** or **HTML only**.  
  If empty, the system uses the **Message HTML** value from the **Email template**. If you enter a value in this field, it overrides the template value.  
  To prevent adding extra `<p>` and `<div>` elements to your email notifications, see the blog post Extra line spacing with paragraph tags in email client by a ServiceNow employee in the Now Community. |
<p>| SMS alternate       | Enter the notification message to send to an SMS device. The SMS alternate message is limited to 140 characters.                                                                                       |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td></td>
<td>If empty, the system uses the <strong>SMS alternate</strong> value from the <strong>Email template</strong>. If you enter a value in this field, it overrides the template value.</td>
</tr>
<tr>
<td></td>
<td>If you don’t fill in the <strong>SMS alternate</strong> field on this form or the email template, then the system uses the email notification subject as the SMS message.</td>
</tr>
<tr>
<td>Importance</td>
<td>Set the importance of the email message to low or high.</td>
</tr>
<tr>
<td>Content type</td>
<td>Select the content type for the email notification:</td>
</tr>
<tr>
<td></td>
<td>• HTML and plain text</td>
</tr>
<tr>
<td></td>
<td>• HTML only</td>
</tr>
<tr>
<td></td>
<td>• Plain text only</td>
</tr>
<tr>
<td></td>
<td>By default, <strong>HTML only</strong> is enabled.</td>
</tr>
<tr>
<td>Include attachments</td>
<td>Select this check box to send all attachments from the triggering record as email attachments.</td>
</tr>
<tr>
<td>Omit watermark</td>
<td>Use this check box to apply or remove the watermark attached to each email. If the email does not contain a watermark, the system reviews the conditions of the inbound actions to create or update task records. For more information, and an alternative way to hide watermarks, see Watermarks on notification emails.</td>
</tr>
<tr>
<td>Message Text</td>
<td>Enter the notification message to send in plain text. This field appears when you set the content type to <strong>HTML and plain text</strong> or <strong>Plain text only</strong>.</td>
</tr>
<tr>
<td></td>
<td>If empty, the system uses the <strong>Message Text</strong> value from the <strong>Email template</strong>. If you enter a value in this field, it overrides the template value.</td>
</tr>
<tr>
<td>From</td>
<td>Enter the email address that you want the email notification to use in the From field. For example, <a href="mailto:helpdesk@yourcompany.com">helpdesk@yourcompany.com</a>. The email must be in a valid format, otherwise a notification message appears near the field.</td>
</tr>
<tr>
<td></td>
<td>Changing this address may require an advanced email setup such as enabling email forwarding, for example when using Sender Policy Framework (SPF) records for spam detection.</td>
</tr>
<tr>
<td>Reply to</td>
<td>Enter the email address you want people to use when replying to the email notification. For example, <a href="mailto:helpdesk@yourcompany.com">helpdesk@yourcompany.com</a>. The email must be in a valid format, otherwise a notification message appears near the field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><a href="mailto:helpdesk@yourcompany.com">helpdesk@yourcompany.com</a></td>
<td>The email must be in a valid format, otherwise a notification message appears near the field. You can add no more than one email address in this field. Changing this address requires an advanced email setup such as enabling email forwarding.</td>
</tr>
<tr>
<td>Push message only</td>
<td>Select this option to send this notification only as a push notification to a mobile device. The Push Notification feature must be active.</td>
</tr>
<tr>
<td>Push messages</td>
<td>Associate one or more push messages with this notification. The Push Notification feature must be active.</td>
</tr>
<tr>
<td>Note:</td>
<td>The push message and notification must be for the same table.</td>
</tr>
</tbody>
</table>

7. If you selected the **Allow Digest** check box, fill in the fields on the **What Digest will contain** tab to create the email digest content for the notification. The following example shows the default view of the tab. The advanced view contains additional fields (see table).
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digest Template</td>
<td>If you want to reuse existing content, such as headers or footers, select an email template to add content to the email digest.</td>
</tr>
<tr>
<td>Digest Subject</td>
<td>Enter the subject line for the email digest. The subject can include variables from the <strong>Select variables</strong> column. If empty, the system uses the <strong>Subject</strong> value from the <strong>Email template</strong>. If you enter a value in this field, it overrides the template value.</td>
</tr>
<tr>
<td>Digest HTML</td>
<td>Enter the recurring content for the email digest. The digest content can include variables from the <strong>Select variables</strong> column. Variables map to column names available from the notification table, its parent tables, and reference tables. Use variables to include values from a record in the table such as an incident short description or comments and work notes.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>To prevent adding extra <code>&lt;p&gt;</code> and <code>&lt;div&gt;</code> elements to your email digest, see the blog post <em>Extra line spacing with paragraph tags in email client</em> by a ServiceNow employee in the Now Community.</td>
</tr>
<tr>
<td>Digest Separator (HTML)</td>
<td>Use the line to separate each item summarized in the digest.</td>
</tr>
<tr>
<td>Digest From</td>
<td>Enter the email address to be used in the From field of the email digest. For example, <a href="mailto:helpdesk@yourcompany.com">helpdesk@yourcompany.com</a>. The email address must be in a valid format, otherwise a notification message appears near the field. Changing this address requires an advanced email setup such as enabling email forwarding.</td>
</tr>
<tr>
<td>Digest Reply To</td>
<td>Enter the email address that you want people to use when replying to the email digest. For example, <a href="mailto:helpdesk@yourcompany.com">helpdesk@yourcompany.com</a>. The email must be in a valid format, otherwise a notification message appears near the field. Changing this address requires an advanced email setup such as enabling email forwarding.</td>
</tr>
<tr>
<td>Digest Text</td>
<td>Enter the recurring content of the email digest to send in plain text. This field appears when you set the content type to HTML and plain text or Plain text only.</td>
</tr>
<tr>
<td>Digest Separator (text)</td>
<td>[Optional] Use the dash character as a line to separate each item summarized in the digest. This field appears when you set the content type to HTML and plain text or Plain text only.</td>
</tr>
</tbody>
</table>

When you save or update the notification, the email Digest option is available for the notification in the notification settings of your users.

8. When you finish creating the notification, click Submit. Or, if you are done modifying the notification, click Update.

**What to do next**
Use the Preview Notification option to check your notification. For example, you can see:
- How the Subject and Message fields are displayed.
- Which users will or will not receive the notification, including the reasons why users will not receive it.
Convert legacy email notifications to rich HTML

By default, new email notifications are created in the rich HTML format. But you can also convert legacy notifications to rich HTML.

Before you begin
Role required: admin

Procedure
1. Navigate to System Notification > Email > Notifications.
2. On the Email Notifications list screen, click the name of the email notification you want to convert.
3. Click the What it will contain tab.
4. Click Switch to Rich HTML Editor.
   The system copies any raw HTML from the Message field and converts it to rich HTML in the Message HTML field. Additionally, any mail scripts in the body are automatically saved to the Email Script [sys_script_email] table and are replaced in the notification body with an embedded script tag. This makes the notification body easier to read.
Note: The string "div" at the bottom of the screen shows the location of your cursor within the Message HTML field. In this case, the cursor is in a line containing an HTML <div> tag.

What to do next
When you convert an email notification that was created in a version prior to Eureka to rich HTML, mail scripts are automatically moved to the Email Script [sys_script_email] table and an embedded script tag with the name of the script is automatically inserted into the body of the notification.

When creating new email notifications, write mail scripts using System Notification > Email > Notification Email Scripts. When the scripts are completed, add a ${mail_script:script_name} embedded script tag to the email notification body. This makes it easy to use the same scripts in multiple email notifications. All you need to copy and paste from one notification to the next is the embedded script tag.

If you manually enter a mail script, any text bounded by <mail_script> </mail_script> in the body of a new or converted email notification or template which is saved to the record, a message asks whether the mail script should be converted.
In many cases, an unconverted mail script fails to run from inside the HTML editor. If you select **Yes**, the script is added to the Email Script [sys_script_email] table and is automatically replaced in the body with an embedded script tag. You can view the mail scripts in their original form by opening the email notification and clicking the **Show Notification Scripts** related link.

**Control visibility to email records generated by notifications**

Define conditions that restrict read access to target email records containing sensitive information.

**Before you begin**

Role required: admin

**About this task**

Use the Email Access Restriction [email_access_restriction] table to define conditions that control read access to an email record generated by a notification containing sensitive information. These conditions are processed by the base system ACL for the Email [sys_email] table. When you specify conditions to restrict access for a notification, the email records are visible only to users that match the conditions specified for the notification.

**Procedure**

1. Navigate to **System Notification > Email Access Restriction**.
2. Click **New**.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification</td>
<td>Choose the notification that generates the email record that should be restricted.</td>
</tr>
<tr>
<td>Application</td>
<td>Displays the application scope.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Table</td>
<td>Displays the target table for the notification that you selected.</td>
</tr>
<tr>
<td>Condition</td>
<td>Use the condition builder to determine who can access the email record. The conditions must evaluate to true to enable read access to the email record.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a short description of the read access restriction.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Advanced conditions for email notifications**

Use an advanced condition to send a notification based on the current email record, changing field values, or system properties.

To send a notification using an advanced condition, you can:

- Call a function that returns a value, or
- Set the global variable `answer` using a script

For example, in the following code, you call a function to prevent the system from sending an email notification if the sender of a self-service request is a member of the XYZ group:

```javascript
(function() {
    var groupMember = gs.getUser();
    return !groupMember.isMemberOf('XYZ');
})();
```

Alternatively, you can script the same advanced condition by using the `answer` variable:

```javascript
var groupMember = gs.getUser();
if(groupMember.isMemberOf('XYZ')){
    answer = false;
} else {
    answer = true;
}
```

Note that the script must set the `answer` variable to `true` to send the notification. If you script no conditionals, the value of `answer` is equal to the last value that you set for the variable.
You can add a script-based condition in the **Advanced condition** field by configuring the Email Notification form and adding the field. You can access the field in the **Advanced** view without configuring the form.

The advanced condition script uses the following business rule global variables:

- **current**: contains the current record from the table to which the notification is linked.
- **event**: contains the event that triggered the notification.

⚠️ **Note:** The **Advanced condition** field is evaluated in addition to other conditions you set on the notification. Both the **Condition** and **Advanced condition** must evaluate to true in order to send the notification.

**Related information**

- [Create an email notification](#)

**Edit HTML content in an email notification**

For added control over the content of an email notification, you can edit the underlying HTML.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Notification > Email > Notifications**.
2. Open an email notification record.
3. On the form, open the **What it will contain** tab.
4. In the **Message HTML** field, click the source code icon (⋯) to open the HTML source code editor.
5. Make the needed changes to the HTML.

6. On the window, click **Ok**.

7. On the form, click **Update**.

Document attachments on an email notification

You can attach documents and reports to email notifications by scripting or linking to the sys ID of the record.

You can include all attachments from the source record with the notification. For example, if an incident update generates a notification, you can include all attachments from the incident record with the notification. To include all attachments from the source record, select the check box for the **Include attachments** field. Note that email messages, including attachments, cannot exceed the maximum email size. This size includes MIME encoding. For details on MIME encoding, see Email service size restrictions.

Attaching documents with scripting

Using scripting, you can attach documents by linking to them, or you can attach various types of reports by specifying their IDs in the system.
Linking to an attachment

You can add an attachment to a notification by linking to the attachment record in the message of the notification. Upon clicking the link, email recipients log in to the instance to view the attachment record.

Linking to attachment records in this fashion requires using email notification scripting. For example:

```javascript
template.print ( 'Attachment: <a href="/sys_attachment.do?sys_id=' + now_GR.sys_id + '">' + now_GR.file_name + '</a>
 ' ) ;
```

Attaching reports using the Sys ID

You can also attach various types of reports, including gauges, dashboards, and charts, to a notification. The scripts to attach these reports take the following syntax:

```${report:X:Y}```

where:

- X is the type of report you want to attach (reportID, gaugeID, dashboardID, or chartID).
- Y is the sys ID of the report, gauge, dashboard, or chart to be attached.

For example:

- `${report:reportID:<abc123>}`
- `${report:gaugeID:<abc123>}`
- `${report:dashboardID:<abc123>}`
- `${report:chartID:<abc123>}`

Note: Multilevel pivot reports can’t attach to email notifications.

Line breaks in email notifications and rich HTML

Rich HTML provides additional control over line breaks in your email notifications and templates.

To provide control over line breaks, a Newlines to HTML check box is available in the Email Script form.
Selecting the **Newlines to HTML** check box indicates that the method for handling line breaks in earlier versions carries forward for email notifications and templates. When an email notification or template is converted to rich HTML, the **Newlines to HTML** check box is automatically selected.

For new mail scripts, add correct HTML line breaks to `template.print()` statements. If an email notification or template is not converted to rich HTML, newlines are automatically wrapped with `<div>` tags, the same as previous versions. The old mail scripts still work. However, the administrator does not enjoy the benefits of working in the rich HTML format, and does not have as much control over exact HTML formatting.

**HTML line breaks in new scripts**

When writing new scripts, insert explicit HTML line breaks and clear the **Newlines to HTML** check box so that no HTML tags are injected when email notifications are generated. For existing notifications and templates, replace `template.print("\n")` JavaScript function calls with `template.print("<br />")`. This replacement gives you better control over the HTML formatting of your email notifications.

**Preview email notifications**

You can preview what notifications look like before you actually enable the instance to send them.

**Before you begin**

Role required: admin
About this task
You can preview both types of notifications as specified by the **Send when** field on the Notification form:

- **Record inserted or updated**: A change to record in the instance triggers the notification.
- **Event is fired**: An event, such as expiration of a certificate or an inbound email action, triggers the notification.

Procedure

1. Navigate to **System Notification > Email > Notifications**.
2. Open the notification or create one.
   You must save the record before you can view the preview accurately.
3. Click **Preview Notification** on the form header.
4. On the Notification Preview window, verify that the notification works as expected.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview records for this breakdown source</td>
<td>The type of event that triggers the notification. This choice list appears if you preview an event-triggered notification. Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Generated Event</strong>: Preview the notification with a generic event that the previewer creates. This does not actually generate an event record.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Existing Event</strong>: Preview with an existing event record in the instance. If you select this option, select the event in the <strong>Event Record</strong> field.</td>
</tr>
<tr>
<td>Event Record</td>
<td>An existing event to preview an event-created notification. This option appears if you select <strong>Existing Event</strong> as the event type (for event-triggered notifications only).</td>
</tr>
<tr>
<td>Event Creator</td>
<td>The user triggering the notification for the purpose of the preview. The event creator defaults to the user who clicked <strong>Preview Notification</strong>. You can change the creator as needed. You can change the preview record as needed to see the changes in the notification content.</td>
</tr>
<tr>
<td>Preview Record</td>
<td>The record triggering the notification for the purpose of the preview. The preview record defaults to one of the records in the table specified in the <strong>Table</strong> field on the Email Notification form. You can change the preview record as needed to see the changes in the notification content.</td>
</tr>
<tr>
<td>Users</td>
<td>The users who will receive the notification, as specified in the <strong>Who will receive</strong> section of the Email Notification form:</td>
</tr>
<tr>
<td></td>
<td>• All users that you specify on the form appear, but only the users that will actually receive the notification with the current preview settings appear in black text.</td>
</tr>
<tr>
<td></td>
<td>• Users that are specified but for whatever reason will not receive the notification appear in red, strikethrough text. Place the cursor over any of these names to see the reason the user will not receive the notification. For example, one reason could be that the user's notification settings are <strong>disabled</strong>.</td>
</tr>
<tr>
<td>Subject and Body</td>
<td>The content of the notification as defined by the template. The <strong>Subject</strong> and <strong>Body</strong> sections on the preview display the content in the corresponding template fields.</td>
</tr>
</tbody>
</table>
5. After you have reviewed the notification, exit the preview window.
6. Make the necessary changes to the notification or template, if necessary.

**Time zone for email notifications**
A system property controls the time zone that the instance uses for the date and time stamp of a message.

The date and time stamp of a notification uses the system time zone, not the time zone of any recipient. The email property `glide.email.append.timezone` controls whether to append the time zone. If true, the system time zone of the instance is appended to any Date/Time fields in outbound email messages (for example, 2018-07-02 04:01:14 PST).

**Specify alternative outbound email addresses for notifications**
By default, the system sends all outbound email notifications from the default email address of the instance, but you can specify an alternative address.

**Before you begin**
**Role required:** admin

**About this task**
For organizations that need to send email messages from specific email addresses, such as from multiple service desks, or they want to send notifications in different languages, the platform supports configuring multiple outbound addresses.

**Procedure**
1. Navigate to **System Notification > Email > Notifications**.
2. Select an existing notification record for the desired event, such as **Incident Closed**.
3. Create a copy of this notification for each outbound email address.
4. Open one of the notification copies, and click the **Advanced view** related link.
5. In the **What it will contain** section, add an email address to the From field that is different from the default instance address.
   For more information on how to construct the From address, refer to section 3.6.2 of RFC 2822.
6. Add a different email address than the From address to the **Reply to** field if you want replies to this notification to go to a different address.
The system checks the **From** field for an address. If this field is empty, then the system uses the default address for the instance. If the **Reply to** field is empty, then all replies are sent to the address from which the notification was sent. If the **Reply to** field contains an email address, then the system sends all replies to the notification to this address.

7. Create mutually-exclusive conditions for notifications of the same type, so only the desired notification is sent when the event is fired.

   For example, if the **Company** is a certain value, then the notification comes from a unique email address entered in the **From** field.

8. Click **Update**.

**Specify an outbound email address for a particular language**

You can specify a different email address for each language your instance supports.

**Before you begin**

Role required: admin

**Procedure**

1. Create or copy a notification record for the desired event.

2. In the **What will it contain** section, enter a new email address in the **From** field.

3. Create the **Subject** and **Message** content in the desired language.

4. In the **When to send** section, create a condition as follows:
   
   a. In the list of **Condition** fields, select **Show Related Fields** from the bottom of the choice list.
   
   b. From the choice list of **Related Fields**, select the field that identifies the recipient.

      For example, select **Caller > User** fields to send the notification to the user who called in an incident, or **Assigned to > User** fields to send the notification to the user to whom an incident is assigned.

   c. From the choice list of user fields, select **Language**.
   
   d. Select the **is** operator.
   
   e. Complete the condition by selecting the language of the desired user.

5. Click **Update**.

   All notifications for that event originate from the specified email address and go out in the language of the recipient.
**Notification variables**

Use notification variables to display dynamic information in the body of a notification such as a field value, a link to a record, or a link to system preferences.

**Syntax**

Specify a notification variable using this syntax:

```
${variable-name+variable-parameters}
```

The `variable-name` portion is always required. Not all notification variables support the `variable-parameters` portion. When available, most variable parameters are optional. See the list of available notification variables for variable names and available parameters.

**Available variables**

The system provides these notification variables.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Available parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>${field-name}</code></td>
<td>Display the value of the specified field.</td>
<td>None</td>
</tr>
<tr>
<td><code>${image-field-name}</code></td>
<td>Display an image associated with a record. This variable is typically used</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>with HTML to specify the source of an image element.</td>
<td></td>
</tr>
<tr>
<td>• <code>${URI}</code></td>
<td>Display a link to the current record.</td>
<td>Any valid <code>sysparm</code> URL parameter.</td>
</tr>
<tr>
<td>• <code>${URI_REF}</code></td>
<td>• <code>URI</code>: The link text is the word <code>LINK</code>.</td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td>• <code>URI_REF</code>: The link text is the display value of the record.</td>
<td>• <code>sysparm_scriptlet</code></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> These variables don’t apply to records in Workspace. To link to</td>
<td>• <code>sysparm_view</code></td>
</tr>
<tr>
<td></td>
<td>a record in Workspace, create a mail script that prints a URL to a</td>
<td></td>
</tr>
<tr>
<td></td>
<td>notification. For more information, see <a href="#">Linking to a record in Workspace</a>.</td>
<td></td>
</tr>
</tbody>
</table>
## Available notification variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Available parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>{reference-field.URI}</code></td>
<td>Display a link to the record listed in a reference field.</td>
<td>Any valid <code>sysparm</code> URL parameter. For example:</td>
</tr>
</tbody>
</table>
| `{reference-field.URI_REF}` | URI: The link text is the word `LINK`  
       | URI_REF: The link text is the display value of the record.                                       | • `sysparm_scriptlet`  
       |                                                                                                  | • `sysparm_view`                                                      |
| `{CMS_URI}`                | Display a link to the specified record within a CMS page.                                        | `<CMS-site>/`  
       |                                                                                                  | `<CMS-page>`: The required relative path to the CMS page.                        |
| `{notification:body}`      | Display the body contents of an email template or email notification. Use this notification      | None                                                                                 |
|                           | variable to specify where to display body content in an email layout.                           |                                                                                      |
| `{mail_script:script_name}` | Run the specified mail script.                                                                  | None                                                                                 |
| `{NOTIF_UNSUB}`           | Display a link unsubscribe from this notification.                                              | `link_text`: specify the text to display as a link within quotation marks.            |
| `{NOTIF_PREFS}`           | Display a link to set notification preferences.                                                   | `link_text`: specify the text to display as a link within quotation marks.            |
| `{comments:n}`            | Display the most recent comments that were made on the target record.                           | Any number greater than 0.                                                           |
|                           | The number of comments to display is `n`. For example, `{comments:3}` displays the last three   |                                                                                      |
|                           | comments that were made to the record.                                                           |                                                                                      |
|                           | To display all comments, use the variable `{comments}`.                                          |                                                                                      |
| `{comments_and_work_notes:n}` | Display the most recent comments and work notes that were made.                                 | Any number greater than 0.                                                           |
Available notification variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Available parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>on the target record. The number of comments and work notes to display is n. For example, ${comments_and_work_notes:3} displays the last three comments and work notes that were made to the record. To display all comments and work notes, use the variable ${comments_and_work_notes}.</td>
<td></td>
</tr>
</tbody>
</table>

Examples
Refer to the following examples to see how each notification variable is rendered in the output:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>${field-name}</td>
<td>Source: Incident ${number} - comments added</td>
</tr>
<tr>
<td></td>
<td>Output: Incident INC1000001 - comments added</td>
</tr>
<tr>
<td>${image-field-name}</td>
<td>Source: &lt;img src='${picture}?t=medium'/&gt;</td>
</tr>
<tr>
<td></td>
<td>Output:</td>
</tr>
<tr>
<td>• ${URI}</td>
<td>${URI} Source: Click here to view incident: ${URI}</td>
</tr>
<tr>
<td>• ${URI_REF}</td>
<td>${URI} Output:</td>
</tr>
<tr>
<td>Variable</td>
<td>Example</td>
</tr>
<tr>
<td>----------</td>
<td>---------</td>
</tr>
<tr>
<td>${URI_REF}</td>
<td>Source: Click here to view incident: ${URI_REF}</td>
</tr>
<tr>
<td>${URI_REF}</td>
<td>Output: Click here to view incident: INC0000055</td>
</tr>
<tr>
<td>• ${reference-field.URI}</td>
<td>Source: Click here to view Incident: ${URI_REF} Click here to view Related Problem: ${problem_id.URI_REF}</td>
</tr>
<tr>
<td>• ${reference-field.URI_REF}</td>
<td>Output: Click here to view Incident: INC0010002 Click here to view Related Problem: PRB0040001</td>
</tr>
<tr>
<td>${CMS_URI}</td>
<td>Source: ${CMS_URI+ess/incident_detail} Output: a link to a target CMS page such as https://&lt;instance name&gt;.service-now.com/ess/incident_detail.do?sysparm_document_key=incident,46e18c0fa9fe19810066a0083f76bd56</td>
</tr>
<tr>
<td>${notification:body}</td>
<td>Source:</td>
</tr>
<tr>
<td>${mail_script:script-name}</td>
<td></td>
</tr>
<tr>
<td>${NOTIF_UNSUB}</td>
<td></td>
</tr>
<tr>
<td>${NOTIF_PREFS}</td>
<td></td>
</tr>
<tr>
<td>Variable</td>
<td>Example</td>
</tr>
<tr>
<td>----------</td>
<td>---------</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Demo Layout - Go To Instance Button</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Advanced</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Layout**

```text
${notification:body}

${mail_script:go_to_instance_button}

${NOTIF_UNSUB} | ${NOTIF_PRE}  
```

Output:
Variable | Example
--- | ---

Notification Preview

Preview records for this breakdown source

Event Creator | Preview Record
--- | ---
Fred Luddy | INC0000060

Users

Beth Anglin

Subject

Incident INC0000060 commented

Body

You can view all the details of the incident by following the link below.

Go to Instance

Unsubscribe | Manage Preferences
Links to records in email notifications

Adding the `$URI` parameter to an outbound email body or template creates a link to a specific record.

When a user clicks the word LINK, the instance prompts the user to log in if not already logged in, and then redirects the user to the record specified in the URI.

The `$URI` parameter has an extension called the `$URI+` format to specify additional arguments in the email link, such as sysparm terms, in addition to the automatically created URI. For example (whitespace added for improved readability):

```plaintext
${URI+&sysparm_scriptlet=current.assigned_to=gs.getUserID()
    &sysparm_scriptlet_condition=current.assigned_to.nil()
    &sysparm_view=incident_active}
```

This example executes the JavaScript:

```javascript
current.assigned_to=gs.getUserID()
```

when the condition of

```javascript
current.assigned_to.nil()
```

is satisfied. Additionally, the script sets the view to `incident_active`.

Linking to a record in Workspace

The `$URI` and `$URI_REF` variables don’t apply to records in Workspace. To link to a record in Workspace, create a mail script and reference it in your notification. For more information on using mail scripts, see JavaScript in emails.

The mail script that you create should print a URL to the notification. The URL must have the following format:

```plaintext
https://<instance_name>/now/workspace/<workspace_name>/record/<table_name>/<sys_id>
```

The following example script shows the logic that a mail script must include to create a link to a record in Workspace.
Enable links to records

Adding the special `${URI}` parameter to an outbound email body or template creates a link to a specific record.

When a user clicks the word LINK, the instance prompts the user to log in if not already logged in, and then redirects the user to the record specified in the URI.

The `${URI}` parameter has an extension called the `${URI+}` format to specify additional arguments in the email link, such as sysparm terms, in addition to the automatically created URI. For example (whitespace added for improved readability):

`${URI+&sysparm_scriptlet=current.assigned_to=gs.getUserID()&sysparm_scriptlet_condition=current.assigned_to.nil()&sysparm_view=incident_active}`

This example executes the JavaScript:

```
current.assigned_to=gs.getUserID()
```

when the condition of

```
current.assigned_to.nil()
```

is satisfied. Additionally, the script sets the view to incident_active.

Change the link text

To show the display value of the record as the link text instead of the word LINK, use the `${URI_REF}` parameter instead of the `${URI}` parameter.
**URI_REF email notification**

Short description: SAP Sales app is not accessible

Click here to view incident: INC0000055

Comments:

For example, if the URL displays an incident record, the link text is the incident number, which is the display value for incidents. If the URL displays a user record, then the link text is the user name.

**Link to related records**

A notification can link to a related record by specifying a reference field in front of the \$\{uri\} or \$\{uri_ref\} parameters.

Format the related record link as follows:

- \$\{<reference field that contains the related record you want to display>.uri\}
- \$\{<reference field that contains the related record you want to display>.uri_ref\}

For example:

<table>
<thead>
<tr>
<th>Related record to provide link to</th>
<th>Notification record table</th>
<th>Reference field</th>
<th>Samples</th>
</tr>
</thead>
</table>
| Related task record to be approved from an approval notification | Approval [sysapproval_approver] | Approval for [sysapproval] | • \$\{sysapproval.uri\}  
• \$\{sysapproval.uri_ref\} |
| Related problem record in an incident notification | Incident | Problem [problem_id] | • \$\{problem_id.uri\}  
• \$\{problem_id.uri_ref\} |

For example, the following notification template produces the email links in the picture below:
Content page links in email notifications

Links to CMS pages can be put in notifications to make it easy for the reader to access the pages.

The link takes the following format: \${CMS_URI+<site>/<page>}

For example, to link the email recipient to a page called Incident in the content site ESS, with the current incident as the target document, use the following format: \${CMS_URI+ess/incident_detail}

The resulting email URL has this format: https://<instance name>.service-now.com/ess/incident_detail.do?sysparm_document_key=incident,46e18c0fa9fe19810066a0083f76bd56

Email unsubscribe

Administrators can add unsubscribe links to notifications so that users can stop receiving particular email messages.

ℹ️ Note: The base system notifications include unsubscribe and notification preferences links.

The system offers two types of macros to create unsubscribe links.

- An unsubscribe link that creates an email message to the instance.
- An unsubscribe link that opens the notification preferences for the user on the instance.

Available unsubscribe macros

<table>
<thead>
<tr>
<th>Unsubscribe type</th>
<th>Macro used</th>
<th>Description</th>
<th>Available parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unsubscribe by email (Unauthenticated)</td>
<td>${NOTIF_UNSUB}</td>
<td>The system generates an HTML mailto hyperlink. When users click the link, their browser or email client creates a pre-</td>
<td>link_text: specify the text to display as a link within</td>
</tr>
</tbody>
</table>
Available unsubscribe macros (continued)

<table>
<thead>
<tr>
<th>Unsubscribe type</th>
<th>Macro used</th>
<th>Description</th>
<th>Available parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>formatted unsubscribe email message to the instance.</td>
<td>quotation marks.</td>
</tr>
<tr>
<td>Unsubscribe by notification preferences (Authenticated)</td>
<td>${NOTIF_PREFS}</td>
<td>The system generates an instance link directly to the notification preferences for this notification type.</td>
<td>link_text: specify the text to display as a link within quotation marks.</td>
</tr>
</tbody>
</table>

Administrators can add unsubscribe macros to any notification record type such as:

- Email layouts
- Email templates
- Email notifications

Unsubscribe by email

Unsubscribe by email requires the user email client or browser to create a pre-formatted email message containing these elements:

- The **To** field has the email address of the instance.
- The **Subject** starts with the string *Unsubscribe from*.
- The **Body** has a JSON string with a name-value pair of **Unsubscribe** and an array value that contains two more name-value pairs.
  - The **notification_id** parameter specifies the Sys ID of the notification the user wants to unsubscribe from.
  - The **unsub_token** parameter specifies an instance ID the system uses to verify that the email came from a ServiceNow instance.

**Note:** Some email clients and web browsers, such as GMail on Chrome, require extra client configuration to support mailto hyperlinks. Administrators can provide an alternative unsubscribe method for users whose email client or browser does not support mailto links. See RFC6068 for information about the mailto URI scheme.

The **Unsubscribe from Notification** inbound action processes the email and unsubscribes the sender from the listed notification.
Note: Unsubscribing by email message does not require users to authenticate with the instance first.

Unsubscribe by notification preferences
Unsubscribe by notification preferences requires the user's browser to navigate to the notification preferences page on the instance. After logging in, the system displays the notification preferences for this particular notification.

Users can set preferences for this notification such as disabling notifications for a particular device. Users must save their notification preferences for changes to take effect.

Example: Unsubscribe links
This email layout adds several unsubscribe links to the bottom of each email notification.

`${NOTIF_UNSUB} from this notification by email or `${NOTIF_UNSUB+link_text="click here"}.
Manage your `${NOTIF_PREFS} or `${NOTIF_PREFS+link_text="click here"}.

When rendered in an email notification, the unsubscribe links only display the link text.
Sample email with unsubscribe links

If a user clicks the **unsubscribe** link, the email client creates a message such as this:
**Scripting for email notifications**

Email scripts allow for business rule-like scripting within an outbound email message.

With mail scripts, you can dynamically change the email output of your system based on different criteria. Mail scripts allow you to perform simple tasks, such as displaying incident data, and complex ones, such as making advanced database queries.

You can add a `${mail_script:script name}` embedded script tag to the body of the email notification or template, replacing `script name` with the name of the script you created. This makes it easy to use the same scripts in multiple email notifications or templates.

If you manually enter a mail script bounded by `<mail_script>` and `</mail_script>` in the body of a new or converted email notification or template, and then attempt to save the record, a message asks whether the mail script should be converted. In many cases, an unconverted mail script fails to run from inside the HTML editor. If you select Yes, the script is added to the Email Script [sys_script_email] table and is automatically replaced in the body with an embedded script tag (`${mail_script:script_name}`).

**JavaScript in emails**

Create mail scripts in System Notifications > Email > Notification Email Script, and refer to them by using `${mail_script:script name}` in the script field.

To print text into the body of the message, use the `template.print("a string")` function.
JavaScript in templates

The `event.parm1` and `event.parm2` parameters that come from the originating event can also be used.

**Mail script API**

Certain variables are available when processing mail_script scripts.

**Mail script variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Object Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>template</td>
<td>Handles printing from the mail script to the email message.</td>
</tr>
<tr>
<td></td>
<td><code>template.print(&quot;message&quot;);</code> //outputs message to the email body.</td>
</tr>
<tr>
<td></td>
<td><code>template.space(&quot;number of spaces&quot;);</code> //outputs spaces to the email body.</td>
</tr>
<tr>
<td>email_action</td>
<td>GlideRecord object for the email notification (sysevent_email_action).</td>
</tr>
<tr>
<td>event</td>
<td>GlideRecord object for the event that fired the notification (sysevent).</td>
</tr>
<tr>
<td>email</td>
<td>EmailOutbound object</td>
</tr>
<tr>
<td></td>
<td>Available methods:</td>
</tr>
<tr>
<td></td>
<td>• <code>addAddress(String type, String address, String displayname)</code>: type can be cc or bcc.</td>
</tr>
<tr>
<td></td>
<td>• <code>setFrom(String address)</code>: override the sender address.</td>
</tr>
<tr>
<td></td>
<td>• <code>setReplyTo(String address)</code>: override the reply to address.</td>
</tr>
<tr>
<td></td>
<td>• <code>setSubject(String subject)</code>: override the subject of the message.</td>
</tr>
<tr>
<td></td>
<td>• <code>setBody(String message)</code>: override the body of the message.</td>
</tr>
</tbody>
</table>
Mail script variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Object Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The email address that is passed by setFrom and setReplyTo needs to be in a valid form such as <a href="mailto:helpdesk@sn.com">helpdesk@sn.com</a> or Display Name <a href="mailto:helpdesk@sn.com">helpdesk@sn.com</a>. If the email address includes a 'Display Name', then that value overrides the instance's display name.</td>
</tr>
</tbody>
</table>

Related information

GlideEmailOutbound API

Example scripting for email notifications

Examples of scripting for email notifications.

Scripting examples for email notifications

A simple text string is the most basic example of the way a mail script works. This script prints out "Incident number - INC00001".

```java
template.print("Incident number - "+ current.number);
```

More advanced scripts, like this one, can be found by browsing through the base system email templates.

```java
template.print("Summary of Requested items:<br />
" + gr.quantity + " X " + gr.cat_item.getDisplayValue() + " at " + gr.cat_item.price.getDisplayValue() + " each <br/>");
```

To dynamically change field values within an email, use the following functions within `<mail_script>` syntax:

```java
... email.setFrom(current.caller_id.email);
email.setReplyTo("joe.employee@yourcompany.com");
email.setSubject("This is the new subject line");
email.setBody("This is the new body");
...```
Using the `instance_name` property ensures that the notification still works when migrated between instances.

```javascript
function dothis(){
    var now_GR = new GlideRecord('sys_attachment');
    gr.addQuery('table_sys_id', current.sys_id);
    gr.query();
    while(gr.next()){ template.print('Attachment: <a href="https://' + gs.getProperty('instance_name') + '.service-now.com/sys_attachment.do?sys_id=' + gr.sys_id + '">' +
        gr.file_name + '</a>');}
}
```

You can specify copied and blind copied recipients by using the email object within a mail script.

```javascript
//email.addAddress(type, address, displayname);
    email.addAddress("cc", "john.copy@example.com", "John Roberts");
    email.addAddress("bcc", "john.secret@example.com", "John Roberts");
```

The following is an example script to add users from `watch_list` as copied recipients.

```javascript
if(!current.watch_list.nil()){ //get watch list addresses and add to cc
    var watcherIds = current.watch_list.split(',');

    //get user records
    var user = new GlideRecord("sys_user");
    user.addQuery("sys_id", watcherIds);
    user.addQuery("notification", 2);
    //email
    user.addQuery("email","!=" , "");
    user.query();

    while(user.next()){ //add to cc list
        email.addAddress("cc", user.email, user.getDisplayValue());
    }
}
```

**Related information**

- TemplatePrinter API
- GlideEmailOutbound API

**Useful attachment scripts**

This is a searchable version of the Useful Attachment Scripts.
CAUTION: The customization described here was developed for use in specific instances, and is not supported by ServiceNow Technical Support. This method is provided as-is and should be tested thoroughly before implementation. Post all questions and comments regarding this customization to our community forum.

Copy attachments from record to record
Use the following script to copy an attachment from one record to another record:

```
GlideSysAttachment.copy('sourcetable','sys_id','destinationtable','sys_id');
```

Note: GlideSysAttachment.copy copies all attachments; it cannot select specific attachments.

Delete duplicate attachments
Use the following script in a business rule, scheduled job, or background script to delete duplicate attachments located in the Attachments [sys_attachment] table:

```
function fixDuplicateImages(){var now_GR =new GlideRecord('sys_attachment');
  gr.addQuery('table_name','LIKE','ZZ_YY%');
  gr.orderBy('table_sys_id');
  gr.orderByDesc('sys_created_on');
  gr.query();var lastID ="not_a_match";var lastFile ="not_a_match";while(gr.next()){var isDuplicate =(lastID == gr.table_sys_id)&&(lastFile == gr.file_name);
    lastID = gr.table_sys_id;
    lastFile = gr.file_name;
    gs.print(gr.table_sys_id+ ' '+ gr.table_name+ ' '+ gr.file_name+ ' '+
              gr.sys_created_on+ ' '+ isDuplicate);if(isDuplicate)
      gr.deleteRecord();}}
```

Display whether tasks have attachments in list view
Use the following script in a business rule to display whether tasks have attachments when viewed in the record list view. Note that the script needs a custom field on the Has Attachments [u_has_attachments] table.
checkAttachment();

function checkAttachment(){ // if inserting then the task has an
  attachment
  if(current.operation()=='insert')
    hasAttachment('true'); // if deleting attachment check for
  other attachments
  if(current.operation()=='delete')
  {var timeNow3 =new GlideDateTime();
    gs.log('has_attachment br: gliderecord query start date time
    is: ' + timeNow3.getNumericValue(),'jwtest');
    var attachCount =new GlideAggregate('sys_attachment');
      attachCount.addQuery('table_sys_id',current.sys_id);
      attachCount.addAggregate('COUNT');
      attachCount.query();

      var numAttachments = '0'; // if no other attachments task does not have
      attachCount.next();
      numAttachments =
      attachCount.getAggregate("COUNT");

      hasAttachment = 'true';
      else{
        hasAttachment = 'false';
      var timeNow4 =new GlideDateTime();
    gs.log('has_attachment br: gliderecord query start date time is: ' +
    timeNow4.getNumericValue(),'jwtest');
  } }

function hasAttachment(answer){
  var task =new GlideRecord('task');
  task.addQuery('sys_id',current.table_sys_id);
  task.query();

  if(task.next()){
    task.u_has_attachment = answer;
    task.autoSysFields(false); // Don't set the lastUpdatedTime or the
    Simultaneous Update Alert will likely get triggered
    task.setWorkflow(false); // Don't allow other business rules to run,
    otherwise multiple notifications will likely be sent
    task.update();
  }
}

Note: Schedule the business rule to run after insert/delete.

Link to attachments in an email notification
Use the following script in an email notification or template to include links to
attachments:
printattachments();

function printattachments(){var now_GR =new GlideRecord('sys_attachment');
    gr.addQuery('tableSysId',current.sys_id);
    gr.query();while(gr.next()){    template.print('Attachment: <a href="http://'+gs.getProperty("instance_name")+'.'+service-now.com/sys_attachment.do?sys_id='+ gr.sys_id+'">'+ gr.file_name+'</a>');}

! Note: Replace "instance_name" with your instance name.

Attachment Logging
Whenever a user downloads an attachment, the action writes an attachment.read event record to the event log. If desired, you can process these events with a Script Action or an Email Notification. This can be useful if you want to do something when an attachment is read. For example, you can record when and by whom certain attachments are downloaded. For this functionality, the current variable must point to a sys_attachment record, and the event record must use the following parameters:

- parm1: File name
- parm2: Table name

Baseline email notifications
The baseline system provides several email notifications.

Some events listed in this table do not appear in a business rule and are fired by other conditions in the platform. Some events are hardcoded and are not user configurable.

Baseline email notification descriptions

<table>
<thead>
<tr>
<th>Email notification</th>
<th>Description</th>
<th>Triggering event</th>
<th>Business Rule Controlling Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appointment Invite</td>
<td>Type: Meeting Invitation</td>
<td>itil_appointment.inserted</td>
<td>Global business rule</td>
</tr>
<tr>
<td></td>
<td>Adds a meeting invitation to the recipient’s calendar by</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email notification</td>
<td>Description</td>
<td>Triggering event</td>
<td>Business Rule</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Appointment Update</td>
<td>Type: Meeting Invitation</td>
<td></td>
<td>Global business rule</td>
</tr>
<tr>
<td></td>
<td>Updates an existing meeting in the recipient’s calendar by sending an</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>iCalendar formatted email</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Approval Rejected</td>
<td>Type: EMAIL</td>
<td>approval.rejected</td>
<td>approver events</td>
</tr>
<tr>
<td></td>
<td>A task-based approval has been rejected – includes the approver’s name.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Approval Rejected by</td>
<td>Type: EMAIL</td>
<td>approval.rejected.by.other</td>
<td>approval events</td>
</tr>
<tr>
<td>Other</td>
<td>A task-based approval has been rejected – includes the approver’s name.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Approval Request</td>
<td>Type: EMAIL</td>
<td>approval.inserted</td>
<td>approver changes</td>
</tr>
<tr>
<td></td>
<td>Sends an email for the recipient to reply with an approval decision. In the</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>approval email, the recipient selects a link</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email notification</td>
<td>Description</td>
<td>Triggering event</td>
<td>Business Rule Controlling Event</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Catalog Approval Request Rejected</td>
<td>Type: EMAIL A catalog request has been rejected – includes the approver’s name.</td>
<td>request.approval.rejected</td>
<td>approval events</td>
</tr>
<tr>
<td>Catalog Approval Request</td>
<td>Type: EMAIL A catalog request for which you were an approver has been cancelled.</td>
<td>request.approval.cancelled</td>
<td>approver changes</td>
</tr>
<tr>
<td>Certificate Expired</td>
<td>Type: EMAIL Notification that the X.509 certificate has expired.</td>
<td>certificate.expired</td>
<td>certificate events</td>
</tr>
<tr>
<td>Certificate Expiring</td>
<td>Type: EMAIL Notification that the X.509 certificate is</td>
<td>certificate.expiring</td>
<td>certificate events</td>
</tr>
</tbody>
</table>
## Baseline email notification descriptions (continued)

<table>
<thead>
<tr>
<th>Email notification</th>
<th>Description</th>
<th>Triggering event</th>
<th>Business Rule Controlling Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>expiring in N days.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change approved</td>
<td>Type: EMAIL</td>
<td>change.approved</td>
<td>Change events and task events</td>
</tr>
<tr>
<td></td>
<td>A change request has been approved.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change assigned to me</td>
<td>Type: EMAIL</td>
<td>change.assigned</td>
<td>Change events</td>
</tr>
<tr>
<td></td>
<td>A change request has been assigned to you.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change assigned to my group</td>
<td>Type: EMAIL</td>
<td>change.assigned.to.group</td>
<td>Change events</td>
</tr>
<tr>
<td></td>
<td>A change request has been assigned to your group.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change commented (to assignee)</td>
<td>Type: EMAIL</td>
<td>change.commented</td>
<td>Change events</td>
</tr>
<tr>
<td></td>
<td>A comment has been added to a change request. The person assigned to the change request receives an email notification.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change commented (unassigned)</td>
<td>Type: EMAIL</td>
<td>change.commented</td>
<td>Change events</td>
</tr>
<tr>
<td></td>
<td>A comment has been added to a change request. The assignment group assigned to the change request receives an email notification.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email notification</td>
<td>Description</td>
<td>Triggering event</td>
<td>Business Rule Controlling Event</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Change Notification</td>
<td>Type: EMAIL Notification of a change in the fields label in a form.</td>
<td>label.notify</td>
<td></td>
</tr>
<tr>
<td>Change rejected</td>
<td>Type: EMAIL A change request has been rejected.</td>
<td>change.rejected</td>
<td>Change events and task events</td>
</tr>
<tr>
<td>Change Task worknoted (unassigned)</td>
<td>Type: EMAIL A work note has been added to a change task. The assignment group assigned to the change task receives an email notification.</td>
<td>change_task.worknoted</td>
<td>Change task events</td>
</tr>
<tr>
<td>Change Task worknoted (to assignee)</td>
<td>Type: EMAIL A work note has been added to a change task. The person assigned to the change task receives an email notification.</td>
<td>change_task.worknoted</td>
<td>Change task events</td>
</tr>
<tr>
<td>Change Task assigned to my group</td>
<td>Type: EMAIL A change task has been assigned to your group.</td>
<td>change_task.assigned.to.group</td>
<td>Change task events</td>
</tr>
<tr>
<td>Email notification</td>
<td>Description</td>
<td>Triggering event</td>
<td>Business Rule Controlling Event</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>---------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>Change Task assigned to me</td>
<td>Type: EMAIL A change task has been assigned to you.</td>
<td>change_task.assigned</td>
<td>Change task events</td>
</tr>
<tr>
<td>Change worknoted (to assignee)</td>
<td>Type: EMAIL A work note has been added to a change request. The person assigned to the change request receives an email notification.</td>
<td>change.worknoted</td>
<td>Change events</td>
</tr>
<tr>
<td>Change worknoted (unassigned)</td>
<td>Type: EMAIL A work note has been added to a change request. The assignment group assigned to the change request receives an email notification.</td>
<td>change.worknoted</td>
<td>Change events</td>
</tr>
<tr>
<td>Email assigned to</td>
<td>Type: EMAIL An incident has been assigned to you (the recipient of the email).</td>
<td>incident.assigned</td>
<td>incident.events</td>
</tr>
<tr>
<td>Email assigned to (sc_task)</td>
<td>Type: EMAIL A task has been assigned to you (the recipient of the email).</td>
<td>sc_task.assigned.to.user</td>
<td>sc_task_events</td>
</tr>
</tbody>
</table>
## Baseline email notification descriptions (continued)

<table>
<thead>
<tr>
<th>Email notification</th>
<th>Description</th>
<th>Triggering event</th>
<th>Business Rule Controlling Event</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>This email notification was used for the legacy Delivery Plan system of email notifications. In order to use this email notification with a workflow, the <code>work_start</code> field needs to be set by the workflow using a Set Value activity.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email assigned To Group</td>
<td><strong>Type:</strong> EMAIL</td>
<td><em>incident.assigned.to.group</em></td>
<td><em>incident events</em></td>
</tr>
<tr>
<td></td>
<td>An incident has been assigned to an assignment group of which you are a member (the recipient of the email).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email assigned to group (sc_task)</td>
<td><strong>Type:</strong> EMAIL</td>
<td><em>sc_task.assigned.to.group</em></td>
<td><em>sc_task_events</em></td>
</tr>
<tr>
<td></td>
<td>A Service Catalog task has been assigned</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email notification</td>
<td>Description</td>
<td>Triggering event</td>
<td>Business Rule Controlling Event</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
<td>------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Incident Closed</td>
<td>Type: EMAIL An incident opened by you (the recipient of the email), has been closed.</td>
<td>incident.updated</td>
<td>incident events</td>
</tr>
<tr>
<td>Incident Commented</td>
<td>Type: EMAIL An incident opened by you (the recipient of the email) has had comments added. This notification uses a template for an employee self-service (ESS) user.</td>
<td>incident.commented</td>
<td>incident events</td>
</tr>
<tr>
<td>Incident Commented</td>
<td>Type: EMAIL An incident assigned to you (the recipient of the email) has had comments added. This notification uses a template for an ITIL user.</td>
<td>incident.commented</td>
<td>incident events</td>
</tr>
<tr>
<td>Incident Opened</td>
<td>Type: EMAIL</td>
<td>incident.inserted</td>
<td>incident events</td>
</tr>
</tbody>
</table>
### Baseline email notification descriptions (continued)

<table>
<thead>
<tr>
<th>Email notification</th>
<th>Description</th>
<th>Triggering event</th>
<th>Business Rule Controlling Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Opened &amp; Unassigned</td>
<td>An incident has been opened for you (the recipient of the email) by someone else. This notification uses a template for an employee self-service (ESS) user.</td>
<td>incident.inserted</td>
<td>incident events</td>
</tr>
<tr>
<td>Incident Resolved</td>
<td>An incident has been opened and is unassigned. This notification uses a template for an ITIL user.</td>
<td>incident.updated</td>
<td>incident events</td>
</tr>
<tr>
<td>Knowledge Closed Created</td>
<td>A contributor's submission to the Knowledge Base was accepted and an article was created.</td>
<td>kb.submission.closed_created</td>
<td>KB event</td>
</tr>
<tr>
<td>Email notification</td>
<td>Description</td>
<td>Triggering event</td>
<td>Business Rule Controlling Event</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------</td>
<td>---------------------------------</td>
</tr>
</tbody>
</table>
| Knowledge Closed Duplicate | Type: EMAIL  
A contributor's submission to the Knowledge Base was determined to be a duplicate, and no article was created. | kb.submission.closed_duplicate                         | KB event                        |
| Knowledge Closed Invalid   | Type: EMAIL  
A contributor's submission to the Knowledge Base was determined to be invalid (unusable). | kb.submission.closed_invalid                          | KB event                        |
| Notify Change Calendar     | Type: Meeting Invitation  
Notifies the recipients of the schedule for a change request and exports the schedule to the Microsoft Outlook calendar.  
The email is in the format of iCalendar formatted email. | change.calendar.notify                                | change events                   |
| Notify Change Calendar Remove | Type: Meeting Invitation  
Notifies the recipients that a scheduled change has | change.calendar.notify.remove                          | change events                   |
### Baseline email notification descriptions (continued)

<table>
<thead>
<tr>
<th>Email notification</th>
<th>Description</th>
<th>Triggering event</th>
<th>Business Rule Controlling Event</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>been closed or assigned to someone else and removes the entry from the Microsoft Outlook calendar. The email is in the format of iCalendar formatted email.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem Task assigned to me</td>
<td>Type: EMAIL A problem task has been assigned to you.</td>
<td>problem_task.assigned</td>
<td>Problem task events</td>
</tr>
<tr>
<td>Problem Task assigned to my group</td>
<td>Type: EMAIL A problem task has been assigned to your group.</td>
<td>problem_task.assigned.to.group</td>
<td>Problem task events</td>
</tr>
<tr>
<td>Problem Task worknoted (to assignee)</td>
<td>Type: EMAIL A work note has been added to a problem task. The person assigned to the problem task receives an email notification.</td>
<td>problem_task.worknoted</td>
<td>Problem task events</td>
</tr>
<tr>
<td>Problem Task worknoted (unassigned)</td>
<td>Type: EMAIL A work note has been added to a problem task. The assignment group assigned</td>
<td>problem_task.worknoted</td>
<td>Problem task events</td>
</tr>
<tr>
<td>Email notification</td>
<td>Description</td>
<td>Triggering event</td>
<td>Business Rule Controlling Event</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
<td>------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td><strong>Problem worknoted (to assignee)</strong></td>
<td>to the problem task receives an email notification.</td>
<td>problem.worknoted</td>
<td>Problem events</td>
</tr>
<tr>
<td><strong>Problem worknoted (unassigned)</strong></td>
<td>A work note has been added to a problem. The person assigned to the problem receives an email notification.</td>
<td>problem.worknoted</td>
<td>Problem events</td>
</tr>
<tr>
<td><strong>Reminder Insert</strong></td>
<td>A work note has been added to a problem. The assignment group assigned to the problem receives an email notification.</td>
<td>reminder.notify</td>
<td></td>
</tr>
<tr>
<td><strong>Reminder Insert</strong></td>
<td>A work note has been added to a problem. The assignment group assigned to the problem receives an email notification.</td>
<td>reminder.notify.delete</td>
<td></td>
</tr>
</tbody>
</table>
## Baseline email notification descriptions (continued)

<table>
<thead>
<tr>
<th>Email notification</th>
<th>Description</th>
<th>Triggering event</th>
<th>Business Rule Controlling Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>A task has been closed or deleted. This notification removes the task reminder from Outlook. The email is in the format of iCalendar formatted email.</td>
<td>reminder.notify.email</td>
<td>sc_request.events</td>
<td></td>
</tr>
<tr>
<td>Reminder Insert Email</td>
<td>Type: EMAIL Sends the recipient a reminder email about a specific task.</td>
<td>sc_request.approved</td>
<td>sc_request.events</td>
</tr>
<tr>
<td>Request Approved</td>
<td>Type: EMAIL A Service Catalog request, opened by the recipient, has been approved.</td>
<td>sc_request.approved</td>
<td>sc_request.events</td>
</tr>
<tr>
<td>Request Assigned</td>
<td>Type: EMAIL A Service Catalog request has been assigned to the recipient.</td>
<td>sc_request.assigned</td>
<td>sc_request.events</td>
</tr>
<tr>
<td>Request Completed</td>
<td>Type: EMAIL A Service Catalog request, opened by the recipient, has been completed.</td>
<td>sc_request.updated</td>
<td>sc_request.events</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4968
<table>
<thead>
<tr>
<th>Email notification</th>
<th>Description</th>
<th>Triggering event</th>
<th>Business Rule Controlling Event</th>
</tr>
</thead>
</table>
| Request Item Assigned        | Type: EMAIL  
An item requested from the Service Catalog has been assigned to you. | sc_req_item.assigned              | sc_request events               |
| Request Item Delivery        | Type: EMAIL  
An item requested from the Service Catalog by the recipient is being delivered. | sc_req_item.delivery              | sc_request events               |
| Request Opened on Behalf     | Type: EMAIL  
A Service Catalog request has been opened on behalf of the recipient. | sc_request.requested_for          | sc_request events               |
| Reset Password               | Type: EMAIL  
The recipient’s password has been reset as requested. | reset.password                    |                                 |
| Scheduled Import Completed   | Type: EMAIL  
A scheduled import set has completed. | scheduled_import_set.completed    |                                 |
| System Upgraded              | Type: EMAIL  
System upgraded. | system.upgraded                   |                                 |
Baseline email notification descriptions (continued)

<table>
<thead>
<tr>
<th>Email notification</th>
<th>Description</th>
<th>Triggering event</th>
<th>Business Rule Controlling Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>The recipient’s system has been upgraded.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task approved</td>
<td>Type: EMAIL An ITIL task has been approved.</td>
<td>task.approved</td>
<td>Change events and task events</td>
</tr>
<tr>
<td>Text Index Completed</td>
<td>Type: EMAIL A scheduled system index has completed.</td>
<td>text_index.complete</td>
<td></td>
</tr>
<tr>
<td>Unscheduled Change</td>
<td>Type: EMAIL A named configuration item has changed, and no active change request exists.</td>
<td>cmdb.unscheduled.change</td>
<td></td>
</tr>
</tbody>
</table>

Notification example: notify an assignment group of updates to Priority 1 Incidents

Notify users by email when there are updates to high priority incidents.

Before you begin
Role required: admin

About this task
Send emails to an assignment group whenever there are updates to an incident in which the Priority is 1 - Critical. Include information that is of interest to the recipients, such as the incident number, category, assignees, and any comments that were added to the incident.
Procedure

1. Navigate to System Notification > Email > Notifications, and then click New.
2. On the email notification form, enter the following values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Priority 1 Incident Updated</td>
</tr>
<tr>
<td>Table</td>
<td>Incident [incident]</td>
</tr>
<tr>
<td>Active</td>
<td>Selected</td>
</tr>
<tr>
<td>Category</td>
<td>Incident Alert</td>
</tr>
<tr>
<td>Send when</td>
<td>Record inserted or updated</td>
</tr>
<tr>
<td>Inserted</td>
<td>Selected</td>
</tr>
<tr>
<td>Updated</td>
<td>Selected</td>
</tr>
<tr>
<td>Conditions</td>
<td>[Priority][is][1 - Critical] AND [Updated][changes]</td>
</tr>
<tr>
<td>Users/Groups in fields</td>
<td>Assignment group</td>
</tr>
<tr>
<td>Subject</td>
<td>Priority ${priority} Incident updated</td>
</tr>
</tbody>
</table>

Note: In this notification, the variable ${priority} returns the value 1 - Critical.

3. In the Message HTML field, enter the following message and script:

```
Short Description: ${short_description}
Click here to view incident: ${URI}
Incident number: ${number}
Category: ${category}
Assigned to: ${assigned_to}
Assignment group: ${assignment_group}
<hr/>
Comments:
${comments}
```

4. From the form context menu, click Save.
5. Preview the email notification to ensure it includes all the needed information.
a. On the notifications form, click **Preview Notification**.

b. Note that the email includes the following information:
   • Short description
   • A link to the incident record
   • Incident number
   • Category
   • The name of the user to whom the incident is assigned
   • The group assigned to the incident
   • Comments from the incident record

6. Test that the email notification sends to an assignment group when its Priority 1 Incident is updated.
   a. Create a user who has an email address that you can monitor, and then create a group that includes the user that you created.
   b. Navigate to **Incident > Open**, and then open an incident in which the **Priority** is **1 - Critical**.
   c. In the **Assignment group** field, enter the group that you created.
   d. From the form context menu, click **Save**.
   e. Add comments to the form to update the incident, and then click **Update**.
   f. Check the email account of the user member in the assignment group.

**Notification example: notify task assignees**

Notify users who are assigned a Task [task] record.

**Before you begin**

Role required: admin

Set up your email as a test email address. Navigate to **System Properties > Email Properties**, and then enter your email address under **Send all email to this test email address**.

**Procedure**

1. Navigate to **System Notification > Email > Notifications**, and then click **New**.
2. On the form, enter the following values:
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Task Assigned</td>
</tr>
<tr>
<td>Table</td>
<td>Task [task]</td>
</tr>
<tr>
<td>Active</td>
<td>Selected</td>
</tr>
<tr>
<td>Category</td>
<td>Uncategorized</td>
</tr>
<tr>
<td>Send when</td>
<td>Record inserted or updated</td>
</tr>
<tr>
<td>Inserted</td>
<td>Selected</td>
</tr>
<tr>
<td>Updated</td>
<td>Selected</td>
</tr>
<tr>
<td>Conditions</td>
<td>[Assigned to][changes]</td>
</tr>
<tr>
<td>Users/Groups in fields</td>
<td>Assigned to</td>
</tr>
<tr>
<td>Subject</td>
<td>Task Assigned</td>
</tr>
</tbody>
</table>

3. In the **Message HTML** field, add a message to send to whomever the task is assigned to.

4. From the form context menu, click **Save**.

5. To see a mock version of the system email that you created, click **Preview Notification** on the notification form.

6. Test the notification sends to a task assignee.
   a. Assign some task records.
   b. Check your email for assignment notifications.

**Email templates**

Email templates enable administrators to create reusable content for the subject line and message body of email notifications.

Templates deliver consistent information on specific system activities and improve the efficiency of creating multiple email notifications for similar actions. If necessary, you can make minor changes on the fly to an email that uses a template by overriding the subject line and message body content in the notification form. A common practice is to define the message body in a template and create new subject lines for different types of recipients. There is no limit to the number of templates that you can create.
Email templates are created in rich HTML format, and administrators have the option of converting existing email templates to rich HTML (starting with the Eureka release). This format provides several advantages, including:

- Raw HTML content is converted into a WYSIWYG format.
- The content can be edited in a feature-rich HTML editor.
- Mail scripts are condensed into a single, easy-to-read line that can be reused in multiple email notifications.
- To prevent broken links, images linked using URLs relative to a particular instance are converted to absolute links.

Create an email template

You can create an email template with rich HTML formatting, rather than plain text.

Before you begin
Role required: admin

Procedure
1. Navigate to System Notifications > Email > Templates.
2. Click New.
3. Fill in the form fields (see table).
Email Template form with the HTML editor

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the template. For example, change.update.risk.</td>
</tr>
<tr>
<td>Application</td>
<td>The type of scoped application.</td>
</tr>
<tr>
<td>Email layout</td>
<td>If the message body for the template is to be formatted using a predefined email layout, select the layout.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the name of the table involved. For example, Change Request [change_request].</td>
</tr>
<tr>
<td>Subject</td>
<td>Enter a subject line that explains the purpose of the email. Select the appropriate variables for the subject line from the fields available on the selected table. Place the cursor where you want the variable to appear, and click the field name in the Select variables column. For example:</td>
</tr>
<tr>
<td></td>
<td><code>${sys_class_name} ${number} with ${risk} risk has been assigned to you.</code></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Message HTML**         | Enter the content of the email template message. You can use the HTML editor toolbar to format the HTML, and you can include variables from the **Select variables** column. Variables map to column names available from the notification table, its parent tables, and reference tables. Use variables to include values from a record in the table such as an incident short description or comments and work notes. **Notes:**  
  • When a template is applied to a notification, the contents of this field are used when you select **HTML and plain text** or **HTML** in the **Content Type** field in the Email Notification form.  
  • You cannot use HTML code to control the appearance of the contents in the `{comments}` variable.  
  • If you want to include a link to the record that triggered the notification, see **Enable links to records**. |
| **Message Text**         | Enter the notification message to send in plain text. **Note:** When a template is applied to a notification, the contents of this field are used when you select **HTML and plain text** or **Text** in the **Content Type** field in the Email Notification form.                                                                                                                      |
| **SMS alternate**        | Create a different message to be delivered to an SMS device. Enter a brief message, showing the most important information only. If this message field is blank, the contents of the **Message Text** field are used for the SMS message. **Note:** The message in this field is used when the message is sent to a device configured as SMS.                                           |

**Related information**

- Create an email layout

**Apply a template to an email notification**

After you create an email template, you can apply it to a notification.

**Before you begin**

Role required: admin
Procedure
1. Navigate to System Notification > Email > Notifications.
2. Open the email notification record that should use the template.
3. Navigate to the What it will contain section.
4. From the Email template field, select the appropriate template.
5. Click Update.

Convert an email template to rich HTML
If you have an email template created prior to the Eureka release, you can convert it to rich HTML.

Before you begin
Role required: admin

Procedure
1. Navigate to System Policy > Email > Templates.
2. Open the email template you want to convert.
3. Click Switch to Rich HTML Editor.

When content is converted, these changes are made to the content:
• **HTML Editor:** Any raw HTML in the *Message* field is rendered as WYSIWYG text in the *Message HTML* field. The content can be edited in a feature-rich HTML editor.

• **Simplified Mail Scripts:** Any mail scripts in the body are automatically saved to the Email Script [sys_script_email] table and are replaced in the notification body with an embedded script tag. This makes the template body easier to read and makes it easier to reuse scripts in multiple email templates.

4. Modify the message text, as needed, using the WYSIWYG editor or by editing the underlying HTML.

  🔄 **Note:** The letter "P" at the bottom of the screen shows the location of your cursor within the *Message* field. In this case, the cursor is in a line containing an `<HTML>` tag.

  🔄 **Note:** Email templates that are already formatted with rich HTML do not show the **Switch to Rich HTML Editor** button.

**Example:**

Whether you are working with templates converted from earlier versions or creating new templates in the rich HTML format, it is a good practice to write mail scripts in **System Notification > Email > Notification Email Scripts**. When the scripts are completed, a `${mail_script:script name}` embedded script tag should be added to the email template body. This makes it easy to use the same scripts in multiple email templates. All that needs to be copied and pasted from one template to the next is the embedded script tag.
If you manually enter a mail script in the body of a new or converted email notification or template, and then attempt to save the record, a message asks whether the mail script should be converted. Unconverted mail scripts often fail to run from inside the HTML editor. If you select Yes, the script is added to the Email Script [sys_script_email] table and is automatically replaced in the body with an embedded script tag.

You can view the mail scripts in their original form by opening the email template and clicking the Show Notification Scripts related link.

**Construct an email message with a template**

Email templates provide a list of the fields from database tables that are available for constructing an email message.

An email template can include a mailto automatic response link, which enables the email recipient to simply choose a link that sends a preformatted response back to the instance. An example is the email template used for notification that an approval is required. The following example shows the base email:

![Email notification with the template specified](image)

In this case, when a change request approval is requested, an update is made to the sysapproval_approval table. The "approval events" business rule is then executed, which creates the "approval.inserted" event. The "Approval
Request" email event is defined to process the approval.inserted event, and this email event is defined to use the following change.itil.approve.role email template. Notice that this template has two mailto: items specified. One for "mailto.approval" and one for "mailto.rejection." This email template builds an automatic response that lets the email receiver simply click a link in the email to either approve or reject the change request.

Here is what the change.itil.approve.role template looks like using the rich HTML editor:

The selection list on the right shows the available fields from the sysapproval_approver table.

Notice the change.itil.approve.role template also uses a predefined email layout (Unsubscribe and Preferences), which provides links for the recipient to unsubscribe from approval notifications and set notification preferences.

And here is the mailto.approval template:
**mailto approval template**

If you put text on the lines following the **Click here to approve ${sysapproval}** line, this text forms the actual body of the email.

The combination of templates used would generate an email similar to the following example:

**Template generated email message**

*Short Description:* Upgrade to a new version of Windows Office  
*Click here to view Approval Request:* [LINK]  
*Click here to view Change Request:* [LINK]  

*Priority:* 4 – Low  
*Category:* Software  
*Comments:*  
All matches for the sales department must be updated to the latest version of Windows Office  

*Click here to approve CHG30003*  
*Click here to reject CHG30003*

[Unsubscribe] | [Notification Preferences]

Notice that the email recipient can use the following links in the mail:

- A link to view all the details of the change request  
- A link to view the approval record  
- A link that generates an automatic email response to approve the change
• A link that generates an automatic email response to reject the change
• A link to unsubscribe from approval notifications and another link to set notification preferences

Related information

Email layouts

Add blank lines in an email template
You can easily add blank lines in an email template using HTML tags.

Judicious use of these HTML tags can make your email easier to read.

• You can use `<br/>` to insert a line break
• You can wrap paragraphs in `<p>` ... `</p>` tags to format your email nicely.

Calendar integration
With email notifications, you can use import export maps to leverage information about records and integrate with Outlook or another calendar.

For example, an email notification can create a calendar event based on the planned start and end dates of a change request. To enable integration with a calendar, the following iCalendar variables are available to be added to an email template message and reference the email template from the notification. The variables must be added to the **Message Text** field.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>${dtstart}</td>
<td>Start Date</td>
</tr>
<tr>
<td>${dtend}</td>
<td>End Date</td>
</tr>
<tr>
<td>${location}</td>
<td>Location</td>
</tr>
<tr>
<td>${alarm_time}</td>
<td>Alert or reminder time</td>
</tr>
</tbody>
</table>

By default, the instance computes the value of iCalendar variables using import and export maps for the Appointment [itil_appointment] and Change Request [change_request] tables. The instance also uses import and export maps for other tables, depending on which plugins you activate. For example, if you activate the Incident (com.snc.incident) plugin, the instance uses the import and export maps of the Incident [incident] table.
Each import export map can specify a different set of iCalendar fields. For example, the icalendar.change_request import export map only maps two iCalendar fields.

### iCalendar change request mappings

<table>
<thead>
<tr>
<th>Associated variable name</th>
<th>Field mapped</th>
<th>Field label</th>
</tr>
</thead>
<tbody>
<tr>
<td>start_date</td>
<td>start_date</td>
<td>Planned start date</td>
</tr>
<tr>
<td>end_date</td>
<td>end_date</td>
<td>Planned end date</td>
</tr>
</tbody>
</table>

The instance uses the **External Name** value as the variable name in the email template. For example, the icalendar.change_request import export map defines the *dtstart* and *dtend* variables.

### Map date fields to iCalendar variables

You can specify what fields provide the date information in calendar invitation notifications by changing the field mappings of the *dtstart* and *dtend* variables in the import export map for the iCalendar invitation.
Before you begin
Role required: admin

Procedure

1. In the navigation filter, enter `sys_impex_map.list`.
2. Open a map to edit.

3. In the Field Maps related list, click either the `end_date` or `start_date` mapped field to change the mapping for `dtstart` or `dtend`, as needed.
4. Change the **Database** field to the field you want to use to set the start date or end date.
5. Click **Update**.

Create iCalendar invitations for custom tables

To generate iCalendar invitations that use field values from custom tables, create an import export map that computes the values of the iCalendar fields.

Before you begin
Role required: admin

Procedure

1. Create the custom table and fields using the **Date/Time** field type for the fields that map to the `${dtstart}` and `${dtend}` variables.
2. In the navigation filter, enter `sys_impex_map.list`.
3. Click **New**.
4. Set the following fields:
   - **Name**: Use the following naming convention: `icalendar.<table name>`. For example, `icalendar.u_my_custom_table`.
   - **Table**: Select the custom table you created.
   - **Type**: Select `icalendar`.
5. Right-click the form header and select **Save**.
6. In the Field Maps related list, click **New**.
7. In the Mapping Entry Wizard, select **Mapping to a Database Field**.
8. Create field mappings for `dtstart` and `dtend`. These variables are required.
   For example, map the **External Name** `dtstart` to the `u_meeting_start_time` field in `u_my_custom_table`.
9. Click **Submit**.
10. Create field mappings for any other iCalendar fields as necessary.
11. Click **Update**.

Here are sample field mappings between iCalendar variables and custom fields in a custom table, `u_my_custom_table`:

### Sample field mappings

<table>
<thead>
<tr>
<th>External name</th>
<th>Database field</th>
<th>Type</th>
<th>Map</th>
</tr>
</thead>
<tbody>
<tr>
<td>dtstart</td>
<td><code>u_meeting_start_time</code> field</td>
<td>icalendar</td>
<td><code>u_my_custom_table</code></td>
</tr>
<tr>
<td>dtend</td>
<td><code>u_meeting_end_time</code> field</td>
<td>icalendar</td>
<td><code>u_my_custom_table</code></td>
</tr>
<tr>
<td>description</td>
<td><code>u_meeting_description</code> field</td>
<td>icalendar</td>
<td><code>u_my_custom_table</code></td>
</tr>
</tbody>
</table>

12. Create an email template that defines what to include in the iCalendar invitation.

   **a.** Set the **Table** field to the custom table you created.

   **b.** In the **Message** text field, use the following format to define the iCalendar invitation:

   ```
BEGIN:VCALENDAR
PRODID:-//Service-now.com//Outlook 11.0 MIMEDIR//EN
VERSION:2.0
METHOD:REQUEST
BEGIN:VEVENT
ATTENDEE;ROLE=REQ-PARTICIPANT;RSVP=TRUE:MAILTO:${to}
DTSTART:${dtstart}
DTEND:${dtend}
UID:${sys_id}
DTSTAMP:${dtstamp}
DESCRIPTION:${description}
SUMMARY:${u_meeting_summary}
END:VEVENT
```
**Note:** Mail script is not allowed or processed in meeting invitation email templates.

### iCalendar invitation template details

<table>
<thead>
<tr>
<th>iCalendar template line</th>
<th>Required?</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>BEGIN:VCALENDAR</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>PRODID:~-//Service-now.com//Outlook 11.0 MIMEDIR//EN</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>VERSION:2.0</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>METHOD:REQUEST</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>BEGIN:VEVENT</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>ATTENDEE;ROLE=REQ-PARTICIPANT;RSVP=TRUE:MAILTO: ${to}</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>DTSTART: ${dtstart}</td>
<td>Yes</td>
<td>You must use the import export map to map dtstart to a start time field on the custom table.</td>
</tr>
<tr>
<td>DTEND: ${dtend}</td>
<td>Yes</td>
<td>You must use the import export map to map dtend to an end time field on the custom table.</td>
</tr>
<tr>
<td>UID: ${sys_id}</td>
<td>Yes</td>
<td>You must provide the name of a field that uniquely identifies the record, such as the sys_id or the record number field.</td>
</tr>
<tr>
<td>DTSTAMP: ${dtstamp}</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>DESCRIPTION: ${description}</td>
<td>No</td>
<td>To include a multiple line description, you must use the import export map to map description to a text field on the custom table. The field mapping ensures that the</td>
</tr>
<tr>
<td>iCalendar template line</td>
<td>Required?</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>system encodes line breaks correctly for the iCalendar file format.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUMMARY: ${u_meeting_summary}</td>
<td>No</td>
<td>To include a summary from a text field on the custom table, provide the name of the field, such as u_meeting_summary. The summary field value must not contain line breaks. You do not need to create a field mapping.</td>
</tr>
<tr>
<td>END:VEVENT</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>END:VCALENDAR</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

13. Create an email notification to trigger the iCalendar invitation and ensure the following fields are set accordingly:

- **Table**: Select the custom table.
- **Type**: Select *Meeting Invitation*.
- **Content type**: Select *Plain text* only.
- **Email template**: Select the template you created.

**Email layouts**

Create reusable content for the message body of email templates.

**Email layout overview**
Administrators can use email layouts to:

- Ensure all email notifications have a consistent layout such as always displaying a header, body, and footer.
- Display static content on all email notifications such as a company logo or a background.
- Declare inline styles available for use in the message body of an email template such as setting a text font, size, and color.
- Provide users with links to common response actions such as unsubscribe from a notification or manage notification preferences.

⚠️ **Note:** To display dynamic content such as mail scripts, use email templates. For more information, see Create an email template.

Email layouts insert HTML elements into the message body of email templates. Any style elements you define in the email layout are available to the email template. Email layouts support style sheets in these formats.

- Internal style sheets defined within a `<style>` element.
- Inline styles within a `style` attribute.

By default, the system includes several sample layouts administrators can use to create their own layouts. Administrators can create email layouts using an inline HTML editor or manually entering HTML code. The system stores email layout records in the Email Layout [sys_email_layout] table.

⚠️ **Note:** If there is no content in the notification from either the notification record or the template, the layout won’t be applied.

Create an email layout

Create an email layout to specify the HTML content you want to appear in the body of one or more email templates.

**Before you begin**

- Role required: admin
- Record required: email template record

**Procedure**

1. Navigate to **System Policy > Email > Layouts**.
   The system displays the list of existing email layouts.

2. Click **New**.
The system displays a blank email layout form.

3. Fill in the form.

### Email layout fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specify a unique name for the record.</td>
</tr>
<tr>
<td>Application</td>
<td>Lists the parent application to which this record belongs.</td>
</tr>
<tr>
<td>Description</td>
<td>Specify an optional description of the layout.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select whether to display the Advanced Layout field.</td>
</tr>
<tr>
<td>Layout</td>
<td>Use the inline editor to add HTML elements. The system displays HTML from</td>
</tr>
<tr>
<td></td>
<td>this field in the body of any email template that uses the layout. Include</td>
</tr>
<tr>
<td></td>
<td>notification variables to show content from the related record. For more</td>
</tr>
<tr>
<td></td>
<td>information notification variables see Notification variables.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The editor automatically formats any HTML code you enter from the</td>
</tr>
<tr>
<td></td>
<td>Source code view.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Use this field to manually enter HTML code. The system displays HTML from</td>
</tr>
<tr>
<td>Layout</td>
<td>this field in the body of any email template that uses the layout.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To enter text in this field, select Click here to disable</td>
</tr>
<tr>
<td></td>
<td>syntax highlighting and script formatting.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
   The system creates the email layout record.

5. Navigate to **System Policy > Email > Templates**.
   The system displays the list of existing email templates.

6. Select the email template which you want to use an email layout.
   The system displays the email template record.

7. In **Email layout**, select the email layout you want to use to format the body of email messages.

8. Click **Update**.
   The email template uses the selected email layout to format the body of email messages.
Email retention

You can archive and eventually destroy email messages that you no longer need or if your Email table is excessively large.

Email retention is available starting with the Helsinki release.

Email archive and destruction plugins

The email archiving and destruction feature uses the Data Archiving and Email Retention plugins. The Data Archiving plugin must be active to archive and destroy email records. The Email Retention plugin provides a set of rules that specify when the system archives and destroys email records.

Note: The Email Retention plugin also prevents the system from deleting watermarks, which are required for inbound email actions to continue to function.

The Email Retention plugin and associated archive and destroy rules are active by default on new instances. On upgraded instances, you must manually activate both the plugin and the archive and destroy rules. ServiceNow recommends that you review and approve these rules before activating them.

If your instance already has a process to manage email records, you do not need to activate the Email Retention plugin. If you want to replace your current process with Email Retention, be sure to deactivate the current process before activating the archive and destroy rules.

Archiving and destroying email records

Archiving means moving records from the Email [sys_email] table to the Archive Email [ar_sys_email] table when they exceed the archive rule time limit. Destroying means deleting records in the Archive Email table when they exceed the destroy rule time limit.

Note: When a destroy rule deletes email records, associated watermarks are not deleted. They are preserved to ensure that your inbound email actions continue to function.

Default archive and destroy rules

Email Retention provides these email archive rules:

- **Emails - Ignored and over 90 days old**: archives email message records that were created more than 90 days prior to the current date and are of type received-ignored or sent-ignored.

- **Emails - Over a year old**: archives email message records that were created more than 365 days prior to the current date.
Email Retention also provides this email destroy rule:

- **Email Archive - Over a year old**: destroys email records that have been archived for more than 365 days prior to the current date.

With these default settings, your email messages are kept on the instance for a total of two years: one year in the Email table, and one year in the Email archive table. At the end of this period, the system deletes the expired email records from the Email archive table.

⚠️ **Note**: By default these rules are active on new instances and inactive on upgrades. The system runs archive and destroy rules when you activate them.

### Compatibility with other record management implementations

If you are already using another method to manage email records, such as table cleaners, you do not have to use the Email Retention feature. To prevent unexpected record deletion, ServiceNow recommends that you avoid using multiple email management processes on the same instance at the same time.

⚠️ **Note**: For assistance replacing your existing record management implementation with Email Retention, contact your professional services or sales representative.

### Effects of archiving and deleting email records

Inbound email actions copy the body of an email to the work notes of the related record. If the inbound email record is later deleted, the work notes still contain a text copy of the email.

When the system sends an email message about a record, the activity formatter displays a **Sent Email** section with a link to the email message. If the system archives the email message, the activity formatter removes **Sent Email** section. When the system deletes the email message, it is no longer visible in the activity formatter nor the work notes.

⚠️ **Note**: Set the archive time length long enough so your users can access sent emails though the activity formatter.

Archiving email records changes the methods available to the system to identify inbound email as a reply. After archiving an email record, the system can no longer use the **In-Reply-To** field to match an incoming email to an email record. However, the system can still match incoming email to an existing record from a record number or watermark.
Activate the Email Retention plugin

The Email Retention plugin provides archive and destruction rules for email messages. It is active by default for new instances, but must be activated for upgrades.

About this task

Required role: admin
The Email Retention plugin requires these plugins:

• Data Archiving
• System Mailboxes

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   ✟ Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Archive email manually

You can archive email messages manually on demand instead of waiting for the instance to archive them based on a scheduled job.

Before you begin

Role required: admin

About this task

Email Retention provides these email archive rules:

• Emails - Ignored and over 90 days old: archives email message records that were created more than 90 days prior to the current date and are of type received-ignored or sent-ignored.
• Emails - Over a year old: archives email message records that were created more than 365 days prior to the current date.
You can manually archive email messages that meet these archive rules or any additional archive rules that you create.

ℹ️ Note: An archive record must be active for the instance to be able to process records with it.

Procedure
1. Navigate to System Archiving > Archive Rules.
2. Open the email archiving rule that you want to modify.
3. Click Recalculate Estimate to see how many records in the Email [sys_email] table are going to be archived. The estimate appears in the Record estimate field.
4. Click Run Archive Now.

ℹ️ Note: You can also archive related records.

Watermarks on notification emails
By default, the system generates a watermark label at the bottom of each notification email to allow matching incoming email to existing records. Each watermark includes a random 20-character string that makes it unique.

Starting with the Jakarta release, the system automatically generates randomized watermarks for notification emails in base systems. The random 20-character string reduces the possibility of a watermark being guessed or coincidentally matching the watermark of an email from another instance.

ℹ️ Note: If you are upgrading from a release before Jakarta, random watermark support is optional and requires the Random Watermark Support plugin to be activated.

Watermark format
The email watermark always begins with "Ref:" to identify the label as a watermark. After this identifier, the default label is 31 characters in length and consists of:

- Customizable prefix — The default prefix is MSG.
- Auto-numbered identifier — The numeric string identifying the source record, such as incident, problem, or change request.
- An underscore character followed by a random 20-character string
When inbound emails are processed, the system matches random watermarks to the appropriate source records.

**Watermark configuration**

Watermarks are always generated, but you can configure them to:

- Create a custom watermark prefix for each instance to prevent accidentally triggering events in the wrong instance.
- Have custom prefix characters after MSG
- Be hidden globally
- Be omitted from individual email messages

If watermarks are omitted from email notifications, inbound email actions might not work properly. Without a watermark, the system processes inbound email messages as described in **Criteria for matching email to inbound actions**.

⚠️ **Note**: Email clients that use the plain text version of the email still show the watermark.

**Create a custom watermark prefix for email notifications**

By default, email notifications use the watermark prefix **MSG**, but you can create a custom watermark prefix.

**Before you begin**

Role required: admin
About this task
Any email notifications that are forwarded from one instance to another might be more easily distinguished with different prefixes for each instance. To avoid unintentionally triggering events in the wrong instance, create a unique watermark prefix for each instance.

⚠️ Note: Do not use colons (:) in custom watermark prefixes. Colons are a reserved character and may cause the watermark to be ignored.

Procedure
1. Navigate to System Definition > Number Maintenance.
2. Open the MSG record in the Email Watermark [sys_watermark] table.
3. Enter the unique Prefix for this instance.
4. Click Update.

Results
Your custom watermark applies to all new email notifications. Email notifications that existed before you created a custom watermark keep the same watermarks as before.

Omit an email notification watermark
You can omit watermarks on email notifications if you do not want the instance to match the notification to an existing record.

Before you begin
Role required: admin
Procedure
1. Navigate to System Notification > Email > Notifications.
2. Select the email notification to update.
3. Click the Advanced View related link.
4. In the What it will contain section, select the Omit watermark check box.

What to do next
When incoming email does not contain a watermark, the system searches the subject line and message body for a record number. The system attempts to match any record number that it finds to an existing record. If there is a matching record number, the system updates the record with the values in the incoming email. To ensure that response email messages don't update records, remove the record number variable $\{number\}$ from the Subject and Message HTML fields.

Hide email watermarks globally
Rather than omitting watermarks, it is possible to hide watermarks on a global basis using HTML markup.

Before you begin
Role required: admin

About this task
Watermarks can only be hidden in the HTML message. The text version of the message, because it does not have markup allowing show/hide semantics, will always have the watermark.

Procedure
1. Navigate to sys_properties.list in the Application Navigator.
2. Create a new property named glide.email.watermark.visible and set it to false.
   This ensures that all watermarks are hidden on all email messages. This cannot be done on a per-email basis.

Email digests
An email digest is a single email that summarizes the activity for a selected notification and its target record during a specified time interval. You can
enable an email digest to reduce the number of notifications received when frequent updates to the associated record occur within a short time period.

Example email digest

```
Your incident INC0010015 has comments added - Digest

Service Management <it@example.com>
Monday, August 28, 2017 at 2:31 PM
To: fred.luddy@example.com

A copy of this message is on the server.

Summary of comments

Incident commented: Added clarification

Incident commented: More information on issue

Incident commented: Follow up scheduled

Unsubscribe

Ref: MSG0000320_ChV7spJr41TzAA8TNvnm6
```

⚠ Note: Email digests apply to email notifications only and are not supported for SMS messages, push notifications, and activity streams.

How email digests work

In new and upgraded instances, the Email digest (com.glide.email_digest) plugin is activated by default. Your instance must use the UI16 interface, since the email digest feature involves setting user notification preferences in the System Settings window.

Admins determine which notifications can be delivered in an email digest and configure the digest content for those notifications. Admins can also control the intervals for digests. An interval is the length of time that notifications are collected for the digest, such as daily or hourly.

Users enable the digest and select the digest interval for a specific notification in their notification preferences. The system accumulates the notifications that
normally would be sent during the specified interval and summarizes them in the email digest.

When processing an email digest, the system:

• Stores the digest configuration for the notification in the Notifications [sysevent_email_action] table.

• Temporarily stores the notification content accumulated for a user in the Email Digest Parts [sys_email_digest_part] table and the Email Digest Part Users [sys_email_digest_part_user] table.

• Runs an email digest job every 15 minutes to check when a digest is ready to be sent to a user.

The system uses the digest interval to determine when the digest is ready to be sent. The digest interval begins when the first notification is triggered for the user and stops at the end of the interval time.

• Sends the email digest to the user soon after the selected digest interval ends.

For example, if a user selects an hourly digest interval and the first notification is triggered at 08:15, the interval starts at 08:15. When the digest interval ends, the system generates the email digest approximately one hour later, at about 09:15 or shortly after, depending on when the email digest job ran.

Set up email digests

What to do — admins

1. Review the base system digest intervals and if needed, create or modify intervals.

   The base system digest intervals are one day (24 hours), one hour, every four hours, and seven days (weekly).

2. Determine the email notifications that can be delivered in a digest and configure the email digest content for those notifications.

   When determining which notifications are appropriate for an email digest, consider the notification content and intervals that your users can select. For example, digests that can be generated weekly might be better suited for notifications that are non-urgent.

What to do — all users

For a notification that can be delivered in an email digest, enable the email digest in your notification preferences (Notifications tab in
the System Settings window). You also specify the interval time that the notifications are accumulated.

**Next step**

If you are an admin, begin the digest setup process by reviewing the base system email digest intervals and create or modify the intervals.

**Create or modify email digest intervals**

Admins can create or modify the email digest intervals (length of time) during which activity for a selected notification is accumulated in an email digest. Users select a digest interval when they enable an email digest in their notification preferences.

**Before you begin**

Role required: admin

**About this task**

Before adding an email digest interval, review the base system digest intervals in the Digest Intervals [sys_email_digest_interval] table. You can modify intervals, including the base system intervals, which are one day (24 hours), one hour, every four hours, and seven days (weekly).

**Procedure**

1. Navigate to **System Notification > Email > Digest Intervals**.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To add an interval</td>
<td>Click <strong>New</strong>.</td>
</tr>
<tr>
<td>To modify an interval</td>
<td>Select the interval to be changed.</td>
</tr>
</tbody>
</table>

2. Enter the new or changed interval information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Interval name that describes the interval length of time, for example: Every 2 hours.</td>
</tr>
<tr>
<td>Interval</td>
<td>Length of the interval, either number of <strong>Days</strong> or <strong>Hours</strong> (hours, minutes, and seconds). The minimum time</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>length allowed is one hour, and the maximum time length allowed is seven days (one week).</td>
</tr>
</tbody>
</table>

3. If you created an interval, click **Submit**. Or, if you changed an interval, click **Update**. The system updates the Digest Intervals [sys_email_digest_interval] table with the new or modified interval. The digest interval is listed as an option in the notification preferences (**Notifications** tab in the System Settings window) when a user enables a digest for the notification. For example:

![](image)

4. To delete an interval, select the interval to be deleted in the Digest Intervals [sys_email_digest_interval] table and click **Delete**.

⚠️ **Note:** If the interval is in use, the system does not remove the interval.

**What to do next**
Determine the email notifications that can be delivered in a digest and configure the email digest content for those notifications.

**Related information**
Email digest properties
Configure email digests

Use the Notification form to create or modify the content of an email digest for a notification. You can also disable the email digest for a notification so that it is not available in the notification preferences of your users.

Before you begin
Role required: admin

About this task
When you create or update a notification, use the What Digest will contain tab of the Notification form to configure the email digest for the notification. After you define the digest content, the digest option for the notification is available in the notification settings of your users.

Procedure
1. Navigate to System Notification > Email > Notifications.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you are creating a notification</td>
<td>Click New to open the Notification form.</td>
</tr>
<tr>
<td>If you are modifying a notification</td>
<td>Select the notification to be changed.</td>
</tr>
</tbody>
</table>

2. In the Notification form, select the Allow Digest check box to display the What Digest will contain tab and define the digest content.
3. Complete the fields in the **What Digest will contain** tab. The example shows the default view of the tab. The advanced view contains additional fields (see table).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digest Template</td>
<td>If you want to reuse existing content, such as headers or footers, select an email template to add content to the email digest.</td>
</tr>
<tr>
<td>Digest Subject</td>
<td>Enter the subject line for the email digest. The subject can include variables from the <strong>Select variables</strong> column. If empty, the system uses the Subject value from the Email template. If you enter a value in this field, it overrides the template value.</td>
</tr>
<tr>
<td>Digest HTML</td>
<td>Enter the recurring content for the email digest. The digest content can include variables from the <strong>Select variables</strong> column.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Variables</td>
<td>Variables map to column names available from the notification table, its parent tables, and reference tables. Use variables to include values from a record in the table such as an incident short description or comments and work notes. To prevent adding extra <code>&lt;p&gt;</code> and <code>&lt;div&gt;</code> elements to your email digest, see the blog post Extra line spacing with paragraph tags in email client by a ServiceNow employee in the Now Community.</td>
</tr>
<tr>
<td>Digest Separator (HTML)</td>
<td>Use the line to separate each item summarized in the digest.</td>
</tr>
<tr>
<td>Digest From</td>
<td>Enter the email address to be used in the From field of the email digest. For example, <a href="mailto:helpdesk@yourcompany.com">helpdesk@yourcompany.com</a>. The email address must be in a valid format, otherwise a notification message appears near the field. Changing this address requires an advanced email setup such as enabling email forwarding.</td>
</tr>
<tr>
<td>Digest Reply To</td>
<td>Enter the email address that you want people to use when replying to the email digest. For example, <a href="mailto:helpdesk@yourcompany.com">helpdesk@yourcompany.com</a>. The email must be in a valid format, otherwise a notification message appears near the field. Changing this address requires an advanced email setup such as enabling email forwarding.</td>
</tr>
<tr>
<td>Digest Text</td>
<td>Enter the recurring content of the email digest to send in plain text. This field appears when you set the content type to HTML and plain text or Plain text only.</td>
</tr>
<tr>
<td>Digest Separator (text)</td>
<td>[Optional] Use the dash character as a line to separate each item summarized in the digest. This field appears when you set the content type to HTML and plain text or Plain text only.</td>
</tr>
</tbody>
</table>

4. When you finish creating the notification, click Submit. Or, if you are done modifying the notification, click Update. The email Digest option is displayed in the notification settings of your users.
**Note:** The email recipients identified in the **Who will receive** tab will receive the digest after they **enable the digest** in their notification preferences. If the user is not a designated recipient for the notification, a digest is not generated even though the user may have the digest enabled for a notification. In this case, the user receives the actual notifications when they are generated.

5. [Optional]. To disable the email digest for a notification, unselect the **Allow Digest** check box and click **Update** when you finish your changes to the notification. When you disable the digest content, the digest option is also no longer available for the notification and is not listed in the notification preferences for your users. If a user previously enabled the digest option for the notification, the system stops collecting those notifications for a digest and does not generate the digest.

**Note:** If you disabled the digest and want to make the digest available again, select the **Allow Digest** check box. The system retains the previously saved digest content and displays it in the **What Digest will contain** tab.

**Related information**

- Email digests
- Create or modify email digest intervals
- Enable an email digest

**Enable an email digest**

In your notification preferences, you can enable an email digest that summarizes the activity for a selected notification during a specified time interval. The digest is a single email that you receive instead of the individual notifications generated during the specified interval.

**Before you begin**

Role required: none

**About this task**

The email digest option is available for a notification (in your notification preferences) only when your admin has configured the email digest content for that notification.

Consider enabling an email digest to reduce the number of emails you would normally receive when the target record for a notification is frequently updated within a short time period.
Procedure

1. Click the gear icon (⚙️) in the banner frame to open the System Settings window, and click the Notifications tab.

2. Select the notification:
   a. In the Notifications By Category section, click the row or right arrow (>) of the category that you want to view.
   b. In the list of notifications for the category, click the row or right arrow (>) next to the notification that you want to edit.

3. To enable or disable an email digest for the notification, if an email digest is available:
   a. Click the Email Digest switch.
      The email digest is enabled when the switch is green and disabled when the switch is grey.
   b. If you enabled the digest, select the Interval (length of time) during which the notifications are accumulated.

   ![System Settings Tree](image)

   The digest interval begins with the first occurrence of notification activity. For example, if you select the daily (1 Day) interval and the first notification occurs at 07:00, the system begins accumulating notifications at 07:00 and stops at 07:00 the next day.

   Soon after the interval ends, the system sends the email digest to you instead of sending the individual notifications generated during the digest interval.
If you disabled the digest, the system immediately stops accumulating the notifications for the digest and does not send the email digest. The system resumes sending the notifications as they are generated.

Related information
- Apply notification conditions
- Email digests

Domain separation and Notifications
Domain separation is supported in the Notifications application. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Standard
- Includes Basic level support.
- Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see Application support for domain separation.

Overview
Domain separation is specifically supported in Notifications but not in email accounts. Notifications are not data-separated but they are process-separated. Notifications are also triggered by specific actions.

How domain separation works in Notifications
There are two basic components of domain separation and Notifications.
- Notifications are process-separated (not data-separated).
- Notifications are triggered in two main ways:
1. When a record is Inserted or Updated
   a. Notifications with matching conditions AND in the same domain as the
      inserted/updated record are processed.

2. When an event defined in the notification is triggered
   a. Events typically have a target record. For example, [incident.inserted]
      event references the incident record being inserted.
   b. When an event is fired, notifications configured for that event in the same
      domain as the event’s target record are processed.

Domains and email accounts

Domain separation is not supported in email accounts for these reasons:

1. Sending mail: There is only one SMTP sender per account. This prohibits
   providing domains for each account, and they are not configurable.

2. For receiving Inbound mail: You can set up multiple email accounts but
   cannot meaningfully set the domain of an inbound email action. Inbound
   Actions are processed in the domain of the user who sent the email. For
   example: User_A in Domain A sends an email to a ServiceNow email account
   which executes the “Create an incident” inbound email action. The resulting
   new incident created by the inbound action is in Domain A.

To learn more see Inbound email actions.

⚠️ Note: If the number of email accounts exceeds 20, reception of email
slows down.

Use case

• If an instance is using the Domain separation plugin and a new email
  notification is defined for a domain that has the same event as the notification
  on the global domain, the user receives two emails for the same event.

  Solution: Set the [sys_overrides] field on the notification that belongs to
  the domain so it overrides the setting on global. For more information, see
  Delegated administration.

Related information

Domain separation for service providers
Troubleshooting notification emails

Logs and diagnostics are provided to help determine whether notification emails are being sent and received successfully, what any issues are, and who receives the email.

Diagnostics help monitor the overall health of the system and troubleshoot general problems, such as not receiving any incoming mail. Logs help identify problems with individual emails, and different logs are useful for diagnosing different types of problems.

Log checking scenarios

<table>
<thead>
<tr>
<th>Problem</th>
<th>Log</th>
</tr>
</thead>
<tbody>
<tr>
<td>Need to check whether an individual notification email was successfully sent</td>
<td>Check the <strong>Sent</strong> System Mailbox for that email. Also check the <strong>Failed</strong> System Mailbox for failure notifications.</td>
</tr>
<tr>
<td>Individual email failed</td>
<td>• Check the message log of the individual email.</td>
</tr>
<tr>
<td></td>
<td>• Check the <strong>Error string</strong> field of the email record.</td>
</tr>
<tr>
<td>Email not received by end user</td>
<td>• Check the <strong>Junk</strong> System Mailbox for notifications about returned emails. These emails also appear in the Emails log with a <strong>Type</strong> of received-ignored.</td>
</tr>
<tr>
<td></td>
<td>• Check the <strong>Error string</strong> field of the email record.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning:</strong> Some email servers do not return error strings</td>
</tr>
<tr>
<td></td>
<td>• Check the message log of the individual email for the reasons different recipients were included or excluded.</td>
</tr>
</tbody>
</table>
Troubleshooting resources

See the following resources on troubleshooting inbound and outbound email problems.

<table>
<thead>
<tr>
<th>Error or symptom</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance not receiving inbound email</td>
<td>See Inbound Email Troubleshooting, ServiceNow KB0524472. This KB article also provides links to a video series on troubleshooting inbound emails.</td>
</tr>
<tr>
<td>Instance not sending outbound email</td>
<td>See Troubleshooting Outbound Email, ServiceNow KB0521382. This KB article also provides links to a video series on troubleshooting outbound emails.</td>
</tr>
<tr>
<td>Email from Outlook produces an empty Incident record containing an attachment named winmail.dat.</td>
<td>Configure the local Outlook client or Exchange server to not send Rich Text formatted (RTF) data to the instance.</td>
</tr>
</tbody>
</table>

Email diagnostics

The Diagnostics and Connection page provides information on the current state of your email configuration. This page includes status on email properties, scheduled jobs, and email account connections that affect how your instance receives and sends email.

Email diagnostic information can help you identify problems with inbound or outbound email. The following video shows different steps to determine why your instance is not receiving inbound emails. One of the steps uses email diagnostics to check the email connection status and email reader scheduled job.

Troubleshooting steps to take when a ServiceNow instance does not receive email

Navigate to the Diagnostics and Connection page from either of these modules:

- **System Mailboxes > Email Diagnostics**
- **System Diagnostics > Email Diagnostics**
Email Diagnostics and Connection page

For quick status on a field, point to the green check mark or red X icon. The check mark icon indicates that the item is operational or healthy, while the X icon indicates that the item is not operational or within the expected range.

### Mail diagnostics

<table>
<thead>
<tr>
<th>Diagnostic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Sending is [Status]</td>
<td>Status of outbound email as either <strong>Enabled</strong> or <strong>Disabled</strong>. To change the status, click the <strong>Modify Email Sending/Receiving</strong> related link, and in the Email Properties form, update the <strong>Email sending enabled</strong> property.</td>
</tr>
<tr>
<td>Email Sending</td>
<td></td>
</tr>
<tr>
<td>Email in Queue</td>
<td>Number of email messages that are ready to be sent.</td>
</tr>
<tr>
<td>Last Sent Mail</td>
<td>Date and time the last email message was sent.</td>
</tr>
<tr>
<td>Diagnostic</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SMTP Sender State</td>
<td>Current state of the SMTP Sender job, which sends email on a recurring schedule. By default, this job runs every minute.</td>
</tr>
<tr>
<td></td>
<td>To update the SMTP Sender state, click the <strong>SMTP Sender Job</strong> related link, and in the Schedule table, open the SMTP Sender record to be changed.</td>
</tr>
<tr>
<td>SMTP Processing Time</td>
<td>Duration of the last SMTP Sender job run. This value should be shorter than the SMTP Sender interval.</td>
</tr>
<tr>
<td>SMTP Job Last Run</td>
<td>Date and time when the SMTP Sender job last ran.</td>
</tr>
<tr>
<td>Default SMTP Status</td>
<td>Indication of whether the SMTP connection was successful, shown only if the email accounts feature is active.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Default SMTP</strong> to change your SMTP account settings.</td>
</tr>
<tr>
<td>SMS Sender State</td>
<td>Current state of the <strong>SMS Sender</strong> job, which sends SMS notifications on a recurring schedule. By default, this job runs every minute.</td>
</tr>
<tr>
<td></td>
<td>To update the SMS Sender job, click the <strong>SMS Sender Job</strong> related link, and in the Schedule table, open the SMS sender record to be changed.</td>
</tr>
<tr>
<td>SMS Sender Processing Time</td>
<td>Duration of the last <strong>SMS Sender</strong> job run. This value should be shorter than the <strong>SMS Sender</strong> interval.</td>
</tr>
<tr>
<td>SMS Sender Job Last Run</td>
<td>Date and time when the <strong>SMS Sender</strong> job last ran.</td>
</tr>
<tr>
<td>Email Receiving is [Status]</td>
<td></td>
</tr>
<tr>
<td>Email Receiving</td>
<td>Status of inbound email as either <strong>Enabled</strong> or <strong>Disabled</strong>.</td>
</tr>
<tr>
<td></td>
<td>To change the status for email receiving, click the <strong>Modify Email Sending/Receiving</strong> related link, and in the Email Properties form,</td>
</tr>
<tr>
<td></td>
<td>update the <strong>Email receiving enabled</strong> property.</td>
</tr>
</tbody>
</table>
### Mail diagnostics (continued)

<table>
<thead>
<tr>
<th>Diagnostic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Received Email</td>
<td>Date and time the last email message was received.</td>
</tr>
<tr>
<td>Email Reader Status</td>
<td>Current state of the email reader job, which downloads any email waiting on the mail server and creates email.read events.</td>
</tr>
<tr>
<td></td>
<td>To update the Email Reader Status job, click the Email Reader Job related link, and in the Schedule table, open the email reader record to be changed.</td>
</tr>
<tr>
<td>Email Reader Processing Time</td>
<td>Duration of the last reader job run. This value should be shorter than the reader interval.</td>
</tr>
<tr>
<td>Job Last Run</td>
<td>Date and time when the reader job last ran.</td>
</tr>
</tbody>
</table>

**Connection Status**

| {Accounts}              | The result of the test connection to the accounts. The connection is tested every time you load the page.                                                                                                   |

### Related information

**Scheduled jobs**

### System email log and mailboxes

The system email log records all emails that the instance creates or receives. System mailboxes are filtered views of this log.

Every notification email that the instance creates or receives is recorded in an Email [sys_email] record. You can navigate to a log of these records at **System Logs > Emails**.

The System Mailboxes are filtered views of the Emails [sys_email] table. The instance assigns an email record to a system mailbox depending on the values of the **Type** and **State** fields. For more information, see **System mailboxes**.

The following fields can be included in the layout of the system log and any of the system mailboxes:
### Email log

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mailbox</td>
<td>The system mailbox that lists this email record. The instance sets the value of this field according to the values of the <strong>Type</strong> and <strong>State</strong> fields.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the email (Error, Ignored, Processed, or Ready).</td>
</tr>
<tr>
<td>Receive type</td>
<td>The type of inbound email (None, Forward, New, or Reply).</td>
</tr>
<tr>
<td>Type</td>
<td>The status of the email. Choices are:</td>
</tr>
<tr>
<td></td>
<td>• received: The server received this email.</td>
</tr>
<tr>
<td></td>
<td>• received - ignored: The server received this email, but it was ignored by the instance for inbound email action purposes. Typically, these emails are either spam or auto-replies. See the Error String field for details.</td>
</tr>
<tr>
<td></td>
<td>• send - failed: The server has attempted to send the email and failed. See the Error String field for details.</td>
</tr>
<tr>
<td></td>
<td>• send - ignored: The server skipped sending this email. Typically, this is for an email which was generated but lacked a recipient email address or is a duplicate email. See the Error String field for details.</td>
</tr>
<tr>
<td></td>
<td>• send - ready: The email is ready to be sent, but has not been sent out by the mail server. Typically, an email remains in this state for only a short time.</td>
</tr>
<tr>
<td></td>
<td>• sent: The email was sent by the instance without any errors or issues.</td>
</tr>
<tr>
<td>Target</td>
<td>A Document ID reference to the record if the email is generated by an insert, update, or delete of a particular record.</td>
</tr>
<tr>
<td>User</td>
<td>The name of the user, from the user record, of the instance from which the email notification was sent.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This is a string field.</td>
</tr>
<tr>
<td>Notification Type</td>
<td>The type of notification. Choices are:</td>
</tr>
</tbody>
</table>
### Email log (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>UID</td>
<td>The unique ID of the email stored on the server.</td>
</tr>
<tr>
<td>Created</td>
<td>The date and time of the email activity for the locale of the machine running the instance.</td>
</tr>
<tr>
<td>Deleted</td>
<td>For inbound email, indicates whether the email was deleted from the email server.</td>
</tr>
<tr>
<td>Weight</td>
<td>The weight of the email, which determines the sending priority relative to other notifications on the same table.</td>
</tr>
<tr>
<td>Importance</td>
<td>An indication that the email was sent with a changed level of importance, such as Urgent.</td>
</tr>
<tr>
<td>Originating Event and Notification</td>
<td>For emails generated by notifications, an embedded list that stores the event and notification that created the email.</td>
</tr>
<tr>
<td>Subject</td>
<td>The email subject. For notifications, you create the subject text in System Notification &gt; Email &gt; Notifications.</td>
</tr>
<tr>
<td>Error String</td>
<td>The error string captured from the email server to determine why the email was not sent. This is logged only if the email is send-failed.</td>
</tr>
<tr>
<td>Recipients</td>
<td>The email addresses of the recipients.</td>
</tr>
<tr>
<td>Body</td>
<td>The body of the email, displayed in raw HTML markup. Use the related link Preview HTML Body to see the body text as rendered HTML.</td>
</tr>
<tr>
<td>Content type</td>
<td>The email content type.</td>
</tr>
<tr>
<td>Headers</td>
<td>Any headers embedded in the email.</td>
</tr>
</tbody>
</table>

### Message logs for individual emails

The email log entries for an individual notification email are accessible as a related list in the email record. The **Error string** field in the email record can provide additional information.
Every email record contains an Email Log related list. This list shows the Email Log Entry [syslog_email] records. For troubleshooting purposes, the most useful fields are probably Level and Message.

To diagnose problems with outbound emails, also examine the Error string field in the email record. However, not every receiving email server sends back an error string.

**Note:** The Email Log Entry record is available for only 7 days after the email record is created.

**Inbound actions on received emails**

Check these logs as the first step to diagnose issues with inbound actions. The logs show which inbound action did or did not apply and for what reason.

**Note:** If an inbound action did not update any field on the target record, the log indicates that the inbound action was skipped.

### Inbound email log

<table>
<thead>
<tr>
<th>Created</th>
<th>Level</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>2018-12-17 07:57:24</td>
<td>Information</td>
<td>Skipping 'Update Incident (BP); email is type 'new', which does not match inbound Email Action's type 'reply'</td>
</tr>
<tr>
<td>2018-12-17 07:57:24</td>
<td>Information</td>
<td>Skipping 'Update Change task'; email is type 'new', which does not match inbound Email Action's type 'reply'</td>
</tr>
<tr>
<td>2018-12-17 07:57:24</td>
<td>Information</td>
<td>Skipping 'Unsubscribe from Notification'; condition 'subjectSTARTSWITHUnsubscribe from=EQ' failed</td>
</tr>
<tr>
<td>2018-12-17 07:57:24</td>
<td>Information</td>
<td>Ready for update</td>
</tr>
<tr>
<td>2018-12-17 07:57:24</td>
<td>Information</td>
<td>Skipping 'Process CAB meeting invite replies'; condition 'subjectSTARTSWITHThTentative: CAB Meeting: Your attendance is requested in CAB<em>ORsubjectSTARTSWITHAccepted: CAB Meeting: Your attendance is requested in CAB</em>ORsubjectSTARTSWITHDeclined: CAB Meeting: Your attendance is requested in CAB*EQ failed</td>
</tr>
<tr>
<td>2018-12-17 07:57:24</td>
<td>Information</td>
<td>Skipping 'Create Live Feed Reply'; email is type 'new', which does not match inbound Email Action's type 'reply'</td>
</tr>
<tr>
<td>2018-12-17 07:57:24</td>
<td>Information</td>
<td>Processed 'Create Incident'; created incident dBCC0010002</td>
</tr>
</tbody>
</table>

**Reasons for including or excluding recipients**

For outbound notifications, the email system log provides reasons that recipients were included or excluded.
Each log entry corresponds to a reason for inclusion or exclusion. For example, all users who were excluded because they are inactive appear in a single log entry.

A series of system properties can be used to fine-tune the information to be logged. Two properties, `glide.notification.recipient.include_logging` and `glide.notification.recipient.exclude_logging`, control all recipient inclusion and exclusion logging. Several other properties allow you to tailor the information reported in the logs to meet your needs. All of the properties are enabled by default.

### Outbound email log

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Level</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>2016-12-18</td>
<td>09:00:19</td>
<td>Information</td>
<td>Notification (unknown) included recipients as member of a group in the notification's &quot;Groups&quot; field: &quot;Ethan Gale (IT manager?) (FccSzaia1a1354200c5b5cb6f224b8b5), 'Fred Luddy' (5137153cc611227c7000bd1bd8c8d2005), 'Jane Andrews (incident analyst)' (W7ac8b212131a2f260c5b1b5f5244b8b2)&quot;</td>
</tr>
<tr>
<td>2016-12-18</td>
<td>09:00:19</td>
<td>Information</td>
<td>Notification (unknown) excluded recipients because user's &quot;Notification&quot; setting is disabled: 'ITIL User' (651b365e5c5b60014000fbb0b05854ae06), 'Don Goodlife' (5eb1b365b112271007b00f0f0b0b0b0d0) &quot;David Loo&quot; (5137153cc611227c7000bd1bd8c8d2007), 'Rick Anglin' (46d4a232af6fe1358130121000cc0b0e66)</td>
</tr>
</tbody>
</table>

### Push notifications

In addition to sending email and SMS notifications, an instance can send push notifications to mobile devices.

A push notification is a text message that appears on a user’s mobile device to alert them about something important or to ask them to perform an action. Your instance supports push notifications.
An example push notification

Use push notifications to send messages to users when certain conditions are triggered on your instance, such as the assignment of an incident to the user. A push notification can even ask for a reply, and the instance can process the reply by acting on the related records. For example, you can have the instance send an approval request for a Change to a user. You can let the user approve or deny the Change by clicking a response button on the push notification. The user's response can then update the status of the Change record.

You can set up push notifications in a similar manner to email and SMS notifications. Determine:

• who to send the notification to
• when it should be sent
• what it should contain

The ServiceNow mobile app is available as ServiceNow Classic and as ServiceNow Agent. By default, ServiceNow Classic supports push notifications, but you can also develop your own push application and configure your instance to send push notifications to it. For more information on setting up push notifications in ServiceNow Agent, go to Mobile push notifications.
Push notification setup
Push notification setup differs depending on the mobile or push application that you want your users to use. For an overview, see:

- Push notification setup with the ServiceNow Classic mobile app

  Note: Push notifications for on-premise instances are not supported.

- Push notification setup with a custom push application for ServiceNow Classic mobile apps. If you create your own application, you must understand how push notifications and the Apple Push Notification Service system work. For more information, see the APNs Overview in the Local and Remote Notification Programming Guide for Apple developers.

Important: Apple does not guarantee delivery of all push notifications. Review the Quality of Service (QoS) information in the Local and Remote Notification Programming Guide for Apple developers.

Push notification system
The push notification system involves several key elements that manage the delivery of push messages and push notification responses.

Customer instance
Your ServiceNow instance.

Push proxy
An instance that collects all push notifications that go to the ServiceNow Classic mobile application and forwards them to the ServiceNow applications for Apple iOS or Android. If you create a custom push application, you do not use the push proxy.

Push provider
The provider of push messages, which is the Apple Push Notification service (APNs) or Firebase Cloud Messaging (FCM) service, for the ServiceNow Classic mobile app or custom mobile apps.

Push application on a mobile device
The application, such as the ServiceNow Classic mobile application. You can also build and customize your own push application.

Push notification process
The push notification process is as follows:
1. Activity on the instance triggers a push notification.

2. The instance looks for who to send the notification to and checks the user notification preferences to find their push device settings.

3. The instance sends the push notification to the push notification service, either the Apple Push Notification service (APNs) or Firebase Cloud Messaging (FCM) service. If you are using the ServiceNow Classic mobile app, the instance sends the notification through a push proxy instance, which then forwards the notification to the APNs or FCM service.

4. The push notification service sends the notification to the user’s push application. When the instance sends the notification to the push notification service, it includes message content along with the instance name and ID. This information ensures that a response to the notification is sent back to the correct instance. If the user can reply to the notification, such as sending an approval to a change request, the response is sent via REST message back to the instance.

5. The instance identifies a script to run to handle the response.

6. The script performs an action on the instance, such as marking a change request approved. If there is invalid JSON or if the script fails, an error response is sent back to the device.

**Push notification with the ServiceNow Classic mobile app**

**Push notification responses**

With custom push applications, you can have your users act on records in the instance by responding to a push notification.

The actions that they can take are defined in a script that you associate with the notification message. The response is sent to the instance in this format:

```
https://{instance_name}/api/now/v1/push/{application Name}/action/{action}
```

The application name is the push application the user is using. The application name must match the application name in the Push Application [sys_push_application] table. The action is the Sys ID of the action in the Push Notifications Actions [sys_push_notif_act_script] table.

**Activate push notifications**

Several plugins must be activated to use push notifications. If you have the Mobile UI (com.glide.ui.m) plugin active, push notification plugins are automatically activated.
Before you begin
Role required: admin

About this task
Ensure the following plugins are active on your instance:

- Push Notification: Provides the necessary components and REST APIs to send push notifications to mobile devices.
- Notification System Push Addon: Adds support for push notifications to the existing notification system.
- Push Feedback: Handles feedback from Apple on which devices are no longer valid so they do not keep receiving push notifications.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.
4. On the form, fill in the fields.
Activate Plugin request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

5. Click **Submit**.

Installed with push notifications

Several types of components are installed with the push notifications plugins.

Tables installed with push notifications

These tables are installed with push notifications.

<table>
<thead>
<tr>
<th>Table name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Push Applications [sys_push_application]</td>
<td>Push applications registered to the instance to receive push messages.</td>
</tr>
<tr>
<td>Table name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Push Default Registrations [sys_push_notif_default_reg]</td>
<td>Contains all the notifications users are automatically subscribed to for a given push application. You can add notifications to this table on the Push Default Registrations related list on the Push Application form.</td>
</tr>
<tr>
<td>Push Feedbacks [sys_push_feedback]</td>
<td>Feedback from the APNs that tells the instance which push devices can no longer receive push messages. The feedback is handled either on the same instance where your notifications are triggered, or on a central instance that uses a REST call to tell your instance which push applications to deactivate.</td>
</tr>
<tr>
<td>Push Message Attribute Definitions [sys_push_notif_msg_attr_def]</td>
<td>The attribute definitions used for push message content specification.</td>
</tr>
<tr>
<td>Push Message Attribute Values [sys_push_notif_msg_attr_val]</td>
<td>The values associated with push messages.</td>
</tr>
<tr>
<td>Push Notifications [sys_push_notification]</td>
<td>The push notifications that the instance attempted to send to users.</td>
</tr>
<tr>
<td>Push Notification Actions [sys_push_notif_act_script]</td>
<td>The action scripts that the instance uses in response to an actionable push message.</td>
</tr>
<tr>
<td>Push Notification Installations [sys_push_notif_app_install]</td>
<td>The devices with push apps where users agreed to receive push notifications. This table lists the records by the token for the push app. The instance uses this information to know which push device and app to send notifications to. Records are created in this table when a user logs on an instance with the push app. The Mobile Devices [sys_mobile_devices] table, which is installed with the Mobile UI plugin, contains all the user devices that logged in to the instance with the ServiceNow Classic mobile application.</td>
</tr>
<tr>
<td>Push Notification Messages [sys_push_notif_msg]</td>
<td>Messages customized for push notifications. These messages can be associated with a notification.</td>
</tr>
<tr>
<td>Table name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Push Notification Message Contents [sys_pushnotifmsgcontent]</td>
<td>The entire content, including JSON, for push messages.</td>
</tr>
<tr>
<td>Push Platforms [sys_push_platform]</td>
<td>The platforms that are supported for push notifications, and the maximum payload size.</td>
</tr>
</tbody>
</table>

**Business rules installed with push notifications**

These business rules are installed with push notifications.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build Device and Subscriptions</td>
<td>Push Installation [sys_push_notification_installation]</td>
<td>Automatically creates a notification device on a user’s notification preferences when the user registers a mobile application with the instance.</td>
</tr>
</tbody>
</table>

**Outbound REST messages installed with push notifications**

These outbound REST messages are installed with push notifications.

<table>
<thead>
<tr>
<th>REST message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNowMobileApp Push</td>
<td>The REST message that you can use with your custom iOS mobile app.</td>
</tr>
</tbody>
</table>

**Roles installed with push notifications**

These roles are installed with push notifications.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>push_admin</td>
<td>Can create and modify push notifications.</td>
</tr>
</tbody>
</table>

**Push components installed with push notifications**

These components are installed with push notifications.
### Push applications installed with push notifications

<table>
<thead>
<tr>
<th>Push application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNowPushApp</td>
<td>The push application record for the ServiceNow ServiceNow Classic mobile application.</td>
</tr>
</tbody>
</table>

**Note:** The ServiceNow Classic mobile app automatically subscribes users to several push notifications. You can see the list of these notifications in the Push Default Registrations related list on the ServiceNowPushApp application record.

### Message content installed with push notifications

<table>
<thead>
<tr>
<th>Message content</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConnectMessageContent</td>
<td>The payload for ServiceNow connect messages.</td>
</tr>
<tr>
<td>Generic Approval (Background)</td>
<td>The payload that provides an approval and rejection option to the user receiving the push message.</td>
</tr>
<tr>
<td>Generic Approval (Foreground)</td>
<td>The payload that provides an approval and rejection option to the user receiving the push message.</td>
</tr>
<tr>
<td>Generic Record Payload</td>
<td>A generic payload that you can use to send push messages to users.</td>
</tr>
</tbody>
</table>

### Push notification actions installed with push notifications

<table>
<thead>
<tr>
<th>Push notification action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval - Approve</td>
<td>Allows an administrator to approve a request.</td>
</tr>
<tr>
<td>Approval - Reject</td>
<td>Allows an administrator to reject a request.</td>
</tr>
</tbody>
</table>

### Push notifications installed with push notifications

<table>
<thead>
<tr>
<th>Push notifications</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConnectMessagePushNotification</td>
<td>Live Feed Message [live_message]</td>
<td>Sends a push notification when a new live feed message</td>
</tr>
</tbody>
</table>
Push notification properties

Push notifications provides several properties to customize the setup.

Add these properties to the System Properties [sys_properties] table.

**glide.push.apns.version**

Controls which version of the Apple Push Notification service (APNs) to use in your instance. You can use APNs version 1 or 2. The system uses APNs version 2 by default. To use APNs version 1 instead, set the value to 1.

- Type: integer
- Default value: 2

**glide.push.debug**

Creates entries in the system log for push notification errors.

- Type: true | false
- Default value: false

**glide.push.enabled**

Enables or disables push notifications.

- Type: true | false
- Default value: true

**glide.push.feedback.debug**

Creates entries in the system log for feedback sent by the APNs for custom iOS push applications.

- Type: true | false
- Default value: false

**glide.push.notification.ttl_seconds**

Specifies the number of seconds after which a queued push notification expires. After a push notification is triggered, it is queued and finally processed by a scheduled job. If the time the notification sits in the queue exceeds this value, the notification is not sent. Check the Push Notifications log for more information.

- Type: integer
- Default value: 21600
Push notification setup with the ServiceNow Classic mobile app

The ServiceNow Classic mobile application automatically enables push notifications and configures mobile devices for push notifications when users initially log in to the instance with ServiceNow Classic.

Note: Push notifications with the ServiceNow Classic mobile application are not supported in on-premise instances.

Setting up push notifications involves both the system administrator and users.

• Admin creates or updates push notifications for the ServiceNow Classic mobile app. The admin does not need to set up the mobile devices for users nor update their user preferences for receiving push notifications.

• Users install the ServiceNow Classic mobile app on their iOS or Android mobile devices and set their preferences for receiving notifications on the ServiceNow Classic mobile app.

What to do — admins

Admins create push notifications, similar to setting up email notifications. A push notification has two main parts: the push message and the notification, which includes the push message.

Note: The push message and notification must be for the same table.

Create the push message
Before creating a push notification, create the push message with the actual message content (JSON payload) to be included in the push notification.

**Create the push notification that includes the push message**

Create the push notification that includes the push message and message content. A push notification specifically sends the push message. You can update a standard platform notification and use it as a push notification that includes the push message.

**Add the new push notification to the Push Default Registration table**

To ensure that a new push notification is included and enabled in the notification preferences of your users, register a new push notification in the Push Default Registration table. The notification is listed in the notification preferences of your users the next time that they log in to the ServiceNow Classic mobile app.

**What to do — ServiceNow Classic mobile app users**

**Download the ServiceNow Classic mobile app**

Install the ServiceNow Classic mobile app on an iOS or Android mobile device.

**Agree to accept push notifications**

After installing the ServiceNow Classic mobile app, users are asked to accept push notifications. When the instance receives the push notification acceptance message from a user, it creates a record in the Push Notification Installations [sys_push_notif_app_install] table. This record is what the instance uses to identify the device + mobile application combination necessary to identify a push notification recipient.

The device then performs the following actions:

- Obtains a token that identifies the device.
- Triggers the creation of the device in the user notification preferences.

**Log in to the company instance from the ServiceNow Classic mobile app**

Logging in automatically subscribes users to the push-specific notifications registered in the Push Default Registration table.

**Update preferences for receiving notifications on the ServiceNow Classic mobile app**
Users can **enable or disable notifications** through **Notification Settings** in the ServiceNow Classic mobile app. They can set additional notification preferences, such as conditions or filters that affect notification delivery, by using the System Settings window on a desktop or mobile browser. For details, see Setting notification preferences in UI16.

**Next steps**

If you are an admin, review the base system notifications and determine if new **push message content** and **push notifications** are needed.

**Create a push message**

Before you create a push notification, create the push message with the actual message content for the notification.

**Before you begin**

The **Push notification plugin** must be active. The plugin is active by default.

Role required: admin

**About this task**

The push message and notification must be for the same table.

**Procedure**

1. Navigate to **System Notification > Push > Push Messages** and click **New**.
2. Fill out the fields on the form (see table).
3. Click **Submit**.

**Push Notification Message form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name for the message.</td>
</tr>
<tr>
<td>Push App</td>
<td>Select the ServiceNow Classic mobile application.</td>
</tr>
<tr>
<td>Push Message Content</td>
<td>Select the JSON content to be included in the push notification payload.</td>
</tr>
</tbody>
</table>

**Note:** For details on defining payloads that control push notification behavior, see KB0622333. For example, you can specify predefined button pairs (Yes/No, Approve/Reject, Accept/Decline) as part of the push message content.
### Field | Description
--- | ---
Message | Enter the message. You can add variables just as you would for other notifications. Any message you enter here overrides the message in the notification.

**Related list**

| Push Message Attribute Values | Optional. Select the attributes that apply to this notification. For details, see [Create an attribute value or action for a push message](#). |

**What to do next**

*Set up the push notification* that contains the message created or update an existing push notification to use the push message.

### Create a notification using a push message

Email administrators can create a notification that specifically sends a push notification.

**Before you begin**

Configure the push message before performing these steps.

Role required: admin

**About this task**

You can associate a push message with a standard notification. A push message specifies the text the system sends as part of the push notification to the mobile device.

**Procedure**

1. Navigate to *System Notification > Create Push Notification*.
2. Fill out the notification form as necessary (see [Create an email notification](#) for descriptions of the form fields.
3. Click the *What it will contain* tab.
4. Next to *Push Messages*, click the lock icon and select a push message.

   **Note:** The push message and notification must be for the same table.

5. If you want this notification to be sent only as a push notification and not as any other type of notification, select *Push Message Only*.
6. Click **Submit**.

   If the notification fails, the user is not notified. If the message fails to send because it exceeds the maximum payload, the instance logs the failure in the System Log.

**What to do next**

Add the push notification to the Push Defaults Registrations table so that the push notification is listed in the notification preferences for users. Users can then select which notifications they want to receive for the ServiceNow Classic mobile app.

**Add a push notification to the Push Default Registrations table**

After you create a new push notification, add it to the Push Default Registration table. Push notifications registered in this table are listed and automatically enabled in the notification settings of your ServiceNow Classic mobile app users.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Notification > Push > Push Application**.

2. Select the **ServiceNow Classic Mobile Application**.

3. In the Push Application form for the ServiceNow Classic mobile app, select the **Push Default Registrations** tab and click **New**.
4. In the Push Default Registration New record, select the notification to be registered.

5. Click **Submit**.

   The next time that users log in to their instance, the new push notification is included in their list of notifications.

---

**Push notification setup with a custom push application for ServiceNow Classic mobile apps**

If you are using your own custom mobile or push application, you must configure your app for use and set up the push contents.

Setting up a push notification infrastructure that uses a custom push app involves a push admin (also called push app developer or mobile app developer) and system administrator. When push admins create a customized push app, they also configure the app, its push message content (payload generators), and optional attributes, such as push action scripts. The admin creates and updates the push notifications for the custom push app. After users install the custom push app and initially log in to their instance from their mobile device, the system automatically creates a device (channel) for the custom app.
Note: These instructions are intended for users who develop their own customized push application. You do not need to configure the ServiceNow Classic mobile push application.

Note: This process describes configuration used in the ServiceNow Classic mobile app. Push Notification configuration for the current ServiceNow mobile UI can be found at Mobile push notifications.

Before you begin
Complete the steps in Activate push notifications.
Assign the push_admin role to your organization’s mobile app developer.

What to do — push admin
Configure push notifications for your custom push app. This process differs for iOS and Android devices.

1. (iOS only) Upload a push certificate to your instance
   Upload a push certificate to your instance so that you can use it later to connect your iOS device to the push notification system.

2. Create a push application record for your custom app
   Register your customized mobile application with your instance to receive push notifications for the application. The instance uses this push application record to identify the device + push application combination necessary to determine a push notification recipient.
3. Create push message content

Create a JSON content payload for different types of push notifications. The content determines how a push notification appears on the push application, and whether the user can send a message in response to the push notification. The push admin can create attribute definitions that specify a default push action script or string, for use in the push message content.

4. (Optional) Create a push message attribute definition

Push message attribute definitions allow you to create reusable properties for push message content specification.

5. (Optional) Create an attribute value or action for a push message

You can create attribute values that override the default attribute definitions used in the push message content.

6. (Optional) Create a push action

A push action is a server-side script that runs when the instance receives a response to an actionable push message.

What to do — admin

Create the push messages and push notifications

The administrator creates the push messages, sets up push notifications for the custom push app, and if desired, the content.

Next steps

Use the Push Installation API to opt users in to receive push notifications. For more information, see Push Installation API.

Upload a push certificate to your instance

Upload a push certificate to your instance so that you can use it later to connect your iOS device to the push notification system.

Before you begin

Using your Apple developer environment, create a push certificate and convert it to a PKCS (.p12) file. For details on generating the .p12 file with the required certificate and private key, see Enable push notifications and Communicate with APNs using a TLS certificate in the Apple documentation.
Note: Ensure that your certificate is a push certificate and not a developer certificate. Also, if you're developing an app for testing purposes, ensure that you create a Sandbox certificate. If you're developing an app that you plan to launch in the Apple App Store, ensure that you create a Production certificate.

Role required: push_admin or admin

Note: This process describes configuration used in the ServiceNow Classic mobile app. Push Notification configuration for the current ServiceNow mobile UI can be found at Mobile push notifications

About this task
After you create a PKCS (.p12) file that contains the iPhone developer certificate and the private key used to sign the certificate, you need to upload the file to your instance. The system uses the information in the PKCS file to communicate with the APNs.

Procedure
1. Navigate to System Definition > Certificates, and then click New.
2. On the form, fill in the following fields:
   • Name: Enter a certificate name.
   • Type: Select PKCS12 Key Store.
3. Attach the PKCS (.p12) file to the record.
4. Click Submit.

What to do next
Create a push application record for your custom app

Create a push application record for your custom app
Register your customized mobile application with your instance to receive push notifications for the application.

Before you begin
Complete the following:
1. Activate push notifications
2. (iOS only) Upload a push certificate to your instance

Role required: admin or push_admin
Note: This process describes configuration used in the ServiceNow Classic mobile app. Push Notification configuration for the current ServiceNow mobile UI can be found at Mobile push notifications.

About this task
Push notifications are application-specific: They are sent to one type of mobile application, regardless of how many users have this application installed. If you develop your own mobile application, you must configure it for use by creating a record for it in the Push Application [sys_push_application] table. By default, ServiceNow mobile applications are automatically set up and ready to use.

Procedure
1. Navigate to System Notification > Push > Push Application, and then click New.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Name of the push application.</td>
</tr>
<tr>
<td>Name</td>
<td>Database name of the push application. Enter a name that doesn't include spaces.</td>
</tr>
<tr>
<td>Push</td>
<td>Type of push service to enable for the application. Because you're setting up a custom push app, select Direct.</td>
</tr>
<tr>
<td>Feedback</td>
<td>Type of push feedback to use for the application. Because custom push apps don't receive push feedback, select None.</td>
</tr>
<tr>
<td>Apple</td>
<td></td>
</tr>
<tr>
<td>Certificate</td>
<td>The X.509 certificate that you created on the Apple notifications portal. The certificate enables a device to talk to the APNs.</td>
</tr>
<tr>
<td>Sandbox Certificate</td>
<td>Sandbox certificate that you created on the Apple notifications portal. The certificate enable a device to talk to the APNs.</td>
</tr>
<tr>
<td>APNS Bundle Id</td>
<td>Bundle ID included in the certificate that you created on the Apple notifications portal. The system populates this field automatically after you specify a certificate.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>API key</td>
<td>FCM API key you obtained from Google for the Android push notification.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**What to do next**

Create push message content that contains the JSON content in the push notification payload.

In the Push Default Registrations related list, you can select the notifications that you want automatically subscribed to users who use this application. Users are subscribed to only active notifications.

**Create push message content**

Push message content specifies additional JSON content in the push notification payload that is sent to the push provider.

**Before you begin**

Complete the following:

1. **Activate push notifications**
2. (iOS only) **Upload a push certificate to your instance**
3. **Create a push application record for your custom app**

You must know how to use JSON with push messages.

Role required: admin or push_admin

**Note:** This process describes configuration used in the ServiceNow Classic mobile app. Push Notification configuration for the current ServiceNow mobile UI can be found at [Mobile push notifications](#).

**About this task**

Push message content defines the style of push notification that can be sent out for your custom app. You can add custom content, such as a picture, icons, or action buttons for the user to respond to the notification. Use the following variables in the script:

- `current`: properties of the current record.
- `message`: push message sent as the body of the entire push content.
- `attributes`: object of the push message attributes that you define.
Procedure

1. Navigate to **System Notification > Push > Push Message Content**.
2. In the Push Notification Message Contents table, click **New**.
3. Fill out the fields on the Push Notifications Message Content form (see table).
4. Click **Submit**.

### Notification Message form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name for the message content.</td>
</tr>
<tr>
<td>Push app</td>
<td>The push application the content can be used with.</td>
</tr>
<tr>
<td>Push Message Generation</td>
<td>Enter a script that determines the message content. See the example scripts.</td>
</tr>
<tr>
<td>Related list</td>
<td></td>
</tr>
<tr>
<td>Push Message Attribute Definitions</td>
<td>Select the attributes that apply to this notification. Attributes can be a value or an action. These attributes are used as default values for the content items you create in the content script. However, any attributes you create with the push message can override these attributes. See Create a push message attribute definition for information on creating attributes.</td>
</tr>
</tbody>
</table>
Example:
The following is an example of a content record that creates a two-button layout, one to approve something, such as a change request, and one to decline it.

```javascript
var json = {
  "table": current.getTableName(),
  "sys_id": current.sys_id,
  "template": {
    "type": "2 button",
    "button1": {
      "title": "Approve",
      "action": attributes.button_action,
      "parameters": {
        "response": "approve"
      }
    },
    "button2": {
      "title": "Decline",
      "action": attributes.button_action,
      "parameters": {
        "response": "decline"
      }
    }
  }
};
```

What to do next

Define a push message attribute to specify a default push action script or string that you can use in the push message content.

Create a push message attribute definition

Push message attribute definitions allow you to create reusable properties for push message content specification.

Before you begin

1. Activate push notifications
2. (iOS only) Upload a push certificate to your instance
3. Create a push application record for your custom app
4. Create push message content
Role required: admin or push_admin

Note: This process describes configuration used in the ServiceNow Classic mobile app. Push Notification configuration for the current ServiceNow mobile UI can be found at Mobile push notifications.

About this task
Use an attribute definition to specify a default push action script or string that you can then use in the push message content.

You can override these attributes by creating any push message attribute values.

Procedure
2. Select a content record or script record.
3. In the Push Message Attribute Definitions related list, click New.
4. Fill out the fields on the form (see table).
5. Click Submit.

Push Message Attribute Definition form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute Name</td>
<td>Enter a descriptive name for the layout.</td>
</tr>
<tr>
<td>Attribute Type</td>
<td>Select the type of attribute:</td>
</tr>
<tr>
<td></td>
<td>• Action: An action to take on the instance, as defined by a script.</td>
</tr>
<tr>
<td></td>
<td>• String: An arbitrary string to send as part of the message content.</td>
</tr>
<tr>
<td></td>
<td>The string can specify items like a button label in the message.</td>
</tr>
<tr>
<td>Default Script</td>
<td>Select the mobile action script that tells the instance what to do when it</td>
</tr>
<tr>
<td></td>
<td>receives a response from the push notification. This option appears if you</td>
</tr>
<tr>
<td></td>
<td>select Action for the Type.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default Value</td>
<td>Specify an arbitrary string value to be placed in the attribute that is used by the message content. For example, the string could specify a button label. This option appears if you select <strong>String</strong> for the <strong>Type</strong>.</td>
</tr>
</tbody>
</table>

**What to do next**

If you want to override default attribute definitions, see Create an attribute value or action for a push message.

**Create an attribute value or action for a push message**

Attribute values are associated with push messages to provide a way for the message to include certain types of information in the push notification.

**Before you begin**

Complete the following:

1. **Activate push notifications**
2. (iOS only) **Upload a push certificate to your instance**
3. **Create a push application record for your custom app**
4. **Create push message content**
5. **Create a push message attribute definition**

Role required: admin or push_admin

⚠️ **Note:** This process describes configuration used in the ServiceNow Classic mobile app. Push Notification configuration for the current ServiceNow mobile UI can be found at Mobile push notifications

**About this task**

These push message attribute values override values that you set in an attribute definition on the Push Content form.

**Procedure**

1. Navigate to **System Notification > Push > Push Messages**.
2. Select a message.
3. In the Push Message Attribute Values related list, click **New**.
4. Fill out the fields on the form (see table).
5. Click **Submit**.
Push Message Attribute Values form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute</td>
<td>Select a push message attribute definition.</td>
</tr>
<tr>
<td>Value/Action</td>
<td>Enter the value for the attribute or select the push action. This field</td>
</tr>
<tr>
<td></td>
<td>changes to Value or Action depending on the type of attribute you select</td>
</tr>
<tr>
<td></td>
<td>in the Attribute field.</td>
</tr>
</tbody>
</table>

**What to do next**

(Optional) **Create a push action** to perform an action on the instance.

**Create a push action**

A push action is a server-side script that runs when the instance receives a response to an actionable push message.

**Before you begin**

Complete the following:

1. **Activate push notifications**
2. (iOS only) **Upload a push certificate to your instance**
3. **Create a push application record for your custom app**
4. **Create push message content**
5. **Create a push message attribute definition**
6. **Create an attribute value or action for a push message**

Role required: admin or push_admin
Note: This process describes configuration used in the ServiceNow Classic mobile app. Push Notification configuration for the current ServiceNow mobile UI can be found at Mobile push notifications.

About this task
Create a push action to perform an action on the instance. For example, you might have an actionable push message that lets the user approve a change request. The action that handles the response should update the Approval field on the relevant Change Request record.

You can use global variables or, optionally, current variables and parameters passed through the JSON content.

Procedure
2. Fill in the form fields (see table).
3. Click Submit.

<table>
<thead>
<tr>
<th>Push Notification Action form fields</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Script</td>
</tr>
</tbody>
</table>

Requeue failed push notification messages
Push notification delivery might fail for various reasons. You can view which messages failed and requeue them to be sent out if necessary.

Before you begin
Role required: admin

About this task

Note: There is no way for the instance to guarantee or confirm push message delivery. For more information on how Apple handles push notifications, see the Local and Remote Notification Programming Guide for Apple developers.

Messages can also fail to send for several reasons, such as a large message queue or other issue with the instance. You can use a system property to control how long the instance queues a push notification after it is triggered.
Push notification message payload size is limited by provider:

- Apple iOS: 2,048 bytes
- Google: 4,096 bytes

Your instance does not send push messages that exceed this limitation. System logs save any failed messages. For details on Apple payload limitations, see the Local and Remote Notification Programming Guide for Apple developers.

Procedure

1. Navigate to System Logs > Push Notifications.
   By default, the messages that were created today appear. You can change the filter if necessary. The Type column can have these values:
   - failure: The message could not be sent.
   - pending: The message is queued for processing.
   - success: The message was successfully sent, although not necessarily received by the mobile device.

2. Put any failed messages back into the queue to be resent by selecting the check boxes next to the failed messages, and then selecting Re-queue failed push notifications from the choice list.

3. If some push notifications continue to fail, consider increasing the value in the glide.push.notification.ttl_seconds property. See Push notification properties for more information.

Push notification retention

You can archive and eventually destroy push notifications that you no longer need or if your Push Notification table is excessively large.

Push notification retention is available starting with the Jakarta release.

Push notification archive and destruction plugins

The push notification archiving and destruction feature uses the Data Archiving and Push Retention plugins. The Data Archiving plugin must be active to archive and destroy push notification records. The Push Retention plugin provides a set of rules that specify when the system archives and destroys push notification records.

In new instances, the Push Retention plugin and associated archive and destroy rules are active by default. On upgraded instances, you must manually activate both the plugin and the archive and destroy rules. Be sure to review and approve the archive and destroy rules before activating them.
If your instance already has a process for managing push notification records, you do not need to activate the Push Retention plugin. If you want to replace your current process with Push Retention, be sure to deactivate the current process before activating the archive and destroy rules.

**Archiving and destroying push notification records**

Archiving means moving records from the Push Notification [sys_push_notification] table to the Push Notification Archive [ar_sys_push_notification] table when they exceed the archive rule time limit. Destroying means deleting records in the Push Notification Archive table when they exceed the destroy rule time limit.

**Default archive and destroy rules**

Push retention provides the following push archive rules:

- **Push Notification - Over a year old**: archives push notification records that were created more than 365 days prior to the current date.
- **Push Notification Archive - Over a year old**: destroys push notification records that have been archived for more than 365 days prior to the current date.

With these default settings, your messages are kept on the instance for a total of two years: one year in the Push Notification table, and one year in the Push Notification Archive table. At the end of the period, the system deletes the expired notification records from the Push Notification Archive table.

**Note:** By default these rules are active on new instances and inactive on upgrades. The system runs archive and destroy rules when you activate them.

**Compatibility with other record management implementations**

If you are already using another method for managing push notification records, such as table cleaners, you do not have to use the Push Retention feature. To prevent unexpected record deletion, avoid using multiple push notification management processes on the same instance at the same time.

**Note:** For assistance replacing your existing record management implementation with push notification retention, contact your professional services or sales representative.

**Activate the Push Retention plugin**

The Push Retention plugin (com.glide.push_retention) provides the retention policy for push notifications, so that you can specify when the system archives and destroys push notification records.
Before you begin
Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   🔄 Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related information
List of plugins (Rome)

Archive push notifications manually
You can manually archive push notifications on demand instead of waiting for the instance to archive them based on a scheduled job.

Before you begin
Role required: admin

About this task
Push retention provides these push notification archive rules:

• Push Notification - Over a year old: archives push notification records that were created more than 365 days prior to the current date.

• Push Notification Archive - Over a year old: destroys push notification records that have been archived for more than 365 days prior to the current date.

You can manually archive push notification messages that meet the default archive and destroy rules or any additional archive rules that you create.
Procedure

1. Navigate to System Archiving > Archive Rules.
2. Open the push notification archiving rule, for example Push Notification - Over a year old
3. Click Recalculate Estimate to see how many records in the Push Notification [sys_push_notification] table are going to be archived. The estimate appears in the Record estimate field.
4. Click Run Archive Now.

Subscription-based notifications

Subscription-based notifications enable users to proactively subscribe to items that interest them and unsubscribe from messages that are not mandatory.

Users can also specify additional notification channels that each of their notifications can be configured to use.

Before users can manage the notifications that are sent to them, administrators must create email notifications to which users can subscribe. Administrators can also make subscription-based notifications mandatory so users cannot unsubscribe to them. Then users can subscribe or unsubscribe to the notifications, and add schedules and filters to the subscription to limit the notifications that can be received.

Notifications that administrators mark as subscribable are automatically available in user notification settings. Users are limited to one subscription per notification.

Administrators should create subscription-based notifications when they do not want to specify users for a notification and want to let users proactively subscribe to the notification.

⚠️ Note: Subscription-based notifications are not domain aware and cannot support domain-specific settings.

Subscriptions 2.0 plugin

The Subscription Based Notifications 2.0 plugin must be active to use subscribable notifications. This plugin is active by default on all new and upgraded instances.

The plugin installs the Notification Subscription [sys_notif_subscription] table, which holds user subscriptions to all notifications.
Subscriptions and notification preferences

Users can subscribe to notifications available to them through their notification preferences. In the UI16 interface, all users can set and modify their notification preferences through the Notifications tab of the System Settings window. In the UI15 interface and earlier, admins and users set their notification preferences through the Notification Preferences link in the User form.

Setting notification preferences in UI16

You can set your own notification preferences, including personal subscriptions and channels for receiving them. All users can set these preferences through the Notifications tab of the System Settings window.

With the Notifications tab, you can:

• Search for a specific notification in the list of your notifications.
• Use a global switch to enable or disable all your notifications.
• Enable or disable a particular channel for receiving notifications, as well as create, edit, or delete channels.
• Control the notifications that you receive and apply conditions to restrict notification delivery.
• Create personal notifications, which are subscriptions to notifications that are important to you.

Comparison between notification preferences in UI16 and earlier interfaces

In new and upgraded instances that use the UI16 interface, the System Settings window is the central location for managing your notification preferences. The Notification Preference User Interface (com.glide.notification.preference.ui) plugin is activated by default.
Notification preferences in UI16 and UI15

In UI15 and earlier interfaces:

- Users set notification preferences through the Notification Preferences link in the User form (Self service > My Notification Preferences).
- Admins created user devices and set notification preferences for users through the Notification Preferences link in the User form, accessed through the User Administration module (User Administration > Users).

**Note:** Admins can revert to the UI15 notification preferences interface by setting the `glide.notification.preference.UI.enabled` property to false.

Manage your notification preferences in UI16

To access your notification preferences, click the gear icon (⚙️) in the banner frame, and in the System Settings window, click the Notifications tab. You can also access the System Settings by navigating to Self Service > My Notification Preferences.
In the **Notifications** tab, use the following settings to manage your notifications:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Search**            | Search bar for finding notifications. To find a notification:  
  • Enter the name of the notification you are searching for. When you type the first three characters, the system automatically returns a list of notifications matching the characters entered.  
  • Enter two asterisks to return a list of all notifications in alphabetic order (the notifications are not organized by category). |
| **Allow notifications** | Global switch for enabling or disabling all notifications. |
| **Notification channels** | List of your channels for receiving notifications. Use this section to:  
  • Enable or disable a channel by using its toggle switch. If you disable a channel, notifications are not delivered through that channel.  
  • **Add channels** using the **Create Channel** option.  
  • **Modify channel information**. Click the channel row or the right arrow (>) next to the appropriate channel to edit or delete it. |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notifications by category</td>
<td>List of notification categories that identify and group related notifications. Each category contains the notifications that you can subscribe to. To view the notifications in a given category, click the category row or the right arrow (&gt;) next to the appropriate category. You can:</td>
</tr>
<tr>
<td></td>
<td>• Edit settings for a notification:</td>
</tr>
<tr>
<td></td>
<td>◦ Enable or disable channels for the selected notification.</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>Apply notification conditions</strong>, such as schedules and filters, that affect the delivery of the notification.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Create personal notifications</strong>, which are subscriptions to specific notifications that matter to you.</td>
</tr>
</tbody>
</table>

**Create notification channels**

You can add channels to receive your notifications. A notification channel is an email account or voice message system that you have access to.

**Before you begin**

Role required: none

**About this task**

Notification channels include email addresses, service providers for SMS messages, and mobile applications. You can create voice notification channels to support applications like Notify.

ℹ️ **Note:** If you are using the ServiceNow mobile application or a custom push application, you do not need to create a push channel for your mobile device. The system automatically creates a channel for the mobile app after you initially log in to your instance from your mobile device.

**Procedure**

1. Click the gear icon (⚙️) in the banner frame to open the System Settings window, and click the **Notifications** tab.
2. Click **Create Channel**.
3. Complete the fields on the New Channel form.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name for the channel, such as the device or email account.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of channel:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Email</strong>: for email messages.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: All users with an email address have a primary email channel, which is created automatically after a notification is sent to them.</td>
</tr>
<tr>
<td></td>
<td>• <strong>SMS</strong>: for SMS messages.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Voice</strong>: for phone messages.</td>
</tr>
<tr>
<td>Email address</td>
<td>The email address of the channel.</td>
</tr>
<tr>
<td>Phone number</td>
<td>The phone number for SMS messages or for voice messages.</td>
</tr>
<tr>
<td>Service provider</td>
<td>The service provider for SMS messages.</td>
</tr>
</tbody>
</table>
4. Click **Save**.
The system creates and enables the channel, and adds it to the list of notification channels.

**What to do next**
To receive notifications on your new notification channel, you must enable the channel for individual notifications. After you enable the channel for a notification, you can set conditions to further control the notifications that you receive on the channel. For more information, see **Apply notification conditions**.

**Modify notification channels**
You can update channel information for your notifications.

**Before you begin**
Role required: none

**Procedure**
1. Click the gear icon (⚙️) in the banner frame to open the System Settings window, and click the **Notifications** tab.
2. In the Notification Channels section, click the channel row or the right arrow (>) next to the channel name.
3. In the Edit Channel form, update the fields (see **Create notification channels** for descriptions of the form fields).
4. Click **Save**.

**Results**
The system updates and saves the channel information that you modified.

**Delete a notification channel**
Delete a notification channel so that you no longer receive notifications through the channel.

**Before you begin**
Role required: admin
Procedure

1. Click the gear icon (⚙️) in the banner frame to open the System Settings window, and click the Notifications tab.

2. In the Notification Channels section, click the channel row or the right arrow (►) next to the channel name.

3. On the Edit Channel form, click Delete.

Results
The system deletes the channel from the list of notification channels and no longer delivers notifications to that channel.

Apply notification conditions
You can set various conditions and filters to control the notifications you receive. You can also enable or disable an email digest and the delivery of individual notifications by channel.

Before you begin
Role required: none

About this task
You can choose to enable certain features and set different conditions that control the notifications you receive. You can:
• Enable or disable an email digest if a digest is available for the notification. An email digest is a single email that summarizes the activity for the notification during a time interval that you specify. Admins configure the email digest content for a notification.
• Enable or disable a channel on which the notification is received.
• Set preconfigured schedules and filters that determine when you receive your notifications.
• Set more advanced filter conditions to limit the notifications delivered to you.

Procedure
1. Click the gear icon (⚙️) in the banner frame to open the System Settings window, and click the Notifications tab.
2. Select the notification:
   a. In the Notifications By Category section, click the row or right arrow (▶) of the category that you want to view.
   b. In the list of notifications for the category, click the row or right arrow (▶) next to the notification that you want to edit.
3. To enable or disable an email digest for the notification, if an email digest is available:
   a. Click the Email Digest switch.
      The email digest is enabled when the switch is green and disabled when the switch is grey.
   b. If you enabled the digest, select the Interval (length of time) during which the notifications are accumulated.
The interval begins with the first occurrence of notification activity during the specified interval. For example, if you selected the Daily interval and the first notification occurs at 07:00, the system begins accumulating notifications at 07:00 and stops at 07:00 the next day. Soon after the interval ends, the system sends the email digest instead of sending the individual notifications that were triggered during the digest interval. If you disabled the digest, the system immediately stops accumulating the notifications and does not send the email digest.

4. To enable or disable a channel on which the notification is received, click the switch for the channel. The notification is enabled when the switch is green and disabled when the switch is grey. If you previously disabled an entire channel, you cannot enable that channel for the notification.

5. To set more criteria for notification delivery, click the row or the right arrow (>) next to the channel for the notification.
a. Complete the Apply Conditions form (see table).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule</td>
<td>Select a schedule that determines when the notification can and cannot be received.</td>
</tr>
<tr>
<td>Filter</td>
<td>Select a pre-configured filter with the criteria that determines when the notification can be sent. For example, you might select a filter whose conditions send notifications when an incident with a priority of <strong>1 - Critical</strong> is opened for a network issue.</td>
</tr>
<tr>
<td>Advanced filter</td>
<td>Select this check box to use the condition builder to create additional criteria. When you select the check box, the <strong>Table</strong> and <strong>Conditions</strong> fields are displayed.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table for the notification. For example, if you selected an incident-related notification, you might select the Incident <code>[incident]</code> table.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Define as many conditions as needed to limit the notifications you receive. For example, you can choose to be notified only when an incident communication plan is created for a specific configuration item.</td>
</tr>
</tbody>
</table>
b. Click **Save**.
   To navigate back, click the left arrow (≪) at the top of the Notifications window.

**Create personal notifications**

You can create personal notifications, which are subscriptions to notifications of importance to you. You can apply conditions that control specific content included in your personal notification, and also enable or disable the channels for delivery.

**Before you begin**

Role required: none

**About this task**

A personal notification is a subscribable notification that you can customize. You can assign the notification a name that is meaningful to you and filter the information received in that notification.

⚠️ **Note:** Users are limited to one subscription per notification.

**Procedure**

1. Click the gear icon (⚙️) in the banner frame to open the System Settings window, and click the **Notifications** tab.
2. Click **Create Personal Notification**.
3. Complete the New Personal Notification form (see table).

<table>
<thead>
<tr>
<th>System Settings</th>
<th>Notifications</th>
<th>New Personal Notification</th>
<th>Switch to UILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄 General</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 Theme</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 Accessibility</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 Lists</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 Forms</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 Notifications</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 Developer</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>My special notification on new incidents</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Notification</strong></td>
<td>Incident Opened and Unassigned</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Send when</strong></td>
<td>All of these conditions must be met</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td>is</td>
<td>1 - Critical</td>
<td>OR</td>
</tr>
<tr>
<td>or</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>New Criteria</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name for your personal notification. Use a meaningful name to distinguish it from system notifications.</td>
</tr>
<tr>
<td>Notification</td>
<td>The notification to subscribe to. You can subscribe only to notifications that are configured to allow subscriptions. Depending on the notification you select, the Table, Affected record, and Send when fields are displayed.</td>
</tr>
<tr>
<td>Table</td>
<td>The database table that the notification is linked to.</td>
</tr>
<tr>
<td>Affected record</td>
<td>The specific record that the notification is based on. This field appears when you select a notification that has an affected record (for example, a notification for a problem record that has multiple affected CIs). Click the lookup icon, select the table and specific document (record) in that table, and click OK.</td>
</tr>
<tr>
<td>Send when</td>
<td>Another condition that must be met to send the notification. For example, you might create a filter whose conditions send notifications when an incident with a priority of 1 - Critical is opened for a network issue.</td>
</tr>
</tbody>
</table>

4. Click **Save**. The system creates the personal notification and adds it to the appropriate notification category. In the following example, notice the category in which the system placed the personal notification.
5. Enable or disable the channels for your personal notification.

6. Navigate back to the list of notifications for the category by clicking the left back arrow ( freopen) at the top of the form. Notice that your Personal Notifications are listed above the System Notifications in the given category.

7. Navigate back by clicking the left back arrow ( freopen) at the top of the form or by clicking the Notifications tab.

User notification preferences in UI15 and earlier

In UI15 and earlier interfaces, use the Notification Preferences link in the User form to manage the notifications that you can subscribe to.

The following instructions explain how to use Notification Preferences to manage notifications.

Set up a notification device in UI15 and earlier

You can add devices for a user to receive notifications. A device is a mobile device, email account, or voice message system that the user has access to.

Before you begin
Role required: admin

About this task
Notification devices include email addresses, service providers for SMS messages, and mobile applications.
Procedure

1. Navigate to **User Administration > Users**.

2. Select a user.

3. Click **Notification Preferences**.

4. Click **Create New Device**.

5. Fill in the fields on the form (see table).

6. Click **Submit**.

### New Device form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name of the device or account.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of device:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Email</strong>: for email messages.</td>
</tr>
<tr>
<td></td>
<td>• <strong>SMS</strong>: for SMS messages.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Mobile</strong>: for push notifications.</td>
</tr>
<tr>
<td>Email address</td>
<td>The user's email address.</td>
</tr>
<tr>
<td>Mobile application</td>
<td>The <strong>mobile application</strong> for push notifications.</td>
</tr>
<tr>
<td>Phone number</td>
<td>The user's phone number for SMS messages.</td>
</tr>
<tr>
<td>Service provider</td>
<td>The service provider for SMS messages.</td>
</tr>
<tr>
<td>User</td>
<td>The user's record in the system.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>A number that determines which device receives the notification when multiple devices are configured. The device with the lowest number receives the notification.</td>
</tr>
<tr>
<td>Active</td>
<td>A flag that indicates if the device is active.</td>
</tr>
<tr>
<td>Related list</td>
<td></td>
</tr>
<tr>
<td>Notification Device</td>
<td>Additional, optional attributes of an SMS device used inside an advanced script from the SMS service provider. These attributes are generally used to deliver SMS notifications to an internal SMS distribution technology. This advanced scripting procedure is not necessary for configuring external SMS providers.</td>
</tr>
<tr>
<td>Variables</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** If you inactivate a device, it still appears in the user preferences, but the switches that allow users to select the notifications are grayed out for that device column.

### Edit a notification device in UI15 and earlier

All users can edit their notification preferences, including notification devices.

**Before you begin**

Role required: none

**Procedure**

1. Navigate to **Self-Service > My Profile**.
2. Click **Notification Preferences**.
3. Click the name of the existing device.

The device form opens allowing you to make certain modifications, depending on your user role. See **Set up a notification device in UI15 and earlier** for a description of all fields.
Add personal subscriptions in UI15 and earlier

After setting up your devices, you can subscribe to notifications that are configured as subscribable.

Before you begin
The Subscription Based Notifications 2.0 plugin must be active.

About this task
If you have subscribed to messages, your list of notification messages can build over time. You can create preferences for how and when these messages are delivered, or unsubscribe to messages that are not configured as mandatory.

Note: Conditions that you apply to personal subscriptions do not override the filters that the administrator creates for the subscribable notifications. Your conditions are evaluated after the conditions on the subscribable notification are met. If the notification filter set by the administrator fails, the filter conditions on your personal subscription are not evaluated.

Procedure
1. Navigate to Self-Service > My Profile to open your user profile.
2. Click the Notification Preferences related link. The Notification Preferences page opens. You can see your personal subscriptions and the general notifications that you are subscribed to.
3. Click Subscriptions.
4. Click Add Personal Subscriptions.
5. Fill in the fields as described in the table.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name for the subscription.</td>
</tr>
<tr>
<td>Notification</td>
<td>The notification to subscribe to. You can only subscribe to notifications that are configured to allow subscriptions.</td>
</tr>
<tr>
<td>Table</td>
<td>The table that the incident is configured to run on. You cannot modify the table from this form. To select another table, configure the notification. See Create an email notification.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box indicating whether the subscription is active. Users can receive notifications for subscriptions only if the subscription is active. If it is not active, the on-off switch for the subscription is set to off and is read-only.</td>
</tr>
<tr>
<td>Send to</td>
<td>The devices that this subscription is sent to. Selecting the devices in this field is the same as turning on the switch for the subscription on the Subscriptions page.</td>
</tr>
<tr>
<td>Affected record</td>
<td>The specific record that the subscription is based on. Click the lookup icon, and then select the table and the specific record in that table.</td>
</tr>
<tr>
<td>Send when</td>
<td>Another condition that must be met to send the notification. For example, you might select a filter whose conditions send notifications when an incident with a priority of 1 - Critical is opened for a network issue. The system evaluates the conditions in this filter after the conditions set in the notification filter by the administrator.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

7. You can turn the subscription for active subscribable notifications on or off using the switch on the Subscriptions management section of the Notification Preferences page.

Personal subscriptions are saved in the Notification Subscriptions [sys_notif_subscription] table. The records in this table are made active or...
inactive when you slick the switch to subscribe or unsubscribe from the notification.

8. You can edit the subscription at any time by clicking **Edit** next to it.

**Select notifications in UI15 and earlier**

Administrators can configure notification preferences for each user and users can also select which notifications they want to receive for various devices.

**Procedure**

1. Navigate to **Self-Service > My Profile** to select your own notifications, or if you have admin access, navigate to **User Administration > Users** to select notifications for another user.

2. Click a user record to open it.

3. On the User form, click **Notification Preferences** under Related Links.

   The notification preferences page appears. The preferences pages show all the notifications available to the user and the devices that the user has configured, such as email or mobile phone. If a user does not have read access to the table on which the notification is based, the notification does not appear.

   Every user has the **Primary email** device, where subscriptions to email notifications can be enabled.
4. Click the switch next to the notification to subscribe the user to it.

Modify notifications for a user device in UI15 and earlier

After you set up the devices through which users receive notifications, you can assign the notifications to each device and add advanced conditions to limit what notifications are received.

Before you begin
Role required: admin

Procedure
1. On the Notification Preferences page for a user, find the notification from the list of notifications.
2. Click Edit next to the notification. The preferences for that notification appear.
3. Fill in the fields on the form (see table).
4. Click Submit.
Notification preferences for a user's device

Form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification Message</td>
<td>Select the notification. Related fields appear for certain notifications. For example, if you select <strong>CI affected</strong> or <strong>Location affected</strong>, a field appears for selecting the CI or the location. Duplicate messages are not permitted on a device.</td>
</tr>
<tr>
<td>Device</td>
<td>Modify the device if necessary.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Select a schedule that determines when the notification can and cannot be received.</td>
</tr>
<tr>
<td>Filter</td>
<td>Select a pre-configured filter with the criteria that determines when the notification can be sent. For example, you might select a filter whose conditions send notifications when an incident with a priority of <strong>1 - Critical</strong> is opened for a network issue. The system evaluates the conditions in this filter after the conditions in the notification filter set by the administrator. This field is not available when an advanced filter is configured.</td>
</tr>
<tr>
<td>Advanced filter</td>
<td>Select this option if you want to use the condition builder to create additional criteria. When you select the check box, the Table and Conditions fields replace the Filter field.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table for the notification. For example, if you select the <strong>CI affected</strong> notification message, you might select the Incident [incident] or Change Request [change_request] table.</td>
</tr>
</tbody>
</table>
Create a service provider
Administrators can configure service providers for devices that use SMS.

Before you begin
Role required: admin

About this task
Administrators also have the option of configuring how a device's service provider affects the construction of the device's email address.

Procedure
1. Navigate to the Notification Service Provider [cmn_notif_service_provider] table by typing `cmn_notif_service_provider.list` in the application navigator filter.
2. Fill out or change the fields on the form (see table).
3. Click **Update**.
4. Click **Save** on the Notification Preferences page.

### The Notification Service Provider form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Configured name of the service provider.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of device, in this case <strong>SMS</strong>.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Enables or disables this notification device.</td>
</tr>
<tr>
<td>Advanced notification</td>
<td>Removes all the previous options and displays the <strong>Advanced script</strong> field.</td>
</tr>
<tr>
<td>Advanced script</td>
<td>Used for custom notifications that run a script rather than construct a traditional SMS/email. This is generally used when all outbound SMS messages must run through a central SMS hub, as opposed to being sent directly from the instance to the SMS provider. Advanced users can construct a script in this field that will send a notification to an old style numeric pager that cannot receive SMS communications. This field is rarely used and employs advanced scripts. Contact your representative to assist you with any advanced SMS scripting.</td>
</tr>
<tr>
<td>Construct address manually</td>
<td>Removes the prefix and suffix options and displays the <strong>Construction script</strong> field.</td>
</tr>
<tr>
<td>Construction script</td>
<td>Allows you to script the email address construction as you would in a business rule. For example, abc + current.phone_number + <a href="mailto:def@text.att.net">def@text.att.net</a> would construct an email address of <a href="mailto:abc2223334444def@text.att.net">abc2223334444def@text.att.net</a>. <strong>NOTE</strong>: Current is a reference to the device, not the service provider, hence the current.phone_number variable that uses the device's phone_number value.</td>
</tr>
<tr>
<td>SMS Provider Email Prefix</td>
<td>Places the provided text before the device's specified phone number; for example: <a href="mailto:PREFIX2223334444@text.att.net">PREFIX2223334444@text.att.net</a></td>
</tr>
<tr>
<td>SMS Provider Email Suffix</td>
<td>Places the provided text after '@' sign; for example: 2223334444@SUFFIX</td>
</tr>
<tr>
<td>Notification Device Variables</td>
<td>Additional, optional attributes of an SMS device used inside an SMS service provider's <strong>Advanced script</strong>. This is generally used to deliver SMS notifications to an internal SMS distribution technology. This is an advanced scripting procedure and is not necessary for configuring external SMS providers.</td>
</tr>
</tbody>
</table>

**Select a service provider**

You can configure how a device's service provider affects the construction of the device's email address.
Before you begin
Role required: admin

Procedure
1. Navigate to User Administration > Users and open any user's record.
2. Under Related Links, click Notification Preferences, and then click an SMS notification device.
3. If no SMS device is present, click New Device and configure one.
4. Select the appropriate service provider, and then click the reference icon for the Service provider field. The service providers are saved in the Notification Service Provider [cmn_notif_service_provider] table. Only active providers are visible.

SMS notification advanced scripting
You can use these objects and their attributes in your advanced notification scripts on the SMS Notification Service Provider form.

Objects and attributes

<table>
<thead>
<tr>
<th>Object</th>
<th>Example attributes</th>
</tr>
</thead>
</table>
| current | • current.number  
        | • current_assigned_to  
        | • current.company  
        | • current.state  |
| email  | • email.notify  
        | • email.sourceTable  
        | • email.contentType  
        | • email.attachments  
        | • email.HTML  
        | • email.dataVersionHeader  
        | • email.UID  
        | • email.allowSavingNoRecipientEmail  
        | • email.recipients  
        | • email.ignore  |
### Objects and attributes (continued)

<table>
<thead>
<tr>
<th>Object</th>
<th>Example attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• email.save</td>
</tr>
<tr>
<td></td>
<td>• email.headers</td>
</tr>
<tr>
<td></td>
<td>• email.sysID</td>
</tr>
<tr>
<td></td>
<td>• email.attachmentLimits</td>
</tr>
<tr>
<td></td>
<td>• email.class</td>
</tr>
<tr>
<td></td>
<td>• email.sysId</td>
</tr>
<tr>
<td></td>
<td>• email.textLabel</td>
</tr>
<tr>
<td></td>
<td>• email.hashCode</td>
</tr>
<tr>
<td></td>
<td>• email.weight</td>
</tr>
<tr>
<td></td>
<td>• email.equals</td>
</tr>
<tr>
<td></td>
<td>• email.logEmail</td>
</tr>
<tr>
<td></td>
<td>• email.reset</td>
</tr>
<tr>
<td></td>
<td>• email.wait</td>
</tr>
<tr>
<td></td>
<td>• email.body</td>
</tr>
<tr>
<td></td>
<td>• email.SMSText</td>
</tr>
<tr>
<td></td>
<td>• email.watermark</td>
</tr>
<tr>
<td></td>
<td>• email.textLabelLegacy</td>
</tr>
<tr>
<td></td>
<td>• email.sourceHeader</td>
</tr>
<tr>
<td></td>
<td>• email.subject</td>
</tr>
<tr>
<td></td>
<td>• email.instance</td>
</tr>
<tr>
<td></td>
<td>• email.importance</td>
</tr>
<tr>
<td>device</td>
<td>• device.service_provider</td>
</tr>
<tr>
<td></td>
<td>• device.group</td>
</tr>
<tr>
<td></td>
<td>• device.order</td>
</tr>
<tr>
<td></td>
<td>• device.sys_id</td>
</tr>
<tr>
<td></td>
<td>• device.sys_updated_by</td>
</tr>
<tr>
<td></td>
<td>• device.sys_created_by</td>
</tr>
<tr>
<td></td>
<td>• device.primary_email</td>
</tr>
</tbody>
</table>
Objects and attributes (continued)

<table>
<thead>
<tr>
<th>Object</th>
<th>Example attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• device.schedule</td>
</tr>
<tr>
<td></td>
<td>• device.name</td>
</tr>
<tr>
<td></td>
<td>• device.sys_created_on</td>
</tr>
<tr>
<td></td>
<td>• device.email_address</td>
</tr>
<tr>
<td></td>
<td>• device.active</td>
</tr>
<tr>
<td></td>
<td>• device.phone_number</td>
</tr>
<tr>
<td></td>
<td>• device.sys_mod_count</td>
</tr>
<tr>
<td></td>
<td>• device.sys_updated_on</td>
</tr>
<tr>
<td></td>
<td>• device.user</td>
</tr>
<tr>
<td></td>
<td>• device.sys_meta</td>
</tr>
<tr>
<td></td>
<td>• device.type</td>
</tr>
</tbody>
</table>

Make a notification mandatory

To prevent users from turning off or deleting a subscription to a notification, make the notification mandatory.

Before you begin
Role required: admin

About this task
When you make a notification mandatory, the notification is locked in user notification preferences, preventing the user from removing or unsubscribing to the notification, filtering it, or changing the schedule.

Users receive mandatory notifications even if they disable notifications.

⚠️ Note: Mandatory notifications apply to only the primary device of the user. You cannot make a notification mandatory for secondary devices.

Procedure

1. Navigate to System Notification > Email > Notifications.
2. Open the appropriate notification.
3. Configure the form and add the Mandatory field. This field does not display by default.
a. Click the context menu icon ( ) and select **Configure > Form Layout**.

b. Using the slushbucket, select the **Mandatory** field and the order in which you want the field to appear.

c. Click **Save**.

4. Select the **Mandatory** check box.

When a user checks their notification preferences, the control button for the mandatory notification is on and is read only.

---

**Force a notification to be sent**

To force a notification to be sent to the specified users, enable forced delivery.

**Before you begin**

Role required: admin

**About this task**

Forcing a notification means that the relevant users receive the notification, even if they have not subscribed to the notification or have turned off the subscription. In addition, the users receive the notification even if the **Notification** field is set to **Disable**.

**Note:** Forced delivery applies to only the primary device of the user. You cannot force a notification to be sent to secondary devices.
Procedure
1. Navigate to System Notification > Email > Notifications.
2. Open the appropriate notification.
3. Configure the form and add the Force delivery field.
4. Select the Force delivery check box.
5. Click Update.
   Unlike using the Mandatory option, forcing the delivery does not lock the user's preference or prevent the user from unsubscribing from the notification.

Create a notification filter
Notification filters enable a user to control the delivery of messages by creating special conditions on multiple tables in a single, reusable filter.

Before you begin
Role required: admin

About this task
For example, you can create a filter that controls message delivery when active incidents, problems, and change requests for network issues reach a critical state. For UI15 and earlier interfaces, notification filters are available for selection in the Filter field of a user's Notification Preferences form. For UI16, filters for notifications or channels are set through the Notifications tab of the System Settings window. For details, see Apply notification conditions.

Note: The system applies the user's filter conditions after the administrator's conditions have been evaluated. If the administrator's conditions fail, the system ignores notification filters.

Procedure
1. Navigate to System Notification > Email > Notification Filters and create a record.
2. In the Notification conditions related list of the new record, create and submit filter conditions on one or more tables.
3. Repeat the procedure to create additional conditions on other tables for this filter.

### Filter device notifications using a schedule

You can associate devices, such as Email, SMS, and Voice, to schedules that define when the devices can and cannot receive notifications.

**Before you begin**

Role required: admin

**About this task**

Notifications that are triggered outside of the scheduled days and times for the device are not queued up for delivery at a later time. For example, if
an administrator selects the **Weekdays** schedule for an email device, the
device receives email notifications triggered between Monday and Friday. If
notifications are triggered on Saturday, they are not delivered to the device.

**Procedure**

1. Define schedules as needed using **System Scheduler > Schedules > Schedules**.
2. Add or edit a device.
3. Configure the New Device for System Administrator form and add the **Schedule** field.
4. In the **Schedule** field, select the schedule for the device.
5. Click **Submit**.

**Edit the schedule or filter of an existing notification message**

You can update a schedule or filter that was previously created for an email notification.

**Before you begin**

Role required: admin

**About this task**

To edit the schedule or filter of an existing notification message:

**Procedure**

1. In the Notification Preferences screen, click the message to edit.
   You cannot edit any attributes of a mandatory message.
2. Make the appropriate changes in the form.
3. Click **Update**.

**Email unsubscribe**

Administrators can add unsubscribe links to notifications so that users can stop receiving particular email messages.

ℹ️ **Note:** The base system notifications include unsubscribe and notification preferences links.

The system offers two types of macros to create unsubscribe links.
• An unsubscribe link that creates an email message to the instance.
• An unsubscribe link that opens the notification preferences for the user on the instance.

### Available unsubscribe macros

<table>
<thead>
<tr>
<th>Unsubscribe type</th>
<th>Macro used</th>
<th>Description</th>
<th>Available parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unsubscribe by email (Unauthenticated)</td>
<td>${NOTIF_UNSUB}</td>
<td>The system generates an HTML mailto hyperlink. When users click the link, their browser or email client creates a pre-formatted unsubscribe email message to the instance.</td>
<td><strong>link_text</strong>: specify the text to display as a link within quotation marks.</td>
</tr>
<tr>
<td>Unsubscribe by notification preferences (Authenticated)</td>
<td>${NOTIF_PREFS}</td>
<td>The system generates an instance link directly to the notification preferences for this notification type.</td>
<td><strong>link_text</strong>: specify the text to display as a link within quotation marks.</td>
</tr>
</tbody>
</table>

Administrators can add unsubscribe macros to any notification record type such as:

• Email layouts
• Email templates
• Email notifications

### Unsubscribe by email

Unsubscribe by email requires the user email client or browser to create a pre-formatted email message containing these elements:

• The **To** field has the email address of the instance.
• The **Subject** starts with the string *Unsubscribe from*.
• The **Body** has a JSON string with a name-value pair of `Unsubscribe` and an array value that contains two more name-value pairs.
  - The **notification_id** parameter specifies the Sys ID of the notification the user wants to unsubscribe from.
  - The **unsub_token** parameter specifies an instance ID the system uses to verify that the email came from a ServiceNow instance.
Some email clients and web browsers, such as GMail on Chrome, require extra client configuration to support mailto hyperlinks. Administrators can provide an alternative unsubscribe method for users whose email client or browser does not support mailto links. See RFC6068 for information about the mailto URI scheme.

The Unsubscribe from Notification inbound action processes the email and unsubscribes the sender from the listed notification.

Unsubscribe by notification preferences

Unsubscribe by notification preferences requires the user's browser to navigate to the notification preferences page on the instance. After logging in, the system displays the notification preferences for this particular notification.

Users can set preferences for this notification such as disabling notifications for a particular device. Users must save their notification preferences for changes to take effect.

Example: Unsubscribe links

This email layout adds several unsubscribe links to the bottom of each email notification.

```
$\{NOTIF_UNSUB\} from this notification by email or $\{NOTIF_UNSUB+link_text="click here"\}.

Manage your $\{NOTIF_PREFS\} or $\{NOTIF_PREFS+link_text="click here"\}.
```

When rendered in an email notification, the unsubscribe links only display the link text.
If a user clicks the **Unsubscribe** link, the email client creates a message such as this:
Sample unsubscribe by email message

Notifications in messaging applications

Enable users to receive their ServiceNow platform notifications in Slack or Microsoft Teams messaging applications. Use the Now Actions app to configure the messaging apps for your instance.

Admin setup

To enable ServiceNow notifications within Slack or Microsoft Teams, you must be an administrator for both ServiceNow and the third-party application.

1. Request IntegrationHub

   The Slack and Microsoft Teams spokes require a Starter subscription to IntegrationHub. To activate IntegrationHub and view available subscription types, see Request an IntegrationHub plugin.

   Note: Messaging notifications do not consume IntegrationHub transactions.

2. Request the Messaging Notification plugin

   To activate this feature, request the Messaging Notification plugin (com.glide.notification.messaging) through the HI Customer Service system. This plugin activates related plugins if they are not already active.

3. Install the Now Actions messaging app for Slack or Microsoft Teams

   As an administrator for both ServiceNow and the third-party application, find and install the Now Actions app. Install the application in ServiceNow to associate the app with your instance.
Note: The primary owner of a Slack workspace or organization owns and manages the application. To avoid losing admin access to the workspace or organization, transfer primary ownership before any administration changes occur. If you transfer primary ownership, update the JSON payload for the Slack installation in the Notification Integration page. For more information about editing the Slack installation, see Install the Now Actions messaging app.

If the Now Actions app is uninstalled, the workspace or team displays as inactive in the Notification Integration page. To view the Notification Integration page, navigate to System Notification > Messaging > Messaging Integration Configuration.

4. Configure message content

Create a message in the Message Contents [messaging_content] table that you can use in multiple notifications. Messages can be informative, or they can request action from an individual Slack or Teams user. For example, the Approval Request message includes Approve and Reject buttons to take the associated action in ServiceNow. Only users that have linked their Slack or Teams account with their ServiceNow account can take action in ServiceNow from the third-party application.

5. Create a messaging notification

Notifications define when a message is sent, who it is sent to, and what it contains. To send a notification to Slack or Teams, add a messaging content record to the notification and configure the notification messaging channel. Notifications that require action must be sent to individual users instead of groups.

Note: Message Channel Sync Job can sync more than 1000 channels using pagination.

User setup

To enable individual ServiceNow notifications in Slack or Microsoft Teams, and to take action on notifications, configure your system settings and link your user accounts.

Link your ServiceNow user account to your Slack or Microsoft Teams account

Link your ServiceNow account to your Slack or Teams account to take action on ServiceNow notifications from within Slack or Teams. If you do not link accounts, you can still receive notifications within
Configure system settings

Each user can enable ServiceNow notifications in a third-party application by configuring the communication channel in their system settings. Opt in to receive approval requests and other actionable notifications in third-party channels.

Notification channels

In ServiceNow, a notification channel is a method or device for receiving notifications. For example, in the base system you can elect to receive notifications through email or SMS channels. If messaging applications are enabled on your instance, you can enable notifications to Slack and Teams using Notification Channels in your system settings.

Actions and events

The Message Actions [messaging_observer_handler] table processes communication channel events, such as adding or deleting a Slack channel, to keep the instance and the third-party application in sync. Only developers creating Slack or Teams applications should add actions to this table. Register new actions with the instance through the Message Event Registry [messaging_observable] table. To remove a base system action, clear the active flag instead of deleting the record.

Logging

The Inbound and Outbound message logs contain information on actions, events, and activities between ServiceNow and the third-party application. Use the logs to identify the content, state, and origin of communications to and from your instance.

Request the Messaging Notification plugin

To activate this feature, request the Messaging Notification plugin (com.glide.notification.messaging) through the HI Customer Service system. This plugin activates related plugins if they are not already active.

Before you begin

Role required: admin

About this task

There are two ways to request a plugin:
• Access the Now Support Service Catalog directly by clicking Service Catalog > Activate Plugin on Now Support.

• Access the Now Support Service Catalog through the All Applications page on your instance by following these steps.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.

3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments. |

5. Click **Submit**.

**Related information**

List of plugins (Rome)

**Install the Now Actions messaging app**

As an administrator for both ServiceNow and the third-party application, find and install the Now Actions app. Install the application in ServiceNow to associate the app with your instance.

**Before you begin**

To activate this feature, request the Messaging Notification plugin (com.glide.notification.messaging) through the HI Customer Service system. This plugin activates related plugins if they are not already active. For more information, see **Request the Messaging Notification plugin**.

Roles required:

- Admin or messaging_admin in ServiceNow
- Administrator for Slack or Teams
Install the Now Actions messaging app for Slack

Install the Now Actions messaging app from the Slack App Directory and associate the app with your instance.

Procedure

1. Install the Now Actions app from the Slack App Directory.
   b. Click Authorize when prompted.
   c. Enter a customized name, app description, and icon (optional).
   d. Configure your Now Actions web address. This is the base URL for your instance. For example, https://<instance_name>.service-now.com/.
   e. Copy the JSON configuration found in the Add your Slack credentials to your app section for use in later steps.
2. Associate your Slack app with your instance.
   a. Navigate to System Notification → Messaging Integration Configuration.
   b. Click the Install button next to Slack.
   c. In the JSON Configuration pop-up, paste in the JSON configuration you copied in earlier steps.
3. Check for installation verification. The Slack workspace should appear below the Slack heading on the Notification Integration page.

During installation, the instance synchronizes with all public Slack channels in the workspace. New public channels added after installation will automatically synchronize with the instance. You can browse to System Notification > Messaging Channels on your instance to verify that the new channel appears on the instance.

What to do next
To update the app after installation, use the Configure JSON Payload and Settings on Slack icons on the Notification Integration page. You can view the JSON payload, view app credentials, change app appearance, or delete the app.
Install the Now Actions messaging app for Microsoft Teams

Associate the Now Actions messaging app with your instance.

**Procedure**

1. Associate your Microsoft Teams app with your instance.
   
   a. Navigate to **System Notification → Messaging Integration Configuration**.
   
   b. Click the **Install** button next to Microsoft Teams.
   
   c. A pop-up message appears to confirm redirection to Microsoft Teams to verify your identity. Click **OK**.

   ![Entering a third-party site](image)

   d. When prompted, log in to Microsoft Teams with your Teams admin account.
   
   e. Click **Accept** to accept the permissions for the app.
f. If the selected workspace has already been assigned, you are asked whether you want to proceed to overwrite the previous assignment. Click Override to change the workspace, or click Cancel to leave the current assignment in place.

g. After authentication, installation will start in the background. Once installation completes, a message appears confirming the installation.
h. Click the **app package** link to access a knowledge base article KB0690098, containing the application package for Microsoft Teams. Follow the steps in the article to make this package available for your Microsoft Teams users.

2. Check for installation verification. The new team should appear below the Teams heading on the Notification Integration page.

During installation, the instance synchronizes with all public Teams channels. To add channels created after the install, open Microsoft Teams and @mention the app from the new channel. You can browse to **System Notification > Messaging Channels** on your instance to verify that the new channel appears on the instance.

**What to do next**

To receive a ServiceNow notification in Microsoft Teams, create a message and a notification. See **Configure message content** and **Create a messaging notification**.

**Configure message content**

Create a message in the `Message Contents [messaging_content]` table that you can use in multiple notifications. Messages can be informative, or they
can request action from an individual Slack or Teams user. For example, the Approval Request message includes Approve and Reject buttons to take the associated action in ServiceNow.

Before you begin
Role required: admin or messaging_admin

About this task
To enable users to take actions in Slack or Teams, use the Buttons message type and define scripted behavior. Only users that have linked their Slack or Teams account with their ServiceNow account can take action in ServiceNow from the third-party application.

Procedure
1. Navigate to System Notification > Messaging Content.
2. Open an existing notification record or click New to create a new record.
3. Fill in or modify the fields as appropriate.

### Messaging content fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the message.</td>
</tr>
<tr>
<td>Type</td>
<td>Select a type of message.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Simple</strong>: Send an informative message to an entire Team or Slack channel.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Buttons</strong>: Send a message to an individual user in Slack or Teams and define the desired behavior in the Script field. Associate buttons in the message with actions in ServiceNow. Use the Approval Request as an example.</td>
</tr>
<tr>
<td>Target table</td>
<td>To use record content in your message, select the appropriate table.</td>
</tr>
<tr>
<td>Fields</td>
<td>Select which fields from the <strong>Target table</strong> appear in a simple message. Changing the order of the fields changes the display order in the notification.</td>
</tr>
<tr>
<td>Message heading</td>
<td>Enter text to appear at the top of the message.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Message</td>
<td>Enter the content of the message. Use notification variables to include dynamic information in your message. For example, use <code>Incident ${number}</code> to include the incident number in the message. For available variables, see Notification variables.</td>
</tr>
<tr>
<td>Buttons</td>
<td>Select or create buttons to use on the form. After selecting or creating a button, you must define button behavior in the Script field. Only visible when Buttons is selected in the Type field</td>
</tr>
<tr>
<td>Script</td>
<td>This field is only visible when Buttons is selected in the Type field. Enter a script to define what happens in your instance when a user selects a button in Slack or Microsoft Teams. Use the <code>actions.get</code> method to return the name of the button selected by the user.</td>
</tr>
</tbody>
</table>

```javascript
if (actions.get('button') == 'Approve') {
    target.state = 'approved';
    target.update();
}
```

In this example, the script conditionally executes when the "Approve" button is selected.

Use the method `sn_notification.Messaging.send` to send information to the messaging window.

```javascript
var content = new GlideRecord("messaging_content");
content.get("1bb10839572213007f004758ef94f9c4");
sn_notification.Messaging.send(application, userId, content, target);
```

In this example, the script stores a Message Content record in the `content` variable. It then posts a message from that Message Content record.

| Application | Select the application scope for this notification. |

4. Click Submit

Example:
This example shows the output of a message in Microsoft Teams. This message is of the buttons type, which shows buttons and performs scripted actions based on the user selection. In this case, the script uses the
sn_notification.Messaging.send method to display the change in state for the record.

What to do next
Use the message in a notification. For more information about creating notifications, see Create a messaging notification.

Create a messaging notification
Notifications define when a message is sent, who it is sent to, and what it contains. To send a notification to Slack or Teams, add a messaging content record to the notification and configure the notification messaging channel. Notifications that require action must be sent to individual users instead of groups.

Before you begin
Role required: admin

Procedure
2. Click New.
3. Fill in or modify the fields as appropriate.
Use Notifications to notify users about specific activities in ServiceNow, such as updates to incidents or change requests. Notifications allow administrators to specify:
- When to send the notification
- Who receives the notification
- What content is in the notification

## Messaging notification fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the notification. Use descriptive names to ensure that your users are able to easily distinguish between notifications.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table to trigger the message. Must be a table or database view within the same application scope. <strong>Note:</strong> Notifications running on the task [task] table are not supported. Instead, use a table extended from task.</td>
</tr>
<tr>
<td>Category</td>
<td>Select a category for the notification. A category groups related notifications in the system settings. <strong>Note:</strong> Do not leave the category as Uncategorised, as users may not be able to find the notification in their list of notifications.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for this notification.</td>
</tr>
</tbody>
</table>

**Note:** Notification records are shared between messaging, email, and push notifications. Some fields on the form are not relevant to messaging notification records. Leave fields not described here at their default values.

4. Click **Advanced view** under **Related links** to switch the advanced view. Switching to the Advanced view saves the current record.
5. Open the **When to send** tab and complete the form.

Note: If the same trigger generates multiple notifications, the system only sends one notification. The system considers all other notifications, even if they have a different subject and body, as duplicates. The Ignore Duplicates business rule controls this functionality.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Send when | Select under what condition the notification is sent:  
• When a record is inserted or updated  
• When a particular event is fired  
• When triggered as an action step in Flow Designer |
| Weight | Set a numerical value for the notification priority relative to other notifications with the same target table and recipients. The system only sends the notification with the highest weight. The default value 0 causes the system to always send the notification (assuming the conditions are met). |
| Conditions | Use the condition builder to select the conditions under which this notification is sent. For example, select **Priority > greater than > 3 - Moderate** to send the notification only for High and Critical priority incidents. |
### Field | Description
--- | ---
**Inserted** | Select the check box to enable messaging notification when a record is inserted. This field appears when you set the **Send when** field to **Record inserted or updated**.

**Updated** | Select the check box to enable messaging notification when a record is updated. This field appears when you set the **Send when** field to **Record inserted or updated**.

**Event name** | Select the event that triggers this notification. This field appears when you set the **Send when** field to **Event is fired**.

**Advanced condition** | Create a script to define more filter conditions, like sending a notification based on the current messaging record, changing field values, or changing system properties.

The advanced condition script must return **true** or set a global answer variable to **true** to send the notification.

The advanced condition script uses the following global variables:

- **current**: Contains the current record from the table to which the notification is linked.
- **event**: Contains the event that triggered the notification.

**Note**: The **Advanced condition** field is evaluated in addition to other conditions you set on the notification. Both the condition and advanced condition must evaluate to true to send the notification.

---

6. Open the **Who will receive** tab and fill in or modify the following fields.

### Field | Description
--- | ---
**Messaging Channels** | Select the messaging channels to receive the messaging notification. Only complete this field if creating a simple notification to send to a channel. Simple notifications use a Messaging Content record of Type **Simple**.

**Users** | Select the users you want to receive the messaging notification. Only complete this field if creating a notification that requires user action. Notifications that require user action use a Messaging Content record of Type **Buttons**.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Users/groups in fields             | Select users or groups from reference fields. For example, if a notification uses the Incident [incident] table, you can select users or groups from incident fields like **Opened by** and **Assignment group**.  

**Note:** You can dot-walk to values in reference fields by clicking the plus sign in the field selector and then selecting the related field.  

If you address the notification to a user with an inactive record in the User [sys_user] table, the system does not send the notification to that user.  

| Groups                             | Select the groups you want to receive the messaging notification. You can search for groups with the reference lookup icon or by manually entering the group name. This list of groups is static.  

| Send to event creator              | Select this check box to send the notification to the person who performed the action that started the notification process if the person is also a recipient. If the event creator is not specified in one of the recipient fields, the event creator does not receive a notification, regardless of the setting in this field.  

For new notifications, this option is selected by default.  

| Event parm 1 contains recipient    | Select this check box if the event parameter 1 contains one or more notification recipients (in a comma separated-list). This field is visible only when the **Send when** field is set to **Event is fired**.  

| Event parm 2 contains recipient    | Select this check box if the event parameter 2 contains one or more notification recipients (in a comma-separated list). This field is visible only when the **Send when** field is set to **Event is fired**.  

7. Open the **What it will contain** tab and fill in or modify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Messaging content                  | Select a messaging content record to be used in this notification.  

8. Click **Update**.
Link your ServiceNow user account to your Slack or MS Teams account for Now Actions

Link your ServiceNow account to your Slack or Teams account to take action on ServiceNow notifications from within Slack or Teams. If you do not link accounts, you can still receive notifications within group channels. However, you cannot to approve ServiceNow requests or take action on notifications from within Slack or Teams.

Before you begin
Role required: none

Procedure
1. Open the Slack or Teams application
2. Find the Now Actions bot. This bot is found in the left panel of Slack under Apps, and in the left panel of Teams in the Chat tab.
3. Start a conversation with the Now Actions bot. The bot then presents a link to authenticate.

Authentication message

4. Click the Connect to ServiceNow link.
   A new browser tab opens and prompts the user to Deny or Confirm the connect between your Slack or Teams account and your ServiceNow account. This link will expire five minutes after it is displayed.
5. Click Confirm to link the accounts.
6. After confirmation, you are directed to the instance user record. A confirmation message is displayed at the top of the screen.

Configure system settings
Configure the system settings of your instance to set the UI experience that you want.

Before you begin
Role required: admin

About this task
You can customize your general settings, theme, accessibility, lists, forms, notifications, and developer tools. You can also switch your instance UI to a previous version.

Procedure
1. Click the settings icon (⚙️) in your instance header.
2. In the System Settings modal, select a tab and change your system settings.
<table>
<thead>
<tr>
<th>Tab</th>
<th>System Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td><strong>Compact user interface:</strong> Option to display a compact user interface.</td>
</tr>
<tr>
<td><strong>Compact list date/time</strong></td>
<td><strong>Compact list date/time:</strong> Option to display a compact list date and time.</td>
</tr>
<tr>
<td><strong>Keyboard shortcuts enabled</strong></td>
<td><strong>Keyboard shortcuts enabled:</strong> Option to enable keyboard shortcuts.</td>
</tr>
<tr>
<td><strong>Home</strong></td>
<td><strong>Home:</strong> Option to select <strong>Homepages</strong> or <strong>Dashboards</strong> for your instance home.</td>
</tr>
<tr>
<td><strong>Date/Time</strong></td>
<td><strong>Date/Time:</strong> Select <strong>Calendar, Time Ago, or Both.</strong></td>
</tr>
<tr>
<td><strong>Time zone</strong></td>
<td><strong>Time zone:</strong> Time zone displayed in your instance.</td>
</tr>
<tr>
<td><strong>Printer friendly version</strong></td>
<td><strong>Printer friendly version:</strong> Printer-friendly version of a notification.</td>
</tr>
<tr>
<td><strong>Theme</strong></td>
<td><strong>Theme:</strong> Color scheme for your instance.</td>
</tr>
<tr>
<td><strong>Accessibility</strong></td>
<td><strong>Accessibility:</strong> Accessibility features for your instance.</td>
</tr>
<tr>
<td><strong>Data visualization patterns enabled</strong></td>
<td><strong>Data visualization patterns enabled:</strong> Option to enable data visualization patterns.</td>
</tr>
<tr>
<td><strong>Accessibility enabled:</strong></td>
<td><strong>Accessibility enabled:</strong> Option to enable accessibility.</td>
</tr>
<tr>
<td><strong>Enable Accessibility to toggle these features.</strong></td>
<td><strong>Enable Accessibility to toggle these features.</strong></td>
</tr>
<tr>
<td><strong>Show tooltips on forms</strong></td>
<td><strong>Show tooltips on forms:</strong> Option to show tooltips on forms. Tooltips display when you point to a UI element.</td>
</tr>
<tr>
<td><strong>Show Date &amp; Time format in field label</strong></td>
<td><strong>Show Date &amp; Time format in field label:</strong> Option to show date and time format in field labels.</td>
</tr>
<tr>
<td><strong>Show Record Preview tooltips on Slushbucket items when available</strong></td>
<td><strong>Show Record Preview tooltips on Slushbucket items when available:</strong> Option to show record preview tooltips on slushbucket items when available. Tooltips</td>
</tr>
<tr>
<td>Tab</td>
<td>System Setting</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Lists</strong>: List preferences for your instance.</td>
<td><strong>Wrap longer text in list columns</strong>: Option to wrap text in list columns.</td>
</tr>
<tr>
<td><strong>Forms</strong>: Form preferences for your instance.</td>
<td><strong>Tabbed forms</strong>: Option to enable tabbed forms. Related list loading: Select <strong>With the Form, After Form Loads</strong>, or <strong>On-demand</strong>.</td>
</tr>
<tr>
<td><strong>Notifications</strong>: Notification settings for your instance.</td>
<td><strong>Allow Notifications</strong>: Option to enable notifications. To receive notifications for Simple type messages, enable the notification channel. You don’t need to toggle individual notifications. For more information on message types, see Configure message content.</td>
</tr>
</tbody>
</table>
| **Primary email** | - Option to receive email notifications in your primary email.  
- Configure your primary email by clicking the configure icon (▸).  
- **Create Personal Notifications**: Select to configure a personal notification. Select a parent notification from the list and click the configure icon (▸). Child notifications are displayed for each entry. Toggle a notification. |
| **Developer**: Developer tools for your instance. | **Application**: Application of your instance. Set if other than **Global**.  
**Show application picker in header**: Option to display the application picker in your instance header. |
<table>
<thead>
<tr>
<th>Tab</th>
<th>System Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Update Set</strong></td>
<td>Update set for your instance. Select an update set if other than <strong>Global</strong>.</td>
</tr>
<tr>
<td><strong>Show update set picker in header</strong></td>
<td>Option to display the update set picker in your instance header.</td>
</tr>
<tr>
<td><strong>JavaScript Log and Field Watcher</strong></td>
<td>Option to display the JavaScript log and field watcher.</td>
</tr>
<tr>
<td><strong>Automated Test Framework Page Inspector</strong></td>
<td>Option to display the automated test framework page inspector.</td>
</tr>
</tbody>
</table>

| **Switch to UI15** | Switch your instance to U15. Click the button again to return to your current version. |

**Unlink your ServiceNow user account from your Slack or MS Teams account for Now Actions**

Unlink your ServiceNow account from your Slack or MS Teams account to stop receiving actionable ServiceNow notifications in Slack or Teams.

**Before you begin**
Role required: none

**About this task**
If you unlink your account to a messaging app for Now Actions, you must also disable the corresponding messaging channel in your notification preferences.

**Procedure**

1. Navigate to **Self-Service > My Profile**.
2. Click the **View Linked Accounts** related link.
3. In the Linked Accounts page, check the selection box for the messaging integration to be unlinked.
4. Select **Actions on selected rows...**, then click **Unlink account**.
   Your ServiceNow account is unlinked from the Now Actions messaging integration (the link is inactive).

   **Note:** Even though you unlinked your account, you still receive notifications in any group channels to which you belong.
5. Disable the messaging channel in your Notification Preferences.
a. Select the gear icon in the banner frame to access the System Settings window.

b. Under Notification Channels, disable the appropriate messaging channel.

Note: If you want to link your ServiceNow account again, follow the steps in Link your ServiceNow user account to your Slack or MS Teams account for Now Actions.

Set up notifications for a custom Slack app
Send ServiceNow notifications to users via your own Slack bot.

Before you begin
• Request IntegrationHub
• Request the Messaging Notification plugin
• Create a custom application for Slack

Role required: admin or messaging_admin

Procedure
1. Create a JSON for your custom Slack application.

   Ensure that your JSON matches the following example format:

   ```json
   {
   "bot_user_id" : "U9TLFR6TA",
   "scope" : "bot,channels:read",
   "client_id" : "294380102274.335446283495",
   "client_secret" : "ed0da5felf844fdac15a9e1ac1b0b831",
   "verification_token" : "YXSNsRhioCeU8h9Fm2k4ACu0",
   "app_id" : "A9VD48BEK",
   "access_token" : "xoxp-294380102274-295238228534-335452648487-2fac31f923dadd7ff30f2bc8c852809d",
   "bot_access_token" : "xoxp-333695856928-6pNwnO3Y6vN5GI7KCAIPwv6V",
   "team_id" : "T8NB63082",
   "team_name" : "sn-notif-ext-test",
   "user_id" : "U8P706QFQ",
   "bot_username" : "empdmyers1snnotifext"
   }
   ```

   To get the Bot User ID, copy the member ID of the bot user in the Slack app.

   The Scope is always bot,channels:read.
To get the Client ID, Client Secret, and Verification Token, see the Basic Information page in your Slack workspace.

To get the App ID, copy the 9-character identifier from the app URL in your Slack workspace.

To get the Access Token and Bot Access Token, see the OAuth & Permissions page in your Slack workspace.

To get the Team ID, view the HTML source code for your Slack workspace page.

The Team Name is the same as your subdomain in your Slack workspace.

To get the User ID, copy the member ID for your own account in the Slack app.

The Bot Username is the name that you assigned to the bot user in Slack.

2. In your ServiceNow instance, navigate to System Notification > Messaging > Messaging Integration Configuration.

3. Next to the Slack listing, click Install.

4. On the JSON Configuration window, paste the JSON that you created in Step 1.

5. Click Submit.
6. On the confirmation window, click **Skip**.

### Configuration Submitted

You've completed the configuration process in ServiceNow. Now go to Slack to finish configuring the integration.

[Skip] [Go To Slack]

### Results

The system creates a notification channel for your custom Slack app automatically.

### What to do next

- Link ServiceNow user accounts to your custom Slack app so that users can take action on notifications that are delivered by your Slack bot.
- For each user account that you link, enable the notification channel using the system settings.
- Create notifications for your custom Slack app by following the steps in Create a messaging notification and Configure message content.

### Related information

- Slack API documentation

### Provider notification

Send notifications directly to recipients via the provider on supported channels. Notifications can be simple messages for review, or actionable messages with buttons that users can select to perform certain actions.

### Important terms

- **Provider**

  A provider is an implementation that delivers notifications to destinations of a specific channel.

- **Channel**
A channel represents a particular communication mechanism with a recipient.

**Destination Type**

A destination type represents a logical way of categorizing a destination for the underlying channel and is required to send via a channel, as well as set a preference. As an admin, you can modify the notification **Auto Opt-in** behavior for a destination type.

**Destination**

A destination is a specific contact information of a recipient for a channel. It includes a destination type and an identifier suitable for use in the channel. Destination Type sent by default is either set to true or false during the adapter installation. This determines if the destination type is opt-in or opt-out.

- If sent by default is set to true, notifications are delivered to the recipients if they have not explicitly opted-in/out to receive a notification on the destination type.
- If sent by default is set to false, notifications are not delivered to the recipients if they have not explicitly opted in to receive the notification on the destination type.

**Destination preference precedence**

Notifications are delivered to the destinations that honor the following preference precedence:

1. Notification preference of the recipient
2. Destination preference of the recipient
3. Destination Type send by default. You also have the option to modify **Auto Opt-in** behavior for a destination type.

**Common content for a notification**

Provide common notification content so that different notification channels can use the same generic content.

**Actionable notification**

Enable provider admins to define an actionable notification and send it to users. You can also enable response actions.

ℹ️ **Note:** A notification should either have Common Content or Provider Content in order to be delivered to the recipients.
Note: All the above-mentioned capabilities are applicable only for Virtual Agent and Workspace providers.

Create a provider notification

Execute the following steps to create a provider notification for Virtual Agent and Workspace providers.

Before you begin
Role required: admin

Procedure
1. Navigate to System Notification > Provider > Notifications and select New.
2. On the form, fill in the fields.

Notifications form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the notification.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to receive notifications about.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the notification.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the notification. The notification is active by default.</td>
</tr>
<tr>
<td>Trigger</td>
<td>System action that triggers the notification. You can send the notification after a record is changed or after an event is triggered.</td>
</tr>
<tr>
<td>Inserted</td>
<td>Option to send the notification after a record is inserted. This field appears when you select Record Change in the Triggered By field.</td>
</tr>
<tr>
<td>Updated</td>
<td>Option to send the notification after a record is updated. This field appears when you select Record Change in the Triggered By field.</td>
</tr>
<tr>
<td>Event</td>
<td>Event that triggers the notification. For example, to send a notification after an incident is closed or resolved, you would select the incident.inactive event. By default, this event is logged in the system each time a user resolves or closes an incident.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Note</td>
<td>You can select only an event that shares the same table as the notification. This field appears when you select <strong>Event</strong> in the <strong>Triggered By</strong> field.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Filter to specify the table records that users receive notifications about. For example, to send notifications about top-priority incidents, you would select <strong>Incident</strong> [incident] in the <strong>Table</strong> field and set the conditions to <strong>[Priority] [is] [1 - Critical]</strong>.</td>
</tr>
<tr>
<td>Audience</td>
<td>Users who receive the notification. <strong>Note:</strong> Notifications in messaging channels are sent only to users with ServiceNow accounts (sys_user profiles). Consumers and customer contacts are considered as guests and cannot receive notifications in messaging channels.</td>
</tr>
<tr>
<td>Users in fields</td>
<td>Record fields that include users who receive the notification. For example, to send the notification to the record assignee, select <strong>Assigned to</strong>.</td>
</tr>
<tr>
<td>Is originating user included?</td>
<td>Option to include the user who changed the record or triggered the event.</td>
</tr>
</tbody>
</table>

3. Select **Submit**.

**Note:** Use the **Submit** button for Virtual Agent notifications. The **Submit and Add Common Content** button is for other use cases.

**Create and update a provider notification for all users**
Create a new notification in the notification provider framework to send to both sys and non-sys users.

**Before you begin**
Role required: admin and notifications provider admin

**Procedure**
1. Navigate to **System Notification > Provider > Notifications**. A list of notifications shows up.
2. Click **New** to create a new notification.

3. Fill in the fields in the Notification form.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the notification</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of the notification record</td>
</tr>
<tr>
<td>Table</td>
<td>Table name on which the notification is triggered</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the notification</td>
</tr>
<tr>
<td>Triggered By</td>
<td>Trigger used in the notification record</td>
</tr>
</tbody>
</table>

**Note:** The options in this field depend on the selected table. For example, if you select an incident table, the options are Events or Record Change.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inserted</td>
<td>Condition to trigger the notification</td>
</tr>
<tr>
<td>Updated</td>
<td>Condition to trigger the notification</td>
</tr>
<tr>
<td>Conditions</td>
<td>Additional conditions to trigger the notification</td>
</tr>
<tr>
<td>Users</td>
<td>Names of the available sys users</td>
</tr>
<tr>
<td>Recipients in fields</td>
<td>Field in the currently selected table that contains the users who receive an email notification</td>
</tr>
</tbody>
</table>

**Note:** The **Recipients in fields** field under Recipients allows you to choose both sys and non-sys users to send notifications to.

| Is originating user included? | Option to include the originating user to be included in the notification |

4. Click **Submit**.

**Note:** If you want to add common content immediately after submitting the notification record, click **Submit and Add Common Content**. See [create common content](#) for more information.
5. Open the recently created notification.

6. Update the form using any of the available related lists. See Create and add additional recipients for more information.

Create and add additional recipients

Update the notifications form by adding additional recipients from the Additional Recipients related list to send notifications to.

Before you begin
Role required: admin and notifications provider admin

Procedure

1. Click Additional Recipients related list on the notification form to add new recipients.

   Note: An error message about adding content to the notification shows up. See create common content and create default content to create content for a notification.

2. Click New in the Additional Recipients related list to add additional recipients. The Additional Recipients form shows up.

3. Fill up the fields in the Additional Notification Recipients form.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification</td>
<td>Name of the notification</td>
</tr>
<tr>
<td></td>
<td>Note: The Notification name auto-populates and the Recipient Table field gets User[sys_user] as the default value.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of the recipient record</td>
</tr>
<tr>
<td>Recipient Table</td>
<td>Table name of the recipient</td>
</tr>
<tr>
<td></td>
<td>Note: You can also select a non-sys users table.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the notification</td>
</tr>
<tr>
<td>Static Recipients</td>
<td>Names of static recipients of the notification</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dynamic Conditions</td>
<td>Dynamic filter conditions for the users</td>
</tr>
</tbody>
</table>

**Note:** Click the refresh button next to the records matching condition link to update the exact number of records matching the latest filter condition. By default, it shows the total number of records in the current table.

**Note:** Only one active record can be added for a particular recipient table. If you want to add another record for the recipient table, you will have to deactivate the current record.

**Note:** For one recipient table, we can use either static recipients or dynamic conditions.

4. Click **Submit**.

**Create common content for a notification**

Provide common notification content so that different notification channels can use the same generic content.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Notification > Provider > Notifications**.
   
   A list of notifications shows up.

2. Click either **New** to create a new notification or select an existing notification.

3. Create the common content. There are two ways to create the common content.
   - If you have clicked **New**, do the following.
     - a. Fill the necessary fields on the Notification form to create a new notification record.
     - b. Click **Submit and Add Content**.
• If you have selected an existing notification, do the following.
  a. Scroll down to the Notification Contents related list.
  b. Click **New Shared Content**.
  c. Select **Common** to create common content type.
     The Notification Common Content form shows up.

4. Fill the Notification Common Content form to create a common content.

   ✋ **Note:** The **Short text** and **Long text** fields are the major fields to create a common content.

5. Click **Submit**.

### Create default content in a provider

Create and use the default content for a notification that doesn’t have a content provider or some of the fields in the content provider are not present.

**Before you begin**
Role required: admin

**Procedure**

1. Enter `sys_notification_content.list` in the left navigator.
   A list of **Notification Contents** shows up.

2. Click **New Provider Content**.

   ✋ **Note:** Both shared content and provider content can be default content. Provider content has been considered for this example.

3. Select the type of Notification Content you would like to create.

4. Fill the **Notification Content** form for the type you have selected in the previous step.

   ✋ **Note:** The **is default** field is visible only if the **Notifications** field is not present.

5. Click **Submit**.
   A new default content has been created.

6. Go to **Notification Providers** and select one of the providers.
   The **Notification Providers** form for the selected provider opens.

7. Click the search icon in the **Default content** field to select the default content.

   ✋ **Note:** The **Default content** is associated with a provider through the **Default content** field.
The Select the document modal opens up.

8. Select the default content in the Document field.
   You can select the recently created or any previous default content.

9. Save the changes.

Implementing notification action with a script

Use the Script field in the Notification Action form to update and implement a notification action.

Before you begin
Role required: admin

Procedure
1. Navigate to System Notification > Provider > Notifications.
   A list of notifications shows up.
2. Select an existing notification.
3. Scroll down to the Notification Actions related list.
4. Open the Notification Action form. There are two ways to reach the Notification Action form.
   • If there are no existing notification actions under Notification Actions related list, do the following.
     a. Click New Provider Action under Notification Actions related list.
     b. Select the type of notification action you would like to create from the Notification Action wizard.

   Note: Scriptable Action, Flow Action and Virtual Agent are the only types of notification actions available.
   • If there is an existing notification action, select one from the list under Notification Actions related list.
     The Notification Action form shows up.
5. On the form, update the fields as required.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the actionable notification.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of the actionable notification record.</td>
</tr>
</tbody>
</table>
### Fields | Description
---|---
Notification | Name of the notification containing the actionable notification record.
Active | Option to activate the actionable prompt record.
Script | Script to implement the actionable notification.

6. Click **Update**.

**Select provider notification action capabilities**

Enable provider notification definitions to accept actions as scriptable action, flow actions, and virtual agent.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Notification > Provider > Notifications**.
   
   A list of notifications shows up.

2. Select an existing notification.

3. Scroll down to the related lists.

4. Select the Actions related list.

5. Click **New Provider Action**.
   
   The Notification Action wizard shows up.

6. Select one of the following types of notification actions you would like to create from the Notification Action wizard.

   • Scriptable Action
   • Flow Action
   • Virtual Agent

**Create a scriptable notification action**

Select **Scriptable Action** from the Notification Action wizard to create a scriptable notification action.

**Before you begin**

Role required: admin
Before performing this task, you must complete Select provider notification action capabilities.

**Procedure**

1. Select **Scriptable Action**.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the notification action.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of the notification action record.</td>
</tr>
<tr>
<td>Notification</td>
<td>Name of the notification containing the notification action record.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the notification action record.</td>
</tr>
<tr>
<td>Script</td>
<td>Script to implement the notification action.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**Create a flow notification action**

Select **Flow Action** from the Notification Action wizard to create a flow notification action.

**Before you begin**

Role required: admin

**Procedure**

1. Select **Flow Action**.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the notification action.</td>
</tr>
<tr>
<td>Notification</td>
<td>Name of the notification containing the notification action record.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Async</td>
<td>Option to execute configured flow or action asynchronously.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the notification action record.</td>
</tr>
<tr>
<td>Choose Flow or Action</td>
<td>Option to select either Flow or Action. See Flow Designer for more information.</td>
</tr>
<tr>
<td>Note: You can select either</td>
<td></td>
</tr>
<tr>
<td>Flow or Action, but not both.</td>
<td></td>
</tr>
<tr>
<td>Inputs</td>
<td>Script used for the creation of flow notification action.</td>
</tr>
<tr>
<td>Note: The script returns Json of</td>
<td></td>
</tr>
<tr>
<td>key value pairs, which is passed</td>
<td></td>
</tr>
<tr>
<td>as input in executing configured</td>
<td></td>
</tr>
<tr>
<td>flow or action.</td>
<td></td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**Add actions to the notification content**

Use the Link Actions to Content related list to add actions to the notification content, selection of the provider notification and ordering of actions of an actionable content.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Notification > Provider > Notifications**.
   A list of notifications shows up.
2. Click either **New** to create a new notification or select an existing notification.
3. Scroll down to the related lists and select the Link Actions to Content related list.
4. Click **New** to create an actionable content.
   The Actionable Content form shows up.
5. Fill in the following in the form.
<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the action set</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of the notification</td>
</tr>
<tr>
<td>Notification</td>
<td>Name of the notification</td>
</tr>
<tr>
<td>Actions</td>
<td>Option to select the actions</td>
</tr>
</tbody>
</table>

**Note:** You can now set the order of actions of an actionable content.

<table>
<thead>
<tr>
<th>Provider</th>
<th>Option to select the required provider for the actionable content</th>
</tr>
</thead>
</table>

**Note:** A provider can reuse the actions defined by another provider.

**Note:** In order to avoid confusion with duplicate action names set by different providers, the Actions related list displays the Class of a particular action.

| Active      | Option to activate the action set                   |

6. Click **Submit**.
Email client
Send email directly from any record, such as an incident, change request, or problem record.

Using the email client
You can use the email client either from a form or the record view in a workspace.

• To open the email client from a form, open a record and click the more options menu (●). Click the email icon (✉).

   Note: In UI15, the email icon (✉️) appears in the form header.
• To open the email client in a workspace, open a record and click the menu icon (≡). Click Compose Email.

The email client looks like a standard email interface, which contains a toolbar for text formatting and adding attachments.

![Compose Email](image)

The email client uses the multipart/mixed content type and supports HTML markup in the message body.
**Note:** The **Subject** field on the email client allows a larger character count than the default setting for the **Subject** field on the Email [sys_email] table. If the subject text from the client is being truncated, increase the **Max length** value for the **Subject** field on the Email table.

For more information on using the email client in a workspace, see [Communicating via email in workspace](#).

**Activation information**

The email client is activated with the Email Client plugin (com.glide.email_client), which is active by default on the Now Platform.

The email client is enabled by default on the incident table. To enable the email client for another table, add the `email_client` dictionary attribute on the table’s collection record. For more information, see [Enable the email client for a table](#).

The email client is enabled by default on the change table.

Give users access to the email client by assigning them the email_composer role.

**More setup**

You can configure the email client by creating an Email Client Configuration [sys_email_client_configuration] record. For more information, see [Email client configurations](#).

You can also create email client templates or quick messages to use predefined content in email client messages. For more information, see the following:

- Create an email client template
- Composing emails with quick messages

Optionally, you can give users the option to send email client messages as SMS text messages. For more information, see [Enable SMS delivery with the email client](#).

**Enable the email client for a table**

Enable the email client for a table so that users can send emails directly from the table record.

**Before you begin**

Role required: admin
About this task
The email client is enabled by default on the Incident [incident] table. You can enable the email client for another table by adding the email_client dictionary attribute to the table.

ℹ️ Note: This capability is not inherited by tables that extend the current table. For example, enabling the email client on the Task table does not enable it for the Incident or Problem tables.

Procedure
1. Open a record in the table that you want to enable the email client for. For example, to enable the email client for the Problem [problem] table, navigate to Problem > Open, and then open any problem record.
2. On the form, click the menu icon (☰) and then click Configure > Dictionary.
3. On the Dictionary Entries list, open the first record. The first record has the record type Collection and does not have any entry for Column name.
4. On the form, in the Related Links section, click Advanced view.
5. In the Attributes field, enter email_client=true. If there are other values in the field, separate the attribute with a comma.
6. Click Update.

Components installed with the email client
Several types of components are installed with activation of the Email Client (com.glide.email_client) and Email Client Template (com.glide.email_client_template) plugins, including tables and user roles.

ℹ️ Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email client administrator [email_client_admin]</td>
<td>Configures the email client to fit the needs of your organization.</td>
<td>• email_client_quick_message_author</td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>------------------------------------------------------------</td>
<td>--------------------------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Email composer [email_composer]</td>
<td>Creates email client messages.</td>
<td>• None</td>
</tr>
<tr>
<td>Read-only role for email client templates</td>
<td>Reads email client templates and requests the email client administrator to reconfigure the templates as needed.</td>
<td>• None</td>
</tr>
<tr>
<td>Quick message author [email_client_quick_message_author]</td>
<td>Creates quick messages for users in their group.</td>
<td>• None</td>
</tr>
</tbody>
</table>

**Tables installed**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Client Configuration [sys_email_client_configuration]</td>
<td>Controls for the email client. There is only one Email Client Configuration record for each table that uses the email client.</td>
</tr>
<tr>
<td>Email Client From Address [sys_email_client_from_address]</td>
<td>Email addresses that users can select as the From address of an email client message.</td>
</tr>
<tr>
<td>Recipient Qualifier [sys_recipient_qualifier]</td>
<td>Email addresses that users can send email client messages to.</td>
</tr>
<tr>
<td>Email Client Template [sys_email_client_template]</td>
<td>Templates that are applied automatically to qualified email client messages.</td>
</tr>
</tbody>
</table>
Email client configurations

Use email client configurations to manage the behavior of your email client. Each configuration consists of different email controls for setting allowable email recipients and email addresses.

In new and upgraded instances, the Email Client Configuration module is activated by default through the Email Client plugin (com.glide.email_client).

**Note:** If you upgraded to the Madrid release, a default email client configuration is created automatically during upgrade. This default email configuration is used if you do not define any other email client configurations. Also, if you previously defined certain email client properties to control email address auto-complete, disambiguation, and the display of the From and Reply-To email addresses, those settings are retained in the default email client configuration.

How email client configurations work

Email client configurations determine how your email client behaves, such as whether the From address or Reply-To address should be displayed. A configuration applies to a specific ServiceNow table, which enables you to define email client behavior for a specific context, purpose, or application. For example, if you have email client users who send email about Customer Service case records, you can create a configuration that applies email client controls specific to customer service. You can also select the email client recipient qualifiers for controlling the auto-complete recipient results from a selected table, such as the Customer Contact table.

An email client configuration consists of the following components:

**Email client recipient qualifiers**

Recipient qualifiers control the email recipients returned in the auto-complete results for the To, Cc, and Bcc fields of the email client. You can provide additional qualifiers displayed in the auto-complete results to differentiate recipients that have the same names and narrow the results.

**Note:** Use the To is Optional field in the Email Client Configuration form to make the To: field optional to send an email.

**Email client From addresses**

This control enables the display of the From and Reply-To addresses. Use the Email Client Template to create a set of allowable From addresses that can be used when a user sends an email with the
email client. You can provide a specific From address to be used in the email client, or you can choose to hide it entirely.

Email client attachment handling

By default, attachments that are sent from the email client are attached to the target record. Instead, you can select to attach files to the Email [sys_email] record, or you can set conditions that define which email client attachments are added to the target record. To see the status of all email attachments, go to the Email Attachments [sys_email_attachment] table.

You can also use an Email Client Template to define the content of an email client message and set other message characteristics, such as an email sender (From address) configuration.

Email client configuration process

Users with the admin role define and edit email client configurations. Users with the email_client_admin role can edit configuration information in selected tables.

1. Build the various email client controls that can be used to create an email client configuration.
   - Define email client recipient qualifiers
   - Define email client from addresses

2. Create the email client configuration.
   Define an email client configuration that determines how your email client behaves when users create an email message.

Define email client recipient qualifiers

Create a configuration that controls the auto-complete list of recipients displayed in the email client.

Before you begin
Role required: email_client_admin

About this task
You can specify recipient qualifiers that display additional fields (from a selected ServiceNow table) in the auto-complete list. These fields differentiate email recipients who have the same first and last names.
Use the following tabs in the Email Client Recipient Qualifier form to define a recipient configuration.
- **Display Configuration** – Set up the email recipient auto-complete behavior and optionally select additional fields to differentiate recipients who have the same name. The additional fields ensure that users select the proper recipient for an email.

- **Query Configuration** – Specify a condition or script that queries the selected table and filters the recipient results returned.

You can define different recipient configurations, which can be used in an email client configuration.

**Procedure**

1. Navigate to **Email Client > Email Client Recipient Qualifier** and click **New**.
2. Fill in the fields at the top of the Recipient Qualifier form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for this email client recipient configuration.</td>
</tr>
<tr>
<td>Application</td>
<td>The type of scoped application.</td>
</tr>
<tr>
<td>Table</td>
<td>The ServiceNow table to be queried for recipients.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of this recipient configuration.</td>
</tr>
</tbody>
</table>

3. Fill in the fields in the **Display Configuration** tab to control the auto-complete display in the email client.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Address</td>
<td>The field on the table that contains the recipient email address.</td>
</tr>
<tr>
<td>Display Name</td>
<td>The field on the table used for the recipient name displayed.</td>
</tr>
<tr>
<td>Order</td>
<td>The order of results returned relative to other recipient qualifiers defined.</td>
</tr>
<tr>
<td>Additional Display Fields</td>
<td>A content list for choosing additional fields from the table to be displayed in the auto-complete list.</td>
</tr>
</tbody>
</table>
4. Fill in the fields in the Query Configuration tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prefix Search</td>
<td>Option to find the desired recipient using prefix.</td>
</tr>
<tr>
<td>Note: Selecting the <strong>Prefix Search</strong> option displays the <strong>Last Name Field</strong> drop-down menu with options to filter the recipient's name.</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Select the method for filtering the recipients returned in the auto-complete list:</td>
</tr>
<tr>
<td></td>
<td>• Condition</td>
</tr>
<tr>
<td></td>
<td>• Script</td>
</tr>
<tr>
<td>Conditions</td>
<td>If you selected Condition for the <strong>Type</strong>, use the condition builder to specify the conditions that must be met to return the appropriate recipients.</td>
</tr>
<tr>
<td>Script</td>
<td>If you selected Script for the <strong>Type</strong>, enter a script that uses these variables to return the appropriate recipients:</td>
</tr>
<tr>
<td></td>
<td>• recipientQuery: GlideRecord for the table being queried.</td>
</tr>
<tr>
<td></td>
<td>• targetRecord: GlideRecord for the target record from which the email client was opened.</td>
</tr>
</tbody>
</table>
For example, this recipientQuery is a GlideRecord that represents the Customer Contact table. The targetRecord variable is a Customer Service case from which the email client was opened. This query limits the email client auto-complete results to contacts who belong to the same account as the Customer Service case.

```javascript
(function (recipientQuery, targetRecord)
{
    // Limit results to contacts belonging to the account for the case.
    var account = targetRecord.getValue('account');
    recipientQuery.addQuery('account', account);
})(recipientQuery, targetRecord);
```

5. Click Submit.
The recipient qualifier configuration is added to the Recipient Qualifier [sys_recipient_qualifier] table and is available for use in an email client configuration.

**Define email client from addresses**
Set an allowable email address that is displayed in the From address of a message sent from the email client.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to Email Client > Email Client From Address and click New.
2. In the Display name, enter the name to be displayed in the From field of the email client message.
3. Enter a valid Email address for the From address in the email client.
4. Click **Submit**.
   The From address is added to the Email Client From Address [sys_email_client_from_address] table.

**Create an email client configuration**
Define a configuration that controls the display and behavior of the email client that is based on a selected ServiceNow table.

**Before you begin**
Role required: email_client_admin

**About this task**
The configuration determines the recipient auto-complete results that are displayed, email addresses that can be entered, and a set of allowable From addresses to be used when sending a message with the client.

You can create one email client configuration per ServiceNow table.

**Procedure**
1. Navigate to **Email Client > Email Client Configuration** and click **New**.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for this email client configuration.</td>
</tr>
<tr>
<td>Application</td>
<td>Type of scoped application.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that indicates that the configuration is active. The configuration is active by default.</td>
</tr>
<tr>
<td>Table</td>
<td>ServiceNow table that this client configuration applies to. Select a table from the list.</td>
</tr>
</tbody>
</table>

3. In the Recipient Configuration section, select **Recipient Qualifiers** to be used for this client configuration.
   a. Click the lock icon (🔒). By default, two types of recipients are available: Active Users with email accounts and Active Groups with email accounts.
   b. Click the search icon (🔍) and select a recipient configuration from the list of available recipient configurations.
   c. Click the lock icon (🔒) to lock it.

4. In the Display Configuration section:
a. Select the **Display From** option to display the From email address in the email client. To hide the From email address in the email client, clear the check box.

b. Select the **Display Reply-To** option to display the Reply To address in the email client. To hide the Reply To email address in the email client, clear the check box.

5. In the Attachment Handling section, select from one of three choices for the **Attachment Send Action** field:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attach to Email Record</td>
<td>Keep email client attachments on the Email [sys_email] record when you send an email.</td>
</tr>
<tr>
<td>Attach to Target Record</td>
<td>Attach email client attachments to the target record when you send an email. This option is the default value.</td>
</tr>
<tr>
<td>Conditionally Attach to Target Record</td>
<td>Set conditions that define which email client attachments are moved to the target record when you send an email. Attachments that do not meet the conditions remain on the email record when you send an email.</td>
</tr>
</tbody>
</table>

6. In the Filter Configuration section, select **Email Address Filters** to be applied to the email client.

a. Unlock the lock icon (🔒).

b. Click the search icon (🔍) and select one or more Email Address Filters.

c. Click the lock icon (🔒) to lock **Email Address Filters**.

Each filter that you select evaluates a given email address and determines whether or not the given address is valid to apply to an outbound email.

7. Click **Submit**.

The configuration is added to the Email Client Configuration [sys_email_client_configuration] table.

---

**Create an email client template**

You can create a different template for each table that uses the email client.
Before you begin
Role required: admin

About this task
The email client uses its own email templates to define default values for fields. Use the following sections in the Email Client Template form to build a client template:

- **Content**: The message body.
- **Recipients**: The email addresses of users receiving the email message. The email addresses are displayed in the To, Cc, and Bcc fields of the message.
- **Sender Configuration**: The method used to generate the email sender (From email address) of the message.

Procedure
1. Navigate to **Email Client > Email Client Templates**.
2. Click **New**.
3. Fill in the fields at the top of the Email Client Template form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique template name.</td>
</tr>
<tr>
<td>Table</td>
<td>The table that the template applies to. Enable the email client for the same table.</td>
</tr>
<tr>
<td>Conditions</td>
<td>The conditions that determine when this client template is used. Use the condition builder to identify the target record that must match before this template is applied to the email client.</td>
</tr>
<tr>
<td>Application</td>
<td>The type of scoped application.</td>
</tr>
<tr>
<td>Execution Order</td>
<td>A number that indicates the order in which template conditions are evaluated.</td>
</tr>
</tbody>
</table>

4. Fill in the fields in the **Content** tab.
### Field Description

#### Subject
Enter a description of the email.

**Note:** The **Subject** field on the email client allows a larger character count than the default setting for the **Subject** field on the Email [sys_email] table. If the subject text from the client is being truncated, increase the **Max length** value for the **Subject** field on the Email table.

#### Content Type
Select the format of the message body content: HTML or plain text.

#### Body HTML
If you selected HTML for the **Content type**, enter the content of the message body using the HTML editor toolbar to format the HTML.

To reference field values, select variables from the variables list or manually type variable references using the syntax `{table_name.variable_name}`. To reference the user who launches the email client, enter the variable `{current_user}`.

**Note:** Line breaks don't appear for multi-line fields such as `{description}` and `{comments}` in the email client template.

You can call a mail script by using `{mail_script:script name}` in the **Body HTML** field.

#### Body text
If you selected plain text for the **Content type**, enter any text or mail script that you want to appear in the message body.
You can insert a mail script in the **Body text** field by using the following syntax:

```
<mail_script> [code] </mail_script>
```

5. Fill in the fields in the **Recipients** tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To</strong></td>
<td>Enter a comma-separated list of either field names that contain user email addresses or specific email addresses. To reference an email address using a script, create a script include and then call the script include in the <strong>To</strong> field. Your script must start with the <code>javascript:</code> prefix. The script must return email addresses in a comma-separated string.</td>
</tr>
<tr>
<td><strong>Cc</strong></td>
<td>Enter a comma-separated list of either field names that contain user email addresses or specific email addresses. To reference an email address using a script, create a script include and then call the script include in the <strong>Cc</strong> field. Your script must start with the <code>javascript:</code> prefix. The script must return email addresses in a comma-separated string. This field cannot have the same addresses as the <strong>To</strong> field.</td>
</tr>
<tr>
<td><strong>Bcc</strong></td>
<td>Enter a comma-separated list of either field names that contain user email addresses or specific email addresses. To reference an email address using a script, create a script include and then call the script include in the <strong>Bcc</strong> field. Your script must start with the <code>javascript:</code> prefix. The script must return email addresses in a comma-separated string. This field cannot have the same addresses as the <strong>To</strong> or <strong>Cc</strong> fields.</td>
</tr>
</tbody>
</table>

6. In the **Sender Configuration** tab, select the **From Generation Type** to determine how the sender (From address) in the email client message is generated.
Use this field only if you want a different From address than the one defined in your SMTP email account.

- None: The From address is not generated in the email client message.
- SMTP Email Account: Use the From address of the SMTP email account for the instance as the sender.
- Select From List: Choose from a list of allowable From addresses defined in the Email Client From Address [sys_email_client_from_address] table.
- Script: Run a GlideRecord query on the Email Client From Address [sys_email_client_from_address] table. For example, the following script sets the From address based on the location of the incident caller:

```javascript
(function (fromAddressQuery, targetRecord) {
    // targetRecord is incident for this template
    var location = targetRecord.caller_id.country;

    if (location == 'us')
        fromAddressQuery.addQuery('email_address', 'servicedesk.us@example.com');
    else if (location == 'japan')
        fromAddressQuery.addQuery('email_address', 'servicedesk.jp@example.com');
    else if (location == 'uk')
        fromAddressQuery.addQuery('email_address', 'servicedesk.uk@example.com');
}) (fromAddressQuery, targetRecord);
```

- Text: Enter the email From address to be used in the client.

**Note:** The From email address does not appear in the email client unless you configure email client to display the From address. For more information on managing the behavior of email client, see Email client configurations.

**Note:** If the domain for the From address is not the domain of the SMTP email account server, the owner of the From domain must configure the SPF record for the domain. The owner changes the domain settings to allow the instance to send email as if from that domain. For details on using SPF records, see ServiceNow KB0535456.

7. Click Submit.

The template is added to the Email Client Templates [sys_email_client_template] table.

**Related information**

Script includes
Apply an email client template

After you create an email client template, you can apply it to an email.

Before you begin
Role required: admin

About this task
The following steps are implemented only after creating an email client template

Procedure
1. Click the ellipsis (...) icon at the top of the template to apply the template to an email
2. Select Email.
3. Fill in the fields to compose an email. See Create an email client template for field details.

Note: The body of the email is filled up with the details from the incident record. If you modify one or more fields in the incident record and are not saved, the unsaved changes still reflect in the email body.

Note: 2000 characters is the total limit for all the changes in the incident record. If some of your changes are not reflected and get truncated in the email body, this is because the total changes is more than 2000 character limit.

Create an email client response template

You can now create custom email client response templates that support conditions.

Before you begin
Role required: admin
Procedure

1. Navigate to Email Client > Email Client Templates. The following options for Response Template - Received and Response Template - Sent show up.

2. Click one of the available options to create a template for that selected option.

3. Fill in the fields at the top of the Email Client Template form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Auto-filled template name based on the selected template option.</td>
</tr>
<tr>
<td></td>
<td>✅ Note: This is a read-only field.</td>
</tr>
<tr>
<td>Table</td>
<td>Auto-filled table name.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This is a read-only field because for response templates, the table name is</td>
</tr>
<tr>
<td><strong>Conditions</strong></td>
<td>The conditions that determine when this client response template is used. Use</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If the conditions are not true, the email client gets the default template.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Select the target table name under conditions that the template applies.</td>
</tr>
</tbody>
</table>

**Application**
The type of scoped application.

**Execution Order**
A number that indicates the order in which template conditions are evaluated.

4. Fill in the fields in the **Content** tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject</td>
<td>Enter a description of the email.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Field Description

**Note:** The Subject field on the email client allows a larger character count than the default setting for the Subject field on the Email [sys_email] table. If the subject text from the client is being truncated, increase the Max length value for the Subject field on the Email table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Type</td>
<td>Select the format of the message body content: HTML or plain text.</td>
</tr>
<tr>
<td>Body HTML</td>
<td>If you selected HTML for the Content type, enter the content of the message body using the HTML editor toolbar to format the HTML. To reference field values, select variables from the variables list or manually type variable references using the syntax <code>${table_name.variable_name}</code>. To reference the user who launches the email client, enter the variable <code>${current_user}</code>. <strong>Note:</strong> Line breaks don’t appear for multi-line fields such as <code>${description}</code> and <code>${comments}</code> in the email client template. You can call a mail script by using <code>${mail_script:script name}</code> in the Body HTML field.</td>
</tr>
<tr>
<td>Body text</td>
<td>If you selected plain text for the Content type, enter any text or mail script that you want to appear in the message body. You can insert a mail script in the Body text field by using the following syntax: <code>&lt;mail_script&gt; [code] &lt;/mail_script&gt;</code></td>
</tr>
</tbody>
</table>

5. Fill in the fields in the Recipients tab.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Enter a comma-separated list of either field names that contain user email addresses or specific email addresses. To reference an email address using a script, create a script include and then call the script include in the <strong>To</strong> field. Your script must start with the <code>javascript:</code> prefix. The script must return email addresses in a comma-separated string.</td>
</tr>
<tr>
<td>Cc</td>
<td>Enter a comma-separated list of either field names that contain user email addresses or specific email addresses. To reference an email address using a script, create a script include and then call the script include in the <strong>Cc</strong> field. Your script must start with the <code>javascript:</code> prefix. The script must return email addresses in a comma-separated string. This field cannot have the same addresses as the <strong>To</strong> field.</td>
</tr>
<tr>
<td>Bcc</td>
<td>Enter a comma-separated list of either field names that contain user email addresses or specific email addresses. To reference an email address using a script, create a script include and then call the script include in the <strong>Bcc</strong> field. Your script must start with the <code>javascript:</code> prefix. The script must return email addresses in a comma-separated string. This field cannot have the same addresses as the <strong>To</strong> or <strong>Cc</strong> fields.</td>
</tr>
</tbody>
</table>

6. In the **Sender Configuration** tab, select the **From Generation Type** to determine how the sender (From address) in the email client message is generated.

Use this field only if you want a different From address than the one defined in your SMTP email account.

- None: The From address is not generated in the email client message.
- SMTP Email Account: Use the From address of the SMTP email account for the instance as the sender.
- Select From List: Choose from a list of allowable From addresses defined in the Email Client From Address [sys_email_client_from_address] table.
- Script: Run a GlideRecord query on the Email Client From Address [sys_email_client_from_address] table.

For example, the following script sets the From address based on the location of the incident caller:

```javascript
(function (fromAddressQuery, targetRecord) {
    // targetRecord is incident for this template
    var location = targetRecord.caller_id.country;
    if (location == 'us') {
        // Set the From address to the caller's country
        fromAddressQuery.set('from_address', location);
    }
})(fromAddressQuery, targetRecord);
```
fromAddressQuery.addQuery('email_address', 'servicedesk.us@example.com');
else if (location == 'japan')
    fromAddressQuery.addQuery('email_address', 'servicedesk.jp@example.com');
else if (location == 'uk')
    fromAddressQuery.addQuery('email_address', 'servicedesk.uk@example.com');
}}(fromAddressQuery, targetRecord);

• **Text:** Enter the email From address to be used in the client.

  🔄 **Note:** The From email address does not appear in the email client unless you configure email client to display the From address. For more information on managing the behavior of email client, see Email client configurations.

  🔄 **Note:** If the domain for the From address is not the domain of the SMTP email account server, the owner of the From domain must configure the SPF record for the domain. The owner changes the domain settings to allow the instance to send email as if from that domain. For details on using SPF records, see ServiceNow KB0535456.

7. Click **Submit**.

**Composing emails with quick messages**

Insert predefined content into the message body of emails that you send from the email client.

**Using quick messages**

In the email client, you can select a quick message to fill the email body with the content that is specified in the quick message. After you define one or more quick messages, the Quick Message selector appears in the email client so that you can construct an email with multiple quick messages.

By default, the quick message content is inserted at the place of the cursor. It doesn't replace content that you created before selecting the quick message. To replace message content with a quick message, highlight the text to replace and then select a quick message.

flammatory Note: To instead have quick message content replace all existing content in an email draft, set the `glide.email_client.quick_message.insert` property to **false**.
Adding quick messages to an email

Creating quick message content
Define quick messages by creating records in the Email Client Canned Messages [sys_email_canned_message] table.

When you define a quick message, you can add any of the following types of content into the message body:

- Icons
- Logos
- Pictures
- Rich-text HTML
- Hyperlinks
- Variables
- Any other HTML constructs

⚠️ Note: If you add attachments to the quick message, the attachments are not sent as part of the email distribution.
Assign the email_client_quick_message_author role to business managers so that they can create quick messages for users in their group.

**Setting quick message conditions**
When you define a quick message, you can limit the availability of the quick message according to:

- The user who launches the email client
- The group of the user who launches the email client
- The table of the record from which you launch the email client
- The target record from which you launch the email client

For example, if you designate Beth Anglin as the user for a certain quick message, the quick message is available in the email client only for Beth Anglin.

If you associate a quick message to the Incident [incident] table, the quick message is available in the email client only after you launch from an incident record. If you specify a target record from the Incident table for the quick message, the quick message becomes available in the email client only for matching incident records.

**Define a quick message**
Create predefined content to add in the email client so that users can write emails consistently and efficiently.

**Before you begin**
Role required: email_client_quick_message_author or admin

**Procedure**
1. Navigate to Email Client > Quick Messages.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name that appears in the Quick Message selector.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for activating the quick message. When selected, the quick message is available for selection in the Quick Message selector.</td>
</tr>
<tr>
<td>Application</td>
<td>Type of scoped application.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>User</td>
<td>User who has access to this quick message. Selecting a user restricts access to that user only. Leave the field blank to have no user-based restrictions.</td>
</tr>
<tr>
<td>Group</td>
<td>Group whose members have access to this quick message. Selecting a group restricts access to members of that group only. Leave the field blank to have no group-based restrictions.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to which the quick message applies. To make the quick message available for all tables, leave blank.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Target record that must match the conditions before the quick message appears for selection in the email client.</td>
</tr>
<tr>
<td>Body</td>
<td>Content to insert in the <strong>Message Text</strong> field in the email client. By default, the field supports HTML format. To reference field values, select variables from the variables list or manually type variable references using the syntax <code>${table_name.variable_name}</code>. To reference the user who launches the email client, enter the variable <code>${current_user}</code>.</td>
</tr>
</tbody>
</table>

\*\*\* Note: \*\*Line breaks don't appear for multi-line fields such as `${description}` and `${comments}` in the email client template.\*\*\*

4. Click **Submit**.

### Enable SMS delivery with the email client

Give users the option to send an email client message as an SMS text message.

**Procedure**

1. In the application navigator, enter `sys_properties.list`.
2. From the list, find and open the record for the `glide.email_client.show_sms_option` property.
3. On the form, change **Value** to **true**.
4. Click **Update**.

**Results**

In the email client, user can select to send the message as an SMS text message.
If the recipient doesn’t have a registered SMS device, the email client sends the message to the primary email device.

**Related information**

Add a system property

**Parse an email thread**

Parse the most recent email in an email thread by using Email Reply Separators.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to System Policy > Email > Email Reply Separators. A list of email reply separators shows up.
2. Click New to create a new email reply separator.
3. On the Email Reply Separator form, fill in the fields.
<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the separator.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of the separator.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the separator.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of separator.</td>
</tr>
<tr>
<td></td>
<td>• String: Searches for the specified string to parse out an email thread.</td>
</tr>
<tr>
<td></td>
<td>• Regex: Searches for the specified regular expression to parse out an email thread.</td>
</tr>
<tr>
<td>Order</td>
<td>Priority of the separator.</td>
</tr>
<tr>
<td>Separator</td>
<td>Separator value based on the selection of the <strong>Type</strong>.</td>
</tr>
<tr>
<td>Short description</td>
<td>Description about the separator.</td>
</tr>
<tr>
<td>Language</td>
<td>Language of the reply separator.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> All email clients don’t indicate a language, so all active reply separators are applied to locate a separator in the email message.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Automating system responses to inbound email**

Save time from responding to emails manually when you configure your instance to send replies, create incidents, or update records automatically in response to inbound emails.

You can define system responses to inbound emails in two ways:

- Create an inbound email flow in Flow Designer
- Script an inbound email action
Inbound email trigger in Flow Designer

With the inbound email trigger in Flow Designer, you can create flows that define the automated processes that your instance takes when it receives an email.

Inbound email flows take priority over inbound email actions. If you create flows with inbound email triggers, emails are first processed by the inbound email triggers before they are processed by inbound email actions.

The following diagram shows the processing order for inbound emails. When an email is sent to your instance, the system first classifies the email as a reply, forward, or new email. Then the system runs the inbound email through an inbound email flow. If the flow issues stop processing, the email is finished being processed. If the flow does not issue stop processing, the system tries to match the email to another inbound email flow. If at any point the email does not match with an inbound email flow, the system matches the email to an inbound email action instead.
The benefits to automating system responses to inbound emails in Flow Designer are:

- Provides an easy and accessible interface that uses natural language.
- Consolidates configuration and runtime information into a single environment so process owners and developers can create, operate, and troubleshoot flows from a single interface.
- Reduces upgrade costs, with upgrade-safe Now Platform logic replacing complex custom script.
- Reduces development costs by providing a library of reusable actions.

For more information on creating inbound email flows in Flow Designer, see Flow trigger types or follow the steps in Create a flow with an inbound email trigger. To view or manage your inbound email flows, navigate to Flow Designer > Inbound Email Flows.

Inbound email actions

Define an inbound email action to script how the system responds to an inbound email.

⚠️ Note: Inbound email flows take priority over inbound email actions. If you create flows with inbound email triggers, emails are first processed by the inbound email triggers before they are processed by inbound email actions.

Inbound email actions are similar to business rules: both use conditions and scripts that take action on a target table. An inbound email action checks the email for a watermark that associates it with a task and checks for other conditions. If the conditions are met, the system takes the inbound email action that you configure. The system can take two types of actions:

- Record action: setting a value for a field in the target table.
- Email reply: sending an email back to the source that triggered the action.

By default, if an email has no identifiable watermark, an inbound email action attempts to create an incident from the message. If the email has a watermark of an existing incident, an inbound email action updates the existing incident according to the action's script.

⚠️ Note: From Paris release and beyond, if an email body has multiple watermarks, consider the last valid watermark in the email body.
Watch this six-minute video to learn about the actions that the instance can take in response to messages from users and shows how to create or modify email notifications to users. Configuring inbound email actions and email notifications

**Inbound email receive types**
The system classifies all incoming email into one of three types: forward, reply, or new.

<table>
<thead>
<tr>
<th>Order</th>
<th>Type</th>
<th>Criteria</th>
</tr>
</thead>
</table>
| 1     | Forward | The system classifies an email as a forward only when it meets all these criteria:  
|       |       | • The subject line contains a recognized forward prefix such as **FW:**.  
|       |       | • The email body contains a recognized forward string such as **From:**. |
|       |       | The system classifies any email that meets these criteria as a forward, even if the message contains a watermark or record number that otherwise classifies it as a reply. |
| 2     | Reply | The system classifies an email as a reply when it fails to match it to the forward receive type and it meets any one of these criteria:  
|       |       | • The subject line or email body contains a recognized watermark such as **Ref:MSG0000008**. |
|       |       | • There is no watermark and the Reply-To header contains a recognized message ID of an email with a target record. |
|       |       | • There is no watermark and the subject line contains a recognized reply prefix such as **RE:** and a recognized record number such as **INC0005574** |
| 3     | New  | The system classifies an email as new when it fails to match it to the forward and reply receive types. |
Determining the type of incoming email

Attachments
If an inbound email contains one or more email attachments, the inbound email action adds the attachments to the first record the action produces.

Character encoding
- If the email encoding is ASCII-7 or UTF-8, inbound email actions preserve the character encoding in any associated task records they produce.
- If the email encoding is ISO-8859-1, the inbound email action attempts to convert the email to Windows 1252.
- Inbound email actions convert any other encodings (for example, Mac OS Roman) to plain text, which may or may not be readable.

See the System email log and mailboxes for examples of what you might see if a notification or inbound email action is not processed.

Note: The state of all incoming emails that have been run against inbound email actions, even if there is no matching action, is changed to Processed.

Domain separation
The system ignores the domain that the inbound email action record is in when it creates a record based on the inbound email action. Keep inbound actions in the global domain. For example, if your inbound email action creates an incident, the system creates the incident in the same domain as the user in the
**Caller** field. If that user is not in the User [sys_user] table, the incident is in the global domain.

**Related information**
- Notification variables
- Watermarks on notification emails

**Inbound email action processing**

The system determines which inbound actions to run by comparing the inbound email type and inbound action conditions to the incoming email message. Certain properties are available to set the reply and forwarding prefixes in the email subject lines that your instance recognizes when processing inbound emails.

**Note:** Inbound email flows take priority over inbound email actions. If you create flows with inbound email triggers, emails are first processed by the inbound email triggers before they are processed by inbound email actions.

The system follows this processing flow to determine whether to run an inbound action.

The system only runs an inbound action when:
• The incoming email type matches the inbound action **Type**.
• If present, the watermark or record number refers to a record in the **Target** table.
• The inbound action **Conditions** evaluates to true.

If any of these criteria are not met, the system skips the current inbound action and evaluates the next active inbound action. The system processes inbound actions from the lowest to highest **Order** value. If the inbound action has **Stop processing** enabled, the system updates the **State** of the email record to **Processed** after running the inbound action **Script**.

The following video shows how an inbound action condition prevents an incident from being created.

**Troubleshooting when inbound email isn't processed**

**Prefixes recognized in email subject lines**

**Email reply prefixes**

When no watermark is present or the In-Reply-To email header is present, the instance recognizes email containing a prefix from the glide.email.reply_subject_prefix property as reply email. You can use this property to set non-standard reply prefixes in your email system.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.email.reply_subject_prefix</td>
<td>Specifies the list of prefixes (comma-separated) in the subject line that identify an email reply.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: re:,aw:,r:</td>
</tr>
<tr>
<td></td>
<td>• Location: Add to the System Properties [sys_properties] table</td>
</tr>
</tbody>
</table>

**Note**: Prefixes are case insensitive.

**Email forward prefixes**
Emails with certain prefixes trigger the forward type of inbound email action. The instance recognizes any email whose subject line contains a prefix from the `glide.email.forward_subject_prefix` property as forwarded email. Emails with these prefixes trigger inbound email actions of the type forward. Use this property to set non-standard forward prefixes in your email system or you want email forwards to behave like replies. If the value of the system property is empty, then the system reverts to using the values `fw:` and `fwd:`.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>glide.email.forward_subject_prefix</code></td>
<td>Specifies the list of prefixes (comma-separated) in the subject line that identify a forwarded email.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: fw:, fwd:</td>
</tr>
<tr>
<td></td>
<td>• Location: Add to the System Properties <code>sys_properties</code> table</td>
</tr>
</tbody>
</table>

**Note:** Prefixes are case insensitive.

### Email forwards as replies

Properties are available to force inbound actions to process forwarded mail as replied mail. These properties control the subject prefix that the inbound actions use.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value needed</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>glide.email.reply_subject_prefix</code></td>
<td><code>re:, Re:, RE:, aw:, r:, fw:, fwd:, Fwd:, FWD:</code></td>
</tr>
<tr>
<td><code>glide.email.forward_subject_prefix</code></td>
<td>[any text that is not a forward prefix]</td>
</tr>
</tbody>
</table>

These properties cause the Update Incident inbound action to process all forwarded and replied-to mail.
**Note:** The `glide.email.forward_subject_prefix` property must contain some text so that the forwarded email can be processed as a Reply. It can be any text except a forward prefix (that is, fw:,fwd:,Fwd:,FWD:).

### Matching a sender email address to a user

The instance matches a sender's email address to an active user in the User [sys_user] table using inbound actions.

When processing an email, the instance sets the current user to the user whose email address matches `email.from`. Inbound actions can then reference that current user. For example, the base system inbound action Create Incident sets the `caller_id` of the incident to the value returned by `gs.getUserID()`.

If multiple users have the same email address, the instance first searches for an active user with the email address. The instance does not match inactive users.

**Note:** Each user record must have a unique email address so that the instance can reliably match the email to the correct user.

If a unique email address for each user is not possible, assign a shared email address to only one active user so that the instance always matches incoming email from that address to the active user.

### Matching watermarks in the Subject line or Body

The following examples illustrate how the instance matches randomized watermarks in an email subject line or body.

**Note:** For instances upgraded from a release before Jakarta, the system can recognize both randomized and non-randomized watermarks during a watermark transition period.

<table>
<thead>
<tr>
<th>Subject Line or Body Contents</th>
<th>Matching Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ref:MSG0000008_aLJc130zDhCVuh3spXmt</td>
<td>The instance recognizes this string as a watermark and searches the Email Watermarks [sys_watermark] table for a record with the number MSG0000008_aLJc130zDhCVuh3spXmt. If this watermark exists, the instance matches the email to the associated record. If this watermark does not exist, the system processes inbound email</td>
</tr>
</tbody>
</table>
Examples of matching watermarks in the Subject line or body (continued)

<table>
<thead>
<tr>
<th>Subject Line or Body Contents</th>
<th>Matching Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>messages as described in Criteria for matching email to inbound actions.</td>
<td></td>
</tr>
<tr>
<td>Ref: MSGWTR0000008_wfLLz42lxCgUvG2J1Ynh</td>
<td>The instance recognizes this string as a watermark and searches the Email Watermarks [sys_watermark] table for a record with the number MSGWTR0000008_wfLLz42lxCgUvG2J1Ynh. If this watermark exists, the instance matches the email to the associated record. If this watermark does not exist, the system processes inbound email messages as described in Criteria for matching email to inbound actions.</td>
</tr>
</tbody>
</table>

Matching record numbers in the Subject line or Body

The following examples illustrate how the instance matches record numbers in the subject line of an email to an existing record when no watermark is present.

Examples of matching record numbers in the Subject line

<table>
<thead>
<tr>
<th>Subject line contents</th>
<th>Matching results</th>
</tr>
</thead>
<tbody>
<tr>
<td>RE: Example INC0005574</td>
<td>The instance recognizes this subject line as a reply and recognizes the INC prefix as belonging to the Incident table. The instance searches the Incident table for an existing record INC0005574. If this incident exists, the email is associated with this incident. If this incident record does not exist, the instance uses the inbound action for new emails to create an incident and associates the new incident with the email.</td>
</tr>
<tr>
<td>RE: Example &quot;INC0005574&quot;</td>
<td>The instance recognizes this subject line as a reply but does not recognize the &quot;INC prefix as belonging to the Incident table because of the quotation mark. The same error occurs for any character other than a space before the record number. The instance instead uses the inbound action for new emails to create an incident and associates the new incident with the email.</td>
</tr>
<tr>
<td>RE: Example *INC0005574</td>
<td>The instance recognizes this subject line as a reply but does not recognize the &quot;INC prefix as belonging to the Incident table because of the quotation mark. The same error occurs for any character other than a space before the record number. The instance instead uses the inbound action for new emails to create an incident and associates the new incident with the email.</td>
</tr>
</tbody>
</table>
Examples of matching record numbers in the Subject line (continued)

<table>
<thead>
<tr>
<th>Subject line contents</th>
<th>Matching results</th>
</tr>
</thead>
<tbody>
<tr>
<td>RE: &quot;Example INC0005574&quot;</td>
<td>The instance recognizes this subject line as a reply and recognizes the INC prefix as belonging to the Incident table. The instance searches the Incident table for an existing record INC0005574&quot;, which it cannot find because of the quotation mark. The same error occurs for any character other than a space at the end of the record number. The instance instead uses the inbound action for new emails to create an incident and associates the new incident with the email.</td>
</tr>
<tr>
<td>RE: Example INC0005574*</td>
<td></td>
</tr>
<tr>
<td>RE: CHG0008593 and INC000576</td>
<td>The instance recognizes this subject line as a reply and recognizes one, but not both, of the number prefixes. There is no way to predict which prefix the instance matches first. Whichever prefix it matches, it searches the corresponding table for a matching record. If the record exists, the email is associated with the table. If the record does not exist, the instance uses the inbound action for new emails to create an incident and associates the new incident with the email.</td>
</tr>
<tr>
<td>FW: Example INC0005574</td>
<td>The instance recognizes this subject line as a forward because of the FW: prefix. It uses the inbound action for forwarded emails to create an incident and associates the new incident with the email.</td>
</tr>
<tr>
<td>Example INC0005574</td>
<td>The instance recognizes this subject as a new email because it does not contain a matching reply or forward prefix. It uses the inbound action for new emails to create an incident and associates the new incident with the email.</td>
</tr>
</tbody>
</table>

**Criteria for matching email to inbound actions**

The system matches incoming email to the conditions of the active inbound actions.

- The instance recognizes this subject line as a reply and recognizes the INC prefix as belonging to the Incident table. The instance searches the Incident table for an existing record INC0005574", which it cannot find because of the quotation mark. The same error occurs for any character other than a space at the end of the record number. The instance instead uses the inbound action for new emails to create an incident and associates the new incident with the email.

- The instance recognizes this subject line as a reply and recognizes one, but not both, of the number prefixes. There is no way to predict which prefix the instance matches first. Whichever prefix it matches, it searches the corresponding table for a matching record. If the record exists, the email is associated with the table. If the record does not exist, the instance uses the inbound action for new emails to create an incident and associates the new incident with the email.

- The instance recognizes this subject line as a forward because of the FW: prefix. It uses the inbound action for forwarded emails to create an incident and associates the new incident with the email.

- The instance recognizes this subject as a new email because it does not contain a matching reply or forward prefix. It uses the inbound action for new emails to create an incident and associates the new incident with the email.
The default inbound actions create or update task record under these conditions.

**Default matching criteria**

- **Start**
  - Subject line contains a forward prefix: Run Forward inbound email action
  - Subject line or body contains a watermark: Run Reply inbound action
  - “From:” appears in the email body: Run Forward inbound email action
- **Stop**
  - Reply-To header contains a record number: Skip Reply inbound email action
  - Subject line contains a reply prefix and record number: Run New inbound email action
  - The record table matches the inbound email action table: Run New inbound email action

If you customize or deactivate the default inbound actions, the system checks the conditions of the active inbound actions. If the system cannot find an inbound action with matching conditions, it sets the state to **Processed**.

**Custom matching criteria**

- **Start**
  - Default inbound email actions are active: Email is matched to default inbound email actions
  - Email matches conditions of an active inbound email action: Matching inbound email action runs
- **Stop**
  - Email state is set to **Processed**
**Inbound action type criteria**

<table>
<thead>
<tr>
<th>Inbound email action type</th>
<th>Required matching criteria</th>
<th>Name of default action (Incident table)</th>
<th>Result of default action</th>
</tr>
</thead>
</table>
| Forward                   | The email contains the following conditions:  
1. A subject starting with a recognized forward prefix (even if a watermark or an In-Reply-To header is present).  
2. From <user email> appears anywhere in the email body. | Create Incident (Forwarded) | Create new record |
| Reply                     | The email contains one of the following conditions and the table specified in the email matches the table of the inbound action:  
1. A valid watermark that matches an existing record.  
2. An In-Reply-To email header (when no watermark is present) that matches an existing record.  
3. A subject line starting with a recognized reply prefix (when neither a watermark nor an In-Reply-To header is present) and a valid record number that matches an existing record. | Update Incident (BP) | Update existing record |
| New                       | The email does not meet the conditions for either a reply or forward type inbound email action | Create Incident | Create new record |

If more than one inbound action is available for a particular type, the instance uses the Table field to match the email to a particular table. If there is also more than one action for the inbound action’s table, the instance uses the **Order** field to determine the order in which the actions run.

**Create an inbound email action**

You can create inbound email actions to define the actions that the system takes when an email is received.
Before you begin
Role required: admin

Procedure
1. Navigate to System Policy > Email > Inbound Actions.
2. Click New.
3. Fill in the fields as described in the table.

Note: You might need to configure the form to see all fields.

Inbound Email Actions form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When to run</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name for this email action.</td>
</tr>
<tr>
<td>Target table</td>
<td>Select the table where the action adds or updates records.</td>
</tr>
<tr>
<td>Action type</td>
<td>Select the type of action the instance takes. Select <strong>Record Action</strong> to modify a record in the instance, or select <strong>Reply Email</strong> to have the instance send an email back to the source of the inbound email.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to activate the inbound email action. Clear the check box to disable the action.</td>
</tr>
<tr>
<td>Stop processing</td>
<td>Select this check box to prevent the system from running additional inbound email actions after this action runs.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the message type required to run the action. The action runs only if the inbound email is of the selected type. Available types are:</td>
</tr>
<tr>
<td></td>
<td>• New: An email that is not recognized as a reply or forward.</td>
</tr>
<tr>
<td></td>
<td>• Reply: An email with a watermark with an In-Reply-To email header, or whose subject line begins with a recognized reply prefix.</td>
</tr>
<tr>
<td></td>
<td>• Forward: An email whose subject line begins with a recognized forward prefix, even if the email also contains a watermark or In-Reply-To header.</td>
</tr>
<tr>
<td>Note:</td>
<td>By default, inbound emails of the <strong>Forward</strong> type always generate new incidents regardless of the presence of a watermark. If this behavior does not match your business logic, you can change the recognized reply and forward prefixes to treat forwards like replies.</td>
</tr>
<tr>
<td>Required roles</td>
<td>Specify required roles the sender must have to trigger the inbound action.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter a number that specifies when this inbound action runs relative to other inbound actions that use the same target table. The instance processes the action with the lowest order number first.</td>
</tr>
<tr>
<td>From</td>
<td>Select the user required to run the action. If a user is selected, the action runs only when the email sender matches the user name. Leave this field blank to perform the action for all users.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If the selected user is later archived or deleted, the restriction is removed and anyone can trigger the inbound email action.</td>
</tr>
<tr>
<td><strong>Condition</strong></td>
<td>Specify the condition that must evaluate to true to trigger the inbound action. Build a condition with the choice lists or enter a statement that determines when the inbound email action runs. For example: email.subject.startsWith(&quot;chg:&quot;)</td>
</tr>
<tr>
<td><strong>Actions</strong></td>
<td></td>
</tr>
<tr>
<td>Field actions</td>
<td>This field appears if the <strong>Action type</strong> is Record Action. Specify how information in the email is inserted into the record. For example, select [Created by] [From email] [Sender], so that when the request is inserted, you can see who it is for.</td>
</tr>
<tr>
<td><strong>Reply</strong></td>
<td>This field appears if the <strong>Action type</strong> is Reply Email. compose the email message to send to the source that triggered the inbound email action.</td>
</tr>
<tr>
<td><strong>Script</strong></td>
<td>Enter the script the action runs. Typically, this script uses the validators script include and email variables. A template is provided:</td>
</tr>
<tr>
<td></td>
<td>(function runAction(/<em>GlideRecord</em>/ current, /<em>GlideRecord</em>/ event, /<em>EmailWrapper</em>/ email, /<em>ScopedEmailLogger</em>/ logger) {</td>
</tr>
<tr>
<td></td>
<td>// Implement email action here</td>
</tr>
<tr>
<td></td>
<td>})(current, event, email, logger);</td>
</tr>
<tr>
<td></td>
<td>The following objects are available:</td>
</tr>
<tr>
<td><strong>current</strong>:</td>
<td>access the record referred to by the inbound email. For example, current.assigned_to accesses the person assigned to the task.</td>
</tr>
<tr>
<td><strong>event</strong>:</td>
<td>access one of the parameters of the originating event. For example, event.parm1 accesses the first parameter of the event or event.parm2 for the second parameter. See for more information.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>email</strong></td>
<td>access the inbound current email record. For example, email.subject accesses the content in the subject line of the email. See Accessing email object variables for more information.</td>
</tr>
<tr>
<td><strong>logger</strong></td>
<td>add a message to the log file with the source set to email.&lt;Sys ID of incoming email&gt;. For example: logger.log (&quot;Some information&quot;)</td>
</tr>
</tbody>
</table>

### Description

Enter a detailed explanation of what this inbound email action does.

### Other fields

**Order**

Enter a number to define the order in which this email action should be processed. Actions with lower numbers are processed first. The Ordered Email Processing plugin does not install this field.

### Accessing email object variables

An inbound email action script contains the email object to access various pieces of an inbound email through variables. You can use the global variable sys_email with inbound email actions.

#### Accessing email objects with variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>email.to</strong></td>
<td>Contains a comma-separated list of email addresses in the To: and Cc: boxes.</td>
</tr>
<tr>
<td><strong>email.direct</strong></td>
<td>Contains a comma-separated list of email addresses in the To: box.</td>
</tr>
<tr>
<td><strong>email.copied</strong></td>
<td>Contains a comma-separated list of email addresses in the Cc: box.</td>
</tr>
<tr>
<td><strong>email.body_text</strong></td>
<td>Contains the body of the email as a plain text string.</td>
</tr>
<tr>
<td><strong>email.body_html</strong></td>
<td>Contains the body of the email as an HTML string.</td>
</tr>
</tbody>
</table>
## Accessing email objects with variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>email.from</code></td>
<td>Contains an email address that depends on the following conditions:</td>
</tr>
<tr>
<td></td>
<td>• If the address listed in the email Headers field matches an existing user's Email address, this variable contains the user’s email address.</td>
</tr>
<tr>
<td></td>
<td>• If the address listed in the email Headers field does not match an existing user's Email address, this variable contains the address listed in the email Headers field.</td>
</tr>
<tr>
<td><code>email.from_sys_id</code></td>
<td>Contains the Sys ID of the user who sent the email to the instance.</td>
</tr>
<tr>
<td><code>email.origemail</code></td>
<td>Contains the address of the email sender as listed in the email Headers field.</td>
</tr>
<tr>
<td><code>email.subject</code></td>
<td>Contains the subject of the email as a plain text string.</td>
</tr>
<tr>
<td><code>email.recipients</code></td>
<td>Contains a comma-separated list of recipient addresses as a plain text string.</td>
</tr>
<tr>
<td><code>email.recipients_array</code></td>
<td>Contains the recipient addresses as an array.</td>
</tr>
<tr>
<td><code>email.content_type</code></td>
<td>Contains the MIME content type of the email (for example, text/plain; charset=&quot;us-ascii&quot; or text/html; charset=&quot;us-ascii&quot;).</td>
</tr>
<tr>
<td><code>email.headers</code></td>
<td>Contains details about the sender, route, and receiver as a plain text string in the format of the sending email client.</td>
</tr>
<tr>
<td><code>email.importance</code></td>
<td>Contains an indication from the sender about how important a</td>
</tr>
</tbody>
</table>
Accessing email objects with variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>message is.</td>
<td>The value can be <strong>High</strong>, <strong>Low</strong>, or empty.</td>
</tr>
</tbody>
</table>

<i>Note:</i> The instance follows **RFC 2822** (Internet Message Format), which requires multiple email addresses in a group to be separated by commas, not semicolons. The instance can set the values of the `email.to`, `email.direct`, and `email.copied` variables only if emails addressed to groups follow the expected RFC format.

**Inbound email.recipient variables**
The recipients variables (`email.recipients`, `email.recipients-array`) allow processing of inbound email based on the email recipients. For example, you can create a script to process email based on the array values:

```javascript
var rarray = email.recipients_array ;
for ( var i = 0 ; i < rarray.length ; i ++ ) {
    var recipient = rarray [i ] ;
    // do something with it
}
```

**The sys_email variable**
This variable lets you access the received sys_email record that triggered the inbound email action. It can be used to reference fields on the email record, such as `uid`, `sys_id`, `content_type`, and so on.

**Email user matching**
When the instance receives an email message, the system searches for an existing user record with the same email address as the sender.

**Matching email to existing users**

<table>
<thead>
<tr>
<th>Value of email.from Variable</th>
<th>Matching User ID</th>
<th>Email Address</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
<td><a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
<td><a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
</tr>
<tr>
<td>&quot;Michael Tossi&quot;<a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
<td><a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
<td><a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
</tr>
<tr>
<td>&quot;Tossi, Michael&quot;<a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
<td><a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
<td><a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
</tr>
<tr>
<td>&quot;Tossi&quot;<a href="mailto:mtossi@company.com">mtossi@company.com</a></td>
<td><a href="mailto:mtossi@company.com">mtossi@company.com</a></td>
<td><a href="mailto:mtossi@company.com">mtossi@company.com</a></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Note: This functionality requires that you activate the Email Automatic User Creation plugin.

Inbound Email Action scripts no longer support the `gs.createUser()` method. Use either the automatically-generated email variables or the `gs.GetUserID()` method instead.

User impersonations and inbound actions

When the instance receives an email, it can take a variety of actions by impersonating the sender.

If the sender of an incoming email matches an existing user, the instance impersonates the matching user to complete any inbound email actions. If the sender does not match an existing user, the instance impersonates the Guest user to complete any inbound email actions. If the impersonated user is locked out, the inbound email action fails.

Note: If inbound email comes from an untrusted domain, the instance impersonates the Guest user unless you explicitly prevent users from untrusted domains from triggering inbound actions. For more information on filtering domains, see Designate untrusted and trusted email domains.

Enable automatic user creation

An administrator can set an email property to automatically create users from incoming email. The administrator provides a list of trusted domains to prevent untrusted users from being automatically created.

Before you begin
Role required: admin

About this task
For example, you can prevent email from users outside your company domain from creating incidents. When an instance receives a message and there is no matching email address from the sender, the instance can create a user with the User ID `[sys_user.user_name]` set to the sender's full email address. Users in your instance must still have write and update access to the records that they create or update through inbound email actions.

Note: To learn more about the `glide.user.trusted_domain` property, which affects automatic email creation, see in the Instance Security Hardening Settings.
## Creating users from incoming email

<table>
<thead>
<tr>
<th>Value of email.from Variable</th>
<th>User ID Created</th>
<th>Email Address</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="mailto:new.user@company.com">new.user@company.com</a></td>
<td><a href="mailto:new.user@company.com">new.user@company.com</a></td>
<td><a href="mailto:new.user@company.com">new.user@company.com</a></td>
<td>New User</td>
</tr>
<tr>
<td>&quot;New User&quot; <a href="mailto:new.user@company.com">new.user@company.com</a></td>
<td><a href="mailto:new.user@company.com">new.user@company.com</a></td>
<td><a href="mailto:new.user@company.com">new.user@company.com</a></td>
<td>New User</td>
</tr>
<tr>
<td>&quot;User, New&quot; <a href="mailto:new.user@company.com">new.user@company.com</a></td>
<td><a href="mailto:new.user@company.com">new.user@company.com</a></td>
<td><a href="mailto:new.user@company.com">new.user@company.com</a></td>
<td>New User</td>
</tr>
<tr>
<td>&quot;User&quot; <a href="mailto:nuser@company.com">nuser@company.com</a></td>
<td><a href="mailto:nuser@company.com">nuser@company.com</a></td>
<td><a href="mailto:nuser@company.com">nuser@company.com</a></td>
<td>User</td>
</tr>
</tbody>
</table>

### Procedure

1. Navigate to **System Properties > Email Properties**.
2. Select the check box for **Automatically create users for incoming email from trusted domains** (`glide.pop3readerjob.create_caller`).

![Property name: glide.pop3readerjob.create_caller](image)

- Automatically create users for incoming emails from trusted domains
  - Yes | No

3. Enter the list of trusted domains in **Trusted domains for creating users from incoming emails** (`glide.user.trusted_domain`).

![Property name: glide.user.trusted_domain](image)

- Trusted domains when creating new users from incoming email (Ignore email from untrusted domains unless from an existing user; use * for all domains)
  - *

**Note:** The `glide.user.trusted_domain` property prevents user creation if the sender is not from a trusted domain. However, the system may still process inbound actions for emails that are received from the domain. To have the system ignore these emails, set up a system address filter. For more information on setting up system address filters, see System address filters. You can also prevent untrusted users from triggering inbound actions by locking out the guest user.
4. Click **Save**.

5. **Optional:** Complete the following steps to lock out the guest user.
   a. Navigate to **User Administration > Users** and select the user **guest**.
   b. Select the **Locked out** field to disable the guest account.

**What to do next**

When the property `glide.pop3readerjob.create_caller` is set to **false**, the instance runs inbound actions from users who do not match an existing user by impersonating the guest user.

If the property `glide.pop3readerjob.create_caller` is set to **true**, but a user has a valid email address associated with a non-primary device, the instance creates a new user record for that email address if there is no matching email address in the Users [sys_user] table. The instance does not validate non-primary email addresses against the Notification Devices [cmn_notif_device] table.

The method the instance uses to create users can be upgraded to use the full email address by activating the Email Automatic User Creation plugin.

The plugin sets the property `glide.email.create_userid_from_email` to **true** by default. After activating the plugin, enable automatic user creation from email.

⚠️ **Warning:** Review your existing user records to reconcile any that contain identical email addresses. If you activate the plugin prior to reconciling email addresses, your instance cannot distinguish between users with identical email addresses and randomly selects one of the users with the matching email address.

**Allowing locked out users to process inbound email actions**

A property is available to allow locked out users to trigger inbound actions. For example, enabling the property can allow locked out users to reset their password and send email to the instance asking for assistance.

**Property allowing locked out users to trigger inbound email actions**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>glide.pop3.process_locked_out</code></td>
<td>Enables (true) or disables (false) the ability for locked out users to trigger inbound actions.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• System Properties [sys_properties] table</td>
</tr>
</tbody>
</table>
Warning: Enabling this property (`glide.pop3.process_locked_out`) also enables users from untrusted domains to trigger inbound actions. The user must still be active.

Redirecting email to the instance POP3 account

Configure other mailboxes to forward email to the instance's POP3 account.

By default, the **POP Reader** scheduled job checks for new email every two minutes. It connects to the mail server and account specified in email properties. The **POP Reader** downloads any email waiting on the mail server and creates `email.read` events. After the instance processes the events, the inbound email actions run.

The **POP Reader** shows the number of emails processed during the reader's last run. The message shows the number of emails the reader processed or 0 if no emails were available. The reader resets the status each time it runs.

While it is not possible to specify more than one POP3 account for the instance, you can forward other mailboxes to the designated POP3 account. This script can be added to the Create Incident inbound email action to differentiate the content based on the original recipient, and then set an `assignment_group` value.

```javascript
if(email.direct.indexOf('facilities@anycorp.com')>-1)
  current.assignment_group.setDisplayValue('Facilities Management');
```

Setting field values from the email body

Values in an inbound email can set field values in a task record.

Any name:value pair in an inbound email body gets parsed into a variable/value pair in the inbound email script. The name:value pair must be on its own line. Note that most email clients limit the number of characters allowed per line and may truncate excessively long name:value pairs.

**Tip:** To prevent unexpected parsing, ensure that all the names in the name:value pairs are unique.

To populate a reference field, use `setDisplayValue()` instead. See Redirecting Emails for an example of using `setDisplayValue()` in an inbound email action.

**Note:** The action always generates a lowercase variable name. Also, this functionality does not work on reference fields.
For example, if an email body contains this line:

```
Foo:bar
```

The inbound email script creates the variable `email.body.foo` with the value of `bar`. You can use these variables to create conditions such as:

```
if(email.body.foo!=undefined){
    current.[field]=email.body.foo;
}
```

In this example, the script sets the value of `[field]` to the value `bar`.

**Note:** Spaces are rendered as underscores when a name:value pair gets parsed into a variable/value pair. For example, if an email body contains a line with spaces like `my variable:data`, then the inbound email script creates the variable `email.body.my_variable`. The value of the variable is `data`.

### Integrate inbound events

This example illustrates how to create a notification from an inbound JSON request.

#### Before you begin

Role required: admin

#### About this task

When complete, you will be able to:

- Send a JSON request to the [imp_notification] web service import set with the JSON processor
- Create a new import set in the [imp_notification] table in the instance using data from the JSON request

The following example steps assume you have your own demonstration instance.

#### Procedure

1. Activate the JSON Web Service plugin.
2. Install the RESTClient Firefox plugin.
3. Open the RESTClient.
4. Create the following JSON request.
   - **Method**: POST
   - **URL**: `http://<instance name>.service-now.com/imp_notification.do?JSON`
• **Headers**: Authorization: Basic

• **Body**:

```json
{"sysparm_action":"insert","message":"this is an event","uuid":"abc"}
```

5. Click **Send**.

6. Navigate to **Response > Response Body (Raw)**.

7. Verify that the instance sends back a response with a `sys_id`.

8. Login to your development instance.

9. In Navigation filter, enter **imp_notification.list**.

10. Verify that the import set table has an event matching your JSON request.

**Reprocess received emails**

When an email has been processed incorrectly, fix the underlying problem, then reprocess the email. You can reprocess emails individually or in a batch.
Before you begin
Role required: admin

About this task
Various scenarios can result in improperly processed emails. After taking corrective action, reprocess the emails to get correct email records. Two of the most common scenarios are:

• The inbound action failed to trigger correctly. After you update or fix the inbound action, reprocess the affected emails to create the correct records.

• Emails have accidentally ended up on a development instance, usually due to the username or password of a production or test instance being reused on the development instance. In this case, you first export the emails from the development instance as XML and import them to the correct instance. On the correct instance, reprocess the imported emails to obtain correct email records.

You can reprocess emails with the types received or received-ignored. Such emails are processed to the system mailboxes Received and Junk, respectively.

Take the following steps only after fixing the underlying problem. This procedure only reprocesses the emails.

Procedure
1. Navigate to the relevant System Mailbox or navigate to System Logs > Email.
2. Decide whether to reprocess emails individually or in a batch.
• To reprocess an individual email, open that email and click **Reprocess**.

To reprocess several emails at once, select them from the mailbox or the email log and apply the **Reprocess received emails** action.

Remember that you can reprocess only received or received-ignored emails.

**Inbound email action examples**

Various examples of inbound email actions are available to help you build your own inbound email actions. These examples show how to set up inbound email actions to handle email replies, create (log) a problem record, request a change, and update an incident.

**Inbound email action example: handling email replies**

This example shows you how to set up inbound email actions to handle replies that users send back to the instance.
Before you begin
Role required: admin

About this task
The inbound email action parses the email and responds using a script. By default, an email received by the instance creates a new incident, and the body of the email is added to the Additional Comments text box. More refined Inbound Email Actions can create incident tickets with more data, thus saving the incident management team valuable time.

Normally, when a user responds to an email sent by the instance, the inbound email action matches the watermark to an existing incident, and updates the incident rather than creating a new record. However, if the watermark is missing, this inbound email action attempts to match a reply to the original incident.

This inbound email action is replicated in Flow Designer as the sample flow Inbound Email Flow Example: handling email replies. To view the sample flow, navigate to Flow Designer > Designer.

Procedure
1. Navigate to System Policy > Inbound Actions and click New.
2. Populate the form as follows:

<table>
<thead>
<tr>
<th>Inbound action field values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Target table</td>
</tr>
</tbody>
</table>

3. In Script, enter this code.

```javascript
gs.include('validators');

//Note: current.caller_id and current.opened_by are already set to the first UserID that matches the From: email address

if (current.getTableName() == "incident") {
    current.comments = "reply from: " + email.origemail + "\n\n" + email.body_text;

    if (email.body.assign != undefined)
        current.assigned_to = email.body.assign;

    if (email.body.priority != undefined && isNumeric(email.body.priority))
        current.priority = email.body.priority;
}```
Inbound email action example: logging a problem

This example shows you how to set up inbound email actions to create a problem record.

Before you begin
Role required: admin

About this task
Inbound email actions allow users to log or update incidents on an instance via email. The inbound email action parses the email and responds using a script.

This inbound email action is replicated in Flow Designer as the sample flow Inbound Email Flow Example: logging a problem. To view the sample flow, navigate to Flow Designer > Designer.

Procedure
1. Navigate to System Policy > Inbound Actions and click New.
2. Populate the form as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Log Problem</td>
</tr>
<tr>
<td>Type</td>
<td>New</td>
</tr>
<tr>
<td>Active</td>
<td>True</td>
</tr>
<tr>
<td>Target Table</td>
<td>Problem [problem]</td>
</tr>
<tr>
<td>Condition</td>
<td>email.subject.indexOf(&quot;Problem: &quot;) == 0</td>
</tr>
<tr>
<td>Script</td>
<td>current.description = email.body_text;</td>
</tr>
<tr>
<td></td>
<td>current.short_description = email.subject.toString().substring(9);</td>
</tr>
</tbody>
</table>
Inbound email action example: requesting a change

This example shows you how to set up inbound email actions to create a change request record.

Before you begin
Role required: admin

About this task
Inbound Email Actions allow users to log or update incidents on an instance via email. The inbound email action parses the email and responds using a script.

Procedure

1. Navigate to **System Policy > Inbound Actions** and click **New**.
2. Populate the form as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Request Change</td>
</tr>
<tr>
<td>Type</td>
<td>New</td>
</tr>
<tr>
<td>Active</td>
<td>True</td>
</tr>
<tr>
<td>Target Table</td>
<td>Change Request [change_request]</td>
</tr>
<tr>
<td>Condition</td>
<td>email.subject.indexOf(&quot;Change Request: &quot;) == 0</td>
</tr>
<tr>
<td>Script</td>
<td>current.comments = email.body_text;</td>
</tr>
<tr>
<td></td>
<td>current.short_description = email.subject;</td>
</tr>
</tbody>
</table>
Values automatically set from incoming email

The default inbound action for the Incident table automatically sets the following field values when it receives an incoming email.

<table>
<thead>
<tr>
<th>Field value set</th>
<th>Value used from incoming email</th>
</tr>
</thead>
<tbody>
<tr>
<td>current.caller_id</td>
<td>User ID of the first user whose email address matches the email.from variable.</td>
</tr>
<tr>
<td>current.opened_by</td>
<td>User ID of the first user whose email address matches the email.from variable.</td>
</tr>
</tbody>
</table>

If multiple users have the same email address, the instance first searches for an active user with the email address. Use unique email addresses for each user record whenever possible. If not, having only one active user with the shared email address guarantees that the instance always matches incoming email from this address to the active user.
Specifying the inbound email processing order

You can configure a processing order for inbound email actions and use the order to manage multiple filters in inbound email actions.

The Ordered Email Processing (com.glide.email_ordered_processing) plugin is enabled by default for new instances. Users with the admin role can activate the plugin for upgraded instances. The plugin adds the Order column to the Rules [sysrule] table, which the instance uses to determine when to process emails. Admins can also add a command to an action script that halts processing after the script runs.

Configure the processing order

Configure the processing order for inbound email actions to force them to run in a prescribed order.

Before you begin
Role required: admin

Procedure
1. Navigate to System Policy > Email > Inbound Actions.
2. Open an existing inbound action or create one.
3. Complete the form and assign an order number to the Order field to establish when this inbound rule should run in relation to other rules. If you upgraded and activated the plugin, the Order field might be named Execution Order.

Note: Ensure each inbound action has a unique Order value to ensure the system stops processing as expected. If multiple inbound actions have the same Order value, the system might evaluate all of the inbound actions, even if one of them contains the event.state="stop_processing"; script or has the Stop processing option selected.
4. To stop rule processing when an inbound email action runs successfully: add the following line to the bottom of the script:
• Select the **Stop processing** check box.

• Add the following line to the bottom of the **Actions** script:

```
event.state="stop_processing";
```

### Manage multiple filters in an inbound email action

Use process ordering and the `stop_processing` command to manage multiple filters in inbound email actions.

**Before you begin**

Role required: admin
About this task
In this example, you can create new problem records when prb: appears in the subject line and new change requests when chg: appears in the subject line. All other emails are used to create an incident. The actions are set up as follows:

Procedure
1. Create an action with a condition of Subject > starts with > chg: and the event.state="stop_processing"; command appended to the script.
2. Assign this action an Order value of 100.
3. Create an action with a condition of Subject > starts with > prb: and the event.state="stop_processing"; command appended to the script.
4. Assign this action an Order value of 200.
5. Create an action for incident with no conditions and an Order value of 300.

   It is not necessary to add the stop_processing command to the script for the incident action unless you want processing to stop at this rule to avoid continuing to another action.

Results
If either a change request or a problem is created, the stop_processing command stops processing, and no incident record is created. If neither a change request nor a problem is created, the inbound email action for incident creates a record.

Notify
Notify provides support for SMS and voice channels on the ServiceNow platform for communicating internally with team members and externally with customers and contractors. The plug-in also provides APIs and workflow activities to achieve the above. Some customers directly make use of the APIs in their products others via products like Major Incident Management, On-Call and CTI Softphone.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Notify Release notes</td>
<td>• Activate Notify</td>
<td>• Notify workflow activities</td>
</tr>
<tr>
<td>• Differences between Legacy Notify and Notify</td>
<td>• Configure Notify with Twilio</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Notify Number and Number groups</td>
<td></td>
</tr>
</tbody>
</table>
### Use
- Using Notify with tasks
- Using Notify with Incident Communications Management
- Using Notify with On-Call Scheduling
- Notify conference calls
- Use SMS with Notify

### Develop
- Developer training
- Developer documentation
- Components installed with Notify

### Integrate
- Notify-Twilio Direct driver

### Troubleshoot and get help
- Ask or answer questions in the developer community
- Search the Known Error Portal for known error articles
- Contact Customer Service and Support

### Migrate
- Migrating from Legacy Notify
- Migrate to Notify-Twilio Direct driver

### Activate Notify
You can activate the Notify (com.snc.notify) plugin if you are an administrator. This plugin includes demo data and activates related plugins if they are not already active.

### Before you begin
Role required: admin

### About this task
Notify activates these related plugins if they are not already active.
## Plugins for Notify

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E164 Compliant Phone Number [com.glide.phone_number]</td>
<td>Provides E-164 compliant phone number support.</td>
</tr>
<tr>
<td>SMS Preferences [com.snc.sms_pref]</td>
<td>Provides ability to set SMS preferences for receiving messages from different providers.</td>
</tr>
</tbody>
</table>

⚠️ **Note:** If you are upgrading from an earlier version of Notify, the Notify-Twilio driver remains active.

### Procedure

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

⚠️ **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

### Related information

- [List of plugins](#)

### Differences between Notify and Legacy Notify

Describes the differences between the Notify and Legacy Notify applications, including architecture, workflows, Twilio support, and task-initiated conference calls.

<table>
<thead>
<tr>
<th>Legacy Notify (com.snc.notifynow)</th>
<th>Notify (com.snc.notify)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is deprecated. Supported only telephony services.</td>
<td>Supports pure conferencing solutions such as Zoom in addition to the Telephony providers like Twilio.</td>
</tr>
<tr>
<td>Legacy Notify (com.snc.notifynow)</td>
<td>Notify (com.snc.notify)</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Manage a single number from a Twilio account per instance.</td>
<td>Provides support for multiple numbers per Twilio account, especially cross-geographical scenarios.</td>
</tr>
<tr>
<td>Does not include support for customizable workflows for Voice and SMS incoming or outgoing scenarios.</td>
<td>Workflow-driven approach for handling incoming and outgoing Voice and SMS events, making the integration easy to customize.</td>
</tr>
<tr>
<td>Hard-coded join conference SMS and IVR prompts for joining a conference call.</td>
<td>Includes a configurable workflow for handling SMS and Voice IVR prompts.</td>
</tr>
<tr>
<td>Support for SMS-based answers.</td>
<td>Notify On Task support for sending SMS and initiating conference calls from any task.</td>
</tr>
</tbody>
</table>

### Migrating from Legacy Notify

When migrating to Notify from the Legacy Notify functionality, several changes are made to the instance.

If the Legacy Notify functionality is already enabled, several automatic changes occur when you activate Notify:

- The Legacy Notify menu is removed from the application navigator.
- Two separators are added to the new Notify menu: **Legacy Notify** and **Legacy Notify Admin**. New modules that replace the Legacy Notify modules are added to these sections.

⚠️ **Note:** The added modules are not the same modules that were in the Legacy Notify menu. Any customizations made to the Legacy Notify modules are not preserved.

- The notify_admin role allows access to Notify modules.
- The notifynow_admin role allows access to Legacy Notify modules.
- All workflow activities from the Legacy Notify application are moved to the **Legacy Notify** group.

### Notify-Twilio Direct driver

The Notify-Twilio integration with the Notify-Twilio Direct driver provides APIs and workflow activities for applications to handle various notification features.
The Notify-Twilio Direct driver provides the following notification features:

- Start and manage a conference
- Send and receive SMS messages
- Send and receive calls

Notify automatically creates a TwiML application in the Twilio account and configures the application to use the instance as an endpoint.

Phone numbers associated with the Twilio account are imported to Notify. To manage phone numbers per instance, set up one Twilio account for each instance and configure all relevant phone numbers for the instance under that account.

⚠️ Note: Only one Twilio account (or subaccount) can be configured on a given Notify driver at a time. Both the old and new driver can be used simultaneously because they can be configured with different accounts.

**Activation Information**

For new customers, only the Notify-Twilio Direct driver is available by default. For customers upgrading to the latest version, both the Notify-Twilio Direct and Notify-Twilio drivers are available.

The Notify plugin must be active to access Notify.

**Related information**

- [Configure Notify with Twilio](#)

**Differences between Notify-Twilio and Notify-Twilio Direct**

Describes the differences between the Notify-Twilio and Notify-Twilio Direct drivers, including architecture, workflows, Twilio support, and task-initiated conference calls.

### Differences between Notify-Twilio and Notify-Twilio Direct

<table>
<thead>
<tr>
<th>Notify-Twilio (com.snc.notify.twilio)</th>
<th>Notify-Twilio Direct (com.snc.notify.twilio_direct)</th>
</tr>
</thead>
<tbody>
<tr>
<td>This plugin is deprecated. Notify - Twilio Direct Driver now replaces this plugin.</td>
<td>Provides next generation integration with Twilio and Notify.</td>
</tr>
<tr>
<td>Uses Java SDK based integration with Twilio.</td>
<td>It is a JavaScript based driver which uses platform provided outbound REST APIs to connect to Twilio.</td>
</tr>
</tbody>
</table>
## Differences between Notify-Twilio and Notify-Twilio Direct (continued)

<table>
<thead>
<tr>
<th>Notify-Twilio (com.snc.notify.twilio)</th>
<th>Notify-Twilio Direct (com.snc.notify.twilio_direct)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NA</td>
<td>Adds support for various advanced SMS features such as Co-pilot messaging, Twilio Notify bulk SMS.</td>
</tr>
<tr>
<td>NA</td>
<td>Adds support for various functionalities in conference calls such as view the participant who is speaking on the conference call, disable beep when someone enters/exits a conference, advanced call features like machine detection and so on.</td>
</tr>
</tbody>
</table>

### Migrate to Notify-Twilio Direct driver

Migrating to Notify-Twilio Direct driver provides next-generation integration with Twilio and Notify.

**Before you begin**
- Role required: notify_admin
- You must be connected to Twilio using the Notify Twilio driver.

**Procedure**

1. Click **Migrate Now**.
2. Click **Ok** on the confirmation dialog.
   - A disconnection of the Twilio driver is initiated and the Account SID and Auth Token are copied to Twilio Direct’s configuration page. Twilio Direct is then autoconnected to that account, and you are redirected to the driver’s configuration page.

### Configure Notify with Twilio

Configure Notify to use the Twilio telephony service.

**Before you begin**
- You must have an SID and authentication token for an active Twilio account (https://www.twilio.com/). You must have a separate contract with Twilio.
Important: Ensure that each instance on which you configure Notify uses a different Twilio account. Each account specifies a unique account SID, authentication token, telephone numbers, and endpoint. Using the same account across multiple instances may cause your Twilio service configuration to be overwritten.

Note: Account and sub-account are Twilio categorizations, and both act the same for a ServiceNow instance.

Role required: notify_admin

Procedure

1. Navigate to Notify > Administration > Twilio Direct Configuration.
2. On the Twilio Account Properties page, enter your Account SID.
3. Enter your Auth Token.
4. Click Connect.
   
   If the account is not associated with an instance and the connection is successful, a read-only list of E.164 and short code phone numbers associated with this Twilio account appears. This list displays the phone number, supported capabilities such as voice or SMS, the country for each Twilio number, and the Notify number group to which the number belongs.

   If the account is already associated with an instance, the system displays an error message. To connect to this account,
   - Disconnect the account from the instance.
   - Delete the TwiML apps in the Twilio account.

   Note: If you buy or release numbers on the Twilio account, open the configuration page again to refresh the list of numbers. Numbers removed from the Twilio service remain as Notify Number records, but with the Active field set to false. Use only active phone numbers for inbound or outbound communication.

What to do next

Phone numbers and short codes are provided by Twilio once the account is successfully connected and are stored on the Notify Phone Numbers [notify_number] table. Assign each number to a number group. Number groups allow you to control which workflows run when using the phone numbers in each number group.
**Twilio-Direct callback testing**

Make an outgoing call or send an SMS using Twilio and trigger callbacks to ServiceNow to test whether Twilio can reach the instance. You can also view when the last callback test was run, its status, and the test logs.

**Before you begin**

Role required: admin, notify_admin

**Procedure**

1. Navigate to **Notify > Administration > Twilio Direct Configuration**.
2. Click **Test Callbacks**.
3. Select the SMS option and click **Initiate SMS**.
4. Select the call option and click **Initiate Test Call**.

   **Note:** The callbacks can be tested only after a connection is established with Twilio.

**Advanced configuration for SMS**

Use the Twilio co-pilot features to improve SMS delivery with phone number like using multiple numbers to send high-volume messages and content intelligence to automatically format every message without writing custom code. Reach large lists of users with one API request.

**Before you begin**

Role required: notify_admin

**About this task**

The Twilio co-pilot features are enabled in your instance once configured.

An example of a copilot feature is that you can configure which identity (phone number, shortcode, or alpha sender ID) to use to send a message. You can also spread the messaging traffic over several phone numbers or prioritize an alpha sender ID when sending messages to countries where alpha senders are commonly used. To know more about these features, visit https://www.twilio.com/copilot.

**Important:** All the Twilio numbers must be part of the same messaging service for which you have enabled the **Advance SMS Features** feature.

The Twilio Notify bulk SMS feature is used to send SMS in bulk to customers. Use the passthrough sendBulkSMS API to reach large number of users across using a single API request. For more information on these features visit https://www.twilio.com/notify.
Procedure

1. Navigate to Notify > Administration > Twilio Direct Configuration.
2. On the Twilio Account Properties page, enter your Account SID.
3. Enter your Auth Token.
4. Click Connect.
5. On the Advance SMS Features tab, check the Intelligent SMS Handling box.
   
   Note: To setup Alpha Sender ID, users need to go to Twilio console.
6. On the Advance SMS Features tab, check the Twilio Notify Bulk SMS box.
   
   Note: This feature uses Twilio Notify feature and might have an associated cost. Contact Twilio Support for more details.

Related information

Use SMS with Notify

Advanced configuration for voice

Configure Answering Machine Detection (AMD) to determine if a human has picked up the call or not.

Before you begin
Role required: notify_admin

Procedure

1. Navigate to Notify > Administration > Twilio Direct Configuration.
2. On the Twilio Account Properties page, enter your Account SID.
3. Enter your Auth Token.
4. Click Connect.
5. On the Advance Voice Features tab, check the Detect answering machine box.
6. On the Advance Voice Features tab, enter the number of seconds in the Machine detection timeout field to set a timeout value.

Disconnect from a Twilio account

If a Twilio account is already associated with a different system, disconnect the account from the other system before connecting to the current instance.
Before you begin
Role required: notify_admin

Procedure
1. Navigate to Notify > Administration > Twilio Direct Configuration.
2. On the Twilio Account Properties page, click Disconnect.
3. In the Disconnecting Twilio account pop-up window, click OK.
   The account is disconnected from the instance. The system clears the Account SID and Auth Token fields and deactivates the list of associated phone numbers.

Public URLs
On-premise customers should ensure that the URLs are accessible from the Internet for the Notify-Twilio driver to work correctly.

The Notify-Twilio drivers (both new and old) require that specific URLs on the instance be accessible from the Internet by the Twilio server without authentication. If the instance is within a private network, you need to either port forward or set up a reverse proxy.

For the Notify-Twilio driver, the URLs are:

- /NotifyTwilioCallProcessor.do
- /NotifyTwilioCallStatusProcessor.do
- /NotifyTwilioSMSProcessor.do
- /NotifyTwilioDialStatusProcessor.do
- /NotifyTwilioEventProcessor.do
- /NotifyTwilioDialProcessor.do
- /NotifyTwilioRecordingProcessor.do

For the Notify-Twilio Direct driver, the URLs are:

- /api/sn_twilio_direct/twilio_callbacks/process/twiml/{callback_name}
- /api/sn_twilio_direct/twilio_callbacks/process/xml/{callback_name}

⚠️ Note: The glide.notify.endpoint property needs to be set to an Internet visible name because the instance name inside a private network can be different from the Internet domain.
Components installed with Twilio Direct driver

Several types of components are installed with the Twilio Direct driver for integration with Notify.

Business rules installed with Twilio Direct driver

Twilio installs the following business rules:

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Connected</td>
<td>[sn_twilio_direct_twilio_config]</td>
<td>Verifies if Twilio is completely configured and displays an info message.</td>
</tr>
<tr>
<td>Disconnected Message</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calculate test duration</td>
<td>[sn_twilio_direct_callback_test]</td>
<td>Sets the duration for Twilio Callback tests.</td>
</tr>
<tr>
<td>Machine detection timeout</td>
<td>[sn_twilio_direct_twilio_config]</td>
<td>Verifies the timeout values for detecting the answering machine if the Detect answering machine is enabled. The valid range of the timeout is 3-120 seconds.</td>
</tr>
<tr>
<td>Machine detection timeout range check</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move credentials</td>
<td>[sn_twilio_direct_twilio_config]</td>
<td>Moves the account credentials to [sn_twilio_direct_basic_auth]</td>
</tr>
<tr>
<td>Populate Credentials</td>
<td>[sn_twilio_direct_twilio_config]</td>
<td>Populates the current SID and Auth token from the [sn_twilio_direct_basic_auth] table to display them.</td>
</tr>
<tr>
<td>Set outbound calculated fields &amp; auth</td>
<td>[sn_twilio_direct_twilio_config]</td>
<td>Sets the account credentials in the basic auth profile</td>
</tr>
<tr>
<td>Set Reset JWT Key</td>
<td>[sn_twilio_direct_basic_auth]</td>
<td>Copies the auth token from [sn_twilio_direct_basic_auth] to signing key password in [jwt_keystore_aliases].</td>
</tr>
<tr>
<td>Validate &amp; set inbound calculated fields</td>
<td>[sn_twilio_direct_twilio_config]</td>
<td>Populates the callback_endpoint field based on the inbound rest field value. Displays an error message if</td>
</tr>
</tbody>
</table>
## Business rule

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>the endpoint URLs are not in the correct format.</td>
</tr>
</tbody>
</table>

### Validate Fast Bulk SMS option

- **Table:** [sn_twilio_direct_twilio_config]
- **Description:** When **Twilio Notify bulk SMS** is enabled, validates the Twilio messaging and Notify service id.

### Validate Intelligent SMS option

- **Table:** [sn_twilio_direct_twilio_config]
- **Description:** When **Intelligent SMS handling** is enabled, validates the Twilio messaging service id.

## Tables installed with Twilio Direct driver

The tables installed with Twilio Direct driver are described below.

### Tables installed with Twilio Direct driver

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[sn_twilio_direct_callback_processor]</td>
<td>Extends the application file. Contains scripts which process callback payloads from Twilio and generate appropriate response XML or TwiML document.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Use caution when editing, deleting or adding new Callback Processor scripts as they are one of the key core components of the driver.</td>
</tr>
<tr>
<td>[sn_twilio_direct_twilio_config]</td>
<td>Extends the application file. Contains configuration option values for the driver.</td>
</tr>
<tr>
<td>[sn_twilio_direct_basic_auth]</td>
<td>Extends the basic auth credentials. The Account SID and Auth token are stored in this table.</td>
</tr>
<tr>
<td>[sn_twilio_direct_callback_test]</td>
<td>Stores the history of callback test runs.</td>
</tr>
</tbody>
</table>
Notify Zoom connector
The Notify Zoom Connector expands the Notify communication channel by managing and initiating a Zoom meeting directly from any task record such as an incident or a change.

Compatibility
New York and later

Key Features
• Start and end Zoom meeting directly from any task record such as incident, or a change or even from the Major incident Workbench.
• Manage a Zoom meeting by adding or removing participants.
• Track and report meeting details such as meeting duration and attendees for further analysis.

System Requirements
• Install and activate the Notify plugin (com.snc.notify) before you install the application.
• Ensure that the system has Zoom spoke, version 1.0.2, for ServiceNow IntegrationHub plugin (sn_zoom_spoke) installed and the necessary IntegrationHub license to use Zoom for meeting management.

Plugins
• ServiceNow IntegrationHub Installer (com.glide.hub.integrations): Suite of plugins necessary to design integration flows in the Flow Designer application.
• The Zoom spoke, version 1.0.2 (com.sn.zoom.spoke) for ServiceNow IntegrationHub provides actions that allow user to create and manage the conference meetings.

Set up Notify Zoom connector in Zoom
Use the Notify Zoom connector to expand the Notify communication channel by managing and initiating a Zoom meeting directly from any task record such as an incident or a change.

Before you begin
Role required: admin, Zoom admin
1. Ensure that you have Zoom spoke installed on your instance.
2. Make sure you have the required credentials and connections to Zoom on your instance.
3. Configure the Notify Zoom connector with the same Zoom account with which you created the OAuth app for Zoom spoke.

**Procedure**

1. On your Zoom OAuth app, navigate to **Feature > Add Feature > Event Subscription**.
2. Use the toggle button to enable the event subscription feature.
3. In the form that appears, fill in the URL. The URL is used to post information about events in Zoom to your instance. The format of the URL is: `https://yourinstancename.com/api/sn_notify_zoom/notify_zoom/ZoomEvent`
4. Use the **Add Events** button to list all the events which Zoom is informing Notify about.
5. In the categories that appear, select **Meeting** and select all the meeting-related events from the list and click **Done**.
6. Under **Recording**, select **All Recordings have completed** and **Recording Transcript files have completed** from the list and click **Done**.
7. Click **Save** on the Add feature screen.
8. A **Verification Token** appears on the Add Feature screen. Record the token by clicking **Copy**

**What to do next**
Configure Notify with the verification token from Zoom.

**Related information**
Configure Notify Zoom connector in Notify

**Configure Notify Zoom connector in Notify**
Configure Notify to receive the event information from Zoom. An event is usually any action that is related to a meeting.

**Before you begin**
Role required: admin
Procedure

1. Navigate to Notify > Zoom > Configuration.
2. Paste the verification token that you recorded on Zoom Event Subscription screen in the Webhook validation token field.
3. Save the record.

What to do next
Configure and use Zoom as a conference provider from any of the task records.

Note: The person creating a conference is the host of the conference and must have their email set in their ServiceNow profile and use the same email for the Zoom account.

Related information
- Configure a provider in Notify
- Start a conference call

Disable Zoom meeting password
Disable Zoom meeting password so that you can join a Zoom meeting without any meeting password.

Before you begin
Role required: notify_admin or admin

Procedure

1. Navigate to Notify > Zoom > Configuration.
2. Select Do not set password.
3. Click Update.

Notify voice and SMS capabilities
Notify provides support for SMS and voice channels for communicating internally with team members and externally with customers and contractors.

Notify provides a way for applications to start and manage a conference, send/receive SMS, send/receive calls and present them with IVR like system.

How Notify processes incoming calls
Notify processes incoming calls using workflow activities.
Any Notify activity that manages incoming phone calls creates a record on the Notify Workflow Activity [notify_wf_activity] table. Each notify_wf_activity record is associated with a single call. These records store JSON data detailing the actions to send to the telephony provider.

Notify processes incoming calls in the following way:

1. A person calls a Notify phone number.
2. Notify launches the incoming call workflow associated with that Notify phone number.
3. The workflow reaches a Notify activity and invokes the activity onExecute() function.
4. The activity creates a new notify_wf_activity record detailing any actions to take, with a State value of execute.
5. Notify sends the specified actions to the telephony provider.
6. The notify_wf_activity record State changes to processed.
7. The telephony provider sends a response.
8. Response arguments, such as user input or recording info, are stored as JSON data in the notify_wf_activity response_args field.
9. The notify_wf_activity State changes to complete.
10. The JSON data from the notify_wf_activity record is copied to the Last action field in the Notify call record that triggered the workflow.
11. The workflow invokes the onUpdate() function in executing activities.
12. The activity confirms that the associated notify_wf_activity record has completed, and changes the activity state to finished.
13. The workflow transitions to the next activity.

Notify conference calls

Notify administrators, major incident managers, or communications managers can manage conference calls.

Conference call records are stored on the Notify Conference Calls [notify_conference_call] table. Conference call participant records are stored on the Notify Conference Call Participants [notify_participant] table.

Conference call and participant records are created automatically when starting and connecting to a conference call. Most fields, such as the Duration of a call, are set automatically using business rules.
**Note:** If a participant attempts to join a conference call using an invalid phone number, the caller is added to the participant list and the phone number is marked with a status of *Invalid*.

Notify administrators, major incident managers, or communications managers can manage conference call participants.

Several conference call workflows are available by default. These workflows can be used for incoming and outgoing calls and incoming SMS messages. Conference call workflows are:

- Notify: (Re)join Conference Call
- Notify: Join Conference Call Via SMS
- Notify: (Re)join Conference Call with muting

**Note:** Notify: (Re)join Conference Call with muting is available only with demo data.

The number groups Conference Call Group and Notify On Task Group use these conference call workflows by default.

**Start a conference call**

Start a conference call from a task or an incident communication plan by inviting one or more users to join a call. The conference will not start until at least two participants join.

**About this task**

Call participants can include:

- Users who have been assigned specific responsibilities
- Ad-hoc user contacts
- Other involved parties who are not recorded as users, such as third-party contacts

**Procedure**

1. Navigate to Incident Communications Management > Open.
2. Open the relevant incident communication plan.
3. Click the Initiate Conference Call related link.
4. From the dialog box that appears, choose the Conference Bridge that you want to dial from.
5. Select the participants for the conference.
The dialog box displays the Recommended and Selected participants for the conference. All users from the User Contacts list in the incident communication plan are in the Recommended section by default. The user who initiates the conference call is added to the selected list of participants.

If a shift exists for the group contacts, the primary and secondary on-call resources are shown in the Recommended list.

Calls are placed to the number in the Mobile phone field on the user record. If that information is blank, the user cannot be contacted through Notify. The mobile phone number has to be an E.164 compliant phone number. If the phone number is a local number, without the + prefix, the number will be
retrieved based on the user's location and, if possible, converted into a valid E.164 number.

6. To select ad-hoc participants,

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the reference lookup icon, and select the relevant user.</td>
<td>Click <strong>Add to selected</strong>.</td>
</tr>
<tr>
<td>Enter the participant's phone number</td>
<td>Click <strong>Add to selected</strong>.</td>
</tr>
</tbody>
</table>

7. After the participant list is finalized, click **Start Call**. The conference call starts and a **Conference call initiated** message is displayed at the top of the incident communication plan form. Each user is called and can accept the call to join the conference.

8. Click the **Conference call initiated** message to see details of that conference call. When the final participant leaves the conference, the conference call closes.

   ✉  Note:  VoIP phone systems, which do not use touch tone phones, may encounter issues with recognizing key presses. To avoid problems, ensure that conference call users use touch tone phones, or configure your VoIP system settings to recognize key presses, as described in your VoIP system documentation.

Add participants to a conference call

Add a participant to a conference call using Notify.

Before you begin
Role required: notify_admin, major_incident_manager, or communication_manager

About this task
You can add the following participants:

- Users who have been assigned specific responsibilities
- Required ad-hoc user contacts
- Other involved parties who are not recorded as users, such as third-party contacts
Procedure
1. Navigate to **Notify > Conference Calls**.
2. Open the conference call that you want to add a participant to.
3. Click the **Add Participant** related link.
4. In the dialog box that appears, select the participants you want to add to the conference.
   You can add a single participant, a group of participants, or a phone number.

**Add Participants dialog box**

5. You can send an optional message for the participant who you want to add in the **Include a brief message for participants** field.

6. Click **Add Participant**.
   The selected user, group, or phone number is added to the selected conference call.
Related information

Mute or kick a conference call participant

Mute or unmute all participants
As a communications manager or a conference call host, mute/unmute all the conference participants from the workbench.

Before you begin
Role required: notify_admin, major_incident_manager, or communications_manager
Before starting this procedure, ensure there is an active conference call with one or more participants.

Procedure
1. Navigate to Major Incident Management in the application filters.
2. Select the incident that you are trying to resolve.
3. On the incident, click View Workbench
4. In the Conferences tab, select a conference

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute All</td>
<td>Click this button to mute all the participants in the conference</td>
</tr>
<tr>
<td>Unmute All</td>
<td>Click this button to unmute all the participants in the conference</td>
</tr>
</tbody>
</table>
Mute All

Unmute All
Mute or kick a conference call participant
As a communications manager, you can mute or kick conference call participants.

Before you begin
Role required: notify_admin, major_incident_manager, or communication_manager
Before starting this procedure, ensure there is an active conference call with one or more participants.

Note: Any participant with the host flag set to active, can mute or kick a participant from a conference call.

Procedure
1. Navigate to Notify > Conference Calls.
2. Select a conference call.
3. In the Notify Conference Call Participants related list, select a participant.
4. Click Mute or Kick.

   Note: You can unmute a muted participant. A kicked participant may rejoin the conference call by calling in again.

Send a message to conference call participants
Send a brief message as a text or voice message to the participants of a conference call to set a context to the call.

Before you begin
Role required: major incident manager

About this task
You must configure a telephony provider like Twilio so that you can use one of the Notify numbers to send SMS to the conference call participants.

Procedure
1. Navigate to Major Incident Management > View Workbench.
2. In the Conference tab, select the type of the call and click Start Call.
3. In the Include a brief message for participants field, type the message that you want to send to the conference call participants and click Start Call.
**Initiate a conference call**

**Conference Bridge**
+14046204596

**Add Participants**
- Email

**Selected**
- System Administrator (Open eig
- Lucy Barnes (Incident Manage

**Include a brief message for participants**

*Users displayed in red do not have a mobile phone number*

*160 characters remaining of 160 characters*

**Note:** Upon clicking **Start Call** the message text entered will be stored as description on the conference call record. If the OOB workflow is not modified, then the workflow takes care of sending this message text as SMS to the user. This is applicable if you have configured a telephony provider.

**Viewing conference call information**

Conference calls are listed as system activities in the **Activity** section of the Incident Communication Plan form and also are listed in the **Conference Calls** related list.
List of Notify calls

If you are a Notify administrator, you can view a list of calls and the status of a call made to or from Notify. The call records help in reporting and analytics.

To view a list of calls, navigate to Notify > Calls.

Call records are generated automatically when a user calls a Notify number or when a user makes an outbound call through Notify. You cannot create call records manually.

**Note:** Although you can delete a call record, doing so may result in cascade deletion of related records.

For Notify calls where the source is specified, such as a task number, the source is added to the Notify Calls [notify_call] table in the Source column. For Notify conference calls where the source is specified, the source is added to the records for each of the calls in the conference.

<table>
<thead>
<tr>
<th>Call status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>initiated</td>
<td>The number has just been dialed</td>
</tr>
<tr>
<td>ringing</td>
<td>The call is currently ringing.</td>
</tr>
<tr>
<td>in_progress</td>
<td>The call was answered and is currently in progress.</td>
</tr>
<tr>
<td>no_answer</td>
<td>The call was not answered.</td>
</tr>
<tr>
<td>Call status</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>completed</td>
<td>The call was answered and has ended normally.</td>
</tr>
<tr>
<td>busy</td>
<td>The caller received a busy signal.</td>
</tr>
<tr>
<td>failed</td>
<td>The call could not be completed as dialed, most likely because the phone number was non-existent.</td>
</tr>
<tr>
<td>invalid</td>
<td>The call could not be connected since input is invalid.</td>
</tr>
<tr>
<td>unknown</td>
<td>The driver does not support the status</td>
</tr>
</tbody>
</table>

### Use SMS with Notify

Send and receive SMS messages using Notify.

Notify stores inbound and outbound SMS messages in the Notify Messages [notify_message] table.

Notify supports sending concatenated SMS messages. Messages that exceed 160 characters, or 70 unicode characters, are split into multiple messages. This may affect your total telephony cost because each message can incur a cost. Some mobile carriers, such as Sprint, do not support concatenated SMS messages.

To send SMS messages to an individual recipient, use the Notify API `sendSMS` method. This method takes one recipient as an input parameter. You can also use the `send SMS` workflow activity.

To send SMS messages to one or more recipients, use the Notify API `sendBulkSMS` method. This method takes a list as an input parameter and uses one API call to send multiple messages. Include the list of phone numbers in an array in the API call. This method improves performance by streamlining platform checks and Notify number validation.

> **Note:** When using `SNC.Notify.sendBulkSMS` API, instead of simply iterating over the numbers, all the given numbers are sent for SMS to Twilio in one API call. This happens only when Twilio Direct driver is active and Twilio Notify bulk SMS is enabled for the number in Advanced SMS features.

The Notify-Twilio integration provides programmable SMS outbound message status tracking with Status Callbacks. These callbacks can be helpful to see if a message has been delivered, failed, or ran into some other delivery issues.
SMS Statuses

Every Twilio SMS message request has a status value which describes the current state of the message. Use this information for troubleshooting SMS related incidents/ issues. Here are few descriptions of possible statuses of SMS sent from Notify through Twilio REST API.

Outbound message status progression

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>queued</td>
<td>The message has been queued by the provider to be sent to the carrier network.</td>
</tr>
<tr>
<td>accepted</td>
<td>The message is being processed by the provider before sending it to the carrier network.</td>
</tr>
<tr>
<td>sending</td>
<td>The message is being forwarded to the carrier network.</td>
</tr>
<tr>
<td>sent</td>
<td>The message has been successfully forwarded to the carrier network.</td>
</tr>
<tr>
<td>receiving</td>
<td>The provider has received an incoming message from the carrier network and is processing it.</td>
</tr>
<tr>
<td>received</td>
<td>ServiceNow has received the incoming message from the provider.</td>
</tr>
<tr>
<td>delivered</td>
<td>The message has been delivered to the target device.</td>
</tr>
<tr>
<td>undelivered</td>
<td>The message could not be delivered to the target device.</td>
</tr>
<tr>
<td>failed</td>
<td>The message failed to be forwarded to the carrier network.</td>
</tr>
<tr>
<td>unknown</td>
<td>The driver does not support the status</td>
</tr>
</tbody>
</table>

Note: A provider may not be able to report this status if the upstream carrier does not report this.
Send an SMS with Zoom meeting invite

Send an SMS with Zoom meeting invite to ensure that the meeting participants or any newly added participant is updated with the meeting details when the meeting host starts the conference or adds a participant to the conference.

Before you begin
Role required: notify_admin or admin

ℹ️ Note: You need a telephony provider like Twilio or Nexmo.

Procedure
1. Navigate to Notify > Zoom > Configuration.
2. In the Run Workflow on conference change field, enter Notify Zoom: Send SMS on Conference Change.
   The Notify Zoom: Send SMS on Conference Change workflow is available with the demo data of the Notify Zoom Connector plugin (sn_notify_zoom).
3. Click Update.

Outbound communication requirements
Outbound communications initiated through Notify, such as phone calls and SMS messages, must satisfy recipient number requirements.

Recipient number requirements
These requirements apply to any number that receives a Notify phone call or message.

- The number must be E.164 compliant.
- The number must be different than the phone number used to initiate the call or message.

These requirements apply to all outbound communication initiated through Notify, such as by using Notify workflow activities or the Notify JavaScript API.

Invalid numbers prevent Notify workflows from running and cause an error to be logged. Set the glide.notify.debug property to true to create detailed error logs.

Using Notify with tasks
Notify allows you to initiate conference calls and send SMS alerts from task records.
This functionality is available for all tables that extend the Task table, such as incident, problem, or change request. All calls and messages made from tasks are initiated using a single Notify phone number (E.164 or short code). You can configure which phone number is used by setting the property `glide.notify.task.phone_number`.

**Start a conference call from a task**

Use Notify to start conference calls from a task record.

**Before you begin**
- Role required: itil
- Notify must be set up before you can use Notify on task. Ensure there are Notify phone numbers (E.164 or short code) in number groups with phone call workflow.

Use the `glide.enable.notify_on_task` property to enable Notify integration for Task table and its extensions. Entering phone number in `glide.notify.task.phone_number` property is equivalent to setting `glide.enable.notify_on_task` to true.

**Procedure**

1. Navigate to any task record, such as an incident or change request.
2. Click the **Start conference call** related link.
3. Select one or more **Recipients** to participate in the conference call.
4. Click **Start**.
   - Any conference call records created from a task are associated with that task. You can view associated conference calls from the task record in the **Conference calls** related list. You may need to configure the form to add the related list.

**Manage conference calls on task**

Add and manage multiple participants on the conference including self-joining in to the conference call and end the conference call when the discussion is over.

**Before you begin**
- Role required: itil, itil_admin, or admin
- A conference call is already initiated.
About this task
The **Manage Conference Calls** UI action is available for any table that extends the Task [task] table. If at least one conference call is active on a task record, the link appears on the related links section of the form. Out of the tables that extend the task table, the **Manage Conference Calls** UI action is intentionally hidden for Incident Communication Plan [incident_alert] table and Communication Task [comm_task] table. For these two tables, the functionality is already available as **Join conference call** and **End conference call** UI actions.

Procedure
1. Navigate to any task record such as Incident, Problem, or Change Request.
2. Open the record on which the conference all is active.
3. In the related links, click **Manage Conference Calls**.
4. In the Manage Conferences window, you can perform the following activities:

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Join Conference Call</td>
<td>If the logged in user is not already a part of the conference call, the user can join the conference.</td>
</tr>
<tr>
<td>Add Participants</td>
<td>Add participants to the conference who can contribute to the discussion.</td>
</tr>
<tr>
<td>End Conference Call</td>
<td>End the conference when the discussion is over.</td>
</tr>
</tbody>
</table>

5. **Optional:** In the Manage Conferences window, click the conference call number to know the details of the conference.

Send an SMS alert from a task
Use Notify to send information related to a call through SMS alerts from a task record.

**Before you begin**
Role required: itil

**About this task**
Ensure that there are Notify phone numbers (E.164 or short code) in number groups with SMS workflows.
Use `glide.enable.notify_on_task` property to enable Notify integration for Task table and its extensions. Entering phone number in `glide.notify.task.phone_number` property is equivalent to setting `glide.enable.notify_on_task` to true.

Procedure

1. Navigate to any task record such as an incident or a change request.
2. Click the Send SMS related link.
3. In the From choice list, select the phone number from which you want to send the SMS message.
4. Select and add the participants to whom you want to send the SMS message. All users from the User Contacts list in the incident communication plan are in the Recommended section by default.

   The dialog box displays the Recommended and Selected participants you selected to send an SMS message.

5. To select ad-hoc participants, choose one of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the reference lookup icon and select the relevant user</td>
<td>Click Add to selected.</td>
</tr>
<tr>
<td>Enter the participant's phone number</td>
<td>Click Add to selected.</td>
</tr>
</tbody>
</table>

6. After the participant list is finalized, type the message you want to send to the participants in the Message field and click Send SMS.

Results

Any SMS records created from a task are associated with that task. You can view associated SMS messages from the task record in the SMS Messages related list. You might need to configure the form to add this related list.

Using Notify with Incident Communications Management

Use Notify with incident communication plan to send SMS messages or start conference calls.

Certain configuration steps are required to use Notify with an incident communication plan.
• Both Notify and Incident Communications Management must be active.
• Notify must be configured and able to initiate and receive phone calls and SMS messages.
• The property `com.snc.iam.notify_number` must be set to an active Notify number with outgoing voice and SMS capability.
• This Notify number must belong to a number group configured with inbound and outbound conference call workflows.

**Note:** The Conference Call Group number group is configured with conference call workflows by default.

**Related information**
- Incident Communications Management
- Numbers and number groups
- Notify conference calls

**Initiate a conference call from incident communication plan**

Use Notify to initiate a conference call from an incident communication plan by inviting one or more users.

**About this task**
Role required: admin

**Procedure**
1. Navigate to **Incident Communications Management > All**.
2. Open the relevant incident communication plan.
3. Click the **Conference** tab.
4. For the relevant incident communications task, under **Actions**, click **Start Conference Call**.
5. Select the conference bridge and the participants for the conference call. Available options in the conference bridge depend on the conference providers configured. For more information, refer **Configure a provider in Notify**.

**Join and end a conference call from incident communications management**

After a conference call is initiated, join the call to participate in the discussion or end the call when the conference is no longer required.
Before you begin
Role required: ia_admin or admin

Procedure
1. Navigate to Incident Communications Management > All.
2. Open the relevant incident communication plan.
3. Click the Conference tab.
4. For the relevant incident communications task, under Actions, perform one of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Join Conference Call</td>
<td>If you are not already logged into the conference call, you can join the conference.</td>
</tr>
<tr>
<td>End Conference Call</td>
<td>End the conference when the discussion is over.</td>
</tr>
</tbody>
</table>

Note: The work notes get updated with the details of the conference call such as duration and participants.

Send communication updates for an incident communications plan
Update users on the latest communication on an incident through selected communication channels.

Before you begin
• Role required: admin
• Activate the Notify plugin (com.snc.notify) if you want to send communication through SMS.
• Set at least one communication channel for a communication task as SMS or email.

Procedure
1. Navigate to Incident Communications Management > All.
2. Open an incident communication plan record.
3. From the Incident Communication Tasks related list, open the incident communication task for which you want to send updates.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
4. In the related links, click **Start Updates**.

5. Fill the required information and click **Send**.
   For sending an SMS communication, in the From choice list, select a number from which you want to send the communication.

6. Click **Send**.

**Related information**

**Incident Communications Management**

**Using Notify with On-Call Scheduling**

When using both Notify and On-Call Scheduling, you can send On-call escalation notifications as SMS messages, in addition to emails.

Configure the following items to use Notify with On-Call Scheduling:

- You must add at least one Notify phone number to the On-Call Group number group. This group is configured by default to handle inbound SMS responses (via On-Call: Check Assignment Response) that accepts or rejects an on-call assignment and to handle outbound voice calls (via On-Call: Assign by Acknowledgement Voice) to accept or reject assignments.

- You must configure workflows, such as the On-Call: Assign by Acknowledgement to drive escalations via SMS and Voice.

**Set up Notify with On-Call Scheduling**

You can configure on-call scheduling to use Notify functionality to send SMS alerts and assign users to tasks based on the SMS responses.

**Before you begin**

Ensure that the Notify and On-Call Scheduling plugins on your instance are activated.

Role required: admin

**About this task**

Set up Notify with On-Call Scheduling for the first time or migrate from On-Call Scheduling with NotifyNow.
Procedure

1. Navigate to Notify > Numbers.

2. Select the phone number you want to use to send and receive on-call scheduling messages.

3. In the Notify group field, select the On-Call Group.
   The On-Call Group is configured with the on-call workflows: On-Call: Check Assignment Response and On-Call: Assign by Acknowledgement Voice by default.

4. Navigate to Workflow > Workflow Editor.

5. Select the On-Call: Assign by Acknowledgement workflow.
   If migrating from NotifyNow, and you have previously customized this workflow, you must import the new version of the workflow manually. See KB0551603 for more information.

6. Click the workflow menu icon in the title bar and select Copy to copy the On-Call: Assign by Acknowledgement per rota workflow. Save the copied workflow under a different name than what it is named by default.

   Note: You must avoid modifying default workflows and instead choose to copy and then modify the required workflow.

7. Select a Send SMS activity.

8. In the To (script) field, modify the getRecipientsAndNumberToSendFrom() to use the correct from number's sys ID.

9. Close the Workflow Editor

10. Navigate to On-Call Scheduling > Trigger Rules.

11. Select a trigger rule that launches an assignment workflow

12. In the Trigger action field, select Workflow.

13. In the Trigger workflow field, select the On-call: Assign by Acknowledgement workflow.

14. Click Update.

15. Repeat the previous 3 steps for each assignment trigger rule.
   Each time the conditions for one of these trigger rules is met, the On-call: Assign by Acknowledgement workflow runs.

Related reference

Workflow editor title bar
Controlling the on-call communication channel with Notify

Configure On-Call Scheduling with Notify to always use a user's preferred communication channel.

If Force communication channel is specified in the Escalation settings for rosters, the preferred user device is used: SMS, voice, or email.

For example, if the preferred device is SMS and the on-call member does not have an SMS device defined, the user is not contacted even if the user has an email address. When forcing a communication channel on an escalation level does not succeed, no further communication attempts are made. The fact that the user could not be reached is logged.

Related information

Subscription-based notifications

Workflow: On-Call: Assign by Acknowledgement

The On-Call: Assign by Acknowledgement workflow is provided with Notify.

The workflow uses data from the escalation settings, including overlapping shifts and custom escalation settings, of shifts and rosters. Depending on these escalation settings, the workflow iterates through the defined escalation chain and sends notifications by SMS, email, or voice to users asking them for incident assignment. The workflow respects time-off as specified in the rosters. People who have time-off are not included in the escalation chain and no notifications are sent to them.

When you install both On-Call Scheduling and Notify, the message_number column is added to the Notify Messages [notify_messages] table to track responses to on-call assignment requests. This column indicates if the contacted user accepted or rejected the assignment. Before you can send notifications, you must define trigger rules. Trigger rules determine the conditions that must be met before a notification is sent and what action must be taken.

Call a user from the WebRTC UI

Make outbound calls and receive a voice call in the browser through the WebRTC interface from On-Call Schedules landing page, Roster and Escalation Details modal and on-call calendar.

Before you begin
Role required: itil
Procedure
1. Navigate to On Call scheduling > On Call calendars.
2. In the calendar that opens, click the name of the user you want to call.
3. Choose Call to call the user.

Key differences between on-call scheduling with NotifyNow and with Notify
There are key differences between on-call scheduling with NotifyNow and on-call scheduling with Notify.

Tracking responses to questions
The On call: Assign by Acknowledgement workflow no longer uses the Notify Question tables to track assignment responses. When you install On-Call Scheduling with Notify, the message_number column is added to the Notify Messages [notify_messages] table to track responses to on-call assignment requests. This column indicates if the contacted user accepted or rejected the assignment.

Notify administration
As a Notify administrator, you can create number and number groups, create and modify workflows, update the tables and so on.
Numbers and number groups

Number groups allow you to group Notify phone numbers and share workflows across grouped numbers.

Each phone number within Notify has an associated number group. Numbers within a group use the same workflows for handling incoming and outgoing calls and SMS messages.

Numbers associated with a group appear on the Notify Phone Numbers related list on the Notify Phone Number Group form.

If the number group workflows have incorrect conditions, a warning appears.

Create a number group

Group Notify phone numbers and share workflows across grouped numbers.

Before you begin

Role required: notify_admin

About this task

Each phone number within Notify has an associated number group. Numbers within a group use the same workflows for handling incoming and outgoing calls and SMS messages.

Numbers associated with a group appear on the Notify Phone Numbers related list on the Notify Phone Number Group form.
Procedure

1. Navigate to Notify > Number Groups.

2. Click New.

3. Enter a Name, and select Notify: (Re)join Conference Call for the Incoming call workflow field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the number group.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Incoming call workflow</td>
<td>Workflow to run when there is an incoming phone call for this group.</td>
</tr>
<tr>
<td>Incoming SMS workflow</td>
<td>Workflow to run when there is an incoming SMS message for this group.</td>
</tr>
<tr>
<td>Outgoing call workflow</td>
<td>Workflow to run when there is an outgoing phone call for this group.</td>
</tr>
<tr>
<td>Outgoing SMS workflow</td>
<td>Workflow to run when there is an outgoing SMS message for this group.</td>
</tr>
</tbody>
</table>


Short codes can only be associated with SMS workflow groups. You cannot add an incoming or outgoing call to a short code group.

4. Click **Submit**.

**What to do next**

**Associate a number to a number group**

After creating a number group, associate numbers with that group to use the selected workflows.

⚠️ **Note:** Each phone number can only be associated with one number group.

**Associate a number to a number group**

Associate a Notify number to a number group to use inbound and outbound workflows.

**Before you begin**

Role required: notify_admin
Procedure

1. Navigate to Notify > Numbers.

2. Click the listed phone number and assign it to a Number Group, as appropriate.

   Note: Each phone number can only be associated with one number group.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Number for the entry.</td>
</tr>
<tr>
<td>Phone number</td>
<td>E.164 phone number, if applicable.</td>
</tr>
<tr>
<td>Notify group</td>
<td>(Optional) Group to which this number is assigned.</td>
</tr>
<tr>
<td>Number owner</td>
<td>Service provider of the number.</td>
</tr>
<tr>
<td>Short Code</td>
<td>Short code number, if applicable.</td>
</tr>
</tbody>
</table>
3. Click **Update**.

### Configure a provider in Notify

Configure a conference provider or a phone number to be used as choices for initiating a conference call. For sending SMS, configure preferences for phone numbers.

**Before you begin**

Role required: notify_admin

**About this task**

**Procedure**

1. Navigate to **Notify > Provider Selector**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Provider selector fields</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Order</td>
</tr>
<tr>
<td>Source table</td>
</tr>
<tr>
<td>Condition</td>
</tr>
<tr>
<td>Active</td>
</tr>
<tr>
<td>Default</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual selection</td>
<td>Disables the automatic selection of this provider, for example, if in a communication plan you want to use this provider only as a forced communication channel.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

5. In the Provider Selector Choices section, click **New**.

6. Search for the conference provider or the Notify group that contains the phone numbers for initiating a conference.
   For sending SMS, search for the Notify group that contains the phone numbers.

7. Click **Submit**.

**Configure SMS opt-out preferences**

Allow recipients to opt out of receiving text messages.

**Before you begin**

Role required: admin, notify_admin

**About this task**

According to regulations in the CTIA Short Code Monitoring Handbook, recipients must be allowed to opt out of receiving text messages. The opt-out functionality is applicable only to Notify. When the user sends an SMS message with an opt-out keyword to any Notify number, the user is opted out of receiving messages from only the Notify number to which the message has been sent, not from all Notify numbers on that instance.

**Important:** The Advanced opt-out feature is automatically enabled for short code and long code numbers associated with a Messaging Service. For more information, refer Getting Started with Advanced Opt-Out for Messaging Services. As this feature is a duplicate of the Twilio’s new Advanced Opt-out feature, you should not activate the feature for numbers that are part of Messaging Service. For long code numbers that are not part of a Messaging service, Twilio handles the opt-out for default stop keywords listed at Twilio support for opt-out keywords.

**Note:** This feature is disabled by default and holds significance for short-code and long codes that are not part of Messaging Service. To enable this feature, the Notify admin needs to create a configuration for short and long codes using the given procedure.
Procedure

1. Navigate to Notify > Administration > SMS Preference Configuration.
2. Click **New** in the SMS Preference Configuration window.
3. Fill in the form fields.

### SMS configuration preference fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider</td>
<td>Select the provider for which you are configuring the SMS preferences.</td>
</tr>
<tr>
<td>Name</td>
<td>A user-friendly name for the configuration.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the preference configurations apply. If you have multiple configurations, this field indicates which configuration to consider first.</td>
</tr>
<tr>
<td>Default preference</td>
<td>The default preference for the configuration. The two options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Opt-in</strong>: Users by default will receive SMS messages.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Opt-out</strong>: Users by default will not receive SMS messages. They can start receiving SMS messages from a specific Notify number after sending a message with an opt-in keyword like START or BEGIN.</td>
</tr>
<tr>
<td>Enable for long code</td>
<td>Option that enables the opt-out feature for long code or toll-free numbers.</td>
</tr>
<tr>
<td>Enable for short code</td>
<td>Enables the opt-out feature for short codes only.</td>
</tr>
<tr>
<td>Opt-out keywords</td>
<td>Keyword replies that prevent a customer from receiving new messages from the phone number they're responding to. You can configure standard keywords such as</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>STOP, STOPALL, END, CANCEL, QUIT, and UNSUBSCRIBE.</td>
<td></td>
</tr>
<tr>
<td>Opt-out confirmation message</td>
<td>Customized confirmation message to send to customers when they opt out of receiving SMS messages.</td>
</tr>
<tr>
<td>Opt-in keywords</td>
<td>Customized confirmation responses that enable customers to receive the messages coming from a phone number. You can configure standard keywords such as START, UNSTOP, and YES.</td>
</tr>
<tr>
<td>Opt-in confirmation message</td>
<td>A customized confirmation message to send to customers when they opt in to receiving SMS messages.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Notify workflow activities**

Notify workflow activities manage calls and SMS messages in Notify.

All Notify workflows that manage a phone call must run on the notify_call table. Call-related Notify activities can be added only to workflows where the **Table** field value is **Notify Call [notify_call]**.

You can identify if an outbound call was answered by a human or by an answering machine from within a Notify workflow by evaluating the **current.is_human** variable, such as with an **If** workflow activity. This variable is set by the telephony provider when an outbound call is answered. This variable is always true for inbound calls.

**Note:** Do not add a **Timer** activity between multiple Notify activities that interact with active phone calls.

**Important:** When creating a Notify workflow, set the workflow **If condition matches** field to **-- None --**. Notify controls which workflow to run based on the configured number groups.

**Related information**

Using variables in Notify workflow activities
**Join conference call workflow activity**

The **Join Conference Call** activity connects an incoming or outgoing call to a Notify conference call.

Notify includes the workflows Notify: (Re)join Conference Call and Notify: Join Conference Call Via SMS to demonstrate how to use the **join conference call** activity to connect inbound and outbound calls, and inbound SMS messages to a conference call.

**Input variables**

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Select this check box to record the conference call.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to display advanced configuration options.</td>
</tr>
<tr>
<td>Script</td>
<td>Specify advanced configuration options using JavaScript, such as if the new participant should be muted upon joining the conference call. You can access values from the workflow scratchpad.</td>
</tr>
</tbody>
</table>

**Conditions**

The conditions determine which transition comes after this activity. The **join conference call** activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if the conference_call scratchpad variable is not set.

**Scratchpad entries**

The activity uses the workflow scratchpad to read persistent values.

<table>
<thead>
<tr>
<th>Scratchpad variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>workflow.scratchpad.conference_call</td>
<td>A GlideRecord for a single conference call record. A call processed by this activity is added to this conference call. If this value is not specified, the</td>
</tr>
</tbody>
</table>
Values read from scratchpad (continued)

<table>
<thead>
<tr>
<th>Scratchpad variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>join conference call</td>
<td>activity will log an error. When initiating an outgoing call workflow using the Notify API <code>call(String notifyPhoneNumber, String toPhoneNumber, GlideRecord conferenceCall)</code> method, this scratchpad value is set automatically to the conference call GlideRecord. For incoming call workflows, or workflows initiated using a different mechanism, you must explicitly set this scratchpad value.</td>
</tr>
</tbody>
</table>

Enable different attributes available with Join Conference Call activity

System administrators can enable any or all of the below attributes and use them in the Join Conference Call workflow activity.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hangupOnStar</td>
<td>When hangupOnStar is enabled (set to true), participants in a conference call can press the * button to disconnect from the call. Control is returned to the workflow, which can be used to trigger customer-defined actions.</td>
</tr>
<tr>
<td>muted</td>
<td>When muted is enabled (set to true), the participant will join the conference in a muted state.</td>
</tr>
<tr>
<td>beepOnEnter</td>
<td>When beepOnEnter is enabled (set to true), a notification beep is played when a user joins the conference.</td>
</tr>
<tr>
<td>beepOnExit</td>
<td>When beepOnExit is enabled (set to true), a notification beep is played when a user leaves the conference.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>enableImmediateInput</td>
<td>When enableImmediateInput is enabled (set to true), it allows input of a single digit immediately after the conference ends for this user and sets that in workflow.scratchpad.confDigits. This option will be ignored if hangupOnStar is false.</td>
</tr>
</tbody>
</table>

To enable any of the above attributes, perform the following steps:

1. Navigate to **Workflow > Administration > Workflow Versions**.
2. Open the Notify: (Re)join Conference Call workflow.
3. Click the **Show Workflow** related link.
4. To modify the workflow, click the WorkFlow Actions icon and click **Checkout**.
5. Open the Join Conference Call workflow activity.
6. Enable the **Advanced** check box to display the **Script** field.
7. Set the **hangupOnStar** attribute to true in the **config** variable in the script. The default setting is false.
8. Click **Update**.
9. Click the WorkFlow Actions icon and click **Publish** to save the changes.

Similarly, you can enable the other attributes.

**Call workflow activity**

The **Call** activity makes outbound phone calls using a Notify workflow. This workflow activity can be added to any table.

**Input variables**

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify Number</td>
<td>The Notify phone number to make the call from. When you initiate a call, the outgoing call workflow for the number group associated with this number runs.</td>
</tr>
</tbody>
</table>
## Input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone number to call</td>
<td>The E.164-compliant phone number to call.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use a script to determine number to call, and the Notify number to call from instead of using the <strong>Phone number to call</strong> and <strong>Notify Number</strong> variables.</td>
</tr>
<tr>
<td>Script</td>
<td>Define a script that controls which number to call. This script should return a string listing the Notify number <code>sys_id</code>, as well as the phone number to call, such as <code>{notify_number: 'sys_id', phone_number: '+316...'}</code></td>
</tr>
</tbody>
</table>

## Conditions

The conditions determine which transition comes after this activity. The **call** activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if the call could not be set up due to invalid data returned by the advanced script.

## Send SMS workflow activity

The **send SMS** workflow activity to send short text messages using Notify to users' phones. This workflow activity can be added to any table.

## Input variables

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Select the Notify phone number to use to send the SMS message.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use JavaScript to determine which numbers to send the message to, and the Notify number to use to send the message.</td>
</tr>
</tbody>
</table>
### Input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Select any number of users to send the message to. The user record must have a E.164-compliant phone number or notification device configured for SMS messages.</td>
</tr>
<tr>
<td>To (groups)</td>
<td>Select any number of groups to send the message to. All members of that group with an E.164-compliant phone number or SMS notification device receive the message.</td>
</tr>
</tbody>
</table>
| Message      | Enter the message to send. You can add field values from the current record by using the Select variables box. You can also add values from the workflow scratchpad. If a field and a scratchpad variable have the same name, the field value is used.  
Because you can use variables in this message, it is not possible to determine the length of the message at design time. If the activity sends a message that is longer than supported by the telephony provider, the message is truncated and the instance logs a warning. |
| To (script)  | Enter a script to determine which numbers to send the message to, and the Notify number to use to send the message.  
The script should return a JavaScript object with the format `{notify_number: '\...sys_id...\', users: [...], groups: [...], numbers: [...]}. Specify the users or groups to send the message to as an array of sys_id values. Specify other numbers as an array of E.164-compliant phone numbers.  
This field appears only if **Advanced** is selected. |

### Conditions

The conditions determine which transition comes after this activity. This activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if the Notify number used to make the call is not configured correctly or unable to send SMS messages, or if an error occurs while sending the SMS.

### Forward call workflow activity

The **Forward Call** activity forwards a Notify call to an E.164-compliant phone number.
If the person receiving a forwarded call hangs up, the forward call activity completes and transitions to the next activity. Any further Notify activities in the workflow run for the caller only.

**Input variables**

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone number to call</td>
<td>Enter the phone number to forward the call to.</td>
</tr>
<tr>
<td>Timeout (in seconds)</td>
<td>Enter the amount of time to wait for the call to be answered before hanging up.</td>
</tr>
<tr>
<td>Record</td>
<td>Select this check box to record the conversation.</td>
</tr>
</tbody>
</table>

**Conditions**

The conditions determine which transition comes after this activity. The forward call activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if the phone number to call is invalid.

**Input workflow activity**

The Input activity creates a phone menu by presenting a list of options on a Notify call.

**Input Variables**

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of digits</td>
<td>Specify the maximum number of digits the caller can enter. A caller can enter fewer digits than the maximum and press the Finish key to complete the entry.</td>
</tr>
<tr>
<td>Finish key</td>
<td>Specify the key a caller can press on their phone when finished selecting a menu option.</td>
</tr>
</tbody>
</table>
Input Variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timeout (in seconds)</td>
<td>Specify the amount of time to wait before closing the menu automatically when the caller does not select a menu option.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use a script to build the phone menu, instead of using the activity conditions.</td>
</tr>
<tr>
<td>Script</td>
<td>Define the script to build the phone menu. The script must specify an answer variable as a JavaScript object with the following format:</td>
</tr>
</tbody>
</table>

```javascript
answer = {
  "1": {
    "play": "https://some_url.com/options/one.mp3",
    "myCustomData": "some data here"
  },
  "2": {
    "play": "https://some_url.com/options/two.mp3",
    "myCustomData": "some other data here"
  },
  "3": {
    "speak": "type 3 to speak to a representative",
    "language": "en-US",
    "myCustomData": "some more data here"
  }
};
```

The script may specify either a text-to-speech string and language code using the speak attribute or URL of the music to be played using the play attribute. You can also add optional attributes to store related information, such as myCustomData in the example above.

ℹ️ Note: The script object continues to support say attribute for backward compatibility.

**Conditions**

The conditions determine the transition that comes after this activity.

The input activity does not specify any conditions by default. You must define conditions to build the phone menu. Each condition is one option on the phone menu.
menu. Notify reads the text from each condition **Name** to the caller, up to 100 characters per condition.

You can specify a language for each condition by prefixing the message with the language code, in the format `xx-XX:<Message>`. For example, add `fr-CA:` for Canadian French. Available languages are stored on the Notify Language [notify_language] table.

The condition that the activity transitions through depends on the digits entered by the caller. Set the condition **Condition** value to `parseInt(workflow.scratchpad.digits) == <expected digits>`. For example, to transition through a condition when the caller presses the number 3, set the **Condition** to `parseInt(workflow.scratchpad.digits) == 3`.

You can add an error condition to this activity. The activity transitions through the error condition if the advanced script returns an invalid value, or if the text to say for a condition is empty.

**Scratchpad Entries**

The activity uses the workflow scratchpad to write persistent values.

<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>workflow.scratchpad.digits</td>
<td>The digits entered by the caller, as a string.</td>
</tr>
<tr>
<td>workflow.scratchpad.menu&lt;activity name&gt;</td>
<td>The entire <strong>answer</strong> variable, if using the advanced script option. You can access this menu from other activities after this activity successfully executes. For example, if the activity name is <em>choices</em>, you can access values from the menu using</td>
</tr>
</tbody>
</table>

```javascript
var previousActivity = "choices";
var choicesMenu = workflow.scratchpad.menu[previousActivity];
var menuItem = choicesMenu[workflow.scratchpad.digits]; // Selects the menu item based on the caller's input.
var selectedValue = menuItem.myCustomData; // get the custom data for the selected menu item.
```
Hangup workflow activity

The **Hangup** activity disconnects an active Notify phone call.

You can use the **hangup** activity to disconnect only calls that have been answered. Use the **reject** activity to disconnect calls that have not been answered.

Play workflow activity

The **Play** activity plays a sound file on a Notify call.

**Input Variables**

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>Enter the URL of a sound file to play. If the URL is inaccessible, or if the audio file mime type is not supported by the telephony provider, the <strong>play</strong> activity is skipped.</td>
</tr>
<tr>
<td>Loop</td>
<td>Enter the number of times the sound file should play.</td>
</tr>
</tbody>
</table>

**Conditions**

The conditions determine which transition comes after this activity. The **play** activity does not specify any conditions by default.

You can create an error condition to handle errors with the sound file. The activity transitions through the error condition if the specified sound file is not available, or has an unsupported mime type. Supported mime types are listed on the Notify Audio MIME Types [notify_mime_type] table.

Record workflow activity

The **Record** workflow activity records audio from a user on a Notify call.

**Note:** The Record workflow activity records Notify call but not the Notify conference call. To record the Notify conference call, you can set the **Record** activity variable on the **Join Conference Call** workflow activity.

**Input Variables**

Input variables determine the initial behavior of the activity.
### Input Variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max duration (in seconds)</td>
<td>Enter the maximum duration, in seconds, allowed for a recording.</td>
</tr>
<tr>
<td>Timeout (in seconds)</td>
<td>Enter the amount of time to wait before ending a recording automatically when the caller is silent.</td>
</tr>
<tr>
<td>Finish Key</td>
<td>Specify the key a caller can press on their phone to end the recording.</td>
</tr>
</tbody>
</table>

### Scratchpad Entries

The activity uses the workflow scratchpad to store persistent values.

The **record** activity adds the **recording** variable to the workflow scratchpad. This variable stores metadata about the recording, such as URL, ID, and duration. You can access the following values from this variable.

#### Values written to scratchpad

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>recording.recordingDuration</td>
<td>The duration of the recording, in seconds.</td>
</tr>
<tr>
<td>recording.from_number</td>
<td>The caller’s phone number, including country code.</td>
</tr>
<tr>
<td>recording.notify_number</td>
<td>The Notify phone number used to respond to the call, including country code.</td>
</tr>
<tr>
<td>recording.recordingID</td>
<td>The ID used by the telephony provider to identify the recording.</td>
</tr>
<tr>
<td>recording.recordingURL</td>
<td>The URL from the telephony provider to access the recording.</td>
</tr>
</tbody>
</table>

### Reject workflow

The **Reject** workflow activity rejects an incoming Notify call.

You can use the **reject** activity to disconnect only calls that have not yet been answered. Use the **hang up** activity to disconnect calls that have been answered.
Input variables
Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reason</td>
<td>Select a reason for rejecting the call, such as busy.</td>
</tr>
</tbody>
</table>

Say workflow activity
The say workflow activity allows you to play a message, using text to speech, on a Notify call.

Input variables
Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text to say</td>
<td>Specify the text to read.</td>
</tr>
<tr>
<td>Language</td>
<td>Select the language and locale to use when reading text.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use a script to define the language and message, instead of using the Text to say and Language values.</td>
</tr>
<tr>
<td>Script</td>
<td>Define a script to set what text is read on the call. The script must return a string that defines the language and the text to read. For example, to play an English-language message, return {language: 'en-US', text: 'Text to read'}.</td>
</tr>
</tbody>
</table>

Forward to notify client workflow activity
The forward to notify client workflow activity connects a phone call to a Notify WebRTC client.

Input variables
Input variables determine the initial behavior of the activity.
### Input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Select the user to connect the call to.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use a script to determine which client to connect to, instead of using the <strong>User</strong> variable.</td>
</tr>
<tr>
<td>Script</td>
<td>Define a script that controls which client to connect to. This script should return a GlideRecord for a single User [sys_user] record.</td>
</tr>
<tr>
<td>Timeout (in seconds)</td>
<td>Enter the amount of time to wait for the call to be connected before hanging up.</td>
</tr>
<tr>
<td>Record</td>
<td>Select this check box to record the call.</td>
</tr>
</tbody>
</table>

### Conditions

The conditions determine which transition comes after this activity. The **Forward to Notify Client** activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if there is an issue with the Notify client.

### Queue workflow activity

The **Queue** activity places an active Notify call in a queue.

Add the **Queue** activity to a workflow on the Notify Call [notify_call] table to put the current call on hold. This activity does not specify any input variables.

The queue that the call is added to is given a random ID.

### Notify activity event handlers

Notify workflow activities provide JavaScript functions that are invoked automatically when your telephony provider broadcasts certain events.

When the telephony provider broadcasts an event related to a Notify call, such as the caller hanging up, the event is processed by the workflow associated with that Notify call. All currently-executing Notify activities in that workflow invoke a JavaScript function associated with that event.

Not all activities that support an event provide a default event handler implementation. You can provide an implementation for those event handlers when creating custom Notify activities.
Creating Notify activities

Default Notify workflow generally performs a single action, such as initiating a phone call. You can create custom Notify workflow activities to implement more complex functionality.

Use event handler functions in each Notify activity definition to design your own activity behavior. For example, you can set the activity result if the caller hangs up by using the `onCompleted` function.

```javascript
onCompleted: function() {
  activity.result = 'call_ended';
},
```

When creating a new Notify workflow activity, follow these design principles.

- **Within `onExecute` event handler function**, create a new NotifyAction object. Use this object to create a simple or complex action, then serialize the object to the notify_wf_activity table.

- **Within the `onUpdate` event handler function**, deserialize the NotifyAction object from the notify_wf_activity table and use this object to perform any other operations.

- Use the other event handler functions and the Notify as needed to implement the desired activity behavior.

Related information

Notify languages

Notify supports multiple languages when using text-to-speech. For example, when using the `input` or `say` workflow activities, you can specify which language to use when reading the text.

The list of available languages is stored on the Notify Languages [notify_language] table. By default, languages supported by all Notify telephony providers are available. You can add additional languages if they are supported by your specific telephony provider.
Available Notify activity event handlers

When creating Notify workflow activities, you can use event-handler functions to respond to events from a telephony provider.

Not all activities or telephony providers support all events. For example, the **Reject** activity ends the call before the caller connects so the **onNoAnswer** function is never invoked from this activity.

⚠️ **Note:** When configuring an activity to respond to an event, ensure that your telephony provider supports that event.

The following table describes available event handlers and lists the Notify workflow activities that can invoke each handler.

<table>
<thead>
<tr>
<th>Event handlers</th>
<th>Description</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>onExecute</td>
<td>Runs when the activity first runs.</td>
<td>All call-related activities</td>
</tr>
<tr>
<td>onUpdate</td>
<td>Runs when the call record associated with the workflow is updated.</td>
<td>All call-related activities</td>
</tr>
<tr>
<td>onCompleted</td>
<td>Runs when a call ends.</td>
<td>All call-related activities</td>
</tr>
<tr>
<td>onRinging</td>
<td>Runs when a call starts ringing.</td>
<td>Forward call, call, join conference call, forward to notify client</td>
</tr>
<tr>
<td>onInProgress</td>
<td>Runs when both parties are connected on a call.</td>
<td>Forward call, call, join conference call, forward to notify client</td>
</tr>
<tr>
<td>onNoAnswer</td>
<td>Runs when a call is not answered.</td>
<td>Forward call, call, join conference call, forward to notify client</td>
</tr>
<tr>
<td>onBusy</td>
<td>Runs when a called number is busy.</td>
<td>Forward call, call, join conference call, forward to notify client</td>
</tr>
<tr>
<td>onFailed</td>
<td>Runs when an error occurs.</td>
<td>All call-related activities</td>
</tr>
</tbody>
</table>

Components installed with Notify

Several types of components are installed with the Notify application.
Roles installed with Notify

Notify adds the following roles.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify administrator [notify_admin]</td>
<td>Administrator with privileges for Notify 2 functionality.</td>
<td>• workflow_admin&lt;br&gt;• workflow_creator&lt;br&gt;• workflow_publisher</td>
</tr>
<tr>
<td>Notify viewer [notify_view]</td>
<td>Can view notify content. This role has read-only access to the Notify Conference Calls table [notify_conference_call] and the Notify Conference Call Participants table [notify_participant].&lt;br&gt;The itil role inherits the notify_view role when the Incident Communications Management and the Notify plugins are activated.</td>
<td></td>
</tr>
</tbody>
</table>

Tables installed with Notify

Notify adds the following tables.

<table>
<thead>
<tr>
<th>Tables</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table</strong></td>
</tr>
<tr>
<td>Notify Conference Calls [notify_conference_call]</td>
</tr>
<tr>
<td>Notify Calls [notify_call]</td>
</tr>
<tr>
<td>Table</td>
</tr>
<tr>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Notify Call Queue [notify_queue]</td>
</tr>
<tr>
<td>Notify Call Status [notify_call_status]</td>
</tr>
<tr>
<td>Notify Client Connected Sessions [notify_client_session]</td>
</tr>
<tr>
<td>Notify Conference Call Participants [notify_participant]</td>
</tr>
<tr>
<td>Notify Conference Call Participant Sessions [notify_participant_session]</td>
</tr>
<tr>
<td>Notify Messages [notify_message]</td>
</tr>
<tr>
<td>Notify Phone Numbers [notify_number]</td>
</tr>
<tr>
<td>Notify Phone Number Groups [notify_group]</td>
</tr>
<tr>
<td>Notify Languages [notify_language]</td>
</tr>
<tr>
<td>Notify Recordings [notify_recording]</td>
</tr>
<tr>
<td>Notify Workflow Activity [notify_wf_activity]</td>
</tr>
<tr>
<td>Notify Audio MIME Types [notify_mime_type]</td>
</tr>
<tr>
<td>Temporary Serialized Notify Action Cache</td>
</tr>
</tbody>
</table>
### Tables (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[notify_action]</td>
<td></td>
</tr>
<tr>
<td>Notify SMS Template</td>
<td>Contains the templates which are used while sending a Notify SMS.</td>
</tr>
<tr>
<td>[notify_sms_template]</td>
<td></td>
</tr>
</tbody>
</table>

### Notify call sequence

![Notify call sequence diagram](image)

### Properties installed with Notify

Notify adds the following properties.

### Properties for Notify

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_twilio_driver.max_conference_participants</td>
<td>Twilio maximum limit for number of participants in the conference call.</td>
</tr>
<tr>
<td>com.snc.iam.notify_number</td>
<td>The Notify number to use for conference calls.</td>
</tr>
</tbody>
</table>

**Note:** This number must have a group configured with conference call workflows.
### Properties for Notify (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.notify.task.phone_number</td>
<td>Notify phone number used for sending SMS-s and starting conference calls from any record that belongs to the task table (or a table that extends the task table). The number must be entered in E.164-compliant format.</td>
</tr>
<tr>
<td>glide.notify.sms.max_concatenation</td>
<td>Notify supports the concept of SMS concatenation. When the SMS body exceeds the maximum length of a single SMS (160 characters for plaintext SMS messages or 70 characters for Unicode SMS messages), Notify can concatenate up to 10 SMS messages which will be joined on the receiver’s mobile phone. This property configured the maximum number of SMS messages that will be concatenated into one large SMS message. If the body length is exceeded the body will be truncated and a message will be logged. Note: The charges are per sms, which means that 1600 character SMS will be 10 times as expensive as a 160 character SMS. Also note that not all providers support SMS concatenation.</td>
</tr>
<tr>
<td>glide.enable.notify_on_task</td>
<td>Use this property to enable Notify integration for Task table and its extensions. Entering phone number in</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
## Properties for Notify (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>'glide.notify.task.phone_number'</code> property</td>
<td>Equivalent to setting this to true.</td>
</tr>
<tr>
<td><code>glide.notify.endpoint</code></td>
<td>If the instance is accessible on public internet using some other name, which can happen if the instance is within a private network and is accessible via a reverse proxy from outside. In that case the public name needs to be provided here. e.g. https://some_public_domain.com</td>
</tr>
<tr>
<td><code>glide.notify.sms.save_confirmation_in_db</code></td>
<td>Check <strong>Yes</strong> if you want track the confirmation of opt-in/out requests SMS. The confirmations are saved in notify_message table.</td>
</tr>
<tr>
<td><code>com.snc.iam.enable_notify</code></td>
<td>Use this property to enable Notify integration for Incident Communications Management. Entering phone number in <code>com.snc.iam.notify_number</code> property is equivalent to setting this to true.</td>
</tr>
<tr>
<td><code>com.snc.iam.notify_number</code></td>
<td>The Notify number to use for conference calls. Note that this number needs to have a group configured with conference call workflows.</td>
</tr>
<tr>
<td><code>com.snc.on_call_rotation.notify_webrtc_number</code></td>
<td>Specify a valid Notify number with voice capability. This will enable On-Call integration with Notify which allows On-Call users to directly call people on rosters from the browser.</td>
</tr>
</tbody>
</table>
## Properties for Notify (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_major_inc_mgmt.notify_webrtc_number</td>
<td>Specify a valid Notify Number with voice capability. This will enable a specific Major Incident Management integration with Notify which allows Workbench users to directly call people from the browser.</td>
</tr>
</tbody>
</table>

## Business rules installed with Notify

Notify adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Call Workflows for Shortcodes</td>
<td>[notify_group]</td>
<td>Checks and displays an error if the call is being triggered by a short code.</td>
</tr>
<tr>
<td>Update Participant Duration</td>
<td>[notify_participant]</td>
<td>Updates participant duration when it becomes inactive.</td>
</tr>
<tr>
<td>Check if Notify call exists and active</td>
<td>[notify_participant_session]</td>
<td>Checks if Notify call has valid reference record and updates it if the call is inactive currently.</td>
</tr>
<tr>
<td>Update Last Active On</td>
<td>[notify_participant]</td>
<td>Sets the last active before insertion/update of Notify participant.</td>
</tr>
<tr>
<td>Show info msg about selection in choice</td>
<td>[notify_group_selector_choice]</td>
<td>Displays a message if either Notify group or conference provider is not selected.</td>
</tr>
<tr>
<td>Validate values in the choice</td>
<td>[notify_group_selector_choice]</td>
<td>Checks if either of Notify group or conference provider is filled.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set scratchpad values</td>
<td>[notify_group_selector_choice]</td>
<td>Checks if conference provider is available by iterating through service provider list.</td>
</tr>
<tr>
<td>Show message for empty choices</td>
<td>[notify_group_selector]</td>
<td>Displays an info message if there are no choices for the provider selector.</td>
</tr>
<tr>
<td>Clear fields when Manual Selection is set</td>
<td>[notify_group_selector]</td>
<td>Clears out some fields when manual selection is set in Notify group selector table.</td>
</tr>
<tr>
<td>Update Participant Duration</td>
<td>[notify_participant_session]</td>
<td>Calculates the duration of participant on conference call.</td>
</tr>
<tr>
<td>Update session muted state</td>
<td>[notify_participant]</td>
<td>Sets the value of mute and expelled to true once the conference call participant becomes inactive.</td>
</tr>
<tr>
<td>Update conference call</td>
<td>[notify_participant]</td>
<td>Sets the state of conference call based on the participant leaving or joining the call.</td>
</tr>
<tr>
<td>Validate Order field value</td>
<td>[notify_group_selector]</td>
<td>Validates order field value to be unique amongst all provider selectors.</td>
</tr>
<tr>
<td>Restrict Workflows For only Voice Nums</td>
<td>[notify_number]</td>
<td>Restricts association of voice only capable number with number group having inbound/outbound SMS workflows.</td>
</tr>
<tr>
<td>Restrict Workflows For only SMS Numbers</td>
<td>[notify_number]</td>
<td>Restricts association of SMS only capable number with number group having inbound/outbound voice workflows.</td>
</tr>
<tr>
<td>Validations on default record</td>
<td>[notify_group_selector]</td>
<td>Validates that source table and order field are mandatory in case of default set to false and</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Clearing fields when Default is true</td>
<td>[notify_group_selector]</td>
<td>Clears out some fields when default is set to true.</td>
</tr>
<tr>
<td>No Default selector set</td>
<td>[notify_group_selector]</td>
<td>Ensures one active provider selector is set as default.</td>
</tr>
<tr>
<td>Check active default selector is unique</td>
<td>[notify_group_selector]</td>
<td>Ensures only one provider selector is set as default.</td>
</tr>
<tr>
<td>Process SMS preferences for incoming SMS</td>
<td>[notify_message]</td>
<td>When an SMS preference configuration defined for a particular telephony provider, then apply it for every incoming SMS.</td>
</tr>
<tr>
<td>Check default notify group is unique</td>
<td>[notify_group]</td>
<td>Validates that not more than one group is set as default Notify group.</td>
</tr>
<tr>
<td>Trigger conference end</td>
<td>[notify_conference_call]</td>
<td>When a conference call ends, triggers the notify.conference.end event</td>
</tr>
<tr>
<td>Update Call Active State</td>
<td>[notify_call_status]</td>
<td>Updates the status of the call in notify_call_status with the status received from Twilio.</td>
</tr>
<tr>
<td>Update Conference Call Active State</td>
<td>[notify_participant]</td>
<td>Updates the active flag in notify_participant table. Also calculates the duration when the call is ended by a participant.</td>
</tr>
<tr>
<td>Update Participant Active State</td>
<td>[notify_participant_session]</td>
<td>Updates the active flag for the participant (notify_participant), and calculates the total time</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>on the call upon disconnecting from the call.</td>
</tr>
<tr>
<td>Update</td>
<td>notify_call</td>
<td>Synchronizes the state of the call between notify_call and notify_participant_session. Upon disconnecting from the call, updates notify_participant_session with the duration of the call.</td>
</tr>
<tr>
<td>Participant</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Session</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active State</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>[notify_group]</td>
<td>Checks notify_group table and displays an error if the workflow is not configured correctly.</td>
</tr>
<tr>
<td>Warn for</td>
<td></td>
<td></td>
</tr>
<tr>
<td>incorrectly</td>
<td></td>
<td></td>
</tr>
<tr>
<td>configured</td>
<td></td>
<td></td>
</tr>
<tr>
<td>workflow</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Notify connector for Microsoft Teams**

Notify connector for Microsoft Teams enables you to manage and initiate a Microsoft Teams meeting directly from any record such as an incident, or a task.

**Key Features**

- Start and end Microsoft Teams meetings directly from any record such as an incident or a task or from the major incident workbench.
- Manage a Microsoft Teams meeting by adding or removing participants.

**System Requirements**

Install and activate the Notify plugin (com.snc.notify) before you install the application.

Install the ServiceNow IntegrationHub Installer (com.glide.hub.integrations) plugin to design the integration flows in the Flow Designer application. For more information, see Request IntegrationHub.

**Set up and configure Notify connector for Microsoft Teams**

Use Notify connector to expand the Notify communication channel by managing and initiating a Microsoft Teams meeting directly from any task record such as an incident or a change.
Setup and configure Notify connector for Microsoft Teams for multi-tenant

Configure the Notify connector for Microsoft Teams using the multi-tenant app. You can use the Microsoft Azure apps instead of creating a separate Microsoft Azure app for the integration.

Set up Notify connector for Microsoft Teams

Install and activate the Notify plugin (com.snc.notify) to be able to initiate a Microsoft Teams meeting directly from an incident record.

Before you begin
Role required: admin

Procedure
1. Navigate to System Definition > Plugins.
2. In the search field, enter Notify.
3. Click Install.

Connect the ServiceNow instance to your Microsoft Teams tenant

Connect your ServiceNow instance to your Microsoft Teams tenant to enable the users to create their requests from within Microsoft Teams.

Before you begin
Role required: External admin (external_app_install_admin)

Procedure
1. Navigate to ServiceNow for Microsoft Teams > Install Azure apps.
2. Click Connect to install Microsoft Teams in your instance.
   This connects your tenant to the ServiceNow instance.
3. Select the **Consent on behalf of your organization** option to provide the consent for all your users, and click **Accept** button to provide the admin consent.

![Microsoft Permissions requested](image)

**Permissions requested**

**Tab SSO**

**ServiceNow**

This app would like to:

- View users' basic profile
- Maintain access to data you have given it access to
- **Consent on behalf of your organization**

If you accept, this app will get access to the specified resources for all users in your organization. No one else will be prompted to review these permissions.

Accepting these permissions means that you allow this app to use your data as specified in their terms of service and privacy statement. **The publisher has not provided links to their terms for you to review.** You can change these permissions at [https://myapps.microsoft.com](https://myapps.microsoft.com). [Show details]

Does this app look suspicious? [Report it here]

![Cancel Accept buttons](image)

Tab SSO is one of the apps to verify the users and connect the Microsoft tenant to the ServiceNow instance. Provide the desired Microsoft tenant details to connect to the ServiceNow instance.

Select the **Consent on behalf of your organization** option to provide the consent for all your users.

**Note:** All the users must also accept the permissions, not accepting the permissions result in not being able to use the ServiceNow integrations with Microsoft Teams.
Authorize multi-tenant Azure apps to grant required permissions

Authorize the multi-tenant apps to enable ServiceNow to make API calls to Microsoft to enable each of the ServiceNow for Teams application workflows.

Before you begin
Role required: External admin (external_app_install_admin) (This role is available out of the box for users and is a part of channel proxy plugin)

About this task
To connect your ServiceNow instance to your M365 tenant and to Authorize apps, the user must have both the external_app_install_admin role as well as the application administrator role in M365. Application administrator is a Microsoft driven role, for more information on roles, refer Azure AD built-in roles.

Procedure
1. Navigate to ServiceNow for Microsoft Teams > Install Azure apps.

2. Click Authorize for Notify Connector.

3. Provide the admin consent by clicking on Accept button.

This authorizes to create a new app for Meeting extensibility app, and to create a new tab for a major incident meeting from the major incident workbench in Microsoft Teams.
Permissions requested
Review for your organization

Notify Connector
ServiceNow ©

This app would like to:
✓ Sign in and read user profile
✓ Read all users' full profiles
✓ Read and create online meetings
✓ Join group calls and meetings as a guest
✓ Join group calls and meetings as an app
✓ Initiate outgoing group calls from the app
✓ Initiate outgoing 1 to 1 calls from the app
✓ Manage Teams apps for all chats
✓ Allow the Teams app to manage all tabs for all chats

If you accept, this app will get access to the specified resources for all users in your organization. No one else will be prompted to review these permissions.

Accepting these permissions means that you allow this app to use your data as specified in their terms of service and privacy statement. The publisher has not provided links to their terms for you to review. You can change these permissions at https://myapps.microsoft.com. Show details

Does this app look suspicious? Report it here

Cancel  Accept
Upon successful authorization, the app is shown as **Installed**.

Download manifest file and configure Notify connector for Microsoft Teams app in Microsoft Teams

Download the Notify connector for Microsoft Teams manifest file from your instance and configure the manifest file in Microsoft Teams to use Notify connector for Microsoft Teams app.

**Before you begin**

Role required: external_app_install_admin

**Procedure**

1. Navigate to **ServiceNow for Microsoft Teams > Application Manifest > Meetings Bot**.

After you install the ServiceNow for Teams multi-tenant app, the client ID and the app ID entries will not be displayed in the manifest screen.

2. On the form, fill in the fields.
Manifest for Notify connector for Microsoft Teams

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short name</td>
<td>Short name of the meetings bot.</td>
</tr>
<tr>
<td>State</td>
<td>State of the manifest file.</td>
</tr>
<tr>
<td>Full name</td>
<td>Complete name of the meetings bot.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the meetings bot.</td>
</tr>
<tr>
<td>Use default images</td>
<td>Option to use default images for the meetings bot.</td>
</tr>
</tbody>
</table>

**Note:** If you want to customize the company branding, clear the *Use default images* option and then upload the icons. For more information on the size of icons, refer [App icons and manifest schema icons](#).

You can upload an image for **Color image** and **Outline image** options.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description for the manifest file.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description for the manifest file.</td>
</tr>
</tbody>
</table>

3. Click **Move to Ready**.

4. Click **Download Manifest**.

   The manifest file downloads in the zip format.

5. Launch Microsoft Teams application.

6. Navigate to **Apps > Upload a customised app**.

7. Navigate to the location where the manifest file is downloaded and select the zip file.

8. Click **Open**.

   The **ServiceNow Meetings Bot** card will appear in Microsoft Teams.

**Make Microsoft Teams the default communication channel**

Make Microsoft Teams the default communication channel to initiate a conference call to resolve a ticket.

**Before you begin**

Role required: admin
Procedure

1. Navigate to Notify > Provider Selector.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the provider you are adding, for example, Microsoft Teams.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which this provider appears when multiple providers are configured.</td>
</tr>
<tr>
<td>Source table</td>
<td>The table to which Microsoft Teams must be added.</td>
</tr>
<tr>
<td>Condition</td>
<td>Field to add the filter conditions.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for indicating whether Microsoft Teams as a provider is active.</td>
</tr>
<tr>
<td>Default</td>
<td>Option for making Microsoft Teams the default provider if other notify providers like Zoom or Twilio are configured.</td>
</tr>
<tr>
<td>Manual Selection</td>
<td>Option for disabling the automatic selection of this provider.</td>
</tr>
</tbody>
</table>

4. Click Submit.
The list of service providers displays.
5. Click the newly created service provider.
6. In the Provider Selector Choices section, click New.
   a. Notify number group: Select the required notify group.
   b. Conference provider: Select Microsoft Teams.
   c. Click Submit.

Setup and configure Notify connector for Microsoft Teams for single-tenant
Configure the Notify connector for Microsoft Teams using the single-tenant app.
You may need to use Single Tenant setup in certain cases due to your company or regulatory requirements.
Add App Studio in Microsoft Teams

Add App Studio to Microsoft Teams so that you can use it to create apps to make calls using Notify connector with Microsoft Teams.

Before you begin
Role required: admin

Procedure
1. Launch Microsoft Teams.
2. Click Apps menu.
3. In the apps search field, enter App Studio.
4. Click the App Studio card.
5. Click the Open button.

The App Studio menu is added to the left navigation bar in Microsoft Teams.

Note: If the App Studio icon doesn’t appear in the left navigation bar in Microsoft Teams, click the More added apps icon (…) and click App Studio.

What to do next
Create an app in Microsoft Teams to enable making calls

Create an app to make outbound calls from Microsoft Teams.
Before you begin
Role required: admin

Procedure
1. Launch Microsoft Teams.
2. Click the **App Studio** menu.
3. Click the **Manifest editor** tab.
4. Click the **Create a new app** button.
5. On the **App details form**, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short name</td>
<td>Name of your application. For example, ServiceNow for Microsoft Teams.</td>
</tr>
<tr>
<td>App ID</td>
<td>Unique identification number for the app. You generate the app id by clicking the <strong>Generate</strong> button.</td>
</tr>
<tr>
<td>Package Name</td>
<td>Name of the package for your application. For example, ServiceNow for Microsoft Teams.</td>
</tr>
<tr>
<td>Version</td>
<td>Version for the app. For example, 1.0.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the app.</td>
</tr>
<tr>
<td>Full description</td>
<td>Detailed description of the app.</td>
</tr>
<tr>
<td>Developer/Company Name</td>
<td>Name of your company.</td>
</tr>
<tr>
<td>Website</td>
<td>Link to your company website.</td>
</tr>
<tr>
<td>Privacy Statement</td>
<td>Link to the privacy statement for your app.</td>
</tr>
<tr>
<td>Terms of use</td>
<td>Link to the terms and conditions for your app.</td>
</tr>
</tbody>
</table>

6. Set up the branding for your app by adding an icon and choosing colors.

   a. Click the **Update** button.

   b. Select an image file for your icon.
c. Click the **Open** button.
   The selected image will be the icon for your app.

7. Set up the bot.

   A bot allow the users to interact with your web service through text, interactive cards, and task modules to obtain the desired information.

   a. Navigate to **Capabilities > Bots**.
   b. Click the **Set up** button.
   c. Name: Provide a name for your bot.
   d. Calling bot: Select the **My bot supports video call**, and **My bot supports audio call** options.
   e. Scope: Select the **Personal**, **Team**, and **Group Chat** options.
   f. Click the **Create bot** button.

8. Click **Generate Password**.
   Note this password for later use.

### Manage permissions for the Notify connector app

Assign permissions to users to be able to authenticate successfully and participate in conference calls in Microsoft Teams.

#### Before you begin

**Role required:** Microsoft Azure admin

#### About this task

The Meeting extensibility app depends on Notify connector for Microsoft Teams app. You can configure the existing Notify connector app in Azure portal for Meeting Extensibility to have a seamless conference call experience in Microsoft Teams.

To use the Meeting Extensibility app, you need to assign the following permissions for the app in the Microsoft Azure portal:

- TeamsTab.ReadWriteForChat.All
- TeamsAppInstallation.ReadWriteForChat.All

For more information to manage permissions to use Meeting Extensibility for Microsoft Teams, refer [Configure the app for Meeting Extensibility in Microsoft Azure portal](#).
Procedure

1. Log in to the Microsoft Azure portal.


3. Open the existing app you are using for Notify.

4. Navigate to Manage > API Permissions > Add a permission > Microsoft Graph.

5. Click Application Permissions.

6. Grant the OnlineMeetings.ReadWrite.All permission to enable the initiation of calls by users who are not signed in.

   a. In the search field for Select permissions, enter OnlineMeetings.

   b. Click OnlineMeetings option.

   c. Select the OnlineMeetings.ReadWrite.All option.

7. Grant the permissions for the user to initiate a call, and to join a conference call.

   a. In the search field for Select permissions, enter Calls.

   b. Click the Calls option.
c. Select **Calls.InitiateGroupCall.All**, **Calls.JoinGroupCall.All**, and **Calls.JoinGroupCallAsGuest.All** options.

<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calls Initiate Group Call All</td>
<td>Allows the app to initiate outgoing calls from the app.</td>
</tr>
<tr>
<td>Calls Join Group Call All</td>
<td>Allows the app to join scheduled meetings in your organization, without a signed-in user.</td>
</tr>
<tr>
<td>Calls Join Group Call As Guest All</td>
<td>Allows the app to join group calls and meetings as a guest.</td>
</tr>
</tbody>
</table>

8. Grant the **User.Read.All** permission to read the profile properties, reports, and managers of other users in your organization in User permissions.

a. In the search field for **Select permissions**, enter **User**.

b. Click the **User** accordion.
c. Select the **User.Read.All** check box.

| User (1) |
|-----------------|-----------------|
| ✔️ User.Export.All  | Export user's data | Yes |
| ✔️ User.InviteAll  | Invite guest users to the organization | Yes |
| ✔️ User.ManageIdentities.All | Manage all users' identities | Yes |
| ✔️ User.Read.All  | Read all users' full profiles | Yes |
| ✔️ User.ReadWrite.All | Read and write all users' full profiles | Yes |

9. Click **Update permissions**.

10. Grant admins access to the Azure applications that require admin approval.
   a. In the **API permissions** screen, click the **Grant admin consent for {tenant}** link.
   b. Click **Yes** in the pop-up dialog box.

Create a Microsoft Teams application registry entry in your ServiceNow instance

Register your Microsoft Teams application with your ServiceNow instance for OAuth authorization.

Before you begin
Role required: admin

Procedure
1. Navigate to **System OAuth > Application Registry**.
2. Click **New**.
3. Click **Connect to a third-party OAuth Provider**.
4. On the form, fill the fields.

### Third-party OAuth Provider form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record, for example, Microsoft Teams.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID created during the app creation in Microsoft Teams.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Client Secret</td>
<td>The password you generated when creating the app in Microsoft Teams.</td>
</tr>
<tr>
<td>Default Grant Type</td>
<td><strong>Client Credentials.</strong></td>
</tr>
<tr>
<td>Token URL</td>
<td>Token endpoint URL that includes the Directory ID of your app with the structure <a href="https://login.microsoftonline.com/">https://login.microsoftonline.com/</a>&lt;Directory ID&gt;/oauth2/v2.0/token, where &lt;Directory ID&gt; is the tenant ID created during the app creation in Microsoft Teams.</td>
</tr>
</tbody>
</table>

5. Right-click in the form header and click **Save**.

6. Create an OAuth entity scope to provide the read and write permissions for users.
   a. Click the **OAuth Entity Scopes** tab.
   b. Double-click **Insert a new row**, and enter **Default**.
   c. Enter `.default` as the OAuth scope.
   d. Right-click in the form header and click **Save**.

7. Click **Update**.

**Results**
The Microsoft Teams app is now registered with an OAuth profile authorization.

**Create a Connection & Credentials alias for Microsoft Teams**
Create an alias that labels a credential or connection record.

**Before you begin**
Role required: admin

**About this task**
Create an alias to associates the connection information with the credential data required to complete the application integration. For more information, refer **Introduction to credentials, connections, and aliases**.

**Procedure**
1. Navigate to **Connections & Credentials > Credentials Aliases**.
2. Click **MSTeamsCommunicationsSpoke**.
3. In the **Credentials** tab, click **New**.
4. Click OAuth 2.0 Credentials.
5. Set the values for the credentials.
   a. In the Name field, provide a name for the credential, for example, "ServiceNow Microsoft Teams credentials."
   b. In the OAuth entity Profile field, enter the OAuth Entity profile information. The profile ID is set when you generate the application registry entry.
6. Click Submit.

Set up Notify connector for Microsoft Teams
Install and activate the Notify plugin (com.snc.notify) to be able to initiate a Microsoft Teams meeting directly from an incident record.

Before you begin
Role required: admin

Procedure
1. Navigate to System Definition > Plugins.
2. In the search field, enter Notify.
3. Click Install.

Make Microsoft Teams the default communication channel
Make Microsoft Teams the default communication channel to initiate a conference call to resolve a ticket.

Before you begin
Role required: admin

Procedure
1. Navigate to Notify > Provider Selector.
2. Click New.
3. On the form, fill in the fields.
Provider selector form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the provider you are adding, for example, Microsoft Teams.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which this provider appears when multiple providers are configured.</td>
</tr>
<tr>
<td>Source table</td>
<td>The table to which Microsoft Teams must be added.</td>
</tr>
<tr>
<td>Condition</td>
<td>Field to add the filter conditions.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for indicating whether Microsoft Teams as a provider is active.</td>
</tr>
<tr>
<td>Default</td>
<td>Option for making Microsoft Teams the default provider if other notify providers like Zoom or Twilio are configured.</td>
</tr>
<tr>
<td>Manual Selection</td>
<td>Option for disabling the automatic selection of this provider.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
   The list of service providers displays.

5. Click the newly created service provider.

6. In the **Provider Selector Choices** section, click **New**.
   a. Notify number group: Select the required notify group.
   b. Conference provider: Select Microsoft Teams.
   c. Click **Submit**.

**Using Notify connector for Microsoft Teams with task records**

Notify connector for Microsoft Teams enables you to initiate conference calls from task records such as incidents, problems, or change requests.

**Start and manage a conference call from a task record**

Make a conference call from a task record such as an incident, problem record, or change request in Microsoft Teams.

**Before you begin**

Role required: itil, itil_admin, or admin
Procedure

1. Navigate to any task record, such as an incident, problem, or change request.

2. Click the **Start conference call** related link.

3. In the dialog box, select the participants for the conference.
   
   All users from the User Contacts list in the task record are in the recommended section by default. The user who initiates the conference call is added to the selected list of participants.

4. After you finalize the participant list, click **Start**.

   A notification is sent to all the users in Microsoft Teams that a call has been initiated. Each user can accept the call to join the conference call.

   The host can view the users who have answered the call in Microsoft Teams.

5. Do one of the following activities.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add participants</td>
<td>Click the <strong>Manage Conference Calls</strong> related link, and select <strong>Add Participants</strong>.</td>
</tr>
<tr>
<td>End the conference call</td>
<td>Click the <strong>Manage Conference Calls</strong> related link, and selecting <strong>End Conference Call</strong></td>
</tr>
</tbody>
</table>

**Using Notify connector for Microsoft Teams with Incident Communication Management**

Use Notify with an incident communication plan to start conference calls.

The property `com.snc.iam.enable_notify` must be enabled in Notify Properties to make calls from major incident record.

1. Navigate to **Notify > Administration > Notify Properties**.

2. Check the option **Enable Notify integration for Incident Communications Management**. Entering phone number in 'com.snc.iam.notify_number' property is equivalent to setting this to true (com.snc.iam.enable_notify).

   Right-click on the "Enable Notify integration for Incident Communications Management. Entering phone number in 'com.snc.iam.notify_number' property is equivalent to setting this to true" text and click **Edit Property** to view the property details.
3. Click **Save**.

Start a conference call from an incident communication plan

Initiate a conference call in Microsoft Teams from an incident communication plan so you can discuss the resolution of an incident.

**Before you begin**

Role required: incident_communication_manager

**Procedure**

1. Navigate to **Incident Communications Management > Open**.
2. Open the relevant incident communication plan.
3. Click the **Initiate Conference Call** related link.
4. In the dialog box, select the participants for the conference.
5. After you finalize the participant list, click **Start Call**.

**Results**

A notification is sent to all the selected users in Microsoft Teams that a call is initiated. Each user can accept the call to join the conference call.

As the host, you can view the users who have answered the call.

Add participants to a conference call from the incident communication plan

Add a participant to a conference call on a task record from the incident communication plan.
Before you begin
Role required: ia_admin, or admin

Procedure
1. Navigate to Incident Communications Management > All.
2. Open the relevant incident communication plan.
3. Click the Conference tab.
4. Click (+) Participants under Active Participants.
5. In the dialog box, select the participants you want to add to the conference call.
6. Click Add Participants.

Results
A notification is sent to all the selected users in Microsoft Teams that a call is initiated. Each user can accept the call to join the conference call.
As the host, you can view the users who have answered the call.

Mute a participant in a conference call
Mute a participant in a conference call to avoid unnecessary background disruption.

Before you begin
This procedure assumes that there is an active conference call with one or more participants.
Role required: ia_admin, or admin

Procedure
1. Navigate to Incident Communications Management > All.
2. Open the relevant incident communication plan.
3. Click the Conference tab.
4. Click Mute next to the participant name you want to mute.

End a conference call made through an incident record
As a host or a user with the incident communication manager role, you can end the conference call.

Before you begin
Role required: ia_admin or admin
Procedure
1. Navigate to Incident Communications Management > All.
2. Open the relevant incident communication plan.
3. Click the Conference tab.
4. Click End Conference Call.

Results
When you end a call, only the host (bot) exits the call. The other participants still stay in the call until they manually disconnect. After the host (bot) exits the call, call details are no longer logged.

Using Notify connector for Microsoft Teams with a major incident
Initiate a conference call from the major incident workbench by inviting one or more users to join a call. The conference doesn't start until at least two participants join.

Notify administrators, major incident managers, or communications managers can manage conference calls.

Conference call records are stored in the Notify Conference Calls [notify_conference_call] table. Conference call participant records are stored in the Notify Conference Call Participants [notify_participant] table.

Initiate a conference call
As a participant in a major incident ticket, you can create a conference call from the record.

Procedure
1. Navigate to Incident > Major incidents > Open.
2. Open the relevant major incident.
3. Click the Conference tab.
4. Select the participants for the conference.
5. After you finalize the participant list, click Start Call.

Results
A notification is sent to all the users in Microsoft Teams that a call is initiated. Each user can accept the call to join the conference call.

As the host, you can view the users who have answered the call.
Join a conference call
After a conference call is initiated, as a logged-in user with the major incident manager role, you can join the conference call.

Before you begin
Role required: notify_admin, major_incident_manager, or communication_manager

Procedure
1. Navigate to Incident > Major incidents > Open.
2. Open the relevant major incident.
3. Click the Conference tab.
4. Click the Join Call related link to join the ongoing conference call.

Add participants to a conference call
Add a participant to a conference call to participate in the discussion to resolve the major incident.

Before you begin
Role required: notify_admin, major_incident_manager, or communication_manager

Procedure
1. Navigate to Incident > Major incidents > Open.
2. Open the relevant major incident.
3. Click the Conference tab.
4. Click (+) Participants under Active Participants.
5. In the dialog box that appears, select the participants for the conference.

6. Click **Add Participants**.

**Results**
A notification is sent to all the users in Microsoft Teams that a call is initiated. Each user can accept the call to join the conference call.

As the host, you can view the users who have answered the call.

**Mute participants from a major incident conference call**
Mute a participant from the conference call to avoid unnecessary background disruption.

**Before you begin**
Before starting this procedure, ensure that there is an active conference call with one or more participants.

Role required: notify_admin, major_incident_manager, or communications_manager
Procedure
1. Navigate to Incident > Major incidents > Open.
2. Open the relevant major incident.
3. Click the Conference tab.
4. Click Mute next to the participant name you want to mute.

End a conference call from a major incident
As a host or participant with the major incident manager role, you can end the conference call.

Before you begin
Role required: notify_admin, major_incident_manager

Procedure
1. Navigate to Incident > Major incidents > Open.
2. Open the relevant major incident.
3. Click the Conference tab.
4. Click End Call.

Results
When you end a call from ServiceNow, only the host (bot) exits the call. The other participants still stay in the call until they manually disconnect. The call details are no longer logged after the host (bot) exits the call.

Manage calls in Microsoft Teams
Manage conference calls in Microsoft Teams by muting or unmuting participants, or ending the call.

Mute participants from Microsoft Teams
As a manager or a conference call host, you can mute conference participants to avoid distraction.

Before you begin
Ensure that there is an active conference call with one or more participants.

Role required: notify_admin, major_incident_manager, communications_manager, itil_admin
Procedure

1. Open the active conference call in Microsoft Teams.

2. Click the participants icon ( ) in the toolbar.

3. Mute an individual participant or mute all participants.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
</table>
| Mute an individual participant | a. Select the participant name.  
                              | b. Click Mute. |
| Mute all participants        | Click the Mute all button that appears on the top of the participant list. |

End a call from Microsoft Teams

As the host or a user with the manager role, you can end a conference call after the discussion ends.

Before you begin
Role required: notify_admin, major_incident_manager, communications_manager, or itil_admin

Procedure

1. Open the active conference call in Microsoft Teams.

2. Click more options icon ( ) in the toolbar.

3. Click End meeting.

4. Click Confirm in the dialog box.

Results
All users are terminated from the conference call.

Orchestration

ServiceNow® Orchestration extends the workflow engine to manage processes and to automate things outside of a ServiceNow instance.

Orchestration is available as a separate subscription from the rest of the ServiceNow platform. See Activate Orchestration for details.
Introduction to Orchestration

Orchestration automates simple or complex multi-system tasks on remote services, servers, applications, and hardware.

An Orchestration process can cross all management disciplines and interact with hosted services and all types of infrastructure elements. These capabilities provide a powerful system for managing IT and Business processes quickly and reliably.

Orchestrated solutions aide collaboration among teams by providing reusable data and versioning for both the workflows and the activities within them. Subject matter experts can create activities that are reusable to numerous workflow developers. When an activity requires a change, developers can see the downstream implication of the change immediately by knowing which workflows use the activity. Well-designed orchestrations never fail and apply human tasks to address errors as they arise.

Orchestration tools

Orchestration can make calls outside of a ServiceNow instance, directly to web services or through a MID Server to systems within corporate firewall. Orchestration also enables the creation reusable activities that wrapper Java
Script functions for manipulating things inside the platform. Orchestration extends the Workflow editor by providing these features:

- **Activity packs** containing ready-to-use activities.
- **Activity Designer**, which enables developers to create custom activities without an over dependence to create scripts to orchestrate to third-party systems.
- Ability to create activity packs using **Scoped Applications**.
- A **Databus** for following the flow of data across orchestration activities.

Orchestration Core provides entitlements to use specific applications:

**FIPS Approved mode**

Supports Federal Information Processing Standards (FIPS) 140-2 standards for outbound integrations. In FIPS approved mode, activities that use HTTPS calls use TLS v1.2 or TLS v1.3 and SSH activity pack uses only ServiceNow SSH.

**Client Software Distribution**

An application that automates software delivery from the Service Catalog. Provides OOB support for SCCM. Partner solutions support Macs using JAMF. Other third-party solutions provide support through the extension framework.

**Password Reset**

An application for users to reset their password in Active Directory. It can expand to communicate with other third-party systems.

**Orchestration ROI**

Enables users to evaluate estimated costs and actual costs for tasks, automate these tasks, and track the ROI of these tasks.

**Systems that Orchestration can automate**

Orchestration can automate tasks such as employee onboarding, user access rights, server management, managed file transfers, and Security Operations Orchestration activities. For example, you might use the Active Directory and Exchange activities provided in the base Orchestration system to set up network accounts and mailboxes for new employees.

If Orchestration does not provide the activities you need for an integration, create the necessary activities using the templates in the Orchestration Activity Designer. The external systems that Orchestration can automate for:
• Any system exposing web services (SOAP, REST)
• Any system accessible from the command line (such as a UNIX system accessible through SSH, a Windows system enabled for PowerShell remoting or WMI)
• Numerous proprietary services: Windows Active Directory, Microsoft Exchange mail servers, InfoBlox, and F5 Networks.

⚠️ Note: For a full list of Activity Pack service offerings, see Orchestration Core Activity Packs.

• Any filesystem accessible by SFTP
• Any database with a compliant JDBC driver
• Additional Activity Packs are also available with other ServiceNow products, such as Security Operations

Orchestration capabilities

Orchestration workflow

When an Orchestration activity starts within a workflow, Orchestration launches a probe and writes a probe record to the ECC Queue. The workflow pauses as the MID Server picks up the request and executes the probe. When the probe
reports back, the workflow resumes as the results are analyzed. The workflow can exit or continue at this point.

**Orchestration workflow**

Orchestration video tutorial

Watch the introductory video for Orchestration.

**Domain separation and Orchestration**

Domain separation is supported in Orchestration. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: Standard***

- Includes Basic level
- Business logic: Processes can be created or modified per customer by the service provider. The use cases reflect proper use of the application by multiple service provider customers in a single instance.
- The owner of the instance needs to be able to configure MVP business logic and data parameters per tenant as expected for the specific application.

Use case: As an admin, I need the ability to make comments mandatory on close of a record for one tenant, but not for another.

**Related information**

- Domain separation for service providers

**Activate Orchestration**

The Orchestration (com.snc.runbook_automation) plugin is available as a separate subscription from the rest of the ServiceNow platform.

**Before you begin**

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization’s production and subproduction instances, generally within a few days.
If you don’t have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps.

Role required: none

**Procedure**

1. Navigate to **System Applications > All Available Applications > All.**
2. On the All Applications page, click **Request Plugin** to open the Request form on HI.

3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th><strong>Activate Plugin request form</strong></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time. <strong>Note:</strong> Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the <strong>Reason/Comments</strong> field.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**List of Orchestration plugins**

This table lists all plugins available for Orchestration and their dependencies.

These Orchestration plugins are available for purchase or can be requested as part of your Orchestration subscription. Contact your account representative for details.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Dependencies</th>
</tr>
</thead>
</table>
| Orchestration [com.snc.runbook_automation] | Main plugin for the Orchestration feature. This plugin extends Workflow to automate operations with external systems. Use this plugin to orchestrate business services, applications, and infrastructure. This plugin automates operations such as deployments, configurations, | • Orchestration - ROI  
• Orchestration - Runtime |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Dependencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orchestration - Active Directory</td>
<td>Installs the Active Directory activity pack. These activities create, delete, and manage objects in Windows Active Directory.</td>
<td>Orchestration</td>
</tr>
<tr>
<td>[com.snc.orchestration.ad]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Orchestration - Asset Lease Management</td>
<td>Provides the software lease functionality for Client Software Distribution. Allows users to select the start and end dates of software leases and to request an extension of a lease.</td>
<td>None</td>
</tr>
<tr>
<td>[com.snc.orchestration.asset_lease_management]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Orchestration - Azure Active Directory</td>
<td>Installs the Azure AD activity pack. These activities automate employee onboarding and offboarding functions on Azure Active Directory and manage Office 365 licensing.</td>
<td>Orchestration</td>
</tr>
<tr>
<td>[com.snc.orchestration.azure.ad]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Orchestration - Client Software Distribution | Allows the distribution of software from the service catalog using third party management systems, such as Microsoft System Center Configuration Manager (SCCM).            | • Orchestration - System Center Configuration Manager  
• Orchestration - Asset Lease Management |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Dependencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orchestration - Exchange</td>
<td>Installs the Exchange activity pack. These activities manage Microsoft Exchange mail systems.</td>
<td>Orchestration</td>
</tr>
<tr>
<td>Orchestration - F5 network management</td>
<td>Installs the F5 Network Management activity pack. These activities configure elements of an F5 load balancer, including pools, pool members, and the virtual servers contained in the pool.</td>
<td>Orchestration</td>
</tr>
<tr>
<td>Orchestration - Infoblox DDI Activity Pack</td>
<td>Installs the Infoblox DDI activity pack. These activities support Infoblox DDI management.</td>
<td>Orchestration</td>
</tr>
<tr>
<td>Orchestration - PowerShell</td>
<td>Installs the PowerShell activity pack. These activities control and automate the administration of Windows machines and applications, using the Windows .NET Framework.</td>
<td>Orchestration</td>
</tr>
<tr>
<td>Orchestration - Probe</td>
<td>Installs the Probe activity pack. These activities run ServiceNow® probes on target hosts to return specific information.</td>
<td>Orchestration</td>
</tr>
</tbody>
</table>
| Orchestration - ROI                      | Installs an Orchestration application that estimates savings resulting from automated tasks in an instance and computes actual savings. Orchestration - ROI is activated automatically with a base Orchestration subscription. | • Performance Analytics  
• Cost Management |
| Name                                                                 | Description                                                                                                                                                                                                                                                                                                                                                           | Dependencies                                      |
|----------------------------------------------------------------------|--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------|
| Orchestration - ROI Premium [com.snc.runbook_automation.roi_premium] | Installs a premium dashboard that displays detailed reports on calculated savings for automated tasks over time. The Orchestration - ROI Premium plugin requires purchase and activation of the Performance Analytics - Premium plugin to display its reports.                                                                                                                       | • Orchestration - ROI                             |
|                                                                      | Note: This plugin is not automatically enabled when Orchestration is active.                                                                                                                                                                                                                                                                                                  | • Performance Analytics - Premium                 |
| Orchestration - Runtime [com.snc.runbook_automation.runtime]          | Enables other applications on the ServiceNow platform to distribute and use orchestration content without requiring an Orchestration subscription. The Orchestration - Runtime plugin displays the Orchestration activities shipped with these applications in the Workflow Editor and allows customers to modify the activities without requiring an Orchestration license.                                                                                                         | • Workflow Runtime Engine                        |
|                                                                      |                                                                                                                                                                                                                                                                                                                                                                       | • Core Automation                                |
| Orchestration - SFTP [com.snc.orchestration.sftp]                    | Installs the SFTP File Transfer activity pack. These activities manage files and directories on an SFTP server and move files from one SFTP server to another.                                                                                                                                                                                                                      | Orchestration                                    |
| Orchestration - SSH [com.snc.orchestration.ssh]                     | Installs the SSH activity pack. These activities read, write, and copy files, and reset user passwords on Linux computers.                                                                                                                                                                                                                                           | Orchestration                                    |
| Orchestration - System Center Configuration Manager [com.snc.orchestration.sccm_mgnt] | Installs the System Center Configuration Manager (SCCM) activity pack. These activities manage software deployments and collections on an SCCM server.                                                                                                                                                                                                                                           | Orchestration                                    |
**Orchestration Runtime plugin**

The Orchestration – Runtime plugin enables other applications on the ServiceNow® platform to automate tasks, without requiring an Orchestration subscription.

The Orchestration – Runtime plugin can be activated as part of another plugin or application. It is used by strategic technology partners and ServiceNow applications to distribute activity packs to customers who may not own Orchestration. For example, the Security Incident Response Management (SIRM) application provides orchestration content, which includes activities that are available from the Packs tab in the Workflow Editor. Customers who purchase SIRM can consume and modify the activities that SIRM ships without having to purchase an Orchestration license.

**Included with the plugin**

The Orchestration – Runtime plugin provides access to the Packs and Data tabs in the Workflow Editor. This plugin gives users access to custom activities for their applications and enables them to reuse data from the Databus. This plugin does not provide access to custom Orchestration activity packs or to the activity designer. The Custom tab in the Workflow Editor is not available without an Orchestration subscription.

**Orchestration plugin relationships**

The Orchestration – Runtime plugin activates these application plugins:

- Orchestration - ROI
- Orchestration - Client Software Distribution
- Orchestration - Runtime
- Service Release Automation
- Security Incident Response

**Dependencies**

The Orchestration – Runtime plugin activates these application plugins:
• Security Incident Response Orchestration
• Service Release Automation

Access to activities
Custom activities shipped with ServiceNow® applications are available in the Packs tab of the Workflow Editor for use in workflows. To edit these activities, navigate to Orchestration > Activity Designer Activities and select the activity you want to modify. For information about the provider templates used to create these activities, see Orchestration custom activity templates.

List of Orchestration activities
Use Orchestration activities in a Workflow to integrate with third-party systems.

Several Orchestration activities have been rewritten as scoped activities using the activity designer and grouped into activity packs. Other non-scoped activities are deprecated and may or may not appear in the Workflow Editor. However, all deprecated activities still function in existing workflows that use them.

Global activities
These activities run in the global scope only. Any activities you create in the global scope are organized in the Global category in the Packs and Custom tabs in the Workflow Editor.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Server Alive</td>
<td>Runs a command (including shell scripts) on a Linux or UNIX computer via SSH to validate whether the target system is alive.</td>
</tr>
</tbody>
</table>

Active Directory (AD) activities
All AD Orchestration activities were rewritten in the Geneva release as scoped activities and are available in the Active Directory activity pack. All previous version AD activities that were built on activity definitions are deprecated and are unavailable for use in new workflows.
<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create AD Object</td>
<td>Creates a user account in Windows Active Directory when a user account is created in a ServiceNow instance.</td>
</tr>
<tr>
<td>Disable AD User Account</td>
<td>Marks a Windows Active Directory user account disabled, making it inactive.</td>
</tr>
<tr>
<td>Enable AD User Account</td>
<td>Enables a Windows Active Directory user account, making it active.</td>
</tr>
<tr>
<td>Query AD</td>
<td>Retrieves entries from the Windows Active Directory based on a search filter.</td>
</tr>
<tr>
<td>Remove AD Object</td>
<td>Deletes a user account from Windows Active Directory.</td>
</tr>
<tr>
<td>Reset AD User Password</td>
<td>Resets the password of a user account in Windows Active Directory.</td>
</tr>
<tr>
<td>Change AD User Password</td>
<td>Changes the password of a user account in Windows Active Directory.</td>
</tr>
<tr>
<td>Update AD Object</td>
<td>Updates a user account in Windows Active Directory.</td>
</tr>
<tr>
<td>Is AD Account Locked</td>
<td>Determines if an Active Directory user account is locked.</td>
</tr>
<tr>
<td>Unlock AD Account</td>
<td>Unlocks a locked Active Directory user account.</td>
</tr>
</tbody>
</table>

**Azure AD**

All these activities are scoped and part of the Azure AD activity pack. They do not have legacy versions.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add User to Group</td>
<td>Adds a user to an existing security group in Azure Active Directory.</td>
</tr>
<tr>
<td>Assign User License</td>
<td>Assigns an extra Office 365 software license to the named user.</td>
</tr>
<tr>
<td>Create User</td>
<td>Creates a user for the Azure Active Directory tenant.</td>
</tr>
<tr>
<td>Activity</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Delete User</td>
<td>Deletes the named user's account from the Azure Active Directory tenant.</td>
</tr>
<tr>
<td>Get User Info</td>
<td>Returns the named user's information from the Azure Active Directory.</td>
</tr>
<tr>
<td>Remove User from Group</td>
<td>Removes an existing user from a security group in Azure Active Directory.</td>
</tr>
<tr>
<td>Remove User License</td>
<td>Revokes the specified Office 365 software license for the named user.</td>
</tr>
<tr>
<td>Reset User Password</td>
<td>Changes the named user's Azure Active Directory password.</td>
</tr>
</tbody>
</table>

### F5 Network Management activities

All these activities are scoped and part of the F5 Network Management activity pack. They do not have legacy versions.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add F5 Pool</td>
<td>Creates the load balancer pool.</td>
</tr>
<tr>
<td>Check F5 Pool</td>
<td>Checks the status of a pool to validate whether it is available to accept traffic.</td>
</tr>
<tr>
<td>Delete F5 Pool</td>
<td>Deletes an F5 pool.</td>
</tr>
<tr>
<td>Add F5 Pool Member</td>
<td>Adds a member to an F5 pool.</td>
</tr>
<tr>
<td>Get F5 Pool Member</td>
<td>Returns the pool members and verifies the pool status.</td>
</tr>
<tr>
<td>Delete F5 Pool Member</td>
<td>Deletes an F5 pool member.</td>
</tr>
<tr>
<td>Add F5 Virtual Server</td>
<td>Adds a virtual server.</td>
</tr>
<tr>
<td>Modify F5 Virtual Server</td>
<td>Configures a virtual server assigned to an F5 pool with irules and a vlan.</td>
</tr>
<tr>
<td>Delete F5 Virtual Server</td>
<td>Deletes a virtual server from an F5 pool.</td>
</tr>
<tr>
<td>Add F5 Profile to Virtual Server</td>
<td>Adds a profile to a virtual server assigned to an F5 pool.</td>
</tr>
</tbody>
</table>
# Infoblox activities

All these activities are scoped and part of the Infoblox DDI activity pack. They do not have legacy versions.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP Reserve IP v4</td>
<td>Reserves an IP address range for DHCP use.</td>
</tr>
<tr>
<td>Address Range</td>
<td></td>
</tr>
<tr>
<td>DHCP Delete IP</td>
<td>Deletes IP reservations in DHCP using either an IPv4 or IPv6 address range.</td>
</tr>
<tr>
<td>Reservation</td>
<td></td>
</tr>
<tr>
<td>DHCP List IP</td>
<td>Generates a list of all the DHCP range reservations on a specific Infoblox server.</td>
</tr>
<tr>
<td>Reservations</td>
<td></td>
</tr>
<tr>
<td>List DNS C-records</td>
<td>Retrieves all canonical (CNAME) records from a specified Infoblox server.</td>
</tr>
<tr>
<td>Register DNS A-record</td>
<td>Creates a DNS A record on a specified Infoblox server.</td>
</tr>
<tr>
<td>Register DNS C-Record</td>
<td>Creates a DNS canonical (CNAME) record on a specified Infoblox server.</td>
</tr>
<tr>
<td>List DNS Record</td>
<td>Generates a list of all the DNS entries on a specific Infoblox server.</td>
</tr>
<tr>
<td>DNS Delete</td>
<td>Deletes DNS records of any type from in Infoblox server, such as C and A records.</td>
</tr>
<tr>
<td>IPAM Register IP</td>
<td>Registers an IP address in a network using Infoblox IPAM.</td>
</tr>
<tr>
<td>Address</td>
<td></td>
</tr>
<tr>
<td>IPAM Reserve IP</td>
<td>Reserves an IP address in a network using Infoblox IPAM.</td>
</tr>
<tr>
<td>Address</td>
<td></td>
</tr>
<tr>
<td>IPAM List IP</td>
<td>Returns an array of all IP Address within the named Infoblox Server.</td>
</tr>
<tr>
<td>Reservations</td>
<td></td>
</tr>
<tr>
<td>IPAM Delete</td>
<td>Deletes an IP Address within a named Infoblox server.</td>
</tr>
<tr>
<td>Create Network</td>
<td>Creates networks on a specified Infoblox server.</td>
</tr>
<tr>
<td>Get Network Details</td>
<td>Retrieves the information about a specific network on an Infoblox server.</td>
</tr>
<tr>
<td>Delete Network</td>
<td>Deletes a network from an Infoblox server.</td>
</tr>
<tr>
<td>List Registered</td>
<td>Retrieves all the networks associated with an Infoblox server.</td>
</tr>
<tr>
<td>Networks</td>
<td></td>
</tr>
</tbody>
</table>
Microsoft Exchange activities

All Exchange Orchestration activities were rewritten in the Geneva release as scoped activities and are available in the Exchange activity pack. All previous version Exchange activities that were built on activity definitions are deprecated and are unavailable for use in new workflows.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Address List</td>
<td>Creates an address list that acts as an alias for emailing all users in the group. This alias cannot be used to manage user permissions.</td>
</tr>
<tr>
<td>Delete Address List</td>
<td>Removes an existing address list from an Exchange server.</td>
</tr>
<tr>
<td>Get Address List</td>
<td>Retrieves all attributes from the specified Exchange address list.</td>
</tr>
<tr>
<td>Move Address List</td>
<td>Moves an Exchange address list to another location in the address hierarchy.</td>
</tr>
<tr>
<td>Set Address List</td>
<td>Modifies an Exchange address list.</td>
</tr>
<tr>
<td>Update Address List</td>
<td>Adds or removes users from the specified address list and immediately applies any cached address list changes to the server.</td>
</tr>
<tr>
<td>Create Mailbox</td>
<td>If a user does not exist, creates a new Active Directory user and associated Exchange mailbox.</td>
</tr>
<tr>
<td>Delete Mailbox</td>
<td>Deletes the Exchange mailbox of an Active Directory user.</td>
</tr>
<tr>
<td>Disable Mailbox</td>
<td>Disables the mailbox associated with a specified Active Directory account.</td>
</tr>
<tr>
<td>Enable Mailbox</td>
<td>Creates a mailbox for an existing Active Directory user.</td>
</tr>
<tr>
<td>Get Mailbox</td>
<td>Gets the mailbox for the specified user or all mailboxes on an Exchange server.</td>
</tr>
<tr>
<td>Activity</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set Mailbox</td>
<td>Modifies the settings of an existing Exchange mailbox.</td>
</tr>
</tbody>
</table>

**PowerShell activities**

These PowerShell activities were rewritten as scoped activities and are available in the PowerShell activity pack. All previous version PowerShell activities that were built on activity definitions are deprecated and are unavailable for use in new workflows.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Windows App</td>
<td>Installs an application on a Windows target machine.</td>
</tr>
<tr>
<td>Join Domain</td>
<td>Joins a Windows machine to a domain.</td>
</tr>
<tr>
<td>Uninstall Windows App</td>
<td>Uninstalls an application from a Windows target machine.</td>
</tr>
<tr>
<td>Change Service State</td>
<td>Starts or stops a Windows service on a remote system.</td>
</tr>
</tbody>
</table>

**Probe activities**

These probe activities were rewritten as scoped activities and are available in the Probe activity pack. All previous versions of these activities that were built on activity definitions are deprecated and are unavailable for use in new workflows.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolve DNS Name</td>
<td>Resolves an IP address or a fully qualified domain name (FQDN) into one or more IP addresses.</td>
</tr>
<tr>
<td>SNMP Query</td>
<td>Queries an SNMP device.</td>
</tr>
</tbody>
</table>

**SCCM activities**

All these activities are scoped and part of the SCCM activity pack. They do not have legacy versions.
<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to Device Collection</td>
<td>Adds a device to a Microsoft System Center Configuration Manager (SCCM) device collection.</td>
</tr>
<tr>
<td>Add to User Collection</td>
<td>Adds a user to a Microsoft System Center Configuration Manager (SCCM) user collection.</td>
</tr>
<tr>
<td>Get Applications</td>
<td>Returns a list of all the applications available on a Microsoft System Center Configuration Manager (SCCM) server.</td>
</tr>
<tr>
<td>Get Deployments</td>
<td>Returns the list of deployments performed by Orchestration using a Microsoft System Center Configuration Manager (SCCM) server.</td>
</tr>
<tr>
<td>Get Device Collections</td>
<td>Returns the list of available device collections on a Microsoft System Center Configuration Manager (SCCM) host.</td>
</tr>
<tr>
<td>Get User Collections</td>
<td>Returns the list of available user collections on a Microsoft System Center Configuration Manager (SCCM) host.</td>
</tr>
<tr>
<td>Remove from Device Collection</td>
<td>Removes a device from a Microsoft System Center Configuration Manager (SCCM) device collection.</td>
</tr>
<tr>
<td>Remove from User Collection</td>
<td>Removes a user from a Microsoft System Center Configuration Manager (SCCM) user collection.</td>
</tr>
</tbody>
</table>

**SSH activities**

These SSH activities were rewritten as scoped activities and are available in the SSH activity pack. The SSH activities not converted to scoped activities were moved to the Orchestration - Deprecated category, but are still available for all workflows.
<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Copy</td>
<td>Copies a file on a Linux or Unix computer, via SSH.</td>
</tr>
<tr>
<td>File Read</td>
<td>Reads a file on a Linux or Unix computer, via SSH.</td>
</tr>
<tr>
<td>File Write</td>
<td>Writes a file on a Linux or UNIX computer.</td>
</tr>
<tr>
<td>File Replace String</td>
<td>Finds and replaces a string in a file on a Linux or UNIX computer.</td>
</tr>
<tr>
<td>Files Compare</td>
<td>Compares two files on a Linux or Unix computer, via SSH.</td>
</tr>
<tr>
<td>Reset Linux User Password</td>
<td>Resets the password for a given user on a Linux computer.</td>
</tr>
<tr>
<td>Secure Copy</td>
<td>Copies a file from one host to another, without storing the copied file on the MID Server.</td>
</tr>
</tbody>
</table>

**SFTP activities**

All these activities are scoped and part of the SFTP File Transfer activity pack. They do not have legacy versions.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy File</td>
<td>Copies a file from an SFTP server (source host) to another SFTP server (target host).</td>
</tr>
<tr>
<td>Create Directory</td>
<td>Creates a directory on an SFTP server.</td>
</tr>
<tr>
<td>Get File List</td>
<td>Returns a list of files from a given directory and its subdirectories on an SFTP server (source host).</td>
</tr>
<tr>
<td>Activity</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Remove File or Directory</td>
<td>Removes a file or a directory on an SFTP server, including subdirectories, when configured.</td>
</tr>
<tr>
<td>Rename File or Directory</td>
<td>Renames a file or directory to a new name on an SFTP server.</td>
</tr>
<tr>
<td>Set File Attributes</td>
<td>Sets common file attributes, such as timestamps, size, permissions, and UID/GID, for a file or directory on an SFTP server.</td>
</tr>
</tbody>
</table>

**Deprecated activities**

These activities have been removed from the Workflow Editor and are not available for new workflows, but continue to work normally in existing workflows. You can reactivate the deprecated activity or duplicate the functionality of a deprecated activity as a scoped activity by recreating it using the activity designer.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Probe</td>
<td>Launches a MID Server probe on behalf of a document.</td>
</tr>
<tr>
<td>SOAP Request</td>
<td>Executes a SOAP request on a target server. The SOAP Message activity replaces this activity.</td>
</tr>
<tr>
<td>Run Command</td>
<td>Runs a command (including shell scripts) on a Linux or UNIX computer.</td>
</tr>
<tr>
<td>Run SCP</td>
<td>Uses Secure Copy Protocol (SCP) to copy a file from one computer to another, including the directory in which the file resides. The Secure Copy activity replaces the Run SCP activity.</td>
</tr>
<tr>
<td>Run Powershell</td>
<td>Executes Windows PowerShell commands on a MID Server.</td>
</tr>
</tbody>
</table>

**Available activity packs**

Activity packs are available with your subscription to Orchestration.

**Before you begin**

Role required: admin

**About this task**

The following activity packs are available and active with your Orchestration subscription:
• Orchestration - Active Directory (com.snc.orchestration.ad)
• Orchestration - Azure Active Directory (com.snc.orchestration.azure.ad)
• Orchestration - Exchange (com.snc.orchestration.exchange)
• Orchestration - SFTP (com.snc.orchestration.sftp)
• Orchestration - Infoblox DDI Activity Pack (com.snc.orchestration.infoblox)
• F5 Network Management activity pack (com.snc.orchestration.f5)
• Orchestration - SSH (com.snc.orchestration.ssh)
• Orchestration - PowerShell (com.snc.orchestration.powershell)
• Orchestration - System Center Configuration Manager (com.snc.orchestration.sccm_mgnt)

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
4. On the form, fill in the fields.

**Activate Plugin request form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Deprecated Orchestration activities**

These Orchestration activities have been deprecated.

**Run Probe**

The Run Probe activity launches a MID Server probe on behalf of a document. All Orchestration activities that launch a probe on a target machine are based on the Run Probe activity. Your ServiceNow instance must have access to a MID Server configured to use SSH to run this activity.
\textbf{Attention:} This activity is deprecated and is unavailable for new workflows. To replace the functionality of this probe, use the \textit{Probe activity template} to create a custom activity. Workflows from a previous release that use the Run Probe activity can continue to do so.

### Run Probe Input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Probe</td>
<td>Select a MID Server probe from the list. This is the name of the probe as it appears in the \textit{discovery_probes} table.</td>
</tr>
<tr>
<td>Source for probe</td>
<td>Enter the IP address of the host system against which the probe runs (the probe's target).</td>
</tr>
<tr>
<td>Sensor script</td>
<td>The script to run using the results of the probe. The output from the probe is contained in a variable called \textit{output}. Any error from the probe is contained in a variable called \textit{error}.</td>
</tr>
</tbody>
</table>

### SOAP Request

The SOAP Request activity executes a SOAP request on a target server.

\textbf{Attention:} This activity is deprecated and is replaced by the \textit{SOAP Message workflow activity} activity. Workflows from a previous release that use the SOAP Request activity can continue to do so. However, this activity is not available for new workflows.

### SOAP Request input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOAP URL</td>
<td>The SOAP endpoint.</td>
</tr>
<tr>
<td>Username</td>
<td>User name for basic authentication credentials.</td>
</tr>
<tr>
<td>Password</td>
<td>Password for basic authentication credentials.</td>
</tr>
<tr>
<td>Envelope Script</td>
<td>Script for setting up parameters for the web service.</td>
</tr>
<tr>
<td>Sensor Script</td>
<td>The script to execute after the request has been made and a response has been received.</td>
</tr>
</tbody>
</table>
Reactivate a deprecated activity

Orchestration activities that were converted to activity packs are deprecated for upgraded and new instances but can be reactivated for use in new workflows.

Before you begin
Role required: workflow_admin, admin

⚠️ **Note:** Reactivation of deprecated activities for use in new workflows is discouraged. Legacy activities cannot use the unique features of the scoped applications, such as reuse of data from the databus and input variable testing.

Procedure

1. Navigate to **Workflow > Administration > Activity Definitions.**
2. In the list of activities, clear the condition **Category != deprecated** from the filter.

```
   All > Category != deprecated
```

3. Open the definition record for the activity you want to reactivate.
4. Select the **What to Display** tab.
5. In the **Category** field, replace the value **deprecated** with another category. This can be an arbitrary string.
6. Click **Update**. The system creates a new category using the value provided and reactivates the activity, which becomes available in the **Core** tab of the Workflow Editor.

SOAP Message workflow activity

The **SOAP Message** activity uses SOAP messages defined in the System Web Services plugin and can call the messages using a MID Server.

Your instance must have access to a MID Server configured to use SOAP.
### Input variables

#### SOAP Message activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOAP Message</td>
<td>soap_message</td>
<td>The SOAP Message defined under the System Web Services plugin's Outbound SOAP Message [sys_soap_message] table. (System Web Services &gt; Outbound &gt; SOAP Message)</td>
</tr>
<tr>
<td>SOAP Message Function</td>
<td>soap_message_function</td>
<td>The function to call that is defined in the SOAP Message. Functions are listed in the SOAP Message Functions related list in each SOAP Message record.</td>
</tr>
<tr>
<td>SOAP Endpoint</td>
<td>soap_endpoint</td>
<td>Endpoint to use instead of the SOAP endpoint value in the SOAP Message Function record. Leave this field blank to use the defined endpoint in the SOAP Message Function record.</td>
</tr>
<tr>
<td>Variables</td>
<td>variables</td>
<td>Variables to substitute into the SOAP Envelope defined in the SOAP Message Function record. Use this format for the string: name1=value1, name2=value2, ... If either the name or value contains a comma or equal sign, escape these characters with a backslash.</td>
</tr>
<tr>
<td>Use MID Server</td>
<td>use_midserver</td>
<td>Check box for using a MID Server to send the SOAP message. A MID Server might be necessary to reach an endpoint within a firewall or a sub-network that is not visible from the instance. If this check box is selected (true), but no MID Server is defined in the MID Server field, workflow automatically attempts to find a MID Server.</td>
</tr>
<tr>
<td>MID Server</td>
<td>midserver</td>
<td>Name of the MID Server to use. This field appears when you select the Use MID Server check box. The workflow</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc. in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
SOAP Message activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>ignores this parameter if the <code>use_midserver</code> parameter is disabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> You can only select a specific MID Server in the legacy SOAP message activity and REST messages. These legacy activities do not use the MID Server selection criteria available starting with the Istanbul release.</td>
</tr>
<tr>
<td>Sensor Script</td>
<td>sensor_script</td>
<td>The script to execute after the request has been made and a response has been received. You can access the full XML response body from the <code>activity.output</code> object.</td>
</tr>
</tbody>
</table>

Probes used by Orchestration

Certain probes, controlled by MID Servers, perform Orchestration tasks on remote computers, such as restarting a server or creating virtual machines from templates.

How Orchestration probes work

When a Workflow executes an Orchestration activity, that activity launches a probe, which writes an `output` record to the ECC Queue. The MID Server selected for the activity checks the ECC Queue for assignments, and then executes the appropriate probe to do the work on the target machine. The information about the activity (machine restarted, files copied, etc.) that is returned from the target machine by the probe is written to the ECC Queue as an `input` record. This information is then sent from the ECC Queue to a sensor that is built into the Workflow activity. The Workflow is updated, and the next activity is executed.

**Note:** The probe parameters are set by the activities that launch the probe.
How Orchestration uses probes

The base system includes the following Orchestration probes (Orchestration > Definition > Probes).

<table>
<thead>
<tr>
<th>Probe Name</th>
<th>ECC Queue Topic</th>
<th>ECC Queue Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
<td>Command</td>
<td></td>
<td>A probe that runs a local command on the MID server.</td>
</tr>
<tr>
<td>DNS Name Resolver</td>
<td>DNSNameResolver</td>
<td></td>
<td>A probe that resolves a fully qualified domain name (FQDN) into an IP address. The probe executes MID Server queries in parallel. It utilizes DNS lookup by the MID Server host OS to make use of the OS maintained DNS cache. It also leverages the hosts file on the OS.</td>
</tr>
<tr>
<td>SCPCommand</td>
<td>SCPCCommand</td>
<td></td>
<td>A probe that copies files securely from one machine to another. The copy function is performed using the MID Server as a tunnel.</td>
</tr>
<tr>
<td>Shazzam</td>
<td>Shazzam</td>
<td></td>
<td>A probe that identifies active devices.</td>
</tr>
<tr>
<td>Probe Name</td>
<td>ECC Queue Topic</td>
<td>ECC Queue Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SNMPProbe</td>
<td>SNMP</td>
<td>SNMP Query</td>
<td>This is a generic SNMP probe.</td>
</tr>
<tr>
<td>SOAPProbe</td>
<td>SOAPProbe</td>
<td></td>
<td>A probe that sends a SOAP request to target machine.</td>
</tr>
<tr>
<td>SSHCommand</td>
<td>SSHCommand</td>
<td></td>
<td>A probe that executes shell scripts from a command line after logging in to a target machine via SSH.</td>
</tr>
<tr>
<td>SSHCommandLong</td>
<td>SSHCommandLong</td>
<td></td>
<td>A probe that executes long running shell scripts from a command line after logging in to a target machine via SSH.</td>
</tr>
<tr>
<td>VMWare</td>
<td>VMWareProbe</td>
<td></td>
<td>A generic VMware probe that executes the MID Server script include in the ECC queue name that is set by a VMware Orchestration activity. This probe can run any MID Server script include.</td>
</tr>
</tbody>
</table>
| Windows - PowerShell | PowerShell     | Windows - PowerShell    | A probe that runs a Windows PowerShell script on the MID Server. The PowerShell script is provided as the value of a parameter with name ending in .ps1. Two variables are available to the script:  
  • $computer: The computer pointed to as the source for this probe. |
Probe List (continued)

<table>
<thead>
<tr>
<th>Probe Name</th>
<th>ECC Queue Topic</th>
<th>ECC Queue Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$cred</td>
<td></td>
<td></td>
<td>• $cred: A PowerShell credential, using a user name and password from the Credentials table, that logs into $computer successfully.</td>
</tr>
</tbody>
</table>

**PowerShell activities**

PowerShell is built on the Windows .NET Framework and is designed to control and automate the administration of Windows machines and applications.

PowerShell must be installed on any MID Server that uses these activities. MID Servers using PowerShell must be installed on a supported Windows operating system. ServiceNow supports PowerShell 3.0 to 5.1.

The ServiceNow Orchestration plugin adds these basic PowerShell activities to workflows. For instructions on using activities from the PowerShell activity pack, see [PowerShell activity pack](#).

**Legacy Run PowerShell activity**

The Run PowerShell activity executes Windows PowerShell commands on a MID Server.

⚠️ **Attention:** This activity is deprecated and is unavailable for new workflows. To replace the functionality of this activity, use the [Powershell activity template](#) to create a custom, scoped activity. Workflows from a previous release that use the Run PowerShell activity can continue to do so.

**Result Values**

The workflow designer can assign a result value using activity.result from within a script field of the activity. By default, the success or failure of the PowerShell commands used determines the result value of the Run PowerShell activity.

Possible result values are:

- Success
- Failure
Scratchpad Entries

Information written to stdout by the executing script is captured and returned to the activity in the activity.output variable. This information can be parsed, processed, or saved (to a scratchpad variable, for example) for future processing in the activity’s sensor script.

An example would be to run the `get-date` command to get the MID Server’s current time. This sensor script saves the full output received, but we can process it to return and save only the time.

Note: This is an over-simplified example. In most cases, the script operates against some remote Windows computer. However, the principal is the same – whatever is written to stdout is returned in activity.output and available to process.

Input Variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>IP address of the target Windows machine. This value is mapped to the $computer variable for use in commands (see the example in the Command field). A PowerShell credential variable called $cred that is based on information in the ServiceNow Credentials table will authenticate on the computer pointed to by Hostname.</td>
</tr>
</tbody>
</table>
| Command     | Enter the PowerShell command to run. For example, to execute a simple WMI query against a remote machine pointed to by the hostname variable, the command is: `get-wmiobject <class> -computer $computer -credential $cred` If no credentials authenticate on the computer, the command runs in the context of the MID Server user.
Input Variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>You cannot run both a command and a script file. Specifying a</td>
</tr>
<tr>
<td></td>
<td>command hides the Script file variable.</td>
</tr>
<tr>
<td>Sensor script</td>
<td>The script to run using the results of the probe. The output from the</td>
</tr>
<tr>
<td></td>
<td>probe is contained in a variable called output. Any error from the</td>
</tr>
<tr>
<td></td>
<td>probe is contained in a variable called error.</td>
</tr>
<tr>
<td>Script file</td>
<td>The MID Server script file to run. You cannot run both a script file</td>
</tr>
<tr>
<td></td>
<td>and a command. Selecting a script file hides the Command variable.</td>
</tr>
<tr>
<td>PowerShell script</td>
<td>Additional parameters, in JSON format, used by the specified</td>
</tr>
<tr>
<td>variables</td>
<td>script file.</td>
</tr>
</tbody>
</table>

States
The activity state tells the workflow engine what to do with the activity.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine knows to start the onExecute function of the activity.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the</td>
</tr>
<tr>
<td></td>
<td>activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was cancelled.</td>
</tr>
</tbody>
</table>

Add workflow variables for the command line using the normal workflow variable syntax. In the example above, if the <class> was in a workflow input variable called myclass, the command would look like:

```
get-wmiobject $ {workflow. inputs. myclass } -computer $computer -credential $cred
```

Similarly, if the variable is a scratchpad variable named myclass, the command would look like:

```
get -wmiobject $ {workflow. scratchpad. myclass } -computer $computer -credential $cred
```
**HResult codes**

When a PowerShell script encounters an error, the Windows machine may return an HResult code as part of the error message.

PowerShell activities can read and interpret this code. Not all PowerShell errors include an HResult code. In the event of a failed PowerShell script, you can use the HResult code to move the workflow through a specific condition.

For example, when resetting an Active Directory password to a password that does not meet policy requirements, such as minimum length or complexity, the PowerShell script returns the HResult code -2146022651. To use this code, create an activity condition with the **Condition** value of `activity.hresult = -2146022651`. If the PowerShell script returns this code when the activity runs, the workflow transitions through this new condition.

**SSH activities**

SSH activities allow workflows to perform operations on Linux and Unix computers.

Your ServiceNow instance must have access to a MID Server configured to use SSH to run these Orchestration activities.

**Run Command activity**

The Run Command activity runs a command (including shell scripts) on a Linux or UNIX computer.

⚠️ **Attention:** The Run Command activity is deprecated in this release. If you have a workflow created in a previous version that uses this activity, your workflow will continue to work normally after upgrading to Helsinki. However, to use this functionality in a new workflow, you must create a custom activity using the SSH activity template in the ServiceNow® activity designer.

**Input variables**

**Run command input variables**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long running</td>
<td>Select this check box to disable the SSH connection timeout if you think the command will take longer to run than the default 60 seconds. Orchestration periodically checks the running process to determine its status until it is finished.</td>
</tr>
</tbody>
</table>
Run command input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>Hostname or IP address of destination server for SSH activity.</td>
</tr>
<tr>
<td>Directory</td>
<td>Name of the working directory.</td>
</tr>
<tr>
<td>Command</td>
<td>The command to run from this activity.</td>
</tr>
<tr>
<td>Sudo</td>
<td>Select this check box to use <code>sudo</code> to run the command on the host machine.</td>
</tr>
<tr>
<td>Sensor script</td>
<td>The script to run using the results of the probe. The output from the probe is contained in a variable called <code>output</code>. Any error from the probe is contained in a variable called <code>error</code>.</td>
</tr>
</tbody>
</table>

Run SCP activity

The Run SCP activity uses Secure Copy Protocol (SCP) to copy a file from one computer to another, including the directory in which the file resides.

⚠️ Note: This activity is deprecated in the Geneva release and is not available for use in new workflows. If you have a workflow created in a previous version that uses this activity, your workflow will continue to work normally after upgrading. The custom Secure Copy activity replaces the Run SCP activity in the Geneva release.

Input variables

Run SCP input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Host</td>
<td>Hostname or IP address of the source computer.</td>
</tr>
<tr>
<td>From File</td>
<td>Absolute path to the file to copy. This value can be a directory.</td>
</tr>
<tr>
<td>To Host</td>
<td>Hostname or IP address of the target computer.</td>
</tr>
<tr>
<td>To File</td>
<td>Path to the target file. This path can be absolute or relative to the logged in user's home directory. The specified directory must already exist on the target computer.</td>
</tr>
<tr>
<td>Copy Directory</td>
<td>Check box to copy a directory defined in the <strong>From File</strong> variable and all files contained in that directory.</td>
</tr>
</tbody>
</table>
**Orchestration applications**

Orchestration provides several applications with your subscription.

**Orchestration ROI**

The Orchestration ROI application allows you to estimate and compute cost savings for tasks in your system that could be automated with Orchestration.

After you automate the tasks, you can track cost savings by associating Orchestration workflows with corresponding task areas. Configuration in the application allows you to select the hourly rate for performing the task manually, the rules the system uses to select tasks for evaluation, and the time period of the evaluation. Orchestration ROI estimates your savings by multiplying the cost of performing repetitive tasks manually by the estimated number of times the system performs those tasks automatically during a specific date/time range. The system also calculates the actual savings of your automations. Orchestration ROI is included with the base Orchestration subscription.

Orchestration ROI reports offer a number of views of the comparative data and allow you to access the associated records directly from the reports. The standard reports included with the Orchestration - ROI plugin provide summaries, estimated costs, and calculated costs for automated processes. The ROI premium dashboard uses Performance Analytics to provide detailed reports on calculated savings over time. Performance Analytics requires a different plugin and subscription.

**Note:** When Orchestration ROI is activated as a dependent plugin of Orchestration, demo data is not installed. If you want to use demo data as a template for your own ROI evaluation, submit a request to ServiceNow® technical support for an Orchestration ROI plugin upgrade with demo data selected.

To set up Orchestration ROI, complete the configuration tasks in the order shown here.

**Create Orchestration ROI labor rate cards**

Before calculating your Orchestration ROI, you must create labor rate cards for the manual work that would be required to complete the tasks correlated to the ROI calculations.

**Before you begin**

Role required: orchestration_manager
About this task
The hourly rates defined in the rate cards are used to determine the savings from your orchestrated tasks.

Procedure
1. Navigate to Orchestration > ROI > Labor Rate Cards.
2. Complete the fields in the form using the descriptions in .
3. Click Submit.
4. Create additional rate cards as needed.

Create an Orchestration ROI automation entry record
The ROI automation entry record couples the cost of performing a task with the specific workflow that automates the task, for the purpose of calculating the resulting savings.

Before you begin
Role required: orchestration_manager
Before starting this procedure, verify that the appropriate labor rate cards were created.

About this task
Use this record to apply a manual hourly rate to a task that is performed automatically by your instance. To determine the savings realized from orchestrating a task, the system can evaluate whether those savings were estimated or calculated.

• Estimated savings: Uses the labor rate, the time estimates for completion of the task, and the number of automations that have been run to determine savings.

• Calculated savings: Uses the labor rate, the time calculated for completion of the task, based on the configured evaluation period, and the number of automations that have been run to determine savings.

Procedure
1. Navigate to Orchestration > ROI > Automation Entry Form.
2. Fill in the fields on the form, as appropriate.
## Automation Entry Form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Category of the selected workflow automation. The following categories are provided in the base Orchestration - ROI system:</td>
</tr>
<tr>
<td></td>
<td>• Access &amp; Identity Management</td>
</tr>
<tr>
<td></td>
<td>• Datacenter Automation</td>
</tr>
<tr>
<td></td>
<td>• IT Service Management</td>
</tr>
<tr>
<td></td>
<td>• Other</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To create a category, open the dictionary record for the Automation Entry Form [automation_entry_form] table and add an option to the choice list.</td>
</tr>
<tr>
<td>Item</td>
<td>Unique name for the specific task within the category. This value represents the work to which the labor rate card applies, such as <strong>Password Reset</strong>.</td>
</tr>
<tr>
<td>Resource</td>
<td>Labor rate card to apply to this automation entry. You must have IT Cost Management active on the instance for this field to appear.</td>
</tr>
<tr>
<td>Associated Workflows</td>
<td>Workflow automations created to automate this manual task. The system uses this field to identify the number of automations that have been run.</td>
</tr>
<tr>
<td>Estimated Duration (min) per Task</td>
<td>Estimated time to perform this task manually.</td>
</tr>
<tr>
<td>Estimated Volume per Month</td>
<td>Estimated number of times needed to perform this task manually per month.</td>
</tr>
<tr>
<td>Read-only fields</td>
<td>Start time for the evaluation period. Configure this value in the Time Range for Calculated Averages module.</td>
</tr>
<tr>
<td></td>
<td>End time of the evaluation period. Configure this value in the Time Range for Calculated Averages module.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Calculated average duration per task (min)</td>
<td>Actual time required to perform this task manually.</td>
</tr>
<tr>
<td>Calculated average volume per month</td>
<td>Actual average number of times this task is performed manually per month.</td>
</tr>
</tbody>
</table>

3. Select one of these submission options:
   - **Submit**: Saves the record to the table without running any calculations.
   - **Submit and process now**: Saves the record and calculates the savings based on the hourly rate and the number of workflow contexts for this automation entry.

**Create an Orchestration ROI correlated task rule**

The correlated task rule applies configurable conditions to fields in a selected table that tell the instance which manual tasks correspond to an automation entry record.

**Before you begin**

Role required: orchestration_manager

Before starting this procedure, make sure you have created labor rate cards and the appropriate automation entry records for the automated tasks you want to evaluate.

**About this task**

Create conditions that the system can use to correlate manual tasks to the automation entry. For example, a rule on the Incident [incident] table uses these conditions to correlate the employee on-boarding task to values configured in the Employee OnBoarding automation entry record:

- **[Subcategory] [is] [Employee OnBoarding]**
- **[Sort description] [contains] [new employee]**

When a new employee opens an incident to request services or assets which are typically handled manually, Orchestration applies the usual labor rate for the manual work to the potential automated solution, and then computes the actual savings.
Procedure

1. Navigate to **Orchestration > ROI Task Correlation > Correlated Tasks Rules**.
2. Click **New**.
3. Fill in the fields on the form, as appropriate.

**Automation entry form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automation entry</td>
<td>Automation entry record that correlates to the manual task defined by these conditions. The entry record names the workflow used to automate the task and defines the labor rate used to calculate the cost of the task.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to filter, using these conditions. The rule selects records from this table that match the conditions. Information from these records is used to calculate the actual time to perform a manual task and the actual volume for that manual task.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition builder to use to filter records for this table. Use these conditions to identify all manual tasks correlated to this automation entry.</td>
</tr>
<tr>
<td>Read-only fields</td>
<td></td>
</tr>
<tr>
<td>Processed on</td>
<td>Date and time that the system performs the matching records lookup. The system automatically searches for new manual tasks matching these conditions.</td>
</tr>
</tbody>
</table>

4. Select one of these submission options:
   - **Submit**: Saves the record to the table without running any calculations.
   - **Submit and process now**: Saves the record, looks up all matching tasks, and saves matching record information to the Correlated Tasks [manual_mapping_records] table.

5. To view a rule, select the link in the **Table** column of the **Correlated Tasks Rules** related list for the automation entry you want to see.

6. To view the list of tasks that match all correlated rules in the system, navigate to **Orchestration > ROI Task Correlation > Correlated Tasks**.

7. To view the list of tasks that match this rule in the system, click **Correlated Tasks** under **Related Links** in this form.
Configure the time range for Orchestration ROI calculations

Select a date range to calculate the average number of tasks and the duration per month for the correlated tasks.

Before you begin
Role required: orchestration_manager

About this task
By default, the system creates a range ending at the current date and time and extending back over the previous month. You can change this range at any time and recalculate the ROI instantly.

Procedure
1. Navigate to Orchestration > ROI Task Correlation > Time Range for Calculated Averages.
2. Enter a new start or end date and time or click the icon to select a date using the calendar.
3. Click Calculate to recalculate the ROI based on the new time range and to save your settings.

Installed with Orchestration ROI
Several types of components are installed with the Orchestration - ROI plugin (com.snc.runbook_automation.roi).

Tables installed with Orchestration ROI
Tables are added with activation of Orchestration ROI.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense and Savings</td>
<td>Contains the data for the reports in Orchestration &gt; ROI Reports &gt; Predicted Savings.</td>
</tr>
<tr>
<td>[run_rate_predicted_savings]</td>
<td></td>
</tr>
<tr>
<td>Savings Report</td>
<td>Contains the number of automations that have been run before the date specified in the Processed On column, based on:</td>
</tr>
<tr>
<td>[savings_report]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Detailed Savings Report [detailed_savings_report]</td>
<td>Contains a detailed list for the Savings Report [savings_report] table. This list contains each automation’s run date and savings for that automation.</td>
</tr>
<tr>
<td>Automation Entries [automation_entry_form]</td>
<td>Contains automation entries that couple labor resources to specific manual tasks. You can specify the estimated duration to perform a task manually and the estimated number of times that a task is performed per month. If this automation entry already has workflow automations implemented, you can specify the associated workflows. The system calculates the savings, based on the labor rate card and the number of workflow automations that have been performed.</td>
</tr>
<tr>
<td>Roadmap Planning [roadmap_planning]</td>
<td>Contains roadmap planning for each automation entry to be implemented. You can provide estimated hours to implement a workflow automation, the automation percentage anticipated by the end of the year, and the starting month to implement the workflow.</td>
</tr>
<tr>
<td>Correlated Tasks [manual_mapping_records]</td>
<td>Contains all matching manual tasks for each automation entry. Each tasks’s information is stored in this table for the system to use to calculate the actual duration and volume for each manual task.</td>
</tr>
<tr>
<td>Correlated Tasks Rules [manual_mapping_conditions]</td>
<td>Contains the correlated task rules the system uses to look up manual tasks corresponding to each automation entry.</td>
</tr>
</tbody>
</table>
Plugins installed with Orchestration ROI

Plugins are installed with activation of Orchestration ROI, if they are not already active.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Management [com.snc.cost_management]</td>
<td>Provides the labor rate cards Orchestration ROI uses to determine the savings for each automated task. See for more information.</td>
</tr>
</tbody>
</table>

Roles installed with Orchestration ROI

Roles are added with activation of Orchestration ROI.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orchestration manager [orchestration_manager]</td>
<td>Manages all activities in the Orchestration ROI module.</td>
<td>• pa_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• report_admin</td>
</tr>
</tbody>
</table>

UI actions installed with Orchestration ROI

UI actions are added with activation of Orchestration ROI.

<table>
<thead>
<tr>
<th>UI actions for Orchestration - ROI</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI action</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>Savings Report</td>
</tr>
<tr>
<td>Estimated and Projected Savings</td>
</tr>
</tbody>
</table>
### UI actions for Orchestration - ROI (continued)

<table>
<thead>
<tr>
<th>UI action</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submit AND process now</td>
<td>Automation Entry Form [automation_entry_form]</td>
<td>Processes this new entry</td>
</tr>
<tr>
<td>Correlated Tasks</td>
<td>Correlated Tasks Rules [manual_mapping_conditions]</td>
<td>Displays all matching tasks from the Correlated Tasks [manual_mapping_records] table.</td>
</tr>
<tr>
<td>Detailed Savings Report</td>
<td>Automation Entry Form [automation_entry_form]</td>
<td>Displays the list of automations that have been run, based on associated workflows.</td>
</tr>
<tr>
<td>Task</td>
<td>Correlated Tasks [manual_mapping_records]</td>
<td>Displays the task record.</td>
</tr>
<tr>
<td>Submit AND process now</td>
<td>Correlated Tasks Rules [manual_mapping_conditions]</td>
<td>Processes a correlated task rule. This action performs matching on the specified table and the filter conditions.</td>
</tr>
</tbody>
</table>

### Script includes installed with Orchestration ROI

Script includes are added with activation of Orchestration ROI.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OrchestrationROIAjax</td>
<td>Script that calculates the actual duration and volume of a task.</td>
</tr>
<tr>
<td>OrchestrationROI</td>
<td>Script that calculates the number of workflow contexts, looks up all matching tasks, calculates savings, and other functions used in the UI actions.</td>
</tr>
<tr>
<td>ROIDemoDataUtil</td>
<td>Script that updates demo data timestamps.</td>
</tr>
</tbody>
</table>

### Client scripts installed with Orchestration ROI

Client scripts are added with activation of Orchestration ROI.
**Client script**

| Display info for processing rules | Correlated Tasks Rules [manual_mapping_conditions] | Displays annotation on the Correlated Task Rule form advising that new task rules are not evaluated until the time specified in the ROI schedule. |

---

**Business rules installed with Orchestration ROI**

Business rules are added with activation of Orchestration ROI.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete corresponding records</td>
<td>Automation Entry Form [automation_entry_form]</td>
<td>When a record is deleted from the Automation Entry Form [automation_entry_form] table, this business rule deletes all records in other ROI tables that reference this entry.</td>
</tr>
<tr>
<td>Insert into Run Rate &amp; Savings</td>
<td>Automation Entry Form [automation_entry_form]</td>
<td>When a new automation entry is provided, this business rule calculates the estimated savings, based on the estimated duration of a task and its associated labor rate card.</td>
</tr>
<tr>
<td>Insert into Savings Reports</td>
<td>Automation Entry Form [automation_entry_form]</td>
<td>When a new automation entry is provided, this business rule inserts a new record into the Savings Report [savings_report] table with the automations_run field set to 0.</td>
</tr>
</tbody>
</table>

---

**Orchestration ROI reports**

Orchestration ROI provides a collection of standard and premium reports to help you calculate savings from automating services in your organization.

The ROI standard reports are included with Orchestration ROI. The premium reports provide enhanced views generated with Performance Analytics and require the Orchestration - ROI Premium plugin.
Orchestration ROI standard reports
The dashboard of standard ROI reports provides summaries, estimated costs, and calculated costs for automated processes. To access the ROI standard dashboard, navigate to **Orchestration > ROI Reports > Dashboard**.

**Summary tab**
The Summary tab contains four reports on automation categories.

### ROI summary report sample

**Automation Savings by Category Over Time (Uses Estimated Duration)**

- **April 2015, Datacenter Automation = $11,227.50**
  (80.03%)

---

### Standard ROI summaries by category

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual Tasks by Category Over Time</td>
<td>Trend of manual tasks by category over time. For example, if you use automations to perform a portion of the necessary tasks, the report shows the number of tasks still executed manually, decreasing over time.</td>
</tr>
</tbody>
</table>
### Standard ROI summaries by category (continued)

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="#">Automations by Category Over Time</a></td>
<td>Trend of automated tasks by category over time. For example, this chart can show the increase in the number of automated tasks as a workflow automation rolls out slowly over time.</td>
</tr>
<tr>
<td><a href="#">Automation Savings by Category Over Time</a></td>
<td>Amount of savings from automated tasks over time, based on the estimated duration of the task, the number of automations performed, and the cost from the labor rate card.</td>
</tr>
<tr>
<td><a href="#">Automation Savings by Category Over Time</a></td>
<td>Amount of savings from automated tasks over time, based on the calculated duration of the task, the number of automations performed, and the cost from the labor rate card.</td>
</tr>
</tbody>
</table>

**Estimated Costs tab**

The Estimated Costs tab contains eight reports on estimated time and expense for automations.
### Standard ROI time and expense estimates

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Estimated Time Spent by Task Category</td>
<td>Total estimated time spent, in minutes, on all tasks by task category.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Pie chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Automation Entry Form [automation_entry_form]</td>
</tr>
<tr>
<td>Estimated Volume of Manual Tasks per Month by Category</td>
<td>Total estimated volume of all tasks per month by task category.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Pie chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Automation Entry Form [automation_entry_form]</td>
</tr>
<tr>
<td>Report</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Predicted Hours Spent Monthly by Category (Uses Estimated Duration & Volume) | Total predicted hours spent monthly on all manual tasks by category, using the estimated duration of each task and the estimated volume of each task per month.  
- **Type**: Bar chart  
- **Table**: Expense and Savings [run_rate_predicted_savings] |
| Predicted Monthly Expense by Category (Uses Estimated Duration & Volume) | Total predicted monthly expense for all manual tasks by category, using the estimated duration of each task, estimated volume of each task per month, and the cost from the labor rate card.  
- **Note**: This report uses negative numbers to express an expense.  
- **Type**: Bar chart  
- **Table**: Expense and Savings [run_rate_predicted_savings] |
| Predicted Hours Spent Quarterly by Category (Uses Estimated Duration & Volume) | Total predicted hours spent quarterly on all manual tasks by category, using the estimated duration of each task and the estimated volume of each task per month.  
- **Type**: Bar chart  
- **Table**: Expense and Savings [run_rate_predicted_savings] |
| Predicted Quarterly Expense by Category (Uses Estimated Duration & Volume) | Total predicted quarterly expense for all manual tasks by category, using the estimated duration of each task, estimated volume of each task per month, and the cost from the labor rate card.  
- **Note**: This report uses negative numbers to express an expense.  
- **Type**: Bar chart  
- **Table**: Expense and Savings [run_rate_predicted_savings] |
### Standard ROI time and expense estimates (continued)

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
</table>
| Predicted Hours Spent Annually by Category (Uses Estimated Duration & Volume) | Total predicted hours spent annually on all manual tasks by category, using the estimated duration of each task and the estimated volume of each task per month.  
- **Type:** Bar chart  
- **Table:** Expense and Savings [run_rate_predicted_savings] |
| Predicted Annual Expense by Category (Uses Estimated Duration & Volume) | Total predicted annual expense for all manual tasks by category, using the estimated duration of each task, estimated volume of each task per month, and the cost from the labor rate card.  
- **Note:** This report uses negative numbers to express an expense.  
- **Type:** Bar chart  
- **Table:** Expense and Savings [run_rate_predicted_savings] |

### Costs from Correlated Tasks tab
The Costs from Correlated Tasks tab contains eight reports on time and expense for automations based on actual calculations.
Standard ROI calculated time and expense of automations

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Spent by Task Category</td>
<td>Total actual time spent, in minutes, on all tasks by task category.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Pie chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Automation Entry Form [automation_entry_form]</td>
</tr>
<tr>
<td>Volume of Manual Tasks per Month by Category</td>
<td>Total actual volume of all tasks per month by task category.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Pie chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Automation Entry Form [automation_entry_form]</td>
</tr>
<tr>
<td>Report</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Projected Hours Spent Monthly by Category (Uses Calculated Duration & Volume) | Total projected hours spent monthly on all manual tasks by category, using the calculated duration of each task and the calculated volume of each task per month.  
• **Type**: Bar chart  
• **Table**: Expense and Savings  
[run_rate_predicted_savings]                                                                                                                                 |
| Projected Monthly Expense by Category (Uses Calculated Duration & Volume) | Total projected monthly expense for all manual tasks by category using the calculated duration of each task, the calculated volume of each task per month, and the cost from the labor rate card.  
**Note**: This report uses negative numbers to express an expense.  
• **Type**: Bar chart  
• **Table**: Expense and Savings  
[run_rate_predicted_savings]                                                                                                                                 |
| Projected Hours Spent Quarterly by Category (Uses Calculated Duration & Volume) | Total projected hours spent quarterly on all manual tasks by category, using the calculated duration of each task and the calculated volume of each task per month.  
• **Type**: Bar chart  
• **Table**: Expense and Savings  
[run_rate_predicted_savings]                                                                                                                                 |
| Projected Quarterly Expense by Category (Uses Calculated Duration & Volume) | Total projected quarterly expense for all manual tasks by category using the calculated duration of each task, the calculated volume of each task per month, and the cost from the labor rate card.  
**Note**: This report uses negative numbers to express an expense.  
• **Type**: Bar chart  
• **Table**: Expense and Savings  
[run_rate_predicted_savings]                                                                                                                                 |
Standard ROI calculated time and expense of automations (continued)

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Projected Hours Spent Annually by Category</td>
<td>Total projected hours spent annually on all manual tasks by category, using the calculated duration of each task and the calculated volume of each task per month.</td>
</tr>
<tr>
<td>(Uses Calculated Duration &amp; Volume)</td>
<td>• <strong>Type</strong>: Bar chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Expense and Savings [run_rate_predicted_savings]</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This report uses negative numbers to express an expense.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Expense and Savings [run_rate_predicted_savings]</td>
</tr>
<tr>
<td>Projected Annual Expense by Category</td>
<td>Total projected annual expense for all manual tasks by category using the calculated duration of each task, the calculated volume of each task per month, and the cost from the labor rate card.</td>
</tr>
<tr>
<td>(Uses Calculated Duration &amp; Volume)</td>
<td></td>
</tr>
</tbody>
</table>

Schedule Orchestration ROI calculations for standard reports

The scheduled job that calculates Orchestration ROI standard reports is active by default and controlled by system properties.

**Before you begin**

Role required: orchestration_manager, admin

**About this task**

The system provides a default scheduled job called Processing ROI Schedule that allows you to configure when Orchestration calculates the ROI for standard reports. This schedule allows scripting for advanced conditions. To modify the schedule or write a script to run, open Processing ROI Schedule from System Scheduler > Scheduled Jobs > Scheduled Jobs and click **Configure Job Definition**. To execute the schedule directly from the job definition, click **Execute Now**

To control the running of the schedule job with the Orchestration properties.
Procedure

1. Navigate to **Orchestration ROI > Properties**.
2. Configure the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>roi.processing.active</td>
<td>Activate scheduled job for ROI processing. This property activates the Processing ROI Schedule scheduled job.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default</strong>: true</td>
</tr>
<tr>
<td>roi.processing.interval</td>
<td>Scheduled ROI processing interval (hours). This property sets the repeat interval for the scheduled job that processes savings reports and correlated tasks.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default</strong>: 24</td>
</tr>
</tbody>
</table>

3. Click **Save** to save your changes.

**Orchestration ROI premium reports**

The premium dashboard provides detailed reports on calculated savings over time.

The ROI premium reports require the Orchestration - ROI Premium plugin and are built using **Performance Analytics**. The Orchestration - ROI Premium plugin is dependent on the **Performance Analytics - Premium** plugin which requires a separate subscription.

**Important:** You must activate the Performance Analytics scheduled collection job before Orchestration ROI premium can display data.

To access the ROI premium dashboard, navigate to **Orchestration > ROI Reports > Premium Dashboard**.
**ROI By Category tab**

The ROI By Category tab contains three reports showing the calculated savings over time by category.

### Calculated savings monthly by category

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ROI - Monthly By Category</strong></td>
<td>Shows the calculated savings each month by category. The chart displays the total calculated savings against the calculated savings for each category.</td>
</tr>
<tr>
<td>Type</td>
<td>Column chart</td>
</tr>
<tr>
<td>Table</td>
<td>Detailed Savings Report [detailed_savings_report]</td>
</tr>
</tbody>
</table>

### Premium reports for calculated savings over time by category

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ROI - By Category</strong></td>
<td>Shows the trend of calculated savings by category.</td>
</tr>
<tr>
<td>Type</td>
<td>Spline chart</td>
</tr>
<tr>
<td>Table</td>
<td>Detailed Savings Report [detailed_savings_report]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ROI - Running Sum 12 month period</strong></td>
<td>Shows the running sum of calculated savings for all categories in the last 12 months.</td>
</tr>
<tr>
<td>Type</td>
<td>Area chart</td>
</tr>
<tr>
<td>Table</td>
<td>Detailed Savings Report [detailed_savings_report]</td>
</tr>
</tbody>
</table>

**ROI By Automation Entry**

The ROI By Automation Entry tab contains two reports showing the calculated savings over time by automation entry.
Calculated savings for the current month by automation entry

Calculated savings over time by automation entry

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROI By Automation Entry</td>
<td>Shows the current month’s calculated savings for each automation entry.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Column</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Detailed Savings Report [detailed_savings_report]</td>
</tr>
<tr>
<td>ROI - By Automation Entry Top 10 List</td>
<td>Shows the top 10 automation entries that have the most calculated savings in the current month.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Scorecard</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Detailed Savings Report [detailed_savings_report]</td>
</tr>
</tbody>
</table>

Request Orchestration ROI premium reports

To view the Orchestration ROI premium reports, you must request activation of the Orchestration - ROI Premium (com.snc.runbook_automation.roi_premium) plugin. The Orchestration - ROI Premium plugin is included with an Orchestration subscription, but must be activated by request.

Before you begin
The Orchestration - ROI Premium plugin requires the Performance Analytics - Premium plugin, which must be purchased separately.

Role required: admin
Procedure

1. Navigate to **System Applications > All Available Applications > All.**

2. On the All Applications page, click **Request Plugin** to open the Request form on HI.

3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. On the form, fill in the fields.

**Activate Plugin request form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>
Schedule Orchestration ROI calculations for premium reports

Orchestration ROI premium reports use a Performance Analytics job that must be activated before premium reports can be generated.

**Before you begin**
Role required: orchestration_manager, admin

**About this task**
The scheduled job required to calculate premium ROI reports is called [PA ROI] Historic Data Collection and is installed with the Orchestration - ROI Premium [com.snc.runbook_automation.roi_premium] plugin. This job is not active by default.

**Procedure**
1. Navigate to **Performance Analytics > Data Collector > Jobs**.
2. Search for the [PA ROI] Historic Data Collection job.
3. Select the **Active** check box.
4. The scheduling options appear for the value selected in the **Run** field.
   
   For instructions on creating a schedule, see [ Link].
5. To execute the schedule directly from the job definition, click **Execute Now**.
6. Click **Update**.

### Client Software Distribution

The Client Software Distribution (CSD) application allows administrators to distribute software from the service catalog using third-party management systems.

CSD allows an administrator to create all the records necessary to deploy software from service catalog requests, including software models and catalog items. You can use the CSD application to automate the deployment and revocation of software from an SCCM host using the custom SCCM activity pack. You can define lease periods for software distributed from the Service Catalog and allow lease extensions in some cases, pending approvals. Deployment is accomplished using Orchestration activities and workflows.

CSD also integrates with Software Asset Management to manage license counts for deployed software.

#### CSD process flow using SCCM

![CSD process flow using SCCM](image)

#### Request client software distribution

Client software distribution requires the Orchestration - Client Software Distribution plugin (com.snc.orchestration.client_sf_distribution), which is available by request with a subscription to Orchestration.

**Before you begin**
Role required: admin

**About this task**
The Orchestration - Client Software Distribution plugin activates the Orchestration - System Center Configuration Manager plugin that contains
the custom SCCM activities used to deploy or revoke software using an SCCM server. For additional plugin dependencies, see Plugins installed with client software distribution.

Note: The Orchestration - Client Software Distribution plugin runs in its own application scope.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the <strong>Reason/Comments</strong> field.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Installed with client software distribution**

Several types of components are installed with client software distribution (CSD).

**Tables installed with client software distribution**

These tables are installed with the Orchestration - Client Software Distribution plugin (com.snc.orchestration.client_sf_distribution).

**Client software distribution tables**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client Software Distribution Catalog Item [sn_client_sf_dist_cat_item]</td>
<td>Contains all catalog items created for client software distribution. This table extends the Catalog Item [sc_cat_item] table.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Client Software Distribution Software Request</td>
<td>Contains all requested software, and their statuses.</td>
</tr>
<tr>
<td>Request [sn_client_sf_dist_req_software]</td>
<td></td>
</tr>
<tr>
<td>Client Software Distribution Application</td>
<td>Contains all discovered CSD applications.</td>
</tr>
<tr>
<td>Application [sn_client_sf_dist_application]</td>
<td></td>
</tr>
<tr>
<td>Client Software Distribution Provider</td>
<td>Contains all software distribution providers.</td>
</tr>
<tr>
<td>Provider [sn_client_sf_dist_provider]</td>
<td></td>
</tr>
<tr>
<td>Client Software Distribution Extension Key</td>
<td>Contains the predefined CSD extension keys.</td>
</tr>
<tr>
<td>Extension Key [sn_client_sf_dist_extension_key]</td>
<td></td>
</tr>
<tr>
<td>Client Software Distribution Extension Point</td>
<td>Contains the customization script for the extension keys.</td>
</tr>
<tr>
<td>Extension Point [sn_client_sf_dist_extension_point]</td>
<td></td>
</tr>
<tr>
<td>Client Software Distribution Software Configuration</td>
<td>Base table for all software provider configurations.</td>
</tr>
<tr>
<td>Software Configuration [sn_client_sf_dist_software_config]</td>
<td></td>
</tr>
<tr>
<td>SCCM Server Instance [sn_client_sf_dist_cmdb_ci_sccm_server]</td>
<td>Contains all SCCM server instances. This table extends the Configuration Item [cmdb_ci] table.</td>
</tr>
<tr>
<td>SCCM Application [sn_client_sf_dist_sccm_application]</td>
<td>Contains all discovered SCCM applications. This table extends the Client Software Distribution Application [sn_client_sf_dist_application] table.</td>
</tr>
<tr>
<td>SCCM Application Catalog Item</td>
<td>Contains all catalog items created for SCCM applications. This table extends the Client Software Distribution Catalog Item [sn_client_sf_dist_cat_item] table.</td>
</tr>
<tr>
<td>[sn_client_sf_dist_sccm_app_cat_item]</td>
<td></td>
</tr>
<tr>
<td>SCCM Collection [sn_client_sf_dist_sccm_collection]</td>
<td>Contains all discovered SCCM collections.</td>
</tr>
<tr>
<td>SCCM Deployment [sn_client_sf_dist_sccm_deployment]</td>
<td>Contains all discovered SCCM deployments.</td>
</tr>
<tr>
<td>SCCM Configuration [sn_client_sf_dist_sccm_config]</td>
<td>Contains the SCCM application, install and uninstall collections,</td>
</tr>
</tbody>
</table>
Client software distribution tables (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>and Discovery model. This table extends the Client Software Distribution Software Configuration [sn_client_sf_dist_software_config]</td>
</tr>
</tbody>
</table>

Plugins installed with client software distribution

These plugins are installed with the Orchestration - Client Software Distribution plugin, if they are not already active.

For instructions on requesting activation of Client Software Distribution (CSD) see Request client software distribution.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orchestration - System Center Configuration Manager [com.snc.orchestration.sccm_mgnt]</td>
<td>Installs the custom SCCM Orchestration activities that do work on the SCCM target host.</td>
</tr>
<tr>
<td>Orchestration - Asset Lease Management [com.snc.orchestration.asset_lease_management]</td>
<td>Installs the lease functionality for software distributed through the Service Catalog. This includes starting, stopping, and extending leases.</td>
</tr>
<tr>
<td>Service Catalog Scoped API [com.glideapp.servicecatalogScoped.api]</td>
<td>Installs the API to support application creation in the Service Catalog.</td>
</tr>
<tr>
<td>Software Asset Management [com.snc.software_asset_management]</td>
<td>Provides the ability to manage software assets, including the reconciliation of entitlements to licenses for named users, workstation, and enterprise software agreements.</td>
</tr>
</tbody>
</table>
Roles installed with client software distribution
These roles are installed with the Orchestration - Client Software Distribution plugin.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client software distribution admin</td>
<td>Administrator role for managing client software distribution application.</td>
<td>• sam</td>
</tr>
<tr>
<td>[sn_client_sf_dist.csd_admin]</td>
<td></td>
<td>• agent_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• report_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• catalog_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• itil</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• workflow_admin</td>
</tr>
</tbody>
</table>

Script includes installed with client software distribution
These script includes are installed with the Orchestration - Client Software Distribution plugin.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSDExtensionPoint</td>
<td>Execute the CSD provider's specific code</td>
</tr>
<tr>
<td>CSDUtil</td>
<td>Utility functions for the CSD application.</td>
</tr>
<tr>
<td>RefQualsCSD</td>
<td>Reference qualifier filter. This script provides the filter functions for</td>
</tr>
<tr>
<td></td>
<td>the CSD providers, devices, SCCM application, install collections, and</td>
</tr>
<tr>
<td></td>
<td>uninstall collections.</td>
</tr>
<tr>
<td>SCCMCatttemHandler</td>
<td>Sets the field values of specific SCCM catalog items. These values are the</td>
</tr>
<tr>
<td></td>
<td>SCCM catalog item table name, catalog item name, SCCM provider, and SCCM</td>
</tr>
<tr>
<td></td>
<td>software configuration.</td>
</tr>
<tr>
<td>SoftwareCatttemCreator</td>
<td>Creates software catalog items</td>
</tr>
<tr>
<td>CSDCatttemHandler</td>
<td>Base class for CSD catalog item creation. This script is used by the Create</td>
</tr>
<tr>
<td></td>
<td>Catalog Item UI action to create and application catalog.</td>
</tr>
</tbody>
</table>
Script includes for Orchestration - Client Software Distribution (continued)

<table>
<thead>
<tr>
<th>Script Include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSDDemoDataUtil</td>
<td>Populates demo data.</td>
</tr>
<tr>
<td>CSDDemoDataUtilAjax</td>
<td>Populates demo data.</td>
</tr>
</tbody>
</table>

Properties installed with client software distribution

Properties for client software distribution (CSD) manage the installation status of requested software deployments and configure scheduled Discoveries.

To access CSD properties, navigate to **Client Software Distribution > Properties**. The following properties are available:

**Client software distribution properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status check expiration interval (days)</td>
<td>sn_client_sf_dist.softwareInstallExpDays</td>
<td>Controls how many days the system waits before ignoring the software installation status. The default time limit for installing software is 30 days before the system stops checking the installation status of a deployment. Installation statuses are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Not installed:</strong> User has not installed requested software prior to the expiration of the configured time limit.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Installed:</strong> Software was installed within...</td>
</tr>
</tbody>
</table>
### Client software distribution properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>the configured time limit.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Status check expired</strong>: Time limit has expired for the user to install the requested software. The system no longer checks the status of this deployment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Revoked</strong>: Software was revoked by the administrator.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Default value</strong>: 30</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reconcile software installation status interval (hours)</th>
<th>sn_client_sf_dist.softwareInstallIntervalHour</th>
<th>Determines when the scheduled job runs that determines the installation status. By default, the system checks the installation status every hour.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Type</strong>: integer</td>
<td><strong>Default value</strong>: 24</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Set scheduled application Discovery interval (days)</th>
<th>sn_client_sf_dist.discoveryExeDay</th>
<th>Sets the repeat interval for the scheduled job that runs application Discovery. By default, Discovery runs at midnight on the day set with this value.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Type</strong>: integer</td>
<td><strong>Default value</strong>: 5</td>
</tr>
</tbody>
</table>
### Client software distribution properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set lease execution schedule job interval (minutes)</td>
<td>sn_client_sf_dist.lease_execution_interval</td>
<td>Interval in which the CSD Lease Schedule scheduled job checks for requested software leases to start, stop, or extend.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Default value:</strong> 1</td>
</tr>
<tr>
<td>Set time prior to lease end to notify requester (days)</td>
<td>sn_client_sf_dist.lease_end_notification</td>
<td>Determines how many days prior to the end of a software lease to notify the requester. If lease extensions are allowed, ensure that this period provides enough time for the approval process to complete before the lease expires.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Default value:</strong> 5</td>
</tr>
</tbody>
</table>

### Workflows installed with client software distribution

These workflows are installed with the Orchestration - Client Software Distribution plugin

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discover SCCM</td>
<td>Retrieves lists of applications, collections, and deployments from SCCM servers using custom CSD orchestration activities. An administrator runs this workflow from a UI action in a <strong>SCCM Server Instance record.</strong></td>
</tr>
</tbody>
</table>
### Workflows installed with client software distribution (continued)

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order Client Software</td>
<td>Runs automatically when a user orders software from the service catalog.</td>
</tr>
<tr>
<td>Deploy SCCM Application</td>
<td>Triggered by the Order Client Software workflow to deploy software through SCCM server. This workflow adds either the user or the device into the SCCM collection.</td>
</tr>
<tr>
<td>Revoke Client Software</td>
<td>Begins the software revocation process for software deployed by an external provider. Administrators run this workflow from a UI action on the Requested Software record and the Installed Software Not Entitled record. This workflow triggers the appropriate provider workflow that performs the actual revocation. For example, this workflow triggers the Revoke SCCM Application workflow for applications in SCCM uninstall collections.</td>
</tr>
<tr>
<td>Revoke SCCM Application</td>
<td>Revokes SCCM applications that are members of an uninstall collection. The Revoke Client Software workflow triggers this workflow to revoke software deployed by an SCCM server. This workflow moves either the user or the device from the SCCM collection into the appropriate uninstall collection.</td>
</tr>
</tbody>
</table>

### Related information

- Using extension points to extend application functionality
- Using scripted extension points in server-side scripts
- Using UI extension points in server-side UI macros
- Using client extension points in client-side UI scripting

### Create licenses and counters for distributed software

Licenses and software counters are associated with the software model and must be created if you want to track the license for software deployed by client software distribution (CSD).

**Before you begin**

Role required: sam or admin

You can create software licenses and counters in Software Asset Management for software items deployed from the service catalog by CSD. CSD depends on the software counter result to determine if the license is available for the
requested software. If the license Valuation is greater than 0, and the license type is Not allocated, CSD assumes that the license is available for the software.

Procedure
1. Navigate to Software Asset > Software Licenses.
2. Add a new software license for the software model you used in CSD.
3. Navigate to Software Asset > Reconciliation > Software Counters.
4. Create a software counter for the software model you created.
5. Run the counter to retrieve the software license information.

Client software distribution ordering process
Software deployed by Client Software Distribution (CSD) can be ordered from the service catalog by individual users or by approved users on behalf of others.

Client Software Distribution catalog items have different options, depending on how ordering is configured.

Lease start and end dates
All software deployed by CSD requires users to specify the beginning date for the lease. This is enforced by the Orchestration - Asset Lease Management plugin that is activated automatically with CSD. The system prepopulates the Lease start field with the current date and time.

If the catalog item is configured for revocation (uninstall), the form displays the Lease end field, which allows the requester to define an end date and time for the lease. The system validates user input in these fields to ensure that the dates selected define a future window. The Lease end field is not mandatory and can be left blank to order software with no end date.

Note: For systems deploying software from Microsoft System Center Configuration Management (SCCM), the Lease end field is only available if the SCCM configuration specifies an uninstall collection.

Software offered only to the logged in user
If the software catalog item is configured with the Order on behalf of check box cleared, the User field does not appear on the order form. The logged in user selects the device on which to deploy the software from the Device to install this software on field. Only those devices assigned to the logged in user appear in the list.
In this example, a user has logged into the service catalog to order Firefox for a computer that is assigned to her. She selects the machine from a list of devices she owns and selects the date and time the lease should begin. This software is deployed through Microsoft System Center Configuration Management (SCCM), but does not have an uninstall collection configured and cannot be revoked automatically by the system. As a result, the Lease end field is not available.

Software ordered on behalf of another user

If the software catalog item is configured with the Order on behalf of check box selected, the User field appears on the form. The logged in user can select any user from this field. The Device to install this software on field only lists the devices assigned to the user selected in the User field. If an approval is required for software ordered on behalf of another user, the system automatically sends an approval request to the manager of the user receiving the software. The approval is skipped if the requester is the named user's manager.

In this example, a manager is ordering Google Chrome for a contractor. The manager selects the contractor from the User field and then chooses a computer from the list of devices assigned to the contractor. This software has an SCCM uninstall collection configured, which allows the manager to select an end date for the lease that coincides with the end of the user's contract. When the lease expires, SCCM automatically uninstalls the software from the device.
Defining software lease window

Extend a software lease

Users of software deployed by Client Software Distribution (CSD) can request the extension of a lease window, if the software is revocable by a software distribution system.

Before you begin
Role required: Any system user

About this task
If your software has a lease end date defined, and the software status is Installed, you can request an extension of the lease, pending any approvals your organization requires.

Procedure
1. Navigate to Service Catalog > My Requested Software.
   The list shows only the software you have requested from the service catalog.
2. Select the record for the installed software whose lease you want to extend.
3. Under Related Links click Extend Lease.
4. In the dialog box that appears, select a new lease end date in the calendar and click OK. You must select a date later than the current date.

If the lease extension is subject to manager approval, you are notified of the decision. If the request is approved, a notification shows the new lease end date. If the new end date is within 5 days (the default notification period) of the date when you made the request, CSD sends an immediate end-of-lease notification.

**Important:** If lease extensions in your organization require approval, make sure the approver is available and has enough time to process your extension request. If the extension cannot be approved before the original end date expires, the software is revoked.

**Client software distribution from SCCM**

You can use Client Software Distribution (CSD) to deploy and revoke software deployments from Microsoft System Center Configuration Management (SCCM) and manage distributions on SCCM hosts.

The SCCM activity pack contains Orchestration activities that CSD uses to deploy software from a service catalog request and manage user and device collections on SCCM servers. In addition, CSD can manage license counts for deployed software using ServiceNow Software Asset Management, revoke
software deployed by SCCM without user interaction, and manage lease periods.

**Configuring SCCM**

Follow the SCCM configuration procedures in the order shown.

**Configure the Application Administrator role on the SCCM server**

To deploy software using ServiceNow® Client Software Distribution (CSD), ensure that an SCCM administrative user has the correct permissions to deploy software and that PowerShell is properly configured.

**Before you begin**

SCCM role required: Application Administrator

**About this task**

These instructions are for Microsoft 2012 R2 Server.

**Procedure**

1. In the System Center Configuration Manager console, navigate to Administration > Security > Administrative Users.
2. Right-click the user to whom you want to grant the Application Administrator role.
3. Select Properties from the drop-down menu.
4. In the Properties dialog box, select the Security Roles tab.
5. Ensure that the user has the Application Administrator role.
6. If the user does not already have this role, click Add, select this role from the list, and click OK.
7. Log into SCCM as the user with the Application Administrator role.

8. Open the menu from the upper left corner of the console and select **Connect via Windows PowerShell.**
9. Ensure that the user can access the CM console. This action establishes the environment path to PowerShell for the logged in Application Administrator user.

**Update the SCCM cmdlet libraries**

Ensure that the System Center Configuration Manager SCCM Cmdlet Library is up-to-date.

**Before you begin**

SCCM role required: Either current user or system administrator, depending on settings.

**About this task**

The System Center Configuration Manager SCCM Cmdlet Library installs and updates the Windows PowerShell module for SCCM. SCCM checks for library updates on a daily basis. Out-of-date libraries can cause Discovery of the SCCM server to fail, because the system cannot parse the SCCM activity output. This warning message appears in the ECC queue input records for the SCCM GET activities:

```
WARNING: An update to the System Center 2012 Configuration Manager Cmdlet Library is available. Please go to 'http://go.microsoft.com/fwlink/?LinkId=528947' to download the latest version.
Running cmdlet version: 5.0.8231.1004 Latest cmdlet version: 5.0.8328.1155
```

If you elect to use an earlier version library, use this procedure to disable the CM update check, which allows Discovery to proceed without issues.

**Procedure**

1. Log into the SCCM console as an administrator.
2. Open the menu from the upper left corner of the console.
3. Select **Connect via Windows PowerShell**.
4. Run one of these commands to disable the update check:
   - **Per-user**: `Set-CMCmdletUpdateCheck -CurrentUser -IsUpdateCheckEnabled 0`
   - **Per-system**: `Set-CMCmdletUpdateCheck -System -IsUpdateCheckEnabled 0`

   **Important**: The per-system cmdlet must run in an elevated Windows PowerShell session.

5. Run the `Get-CMCmdletUpdateCheck` command to refresh the console and check the settings.
6. Ensure that the value of the *isEnabled* configuration variable has changed to **False**.
   This indicates that the warning for an out of date cmdlet library is disabled for the users specified.
7. To re-enable the update check, run the `-IsUpdateCheckEnabled 1` command for either the current user or for the system.

**Configure the MID Server for SCCM activities**

To use a MID Server with Microsoft System Center Configuration Management (SCCM) activities, configure it to communicate with the SCCM server.

**Before you begin**

Role required: admin

**Procedure**

1. In the navigation filter, enter `cmdb_ci_dns_name.list`.
2. Click **New**.
3. Enter the fully-qualified domain name (FQDN) of the SCCM server in the **Name** field.
4. Right-click in the form header and select **Save**.
5. In the **IP Address** related list, click **New**.
6. In the **IP Address** field, enter the IP address of the SCCM server.
7. In the **Nic** field, select **eth0** or your preferred network interface controller.
8. Leave the **Netmask** field blank.
9. Click **Submit**.

**Create Windows credentials for SCCM deployments**

Microsoft System Center Configuration Manager (SCCM) requires the appropriate credentials to deploy applications using the Client Software Distribution application.

**Before you begin**
Role required: sn_client_sf_dist.csd_admin or admin

**About this task**
Client software distribution requires Windows credentials that have administrative rights on the SCCM server.

**Procedure**
1. Navigate to **Orchestration > Credentials**.
2. Click **New**.
3. In the list of credential types, select **Windows Credentials**.
4. Provide a user name and password with administrative rights on the SCCM server.

**Important:** Ensure the following:

- This user must have the Application Administrator role on the SCCM server.
- Use the credentials to log into the SCCM Server and connect via Windows PowerShell from the System Center Configuration Manager console at least once to set the path variable for that credential.

5. Fill in the other fields on the form, as appropriate.
   For details, see **Windows credentials**.
6. Click **Submit**.
Retrieve SCCM data for client software distribution

Retrieve the collections and the list of applications available for deployment from your SCCM servers.

Before you begin

Role required: sn_client_sf_dist.csd_admin or admin

Before starting this procedure:

- Set up your Microsoft System Center Configuration Manager (SCCM) server, create the applications and collections, and configure the deployments you need. For information, see your SCCM documentation.
- Configure a user with the Application Deployment Manager role on the SCCM server.
- Set up the MID Server to communicate with the SCCM server.
- Add Powershell credentials to the ServiceNow Credentials [discovery_credentials] table for the SCCM user who has the Application Deployment Manager role.

About this task

To populate the Client Software Distribution application with SCCM data:

Procedure

1. Navigate to Client Software Distribution > SCCM > SCCM Server Instance.
2. Click New.
3. In the SCCM Server Instance form, identify the server by name and provide the fully qualified domain name.
4. Click Submit.

   The new SCCM server appears in the list.
5. Open the new SCCM record and click Discover now under Related links.
The system runs the Discover SCCM workflow that retrieves the application, collection, and deployment data from the SCCM server.

### Retrieving SCCM data with Discovery

<table>
<thead>
<tr>
<th>SCCM Server Instance</th>
<th>SCCM Server</th>
<th>Name</th>
<th>SCCM Server</th>
<th>Fully qualified domain name</th>
<th>win2008-sccm.autotab.service-now.com</th>
</tr>
</thead>
</table>

### SCCM server Discovery for client software distribution

A Discovery workflow populates ServiceNow tables with collection, application, and deployment data retrieved from SCCM servers.

Users run the **Discover SCCM** workflow from an **SCCM Server Instance record** to populate the following ServiceNow tables:

### SCCM data populated in ServiceNow tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Fields</th>
</tr>
</thead>
</table>
| SCCM Application [sn_client_sf_dist_sccm_application] | • name  
• publisher  
• version  
• model  
• sccm_server |
| SCCM Collection [sn_client_sf_dist_sccm_collection] | • name  
• type  
• sccm_server |
| SCCM Deployment [sn_client_sf_dist_sccm_deployment] | • application  
• collection  
• type |
Note: For details about the custom activities used in this workflow to extract data from an SCCM server, see Orchestration SCCM activity pack.

Set up a software model for an SCCM application

Using the applications discovered on the SCCM server, set up a software model used by the Software Asset Management application to manage licenses.

Before you begin
Role required: sn_client_sf_dist.csd_admin or admin
Before creating software models, you must discover the applications available for deployment on the SCCM server. See Retrieve SCCM data for client software distribution for details.

About this task
You can link an SCCM application to an existing software model or create a new model.

Procedure

1. Navigate to Client Software Distribution > SCCM > SCCM Applications. A list of applications discovered on the SCCM server appears.
2. Open an SCCM application record.
3. To link to an existing model, click the magnifying glass icon in the Model field and select a model from the list.

4. To create a model, click Create Software Model under Related Links.
   
   a. Complete the software model fields.
      See for details.

   b. Click Submit.
      The view returns to the SCCM Applications form.
Define an SCCM configuration

To create catalog items for SCCM software deployment or to configure your instance to revoke software through SCCM, you must first associate that software with a collection through an SCCM configuration.

Before you begin

Before you create an SCCM configuration record, make sure you have discovered the SCCM applications, collections, and deployments and set up the necessary software models.

Role required: sn_client_sf_dist.csd_admin or admin

About this task

The SCCM configuration process associates software with SCCM collections. To deploy software from an SCCM server, the user or device must be a member of an SCCM collection associated with an install deployment. Client Software Distribution (CSD) allows you to revoke unentitled software using an SCCM server when that software can be removed using an uninstall collection. Users requesting revokable software from the Service Catalog also have the ability to define lease start and stop dates and request lease extensions.

SCCM table references
Procedure

1. Navigate to **Client Software Distribution > SCCM > SCCM Applications**.
2. Open an application that has a configured software model.
3. Under **Related Links**, click **Create Software Configuration**.
4. Complete the form, using the fields in the table.

### SCCM configuration form

- **Name**: Dropbox
- **SCCM application**: Dropbox
- **SCCM collection**: Dropbox
- **SCCM uninstall collection**: Dropbox
- **Discovery model**: Dropbox, Dropbox, Dropbox, 3.0

### SCCM configuration fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Recognizable name for this SCCM software configuration.</td>
</tr>
<tr>
<td>SCCM application</td>
<td>Name of an application hosted on the SCCM server.</td>
</tr>
<tr>
<td>SCCM collection</td>
<td>Name of the collection associated with the <strong>install</strong> deployment for the selected application on the SCCM server. Only those collections associated with the application are available for selection.</td>
</tr>
<tr>
<td>SCCM uninstall collection</td>
<td>Name of the collection associated with the <strong>uninstall</strong> deployment for the selected application on the SCCM server. You must specify an uninstall collection to:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• Define a lease end date for deployed software.</td>
</tr>
<tr>
<td></td>
<td>• Allow lease extensions.</td>
</tr>
<tr>
<td></td>
<td>• Revoke software from a user's machine.</td>
</tr>
<tr>
<td>Discovery model</td>
<td>Discovery model that links the unentitled software installation with the SCCM configuration. From the SCCM configuration record, Client Software Distribution can determine which collection to use to revoke the software. Unentitled software is software found on the user's machine that the user is not entitled to use.</td>
</tr>
</tbody>
</table>

Create a catalog item for an SCCM application

Using the applications discovered on the SCCM server, create a catalog item for an application you want to offer for distribution from the service catalog.

Before you begin
Role required: sn_client_sf_dist.csd_admin or admin
Before creating a catalog item, you must link the application to a software model and create at least one software configuration.

Procedure

1. Navigate to Client Software Distribution > SCCM > SCCM Applications. A list of applications discovered on the SCCM server appears.

2. Open a record for an SCCM application.

4. Add price information and complete the following fields added to the Client Software Distribution Catalog Item [sn_client_sf_dist_cat_item] table by the Orchestration - Client Software Distribution plugin:

**SCCM fields in the catalog item form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skip approval (skip_approval)</td>
<td>Check box that allows skipping approval for this item by the requester's manager when a user orders it from the service catalog. Use this field in conjunction with the <strong>Order on behalf of</strong> field to ensure that software ordered by a logged in user on behalf of another user is subject to approval. By default, this check box is cleared, requiring manager approval for all new catalog items.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>There are two levels of approval possible. By default, all category items require group approval for items in excess of $1000. If that approval is given or skipped, the system evaluates the <strong>Skip approval</strong> check box to determine if the software item requires approval by the requester's manager.</td>
</tr>
<tr>
<td>Check license compliance</td>
<td>Check box that forces the system to determine if deploying this item is allowed under the current license.</td>
</tr>
</tbody>
</table>
| Order on behalf of                         | Check box that allows the logged-in user to order this software from the service catalog for another user. This permits service desk personnel to order SCCM deployments for other users in the system. By default, this feature is enabled. To prevent unauthorized users from ordering software, ensure that approvals are required for this type of deployment by clearing the **Skip approval** check box. If an approval is required for software ordered on behalf of a user, the system automatically sends an approval request to the manager of the user receiving the software. The approval is skipped if the requestor is the named user's manager. Software items requested from the service catalog on behalf of a different user require the following information:  
  - **User**: User selected for deployment. This field is automatically populated with the name of the logged in user. You can select another user from the list.  
  - **Device to install this software on**: Device belonging to the selected user on which to deploy the software. Only devices belonging to that user appear in the choice list. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Lease start</strong></td>
<td>Date and time to deploy the software. This is the start time for the lease. A lease can be open-ended or have a lease end time.</td>
</tr>
<tr>
<td>SCCM configuration</td>
<td>Name of the SCCM configuration record for this application. This record defines the collection and uninstall collection for this application. This configuration is required for all deployments, revocations, and leases performed by the SCCM server.</td>
</tr>
</tbody>
</table>

5. If the catalog item requires approval because of cost, be sure to configure an approval group in the **Approved By Group** related list. By default, the Service Catalog Request workflow runs when an item costing more than $1000 is ordered and looks for an appropriate approval group. If no approval group is configured for the item, this workflow skips approval altogether and ends. The system then runs the Order Client Software workflow, which evaluates the **Skip approval** check box to determine if approval by the requester's manager is required.

6. Click **Update**. The view returns to the SCCM Applications list.

7. To see all client software distribution (CSD) catalog items, navigate to **Client Software Distribution > Maintain Items > Software Items**.

**SCCM deployment**

Ordering an SCCM application from a client software distribution (CSD) catalog item in the service catalog triggers the Order Client Software workflow.

This process deploys an SCCM application to a user or device through a service catalog order:

1. If the **Skip approval** check box is cleared in the software catalog item, the Order Client Software workflow sends the catalog request to the requesting user's manager for approval.

2. If the **Check license compliance** check box is selected in the software catalog item, the workflow performs a software license check. If there is no license available, the workflow creates a catalog task to procure more licenses and assigns the task to the Client Software Distribution Administrators group.
3. The Order Client Software workflow triggers the Deploy SCCM Application workflow as a subflow. This workflow adds either the user or the device to the SCCM collection using the Add to User Collection or Add to Device Collection SCCM activity.

4. If the software configuration specifies **SCCM uninstall collection** in the software catalog item, the Deploy SCCM Application workflow checks if the user or device exists in the uninstall collection. The workflow uses the **Is Device in Collection** or **Is User in Collection** SCCM activity. If the user or device exists in the uninstall collection, the workflow removes the device or user. The workflow uses the **Remove from Device Collection** or **Remove from User Collection** SCCM activity before adding it to the **SCCM install collection**.

**Client software distribution validation process**

After SCCM deploys software to a target computer, client software distribution (CSD) detects the installation and validates its status.

Client software distribution uses the following methods for detecting software installed on the target machine:

- **Discovery**: CSD is configured to leverage Discovery to detect software installations. You can run Discovery manually at any time, or by a scheduled job.

- **Microsoft SCCM Integration**: You can import SCCM data into the CMDB using the features in the Integration - Microsoft SCCM plugin if Discovery is not active on the instance.

The instance uses the data gathered by Discovery or the SCCM integration plugin to populate the Software Installation [cmdb_sam_sw_install] table. To validate installations using this data, CSD runs a scheduled job called Reconcile Requested Software that uses CSD property settings. This process reconciles the software installation data accumulated in the CMDB and makes these status updates:

- **Not installed** to **Installed**: The user has installed the requested software within the time limit configured in the **sn_client_sf_dist.softwareInstallExpDays** property.

- **Not installed** to **Status check expired**: The time limit has expired for the user to install the requested software. The system stops checking for installation when the time limit expires.

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
SCCM software revocation

An administrator can revoke software without any user interaction using Microsoft System Center Configuration Manager (SCCM) if the software configuration specifies an SCCM uninstall collection, even if the software was installed by some other process or user.

Revoke software deployed through the service catalog

Software deployed by SCCM can be revoked, but only when the software’s status is **Installed** and the application associated with the software configuration has an uninstall collection configured.

**Before you begin**

- Create an **SCCM configuration record** for the application that names an appropriate uninstall collection.
- Associate the **CSD catalog item** for the application with the SCCM configuration that specifies the uninstall collection.

Role required: sn_client_sf_dist.csd_admin or admin

A workflow called **Revoke SCCM Application** moves either the user or the device from its respective collection and adds it to the appropriate uninstall collection. When SCCM performs an internal policy check and finds the user or device in the uninstall collection, SCCM removes the related software package from the client computer.

**Procedure**

1. Navigate to **Client Software Distribution > Reports > Requested Software**.
2. Open the record for the SCCM software package you want to revoke. The package must have a **Status** of **Installed** to be revocable.
3. Under **Related Links**, click **Revoke software**.

   This action runs the Revoke Client Software workflow, which triggers the Revoke SCCM Application subflow that moves the user or device from the install collection to the uninstall collection. When SCCM performs an internal policy check and finds the user or device in the uninstall collection, SCCM removes the related software package from the client computer.
**Revoke unentitled software**

An administrator can revoke software using Microsoft System Center Configuration Manager (SCCM) that a user is not entitled to use even if the software was installed by some other process or user.

**Before you begin**

To revoke software using SCCM, you must create an **SCCM configuration record** for the application, in which the appropriate software Discovery model is defined. See **Software discovery models**.

Role required: sn_client_sf_dist.csd_admin or admin

Client Software Distribution (CSD) uses **Software Asset Management** to identify unentitled software installations. Discovery detects the software on the user’s machine, and SAM determines if the user or device is entitled to use that software. This might include software that was not installed through a catalog request or software that the user installed without approval. If the software installation's Discovery model is associated with an SCCM software configuration that has an uninstall collection defined, then an administrator can use CSD to revoke that software from the user's machine without involving the user.

**Procedure**

1. Navigate to **Client Software Distribution > Reports > Installed Software Not Entitled**.
2. Select the record for the installation that has unentitled users.
3. Under **Related Links**, click **Revoke software**.

   This action runs the Revoke Client Software workflow, which triggers the Revoke SCCM Application subflow that moves the user or device from the install collection to the uninstall collection. When SCCM performs an internal
policy check and finds the user or device in the uninstall collection, SCCM removes the related software package from the client computer.

### Revoking a software installation

![Software installation image]

**SCCM software revocation workflow**

The Revoke SCCM Application workflow moves a user or device from an install collection to an uninstall collection to revoke software installed from Microsoft System Center Configuration Manager (SCCM).

For the revocation workflow to run, the software package must have a status of *Installed* and must be pre-configured for an appropriate uninstall collection. See [Revoke software deployed through the service catalog](#) for configuration instructions. When an administrator initiates the revocation process, the system launches the Revoke SCCM Application workflow to move the user or device collection associated with installation to the appropriate SCCM uninstall collection. When the SCCM server performs a policy check, it finds the additions to the user or device uninstall collection and revokes the software package associated with that collection.

The workflow employs two custom activities, **Remove from User Collection** and **Remove from Device Collection**, to remove either the user or the device from its original collection. The workflow then adds the user or device to the appropriate uninstall collection on the SCCM server with the **Add to User Collection** or **Add to Device Collection** activity.

**Note:** This workflow is triggered by the Revoke Client Software workflow as a subflow.
Client software distribution dashboard

The CSD dashboard provides a collection of visual reports for the Client Software Distribution application.

CSD dashboard

To access the CSD dashboard, navigate to Client Software Distribution > Requested Software > Dashboard.

Sample report from CSD dashboard

![Sample report from CSD dashboard](image)

Client software distribution reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Tasks</td>
<td>Displays all open tasks grouped by the requested item's stage value.</td>
</tr>
<tr>
<td></td>
<td>• Type: List reports</td>
</tr>
<tr>
<td></td>
<td>• Table: Catalog Task [sc_task]</td>
</tr>
<tr>
<td>Top 10 Applications Installed</td>
<td>Displays the top 10 applications installed by request count.</td>
</tr>
<tr>
<td></td>
<td>• Type: Bar chart</td>
</tr>
<tr>
<td></td>
<td>• Table: Requested Software [sn_client_sf_dist_req_software]</td>
</tr>
<tr>
<td>Total Software Request Item Over Time</td>
<td>Displays the total software items requested each month.</td>
</tr>
<tr>
<td></td>
<td>• Type: Line chart</td>
</tr>
<tr>
<td></td>
<td>• Table: Requested Software [sn_client_sf_dist_req_software]</td>
</tr>
</tbody>
</table>
### Client software distribution reports (continued)

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requests Completed Report</td>
<td>Displays the total of software requests completed each month.</td>
</tr>
<tr>
<td></td>
<td><strong>Type</strong>: Line chart</td>
</tr>
<tr>
<td></td>
<td><strong>Table</strong>: Requested Software [sn_client_sf_dist_req_software]</td>
</tr>
<tr>
<td>Installed Software Not Entitled</td>
<td>Displays installed software that users or devices are not entitled to use. This can be software deployed through CSD or by another process that does not comply with licensing. This report is on a Software Asset Management table.</td>
</tr>
<tr>
<td></td>
<td><strong>Type</strong>: List reports</td>
</tr>
<tr>
<td></td>
<td><strong>Table</strong>: Software Installation [cmdb_sam_sw_install]</td>
</tr>
<tr>
<td>Software Installation Status</td>
<td>Displays the count of requested software, grouped by installation status, for each month.</td>
</tr>
<tr>
<td></td>
<td><strong>Type</strong>: Line chart</td>
</tr>
<tr>
<td></td>
<td><strong>Table</strong>: Requested Software [sn_client_sf_dist_req_software]</td>
</tr>
<tr>
<td>Software Requested Item Stage</td>
<td>Displays the sum of all requested items, grouped by the requested item’s stage, for each month.</td>
</tr>
<tr>
<td>Report</td>
<td><strong>Type</strong>: Line chart</td>
</tr>
<tr>
<td></td>
<td><strong>Table</strong>: Requested Software [sn_client_sf_dist_req_software]</td>
</tr>
<tr>
<td>License Counts Available</td>
<td>Displays the license counts for all available applications.</td>
</tr>
<tr>
<td></td>
<td><strong>Type</strong>: List reports</td>
</tr>
<tr>
<td></td>
<td><strong>Table</strong>: SCCM Application Catalog Item [sn_client_sf_dist_sccm_app_cat_item]</td>
</tr>
</tbody>
</table>

### Usage Overview dashboard

Navigate to **Client Software Distribution > Usage Overview** to view the current transaction count for your instance.

### Client software distribution extension framework

Client software distribution (CSD) provides built-in extension points for integrating a ServiceNow instance with client software distribution providers, such as Casper, Altiris, or LANDesk.
CAUTION: The use of CSD extension points is an advanced procedure intended for use by experienced Now Platform developers only. Instructions for customizing your instance to deploy and revoke software from a software distribution provider can be found in the CSD Extension Implementation Guide.

Configure client software distribution providers

Identify the provider and specify the workflows and extension points for a customized software distribution process.

Before you begin

Perform the development tasks described in the CSD Extension Implementation Guide before attempting this procedure.

Role required: sn_client_sf_dist.csd_admin, admin

Procedure

1. Navigate to Client Software Distribution > Extensions > Providers.
2. Click New.
3. Complete the form using the fields in the table.

Client software distribution provider fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name of the provider.</td>
</tr>
<tr>
<td>Provider server table</td>
<td>Table name of the provider server. You must create this table as an extension of the Configuration Item [cmdb_ci] table. For example, you might call your table Casper Server Instance [cmdb_ci_casper_server_instance].</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Discovery flow</td>
<td>Flow that discovers the provider server and returns the data from that server back to the instance. This is the flow you create with custom activities that query the provider server.</td>
</tr>
<tr>
<td>Software configuration table</td>
<td>Table name of the software configuration for this provider. You create this table as an extension of the Client Software Distribution Software Configuration [sn_client_sf_dist_software_config] table. For example, you might create a table called Casper Software Configuration [sn_client_sf_dist_casper_sf_config].</td>
</tr>
<tr>
<td>Deployment extension key</td>
<td>The SetDeploymentData key provided with CSD. This key sets up the data for the software ordering and deployment workflow.</td>
</tr>
<tr>
<td>Deployment flow</td>
<td>Flow that deploys software from the provider server. This is the flow you created with custom activities that tells the provider where to deploy an application requested from the service catalog.</td>
</tr>
<tr>
<td>Revocation extension key</td>
<td>The SetRevocationData key provided with CSD. This key sets up the data for installation revocation.</td>
</tr>
<tr>
<td>Revocation flow</td>
<td>Flow that revokes an installation from a provider server. This is the flow you created with custom activities that tells the provider which application to remove from a device.</td>
</tr>
<tr>
<td>Use Flow</td>
<td>Option to use IntegrationHub flows for client software distribution. When this option isn’t selected,</td>
</tr>
</tbody>
</table>
Orchestration workflows are used for client software distribution.

**Note:**

---

### Client software distribution extension keys

Client software distribution (CSD) extension keys allow you to customize the deployment and revocation of software from distribution providers.

These pre-defined keys allow you to generate input variables for workflows that deploy and revoke software from external distribution providers:

- **SetDeploymentData**: Sets the software order information and generates the input variables for the deployment workflow.
- **SetRevocationData**: Generates the input variables for the revocation workflow.
- **CheckRevocable**: Specifies the conditions that determine if an installation can be revoked. If the software configuration associated with the installed software allows uninstallation, the installed software can be revoked.

---

### Client software distribution extension points

The client software distribution (CSD) extension points create the customization code for the specific provider and the extension keys.

The purpose of the extension points is to associate extension keys with a specific provider, and then create a script that sets input variables for your custom deployment and revocation workflows. Another extension point script tells CSD if the provider has the capability to revoke software. If this is the case, CSD enables the UI action that triggers revocation from the provider.

#### SetDeploymentData

The script associated with this extension key must set the `csdExtensionResult` object with these attributes:

- **deploymentWorkflowInputs**: Object that specifies the deployment workflow input variables.
- **softwareModel**: Software model sys_id.
- **deploymentType**: An integer. Use 1 for deployment to a user and 2 for deployment to a device.
- **softwareApplication**: Software application sys_id.
**CheckRevocable**

The script associated with this extension key gets the input parameter `csdExtensionInputs.softwareConfiguration`, which is a Client Software Distribution record in the Software Configuration `sn_client_sf_dist_software_config` table. All providers' software configurations are extended from this table, but may have different attributes.

This script must set the `csdExtensionResult` object to true or false, depending on whether the software configuration specifies uninstallation.

**SetRevocationData**

The script associated with this extension key gets the input parameter `csdExtensionInputs.softwareConfiguration`, which is a Client Software Distribution record in the Software Configuration `sn_client_sf_dist_software_config` table. All providers' software configurations are extended from this table, but may have different attributes.

The script must set the `csdExtensionResult` object with these attributes:

- **revocationWorkflowInput**: Object that specifies the revocation workflow input variables.
- **softwareModel**: Software model sys_id.
- **deploymentType**: An integer. Use 1 for deployment to a user and 2 for deployment to a device.

**Related information**

- Using extension points to extend application functionality
- Using scripted extension points in server-side scripts
- Using UI extension points in server-side UI macros
- Using client extension points in client-side UI scripting

**Orchestration examples**

These examples demonstrate how Orchestration can be used to automate common tasks.

**Active Directory automation example**

A set of six Orchestration Active Directory activities enables organizations to automate their on-boarding/off-boarding processes with auditable, self-documenting workflows that save time and eliminate mistakes.
The activities in the Active Directory activity pack are designed to manage user accounts and reset user passwords. The following activities cover the most common use cases administrators encounter when managing Active Directory user accounts:

- Create AD User Account
- Update AD User Account
- Remove AD User Account
- Disable AD User Account
- Query AD
- Reset AD User Password.

These activities share a common design, have complementary functionality, and share a common set of parameters. They can be used singly or together to create consistent workflows for provisioning and de-provisioning user accounts.

Update Active Directory with Orchestration

An organization plans to make their ServiceNow instance the single system of record for user account data and wants to update Active Directory with the latest changes.

About this task

The solution is to create an Orchestration workflow that pushes changes from the ServiceNow user record down to the Active Directory to create a new user record or update an existing record. This is accomplished by creating an Orchestration workflow that can create and update records in Active Directory based on the data in the ServiceNow User [sys_user] table.

Note: This example workflow assumes that ServiceNow is configured for LDAP and an LDAP server is configured to accept the new user accounts. The Active Directory user management activities are not dependent on LDAP, but the presence of LDAP makes this example workflow much easier. You must provide the domain controller’s IP address to the workflow, either by hardcoding it, adding another workflow input, or using a script to look it up from the CMDB.

Procedure

1. Navigate to Workflow > Workflow Editor.
2. In the Workflow tab, click the + icon to create a new workflow using these variables:
3. Click **Submit**.
   A basic workflow with a Begin and End point appears on the canvas.

4. Click the menu icon in the upper left corner of the canvas and select **Edit Inputs** from the context menu.

5. In the Workflow Inputs form, click **New** in the **Variables** record list, and create a new variable, using the fields in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Reference</td>
</tr>
<tr>
<td>Label</td>
<td>User</td>
</tr>
<tr>
<td>Column name</td>
<td>u_user</td>
</tr>
<tr>
<td>Reference Specification &gt; Reference</td>
<td>User (sys_user)</td>
</tr>
</tbody>
</table>
6. Click **Submit**.

7. In the **Custom** tab, expand **Custom Activities > Active Directory**.

8. Drag and drop the Update AD Object activity onto the transition line between the Begin and End points of the new workflow.

   This action automatically links the activity with the end point and opens the Workflow Activity property form.

9. Complete the form using the fields in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a logical name such as <strong>Update user data</strong>.</td>
</tr>
<tr>
<td>Domain controller</td>
<td>The ServiceNow LDAP integration adds a reference to the LDAP server to which the user's account is linked. To identify the LDAP server, enter the following statement:</td>
</tr>
<tr>
<td></td>
<td>${workflow.inputs.u_user.ldap_server.server_url}</td>
</tr>
<tr>
<td>Type</td>
<td>Type of AD object. In this case, the type is <strong>User</strong>, which is the default.</td>
</tr>
<tr>
<td>Object name</td>
<td>This example assumes that the ServiceNow user name matches the Active Directory sAMAccountName. Enter the following:</td>
</tr>
<tr>
<td></td>
<td>${workflow.inputs.u_user.user_name}</td>
</tr>
<tr>
<td>Object data</td>
<td>Updates the user's account in Active Directory, if the user exists. In this example, the user's title is updated:</td>
</tr>
<tr>
<td></td>
<td>{&quot;title&quot;: &quot;QA&quot;}</td>
</tr>
</tbody>
</table>

10. Click **Submit**.

    The workflow looks like this:

    ![Workflow diagram](image-url)
11. Attach both activity outcomes (Success and Failure) to the end point. At this point, the workflow takes a ServiceNow user record as input and updates the First Name, Last Name, and Title of the corresponding Active Directory account. If the account does not exist in Active Directory, the workflow fails.

**Note:** In a normal workflow, some type of alternate action is desirable upon failure. For example, you might send an email notification if the workflow failed to update the record.

12. To prevent the workflow from failing, add a Create AD Object activity to the transition lines between Begin and the Update AD Object activity.

13. Complete the Workflow Activity property form using the fields in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a logical name such as <strong>Create user data.</strong></td>
</tr>
</tbody>
</table>
| Domain controller | Same as for the update activity.  
|                 | `${workflow.inputs.u_user.ldap_server.server_url}`                   |
| Ou             | The organizational unit to which this object belongs. For the purpose of this example, you can enter **OU=HQ,OU=Managed Objects** |
| Object name    | Same as for the update activity.  
|                 | `${workflow.inputs.u_user.user_name}`                                 |
| Object data    | Creates an account with only the user name in it. For the purpose of this example, you can enter  
|                 | "${workflow.inputs.u_user.first_name}", "SN" :  
|                 | "${workflow.inputs.u_user.last_name}"                                 |

14. Click **Submit**.

15. Connect the Failure outcome of the Create AD Object activity to End. For this example, we are ignoring errors. The workflow now looks like this:
Creating an AD user

This procedure builds a simple workflow that creates a bare-bones Active Directory account consisting of a user name only. The workflow then updates that account with additional information provided by the ServiceNow User [sys_user] table. However, we do not want to execute the Create AD Object activity if the user account already exists. The workflow needs to query Active Directory for matching user records and then branch the workflow based on the results of the query. If an account already exists, then the workflow should update the account. If the account does not exist, then the workflow should create the account in Active Directory.

16. Drag and drop the Query AD activity onto the transition between Begin and Create AD Object.

17. Complete the Workflow Activity property form using the fields in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a logical name such as Search for existing account.</td>
</tr>
<tr>
<td>Domain</td>
<td>controller ${workflow.inputs.u_user.ldap_server.server_url}</td>
</tr>
<tr>
<td>Properties</td>
<td>A comma-separated list of Active Directory properties to return. For example, givenName, SN, title. If the parameter field is blank, then all properties are returned. In this workflow, we leave the field blank.</td>
</tr>
</tbody>
</table>
| Search filter | An LDAP filter string that defines the search parameters. Use any valid LDAP filtering criteria. To find user accounts matching the input record, we use:  
  (samaccountname=${workflow.inputs.u_user.user_name}) |

18. Click Submit.

19. Connect the Failure outcome for the query activity to the End point. Remember that we are ignoring errors in this workflow.
20. Connect the Success outcome of the query activity to the Update AD Object activity.
   The workflow now looks like this:

   **Querying AD for user accounts**

   The Query AD activity returns its results as a JSON string in the workflow data bus. This JSON string is always an array of objects. Each object corresponds to an Active Directory entry that matched the query. Our workflow should branch, whether that array is empty or not.

21. Drag a standard If activity from the Conditions folder in the Core tab and drop it onto the transition between Query AD and Update AD Object.

22. Complete the Workflow Activity properties form using the fields in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a logical name such as <strong>Account exists</strong>.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to open the Script field.</td>
</tr>
</tbody>
</table>
| Script  | For the If activity to work correctly, we must return a **yes** or **no** in the answer variable (var) which corresponds to the Yes and No outcomes of the query activity. Line 1 converts the Query AD results from a JSON string into a Javascript array called `queryResults`. Line 2 checks the length of that array. If the array is more than 0, a match to the account was found, and we set our answer to yes. Otherwise, the answer is no.  
   
   ```javascript
   var queryResults=new JSON().decode(data.get(5).output);
   answer = ( queryResults.length>0 ? 'yes' : 'no' );
   ```

   **Note:** The expression `data.get(5)` in this script identifies the Query AD output in the Databus by order number, since it was the fifth activity added to the workflow.
23. Click **Submit**.

24. In the canvas, create a transition from the Yes outcome of the If activity to the Update AD Object activity.

25. Create a transition from the No outcome of the If activity to the Create AD Object activity.

This is the final step. This workflow will query Active Directory to determine if an account already exists. If an account exists, the workflow updates that account. If an account does not exist, the workflow creates the account and then updates the Active Directory with the configured user data set.

Creating the conditional paths

Orchestration activity packs

The base Orchestration system includes packs of custom activities you can use to automate typical IT and business processes in your network.

Activity packs allow you to automate several common business processes, such as managing Active Directory accounts and Exchange server mailboxes. Activity packs can also automate IT functions such as starting and stopping Windows servers, joining domains, assigning IP addresses, and configuring load balancers.
Use an activity pack

The **Packs** tab of the Workflow Editor contains any activity packs downloaded from the ServiceNow Store and any activity packs that you create.

**Before you begin**
**Roles required**: admin, activity_admin, activity_creator

**About this task**
You can organize custom activities into packs and upload them to the ServiceNow Store. Your custom packs do not appear in the tree until at least one activity in the pack is published. Activities added to an existing pack are not displayed until they are published. Activity packs from any application scope can appear in the **Packs** tab, regardless of the current scope setting for the instance.

**Procedure**
1. In the Workflow Editor palette, select the **Packs** tab.
2. Click the download icon.

   The hierarchy in the tab organizes packs by vendor, scope, category, and activity.

![Download packs](image)
Active Directory activity pack

The Active Directory (AD) activity pack enables an administrator to create, delete, and manage objects in Windows Active Directory, such as users, groups, and computers, using a ServiceNow Orchestration workflow.

Activities in this pack can reset a password automatically from a user request or manage any user account in Active Directory, whether or not it was created by an Orchestration workflow.

Domain controllers are identified by the IP address of the host machine. To use the hostname of the domain controller, add the Resolve DNS Name activity to resolve the hostname into an IP, and then pass the IP into the Active Directory activity.

Your instance must have access to a MID Server configured to use PowerShell to run these activities.

Note: All Active Directory activities pass through error messages returned from Active Directory. To view these error messages, point to the failed activity in the workflow canvas or select the Workflow Log tab in a Workflow Context record.

Custom Active Directory activities

Orchestration provides custom Active Directory activities that were created with the Orchestration Create a PowerShell activity, starting with the Geneva release. These activities perform the same functions as AD activities by the same name from previous releases and replace those activities for all new workflows. Existing workflows from earlier versions that were created with legacy AD activities continue to function normally after an upgrade to Istanbul. However, all new workflows must use these custom AD activities. The Powershell activity template gives workflow administrators the ability to store input and output variables from the Query AD activity in the Databus.

Note: To use the Active Directory custom activities, you must request activation of the Orchestration - Active Directory plugin.

Active Directory credentials with LDAP

If you are using an LDAP Server with MID Servers, note that Orchestration and Active Directory activities do not use the user name and password configured on LDAP Servers. You must create a Windows type orchestration credential record. The username and password in the credentials record is used for LDAP queries that Orchestration and workflow activities perform.
Connection port used by AD Orchestration activities
All Active Directory activities use port 389 for LDAP access. If you are using AD activities with Oracle Virtual Directory (OVD) as a proxy, set up pass-through on port 389 only.

Add User to Group AD activity
The Add User to Group activity adds a user to a group in Windows Active Directory.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

Input variables

<table>
<thead>
<tr>
<th>Add User to Group input variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable</td>
</tr>
<tr>
<td>DomainController</td>
</tr>
<tr>
<td>UserName</td>
</tr>
<tr>
<td>GroupName</td>
</tr>
</tbody>
</table>

Output variables

<table>
<thead>
<tr>
<th>Add User to Group output variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable</td>
</tr>
<tr>
<td>result</td>
</tr>
<tr>
<td>errorMessage</td>
</tr>
</tbody>
</table>
Conditions

Add User to Group conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>User was successfully added to group.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to add the user to the group. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

Change AD User Password activity

The Change AD User Password activity changes the password for an Active Directory user account.

This activity requires the user's current password to run, unlike the Reset AD User Password activity. If the new password violates any Active Directory password requirements, such as length or character combinations, the activity fails and returns the appropriate error message. This error message appears in the ECC queue and in hint text when a user points to the activity in the Workflow Editor.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

Note: This activity replaces an AD activity by the same name available in prior releases. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul. However, all new workflows must use the custom version of this activity, which was built with the PowerShell activity designer.

Input variables

Change AD User Password input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>User</td>
<td>The sAMAccountName of the Active Directory user account.</td>
</tr>
<tr>
<td>New_password</td>
<td>The new password to assign this user.</td>
</tr>
<tr>
<td>Old_password</td>
<td>The user's current password.</td>
</tr>
</tbody>
</table>
Output variables

Change AD User Password output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>One of the following outcomes:</td>
</tr>
<tr>
<td></td>
<td>• failure</td>
</tr>
<tr>
<td></td>
<td>• success</td>
</tr>
<tr>
<td></td>
<td>• Policy Failure</td>
</tr>
<tr>
<td></td>
<td>• Incorrect old password</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources.</td>
</tr>
<tr>
<td>hresult</td>
<td>Powershell command result.</td>
</tr>
</tbody>
</table>

Conditions
The activity provides the following conditions:

Change AD User Password conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Password successfully reset.</td>
</tr>
<tr>
<td>Policy Failure</td>
<td>Password does not comply with the organization's Active Directory requirements.</td>
</tr>
<tr>
<td>Incorrect old password</td>
<td>Password being changed was not entered correctly.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to change the password. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

Active Directory credentials with LDAP
If you are using an LDAP Server with MID Servers, note that Orchestration and Active Directory activities do not use the user name and password configured on LDAP Servers. You must create a Windows type orchestration credential record. The username and password in the credentials record is used for LDAP queries that Orchestration and workflow activities perform.
Create AD Object activity

The Create AD Object activity creates an object in Windows Active Directory.

This activity fails if it finds an existing object with matching input variables.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

⚠️ Note: This activity replaces an AD activity by the same name available in prior releases. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul. However, all new workflows must use the custom version of this activity, which was built with the PowerShell activity designer.

Input variables

Create AD Object input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>Type</td>
<td>The object type to create: user, group, or computer.</td>
</tr>
<tr>
<td>OU</td>
<td>The organizational unit to which this object belongs.</td>
</tr>
<tr>
<td>ObjectName</td>
<td>The sAMAccountName of the Active Directory object.</td>
</tr>
<tr>
<td>ObjectData</td>
<td>A JSON object containing Active Directory property names and their corresponding values. For example:</td>
</tr>
</tbody>
</table>

```json
{
  "givenName" : "John",
  "SN" : "Doe",
  "title" : "Sr. Account Specialist",
  "allowLogin" : true
}
```

This example sets the first name (givenName), last name (SN), and title on the Active Directory user account and allows that user to log in (allowLogin). This field allows...
Create AD Object input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>expression</td>
<td>evaluation via the ${} variable substitution syntax.</td>
</tr>
</tbody>
</table>

Output variables

Create AD Object output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources.</td>
</tr>
</tbody>
</table>

Conditions

Create AD Object conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>A Windows Active Directory object was created successfully.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to create the AD object. Additional</td>
</tr>
<tr>
<td></td>
<td>details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

Disable AD User Account activity

The Disable AD User Account activity disables a Windows Active Directory user account, making it inactive.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

Note: This activity replaces an AD activity by the same name available in prior releases. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul. However, all new workflows must use the custom version of this activity, which was built with the PowerShell activity designer.
Input variables

Disable AD User Account input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>User</td>
<td>The sAMAccountName of the Active Directory user account.</td>
</tr>
</tbody>
</table>

Output variables

Disable AD User Account output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either <strong>success</strong> or <strong>failure</strong>.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources.</td>
</tr>
</tbody>
</table>

Conditions

Disable AD User Account conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>AD user account was successfully disabled.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to disable the account. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

Enable AD User Account activity

The Enable AD User Account activity enables a Windows Active Directory user account, making it active.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Active Directory**.

**Note:** This activity replaces an AD activity by the same name available in prior releases. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul. However, all new workflows must use the custom version of this activity, which was built with the PowerShell activity designer.
**Input variables**

**Enable AD User Account input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>The sAMAccountName of the Active Directory user account.</td>
</tr>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
</tbody>
</table>

**Output variables**

**Enable AD User Account output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either <strong>success</strong> or <strong>failure</strong>.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources.</td>
</tr>
</tbody>
</table>

**Conditions**

**Enable AD User Account conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>AD user account was successfully enabled.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to enable the AD user account. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

**Is AD Account Locked activity**

The Is AD Account Locked activity determines whether an Active Directory user account is locked.

An account may be locked automatically if a user enters an incorrect password more times than allowed by the Active Directory security policy. You can unlock an account using the Unlock AD User Account activity.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Active Directory**.
Note: This activity replaces an AD activity by the same name available in prior releases. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul. However, all new workflows must use the custom version of this activity, which was built with the PowerShell activity designer.

Input variables

Is AD Account Locked input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>User</td>
<td>The sAMAccountName of the Active Directory user account.</td>
</tr>
</tbody>
</table>

Output variables

Is AD Account Locked output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources.</td>
</tr>
<tr>
<td>output</td>
<td>The query result.</td>
</tr>
</tbody>
</table>

Conditions

Is AD Account Locked conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locked</td>
<td>The AD account is locked.</td>
</tr>
<tr>
<td>Unlocked</td>
<td>The AD account is unlocked.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while processing the query. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>
Query AD activity

The Query AD activity retrieves entries from the Windows Active Directory based on an LDAP search filter and stores the results as a JSON string that can be used in the data bus.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory > .

Note: This activity replaces an AD activity by the same name available in releases prior to Geneva. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul and will continue to save query results to the scratchpad. However, all new workflows must use the custom version of this activity. This activity was built with the Create a PowerShell activity, which stores input and output variables in the databus instead of the scratchpad.

Input variables

Query AD input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>Properties</td>
<td>A comma-separated list of Active Directory properties to return. For example, givenName, SN, title. If this field is blank, then all properties are returned.</td>
</tr>
<tr>
<td>SearchFilter</td>
<td>An LDAP filter string that defines the search parameters. Use any valid LDAP filtering criteria. For example, to find user accounts matching the ServiceNow input record, use: (samaccountname=${workflow.inputs.u_user.user_name})</td>
</tr>
</tbody>
</table>

Output variables

Query AD output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources.</td>
</tr>
<tr>
<td>output</td>
<td>The query result.</td>
</tr>
</tbody>
</table>
Conditions

Query AD conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The query completed as expected.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while processing the query. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

Remove AD Object activity

The Remove AD Object activity deletes an object from Windows Active Directory.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Active Directory**.

⚠️ **Note:** This activity replaces an AD activity by the same name available in prior releases. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul. However, all new workflows must use the custom version of this activity, which was built with the **PowerShell activity designer**.

Input variables

Remove AD Object input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>ObjectName</td>
<td>The sAMAccountName of the Active Directory object.</td>
</tr>
<tr>
<td>Type</td>
<td>The object type to remove:</td>
</tr>
<tr>
<td></td>
<td>• user</td>
</tr>
<tr>
<td></td>
<td>• group</td>
</tr>
<tr>
<td></td>
<td>• computer</td>
</tr>
</tbody>
</table>
Output variables

Remove AD Object output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either <strong>success</strong> or <strong>failure</strong>.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources.</td>
</tr>
</tbody>
</table>

Conditions

Remove AD Object conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>AD object was successfully removed.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to remove the AD object. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

Remove User from Group AD activity

The Remove User from Group activity removes a user from a group in Windows Active Directory.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Active Directory**.

Input variables

Remove User from Group input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>UserName</td>
<td>Name of the user to remove from the group.</td>
</tr>
<tr>
<td>GroupName</td>
<td>Name of the group from which this user is removed.</td>
</tr>
</tbody>
</table>
Output variables

Remove User from Group output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either <strong>success</strong> or <strong>failure</strong>.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources.</td>
</tr>
</tbody>
</table>

Conditions

Remove User from Group conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>User was successfully removed from the group.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to remove the user from the group.</td>
</tr>
</tbody>
</table>

Reset AD User Password activity

The Reset AD User Password activity resets the password of a user account in Windows Active Directory.

If the new password violates any Active Directory password requirements, such as length or character combinations, the reset activity fails and returns the appropriate error message. This error appears in the ECC Queue and when you point to the activity in the Workflow Editor.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Active Directory**.

ℹ️ Note: This activity replaces an AD activity by the same name available in prior releases. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul. However, all new workflows must use the custom version of this activity, which was built with the PowerShell activity designer.
Input variables

Reset AD User Password input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>User</td>
<td>The sAMAccountName of the Active Directory user account.</td>
</tr>
<tr>
<td>Password</td>
<td>The new password for the user. This password must comply with the organization's Active Directory requirements.</td>
</tr>
<tr>
<td>ForceChange</td>
<td>Makes this password temporary by forcing the user to change it at the next login.</td>
</tr>
<tr>
<td>Unlock</td>
<td>Unlock the account if the account is locked.</td>
</tr>
</tbody>
</table>

Output variables

Reset AD User Password output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>One of the following outcomes:</td>
</tr>
<tr>
<td></td>
<td>• failure</td>
</tr>
<tr>
<td></td>
<td>• success</td>
</tr>
<tr>
<td></td>
<td>• Policy Failure</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources.</td>
</tr>
<tr>
<td>hresult</td>
<td>Powershell command result.</td>
</tr>
</tbody>
</table>

Conditions

Reset AD User Password conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Password was successfully reset.</td>
</tr>
<tr>
<td>Policy Failure</td>
<td>New password does not comply with the organization's Active Directory requirements.</td>
</tr>
</tbody>
</table>
Reset AD User Password conditions (continued)

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to reset the password. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

Unlock AD Account activity

The Unlock AD Account activity unlocks a locked Active Directory user account.

You can use the Is AD Account Locked activity activity to determine if an account is locked.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

⚠️ Note: This activity replaces an AD activity by the same name available in prior releases. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul. However, all new workflows must use the custom version of this activity, which was built with the PowerShell activity designer.

Input variables

Unlock AD Account input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>User</td>
<td>The sAMAccountName of the Active Directory user account.</td>
</tr>
</tbody>
</table>

Output variables

Unlock AD Account output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources.</td>
</tr>
</tbody>
</table>
Conditions

Unlock AD Account conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The account was successfully unlocked.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to unlock the account. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

Update AD Object activity

The Update AD Object activity updates an object in Windows Active Directory.

This activity only replaces existing values with new values. It cannot add new values to AD records such as adding a new group member to an AD group. For complex AD operations, use the Run PowerShell activity instead. The activity fails if it cannot find an existing account with matching object name and data.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

Note: This activity replaces an AD activity by the same name available in prior releases. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul. However, all new workflows must use the custom version of this activity, which was built with the PowerShell activity designer.

Input variables

Update AD Object input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>ObjectName</td>
<td>The sAMAccountName of the Active Directory object.</td>
</tr>
<tr>
<td>ObjectData</td>
<td>A JSON object containing Active Directory properties and their values. For example, to set the first name, last name, and title of a user, clear the user's manager, and set the VIP flag to true, the Object Data specifies:</td>
</tr>
</tbody>
</table>

```json
{ "givenName" : "John", "SN" : "Doe", "title" : "Sr. Account Specialist", "manager" : null, "msTSAllowLogon" : false }
```
Update AD Object input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The object type to update: user, group, or computer.</td>
</tr>
</tbody>
</table>

Output variables

Update AD Object output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either <strong>success</strong> or <strong>failure</strong>.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources.</td>
</tr>
</tbody>
</table>

Conditions

Update AD Object conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>AD object was successfully updated.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to update an AD object. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

Azure AD activity pack

The Azure AD activity pack enables an administrator to automate employee onboarding and offboarding functions on Azure AD and manage Office 365 licensing.

Use the Azure AD activities to add and remove users to Azure Active Directory, manage security group membership, and assign or remove Office 365 licenses for individual users.

The Azure AD activities were created with the Orchestration REST Web Service activity template.

Add User to Group Azure AD activity

The Add User to Group activity adds a user to an existing security group in Azure Active Directory.
To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Azure AD**. This activity was built with the **REST** web service activity template.

⚠️ **Important:** The REST message used for this activity must be configured to use OAuth2 authentication.

### Input variables

**Add User to Group input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user_id</td>
<td>Object ID (GUID) of the member to be added.</td>
</tr>
<tr>
<td>group_id</td>
<td>Object ID (GUID) of the target group.</td>
</tr>
</tbody>
</table>

### Output variables

**Add User to Group output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Returns the error string from the REST message. If there are no errors, this variable returns a null value.</td>
</tr>
<tr>
<td>body</td>
<td>Contains a string value representing the output from the REST message.</td>
</tr>
<tr>
<td>status_code</td>
<td>Contains the status code returned from the Web service.</td>
</tr>
</tbody>
</table>

### Conditions

**Add User to Group conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully added the object ID to the security group.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to update the group's membership, or the activity failed to connect to Azure AD.</td>
</tr>
</tbody>
</table>
Assign User License Azure AD activity

The Assign User License activity assigns an additional Office 365 software license to the named user.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Azure AD**. This activity was built with the **REST** web service activity template.

**Important:** The REST message used for this activity must be configured to use OAuth2 authentication.

### Input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user_id</td>
<td>The object ID (GUID) or the user principal name of the target user. An example of a user principal name is <code>someuser@a830edad9050849NDA1.onmicrosoft.com</code>.</td>
</tr>
<tr>
<td>sku_id</td>
<td>Subscription SKU ID associated with the tenant’s enterprise agreement.</td>
</tr>
</tbody>
</table>

### Output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Returns the error string from the REST message. If there are no errors, this variable returns a null value.</td>
</tr>
<tr>
<td>body</td>
<td>Contains a string value representing the output from the REST message.</td>
</tr>
<tr>
<td>status_code</td>
<td>Contains the status code returned from the Web service.</td>
</tr>
</tbody>
</table>
Conditions

Assign User License conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully assigned an Office 365 license to a user.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to assigned an Office 365 license to a user, or the activity failed to connect to Azure AD.</td>
</tr>
</tbody>
</table>

Create User Azure AD activity

The Create User activity creates a user for the Azure Active Directory tenant.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Azure AD. This activity was built with the REST web service activity template.

⚠️ Important: The REST message used for this activity must be configured to use OAuth2 authentication.

Input variables

Create User input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>display_name</td>
<td>Name of the Azure AD user in the accepted display format, such as jacinto.gawron.</td>
</tr>
<tr>
<td>user_principal_name</td>
<td>User principal name (UPN) in an email format. For example, you might enter <a href="mailto:jacinto.gawron@khitomer.com">jacinto.gawron@khitomer.com</a>.</td>
</tr>
<tr>
<td>mail_nickname</td>
<td>User's email alias that redirects to the user’s full address.</td>
</tr>
<tr>
<td>password</td>
<td>User’s Azure AD password. This password must be passed as a workflow input with a type of Password (2 Way Encrypted) and must meet the password policy set in Azure AD.</td>
</tr>
</tbody>
</table>
*Create User input variables (continued)*

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>change_password</td>
<td>Control that requires the user to change his or her password at the next login, if set to true.</td>
</tr>
<tr>
<td>account_enabled</td>
<td>Control that sets the user's account is enabled, if set to true.</td>
</tr>
<tr>
<td>given_name</td>
<td>First name of the user.</td>
</tr>
<tr>
<td>surname</td>
<td>Last name of the user.</td>
</tr>
<tr>
<td>other_mails</td>
<td>List of additional email addresses for the user. For example, you might enter [&quot;<a href="mailto:jac@home.com">jac@home.com</a>&quot;, &quot;<a href="mailto:jgawron@fabrikam.com">jgawron@fabrikam.com</a>&quot;].</td>
</tr>
<tr>
<td>country</td>
<td>The country or region in which the user is located. For example, you might enter <strong>US</strong> or <strong>UK</strong>. The default value is set to <strong>US</strong>.</td>
</tr>
<tr>
<td>city</td>
<td>City in which the user is located.</td>
</tr>
<tr>
<td>department</td>
<td>Name of the department in which the user works.</td>
</tr>
<tr>
<td>mobile</td>
<td>User's primary cell phone number.</td>
</tr>
<tr>
<td>job_title</td>
<td>User's job title.</td>
</tr>
<tr>
<td>physical_delivery_office_name</td>
<td>Office location in the user place of business.</td>
</tr>
<tr>
<td>postal_code</td>
<td>Postal code of the user's address.</td>
</tr>
<tr>
<td>preferred_language</td>
<td>Language in which the user prefers to communicate. This value must follow the ISO 639-1 Code. For example, you might enter <strong>en-US</strong>. The default value is set to <strong>en-US</strong>.</td>
</tr>
<tr>
<td>state</td>
<td>State or province for the user's address.</td>
</tr>
<tr>
<td>street_address</td>
<td>Street address of the user's place of business.</td>
</tr>
</tbody>
</table>
Create User input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>telephone_number</td>
<td>Primary telephone number of the user’s place of business.</td>
</tr>
<tr>
<td>usage_location</td>
<td>Two letter country code that is required for users who are assigned Office 365 licenses. The default value is <strong>US</strong>.</td>
</tr>
</tbody>
</table>

Output variables

Create User output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Returns the error string from the REST message. If there are no errors, this variable returns a null value.</td>
</tr>
<tr>
<td>status_code</td>
<td>Contains the status code returned from the Web service.</td>
</tr>
<tr>
<td>user_exists</td>
<td>Output variable mapped to the JSON message that contains the <strong>User already exists</strong> error.</td>
</tr>
<tr>
<td>user_info</td>
<td>The <strong>user_info</strong> array contains attributes that can be leveraged by other activities as inputs. For example, the user <strong>objectid</strong> output (GUID) can be passed to the Add User to Group activity as the <strong>user_id</strong> input.</td>
</tr>
<tr>
<td></td>
<td>* <strong>objectid</strong>: User's Azure AD identifier.</td>
</tr>
<tr>
<td></td>
<td>* <strong>accountEnabled</strong>: Boolean variable indicating whether the user's account is active or inactive.</td>
</tr>
<tr>
<td></td>
<td>* <strong>displayName</strong>: Users display name, such as <strong>jacinto.gawron</strong>.</td>
</tr>
</tbody>
</table>
Create User output variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>userPrincipalName</td>
<td>User’s name in email format, such as <a href="mailto:jacinot.gawron@wammo.com">jacinot.gawron@wammo.com</a>.</td>
</tr>
<tr>
<td>mailNickname</td>
<td>User’s email alias.</td>
</tr>
</tbody>
</table>

Conditions

Create User conditions

<table>
<thead>
<tr>
<th>Conditions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created user</td>
<td>Activity successfully created the user.</td>
</tr>
<tr>
<td>User already exists</td>
<td>User already exists in the tenant domain.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to connect to Azure AD, or an input value was invalid.</td>
</tr>
</tbody>
</table>

Delete User Azure AD activity

The Delete User activity deletes the named user’s account from the Azure Active Directory tenant.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Azure AD. This activity was built with the REST web service activity template.

Important: The REST message used for this activity must be configured to use OAuth2 authentication.

Input variables

Delete User input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user_id</td>
<td>The object ID (GUID) or the user principal name of the target user. An example of a user principal name is <a href="mailto:someuser@a830edad9050849NDA1.onmicrosoft.com">someuser@a830edad9050849NDA1.onmicrosoft.com</a>.</td>
</tr>
</tbody>
</table>
Output variables

Delete User output variables

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Returns the error string from the REST message. If there are no errors, this variable returns a null value.</td>
</tr>
<tr>
<td>body</td>
<td>Contains a string value representing the output from the REST message.</td>
</tr>
<tr>
<td>status_code</td>
<td>Contains the status code returned from the Web service.</td>
</tr>
</tbody>
</table>

Conditions

Delete User conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted user</td>
<td>Activity deleted the specified user.</td>
</tr>
<tr>
<td>User does not exist</td>
<td>Specified user does not have an account in the tenant domain.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to connect to Azure AD.</td>
</tr>
</tbody>
</table>

Get User Info Azure AD activity

The Get User Info activity returns the named user’s information from the Azure Active Directory.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Azure AD. This activity was built with the REST web service activity template.

Important: The REST message used for this activity must be configured to use OAuth2 authentication.
Input variables

Check If User Exists input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user_id</td>
<td>The object ID (GUID) or the user principal name of the target user. An example of a user principal name is <a href="mailto:someuser@a830ed9050849NDA1.onmicrosoft.com">someuser@a830ed9050849NDA1.onmicrosoft.com</a>.</td>
</tr>
</tbody>
</table>

Note: Version 2 of this activity enforces input validation. If empty, the following message appears: "Mandatory input 'user_id' is empty".

Output variables

Check If User Exists output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Returns the error string from the REST message. If there are no errors, this variable returns a null value.</td>
</tr>
<tr>
<td>body</td>
<td>Contains a string value representing the output from the REST message.</td>
</tr>
<tr>
<td>status_code</td>
<td>Contains the status code returned from the Web service.</td>
</tr>
</tbody>
</table>
| user_info  | The **user_info** array contains attributes that can be leveraged by other activities as inputs. For example, the user **objectid** output (GUID) can be passed to the Add User to Group activity as the **user_id** input.  
  - **objectid**: User's Azure AD identifier.  
  - **accountEnabled**: Boolean variable indicating whether the user's account is active or inactive. |
Check If User Exists output variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• displayName</td>
<td>Users display name, such as jacinto.gawron.</td>
</tr>
<tr>
<td>• userPrincipalName</td>
<td>User's name in email format, such as <a href="mailto:jacinto.gawron@wammo.com">jacinto.gawron@wammo.com</a>.</td>
</tr>
<tr>
<td>• mailNickname</td>
<td>User's email alias.</td>
</tr>
</tbody>
</table>

Conditions

Check If User Exists conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User exists</td>
<td>Activity found the named user.</td>
</tr>
<tr>
<td>User does not exist</td>
<td>Activity was unable to find the named user in the customer tenant domain.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to connect to Azure AD.</td>
</tr>
</tbody>
</table>

Remove User from Group Azure AD activity

The Remove User from Group activity removes an existing user from a security group in Azure Active Directory.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Azure AD. This activity was built with the REST web service activity template.

Important: The REST message used for this activity must be configured to use OAuth2 authentication.

Input variables

Remove User from Group input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user_id</td>
<td>Object ID (GUID) of the user to be removed.</td>
</tr>
</tbody>
</table>
Remove User from Group input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>group_id</td>
<td>Object ID (GUID) of the target group.</td>
</tr>
</tbody>
</table>

Output variables

Remove User from Group output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Returns the error string from the REST message. If there are no errors, this variable returns a null value.</td>
</tr>
<tr>
<td>body</td>
<td>Contains a string value representing the output from the REST message.</td>
</tr>
<tr>
<td>status_code</td>
<td>Contains the status code returned from the Web service.</td>
</tr>
</tbody>
</table>

Conditions

Remove User from Group conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity removed the object ID from the security group.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to update the group’s membership, or the activity failed to connect to Azure AD.</td>
</tr>
</tbody>
</table>

Remove User License Azure AD activity

The Remove User License activity revokes the specified Office 365 software license for the named user.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Azure AD. This activity was built with the REST web service activity template.

Important: The REST message used for this activity must be configured to use OAuth2 authentication.
Input variables

Remove User License input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user_id</td>
<td>The object ID (GUID) or the user principal name of the target user. An example of a user principal name is <a href="mailto:someuser@a830edad9050849NDA1.onmicrosoft.com">someuser@a830edad9050849NDA1.onmicrosoft.com</a>.</td>
</tr>
<tr>
<td>sku_id</td>
<td>Subscription SKU ID associated with the tenant's enterprise agreement.</td>
</tr>
</tbody>
</table>

Output variables

Remove User License output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Returns the error string from the REST message. If there are no errors, this variable returns a null value.</td>
</tr>
<tr>
<td>body</td>
<td>Contains a string value representing the output from the REST message.</td>
</tr>
<tr>
<td>status_code</td>
<td>Contains the status code returned from the Web service.</td>
</tr>
</tbody>
</table>

Conditions

Remove User License conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity removed an Office 365 license from the named user.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to remove an Office 365 from a user, or the activity failed to connect to Azure AD.</td>
</tr>
</tbody>
</table>
Reset User Password Azure AD activity

The Reset User Password activity changes the named user’s Azure Active Directory password.

The Azure password policy imposes constraints on the complexity, length, and re-use of a password.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Azure AD. This activity was built with the REST web service activity template.

**Important:** The REST message used for this activity must be configured to use OAuth2 authentication.

### Input variables

**Reset User Password input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user_id</td>
<td>The object ID (GUID) or the user principal name of the target user. An example of a user principal name is <a href="mailto:someuser@a830edad9050849NDA1.onmicrosoft.com">someuser@a830edad9050849NDA1.onmicrosoft.com</a>.</td>
</tr>
<tr>
<td>password</td>
<td>User’s Azure AD password. This password must be passed as a workflow input with a type of Password (2 Way Encrypted) and must meet the password policy set in Azure AD.</td>
</tr>
<tr>
<td>change_password</td>
<td>Control that requires the user to change his or her password at the next login, if set to true.</td>
</tr>
</tbody>
</table>

### Output variables

**Reset User Password output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Returns the error string from the REST message. If there are no errors, this variable returns a null value.</td>
</tr>
</tbody>
</table>
Reset User Password output variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>body</td>
<td>Contains a string value representing the output from the REST message.</td>
</tr>
<tr>
<td>status_code</td>
<td>Contains the status code returned from the Web service.</td>
</tr>
</tbody>
</table>

Conditions

Reset User Password conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity reset the named user’s password.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to reset the named user’s password, or the activity failed to connect to Azure AD.</td>
</tr>
</tbody>
</table>

Exchange activity pack

The Exchange activity pack allows workflows to manage Microsoft Exchange mail systems.

The use of Orchestration Exchange activities requires the following:

- Microsoft Exchange 2010 or 2013.
- A MID Server configured to run Powershell 2.0
- A target Exchange server in the same Active Directory domain as the instance.
- Powershell Remoting enabled on the target Exchange server.

⚠️ Note: These activities cannot be used to interact with Microsoft Exchange Online.

Orchestration provides custom Exchange activities that were created with the Orchestration activity designer template. These activities perform the same functions as Exchange activities by the same name from previous releases and replace those activities for all new workflows. The custom Exchange activities were built with a Powershell activity template, which gives workflow administrators the ability to store input and output variables in the databus.
**Note:** Existing workflows from earlier versions that were created with legacy Exchange activities continue to function normally after an upgrade to Geneva. However, all new workflows must use these custom Exchange activities.

To use the Microsoft Exchange custom activities, you must request activation of the Orchestration - Exchange plugin. The custom Exchange activities are available in the Workflow Editor on the **Custom** tab. Expand the **Custom Activities** tree and select the **Exchange** category for the activity you want to use.

![Accessing custom Exchange activities](image-url)

- **Global**
- **Exchange**
  - **AddressList**
    - Delete AddressList - Version 1
    - Set AddressList - Version 1
    - Move AddressList - Version 1
    - Create AddressList - Version 1
    - Update AddressList - Version 1
    - Get AddressList - Version 1
  - **Mailbox**
    - Get Mailbox - Version 1
    - Disable Mailbox - Version 1
    - Enable Mailbox - Version 1
    - Create Mailbox - Version 1
    - Delete Mailbox - Version 1
    - Set Mailbox - Version 1
Configure MID Server for Exchange

Configure a MID Server with defined IP ranges to use Exchange.

About this task
If the MID Server manages resources within defined IP ranges, instead of all computers on your network, you must perform additional configuration steps to run Exchange activities. You do not need to perform these steps if your MID Server uses the default configuration.

Procedure
1. In the navigation filter, enter cmdb_ci_dns_name.list.
2. Click New.
3. Enter the fully-qualified domain name (FQDN) of your Exchange server in the Name field.
4. Right-click the form header and select Save.
5. In the IP Address related list, click New.
6. In the IP Address field, enter the IP address of your Exchange server.
7. In the Nic field, select eth0 or your preferred network interface controller.
8. Leave the Netmask field blank.
9. Click Submit.

Pass multivalued properties with an Exchange activity

To set a multivalued property using an Exchange activity, you must use a specific parameter format.

About this task
The Optional parameters shared input variable allows you to set multivalued properties.

Procedure
• To set a multivalued property, replacing any existing values, use this format: "PropertyName":"(value1, value2, value3)"
• To add values, use this format: "PropertyName":"+(value1, value2, value3);"
• To remove values, use this format: "PropertyName":"-(value1, value2, value3);"
• To both add and remove values, use this format: "PropertyName":"-(value1, value2, value3):+(value1, value2, value3);"
Create Address List activity

The Create Address List activity creates a new address list that acts as an alias for emailing all users in the group.

This alias cannot be used to manage user permissions. This activity implements the Microsoft Exchange New-AddressList command.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Exchange > Address List.

Note: This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Create Address List input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>name</td>
<td>Name of the new address list to create.</td>
</tr>
<tr>
<td>parameters</td>
<td>Optional parameters to pass to the Exchange server written in JavaScript Object Notation (JSON). Exchange activities cannot pass parameters that reference an object, such as a PSCredential object. Plain text is automatically converted to SecureString objects for parameters that require that data type. Attempting to save an activity that specifies duplicate parameters, including parameters from activity variables, or incorrectly formatted JSON causes a warning message to appear.</td>
</tr>
</tbody>
</table>

Note: When passing a switch parameter, such as ForceUpgrade, you must use the format "parameter": "true".
Output variables

Create Address List output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either <strong>success</strong> or <strong>failure</strong>.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
<tr>
<td>output</td>
<td>Raw XML payload from the Exchange server. This data includes all Exchange attributes.</td>
</tr>
</tbody>
</table>

Conditions

Create Address List conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in creating a new address list.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to create a new address list.</td>
</tr>
</tbody>
</table>

Delete Address List activity

The Delete Address List activity removes an existing address list from an Exchange server.

This activity implements the Microsoft Exchange **Remove-AddressList** command.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Exchange > Address List**.

**Note:** This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the **PowerShell activity designer**, which gives workflow administrators the ability to store input and output variables in the **databus**.
Input variables

Delete Address List input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>identity</td>
<td>Name of the address list to remove.</td>
</tr>
<tr>
<td>domainController</td>
<td>Fully-qualified domain name (FQDN) of the domain controller that writes to Active Directory.</td>
</tr>
<tr>
<td>recursive</td>
<td>Check box that indicates if the activity should delete Active Directory elements that are children of the specified address list.</td>
</tr>
<tr>
<td>whatif</td>
<td>Check box that indicates if the activity should stage the changes without applying them. Use this variable to test your activity settings before using the activity in a live workflow. When this variable is selected, the Exchange server does not make any changes but indicates if the command would succeed or fail. You can review any messages from the Exchange server using the ECC queue.</td>
</tr>
</tbody>
</table>

Output variables

Delete Address List output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
</tbody>
</table>

Conditions

Delete Address List conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in removing the address list from the Exchange server.</td>
</tr>
</tbody>
</table>
Delete Address List conditions (continued)

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failure</td>
<td>The activity failed to remove the address list from the Exchange server.</td>
</tr>
</tbody>
</table>

**Get Address List activity**

The Get AddressList activity retrieves all attributes from the specified Exchange address list.

This activity implements the Microsoft Exchange Get-AddressList command.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Exchange > Address List**.

**Note:** This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the **PowerShell activity designer**, which gives workflow administrators the ability to store input and output variables in the **databus**.

**Input variables**

**Get Address List input variables**

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>domainController</td>
<td>Fully-qualified domain name (FQDN) of the domain controller that writes to Active Directory.</td>
</tr>
<tr>
<td>identity</td>
<td>Name of the address list to get attributes from. If you enter a value in this variable, leave the <strong>container</strong> and <strong>searchText</strong> variables blank.</td>
</tr>
<tr>
<td>organization</td>
<td>Organization to which the specified address list belongs.</td>
</tr>
<tr>
<td>searchText</td>
<td>Filter text that causes the activity to return only results that contain this text. This variable can only be used with</td>
</tr>
</tbody>
</table>
Get Address List input variables (continued)

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Container</td>
<td>Parent address list of the address list from which you want to retrieve attributes. If you enter a value in this variable, leave the identity and searchText variables blank.</td>
</tr>
</tbody>
</table>

Output variables

Get Address List output variables

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>Error</td>
<td>Error message if the operation fails.</td>
</tr>
<tr>
<td>Output</td>
<td>Raw XML payload from the Exchange server. This data includes all Exchange attributes.</td>
</tr>
</tbody>
</table>

Conditions

Get Address List conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in retrieving the attributes from the address list.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to retrieve the attributes from the address list.</td>
</tr>
</tbody>
</table>

Move Address List activity

The Move Address List activity moves a Microsoft Exchange address list to another location in the address hierarchy.

This activity implements the Microsoft Exchange Move-AddressList command. The Exchange server caches the changes from this activity but does not immediately apply them. Use the Update Address List activity after this activity to apply the changes or wait for the Exchange server to automatically apply cached changes.
To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Exchange > Address List**.

**Note:** This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the **PowerShell activity designer**, which gives workflow administrators the ability to store input and output variables in the **databus**.

### Input variables

#### Move Address List input variables

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>identity</td>
<td>Name of the address list to move.</td>
</tr>
<tr>
<td>target</td>
<td>Path to the address list's new location.</td>
</tr>
<tr>
<td>domainController</td>
<td>Fully-qualified domain name (FQDN) of the domain controller that writes to Active Directory.</td>
</tr>
<tr>
<td>whatif</td>
<td>Check box that indicates if the activity should stage the changes without applying them. Use this variable to test your activity settings before using the activity in a live workflow. When this variable is selected, the Exchange server does not make any changes but indicates if the command would succeed or fail. You can review any messages from the Exchange server using the ECC queue.</td>
</tr>
</tbody>
</table>

### Output variables

#### Move Address List output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either <strong>success</strong> or <strong>failure</strong>.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
</tbody>
</table>
Conditions

Move Address List conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in moving the address list to another location.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to move the address list to another location.</td>
</tr>
</tbody>
</table>

Set Address List activity

The Set Address List activity modifies a Microsoft Exchange address list.

Use the Optional parameters variable to pass specific values to the Microsoft Exchange server. This activity implements the Microsoft Exchange Set-AddressList command.

The Exchange server caches the changes from this activity but does not immediately apply them. Use the Update Address List after this activity to apply the changes or wait for the Exchange server to automatically apply cached changes.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Exchange > Address List.

Note: This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Set Address List input variables

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>identity</td>
<td>Name of the address list to modify.</td>
</tr>
</tbody>
</table>
Set Address List input variables (continued)

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>parameters</td>
<td>Optional parameters to pass to the Exchange server written in JavaScript Object Notation (JSON). Exchange activities cannot pass parameters that reference an object, such as a PSCredential object. Plain text is automatically converted to SecureString objects for parameters that require that data type. Attempting to save an activity that specifies duplicate parameters, including parameters from activity variables, or incorrectly formatted JSON causes a warning message to appear.</td>
</tr>
</tbody>
</table>

Note: When passing a switch parameter, such as ForceUpgrade, you must use the format "parameter":"true".

Output variables

Set Address List output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
</tbody>
</table>

Conditions

Set Address List conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in modifying the specified address list.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to modify the specified address list.</td>
</tr>
</tbody>
</table>

Update Address List activity

The Update Address List activity adds or removes users from the specified address list and immediately applies any cached address list changes to the server.

Use the optional parameters variable to specify which users to add or remove. This activity implements the Microsoft Exchange Update-AddressList command.
To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Exchange > Address List.

Note: This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

**Input variables**

**Update Address List input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>identity</td>
<td>Name of the address list to update.</td>
</tr>
<tr>
<td>domainController</td>
<td>Fully-qualified domain name (FQDN) of the domain controller that writes to Active Directory.</td>
</tr>
<tr>
<td>whatif</td>
<td>A check box that indicates if the activity should stage the changes without applying them. Use this variable to test your activity settings before using the activity in a live workflow. When this variable is selected, the Exchange server does not make any changes but indicates if the command would succeed or fail. You can review any messages from the Exchange server using the ECC queue.</td>
</tr>
</tbody>
</table>

**Output variables**

**Update Address List output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either Success or Failure.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
</tbody>
</table>
Conditions

Update Address List conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in adding or removing users from the specified address list.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to add or remove users from the specified address list.</td>
</tr>
</tbody>
</table>

Create Mailbox activity

The Create Mailbox activity creates a new Active Directory user, if that user does not already exist, and a Microsoft Exchange mailbox for that user.

This activity implements the Microsoft Exchange **New-Mailbox** command.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Exchange > Mailbox**.

**Note:** This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the **PowerShell activity designer**, which gives workflow administrators the ability to store input and output variables in the **databus**.

Input variables

Create Mailbox input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>first_name</td>
<td>First name of the user.</td>
</tr>
<tr>
<td>middle_initial</td>
<td>Middle initial of the user.</td>
</tr>
</tbody>
</table>
Create Mailbox input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>last_name</td>
<td>Last name of the user.</td>
</tr>
<tr>
<td>alias</td>
<td>The display name for the mailbox address, the part of the email address to the left of the @ symbol. If no alias is specified, the activity uses First name.Last name as the alias. The alias is also used as the user's principal name (UPN) if none is specified in the optional parameters.</td>
</tr>
<tr>
<td>password</td>
<td>Password to use for the new mailbox. The password is encrypted when it is sent to the target host.</td>
</tr>
<tr>
<td>parameters</td>
<td>Optional parameters to pass to the Exchange server written in JavaScript Object Notation (JSON). Exchange activities cannot pass parameters that reference an object, such as a PSCredential object. Plain text is automatically converted to SecureString objects for parameters that require that data type. Attempting to save an activity that specifies duplicate parameters, including parameters from activity variables, or incorrectly formatted JSON causes a warning message to appear.</td>
</tr>
</tbody>
</table>

![Note:](image) When passing a switch parameter, such as ForceUpgrade, you must use the format "parameter":"true".

Output variables

Create Mailbox output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
<tr>
<td>output</td>
<td>Raw XML payload from the Exchange server. This data includes all Exchange attributes.</td>
</tr>
</tbody>
</table>
Conditions

Create Mailbox conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in creating a new mailbox for the specified user. If no Active Directory account existed for that user, this activity succeeded in creating a new account.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to create a new mailbox or an Active Directory account for the specified user.</td>
</tr>
</tbody>
</table>

Delete Mailbox activity

The Delete Mailbox activity deletes the Microsoft Exchange mailbox of an Active Directory user.

Optional parameters determine how the Exchange server handles the mailbox after deleting the user. This activity implements the Microsoft Exchange Remove-Mailbox command.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Exchange > Mailbox.

Note: This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Delete Mailbox input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server’s assigned domain.</td>
</tr>
<tr>
<td>user</td>
<td>Active Directory user to delete. The activity passes this value to Exchange as the Identity Exchange variable.</td>
</tr>
</tbody>
</table>
Delete Mailbox input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>parameters</td>
<td>Optional parameters to pass to the Exchange server written in JavaScript Object Notation (JSON). Exchange activities cannot pass parameters that reference an object, such as a PSCredential object. Plain text is automatically converted to SecureString objects for parameters that require that data type. Attempting to save an activity that specifies duplicate parameters, including parameters from activity variables, or incorrectly formatted JSON causes a warning message to appear.</td>
</tr>
</tbody>
</table>

**Note:** When passing a switch parameter, such as ForceUpgrade, you must use the format "parameter": "true".

Output variables

Delete Mailbox output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either <strong>success</strong> or <strong>failure</strong>.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
</tbody>
</table>

Conditions

Delete Mailbox conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in deleting the specified user’s mailbox.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to delete the specified user’s mailbox.</td>
</tr>
</tbody>
</table>

Disable Mailbox activity

The Disable Mailbox activity disables the mailbox associated with a specified Active Directory account.

This activity implements the Microsoft Exchange **Disable-Mailbox** command.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Exchange > Mailbox**.
Note: This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Disable Mailbox input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>user</td>
<td>Active Directory user who's mailbox should be disabled. The activity passes this value to Exchange as the Identity Exchange variable.</td>
</tr>
<tr>
<td>parameters</td>
<td>Optional parameters to pass to the Exchange server written in JavaScript Object Notation (JSON). Exchange activities cannot pass parameters that reference an object, such as a PSCredential object. Plain text is automatically converted to SecureString objects for parameters that require that data type. Attempting to save an activity that specifies duplicate parameters, including parameters from activity variables, or incorrectly formatted JSON causes a warning message to appear.</td>
</tr>
</tbody>
</table>

Note: When passing a switch parameter, such as ForceUpgrade, you must use the format "parameter": "true".

Output variables

Disable Mailbox output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
</tbody>
</table>
Conditions

Disable Mailbox conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in disabling the specified mailbox.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to disable the specified mailbox.</td>
</tr>
</tbody>
</table>

Enable Mailbox activity

The Enable Mailbox activity creates a new mailbox for an existing Active Directory user.

This activity implements the Microsoft Exchange `Enable-Mailbox` command.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Exchange > Mailbox.

**Note:** This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Enable Mailbox input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>user</td>
<td>Active Directory user who's mailbox should be enabled. The activity passes this value to Exchange as the Identity Exchange variable.</td>
</tr>
<tr>
<td>parameters</td>
<td>Optional parameters to pass to the Exchange server written in JavaScript Object Notation (JSON). Exchange activities cannot pass parameters that reference an object, such as a...</td>
</tr>
</tbody>
</table>
Enable Mailbox input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSCredential object. Plain text is automatically converted to SecureString objects for parameters that require that data type. Attempting to save an activity that specifies duplicate parameters, including parameters from activity variables, or incorrectly formatted JSON causes a warning message to appear.</td>
<td></td>
</tr>
</tbody>
</table>

Note: When passing a switch parameter, such as ForceUpgrade, you must use the format "parameter":"true".

Output variables

Enable Mailbox output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
</tbody>
</table>

Conditions

Enable Mailbox conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in creating a new mailbox for the specified user.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to create a new mailbox for the specified user.</td>
</tr>
</tbody>
</table>

Get Mailbox activity

The Get Mailbox activity gets the mailbox for the specified user or all mailboxes on a Microsoft Exchange server.

This activity implements the Microsoft Exchange Get-Mailbox command.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Exchange > Mailbox.
Note: This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Get Mailbox input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>user</td>
<td>User whose mailbox this activity should retrieve. If no user is specified, the activity gets all mailboxes on the Exchange server. The activity passes this value to Exchange as the Identity Exchange variable.</td>
</tr>
<tr>
<td>parameters</td>
<td>Optional parameters to pass to the Exchange server written in JavaScript Object Notation (JSON). Exchange activities cannot pass parameters that reference an object, such as a PSCredential object. Plain text is automatically converted to SecureString objects for parameters that require that data type. Attempting to save an activity that specifies duplicate parameters, including parameters from activity variables, or incorrectly formatted JSON causes a warning message to appear.</td>
</tr>
</tbody>
</table>

Note: When passing a switch parameter, such as ForceUpgrade, you must use the format "parameter":"true".

Output variables

Get Mailbox output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
</tbody>
</table>
Get Mailbox output variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>output</td>
<td>Raw XML payload from the Exchange server. This data includes all Exchange attributes.</td>
</tr>
</tbody>
</table>

Conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in retrieving the attributes of the specified mailbox.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to retrieve the attributes of the specified mailbox.</td>
</tr>
</tbody>
</table>

Set Mailbox activity

The Set Mailbox activity modifies the settings of an existing Microsoft Exchange mailbox.

Use the optional parameters variable to pass specific values to the Exchange server. This activity implements the Microsoft Exchange Set-Mailbox command.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Exchange > Mailbox.

Note: This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
</tbody>
</table>
Set Mailbox input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>domain</td>
<td>The name of the Exchange server’s assigned domain.</td>
</tr>
<tr>
<td>user</td>
<td>Active Directory user whose mailbox you want to modify. The activity passes this value to Exchange as the Identity Exchange variable.</td>
</tr>
<tr>
<td>parameters</td>
<td>Optional parameters to pass to the Exchange server written in JavaScript Object Notation (JSON). Exchange activities cannot pass parameters that reference an object, such as a PSCredential object. Plain text is automatically converted to SecureString objects for parameters that require that data type. Attempting to save an activity that specifies duplicate parameters, including parameters from activity variables, or incorrectly formatted JSON causes a warning message to appear.</td>
</tr>
</tbody>
</table>

⚠️ Note: When passing a switch parameter, such as ForceUpgrade, you must use the format "parameter":"true".

Output variables

Set Mailbox output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either <strong>success</strong> or <strong>failure</strong>.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
</tbody>
</table>

Conditions

Set Mailbox conditions

<table>
<thead>
<tr>
<th>Conditions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in modifying the settings of the specified mailbox.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to modify the settings of the specified mailbox.</td>
</tr>
</tbody>
</table>
**F5 Network Management activity pack**

Orchestration provides custom activities for configuring elements of an F5 load balancer, including pools, pool members, and the virtual servers contained in the pool.

All F5 custom activities are in the F5 Network Management Application scope and are activated by the Orchestration - F5 network management plugin, which must be activated by request.

ServiceNow provides custom F5 activities, built from the REST web service activity template, that you can use to perform the following tasks:

- Add, delete, or verify pools.
- Add, delete, or identify pool members.
- Add or delete virtual servers.
- Add a profile to a virtual server.
- Configure the virtual server for vlans, irules, pool, and persistence.

**Add F5 Pool Member activity**

The Add F5 Pool Member activity adds a member to an F5 load balancer pool.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Active Directory**.

**REST settings**

- **REST message**: F5 POOL Membership Management
- **REST function**: post

**Input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PoolName</td>
<td>Name of this pool, such as testPool.</td>
</tr>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
<tr>
<td>MemberName</td>
<td>Pool member IP address and port, such as 192.168.2.19:80.</td>
</tr>
</tbody>
</table>
Output variables

Add F5 Pool Member output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
<tr>
<td>error</td>
<td>The REST error.</td>
</tr>
<tr>
<td>output</td>
<td>The REST output.</td>
</tr>
</tbody>
</table>

Conditions

Add F5 Pool Member conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully added an F5 load balancer pool member.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to add an F5 load balancer pool member.</td>
</tr>
</tbody>
</table>

Get F5 Pool Member activity

The Get F5 Pool Member activity returns the pool members and verifies the pool's status.

Use this activity to verify that a pool member was created properly.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

REST settings

- **REST message**: F5 POOL Membership Management
- **REST function**: get
Input variables

Get F5 Pool Member input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PoolName</td>
<td>Name of this pool, such as testPool.</td>
</tr>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
</tbody>
</table>

Output variables

Get F5 Pool Member output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MembersArray</td>
<td>Array for the returned pool member IP address and port, such as 192.168.2.19:80.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
<tr>
<td>error</td>
<td>The REST error.</td>
</tr>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>output</td>
<td>The REST output.</td>
</tr>
</tbody>
</table>

Conditions

Get F5 Pool Member conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully returned the F5 load balancer pool members.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to return the F5 load balancer pool members</td>
</tr>
</tbody>
</table>

Delete F5 Virtual Server activity

The Delete F5 Virtual Server activity deletes a virtual server from an F5 load balancer pool.
This activity was built using the [REST web service activity template](#). To access the activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Active Directory**.

**REST settings**
- **REST message**: F5 VIP Management
- **REST function**: delete

**Input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
<tr>
<td>name</td>
<td>The virtual server's name, such as testVIP.</td>
</tr>
</tbody>
</table>

**Output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
</tbody>
</table>

**Conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully deleted the virtual server from the F5 load balancer pool.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to delete the virtual server from the F5 load balancer pool.</td>
</tr>
</tbody>
</table>

**Check F5 Pool activity**
The Check F5 Pool activity checks the status of a pool to determine if it is available to accept traffic.
Use this activity to determine if a pool you just created is up and running with the proper configuration.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

**REST settings**
- **REST message**: F5 POOL Management
- **REST function**: get

**Input variables**

Check F5 Pool input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
<tr>
<td>PoolName</td>
<td>Name of this pool, such as testPool.</td>
</tr>
</tbody>
</table>

**Output variables**

Check F5 Pool output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
<tr>
<td>error</td>
<td>The REST error.</td>
</tr>
</tbody>
</table>

**Conditions**

Check F5 Pool conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully returned the status of the F5 load balancer pool.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to return the status of the F5 load balancer pool.</td>
</tr>
</tbody>
</table>
Add F5 Profile to Virtual Server activity

The Add F5 Profile to Virtual Server activity adds a profile to a virtual server assigned to an F5 load balancer pool.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

REST settings

- REST message: F5 VIP Profile Management
- REST function: post

Input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>The virtual server's name, such as testVIP</td>
</tr>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
<tr>
<td>VirtualServerName</td>
<td>Name of the virtual server, such as testVIP.</td>
</tr>
</tbody>
</table>

Output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>output</td>
<td>The REST output.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
</tbody>
</table>
Conditions

Add F5 Profile to Virtual Server conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully added the F5 load balancer profile to the virtual server.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to add the F5 load balancer profile to the virtual server.</td>
</tr>
</tbody>
</table>

Modify F5 Virtual Server activity

The Modify F5 Virtual Server activity configures a virtual server assigned to an F5 load balancer pool with irules and a vlan.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

REST settings

- REST message: F5 VIP Management
- REST function: put

Input variables

Modify F5 Virtual Server input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>The virtual server's name, such as testVIP.</td>
</tr>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
<tr>
<td>irules</td>
<td>The irules for the virtual server, such as _sys_https_redirect.</td>
</tr>
<tr>
<td></td>
<td>• pool: Name of the pool for the virtual server, such as testPool.</td>
</tr>
<tr>
<td></td>
<td>• persistent: Persistent profile for the virtual server, such as cookie.</td>
</tr>
</tbody>
</table>
Modify F5 Virtual Server input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>vlans</td>
<td>Vlans for the virtual server, such as internal.</td>
</tr>
</tbody>
</table>

Output variables

Modify F5 Virtual Server output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
<tr>
<td>output</td>
<td>The REST output.</td>
</tr>
</tbody>
</table>

Conditions

Modify F5 Virtual Server conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully configured a virtual server assigned to an F5 load balancer pool.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to configure a virtual server assigned to an F5 load balancer pool.</td>
</tr>
</tbody>
</table>

Add F5 Virtual Server activity

The Add F5 Virtual Server activity adds a virtual server.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

REST settings

- **REST message**: F5 POOL Membership Management
- **REST function**: post
**Input variables**

Add F5 Virtual Server input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>The virtual server’s name, such as testVIP.</td>
</tr>
<tr>
<td>description</td>
<td>Description of this virtual server.</td>
</tr>
<tr>
<td>ipProtocol</td>
<td>Protocol used for this virtual server, such as tcp.</td>
</tr>
<tr>
<td>destination</td>
<td>Virtual server IP address and port number, such as 192.168.4.20:80.</td>
</tr>
<tr>
<td>mask</td>
<td>Subnet mask for this virtual server, such as 255.255.255.255.</td>
</tr>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
<tr>
<td>sourceAddressTranslation</td>
<td>Source address translation mode.</td>
</tr>
</tbody>
</table>

**Output variables**

Add F5 Virtual Server output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
<tr>
<td>error</td>
<td>The REST error.</td>
</tr>
<tr>
<td>output</td>
<td>The REST output.</td>
</tr>
</tbody>
</table>

**Conditions**

Add F5 Virtual Server conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully added a virtual server.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to add a virtual server.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Delete F5 Pool Member activity
The Delete F5 Pool Member activity deletes an F5 load balancer pool member.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

REST settings
- REST message: F5 POOL Membership Management
- REST function: delete

Input variables

Delete F5 Pool Member input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PoolName</td>
<td>Name of this pool, such as testPool.</td>
</tr>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
<tr>
<td>MemberName</td>
<td>Pool member IP address and port, such as 192.168.2.19:80.</td>
</tr>
</tbody>
</table>

Output variables

Delete F5 Pool Member output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
<tr>
<td>error</td>
<td>The REST error.</td>
</tr>
</tbody>
</table>

Conditions

Delete F5 Pool Member output variables

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity succeeded in deleting an F5 load balancer pool member.</td>
</tr>
</tbody>
</table>
Delete F5 Pool Member output variables (continued)

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failure</td>
<td>Activity failed to delete an F5 load balancer pool member.</td>
</tr>
</tbody>
</table>

Delete F5 Pool activity

The Delete F5 Pool activity deletes an F5 load balancer pool.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

REST settings

- **REST message**: F5 POOL Management
- **REST function**: delete

Input variables

Delete F5 Pool input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
<tr>
<td>PoolName</td>
<td>Name of this pool, such as testPool.</td>
</tr>
</tbody>
</table>

Output variables

Delete F5 Pool output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>error</td>
<td>The REST error.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
</tbody>
</table>
Conditions

Delete F5 Pool conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully deleted the F5 load balancer pool.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to delete the F5 load balancer pool.</td>
</tr>
</tbody>
</table>

Add F5 Pool activity

The Add F5 Pool activity creates the F5 load balancer pool.

Use this activity to verify that a pool member was created properly.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

REST settings

- **REST message**: F5 POOL Management
- **REST function**: post

Input variables

Add F5 Pool input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PoolName</td>
<td>Name of this pool, such as testPool.</td>
</tr>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
<tr>
<td>MemberName</td>
<td>Pool member IP address and port, such as 192.168.2.19:80.</td>
</tr>
</tbody>
</table>
Output variables

Add F5 Pool output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
<tr>
<td>error</td>
<td>The REST error.</td>
</tr>
<tr>
<td>output</td>
<td>The REST output.</td>
</tr>
</tbody>
</table>

Conditions

Add F5 Pool conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity succeeded in creating the F5 load balancer pool.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to create the F5 load balancer pool.</td>
</tr>
</tbody>
</table>

Infoblox DDI activity pack

This activity pack supports Infoblox DDI management through ServiceNow Orchestration.

The Infoblox DDI activity pack manages the IP addresses used in a network by integrating DNS and DHCP. Custom Orchestration activities use Infoblox Web API (WAPI) REST web services to access the Infoblox GRID server.

**Important:** Managing IP addresses through the Infoblox server requires a fully functional MID Server.

Starting with the Jakarta release, the Infoblox activity pack updates to version 2. This update supports Infoblox network views, which can restrict the visibility of network data. The view parameter can be passed as a query parameter or payload content, to do operations in a specific view. Version 2 also supports specifying the version of WAPI to use in integration endpoints. Supported for Infoblox:

- WAPI version 2.0 for REST messages
- NIOS appliance version 7.0
Note: To use the Infoblox DDI activities and workflow, you must request activation of the Orchestration - Infoblox DDI Activity Pack plugin.

Create a REST credential for Infoblox activities

All Infoblox activities require a REST credential to manage IP addresses from the Infoblox DDI server.

Before you begin

Before starting this procedure, make sure you have the following:

- A properly configured and running Infoblox DDI Grid Server.
- REST credentials defined on the Infoblox DDI server.

Role required: admin

About this task

You must create a REST credential record on the ServiceNow instance that each Infoblox activity can use to access management features on the Infoblox server.

Procedure

1. Navigate to Orchestration > Credentials and click New.
2. In the list of credential types, select Basic Auth Credentials.
3. Create the credential record with a logical name, such as InfobloxCred.
4. Right-click in the header bar of your new credential record and select Copy sys_id from the context menu. Follow browser instructions to copy the sys_id if browser security measures restrict this function.
5. Paste the sys_id into the restCredentials input field of each activity you use.

Infoblox workflows

The Infobox DDI activity pack includes two default workflows, one that reserves and registers IP addresses and another that releases IP addresses.

To access these workflows, navigate to Workflow > Workflow Editor and select the Workflows tab. Click on a workflow to open it, and then click the information icon in the workflow header to display the properties dialog box.

Infoblox Reserve/Register IP in IPAM

Use this workflow to register IPv4 addresses or request the next available IP address on IPAM. Optionally, you can use it to register IP addresses on DNS. The custom Infoblox activities used in this workflow are:
• IPAM Register IP Address
• IPAM Reserve IP Address
• Register DNS A-Record
• Get Network Details

Infoblox Reserve/Register IP input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Infoblox Server</td>
<td>IP address of the Infoblox DDI server.</td>
</tr>
<tr>
<td>Network</td>
<td>Network containing the target IP address.</td>
</tr>
<tr>
<td>Zone</td>
<td>The DNS zone for the IP address being registered.</td>
</tr>
<tr>
<td>Rest Credentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>DNS Host Name</td>
<td>Name of the DNS server machine on which the IP address is being registered.</td>
</tr>
<tr>
<td>IPv4 Address</td>
<td>IP address being reserved or registered.</td>
</tr>
</tbody>
</table>

Infoblox Release IPAM Reservations
Use this workflow to release (delete) all the IPAM reservations associated with an IPv4 address. The custom Infoblox activities used in this workflow are:

• IPAM List IP Reservations
• List DNS Record
• DNS Delete
• IPAM Delete

Infoblox Release IPAM Reservations input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rest Credentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>IP to Delete</td>
<td>IP address to release.</td>
</tr>
<tr>
<td>Infoblox Server</td>
<td>IP address of the Infoblox DDI server.</td>
</tr>
</tbody>
</table>
Infoblox roles and permissions

Define the roles and permissions that the Infoblox activities need to access the various resources on the Infoblox server.

Admin groups

There are three types of admin groups on an Infoblox server:

• Superuser
• Default
• Limited Access

To perform specific operations on the Infoblox server, the Limited Access user must have a minimum set of privileges for the desired resources, using either the user interface or an API. These privileges are based on read and read/write access. For more information, refer to the “About Admin Groups” section in the Infoblox NIOS Administrator Guide.

Permission hierarchy

1. User: A user can be part of multiple groups.
2. Group: A group can have many roles.
3. Role: Each role consists of specific resource permissions.

Required permissions

The ServiceNow Infoblox activity pack requires appropriate read and read/write privileges for these resources:

• Network
• DHCP
• DNS
• IPAM

This example shows a default DHCP admin role, its resources, and the related permissions for each.
Infoblox DHCP activities

The Infoblox DHCP activities manage the IP addresses reserved for DHCP in your network.

Use these activities to reserve, list, or delete IP addresses that are used for DHCP assignment in your network.

DHCP Reserve IP v4 Address Range activity

The DHCP Reserve IP v4 Address Range activity reserves an IP address range for DHCP use.

The DHCP activities use the REST web service activity template to manage IP addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > DHCP.

Input variables

**DHCP Reserve IP v4 Address Range input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>startIpAddress</td>
<td>Beginning IPv4 address of the range to reserve.</td>
</tr>
<tr>
<td>endIpAddress</td>
<td>Ending IPv4 address of the range to reserve.</td>
</tr>
</tbody>
</table>
DHCP Reserve IP v4 Address Range input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
<tr>
<td></td>
<td>Note: This field is mandatory. If the field is empty, the orchestration activity will fail.</td>
</tr>
<tr>
<td>view</td>
<td>Name of the Infoblox network view. The default value is default.</td>
</tr>
<tr>
<td></td>
<td>Note: If the field is empty, the operation is treated as happening in the default view.</td>
</tr>
</tbody>
</table>

Output variables

DHCP Reserve IP v4 Address Range output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCPIPv4AddressRange</td>
<td>Range of reserved IPv4 addresses.</td>
</tr>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
</tbody>
</table>

Conditions

DHCP Reserve IP v4 Address Range conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully reserved the specified IPv4 address range.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to reserve the specified IPv4 address range.</td>
</tr>
</tbody>
</table>

DHCP Delete IP Reservation activity

The DHCP Delete IP Reservation activity deletes IP reservations in DHCP using either an IPv4 or IPv6 address range.

An automation can obtain an Infoblox DHCP object to delete from either of these activities:
• DHCP List IP Reservations
• DHCP Reserve IPv4 Address Range

The DHCP activities use the REST web service activity template to manage IP addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > DHCP.

### Input variables

#### DHCP Delete IP Reservation input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>ipToDelete</td>
<td>IP address range to delete, in the form: range/&lt;encrypted code&gt;:&lt;start range&gt;/&lt;end range&gt;/default</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
</tbody>
</table>

**Note:** This field is mandatory. If the field is empty, the orchestration activity will fail.

### Output variables

#### DHCP Delete IP Reservation output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCPDeletedIpRange</td>
<td>Range of deleted IP addresses.</td>
</tr>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
</tbody>
</table>
Conditions

**DHCP Delete IP Reservation conditions**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully deleted the specified IP address range.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to delete the specified IP address range.</td>
</tr>
</tbody>
</table>

**DHCP List IP Reservations activity**

The DHCP List IP Reservations activity generates a list of all the DHCP range reservations on a specific InfoBlox server.

The DHCP activities use the REST web service activity template to manage IP addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Infoblox DDI > DHCP**.

**Input variables**

**DHCP List IP Reservations input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
</tbody>
</table>

*Note:* This field is mandatory. If field is empty, the orchestration activity will fail.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>view</td>
<td>Name of the Infoblox network view. The default value is default.</td>
</tr>
</tbody>
</table>

*Note:* If the field is empty, the operation is treated as happening with no view and returns the values with data from all views.
Output variables

DHCP List IP Reservations output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
</table>
| reference | Reference value for an array of DHCP address ranges in this format: \( \text{range/\langle encrypted code\rangle/\langle start range\rangle/\langle end range\rangle/} \) default |}
| network   | Address of the network containing the IP address range.                      |
| network_view | Routing domain associated with the network returned.                       |

Conditions

DHCP List IP Reservations conditions

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully returned an array of DHCP IP address ranges.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to return an array of DHCP IP address ranges.</td>
</tr>
</tbody>
</table>

Infoblox DNS activities

The Infoblox DNS activities manage DNS records in your network using an Infoblox DDI Grid Server.

Use these activities to register, list, or delete DNS records managed on an Infoblox server.

List DNS C-records activity

The List DNS C-records activity retrieves all canonical (CNAME) records from a specified Infoblox server.

The DNS activities use the REST web service activity template to manage DNS records using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > DNS.
## Input variables

### List DNS C-records input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
</tbody>
</table>

- **Note:** This field is mandatory. If field is empty, the orchestration activity will fail.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>view</td>
<td>Name of the Infoblox network view. The default value is default.</td>
</tr>
</tbody>
</table>

- **Note:** If the field is empty, the operation is treated as happening with no view and returns the values with data from all views.

## Output variables

### List DNS C-records output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
<tr>
<td>reference</td>
<td>Reference value for a DNS CNAME record, such as: record:cname/ Zg5zLmJpbmRfy25hbWUkL19kZWZhdWx0LmNvbS50ZXN0LmNuYW1l:cname.test.com/default</td>
</tr>
<tr>
<td>canonicalName</td>
<td>CNAME record.</td>
</tr>
<tr>
<td>name</td>
<td>Name of the network option returned, such as domain-name-server.</td>
</tr>
<tr>
<td>view</td>
<td>The assigned view of the DNS data. A given zone can have multiple views, which are accessed depending on the IP address of the source of the query. The default view of DNS data for this activity is the network view.</td>
</tr>
</tbody>
</table>
Conditions

List DNS C-records conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully listed the DNS C records.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to list the DNS C records.</td>
</tr>
</tbody>
</table>

Register DNS A-record activity

The Register DNS A-record activity creates a DNS A record on a specified Infoblox server.

The DNS activities use the REST web service activity template to manage DNS records using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > DNS.

Input variables

Register DNS A-record input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>network</td>
<td>Address of the network containing the IP address to register in the record.</td>
</tr>
<tr>
<td>hostName</td>
<td>Name of the actual server machine associate with the IP address in this record.</td>
</tr>
<tr>
<td>zone</td>
<td>The DNS zone associated with the record being created.</td>
</tr>
<tr>
<td>ipAddress</td>
<td>Specific IP address registered in this record.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
</tbody>
</table>

Note: This field is mandatory. If the field is empty, the orchestration activity will fail.
### Register DNS A-record input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>view</td>
<td>Name of the Infoblox network view. The default value is <strong>default</strong>.</td>
</tr>
</tbody>
</table>

**Note:** If the field is empty, the operation is treated as happening in the default view.

### Output variables

#### Register DNS A-record output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
<tr>
<td>DNSARecord</td>
<td>Name of the record registered, expressed in the format: <code>record:host/&lt;encrypted code&gt;:&lt;network name&gt;/default</code>.</td>
</tr>
</tbody>
</table>

### Conditions

#### Register DNS A-record conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully created the DNS A record.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to create the DNS A record.</td>
</tr>
</tbody>
</table>

### Register DNS C-Record activity

The Register DNS C-Record activity creates a DNS canonical (CNAME) record on a specified Infoblox server.

The DNS activities use the **REST web service activity** template to manage DNS records using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Infoblox DDI > DNS.**
### Input variables

#### Register DNS C-Record input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>cname</td>
<td>The DNS canonical record to create, as expressed by the c_name value.</td>
</tr>
<tr>
<td>recordName</td>
<td>Name of the record to create.</td>
</tr>
<tr>
<td>zone</td>
<td>The DNS zone containing the canonical record to create.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
<tr>
<td>view</td>
<td>Name of the Infoblox network view. The default value is default.</td>
</tr>
</tbody>
</table>

<i>Note:</i> This field is mandatory. If the field is empty, the orchestration activity will fail.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>view</td>
<td>Name of the Infoblox network view. The default value is default.</td>
</tr>
</tbody>
</table>

<i>Note:</i> If the field is empty, the operation is treated as happening in the default view.

### Output variables

#### Register DNS C-Record output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
<tr>
<td>DNSCRecord</td>
<td>Name of the CNAME record registered, expressed in the format: record:cname/&lt;encrypted code&gt;:&lt;network name&gt;/default.</td>
</tr>
</tbody>
</table>

### Conditions

#### Register DNS C-Record conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully created the canonical DNS record.</td>
</tr>
</tbody>
</table>
Register DNS C-Record conditions (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failure</td>
<td>Activity failed to create the canonical DNS record.</td>
</tr>
</tbody>
</table>

List DNS Record activity

The List DNS Record activity generates a list of all the DNS entries on a specific InfoBlox server.

The DNS activities use the REST web service activity template to manage DNS records using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > DNS.

Input variables

List DNS Record input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is mandatory. If field is empty, the orchestration activity will fail.</td>
</tr>
<tr>
<td>view</td>
<td>Name of the Infoblox network view. The default value is default.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the field is empty, the operation is treated as happening with no view and returns the values with data from all views.</td>
</tr>
</tbody>
</table>
Output variables

List DNS Record output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reference</td>
<td>Reference value for a DNS record, such as: record:cname/Zg5zLm3pbmRfY25hbWUkLi9kZWZhdWx0LmNvbS50ZXN0LmNvYW1l:cname.test.com/default</td>
</tr>
<tr>
<td>configure_for_dhcp</td>
<td>Returns the status of a DHCP fixed address object.</td>
</tr>
<tr>
<td>host</td>
<td>Host machine with which the DNS record is associated.</td>
</tr>
<tr>
<td>ipv4addr</td>
<td>The reserved IPv4 address associated with a DNS record.</td>
</tr>
<tr>
<td>name</td>
<td>Name of the network option returned. For example, the name of the DNS record object from the reference example is cname.test.com.</td>
</tr>
<tr>
<td>view</td>
<td>The assigned view of the DNS data. A given zone can have multiple views, which are accessed depending on the IP address of the source of the query. The default view of DNS data for this activity is the network view.</td>
</tr>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
</tbody>
</table>

Conditions

List DNS Record conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully listed all the available DNS record.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to list the available DNS record.</td>
</tr>
</tbody>
</table>

DNS Delete activity

The DNS Delete activity deletes DNS records of any type from in Infoblox server, such as C and A records.

The DNS activities use the REST web service activity template to manage DNS records using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > DNS.
**Note:** It is faster to create a new record than recover one that has been deleted.

## Input variables

### DNS Delete input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>RecordToDelete</td>
<td>Name of the DNS record to delete. The record is expressed in this format:</td>
</tr>
<tr>
<td></td>
<td>record: cname/ ZG5zLmJpbmRfY25hbWUkLl9kZWNhWx0LmNvbS50ZXN0LmNlY3NlZWQ%</td>
</tr>
<tr>
<td></td>
<td>11c.test.com/default</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is <strong>2.0</strong>.</td>
</tr>
</tbody>
</table>

*Note:* This field is mandatory. If the field is empty, the orchestration activity will fail.

## Output variables

### DNS Delete output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DeletedRecord</td>
<td>Name of the deleted DNS record.</td>
</tr>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
</tbody>
</table>

## Conditions

### DNS Delete conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully deleted the specified DNS record.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to delete the specified DNS record.</td>
</tr>
</tbody>
</table>
Infoblox IPAM activities

The Infoblox IPAM activities manage IP addresses in your network using an Infoblox DDI Grid Server.

Use these activities to register, reserve, list, or delete IP addresses.

IPAM Register IP Address activity

The IPAM Register IP Address activity registers an IP address in a network using Infoblox IPAM.

The output of this activity produces an InfoBlox IP address record that can be used for other IPAM functions in the format `fixedaddress/<encryptedkey>:<reserved ip address>/<view>`. 

The IPAM activities use the REST web service activity template to manage IP addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Infoblox DDI > IPAM**.

Input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>macAddress</td>
<td>Mac address of the computer for which this IP address is registered.</td>
</tr>
<tr>
<td>ipAddress</td>
<td>Specific IP address to register.</td>
</tr>
<tr>
<td>network</td>
<td>Address of the network containing the registered IP address.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is <strong>2.0</strong>.</td>
</tr>
</tbody>
</table>

**Note:** This field is mandatory. If the field is empty, the orchestration activity will fail.

| view               | Name of the Infoblox network view. The default value is **default**.        |
IPAM Register IP Address input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>If the field is empty, the operation is treated as happening in the default view.</td>
</tr>
</tbody>
</table>

Output variables

IPAM Register IP Address output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
<tr>
<td>IPAddressRecord</td>
<td>IPAM record of the registered IP address.</td>
</tr>
</tbody>
</table>

Conditions

IPAM Register IP Address conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully registered the specified IP address.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to register the specified IP address.</td>
</tr>
</tbody>
</table>

IPAM Reserve IP Address activity

The IPAM Reserve IP Address activity reserves an IP address in a network using Infoblox IPAM.

The output of this activity produces an InfoBlox IP address record that can be used for other IPAM functions in the format fixedaddress/<encrypted key>:<reserved ip address>/<view>.

The IPAM activities use the REST web service activity template to manage IP addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > IPAM.
Input variables

### IPAM Reserve IP Address input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>macAddress</td>
<td>Mac address of the computer for which this IP address is reserved.</td>
</tr>
<tr>
<td>network</td>
<td>Address of the network containing the reserved IP address. The Infoblox server reserves the next available IP address from this network.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is <strong>2.0</strong>.</td>
</tr>
<tr>
<td>view</td>
<td>Name of the Infoblox network view. The default value is <strong>default</strong>.</td>
</tr>
</tbody>
</table>

**Note:** This field is mandatory. If the field is empty, the orchestration activity will fail.

### Output variables

### IPAM Reserve IP Address output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
<tr>
<td>IPAddressRecord</td>
<td>IPAM record of the reserved IP address.</td>
</tr>
<tr>
<td>IPAddress</td>
<td>Selected IP address to reserve.</td>
</tr>
</tbody>
</table>
Conditions

### IPAM Reserve IP Address conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully reserved the specified IP address.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to reserve the specified IP address.</td>
</tr>
</tbody>
</table>

### IPAM List IP Reservations activity

The IPAM List IP Reservations activity returns an array of all IP Address within the named InfoBlox Server.

The IPAM activities use the REST web service activity template to manage IP addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > IPAM.

### Input variables

#### IPAM List IP Reservations input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints.</td>
</tr>
<tr>
<td></td>
<td>The default value is <strong>2.0</strong>.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field is mandatory. If field is empty, the orchestration activity will fail.</td>
</tr>
<tr>
<td>view</td>
<td>Name of the Infoblox network view. The default value is <strong>default</strong>.</td>
</tr>
<tr>
<td>Note:</td>
<td>If the field is empty, the operation is treated as happening with no view and returns the values with data from all views.</td>
</tr>
</tbody>
</table>
Output variables

The output of this activity produces an array of reserved IP addresses in the format fixedaddress/<encrypted key>:<reserved ip address>/view.

IPAM List IP Reservations output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reference</td>
<td>Reference value of a reserved IP address contained in an array of addresses, such as fixedaddress/2G5zLmZpeGVkX2FkJc3MkMTAuMC4xMDMuMTEuMC4u:0.0.0.11/default&quot; ipv4addr: &quot;0.0.0.11&quot;</td>
</tr>
<tr>
<td>ipv4addr</td>
<td>The reserved IPv4 address.</td>
</tr>
<tr>
<td>network_view</td>
<td>Routing domain associated with the network returned.</td>
</tr>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
</tbody>
</table>

Conditions

IPAM List IP Reservations conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully retrieved the list of reserved IP addresses from the Infoblox server.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to retrieve the list of reserved IP addresses from the Infoblox server.</td>
</tr>
</tbody>
</table>

IPAM Delete activity

The IPAM Delete activity deletes an IP Address within a named InfoBlox server.

The IPAM activities use the REST web service activity template to manage IP addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > IPAM.
**Input variables**

### IPAM Delete input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>itemToDelete</td>
<td>The IP address to delete, in the format <code>fixedaddress/&lt;encrypted key&gt;:&lt;reserved ip address&gt;/&lt;view&gt;</code>.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is <strong>2.0</strong>.</td>
</tr>
</tbody>
</table>

**Note:** This field is mandatory. If the field is empty, the orchestration activity will fail.

**Output variables**

### IPAM Delete output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DeletedRecord</td>
<td>IPAM record of the deleted IP address.</td>
</tr>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
</tbody>
</table>

**Conditions**

### IPAM Delete conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully deleted the specified IP address.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to delete the specified IP address.</td>
</tr>
</tbody>
</table>

**Infoblox network activities**

The Infoblox network activities manage networks using an Infoblox DDI Grid Server.

Use these activities to create, list, or delete networks on an Infoblox server.
Create Network activity

The Create Network activity creates new networks on a specified Infoblox server.

The network activities use the REST web service activity template to manage network addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > Network.

Input variables

Create Network input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>network</td>
<td>Address of the network to create.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
</tbody>
</table>

ℹ️ **Note:** This field is mandatory. If the field is empty, the orchestration activity will fail.

| view               | Name of the Infoblox network view. The default value is default. |

ℹ️ **Note:** If the field is empty, the operation is treated as happening in the default view.

Output variables

Create Network output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NetworkCreated</td>
<td>Address of the network created.</td>
</tr>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
</tbody>
</table>
Conditions

Create Network conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully created the network.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to create the network.</td>
</tr>
</tbody>
</table>

Get Network Details activity

The Get Network Details activity retrieves the information about a specific network on an Infoblox server.

The network activities use the REST web service activity template to manage network addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > Network.

Input variables

Get Network Details input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>network</td>
<td>Address of the network whose details you want to see.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
</tbody>
</table>

<i>Note: This field is mandatory. If the field is empty, the orchestration activity will fail.</i>

| view | Name of the Infoblox network view. The default value is default. |
|      | <i>Note: If the field is empty, the operation is treated as happening in the default view.</i> |
Output variables
The output variables from this activity are objects on the Infoblox server used to identify network details. For more information, refer to the Infoblox documentation.

Get Network Details output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
<tr>
<td>NetworkOptions</td>
<td>The <code>NetworkOptions</code> array contains these attributes:</td>
</tr>
<tr>
<td></td>
<td>• <strong>reference</strong>: Reference value for the network requested. This value is in the form of <code>network/</code> ZG5zLm5ldHdvcmshMTA5Lw4wLjAvMTYvMA:10.1.0.0%2F1</td>
</tr>
<tr>
<td></td>
<td>• <strong>options</strong>: The <code>options</code> array contains these attributes:</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>name</strong>: Name of the network option returned, such as <code>domain-name-server</code>.</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>num</strong>: Index number of the option. For example, the index for <code>domain-name-server</code> is 6.</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>use_option</strong>: Indicates whether a DHCP option is used at that level in the network heirarchy. Set this value to <code>True</code> to override the Grid Level DHCP option with this option at the network level.</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>value</strong>: Value to use for this option. For example, the value for the <code>domain-name-server</code> option is the IP address of the server machine.</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>vendor_class</strong>: The class of the network object. The options are <code>DHCP</code>, <code>DNS</code>, or <code>IPAM</code>.</td>
</tr>
</tbody>
</table>

Conditions

Get Network Details conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully retrieved network details from the Infoblox server.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to retrieve network details from the Infoblox server.</td>
</tr>
</tbody>
</table>
Delete Network activity

The Delete Network activity deletes a network from an Infoblox server.

The network activities use the REST web service activity template to manage network addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > Network.

Input variables

Delete Network input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>networkToDelete</td>
<td>Reference number of the network to delete from the Infoblox server. You can obtain this value either by using the List Registered Networks activity or when creating a network with the Create Network activity. An example of the network reference value is: network/ZG5zLm5ldHdvcm5kMTUuMC40NS4wLzI0LzA:15.0.45.0/24/default.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
</tbody>
</table>

ℹ️ Note: This field is mandatory. If the field is empty, the orchestration activity will fail.

Output variables

Delete Network output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DeletedNetwork</td>
<td>Reference number of the deleted network from the Infoblox server.</td>
</tr>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
</tbody>
</table>
Conditions

**Delete Network conditions**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully deleted the network.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to delete the network.</td>
</tr>
</tbody>
</table>

**List Registered Networks activity**

The List Registered Networks activity retrieves all the networks associated with an Infoblox server.

The network activities use the [REST web service activity template](#) to manage network addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Infoblox DDI > Network**.

**Input variables**

**Activity input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
<tr>
<td>view</td>
<td>Name of the Infoblox network view. The default value is default.</td>
</tr>
</tbody>
</table>

**Note:** This field is mandatory. If field is empty, the orchestration activity will fail.

**Note:** If the field is empty, the operation is treated as happening with no view and returns the values with data from all views.
Output variables

Activity output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reference</td>
<td>Reference value of a registered network.</td>
</tr>
<tr>
<td>network</td>
<td>Network address.</td>
</tr>
<tr>
<td>network_view</td>
<td>Routing domain associated with the network returned.</td>
</tr>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
</tbody>
</table>

Conditions

Activity conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully retrieved the list of registered networks available on the Infoblox server.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to retrieve the list of registered networks available on the Infoblox server.</td>
</tr>
</tbody>
</table>

PowerShell activity pack

PowerShell is built on the Windows .NET Framework and is designed to control and automate the administration of Windows machines and applications.

Orchestration provides custom PowerShell activities that were created with the PowerShell activity designer template. These activities perform the same functions as PowerShell activities by the same name from previous releases and replace those activities for all new workflows. These custom activities give workflow administrators the ability to store input and output variables in the databus.

Note: Existing workflows from earlier versions that were created with legacy PowerShell activities continue to function normally after an upgrade to Geneva. However, all new workflows must use these custom PowerShell activities.

Starting with the Rome release, there are the following updates to the PowerShell activity pack:
• A new PowerShell probe (V2), which takes advantage of IntegrationHub functionality

• The ability to insert debug statements in the PowerShell scripts and produce the resulting messages at runtime

To use the PowerShell custom activities, you must request activation of the Orchestration - PowerShell plugin. These activities are available in the Workflow Editor on the Custom tab. Expand the Custom Activities tree and select the PowerShell category for the activity you want to use.

ServiceNow supports PowerShell 3.0 to 5.1.

PowerShell activity designer
PowerShell activities are configured to return data to a workflow from a host using Microsoft PowerShell.

You must purchase Orchestration to use this template. For specific information about using the tools in the activity designer, refer to these resources:

• Orchestration activity designer

• Create input variables

• Create a parsing rule

ServiceNow supports PowerShell 3.0 to 5.1.

PowerShell protocols and troubleshooting
PowerShell uses the Windows Management Instrumentation (WMI) and Windows Remote Management (WinRM) protocols to enable Orchestration activities to run commands on remote Windows hosts.

Windows Management Instrumentation (WMI)
WMI provides a uniform interface for any local or remote applications or scripts that obtain management data from a computer system, a network, or an enterprise. WMI contains these components:

• Managed objects and WMI providers: A WMI provider is a COM object that monitors one or more managed objects for WMI. A managed object is a logical or physical enterprise component, such as a hard disk drive, network adapter, database system, operating system, process, or service.

• WMI infrastructure: The WMI infrastructure is a Microsoft Windows operating system component known as the WMI service (winmgmt). The WMI infrastructure is composed of the WMI Core and the WMI repository. The
WMI repository is organized by WMI namespaces. The WMI service creates namespaces, such as root\default, root\cimv2, and root\subscription, at system startup and preinstalls a default set of class definitions, including the Win32 Classes, the WMI System Classes, and others. The remaining namespaces found on your system are created by providers for other parts of the operating system or products.

• **WMI consumers**: A WMI consumer is a management application or script that interacts with the WMI infrastructure. A management application can query, enumerate data, run provider methods, or subscribe to events by calling either the COM API or the Scripting API for WMI.

**WMI installation and configuration**

For the MID Server to successfully make a remote connection to the target host, TCP port 135 must be open. The Windows firewall automatically creates an inbound rule for WMI connectivity called Windows Management Instrumentation (DCOM-In).

**Windows Remote Management (WinRM)**

WinRM is the Microsoft implementation of WS-Management Protocol, a standard Simple Object Access Protocol (SOAP) protocol that allows hardware and operating systems from different vendors to interoperate.

WinRM contains these components:

• **WinRM Scripting API**: This scripting API enables Orchestration to obtain data from remote computers, using scripts that perform WS-Management protocol operations.

• **WMI Service**: The WMI service continues to run side-by-side with WinRM and provides requested data or control through the WMI plug-in. You can continue to obtain data from standard WMI classes, such as as Win32_Process.

**WinRM configuration**

WinRM is automatically installed on Windows 2008 R2 and above operating systems, but must be configured before use.

1. In a command prompt, enter `winrm quickconfig`. This command is not case sensitive.

2. When the console displays **Make these changes [y/n]?:**, enter `y`.

The `winrm quickconfig` command performs the following operations:
• Starts the WinRM service, and sets the service startup type to **auto start**.
• Configures a listener for the ports that send and receive WS-Management protocol, using either HTTP or HTTPS on any IP address.
• Creates a firewall exception for the current user profile.

**MID Server PowerShell files**

PowerShell functions are stored in script files (*.ps1) that use a PowerShell Script module (*.psm1) file name extension.

The PowerShell functions are used by the PowerShell MID Server script files included in these activity packs:

- Active Directory
- Exchange
- SCCM
- PowerShell

**PSScript.ps1**

This script performs a few tasks, such as credential testing, password encryption, and the execution of scripts configured in the Orchestration Activity Designer or in MID Script Files. However, this document focuses on how PSScript.ps1 uses the **credential.psm1** module for testing access to remote hosts.

The PowerShell variables are generally used directly in the **PowerShell execution command** or as arguments in the MID Server script file you specify. There are special variables that are passed to PSScript.ps1, such as **credType**.
Using credType in execution parameters

PowerShell credTypes

The PowerShell credential types:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WMI</td>
<td>testCredentialWMI</td>
</tr>
<tr>
<td>Exchange</td>
<td>testCredentialExchange</td>
</tr>
<tr>
<td>AD</td>
<td>testCredentialAD</td>
</tr>
<tr>
<td>SCCM</td>
<td>testCredentialSCCM</td>
</tr>
</tbody>
</table>

If no credential type is passed to the PSScrip.ps1 script, the MID Server defaults to the WMI test function to test access to the target host. If there is a credential type used, the MID Server runs the corresponding test function for that credential type.

Exit codes

These exit codes are returned from the PSScript.ps1 script and logged in the MID Server log file.
## PSScript.ps1 exit codes

<table>
<thead>
<tr>
<th>Type</th>
<th>Test function</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>PowerShell command/script ran successfully.</td>
</tr>
<tr>
<td>1</td>
<td>Test finished successfully, but the command/script failed to execute.</td>
</tr>
<tr>
<td>2</td>
<td>Incorrect syntax passed to script.</td>
</tr>
<tr>
<td>3</td>
<td>All credentials including MID Server service account failed to execute the command/script.</td>
</tr>
<tr>
<td>4</td>
<td>Passed test and executed the activity, but an error was returned. Example user cannot be found.</td>
</tr>
</tbody>
</table>

## DiagnosticsUtil.psm1

The MID Server uses this module file to perform PowerShell logging that assists debugging any Orchestration activity using PowerShell scripting. You can also add debugging statements directly to custom scripts.

### PowerShell diagnostic utilities

<table>
<thead>
<tr>
<th>Utility</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNCLog-DebugInfo</td>
<td>Log a debug message for a PowerShell script or PowerShell Orchestration activity. Examples:</td>
</tr>
<tr>
<td></td>
<td>• SNCLog-DebugInfo -message &quot;My debug message...&quot;</td>
</tr>
<tr>
<td></td>
<td>• SNCLog-DebugInfo &quot;My debug message&quot;</td>
</tr>
<tr>
<td>SNCLog-ParameterInfo</td>
<td>Log a function parameter value. For &quot;function getHostName( param( [String] $target )&quot;, the first value to the PowerShell hashtable is a string to indicate which function executes, and the values for each of the function parameters. Examples:</td>
</tr>
</tbody>
</table>
### PowerShell diagnostic utilities (continued)

<table>
<thead>
<tr>
<th>Utility</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Function with single parameter:</td>
</tr>
<tr>
<td></td>
<td>SNCLog-ParameterInfo @(&quot;Running getHostName&quot;, $target)</td>
</tr>
<tr>
<td></td>
<td>️ Note: The debug message shows, 'Running getHostName $target: [actual value of $target]'</td>
</tr>
<tr>
<td></td>
<td>• Function with multiple parameters:</td>
</tr>
<tr>
<td></td>
<td>SNCLog-ParameterInfo @(&quot;Running functionName&quot;, $param1, $param2, $param3)</td>
</tr>
<tr>
<td>SNCObfuscate-Value</td>
<td>Use this utility to encrypt values for security purposes. The function displays &quot;$variableName&quot;:***, where *** is the obfuscated value. Example:</td>
</tr>
<tr>
<td></td>
<td>• SNCObfuscate-Value $password</td>
</tr>
<tr>
<td></td>
<td>️ Note: The debug message reads: &quot;$password : ***&quot;</td>
</tr>
</tbody>
</table>

### Credentials.psm1

The MID Server uses this module file to test access to a target host. The MID Server loops through all Windows credentials stored in its credentials table using the following access type functions, unless the PowerShell activity has a credential type (credType) defined. All ServiceNow® authored PowerShell activities are hard-coded to use a specific credential type. As a result, the MID Server only tests credential access against the designated function.

### PowerShell test functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>testCredentialWMI</td>
<td>Tests the given user and password on the target host using the Get-WMI object.</td>
</tr>
</tbody>
</table>
### PowerShell test functions (continued)

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>testCredentilAD</td>
<td>Tests the given user and password on the target host using the built-in DirectoryEntry object.</td>
</tr>
<tr>
<td>testCredentialExchange</td>
<td>Tests the given user and password to create a session on an Exchange host. This test uses the built-in PowerShell remoting feature on a remote host. WinRM is configured on Exchange servers by default.</td>
</tr>
<tr>
<td>testCredentialSCCM</td>
<td>Tests the given user and password to create a session on an SCCM server. This test uses the built-in PowerShell remoting feature on a remote host. This test requires WinRM to be configured.</td>
</tr>
<tr>
<td>testNoCredentialAccessWMI</td>
<td>Tests the given user and password on the target host, using the Get-WMI object. This test is used when no credType is used.</td>
</tr>
</tbody>
</table>

**Note:** If the test passes using one of these functions, that credential is used to run the PowerShell script/command. If the tests fail to access the target host using these functions, the MID Server runs the PowerShell script/command under the account of the MID Server service.

This diagram illustrates the dependency of the credential selection behavior on the host being targeted by the PowerShell activity. If the target host is the IP address or host name of the MID Server, the MID Server bypasses all credentials in the Credentials table and uses the account of the MID Server service. If the target host is not the MID Server, then all Windows credentials are used first. If all credentials in the Credentials table are unsuccessful in running the PowerShell activity, then the MID Server uses the MID Server service account.
**PowerShell credential selection criteria**

![Flowchart of PowerShell credential selection criteria]

**ActiveDirectory.psm1**

This module file stores the functions used by the PowerShell scripts shipped with the Active Directory activity pack.

**Exchange.psm1**

This module file stores the functions used by the PowerShell scripts shipped with the Exchange activity pack.

**SCCM.psm1**

This module file stores the functions used by the PowerShell scripts shipped with the SCCM activity pack.

**Set up credential tags for a PowerShell activity**

Credential tagging gives an administrator more control over the credentials used in a PowerShell activity.

**Before you begin**

Role required: admin, activity_creator or workflow_admin
About this task
Tagging is useful when the activity requires specific credentials to perform a task. By populating the **Credential tag** field you are telling the activity to use a credential that has a specific tag set for it. Additionally, credential tagging allows you to use a different underlying credential in development, testing, and production systems without having to change the activity for a given target system. For example, you can use the **SCCMCred** tag and have it point to both a development and test instance.

Procedure
1. Navigate to **Orchestration > Credentials**.
2. Select the credential you want to tag.
3. Enter a unique name in the **Tag** field that is descriptive of the credentials purpose.

4. Click **Update**.
5. Open the Workflow Editor and select the PowerShell activity you want to tag.
6. In the activity's Execution Command, add the name of the tag you created to the **Credential tag** field.

**PowerShell troubleshooting**

Authentication and access denied errors can prevent PowerShell activities from running a command on a target host.

Use these procedures for troubleshooting authentication failures with Orchestration PowerShell activities and when the Remote Procedure Call (RPC) server is unavailable or when access is denied. The authentication failure error displays when all credentials, including those of the local MID Server service account, do not have the correct permissions to run the Powershell script/command. The same error displays when the target host is unreachable.
Authentication failure in an Active Directory activity

This example uses the Create AD Object activity to illustrate troubleshooting authentication failure in PowerShell.

Before you begin
Role required: Permissions to access and create accounts on Active Directory

About this task
Validate that the account you are using has the proper permissions to run the activity.

Procedure
1. Log on to the target machine using the account under which you want to run the activity.
   Active Directory tools must be installed on this machine.
2. Launch the Active Directory Users and Computers application.
3. Navigate to the OU under which you want to create the Active Directory object.
4. Attempt to create the object.
   If this procedure is successful under the specified user, the following might be the cause of the authentication failure:
• User name is invalid.
• Password entered incorrectly.
• Domain controller is unreachable.

⚠️ Note: The majority of the return codes listed in the MID Server log for this error are 1s and 3s. This is because the Active Directory activities use the ADSI provider and not WMI or WinRM. An error code of 1 means the account was able to connect with the test account, but running the script failed.

An error code of 3 means that the MID Server attempted to run the PowerShell activity under the MID Server service account but failed.

Authentication failure in an Exchange activity

This example uses the Create Mailbox activity to illustrate troubleshooting authentication failure in PowerShell.

Before you begin

Role required: Permissions to access and create mailboxes on the Exchange server

Procedure

1. Validate that the account you are using has the proper permissions to run the PowerShell activity.
2. Log on to a machine that has the Exchange Management Shell (EMS) installed.
3. Create a user using the New-mailbox Exchange commandlet.
Creating a new user in Exchange

If this procedure is successful under the specified credential, the following is the likely cause of the failure:

- User name is invalid.
- Password entered incorrectly.
- Exchange server is unreachable.

4. If the Exchange server is unreachable, examine the MID Server logs. Because the Exchange activities use WinRM to access the Exchange server, the logs can provide more troubleshooting information.

![Code Snippet]

Note: Ensure that the error is NOT WinRM cannot process the request.

Remote Procedure Call (RPC) server unavailable or access denied

Typically, this error is logged when running a PowerShell script/command that uses WinRM or WMI.

Possible causes of error

The target host might have one of these issues:

- WinRM isn’t configured.
- Firewall is blocking access to the host over TCP port 135 (WMI) or HTTP/HTTPS and TCP port 5985 (WinRM).
- Kerberos issue, caused by hopping to multiple hosts using WMI.

Example WinRM error

The Create Mailbox activity from the Exchange activity pack has generated an error in the ECC queue involving authentication using the MID Server service credential. This occurred because the MID Server credential is the last to be used if the targeted host is not the MID Server.
Authentication failure error message

The MID Server log shows that the MID Server tried to run the activity under specific credentials, but wasn’t successful and received an exit code of **1**.

**MID Server error code**

```
Attempting to use credential with username 'service-now\joel.zamalloa'
Running command: -> C:\Windows\System32\WindowsPowerShell\v1.0\powershell.exe -executionpolicy bypass -PSscript.ps1 -computer '10.33.129.140' -script 'C:\Users\joel.zamalloa.adm\Desktop\PS\script.ps1' -usecred $true -isDiscovery $false -debug $true; exit $LASTEXITCODE'
Thread name is Powershell is executing...

... Gobbled: [10.33.129.140] connecting to remote server failed with the following error messag... Gobbled: : The WMI client cannot process the request. Default authentication may... Gobbled: be used with an IP address under the following conditions: the transport is HTTP... Gobbled: ps or the destination is in the trustedhosts list, and explicit credentials are... Gobbled: provided. Use winrm cmd to configure trustedhosts. Note that computers in the... Gobbled: Trustedhosts list might not be authenticated. For more information on how to set... Gobbled: on, see the about_Remote_Troubleshooting Help topic.

... Gobbled: - CategoryInfo : OpenError : (System.Managem...RemoteRunspace:Rem... Gobbled: : FullyQualifiedErrorId : PSSessionOpenFailed

The exit value from WaitFor() is 1
The status code returned from running the command is 1 windows credentials all failed... attempting to use the credential from the local MID server.
```

**Join Domain activity**

The Join Domain activity joins a Windows computer to a domain.

If the computer is already a member of a domain, this activity completes without modifying the computer. Joining a domain requires a username and password. This user must have domain administration privileges or privileges to join a computer to the domain.

**Note:** This activity replaces a Powershell activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.
Input variables

Join Domain input variables

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>Hostname or IP address of the Windows server that is joining the domain.</td>
</tr>
<tr>
<td>Domain</td>
<td>Name of the domain to join.</td>
</tr>
<tr>
<td>Domain_user</td>
<td>The name of a user who has domain administration privileges or privileges to join a computer to the domain.</td>
</tr>
<tr>
<td>Domain_user_password</td>
<td>The password for the user who has domain administration privileges or privileges to join a computer to the domain.</td>
</tr>
</tbody>
</table>

Output variables

Join Domain output variables

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources. If this variable is not null, the operation has failed.</td>
</tr>
</tbody>
</table>

Conditions

Join Domain conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in joining the computer to the domain.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to join the computer to the domain.</td>
</tr>
</tbody>
</table>

Install Windows App activity

The Install Windows App activity installs an application from an MSI package on a Windows target machine.
**Note:** This activity replaces a Powershell activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

### Input variables

**Install Windows App input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>Hostname or IP address of the target Windows machine on which the service is installed. Use the Resolve DNS MID Server capability to resolve hostnames into IP addresses.</td>
</tr>
<tr>
<td>installpath</td>
<td>Path to the installer. The installer can be on any machine that is visible to both the MID Server and the target machine (local drive, UNC path, mapped drive, etc.).</td>
</tr>
<tr>
<td>installer</td>
<td>Name of the installer file, such as winzip150.msi. The installer must be an MSI package.</td>
</tr>
<tr>
<td>arguments</td>
<td>The parameter that contains the command line arguments to the MSI package. These are name=value pairs, separated by a space. For example, the argument might appear as: INSTALLDIR=c:\myinstallfolder ADDDESKTOPICON=0. These arguments are dependent on what the actual MSI being installed defines. If there are no arguments, leave the field empty.</td>
</tr>
</tbody>
</table>

### Output variables

**Install Windows App output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either <strong>success</strong> or <strong>failure</strong>.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The <strong>executionResult.errorMessages</strong> from the Activity designer parsing sources.</td>
</tr>
</tbody>
</table>

### Conditions

The activity state tells the workflow engine what to do with the activity.
Install Windows App conditions

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The Windows application was successfully installed on the target machine.</td>
</tr>
<tr>
<td>Failure</td>
<td>The Windows application failed to install on the target machine</td>
</tr>
</tbody>
</table>

Enable WMI Windows Installer provider

To install software on Windows machines using the Install Windows App activity, enable WMI Windows Installer provider on all target machines.

Before you begin

- It is recommended that the MID Server, the target machine, and the installer source machine be on the same Active Directory domain. However, if these computers are on separate domains, those domains must have a trust relationship established between them.

- If the installer path is a UNC file sharing machine, the Active Directory account of the target computer must be trusted for delegation. For instructions on this configuration, see the posting on the community for installing and uninstalling Windows applications.

About this task

**Note:** See WMI Providers for a list of Windows operating systems that provide this tool by default.

Procedure

1. Open the Control Panel.
2. Go to Add or Remove Programs.
3. Select Add/Remove Windows Components.
   This action opens a secondary window displaying additional selections.
5. Select WMI Windows Installer Provider check box.
6. Click OK to return to the Windows Components Wizard window.
7. Click Next.
   You might be asked for the Windows installation CD to complete this process.
**Change Service State activity**

The Change Service State activity starts or stops a Windows service on a remote system.

This activity replaces a Powershell activity by the same name available in releases prior to Istanbul. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Istanbul. However, all new workflows must use the custom version of this activity. This activity was built with the Powershell activity template, which gives workflow administrators the ability to store input and output variables in the databus.

**Input Variables**

**Change Service State input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>Hostname or IP address of the target Windows machine on which the service is installed. Use the Resolve DNS activity to resolve hostnames into IP addresses.</td>
</tr>
<tr>
<td>service</td>
<td>Name of the Windows service to start or stop. The service parameter is the service name, not the display name of the service affected.</td>
</tr>
<tr>
<td>state</td>
<td>There are two actions to select for a service state change: <strong>StartService</strong> or <strong>StopService</strong>.</td>
</tr>
</tbody>
</table>

**Output variables**

**Change Service State output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>errorMessage</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources. If there is no error, this value is null.</td>
</tr>
</tbody>
</table>
Conditions

Change Service State conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The target service was successfully started or stopped.</td>
</tr>
<tr>
<td>Failure</td>
<td>The update to the target service was unsuccessful, or the service was not found on the target system.</td>
</tr>
</tbody>
</table>

Restart Windows Server activity

The Restart Windows Server activity stops and then restarts a Windows server using Powershell.

⚠️ Note: This activity replaces a Powershell activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the Powershell activity template, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Restart Windows Server input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>Hostname or IP address of the Windows server to restart.</td>
</tr>
</tbody>
</table>

Output variables

Restart Windows Server output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources. If this variable is not null, the operation has failed.</td>
</tr>
</tbody>
</table>
Conditions

Restart Windows Server conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in restarting the Windows server.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to restart the Windows server.</td>
</tr>
</tbody>
</table>

Uninstall Windows App activity

The Uninstall Windows App activity uninstalls an application from a Windows target machine.

The only applications that can be uninstalled using this activity are those that were installed by a Windows Installer.

⚠️ **Note:** This activity replaces a Powershell activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the **Powershell activity template**, which gives workflow administrators the ability to store input and output variables in the **databus**.

Input variables

Uninstall Windows App input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>Hostname or IP address of the Windows target machine on which to uninstall an application.</td>
</tr>
<tr>
<td>product</td>
<td>The name of the application to uninstall exactly as it appears in the Windows Add/Remove Programs list.</td>
</tr>
</tbody>
</table>

Output variables

Uninstall Windows App output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either <em>success</em> or <em>failure</em>.</td>
</tr>
</tbody>
</table>
Uninstall Windows App output variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>errorMessage</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources. If this variable is not null, the operation has failed.</td>
</tr>
</tbody>
</table>

Conditions

Uninstall Windows App conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in uninstalling the application from the Windows server.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to uninstall the application from the Windows server.</td>
</tr>
</tbody>
</table>

Probe activity pack

Orchestration provides an activity pack customized using the ServiceNow activity designer that runs probes on target hosts to return specific information.

These custom activities were built with the Create a probe activity, which gives workflow administrators the ability to store input and output variables in the databus.

To use the custom probe activities, you must request activation of the Orchestration - Probe plugin.

Resolve DNS Name activity

The Resolve DNS Name activity takes an IP address or a fully qualified domain name (FQDN), which it resolves into one or more IP addresses.

The domain name is sent through the MID Server to the domain name system (DNS) to resolve the name. If a single IP address is returned, it is stored in two variables: `resolved_ip` and `resolved_ips`. If multiple IP addresses are returned, the first IP address is stored in the `resolved_ip` variable, and all the addresses are stored in the `resolved_ips` variable. If an IP address is provided instead of an FQDN, this address is output directly to both variables. Your ServiceNow instance must have access to a MID Server configured to use Resolve DNS to run this activity.
This activity replaces an activity by the same name available in releases prior to Istanbul. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Istanbul. However, all new workflows must use the custom version of this activity. This activity was built with the Probe activity template, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

**Resolve DNS Name input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FQDN</td>
<td>The fully qualified domain name to resolve or an IP address.</td>
</tr>
</tbody>
</table>

Output variables

**Resolve DNS Name output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ip</td>
<td>The first IP address of the resolved DNS name.</td>
</tr>
<tr>
<td>ips</td>
<td>Comma separated list of resolved IP addresses.</td>
</tr>
</tbody>
</table>
| result   | One of the following:  

- **resolved**: Able to resolve the specified DNS name.  
- **unresolved**: Unable to resolve the specified DNS name. |

Conditions

**Resolve DNS Name conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully resolved the DNS name.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to resolve the DNS name.</td>
</tr>
</tbody>
</table>
SNMP Query activity

The SNMP Query activity queries an SNMP device.

Your ServiceNow instance must have access to a MID Server configured to use SNMP to run this activity.

This activity replaces an activity by the same name available in releases prior to Istanbul. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Istanbul. However, all new workflows must use the custom version of this activity. This activity was built with the Probe activity template, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

<table>
<thead>
<tr>
<th>SNMP Query input variables</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Variable</strong></td>
</tr>
<tr>
<td>hostname</td>
</tr>
<tr>
<td>oids</td>
</tr>
</tbody>
</table>

Output variables

<table>
<thead>
<tr>
<th>SNMP Query output variables</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Variable</strong></td>
</tr>
<tr>
<td>description</td>
</tr>
<tr>
<td>timeout</td>
</tr>
<tr>
<td>error</td>
</tr>
<tr>
<td>oid_data</td>
</tr>
</tbody>
</table>
Conditions

SNMP Query conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully ran the query on the target device.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to run the query on the target device. Failure could be caused by invalid credentials or a device that is not accessible.</td>
</tr>
</tbody>
</table>

SCCM activity pack

The Microsoft System Center Configuration Management (SCCM) activity pack provides Orchestration activities you can use to manage software deployments and collections on an SCCM server.

You can use SCCM Orchestration activities to deploy and revoke software from an SCCM server or manage user and device collections. The system manages software on an SCCM server using Orchestration activities and workflows.

Client software distribution requires:

- SCCM 2012 R2 and later.
- Powershell 3.x.
- Powershell Remoting enabled.
- The Windows PowerShell x86 execution policy must be set to unrestricted mode.
- Latest version of the SCCM cmdlet library installed on the SCCM server.
- Use the credentials to log onto the SCCM Server and connect via Windows PowerShell from the System Center Configuration Manager console at least once to set the path variable for that credential.

Request SCCM activities

The Orchestration - System Center Configuration Manager plugin installs the SCCM activity pack that deploys software from an SCCM host and manages user and device collections.

Before you begin

Role required: admin
About this task

The SCCM plugin is activated automatically when the Orchestration - Client Software Distribution [com.snc.orchestration.sccm_mgnt] plugin is activated, but can be activated separately.

Note: The activities in the SCCM plugin run in the System Center Configuration Manager scope.

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.
4. On the form, fill in the fields.
Activate Plugin request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>this plugin to be enabled</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

| Reason/Comments                            | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments. |

5. Click **Submit**.

Configure the MID Server for SCCM activities

To use a MID Server with Microsoft System Center Configuration Management (SCCM) activities, configure it to communicate with the SCCM server.

**Before you begin**
Role required: admin

**Procedure**
1. In the navigation filter, enter `cmdb_ci_dns_name.list`.
2. Click **New**.
3. Enter the fully-qualified domain name (FQDN) of the SCCM server in the **Name** field.
4. Right-click in the form header and select **Save**.
5. In the **IP Address** related list, click **New**.
6. In the **IP Address** field, enter the IP address of the SCCM server.
7. In the **Nic** field, select **eth0** or your preferred network interface controller.
8. Leave the **Netmask** field blank.
9. Click **Submit**.

### Add to Device Collection activity

The Add to Device Collection activity adds the specified device into a Microsoft System Center Configuration Manager (SCCM) device collection.

The Add to Device Collection activity uses the **Powershell activity template** to add a specified device to an SCCM device collection. The activity is configured to use a MID Server with Powershell capabilities and to run a MID Server script called **AddToDeviceCollection.ps1** to edit the collection.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > System Center Configuration Manager (SCCM)**.

**Note:** The Add to Device Collection activity does not use pre-processing or post processing scripts.

### Input variables

#### Add to Device Collection input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
<tr>
<td>collection</td>
<td>Name of the device collection.</td>
</tr>
<tr>
<td>device</td>
<td>Name of the device to add to the collection.</td>
</tr>
</tbody>
</table>
Output variables

Add to Device Collection output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>output</td>
<td>Variable that contains a value that is passed to other activities in the workflow.</td>
</tr>
<tr>
<td>error</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>

Conditions

Add to Device Collection conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully added the device to the SCCM device collection.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to add the device to the SCCM device collection.</td>
</tr>
</tbody>
</table>

Add to User Collection activity

The Add to User Collection activity adds a user to a Microsoft System Center Configuration Manager (SCCM) user collection.

The Add to User Collection activity uses the Powershell activity template to access the SCCM server. The activity is configured to use a MID Server with Powershell capabilities and to run a MID Server script called AddToUserCollection.ps1 to edit the collection.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > System Center Configuration Manager (SCCM).

Note: The Add to User Collection activity does not use pre-processing or post processing scripts.

Input variables

Add to User Collection input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
</tbody>
</table>
Add to User Collection input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>collection</td>
<td>Name of the user collection.</td>
</tr>
<tr>
<td>user</td>
<td>Name of the user to add to the collection.</td>
</tr>
</tbody>
</table>

Output variable

Add to User Collection output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>output</td>
<td>Variable that contains a value that is passed to other activities in the workflow.</td>
</tr>
<tr>
<td>error</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>

Conditions

Add to User Collection conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully added a user to the SCCM user collection.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to add a user to the SCCM user collection.</td>
</tr>
</tbody>
</table>

Get Applications activity

The Get Applications activity returns a list of all the applications available on a Microsoft System Center Configuration Manager (SCCM) server.

The Get Applications activity uses the Powershell activity template to access the applications on the SCCM server. The activity is configured to use a MID Server with Powershell capabilities and to run a MID Server script called GetApplications.ps1. This script filters the results of the GET, so that only specific attributes are returned for the applications on the SCCM server. Filtering the results in this manner controls the size of the payload, while providing the most desirable application data. The list of available applications is returned as an array in a JSON object.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > System Center Configuration Manager (SCCM).

Note: The Get Applications activity does not use a pre-processing script.
Input variables

Get Applications input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
</tbody>
</table>

Output variables

The output variables for the Get Applications activity contain an array of objects called `applications` and an error message. Each object in the array contains the attributes in this table.

Get Applications output variables

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>applications</td>
<td>The <code>applications</code> array contains these attributes:</td>
</tr>
<tr>
<td></td>
<td>• <code>id</code>: Primary key of the SCCM application.</td>
</tr>
<tr>
<td></td>
<td>• <code>ciUniqueId</code>: Unique ID of the SCCM application.</td>
</tr>
<tr>
<td></td>
<td>• <code>name</code>: Name of the application.</td>
</tr>
<tr>
<td></td>
<td>• <code>manufacturer</code>: Manufacturer of the application.</td>
</tr>
<tr>
<td></td>
<td>• <code>version</code>: Version of the application.</td>
</tr>
<tr>
<td></td>
<td>• <code>isDeployable</code>: True/false value indicating if this application is deployable.</td>
</tr>
<tr>
<td></td>
<td>• <code>isDeployed</code>: True/false value indicating if this application is already deployed.</td>
</tr>
<tr>
<td></td>
<td>• <code>numberOfUsersWithApp</code>: Count of users with this application installed.</td>
</tr>
<tr>
<td></td>
<td>• <code>numberOfDevicesWithApp</code>: Count of devices on which this application is installed.</td>
</tr>
<tr>
<td></td>
<td>• <code>application</code>: Object containing the data set listed above for this application. Use the script to parse additional data from this set that you might need.</td>
</tr>
<tr>
<td>error</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>
Conditions

Get Applications conditions

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully retrieved the list of applications available on the SCCM host.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to retrieve the list of applications available on the SCCM host.</td>
</tr>
</tbody>
</table>

Get Deployments activity

The Get Deployments activity returns the list of deployments performed by Orchestration using a Microsoft System Center Configuration Manager (SCCM) server.

The Get Deployments activity uses the Powershell activity template to access the deployments on the SCCM server. The activity is configured to use a MID Server with Powershell capabilities and to run a MID Server script called GetDeployments.ps1 that returns the deployments on the host. This script filters the results of the GET, so that only specific attributes are returned for the deployments on the SCCM server. Filtering the results in this manner controls the size of the payload, while providing the most desirable deployment data. The list of available deployments is returned as an array in a JSON object.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > System Center Configuration Manager (SCCM).

Note: The Get Deployments activity does not use pre-processing scripts.

Input variables

Get Deployments input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
</tbody>
</table>
Output variables

Get Deployments output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>deployments</td>
<td>The deployments array contains these attributes:</td>
</tr>
<tr>
<td></td>
<td>• id: Primary key of the SCCM application.</td>
</tr>
<tr>
<td></td>
<td>• applicationId: Primary key of the SCCM application.</td>
</tr>
<tr>
<td></td>
<td>• softwareName: Name of the software that will be deployed.</td>
</tr>
<tr>
<td></td>
<td>• collectionId: Primary key of the SCCM collection.</td>
</tr>
<tr>
<td></td>
<td>• collectionName: Name of the SCCM collection.</td>
</tr>
<tr>
<td></td>
<td>• desiredConfigType: Possible values are: Install (1) and Uninstall (2).</td>
</tr>
<tr>
<td></td>
<td>• deploymentIntent: Intended purpose of the deployment. Possible values are: Available (1) and Required (2).</td>
</tr>
<tr>
<td></td>
<td>• numberSuccess: Number of clients that successfully installed the deployment.</td>
</tr>
<tr>
<td></td>
<td>• numberErrors: Number of clients with an error when installing the deployment.</td>
</tr>
<tr>
<td></td>
<td>• deployment: Object containing the data set of attributes listed here for this deployment. Use the post-processing script to parse additional data from this set that you might need..</td>
</tr>
<tr>
<td>error</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>

Conditions

Get Deployments conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully retrieved the list of deployments performed by Orchestration using an SCCM host.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to retrieve the list of deployments performed by Orchestration using an SCCM host.</td>
</tr>
</tbody>
</table>
Get Device Collections activity

The Get Device Collections activity returns the list of available device collections on a Microsoft System Center Configuration Manager (SCCM) host.

The Get Device Collections activity uses the **Powershell activity template** to access the collections on the SCCM server. The activity is configured to use a MID Server with Powershell capabilities and to run a MID Server script called **GetDeviceCollections.ps1** that returns the device collections on the server. This script filters the results of the GET, so that only specific attributes are returned for the device collections on the SCCM server. Filtering the results in this manner controls the size of the payload, while providing the most desirable device collection data. The list of available collections is returned as an array in a JSON object.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > System Center Configuration Manager (SCCM)**.

**Note:** The Get Device Collections activity does not use pre-processing scripts.

### Input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
</tbody>
</table>

### Output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>deviceCollections</td>
<td>The <strong>deviceCollections</strong> array contains these attributes:</td>
</tr>
<tr>
<td></td>
<td>• <strong>id</strong>: Primary key of the SCCM device collection.</td>
</tr>
<tr>
<td></td>
<td>• <strong>name</strong>: Name of the SCCM device collection.</td>
</tr>
<tr>
<td></td>
<td>• <strong>collectionType</strong>: Type of SCCM collection. In this case, the value is <strong>device</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>localMemberCount</strong>: Count of device collection members visible at the local SCCM site.</td>
</tr>
<tr>
<td></td>
<td>• <strong>memberCount</strong>: Count of all device collection members.</td>
</tr>
</tbody>
</table>
Get Device Collections output variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>deviceCollection</td>
<td>Object containing the data set of attributes listed here for this device collection. Use the post-processing script to parse additional data from this set to use.</td>
</tr>
<tr>
<td>error</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>

Conditions

Get Device Collections conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully retrieved a list of device collections available on the SCCM host.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to retrieve a list of device collections available on the SCCM host.</td>
</tr>
</tbody>
</table>

Get User Collections activity

The Get User Collections activity returns the list of available user collections on a Microsoft System Center Configuration Manager (SCCM) server.

The Get User Collections activity uses the Powershell activity template to access the user collections on the SCCM server. The activity is configured to use a MID Server with Powershell capabilities and to run a MID Server script called GetUserCollections.ps1 that returns the user collections on the host. This script filters the results of the GET, so that only specific attributes are returned for the user collections on the SCCM server. Filtering the results in this manner controls the size of the payload, while providing the most desirable user collection data. The list of available collections is returned as an array in a JSON object.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > System Center Configuration Manager (SCCM).

Note: The Get User Collections activity does not use pre-processing scripts.
Input variables

Get User Collections input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
</tbody>
</table>

Output variables

Get User Collections output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
</table>
| userCollections | The userCollections array contains these attributes:  
|               | • id: Primary key of the SCCM user collection.  
|               | • name: Name of the SCCM user collection.  
|               | • collectionType: Type of SCCM collection. In this case, the value is user.  
|               | • localMemberCount: Count of user collection members visible at the local SCCM site.  
|               | • memberCount: Count of all user collection members.  
|               | • userCollection: Object containing the data set of attributes listed here for this user collection. Use the post-processing script to parse additional data from this set to use.  
| error        | Variable that contains the activity output error message.                                                                                     |

Conditions

Get User Collections conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully retrieved the list of available user collections on an SCCM host.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to retrieve the list of available user collections on an SCCM host.</td>
</tr>
</tbody>
</table>

Is Device in Collection activity

This activity verifies if a device exists in an SCCM device collection.
The Is Device in Collection activity uses the PowerShell activity template to verify if a specific device exists in an SCCM device collection. The activity is configured to use a MID Server with PowerShell capabilities and to run a MID Server script called `IsDeviceInCollection.ps1` to perform the test.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > System Center Configuration Manager (SCCM).

### Input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
<tr>
<td>collection</td>
<td>Name of the device collection.</td>
</tr>
<tr>
<td>device</td>
<td>Name of the device to verify is in the collection.</td>
</tr>
</tbody>
</table>

### Output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>output</td>
<td>Variable that contains the test result: True/False</td>
</tr>
<tr>
<td>errorMessage</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>

### Conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exist</td>
<td>The device exists in the collection.</td>
</tr>
<tr>
<td>Not exist</td>
<td>The device does not exist in the collection.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed.</td>
</tr>
</tbody>
</table>

### Is User in Collection activity

This activity verifies if a user exists in an SCCM user collection.

The Is User in Collection activity uses the PowerShell activity template to verify if a specific user exists in an SCCM user collection. The activity is configured to use...
a MID Server with PowerShell capabilities and to run a MID Server script called IsUserInCollection.ps1 to perform the test.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > System Center Configuration Manager (SCCM).

### Input variables

**Is User in Collection input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
<tr>
<td>collection</td>
<td>Name of the user collection.</td>
</tr>
<tr>
<td>user</td>
<td>Name of the user to verify is in the collection.</td>
</tr>
</tbody>
</table>

### Output variables

**Is User in Collection output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>output</td>
<td>Variable that contains the test result: True/False</td>
</tr>
<tr>
<td>errorMessage</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>

### Conditions

**Is User in Collection conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exist</td>
<td>The user exists in the collection.</td>
</tr>
<tr>
<td>Not exist</td>
<td>The user does not exist in the collection.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed.</td>
</tr>
</tbody>
</table>

### Remove from Device Collection activity

The Remove from Device Collection activity removes a device from a Microsoft System Center Configuration Manager (SCCM) device collection.

The Remove from Device Collection activity uses the Powershell activity template to remove a device from a device collection on a Microsoft SCCM.
The activity is configured to use a MID Server with Powershell capabilities and to run a MID Server script called RemoveFromUserCollection.ps1 to edit the collection.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > System Center Configuration Manager (SCCM).

**Input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
<tr>
<td>collection</td>
<td>Name of the device collection.</td>
</tr>
<tr>
<td>device</td>
<td>Name of the device to add to the collection.</td>
</tr>
</tbody>
</table>

**Output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>output</td>
<td>Variable that contains a value that is passed to other activities in the workflow</td>
</tr>
<tr>
<td>error</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>

**Conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully removed the device from the SCCM device collection.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to remove the device from the SCCM device collection.</td>
</tr>
</tbody>
</table>

**Remove from User Collection activity**

The Remove from User Collection activity removes a user from a Microsoft System Center Configuration Manager (SCCM) user collection.
The Remove from User Collection activity uses the **Powershell activity designer template** to access a user collection on a Microsoft SCCM target host. The activity is configured to use a MID Server with Powershell capabilities and to run a MID Server script called `RemoveFromUserCollection.ps1` to edit the collection.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > System Center Configuration Manager (SCCM)**.

### Input variables

**Remove from User Collection input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
<tr>
<td>collection</td>
<td>Name of the user collection.</td>
</tr>
<tr>
<td>user</td>
<td>Name of the user to add to the collection.</td>
</tr>
</tbody>
</table>

### Output variables

**Remove from User Collection output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>output</td>
<td>Variable that contains a value that is passed to other activities in the workflow.</td>
</tr>
<tr>
<td>error</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>

### Conditions

**Remove from User Collection conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully removed the user from the SCCM user collection.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to remove the user from the SCCM user collection.</td>
</tr>
</tbody>
</table>

### SFTP File Transfer activity pack

Use the SFTP File Transfer activities to manage files and directories on an SFTP server and to move files from one SFTP server to another.
The SFTP activity pack includes scoped activities for common file transfer tasks and a ready-to-use workflow that includes these activities. Use the SFTP workflow to control which files are going to be moved, what conditions the files need to meet, the order in which the files are moved, and which overwrite options are executed.

**Note:** To use the SFTP File Transfer activities and workflow, you must request activation of the Orchestration - SFTP plugin.

### SFTP File Transfer workflow

The SFTP File Transfer activity pack includes a scoped workflow that uses multiple activities to manage files on SFTP servers.

The maximum activity count for the SFTP File Transfer workflow is set to 10,000. This allows the workflow to move up to 1000 files from one server to another.

### Accessing the workflow

- Navigate to **Workflow > Workflow Editor** and select the **Workflows** tab.
- Click on the SFTP File Transfer workflow to open it.
- Click the information icon in the workflow header to display the properties dialog box.

### Input variables

#### SFTP File Transfer workflow input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source host</td>
<td>Name or IP address of the server containing the files you want to move.</td>
<td></td>
</tr>
<tr>
<td>Source port</td>
<td>Port number to use to communicate with the source server.</td>
<td>22</td>
</tr>
<tr>
<td>Source directory</td>
<td>Full path to the directory where the source files are located.</td>
<td></td>
</tr>
<tr>
<td>Source files</td>
<td>Names of specific source files to move. Separate the file names in this list with semi-colons. This field supports the use of wild cards. For information about how the values in this field are affected by options in other fields, see the section below the table.</td>
<td></td>
</tr>
</tbody>
</table>
### SFTP File Transfer workflow input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excluded files</td>
<td>Names of specific source files to exclude from the move. The system moves all other files found in the source directory or subfolders. Separate the file names in this list with semi-colons. This field supports the use of wild cards. For information about how the values in this field are affected by options in other fields, see the section below the table.</td>
<td></td>
</tr>
<tr>
<td>Target host</td>
<td>Name or IP address of the server to which the files are being moved.</td>
<td></td>
</tr>
<tr>
<td>Target port</td>
<td>Port number to use to communicate with the target host.</td>
<td>22</td>
</tr>
<tr>
<td>Datetime format</td>
<td>Timestamp format to apply when the $[DateTime]$ variable is used in the Target directory or Target files field. The system uses the current time from the instance to create timestamp values.</td>
<td>yyyy-MM-dd</td>
</tr>
<tr>
<td>Target directory</td>
<td>Path to the directory in the target host where the files are being moved. You can specify a target directory whose name includes the timestamp by adding the $[DateTime]$ variable to the directory name. For example, you might enter this path to a target directory: /user/jacinto.gawron/documents/projects_$[DateTime]$. This produces the projects_20150505 directory. When the timestamp variable is used, the system uses the format specified in the Datetime format field.</td>
<td></td>
</tr>
<tr>
<td>Target file</td>
<td>Format to use for target file names when a timestamp is added. You can configure the system to add the timestamp as a prefix to the file name or insert the timestamp into the name, using these variables:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• $[DateTime]$: Current timestamp, using the format defined in the Datetime format field.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• $[SourceFile]$: Complete file name.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• $[SourceFile:Base]$: Base file name without the extension.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• $[SourceFile:Ext]$: File extension only.</td>
<td></td>
</tr>
</tbody>
</table>
**SFTP File Transfer workflow input variables (continued)**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>A target file name with the timestamp added as a prefix is expressed as: $[DateTime]$_$[SourceFile]. This produces a file name that looks like this: 20150505_file1.txt</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A target file name with the timestamp inserted into the name is expressed as: $[SourceFile:Base]$_$[DateTime]$[SourceFile:Ext]. This produces a file name that looks like this: file1_20150505.txt</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Apply move conditions</strong></td>
<td>Check box to apply conditions to the file transfer. If this check box is selected, additional fields appear for setting conditions.</td>
<td>false</td>
</tr>
<tr>
<td><strong>Minimum file size, in bytes</strong></td>
<td>Condition that defines a target file's minimum size requirement. This setting can help determine if the file is valid. This field appears when the <strong>Apply move conditions</strong> check box is selected.</td>
<td>0</td>
</tr>
<tr>
<td><strong>Maximum file size, in bytes</strong></td>
<td>Condition that defines a target file's maximum size requirement. This field appears when the <strong>Apply move conditions</strong> check box is selected.</td>
<td>-1</td>
</tr>
<tr>
<td><strong>File is not older than</strong></td>
<td>Condition that sets the earliest acceptable date for this file's age range. The range starts at 00:00 (midnight) on the date specified. This field appears when the <strong>Apply move conditions</strong> check box is selected.</td>
<td></td>
</tr>
<tr>
<td><strong>File is not newer than</strong></td>
<td>Condition that sets the latest acceptable date for this file's age range. The range ends at 23:59 on the date specified. This field appears when the <strong>Apply move conditions</strong> check box is selected.</td>
<td></td>
</tr>
<tr>
<td><strong>Include subfolders</strong></td>
<td>Check box to move the files from subfolders in the source directory. For information about how your selection affects other fields in the form, see the section below the table.</td>
<td></td>
</tr>
<tr>
<td><strong>Move order</strong></td>
<td>Order in which the files are moved from the source to the target. The possible options are:</td>
<td></td>
</tr>
<tr>
<td>• None (same order as files in the source directory)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• By timestamp</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
<td>Default value</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Sort order</td>
<td>Order in which the files are sorted in the target directory, using the option selected in the <strong>Move order</strong> field. Sorting options are <strong>Ascending</strong> and <strong>Descending</strong>.</td>
<td>desc</td>
</tr>
<tr>
<td>Maximum number of retries</td>
<td>Number of attempts the activity can make to connect to the target host or to move a file before timing out. When the retry limit to move a file or to connect to the host is exceeded, the system logs a failure. If the maximum number of failures is not exceeded, the system attempts to connect again or to move the next file named.</td>
<td>2</td>
</tr>
<tr>
<td>Time between retries, in seconds</td>
<td>Time, in seconds, between repeat attempts to connect to the target or to begin moving a file.</td>
<td>10</td>
</tr>
<tr>
<td>Maximum number of failures</td>
<td>Acceptable number of times the system can fail to connect to the target host or to move a file before it quits trying. A failure occurs when the number of configured retries is exceeded. Using the default settings, failure occurs when the system cannot connect to the target or move a file after two retries.</td>
<td>0</td>
</tr>
<tr>
<td>Duplicate file action</td>
<td>Action to take if a file being moved already exists in the target directory. The choices are:</td>
<td>overwrite</td>
</tr>
<tr>
<td></td>
<td>• <strong>Overwrite if file exists</strong> (default)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>Rename with index</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>Do not move</strong></td>
<td></td>
</tr>
<tr>
<td>Preserve file attributes</td>
<td>Check box to use the time stamp and mode information from the source files for the copied files. If this check box is cleared, the copied files have a current time stamp and mode.</td>
<td>false</td>
</tr>
</tbody>
</table>

Note: This timestamp is a file attribute and is not appended to the file name.
### SFTP File Transfer workflow input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upon success, remove files from source</td>
<td>Check box to delete original files from the source directory when they are copied to the new location. Clear this check box to keep the source files in their current location in the source host.</td>
<td>false</td>
</tr>
<tr>
<td>Upon failure, keep moved files on target</td>
<td>Check box to keep any files on the target that were moved successfully, even if the entire file transfer operation ended in failure. If this check box is cleared, the system removes all successfully transferred files from the target when general failure occurs.</td>
<td>true</td>
</tr>
<tr>
<td>Credential tag for source</td>
<td>Specific credential alias this activity must use to run SSH commands on the source host.</td>
<td></td>
</tr>
<tr>
<td>Credential tag for target</td>
<td>Specific credential tag this activity must use to run SSH commands on the target host.</td>
<td></td>
</tr>
</tbody>
</table>

### File selection logic

When selecting the files to move from the source host, the system uses this logic:

- If the Source files and Excluded files fields are empty, the system moves all the files in the source directory.

- When the Include subfolders check box is selected, the following dependencies exist:
  - If no files are specified in the Source files and Exclude files fields, the system moves all files in the source directory and all files in all subfolders of the source directory.
  - If the Source files field contains file names, the system moves those files from their location on either the source directory or any of its subfolders.
  - If the Exclude files field contains file names, the system moves all the files from the source directory and its subfolders except those excluded files.

- When the Include subfolders check box is cleared, the system looks only in the source directory for files to move or exclude.
Copy File activity

The Copy File activity copies a file from an SFTP server (source host) to another SFTP server (target host).

Input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sourceHost</td>
<td>Name or IP address of the server containing the files you want to transfer.</td>
</tr>
<tr>
<td>sourcePort</td>
<td>Port number to use to communicate with the source server. The default port number is 22.</td>
</tr>
<tr>
<td>sourceFilePath</td>
<td>Full path to the file to copy from the source host.</td>
</tr>
<tr>
<td>targetHost</td>
<td>Name or IP address of the server to which you want to move the files.</td>
</tr>
<tr>
<td>targetPort</td>
<td>Port number to use to communicate with the target server. The default port number is 22.</td>
</tr>
<tr>
<td>targetFilePath</td>
<td>Full path to the copied file on the target host.</td>
</tr>
<tr>
<td>tempFileSuffix</td>
<td>Temporary suffix to use when moving a file. If this field contains a value, the activity deletes the duplicate target file, if it exists, and then copies the source file to a temporary file using <code>targetFilePath + tempFileSuffix</code> as the name. Upon completion, the activity renames the file to the actual target file name. If this field is blank, the activity copies the source file directly to the target file and overwrites it, if it already exists.</td>
</tr>
<tr>
<td>sourceCredentialTag</td>
<td>Specific credential alias this activity must use to run SSH commands on the source host.</td>
</tr>
<tr>
<td>targetCredentialTag</td>
<td>Specific credential tag this activity must use to run SSH commands on the target host.</td>
</tr>
</tbody>
</table>
Output variables

Copy File output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>errorMessages</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources. If this variable is not null, the operation has failed.</td>
</tr>
<tr>
<td>result</td>
<td>Text message advising that the command was executed successfully.</td>
</tr>
</tbody>
</table>

Conditions

Copy File conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in copying the file.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to copy the file.</td>
</tr>
</tbody>
</table>

Create Directory activity

The Create Directory activity creates a new directory on an SFTP server.

Input variables

Create Directory input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sourceHost</td>
<td>Name or IP address of the server containing the files you want to move.</td>
</tr>
<tr>
<td>sourcePort</td>
<td>Port number to use to communicate with the source server. The default port number is 22.</td>
</tr>
<tr>
<td>sourceDirectory</td>
<td>Path to the target directory to create.</td>
</tr>
<tr>
<td>sourceCredentialTag</td>
<td>Specific credential alias this activity must use to run SSH commands on the host.</td>
</tr>
</tbody>
</table>
Output variables

Create Directory output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>errorMessage</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources. If this variable is not null, the operation has failed.</td>
</tr>
<tr>
<td>result</td>
<td>Text message advising that the command was executed successfully.</td>
</tr>
</tbody>
</table>

Conditions

Create Directory conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in creating the directory.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to create the directory.</td>
</tr>
</tbody>
</table>

Get File List activity

The Get File List activity returns a list of files from a given directory and its subdirectories on an SFTP server (source host).

Input variables

Get File List input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sourceHost</td>
<td>Name or IP address of the server containing the files you want to list.</td>
</tr>
<tr>
<td>sourcePort</td>
<td>Port number to use to communicate with the target server. The default port number is 22.</td>
</tr>
<tr>
<td>sourceDirectory</td>
<td>Path to the target directory containing the files to list.</td>
</tr>
<tr>
<td>sourceFiles</td>
<td>List of target files to return. This is a comma separated list that accepts wildcards, such as *.txt.</td>
</tr>
<tr>
<td>excludedFiles</td>
<td>List of target files to exclude. This is a comma separated list that accepts wildcards, such as *.txt.</td>
</tr>
</tbody>
</table>
Get File List input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>includeSubfolders</td>
<td>True/false variable that determines if files from subfolders are included in the list. The default value for this variable is false.</td>
</tr>
<tr>
<td>sourceCredentialTag</td>
<td>Specific credential alias this activity must use to run SSH commands on the host.</td>
</tr>
</tbody>
</table>

Output variables

Get File List output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources. If this variable is not null, the operation has failed. An activity can examine the error message to customize a condition. For example, if the error message contains NO_SUCH_FILE, the activity can be considered successful, depending on circumstances.</td>
</tr>
<tr>
<td>result</td>
<td>List of requested files, returned as a JSON string.</td>
</tr>
</tbody>
</table>

Conditions

Get File List conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in listing the requested files.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to list the requested files.</td>
</tr>
</tbody>
</table>

Remove File or Directory activity

The Remove File or Directory activity removes a file or a directory on an SFTP server, including subdirectories, when configured.
Input variables

Remove File or Directory input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sourceHost</td>
<td>Name or IP address of the server containing the files you want to remove.</td>
</tr>
<tr>
<td>sourcePort</td>
<td>Port number to use to communicate with the target server. The default port number is 22.</td>
</tr>
<tr>
<td>sourceFilePath</td>
<td>Full path to the file or directory to remove. To remove multiple files or directories using a single activity, enter a semicolon-separated list of paths in this field.</td>
</tr>
<tr>
<td>isDirectory</td>
<td>True/false variable that determines if the specified file path is a directory. The default value for this variable is false.</td>
</tr>
<tr>
<td>includeSubfolders</td>
<td>True/false variable that determines if the given directory and all of its subfolders should be removed. The default value for this variable is false. If the value for this field is false, then the activity can only remove an empty directory. This field appears when the isDirectory checkbox is selected.</td>
</tr>
<tr>
<td>sourceCredentialTag</td>
<td>Specific credential alias this activity must use to run SSH commands on the host.</td>
</tr>
</tbody>
</table>

Output variables

Remove File or Directory output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources. If this variable is not null, the operation has failed.</td>
</tr>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>deletionResults</td>
<td>The deletionResults array contains these attributes:</td>
</tr>
<tr>
<td></td>
<td>• fullPath: Full path to the file or directory targeted.</td>
</tr>
<tr>
<td></td>
<td>• status: Either succeeded or failed.</td>
</tr>
<tr>
<td></td>
<td>• reason: Text message describing the cause of a failure.</td>
</tr>
</tbody>
</table>
**Conditions**

**Remove File or Directory conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in removing the file or directory specified.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to remove the file or directory specified.</td>
</tr>
</tbody>
</table>

**Rename File or Directory activity**

The Rename File or Directory activity renames a file or directory to a new name on an SFTP server.

**Input variables**

**Rename File or Directory input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sourceHost</td>
<td>Name or IP address of the server containing the file or directory you want to rename.</td>
</tr>
<tr>
<td>sourcePort</td>
<td>Port number to use to communicate with the target server. The default port number is <strong>22</strong>.</td>
</tr>
<tr>
<td>sourceFilePath</td>
<td>Full path to the file or directory to rename.</td>
</tr>
<tr>
<td>targetFilePath</td>
<td>Full path to the renamed file or directory.</td>
</tr>
<tr>
<td>sourceCredentialTag</td>
<td>Specific <code>credential alias</code> this activity must use to run SSH commands on the host.</td>
</tr>
</tbody>
</table>

**Output variables**

**Rename File or Directory output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>errorMessages</td>
<td>The <code>executionResult.errorMessages</code> from the <code>Activity designer parsing sources</code>. If this variable is not null, the operation has failed.</td>
</tr>
<tr>
<td>result</td>
<td>A message saying that the operation has been successful. For example, you might see: <code>Rename /tmp/sftp_test/subdir1 to /tmp/sftp_test/subdir2 complete</code>.</td>
</tr>
</tbody>
</table>
Conditions

Rename File or Directory conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in renaming the file or directory.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to rename the file or directory.</td>
</tr>
</tbody>
</table>

Set File Attributes activity

The Set File Attributes activity sets common file attributes, such as timestamps, size, permissions, and UID/GID, for a file or directory on an SFTP server.

A good practice is to use the Get File List activity to return a list of files and their attributes first. Then, when you moved a file from a source host to a target host, use the Set File Attributes activity to set the source file attributes on the target file. This is demonstrated in the SFTP File Transfer workflow.

Input variables

Set File Attributes input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sourceHost</td>
<td>Name or IP address of the server containing the file or directory whose attributes you want to change.</td>
</tr>
<tr>
<td>sourcePort</td>
<td>Port number to use to communicate with the target server. The default port number is 22.</td>
</tr>
<tr>
<td>sourceFilePath</td>
<td>Full path to the file or directory whose attributes you want to change.</td>
</tr>
<tr>
<td>userID</td>
<td>User ID attribute to apply to the file or directory. The UID and GUID variables must be set together as a pair.</td>
</tr>
<tr>
<td>groupID</td>
<td>Group ID attribute to apply to the file or directory. The UID and GUID variables must be set together as a pair.</td>
</tr>
<tr>
<td>permissions</td>
<td>File or directory permissions to set for the user and group specified. This value must be expressed as an integer, such as 16877, which defines these permissions: rwxr-xr-x.</td>
</tr>
</tbody>
</table>
Set File Attributes input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>accessTimestamp</td>
<td>Override the timestamp when the file or directory was last accessed. The access and modification timestamps must be set together as a pair.</td>
</tr>
<tr>
<td>modificationTimestamp</td>
<td>Override the timestamp when the file or directory was last modified. The access and modification timestamps must be set together as a pair.</td>
</tr>
<tr>
<td>sizeInBytes</td>
<td>Size of the file or directory, expressed in bytes.</td>
</tr>
<tr>
<td>sourceCredentialTag</td>
<td>Specific credential alias this activity must use to run SSH commands on the host.</td>
</tr>
</tbody>
</table>

Note: The permissions number is an internal value returned by the Get File List activity.

Output variables

Set File Attributes output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources. If this variable is not null, the operation has failed.</td>
</tr>
<tr>
<td>result</td>
<td>Text message advising that the command was executed successfully.</td>
</tr>
</tbody>
</table>

Conditions

Set File Attributes conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in changing the attributes of the specified file or directory.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to change the attributes of the specified file or directory.</td>
</tr>
</tbody>
</table>
**SSH activity pack**

Orchestration provides an activity pack of SSH activities that were customized using the ServiceNow activity designer.

These activities perform the same functions as SSH activities by the same name from previous releases and replace those activities for all new workflows. The custom SSH activities were built with the Create an SSH activity, which gives workflow administrators the ability to store input and output variables in the databus.

⚠️ **Note:** Existing workflows from earlier versions that were created with legacy SSH activities continue to function normally after an upgrade to Geneva. However, all new workflows must use these custom SSH activities.

To use the SSH custom activities, you must request activation of the Orchestration - SSH plugin.

**Secure Copy activity**

The Secure Copy activity copies a file from one host to another, without storing the copied file on the MID Server.

This activity replaces an SSH activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the SSH activity designer template, which gives workflow administrators the ability to store input and output variables in the databus.

**Input variables**

**Secure Copy input variables**

<table>
<thead>
<tr>
<th>Input variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>from_host</td>
<td>Host name or IP address of the source machine.</td>
</tr>
<tr>
<td>from_scp_file</td>
<td>Name of the file to copy, including the absolute path.</td>
</tr>
<tr>
<td>to_host</td>
<td>Host name or IP address of the target machine.</td>
</tr>
<tr>
<td>to_scp_file</td>
<td>Path to the target file. This path can be absolute or relative to the logged in user's home directory.</td>
</tr>
<tr>
<td>debug_mid</td>
<td>Check box that enables debug logging when selected.</td>
</tr>
</tbody>
</table>
Secure Copy input variables (continued)

<table>
<thead>
<tr>
<th>Input variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>debug_ssh</td>
<td>Check box that enables J2SSH debug logging when selected.</td>
</tr>
</tbody>
</table>

Output variables

Secure Copy output variables

<table>
<thead>
<tr>
<th>Output variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>payload</td>
<td>The <code>executionResult.payload</code> from the Activity designer parsing sources.</td>
</tr>
<tr>
<td>output</td>
<td>The <code>executionResult.output</code> from the parsing sources.</td>
</tr>
</tbody>
</table>

Conditions

Secure Copy conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully copied the file from one host to another.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to copy the file from one host to another.</td>
</tr>
</tbody>
</table>

Files Compare activity

The Files Compare activity compares two files on a Linux or UNIX computer. This activity replaces an SSH activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the SSH activity designer template, which gives workflow administrators the ability to store input and output variables in the databus.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Global > Orchestration - SSH.
Input variables

**Files Compare input variables**

<table>
<thead>
<tr>
<th>Input variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>Hostname or IP address of the destination server for SSH activity.</td>
</tr>
<tr>
<td>Directory</td>
<td>Name of the working directory.</td>
</tr>
<tr>
<td>OldFile</td>
<td>Name of the first file to compare.</td>
</tr>
<tr>
<td>NewFile</td>
<td>Name of the second file to compare.</td>
</tr>
</tbody>
</table>

Output variables

**Files Compare output variables**

<table>
<thead>
<tr>
<th>Output variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>contents</td>
<td>File comparison result. This is the difference of the two compared files.</td>
</tr>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>return-code</td>
<td>Either 0, if the two files are the same, or 1, if the two files are different.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources.</td>
</tr>
</tbody>
</table>

Conditions

**Files Compare conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully compared the specified files.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity could not compare the specified files.</td>
</tr>
</tbody>
</table>

File Read activity

The File Read activity reads a file on a Linux or UNIX computer.

This activity replaces an SSH activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally...
after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the SSH activity designer template, which gives workflow administrators the ability to store input and output variables in the databus.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Global > Orchestration - SSH.

Input variables

<table>
<thead>
<tr>
<th>File read input variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input variable</td>
</tr>
<tr>
<td>Hostname</td>
</tr>
<tr>
<td>Directory</td>
</tr>
<tr>
<td>File</td>
</tr>
</tbody>
</table>

Output variables

<table>
<thead>
<tr>
<th>File read output variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output variable</td>
</tr>
<tr>
<td>contents</td>
</tr>
<tr>
<td>result</td>
</tr>
<tr>
<td>errorMessage</td>
</tr>
</tbody>
</table>

Conditions

<table>
<thead>
<tr>
<th>File Read conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
</tr>
<tr>
<td>Success</td>
</tr>
<tr>
<td>Failure</td>
</tr>
</tbody>
</table>

File Write activity

The File Write activity writes a file on a Linux or UNIX computer.
The source file can be an absolute or relative path from the Directory. If an absolute path is used, then no value is required in the Directory field.

This activity replaces an SSH activity by the same name available in releases prior to Istanbul. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Istanbul. However, all new workflows must use the custom version of this activity. This activity was built with the SSH activity template, which gives workflow administrators the ability to store input and output variables in the databus.

**Input variables**

**File Write input variables**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>Hostname or IP address of destination server for SSH activity.</td>
</tr>
<tr>
<td>directory</td>
<td>Name of the working (target) directory.</td>
</tr>
<tr>
<td>file</td>
<td>Name of the file to be written.</td>
</tr>
<tr>
<td>behavior</td>
<td>Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>overwrite</strong>: Creates the file if it does not exist and overwrites the file if it does exist.</td>
</tr>
<tr>
<td></td>
<td>• <strong>append</strong>: Creates the file if it does not exist and appends the new content to an existing file.</td>
</tr>
<tr>
<td></td>
<td>• <strong>create only</strong>: Creates the file if it does not exist and fails if the file does exist.</td>
</tr>
<tr>
<td>contents</td>
<td>What to write or append (depending on the behavior) to the file</td>
</tr>
</tbody>
</table>

**Output variables**

**File Write output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>return_code</td>
<td>Indicates whether or not the file write operation was successful.</td>
</tr>
<tr>
<td>error_message</td>
<td>Message that indicates if an error has occurred. Any value other than 0 indicates a failure.</td>
</tr>
</tbody>
</table>
## Conditions

### File Write conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity wrote a file in the target directory.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to write a file in the target directory.</td>
</tr>
</tbody>
</table>

### File Copy activity

The custom File Copy activity copies a file on a Linux or UNIX computer.

This activity replaces an SSH activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the [SSH activity designer template](https://service-now.com), which gives workflow administrators the ability to store input and output variables in the [databus](https://service-now.com).

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Global > Orchestration - SSH**.

### Input variables

#### File Copy input variables

<table>
<thead>
<tr>
<th>Input variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>Hostname or IP address of destination server for SSH activity.</td>
</tr>
<tr>
<td>directory</td>
<td>Name of the working directory.</td>
</tr>
<tr>
<td>src_file</td>
<td>Name of the source file.</td>
</tr>
<tr>
<td>dst_file</td>
<td>The name of the destination file.</td>
</tr>
</tbody>
</table>
Output variables

File Copy output variables

<table>
<thead>
<tr>
<th>Output variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
</tbody>
</table>

Conditions

File Copy conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully copied the file on the specified host.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to copy the file on the specified host.</td>
</tr>
</tbody>
</table>

File Replace String activity

The File Replace String activity finds and replaces a string in a file on a Linux or UNIX computer.

This activity replaces an SSH activity by the same name available in releases prior to Istanbul. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Istanbul. However, all new workflows must use the custom version of this activity. This activity was built with the SSH activity template, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

File Replace String input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>Hostname or IP address of destination server for SSH activity.</td>
</tr>
<tr>
<td>directory</td>
<td>Name of the working (target) directory.</td>
</tr>
<tr>
<td>file</td>
<td>Name of the file in which the string is to be replaced.</td>
</tr>
<tr>
<td>find_pattern</td>
<td>A regular expression of the text to replace.</td>
</tr>
<tr>
<td>replace_string</td>
<td>The replacement string for the text found by the expression in the find_pattern variable.</td>
</tr>
</tbody>
</table>
File Replace String input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
</table>
| options  | Replacement options:  
  • **first**: Replaces the first occurrence of the pattern.  
  • **all**: Replaces all occurrences of the pattern. |

Output variables

File Replace String output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>return_code</td>
<td>Indicates whether or not the string was replaced successfully in the target file.</td>
</tr>
<tr>
<td>error_message</td>
<td>Message that indicates if an error has occurred. Any value other than 0 indicates a failure.</td>
</tr>
</tbody>
</table>

Conditions

File Replace String conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity has successfully replaced the string in the file.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity has failed to replaced the string in the file.</td>
</tr>
</tbody>
</table>

Reset Linux User Password activity

The Reset Linux User Password activity resets the password for a given user on a Linux computer.

This activity requires that the user executing the command be able to run the **chpasswd** command and, if expiring the password immediately, to run **chage** with **sudo** privileges.

This activity replaces an SSH activity by the same name available in releases prior to Istanbul. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after
upgrading to Istanbul. However, all new workflows must use the custom version of this activity. This activity was built with the [SSH activity template](#), which gives workflow administrators the ability to store input and output variables in the [databus](#).

### Input variables

**Reset Linux User Password input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>IP address of the target Linux machine.</td>
</tr>
<tr>
<td>user</td>
<td>Name of the user whose password is being reset.</td>
</tr>
<tr>
<td>password</td>
<td>New password set for this user. The password is a workflow variable that is encrypted either as a <code>password2</code> field or by calling the encryption method of a <code>Packages.com.glide.util.Encrypter</code> object.</td>
</tr>
<tr>
<td>force_change</td>
<td>Indicates if this password is temporary and to force the named user to change the password at login.</td>
</tr>
</tbody>
</table>

### Output variables

**Reset Linux User Password output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>return_code</td>
<td>Indicates whether or not the user password reset action was successful.</td>
</tr>
<tr>
<td>error_message</td>
<td>Describes any error that occurred during password reset. If no error occurred, this value is null.</td>
</tr>
</tbody>
</table>

### Conditions

**Reset Linux User Password conditions**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully changed specified user’s password</td>
</tr>
</tbody>
</table>
Reset Linux User Password conditions (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failure</td>
<td>Activity failed to change specified user’s password.</td>
</tr>
</tbody>
</table>

Global activities

Global activities are Orchestration activities created in the global scope.

Any activities you create in the global scope are listed in the Global category in the Packs and Custom tabs of the Workflow Editor.

Global activities

[Workflow Editor interface showing Global activities with Pack and Custom categories]

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Test Server Alive activity

The Test Server Alive activity determines if a target system is alive by its response to a particular protocol.

This activity replaces an activity by the same name available in releases prior to Istanbul. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Istanbul. However, all new workflows must use the custom version of this activity. This activity was built with the Probe activity template, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Test Server Alive input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>port_probes</td>
<td>A comma separated list of protocols to use to check for signs of activity on the target machine (example: wmi, wins, https, ssh, http, https, snmp, dns)</td>
</tr>
<tr>
<td>hostname</td>
<td>Hostname or IP address of the target system to check.</td>
</tr>
</tbody>
</table>

Output variables

Test Server Alive output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>alive</td>
<td>Code that indicates whether or not the server is alive. If any value but '1' is returned, the server is not alive.</td>
</tr>
</tbody>
</table>

Conditions

Test Server Alive conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity determined that the device is running.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to determine if the target device is running. Failure could</td>
</tr>
</tbody>
</table>
Test Server Alive conditions (continued)

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>be caused by a missing protocol or a device that is not accessible.</td>
<td></td>
</tr>
</tbody>
</table>

Orchestration activity designer

The Orchestration activity designer enables a user with either the workflow_admin or activity_creator and workflow_creator roles to construct reusable activities that suit an organization's business needs.

Activities created by the activity designer offer the following advantages over core activities offered in previous releases:

- Reuse custom activities in multiple workflows.
- Upload and download custom activities from the ServiceNow Store.
- Parse data from standard input formats.
- Test input variables against a target host or endpoint and inspect the payload.
- Automatically map values from a test payload to an activity's output variables.
- Share data between activities.
- View previous versions of an activity.

Access to the activity designer requires activation of ServiceNow Orchestration. For instructions about managing transitions and conditions for all activities, see Workflow activities.

Orchestration provides numerous pre-defined activities, which are reusable components that can be used in numerous workflows without having to understand the complexities of the underlying system. These activities are grouped into activity packs, which address specific business needs, such as: Active Directory, Azure AD, Exchange, Infoblox DDI, and PowerShell. There are other ServiceNow applications which provide and maintain their own separate activity packs, such as Security Incident Response, Cloud Management, or Release Automation.

Customers can also build their own activities and activity packs. You can construct custom activities with a specified template through the Orchestration Activity Designer. Custom-built activities built with the Activity Designer are referred to as activity elements. Activity elements provide optimal operations, enable code reuse, and minimize the need to write code. They also enable you
to follow the flow of data within a given workflow across orchestration activities. Incorporating activity elements limits the dependency on the scratchpad which reduces problems in complex workflows. Limit the use of core activities, like ‘Run Script’, unless you need direct access the scratchpad, for example, for a counter. Activity elements do not have direct access to the scratchpad. You can, however, pass scratchpad variables as inputs into your activities.

Orchestration activities created by the activity designer:

- Can be uploaded and shared in the ServiceNow App Store
- Use the databus, which allows the activity to have well-defined inputs and outputs
- Share data across activities within a workflow
- Use versioning
- Provide a consistent approach for activity development regardless protocol

† Note: Prior to the Fuji release, activities were built with Activity Definitions. In Fuji, a new architecture was introduced using the Activity Designer. Orchestration Core activities, built originally as Activity Definitions, have been converted to use the new template format (Activity Elements) and the databus offered with the activity designer. Workflows in upgraded instances that use legacy activities continue to work normally.

For instructions on using activities to construct a workflow, see Add an activity to a workflow.

Introduction to credentials, connections, and aliases for Orchestration

All application integrations in Orchestration require connection information, credentials, and connection and credential aliases to their respective applications to access resources.

Before you can execute an application integration in Orchestration, you must create and configure the corresponding connection information and credentials. The Connections pertains to an integration with a system, such as an IP address or endpoint with protocols. It contains specific details, such as database particulars, when integrating with a database. The associated Credentials are the authentication data required to make the connection.

Connection information and credentials can vary between QA/Development/Production environments for the same integration. The tight coupling between this data and application metadata, such as workflow or job scheduling, make application metadata obsolete when you change environments. To alleviate this problem, the concept of an alias is introduced, for connections...
and credentials, to decouple this data from application metadata. These aliases allow customers to design their application metadata to couple to an alias, which during runtime resolves to connection and credential data.

There are two types of aliases, a **connection and credential alias** and a **credential alias**. There are business rules that enforce certain constraints on these aliases. Names should contain alphabets, numbers, and underscores but cannot have special characters. The alias must be unique in a scope. If you choose to have multiple active connections, you can have more than one active connection in the same domain. If you do not choose this option, you can have only one active connection in per domain.

⚠ **Note:** If you enable multiple active connections, when the connection records resolve, your application picks one connection based on an established order. The order of the connections depends on the API you use to retrieve connection data.

You can add additional connection attributes to an alias, which are available in connection data during run time. Variables overridden by connection administration during run time should not affect the alias.

The **credential alias** resolves only credential data. Along with alias data model, you can use a scriptable API which can get connection and credential data during runtime.

### Using Connection and Credential Alias with Orchestration

Define an alias to label a credential or connection record.

The Credential and Connection Alias defines an alias that labels a credential or connection record. It is extended from the sys_metadata table. It requires the admin role. The credential_admin and connection_admin have read access to sys_alias. A connection alias contains:

- **Name**
  - Name of the alias.

- **ID**
  - This field is based on the format "scope name.alias name" Unique index on ID to ensure unique record based on scope name + name. If the scope is global, the ID is the alias name.

- **Type**
  - You can select either 'Credential' or 'Connection and Credential'. The default is Connection and Credential.

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
This field is applicable when the alias type is set to Connection and Credential. There are three connection types: HTTP, JDBC, JMS. The default is HTTP.

If you create a workday alias in global scope, the ID is set to workday
If you create a workday alias in hr app scope, the ID is set to x_hr_app.workday

- Name can only contain alphabets, numbers and underscore.
- During the upgrade, the tag in credential record will be migrated to connection alias. If the tag in previous release’s credential record contains special characters other than alphabets, numbers and underscore, the tag data will be preserved during the upgrade. The user still can use these connection alias, but the user cannot update these alias, unless he removes these special characters when do the update.

Using credentials with Orchestration
Orchestration requires credentials to access resources.

Credential table
The credential table (discovery_credential) defines credentials that can be used for integration. In the previous release, the Credential table contains a string-type tag field, which labels a credential and the tag is used in orchestration activities. In the madrid release, we rename tag to credential alias, and change the type from string to GlideList, which is a reference to connection alias table.

Credential types
The following credential types are provided:

<table>
<thead>
<tr>
<th>Credential type</th>
<th>Description</th>
<th>Supports Test Credential option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applicative credentials</td>
<td>The credentials to explore the applications on a device or computer. Often need applicative credentials.</td>
<td>No</td>
</tr>
<tr>
<td>Amazon Web Service credentials</td>
<td>The Amazon Web Services (AWS) master account, access key ID, and secret access key.</td>
<td>No</td>
</tr>
</tbody>
</table>

Note: You cannot test AWS credentials through the Test
<table>
<thead>
<tr>
<th>Credential type</th>
<th>Description</th>
<th>Supports Test Credential option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Azure Service Principal and Enterprise Agreement credentials</td>
<td>The Azure service principals required for an Azure subscription.</td>
<td>No</td>
</tr>
<tr>
<td>Basic authentication credentials</td>
<td>A user name and password.</td>
<td>No</td>
</tr>
<tr>
<td>CIM credentials</td>
<td>The user name and password required to access a CIMOM - Common Information Model Object Manager (CIM) server, which obtains information about VMware ESX servers.</td>
<td>No</td>
</tr>
<tr>
<td>Cloud credentials</td>
<td>Credentials that Orchestration uses to access cloud resources.</td>
<td>No</td>
</tr>
<tr>
<td>JDBC credentials</td>
<td>A user name and password to access a Java Database Connectivity (JDBC) connection.</td>
<td>Yes</td>
</tr>
<tr>
<td>JMS credentials</td>
<td>A user name and password to access to a Java Message Service (JMS).</td>
<td>Yes</td>
</tr>
<tr>
<td>OAuth 2.0 credentials</td>
<td>OAuth 2.0 credentials enable ServiceNow to obtain access to user accounts on an HTTP service.</td>
<td></td>
</tr>
<tr>
<td>SNMP community credentials</td>
<td>The community string to access devices via SNMP.</td>
<td>Yes</td>
</tr>
<tr>
<td>SNMPv3 credentials</td>
<td>The user name and keys required to access devices on your SNMP v3 network.</td>
<td>Yes</td>
</tr>
<tr>
<td>SSH credentials</td>
<td>The user name and password to access Linux and Unix devices.</td>
<td>Yes</td>
</tr>
<tr>
<td>SSH private key credentials</td>
<td>The private key credentials to access Linux and Unix devices.</td>
<td>Yes</td>
</tr>
</tbody>
</table>

ℹ️ Note: For better security, SSH private key credentials are recommended over SSH password credentials.
<table>
<thead>
<tr>
<th>Credential type</th>
<th>Description</th>
<th>Supports Test Credential option</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware credentials</td>
<td>Credentials to access vCenter resources. These credentials are required for any work that is performed on vCenter, such as cloning a virtual machine.</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows credentials</td>
<td>The user name and password required to access Windows computers. Several permission requirements must be met to use Windows credentials.</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**How MID Servers use credentials**

By default, Windows MID Servers use the login credentials of the MID Server service on the host machine to discover Windows devices in the network. You should configure these service credentials so that they have domain or local administrator privileges. For Linux and UNIX machines and network devices, the MID Server uses the SSH and SNMP credentials configured in the instance in **Discovery > Credentials**.

MID Servers that Orchestration uses must have access to the necessary credentials to execute commands on computers in the network as specified by the **Workflow activities**. Orchestration can use the same SSH and SNMP credentials as Discovery, but has two additional credentials designed for specific Workflow activities: Windows (for **PowerShell**) and VMware.

**Encryption and decryption**

The platform stores credentials in an encrypted field on the Credentials [discovery_credentials] table. Once they are entered, they cannot be viewed.

When credentials are requested by the MID Server, the platform decrypts the credentials using the following process:

1. The credentials are decrypted on the instance with the password2 fixed key.
2. The credentials are re-encrypted on the instance with the MID Server's public key.
3. The credentials are encrypted on the load balancer with SSL.
4. The credentials are decrypted on the MID Server with SSL.
5. The credentials are decrypted on the MID Server with the MID Server's private key.
Note: The platform does not have separate encryption keys for multi-tenant instances.

Credential order

Credentials can be assigned an order value in the Credentials form, which forces the application to try all the credentials at their disposal in a certain sequence. If you do not specify an order value, the application tries the credentials in the Credentials [discovery_credential] table randomly, until it finds one that works, such as when Orchestration attempts to run a command on an SSH server (such as a Linux or UNIX machine), or when Discovery attempts to query an SNMP device (such as a printer, router, or UPS).

After identifying the credentials for a device, Discovery and Orchestration create an affinity between the credentials and the device using the Credential Affinity [dscy_credentials_affinity] table. All subsequent discoveries or Orchestration activities attempt to match the credentials in this table with a device for which an affinity exists. If credentials for a device change, Discovery and Orchestration try all available credentials again until they create a new affinity.

Note: If Orchestration and Discovery are installed, and credential alias is enabled, multiple affinities can exist. In this case, the platform looks up credentials for each affinity and inserts the credential for the affinity with the lowest order into the probe.

Ordering credentials is useful in the following situations:

- The credentials table contains many credentials, with some used more frequently than others. For example, if the table contains 150 SSH credentials, and 5 of those are used to log into 90% of the devices, it is good practice to configure those five with low order numbers, which places them at the top of the execution list. Discovery and Orchestration will work faster if they try these common credentials first. After the first successful connection, the system knows which credentials to use the next time for each device.

- The system has aggressive login security. For example, if the Solaris database servers in the network only allow three failed login attempts before they lock out the MID Server, configure the database credentials with a low order value.

Credential alias

Credential alias allows flow and workflow creators to:

- Assign individual credentials to any activity in an Orchestration workflow
- Assign individual credentials to any action in Flow Designer
• Assign different credentials to each occurrence of the same activity type in an Orchestration workflow.

• Assign different credentials to each occurrence of the same action in designer flow.

Credential alias also works with credential affinities.

**External credential stores**

If you do not want credentials stored in your instance, you can use external credential repositories. External credential stores save the credentials in an external site that your instance can access. Only CyberArk is supported.

**Connections with Orchestration**

Use the connections table to setup a JMS, JDBC, or HTTP(s) connection to a target host.

**Connection Table**

The Connection table (sys_connection) is the base table for all connection tables. You can setup connections for the following protocols:

• JDBC
• JMS
• HTTP(s)

The connection table references the connection alias table, which couples the connection alias to connection information. Every connection records the following information:

<table>
<thead>
<tr>
<th>Base connection properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Name of the connection. This field must be unique on the table.</td>
</tr>
<tr>
<td><strong>Credential</strong></td>
<td>Specify the credential to use with this connection. This is optional.</td>
</tr>
<tr>
<td><strong>Connection alias</strong></td>
<td>The connection alias resolves your connection and credentials at run time. Only one connection is active per Connection alias at any one time.</td>
</tr>
</tbody>
</table>
Base connection properties (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check to make the current connection active.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain to which the connection belongs.</td>
</tr>
</tbody>
</table>

Credential is unique across active connections, if not empty

**Upgrading connection information**
The JDBC connection (jdbc_connection) and JMS connection (orch_jms_ds) tables are existing Orchestration connection tables. In madrid, we re-parent them to extend from Connection (sys_connection) table. They move from Orchestration run time plugins to Credentials & Connections plugins. They are originally extended from sys_metadata. The sys_metadata related data will be removed. JDBC field name changes:

- JDBC server is renamed to host
- Database port is renamed to port

**Create custom activities using custom activity designer templates**

You can create and update different types of custom activities in the Workflow Editor using a custom template.

**Before you begin**
Roles required: workflow_admin or activity_creator

**About this task**
The Activity Designer contains common steps which are applicable to all the activities that you create. This procedure guides you through the common steps and the order they should be set up. You specify an activity template before you create a custom activity.

**Procedure**
1. Navigate to Orchestration > Workflow Editor. The Welcome tab of the Workflow Editor opens.
2. On the Custom tab in the palette, click + to create a new activity select the appropriate template from the list.
The Activity Designer form appears, with a stage indicator at the top. All new activities start at the **General** stage. The current stage shows with a blue underscore.

### Activity designer stage indicator

3. **Add the general properties.**
   This information is standard for each custom activity, include a name, description, and other related information.

4. **Create the template Create input variables for the template.**
   Create the variables to pass into the activity in the Inputs form of the activity designer.

5. **Optional:** **Add a pre-processing script.**
   For input validation or transforming input data, you might need a pre-processing script.

   **Note:** This step is not included in the Run Script activity.

6. **Click Continue to open the Execution Command form, then fill out the Execution Command step based on the corresponding execution templates:**
• Create a SOAP web service activity
• Create a JDBC activity
• Create a JavaScript Probe activity
• Create a PowerShell activity
• Create a REST web service activity
• Create a Probe activity
• Create an SFTP activity
• Create a Run Script activity
• Create an SSH activity
• Create a JMS activity

7. **Optional:** Test your inputs.

8. **Optional:** In the Outputs form, define local and/or output variables. Local variables can be used for temporary storage when cascading parsing rules. For example, you might extract an XML payload from within a JSON payload. A local variable can access the XML document and use that as a source for another parsing rule. The graphic shows a Local1 variable source to parse data for Output2.

   ![Define local variable](image)

9. Use one of the options to assign values to Outputs:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
   | Parsing rule    | You can create a parsing rule and map them to the output fields by dragging and dropping the variables into the parsing rules structure. The REST, SOAP, and JDBC templates provide auto-mapping to create the parsing rules automatically. If available from the test inputs form, au-
Post-processing scripts allow you to code your own output data validation, output parsing code, and related tasks. Post-processing executes after the execution command results have been returned and before the parsing rules and conditions are run. Click Go to Post-Processing (Advanced) to create a post-processing script.

Note: If you create a script, this step reflects as a stage in the indicator.

10. Click Continue to open the Conditions form to create exit condition rules for your activity and then click Save.

General properties for activity designer templates
The following General Property fields are common to all activity designer templates.

General Property fields common to all activity designer templates

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name of the activity. Select a unique name that makes the activity easily identifiable in the palette. If you do not name the activity, it is identified in the Data tab of the Workflow Editor with an index number when it is added to a workflow. This index reflects the order in which the custom activity was added to the workflow. Only custom activities and their output variables appear in the Data tab.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of what the activity does.</td>
</tr>
<tr>
<td>Image</td>
<td>Icon that identifies an activity of this type in the workflow palette.</td>
</tr>
<tr>
<td>Execution template</td>
<td>Predefined template selected for this activity.</td>
</tr>
</tbody>
</table>
General Property fields common to all activity designer templates (continued)

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Current scope set on the instance. To view the scope, click the gear icon on the right side of the title bar in any record or list and look at the value in the Application field. The activity runs in this scope within a workflow. You cannot view or change the scope for the instance in the Workflow Editor.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Accessibility setting for this activity, by scope. The following options are available:</td>
</tr>
<tr>
<td></td>
<td>• All application scopes: This activity is available to all application scopes.</td>
</tr>
<tr>
<td></td>
<td>• This application scope only: Use of this activity is restricted to the scope named in the Application field.</td>
</tr>
<tr>
<td>Category</td>
<td>Category for this activity in the Custom and Packs tabs. All categories are listed under their scope in the collapsible hierarchy.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the activity.</td>
</tr>
</tbody>
</table>

**Create input variables**

Create the variables to pass into the activity in the **Inputs** form of the activity designer.

**Before you begin**

You must name your activity in the **General** form before you can advance to the **Inputs** stage.

Roles required: workflow_admin or activity_creator

>i Note: Variable strings in the **Inputs** form have a 255 character limit.

**Procedure**

1. Click the + icon to create a new input variable.

   The designer creates a default variable called **Input1**.
2. Type your new variable name in the field.
3. To change the name of a variable or any of its attributes, double-click the value and then select or enter a new value in the field that appears.
4. Configure your variable using these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Data type for this variable. Double-click on the field to display the choice list. In addition to the usual data types, you can create input arrays and encrypt individual variables that contain sensitive data. Encrypted variables are passed to the ECC Queue and then decrypted by the MID Server when they run on the target host. Sensitive data returned from running these variables on the host can then be passed to another activity through encrypted output variables.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Marks an input variable as mandatory. Variables marked as mandatory are required fields in the properties form for the activity in the workflow. The input testing feature allows you to filter on mandatory variables.</td>
</tr>
<tr>
<td>Default</td>
<td>Default value for this input variable. Default values are prepopulated for</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>variables in the properties form for the activity in the workflow. You can override this value when you test the variables.</td>
</tr>
</tbody>
</table>

5. To reorder the variable list, select a row and then drag the row to its new location.

   When you select a row to move it, the pointer icon changes to an up/down arrow icon (↕).

6. To delete a variable, click the delete icon (🗑) in the row.

7. Click Continue to advance to the Execution Command stage or click Go to Pre-Processing (Advanced) to create a script that runs before the activity executes.

---

**Map an input variable**

After you create the input variables, map them to the fields in the Execution Command form.

**Before you begin**

Role required: activity_admin, activity_creator

**About this task**

These fields contain values required by the target host or endpoint to authenticate and query for data. Included in this example are fields for a command to run on the target and the MID Server to use, if one is required.

**Procedure**

To map a variable, drag it into the appropriate field.

The designer automatically expresses the variable in the syntax the system requires.
Configure the PowerShell execution command

Use the input variables you created to configure the command that Orchestration executes on the Windows target machine.

Before you begin
Create the input variables you need in the Inputs form before you can advance to the Execution Command stage.

Role required: activity_creator, admin

Note: You can test the PowerShell connection between the MID Server and the target computer without having to run the activity in a workflow context. For details, see test template outputs.

Procedure

1. Drag variables from the list of inputs and drop them into command fields. The system formats the variable in the proper syntax for the command.
2. Complete the fields shown in the table.

### PowerShell command fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Input variable builder. Create variables to map to available fields.</td>
</tr>
<tr>
<td>Target host</td>
<td>Host name or IP address of the target server for this PowerShell activity.</td>
</tr>
<tr>
<td>Script type</td>
<td>Type of script to run on the PowerShell host. Available options are:</td>
</tr>
<tr>
<td></td>
<td>• Custom Powershell command</td>
</tr>
<tr>
<td></td>
<td>• MID Server script file</td>
</tr>
<tr>
<td>MID Server script file</td>
<td>MID Server script file to run. This field is available when the <strong>Script type</strong> selected is <strong>MID Server script file</strong>.</td>
</tr>
<tr>
<td>Command</td>
<td>Command that this activity runs on the target host. This field is available when the <strong>Script type</strong> selected is <strong>Custom Powershell command</strong>. You can drag and drop input variables from the variable builder into this field to create your command.</td>
</tr>
<tr>
<td>Powershell variables</td>
<td>Name-value pairs to pass to the host with Powershell. You can create these variables manually, or drag input variables into the <strong>Value</strong> field. Encrypted input variables retain their encryption, regardless of the data type settings in this field. If you type in a value and select the <strong>Encrypted</strong> data type, your value appears in plain text in this field and is only encrypted when it passes to the ECC Queue.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use MID service account</td>
<td>Forces this activity to authenticate on the target host using the credentials of the MID Server service account only, without trying any other credentials. When this check box is selected, the <strong>Credential tag</strong> field is not available.</td>
</tr>
<tr>
<td>Credential tag</td>
<td>Specific credential alias this activity must use to run Powershell commands on the host. If this field is left blank, the MID Server tries all the available credentials until it finds a valid one, ending with the MID Server service account. If a credential alias is defined, the MID Server tries the credentials for that alias only and does not try the MID Server service account. This field is not available when the <strong>Use MID service account</strong> check box is selected.</td>
</tr>
<tr>
<td>Required MID Server capabilities</td>
<td>MID Server to use for querying Powershell, by capabilities. By default, the system selects a Powershell MID Server.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

4. Click **Continue** to advance to the **Outputs** stage.

**Test activity template inputs**

You can test the input parameters of a custom activity during its development without having to run the activity in a workflow context.

**Before you begin**

Create input variables and map them to fields in the **Execution Command** form or provide actual values for these fields.

Role required: web_service_admin, activity_admin, activity_creator

**About this task**

An input test executes only the input parameters against an endpoint and not the pre-processing or post-processing scripts. You need to use a workflow to test a pre-processing or post-processing script. You do not need to check out the activity to test it, and you can test input variables from any stage in the activity designer, if your activity is properly configured. Typically, the **Execution Command** stage is the point at which your inputs are ready for testing.

**Note:** If you intend to use auto-mapping, you must test your input variables.
Procedure

1. Click **Test Inputs**.
   
   The list of input source variables appears. If you added default values for these variables, those values appear in the **Substitute Value** column. Mandatory variables are marked with a red star. In this example, a SOAP endpoint returns a value for a stock quote variable.

![Fill in your test values](image)

2. Filter the variable list with these controls:
   
   - **All Inputs**: Displays all input variables. This is the default view.
   - **Mandatory Inputs**: Displays only mandatory input variables.
   - **Inputs Without Defaults**: Shows input variables that do not have assigned default values.

3. Reset values as needed.
   
   - **Reset default values**: Replaces any test values set in this form with the default values, if they are present.
   - **Clear values**: Clears all values in the input variable list, even if default values exist.

4. When your test values are configured correctly, click **OK**.
   
   The system runs the values for all the inputs configured against the specified target and returns the resulting payload. The buttons in the Response form display different views of the payload. The entire payload appears in the **Raw Output** window.
5. To map appropriate parameter values in the payload to variables in the **Outputs** stage automatically, select an **auto-mapping option**.

6. Alternately, you can click **Save for parsing rules** to copy the entire payload to the parsing rules. This allows you to manually select values for the output variables directly from the payload. This action completely overwrites any previous payload that existed in the parsing rules.

7. Click the **X** in the upper right corner of the window to close it.

**Data encryption for activity variables**

You can protect sensitive data passed from Orchestration activities by encrypting input and output variables.

The system never stores encrypted variables as clear text. If the MID Server is used to fulfill the activity, the corresponding ECC Queue's input payload is encrypted if an **encrypted output variable** is defined in the template. Output variables passed to a downstream activity as input variables maintain their encryption throughout processing.

Inputs that require data encryption come from one of these sources:
• Workflows: These inputs are provided through the Workflow Editor and must be in the password2 format for two-way encryption.

• Service catalog requests: These input values are provided to an activity as encrypted variables from a service catalog item.

• GlideRecord: These are variables attached to any ServiceNow table. The source column in the table must be a password2 type variable.

• Activity outputs: These are variables passed as outputs from one activity to a downstream activity as inputs, through the data bus.

• Empty string: The system allows you to define encrypted input variables but never pass a value into the variable.

**Activity designer template pre-processing fields**

Use the **Pre Processing** form of the activity designer to define a script to run before the activity executes.

**Pre-processing fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input process script</td>
<td>Script to run before the activity executes.</td>
</tr>
<tr>
<td>Variables</td>
<td>Input variables that are available to use as building blocks in the input process script. Click the arrow above the field to open the variables list. Click an item in the tree to add it to your script in the appropriate syntax. The list displays execution parameters and input variables you passed into the activity on the <strong>Inputs</strong> form. All activity variables added in the <strong>Inputs</strong> form are read-only and are expressed in the pre-processing script with this syntax: <code>activityInput.variable</code>. Before the activity executes and makes a call to the service or host, you can override the effective execution value of this variable by assigning values to the <code>executionParam.variable_name</code> execution parameter. Refer to the specific execution parameters for your template.</td>
</tr>
</tbody>
</table>

**Logging**

Activity designers can add logging to the pre-processing using the **ActivityLogger** API, which works for scoped or global applications. Logged data from the script appears in the **Workflow Log** related list in the context records.
for any workflow that uses the activity. The Source for these messages in the workflow log is ACTIVITY.

**Important:** To display the debug messages in the workflow log, set the glide.workflow.log.debug property to true.

The supported messages are:

- `ActivityLogger.debug("Pre Processing Log Message");`
- `ActivityLogger.info ("Pre Processing Log Message");`
- `ActivityLogger.warn ("Pre Processing Log Message");`
- `ActivityLogger.error("Pre Processing Log Message");`

**Template post-processing fields**

From the Post Processing form in the activity designer you can define a script to run after the activity executes.

**Post-processing fields**

To use the results returned by the activity, append the executionResult. prefix to these parameters.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output process script</td>
<td>Script to run after the activity executes.</td>
</tr>
<tr>
<td>Variables</td>
<td>Input variables that are available to use as building blocks in the output process script. Click the arrow above the field to open the variables list. Click an item in the tree to add it to your script in the appropriate syntax. The list displays execution results and the variables you passed into the activity on the Inputs form. All activity variables added in the Inputs form are read-only and are expressed in the post-processing script with this syntax: activityInput.variable.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>For parameter descriptions, refer to the table in the post-processing parameters topic for this activity.</td>
</tr>
</tbody>
</table>

**Logging**

Activity designers can add logging to the post-processing script using the `ActivityLogger` API, which works for scoped or global applications. Logged data from the script appears in the **Workflow Log** related list in the context records for any workflow that uses the activity. The **Source** for these messages in the workflow log is **ACTIVITY**.

**Important:** To display the debug messages in the workflow log, set the `glide.workflow.log.debug` property to `true`.

The supported messages are:

- `ActivityLogger.debug("Post Processing Log Message");`
- `ActivityLogger.info ("Post Processing Log Message");`
- `ActivityLogger.warn ("Post Processing Log Message");`
- `ActivityLogger.error("Post Processing Log Message");`

**Auto-map activity output variables**

You can map parameter values in a test payload to variables in the **Outputs** tab automatically.

**Before you begin**

Role required: admin

**Procedure**

1. From the Execution Command in the template, select the **Inputs** tab.
2. Click **Test Inputs** to test the input parameters.
If you added actual values for the parameters and fields, the system runs those values against the specified target and returns the resulting payload. If you mapped input variables to fields and parameters, the system displays a dialog box for assigning test values to those variables.

3. Provide test values, if requested, and click **OK** to display the payload. The entire payload appears in the **Raw Output** tab of the Response form.

4. Select an auto-mapping option:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Auto-Map to Local     | Translates the entire payload into a JSON object and places it in the data bus. This allows for post-processing manipulation in JavaScript. This selection causes the entire data field on the right to disappear and the inputs structure to be auto-populated with these default variables:  
  • output  
  • totalRows  
  • errorMessage  
  • eccSysId |
| Auto-Map to Output    | Automatically populates the output variables in the activity with the same default variables used as inputs for the local variable. |

⚠️ **Note:** No parsing rules are available with auto-mapping selections.

**Create an output variable**

The **Outputs** form in the designer contains a variable builder for creating data structures of objects and arrays.

**Before you begin**

Roles required: activity_admin, activity_creator
About this task
Elements in this structure are mapped with Create a parsing rule to specific data contained in payloads returned from an endpoint or host. These variables and their values are then made available locally or for reuse in other activities.

Procedure
1. Click the + icon in the Outputs column to create a local or output variable.

   Local variables are only available within an activity and are not visible in the data structures displayed in the Custom tab. Output variables are available for reuse in other activities, either individually or as an entire data structure. When you create a new variable of either type, the designer provides a default name of Local1 or Output1.

2. Type your new variable name in the field and select a data type.

   Variable names must be unique within an array or an object. You can assign a data type of Encrypted to output variables that contain sensitive data. Data protected by encryption is passed to other activities or processes encrypted and is never displayed in plain text.

3. To change the name of a variable or any of its attributes, double-click the value, type a new value in the editing field, and then press Enter.

   The icon to the left of the name reflects the data type of the variable.

4. To reorder the variable list, select a row and then drag the row to its new location.

   When you select a row to move it, the pointer icon changes to an up/down arrow icon (↑↓).

5. Drag and drop the row into another location.

6. To reuse a variable from another activity, drag it from the Custom tab in the palette and drop it onto the Local or Output heading at the top of the variable list. To copy an entire data structure, drag the parent object or array into the variable list header.

   The designer duplicates the copied data structure in the outputs variable builder.
7. To delete a variable, click the delete icon (🗑️) in the row.

Activity designer template outputs

Output variables contain messages returned from a destination that are available to other activities in a workflow or internally to the activity.

Activity designer output fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable name</td>
<td>Name of a variable, either Local or Output, that this activity passes.</td>
</tr>
<tr>
<td>Local</td>
<td>Variable that contains a value used within an activity. For example, use a local variable to identify metadata that is processed within an activity before the final value is exported to an output variable.</td>
</tr>
<tr>
<td>Output</td>
<td>Variable that contains a value that is passed to other activities in the workflow.</td>
</tr>
</tbody>
</table>

Map an output field

Mapping is configured with parsing rules that allow you to build expressions in the appropriate data format for the selected payload.

Before you begin

Role required: activity_admin, activity_creator

About this task

When you are finished creating the output data structure, map each variable to the specific data you want to extract from the target host.
Procedure

To map a variable, drag it from the Outputs variable builder and drop it into an empty Variable name field in the Parsing rules section.

See create a parsing rule for instructions on configuring parsing for output variables.

Create a parsing rule

Populate output variables defined in a custom activity with payload data returned from an inputs test on an external host or endpoint.

Before you begin

Roles required: activity_admin, activity_creator

About this task

Procedure

1. Navigate to Workflow > Workflow Editor.
2. From the Custom tab in the palette, open a custom activity.
3. In the Activity Designer form, advance to the Output stage.
4. Drag an output variable from the data structure builder into the Variable name field in the Parsing rules builder.
The parsing rules form appears for the selected variable. By default, the parsing type is set to **Direct**, which populates the variable with all the data from the selected payload, without parsing the contents. Each template has a specific default parsing source.

5. Complete the form using the fields in the table.
   In this example, the parsing type selected is **XML**, which allows you to select specific parameters from the payload to parse.
## Parsing rules fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parsing source</td>
<td>Source of the data returned from the target host or endpoint. Each template opens to a specific, default payload. Available choices depend on the execution template selected for the activity. You can also use local variables as a parsing source if a parsing rule has previously been defined for them. For a list of the available payloads for each template, see Activity designer parsing sources.</td>
</tr>
<tr>
<td>Expression</td>
<td>Expression used to extract specific data from the selected parsing source. This expression is created from clickable data in the sample payload and appears in the format selected in the Parsing type field. When testing, the expression can return multiple results. Discern which choice gives reliable or predictable results before choosing your expression.</td>
</tr>
<tr>
<td>Note</td>
<td>The system cannot generate clickable RegEx expressions from sample data. You must write all regular expressions manually.</td>
</tr>
<tr>
<td>Variable name</td>
<td>Revised variable name as it is used in the final output expression. The system adds the activityOutput or activityLocal prefix to the variable you specify.</td>
</tr>
<tr>
<td>Parsing type</td>
<td>The language to use for querying the target host's payload. The selections are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Direct</strong>: Maps to the entire content of the payload selected in the Parsing source field, without any parsing. This is the default parsing type.</td>
</tr>
<tr>
<td></td>
<td>• <strong>XML</strong>: XPath query used for selecting nodes from an XML payload.</td>
</tr>
<tr>
<td></td>
<td>• <strong>JSON</strong>: JSONPath query for selecting parts of a JSON payload.</td>
</tr>
<tr>
<td></td>
<td>• <strong>RegEx</strong>: Parsing method that uses a regular expression to extract data from a payload. The RegEx parsing type does not support multi-line parsing and is not case sensitive.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of this parsing rule.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sample payload data</td>
<td>Sample data from the source containing the data requested. This field is not available for <strong>Direct</strong> parsing types. After you click <strong>Parse sample data</strong>, the data in this field cannot be edited, but becomes clickable for the purpose of creating expressions. Click <strong>Edit sample data</strong> to make the field editable again.</td>
</tr>
<tr>
<td>Parsing results</td>
<td>Displays the data returned from the source by the selected expression. This field is not available for <strong>Direct</strong> parsing types.</td>
</tr>
</tbody>
</table>

6. To retest the inputs, click **Get sample payload from test**. This action reopens the test form, allowing you to substitute different test values and create a different payload.

7. Click **Save** to have the parsing rules overwrite the previous payload with the one you just created.

8. To create an expression for the parsing rule, click the specific parameter you want to see in the sample payload. The value for that parameter appears in the **Parsing result** field, and the system creates the appropriate expression in the **Expression** field.

9. Click **Submit** to save the parsing rule for that variable.

**Activity designer parsing sources**

This table lists the parsing sources available with each execution template.

<table>
<thead>
<tr>
<th>Parsing sources</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Template</strong></td>
</tr>
</tbody>
</table>
| SOAP Web Service| • executionResult.body (Default)  
|                 | • executionResult.status_code  
|                 | • executionResult.header  
|                 | • executionResult.error      |
| JDBC            | • executionResult.output (Default)  
|                 | • executionResult.errorMessages  
|                 | • executionResult.probeCompletedEccId  
|                 | • executionResult.totalRows     |

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
## Parsing sources (continued)

<table>
<thead>
<tr>
<th>Template</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>JavaScript Probe</td>
<td>• <code>executionResult.payload</code> (Default)</td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult.output</code></td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult.eccSysId</code></td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult.errorMessages</code></td>
</tr>
<tr>
<td>Powershell</td>
<td>• <code>executionResult.output</code> (Default)</td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult.tags</code></td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult_hresult</code></td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult.eccSysId</code></td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult.errorMessages</code></td>
</tr>
<tr>
<td>REST Web Service</td>
<td>• <code>executionResult.body</code> (Default)</td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult.status_code</code></td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult.header</code></td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult.error</code></td>
</tr>
<tr>
<td>SFTP</td>
<td>• <code>executionResult.output</code> (Default)</td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult.eccSysId</code></td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult.errorMessages</code></td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult.tags</code></td>
</tr>
<tr>
<td>Probe</td>
<td>• <code>executionResult.output</code> (Default)</td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult.payload</code></td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult.eccSysId</code></td>
</tr>
<tr>
<td>SSH</td>
<td>• <code>executionResult.output</code> (Default)</td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult.eccSysId</code></td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult.errorMessages</code></td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult.tags</code></td>
</tr>
<tr>
<td>JMS</td>
<td>• <code>executionResult.status</code></td>
</tr>
<tr>
<td></td>
<td>• <code>executionResult.standardHeaders</code></td>
</tr>
</tbody>
</table>
### Parsing sources (continued)

<table>
<thead>
<tr>
<th>Template</th>
<th>Source</th>
</tr>
</thead>
</table>
|          | • executionResult.customHeaders  
|          | • executionResult.messagePayload  
|          | • executionResult.eccSysId  
|          | • executionResult.errorMessages |

### Activity designer parsing rule example

In this example, the parsing rule is configured to populate the `activityOutput.ipv4` variable with the value for the IP address from a domain server, using PowerShell.

#### Before you begin
Role required: activity_creator, activity_admin

#### About this task
To generate the sample data, the administrator must actually run the command on the host and then paste the data returned into the **Sample payload data** field when creating the parsing rule. The administrator can then create an expression that returns IP addresses from that sample in two formats: `ipv4` and `ipv6`. In this example, the system produces two expressions to use for the parsing rule.

#### Procedure

1. Navigate to Workflow > Workflow Editor and open the activity that runs on the host.
2. Click the **Inputs** tab, and note the **Command**.
3. In a PowerShell console, run the **Command** on the host to extract the XML sample that contains the values you need.

4. Copy the data that is returned to the clipboard.

5. In the activity designer, click the **Outputs** tab and paste the returned data into the **Sample payload data** field.

   In this example, the data includes IP addresses in two different formats and the domain name.

6. Select the parsing type for the source. In this example, select **XML**.

7. Click **Parse sample data**.

   The system displays the XML in the proper format, and it becomes **clickable**.

   In this view, the system can translate clicked data from the sample into an expression.
8. To create the expression, click the elements in the data sample you want to map to the variable.

Based on the sample data you clicked, the system creates two expressions.

9. Select an expression from the list.

The desired result is the IP address that has a **type** attribute of **ipv4**. The system populates the **Expression** field with this choice.
10. Click **Test expression**.

The system parses the payload using the selected expression and returns the requested data in the **Parsing result** field.

11. Click **Submit**.

The view returns to the **Outputs** tab of the activity designer. The new parsing rule is listed, and a blank row is available for another rule.

**Activity conditions**

Create the exit conditions for your activity in the **Condition** column and set the order for each.

The system evaluates the condition with the lowest order number first and stops when it finds the first true condition. The system delays evaluation of conditions with an **Else** value set to **true** until all conditions with an **Else** value set to **false** are evaluated. If the system does not find a true condition, it looks for a default
condition in which the value for **Else** is true and takes this exit. You must have at least one default exit condition, or the activity hangs when the workflow runs.

The following are possible conditions you might create for an activity:

### Sample activity conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Evaluation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Tests for a success condition. <strong>Else</strong> is set to false and the Order is set to 100. If this condition is true, the activity takes the Success exit. If this condition is false, the system evaluates the next condition in order.</td>
</tr>
<tr>
<td>Retry</td>
<td>Tests for a condition that runs the activity again. <strong>Else</strong> is set to false. If this condition is true, the activity runs again. If this condition is false, the system takes the default Failure exit.</td>
</tr>
<tr>
<td>Failure</td>
<td>Default condition that allows the workflow to continue if the other conditions in the activity are false. <strong>Else</strong> is set to true.</td>
</tr>
</tbody>
</table>

### Orchestration custom activity templates

Orchestration provides customizable activity templates to create and manage custom activities in the Workflow Editor.

You create and update different types of Orchestration activities with the Activity Designer using activity templates for SSH, PowerShell, REST, SOAP, JMS, SFTP, JDBC, JavaScript Probes, and Probes.

Hundreds of workflows can share these activities simultaneously. Before you change an activity, you should check the workflows that they are part of by clicking the form menu icon (≡) and selecting **Used In**. Any central change to a versioned activity automatically updates across workflows unless you have pinned that activity.

All the Orchestration Core activities are built using the Activity Designer in scoped applications. Custom activities can be developed in the global scope...
or their own application scope even if that scope is different from the scope of the workflow. Use Activity scoping when build your own activity packs.

Create a JDBC activity
Create a custom JDBC activity to automate SQL commands and stored procedure calls to relational databases from workflow.

Before you begin
Role required: activity_admin, activity_creator

About this task
The JDBC activity template allows you to execute ANSI SQL statements or stored procedures on a target database. Support for stored procedures with IN, OUT, and INOUT parameters are available in Rome. To learn how to set up these parameters, see JDBC stored procedure parameters.

Note: If you are transferring bulk data into a ServiceNow instance from an external data source, use Import sets. The JDBC activities allow you to transfer data between external data sources and ServiceNow within a workflow. It is not intended to replace the bulk import features of data sources.

Procedure
1. Create or verify your JDBC credential.
   Your JDBC credentials must have permission for the target database and proper configuration for the corresponding JDBC connection. Credentials must be set up before you can create a JDBC activity.

2. Create or verify your JDBC connection.
   Your JDBC connection must be configured with valid JDBC credentials set up before you can create a JDBC activity.

3. Create a custom activity.
   This action creates a custom activity using a template.

4. After setting up general properties and creating input variables, configure the JDBC Execution Command:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JDBC Connection</td>
<td>Configure or reference the appropriate JDBC Connection for the database. The connection selected provides the activity with the following information:</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• Target database information (server and database names)</td>
</tr>
<tr>
<td></td>
<td>• Connection URL</td>
</tr>
<tr>
<td></td>
<td>• Target database port (if different from standard port number)</td>
</tr>
<tr>
<td></td>
<td>• Database instance name</td>
</tr>
<tr>
<td>Credential</td>
<td>JDBC credential to use for your JDBC connection.</td>
</tr>
<tr>
<td>SQL statement</td>
<td>Input the ANSI SQL to execute on the JDBC target database.</td>
</tr>
</tbody>
</table>

**Note:** This field is hidden when the Stored Procedure check box is selected.

You can map the input variables you created to configure the SQL statements. By default, you can run the following SQL statements.

- select
- insert
- update
- delete
- show
- create
- describe

For added security measure, a MID Server property controls the operations that this JDBCOrchestration-Probe executes, which restricts the SQL commands used. This property protects against potentially destructive commands, such as drop database. The mid.property.jdbc_operations contains the MID Server property controls.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note:</td>
<td>You cannot run multiple statements of different types. For example, you cannot run a select statement and an update statement together, but you can run two insert statements. However, you cannot run multiple select statements in this activity.</td>
</tr>
<tr>
<td>Maximum rows</td>
<td>Maximum number of records to retrieve from database. The default is 1000.</td>
</tr>
<tr>
<td>Maximum payload size (KB)</td>
<td>You can set a limit on the maximum payload size of data retrieved from the database. The default is 64 kilobytes.</td>
</tr>
<tr>
<td>Connection timeout</td>
<td>How long the activity waits to make the connection. This field is populated automatically from the data source, but can be changed for this activity.</td>
</tr>
<tr>
<td>Query timeout</td>
<td>Elapsed time to wait after running the query until the data is returned. This field is populated automatically from the data source, but can be changed for this activity.</td>
</tr>
<tr>
<td>Required MID Server capabilites</td>
<td>MID Server to use for querying JDBC, by capabilities. By default, the system selects a MID Server that has JDBC capability.</td>
</tr>
<tr>
<td>Use stored procedure</td>
<td>If checked, you can run a stored procedure on MySQL, Oracle, or SQL Server databases by entering the procedure name and parameters. See JDBC stored procedure parameters.</td>
</tr>
</tbody>
</table>

**Note:** You can map parameter values in a test payload to variables in the Outputs tab automatically. See automap output variables.
What to do next

- Test JDBC activity inputs
- Use auto-mapping to generate outputs and parsing rules (recommended for JDBC)
- If you do not use auto-mapping, you can manually create output variables and create parsing rules

Related information

Create custom activities using custom activity designer templates

Create a JDBC connection for an Orchestration activity

The JDBC Connection [jdbc_connection] table provides the information custom JDBC Orchestration activities use to connect to various target databases.

Before you begin

You must have an appropriate JAR file, whether it is supplied with the instance or a custom JAR file.

Tip: The ServiceNow instance supplies mysql-connector-java-5.1.21.jar, sql-server-jdbc-4.0.jar, and ojdbc6.jar files as part of the current release, which supports MySQL, SQLServer, and Oracle databases. Other databases, such as Sybase or DB2 Universal, must use a custom JAR file that must be uploaded to the instance before setting the JDBC connection.

Related information

Create custom activities using custom activity designer templates

Create a JDBC connection for an Orchestration activity

The JDBC Connection [jdbc_connection] table provides the information custom JDBC Orchestration activities use to connect to various target databases.

Before you begin

You must have an appropriate JAR file, whether it is supplied with the instance or a custom JAR file.

Tip: The ServiceNow instance supplies mysql-connector-java-5.1.21.jar, sql-server-jdbc-4.0.jar, and ojdbc6.jar files as part of the current release, which supports MySQL, SQLServer, and Oracle databases. Other databases, such as Sybase or DB2 Universal, must use a custom JAR file that must be uploaded to the instance before setting the JDBC connection.

Role required: activity_admin, activity_creator

About this task

JDBC credentials are retrieved separately by the activity designer template and support external credential storage, such as CyberArk.

Procedure

1. Navigate to Orchestration > Credentials & Connections > JDBC Connections and click New.
2. Complete the form using the fields in the table.
   - The database selection in the Format field determines which fields are available.

<table>
<thead>
<tr>
<th>Field</th>
<th>Database Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>All</td>
<td>Unique name of this JDBC connection. For example, you might enter JDBC MySQLProd.</td>
</tr>
<tr>
<td>Field</td>
<td>Database Format</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Query timeout</td>
<td>All</td>
<td>Maximum elapsed time the JDBC query is allowed to run without a response.</td>
</tr>
<tr>
<td>Connection timeout</td>
<td>All</td>
<td>Maximum elapsed time for the JDBC activity to wait while attempting to connect to the target database.</td>
</tr>
<tr>
<td>Application</td>
<td>All</td>
<td>Scope for this table. By default, the JDBC Connection [jdbc_connection] table runs in the <strong>Global</strong> scope.</td>
</tr>
<tr>
<td>Domain</td>
<td>All</td>
<td>Domain for this table. By default, the JDBC Connection [jdbc_connection] table runs in the <strong>global</strong> domain.</td>
</tr>
<tr>
<td>Format</td>
<td>All</td>
<td>Database type for this connection. The default choices are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MySQL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Oracle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SQLServer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• None</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can add <strong>Sybase</strong> or <strong>DB2 Universal</strong> to the choice list by uploading the appropriate JDBC driver JAR file to the instance. Orchestration automatically recognizes these drivers when they are loaded into the system and adds them to this list.</td>
</tr>
<tr>
<td>Server</td>
<td>Oracle, MySQL, SQLServer</td>
<td>Host name or IP address of the database server.</td>
</tr>
<tr>
<td>Oracle sid</td>
<td>Oracle</td>
<td>The Oracle database site identifier. The default value is <strong>orcl</strong>.</td>
</tr>
<tr>
<td>Oracle port</td>
<td>Oracle</td>
<td>Port that the Oracle database is using. The default value is <strong>1521</strong>.</td>
</tr>
<tr>
<td>Database name</td>
<td>MySQL, SQLServer</td>
<td>Name of the database.</td>
</tr>
<tr>
<td>Database port</td>
<td>MySQL, SQLServer</td>
<td>Port that the selected database is using.</td>
</tr>
<tr>
<td>Field</td>
<td>Database Format</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Instance name</td>
<td>SQLServer</td>
<td>Instance name for the selected SQLServer</td>
</tr>
<tr>
<td>Connection URL</td>
<td>All</td>
<td>URL that the MID Server uses to connect to the specified database. The URL is created automatically when you save the form, and is read-only for the default databases. <strong>Note:</strong> If the format selected is not one of the default databases, you must create the connection URL manually so that the MID Server knows how to create the connection.</td>
</tr>
<tr>
<td>JDBC driver</td>
<td>None, DB2 Universal, Sybase</td>
<td>The JDBC driver to use for this connection when it is not a default database. <strong>Note:</strong> If you add a Sybase or DB2 Universal database, you must enter the driver name in this field and upload the driver JAR file to the instance.</td>
</tr>
</tbody>
</table>

**JDBC connection to Oracle example**

![JDBC connection to Oracle example](image)

3. Click **Submit**.

**Related reference**

JDBC credentials
Auto-map JDBC activity output variables

The ServiceNow activity designer allows you to map parameter values in a JDBC test payload to variables in the **Outputs** tab automatically.

**Before you begin**

Role required: admin

**Procedure**

1. In the JDBC provider template form, select the **Inputs** tab.
2. Click **Test Activity** to test the input parameters.
   - If you added actual values for the parameters and fields, the system runs those values against the specified target and returns the resulting payload. If you mapped input variables to fields and parameters, the system displays a dialog box for assigning test values to those variables.
3. Provide test values, if requested, and click **OK** to display the payload.
   - The entire payload appears in the **Raw Output** tab of the Response form.
4. Select one of these auto-mapping options.
   - **Auto-Map to Local**: Directly maps values to a local variable for use within the activity.
   - **Auto-Map to Output**: Directly maps values to the output variable to pass to other activities in the workflow. Auto-mapping to an output variable creates an array of objects, each of which contains the column names from the query result.

**JDBC stored procedure parameters**

You can use Orchestration to run a stored procedure on MySQL, Oracle DB, and MS-SQL databases.

There is support of multiple data types, with the following limitations:

- Only one result-set is returned.
- The order of input and output data types in the stored procedure parameters must match the activity definition.
- Binary, Blob, Varbinary, and LongBinary should be base64 encoded.
- Date, Time, and Timestamp have a specific format:
Date format: yyyy-mm-dd

yyyy-mm-dd is the supported format.

Time format: hh:mm:ss[.sss]

hh:mm:ss[.sss] is the supported format. Precision is in milliseconds only, microseconds or nanoseconds cannot be handled.

⚠ **Note:** 10:30:59 and 10:30:59.999000 are correct but 10:30:59. is incorrect.

Timestamp format: yyyy-mm-dd hh:mm:ss[.ffffff]

yyyy-mm-dd hh:mm:ss[.ffffff] is the supported format. Precision is to microseconds.

- ResultSet is the first result set coming back from database server.
- MS-SQL does not support INOUT parameters. If you use INOUT parameters, the Activity Template transparently maps them to OUT parameters.

⚠ **Note:** If you do not want to do a validation of data types in stored procedure parameters, like the legacy behavior, you set the glide.stored_proc.data_type.validation as false. See MID Server properties for more information.

### Stored procedure parameters

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>Type of stored procedure parameter. Supported parameters:</td>
</tr>
<tr>
<td></td>
<td>• IN</td>
</tr>
<tr>
<td></td>
<td>• OUT</td>
</tr>
<tr>
<td></td>
<td>• INOUT</td>
</tr>
<tr>
<td>Sql Type</td>
<td>A SQL data type. Supported data types:</td>
</tr>
<tr>
<td></td>
<td>• ARRAY</td>
</tr>
<tr>
<td></td>
<td>• BIGINT</td>
</tr>
<tr>
<td></td>
<td>• BINARY</td>
</tr>
<tr>
<td></td>
<td>• BIT</td>
</tr>
<tr>
<td></td>
<td>• BLOB</td>
</tr>
</tbody>
</table>
### Stored procedure parameters (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• CHAR</td>
<td></td>
</tr>
<tr>
<td>• CLOB</td>
<td></td>
</tr>
<tr>
<td>• DATE</td>
<td></td>
</tr>
<tr>
<td>• DECIMAL</td>
<td></td>
</tr>
<tr>
<td>• DISTINCT</td>
<td></td>
</tr>
<tr>
<td>• DOUBLE</td>
<td></td>
</tr>
<tr>
<td>• FLOAT</td>
<td></td>
</tr>
<tr>
<td>• INT</td>
<td></td>
</tr>
<tr>
<td>• INTEGER</td>
<td></td>
</tr>
<tr>
<td>• JAVA_OBJECT</td>
<td></td>
</tr>
<tr>
<td>• LONGVARBINARY</td>
<td></td>
</tr>
<tr>
<td>• LONGVARCHAR</td>
<td></td>
</tr>
<tr>
<td>• NULL</td>
<td></td>
</tr>
<tr>
<td>• NUMERIC</td>
<td></td>
</tr>
<tr>
<td>• OTHER</td>
<td></td>
</tr>
<tr>
<td>• REAL</td>
<td></td>
</tr>
<tr>
<td>• REF</td>
<td></td>
</tr>
<tr>
<td>• REF_CURSOR</td>
<td></td>
</tr>
<tr>
<td>• SMALLINT</td>
<td></td>
</tr>
<tr>
<td>• STRUCT</td>
<td></td>
</tr>
<tr>
<td>• TIME</td>
<td></td>
</tr>
<tr>
<td>• TIMESTAMP</td>
<td></td>
</tr>
<tr>
<td>• TINYINT</td>
<td></td>
</tr>
<tr>
<td>• VARBINARY</td>
<td></td>
</tr>
<tr>
<td>• VARCHAR</td>
<td></td>
</tr>
</tbody>
</table>

| Name/Value        | Name-value pairs to pass to the host. You can create these parameters manually, or drag and drop input |

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Stored procedure parameters (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>variables into the parameter fields and assign a value.</td>
</tr>
</tbody>
</table>

⚠️ Note: Not all database providers support the entire realm of JDBC data types. Reference your database reference manual to understand the supported datatypes for your installation.

Test JDBC activity template inputs

You can test the input parameters of a custom JDBC activity during its development without having to run the activity in a workflow context.

Before you begin
Create input variables and map them to fields in the Execution Command form or provide actual values for these fields. Role required: web_service_admin, activity_admin, activity_creator

About this task
This test executes only the input parameters against an endpoint and not the pre-processing or post-processing scripts. It is not necessary to check out the activity to test it.

⚠️ Note: If you provide enough information for Orchestration to contact the endpoint or host and return data, you can test the input variables. You can test from any stage in the activity designer. Typically, the Execution Command stage is the point at which your inputs are ready for testing.

Procedure

1. From the JDBC Execution Command, click Test Inputs.
   The list of input source variables appears. If you added default values for these variables, those values appear in the Substitute Value column. Mandatory variables are marked with a red star.

   ⚠️ Note: The test fails if the MID Server cannot be found or if it cannot connect to the target.
2. Filter the variable list with these controls:
   • **All Inputs**: Displays all input variables. This control is the default view.
   • **Mandatory Inputs**: Displays only mandatory variables.
   • **Inputs Without Defaults**: Shows input variables that do not have assigned default values.

3. Reset values as needed.
   • **Reset default values**: If values are present, this control replaces any test values set in this form with the default values.
   • **Clear values**: Clears all values in the input variable list, even if default values exist.

4. When your test values are configured correctly, click **OK**.
   The system runs the values for all the inputs configured against the specified target and returns the resulting payload. The buttons in the Response form display different views of the payload. The entire payload appears in the **Raw Output** window.
5. To map appropriate parameter values in the payload to variables in the **Outputs** stage automatically, select an auto-mapping option.

6. 

7. Click the X in the upper right corner of the window to close it.

**Create a SOAP web service activity**

Use this template to create a custom SOAP activity.

**Before you begin**

Role required: web_service_admin, activity_admin, activity_creator

**About this task**

For instructions on using the activity template process flow, see [create custom activities](#).
Procedure

1. Create a custom activity.
   This action creates a custom activity using a template.

2. After setting up general properties and creating input variables, configure the SOAP web service Execution Command:

<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Map the input variables</strong></td>
<td>Use the variables you created to configure the command that Orchestration executes on the SOAP web service.</td>
</tr>
<tr>
<td><strong>Web service message</strong></td>
<td>Specify the SOAP web service message to use for this activity. If you need information on SOAP web services messages, see .</td>
</tr>
<tr>
<td><strong>Web service message function</strong></td>
<td>Specify the SOAP message function available in conjunction with the SOAP web service.</td>
</tr>
<tr>
<td><strong>Endpoint</strong></td>
<td>If you enter an endpoint in this field, it overrides the endpoint URL configured in the SOAP message web service. Click the lock icon to open the input field and add the endpoint.</td>
</tr>
<tr>
<td><strong>SOAP message parameters</strong></td>
<td>Name-value pairs to pass to the SOAP endpoint. You can create these parameters manually, or drag input variables into the parameter fields and then assign a value. Parameters defined in the SOAP message that use $() can be assigned data from this activity template. Use the Additional attribute column to configure the system to not escape the text. By default, text sent to the SOAP message is escaped. The Name column is auto-populated if the users have provided variables using variable substitution in the SOAP message.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use MID Server</td>
<td>Check box that determines if a MID Server must be used to invoke the SOAP web service. If the SOAP web service message function defines a MID Server, that MID Server is used instead of the one selected here.</td>
</tr>
<tr>
<td>Required MID Server capabilities</td>
<td>MID Server with the appropriate capabilities for connecting to the SOAP endpoint. By default, the system selects a MID Server with SOAP capabilities. This field is available when the Use MID Server check box is selected.</td>
</tr>
<tr>
<td>Timeout</td>
<td>Allowed duration of the SOAP web service request before it times out, in seconds. The default is 10.</td>
</tr>
<tr>
<td>Authentication</td>
<td>Determines what type of authentication is required for the endpoint. The options are:</td>
</tr>
<tr>
<td></td>
<td>• Use existing credentials in SOAP message: Uses credential definitions from the SOAP message definition.</td>
</tr>
<tr>
<td></td>
<td>• Override with Basic Authentication credentials: Uses basic authentication credentials. Overrides the credentials in the SOAP message definition. Basic authentication credentials must be provisioned before they are available for selection.</td>
</tr>
<tr>
<td></td>
<td>• Override with Certificate Authentication credentials: Overrides the credentials in the SOAP message definition with certificate authentication credentials.</td>
</tr>
<tr>
<td></td>
<td>• Override with Both Basic and Certificate Authentication credentials: Overrides the credentials in the SOAP message definition with both</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| basic authentication or certificate authentication credentials.  
- **Override with WS-Security Username profile**: Overrides the credentials in the SOAP message definition with credentials defined a WS Security Profile. |
| Required REST endpoint basic authentication credentials. This field is available when **Override with Basic Authentication credentials** is selected in the **Authentication** field. Only basic authentication credentials appear in the selection list, which includes credentials stored on the instance and credential IDs from an external storage system. If you are using credentials stored in a CyberArk safe, you can override the default safe defined in the MID Server configuration file by adding the name of a different safe as a prefix to the credential ID, separated by a colon. For example, `newsafe:orch-test-f5`. See **Configure the MID Server for CyberArk** for details. |
| Protocol profile to use for authentication. This field is available when the authentication type is either **Override with Certificate Authentication credentials** or **Override with Both Basic and Certificate Authentication credentials**. |

**Note:** You can map parameter values in a test payload to variables in the **Outputs** tab automatically. See **automap output variables**.
What to do next

- Use **auto-mapping** to generate outputs and parsing rules (recommended for JDBC)
- If you do not use auto-mapping, you can manually create output variables and create parsing rules

Auto-map SOAP activity output variables

The ServiceNow activity designer allows you to map parameter values in a SOAP test payload to variables in the **Outputs** stage automatically.

Before you begin

Role required: web_service_admin, activity_admin, activity_creator

About this task

ℹ️ **Note:** You can test input variables from any stage in the activity designer if you have provided enough information for Orchestration to contact the endpoint and return data. Typically, the **Execution Command** stage is the point at which your inputs are ready for testing.

Procedure

1. In the activity designer, proceed to the **Execution Command** stage.
2. Define an appropriate MID Server, if requested.
   - The test fails if the MID Server cannot be found or if it cannot connect to the target.
3. Click **Test Activity** to test the input parameters.
   - If you added actual values for the parameters and fields, the system runs those values against the specified target and returns the resulting payload. If you mapped input variables to fields and parameters, the system displays a dialog box for assigning test values to those variables.
4. Provide test values, if requested, and click **OK** to display the payload.
   - The entire payload appears in the **Raw Output** tab of the Response form.
5. Select one of these auto-mapping options.
• **Auto-Map to Local**: Directly maps values to a local variable for use within the activity.

• **Auto-Map to Output**: Directly maps values to the output variable to pass to other activities in the workflow. Auto-mapping to an output variable creates an array of objects, each of which contains the column names from the query result.

**Provide credentials to access a SOAP message WSDL**

If the SOAP WSDL you are requesting in a test payload requires authentication, you must provide basic auth credentials in either the SOAP message or the SOAP activity.

**Before you begin**
Role required: web_service_admin, activity_admin, activity_creator

The ServiceNow instance only supports basic auth credentials for accessing a WSDL. If the SOAP function or the SOAP message does not provide these credentials, you must configure them in the SOAP activity template. Orchestration uses these priorities for deciding which basic authentication credentials to use:

• SOAP message: Credentials for a SOAP message are used if no other credentials are defined.

• SOAP function: Credentials for a SOAP function override the credentials configured for the SOAP message.

• SOAP activity template: Credentials for a SOAP activity template override both the SOAP function and SOAP message credentials.

**Procedure**

1. Navigate to **System Web Services > Outbound > SOAP Message**.
2. Select the SOAP message you want the activity to use.
3. In the SOAP Message record, select the **Download WSDL** check box.
4. In the **Authentication type** field, select **Basic**.
   
   The **Basic auth profile** field appears.
5. Select the basic auth profile to use with this SOAP message.
6. Alternately, you can configure basic authentication credentials in Configure the SOAP execution command.

   a. In the **Authentication** field, select **Override with Basic Authentication credentials**.
      The **Credentials** field appears.

   b. Select the basic auth credentials to use to access the WSDL.
This setting overrides any credentials configured in the SOAP message.

Configure the SOAP execution command

Use the input variables you created to configure the command that Orchestration executes on the SOAP endpoint.

Before you begin

Create the input variables you need in the Inputs form before you can advance to the Execution Command stage.

Role required: web_service_admin, activity_admin, activity_creator

Note: You can test the SOAP connection between the MID Server and the endpoint without having to run the activity in a workflow context. For details, see test template outputs.
Procedure

1. Drag variables from the list of inputs and drop them into command fields. The system formats the variable in the proper syntax for the command.

SOAP execution command

2. Complete the fields shown in the table.

SOAP template execution command fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Input variable builder. <strong>Create input variables</strong> to map to available fields.</td>
</tr>
<tr>
<td>Web service message</td>
<td>to use for this activity. Users must have the web_service_admin role to configure this field.</td>
</tr>
<tr>
<td>Web service message function</td>
<td>SOAP message function to use for this activity. Users must have the web_service_admin role to configure this field.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>Endpoint URL for the SOAP web service this activity uses. Enter an endpoint in this field to override the endpoint configured in the SOAP message. Click the lock icon to open the input field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SOAP message parameters</td>
<td>Name-value pairs to pass to the SOAP endpoint. You can create these parameters manually, or drag input variables into the parameter fields and then assign a value. Parameters defined in the SOAP message that use ${} can be assigned data from this activity template. Use the <strong>Additional attribute</strong> column to configure the system to not escape the text. By default, text sent to the SOAP message is escaped. The <strong>Name</strong> column is auto-populated if the users have provided variables using variable substitution in the SOAP message.</td>
</tr>
<tr>
<td>Use MID Server</td>
<td>Check box that determines if a MID Server must be used to invoke the SOAP web service.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>If the SOAP web service message function defines a MID Server, that MID Server is used instead of the one selected here.</td>
</tr>
<tr>
<td>Required MID Server capabilities</td>
<td>MID Server with the appropriate <strong>capabilities</strong> for connecting to the SOAP endpoint. By default, the system selects a MID Server with SOAP capabilities. This field is available when the <strong>Use MID Server</strong> check box is selected.</td>
</tr>
<tr>
<td>Timeout</td>
<td>Allowed duration of the SOAP web service request before it times out, in seconds. The default is 10.</td>
</tr>
<tr>
<td>Authentication</td>
<td>Determines what type of authentication is required for the endpoint. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use existing credentials in SOAP message</strong>: Uses credential definitions from the SOAP message definition.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Override with Basic Authentication credentials</strong>: Uses basic authentication credentials. Overrides the credentials in the SOAP message definition. Basic authentication credentials must be provisioned before they are available for selection.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Override with Certificate Authentication credentials</strong>: Overrides the credentials in the SOAP message definition with certificate authentication credentials.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Override with Both Basic and Certificate Authentication credentials</strong>: Overrides the credentials in the SOAP message definition with both basic and certificate authentication credentials.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>message definition with both basic authentication or certificate authentication credentials.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Override with WS-Security Username profile</strong>: Overrides the credentials in the SOAP message definition with credentials defined in a WS Security Profile.</td>
<td></td>
</tr>
<tr>
<td><strong>Credentials</strong></td>
<td>Required REST endpoint basic authentication credentials. This field is available when <strong>Override with Basic Authentication credentials</strong> is selected in the <strong>Authentication</strong> field. Only basic authentication credentials appear in the selection list, which includes credentials stored on the instance and credential IDs from an external storage system. If you are using credentials stored in a CyberArk safe, you can override the <strong>default safe</strong> defined in the MID Server configuration file by adding the name of a different safe as a prefix to the credential ID, separated by a colon. For example, <strong>newsafe:orch-test-f5</strong>.</td>
</tr>
<tr>
<td><strong>Protocol Profile</strong></td>
<td>Protocol profile to use for authentication. This field is available when the authentication type is either <strong>Override with Certificate Authentication credentials</strong> or <strong>Override with Both Basic and Certificate Authentication credentials</strong>.</td>
</tr>
</tbody>
</table>
### SOAP execution parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web service message function</td>
<td>web-service_message_function</td>
<td>Reference</td>
<td>The sys_id of the SOAP message function.</td>
</tr>
<tr>
<td>Web service endpoint</td>
<td>web_service_endpoint</td>
<td>String</td>
<td>URL of the SOAP endpoint.</td>
</tr>
<tr>
<td>Parameters</td>
<td>parameters</td>
<td>Array of JavaScript objects</td>
<td>Array of JavaScript objects, expressed with the <code>executionParam</code> prefix. For instructions on creating arrays using this parameter, see <a href="#">Create a JavaScript array in a SOAP template</a>.</td>
</tr>
<tr>
<td>Use mid server</td>
<td>use_mid_server</td>
<td>Boolean</td>
<td>When true, indicates that a MID Server is used.</td>
</tr>
<tr>
<td>MidCapabilities</td>
<td>midCapabilities</td>
<td>String (comma separated)</td>
<td>List of references to required MID Server capabilities.</td>
</tr>
<tr>
<td>Time out</td>
<td>time_out</td>
<td>String</td>
<td>Allowed duration of the SOAP web service request before it times out, in seconds. The default is <strong>10</strong>.</td>
</tr>
<tr>
<td>ValueCapabilities</td>
<td>valueCapabilities</td>
<td>Array of hashmap</td>
<td>Capability values used to select the MID Server. For more information, see <a href="#">MID Server capabilities</a>. Use this example to customize the MID Server selection if there are additional capabilities that are assigned by value:</td>
</tr>
</tbody>
</table>

```javascript
var valueCapability = {
    'NEW_MID_CAPABILITY': 'NEW_MID_CAPABILITY_VALUE',
};
executionParam.valueCapabilities.push(valueCapability);
```
### SOAP execution parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auth Type</td>
<td>auth_type</td>
<td>Boolean</td>
<td>Type of credentials to use. The choices are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- basic_auth_pick_credentials</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- use_existing_credentials</td>
</tr>
<tr>
<td>Credentials</td>
<td>credentials</td>
<td>Reference</td>
<td>Credentials to use for this SOAP message when the auth_type is basic_auth_pick_credentials.</td>
</tr>
</tbody>
</table>

### Create a JavaScript array in a SOAP template

These are instructions for creating JavaScript arrays using SOAP execution parameters.

**Before you begin**

Role required: web_service_admin, activity_admin, activity_creator

**About this task**

To add more name-value pairs to the parameter's array, append the values to the existing array.

**Procedure**

1. Create a JavaScript object with the following syntax, and add it to the executionParam.parameter array:

   ```javascript
   var newParameter = {
     "name": "parameterName", "value": "parameterValue", "additional_attribute": "none"}
   executionParam.parameters.push(newParameter);
   
   By adding the new parameter JavaScript object to the array, you ensure that any elements already available in the array are not impacted.

2. Make sure to set the value in the Additional attribute column in the SOAP message parameters input field to Do not escape text.

   In this case, the system does not escape the value specified for the value attribute. An example of this is:
var newParameter =
{"name":"parameterName","value":"parameterValue","additional_attribute":"do_not_escape_text"};
executionParam.parameters.push(newParameter);

>Note: If the value for the **additional_attribute** field is **None**, then the system escapes the value specified by the **value** attribute. In the first example, **parameterValue** is escaped.

**SOAP template post-processing parameters**
Use these parameters to create a post-processing script.

**Activity designer post-processing parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status code</td>
<td>status_code</td>
<td>Integer</td>
<td>Contains the status code returned from the web service.</td>
</tr>
<tr>
<td>Header</td>
<td>header</td>
<td>Hashmap of JavaScript object</td>
<td>Contains the key value paired hashmap associated with the header values passed into the web service. You can access each value with <code>executionResult.header[keyName]</code>.</td>
</tr>
<tr>
<td>Body</td>
<td>body</td>
<td>String</td>
<td>Contains a string value representing the output from the SOAP message</td>
</tr>
<tr>
<td>Error</td>
<td>error</td>
<td>String</td>
<td>Returns the error string from the SOAP web service, unless there are no errors, in which case it returns <code>null</code>.</td>
</tr>
</tbody>
</table>

**Create a JavaScript Probe activity**
Create a JavaScript Probe activity to instruct a MID server to execute server-side javascript.

**Before you begin**
Role required: activity_creator or workflow_admin

**About this task**
The JavascriptProbe activity has the same functionality as making ‘Packages’ calls into standard Java libraries. It allows you to have more control over the Java libraries on the MID Server. You can load your own JAR files on the MID Server and have the JavascriptProbe make Package calls into those java files.
Procedure

1. Create a custom activity.
   This action creates a custom activity using a template.

2. After setting up general properties and creating input variables, configure the JavaScript probe activity Execution Command:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map the input variables</td>
<td>Use the variables you created to configure the command that OrchestratiOn executes on the MID server.</td>
</tr>
<tr>
<td>Script type</td>
<td>Select the type of script to include. Available options are:</td>
</tr>
<tr>
<td></td>
<td>• Custom JavaScript</td>
</tr>
<tr>
<td></td>
<td>• MID Server script include</td>
</tr>
<tr>
<td>Script</td>
<td>Custom JavaScript to run with this probe.</td>
</tr>
<tr>
<td></td>
<td>Note: This field is available when the Script type selected is Custom JavaScript.</td>
</tr>
<tr>
<td>MID Server script include</td>
<td>Script for the MID Server to run with this probe.</td>
</tr>
<tr>
<td></td>
<td>Note: This field is available when the Script type selected is MID Server script include.</td>
</tr>
<tr>
<td>Select MID Server by host</td>
<td>MID Server on which the probe runs.</td>
</tr>
<tr>
<td>Required MID Server capabilities</td>
<td>MID Server to use, by capabilities.</td>
</tr>
<tr>
<td>Parameters</td>
<td>Name-value pairs to pass to the host with this probe. You can create these parameters manually, or drag input variables into the Parameters fields and assign a value.</td>
</tr>
</tbody>
</table>

Note: You can map parameter values in a test payload to variables in the Outputs tab automatically. See automap output variables.
What to do next
Finish creating your JavaScript probe activity by creating output variables, creating a parsing rule, or creating template conditions. Refer to the create custom activities topic to know your template options.

JavaScript probe template execution parameters
You use execution parameters to create the input process script in the Preprocessing form of the activity designer.

For descriptions of the JavaScript Probe command fields, see the table in Configure the JavaScript Probe execution command.

ℹ️ Note: You must use the `executionParam.` prefix with all variables in this table.

### JavaScript template execution parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
</table>
| Script Type      | script_type      | Enumerated        | Type of script to run. The possible types are:  
• custom_javascript_type  
• mid_script_include_type |
| Script           | script           | String            | Script that runs custom JavaScript when the `script_type` is `custom_javascript_type`.                                                   |
| Mid script include | mid_script_include | Reference | The sys_id reference associated with the MID Server script include to call, when the `script_type` is `mid_script_include_type`. |
| Source           | source           | String            | Target host on which to run the script.                                                                                              |
| MidCapabilities  | midCapabilities  | String (comma separated) | List of required MID Server capabilities.                                                                                           |
| Parameters       | parameters       | Array of JavaScript object | Array of JavaScript objects, expressed with the `executionParam.` prefix.                                                               |
### JavaScript template execution parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>To add more name-value pairs to the <code>parameters</code> array, append them to the existing array. Create a JavaScript object with the following syntax, and add it to the <code>executionParam.parameters</code> array. This assigns additional parameters to the message:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>var newParameter = {&quot;name&quot;:&quot;parameterName&quot;,&quot;value&quot;:&quot;parameterValue&quot;}; executionParam.parameters.push(newParameter);</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>ValueCapabilities</td>
<td>valueCapabilities</td>
<td>Array of hashmap</td>
<td>Capability values used to select the MID Server. For more information, see <a href="#">MID Server capabilities</a>. If there are additional capabilities that are assigned by value, use this example to customize the MID Server selection:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>var valueCapability = {'NEW_MID_CAPABILITY':'NEW_MID_CAPABILITY_VALUE'}; executionParam.valueCapabilities.push(valueCapability);</td>
</tr>
</tbody>
</table>

### JavaScript probe template post-processing parameters

Use these parameters to create a post-processing script.
JavaScript probe post-processing parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payload</td>
<td>payload</td>
<td>String</td>
<td>Contains raw payload returned from the JavaScript Probe.</td>
</tr>
<tr>
<td>Output</td>
<td>output</td>
<td>String</td>
<td>Contains output data returned from the JavaScript Probe.</td>
</tr>
<tr>
<td>EccSysId</td>
<td>eccSysId</td>
<td>String</td>
<td>Contains the reference ID associated with the ECC Queue input message.</td>
</tr>
<tr>
<td>Error Messages</td>
<td>errorMessages</td>
<td>String</td>
<td>Contains the error messages returned from the JavaScript probe. If no error messages are returned, this value is null.</td>
</tr>
</tbody>
</table>

Configure the JavaScript Probe execution command

Use the input variables you created to configure the command that Orchestration executes on the JavaScript Probe target host.

Before you begin

Create the input variables you need in the Inputs form before you can advance to the Execution Command stage.

Role required: activity_creator, admin

⚠️ Note: You can test the JavaScript Probe connection between the MID Server and the target without having to run the activity in a workflow context. For details, see test template outputs.

Procedure

1. Drag variables from the list of inputs and drop them into command fields. The system formats the variable in the proper syntax for the command.
2. Complete the fields shown in the table.

### JavaScript Probe execution command fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Input variable builder. Create input variables to map to available fields.</td>
</tr>
<tr>
<td>Script type</td>
<td>Select the type of script to include. Available options are:</td>
</tr>
<tr>
<td></td>
<td>- Custom JavaScript</td>
</tr>
<tr>
<td></td>
<td>- MID Server script include</td>
</tr>
<tr>
<td>Script</td>
<td>Custom JavaScript to run with this probe. This field is available when the</td>
</tr>
<tr>
<td></td>
<td>Script type selected is Custom JavaScript.</td>
</tr>
<tr>
<td>MID Server script include</td>
<td>Script for the MID Server to run with this probe. This field is available</td>
</tr>
<tr>
<td></td>
<td>when the Script type selected is MID Server script include.</td>
</tr>
<tr>
<td>Select MID Server by host</td>
<td>MID Server on which the probe runs.</td>
</tr>
</tbody>
</table>
3. Click **Save**.

4. Click **Continue** to advance to the **Outputs** stage.

**Create a PowerShell activity**

Create a custom PowerShell activity return data to a workflow from a host using Microsoft PowerShell.

**Before you begin**
Role required: activity_creator or workflow_admin

**About this task**
ServiceNow supports PowerShell 3.0 to 5.1.

**Procedure**

1. Create a **custom activity**.
   This action creates a custom activity using a template.

2. After setting up **general properties** and **creating input variables**, configure the PowerShell Execution Command:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map the input variables</td>
<td>Use the variables you created to configure the command that Orchestration executes on the MID Server.</td>
</tr>
<tr>
<td>Target host</td>
<td>Host name or IP address of the target server for this PowerShell activity.</td>
</tr>
</tbody>
</table>
| Script type        | Type of PowerShell script to run on the PowerShell host. Available options are:  
  - Custom PowerShell command  
  - MID Server script file  |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server script file</td>
<td>The MID Server script file contains the PowerShell scripts. This field is available when the <strong>Script type</strong> selected is MID Server script file.</td>
</tr>
<tr>
<td>Command</td>
<td>PowerShell command the activity executes. This field is available when the <strong>Script type</strong> selected is <strong>Custom PowerShell command</strong>. You can create your commands by dragging and dropping input variables from the variable builder into this field.</td>
</tr>
<tr>
<td>PowerShell variables</td>
<td>Name-value pairs to pass to the host with PowerShell. You can create these variables manually, or drag input variables into the <strong>Value</strong> field. Encrypted input variables retain their encryption, regardless of the data type settings in this field. If you type in a value and select the <strong>Encrypted</strong> data type, your value appears in plain text. It is only encrypted when it passes to the ECC Queue.</td>
</tr>
<tr>
<td>Use MID Service Account</td>
<td>If checked, this activity authenticates on the target host using the credentials of the MID Server service account only, without trying any other credentials.</td>
</tr>
<tr>
<td>Credential tag</td>
<td>Credential tag this activity must use to run PowerShell commands on the host. If this field is left blank, the MID Server tries all the available credentials until it finds a valid one, ending with the MID Server service account. If a credential tag is defined, the MID Server tries the credentials with that tag specified only and does not try the MID Server service account.</td>
</tr>
</tbody>
</table>

**Note:** The **Credential tag** field is not available.
Required MID Server capabilities

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note: This field is not available when the Use MID service account check box is selected.</td>
<td></td>
</tr>
</tbody>
</table>

MID Server to use for querying PowerShell, by capabilities. By default, the system selects a PowerShell MID Server.

Note: You can map parameter values in a test payload to variables in the Outputs tab automatically. See automap output variables.

What to do next

Finish creating your PowerShell activity by creating output variables, creating a parsing rule, or creating template conditions. Refer to the create custom activities topic to know your template options.

PowerShell template execution parameters

You use execution parameters to create the input process script in the Pre Processing form of the activity designer.

For descriptions of the Powershell command fields, see the table in Configure the PowerShell execution command.

Note: You must use the executionParam prefix with all variables in this table.

Powershell execution parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>source</td>
<td>String</td>
<td>Target host on which to execute the command.</td>
</tr>
<tr>
<td>Script type</td>
<td>script_type</td>
<td>Enumeration</td>
<td>Type of script to run. The possible types are:</td>
</tr>
<tr>
<td>Name</td>
<td>Variable</td>
<td>Type</td>
<td>Usage</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------</td>
<td>--------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>command:</strong> Custom PowerShell command.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>file:</strong> Identifies the MID Server script file to run.</td>
</tr>
<tr>
<td>Command</td>
<td>command</td>
<td>String</td>
<td>Command sent to the MID Server for it to run on the target host.</td>
</tr>
<tr>
<td>MidScriptFile</td>
<td>midScriptFile</td>
<td>Reference</td>
<td>Reference sys_id of the MID Server script file to execute, when the script_type is file.</td>
</tr>
<tr>
<td>PowershellVariables</td>
<td>powershellVariables</td>
<td>Array of hashmap</td>
<td>Hashmap of JavaScript objects with name, value, and type for each object. The type of each object can be one of plain, encrypted, boolean, or null, corresponding to the PowerShell variable type selected in the inputs tab. For example, you might enter:</td>
</tr>
</tbody>
</table>

```javascript
var newParameter = {
    "name":"parameterName",
    "value":"parameterValue",
    "type": "plain"
};
executionParam.powershellVariables.push(newParameter);
```
## Powershell execution parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credential tag</td>
<td>credential_tag</td>
<td>String</td>
<td>Specific credential tag this activity must use to run PowerShell commands on the host.</td>
</tr>
<tr>
<td>MidCapabilities</td>
<td>midCapabilities</td>
<td>String (comma separated)</td>
<td>List of required MID Server capabilities.</td>
</tr>
</tbody>
</table>
| ValueCapabilities     | valueCapabilities | Array of hashmap | Capability values used to select the MID Server. For more information, see MID Server capabilities. If there are additional capabilities that are assigned by value, use this example to customize the MID Server selection:

```javascript
var valueCapability = {
  'NEW_MID_CAPABILITY': '
  NEW_MID_CAPABILITY_VALUE
'};
executionParam.valueCapabilities.push(valueCapability);
```

## Powershell post-processing parameters and payload parsing

Use these parameters to create a post-processing script, payload parsing, and tagging.

## Powershell post-processing parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tags</td>
<td>tags</td>
<td>Hashmap of tag</td>
<td>Contains the tags used to extract output using the PowerShell</td>
</tr>
</tbody>
</table>
Powershell post-processing parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>values to return from the PowerShell command.</td>
</tr>
</tbody>
</table>
|       |           |       | Write-Host %tagname1%  
output1 line 1  
output1 line 2  
|       |           |       | Write-Host%  
Write-Host %tagname2%  
output2 line 1  
output2 line 2  
|       |           |       | Write-Host%  |
|       |           |       | The tags returned are JavaScript hashmap objects in which each key is prefixed with tag appended with the tagname. |
| Hresult | hresult  | String | Contains any hresult returned from the PowerShell command. If no hresult is returned, this parameter is null. |
| Output  | output   | String | Contains the raw output from the PowerShell command. |
| EccSysID | eccSysID | String | Contains the reference ID associated with the ECC Queue input message returned by the activity. |
Powershell post-processing parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>ErrorMessages</td>
<td>errorMessages</td>
<td>String</td>
<td>Contains any error messages retrieved from the PowerShell command. This value is null if there are no error messages.</td>
</tr>
</tbody>
</table>

Create a REST web service activity

Use this procedure to create a custom REST web service Orchestration activity.

Before you begin
Role required: web_service_admin, activity_admin, activity_creator

About this task
To create and use a REST web service workflow activity:

• Create a REST message if an appropriate one is not already configured.
• Assign the web_service_admin role to any user who must create or edit a custom REST activity.
• Determine an application, or scope, for this activity.
• Determine the REST endpoint to use for the activity. Use this value to override the endpoint configured in the REST message.
• Optionally, create basic authentication credentials. Use this value to override the credentials configured in the SOAP message.

Procedure
1. Create a custom activity.
   This action creates a custom activity using a template.

2. After setting up general properties and creating input variables, configure the REST web service Execution Command:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map the input variables</td>
<td>Use the variables you created to configure the command that Orchestration executes.</td>
</tr>
<tr>
<td>REST message</td>
<td>Name of an existing REST message to use in this activity.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>REST message function</td>
<td>REST message function to use for this activity.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>Endpoint URL for the REST web service this activity uses. Enter an endpoint in this field to override the endpoint configured in the REST message. Click the lock to open the input field.</td>
</tr>
<tr>
<td>Variable substitutions</td>
<td>Name-value pairs to pass to the REST endpoint. You can create these parameters manually, or drag input variables into the parameter fields, and then assign a value. Parameters defined in the REST message that use ${} can be assigned data from this activity template. Use the <strong>Additional attribute</strong> column to configure the system to not escape the text. By default the text sent to the REST message is escaped. If the users have provided variables using variable substitution in the REST message, then the <strong>Name</strong> column is automatically populated.</td>
</tr>
<tr>
<td>Additional Headers</td>
<td>Additional HTTP header parameters for the REST message selected. You can also use these values to override parameters inherited from the REST message.</td>
</tr>
<tr>
<td>Additional Query Parameters</td>
<td>Additional query parameters for the REST message selected. You can also use these values to override parameters inherited from the REST message.</td>
</tr>
<tr>
<td>Use MID Server</td>
<td>Check box that determines if a MID Server should be used to invoke the REST web service.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Required MID Server capabilities</td>
<td>MID Server with the appropriate capabilities for connecting to the REST endpoint. By default, the system selects a MID Server with REST capabilities. This field is available when the Use MID Server check box is selected.</td>
</tr>
<tr>
<td>Timeout</td>
<td>Allowed duration of the REST web service request before it times out, in seconds. The default is 10.</td>
</tr>
<tr>
<td>Authentication</td>
<td>Determines what type of authentication is required for the endpoint. The options are:</td>
</tr>
<tr>
<td></td>
<td>• Use existing credentials in REST message: Uses credential definitions from the REST message definition.</td>
</tr>
<tr>
<td></td>
<td>• Override with Basic Authentication credentials: Uses basic authentication credentials to override the credentials in the REST message definition. Basic authentication credentials must be provisioned before they are available for selection.</td>
</tr>
<tr>
<td></td>
<td>• Override with Certificate Authentication credentials: Uses a certificate, such as a private key, to override the credentials in the REST message definition.</td>
</tr>
<tr>
<td></td>
<td>• Override with Both Basic and Certificate Authentication credentials: Uses both basic authentication and certificate authentication to override the credentials in the REST message definition.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Override with OAuth Authentication</td>
<td>credentials: Uses OAuth 2.0 credentials to override the credentials in the REST message definition. The REST message selected for this activity must have its Authentication type set to OAuth 2.0 and its OAuth profile configured appropriately.</td>
</tr>
<tr>
<td>Credentials</td>
<td>Required REST endpoint basic authentication credentials. This field is available when Override with Basic Authentication credentials is selected in the Authentication field. Only basic authentication credentials appear in the selection list, which includes credentials stored on the instance and credential IDs from an external storage system. If you are using credentials stored in a CyberArk safe, you can override the default safe defined in the MID Server configuration file. See Configure the MID Server for CyberArk for details. Add the name of a different safe as a prefix to the credential ID, separated by a colon. For example, newsafe:orch-test-f5.</td>
</tr>
<tr>
<td>Protocol Profile</td>
<td>Certificate authentication to use. This field is available when the selections in the Authentication are either Override with Certificate Authentication credentials or Override with Both Basic and Certificate Authentication credentials.</td>
</tr>
<tr>
<td>OAuth profile</td>
<td>Profile for the OAuth provider for this REST message. See for more information.</td>
</tr>
</tbody>
</table>

**Note:** You can map parameter values in a test payload to variables in the Outputs tab automatically. See automap output variables.
What to do next
Finish creating your Rest web service activity by creating output variables, creating a parsing rule, or creating template conditions. Refer to the create custom activities topic to know your template options.

Auto-map REST activity output variables
The ServiceNow activity designer allows you to map parameter values in a REST test payload to variables in the Outputs stage automatically.

Before you begin
Role required: web_service_admin, activity_admin, activity_creator

About this task
Note: You can test input variables from any stage in the activity designer if you have provided enough information for Orchestration to contact the endpoint and return data. Typically, the Execution Command stage is the point at which your inputs are ready for testing.

Procedure
1. In the activity designer, proceed to the Execution Command stage.
2. Define an appropriate MID Server, if requested. The test fails if the MID Server cannot be found or if it cannot connect to the target.
3. Click Test Activity to test the input parameters. If you added actual values for the parameters and fields, the system runs those values against the specified target and returns the resulting payload. If you mapped input variables to fields and parameters, the system displays a dialog box for assigning test values to those variables.
4. Provide test values, if requested, and click OK to display the payload. The entire payload appears in the Raw Output tab of the Response form.
5. Select one of these auto-mapping options.
- **Auto-Map to Local**: Directly maps values to a local variable for use within the activity.

- **Auto-Map to Output**: Directly maps values to the output variable to pass to other activities in the workflow. Auto-mapping to an output variable creates an array of objects, each of which contains the column names from the query result.

### REST template execution parameters

You use execution parameters to create the input process script in the **Pre Processing** form of the activity designer.

For descriptions of the REST web service command fields, see [Configure the REST execution command](#).

**Note**: You must use the `executionParam.` prefix with all variables in this table.

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web service message</td>
<td>web_service_message</td>
<td>Reference</td>
<td>The sys_id of the corresponding web service message.</td>
</tr>
<tr>
<td>Web service message function</td>
<td>web_service_message_function</td>
<td>Reference</td>
<td>The sys_id of the REST message function.</td>
</tr>
<tr>
<td>Web service endpoint</td>
<td>web_service_endpoint</td>
<td>String</td>
<td>URL of the REST endpoint.</td>
</tr>
<tr>
<td>Parameters</td>
<td>parameters</td>
<td>Array of JavaScript objects</td>
<td>Array of JavaScript objects, expressed with the <code>executionParam.</code> prefix. For instructions on creating arrays using this parameter see <a href="#">Create a JavaScript array in a REST template</a>.</td>
</tr>
<tr>
<td>Use mid server</td>
<td>use_mid_server</td>
<td>Boolean</td>
<td>Selects whether or not to use the MID Server. A value of <code>true</code> uses the MID Server, and a value of <code>false</code> does not use the MID Server.</td>
</tr>
</tbody>
</table>
### REST template execution parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>MidCapabilities</td>
<td>midCapabilities</td>
<td>String (comma separated)</td>
<td>List of references to required MID Server capabilities.</td>
</tr>
<tr>
<td>Time out</td>
<td>time-out</td>
<td>String</td>
<td>Allowable time out duration, expressed in seconds.</td>
</tr>
<tr>
<td>ValueCapabilities</td>
<td>valueCapabilities</td>
<td>Array of hashmap</td>
<td>Capability values used to select the MID Server. For more information, see MID Server capabilities. Use this example to customize the MID Server selection if there are additional capabilities that are assigned by value:</td>
</tr>
<tr>
<td>Auth Type</td>
<td>auth-type</td>
<td>Boolean</td>
<td>Type of credentials to use. Choices are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• basic_auth_pick_credentials</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• use_existing_credentials</td>
</tr>
<tr>
<td>Credentials</td>
<td>credentials</td>
<td>Reference</td>
<td>Contains the credentials to use for this REST message when the auth_type selected is basic_auth_pick_credential</td>
</tr>
</tbody>
</table>
About this task
To add more name-value pairs to the parameter’s array, append the values to the existing array.

Procedure
1. Create a JavaScript object with the following syntax, and add it to the executionParam.parameter array:

```javascript
var newParameter = {
  "name": "parameterName",
  "value": "parameterValue",
  "additional_attribute": "none"
};

executionParam.parameters.push(newParameter);
```

By adding the new parameter JavaScript object to the array, you ensure that any elements already available in the array are not impacted.

2. Make sure to set the value in the Additional attribute column in the REST message parameters input field to Do not escape text.

In this case, the system does not escape the value specified for the value attribute. An example of this is:

```javascript
var newParameter = {
  "name": "parameterName",
  "value": "parameterValue",
  "additional_attribute": "do_not_escape_text"
};

executionParam.parameters.push(newParameter);
```

⚠️ Note: If the value for the additional_attribute field is None, then the system escapes the value specified by the value attribute. In the first example, parameterValue is escaped.

REST template post-processing parameters
Use these parameters to create a post-processing script.

Activity designer post-processing parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status code</td>
<td>status_code</td>
<td>Integer</td>
<td>Contains the status code returned from the REST web service.</td>
</tr>
<tr>
<td>Header</td>
<td>header</td>
<td>Hashmap of JavaScript object</td>
<td>Hashmap of key value pairs associated with the header values passed into the web service. You can access each value with executionResult.header[keyName].</td>
</tr>
</tbody>
</table>
Activity designer post-processing parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Body</td>
<td>body</td>
<td>String</td>
<td>Contains a string value representing the output from the REST message</td>
</tr>
<tr>
<td>Error</td>
<td>error</td>
<td>String</td>
<td>Returns the error string from the REST web service, unless there are no errors, in which case it returns null.</td>
</tr>
</tbody>
</table>

Configure the REST execution command

Use the input variables you created to configure the command that Orchestration executes on the REST endpoint.

Before you begin

Create the input variables you need in the Inputs form before you can advance to the Execution Command stage.

Role required: web_service_admin, activity_admin, activity_creator

Note: You can test the REST connection between the MID Server and the endpoint without having to run the activity in a workflow context. For details, see test template outputs.

Procedure

1. Drag variables from the list of inputs and drop them into command fields. The system formats the variable in the proper syntax for the command.
2. Complete the fields shown in the table.

**REST execution command fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Input variable builder. <strong>Create input variables</strong> to map to available fields.</td>
</tr>
<tr>
<td>REST message</td>
<td>Name of an existing REST message to use in this activity. Users must have the web_service_admin role to configure this field.</td>
</tr>
<tr>
<td>REST message function</td>
<td>REST message function to use for this activity. Users must have the web_service_admin role to configure this field.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>Endpoint URL for the REST web service this activity uses. Enter an endpoint in this field to override the endpoint configured in the REST message. Click the lock to open the input field.</td>
</tr>
<tr>
<td>Variable substitutions</td>
<td>Name-value pairs to pass to the REST endpoint. You can create these parameters manually, or drag and drop input variables into the parameter fields, and then assign a value. Parameters defined in the REST message that use $@{ }$ can be assigned data from this activity template. Use the <strong>Additional attribute</strong> column to configure the system to not escape</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>the text. By default the text sent to the REST message is escaped. The <strong>Name</strong> column is automatically populated if the users have provided variables using variable substitution in the REST message.</td>
</tr>
<tr>
<td>Additional Headers</td>
<td>Additional HTTP header parameters for the REST message selected. You can also use these values to override parameters inherited from the REST message.</td>
</tr>
<tr>
<td>Additional Query Parameters</td>
<td>Additional query parameters for the REST message selected. You can also use these values to override parameters inherited from the REST message.</td>
</tr>
<tr>
<td>Use MID Server</td>
<td>Check box that determines if a MID Server should be used to invoke the REST web service.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the REST web service message function defines a MID Server, that MID Server is used instead of the one selected here.</td>
</tr>
<tr>
<td>Required MID Server</td>
<td>MID Server with the appropriate <strong>capabilities</strong> for connecting to the REST endpoint. By default, the system selects a MID Server with REST capabilities. This field is available when the <strong>Use MID Server</strong> check box is selected.</td>
</tr>
<tr>
<td>capabilities</td>
<td></td>
</tr>
<tr>
<td>Timeout</td>
<td>Allowed duration of the REST web service request before it times out, in seconds. The default is 10.</td>
</tr>
<tr>
<td>Authentication</td>
<td>Determines what type of authentication is required for the endpoint. The options are:</td>
</tr>
<tr>
<td></td>
<td><strong>• Use existing credentials in REST message:</strong> Uses credential definitions from the REST message definition.</td>
</tr>
<tr>
<td></td>
<td><strong>• Override with Basic Authentication credentials:</strong> Uses basic authentication credentials to override the credentials in the REST message definition. Basic authentication credentials must be provisioned before they are available for selection.</td>
</tr>
<tr>
<td></td>
<td><strong>• Override with Certificate Authentication credentials:</strong> Uses a certificate, such as a private key, to override the credentials in the REST message definition.</td>
</tr>
<tr>
<td></td>
<td><strong>• Override with Both Basic and Certificate Authentication credentials:</strong> Uses both basic authentication and certificate authentication to override the credentials in the REST message definition.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• <strong>Override with OAuth Authentication credentials</strong></td>
<td>Uses OAuth 2.0 credentials to override the credentials in the REST message definition. The REST message selected for this activity must have its <strong>Authentication type</strong> set to OAuth 2.0 and its OAuth profile configured appropriately.</td>
</tr>
<tr>
<td>Credentials</td>
<td>Required REST endpoint basic authentication credentials. This field is available when <strong>Override with Basic Authentication credentials</strong> is selected in the <strong>Authentication</strong> field. Only basic authentication credentials appear in the selection list, which includes credentials stored on the instance and credential IDs from an external storage system. If you are using credentials stored in a CyberArk safe, you can override the default safe defined in the MID Server configuration file by adding the name of a different safe as a prefix to the credential ID, separated by a colon. For example, namesafe:orch-test-f5.</td>
</tr>
<tr>
<td>Protocol Profile</td>
<td>Certificate authentication to use. This field is available when the selections in the <strong>Authentication</strong> field is either <strong>Override with Certificate Authentication credentials</strong> or <strong>Override with Both Basic and Certificate Authentication credentials</strong>.</td>
</tr>
<tr>
<td>OAuth profile</td>
<td>Profile for the OAuth provider for this REST message. See for more information.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

4. Click **Continue** to advance to the **Outputs** stage.

Create an SFTP activity

Create an activity that executes basic SFTP commands on a remote server.

**Before you begin**
Roles required: activity_creator or workflow_admin

**About this task**
You can create a custom activity that manages files and directories on a target host or copies a file from one SFTP server to another. The file content is streamed through a MID Server, which avoids having to store the data on the hard drive of the MID Server host machine.
**Note:** This activity requires the credentials of a user who can execute SFTP commands on the source host. The **Copy File** activity, provided in the activity pack, requires separate credentials to access the target host.

**Procedure**

1. Create a **custom activity**.
   This action creates a custom activity using a template.

2. After setting up **general properties** and **creating input variables**, configure the SFTP Execution Command:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Command</strong></td>
<td>Type of activity to create. The choices are:</td>
</tr>
<tr>
<td></td>
<td>• Copy file</td>
</tr>
<tr>
<td></td>
<td>• Create directory</td>
</tr>
<tr>
<td></td>
<td>• Get file list</td>
</tr>
<tr>
<td></td>
<td>• Remove file or directory</td>
</tr>
<tr>
<td></td>
<td>• Rename file or directory</td>
</tr>
<tr>
<td></td>
<td>• Set file attributes</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The fields that display on the form depend on the command you select.</td>
</tr>
<tr>
<td><strong>Source host</strong></td>
<td>Name or IP address of the server containing the files targeted by the activity.</td>
</tr>
<tr>
<td><strong>Source port</strong></td>
<td>Port number to use to communicate with the source server. The default port number is 22.</td>
</tr>
<tr>
<td><strong>Source file path</strong></td>
<td>Full path to a file (/temp/test_data_file.txt) or directory (/temp/test_dir) on a source host depending on the selected command. Field available on following commands:</td>
</tr>
<tr>
<td></td>
<td>• Copy file</td>
</tr>
<tr>
<td></td>
<td>• Remove file or directory</td>
</tr>
<tr>
<td></td>
<td>• Set file attributes</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source directory</td>
<td>Path to the directory where the source files are located. Field available on following commands:</td>
</tr>
<tr>
<td></td>
<td>• Create directory</td>
</tr>
<tr>
<td></td>
<td>• Get file list</td>
</tr>
<tr>
<td>Source files</td>
<td>Names of specific source files to include in the file transfer. Separate the file names with semi-colons. This field supports a semi-colon separated list of wild-card patterns. For example: *.txt; a?cd.pdf. If this field is blank, all files are included. Field available on following command:</td>
</tr>
<tr>
<td></td>
<td>• Get file list</td>
</tr>
<tr>
<td>Note:</td>
<td>For information about how the values in this field affect options in other fields, see the logic explanation which follows.</td>
</tr>
<tr>
<td>Is a directory</td>
<td>If checked, specifies the file path is a directory. Field available on following command:</td>
</tr>
<tr>
<td></td>
<td>• Remove file or directory</td>
</tr>
<tr>
<td>Credential tag for source</td>
<td>Specific credential tag this activity must use to run SFTP commands on the source host.</td>
</tr>
<tr>
<td>Credential tag for target</td>
<td>Specific credential tag this activity must use to run SFTP commands on the target host. Field available on following command:</td>
</tr>
<tr>
<td></td>
<td>• Copy file</td>
</tr>
</tbody>
</table>
| Excluded files      | Names of specific source files to exclude from the file transfer. The activity acts on all other files found in the source directory or subfolders. Separate the file names with commas. This field supports comma-sepa-
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td><strong>Include subfolders</strong></td>
<td>If checked, includes the files from subfolders in the source directory. Field available on following command:</td>
</tr>
<tr>
<td></td>
<td>• Get file list</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For information about how the values in this field affect options in other fields, see the logic explanation which follows.</td>
</tr>
<tr>
<td><strong>Target host</strong></td>
<td>Name or IP address of the server to which the files are being transferred. Field available on following command:</td>
</tr>
<tr>
<td></td>
<td>• Copy file</td>
</tr>
<tr>
<td><strong>Target port</strong></td>
<td>Port number to use to communicate with the target host. The default port number is 22. Field available on following command:</td>
</tr>
<tr>
<td></td>
<td>• Copy file</td>
</tr>
<tr>
<td><strong>Target file path</strong></td>
<td>Full path to a file on a target host. Field available on following commands:</td>
</tr>
<tr>
<td></td>
<td>• Copy file</td>
</tr>
<tr>
<td></td>
<td>• Rename file or directory</td>
</tr>
<tr>
<td><strong>Suffix for temporary file</strong></td>
<td>If a file exists on a target host, this command enables a temporary suffix to use for a file name. If this field con-</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5606
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>tains a value, the activity first copies the source file to a temporary file on the target host using <code>targetFilePath + tempFileSuffix</code> as the name. Upon completion, the activity renames the file to the actual target file name. If this field is blank, the activity copies the source file directly to the target file and overwrites it, if it exists. Field available on following command:</td>
</tr>
<tr>
<td></td>
<td>• Copy file</td>
</tr>
<tr>
<td>UID</td>
<td>User ID attribute to apply to a file or directory. The UID and GID values must be set together as a pair or they are ignored. The UID and GID numbers are internal values returned by the Get File List activity. Typically, you first use the Get File List activity to return a list of files and their attributes. Then you can move a file from a source host to a target host and set the source file attributes on the target file. This flow is demonstrated in the SFTP File Transfer workflow. Field available on following command:</td>
</tr>
<tr>
<td></td>
<td>• Set file attributes</td>
</tr>
<tr>
<td>GID</td>
<td>Group ID attribute to apply to a file or directory. The UID and GID values must be set together as a pair or they are ignored. The UID and GID numbers are internal values returned by the Get File List activity. Typically, you first use the Get File List activity to return a list of files and their attributes. Then you can move a file from a source host to a target host and set the source file attributes on the target file. This flow is demonstrated in the SFTP File Transfer workflow. Field available on following command:</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Permissions</strong></td>
<td>File or directory permissions to set for the user and group specified. This value must be expressed as an integer, such as <code>16877</code>, which defines these permissions: <code>rwxr-xr-x</code>. The permissions numbers are internal values returned by the Get File List activity. Typically, you first use the Get File List activity to return a list of files and their attributes. Then you can move a file from a source host to a target host and set the source file attributes on the target file. This flow is demonstrated in the SFTP File Transfer workflow. Field available on following command:</td>
</tr>
<tr>
<td>Access timestamp</td>
<td>Override the timestamp when the file or directory was last accessed. The access and modification timestamps must be set together as a pair. Field available on following command:</td>
</tr>
<tr>
<td>Modification timestamp</td>
<td>Override the timestamp when the file or directory was last modified. The access and modification timestamps must be set together as a pair. Field available on following command:</td>
</tr>
<tr>
<td>Size in bytes</td>
<td>Size of a file, expressed in bytes. Field available on following command:</td>
</tr>
<tr>
<td>Required MID Server capabilities</td>
<td>MID Server with the appropriate capabilities for connecting to the source and target servers.</td>
</tr>
</tbody>
</table>
The system uses this logic to determine which files to move from the source host:

• If the Source files field is empty, the system selects all the files in the source directory. Otherwise, it only selects those files whose names match one of the file name patterns given in the field.

• If the Excluded files field is empty, the system excludes nothing. Otherwise, it excludes those files whose names match one of the file name patterns given in the field.

• The exclude rule has a higher preference than the include rule. If a file name matches one of the file name patterns in the Excluded files field, it does not get into the selection regardless of the include rule.

• When the Include subfolders check box is cleared, the system looks only in the source directory for files to include or exclude. Otherwise, it looks in the source directory and any of its subfolders for files to include or exclude.

Note: You can map parameter values in a test payload to variables in the Outputs tab automatically. See automap output variables.

What to do next

• Use auto-mapping to generate outputs and parsing rules (recommended for JDBC)

• If you do not use auto-mapping, you can manually create output variables and create parsing rules

SFTP template execution parameters

You use execution parameters to create the input process script in the Preprocessing form.

For descriptions of the command fields, see Configure the SFTP execution command.

Note: You must use the executionParam. prefix with all variables in this table.

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
<td>command</td>
<td>String</td>
<td>Identifies the function of this activity. The possible commands are:</td>
</tr>
<tr>
<td>Name</td>
<td>Variable</td>
<td>Type</td>
<td>Usage</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source</td>
<td>source</td>
<td>String</td>
<td>Identifies the source host.</td>
</tr>
<tr>
<td>Source port</td>
<td>source_port</td>
<td>Integer</td>
<td>Identifies the port used to communicate with the source host.</td>
</tr>
<tr>
<td>Source directory</td>
<td>source_directory</td>
<td>String</td>
<td>Path to the source directory of the files to be moved.</td>
</tr>
<tr>
<td>Source files</td>
<td>source_files</td>
<td>String</td>
<td>Names of the files on the source to be moved.</td>
</tr>
<tr>
<td>Excluded files</td>
<td>excluded_files</td>
<td>String</td>
<td>Lists the files excluded from the operation.</td>
</tr>
<tr>
<td>Source file path</td>
<td>source_file_path</td>
<td>String</td>
<td>Path to the source files to be moved.</td>
</tr>
<tr>
<td>Target host</td>
<td>target_host</td>
<td>String</td>
<td>Identifies the target host.</td>
</tr>
<tr>
<td>Target port</td>
<td>target_port</td>
<td>Integer</td>
<td>Identifies the port used to communicate with the target host.</td>
</tr>
<tr>
<td>Target directory</td>
<td>target_directory</td>
<td>String</td>
<td>Full path to the target directory on the target host.</td>
</tr>
</tbody>
</table>
## SFTP execution parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target file path</td>
<td>target_file_path</td>
<td>String</td>
<td>Full path to a file or directory on the source host or on the target host. For example, this value is used in the Rename File or Directory activity in the activity pack.</td>
</tr>
<tr>
<td>Temp file postfix</td>
<td>temp_file_postfix</td>
<td>String</td>
<td>Temporary file name extension used by the Copy File activity when moving a file. If this field contains an extension, the source file is copied to a temporary file using <code>target file name + temp_file_postfix</code>, before being renamed to the actual target file. If this field is blank, the source file is copied directly to the target file.</td>
</tr>
<tr>
<td>Is directory</td>
<td>is_directory</td>
<td>Boolean</td>
<td>Indicates whether the given file path is a directory.</td>
</tr>
<tr>
<td>Include subfolders</td>
<td>include_subfolders</td>
<td>Boolean</td>
<td>Indicates whether the system looks into subfolders of the source directory for files to include and exclude.</td>
</tr>
<tr>
<td>File attribute uid</td>
<td>file_attribute_uid</td>
<td>Integer</td>
<td>User ID associated with a file or directory.</td>
</tr>
<tr>
<td>File attribute gid</td>
<td>file_attribute_gid</td>
<td>Integer</td>
<td>Group ID associated with a file or directory.</td>
</tr>
</tbody>
</table>
SFTP execution parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>File attribute permissions</td>
<td>file_attribute_permissions</td>
<td>Integer</td>
<td>File or directory permissions for the user and group specified.</td>
</tr>
<tr>
<td>File attribute atime</td>
<td>file_attribute_atime</td>
<td>Integer</td>
<td>Access time stamp from the file attributes.</td>
</tr>
<tr>
<td>File attribute mtime</td>
<td>file_attribute_mtime</td>
<td>Integer</td>
<td>Modification time stamp from the file attributes.</td>
</tr>
<tr>
<td>File attribute size</td>
<td>file_attribute_size</td>
<td>Integer</td>
<td>Size of the file, in bytes.</td>
</tr>
<tr>
<td>Source credential tag</td>
<td>source_credential_tag</td>
<td>String</td>
<td>Credential alias used to run the command on the source host.</td>
</tr>
<tr>
<td>Target credential tag</td>
<td>target_credential_tag</td>
<td>String</td>
<td>Credential tag used to run the command on the target host.</td>
</tr>
<tr>
<td>MidCapabilities</td>
<td>midCapabilities</td>
<td>String (comma separated)</td>
<td>List of required MID Server capabilities.</td>
</tr>
</tbody>
</table>

SFTP post-processing parameters and payload parsing
Use these parameters to create a post-processing script, payload parsing, and tagging.

SFTP post-processing parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output</td>
<td>output</td>
<td>String</td>
<td>Contains output data returned by the query.</td>
</tr>
<tr>
<td>EccSysId</td>
<td>eccSysId</td>
<td>String</td>
<td>Contains the Reference ID associated with the ECC Queue input message.</td>
</tr>
<tr>
<td>ErrorMessages</td>
<td>errorMessages</td>
<td>String</td>
<td>Contains the error messages returned from the query. If no error</td>
</tr>
</tbody>
</table>
SFTP post-processing parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>messages are returned, this value is null.</td>
</tr>
<tr>
<td>Tags</td>
<td>tags</td>
<td>Hashmap of tag values returned from the SSH command</td>
<td>Contains the tags used to extract output using the SSH commands. The tag output is delimited by double percentage signs, as in <code>%%tagname%% ... %%</code>. Set up the command using the following format:</td>
</tr>
</tbody>
</table>

```
%%tagname1%%
output1 line 1
output1 line 2
...
%%

%%tagname2%%
output2 line 1
output2 line 2
...
%%
```

The tags returned are JavaScript hashmap objects in which each key is prefixed with `tag` appended with the `tagname`. 

```
{"__text__": 
"tagtagname1":"output1 line1
output1 line2
",
"tagtagname2":"output2 line1
output2 line2
"}
```

Configure the SFTP execution command

Use the input variables you created to configure the command that Orchestration executes on the SFTP target.

**Before you begin**

Create the input variables you need in the **Inputs** form before you can advance to the **Execution Command** stage.
Role required: activity_creator, admin

Note: You can test the JDBC connection between the MID Server and the target without having to run the activity in a workflow context. For details, see test template outputs.

Procedure

1. Drag variables from the list of inputs and drop them into command fields. The system formats the variable in the proper syntax for the command.

   ![SFTP execution command](image)

   2. Complete the fields shown in the table.

   ![SFTP command fields](image)
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source port</td>
<td>Port number to use to communicate with the source server. The default port number is 22.</td>
<td>All</td>
</tr>
<tr>
<td>Source file path</td>
<td>Full path to a file on a source host.</td>
<td>• Copy file</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Remove file or directory</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Set file attributes</td>
</tr>
<tr>
<td>Source directory</td>
<td>Path to the directory where the source files are located.</td>
<td>• Create directory</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Get file list</td>
</tr>
<tr>
<td>Source files</td>
<td>Names of specific source files to include in the management action. Separate the file names in this list with semi-colons. This field supports the use of wild cards. If this field is blank, all files are included. For information about how the values in this field are affected by options in other fields, see the section below the table.</td>
<td>Get file list</td>
</tr>
<tr>
<td>Is a directory</td>
<td>Check box that determines if the specified file path is a directory.</td>
<td>Remove file or directory</td>
</tr>
<tr>
<td>Credential tag for source</td>
<td>Specific credential alias this activity must use to run SFTP commands on the source host.</td>
<td>All</td>
</tr>
<tr>
<td>Credential tag for target</td>
<td>Specific credential tag this activity must use to run SFTP commands on the target host.</td>
<td>Copy file</td>
</tr>
<tr>
<td>Excluded files</td>
<td>Names of specific source files to exclude from the management action. The activity acts on all other files found in the source directory or subfolders. Separate the file names in this list with semi-colons. This field supports the use of wild cards. For information about how the values in this field are affected by options in other fields, see the section below the table.</td>
<td>Get file list</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Command</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Include subfolders</td>
<td>Check box to manage the files from subfolders in the source directory. For information about how your selection affects other fields in the form, see the section below the table.</td>
<td>Get file list</td>
</tr>
<tr>
<td>Target host</td>
<td>Name or IP address of the server to which the files are being transferred.</td>
<td>Copy file</td>
</tr>
<tr>
<td>Target port</td>
<td>Port number to use to communicate with the target host. The default port number is 22.</td>
<td>Copy file</td>
</tr>
<tr>
<td>Target file path</td>
<td>Full path to a file on a target host.</td>
<td>• Copy file</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Rename file or directory</td>
</tr>
<tr>
<td>Suffix for temporary file</td>
<td>Temporary suffix to use for a file name if the file already exists on a target host. If this field contains a value, the activity deletes the duplicate target file if it exists, and then copies the source file to a temporary file using <code>targetFilePath + tempFileSuffix</code> as the name. Upon completion, the activity renames the file to the actual target file name. If this field is blank, the activity copies the source file directly to the target file and overwrites it, if it already exists.</td>
<td>Copy file</td>
</tr>
<tr>
<td>UID</td>
<td>User ID attribute to apply to a file or directory. The UID and GID values must be set together as a pair or they are ignored.</td>
<td>Set file attributes</td>
</tr>
<tr>
<td>GID</td>
<td>Group ID attribute to apply to a file or directory. The UID and GID values must be set together as a pair or they are ignored.</td>
<td>Set file attributes</td>
</tr>
<tr>
<td>Permissions</td>
<td>File or directory permissions to set for the user and group specified. This value must be expressed as an integer, such as 16877, which defines these permissions: <code>rwxr-xr-x</code>. The permissions number is an internal value returned by the Get File List activity. Typically, you first use the Get File List activity to return a list of files and their attributes. Then you can move a file from a source host to a target host and set the source file attributes on</td>
<td>Set file attributes</td>
</tr>
</tbody>
</table>
Field | Description | Command
---|---|---
the target file. This is demonstrated in the SFTP File Transfer workflow. | | 
Access timestamp | Override the timestamp when the file or directory was last accessed. The access and modification timestamps must be set together as a pair. | Set file attributes
Modification timestamp | Override the timestamp when the file or directory was last modified. The access and modification timestamps must be set together as a pair. | Set file attributes
Size in bytes | Size of a file, expressed in bytes. | Set file attributes
Required MID Server capabilities | MID Server with the appropriate capabilities for connecting to the source and target servers. By default, the system selects an SSH MID Server. | All

The system uses this logic to determine which files to move from the source host:

- If the **Source files** field is empty, the system select all the files in the source directory. Otherwise, it only selects those files whose names match one of the file name patterns given in the field.

- If the **Excluded files** field is empty, the system excludes nothing. Otherwise, it excludes those files whose names match one of the file name patterns given in the field.

- The exclude rule has a higher preference than the include rule. A file whose name matches one of the file name patterns in the **Excluded files** field does not get into the selection, even though it would be selected by the include rule.

- When the **Include subfolders** check box is cleared, the system looks only in the source directory for files to include or exclude. Otherwise, it looks in the source directory and any of its subfolders for files to include or exclude.

3. Click **Save**.

4. Click **Continue** to advance to the **Outputs** stage.

**Create a probe activity**

Create an activity that runs a probe on the target host that is configured to return specific information..
Before you begin
Role required: activity_creator or workflow_admin

About this task
For instructions on using the activity template process flow, see create custom activities.

Procedure
1. Create a **custom activity**.
   This action creates a custom activity using a template.
2. After setting up **general properties** and **creating input variables**, configure the Probe Execution Command:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Map the input variables</strong></td>
<td>Use the variables you created to configure the command that Orchestracion executes.</td>
</tr>
<tr>
<td><strong>Probe</strong></td>
<td>Probe to run with this activity, from the list of probes in the system</td>
</tr>
<tr>
<td><strong>Target host</strong></td>
<td>Host name or IP address of the target server for this activity.</td>
</tr>
<tr>
<td><strong>Parameters</strong></td>
<td>MID Server to use, by capabilities.</td>
</tr>
<tr>
<td><strong>Required MID Server capabilities</strong></td>
<td>Name-value pairs to pass to the host with this probe. You can create these parameters manually, or drag and drop input variables into the parameter fields and assign a value.</td>
</tr>
</tbody>
</table>

**Note:** You can map parameter values in a test payload to variables in the Outputs tab automatically. See automap output variables.

What to do next
- Use **auto-mapping** to generate outputs and parsing rules
- If you do not use auto-mapping, you can manually create output variables and create parsing rules
Probe template execution parameters

You use execution parameters to create the input process script in the Pre Processing form.

For descriptions of the command fields, see Configure the Probe execution command.

**Note:** You must use the executionParam. prefix with all variables in this table.

### Probe activity execution parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Probe</td>
<td>probe</td>
<td>Reference</td>
<td>The sys_id of the MID Server probe.</td>
</tr>
<tr>
<td>Source</td>
<td>source</td>
<td>String</td>
<td>Intended target host</td>
</tr>
<tr>
<td>Parameters</td>
<td>parameters</td>
<td>Array of JS object</td>
<td>Array of JavaScript objects, expressed with the executionParam. prefix. To add more name-value pairs to the parameters array, append them to the existing array. Create a JavaScript object with the following syntax, and add it to the executionParam.parameter array. This assigns additional parameters to the message:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>var newParameter =</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>{&quot;name&quot;:&quot;parameterName&quot;,&quot;value&quot;:&quot;parameterValue&quot;};</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>executionParam.parameters.push(newParameter);</td>
</tr>
<tr>
<td>MidCapabilities</td>
<td>midCapabilities</td>
<td>String (comma separated)</td>
<td>List of required MID server capabilities.</td>
</tr>
<tr>
<td>ValueCapabilities</td>
<td>valueCapabilities</td>
<td>Array of hashmap</td>
<td>Capability values used to select the MID Server. For more information, see MID Server capabilities. If there are additional capabilities</td>
</tr>
</tbody>
</table>
Probe activity execution parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>that are assigned by value, use this example to customize the MID Server selection:</td>
</tr>
</tbody>
</table>

```javascript
var valueCapability = 
{"NEW_MID_CAPABILITY":"NEW_MID_CAPABILITY_VALUE"};
executionParam.valueCapabilities.push(valueCapability);
```

Probes template post-processing parameters

Use these parameters to create a post-processing script.

Probe post-processing parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payload</td>
<td>payload</td>
<td>String</td>
<td>Contains raw payload returned from the probe.</td>
</tr>
<tr>
<td>Output</td>
<td>output</td>
<td>String</td>
<td>Contains output data returned from the probe.</td>
</tr>
<tr>
<td>EccSysId</td>
<td>eccSysId</td>
<td>String</td>
<td>Contains the reference ID associated with the ECC Queue input message.</td>
</tr>
</tbody>
</table>

Configure the Probe execution command

Use the input variables you created to configure the command that Orchestration executes on the target.

Before you begin

Create the input variables you need in the Inputs form before you can advance to the Execution Command stage.

Role required: activity_creator, admin

**Note:** You can test the activity connection between the MID Server and the target without having to run the activity in a workflow context. For details, see test template outputs.
Procedure

1. Drag variables from the list of inputs and drop them into command fields. The system formats the variable in the proper syntax for the command.

   **Probe execution command**

   ![Probe execution command interface]

   - **Input**: Input variable builder. Create input variables to map to available fields.
   - **Probe**: Probe to run with this activity, from the list of probes in the system.
   - **Target host**: Host name or IP address of the target server for this activity.
   - **Required MID Server capabilities**: MID Server to use, by capabilities.
   - **Parameters**: Name-value pairs to pass to the host with this probe. You can create these parameters manually, or drag and drop input variables into the parameter fields and assign a value.

2. Complete the fields shown in the table.

   **Probe execution command fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Input variable builder. Create input variables to map to available fields.</td>
</tr>
<tr>
<td>Probe</td>
<td>Probe to run with this activity, from the list of probes in the system.</td>
</tr>
<tr>
<td>Target host</td>
<td>Host name or IP address of the target server for this activity.</td>
</tr>
<tr>
<td>Required MID Server capabilities</td>
<td>MID Server to use, by capabilities.</td>
</tr>
<tr>
<td>Parameters</td>
<td>Name-value pairs to pass to the host with this probe. You can create these parameters manually, or drag and drop input variables into the parameter fields and assign a value.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

4. Click **Continue** to advance to the **Outputs** stage.
Create an SSH activity
Create an activity that extracts data from a target host that uses the SSH network protocol.

Before you begin
Role required: activity_creator or workflow_admin

About this task
For instructions on using the activity template process flow, see create custom activities.

Procedure
1. Create a custom activity.
   This action creates a custom activity using a template.
2. After setting up general properties and creating input variables, configure the SSH Execution Command:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map the input variables</td>
<td>Use the variables you created to configure the command that Orchestration executes.</td>
</tr>
<tr>
<td>Target host</td>
<td>Host name or IP address of the target server for this activity.</td>
</tr>
<tr>
<td>Command</td>
<td>Command this activity runs on the target host. You can invoke a MID Server script from this field using any script type that the SSH command line supports. For more information, see Advanced SSH script options below the table.</td>
</tr>
<tr>
<td>Directory</td>
<td>Directory on the target host where the command is run.</td>
</tr>
<tr>
<td>Credential tag</td>
<td>The Orchestration credential tag to use when running the command.</td>
</tr>
<tr>
<td>Required MID Server capabilities</td>
<td>MID Server with the appropriate capabilities for connecting to the host. By default, the system selects a MID Server with SSH capabilities.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Long running</td>
<td>If checked, disables the SSH connection timeout for commands that might take longer to run than the default 60 seconds. Orchestration periodically checks the running process to determine its status until it is finished.</td>
</tr>
<tr>
<td>Must Sudo</td>
<td>If checked, enables the use of <code>sudo</code> to run commands.</td>
</tr>
</tbody>
</table>

**Note:** You can map parameter values in a test payload to variables in the **Outputs** tab automatically. See automap output variables.

**Example: Advanced SSH script options**

To run a MID Server script on the target host, specify the script type and pass the name of the script into the `${syncFile()}` parameter. The system uses this parameter to locate the named script in the MID Server Script File [ecc_agent_script_file] table and run it on the target host. For example, a bash script can be expressed as:

```
bash ${syncFile("<MID script name>")} argument1 argument2 argument3
```

A base script (*main_script.bash*) can reference another script (*my_include.bash*) as well as a separate file (*.my_profile*) located on the target host. Both scripts and the file referenced must be synced to the MID Server, using the `${syncFile()}` parameter, to execute properly.

```
source ${syncFile(".my_profile")}
cp ${syncFile("my_include.bash")} /usr/ssmith/my_include.bash
bash ${syncFile("main_script.bash")} one two three four five six
rm /usr/ssmith/my_include.bash
```

A Python example with inline comments might look like this:

```
set $LIB_DIR=/usr/bin;
# Sync a file that is referenced inside myF5CreateLBPool.py
cp ${syncFile("specialFunctions.py")} ~/specialFunctions.py
# set up environment variables
source ${syncFile(".python_profile")}
# call script that sets up dependencies on the box from remote package repos
python ${syncFile("setupPythonDependencies.py")} pycontrol
# call a script that requires functions from the package as well as a function from myIncludedFile
python ${syncFile("myF5CreateLBPool.py")} snow_pool myActualValue
```
# user is responsible for their own cleanup
rm ~/specialFunctions.py

What to do next

- Use auto-mapping to generate outputs and parsing rules
- If you do not use auto-mapping, you can manually create output variables and create parsing rules

SSH template execution parameters

Use execution parameters to create the input process script in the Pre Processing form of the activity designer.

For descriptions of the command fields, see Configure the SSH execution command.

ℹ️ Note: You must use the `executionParam.` prefix with all variables in this table.

<table>
<thead>
<tr>
<th>SSH execution parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Source</td>
</tr>
<tr>
<td>Command</td>
</tr>
<tr>
<td>Directory</td>
</tr>
<tr>
<td>Credential tag</td>
</tr>
<tr>
<td>MidCapabilities</td>
</tr>
<tr>
<td>ValueCapabilities</td>
</tr>
</tbody>
</table>
### SSH execution parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
</table>
| customize the MID Server selection: |              |        | var valueCapability = {
|                    |              |        |   'NEW_MID_CAPABILITY': 'NEW_MID_CAPABILITY_VALUE'};
|                    |              |        | executionParam.valueCapabilitie s.push(valueCapability);               |
| Long running       | long_running | Boolean| Indicates whether or not the command is long running. A value of true indicates that the command is long running. |
| Must sudo          | must_sudo    | Boolean| Indicates whether or not this activity must use sudo to run root commands. A value of true indicates that `sudo` must be used. |

### SSH post-processing parameters and payload parsing

Use these parameters to create a post-processing script, payload parsing, and tagging.

#### SSH post-processing parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output</td>
<td>output</td>
<td>String</td>
<td>Contains the output returned from the SSH command.</td>
</tr>
<tr>
<td>EccSysID</td>
<td>eccSysID</td>
<td>String</td>
<td>Contains the reference ID associated with the ECC Queue input message returned by the activity.</td>
</tr>
<tr>
<td>ErrorMessages</td>
<td>errorMessages</td>
<td>String</td>
<td>Contains the error messages retrieved from the SSH command. This value is <code>null</code> if there are no error messages.</td>
</tr>
</tbody>
</table>
SSH post-processing parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tags</td>
<td>tags</td>
<td>Hashmap of tag values</td>
<td>Contains the tags used to extract output using the SSH commands. The tag output is delimited by double percentage signs, as in <code>%%tagname%% ... %%</code>. Set up the command using the following format:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>returned from the SSH command</td>
<td></td>
</tr>
</tbody>
</table>

The tags returned are JavaScript hashmap objects in which each key is prefixed with `tag` appended with the tagname.

```json
{"__text__": 
  "tagtagname1":"output1 line1
  output1 line 2
  
  
%}
%tagname2%
  output2 line1
  output2 line 2
  

%}
```

**Configure the SSH execution command**

Use the input variables you created to configure the command that Orchestration executes on the host target.

**Before you begin**
Create the input variables you need in the **Inputs** form before you advance to the **Execution Command** stage.

Role required: activity_creator, admin
**Note:** You can test the SSH connection between the MID Server and the target without having to run the activity in a workflow context. For details, see test template outputs.

**Procedure**

1. Drag variables from the list of inputs and drop them into command fields. The system formats the variable in the proper syntax for the command.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input</strong></td>
<td>Input variable builder. <a href="#">Create input variables</a> to map to available fields.</td>
</tr>
<tr>
<td><strong>Target host</strong></td>
<td>Host name or IP address of the target server for this activity.</td>
</tr>
<tr>
<td><strong>Command</strong></td>
<td>Command this activity runs on the target host. You can invoke a MID Server script from this field using any script type that is supported by the SSH command line. For more information, see <a href="#">Advanced SSH script options</a> below the table.</td>
</tr>
<tr>
<td><strong>Directory</strong></td>
<td>Directory on the target host where the command is run.</td>
</tr>
<tr>
<td><strong>Credential tag</strong></td>
<td>The credential alias to use when running the command.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Select MID Server by capabilities | MID Server with the appropriate capabilities for connecting to the host. By default, the system selects a MID Server with SSH capabilities.
Long running | Check box to disable the SSH connection timeout for commands that might take longer to run than the default 60 seconds. Orchestration periodically checks the running process to determine its status until it is finished.
Must Sudo | Check box to allow the use of *sudo* to run commands.

3. Click **Save**.

4. Click **Continue** to advance to the **Outputs** stage.

**Create a run script activity**

Create an activity that runs any script.

**Before you begin**

Role required: activity_creator or workflow_admin

**Procedure**

1. Create a **custom activity**.
   This action creates a custom activity using a template.

2. After setting up **general properties** and creating input variables, configure the Run Script Execution Command:
   Create a script for this activity to execute.

   **Note:** You can map parameter values in a test payload to variables in the **Outputs** tab automatically. See automap output variables.

**What to do next**

- Use **auto-mapping** to generate outputs and parsing rules
- If you do not use auto-mapping, you can manually **create output variables** and **create parsing rules**

**Run Script template processing script**

Use the Run Script custom template Script form to enter a script to call and use with other activities.
Run Script processing script

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processing script</td>
<td>Script that the activity runs.</td>
</tr>
<tr>
<td>Variables</td>
<td>Input variables that are available to use as building blocks in the input process script. Click the arrow above the field to open the variables list. Click an item in the tree to add it to your script in the appropriate syntax. The list displays input variables you passed into the activity on the Inputs form. All activity variables added in the Inputs form are read-only and are expressed in the processing script with this syntax: <code>activityInput.variable</code></td>
</tr>
</tbody>
</table>

Create a JMS activity

Create a custom JMS activity to retrieve or send messages to external systems using the Java Messaging Service.

Before you begin
Role required: activity_creator or workflow_admin

About this task
The JMS activity supports third party JMS providers whose JMS client application is written with a typical Java EE pattern and can support these operations:

- Using JNDI to find a ConnectionFactory object.
- Using JNDI to find one or more destination objects.
- Using the ConnectionFactory to create a JMS connection object.
- Using the JMS connection to create one or more JMS session objects.
- Using a JMS session and the destinations to create the MessageProducer and MessageConsumer objects.
- Starting the JMS connection to enable delivery or consumption of messages.

Note: The JMS activity designer has been tested with the JMS providers ActiveMQ and Tibco EMS. When connecting to a JMS provider, refer to your third party user documentation.
Procedure

1. Create or verify your JMS credential.
   Your JMS credentials must have permission for the target database and proper configuration for the corresponding JMS connection. Credentials must be set up before you can create a JMS activity.

2. Create or verify your JMS connection.
   Your JMS connection must be configured with valid JMS credentials set up before you can create a JMS activity.

3. Create a custom activity.
   This action creates a custom activity using a template.

4. After setting up general properties and creating input variables, configure the JMS Execution Command:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure your credential</td>
<td>Fill in the fields necessary for your database connection.</td>
</tr>
<tr>
<td>Connection Factory</td>
<td>Name of the JMS Connection Factory. You should create or verify your JMS connection. This configuration links the name of the Initial Context Factory with the URL of the JMS provider.</td>
</tr>
<tr>
<td>Destination Type</td>
<td>Type of destination used for this message:</td>
</tr>
<tr>
<td></td>
<td>• Queue: Message is queued for point-to-point communications.</td>
</tr>
<tr>
<td></td>
<td>• Topic: Message is used for publish and subscribe communication.</td>
</tr>
<tr>
<td></td>
<td>Note: The GET operation is only supported for the Queue destination type.</td>
</tr>
<tr>
<td>Destination Name</td>
<td>Name of the queue or topic destination that is configured on the JMS provider.</td>
</tr>
<tr>
<td>Message Type</td>
<td>The JMS message type value. Only the Text Message type is supported. The queue or topic destination must</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td>be configured to receive or send only Text Message. Other message types are dropped, since the JMS Activity cannot process them.</td>
</tr>
<tr>
<td><strong>Operation</strong></td>
<td>The programmatic operation to perform on the destination. The choices are <strong>PUT</strong> or <strong>GET</strong>.</td>
</tr>
<tr>
<td><strong>Timeout (Secs)</strong></td>
<td>Allowed time to wait for a message in the message queue before it times out, in seconds. The default is <strong>30</strong>.</td>
</tr>
<tr>
<td><strong>Custom message headers</strong></td>
<td>The custom header values in a name/value pair format, that is available on the JMS destination.</td>
</tr>
<tr>
<td><strong>Message payload</strong></td>
<td>Actual message content or payload that is sent to the JMS destination.</td>
</tr>
<tr>
<td><strong>Credential tag</strong></td>
<td>A tag for an individual credential for a JMS activity in an Orchestration workflow.</td>
</tr>
<tr>
<td><strong>Required MID Server capabilities</strong></td>
<td>MID Server to use, by capabilities.</td>
</tr>
</tbody>
</table>

### What to do next

- Use **auto-mapping** to generate outputs and parsing rules
- If you do not use auto-mapping, you can manually **create output variables** and **create parsing rules**

### Create a JMS connection for an Orchestration activity

Configure your system to use Java Messaging Service (JMS) with a custom Orchestration JMS activity.

### Before you begin

**Role required:** admin
About this task
The MID Server must have the correct JMS connection factories for your organization. Configure those values in the mid.property.jms.command.allowed_factory_names property, found in MID Server > Properties. The default values for this property can be changed to any value or comma-separated list of values that the third-party JMS provider advertises.

Procedure
1. Navigate to MID Server > JAR Files.
2. Click New and add:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique and descriptive name for identifying the file in the instance.</td>
</tr>
<tr>
<td>Version</td>
<td>A version number for the file, if one is available.</td>
</tr>
<tr>
<td>Source</td>
<td>Location of the JAR file for reference purposes. Source information is not used by the system.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of the JAR file and its purpose in the instance.</td>
</tr>
</tbody>
</table>

3. Click the paper clip icon in the banner and attach the JMS driver jar file. The JMS driver jar file should be available as part of JMS provider installation. Few JMS vendors make them available as a separate product. Refer to the JMS provider documentation to determine which JMS client driver jar files require the client applications to connect to the JMS provider. For example, if you are trying to connect to ActiveMQ V5.10 (JMS provider), you need the activemq-all-5.10.1.jar file.

5. Click New, add the following, and click Submit:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of this connection factory.</td>
</tr>
<tr>
<td>Initial Context Factory</td>
<td>Name of the JNDI class that is used to create the InitialContext.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Provider URL</td>
<td>Location of the running JMS provider installation.</td>
</tr>
</tbody>
</table>

Note: For example, to connect to ActiveMQ V5.1: tcp://ipAddressOrHostName:61616.

6. Navigate to Orchestration > Credentials.

7. Click New, select JMS Credentials, and provide the user name and password the MID should use to communicate with the JMS provider. For more information, see JMS credentials.

8. Click Submit. You are ready to create a custom JMS activity.

JMS template execution parameters
You use execution parameters to create the input process script in the Preprocessing form.

You must use the executionParam. prefix with all variables in this table.

<table>
<thead>
<tr>
<th>JDBC execution parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Jms ds</td>
</tr>
<tr>
<td>Destination type</td>
</tr>
<tr>
<td>Destination name</td>
</tr>
<tr>
<td>Message type</td>
</tr>
<tr>
<td>Operation</td>
</tr>
</tbody>
</table>
### JDBC execution parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time out</td>
<td>time_out</td>
<td>Integer</td>
<td>Length of time to wait for the query to return results.</td>
</tr>
<tr>
<td>Custom headers</td>
<td>custom_headers</td>
<td>Array of JavaScript objects</td>
<td></td>
</tr>
<tr>
<td>Message payload</td>
<td>message_payload</td>
<td>String</td>
<td></td>
</tr>
<tr>
<td>Credential tag</td>
<td>credential_tag</td>
<td>String</td>
<td>List of required MID Server capabilities.</td>
</tr>
<tr>
<td>MidCapabilities</td>
<td>midCapabilities</td>
<td>String (comma separated)</td>
<td></td>
</tr>
<tr>
<td>ValueCapabilities</td>
<td>valueCapabilities</td>
<td>Array of hashmap</td>
<td>Capability values used to select the MID Server. For more information, see MID Server capabilities. If there are additional capabilities that are assigned by value, use this example to customize the MID Server selection:</td>
</tr>
</tbody>
</table>

```javascript
var valueCapability = {
  'NEW_MID_CAPABILITY': 'NEW_MID_CAPACITY_VALUE'};
executionParam.valueCapabilities.push(valueCapability);
```

### JMS template post-processing parameters

Use these parameters to create a post-processing script.
### JMS post-processing parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>status</td>
<td>String</td>
<td>Status of the operation (Put or Get) on the JMS destination.</td>
</tr>
<tr>
<td>StandardHeaders</td>
<td>standardHeaders</td>
<td>String</td>
<td>All the standard headers, as specified by JMS, that are obtained as part of the JMS message during a Get operation. This field is applicable only for Get operations.</td>
</tr>
<tr>
<td>CustomHeaders</td>
<td>customHeaders</td>
<td>String</td>
<td>All custom headers added by a producer or publisher application that are obtained as part of the JMS message during a Get operation. This field is applicable only for Get operations.</td>
</tr>
<tr>
<td>MessagePayload</td>
<td>messagePayload</td>
<td>String</td>
<td>Message payload that is obtained as part of the JMS message during a Get operation. This field is applicable only for Get operations.</td>
</tr>
<tr>
<td>EccSysID</td>
<td>eccSysID</td>
<td>String</td>
<td>Contains the reference ID associated with the ECC Queue input message returned by the activity.</td>
</tr>
<tr>
<td>ErrorMessages</td>
<td>errorMessages</td>
<td>String</td>
<td>Contains any error messages retrieved from the JMS command. This value is null if there are no error messages.</td>
</tr>
</tbody>
</table>

### Activity scoping

Custom activities run in their own scope, even if it is different from that of the workflow.

Any script that runs inside a custom activity with a scope can only access outside artifacts that are within the scope of that activity or artifacts that are configured to run in any scope. Conversely, an outside artifact can only access the script inside that private activity if the outside artifact is running in the same...
scope. Activities with public scopes can interact with outside artifacts in any application scope.

You can use private activities as part of a workflow that has a public application scope. These activities are protected from reaching outside of the workflow or from being reached from outside the workflow. For details about setting application scoping for custom activities, see the field description table for the appropriate activity template.

Note: Custom activities uploaded to the ServiceNow Store must be configured as accessible to all application scopes.

Publish a custom activity

When a user creates a custom activity and saves or submits it, that activity appears in the Custom and Packs tabs of the designer palette, but is visible only to the user who created it.

Before you begin
Roles required: admin, activity_admin, activity_creator

Procedure

1. When you finish configuring the activity, click Publish.
   
   This makes the activity accessible to other users on the instance with the workflow_admin or activity_creator role. Published activities are available for upload to the ServiceNow Store, can be added to workflows, and can be edited by any user with the proper roles.

2. To edit a published activity, click Checkout.
   
   When an activity is checked out by a user, only that user can modify it. The fields of a checked out activity are read-only for all other users.

3. When you are finished editing the checked out activity, publish it again.
   
   The system adds a new version of this activity to the Custom tab in the Workflow Editor palette.

   Note: Activities you create and publish are visible in the Packs tab only if they were created in the current application scope.

Return a locked activity to a published state

Problems can arise if an activity version is checked out by a user and not checked back in. An activity in this state cannot be checked out for update.
Before you begin
Role required: admin, activity_admin, activity_creator

About this task
An administrator can return a locked activity to a published state.

Procedure
1. Open the Workflow Editor.
2. From the Custom tab, open the activity that is locked.
3. Click the menu icon in the title bar and select Versions from the context menu.
   A list of all the versions of that activity appears. The locked version displays the user who checked it out.

4. Select the checked out version.
   The system opens the record in the activity designer.
5. Click the menu icon again and select Force Checkout from the context menu.
   The activity fields become editable.
6. Click Publish.
   The activity becomes available to users with the appropriate roles.

Copy a custom activity
You can copy activities for reuse from the Custom tab in the global scope.

Before you begin
Role required: admin, activity_admin, activity_creator

About this task
⚠️ Note: You cannot copy an activity in a private scope.
Procedure

1. To reuse an activity in the global scope, expand the parent category to display the activities.

2. Right-click the activity you want to copy and select one of these options:

   • **Copy into global scope as new activity**: Copies the activity with the new name you provide, uses the same version number as the original activity, and moves it to the global scope in the **Custom** tab.

   ![](image)
   
   **Naming an activity copy**
   
   Add F5 Virtual Server - v1 - Copy into global scope as new activity
   
   Activity name
   
   ![Activity name field]
   
   [Cancel] [OK]

   • **Copy into global scope as new version**: Copies the activity using the same name, increments the version number, and moves it to the global scope in the **Custom** tab. The system automatically adds the parent category to the **Custom** tab if it does not already exist. This action will overwrite another activity with the same name and version number.

   ![](image)
   
   **Creating a new activity version**
   
   Confirm copy
   
   Are you sure you want to copy 'Reset AD User Password - v1' activity into global as a new version?
   This action will overwrite an existing activity with the same name.
   
   [Cancel] [OK]

   **Note:** If the activity is in any other scope but global, the system displays this message: **Cannot copy privately scoped activity.**

Orchestration databus

The databus allows workflow designers to track the flow of data through an Orchestration workflow and provides access to output data that can be consumed by other custom activities.

Data is made available in a workflow when you use activities created with the **Orchestration activity designer**. The activity designer provides the ability to specify well defined inputs and outputs for your activities. When you use those activities on the workflow canvas, the outputs appear in the **Data** tab and are available for use as inputs in subsequent activities.
Note: Orchestration does not filter the data you are given for reuse in the Data tab. You must make sure an activity in the workflow canvas has executed before you consume its output data.

When you drop a custom activity onto the workflow canvas, the system assigns it an index. If you delete an activity from the canvas and add a new one, the indexes are not reused. This ensures that you don’t accidentally start subscribing to data you did not intend to use. If you update an activity in the activity designer, the system automatically updates the activity on the canvas to ensure the data you are subscribing to downstream is not affected.

Reuse data in the activity designer

The Data tab in the Workflow Editor lists all custom activities used in the current workflow that produce data and displays that data for reuse in other custom activities.

Before you begin
Roles required: workflow_creator

About this task
Activities are categorized by application in this tab and are available for use as data sources for other activities. The Data tab is a graphical representation of the workflow Databus, which manages all the temporary data used by the current workflow.

Procedure
1. Drag output variables from an activity in this tab into the inputs of another activity on the workflow canvas to link the activities together.

You can use any of the outputs in the structure, regardless of the application to which they belong. An index number in parenthesis after the activity name provides a unique identifier for the parameters that you use as input data in other activities. If you do not name a custom activity, the only identifier for that activity in the Data tab is the index number. Index numbers indicate the sequence in which custom activities were added to the workflow and are not reused. When you drag a custom activity onto the workflow canvas, the system adds that activity and its output data to the structure. Conversely, if you remove a custom activity from the canvas, that activity and its outputs disappear from the data list.
2. Point to an activity to display information about it in a pop-up window.

Any output data reused by the activity is listed in the **Databus Output** field of the pop-up window.

**MID Servers for Orchestration**

Orchestration automatically selects an appropriate MID Server based on the capabilities that you configure in activities, the IP addresses of target devices, and the application that the MID Server is allowed to use.

To allow a MID Server to work with Orchestration, it must have the **Orchestration** application or the **ALL** application assigned to it. See **Configure a default MID Server for each application** for instructions.

You can have MID Servers focus on different capabilities and separate sections of your network. See:

- MID Server capabilities
- Map an IP address to a DNS name

You can also specify a default MID Server to use if no MID Servers meet the capability and IP range criteria for an activity. See **Select the default MID Server for Orchestration**.
Related reference

MID Server capabilities

MID Server capabilities define the specific functions of a MID Server within an IP address range.

Nmap capability

The Nmap capability is only assigned to MID Servers for which the Network Mapper (Nmap) scanner has been installed for credential-less Discovery. This capability cannot be added to or removed from any MID Server manually. For instructions on installing or uninstalling Nmap, see Install and uninstall Nmap on a MID Server.

MID Server capability values

Capabilities provided in the base system do not have a defined value string. The capability value can be blank, a single value, or a * (wildcard). A MID Server configured to use a capability that has no value can locate any device using that capability's protocol. If a capability has a defined value, the MID Server using that capability finds only those devices using that protocol that match the value string exactly. The exception to this is the Resolve DNS capability, which is configured to resolve any DNS name into an IP address using a partial string match. The * (wildcard) will match a request capability specifying any non-blank value.

Starting with the Madrid release, the [capability name]:[value] combination appears in the slushbucket when you add a capability to a MID Server. This combination allows you to see all the capabilities that have different values, even if the capability name is the same. For example, if you are using the Cloud Management capability, and you use the value field to specify the us-west logical datacenter on one of the capability records, you can see the combination in the Collection list.
MID Server selection

The MID Server is selected using an algorithm based on the capabilities available. The selector produces a list of suitable MIDs using filters in the following order: `server status` > `applications` > `IP range` > `capabilities`. The algorithm searches the capabilities in the following sequence and, if a step finds at least one MID server, the remaining steps are skipped:

1. **Exact value match**: Find each MID Server containing capabilities with name/value pairs with an exact match to all requested capability name/value pairs. Blank is a valid value. * (wildcard) values are ignored.

2. **Wildcard value match**: The same as an exact value match, but also allows a non-blank request value to match MID server capability records containing value *.

3. **Special capability name ALL**: Find each MID Server containing the special capability name ALL, ignoring capability’s value field.

**Note**: If the requested capability name does not exist in the `ecc_agent_capability` table, `BadArgumentException` is thrown rather than falling back to the ALL capability.

Scripted MID Server capability value matching

You can use value tests to create capabilities that find devices using values without requiring exact string matching. Action on these values is controlled by a user-defined script.
The Resolve DNS capability is provided in the base system and is configured to resolve DNS names into IP addresses for devices whose names end with a specified domain name. The capability Value entered is automatically prefaced with a dot during processing to match domain syntax. This value can contain one or more sub-domains, but must include the end of the domain string. Matching devices must end with the identical syntax. The script for the Resolve DNS capability determines if a device name matches the criteria defined by Value. If a match exists, the platform performs the address resolution automatically. For example, if the value for the Resolve DNS capability is service-now.com, the MID Server with this capability finds lnxlab01.sandiego.service-now.com and dbsrv101.sanjose.service-now.com. If the value is changed to sandiego.service-now.com, then the MID Server finds only lnxlab01.

Note: If Value in the Resolve DNS capability is blank, then all domains match.

To view the script for evaluating this capability, navigate to MID Server > Capability Value Tests and select Resolve DNS from the list.

Configure MID Server capabilities

MID Server capabilities define the specific functions of a MID Server within an IP address range, allowing an application to select the most appropriate MID Server. Configure capabilities on MID Servers for applications like Orchestration, Cloud Management, and Service Mapping.

Before you begin
Role required: admin or sm_admin
1. Ensure that the MID Server can connect to elements inside and outside your network
2. Download and install the MID Server on a Linux or Windows host
3. Configure your MID Server
4. Configure MID Server security
5. Ensure that the MID Server can connect to elements inside and outside your network
6. Download and install the MID Server on a Linux or Windows host
7. Configure your MID Server
8. Configure MID Server security

About this task
Several applications use capabilities, IP ranges, and MID Server selection to narrow the pool of MID Servers the applications need.

⚠️ Note: At least one capability is required for each MID Server used by Orchestration. See MID Servers for Orchestration for more information.

The following capabilities are available by default with Discovery:

<table>
<thead>
<tr>
<th>All</th>
<th>IBM</th>
<th>Resolve DNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ansible</td>
<td>JDBC</td>
<td>REST</td>
</tr>
<tr>
<td>AWS</td>
<td>NetApp</td>
<td>SNMP</td>
</tr>
<tr>
<td>Azure</td>
<td>Nmap</td>
<td>SOAP</td>
</tr>
<tr>
<td>Chef</td>
<td>OpenStack</td>
<td>SSH</td>
</tr>
<tr>
<td>Cloud Management</td>
<td>PowerShell</td>
<td>VMware</td>
</tr>
<tr>
<td>Google</td>
<td>RCA</td>
<td>WMI</td>
</tr>
</tbody>
</table>
Procedure

1. Navigate to **MID Server > Capabilities**.

2. Select an existing capability. You can also select **ALL** to include all capabilities.

   ✪ **Note:** Ensure that each IP address range has MID Servers with the necessary capabilities to complete the Orchestration activities on that network segment.

3. Create a new capability:
   a. Click **New**.
   b. Configure the value for a custom capability.
      
      **Example**
      An example is a capability for **DOMAIN**, with a value of **service-now**.
   c. Click **Submit**.

4. Click **Edit** in the MID Servers related list to add MID Servers to the capability.

5. Select one or more MID Servers for this capability from the **Available** list.

6. Click **Save**.

   The capability defined here also appears in the primary record for this MID Server.

---

**Select the default MID Server for Orchestration**

Orchestration uses the default MID Server if it cannot find a MID Server with the correct IP range and capability.

Specify the default MID Server in either of these locations:

- The **Default MID Server** field on the Orchestration application record. See **Configure a default MID Server for each application** for instructions.

- The **Default MID Server to use for Orchestration Activities** property. Navigate to **Orchestration > MID Server Properties** to set this value.

These two values are automatically kept in synch. You can change the default MID Server in either location.
**PowerShell probe version 2 system property**

View detailed PowerShell credential information and view extended logging information.

Starting with the madrid release, there is a new system property for the PowerShell probe which enables the version 2 of the probe. This new version enables you to view detailed credential information on why PowerShell credentials fail or succeed. You can also view logging information for an ECC Queue payload and Workflow Context log.

`mid.server.rba_powershell_v2`

Enables the PowerShell probe version 2 for use with all PowerShell activities. The default value is true. If you choose false, the legacy PowerShell probe is used. Unless there are issues, use version 2, as the legacy version is going to be deprecated.

ℹ️ **Note:** This property only applies to Orchestration activities. Discovery probes are not affected.

You can access the property by selecting the MID Server Properties link in the navigation pane:

<table>
<thead>
<tr>
<th>Orchestration MID Server Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server</td>
</tr>
<tr>
<td>Default MID Server to use for Orchestration Activities</td>
</tr>
<tr>
<td>Debug SSH Probes</td>
</tr>
<tr>
<td>Use PowerShell Probe V2</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

---

**PowerShell log property**

Enable debug messages to display from PowerShell.

This property enables control of when and where to display debug messages generated by debug statements embedded in the PowerShell scripts.

`mid.property.powershell.log_info`
The new MID Server PowerShell log property:

• Displays logging information.

  ℹ️ **Note:** Once logging is enabled, OOB PowerShell scripts log information.

• Adds logging information to your developed PowerShell scripts and PowerShell activities.

  ℹ️ **Note:** Logging information is only available when property is enabled.

• Logging is not enabled by default.

If the property is set to true, debug messages display from the workflow context or from the Response popup after you test inputs. The ecc_queue entry payload for each of the PowerShell activities is going to show all the debug messages that were logged.

Enable the PowerShell log property for each MID Server. If the MID Server field is empty, the property applies to all MID Servers. There are separate credential debug messages that always come back regardless of this setting. The credential debug messages show which credentials have been used and other related information.

  ℹ️ **Note:** All the debug messages that come back to the instance are also saved to the MID Server log file. The log file might have additional debug messages generated from Java code, which might help the debug process.
Use the Orchestration Usage dashboard

This dashboard shows an overview of Orchestration usage metrics to show customers how their organization uses Orchestration and to support license compliance.

**Before you begin**

Role required: orchestration_manager

**Procedure**

1. To view the dashboard, navigate to **Orchestration > Operations & Troubleshooting > Orchestration Usage Dashboard**.

The Orchestration Usage dashboard displays. The tabs on the dashboard include Licensable Usage and Orchestration Usage. Reports on these tabs include:

<table>
<thead>
<tr>
<th>Orchestration Usage Metrics</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Transaction Summary Last 12 months** | A running transaction count of all Orchestration transactions over the last 12 months. Includes:  
- The count of orchestration transactions associated with the HR Application  
- The count of Orchestration transactions associated with the Security Operations Application |
<p>| <strong>Transaction Summary YTD</strong> | Cumulative count of all transactions since the time the Orchestration plugin was activated or the customer upgraded to Geneva. |
| <strong>365 day Running Average of Server</strong> | The running average over the last 365 days for cmdb_ci_computer - cmdb_ci_server. This includes all physical and virtual client nodes and excludes server nodes from the count. |
| <strong>365 day Running Average of Client</strong> | The running average over the last 365 days for cmdb_ci_server. This includes all physical and virtual server nodes. |</p>
<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orchestration Transactions by Month for Last 12 Months</td>
<td></td>
</tr>
<tr>
<td>Average Client Nodes Orchestrated Last 365 Days</td>
<td></td>
</tr>
<tr>
<td>Average Server Nodes Orchestrated Last 365 Days</td>
<td></td>
</tr>
<tr>
<td>Number of Orchestration Activities Developed Last 365 Days</td>
<td>The aggregate number of activity definitions you have developed and OOB activity definitions you have modified. This number includes activity elements (Activities build with the Activity Designer) you have developed and OOB activity definitions you have modified.</td>
</tr>
<tr>
<td>Note:</td>
<td>This number excludes activity elements that are shipped with ServiceNow Applications that use the Orchestration Runtime e.g. ServiceNow Security Operations and Human Resources Apps.</td>
</tr>
<tr>
<td>Cumulative Client Nodes Orchestrated by Month</td>
<td></td>
</tr>
<tr>
<td>Cumulative Server Nodes Orchestrated by Month</td>
<td></td>
</tr>
<tr>
<td>Usage by Provider Last 12 Months</td>
<td>Breaks down emphasis by provider, such as PowerShell, JDBC, SSH, etc.</td>
</tr>
<tr>
<td>Top 10 Orchestration Activities</td>
<td></td>
</tr>
</tbody>
</table>

2. **Optional:** You can add more widgets to the dashboard by clicking the **Add Content** icon ( ). In the upper right corner of the dashboard.

**Note:** You should not modify the first tab in this Dashboard. If you want a different dashboard experience, add a tab and customize that with your usage reports.
Password Reset

The ServiceNow® Password Reset enforces strong and secure passwords by enabling end users to reset or change their passwords either by self-service process or by taking the help of a service desk agent.

Features of Password Reset application

Manage enrollment

Automatically enrolls end users or allows manual enrollment.

Verification types

Validates user authenticity with the help various verifications.

Integrated plugins

Resets passwords on directly from Windows application and Microsoft Azure active directory (AD).

Enrollment types

Enables end users to enroll in different password reset programs as per their convenience.

Password Reset Quebec Release Notes

See changes and new features in this release

Get started

Select a tile to get started.

Exploring Password Reset

Get an overview of Password Reset so you can understand how to set it up and use it for your organization.
Self-service and Service Desk-assisted processes
In addition to configuring the connections, user groups, and verifications, you can specify one of the following operational methods for the organization:

Self-service process
End users reset passwords using a browser on any supported interface, including mobile devices. They can provide the identifying information and answer questions or submit a securely delivered code number. Here is the example for self-service process for password reset. The example of the default self-service password reset flow is as follows:

1. If a user does not remember the password, the user can click **Forgot Password?** on the login screen.

2. The Password Reset application starts. The user provides identification by entering a **Username** and clicks **Next**.

3. In the Verify tab, the user provides personal data associated with the username. In this example, the user enters the email address associated with the user profile. The admin can configure a different verification method. For example, a personal question that only the user can answer.
4. The **Reset** page tells the user to check email for instructions.

5. The user opens the email and clicks the **here** link to reset the password. The link is valid for a period of time that admin specifies by using the `password_reset.request.expiry` property.

6. The **Reset Password** page guides the user to reset the password.

**Service desk-assisted process**

An end user requests the assistance of a service desk agent, over the phone or in person. The agent processes the request. Each service desk agent has the Password Reset admin service desk role. The Reset request form that the agent works presents a **user** field and a **Process** field. On the form, the agent can view all processes in the end user’s domain.

**Next steps**

Do this next if you are a:
• Administrator—Configure password reset for your users
• End user—Start resetting your password

Related reference

Installed with Password Reset

Related information

Domain separation and the Password Reset application

Installed with Password Reset

Tables, roles, business rules, scripts, and workflows are installed with the Password Reset application.

Password Reset tables

<table>
<thead>
<tr>
<th>Table name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Reset Active Answer [pwd_active_answer]</td>
<td>Security questions and associated answers, in an encrypted state, that users selected while going through the enrollment process.</td>
</tr>
<tr>
<td>Password Reset Active Question [pwd_active_question]</td>
<td>Security questions that users selected while going through the enrollment process.</td>
</tr>
<tr>
<td>Password Reset Activity Monitor [pwd_activity_monitor]</td>
<td>Password Reset lockout activity.</td>
</tr>
<tr>
<td>Password Reset Credential Store [pwd_cred_store]</td>
<td>Password Reset credential stores that are available.</td>
</tr>
<tr>
<td>Password Reset Credential Store Parameters [pwd_cred_store_param]</td>
<td>User-created credential store parameters.</td>
</tr>
<tr>
<td>Password Reset Credential Store Types [pwd_cred_store_type]</td>
<td>Password Reset credential store types that are available.</td>
</tr>
<tr>
<td>Table name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Password Reset Desktop Access Control [pwd_access_control]</td>
<td>Password Reset Windows Application access control.</td>
</tr>
<tr>
<td>Password Reset Desktop Access Log [pwd_access_log]</td>
<td>Password Reset Windows Application access logs.</td>
</tr>
<tr>
<td>Password Reset Device Enrollment Code [pwd_dvc_enrollment_code]</td>
<td>Device enrollment codes that were sent to users during SMS code enrollment.</td>
</tr>
<tr>
<td>Password Reset Devices [pwd_device]</td>
<td>User SMS devices that are in a state of verified.</td>
</tr>
<tr>
<td>Password Reset Email Verification Code [pwd_email_code]</td>
<td>Verification codes that were sent to users via email for password reset or email address enrollment.</td>
</tr>
<tr>
<td>Password Reset Enrollment for Verification [pwd_enrollment]</td>
<td>Information about user enrollment by verification.</td>
</tr>
<tr>
<td>Password Reset Enrollment Snapshot [pwd_enrollment_snapshot]</td>
<td>Snapshot of user enrollment by verification. This table is regenerated daily by a scheduled job named Password Reset Enrollment Snapshot.</td>
</tr>
<tr>
<td>Password Reset Extension Type [pwd_extension_type]</td>
<td>Extension types that are available.</td>
</tr>
<tr>
<td>Password Reset History [pwd_history]</td>
<td>History of passwords that users reset.</td>
</tr>
<tr>
<td>Password Reset Identification Type [pwd_identification_type]</td>
<td>Password Reset identification types that are available.</td>
</tr>
<tr>
<td>Password Reset Process [pwd_process]</td>
<td>Password Reset processes that are available.</td>
</tr>
<tr>
<td>Password Reset Process Credential Store [pwd_process]</td>
<td>Credential stores and the associated Password Reset processes that the application is using.</td>
</tr>
<tr>
<td>Table name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>[pwd_map_proc_to_cred_store]</td>
<td>Groups and the associated Password Reset processes that the application is using.</td>
</tr>
<tr>
<td>Password Reset Process User Group [pwd_map_proc_to_group]</td>
<td>Verifications and the associated Password Reset processes that the application is using.</td>
</tr>
<tr>
<td>Password Reset Process Verification [pwd_map_proc_to_verification]</td>
<td>Questions that the application uses for security question verifications.</td>
</tr>
<tr>
<td>Password Reset Request [pwd_reset_request]</td>
<td>Information about Password Reset requests.</td>
</tr>
<tr>
<td>Password Reset Request Verification [pwd_map_request_to_verification]</td>
<td>Password reset requests and the associated verification that the application is using.</td>
</tr>
<tr>
<td>Password Reset SMS Verification Code [pwd_sms_code]</td>
<td>SMS verification codes that were sent to users for a password reset.</td>
</tr>
<tr>
<td>Password Reset User Lockout [pwd_user_lockout]</td>
<td>Users that are locked out of Password Reset.</td>
</tr>
<tr>
<td>Password Reset Verification [pwd_verification]</td>
<td>Verifications that are available.</td>
</tr>
<tr>
<td>Password Reset Verification Param [pwd_verification_param]</td>
<td>User-created verification parameters.</td>
</tr>
<tr>
<td>Password Reset Verification Type [pwd_verification_type]</td>
<td>Password Reset verification types that are available.</td>
</tr>
</tbody>
</table>

**Password Reset roles**

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>password reset administrator [password_reset_admin]</td>
<td>Configures and maintains Password Reset and Password Change.</td>
</tr>
</tbody>
</table>
### Role Description

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>service desk agent</td>
<td>Resets passwords on behalf of users, tracks password reset requests, and views logs.</td>
</tr>
<tr>
<td>[password_reset_service_desk]</td>
<td></td>
</tr>
<tr>
<td>credentials manager</td>
<td>Determines which credential stores are valid for use with Password Reset.</td>
</tr>
<tr>
<td>[password_reset_credential_manager]</td>
<td></td>
</tr>
</tbody>
</table>

### Password Reset business rules

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abort if password history limit exceeds</td>
<td>Password Reset Credential Store Parameters</td>
<td>Prevents setting password history limit that exceeds the value of the password_reset.history.limit property.</td>
</tr>
<tr>
<td></td>
<td>[pwd_cred_store_param]</td>
<td></td>
</tr>
<tr>
<td>Add default parameters QA verification</td>
<td>Password Reset Verification</td>
<td>If no parameters for Security Question verifications are specified, generates parameters.</td>
</tr>
<tr>
<td></td>
<td>[pwd_verification]</td>
<td></td>
</tr>
<tr>
<td>Add default parameters SMS verification</td>
<td>Password Reset Verification</td>
<td>If there are no parameters specified, generates SMS verification parameters.</td>
</tr>
<tr>
<td></td>
<td>[pwd_verification]</td>
<td></td>
</tr>
<tr>
<td>Add params personal confirm verification</td>
<td>Password Reset Verification</td>
<td>If there are no parameters specified, generates personal data confirmation verification parameters.</td>
</tr>
<tr>
<td></td>
<td>[pwd_verification]</td>
<td></td>
</tr>
<tr>
<td>Add params personal verification</td>
<td>Password Reset Verification</td>
<td>If there are no parameters specified, generates personal data verification parameters.</td>
</tr>
<tr>
<td></td>
<td>[pwd_verification]</td>
<td></td>
</tr>
<tr>
<td>Check unique verifications</td>
<td>Password Reset Process Verification</td>
<td>Prevents a verification from being assigned multiple times to a specific Password Reset process.</td>
</tr>
<tr>
<td></td>
<td>[pwd_map_proc_to_verification]</td>
<td></td>
</tr>
<tr>
<td>Clear parameters for Mock verification</td>
<td>Password Reset Verification</td>
<td>Clears parameters for the Mock verification.</td>
</tr>
<tr>
<td></td>
<td>[pwd_verification]</td>
<td></td>
</tr>
<tr>
<td>Deactivate process with no group</td>
<td>Password Reset Process User Group</td>
<td>Deactivates the process if it does not apply to all users or if the groups associated with it are removed.</td>
</tr>
<tr>
<td></td>
<td>[pwd_map_proc_to_group]</td>
<td></td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Deactivate process with no min ver</td>
<td>Password Reset Process Verification</td>
<td>Deactivates the process if the verifications associated with the process are less than the minimum value for the process.</td>
</tr>
<tr>
<td></td>
<td>[pwd_map_proc_to_verification]</td>
<td></td>
</tr>
<tr>
<td>Deactivate process with no verification</td>
<td>Password Reset Process Verification</td>
<td>Deactivates the process if the verifications associated with it are removed.</td>
</tr>
<tr>
<td></td>
<td>[pwd_map_proc_to_verification]</td>
<td></td>
</tr>
<tr>
<td>Delete history passwords if needed</td>
<td>Password Reset Credential Store [pwd_cred_store]</td>
<td>Deletes history passwords if needed.</td>
</tr>
<tr>
<td>Enforce password history message</td>
<td>Password Reset Credential Store [pwd_cred_store]</td>
<td>Passes enforce password related messages to the server.</td>
</tr>
<tr>
<td>Google Auth Enabled Check</td>
<td>Password Reset Process [pwd_process]</td>
<td>Deactivates the process with Google Authenticator verification if the Google Authenticator is disabled.</td>
</tr>
<tr>
<td>GoogleAuthSysPropertyCheck</td>
<td>Password Reset Process Verification [pwd_map_proc_to_verification]</td>
<td>Deactivates the process with the Google Authenticator verification if the Google Authenticator is disabled.</td>
</tr>
<tr>
<td>Handle req_enroll validation/defaut val</td>
<td>Password Reset Process Verification [pwd_map_proc_to_verification]</td>
<td>Handles requires_enrollment and auto_enroll values for the process.</td>
</tr>
<tr>
<td>Insert/update scheduled job for reminder</td>
<td>Password Reset Process [pwd_process]</td>
<td>Inserts/updates the scheduled job for enrollment reminder.</td>
</tr>
<tr>
<td>Order must be unique</td>
<td>Password Reset Desktop Access Control [pwd_access_control]</td>
<td>Enforces order to be unique.</td>
</tr>
<tr>
<td>Parameter Names Cannot Be Updated</td>
<td>Password Reset Verification Param [pwd_verification_param]</td>
<td>Prevents parameter name changes.</td>
</tr>
<tr>
<td>Password Reset Activity Monitor</td>
<td>Password Reset User Lockout [pwd_user_lockout]</td>
<td>Creates an event when number of users locked out of Password Reset Monitor exceeds the threshold.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Password Reset Validate</td>
<td>Password Reset Process</td>
<td>Checks that either Email password or Display password is selected when the Auto-generate check box is selected.</td>
</tr>
<tr>
<td>Auto-generate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Personal Data Confirm Param</td>
<td>Password Reset Verification Param</td>
<td>Checks that a column exists in the sys_user table for the parameter used in a personal data confirmation verification.</td>
</tr>
<tr>
<td>Validation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Personal Data Param Validation</td>
<td>Password Reset Verification Param</td>
<td>Checks that a column exists in the sys_user table for the parameter used in a personal data verification.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prevent against deletion</td>
<td>Password Reset Credential Store</td>
<td>Checks whether the credential store is part of an active process before allowing deletion.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prevent against deletion</td>
<td>Password Reset Identification Type</td>
<td>If an identification type is part of an active process, prevents the identification type from being deleted.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prevent against deletion</td>
<td>Password Reset Verification</td>
<td>If the verification is part of an active process, prevents it from being deleted.</td>
</tr>
<tr>
<td></td>
<td>[pwd_verification]</td>
<td></td>
</tr>
<tr>
<td>Prevent against deletion</td>
<td>Password Reset Credential Store</td>
<td>Prevents deletion when the type is in use.</td>
</tr>
<tr>
<td>when in use</td>
<td>[pwd_cred_store_type]</td>
<td></td>
</tr>
<tr>
<td>Prevent against deletion</td>
<td>Password Reset Verification Type</td>
<td>Prevents deletion when the type is in use.</td>
</tr>
<tr>
<td>when in use</td>
<td>[pwd_verification_type]</td>
<td></td>
</tr>
<tr>
<td>Queue event if history limit</td>
<td>Password Reset Credential Store Parameters</td>
<td>Queues the pwd.credStore.history.limit.decrease event if history limit decreases.</td>
</tr>
<tr>
<td>decreases</td>
<td>[pwd_cred_store_param]</td>
<td></td>
</tr>
<tr>
<td>Security Questions Param</td>
<td>Password Reset Verification Param</td>
<td>Checks for valid parameters in security question verifications.</td>
</tr>
<tr>
<td>Validation</td>
<td>[pwd_verification_param]</td>
<td></td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Send SMS code</td>
<td>Password Reset Device Enrollment Code</td>
<td>Sends an enrollment code to a device.</td>
</tr>
<tr>
<td></td>
<td>[pwd_dvc_enrollment_code]</td>
<td></td>
</tr>
<tr>
<td>Set new record flag</td>
<td>Password Reset Process [pwd_process]</td>
<td>Sets a new record flag for the client to take appropriate action.</td>
</tr>
<tr>
<td>Send SMS Verification Code Via Notify</td>
<td>Password Reset SMS Verification Code</td>
<td>Sends out SMS authentication code via Notify if the Notify plugin is active.</td>
</tr>
<tr>
<td></td>
<td>[pwd_sms_code]</td>
<td></td>
</tr>
<tr>
<td>Single credential store per process</td>
<td>Password Reset Process Credential Store</td>
<td>Prevents having more than one credential store per process.</td>
</tr>
<tr>
<td></td>
<td>[pwd_map_proc_to_cred_store]</td>
<td></td>
</tr>
<tr>
<td>SMS Code Param Validation</td>
<td>Password Reset Verification Param</td>
<td>Checks for valid parameters in SMS code verifications.</td>
</tr>
<tr>
<td></td>
<td>[pwd_verification_param]</td>
<td></td>
</tr>
<tr>
<td>Update action based on access conditions</td>
<td>Password Reset Desktop Access Log</td>
<td>Updates the “action” field of this log record based on the access conditions.</td>
</tr>
<tr>
<td></td>
<td>[pwd_access_log]</td>
<td></td>
</tr>
<tr>
<td>Update proc_to_cred_store</td>
<td>Password Reset Process [pwd_process]</td>
<td>Enforces a one-to-one relation between a Password Reset process and a credential store.</td>
</tr>
<tr>
<td>Validate Process</td>
<td>Password Reset Process [pwd_process]</td>
<td>Verifies that a Password Reset process is configured correctly.</td>
</tr>
<tr>
<td>Validate Pwd Cred Store Name</td>
<td>Password Reset Credential Store [pwd_cred_store]</td>
<td>Enforces the name to be unique.</td>
</tr>
<tr>
<td>Validate Pwd Cred Store Type Name</td>
<td>Password Reset Credential Store Types [pwd_cred_store_type]</td>
<td>Enforces the name to be unique.</td>
</tr>
<tr>
<td>Validate Pwd Extension Type Name</td>
<td>Password Reset Extension Type [pwd_extension_type]</td>
<td>Enforces the name to be unique.</td>
</tr>
<tr>
<td>Validate Pwd Identification Type Name</td>
<td>Password Reset Identification Type</td>
<td>Enforces the name to be unique and not empty.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Validate Pwd Process Name</td>
<td>Password Reset Process [pwd_process]</td>
<td>Enforces the name to be unique.</td>
</tr>
<tr>
<td>Validate Pwd Verification Name</td>
<td>Password Reset Verification [pwd_verification]</td>
<td>Enforces the name to be unique.</td>
</tr>
<tr>
<td>Validate Pwd Verification Type Name</td>
<td>Password Reset Verification Type [pwd_verification_type]</td>
<td>Enforces the name to be unique.</td>
</tr>
<tr>
<td>Validate Security Question</td>
<td>Password Reset Question [pwd_question]</td>
<td>Validates rules for security questions such as no duplicates or empty questions.</td>
</tr>
<tr>
<td>Verify Account Lookup Script</td>
<td>Password Reset Credential Store [pwd_cred_store]</td>
<td>Checks whether the account lookup script has the correctly named function.</td>
</tr>
<tr>
<td>VerifyAutoEnroll</td>
<td>Password Reset Verification Type [pwd_verification_type]</td>
<td>Checks whether auto-enroll is selected and ensures that an enrollment check script is provided.</td>
</tr>
</tbody>
</table>

**Password Reset UI pages**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$pwd_reset</td>
<td>First page of self-service reset process (asks for user ID).</td>
</tr>
<tr>
<td>$pwd_reset_serviceDesk</td>
<td>First page of service desk assisted reset process (asks for user ID).</td>
</tr>
<tr>
<td>$pwd_verify</td>
<td>Second page of reset process (asks user to verify identity).</td>
</tr>
<tr>
<td>$pwd_new</td>
<td>Last page of password change process (asks for new password).</td>
</tr>
<tr>
<td>$pwd_success</td>
<td>Page that appears when password is reset successfully.</td>
</tr>
<tr>
<td>$pwd_error</td>
<td>Page that appears on error during reset process.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>$pwd_confirm</td>
<td>For processes configured to email password reset URL: After successful verification, this page displays message about sending link to user.</td>
</tr>
<tr>
<td>$pwd_change</td>
<td>Page for changing password.</td>
</tr>
<tr>
<td>$pwd_change_success</td>
<td>Page that appears when password is changed successfully.</td>
</tr>
<tr>
<td>$pwd_change_error</td>
<td>Page that appears on error during password change process.</td>
</tr>
<tr>
<td>$pwd_enrollment_form_container</td>
<td>Enrollment page for all verifications.</td>
</tr>
<tr>
<td>$pwd_enrollment_success</td>
<td>Page that appears when enrollment is successful.</td>
</tr>
<tr>
<td>$pwd_enroll_error</td>
<td>Page that appears when any error happens during enrollment.</td>
</tr>
<tr>
<td>$pwd_unlock_success</td>
<td>Page that appears when locked user is successfully unlocked.</td>
</tr>
<tr>
<td>$pwd_reset_downloads_ui</td>
<td>Page for downloading Password Reset Windows Application.</td>
</tr>
</tbody>
</table>

**Password Reset UI macros**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$pwd_csrf_validation</td>
<td>CSRF validation for Password Reset Application. If violation is detected, the page will be redirected to the error page.</td>
</tr>
<tr>
<td>$pwd_display_password</td>
<td>Displays a temporary password on the success page if the process is configured to auto-generate.</td>
</tr>
<tr>
<td>$pwd_enroll_email_ui and $pwd_verify_email_ui</td>
<td>UI for email enrollment and verification.</td>
</tr>
<tr>
<td>$pwd_enroll_google_auth_ui and $pwd_verify_google_auth_ui</td>
<td>UI for Google Authentication enrollment and verification.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>$pwd_enroll_questions_ui</td>
<td>UI for question and answer security validation enrollment.</td>
</tr>
<tr>
<td>$pwd_enroll_questions_ui_js</td>
<td>JavaScript code that requires server-side data for security question and answer enrollment.</td>
</tr>
<tr>
<td>$pwd_enroll_sample_ui</td>
<td>Sample UI macro for enrollment for Mock Verification Type.</td>
</tr>
<tr>
<td>$pwd_enroll_sms_ui and $pwd_verify_sms_ui</td>
<td>UI for SMS enrollment and verification.</td>
</tr>
<tr>
<td>$pwd_enrollment_form_title</td>
<td>Jelly macro function that prints the title for the enrollment form. A verification ID is mandatory.</td>
</tr>
<tr>
<td>$pwd_error_message</td>
<td>UI for displaying error messages.</td>
</tr>
<tr>
<td>$pwd_process_flow</td>
<td>UI for indicating current stage.</td>
</tr>
<tr>
<td>$pwd_process_footer</td>
<td>JavaScript code to get the footer macro name.</td>
</tr>
<tr>
<td>$pwd_reset_stylesheet</td>
<td>JavaScript code to get the default CSS file ID.</td>
</tr>
<tr>
<td>$pwd_verify_personal_data_ui and $pwd_verify_personal_data_confirmation_ui</td>
<td>UI for verifying personal data and for confirming personal data.</td>
</tr>
<tr>
<td>$pwd_verify_questions_ui</td>
<td>UI for verifying questions.</td>
</tr>
<tr>
<td>$pwd_verify_simple_ui</td>
<td>Input section for a simple verification method. This field is a single input field.</td>
</tr>
</tbody>
</table>

### UI scripts installed with Password Reset

You can create a UI script and reference the script from a UI macro or UI page by using a `<g:include_script>` Jelly tag. The following example shows how the $pwd_enroll_questions_ui UI macro can reference the $pwd_enroll_questions_ui script. In the example, `[UI Script Name]+".jsdbx"` is the name of the script:

```xml
<g:include_script src="$pwd_enroll_questions_ui.jsdbx" />
```

By referencing an external script, you can maintain separation between client JavaScript code and Jelly code, which simplifies maintenance. You can use the following installed scripts with Password Reset UI macros:
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$pwd_csrf_common_ui_script</td>
<td>Common UI script for handling a Cross-site Request Forgery (CSRF).</td>
</tr>
<tr>
<td>$pwd_enroll_email_ui</td>
<td>JavaScript code for the $pwd_enroll_questions_ui UI macro.</td>
</tr>
<tr>
<td>$pwd_enroll_google_auth_ui</td>
<td>JavaScript code for the $pwd_enroll_google_auth_ui UI macro.</td>
</tr>
<tr>
<td>$pwd_enroll_questions_ui</td>
<td>JavaScript code for the $pwd_enroll_questions_ui UI macro.</td>
</tr>
<tr>
<td>$pwd_enroll_sample_ui</td>
<td>Included sample client JavaScript for the $pwd_enroll_sample_ui UI macro.</td>
</tr>
<tr>
<td>$pwd_enroll_sms_ui</td>
<td>SMS enrollment UI script.</td>
</tr>
<tr>
<td>$pwd_enrollment_submit_event</td>
<td>UI script for an enrollment submission event.</td>
</tr>
<tr>
<td>$pwd_util</td>
<td>Utilities for password reset UI pages and UI macros.</td>
</tr>
<tr>
<td>$pwdWfManager</td>
<td>Helper class to handle workflow activities and post-processing.</td>
</tr>
</tbody>
</table>

**Password Reset workflows**

The Password Reset plugin adds workflows that you can use as examples to create custom workflows for Password Reset processes.

**Workflows that connect to a credential stores**

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Reset - AD</td>
<td>Connects to an AD server.</td>
</tr>
<tr>
<td>Pwd Reset - Local ServiceNow</td>
<td>Current (local) instance.</td>
</tr>
<tr>
<td>Pwd Reset - Master</td>
<td>Password Reset master workflow.</td>
</tr>
<tr>
<td>Pwd Reset - Mock Fatal</td>
<td>Example workflow to use in Password Reset testing to simulate a fatal error. No retries.</td>
</tr>
<tr>
<td>Pwd Reset - Mock Non Fatal</td>
<td>Example workflow to use in Password Reset testing to simulate a non-fatal error.</td>
</tr>
</tbody>
</table>
### Workflows that connect to a credential stores (continued)

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Reset - Mock Success</td>
<td>Example workflow to use in Password Reset testing to simulate a successful completion.</td>
</tr>
<tr>
<td>Pwd Reset - Remote ServiceNow</td>
<td>Connects to a remote(SOAP) ServiceNow instance.</td>
</tr>
</tbody>
</table>

### Workflows that test the connection to a credential store

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Connection Test - AD</td>
<td>Tests connection to an AD server.</td>
</tr>
<tr>
<td>Pwd Connection Test - Local SN</td>
<td>Tests connection to local instance.</td>
</tr>
<tr>
<td>Pwd Connection Test - Master</td>
<td>Master workflow to test credential store connectivity.</td>
</tr>
<tr>
<td>Pwd Connection Test - Mock Failure</td>
<td>Example credential store connection test that simulates a failed connection.</td>
</tr>
<tr>
<td>Pwd Connection Test - Mock Success</td>
<td>Example credential store connection test that simulates a successful connection.</td>
</tr>
<tr>
<td>Pwd Connection Test - Remote SN</td>
<td>Tests connection to a remote(SOAP) ServiceNow instance.</td>
</tr>
</tbody>
</table>

### Workflows that determine the lock state of a user account

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Get Lock State - AD</td>
<td>Gets a user account lock state for the AD server.</td>
</tr>
<tr>
<td>Pwd Get Lock State - Local SN</td>
<td>Workflow to get a user account lock state for the local instance.</td>
</tr>
<tr>
<td>Pwd Get Lock State - Master</td>
<td>Master workflow to get a user account lock state.</td>
</tr>
<tr>
<td>Pwd Get Lock State - Remote SN</td>
<td>Gets a user account lock state for the remote(SOAP) ServiceNow instance.</td>
</tr>
</tbody>
</table>
### Workflows that unlock a user account

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Unlock Account – AD</td>
<td>Unlocks a user account for a local instance.</td>
</tr>
<tr>
<td>Pwd Unlock Account - Local SN</td>
<td>Workflow to unlock a user account for a local instance.</td>
</tr>
<tr>
<td>Pwd Unlock Account - Master</td>
<td>Master workflow to unlock a user account.</td>
</tr>
<tr>
<td>Pwd Unlock Account – Remote SN</td>
<td>Unlocks a user account for a remote (SOAP) ServiceNow instance.</td>
</tr>
</tbody>
</table>

### Workflows that change a password

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Change - Master</td>
<td>Password change master workflow.</td>
</tr>
<tr>
<td>Pwd Change – Local ServiceNow</td>
<td>Connects to a local instance to change a password.</td>
</tr>
<tr>
<td>Pwd Change – AD</td>
<td>Connects to an AD server to change a password.</td>
</tr>
<tr>
<td>Pwd Change – Remote ServiceNow</td>
<td>Connects to a remote (SOAP) ServiceNow instance to change a password.</td>
</tr>
</tbody>
</table>

### Password Reset notifications

<table>
<thead>
<tr>
<th>Name</th>
<th>Fired by event name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Reset – Send SMS Code</td>
<td>pwd.send_sms_code.trigger</td>
<td>Sends out SMS authentication code for verification.</td>
</tr>
<tr>
<td>[K] Password Reset – Send Email Code</td>
<td>pwd.send_email_code.trigger</td>
<td>Sends out authentication code via Email for verification.</td>
</tr>
<tr>
<td>Password Reset - Enrollment Reminder</td>
<td>pwd.enrollment_reminder.trigger</td>
<td>Sends emails to remind users to enroll in the required verifications.</td>
</tr>
<tr>
<td>Name</td>
<td>Fired by event name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Password Reset - New Password Confirmation</td>
<td>pwd.email.trigger</td>
<td>For the Email Password process, sends an email that includes the new password.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> If the Notify plugin is active, SMS code is sent via Twilio instead of ServiceNow Notification.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Password Reset - Send Verify Code</td>
<td>pwd.send_verify_code.trigger</td>
<td>Sends authentication code to users using email or SMS for password reset or enrollment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Check the following items if the instance does not send the email notification to the user:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Check the System Event [sys_event] table to see if the email was sent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Verify that the user is subscribed to the notification.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Verify that the Default Self Service password reset process and password reset properties are configured correctly.</td>
</tr>
<tr>
<td></td>
<td>password.reset.url</td>
<td>For the Email Password Reset URL process: Sends email that includes a link to the password reset URL.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
SOAP messages for Password Reset

<table>
<thead>
<tr>
<th>SOAP Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Password</td>
<td>When the Orchestration Add-on plugin is active, the system can use the SOAP protocol to change passwords on remote credential stores such as a remote ServiceNow instance.</td>
</tr>
<tr>
<td>Password Reset Request</td>
<td>When the Orchestration Add-on plugin is active, the system can use the SOAP protocol to reset passwords on remote credential stores such as a remote ServiceNow instance.</td>
</tr>
</tbody>
</table>

REST API

Name: Pwd Reset

API ID: pwd_reset

Base API path: /api/now/pwd_reset

Resources (Version v1)

<table>
<thead>
<tr>
<th>Name</th>
<th>Resource path</th>
<th>API Version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pwd_init</td>
<td>/api/now/v1/pwd_reset/init</td>
<td>v1</td>
<td>Initial request to establish session, write logs, and fetch UI messages.</td>
</tr>
<tr>
<td>pwd_identify</td>
<td>/api/now/v1/pwd_reset/identify</td>
<td>v1</td>
<td>Get identification page components.</td>
</tr>
<tr>
<td>pwd_verify</td>
<td>/api/now/v1/pwd_reset/verify</td>
<td>v1</td>
<td>Get verification page components.</td>
</tr>
<tr>
<td>pwd_new</td>
<td>/api/now/v1/pwd_reset/reset</td>
<td>v1</td>
<td>Get resetting password page components.</td>
</tr>
<tr>
<td>pwd_success</td>
<td>/api/now/v1/pwd_reset/success</td>
<td>v1</td>
<td>Get success page components.</td>
</tr>
<tr>
<td>pwd_failure</td>
<td>/api/now/v1/pwd_reset/failure</td>
<td>v1</td>
<td>Get failure page components.</td>
</tr>
</tbody>
</table>
Resources (Version v2)

<table>
<thead>
<tr>
<th>Name</th>
<th>Resource path</th>
<th>API Version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pwd_init</td>
<td>/api/now/v2/pwd_reset/init</td>
<td>v2</td>
<td>Initial request to establish session, write logs, and fetch UI messages.</td>
</tr>
<tr>
<td>pwd_identify</td>
<td>/api/now/v2/pwd_reset/identify</td>
<td>v2</td>
<td>Get identification page components.</td>
</tr>
<tr>
<td>pwd_verify</td>
<td>/api/now/v2/pwd_reset/verify</td>
<td>v2</td>
<td>Get verification page components.</td>
</tr>
<tr>
<td>pwd_new</td>
<td>/api/now/v2/pwd_reset/reset</td>
<td>v2</td>
<td>Get reset password page components.</td>
</tr>
<tr>
<td>pwd_success</td>
<td>/api/now/v2/pwd_reset/success</td>
<td>v2</td>
<td>Get success page components.</td>
</tr>
<tr>
<td>pwd_failure</td>
<td>/api/now/v2/pwd_reset/failure</td>
<td>v2</td>
<td>Get failure page components.</td>
</tr>
</tbody>
</table>

Domain separation and the Password Reset application

Domain separation is supported in the Password Reset application. A password reset process that you define in any domain is isolated from a process that you create in any other domain. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Standard

- Includes Basic level support.
- Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.
For more information on support levels, see Application support for domain separation.

**How domain separation works in Password Reset**

Domain separation for Password Reset is applied at the process level. The admin configures the following elements to define a password reset process: A connection to a credential store, user groups that can use the process, method of identification, and verifications to use during the process.

- A connection to the credential store where user credentials (like username/password) are securely stored. Each connection inherits the domain setting from a template called a connection type. Each connection type is tied to a domain (the connection type record has a domain field). There are uniqueness constraints on connection names within a domain.

- One or more user groups on the ServiceNow instance that can use the password reset process. User accounts are members of one or more domains — they use the standard ServiceNow domain separation. When a user enrolls to use one of the password reset processes that is configured for the organization, the user is allowed to choose only from the processes in the user’s domain.

- The identification — the method that the end user employs to claim identity for the public password reset or password change process. Each identification inherits the domain setting from a template called an identification type. Each identification type is tied to a domain (the identification type record has a domain field). There are uniqueness constraints on identification names within a domain.

- One or more verifications — methods to verify the identity of the person who is attempting to reset the password. Each verification inherits the domain setting from a template called a verification type. Each verification type is tied to a domain (the verification type record has a domain field). There are uniqueness constraints on verification names within a domain.

- All Password Reset tables have a domain column.

- Password Reset process tables include a `sys-overrides` column on business rules, UI actions, and so on.

- The Password Reset application is built using Orchestration. Orchestration supports "Data only" domain separation — the data security model of separating visibility of data from one domain to another.

**Password Change process**

The Password Change application extends the Password Reset application by letting admins define how users change their passwords. A service desk-assisted
process is not supported. An admin must publish the URL for the self-service password change form.

The Password Change application enables an end user to change a password over the Internet using a browser on any supported interface, including mobile devices. The end user can select from any configured process in the end user’s domain (or child domain of an end user’s domain).

A password change process uses the same elements as a password reset process (connections, user groups, identifications, and verifications), with the same domain-separation features.

**Related information**

- Domain separation for service providers

**Setting up Password Reset process**

The Password Reset application is active by default and includes example verifications. The base system enables connections only to the local ServiceNow instance credential store types.

**Requirements**

Role required: admin

**Note:** The Password Reset application is not available during an upgrade.

**Active and available plugins**

- To enable connections to Active Directory (AD) and Remote (SOAP) ServiceNow Instance credential store types, activate the Password Reset - Orchestration Add-on plugin. The plugin also activates the Password Reset Windows Application (com.glideapp.password_reset_desktop). No other components are installed. Orchestration is available as a separate subscription. See [Request the Password Reset - Orchestration Add-on plugin](#).

- To enable connections to Microsoft Azure AD spoke for Password Reset, Integrate Microsoft Azure AD spoke with Password Reset and Configure the connection to Microsoft Azure AD credential store.

**Next steps**

Plan and configure the Password Reset processes for your organization. See the Password Reset admin guide.
Setup guide for Microsoft Azure AD for Password Reset

Set up Microsoft Azure AD for Password Reset by activating the plugin and configuring the Microsoft Azure AD instance. The Microsoft Azure AD plugin is activated with the help of this plugin. Microsoft Azure AD for Password Reset is also available in the ServiceNow store.

Related information

Request the Microsoft Azure AD for Password Reset plugin

Microsoft Azure AD users can reset passwords with the Microsoft Azure AD for Password Reset plugin.

Before you begin

Role required: admin

About this task

You can request the plugin from Now Support (HI) or from your instance.

From Now Support:

• In Now Support, navigate to Service Catalog Activate Plugin.
  Or:

Procedure

1. In your instance, navigate to System Applications > All Available Applications > All.

2. On the All Applications page, select Request Plugin to open the request form on Now Support.
3. On Now Support, select to be redirected to the HI Service Portal Service Catalog.

4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current date.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for ServiceNow personnel who will</td>
</tr>
</tbody>
</table>

**Note:** By default, plugins are activated in two batches each business day: once in the morning and once in the evening, Pacific (U.S.) time. If you need your plugin activated at a specific time, enter a request for this in the Reason/Comments field.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>activate the plugin. For example, if you need the plugin activated on a specific day or time instead of during one of the default activation windows, specify it in the comments.</td>
</tr>
</tbody>
</table>

5. Click **Submit**. The Microsoft Azure AD for Password Reset plugin is activated.

**What to do next**

Plan, create, and customize the Password Reset process for your organization.

**Setup guide for Microsoft Active Directory for Password Reset**

Enable connections to Active Directory (AD) and Remote (SOAP) ServiceNow Instance credential store types by activating the Password Reset - Orchestration add-on plugin. Microsoft AD for Password Reset is also available in the ServiceNow store.

**Related information**

- Request the Password Reset - Orchestration Add-on plugin
- Password Reset Windows Application

**Request the Password Reset - Orchestration Add-on plugin**

The Password Reset - Orchestration Add-on plugin activates the Password Reset Windows Application (com.glideapp.password_reset_desktop) and enables connections to the Active Directory (AD) and 'Remote (SOAP) ServiceNow instance' credential store types. No other components are installed.

**Before you begin**

Role required: admin

**About this task**

There are two ways to request a plugin:

- Access the Now Support Service Catalog directly by clicking **Service Catalog > Activate Plugin** on Now Support.
- Access the Now Support Service Catalog through the All Applications page on your instance by following these steps.
Procedure

1. Navigate to **System Applications > All Available Applications > All**.
2. On the All Applications page, click **Request Plugin** to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.
4. On the form, fill in the fields.

### Activate Plugin request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Note:</td>
<td>Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Password Reset Windows Application

The Password Reset Windows Application enables a user, who forgets the password or is locked out of a Windows computer, to reset the password directly from the Windows login screen.

How the Password Reset Windows Application works

Download the Password Windows Reset application from the ServiceNow Store and run an EXE or MSI file to install or distribute the application to user computers. The application installs a link on the Windows login screen. The user clicks the link (Forgot Password? as depicted in the examples on various Windows versions) and is then guided through the process of resetting the password.
By default, when a user requests a reset, the instance sends the user a URL with a user-specific token. After the user opens the URL, the instance prompts the user to enter and confirm the new password. The instance does not send a temporary password.
Restrictions on the Password Reset Windows Application

- The Password Reset Windows Application does not support custom verifications.

- The Password Reset Windows Application uses the base-system CAPTCHA service even if the Password Reset application is configured to use Google reCAPTCHA with the web interface. See the section titled "Settings on the Details tab" in Configure your Password Reset process.

- The Password strength indicator is not supported. See Configure the connection to a credential store for the Password Reset processes.

- For some verification types, you can use only one verification. Custom verifications are not supported. See Password Reset verifications for details.

- Custom UI macros configured on the Process > Advanced page are not supported (for example, entry, success, or failure macros). The system displays only the default success and failure messages.

- The Password Reset Windows Application supports newline characters in the Password rule hint text. Other formatting is not supported (bold, underline, hyperlink, and so on). See Configure the connection to a credential store for the Password Reset processes.

Password Reset Windows Application installation requirements

Activate the Password Reset Orchestration Add-on plugin to use the Password Reset Windows Application. You must activate the Password Reset Orchestration Add-on plugin to use the Password Reset Windows Application.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required ServiceNow release</td>
<td>Password Reset Windows Application version 4.1 is supported on Kingston, London, Madrid, New York, Orlando, and newer releases. Jakarta and earlier releases are not supported.</td>
</tr>
<tr>
<td>Required hardware</td>
<td>• 1 GHz or faster processor</td>
</tr>
<tr>
<td></td>
<td>• 512 MB of RAM</td>
</tr>
<tr>
<td></td>
<td>• 10 MB of available hard disk space (x86)</td>
</tr>
<tr>
<td></td>
<td>• 10 MB of available hard disk space (x64)</td>
</tr>
</tbody>
</table>
## Password Reset Admin Guide

The Password Reset application enables an end user to reset or change a password using a self-service process. Alternatively, your organization can implement a process that requires a service desk agent to reset passwords for end users.

Watch the video: Introducing Password Reset (video)
Password Reset processes
Users with the password_reset_admin role configure how the process of resetting a password works for an end user.

- **Self-service process:** Users reset passwords over the internet using a browser on any supported interface, including mobile devices.
- **Service desk-assisted process:** A user requests the assistance of a service desk agent, over the phone or in person. Users do not reset passwords.

End-user experience of the self-service process
The following example is typical:

1. On the login page, the user clicks the **Forgot Password?** link to start the process.

   ![Login page example](image)

   - **User name**
     - able.tuter
   - **Password**
   - **Remember me**
   - **Forgot Password?**
   - **Login**

2. The Identify page opens and the user enters their identifying information (typically user name or email address). The example includes the default Google reCAPTCHA security feature:
3. On the Verify page, the user verifies their identity by providing information that proves that they are who they say they are. You, the admin, configure the method of verification and you can require multiple verifications. In the example, the admin has configured the Security Question verification. The user must answer a question to prove identity. (Earlier, the user selected the question and provided a secure private answer while enrolling in the password reset process.) Other possible verifications require the user to enter a code number that was sent to a mobile device by SMS text, through the Google Authenticator app, or by email.
4. The system checks the credential store to verify identity and then displays the new password on the Reset page.

Elements of a password reset process

You configure the following elements of the process for your organization:

• A connection to the credential store for your organization where user credentials (like username/password) are securely stored.

• One or more user groups on the ServiceNow instance that can use the password reset process.

• The type of identification that users must enter to identify themselves (typically user name or email address).

• One or more verifications — methods to verify the identity of the user. Examples:
  ◦ QA Verification: Answer a question that only the user knows (based on the Security Question verification type).
  ◦ Email verification: Enter a code number that was emailed to the user.
° **SMS verification**: Enter a code number that was texted to a mobile device.

° **Google Authenticator verification**: Enter a code number that appears on the Google Authenticator app on a mobile device.

**How to implement a password reset process**

1. Plan your implementation: Consider all applicable organizational guidelines, security policies, and areas of the organization.

2. Set up the elements of the password reset and password change processes according to the plan:
   
   • Connection to the credential store.
   
   • User groups that use the password reset process.
   
   • Identification type to use.
   
   • Verifications to use.

3. In the service desk-assisted model, assign service desk agents to monitor and reset passwords as needed.

4. Monitor password reset activity to identify security threats and to ensure compliance with the password policy requirements of your organization.

**Password Reset Windows Application**

If a user forgets the password or gets locked out of a Windows computer, the user can reset the password directly from the Windows login screen. The user clicks the **Forgot Password?** link and is then guided through the process of resetting the password. To learn more, see [Password Reset Windows Application](#).

**Password Change application**

The Password Change application extends the Password Reset application by letting admins define how users change their passwords. Only a self-service process is supported and an admin must publish the URL to the password change form.

1. The user logs in to the instance and then selects the **Change Password** module or link from the user profile record. Password change is supported on mobile devices.

2. On the **Change Password** page, the user selects the credential store where the password resides.

3. The user enters the old password and then enters and confirms a new password.
4. Workflows validate the old password and then implement the new password.

5. The system notifies the user that the password was changed.

**What to do next**

*Plan your Password Reset processes*

**Plan your Password Reset processes**

To ensure security and efficiency, take the time to plan your Password Reset implementation.

**Before you begin**

Role required: password_reset_admin or admin

**Procedure**

1. Decide on the password reset process:
   
   - **Self-service process:** Users reset their password over the Internet using a browser on any supported interface, including mobile devices. To make the Password Reset application with Orchestration available to all users publicly, create a new Password Reset process only for this purpose and make it accessible to all users by setting the Public access property. See .
   
   - **Service desk-assisted process:** Users reset passwords by requesting the assistance of a service desk agent, over the phone or in person. Only service desk agents with the password_reset_service_desk role can reset user passwords. Watch the videos: *Resetting User Passwords (Video)* and *How to Set Up a Service Desk-Assisted Password Reset Process (Video)*.

2. Decide how groups and roles differ in access and security needs.

   Analyze and assess how members of each group in your organization access the system. For example, if members of the sales group primarily access the system remotely, consider using a stronger method or multiple methods to verify the identity of each user.

   Identify user roles that have access to critical information and resources. For example, stronger verifications might be required for roles that have access to employee data, accounting information, or network configurations.

   Based on your analysis of groups and roles, determine the number and variety of verifications needed for the different Password Reset processes.

3. Decide how to manage credentials.

   Determine whether single sign-on is enabled with the type of directory service or other credential store used. If the directory service is configured for single sign-on, consider increasing the level of security by using multiple methods to
verify identity of a user. A compromised user name and password can easily allow access to associated systems in a single sign-on environment.

4. Decide how to implement enrollment in the Password Reset program. For example, will enrollment be optional or required? Will users be auto-enrolled? How will users be notified to enroll in the program? The answers to these questions will help you determine the appropriate verification types to use.

5. Decide which Password Reset options to offer to users.
   - If your organization uses single sign-on, how will users reset their password if they are unable to log on?
   - What options are available to users working off-site?

Related information

Configure your Password Reset process

Configure your Password Reset process

To implement the process, you configure credentials, verification methods and settings, and enrollment settings. You also specify which users the process applies to.

Before you begin
Role required: password_reset_admin or admin

1. Be sure to Plan your Password Reset processes.

2. Create the credential store record for usernames and passwords that are managed.

Note: For LDAP integrations: If the Active Directory settings require users to reset the password when logging in, the results depend on the Password Reset plugin that is installed.

   - The Password Reset plugin cannot change an AD password. End users will not be able to log in to the instance.
   - The Self Service Password Reset plugin depends on the Password Reset Basic plugin. Self service is intended for password reset only on the local ServiceNow instance and cannot change an AD password.
   - The Password Reset Orchestration Add-on plugin is built on top of Orchestration AD activities. The plugin supports changing the AD password.
3. Define the verifications that the process will use.

4. Configure Password Reset to auto-enroll users or to enable users to enroll for the program. See Configure your Password Reset process to auto-enroll users and Enable users to enroll for Password Reset.

**About this task**
A Password Reset process consists of the following elements:

- The credential store that contains user login credentials.
- Optionally, the user groups that are authorized to use the Password Reset process.
- The verifications that verify the identity of the requesting user and that enable the service desk agents to authorize reset of the password. (Verifications are implemented by script includes.)

**Procedure**

1. Navigate to **Password Reset** > **Processes**.
2. Click **New** and then specify a meaningful **Name** and **Description** for the process.
3. Select the **Credential store** that contains the user credentials that the process applies to.
4. Specify the process that you are defining: Select the **Password Reset** check box, the **Password change** check box or both check boxes.
5. Specify the **Apply to all users** setting.

<table>
<thead>
<tr>
<th>Setting of the Apply to all users check box</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected</td>
<td>All users use the process that you are defining. This setting is useful only if all users have access to the authentication methods that are defined in this process.</td>
</tr>
<tr>
<td>Not selected</td>
<td>Only the users in the groups that you specify use the process. You specify the groups in the <strong>Groups</strong> related list.</td>
</tr>
</tbody>
</table>

6. For **Password Reset**, configure settings on the **Password Reset Details** tab.
## Settings on the Details tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Public access</strong></td>
<td>The check box is available only when <strong>Password reset</strong> is selected.</td>
</tr>
<tr>
<td></td>
<td>• Select the check box to enable a self-service process with public user access to the Password Reset or Password Change form through a URL.</td>
</tr>
<tr>
<td></td>
<td>• Clear the check box to define a Service desk-assisted process in which only service desk agents can reset a password at the request of a user.</td>
</tr>
<tr>
<td><strong>Public URL</strong></td>
<td>The field is available only when <strong>Public access</strong> is selected.</td>
</tr>
<tr>
<td></td>
<td>URL of the page where users go to reset or change the password. The value from the URL suffix field is appended to the URL when you tab out of the URL suffix field. For the Default self-service Password Reset process, this value must be /$pwd_reset.do?sysparm_url=ss_default.</td>
</tr>
<tr>
<td><strong>URL suffix</strong></td>
<td>The field is available only when <strong>Public access</strong> is selected.</td>
</tr>
<tr>
<td></td>
<td>Suffix used to create a unique URL for the Password Reset or Password Change form.</td>
</tr>
<tr>
<td><strong>Display CAPTCHA</strong></td>
<td>The check box is available only when <strong>Public access</strong> is selected.</td>
</tr>
<tr>
<td></td>
<td>Select the check box to display a CAPTCHA on the user identification page.</td>
</tr>
<tr>
<td></td>
<td>The Password Reset application uses Google reCAPTCHA as the default CAPTCHA service. See <strong>Configure Google reCAPTCHA for the password reset process</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Password Reset Windows Application uses the base-system CAPTCHA service even if the Password Reset application is configured to use Google reCAPTCHA.</td>
</tr>
<tr>
<td></td>
<td>Because on-premises instances do not have access to the Internet, the instances cannot use the Google reCAPTCHA service. Set the password_reset.captcha.google.enabled system property to <strong>false</strong> for on-premises instances.</td>
</tr>
</tbody>
</table>
To use the base system CAPTCHA, change the `password_reset.captcha.google.enabled` system property to `false`.

**Identification type**
Method that the user employs to claim identity for the public Password Reset or Password Change process. Any selection overrides the default identification that is associated with the process.

The base system includes the Email and Username Identification identification types. You can create a custom identification type (some knowledge of JavaScript is recommended).

See [Personal data identification types and confirmation type verifications](#).

**Redirect URL**
URL to go to after a successfully resetting a password — typically, the URL of the original login page.

Enter a complete path, including the protocol (for example, `https://myDomain.myURL.com`). If the path is under the same domain as the **Public URL**, then start the path with the `/` character.

![Note:](notes.png) If the **Auto-generate password** check box is selected, then the instance displays the new password. The user must click **Done** to go to the URL.

**Minimum verifications**
Number of verifications that a user must successfully submit to reset the password.

If the number exceeds the number of mandatory verifications, then the user must submit enough additional optional verifications to meet the number specified for **Minimum verifications**.

![Note:](notes.png) Each user must submit all mandatory verifications regardless of the number specified.

By default, during the password reset process, the system presents optional verifications to the user based on the **Order** values for the verifications. If you selected **Allow user to choose from optional verifications**, then the Verification page presents all optional verifications to the user. The user then selects the appropriate number of verifications. In this...
example, the **Minimum verifications** value is 1. Because no mandatory verifications are configured, the user can choose an optional verification.

Also, see **Allow user to choose from optional verifications**.

| Allow user to choose from optional verifications | Select the check box to enable a user, on the Verifications page during the process of resetting the password, to select which optional verifications to use. The choice of optional verifications appears only if the **Minimum verifications** setting is greater than the number of mandatory verifications.

The number that you specify for **Minimum verifications** determines how many optional verifications that the user is allowed to select.

In the example, the **Minimum verifications** setting is 2 and there are no mandatory verifications. The user has selected two optional verifications, so cannot select a third verification. |

| Email Password Reset URL | Select the check box to enable users to reset the password by clicking a link in an email that the instance sends to them. By default, the self-service Password Reset processes enable this option.

When you select this option, the **Auto-generate password** check box is not available.

**Note:** See [for an outline of the process that is enabled by default.](#) |
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable account unlock</td>
<td>This check box is available only when <strong>Password reset</strong> is selected. Select the check box to allow user accounts on credential stores to be unlocked without resetting the password.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Not supported by the default self-service Password Reset process.</td>
</tr>
<tr>
<td>Unlock user account</td>
<td>Select the check box to unlock user accounts on credential stores after a password reset.</td>
</tr>
<tr>
<td>Auto-generate password</td>
<td>Select the check box to auto-generate a new password for the user. When this check box is selected, you must select the <strong>Email password</strong> or <strong>Display password</strong> check box, or both. This setting is useful for service desk-assisted processes. This check box is available only when:</td>
</tr>
<tr>
<td></td>
<td>• The <strong>Password reset</strong> check box is selected.</td>
</tr>
<tr>
<td></td>
<td>• The <strong>Email Password Reset URL</strong> check box is cleared.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you use the credential store on your local ServiceNow instance or an Active Directory credential store: Clear the check box to enable the <strong>Enforce history policy</strong> option for a credential store. See <em>Configure the connection to a credential store for the Password Reset processes.</em></td>
</tr>
<tr>
<td>User must reset password</td>
<td>This check box is available only when <strong>Auto-generate password</strong> is selected. Select the check box to require users to reset their password immediately after logging in with the auto-generated password.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Users whose credentials are held in the local ServiceNow instance credential store are prompted to change their password the first time that they log in. Users whose credentials are held in an Active Directory credential store are not prompted to change their passwords in the instance. Such users must change their passwords from a computer on the domain.</td>
</tr>
<tr>
<td>Display password</td>
<td>This check box is available only when <strong>Auto-generate password</strong> is selected.</td>
</tr>
</tbody>
</table>
7. For **Password Reset**, configure settings of interest on the **Advanced** tab.

### Advanced tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry UI macro</td>
<td>UI macro that displays a customized message to users when they access the initial Password Reset screen.</td>
</tr>
<tr>
<td>Success UI macro</td>
<td>UI macro that displays a customized message to users on the final Password Reset screen when their password is successfully reset.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Failure UI macro</td>
<td>UI macro that displays a customized message to users on the final Password Reset screen when their password reset fails.</td>
</tr>
<tr>
<td>Post reset script</td>
<td>Script include that performs actions after the Password Reset process completes whether the outcome is success or failure. For more information on customizing post processor scripts, see the Post reset script category as described in Password Reset extension script categories.</td>
</tr>
<tr>
<td>Header UI macro /</td>
<td>Macros that add a header or footer to customize the appearance of the pages that end users work in while resetting a password (the Identify, Verify, and Reset pages. See Add a custom header or footer to the user pages for Password Reset.</td>
</tr>
<tr>
<td>Footer UI macro</td>
<td></td>
</tr>
</tbody>
</table>

8. For **Password Reset**, fill in any fields of interest on the **Enrollment Reminder** tab.


10. From the **Password Reset Process Verifications** related list, select one or more verifications. See **Password Reset verifications**.

11. Optional: From the **Password Reset Process Groups** related list, select the user groups that will use the process that you are defining. The **Password Reset Process Groups** related list appears only if the **Apply to all users** check box is not selected.

12. Save the record and then select the **Active** check box to enable the Password Reset process that you configured. The check box is available only after the record has been saved.

13. Click **Update**.

14. Navigate to **Password Reset > Properties** to set the properties that configure the Password Reset experience for end users.
Related information

Plan your Password Reset processes
Configure the required strength for passwords

Credential stores for Password Reset

Credential stores hold user information such as user names and passwords that can be used as login credentials. Examples include the User table [sys_user] or an Active Directory server.

Users with the password_reset_admin or password_reset_credential_manager role can create and modify connections to credential stores.

Credential store types installed with the base system

A credential store type is a set of workflows that specify how to connect to a credential store. Navigate to Password Reset > Credential Stores to view the list of example credential stores that are based on the base-system types. The base system includes the following credential store types:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local ServiceNow Instance</td>
<td>Represents the current (local) ServiceNow instance.</td>
</tr>
<tr>
<td>AD Credential Store</td>
<td>Represents an Active Directory credential store. Installed with the Password Reset - Orchestration Add-on plugin.</td>
</tr>
</tbody>
</table>

Connection workflows for credential store types

A credential store type workflow requires a subflow that defines how to connect to the store, and can include an optional subflow that defines how to test the connection. Use the Pwd reset – AD and Pwd Reset - Local subflows as models for your custom connection workflows.
**Creating a custom credential store type**

You can use a credential store type as a model to create a custom type. See [Create a credential store type for Password Reset](#).

**Related information**

- Request the Password Reset - Orchestration Add-on plugin
- Create a credential store type for Password Reset

**Configure the connection to a credential store for the Password Reset processes**

You create a Password Reset credential store record to configure access to your credential store server while a user is changing or resetting a password. In addition to host connection information, you can specify the password hints that
users should see, restrictions on password reuse, the allowed number of failed reset attempts, and other settings.

**About this task**
For an AD credential store, skip this procedure and instead follow the instructions in Integrate Password Reset with your Active Directory service. The Password Reset Windows Application supports only AD credential stores.

**Procedure**

1. Navigate to **Password Reset > Credential Stores**.
2. Select one of the following sample credential stores:
   - **Local ServiceNow Instance** credential store.
   - **Remote (SOAP) ServiceNow** credential store (installed with the Orchestration Add-on).
3. Enter a unique and meaningful **Name** and **Description**, and then fill in the form.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of credential store that you are connecting to. A ServiceNow credential store type is a template that provides the required set of capabilities for a particular kind of credential store. Credential stores inherit the functionality of the credential store type.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** For an AD credential store, skip this procedure and see Integrate Password Reset with your Active Directory service. The Password Reset Windows Application supports only AD credential stores.

<table>
<thead>
<tr>
<th>Auto-generate password</th>
<th>Script include that generates a temporary password for use during the reset process.</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you select the <strong>Enforce history policy</strong> check box, then you must specify a value for <strong>Auto-generate password</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enforce history policy</th>
<th>Appears only if you select a credential store <strong>Type</strong> of <strong>AD Credential Store</strong> or <strong>Local ServiceNow Instance</strong>. For information on configuring the setting for an AD credential store, see Configure the connection to an AD credential store.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the <strong>Enforce history policy</strong> check box to ensure that users do not reuse passwords. For example, you might configure the history policy to not allow the user to reuse any of the previous 10 passwords. Follow this procedure:</td>
<td></td>
</tr>
</tbody>
</table>
**a.** Select the **Enforce history policy** check box.

**b.** In the Password Reset Credential Store Parameters related list, create a `password_history_limit` parameter.

**c.** Set the value of the parameter to the number of previous passwords that cannot be used (maximum 10). The default value of 0 (zero) enables use of any previous password.

<table>
<thead>
<tr>
<th>Hostname</th>
<th>URL or IP address of the credential store.</th>
</tr>
</thead>
<tbody>
<tr>
<td>User account lookup</td>
<td>Script include that maps the user ServiceNow platform ID to the user credential store ID. A default script, <code>PwdDefaultUserAccountLookup</code>, returns the user ServiceNow platform user name.</td>
</tr>
<tr>
<td>Password rule hint</td>
<td>Specify the text that appears on the password reset page to help the user to create a password that meets all requirements. The <strong>Password rule script</strong> enforces the requirements.</td>
</tr>
<tr>
<td><strong>Note:</strong> The Password Reset Windows Application supports newline characters in the hint. Other formatting is not supported (bold, underline, hyperlink, and so on).</td>
<td></td>
</tr>
<tr>
<td>Password rule</td>
<td>Specify the client script that validates the new password that the user enters. The script is invoked when the user enters a new password and clicks <strong>Password Reset</strong>. You can use the script to enforce password strength/complexity requirements.</td>
</tr>
<tr>
<td>Enable Password Strength</td>
<td>Select the check box to:</td>
</tr>
<tr>
<td></td>
<td>• Display the text box for the <strong>Strength rule script</strong> so you can update the script.</td>
</tr>
<tr>
<td></td>
<td>• Display the graphical <strong>Password Strength</strong> bar to the user while the user changes or resets the password.</td>
</tr>
<tr>
<td><strong>Note:</strong> The Password Reset Windows Application does not support Password Strength.</td>
<td></td>
</tr>
<tr>
<td>Strength rule</td>
<td>This text box appears only if you select <strong>Enable Password Strength</strong>. Specify the client script that calculates the strength/complexity of the password that the user enters. The script is invoked when the user begins to enter a new password during the reset process.</td>
</tr>
<tr>
<td>Default settings:</td>
<td></td>
</tr>
<tr>
<td>• Selected for local ServiceNow credential stores</td>
<td></td>
</tr>
<tr>
<td>• Not selected for other credential stores</td>
<td></td>
</tr>
</tbody>
</table>
Note:
To guide the user during the reset process, the system displays a graphical bar labeled **Password Strength** under the **New password** field.

Note: The Password Reset Windows Application does not support Password Strength.

4. Click **Submit**.

5. If you use the Local ServiceNow Instance credential store and you selected the **Enforce history policy** check box, then follow these steps:
   a. Open the Password Reset process that is associated with the credential store: **Password Reset > Processes**.
   b. On the **Password Reset Details** tab of the Password Reset Process form, clear the **Auto-generate password** check box and then save the process definition.

6. Test the connection to the credential store.

Related information

- Configure the required strength for passwords

**Credentials Store for Password Reset for Active Directory**

A credential store type is a set of workflows that specify how to connect to a credential store. Navigate to **Password Reset > Credential Stores** to view the list of example credential stores that are based on the base-system types.

Related information

- Integrate Password Reset with your Active Directory service
- Configure the connection to an AD credential store

**Integrate Password Reset with your Active Directory service**

When the Password Reset - Orchestration Add-on plugin is activated, the Password Reset application can change passwords on an Active Directory credential store. The application changes passwords by referencing an Active Directory user role with the appropriate password change privileges.
Before you begin
Role required: admin
Active Directory must have a user role with the following privileges:

Descendent User objects:
• Reset password
• Read/Write pwdlastset
• Read/Write UserAccountcontrol
• Write Account Restrictions
• Read/Write lockouttime
• Read MemberOf

Descendent Group objects:
• Read Members
• Read MemberOf

Procedure
1. Install a MID Server on a Windows computer that can connect to Active Directory.
2. Configure the MID Server.
3. If using the Workflow and Orchestration add-ons, in the ServiceNow instance, navigate to Orchestration > Credentials.
4. Click New, complete the form with the following values for the AD credential, and then click Submit.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select Windows.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter your Active Directory domain user. For example, <code>domain\admin</code>.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter your Active Directory domain user password.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Applies to | Select the MID Server that you use to access the Active Directory server.

#### Note:
If you are using IntegrationHub, follow these steps:

- Navigate to **Connections and Credentials > Connections and Credentials Aliases > AD > Connections > New** and then set up your connection.

Or

- From the AD Credential store, click **AD Connection Alias** to create a new connection.

#### What to do next
Create a connection to the credential store as described in **Configure the connection to an AD credential store**.

### Configure the connection to an AD credential store

You create a Password Reset credential store record to configure access to your Active Directory server while a user is changing or resetting a password. In addition to host connection information, you can specify the password hints that users should see, restrictions on password reuse, the allowed number of failed reset attempts, and other settings.

#### About this task
The Orchestration add-on installs the AD Credential Store type. The Password Reset Windows Application supports only **AD Credential Store**.

#### Procedure

1. Navigate to **Password Reset > Credential Stores** and select **Sample AD Credential Store** to use as a template.

2. Enter a unique and meaningful **Name** and **Description** and then fill in the form.

<table>
<thead>
<tr>
<th>Type</th>
<th>Select AD Credential Store. A ServiceNow credential store type is a template that provides the required set of capabilities for a particular type of credential store. Credential stores inherit the functionality of the credential store type.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-generate password</td>
<td>Specify a script include that generates a temporary password for use during the reset process.</td>
</tr>
</tbody>
</table>
Note: If you select the Enforce history policy check box, then you must specify a value for Auto-generate password.

| Enforce history policy | Appears only if you select a credential store Type of AD Credential Store or Local ServiceNow Instance. For information on configuring the setting for credential store types other than AD, see Configure the connection to a credential store for the Password Reset processes.

Select the Enforce history policy check box to enforce both of the following password reset policies:

- **History policy (password reuse):** Active Directory domains can be configured to include a history policy that ensures that users do not reuse passwords. For example, the history policy might be configured to not allow the user to reuse any of the previous 10 passwords when resetting a password.

- **Maximum number of reset attempts:** You can configure the maximum number of attempts to reset a password. A user who fails to reset the password (by failing password policies or the history policy) the specified number of times is blocked.

Follow this procedure to enforce the history policy that is configured for the AD credential store and to enforce the password policy:

a. Select the Enforce history policy check box.

b. In the Password Reset Credential Store Parameters related list, set the value of the max_reset_attempts parameter to the number of allowed attempts to change or reset the password. Attempts fail when password policies which are set up on the remote AD server. The max_reset_attempts setting applies only to Password Reset processes that use AD credential stores. The default value of 0 (zero) enables an unlimited number of reset attempts.

| Hostname | Specify the URL or IP address of the credential store.

| User account lookup | Specify the script include that maps the user ServiceNow platform ID to the user credential store ID.

The default script, PwdDefaultUserAccountLookup, returns the user ServiceNow platform user name.

| Password rule hint | Specify the text that appears on the password reset page to help the user to create a password that meets all requirements. The Password rule script enforces the requirements.
**Note:** The Password Reset Windows Application supports newline characters in the hint. Other formatting is not supported (bold, underline, hyperlink, and so on).

<table>
<thead>
<tr>
<th>Password rule</th>
<th>Specify the client script that validates the new password that the user enters. The script is invoked when the user enters a new password and clicks <strong>Password Reset</strong>. You can use the script to enforce password strength/complexity requirements.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Password Strength</td>
<td>Select the check box to:</td>
</tr>
<tr>
<td></td>
<td>• Display the text box for the <strong>Strength rule</strong> script so you can update the script.</td>
</tr>
<tr>
<td></td>
<td>• Display the graphical <strong>Password Strength</strong> bar to the user while the user changes or resets the password.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The Password Reset Windows Application does not support Password Strength.</td>
</tr>
<tr>
<td>Strength rule</td>
<td>This text box appears only if you select <strong>Enable Password Strength</strong>.</td>
</tr>
<tr>
<td></td>
<td>Specify the client script that calculates the strength/complexity of the password that the user enters. The script is invoked when the user begins to enter a new password during the reset process.</td>
</tr>
<tr>
<td></td>
<td><strong>Default settings:</strong></td>
</tr>
<tr>
<td></td>
<td>• Selected for local ServiceNow credential stores</td>
</tr>
<tr>
<td></td>
<td>• Not selected for other credential stores</td>
</tr>
</tbody>
</table>

**Note:**

To guide the user during the reset process, the system displays a graphical bar labeled **Password Strength** under the **New password** field.

**Note:** The Password Reset Windows Application does not support Password Strength.

3. **Click Submit.**

4. On the domain controller, set **Password Aging** (MINAndPassword_AGE) to zero.

5. To enforce the history policy that is configured for the AD credential store, follow these steps:
a. Open the Password Reset process that is associated with the credential store: **Password Reset > Processes**.

b. On the **Password Reset Details** tab of the Password Reset Process form, clear the **Auto-generate password** check box and then save the process definition.

c. On the domain controller, set the history policy to twice the desired number of passwords. For example, to enforce that the last 11 passwords are not repeated, set the history policy to 22.

   **Note:** To enforce the history policy that is configured for the AD credential store, the system auto-generates a new temporary password for each reset cycle. The system auto-generates the temporary password even though you cleared the **Auto-generate password** check box on the Password Reset Process form. Because the user immediately replaces the temporary password with a new password, two passwords are created for each reset cycle.

6. To enforce the maximum number of attempts to reset the password: In the Password Reset Credential Store Parameters related list, set the value of the **max_reset_attempts** parameter to the number of allowed failed attempts. The default value of 0 (zero) enables an unlimited number of reset attempts.

   **Note:** The **max_reset_attempts** setting applies only to Password Reset processes that use AD credential stores.

7. Click **Submit**.

8. Test the connection to the credential store.

**Related information**

Configure the required strength for passwords

**Credential Store for Password Reset for Microsoft Azure AD**

A credential store type is the set of flows to manage password and account of Microsoft Azure AD user. Navigate to **Password Reset > Credential Stores** to view the list of example credential stores that are based on the base-system types.

**Related information**

Integrate Password Reset with your Microsoft Azure AD

Configure the connection to Microsoft Azure Active Directory (AD) credential store
Integrate Password Reset with your Microsoft Azure AD

When the Microsoft Azure AD Spoke for Password Reset is activated, the Password Reset application can manage passwords of a Microsoft Azure AD Application. The application manages passwords by referencing an Azure AD user with appropriate roles and password change privileges.

Before you begin
Role required: admin

Procedure

1. Set up Microsoft Azure AD spokeSetup for Password Reset.
2. Configure Servicenow Credential Store.
   The Microsoft Azure AD Spoke for Password Reset is integrated.

What to do next
Create a connection to the credential store as described in Configure the connection to an AD credential store.

Configure the connection to Microsoft Azure Active Directory (AD) credential store

Create a Password Reset credential store record to configure access to your Microsoft Azure AD server while a user is changing or resetting a password. In addition to host connection information, you can specify the password hints that users should see and other settings.

About this task
The Microsoft Azure AD Spoke for Password Reset installs the Microsoft Azure AD Credential Store type. The Microsoft Azure AD application supports only the Microsoft Azure AD Credential Store.

Procedure

1. Navigate to Password Reset > Credential Stores and select Sample Microsoft Azure AD credential store which you can use out of the box or as a template.
2. Enter a unique Name and Description and then complete the form.

| Type | Select Sample Microsoft Azure AD credential store. A ServiceNow credential store type is a template that provides the required set of capabilities for a particular type of credential store. Credential stores inherit the functionality of the credential store type. |

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th><strong>Auto-generate password</strong></th>
<th>Specify a script include that generates a temporary password for use during the reset process.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hostname</strong></td>
<td>Specify the domain name of the Azure AD application in this column.</td>
</tr>
<tr>
<td><strong>User account lookup</strong></td>
<td>Specify the script include that maps the user ServiceNow platform ID to the user credential store ID.</td>
</tr>
<tr>
<td></td>
<td>The default script, PwdDefaultUserAccountLookup, returns the user ServiceNow platform user name.</td>
</tr>
<tr>
<td><strong>Password rule hint</strong></td>
<td>Specify the text that appears on the password reset page to help the user to create a password that meets all requirements. The Password rule script enforces the requirements.</td>
</tr>
<tr>
<td><strong>Password rule</strong></td>
<td>Specify the client script that validates the new password entered by the user. The script is invoked when the user enters a new password and clicks Password Reset.</td>
</tr>
<tr>
<td><strong>Enable Password Strength</strong></td>
<td>Select the check box to:</td>
</tr>
<tr>
<td></td>
<td>• Display the text box for the Strength rule script so you can update the script.</td>
</tr>
<tr>
<td></td>
<td>• Display the graphical Password Strength bar to the user while the user changes or resets the password.</td>
</tr>
<tr>
<td><strong>Strength rule</strong></td>
<td>This text box appears only if you select Enable Password Strength. Specify the client script that calculates the strength/complexity of the password that the user enters. The script is invoked when the user begins to enter a new password during the reset process.</td>
</tr>
<tr>
<td></td>
<td>Default settings:</td>
</tr>
<tr>
<td></td>
<td>• Selected for local ServiceNow credential stores</td>
</tr>
<tr>
<td></td>
<td>• Not selected for other credential stores</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>To guide the user during the reset process, the system displays a graphical bar labeled Password Strength under the New password field.</td>
</tr>
<tr>
<td><strong>Enable password policy</strong></td>
<td>Check this option to select either a default password policy or one you created yourself previously.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
Password Reset Credential store record to access your Microsoft Azure AD server is configured.

ℹ️ **Note:** The **Enable Password Policy** option is new in the Quebec release. Checking the option displays your password policy choices right from your instance. To learn more, see [Enable password policies on your instance](#).
What to do next
Test the connection to a credential store

Test the connection to a credential store
You should test the connection to a credential store after you configure a new credential store or when users experience problems that might involve the connection.

Before you begin
Role required: admin

Procedure
1. Navigate to Password Reset > Credential Stores and then open the credential store record.
2. In the header bar, click Save and Test Connection. A progress page displays the result of the test.

Set up SOAP credentials for Password Reset
When the Orchestration Add-on plugin is activated, the ServiceNow platform can use the SOAP protocol to interact with remote credential stores such as a remote ServiceNow instance.

Before you begin
Role required: admin or web_service_admin

Procedure
1. Navigate to System Web Services > Outbound > SOAP Message.
2. Click Password Reset Request.
3. From the Soap Message Functions related list, configure both the password_reset and sys_user_get_record functions by completing the following steps.
   a. In Basic auth user ID, enter the user ID for the remote system user who has privileges to update records on the User [sys_user] table.
   b. In Basic auth user password, enter the password for the remote system user who has privileges to update records on the User [sys_user] table.
   c. Select Use basic auth.
   d. Click Update.
   You do not need to enter a value in the SOAP endpoint field. The field shows the name of the ServiceNow instance used for Password Reset.
Delete a connection to a credential store for Password Reset

Important: Before you delete the connection to a credential store, check all Password Reset processes to ensure that the credential store is not in use. If the credential store is being used by a process, update the process before deleting the credential store.

Before you begin
Role required: password_reset_admin or password_reset_credential_manager

Procedure
1. Navigate to Password Reset > Credential Stores and then select the check box for the credential store.
2. In the Actions choice list, select Delete.

Password Reset verifications
Each verification specifies the method and process for verifying the identity of the user that is requesting password reset.

Verifications included with Password Reset
The Password Reset application includes the following verifications in the base system. You can create a verification based on either a base-system verification or a verification type (a template).

Note: The Password Reset Windows Application does not support custom verifications.

| QA verification | Implements a self-service Password Reset model with questions that are included with the base system or custom questions that the admin defines. While enrolling for the process, the user decides which questions to provide answers for. Questions are presented in the language that the user requested during login. When a user requests password reset, the system poses a specified number of the questions that the user selected during enrollment. The user must answer all questions correctly to verify identity. |
## Password Reset verifications (continued)

For information on the user enrollment experience, see Users: Enroll in the Password Reset program using questions and answers.

This verification is based on the **Security Questions** verification type.

<table>
<thead>
<tr>
<th>Verification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Email verification</strong></td>
<td>This verification relies on auto-generated code numbers. You typically implement Email verification as a self-service Password Reset model. When a user requests password reset, the system sends a verification code to an email address that the user authorized during enrollment. To verify identity, the user then submits the code on the Password Reset Verify page. For information on the user enrollment experience, see Users: Enroll in the Password Reset program using emailed codes. The Password Reset Windows Application supports Email verification. This verification is based on the <strong>Email Code</strong> verification type.</td>
</tr>
<tr>
<td><strong>SMS verification</strong></td>
<td>Implements a self-service or service desk-assisted Password Reset model that relies on auto-generated code numbers. When a user requests password reset, the system sends a code to an SMS-capable device that the user has authorized. To verify identity, the user then submits the code on the Password Reset Verify page. You can use the ServiceNow Notify feature to send the codes. For information on the user enrollment experience, see Users: Enroll in the Password Reset program using SMS codes. This verification is based on the <strong>SMS Code</strong> verification type.</td>
</tr>
</tbody>
</table>
**Password Reset verifications (continued)**

<table>
<thead>
<tr>
<th>Verification Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Google Authenticator verification</td>
<td>Password Reset model that relies on auto-generated code numbers. You typically implement Google Authenticator verification as a self-service Password Reset model. When a user requests password reset, the user reads a code from the Google Authenticator app on a device that the user has paired. To verify identity, the user then submits the code on the Password Reset Verify page. For information on the user enrollment experience, see Users: Enroll in the Password Reset program using Google Authenticator. The Password Reset Windows Application supports Google Authenticator verification. This verification is based on the <strong>Google Authenticator</strong> verification type.</td>
</tr>
<tr>
<td>Personal Data — Confirm Email Address</td>
<td>Implements a self-service Password Reset model that relies on user information that is available in the user profile on the instance. This verification is based on the <strong>Personal Data Confirmation</strong> verification type.</td>
</tr>
<tr>
<td>Personal Data — Enter User Name</td>
<td>Implements a self-service Password Reset model that relies on user information that is available in the user profile on the instance. This verification is based on the <strong>Personal Data</strong> verification type.</td>
</tr>
</tbody>
</table>

**Verifications included with the demo data**

The following demo data is based on the Mock verification type:
- Sample Mock verification #1
- #2

**Related information**

- Create a custom Password Reset verification type
- Create a custom Password Reset verification
- Create a Password Reset verification from an existing verification
Personal data identification types and confirmation type verifications

Personal data verifications allow users to verify their identity by providing answers to questions that are generated from personal information stored in the User table [sys_user].

User experience

For an example of how a user might enroll for Personal data verification, see Users: Enroll in the Password Reset program using questions and answers.

Personal data identification types

The Password Reset application provides the email and username identification types. You can use either type as provided or as a model to create a custom identification type.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Identification</td>
<td>Identifies users by their email addresses.</td>
</tr>
<tr>
<td>Username Identification</td>
<td>Identifies users by their user names.</td>
</tr>
</tbody>
</table>

Personal data confirmation verifications

- **Personal data verification**: If users are associated with a Password Reset process that uses a personal data verification, the users are typically not required to enroll for Password Reset.

- **Personal data confirmation verifications** allow employees with the password_reset_service_desk role to access personal data from the sys_user table when assisting a user with a password reset request.

To configure personal data and personal data confirmation verifications, you specify parameters as name/value pairs that correspond to a particular piece of user information. For example, to verify users by their email address:

1. Set the **label** parameter (the text that the end user should see) to *Email* (that is, label=Email).

2. Set the **column** parameter (the column in the table that holds the verification data) to *email* (that is, column=email).

**Note:** You can use only one set of name/value pair parameters per verification. Additional parameters are ignored.
To use multiple pieces of personal information for user verification, create more personal data or personal data confirmation verifications and add the verifications to the related Password Reset process.

**Personal data and personal data confirmation type verifications**

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>label</td>
<td>Text to display as a label for the field that the user fills in during the password reset request.</td>
</tr>
<tr>
<td></td>
<td>Data Type: string</td>
</tr>
<tr>
<td></td>
<td>Default Value: n/a</td>
</tr>
<tr>
<td>column</td>
<td>Column of the sys_user table that provides the data that is used to verify the identity of the user.</td>
</tr>
<tr>
<td></td>
<td>Data Type: string</td>
</tr>
<tr>
<td></td>
<td>Default Value: n/a</td>
</tr>
</tbody>
</table>

**Related information**

Create a custom identification type for Password Reset

**SMS Code Verification type for Password Reset**

Using the Simple Message Service (SMS) Code Verification type, a user can verify identity with the help of any SMS-enabled device, like a cell phone that accepts text messages. When a user requests password reset, the system sends a numerical code to the device and the user then enters the code on the Password Reset Verification page.

You can change the default behavior of an SMS code verification using either of the following methods:

- Set parameter values, as shown in the table.
- Update property settings for the Password Reset application.

⚠️ **Note:** The system allows only one instance of each SMS code parameter.

**SMS Code Verification type parameters**

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>expiry</td>
<td>Number of minutes the verification code is valid.</td>
</tr>
</tbody>
</table>
### SMS Code Verification type parameters (continued)

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Description</th>
<th>Data Type</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>complexity</td>
<td>Number of digits in the numerical verification code.</td>
<td>integer (any positive integer)</td>
<td>4</td>
</tr>
<tr>
<td>pause_window</td>
<td>Number of minutes before the user can request another SMS code for verification.</td>
<td>integer (any positive integer)</td>
<td>2</td>
</tr>
<tr>
<td>max_per_day</td>
<td>Maximum number of codes sent for verification in one day.</td>
<td>integer (any positive integer)</td>
<td>10</td>
</tr>
</tbody>
</table>

### User experience

For information on how users enroll for SMS verification, see [Users: Enroll in the Password Reset program using SMS codes](#).

### Use NotifyNow to send SMS codes for enrollment and verification

You can configure the Password Reset application to send SMS codes for enrollment and verification using the ServiceNow NotifyNow application (via the Twilio SMS Messaging system). NotifyNow is tightly integrated with the workflow engine and business rules and delivers a highly configurable and trusted way to deliver SMS messages.

**Before you begin**

Role required: admin

**About this task**

NotifyNow requires a separate contract with Twilio.
Procedure
1. Enroll for a Twilio account and telephone number at https://www.twilio.com/
2. Activate the Notify plugin.
3. Associate the Twilio account with Notify.

Results
No other configuration is required. Users who request password change or password reset receive SMS codes through NotifyNow.

Related information

Specify the number of required security questions
When designing a Security Questions verification for Password Reset, you can specify the number of questions to display when users enroll. You can also specify the number to display when a user is verifying identity while resetting the password.

Before you begin
Role required: password_reset_admin or admin

Procedure
1. Navigate to Password Reset > Verifications and then open a verification that uses the Security Questions Verification Type.
2. Configure the parameters in the Password Reset Verification Parameters related list.

Parameters for Security Questions Verification

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>num_enroll</td>
<td>Number of questions that a user must provide answers to while enrolling for the Password Reset process. The value that you specify here overrides the setting of the Number of security questions required during enrollment property. See Configure Password Reset properties. <strong>Data Type</strong>: Positive integer that does not exceed the number of questions in the security questions list (Password Reset &gt; Security Questions).</td>
</tr>
<tr>
<td>Parameter Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| num_reset      | Number of security questions that are displayed on the Verify page while a user is attempting to reset the password. The user must answer all questions correctly to verify identity. The questions are selected at random and are presented in random order. 

The value that you specify here overrides the setting of the **Number of security questions required during the password reset request** property. See Configure Password Reset properties. 

**Data Type**: Positive integer that does not exceed the value of the num_enroll parameter 

**Default Value**: 3 |

3. Click **Update**.

**Related information**

Add a custom question to the Security Questions verification

**Configure your Password Reset process to auto-enroll users**

To simplify management, many organizations auto-enroll users in the Password Reset program. Every base-system verification type enables you to specify automatic enrollment for your process.

**Before you begin**

Role required: password_reset_admin or admin

**About this task**

To enable automatic enrollment, you configure settings for the verification type that your Password Reset process is based on.

**Procedure**

1. Navigate to **Password Reset > Extensions > Verification Types**.

2. Click the verification type for the verification that your Password Reset process uses. The verification type for each base-system verification is identified in **Password Reset verifications**.

3. On the **Verification Types** page, specify the following settings:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enrollment check</td>
<td>Script that determines whether a user is enrolled for verification.</td>
</tr>
<tr>
<td>Note:</td>
<td>For automatic enrollment to work, the <strong>Enrollment check</strong> script must return true. This may require additional setup by the admin to ensure that the preconditions are met. For example, for the <strong>SMS Code</strong> verification type, records must be populated in particular tables.</td>
</tr>
<tr>
<td></td>
<td>If no script is specified when <strong>Automatic Enrollment</strong> is selected, a default script is provided.</td>
</tr>
<tr>
<td>Automatic enrollment</td>
<td>Select the check box to auto-enroll users.</td>
</tr>
<tr>
<td>Note:</td>
<td>If <strong>Automatic enrollment</strong> is not selected, then you must provide an enrollment UI macro and enrollment processor script as described in Create a custom Password Reset verification type.</td>
</tr>
</tbody>
</table>

4. Repeat the procedure for all verifications that your Password Reset process uses.

**Enable users to enroll for Password Reset**

To enable users to enroll for the Password Reset program, you specify a UI macro that takes the user through the enrollment process and a script that processes the enrollment data that the user entered. The base system includes a functioning macro and script.

**Before you begin**

Role required: password_reset_admin or admin

**About this task**

To enable users to enroll, you configure settings for the verification type that your Password Reset process is based on.
Procedure

1. Navigate to **Password Reset > Extensions > Verification Types**.

2. Click the verification type for the verification that your Password Reset process uses. The verification type for each base-system verification is identified in **Password Reset verifications**.

3. On the **Verification Types** page, specify the following settings:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic enrollment</td>
<td>Clear the check box to disable automatic enrollment.</td>
</tr>
<tr>
<td>Enrollment UI</td>
<td>Enrollment UI macro that takes the user through the enrollment process.</td>
</tr>
<tr>
<td>Enrollment processor</td>
<td>Enrollment processor script that processes enrollment data.</td>
</tr>
</tbody>
</table>

4. Repeat the procedure for all verifications that your Password Reset process uses.

**Example: Enabling user enrollment**

This example verification type uses the `pwd_enroll_sms_ui` enrollment UI macro and the `PwdEnrollSMSProcessor` enrollment processor script.
A verification type must also define a verification UI macro and a corresponding verification processor script. The example uses the `pwd_verify_sms_ui` verification UI macro and the `PwdVerifySMSProcessor` verification processor script.

**Verification UI macro**

```
<xml version="1.0" encoding="utf-8" ?
<!DOCTYPE jelly PUBLIC "-//Jelly Team//DTD Jelly 1.0//EN" "http://jelly.sourceforge.net/dtd/v1.0.dtd">
  <jelly xmlns="jelly:core" xmlns="glide" xmlns:js="null" xmlns:gl="null">
    <script language="javascript">
      addLoadEvent(getVerificationInfo);

      function getVerificationInfo() {
        var ga = new GlideAjax('/saasPublic мероприятиеSMS');
        ga.addParam('sysparm_name', 'getSMSVerificationInfo');
        ga.addParam('sysparm_user_id', '${sysparm_sys_user_id}');

        // add CSRF token for AJAX handling.
        ga.addParam('sysparm_pwd_verify_token', findCSRFElement().value);
        ga.getXML(onGetVerificationInfoResponse, null);
      }

      function handleGetVerificationInfoResponse(response, args) {
        // Process the verification form request, and return whether the user was successfully verified
        // Process the verification form request, and return whether the user was successfully verified
      }
    </script>
  </jelly>
```

**Verification processor script**

```javascript
var PwdVerifySMSProcessor = Class.create();

PwdVerifySMSProcessor.prototype = {
  initialize: function() {
    // Initialization stuff here...
  },

  process: function() {
    // Process the verification form request, and return whether the user was successfully verified
    // Process the verification form request, and return whether the user was successfully verified
  }
};
```
Configure Password Reset properties

You can specify properties that configure the Password Reset experience for end users.

Before you begin
Role required: password_reset_admin

About this task
While there are no range limits for the values you can enter for properties, consider using only positive integer values starting at 1. When you determine the limit for the upper range of a property, consider the task that the user is performing.

For example, you would not want to allow 100 attempts for users to verify their identity. A more common value is 3 attempts. Similarly, you may not want to force users who are completing the enrollment process to spend time selecting and answering 30 security questions. The more commonly used number of security questions is between 5 and 7.

Procedure
1. Navigate to Password Reset > Properties.
2. Update settings as needed and then click Save.

<table>
<thead>
<tr>
<th>Password Reset properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Property Label</strong></td>
<td><strong>Property Name</strong></td>
</tr>
<tr>
<td>Password Reset Global properties</td>
<td>password_reset.enrollment_reminder_email_template</td>
</tr>
<tr>
<td>Workflow polling frequency</td>
<td>password_reset.wf.refresh_rate</td>
</tr>
<tr>
<td>Property Label</td>
<td>Property Name</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>Workflow expiration</td>
<td>password_reset wf.timeout</td>
</tr>
<tr>
<td>Disable CAPTCHA validation functionality</td>
<td>password_reset captcha.ignore</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Password Reset Request properties</td>
<td>password_reset request max_attempts</td>
</tr>
<tr>
<td>Property Label</td>
<td>Property Name</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>---------------------------------------------------------</td>
</tr>
<tr>
<td>by the value in max_attempt_window.</td>
<td></td>
</tr>
<tr>
<td>• Type: integer</td>
<td></td>
</tr>
<tr>
<td>• Default value: 3 (attempts)</td>
<td></td>
</tr>
<tr>
<td>Number of minutes a user must wait to reset/change password after exceeding the maximum allowed unsuccessful attempts</td>
<td>password_reset.request.max_attempt_window</td>
</tr>
<tr>
<td>• Type: integer</td>
<td></td>
</tr>
<tr>
<td>• Default value: 1440 (minutes)</td>
<td></td>
</tr>
<tr>
<td>Number of minutes a user must wait to reset/change password after the last successful reset/change</td>
<td>password_reset.request.success_window</td>
</tr>
<tr>
<td>• Type: integer</td>
<td></td>
</tr>
<tr>
<td>• Default value: 1440 (minutes)</td>
<td></td>
</tr>
<tr>
<td>Number of minutes a user must wait to start a reset request after the last successful unlock account</td>
<td>password_reset.request.unlock_window</td>
</tr>
<tr>
<td>• Type: integer</td>
<td></td>
</tr>
<tr>
<td>• Default value: 1440 (minutes)</td>
<td></td>
</tr>
<tr>
<td>Number of minutes before a password reset request expires</td>
<td>password_reset.request.expiry</td>
</tr>
<tr>
<td>Property Label</td>
<td>Property Name</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Password Reset Security Question properties

<table>
<thead>
<tr>
<th>Minimum number of characters in any answer</th>
<th>password_reset.qa.ans_min_len</th>
<th>Minimum number of alphanumeric characters that the user must enter in the answer text box for any security question. Default value: 3 characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of security questions required during the password reset request</td>
<td>password_reset.qa.num_reset</td>
<td>Number of security questions that are displayed on the Verify page while a user is attempting to reset the password. The user must answer all questions correctly to verify identity. The questions are selected at random and are presented in random order. • Type: integer • Default value: 3 (questions)</td>
</tr>
<tr>
<td>Property Label</td>
<td>Property Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Number of security questions required during enrollment</td>
<td>password_reset.qa.num_enroll</td>
<td>Number of questions that a user must provide answers to while enrolling for the Password Reset process.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Possible values: Integers that are greater than or equal to the number specified for the Number of security questions required during enrollment (the num_enroll parameter).</td>
</tr>
</tbody>
</table>

**Note:** You can override this property setting for a Password Reset process by configuring the num_reset parameter. See Specify the number of required security questions.
<table>
<thead>
<tr>
<th>Property Label</th>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>enrollment property</td>
<td>(the num_reset parameter).</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** While attempting to verify identity, if a user answers a question incorrectly, the application refreshes with a random set of the specified questions in random order. You should, therefore, require more questions than specified for the **Number of security questions required during enrollment** property (the num_reset parameter).

**Note:** You can override this property setting for a Password Reset process by configuring the **num_enroll** parameter. See **Specify the number of required security questions.**
<table>
<thead>
<tr>
<th>Property Label</th>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Reset SMS Code properties</td>
<td></td>
<td>Maximum number of SMS codes that are sent to a user within one 24-hour period. The 24-hour period begins when a user clicks <strong>Send Code</strong>.</td>
</tr>
</tbody>
</table>
| Maximum number of SMS codes sent for verification per day | password_reset.sms.max_per_day                     | - Type: integer  
- Default value: 10 (per day)                                                                                                                                            |
| Number of minutes before the user can attempt to send another SMS code for verification | password_reset.sms.pause_window                    | Time that must pass before another SMS code can be sent to a user.                                                                                                                  |
| Number of digits in the SMS code sent to the user | password_reset.sms.default_complexity              | Number of characters required for a user to reset their password.                                                                                                                         |

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Property Label</th>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Type: integer</td>
<td>• Default value: 4 (digits)</td>
<td>You can override this SMS code property by adding the complexity parameter in the SMS code verification.</td>
</tr>
<tr>
<td>Number of minutes before the SMS code expires</td>
<td>password_reset.sms.expiry</td>
<td>Time, in minutes, until the SMS code sent to the user expires.</td>
</tr>
<tr>
<td>• Type: integer</td>
<td>• Default value: 5 (minutes)</td>
<td>Note: You can override this SMS code property by the expiry parameter in the SMS code verification.</td>
</tr>
</tbody>
</table>

Password Reset Monitoring and Reporting properties

<table>
<thead>
<tr>
<th>Time interval, in minutes, for counting blocked users</th>
<th>password_reset.activity_monitor.incident_window</th>
<th>Time window to count the number of blocked users.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Type: integer</td>
<td>• Default value: 60 (minutes)</td>
<td></td>
</tr>
</tbody>
</table>

<p>| Number of blocked users, in the defined time interval, that triggers a system log event | password_reset.activity_monitor.incident_threshold | Number of blocked (or locked) users, within the specified time window, that triggers a system log event. |</p>
<table>
<thead>
<tr>
<th>Property Label</th>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Type: integer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Default value: 10</td>
<td>(blocked users)</td>
</tr>
<tr>
<td>Password Reset Style Sheet</td>
<td>password_reset.stylesheet</td>
<td>Name of a custom CSS style sheet in the Style Sheet [content_css] table. You can use the default style sheet as a template for the custom style sheet. You cannot add element definitions to the style sheet.</td>
</tr>
<tr>
<td>Style sheet to apply to end-user pages during the password reset process.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Email template for reminder emails | password_reset.email_template_default | Template to use to specify the subject and body of the email messages to remind users to enroll for the Password Reset process. For example:  
• [Subject] Reminder: Enroll in the Password Reset program  
• [Body] Click here to enroll for the password reset service. |
<table>
<thead>
<tr>
<th>Property Label</th>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note: You must create an email template in the password_reset table to use it as a reminder.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type: string</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default value: email_template_default</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Several components in the Self Service Password Reset (com.snc.password_reset) plugin and the Password Reset (com.glideapp.password_reset) plugin control the password reset flow. The following properties affect Password Reset, but do not appear on the Password Reset > Properties page:

- You can add the glide.pwd_reset.onetime.token.validity property to the System Properties [sys_properties] table to specify the number of hours that the Password Reset token should be valid. Default: 12.

**Note:** The setting for the password_reset.request.expiry property (time period during which a user must perform the Password Reset process) takes precedence over the setting for glide.pwd_reset.onetime.token.validity.

Properties accessible from the System Properties [sys_properties] table:

- For Password Reset on mobile devices, you can specify the URL that the user is taken to when user taps the **Forgot password?** button. See the glide.security.password_reset.uri property in High Security Settings. Default: /$pwd_reset.do?sysparm_url=ss_default

- If glide.security.forgot_password.display.link is set to **true**, displays the **Forgot Password?** link on the login page.

### Send email to remind users to enroll for Password Reset

You can automatically send messages that remind users to enrolled in the Password Reset process. You specify the text of the message and can configure the messages to repeat at intervals.

**Before you begin**

Role required: password_reset_admin
About this task
The default email content is:
• Subject: Reminder: Enroll in the Password Reset program
• Body: Click here to enroll in the Password Reset program.

To customize the email, see Customize the Password Reset enrollment reminder email.

Procedure
1. Navigate to Password Reset > Processes and select your process.
2. Click the Enrollment Reminder tab, configure the following settings, and then click Update. (The tab appears only when the Password reset check box is selected.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send reminder</td>
<td>Select the check box to send reminder emails to users (either all users or users in the specified groups, as you configured). Clear the check box to send no reminders.</td>
</tr>
<tr>
<td>Sender alias</td>
<td>Enter a non-functional email alias that should appear in both the To and From fields of the message. For example, <a href="mailto:do-not-reply@myCompany.com">do-not-reply@myCompany.com</a>. Users will not be able to respond to the alias. The alias is required by the email system to use the bcc field for all of the users who receive the message. The intent is that the users should not see the other addressees. Default: <a href="mailto:do-not-reply@ServiceNow.com">do-not-reply@ServiceNow.com</a></td>
</tr>
<tr>
<td>Send, Day, and Time</td>
<td>Specify a schedule of one message each month or one message each week.</td>
</tr>
<tr>
<td></td>
<td>• If you set Send to Monthly, then enter the day of the month and optionally the time of day when the message should be sent.</td>
</tr>
<tr>
<td></td>
<td>• If you set Send to Weekly, then enter the day of the week and optionally the time of day when the message should be sent. Default: Weekly message at 00:00 on Monday</td>
</tr>
<tr>
<td>Starting</td>
<td>Date and time to send the first message. Click the calendar button to specify the setting. Default: [Now]</td>
</tr>
</tbody>
</table>
Customize the Password Reset enrollment reminder email

The email message that reminds users to enroll for the Password Reset process is based on an email template. To customize the message, you can modify the default template or create a custom template.

Before you begin
Role required: password_reset_admin

About this task
The default email content is:

- Subject: Reminder: Enroll in the Password Reset program
- Body: Click here to enroll in the Password Reset program.

Procedure
1. To modify the email subject text:
   a. Navigate to System Policy > Email > Templates.
   b. Open the Password reset enrollment reminder template.
   c. Update the Subject field as needed.
   d. In the Message HTML text box, you can add code as needed, but do not modify the default text.

2. To modify the email body content:
   a. Navigate to System Notifications > Email > Notification Email Scripts.
   b. Open the pwd.enrollment_reminder script.
   c. Modify only the indicated portion of the script.
3. To create a custom email template:
   a. Make a copy of the **Password reset enrollment reminder** template and edit as described above.
   b. Navigate to **Password Reset > Properties** and enter the template name in the **Email template for enrollment reminder emails** field.

**Configure the required strength for passwords**

The password that a user defines must meet certain requirements — for example, it must contain at least 12 characters, it must include a numeral, and so on. You can configure the requirements as needed for your organization.

**Before you begin**

Role required: password_reset_admin
About this task
The base system includes example credential stores with various password requirements. You can modify password requirements and provide users with hints for creating a password. The default requirements are:

- At least eight characters
- At least one uppercase and one lowercase letter
- At least one numeral

Note: In addition to configuring password strength requirements, you can configure several other settings for the credential store, as described in Configure the connection to a credential store for the Password Reset processes.

Procedure
1. Navigate to Password Reset > Credential Stores.
2. Select the credential store in the list and then configure the following settings:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password rule hint</td>
<td>Specify the text that appears on the password reset page to help the user to create a password that meets all requirements. The Password rule script enforces the requirements.</td>
</tr>
<tr>
<td></td>
<td>Note: The Password Reset Windows Application supports newline characters in the hint. Other formatting is not supported (bold, underline, hyperlink, and so on).</td>
</tr>
<tr>
<td>Password rule</td>
<td>Specify the client script that validates the new password that the user enters. The script is invoked when the user enters a new password and clicks Password Reset. You can use the script to enforce password strength/complexity requirements.</td>
</tr>
<tr>
<td>Enable Password Strength</td>
<td>Select the check box to:</td>
</tr>
<tr>
<td></td>
<td>• Display the text box for the Strength rule script so you can update the script.</td>
</tr>
<tr>
<td></td>
<td>• Display the graphical Password Strength bar to the user while the user changes or resets the password.</td>
</tr>
<tr>
<td></td>
<td>Note: The Password Reset Windows Application does not support Password Strength.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Strength rule      | This text box appears only if you select **Enable Password Strength**. Specify the client script that calculates the strength/complexity of the password that the user enters. The script is invoked when the user begins to enter a new password during the reset process. Default settings:  
• Selected for local ServiceNow credential stores  
• Not selected for other credential stores  
**Note:** To guide the user during the reset process, the system displays a graphical bar labeled **Password Strength** under the **New password** field. |
|                    | **Note:** The Password Reset Windows Application does not support Password Strength.                                                                                                                         |

3. **Click Submit.**  
You should test the connection to a credential store after you configure a new credential store or when users experience problems that might involve the connection.

4. **Navigate to** **Password Reset > Credential Stores** and then open the credential store.

5. **In the header bar, click Save and Test Connection.**  
A progress page displays the result of the test.

Specify lockout for failed login attempts

The system provides inactive script actions that enable you to specify the number of failed login attempts before a user account is locked and to reset the count after a successful login.

**Before you begin**  
Role required: admin
Procedure

Navigate to **System Policy > Script Actions** to view or activate the scripts.

**Note:** Starting with the Kingston release, following a zBoot, the script actions **SNC User Lockout Check with Auto Unlock** and **SNC User Clear** are activated.

To learn more about properties that affect failed login attempts, see in the Instance Security Hardening Settings.

<table>
<thead>
<tr>
<th>Script action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SNC User Lockout Check with Auto Unlock</strong></td>
<td>• Uses the value of the <code>glide.user.max_unlock_attempts</code> property to set the limit for failed login attempts.</td>
</tr>
<tr>
<td></td>
<td>• Unlocks the user account after the time period that is specified for the <code>glide.user.unlock_timeout_in_mins</code> property. If no value is specified, then the system unlocks the user account after the default period of 15 minutes.</td>
</tr>
<tr>
<td><strong>SNC User Lockout Check</strong></td>
<td>Tracks the number of failed login attempts and locks the user account after a specified number of failed login attempts (default: 5).</td>
</tr>
<tr>
<td><strong>SNC User Clear</strong></td>
<td>Updates the user record after a successful login: Resets the number of failed login attempts and updates the date of the last login.</td>
</tr>
</tbody>
</table>

**What to do next**

Each time a user attempts to log in, the action is recorded in an event log. You can view a log of failed login attempts.

1. Navigate to **System Policy > Event Logs**.
2. Filter for **login.failed** in the **Name** field. You can view the attempted login name, date, and IP address logged for the attempt.

**Configure Google reCAPTCHA for the password reset process**

To use the Google reCAPTCHA service, instances that are running on a domain other than `service-now.com` require an API key pair from Google.
Before you begin
Role required: admin

About this task

• The procedure described in this topic is optional for instances that are running on the service-now.com domain.

• Because on-premises instances do not have access to the Internet, they cannot use the Google reCAPTCHA service. Do not follow the procedure described in this topic. Instead, set the password_reset.captcha.google.enabled system property to false. This setting enables the CAPTCHA service that is provided with the base system.

• The Password Reset Windows Application uses the base-system CAPTCHA service even if the Password Reset application is configured to use Google reCAPTCHA.

Procedure

1. Request an API key pair (a site key and a secret) from Google at https://www.google.com/recaptcha.

2. Set the following system properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>password_reset.captcha.google.enabled</td>
<td>Set to true. Type: string Default: true</td>
</tr>
<tr>
<td>google.captcha.site_key</td>
<td>Set to the site key that Google provided. Type: string Default: A site key that Google provided to ServiceNow</td>
</tr>
<tr>
<td>google.captcha.secret</td>
<td>Set to the secret that Google provided. Type: password2</td>
</tr>
</tbody>
</table>
Settings on the Advanced tab of the Password Reset Processes form

UI macros and script includes can extend the basic functionality of a Password Reset process.

The Advanced tab appears when you are configuring a Password Reset process (Password Reset > Processes).

### Advanced tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry UI macro</td>
<td>UI macro that displays a customized message to users when they access the initial Password Reset screen.</td>
</tr>
<tr>
<td>Success UI macro</td>
<td>UI macro that displays a customized message to users on the final Password Reset screen when their password is successfully reset.</td>
</tr>
<tr>
<td>Failure UI macro</td>
<td>UI macro that displays a customized message to users on the final Password Reset screen when their password reset fails.</td>
</tr>
<tr>
<td>Post reset script</td>
<td>Script include that performs actions after the Password Reset process completes whether the outcome is success or failure. For more information on customizing post processor scripts, see the Post reset script category as described in Password Reset extension script categories.</td>
</tr>
<tr>
<td>Header UI macro / Footer UI macro</td>
<td>Macros that add a header or footer to customize the appearance of the pages that end users work in</td>
</tr>
</tbody>
</table>
### Advanced tab (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>while resetting a password (the Identify, Verify, and Reset pages. See Add a custom header or footer to the user pages for Password Reset.</td>
</tr>
</tbody>
</table>

![Password Reset Customization](image)

### Customizing Password Reset processes

Password Reset scripts enable you to customize Password Reset by creating your own credential store, verification, and identification types, and extend them by defining extension scripts. You can also create a custom credential store type, custom verification type, or verification.

### Legacy

Password Reset scripting is available to users with the `password_reset_admin` role. The easiest way to customize Password Reset is:

1. Create custom types and scripts as described in [Password Reset extension script categories](#).
   
   Extension scripts are example script includes that enable you to extend functionality in a password reset process. The extension script category refers to the specific types of behavior for an extension script (for example, credential store, verification, identification type, or as a post-processor).

2. Follow the configuration steps described in [Configure your Password Reset process](#).

3. Select the new types that you created. You can customize the following components:
• Credential store types: Define new types for how to connect to your credential stores by creating custom workflows for connection and testing. See Create a credential store type for Password Reset.

• Verification types: Define new types for how users are verified. See Create a custom Password Reset verification type.

• Identification types: Define new types for how users can identify themselves. See Create a custom identification type for Password Reset.

Advanced password reset configuration
You can customize the Password Reset and Password Change applications to meet your organization’s needs. See Password Reset and Password Change applications for more information. Also see Configure Password Reset properties for a list of properties that control several aspects of password reset.

Customize password reset processes and integrate third-party credential services
To customize password reset processes or to integrate them with third-party credential services such as Okta or Microsoft Azure AD, use IntegrationHub capabilities. Use Action Designer to create or modify actions like user unlock, change password, and get user status. Use Flow Designer to create or modify subflows that perform the actions.

Before you begin
Role required: admin, password_reset_admin, or password_reset_credential_manager

About this task
• The base system provides actions, subflows, and credential store types for the "Local ServiceNow Instance" identity provider.

• For Microsoft Active Directory, the subflows are available when you activate the Password Reset - Orchestration Add-on plugin.

• To use any other identity provider such as Okta, you must use IntegrationHub to create the required actions, subflows, and custom credential store types.

• For Microsoft Azure AD, the subflows are available when you activate the Password Reset - Microsoft Azure AD plugin.
**Procedure**

1. Use Action Designer to create password reset actions like user unlock, change password, and get user status. See *Action Designer* for more information.

2. Use Flow Designer to create the following subflows. Use the specified names, inputs, and outputs for the subflows. See *Subflows* for more information.

<table>
<thead>
<tr>
<th>Subflow name</th>
<th>Input</th>
<th>Input type</th>
<th>Output</th>
<th>Output type</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Provider Name&gt; Password Unlock</td>
<td>Password Reset Request</td>
<td>Record.Password Reset Request</td>
<td>Error Message</td>
<td>String</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Status</td>
<td>Choice</td>
</tr>
<tr>
<td>&lt;Provider Name&gt; Password Reset</td>
<td>Password</td>
<td>Password (2 Way Encrypted)</td>
<td>Status</td>
<td>Choice</td>
</tr>
<tr>
<td></td>
<td>Password Reset Request</td>
<td>Record.Password Reset Request</td>
<td>Error Message</td>
<td>String</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;Provider Name&gt; Password Change</td>
<td>Password Reset Request</td>
<td>Record.Password Reset Request</td>
<td>Status</td>
<td>Choice</td>
</tr>
<tr>
<td></td>
<td>Current Password</td>
<td>Password (2 Way Encrypted)</td>
<td>Error Message</td>
<td>String</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New Password</td>
<td>Password (2 Way Encrypted)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Notes:**
- *Name* under Advanced options is `old_password`.
- *Name* under Advanced options is `new_password`.

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Subflow name</th>
<th>Input</th>
<th>Input type</th>
<th>Output</th>
<th>Output type</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Provider Name&gt; Password Connection Test</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Error Message</td>
<td>String</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Status</td>
<td>Choice</td>
</tr>
</tbody>
</table>

3. For third party providers, create a credential store type.
   a. Select the **Use Flow** check box.
   b. Select the password reset subflows that you created for the provider. See Password Reset application for more information.

4. Create password reset credential store. Select the credential store type created for the provider.

5. Create a password reset process. Select the credential store created for the provider.

**Results**
The password reset mechanism for the required third-party application is set up.

**Add a custom question to the Security Questions verification**
To enroll for the 'Security Questions' verification, the user selects several questions and supplies confidential answers that only the user knows. You can add a custom question to the set of questions that are included with the base system.

**Before you begin**
Role required: password_reset_admin or admin

**About this task**
The base system provides a large set of default questions in all supported languages. Questions are presented to each user in the language that the user requested during login. Creating a custom English language question is a one-step process. To create a custom question in a non-English language, you can use either of the following options:

- Create a custom question in the non-English language.
- Create a custom English language question plus one or more translations of the question into other languages.
Procedure

1. Navigate to **Password Reset > Security Questions**.

   - **Note:** Each question in the list is presented to users when they enroll for the Password Reset process. The user selects each question to use by providing a confidential answer to the question.

2. Follow this procedure to create a custom question in a single language.

   - **Note:** To enter non-English question text, you must request the language when logging in.

   a. On the Password Reset Questions page, click **New**.

   b. Enter the text in the **Question (Translated field)** field and then click **Submit**. The question is added to the list of questions that is presented to users when they enroll. No additional steps are needed and you can skip the remaining steps.

3. Follow this procedure to create a custom question in English and the same question in one or more other languages:

   a. Click **New**, enter English language text in the **Question (Translated field)** field, and then click **Submit**.

   b. Create a record in the **sys_translated** table for the non-English language question. Details appear at and .

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label (translate)</td>
<td>Non-English equivalent of the English text in the <strong>Value</strong> field.</td>
</tr>
<tr>
<td>Element</td>
<td>Name of the field in the Password Reset Question [pwd_question] table: question_translated</td>
</tr>
<tr>
<td>ID</td>
<td>ISO 639.2 code for the language.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that you are adding the translated question to: the Password Reset Question [pwd_question] table.</td>
</tr>
<tr>
<td>Language</td>
<td>Language code for this translated text.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Value</td>
<td>English-language question that you added in the Security Questions table.</td>
</tr>
</tbody>
</table>

c. Repeat the process for each language that users might request.

**Add a custom header or footer to the user pages for Password Reset**

You can specify UI macros that add a header or footer to the pages that end users work in while resetting a password (the Identify, Verify, and Reset pages).

**Before you begin**

Role required: password_reset_admin

**About this task**

![Diagram showing a custom header and footer]

**Procedure**

1. Configure a UI macro for the header or footer: Navigate to System UI > UI Macros, click New, and then enter a meaningful Name and Description.

2. In the XML text box, enter the macro text. The example macro adds the text "Trust Acme to Deliver!" to the footer of the page that users work in while resetting a password.
3. Select the **Active** check box and then click **Submit**.

4. Navigate to **Password Reset > Processes** and select the process to update.

5. On the **Advanced** tab, click ( ) for the **Header UI macro** or **Footer UI macro** and select the macro that you created.

6. Click **Save**.

7. Verify the appearance of the end-user pages.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the reset pages are Public Access</td>
<td>On the <strong>Password Reset Details</strong> tab, click the <strong>Public URL</strong>.</td>
</tr>
<tr>
<td>If the reset pages are not Public Access</td>
<td>Log in as an end user and request password reset.</td>
</tr>
</tbody>
</table>

**Create a Password Reset verification from an existing verification**

The Password Reset application includes several example verifications that you can use as they are or as the basis for a custom verification. If the verification types in the base system do not meet your needs, you can create a custom verification type.

**Before you begin**

Role required: password_reset_admin
About this task

Note: The Password Reset Windows Application does not support custom verifications.

Procedure

1. Navigate to **Password Reset > Verifications** and select a verification.
2. If needed, modify the parameters on the **Password Reset Verification Parameters** tab. The parameters are described in the instructions for the type of verification that you are working on.
3. Click **Submit**.
4. Each verification type has properties that control the user experience. Review the property settings and update as needed.

Create a custom Password Reset verification type

Each verification in Password Reset is based on the settings for a verification type. If the verification types in the base system do not meet your needs, you can create a custom verification type.

Before you begin

Role required: password_reset_admin or admin
Review the verification types that are provided in the base system to determine whether to create a custom verification type. Then review the verification type components to develop.

Procedure

1. Navigate to **Password Reset > Extensions > Verification Types**.
2. Click **New**, enter a unique and meaningful **Name** and **Description**, and then fill in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enrollment check</td>
<td>Script that determines whether a user is enrolled for verification. Automatic enrollment requires an enrollment check. If no script is specified when <strong>Automatic Enrollment</strong> is selected, a default script is provided.</td>
</tr>
<tr>
<td>Automatic enrollment</td>
<td>Select the check box to auto-enroll users. If <strong>Automatic enrollment</strong> is not selected, then</td>
</tr>
</tbody>
</table>
3. Click **Submit**.

**Related reference**
- Installed with Password Reset

**Related information**
- Password Reset script includes
- Password Reset extension script categories

**Create a custom Password Reset verification**

Use a verification type in the base system as a template to design a custom verification. The Password Reset Windows Application does not support custom verifications.

**Before you begin**
Role required: password_reset_admin

**About this task**

**Verification types in the base system**

<table>
<thead>
<tr>
<th>Verification type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal Data Confirmation</td>
<td>Verifies user identity using data from the User [sys_user] table. The user data is displayed to a service desk agent. The agent verifies the data. Enrollment is not required for this type. Recommended for service desk-assisted processes.</td>
</tr>
</tbody>
</table>
### Verification types in the base system (continued)

<table>
<thead>
<tr>
<th>Verification type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Note:</strong> The Password Reset Windows Application does not support the Personal Data Confirmation Verification type.</td>
</tr>
<tr>
<td></td>
<td>See <a href="#">Personal data identification types and confirmation type verifications</a>.</td>
</tr>
<tr>
<td>Personal Data</td>
<td>Verifies user identity using data from the User [sys_user] table. The user is required to answer questions.</td>
</tr>
<tr>
<td></td>
<td>Enrollment is not required for this type.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Password Reset Windows Application allows you to define and use multiple verifications of the Personal Data type.</td>
</tr>
<tr>
<td></td>
<td>See <a href="#">Personal data identification types and confirmation type verifications</a>.</td>
</tr>
<tr>
<td>Email Code</td>
<td>When a user requests password reset, the system sends a verification code to the email address in the user profile or to an email address that the user authorized during enrollment. To verify identity, the user then submits the code on the Password Reset Verify page.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Password Reset Windows Application allows you to define and use multiple verifications of the Email Code type.</td>
</tr>
<tr>
<td></td>
<td>See <a href="#">Personal data identification types and confirmation type verifications</a>.</td>
</tr>
<tr>
<td>Google Authenticator</td>
<td>While requesting password reset, the user reads a code from the Google Authenticator app on a device that the user has paired. To verify identity, the user then submits the code on the Password Reset Verify page.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Password Reset and Password Reset Windows Application support only a single verification of the SMS Code type.</td>
</tr>
<tr>
<td>Security Questions</td>
<td>Verifies user identity by presenting personal security questions that the user must answer correctly.</td>
</tr>
</tbody>
</table>
## Verification types in the base system (continued)

<table>
<thead>
<tr>
<th>Verification type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> The Password Reset and Password Reset Windows Application support only a single verification of the Security Questions type.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> The Password Reset and Password Reset Windows Application support only a single verification of the SMS Code type.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> The Password Reset Windows Application does not support the Mock verification type.</td>
<td></td>
</tr>
</tbody>
</table>

### SMS Code

When a user requests password reset, the system sends a code to an SMS-capable device that the user has authorized. To verify identity, the user then enters the code on the Password Reset web page.

**Field**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Create verifications based on one of the verification types in the base system.</td>
</tr>
</tbody>
</table>

---

### Mock

Not a functional identity verification. Demonstrates how to add a verification type in a Password Reset process.

**Procedure**

1. Navigate to **Password Reset > Extensions > Verification Types**.
2. Click **New**, enter a unique and meaningful **Name** and **Description**, and then fill in the form.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Field Description

Password Reset supports the following types. You can create multiple instances of any type.

- Personal Data Confirmation Verification
- Personal Data Verification
- Security Question Verification
- SMS Code Verification

The Password Reset Windows Application supports the following types:

- Personal Data Verification. You can create only a single instance.
- Security Question Verification. You can create multiple instances.
- SMS Code Verification. You can create only a single instance.

<table>
<thead>
<tr>
<th>Order</th>
<th>Position of the verification as it appears on the Enrollment form and Password Reset form.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Reset Verification Parameters</td>
<td>Parameters used by a verification to configure specific behaviors, like number of questions required to enroll, request expiration time, and columns used. Set parameters for any behavior that should be different from the value that is specified in the Password Reset properties. The available parameters are described separately for each verification type.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

4. Each verification type has properties that control the user experience. Review the property settings and update as needed.

### Create a custom identification type for Password Reset

A custom identification type enables the user to enter alternative verification information such as an employee ID while resetting the password.

**Before you begin**

Role required: password_reset_admin or admin
About this task

Procedure

1. Navigate to Password Reset > Extensions > Identification Types.
2. Click New, enter a unique and meaningful Name and Description, and then fill in the form.

<table>
<thead>
<tr>
<th>Identification field label</th>
<th>Text to display as a label for the Identification field.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identification processor</td>
<td>Identification processor script. Choose an existing script or create your own using the Identification form processor category (extension script).</td>
</tr>
</tbody>
</table>

3. Click Submit.

Related information

Create a Password Reset extension script

Create a credential store type for Password Reset
You can create a custom credential store type if the base-system types do not meet your needs.

Before you begin
Role required: password_reset_admin or password_reset_credential_manager

Procedure

1. Navigate to Password Reset > Extensions > Credential Store Types.
2. Click New, enter a unique and meaningful Name and Description.
3. To use password reset subflows in IntegrationHub, leave the Use Flow selected. Select the subflows created for the third-party application.

Note: See Customize password reset processes and integrate third-party credential services for information on creating provider-specific subflows.

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlock user flow</td>
<td>Defines process to unlock a user.</td>
</tr>
<tr>
<td>Subflow</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Password reset flow</td>
<td>Unlocks the specified user account. Expires the current password and changes the password to the provided new password if it conforms to the password format and history policies.</td>
</tr>
<tr>
<td>Password change flow</td>
<td>Changes the password of an authenticated and unlocked user account to the provided new password. Verifies the new password conforms to the password format and history policies. Displays an error if the user is not authenticated or is locked out. Use the Password Reset flow to unlock a locked user account and require a password change.</td>
</tr>
<tr>
<td>Get user lock state flow</td>
<td>Retrieves the lock status of a local ServiceNow user account.</td>
</tr>
<tr>
<td>Connection test flow</td>
<td>Defines how to test the connection.</td>
</tr>
</tbody>
</table>

4. To use the password reset workflows in Orchestration, clear the **Use Flow** check box.

**Note:** You may need to configure the form to see the Get user lock state workflow and the Unlock user workflow.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Reset workflow</td>
<td>Subflow that defines the credential store processing. Password Reset workflows are available to use as a model. Provide scripts for each of the activities defined for the subflow. For more information about how to create a workflow, see Create a workflow. For installed workflows, see Installed with Password Reset.</td>
</tr>
<tr>
<td>Connection test workflow</td>
<td>Subflow that defines how to test the connection. Connection test workflows are available to use as a model. If you create a connection test subflow, provide scripts for each of the activities defined for the subflow. For installed workflows, see Installed with Password Reset.</td>
</tr>
<tr>
<td>Get user lock state workflow</td>
<td>Subflow that defines how to get the user lock state. Get user lock state workflows are available to use as a model. Provide scripts for each of the activities defined for the subflow. For</td>
</tr>
</tbody>
</table>
Unlock user workflow

Subflow that defines how to unlock a user. Unlock user workflows are available to use as a model. If you create a connection test subflow, provide scripts for each of the activities defined for the subflow. For installed workflows, see Installed with Password Reset.

5. Click Submit.

Password Reset script includes

The Password Reset plugin installs script includes that implement password reset processes. To enable you to extend functionality, each base-system script include provides extension points that you can use to invoke "extension scripts" that you customized.

The extension script category refers to the specific types of behavior for an extension script (for example, credential store, verification, identification type, or as a post-processor).

'Enrollment check' script includes

All enrollment check script includes take the following parameters and return a boolean indicating whether the user is enrolled for Password Reset.

- `params.userId`: The sys_id of the user being checked (table: [sys_user]).
- `params.verificationId`: The sys_id of the verification being checked (table: [pwd_verification]).

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdAlwaysEnrolled</td>
<td>Default check of whether a user is enrolled that always returns true.</td>
</tr>
<tr>
<td>PwdMockIsEnrolled</td>
<td>Default check of whether a user is enrolled that always returns true.</td>
</tr>
<tr>
<td>PwdQuestionsEnrollmentCheck</td>
<td>Determines whether a user has enrolled for Password Reset using security question verification.</td>
</tr>
<tr>
<td>PwdSMSEnrollmentCheck</td>
<td>Determines whether a user has enrolled for Password Reset using SMS verification.</td>
</tr>
</tbody>
</table>
Identification form processor' script includes

Identification form processor script includes provide functionality for extending identification processing.

All identification form processor script includes take the following parameters, and return the sys_id of the user that corresponds to the requested input. If the user was not identified, it returns null.

- **params.processId**: The sys_id of the calling Password Reset process (table: [pwd_process]).
- **param request**: The form request object. Fields in the form can be accessed with `request.getParameter('<element-id>')`. The supported request parameter is `sysparm_user_id`, the user identifier value entered in the form.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdIdentifyViaEmail</td>
<td>Verifies a user's identity by checking the email address.</td>
</tr>
<tr>
<td>PwdIdentifyViaUsername</td>
<td>Verifies a user's identity by checking the user name.</td>
</tr>
</tbody>
</table>

Enrollment form processor' script includes

Enrollment form processor script includes provide functionality for extending enrollment form processing.

All enrollment form processor script includes take the following parameters, and return a boolean indicating whether the user was successfully enrolled.

- **params.userId**: The sys_id of the user trying to enroll (table: [sys_user]).
- **params.verificationId**: The sys_id of the verification used to enroll (table: [pwd_verification]).
- **params.enrollmentId**: The sys_id of this enrollment process.
- **request**: The form request object. Fields in the form can be accessed with `request.getParameter('<element-id>')`.

You should add the following information to the state of the enrollment process:

- `gs.getSession().putProperty("result.status",status)`: Whether the user was successfully enrolled.
- `gs.getSession().putProperty("result.message",message)`: An associated message to be returned to the UI, such as a detailed error message.
- `gs.getSession().putProperty("result.value",value)`: A custom value associated with the enrollment.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdEnrollQuestionsProcessor</td>
<td>Handles questions and answers for verification.</td>
</tr>
<tr>
<td>PwdEnrollSampleProcessor</td>
<td>Provides an enrollment processor for sample verification.</td>
</tr>
<tr>
<td>PwdEnrollSMSProcessor</td>
<td>Provides an enrollment processor for SMS verification.</td>
</tr>
</tbody>
</table>

**'User account lookup' script includes**

User account lookup script includes return the credential store account_id for a given user.

The following parameter returns the credential store account_id for a given user.

- `params.userId`: The sys_id of the user being checked (table: `[sys_user]`).

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdDefaultUserAccountLookup</td>
<td>Provides a default script for user account lookup from a user_id to the account in a credential store. The default mapping is to use the user name as the account name.</td>
</tr>
</tbody>
</table>

**'Password generator' script includes**

Password generator script includes take the following parameter, and return an auto-generated string password.

- `params.credentialStoreId`: The sys_id of the calling Password Reset process (table: `[pwd_process]`).

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdDefaultAutoGenPassword</td>
<td>Generates a password from a random word and 4 digits.</td>
</tr>
</tbody>
</table>

**'Verification processor' script includes**

If the user identity is verified, the verification processor script includes return `true`.

Verification processor script includes take the following parameters:
• `params.resetRequestId`: The sys_id of the current Password Reset request (table: [pwd_reset_request]).

• `params.userId`: The sys_id of the user to be verified (table: [sys_user]).

• `params.verificationId`: The sys_id of the verification (table: [pwd_verification]).

• `request`: The form request object. Access the fields in the form with `request.getParameter('<element-id>')`.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdVerifyPersonalDataConfirmationProcess</td>
<td>Verifies that the user accepts the answer.</td>
</tr>
<tr>
<td>PwdVerifyPersonalDataProcessor</td>
<td>Verifies that the user's answers match the expected data in the system.</td>
</tr>
<tr>
<td>PwdVerifyQuestionsProcessor</td>
<td>Provides question and answer verification of user input on the second page of the verification form.</td>
</tr>
<tr>
<td>PwdVerifySimpleProcessor</td>
<td>Provides simple verification of user input on the second page of the verification form.</td>
</tr>
<tr>
<td>PwdVerifySMSProcessor</td>
<td>Provides SMS verification of user input on the second page of the verification form.</td>
</tr>
</tbody>
</table>

'Post processor' script includes

Post processor script includes execute custom actions after the Password Reset process has completed.

All post processor script includes take the following parameters.

• `params.resetRequestId`: The sys_id of the current Password Reset request (table: [pwd_reset_request]).

• `params.wfSuccess`: A flag indicating whether the workflow completed successfully: True if, and only if, successful.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdPostProcessor</td>
<td>Executes actions after the process completes for success, failure, or both conditions.</td>
</tr>
</tbody>
</table>

**Related information**

- Using extension points to extend application functionality
- Using scripted extension points in server-side scripts
- Using UI extension points in server-side UI macros
- Using client extension points in client-side UI scripting

**Example custom scripts for Password Reset**

The example scripts perform a user account lookup and processes an identification form, define a credential store, and create an identification type.

**Perform a user account lookup and process an identification form**

The main script calls two extension scripts, one to perform the user account lookup, and the other to process the identification form.

```javascript
// User account lookup
var lookupExtensionSysId = getExtensionScriptSysId('SampleUserAccountLookupExtension', 'user_account_lookup');
var lookupExtension = new SNC.PwdExtensionPoint(lookupExtensionSysId);

// Setup parameters required for this extension type - userId
var params = new SNC.PwdExtensionPointParameter();
params.userId = 'joe.employee';

// Invoke the extension
var answer = lookupExtension.process(params);
gs.print('user: ' + answer);

// Form processor sample - Identification form processor
var identExtensionSysId = getExtensionScriptSysId('SampleIdentificationProcessorExtension', 'identification_form_processor');
var identificationExtension = new SNC.PwdExtensionPoint(identificationExtensionSysId);

// Setup parameters required for this extension type - processId
var params = new SNC.PwdExtensionPointParameter();
params.processId = 'pwdreq1234';

// Simulate the posted form parameter for the identification processor
```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Define a credential store

The following is an example of an extended process function in the User Account Lookup category used to define a credential store. To create this extension script, go to Password Reset > Extensions > New extension script and create a new script as described in Create an Extension Script. To configure the User Lookup in a Password Reset process, see Credential Stores.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<record_update table="sys_script_include">
  <sys_script_include action="INSERT_OR_UPDATE">
    <active>true</active>
    <client_callable>false</client_callable>
    <description>Simple account lookup that returns the supplied user id</description>
    <name>SampleUserAccountLookupExtension</name>
    <script><![CDATA[var SampleUserAccountLookupExtension = Class.create();
SampleUserAccountLookupExtension.prototype = {
  category: 'password_reset.extension.user_account_lookup', // DO NOT REMOVE THIS LINE!

  /***
   * Returns the credential-store account id for a given user
   */
]]>
```
* @param params.userId  The sys-id of the user being checked (table: sys_user)
* @return               The credential-store account-id (string) for a given user

**********/

process: function(params) {
    return params.userId;
},

type: 'SampleUserAccountLookupExtension'

};]]></script>
Create an identification type

The following is an example of an extended processForm function in the Identification Form Processor category that can be used to create an identification type. To create this extension script, go to Password Reset > Extensions > New extension script and create a new script as described in Create an Extension Script.

```xml
<?xml version="1.0" encoding="UTF-8"?
<record_update table="sys_script_include">
    <sys_script_include action="INSERT_OR_UPDATE">
        <active>true</active>
        <client_callable>false</client_callable>
        <description>Script that processes an identification form. Returns the sys-id of the user that corresponds to the requested input; if no user was found, null should be returned.</description>
        <name>SampleIdentificationProcessorExtension</name>
        <script><![CDATA[
            var SampleIdentificationProcessorExtension = Class.create();
            SampleIdentificationProcessorExtension.prototype = {
                category: 'password_reset.extension.identification_form_processor', // DO NOT REMOVE THIS LINE!

                //**********
                // Process the identification form request, and returns the user's sys_id. if user was not identified return null.
                //
                // * @param params.processId   The sys-id of the calling password-reset process (table: pwd_process)
                // * @param request            The form request object. fields in the form can be accessed using: request.getParameter('<element-id>')
                // * supported request parameters:
                //   * @return The sys-id of the user that corresponds to the requested input; if no user was found, null should be returned.
                //**********
                processForm: function(params, request) {
                    return request.getParameter('sysparm_user_id') + '_' + params.processId;
                },

                type: 'SampleIdentificationProcessorExtension'
            };
        ]]>></script>
    </sys_script_include>
</record_update>
```
Use the **process** and **processForm** extensions

This example shows a script that uses two sample extensions, one **process** extension and one **processForm** extension.

```plaintext
// User account lookup
var lookupExtensionSysId = 
getExtensionScriptSysId('SampleUserAccountLookupExtension', 'user_account_lookup');
var lookupExtension = new SNC.PwdExtensionPoint(lookupExtensionSysId);

// Setup parameters required for this extension type - userId
var params = new SNC.PwdExtensionPointParameter();
params.userId = 'joe.employee';

// Invoke the extension
var answer = lookupExtension.process(params);
```
// Form processor sample - Identification form processor
var identExtensionSysId = getExtensionScriptSysId('SampleIdentificationProcessorExtension', 'identification_form_processor'); var identificationExtension = new SNC.PwdExtensionPoint(identExtensionSysId);

// Setup parameters required for this extension type - processId
var params = new SNC.PwdExtensionPointParameter();
params.processId = 'pwdreq1234';

// Simulate the posted form parameter for the identification processor
var request = new SNC.PwdExtensionPointParameter();// A real life case will inject it's own request object
request.setParameter('sysparm_user_id', 'joe.employee');

var userIdentity = identificationExtension.processForm(params, request);
gs.print('identity: ' + userIdentity);

// Simple helper to return the sys-id for a given extension script function
function getExtensionScriptSysId(scriptName, category) {
  var result;
  var now_GR = new GlideRecord('sys_script_include');
  gr.addQuery('name', scriptName);
  gr.addQuery('script', 'CONTAINS', 'category: ' + category + '\');
  gr.query();
  if (gr.next()) {
    result = gr.getValue('sys_id');
  }
  return result;
}

process function:

```xml
<record_update table="sys_script_include" action="INSERT_OR_UPDATE"><active>true</active><client_callable>false</client_callable><description>Simple account lookup that returns the supplied user id</description><name>SampleUserAccountLookupExtension</name><script><![CDATA[
var SampleUserAccountLookupExtension = Class.create();
SampleUserAccountLookupExtension.prototype={
    category:'password_reset.extension.user_account_lookup',// DO NOT REMOVE THIS LINE!
    
    //**********
    * Returns the credential-store account id for a given user
    * @param params.userId  The sys-id of the user being checked (table: sys_user)
    * @return  The credential-store account-id (string) for a given user
]]>
```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc. in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
process:function(params){return params.userId;},

type:'SampleUserAccountLookupExtension'

**processForm function:**

```xml
<?xml version="1.0" encoding="UTF-8"?>
<record_update
table="sys_script_include">
    <sys_script_include
        action="INSERT_OR_UPDATE">
        <active>true</active>
        <client_callable>false</client_callable>
        <description>Script that processes an identification form.&#13;

        Returns the sys-id of the user that corresponds to the
        requested input; if no user was found, null should be
        returned.&#13;</description>
        <name>SampleIdentificationProcessorExtension</name>
        <script><![CDATA[
        var SampleIdentificationProcessorExtension = Class.create();
        SampleIdentificationProcessorExtension.prototype={
            category:'password_reset.extension.identification_form_processor',// DO NOT REMOVE THIS LINE!

            //************
            * Process the identification form request, and returns the user's sys_id. If user was
            * not identified return null.
            *
            * @param params.processId The sys-id of the calling password-reset process (table:
            * pwd_process)
            * @param request The form request object. Fields in the form can be accessed
            * using: request.getParameter('<element-id>')
            * Supported request parameters:
            *    sysparm_user_id - the user identifier value entered in
            *    the form.
        ]]></script>
    </sys_script_include>
</record_update>
```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Password Reset extension script categories

You can use a custom extension script to extend Password Reset functionality for credential store, verification, or identification types.

⚠️ Note: To use a script include as an extension script, you must set it to Active status.

Password Reset extension script categories

Extension scripts must specify a category that indicates which script include is being extended, for example, category: 

'password_reset.extension.enrollment_check'. The ServiceNow platform installs several scripts in each category. A script in the Enrollment check category can perform the enrollment check for a verification. Detailed information on each extension script appears in Password Reset extension scripts.
<table>
<thead>
<tr>
<th>Extension script category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enrollment check</td>
<td>Defines how to check that a user is enrolled in the Password Reset process. Scripts of this category are available in the Enrollment check field when you define a verification type (Password Reset Verification Type form).</td>
</tr>
<tr>
<td>Enrollment form processor</td>
<td>Defines how an enrollment form is processed (if automatic enrollment is not configured). Scripts of this category are available in the Enrollment form processor field when you define a verification type (Password Reset Verification Type form).</td>
</tr>
<tr>
<td>Identification form processor</td>
<td>Defines how a user identification is processed. Scripts of this category are available in the Identification processor field when you define a verification type (Password Reset Identification Type form).</td>
</tr>
<tr>
<td>Password generator</td>
<td>Defines how to generate a password. Scripts of this category are available in the Auto generate password field when you configure a credential store (Password Reset Credential Store Type form).</td>
</tr>
<tr>
<td>Post reset script</td>
<td>Executes at the end of a Password Reset process. Scripts of this category are available in the Post reset script field when you configure a process (Password Reset Process form).</td>
</tr>
<tr>
<td>User account lookup</td>
<td>Defines how to look up a user account. Scripts of this category are available in the User account lookup field when you configure a credential store (Password Reset Credential Store form).</td>
</tr>
<tr>
<td>Verification form processor</td>
<td>Defines how a verification form is processed. Scripts of this category are available in the Verification processor field when you define a verification type (Password Reset Verification Type form).</td>
</tr>
</tbody>
</table>

**Related information**

**Password Reset extension scripts**

Extension scripts allow you to extend Password Reset functionality in credential store, verification, or identification types.
Password Reset extension script includes

Each script include is associated with a specific category, which is available in the appropriate field of a Password Reset form.

> Note: Create extension scripts only from the Password Reset Extension Script form (Password Reset > Extensions > New extension script). Extension scripts are special purpose script includes that are not created in the System Definition > Script Includes interface. To use a script include as an extension script, you must set it to Active status.

'Enrollment Check' script include category

<table>
<thead>
<tr>
<th>Script include category</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
<th>Output fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enrollment Check</td>
<td>Checks whether a user is enrolled for a given verification.</td>
<td>process(params)</td>
<td>Parameters:</td>
<td>Returns:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• params.userId - The sys_id of the user to check (table: sys_user).</td>
<td>(boolean)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• params.verificationId - The sys_id of the verification to check (table: pwd_verification).</td>
<td>true, if the user is enrolled in the specified verification; otherwise, false.</td>
</tr>
</tbody>
</table>

This Enrollment Check example signals that the user is enrolled if both expected parameters are supplied. The code would be contained in the Script field of an extension script named SampleEnrollmentCheck:

```javascript
var SampleEnrollmentCheck = Class.create();
SampleEnrollmentCheck.prototype = {
  category:'password_reset.extension.enrollment_check', // DO NOT REMOVE THIS LINE!

  process: function(params)

  /**********
  * Returns boolean telling whether the user is enrolled.
  * This sample returns true if both parameters are supplied, false otherwise.
  *
  * @param params.userId The sys-id of the user being checked (table: sys_user)
  * @param params.verificationId The sys-id of the verification being checked (table: pwd_verification)
  * @return Boolean indicating whether the user is enrolled into the specified verification
```
```
process:function (params) {return (params.userId && params.verificationId)?
    true:false; },
type:'SampleEnrollmentCheck'};
```

### 'Enrollment Form Processor' script include category

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enrollment Form Processor</td>
<td>Checks whether all necessary information has been collected from the user. Stores the information so it can be used for verification when the user resets their password.</td>
<td>process(params)</td>
<td>Parameters:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• params.resetRequestId - The sys_id of the current Password Reset request (table: pwd_reset_request).</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• params.userId - The sys_id of the user to be verified (table: sys_user).</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• params.verificationId - The sys_id of the verification to be processed (table: pwd_verification).</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• request - The form request object. Fields in the form can be accessed with request.getParameter('&lt;element-id&gt;').</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The following information should be added to the state of the enrollment process:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• gs.getSession().putProperty(&quot;result.status&quot;,status) - Whether the user was successfully enrolled.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• gs.getSession().putProperty(&quot;result.message&quot;,message) - An associated message to be returned to the user, such as a detailed error message.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• gs.getSession().putProperty(&quot;result.value&quot;,value) - A custom value associated with the enrollment.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This example processes an enrollment form submission successfully if the user-submitted response was success. The code would be contained in the `Script` field of an extension script named `SampleEnrollmentProcessor`:

```javascript
var SampleEnrollmentProcessor = Class.create();
SampleEnrollmentProcessor.prototype = {
    category: 'password_reset.extension.enrollment_form_processor', // DO NOT REMOVE THIS LINE!
};
```
Process the enrollment form request, and return whether the user was successfully enrolled.

- @param params.userId The sys_id of the user trying to enroll (table: sys_user)
- @param params.verificationId The sys_id of the verification to be enrolled into (table: pwd_verification)
- @param params.enrollmentId The sys_id of this enrollment process
- @param request The form request object. Fields in the form can be accessed with
- @return boolean telling whether the user was successfully enrolled

The following information should be added to the state of the enrollment process
- gs.getSession().putProperty("result.status",status) - whether the user was successfully enrolled
- gs.getSession().putProperty("result.message",message) - an associated message to be returned
- to the UI. Eg. a detailed error message
- gs.getSession().putProperty("result.value",value) - custom value associated with the enrollment

processForm: function (params, request) {var verificationId = params.verificationId; var sampleInput = request.getParameter ('sample_input');

if (gs.nil (verificationId) || (sampleInput!= 'success')) { return false; }

var now_GR = new GlideRecord ('sys_user');
now_GR.get (params. userId);
now_GR.print ('User:' + now_GR.getValue ('user_name') + ' successfully enrolled'); return true; },

'Identification Form Processor' script include category

<table>
<thead>
<tr>
<th>Script Include category</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identification Form Processor</td>
<td>Processes an identification form request.</td>
<td>processForm(params, request)</td>
<td>Parameters:</td>
</tr>
<tr>
<td>Script include category</td>
<td>Description</td>
<td>Method signature</td>
<td>Input fields</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------</td>
<td>------------------</td>
<td>--------------</td>
</tr>
</tbody>
</table>

- **params.processId** - The sys_id of the calling Password Reset process (table: pwd_process).

- **request** - The form request object. Fields in the form can be accessed with request.getParameter('<element-id>'). Use request.getParameter('sysparm_user_id') to get the user ID that was entered in the form.

This example attempts to identify the user within the sys_user table given a user name submitted from the identification form. The code would be contained in the **Script** field of an extension script named `PwdIdentifyViaUsername`:

```javascript
var PwdIdentifyViaUsername = Class.create();
PwdIdentifyViaUsername.prototype = {
    initialize: function () {
    },

    **********
    * Process the identification form request, and returns the user's sys_id. If user was not identified return null.
    *
    * @param params.processId The sys_id of the calling Password Reset process (table: pwd_process)
    * @param request The form request object. fields in the form can be accessed with
    * request.getParameter('<element-id>')
    * Supported request parameters: sysparm_user_id - the user identifier value entered in the form
    * @return The sys_id of the user that corresponds to the requested input; if no user was found, null should be returned
    **********

    processForm: function (params, request) {
        var processId = params.processId;
        var sysparm_user_id = request.getParameter('sysparm_user_id');
        var now_GR = new GlideRecord('sys_user');
        now_GR.addQuery('user_name', sysparm_user_id);
        now_GR.query();
        if (!now_GR.next()) {
            return null;
        }
        return now_GR.sys_id;
    }

};
```
'Password Generator' script include category

<table>
<thead>
<tr>
<th>Script include category</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
<th>Output fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Generator</td>
<td>Returns an auto-generated password.</td>
<td>process(params)</td>
<td>Parameters:</td>
<td>Returns: (String) an auto-generated password.</td>
</tr>
</tbody>
</table>

This example randomly generates a password from a base word and numbers. The base word is selected depending on the credential store. The code would be contained in the Script field of an extension script named SamplePasswordGenerator:

```javascript
var SamplePasswordGenerator = Class.create();
SamplePasswordGenerator.prototype = {
    category: 'password_reset.extension.password_generator', // DO NOT REMOVE THIS LINE!

    process: function (params) {
        var basePassword;

        var now_GR = new GlideRecord('pwd_cred_store');
        now_GR.addQuery('name', 'Local ServiceNow Instance');
        now_GR.query(); if (now_GR.next()) { if (params.credentialStoreId == now_GR.getValue('sys_id'))
            basePassword = "Password"; else
            basePassword = "Dorwssap"; } return this.generateSimple(basePassword);
    },
```

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
generateSimple:function (base) {var pwd = base; var numbers = '0123456789'; var length = 4;

    for (var i = 0, n = numbers.length; i < length; i++) {
        pwd += numbers.charAt(Math.floor(Math.random() * n) + 1); } return pwd;},
type:'SamplePasswordGenerator'};

'Post Reset' script include category

<table>
<thead>
<tr>
<th>Script include category</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
<th>Output fields</th>
</tr>
</thead>
</table>
| Post Reset              | Performs additional operations after the completion of the Password Reset process. | process(params) | Parameters:
  • params.resetRequestId - The sys_id of the calling Password Reset process (table: pwd_process).
  • params.wfSuccess - A flag indicating whether the workflow completed successfully. True if, and only if, successful. | Returns: void |

This example adds failed reset requests to the system log. The code would be contained in the Script field for an extension script named PwdPostProcessor:

```javascript
var PwdPostProcessor = Class.create();

PwdPostProcessor.prototype = {
    category: 'password_reset.extension.post_reset_script', // DO NOT REMOVE THIS LINE!

    initialize:function () { },

    /**********
    * Execute custom actions after the Password Reset process has completed.
    *
    * @param params.resetRequestId The sys_id of the current Password Reset request (table: pwd_reset_request)
```
* @param params.wfSuccess  A flag indicating if the workflow completed successfully.
*  True if (and only if) successful.
* @return no return value
**********/

process: function (params) {
  if (!params.wfSuccess) {
    now_GS.log ('[PwdPostProcessor.process] failure post processing for request [' +
    params.resetRequestId + ']');
  }

  // We could place actions here that we always want executed return;
},

type:'PwdPostProcessor' }

'User Account Lookup' script include category

<table>
<thead>
<tr>
<th>Script include category</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
<th>Output fields</th>
</tr>
</thead>
</table>
| User Account Lookup    | Gets the credential store account ID for a given user. | process(params) | Parameters:
  • params.userId - The sys_id of the user being checked (table: sys_user). | Returns: (String) the credential store account ID for the given user. |

This example gets the credential store account for a user. This code would be contained in the Script field of an extension script named SampleUserAccountLookupExtension:

```javascript
var SampleUserAccountLookupExtension = Class.create();
SampleUserAccountLookupExtension.prototype = { 
  category:'password_reset.extension.user_account_lookup', // DO NOT REMOVE THIS LINE!

  **********
  * Returns the credential store account id for a given user.
  * This sample echoes the user_id supplied as the credential store account id for that user.
  *
  * @param params.userId The sys_id of the user being checked (table: sys_user)
  * @return The credential store account id (string) for a given user
  **********/
```
'Verification Form Processor' script include category

<table>
<thead>
<tr>
<th>Script include category</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
<th>Output</th>
</tr>
</thead>
</table>
| Verification Form Processor | Processes a verification form request and indicates whether the user was verified or not. | processForm(params, request) | Parameters:  
  - `params.resetRequestId` - The sys_id of the current Password Reset request (table: pwd_reset_request).  
  - `params.userId` - The sys_id of the user to be verified (table: sys_user).  
  - `params.verificationId` - The sys_id of the verification to be processed (table: pwd_verification).  
  - `request` - The form request object. Fields in the form can be accessed with `request.getParameter('<element-id>')`. | Returns: (boolean) true, if the user is verified; otherwise, false. |

This example shows a verification processor that returns true only if the user sent `ok` in the input field; otherwise, it returns false. The code would be contained in the Script field of an extension script named `SampleVerificationFormProcessor`:

```javascript
var SampleVerificationFormProcessor = Class.create();
SampleVerificationFormProcessor.prototype = {
    category:'password_reset.extension.verification_form_processor', // DO NOT REMOVE THIS LINE!

    /**********
    * Process the verification form request, and return whether the user was successfully verified.
    * This is a sample verification processor returns true only if the user sent "ok" in the input field;
    * otherwise, it returns false.

```
Related information

Extension points
- Implementing scripted extension points in custom code
- Implementing UI extension points in custom code
- Implementing client extension points in custom code

Create a Password Reset extension script

Create extension scripts only from the Password Reset Extension Script form. Do not create extension scripts in the System Definition > Script Includes interface.

Before you begin
Role required: password_reset_admin or admin

Note: To use a script include as an extension script, you must set it to Active status.

Procedure

1. Navigate to Password Reset > Extensions > New extension script.

2. Enter a name in the Extension script name field.
   Use CamelCase to construct a name without spaces, for example, PwdEnrollmentCustom.

3. Select an Extension script category.
• Enrollment check
• Enrollment form processor
• Identification form processor
• Password generator
• User account lookup
• Verification form processor

4. Click **Submit**.
   A new instance of the script include for the selected category opens.

5. Edit the script by providing an implementation in the body of the process or `processForm` function, depending on the script category. You can add additional functions as long as the process or `processForm` function accepts the defined parameters and returns the expected results.

   **Note:** Do not edit or delete the `Category` declaration.

6. Click **Update**.

**Service desk: Reset a password or unlock a user account**

In a service desk-assisted Password Reset process, service desk agents with the `password_reset_service_desk` role reset user passwords—users cannot reset passwords.

**Before you begin**

Role required: `password_reset_admin` or `password_reset_service_desk`

Watch a video example of service desk agents resetting passwords: Resetting User Passwords (Video).
Note:

• You must clear the Public access property to enable the service desk-assisted process. See Configure your Password Reset process.

• You can perform this activity on a mobile device.

Procedure

1. Navigate to Password Reset > Service Desk.

2. Select a user and the Password Reset process to use.

3. Click Verify Identity.

4. On the Verify Identity form, enter the answers that the user provides and then click Continue.

   If the user identity is verified, the Reset Password form displays identity verification and status of the account lock.

5. Perform one of the following actions.

   • If the user is not locked, the form displays the Reset password button. Enter the new password and click Reset password.

   • If the user is locked, the form displays the Reset password and Unlock account buttons. You can enter a new password and click Reset password to reset the password and unlock the account. If the Enable account unlock check box is selected for the password process, you can unlock the account without resetting the password by clicking Unlock account.

6. To reset the password for a different user, you must first navigate out of the Service Desk and then navigate to Password Reset > Service Desk.

View user requests for password reset

The Reset Requests module displays the status of each password reset request from the Password Reset Request table [pwd_reset_request].

Before you begin

Role required: password_reset_admin or password_reset_service_desk

Procedure

Navigate to Password Reset > Reset Requests.
### Password Reset request fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>User whose password is being reset or changed.</td>
</tr>
<tr>
<td>Process</td>
<td>Process that implements this password reset request.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of Password Reset request:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Change Password</strong>: Request to change a password.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Help Desk</strong>: Request opened on behalf of the requesting user by a service desk agent.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Self Service</strong>: Requesting user opened the reset request.</td>
</tr>
<tr>
<td>Action Type</td>
<td>Corrective action performed during the Password Reset request.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Change Password</strong>: Update the credential store with the new password.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Reset and Unlock Account</strong>: Generate a new password for the user and unlock the user account.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Reset Password</strong>: Generate a new password for the user.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Unlock Account</strong>: Unlock the user account.</td>
</tr>
<tr>
<td>Status</td>
<td>Result of the Password Reset request:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Completed With Failure</strong>: User completed all steps in the Password Reset process, but the password was not reset in the credential store.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Completed With Success</strong>: User completed all steps in the Password Reset process and the password was reset in the credential store.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Expired</strong>: User did not complete all steps in the Password Reset process in the time allowed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>In Progress</strong>: User is working through the steps to reset the password.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Max Number of Attempts</strong>: User failed to answer the security questions correctly during the identity verification step and has exceeded the maximum number of attempts allowed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Verified</strong>: User has completed the identity verification step and is verified. The user can move to the Password Reset step.</td>
</tr>
<tr>
<td>Active</td>
<td>Whether the request is open or closed.</td>
</tr>
<tr>
<td>Retry</td>
<td>Total number of times the user has attempted to complete a password reset request.</td>
</tr>
</tbody>
</table>
Unblock a Password Reset user

If a user is manually banned or is flagged as exceeding max attempts, the user can be blocked (not allowed to use the Password Reset application). You can unblock a blocked user.

Before you begin
Role required: password_reset_admin or password_reset_service_desk

About this task
Blocking events include:
• The user exceeded the limit for the number of failed password attempts.
• The most recent password reset occurred before the wait time required until the next reset.
• The user failed to provide the correct information while attempting to reset the password.

If the number of blocked or locked users exceeds the limit within a defined time interval, it triggers a system log event. You can configure the number of blocked or locked users and the time interval required to generate the log event by setting the password_reset.activity_monitor.incident_threshold and password_reset.activity_monitor.incident_window properties.

Procedure
1. To view the list of blocked users, navigate to Password Reset > Blocked Users.
2. To unblock a self-service user:
   a. Navigate to Password Reset > Blocked Users.
   b. Select a user from the list.
   c. Select Delete on the Actions on selected rows list.
3. To unblock a user whose password was reset by a service desk agent:
   If a user is manually banned or flagged as exceeding max attempts, the user can be blocked (not allowed to use the Password Reset application). When the password reset request is made through self-service, the user is unblocked when the password is successfully reset.

   In contrast, service desk agents are allowed any number of retries. The max_attempt_reached limit does not apply and the Blocked status for the user is not reset after the password is reset. As a result, after you successfully reset a user password, you must unblock the user manually.
If the user is not unblocked manually, then the system resets the blocked state only when the `max_attempt_window` time period elapses and the user tries to reset the password using self-service.

**a.** After you successfully reset a user password, navigate to **Password Reset > Blocked Users**.

**b.** Change the **Blocked** setting for the user from true to false.

**Related information**

Configure Password Reset properties

Password Reset and Password Change reports and logs

**Integrate Password Reset with a Service Portal widget**

You can enable a Password Reset process in a Service Portal page by adding a widget that opens the password reset pages inside the portal.

**Before you begin**

Role required: admin or sp_admin

**Procedure**

1. On the Service Portal Designer for the portal, create a new page — the page where the user will perform the password reset process.

2. On the **Widget** tab, under Layouts, select the 12-column layout and drop it onto the page.

3. Drop the **Pwd reset** widget into the 12-column layout and then save the page. The three tabs of the password reset process appear in the layout.

4. In the "Reset my password" link on the login page for the portal, specify the URL of the new password reset page. The URL must include one required parameter and may contain one optional parameter:
   - **Required**: `sysparm_show_custom_header_footer=false`. This parameter disables the native header and footer feature of the password reset page.
   - **Optional**: `sysparm_redirect_url=<portalName>?id=<pageName>`. This parameter specifies the page to go to after a successful reset — typically the login page for the portal.

For example, `https://server.acme.com/acme_community?id=password_reset_page&sysparm_show_custom_header_footer=false&sysparm_redirect_url=acme_community?id=communities_login`
Integrate Password Reset with a CMS integration

You can configure a site in the ServiceNow content management (CMS) application to define a single-site access point that includes the Password Reset service. For example, you can create an employee self-service site that provides Password Reset service.

Before you begin
Role required: content_admin

About this task
Each Password Reset process requires a separate CMS page.

Procedure
1. Navigate to Content Management > Specialty Content > iFrames and create an iFrame record.
2. Go to Content Management > Sites and create a site that has no login page.
3. Go to Content Management > Pages and create a password reset page.
4. Enter the name of the site that you created in the Content site field (Password Reset self-service in the example).
5. Right-click the form header and click Save.
6. Click the Edit Page related link and then click Add content.
7. In the Content Blocks section, select the iFrame that you created. Add more content as needed.
8. Click Update.
Password Reset and Password Change reports and logs

The Password Reset application provides several tools for monitoring and troubleshooting password reset activities.

Users with the password_reset_credential_manager or password_reset_admin role can view the status of password reset activities, identify potential security threats, and monitor for compliance with password security policies.

The Reset Requests, Activity Log, and Blocked Users modules are useful for monitoring password reset activities and for troubleshooting password reset issues. They also provide access to more detailed information than is provided on the Overview module.

To make room for new data, the system periodically purges the data that is used for password reset monitoring and reporting.

Password Reset Overview module

The Password Reset > Overview module displays reports on password reset and password change activities. Users with the password_reset_admin role can customize the layout of the reports that appear in the Overview module.

### Password Reset reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Requests (last 7 days)</td>
<td>Number of password reset requests by type during the last 7 days.</td>
</tr>
<tr>
<td>Blocked Users (last 7 days)</td>
<td>Number of users blocked over the last 7 days.</td>
</tr>
<tr>
<td>Password Reset Request Status (last 7 days)</td>
<td>Status of all password reset requests by process.</td>
</tr>
<tr>
<td>Password Reset Request by Action (last 30 days)</td>
<td>Number of password reset requests by action type: <strong>Reset Password</strong>, <strong>Unlock Account</strong>, or <strong>Reset and Unlock</strong>.</td>
</tr>
</tbody>
</table>
Password Reset reports (continued)

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Reset Top Users (last 30 days)</td>
<td>Number of password reset requests per user. Many password reset requests from a single user could indicate a security issue.</td>
</tr>
<tr>
<td>Password Reset Failed Verifications (last 7 days)</td>
<td>Number of failed verification attempts, by verification instance. A failed verification occurs when a user attempts to reset the password, but fails for one reason or another, during the identity verification step. Many failed verification attempts for a specific type of verification could indicate that the process is too complicated or unclear.</td>
</tr>
<tr>
<td>Password Reset Enrollment By Verification</td>
<td>Number of users by verification type who enrolled and did not enroll in the password reset program. A large number for users who did not enrolled could indicate a compliance or communication issue within the organization.</td>
</tr>
<tr>
<td>Password Change Top Users (last 30 days)</td>
<td>Number of password change requests per user. Many password change requests from a single user could indicate a security issue.</td>
</tr>
</tbody>
</table>

Password Reset activity log

The activity log ([Password Reset > Activity Log](#)) provides detailed information that you can use to troubleshoot and to generate reports on password reset metrics. Information contained in the activity log is stored in the Password Reset activity log [pwd_reset_activity] table.

You must have the password_reset_credential_manager or password_reset_admin role to view the log.

Password Reset event log

The event log is a valuable resource for troubleshooting. On the Start menu, click Programs (or All Programs) > Administrative Tools > Event Viewer.

If the log does not appear, then, on the Windows Logs menu, click Applications > Service Logs.

You must have the admin role to view the log.
To write to the Password Reset event log

Edit the DebugFlag registry key entry at: Computer > HKEY_LOCAL_MACHINE > SOFTWARE > Microsoft > Windows > CurrentVersion > Authentication > Credential Providers > {B6EFF27D-C1C4-481F-B81B-F3547C47D58A}

By default, the key is set to 0. Set the key to 1 to write log entries to the ServiceNowPwdReset event log.

You must have the password_reset_credential_manager or password_reset_admin role to write to the log.

Password Reset blocked user notification

You can receive email notifications when the number of users that are blocked or locked exceeds the password blocked threshold. Notifications can alert you to suspicious activities. The default threshold is 10.

To subscribe: Add an email notification device or modify an existing device and then subscribe to the Password Reset-Activity Monitor Lockout notification.

You must have the password_reset_credential_manager or password_reset_admin role to subscribe.

Schedule for purging Password Reset data

To make room for new data, the system periodically purges the data that is used for password reset monitoring and reporting. Information contained in reports and monitoring tools could change dramatically immediately after a data purge.

Users with the password_reset_credential_manager or password_reset_admin role can follow this procedure to modify the purge interval:

1. On a non-production instance: Navigate to Automated Test Framework > Administration > Table Cleanup.
2. Modify the designated tables.
3. Test all changes on the non-production instance.
4. Modify the tables on your production instance and test.

Alternatively, contact ServiceNow Technical Support to modify the purge interval.

Purge intervals for Password Reset tables

<table>
<thead>
<tr>
<th>Table name</th>
<th>Purge interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>[pwd_reset_request]</td>
<td>90 days (7,776,000 seconds).</td>
</tr>
</tbody>
</table>
Purge intervals for Password Reset tables (continued)

<table>
<thead>
<tr>
<th>Table name</th>
<th>Purge interval</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Depending on your organizational data monitoring requirements, you could configure the rule to:</td>
</tr>
<tr>
<td></td>
<td>• Purge successful requests after 90 days</td>
</tr>
<tr>
<td></td>
<td>• Keep failed requests for 120 days</td>
</tr>
<tr>
<td>[pwd_user_lockout]</td>
<td>90 days (7,776,000 seconds).</td>
</tr>
<tr>
<td></td>
<td>Depending on your organizational data monitoring requirements, you could configure the rule to:</td>
</tr>
<tr>
<td></td>
<td>• Purge successful requests after 90 days</td>
</tr>
<tr>
<td></td>
<td>• Keep failed requests for 120 days</td>
</tr>
<tr>
<td>[pwd_reset_activity]</td>
<td>90 days (7,776,000 seconds).</td>
</tr>
<tr>
<td>[pwd_activity_monitor]</td>
<td>90 days (7,776,000 seconds).</td>
</tr>
<tr>
<td>[pwd_dvc_enrollment_code]</td>
<td>1 day (86,400 seconds).</td>
</tr>
<tr>
<td>[pwd_sms_code]</td>
<td>1 day (86,400 seconds).</td>
</tr>
</tbody>
</table>

Related information

View user requests for password reset
Unblock a Password Reset user

User guide: Resetting your password

Your experience might differ, but the self-service process is a typical process that you might follow to reset your password.

Example experience of the self-service process

Your experience might differ, but here:
1. On the login page, you click the **Forgot Password?** link to start the process.

2. The Identify page opens and you enter your identifying information (typically username or email address). The example includes the default Google reCAPTCHA security feature:

3. On the Verify page, you verify your identity by providing information that proves that you are who you say you are. The admin configured the method of verification and can require multiple verifications. In the example, the admin has configured the Security Question verification. You must answer a question to prove your identity. (Earlier, while enrolling for the password reset process, you selected the question and provided a secure private answer.) Other possible verifications require you to enter a code number that was sent to a mobile device by SMS text, through the Google Authenticator app, or by email.
4. The system checks the credential store to verify your identity and then displays, on the Reset page, the new password.

Enroll in the Password Reset program

Some organizations auto-enroll users in a Password Reset program. Your organization could offer end users the option to enroll for one or more methods of verifying identity when resetting the password. End users can enroll for most Password Reset programs on a mobile device.

End users might enroll for any combination of the following methods:
Verify your identity using security questions (QA verification)

- To enroll, you choose multiple questions that only you can answer (like the name of your first pet) and then supply answers. The system stores your answers securely.
- Later, when you want to reset your password, the system presents one or more of the questions. You answer the questions to verify your identity. See

Verify your identity using an SMS code (SMS verification)

- To enroll, you authorize a device like a cellular phone for SMS verification.
- Later, when you want to reset your password, you get a code number on the device and enter the code on the web page to verify your identity.

Verify your identity using an Emailed code

- To enroll, you authorize one or more email addresses.
- Later, when you want to reset your password, the system sends a code number to the email address. You then enter the code on the web page to verify your identity.

Verify your identity using the Google Authenticator app

- You enroll on a computer that you normally use to access the instance (you use Google Authenticator to reset your password, but cannot use Google Authenticator to enroll for Password Reset Windows Application.). After you have enrolled, you load the Google Authenticator app on one or more devices and then authorize the devices for Google Authenticator verification.
- Later, when you want to reset your password, read the Google Authenticator code on your device and then enter the code on the web page to verify your identity.

Users: Enroll in the Password Reset program using questions and answers

Your organization might ask you to select the questions to use when resetting your password. You select the questions and provide answers that only you
know. At another time, when you reset your password, your answers verify your identity. You can enroll on a mobile device.

**Before you begin**
Role required: none

**About this task**
The list of questions is presented in the language that you requested while logging in.

**Procedure**
1. Navigate to **Password Reset > Enroll** and then click the **QA Verification** tab.
   If you are required to enroll for the QA verification method, then the tab is marked with an asterisk (*).
2. For each **Question** field, select a question from the list and then enter the **Answer** field. Repeat the process until the required number of **Question** and **Answer** fields are filled in.
3. Click **Submit**.
4. **Optional:** Enroll for an extra identity verification using any of the other methods that your organization offers. See:
   - Users: Enroll in the Password Reset program using SMS codes
   - Users: Enroll in the Password Reset program using Google Authenticator
   - Users: Enroll in the Password Reset program using emailed codes

**Users: Enroll in the Password Reset program using SMS codes**
To prove that you are who you say you are (verify your identity) while resetting your password, you can use a code number (the SMS code) that was delivered to your mobile phone or device. You can enroll on a mobile device.

**Before you begin**
Role required: none

**Procedure**
1. Navigate to **Password Reset > Enroll** and then click the **SMS Verification** tab.
   If your organization requires you to enroll for the SMS verification method, then the tab is marked with an asterisk (*).
2. If you had previously added an SMS-enabled device to your Password Reset profile, the device is listed. To add and verify a device, click **Add Device** and
then follow the instructions. Provide a meaningful Name for each device. Repeat the process for as many devices as you need.

3. After you verify each device, select the Authorized check box for each device that you expect to use to change or reset your password.

❗ Note: You can deauthorize a device at any time by clearing the Authorized check box.

4. Click Submit.

5. Optional: Enroll for an additional identity verification using any of the other methods that your organization offers. See:
   - Users: Enroll in the Password Reset program using questions and answers
   - Users: Enroll in the Password Reset program using Google Authenticator
   - Users: Enroll in the Password Reset program using emailed codes

**Users: Enroll in the Password Reset program using emailed codes**

To prove that you are who you say you are (verify your identity) while resetting your password, you enter a code that was sent to your email address. You can enroll for this program on a mobile device.

**Before you begin**
Role required: none

**About this task**
During this enrollment process, you add the email address, the system sends you a code so you can verify the address, and then you authorize the address to be used for the Password Reset process. By default, the system sends the code to the email address that is associated with your ServiceNow profile. You can send the code to additional email addresses.

**Procedure**

1. Navigate to Password Reset > Enroll and then click the Email Verification tab. If your organization requires you to enroll for the Email verification method, then the tab is marked with an asterisk (*). Email addresses that were added previously are listed on the tab.

2. Click Add Email, enter the Email address and a meaningful Email name to associate with the address and then click Add Email. Repeat the process for as many email addresses as you need.

3. On the Email Verification tab, for each email that should receive Password Reset codes, click Verify.
The system sends an email message with a code and then displays the **Verify the Email Address** pop-up.

4. On the **Verify the Email Address** pop-up, enter the code and click **Verify**. If this process fails, click **Send a New Code** to send a different code and try again.

5. After you verify each email address, select the **Authorized** check box for each address that you expect to use to change or reset your password.

   **Note:** To deauthorize an email address so that it does not receive Password Reset codes, clear the **Authorized** check box.

6. Click **Submit**.

7. **Optional:** Enroll for an additional identity verification using any of the other methods that your organization offers. See:
   - Users: Enroll in the Password Reset program using questions and answers
   - Users: Enroll in the Password Reset program using SMS codes
   - Users: Enroll in the Password Reset program using Google Authenticator

**Users: Enroll in the Password Reset program using Google Authenticator**

To prove that you are who you say you are (verify your identity) while resetting your password, you get a code number from Google Authenticator on your cell phone or mobile device and then enter the code on the Password Reset web page. If you already paired a device (for example, to log in to the ServiceNow instance), you can skip this enrollment process.

**Before you begin**

Role required: none

**About this task**

You cannot enroll for the Password Reset program on a mobile device.

**Procedure**

1. Navigate to **Password Reset > Enroll** and then click the **Google Authenticator Verification** tab.

   **Note:** If your organization requires you to enroll for the Google Authenticator verification method, then the tab is marked with an asterisk (*).

2. Download the Google Authenticator app to your device.

3. Open the app and then use the device to scan the QR code on the tab.
4. When the device generates a code, enter the code in the text box and then click **Pair Device**.

5. Click **Submit**.

6. **Optional:** If the system displays a success message, click **Submit**. If the system displays a failure message, enter the code again, click **Pair Device**, and then click **Submit**.

   When you submit the enrollment, the tab displays the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate New QR Code</td>
<td>Enables you to pair a device with a new code. This option is useful if you have a new device. Existing multi-factor authentication data is replaced with the new data.</td>
</tr>
<tr>
<td>Disable Multi-factor Authentication</td>
<td>Deletes existing multi-factor authentication data. The Google Authenticator verification is no longer available.</td>
</tr>
</tbody>
</table>

7. **Optional:** Enroll for an additional identity verification using any of the other methods that your organization offers. See:

   - Users: Enroll in the Password Reset program using questions and answers
   - Users: Enroll in the Password Reset program using SMS codes
   - Users: Enroll in the Password Reset program using emailed codes

---

**Instructions for users: Reset your password on Windows systems**

If your organization uses the Password Reset Windows Application, you can reset your password directly from your Windows login screen.

**Before you begin**

Role required: none
Procedure

1. Start your computer or press **Ctrl+Alt+Delete** to go to the Windows login screen.

2. Click the **Forgot Password?** link. (Your administrator may configure different text for the link.)

3. On the **Identify** page, enter the requested information and then click **Next**.
4. On the **Verify** page, enter the requested information, and then click **Next**.

    **Note:** You might be given the option to choose the method used to verify your identity.

If your identity is verified, the **Reset** page displays whether you were successfully verified and the state of your account (either locked or unlocked).

5. Based on your locked/unlocked state, perform one of the following actions:

   - If your account is not locked, the page displays the **Reset Password** button. Enter and reenter the new password and then click **Reset Password**.
   - If your account is locked, the page displays the **Reset Password** and **Unlock Account** buttons.
     - You can enter a new password and click **Reset password** to reset the password and unlock the account.
     - If your administrator has selected **Enable account unlock** for the password process, you can unlock the account without resetting the password by clicking **Unlock account**.

### Process Automation Designer

ServiceNow® Process Automation Designer enables process owners to author cross-enterprise workflows and create a single, unified process. You can also use Process Automation Designer to provide end users with a simplified, task-oriented view of your process.

#### Process Automation Designer benefits

Process Automation Designer is a Now Platform® feature that enables you, as a business process owner, to organize Flow Designer content into unified and digitized cross-enterprise processes. With Process Automation Designer, you gain these benefits:

   - Connect multiple flows and actions into an end-to-end business workflow.
   - Reuse existing Flow Designer flows, subflows, or actions to automate process activities.
   - Organize process activities in a digitized task board interface.
   - Guide end users to complete a process in a task-oriented interface, such as a playbook.
   - Consolidate separate business processes across the organization.
   - Define a consistent record life cycle from creation to completion.
   - Pass data between the activities and stages of a business process.
• Specify the conditions and the order in which activities and stages run.
• Visualize and manage the activities and stages of your process.

Creating a well-designed process
The automated business processes that you design guide your end users and help them focus on the tasks and information that matter to them. A well-designed process can do these things:

• Start up, or trigger, automatically for the types of records that your end users care about
• Reuse activities from existing Flow Designer content
• Has well-defined lanes that end users can follow for a record
• Clearly show the next steps that end users must take to move through a record’s life cycle

Process Automation Designer content
Process Automation Designer has these components:

Processes
A process is a Now Platform® representation of a cross-enterprise business process for your organization. A process owner is responsible for creating and maintaining a process.

Triggers
A trigger specifies when to start running your process.

Lanes
A lane is a grouped sequence of activities in a process. A process owner creates a lane to specify a logical grouping of activities. A lane represents one stage in your overall business process.

Activities
An activity defines the Flow Designer content that powers the process’s automation. An activity can also specify the user-facing experience that the process produces when it runs.

For more information about how to use and navigate the Process Automation Designer user interface, see Exploring Process Automation Designer.

Getting started
Before you get started with Process Automation Designer, familiarize yourself with any features that your business uses to automate operations on the Now
Platform, such as Flow Designer, business rules, and workflows. Learning about these concepts can help you avoid creating any conflicting logic in your processes.

If you’re a process owner who wants to learn the basics of digitizing your business process, check out the following resources:

• Get started with ServiceNow® Process Automation
• Get started with processes
• Design your first automated process
• View your process executions

If you’re a ServiceNow Process Automation administrator who wants to set up and customize Process Automation Designer, check out the following resources:

• Triggers
• Process definitions
• Activity definitions

**Activate Process Automation Designer**

Activate Process Automation Designer to create processes for your subscribed applications.

Each application subscription entitles you to create processes for its associated tables.

• Application tables
• Custom tables that extend the application tables
• Custom tables authorized by the application subscription

You can activate Process Automation Designer for the application that you want your processes to run in by purchasing a subscription for the appropriate application. If you already have a subscription to your application but you still can’t create processes for your application’s tables, enable the appropriate plugin.

ℹ️ **Note:** The Process Automation Designer plugins you enable determine which tables are available for you to create processes.

See the following sections to learn how to activate Process Automation Designer for your application.
Activate Process Automation Designer for App Engine

Activate Process Automation Designer on your instance to create processes triggered by Now Platform® tables.

About this task
In order to create processes in Process Automation Designer that are triggered by Now Platform tables, you must purchase a subscription to the Now Platform App Engine.

To purchase this subscription, contact your ServiceNow account manager. Your account manager can arrange to have the plugin activated on your organization's production and subproduction instances, generally within a few days.

If you don't have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps to enable the Process Automation Designer for App Engine [com.glide.pad.license] plugin:

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.
4. On the form, fill in the fields.

**Activate Plugin request form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>this plugin to be enabled</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

<table>
<thead>
<tr>
<th>Reason/Comments</th>
<th>Information that would be helpful for the ServiceNow personnel who are activating the plugin.</th>
</tr>
</thead>
</table>

5. Click **Submit**.

**Results**

You can create triggers in Process Automation Designer for **custom tables that you create**. Enabling the **Process Automation Designer for App Engine [com.glide.pad.license]** plugin lets you create processes for these tables and their **extensions**.
• Affected Cls [cmdb_outage_ci_mtom]
• Agent Capacity [awa_agent_capacity]
• Agent channel availability [awa_agent_channel_availability]
• Agent Presence [awa_agent_presence]
• Announcement [announcement]
• Assessment Category Result [asmt_category_result]
• Assessment Instance [asmt_assessment_instance]
• Assessment Metric [asmt_metric]
• Assessment Metric Template [asmt_template]
• Assessment Metric Type [asmt_metric_type]
• Assessment Metric Type Group [asmt_metric_type_group]
• Assessment Net Promoter Score [asmt_nps_result]
• Assessment Template Definition [asmt_template_definition]
• Assignment Eligibility [awa_eligibility_pool]
• Assignment Rule [awa_assignment_rule]
• Audit [cert_audit]
• Audit Result [cert_audit_result]
• AWA Agent Presence and Capacity [awa_agent_presence_capacity]
• AWA Document Size [awa_document_size]
• Base Configuration Item [cmdb]
• Building [cmn_building]
• Business Calendar [business_calendar]
• Certification Template [cert_template]
• CI Relation Filter [cmdb_rel_filter]
• CI Relationship [cmdb_rel_ci]
• CI Relationship Rollup [cmdb_rel_rollup]
• CI Relationship Type [cmdb_rel_type]
• CI/User Relationship Type [cmdb_rel_user_type]
• CIs Affected [task_ci]
• CMDB Group [cmdb_group]
• CMDB Group Event Queue [cmdb_group_event_queue]
• CMDB Group Type [cmdb_group_type]
• CMDB Health Configuration [cmdb_health_config]
• CMDB Health Metric [cmdb_health_metric]
• CMDB Health Result [cmdb_health_result]
• CMDB Health Scorecard [cmdb_health_scorecard]
• Company [core_company]
• Connection & Credential Aliases [sys_alias]
• Connection & Credential Templates [sys_alias_templates]
• Cost Center [cmn_cost_center]
• Country [core_country]
• Department [cmn_department]
• Direct Relationships [cmdb_related]
• [dms_document]
• Draft Document [draft_document]
• Follow On Task [cert_follow_on_task]
• Group [sys_user_group]
• Group Member [sys_user_grmember]
• Group Queue Priority [awa_group_queue_priority]
• Group Relationship [cmdb_rel_group]
• Group Role [sys_group_has_role]
• Group Skill [sys_group_has_skill]
• Guided Setup Task [gsw_task]
• Holiday [sys_holiday]
• Impacted CIs [task_cmdb_ci_service]
• Inbox Layout [awa_inbox_layout]
• Interaction [interaction]
• IP Address Pool [cmdb_ip_address_pool]
• IP Address Range [cmdb_ip_address_range]
• IP Address to DNS Name [cmdb_ip_address_dns_name]
• IP Service [cmdb_ip_service]
• KB Submission [kb_submission]
• Knowledge [kb_knowledge]
• Knowledge Base [kb_knowledge_base]
• Knowledge Category [kb_category]
• Knowledge Feedback [kb_feedback]
• Knowledge Feedback Task [kb_feedback_task]
• Knowledge Use [kb_use]
• Location [cmn_location]
• Metric [metric_instance]
• Model Category [cmdb_model_category]
• Offer Details [awa_offer_details]
• OS User [cmdb_os_user]
• Outage [cmdb_ci_outage]
• Page [sp_page]
• Peer Relationships [cmdb_peer]
• People Relationship [cmdb_rel_person]
• Presence State [awa_presence_state]
• Private Task [vtb_task]
• Product Model [cmdb_model]
• Queue [awa_queue]
• Related Entry [cmdb_related_entry]
• Report [sys_report]
• Role [sys_user_role]
• Roster [cmn_rota_roster]
• Rotation Escalation [cmn_rota_escalation]
• Scheduled Suite Run [sys_atf_schedule_run]
• Service [cmdb_ip_service_ci]
• Service Portal [sp_portal]
• Shift [cmn_rota]
• Shift Escalation Set [cmn_rota_escalation_set]
• Shift Escalation Step Definition [cmn_rota_esc_step_def]
• Skill Category [cmn_skill_category]
Activate Process Automation Designer for Customer Service Management (CSM)

Activate Process Automation Designer on your instance so that you can create processes triggered by CSM tables.

About this task

In order to create processes in Process Automation Designer that are triggered by CSM tables and custom tables that extend from them, you'll need to purchase a subscription to CSM.

Note: If you create a custom table such as My Table [x_my_table], you can create processes that trigger from it. However, you cannot create a process that triggers from a table belonging to another Process Automation Designer plugin.
To purchase this subscription, contact your ServiceNow account manager. Your account manager can arrange to have the plugin activated on your organization’s production and subproduction instances, generally within a few days.

If you don’t have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps to enable the Playbooks for Customer Service Management [com.sn_csm_playbook] plugin:

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. On the All Applications page, click **Request Plugin** to open the Request form on HI.

3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. On the form, fill in the fields.
## Activate Plugin request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>this plugin to be enabled</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Results**

Enabling the **Playbooks for Customer Service Management [com.sn_csm_playbook]** plugin lets you create processes for these tables and their extensions:

- Account [customer_account]
- Case [sn_customerservice_case]
- Change Request [change_request]
- Consumer [csm_consumer]
- Contact [customer_contact]
- Escalation [sn_customerservice_escalation]
• Household [csm_household]
• Incident [incident]
• Interaction [interaction]
• Order [csm_order]
• Order Line Item [csm_order_line_item]
• Problem [problem]
• Request [sc_request]
• Service Organization [sn_customer_service_organization]
• Task [sn_customerservice_task]

⚠️ Note: If you create a custom table that extends a CSM table such as Case, you can create processes that trigger from it.

Activate Process Automation Designer for Field Service Management

Activate Process Automation Designer on your instance so that you can create processes triggered by tables.

About this task

In order to create processes in Process Automation Designer that are triggered by Field Service Management tables, you must purchase a subscription to Field Service Management.

To purchase this subscription, contact your ServiceNow account manager. Your account manager can arrange to have the plugin activated on your organization’s production and subproduction instances, generally within a few days.

If you don’t have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps to enable the Playbooks for Field Service Management [com.sn_fsm_playbook] plugin:

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Note: Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.</td>
<td></td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Results**

Enabling the **Playbooks for Field Service Management [com.sn_fsm_playbook]** plugin lets you create processes for these tables and their extensions:

- Work Task Flow [sf_work_task]
- Work Order Flow [sf_work_order]
- Work Order Task [wm_Task]
- Work Order [wm_order]
- Work Order Model [cmdb_workorder_product_model]
- Work Task Model [cmdb_worktask_product_model]
- Work Type [wm_work_type]
- Agent Personal Schedule [agent_events]
- Appointment Booking [sn_apptmnt_booking_appointment_booking]
- Questionnaire [wm_questionnaire]
- Service Order Task [sm_task]
- Service Order Task Template Dependency [sm_m2m_task_template_dependency]
- Asset Usage [sm_asset_usage]
Activate Process Automation Designer for IT Service Management (ITSM)

Activate Process Automation Designer on your instance so that you can create processes triggered by ITSM tables.

About this task
In order to create processes in Process Automation Designer that are triggered by ITSM tables and custom tables that extend from them, you'll need to purchase a subscription to ITSM.

To purchase this subscription, contact your ServiceNow account manager. Your account manager can arrange to have the plugin activated on your organization's production and subproduction instances, generally within a few days.

If you don't have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps to enable the Process Automation Designer for ITSM [com.snc.itsm.playbook] plugin:

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Activate Plugin request form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Target Instance</td>
</tr>
<tr>
<td>Plugin Name</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
</tr>
<tr>
<td>Reason/Comments</td>
</tr>
</tbody>
</table>

5. Click Submit.

Results
Enabling the Process Automation Designer for ITSM [com.snc.itsm.playbook] plugin lets you create processes for these tables and their extensions:
Getting started with Process Automation

Learn how Process Automation applications can help you use the Now Platform® to transform your manual business processes into digitized, automated workflows.

ServiceNow Process Automation applications help you digitize, visualize, and manage the cross-enterprise workflows for your business. Digitizing your business processes with Process Automation applications gives you these benefits:

- Management of process compliance
- Ownership of continual process improvement
- Collaboration across divisions and departments
- Visibility into process outcomes

Process Automation applications

The ServiceNow Process Automation applications that you can use to digitize your business processes into automated workflows on the Now Platform include:

**Flow Designer**

ServiceNow® Flow Designer enables process owners to use natural language to automate approvals, tasks, notifications, and record operations without having to code. You can use the Flow Designer design environment to author flows and actions and to manage flow executions.

**Process Automation Designer**

ServiceNow® Process Automation Designer enables process owners to author cross-enterprise workflows and create a single, unified process. You can also use Process Automation Designer to provide end users with a simplified, task-oriented view of your process.

Roles involved in Process Automation

Depending on the Process Automation application that you use, you may need to coordinate with other teams or individuals to ensure that your automated processes run smoothly. One possible way in which you could organize the roles for Process Automation applications is:
A developer uses Flow Designer to work on flows, actions, and activity definitions to automate individual pieces of a business process.

A process owner uses Process Automation Designer to organize the pieces of the business process into a digitized, cross-enterprise workflow.

A Workspace administrator uses Playbook Experience to work on Playbooks to configure the appropriate views of the business process for the right system users.

An agent, the end user in this case, uses Agent Workspace to work on the individual tasks within the business process. In this case, the end user of the business process interacts with a Playbook, which is a graphical view of the business process on the Now Platform.

Learn more about Process Automation
To find out more about how you can use Flow Designer and Process Automation Designer to digitize your business processes, try checking out these resources:

- Flow Designer fundamentals course
- Flow Designer
- Getting started with processes

Getting started with processes
Learn the basics of designing an automated process for your organization. Get an overview of how processes work on the Now Platform.

Processes
Processes are Now Platform representations of your manual cross-enterprise workflows. By creating a process record on the platform, you’re digitizing
these workflows. A process has two dimensions: the process definition and the associated process executions.

**Process definitions**

A *process definition* is where a process owner configures and organizes multiple instances of Flow Designer content into a coherent business process. A process definition consists of a trigger, a sequence of lanes, and a sequence of activities.

**Process executions**

A process execution is a single, runtime instance of a process definition.

**Designing a process**

When you design your business process in Process Automation Designer, you’re creating a process definition.

Each process definition consists of a trigger as well as lanes and activities. Triggers define the conditions that, when met, start running your process. Lanes and activities represent stages and individual steps in your overall business process. In the Process Automation Designer design environment, you can organize these lanes and processes into a sequence that reflects how your business process runs.

When you’re done creating your process definition, activate it so that it runs when triggered.

![Process Definition](image)

**What happens when a process runs**

When your activated process definition is triggered, the system creates a process execution, which represents a single, running instance of your process definition.
After you create the process execution, the system evaluates each activity within your process. The system iterates through each activity in your process until the final activity finishes running, which means that the process execution is completed. As each activity runs, automated record operations occur on the Now Platform.

If a Workspace administrator has set up a Playbook experience for your process, then your process execution renders as a Playbook. A Playbook is a visual representation of your process, which is associated with a record in a Workspace.

In summary, your process runs when:

1. The system creates a process execution.
2. Any configured Workspace Playbook for your process renders for agents.
3. Automated operations on records that are associated with your process execution occur on the Now Platform.

Learn more about processes
If you’re ready to start digitizing your business process with Process Automation Designer, try checking out these resources:

• Design your first automated process
• Create a process definition

Design an automated process
Transform an example manual business process into a well-designed, automated process that runs on the Now Platform®.
Before you begin

- Enable the Process Automation Designer for App Engine [com.glide.pad.license] plugin with a subscription to the Now Platform App Engine. For more information, see Activate Process Automation Designer.
- Follow the steps to Configure a Playbook user experience.
- Ensure that your current application is set to Global. For more information, see Application picker.
- Role required: admin or pd_admin

About this task

In the following procedure, you can step through an example of how to digitize a manual business process on the Now Platform using Process Automation Designer. In this example, you can use Process Automation Designer to standardize and automate how Service Desk agents handle chat interactions with VIP users.

The manual business process for this example consists of the following stages:

1. **Identify and Log:** A Service Desk agent learns of an issue that a VIP user is facing while chatting with the user in a messaging application. The Service Desk agent creates an interaction record to track this issue.

2. **Classify and Diagnose:** The Service Desk agent associates an incident record with the interaction and sets the incident’s priority to High. The agent then enters the Assigned To user for the incident.

3. **Communicate Work in Progress:** The assignee updates the incident record’s state to Work in Progress and emails the VIP user when progress is made on the incident.

4. **Resolve:** When the incident is resolved, the assignee emails the resolution information to the VIP user.

Procedure

1. Create a process named **Handle Interactions with VIPs.**


   b. In the main header, click **Create a new process.**

   c. On the form, fill in the fields.
### Field | Action
---|---
Label | Enter Handle Interactions with VIPs.
Description | Enter This process defines how Service Desk agents can handle interaction records that are created for VIP users.
Application | Select Global.

**d. Click Select a trigger.**

**e. Click the Define your own trigger conditions for when your process runs option.**

**f. From the list of trigger options, select Record Create.**

**g. Click Set your trigger conditions.**

**h. In the Table list, select Interaction [interaction].**

**i. Use the condition builder to add the following condition to your trigger:**

- ![Condition Example](https://via.placeholder.com/150)

**j. Click Go to Designer.**

The Process Automation Designer design environment appears.

### 2. Add a lane for each stage in your process.

**a. Click + Add new lane to add the first lane to your process.**

**b. In the lane properties panel's Label field, enter Classify and Diagnose.**

**Note:** Because the Identify and Log stage triggers this process, don't add a lane for that stage.

**c. In the Description field, enter Associate an incident with the interaction.**

**d. In the When to start field, leave Immediately selected, and then click Save.**
e. Click + Add new lane to add another lane to your process.

f. In the lane properties panel's Label field, enter Communicate Work in Progress.

g. In the Description field, enter Notify VIP of work in progress.

h. In the When to start field, leave After Previous selected, and then click Save.

i. Click + Add new lane to add the final lane to your process.

j. In the lane properties panel's Label field, enter Resolve.

k. In the Description field, enter Resolve incident and share resolution details.

l. In the When to start field, leave After Previous selected, and then click Save.

3. Add the Create incident from interaction activity to the Classify and Diagnose lane.

a. Under the Classify and Diagnose lane, click + Add an activity.

b. In the activity picker, select Common Activities, and then select Automated Create Record under Non-Interactive.

c. In the activity properties panel's Label field, enter Create incident from interaction.

d. In the When to start field, leave Immediately selected, and then click Save.

e. Click the Create incident from interaction activity card.

f. In the activity properties panel, click Configure activity.

g. On the Configure your activity screen, locate the Variables section under Inputs.

h. In the Table Name list, select Incident [incident].

i. From the Fields list, select Assigned To.

j. Next to the Assigned To field, select the data pill picker icon ( ).

k. Dot-walk to the Interaction record's Assigned To field by selecting Context > Input Record - interaction > Assigned To.

l. In the Fields list, select Impact and then select 2 - Moderate.

m. Under Fields, select Urgency and then select 1 - High.

n. In the Fields list, select Short Description.
o. Dot-walk to the Interaction record’s Short description field by selecting Context > Input Record - interaction > Short Description.

p. In the Fields list, select Caller.

q. Dot-walk to the Interaction record’s Opened for field by selecting Context > Input Record - interaction > Opened for.

r. In the Wait for user input field, leave No selected.

s. In the Fields to show after creation field, enter priority.

t. Click Update to finish updating the inputs for the activity.

The Create incident from interaction activity automatically maps the Assigned To and Short Description fields from the interaction record to the incident record when your process runs.

4. Add the Wait for assignee to update activity to the Communicate Work in Progress lane.

a. Under the Communicate Work in Progress lane, click + Add an activity.

b. In the activity picker, select Common Activities, and then select Wait For Condition under Interactive.

c. In the activity properties panel’s Label field, enter Wait for assignee to update.

d. In the When to start field, leave Immediately selected, and then click Save.

e. Click the Wait for assignee to update activity card.

f. In the activity properties panel, click Configure activity.

g. On the Configure your activity screen, locate the Variables section under Inputs.

h. Next to the Record field, select the data pill picker icon ( )

i. Dot-walk to the Create incident from interaction activity’s record output by selecting Activities > 1:1 - automated_create_record > Outputs > record.

j. In the Table list, select Incident [incident].
k. Use the condition builder to add the following condition to your activity:

• [Updated by][is][Activities > 1:1 - automated_create_record > Outputs > record > Assigned to].

l. Click Update to finish updating the inputs for the activity.

The Wait for assignee to update activity pauses the process until the Assigned To user for the Incident record updates the record.

5. Add the Send update to VIP activity to the Communicate Work in Progress lane.
   a. Under the Communicate Work in Progress lane, select + Add an activity.
   b. In the activity picker, select Common Activities, and then select Instruction under Default.
   c. In the activity properties panel's Label field, enter Send update to VIP.
   d. In the When to start field, leave After Previous selected, and then select Save.
   e. Click the Send update to VIP activity card.
   f. In the activity properties panel, select Configure activity.
   g. On the Configure your activity screen, locate the Variables section under Inputs.
   h. In the Message field, enter Notify the VIP user that work on their issue is in progress.
   i. Leave the Wait for user input field's value as Yes.
   j. Click Update to finish updating the inputs for the activity.
   The Send update to VIP activity prompts the agent to send an email to the VIP user when the assignee for the incident record makes an update.

6. Add the Wait for incident resolution activity to the Resolve lane.
   a. Under the Resolve lane, select + Add an activity.
   b. In the activity picker, select Common Activities, and then select Wait For Condition under Interactive.
   c. In the activity properties panel's Label field, enter Wait for incident resolution.
   d. In the When to start field, leave Immediately selected, and then click Save.
e. Click the **Wait for incident resolution** activity card.

f. In the activity properties panel, click **Configure activity**.

g. On the Configure your activity screen, locate the Variables section under Inputs.

h. Next to the **Record** field, select the data pill picker icon (🔧).

i. Dot-walk to the **Create incident from interaction** activity's **record** output by selecting **Activities > 1:1 - automated_create_record > Outputs > record**.

j. In the **Table** field, select **Incident [incident]**.

k. Use the **condition builder** to add the following condition to your activity:

   • [State][is][Resolved].

l. Select **Update** to finish updating the inputs for the activity.

The **Wait for incident resolution** activity pauses the process until the Incident’s state becomes **[Resolved]**.

7. Add the **Share resolution details with VIP** activity to the **Resolve** lane.

   a. Under the **Resolve** lane, select **+ Add an activity**.

   b. In the activity picker, select **Common Activities**, and then select **Instruction** under Default.

   c. In the activity properties panel's **Label** field, enter **Share resolution details with VIP**.

   d. In the **When to start** field, leave **After Previous** selected, and then click **Save**.

   e. Click the **Share resolution details with VIP** activity card.

   f. In the activity properties panel, click **Configure activity**.

   g. On the Configure your activity screen, locate the Variables section under Inputs.

   h. In the **Message** field, enter **Provide the Resolution Notes from the Incident record in an email to the VIP user**.

   i. Leave the **Wait for user input** field's value as **Yes**.

   j. Click **Update** to finish updating the inputs for the activity.
The **Share resolution details with VIP** activity prompts the agent to send the issue resolution details to the VIP user.

8. In the main header, click **Activate** so that your process runs when triggered.

9. View your activated process as a playbook in Workspace.

   a. Close the Process Automation Designer tab and navigate to **Workspace Experience > Agent Workspace Home**.

   b. In the side menu, click the lists icon (ಠ‿↼ಠ).

   c. In the **Lists** tab under Interactions, click **My Interactions**.

   d. In the form header, click **New**.

   e. On the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select <strong>Chat</strong></td>
</tr>
<tr>
<td>Opened for</td>
<td>Select a VIP user.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Select a user that can make updates to Incident records.</td>
</tr>
<tr>
<td>Short description</td>
<td>Enter <em>Testing out the Handle Interactions with VIPs playbook.</em></td>
</tr>
</tbody>
</table>

   f. In the form header, click **Save**.

   g. In the Contextual side panel, click the playbook icon (ಠ‿↼ಠ).

**Results**

Your process appears in the Workspace Contextual side panel as a playbook. Here, Workspace agents can get a task-oriented view of the automated business process. Agents can step through the activities that you set up to see where the record is in the overall process.
Process Automation Designer architecture

Understand how Process Automation Designer works in the Now Platform® to automate cross-functional processes and consolidate them into task-oriented views for your end users.

Process Automation Designer consists of a design time environment that lets you produce a runtime view of a record’s life cycle. The design time environment is a space where process owners can create process definitions. Meanwhile, the runtime experience is where end users, such as Workspace agents, follow the process to complete records.

Design time environment

The Process Automation Designer design time environment consists of these components:

Process definitions

A process definition is where a process owner configures and organizes multiple instances of Flow Designer content into a coherent business process. A process definition consists of a trigger, a sequence of lanes, and a sequence of activities.

Trigger definitions

A trigger definition specifies the conditions that must be met to run a process definition. A user with the admin, pd_admin, or pd_trigger_author role typically creates and configures a trigger definition that process authors can use as a template. A trigger
definition specifies the record operation and table conditions that must be met to start running a process definition. A process owner typically selects a trigger template when creating a process definition.

**Trigger instances**

A *trigger instance* is produced when you select a trigger template. The trigger instance stores the conditions that a record must meet to start running the process.

**Lanes**

A *lane* is a logical grouping of activities in a process definition. A process owner creates a lane to group activities and specify the *start rule* for when the lane should start running. A lane represents one stage in your overall business process.

**Activity definitions**

An *activity definition* maps Flow Designer inputs and outputs to an activity instance. An activity definition contains:

- The *automation plan* to map the triggering input record data to action or flow inputs
- The *activity experience* to map action or flow outputs to a user-facing view of the process definition

A user with the admin, pd_admin, or pd_content_author roles typically specifies the automation plan and activity experience when creating an activity definition.

**Activity instances**

An *activity instance* is produced when you add an activity to a process definition. The activity instance stores the automation plan data mappings from the activity definition. You can change these data mappings when the default values do not fit your process. The process can specify the start rules for when the activity should start running.

**Start rules**

A *start rule* specifies when a lane or an activity starts running. A process owner can use start rules to specify what parts of a process run simultaneously and what parts run serially.

For more information about how to use and navigate the Process Automation Designer user interface, see Exploring Process Automation Designer.
Runtime experience

Process Automation Designer produces these runtime components:

**Process executions**

A process execution stores the details of running a process definition in a context record. You can use a process execution to troubleshoot and verify that process definitions run as expected.

**Activity executions**

An activity execution stores the details of running an activity instance in a context record. You can use an activity execution to troubleshoot and verify that process definitions run as expected.

**User-facing views**

A user-facing view is a user interface that displays the output or results of a process definition, such as a Playbook. A workspace administrator can specify a user-facing view as part of setting up a Playbook experience. See Set up a Playbook.

During runtime for a process definition, your instance:

1. Evaluates any conditions specified in the trigger definition and processes the trigger.
2. Processes the event and starts running the process definition in the background.
3. Builds the automation plans from each activity into an entire process plan.
4. Runs the process plan for your process definition.
5. Stores the process execution information in the Process Execution [sys_pd_context] table.
6. Supplies data for a user-facing view of your process execution.

Data security and HTML sanitization

Process Automation Designer protects against cross-site scripting and code injection by evaluating all string data for HTML markup. The system only preserves HTML markup that is present in its inclusion list. All other HTML markup is removed from string data.

The inclusion list supports these HTML elements and attributes, which cannot be modified.
### HTML inclusion list

<table>
<thead>
<tr>
<th>HTML element</th>
<th>Included Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>class, href, target, title</td>
</tr>
<tr>
<td>abbr</td>
<td>class, title</td>
</tr>
<tr>
<td>address</td>
<td>class</td>
</tr>
<tr>
<td>area</td>
<td>alt, class, coords, href, shape</td>
</tr>
<tr>
<td>article</td>
<td>class</td>
</tr>
<tr>
<td>aside</td>
<td>class</td>
</tr>
<tr>
<td>audio</td>
<td>autoplay, class, controls, loop, preload, src</td>
</tr>
<tr>
<td>b</td>
<td>class</td>
</tr>
<tr>
<td>bdi</td>
<td>class, dir</td>
</tr>
<tr>
<td>bdo</td>
<td>class, dir</td>
</tr>
<tr>
<td>big</td>
<td>class</td>
</tr>
<tr>
<td>blockquote</td>
<td>cite, class</td>
</tr>
<tr>
<td>br</td>
<td>class</td>
</tr>
<tr>
<td>caption</td>
<td>class</td>
</tr>
<tr>
<td>center</td>
<td>class</td>
</tr>
<tr>
<td>cite</td>
<td>class</td>
</tr>
<tr>
<td>code</td>
<td>class</td>
</tr>
<tr>
<td>col</td>
<td>align, class, span, valign, width</td>
</tr>
<tr>
<td>colgroup</td>
<td>align, class, span, valign, width</td>
</tr>
<tr>
<td>dd</td>
<td>class</td>
</tr>
<tr>
<td>del</td>
<td>class, datetime</td>
</tr>
<tr>
<td>details</td>
<td>class, open</td>
</tr>
<tr>
<td>div</td>
<td>class</td>
</tr>
<tr>
<td>dl</td>
<td>class</td>
</tr>
<tr>
<td>dt</td>
<td>class</td>
</tr>
<tr>
<td>em</td>
<td>class</td>
</tr>
<tr>
<td>HTML element</td>
<td>Included Attributes</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>emp</td>
<td>class</td>
</tr>
<tr>
<td>font</td>
<td>class, color, face, size</td>
</tr>
<tr>
<td>footer</td>
<td>class</td>
</tr>
<tr>
<td>h1</td>
<td>class</td>
</tr>
<tr>
<td>h2</td>
<td>class</td>
</tr>
<tr>
<td>h3</td>
<td>class</td>
</tr>
<tr>
<td>h4</td>
<td>class</td>
</tr>
<tr>
<td>h5</td>
<td>class</td>
</tr>
<tr>
<td>h6</td>
<td>class</td>
</tr>
<tr>
<td>header</td>
<td>class</td>
</tr>
<tr>
<td>hr</td>
<td>class</td>
</tr>
<tr>
<td>html</td>
<td>class</td>
</tr>
<tr>
<td>i</td>
<td>class</td>
</tr>
<tr>
<td>img</td>
<td>alt, class, height, src, title, width</td>
</tr>
<tr>
<td>input</td>
<td>aria-label, class, type, value</td>
</tr>
<tr>
<td>ins</td>
<td>class, datetime</td>
</tr>
<tr>
<td>li</td>
<td>class</td>
</tr>
<tr>
<td>mark</td>
<td>class</td>
</tr>
<tr>
<td>nav</td>
<td>class</td>
</tr>
<tr>
<td>ol</td>
<td>class</td>
</tr>
<tr>
<td>p</td>
<td>class</td>
</tr>
<tr>
<td>pre</td>
<td>class</td>
</tr>
<tr>
<td>s</td>
<td>class</td>
</tr>
<tr>
<td>section</td>
<td>class</td>
</tr>
<tr>
<td>small</td>
<td>class</td>
</tr>
<tr>
<td>span</td>
<td>class</td>
</tr>
</tbody>
</table>
Exploring Process Automation Designer

Get an overview of the Process Automation Designer landing page and design environment.

Process Automation Designer landing page

You can view the Process Automation Designer landing page by navigating to Process Automation > Process Automation Designer. The landing page displays a list view of process definitions that are available for you to view or edit. For more information on creating a process definition to add to this list, see Getting started with processes.
Process Automation Designer gives you a simple, interactive way to design digitized, automated processes for your business in a task board view. The Process Automation Designer design environment consists of the main header, activity design space, and configuration panel.

**Main header**

The main header displays information about the process definition that you're currently designing. In the main header, you can:

- Access the properties for your process definition. For more information, see [Process definition properties](#).
- Confirm your process definition's status and activation state, created or updated date and time, and application scope.
- Activate your process definition so that it runs when triggered. For more information, see [Process definition statuses and activation states](#).

**Activity design space**

Organize activities into lanes to design your process definition.

- An activity represents one step within your overall business process. An activity can automate operations on the Now Platform, such as creating or updating records, displaying record information, and running automated actions in the background.
- A lane is a set of activities that represents one stage within your business process.
For more information, see Process Automation Designer lanes and activities.

Properties panel

The properties panel lets you set various options for your process definition, activities, and lanes. In the properties panel, you can:

• Add or edit the name for your process definition, lane, or activity.
• Add or edit the description for your process definition, lane, or activity.
• Define the start rule for your lane or activity.
• Access the configuration options for your lane or activity.

Process Automation Designer system properties

Review the system properties for Process Automation Designer. You can configure these properties to control how the system handles Process Automation Designer events.

The system properties for Process Automation Designer provide advanced configuration options for how the system handles Process Automation Designer events. To set Process Automation Designer system properties, access the System Properties [sys_properties] table.

The following system properties relate to the Process Automation Designer configuration:
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.glide.event_manager.process_automation.claim_limit</td>
<td>Number of Process Automation events that the event handler can process in a single transaction.</td>
</tr>
<tr>
<td>sn_agent_workspace.default_view_editable_tables</td>
<td>Default table views, as a comma-separated list, that you want to allow Workspace to render within a playbook card.</td>
</tr>
</tbody>
</table>

### Process definitions

Process definitions are Now Platform® representations of cross-enterprise processes for your organization. Create and activate a process definition to run your digitized business process on the Now Platform.

Each process definition that you design in Process Automation Designer has a trigger, a sequence of lanes, and a sequence of activities.

You can view your list of process definitions by navigating to Process Automation > Process Automation Designer. Clicking one of the process definitions in this list allows you to edit the process definition in Process Automation Designer. If there are no process definitions in this list, you can create a new one by clicking Create a new process. For more information on creating process definitions, see create a process definition.

### Process definition properties

After you create a process definition, you can access its properties by clicking Process properties in the Process Automation Designer main header. In the resulting Process properties screen, you can edit the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Name of the process to display to users in Process Automation Designer and the Workspace Playbook.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of what your process does.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions that must be met to run your process definition.</td>
</tr>
<tr>
<td>Run my trigger</td>
<td>Option that defines how many times your trigger can run for your process definition. Choices include:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• <strong>Once</strong>:</td>
<td>Triggers the process definition once for the life of the triggering input record.</td>
</tr>
<tr>
<td>• <strong>For each unique change</strong>:</td>
<td>Triggers the process definition for every unique update to a non-system field even if the flow is currently running.</td>
</tr>
</tbody>
</table>

**Note:** The system stores a history of every change to a record and determines whether the change is unique. For example, if an incident record's **State** field changes from **In Progress** to **On Hold**, the process definition runs. However, if the **State** field then changes back to **In Progress**, the process definition doesn’t run.

**Note:** Process definitions that have a trigger that runs **For each unique change** can produce recursions when run in a non-interactive session. When such processes make a change to the trigger record, the change meets the process definition’s trigger conditions and causes a recursion.

• **Only if not currently running**: Triggers the process definition for every unique change if a process execution is not currently running.

• **For every update**: Triggers the process definition every time the input record is updated, regardless of whether there has already been or there currently are any running process executions.
Run on extended
Option to trigger your process definition when record operations occur on tables that extend the input table. For example, if your selected table is the Task [task] table and you select this option, your process definition triggers when a Problem [problem] record is created or updated. For more information, see Process Automation Designer triggers.

Note: After you create a process definition, you can’t change the trigger’s input table or trigger type. For more information, see Process Automation Designer triggers.

Design considerations
Refer to these design considerations when working with process definitions:

Avoid duplicating business logic used in Flow Designer, Workflow, and business rules
Replace separate business logic such as business rules, flows, and workflows with a consolidated process definition. Make sure that you deactivate any external business logic you replace to avoid duplication of effort.

Ignore records added or updated by import and update sets
Record triggers ignore records added or updated by applying an update set or importing an XML file. These operations apply to the entire application or table rather than an individual record.

Create a process definition
Enable process owners to configure and organize multiple instances of Flow Designer content into an automated business process on the Now Platform®.

Before you begin
• Activate Process Automation Designer for your appropriate application.
• Familiarize yourself with the tables and relationships that your application uses for the process that you want to create.
• Make sure to familiarize yourself with any features that your business uses to automate operations on the Now Platform, such as Flow Designer, business...
rules, and workflows. Learning about these concepts can help you avoid creating any conflicting logic in your processes.

- Learn how to get started with ServiceNow® Process Automation.
- Role required: admin or pd_admin

**Procedure**


2. In the landing page's main header, click **Create a new process**. The Basic process details screen appears.

3. Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter a unique, user-facing name for your process. This name appears in user-facing views of your process, such as a Workspace playbook.</td>
</tr>
<tr>
<td>Description</td>
<td>Optionally, enter some descriptive details about your process.</td>
</tr>
<tr>
<td>Application</td>
<td>Choose an application scope that you want your process to run in. Selecting <strong>Global</strong> lets your process run in any application scope. For more information, see <strong>Application scope</strong>.</td>
</tr>
</tbody>
</table>

4. Select **Select a trigger** to go on to the next step. The Select a trigger screen appears.

5. Select one of the following options:

   - **Define your own conditions for when your process runs**: If you want to create your own custom conditions for when your process should run, select this option, choose a trigger type, and then select **Set your trigger conditions**. On the next screen, select a **Table** to trigger your process and the **Conditions** that cause your process to run. Finally, you can choose to run your trigger on extended tables. When you’re done adding conditions to your trigger, click **Go to Designer**.

   - **Choose an existing trigger**: If you want to use a trigger that has all of the conditions you need for your process, select this option. Then, choose an existing trigger from the list and select **Go to Designer**. The Process Automation Designer design environment appears.
6. Click + Add new lane to add the first lane to your process. The lane properties panel appears.

7. Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter a unique name for your lane. This name appears in user-facing views of your process, such as a Workspace playbook.</td>
</tr>
<tr>
<td>Description</td>
<td>Optionally, enter some descriptive details about your lane.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>After the lane starts, the lane runs only if specific conditions are met.</td>
</tr>
<tr>
<td>When to start</td>
<td>Choose when you want your lane to start running. Options include:</td>
</tr>
<tr>
<td></td>
<td>• After Previous: Your lane starts running as soon as all of the activities in the immediately preceding lane have a state of Skipped or Complete.</td>
</tr>
<tr>
<td></td>
<td>• Immediately: Your lane starts running as soon as your process definition is triggered. Your lane doesn't depend on the state of any preceding lanes.</td>
</tr>
<tr>
<td></td>
<td>• With Previous: Your lane starts running as soon as the immediately preceding lane starts running.</td>
</tr>
</tbody>
</table>

8. Click Save to finish adding the lane to your process. At any point while in the Process Automation Designer design environment, you can add more lanes to your process by clicking + Add new lane and then filling in the fields as described in the previous step.

9. Under your lane, click + Add an activity to add the first activity to your lane. The activity picker appears.

10. In the activity picker, search for an activity to add or select one from the list of Common Activities. To choose an activity for a custom application, first select the application and then select the activity from the resulting list within the picker.
Your selected activity appears under the lane, and the activity properties panel appears.

11. Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter a unique name for your activity. This name appears in user-facing views of your process, such as a Workspace playbook.</td>
</tr>
<tr>
<td>Description</td>
<td>Optionally, enter some descriptive details about your activity.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>After the activity starts, the activity runs only if specific conditions are met.</td>
</tr>
<tr>
<td>When to start</td>
<td>Choose when you want your activity to start running. Options include:</td>
</tr>
<tr>
<td></td>
<td>• After Previous: Your activity starts running as soon as the immediately preceding activity has a state of Skipped or Complete.</td>
</tr>
<tr>
<td></td>
<td>• Immediately: Your activity starts running as soon as its lane starts running. Your activity doesn’t depend</td>
</tr>
<tr>
<td>Field</td>
<td>Action</td>
</tr>
<tr>
<td>-------</td>
<td>--------</td>
</tr>
<tr>
<td></td>
<td>on the state of any preceding activities.</td>
</tr>
<tr>
<td></td>
<td>• <strong>With Previous</strong>: Your activity starts running as soon as the immediately preceding activity starts running.</td>
</tr>
</tbody>
</table>

12. Click **Save** to finish adding the basic details for your activity. At any point while in the Process Automation Designer design environment, you can add more activities to a lane by clicking **+ Add an activity** under the lane, and then filling in the fields as described in the previous step.

13. Click the card for the activity that you just added. The activity properties panel appears.

14. In the properties panel, click **Configure activity**. The Configure your activity screen appears.

15. In the Variables section under Inputs, add the values for the activity's inputs. You can add static data to an input by entering text next to the label for the input. To add dynamic data to an activity input, click the data pill picker icon and navigate, or dot-walk, to the data pill whose dynamic value you want to use when your activity runs. You can select dynamic data from fields in the input record. If your activity has a start rule of **After Previous**, you can also select dynamic data from the outputs of other activities in your process. For more information on dot-walking to related fields and records on the Now Platform, see [selecting fields on related tables using dot-walking](#).
16. Click **Update** to finish updating your activity’s inputs.

17. Keep adding lanes and activities according to your manual business process. For an example of how to design an entire digitized process with Process Automation Designer, see **Design an automated process**.

18. After you’ve added all of the appropriate lanes and activities to your process, click **Activate** in the main header.

Activating your process publishes it so that it runs when triggered.

**Note:** If you make changes to your process definition after activating it, the system saves your changes but deactivates your process definition. You must click **Activate** again to publish any new changes to your process definition. For more information, see **Process definition statuses and activation states**.

**Results**

When your process definition’s trigger conditions are met, your process runs. As a result, the system creates a Process Execution record and renders any previously configured user-facing views of your process, such as a Workspace playbook. For an example of how to digitize a manual business process that renders as a playbook, see **Design an automated process**.
Test a process

Verify that your process works as expected by running the process with test trigger data. Identify and resolve all errors before activating your process.

Before you begin

- Set up an application in Guided Application Creator to store Process Automation Designer content.
- Create a process definition
- Role required: admin or pd_admin

About this task

Testing a process bypasses the normal process trigger to run it with the sample data you provide. Every test you run creates or changes records on your instance. To avoid unwanted record changes, test processes on a non-production instance that contains relevant demonstration data.

Procedure

   The Process Automation Designer landing page appears.

2. Select the process you want to test.
   The process details screen appears.

3. Select Test.
   The system displays the Test your process dialog. The contents of the dialog depend on the type of trigger record your process uses.
4. Select a process trigger record to use for testing.  
   The process uses this record as if it met your process trigger conditions.

5. Select Run Test.  
   The system runs the process using the record you selected as test data. When the test is complete, the system displays options to view process execution details and a playbook preview.

6. From Process execution details, select View for information about the process state, activities run, and log messages produced.  
   The system opens a Process Execution form in a new tab.

7. From Playbook preview, select a playbook experience type, and select View.  
   The system opens a sample playbook in a new tab.

8. Identify and resolve any errors in your process. Update and test your process until it is ready for release.

What to do next  
Publish your process to a production instance and activate it.

Process definition statuses and activation states  
View your process definition's status in the Process Automation Designer main header. This status indicates whether the process definition is active or inactive.

The Status label in the main header of Process Automation Designer describes the current state of configuration changes that were made to your process definition. The status also indicates whether your process definition is active or inactive. If your process definition is active, you can add it to an end user-facing view, such as a playbook.

Process definition statuses include:

Draft  
Your process definition is inactive. Any changes that you make are automatically saved to your draft process definition.

Published  
Your process definition is active, and you can add it to an end user-facing view, such as a playbook. Any changes that you make after clicking Activate are automatically saved. However, these changes aren't activated in your published process definition until you click Activate again.
Process definition status and activation state flow

Process executions

A process execution is a single, runtime instance of a process definition. Process execution records provide runtime information about process definitions, such as the current state and input record.

A process execution represents a runtime execution of your process definition. Each time a process definition is triggered, Process Automation Designer automatically creates a record in the Process Executions [sys_pd_context] table.

To access the records for an In Progress process execution, navigate to Process Automation > Process Automation Administration > Active Processes. Alternatively, you can see the process executions for all processes that ran today by navigating to Process Automation > Process Automation Administration > Today's Executions.

Fields

By default, each process execution record contains the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the process definition that triggered this process execution</td>
</tr>
<tr>
<td>Created</td>
<td>Date and time when the process definition triggered</td>
</tr>
<tr>
<td>Input Record</td>
<td>Table name and record number that triggered this process execution</td>
</tr>
<tr>
<td>State</td>
<td>Current status of the overall process execution. For more information, see Process execution states.</td>
</tr>
</tbody>
</table>

Process execution states

A process execution record can have one of the following states:
<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queued</td>
<td>The process definition triggered, but the system hasn’t started running the process execution yet.</td>
</tr>
<tr>
<td>In Progress</td>
<td>The process definition triggered, and the process execution is currently running. One or more activities in the process definition have a state of Ready or In Progress.</td>
</tr>
<tr>
<td>Complete</td>
<td>The process definition triggered, and the process execution is done running. All activities in the process definition have a state of Skipped or Complete.</td>
</tr>
<tr>
<td>Error</td>
<td>The process definition triggered, but an activity has an Error state. Errors can occur when the action, subflow, or flow specified in the activity definition's automation plan fails to run.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>A user with the admin or pd_admin role explicitly canceled the process execution, and the execution has stopped running.</td>
</tr>
</tbody>
</table>

**Process Automation Designer triggers**

Process Automation Designer triggers specify when to start running your process.

In Process Automation Designer, triggers indicate when your process should start running. Each trigger has a type and conditions that, when met, start running your activated process definition.

You can choose a trigger when you create a process definition in Process Automation Designer. Start by adding a trigger, which defines the trigger type. Then, set conditions and other options to refine your trigger so that it fires in a way that makes sense for your business process. For more information, see [Create a process definition](#).

If there are no triggers that fit your use case, you can create your own trigger definition instead. For more information, see [Create a trigger definition](#).
How triggers work

1. User with the pd_admin or pd_trigger_owner role creates the new trigger.
2. Create a new process and add a trigger to your process.
3. Design and activate your process.
4. The trigger conditions are met.
5. Your process runs.

Trigger types

In your Trigger Definition [sys_pd_trigger_definition] record, you can choose a trigger type, which determines when your trigger fires. These trigger types represent record operations that can occur in the Now Platform®. The following trigger types are available in your instance by default:

**Record Created**

The process runs when a user creates a record anywhere in the Now Platform.

**Record Updated**

The process runs when a user updates an existing record anywhere in the Now Platform.

**Record Created or Updated**

The process runs when a user creates a record or updates an existing record anywhere in the Now Platform.

*Note:* Triggers only fire for record operations that are interactive, or made by users. Triggers don't fire for non-interactive record operations. For more information, see Non-interactive sessions.

Conditions to run

After you add a trigger to your process, you can then set conditions and other options that determine when and how your trigger fires.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditions</td>
<td>Use the condition builder to create field conditions for when your process runs. See Condition builder.</td>
</tr>
<tr>
<td>Run my process</td>
<td>Choose an option for when your process runs. Options include:</td>
</tr>
<tr>
<td>Option</td>
<td>Action</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• <strong>Once</strong>:</td>
<td>Triggers the process definition once for the life of the triggering</td>
</tr>
<tr>
<td></td>
<td>input record.</td>
</tr>
<tr>
<td>• <strong>For each unique change</strong>:</td>
<td>Triggers the process definition for every unique update to a non-system</td>
</tr>
<tr>
<td></td>
<td>field even if the flow is currently running.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>🔄 <strong>Note</strong>: The system stores a history of every change to a record</td>
</tr>
<tr>
<td></td>
<td>and determines whether the change is unique. For example, if an</td>
</tr>
<tr>
<td></td>
<td>incident record's <strong>State</strong> field changes from <strong>In Progress</strong> to</td>
</tr>
<tr>
<td></td>
<td><strong>On Hold</strong>, the process definition runs. However, if the <strong>State</strong></td>
</tr>
<tr>
<td></td>
<td>field then changes back to <strong>In Progress</strong>, the process definition</td>
</tr>
<tr>
<td></td>
<td>doesn't run.</td>
</tr>
<tr>
<td>• Only if not currently running:</td>
<td>Triggers the process definition for every unique change if a process</td>
</tr>
<tr>
<td></td>
<td>execution is not currently running.</td>
</tr>
<tr>
<td>• For every update:</td>
<td>Triggers the process definition every time the input record is</td>
</tr>
<tr>
<td></td>
<td>updated, regardless of whether there has already been or there</td>
</tr>
<tr>
<td></td>
<td>currently are any running process executions.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run on extended</td>
<td>Select this option to trigger the process on tables that extend from your selected table. For example, if you enable this option and select the Configuration Item [cmdb_ci] table, your process runs when record operations occur on the Server [cmdb_ci_server], Computer [cmdb_ci_computer], and other extended tables. For more information, see Table extensions and classes.</td>
</tr>
</tbody>
</table>

**Design considerations**

Refer to these design considerations when working with triggers:

**Create unique filter conditions for record triggers on the same table**

To prevent processes from overwriting each other, create unique filter conditions for each process that runs on the same table. If multiple processes on the same table have the same filter, there is no way to know the order in which the processes will run.

**Avoid duplicating triggers used in Flow Designer flows**

Process Automation Designer triggers do not override Flow Designer triggers. For both applications, when the trigger conditions are met, the automated processes run.

**Ignore records added or updated by import and update sets**

Record triggers ignore records that were added or updated by applying an update set or importing an XML file. These operations apply to the entire application or table instead of an individual record.

**Create a trigger definition**

Define the type of trigger that determines when to start running your process.

**Before you begin**

- Make sure to set your current application to the application that you want your process to run in. For more information, see Application picker.
- Role required: admin, pd_admin, or pd_trigger_author
Procedure


2. In the context header, click New.

3. On the Process Automation Designer Trigger Definition form, in the Label field, enter any label for your trigger definition. This label appears as a trigger option when you Create a process definition.

4. Next to the Trigger Type field, click the lookup using list icon (🔍).

5. In the Process Automation Designer Trigger Types list, select a trigger type to use for your trigger definition. Options include:
   - **Record Created**: The process runs when a user creates a record anywhere in the Now Platform.
   - **Record Updated**: The process runs when a user updates an existing record anywhere in the Now Platform.
   - **Record Created or Updated**: The process runs when a user creates a record or updates an existing record anywhere in the Now Platform.

   **Note**: Triggers only fire for record operations that are interactive, or made by users. Triggers don't fire for non-interactive record operations. For more information, see Non-interactive sessions.

6. Click Next to go on to the next step.

7. In the Table list, select a table whose record operations you want to trigger your process.

8. Under Condition, use the condition builder to add field conditions for when you want to trigger your process.

9. To trigger your process for tables that extend your selected table, select the Run On Extended check box. For more information, see .

10. Click Update to finish creating your trigger definition.
Results
Your trigger definition is added to the Trigger Definition [sys_pd_trigger_definition] table. You can now select your preset trigger when you Create a process definition.

Process Automation Designer lanes and activities
In Process Automation Designer, an activity represents one step in your overall business process. You can sequence many activities together in a lane, which represents one stage in your process.

Lanes
A lane represents one stage in your business process. Use lanes to sequence process activities in an order that makes sense for your cross-enterprise workflow. A lane is made up of many sequenced activities that are grouped in a logical way. In the Process Automation Designer design environment, you can add a lane to your process by clicking + Add new lane.

The visual separator for your lane depends on the start rule that you select. For example, choosing for Lane 3 to start immediately after Lane 2 causes the visual separator to appear as dotted lines. Choosing for Lane 4 to start with Lane 3 causes the visual separator to appear as a chevron. For more information, see Lane and activity properties.

Activities
In Process Automation Designer, an activity represents one step in your overall business process. In the system, an activity is one instance of an activity definition. For more information on activity instances and activity definitions, see the Process Automation Designer architecture and activity definitions.
Adding an activity to your process

In the Process Automation Designer design environment, you can add an activity to a lane by clicking **+ Add an activity**, which causes the activity picker to appear. In the activity picker, you can search for an activity to add or select one from the list of Common Activities. To choose an activity for a custom application, first select the application and then select the activity from the resulting list within the picker.

If there isn’t an activity that fits your use case, you can create your own activity definition to add to the activity picker. For more information, see **create an activity definition**.

Interactive and Non-Interactive activities

Activity categories include:

- **Interactive Activities**
  
  When an interactive activity runs, it prompts a user for input in a Workspace playbook experience. For more information, see **Interactive activities**.

- **Non-Interactive Activities**
  
  When a non-interactive activity runs, it runs entirely behind-the-scenes and requires no user input. For more information, see **Non-Interactive activities**.
Lane and activity properties

In the properties panel, you can add names, descriptions, and start rules to the lanes and activities in your process. Click the show or hide properties panel icon ( ) to show or hide the basic properties for your currently selected lane or activity. If you don’t select an activity or lane, your process definition’s properties appear in the configuration panel instead. The basic properties for each lane and activity include:

Label

You can enter a display name for your lane or activity. This name appears in any user-facing view of your process definition, such as a Workspace Playbook.

>Note: Keep your lane and activity names brief, as the system truncates long names.

Description

Optionally, enter a description for your activity or lane. This description only appears within Process Automation Designer and isn’t visible in user-facing views of your process definition.

Condition to run

Conditions that must be met to run an activity or lane. You can use data from prior activities to build conditions.

When to start

Select a start rule for when your activity or lane should start running, from the following options:

• **After Previous**: Your activity or lane starts running when the immediately preceding activity or lane has a state of Skipped or Complete.

• **Immediately**: Your activity starts running as soon as its lane starts running. Your lane starts running when your process definition is triggered. Your activity or lane doesn’t depend on the state of any preceding activities or lanes.

• **With Previous**: Your activity or lane starts running when the immediately preceding activity or lane starts running.
Activity inputs

Each activity has inputs that you can configure. Activity inputs are data that you provide so that the activity runs and performs its function appropriately. For example, the Instruction activity when a Message input, whose data displays a message within a Workspace Playbook card. You can view each activity's inputs by opening the properties panel for the activity and clicking Configure activity. On the Configure your activity screen, the activity's inputs appear in the Variables section under Inputs.
Creating static and dynamic values for activity inputs

You can add static data to an input by entering text next to the label for the input. To add dynamic data to an activity input, click the data pill picker icon ( cười ) and navigate, or dot-walk, to the data pill whose dynamic value you want to use when your activity runs. You can select dynamic data from fields in the input record. If your activity has a start rule of After Previous, you can also select dynamic data from the outputs of other activities in your process. For more information on dot-walking to related fields and records on the Now Platform, see selecting fields on related tables using dot-walking.
An example using static and dynamic data for the Message input

![Configure activity interface](image)

ℹ️ Note: You can dot-walk to fields in a Reference but not in a Document ID or Sys ID.

The inputs for interactive activities typically provide data that renders in a Playbook for a Workspace agent to interact with. The inputs for non-interactive activities can render in a Playbook but don’t require any user input in order to run. For more information, see Interactive activities and Non-Interactive activities.

Editing activity inputs and outputs
You can change the default inputs and outputs for an activity definition by selecting the Activity actions icon (:flexbox:) on an activity, and then selecting Edit subflow in Flow Designer or Edit action in Action Designer. For more information on how to work with the default inputs and outputs for activities in Process Automation Designer, see Create an action as an activity automation plan.

ℹ️ Note: You must have the appropriate user roles to access Flow Designer and Action Designer. For more information, see User access to Flow Designer.

Design considerations
Refer to these design considerations when working with lanes and activities:

Keep Now Platform state models in mind when designing your process
Some record types already have state models that describe their life cycle. Use any existing state model as a template for the design of your process. For more information, see State Management.

Create Task activity
Create a task record from previously gathered or generated data.

Roles and availability
- This activity is available as a Process Automation Designer common activity. Users with the admin, pd_admin, pd_author, or pd_content_author can add this activity to a process definition.

Inputs
Open the activity properties panel and configure your activity to add values for the following inputs.

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data from prior activities to build the conditions to run this activity.</td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With Previous - the activity runs at the same time as the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• After Previous - the activity only runs after the previous activity completes running</td>
</tr>
</tbody>
</table>
### Input | Type | Description
--- | --- | ---
Immediately - the activity runs immediately without waiting for other activities

<table>
<thead>
<tr>
<th>Assigned To</th>
<th>Reference.User [sys_user]</th>
<th>User responsible for completing the task associated with the activity.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>String</td>
<td>Summary of the task to complete.</td>
</tr>
<tr>
<td>Wait for user input</td>
<td>Choice</td>
<td>Option to pause the process until the end user manually completes or skips the activity.</td>
</tr>
</tbody>
</table>

### Advanced inputs
After configuring the required inputs for your activity, you can also choose to configure advanced inputs. On the Configure your activity screen, select **Advanced View** to display these advanced inputs. The advanced view also lets you access the Activity Experience section. In this section, you can set values for the activity's properties and components that render in user-facing views of your process. For more information, see [Activity experience](#).

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment Group for this Process Step</td>
<td>Reference.Group [sys_user_group]</td>
<td>Assignment group allowed to perform this process activity.</td>
</tr>
<tr>
<td>Assigned to this Process Step</td>
<td>Reference.User [sys_user]</td>
<td>User allowed to perform this process activity.</td>
</tr>
<tr>
<td>Task Table</td>
<td>Table Name</td>
<td>Name of the task table extension in which you want to create a task.</td>
</tr>
<tr>
<td>Add Field</td>
<td>Template Value</td>
<td>Field values to assign when creating the task record.</td>
</tr>
</tbody>
</table>
### Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fields to show after creation</td>
<td>String</td>
<td>Comma-separated list of fields to display for a created record.</td>
</tr>
<tr>
<td>Wait for Task completion</td>
<td>True/False</td>
<td>Pause the process until the created Task record is complete.</td>
</tr>
</tbody>
</table>

### Outputs

These outputs can provide data to other activities in your process. You can access this data as activity inputs when you configure your activity:

<table>
<thead>
<tr>
<th>Output</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table Name</td>
<td>Table containing new record.</td>
</tr>
<tr>
<td>Record</td>
<td>Reference.Task[task]</td>
<td>Reference to record created.</td>
</tr>
</tbody>
</table>

### Instruction activity

Display a simple message to guide end users through your process.

### Roles and availability

- This activity is available as a Process Automation Designer common activity. Users with the admin, pd_admin, pd_author, or pd_content_author can add this activity to a process definition.

### Inputs

Open the activity properties panel and configure your activity to add values for the following inputs:

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome.</td>
</tr>
<tr>
<td>Input</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data from prior activities to build the conditions to run this activity.</td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include • With Previous - the activity runs at the same time as the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• After Previous - the activity only runs after the previous activity completes running • Immediately - the activity runs immediately without waiting for other activities</td>
</tr>
<tr>
<td>Message</td>
<td>String</td>
<td>Message text to display to end users.</td>
</tr>
<tr>
<td>Wait for user input</td>
<td>Choice</td>
<td>Option to pause the process until the end user manually completes or skips the activity.</td>
</tr>
</tbody>
</table>

### Outputs

These outputs can provide data to other activities in your process. You can access this data as activity inputs when you configure your activity:

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Reference to the record associated with the activity.</td>
</tr>
</tbody>
</table>
**Placeholder activity**
Display an activity card in Process Automation Designer to indicate what a future activity does.

**Roles and availability**
- This activity is available as a Process Automation Designer common activity. Users with the admin, pd_admin, pd_author, or pd_content_author can add this activity to a process definition.

**Inputs**
Open the activity properties panel and configure your activity to add values for the following inputs.

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Choice</td>
<td>Activities that you can select to replace the placeholder.</td>
</tr>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome. You can use this input to describe the activity needed to replace this placeholder.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data from prior activities to build the conditions to run this activity.</td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With Previous - the activity runs at the same time as the previous activity.</td>
</tr>
<tr>
<td>Input</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>• After Previous - the activity only runs after the previous activity completes running</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Immediately - the activity runs immediately without waiting for other activities</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Outputs**
This activity does not produce output.

**Design considerations**

**Add placeholders activities to skip activity configuration**

Process designers can use placeholder activities to communicate the intent of an activity or process without having to do any configuration. Process designers can defer configuration to another time or delegate the configuration to another user who may better understand the process data model.

**Edit placeholder activities to replace them with other activities**

Placeholder activities help process designers create process definitions, but do not produce any output or advance a process when run. Edit Placeholder activities when you are ready to replace them with another activity type and configure them.

**User Form activity**

Display a form in a user-facing view to collect input values for your process.

**Roles and availability**

• This activity is available as a Process Automation Designer common activity. Users with the admin, pd_admin, pd_author, or pd_content_author can add this activity to a process definition.

**Inputs**

Open the activity properties panel and configure your activity to add values for the following inputs.
<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data from prior activities to build the conditions to run this activity.</td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With Previous - the activity runs at the same time as the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• After Previous - the activity only runs after the previous activity completes running</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Immediately - the activity runs immediately without waiting for other activities</td>
</tr>
<tr>
<td>Table</td>
<td>Table Name</td>
<td>Table containing activity or process data.</td>
</tr>
<tr>
<td>Record</td>
<td>Reference</td>
<td>Reference to the record you want to display.</td>
</tr>
<tr>
<td>Form View</td>
<td>String</td>
<td>Form view to use for data collection. If you don’t provide a form view, the system uses the default view.</td>
</tr>
</tbody>
</table>
## Advanced inputs
After configuring the required inputs for your activity, you can also choose to configure advanced inputs. On the Configure your activity screen, select Advanced View to display these advanced inputs. The advanced view also lets you access the Activity Experience section. In this section, you can set values for the activity's properties and components that render in user-facing views of your process. For more information, see Activity experience.

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment Group</td>
<td>Reference.Group [sys_user_group]</td>
<td>Group responsible for completing the task associated with the activity.</td>
</tr>
<tr>
<td>Assigned To</td>
<td>Reference.User [sys_user]</td>
<td>User responsible for completing the task associated with the activity.</td>
</tr>
<tr>
<td>Display Fields</td>
<td>String</td>
<td>Comma-separated list of fields to display above the user form.</td>
</tr>
<tr>
<td>Footer</td>
<td>String</td>
<td>Footer text to display to end users.</td>
</tr>
<tr>
<td>Show Attachments</td>
<td>True/False</td>
<td>Option to include attachments in the user form.</td>
</tr>
<tr>
<td>Input</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show SLA</td>
<td>True/False</td>
<td>Option to show SLA countdown details for the task.</td>
</tr>
<tr>
<td>Show Checklist</td>
<td>True/False</td>
<td>Option to show record checklist items.</td>
</tr>
</tbody>
</table>

### Outputs

These outputs can provide data to other activities in your process. You can access this data as activity inputs when you configure your activity:

<table>
<thead>
<tr>
<th>Output</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table Name</td>
<td>Name of the table associated with the activity.</td>
</tr>
<tr>
<td>Record</td>
<td>Reference.Task[task]</td>
<td>Reference to the record associated with the activity.</td>
</tr>
</tbody>
</table>

### Interactive activities

An interactive activity prompts a user for input in a Workspace playbook experience when your process runs.

An interactive activity requires user input and can’t proceed to completion without processing that user input. Agents can provide input for an interactive activity within an activity card for a Workspace Playbook. For example, if your activity requires a user to enter work notes for a record, you can configure the activity inputs to prompt a Workspace agent to add work notes information in the Playbook card.
To learn how to design a process with interactive activities, see design an automated process.

**Advanced Instruction activity**

Display detailed instructions to guide end users through your process.

**Roles and availability**

- This activity is available as a Process Automation Designer common activity. Users with the admin, pd_admin, pd_author, or pd_content_author can add this activity to a process definition.

**Inputs**

Open the activity properties panel and configure your activity to add values for the following inputs.

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data from prior activities to build the conditions to run this activity.</td>
</tr>
<tr>
<td>Input</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With Previous - the activity runs at the same time as the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• After Previous - the activity only runs after the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Immediately - the activity runs immediately without waiting for other</td>
</tr>
<tr>
<td></td>
<td></td>
<td>activities</td>
</tr>
<tr>
<td>Title</td>
<td>String</td>
<td>Title displayed to end users.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Details to display in the message to end users.</td>
</tr>
<tr>
<td>Wait for user input</td>
<td>Choice</td>
<td>Option to pause the process until the end user manually completes or skips</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the activity.</td>
</tr>
</tbody>
</table>

**Advanced inputs**

After configuring the required inputs for your activity, you can also choose to configure advanced inputs. On the Configure your activity screen, select **Advanced View** to display these advanced inputs. The advanced view also lets you access the Activity Experience section. In this section, you can set values for the activity's properties and components that render in user-facing views of your process. For more information, see [Activity experience](#).

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment Group</td>
<td>Reference.Group</td>
<td>Group responsible for completing the task</td>
</tr>
</tbody>
</table>
## Checklist Task activity

Pause the process and prompt the end user to complete all items in a task checklist.

## Roles and availability

- This activity is available as a Process Automation Designer common activity. Users with the admin, pd_admin, pd_author, or pd_content_author can add this activity to a process definition.

## Inputs

Open the activity properties panel and configure your activity to add values for the following inputs.

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
</tbody>
</table>

## Outputs

These outputs can provide data to other activities in your process. You can access this data as activity inputs when you configure your activity:

<table>
<thead>
<tr>
<th>Output</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Reference.Task [task]</td>
<td>Reference to the record associated with the activity.</td>
</tr>
<tr>
<td>Input</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data from prior activities to build the conditions to run this activity.</td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With Previous - the activity runs at the same time as the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• After Previous - the activity only runs after the previous activity completes running</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Immediately - the activity runs immediately without waiting for other activities</td>
</tr>
<tr>
<td>Checklist Template</td>
<td>Reference.Task [task]</td>
<td>Checklist template used to complete the task.</td>
</tr>
<tr>
<td>Task</td>
<td>Reference.Task [task]</td>
<td>Reference to the Task record to update.</td>
</tr>
<tr>
<td>Show SLA</td>
<td>True/False</td>
<td>Option to show SLA countdown details for the task.</td>
</tr>
<tr>
<td>Can Skip</td>
<td>True/False</td>
<td>Option to allow end users to skip this activity and continue the process.</td>
</tr>
</tbody>
</table>
**Advanced inputs**
After configuring the required inputs for your activity, you can also choose to configure advanced inputs. On the Configure your activity screen, select **Advanced View** to display these advanced inputs. The advanced view also lets you access the Activity Experience section. In this section, you can set values for the activity's properties and components that render in user-facing views of your process. For more information, see Activity experience.

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skip Assignment Group</td>
<td>Reference.Group [sys_user_group]</td>
<td>Group that is allowed to skip this activity when the Can Skip option is enabled.</td>
</tr>
<tr>
<td>Skip Assigned To</td>
<td>Reference.User [sys_user]</td>
<td>User that is allowed to skip this activity when the Can Skip option is enabled.</td>
</tr>
</tbody>
</table>

**Outputs**
These outputs can provide data to other activities in your process. You can access this data as activity inputs when you configure your activity:

<table>
<thead>
<tr>
<th>Output</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checklist Task</td>
<td>Reference.Task [task]</td>
<td>Task record to update when this activity completes.</td>
</tr>
</tbody>
</table>

**Collect User Data activity**
Pause the process and prompt the end user to enter data for use later in the process.

**Roles and availability**
- This activity is available as a Process Automation Designer common activity.
  - Users with the admin, pd_admin, pd_author, or pd_content_author can add this activity to a process definition.

**Inputs**
Open the activity properties panel and configure your activity to add values for the following inputs.
<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data from prior activities to build the conditions to run this activity.</td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With Previous - the activity runs at the same time as the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• After Previous - the activity only runs after the previous activity completes running</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Immediately - the activity runs immediately without waiting for other activities</td>
</tr>
</tbody>
</table>

**Advanced inputs**

After configuring the required inputs for your activity, you can also choose to configure advanced inputs. On the Configure your activity screen, select **Advanced View** to display these advanced inputs. The advanced view also lets you access the Activity Experience section. In this section, you can set values for the activity’s properties and components that render in user-facing views of your process. For more information, see [Activity experience](#).
<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment Group for this Process Step</td>
<td>Reference.Group [sys_user_group]</td>
<td>Assignment group allowed to perform this process activity.</td>
</tr>
<tr>
<td>Assigned to this Process Step</td>
<td>Reference.User [sys_user]</td>
<td>User allowed to perform this process activity.</td>
</tr>
<tr>
<td>User form for data collection</td>
<td>Choice</td>
<td>Type of input form used to collect data. Options include Create Record, Create Task, Email, Manual Activity, Record Created, and Update Record.</td>
</tr>
<tr>
<td>Wait for user input</td>
<td>Choice</td>
<td>Option to pause the process until the end user manually completes or skips the activity.</td>
</tr>
</tbody>
</table>

**Outputs**

These outputs can provide data to other activities in your process. You can access this data as activity inputs when you configure your activity:

<table>
<thead>
<tr>
<th>Output</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Reference.Flow Data</td>
<td>Reference to record containing collected data.</td>
</tr>
</tbody>
</table>

**Create Record activity**

Pause the process and prompt the end user to create a record in a form view.

**Roles and availability**

- This activity is available as a Process Automation Designer common activity. Users with the admin, pd_admin, pd_author, or pd_content_author can add this activity to a process definition.

**Inputs**

Open the activity properties panel and configure your activity to add values for the following inputs.
<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data from prior activities to build the conditions to run this activity.</td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With Previous - the activity runs at the same time as the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• After Previous - the activity only runs after the previous activity completes running</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Immediately - the activity runs immediately without waiting for other activities</td>
</tr>
<tr>
<td>Table</td>
<td>Table Name</td>
<td>Table in which to insert new record.</td>
</tr>
<tr>
<td>Create Record View</td>
<td>String</td>
<td>Form view to use for record creation. If you don’t provide a form view, the system uses the default view.</td>
</tr>
<tr>
<td>Input</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Template Fields</td>
<td>Template Value</td>
<td>Field values to set during record creation.</td>
</tr>
</tbody>
</table>

**Note:** Many form views are not supported in Workspace.

### Outputs

These outputs can provide data to other activities in your process. You can access this data as activity inputs when you configure your activity:

<table>
<thead>
<tr>
<th>Output</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table Name</td>
<td>Table containing new record.</td>
</tr>
<tr>
<td>Create Record View</td>
<td>String</td>
<td>Form view used for record creation.</td>
</tr>
<tr>
<td>Record Created</td>
<td>Sys ID</td>
<td>Unique identifier of the record that this activity created.</td>
</tr>
</tbody>
</table>

### Design considerations

**Create form views for activities that you want to render in a Workspace playbook**

Use a form view to display only the fields your users need to create a record. Your view should display required fields or those fields validated by other business logic. See View Management.

**Run non-interactive activities before interactive activities**

While a Create Record activity interactively gathers data from users, it prevents the process from starting any dependent activities. For example, a Create Record activity would prevent starting **After Previous** activities, which may be in other lanes. Where possible, design your processes to run non-interactive activities before interactive activities that could block them.

**Guided Decision activity**

Choose a decision tree from your Guided Decisions framework to step agents through how to proceed with a task.
Roles and availability

This activity is available with a subscription to Customer Service Management (CSM). For more information on how to enable this activity for use in Process Automation Designer, see Activate Process Automation Designer for Customer Service Management (CSM).

Inputs

Open the activity properties panel and configure your activity to add values for the following inputs.

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data from prior activities to build the conditions to run this activity.</td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With Previous - the activity runs at the same time as the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• After Previous - the activity only runs after the previous activity completes running</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Immediately - the activity runs immediately without waiting for other activities</td>
</tr>
</tbody>
</table>
Advanced inputs
After configuring the required inputs for your activity, you can also choose to configure advanced inputs. On the Configure your activity screen, select Advanced View to display these advanced inputs. The advanced view also lets you access the Activity Experience section. In this section, you can set values for the activity’s properties and components that render in user-facing views of your process. For more information, see Activity experience.

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decision Tree</td>
<td>Reference</td>
<td>The Decision Tree [ga_decision_tree] record whose decision inputs and guidance you want to show to agents in the Workspace playbook. For more information on how to set up the Guided Decisions framework, see Guided Decisions for Customer Service Management.</td>
</tr>
<tr>
<td>Task</td>
<td>Reference</td>
<td>The triggering Case [sn_customerservice_case] record.</td>
</tr>
</tbody>
</table>

Outputs
There are no outputs for this activity.

Send Email activity
Create an email from previously gathered or generated data.

Roles and availability
- This activity is available as a Process Automation Designer common activity. Users with the admin, pd_admin, pd_author, or pd_content_author can add this activity to a process definition.

Inputs
Open the activity properties panel and configure your activity to add values for the following inputs.
<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data from prior activities to build the conditions to run this activity.</td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With Previous - the activity runs at the same time as the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• After Previous - the activity only runs after the previous activity completes running</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Immediately - the activity runs immediately without waiting for other activities</td>
</tr>
<tr>
<td>To</td>
<td>List of Users</td>
<td>Recipient list for the email.</td>
</tr>
<tr>
<td>Cc</td>
<td>List of Users</td>
<td>Cc recipient list for the email.</td>
</tr>
<tr>
<td>Subject</td>
<td>String</td>
<td>Subject of the email.</td>
</tr>
<tr>
<td>Body</td>
<td>HTML</td>
<td>Body of the email.</td>
</tr>
<tr>
<td>Wait for user input</td>
<td>Choice</td>
<td>Option to pause the process until the end user</td>
</tr>
</tbody>
</table>
### Advanced inputs
After configuring the required inputs for your activity, you can also choose to configure advanced inputs. On the Configure your activity screen, select **Advanced View** to display these advanced inputs. The advanced view also lets you access the Activity Experience section. In this section, you can set values for the activity's properties and components that render in user-facing views of your process. For more information, see [Activity experience](#).

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned To</td>
<td>Reference.User [sys_user]</td>
<td>User responsible for completing the task associated with the activity.</td>
</tr>
<tr>
<td>Assignment Group</td>
<td>Reference.Group [sys_user_group]</td>
<td>Group responsible for completing the task associated with the activity.</td>
</tr>
<tr>
<td>To Email Address</td>
<td>String</td>
<td>Comma-separated list of email addresses.</td>
</tr>
<tr>
<td>Cc Email Address</td>
<td>String</td>
<td>Comma-separated list of copied email addresses.</td>
</tr>
<tr>
<td>Bcc</td>
<td>List of Users</td>
<td>Bcc blind copy recipient list for the email.</td>
</tr>
<tr>
<td>Bcc Email Address</td>
<td>String</td>
<td>Comma-separated list of blind copied email addresses.</td>
</tr>
<tr>
<td>Target Record</td>
<td>Reference.Task [task]</td>
<td>Reference to the record that the system attaches the email to.</td>
</tr>
<tr>
<td>Table</td>
<td>Table Name</td>
<td>Table containing activity or process data.</td>
</tr>
</tbody>
</table>
Outputs
These outputs can provide data to other activities in your process. You can access this data as activity inputs when you configure your activity:

<table>
<thead>
<tr>
<th>Output</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Reference.Task[task]</td>
<td>Reference to record created.</td>
</tr>
<tr>
<td>Email</td>
<td>Reference.Notification[sys]</td>
<td>Reference to the newly created email notification record</td>
</tr>
</tbody>
</table>

Show Knowledge Article activity
Display a knowledge article to end users.

Roles and availability
- This activity is available as a Process Automation Designer common activity. Users with the admin, pd_admin, pd_author, or pd_content_author can add this activity to a process definition.

Inputs
Open the activity properties panel and configure your activity to add values for the following inputs.

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data from prior activities to build the conditions to run this activity.</td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include</td>
</tr>
</tbody>
</table>
### Advanced inputs

After configuring the required inputs for your activity, you can also choose to configure advanced inputs. On the Configure your activity screen, select **Advanced View** to display these advanced inputs. The advanced view also lets you access the Activity Experience section. In this section, you can set values for the activity's properties and components that render in user-facing views of your process. For more information, see [Activity experience](#).

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment Group</td>
<td>Reference.Group [sys_user_group]</td>
<td>Group responsible for completing the task associated with the activity.</td>
</tr>
<tr>
<td>Assigned To</td>
<td>Reference.User [sys_user]</td>
<td>User responsible for completing the task</td>
</tr>
</tbody>
</table>
### Outputs

These outputs can provide data to other activities in your process. You can access this data as activity inputs when you configure your activity:

<table>
<thead>
<tr>
<th>Output</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Reference.Task[task]</td>
<td>Reference to the record associated with the activity.</td>
</tr>
</tbody>
</table>

### Show List of Records activity

Display a list records that match a set of conditions.

### Roles and availability

- This activity is available as a Process Automation Designer common activity. Users with the admin, pd_admin, pd_author, or pd_content_author can add this activity to a process definition.

### Inputs

Open the activity properties panel and configure your activity to add values for the following inputs.

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data from prior activities to build the conditions to run this activity.</td>
</tr>
<tr>
<td>Input</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With Previous - the activity runs at the same time as the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• After Previous - the activity only runs after the previous activity completes running</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Immediately - the activity runs immediately without waiting for other activities</td>
</tr>
<tr>
<td>Table</td>
<td>Table Name</td>
<td>Table containing records you want to display to end users.</td>
</tr>
<tr>
<td>Fields to show</td>
<td>String</td>
<td>Comma-separated list of fields to display as columns of a list.</td>
</tr>
<tr>
<td>Wait for user input</td>
<td>Choice</td>
<td>Option to pause the process until the end user manually completes or skips the activity</td>
</tr>
</tbody>
</table>

**Advanced inputs**

After configuring the required inputs for your activity, you can also choose to configure advanced inputs. On the Configure your activity screen, select **Advanced View** to display these advanced inputs. The advanced view also lets you access the Activity Experience section. In this section, you can set values for the activity’s properties and components that render in user-facing views of your process. For more information, see [Activity experience](#).

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment Group</td>
<td>Reference.Group [sys_user_group]</td>
<td>Group responsible for completing the task</td>
</tr>
<tr>
<td>Input</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assigned To</td>
<td>Reference.User [sys_user]</td>
<td>User responsible for completing the task associated with the activity.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Condition Builder</td>
<td>Criteria that you want your list of records to meet.</td>
</tr>
</tbody>
</table>

**Outputs**

These outputs can provide data to other activities in your process. You can access this data as activity inputs when you configure your activity:

<table>
<thead>
<tr>
<th>Output</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Reference.Task [task]</td>
<td>Reference to the record associated with the activity.</td>
</tr>
<tr>
<td>Fields</td>
<td>String</td>
<td>Comma-separated list of system field names to display as columns in the list.</td>
</tr>
</tbody>
</table>

**Two Step Instruction activity**

Display a different message to end users based on the current activity state. You can specify an initial state message, a skipped state message, and a completed state message.

**Roles and availability**

- This activity is available as a Process Automation Designer common activity. Users with the admin, pd_admin, pd_author, or pd_content_author can add this activity to a process definition.

**Inputs**

Open the activity properties panel and configure your activity to add values for the following inputs.
<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data from prior activities to build the conditions to run this activity.</td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With Previous - the activity runs at the same time as the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• After Previous - the activity only runs after the previous activity completes running</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Immediately - the activity runs immediately without waiting for other activities</td>
</tr>
<tr>
<td>Initial Message</td>
<td>String</td>
<td>Message text to display to end users when the activity state is In Progress.</td>
</tr>
<tr>
<td>Completed Message</td>
<td>String</td>
<td>Message text to display to end users when the activity state is Completed.</td>
</tr>
<tr>
<td>Input</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Skipped Message</td>
<td>String</td>
<td>Message text to display to end users when the activity state is Skipped.</td>
</tr>
</tbody>
</table>

**Advanced inputs**

After configuring the required inputs for your activity, you can also choose to configure advanced inputs. On the Configure your activity screen, select **Advanced View** to display these advanced inputs. The advanced view also lets you access the Activity Experience section. In this section, you can set values for the activity's properties and components that render in user-facing views of your process. For more information, see [Activity experience](#).

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment Group</td>
<td>Reference.Group [sys_user_group]</td>
<td>Group responsible for completing the task associated with the activity.</td>
</tr>
<tr>
<td>Assigned To</td>
<td>Reference.User [sys_user]</td>
<td>User responsible for completing the task associated with the activity.</td>
</tr>
</tbody>
</table>

**Outputs**

These outputs can provide data to other activities in your process. You can access this data as activity inputs when you configure your activity:

<table>
<thead>
<tr>
<th>Output</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Reference.Task[task]</td>
<td>Reference to the record associated with the activity.</td>
</tr>
</tbody>
</table>

**Update Record activity**

Update a record with the field values you specify.

**Roles and availability**

- This activity is available as a Process Automation Designer common activity. Users with the admin, pd_admin, pd_author, or pd_content_author can add this activity to a process definition.
## Inputs
Open the activity properties panel and configure your activity to add values for the following inputs.

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data from prior activities to build the conditions to run this activity.</td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With Previous - the activity runs at the same time as the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• After Previous - the activity only runs after the previous activity completes running</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Immediately - the activity runs immediately without waiting for other activities</td>
</tr>
<tr>
<td>Table</td>
<td>Table Name</td>
<td>Table containing the record to update.</td>
</tr>
<tr>
<td>Record</td>
<td>Reference</td>
<td>Reference to the record you want to update.</td>
</tr>
<tr>
<td>Fields</td>
<td>Template Value</td>
<td>Field values to change during record update.</td>
</tr>
<tr>
<td>Input</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Wait for user input</td>
<td>Choice</td>
<td>Option to pause the process until the end user manually completes or skips the activity.</td>
</tr>
</tbody>
</table>

**Advanced inputs**

After configuring the required inputs for your activity, you can also choose to configure advanced inputs. On the Configure activity screen, select **Advanced View** to display these advanced inputs. The advanced view also lets you access the Activity Experience section. In this section, you can set values for the activity’s properties and components that render in user-facing views of your process. For more information, see **Activity experience**.

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment Group</td>
<td>Reference.Group</td>
<td>Group responsible for completing the task associated with the activity.</td>
</tr>
<tr>
<td></td>
<td>[sys_user_group]</td>
<td></td>
</tr>
<tr>
<td>Assigned To</td>
<td>Reference.User</td>
<td>User responsible for completing the task associated with the activity.</td>
</tr>
<tr>
<td></td>
<td>[sys_user]</td>
<td></td>
</tr>
<tr>
<td>Fields to show after update</td>
<td>String</td>
<td>Comma-separated list of fields to display for an updated record.</td>
</tr>
</tbody>
</table>

**Outputs**

These outputs can provide data to other activities in your process. You can access this data as activity inputs when you configure your activity:

<table>
<thead>
<tr>
<th>Output</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table Name</td>
<td>Table containing updated record.</td>
</tr>
<tr>
<td>Record</td>
<td>Document ID</td>
<td>Reference to record updated.</td>
</tr>
</tbody>
</table>
Design considerations

Create form views for activities that you want to render in a Workspace playbook

Use a form view to display only the fields your users need to update a record. Your view should display required fields or those fields validated by other business logic. See View Management.

Run non-interactive activities before interactive activities

If an Update Record activity interactively gathers data from users, it prevents the process from starting any dependent activities. For example, an Update Record activity would prevent starting After Previous activities, which may be in other lanes. Where possible, design your processes to run non-interactive activities before interactive activities that could block them.

Wait For Condition activity

Pause the process until a record has field values that match a set of conditions.

Roles and availability

• This activity is available as a Process Automation Designer common activity. Users with the admin, pd_admin, pd_author, or pd_content_author can add this activity to a process definition.

Inputs

Open the activity properties panel and configure your activity to add values for the following inputs.

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data from prior activities to build the conditions to run this activity.</td>
</tr>
<tr>
<td>Input</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With Previous - the activity runs at the same time as the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• After Previous - the activity only runs after the previous activity completes running</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Immediately - the activity runs immediately without waiting for other activities</td>
</tr>
<tr>
<td>Record</td>
<td>Reference</td>
<td>Reference to the record that pauses the process until conditions match.</td>
</tr>
<tr>
<td>Table</td>
<td>Table Name</td>
<td>Table containing the record to update.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Template Value</td>
<td>Criteria that a record must meet for the process to continue.</td>
</tr>
</tbody>
</table>

**Advanced inputs**

After configuring the required inputs for your activity, you can also choose to configure advanced inputs. On the Configure your activity screen, select **Advanced View** to display these advanced inputs. The advanced view also lets you access the Activity Experience section. In this section, you can set values for the activity’s properties and components that render in user-facing views of your process. For more information, see **Activity experience**.
<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>Date/Time</td>
<td>Amount of time to wait before the activity times out and its state is set to Skipped. This input requires setting the Enable timeout input.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Choice</td>
<td>Schedule used to compute duration values. This input requires setting the Enable timeout input.</td>
</tr>
</tbody>
</table>

**Outputs**

The Wait for Condition activity has no outputs.

**Non-Interactive activities**

A non-interactive activity runs entirely behind-the-scenes on the Now Platform® and doesn't require any user input.

A non-interactive activity is an entirely automated operation on the Now Platform which doesn't require any user input to proceed to completion. Non-interactive activities still render in a Workspace Playbook, but only display information to agents. Configure the activity inputs for an interactive activity so that the activity is a fully automated operation on the Now Platform.

When non-interactive activities run, they automatically proceed to completion or are skipped. For example, if your activity automatically updates the Assigned To user for a record, the Playbook card can display the newly updated Assigned To user's name to the Workspace agent, but the card's status is automatically set to Complete.
To learn how to design a process with non-interactive activities, see design an automated process.

**Automated Create Record activity**

Create a record without pausing the process to ask for user input. When the activity runs, it immediately creates the record and continues to the next activity in the process. The record must meet server-side validation rules such as data policies, business rules and dictionary-defined mandatory fields but ignores UI policies.

**Roles and availability**

• This activity is available as a Process Automation Designer common activity. Users with the admin, pd_admin, pd_author, or pd_content_author can add this activity to a process definition.

**Inputs**

Open the activity properties panel and configure your activity to add values for the following inputs.

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data</td>
</tr>
<tr>
<td>Input</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>from prior activities to build the conditions to run this activity.</td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With Previous - the activity runs at the same time as the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• After Previous - the activity only runs after the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Immediately - the activity runs immediately without waiting for other</td>
</tr>
<tr>
<td></td>
<td></td>
<td>activities</td>
</tr>
</tbody>
</table>

| Table Name                | Table Name | Table in which you want to create a new record.                              |
| Fields                    | Template Value | Field values to set during record creation.                                 |

**Outputs**

These outputs can provide data to other activities in your process. You can access this data as activity inputs when you configure your activity:

<table>
<thead>
<tr>
<th>Output</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Name</td>
<td>Table Name</td>
<td>Table containing new record.</td>
</tr>
<tr>
<td>Record</td>
<td>Reference.Task [task]</td>
<td>Reference to record created.</td>
</tr>
</tbody>
</table>
Automated Send Email activity

Create an email from previously gathered or generated data without pausing the process to ask for user input. When the activity runs, it immediately sends the email and continues to the next activity in the process.

Roles and availability

• This activity is available as a Process Automation Designer common activity. Users with the admin, pd_admin, pd_author, or pd_content_author can add this activity to a process definition.

Inputs

Open the activity properties panel and configure your activity to add values for the following inputs.

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data from prior activities to build the conditions to run this activity.</td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With Previous - the activity runs at the same time as the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• After Previous - the activity only runs after the previous activity completes running</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Immediately - the activity runs</td>
</tr>
<tr>
<td>Input</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>To</td>
<td>List of Users</td>
<td>Recipient list for the email.</td>
</tr>
<tr>
<td>Cc</td>
<td>List of Users</td>
<td>Cc recipient list for the email.</td>
</tr>
<tr>
<td>Subject</td>
<td>String</td>
<td>Subject of the email.</td>
</tr>
<tr>
<td>Body</td>
<td>HTML</td>
<td>Body of the email.</td>
</tr>
</tbody>
</table>

**Advanced inputs**

After configuring the required inputs for your activity, you can also choose to configure advanced inputs. On the Configure your activity screen, select **Advanced View** to display these advanced inputs. The advanced view also lets you access the Activity Experience section. In this section, you can set values for the activity’s properties and components that render in user-facing views of your process. For more information, see **Activity experience**.

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Email Address</td>
<td>String</td>
<td>Comma-separated list of email addresses.</td>
</tr>
<tr>
<td>Cc Email Address</td>
<td>String</td>
<td>Comma-separated list of copied email addresses.</td>
</tr>
<tr>
<td>Bcc</td>
<td>List of Users</td>
<td>Bcc blind copy recipient list for the email.</td>
</tr>
<tr>
<td>Bcc Email Address</td>
<td>String</td>
<td>Comma-separated list of blind copied email addresses.</td>
</tr>
<tr>
<td>Target Record</td>
<td>Reference.Task [task]</td>
<td>Reference to the record that the system attaches the email to.</td>
</tr>
<tr>
<td>Table</td>
<td>Table Name</td>
<td>Table containing activity or process data.</td>
</tr>
</tbody>
</table>
Outputs
These outputs can provide data to other activities in your process. You can access this data as activity inputs when you configure your activity:

<table>
<thead>
<tr>
<th>Output</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Reference.Task[task]</td>
<td>Reference to record created.</td>
</tr>
<tr>
<td>Email</td>
<td>Reference.Notification[sys_event]</td>
<td>Reference to the newly created email notification record</td>
</tr>
</tbody>
</table>

Automated Update Record activity
Update a record without pausing the process to ask for user input. When the activity runs, it immediately updates the record and continues to the next activity in the process. The record must meet server-side validation rules such as data policies, business rules and dictionary-defined mandatory fields but ignores UI policies.

Roles and availability
- This activity is available as a Process Automation Designer common activity. Users with the admin, pd_admin, pd_author, or pd_content_author can add this activity to a process definition.

Inputs
Open the activity properties panel and configure your activity to add values for the following inputs.

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data from prior activities to...</td>
</tr>
<tr>
<td>Input</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>build the conditions to run this activity.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With Previous - the activity runs at the same time as the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• After Previous - the activity only runs after the previous activity completes running</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Immediately - the activity runs immediately without waiting for other activities</td>
</tr>
<tr>
<td>Record</td>
<td>Reference</td>
<td>Reference to the record you want to update.</td>
</tr>
<tr>
<td>Table</td>
<td>Table Name</td>
<td>Table containing the record to update.</td>
</tr>
<tr>
<td>Fields</td>
<td>Template Value</td>
<td>Field values to change during record update.</td>
</tr>
</tbody>
</table>

**Outputs**
These outputs can provide data to other activities in your process. You can access this data as activity inputs when you configure your activity:

<table>
<thead>
<tr>
<th>Output</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table Name</td>
<td>Table containing updated record.</td>
</tr>
<tr>
<td>Record</td>
<td>Reference,Task[task]</td>
<td>Reference to record updated.</td>
</tr>
</tbody>
</table>
Look Up Records activity
Find system records that match a set of conditions.

Roles and availability
• This activity is available as a Process Automation Designer common activity. Users with the admin, pd_admin, pd_author, or pd_content_author can add this activity to a process definition.

Inputs
Open the activity properties panel and configure your activity to add values for the following inputs.

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>String</td>
<td>Title to display as activity and playbook card.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>Information to display about activity usage or outcome.</td>
</tr>
<tr>
<td>Condition to run</td>
<td>Condition Builder</td>
<td>Criteria that must be met to run the activity. You can use the output data from prior activities to build the conditions to run this activity.</td>
</tr>
<tr>
<td>When to start</td>
<td>Choice</td>
<td>Option to specify when the activity runs. Options include</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With Previous - the activity runs at the same time as the previous activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• After Previous - the activity only runs after the previous activity completes running</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Immediately - the activity runs</td>
</tr>
</tbody>
</table>
immediately without waiting for other activities

Table Name
Table whose records you want to look up

Condition Builder
Criteria that you want your list of records to meet.

Advanced inputs
After configuring the required inputs for your activity, you can also choose to configure advanced inputs. On the Configure your activity screen, select Advanced View to display these advanced inputs. The advanced view also lets you access the Activity Experience section. In this section, you can set values for the activity’s properties and components that render in user-facing views of your process. For more information, see Activity experience.

Order by
Field you want to use to sort a list of records.

Sort Type
Option to sort records alphabetically or reverse alphabetically.

Max Results
Maximum number of results to display to end users.

Outputs
These outputs can provide data to other activities in your process. You can access this data as activity inputs when you configure your activity:

Records
References to the records that meet your specified conditions

Count
Number of records found
Activity definitions

Activity definitions describe how the activities in your process definition get the data that they need when your process runs.

Activity definitions provide default configurations and values for your activities so that they can run properly when your process definition is triggered. Each activity definition contains some basic configuration details, as well as an automation plan and activity experience.

The Activity Definition [sys_pd_activity_definition] table lists the definitions for the activities that you can add to a process definition in Process Automation Designer. To access these activity definitions, navigate to Process Automation > Process Automation Administration > Activity Definitions.

Fields
Each activity definition record has these basic fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Name of the activity to display to users in Process Automation Designer.</td>
</tr>
<tr>
<td>Table</td>
<td>Name of the table whose records the activity can access as inputs. Typically, this table is either the Task [task] or Global [global] table.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that the activity can run in.</td>
</tr>
<tr>
<td>Accessible From</td>
<td>Options include:</td>
</tr>
<tr>
<td></td>
<td>* All application scopes - Users can access this activity from any application scope.</td>
</tr>
<tr>
<td></td>
<td>* This application scope only - Users can access this activity from the application scope that you specify in the Application field only.</td>
</tr>
<tr>
<td>Description</td>
<td>Optional description for the activity.</td>
</tr>
</tbody>
</table>

Automation plan
Each activity definition has an automation plan. The automation plan for an activity definition specifies:
• The Flow Designer flow or action, which drives the activity's automation
• The activity's inputs, which are the data that the activity needs to run your process

Activity designers can configure the visibility of each activity input.

**Include in standard modal**

Hides the input from the properties panel. Process designers can only see the input from the standard modal when they select the **Show advanced properties** option.

**Include in standard modal and configuration panel**

Displays the input in the properties panel. Process designers can also see the input from the standard modal when they select the **Show advanced properties** option.

**Admin visibility only**

Hides the input from users who do not have the admin or pd_admin roles.

**Activity experience**

Each activity also has an optional activity experience. The activity experience specifies an experience type, associated record, and details for what data to render in the activity's associated Workspace Playbook card. Activity experience configurations only apply to activities that you add to a process definition which has an associated Playbook user experience in a Workspace. For more information, see [Set up Playbook Experiences](#).

**Experience type**

An experience type defines the data, or properties, that describe how the activity renders as a Workspace Playbook card at runtime. For example, a Record experience type tells the system that the activity can display a title, tagline, description, footer, and service level agreement (SLA) information in the Playbook card when your activated process runs. For more information, see [Experience types](#).

**Associated record**

The associated record defines the record whose data can render within a Playbook card at runtime. The associated record is dynamic, which means that it changes frequently as the process progresses. Because of this dynamic nature, you may want to use the data pill picker (🔗) to map the associated record to output.
record data within the underlying subflow or action specified in the automation plan.

**Data to render in the Playbook card**

You can specify the data to render in the Playbook card in the sections under the Associated Record section. To add dynamic data to fields that render in this user-facing view, use the data pill picker next to a data field and navigate, or dot-walk, to the appropriate data pill. The data pill should point to data within the subflow or action specified in the activity definition's automation plan.

**Note:** An activity experience contains many sections where you can specify the data to appear within the Playbook card. These sections vary depending on the experience type that you select. For example, a Record experience type has Details, Form, Attachments, and Features sections, while a Knowledge experience type has Knowledge, Details, and Features sections. For more information, see [Experience types](#).

**Actions to render in the Playbook card**

You can specify the Playbook actions that you want to render in an activity's Playbook card using the Playbook Experience Action Assignment Map related list. A Playbook action displays as a button in the Playbook card's footer. Playbook actions can run server scripts, dispatch client actions, or render UI components. For more information, see [Custom Playbook actions](#).

To add a Playbook action to your activity definition, select **New** in the Playbook Experience Action Assignment Map related list. Then, choose a Playbook action from the Action Assignment list. Next, choose a Playbook user experience that you want the Playbook action to appear in from the Playbook Experience list, and then click **Submit**.

**Design considerations**

Refer to these design considerations when working with activity definitions:

**Avoid calling triggered Flow Designer flows in an activity’s automation plan**

To prevent unintentionally running a flow outside of Process Automation Designer, you can use only subflows or actions in activity automation plans. Alternatively, you can set the flow's trigger to only run if not already running. For more information, see [Flow trigger types](#).
Specify default input values in your activity definitions

Preconfiguring default input values for your activity definitions reduces the time and complexity needed for a process owner to create a process definition.

Create an action as an activity automation plan

Create an example action to configure and run as an activity from Process Automation Designer.

Before you begin

Role required:

- This task requires some knowledge of creating flows in the Flow Designer environment. For more information, see Flow Designer.
- This task requires some knowledge of server-side scripting. For more information, see Server-side scripting.
- admin

About this task

Each activity definition requires an automation plan to run Flow Designer content. The automation plan tells Process Automation Designer what input values to use when running an action or subflow. An automation plan can specify static default values or can prompt process owners to provide dynamic values when they add an activity to a process.

In this example, you create a reusable Flow Designer action to use as an activity’s automation plan. The action you create associates a Task [task] record with a parent record.

Procedure

2. In the main header, click + New > Action.
   The Action Properties screen appears.
3. In the Action Properties screen, fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter Associate Record with Parent.</td>
</tr>
<tr>
<td>Application</td>
<td>Leave Global selected.</td>
</tr>
<tr>
<td>Accessible From</td>
<td>Leave All application scopes selected.</td>
</tr>
</tbody>
</table>
4. Click **Submit**.
   The Flow Designer design environment appears.

5. Under the Action Outline, click **Inputs**.

6. In the Action Input header, click **+ Create Input**, and then fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter Record.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter record.</td>
</tr>
<tr>
<td>Type</td>
<td>Select Reference.Task[task]</td>
</tr>
</tbody>
</table>

7. In the Action Input header, click **+ Create Input**, and then fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter Parent Record.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter record.</td>
</tr>
<tr>
<td>Type</td>
<td>Select Reference.Task[task]</td>
</tr>
</tbody>
</table>

8. Click the add a new step icon (➕).
   The Select Step to add screen appears.

9. Under ServiceNow Data, select the **Update Record** step.
   The **Update Record** step appears in the Action Outline under Inputs.

10. In the **Record** field, click the data pill picker icon (🔍), and then dot-walk to **Inputs > Record**.

11. Under Field Values, click **+Add Field Value**, and then select **Parent** from the list.

12. Next to the **Parent** field, click the data pill picker icon (🔍), and then dot-walk to **Inputs > Parent Record**.

13. Under the Action Outline, click **Outputs**.

14. Under Action Output, click **+ Create Output**, and then fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter Record.</td>
</tr>
<tr>
<td>Field</td>
<td>Action</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Name</td>
<td>Enter record</td>
</tr>
<tr>
<td>Type</td>
<td>Select <strong>Reference.Task[task]</strong></td>
</tr>
</tbody>
</table>

**15.** In the Action Output header, click **+ Create Output**, and then fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter <strong>Parent Record</strong></td>
</tr>
<tr>
<td>Name</td>
<td>Enter record</td>
</tr>
<tr>
<td>Type</td>
<td>Select <strong>Reference.Task[task]</strong></td>
</tr>
</tbody>
</table>

**16.** In the Action Output header, click **Exit Edit Mode**.

**17.** Next to the **Record** output’s Value column, click the data pill picker icon ( ), and then dot-walk to **Inputs > Record**

**18.** Next to the **Parent Record** output’s Value column, click the data pill picker icon ( ), and then dot-walk to **Inputs > Parent Record**.

**19.** In the main header, click **Save > Publish** to make your action available to add to an activity definition’s automation plan.

**Results**
You can now add your custom Flow Designer action to an automation plan for your custom activity definition.

**What to do next**
Add your custom action to an automation plan when you **Create an activity definition**.

**Create an activity definition**
Specify the action or subflow you want an activity to run. Configure the inputs you want process designers to set when adding the activity to a process. Select the experience you want end users to have when the activity runs.
Before you begin

- Create a Flow Designer subflow or action that you want to use as the automation plan for your activity. For example, see Create an action as an activity automation plan.
- Make sure to set your current application to the application that you want your activity to run in. For more information, see Application picker.
- Role required: admin, pd_admin, or pd_content_author

Procedure

1. To start creating a new activity definition, do one of the following:
   - Follow the steps to Create a process definition. Then in the Process Automation Designer activity design space, click Add an activity > Create a new activity.

   The Activity Definition form view appears.

2. Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter a unique name for your activity. This name appears in the Process Automation Designer design environment as well as in any user-facing views of your process, such as a Workspace playbook.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table whose records the activity can access as inputs. When adding inputs to your activity in Process Automation Designer, you can dot-walk to dynamic record data from this table. See Dot-walking to data in related tables.</td>
</tr>
</tbody>
</table>

Note: The table specified for a process definition's triggering input record overrides the activity definition table at design time. See Process Automation Designer triggers.
<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Optionally, enter some descriptive details about your activity.</td>
</tr>
<tr>
<td>Accessible From</td>
<td>Choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• All application scopes - You can add this activity to a process definition in any application scope.</td>
</tr>
<tr>
<td></td>
<td>• This application scope only - You can only add this activity to process definitions within the same application scope specified in the Application field.</td>
</tr>
</tbody>
</table>

3. Under the Automation Plan section next to the **Flow or Action** field, click the lookup documents using list icon (🔍). The Select the document screen appears.

4. In the Table Name list, select one of the following options:
   - To use a Flow Designer subflow to automate your activity, select **Flow**.
   - To use a Flow Designer action to automate your activity, select **Action Type**.

   **Note:** You can only use published actions or subflows for an activity definition’s automation plan.

5. Next to the **Document** field, click the lookup documents using list icon (🔍). The Flows or Action Types screen appears.

6. From the list, select the subflow or action that you want to use to automate your activity. Then, click **OK**.

7. From the list, select an experience type for the properties and components that you want your activity to use when it renders in a user-facing view of your process. For more information, see **Experience types**.

8. Click **Submit** to save and create your activity definition record. The Activity Definitions list view appears.

9. Under the **Label** column in the list, select your activity definition. The Activity Definition form view appears.

10. Select the Automation Plan section. The system displays the available variables for the action or subflow. Process Automation Designer displays a variable for each action or subflow input.
11. For each variable, configure the default value you want each variable to have.
   Leave a variable blank when you want a process designer to configure the value when adding the activity to a process.

12. For each variable, select where it is visible.

<table>
<thead>
<tr>
<th>Visibility</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include in standard modal</td>
<td>Only displays the variable as an input from the Advanced properties modal.</td>
</tr>
<tr>
<td>Include in standard modal and configuration panel</td>
<td>Displays the variable as an input in the properties panel and the Advanced properties modal.</td>
</tr>
<tr>
<td>Admin visibility only</td>
<td>Only displays the variable as an input from the Advanced properties modal to users that have the admin or pd_admin roles.</td>
</tr>
</tbody>
</table>

Process designers can only set values for variables that they have access to.

13. Select the Activity Experience section.

14. For Experience Type field, select the lookup documents using list icon (🔍). The Activity Types list appears.

15. Under the Associated Record section, select values for the Associated table and Associated record fields.
   These values are typically Record and Table Name outputs for the Flow Designer subflow or action specified in your activity's automation plan. For example, you can click the data pill picker icon (🔍) next to the Associated record field and dot-walk to the Table Name output by selecting VL > My Activity > Outputs > Record.
   The system associates a record with your activity so that, when the activity runs, it knows which record's data to output.
16. If you want to set up the default activity data that renders in user-facing views of your process, enter the values for that data in the other sections under Activity Experience. The sections and fields that appear under Activity Experience vary depending on the experience type that you select. For more information, see Experience types.

17. Click **Update** to finish creating your activity definition.

**Results**
You can now select your custom activity from the activity picker in the Process Automation Designer design environment. Select the appropriate application scope for your activity to view it in the picker.
Experience types

An experience type describes what properties and components to use when an activity renders as a card in a Workspace playbook.

When creating an activity definition, you must select an experience type to associate your activity definition with. Process Automation Designer comes with the following experience types that are available in your instance by default:

- Approval
- Catalog Item
- Create Record
- Instructional
- Knowledge
- List
- Notification
- Record

Depending on the experience type that you choose, different sections and fields appear under the activity definition’s Activity Experience. These sections
and fields let you set up the activity data that renders in user-facing views of your process, such as a Workspace Playbook.

⚠️ **Note:** Each experience type also displays an Associated Record section. For more information on how to set up the Associated Record section for an activity definition, see [Create an activity definition](#).

**Approval**

If you choose the Approval experience type, the following sections appear in the Activity Experience section for your activity definition:

- **Record**
  - Displays the following fields:
    - Record fields

- **Details**
  - Displays the following fields:
    - Tagline
    - Icon
    - Title
    - Description
    - Footer

- **Form**
  - Displays the following fields:
    - Form View
    - Form fields

- **Attachments**
  - Displays the following fields:
    - Attachment source
    - Attachments read only

- **Features**
  - Displays the following fields:
    - Is Automated
Catalog Item
If you choose the Catalog Item experience type, the following sections appear in the Activity Experience section for your activity definition:

Service Catalog
Displays the following fields:
• Service Catalog Table
• Service Catalog Record

Details
Displays the following fields:
• Tagline
• Description
• Record fields
• Footer

Form
Displays the following fields:
• Form View
• Form fields

Attachments
Displays the following fields:
• Attachment source

Features
Displays the following fields:
• Show SLA
• Show Checklist
• Is Automated

Create Record
If you choose the Create Record experience type, the following sections appear in the Activity Experience section for your activity definition:

Details
Displays the following fields:
- Tagline
- Icon
- Title
- Description
- Pending State Title
- Pending State Description
- Record fields
- Footer

**Form**

Displays the following fields:
- Form View
- Form fields

**Attachments**

Displays the following fields:
- Attachment source
- Attachments read only

**Features**

Displays the following fields:
- Show SLA
- Show Checklist
- Is Automated

**Guided Decision**

ℹ️ **Note:** The Guided Decision experience type is available with a subscription to Customer Service Management (CSM). For more information on how to enable this activity for use in Process Automation Designer, see [Activate Process Automation Designer for Customer Service Management (CSM)](#).

If you choose the Guided Decision experience type, the following fields appear in the Activity Experience section for your activity definition:

- Decision Tree Execution
- Decision Tree
**Instructional**

If you choose the Instructional experience type, the following sections appear in the Activity Experience section for your activity definition:

**Details**

Displays the following fields:
- Tagline
- Icon
- Title
- Description
- Footer

**Features**

Displays the following fields:
- Is Automated

**Knowledge**

If you choose the Knowledge experience type, the following sections appear in the Activity Experience section for your activity definition:

**Knowledge**

Displays the following fields:
- Knowledge Table
- Knowledge Record

**Details**

Displays the following fields:
- Title
- Footer

**Features**

Displays the following fields:
- Is Automated

**List**

If you choose the List experience type, the following sections appear in the Activity Experience section for your activity definition:
Details
Displays the following fields:
• Tagline
• Icon
• Title
• UI View

List Details
Displays the following fields:
• List Title
• Record fields
• Max Columns

Table Details
Displays the following fields:
• Table
• Query
• Columns
• Row Count

Features
Displays the following fields:
• Is Automated

Notification
If you choose the Notification experience type, the following sections appear in the Activity Experience section for your activity definition:

Form
Displays the following fields:
• To
• Subject
• Body

Features
Displays the following fields:
  • Is Automated

**Record**
If you choose the Record experience type, the following sections appear in the Activity Experience section for your activity definition:

**Details**
Displays the following fields:
  • Tagline
  • Icon
  • Title
  • Description
  • Pending State Title
  • Pending State Description
  • Record fields
  • Footer

**Form**
Displays the following fields:
  • Form View
  • Form fields

**Attachments**
Displays the following fields:
  • Attachment source
  • Attachments read only

**Features**
Displays the following fields:
  • Show SLA
  • Show Checklist
  • Is Automated
Activity executions

Activity execution records provide runtime information about activities in a process definition, such as the activity’s current state and associated record.

An activity execution represents a runtime execution of your activity. Each time one of your process definitions triggers, Process Automation Designer automatically creates records for each activity that runs within the triggered process definition.

To access the activity execution records for an In Progress process execution, navigate to Process Automation > Process Automation Administration > Active Processes. Alternatively, you can see the activity executions for all processes that ran today by navigating to Process Automation > Process Automation Administration > Today’s Executions. Select a process execution record from the list. Then, you can view the associated activity execution records in the Activity Executions related list.

Fields

By default, each record in the Activity Executions related list contains the following fields:

<table>
<thead>
<tr>
<th>Activity Execution fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Label</td>
</tr>
<tr>
<td>Lane</td>
</tr>
<tr>
<td>State</td>
</tr>
<tr>
<td>Activity Type</td>
</tr>
<tr>
<td>Associated Record</td>
</tr>
<tr>
<td>Execution index</td>
</tr>
</tbody>
</table>

Activity execution states

Activity execution states indicate the status of an activity in a triggered process definition. Activities that render in a Workspace Playbook card can display this state to agents. An activity execution record can have one of the following states:
<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>The process definition triggered, but the activity execution is waiting on preceding activities to complete before it can start running.</td>
</tr>
<tr>
<td>Ready</td>
<td>The process definition triggered, and the activity will start running soon.</td>
</tr>
<tr>
<td>In Progress</td>
<td>The process definition triggered, and the activity execution is running.</td>
</tr>
<tr>
<td>Complete</td>
<td>The process definition triggered, and the activity execution is done running.</td>
</tr>
<tr>
<td>Skipped</td>
<td>The process definition triggered, but a user chose to skip this activity execution and move on to the next activity. Also, if the activity contains a condition that evaluates to false, the system skips the activity.</td>
</tr>
<tr>
<td>Error</td>
<td>The process definition triggered, but an error with the activity's automation plan or activity experience occurred. Errors can occur when the underlying action or subflow in the activity's automation plan fails to run.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>A user with the admin, flow_designer, or action_designer role explicitly canceled the underlying action or subflow in the activity's automation plan.</td>
</tr>
</tbody>
</table>

**Process Automation Designer roles**

Grant users one or more Process Automation Designer roles to enable them to create triggers, process definitions, and activity definitions.

System administrators can grant users access to Process Automation Designer by assigning delegated development permissions or directly assigning user roles. The following user roles are available for Process Automation Designer:
<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pd_admin</td>
<td>Enables users to create, update, and delete trigger definitions. Also enables users to launch the Process Automation Designer environment to create, activate, edit, and delete process definitions, activity definitions, and trigger definitions.</td>
</tr>
<tr>
<td>pd_author</td>
<td>Enables users to launch the Process Automation Designer environment to create, activate, edit, and delete process definitions.</td>
</tr>
<tr>
<td>pd_content_author</td>
<td>Enables users to create, edit, and delete activity definitions and trigger definitions.</td>
</tr>
<tr>
<td>pd_trigger_author</td>
<td>Enables users to create, update, and delete trigger definitions.</td>
</tr>
<tr>
<td>pd_operator</td>
<td>Enables users to view process executions, activity executions, and execution logs only.</td>
</tr>
</tbody>
</table>

**Note:** Granting users Process Automation Designer roles does not automatically allow them to access the Flow Designer design environment. Granting users access to Flow Designer may be helpful when creating activity definitions. For more information on Flow Designer roles, see user access to Flow Designer.

**Domain separation and Process Automation Designer**

Process Automation Designer supports data separation. The domain value of the triggering input record determines the domain context. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: Basic**
• Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.

• The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.

How domain separation works in Process Automation Designer
The system domain separates Process Automation Designer content according to these rules:

**Process Automation Designer content runs from the domain it is triggered from**

Activities and process definitions run from the domain of the record or user who initiates them. For example, when a user from the child domain ACME triggers a process definition belonging to the parent domain TOP, the process definition runs in the context of the child domain ACME.

**Flow Designer content runs in the domain of the calling Process Automation Designer activity**

Whenever an activity definition calls an action or flow, the system runs the Flow Designer content in the same domain context as the triggering Process Automation Designer content. If the Flow Designer content has a matching domain-specific process override, then the system runs the override version instead. While Process Automation Designer does not support process overrides, it uses any process overrides defined within Flow Designer.

**Process Automation Designer configuration files are visible to all domain users**

Process Automation Designer configuration files are not domain separated. Any user with the appropriate roles can view all process definitions, trigger definitions, and activity definitions.
Related information

Domain separation for service providers

Remote tables

Connect the Now Platform to third-party sources, or to another instance, so that you can retrieve external data and optionally cache it in the memory. You can view external data in lists or forms and process it with standard Glide scripts. You can also group, sort, aggregate, and filter the data just like you would for standard internal tables.

Remote table components

Use the following components to build an external data framework:

Remote tables

You create remote tables to describe the schema for the data that you want to retrieve from an external source.

The table definition is in the Now Platform, but its rows, or external records, live in the memory. You create a remote table the same way that you would create a standard internal table. You define columns and controls and designate application access for it just like you would do for an internal table. Unlike an internal table, a remote table does not get its records from the Now Platform database. It gets its records from running an associated script against an external data source.

To learn more about creating remote tables, see Create a remote table.

Script definitions

You create and associate a script definition with a remote table. The external data that you’ve retrieved using the script can be cached in the memory. You can also designate how this data is cached and how long the data is cached in the memory. Every time that you refresh a list that contains the external data from a remote table, the associated script runs again.

To learn more about script definitions and how to associate them with a remote table, see Create a script definition for a remote table.

How remote tables work

By using a remote table, you can retrieve the data from external sources or from another instance with REST or SOAP services. The external data lives in the
memory in read-only mode, which makes the data temporary, or transient, within the Now Platform. You can then view and manipulate the external data without importing or storing it.

You view the external data in lists or forms in the same way that you view internally stored data. You can manipulate this data by using standard Glide records, business rules, remote APIs, scripting, table reference fields, services, and development tools in the Now Platform.

**Important:** All data that is retrieved from the external source lives in the memory, so make sure that your data set is small. To minimize query times, don’t add more than 1000 rows to a remote table.

### External data life cycle within the Now Platform

The data that you retrieve from an external source has a finite duration, or life cycle, within the Now Platform.

- When you run a script that is associated with a remote table, the retrieved data lives in the memory for as long as the list or form appears. After you close the list or form, that external data is purged from the memory. The next time that you use or views the external data in this remote table, the memory is repopulated from the external system.

- However, if you have defined caching parameters for the script, the external data remains cached in the memory for the specified caching duration.

  For example, if you designate that the external data should be cached for 300 seconds, it remains cached in the memory for 5 minutes. After that time expires, the cached data is purged from the memory. The next time that you use or views the external data in this remote table, the cache is refreshed from the external system.

### Practical applications for remote tables

Set up and use remote tables in your enterprise when:

- You want to fetch external data for temporary use without storing it in the Now Platform. For example, you can create a remote table that fetches weather-related data that appears on a homepage when a user logs in. You would then create an associated script definition that retrieves this data from a third-party weather source that is based on the user’s location.

- You want to retrieve customer details that are stored in an external Customer Relationship Management (CRM) application for viewing in Customer Service Management functions such as Agent Workspace.
Note: To learn more about data retrieval for Customer Service Management, see Third-party data integration for CSM.

• You want to retrieve and view personnel data from Human Capital Management (HCM) applications such as Workday or SAP SuccessFactors for use in HR Service Delivery functions.

Post-filtering and sorting
When you run a remote table script, it applies post-filtering and sorting query conditions after it adds rows to a table. These applied conditions support any other required queries that the script does not handle. When you apply post-filtering and sorting, the remote table queries work like standard internal table queries.

When you create remote table scripts, you generally handle the most frequent and expansive queries in the script. Post-filtering queries and sorting can take a long time and may adversely affect how your instance performs. Use a small data set instead so that it doesn’t take much time to do post-filtering and sorting.

Based on your use cases, determine if you should try a narrower query in the external call or a more expansive query. Because the internal filtering and sorting can be expensive to run on large result sets, use a narrower query when the data doesn’t require extra filtering. Use a more expansive query when a more general query would return a small result set and would require extra filtering and sorting.

Differences between remote tables and the IntegrationHub
Choose whether to use a remote table or IntegrationHub to process external data.

• When you want to temporarily cache external data, use remote tables.

• If you want more advanced importing and transformation options, including Flow Designer, or if you want to develop custom integrations, use the IntegrationHub.

Note: If you create a remote table that uses the data from an external source that is outside of the Now Platform, you must have an IntegrationHub subscription entitlement. To learn more about the IntegrationHub, see IntegrationHub.

Activate the remote tables plugin
If you have the admin role, you can activate the Remote Tables plugin (com.glide.script.vtable). This plugin includes demo data and activates related plugins if they are not already active.
Before you begin
Role required: admin

About this task
Remote Tables activates these related plugins if they are not already active.

Plugins for Remote Tables

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Tables [com.glide.script.vtable]</td>
<td>Supports remote tables and associated script definitions that can be used to retrieve and optionally cache data from external sources.</td>
</tr>
<tr>
<td>Transformation Service [com.glide.transform]</td>
<td>Supports use of Transform APIs that are associated with the remote tables.</td>
</tr>
</tbody>
</table>

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related information

Create a remote table
Create a remote table so that you can see the data that you retrieved from an external source.

Before you begin
Role required: admin
About this task
When you designate a table as a remote table, keep the following points in mind:

• You can create a remote table using this form, or by using the standard Create Tables form that you access from System Definition > Tables.

  Note: To learn more about creating tables in an instance, see Create a table.

• Before you create a remote table, you must have a good understanding of external data sources.

  For example, if you want to retrieve CRM data for use in Customer Service Management, you must understand how the data is structured in the external CRM source.

• Unlike standard internal tables, you can’t extend a remote table from another table.

• A remote table needs an external primary key to relate its temporary data to the data that is stored in the external source. When you designate a table as remote, only a sys_id field is auto-generated and appears in the Columns section, which it uses as its primary key for use in Glide records. All external table primary key values are converted to string values. CRUD (Create, Read, Update, Delete) fields are not generated for a remote table, as they are for standard internal tables.

Procedure
1. Navigate to System Definition > Remote Tables > Tables.
2. Click New.
3. On the form, fill in the fields.

  Note: You create a remote table in the same manner as a normal table, but designate it as a remote table. The following controls differ in how they operate and what you enter into them when you create a remote table:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Table name, which is automatically populated based on the table label and a prefix as follows:</td>
</tr>
</tbody>
</table>
Control | Description
--- | ---
• For a remote table in a scoped application, the name is prefixed with a namespace identifier and the string `st_` to indicate that it is remote and part of an application.
• For a remote table in the global application, the name is prefixed with the string `u_st_`.
You can’t modify the prefix; however, you can modify the rest of the table name. The name can contain only lowercase, alphanumeric ASCII characters and underscores (_).

Extends Table | Option that is not available if you select the Remote Table option to designate that this table is remote. It no longer appears because you can’t extend remote tables from other tables.

Remote Table | Option to designate this table as a remote table. A remote table is a table to which you can associate a script definition for retrieval of data from an external data source. Unlike a standard internal table, the data does not come from records in the current instance.

ℹ️ Note: To learn more about remote tables, see:
- Remote tables
- Create a remote table

4. In the Columns section, use the Table Columns embedded list to add columns to the remote table like you do when you create columns for a standard internal table.

5. In the Controls section, define additional remote table options like you do when you define additional table options for a normal table.

6. In the Application Access section, define the scope protection for the remote table like you do when you define additional table options for a normal table. For more information, see Application access settings.

7. Click Submit.

Results
A remote table is created in the instance.

Create a script definition for a remote table
Define and associate a script with a remote table so that you can retrieve data from an external source with it. The Now Platform retrieves and caches the data for the remote table by running the script against an external data source so
you can view or modify it. You can also designate how this external data is cached and how long the data is cached in the memory until the script must run again.

Before you begin
Role required: admin

About this task
You create script definitions for remote tables like you do for other scripts. To learn more about entering, modifying, and debugging scripts, see JavaScript syntax editor.

Procedure
1. Navigate to **System Definition > Remote Tables > Definition**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the script that you are creating to associate with the selected remote table.</td>
</tr>
<tr>
<td>Table</td>
<td>Name of the remote table that you want to associate the script that you are creating.</td>
</tr>
<tr>
<td></td>
<td>• For a remote table in a scoped application, the name is prefixed with a namespace identifier and the string <code>st_</code> to indicate that it is remote and part of an application.</td>
</tr>
<tr>
<td></td>
<td>• For a remote table in the global application, the name is prefixed with the string <code>u_st_</code>.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that is associated with this remote table. If you are working on an application or are creating a remote table from an application record, the field defaults to that application. Otherwise, the field defaults to <code>Global</code>. Any records that are created from the table record, such as modules and security rules, are assigned to this application by default.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for activating the script that you are associating with the remote table. You can have multiple inactive script definitions for a remote table, but can only have one active script definition.</td>
</tr>
</tbody>
</table>
Control | Description
--- | ---
Advanced | Option to access the Caching section to designate how the memory caching should operate in the Now Platform for this remote table.

**Note:** Only advanced users should set caching parameters for a remote table.

4. In the Script section, add your JavaScript syntax to the skeleton template:

```javascript
(function executeQuery(v_table, v_query) {
  // Main API:
  v_table.addRow({ ... }) - adds a row to the result set

  // There are also query helper methods
  v_query.getEncodedQuery() - returns encoded querystring
  v_query.getCondition(field) - returns encoded querystring for the given field (includes field name, operator, and value)
  v_query.getParameter(field) - returns parameter for the given field (only includes value for equality conditions)

  v_query.isGet() - returns whether the query is a single get by sys_id
  v_query.getSysId() - returns parameter for sys_id field
  v_query.isTextSearch() - returns whether the query contains a text query parameter
  v_query.getTextSearch() - returns text search query parameter (internal field name 123TEXTQUERY321)
  v_query.getFirstRowWanted() - returns the first row to include
  v_query.getLastRowWanted() - returns the last row to include

  // Your code goes here
  v_table.addRow({...})
})(v_table, v_query);
```

**Note:** To learn more about entering, modifying, and debugging scripts, see JavaScript syntax editor.

5. In the Caching section, designate how this data is cached and how long the data is cached in the memory of the Now Platform:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cache TTL</td>
<td>Cache time to live, expressed in seconds, that external data is cached in memory for this remote table script definition. For example, enter 300 to cache the data in the memory for 5 minutes. The maximum value you can enter is 60 minutes (3600 seconds).</td>
</tr>
</tbody>
</table>

**Note:** By default, the external data is cached in the memory by user.

6. Click Submit.
Results
When you activate a script definition, you associate it with the remote table so that you can retrieve and cache the external data.

Related information

Example 1: Retrieving all incident records from an external source
These are examples of script definitions you might create for retrieval and caching of data from sources external to your current instance. In this first example, we create a script to load all incident records from an external source.

For Remote Table API information, refer to:
• `v_table()`
• `v_query()`

```javascript
/**
 * Using `v_query`, add the rows to `v_table`
 */
(function executeQuery(v_table, v_query) {
    fetchAllIncidents(v_table, v_query);
    /**
     * fetch all incidents records from the remote instance
     */
    function fetchAllIncidents(v_table, v_query) {
      // Uses RestMessage with name 'Remote Instance Incidents' and function 'All Incidents'
      // Create a RestMessage first which calls an external REST service
      try {
        var restMessage = new sn_ws.RESTMessageV2('Remote Instance Incidents', 'All Incidents');
        var response = restMessage.execute();
        var responseBody = response.getBody();
        // if REST call ends up in an error, set the last error message which shows up
        // at the bottom of the list view
        if (response.haveError()) {
          v_query.setLastErrorMessage(response.getErrorMessage());
          // can use gs.error() or gs.addErrorMessage() while debugging
          // gs.debug() messages visible in session debugger
          // gs.debug(response.getErrorMessage());
          return;
        }
      } catch (ex) {
        v_query.setLastErrorMessage(ex.message);
      }
    }
```
function fetchAllIncidents(v_table, v_query) {
  // Uses RestMessage with name 'Remote Instance Incidents' and function 'All Incidents'
  // Create a RestMessage first which calls an external REST service
  try {
    var restMessage = new sn_ws.RESTMessageV2('Remote Instance Incidents', 'All Incidents');
  }
})

These code snippets are of note in this script:

function getTransformerDefinition() {
  // create a rule list to map a field to its element path
  var ruleList = new sn_tfrm.TransformerRuleList()
    .fromJson() // the response body is a JSON
    // 'active' field maps to path '$.active'
    .addRule("active", "$.active")
    .addRule("caller_id", "$.caller_id.value")
    .addRule("number", "$.number")
    .addRule("short_description", "$.short_description")
    .addRule("sys_id", "$.sys_id")
    .addRule("updates", "$.sys_mod_count");
  var recordPath = "$result";
  return new sn_tfrm.TransformerDefinition(ruleList, recordPath);
}
If no problems are encountered in the data retrieval, it gets the data body for the records.

```javascript
var transformerDefinition = getTransformerDefinition();
var transformer = new sn_tfrm.Transformer(transformerDefinition, responseBody);
// transformer parses the responseBody and extracts rows
while (transformer.transform()) {
    // row is field-value map e.g. { active:"true", number: "INC0000001"}
    var row = transformer.getRow();
    // you may do any additional transformations to the row like GlideDuration,
    GlideDataTime etc. For example,
    // row.duration = new GlideDuration(row.duration);
    // finally add the row to the remote table
    v_table.addRow(row);
}
```

It then uses the Transformer API to perform any required data transformations, extracts rows, and then adds a row for each record to the remote table.

Note: To learn more about use of RESTMessageV2 and how to define a direct message, see RESTMessageV2 - Scoped, Global and Direct RESTMessageV2 example.
/**
 * returns a sn_tfrm.TransformerDefinition, which defines the mapping of the table fields
 * and elements in the response body
 */
function getTransformerDefinition() {
  // create a rule list to map a field to its element path
  var ruleList = new sn_tfrm.TransformerRuleList()
      .fromJson() // the response body is a JSON
      // 'active' field maps to path '$.active'
      .addRule("active", "$.active")
      .addRule("caller_id", "$.caller_id.value")
      .addRule("number", "$.number")
      .addRule("short_description", "$.short_description")
      .addRule("sys_id", "$.sys_id")
      .addRule("updates", "$.sys_mod_count");
  var recordPath = "$ .result";
  return new sn_tfrm.TransformerDefinition(ruleList, recordPath);
}
})(v_table, v_query);

getTransformerDefinition defines the schema of the record in the external API response body. It maps each of the fields in the table script to an element in the external record. Any external data elements outside of this mapping are not supported or retrieved.

⚠️ Note: You must map a sys_id in the transformer definition to an element in the external data. In this case, the sys_id is mapped to the external incident sys_id. The maximum length of the sys_id is 32 characters. You do this sys_id mapping so forms that use the external data can operate properly.

Related reference

Debugging remote table script definitions

Related information

TransformerDefinition API - Scoped, Global
TransformerRuleList API - Scoped, Global
TransformerScripted API - Scoped, Global

Example 2: Retrieving specific records from a third-party source

In this example, we create a script to retrieve specific types of incident records from a third-party source.
For Remote Table API information, refer to:

- `v_table()
- `v_query()

```javascript
/**
 * Using `v_query`, add the rows to `v_table`
 */
(function executeQuery(v_table, v_query) {
  if (v_query.isGet()) {
    bySysId(v_table, v_query, v_query.getSysId());
  }
  else if (v_query.getParameter("caller_id")) {
    byCallerId(v_table, v_query, v_query.getParameter("caller_id"));
  }
  else {
    fetchAllIncidents(v_table, v_query);
  }
  /**
   * fetch all incidents records from the remote instance
   */
  function fetchAllIncidents(v_table, v_query) {
    // Uses RestMessage with name 'Remote Instance Incidents' and function 'All Incidents'
    // Create a RestMessage first which calls an external REST service
    var restMessage = new sn_ws.RESTMessageV2('Remote Instance Incidents', 'All Incidents');
    loadData(v_table, v_query, restMessage);
  }
  /**
   * fetches a specific record from the remote instance with Sys Id being `sys_id`
   */
  function bySysId(v_table, v_query, sys_id) {
    // Uses RestMessage with name 'Remote Instance Incidents' and function 'By SysId'
    var restMessage = new sn_ws.RESTMessageV2('Remote Instance Incidents', 'By SysId');
    // sets variable 'sys_id'
    restMessage.setStringParameterNoEscape("sys_id", sys_id);
    loadData(v_table, v_query, restMessage);
  }
  /**
   * fetches records from the remote instance with Caller (caller_id) being `caller_id`
   */
  function byCallerId(v_table, v_query, caller_id) {
    var restMessage = new sn_ws.RESTMessageV2('Remote Instance Incidents', 'By CallerId');
    restMessage.setStringParameterNoEscape("caller_id", caller_id);
    loadData(v_table, v_query, restMessage);
  }
```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
function loadData(v_table, v_query, restMessage) {
    try {
        var response = restMessage.execute();
        var responseBody = response.getBody();

        // if REST call ends up in an error, set the last error message which shows up
        // at the bottom of the list view
        if (response.haveError()) {
            v_query.setLastErrorMessage(response.getErrorMessage());
            // can use gs.error() or gs.addErrorMessage() while debugging
            // gs.debug() messages visible in session debugger
            // gs.debug(response.getErrorMessage());
            return;
        }
    } catch (ex) {
        v_query.setLastErrorMessage(ex.message);
        // gs.debug(ex.message);
        return;
    }

    var transformerDefinition = getTransformerDefinition();
    var transformer = new sn_tfrm.Transformer(transformerDefinition, responseBody);
    // transformer parses the responseBody and extracts rows
    while (transformer.transform()) {
        // row is field-value map e.g. { active:"true", number: "INC0000001"}
        var row = transformer.getRow();
        // you may do any additional transformations to the row like GlideDuration,
        GlideDataTime etc. For example,
        // row.duration = new GlideDuration(row.duration);
        // finally add the row to the remote table
        v_table.addRow(row);
    }
}

/**
 * returns a sn_tfrm.TransformerDefinition, which defines the mapping of the table fields
 and elements in the response body
 */
function getTransformerDefinition() {
    // create a rule list to map a field to its element path
    var ruleList = new sn_tfrm.TransformerRuleList()
        .fromJson() // the response body is a JSON
// 'active' field maps to path '$.active'
.addRule("active", "$.active")
.addRule("caller_id", "$.caller_id.value")
.addRule("number", "$.number")
.addRule("short_description", "$.short_description")
.addRule("sys_id", "$.sys_id")
.addRule("updates", "$.sys_mod_count");
var recordPath = "$.result";
return new sn_tfrm.TransformerDefinition(ruleList, recordPath);
}
})(v_table, v_query);

These code snippets are of note in this script:

function fetchAllIncidents(v_table, v_query) {
    // Uses RestMessage with name 'Remote Instance Incidents' and function 'All Incidents'
    // Create a RestMessage first which calls an external REST service
    var restMessage = new sn_ws.RESTMessageV2('Remote Instance Incidents', 'All Incidents');
    loadData(v_table, v_query, restMessage);
}

function bySysId(v_table, v_query, sys_id) {
    // Uses RestMessage with name 'Remote Instance Incidents' and function 'By SysId'
    var restMessage = new sn_ws.RESTMessageV2('Remote Instance Incidents', 'By SysId');
    // sets variable 'sys_id'
    restMessage.setStringParameterNoEscape("sys_id", sys_id);
    loadData(v_table, v_query, restMessage);
}

function byCallerId(v_table, v_query, caller_id) {
    var restMessage = new sn_ws.RESTMessageV2('Remote Instance Incidents', 'By CallerId');
    restMessage.setStringParameterNoEscape("caller_id", caller_id);
    loadData(v_table, v_query, restMessage);
}

You can create a RestMessage and directly use it in the script. In this example, it uses a RESTMessageV2 API with the name of Remote Instance Incidents, and the function All Incidents, which gets all incident data. Once a response is returned from the server, an error message appears if problems are encountered in the data retrieval.

When you query a specific record using GlideRecord.get("<sys_id>"), then v_query.isGet() is 'true'. It fetches the specific record from the external service.
You can also handle any other specific query conditions in the script, such as using `caller_id` in the preceding code snippet. The remainder of this script operates in a manner similar to Example 1.

```javascript
function getTransformerDefinition() {
// create a rule list to map a field to its element path
var ruleList = new sn_tfrm.TransformerRuleList()
    .fromJson() // the response body is a JSON
    // 'active' field maps to path '$.active'
    .addRule("active", ".active")
    .addRule("caller_id", ".caller_id.value")
    .addRule("number", ".number")
    .addRule("short_description", ".short_description")
    .addRule("sys_id", ".sys_id")
    .addRule("updates", ".sys_mod_count");
var recordPath = ".result";
return new sn_tfrm.TransformerDefinition(ruleList, recordPath);
}
})(v_table, v_query);
```

If no problems are encountered in the data retrieval, it gets the data body for the records. It then uses the Transformer API to perform any required data transformations, extracts rows, and then adds a row for each record to the remote table.

getTransformerDefinition defines the schema of the record in the external API response body. It maps each of the fields in the table script to an element in the external record. Any external data elements outside of this mapping are not available in the remote table.

### Debugging remote table script definitions

You can enable session debugging for remote table script definitions. To enable script definition logging in a session debug log, set the `glide.script.vtable.log.debug` property to `true`.

When you create remote table script definitions, you can use the `gs.debug()` command to add debug logs that are visible in the session debugger. The session debugger also contains debug logs with [RemoteTable] tags, each with the following information:

- Query definition
- Number of rows loaded in the remote table
- Number of aggregate rows (if GlideAggregate)
Prolonged use of the glide.script.vtable.log.debug property can affect performance, so it is best to set its value to **false** when you finish a debugging session.

**Note:** If you are not on the application node that processed your remote table script, you may not see the resulting log statements. In this case, contact Technical Support.

Use the `v_query.setLastErrorMessage(message)` API to set the last error message that appears at the bottom of the list view. In script, you can retrieve this message using the `glideRecord.getLastErrorMessage()` API. To learn more about these APIs, see Text-To-Display.

**Related information**

- Available system properties
- Script Debugger and Session Logging

**Domain separation and remote tables**

Domain separation is unsupported in remote tables. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: No support**

- The domain field may exist on data tables but there is no business logic to manage the data.
- This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation.

**Overview**

Domain separation provides complete data isolation for domain-specific users.

**How domain separation works with remote tables**

When you create standard internal tables, you can add a sys_domain field, which results in domain separation of the data that is stored in the table. This functionality is not supported when you natively create remote tables, which results in lack of domain separation for rows that are added to a remote table.

However, script definitions that you create and associate with a remote table can be domain (data) separated. When you create the script, you can include
DomainSupport APIs that provide domain separation support. If the script definition is domain separated, only users that belong to the designated domain can view the data in the remote table.

**Related information**

Create a script definition for a remote table

Domain separation

**Response templates**

Resolve cases or support issues faster and more efficiently with response templates. Response templates (formerly known as templated snippets) are reusable messages that can be copied to case or task forms to provide quick and consistent messages to users, or to display standard chat response messages to requesters in Agent Chat.

**Assign response template roles**

The following roles are installed when you activate the response templates plugin.

<table>
<thead>
<tr>
<th>Response template role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response template administrator [sn Templated_snip.template_snippet_admin]</td>
<td>Grants access to scoped administration of the response templates feature.</td>
</tr>
<tr>
<td>Response template writer [sn Templated_snip.template_snippet_writer]</td>
<td>Grants access to create, read, update, and delete (CRUD) response template content.</td>
</tr>
<tr>
<td>Response template reader [sn Templated_snip.template_snippet_reader]</td>
<td>Grants access to read response template content.</td>
</tr>
<tr>
<td>System Administrator [admin]</td>
<td>Response template administrator [sn Templated_snip.template_snippet_admin]</td>
</tr>
<tr>
<td>Response template role</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Note:</strong> Admin inherits this role by default. When the Templated Responses [com.sn_templated_snip] plugin is activated without activating related HR applications, you can still use response templates.</td>
<td></td>
</tr>
<tr>
<td>• Admin can reassign this role to other users.</td>
<td></td>
</tr>
<tr>
<td>• Admin can also remove the Contained Role [sys_user_role_contains] table so Admin users do not inherit this role by default. Or:</td>
<td></td>
</tr>
<tr>
<td>1. Enter <code>sys_store_app_list.do</code> in the Filter navigator search bar of an instance, or <code>https://YOUR_INSTANCE/sys_store_app_list.do</code> from a web browser.</td>
<td></td>
</tr>
<tr>
<td>2. Search for and select <strong>Templated Snippets</strong>.</td>
<td></td>
</tr>
<tr>
<td>3. Scroll down to <strong>Related Links</strong>.</td>
<td></td>
</tr>
<tr>
<td>4. Click <strong>Remove from the role contained by admin</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

Before you begin using response templates, you must assign these roles to the appropriate roles, groups, or users in your application.

• To assign a role to another role, see **Add a role to an existing role**.
• To assign a role to a group, see **Assign a role to a group**.
• To assign a role to a user, see **Assign a role to a user**.

For example,

• In the HR Service Delivery application, users with the HR administrator role are assigned the response template administrator role, users with the HR manager role are assigned the response template writer role, and users with the HR case writer role are assigned the response template reader role.
In the Customer Service Management application, users with the customer service manager role (sn_customerservice_manager) inherit the response template writer role. Users with the customer service agent role (sn_customerservice_agent) inherit the response template reader role and can access response templates assigned to all groups to which they belong.

How to use response templates
Users with the response template writer [sn_templated_snip.template_snippet_writer] role can create response templates. Each template is associated with a table that is an extension of the Task [task] or Interaction [interaction] table. Response templates include a short name for specifying a shortcut that can be used to identify the message. For chat response templates used in Agent Workspace, agents use the slash command with a short name to present the standard message during a chat. You can also configure the template to

• Include variables pulled from a table
• Specify a condition builder to specify the conditions that must be met for the template to be available for use, such as for a specific HR service

• Create or modify a response template

Users with the response template reader [sn_templated_snip.template_snippet_reader] role can then copy response template content and use it in their responses to users when working on case or task forms that meet the specified conditions. For example, a response template for payroll discrepancy cases enables HR agents to use a standardized message when responding to that case type. See Copy a response template to an HR case for an HR-specific example.

Example: Response template to escalate payroll discrepancy cases
You are part of an enterprise HR organization using the HR Service Delivery application. You want your HR agents to respond to and, when necessary, escalate payroll discrepancy cases quickly and consistently. Create a response template so that HR agents have a reusable message to use when responding to employees about that case type.

One of your HR managers with the response template writer role is responsible for creating the template to escalate payroll discrepancy cases. The template is associated with the HR Payroll Case [sn_hr_core_case_payroll] table, and a condition filters on cases that match the appropriate HR service called Payroll Discrepancy. In the template body, the response text appears with variables, such as the subject person name in the salutation.
HR case writers with the response template reader role can copy the response template content and use it in their responses to employees when working on cases. Response templates provide a faster and efficient way to resolve cases.

**Activation information**

To use response templates in your application, you must activate response templates. For information on what components are installed with the feature, see Components installed with response templates.

**Activate response templates**

You can activate response templates (formerly known as templated snippets) [com.sn_templated_snip] if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**

Role required: admin

> **Note:** If you are using Agent Chat, the Agent Chat (com.glide.interaction.awa) plugin automatically activates response templates.

**About this task**

Response templates activate these related plugins if they are not already active.

**Plugins for response templates**

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scoped Application Restricted Caller Access</td>
<td>Allows scoped applications to restrict access to public tables and script includes.</td>
</tr>
<tr>
<td>[com.glide.scope.access.restricted_caller]</td>
<td></td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to **System Applications > All Available Applications > All.**
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Related information**

**List of plugins (Madrid)**

**Components installed with response templates**

Several types of components are installed with activation of the Templated Responses (com.sn_templated_snip) plugin, including tables and user roles.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

**Roles installed**

By default, the following HR roles contain the following response template roles.

**Note:** The Templated Responses [com.sn_templated_snip] plugin activates the sn_templated_snip.min_admin_count system property [sys_properties.list]. This property prevents you from deleting your only Response Template admin user by requiring a minimum number (default is two) of active users with this role.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response templates administrator [sn_templated_snip.template_snippet_admin]</td>
<td>Grants access to scoped administration of the response templates feature.</td>
<td>• sn_templated_snip.template_snippet_admin</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response templates writer [sn_templated_snip.template_snippet_writer]</td>
<td>Grants access to</td>
<td>• sn_templated_snip.template_snippet_writer</td>
</tr>
</tbody>
</table>
### Role title [name]

<table>
<thead>
<tr>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>create, read, update, and delete (CRUD) response template content.</td>
<td></td>
</tr>
</tbody>
</table>

### Response templates reader

**[sn_templated_snip.template_snippet_reader]**

- Grants access to read response template content.
- None

You can assign these roles to the appropriate roles, groups, or users in your application.

- To assign a role to another role, see Add a role to an existing role.
- To assign a role to a group, see Assign a role to a group.
- To assign a role to a user, see Assign a role to a user.

For further information on user administration and how to manage users, see User administration.

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response Template [sn_templated_snip_note_template]</td>
<td>Table for .</td>
</tr>
<tr>
<td>M2M Response Template to Channel [m2m_response_template_to_channel]</td>
<td></td>
</tr>
</tbody>
</table>
For further information on table administration and how to manage data, see Table administration.

**Create or modify a response template**

Create or modify a response template (formerly known as a templated snippet) to define a reusable message that can be copied to case or task forms or used in Agent Chat sessions to provide quick and consistent messages to users.

**Before you begin**

Role required: sn_templated_snip.template_snippet_writer

**About this task**

Each response template is associated with a table that is an extension of the Task [task] table or, if using Agent Workspace, the Interaction [interaction] table. The template can be configured to include variables pulled from that table. You can also use a condition builder to specify the conditions that a case must meet for the template to be available for use, such as for a specific HR service or for chat. For chat response templates, you specify a short name (shortcut) that is used with the slash command as a quick way to present the response message to a user.

**Procedure**

1. Navigate to System Definition > Response template configuration.
2. Click **New** or open a record.
3. Fill in the fields on the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the response template.</td>
</tr>
<tr>
<td>Short Name</td>
<td>Short description that identifies the response template when using chat in Agent Workspace. Use the short name with a quick command (/) to show the text from the template body of the response template while in chat. This feature provides a fast and consistent way to populate text while in chat.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>For example, the short name \texttt{gm} identifies the chat response template for a Good Morning greeting. Enter \texttt{/gm} in a chat window to show the text from this response template.</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Name of the table that the response template is associated with.</td>
</tr>
<tr>
<td>\textbf{Note:}</td>
<td>If you are creating a response template for Agent Workspace chat, the associated table is the Interaction [interaction] table. For other response templates, the table must be an extension of the Task [task] table.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions that determine when the response template is available for use.</td>
</tr>
<tr>
<td></td>
<td>When defining conditions like case sensitivity or null values, see API\texttt{GlideFilter - Scoped, Global}.</td>
</tr>
<tr>
<td>\textbf{Note:}</td>
<td>The conditions available depend on the table you select. For chat response templates, specify the condition: \texttt{[Type] [is] [Chat]}</td>
</tr>
<tr>
<td>Application</td>
<td>The application that created the response template.</td>
</tr>
<tr>
<td>Group visibility</td>
<td>Indicates what groups have access to the response template. Adding groups filters who can view the response template.</td>
</tr>
<tr>
<td>\textbf{Note:}</td>
<td>Leaving this field empty makes the response template available to all groups.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Template body</td>
<td>Text of the response template providing instructions to the agent on how to respond to a specific case or task. You can reference field values by selecting variables from the variables list based on the table you select. You can manually enter custom variable references:</td>
</tr>
<tr>
<td></td>
<td>• Current user: <code>${current_user}</code></td>
</tr>
<tr>
<td></td>
<td>• Current date: <code>${Date}</code></td>
</tr>
<tr>
<td></td>
<td>Or, place your mouse where you want the custom variable reference to appear and select the Insert Current User or Insert Current Date buttons.</td>
</tr>
<tr>
<td></td>
<td>✋ Note: Response templates do not support rich text.</td>
</tr>
<tr>
<td>Select variables</td>
<td>Variables you can add to the template body.</td>
</tr>
<tr>
<td></td>
<td>✋ Note: The variables available depend on the table you select.</td>
</tr>
</tbody>
</table>

**Example**

The following GIF shows an example of an HR manager in the HR Service Delivery application creating a response template to escalate payroll discrepancy cases. The template is associated with the HR Payroll Case `[sn_hr_core_case_payroll]` table, and a condition is set to filter on cases that match the Payroll Discrepancy HR service. The template text is pasted into the body, and then a variable for the subject person is added to the salutation.
4. Click **Submit** or **Update**. The Channels related list appears. Channels limit the response template to only the channels you add. If you leave this blank, the response template is available to no channels. This feature allows you to have different messages for chats, emails, or form. For more information, see.
What to do next
You can copy response template content to any field on a form that meets the specified conditions.

The following GIF shows an example of an HR case writer in the HR Service Delivery application opening a payroll discrepancy case and copying a payroll discrepancy escalation template to the comments field in the HR case form for the employee to read.

![GIF of HR case writer]

Self-service
The Self-Service application gives supported end users a clean, simple front end to their IT support organization.

By default, the Self-Service application provides access to common actions, such as viewing your homepage, accessing the Service Catalog, viewing knowledge articles, working with incidents, and taking surveys.

Service catalog requests
This page contains links to content on service catalog requests.

Add new request items
Use ServiceNow's web-based interface to add new items to a request.
Before you begin
Roles required: Only an administrator or a user with the catalog_admin role can add a new item to a submitted request.

About this task
Modifying a request does not resubmit it to the approval process.

Procedure
1. Navigate to **Service Catalog > Open Records > Requests** and open an existing request.
2. Click **Add New Item**.
3. In the dialog box that appears, choose an item and a quantity to add.
4. Click **OK**.

**Amazon EC2 instance request from the Service Catalog**

Users can request the provisioning and deletion of virtual computers (Linux or Windows) in the Amazon EC2 virtual computing environment through the ServiceNow Service Catalog.

The Amazon EC2 offering requires the purchase and activation of ServiceNow Orchestration Automaton.

**Request an instance**
Request the provisioning of a new Amazon EC2 instance through the service catalog.

**Procedure**
1. Navigate to **Self-Service > Service Catalog**.
2. Select **Amazon EC2 Instance** from the **Request Application Infrastructure** category.
3. Select the operating system, the type of instance (Large or Small), and the number of instances requested.

   See the specifications for Large and Small instances in Amazon EC2 Instance Types.

4. Type a reason for the request.

5. Click Order Now to order the instance.

   The Order Status form appears, summarizing the request. A status bar tracks the progress of the approval and provisioning of the EC2 instance.
Upon successful creation of the instance, you receive an email containing the instance ID, IP address, and the public DNS for the instances created.

Terminate an instance
Shut down an Amazon EC2 instance through the service catalog.

Procedure
1. Navigate to Service Catalog > Routine Changes > Terminate Amazon EC2 Instance.
   A list appears displaying the instances that are assigned to you.
2. Select an instance from the list and click Order.
   This list does not support multi-line selection, and there is no undo feature.

Check-out redirect property
A property called One-step checkout redirect (glide.vm.checkout_redirect) controls the view presented to virtual machine requesters in the service catalog.
By default, this property is set to false, which redirects the view to the Order Status form when the requester clicks Order Now. When this property is set to true, ServiceNow redirects the requester to his or her My Virtual Assets portal. This property is located in Cloud Management > Administration > Properties.

Delete request items
Use ServiceNow's web-based interface to delete items from a request.

About this task
All users can delete items from their own requests any time prior to delivery. Modifying a request does not resubmit it to the approval process.
Procedure

1. Navigate to **Service Catalog > Open Records > Requests** and open an existing request.

2. In the **Requested Items** related list, select the check box beside the item to delete.

3. In the **Actions** choice list, select **Delete**.

   ServiceNow recalculates the price and delivery date for the order.

---

Place a request

Use ServiceNow's web-based interface for ordering predefined goods and services.

Procedure

1. Navigate to **Self-Service > Service Catalog**.

   The default catalog view organizes items in categories and subcategories.

   **Default catalog view**

   ![Service Catalog]

2. Select an item to order.
**Note:** Some items are order guides, which combine related items for easier ordering. For example, an order guide called New Employee Hire presents a list of items that new employees typically receive (desk, phone, computer, email account). After you select the items you want to order, the order guide requests the information required and shows a separate time to delivery for each item ordered.

The order screen requests any additional information that's needed, such as the requester's name or location and the date the item is needed. It also displays the item's delivery time after approval.

### Delivery time

![Delivery time](image)

3. Enter complete and accurate information to expedite your order.
4. Order any other items required.
5. Click **Order Now** when the order is complete.

ServiceNow displays a confirmation screen for your order:

![Order submitted](image)
You can view the order's progress in the **Stage** column.

ℹ️ **Note:** It may be useful to note the order number for future reference.

ServiceNow automatically notifies the approvers if approval is required and creates work orders to fulfill the order according to your organization's process. For example, if you order a new notebook computer, the purchasing group might receive a work order to order the computer, and the desktop services group might receive a work order to configure the new computer and deliver it to your office after it arrives.

### Create incidents and change requests from a requested item

You can quickly open an incident or a change request from a requested item. It also maintains a relationship between the requested item, and its associated incidents or change requests.

**Before you begin**
The administrator must enable the **Create Change** and **Create Incident** UI actions for the Requested Item [sc_req_item] table. The administrator must set the **Active** field to **true** when **editing these UI actions**.

Role required: itil

**Procedure**
1. Navigate to **Self-Service > Requested Items**.
2. Open a requested item.
3. Click the Additional actions menu icon and select **Create Change** or **Create Incident**.

**Related information**
- Record Producer
- Service catalog requests

**View request status**

View the status of a request to see its progress, and determine when it may be fulfilled.
Procedure
1. Navigate to Self-Service > Requested Items.
2. Click your order number to view details.
3. View the order's progress in the Stage field.

4. Check the Backordered field, and if the item is backordered, review comments for information about its return to stock.

Customize homepages
If you are assigned at least one role in the system, you can create a customized homepage that you can see when you log in.

About this task
The content on your homepage comes from a variety of sources, such as graphs and charts generated from a report, application modules, a service catalog category, the scrolling news widget, which is the News knowledge category.

Procedure
1. Navigate to Self-Service > Homepage.
2. Add any item to the homepage by clicking the add content icon ( ) or the Add content link at the top.
A window will open that lets you select from a number of different homepage items you can add. Some items pertain to specific features and applications, such as CMS content blocks and the Work Management dispatch map. So the list of items varies depending on what is active on your system.

3. Reposition elements on your homepage by dragging and dropping them to a new location.

4. To remove a homepage item, click the [X] on the right side of the item's header.

Delete custom homepages

You can delete any of your custom homepages if you no longer need them.

Procedure

1. Click the Delete page link at the bottom of the homepage.

2. Click OK to confirm the deletion.

Service Delegation

Service delegation is the ability to designate other users to view and interact with approvals sent or tasks assigned to you, and to receive copies of all email notifications sent to you.

Note: Users to whom you delegate responsibility see all pending tasks and approvals regardless of the delegation period.

Note: Delegation does not cascade. When a user acts as a delegate for another user, the delegate cannot in turn delegate to a third party. The original delegate is the only user who receives assignments and notifications. Delegation does not grant the delegate access to tasks where the caller or requester is the user for whom the delegate was created.
Add the Delegates related list to a user profile

To delegate approvals and tasks to another user, configure your user profile form to display the Delegates related list.

Before you begin
Role required: personalize_form or admin.

Procedure
1. Navigate to Self-Service > My Profile.
2. On the form context menu, navigate to Configure > Related Lists, and then add the Delegate->User related list.

Results
The Delegates related list displays at the bottom of the user profile form.

Delegate approvals and tasks to another user

If a user is out of the office, that user can delegate responsibilities to other users for a period of time.

Procedure
1. Navigate to Self Service > My Profile.
2. In the Delegates related list, click New.
If the list is not visible, configure the form to add the Delegate->User related list.

3. Select the Delegate (User).
4. Set the period of time.
5. Specify the responsibilities the delegate will assume using the following check boxes. You can delegate:

- **Approvals**: The delegate can approve items on your behalf.
- **Assignments**: The delegate can view and work on tasks assigned to you.
- **CC notifications**: The delegate receives a copy of email notifications sent to you, except those marked as Meeting Invitation.

⚠️ Note: If the Approvals check box is selected but CC notifications is not, the delegate does not receive approvals.

- **Meeting invitations**: The delegate receives a copy of email notifications sent of the type Meeting Invitation.

⚠️ Note: You must select an active user as your delegate. The instance only delegates to active users. You can remove delegates from this list at any time.

**Example:**
A sample delegation looks like this:

![Delegation options](image)

Note: If your delegate gets email notifications, they will be the same email notifications sent to you. The delegate may be confused to see "Incident assigned to you" emails, so make sure they know they are a delegate.
Service administration
Configure settings for services that support business applications or the platform.

Assessments
Use assessments to evaluate, score, and rank records from any table in the system.

You can assess projects that executives want to evaluate for effective management, or rate and compare a vendor’s goods and services. Use assessments to send custom questionnaires to selected users or write scripts that query the database directly. You can then compare assessment results for the records using unique graphical views designed to highlight key performance information. Share an assessment between ServiceNow instances by using update sets, which is the recommended way to move assessment data from one instance to another.

The Assessments plugin is enabled by default.

You can only edit an assessment that has the same application scope as that of your current session.

The differences between assessments, surveys, and quizzes, and when to use each; also provides a quick look at the three stages in the survey process: designing, sharing, and evaluating.

Installed with Assessments
Several types of components are installed with activation of Assessments.

• Demo data is available for assessments and surveys.
• Vendor Performance offers an additional set of vendor assessment demo data.

Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description: Assessments</th>
<th>Description: Surveys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessable Record [asmt_assessable_record]</td>
<td>Stores all assessable records.</td>
<td>For system use only.</td>
</tr>
<tr>
<td>Assessment Category Result</td>
<td>Stores all category results.</td>
<td>For system use only.</td>
</tr>
<tr>
<td>Table</td>
<td>Description: Assessments</td>
<td>Description: Surveys</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>[asmt_category_result]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assessment Category User</td>
<td>Stores associations between users and metric categories they can assess. A user that is associated to a category is a category user.</td>
<td>Stores associations between users and surveys. A user that is associated to a survey is a survey user and is automatically associated to all the survey's categories.</td>
</tr>
<tr>
<td>[asmt_m2m_category_user]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assessment Group</td>
<td>Stores all assessment groups.</td>
<td>For system use only.</td>
</tr>
<tr>
<td>[asmt_assessment]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assessment Instance</td>
<td>Stores all assessment instances.</td>
<td>Stores all survey instances.</td>
</tr>
<tr>
<td>[asmt_assessment_instance]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assessment Instance Question</td>
<td>Stores all assessment instance questions, each of which represents one question on one assessment instance.</td>
<td>Stores all survey instance questions, each of which represents one question on one survey instance.</td>
</tr>
<tr>
<td>[asmt_assessment_instance_question]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assessment Metric</td>
<td>Stores all metrics.</td>
<td>Stores all survey questions.</td>
</tr>
<tr>
<td>[asmt_metric]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assessment Metric Definition</td>
<td>Stores all metric definitions.</td>
<td>Stores all answer options for survey questions.</td>
</tr>
<tr>
<td>[asmt_metric_definition]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assessment Metric Template</td>
<td>Stores all metric templates.</td>
<td>Stores all question templates.</td>
</tr>
<tr>
<td>[asmt_template]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assessment Metric Type</td>
<td>Stores all metric types.</td>
<td>Stores all survey definitions.</td>
</tr>
<tr>
<td>[asmt_metric_type]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description: Assessments</td>
<td>Description: Surveys</td>
</tr>
<tr>
<td>-------</td>
<td>------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Assessment Stakeholders [asmt_m2m_stakeholder]</td>
<td>Stores associations between assessable records and category users. A category user that is associated to an assessable record is a stakeholder.</td>
<td>Not used for surveys.</td>
</tr>
<tr>
<td>Assessment Template Definition [asmt_template_definition]</td>
<td>Stores all metric template definitions.</td>
<td>Stores all question template definitions.</td>
</tr>
<tr>
<td>Assessment X Category Matrix [asmt_m2m_xcategory_matrix]</td>
<td>Allows users to specify metric categories as the X axis of a decision matrix.</td>
<td>Not used for surveys.</td>
</tr>
<tr>
<td>Assessment Y Category Matrix [asmt_m2m_ycategory_matrix]</td>
<td>Allows users to specify metric categories as the Y axis of a decision matrix.</td>
<td>Not used for surveys.</td>
</tr>
<tr>
<td>Bubble Chart [asmt_bubble_chart]</td>
<td>Stores all bubble chart definitions.</td>
<td>Not used for surveys.</td>
</tr>
<tr>
<td>Category Assessable Records [asmt_m2m_category_assessment]</td>
<td>Stores associations between assessable records and metric categories.</td>
<td>For system use only.</td>
</tr>
<tr>
<td>Decision Matrix [asmt_decision_matrix]</td>
<td>Stores all decision matrixes.</td>
<td>Not used for surveys.</td>
</tr>
</tbody>
</table>
### Table

<table>
<thead>
<tr>
<th>Metric Category</th>
<th>Description: Assessments</th>
<th>Description: Surveys</th>
</tr>
</thead>
<tbody>
<tr>
<td>[asmt_metric_category]</td>
<td>Stores all metric categories.</td>
<td>Stores all survey categories.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Metric Result</th>
<th>Description: Assessments</th>
<th>Description: Surveys</th>
</tr>
</thead>
<tbody>
<tr>
<td>[asmt_metric_result]</td>
<td>Stores all metric results.</td>
<td>Stores all survey responses.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signature</th>
<th>Description: Assessments</th>
<th>Description: Surveys</th>
</tr>
</thead>
<tbody>
<tr>
<td>[asmt_signature]</td>
<td>Stores all signature records for assessments and [Attestations</td>
<td>GRC attestations]].</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trigger Condition</th>
<th>Description: Assessments</th>
<th>Description: Surveys</th>
</tr>
</thead>
<tbody>
<tr>
<td>[asmt_condition]</td>
<td>Stores all assessment trigger conditions.</td>
<td>Stores all survey trigger conditions.</td>
</tr>
</tbody>
</table>

### Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_portal_surveys.sp_survey.email_redirection</td>
<td>Allow a survey accessed from a link in an email to open in the Service Portal (applies only for surveys).</td>
</tr>
</tbody>
</table>

- **Type**: Yes/No
- **Default value**: no
- **Location**:
  - Assessments > Admin > Assessment Properties
  - Survey Management > Administration > Properties
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.assessment.signature_authentication</td>
<td>Require authentication for user signature. When Yes is selected, this property requires credentials for a full name signature. <strong>Type</strong>: True/False <strong>Default value</strong>: true <strong>Location</strong>: Assessments &gt; Admin &gt; Assessment Properties &gt; Survey Management &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td>css.assessment.question.header.background.color</td>
<td>Sets the background color of question headers on assessment and survey questionnaires. <strong>Type</strong>: color <strong>Default value</strong>: #767676 <strong>Location</strong>: Assessments &gt; Admin &gt; Assessment Properties</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>css.assessment.caption.background.color</td>
<td>Sets the background color of the caption on assessment and survey questionnaires.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: color</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: #eee</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>:</td>
</tr>
<tr>
<td></td>
<td>◦ Assessments &gt; Admin &gt; Assessment Properties</td>
</tr>
<tr>
<td></td>
<td>◦ Survey Management &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td></td>
<td>• <strong>Learn more</strong>: Customize the appearance of a survey</td>
</tr>
<tr>
<td>com.snc.assessment.decision_matrix_filter_max_entries</td>
<td>Maximum number of items to show for a decision matrix field filter.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 1000</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>:</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>◦ Assessments &gt; Admin &gt; Assessment Properties</td>
<td>• Learn more: Customize the appearance of a survey</td>
</tr>
<tr>
<td>◦ Survey Management &gt; Administration &gt; Properties</td>
<td>• Learn more: Customize the appearance of a survey</td>
</tr>
<tr>
<td>◦ css.assessment.caption.font.color</td>
<td>Sets the font color of the caption text on assessment and survey questionnaires.</td>
</tr>
<tr>
<td></td>
<td>• Type: color</td>
</tr>
<tr>
<td></td>
<td>• Default value: #ffffff</td>
</tr>
<tr>
<td></td>
<td>• Location: ◦ Assessments &gt; Admin &gt; Assessment Properties ◦ Survey Management &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td></td>
<td>• Learn more: Customize the appearance of a survey</td>
</tr>
</tbody>
</table>
User roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>assessment administrator</td>
<td>Contains roles</td>
<td>• None</td>
</tr>
<tr>
<td>[assessment_admin]</td>
<td>Can administer the Assessments application. Can access all the modules of the Assessments application.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note: The assessment_admin role is contained by the itil_admin role. It is also contained by the survey_admin role.</td>
<td></td>
</tr>
</tbody>
</table>

Script includes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AssessmentUtils</td>
<td>Core code for assessment functionality.</td>
</tr>
<tr>
<td>AssessmentUtilsAJAX</td>
<td>AJAX based code for displaying scorecard data.</td>
</tr>
<tr>
<td>MigrateSurveyToAssessment</td>
<td>Code for migrating legacy surveys to assessment surveys.</td>
</tr>
<tr>
<td>RatingUtilsAJAX</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>SurveyUtils</td>
<td>Core code for survey functionality.</td>
</tr>
</tbody>
</table>

Client scripts

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate Assessable Record Field choice list</td>
<td>Trigger Condition [asmt_condition]</td>
<td>Limits the Assessable Record Field choices to those that are compatible with the selected assessment.</td>
</tr>
<tr>
<td>Check survey schedule period</td>
<td>Trigger Condition [asmt_condition]</td>
<td>Checks the selected survey definition’s Schedule period. If Schedule period is set to Only Once, this client script displays a warning message that each</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Clear display_when when depends changed</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Shows the Display when field when the Depends on field is set. Clears the Display when field when the Depends on field changes and the options need to change.</td>
</tr>
<tr>
<td>Conditionally Set Type for Surveys</td>
<td>Group [sys_user_group]</td>
<td>Sets the user group Type to survey if you create a new group from the User Groups module.</td>
</tr>
<tr>
<td>Data type -- Hide choices for surveys</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Ensures only Data type options that are valid for surveys are available on the Survey Question form.</td>
</tr>
<tr>
<td>Data type -- Show/ Hide Not Applicable</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Hides the Allow not applicable field and sets its value to false if the metric method is Assessment and the data type is Percentage, Checkbox, Date, Date/Time, Number, or String.</td>
</tr>
<tr>
<td>Datatype defaults to String for surveys</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Sets the default Data type field value to String on the Survey Question form.</td>
</tr>
<tr>
<td>Fetch Min/ Max</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Updates the Min and Max fields to match the least and greatest metric template definition values if an assessment administrator</td>
</tr>
</tbody>
</table>

user can only take the selected survey once.
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Assessable Record Field</td>
<td>Trigger Condition [asmt_condition]</td>
<td>Selects or changes the Template value.</td>
</tr>
<tr>
<td>Hide Survey Instance Trigger ID if Empty</td>
<td>Assessment Instance [asmt_assessment_instance]</td>
<td>Hides the Assessable Record field unless the evaluation method of the metric type selected in the Assessment field is Assessment.</td>
</tr>
<tr>
<td>Hide user lists</td>
<td>Assessable Record [asmt_assessable_record]</td>
<td>Hides the Category users related list if the associated metric type schedule type is On demand.</td>
</tr>
<tr>
<td>Hide user related lists</td>
<td>Metric Category [asmt_metric_category]</td>
<td>Hides the User related list if the associated metric type schedule type is On demand and the Evaluation method is not Survey.</td>
</tr>
<tr>
<td>Hide value or String value</td>
<td>Assessment Instance Question [asmt_assessment_instance_question]</td>
<td>Hides the Value field and shows the String value field if the associated metric data type is Date, Date/Time, or String. Does the opposite if the data type is anything else.</td>
</tr>
<tr>
<td>Livefeed deletion warning</td>
<td>Assessable Record [asmt_assessable_record]</td>
<td>Displays a warning message if an assessment administrator clears the Live feed check box.</td>
</tr>
<tr>
<td>Method -- Show/</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Hides the Mandatory and Allow not...</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hide Not Applicable</td>
<td></td>
<td>applicable fields and sets both values to false if the metric method is Script. Shows the Mandatory field if the metric method is Assessment. Shows the Allow not applicable field if the method is Assessment except when the data type is Percentage, Checkbox, Date, Date/Time, Number, or String.</td>
</tr>
<tr>
<td>Min/Max Control</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Makes the Min and Max fields mandatory except when the data type is Template.</td>
</tr>
<tr>
<td>Min/Max Read-only</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Makes the Min and Max fields read-only when the data type is Choice or Likert Scale.</td>
</tr>
<tr>
<td>Populate Groups</td>
<td>Assessment Metric [asmt_metric_type]</td>
<td>Populates the available values for the Filter field with fields from the selected metric type table.</td>
</tr>
<tr>
<td>Read only Type</td>
<td>Metric Category [asmt_metric_category]</td>
<td>Makes the Type field read-only when it contains a value.</td>
</tr>
<tr>
<td>Reload Decision Matrix Filter Columns</td>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Populates the available choices for the Default matrix filter as appropriate if the Filter field value changes.</td>
</tr>
<tr>
<td>Reload default filters</td>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Populates the available choices for the Default filter as appropriate</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set scale factor</td>
<td>Assessment Metric Type</td>
<td>if the Display all filters value changes.</td>
</tr>
<tr>
<td></td>
<td>[asmt_metric_type]</td>
<td></td>
</tr>
<tr>
<td>Set table field</td>
<td>Metric Category</td>
<td>Sets the category Table value to that of the metric type.</td>
</tr>
<tr>
<td></td>
<td>[asmt_metric_category]</td>
<td></td>
</tr>
<tr>
<td>Show and Hide Scheduled Job</td>
<td>Assessment Metric Type</td>
<td>Hides the Scheduled job field if the Schedule type is On demand and shows</td>
</tr>
<tr>
<td></td>
<td>[asmt_metric_type]</td>
<td>the Scheduled job field if the Schedule type is Scheduled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show and Hide Scheduled Job Survey View</td>
<td>Assessment Metric Type</td>
<td>Shows the Scheduled job field on the Survey Definition form if the Schedule</td>
</tr>
<tr>
<td></td>
<td>[asmt_metric_type]</td>
<td>period is Daily, Weekly, Monthly, or Yearly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toggle Metric Definitions (Load)</td>
<td>Assessment Metric Type</td>
<td>Displays the Assessment Metric Definitions related list if the data type</td>
</tr>
<tr>
<td></td>
<td>[asmt_metric]</td>
<td>is Choice or Likert Scale.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toggle Metric Definitions (Update)</td>
<td>Assessment Metric Type</td>
<td>Displays the Assessment Metric Definitions related list if the data type</td>
</tr>
<tr>
<td></td>
<td>[asmt_metric]</td>
<td>is Choice or Likert Scale.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sets the Method field to the appropriate value if the data type is</td>
</tr>
<tr>
<td></td>
<td></td>
<td>compatible with one method only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update Min And Max Default Values</td>
<td>Assessment Metric Type</td>
<td>Sets reasonable default values for the Min and Max fields, based on the</td>
</tr>
<tr>
<td></td>
<td>[asmt_metric]</td>
<td>data type.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Validate Probability</td>
<td>Survey Trigger Condition [asmt_condition]</td>
<td>Ensures that the Probability (%) value is a whole number between 1 and 100.</td>
</tr>
<tr>
<td>Verify Max</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Verifies that the Max value is greater than the Min value and greater than or equal to zero if the metric method is Assessment.</td>
</tr>
<tr>
<td>Verify Min</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Verifies that the Min value is less than the Max value and greater than or equal to zero if the metric method is Assessment.</td>
</tr>
<tr>
<td>Verify Value</td>
<td>Assessment Metric Definition [asmt_metric_definition]</td>
<td>Verifies that the Value is greater than or equal to zero.</td>
</tr>
<tr>
<td>Verify Value</td>
<td>Assessment Template Definition [asmt_template_definition]</td>
<td>Verifies that the Value is greater than or equal to zero.</td>
</tr>
</tbody>
</table>

**Business rules**

**Business rules for Assessments**

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessable domain matches type</td>
<td>Assessable Record [asmt_assessable_record]</td>
<td>Ensures that all new assessable records are in the same domain as the metric type. This is a special requirement of assessment domain separation, that all records must be in the same domain.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Auto stakeholder creation</td>
<td>Assessment Category User [asmt_m2m_category_user]</td>
<td>Assigns new category users as stakeholders automatically for assessable records if the associated category has the Create stakeholders check box selected.</td>
</tr>
<tr>
<td>Auto stakeholder creation</td>
<td>Category Assessable Records [asmt_m2m_category_assessment]</td>
<td>Creates stakeholders from all of a category’s category users automatically for new assessable records if:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The Create stakeholders check box is selected for the metric category.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The same metric category is associated to the new assessable record.</td>
</tr>
<tr>
<td>Auto stakeholder creation</td>
<td>Metric Category [asmt_metric_category]</td>
<td>Assigns all of a category’s category users as stakeholders for each assessable record associated to the category when the Create stakeholders check box is selected for the category.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Calculate category max weight</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Calculates the sum of all metric weights in a category.</td>
</tr>
<tr>
<td>Cancel notification workflow</td>
<td>Assessment Instance [asmt_assessment_instance]</td>
<td>Cancels the workflow that generates assessment email notifications when an assessment instance is deleted or changes state to Complete or Canceled.</td>
</tr>
<tr>
<td>Category domain matches type</td>
<td>Metric Category [asmt_metric_category]</td>
<td>Ensures that all new categories are in the same domain as the metric type. This is a special requirement of assessment domain separation, that all records must be in the same domain.</td>
</tr>
<tr>
<td>Check Live Feed Groups</td>
<td>Assessable Record [asmt_assessable_record]</td>
<td>Selects the Live feed check box if a live feed group is associated with the source record. If the Live feed check box is selected and no live feed group is associated with the source record, this business rule clears the check box.</td>
</tr>
<tr>
<td>Check only one default</td>
<td>Bubble Chart [asmt_bubble_chart]</td>
<td>Ensures there is only one default bubble</td>
</tr>
</tbody>
</table>
### Business rules for Assessments (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check only one default</td>
<td>Decision Matrix [asmt_decision_matrix]</td>
<td>Ensures there is only one default decision matrix for a metric type.</td>
</tr>
<tr>
<td>Create actual results</td>
<td>Assessment Instance [asmt_assessment_instance]</td>
<td>Generates assessment and category results from the user responses if a user completes an assessment.</td>
</tr>
<tr>
<td>Create Business Rule on Remote table</td>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Generates the following business rules if an assessment administrator creates or updates a metric type:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Business rule called Auto business rule for Assessments, which monitors the Table selected for the metric type. When someone adds a record that meets the metric type conditions, this business rule generates an assessable record. If someone changes the metric type’s Table or conditions, the Create Business Rule on Remote table business</td>
</tr>
</tbody>
</table>
### Business rules for Assessments (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>The Create Business Rule on Remote table business rule generates automatic business rules only for metric types with Evaluation method set to Assessment.</td>
</tr>
<tr>
<td>Create Scheduled Job</td>
<td>Assessment Metric Type</td>
<td>Assessments: Generates a scheduled job for the creation of assessment components if either of these conditions is met:</td>
</tr>
<tr>
<td></td>
<td>[asmt_metric_type]</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Create Survey Records</td>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Generates various records and populates certain fields on those records when someone creates a new survey definition, which is a metric type with Evaluation method set to Survey. More specifically, this business rule generates a survey category and assessable record, both associated to the survey definition.</td>
</tr>
</tbody>
</table>
### Business rules for Assessments (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create UI Action on Remote table</td>
<td>Assessment Metric Type</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>decision_matrix_axis</td>
<td>Global</td>
<td>Limits available categories for X- and Y-axes to those that belong to the type if there is a metric type specified on the Decision Matrix form.</td>
</tr>
<tr>
<td>Delete Live Feed Group</td>
<td>Assessable Record</td>
<td>Deletes the assessable record's live feed group, if there is one, when an assessment administrator deletes an assessable record.</td>
</tr>
<tr>
<td>delete related users</td>
<td>Category Assessable Records</td>
<td>Deletes any stakeholders for the assessable record and category when an assessment administrator disassociates a category from an assessable record.</td>
</tr>
<tr>
<td>Do not allow category to change</td>
<td>Assessment Metric</td>
<td>Prevents the Category field from being changed if there are any conditional question dependencies related to the current record.</td>
</tr>
<tr>
<td>Do not allow datatype to change</td>
<td>Assessment Metric</td>
<td>Prevents the Data type and Template fields from being changed if there are any conditional question dependencies related to the current record.</td>
</tr>
</tbody>
</table>
### Business rules for Assessments (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensure Types Match</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Sets the type of a metric to the type of the associated category.</td>
</tr>
<tr>
<td>Ensure types match</td>
<td>Assessment Stakeholders</td>
<td>Ensures users can only create a stakeholder from a category user and assessable record of the same type.</td>
</tr>
<tr>
<td>Ensure types match</td>
<td>Category Assessable Records</td>
<td>Prevents users from associating categories of one type to an assessable record of a different type.</td>
</tr>
<tr>
<td>Evaluate filters</td>
<td>Assessable Record [asmt_assessable_record]</td>
<td>Performs the following after the system generates a new assessable record:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Checks all filter conditions for categories in the type.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Automatically associates the new assessable record to all categories for which it meets the category filter conditions.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Generate assessment trigger condition</td>
<td>Trigger Condition [asmt_condition]</td>
<td>Generates a business rule the survey or assessment trigger condition uses to send surveys or assessments.</td>
</tr>
<tr>
<td>getStakeholders</td>
<td>Global [global]</td>
<td>Ensures that only category users for categories associated with the assessable record are available on the Assessable Record form when users edit the Category users related list.</td>
</tr>
</tbody>
</table>
| Link assessable record and category       | Metric Category [asmt_metric_category] | Sets these hidden fields as follows for a newly created survey category:  
  • Table: Assessment Metric Type [asmt_metric_type]  
  • Filter: <sys_id of the survey definition the new survey category is associated with> |
| Live Feed Group                           | Assessable Record [asmt_assessable_record] | Creates a live feed group for the assessable record, if one does not exist, when the record is saved with the Live feed check box selected. If the check box is then... |
## Business rules for Assessments (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metric domain matches category</td>
<td>Assessment Metric</td>
<td>Ensures that all new metrics are in the same domain as the category to which they belong. This is a special requirement of assessment domain separation, that all records must be in the same domain.</td>
</tr>
<tr>
<td>Notify assessment user</td>
<td>Assessment Instance</td>
<td>Starts a workflow that sends an email notification to the assigned user when an assessment instance changes to the Ready state or the user to which it is assigned changes. The workflow generates other assessment email notifications at later stages.</td>
</tr>
<tr>
<td>Prevent recursive dependencies</td>
<td>Assessment Metric</td>
<td>Prevents the Depends on field from being set in a way that creates a recursive conditional question dependency.</td>
</tr>
</tbody>
</table>
## Business rules for Assessments (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publish Survey</td>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Generates survey instances and assigns them to the associated survey users when the survey definition state changes from Draft to Published.</td>
</tr>
<tr>
<td>Remove auto create Business Rules</td>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Deletes the automatically created business rule for a metric type when an assessment administrator deletes that metric type.</td>
</tr>
<tr>
<td>Remove auto create UI Actions</td>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Remove auto created business rule</td>
<td>Survey Trigger Condition [asmt_condition]</td>
<td>Deletes the automatically created business rule when someone deletes the survey trigger condition.</td>
</tr>
<tr>
<td>Remove Scheduled Job</td>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Assessments: Deletes the scheduled job for a metric type if either of these conditions is met:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Someone deletes the metric type.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Someone changes the schedule type from Scheduled to On demand.</td>
</tr>
</tbody>
</table>
## Business rules for Assessments (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surveys: Deletes the scheduled job for a survey definition if the schedule period is set to Only Once or No Limit.</td>
<td>Assessment Metric Definition [asmt_metric_definition]</td>
<td>Updates the Min and Max fields for metrics and survey questions based on the metric definition Value.</td>
</tr>
<tr>
<td>Set Domain for M2M Cat Assessable Recs</td>
<td>Category Assessable Records [asmt_m2m_category_assessment]</td>
<td>Ensures that assessable records are only associated to categories in the same domain. This is a special requirement of assessment domain separation, that all records must be in the same domain.</td>
</tr>
<tr>
<td>Set Domain for M2M Category Users</td>
<td>Assessment Category User [asmt_m2m_category_user]</td>
<td>Ensures that users are only linked to categories in the same domain. This is a special requirement of assessment domain separation, that all records must be in the same domain.</td>
</tr>
<tr>
<td>Set Domain for M2M Stakeholders</td>
<td>Assessment Stakeholders [asmt_m2m_stakeholder]</td>
<td>Ensures that assessable records are only linked to category users in the same domain. This is a special requirement of assessment domain separation, that all records must be in the same domain.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Require domain separation</td>
<td></td>
<td>Requirement of assessment domain separation, that all records must be in the same domain.</td>
</tr>
<tr>
<td>Set scratchpad fields</td>
<td>Assessment Metric Type</td>
<td>Caches field values for use by other scripts that run on the Assessment Metric Type form.</td>
</tr>
<tr>
<td>Store view type</td>
<td>Metric Category</td>
<td>Ensures that the Type field only allows users to select metric types used for assessments.</td>
</tr>
<tr>
<td>Synchronize category survey</td>
<td>Assessment Category User</td>
<td>Ensures that the same users are associated with all of a survey's categories.</td>
</tr>
<tr>
<td>Users</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Synchronize survey users and</td>
<td>Metric Category</td>
<td>Adds all users associated with a survey's existing categories to any newly created category for that survey.</td>
</tr>
<tr>
<td>Stakeholder</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update Category Count</td>
<td>Assessment Metric</td>
<td>Updates the value in the Total metrics field on the Metric Category form when metrics are added to and deleted from the category.</td>
</tr>
<tr>
<td></td>
<td>[asmt_metric]</td>
<td></td>
</tr>
<tr>
<td>Update records that match</td>
<td>Metric Category</td>
<td>Automatically performs these tasks when an assessment</td>
</tr>
<tr>
<td>filter</td>
<td>[asmt_metric_category]</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Administrator edits the Filter field:</td>
<td></td>
<td>• Associates the category to assessable records that meet the filter conditions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Disassociates the category from assessable records that do not meet the filter conditions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Assessable records related list reflects these changes when the record is saved.</td>
</tr>
<tr>
<td>Update scheduled job on schedule change</td>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Updates the survey creation scheduled job to reflect schedule period changes.</td>
</tr>
<tr>
<td>Validate mandatory and not applicable</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Sets the Mandatory and Allow not applicable fields to false if the metric method is Script. If the metric data type is Percentage, the business rule sets the Allow not applicable field to false.</td>
</tr>
<tr>
<td>Verify min/max</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Ensures that the Min is greater than or equal to zero and less than the Max.</td>
</tr>
</tbody>
</table>
Business rules for Assessments (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify value</td>
<td>Assessment Template Definition [asmt_template_definition]</td>
<td>Sets the Min to 0 and the Max to 1 if the data type is Checkbox or Yes/No.</td>
</tr>
<tr>
<td>Verify value</td>
<td>Assessment Metric Definition [asmt_metric_definition]</td>
<td>Ensures that users can only enter a metric definition Value greater than or equal to zero. Ensures that the metric definition Value is different from the Value for all other metric definitions related to the metric.</td>
</tr>
</tbody>
</table>

Assessment administrator tasks

Before you create assessments, assign the assessment_admin role to the appropriate users in your organization and determine your objectives for the assessment.

Decide which sets of records in the system to assess, which themes you are interested in, and which traits to measure. Consider your organization’s options for obtaining the data to compare. If you intend to use assessment questionnaires, consider which people can answer the questions.
# Assessment terminology

Assessment admins use several terms when working with assessments.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metric type</td>
<td>A <em>metric type</em> defines a set of records to evaluate, such as vendors, projects, or employees.</td>
</tr>
<tr>
<td>Assessable record</td>
<td>An <em>assessable record</em> links a record to evaluate, such as the company record for Amazon or the user record for a sales representative, to a metric type, such as vendors or employees. You define sets of assessable records when you create metric types.</td>
</tr>
<tr>
<td>Metric category</td>
<td>A <em>metric category</em> represents a theme for evaluating assessable records. Categories contain one or more individual metrics, which define specific traits or values that comprise the theme. Examples of categories include overall vendor performance or quality of delivery services. You can also set filter conditions that control which assessable records to evaluate for the metrics in a category.</td>
</tr>
<tr>
<td>Metric</td>
<td>A <em>metric</em> is a trait or value used to evaluate assessable records. A metric can measure subjective values in an assessment questionnaire, or gather objective values in a database query run by a script. Examples of metrics include perceived courtesy of sales representatives or number of incidents per vendor.</td>
</tr>
<tr>
<td>Category user</td>
<td>A <em>category user</em> is a person who knows about a specific category. One person can be a category user for multiple categories. Examples of category users include a vendor manager who oversees all purchasing operations or a supervisor of a sales team.</td>
</tr>
<tr>
<td>Stakeholder</td>
<td>A <em>stakeholder</em> is a category user who knows about a specific assessable record. Examples of stakeholders include a vendor manager who coordinates purchases from Amazon or a supervisor of a sales team who manages a specific employee.</td>
</tr>
<tr>
<td>Assessment instance</td>
<td>An <em>assessment instance</em> represents one assessment questionnaire assigned to one user. The system generates a new assessment instance for each assigned user when:</td>
</tr>
<tr>
<td></td>
<td>• The assessment generation scheduled job runs.</td>
</tr>
<tr>
<td></td>
<td>• An assessment administrator creates an on-demand assessment.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Scorecard</td>
<td>A scorecard provides a visual illustration of an assessable record’s performance, based on assessment results. Use scorecards to view a variety of data summaries for one assessable record and to compare the ratings with other assessable records.</td>
</tr>
<tr>
<td>Decision matrix</td>
<td>A decision matrix is a graph with two axes that plots the assessment results for multiple assessable records. Use decision matrices to determine the relative standing of assessable records in selected categories.</td>
</tr>
<tr>
<td>Bubble chart</td>
<td>A bubble chart is a graph with three axes that plots the assessment results for multiple assessable records. Use bubble charts to determine the relative standing of assessable records in selected categories, with an emphasis on one category.</td>
</tr>
</tbody>
</table>

**Assessment roles**

The Assessments application requires certain roles to perform assessment tasks. No role is required to take assessment questionnaires that are assigned to you.

<table>
<thead>
<tr>
<th>Role Title</th>
<th>Role Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Assessment administrator | assessment_admin | Assessment administrators set up assessments. They know which records to evaluate, the criteria on which to evaluate the records, and who to assign assessments to.  

**Note:** By default, users with the assessment_admin role have limited system rights and might not have access to all source records to assess. When planning assessments, grant additional roles to assessment administrators as needed. For example, to create and manage vendor assessments, the assessment administrator must also have the vendor_manager role, which grants access to the Company table and other relevant tables.  

<p>| ITIL user  | itil            | ITIL users perform basic technician operations in the system. In the Assessments |</p>
<table>
<thead>
<tr>
<th>Role Title</th>
<th>Role Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>admin</td>
<td>Administrators have access to all aspects of the assessment process. Only administrators can set up assessment schedules.</td>
</tr>
</tbody>
</table>

**Assessment methods**

The available methods are **Assessment**, for non-scripted metrics, and **Script**, for scripted metrics. Each method serves a different function and can be used with certain data types.

Use the **Method** field to specify how to use the metric.

**Assessment method**

Metrics with the Method set to Assessment are called non-scripted metrics. Use each non-scripted metric to define a question for assessment questionnaires. Non-scripted metrics are useful if you want to obtain subjective data like personal opinions.

You can use the Assessment method with these **Data type** values:

- Attachment
- Checkbox
- Choice
- Date
- Date/Time
- Likert Scale
- Number
- Percentage
- String
- Template
- Yes/No

**Script method**

Metrics with the Method set to Script are called scripted metrics. Use each scripted metric to define a custom script for database queries. Scripted metrics are useful if your system contains reliable data for the traits you want to evaluate.
You can use the Script method with these **Data type** values:

- Duration
- Number
- Percentage

Use the Script field to write JavaScript code. By default, the field contains information about available variables and an example, which you can use as the basis of your script or replace entirely:

You must use the following variables in your script:

- **primary**: Input variable used to access the sys_id of the record being assessed.
- **actual_result**: Output variable that contains the actual value for this metric. The system uses this variable to populate the Actual value field on the Metric Result form. For each actual_result, you must specify a corresponding **scaled_result** value.
- **scaled_result**: Output variable that contains a numerical scaled value to represent an actual value. The system uses this variable to populate the Scaled value field on the Metric Result form. Ensure the scaled values you specify are between or equal to the **Min** and **Max** values for the metric. The Scale definition field determines how the system uses the scaled value. A scale definition of **Low** means smaller numbers are better, such as for a metric that measures the number of incidents for a vendor. **High** means larger numbers are better, such as for a metric that measures user satisfaction on a scale of one to five.

**Script example**

The metric Number of active devices uses the script pictured below. The **primary** variable is used to find CIs that are associated to the vendor record being assessed. The script retrieves the actual_result, the number of CIs associated to the vendor, then calculates the correct scaled_result. The script uses a series of scaled values, from the **Min** to the **Max** value, to represent actual values. Because the Scale definition is set to **High**, the greatest scaled values are best.
meaning a vendor associated to the most CIs scores highest. The system stores the actual and scaled values in a metric result record for the vendor.

**Scripted metric example**

<table>
<thead>
<tr>
<th>Field Type</th>
<th>Data type: Number</th>
<th>Min: 0</th>
<th>Max: 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dependent plugin: CMBD</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale definition: High</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

```javascript
var gr = new GlideRecord('mdm_ci');
gr.addQuery('Vendor', 'primary');
gr.addQuery('Install_status NOT IN100,7,8');
gr.query();

actual_result = gr.getNowCount();
if (actual_result < 1) {
  scaled_result = 0;
} else if (actual_result < 1000) {
  scaled_result = 1;
} else if (actual_result < 10000) {
  scaled_result = 2;
} else if (actual_result < 25000) {
  scaled_result = 3;
} else if (actual_result < 50000) {
  scaled_result = 4;
} else {
  scaled_result = 5;
}
```

- Match to least and greatest scaled values.
- Specify how to calculate the actual_result value.
- Specify each return value or range of return values you want to score.
- Specify a numerical scaled value for each return value.

**Related information**

Assessment metrics
- Create an assessment metric for a category
- Create an assessment metric definition
- Create a metric template
- Update a metric minimum and maximum value to match a template

**Data types for assessments**

Metric data types have functions that depend on the method that you select.

**Assessment data types**

<table>
<thead>
<tr>
<th>Data type</th>
<th>Compatible methods</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>Assessment</td>
<td>On questionnaires, users attach one or more files to a question.</td>
</tr>
<tr>
<td>Checkbox</td>
<td>Assessment</td>
<td>On questionnaires, users select a check box next to a statement.</td>
</tr>
</tbody>
</table>

Set the **Scale definition** field to **High** if a selected check box equates to a good score.
<table>
<thead>
<tr>
<th>Data type</th>
<th>Compatible methods</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choice</td>
<td>Assessment</td>
<td>On questionnaires, users select a value from a list of custom answer options. Create a metric definition for each answer option.</td>
</tr>
<tr>
<td>Date</td>
<td>Assessment</td>
<td>On questionnaires, users select a date.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Assessment</td>
<td>On questionnaires, users select a date and time.</td>
</tr>
</tbody>
</table>
## Assessment data types (continued)

<table>
<thead>
<tr>
<th>Data type</th>
<th>Compatible methods</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>Script</td>
<td>When the script runs, the system populates the <strong>Duration value</strong> and <strong>Scaled value</strong> fields on the <strong>Metric Result</strong> form with the appropriate values from the <code>actual_result</code> and <code>scaled_result</code> variables in the metric script.</td>
</tr>
<tr>
<td>Likert Scale</td>
<td>Assessment</td>
<td>On questionnaires, users select a value from a custom scale of answer options. Create a metric definition for each answer option, which is represented by a radio button on the scale. A Likert scale metric that evaluates an application's ease of use might have the metric definitions <strong>Easy</strong>, <strong>Average</strong>, and <strong>Difficult</strong>. If you want to reuse a series of answer options for multiple metrics, create a metric template and use the <strong>Template data type</strong> instead of the Likert Scale data type.</td>
</tr>
<tr>
<td>Number</td>
<td>Assessment, Script</td>
<td><strong>Assessment</strong>: On questionnaires, users enter a number. <strong>Script</strong>: When the script runs, the system populates the <strong>Actual value</strong> and <strong>Scaled value</strong> fields on the <strong>Metric Result</strong> form with the appropriate values from the <code>actual_result</code> and <code>scaled_result</code> variables in the metric script.</td>
</tr>
</tbody>
</table>
### Assessment data types (continued)

<table>
<thead>
<tr>
<th>Data type</th>
<th>Compatible methods</th>
<th>Description</th>
</tr>
</thead>
</table>
| Percentage  | Assessment, Script | **Assessment** On questionnaires, users enter a number.  

Approximately what percent of the time are your incidents resolved in a week?  

50 %

**Script** When the script runs, the system populates the **Actual value** and **Scaled value** fields on the Metric Result form with the appropriate values from the `actual_result` and `scaled_result` variables in the metric script. |
| String      | Assessment         | On questionnaires, users enter text. The size of the string field depends on the String option you select:  

**String single line wide data type**  

Additional comments  

Additional comments  

Additional comments |
| Template     | Assessment         | On questionnaires, users select a value from a predefined series of answer options. There must be at least one template defined to use this data type. For a template, there is a template definition for each answer option, which is represented by a radio button. |
| Yes/No       | Assessment         | On questionnaires, users select **Yes** or **No** from a list. |
### Assessment data types (continued)

<table>
<thead>
<tr>
<th>Data type</th>
<th>Compatible methods</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Set the **Scale definition** field to **High** if selecting **Yes** equates to a better score.

### Related information

- Assessment metrics
- Create an assessment metric definition
- Create a metric template
- Update a metric minimum and maximum value to match a template

### Configure an assessment

Configure an assessment to evaluate, score, and rank records from any table in the system.

**Before you begin**

Role required: admin, survey_creator, or assessment_admin

**Procedure**

1. Navigate to **Assessments** > **Metric Definition** > **Types**.
2. Click **New**.
3. Enter the field information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the assessment.</td>
</tr>
<tr>
<td>Assessment duration</td>
<td>Allowed duration to complete an assignment after its generation.</td>
</tr>
<tr>
<td>Live feed</td>
<td>Checkbox that automatically creates live feed groups for newly generated assessable records of this type.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Notify manager if overdue</td>
<td>Checkbox to send a notification to the manager when the assessment becomes overdue.</td>
</tr>
<tr>
<td>Scale factor</td>
<td>Scale value for all assessment results.</td>
</tr>
<tr>
<td>Pagination setting for Service Portal view</td>
<td>The setting on which the pagination is based for desktop or tablet view in Service Portal.</td>
</tr>
<tr>
<td></td>
<td>• Category: default</td>
</tr>
<tr>
<td></td>
<td>• Question: 1 question per page (automatic for mobile)</td>
</tr>
<tr>
<td></td>
<td>• None: no pagination</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field is displayed only when Service Portal is installed.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Business rule that is automatically created for assessable record generation.</td>
</tr>
<tr>
<td>Schedule type</td>
<td>Scheduled or on-demand assessment type.</td>
</tr>
<tr>
<td>Scheduled job</td>
<td>Scheduled job the system creates for this assessment definition when the schedule period is a repeating interval.</td>
</tr>
<tr>
<td></td>
<td>The system sets the scheduled job to run according to the selected schedule period. If you change the schedule period and save the survey definition:</td>
</tr>
<tr>
<td></td>
<td>• The system deletes the old scheduled job.</td>
</tr>
<tr>
<td></td>
<td>If you selected a recurring schedule period:</td>
</tr>
<tr>
<td></td>
<td>• A new scheduled job is created.</td>
</tr>
<tr>
<td></td>
<td>For example, if you change the schedule period from Daily to Weekly and save the record:</td>
</tr>
<tr>
<td></td>
<td>• The system deletes the daily scheduled job.</td>
</tr>
<tr>
<td></td>
<td>• Creates a weekly one set to run a week from the current date.</td>
</tr>
<tr>
<td></td>
<td>This field is visible to administrators only if the schedule period is Daily, Weekly, Monthly, or Yearly.</td>
</tr>
<tr>
<td>Evaluation method</td>
<td>Type of assessment.</td>
</tr>
<tr>
<td>Roles</td>
<td>Roles with read access for this metric type.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to enable the distribution of this assessment to recipients.</td>
</tr>
<tr>
<td>Owners</td>
<td>Owners of the assessment. You can add a user with the survey_creator, survey_admin, or assessment_admin role.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the assessment.</td>
</tr>
<tr>
<td>Conditions</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Table that contains records to assess for this type.</td>
</tr>
<tr>
<td>Enforce condition</td>
<td>Checkbox to delete the existing assessable records of this type that do not meet the specified conditions.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions that the assessable records of this type should meet.</td>
</tr>
<tr>
<td>Decision Matrix</td>
<td></td>
</tr>
<tr>
<td>Filter field</td>
<td>Field on the Filter table to identify filter menu choices on decision matrices and scorecard averages for this type.</td>
</tr>
<tr>
<td>Filter condition</td>
<td>Conditions to filter results on decision matrices and scorecard averages for this type.</td>
</tr>
<tr>
<td>Default matrix filter</td>
<td>Default filter menu choice on decision matrix of this type.</td>
</tr>
<tr>
<td>Assessors</td>
<td></td>
</tr>
<tr>
<td>User field</td>
<td>User field from the table specified in the Conditions tab. The assessment will be assigned to all users of this user field in the table.</td>
</tr>
<tr>
<td></td>
<td>When you save the assessment and click Generate Assessable Records, an assessable record is created for each unique user of the user field. This is applicable for Scheduled and On-demand assessments.</td>
</tr>
<tr>
<td></td>
<td>For an on-demand assessment, each assessor assesses all assessable records. For a scheduled assessment, each assessor assesses only the corresponding assessable record.</td>
</tr>
<tr>
<td>Related Links</td>
<td></td>
</tr>
<tr>
<td>Generate Assessable Records</td>
<td>Creates assessable records for this metric type.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Benchmarks</td>
<td>Opens the Benchmarks Dashboard that provides visibility into your key performance indicators (KPIs) and trends.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>• This related link is available only for survey_admin, assessment_admin and survey_reader with bm_viewer role.</td>
</tr>
<tr>
<td></td>
<td>• You must opt in to Benchmarks to view the dashboard. See <a href="#">Enable Benchmarks</a>.</td>
</tr>
<tr>
<td></td>
<td>• This is applicable only for a published survey.</td>
</tr>
<tr>
<td>Create Improvement Initiative</td>
<td>Opens the Improvement Initiative window to create an improvement initiative record that helps in improving the performance of the assessment.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>• This related link is available only for the survey_admin and assessment_admin role. A survey_reader can only view the created improvement initiative records.</td>
</tr>
<tr>
<td></td>
<td>• You should activate the Continual Improvement Management plugin (com.sn_cim).</td>
</tr>
</tbody>
</table>

**Related Lists**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metric Categories</td>
<td>All metric categories for this assessment.</td>
</tr>
<tr>
<td>Assessable Records</td>
<td>All assessable records for this assessment.</td>
</tr>
<tr>
<td>Improvement Initiatives</td>
<td>Displays improvement initiatives associated with the survey.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This related list is available only when there is at least one improvement initiative record.</td>
</tr>
</tbody>
</table>

**Assessment generation**

In the Assessments application, administrators or assessment administrators can trigger the system to generate scheduled assessments or on-demand assessments when all the prerequisite steps are completed.

An assessment administrator must publish the metric type to enable assessment generation.
The system performs these tasks when it generates assessments:

- Creates assessment questionnaires from non-scripted metrics and assigns the questionnaires to users. When users complete their assigned questionnaires, the system uses their responses to calculate assessment results.
- Runs scripted metrics from each category to query the database and calculate assessment results.

Each time the system generates assessments, it creates some or all of the following components. Consider having an administrator set a schedule for recurring data cleanup, as the system can potentially generate a considerable amount of assessment data.

- Assessment group
- Assessment instances
- Assessment results

**Assessment groups**

An assessment group is a container for assessment instances and assessment results generated in a single occurrence.

The system generates an assessment group every time the scheduled job runs or the API is called, when there is at least one assessable record associated to a category in the type. You can find assessment group records in Assessments > Assessment Groups.

The Assessment Group form displays the group **Number**, the associated **Metric type**, and these related lists:

- **Assessment Instances**: Lists all assessment instances within this group. There may be no records in this related list. The system does not generate assessment instances if there are only scripted metrics for the type.
- **Metric Results**: Lists all **metric results** for this group. There may be no records in this related list initially. The system generates metric results immediately for scripted metrics, but not for non-scripted metrics, which appear as questions on assessments and require user response. The system dynamically updates the records in this list as users complete assessment questionnaires.
- **Assessment Category Results**: Lists all **category results** for this group. There may be no records in this related list initially. The system generates category results immediately if there are only scripted metrics in a category. Otherwise, the system does not calculate category results until a user completes an assessment questionnaire that contains questions from the category.
Note: To prevent the loss of important assessment data, you cannot delete an assessment group if it contains any assessment instances, metric results, or category results.

View an assessment metric category

View assessment metric categories that are used with assessment metric types and assessment metrics in generating the bubble charts on the Demand Workbench. The bubble charts help the demand managers to visually assess the demands.

Before you begin
Role required: it_pps_admin

About this task
The Demand Management application comes with an assessment metric type named Demand, five default assessment metric categories, and assessment metrics.

Procedure
1. Navigate to Project Administration > Settings > Assessments Metric Categories.
2. Open an assessment metric category to review it.
   The following default assessment metric categories are available with the Demand Management.

<table>
<thead>
<tr>
<th>Assessment metric category</th>
<th>Data source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>T-Shirt size field on the Demand form.</td>
<td>Assesses demand size relative to the size of other demands.</td>
</tr>
<tr>
<td>Strategic Alignment</td>
<td>Rating field in the assessment category result for the Strategic Alignment metric category.</td>
<td>Assesses how closely the demand aligns with strategic goals of the organization compared to other demands.</td>
</tr>
<tr>
<td>Risk</td>
<td>Rating field in the assessment category result for the Risk metric category.</td>
<td>Assesses demand risks compared to other demands.</td>
</tr>
</tbody>
</table>
### Assessment metric categories

In the Assessments application, a metric category represents a theme for evaluating assessable records in a given metric type.

Each category has a numeric weight value to indicate its importance relative to other categories. Within a category, records called metrics are the traits or values used to evaluate assessable records. For example, there are many categories within the Vendor metric type, including Support Rating, which contains metrics that measure the quality of vendors’ customer support services. Assessable records must be associated to categories to be eligible for evaluation. Assessment administrators create categories and manage which assessable records each category is associated to.

### Weight categories and metrics

When you create a metric category or metric, you must specify a weight, a numeric value that indicates the importance of the category or metric relative to other categories and metrics.

The greater the weight value, the more important the item is. The system uses weight values in assessment result calculations. Consider these recommendations when choosing weight values.

- **Determine a weighting scale and use it consistently.** In general, use a scale with a small numeric range. A standard 1-10 scale is usually appropriate, where 1 is least and 10 most important. Understand that increasing the maximum value of a weighting scale impacts all related result calculations.

- **Use the same weighting scale for metric categories and metrics.** Though there is no limitation, consider using the same or very similar weighting scales for both categories and metrics to make it easier to remember which values to use. A scale of 1-10 is an effective and simple weighting system, but may not be suitable for all organizations.

<table>
<thead>
<tr>
<th>Assessment metric category</th>
<th>Data source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROI</td>
<td>Impact and Financial return fields on the Demand form.</td>
<td>Assesses demand return on investment compared to other demands.</td>
</tr>
<tr>
<td>Cost</td>
<td>Labor costs, Capital expense, and Operating expense fields on the Demand form.</td>
<td>Assesses demand cost compared to other demands.</td>
</tr>
</tbody>
</table>
Note: If you do not want to use weighting, set the same weight value for all categories and metrics. The default weight value is 10.

Related reference
Metric templates
Related information
Assessment metrics
Create an assessment metric for a category
Create an assessment metric definition
Create a metric template
Update a metric minimum and maximum value to match a template

Create a category for assessable records
After you create a metric type and generate assessable records, create categories for the themes you are interested in using to evaluate the assessable records.

Before you begin
Role required: none

Procedure
1. Navigate to Assessments > Metric Definition > Categories.
2. Click New to create a new metric category and then complete the Metric Category form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the metric category. The name appears on assessment questionnaires.</td>
</tr>
<tr>
<td>Type</td>
<td>[Required] Metric type this category is used for. Metrics in this category can be used to evaluate assessable records for the type you select. This field becomes read-only after you save the record.</td>
</tr>
<tr>
<td>Create stakeholders</td>
<td>Check box that enables (selected) or disables (cleared) automatic stakeholder creation for this category. When the check box is selected, the system makes all associated category users stakeholders for each assessable record associated to this category. This saves the time required to manually create stakeholders. For more information, see</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Create Stakeholders Automatically. Existing stakeholders are not impacted if you clear the check box.</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>[Read-Only] Table that contains the records to evaluate with metrics in this category. The system automatically populates this field with the same table as the metric type selected. The table does not appear in the field until you save the form. This field is visible depending on whether a Type is selected.</td>
</tr>
<tr>
<td>Weight</td>
<td>[Required] Numerical value that represents the importance of this category relative to other categories. A greater value indicates greater importance. For more information, see weight categories and metrics. The default value is 10.</td>
</tr>
</tbody>
</table>
| Scoring type | Scoring method for an attestation category. This field appears only when the metric type is an attestation with a Scoring type of Percent. Use this field to configure different scoring types for specific attestation categories. Possible selections are:  
  • Percent: Attestation score as a weighted percentage of correct answers for scored questions.  
  • All or nothing: All answers for attestation type questions must be correct or the score is zero for the entire category. |
<p>| Total metrics| [Read-Only] Number of metrics associated to this category.                                                                                                                                               |
| Filter       | Filter conditions that assessable records must meet to be evaluated using metrics in this category. The filter operates on fields on the selected table. If you specify a filter condition, the system automatically associates matching assessable records to the category when you save the record. If you change the filter conditions, the system removes and creates assessable record associations as needed. The system also deletes stakeholders for assessable records it disassociates. The system does not remove assessable record associations created by users, even if the assessable records do not match the filter conditions. This field is visible only when a Type is selected. |
| Description  | Descriptive information about the category that appears on assessment questionnaires.                                                                                                                  |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roles</td>
<td>Only those users with the specified roles can perform the assessment for this category. If no role is specified, then users with any role can perform the assessment for this category.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the Roles property does not appear on the form, ask your admin to add the property.</td>
</tr>
<tr>
<td>Details</td>
<td>Text field containing an HTML editor. Use this field to present important details about this category to assessment recipients. Details can include formatted lists, images, videos, or links to external websites. You may need to configure the form to see this field.</td>
</tr>
<tr>
<td>Related Lists</td>
<td></td>
</tr>
<tr>
<td>Assessment</td>
<td>All metrics associated to this category. There must be at least one metric associated to the category to use any assessments with the category.</td>
</tr>
<tr>
<td>Metrics</td>
<td></td>
</tr>
<tr>
<td>Assessable</td>
<td>All assessable records associated to this category. There must be at least one assessable record associated to the category to use any assessments with the category. This related list is hidden if the Evaluation method is Attestation.</td>
</tr>
<tr>
<td>records</td>
<td><strong>Note:</strong> Category users are automatically generated based on the user field is specified in the Assessors tab of the assessment after publishing the assessment.</td>
</tr>
<tr>
<td>Users</td>
<td>All users associated to this category. There must be at least one category user to create scheduled assessments using metrics in this category.</td>
</tr>
<tr>
<td></td>
<td>If any user field is specified in the Assessors tab of the assessment, the corresponding users are automatically generated after publishing the assignment.</td>
</tr>
<tr>
<td></td>
<td>This related list is available only when the associated metric type has schedule type set to Scheduled. Category users are not a part of the on-demand assessment process.</td>
</tr>
</tbody>
</table>

**Related reference**

Assessable record associations
Related information

Assessment metrics
Assessment metric categories

Assessable record associations

Only the assessable records associated to a category can be evaluated using metrics in that category. Manage which assessable records you evaluate for each category by creating and removing the associations.

Only the assessable records associated to a category can be evaluated using metrics in that category. Manage which assessable records you evaluate for each category by creating and removing the associations.

Note: You can also manage which categories an assessable record is associated to using the Assessable Record form.

Related information

Assessment metrics
Create a category for assessable records

Manage an assessable record automatically

You must define at least one filter condition in the Metric Category form to automatically associate assessable records with the category.

Before you begin
Role required: assessment_admin or admin

Procedure

1. Navigate to Assessments > Metric Definition > Categories.
2. Open a category.
3. In the Filter field, create a condition statement that defines the records you want to associate to this category. The available fields are from the table defined for the metric type.

For example, for a category in the Vendor type, you might create the condition [Country] [is] [Germany]. Metrics in the category will be used only to evaluate vendors that meet this condition.

4. Save the record.
   The system associates this category to all assessable records that match the filter condition. As the system generates new assessable records that match the condition, it associates them to this category. If you change the filter
condition, the system removes and creates assessable record associations, as appropriate. Note the following:

- The system does not remove assessable record associations created manually, even if the assessable records do not match the filter conditions.
- The system deletes any related stakeholders, if applicable, when it disassociates assessable records from a category.
- The system does not create or remove assessable record associations if the related source records change. For example, consider the previous example in which all assessable records for vendors based in Germany were associated to a particular category. Assume that a user changes the Country of one of the vendor records from Germany to Canada. The system does not disassociate the related assessable record from the category, even though it no longer matches the filter condition.

Note: To configure the system to automatically associate all assessable records from a metric type to a category, use the same category condition as the metric type condition. For example, if the Vendor metric type has the condition [Vendor] [is] [true], create the same condition for the category. If the metric type does not have a condition specified, you can use the category condition [Sys ID] [is not empty], which includes all records from any table.

Related information

Assessment metrics
Create a category for assessable records

Manage an assessable record manually

You can manually create and remove assessable record associations for a category using a related list on the Metric Category form.

Before you begin
Role required: assessment_admin or admin

About this task
Keep in mind that when you disassociate an assessable record from a category, the system deletes any related stakeholders, if applicable, and you can no longer evaluate the assessable record using metrics in that category.
Procedure
1. Navigate to **Assessments > Metric Definition > Categories**.
2. Open a category.
3. In the **Assessable records** related list, click **Edit** and use the slushbucket to add or remove one or more assessable records.
   Only assessable records associated to this category's metric type are available for selection.

**Related information**
- Assessment metrics
- Create a category for assessable records

**Delete a category**
When you delete a category, the system also deletes the associated category users and stakeholders.

**Before you begin**
Role required: assessment_admin or admin

Procedure
1. Navigate to **Assessments > Metric Definition > Categories**.
   Alternatively, navigate to a record that contains a related list for categories.
2. Open a record from the list.
3. On the Metric Category form, click **Delete**.
4. Click **OK** when asked to confirm the action.
   The system displays messages at the top of the form describing the actions taken.

**Related information**
- Assessment metrics
- Create a category for assessable records

**Assessment metrics**
In the Assessments application, a metric is a trait or value used to evaluate assessable records.
Depending on the metric method, a metric can be used as either of the following:

- A question on assessment questionnaires, to obtain a subjective value such as how much people enjoy using each cell phone offered in the service catalog.
- A script that queries the database, to obtain an objective value such as the number of incidents related to each cell phone.

Each metric is associated to one metric category and can be used to evaluate assessable records for that category only. For example, the Support Rating category contains metrics that measure the quality of vendors' customer support services. One metric addresses the quality of product documentation. Others address the strength of the user community, self-service options, online training, and other support services. Each metric has a numeric weight value to indicate its importance relative to other metrics in the same category.

Assessment administrators can create and administer metrics and metric templates, which define reusable sets of answer options for metrics used as assessment questions. If you decide to use metric templates, you may want to create them before you create metrics.

**Note:** Changes to assessment metrics and metric templates are reflected in assessment questionnaires and results, even if users have saved responses already. If possible, avoid changing the original meaning of a metric question, the data type, or any metric templates in use by existing assessments.

**Related information**
- Create a metric template
- Update a metric minimum and maximum value to match a template

**Create an assessment metric for a category**

After you create a category, create metrics you can use to evaluate the assessable records for that category.

**Before you begin**
Role required: assessment_admin or admin

**About this task**
When you create metrics, consider the focus of the category and what characteristics you want to measure for the items you will assess.
Procedure

1. Navigate in one of the following ways:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessments &gt; Metric Definition &gt; Categories</td>
<td>Open a category, and locate the Assessment Metrics related list.</td>
</tr>
<tr>
<td>Assessments &gt; Metric Definition &gt; Metrics</td>
<td>This is the suggested navigation path, as the system links metrics to the category from which they are created.</td>
</tr>
</tbody>
</table>

2. Click New.

3. Fill in the fields, as appropriate.

Assessment Metric form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the metric.</td>
</tr>
<tr>
<td>Category</td>
<td>Metric category that the metric belongs to. The system automatically populates the category if you create a new metric from the Metric Category form.</td>
</tr>
</tbody>
</table>

**Note:** You cannot change the category if the Depends on field is set or if another metric depends on this metric

<table>
<thead>
<tr>
<th>Method</th>
<th>Determines how to use the metric.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Assessment</td>
<td>Non-scripted metric. Make the metric available as a question on an assessment questionnaire. The Assessment method is compatible with all data types except Duration.</td>
</tr>
<tr>
<td>• Script</td>
<td>Scripted metric. Obtain values by writing a custom script. The Script method is compatible with the Duration, Number, and Percentage data types.</td>
</tr>
</tbody>
</table>
| • Default answer from field | This option appears only if you have selected an Assessment Metric Type that contains a table. The General tab adds two fields:  
  ◦ Default answer: Select the default answer for the question. The list comes from the selected table.  
  ◦ Ask question: Specifies when to ask the question: always or only if the default answer is empty. |
### Field Description

**• Default answer from script:** The General tab adds a field:

- **Ask question:** Specifies when to ask the question: always or only if the script does not contain a default answer. The script is defined on the Field Type tab.

> **Note:** If you select a Data type that is incompatible with the selected Method, the system automatically changes the Method to the correct value.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>Numeric value that represents the importance of this metric relative to other metrics in the same category. By default, the weight is 10. For weighting suggestions, see Weight Metrics and Metric Categories. This field is visible and required unless the Data type is Date, Date/Time, or String. These data types are not included in results calculations.</td>
</tr>
<tr>
<td>Order</td>
<td>Numeric value that determines the order of the metric question on assessment questionnaires, relative to other metric questions in the same category. The metric with the smallest order value appears as the first question in the category section. By default, the order is 100. For more information about questionnaire layout, see Complete Assessment Questionnaires.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that determines whether this metric is used to gather assessment results. If a non-scripted metric (Assessment method) is inactive, the question does not appear on assessment questionnaires generated after the metric becomes inactive. If a scripted metric (Script method) is inactive, the script does not run.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Check box that makes the metric question mandatory (selected) or optional (cleared) on assessment questionnaires. Users cannot submit questionnaires unless they provide valid responses to all mandatory questions, which display a red field status indicator. This field is visible only if the Method is Assessment, the Depends on field is empty, and the data type is not Checkbox.</td>
</tr>
<tr>
<td>Allow not applicable</td>
<td>Check box that determines whether to include a Not Applicable answer option on this metric question on assessment questionnaires. Users can select Not Applicable if they do not have sufficient information to respond to a question or if a question does not apply to a particular assessable record. User responses of Not Applicable are excluded from results calculations. This field is visible only if the Method is Assessment and certain data types are selected.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details</strong></td>
<td>Text field containing an HTML editor. Use this field to present important details about this metric to assessment recipients. Details can include formatted lists, images, videos, or links to external websites.</td>
</tr>
</tbody>
</table>

*What type of men's trousers are expressly forbidden by company policy?*

**Female employees may mark this question "Not Applicable."**

<table>
<thead>
<tr>
<th>General Section</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Question</strong></td>
</tr>
</tbody>
</table>

| **Description** | Information about the metric and what it evaluates. If the **Method** is **Assessment**, include details that help users understand how to answer the question. This text appears as a hint when a user points to the question text on the questionnaire. |

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depends on</td>
<td>Setting used to make this metric a conditional question. Select an existing metric question from the list, which displays Checkbox, Choice, Likert Scale, Template, and Yes/No metrics of the same category as this metric. Then, use the Displayed when field to set the conditions that display this metric question on questionnaires. The system prevents the creation of recursive dependencies between metrics. For example, if Metric A depends on Metric B, Metric B cannot depend on Metric A. This field is visible only if the Method is Assessment.</td>
</tr>
<tr>
<td>Displayed when</td>
<td>Answer options for the selected Depends on metric question that, when chosen on questionnaires, display this metric question. This field is visible and required only if the Depends on field is set.</td>
</tr>
<tr>
<td>Field Type Section</td>
<td></td>
</tr>
</tbody>
</table>
| Data type        | [Required] Format of the expected response data. The function of the data type depends on the selected Method. If the method is Assessment, the data type determines how users answer the corresponding question on questionnaires. If the method is Script, the data type determines how the system calculates assessment results.  

**Note:** If another metric depends on this metric, you cannot change the data type. |
| Randomize answers | Check box that determines whether to present the answer options for this metric question in a random order. The order of answer options can influence users, which creates biased results. Randomizing answer options can help prevent this bias. This field is visible only if a data type that requires metric definitions is selected.  

**Note:** Randomizing answer options for certain questions can make those questions confusing for the person answering. In general, only randomize options that do not follow a logical order. For example, the following question is confusing when randomization is enabled: |
| Template         | Metric template to use for the metric question. A metric template is a set of predefined answer options. This field is visible and required only if the Data type is Template.  

**Note:** If another metric depends on this metric, you cannot change the template. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dependent plugin</td>
<td>Plugin that contains the tables queried in the script. The system executes the script only if the plugin is active. The default available values are Asset Management, CMDB, Core, Cost Management, Procurement, and Software Asset Management. If the Method is Script, select a plugin. This field is visible only if the Method is Script.</td>
</tr>
<tr>
<td>Note</td>
<td>An administrator may need to add more choices of plugins to the field.</td>
</tr>
<tr>
<td>Scale definition</td>
<td>Setting that determines whether lesser or greater numerical values equate to a good score in assessment result calculations. Select Low if lesser numerical values are better, such as for a metric that measures the number of incidents for a vendor. Select High if greater numerical values are better, such as for a metric that measures user satisfaction on a scale of one to five. The default value is High. This field is visible and required unless the Data type is Date, Date/Time, or String. Results for these data types are not included in results calculations.</td>
</tr>
<tr>
<td>Note</td>
<td>For information about how to set the scale definition for data types that do not require you to set a numerical value, see Data Types.</td>
</tr>
<tr>
<td>Min</td>
<td>Lowest numerical value to be used as an answer option on assessments or as a scaled value in a scripted metric. This field is visible and required only if certain data types are selected. If the data type is Choice or Likert Scale, this field is read-only and is set automatically based on the smallest metric definition Value.</td>
</tr>
<tr>
<td>Max</td>
<td>Highest numerical value to be used as an answer option or scaled value. This field is visible and required only if certain data types are selected. If the data type is Choice or Likert Scale, this field is read-only and is set automatically based on the largest metric definition Value.</td>
</tr>
<tr>
<td>Script</td>
<td>Script that obtains the desired system information. This field is visible and required only if the Method is Script. For more information about using this field, see Script methods.</td>
</tr>
<tr>
<td>Related List</td>
<td>Assessment Metric Definitions lists all metric definitions, which appear as answer options for questions on assessment questionnaires. Click New to create a new metric definition. This related list is available only if the Data type is Choice or Likert Scale.</td>
</tr>
</tbody>
</table>

4. Save the record.

When you create a Choice or Likert Scale question, reopen the Assessment Metric form after you submit it to create a metric definition. If you distribute
a questionnaire without creating the answers for questions with these data
types, recipients are unable to answer the questions. If the questions are
mandatory, the recipients are unable to submit their questionnaires.

Related information

Assessment metrics
Create an assessment metric definition
Create a metric template
Update a metric minimum and maximum value to match a template

Create an assessment metric definition

Metrics with Choice or Likert Scale data types must have metric definitions
defined to represent answer options on questionnaires.

Before you begin

Role required: assessment_admin or admin

About this task

Each metric definition appears as one answer option for a question on an
assessment questionnaire. For example, a metric for the question "How satisfied
are you with the quality of this vendor?" has three metric definitions to create
these answer options: **Very satisfied, Somewhat satisfied, and Not at all satisfied.**

Procedure

1. Open the metric record you want to edit.

2. In the **Assessment Metric Definitions** related list, click **New** to create a new
metric definition.

3. Fill in the fields:
   - **Display:** Enter the text you want to appear as the answer option.
   - **Value:** Enter the numeric value, greater than or equal to zero, to which the
     answer option equates. Values are used to calculate metric results. When
     you view assessment questions, metric definitions appear in order from least
to greatest value.
     - The system sets the minimum and maximum values according to the
       metric definition values.
     - To prevent reporting confusion, no two metric definitions for a given metric
       should have the same Value.

4. Click **Submit**.
Change the order of an answer

By default, the order of answer options is established when a question is created with a data type of Choice or Likert Scale.

Before you begin
Role required: assessment_admin or admin

About this task
The system creates an Order value for each choice based on where it appears in the original list when you submit it. This order corresponds to the Value setting you give the answer. The choice with the lowest order number appears first, and the choice with the highest order number appears last. If you want to reconfigure the order of the answer options, you must do so by editing the Order field and not the Value field.

The Order column is hidden in the base system.

Procedure
To edit these records, configure the Assessment Metric Definitions related list in the question record to show the Order column, and then edit the order number in the list. The Value setting remain the same for each answer option after reorganization.

Related information
Assessment metrics

Metric types and assessable records
In the Assessments application, assessment administrators create and administer metric types and assessable records.
A metric type defines a set of records an organization wants to evaluate, such as vendors, projects, or employees. For each type, the system generates unique assessable records that link the type to records that need to be evaluated, such as the individual records for the vendors Amazon and Intel. There may be multiple assessable records for the same source record if the source record meets the criteria for more than one type. For example, you might want to evaluate a record on the Company table, such as Intel, as a vendor and as a manufacturer, with different categories and metrics.

For configuration suggestions, see Assessment administrator tasks.

Assessable records

An assessable record links a source record you want to evaluate, such as the company record for Amazon or the user record for a sales representative, to a metric type, such as vendors or employees.

You use assessments to evaluate the assessable record. The system generates assessable records from the source records that match the table and conditions set on the Assessment Metric Type form. You evaluate the assessable records with metric categories and metrics, which define traits and values to assess. For metric types with the On demand schedule type, you can generate on-demand assessments from the Assessable Record form. This method of assessment generation makes it easy to create and preview short questionnaires or to quickly obtain assessment results for specific assessable records.

You can set up an assessment description that includes information from multiple fields on an assessable record and is displayed on multiple lines. This set up provides the user who is taking the assessment with a more detailed and understandable description of the information being requested on the assessment questionnaire. Create a multi-line description using table titles, which can be defined to use one or more fields from the selected table. See Customize the mobile list title for more information.

Related information

Use update sets for surveys and assessments
Metric types and assessable records
View an assessable record
Customize the mobile list title

Create metric types and generate assessable records

Each metric type sets a table and filter conditions that define a set of records to evaluate.
**Before you begin**
Role required: assessment_admin or admin

**About this task**
For example, the Vendor Performance application provides the Vendor metric type, which defines an assessable record for each source record in the Company [core_company] table that has the Vendor field selected. Create a metric type for each set of records you want to evaluate, such as vendors, users within an organization, or projects.

In addition to defining assessable records, metric types also determine how to filter decision matrix data and set the schedule type, which determines whether assessments are on-demand or scheduled.

**Procedure**
1. Navigate to Assessments > Metric Definition > Types.
2. Click New.
3. Fill in the fields, as appropriate (see table).
4. When you are satisfied with the type settings, click Generate Assessable Records to save the record and create assessable records. The page redirects to the list of assessable records created.

   You must click Generate Assessable Records to create the initial set of assessable records based on the table and conditions specified on the type record. After that, the system creates an assessable record each time a new matching record is created. Generate Assessable Records is located under Related Links.

   **Note:** Clicking Generate Assessable Records can trigger the deletion of existing assessable records under certain circumstances. For more information, see Enforce a condition to delete an assessable record.

**Metric types**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Live feed</td>
<td>Check box that determines whether to enable (selected) or disable (cleared) the Live Feed view in scorecards for all assessable records created from this type.</td>
</tr>
<tr>
<td>Notify manager if overdue</td>
<td>Check box that determines whether to send (selected) email notifications a user's manager when that user fails to submit an assigned questionnaire on time.</td>
</tr>
<tr>
<td>Assessment manager</td>
<td>Manager for this assessment metric type. These users are responsible only for managing the assessment process and not the results. The system notifies the assessment manager when an assessment for this metric type is past due.</td>
</tr>
<tr>
<td>Scoring type</td>
<td>Scoring method to use for questions with a data type of attestation. The possible selections are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Percent</strong>: Attestation score as a weighted percentage of correct answers for scored questions. When you select this scoring type, categories can be scored as <strong>Percent</strong> or <strong>All or nothing</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>All or nothing</strong>: Requires all answers for attestation type questions to be correct, or the score is zero for the entire attestation. When you select this scoring type, all categories are scored automatically as <strong>All or nothing</strong>.</td>
</tr>
<tr>
<td>Scale factor</td>
<td>[Required] Number to represent the best possible score for assessment results. All results for assessments of this type are scaled to this number. 10 is generally a good scale factor.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field becomes read-only when it contains a value and you save the metric type. Choose a scale factor you are satisfied with before you save the metric type.</td>
</tr>
<tr>
<td>Pagination setting for Service Portal view</td>
<td>Specify how the user will see pages on the desktop or tablet view in Service Portal.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Category</strong>: Display each category on a separate page. The categories appear in the following order:</td>
</tr>
<tr>
<td></td>
<td>◦ Each category appears in sequence on a separate page for the first assessable record</td>
</tr>
<tr>
<td></td>
<td>◦ Then each category appears in sequence on a separate page for the next assessable record</td>
</tr>
<tr>
<td></td>
<td>◦ and so on</td>
</tr>
<tr>
<td></td>
<td>• <strong>Question</strong>: Display each question on a separate page. Questions appear on separate pages for mobile devices regardless of this</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Setting. Each question appears for each category as described for the <strong>Category</strong> setting. <img src="https://example.com" alt="Note" /> <strong>Note:</strong> This field appears only when Service Portal is installed.</td>
<td><img src="https://example.com" alt="Note" /> <strong>Note:</strong> Users with these roles do not have access to Assessments modules unless they are also assessment administrators. Users with these roles can navigate to the records by other means, such as from reference fields on assessment instances. This field provides the option to easily grant certain users access to specific assessment data in special cases. For example, the <strong>Vendor</strong> metric type provides access to users with the vendor_manager role so they can view results and compare assessable records when they open scorecards or decision matrixes in the <strong>Vendor Performance</strong> application.</td>
</tr>
<tr>
<td>Roles</td>
<td>Additional user roles that can view the results and access records associated with this type. Users with the specified roles have read access to this type record as well as to associated categories, metrics, assessable records and scorecards, category users, stakeholders, and decision matrixes. <img src="https://example.com" alt="Note" /> <strong>Note:</strong> Users with these roles do not have access to Assessments modules unless they are also assessment administrators. Users with these roles can navigate to the records by other means, such as from reference fields on assessment instances. This field provides the option to easily grant certain users access to specific assessment data in special cases. For example, the <strong>Vendor</strong> metric type provides access to users with the vendor_manager role so they can view results and compare assessable records when they open scorecards or decision matrixes in the <strong>Vendor Performance</strong> application.</td>
</tr>
<tr>
<td>Signature</td>
<td>[Optional] Acknowledgement by a survey recipient of requirements, admonitions, or expectations related to an assessment. For more information, see <a href="#">Create an assessment signature</a>.</td>
</tr>
<tr>
<td>Return URL</td>
<td>Destination address of a web page that is presented to users after they submit an assessment for this metric type. When a return URL is configured, the end note content does not appear.</td>
</tr>
<tr>
<td>State</td>
<td>[Read-Only] Status of the assessment: <strong>Draft</strong> or <strong>Published</strong>.</td>
</tr>
<tr>
<td>Business rule</td>
<td>[Admin only] Business rule the system creates to monitor the specified table. When a new record is added to the table that meets the metric type conditions, the business rule generates a corresponding assessable record. If someone changes the table or conditions of the metric type, the system updates the business rule to reflect the changes. Existing assessable records associated with the metric type are not affected.</td>
</tr>
<tr>
<td>Schedule type</td>
<td>Setting that determines which assessment process to use. Select <strong>On demand</strong> or <strong>Scheduled</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Scheduled job | [Admin only] Scheduled job the system creates to generate assessments for this metric type. This field is populated the first time you save the record. The scheduled job name follows the format <type name> Assessment Creation. Administrators can configure a recurring assessment generation schedule for the metric type. This field is visible only when the schedule type is **Scheduled**.  

**Note**: If you change the schedule type from **Scheduled** to **On demand**, the system deletes the scheduled job. If you change the schedule type back to **Scheduled**, the system creates a new scheduled job. The previous assessment generation schedule is not saved, but can be reconfigured if desired. |
| Evaluation method | [Admin only] Indicates the evaluation method for this metric type. The system sets this field based on how the metric type is created. The possible evaluation methods are:  

- **Assessment**: Default filter value for metric types. Only this evaluation method uses assessable records, conditions, and stakeholders.  
- **Attestation**: For details, see Attestations - Legacy.  
- **Survey**: For details, see Survey definitions. |
| Scale factor | [Required] Number to represent the best possible score for assessment results. All results for assessments of this type are scaled to this number. **10** is generally a good scale factor.  

**Note**: This field becomes read-only when it contains a value and you save the metric type. Choose a scale factor that you are satisfied with before you save the metric type. |
<p>| Allow retake | Check box that allows users to modify their answers to a completed assessment, quiz, survey, or attestation. After the due date, the system removes the assessment from the user’s My Assessments and Surveys page. |
| Active | Check box that determines whether the metric type is active. When the metric type is inactive (cleared), assessment generation is disabled and users cannot take existing assessments. |
| Description | Helpful information about this type. Enter a clear description of the type and its purpose. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>Introductory content to display on assessment questionnaires. Consider adding a company logo, a welcome message, background information about the survey, or instructions. You may need to configure the form to see this field.</td>
</tr>
<tr>
<td>End note</td>
<td>Content to display on the screen that appears when someone submits an assessment questionnaire. Consider adding a thank you message, followup instructions, or other applicable information. You may need to configure the form to see this field. End notes are not displayed if a Return URL is specified.</td>
</tr>
<tr>
<td>Send notifications</td>
<td>Select the check box to send notifications for this assessment, survey, or attestation. You may need to configure the form to see this field.</td>
</tr>
</tbody>
</table>

**Condition section**

| Table                  | [Required] Table that contains the records you want to evaluate. The system creates assessable records for records on this table that meet the conditions you specify, if any. The number of matching records appears as a link by the **Condition** field. The link dynamically updates if you change the table selection. Click the link to open the list of matching records in a new tab or window. | **Note:** Additional roles are required to view the records on certain tables. If you select a table that you do not have access to, a warning message appears by the **Condition** field where the number of matching records would be. You cannot generate assessable records for tables you do not have sufficient roles for. |
| Enforce condition      | Check box that determines what happens to assessable records when you change the selected table or conditions.                                                                                                   |
| Condition              | Condition builder that defines specific records to assess from the selected table. If you do not specify any conditions, the system creates assessable records for all records on the selected table. Click the refresh icon to update the adjacent record count. | **Note:** If you change the table or conditions, you must click **Generate Assessable Records** to create new assessable records. |

**Decision Matrix section**

<p>| Filter field           | [Required] Field on the selected table that can be used to filter results on decision matrixes and scorecards. For example, if the selected |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The table is <code>Company[core_company]</code> and you choose <strong>Vendor type</strong> as the filter field:</td>
</tr>
<tr>
<td></td>
<td>• When you view decision matrixes for this type, the decision matrix menu to filter plotted items lists vendor types: <strong>Applications</strong>, <strong>Hardware</strong>, <strong>Services</strong>, and <strong>Software</strong>.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Filter example" /></td>
</tr>
<tr>
<td></td>
<td>• On scorecards for this type, the Averages view displays ratings by vendor type.</td>
</tr>
<tr>
<td>Filter condition</td>
<td>Condition builder that defines which records from the table are available as choices on the filter menu. For example, if the filter field is <strong>Vendor type</strong> and you create the filter condition <code>[Name] [does not contain] [Hardware]</code>, only records with vendor types of <strong>Applications</strong>, <strong>Services</strong>, and <strong>Software</strong> are possible choices as decision matrix filters.</td>
</tr>
<tr>
<td>Default matrix filter</td>
<td>Record to use as the default filter choice on decision matrixes and scorecards. The selected <strong>Filter field</strong> and <strong>Filter condition</strong> control the available record choices. To see the records, if any, click the refresh icon next to the field. Consider the case that the filter field is <strong>Vendor type</strong> and you select <strong>Applications</strong> as the default matrix filter. The filter choice on decision matrixes for this type is set to <strong>Applications</strong> by default. If you change the value of the <strong>Table</strong> or <strong>Filter condition</strong> field, you must click the refresh icon to view the updated <strong>Default matrix filter</strong> choices. If you do not, the system selects the first available choice from the updated field choices when you save the record.</td>
</tr>
<tr>
<td>Related Lists</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Metric Categories</td>
<td>All metric categories associated with the type.</td>
</tr>
<tr>
<td>Assessable Records</td>
<td>All assessable records associated with the type. This related list is hidden in the Attestation view of this form.</td>
</tr>
</tbody>
</table>

**Note:** The *Generate Assessments* button is visible to administrators in certain cases for scheduled assessments. Do not click the button until after completing the prerequisite tasks.

**Related reference**
- Assessment scorecard averages

**Related information**
- Schedule an assessment
- Schedule types
- Set an assessment generation schedule
- On-demand assessments
- Enforce a condition to delete an assessable record
- Metric types and assessable records

**Delete a metric type**
Deleting a metric type entails deleting many related records.

**Before you begin**
Role required: assessment_admin or admin

**About this task**
You must delete some of these records manually before deleting the type, while the system deletes others automatically with the type.

**Procedure**
1. Delete the records associated with the type to delete:
   - *Assessment results* (metric and category results)
   - *Assessment instance* (questions and assessment instances, in that order)
   - *Assessment groups*
2. Delete the type.
A confirmation dialog box appears and alerts you that certain records associated with the type will also be deleted.

3. **Click OK** to delete the type and these related records:
   - Scheduled job for assessment generation
   - Business rule for assessable record generation
   - Assessable records
   - Metric categories
   - Category users
   - Stakeholders
   - Metrics
   - Metric definitions
   - Decision matrixes

**Related information**

Metric types and assessable records

**Export an assessment**

You can share assessments between ServiceNow instances by exporting an assessment and then importing the assessment on another instance.

**Before you begin**

Role required: assessment_admin or admin

⚠️ **Note:** Update sets are available in the Helsinki release and should be used to move data from one instance to another. For information about update sets, see [System update sets](#).

**About this task**

⚠️ **Note:** The system exports a single XML file that does not contain result data.

The XML file contains a metric type `[asmt_metric_type]` and the following records that are associated with the type:

- Assessable records `[asmt_assessable_record]`
- Metric categories `[asmt_metric_category]`
- Metrics `[asmt_metric]`
- Metric definitions `[asmt_metric_definition]`
- Category users `[asmt_m2m_category_user]`
• Stakeholders [asmt_m2m_stakeholder]

• Decision matrixes [asmt_decision_matrix], [asmt_m2m_xcategory_matrix], and [asmt_m2m_ycategory_matrix]

Procedure
1. Navigate to Assessments > Metric Definition > Types.
2. Right-click the record and select Export Assessment.
3. Save the XML file.

Related information
Import an assessment
Metric types and assessable records

Import an assessment
Share assessments between ServiceNow instances by importing a previously exported assessment.

Before you begin
Role required: admin

⚠️ Note: Update sets are available in the Helsinki release and should be used to move data from one instance to another. For information about update sets, see System update sets.

Procedure
1. Ensure that the target instance has assessments enabled.
2. Follow the procedure detailed in Import a Record as XML Data.

Related information
Export an assessment

Use update sets for surveys and assessments
Use an update set to capture changes to surveys and assessments.

Before you begin
Role required: admin or survey_admin
When developing surveys and assessments, you can use an update set to capture the changes and move them from a development instance to a
production instance. Once an update set is created and marked current, all of the updates to the following tables are recorded in the update set.

The following tables are now update set enabled and also extend the application file:

- Assessment Metric Templates [asmt_template]
- Assessment Template Definitions [asmt_template_definition]
- Assessment Metric Definitions [asmt_metric_definition]: survey question answer options
- Schedule [sys_trigger]: scheduled jobs associated with the survey
- Assessment Metric Categories [asmt_metric_category]: survey categories
- Assessment Metrics [asmt_metric]: survey questions
- Assessment Category Users [asmt_m2m_category_user]: survey users
- Trigger Conditions [asmt_condition]

Create an assessment signature

A signature on an assessment questionnaire contains assertions that can communicate directions, a legal statement, or any text that you want the recipient to consider.

Before you begin
Role required: assessment_admin or admin

About this task
You can require the recipient to select a check box or provide a full signature to acknowledge acceptance of the assertion before submitting the form. You can display assertions without requiring a signature. An assessment property called Require authentication for user signature allows you to require users to provide their user name and password when an assessment asks for a full name signature.

Procedure

1. Navigate to Assessments > Metric Definition > Signatures.
   All signatures in the system appear in this list.
2. Click New.
3. Complete and submit the form using the fields in the table.
Assessment signature fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name for this signature</td>
</tr>
<tr>
<td>Signature type</td>
<td>Type of signature required. The selections are <strong>Checkbox</strong>, <strong>Full name</strong>, or <strong>Assertion only</strong>. If <strong>Assertion only</strong> is selected, no signature is required to submit the questionnaire. By default, the system requires user authentication for a full name entry.</td>
</tr>
<tr>
<td>Assertion</td>
<td>Text to present to recipients that requires acknowledgement.</td>
</tr>
</tbody>
</table>

Assessable records

An assessable record links a source record you want to evaluate, such as the company record for Amazon or the user record for a sales representative, to a metric type, such as vendors or employees.

You use assessments to evaluate the assessable record. The system generates assessable records from the source records that match the table and conditions set on the Assessment Metric Type form. You evaluate the assessable records with metric categories and metrics, which define traits and values to assess. For metric types with the **On demand** schedule type, you can generate on-demand assessments from the Assessable Record form. This method of assessment generation makes it easy to create and preview short questionnaires or to quickly obtain assessment results for specific assessable records.

You can set up an assessment description that includes information from multiple fields on an assessable record and is displayed on multiple lines. This provides the user who is taking the assessment with a more detailed and understandable description of the information being requested on the assessment questionnaire. Create a multi-line description using table titles, which can be defined to use one or more fields from the selected table. See [Customize the mobile list title](#) for more information.

Related information

- Metric types and assessable records
- View an assessable record
- Customize the mobile list title

View an assessable record

View the Assessable Record form to edit preferences and perform various actions.
Before you begin
Role required: assessment_admin or admin

Procedure

1. Navigate to Assessments > Assessable Records.
2. Open a record from the list.
   By default, the list displays only assessable records with Active metric types.
3. On the Assessable Record form, edit fields and perform other actions as necessary (see table).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>[Read-Only] Assessable record name based on the display value of the source record. The name appears on assessment questionnaires.</td>
</tr>
<tr>
<td>Source</td>
<td>[Read-Only] Source record the assessable record is linked to. The Source reflects the table name and source record display value. For example, if the Name field is the display value for the Company table, the assessable record for a company record named Amazon has the Source value Company: Amazon.</td>
</tr>
<tr>
<td>Live feed</td>
<td>Check box that, when selected, creates a live feed group for the assessable record, which appears on the scorecard. If you clear the check box after a live feed group has been created, the system deletes the live feed group and all its messages.</td>
</tr>
<tr>
<td>Type</td>
<td>[Read-Only] Metric type from which the assessable record was generated.</td>
</tr>
<tr>
<td>Decision matrix</td>
<td>Check box that, when selected, enables this assessable record's results data to appear on decision matrixes of the same metric type. Decision matrixes are graphs that plot the assessment results for multiple assessable records. If you clear the check box, the assessable record still appears on the default decision matrixes if you click the View Matrix related link on the assessable record's scorecard.</td>
</tr>
</tbody>
</table>
### Live feed group

[Read-Only] Live feed group for this assessable record. When you select the **Live feed** check box and save the record, the system populates this field.

### Related Links

<table>
<thead>
<tr>
<th>View Scorecard</th>
<th>Opens the scorecard for the assessable record.</th>
</tr>
</thead>
</table>

### Related Lists

<table>
<thead>
<tr>
<th>Category</th>
<th>All metric categories associated with the assessable record. An assessable record must be associated to a category to be evaluated. Click <strong>Edit</strong> to add or remove category associations. Note that it is often more efficient to associate assessable records to categories using the Metric Category form.</th>
</tr>
</thead>
</table>
| Category users | All stakeholders who can take assessment questionnaires about this assessable record. Click **Edit** to create and delete stakeholders. For more information about this and other methods of creating stakeholders, see **Stakeholders**.  
This related list is available only when the associated metric type has the **Scheduled** schedule type. |

### Related information

- Metric types and assessable records
- Assessable records

### Enforce a condition to delete an assessable record

By default, the system does not delete assessable records, even if you change the table or conditions for the type and the existing assessable records no longer match.

#### Before you begin

**Role required:** assessment_admin or admin

#### About this task

The system can be configured so you can trigger the deletion of assessable records that do not match the type table and conditions.
Procedure

1. On the Assessment Metric Type form, select the **Enforce condition** check box to enable deletion of existing assessable records of this type that do not match the table or conditions specified.

   When the check box is cleared, the system retains existing assessable records of this type, even if they do not match the table and conditions specified.

2. Click **Generate Assessable Records** to delete all assessable records associated with the type that do not match the current table and conditions.

   The system does not automatically delete assessable records, even if the **Enforce condition** check box is selected. You must click **Generate Assessable Records** with the check box selected every time you want the system to delete non-matching assessable records.

Related information

- Metric types and assessable records

Delete an assessable record

When you delete an assessable record, the system deletes any stakeholders for the record.

Before you begin

Role required: assessment_admin or admin

About this task

- **Note:** If a source record is deleted, the system deletes the associated assessable record. To delete the source record, you must first delete all associated metric results and category results.

Procedure

Delete the assessable record:

- To delete a single record, open the record and click **Delete**.
- To delete multiple records, use the Assessable Records list.

Related information

- Metric types and assessable records
- Assessable records
Add a metric category and metric in the question bank for assessments

Reuse the question categories (metric categories) and questions (metrics) added in the question bank for assessments. You can add metric categories or metrics from the question bank to an assessment, or from the assessment to a question bank.

Before you begin
Role required: admin or assessment_admin

Procedure
1. Navigate to Assessments > Question Bank.
2. Click New.
3. In the Metric Category form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the metric category.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the metric category.</td>
</tr>
<tr>
<td>Total metrics</td>
<td>Total number of metrics in the metric category. This number is automatically updated when you add or delete metrics from the category.</td>
</tr>
</tbody>
</table>

4. Right-click on the title bar and click Save.
5. In the Assessment Metrics related list, click New.
6. In the Assessment Metric form, fill the fields. For more information on assessment metric fields, refer to Create an assessment metric for a category.
7. Click Submit.

Configure metric categories or metrics for an assessment using the question bank

Reuse question categories (metric categories) and questions (metrics) from the Question Bank module while creating or updating an assessment.

Before you begin
Role required: admin or assessment_admin
Procedure

1. Navigate to **Assessments > Metric Definitions > Types**.

2. Open an assessment definition.

3. **Optional:** To add metric categories to an assessment from the question bank in Platform, perform the following steps.

   a. In the Metric Categories related list, click **New Category from Bank**.
      The New Category from Bank dialog box is displayed with a list of all metric categories added in the question bank.

   b. Select the required categories and click **Add Selected**.
      A copy of the metric category and the corresponding metrics is created in the Metric Categories related list.

4. **Optional:** To add metrics to an assessment from the question bank in Platform, perform the following steps.

   a. In the Metric Categories related list, open a metric category definition.

   b. In the Assessment Metrics related list, click **New Metric from Bank**.
      The New Metric from Bank dialog box is displayed with a list of questions available in the question bank.

   c. Select the required metrics and click **Add Selected**.
      A copy of the metric and the corresponding metric definitions is created in the Assessment Metrics related list of the category.

5. **Optional:** To add a metric category to the question bank from an assessment in Platform, perform the following steps.

   a. In the Metric Categories related list, open a metric category definition.

   b. Click **Add to Question Bank**.
      A copy of the category is created along with its metrics and metric definitions in the question bank.

6. **Optional:** To add a metric to the question bank from an assessment in Platform, perform the following steps.

   a. In the Metric Categories related list, open a metric category definition.

   b. In the Assessment Metrics related list, open the required metric definition.
c. Click **Add to Question Bank**.
   The Add to Question Bank dialog box is displayed.

d. In the **Choose a question bank to add this question/metric** field, select a metric category that you want to add this metric to, and click **OK**.
   A copy of the metric and the corresponding metric definitions is created for the selected category in the question bank.

**Copy an assessment**
Create a copy of an assessment with at least one category to reduce the effort of creating another assessment with similar data.

**Before you begin**
Role required: assessment_admin or admin

**About this task**
All associated questions (type), configurations, categories, metrics, domain separation rules, and role-based categories are copied. Assigned users, category users, instances, and trigger conditions are not copied.

**Procedure**
1. Navigate to **Assessments > Metric Definition > Types**.
2. Select an assessment metric type.
3. In the title bar, click **Copy**, or click the menu icon, and select **Copy**.

**Create a metric template**
Create a metric template to define reusable rating scales for evaluating non-scripted metrics.

**Before you begin**
Role required: assessment_admin or admin

**Procedure**
1. Navigate to **Assessments > Metric Definition > Templates**.
2. Click **New**.
3. Fill in the **Name** field on the Assessment Metric Template form.
4. To use images for template choices, such as for image scale questions, select **Allow Image**.
5. Click Submit.

6. Under the Assessment Template Definitions related list, click New. Create a template definition for each answer option you want to appear on an assessment question.

7. Fill in the following fields:

   - **Display:** Enter the text to appear as the answer option.
   - **Value:** Enter a numeric value, equal to or greater than zero, that you want the answer option to equate to. Values are used in results calculations.
   - **Selected Image:** Click to add the image to use for selected state.
   - **Unselected Image:** Click to add the image to use for unselected state.

When you view assessment questions that use templates, answer options appear in order from least to greatest Value.

♀ Tip: To prevent reporting confusion, no two template definitions for a given template should have the same Value.

8. Click Update.

Related information

- Assessment metrics
  - Create an assessment metric for a category
  - Create an assessment metric definition

Metric templates

Metric templates define reusable rating scales for evaluating non-scripted metrics.

Each answer option on the scale is defined as a template definition, much like a metric definition. For example, the metric template named Satisfaction contains the template definitions: **Very Satisfied**, **Satisfied**, **Neutral**, **Dissatisfied**, and **Very Dissatisfied**.

Metric templates are available for metrics that have **Template** as the Data type. The following metric templates are available by default.

### Default metric templates

<table>
<thead>
<tr>
<th>Name</th>
<th>Assessment template definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Likert 5</td>
<td>Strongly Disagree, Disagree, Neutral, Agree, Strongly Agree</td>
</tr>
</tbody>
</table>
Default metric templates (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Assessment template definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Satisfaction</td>
<td>Very Dissatisfied, Dissatisfied, Neutral, Satisfied, Very Satisfied</td>
</tr>
<tr>
<td>Frequency</td>
<td>Never, Seldom, Sometimes, Most of the time, All of the time</td>
</tr>
<tr>
<td>Amount</td>
<td>None, Few or little, Average amount, Many, Quite a lot</td>
</tr>
<tr>
<td>Size</td>
<td>Very Small, Small, Average, Large, Very Large</td>
</tr>
<tr>
<td>Quality</td>
<td>Very Poor, Poor, Average, Good, Very Good</td>
</tr>
<tr>
<td>Complexity</td>
<td>Very Complex, Complex, Moderate, Simple, Very Simple</td>
</tr>
</tbody>
</table>

Related information

Assessment metrics
Create an assessment metric definition

Update a metric minimum and maximum value to match a template

For assessment results to be properly calculated, the Min and Max values of a metric that uses a template must be equal to the smallest and largest template definition Value, respectively.

Before you begin
Role required: assessment_admin or admin

About this task
The system sets the Min and Max fields automatically when you create a metric of the Template data type, based on the template definition values. However, the system does not update these fields for existing metrics if you add a new template definition to a template or if you update the Value of an existing template definition. If the new Value is less than the minimum value of any metrics that use the template or greater than the maximum value, update the metrics accordingly.

To edit the minimum and maximum values for a question that has the Template data type:

Procedure
1. Navigate to Assessments > Metric Definition > Metrics.
2. Configure the list to show the Min and Max columns.
3. Run the following list filter condition: [Template] is [select the template you updated]

4. Ensure the Min and Max values match the smallest and largest template definition value for the selected template, respectively.

   If the values do not match, edit the Min and Max directly from the list.

   **Note:** When the data type is Template, a UI policy prevents the editing of Min and Max from the form.

**Related information**

- Assessment metrics
- Create an assessment metric for a category
- Create an assessment metric definition

**Category users and stakeholders**

Users who take assessments are individuals in your organization who have specific knowledge of the assessment categories and the records being assessed. A person who is qualified to answer assessment questions from metrics in a specific category becomes a category user when associated to that category. A category user then becomes a stakeholder when associated to a specific assessable record.

The system determines which assessable records and questions a user receives by looking at the metric categories and assessable records for which those users are stakeholders. Assessment administrators can create and manage category users and stakeholders.

   **Note:** Category users and stakeholders are used only for scheduled assessments.

**Category users**

Category users are users who can potentially answer assessment questions about a particular metric category for scheduled assessments. Category users should have special knowledge of the categories and the metrics those categories contain. A category user becomes a stakeholder when associated to an assessable record. Create at least one category user for each category you want to use for assessment questionnaires. There is no need for category users if the category contains only scripted metrics.
Stakeholders
A stakeholder is a category user with specific product or service knowledge, who is associated to an assessable record. A stakeholder is familiar with the assessable record and all the metrics within a specific category. The same category user can be associated to multiple assessable records, in which case the system creates a stakeholder record for each association. There are multiple ways to create stakeholders:

- Configure the system to create stakeholders automatically.
- Associate multiple category users to multiple assessable records.
- Associate multiple category users to one assessable record.
- Associate one category user to one assessable record.

⚠️  Note: Ensure you establish the desired user and assessable record associations to categories before attempting to creating stakeholders.

Related information
Create a category user
Create stakeholders automatically
Associate multiple category users to multiple assessable records
Associate multiple category users to one assessable record
Associate one category user to one assessable record
Delete a stakeholder for multiple assessable records
Delete a stakeholder for one assessable record

Create a category user
Create category users by associating users in the system to metric categories.

Before you begin
Role required: assessment_admin or admin

About this task
When you create category users, choose users who are knowledgeable and can answer questions from that category. For example, a purchasing agent is a good category user for metrics that evaluate a vendor's discount practices.

Procedure
1. Navigate to Assessments > Metric Definitions > Categories.
2. Open a category record.
Note: The category must be associated to a metric type that has the Schedule type set to Scheduled.

3. In the Users related list, click Edit.
4. Select the appropriate users for this category.

Related reference
- Category users and stakeholders

Related information
- Create stakeholders automatically
  - Associate multiple category users to multiple assessable records
  - Associate multiple category users to one assessable record
  - Associate one category user to one assessable record
  - Delete a stakeholder for multiple assessable records
  - Delete a stakeholder for one assessable record

Create stakeholders automatically
You can configure the system to create stakeholders automatically from all category users and assessable records associated with a category using the Create stakeholders check box on the Metric Category form.

Before you begin
Role required: assessment_admin or admin

About this task
If you associate a user to the category, the system makes the resulting category user a stakeholder for all the assessable records associated to the category. Similarly, if you associate a new assessable record to the category, the system makes all category users stakeholders for that record if they are not already stakeholders.

Note: Use the Create stakeholders check box with caution. You can end up with more stakeholders than you want and a large amount of unnecessary assessment data. Automatic stakeholder creation is best suited to assessment implementations in which category users are knowledgeable about all or most of the assessable records associated to each category.
**Procedure**

1. Navigate to **Assessments > Metric Definition > Categories**.
2. Select a category.
3. Associate category users and assessable records to the category.
4. Select the **Create stakeholders** check box.
5. Click **Update**.
   All the category users are associated to all the assessable records as stakeholders.
6. In the **Assessable Records** related list, click **Edit**.
7. Using the slushbucket, associate an assessable record to the category.

![](image)

8. Click **Save**.
   The system makes all category users stakeholders for the new assessable record.
9. Delete stakeholders as needed.

**Related reference**
- Category users and stakeholders

**Related information**
- Create a category user
- Associate multiple category users to multiple assessable records
- Associate multiple category users to one assessable record
- Associate one category user to one assessable record
- Delete a stakeholder for multiple assessable records
- Delete a stakeholder for one assessable record

**Associate multiple category users to multiple assessable records**
The stakeholder list helper in the create stakeholders module is the most efficient way to associate multiple category users to multiple assessable records in a single interface.

**Before you begin**
Role required: assessment_admin or admin
About this task
You can select category users from one category at a time.

小编一起Note:  You cannot edit or delete stakeholders using the list helper.

Procedure
1. Navigate to Assessments > Advanced > Create Stakeholders. The stakeholder list helper appears.

2. Select a metric type from the list of available types.

一起Note:  Only metric types for scheduled assessments are available. On-demand assessments do not use category users or stakeholders.

3. Select a category from the list of available categories.

一起Note:  Only categories within the selected metric type are available.

The system populates the Category User and Assessable Records lists with category users and assessable records associated to the selected category.

4. Select one or more category users from the Category Users list.

5. Select one or more assessable records from the Assessable Records list.

6. Click the Associate arrow between the lists to complete the association. A message above the list helper advises you that the selected category users are now stakeholders for the selected assessable records.

Related reference
Category users and stakeholders
Related information
Create a category user
Create stakeholders automatically
Delete a stakeholder for multiple assessable records

You can delete stakeholders for multiple assessable records.

**Before you begin**
Role required: assessment_admin or admin

**Procedure**

1. Navigate to **Assessments > Advanced > Assessment Stakeholders**.
2. Sort the list by **Assessable Record** or **Category User** depending on the perspective you want.
3. Select the check box for each stakeholder you want to delete.
4. Select **Delete** in the **Actions** choice list.
5. Click **OK** to confirm the action.
   The system deletes the stakeholders.

**Related reference**
- Category users and stakeholders

**Related information**
- Create a category user
- Create stakeholders automatically
- Associate multiple category users to multiple assessable records
- Associate multiple category users to one assessable record
- Associate one category user to one assessable record
- Delete a stakeholder for one assessable record

Associate one category user to one assessable record

You can create a single stakeholder using the list in the Assessment Stakeholders module.

**Before you begin**
Role required: assessment_admin or admin
Procedure

1. Navigate to **Assessments > Advanced > Assessment Stakeholders.**
2. Click **New.** On the Assessment Stakeholders form, fill in these fields:
   - **Category user:** Select a category user.
   - **Assessable record:** Select an assessable record.
3. Click **Submit.**

The selected category user becomes a stakeholder for the selected assessable record. To verify the association, navigate to the assessable record and note that the selected category user is on the Category users related list.

ℹ️ **Note:** Do not create stakeholders from category users and assessable records of different metric types.

Related reference

- Category users and stakeholders

Related information

- Create a category user
- Create stakeholders automatically
- Associate multiple category users to one assessable record
- Associate multiple category users to multiple assessable records
- Delete a stakeholder for multiple assessable records
- Delete a stakeholder for one assessable record

Associate multiple category users to one assessable record

You can create many stakeholders for a single assessable record from the Assessable Record form.

**Before you begin**

Role required: assessment_admin or admin
About this task
You can also edit or delete stakeholders from the form.

Procedure
1. Navigate to **Assessments > Assessable Records**.
2. Open a record from the list.
3. In the **Category users** related list, click **Edit**. These category users are the stakeholders for this assessable record.

![Category users related list](image)

4. Use the slushbucket to edit the category users associated to this assessable record. Add category users to create stakeholders. Remove category users to delete stakeholders.

   The system only shows category users for categories associated to the assessable record. For example, if an assessable record is only associated to the Compliance Score and Support Rating categories, you do not see User Satisfaction category users.

Related reference
- **Category users and stakeholders**

Related information
- Create a category user
- Create stakeholders automatically
- Associate multiple category users to one assessable record
Associate one category user to one assessable record
Delete a stakeholder for multiple assessable records
Delete a stakeholder for one assessable record

**Delete a stakeholder for one assessable record**
You can delete stakeholders for one assessable record.

**Before you begin**
Role required: assessment_admin or admin

**Procedure**
1. Navigate to Assessments > Assessable Records.
2. Open an assessable record.
3. In the Category Users related list, select the check box for each stakeholder you want to delete.
4. Select Delete in the Actions choice list.
5. Click OK to confirm the action.
   The system deletes the stakeholders.

**Related reference**
Category users and stakeholders

**Related information**
Create a category user
Create stakeholders automatically
Associate multiple category users to multiple assessable records
Associate multiple category users to one assessable record
Associate one category user to one assessable record
Delete a stakeholder for multiple assessable records

**Generate an on-demand assessment**
Use on-demand assessments to familiarize yourself with the basic assessment process and test your questionnaires using minimal configuration.

**Before you begin**
Role required: assessment_admin or admin
About this task
Select the assessable records to evaluate, create the categories and questions, and then assign an assessment to a user in the system. Pre-configured stakeholders are not used for on-demand assessments.

Procedure
1. Create a metric type and set the Schedule type to On demand to allow for testing of your assessment configuration.
2. Generate the assessable records for the metric type you created.
3. Create the metric categories required to evaluate the assessable records selected.
4. Create one or more assessment questions, or metrics, for each category.
5. Publish the assessment.
6. Perform an on-demand assessment to test your categories and metrics.
7. Analyze the assessment ratings in an assessment scorecard or decision matrix.

Related reference
Assessments

On-demand assessments
On-demand assessments can be generated for metric types with the Schedule type field set to On demand.

For the system to properly generate on-demand assessments, the metric type must be active and published. The metric type must also be associated to at least one metric category. That metric category must be associated to one or more of each of the following items:

- Assessable record
- Metric

By default, an assessment administrator can generate an on-demand assessment for one assessable record or multiple assessable records.

Related information
Assessment generation
Scheduled assessments
Generate an on-demand assessment for multiple assessable records
Generate an on-demand assessment for one assessable record

When you generate an on-demand assessment from the Assessable Record form, the resulting assessment contains questions from the categories associated to the assessable record.

Before you begin
Role required: assessment_admin or admin
Publish the assessment.

Procedure
1. Navigate to Assessments > Assessable Records.
2. Open an assessable record associated to a metric type that has the On demand schedule type.
3. To assign the assessment to users configured in the Assessors tab of the assessment, and other specified users, perform these steps.
   a. On the Assessment Metric Type form, click Assign Assessment.
   b. Select a user from the Recent Assessors list or select a different user.
   c. Click OK.
4. To assign the assessment to users configured in the Assessors tab of the assessment, click Assign to Assessors.

Results
The system generates an assessment instance assigned to the selected users.

Related information
   - Assessment generation
   - Scheduled assessments
   - Clean up assessment data

Generate an on-demand assessment for multiple assessable records

When you generate an on-demand assessment from the Assessment Metric Type form, the resulting assessment contains questions from all categories associated to any assessable records for the metric type.
Before you begin
Role required: assessment_admin or admin
Publish the assessment.

About this task
For example, if there are 15 assessable records associated to at least one category with assessment metrics, the assessment contains questions for all 15 assessable records.

Procedure
1. Navigate to **Assessments > Metric Definition > Types**.
2. Open a metric type that has the **On demand** schedule type.
3. To assign the assessment to users configured in the **Assessors** tab of the assessment, and other specified users, perform these steps.
   a. On the Assessment Metric Type form, click **Assign Assessment**.
   b. Select a user from the Recent Assessors list or select a different user.
   c. Click **OK**.
4. To assign the assessment to users configured in the **Assessors** tab of the assessment, click **Assign to Assessors**.

Results
The system generates an assessment instance assigned to the selected users.

Related information
- Assessment generation
- Generate a scheduled assessment manually
- Assessment groups
- Clean up assessment data

**Generate an assessment with the on-demand API**
The Assign Assessment buttons call an API to generate on-demand assessments.

Before you begin
Role required: assessment_admin or admin
About this task

Procedure

1. To generate an assessment, call the AssessmentCreation API from any script in the system, such as a business rule or client script.

2. Use the sys_ids of these items:
   - An assessable record to evaluate. The assessable record must be associated with an on-demand type and at least one category that contains non-scripted metrics.
   - One or more users who should perform the assessment. The API generates a questionnaire about the specified assessable record for each user.

Related information

- Assessment generation
- Scheduled assessments
- Generate a scheduled assessment manually
- Generate a vendor type assessment manually
- Set an assessment generation schedule
- Assessment instances
- View an assessment instance
- Clean up assessment data

Schedule an assessment

After you have evaluated your questionnaires using on-demand assessments, edit your categories and metrics as needed, reset your metric type record, and select the users who are qualified to evaluate the assessable records.

Before you begin
Role required: assessment_admin or admin

Procedure

1. Open the metric type you created for the on-demand assessment and set the Schedule type to Scheduled.

2. Make sure the categories and metrics you created for the on-demand assessment are correct.

3. Create category users who have special knowledge of your categories.
4. Create **stakeholders** by associating category users to specific assessable records.

5. **Set a schedule** for automatic assessment generation or **generate the assessment manually**. This procedure must be done by a system administrator.

6. **Configure email notifications** to remind users of their assigned assessments and to report to managers when an employee misses an assessment deadline.

7. Analyze the assessment ratings in an assessment scorecard or decision matrix.

**Related reference**

**Assessments**

**Schedule types**

You can schedule assessments for preconfigured users or send them to any user on demand.

On-demand assessments require less setup. Scheduled assessments define users, or **stakeholders**, who have specific knowledge of the records being evaluated, and automatically send out assessment questionnaires to those users at scheduled intervals. The best practice is to configure an on-demand assessment first to familiarize yourself with the process and test your questionnaires. When you are satisfied with your categories and questions, reconfigure for a scheduled assessment. These configuration paths are the easiest for both assessment types. Refer to **Key Terms** for definitions of the terms used in these procedures.

**Related reference**

**Assessments**

**Set an assessment generation schedule**

You can set assessment generation schedules. You must set a schedule for each metric type individually.

**Before you begin**

Role required: assessment_admin or admin

**Procedure**

1. Navigate to **Assessments > Metric Definition > Types**.
2. Open the appropriate metric type record.
3. Click the reference icon next to the **Scheduled job** field to open the Schedule Item record.
4. Locate the **Trigger type** field and set a recurring schedule for the scheduled job.

For example, if you want to generate assessment components each month, select the **Interval** or **Repeat** trigger type and specify a **Repeat** value of 30 days. Alternatively, select **Day in Month** and specify a Run time and Run day of month.

The optimal frequency of assessment generation is subjective. When you set the schedule, keep in mind the number of records to evaluate, how often your organization requires updated assessment results, the time and effort required of users to complete assessments, and other relevant factors.

**Publish a metric type**

Before it is possible to generate assessments, an assessment administrator must publish the associated metric type.

**Before you begin**

Role required: assessment_admin or admin

**About this task**

The **State** field on the Assessment Metric Type form indicates whether the type is published. The default state is **Draft**, which disables the system from generating assessments.

**Procedure**

1. Navigate to **Assessments > Metric Definition > Types**.
2. Open a metric type record, and click **Publish**.

   The **Publish** button is available only if the state is **Draft** and there is at least one metric associated with the type.

   **Note:** A metric type cannot be moved back to the **Draft** state after it has been published.

**Scheduled assessments**

The system generates a unique scheduled job for each metric type with the **Schedule type** field set to **Scheduled**.

The system generates a unique scheduled job for each metric type with the **Schedule type** field set to **Scheduled**. Each scheduled job generates assessment components for the related metric type. By default, the scheduled job runs
when an administrator executes it manually, but administrators can set a schedule to generate assessments automatically on a recurring basis.

For the system to properly generate scheduled assessments, the metric type must be active and published. The metric type must also be associated to at least one metric category. That metric category must be associated to one or more of each of the following items:

- Assessable record
- Stakeholder associated to one of the assessable records
- Metric

Related information

Assessment metrics

Generate a scheduled assessment manually

Administrators can generate scheduled assessments manually.

Before you begin
Role required: assessment_admin or admin

About this task
Use this option, for example, if you have set a schedule but want to generate assessments before the next scheduled run date.

Procedure
1. Navigate to Assessments > Metric Definition > Types.
2. Open the appropriate metric type record.
3. Click Generate Assessments to trigger the scheduled job immediately.

Note: Be careful to click Generate Assessments, not Generate Assessable Records.

Generate a vendor type assessment manually

The Vendor Performance feature provides a direct method of generating assessments for the Vendor metric type.

Before you begin
Role required: admin
Procedure

1. Navigate to Vendor Performance > Admin > Generate Assessments.

2. Click Generate Assessments to execute the scheduled job for the Vendor type.

Clean up assessment data

The assessment process generates a considerable amount of data, some of which is not useful after a short time.

Before you begin

Role required: assessment_admin or admin

About this task

The assessment process generates a considerable amount of data, some of which is not useful after a short time. Assessments include a scheduled job called Remove Old Assessment Data that is available to administrators only. The scheduled job removes these items if they are more than a year old:

• Assessment instance questions
• Assessment instances
• Metric results

By default, the scheduled job is executed manually. Administrators can configure the scheduled job to run automatically on a recurring schedule.

Procedure

1. Navigate to System Scheduler > Scheduled Jobs > Scheduled Jobs.

2. Open the Remove Old Assessment Data record.

3. On the Schedule Item form, set the Trigger type field to run the scheduled job on a recurring schedule.
   It is recommended to set the scheduled job to run on a weekly or monthly basis.

4. Optional: Click Execute Now to run the scheduled job.

Assessment instances

An assessment instance represents one occurrence of a questionnaire assigned to one user.
The system generates assessment instances only when the required conditions are met, as described in Scheduled assessments and On-demand assessments, and there are non-scripted metrics in at least one category.

When the system generates scheduled assessments for a metric type, each assessment instance contains questions about assessable records and categories related to the stakeholder to which it is assigned.

Example:

Recall that there can be multiple stakeholder records associated with one user record. Minh Leclare is a stakeholder for these items related to the Vendor metric type:

<table>
<thead>
<tr>
<th>Assessable record</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amazon</td>
<td>User Satisfaction</td>
</tr>
<tr>
<td>Acme</td>
<td>User Satisfaction</td>
</tr>
<tr>
<td>Acme</td>
<td>Reliability</td>
</tr>
<tr>
<td>Cisco</td>
<td>Reliability</td>
</tr>
</tbody>
</table>

When the system generates a scheduled assessment, Minh is assigned one assessment instance to evaluate Amazon, Acme, and Cisco by answering questions from the categories as a stakeholder. Assuming that there are three questions in the User Satisfaction category and six questions in Reliability, Minh's questionnaire contains three questions about Amazon, nine questions about Acme, and six questions about Cisco.

When the system generates an on-demand assessment for a specific assessable record, the assessment instance contains questions about that assessable record and all its associated categories. When the system generates an on-demand assessment for a metric type, the assessment instance contains questions about all that metric type's assessable records and their associated categories.

**View an assessment instance**

An assessment instance represents one occurrence of a questionnaire assigned to one user.

**Before you begin**

Role required: admin, survey_admin, or assessment_admin
Procedure

1. Navigate to **Assessments > Assessment Instances**. The following sub-modules are available based on the state of the instances:

- **Ready to take**: Displays assessment instances that are ready to be taken by the user. By default, these instances are sorted in ascending order by the **Number** field.

- **In progress**: Displays assessment instances that are in progress. By default, these instances are sorted in ascending order by the **Number** field.

- **Completed**: Displays assessment instances that are complete. By default, these instances are sorted in descending order by the **Taken on** field.

- **Cancelled**: Displays assessment instances that are cancelled. By default, these instances are sorted in ascending order by the **Number** field.

- **All**: Displays assessment instances in all states. By default, these instances are sorted in ascending order by the **Number** field.

2. Click an assessment instance number to open the record from the required sub-module. By default, the following fields are displayed in the Assessment Instance form for all sub-modules other than **Completed**.

   里程碑: When you open an instance in the **Completed** sub-module, you are redirected to the User’s Response page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Auto-generated record number.</td>
</tr>
<tr>
<td>Metric type</td>
<td>Metric type of this assessment.</td>
</tr>
<tr>
<td>Assessment group</td>
<td>Assessment group to which this assessment belongs.</td>
</tr>
<tr>
<td>Due date</td>
<td>Date by which the assessment instance must be completed. The system populates the due date from the value in the metric type <strong>Assessment duration</strong> field. The system generates email notifications related to the due date.</td>
</tr>
</tbody>
</table>

   里程碑: By default, the system runs the **Cancel Expired Assessments** script every 30 days to cancel expired survey, assessment, and quiz instances that are in the Work in progress or Ready to take states.

<p>| State | State of the assessment. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain</td>
<td>Domain associated with the instance.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User this assessment is assigned to. This field becomes read-only when the state is In progress, Complete, or Canceled.</td>
</tr>
<tr>
<td>Signature</td>
<td>Name of the signature record attached to this assessment. A signature requires that assessment recipients acknowledge that they have read any assertions attached to a questionnaire.</td>
</tr>
<tr>
<td>Signature result</td>
<td>Verification provided by the recipient when a signature is required. This value is either the recipient's full name from the User [sys_user] table or checked, indicating that the recipient acknowledged reading the assertion by selecting a check box.</td>
</tr>
</tbody>
</table>

3. **Click Take assessment** to open the questionnaire. This button is available if all the following conditions are true for the assessment instance:
   - It is **Assigned to** you.
   - The **State** is **Ready to take** or **In progress**.
   - The associated metric type is **Active**.

**Related information**

- **Assessment generation**
  - Generate a scheduled assessment manually

**Configure trigger conditions for an assessment**

Trigger conditions specify when to send a particular assessment and who to send the assessment to.

**Before you begin**

Role required: assessment_admin or admin

**Procedure**

1. Navigate to **Assessments > Admin > Trigger Conditions**.
2. Complete the fields as described in the table:
### Trigger Condition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment</td>
<td>[Required] Metric type to generate assessment instances for. Triggered assessments only work if the metric type is set to the <strong>On demand</strong> schedule type.</td>
</tr>
</tbody>
</table>
| Table       | [Required] Table to run the trigger condition on. You can select only tables in the current application scope.  

The table must have a connection to the assessable records for the selected **Assessment**. For example, you might want to send a vendor assessment when incidents close that are related to vendors you assess. In this case, select the Incident [incident] table. After you select a table, ensure there is at least one option for the **Assessable Record Field**. If there is not, select a different table. |
<p>| User field  | [Required] Field that stores the users you want to send the assessment. You can select any field, on the selected <strong>Table</strong> or on a related table, that references the User [sys_user] table. Use the tree picker to select a field. |
| Repeat Interval | Minimum period that must pass before the trigger condition can resend the assessment to the same user. For example, assume the repeat interval is set to 30 days. Even if the same user is eligible for multiple assessments from this trigger condition, the system can only send the user one assessment every 30 days. |
| Active      | Check box that determines whether this trigger condition is active (selected).                                                                 |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business rule</td>
<td>[Admin only] Business rule the system creates to monitor the selected table. When the condition is met, the business rule sends the assessment to the correct user. No configuration is necessary for this business rule.</td>
</tr>
<tr>
<td>Trigger randomly</td>
<td>Check box that determines whether to send the assessment to the appropriate user every time the condition is met (cleared) or only a percentage of the time (selected), as specified in the Probability (%) field.</td>
</tr>
<tr>
<td>Probability (%)</td>
<td>Probability out of 100 that the assessment will be sent each time the condition is met. For example, if the probability is set to 50, the system sends the assessment approximately 50% of the time the conditions are met, assuming there are no repeat interval restrictions. This field is visible and required only when the Trigger randomly check box is selected.</td>
</tr>
<tr>
<td>Assessable Record Field</td>
<td>[Required] Field on the selected Table that determines which assessable record will be the subject of the assessment. Only appropriate reference fields on the selected Table are available to select. If there are no Assessable Record Field options available, you must select a different Table. If the selected Assessment evaluates records on the Company [core_company] table and the selected Table is Incident, the only Assessable Record Field options are fields on the Incident table that reference the Company table. For example, Company or, if vendor ticketing is enabled, Vendor. If you select Vendor, the trigger condition sends an assessment about the Vendor for the incident, assuming there is an assessable record for the associated company. The assessment contains questions from all metric categories associated with the assessable record.</td>
</tr>
<tr>
<td>Related Field 1 – Related Field 4</td>
<td>Field that contains a value you want to store for reporting purposes. You can pick any reference field on the selected Table. When the trigger condition generates an assessment instance, the system stores the value from the triggering record. Select up to four fields. For example, if you select the Incident table, you might select Caller and Vendor as related fields. That stores the caller and vendor.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>Summary information to identify the trigger condition.</td>
</tr>
<tr>
<td>Condition</td>
<td>[Required] Condition builder that defines the criteria that must be true to send the assessment. For example, if you want to send an assessment whenever an incident closes, create the condition [State] [is] [Closed].</td>
</tr>
</tbody>
</table>

**Related reference**
- Assessment trigger conditions
- Survey trigger conditions
- Assessable records

**Assessment trigger conditions**
A trigger condition tells the system who to send a designated assessment to and when, based on specific conditions.

With trigger conditions, assessment administrators can configure the system to generate assessments each time a specific action occurs, such as when an incident or change request closes. The trigger condition sends the assessment to specified users who are related to the triggering record, such as incident callers or change request assignees. You can choose to send the assessment every time the condition is met, or set a probability for the system to send the assessment at random when the condition is met.

**Trigger condition configuration**

<table>
<thead>
<tr>
<th>Assessment</th>
<th>Vendor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Incident [incident]</td>
</tr>
<tr>
<td>User field</td>
<td>Assigned to</td>
</tr>
<tr>
<td>Repeat Interval</td>
<td>30 days</td>
</tr>
<tr>
<td>Active</td>
<td>true</td>
</tr>
<tr>
<td>Trigger randomly</td>
<td>false</td>
</tr>
</tbody>
</table>
Trigger condition configuration (continued)

<table>
<thead>
<tr>
<th>Assessable Record Field</th>
<th>Vendor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related Field 1</td>
<td>Caller</td>
</tr>
<tr>
<td>Related Field 2</td>
<td>Vendor</td>
</tr>
<tr>
<td>Condition</td>
<td>[State] [is] [Closed] and [Vendor] [is not empty]</td>
</tr>
</tbody>
</table>

**Trigger condition example**

Modesto Scroggie is the caller on an incident that is assigned to Boris Catino, a service desk technician. Boris contacts a vendor to resolve Modesto's issue and sets the Vendor field to Microsoft. When the incident closes, the system creates an assessment instance assigned to Boris so he can evaluate Microsoft as a vendor.

Because two related fields were selected as part of the trigger condition, the assessment instance stores the following information from the incident:

- **Related record 1**: User: Modesto Scroggie
- **Related record 2**: Company: Microsoft

**Note**: Even though the trigger condition is set to be triggered every time the conditions are met, the Repeat Interval setting ensures that Boris does not receive another assessment if another vendor incident assigned to him closes within 30 days of the first one.

**Related information**

- View an assessment metric category

**Enable manager notifications**

Users with the assessment_admin role can enable the Notify manager assessment is overdue email notification.

**Before you begin**

Role required: assessment_admin or admin

**About this task**

This notification sends emails to assessors' managers when assessors do not complete their assigned assessments on time. For more information, see the table of assessment notifications. You must enable or disable this email notification separately for each metric type.

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Procedure

1. Navigate to Assessments > Metric Definition > Types.
2. Open a metric type.
3. Select the Notify if overdue check box.

To disable manager notifications, clear the check box.
4. Save the record.

Note: The assessor’s user record must have a manager specified in the Manager field to use this notification. You might need to configure the form to use this field.

Assessment notifications

You can configure the system to send email notifications for assessments.

You can configure any of the following types of notification during the process of generating assessable records:

- Notify assessment user: This message notifies you of an assigned assessment and includes the type, the due date, and basic instructions. The message also contains a link to the record where you take the assessment.

Note: If a user has a pending assessment, then the system will not generate another instance of the same assessment.

- Remind assessment user: This message reminds you of the due date if half the time passes and you have not completed the assessment. The message content is the same as the first notification.

- Notify manager assessment is overdue: If you do not complete an assessment by the due date, the system may send a notification to your manager, depending on configuration.

Note: By default, the system runs a script every 30 days to cancel expired assessment and survey instances that are in the Work in progress or Ready to take states.
Related information
Create metric types and generate assessable records

Assessment notification workflow
The system sends assessment notifications according to the Notify assessment user workflow. Users with the workflow_admin, workflow_creator, or workflow_publisher roles can view workflows.

1. To open the graphical Workflow Editor, navigate to Workflow > Workflow Editor.
2. In the activity menu, click the link to choose an existing workflow.

![Workflow Window]

3. Select Notify assessment user from the Workflow Versions list. The workflow appears.

![Notify Assessment User Workflow]
Related information
Assessment notifications

View a metric result
Metric results contain values that represent an evaluated record’s performance for a specific metric, based on a single evaluation from one user or from the execution of a script. Metric results contain actual values as well as calculated values. The system uses values from metric results to calculate category results.

Before you begin
Role required: assessment_admin or admin

About this task
If there is an active scripted metric when the assessment is generated, the system automatically produces a metric result for each associated assessable record. The system produces an additional metric result for each question a user answers on a completed assessment questionnaire. If multiple users complete questionnaires with the same questions on the same assessable records, the system produces metric results for each user’s responses. For example, three users complete questionnaires that contain the same four questions about the Acme Corporation record. The system produces 12 metric results: one per user for each question.

Procedure
1. Navigate to Assessments > Results > Metric Results.
2. Open the metric result record you want to view.
   All fields on the form except Updated and String value are read-only.

Metric Result form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User who completed the assessment questionnaire. This field is blank when the method is Script.</td>
</tr>
<tr>
<td>Instance</td>
<td>Assessment instance completed by the Assigned to user. This field is blank when the method is Script.</td>
</tr>
<tr>
<td>Actual value</td>
<td>Unscaled value from a user response or script, depending on the method:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Assessment</strong>: Value obtained from the user response to the assessment instance question. The actual value is determined by the metric data type:</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>Checkbox</strong>: The actual value is 0 if the check box is cleared and 1 if it is selected.</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>Choice</strong> or <strong>Likert Scale</strong>: The actual value is equal to the Value of the metric definition associated with the chosen answer option.</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>Date, Date/Time, or String</strong>: The actual value is -1 to indicate that these data types do not contribute to category result calculations.</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>Template</strong>: The actual value is equal to the Value of the template definition associated with the chosen answer option.</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>Yes/No</strong>: The actual value is 0 if the response is <strong>No</strong> and 1 if it is <strong>Yes</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Script</strong>: Value the script placed in the actual_result variable. This field is hidden and left blank when the data type is Duration.</td>
</tr>
<tr>
<td>Duration value</td>
<td>Specific kind of actual value that is only applicable if the data type is Duration. The duration value is the value obtained by the script query from the actual_result parameter, such as the average duration of outages for a vendor.</td>
</tr>
<tr>
<td>Scaled value</td>
<td>Appropriate value from the scaled_result variable in the associated metric script. The code in a scripted metric defines a scaling scheme for the actual values it obtains. For example, a scripted metric queries the CMDB to return the number of configuration items (CIs) for a vendor. The code includes this scaling scheme, where actual_result is the number of CIs, and scaled_result is a representation of the quantity of CIs:</td>
</tr>
</tbody>
</table>
If the script detects 315 CIs for the vendor, the Actual value is 315 and the Scaled value is 1 for this metric result.

Note: Although this field is visible only when the method is Script, the system populates the field with the Actual value when the method is Assessment, as the scaled value is used in the Normalized value calculation.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normalized value</td>
<td>Adjusted value that accounts for weights, scale definition, minimum and maximum values, and other factors that impact the metric (like the survey responses or the input value—the actual value given by the user). See the example for Normalized value in View an assessment category result.</td>
</tr>
<tr>
<td>String value</td>
<td>Value that displays the response as it appears on a questionnaire. In some cases this is the same as the Actual value, such as when the metric data type is Percentage. The string value is N/A for unanswered questions of certain data types. For the Attachment data type, the names of the attached files are displayed as comma-separated values.</td>
</tr>
</tbody>
</table>

Assessment results

In the Assessments application, when the system processes completed questionnaires or gathers values returned from scripted metric queries, it generates assessment result records called metric and category results.

Assessment administrators can view assessment results.
The system calculates **metric results** first, normalizes the scores, and then calculates **category results**. Each metric and category result record stores data from one assessment group, for a particular category and source record evaluated. Specifically:

- Metric results: store data calculated from one evaluation of one metric.
- Category results: store data calculated from a weighted average of all metrics in the category.

⚠️ **Note:** Although results data is available to view in the form of metric and category result records, the most meaningful way to view results is in **scorecards** and decision matrixes. These tools display only the most pertinent data in graphical, comparative formats.

### Excluded Responses

The system creates metric results for responses but does not include them in category result calculations if any of the following are true:

- The user selects the **Not Applicable** answer option on a questionnaire.
- The user does not answer the question and the **data type** is not Checkbox.
- The question data type is one of the following: **Date**, **Date/Time**, or **String**.
- The metric result **Actual value**, **Scaled value**, and **Normalized value** fields are set to -1.

### Metric Attachments

After a survey or assessment is submitted, any attachments that have been added by a user are moved to the metric result record. The names of the attached files are added to the **String value** field on the Metric Result form.

⚠️ **Note:** You cannot add or remove attachments from a metric result.

### Assessments overview module

The assessment overview module is a type of homepage that displays various assessment reports, such as results by category and assessments by state.

### Prerequisites

You can view the overview page and refresh, add, delete, and rearrange report widgets.

Role required: assessment_admin
To use the Assessments Overview module, navigate to **Assessments > Overview** and click elements within the reports to obtain more information.

The available reports are:

**Assessments overview module reports descriptions**

<table>
<thead>
<tr>
<th>Report</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessable Records by Type</td>
<td>Assessable Record</td>
</tr>
<tr>
<td>Assessment Instances by Assessment Group</td>
<td>Assessment Instance</td>
</tr>
<tr>
<td>Assessments by State</td>
<td>Assessment Instance</td>
</tr>
<tr>
<td>Answered Questions by Assigned User</td>
<td>Assessment Instance Question</td>
</tr>
</tbody>
</table>
Assessments overview module reports descriptions (continued)

<table>
<thead>
<tr>
<th>Report</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Rating by Type</td>
<td>Assessment Category Result</td>
</tr>
<tr>
<td>Category Result Ratings by Category</td>
<td>Assessment Category Result</td>
</tr>
<tr>
<td>Metrics by Data Type</td>
<td>Assessment Metric</td>
</tr>
<tr>
<td>Stakeholders per Category</td>
<td>Assessment Stakeholders</td>
</tr>
<tr>
<td>Top Rated Items</td>
<td>Metric Result</td>
</tr>
<tr>
<td>Total Metrics by Metric Type</td>
<td>Assessment Metric</td>
</tr>
<tr>
<td>Unanswered Questions by Assigned User</td>
<td>Assessment Instance Question</td>
</tr>
</tbody>
</table>

Assessment results calculation

For every assessment group, there are assessment results.

Data calculated from an evaluation of one metric is classified as a metric result. Data calculated from the weighted average of all metric results in a category is classified as a category result. The system calculates some assessment results when the assessment is generated, and others when users complete questionnaires.

Related information

- Generate a scheduled assessment manually
- Generate a vendor type assessment manually
- Assessment groups

View a bubble chart for assessments

Assessment administrators can view bubble charts to compare the relative standing of assessable records in three metric categories.

Before you begin
Role required: assessment_admin or admin

Procedure

1. Navigate to **Assessments > Admin > Bubble Charts**.
2. Click a **Name** to open the bubble chart record.
3. Under **Related Links**, click **View Bubble Chart**.

![Image]

**Note:** Demand managers and vendor managers can view bubble charts through the Demand Management and Vendor Performance applications. See **Project Portfolio Suite** for more information.

### Bubble charts for assessments

A bubble chart is a dynamically updated graph that plots assessment results for multiple assessable records. Assessment administrators can create and use bubble charts to compare the relative standing of assessable records in three metric categories. The X- and Y-axes each represent a different category. Assessable records are plotted on the chart as circular markers, or bubbles, which vary in size according to scores for the third category.

### Create a bubble chart

Assessment administrators can create bubble charts to compare the relative standing of assessable records in three metric categories.

To create a bubble chart, navigate to **Assessments > Admin > Bubble Charts** and create a record (see table for field descriptions).

![Image]

**Note:** For color fields, either HTML color names or hexadecimal (hex) values are acceptable. For hex values, the # character is optional. Values are not case-sensitive. For example, all of the following values are valid: LightGray, lightgray, #D3D3D3, d3d3d3.
## Bubble Chart form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name for the bubble chart. Bubble Chart is appended to the name when you view the bubble chart.</td>
</tr>
<tr>
<td>Top left label</td>
<td>Label text for the top left, top right, bottom left, and bottom right quadrants, respectively. Choose labels that help interpret results.</td>
</tr>
<tr>
<td>Top right label</td>
<td>For example, a bubble chart that displays vendor assessment results might have the following quadrant labels, where vendors in the top right quadrant have the best scores:</td>
</tr>
<tr>
<td>Bottom left label</td>
<td>• Top left label: Resource</td>
</tr>
<tr>
<td>Bottom right label</td>
<td>• Top right label: Essential Partner</td>
</tr>
<tr>
<td></td>
<td>• Bottom left label: Poor Performer</td>
</tr>
<tr>
<td></td>
<td>• Bottom right label: Reevaluate</td>
</tr>
<tr>
<td>Top left color</td>
<td>Border colors for the top left, top right, bottom left, and bottom right quadrants, respectively. Bubbles are the color of the quadrant they are in.</td>
</tr>
<tr>
<td>Top right color</td>
<td></td>
</tr>
</tbody>
</table>
Bubble Chart form fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bottom left color</td>
<td>Metric type associated with this bubble chart. Only results for assessable</td>
</tr>
<tr>
<td>Bottom right color</td>
<td>records of the selected metric type are plotted on the bubble chart.</td>
</tr>
<tr>
<td>Type</td>
<td>Metric type associated with this bubble chart. Only results for assessable</td>
</tr>
<tr>
<td>X-Axis label</td>
<td>label text for the X-, Y-, and Z-axis categories of the bubble chart. Label</td>
</tr>
<tr>
<td>Y-Axis label</td>
<td>text for the X-, Y-, and Z-axis categories of the bubble chart. These labels</td>
</tr>
<tr>
<td>Z-Axis label</td>
<td>appear along the X- and Y-axes, if applicable, and in bubble score summary</td>
</tr>
<tr>
<td></td>
<td>windows. The metric category name is usually a good label. If these fields</td>
</tr>
<tr>
<td></td>
<td>are left empty, the bubble chart automatically displays the selected category</td>
</tr>
<tr>
<td></td>
<td>names as the labels.</td>
</tr>
<tr>
<td>Metric X category</td>
<td>Metric category each axis represents. Results for the Z-axis category</td>
</tr>
<tr>
<td>Metric Y category</td>
<td>determine the size of each bubble. The Z-axis should generally represent</td>
</tr>
<tr>
<td>Metric Z category</td>
<td>the most important category out of the three.</td>
</tr>
<tr>
<td>Quadrant label color</td>
<td>Color of the label text for the quadrant borders.</td>
</tr>
<tr>
<td>Default</td>
<td>Check box that enables (selected) or disables (cleared) the bubble chart</td>
</tr>
<tr>
<td></td>
<td>as the default. There can be only one default bubble chart per metric type.</td>
</tr>
</tbody>
</table>

**Bubble chart components**

The X- and Y-axes each represent a different metric category. Assessable records are plotted on the chart as circular markers, or bubbles, which vary in size according to scores for the third category.

The bubble chart page has these components:
• **Bubble Chart**
  ◦ **X- and Y-axes**: Each axis represents a metric category.
  ◦ **Bubbles**: Each labeled bubble represents an average of category result data for an assessable record. Point to a bubble to view an assessable record score summary. Click a bubble or bubble label to view the scorecard for the assessable record.

• **Source record list**: List of all records defined by the Table and Condition fields for the associated metric type. Note that the bubble chart only plots records for which there are assessment results. The assessment results are actually associated with the assessable records for each of the listed source records.

**Assessable record score summaries**

Point to a bubble to display a score summary for the assessable record the bubble represents.
The summary displays the assessable record's average score for each category in the following order: X-axis category, Y-axis category, Z-axis category. The scores are based on data from the last 12 months.

Bubble chart score summary

View an assessment scorecard

The Assessments application prepares printable scorecards. A scorecard displays easy-to-interpret assessment results, in which the current calculated ratings for an assessable record are compared to previous ratings or to the ratings of other records.

Before you begin
Role required: assessment_admin or admin

About this task
Users can examine ratings over time, compare ratings for one assessable record with all assessable records in a table, or compare the ratings of two assessable records. All ratings are averages for the time range selected. The system dynamically updates a scorecard each time you view it, so the ratings reflect recently completed assessments and scripted metrics.

Administrators can display a scorecard for any table by creating a Related Link on assessable records. The system provides this link on the Company form by default when Vendor Performance is active.

The Vendor Performance application provides an enhanced scorecard view for vendors.

See Vendor Performance in Project Portfolio Suite.
Procedure
1. Navigate to **Assessments** > **Assessable Records**.
2. Open a record.
3. Under **Related Links**, click **View Scorecard**.

Create a link to a scorecard
Users with the admin role can create UI actions that allow users to view scorecards from tables.

**Before you begin**
Role required: assessment_admin or admin

Procedure
1. Generate **assessable records** you want to evaluate.
   For example, you might create a metric type called **Project** to assess project management records.
2. Navigate to **System Definition** > **UI Actions**.
3. Open the View Scorecard record.
4. Right-click the header bar and select **Insert and Stay** from the context menu to create a duplicate record.
5. Change the **Table** name to the table on which you want the UI action to appear.
   For example, you might select Project [pm_project].

6. Do not edit the **Action name** field or the **Condition** script.
7. Save the record.

8. Navigate to the table on which you created the UI action and open an assessable record.
   a. In this example, navigate to **Project > Projects > All**.
   b. Open any record in the list.
   c. Click **View Scorecard** under **Related Links** to open the scorecard for that assessable record.

   The scorecard appears with the title in the form of `<table display name> Scorecard`. For example, a scorecard for an assessable record in the Project [pm_project] table is named **Project Scorecard**.

   - **Note**: Content does not appear in the scorecard unless the associated assessable record has assessment results or related live feed conversations.

9. Insert a new **View Scorecard** UI action record for each table where you want the related link to appear.

**Export a quiz scorecard as an image**

You can export scorecards as images.

**Before you begin**

Role required: assessment_admin or admin
**Procedure**

1. Click the menu icon and select **Save as PNG** or **Save as JPEG** as the download format.

2. When the export is complete, select **Download** to save the scorecard image to a storage location.

---

**Assessment scorecard averages**

The Averages view compares the current ratings for an assessable record in each metric category with the average, minimum, and maximum values from all assessable records in the filter. All ratings are from assessments generated over the trailing twelve months (TTM).

Select a filter option to compare the current record against all assessable records in that filter. An assessment administrator configures these options in the **Filter field** field in the Assessment Metric Type form.

Rating variances are highlighted as follows:
• **Red**: Ratings are below average in this category. The **Diff** value displays a negative number.

• **Green**: Ratings are above average in this category. The **Diff** value displays a positive number.

• **White**: Ratings are average in this category. The **Diff** value is 0.0.

In the following example, the ratings of the current group are compared against other groups for which Don Goodliffe is the manager.

**Group scorecard with ratings filter**

![Group scorecard with ratings filter](image)

**Assessment scorecard categories**

The Categories view displays a bar chart showing the average ratings for each category in the selected time interval.

Select from these reporting periods:

• All History

• Last 3 Months

• Last 12 Months
Scorecard categories

Assessment scorecard category metrics

The Category Metrics view displays the weighted average results for each metric within a category. Use this view to learn how individual metrics affect the overall rating for the category.

Select a metric category from the choice list to display the chart.
Assessment scorecard head-to-head compare view

The Head to Head Compare view allows you to compare the ratings of two assessable records of the same type. Select an assessable record from the choice list to compare against the current record's trailing twelve month (TTM) ratings.

**Head to head compare**

The Diff column displays the difference between each assessable record's most recent TTM ratings. By default, the system selects the first assessable record in the list when you open this view. The scorecard displays three years of ratings for the comparison record. All ratings are expressed as averages.

**Scorecard head to head compare**

![Scorecard head to head compare diagram]

**Overall Rating**

The Overall Rating is calculated as:

\[
\text{Overall Rating} = \frac{\text{sum of normalized values in category result}}{\text{number of assessment groups}}
\]

In the following example, the calculation is

\[
\frac{(2.13 + 2.86 + 3.79 + 1.43 + 2.39 + 3.7)}{2} = 8.15
\]
Normalized values

<table>
<thead>
<tr>
<th>Assessment group</th>
<th>Category</th>
<th>Weight</th>
<th>Source</th>
<th>Rating</th>
<th>Normalized value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG0010010</td>
<td>Politeness</td>
<td>5</td>
<td>Group: NY DB</td>
<td>9.37</td>
<td>2.13</td>
</tr>
<tr>
<td>ASG0010010</td>
<td>Recommendation</td>
<td>7</td>
<td>Group: NY DB</td>
<td>9</td>
<td>2.86</td>
</tr>
<tr>
<td>ASG0010010</td>
<td>Responsiveness</td>
<td>10</td>
<td>Group: NY DB</td>
<td>8.34</td>
<td>3.79</td>
</tr>
<tr>
<td>ASG00000804</td>
<td>Politeness</td>
<td>5</td>
<td>Group: NY DB</td>
<td>6.29</td>
<td>1.43</td>
</tr>
<tr>
<td>ASG00000804</td>
<td>Recommendation</td>
<td>7</td>
<td>Group: NY DB</td>
<td>7.5</td>
<td>2.39</td>
</tr>
<tr>
<td>ASG00000804</td>
<td>Responsiveness</td>
<td>10</td>
<td>Group: NY DB</td>
<td>8.14</td>
<td>3.7</td>
</tr>
</tbody>
</table>

Overall Rating on the group scorecard

<table>
<thead>
<tr>
<th>History</th>
<th>3 Years</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Current</td>
</tr>
<tr>
<td>Overall Rating</td>
<td>4.96</td>
</tr>
<tr>
<td>Importance Rating</td>
<td>3.30</td>
</tr>
<tr>
<td>Compliance Score</td>
<td>4.81</td>
</tr>
<tr>
<td>User Satisfaction</td>
<td>5.29</td>
</tr>
</tbody>
</table>

Assessment scorecard history

The History view compares the current ratings for each category with ratings from the previous three years or four quarters.

Ratings that have declined are highlighted in red and display negative numbers. Ratings that have improved are highlighted in green with positive numbers. Arrow icons beside the values in the Diff column indicate the trend of the current assessment against the previous assessment.
• **3 Years:** To calculate the current ratings, the system averages the ratings from the trailing twelve month (TTM) period. The **Diff** column shows the discrepancy between the current ratings and the previous calendar year's ratings.

![Scorecard history - 3 years](image)

• **4 Quarters:** Quarterly assessments compare the average rating for each category in the current quarter against the average ratings from the previous four quarters. The **Diff** column shows the discrepancy between the current ratings and the previous quarter's ratings. The column labels count backward, by quarter from the current quarter. For example, if the current quarter is the 3rd quarter of 2013, then the previous quarters appear as 2nd [2013], 1st [2013], 4th [2012], and 3rd [2012]. All four of the previous quarters appear, whether or not there was any data for those quarters.

![Scorecard history - 4 quarters](image)

**Live feed view of assessable records**

The live feed view displays live feed conversations that apply to the assessable record. Users can view the group feed, including tagged comments, and add comments of their own.

To configure a live feed view, an assessment administrator selects the **Live feed** check box on the **Assessable Record** form. Live feed is available on the scorecard even if there are no category results for the other views.

The live feed view provides these viewing options:
• **My Feed**: Displays the user's My Feed preferences.

• **Company**: Displays the user's company feed.

• **Groups**: Displays all available groups and gives the logged in user the option to leave or join a group. Select a group to display that group’s conversations.

• **Tags**: Displays all the tags found in live feed comments. Click a tag to display the conversations containing that tag.

---

**Live Feed group scorecard**

---

**Assessment scorecard ratings**

The scorecard ratings section displays various ratings for the assessable record.

Select one of several views that present different ratings:

- Averages
- Categories
- Category Metrics
- Head to Head Compare
- History
- Live Feed

Some views display an overall rating column, which lists categories used to evaluate the assessable record. Only categories in which the assessable record
has been evaluated appear on the scorecard. If the ratings section does not display any data, the assessable record or category results associated to the assessable record have been deleted.

Click a category to view the category record. Point to a category to display a line chart that shows the rating trend for that category.

Set up and administer quizzes
Set up and administer quizzes.

Before you begin
Role required: assessment_admin or admin
The differences between assessments, surveys, and quizzes, and when to use each; also provides a quick look at the three stages in the survey process: designing, sharing, and evaluating.

Procedure
1. **Optional:** Create reusable question templates for quizzes.
2. Create the quiz using the Quiz Designer or with forms accessed from the navigation menu.
   The quiz record includes specifics such as duration, notification preferences, a questionnaire introduction, and ending notes displayed to recipients.
3. Edit the default category or create additional categories as needed.
   The system creates a category with the same name as the quiz.
4. Define users for each category.
   These are the recipients who answer the questions in a category. You can define different users for each category.
5. Create the questions for each category.
6. Create the answers for each question and determine if the questions are scored.
   
   You can create unique answers or select preconfigured answers from a template.

What to do next
Publish and distribute the quiz. You can send the quiz to a single user or all users in each category.

Review the results from the submitted quizzes in reports and scorecards.

Related reference

Related information

Quizzes
Quizzes are questionnaires you can assign to one or more users to assess their knowledge of any subject. The quiz functionality is built on the assessment engine and provides many of the same features as assessments and surveys.

Each question is scored, and the overall score indicates the percentage of questions the user answered correctly. A quiz may have categories of questions that are assigned only to some users. You can assign weighting values to individual questions or categories of questions that make them more or less important when calculating the overall score. Quizzes require activation by a system administrator.

The differences between assessments, surveys, and quizzes, and when to use each; also provides a quick look at the three stages in the survey process: designing, sharing, and evaluating.

• An administrator can create a quiz for any purpose and assign it to a single user or multiple users.

• A quiz can contain one or more categories of questions. Each category can be assigned to users who answer only the questions in that category.

• The system can send email notifications to these users:
Recipients: The recipient can receive notification of an assigned quiz, a quiz whose allowed duration is at 50%, and a quiz that is overdue.

Recipient’s manager: The recipient's manager can receive notification when a quiz is overdue.

Quiz manager: The quiz manager can receive notification of an overdue quiz to which he or she is assigned.

Quizzes can contain questions that are scored or not scored. Unscored questions assess opinions or involve dates and are not counted in the final score. Scored questions specify correct answers and are scored either as 0% or 100%. You can apply a weighting scale to scored questions to establish their relative importance. You can designate questions with these data types as scored questions:

- Checkbox
- Choice
- Duration
- Likert Scale
- Numeric Scale
- Template
- Yes/No

A quiz question can be dependent on the response to any scored question. For example, you can create a dependent question requesting additional information that appears only if a recipient answers No to a specific question.

**Important terms**

The quiz application involves several terms.

**Terms used in quiz application**

<table>
<thead>
<tr>
<th>Quizzes</th>
<th>A quiz contains information such as duration, state, and notification controls and lists the existing categories. Text fields on the quiz form allow an administrator to create introductory content and end notes that are displayed to the recipient.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Categories</td>
<td>A quiz category represents a theme for quiz questions. Each category contains one or more questions and names the recipients for the questions in that category. By default, the system creates one category with the same name as the quiz. You can create additional categories as needed. Categories can be weighted higher or lower to determine the importance of that category in the overall score.</td>
</tr>
</tbody>
</table>
Terms used in quiz application (continued)

<table>
<thead>
<tr>
<th>Terms</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Questions</td>
<td>A quiz question is a question configured for a category and sent only to the users for that category. Questions have a wide variety of data types and can be individually weighted higher or lower. Questions may be scored or unscored.</td>
</tr>
<tr>
<td>Category user</td>
<td>A category user is the recipient of questions for a specific category. You can select different users to answer the questions for each category.</td>
</tr>
<tr>
<td>Templates</td>
<td>A template is a question data type that provides reusable rating scales for answers to questions. For example, the answer template named Satisfaction contains a satisfaction scale ranging from Very Satisfied to Very Dissatisfied.</td>
</tr>
</tbody>
</table>

Quiz roles

The Quizzes application uses these roles. No role is required to take quizzes that are assigned to you.

<table>
<thead>
<tr>
<th>Quiz roles</th>
<th>Role Title [Name]</th>
<th>Role Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>assessment administrator [assessment_admin]</td>
<td>Can administer the Assessments application and all quiz records. Can access all the modules of the Assessments application.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>✷ Note: The itil_admin role and the survey_admin role contain the assessment_admin role</td>
<td></td>
</tr>
<tr>
<td>Administrator [admin]</td>
<td>Can access all aspects of the assessment and survey processes. Only administrators can modify survey notifications, create survey modules, and import surveys.</td>
<td></td>
</tr>
</tbody>
</table>

Related information

Assessment metrics

Data types for quizzes

You need to choose a data type for each quiz question. Various data types helps you collect and analyze different kinds of data.
## Available data types

<table>
<thead>
<tr>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>Question with a Manage Attachments icon that allows users to attach one or more files.</td>
</tr>
<tr>
<td>Boolean</td>
<td>Question with a check box or a Yes/No list for user responses.</td>
</tr>
<tr>
<td>Choice</td>
<td>List of predefined options. For more information, see the definition for Choices in the Create quiz questions topic. Multiple correct answers are supported.</td>
</tr>
<tr>
<td>Date</td>
<td>Date field.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Time and date field.</td>
</tr>
<tr>
<td>Number</td>
<td>Number field with predefined minimum and maximum values. The default is 1-10.</td>
</tr>
<tr>
<td>Percentage</td>
<td>Percentage field with a prescribed range.</td>
</tr>
<tr>
<td>Scale</td>
<td>Predefined Likert scale. Answer options appear as radio buttons. Multiple correct answers are supported.</td>
</tr>
<tr>
<td>Image Scale</td>
<td>Predefined set of images. Five emojis similar to the Likert scale (very dissatisfied to very satisfied) are provided. However, you can upload additional images in JPG, PNG, or GIF format. Multiple correct answers are supported.</td>
</tr>
<tr>
<td>Numeric scale</td>
<td>Selectable number scale. The default is 1-5. Answer options appear as radio buttons. Multiple correct answers are supported.</td>
</tr>
<tr>
<td>String</td>
<td>Single or multi-line text field.</td>
</tr>
<tr>
<td>Template</td>
<td>Choice list of templates that provide a predefined scale of options. For details, see Configure a template question. Multiple correct answers are supported.</td>
</tr>
<tr>
<td>Reference</td>
<td>Choice list of fields from a specified reference table. This data type does not support reference qualifiers.</td>
</tr>
</tbody>
</table>

## Related information

- Create quizzes with forms
- Create a quiz
- Change the order of an answer
Activate the quiz designer

Administrators can activate the Quiz Designer plugin.

Before you begin
Role required: assessment_admin or admin

Procedure

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   *Note:* When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

Quiz Overview module

The Quiz Overview module is a homepage that displays various reports on data such as results for each category and quizzes that are complete, pending, or in progress.

Before you begin
Role required: assessment_admin or admin

About this task
Users with the **assessment_admin** role can view the overview page and refresh, add, delete, and rearrange widgets.

Procedure

1. Navigate to **Quizzes > Overview**.
2. Click elements within reports to obtain more information. The available reports are:

<table>
<thead>
<tr>
<th>Report</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quizzes by State</td>
<td>Assessment Instance [asmt_assessment_instance]</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc. in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Report</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Questions by Quiz</td>
<td>Assessment Metric [asmt_metric]</td>
</tr>
<tr>
<td>Questions by Data Type</td>
<td>Assessment Metric [asmt_metric]</td>
</tr>
<tr>
<td>Correct Answers by Assigned User</td>
<td>Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Number of Correct Answers</td>
<td>Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Incorrect Answers by Assigned User</td>
<td>Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Number of Incorrect Answers</td>
<td>Metric Results [asmt_metric_result]</td>
</tr>
</tbody>
</table>

**Quiz designer**

The quiz designer provides a single interface that users with the assessment_admin role can use to create, edit, and distribute quizzes. You can also use it to edit existing quizzes and change scoring parameters. Alternatively, you can use the modules of the assessment engine to create and edit the records that make up a quiz. All quiz records are stored in assessment tables and displayed in Quiz views of those tables. For details, see Create quizzes with forms.

**Tools on the Quiz Designer**

The quiz designer includes a design canvas, a header bar, and many controls that you can use to create quizzes.

To open the quiz designer, navigate to Quizzes > Quiz Designer.

The designer contains the following elements:

- Controls tab
- Questions tab
- Categories tab
- Header bar
- Design canvas

**Controls tab**

Controls for the supported question data types are available in the Controls palette. Drag and drop a control onto the designer canvas to create a question of that type.
<table>
<thead>
<tr>
<th>Data type</th>
<th>Description</th>
<th>Scored</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>Question with a Manage Attachments icon that allows users to attach one or more files.</td>
<td>Y</td>
</tr>
<tr>
<td>Boolean</td>
<td>Question with a check box or a Yes/No list for user responses.</td>
<td></td>
</tr>
<tr>
<td>Choice</td>
<td>List of predefined options. For more information, see the definition for Choices Create quiz questions. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>Date</td>
<td>Date field.</td>
<td>N</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date and time field.</td>
<td>N</td>
</tr>
</tbody>
</table>
### Questions tab

This tab displays all metrics added to the question bank for quizzes. Use the **Filter** field to search for questions. Each metric is displayed with its name and type.

### Categories tab

This tab displays all metric categories added to the question bank for quizzes. All metrics in the question bank are grouped under the corresponding metric category. Use the **Filter** field to search for categories or questions.

### Header Bar

The header bar contains tabs that display different views and a menu of various functions.

Click one of the following tabs to change the view in the canvas:

<table>
<thead>
<tr>
<th>Data type</th>
<th>Description</th>
<th>Scored</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Number field with predefined minimum and maximum values. The default is 1-10.</td>
<td>N</td>
</tr>
<tr>
<td>Percentage</td>
<td>Percentage field with a prescribed range.</td>
<td>N</td>
</tr>
<tr>
<td>Scale</td>
<td>Predefined Likert scale. Answer options appear as radio buttons. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>Numeric Scale</td>
<td>Selectable number scale. The default is 1-5. Answer options appear as radio buttons. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>Image Scale</td>
<td>Predefined set of images. Five emojis similar to the Likert scale (very dissatisfied to very satisfied) are provided. However, you can upload additional images in JPG, PNG, or GIF format. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>String</td>
<td>Single or multiline text field.</td>
<td>N</td>
</tr>
<tr>
<td>Template</td>
<td>Choice list of templates that provide a predefined scale of options. For details, see Configure a template question. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>Reference</td>
<td>Choice list of fields from a specified reference table. This data type does not support reference qualifiers.</td>
<td></td>
</tr>
</tbody>
</table>
• **Design**: Add categories and questions, and configure the properties of each. This is the default view of the canvas when you open the designer.

• **Configuration**: Create introductions and end notes for quizzes, and select a signature.

• **Availability**: Select the recipients for each category in the quiz.

Point to the menu icon (≡) in the in the upper right of the quiz designer to select the following options:

- **Save**: Saves the current quiz.
- **Preview**: Displays a preview of the quiz as it appears to the recipients.
- **Publish**: Distributes the quiz to the selected recipients.
- **Save and Publish**: Saves and distributes the quiz in one step.
- **New Quiz**: Opens a fresh canvas for a new quiz.
- **Load Quiz**: Opens a list of existing quizzes that you can select and edit.
- **Copy Quiz**: Creates a copy of the quiz.

The availability of each option depends on the status of the quiz that is opened in the quiz designer.

**Design Canvas**

New quizzes open in the **Design** view. The quiz **Name** field appears above first category in the canvas. A blank question field appears in the category container.

**Related information**

- View an assessment category result
- View a quiz scorecard
- Create a quiz
- Edit a quiz

**Create a quiz**

When you create a quiz, you can create one or more categories and then add questions to each category.

**Before you begin**

Role required: assessment_admin or admin
About this task
Each category can be assigned to a different user or the same users. You can also customize each question and make it dependent on the response to another question.

Create a quiz using these procedures:

Create quiz categories
A category represents a theme for evaluating a specific element of the quiz topic and contains questions pertaining to that theme.

Before you begin
Role required: assessment_admin or admin

About this task
When you create a quiz, the system creates a default category, using the name of the quiz. You can use this category, modify it, or create additional categories as needed. To have any results, a category must contain scored questions.

Procedure
1. Navigate either Quizzes > Quiz Designer or Quizzes > Quizzes and click Quiz Designer in the list header.

2. Enter the name of the quiz in the Name field. The system uses this name as the name of the quiz and the first category.

3. To configure the category, click the gear icon in its title bar.

   The Properties dialog box appears. You can change the name of the category, add a description for it, and enter text in the Details field that introduces or explains the category to the recipients. The system updates the category as you type.

4. Click the X icon to close the category properties dialog box and save your settings.
5. To add a new category, click the + icon in the title bar of an existing category.

Related information
- Quiz designer
- Create a quiz

Create quiz questions
You can create multiple questions for each category but each question can be associated with only one category.

Before you begin
Role required: assessment_admin or admin

About this task
The data type that you select for each question determines how it can be answered by quiz recipients.

You can designate questions to be scored. Only scored questions are shown in the quiz results and considered when calculating the category results. You must also specify a correct answer for scored questions.

Note:
To designate a question as scored, you must use Assessment forms. For instructions, see Configure a scored question.
Procedure

1. In the Design view, drag a data type icon from the Controls palette and drop it into a category container.

2. To configure the question, click in the gear icon in its title bar. The Properties dialog box appears for the question.

3. Fill in the fields on the form, as appropriate.
## Question property fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>[Required] Name of the question. Create a concise and easily recognizable name for your question. The system uses this value to identify the question in Assessment Metric lists and in scorecard charts.</td>
</tr>
<tr>
<td>Question</td>
<td>Text to display as the question on quizzes. Enter a clear, straightforward question that is easy to understand.</td>
</tr>
<tr>
<td>Type</td>
<td>[Read-only] Data type selected for this question. See the table in Controls for possible data types.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that determines whether this question is available on a quiz. If a question is marked inactive, it does not appear on quizzes generated after the question becomes inactive.</td>
</tr>
<tr>
<td>Boolean option</td>
<td>Whether a check box or a Yes/No list appears as the option for the Boolean question.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Check box for requiring users to answer the question. Users cannot submit quizzes until they answer all mandatory questions, which are denoted by a red Introduction_to_Fields#Field_Status_Indicator&quot; --&gt; field status indicator.</td>
</tr>
<tr>
<td></td>
<td>This field is available when the question does not have a dependency and the question Controls is not Boolean with a check box option.</td>
</tr>
<tr>
<td>String option</td>
<td>Setting for the appearance of a string field in a question. This field is available when the question type is String. The string options are:</td>
</tr>
<tr>
<td></td>
<td>• Single line: Single line text field 40 characters in length that allows strings of any length.</td>
</tr>
<tr>
<td></td>
<td>• String line wide: Full page width text field that allows a single line entry of any length.</td>
</tr>
<tr>
<td></td>
<td>• Multiline: Full page width multi-line text field that allows word wrap and returns.</td>
</tr>
<tr>
<td>Min</td>
<td>Lowest positive whole number that users can enter or select to answer the question. This field is available when the question type is Number, Percentage, or Numeric Scale.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Max</td>
<td>Highest positive whole number that users can enter or select to answer the question. This field is available when the question type is <strong>Number</strong>, <strong>Percentage</strong>, or <strong>Numeric Scale</strong>.</td>
</tr>
<tr>
<td>Allow not applicable</td>
<td>Check box for including <strong>Not Applicable</strong> as an option for this question. Users can select <strong>Not Applicable</strong> if they do not have sufficient information to respond to a question. User responses of <strong>Not Applicable</strong> are excluded from results calculations. This field is available when the question does not have a dependency and the question <strong>data type</strong> is not <strong>Boolean</strong> with a check box option.</td>
</tr>
<tr>
<td>Randomize answers</td>
<td>Check box for displaying answer options in a random order whenever the question appears in a quiz. Answer preference is sometimes influenced by the order in which options appear, which can result in biased results. Randomizing options can help prevent this bias. <strong>Note:</strong> Randomizing options for certain questions may make those questions confusing for users. In general, only randomize options that do not follow a logical order.</td>
</tr>
<tr>
<td>Details</td>
<td>Information about the question that is displayed on the quiz. Include details that help users understand how to answer the question. You can also enter HTML text in this field with the WYSIWYG editor. For example, include HTML to embed links and images.</td>
</tr>
<tr>
<td>Correct answer</td>
<td>Answer option that you want to be selected by users. When you specify a correct answer for a question, the system scores the question. This field is available for all data types except <strong>Date</strong>, <strong>Date/Time</strong>, and <strong>String</strong>. Multiple correct answers are supported for a few data types. See <strong>data types</strong>.</td>
</tr>
<tr>
<td>Choices</td>
<td>Options for a question with a data type of <strong>Choice</strong> or <strong>Scale</strong>. The system automatically adds text and values that you can edit for each option. Click the + icon to add an option, or click the X icon to delete an option. By default, the system arranges options in the order established by their values. To change the order, drag and drop the options.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Dependency</td>
<td>Condition builder that hides or displays the question depending on the answer to another question in the same category. Select an existing question from the list with a data type of <strong>Boolean</strong>, <strong>Choice</strong>, <strong>Scale</strong>, or <strong>Template</strong>. Create the condition that must exist for recipients to see the dependent question, using the <strong>is</strong> or <strong>is one of</strong> operator. The system prevents recursive dependencies between questions. For example, if Question A depends on Question B, Question B cannot depend on Question A.</td>
</tr>
</tbody>
</table>

4. To create any special conditions that must be met for a question to appear on the quiz, click the **Dependency** tab. Fill in the fields, as appropriate.

Dependent questions appear on the quiz when a recipient selects a specific answer or combination of answers to another question in the same category.

5. Select a question in the **Displayed when** field. The system selects the appropriate operator and displays the possible answers for the selected question.

6. Select the answers that satisfy the condition. Selected answers are indicated by a check mark.
7. Click X to close the question properties dialog box and save your settings.

8. To add a question with the same data type as an existing question in the category, click the + in the title bar of the existing question.

9. Drag questions to change their order within a category or move them between categories.

10. To delete a question, click the X in its title bar.

**Configure a quiz**
You can configure an entire quiz.

**Before you begin**
Role required: assessment_admin, survey_creator, or admin

**About this task**
The values you enter and select on this page are applied to the entire quiz.

**Procedure**
In the quiz designer, click **Configuration** and then fill in the fields as described in the table.
## Quiz designer configuration

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check box for enabling the distribution of this quiz to recipients.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of this configuration or the quiz to which it is attached.</td>
</tr>
<tr>
<td>Introduction</td>
<td>Introductory content to display on quizzes. You can add a welcome message or background information about the quiz.</td>
</tr>
<tr>
<td>Owners</td>
<td>Owners of the quiz. You can add a user with the survey_creator, survey_admin, or assessment_admin role.</td>
</tr>
<tr>
<td>Signature</td>
<td>[Optional] Acknowledgement by a quiz recipient of requirements, admonitions, or expectations related to a quiz.</td>
</tr>
<tr>
<td>Return URL</td>
<td>Destination address of a web page that is presented to users after they submit a completed quiz. When a return URL is configured, the <strong>End note</strong> content does not appear.</td>
</tr>
<tr>
<td>End note</td>
<td>Content that is displayed to recipients after they submit a completed quiz. You can add a thank you message, follow-up instructions, or other applicable information. End notes are not displayed if a <strong>Return URL</strong> is specified.</td>
</tr>
<tr>
<td>Duration</td>
<td>Amount of time that recipients are given to complete this quiz, starting from the time that the quiz is generated. The default duration is 14 days.</td>
</tr>
<tr>
<td>Manager</td>
<td>Assessment manager for this quiz. These users are only responsible for managing the quiz process and not the results. The system notifies the manager when submissions for this quiz are past due.</td>
</tr>
<tr>
<td>Notify manager if overdue</td>
<td>Check box for sending email notifications to a recipient’s manager when that user fails to submit an assigned quiz before the due date.</td>
</tr>
</tbody>
</table>

## Related Links

- Show Benchmarks: Opens the Benchmarks Dashboard that provides visibility into your key performance indicators (KPIs) and trends.
Select a quiz recipient

When the system distributes a quiz, it sends email notifications to the category users and their managers.

Before you begin
Role required: assessment_admin or admin

About this task
A category can have one or more assigned users, and the same user can be assigned to more than one category.

The system also creates a link to the quiz in the recipients' My Assessments & Surveys portal. Users can only answer questions in the categories that they are assigned to.

Procedure
To select the recipients for each quiz category, click Availability and then fill in the fields as described in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select category</td>
<td>Category for which the selected users are recipients.</td>
</tr>
<tr>
<td>Add users</td>
<td>Users selected as recipients for this category. The choice list shows all users in the system.</td>
</tr>
</tbody>
</table>

Related information
Quiz designer
Publish a quiz

When you publish a quiz, the system sends email notifications to the recipients and to their managers. A card in each recipient’s My Assessments & Surveys portal displays a link to the quiz.

Before you begin
Role required: assessment_admin or admin

Procedure
1. If you want to see the quiz as the recipients will see it, point to the menu icon in the upper right of the quiz designer and click Preview.
2. When you are satisfied with the quiz, click Save and Publish or Publish to distribute it.

Related information
Quiz designer

Create quizzes with forms

As an alternative to the Quiz Designer, you can create a complete quiz using records in the Assessment application.

All the elements of a quiz, the categories, questions, and answers, are stored in tables used by the assessment engine and are displayed in quiz views of these tables. Users creating quizzes in the Assessment application must have the assessment_admin role.

Create a quiz using assessment forms by following the procedures in the order shown here:

• Create the quiz.
• Set up the categories.
• Create the questions for the quiz.
• Create the answers for the questions.
• Distribute the quizzes to recipients.

Note: The recommended method of creating and editing quizzes is to use the quiz designer, which provides a single, intuitive interface for creating and editing quizzes quickly. If you determine that you need to add specific features to your quiz not offered through the quiz designer, you can do so by using some of the specific procedures described here.
Related information
Create a quiz
Create a category for assessable records

Set up a category
A category represents a theme for evaluating a specific element of the quiz topic and contains questions pertaining to that theme.

About this task
When you create a quiz, the system creates a default category with the name of the quiz. You can use this category, modify it, or create additional categories as needed. Categories are records in the Quiz view of the Metric Category table.

Categories have weighting values that contribute to the overall score for the quiz. By default, all categories are given a weighting value of 10. You can assign any weight to your categories. To have any results, a category must contain scored questions.

Procedure
You can create a new category or edit an existing one from the Metric Categories related list of a quiz record.

Related reference
Data types for quizzes
Related information
Create quizzes with forms
Create a quiz
Select a user for a category
Create questions
Create answers for questions
Change the order of an answer
Distribute a quiz
Modify a published quiz

Select a user for a category
Category users are the recipients of the questions for each category.

About this task
A category can have one or more assigned users, and the same user can be assigned to more than one category. When the system distributes a quiz, it sends an email notification, if configured, to the category users and creates a link to the appropriate questionnaire in their assessments and surveys portal. Users can only answer questions attached to their assigned categories.

Procedure
To select users for a category, select the Users related list in a category record, and click Edit.

Related reference
Data types for quizzes
Related information
Create quizzes with forms
Create a quiz
Set up a category
Create questions
Create answers for questions
Change the order of an answer
Distribute a quiz
Modify a published quiz

Create questions
A category can have multiple questions associated with it.

About this task
Each question can only be associated with one category. Each question has an answer data type that determines how recipients answer the question. Questions are records in the Quiz view of the Assessment Metric table.

Procedure
To create questions, open a category record and create a question record from the Assessment Metrics related list. Alternatively, you can navigate to Quiz Management > Questions and create a new record (see table).

⚠️ Warning: When you create a Choice or Likert Scale question, you must reopen the Assessment Metric form after you submit it to create answers. If you distribute a questionnaire without creating the answers for questions with these data types, recipients are unable to answer the questions. If the questions are mandatory, the recipients are unable to submit their questionnaires.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td><strong>[Required]</strong> Name of the question.</td>
</tr>
<tr>
<td>Category</td>
<td><strong>[Required]</strong> Category the question belongs to. The system populates this category if you create a new question from the Metric Category form.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot change the category if the <strong>Depends on</strong> field is set or if another metric depends on this metric.</td>
</tr>
<tr>
<td>Method</td>
<td>Setting that determines how to use the question.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Assessment:</strong> Makes the question available on a quiz distributed to users. The <strong>Assessment</strong> method is compatible with all data types except <strong>Duration</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Script:</strong> Queries the database without user participation. Scripted questions are of limited value for quizzes, because they do not assess a user's knowledge of a topic.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you select a <strong>Data type</strong> that is incompatible with the selected <strong>Method</strong>, the system automatically changes the <strong>Method</strong> to the correct value.</td>
</tr>
<tr>
<td>Weight</td>
<td>Numeric value that represents the importance of this question relative to other questions in the same category. By default, the weight is 10. For weighting suggestions, see <strong>weight categories and</strong></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>metrics</td>
<td>This field is available and required unless the <strong>Data type</strong> is <strong>Date</strong>, <strong>Date/Time</strong>, or <strong>String</strong>. These data types are not included in results calculations.</td>
</tr>
<tr>
<td>Order</td>
<td>[Required] Numeric value that determines the order of the question in the category. The question with the smallest order value appears as the first question in the category's section. By default, the order is 100.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>It does not matter which order value you use for metrics with the <strong>Script</strong> method, because they do not appear on questionnaires.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that determines whether this question appears on quizzes. If a question is inactive, it does not appear on quizzes generated after the question becomes inactive.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Check box for requiring users to answer the question. Users cannot submit questionnaires until they provide valid responses to all mandatory questions, which are denoted by a red field status indicator.</td>
</tr>
<tr>
<td></td>
<td>This field is available only if the <strong>Method</strong> is <strong>Assessment</strong>, the <strong>Depends on</strong> field is empty, and the <strong>Data type</strong> is not <strong>Checkbox</strong>.</td>
</tr>
<tr>
<td>Allow not applicable</td>
<td>Check box for including <strong>Not Applicable</strong> as a possible answer for this question. Users can select <strong>Not Applicable</strong> if they do not have sufficient information to respond to a question. User responses of <strong>Not Applicable</strong> are excluded from results.</td>
</tr>
<tr>
<td>Question</td>
<td>The question that is displayed in quizzes. Enter a clear, straightforward question that is easy to understand.</td>
</tr>
<tr>
<td>Details</td>
<td>Information about the question and what it evaluates. Include details that help users understand how to answer the question or when you need HTML enhanced details for your question. You can create HTML text in this field with the WYSIWYG editor, such as embedding links and images.</td>
</tr>
<tr>
<td>Depends on</td>
<td>An existing question that this question is dependent on. You can select <strong>Checkbox</strong>, <strong>Choice</strong>, <strong>Likert Scale</strong>, <strong>Template</strong>, and <strong>Yes/No</strong> questions from the same category as this question. Then use the Displayed when field to set the conditions for displaying this question. The system prevents the creation of recursive dependencies between questions. For example, if Question A</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>depends on Question B, Question B cannot depend on Question A.</td>
<td></td>
</tr>
</tbody>
</table>

### Question Type

<table>
<thead>
<tr>
<th>Data type</th>
<th>[Required] Format of the expected response data. See the table of data types for details.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Note: You cannot change the data type if another question depends on this question</td>
</tr>
</tbody>
</table>

| Randomize answers | Check box for displaying the possible answers for this question in a random order whenever the question appears. Answer preference is sometimes influenced by the order in which answer options appear, which can result in biased results. Randomizing answer options can help prevent this bias. This check box is available only if the Data type is Choice or Likert Scale. |
|                  | Note: Randomizing answer options for certain questions may make those questions confusing for users. In general, only randomize answer options that do not follow a logical order. |

| Scale definition | Setting that determines whether lesser or greater numerical values equate to a good score in quiz result calculations. Select Low if lesser numerical values are better. Select High if greater numerical values are better. The default value is High. This field is available and required unless the Data type is Date, Date/Time, or String. The results for these data types are not included in results calculations. When the Scored check box is selected, the scale value is set to High and the field is hidden. |
|                 | Note: For information about how to set the scale definition for data types that do not require you to set a numerical value, see Data types for assessments. |

| Min | Lowest numerical value that can be used as an answer option. This field is available and required only if Data type is Number, Duration, or Percentage. |
| Max | Highest numerical value that can be used as an answer option or scaled value. This field is available and required if Data type is Number, Duration, or Percentage. |

<p>| String option | Setting for the appearance of a string field in a question. This field is available when the question type is String. The string options are: |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single line</td>
<td>Single line text field 40 characters in length that allows strings of any length.</td>
</tr>
<tr>
<td>String line wide</td>
<td>Full page width text field that allows a single line entry of any length.</td>
</tr>
<tr>
<td>Multiline</td>
<td>Full page width multiline text field that allows word wrap and returns.</td>
</tr>
<tr>
<td>Scored</td>
<td>Check box for using answers in scoring the category results and showing them in the quiz results. Scored questions are available for these data types:</td>
</tr>
<tr>
<td></td>
<td>• Choice</td>
</tr>
<tr>
<td></td>
<td>• Likert Scale</td>
</tr>
<tr>
<td></td>
<td>• Template</td>
</tr>
<tr>
<td></td>
<td>• Checkbox</td>
</tr>
<tr>
<td></td>
<td>• Yes/No</td>
</tr>
<tr>
<td>Correct answer</td>
<td>[Required] Desired answer to a scored question. This field is available when the <strong>Scored</strong> check box is selected. Multiple correct answers are supported for a few data types. See Data types for quizzes.</td>
</tr>
<tr>
<td>Template</td>
<td>Answer template to use with this question. This field is available when the <strong>Data type is Template</strong>.</td>
</tr>
<tr>
<td>Related List</td>
<td>**List of options for this question. This related list is available only if the <strong>Data type is Choice or Likert Scale</strong>.</td>
</tr>
</tbody>
</table>

**Related reference**
- Data types for quizzes
- Related information
- Assessment metrics
- Create quizzes with forms
- Create a quiz
Set up a category
Select a user for a category
Create answers for questions

Create answers for questions

Questions with Choice or Likert Scale data types must have defined answer options, called metric definitions.

About this task
When you create a question with one of these data types, the Assessment Metric Definitions related list appears. Each metric definition appears as one answer option for a question on a quiz. For example, the question What type of men's trousers are not permitted by company policy? might have these three answers configured as metric definitions: Slacks, Jeans, and Casual cotton.

Procedure
To create an answer option, open the question record you want to edit and click New in the Assessment Metric Definitions related list. Be sure to give each option a Value. The system uses this number to establish the order in which the answers appear in the quiz.

Related reference
Data types for quizzes
Related information
Create quizzes with forms
Create a quiz
Set up a category
Select a user for a category
Create questions
Change the order of an answer

© 2021 ServiceNow, Inc. All rights reserved.
Servicenow, the servicenow logo, Now, and other servicenow marks are trademarks and/or registered trademarks of servicenow, inc., in the united states and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Distribute a quiz
Modify a published quiz

Distribute a quiz
When you finish configuring the answers for the quiz questions, you are ready to distribute the quiz.

About this task
You can send the quiz to all the category users configured for the quiz or to a single category user.

Procedure
1. Navigate to Quiz Management > Quizzes.
2. Open the quiz record, and click Publish. The quiz is placed in the Published state, and it is sent to all its category users. You can edit and resend published quizzes. See Modifying Published Quizzes to learn how various modifications affect the quiz contents.
3. To resend a quiz, click the appropriate button:
   - Assign Quiz: Send the quiz to one category user.
   - Send Quizzes: Send the quiz to all of its category users.
Note: These buttons are hidden if there are no category users defined for the quiz.

Related information

Create a quiz
Modify a published quiz

Modify a published quiz
Post changes to existing questions immediately. Make new questions available to users who have not started the quiz.

Procedure
You can edit a quiz even after it has been distributed, with these results:
• Added questions are available only on quizzes that are distributed after this change.

• Changes to existing questions are immediately available to users before the quiz is submitted or during the retake period. This includes changes to the answers, such as additional choices or changes to the data type.

• Deleted questions are also deleted from the distributed quizzes in users' queues.

**Related information**

Create a quiz
Change the order of an answer

**Add a metric category and metric in the question bank for quizzes**

Reuse the question categories (metric categories) and questions (metrics) added in the question bank for quizzes. You can add metric categories or metrics from the question bank to a quiz, or from the quiz to a question bank.

**Before you begin**
Role required: admin or assessment_admin

**Procedure**

1. Navigate to **Quizzes > Question Bank**.
2. Click **New**.
3. In the Metric Category form, fill the fields.

<table>
<thead>
<tr>
<th>Metric Category fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td>Total metrics</td>
</tr>
</tbody>
</table>

4. Right-click on the title bar and click **Save**.
5. In the Assessment Metrics related list, click **New**.
6. In the Assessment Metric form, fill the fields. For more information on these fields, refer to Create questions.

7. Click Submit.

**Configure metric categories or metrics for a quiz using the question bank**

Reuse question categories (metric categories) and questions (metrics) from the Question Bank module while creating or updating a quiz.

**Before you begin**

Role required: admin or assessment_admin

**Procedure**

1. Navigate to Quizzes > Quizzes.

2. Open a quiz definition.

3. **Optional:** To add metric categories to a quiz from the question bank in Platform, perform the following steps.

   a. In the Metric Categories related list, click **New Category from Bank**.
      The New Category from Bank dialog box is displayed with a list of all metric categories added in the question bank.

   b. Select the required categories and click **Add Selected**.
      A copy of the metric category and the corresponding metric definitions is created in the Metric Categories related list.

4. **Optional:** To add metrics to a quiz from the question bank in Platform, perform the following steps.

   a. In the Metric Categories related list, open a metric category definition.

   b. In the Assessment Metrics related list, click **New Metric from Bank**.
      The New Metric from Bank dialog box is displayed with a list of questions available in the question bank.

   c. Select the required metrics and click **Add Selected**.
      A copy of the metric and the corresponding metric definitions is created in the Assessment Metrics related list of the category.

5. **Optional:** To add a metric category to the question bank from a quiz in Platform, perform the following steps.
a. In the Metric Categories related list, open a metric category definition.

b. Click **Add to Question Bank**.
   A copy of the category is created along with its metrics and metric definitions in the question bank.

6. **Optional:** To add a metric to the question bank from a quiz in Platform, perform the following steps.

   a. In the Metric Categories related list, open a metric category definition.

   b. In the Assessment Metrics related list, open the required metric definition.

   c. Click **Add to Question Bank**.
      The Add to Question Bank dialog box is displayed.

   d. In the **Choose a question bank to add this question/metric** field, select a metric category that you want to add this metric to, and click **OK**.
      A copy of the metric and the corresponding metric definitions is created for the selected category in the question bank.

7. **Optional:** To add a metric category or metric to a quiz from the question bank in Quiz Designer, perform the following steps.

   a. Open the quiz in Quiz Designer.

   b. **Optional:** To add a metric category from the question bank, from the Categories tab in the left panel, drag the required category banner and drop in the Design tab.

   c. **Optional:** To add a metric from the question bank, drag and drop the required metric from the Questions tab or the Categories tab.

**Note:**

- When you drag and drop a metric category, all dependencies within the category are also added to the quiz.

- From the Categories tab, you can drag and drop an individual metric within a metric category.

- When you drag and drop a parent metric, all dependent questions are also added to the metric category.

- When you drag and drop a child metric, only the child question is added to the metric category.
Edit a quiz
You can update a quiz after the quiz has been distributed.

Before you begin
Role required: assessment_admin or admin

About this task
You can only edit a quiz that has the same application scope as that of your current session.

- Questions that you add are available only on quizzes that are distributed after the update.
- Before a quiz is submitted or during the retake period:
  - Changes to existing questions are immediately available to users. This includes changes to the answers, such as additional choices or changes to the data type.
  - Deleted questions are deleted from distributed quizzes in users' queues.

Procedure
Open the quiz: Group the Service Details form with one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quizzes &gt; Quiz Designer</td>
<td>Point to the menu icon in the quiz header bar and select <strong>Load Quiz</strong>.</td>
</tr>
<tr>
<td>Quizzes &gt; Quizzes</td>
<td>Right-click a quiz in the list and select <strong>Quiz Designer</strong>.</td>
</tr>
<tr>
<td>Quizzes &gt; Quizzes</td>
<td>Open a quiz from the list and click <strong>Quiz Designer</strong> in the header of the Assessment Metric Type form.</td>
</tr>
</tbody>
</table>

Related information
Quiz designer

Configure a scored question
Only scored questions are considered when calculating category and quiz results.

Before you begin
Role required: assessment_admin or admin
About this task
A question must have a correct answer specified to be scored. Only results for scored questions are displayed in the quiz scorecard.

Procedure
1. Navigate to Quizzes > Quizzes.
2. Open the quiz containing the questions you want to mark as scored.
3. In the Metric Categories related list on the Assessment Metric Type form, select the category for the questions you want to mark as scored.
4. In the Assessment Metrics related list on the Metric Category form, select a question from the list.
5. In the Question Type section of the Assessment Metric form, select the Scored check box.
   This check box is not available if the question's data type is not supported for scoring.
6. Select the Correct answer for the question.

   Note: Multiple correct answers are supported for a few data types. See Data types for quizzes.
7. Click Update.
8. Repeat the process for all the questions in the category that you want the system to score.
9. Return to the list of metric categories, select another category, and configure scoring for the appropriate questions in that category.

Configure a template question
You can configure template questions when designing quizzes.

Before you begin
Role required: assessment_admin or admin

Procedure
1. Drag the Template data type icon into a category container.
2. Click the gear icon in the question title bar to open the template properties dialog box.
3. Select a predefined scale from the list.
Question entry fields appear for that template.

4. Enter one or more questions that are appropriate for the template.

5. Click the arrow to the right of a question to configure its properties. You must provide a name for each question.
6. Click the up or down arrow to move between questions, or click the back arrow to return to the template properties dialog box.

7. Configure the properties for the remaining questions.

8. Click the X icon to close the template properties dialog box and save your settings.

**Related information**

- Quiz designer
- Create a quiz

**Enable a quiz retake**

You can configure a quiz to allow recipients to resubmit their answers as many times as they like, until the quiz's due date.

**Before you begin**

Role required: assessment_admin or admin

**About this task**

Results are not calculated until the quiz's configured duration has elapsed. The card in the user's queue remains visible until the quiz's due date and displays a button to allow retakes.
Procedure

1. Navigate to Assessments > Metric Definition > Types.
2. Remove the Evaluation method = Assessment filter condition so you can see all the records in the list.
3. Open the quiz.
4. In the Assessment Metric Type form, select the Allow retake check box and save the record.

Related information
- Quiz designer
- Publish a quiz

View a quiz result
You can view quiz results for each question and category, or view the quiz scorecard for a detailed breakdown.

Before you begin
Role required: assessment_admin or admin

About this task
Quiz results are stored in the Metric Result [asmt_metric_result] table and display recipients' answers to each question in a category.

Procedure

Navigate to Quizzes > Quiz Results.

Related information
- Quiz designer
- Publish a quiz
Quiz reports

Quizzes provide several global reports so that assessment administrators can view important statistics.

You can share these reports with specific users or groups and change the display options.

For detailed field information and reporting options, click the link for the chart **Type**. To sort a column in ascending or descending order, click the arrow in the column heading.

---

### Quiz reports

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quizzes by State</td>
<td>State of distributed quizzes. This chart displays the percentage of distributed quizzes that are ready to take, in progress, complete, or canceled.</td>
</tr>
<tr>
<td>• <strong>Type</strong>: Pie Chart</td>
<td></td>
</tr>
<tr>
<td>• <strong>Table</strong>: Assessment Instance [asmt_assessment_instance]</td>
<td></td>
</tr>
<tr>
<td>Total Questions by Quiz</td>
<td>Total number of questions for all categories in each quiz.</td>
</tr>
<tr>
<td>• <strong>Type</strong>: Bar Chart</td>
<td></td>
</tr>
<tr>
<td>• <strong>Table</strong>: Assessment Metric [asmt_metric]</td>
<td></td>
</tr>
<tr>
<td>Questions by Data Type</td>
<td>Total number of questions in all quizzes by data type.</td>
</tr>
<tr>
<td>• <strong>Type</strong>: Bar Chart</td>
<td></td>
</tr>
<tr>
<td>• <strong>Table</strong>: Assessment Metric [asmt_metric]</td>
<td></td>
</tr>
<tr>
<td>Correct Answers by Assigned User</td>
<td>Total number of scored questions answered correctly by each assigned user.</td>
</tr>
<tr>
<td>• <strong>Type</strong>: Bar Chart</td>
<td></td>
</tr>
<tr>
<td>• <strong>Table</strong>: Metric Results [asmt_metric_result]</td>
<td></td>
</tr>
<tr>
<td>Number of Correct Answers</td>
<td>Total number of correct answers for each scored question.</td>
</tr>
<tr>
<td>• <strong>Type</strong>: Bar Chart</td>
<td></td>
</tr>
<tr>
<td>• <strong>Table</strong>: Metric Results [asmt_metric_result]</td>
<td></td>
</tr>
<tr>
<td>Incorrect Answers by Assigned User</td>
<td>Total number of scored questions answered incorrectly by each assigned user.</td>
</tr>
<tr>
<td>• <strong>Type</strong>: Bar Chart</td>
<td></td>
</tr>
<tr>
<td>• <strong>Table</strong>: Metric Results [asmt_metric_result]</td>
<td></td>
</tr>
</tbody>
</table>
### Quiz reports (continued)

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Incorrect Answers</td>
<td>Total number of incorrect answers for each scored question.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Metric Results [asmt_metric_result]</td>
</tr>
</tbody>
</table>

### View a quiz scorecard

You can view scorecards for a quiz record.

**Before you begin**

Role required: assessment_admin or admin

**About this task**

For detailed information about scorecards, see Quiz scorecards.

**Procedure**

1. Navigate to **Quizzes > Quizzes**.
2. Open a quiz record.
3. Under **Related Links**, select **View Scorecard**.
   - The scorecard link is hidden if there are no quiz results to report.
4. The scorecard contains a header that displays the name of the quiz and a section that displays results or a comparison of ratings. You can select from these principal views:
   - Category Results
   - Question Results
   - Average Ratings
   - History

### Quiz scorecards

The Quizzes application prepares printable scorecards.

A scorecard analyzes category and question responses and compares current ratings with previous ratings. You can examine ratings over time, compare question ratings, or compare the ratings of all categories. All ratings are averages for the time range selected.

The system dynamically updates a scorecard each time you view it, so the ratings reflect recently completed quizzes.
Category results

The Category Results view is a stacked bar chart of responses to all questions in a category.

Select the category to display from the choice list above the chart. Category results are only calculated for scored questions.

This view displays responses that use the following data types:

- Checkbox
- Choice
- Likert Scale
- Number
- Template
- Yes/No

Note: The Checkbox and Yes/No data types are combined into the Boolean data type in the Quiz designer.
To view details about a specific response to a question, point to the colored segment representing a specific response. The chart displays the count for those responses and the percentage it represents of the total responses to that question.

Question results
The Question Results view shows the results for all questions in a quiz.
Select a question by name from the choice list to display the results in a pie chart or a bar chart, based on the data type.
**Pie chart**
The pie chart shows question results for these data types:

- Checkbox
- Choice
- Likert Scale
- Number
- Template
- Yes/No

?? **Note:** The Checkbox and Yes/No data types are combined into the Boolean data type in the Quiz designer

**Bar chart**
A bar chart appears when question results use this data type:

- Percentage
By default, all results for percentage questions use a report range of 20% segments. To configure a report range, navigate to Reports > Administration > Report Ranges.

Average ratings

The Average Ratings view displays a bar chart of the weighted average rating for each question in a category.

Use this view to learn how individual questions affect the overall rating for the category. Select a category from the second choice list above the chart. Ratings are only calculated for scored questions.

Average Ratings view

To view the effect of each question's ratings on the entire category's ratings, point to the colored bar. The pop-up box shows the percentage of the total ratings represented by each individual question's weighted average.
Scorecard history

The History view compares the current ratings for the categories and their questions with ratings from the previous three years or four quarters.

Ratings that have declined are highlighted in red and display negative numbers. Ratings that have improved are highlighted in green with positive numbers. Arrow icons beside the values in the Diff column indicate the trend of the current ratings against the previous ratings. Ratings are only calculated for scored questions.

Point to a category to display a line chart that shows the rating trend for that category. Click a category to view the Metric Category form containing the questions.

• **3 Years:** To calculate the current ratings, the system averages the ratings from the trailing twelve month (TTM) period. The Diff column shows the discrepancy between the current ratings and the previous calendar year's ratings.
Scorecard history - 3 years

<table>
<thead>
<tr>
<th>Category</th>
<th>Current</th>
<th>Diff</th>
<th>3 Years</th>
<th>2013</th>
<th>2012</th>
<th>2011</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall Rating</td>
<td>14.81</td>
<td>14.81</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Dress Code</td>
<td>19.45</td>
<td>19.45</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Sexual Harassment</td>
<td>12.50</td>
<td>12.50</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Company Property</td>
<td>12.50</td>
<td>12.50</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

- **4 Quarters**: Quarterly quizzes compare the average rating for each question and category in the current quarter against the average ratings from the previous four quarters. The **Diff** column shows the discrepancy between the current ratings and the previous quarter's ratings. The column labels count backward, by quarter from the current quarter. For example, if the current quarter is the 3rd quarter of 2013, then the previous quarters appear as 2nd [2013], 1st [2013], 4th [2012], and 3rd [2012]. All four of the previous quarters appear, whether or not there was any data for those quarters.

Scorecard history - 4 quarters

<table>
<thead>
<tr>
<th>Category</th>
<th>Current</th>
<th>Diff</th>
<th>3rd</th>
<th>2nd</th>
<th>1st</th>
<th>4th</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall Rating</td>
<td>14.81</td>
<td>14.81</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Dress Code</td>
<td>19.45</td>
<td>19.45</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Sexual Harassment</td>
<td>12.50</td>
<td>12.50</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Company Property</td>
<td>12.50</td>
<td>12.50</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

View an assessment category result

Category results contain values that represent an evaluated record's performance in a specific metric category. Each category result record stores data from one assessment group. Category result values are calculated based...
on category and metric weights and from metric result values for the same category.

**Before you begin**

Role required: assessment_admin or admin

**About this task**

⚠️ **Note:** The system does not include metric results from certain responses in category result calculations. To compensate, the system adjusts the weight of the other normalized metric result values within the same category.

**Procedure**

1. Navigate to **Assessments > Results > Category Results**.
2. Click the reference icon (🔍) next to an assessment group number to open the category result record.
3. View the Assessment Category Result form. All fields on the form are read-only.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Name of the metric category that the category result values apply to.</td>
</tr>
</tbody>
</table>
| Rating  | Rating is used on scorecards and decision matrixes. Rating is updated dynamically as:

\[
\text{Rating} = \frac{\text{Sum of all normalized values that share a particular assessment group, category, and assessable record}}{\text{Number of assessment instances for the assessment group}}
\]

For example: In the Assessment Category Results table example, the assessment group **NY DB** (the assessable record) has a **Rating** value **8.86**.
On the associated Metric Results table, you can see that there are 4 instances of this group: `AINST0000801`, `AINST0000802`, `AINST0000803`, and `AINST0000804`.

The system calculated the rating using:

\[
\frac{(5.14+5.14+1.43+5.71+5.14+4.29+4.29+4.29)}{4} = 8.86
\]

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment group</td>
<td>Assessment group to which the category result is associated. The category result and metric results in this assessment group only.</td>
</tr>
<tr>
<td>Normalized value</td>
<td>Calculated value that measures the Rating relative to the weights of categories used to assess the record evaluated. The normalized value is calculated as follows: [ \text{Normalized value} = \frac{\text{Rating} \times (\text{Associated category weight} / \text{Sum of weights of all categories the source record has category results for in this assessment group})}{\text{Assessment group}} ]</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Example: A source record has four associated category results in assessment group ASG0000907, one for each of these categories:

- Importance Rating (weight = 10)
- Product Reliability (weight = 9)
- Company Alignment (weight = 9)
- Compliance Score (weight = 9)

If this source record's category result for Product Reliability has a Rating of 7.81, the normalized value calculation is:

\[ 7.81 \times \left[ \frac{9}{10+9+9+9} \right] = 1.9 \]

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>Weight of the associated category. You may need to configure the form to see this field.</td>
</tr>
<tr>
<td>Source</td>
<td>Record evaluated as the assessment subject. You may need to configure the form to see this field.</td>
</tr>
</tbody>
</table>

**Related reference**

- Assessment results

**Related information**

- View a metric result

**Create a decision matrix**

The name and labels on a decision matrix are closely linked to the categories you choose for the axes. For that reason, first select the metric type and define the X and Y axes before you fill in other fields on the Decision Matrix form.

**Before you begin**

Role required: assessment_admin or admin

**Procedure**

1. Navigate to **Assessments > Admin > Decision Matrixes**.
2. Click **New** and then select the metric **Type** to plot results for.
3. Right-click the form header and select **Save**.
   The X Axis and Y Axis related lists appear.
4. Define which metric categories the axes represent. Each axis can represent a single category or multiple categories. You must specify at least one category per axis in order for the decision matrix to render properly.
   The available categories are limited to those associated to the metric type selected. To avoid confusion, always update the text for the axis and quadrant labels after editing or adding metric categories to an axis.
5. Fill in the remaining fields on the Decision Matrix form (see table) and save the record.

Note: For color fields, either HTML color names or hexadecimal (hex) values are acceptable. For hex values, the # character is optional. Values are not case-sensitive. For example, all of the following values are valid: LightGray, lightgray, #D3D3D3, d3d3d3.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the decision matrix, which appears as the title on the decision matrix page. It is recommended to include the axis categories in the name. For example, if you selected <strong>Importance Rating</strong> as the X-axis and <strong>User Satisfaction</strong> as the Y-axis, you might name the matrix <strong>Importance vs. User Satisfaction</strong>.</td>
</tr>
<tr>
<td>Type</td>
<td>Metric type associated with this decision matrix. Only results for assessable records of the selected metric type are plotted on the decision matrix.</td>
</tr>
<tr>
<td>Default</td>
<td>Determines whether or not this is the default decision matrix. The default decision matrix opens when you click <strong>View Matrix</strong> on a scorecard. Select the check box to set the matrix as the default decision matrix. If there is already a default decision matrix for the type and you try to save a different matrix with the check box selected, an error message appears. The maximum values for the default decision matrix are controlled by the <strong>Maximum number of items to show for a decision matrix field filter</strong> property (<code>com.snc.assessment.decision_matrix_filter_max_entries</code>), which has a default value of 1000.</td>
</tr>
</tbody>
</table>

**Quadrant Design Section**

<table>
<thead>
<tr>
<th>Quadrant label color</th>
<th>Color of the label text for the quadrants. Each quadrant label displays in the center of the quadrant. You can enter an HTML color name or hex value for this and the other color fields.</th>
</tr>
</thead>
<tbody>
<tr>
<td>X-Axis label</td>
<td>Label text for the X-axis of the decision matrix. It is recommended to include the metric category name in the label text. For example, for an X-axis category of <strong>Importance Rating</strong>, the X-axis label is <strong>Importance</strong>.</td>
</tr>
<tr>
<td>Plotted item color</td>
<td>Color used to display plotted items.</td>
</tr>
<tr>
<td>Top left label</td>
<td>Label text for the top left quadrant. For an X-axis labeled <strong>Importance</strong> and Y-axis labeled <strong>Support</strong>, you might label the top left quadrant <strong>Low importance, high support</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Top left color</td>
<td>Fill color for the top left quadrant.</td>
</tr>
<tr>
<td>Bottom left label</td>
<td>Label text for the bottom left quadrant.</td>
</tr>
<tr>
<td>Bottom left color</td>
<td>Fill color for the bottom left quadrant.</td>
</tr>
<tr>
<td>Bottom left label</td>
<td>Label text for the bottom left quadrant.</td>
</tr>
<tr>
<td>Bottom left color</td>
<td>Fill color for the bottom left quadrant.</td>
</tr>
<tr>
<td>Y-Axis label</td>
<td>Label text for the Y-axis of the decision matrix.</td>
</tr>
<tr>
<td>Highlight item color</td>
<td>Color of highlighted plotted items. When you view a decision matrix from an assessable record's scorecard, the assessable record plotted item appears in the highlight color. Specify a highlight color that is different than the <strong>Plotted item color</strong>.</td>
</tr>
<tr>
<td>Top right label</td>
<td>Label text for the top right quadrant.</td>
</tr>
<tr>
<td>Top right color</td>
<td>Fill color for the top right quadrant.</td>
</tr>
<tr>
<td>Bottom right label</td>
<td>Label text for the bottom right quadrant.</td>
</tr>
<tr>
<td>Bottom right label</td>
<td>Fill color for the bottom right quadrant.</td>
</tr>
</tbody>
</table>

![Diagram of decision matrix](image)
### Decision matrixes

Assessment results obtained by questionnaires and scripted metrics can be mapped to decision matrixes.

Assessment administrators can view and create these dynamically updated graphs, which make it possible to compare assessable records by category. Decision matrixes display data from a trailing twelve month (TTM) period.

**Note:** Assessment administrators can access decision matrixes through the Assessment application and vendor managers can access them through the Vendor Performance application.

### Decision matrix components

The decision matrix page has these components:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Filter</strong></td>
<td>Select the subset of assessable records you want to view. The filter options available vary by metric type, based on the Filter field and Filter condition field settings for each metric type. The maximum values in the filter are controlled by the <strong>Maximum number of items to show for a decision matrix field filter</strong> property (com.snc.assessment.decision_matrix_filter_max_entries), which has a default value of 1000.</td>
</tr>
<tr>
<td><strong>Scale</strong></td>
<td>Select the scale for the decision matrix. The greater the scale, the larger the decision matrix appears.</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Decision matrix</td>
<td>Each axis represents one or more metric categories. If multiple categories are used for an axis, their respective weights determine the positioning of the plotted items.</td>
</tr>
<tr>
<td>X- and Y-axes</td>
<td>The labeled points you see on a decision matrix, called plotted items, represent averages of category result data for assessable records. Point to a plotted item label to view a rating summary for that assessable record. Click a plotted item label to view the scorecard for the assessable record.</td>
</tr>
</tbody>
</table>

**Plotted item rating summaries**

If you point to a plotted item label on a decision matrix, a rating summary appears. The summary displays the assessable record's average ratings for...
each axis. If an axis represents one metric category, the ratings are calculated averages from results for that category. If an axis represents multiple categories, the ratings are calculated averages from weighted results for all of the categories.

The summary shows:

- Current rating
- Difference between the current rating and the rating from the previous year
- Ratings from each previous year, going back three years

**Take an assessment**

Assessments that are assigned to you appear in your assessment and survey queue as a card that displays the assessment name, state, due date, and the associated incident number. Click **Take Survey** when you are ready.

**Before you begin**

Role required: none

**About this task**

Overdue surveys and assessments are marked with a red icon and red due date. You must answer every required question, indicated by a red bar, before
you can submit the assessment as complete. If you start to take an assessment but cannot complete it, save your responses and return to it later. When you have answered all the questions and are satisfied with the responses, submit the assessment.

By default, you cannot modify your answers to an assessment after submission. However, if the administrator has configured an assessment to allow retakes, you can edit your answers and resubmit the questionnaire. Completed assessments configured for retake remain in the queue until their due date and display the Modify Assessment button on the card.

Procedure

1. Navigate to **Self-Service > My Assessments & Surveys**.

   - **Note:** Users with the assessment_admin role can display other users’ assessments and surveys in addition to their own. Use the Show all and Show assigned to me related links to show and hide assessments and surveys. Click a card assigned to another user to open the associated metric type or survey definition.

2. On the assessment card, note the due date.

   - **Note:** Depending on the configuration, you may receive email notifications to remind you of the due date.

3. Click **Take Assessment** to open the questionnaire.

   Assessment questionnaires are arranged in sections: first by record, then by category. Each record appears as a section title. Questions for the record appear below, grouped by category. Each category appears as a subsection below the record name. Click the collapse icon (Collapse) or expand icon (Expand) to hide or show the questions in a category, or all the categories and questions for a record. Colored bars indicate the status of each question.
4. Answer each question to the best of your ability. Point to a question for more information.

If you are unsure of how to respond to a question or if a question does not apply to a particular record, select Not Applicable, if available.

5. Read any assertions present at the end of the assessment and acknowledge with a signature, if required.

A signature can require you to select a check box or authenticate your full name, which the system displays in a read-only field. You cannot submit your answers to the assessment until you provide the required signature.

6. Save or submit the assessment.

- **Save**: Saves your responses without submitting them. You can close the questionnaire and access it later from your queue.

- **Submit**: Submits the completed assessment when you are finished.

7. If prompted, enter your user name and password to verify your full name signature.

If all the questions are answered with valid values, a success message appears. If the system detects an unanswered mandatory question or invalid response, the assessment is not submitted, and a message appears at the
top of the questionnaire explaining the error. Questions with problems are temporarily highlighted.

8. You can modify your responses to the assessment until its due date. To update your answers and resubmit an assessment that permits retakes, click **Modify Assessment**.

**Related information**
- Metric types and assessable records
- Survey definitions

**Assessment questionnaires**

In the assessment process, users complete assessment questionnaires on topics of interest to provide subjective data for future business decisions.

No special role is required to complete an assessment. You are eligible to complete assessments that are assigned to you. For example, you might be expected to evaluate vendors your organization works with, based on traits related to customer service. The system stores your responses so decision makers can compare the performance of the items you evaluate. You and your manager may receive email notifications as reminders of important assessment information.

**Related reference**
- Assessment notifications

**Related information**
- Take an assessment
**Metric types and assessable records**

In the Assessments application, assessment administrators create and administer metric types and assessable records.

A metric type defines a set of records an organization wants to evaluate, such as vendors, projects, or employees. For each type, the system generates unique assessable records that link the type to records that need to be evaluated, such as the individual records for the vendors Amazon and Intel. There may be multiple assessable records for the same source record if the source record meets the criteria for more than one type. For example, you might want to evaluate a record on the Company table, such as Intel, as a vendor and as a manufacturer, with different categories and metrics.

For configuration suggestions, see *Assessment administrator tasks*.

**Assessable records**

An assessable record links a source record you want to evaluate, such as the company record for Amazon or the user record for a sales representative, to a metric type, such as vendors or employees.

You use assessments to evaluate the assessable record. The system generates assessable records from the source records that match the table and conditions set on the Assessment Metric Type form. You evaluate the assessable records with metric categories and metrics, which define traits and values to assess. For metric types with the *On demand* schedule type, you can generate on-demand assessments from the Assessable Record form. This method of assessment generation makes it easy to create and preview short questionnaires or to quickly obtain assessment results for specific assessable records.

You can set up an assessment description that includes information from multiple fields on an assessable record and is displayed on multiple lines. This set up provides the user who is taking the assessment with a more detailed and understandable description of the information being requested on the assessment questionnaire. Create a multi-line description using table titles, which can be defined to use one or more fields from the selected table. See *Customize the mobile list title* for more information.

**Related information**

- Use update sets for surveys and assessments
- Metric types and assessable records
- View an assessable record
- Customize the mobile list title
Delete an assessable record

When you delete an assessable record, the system deletes any stakeholders for the record.

Before you begin
Role required: assessment_admin or admin

About this task

Note: If a source record is deleted, the system deletes the associated assessable record. To delete the source record, you must first delete all associated metric results and category results.

Procedure

Delete the assessable record:

• To delete a single record, open the record and click Delete.
• To delete multiple records, use the Assessable Records list.

Related information

- Metric types and assessable records
- Assessable records

View an assessable record

View the Assessable Record form to edit preferences and perform various actions.

Before you begin
Role required: assessment_admin or admin

Procedure

1. Navigate to Assessments > Assessable Records.
2. Open a record from the list.
   By default, the list displays only assessable records with Active metric types.
3. On the Assessable Record form, edit fields and perform other actions as necessary (see table).
### Viewing Assessable Records

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>[Read-Only] Assessable record name based on the display value of the source record. The name appears on assessment questionnaires.</td>
</tr>
<tr>
<td><img src="Image" alt="Amazon" /></td>
<td></td>
</tr>
<tr>
<td><strong>Source</strong></td>
<td>[Read-Only] Source record the assessable record is linked to. The Source reflects the table name and source record display value. For example, if the <strong>Name</strong> field is the display value for the Company table, the assessable record for a company record named Amazon has the Source value <strong>Company: Amazon</strong>.</td>
</tr>
<tr>
<td><strong>Live feed</strong></td>
<td>Check box that, when selected, creates a live feed group for the assessable record, which appears on the scorecard. If you clear the check box after a live feed group has been created, the system deletes the live feed group and all its messages.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>[Read-Only] Metric type from which the assessable record was generated.</td>
</tr>
<tr>
<td><strong>Decision matrix</strong></td>
<td>Check box that, when selected, enables this assessable record's results data to appear on decision matrixes of the same metric type. Decision matrixes are graphs that plot the assessment results for multiple assessable records. If you clear the check box, the assessable record still appears on the default decision matrixes if you click the <strong>View Matrix</strong> related link on the assessable record's scorecard.</td>
</tr>
<tr>
<td><strong>Live feed group</strong></td>
<td>[Read-Only] Live feed group for this assessable record. When you select the <strong>Live feed</strong> check box and save the record, the system populates this field.</td>
</tr>
</tbody>
</table>

#### Related Links

- **View Scorecard**: Opens the scorecard for the assessable record.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>All metric categories associated with the assessable record. An assessable record must be associated to a category to be evaluated. Click <strong>Edit</strong> to add or remove category associations. Note that it is often more efficient to associate assessable records to categories using the Metric Category form.</td>
</tr>
<tr>
<td>Category users</td>
<td>All stakeholders who can take assessment questionnaires about this assessable record. Click <strong>Edit</strong> to create and delete stakeholders. For more information about this and other methods of creating stakeholders, see <strong>Stakeholders</strong>. This related list is available only when the associated metric type has the <strong>Scheduled</strong> schedule type.</td>
</tr>
</tbody>
</table>

**Related information**
- Metric types and assessable records
- Assessable records

### Domain separation and Assessments

Domain separation is supported for Assessments. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: Standard**
- Includes **Basic** level support.
- Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see **Application support for domain separation**.

**Related information**
- Domain separation for service providers
Approvals

Approvals require authorization on tasks before the work is done. You can define approvals for all tasks and associate users or groups to a task to approve or reject them.

Approvals are defined by navigating to System Policy > Approvals.

The following information defines an approval:

### Approval definition information

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approver</td>
<td>A reference to the user who is responsible for approving the related record.</td>
</tr>
</tbody>
</table>
| State             | Choices are:  
|                   | • Not Yet Requested (This state indicates that you are not yet asking your approvers to approve this request. Until you set the status to **Requested** they will receive no email notifications about the request.)  
|                   | • Requested  
|                   | • Approved  
|                   | • Rejected |
| Approving         | A document_id reference field to the record being approved, on any table.    |
| Comments          | A journal field for storing comments regarding the approval.                 |
| Approval Summarizer | A formatter that displays key fields relevant to the approval from the referenced document. This summarizer will not display if there is no record referenced. |

### Approval engines

The differences in the way that companies handle their approvals, as well as the differences between approvals for the various applications (such as Service Catalog Requests and Change Management), calls for supporting flexibility in setting up approvals within applications. This flexibility is provided through the selection of an “approval engine” that is used to manage the approvals for each of the Task tables (that is, all tables that extend the Task table).

There are three different approval engine options available for each Task table.
### Approval engine options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Rules</td>
<td>A simple set of rules that are evaluated until one matches for the Task table. The matching approval rule is used to create the users that are to approve the task. Set up approval rules by navigating to System Policy &gt; Approvals.</td>
</tr>
<tr>
<td>Process Guides</td>
<td>A sequence of approval steps over which you may control how approvals and rejections are handled. This option is deprecated and should not be used.</td>
</tr>
<tr>
<td>Turn off Engines</td>
<td>Turn off both approval engines for this Task table. This option should be selected and is made read-only when a workflow is used to manage the approval process for the table.</td>
</tr>
</tbody>
</table>

⚠️ **CAUTION:** Not turning off the approval engines might have a performance or behavioral impact on your instance.

### Set up an approval engine

To manage the approvals for each of the Task tables in the system, set up an approval engine.

#### Procedure

1. Navigate to **System Properties > Approval Engines**.

   The following page appears with the Approval Engine option for each Task table in the system. If the Approval Engine option is greyed out and shows Turn engines off, read the Notes in the same row. The most common reason an approval engine is turned off is that a workflow is managing the approvals on the table. Having the approval engine turned off prevents conflicts with the workflow that could cause a range of issues. If you want to use an approval engine on the table, set the workflow to inactive.
2. Select the approval engine option for each Task table from the choice list.

3. Click Save.
   
   These preferences are saved as system properties that are named `glide.approval_engine.<table_name>`.

Approval rules

Many organizations rely on an approval process to ensure that requests are reasonable and fit an organization’s budget.

The service catalog can use these classes of approvals:

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gating approvals</td>
<td>Must occur before a request can be initiated. For example, allow a manager to reject an employee's request for a company car.</td>
</tr>
<tr>
<td>Process approvals</td>
<td>Take place within an execution plan process that has been initiated. For example, allow the security group to reject a request for access to SSN even though the employee's manager approved it.</td>
</tr>
</tbody>
</table>
Note: To enable approval processes to operate smoothly, make sure that the appropriate users have the correct role, and that the role grants access to the necessary tables for users in all the relevant departments and domains.

Set automatic approval rules
Approval rules can automatically set the approval state to something other than Not yet requested. As a result, an approval rule can create a set of approvers. You can also start the approval process by setting the approval state to Requested.

Prerequisites
Role required: admin
Approval rules have two new fields:

• Run rule before: If true, the approval rule runs before the record is inserted/updated.

• Set State: If this rule applies, then the task record's approval state is automatically set to this value.

Note: The Set State field only behaves as expected if the Run rule before check box is enabled.

• In the example below, this rule automatically sets the state of the task to Approved thereby auto-approving the task.

Approval Rules fields

Gating approvals
A gating approval acts as a gate through which a request must pass before it can start.

Until all gating approvals are met, no notifications go out, no tasks get sent to technicians, and nobody starts working on the request in question.

Generate gating approvals with:
Gating approvals

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval rules</td>
<td>Can apply to the service catalog as well as any other task table.</td>
</tr>
<tr>
<td>Item-based approvals</td>
<td>Flag specific catalog items as requiring specific approvals. Any requests for these items automatically require these approvals.</td>
</tr>
</tbody>
</table>

Set up a gating approval via an approval rule

You can set up a gating approval via an approval rule.

**Before you begin**

Role required: admin

**Procedure**

1. From the left navigation pane, select **System Policy > Approval Rules**.
2. Click **New**.

Set these to auto start the approval process

**Approval rules**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of this rule.</td>
</tr>
<tr>
<td>Table</td>
<td>Task table to which this rule applies. For most service catalog approvals, select <strong>Request</strong>.</td>
</tr>
<tr>
<td>Note: The list shows only tables and database views that are in the same scope as the approval rule.</td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Indicator of whether the rule is active (defaults to true).</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Run Rule</td>
<td>Indicator of whether the rule runs before or after the request record is saved. For most approvals, select this check box.</td>
</tr>
<tr>
<td>Before</td>
<td>User who must approve this request (can be empty).</td>
</tr>
<tr>
<td>User</td>
<td>Group that must approve this request (can be empty).</td>
</tr>
<tr>
<td>Group</td>
<td>Set State Value of the approval field on the task in after this rule runs. In most cases, select Requested.</td>
</tr>
<tr>
<td>Set State</td>
<td>Condition Condition under which the rule applies.</td>
</tr>
<tr>
<td>Condition</td>
<td>Script An optional server script to programmatically specify who the approver should be. For example, for the one-line script <code>current.requested_for.manager</code>, ServiceNow checks the requested_for reference field on the current record. It then locates the manager field on the referenced record and assigns that person as the approver. For other examples, see the Script field on approval rules provided by ServiceNow.</td>
</tr>
</tbody>
</table>

Notes and limitations:

a. You can have as many rules as you want on a given table. If more than one rule applies, you'll get more than one approver.

b. You can't get duplicate approvers, for example, if two rules both want Fred Luddy to approve a particular request, the system will only create one approval entry for him.

c. By default all requests start out in a Not yet requested approval state. Approval notifications will not go out until the request's approval state is set to Requested. You can do that manually, or you can do it in script, but the easiest way to do it is to use the Set State field to automatically set the request to Requested.

Set up a gating approval based on the item being ordered

In addition to adding approvals via approval rules, you can also add approvals based on what kind of item is being ordered.

In addition to adding approvals via approval rules, you can also add approvals based on what kind of item is being ordered. We can, for example, specify that all Blackberrys need to be approved by David Loo.

To do so, navigate to the item in question and scroll to the related list of required approvers. There are two lists:
• **Approved By Group**: A list of groups that have to approve requests for this item

• **Approved By**: A list of users who have to approve requests for this item

---

**Approve list**

<table>
<thead>
<tr>
<th>Approved By Group</th>
<th>New</th>
<th>Edit...</th>
<th>Sc cat item = Backberry</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Approval group**
  - Hardware

- Actions on selected rows...

<table>
<thead>
<tr>
<th>Approved By</th>
<th>New</th>
<th>Edit...</th>
<th>Sc cat item = Backberry</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Approver**
  - David Loo

- Actions on selected rows...

---

In the example above, this request must be approved by all members of the Hardware group and by David Loo.

**Notes and limitations:**

1. As with approval rules, you are protected against duplicate entries. Thus if David Loo is a member of the hardware group, as well as being a standalone approver, he will only get one approval request.

2. Item-based approved work in addition to rather than instead of approval rules so you can (and probably will) use both.

**Process approvals**

Once a request has passed its gating approvals, any relevant execution plans are initiated.

Those plans, in turn, create a sequence of required tasks. You can add an approval step to an execution plan, which is configured to occur at the appropriate point.

From the left navigation pane, select **Service Catalog > Execution Plans**, and then select the plan to which to add an approval step. Then click the **New Approval** button.
Add approval

The Approval Task screen appears. Just like a regular Service Catalog execution task, an approval execution task has:

- **Name**: The name of this task
- **Order**: Sequence of this task within the plan
- **SLA**: SLA to which this task applies
- **Delivery Time**: Time allowed for the completion of this task

After you create the task, right click the title bar and select **Save**. Two related lists appear at the bottom of the screen:

- **Approved By Group**: A list of groups that must approve the request before this task is complete
- **Approved By**: A list of users who must approve the request before this task is complete
In the example above, this security approval task must be approved by Fred Luddy.

**Note:** When an in-process approval is rejected, that particular line item is canceled as well, but the request itself isn't necessarily canceled. Thus if one ordered a blackberry and a laptop, and the blackberry was rejected, the laptop request would continue being processed.

**Approve with a process guide**

Process guides work similarly to approval rules in that their execution is controlled via a condition.

**About this task**

The default version of approval tasks allows you to specify that the approval in question be approved by:

1. One or more specific people
2. One or more groups of people

You can optionally use Process Guides instead of approval tasks. Process guides are more flexible in that they allow for:
1. "Any of" or "All of" approvals
2. Sequenced approvals

You can link a process guide to an execution task.

**Procedure**
1. From the left navigation pane, select **System Policy > Process Guides**.
2. Create a new guide.
3. Set the table to **Catalog task**.
4. Fill in a condition under which this guide should attach.
   
   **Example #1:** Apply to all "Capacity Review" tasks.

   ![Add Condition](image1)

   **Example #2:** Apply to all "Capacity Review" tasks where the requester is in Atlanta.

   ![Add Condition](image2)

**Process guide tips and tricks:**

- **a.** All catalog tasks are generated when a request is first submitted, but tasks which aren't active yet have a state of "pending". So if you do not want to send out approval requests until a task has actually started, add "state=open" as part of your condition.

- **b.** There is a "Default" process guide in the system for catalog tasks with a sequence number of 10,000. It behaves exactly the same way the old, pre-process guide code did in regards to approvals. Approvals are based on the execution of task-related lists.

**Schematic of a hypothetical approval process**

In the diagram below of a hypothetical approval process, the gating approval is color coded blue and an in-process approval is orange.
Approval summarizer formatter

The approval summarizer formatter creates the summary at the bottom of an approval form.

The approval summarizer displays different information depending on what is being approved, such as a change request or a service catalog request. Following are two examples.
The **Reject** button allows the approver to deny one or more requested items in a multi-item request, before approving the overall request. If a requested item is denied, the workflow for that item never starts. The approver can then choose to **Accept** the item.
Note: When the overall request is approved, you must ensure this Reject button is hidden. If this button is used after request approval, the requested item workflow is canceled, leaving the stage in an inconsistent state. Similarly, the Accept button on requested items should only appear before the overall request is approved or rejected.

Summarizers
Approval summarizers are stored in the Macro [sys_ui_macro] table.
From the left navigation pane, select System UI > UI Macros. Summarizers use a naming convention of approval_summarizer_ + `<table_name>` (for example, approval_summarizer_change_request is the summarizer for change requests, while approval_summarizer_sc_request is the summarizer for service catalog requests).
Each summarizer is written in Jelly script, which is used to define internal forms. The script is stored in the large XML field at the bottom of the UI Macro form.

Change an approval summarizer
You can modify existing approval summaries to include additional information.

About this task
These are advanced customizations that might not be appropriate for all implementations, and require creating a custom form.

Procedure
1. Navigate to System UI > UI Macros.
2. Open the summarizer you want to change.
3. Copy the script to another location before editing, in case you need to revert it.
4. Modify the script.
5. Click Update.

Create a new custom approval summarizer
After you add a new table that has approvals to an instance, you can add a custom activity formatter by creating a new UI macro and then add it to the appropriate form.

About this task
approval_summarizer can only be used on approval forms in the global scope.
Procedure

1. Navigate to System UI > UI Macros
2. Click New.
3. Give the macro a name that follows the summarizer naming convention:
   approval_summarizer_<tablename>
4. Complete the rest of the form and click Submit.
5. Create an activity formatter and add it to the appropriate form.
   To learn more about activity formatters, see Activity formatter.

Approval with e-signature

Approval with e-signature allows users to approve requests by re-entering their login credentials.

Approval with e-signature supports the following authentication credentials:

- User name and password matching a user in the local database.
- User name and password matching a user authorized by an external identity provider as part of a SAML 2.0 single sign-on integration.

Activate Approval with e-Signature plugin

The Approval with e-Signature plugin (com.glide.e_signature_approvals) allows users to approve requests by re-entering their login credentials.

Before you begin
Role required: admin

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
De-activate e-signatures

Use this procedure to de-activate e-signatures.

Although plugins cannot be removed, e-signatures can be disabled.

1. Navigate to System Definition > E-Signature Registry.
2. Set Enabled to False on any tables where e-signatures are no longer required.

Use e-signature approvals

Users can approve requests with an e-signature.

Users can approve requests with an e-signature by:

- Selecting the Approve or Reject option on a list context menu.
- Clicking the Approve or Reject button on a form.
- Changing a request record's State to Approved in either the list-editor or form.

Selecting any of these options presents the user with an Approver Authentication window, which requests the user’s credentials again.

Installed with approval with e-signature

Installing approval with e-signature installs certain properties.

- Module - E-Signature Registry
- UI Action - Approve (on table sysapproval_approver, with no action name)
- UI Action - Approve (on table sysapproval_approver, with no action name)
- UI Action - Approve (on table sysapproval_approver, with the action name authenticated_list_approval)
- UI Page - form_login_validate_dialog
- UI Page - login_validate_dialog
- UI page: saml2_esignature_login, the re-authentication page that appears when an approver tries to approve a request.
- Properties: see E-signature SAML properties
- Client Script - Authenticate Approver
- Script Include - User
Installing the plugin also disables the two out-of-the-box Approve UI Actions on the `sysapproval_approver` table.

**Select an approval table**

By default, activating the Approval with E-signature plugin enables e-signature for all tables for which a previous approval exists.

**About this task**

E-signature approvals can also be enabled on a table-by-table basis. To enable e-signatures for a table:

**Procedure**

1. Navigate to **System Definition > E-Signature Registry**.
2. In **Table name**, use the drop-down list to select a specific table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>A table drop-down to select the table that requires e-signatures.</td>
</tr>
<tr>
<td>Enabled</td>
<td>If selected, e-signature is required. Clear this option to remove the e-signature requirement.</td>
</tr>
</tbody>
</table>

**Related reference**

- Approval with e-signature
- Set up e-signature approvals
- De-activate e-signatures
- Installed with approval with e-signature

**Related information**

- Set up an approval from a local database

**Set up an approval from a local database**

Enable users to authorize e-signature approvals using local database credentials.
Procedure
1. Activate the Approval with e-signatures plugin.
2. Create user records for approval users.

Related reference
- Approval with e-signature
- Set up e-signature approvals
- De-activate e-signatures
- Installed with approval with e-signature

Related information
- Select an approval table

Use Multi-Provider SSO to set up an SSO approval for a SAML 2.0 authentication
An SSO approval with e-signature requires configuration on the SAML IdP and the ServiceNow instance.

About this task
The SAML IdP must support and honor the forceAuthn attribute in SAML assertion requests. E-signature does not function without this IdP setting. Set up an approval with e-signature using credentials from a SAML 2.0 authentication.

Procedure
1. Activate or upgrade to SAML 2.0 with the Integration - Multiple Provider Single Sign-On Installer plugin.
2. Activate the Approval with E-Signature plugin.
3. Navigate to Multi-Provider SSO > Identity Providers and verify your 2.0 SAML IdP configuration Advanced tab shows the Force AuthnRequest attribute checked.
   Your SAML 2.0 IdP must support the Force AuthnRequest attribute, or e-signature is not supported.
4. On the eSignature Approval tab, enter the following e-signature SAML properties:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assertion Consumer URL for eSignature auth</td>
<td>This property defaults to the appropriate URL. To configure this property,</td>
</tr>
<tr>
<td></td>
<td>click the lock icon to make this field</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Assertion Consumer Index for eSignature authentication</strong></td>
<td>If your Service Provider has more than one URL set for the AssertionConsumerURL, you can set the index to use for eSignature, starting with index 1 or more.</td>
</tr>
<tr>
<td><strong>AuthnRequest URL for eSignature Authentication</strong></td>
<td>You can enter the URL that points to the SAML 2.0 IdP AuthnRequest URL for eSignature authentication. If the URL is the same as the Assertion Consumer URL, you can leave this setting blank.</td>
</tr>
<tr>
<td><strong>Authentication Pop-up Dialog Width</strong></td>
<td>When a user approves a request using eSignature, a dialog opens and a user can enter credentials. This setting controls the width of that dialog box. The default is 500.</td>
</tr>
<tr>
<td><strong>Authentication Pop-up Dialog Height</strong></td>
<td>When a user approves a request using eSignature, a dialog opens and a user can enter credentials. This setting controls the height of that dialog box. The default is 300.</td>
</tr>
</tbody>
</table>

---

The table and diagram above illustrate the options and their descriptions in the context of eSignature authentication settings.
5. Click the **Generate Metadata** button underneath the tabs to regenerate the service provider metadata. Copy this data and update it on the SAML IdP.

**Set up e-signature approvals**

The setup required depends on where user credentials are stored.

See the section that matches the source of your user credentials:

- Setting up approvals from a local database
- E-signature SAML properties

⚠️ **Note:** ADFS 2.0 does not support re-authentication requests that E-Signature requires.

**Related reference**

- Approval with e-signature
- De-activate e-signatures
- Installed with approval with e-signature

**Related information**

- Set up an approval from a local database
- Select an approval table
- Active Approval with e-Signature plugin

**Approval status**

The approval status of a change request is determined by looking at the current status of all the approvers.

If any approver has rejected the change, the approval status will be Rejected. If all approvers have approved the change, the approval status will be Approved. If all approvers are in the Not Requested status or if there are no approvers, the change status will be Not Requested, otherwise the status will be Requested.

For added flexibility when creating approvals, including the ability to set up an "one of" approval where only one person of a group of approvers needs to approve, consider using **Workflows**.

**Related reference**

- Approvals
Generate an approval using approval rules

The system can automatically generate an approval request to individuals or groups when specific criteria are met. The automatic generation of approval requests is driven using the System Policy feature.

In the sample below, a change opened in the category **network** is assigned to the System Administrator:

![Approval Rules](image)

When an approver is automatically added based on approval rules, the status of the approval automatically defaults to "Requested".

**Related reference**

Approvals

Generate approvals using the approvers related list

It is possible to manually add approvers to a request.

Additional approvers can be added by clicking the **Edit** button in the Approvers section near the bottom of a request. When an approver is added manually, the status for that approver defaults to **Not Yet Requested**. When the status of the approver changes to **Requested**, the approver is sent an email requesting approval action.

**Related reference**

Approvals

Generate approvals using workflows

Workflows are a powerful and flexible method of generating approvals. Use workflows to create group approvals and user approvals.

A variety of variables are available to fine-tune the approval process, including the actions that occur when approval or rejection take place. When a workflow...
activity generates an approval record, the system populates the **Workflow activity** field on the approval record with a reference to the activity. Do not use this field when creating business logic. For more information, see [Approval and Rollback Activities](#).

**Note:** Conflicts can arise when the approval process for a table is managed by both the workflow engine and the approval engine. In general, if there is a workflow that manages the approval process for a table, the **approval engine** should be turned off for that table.

**Related reference**

Approvals

**Multiple approvers**

With multiple approvers, all approvers must authorize the request before the status will change to "Approved".

Should any approver reject the request, the status will immediately be set to "Rejected".

**Related reference**

Approvals

**Receive notifications**

Individuals who are designated approvers automatically receive approval notifications, including approval status updates.

Approval notifications will be sent at the following times:

- When an individual is assigned as an approver either automatically or manually. If a group is chosen, then all members of the group will be sent an email. By default, the email an approver receives will contain a "mailto" link that will allow the approver to either approve or reject the request directly from their email system.
- When the request reaches approved status, the person assigned to the request will receive an email indicating it has been approved.

The details contained in the emails and the points at which they are sent can be tailored using [System Definition > Business Rules and System Policy](#).

**Note for Blackberry users:** In order to see the "mailto" links mentioned above to approve or reject a request (i.e. 'Click here to approve CHG55555' or 'Click here to reject CHG55555'), your Blackberry device must be using version 4.5 of
their software which supports HTML emails. If your Blackberry device is using an earlier version, you will not be able to view or use the “mailto” links. However, as a workaround, users can reply to the email and add the statements `state:approved` or `state:rejected` within the body of the email before sending it to force the automatic approval/rejection functionality.

If you create an appropriate Inbound Email Action, you can let approvers respond to approval email notifications with a simple “yes” or “no” answer.

**Embed an approval request within the Outlook email client**

Embed an interactive approval request for service catalog requests in the email notification sent to a user. The user can accept or reject the approval request from the email client.

**Before you begin**

Role required: admin  
The Outlook Actionable Messages plugin (com.sn_ms_oam) should be activated.

**Note:**

- The Outlook Actionable Messages (OAM) feature is not supported in all Microsoft mail products and versions. To verify whether your version of Outlook supports OAM, refer to the Microsoft documentation.
- Actionable messages are supported only for emails sent from the @service-now.com email address. If you are sending an email from a customized email address, you should register as a new service in the Microsoft website setting the scope as Organization. Specify the provider ID value in the `sn_ms_oam.outlookactionable.originator` property.
- Actionable messages are based on the Sender Policy Framework (SPF)/DomainKeys Identified Mail (DKIM) validation for the email sender verification. If an email recipient receives email via an external provider, emails may not be rendered as adaptive cards.
- You cannot customize the default actionable message templates.

**Procedure**

1. Navigate to **System Notification > Email > Notifications**.

2. For the approval notification that requires user approval, in the **What it will contain** tab, add the following script in the **Message** field in addition to the existing information, or to the **Message** field in the configured email template if applicable.

```
${mail_script:include_approval_actionable}
```
For example, for the Catalog Approval Request and Approval Request notifications, you can include the script in `request.itil.approve.role` and `change.itil.approve.role` email templates.

This script includes the Outlook actionable message in the email notification sent to the user for approvals.

3. Click **Update**.

**Dynamic approval forms**

When you are looking at an approval request, the form has a context-appropriate summary of the item to be approved.

For example, if you're looking at a Change Management approval request, you'll see details from the relevant change request. For a Service Catalog approval request, you'll get details of the request.

*Change request approval example*

![Change request approval example](image)

*Rollback Oracle Version*

Performance of the Siebel SFA software has been severely degraded since the upgrade performed this weekend. We moved to an unsupported Oracle DB version. Need to rollback the Oracle instance to a supported version.

*Update*  *Approve*  *Reject*  *Delete*
Scripts and engines execution order

Scripts, assignment rules, business rules, workflows, escalations, and engines all take effect in relation to a database operation, such as insert or update. In many cases, the order of these events is important.

**Note:** Client-based code that executes in the browser, using Ajax or running as JavaScript, will always execute before the form submission to the server.

The order of execution is as follows:

1. **Before** business rules: Scripts configured to execute before the database operation with an order less than 1000.

2. **Before** engines. The following are not executed in any specific order:
   - Approval engine (for task and sys_approval_approver tables)
   - Assignment rules engine (for task tables)
   - Data policy engine
   - Escalation engine
   - Field normalization engine
   - Role engine - keeps role changes in sync with sys_user_has_role table (for sys_user, sys_user_group, sys_user_grmember, and sys_user_role tables)
   - Execution plan engine (for task tables)
   - Update version engine - creates version entry when sys_update_xml entry is written (for sys_update_xml table)
   - Workflow engine (for default workflows)
3. **Before business rules:** Scripts configured to execute before the database operation with an order greater than or equal to 1000.

4. **The database operation (insert, update, delete).**

5. **After business rules:** Scripts configured to execute after the database operation with an order less than 1000.

6. **After engines.** The following are not executed in any specific order:
   - Label engine
   - Listener engine
   - Table notifications engine
   - Role engine - keeps role changes in sync with sys_user_has_role table (for sys_user, sys_user_group, sys_user_grmember and sys_user_role tables)
   - Text indexing engine
   - Update sync engine
   - Data lookup engine inserts or updates
   - Workflow engine (for deferred workflows)
   - Trigger engine (for all Flow Designer flows)

7. **Email notifications.** The following are executed based on the weight of the notification record:
   - Notifications sent on an insert, update, or delete
   - Event-based notifications

8. **After business rules.** Scripts configured to execute after the database operation with an order greater than or equal to 1000.

**Fulfiller experience in ServiceNow Agent**

Approve catalog requests, requested items, or change requests from anywhere using the ITSM ServiceNow Agent application.

As an ITSM agent or technician, you can use the mobile app when connected online to accomplish the following:

- Accept or reject the pending approval requests.
- View the completed approval requests.
Note:

- The request experience is not available in this mobile app.
- On-load catalog UI policies (non-scripted) are supported for variables in record views, for example, requested item and incident.
  - Only the visibility condition is considered.
  - A variable with no value is not displayed.
  - These policies are also applicable for container variables and a group of check boxes.
  - Since the multi-row variable set is displayed with a message that it is not viewable, these policies can be used to display or hide that message.

Watch this three-minute video to learn how to manage approval requests in the mobile app. This video covers: Accessing the Approvals mobile app and viewing and approving or rejecting requests.

**Activation information**

This mobile application runs on the ServiceNow® mobile platform. You should activate the ITSM Mobile Experience (com.sn_itsm_mobile) plugin that enables the ITSM mobile application.

**Get started with the mobile app for Approvals**

Access the My Approvals application instance on your mobile app to manage approval requests using your mobile device.

**Before you begin**

Role required: business_stakeholder or approver_user

**About this task**

Download the ServiceNow® mobile application on an iOS platform from the Apple App Store or on an Android platform from the Google Play Store.

**Procedure**

1. Open the mobile app and tap the plus icon ().[1]
2. Add a ServiceNow instance. For more information on adding the instance, refer to **Add a ServiceNow instance**.[2]
3. Tap **My Approvals** to start managing your requests.
Related information

Agent mobile app

Manage a catalog request approval
Manage your assigned catalog request or requested item by approving or rejecting it from anywhere using your mobile device.

Before you begin
Role required: business_stakeholder or approver_user

Procedure
1. Tap **My Approvals** on your mobile app.
2. To approve or reject a pending approval request, perform the following steps.
   a. Tap the Pending Approvals applet.
      All approvals in the Requested state are displayed.
   b. Swipe a request and tap **Approve** or **Reject**.
      Note: You should specify the reason while rejecting a request.
   c. Optional: To view the details of a pending approval request, tap it.

3. To view a completed approval request, perform the following steps.
   a. Tap the Completed Approvals applet.
      All approval requests that are either accepted or rejected are displayed.
   b. To view the details of the request, tap it.

State flows
State flows enable an administrator to customize transitions from one state to another in tables derived from the Task [task] table and configure the system to perform work during transitions to specific states.

An example of a state transition is when the **State** field in an incident changes from **Active** to **Awaiting User Info**. An administrator might want to trigger an...
event during this transition or make a specific field mandatory when the incident reaches the end state.

State transitions in the Field Service Management application were reimplemented to use state flows. For information about customizing Field Service Management state flows, see State Flow Customization.

Installed with state flows

Several types of components are installed with state flows.

### Tables installed with state flows

Tables are added with state flows.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State Flow [sf_state_flow]</td>
<td>Contains state flow definitions. This table contains all state flow definitions, including those for work orders and work order tasks.</td>
</tr>
<tr>
<td>Work Order Flow [sf_work_order]</td>
<td>Contains state flow definitions for work orders. This table is installed when Field Service Management is activated.</td>
</tr>
<tr>
<td>Work Task Flow [sf_work_task]</td>
<td>Contains state flow definitions for work order tasks. This table is installed when Field Service Management is activated.</td>
</tr>
</tbody>
</table>

### Business rules installed with state flows

Business rules are added with state flows.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assert Field Uniqueness in State Flow</td>
<td>State Flow [sf_state_flow]</td>
<td>Ensures that business rules and UI actions are not accidentally copied to new state flows.</td>
</tr>
<tr>
<td>Check Client Script</td>
<td>State Flow [sf_state_flow]</td>
<td>Adds a client script to new records.</td>
</tr>
<tr>
<td>Check Event Rule</td>
<td>State Flow [sf_state_flow]</td>
<td>Adds or deletes event rules, as the event field is updated.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Check Work Notes Rule</td>
<td>State Flow [sf_state_flow]</td>
<td>Adds or deletes work note rules, as the work notes for a state flow are updated.</td>
</tr>
<tr>
<td>Create Business Rule</td>
<td>State Flow [sf_state_flow]</td>
<td>Automatically creates a business rule when automatic conditions or script are present.</td>
</tr>
<tr>
<td>Create script for Field controls</td>
<td>State Flow [sf_state_flow]</td>
<td>Create scripts for field controls, when they are in use.</td>
</tr>
<tr>
<td>Create UI Action</td>
<td>State Flow [sf_state_flow]</td>
<td>Automatically creates a UI action when manual conditions or script are filled in.</td>
</tr>
<tr>
<td>Delete Related Elements</td>
<td>State Flow [sf_state_flow]</td>
<td>When state flows are deleted, delete all related client scripts, business rules, UI actions and overrides.</td>
</tr>
<tr>
<td>Remove script for Field controls</td>
<td>State Flow [sf_state_flow]</td>
<td>If all field controls are disabled, see if any of the client scripts should be removed.</td>
</tr>
<tr>
<td>State Change</td>
<td>State Flow [sf_state_flow]</td>
<td>Get the correct state choice value when the state is changed.</td>
</tr>
<tr>
<td>Update dependent records</td>
<td>State Flow [sf_state_flow]</td>
<td>When a state flow is made active or inactive, ensure the business rule and UI actions are made active or inactive as well.</td>
</tr>
</tbody>
</table>

**Script includes installed with state flows**

Script includes are added with state flows.

**Script includes for state flows**

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>StateFlow</td>
<td>Implements state flows and supports creation of state flow elements, such as business rules, UI actions, dictionary overrides, and client scripts.</td>
</tr>
<tr>
<td>StateFlowAJAX</td>
<td>Allows access to state flow functionality from client scripts.</td>
</tr>
</tbody>
</table>
Use state flows

You can create custom state flows for any table that uses states.

Make state transitions occur in any order or skip specific states according to your business practices. State flows can manage the behavior of fields and field visibility on a task form. State flows can also trigger system events that perform work such as sending email notifications.

Administrators can configure state flows to:

• Limit the choice list for the State field to contain only those states that are valid for the flow.

• Define the behavior and visibility of specific fields on a task form when state transitions occur and for certain end states.

• Configure events that are triggered when a task changes states.

• Set up UI actions and business rules to implement certain state transitions, or while the task is in certain states.

The State Flow plugin installs records used by work management to control state transitions for work orders and work order tasks. For detailed information about using work management state flows, see State flow customization.

Creating and customizing state flows requires scripting knowledge. Users with the admin role can create state flow records.

Dictionary overrides for state flows

A dictionary override in a state flow defines the starting state for all new records in a specific table.

You set an override in tables that extend a base table only, so that your customizations are applied only to the extended table.

1. In a state flow record, select an Ending state.

   This is the override value which becomes the starting state for all new records in the table named.

2. Click Create Default Value.

   The system populates the Dictionary override field with a value of state, which is the field in the task table affected by the override. The Dictionary override field is read-only. After the override is created, the system hides the Create Default Value button on all subsequent state flow forms for that table.

Events triggered on state changes

You can configure a state flow to trigger a registered system event when a task transitions from a starting state to a specified end state.
For example, you can use events to trigger email notifications and create script actions. When you attach an event to a state flow, the system creates a business rule called State Flow Events for <table name> for the table specified in the state flow. If you specify a start and end state, the business rule executes when the record transitions from the start state to the end state. If the state flow only specifies an end state, the business rule executes whenever that end state is reached. The system creates one business rule for all state flows containing events on a single table. When all events or all state flows on a table are deleted, the system deletes the business rule.

Field controls

You can define controls for individual fields that are enforced when a record transitions between states.

Settings in the Field Controls section of the State Flow form enable you to apply field controls when the system detects a specified state transition or when the end state is the current state when the form is opened. The control is applied only to existing fields on the form. State flows cannot add fields to the form.

For example, you might want the Problem field to be visible when an incident moves to the Awaiting Problem state. If the incident state changes to Awaiting User Info, you hide the Problem field and make the Caller field mandatory.

When creating field controls, configure state flow records with an ending state only and to create the correct behavior for every ending state you want to control. This configuration ensures that the field controls are set properly when the user selects a new state, and also when the user returns a record's State field to the original state. Only specify a full state transition, with both a starting and ending state, when you want a particular behavior for that precise state transition.

Note: State flows use client scripts to enforce field controls. It is possible that your settings can be changed by existing UI policies, which execute after client scripts.

The system creates the following objects, as needed, to enforce field properties in state flows:

<table>
<thead>
<tr>
<th>Field Controls</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Business rule</td>
</tr>
</tbody>
</table>
Field Controls (continued)

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client script (onLoad)</td>
<td><code>&lt;table name&gt;</code> state flow</td>
<td>Sets possible states and initial mandatory, read-only, and visible properties when a record is loaded.</td>
</tr>
<tr>
<td>Client script (onChange)</td>
<td><code>&lt;table name&gt;</code> change state flow</td>
<td>Sets updated mandatory, read-only, and visible properties when a record is changed.</td>
</tr>
</tbody>
</table>

**Rebuild state flows**

You can rebuild state flows when a mismatch between existing and new sys_ids occurs.

When you use an XML file to import a state flow record into an instance, the system attempts to match the incoming states with existing states by comparing sys_ids. Because the sys_ids of items in a choice list can vary between instances, the system can fail to match the states, even though they are otherwise identical.

When matching fails, the start and end states of affected records are left blank or contain numeric values. To repair these records navigate to *State Flows > Admin > Rebuild State Flows*. This module runs a script that compares the numerical value of each item in the *State* field choice list until it finds a match in the imported state flow record.

**State flow cleanup**

**Work notes**

**Related information**

- Use state flows
- Create a state flow

**Create a state flow**

Creating State Flows.

**Procedure**

1. Navigate to *State Flows > State Flows* and click *New*.
2. Fill in the fields, as appropriate.
The system enforces the field controls with the same client script that filters the choice list for the State field.

### Creating state flows

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated record number</td>
</tr>
<tr>
<td>Table</td>
<td>[Required] Table on which the state flow record runs. Only tables that extend the Task [task] table are available in the list.</td>
</tr>
<tr>
<td>Starting state</td>
<td>Name of the state at the beginning of the transition. The selections in this field are filtered by the possible states for the table selected.</td>
</tr>
<tr>
<td>Ending state</td>
<td>Name of the state at the end of the transition. The selections in this field are filtered by the possible states for the table selected.</td>
</tr>
<tr>
<td>Client script</td>
<td>Client script to run for this transition. The client script controls the available states you can select by limiting the contents of the State choice list to valid states. This client script also controls specific field behavior configured for state changes in the Field Controls section of the form.</td>
</tr>
<tr>
<td>Event</td>
<td>Name of an existing event to trigger when this transition occurs. See <code>events triggered on state changes</code> for more information.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of this record. Make sure the name is descriptive of the state transition or the processing that the record is performing. This name does not have to be unique.</td>
</tr>
<tr>
<td>Roles</td>
<td>Not used for any processing.</td>
</tr>
<tr>
<td>Active</td>
<td>Enables or disables this state flow record.</td>
</tr>
<tr>
<td>Class</td>
<td>Defines the state flow class for this record. The system selects the appropriate class from these options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>State Flow</strong>: Records created for state flows in all task-based tables except those in work management.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Work Order Flow</strong>: Records created for state flows in the Work Order [wm_order] table. This class is available when work management is activated.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Work Task Flow</strong>: Records created for state flows in the Work Order Task [wm_task] table. This class is available when work management is activated.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dictionary override</td>
<td>Sets the starting value for the State field on all new records for the table named in the state flow record. See dictionary overrides for configuration procedures.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Noteworthy comments about this state flow transition. For details about how these notes are used, see Work Notes.</td>
</tr>
<tr>
<td>Comment</td>
<td>Details about the customized record.</td>
</tr>
<tr>
<td>Manual (Runs scripts from a UI action that require the user to click a button or related link.)</td>
<td></td>
</tr>
<tr>
<td>Manual condition string</td>
<td>Conditions for enabling a UI action that cannot be defined with the condition builder. For example, you can use this string to define UI actions for mobile devices. This condition has an [and] relationship with the condition in the Manual condition field.</td>
</tr>
<tr>
<td>Manual condition</td>
<td>Conditions for enabling a UI action that can be defined for fields in the target table. This condition has an [and] relationship with the condition in the Manual condition string field.</td>
</tr>
<tr>
<td>Manual script</td>
<td>Script that defines what the UI action does when the conditions are true. This script runs when the user clicks a button or a related link.</td>
</tr>
<tr>
<td>UI action</td>
<td>[Read Only] Name of the button that the system creates to enable this transition. The system creates the label using the same name as the state flow record that created it.</td>
</tr>
<tr>
<td>Automatic (Runs a business rule automatically when a task record is changed and updated.)</td>
<td></td>
</tr>
<tr>
<td>Automatic condition string</td>
<td>Conditions for running the business rule that cannot be defined with the condition builder, such as evaluating if the proposed transition is a valid flow. This condition has an [and] relationship with the condition in the Automatic condition field.</td>
</tr>
<tr>
<td>Automatic condition</td>
<td>Conditions for running the business rule that can be defined for fields in the target table. This condition has an [and] relationship with the condition in the Automatic condition string field.</td>
</tr>
<tr>
<td>Automatic script</td>
<td>Script that performs additional work when the condition is true. This script can do tasks such as update the date and time the transition occurred or notify someone using email when a specific state change occurs. Automatic state transitions occur when changes are made to the task record.</td>
</tr>
</tbody>
</table>
### Field Description

**Business rule**

Name of the business rule created for this transition. Two conditions must be satisfied before this business rule can run. The task must be on a specific starting state, and the Automatic condition must be true. If both of these conditions are satisfied, the business rule performs the transition requested, using the starting and ending states from the State Flow form.

### Field Controls (Determines field properties when a record transitions between states or reaches a specific end state.)

<table>
<thead>
<tr>
<th>Mandatory fields</th>
<th>Makes the selected fields required when this transition occurs, or when the end state is the current state.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read only fields</td>
<td>Prevents the selected fields from being edited when this transition occurs, or when the end state is the current state.</td>
</tr>
<tr>
<td>Visible fields</td>
<td>Displays the selected fields when this transition occurs, or when the end state is the current state.</td>
</tr>
<tr>
<td>Not mandatory</td>
<td>Makes the selected fields optional when this transition occurs, or when the end state is the current state.</td>
</tr>
<tr>
<td>Not read only</td>
<td>Makes the selected fields editable when this transition occurs, or when the end state is the current state.</td>
</tr>
<tr>
<td>Not visible</td>
<td>Hides the selected fields when this transition occurs, or when the end state is the current state.</td>
</tr>
</tbody>
</table>

### 3. Determine if you want the state transition method to be manual or automatic and open the appropriate section on the form.

- **Manual**: Click **Create UI Action** to create a button on the task form that enables users to execute the transition manually. The system uses the value in the Name field as the label for the UI action. The UI action executes the script in the Manual Script field when the conditions are true. For example, a manual transition can create an **Activate** button when an incident is in the New state that enables a user to mark the incident as active.

- **Automatic**: Click **Create Business Rule** to create the business rule. The business rule executes the script in the Automatic Script field when the conditions are true. For example, a business rule created by the system can set an incident state to **Assigned** when the Assigned to field is populated. Business rules are automatically deleted when the state flow record is deleted. For more information, see Business Rules.
4. **Optional:** Click **Create Client Script** to create the script that limits the values offered in a task record’s State field to valid states for that transition.

5. Configure the fields in the **Field Controls** section to control how specific fields display when a task record changes states.

**Related information**

Use state flows

**State flow cleanup**

The business rules, client scripts, and UI actions that the system creates automatically to perform custom transitions exist only while the state flow records that use them are present.

When all the state flows on a table are deleted, the system attempts to delete any unnecessary programming elements that were created on that table, using these criteria:

**State Flow Cleanup**

<table>
<thead>
<tr>
<th>Element</th>
<th>Deleted When</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI action</td>
<td>The state flow that created it is deleted.</td>
</tr>
<tr>
<td>Business rule</td>
<td>The state flow that created it is deleted.</td>
</tr>
<tr>
<td>Dictionary override</td>
<td>The state flow that created it is deleted.</td>
</tr>
<tr>
<td>Business rule that processes events triggered by a state flow</td>
<td>All state flows for the table specified that have events configured are deleted.</td>
</tr>
<tr>
<td>Client script (onLoad)</td>
<td>All state flows for the table are deleted.</td>
</tr>
<tr>
<td>Client script (onChange)</td>
<td>All state flows with field controls are deleted.</td>
</tr>
<tr>
<td>Work notes business rule</td>
<td>All state flows with field controls or work notes are deleted</td>
</tr>
</tbody>
</table>

**Related information**

Use state flows
Create a state flow
Work notes

Work notes are an important part of the state flow process and are used to communicate information about state transitions.

The state flow adds these work notes to the Work notes field of any task making this transition.

These rules apply to state flow work notes:

- For a state flow with no Starting state, the work note is added every time the task transitions to the Ending state.
- For a state flow with a Starting state and an Ending state, the work note is added only when the task transitions from that starting state to that ending state.
- If two state flows with work notes have the same Ending state, but only one has a Starting state, the system adds the work notes from the state flow with the starting state. This better matches the state flow work note to the more important transition between specific starting and ending states.

Related information

Use state flows
Create a state flow

Domain separation and State Flows

Domain separation is unsupported in State Flows. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: No support

- The domain field may exist on data tables but there is no business logic to manage the data.
- This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation.

Overview

Domain separation provides complete data isolation for domain-specific users.

Related information

Domain separation for service providers
Geolocation

The geolocation feature uses Google Maps to track users, plan efficient routes between locations, and assist in finding accurate travel times for applications that require this information, such as Work Management.

The system locates users from latitude and longitude information provided by their mobile devices or browsers. Tracking the location of certain users can improve business processes such as the completion of work order tasks. For example, in work management geolocation, the system updates an agent's position each time that agent updates a task record. When the system updates an agent's location frequently, agents and dispatchers can use features like auto-routing to create efficient schedules.

Geolocation features can be configured by users with the admin role.

Related reference

- Geolocation Google key
- Geolocation history
- Location tracking

Related information

- Activate geolocation

Activate geolocation

An administrator can activate the Geolocation plugin.

Before you begin

Role required: admin

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the Geolocation plugin (com.snc.geolocation) using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for \(<\text{plugin name}>\).

Related information
Geolocation

Installed with geolocation
Several component types are installed with Geolocation.

Modified by Geolocation
The Geolocation plugin adds a field called Geolocation tracked to the User [sys_user] table. This field allows the system to track individual users by their geographical coordinates.

Business rules installed with geolocation
Business rules are added with activation of Geolocation.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GeoLocation Data updated</td>
<td>User [sys_user]</td>
<td>Populates the Latitude and Longitude fields on the Geolocation History [geo_history] table when the Latitude and Longitude fields are updated on the User [sys_user] table.</td>
</tr>
</tbody>
</table>

Related reference
Installed with geolocation

Client scripts installed with geolocation
Client scripts are added with activation of Geolocation.
### Update Geolocation on Task

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Geolocation on Task</td>
<td>Task</td>
<td>Populates the <strong>Latitude</strong> and <strong>Longitude</strong> fields on a user record with GPS coordinates when that user loads any record on the Task table or a table that extends Task. This occurs only when geolocation tracking is enabled for the user.</td>
</tr>
</tbody>
</table>

### Related reference

- **Installed with geolocation**

### Properties installed with geolocation

Geolocation provides the following configurable properties in **Geolocation > Administration > Geolocation Properties**.

The Google Maps plugin provides additional map properties that are used to implement and control specific geolocation features. You must have a private key for Google Maps API for Business to take advantage of the properties listed here.

#### Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.geolocation.allow.toll.roads</td>
<td>Allow toll roads to be used. Allows the system to use toll roads when auto-routing or optimizing task routes for agents.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: True/false</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: True</td>
</tr>
<tr>
<td>glide.geolocation.default.start.time</td>
<td>Default start time for all agents when no schedule is set. This value sets the start time for a day other than the current day, when no scheduled task exists or is continued from the previous day. This property uses a 24 hour clock.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: String</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 08:00</td>
</tr>
<tr>
<td>glide.geolocation.evening.rush.hours</td>
<td>Evening rush hour span, formatted as 14:30-16:00. All times are expressed in 24-hour format.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>glide.geolocation.history.cleanup</td>
<td>Number of days to keep history data. ServiceNow keeps agent geolocation history records for the number of days specified by this value.</td>
</tr>
<tr>
<td>glide.geolocation.morning.rush.hours</td>
<td>Morning rush hour span, formatted as 06:30-08:00. This property uses a 24 hour clock. All times are expressed as a range, separated by a dash with no spaces. Times not using this format are ignored. This property must be used with the work.management.evening.rush.hours and work.management.rush.travel.buffer properties.</td>
</tr>
</tbody>
</table>
| glide.geolocation.proximity | Minimum distance an agent must move to be considered in a new location (in meters). This setting establishes a geolocation perimeter that prevents ServiceNow from creating unnecessary history records when an agent has multiple tasks in the same vicinity. An
Properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| example of this might be when an agent has several tasks in one building. The system assumes that all task activity within the specified radius is part of a single record and does not create additional records when the agent moves from task to task around the building. **Type:** Integer  
**Default value:** 500  
**Note:** The iOS version of the app updates geolocation only when the mobile device detects a significant location change, which is determined by the your device's operating system. When the operating system updates it's location, your app updates with that location change. Distance and time property values are not honored for the iOS version of ServiceNow apps. |
| glide.geolocation.proximity.location | Maximum distance an agent can be from a specific location and still be placed at that location (in meters). This setting defines the maximum distance that an agent can be from a specified location and still be placed at that location by the system. **Type:** Integer  
**Default value:** 200 |
| glide.geolocation.rush.travel.buffer | Percentage to add to all rush hour travel times. The system uses this percentage to calculate schedules when auto-routing an agent. Use this property when both morning and |
### Properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>evening rush hour times are defined.</strong></td>
<td>An example of a valid time buffer percentage is 15.</td>
</tr>
<tr>
<td><strong>Type</strong>: Integer</td>
<td></td>
</tr>
<tr>
<td><strong>Default value</strong>: 0</td>
<td></td>
</tr>
<tr>
<td>glide.geolocation.tracking.frequency</td>
<td>Sets the length of the recurring interval, in seconds, that the system waits between attempts to update a user's geographic coordinates. The system updates geographic coordinates only for users who have geolocation tracking enabled. Minimum amount of time between updating the user's location (in seconds). This setting defines how long the system waits before updating an agent's location, regardless of task activity or travel. This prevents ServiceNow from creating unnecessary history records if an agent in one location views a task multiple times.</td>
</tr>
<tr>
<td><strong>Type</strong>: Integer</td>
<td></td>
</tr>
<tr>
<td><strong>Default value</strong>: 300</td>
<td></td>
</tr>
</tbody>
</table>

**Note**: The Android version of the app updates geolocation data at 15 minute intervals. The app collects a user's location using the interval set in this property, but that data is still uploaded to your instance every 15 minutes.
Properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> The iOS version of the app updates</td>
<td>The iOS version of the app updates geolocation only when the mobile device detects a significant location change, which is determined by the your device's operating system. When the operating system updates it's location, your app updates with that location change. Distance and time property values are not honored for the iOS version of ServiceNow apps.</td>
</tr>
<tr>
<td>glide.geolocation.travel.buffer</td>
<td>Percentage to add to all travel times. An example of a valid percentage value is 15.</td>
</tr>
<tr>
<td>• <strong>Type:</strong> Integer</td>
<td></td>
</tr>
<tr>
<td>• <strong>Default value:</strong> 0</td>
<td></td>
</tr>
<tr>
<td>glide.geolocation.work.spacing</td>
<td>Amount of time (in minutes) to add between the end of a task and the travel start of the next. An example of a valid time value is 10.</td>
</tr>
<tr>
<td>• <strong>Type:</strong> Integer</td>
<td></td>
</tr>
<tr>
<td>• <strong>Default value:</strong> 0</td>
<td></td>
</tr>
</tbody>
</table>

Script includes installed with geolocation

Script includes are added with activation of Geolocation.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GeolocationAJAX</td>
<td>Utilities the system uses when making geolocation AJAX calls.</td>
</tr>
<tr>
<td>GeolocationUtils</td>
<td>Core utilities for geolocation functionality.</td>
</tr>
</tbody>
</table>

Related reference

Installed with geolocation
Geolocation Google key

Geolocation functions in the Now Platform® require a Google Maps API for Business license, or a Google Maps Javascript API Key, to enable use of Google Maps.

The auto-routing or auto-dispatch functions in Field Service Management require this license or Javascript API Key to calculate precise travel time estimates. Without these values, precise driving times cannot be calculated, and it uses rough estimates or fixed times instead.

In System Properties > Google Maps, enable the Geolocation feature using the appropriate entries from a Google Maps API for Business license, or a Google Maps Javascript API Key. To learn more, see Set up Google Maps API.

Related information

Geolocation

Geolocation history

The Geolocation History [geo_history] table contains the history of each tracked user's location over time.

To view geolocation history, navigate to Geolocation > Geolocation History. The record list shows time stamped location data for all users configured for geolocation tracking.

The following system properties, located in Geolocation > Administration > Geolocation Properties, control the data that appears in this table.

• Minimum distance an agent must move to be considered in a new location (in meters): Perimeter that defines a single location in which multiple tasks are present. This property prevents the system from creating unnecessary history records when multiple tasks are in the same general location.

• Maximum distance an agent can be from a specific location and still be placed at that location (in meters): Distance that a user can be from a specified location and still be placed at that location when the system creates history data.

• Number of days to keep history data: Time period for which the system retains history data.

• Minimum amount of time between updating the user's location (in seconds): Time period the system waits before updating a user's location, regardless of how often the user accesses tasks.
Location tracking

Geolocation adds the **Geolocation tracked** field to the User form. In the default view of a user record, select the **Geolocation tracked** check box to enable location tracking for the user.

When a user has geolocation tracking enabled, the system updates the user’s geographic coordinates whenever the user opens, or loads, a record from the Task [task] table or from a table that extends Task. After this initial update, the system continues to update the user’s geographic coordinates at a recurring interval if the user does not close or reload the record. To edit the length of this interval, navigate to **Geolocation > Administration > Geolocation Properties** and change the setting for the property that regulates the update interval for the user’s location. The default setting for this property is 300 seconds (5 minutes).

![Note:](image)

The system can update geographic coordinates only for users who have location services enabled in their browsers. Even users who have the **Geolocation tracked** check box selected may be prompted by their browsers to share or withhold their location.

Related information

Geolocation

Survey Management

With the ServiceNow® Survey Management application you can create, send, and collect responses for basic surveys. If installed, you can also use the Survey widget to set up a survey within Service Portal.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Upgrade to Rome</td>
<td>• Survey Management roles</td>
<td>• Survey designer</td>
</tr>
<tr>
<td>• Get started with Survey Management</td>
<td></td>
<td>• Survey users and groups</td>
</tr>
<tr>
<td>• Key survey terms</td>
<td></td>
<td>• Customize the appearance of a survey</td>
</tr>
<tr>
<td>• Domain separation and Survey Management</td>
<td></td>
<td>• Survey definitions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Survey trigger conditions</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Migrate</th>
</tr>
</thead>
<tbody>
<tr>
<td>• View the results for a survey</td>
<td>• Developer training</td>
<td>• Legacy survey migration</td>
</tr>
<tr>
<td>• View results for all surveys</td>
<td>• Developer documentation</td>
<td></td>
</tr>
<tr>
<td>• Metric result fields</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Get started with Survey Management

Two versions of the application are supported. Survey Management, which is the latest version, and Legacy Surveys. Survey Management improves the user interface and extends the capabilities of the Legacy Surveys application.

The differences between assessments, surveys, and quizzes, and when to use each; also provides a quick look at the three stages in the survey process: designing, sharing, and evaluating.

Configuring surveys

There are many options for advanced configuration in Survey Management:

• Create a survey, add questions, and choose recipients, all in one interface.
• Create conditional questions, which appear only when users answer other questions a certain way.
• Restrict a survey so only specific survey users can take it, and send invitations to those users simultaneously. Alternatively, make the survey a public survey so that any user can take the survey, even anonymous users (users who have not logged in to the ServiceNow system).

Tip: The assessment_take2 UI page should be public for public surveys. If that page is not public, anonymous users do not have access to the page and public surveys do not work.

• Set a schedule to automatically assign a survey to users and to limit how often the same user can take a survey.
• Customize the look and feel of survey questionnaires.
• Save anonymous survey responses.
• Convert survey responses to numerical scores and view them on scorecards.
• Deactivate a survey for maintenance or to retire it without deleting it.

Note: Because surveys use the same tables and other back-end components as assessments, you may see assessment elements such as table and field names in certain places throughout the survey feature.

Legacy Surveys
Survey administrators can continue to use legacy survey functionality and data, however, it is recommended that you migrate legacy surveys to the Survey Management application. Concurrent use of both survey applications can cause confusion and redundancy.

Survey wizards are not impacted and cannot be migrated.

Note: The Legacy Surveys application is not described in the documentation that you are viewing. It is documented on the ServiceNow wiki.

Version comparison

<table>
<thead>
<tr>
<th>Capability</th>
<th>Surveys</th>
<th>Legacy Surveys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surveys in Service Portal.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save new survey responses each time a user takes the same survey.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create question templates to reuse sets of answer options.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Categorize survey questions and report on category results.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deactivate a survey without deleting it.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create conditional questions.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Send surveys automatically based on a schedule.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Customize survey questionnaire color scheme.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save anonymous survey responses for logged-in users.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>View survey responses on graphical scorecards.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save surveys in a draft state until they are ready to publish.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Version comparison (continued)

<table>
<thead>
<tr>
<th>Capability</th>
<th>Surveys</th>
<th>Legacy Surveys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and send surveys from one page.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow only specific users to access a survey.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Send surveys based on conditions.</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Send survey email notifications.</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Limit how often a user can take the same survey.</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Add introduction and end note text.</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Create survey modules.</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Public survey: Allow persons to take a survey without logging in.</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Use update sets to track changes.</td>
<td></td>
<td>✔️</td>
</tr>
</tbody>
</table>

**Related reference**

Survey Management roles

**Related information**

Legacy survey migration

Survey designer

Surveys in Service Portal

Service Portal

**Survey Management roles**

The Survey Management application uses the following roles.

No role is required to take assigned survey questionnaires.

**Survey Management roles**

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey administrator</td>
<td>Create and administer surveys. Survey administrators know what types</td>
<td>• survey_reader</td>
</tr>
<tr>
<td>[survey_admin]</td>
<td>of surveys are necessary, when to send a survey, and to whom. Survey</td>
<td>• assessment_admin</td>
</tr>
<tr>
<td></td>
<td>administrators can use all modules in the Survey application menu.</td>
<td></td>
</tr>
</tbody>
</table>
Survey Management roles (continued)

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey reader</td>
<td>View surveys and related information, such as survey responses, survey groups, scorecards, and reports.</td>
<td>none</td>
</tr>
<tr>
<td>survey_reader</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Key survey terms

These survey terms are used throughout the documentation to describe survey management functions and capabilities.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey definition</td>
<td>Root record on which a survey is built. A survey definition contains information such as the survey name, state, and distribution schedule. Each survey definition has its own categories and questions. Survey definitions are comparable to legacy survey masters.</td>
</tr>
<tr>
<td>Public survey</td>
<td>Any user can take a public survey, even users who have not logged in to the ServiceNow system. For a completed survey, the Assigned to field value is Guest.</td>
</tr>
<tr>
<td>Survey category</td>
<td>Represents a theme for survey questions. Categories contain one or more questions. The system creates one category per survey by default. Additional categories are optional.</td>
</tr>
<tr>
<td>Survey question</td>
<td>A question that appears on a survey questionnaire for the associated survey definition. Survey questions are comparable to legacy survey questions.</td>
</tr>
<tr>
<td>Survey user</td>
<td>User who is authorized to receive invitations for a restricted survey.</td>
</tr>
<tr>
<td>Survey instance</td>
<td>Represents one survey questionnaire assigned to one user. Survey instances are comparable to legacy survey instances.</td>
</tr>
<tr>
<td>Trigger condition</td>
<td>Defines a rule that enables the system to send a survey when an action occurs on a table, such as when an incident closes. Trigger conditions are comparable to legacy survey conditions.</td>
</tr>
</tbody>
</table>
Key survey terms (continued)

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecard</td>
<td>Visual representation of survey responses. Scorecards display a variety of data summaries for one survey definition.</td>
</tr>
</tbody>
</table>

Survey questionnaires

All surveys that are assigned to you appear in your personal assessment and survey queue.

No special role is required to complete a survey but you must be logged in and the survey must be assigned to you. When you submit a survey, the system stores your responses.

Survey notification

If the system is configured to send email, it sends you a notification when a survey is assigned to you. The message contains a link to the survey and instructions for viewing the assessment and survey queue.

Take a survey

Surveys that are assigned to you, and that are not complete, appear in your assessment and survey queue.

Before you begin

Role required: none

About this task

Each assessment or survey appears as a card in the queue. The card contains helpful information, including the survey name, state, and due date, and a button to launch the questionnaire. Overdue surveys are clearly marked with a red icon and red due date. You must answer every mandatory question, indicated by a red asterisk, before you can submit the survey. If you start to take a survey but cannot complete it, save your responses and return to it later. When you have answered all the questions and are satisfied with the responses, submit the survey.

Procedure

1. Navigate to **Self-Service > My Assessments & Surveys**.
   
   Users with the assessment_admin role, including survey administrators, can display other users’ assessments and surveys in addition to their own. Use the **Show all** and **Show assigned to me** related links at the bottom of the queue to
show and hide assessments and surveys. Click a card assigned to another user to open the associated metric type or survey definition.

2. Click **Take Survey** on a survey card to open the questionnaire. If there is more than one survey category, you can click the collapse or expand icon to hide or show the questions in the category.

3. Answer each question to the best of your ability. If you are unsure of how to respond to a question or if a question does not apply to a particular record, select **Not Applicable**, if available.

4. Complete one of the following steps.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save your responses without submitting them</strong></td>
<td>Click <strong>Save</strong>. You can close the questionnaire and access it later from your queue.</td>
</tr>
<tr>
<td><img src="https://example.com" alt="Note:" /> <strong>Note:</strong> The system does not save the survey if there are invalid responses, such as a letter in a date field. You must enter valid responses or remove invalid responses before you can save the survey.</td>
<td></td>
</tr>
<tr>
<td><strong>Submit the survey after answering all questions</strong></td>
<td>Click <strong>Submit</strong>. You cannot return to the questionnaire after submitting.</td>
</tr>
<tr>
<td><img src="https://example.com" alt="Note:" /> <strong>Note:</strong> If there is an unanswered mandatory question or an invalid response, an error message appears and the problematic questions are temporarily highlighted.</td>
<td></td>
</tr>
</tbody>
</table>

**Domain separation and Survey Management**

Domain separation is supported in Survey Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: Basic**
• Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.

• The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response. For more information on support levels, see Application support for domain separation.

Overview
As a survey creator, survey_admin can create surveys in the assigned domain. A Global domain survey_admin can create or edit survey in any domain.

As a survey taker, a user can access the survey record and take the survey based on the domain of the survey record and user. Global domain users can take a survey in any domain.

How domain separation works in Survey Management
There are several main areas to consider in how domain separation works in Survey Management.

Survey Management in domain-separated instances
The following domains are available by default after activating the Domain Support-Domain Extensions Installer [com.glide.domain.msp_extensions.installer] plugin. Only ServiceNow employees can activate this plugin.

• Global
• Acme
• Cisco

Access to surveys in domain-separated instances
Based on the domain of the survey record and users, users can access the survey record and take the survey.

Global domain users can access survey records in any domain. Users in any other domain can access records in their domain and Global domain. For example, users in the Acme domain can access records in the Acme domain and the Global domain.
Global domain users can take a survey in any domain. Users in any other domain can take surveys in their domain as well as the Global domain. For example, users in Acme domain can take surveys in the Acme domain and the Global domain.

<table>
<thead>
<tr>
<th>Location of the survey record</th>
<th>Users who can access and take the survey</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Global, Acme, Cisco</td>
</tr>
<tr>
<td>Global</td>
<td>Yes, Yes, Yes</td>
</tr>
<tr>
<td>Acme</td>
<td>Yes, Yes, No</td>
</tr>
<tr>
<td>Cisco</td>
<td>Yes, Yes, Yes</td>
</tr>
</tbody>
</table>

Any domain user can assign a survey in that domain to the same domain user or a Global domain user. For example, an Acme domain user can assign a survey to a Global domain user or an Acme domain user. Users from other domains are not visible to the Acme domain user.

Although the Global domain user can view a survey from other domains, this user cannot assign the survey of one domain to a user from a different domain. For example, a Global domain user can assign a survey from the Acme domain to another Global domain user or an Acme domain user, but not to a Cisco domain user.

Note: When a task is closed in a child domain and the assigned survey is either in the child domain or the global domain, the user from the child domain can then take the survey.

Trigger conditions in domain-separated instances

A Global domain user can create a triggered condition for a survey from any domain. The Global domain user can create an incident and trigger the survey by selecting a user from the other domain in the User field under Caller. However, the Global user cannot assign the survey to the user of different domain.

A user can assign a trigger condition to a survey if the user belongs to the Global domain or the Survey domain.

If there is no domain path for a trigger condition, users from any domain can view the trigger condition. For example, in the asmt_condition table that has no column for the domain path, users from the Acme domain can view the trigger condition created by the Cisco domain users.
Related information

Domain separation for service providers

Survey responses and results

There is a metric result record for each user response to each question on every survey instance. Survey results for each question and category are calculated automatically based on the metric result records.

If you use survey result calculations for results and scorecards, ensure that the positive indicator field for the question is set appropriately, based on the answer options. To have any results, a category must contain scored questions.

Survey responses

Survey responses are stored in the Metric Result [asmt_metric_result] table and display the recipients' answers to each question in a category. To view general results, navigate to Survey > Survey Responses. To view results for a particular criterion, use a filter on the Metric Result [asmt_metric_result] table. For example, to view results based on the assignment group, apply a filter condition for assignment group.

Survey metric results

Category results

Category results are stored in the Assessment Category Result [asmt_category_result] table and display the overall ratings for each category based on the weighted value for each scored question. To view these results, navigate to Assessments > Results > Category results and filter the results using the [Type.Evaluation method] [is] [Survey] condition.
Assessment category results

Survey scorecards
A scorecard provides a visual breakdown of survey responses, based on the way questions were answered, by category. To access a scorecard, see View a survey scorecard.

Related information
- View a survey scorecard
- Survey designer elements
- Configure category weights for a survey

View results for all surveys
You can view the survey responses that are stored on the Metric Result [asmt_metric_result] table.

Before you begin
Role required: survey_admin or survey_reader

Procedure
1. Navigate to Survey > Survey Responses.
   Do not confuse this module with Survey > Legacy Surveys > Survey Responses, which displays legacy survey responses.
   The Type column displays the survey definition each response is associated with.
2. Select a response to view its details.
View the results for a survey
You can view the responses for one survey definition. Survey results are stored on the Metric Result [asmt_metric_result] table.

Before you begin
Role required: survey_admin or survey_reader

Procedure
1. Navigate to Survey > View Surveys
2. Open a survey definition.
3. Under Related Links, click View Responses, which is available only if there are results. The results are grouped by metric, which is what questions are called in assessments.
4. Open a metric result to view more detail. The metric result contains the user’s response and calculated values of interest to advanced survey administrators. Because the Metric Result table is also used by the assessment feature, many field names are not clear in the context of surveys.

Example

Metric result fields
List of field descriptions for the Metric Result form.
## Metric Result form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment group</td>
<td>Assessment group to which the metric result belongs. An assessment group is a container for survey instances and results generated in a single occurrence. The system generates an assessment group every time at least one survey instance is created. If multiple survey instances are created at once, such as when a survey administrator sends invitations to a list of survey users, they are all stored in the same assessment group.</td>
</tr>
<tr>
<td>Metric</td>
<td>Question that the user answered.</td>
</tr>
<tr>
<td>Data type</td>
<td>Data type of the question the user answered.</td>
</tr>
<tr>
<td>Method</td>
<td>Assessment method. Always <strong>Assessment</strong> for surveys.</td>
</tr>
<tr>
<td>Updated</td>
<td>Date and time the metric result was last updated.</td>
</tr>
<tr>
<td>Source</td>
<td>Survey definition from which the associated survey instance was generated.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User who completed the survey questionnaire.</td>
</tr>
<tr>
<td>Instance</td>
<td>Survey instance completed by the <strong>Assigned to</strong> user.</td>
</tr>
<tr>
<td>Actual value</td>
<td>Value obtained from the user response to the question. The actual value is determined by the question data type:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Checkbox</strong>: The actual value is 0 if the check box is cleared and 1 if it is selected.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Choice</strong> or <strong>Likert Scale</strong>: The actual value is equal to the <strong>Value</strong> of the metric definition associated with the chosen answer option.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Date, Date/Time</strong>, or <strong>String</strong>: The actual value is -1 to indicate that these data types do not contribute to category result calculations.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Template</strong>: The actual value is equal to the <strong>Value</strong> of the template definition associated with the chosen answer option.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Yes/No</strong>: The actual value is 0 if the response is <strong>No</strong> and 1 if it is <strong>Yes</strong>.</td>
</tr>
<tr>
<td>Normalized value</td>
<td>Adjusted value that accounts for the <strong>Scale definition</strong> setting, minimum and maximum values, and other factors.</td>
</tr>
</tbody>
</table>
Metric Result form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The equation that generates the value and an example calculation appear in Normalized value for an assessment.</td>
</tr>
<tr>
<td>String value</td>
<td>Value that displays the response as it appears on a questionnaire. In some cases this is the same as the Actual value, such as when the question data type is Percentage. The string value is N/A for unanswered questions of certain data types.</td>
</tr>
</tbody>
</table>

Normalized value for an assessment

The normalized value is calculated based on a linear equation and the scale definition of the metric. This value can be used for risk assessment.

Normalized value for any metric

The normalized value is directly proportional to the scale definition of the metric. If the scale definition is low, that is, the lower scale values are better, then

Normalized value = 1.0 – Normalized value.

For reporting purpose, use the Metric Result [asmt_metric_result] table.

\[
\text{Normalized value} = \frac{\text{Input Value} - \text{Min value defined in metric}}{\text{Max value defined in metric} - \text{Min value defined in metric}} \times \frac{\text{current metric weight}}{\text{sum of valid metric weight in the metric category}} \times \text{scale_factor}
\]

**Note:**

- If a metric is skipped when taking the assessment, its weight is excluded when calculating \text{sum of valid metric weight in the metric category}.
- The following metric types are excluded in the normalized value calculation:
  - String
  - Date
  - Date/Time
  - Reference
  - Attachment
  - Ranking

For example, consider the following scenario.

Calculate the normalized value for the Please rate the competency of the technician metric.
### Values of the metric

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Input value</td>
<td>3</td>
</tr>
<tr>
<td>Minimum value</td>
<td>1</td>
</tr>
<tr>
<td>Maximum value</td>
<td>6</td>
</tr>
<tr>
<td>Current metric weight</td>
<td>10</td>
</tr>
<tr>
<td>Number of metrics in the metric category</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>• 4 of type=number</td>
</tr>
<tr>
<td></td>
<td>• 1 of type=yes/no</td>
</tr>
<tr>
<td></td>
<td>• 1 of type=string (invalid data type; value cannot be calculated)</td>
</tr>
<tr>
<td>Valid metric weight of each response</td>
<td>10</td>
</tr>
<tr>
<td>Scale factor</td>
<td>10</td>
</tr>
</tbody>
</table>

Normalized value = \( \frac{(3 - 1)}{(6 - 1)} \times \frac{(10)}{(10 + 10 + 10 + 10 + 10)} \times 10 = 0.8 \)

**Normalized value for a multiple selection metric**

The normalized value for a multiple selection metric is calculated by using the weight of the metric and the score for each choice of the metric.

In a multiple selection metric, for each choice that should be used for the normalization calculation, define the normalization input value.

Normalized value = (Score of all choices) \times \frac{(current metric weight)}{(sum of valid metric weight in the metric category)) \times scale_factor

Here, score of all choices of the metric is the sum of individual scores of each choice.

- Score of each choice in a multiple selection metric = Normalization input of the choice / max value of the metric
- Max value of the metric = Sum of the normalization input for all choices of the metric
- Min value of the metric is always 0

For example, consider the following scenario.

Calculate the normalized value for the multiple selection metric, **Please rate the competency of the technician**, with three choices, A, B, and C.
Values of the metric

<table>
<thead>
<tr>
<th>Choice</th>
<th>Normalization input is 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choice A</td>
<td></td>
</tr>
<tr>
<td>Choice B</td>
<td></td>
</tr>
<tr>
<td>Choice C</td>
<td></td>
</tr>
</tbody>
</table>

Minimum value 0

Maximum value 4

Current metric weight 10

Number of metrics in the metric category 5

Valid metric weight of each metric 10

Scale factor 10

If Choice A and B are selected, Normalized value = \(((1 / 4) + (1 / 4)) * (10 / (10 + 10 + 10 + 10 + 10)) \times 10 = 1

Weighted value for a risk assessment

For a risk assessment, the weighted value from metric results table is calculated as following.

\[
\text{weighted_value} = \text{metric.weight} \times \text{result.actual_value}
\]

View a survey scorecard

A survey scorecard provides a visual breakdown of survey responses by category, based on the way questions were answered.

Before you begin

Role required: survey_admin or survey_reader

About this task

A scorecard displays charts for survey results, in which category and question responses are analyzed and current ratings are compared with previous ratings. Users can examine ratings over time, compare question ratings, or compare the ratings of all categories. All ratings are averages for the time range selected. The system dynamically updates a scorecard each time you view it, so the ratings reflect recently completed surveys.
Procedure
1. Navigate to Survey > View Surveys.
2. Open a survey definition.
3. Under Related Links, click View Scorecard. The interactive scorecard displays the following filters:
   - Question Results: Displays the result of all questions or an individual question.
   - Category Results: Displays the results of all questions associated with an individual category or all categories.
   - Average Ratings: Displays the result of weighted average rating for each survey question in an individual category or all categories.
   - History: Displays the result of all questions in comparison with their history (by calendar year or quarters).
   - Sentiment Analysis Results: Displays the results of sentiment analysis for the survey.

   Note: The scorecard link is hidden if there are no survey results to report.

Survey scorecard category results
The Category Results view is a stacked bar chart showing survey results for all questions in an individual category or all categories by respondent count.

Select a category from the list to display the questions from that category in the chart.

This view displays responses that use the following data types:
- Checkbox
- Choice
- Likert Scale
- Number
- Template
- Yes/No
- Multiple selection
- Image Scale
- Numeric Scale

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Note: The Checkbox and Yes/No data types are combined into the Boolean data type in the Survey Designer.

Survey category results

Scorecard Customer Satisfaction Survey

To view details about a specific response, point to the colored bar to display the response, the number of responses, and the percentage it represents of all the responses to that question.

Survey scorecard category results detail

Survey scorecard question results

The Question Results filter displays the result of all questions or an individual question using charts or lists. For the String, Attachment, Date, Date/time, Reference, and Ranking data types, the results are displayed in the list view. The results of all other data types are displayed in the pie chart view.

Pie chart

The pie chart shows question results for all data types other than those that are displayed in the list view. See Survey question data types.
• Checkbox.
• Boolean.
• Choice.
• Likert Scale.
• Number.
• Percentage.
• Yes/No.
• Image Scale.
• Multiple Selection.
• Template. The question result shows the aggregated net promoter score (NPS) with promoters, detractors, and passives.

<table>
<thead>
<tr>
<th>Net promoter score categories</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question score</td>
</tr>
<tr>
<td>9 or 10</td>
</tr>
<tr>
<td>7 or 8</td>
</tr>
<tr>
<td>0 to 6</td>
</tr>
</tbody>
</table>

The result is calculated as:
- %Promoters = Number of promoters / Sample size
- %Detractors = Number of detractors / Sample size
- %Passives = Number of passives / Sample size
- NPS = %Promoters - %Detractors

⚠️ Note: The Checkbox and Yes/No data types are combined into the Boolean data type in the survey designer.
Survey scorecard average ratings

The Average Ratings view displays the weighted average rating for each survey question in an individual category or all categories.

Use this view to learn how individual questions affect the overall rating for the category. Select a survey category from the choice list to display the chart for that category.
To view the effect of each question's ratings on the entire category's ratings, point to the colored bar. The pop-up box shows the percentage of the total ratings represented by each individual question's weighted average.

**Survey scorecard history**

The History view compares the current ratings for the categories and their questions with ratings from the previous three years or four quarters.

Ratings that have declined are highlighted in red and display negative numbers. Ratings that have improved are highlighted in green with positive numbers. Arrow icons beside the values in the **Diff** column indicate the trend of the current survey against the previous survey.
Point to a category to display a line chart that shows the rating trend for that category. Click a category to view the Survey Category form containing the survey questions.

**Survey scorecard trend chart**

![Chart showing Politeness Overall Trend from 1/2011 to 1/2014.](chart-image)

**3 years**

To calculate the current ratings, the system averages the ratings from the trailing twelve month (TTM) period. The **Diff** column shows the discrepancy between the current ratings and the previous calendar year’s ratings.
4 quarters
Quarterly surveys compare the average rating for each question and category in the current quarter against the average ratings from the previous four quarters. The **Diff** column shows the discrepancy between the current ratings and the previous quarter's ratings. The column labels count backward, by quarter from the current quarter. For example, if the current quarter is the 3rd quarter of 2015, then the previous quarters appear as 2nd [2015], 1st [2015], 4th [2014], and 3rd [2014]. All four of the previous quarters appear, whether or not there was any data for those quarters.
Survey scorecard history - 4 quarters

Service Desk Satisfaction Survey

Survey Scorecard

Overall Rating

<table>
<thead>
<tr>
<th>Service Desk Satisfaction Survey</th>
<th>Current</th>
<th>Diff</th>
<th>1st</th>
<th>4th</th>
<th>3rd</th>
<th>2nd</th>
</tr>
</thead>
<tbody>
<tr>
<td>How satisfied were you with the response time to your Incident? (1=not at all, 6=excellent)</td>
<td>0.00</td>
<td>5.40</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>How courteous and respectful was the technician who responded? (1=poor, 6=excellent)</td>
<td>0.00</td>
<td>1.02</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Please rate the technical competency of the technician serving you (1=poor, 6=excellent)</td>
<td>0.00</td>
<td>1.02</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Was technician able to resolve your issue during the first call?</td>
<td>0.00</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>How satisfied are you with your overall service experience? (1=not at all, 6=completely)</td>
<td>0.00</td>
<td>1.14</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Export a survey scorecard as an image

You can export a scorecard as an image to use in presentations or other documents.

Before you begin

Role required: admin or survey_admin
Procedure

1. Click the menu icon (≡) and select Save as PNG or Save as JPEG and wait for the export to complete.

Example

2. Click Download and save the scorecard image to a storage location.

Survey administration

Survey administrators—users with the survey_admin role—create and maintain surveys and configure how they are distributed and published. Surveys on Service Portal are also supported.

Survey administration includes the following procedures.

• Create, customize, and publish surveys.
• Write and maintain survey questions.
• Define trigger conditions for when surveys are sent to users, such as when an incident closes.
• Maintain surveys and survey questions as the organization's needs change.
To set up surveys in Service Portal, you must first install Service Portal and then configure the Survey widget on the page. The base system includes the Survey widget.

**View the overview of all surveys**

Use this homepage to view various survey reports such as results by metric type and state.

**Before you begin**

Role required: admin or survey_admin

**About this task**

You can refresh, add, delete, and rearrange widgets. All reports on the Survey Overview page have demo data.

**Procedure**

1. Navigate to **Survey > Overview**.

   The following reports are available:

<table>
<thead>
<tr>
<th>Report</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment group Customer Satisfaction 90 day average</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>Service Desk Survey 'Timely Response' 90 Days</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>Surveys by Metric Type and State</td>
<td>Assessment Instance [asmt_assessment_instance]</td>
</tr>
<tr>
<td>Service Desk Survey 'Overall Experience' 60 Days</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>Service Desk Survey 'Tech Courteous' 90 Days</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>Service Desk Survey 'First Call Resolve' 60 Days</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>Service Desk Survey 'Tech Competence' 60 Days</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
</tbody>
</table>

2. To view the required information, click elements within the reports.

3. To refresh, edit, or close a widget, point to the widget and select the required option.
Survey designer

Users with the survey_admin role can use the survey designer. The survey designer lets you create survey categories and questions, configure the details, and publish the survey to specific users or groups.

You can assign a survey to individual users or groups who receive all the questions from all the categories. You can also customize each question and make it dependent on the response to another question. The following describes the procedures you follow to create and publish a survey.

- Create survey categories.
- Create questions within each category.
- Configure survey details, such as introductory and closing remarks and time limit.
- Select recipients for the survey.
- Publish the survey to the selected users or groups.

Note: The survey designer replaces the survey creator in the Legacy Surveys application. If you are using Internet Explorer version 8 or earlier, the system redirects you to the survey creator.

Related information

- Create a survey designer template question
- Select recipients for a survey in the Survey Designer
- Publish a survey in the Survey Designer

Survey designer elements

The survey designer is accessible from Survey > Survey Designer.

The survey designer contains the Controls tab, the Questions tab, the Categories tab, a header bar, and the design canvas.

Controls tab

To create a question, drag the appropriate data type control from the Controls palette and drop it onto the designer canvas.
The assessment engine provides a built-in result calculation feature that converts responses to scored question data types to a score from 0 through 10.

### Question data types

<table>
<thead>
<tr>
<th>Data type</th>
<th>Scored</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>No</td>
<td>Question with a Manage Attachments icon that allows users to attach one or more files.</td>
</tr>
</tbody>
</table>
### Question data types (continued)

<table>
<thead>
<tr>
<th>Data type</th>
<th>Scored</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>Yes</td>
<td>Question with a check box or Yes and No choices for user responses.</td>
</tr>
<tr>
<td>Choice</td>
<td>Yes</td>
<td>List of predefined options. For more information, see the definition of the <strong>Choices</strong> field in Create a question in the survey designer.</td>
</tr>
<tr>
<td>Date</td>
<td>No</td>
<td>Date field.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>No</td>
<td>Date and time field.</td>
</tr>
<tr>
<td>Number</td>
<td>No</td>
<td>Number field with predefined minimum and maximum values. The default is 1-10.</td>
</tr>
<tr>
<td>Percentage</td>
<td>No</td>
<td>Percentage field with a prescribed range.</td>
</tr>
<tr>
<td>Scale</td>
<td>Yes</td>
<td>Predefined Likert scale. Answer options appear as radio buttons.</td>
</tr>
<tr>
<td>Numeric</td>
<td>Yes</td>
<td>Selectable number scale. The default is 1-5. Answer options appear as radio buttons.</td>
</tr>
<tr>
<td>String</td>
<td>No</td>
<td>Single or multi-line text field.</td>
</tr>
<tr>
<td>Template</td>
<td>Yes</td>
<td>Choice list of templates that provide a predefined scale of options. For details, see Quiz scorecards.</td>
</tr>
<tr>
<td>Reference</td>
<td>No</td>
<td>Choice list of fields from a specified reference table. This data type does not support reference qualifiers. For example, a user could select a user name if you specify sys_user as the reference table.</td>
</tr>
<tr>
<td>Image</td>
<td>Yes</td>
<td>Question with a choice of images that can be selected. A template can be used to apply the same images to multiple questions.</td>
</tr>
<tr>
<td>Scale</td>
<td>Yes</td>
<td>Question with an order number to be selected for each option. One order number cannot be selected twice. This question can be mandatory and it can also be dependent on a parent question, but not vice versa.</td>
</tr>
<tr>
<td>Multiple Selection</td>
<td>Yes</td>
<td>Question with multiple check boxes that can be selected.</td>
</tr>
</tbody>
</table>
Questions tab
This tab displays all metrics added to the question bank for surveys. Use the Filter field to search for questions. Each metric is displayed with its name and type.

Categories tab
This tab displays all metric categories added to the question bank for surveys. All metrics in the question bank are group under the corresponding metric category. Use the Filter field to search for categories or questions.

Header bar
The tabs on the header bar display views and a menu of functions. Click a tab to change the view on the canvas:

• **Design**: Add and configure the properties of categories and questions. This is the default view.

• **Configuration**: Create introductions and end notes for surveys and select a signature.

• **Availability**: Select the recipients for each category in the survey.

Point to the menu icon (≡) to select an option. The list of options depends on the currently open survey.

• **Save**: Save the current survey without changing its state.

• **Preview**: Display a preview of the survey as it appears to recipients.

• **Publish**: Distribute the survey to the selected recipients.

• **Save and Publish**: Save the survey to the Draft state and distribute the survey in one step.

• **New Survey**: Open a fresh canvas for a new survey.

• **Load Survey**: View the list of existing surveys.

• **Copy Survey**: Copy the current survey.

Design canvas
New surveys open in the canvas of the Design view. The survey Name field appears above first category in the canvas. A blank question field appears in the category container.
Configure a survey in the survey designer

Configuration settings apply to the entire survey.

Before you begin
Role required: admin, survey_creator, or survey_admin

Procedure
1. Navigate to Survey > View Surveys.
2. Open a survey definition in Survey Designer.
3. Select the Configuration tab and complete the Survey Designer Configuration form.

Configuration tab fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Select the check box to enable the distribution of this survey to recipients.</td>
</tr>
<tr>
<td>Survey Owners</td>
<td>Owners of the survey. You can add a user with the survey_creator, survey_admin, or assessment_admin role.</td>
</tr>
<tr>
<td>Anonymize responses</td>
<td>Select the check box to collect survey responses anonymously. Recipients are not listed with survey results. When a user submits a survey, the system clears the Assigned to field for the associated survey instance. Also, survey responses for anonymous surveys do not contain Assigned to values.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of this configuration or the survey to which it is attached.</td>
</tr>
</tbody>
</table>

Note: The Assigned to field is cleared. However, each response record includes the Created By and Updated By fields that are accessible to users with the survey_admin role.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not show survey introduction</td>
<td>Check box to skip the introduction notes when a survey is launched. This functionality is applicable in both the Now Platform and Service Portal product versions.</td>
</tr>
<tr>
<td>notes</td>
<td></td>
</tr>
<tr>
<td>Introduction</td>
<td>Introductory content to display on surveys. You can add a welcome message or background information about the survey.</td>
</tr>
<tr>
<td>Signature</td>
<td>Acknowledgement by a survey recipient of requirements, admonitions, or expectations related to a survey.</td>
</tr>
<tr>
<td>Return URL</td>
<td>Destination address of a web page that is presented to users after they submit a completed survey. When a return URL is configured, the <strong>End note</strong> content does not appear.</td>
</tr>
<tr>
<td>End note</td>
<td>Content that is displayed to recipients after they submit a completed survey. You can add a thank you message, follow-up instructions, or other applicable information. End notes are not displayed if a <strong>Return URL</strong> is specified.</td>
</tr>
<tr>
<td>Public Survey</td>
<td>Enables public access to the survey. No login is required to take a public survey and users or non-users can respond anonymously. For completed public surveys, the <strong>Assigned to</strong> field value is Guest.</td>
</tr>
<tr>
<td>Note: This check box is available only after you save the survey.</td>
<td></td>
</tr>
<tr>
<td>Survey Publish URL</td>
<td>Specifies a URL of the survey that can be shared with users.</td>
</tr>
<tr>
<td>Note: This field is available only after you publish the survey.</td>
<td></td>
</tr>
<tr>
<td>Pagination setting for Service</td>
<td>Specify how the user will see pages on the desktop or tablet view in Service Portal.</td>
</tr>
<tr>
<td>Portal view</td>
<td>• <strong>Category:</strong> Display each category on a separate page.</td>
</tr>
<tr>
<td>• <strong>Question:</strong> Display each question on a separate page. This happens for mobile regardless of this setting.</td>
<td></td>
</tr>
<tr>
<td>• <strong>None:</strong> All items on a single page—no pagination</td>
<td></td>
</tr>
<tr>
<td>Default: <strong>Category</strong></td>
<td></td>
</tr>
<tr>
<td>Note: This field appears only when Service Portal is installed.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Chat Survey</td>
<td>Option to validate if survey questions are supported in a chat survey. Enables conversational questionnaires (pre-chat and post-chat surveys) in the chat client. Also enables you to map chat context variables to survey questions. For information on a chat survey in ITSM Virtual Agent, see [Surveys in ITSM Virtual Agent](https:// servicenow.com).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available only when the Glide Conversation Server plugin (com.glide.cs) is activated.</td>
</tr>
<tr>
<td>One Click Survey</td>
<td>Enables a One Click survey in Service Portal.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option can be selected if the <em>Pagination setting for Service Portal view</em> is set to <em>None</em>.</td>
</tr>
<tr>
<td>Source Table</td>
<td>Table whose field is used as a dynamic value for a question in a triggered survey.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When you select a source table, ensure that its relevant field is selected as <em>Source Field</em> value of a metric.</td>
</tr>
<tr>
<td>Allow Sentiment Analysis</td>
<td>Enables sentiment analysis for this survey.</td>
</tr>
<tr>
<td>Duration</td>
<td>Amount of time that recipients are given to complete this survey, starting from the time that the survey is generated. The default duration is 14 days.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> By default, the system runs the <em>Cancel Expired Assessments</em> script every 30 days to cancel expired survey, assessment, and quiz instances that are in the Work in progress or Ready to take states.</td>
</tr>
<tr>
<td>Outlook Actionable Message</td>
<td>Includes an embedded survey in the survey email notification. After you select this check box and save the survey, a validation is run to ensure all survey questions are supported.</td>
</tr>
</tbody>
</table>

4. Select the **Availability** tab and complete the form,

**Availability tab fields**

<table>
<thead>
<tr>
<th>Accessible by</th>
<th>Defines who can access the survey. Possible values are</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey groups only</td>
<td>If selected, a survey is available for survey groups only.</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is displayed only if the <strong>Accessible by</strong> is <strong>Specific users.</strong></td>
</tr>
<tr>
<td>Add group users</td>
<td>Group users for whom the survey is available.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is displayed only if the <strong>Accessible by</strong> is <strong>Specific users.</strong></td>
</tr>
<tr>
<td>Add users</td>
<td>Users for whom the survey is available.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is displayed only if the <strong>Accessible by</strong> is <strong>Specific users.</strong></td>
</tr>
<tr>
<td>Add recipients lists</td>
<td>Recipients lists for whom the survey is available.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is displayed only if the <strong>Accessible by</strong> is <strong>Specific users.</strong></td>
</tr>
</tbody>
</table>

**Related information**

- View a survey scorecard
- Create a survey designer template question
- Select recipients for a survey in the Survey Designer
- Publish a survey in the Survey Designer
- Create an assessment signature

**Survey categories**

Survey categories provide a way to group questions of a similar theme for a given survey.

There must be at least one survey category per survey definition and every survey question must be associated with a category. When you create a survey, the system generates one category, which all the questions belong to.

For simple surveys, one category is usually enough. Consider creating additional categories if you want to accomplish any of the following tasks.
• Separate groups of questions into collapsible sections by category on the survey questionnaire.

• Report on category scores, which are calculated based on responses for all questions within each category.

Create a category in the survey designer

A category represents a theme for evaluating a specific element of the survey topic and contains questions pertaining to that theme.

Before you begin
Role required: admin or survey_admin

About this task
When you create a survey, the system creates a default category, using the name of the survey. You can use this category, modify it, and create additional categories as needed. To have any results, a category must contain scored questions.

Procedure
1. Navigate to Survey > Survey Designer.
2. Enter the name of the survey in the Name field. The system uses this name as the name of the survey and of the first category.
3. To configure the category, click the gear icon in its title bar and complete the following steps in the Properties dialog box.
   a. Enter a new name and a description for the category.
   b. Enter text in the Details field that introduces or explains the category to recipients.
   c. Click the X icon to close the Properties dialog box and save your settings.
4. To add a new category, click the + icon in the title bar of an existing category. The new category appears below the category that you selected to create it. You can click the X icon in a category header to delete a category that you added in error.

Create a survey category in a survey

You can modify an existing survey to add one or more survey categories.

Before you begin
Role required: admin or survey_admin
About this task
Only one category is required for each survey, but you can add additional categories as needed.

Procedure
1. Navigate to Survey > View Surveys.
2. Open a survey definition.
3. In the Metric Categories related list, open a category or click New. Each survey category is stored as a record on the Metric Category [asmt_metric_category] table with a modified view for survey use.
4. Enter the survey category name and description. The category name appears on questionnaires when either of the following is true.
   • There is more than one category for the survey.
   • There is only one category and its name is different from the survey definition name. If you create a survey using the survey creator, the category name is the same as the survey definition name.
5. Right-click the form header and click Save. The Assessment Metrics and Users related lists appear.
6. Click Update.

Create a question in the survey designer
You can create multiple questions for each category in the survey designer, but each question can only be associated with one category.

Before you begin
Role required: admin or survey_admin

About this task
The data type that you select for each question determines how it can be answered by survey recipients.

Procedure
1. In the Design view, drag a data type icon from the Controls palette and drop it into a category container.
2. To configure the question, click the gear icon in its title bar. The Properties dialog box opens.
3. Complete the form.
### Question property fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Concise name of the question. The system uses this value to identify the question in Assessment Metric lists and in scorecard charts.</td>
</tr>
<tr>
<td>Question</td>
<td>Text to display as the question on surveys. Enter a clear, straightforward question that is easy to understand.</td>
</tr>
<tr>
<td>Type</td>
<td>Data type selected for this question. See the table in Controls for the available data types.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that determines whether this question is available on a survey. A question does not appear on surveys that are generated after the question becomes inactive.</td>
</tr>
</tbody>
</table>
| Mandatory           | Check box to require users to answer the question. Mandatory questions are denoted by a red field status indicator and must be answered before the survey can be submitted.  
This field is available when the question does not have a dependency and the question type is not **Boolean** with a check box option. |
| Allow Additional Information | If selected, the **Additional Information Label** field is enabled. The **Additional Information Label** field value is displayed as a field on the survey response page to provide additional information for a question.  

**Note:** This is not applicable for the String and Template data types. |
| Boolean option      | Whether a check box or a **Yes/No** list appears as the option for a Boolean question.                                                      |
| String option       | Setting for the appearance of a string field in a question. This field is available when the question type is **String**. The string options include the following.  
- **Single line**: Single-line text field 40 characters in length that allows strings of any length.  
- **String line wide**: Full page width text field that allows a single-line entry of any length.  
- **Multiline**: Full page width multiline text field that allows word wrap and returns |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min</td>
<td>Lowest positive whole number that users can enter or select to answer the question. This field is available when the question type is <strong>Number</strong>, <strong>Percentage</strong>, or <strong>Numeric Scale</strong>.</td>
</tr>
<tr>
<td>Max</td>
<td>Highest positive whole number that users can enter or select to answer the question. This field is available when the question type is <strong>Number</strong>, <strong>Percentage</strong>, or <strong>Numeric Scale</strong>.</td>
</tr>
<tr>
<td>Allow not applicable</td>
<td>Check box for including <strong>Not Applicable</strong> as an option for this question. Users can select <strong>Not Applicable</strong> if they do not have sufficient information to respond to a question. User responses of <strong>Not Applicable</strong> are excluded from results calculations. This field is available when the question does not have a dependency and the question type is not <strong>Boolean</strong> with a check box option.</td>
</tr>
<tr>
<td>Randomize answers</td>
<td>Check box for displaying answer options in a random order. Answer preference is sometimes influenced by the order in which options appear, which can result in biased results. Randomizing options can help prevent this bias. <strong>Note:</strong> Randomizing options for certain questions may make those questions confusing for users. In general, only randomize options that do not follow a logical order.</td>
</tr>
<tr>
<td>Positive indicator</td>
<td>Setting that determines whether smaller or larger numerical values equate to a good score in result calculations. Select <strong>Low values</strong> if smaller numerical values are better, such as for a question that measures the number of incidents for a vendor. Select <strong>High values</strong> if larger numerical values are better, such as for a question that measures user satisfaction on a scale of one to five.</td>
</tr>
<tr>
<td>Source Field</td>
<td>Source table field that appears as a dynamic value for the question in a triggered survey. When this field value is selected, a <code>{param}</code> placeholder is added at the end of the question label. <strong>Note:</strong> You can move this placeholder anywhere in the question label. When a user takes the survey, the question with dynamic value is included in the survey instance and <code>{param}</code> placeholder is replaced with the source field value.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>If the record table specified in the trigger condition does not match the source table specified for the survey, or if the system fails to get the dynamic value from the source record, the <code>${param}</code> placeholder is not replaced by any value and is displayed as is. For example, if the survey is triggered from a PRB record and the survey question is configured with a dynamic value from Incident, the <code>${param}</code> placeholder in the survey question label is not replaced by any dynamic value and is displayed as is.</td>
</tr>
<tr>
<td>Allow Sentiment Analysis</td>
<td>Includes this question for the sentiment analysis of a survey.</td>
</tr>
<tr>
<td>Details</td>
<td>Information about the question that is displayed on the survey. Include details that help users understand how to answer the question.</td>
</tr>
<tr>
<td>Choices</td>
<td>Options for a question with a data type of Choice or Scale. The system automatically adds text and values that you can edit for each option. You must have at least two options, and each option must have a unique value. Click the + icon to add an option, or click the X icon to delete an option. By default, the system arranges options in the order established by their values. To change the order, drag and drop the options.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
4. To create any special conditions that must be met before the question appears on the survey, click the Dependency tab. The question must have a data type of **Boolean, Choice, Scale, or Template**.

5. Select a question in the **Displayed when** field. The system selects the appropriate operator and displays the possible answers for the selected question.

6. Select the answer that satisfies the condition. You can select more than one answer. Selected answers are indicated by a check mark.

   The system prevents recursive dependencies between questions. For example, if Question A depends on Question B, Question B cannot depend on Question A.

7. Click the X icon to close the question properties dialog box and save your settings.

8. To add a question with the same data type as an existing question in the category, click the + icon in the title bar of the existing question.

9. Drag and drop questions to change their order within a category or move them between categories.

10. To delete a question, click the X icon in its title bar.

**Related information**

- Survey question template
- Create a survey designer template question

**Survey question data types**

You must choose a data type for each survey question. The data type determines the format of the question and the kind of data that is collected on survey questionnaires.

The following data types are available for surveys:

**Attachment data type**

On questionnaires, users can attach one or more files to a question.

Users click the Manage Attachments icon and select one or more files in the Attachments pop-up window to attach to the question. From this window, users can:
• View a list of the attached files.
• View an attached file in a separate window.
• Rename an attached file.
• Add or delete files

Once a survey has been submitted, attachments cannot be updated or deleted.

Any type of file supported by the platform can be attached to a question. One or more files can be attached a question while taking a survey or completing an assessment.

The assessment administrator can see the attachments associated with an individual question as well as those associated with the survey.

See Administering Attachments for more information.

**Boolean data type**

On questionnaires, users select a check box beside a statement or leave it cleared.

If you select **Boolean**, you must fill in the **Scale definition** field. Select **High** if it is best when users select the check box.

**Choice data type**

On questionnaires, users select a value from a list of choices.

If you select **Choice**, you must fill in the **Scale definition** field and create answer options. Select **High** for the scale definition if the answer option with the largest metric definition **Value** is best.

ℹ️ **Note:** The system sets the **Min** and **Max** fields automatically based on the **Value** settings for the associated metric definitions.
**Date and Date/Time data types**

The **Date** and **Date/Time** data types are similar.

- **Date**: On questionnaires, users select a date.

  ![Date selection example](image1)

- **Date/Time**: On questionnaires, users select a date and time.

  ![Date/Time selection example](image2)

**Likert Scale data type**

On questionnaires, users select a multiple choice value from a custom Likert scale. Each answer option is represented by a radio button on the scale. A Likert scale question that evaluates an application’s ease of use might have the answer options **Easy**, **Average**, and **Difficult**.

![Likert scale example](image3)
If you select **Likert Scale**, you must fill in the **Scale definition** field and create answer options. Select **High** for the scale definition if the answer option with the largest metric definition **Value** is best.

ℹ️ **Note:** The system sets the **Min** and **Max** fields automatically based on the **Value** settings for the associated metric definitions.

**Number data type**

On questionnaires, users enter a number.

If you select **Number**, you must fill in these additional fields:

- **Scale definition**: Select **High** if a larger number is better, such as for a question that measures the number of sales made in a quarter.

- **Min** and **Max**: Enter the smallest and largest numbers users can enter. State the range of acceptable answers in the question text.

**Percentage data type**

On questionnaires, users enter a number.

If you select **Percentage**, you must fill in these additional fields:

- **Scale definition**: Select **High** if a larger percentage is better, such as for a question that measures the percentage of work an agent has completed.

- **Min** and **Max**: Enter the smallest and largest numbers users can enter. Generally 0 and 100 are appropriate minimum and maximum values. If you choose values other than 0 and 100, it is usually best to state the range of acceptable answers in the question text.
Reference data type

On questionnaires, users select a value from a list that is generated from a specified reference table. The response field supports auto-completion.

ℹ️ Note: Reference qualifiers are not supported.

For example, a user could select a user name in response to a question if you specify User [sys_user] as the reference table.

String data type

On questionnaires, users enter text. When you select String, the String option field appears. Select one of the following options to determine how the string field appears on questionnaires:
• **Single line**

  ![Additional comments](image)

• **Single line wide**

  ![Additional comments](image)

• **Multiline**

  ![Additional comments](image)

**Template data type**

On questionnaires, users select a value from a predefined series of answer options. To use this data type, a question template must be defined.

If you select **Template**, you must fill in these additional fields:

- **Template**: Select a template.
- **Scale definition**: Select **High** if the answer option with the largest template definition **Value** is best.

**Yes/No data type**

On questionnaires, users select **Yes** or **No** from a list.
If you select Yes/No, you must fill in the Scale definition field. Select High if Yes is the best answer.

**Image Scale data type**

On questionnaires, users select an image from a predefined set of images as their response. Image scale questions can also be used in a template for better performance with surveys that have the same type of answer options.

Five emojis, similar to the Likert scale (very dissatisfied to very satisfied) are provided. However, you can upload additional images in JPG, PNG, or GIF format. Two images can be uploaded, one for selected case and another for unselected case. Larger size images are reduced to 64 x 64 pixels.

The result behavior depends on the presence of uploaded images. If no selected image is uploaded, then the question shows up blank.

<table>
<thead>
<tr>
<th>Selected image</th>
<th>Unselected image</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Unselected image loads. Clicking on the image changes it to the selected image.</td>
</tr>
<tr>
<td>Yes</td>
<td>No</td>
<td>Selected image loads with 50% opacity. Clicking on the image changes the opacity to 100%.</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>A blank placeholder box is displayed.</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>A blank placeholder box is displayed.</td>
</tr>
</tbody>
</table>

**Note:** N/A option is not supported for image scale type question.

**Multiple selection data type**

On questionnaires, users can select multiple check boxes indicating all answers that apply. For instance, a user can be instructed to "Select all that apply" in a multiple selection question.
**Ranking data type**

On questionnaires, users can select a different order number for each option to rank them. Drag-and-drop functionality is also supported, which allows a user to either fill in the number, or simply drag an option.

One order number cannot be selected twice. This question can be mandatory and it can also be dependent on a parent question, but not vice versa.

**Related information**

Survey question template

**Edit a survey in the survey designer**

You can modify surveys using the survey designer.

**Before you begin**

Role required: admin or survey_admin

**About this task**

You can edit a survey even after it has been distributed, with the following results.
• Added questions are available only on surveys that are distributed after this change.

• Changes to existing questions are immediately available to users before the survey is submitted or during the retake period. This includes changes to the answers, such as additional choices or changes to the data type.

• Deleted questions are also deleted from the distributed surveys in user queues.

Note: You can only edit a survey that has the same application scope as that of your current session.

Procedure
1. Navigate to Survey > Survey Designer.

2. Point to the menu icon in the survey header bar, and select Load Survey.

3. Select a survey from the list and modify it as needed.

4. Point to the menu icon in the survey header bar, and select Save or Save and Publish.
   When you publish the edited survey, the system generates survey instances for any associated survey users.

Configure category weights for a survey
You can assign a weight to each category in a survey. The system calculates results from the weight that you configure.

Before you begin
Configure the Survey Category form to display the Weight field.

Role required: admin or survey_admin

About this task
Weights are set to a value of 10 by default but can be changed.

Procedure
1. Navigate to Survey > View Surveys and select a survey from the list.

2. In the Survey Definition form, select a category from the Metric Categories related list.

3. Edit the default weight value.

4. Click Update.
View a survey instance

A survey instance represents one questionnaire assigned to one user. You view an instance to verify that survey instances were created, to check the state of a survey instance, or to reassign a survey instance.

Before you begin
Role required: admin or survey_admin

Procedure
1. Navigate to Survey > Survey Instances. The following sub-modules are available based on the state of the instances:
   - **Ready to take**: Displays survey instances that are ready to be taken by the user. By default, these instances are sorted in ascending order by the Number field.
   - **In progress**: Displays survey instances that are in progress. By default, these instances are sorted in ascending order by the Number field.
   - **Completed**: Displays survey instances that are complete. By default, these instances are sorted in descending order by the Taken on field.
   - **Cancelled**: Displays survey instances that are cancelled. By default, these instances are sorted in ascending order by the Number field.
   - **All**: Displays survey instances in all states. By default, these instances are sorted in ascending order by the Number field.

2. Open a survey instance from the required sub-module. By default, the following fields are displayed in the Survey Instance form for all sub-modules other than Completed.

Note:
- When you open an instance in the Completed sub-module, you are redirected to the User's Response page.
- Each survey instance is stored as a record on the Assessment Instance [asmt_assessment_instance] table with a modified view for survey use.

Survey Instance form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated record number.</td>
</tr>
<tr>
<td>Metric type</td>
<td>Survey definition this survey instance was created from. Survey definitions are stored on the Assessment Instance table, and the field label on that table is Metric type.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Due date         | Date by which the survey instance should be completed. The system populates the due date based on the **Assessment duration** of the associated survey definition, which is set to 14 days by default. The survey due date is not enforced in the base system. If you want to enforce the due date, consider using a workflow or other mechanism to send survey recipients reminders when a survey is overdue.  
  
  **Note:** By default, the system runs the **Cancel Expired Assessments** script every 30 days to cancel expired survey, assessment, and quiz instances that are in the Work in progress or Ready to take states.                                                                                                                                                                                                                                                                                                                                                                                                                                                                 |
Related information

Schedule periods

Survey users and groups

Survey users and survey user groups help survey administrators control who can take a survey.

Survey administrators can restrict a survey so that only specified users can access it unless a survey administrator manually assigns the survey to a different user. Survey user groups provide a way to quickly designate multiple survey users.

Administering survey users

The list of survey users for a survey is visible on the Survey Definition and Survey Category forms. You can add or remove users from the list of survey users at any point. Note that designating a survey user does not automatically generate a survey instance for that user unless both of the following conditions are true:

- The survey definition Schedule period is set to Daily, Weekly, Monthly, or Yearly. In this case the system assigns a new survey instance to each survey user at the beginning of each schedule period.
- The user has no instances of the survey that are incomplete or that have not yet reached their expiration date.

You can designate survey users from the Survey Designer, the Survey Definition form, or the Survey Category form.

Note: If there are trigger conditions for a survey, do not create survey users. Instead, use the Trigger Conditions form to assign users.

Related information

Send survey invitations to users
Survey trigger conditions
Survey categories
Survey definitions

Create a survey user group

Survey user groups are groups that have the Type field set to survey and display only the information most relevant to surveys. You can assign survey groups or any user group to surveys.
Before you begin
Role required: admin or user_admin

About this task
Though it is possible to designate members of any group as survey users, one reason to create a survey group is to view it conveniently in the survey User Groups module.

By default, the Survey Creators user group is available. When you add a user to this group, the user will be assigned the survey_creator role to create surveys, quizzes, or assessments and view only those surveys, quizzes, or assignments created by the user.

Procedure
1. Navigate to Survey > Administration > User Groups.
2. Click New.
3. Complete the Group form.
4. Right-click the form header and click Save.
The Group Members and Groups related lists appear.
5. To add group members, complete the following steps.
   a. In the Group Members related list, click Edit.
   b. Select users from the list on the left and add them to the Group Members List on the right.
   c. Click Save.

Related information

Select recipients for a survey in the Survey Designer
You can assign survey users while designing or modifying the survey.

Before you begin
Role required: admin or survey_admin

Procedure
1. In the Survey Designer, click the Availability tab.
2. Under Accessible by:, select the Specific users option, then select users.
3. If desired, select the **Survey groups only** check box, then select survey user groups or other groups.

4. Click **Save**.

**Designate a survey user**

You can designate one survey user at a time from the Survey Definition form.

**Before you begin**

Role required: admin or survey_admin

**Procedure**

1. Navigate to **Survey > View Surveys**.
2. Open a survey definition.
   - There must be at least one category.
3. In the **Survey Users** related list, click **New**.
4. Select a **User**.
5. Click **Submit**.
   - The Survey Definition form reopens.
6. Optional: To remove survey users, in the **Survey Users** related list, select the check box beside the user, and then select **Delete** from the action list below the list.

**Designate or remove multiple survey users at one time**

Use the Survey Category form to designate or remove multiple survey users at a time.

**Before you begin**

Role required: admin or survey_admin

**Procedure**

1. Open a survey definition.
2. In the **Metric Categories** related list, open a category.
   - You can choose any category. The system applies survey user changes to all the survey’s categories automatically.
3. In the **Users** related list, click **Edit**.
4. Use the slushbucket to add or remove survey users.
5. Click **Save** to return to the survey category.
   The changes are also reflected in the **Survey Users** related list on the survey definition.

**Allow recipients to retake a survey**

You can configure a survey to allow recipients to resubmit their answers as many times as they like, up to the survey's due date.

**Before you begin**

Configure the Survey Definition form to display the **Allow retake** field. For more information, see

Configure the form .

Role required: admin or survey_admin

**About this task**

Results are not calculated for the survey until the configured duration has elapsed. The card in the user's queue remains visible until the due date of the survey, and a button is displayed to allow retakes.

**Procedure**

1. Navigate to **Surveys > View Surveys**.
2. Select a survey from the list.
3. Select the **Allow retake** check box.
4. Click **Update**.

**Copy a survey**

Create a copy of a survey with at least one category to reduce the effort of creating another survey with similar data.

**Before you begin**

Role required: survey_admin or admin

**About this task**

All associated questions (type), configurations, categories, metrics, domain separation rules, and role-based categories are copied. Assigned users, category users, instances, and trigger conditions are not copied.
Procedure

1. Navigate to **Survey > View Surveys**.
2. Open a survey definition.
3. Perform any of the following steps:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Platform</td>
<td>In the title bar, click <strong>Copy</strong>.</td>
</tr>
<tr>
<td>From Platform</td>
<td>In the title bar, select <strong>Copy</strong> from the context menu.</td>
</tr>
<tr>
<td>From survey designer</td>
<td><strong>a.</strong> In the title bar, click Survey Designer.</td>
</tr>
<tr>
<td></td>
<td><strong>b.</strong> In the Survey Designer title bar, point to the menu icon (≡) on the header bar and click <strong>Copy Survey</strong></td>
</tr>
</tbody>
</table>

Publish a survey
You must publish a survey to enable people to receive and complete survey instances.

Before you begin
Role required: admin or survey_admin

About this task
The **State** field on the Survey Definition form indicates whether the survey is in the **Draft** or **Published** state.

⚠️ Note: You cannot return a survey to the **Draft** state after it has been published. You do have the option to deactivate a survey by clearing the **Active** check box.

Procedure

1. Navigate to **Survey > View Surveys** and select a survey to publish.
2. Click **Publish**.
   When you publish a survey, the system generates survey instances for any associated survey users. You can assign the survey to other users manually.
Publish a survey in the Survey Designer

You must save changes to a survey before you can publish it to the specified recipients or groups.

Before you begin
Role required: admin or survey_admin

Procedure
1. In the Survey Designer, point to the menu and select Load Survey.
2. Select a survey to publish.
3. To preview the survey as a user, point to the menu icon and click Preview.
4. When you are satisfied with the survey, click either Save and Publish or Publish to distribute it.

When you publish a survey, the system sends email notifications to the recipients and to their managers. The system displays a link to the survey on a card in each recipient's My Assessments & Surveys portal.

Customize the appearance of a survey

Assessment and survey administrators can set properties to customize the color of various elements on the questionnaires.

Before you begin
Role required: admin or survey_admin

About this task
For color properties, enter either an HTML color name or hexadecimal (hex) value. For hex values, the # character is required. Values are not case-sensitive.

For example, all of the following formats are valid: LightGray, lightgray, #D3D3D3. A preview of the color appears next to the field.

Note that the customizations you make apply to all assessments and surveys.

Procedure
1. Navigate to either of the following modules.
   - Assessments > Admin > Assessment Properties
   - Survey > Administration > Properties
2. On the properties page, edit the properties as needed.
   Refer to the screenshot below to see what parts of assessment questionnaires are controlled by the properties.
3. Click **Save**.
You may need to clear the browser's cache to see updates.

**Assessment and survey properties**

You can configure a variety of properties to customize the appearance of assessment and survey questionnaires, require authentication for user signatures, open surveys in the service portal view from emails, and limit the number of items shown in a decision matrix field filter.

<table>
<thead>
<tr>
<th>Property</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_portal_surveys.sp_survey.email_redirection</td>
<td>Allow survey link from email to open in service portal view (applies only for surveys)</td>
<td>When Yes is selected, a survey accessed from a link in an email opens in the Service Portal.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This property applies only to surveys.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: No</td>
</tr>
<tr>
<td>com.snc.assessment.signature_authentication</td>
<td>Require authentication</td>
<td>When Yes is selected,</td>
</tr>
</tbody>
</table>
### Assessment and survey properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>for user signature.</td>
<td>this property requires credentials for a full name signature.</td>
<td>• Default value: Yes</td>
</tr>
<tr>
<td><strong>css.assessment.question.header.background.color</strong></td>
<td>Assessment question header background color</td>
<td>Sets the background color of question headers on assessment and survey questionnaires.</td>
</tr>
<tr>
<td><strong>css.assessment.caption.background.color</strong></td>
<td>Assessment caption background color</td>
<td>Sets the background color of the caption on assessment and survey questionnaires.</td>
</tr>
<tr>
<td><strong>com.snc.assessment.decision_matrix_filter_max_entries</strong></td>
<td>Maximum number of items to show for a decision matrix field filter</td>
<td>• Default value: 1000</td>
</tr>
<tr>
<td><strong>css.assessment.caption.font.color</strong></td>
<td>Assessment caption font color</td>
<td>Sets the font color of the caption text on assessment questionnaires.</td>
</tr>
</tbody>
</table>
Assessment and survey properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>and survey questionnaires.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: #ffffff</td>
</tr>
</tbody>
</table>

Survey definitions

A survey definition is the root record upon which a survey is built.

The survey designer generates a survey definition automatically when you save or publish the survey. Survey administrators may want to modify the survey definition to configure additional options for the survey, or to publish the survey when it is ready for distribution.

Survey administrators and survey readers can also send survey invitations directly to users from the survey definition.

Related information

Send survey invitations to users

Modify a survey definition

You can configure additional options for a survey definition.

Before you begin

Role required: admin, survey_creator, or survey_admin

Procedure

1. Navigate to Survey > View Surveys.
   Each survey definition is stored as a record on the Assessment Metric Type [asmt_metric_type] table with a modified view for survey use.

2. Open a survey definition.
   The Response Trend chart with the weekly trend of the survey instance count, and the Survey Summary chart with the overall summary response based on instance states are displayed.

3. Modify the fields on the Survey Definition form.

   Note: You can only edit a survey that has the same application scope as that of your current session.
### Survey Definition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the survey which appears on the questionnaire.</td>
</tr>
<tr>
<td>Description</td>
<td>Helpful information about the survey.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the survey definition. When the <strong>Active</strong> check box is cleared, new survey instances cannot be generated and users cannot complete existing survey instances. Use the <strong>Active</strong> check box to deactivate or activate a published survey.</td>
</tr>
<tr>
<td>Owners</td>
<td>Owners of the survey. You can add a user with the survey_creator, survey_admin, or assessment_admin role.</td>
</tr>
<tr>
<td>Anonymize responses</td>
<td>Check box to ensure that all responses for this survey are stored without the submitting user names. When a user submits a survey, the system clears the <strong>Assigned to</strong> field for the associated survey instance. Also, survey responses for anonymous surveys do not contain <strong>Assigned to</strong> values.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The <strong>Assigned to</strong> field is cleared. However, each response record includes the <strong>Created By</strong> and <strong>Updated By</strong> fields that are accessible to users with the survey_admin role.</td>
</tr>
<tr>
<td>Send notifications</td>
<td>Check box to send a notification that the survey has been taken.</td>
</tr>
<tr>
<td>State</td>
<td>Status of the survey: <strong>Draft</strong> or <strong>Published</strong>.</td>
</tr>
<tr>
<td>Allow retake</td>
<td>Check box that allows users to modify their answers to a completed survey. Users can resubmit a survey as many times as they want until the due date. After that date, the system removes the survey from the user's My Assessments &amp; Surveys page.</td>
</tr>
<tr>
<td>Scheduled job</td>
<td>Scheduled job that the system creates for this survey definition when the schedule period is a repeating interval. The system sets the scheduled job to run according to the selected schedule period. If you change the schedule period and save the survey definition:</td>
</tr>
<tr>
<td></td>
<td>• The system deletes the old scheduled job. If you selected a recurring schedule period:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• A new scheduled job is created. For example, if you change the schedule period from <strong>Daily</strong> to <strong>Weekly</strong> and save the record:</td>
</tr>
<tr>
<td></td>
<td>• The system deletes the daily scheduled job.</td>
</tr>
<tr>
<td></td>
<td>• Creates a weekly one set to run a week from the current date.</td>
</tr>
<tr>
<td></td>
<td>This field is visible to administrators only if the schedule period is <strong>Daily</strong>, <strong>Weekly</strong>, <strong>Monthly</strong>, or <strong>Yearly</strong>.</td>
</tr>
<tr>
<td>Assessment duration</td>
<td>The length of time to complete assigned survey instances, starting from the time the survey instance is generated. The assessment duration sets the Due date for each survey instance. The default duration is 14 days. Configure the form to view this field.</td>
</tr>
<tr>
<td></td>
<td>⚠ <strong>Note:</strong> By default, the system runs the <strong>Cancel Expired Assessments</strong> script every 30 days to cancel expired survey, assessment, and quiz instances that are in the Work in progress or Ready to take states.</td>
</tr>
<tr>
<td>Send notifications</td>
<td>Send notifications for the survey when it is published. Configure the form to see the field.</td>
</tr>
<tr>
<td>Other Options</td>
<td></td>
</tr>
<tr>
<td>Sample Metric</td>
<td>A metric of the current survey that you can include as an image in the email or invitation sent to a survey user. When the survey user clicks the image in the email or while previewing the HTML body, the entire survey is available to be taken.</td>
</tr>
<tr>
<td></td>
<td>⚠ <strong>Note:</strong> You cannot edit or delete a metric that is selected in this field.</td>
</tr>
<tr>
<td>Signature</td>
<td>Acknowledgement by a survey recipient of requirements, admonitions, or policies related to the survey. The signature may require the recipient to select a check box or to type in a full signature to verify having read these assertions. You can display assertions without requiring a signature. Select an existing signature from the list or click <strong>New</strong> to create a new one. The signature form contains these fields:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Name</td>
<td>Descriptive name for this signature.</td>
</tr>
<tr>
<td>• Signature type</td>
<td>Type of signature required. The selections are Check box, Full name, or Assertion only. If Assertion only is selected, no signature is required to submit the survey.</td>
</tr>
<tr>
<td>• Assertion</td>
<td>Text you want to display to recipients.</td>
</tr>
<tr>
<td>By default, a property called</td>
<td>Require authentication for user signature (com.snc.assessment.signature_authentication) requires users to authenticate when providing a full name signature.</td>
</tr>
<tr>
<td>Schedule period</td>
<td>Option that determines how often a user can take the same survey and whether the system generates survey instances on a schedule.</td>
</tr>
<tr>
<td>◉ Note:</td>
<td>If you use a trigger condition for a survey, ensure the schedule period is set to No Limit. Trigger conditions use a different method to regulate how often users can receive survey instances.</td>
</tr>
<tr>
<td>Do not show survey introduction notes</td>
<td>Check box to skip the introduction notes when a survey is launched. This functionality is applicable in both the Now Platform and Service Portal product versions.</td>
</tr>
<tr>
<td>Pagination setting for Service Portal view</td>
<td>The setting on which the pagination is based for desktop or tablet view in Service Portal.</td>
</tr>
<tr>
<td>◉ Note:</td>
<td>This field is displayed only when Service Portal is installed.</td>
</tr>
<tr>
<td>One Click Survey</td>
<td>Enables a One Click survey in Service Portal.</td>
</tr>
<tr>
<td>◉ Note:</td>
<td>This option can be selected if the Pagination setting for Service Portal view is set to None.</td>
</tr>
<tr>
<td>Source Table</td>
<td>Table whose field is used as a dynamic value for a question in a triggered survey.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Chat Survey</strong></td>
<td>Option to validate if survey questions are supported in a chat survey. Enables conversational questionnaires (pre-chat and post-chat surveys) in the chat client. Also enables you to map chat context variables to survey questions. For information on a chat survey in ITSM Virtual Agent, see <a href="#">Surveys in ITSM Virtual Agent</a>.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field is available only when the Glide Conversation Server plugin (com.glide.cs) is activated.</td>
</tr>
<tr>
<td><strong>Outlook Actionable Message</strong></td>
<td>Includes an embedded survey in the survey email notification. After you select this check box and save the survey, a validation is run to ensure all survey questions are supported.</td>
</tr>
<tr>
<td><strong>Allow Sentiment Analysis</strong></td>
<td>Enables sentiment analysis for this survey.</td>
</tr>
<tr>
<td><strong>Introduction &amp; End Notes</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Introduction</strong></td>
<td>Introductory content to display on survey questionnaires. Consider adding a company logo, a welcome message, background information about the survey, or instructions.</td>
</tr>
<tr>
<td><strong>End note</strong></td>
<td>End note that appears when someone submits a survey questionnaire. Consider adding a thank you message, follow-up instructions, or other applicable information.</td>
</tr>
<tr>
<td><strong>Related Links</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Enable Public Access</strong></td>
<td>Link that enables/disables the survey as a public survey. No login is required to take a public survey (including a survey with a trigger condition) and users or non-users can respond anonymously. For completed public surveys, the <strong>Assigned to</strong> field value is Guest.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>You can use the <strong>View Survey URL</strong> related link to share the URL with users.</td>
</tr>
<tr>
<td><strong>Remove Public Access</strong></td>
<td>Link that opens the list of responses for this survey. This related link is available only if there are results for the survey.</td>
</tr>
</tbody>
</table>

*Note: When you select a source table, ensure that its relevant field is selected as **Source Field** value of a metric.*
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Scorecard</td>
<td>Link that opens the scorecard for this survey. This related link is available only if there are results for the survey.</td>
</tr>
<tr>
<td>View Survey URL</td>
<td>Link that opens a dialog box that displays a URL for this survey. The URL is useful for sharing a public survey.</td>
</tr>
<tr>
<td></td>
<td>This related link is available only if the Active check box is selected. The URL does not work until the survey definition is published.</td>
</tr>
<tr>
<td>Show Benchmarks</td>
<td>Opens the Benchmarks Dashboard that provides visibility into your key performance indicators (KPIs) and trends.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• This related link is available only for survey_admin, assessment_admin and survey_reader with bm_viewer role.</td>
</tr>
<tr>
<td></td>
<td>• You must opt in to Benchmarks to view the dashboard. See Enable Benchmarks.</td>
</tr>
<tr>
<td></td>
<td>• This is applicable only for a published survey.</td>
</tr>
<tr>
<td>Create Improvement Initiative</td>
<td>Opens the Improvement Initiative window to create an improvement initiative record that helps in improving the performance of the survey.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• This related link is available only for the survey_admin and assessment_admin role. A survey_reader can only view the created improvement initiative records.</td>
</tr>
<tr>
<td></td>
<td>• You should activate the Continual Improvement Management plugin (com.sn_cim).</td>
</tr>
<tr>
<td>Retry Sentiment Analysis</td>
<td>Checks all survey instances of this survey that do not have sentiment analysis data and sends them for analysis.</td>
</tr>
<tr>
<td>Related Lists</td>
<td></td>
</tr>
<tr>
<td>Trigger Condition</td>
<td>Displays all the trigger conditions associated with the survey.</td>
</tr>
<tr>
<td>Survey Responses</td>
<td>Displays all the responses associated with the survey.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Metric Categories</td>
<td>All survey categories for this survey.</td>
</tr>
<tr>
<td>Survey Users</td>
<td>All survey users who are authorized to take this survey. If no users are</td>
</tr>
<tr>
<td></td>
<td>listed, any user can take this survey.</td>
</tr>
<tr>
<td>Assessment Instances</td>
<td>All survey instances for this survey. Configure the form to add this related</td>
</tr>
<tr>
<td></td>
<td>list to see it.</td>
</tr>
<tr>
<td></td>
<td>⚠ Note: If you add a related list to the form, use list control to omit the</td>
</tr>
<tr>
<td></td>
<td>New button. The system generates survey instances to produce functional</td>
</tr>
<tr>
<td></td>
<td>surveys.</td>
</tr>
<tr>
<td>Improvement</td>
<td>Displays improvement initiatives associated with the survey.</td>
</tr>
<tr>
<td>Initiatives</td>
<td>⚠ Note: This related list is available only when there is at least one</td>
</tr>
<tr>
<td></td>
<td>improvement initiative record.</td>
</tr>
<tr>
<td>Survey Recipients</td>
<td>Recipients lists that are added to the survey.</td>
</tr>
<tr>
<td>Lists</td>
<td></td>
</tr>
</tbody>
</table>

4. Save the record.

**Related information**

- Survey trigger conditions
- Publish a survey

**Schedule periods**

The available schedule periods are **Only Once, No Limit, Daily, Weekly, Monthly,** and **Yearly.**

The default schedule period is **No Limit.** When you set the schedule period to anything except **Only Once** or **No Limit,** the system creates a corresponding scheduled job. The scheduled job performs the following actions.

- Ensures that a user can take one survey instance of the same survey per schedule period.
- Generates a new survey instance for each survey user at the beginning of the new schedule period, as long as the survey user does not have an incomplete instance of that survey. A survey instance is incomplete if the state is not **Complete.**
For example, if you set the schedule period to **Monthly** and someone attempts to **send survey invitations** twice in the same day, the system generates survey instances for the survey users the first time only. At the beginning of the next schedule period, the system generates another survey instance for each survey user who completed the previous one.

Schedule periods are enforced by the **Expiration date** field on the survey instance. As long as the survey instance expiration date has not passed, the assigned user cannot receive a new survey instance. When the system generates a survey instance and the schedule period is anything except **No Limit**, the **Expiration date** field is automatically set to the appropriate date. For example, if the schedule period is **Weekly**, the expiration date is a week after the survey instance is generated.

If you change the schedule period, the scheduled job updates automatically to the correct schedule. However, users who have survey instances for the survey cannot receive new survey instances until their existing survey instances expire, regardless of the new schedule period.

Consider the following example: Sal Pindell receives a survey instance when the schedule period is **Weekly**. The next day, a survey administrator changes the schedule period to **No Limit**. Sal cannot receive another survey instance until one of the following actions occurs.

- Seven days pass from the time Sal’s survey instance was generated.
- A survey administrator deletes Sal’s survey instance.

After one of these actions occurs, Sal can receive a new survey instance anytime, as long as he has no incomplete instances of the survey.

**Note:** If you use a trigger condition for a survey, ensure the schedule period is set to **No Limit**. Trigger conditions use a different method to regulate how often users can receive survey instances.

**Related information**

- Publish a survey
- Survey trigger conditions

**Create a survey designer template question**

You can create a question that uses choice lists from a template.

**Before you begin**

Role required: admin or survey_admin
Procedure

1. Navigate to Survey > Survey Designer and load a survey or create a new survey.

2. Drag the Template data type icon into a category container.

3. Click the gear icon in the question title bar to open the template properties dialog box.

4. Select a predefined scale from the list.

Question entry fields appear for that template.

5. Enter one or more questions that are appropriate for the template.
6. Click the arrow to the right of a question to configure its properties. You must provide a name for each question.

7. Click the back arrow to return to the template properties dialog box.
8. Configure the properties for the remaining questions.
9. Click the X icon to close the template properties dialog box and save your settings.

Related information
- Survey designer elements
- Survey designer
- Edit a survey in the survey designer

Survey questions
Survey questions appear on survey questionnaires for the associated survey definition.

The survey creator generates questions and answer options automatically. However, it provides only the basic configuration options for questions, such as the question text and the data type. You may want to create additional questions or set advanced configuration options for the questions, including making a question appear conditionally or making a question mandatory. You can also use question templates to define reusable sets of answer options.

Survey questions are available from Survey > Questions. The list displays information about each question, including the associated survey definition listed in the Type column, and the data type. Survey administrators can modify these questions.

Create or modify survey questions
You can create and administer survey questions.

Before you begin
Role required: admin or survey_admin

About this task
Changes to a survey, such as the addition of questions or the modification of question templates, do not apply immediately to the existing survey instances. However, the changes apply immediately to any new survey instances that are created after the changes are saved.

Procedure
1. Navigate to Survey > View Surveys.
2. Open a survey definition.
3. In the **Metric Categories** related list, open a category.

4. In the **Assessment Metrics** related list, open an existing question or click **New**. Each survey question is stored as a record on the Assessment Metric [asmt_metric] table with a modified view for survey use.

5. Complete the Survey Question form. The fields that appear depend on the selected **Data type**.

### Survey Question form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the question. When you create a survey, the question name is the same as the text in the Question field.</td>
</tr>
<tr>
<td>Question</td>
<td>Text to use for the question, which appears on survey questionnaires.</td>
</tr>
<tr>
<td>Data type</td>
<td>Data type of the question. The fields for the response depend on the data type.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If another question depends on this question, you cannot change the data type.</td>
</tr>
<tr>
<td>Template</td>
<td>Question template to use for the answer options.</td>
</tr>
<tr>
<td></td>
<td>This field is visible and required only if the data type is <strong>Template</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If another question depends on this question, you cannot change the template.</td>
</tr>
<tr>
<td>Scale definition</td>
<td>Setting that determines whether smaller or larger numerical values equate to a good score in result calculations. Select <strong>Low</strong> if smaller numerical values are better, such as for a question that measures the number of incidents for a vendor. Select <strong>High</strong> if larger numerical values are better, such as for a question that measures user satisfaction on a scale of one to five. This field is visible and required only when certain data types are selected.</td>
</tr>
<tr>
<td>Randomize answers</td>
<td>Check box that determines whether to present the answer options for this question in a random order each time a user opens the survey. Answer preference is sometimes influenced by the order in which answer options appear, which can result in biased results. Randomize answer options to help prevent this bias. This field is visible only if the data type is <strong>Choice</strong> or <strong>Likert Scale</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>Randomizing answer options may make a question confusing. In general, only randomize answer options that do not follow a logical order.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Check box that makes the question mandatory (selected) or optional (cleared) on survey questionnaires. Users cannot submit questionnaires until they provide valid responses to all mandatory questions, which are denoted by a red field status indicator. This field is visible only when the <strong>Depends on</strong> field is empty and the data type is not <strong>Checkbox</strong>. Questions that depend on other questions and check box questions cannot be mandatory.</td>
</tr>
<tr>
<td>Allow not applicable</td>
<td>Check box that determines whether to include a <strong>Not Applicable</strong> answer option for this question on survey questionnaires. User responses of <strong>Not Applicable</strong> are excluded from results calculations. This field is visible only if the data type is <strong>Choice</strong>, <strong>Likert Scale</strong>, <strong>Template</strong>, or <strong>Yes/No</strong>.</td>
</tr>
<tr>
<td>Allow Additional Information</td>
<td>If selected, the <strong>Additional Information Label</strong> field is enabled. The <strong>Additional Information Label</strong> field value is displayed as a field on the survey response page to provide additional information for a question. <strong>Note:</strong> This is not applicable for the String and Template data types.</td>
</tr>
<tr>
<td>Depends on</td>
<td>Setting used to make this a conditional question, meaning that it only appears when users answer another question a certain way. To make a question depend on another question, select an existing question from the list, which displays <strong>Checkbox</strong>, <strong>Choice</strong>, <strong>Template</strong>, and <strong>Yes/No</strong> questions of the same category as this question. Then, use the <strong>Displayed when</strong> field to set the conditions that cause this question to appear on surveys. The system prevents the creation of recursive dependencies between questions. For example, if Question A depends on Question B, Question B cannot depend on Question A.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Displayed when</td>
<td>Answer options for the selected <strong>Depends on</strong> question which, when chosen on surveys, display this question. This field is visible and required only when the <strong>Depends on</strong> field is set.</td>
</tr>
<tr>
<td>Min</td>
<td>Smallest numerical value to be used as an answer option for this question. This field is visible and required only if the data type is <strong>Choice</strong>, <strong>Likert Scale</strong>, <strong>Number</strong>, or <strong>Percentage</strong>.</td>
</tr>
<tr>
<td>Max</td>
<td>Largest numerical value to be used as an answer option for this question. This field is visible and required only if the data type is <strong>Choice</strong>, <strong>Likert Scale</strong>, <strong>Number</strong>, or <strong>Percentage</strong>.</td>
</tr>
<tr>
<td>String option</td>
<td>Selection that determines what kind of response text box appears for this question on survey questionnaires. This field is visible and required only if the data type is <strong>String</strong>.</td>
</tr>
<tr>
<td>Source Field</td>
<td>Source table field that appears as a dynamic value for the question in a triggered survey. When this field value is selected, a ${param} placeholder is added at the end of the question label.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can move this placeholder anywhere in the question label.</td>
</tr>
<tr>
<td></td>
<td>When a user takes the survey, the question with dynamic value is included in the survey instance and ${param} placeholder is replaced with the source field value.</td>
</tr>
<tr>
<td></td>
<td>If the record table specified in the trigger condition does not match the source table specified for the survey, or if the system fails to get the dynamic value from the source record, the ${param} placeholder is not replaced by any value and is displayed as is in the question.</td>
</tr>
<tr>
<td></td>
<td>For example, if the survey is triggered from a <strong>PRB</strong> record and the survey question is configured with a dynamic value from <strong>Incident</strong>, the ${param} placeholder in the survey question label is not replaced by any dynamic value and is displayed as is.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When survey questions are translated to other languages by a survey admin, the ${param} placeholder should not be translated.</td>
</tr>
<tr>
<td>Allow Sentiment Analysis</td>
<td>Includes this question for the sentiment analysis of a survey.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available only for String type questions.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition to filter the reference records from the table specified in the Reference field.</td>
</tr>
</tbody>
</table>

⚠️ **Note:** This field appears only for the Reference metric type.

<table>
<thead>
<tr>
<th>Field validation</th>
<th>Validate the value entered for a String type metric of a survey. Possible validations are:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Email</td>
</tr>
<tr>
<td></td>
<td>• IP Address (IPV4, IPV6)</td>
</tr>
<tr>
<td></td>
<td>• Phone Number (E.164)</td>
</tr>
<tr>
<td></td>
<td>• URL</td>
</tr>
</tbody>
</table>

⚠️ **Note:** This field appears only for the String metric type.

<table>
<thead>
<tr>
<th>Related Lists</th>
<th>Answer options for this question. This related list is available only if the Data type is Choice or Likert Scale.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment Metric Definitions</td>
<td></td>
</tr>
</tbody>
</table>

6. Save the record.

⚠️ **Note:**

• Be sure to create answer options if you select the Choice or Likert Scale data type.

• You cannot delete a survey question (metric) with user responses. To delete a survey question with user responses, you should delete the responses, and then delete the survey question.

**Related reference**

Trigger condition example

**Related information**

Survey question template

Survey trigger conditions
Survey question data types
You must choose a data type for each survey question. The data type determines the format of the question and the kind of data that is collected on survey questionnaires.

The following data types are available for surveys:

Attachment data type
On questionnaires, users can attach one or more files to a question. Users click the Manage Attachments icon and select one or more files in the Attachments pop-up window to attach to the question. From this window, users can:

• View a list of the attached files.
• View an attached file in a separate window.
• Rename an attached file.
• Add or delete files

Once a survey has been submitted, attachments cannot be updated or deleted.

Any type of file supported by the platform can be attached to a question. One or more files can be attached a question while taking a survey or completing an assessment.

The assessment administrator can see the attachments associated with an individual question as well as those associated with the survey.

See Administering Attachments for more information.

Boolean data type
On questionnaires, users select a check box beside a statement or leave it cleared.

If you select Boolean, you must fill in the Scale definition field. Select High if it is best when users select the check box.

Choice data type
On questionnaires, users select a value from a list of choices.
If you select **Choice**, you must fill in the **Scale definition** field and create answer options. Select **High** for the scale definition if the answer option with the largest metric definition **Value** is best.

ℹ️  **Note:** The system sets the **Min** and **Max** fields automatically based on the **Value** settings for the associated metric definitions.

**Date and Date/Time data types**

The **Date** and **Date/Time** data types are similar.

- **Date:** On questionnaires, users select a date.
• **Date/Time:** On questionnaires, users select a date and time.

![Date/Time Example](image)

### Likert Scale data type

On questionnaires, users select a multiple choice value from a custom Likert scale. Each answer option is represented by a radio button on the scale. A Likert scale question that evaluates an application's ease of use might have the answer options **Easy, Average, and Difficult**.

![Likert Scale Example](image)

If you select **Likert Scale**, you must fill in the **Scale definition** field and create answer options. Select **High** for the scale definition if the answer option with the largest metric definition **Value** is best.

**Note:** The system sets the **Min** and **Max** fields automatically based on the **Value** settings for the associated metric definitions.

### Number data type

On questionnaires, users enter a number.

![Number Example](image)

If you select **Number**, you must fill in these additional fields:
• **Scale definition**: Select **High** if a larger number is better, such as for a question that measures the number of sales made in a quarter.

• **Min** and **Max**: Enter the smallest and largest numbers users can enter. State the range of acceptable answers in the question text.

### Percentage data type
On questionnaires, users enter a number.

![Percentage example](approximately what percent of the time are your incidents resolved in a week or less? 50 %)

If you select **Percentage**, you must fill in these additional fields:

• **Scale definition**: Select **High** if a larger percentage is better, such as for a question that measures the percentage of work an agent has completed.

• **Min** and **Max**: Enter the smallest and largest numbers users can enter. Generally 0 and 100 are appropriate minimum and maximum values. If you choose values other than 0 and 100, it is usually best to state the range of acceptable answers in the question text.

### Reference data type
On questionnaires, users select a value from a list that is generated from a specified reference table. The response field supports auto-completion.

ℹ️ **Note**: Reference qualifiers are not supported.

For example, a user could select a user name in response to a question if you specify User [sys_user] as the reference table.
String data type
On questionnaires, users enter text. When you select String, the String option field appears. Select one of the following options to determine how the string field appears on questionnaires:

- Single line

- Single line wide

- Multiline

Template data type
On questionnaires, users select a value from a predefined series of answer options. To use this data type, a question template must be defined.

If you select Template, you must fill in these additional fields:

- Template: Select a template.
- Scale definition: Select High if the answer option with the largest template definition Value is best.

Yes/No data type
On questionnaires, users select Yes or No from a list.
If you select **Yes/No**, you must fill in the **Scale definition** field. Select **High** if **Yes** is the best answer.

**Image Scale data type**

On questionnaires, users select an image from a predefined set of images as their response. Image scale questions can also be used in a template for better performance with surveys that have the same type of answer options.

Five emojis, similar to the Likert scale (very dissatisfied to very satisfied) are provided. However, you can upload additional images in JPG, PNG, or GIF format. Two images can be uploaded, one for selected case and another for unselected case. Larger size images are reduced to 64 x 64 pixels.

The result behavior depends on the presence of uploaded images. If no selected image is uploaded, then the question shows up blank.

<table>
<thead>
<tr>
<th>Selected Image</th>
<th>Unselected Image</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Unselected image loads. Clicking on the image changes it to the selected image.</td>
</tr>
<tr>
<td>Yes</td>
<td>No</td>
<td>Selected image loads with 50% opacity. Clicking on the image changes the opacity to 100%.</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>A blank placeholder box is displayed.</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>A blank placeholder box is displayed.</td>
</tr>
</tbody>
</table>

ℹ️ **Note:** N/A option is not supported for image scale type question.
Multiple selection data type

On questionnaires, users can select multiple check boxes indicating all answers that apply. For instance, a user can be instructed to “Select all that apply” in a multiple selection question.

![Multiple Selection](image)

Ranking data type

On questionnaires, users can select a different order number for each option to rank them. Drag-and-drop functionality is also supported, which allows a user to either fill in the number, or simply drag an option.

![Ranking](image)

One order number cannot be selected twice. This question can be mandatory and it can also be dependent on a parent question, but not vice versa.

Related information

Survey question template

Survey question template

Question templates define reusable sets of answer options for survey questions.

Question templates define reusable rating scales for answering questions, where each answer option on the scale is a template definition. For example, the template named **Satisfaction** represents a satisfaction scale and contains the...
following template definitions: **Very Satisfied**, **Satisfied**, **Neutral**, **Dissatisfied**, and **Very Dissatisfied**.

**Template definition**

Templates are available for survey questions that have **Data type** set to **Template**. The following question templates are available in the base system. You can create or update a template as described in **Create a survey question template**.

**Default question templates**

<table>
<thead>
<tr>
<th>Name</th>
<th>Template definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>None, Few or little, Average amount, Many, Quite a lot</td>
</tr>
<tr>
<td>Complexity</td>
<td>Very Complex, Complex, Moderate, Simple, Very Simple</td>
</tr>
<tr>
<td>Frequency</td>
<td>Never, Seldom, Sometimes, Most of the time, All of the time</td>
</tr>
<tr>
<td>Likert 5</td>
<td>Strongly Disagree, Disagree, Neutral, Agree, Strongly Agree</td>
</tr>
<tr>
<td>Quality</td>
<td>Very Poor, Poor, Average, Good, Very Good</td>
</tr>
<tr>
<td>Satisfaction</td>
<td>Very Dissatisfied, Dissatisfied, Neutral, Satisfied, Very Satisfied</td>
</tr>
<tr>
<td>Size</td>
<td>Very Small, Small, Average, Large, Very Large</td>
</tr>
</tbody>
</table>

**Create a survey question template**

You can create and administer question templates.

**Before you begin**

Role required: admin or survey_admin

**About this task**

Changes to a survey, such as the modification of question templates, apply to existing survey instances immediately. Templates that you create are available for use with both surveys and assessments.
Procedure

1. Navigate to Survey > Templates.
   Each template is stored as a record on the Assessment Metric Template [asmt_template] table.

2. Click New.

3. Enter a Name.

4. Right-click the form header and click Save.

5. In the Assessment Template Definitions related list, click New.
   Create a template definition for each answer option you want to appear on a question.

6. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Enter the text to appear as the answer option.</td>
</tr>
<tr>
<td>Value</td>
<td>Enter a numeric value, greater than or equal to zero, to which the answer option equates. Values are used in results calculations. When you view questions that use templates, answer options appear in order from smallest to largest Value. Each template definition for a given template must have a unique Value.</td>
</tr>
</tbody>
</table>

7. Click Update.

Update min and max values to match templates

If you use survey result calculation data, ensure that the Min and Max values for a question that uses a template are equal to the smallest and largest template definition Value.

Before you begin
Role required: admin or survey_admin

About this task
When you create a question of the Template data type, the system sets the Min and Max fields based on the template definition values. The fields for existing questions are not updated if you add a new template definition to a template or if you update the Value of an existing template. If the new Value is less than the minimum value or greater than the maximum value of any questions that use the template, update the questions accordingly.
Procedure
1. Navigate to Survey > Questions.
2. Configure the list to show the Min and Max columns.
3. Add the following list filter condition: [Template] [is] [<select the template you updated>].
4. Ensure the Min and Max values match the smallest and largest template definition Value for the selected template.
   If the values do not match, edit the Min and Max values directly from the list.
   
   Note: When the data type is Template, a UI policy prevents the editing of Min and Max from the form.

Add a metric category and metric in the question bank for surveys
Reuse the question categories (metric categories) and questions (metrics) added in the question bank for surveys. You can add metric categories or metrics from the question bank to a survey, or from the survey to a question bank.

Before you begin
Role required: admin or survey_admin
Activate the Survey Question Bank Sample Data plugin (com.snc.question_bank_data) to access the demo data for the question bank.

Procedure
1. Navigate to Survey > Question Bank.
2. Click New.
3. In the Metric Category form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the metric category.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the metric category.</td>
</tr>
<tr>
<td>Total metrics</td>
<td>Total number of metrics in the metric category. This number is automatically updated when you add or delete metrics from the category.</td>
</tr>
</tbody>
</table>

4. Right-click on the title bar and click Save.
5. In the Assessment Metrics related list, click New.
6. In the Survey Question form, fill the fields. For information on these fields, see Create or modify survey questions.

7. Click Submit.

Configure metric categories or metrics for a survey using the question bank

Reuse question categories (metric categories) and questions (metrics) from the Question Bank module while creating or updating a survey.

Before you begin
Role required: admin or survey_admin
Activate the Survey Question Bank Sample Data plugin (com.snc.question_bank_data) to access the demo data for the question bank.

Procedure

1. Navigate to Survey > View Surveys.

2. Open a survey definition.

3. Optional: To add metric categories to a survey from the question bank in Platform, perform the following steps.

   a. In the Metric Categories related list, click New Category from Bank. The New Category from Bank dialog box is displayed with a list of all metric categories added in the question bank.

   b. Select the required categories and click Add Selected. A copy of the metric category and the corresponding metric definitions is created in the Metric Categories related list.

4. Optional: To add metrics to a survey from the question bank in Platform, perform the following steps.

   a. In the Metric Categories related list, open a metric category definition.

   b. In the Assessment Metrics related list, click New Metric from Bank. The New Metric from Bank dialog box is displayed with a list of questions available in the question bank.

   c. Select the required metrics and click Add Selected. A copy of the metric and the corresponding metric definitions is created in the Assessment Metrics related list of the category.

5. Optional: To add a metric category to the question bank from a survey in Platform, perform the following steps.
a. In the Metric Categories related list, open a metric category definition.

b. Click Add to question Bank.
   A copy of the category is created along with its metrics and metric definitions in the question bank.

6. Optional: To add a metric to the question bank from a survey in Platform, perform the following steps.

a. In the Metric Categories related list, open a metric category definition.

b. In the Assessment Metrics related list, open the required metric definition.

c. Click Add to Question Bank.
   The Add to Question Bank dialog box is displayed.

   d. In the Choose a question bank to add this question/metric field, select a metric category that you want to add this metric to, and click OK.
      A copy of the metric and the corresponding metric definitions is created for the selected category in the question bank.

7. Optional: To add a metric category or metric to a survey from the question bank in Survey designer, perform the following steps.

a. Open the survey in Survey Designer.

b. Optional: To add a metric category from the question bank, from the Categories tab in the left panel, drag the required category banner and drop in the Design tab.

c. Optional: To add a metric from the question bank, drag and drop the required metric from the Questions tab or the Categories tab.

Note:

- When you drag and drop a metric category, all dependencies within the category are also added to the survey.
- From the Categories tab, you can drag and drop an individual metric within a metric category.
- When you drag and drop a parent metric, all dependent questions are also added to the metric category.
- When you drag and drop a child metric, only the child question is added to the metric category.
Create or modify answer options

You must create answer options, called metric definitions, for survey questions that have **Data type** set to **Choice** or **Likert Scale**.

**Before you begin**
Role required: admin or survey_admin

**About this task**
Changes to a survey, such as the addition or modification of answer options, apply to existing survey instances immediately.

**Procedure**

1. Navigate to **Survey > Questions**.
2. Open a choice or Likert scale survey question.
3. In the **Assessment Metric Definitions** related list, open a metric definition or click **New**.
   Each answer option is stored as a record on the Assessment Metric Definition [asmt_metric_definition] table.
4. Complete the Assessment Metric Definition form.

**Assessment Metric Definition fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Text to appear as the answer option.</td>
</tr>
<tr>
<td>Value</td>
<td>Numeric value, greater than or equal to zero, to which the answer option equates. Values determine the order in which answer options appear. See the example below. Values are also used to calculate survey results. Each metric definition for a given question must have a different <strong>Value</strong>.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Example:**
On survey questionnaires, the answer options for a question appear in order from smallest to largest **Value**. For example, consider the survey question **How do you feel?** with the answer options **Good**, **Neutral**, and **Bad**. The following table shows the answer option order based on the **Value**.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc. in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Answer option order based on value

<table>
<thead>
<tr>
<th>Answer option</th>
<th>Value</th>
<th>Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good</td>
<td>1</td>
<td>First</td>
</tr>
<tr>
<td>Neutral</td>
<td>3</td>
<td>Second</td>
</tr>
<tr>
<td>Bad</td>
<td>5</td>
<td>Third</td>
</tr>
</tbody>
</table>

If you use survey result calculations, ensure the question **Scale definition** is set appropriately based on the answer options. In the previous example, if you want the answer option **Good** to earn the highest score, the scale definition should be **Low** because **Good** has the smallest value.

### Change the order of survey questions

You can easily reorder survey questions at the category level or the question level.

**Before you begin**
Role required: admin or survey_admin

**About this task**
You can change the order in which the questions in one category appear relative to those in other categories for the same survey definition. If you add a new question manually after you create other questions, you may want to change the order of questions.

When you create questions using the survey creator, the system sets the **Order** field for the first question to 101, the second to 102, and so on. After you create a new question outside of the survey creator, the **Order** is set to 100 by default, which means it appears before all questions generated by the survey creator.

**Procedure**

1. Navigate to **Survey > View Surveys** and open the appropriate survey definition.
2. In the **Metric Categories** related list, edit the values in the **Order** column.
3. To change the order of questions within a category, complete the following steps.
   a. Open the **Assessment Metrics** related list.
   b. Edit the values in the **Order** column.
4. Click **Update**.
**Survey trigger conditions**

Trigger conditions specify when to send a particular survey and the persons to send it to.

Survey administrators can use trigger conditions to configure the system to generate a survey instance each time a specified action occurs on a specified table, for example, when an incident or change request closes. The system sends the survey to users that are related to the triggering record, for example, incident callers or change request assignees. You can choose to send a survey every time the condition is met, or you can set a probability for the system to send a survey at random when the condition is met.

Trigger conditions are ideal for sending transactional surveys. Transactional surveys generally measure satisfaction with a recent experience, such as closing an incident or purchasing an item.

 articulate p Note: Trigger conditions are comparable to survey conditions in legacy surveys. If you migrate a legacy survey that has survey conditions, ensure that the survey conditions are deactivated before you recreate them as trigger conditions.

**Configure a trigger condition for a survey**

Configure trigger conditions to specify when to send a particular survey and the persons to send it to.

**Before you begin**

Role required: admin or survey_admin

**Procedure**

1. Navigate to Survey > Trigger Conditions.
2. Click New.

 articulate p Note: Do not specify particular users for a triggered survey because only the specified users are allowed to take the survey.

3. Complete the form.

**Trigger condition fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment</td>
<td>Survey to send.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to run the trigger condition on. You can select only tables in the current application scope. For example, to send a survey</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| whenever an incident closes, select the Incident [incident] table. | User field: Field that stores the users you want to send the survey. You can select any field, on the selected table or on a referenced table, that references the User [sys_user] table. Use the tree picker to select a field.  
- **Note:** To avoid requiring users to log in to take a survey with a trigger condition, set the survey to **Public**.

Minimum period that must pass before the trigger condition can resend the survey to the same user. For example, assume the repeat interval is set to 30 days. Even if the same user qualifies for multiple surveys from this trigger condition, the system can send only one survey every 30 days.  
- **Note:** Ensure that the Schedule period of the selected survey definition is set to **No Limit**. If the schedule period is set to a different value, it prevents the trigger condition from sending surveys as expected.

[Admin only] Application is set to Core.  

Check box that determines whether this trigger condition is active (selected).  

[Admin only] Business rule the system creates to monitor the selected table. When the condition is met, the business rule sends the survey to the correct user. No configuration is necessary for this business rule.  

Check box that determines whether to send the survey to the appropriate user every time the condition is met (cleared) or only a percentage of the time (selected).  

Approximate probability that the survey is sent each time the condition is met. For example, if the probability is set to 50, the system sends the survey approximately 50% of the time the conditions are met. There are no repeat interval restrictions is assumed. This field is visible and required only when **Trigger randomly** is selected.  

Field that contains a value you want to store for reporting purposes. You can pick any reference field on the selected table. When the trigger condition generates a survey instance,
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>the system stores the value from the triggering record. Specify up to four fields.</td>
</tr>
<tr>
<td></td>
<td>For example, select the Incident table, <strong>Assigned to</strong> and <strong>Problem</strong> as related fields. The system stores the assigned user and problem associated with the incident as Related record 1 and Related record 2 in the survey instance record. To view the fields, configure the form for any survey instance.</td>
</tr>
<tr>
<td>Note</td>
<td>You cannot use a related field for the ticket number because you cannot select the Number column. You can, however, use the trigger_id column of the table.</td>
</tr>
<tr>
<td>Description</td>
<td>Summary information to identify the trigger condition.</td>
</tr>
<tr>
<td>Note</td>
<td>For a triggered record, the table title is used for the survey description.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition builder that defines the criteria that must be true to send the survey. For example, to send a survey whenever an incident closes, create the condition <strong>[State] [is] [Closed]</strong>.</td>
</tr>
<tr>
<td>Note</td>
<td>When defining conditions like case sensitivity or null values, see API GlideFilter - Scoped, Global.</td>
</tr>
</tbody>
</table>

You can also create a trigger condition directly from the survey creator. If you select **Certain users can take this survey, based on conditions** in the Survey User Access section, the Trigger Condition form opens automatically when you click **Save as Draft** or **Publish**.
Related information

Schedule periods

Trigger condition example

You can send out auto-triggered surveys when an incident is closed or resolved.

A trigger condition is configured as follows:

- **Assessment**: Service Desk Satisfaction Survey
- **Table**: Incident [incident]
- **User field**: Caller
- **Repeat interval**: 30 days
- **Active**: true
- **Trigger randomly**: false
- **Related Field 1**: Assigned to
- **Related Field 2**: Problem
- **Condition**: [State] [is] [Closed] [or] [State] [is] [Resolved]

Fannie Steese is the caller on incident INC00004305 that is assigned to Boris Catino, a service desk technician. Boris creates PRB010101 based on Fannie’s complaint and closes the incident. The system creates a survey instance assigned to Fannie so she can rate her satisfaction with the incident experience.
Because two related fields were selected as part of the trigger condition, the survey instance stores the following information from the incident:

- User (Related Field 1): **Boris Catino**
- Problem (Related Field 2): **PRB010101**
- Task (automatically created): **INC00004305**

Because the task field is automatically populated, UI-based filtering by dot-walking on incidents (or any task-based table) is supported when creating a report on survey results. For example, you can query all survey instances related to incidents assigned to a group (survey reports on all incidents assigned to networking group, for instance).

**Note:** Even though the trigger condition is set to be triggered each time that the conditions are met, the Repeat interval setting ensures that Fannie does not receive another survey for another of her incidents closes within 30 days of the first incident.

**Survey report example based on task field**

One of the most common use cases for Surveys is to send out an auto-triggered survey when an incident, request, or task is closed. Once you get the survey results back, you can filter the results by users and groups related to the ticket, such as Assignment Group, or Assignee.

Filtering the survey results provides more detail on how people and teams are performing based on ticket data. Since this information is automatically captured, you can dot-walk while filtering the data (instead of utilizing a related field on the Survey trigger condition form, as previously required).

To create a report on incident-triggered survey responses by Assignment group, set up the report on the Task Assessment Details by navigating to ReportsView/Run and clicking Create a report.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Survey distribution

There are several ways for survey administrators to distribute surveys to users.
Surveys are distributed using any of the following methods.

- Send survey invitations to users
- Share a survey URL that opens the survey directly.
- Create a module that opens a survey.

Send survey invitations to users

You can send survey invitations using the Assign Survey or Send Invitations buttons on the Survey Definition form.

Before you begin
Role required: admin or survey_admin

About this task
Use the Send Invitations button to immediately assign survey instances to each survey user that is listed in the survey definition. Use the Assign Survey button to assign a survey instance to any one user at a time.

Each of the buttons generates survey instances assigned to the appropriate users. In addition, if the instance is configured to send email, the system generates survey notifications. For either button to be available, the survey definition must meet all of the following conditions.

- Active check box is selected.
- State is Published.
- Survey is associated with at least one question.
Note: You (or a trigger) can send more than one instance of a survey to a user at any time.

Procedure
1. Navigate to Survey > View Surveys.
2. Select an active, published survey.
3. Complete one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign a survey to users listed in the Survey Users related list</td>
<td>Click Send invitations.</td>
</tr>
<tr>
<td>Assign a survey to any user</td>
<td>Click Assign Survey and select one or more users, and then click OK.</td>
</tr>
</tbody>
</table>

The system creates a survey instance assigned to the user or users, assuming the user is eligible to receive a new survey instance. When you use the Assign Survey button, the selected user is not saved as a survey user.

Define a recipients list for surveys
Use a recipients list to define targeted set of users for whom the survey invite can be sent. You can use a recipients list for multiple surveys.

Before you begin
Role required: admin or survey_admin

Procedure
1. Navigate to Survey > Administration > Recipients Lists.
2. Click New.
3. In the Recipients List form, add the field information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the recipients list.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of users to include in the list. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>• Contacts</td>
</tr>
<tr>
<td></td>
<td>• Internal Users</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>State</td>
<td>State of the recipients list.</td>
</tr>
<tr>
<td></td>
<td>• <strong>New</strong>: List has not yet been generated.</td>
</tr>
<tr>
<td></td>
<td>• <strong>In Progress</strong>: List is currently being generated. (You can see this state only when generating a very large list of recipients.)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Complete</strong>: List is generated.</td>
</tr>
<tr>
<td>Setup</td>
<td>Method used to generate the recipients list. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Upload File</strong>: Upload an Excel file with the recipients list using the specified template.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Dynamic Condition</strong>: Run a script or condition builder to create the recipients list.</td>
</tr>
<tr>
<td>Choose File</td>
<td>Allows you to download an Excel template, and then upload the Excel file with user information using the specified template.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• This field is available only if the <strong>Method</strong> is <strong>Dynamic Condition</strong>.</td>
</tr>
<tr>
<td></td>
<td>• The templates vary based on the entity selected in the <strong>Type</strong> field. For accounts, the template includes columns for sys_id and account number values. For contacts, consumers, and internal users, the template includes columns for sys_id and email values.</td>
</tr>
<tr>
<td>Show Script</td>
<td>If selected, displays the script to create the recipients list.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is available only if the <strong>Method</strong> is <strong>Dynamic Condition</strong>.</td>
</tr>
<tr>
<td>Script</td>
<td>Script to create the recipients list.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is available only if the <strong>Method</strong> is <strong>Dynamic Condition</strong> and the <strong>Show Script</strong> check box is selected.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that stores the user information. The table is selected based on the <strong>Type</strong> field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is available only if the <strong>Method</strong> is <strong>Dynamic Condition</strong>.</td>
</tr>
<tr>
<td>User Field</td>
<td>Table field that refers to users.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Note:</td>
<td>This field is available only if the Method is Dynamic Condition.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Condition builder to create the recipients list based on the specified table and user field. A condition is made up of a selected field, an operator, and a value. Add conditions using the AND and OR buttons. Delete conditions by clicking the Delete button to the right of a condition.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field is available only if the Method is Dynamic Condition.</td>
</tr>
</tbody>
</table>

Note: When the Method is Dynamic Condition, you can either use a script or a condition builder to create the recipients list.

4. Click **Submit**.
   For recipients lists created by the file upload, clicking **Submit** validates the records in the Excel file. Following validation, the system displays a pop-up window with the upload results, including valid and invalid user records.

5. **Optional:** To get the updated user list, navigate to the recipient list and click **Refresh Recipient List**.

Add a recipients list to a survey
Send the survey invites to targeted sets of users by adding a recipients list to a survey.

**Before you begin**
Role required: admin or survey_admin
Recipients lists should be pre-defined in the Recipients Lists submodule. For more information on defining recipients lists, see Define a recipients list for surveys.

**Procedure**
1. Navigate to **Survey > View Surveys**.
2. Open a survey definition.
3. Perform any of the following steps.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Platform</td>
<td>a. Under the <strong>Survey Recipients Lists</strong> related list, click <strong>New</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. In the Survey Recipients Lists form, from the <strong>Recipients List</strong> list, select the required recipients list.</td>
</tr>
<tr>
<td></td>
<td>c. Click <strong>Submit</strong>.</td>
</tr>
<tr>
<td>From Survey Designer</td>
<td>a. Under the <strong>Availability</strong> tab, for the <strong>Accessible By</strong> field, select <strong>Specific users</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. In the <strong>Add recipients lists</strong> list, select the required recipients list.</td>
</tr>
<tr>
<td></td>
<td>c. To send the survey to users, click <strong>Save and Publish</strong>.</td>
</tr>
</tbody>
</table>

4. To send survey invites to all survey users and recipients lists, click **Send Invitations**.

**Note:**
- The **Send Invitations** UI action is available when there is at least one recipients list or survey user for the survey.
- If a user is available in the **Survey Users** related list and multiple recipients lists, the survey invite is sent only once to the user.

**Embed a survey within the Outlook email client**

Embed an interactive survey in the email notification sent to a user. The user can answer the survey questions and submit the survey from the email client instead of opening the survey in a new browser tab.

**Before you begin**
Role required: admin or survey_admin
The Outlook Actionable Messages plugin (com.sn_ms_oam) should be activated.
Note:

- The Outlook Actionable Messages (OAM) feature is not supported in all Microsoft mail products and versions. To verify whether your version of Outlook supports OAM, refer to the Microsoft website.

- Actionable messages are supported only for emails sent from the @service-now.com email address. If you are sending an email from a customized email address, you should register as a new service in the Microsoft website setting the scope as Organization. Specify the provider ID value in the sn_ms_oam.outlookactionable.originator property.

- Actionable messages are based on the Sender Policy Framework (SPF)/DomainKeys Identified Mail (DKIM) validation for the email sender verification. If an email recipient receives email via an external provider, emails may are not rendered as adaptive cards.

- You cannot customize the default actionable message templates.

Procedure

1. Navigate to System Notification > Email > Notifications.

2. For the Survey User Invite notification, in the What it will contain tab, add the following script in the Message field in addition to the existing information.

   ```
   ${mail_script:include_survey_actionable}
   ```

   This script includes the Outlook actionable message in the email notification sent to the user.

3. Navigate to Survey > View Surveys, and open a survey.

4. To send an email notification to the survey user, select the Send notifications check box.

5. Select the Outlook Actionable Message check box and save the survey.
Note:

- The following questions are not supported for an embedded survey:
  - Attachment
  - Date
  - Datetime
  - Template
  - Reference
  - Image Scale
  - Ranking
- Dependent questions are not supported.
- Signature is not supported.
- Mandatory questions are supported.

In both the Platform UI and Survey Designer, a validation is run to ensure all survey questions are supported.

6. Click Assign Survey and assign the survey to a user. An email notification with the embedded survey is sent to the user. The user can take the survey and submit it from the email client instead of opening the survey in a new browser tab.

Enable localization for a survey

Enable a survey user to take a survey in multiple languages.

Before you begin

Role required: admin or survey_admin
The plugin for the language that you want the survey to be available in should be installed.

Note: Localization is applicable only for public surveys.

Procedure

1. Navigate to Survey > Administration > Properties.

2. Enable the Enable/Disable whether to show language picker when a public survey is taken (show_lang_picker_for_publicsurveys) property.

3. In the System Settings window, from the Language list, select the language that you want the survey to be available in.
Note: The Language list is available only when a language plugin is installed.

4. Navigate to Survey > View Surveys and open a public survey.
5. Enter the translated text for the survey title, questions, and answers.
6. Save and publish the survey.

Note: The localization is also applicable in Service Portal if the Assessment Properties Allow survey link from email to open in service portal view (applies only for surveys) (sn_portal_surveys.sp_survey.email_redirection) property is enabled.

- The survey is available for survey users in the translated language.
- Users can change the language of the survey using the language picker.

Survey URLs
You can distribute a survey by giving survey users a survey URL.

Survey administrators can obtain one of the following types of URLs.

- A general URL for a survey, which users can open to take the survey questionnaire. The following process occurs.
  - When someone opens the URL, the system ensures that the person is logged in. It then searches for an instance of the associated survey that is assigned to the logged-in user.
  - If a survey instance is found, the appropriate action occurs based on the State of the survey instance (see table). If there are multiple active survey instances (Ready to take or In progress), the instance with the earliest due date opens.
  - If no survey instance is found, the system creates a new instance for the survey, assigns it to the user, and opens the survey questionnaire.

- A URL for a specific survey instance, which the assigned user can open to take the survey questionnaire. The following process occurs.
  - When someone opens the URL, the system ensures the person is logged in as the user the survey instance is assigned to. Only the assigned user can access the survey questionnaire.
  - The appropriate action occurs, depending on the State of the survey instance (see table).
### Survey states

<table>
<thead>
<tr>
<th>Survey instance state</th>
<th>Action upon opening URL</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ready to take:</strong></td>
<td>The survey questionnaire appears for the user to begin. The user can save or submit responses.</td>
</tr>
<tr>
<td>User has not saved any responses.</td>
<td></td>
</tr>
<tr>
<td><strong>In progress:</strong></td>
<td>The survey questionnaire appears for the user to continue. Any previously saved responses are displayed. The user can save or submit responses.</td>
</tr>
<tr>
<td>User has saved at least one response.</td>
<td></td>
</tr>
<tr>
<td><strong>Complete:</strong></td>
<td>If the schedule period is <strong>No Limit</strong> or if the period restriction has expired, the survey questionnaire for a new survey instance appears for the user to begin.</td>
</tr>
<tr>
<td>User has submitted all required responses.</td>
<td></td>
</tr>
<tr>
<td>If the schedule period restricts the number of times a user can take the same survey, and the period restriction has not expired since the user last completed survey, an error message appears.</td>
<td></td>
</tr>
</tbody>
</table>

If someone opens a URL for an unpublished or deactivated survey, an error message appears.

### Obtain and distribute a general survey URL

You can distribute a general survey URL to allow any eligible user to open a survey questionnaire.

**Before you begin**

Role required: admin or survey_admin

**About this task**

The general URL is available on the Survey Definition form and on the survey creator. You can also email the URL for a public survey that is published.

**Procedure**

1. Navigate to **Survey > View Surveys**.
2. Open a survey definition from the Assessment Metric Types list.
3. To view or copy the URL, click the **View Survey URL** related link.
   This related link is visible only if the survey definition is **Active**.
4. To distribute the URL to users, paste the copied URL as desired, or click the Email button to send via email. The Email button is visible only for a public survey that is published.

What to do next
When a survey user clicks the general survey URL, the system creates a survey instance for the survey user as long as the user does not have an instance in the Ready to take state. The system is configured by default to send an email notification when a survey instance is generated.

As a result, the survey user receives a second notification in addition to the notification that you sent with the general survey URL. This may confuse the survey user. To avoid this issue, you can deactivate auto-notification.

Deactivate auto-notification for surveys
When you send a survey notification with a general survey URL to a survey user, the user may receive a second system-generated notification. To avoid this issue, you can deactivate auto-notification.

Before you begin
Role required: admin or survey_admin

Procedure
1. Navigate to System Notification > Email > Notifications.
2. Open the Survey User Invite notification.
3. Configure the form to add the Send to event creator check box to the Who will receive section.
   The Send to event creator check box is selected by default.
4. Clear the Send to event creator check box.
   The system will no longer send auto-notification messages to survey users.

Obtain a survey instance URL
You can distribute a survey instance URL to allow the assigned user to open a survey questionnaire.

Before you begin
Role required: admin or survey_admin

About this task
The survey instance URL is available on the survey instance record.
Procedure
1. Navigate to **Survey > Survey Instances**.
2. Open the instance for the survey.
3. To view or copy the URL, click **View Instance URL** related link.
   The related link is available only when the survey instance **State** is **Ready to take** or **In progress** and the associated survey definition is **Active**.
4. In the dialog box, select and copy the URL then click **OK** or **Cancel**.
5. Distribute the URL to the assigned user.

Test a survey URL
When there are survey users associated with a survey, the survey is restricted so only those users can use the survey URL. You can test the survey URL to ensure it is restricted.

**Before you begin**
Role required: admin or survey_admin

Procedure
1. Navigate to **Survey > View Surveys** and open a survey for which you are not a survey user.
2. Under **Related Links**, click **View Survey URL**.
3. Copy the URL and click **OK** or **Cancel**.
4. Navigate to the URL.
   You see a message that you are not authorized to take the survey.

Create a survey module
You can create a module that opens a survey.

**Before you begin**
Role required: admin or survey_admin

**About this task**
When a user clicks a survey module, the system performs one of the following actions, depending on the configuration options for the survey and other factors.
• Creates a new survey instance
• Opens an existing survey instance
• Displays an error message.

**Procedure**

1. Perform the appropriate action for your version of the UI:
   - **UI16**: Point to the application menu that contains the module to which you want to add the survey module and click the edit application (pencil) icon.
   - **UI15**: Right-click the application menu you want to add the module to and select *Edit Application Menu*

2. In the **Modules** related list, click **New**.

3. Complete the following fields.
   - **Link type**: Assessment
     Do not select **Survey**, which is used for legacy surveys only.
   - **Assessment**: Select the survey you want the module to open.

4. Complete and save the form.

**Sharing surveys: export and import**

You can export a survey and then import it to a different ServiceNow instance.

⚠️ **Note**: Update sets are available in the Helsinki release and should be used to move data from one instance to another. For information about update sets, see *System update sets*.

The system exports a single XML file that contains a survey definition [asmt_metric_type] and the associated records, including the following.

• Assessment Metric Template [asmt_template]
• Assessment Template Definition [asmt_template_definition]
• Metric definitions [asmt_metric_definition] (survey question answer options)
• Scheduled Jobs associated with the Survey [sys_trigger]
• Survey categories [asmt_metric_category]
• Survey questions [asmt_metric]
• Survey users [asmt_m2m_category_user]
• Trigger Condition [asmt_condition]
Export a survey
You can export a survey and then import it to another instance.

Before you begin
Role required: admin, survey_reader, or survey_admin
For information about update sets, see System update sets.

Procedure
1. Navigate to Survey > View Surveys.
2. Right-click the name of a record to show the context menu.
3. Select Export Assessment.
4. If applicable, follow the prompt in your browser to save the XML file.

Import a survey
You can import a survey that has been exported as an XML file. The exported XML file does not contain result data.

Before you begin
Role required: admin or survey_admin

Note: Update sets are available in the Helsinki release and should be used to move data from one instance to another. For information about update sets, see System update sets.

About this task

Procedure
1. Verify that the target instance has assessments enabled.
2. Follow the steps in to import the assessment.

Use update sets for surveys and assessments
Use an update set to capture changes to surveys and assessments.

Before you begin
Role required: admin or survey_admin
When developing surveys and assessments, you can use an update set to capture the changes and move them from a development instance to a production instance. Once an update set is created and marked current, all of the updates to the following tables are recorded in the update set.
The following tables are now update set enabled and also extend the application file:

- Assessment Metric Templates [asmt_template]
- Assessment Template Definitions [asmt_template_definition]
- Assessment Metric Definitions [asmt_metric_definition]: survey question answer options
- Schedule [sys_trigger]: scheduled jobs associated with the survey
- Assessment Metric Categories [asmt_metric_category]: survey categories
- Assessment Metrics [asmt_metric]: survey questions
- Assessment Category Users [asmt_m2m_category_user]: survey users
- Trigger Conditions [asmt_condition]

Configure a survey in the Connect chat support

Enable a user to take a survey after chatting with a survey agent.

Before you begin
Role required: admin or survey_admin

⚠️ Note: The Connect Support plugin (com.glide.connect.support) should be activated.

Procedure

1. Navigate to Connect Support > Support Administration > Chat Survey.
2. Click New.
3. In the Chat Survey form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey</td>
<td>Survey whose instance should be available in Connect Support.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of chat where the survey is available.</td>
</tr>
<tr>
<td></td>
<td>• Connect: Survey is available in Connect Support.</td>
</tr>
<tr>
<td>Chat queue</td>
<td>Chat queue where the survey is available.</td>
</tr>
<tr>
<td>Active</td>
<td>Specifies if the chat survey configuration is active.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the chat survey configuration.</td>
</tr>
</tbody>
</table>
4. Click Submit.
   When a support agent of the assignment group associated with the chat queue ends a chat with a user, the survey instance is available in the chat window for the users.

Related information
   Monitor incoming Connect Support conversations

Outlook Actionable Messages
Outlook actionable messages plugin enables users to respond to the survey from within the Microsoft Outlook application.

Install Outlook Actionable Messages plugin
Install Outlook Actionable Messages(sn_ms_oam) plugin to configure actionable messages.

Before you begin
Role required: oam_admin

Procedure
1. Navigate to System Application > All Available Applications > All.
2. In the search field, enter Outlook Actionable messages.
   You can search for the application by its name or ID. If you cannot find an application, you may have to request it from ServiceNow store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release note information for all released apps, see the ServiceNow Store version history release notes.
3. Click Install.

Customize fields for the approval message
Customize the body message for a request, change, and request item approval sent in Microsoft Outlook.

Customize fields in the approval message for request
Customize the body message for a request and request item sent in Microsoft Outlook.

Before you begin
Role required: oam_admin
Procedure

1. Navigate to **Actionable Messages > OAM Definition**.

2. Choose one of the following:

<table>
<thead>
<tr>
<th>OAM definition</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request</td>
<td>Click <strong>OAM Request Approval</strong></td>
</tr>
<tr>
<td>Request Item</td>
<td>Click <strong>OAM RITM Approval</strong></td>
</tr>
</tbody>
</table>

3. In the OAM Container section, customize the following fields as required:
   
   a. **Title**: Title of the Outlook approval notification.
   
   b. **Requester info**: User who created the request.
   
   c. **Request Details**: This field can be customized. You can also add additional fields as per the requirement.

4. Click **Update**.

The approval message is displayed in Microsoft Outlook as shown below. Click **View Details** button to view the request in ServiceNow instance.

---

**Customize fields in the approval message for change request**

Customize the body message for a change request approval sent in Microsoft Outlook.

**Before you begin**

Role required: oam_admin
Procedure
1. Navigate to Actionable Messages > OAM Definition.
2. Click OAM Change Approval.
3. In the OAM Container section, customize the following fields as required:
   a. Title: Title of the Outlook approval notification.
   b. Requester info: User who created the request.
   c. Request Details: This field can be customized. You can also add additional fields as per the requirement.
4. Click Update.

The approval message is displayed in Microsoft Outlook as shown below. Click View Approval Request to view the request in ServiceNow instance.

Enable Advanced view for Outlook Actionable Message definition
Enable the advanced view to customize the actionable message as per the requirement for Microsoft Outlook.

Before you begin
Role required: oam_admin

Procedure
1. Navigate to Actionable Messages > OAM Definition.
2. Choose one of the following:
### OAM definition

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request</td>
<td>Click OAM Request Approval</td>
</tr>
<tr>
<td>Request Item</td>
<td>Click OAM RITM Approval</td>
</tr>
<tr>
<td>Change</td>
<td>Click OAM Change Approval</td>
</tr>
</tbody>
</table>

3. Click **Advanced OAM** under **Related Links**.

4. In the OAM Definition form, perform the following actions:
   
   a. Modify the script as required.
   
   b. Click **Update**.

### Sentiment analysis for surveys

You can use sentiment analysis to determine whether user responses for a survey are considered positive, negative, or neutral.

Activate the Sentiment Analysis (com.snc.sentiment_analysis) plugin.

For a survey, you can select questions that should be used for analysis. The survey responses of these questions are sent to the third-party platforms for analysis through the specified connector configurations.

**Note:** You can only use string type questions for sentiment analysis.

The sentiment analysis results are displayed under **Survey > Question Sentiment Results**. The sentiment label is based on the normalized score:

<table>
<thead>
<tr>
<th>Normalized score</th>
<th>Sentiment label</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1 to 0</td>
<td>Negative</td>
</tr>
<tr>
<td>0</td>
<td>Neutral</td>
</tr>
<tr>
<td>0 to 1</td>
<td>Positive</td>
</tr>
</tbody>
</table>

### Configure a sentiment connector

Specify the service URL and other configuration information for third-party APIs that are used for sentiment analysis.

**Before you begin**

Role required: admin
Procedure

1. Change the scope of the current session to **Sentiment Analysis**.

2. Navigate to **Sentiment Analysis > Sentiment Connector Configurations**.

3. Add or edit the connector configuration for a third party vendor such as Google, IBM Watson, and MS Azure.

   **Note:** By default, placeholders are available for configuring connectors for Google, IBM Watson, and MS Azure.

   **Sentiment connector fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the sentiment analysis connector configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the connector configuration.</td>
</tr>
<tr>
<td>Credential Alias</td>
<td>Credential alias associated with the connector configuration. It has a reference to the system level table (sys_alias_list).</td>
</tr>
<tr>
<td>Default</td>
<td>Check box to make this as the default connector configuration.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the connector configuration.</td>
</tr>
<tr>
<td>Script</td>
<td>Script to call the Sentiment Analysis API and the normalize the values.</td>
</tr>
</tbody>
</table>

4. Configure the connector credentials

   a. Open the record referred in the **Credential Alias** field.

   b. Under the **Connections** tab, select the connection.

   c. In the **Connection URL** field, enter the value.

   d. Open the record referred in the **Credentials** field.

   e. Enter the credential information.
Note:

- You should obtain the connection credentials from the respective third-party vendors.
- If the credential is an API key, specify its value. If the credential is basic authentication, that is, user name and password, specify the corresponding information.

f. Select the Active check box and click Update.

5. Select the Active check box for the connector configuration and click Update.

Sentiment analysis properties

You can use the sentiment analysis properties to customize the Sentiment Analysis module.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response time for the outbound call of Sentiment Analysis API</td>
<td>Maximum time (milliseconds) expected for executing the outbound call for Sentiment Analysis API before it’s timeout.</td>
</tr>
</tbody>
</table>

Sentiment analysis results

The sentiment analysis results view contains a bar chart that displays the percentage of positive, negative, and neutral results, along with the instance count for each category.

Color indicators

Following are the color indicators in the bar chart:

- Green: Positive
- Red: Negative
- Blue: Neutral
Surveys in Service Portal

If Service Portal is installed, you can use the Survey widget to set up surveys, quizzes, assessments, risk assessments, and attestations in Service Portal. Surveys for users on mobile devices are fully supported in Service Portal.

To create an intuitive interface for your users, you can set up surveys in Service Portal. You must first install Service Portal and then configure the survey widget on the page. To learn more about configuring a widget, see configure widget instances.

To configure a Survey widget on a page, CTRL + right-click the widget heading and select Instance Options.

Service Portal: Instance options (properties) for the Survey widget

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max records</td>
<td>Number of surveys to list on the Service Portal homepage. The user can click the View all link to view all items. Default: 5</td>
</tr>
<tr>
<td>Title of the widget</td>
<td>Text that appears in the title bar of the surveys widget. Default: My Surveys</td>
</tr>
</tbody>
</table>
Each survey on the My Surveys page contains a progress bar and a description. The color in the progress bar increases as a survey is completed. In the case of a triggered record, the table title is used for the survey description.

For mobile users, the Pagination setting for Service Portal view survey designer property is set to one question per page by default.

**One Click survey**

A One Click survey has no introduction page in Service Portal. This survey does not have the **Submit** and **Cancel** buttons in the desktop and iPad view.
Note:
- The One Click Survey field should be selected in the survey definition.
- If the public access is enabled for a One Click survey, a user can submit the survey without having to log in.

A kiosk survey is a One Click survey with only one question of any of the following types:
- Image Scale
- Choice
- Likert Scale
- Numeric Scale
- Yes/No

When you click the answer of the kiosk survey question in Service Portal, the survey is submitted and the end note is displayed on the same page as that of the survey questions.

Note:
- A kiosk survey does not have any Submit or Cancel buttons.
- A kiosk survey cannot have a signature, dependent questions, or additional information.

URI parameters for One Click survey

Pass these URI parameters through the `createAssessment()` API to store their values in the `asmt_assessment_instance` table for both platform view and Service Portal view.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_refresh_interval</td>
<td>Refresh time (in seconds) after the survey submission to create another instance. For example, <code>sysparm_refresh_interval=5</code>.</td>
</tr>
<tr>
<td>sysparm_trigger_table</td>
<td>Location that is stored as the Trigger Table field in the <code>asmt_assessment_instance</code> table. For example, <code>sysparm_trigger_table=incident</code>.</td>
</tr>
</tbody>
</table>
URI parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_trigger_id</td>
<td>Location sysId that is stored as the Trigger ID field in the asmt_assessment_instance table. For example, sysparm_trigger_id=1c741bd70b2322007518478d83673af3.</td>
</tr>
<tr>
<td>sysparm_kiosk</td>
<td>When set to true, both sysparm_trigger_table and sysparm_trigger_id parameters should be specified. This is a mandatory parameter for kiosk requests. For example, sysparm_kiosk=true.</td>
</tr>
</tbody>
</table>

Related information

Service Portal
Create and edit a page using the Service Portal Designer
Survey designer
Configure a survey in the survey designer

Surveys in ITSM Virtual Agent

You can use surveys in ITSM Virtual Agent to collect survey responses from users through conversational questionnaires (pre-chat and post-chat surveys) in the chat client.

A chat survey is available in ITSM Virtual Agent through the Provide Virtual Agent Feedback topic. The logic that renders the survey dynamically is called from the re-usable Survey topic block. It is common to use the Provide Virtual Agent Feedback topic as the survey setup topic in the general definitions of ITSM Virtual Agent, so that users automatically receive a survey at the end of their conversations. For information about the Survey topic block, see ITSM Virtual Agent.

When you select the Chat Survey check box for a survey, the following conditions are validated for surveys on ITSM Virtual Agent.

- Survey should contain only one metric category.
- Survey can contain only these metric types.
  - Attachment
  - Boolean
  - Check box
  - Choice
  - Date
For information on configuring a survey, see Modify a survey definition and Configure a survey in the survey designer.

The following capabilities are supported for the survey:

- Dependent survey fields
- Introduction and end notes

**Association between a survey and Virtual Agent chat**

After a survey is submitted in a Virtual Agent conversation, a survey instance is created. This instance displays the following information:

- Trigger ID, which is the sys_id of the associated interaction ID created in the Virtual Agent chat
- Trigger table, which is the interaction table

**Related information**

- ITSM Virtual Agent

**Quick start tests for Assessments and Surveys**

Validate that Assessments and Surveys still work after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Assessments and Surveys quick start tests require activating the Automated Test Framework for Survey plugin (com.glide.automated_testing_impl.Survey).
## Test Suite for Survey

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey: Basic Platform Based Test</td>
<td>Create a survey using Platform UI actions.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Survey: Platform test for Dynamic Validation</td>
<td>Validate a survey dynamically.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Survey: Clone Action</td>
<td>Clone a survey and validate the records of the original survey and the cloned survey.</td>
<td>New York</td>
</tr>
<tr>
<td>Survey: Question Bank Flow</td>
<td>Verify the addition of a question bank to a survey.</td>
<td>New York</td>
</tr>
<tr>
<td>Survey: Survey Creator Work Flow</td>
<td>Survey creator can create a survey and assign to the user who can take the survey and submit it.</td>
<td>New York</td>
</tr>
<tr>
<td>Assessment: Assign assessment to assessor</td>
<td>Assign an assessment to an assessor and verify that the instance is created for the assessor.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Assessment: Create assessment as survey creator</td>
<td>Create an assignment as a survey creator.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Assessment: Basic test flow</td>
<td>Verify the basic flow of an assessment.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

## Related information

**Quick start tests**

### Legacy survey migration

Users with the survey_admin role can migrate legacy survey data to create copies of legacy surveys and their related records in assessment tables. The Survey Management application, which is built on the assessment engine, is available as an alternative to legacy surveys.
The following legacy survey components are migrated:

- Survey masters
- Supported survey questions and question choices
- Survey instances
- Survey responses

Legacy survey conditions are not migrated and must be recreated as trigger conditions.

⚠️ Note:

- The Legacy Surveys and Legacy Administration modules are available on instances upgraded from a previous release but not available for new instances. Customers using legacy survey or survey wizard should plan to migrate to the Survey Management application to create modern and high quality surveys for their users.
- The following legacy survey plugins are inactive by default, and are available upon request:
  - Best Practice - Task Survey Management (ID: com.snc.bestpractice.task_survey)
  - Survey Management (ID: com.glideapp.survey)
  - Assessment Components (ID: com.snc.assessment)
  - Survey Wizard (ID: com.glideapp.survey_wizard)
- Survey wizards cannot be migrated.

Migrate a legacy survey

Migrate a legacy survey and its related records to take advantage of a more powerful feature set.

Before you begin
Role required: admin or survey_admin

About this task
To avoid timing out for very large surveys, you can disable the transaction quota. See .
Procedure

1. Navigate to Survey > Legacy Surveys > Masters.
   The list of legacy survey masters appears. By default, the list shows only survey masters that have not been migrated. To show all survey masters, remove the Assessment is empty breadcrumb.

2. Open a survey and click the Migrate to New Survey Management related link or Migrate to New Survey Management in the title bar.
   A dialog box describes what happens when you migrate the survey. Note that certain types of survey questions cannot be migrated.

3. Click OK.
   The system generates records on assessment tables based on the survey master, eligible questions and choices, results, and other related survey components. The original survey components are unaffected.
   System messages may appear at the top of the Survey form to notify you of questions that could not be migrated and to advise you to review migrated Multiple Choice questions.

4. Optional: Click the reference icon beside the Assessment field to view the new survey definition.

5. Optional: Remove survey users from the assessment survey if you want all users to be able to take it.
   When you migrate a survey, any users who have taken it are automatically associated with the assessment survey and become survey users. When there are survey users associated with an assessment survey, only those users can take it.

6. Deactivate any survey conditions associated with the survey by completing the following steps.
   a. Navigate to Survey > Legacy Administration > Survey Conditions.
   b. In the Active column, ensure the value is false for any survey conditions that reference the migrated survey.

7. Navigate to Survey > Administration > Trigger Conditions to create new trigger conditions for the migrated survey.

Results
The Migrate to Assessment related link on the legacy survey record becomes unavailable after the migration. However, if you delete the record referenced in the Assessment field, the related link reappears and you can migrate the legacy survey again.
Survey question migration

Before you migrate a legacy survey, understand that some legacy survey questions cannot be migrated due to incompatible question types.

Legacy survey questions are migrated from the Survey Question [survey_question_new] table to the Assessment Metric [asmt_metric] table. In legacy surveys, the Type field on the Survey Question table determines how the question renders on the survey questionnaire. In assessment surveys, the Data type field on the Assessment Metric table serves a similar purpose. Certain legacy survey types are not supported in assessment surveys.

The following table shows the conversion path for each legacy survey question type to an assessment data type, if there is one.

<table>
<thead>
<tr>
<th>Legacy survey type</th>
<th>Assessment data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Break</td>
<td>Not available</td>
</tr>
<tr>
<td>CheckBox</td>
<td>Checkbox</td>
</tr>
<tr>
<td>Date</td>
<td>Date</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date/Time</td>
</tr>
<tr>
<td>HTML</td>
<td>Not available</td>
</tr>
<tr>
<td>Label</td>
<td>Not available</td>
</tr>
<tr>
<td>List Collector</td>
<td>Not available</td>
</tr>
<tr>
<td>Lookup Multiple Choice</td>
<td>Not available</td>
</tr>
<tr>
<td>Lookup Select Box</td>
<td>Not available</td>
</tr>
<tr>
<td>Macro</td>
<td>Not available</td>
</tr>
<tr>
<td>Macro with Label</td>
<td>Not available</td>
</tr>
<tr>
<td>Multi Line Text</td>
<td>String (String option set to Multiline)</td>
</tr>
<tr>
<td>Multiple Choice</td>
<td>Likert Scale</td>
</tr>
<tr>
<td>Numeric Scale</td>
<td>Number</td>
</tr>
<tr>
<td>Reference</td>
<td>Not available</td>
</tr>
<tr>
<td>Select Box</td>
<td>Choice</td>
</tr>
<tr>
<td>Single Line Text</td>
<td>String (String option set to Single line)</td>
</tr>
</tbody>
</table>
Survey question migration (continued)

<table>
<thead>
<tr>
<th>Legacy survey type</th>
<th>Assessment data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI Page</td>
<td>Not available</td>
</tr>
<tr>
<td>Wide Single Line Text</td>
<td>String <em>(String option set to Single line wide)</em></td>
</tr>
<tr>
<td>Yes / No</td>
<td>Yes/No</td>
</tr>
</tbody>
</table>

**Migrated components**

When you migrate a survey, the system maps records from survey tables to assessment tables.

To create a functional survey on the assessment framework, the system converts survey records to the most logical equivalent assessment survey records. This may mean multiple assessment survey records represent one legacy survey record.

**Migrated components**

<table>
<thead>
<tr>
<th>Survey component</th>
<th>Assessment survey components</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey master [survey_master]</td>
<td>• Survey definition [asmt_metric_type]</td>
</tr>
<tr>
<td></td>
<td>• Assessable record [asmt_assessable_record], for system use only</td>
</tr>
<tr>
<td></td>
<td>• Survey category [asmt_metric_category]</td>
</tr>
<tr>
<td>Survey question [survey_question_new]</td>
<td>• Survey question [asmt_metric]</td>
</tr>
<tr>
<td>Question choice [question_choice]</td>
<td>• Assessment metric definition [asmt_metric_definition]</td>
</tr>
<tr>
<td>Survey instance [survey_instance]</td>
<td>• Assessment group [asmt_assessment], for system use only</td>
</tr>
<tr>
<td></td>
<td>• Survey instance [asmt_assessment_instance]</td>
</tr>
<tr>
<td>Survey response [survey_response]</td>
<td>• Survey instance question [asmt_assessment_instance_question]</td>
</tr>
<tr>
<td></td>
<td>• Survey response [asmt_metric_result]</td>
</tr>
<tr>
<td></td>
<td>• Category result [asmt_category_result], for system use only</td>
</tr>
</tbody>
</table>
Migrated question review

To maintain accurate result calculations, you may need to make minor adjustments to some of the migrated survey records to ensure results are calculated correctly.

Note: The assessment engine provides a built-in result calculation feature that converts each survey response to a score between 0 and 10. The configuration required to maintain accurate result calculations is advanced and is not recommended for basic survey implementations. If you do not plan to use result calculation data, ignore the information in this section.

For each legacy question migrated, the system creates a survey question record on the Assessment Metric [asmt_metic] table. For legacy questions of the **Multiple Choice** and **Select Box** types, the system also creates a metric definition record, on the Assessment Metric Definition [asmt_metric_definition] table, for each legacy question choice.

### Comparable metric definitions and survey question choices

<table>
<thead>
<tr>
<th>Survey question choice field</th>
<th>Related metric definition field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Display</td>
</tr>
<tr>
<td>Value (can be any string value)</td>
<td>Value (must be a numerical value)</td>
</tr>
<tr>
<td>Order</td>
<td>Value (metric definition with smallest Value is first)</td>
</tr>
</tbody>
</table>

When the system migrates legacy survey question choices, it uses the legacy **Order** to set each metric definition **Value**. For the legacy question choice with the smallest **Order**, the corresponding metric definition **Value** is set to 1. For the legacy question choice with the next smallest **Order**, the metric definition **Value** is 2, and so on.

The **Scale definition** field on the migrated Survey Question form determines whether smaller or bigger metric definition values equate to a good score in survey result calculations. By default, the scale definition is set to **High**, meaning bigger values are good. When you migrate a legacy survey, check that the default scale definition makes sense for each question.

For example, the following tables depict a sample migrated question and the metric definitions automatically created for it. Recall that the system uses the order of the legacy survey question choices to set the metric definition value.
**Excellent** has the lowest **Order** value, so when the system creates a metric definition for this question choice, the **Value** is set to **1**. In this case the default scale definition value, **High**, does not make sense, as the system will calculate the worst scores for responses of **Excellent**.

**Legacy question:** Please rate the overall quality of your service.

<table>
<thead>
<tr>
<th>Question choice text</th>
<th>Question choice value</th>
<th>Question choice order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excellent</td>
<td>A</td>
<td>100</td>
</tr>
<tr>
<td>Good</td>
<td>B</td>
<td>200</td>
</tr>
<tr>
<td>Fair</td>
<td>C</td>
<td>300</td>
</tr>
<tr>
<td>Poor</td>
<td>D</td>
<td>400</td>
</tr>
</tbody>
</table>

**Migrated question:** Please rate the overall quality of your service.

<table>
<thead>
<tr>
<th>Metric definition display</th>
<th>Metric definition value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excellent</td>
<td>1</td>
</tr>
<tr>
<td>Good</td>
<td>2</td>
</tr>
<tr>
<td>Fair</td>
<td>3</td>
</tr>
<tr>
<td>Poor</td>
<td>4</td>
</tr>
</tbody>
</table>

If there are no **Order** values for the legacy survey question choices, the system sets each corresponding metric definition **Value** based on the alphanumeric order of the legacy **Text** value.

**Migrated question:** Please rate the overall quality of your service.

<table>
<thead>
<tr>
<th>Metric definition display</th>
<th>Metric definition value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excellent</td>
<td>1</td>
</tr>
<tr>
<td>Good</td>
<td>2</td>
</tr>
<tr>
<td>Fair</td>
<td>3</td>
</tr>
<tr>
<td>Poor</td>
<td>4</td>
</tr>
</tbody>
</table>

You may also need to change the **Scale definition** setting for other migrated questions. For details, see the scale definition recommendations for each survey question data type.
Quizzes

Quizzes are questionnaires you can assign to one or more users to assess their knowledge of any subject. The quiz functionality is built on the assessment engine and provides many of the same features as assessments and surveys.

Each question is scored, and the overall score indicates the percentage of questions the user answered correctly. A quiz may have categories of questions that are assigned only to some users. You can assign weighting values to individual questions or categories of questions that make them more or less important when calculating the overall score. Quizzes require activation by a system administrator.

The differences between assessments, surveys, and quizzes, and when to use each; also provides a quick look at the three stages in the survey process: designing, sharing, and evaluating.

• An administrator can create a quiz for any purpose and assign it to a single user or multiple users.

• A quiz can contain one or more categories of questions. Each category can be assigned to users who answer only the questions in that category.

• The system can send email notifications to these users:
  ◦ Recipients: The recipient can receive notification of an assigned quiz, a quiz whose allowed duration is at 50%, and a quiz that is overdue.
  ◦ Recipient's manager: The recipient's manager can receive notification when a quiz is overdue.
  ◦ Quiz manager: The quiz manager can receive notification of an overdue quiz to which he or she is assigned.

• Quizzes can contain questions that are scored or not scored. Unscored questions assess opinions or involve dates and are not counted in the final score. Scored questions specify correct answers and are scored either as 0% or 100%. You can apply a weighting scale to scored questions to establish their relative importance. You can designate questions with these data types as scored questions:
  ◦ Checkbox
  ◦ Choice
  ◦ Duration
  ◦ Likert Scale
  ◦ Numeric Scale
• Template
• Yes/No

• A quiz question can be dependent on the response to any scored question. For example, you can create a dependent question requesting additional information that appears only if a recipient answers No to a specific question.

**Important terms**
The quiz application involves several terms.

<table>
<thead>
<tr>
<th>Terms used in quiz application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quizzes</td>
</tr>
<tr>
<td>Categories</td>
</tr>
<tr>
<td>Questions</td>
</tr>
<tr>
<td>Category user</td>
</tr>
<tr>
<td>Templates</td>
</tr>
</tbody>
</table>

**Quiz roles**
The Quizzes application uses these roles. No role is required to take quizzes that are assigned to you.

<table>
<thead>
<tr>
<th>Role Title [Name]</th>
<th>Role Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>assessment administrator [assessment_admin]</td>
<td>Can administer the Assessments application and all quiz records. Can access all the modules of the Assessments application.</td>
</tr>
</tbody>
</table>
Quiz roles (continued)

<table>
<thead>
<tr>
<th>Role Title [Name]</th>
<th>Role Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator [admin]</td>
<td>Can access all aspects of the assessment and survey processes. Only administrators can modify survey notifications, create survey modules, and import surveys.</td>
</tr>
</tbody>
</table>

Note: The itil_admin role and the survey_admin role contain the assessment_admin role

Related information
Assessment metrics

Set up and administer quizzes
Set up and administer quizzes.

Before you begin
Role required: assessment_admin or admin
The differences between assessments, surveys, and quizzes, and when to use each; also provides a quick look at the three stages in the survey process: designing, sharing, and evaluating.

Procedure
1. Optional: Create reusable question templates for quizzes.
2. Create the quiz using the Quiz Designer or with forms accessed from the navigation menu.
   The quiz record includes specifics such as duration, notification preferences, a questionnaire introduction, and ending notes displayed to recipients.
3. Edit the default category or create additional categories as needed.
   The system creates a category with the same name as the quiz.
4. Define users for each category.
   These are the recipients who answer the questions in a category. You can define different users for each category.
5. Create the questions for each category.
6. Create the answers for each question and determine if the questions are scored.
   You can create unique answers or select preconfigured answers from a template.
What to do next
Publish and distribute the quiz. You can send the quiz to a single user or all users in each category.
Review the results from the submitted quizzes in reports and scorecards.

Related reference
Metric templates
Related information
Create a quiz

Activate the quiz designer
Administrators can activate the Quiz Designer plugin.

Before you begin
Role required: assessment_admin or admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Quiz Overview module
The Quiz Overview module is a homepage that displays various reports on data such as results for each category and quizzes that are complete, pending, or in progress.

Before you begin
Role required: assessment_admin or admin
About this task
Users with the `assessment_admin` role can view the overview page and refresh, add, delete, and rearrange widgets.

Procedure
1. Navigate to Quizzes > Overview.
2. Click elements within reports to obtain more information. The available reports are:

<table>
<thead>
<tr>
<th>Report</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quizzes by State</td>
<td>Assessment Instance [asmt_assessment_instance]</td>
</tr>
<tr>
<td>Total Questions by Quiz</td>
<td>Assessment Metric [asmt_metric]</td>
</tr>
<tr>
<td>Questions by Data Type</td>
<td>Assessment Metric [asmt_metric]</td>
</tr>
<tr>
<td>Correct Answers by Assigned User</td>
<td>Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Number of Correct Answers</td>
<td>Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Incorrect Answers by Assigned User</td>
<td>Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Number of Incorrect Answers</td>
<td>Metric Results [asmt_metric_result]</td>
</tr>
</tbody>
</table>

Quiz designer
The quiz designer provides a single interface that users with the `assessment_admin` role can use to create, edit, and distribute quizzes.
You can also use it to edit existing quizzes and change scoring parameters.
Alternatively, you can use the modules of the `assessment engine` to create and edit the records that make up a quiz. All quiz records are stored in assessment tables and displayed in Quiz views of those tables. For details, see Create quizzes with forms.

Tools on the Quiz Designer
The quiz designer includes a design canvas, a header bar, and many controls that you can use to create quizzes.
To open the quiz designer, navigate to Quizzes > Quiz Designer.
The designer contains the following elements:
• Controls tab
• Questions tab
• Categories tab
• Header bar
• Design canvas

Controls tab
Controls for the supported question data types are available in the Controls palette. Drag and drop a control onto the designer canvas to create a question of that type.

Question controls

<table>
<thead>
<tr>
<th>Controls</th>
<th>Controls</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>Boolean</td>
</tr>
<tr>
<td>Choice</td>
<td>Date</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Number</td>
</tr>
<tr>
<td>Percentage</td>
<td>Scale</td>
</tr>
<tr>
<td>Numeric Scale</td>
<td>String</td>
</tr>
<tr>
<td>Template</td>
<td>Reference</td>
</tr>
</tbody>
</table>
## Question controls

<table>
<thead>
<tr>
<th>Data type</th>
<th>Description</th>
<th>Scored</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>Question with a Manage Attachments icon that allows users to attach one or more files.</td>
<td>Y</td>
</tr>
<tr>
<td>Boolean</td>
<td>Question with a check box or a Yes/No list for user responses.</td>
<td></td>
</tr>
<tr>
<td>Choice</td>
<td>List of predefined options. For more information, see the definition for Choices Create quiz questions. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>Date</td>
<td>Date field.</td>
<td>N</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date and time field.</td>
<td>N</td>
</tr>
<tr>
<td>Number</td>
<td>Number field with predefined minimum and maximum values. The default is 1-10.</td>
<td>N</td>
</tr>
<tr>
<td>Percentage</td>
<td>Percentage field with a prescribed range.</td>
<td>N</td>
</tr>
<tr>
<td>Scale</td>
<td>Predefined Likert scale. Answer options appear as radio buttons. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>Numeric Scale</td>
<td>Selectable number scale. The default is 1-5. Answer options appear as radio buttons. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>Image Scale</td>
<td>Predefined set of images. Five emojis similar to the Likert scale (very dissatisfied to very satisfied) are provided. However, you can upload additional images in JPG, PNG, or GIF format. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>String</td>
<td>Single or multiline text field.</td>
<td>N</td>
</tr>
<tr>
<td>Template</td>
<td>Choice list of templates that provide a predefined scale of options. For details, see Configure a template question. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>Reference</td>
<td>Choice list of fields from a specified reference table. This data type does not support reference qualifiers.</td>
<td></td>
</tr>
</tbody>
</table>

## Questions tab

This tab displays all metrics added to the question bank for quizzes. Use the Filter field to search for questions. Each metric is displayed with its name and type.
Categories tab
This tab displays all metric categories added to the question bank for quizzes. All metrics in the question bank are grouped under the corresponding metric category. Use the Filter field to search for categories or questions.

Header Bar
The header bar contains tabs that display different views and a menu of various functions.

Click one of the following tabs to change the view in the canvas:

- **Design**: Add categories and questions, and configure the properties of each. This is the default view of the canvas when you open the designer.
- **Configuration**: Create introductions and end notes for quizzes, and select a signature.
- **Availability**: Select the recipients for each category in the quiz.

Point to the menu icon (≡) in the upper right of the quiz designer to select the following options:

- **Save**: Saves the current quiz.
- **Preview**: Displays a preview of the quiz as it appears to the recipients.
- **Publish**: Distributes the quiz to the selected recipients.
- **Save and Publish**: Saves and distributes the quiz in one step.
- **New Quiz**: Opens a fresh canvas for a new quiz.
- **Load Quiz**: Opens a list of existing quizzes that you can select and edit.
- **Copy Quiz**: Creates a copy of the quiz.

The availability of each option depends on the status of the quiz that is opened in the quiz designer.

Design Canvas
New quizzes open in the Design view. The quiz Name field appears above the first category in the canvas. A blank question field appears in the category container.

Related information
- View an assessment category result
- View a quiz scorecard
Create a quiz
Edit a quiz

Create a quiz

When you create a quiz, you can create one or more categories and then add questions to each category.

Before you begin
Role required: assessment_admin or admin

About this task
Each category can be assigned to a different user or the same users. You can also customize each question and make it dependent on the response to another question.

Create a quiz using these procedures:

Create quiz categories

A category represents a theme for evaluating a specific element of the quiz topic and contains questions pertaining to that theme.

Before you begin
Role required: assessment_admin or admin

About this task
When you create a quiz, the system creates a default category, using the name of the quiz. You can use this category, modify it, or create additional categories as needed. To have any results, a category must contain scored questions.

Procedure

1. Navigate either Quizzes > Quiz Designer or Quizzes > Quizzes and click Quiz Designer in the list header.

2. Enter the name of the quiz in the Name field. The system uses this name as the name of the quiz and the first category.

3. To configure the category, click the gear icon in its title bar.

   The Properties dialog box appears. You can change the name of the category, add a description for it, and enter text in the Details field that introduces or explains the category to the recipients. The system updates the category as you type.

4. Click the X icon to close the category properties dialog box and save your settings.
5. To add a new category, click the + icon in the title bar of an existing category.

**Related information**
- Quiz designer
- Create a quiz

**Create quiz questions**
You can create multiple questions for each category but each question can be associated with only one category.

**Before you begin**
Role required: assessment_admin or admin

**About this task**
The data type that you select for each question determines how it can be answered by quiz recipients.

You can designate questions to be scored. Only scored questions are shown in the quiz results and considered when calculating the category results. You must also specify a correct answer for scored questions.

**Note:**
To designate a question as scored, you must use Assessment forms. For instructions, see Configure a scored question.
Procedure

1. In the Design view, drag a data type icon from the Controls palette and drop it into a category container.

2. To configure the question, click in the gear icon in its title bar. The Properties dialog box appears for the question.

3. Fill in the fields on the form, as appropriate.
## Question property fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>[Required] Name of the question. Create a concise and easily recognizable name for your question. The system uses this value to identify the question in Assessment Metric lists and in scorecard charts.</td>
</tr>
<tr>
<td>Question</td>
<td>Text to display as the question on quizzes. Enter a clear, straightforward question that is easy to understand.</td>
</tr>
<tr>
<td>Type</td>
<td>[Read-only] Data type selected for this question. See the table in Controls for possible data types.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that determines whether this question is available on a quiz. If a question is marked inactive, it does not appear on quizzes generated after the question becomes inactive.</td>
</tr>
<tr>
<td>Boolean option</td>
<td>Whether a check box or a Yes/No list appears as the option for the Boolean question.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Check box for requiring users to answer the question. Users cannot submit quizzes until they answer all mandatory questions, which are denoted by a red field status indicator.</td>
</tr>
<tr>
<td></td>
<td>This field is available when the question does not have a dependency and the question Controls is not Boolean with a check box option.</td>
</tr>
<tr>
<td>String option</td>
<td>Setting for the appearance of a string field in a question. This field is available when the question type is String. The string options are:</td>
</tr>
<tr>
<td></td>
<td>• Single line: Single line text field 40 characters in length that allows strings of any length.</td>
</tr>
<tr>
<td></td>
<td>• String line wide: Full page width text field that allows a single line entry of any length.</td>
</tr>
<tr>
<td></td>
<td>• Multiline: Full page width multi-line text field that allows word wrap and returns.</td>
</tr>
<tr>
<td>Min</td>
<td>Lowest positive whole number that users can enter or select to answer the question. This field is available when the question type is Number, Percentage, or Numeric Scale.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Max</td>
<td>Highest positive whole number that users can enter or select to answer the question. This field is available when the question type is <strong>Number</strong>, <strong>Percentage</strong>, or <strong>Numeric Scale</strong>.</td>
</tr>
<tr>
<td>Allow not applicable</td>
<td>Check box for including <strong>Not Applicable</strong> as an option for this question. Users can select <strong>Not Applicable</strong> if they do not have sufficient information to respond to a question. User responses of <strong>Not Applicable</strong> are excluded from results calculations. This field is available when the question does not have a dependency and the question <strong>data type</strong> is not <strong>Boolean</strong> with a check box option.</td>
</tr>
<tr>
<td>Randomize answers</td>
<td>Check box for displaying answer options in a random order whenever the question appears in a quiz. Answer preference is sometimes influenced by the order in which options appear, which can result in biased results. Randomizing options can help prevent this bias.  <strong>Note:</strong> Randomizing options for certain questions may make those questions confusing for users. In general, only randomize options that do not follow a logical order.</td>
</tr>
<tr>
<td>Details</td>
<td>Information about the question that is displayed on the quiz. Include details that help users understand how to answer the question. You can also enter HTML text in this field with the WYSIWYG editor. For example, include HTML to embed links and images.</td>
</tr>
<tr>
<td>Correct answer</td>
<td>Answer option that you want to be selected by users. When you specify a correct answer for a question, the system scores the question. This field is available for all data types except <strong>Date</strong>, <strong>Date/Time</strong>, and <strong>String</strong>. Multiple correct answers are supported for a few data types. See <strong>data types</strong>.</td>
</tr>
<tr>
<td>Choices</td>
<td>Options for a question with a data type of <strong>Choice</strong> or <strong>Scale</strong>. The system automatically adds text and values that you can edit for each option. Click the <strong>+</strong> icon to add an option, or click the <strong>X</strong> icon to delete an option. By default, the system arranges options in the order established by their values. To change the order, drag and drop the options.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displayed when</td>
<td>Condition builder that hides or displays the question depending on the answer to another question in the same category. Select an existing question from the list with a data type of <strong>Boolean</strong>, <strong>Choice</strong>, <strong>Scale</strong>, or <strong>Template</strong>. Create the condition that must exist for recipients to see the dependent question, using the <strong>is</strong> or <strong>is one of</strong> operator. The system prevents recursive dependencies between questions. For example, if Question A depends on Question B, Question B cannot depend on Question A.</td>
</tr>
</tbody>
</table>

4. To create any special conditions that must be met for a question to appear on the quiz, click the **Dependency** tab. Fill in the fields, as appropriate.

Dependent questions appear on the quiz when a recipient selects a specific answer or combination of answers to another question in the same category.

5. Select a question in the Displayed when field. The system selects the appropriate operator and displays the possible answers for the selected question.

6. Select the answers that satisfy the condition. Selected answers are indicated by a check mark.
7. Click X to close the question properties dialog box and save your settings.

8. To add a question with the same data type as an existing question in the category, click the + in the title bar of the existing question.

9. Drag questions to change their order within a category or move them between categories.

10. To delete a question, click the X in its title bar.

Configure a template question
You can configure template questions when designing quizzes.

Before you begin
Role required: assessment_admin or admin

Procedure
1. Drag the Template data type icon into a category container.
2. Click the gear icon in the question title bar to open the template properties dialog box.
3. Select a predefined scale from the list.
Question entry fields appear for that template.

4. Enter one or more questions that are appropriate for the template.

5. Click the arrow to the right of a question to configure its properties. You must provide a name for each question.
6. Click the up or down arrow to move between questions, or click the back arrow to return to the template properties dialog box.

7. Configure the properties for the remaining questions.

8. Click the X icon to close the template properties dialog box and save your settings.

Related information
Quiz designer
Create a quiz

Configure a scored question
Only scored questions are considered when calculating category and quiz results.

Before you begin
Role required: assessment_admin or admin

About this task
A question must have a correct answer specified to be scored. Only results for scored questions are displayed in the quiz scorecard.

Procedure
1. Navigate to Quizzes > Quizzes.
2. Open the quiz containing the questions you want to mark as scored.
3. In the **Metric Categories** related list on the **Assessment Metric Type** form, select the category for the questions you want to mark as scored.

4. In the **Assessment Metrics** related list on the **Metric Category** form, select a question from the list.

5. In the **Question Type** section of the **Assessment Metric** form, select the **Scored** check box.
   
   This check box is not available if the question’s data type is not supported for scoring.

6. Select the **Correct answer** for the question.

   **Note:** Multiple correct answers are supported for a few data types. See **Data types for quizzes**.

7. Click **Update**.

8. Repeat the process for all the questions in the category that you want the system to score.

9. Return to the list of metric categories, select another category, and configure scoring for the appropriate questions in that category.

### Configure a quiz

You can configure an entire quiz.

**Before you begin**

Role required: assessment_admin, survey_creator, or admin

**About this task**

The values you enter and select on this page are applied to the entire quiz.

**Procedure**

In the quiz designer, click **Configuration** and then fill in the fields as described in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check box for enabling the distribution of this quiz to recipients.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of this configuration or the quiz to which it is attached.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Introduction</td>
<td>Introductory content to display on quizzes. You can add a welcome message or background information about the quiz.</td>
</tr>
<tr>
<td>Owners</td>
<td>Owners of the quiz. You can add a user with the survey_creator, survey_admin, or assessment_admin role.</td>
</tr>
<tr>
<td>Signature</td>
<td>[Optional] Acknowledgement by a quiz recipient of requirements, admonitions, or expectations related to a quiz.</td>
</tr>
<tr>
<td>Return URL</td>
<td>Destination address of a web page that is presented to users after they submit a completed quiz. When a return URL is configured, the End note content does not appear.</td>
</tr>
<tr>
<td>End note</td>
<td>Content that is displayed to recipients after they submit a completed quiz. You can add a thank you message, follow-up instructions, or other applicable information. End notes are not displayed if a Return URL is specified.</td>
</tr>
<tr>
<td>Duration</td>
<td>Amount of time that recipients are given to complete this quiz, starting from the time that the quiz is generated. The default duration is 14 days.</td>
</tr>
<tr>
<td>Manager</td>
<td>Assessment manager for this quiz. These users are only responsible for managing the quiz process and not the results. The system notifies the manager when submissions for this quiz are past due.</td>
</tr>
<tr>
<td>Notify manager if overdue</td>
<td>Check box for sending email notifications to a recipient’s manager when that user fails to submit an assigned quiz before the due date.</td>
</tr>
</tbody>
</table>

**Related Links**

**Show Benchmarks**
Opens the Benchmarks Dashboard that provides visibility into your key performance indicators (KPIs) and trends.

**Note:**
- This related link is available only for survey_admin, assessment_admin and survey_reader with bm_viewer role.
- You must opt in to Benchmarks to view the dashboard. See [Enable Benchmarks](#).
- This is applicable only for a published quiz.
Select a quiz recipient

When the system distributes a quiz, it sends email notifications to the category users and their managers.

Before you begin
Role required: assessment_admin or admin

About this task
A category can have one or more assigned users, and the same user can be assigned to more than one category.

The system also creates a link to the quiz in the recipients' My Assessments & Surveys portal. Users can only answer questions in the categories that they are assigned to.

Procedure
To select the recipients for each quiz category, click Availability and then fill in the fields as described in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select category</td>
<td>Category for which the selected users are recipients.</td>
</tr>
<tr>
<td>Add users</td>
<td>Users selected as recipients for this category. The choice list shows all users in the system.</td>
</tr>
</tbody>
</table>

Related information
Quiz designer

Publish a quiz
When you publish a quiz, the system sends email notifications to the recipients and to their managers. A card in each recipient's My Assessments & Surveys portal displays a link to the quiz.

Before you begin
Role required: assessment_admin or admin
**Procedure**

1. If you want to see the quiz as the recipients will see it, point to the menu icon in the upper right of the quiz designer and click **Preview**.

2. When you are satisfied with the quiz, click **Save and Publish** or **Publish** to distribute it.

**Related information**

*Quiz designer*

**Copy a quiz**

Create a copy of a quiz with at least one category to reduce the effort of creating another quiz with similar data.

**Before you begin**

Role required: assessment_admin or admin

**About this task**

All associated questions (type), configurations, categories, metrics, domain separation rules, and role-based categories are copied. Assigned users, category users, instances, and trigger conditions are not copied.

**Procedure**

1. Navigate to **Quizzes > Quizzes**.

2. Select a quiz.

3. Perform any of the following steps:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Platform</td>
<td>In the title bar, click <strong>Copy</strong>.</td>
</tr>
<tr>
<td>From Platform</td>
<td>In the title bar, select <strong>Copy</strong> from the context menu.</td>
</tr>
</tbody>
</table>
| From quiz designer | a. In the title bar, click **Quiz Designer**.  
|                 | b. In the Quiz Designer title bar, point to the menu icon on the header bar and click **Copy Quiz** |

**Edit a quiz**

You can update a quiz after the quiz has been distributed.
Before you begin
Role required: assessment_admin or admin

About this task
You can only edit a quiz that has the same application scope as that of your current session.

• Questions that you add are available only on quizzes that are distributed after the update.

• Before a quiz is submitted or during the retake period:
  ◦ Changes to existing questions are immediately available to users. This includes changes to the answers, such as additional choices or changes to the data type.
  ◦ Deleted questions are deleted from distributed quizzes in users' queues.

Procedure
Open the quiz: Group the Service Details form with one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quizzes &gt; Quiz Designer</td>
<td>Point to the menu icon in the quiz header bar and select Load Quiz.</td>
</tr>
<tr>
<td>Quizzes &gt; Quizzes</td>
<td>Right-click a quiz in the list and select Quiz Designer.</td>
</tr>
<tr>
<td>Quizzes &gt; Quizzes</td>
<td>Open a quiz from the list and click Quiz Designer in the header of the Assessment Metric Type form.</td>
</tr>
</tbody>
</table>

Related information
Quiz designer

Enable a quiz retake
You can configure a quiz to allow recipients to resubmit their answers as many times as they like, until the quiz's due date.

Before you begin
Role required: assessment_admin or admin
About this task
Results are not calculated until the quiz's configured duration has elapsed. The card in the user's queue remains visible until the quiz's due date and displays a button to allow retakes.

Procedure
1. Navigate to Assessments > Metric Definition > Types.
2. Remove the Evaluation method = Assessment filter condition so you can see all the records in the list.
3. Open the quiz.
4. In the Assessment Metric Type form, select the Allow retake check box and save the record.

Related information
Quiz designer
Publish a quiz

View a quiz result
You can view quiz results for each question and category, or view the quiz scorecard for a detailed breakdown.

Before you begin
Role required: assessment_admin or admin

About this task
Quiz results are stored in the Metric Result [asmt_metric_result] table and display recipients' answers to each question in a category.

Procedure
Navigate to Quizzes > Quiz Results.
Related information

Quiz designer
Publish a quiz

View a quiz designer scorecard

The quiz scorecard opens in the Category Results view.

About this task
For detailed information about scorecards, see Quiz Scorecards.

Procedure
1. Navigate to Quizzes > Quizzes.
2. Open the quiz whose results you want to view.
   The scorecard for the selected quiz opens in the Category Results view.
4. Select a category to view from the choice list above the chart.
Related information
Quiz designer

View a quiz category result
Category results are stored in the Assessment Category Result [asmt_category_result] table and display the overall ratings for each category based on the weighted value for each scored question.

Procedure
1. To view category results, navigate to **Quizzes > Category Results**.

2. The system calculates results from the weight configured for each category. Weights are set to a value of 10 by default but can be changed. To edit a category's weight:

3. Navigate to **Quizzes > Categories**, and select a category from the list.
4. In the Metric Category form, edit the default value in the **Weight** field.
5. Click **Update**.

   Note: You can also edit the weight of a question in the Quiz view of the Assessment Metric form.

Related information
Quiz designer
Create quiz categories
Create quiz questions

Take a quiz
All available quizzes assigned to you appear in your personal assessment and survey queue. When you submit a quiz, the system stores your responses. If a quiz allows retakes, you can resubmit it as many times as you like until its due date.

Before you begin
Role required: none
About this task
No special role is required to complete a quiz, but you must be logged in and the quiz must be assigned to you.

If configured to send email, the system sends you a notification when a quiz is assigned to you. The message contains a link to the quiz and instructions for viewing the assessment and survey queue.

Each quiz assigned to you appears in your assessment and survey queue as a card that contains information about the quiz, including a launch button. Overdue quizzes are marked with a red icon and red due date.

You must answer every required question, indicated by a red star, before you can submit the quiz. If you start to take a quiz but cannot complete it, save your responses and return to it later. When you have answered all the questions and are satisfied with the responses, submit the quiz.

By default, you cannot modify your answers to a quiz after submission. However, if the administrator has configured this quiz to allow retakes, the quiz remains in your queue after you finish it and the card shows a Modify Quiz button. You can retake the quiz as many times as you like before the due date.

Procedure
1. Navigate to Self-Service > My Assessments & Surveys.
2. Click Take Quiz on a quiz card to open the questionnaire. If there is more than one quiz category, you can click the collapse or expand icon to hide or show the questions in the category.
3. Answer each question to the best of your ability. If you are unsure of how to respond to a question or if a question does not apply to you, select Not Applicable, if that choice is available.
4. Click Save at any time to save your responses without submitting them. You can reopen the quiz from your queue when you are ready to work on it again.
5. When you are ready to submit the completed quiz, read any assertions that require your attention.
6. If present, select the check box to acknowledge the assertion. If your full name is displayed, you are required to provide authentication to acknowledge the assertion after you submit the quiz.
7. Click Submit.
8. If prompted, enter your user name and password to verify your signature. If you provided valid answers for all mandatory questions, a success message appears, displaying any end note that was configured. If the quiz allows retakes, the card remains in your queue with a Modify Quiz button after submission. If retakes are not permitted, the card disappears from your queue.
9. If the system displays an error message indicating that a question has an invalid response or must still be answered, correct the error and resubmit the quiz.

10. To edit your answers and resubmit a quiz that permits retakes, click Modify Quiz. You can modify your responses to the quiz until its due date.

**View a quiz instance**

View an instance to verify that quiz instances were created, to check the state of a quiz instance, or to reassign a quiz instance. A quiz instance represents one questionnaire assigned to one user.

**Before you begin**

Role required: admin or assessment_admin

**Procedure**

1. Navigate to **Quizzes > Quiz Instances**.
   
   The following submodules are available based on the state of the instances:
   
   - **Ready to take**: Displays quiz instances that the user can take. By default, these instances are sorted in ascending order by the **Number** field.
   
   - **In progress**: Displays quiz instances that are in progress. By default, these instances are sorted in ascending order by the **Number** field.
   
   - **Completed**: Displays quiz instances that are complete. By default, these instances are sorted in descending order by the **Taken on** field.
   
   - **Cancelled**: Displays quiz instances that are canceled. By default, these instances are sorted in ascending order by the **Number** field.
   
   - **All**: Displays quiz instances in all states. By default, these instances are sorted in ascending order by the **Number** field.

2. From the required submodule, click a quiz instance.

   **Note**: When you select an instance in the **Completed** submodule, you are redirected to the User's Response page.

3. In the form, fill the fields. By default, the following fields are displayed for all submodules other than the **Completed** submodule.

   **Quiz instance form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated record number.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Metric type</td>
<td>Metric type of this quiz.</td>
</tr>
<tr>
<td>Due Date</td>
<td>Date by which the quiz instance should be completed. The system populates the due date based on the <em>Assessment duration</em> of the associated quiz definition, which is set to 14 days by default. The quiz due date is not enforced in the base system. If you want to enforce the due date, consider using a workflow or other mechanism to send survey recipients reminders when a survey is overdue.</td>
</tr>
<tr>
<td></td>
<td>Note: By default, the system runs the <em>Cancel Expired Assessments</em> script every 30 days to cancel expired survey, assessment, and quiz instances that are in the Work in progress or Ready to take states.</td>
</tr>
<tr>
<td>State</td>
<td>State of the quiz.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User that the quiz instance is assigned to. This field becomes read-only when the state is <em>In progress</em>, <em>Complete</em>, or <em>Canceled</em>.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain associated with the instance.</td>
</tr>
<tr>
<td>Related Link</td>
<td></td>
</tr>
<tr>
<td>View User's Response</td>
<td>Shows a read-only version of the survey responses completed by the user.</td>
</tr>
<tr>
<td>Related List</td>
<td></td>
</tr>
<tr>
<td>Assessment Instance Questions</td>
<td>All instance question records that store user response values for each question on the quiz questionnaire. The following columns are relevant to quiz:</td>
</tr>
<tr>
<td>Category</td>
<td>Displays the quiz categories the questions belong to.</td>
</tr>
<tr>
<td>Metric</td>
<td>Displays the quiz questions.</td>
</tr>
</tbody>
</table>

**Related information**

**Quiz scorecards**

The Quizzes application prepares printable scorecards.
A scorecard analyzes category and question responses and compares current ratings with previous ratings. You can examine ratings over time, compare question ratings, or compare the ratings of all categories. All ratings are averages for the time range selected.

The system dynamically updates a scorecard each time you view it, so the ratings reflect recently completed quizzes.

**Category results**

The Category Results view is a stacked bar chart of responses to all questions in a category.

Select the category to display from the choice list above the chart. Category results are only calculated for scored questions.

This view displays responses that use the following data types:

- Checkbox
- Choice
- Likert Scale
- Number
- Template
- Yes/No

ℹ️ **Note:** The Checkbox and Yes/No data types are combined into the Boolean data type in the Quiz designer.
To view details about a specific response to a question, point to the colored segment representing a specific response. The chart displays the count for those responses and the percentage it represents of the total responses to that question.

**Quiz category result details**

**Question results**

The Question Results view shows the results for all questions in a quiz.

Select a question by name from the choice list to display the results in a pie chart or a bar chart, based on the data type.
Pie chart
The pie chart shows question results for these data types:

- Checkbox
- Choice
- Likert Scale
- Number
- Template
- Yes/No

Note: The Checkbox and Yes/No data types are combined into the Boolean data type in the Quiz designer

Bar chart
A bar chart appears when question results use this data type:

- Percentage
By default, all results for percentage questions use a report range of 20% segments. To configure a report range, navigate to Reports > Administration > Report Ranges.

**Average ratings**

The Average Ratings view displays a bar chart of the weighted average rating for each question in a category.

Use this view to learn how individual questions affect the overall rating for the category. Select a category from the second choice list above the chart. Ratings are only calculated for scored questions.

To view the effect of each question's ratings on the entire category's ratings, point to the colored bar. The pop-up box shows the percentage of the total ratings represented by each individual question's weighted average.
Quiz reports

Quizzes provide several global reports so that assessment administrators can view important statistics.

You can share these reports with specific users or groups and change the display options.

For detailed field information and reporting options, click the link for the chart Type. To sort a column in ascending or descending order, click the arrow in the column heading.

### Quiz reports

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quizzes by State</td>
<td>State of distributed quizzes. This chart displays the percentage of distributed quizzes that are ready to take, in progress, complete, or canceled.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Pie Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Assessment Instance [asmt_assessment_instance]</td>
</tr>
<tr>
<td>Total Questions by Quiz</td>
<td>Total number of questions for all categories in each quiz.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Assessment Metric [asmt_metric]</td>
</tr>
<tr>
<td>Questions by Data Type</td>
<td>Total number of questions in all quizzes by data type.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Assessment Metric [asmt_metric]</td>
</tr>
<tr>
<td>Correct Answers by Assigned User</td>
<td>Total number of scored questions answered correctly by each assigned user.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Metric Results [asmt_metric_result]</td>
</tr>
</tbody>
</table>
Quiz reports (continued)

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Correct Answers</td>
<td>Total number of correct answers for each scored question.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Incorrect Answers by Assigned User</td>
<td>Total number of scored questions answered incorrectly by each assigned user.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Number of Incorrect Answers</td>
<td>Total number of incorrect answers for each scored question.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Metric Results [asmt_metric_result]</td>
</tr>
</tbody>
</table>

Wizards

The Wizards functionality, which enabled administrators to create wizards that provide a step-by-step sequence of dialog boxes that lead the user through a procedure, was deprecated in the Eureka release. However, some users are still able to access this functionality if they enabled its plugin in previous releases.

For more information about this functionality, see https://docs.servicenow.com/bundle/archive/page/archive/fuji-archive.html.

Service Catalog

With the ServiceNow® Service Catalog application, create service catalogs that provide your customers with self-service opportunities. Customize portals where your customers can request catalog items such as service and product offerings. You can also standardize request fulfillment to ensure the accuracy and availability of the items in the catalogs.

- **Explore**
  - Service Catalog release notes
  - Upgrade to Rome

- **Set up**
  - Set up a service catalog
  - Multiple service catalogs setup
  - Create a category

- **Administer**
  - Create or edit a catalog item
  - Create a service catalog variable
  - Set security for items and categories
- Video: Getting Started with Service Catalog (YouTube playlist)
- Domain separation and Service Catalog

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
</table>
| • Service Catalog for managers and end users  
  • Catalog Builder  
  • Delegated request experience  
  • Service Catalog in Service Portal  
  • Service Catalog in mobile  
  • Service Catalog topic blocks in Virtual Agent | • Developer training  
  • Developer documentation  
  • Installed with Service Catalog Management | • Debug actions on catalog item variables  
  • Debug user criteria of a catalog item  
  • Debug UI customizations for a Service Catalog page  
  • Debug performance diagnostics of a catalog item  
  • Debug a Service Catalog variable  
  • Item diagnostic report  
  • Ask or answer questions in the Service Catalog community  
  • Search the Known Error Portal for known error articles  
  • Contact Customer Service and Support |

**Service Catalog management terms and roles**

The Service Catalog management application uses these roles to manage different aspects of the application.

**Service Catalog terms**

*Execution Plans*
Define how something gets delivered. For example, a PDA could go through procurement / activation / and installation of the desktop software.

**Execution Plan Tasks**

Plan Tasks represent a step in the Execution Plan, are associated with a Fulfillment Group, and have an approximate duration.

**Fulfillment Groups**

Fulfillment Groups work execution tasks. For example, one group can activate a cell phone while a different group installs the desktop software.

**Tickets**

Tickets represent work done by Fulfillment Groups as part of an Execution Plan.

**Service Catalog Management Roles**

<table>
<thead>
<tr>
<th>Role Title [Name]</th>
<th>Role Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator [admin]</td>
<td>Can manage all aspects of the Service Catalog application, including scripting functions such as creating UI macros or business rules.</td>
</tr>
<tr>
<td>Catalog administrator [catalog_admin]</td>
<td>Can manage the Service Catalog application, including catalogs, categories, and items, but not including scripting functions available to administrators.</td>
</tr>
<tr>
<td>Catalog manager [catalog_manager]</td>
<td>Can edit and update a service catalog, as well as the categories and catalog items within the catalog. The manager can assign editors and also a different manager for the service catalog.</td>
</tr>
<tr>
<td>Catalog editor [catalog_editor]</td>
<td>Can edit and update a service catalog, as well as categories and catalog items within the catalog. The editor can assign other editors, but cannot change the catalog manager.</td>
</tr>
<tr>
<td>Catalog builder editor [catalog_builder_editor]</td>
<td>Can create and maintain items in the catalog builder using the templates that the user has access to.</td>
</tr>
</tbody>
</table>
Service catalog setup

Service Catalog enables users with the Catalog Administrators role (catalog_admin) to set up the service catalog.

Service Catalog enables you to set up one or more service catalogs and provides self-service opportunities. You can organize your catalog offerings by using the ability to publish multiple catalogs targeted to specific audiences.

An overview of ServiceNow service catalog administration.

Set up a service catalog

To set up a Service Catalog, plan the way your organization defines and maintains Service Catalog items, and how it fulfills them.

About this task

Administrators and catalog administrators, users with the catalog_admin role, can use the Service Catalog application to define service catalog content and layout. Catalog managers, users with the catalog_manager role, can define and manage a single service catalog. Catalog editors, users with the catalog_editor role, can manage a single service catalog.

Administrators and catalog administrators can define and manage multiple service catalogs. A catalog manager can define and manage a single catalog. One or more catalog editors can manage a single catalog.

Follow these steps to plan for your service catalog:

Procedure

1. Assign roles to the users working with the service catalog.
2. Define content to provide in the service catalog:

<table>
<thead>
<tr>
<th>Catalog items</th>
<th>The goods and services available within the catalog.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Categories</td>
<td>The groups of items displayed on the catalog home page</td>
</tr>
<tr>
<td>Variables</td>
<td>The options available for tailoring a catalog item to meet specific needs.</td>
</tr>
</tbody>
</table>

3. Customize the service catalog homepage to meet your requirements such as defining a Classic Mobile layout.
4. Define the request fulfillment processes your organization uses to deliver ordered catalog items.
5. [Optional] Create a navigation module for the new catalog.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
What to do next
Administrators and catalog administrators can further extend the service catalog to provide more powerful features, using specialized catalog items, configuration options, and scripting functions. For example, administrators can customize the checkout process used when ordering catalog items.

Set up Platform URLs for catalog modules
You can direct users to a specific catalog via a URL to a module in that particular catalog.

About this task
When you create a module for your catalog page, you can direct users to a specific catalog and view from this module via a URL.

Procedure
In the Link Type section, select URL (from Arguments), then in the Arguments field, enter a URL of the form `catalog_home.do?sysparm_catalog=id of sc_catalog record&sysparm_catalog_view=view name of sys_portal_page`.

For example, `catalog_home.do?sysparm_catalog=742ce428d7211100f2d224837e61036d&sysparm_catalog_view=catalog_technical_catalog`.

⚠️ Note: If you make the default catalog inactive, then deactivate the Catalog module otherwise users can continue to access the inactive catalog using that module.

If a URL has a valid `sysparm_catalog` parameter, but an invalid or missing `sysparm_catalog_view` parameter, the view with the default value from the corresponding Catalog Portal Page record is used.

If a URL has a valid `sysparm_catalog_view` parameter, but an invalid or missing `sysparm_catalog` parameter, the corresponding Catalog Portal Page record is used to set the catalog.

⚠️ Note: To ensure peak performance, define both parameters correctly.

Multiple service catalogs setup
Multiple service catalogs enable your organization to offer different sets of services to different teams within the organization, such as IT services, human resources, and facilities management.

Administrators and catalog administrators can define and manage multiple service catalogs. End users can access multiple catalogs from a single
homepage, can search across all catalogs, or can search directly within each catalog.

**Enabling access for catalogs**

You can enable read access to the catalogs by applying the rule **read ACL** on Catalog (sc_catalog) table. See [Access Control Rules](#) for more information.

**Create a catalog**

Using Service Catalog, you can create a catalog and define items and categories within the catalog.

**Procedure**

1. **Navigate to Service Catalog > Catalog Definitions > Maintain Catalogs.**
2. Select **New**.

   ![Catalog configuration form](image)

3. Enter the new catalog details (see table).
4. Right-click the form header and select **Save**.
5. Define catalog items and categories to include in the catalog.
6. **Optional**: Define additional portal pages for the catalog.
7. **Optional**: Manage sites if you are using a CMS system.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Descriptive name for the catalog.</td>
</tr>
<tr>
<td>Application</td>
<td>The application scope for this catalog. For information on the application scope, see <a href="#">Application scope</a>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Manager</td>
<td>Name of the catalog manager assigned to this catalog. (Optional) The manager is able to edit and update the catalog, as well as the categories and catalog items within the catalog. The manager can assign editors and also a different manager for the catalog, if desired. Only one manager can be assigned to a catalog and must have the catalog manager role or catalog_admin role assigned.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to make the catalog available to end users.</td>
</tr>
<tr>
<td>Editors</td>
<td>Name of the catalog editor. (Optional) The editor is able to edit and update the catalog, as well as categories and catalog items within the catalog. The editor can assign other editors, but cannot change the manager. Multiple editors can be assigned to a catalog. Each user must have the catalog editor role assigned.</td>
</tr>
<tr>
<td>Enable Wish List</td>
<td>Select the check box to enable the wish list feature for the catalog.</td>
</tr>
<tr>
<td>Description</td>
<td>Information about the catalog, displayed on the multi-catalog homepage.</td>
</tr>
<tr>
<td>Background Color</td>
<td>The background color used for the catalog on the multi-catalog homepage.</td>
</tr>
<tr>
<td>Desktop image</td>
<td>The larger image to display with the catalog on the multi-catalog homepage. This image is only shown if image display is included in the renderer selected, such as the default Title and Image renderer.</td>
</tr>
<tr>
<td>'Catalog Home' page</td>
<td>The location to direct service catalog users to when they click the Catalog Home button. This field is designed to reference a content page url suffix.</td>
</tr>
<tr>
<td>'Continue Shopping' page</td>
<td>The location to direct service catalog users to when they click the Continue Shopping button. This field is designed to reference a content page url suffix.</td>
</tr>
</tbody>
</table>

**What to do next**

To add a module in the navigator for the new catalog, see [Create a module](#).
Manage items in a catalog

Using Service Catalog, you can view and manage items within a catalog.

About this task

Use the Catalog Items related list on the Catalog form to view and manage the items available in the catalog.

To define a new catalog item for the catalog, click New and enter the details for the item.

Manage catalog portal pages

Using Service Catalog, you can create and manage multiple portal pages for a catalog.

About this task

A catalog portal page provides a homepage for a specific catalog. You can use portal pages to create different catalog views for different user groups. Each portal page accesses the same catalog content and presents that content in different ways.

Catalog portal page details include the owner, title, and view to use for that page.
Procedure

1. The Catalog Portal Pages related list shows portal pages available for that catalog. Each catalog has a default page, created automatically when the catalog is created.

2. Select an appropriate action:
   - Click **New** to create a new portal page.
   - Click **Edit** to select another portal page for the catalog.
   - Select a portal page to view and edit details for that page.

Tables provided with multiple service catalogs

Administrators and catalog administrators must consider these points before they upgrade to multiple service catalogs.

Before upgrading, be aware of changes made to the underlying Service Catalog data model. These changes are made to implement multiple catalogs and do not affect a standard upgrade. However, if you have made customizations, such as changes to the data model, the changes can impact the instance.

The following tables are provided with multiple service catalogs:

<table>
<thead>
<tr>
<th>Table [name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog Site [sc_catalog_site]</td>
<td>Associates catalogs to sites.</td>
</tr>
<tr>
<td>Catalog Portal Page [sc_catalog_view_mtom]</td>
<td>Links catalogs to CMS portal pages. Defines the default catalog to portal page combination used by default links.</td>
</tr>
<tr>
<td>Catalog Items Catalog [sc_cat_item_catalog]</td>
<td>Stores the catalogs an item is available in.</td>
</tr>
<tr>
<td>Catalog Item Category [sc_cat_item_category]</td>
<td>Stores the categories an item is available in.</td>
</tr>
</tbody>
</table>

Catalog site records

Catalog site records appear in the **Sites** related list on the Catalog form.
The Catalog Site [sc_catalog_site] table associates catalogs with CMS web sites. Several service catalog system properties are used to specify values for different sites used by different catalogs.

### Catalog site records properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Catalog site field [name]</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.sc.home.cms_page</td>
<td>CMS homepage [cms_home]</td>
</tr>
<tr>
<td>glide.sc.search.cms_page</td>
<td>CMS search page [cms_search]</td>
</tr>
<tr>
<td>glide.sc.continue.shopping.target</td>
<td>CMS 'Continue Shopping' page [cms_continue_shopping]</td>
</tr>
</tbody>
</table>

### Service catalog categories

Categories organize service catalog items into logical groups. Administrators and catalog administrators can create and configure categories, defining their characteristics and adding content such as catalog items to them.

Categories can have a parent-child relationship, for example, **IT** and **Laptops**. A child category is a subcategory of its parent category. Each catalog item, order guide, record producer, content item, and subcategory appears as a single item within the category. A catalog item can exist in multiple categories, giving you the flexibility to offer the same service from multiple places within your catalog.

Introduces creating categories in a ServiceNow Service Catalog.

---

Certain system properties control the following Service Catalog category configuration.
• How categories are displayed to users. For example, are subcategories displayed in a panel or as a list in the category view.

• What content types and search and navigation elements are available on the homepage. For example, searching the service catalog can be enabled or disabled for all users.

• How catalog items, item class names and item categories appear to users. For example, what number of catalog items or categories are previewed in a section.

Catalog managers and catalog editors can also configure categories, but only categories to which they are assigned.

Note:

• If there are no active items in a category’s hierarchy, that category does not appear in the catalog, and cannot be added to the catalog.

• Users with the admin or catalog_admin roles can view categories only if there is an active item in the category and Availability is set to either Desktop or Both.

• Configure the glide.sc.category.canview.override property to change the roles for this behaviour.

Create a category

Administrators and catalog administrators can create or edit a category.

About this task
To create or edit a category:

Procedure

1. Navigate to Service Catalog > Catalog Definition > Maintain Categories.
   A list of existing categories appears. If the Parent field is blank, the category does not have a parent category.

2. Click New or select the category to edit.
Note: The visibility of a category is controlled by user criteria. See Apply user criteria to items and categories.

### Service Catalog categories

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Descriptive name for the category.</td>
</tr>
<tr>
<td>Application</td>
<td>The application scope in which the category is applicable.</td>
</tr>
</tbody>
</table>

3. Fill in the fields on the form, as appropriate.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog</td>
<td>The catalog this category belongs to.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to indicate that the category is available to add to the service catalog homepage.</td>
</tr>
<tr>
<td>Location</td>
<td>Any location information relevant for the category.</td>
</tr>
<tr>
<td>Parent</td>
<td>Any parent category for which this category is a subcategory.</td>
</tr>
<tr>
<td>Description</td>
<td>Information about the category. The description appears when the category is collapsed on the service catalog homepage. The description also appears in the Related Categories list when a user clicks the parent category title.</td>
</tr>
<tr>
<td>Icon</td>
<td>The small icon displayed beside the category name, when the category is listed as a subcategory.</td>
</tr>
<tr>
<td>Header icon</td>
<td>The icon displayed beside the category header, when the category is a top-level category.</td>
</tr>
<tr>
<td>Desktop image</td>
<td>A larger image to display with the category on the Service Catalog homepage. This image is visible only if the relevant renderer defines it to be used (the default renderer does not display this field).</td>
</tr>
<tr>
<td>Classic Mobile image</td>
<td>A picture to use on Classic Mobile devices for this category. If a mobile image is not selected, the Desktop image appears if the Classic Mobile Subcategory Render Type is set to Cards.</td>
</tr>
<tr>
<td>Classic Mobile Subcategory Render Type</td>
<td>The rendering option to control how subcategories are displayed. Select List for a single-column list, or Cards for a multi-column display.</td>
</tr>
<tr>
<td>Hide description (classic mobile browsing)</td>
<td>Option for displaying the description at the top of the list on Classic Mobile devices.</td>
</tr>
</tbody>
</table>

### Configure dynamic categories

Dynamic categories let you organize and display commonly requested items and knowledge articles. Dynamic categories appear on the right side of the service catalog homepage by default.
About this task
Use dynamic categories to provide users with an access option that automatically adjusts to changing request trends.

To configure dynamic catalog categories:

Procedure
1. Navigate to Service Catalog > Catalog Definition > Maintain Dynamic Categories.
2. Select New or open an existing dynamic category.
3. Fill in the fields on the Dynamic category form, as appropriate.
   The Dynamic category form contains many of the same fields as the Category form. Additional fields are:

   **Name of form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The kind of items to display. Can be Requested items or KB Articles</td>
</tr>
<tr>
<td>Search how long?</td>
<td>For catalog items only, the period during which to search for the most common requests. For example, enter 7 00:00:00 to display the most commonly requested items in the previous seven days.</td>
</tr>
<tr>
<td>Number of Entries</td>
<td>The number of items to display in the dynamic category.</td>
</tr>
</tbody>
</table>

4. Use this example of a step with additional info.
   The results displayed are limited to those items or knowledge articles available in the currently viewed catalog.

Service catalog items
The overall catalog is made up of a collection of discrete catalog items.

The basic Service Catalog item types include:

- Standard catalog items
- Record producers: giving alternative ways of adding information such as Incidents via the service catalog.
• Order guides: to group multiple catalog items in one request.
• Content Items: catalog items which provide information instead of goods or services.

Standard catalog item

A catalog item can be a good or service. If something can be ordered by itself, it is a catalog item. If something only makes sense as part of a greater whole, it is part of an item, rather than an item in and of itself. For example, a new Dell server is a catalog item, as is a new Executive Desk.

Use a catalog item to publish a service to your users. Add a service description, images, and a workflow to determine the approval and fulfillment processes for the catalog items.

Use the variables to present and gather information from the users. Catalog UI Policies and Catalog Client Scripts can also be added to control the item behavior based on user input.

An overview of catalog items in the Service Catalog: what they are, and how to create them and define variables for them.

Types of catalog items

Service Catalog offers a few types of catalog items.

The basic Service Catalog item types include:
• Record producers: giving alternative ways of adding information such as Incidents via the service catalog.
• Order guides: to group multiple catalog items in one request.
• Content Items: catalog items which provide information instead of goods or services.

Record Producer

A record producer is a specific type of catalog item that allows end users to create task-based records, such as incident records, from the service catalog.

Use record producers to provide a better end-user experience instead of using the regular task-based form for creating records. The look and feel of a record producer is similar to that of a catalog item. But the record producer generates a task record such as incident, instead of a requested item.

You can create a record producer for tables and database views that are in the same scope as the record producer. You can also create a record producer for tables that allow create access from applications in other scopes.

Define a record producer in the service catalog or from the table record.

Note:

• Use a record producer to create task-based records only.
• To ensure that standard service catalog processes are followed, such as initiating workflows as expected, do not create requested item records from record producers. Instead, create requested item using catalog items.
• If the record producer script aborts the record generation, no record is generated in the Item Produced Record [sc_item_produced_record] table.

Note: Do not call the update, setAbortAction method, or set the sys_class_name on current record to avoid unexpected behavior.

Create a record producer

You can create a record producer for tables and database views that are in the same scope as the record producer. Also for tables that allow create access from applications in other scopes.

Before you begin
Role required: catalog_admin or admin
About this task
An overview of record producers in the Service Catalog: what they are, and how to create them and define variables and templates for them.

Procedure
1. Navigate to Service Catalog > Catalog Definition > Record Producers.
2. Click New or select the record producer to edit.
3. Complete the Record Producer form.

Record Producers in the Service Catalog

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The descriptive name for the record producer.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The list shows only tables and database views that meet the scope protections for field styles.</td>
</tr>
<tr>
<td>Table name</td>
<td>The table in which the record producer creates records.</td>
</tr>
<tr>
<td>Active</td>
<td>A check box for making the record producer active. Only active record producers are available to users if they meet the role criteria.</td>
</tr>
<tr>
<td>Preview Link</td>
<td>A link that opens a preview of the item.</td>
</tr>
<tr>
<td>Post insert script</td>
<td>Script that operates on the submitted record, after the record is inserted in the associated table.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Post insert script overrides the target record values and record producer template values.</td>
</tr>
<tr>
<td>Accessibility</td>
<td></td>
</tr>
<tr>
<td>Catalogs</td>
<td>The service catalog this record producer belongs to.</td>
</tr>
<tr>
<td>Category</td>
<td>The service catalog category this record producer belongs to. When users perform catalog searches, only items that are assigned to a category appear in search results.</td>
</tr>
<tr>
<td>View</td>
<td>The CMS view in which the item is visible.</td>
</tr>
<tr>
<td>Roles</td>
<td>The roles required to use the record producer.</td>
</tr>
<tr>
<td>Availability</td>
<td>The interface the record producer is available from: Desktop and Classic Mobile, Desktop Only, or Classic Mobile Only.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Can cancel</td>
<td>A check box for displaying a <strong>Cancel</strong> button on the record producer. Users can click <strong>Cancel</strong> to cancel the record producer and return to the last-viewed screen</td>
</tr>
</tbody>
</table>
| What it will contain  | **Short description**  
A short summary of the record producer.                                                                                                           |
|                       | **Description**        
The full description of the record producer. You can embed videos, images, links to internal knowledge base (KB) articles, and links to external sources of information and instruction documentation.  
The description appears under a **More information** link on the record producer to give users any additional information they need. |
<p>| Meta                  | Comma-separated list of tags used to search for the record producer. See <a href="#">Configure keyword search for catalog items</a>.                                                                                      |
| Hide on Service Portal| If selected, the record producer is not available on Service Portal.                                                                                                                                         |
| Redirect To           | Specifies the redirect behavior of the record producer after its generation. Possible values are:                                                                                                       |
|                       | • <strong>Generated Task record</strong>: Redirects to the task record created using the record producer.                                                                                                               |
|                       | • <strong>Catalog Homepage</strong>: Redirects to the service catalog where the order for the record producer is placed.                                                                                               |
|                       | The default value is based on the <strong>Specifies the default behavior of record producer after record generation</strong> property in the <strong>Service Catalog &gt; Catalog Administration &gt; Properties</strong> page. |
| Script                | Scripts that are run to dynamically assign values to specific fields on the created record.                                                                                                               |
| Icon                  | The small icon that appears on the list of service catalog items. <strong>Click the Click to add</strong> link and upload the photo.                                                                                  |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Picture</td>
<td>The picture that appears at the top of the record producer form on the desktop view. Click the <strong>Click to add</strong> link and upload the photo.</td>
</tr>
<tr>
<td>Classic Mobile picture</td>
<td>The small picture that appears on the list of service catalog items. Click the <strong>Click to add</strong> link and upload the photo.</td>
</tr>
<tr>
<td></td>
<td>This field is available when you select the <strong>Classic Mobile</strong> for the <strong>Classic Mobile picture type</strong>.</td>
</tr>
<tr>
<td>Classic Mobile picture type</td>
<td>The picture that the mobile interface uses on the list of service catalog items. Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Desktop: Uses the icon specified in the <strong>Icon</strong> field. Selecting this option hides the <strong>Classic Mobile picture</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• Classic Mobile: Uses the icon specified in the <strong>Classic Mobile picture</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• None: Does not use any picture on the mobile view. Selecting this option hides the <strong>Classic Mobile picture</strong> field.</td>
</tr>
<tr>
<td>Generated Record Data</td>
<td></td>
</tr>
<tr>
<td>Template</td>
<td>Static assignments for fields on the created record.</td>
</tr>
<tr>
<td>Universal Request Config</td>
<td>This section is available only when the Universal Request plugin (com.snc.universal_request) is activated. For information about this configuration, see <strong>Service Catalog configuration for Universal Request</strong>.</td>
</tr>
<tr>
<td>UR certified/enabled item</td>
<td>Option to specify that a universal request should also be created along with a task-based record.</td>
</tr>
<tr>
<td></td>
<td>In the universal request, a reference is created to the associated task-based record, which becomes the primary task of the universal request.</td>
</tr>
<tr>
<td>Requires Additional Review</td>
<td>Option to automatically select the <strong>Needs resolution review</strong> check box on the corresponding universal request. For information about the universal request fields, see <strong>Universal Request form</strong>.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Requires Additional Review</strong> field appears only when the <strong>UR certified/enabled item</strong> check box is selected.</td>
</tr>
</tbody>
</table>

4. To add attachments such as information and instruction documentation to the catalog item, see **Add an attachment**.
5. Click **Submit**. After you submit the form, the **Variables, Variable Sets, Categories,** and **Catalogs** related lists become available.

6. Open the record again to define variables for the record producer.

**Create record producers from tables**

You can create Service Catalog record producers directly from a table record.

**About this task**

To create a record producer from a table record:

**Procedure**

1. Navigate to **System Definition > Tables** and open the table record.

   - **Note:** When using a workflow with a Record producer, set the condition to Run the workflow.

2. Under **Related Links**, click **Add to Service Catalog**.

3. Complete the **Name, Short Description,** and **Category** fields as you would for service catalog items.

4. Use the slushbucket to select the fields and the order in which you want them to appear. To use container variables, select `- container start -` and `- container start -`.
5. Click **Save and Open** to open the record producer and define additional options. Alternatively, click **Save** to return to the table record.

- A record producer is created with these values:
  - **Table name**: table record opened in step 1
  - **Name**, **Short Description**, and **Category**: information entered in step 3
- A variable is created for each of the selected fields with these values:
  - **Name**: Column name of the field
  - **Type**: Variable type that corresponds to the field type
  - **Order**: Position selected in the slushbucket (for example, 100 for the first field and 200 for the second field)
  - **Question**: Column label of the field
- If the field type is **Choice**, a corresponding question choice is created for each field choice.
- The new record producer is added to the **Record Producers** related list on the table record.

### Populate record producer data and redirect users

You can enter data for all records created by the record producer, and redirect an end user to a particular page after the record producer is submitted.

To enter data with a record producer, use any combination of the following methods:

- Create a variable on the record producer with the same name as the field in the target record. For example, a variable named `caller_id` on a **Create a New Incident** record producer populates the `caller_id` field on the new incident record. Use a variable type that corresponds to the field type.

- Define a **template** to assign a static field value for all records created by the record producer.

- Define a script that uses any variable or server-side objects and functions to assign values.
  - Use `current.*FIELD_NAME*` to reference fields on the record being created.
  - Use `producer.*VARIABLE_NAME*` to reference values entered by the end user.
  - Use `RP.getParameterValue` to return specified parameter values passed on the URL. The RP stands for Render Properties, not Record Producer.
Redirect after submitting a record producer

To redirect an end user to a particular page after the record producer is submitted, define the redirect link in the **Script** field using any of the following:

- `producer.redirect`: Enables the redirect behavior within the Platform UI.
- `producer.portal_redirect`: Enables the redirect behavior within Service Portal.

For example, the following code redirects users to their homepage after the record producer is submitted:

- **Within the Platform UI:**
  
  ```
  producer.redirect="home.do";
  ```

- **Within Service Portal:**
  
  ```
  producer.portal_redirect = "sp?id=sc_home"
  ```

The following code gives the id of the record producer:

```
RP.getParameterValue('sysparm_id')
```

**Variables to collect data for record producer fields**

Use variables to collect data for record producer fields.

You can use the following variable types to collect data for the corresponding record producer fields.

**Variables for record producer fields**

<table>
<thead>
<tr>
<th>Field type</th>
<th>Recommended variable type</th>
</tr>
</thead>
<tbody>
<tr>
<td>True/False</td>
<td>Yes/No</td>
</tr>
<tr>
<td>Reference</td>
<td>Reference</td>
</tr>
<tr>
<td>Date or Due Date</td>
<td>Date</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date/Time</td>
</tr>
<tr>
<td>Choice or any field with an associated choice list</td>
<td>Select Box</td>
</tr>
<tr>
<td>Email address</td>
<td>Email</td>
</tr>
<tr>
<td>URL</td>
<td>URL</td>
</tr>
<tr>
<td>HTML</td>
<td>HTML</td>
</tr>
<tr>
<td>List or UI Action List</td>
<td>List Collector</td>
</tr>
</tbody>
</table>
Variables for record producer fields (continued)

<table>
<thead>
<tr>
<th>Field type</th>
<th>Recommended variable type</th>
</tr>
</thead>
<tbody>
<tr>
<td>String with length greater than 256</td>
<td>Multi-Line Text</td>
</tr>
<tr>
<td>String, Integer, Decimal, Floating Point Number</td>
<td>Single-Line Text</td>
</tr>
<tr>
<td>File Attachment</td>
<td>Attachment</td>
</tr>
<tr>
<td>All other field types</td>
<td>Multi-Line Text</td>
</tr>
</tbody>
</table>

Note:

- If the record producer variable is mapped to an encrypted field of another table, then this variable value is not stored in Question Answer [question_answer] table. So, it is also not available in the variable editor of the target record.

- If the record producer variable is masked and encrypted, and also mapped to an encrypted field of another table:
  - The variable value is not stored in Question Answer [question_answer] table.
  - The decrypted value of the variable is copied to the encrypted field of the target record.

Values Returned

When you construct a record producer, be aware of the return value.

Most of these field types return a string. However, there are some exceptions. For example, a Reference value returns the sys_id of the target object, and a List value returns a comma-separated list of sys_ids.

Example 1: For a List value, return an array which can be iterated to retrieve the individual values submitted by your user:

```javascript
var sys_id_string = producer.glide_list_field;
var sys_id_list = string.split (',');
```

Example 2: For a Date or Date/Time value, return a date which GlideDate can evaluate.

```javascript
var glideDateTime = new GlideDateTime(producer.date_field);
```

Order guides

Order guide submits a single service catalog request that generates several items.
For example, a New Employee Hire order guide can contain several items that new employees commonly need, such as business cards, computer, and cell phone. After selecting this order guide, the customer can then provide information about the new employee, including location and job title. The order guide then submits an order for catalog items like business cards, based on the details provided.

Order guides determine which catalog items to order by evaluating order guide rule conditions. Information the customer enters within the order guide can be passed as cascading variables to the ordered items, allowing common information to be reused across multiple items.

Administrators and catalog administrators can create order guides for the service catalog.

Order guides can be run automatically, generating a set of ordered items without needing to manually submit a service catalog request. For example, an onboarding workflow for a new employee can automatically run an order guide to order items for that employee.

The script field in an order guide can be used to add or remove catalog items to or from the order guide. It can be added to the order guide form by configuring the form layout.

- To add a catalog item that is not added to the order guide via a rule base, write the following code in the script field:

  ```java
  guide.add("<sys_id_of_cat_item>")
  ```

- To remove a catalog item that is added to the order guide via a rule base, write the following code in the script field:

  ```java
  guide.remove("<sys_id_of_cat_item>")
  ```

**Video tutorial about order guides**

Shows how an order guide works from the self-service user perspective, and demonstrates how to create an order guide.

**Create an order guide**

You can create an order guide with a two-step or three-step ordering process.

**Procedure**

1. Navigate to **Service Catalog > Catalog Definition > Order Guides**.
2. Click **New**.
3. Fill in the fields as appropriate.
## Order guide

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Order guide name that appears in the catalog.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to indicate whether the order guide is active or not.</td>
</tr>
<tr>
<td>Category</td>
<td>Category heading under which the order guide appears in the catalog.</td>
</tr>
<tr>
<td>Two step</td>
<td>Check box to enable two step ordering instead of the default <strong>three-step ordering</strong>, omitting the final step. With two step ordering, selecting <strong>Check out</strong> submits the request immediately, then displays the order confirmation screen. This is not applicable for Service Portal.</td>
</tr>
<tr>
<td>Icon</td>
<td>A 16x16 pixel image to appear as an icon beside the order guide name in the catalog. If no image is uploaded, the default icon appears beside this order guide. To use your own default icon, upload an image, overwriting the image stored in images/service_catalog/generic_small.gif.</td>
</tr>
<tr>
<td>Cascade variables</td>
<td>Check box to select whether the variables used cascade, which passes their values to the ordered items. If this check box is cleared, variable information entered in the order guide is not passed on to ordered items.</td>
</tr>
<tr>
<td>Ordered Item Link</td>
<td>Link to more information about an ordered item. Select a predefined link item to appear on the ordered item screen. Customers can click the link to access more information. This is not applicable for Service Portal.</td>
</tr>
<tr>
<td>Roles</td>
<td>Roles that users must have to access this order guide.</td>
</tr>
<tr>
<td>Short description</td>
<td>Summary of the order guide purpose.</td>
</tr>
<tr>
<td>Description</td>
<td>Description that appears on the first page of the order guide. Apply formatting with the HTML editor.</td>
</tr>
<tr>
<td>Meta</td>
<td>Comma-separated list of tags used to search for the order guide. See <a href="#">Configure keyword search for catalog items</a>.</td>
</tr>
<tr>
<td>Hide on Service Portal</td>
<td>If selected, the order guide is not available on Service Portal.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Picture</td>
<td>[Optional] Image of the item.</td>
</tr>
<tr>
<td>Order to cart</td>
<td>Check box allowing users to add order guides to their cart, then continue shopping rather than checking out immediately. This is not applicable for Service Portal.</td>
</tr>
<tr>
<td></td>
<td>Note: This setting only works when the Two step check box is also set to true.</td>
</tr>
</tbody>
</table>

### Portal Settings

Use these settings to configure the order guide behavior in Service Portal.

**Request method**

Setting that controls the label displayed for the **Order Now** button and the order submission experience.

- **Order**:
  - Button label: **Order Now**
  - Confirmation dialog box: Displayed
  - Delivery information: Editable

  Note: This is the default setting.

- **Request**:
  - Button label: **Request**
  - Confirmation dialog box: Displayed
  - Delivery information: Not displayed

  This setting can be used in scenarios such as a code access request where the delivery information is pre-determined.

- **Submit**:
  - Button label: **Submit**
  - Confirmation dialog box: Not displayed
  - Delivery information: Not displayed

  This setting can be used in scenarios such as reset password request where no further request information is required.

**Hide ‘Add to Cart’**

If selected, the **Add to Cart** button is not displayed for the order guide. If the **Show Add to Cart** instance option of the widget is set to false, then this setting is ignored.

This setting is selected by default if the **Request method** is **Request** or **Submit**.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>For upgrade scenarios, if the <strong>No cart</strong> field is selected in Platform, run the <code>CatalogPortalSettingsMigration</code> script include to update this setting to the <strong>Hide 'Add to Cart'</strong> field in the <strong>Portal Settings</strong> tab.</td>
<td></td>
</tr>
</tbody>
</table>

**Show Include Toggle**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If selected, a toggle is displayed for each catalog item in the <strong>Choose Options</strong> section in Service Portal. You can click this toggle to include or exclude the catalog item from the order guide request.</td>
</tr>
<tr>
<td>For zboot customers, this option is selected by default for existing order guides in the demo data and new order guides.</td>
</tr>
<tr>
<td>For upgrade customers, this option is selected by default only for new order guides.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click **Save**.

5. In the **Rule base** related list, define the **rules** that determine which items are included in an order.

6. **Optional:** In the **Variables** related list, define any variables required.

**Request an order guide**

Once created, order guides present the customer with a three-step ordering process by default.

**Procedure**

1. **Describe Needs:** Enter information as prompted. Order guide rules evaluate this information to determine which catalog items to order.

2. **Choose Options:** Select configuration options for the ordered items and provide any additional information needed, including attachments.

3. **Check Out:** Review and edit item information, then click **Submit Order** to place the request. If the requested item was ordered as part of an order guide, the **Order Guide** field on the Requested Item form shows the order guide name.

**Note:** The Check Out step can be omitted from an order guide to provide a quicker two-step process. To omit this third step, select the **Two step** check box when creating the order guide.
Review an order guide example

Consider a scenario where you have a New Employee Hire order guide that provides services and items as part of the onboarding process.

About this task

Procedure

1. **Describe Needs**: The order guide prompts the end user for information.

![Order guide example](image)

2. **Choose Options**: The order guide uses the information entered and predefined rules to generate options.

![Order guide example](image)

The end user selects configuration options for the ordered items, and provides any additional information needed.
3. Check Out: The end-user reviews and edits item information, then click **Submit Order** to place the request.

---

**Create an order guide rule to add a catalog item**

You can add a catalog item to an order guide using specific rules.

**About this task**

Order guide rules define conditions that must be met for a specific item to be included in an order. For example, a New Employee Hire order guide rule can state that if the new employee job title is CTO or Director, and the department is IT, then add an executive desktop item to the order.

**Procedure**

1. Navigate to **Service Catalog > Catalog Definition > Order Guides**.
2. Open an order guide.
3. In the **Rule base** related list, click **New**.
4. On the form, fill in the fields.

---

**Rule guide**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guide</td>
<td>The order guide to which the created rules are applied.</td>
</tr>
<tr>
<td>At this position</td>
<td>Tab positions are numbered in order from left to right, with the lowest number appearing at the left of the screen.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Application</td>
<td>Name of the application that is being used.</td>
</tr>
<tr>
<td>If this condition is true</td>
<td>Conditions that must be true for this rule to apply. Create conditions using the <strong>condition builder</strong>. Conditions can be evaluated against <strong>Keywords</strong>, <strong>Requested By</strong>, <strong>Requested For</strong>, or any variables defined for that order guide.</td>
</tr>
<tr>
<td>Include this item</td>
<td>Item to include in the order if all conditions defined in <strong>If this condition is true</strong> are matched.</td>
</tr>
<tr>
<td><strong>Note:</strong> You can also include record producers in the order guide.</td>
<td></td>
</tr>
<tr>
<td>Ignore Mandatory Evaluation</td>
<td>Check box to allow customers to proceed without completing mandatory fields for the Describe Needs and Choose Options screens. The mandatory status of a field is determined by the variable defining that field. If mandatory fields are not enforced, then relevant information is not passed on to the ordered items. For example, in a New Employee Hire order guide, if the address is not provided then this information is not included in business cards ordered.</td>
</tr>
<tr>
<td>Use cart layout</td>
<td>Check box to use the cart layout that has been configured. Uncheck this check box to access the <strong>Show quantity</strong> check box option.</td>
</tr>
<tr>
<td>Show quantity</td>
<td>Check box to show the quantity ordered within the order confirmation. (Only visible if <strong>Use cart layout</strong> is unchecked.)</td>
</tr>
<tr>
<td>Quantity</td>
<td>Default quantity for the order guide. When quantity is shown, this value can be modified during checkout.</td>
</tr>
</tbody>
</table>

5. Click Submit.

**Create an order guide variable**

You can create variables within an order guide.

To create or edit order guide variables, open an order guide, then select an entry from the **Variables** related list.

Service catalog variables within order guides define the questions and potential answers presented to the customer while ordering. This information is used by order guide rules. Variables can also be cascaded, which passes the variable values along to individual ordered items.
Pricing is not supported for an order guide variable, even when you define the pricing for the variable though a variable set, and associate the variable set to the order guide.

Create an item variable assignment

Create an item variable assignment that enables the catalog admin set up a default value mechanism in the order guide context so that the user can focus only on required values.

About this task

For example, you can set the default storage of an iPhone to 64 GB for Sales, and to 16 kB for Development. This setting is configured in the new hire order guide by using mutually exclusive rules and setting the storage variable accordingly for Sales and Development.

The value for an item variable is determined in the following order:

1. Item variable assignment
2. Cascading value (if no item variable assignment exists)
3. Default value defined in the variable definition (if no cascading value or item variable assignment exists)

Procedure

1. Navigate to Service Catalog > Catalog Definition > Order Guides.
2. Open an order guide.
3. Open a rule.
4. In the Item Variable Assignments related list, click New.
5. On the form, fill in the fields.

Item Variable Assignment form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Variable</td>
<td>Name of the Item variable. Select an item variable from the list or create one.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to make the record active.</td>
</tr>
<tr>
<td>Assignment Type</td>
<td>Name of the assignment type. Select either Order Guide Variable or Value. When Order Guide Variable is selected, the Order Guide Variable field is enabled.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Order Guide Variable</td>
<td>Name of the order guide variable. Select an order guide variable from the list or create one. (This field is only visible if Assignment Type is Order Guide Variable.)</td>
</tr>
</tbody>
</table>

6. Click Submit.

What to do next
Set an item variable value to match an order guide variable value, or an order guide default value, using an item variable assignment.

**Cascade an order guide variable**
Cascading enables values entered for variables in the initial order form to be passed to the equivalent variables in the ordered catalog items.

Cascading allows values entered for variables in the initial order form to be passed to the equivalent variables in the ordered catalog items. For example, a variable on the initial order form prompts the customer to enter a delivery location value. If you enable cascading, the value for this variable then populates delivery location fields on each of the ordered items.

To enable cascading, select the **Cascade variables** check box when creating the order guide. Then, create variables on the catalog items that match the names of the corresponding variables in the order guide. When a customer places an order, the variables on the ordered items inherit the values of the identically named variables in the order guide.

**Use a variable set**
You can use a variable set with an order guide.

**About this task**
Cascading variables require that the same variable be on both the order guide and the ordered items. It can be useful to define each variable once in a variable set, then assign the variable set to both the order guide and the individual catalog item. This approach avoids duplication and ensures that the variable is the same in both locations.

To use a variable set with an order guide:

**Procedure**
1. Create the variable set.
2. In the Variable Set form, create each variable.
3. Add the variable set to the order guide and to each catalog item involved.

⚠ Note: The individual variables in a variable set do not appear in the Order guide or Catalog Item forms. To view the variables in a variable set, open the variable set record.

**Hide cascaded variables**

You can hide the duplicated variables on the **Choose Options** screens to keep your screen clean.

When cascading variables, you can hide the duplicated variables on the Choose Options screens, making these screens simpler.

To hide duplicate variables on all screens after the initial Describe Needs screen in the Service Catalog Platform UI, run an **onLoad catalog client** script.

Example:

```javascript
function onLoad(){
    var item = $('current_item');
    var guide = $('sysparm_guide');

    if (item == null && guide == null)
        return;

    if(item != null && guide != null && item.value == guide.value)
        return;
    g_form.setDisplay('YOUR_VARIABLE_NAME',false);
}
```

To hide duplicate variables on all screens after the initial Describe Needs screen in Service Portal, use the **isOrderGuide()** API.

Example:

```javascript
if(g_service_catalog.isOrderGuide())
    g_form.setDisplay('variable_name', false);
```

**Avoid enforcement of a mandatory field**

You can avoid enforcing a mandatory field within tabs.

**About this task**

By default, mandatory fields must be filled in before switching tabs in the **Choose Options** section of order guides.
**Order guide mandatory fields**

In this example, if the customer attempts to select another tab without filling in the *Street Address* field, a warning prompt appears. The customer cannot switch tabs without entering this information.

To avoid this enforcement in all order guides:

**Procedure**

1. Navigate to **Service Catalog > Catalog Administration > Properties**.
2. Locate the property *Validate mandatory fields when switching tabs in 'Choose Options' section of Order Guides* (*glide.sc.guide.tab.validate*).
3. Clear the *Yes* check box.

   If you make this change, mandatory fields are still mandatory, but the customer can switch between tabs before filling in the mandatory fields. Enforcement is then checked when the customer chooses to proceed to the next step.

   To avoid enforcement of mandatory fields altogether, use the *Ignore Mandatory Evaluation* check box within the relevant order guide rule.

**Run order guides automatically**

You can run an order guide automatically from within a workflow or a server script, passing parameters to that order guide to define variable values.

Automatically generate a set of ordered items as part of a wider process, without needing to manually submit a service catalog request and reenter existing information.
For example, you can run an order guide to fulfill HR onboarding requests, passing parameters such as the new employee’s position and department. The order guide then generates a set of requested items such as laptop and email account, based on those parameters.

**Define a content item**

A content item is a service catalog item that provides information instead of goods or services.

**About this task**

Content items can reference knowledge articles, static blocks of text, or external web-based content.

To define content items:

**Procedure**

1. Navigate to **Service Catalog > Catalog Definition > Content Items**.
2. Click **New**.
3. Fill in the form to define the item.

**Content Item form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name, Category, Icon, Roles, Active,</td>
<td>As for standard catalog items.</td>
</tr>
<tr>
<td>Content type</td>
<td>The type of information to display when a user selects the item.</td>
</tr>
<tr>
<td></td>
<td>• <strong>KB Article</strong>: a ServiceNow knowledge article available to users with the specified roles.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Catalog Content</strong>: a static block of text, formatted with HTML.</td>
</tr>
<tr>
<td></td>
<td>• <strong>External Content</strong>: documents or web pages stored outside the base system instance.</td>
</tr>
<tr>
<td>Target</td>
<td>Location where the content appears.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
• **Within Catalog**: displays the content within the catalog iframe window (which may not render some external websites properly).  
• **New Window/Tab**: displays the content in a new browser window or tab. Choose this option if the content does not display properly within the catalog.

**URL** | The full URL (including the prefix http:// or https://) for external content to display when a user selects the item. This field is available only if the **Content type** is **External Content**.

**Note**: Since base system instances are accessed via HTTPS, links to HTTP sites could result in a mixed mode content error or warning, depending on browser security settings.

**KB article** | The knowledge article to display when a user selects the item. This field is available only if the **Content type** is **KB Article**.

**Short description, Description, Picture** | As for standard catalog items. These fields are only available if the **Content type** is **Catalog Content**.

**Meta** | Comma-separated list of tags used to search for the content item. See **Configure keyword search for catalog items**.

**Hide on Service Portal** | If selected, the content item is not available on Service Portal.

4. Click **Submit**.

### Create or edit a catalog item
Define individual catalog items using Service Catalog. You can create, edit, and copy catalog items.

**Before you begin**
Role required: admin

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Procedure

1. Navigate to Service Catalog > Catalog Definition > Maintain Items.
2. Click New.
3. Enter the catalog item details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to appear in the catalog.</td>
</tr>
<tr>
<td>Catalogs</td>
<td>Catalogs this item appears in.</td>
</tr>
<tr>
<td>Category</td>
<td>Category for the item. Categories can only be selected after the Catalogs field is populated. Catalog searches find only items that are assigned to a category.</td>
</tr>
<tr>
<td>Model</td>
<td>Product model to which the item is linked. This field is visible by default only for items created by publishing models. Click the reference icon to view the product model.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to make the item active (available to be ordered).</td>
</tr>
</tbody>
</table>

**Note:** Inactive catalog items added to order guides do not appear in the order guide. Use Visible On Guide, Visible elsewhere to hide the item and show only in the order guide.

<table>
<thead>
<tr>
<th>Access Type</th>
<th>Option to specify if a request can be submitted for a user who does not have access to the catalog item. Possible options are:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Restricted: The request can only be submitted for users who have access to the catalog item.</td>
</tr>
<tr>
<td></td>
<td>• Delegated: The request can be submitted even for users who do not have access to the catalog item.</td>
</tr>
</tbody>
</table>

By default, this field is set to Restricted. For information about delegated request experience, see Delegated request experience.

**Note:** This functionality is only applicable when the catalog item has a Requested For variable.

<p>| Owner       | Owner of the catalog item who has edit access to it.                                                                    |
| Template    | Template using which the item is created.                                                                               |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview Link</td>
<td>Click <strong>Preview Item</strong> to preview in a new window how the current item definition would look in the catalog.</td>
</tr>
<tr>
<td>Ordered Item Link</td>
<td>Link to preview, as shown on the ordered item screen.</td>
</tr>
<tr>
<td>Hide on Service Portal</td>
<td>If selected, the catalog item is not available on Service Portal.</td>
</tr>
<tr>
<td>Availability</td>
<td>Devices to display the item: Desktop and Classic Mobile, Desktop Only, or Classic Mobile Only.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Unsupported catalog item types are not displayed on Classic Mobile devices, even if Availability is set to show an item of this type.</td>
</tr>
<tr>
<td>Item Details</td>
<td></td>
</tr>
<tr>
<td>Short Description</td>
<td>Text that appears on the service catalog homepage, search results, and the title bar of the order form.</td>
</tr>
<tr>
<td>Description</td>
<td>Full description of the item. This description appears in the catalog when a user selects the item or clicks the associated Preview link.</td>
</tr>
<tr>
<td></td>
<td>You can embed videos, images, links to internal knowledge base (KB) articles, and links to external sources of information and instruction documentation.</td>
</tr>
<tr>
<td>Meta</td>
<td>Comma-separated list of tags used to search for the catalog item. Use commas between keywords for better results when searching. The Zing search engine removes common words from search queries that do not produce meaningful results.</td>
</tr>
<tr>
<td>Process Engine</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can specify a value for only one of these fields.</td>
</tr>
<tr>
<td>Flow</td>
<td>Flow that defines how the item request is fulfilled.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Workflow that defines how the item request is fulfilled.</td>
</tr>
<tr>
<td>Execution plan</td>
<td>Execution plan (formerly named delivery plan) that defines how the item request is fulfilled.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icon</td>
<td>Image to appear as an icon beside the item name in the catalog. Upload a 27x27 pixel image. If no image is uploaded, the default icon appears beside this item. To use your own default icon, upload an image. The uploaded image overwrites the default image stored in images/service_catalog/generic_small.gif.</td>
</tr>
<tr>
<td>Picture</td>
<td>Image of the item.</td>
</tr>
<tr>
<td>Classic Mobile</td>
<td>Type of picture to display for the item on mobile devices. Set to Desktop to use the standard desktop picture, Classic Mobile to use a specific image for the mobile device using the Mobile picture field, or None to not use a picture.</td>
</tr>
<tr>
<td>Classic Mobile Picture</td>
<td>Image file for the mobile picture. The field appears if Classic Mobile picture type is set to Classic Mobile.</td>
</tr>
<tr>
<td>Hide Price (classic mobile listings)</td>
<td>Check box to hide the item price on mobile devices. Clear the check box to display the price.</td>
</tr>
<tr>
<td>Pricing</td>
<td></td>
</tr>
<tr>
<td>Price</td>
<td>Price for the item. Select the currency from the choice list.</td>
</tr>
<tr>
<td>Recurring Price</td>
<td>Price that occurs repeatedly at a regular interval. For example, a printer maintenance service could have a $100.00 monthly recurring price.</td>
</tr>
<tr>
<td>Recurring Price Frequency</td>
<td>Time frame for recurrence, such as Monthly or Annually, only if the Recurring Price field has an entry.</td>
</tr>
<tr>
<td>Omit Price in Cart</td>
<td>Check box to hide the item price in the cart and the catalog listing.</td>
</tr>
<tr>
<td>Portal Settings</td>
<td>Use these settings to configure the catalog item behavior in Service Portal.</td>
</tr>
<tr>
<td>Request method</td>
<td>Setting that controls the label displayed for the Order Now button and the order submission experience.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Order:</strong></td>
<td></td>
</tr>
<tr>
<td>◦ Button label: <strong>Order Now</strong></td>
<td></td>
</tr>
<tr>
<td>◦ Confirmation dialog box: Displayed</td>
<td></td>
</tr>
<tr>
<td>◦ Delivery information: Editable</td>
<td></td>
</tr>
<tr>
<td>i Note:        This is the default setting.</td>
<td></td>
</tr>
<tr>
<td><strong>Request:</strong></td>
<td></td>
</tr>
<tr>
<td>◦ Button label: <strong>Request</strong></td>
<td></td>
</tr>
<tr>
<td>◦ Confirmation dialog box: Displayed</td>
<td></td>
</tr>
<tr>
<td>◦ Delivery information: Not displayed.</td>
<td></td>
</tr>
<tr>
<td>This setting can be used in scenarios such as a code access request where the delivery information is pre-determined.</td>
<td></td>
</tr>
<tr>
<td><strong>Submit:</strong></td>
<td></td>
</tr>
<tr>
<td>◦ Button label: <strong>Submit</strong></td>
<td></td>
</tr>
<tr>
<td>◦ Confirmation dialog box: Not displayed</td>
<td></td>
</tr>
<tr>
<td>◦ Delivery information: Not displayed</td>
<td></td>
</tr>
<tr>
<td>This setting can be used in scenarios such as reset password request where no further request information is required.</td>
<td></td>
</tr>
<tr>
<td><strong>Hide 'Add to Cart'</strong></td>
<td>If selected, the <strong>Add to Cart</strong> button is not displayed for the item. If the <strong>Show Add to Cart</strong> instance option of the widget is set to false, then this setting is ignored. This setting is selected by default if the <strong>Request method</strong> is <strong>Request</strong> or <strong>Submit</strong>. For upgrade scenarios, if the <strong>No cart</strong> field is selected in Platform, run the <strong>CatalogPortalSettingsMigration</strong> script include to update this setting to the <strong>Hide 'Add to Cart'</strong> field in the <strong>Portal Settings</strong> tab. i Note: Applicable for a catalog item and order guide.</td>
</tr>
<tr>
<td><strong>Hide Quantity</strong></td>
<td>If selected, the <strong>Quantity</strong> list is not displayed for the catalog item. This is selected by default if the <strong>Request method</strong> is <strong>Request</strong> or <strong>Submit</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>For upgrade customers, if the <strong>No quantity</strong> field is selected in Platform, run the <strong>CatalogPortalSettingsMigration</strong> migration script to update this setting to the <strong>Hide Quantity</strong> field in the <strong>Portal Settings</strong> tab.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• Applicable for a catalog item.</td>
</tr>
<tr>
<td></td>
<td>• An order guide inherits this setting from the included catalog item.</td>
</tr>
<tr>
<td>Hide Delivery time</td>
<td>If selected, the <strong>Delivery Time</strong> field is not displayed for the catalog item.</td>
</tr>
<tr>
<td></td>
<td>This is selected by default if the <strong>Request method</strong> is <strong>Submit</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• Applicable for a catalog item.</td>
</tr>
<tr>
<td></td>
<td>• An order guide inherits this setting from the included catalog item.</td>
</tr>
<tr>
<td>Hide ‘Add to Wish List’</td>
<td>If selected, the <strong>Add to wish list</strong> button is not displayed for the catalog item. If the wish list is disabled for the catalog item or the portal widget instance option is set to false, then this setting is overridden for the item.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Applicable for a catalog item and record producer.</td>
</tr>
<tr>
<td>Hide Attachment</td>
<td>If selected, the <strong>Add attachments</strong> button is not displayed for the catalog item.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• Applicable for a catalog item and record producer.</td>
</tr>
<tr>
<td></td>
<td>• An order guide inherits this setting from the included catalog item.</td>
</tr>
<tr>
<td>Mandatory Attachment</td>
<td>If selected, adding an attachment is mandatory for the catalog item.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Applicable for a catalog item and record producer.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>This section is available only when the Universal Request plugin (com.snc.universal_request) is activated. For information about this configuration, see Service Catalog configuration for Universal Request.</td>
<td></td>
</tr>
<tr>
<td>UR certified/enabled item</td>
<td>Option to specify that a universal request should also be created along with a requested item. In the universal request, a reference is created to the associated requested item, which becomes the primary task of the universal request.</td>
</tr>
<tr>
<td>Requires Additional Review</td>
<td>Option to automatically select the Needs resolution review check box on the corresponding universal request. For information about the universal request fields, see Universal Request form. The Requires Additional Review field appears only when the UR certified/enabled item check box is selected.</td>
</tr>
<tr>
<td>Fields that can be added by configuring the form</td>
<td></td>
</tr>
<tr>
<td>Expand help for all questions</td>
<td>Check box to expand and display help information for all questions on loading the page.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td></td>
</tr>
<tr>
<td>• This field is also applicable in Service Portal.</td>
<td></td>
</tr>
<tr>
<td>• If the Expand help for all questions check box is selected at the catalog item level, then the Always Expanded field setting at the variable level is overridden.</td>
<td></td>
</tr>
<tr>
<td>• If the Expand help for all questions check box is deselected at the catalog item level, then the Always Expanded field setting at the variable level is applicable.</td>
<td></td>
</tr>
<tr>
<td>Template</td>
<td>Template to populate the generated record with predefined values. The field is available for Record Producer items only.</td>
</tr>
<tr>
<td>No Quantity</td>
<td>Check box to hide the quantity selector for the item.</td>
</tr>
<tr>
<td>No Cart</td>
<td>Check box to hide the shopping cart for the item.</td>
</tr>
<tr>
<td>No search</td>
<td>Check box to prevent this item from being listed in search results and also in the Service Catalog widget on the Service Portal. If this is selected:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• In Service Portal, you can neither browse nor search for the item.</td>
</tr>
<tr>
<td></td>
<td>• In Platform, you can browse to find the item.</td>
</tr>
<tr>
<td>Order</td>
<td>Controls the ordering of items in category lists.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain in which the catalog item is created. Applicable when the domain separation is enabled in Service Catalog. For information about domain separation, see Domain separation and Service Catalog.</td>
</tr>
<tr>
<td>Domain Path</td>
<td>Series of three-character codes separated by a slash (/) delimiter to identify a domain. This path string is unique in the domain hierarchy. Applicable when the domain separation is enabled in Service Catalog.</td>
</tr>
</tbody>
</table>

**Related Links**

<table>
<thead>
<tr>
<th>Item Diagnostic</th>
<th>Generates a diagnostic report and score to identify possible issues within the Service Catalog data and configuration.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit checked out item in advanced view</td>
<td>Allows you to edit the catalog item in the advanced view. To add a catalog client script to a checked out item in the Draft state, you can click this related link and add the catalog client script using the Catalog Client Scripts related list.</td>
</tr>
</tbody>
</table>

**Note:** This option is available only after you click Edit in Catalog Builder to edit an item in catalog builder.

**Related Lists**

<table>
<thead>
<tr>
<th>Variables</th>
<th>Variables for the item to provide options for ordering the item.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable Sets</td>
<td>Variable Set linked to the item.</td>
</tr>
<tr>
<td>Link an existing variable set to the item to provide multiple options for ordering the item.</td>
<td></td>
</tr>
<tr>
<td>Approved By Group</td>
<td>Groups that must approve requests for this item.</td>
</tr>
<tr>
<td>Approved By</td>
<td>Users who must approve requests for this item.</td>
</tr>
<tr>
<td>Categories</td>
<td>Additional categories associated with this item.</td>
</tr>
<tr>
<td>Catalogs</td>
<td>Additional catalogs associated with this item.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Catalog Data Lookup Definitions</td>
<td>Catalog data lookup rules associated with the catalog item. For information on creating a data lookup rule, see Create a catalog lookup definition.</td>
</tr>
<tr>
<td>Catalog UI Policies</td>
<td>Catalog UI policies associated with this item.</td>
</tr>
<tr>
<td>Catalog Client Scripts</td>
<td>Catalog client scripts associated with this item.</td>
</tr>
<tr>
<td>Related Items</td>
<td>Related items for a catalog item to provide alternatives. These items are displayed in the catalog item page in Service Portal and Now Mobile.</td>
</tr>
<tr>
<td>Related Articles</td>
<td>Related articles for a catalog item to provide additional information. These articles are displayed in the catalog item page in Service Portal and Now Mobile.</td>
</tr>
<tr>
<td>Service Fulfillment Steps</td>
<td>Associated service fulfillment steps.</td>
</tr>
<tr>
<td>Assigned Topics</td>
<td>Associate a catalog item to a taxonomy and topic. Reserved for future use.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**What to do next**

- Assign the item to additional catalogs and categories, if required.
- Define **variables** for the item, if applicable.
- To add attachments such as information and instruction documentation to the catalog item, see [Add an attachment].

**Related information**

- [Create a service catalog variable](#)
- [Apply user criteria to items](#)
- [Set a recurring price](#)
**Edit a catalog item**

Catalog administrators can edit an item from the service catalog listing. Catalog managers and catalog editors can also edit an item if they are assigned to the item.

**About this task**
To edit a catalog item from the service catalog listing:

**Procedure**
Right-click the header and select one of the following options:
- **Configure Variables**: Add or remove variables from an item.
- **New Variable**: Create a new variable for the item.
- **Configure Item**: Edit the item definition.
- **Configure Client Scripts**: Edit the catalog client scripts for the item.
- **Configure UI Policies**: Edit the catalog UI policies for the item.

**Copy a catalog item**
Copy an item to create a full duplicate of the item, including the item details, attachments, variables, client scripts, and approvals.

**About this task**
Copying can be more useful than using the Insert function because the function only copies the item details.
Procedure

1. Open a catalog item form.
2. Use the Copy button to create a new copy of a catalog item, named Copy of [item name].

Note:
- If you copy an active catalog item, the copy is also active. Consider deactivating the copy by clearing the Active check box until your changes are complete.
- When you specify a table in the Relationship tables which should be part of the Copy Item Action. Table names should be comma separated property in the Service Catalog > Catalog Administration > Properties page, the table records that have a reference to a catalog item are also copied. It is applicable only when you copy the catalog item using the Copy UI action. Table names should be comma-separated without any spaces.

Add a catalog item

Service catalog enables you to add a catalog item to multiple catalogs and categories.

About this task
A catalog item may be available in more than one catalog and category. For example, a laptop carrying case can be available from both Laptops and Cases and Accessories categories.

Within an item:
- The Catalogs related list defines the catalogs where the item is available.
- The Categories related list defines the categories where the item is available.

Procedure

To assign an item to another category or catalog, enter the new details in the appropriate related list.

Note: The values in these lists override the values of the Catalogs and Category fields in the catalog item form. If you change values for either related list, these changes automatically update the values in those fields.
Share catalog items across catalogs

You can share a catalog item, enabling users to order that item from different catalogs. For example, you can share a Password Reset item across catalogs serving different teams.

About this task

To share a catalog item across several catalogs:

Procedure

1. Navigate to Service Catalog > Catalog Definition > Maintain Items
2. Open the item to share.
3. Select the additional catalogs for that item in the Catalogs field.

Shared Catalog Item
4. Select Update.

The shared item then appears in the Catalog Items related list for each catalog selected.

Item diagnostic report

For a catalog item data and configuration, you can identify possible violations from the ServiceNow recommended practices.

The item diagnostic report includes a score that measures the health of the item, and a list of diagnostic result entries. These entries consist of a rule, a document (record that violates the rule), and a count (the number of violations in the record).

Correct violations for best performance and to maintain expected behavior.

The lower the score, the better (0 is ideal). A higher score means that an item has more violations from the ServiceNow recommended practices. Each rule has a different weight and level of importance. For example, a violation of duplicate
variables is more likely to result in user issues. An AJAX usage violation is less likely to cause issues since the result could simply cause a delay in the UI.

Default diagnostic rules
These diagnostic rules are designed as per ServiceNow recommended practices.

<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>checkUserCriteriaUsage</td>
<td>Identifies if the item is using entitlements instead of user criteria</td>
</tr>
<tr>
<td>checkBalancedContainers</td>
<td>Checks if the Container Start and Container End variables are balanced.</td>
</tr>
</tbody>
</table>
Default diagnostic rules (continued)

<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>checkDuplicateVariables</td>
<td>Identifies variables with the same name associated to a catalog item (or an associated variable set).</td>
</tr>
<tr>
<td>checkDOMManipulation</td>
<td>Identifies any DOM violation in catalog client scripts. The DOM is not guaranteed to be the same between releases and can affect catalog client scripts during upgrades. Therefore, it is not recommended for customers to do any kind of DOM manipulation. You can view detailed information for each client script by clicking the information icon.</td>
</tr>
<tr>
<td>checkLookupVariableRowCount</td>
<td>Checks if the Lookup variable is run on tables with many records as it can lead to slower load times.</td>
</tr>
<tr>
<td>checkAJAX</td>
<td>Identifies all AJAX calls in catalog client scripts because, although AJAX calls in catalog client scripts are allowed, they must be asynchronous. All AJAX calls are listed because even asynchronous calls can cause some delay. You can view detailed information for each client script by clicking the information icon.</td>
</tr>
<tr>
<td>checkSelectBoxUnique</td>
<td>Identifies Select Box type variables that have the attribute enabled to show only unique entries in the select box.</td>
</tr>
<tr>
<td>checkOrderGuideRuleBaseCount</td>
<td>Checks for high number of active rule bases in an order guide as higher number of rule bases can lead to slower load times</td>
</tr>
<tr>
<td>checkFormatterVariablesUsage</td>
<td>Checks if the item has the following variable types:</td>
</tr>
</tbody>
</table>
### Default diagnostic rules (continued)

<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Macro</td>
<td></td>
</tr>
<tr>
<td>• Macro with label</td>
<td></td>
</tr>
<tr>
<td>• UI Page</td>
<td></td>
</tr>
</tbody>
</table>

For information on the variable availability across various channels, see [Variable support in various channels](#).

---

### Run the Item Diagnostic Results report

Identify the catalog items that are not designed per ServiceNow recommended practices to run your catalog efficiently.

**Before you begin**

Role required: admin or catalog_admin
About this task
This report runs every weekend on all catalog items of all types.

Procedure
1. Navigate to Service Catalog > Catalog Administration > Request Reports.
2. Select the [Catalog] Item Diagnostics Results report.
   A report is displayed with all active catalog items with a non-zero score. These catalog items are grouped by score and each score has a different color.
3. Click the score to diagnose the associated catalog items.

   Note:
   • Any item with a score greater than zero indicates a recommended practice rule violation.
   • The higher the score, the more is the catalog item deviating from ServiceNow recommended practices.
4. Click the score of the required catalog item.
   Diagnostic results are displayed for the catalog item with violated rules.
   For information on default diagnostic rules per ServiceNow recommended practices, see Item diagnostic report.
5. To understand details of each violated rule, click the Count value for that rule.

Specify related items and articles for a catalog item
Specify related items and articles for a catalog item to provide alternatives and additional information. These items and articles are displayed in the catalog item page in Service Portal and Now Mobile.

Before you begin
Role required: admin, catalog_admin, or catalog_editor

About this task
You cannot specify related items and articles for an order guide.
You cannot specify these types of items as related items for a catalog item.
• Wizard Launcher
• Content Item
• Standard Change Template
• Any item in Admin Home catalog
Procedure

1. Navigate to Service Catalog > Catalog Definitions > Maintain Items.
2. Select the required catalog item.
3. To specify a related article, perform these steps.
   a. In the Related Articles related list, click Edit.
   b. On the Edit Members form, move the required articles from the Collection column to the Related Articles List column.
   c. Click the up or down icon to arrange articles in the required order and click Save.
4. To specify a related catalog item, perform these steps.
   a. In the Related Catalog Items related list, click Edit.
   b. On the Edit Members form, move the required items from the Collection column to the Related Catalog Items List column.
   c. Click the up or down icon to arrange items in the required order and click Save.

   Note: In Service Portal, use the instance options to configure the number of articles and items shown in the Related Articles and Related Items section. See Configure related catalog item widget instance options or Configure knowledge related articles widget instance options.

Related information

Map related articles

Add an ordered item link to an item

Use ordered item links to provide a link on the ordered item screen that provides more information about an item.

Before you begin
Role required: Catalog administrator

About this task
After you order the catalog item, you can click the link to see relevant information about the item ordered, for example, for standard delivery terms and conditions. The URL text and link can be defined once and reused across multiple items.

Links are rendered with an added parameter providing the sys_id of the requested item. For example, if the link is mylink.com, it is rendered as
mylink.com?req_item=abcde12345. This added parameter can be useful for virtual provisioning situations.

⚠️ Note: Ordered item links cannot be configured for Classic Mobile devices.

Procedure
1. Navigate to Service Catalog > Catalog Definition > Ordered Item Links.
2. Click New.
3. Enter a Name for the ordered item link.
4. Enter Link text to display as the link. For example, click here to see more information about the iPhone.
5. Enter the exact Link URL. For example, http://www.mylink.com.
6. Select the Target. You can choose to open the link in a new window or tab, or within the catalog. If Within Catalog is chosen, the link must be within the same site. An HTTP site cannot be called from within HTTPS.
7. Click Submit.
8. Navigate to Service Catalog > Catalog Definition > Maintain Items.
9. Click an item Name.
10. In the Ordered Item Link field, click the reference lookup icon.
11. Click an ordered item link Name.
12. Click Update.

Service catalog UI policy
UI policies can be used to define custom process flows for tasks.

Catalog UI policies control the behavior of catalog item forms when presented to your users. Catalog UI policies can be applied to a catalog item or a variable set.

UI policies are useful when applied to service catalog items. Keep the following points in mind when creating service catalog UI policies:

- A catalog UI policy applies to either a specific catalog item or any item that uses a specific variable set.
- A catalog UI policy can only contain and reference variables that are defined for the catalog item or variable set.
- Like UI policy conditions, the variables in a service catalog UI policy condition must be visible (even if hidden by UI policy or read-only) on the form for the
condition to be tested. Also, ensure that the variables have names. For more information, see Create a catalog client script.

- Limited UI policy functionality applies to following variables:
  - The Mandatory and Read Only policy do not apply to the following variable types: Break, Container Split, Container End, UI Macro, UI Macro with Label, Label, UI Page.
  - The Set visible policy does not apply to the following variable types: Break, Container Split, Container End.

- Service catalog UI policies are applied to variables and variable sets of catalog items ordered in the service catalog. Policies can also be applied when the variables are present in a Requested Item or Catalog Task form.

- Catalog UI policy actions can be applied on a variable set. The actions on a variable set are applied on all variables within the variable set. If different catalog UI policy actions are applied on a variable or a variable set, the action with the lowest order is considered.

- The priority order for UI actions types is:
  1. Mandatory (highest)
  2. ReadOnly/Display

If a variable is set to mandatory and does not have value, readonly or hide do not work on that variable. If a variable is hidden or readonly, and then set to mandatory, the variable field becomes visible or editable.

This priority order is also applicable for variable sets and containers. If a variable set or container has a mandatory variable without any value, then the container or variable set cannot be hidden.

- Catalog UI policies are supported for catalog items viewed in a service catalog wizard.

> **Note:** The UI policy for catalog items always takes precedence over UI policy for variable sets. You can change this behavior by editing the glide.sc.ui_policy.variable_set_run_first property.

**Create a UI policy for catalog items**

You can apply UI policies for catalog items ordered in the service catalog.

**Procedure**

1. Navigate to Service Catalog > Catalog Administration > Catalog UI Policies.
2. Click New.
3. In the **Applies to** field, select **A Catalog Item**.
4. Fill in the remaining fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Applies to**               | Select the type of item this UI policy applies to:  
  • **A Catalog Item**: enables the **Catalog item** field.  
  • **A Variable Set**: enables the **Variable set** field.                                                                                   |
<p>| <strong>Catalog Item or Variable Set</strong> | Select the catalog item or a variable set this UI policy applies to. The field name and options available depend on the <strong>Applies to</strong> selection. |
| <strong>Short description</strong>        | Enter a brief description (example, Out-of-state move).                                                                                     |
| <strong>Active</strong>                   | Select the check box to enable the UI policy. Clear the check box to disable it.                                                            |
| <strong>When to Apply</strong>            |                                                                                                                                              |
| <strong>Catalog Conditions</strong>       | Create conditions for the UI policy using catalog item variables. The policy is applied if the conditions evaluate to true. For example, a catalog item of <strong>Schedule a Move</strong> may have a condition of <strong>move_from &gt; is &gt; San Diego</strong>. The UI policy is applied when an employee schedules a move from San Diego to any other company location. |
| <strong>Note</strong>: The label of a variable associated with a variable set reflects the variable set name. The format is <code>variable_set_name » variable_name</code>. |
| <strong>Applies on a Catalog Item view</strong> | Select the check box to apply the UI policy to catalog items within the order screen. Available in the requester view.                        |
| <strong>Applies on Catalog Tasks</strong> | Select the check box to apply the UI policy on a Catalog Task form. Available in the fulfiller view. See <strong>VEditor</strong>.                                |
| <strong>Applies on Requested Items</strong> | Select the check box to apply the UI policy on a Requested Item form. Available in the fulfiller view. See <strong>VEditor</strong>.                          |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applies on the Target Record</td>
<td>Select the check box to support the catalog UI policy on a record created for task-extended tables via record producers. See Default variable editor.</td>
</tr>
<tr>
<td>On load</td>
<td>Select the check box to apply the UI policy when the form is loaded. Clear the check box to apply the policy only when the form is changed.</td>
</tr>
<tr>
<td>Reverse if false</td>
<td>Select the check box to reverse the UI policy if the <strong>Catalog Conditions</strong> statement evaluates to false.</td>
</tr>
<tr>
<td>Script</td>
<td>Select the check box to use the <strong>Execute if true</strong> and <strong>Execute if false</strong> scripting fields. Scripts are necessary to apply a UI policy other than <strong>Read Only</strong>, <strong>Mandatory</strong>, or <strong>Visible</strong>. For example, you must create a script to apply a UI policy to a specific role.</td>
</tr>
<tr>
<td>Other fields</td>
<td></td>
</tr>
<tr>
<td>Order</td>
<td>Enter the sequence in which this UI policy is evaluated if more than one matching UI policy exists. The order is evaluated from the lowest value to the highest value.</td>
</tr>
<tr>
<td>Global</td>
<td>This field is not used for the service catalog.</td>
</tr>
<tr>
<td>Inherit</td>
<td>This field is not used for the service catalog.</td>
</tr>
<tr>
<td>Catalog UI Policy Actions</td>
<td></td>
</tr>
<tr>
<td>Variable name</td>
<td>Select the variable or variable set that belongs to the catalog item. When you apply catalog UI policy actions on a variable set, the actions are applied on all variables within the variable set. If different catalog UI policy actions are applied on a variable or a variable set, the action with the lowest order is considered.</td>
</tr>
</tbody>
</table>

**Note:**
- Applying catalog UI policy actions on a variable set is not supported on Service Portal.
- The label of variables associated with a variable set reflects the variable set name. The format is `variable_set_name » variable_name`. 
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Sequence in which the UI policy action is evaluated. The order is evaluated from the lowest value to the highest value. This is also applicable in Service Portal.</td>
</tr>
</tbody>
</table>
| Mandatory           | Choice list for specifying how the UI policy affects the mandatory state of the field. Choices are:  
  • Leave alone  
  • True  
  • False |
| Visible             | Choice list for specifying how the UI policy affects the visible state of the field. Choices are:  
  • Leave alone  
  • True  
  • False |
| Read Only           | Choice list for specifying how the UI policy affects the read-only state of the field. Choices are:  
  • Leave alone  
  • True  
  • False |
| Clear the variable value | Check box to clear the variable value on loading the page. The selection is also applicable in Service Portal. |

5. Click **Submit**.

ℹ️ **Note:** Configure the variable form to display all fields.

**Service Catalog UI policy examples**

The following is an example of how Service Catalog UI policies work.

The following UI policy makes it mandatory for any department to specify the name of the department if **Department** is selected for the question **Department or group?**.
Catalog UI policy

Create a Service Catalog client script

You can create client scripts to customize the catalog.

About this task

Use catalog client scripts to control the behavior of the catalog items when presented to your users. Catalog client scripts can be applied to a catalog item or a variable set. These scripts run on the browser instead of the server, allowing you to better control the information that the user submits.

The priority order for g_form APIs is:

1. Mandatory (highest)
2. ReadOnly/Display
If a variable is set to mandatory and does not have value, readonly or hide do not work on that variable. If a variable is hidden or readonly, and then set to mandatory, the variable field becomes visible or editable.

This priority order is also applicable for variable sets and containers. If a variable set or container has a mandatory variable without any value, then the container or variable set cannot be hidden.

Procedure
1. Navigate to Service Catalog > Catalog Administration > Catalog Client Scripts. A list of current custom catalog client scripts appears.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the catalog client script.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Item type this client script applies to:</td>
</tr>
<tr>
<td></td>
<td>• A Catalog Item: enables the Catalog item field.</td>
</tr>
<tr>
<td></td>
<td>• A Variable Set: enables the Variable set field.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to enable the client script. Clear the check box to disable the script.</td>
</tr>
<tr>
<td>UI Type</td>
<td>Whether to apply this field to desktop, Classic Mobile, or both.</td>
</tr>
<tr>
<td>Script</td>
<td>Enter the client script to run on the service catalog item.</td>
</tr>
<tr>
<td>Type</td>
<td>Select when the script runs, such as onLoad or onSubmit.</td>
</tr>
<tr>
<td>Catalog item or Variable set</td>
<td>Select a catalog item or variable set from the list. The field name and options available depend on the selection in the Applies to field.</td>
</tr>
<tr>
<td>Applies on a Catalog Item view</td>
<td>Check box to apply the catalog client script to catalog items displayed within the order screen on the service catalog. Available in the requester view.</td>
</tr>
<tr>
<td>Applies on Requested Items</td>
<td>Check box to apply the catalog client script on a Requested Item form, after the item is requested. Available in the fulfiller view. See VEditor.</td>
</tr>
<tr>
<td>Applies on Catalog Tasks</td>
<td>Check box to apply the catalog client script when a Catalog Task form for the item is being displayed. Available in the fulfiller view. See VEditor.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Applies on the Target Record</td>
<td>Check box to support the catalog UI policy on a record created for task-extended tables via record producers. See Default variable editor.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

### Debug performance diagnostics of a catalog item

Analyze the impact of the variable setup in a catalog item on its runtime performance, and identify any issues. You can review the processing time of the catalog item and its variables based on the triggered SQL queries.

#### Before you begin

Role required: admin or catalog_admin

#### About this task

The variable SQL debugger is not applicable for the following variables:

- Container Start
- Container End
- Container Split
- Break

#### Procedure

1. Enable the variable SQL debugger by navigating to **Service Catalog > Catalog Variables > Enable Variable SQL Debugger**.

   **Note:**
   - The variable SQL debugger is applicable for catalog items and record producers.
   - After you enable the variable SQL debugger, if you disable the display of the troubleshooting information on a catalog page by navigating to **System Diagnostics > Session Debug > Disable All**, the variable SQL debugger is still active.
   - To disable the variable SQL debugger, navigate to **Service Catalog > Catalog Variables > Disable Variable SQL Debugger**.

2. Navigate to **Service Catalog > Catalog Definitions > Maintain Items**, select a catalog item that you want to debug, and click **Try It**.

3. Click the more options icon (•••) and select **Show Variable SQL Debugger**. The following information is displayed in the Variable SQL Debugger window:
• Number of variables included in the catalog item.
• Number of SQL queries triggered for the catalog item.
• Time taken to process and load the catalog item page.
• Time taken to run all SQL queries of the catalog item.

### Variable SQL debugger fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable</td>
<td>Catalog item variable for which the performance diagnostics are displayed.</td>
</tr>
<tr>
<td>Processing</td>
<td>Time taken to process and load the variable.</td>
</tr>
<tr>
<td>Time</td>
<td></td>
</tr>
<tr>
<td>SQL Count</td>
<td>Number of SQL queries triggered for the variable.</td>
</tr>
<tr>
<td>SQL Time</td>
<td>Time taken to run SQL queries for the variable.</td>
</tr>
<tr>
<td>SQLs</td>
<td>Details of the SQL queries triggered for the variable.</td>
</tr>
</tbody>
</table>

4. To sort by any field, click the field name.

⚠️ **Note:**

- By default, variables are sorted in descending order by their processing time.
- Variables within a single-row or multi-row variable set are displayed in hierarchical order.

5. To view the configuration of a variable, click the variable name.

6. To view a detailed summary of all SQL queries triggered for a variable, click **View Details** in the **SQLs** field of the variable.

7. To change the sort order, Use the **Sort By** list.

⚠️ **Note:** By default, triggered SQLs are sorted in descending order by their execution order.

### Debug user criteria of a catalog item

Debug whether a user can access a catalog item based on the matched user criteria and fix any issues.

**Before you begin**

Role required: catalog_manager, catalog_admin, or admin
About this task
You can only debug access issues based on user criteria, but not based on
access control list rules (ACLs). For information about user criteria, see Set
security for items and categories.

For any scripted user criteria that uses a session api such as gs.getUserID(), the
session of the logged-in user is used. Edit the behavior of the scripted user criteria
using the pre-defined user_id variable in the Script field of a user criteria. For
information about the Script field, see Create a user criteria record in Service
Catalog.

Procedure
1. Navigate to Service Catalog > Catalog Administration > User Criteria
   Diagnostics.
   The User Criteria Diagnostics form is displayed.
2. In the Select user field, select the user whose access you want to debug.
3. In the Select catalog item field, select the required catalog item.
4. Click Diagnose.

<table>
<thead>
<tr>
<th>User Criteria Diagnostics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select user</td>
</tr>
<tr>
<td>System Administrator</td>
</tr>
<tr>
<td>Select catalog item</td>
</tr>
<tr>
<td>Samsung Galaxy S7 Edge</td>
</tr>
<tr>
<td>Diagnose</td>
</tr>
</tbody>
</table>

Cannot View
System Administrator cannot view Catalog Item: Samsung Galaxy S7 Edge

User Criteria definition for Samsung Galaxy S7 Edge

<table>
<thead>
<tr>
<th>User Match</th>
<th>Association</th>
<th>User Criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗</td>
<td>Not Available</td>
<td>Non-availability of the Item</td>
</tr>
<tr>
<td>✗</td>
<td>Available</td>
<td>Availability of the Item</td>
</tr>
</tbody>
</table>
• The item hierarchy is displayed along with an indication of the user's access to each node (catalog, category, or catalog item) based on the user criteria associated with the node.

**Note:**
- If the item is available in multiple catalogs or nested categories, the corresponding catalogs and categories are displayed as nodes in a tree format.
- If the user matches multiple user criteria associated with the node, then the user can access the node only if the following conditions are met:
  - The user matches at least one of the user criteria in the **Available For** list.
  - The user does not match any user criteria in the **Not Available For** list.

• All user criteria defined for the item is displayed. For each user criteria, the following information is available:

  **User Match**
  - is displayed if the selected user matches the user criteria.

  **Association**
  - Association of the node with the user criteria, that is, **Available for** or **Not Available for**.

  **User Criteria**
  - Name of the user criteria.

5. To verify if the user can view a node of the hierarchy, click the node. User criteria defined at the node is displayed. For example, when you click a node representing a category, the user criteria defined for the category is displayed.

6. To edit the configuration of a user criteria, click its name under the **User Criteria** column.

### Service catalog variables

Service catalog variables capture and pass on information about choices a customer makes when ordering a catalog item. Variables help define the structure of a catalog item form that is displayed to the customer.
For example, you can define a variable called **Memory** to provide users with memory options at an extra cost for a PC catalog item. An Apple iPhone catalog item can use a variable called **Color** that allows customers to select the color when they order the phone from the catalog. You can define some variables to affect an item price, depending on the choices made.

Service Catalog provides several types of variables, which are also referred to as questions. Variables can be stored, accessed from multiple places, and passed between tasks in a process when fulfilling a request. They can be displayed on the Requested Item and Catalog Task forms after an item has been ordered.

You can define service catalog variables with the catalog_admin role.

**Related information**

- Scriptable service catalog variables
- Use service catalog variables in a report – Report Designer

**Types of service catalog variables**

Variables allow you to specify questions for a catalog item. Several types of service catalog variables are provided. Some variable types accept variable attributes.

See the following sections for more details on each variable type. For details on creating a variable, see Create a service catalog variable. You can also provide help text for any service catalog variable. For information on defining help information, see Define help information for a service catalog variable.

**Support in various channels**

Service Catalog variables are supported in various channels. For information on their availability, see Variable support in various channels.

**Attachment**

When submitting a catalog item request, this variable lets you upload an attachment for a question of the item. After you upload the attachment, you can also download, update, and delete it. Even when fulfilling the request, you can download, update, and delete the attachment in a requested item or catalog task. You can specify restrictions for file size and extensions using the `max_file_size` and `allowed_extensions` variable attributes. For information on these variable attributes, see Service catalog variable attributes.
• You should specify only an integer value for the following:
  ◦ The `max_file_size` variable attribute
  ◦ The `glide.sc.variable.attachment.default_max_size` system property (catalog-level). The default value is 20.

• If the `max_file_size` variable attribute is not specified, the `glide.sc.variable.attachment.default_max_size` system property value is considered as the upper limit for the attachment file size.

• Irrespective of the file size allowed in the variable, the attachment file size cannot exceed the size specified in `com.glide.attachment.max_size` system property, which is applicable for attachments across Now Platform.

• The `g_form.setValue()` API is supported in catalog client scripts.

**Note:** When you edit an attachment, the existing attachment is removed and a new attachment is uploaded.

When you upload an attachment to this variable, an entry is created in the Attachment [sys_attachment] table. The variable is not updated until you submit the item request, add it to the cart, or save the record while editing it (in fulfills/flows). If you delete or update the attachment before submitting the corresponding catalog item, the entry in the Attachment [sys_attachment] table is cleared.

The attachment uploaded for this variable is copied in the following scenarios:

• In an order guide, when the variable is cascaded to a catalog item in the rule base

**Important:** The individual variable attributes are not honored for the catalog items in the rule base. For example, let us consider that a variable in the Describe Needs section allows a .pdf attachment and the variable of a catalog item in the rule base allows a .txt attachment. When you upload an attachment of .pdf type for a variable in the Describe Needs section, it is initially cascaded to the variable in the catalog item as well and the variable attributes specified in the catalog item are not honored. However, if you delete this initially cascaded attachment from an individual item and try to upload a new attachment, then the individual variable attributes of the catalog item are honored.

• In a record producer, when the variable is mapped to a task table field. This variable can be mapped only to the File Attachment field type of a task table.
Important: After an attachment is copied, the changes to the individual attachments are independent. For example, any change to an attachment in the order guide does not impact the same attachment cascaded to the catalog item in the rule base.

Warning: Since the attachments are copied, a larger size can lead to performance issues.

If the system-wide anti-virus check is enabled, the anti-virus check is performed on the attachment when you:

- Submit a request for the corresponding catalog item
- Add the catalog item to the cart or wish list

Note:

- This variable is not supported in a multi-row variable set.
- This variable is supported in flows and workflows.
- This variable is available in condition builder
- For this variable, item variable assignment is not supported in order guide.

### Attachment variable

**Request Credit Card**

<table>
<thead>
<tr>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

**Upload ID Card**

[Upload]

### Break

The break variable displays a horizontal line across the form. This line is a formatting element that does not collect data.

**Example: break variable**

Once this request is fulfilled and the category is created, you will be notified via email and sent a link to begin creating your items.

* Choose the catalog your new category will appear in
Check box

The check box variable lets you enable and disable options by selecting and clearing it.

To make a check box mandatory, select the **Selection Required** option when you create the variable. For example, use this option to require users to select the **I agree** check box for an agreement form. If users try to submit the agreement form without selecting the check box, an alert message is displayed to tell users that they must select the check box.

A group of check box variables is created when you create consecutive check box variables. These check box variables are sorted by their order within the group. If you want to define a custom label for the group of check boxes, create a **label** variable at the start of the consecutive check box variables. The label is then considered a part of this group and acts a label of the group. If there is no custom label, check boxes are grouped under an **Options** label by the application.

In a group of check box variables:

- If any check box variable in the group is mandatory, the entire group becomes mandatory irrespective of the visibility of the mandatory check box variable. An asterisk (*) is then displayed next to the group label and you must select at least one of these check boxes.
- Hiding the label hides the entire group.
- If all other check box variables of a mandatory check box group are hidden and not selected, the following scenarios are applicable:
  - The group remains mandatory as long as there is one check box in the group that is visible and not selected.
  - The last check box of this group cannot be hidden if it is not selected.

In Service Portal, to make a group of check box variables mandatory, set at least one of the check box variables as mandatory. While defining the label for a group of check boxes, setting a label mandatory does not make the group of check box variables mandatory.

In catalog builder, the following scenarios are applicable:

- If there are two consecutive check boxes, then a virtual container is created for a group of check boxes. Only check box variable types can be added inside the group.
- Even if a check box variable is added immediately after a group of check boxes, it is automatically added to the group.
Under the **Type Specifications** tab, you can specify the price in different currency types. Also, you can configure the price in the following pricing models:

- Calculated
- Fixed
- Multiple

For information on the pricing models, see [Price fields](#).

### Example: check box variable

<table>
<thead>
<tr>
<th>Optional Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Powerpoint</td>
</tr>
<tr>
<td>Adobe Acrobat</td>
</tr>
<tr>
<td>Adobe Photoshop</td>
</tr>
<tr>
<td>Siebel Client</td>
</tr>
</tbody>
</table>

For more information on the check box variable, see the following video:

How to create and configure catalog check box variables to present options to customers when ordering items from the service catalog. Explains how to group multiple check boxes in categories, require users to select at least one item from a group, and adjust pricing based on options selected with check box variables.

### Container start, container split, and container end

The container start, container split, and container end variables define a layout for a container that can hold more variables. Use the container start and container end variables to define the start and end points of a container layout. The container end must be used along with the container start to close a container.

A container layout can be split into two or three columns using the container split variable. By default, the split is calculated at the 50% mark.

A container is similar to a variable set. Unlike a variable set, containers can be used anywhere, including inside a variable set. Containers can also be nested inside each other.

For more help with selecting the appropriate container type, see the [Determining if you are using the correct container variable](#) article in the HI Knowledge Base.
Note:

- The container variables are not yet supported on mobile devices.
- Container start, container split, and container end variables are supported in Service Portal. However, if the settings are done on the top-level container, a maximum of two-column layouts can be achieved.
- Variable sets are also considered as containers. So, a container start variable with a two-column layout under a variable set is not supported in Service Portal.

To reproduce the container shown in the following figure, enter the following settings when creating a container start variable:

- Select a Layout with 2 Columns Wide, alternating sides.
- Select the Display title check box to use a collapsible title bar.

**Example: container variable**

**Memory & CPU Options**

<table>
<thead>
<tr>
<th>CPU Speed</th>
<th>Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intel Xeon Processor (2.66GHz 1.33GHz FSB)</td>
<td>1GB</td>
</tr>
<tr>
<td>Intel Xeon Processor (3.73GHz 1.33GHz FSB)</td>
<td></td>
</tr>
</tbody>
</table>

**Date**

The date variable creates a widget with a field and calendar to select a date.

**Example: date variable**

Delivery date

![Calendar widget]
Date and time
The date and time variable creates a widget with a calendar and fields to select a date and time. The time value is stored in Greenwich Mean Time (GMT) and displayed in your time zone.

Example: date and time variable
Pick a suitable date and time

![Calendar widget example]

Duration
Use the duration variable to specify the duration for which a catalog item is available.

For attributes supported by this variable, see variable attributes.

ℹ️ Note: Enter the duration in the DD HH:MM:SS format when setting the default value of the variable, and specifying in the g_form.getValue() and g_form.setValue() functions.

Example: duration variable
Duration

<table>
<thead>
<tr>
<th>Days</th>
<th>Hours</th>
<th>Minutes</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>12</td>
<td>20</td>
</tr>
</tbody>
</table>

Email
The email variable creates a widget to enter and select an email address. The variable accepts only valid email expressions containing @ and domain information.
Note: Variable validation is not supported in Service Portal.

Example: email variable

Email
user@domain.com

HTML
The HTML variable lets you provide content with advanced formatting, including images, for a catalog item.

Use the variable to create fields for user input. You can also use the variable for reusable content when put into a variable set, such as terms and conditions.

The variable is available in two modes: edit and read-only. In edit mode, a toolbar is available, and links do not work. In read-only mode, the toolbar is disabled, and links work. To switch between modes, use entitlements or create a UI policy to set the HTML field to read-only mode.

Note: HTML variables are not supported for display on the shopping cart summary or approval summary screens.

Example: HTML variable

Your comments are valuable to us.

IP Address
Use the IP address variable to specify the IPv4 and IPv6 data for a catalog item. Under the Validation Scripts submodule, a validation script type associated with this variable is available.
Note:
- Variable validation is not supported in Service Portal.
- When you set the default value for the **IP Address** variable, or specify its value in the `g_form.getValue()` and `g_form.setValue()` functions, the delimiter is `.(`.

**Example: IP address variable**

<table>
<thead>
<tr>
<th>IP Address</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

**Label**

The label variable displays a label across the form. Labels are formatting elements. No data is collected.

You can use labels to arrange questions into sections. You can also use labels for questions with multiple options. For example, label **check boxes** for the different options for a question.

You cannot set a Label variable as mandatory. However, you can make mandatory, a group of check box variables preceded by a Label variable.

In Platform, if the `glide.ui.escape_text` property is set to false, then HTML tags are supported for the **Question** and **Help text** fields. In Service portal, the `glide.ui.escape_text` property is not applicable and HTML tags are not supported for these fields.

**Example: label variable**

<table>
<thead>
<tr>
<th>Complete your request</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Do you need this today?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Is this service category for a Department or a Group?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
</tr>
</tbody>
</table>

**List collector**

The list collector variable creates an interface that lets you select and add multiple records from a table. For attributes supported by this variable, see **variable attributes**.
Example: list collector variable

For more information on using the list collector variable, see this video: How to use Service Catalog list collector variables

Note:

- The Reference Qualifier and glide_list attribute applies to releases from Helsinki onward only. The attribute does not apply to Geneva.

- You can set a value for this variable using the `g_form.setValue()` function in a catalog client script.

- When the glide_list attribute is not true, you can only set the value that is visible in the Available list using the `g_form.setValue()` function. This functionality is not applicable when the `setValue()` function is called on Load.

- Table with large data causes performance issues when loading the page. Use reference qualifiers to reduce data or use the glide_list attribute.

- The values in the referenced table do not appear if the user is not logged in.

- The list collector displays a maximum of 100 items in a list. After moving items to the Selected list, you can click Run Filter to refresh the Available list. This action will add more available items to the list, to a maximum of 100 items.
Lookup multiple choice

The lookup multiple choice variable creates radio buttons using data from a table. Its functionality is similar to the lookup select box variable, which creates a choice list from queried data. For attributes supported by this variable, see variable attributes.

Note:

• Table with large data causes performance issues when loading the page. Use reference qualifiers to reduce data or use the reference type variable.

• You cannot add more than 10,000 choices.

Example: lookup multiple choice variable

Software
• Adobe Systems Acrobat 9.0
• Adobe Systems Dreamweaver 5.5
• Adobe Systems Fireworks CS6
• Apple QuickTime Pro 7
• IBM Lotus Notes 8.5.3
• Microsoft Access 2010

Lookup select box

The lookup select box variable creates a choice list using data queried from a table. Its functionality is similar to the lookup multiple choice variable, which creates radio buttons from queried data. For attributes supported by this variable, see variable attributes.

To create the lookup select box shown in the following figure, enter the following values when creating the variable:

• Lookup from table: Incident [incident]

• Lookup value field: Sys ID
• **Lookup label field:** number, category, priority

• **Reference qual:** `caller_id=javascript:gs.getUserID()&active=true`

**Note:**

• Table with large data causes performance issues when loading the page. Use reference qualifiers to reduce data or use the reference type variable.

• You cannot add more than 10,000 choices.

**Example: lookup select box variable**

Knowledge Base

![Lookup select box example](image)

**Custom**

This variable inserts a UI macro into the catalog item.

UI macros in the service catalog do not support the following `glide_list` functions: clickthrough, slushbucket editing, and email field.

• Use **phase one** Jelly only for any UI macros added as variables. Phase two Jelly within the macro is not processed and appears on the page as standard content.

• This variable is not yet supported on Classic Mobile devices.

• This variable is supported in Service Portal through widgets. Create a widget with the same functionality as that of a macro and link the widget with the variable.

**Example: Custom variable**

![Custom variable example](image)
Custom with label
This variable inserts a UI macro with a label.

- This variable is not yet supported on Classic Mobile devices.
- This variable is supported in Service Portal through widgets. Create a widget with the same functionality as that of a macro with label, and link it with the variable.

Example: Custom with label variable

Masked
The masked variable inserts a field that masks the text entered. Each character entered is displayed as an asterisk (*). Use this variable to ask users for sensitive or confidential data such as passwords.

By selecting the Use encryption check box, you can configure the variable to encrypt its value using various encryption algorithms before storing in the database. These values can only be decrypted by using now_GR.variables.var_name.getDecryptedValue() on RITM, Catalog Task, or any task extension record created using a record producer.

On the variable editor, you can also decrypt and encrypt the values of a masked variable using the Show and Hide buttons. These buttons are not available for a fulfiller (itil) without the catalog_view_masked role. You can only view the value that you specified while requesting.

<table>
<thead>
<tr>
<th>Actions on an encrypted variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Fulfiller without the catalog_view_masked role</td>
</tr>
<tr>
<td>View or hide the encrypted</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Actions on an encrypted variable (continued)

<table>
<thead>
<tr>
<th>Actions</th>
<th>Yes</th>
<th>Not applicable</th>
<th>Not applicable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit the encrypted value on catalog forms</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View or hide the encrypted value on the variable editor</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Edit the encrypted value on the variable editor</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

**Note:** If the masked variable is read-only on the variable editor, the variable value is not editable.

Example: masked variable

Password

```
...........
```

Multi-line text

The multi-line text variable creates a field that lets you enter multiple lines of text.

**Example: multi-line text variable**

```
Special software requirements
```

Multiple choice

The multiple choice variable creates radio buttons for question choices.
Example: multiple choice variable

Is this service category for a Department or a Group?
- Department
- Group

Numeric scale

The numeric scale variable creates a set of radio buttons for a range of options, like a Likert scale.

Example: numeric scale variable

How well did we do? 0 1 2 3 4 5

Reference

A reference variable references a record in another table. For example, a variable named `point_of_contact` references the User `[sys_user]` table. For attributes supported by this variable, see variable attributes.

Keep the following information in mind when you create a reference variable:

- Reference variables use the auto-complete feature. To ensure that users have enough information to make the selection, configure the reference lookup list.
- Reference variables store the sys_id of the selected record (like reference fields). To use the display value in a script, use the same methods as for a reference field.

```javascript
current.variables.<variable name>.getDisplayValue()
```

Example: reference variable

Callable name

Howard Johnson

Requested For

Before submitting a catalog item request, this variable helps you specify who this request can be submitted for. You should specify this information while answering catalog item questions.
Important:
• You can only specify users from the User [sys_user] table.
• If you don’t specify the default value for this variable, the current logged-in user requesting the item is considered as the default Requested For variable value.
• You can submit the request for a user based on access to a catalog item. The Access Type field of the catalog item can be used to specify if a request can be submitted for a user who does not have access to the catalog item.

Using the Enable also request for field of the Requested For variable, you can request a catalog item for different users under one request.

For information about delegated request experience, see Delegated request experience.

Important:
• You can add this variable to a catalog item or variable set. However, when submitting the request, a catalog item can have only one Requested For variable.
• You can add only one Requested For variable for a variable set.
• This variable is not supported in a multi-row variable set.
• After the request is submitted, this variable value is visible in the variable editor and variable summarizer.

Requested For variable

Rich Text Label
This variable displays a formatted label on a catalog item form. In the TinyMCE rich text editor, you can format the label and add images or links.
Note:

• You can make this variable visible using catalog client scripts and catalog UI policies.
• You cannot cascade this variable in an order guide.
• You cannot set this variable as mandatory.
• In the Automated Test Framework, this variable is only supported in the Variable State Validation step to check the visibility.
• This variable is not supported in the following:
  ◦ Variable summarizer
  ◦ Multi-row variable set
  ◦ Condition builders and reports
• You cannot specify the following for this variable:
  ◦ Help text and instructions
  ◦ Tool tip
  ◦ Permissions
  ◦ Variable width
  ◦ Example text
• The `g_form.setValue()`, `g_form.setReadOnly()`, and `g_form.setMandatory()` APIs are not supported in catalog client scripts. Only the `g_form.setVisible()` API is supported.

Rich Text Label variable

Select box

The select box variable creates a list from predefined question choices. For attributes supported by this variable, see variable attributes.
**Example: select box variable**

Do you need this today?

Yes

---

**Single-line text**

The single-line text variable creates a field to enter a single line of text. For attributes supported by this variable, see variable attributes.

**Example: single-line text variable**

Last Name

Johnson

---

**UI page**

The UI page variable inserts a UI page into the catalog item.

- Use phase one Jelly only for any UI macros added as variables. Phase two Jelly within the macro is not processed and appears on the page as standard content.

- The client scripts of a UI page are ignored when you define the associated UI Page variable for a catalog item. This behavior is applicable as long as the `glide.ui.escape_text` and `glide.ui.escape_all_script` properties are set to true. For information about these high security settings, see High Security Settings.

- This variable is not yet supported on Classic Mobile devices and in Service Portal.

---

**URL**

The URL variable creates a widget for users to enter URLs. URLs are validated for the following protocols: HTTP, HTTPS, FTP.

**Note:**

- Variable validation is not supported in Service Portal.

- This variable is not editable on Now Mobile.

**Example: URL variable**

Enter URL

http://www.servicenow.com/
Wide single-line text

The wide single-line text variable creates a field that spans the form, letting users enter longer lines of text. For attributes supported by this variable, see variable attributes.

Example: wide single-line text variable

Yes/No

The Yes or No variable creates a choice list with Yes and No as options.

Example: Yes or No variable

Variable support in various channels

Service Catalog variables are supported in various channels.

Variable support

<table>
<thead>
<tr>
<th>Variable</th>
<th>Now Platform</th>
<th>Service Portal</th>
<th>Now Mobile</th>
<th>Conversational Interface in Virtual Agent</th>
<th>Variable editor in Workspace and Catalog Item UIB component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Break</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>CheckBox</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Container End</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Container Split</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Container Start</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Date</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
## Variable support (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Now Platform</th>
<th>Service Portal</th>
<th>Now Mobile</th>
<th>Conversational interface in Virtual Agent</th>
<th>Variable editor in Workspace and Catalog Item UIB component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Email</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>HTML</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>IP Address</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Label</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>List Collector</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Lookup Multiple Choice</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Lookup Select Box</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Macro</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Macro with Label</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Masked</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Multi Line Text</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Multiple Choice</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Numeric Scale</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Reference</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Requested For</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Rich Text Label</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Select Box</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Variable support (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Now Platform</th>
<th>Service Portal</th>
<th>Now Mobile</th>
<th>Conversational interface in Virtual Agent</th>
<th>Variable editor in Workspace and Catalog Item UIB component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Line Text</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>UI Page</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>URL</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Wide Single Line Text</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Yes / No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Create a service catalog variable

Create service catalogs variables to gather information from users ordering a catalog item, for example, to ask users which options they want for the item.

Procedure

1. Navigate to Service Catalog > Catalog Definitions > Maintain Items.
2. Select the catalog item that you want to create a variable for.
3. In the Variables related list, click New.
4. Select the variable type.
   Only the applicable fields for the variable type are then displayed.
5. In the form, fill the fields.

Variable form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Read-only field that indicates which applications can use this variable.</td>
</tr>
<tr>
<td>Map to field</td>
<td>Maps the variable to a specific field on the table for the record producer.</td>
</tr>
<tr>
<td></td>
<td>This field appears if the variable belongs to a record producer.</td>
</tr>
<tr>
<td>Type</td>
<td>The variable type that you want to create.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Catalog item</td>
<td>Catalog item using the variable.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the variable is placed on the page for the catalog item. The variables are organized from top to bottom from least to greatest order value. For example, a variable with an order value of 1 is placed above other variables with higher-order values.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to make the variable available for use</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Check box to make the variable mandatory as part of the ordering process.</td>
</tr>
<tr>
<td></td>
<td>✉️ Note: This behavior is applicable only on page load, and can be changed via client APIs.</td>
</tr>
<tr>
<td>Read only</td>
<td>Option to make a variable read only or editable.</td>
</tr>
<tr>
<td>Hidden</td>
<td>Option to hide a variable.</td>
</tr>
<tr>
<td>Unique</td>
<td>Option to disallow duplicate values for this variable within a multi-row variable set.</td>
</tr>
<tr>
<td></td>
<td>✉️ Note:</td>
</tr>
<tr>
<td></td>
<td>• This field appears only for a variable created in a multi-row variable set.</td>
</tr>
<tr>
<td></td>
<td>• This behavior is applicable only in Now Platform, Service Portal, and variable editor in Agent Workspace.</td>
</tr>
<tr>
<td>Selection</td>
<td>Check box to require users to select the check box variable. For example, use this option to require users to select an I agree check box for an agreement form. If users try to submit the agreement form without selecting the check box, an alert message is displayed to tell users that they must select the check box.</td>
</tr>
<tr>
<td>Required</td>
<td></td>
</tr>
<tr>
<td>Global</td>
<td>If selected, the variable is available for all catalog tasks within service catalog workflows or execution plans by default. If deselected, the variable must be associated with individual catalog tasks.</td>
</tr>
<tr>
<td>Field</td>
<td>Field that the variable maps to. This field appears if the variable belongs to a record producer.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Record producer table</td>
<td>Table that the record producer creates a record in. This field appears if the variable belongs to a record producer.</td>
</tr>
<tr>
<td>Question</td>
<td>Question to ask users ordering the catalog item.</td>
</tr>
<tr>
<td>Name</td>
<td>A name to identify the question.</td>
</tr>
<tr>
<td></td>
<td>Note: If this field is empty, its value is auto-populated based on the Question field for all variable types except break, container split, and container end.</td>
</tr>
<tr>
<td>Tooltip</td>
<td>Tooltip text to display when users point to the variable. Enter a brief note to describe the purpose of the 'Question'.</td>
</tr>
<tr>
<td>Example text</td>
<td>Hint that is displayed in the question field before a user enters a value.</td>
</tr>
<tr>
<td></td>
<td>Applicable for the following variables:</td>
</tr>
<tr>
<td></td>
<td>• IP Address</td>
</tr>
<tr>
<td></td>
<td>• Email</td>
</tr>
<tr>
<td></td>
<td>• URL</td>
</tr>
<tr>
<td></td>
<td>• Single Line Text</td>
</tr>
<tr>
<td></td>
<td>• Wide Single Line Text</td>
</tr>
<tr>
<td></td>
<td>• Multi Line Text</td>
</tr>
<tr>
<td></td>
<td>• Date</td>
</tr>
<tr>
<td></td>
<td>• Date/Time</td>
</tr>
<tr>
<td>Rich Text</td>
<td>Formatted label to be displayed on a catalog item form.</td>
</tr>
<tr>
<td></td>
<td>Applicable for the Rich Text Label variable.</td>
</tr>
<tr>
<td>Annotation</td>
<td></td>
</tr>
<tr>
<td>Show help</td>
<td>If selected, displays the help text and instructions for the variable.</td>
</tr>
<tr>
<td></td>
<td>Note:</td>
</tr>
<tr>
<td></td>
<td>• It is not available for break and check box variables.</td>
</tr>
<tr>
<td></td>
<td>• Help text and instructions are not available for a variable set.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Always Expanded</td>
<td>If selected, the <strong>Help text</strong> and <strong>Instructions</strong> field value are expanded by default when the catalog item page loads. This check box appears only when the <strong>Show help</strong> check box is selected.</td>
</tr>
</tbody>
</table>
| **Note:**             | • This field is also applicable in Service Portal.  
• This field is not applicable in the variable editor in Workspace and Catalog Item UIB component.  
• If the **Expand help for all questions** check box is selected at the catalog item level, then the **Always Expanded** field setting at the variable level is overridden.  
• If the **Expand help for all questions** check box is deselected at the catalog item level, then the **Always Expanded** field setting at the variable level is applicable.                                                                                                                                                                                                                                                                                                           |
<p>| Help tag              | If the <strong>Always Expanded</strong> check box is deselected, click the value specified in this field to display the <strong>Help text</strong> and <strong>Instructions</strong> field values. This field is not applicable in the variable editor in Workspace and Catalog Item UIB component.                                                                                                                                                                                                                                                                                                                  |
| Help text             | Help information for a service catalog variable. This field is applicable in Now Platform, Service Portal, and variable editor in Workspace, and Catalog Item UIB component. However, in Workspace and Catalog Item UIB component, you can view either help text or instructions. If both instructions and help text are available, you can view only the instructions. This field is not applicable for Break, CheckBox, Container End, Container Split, Macro, and UI Page variables. In Workspace and Catalog Item UIB component, this field is additionally not applicable for a Masked variable. |
| Instructions          | Information that requires rich text formatting or adding images to support help information.                                                                                                                                                                                                                                                                                                                                                                                                                                                                   |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>This field is applicable in Now Platform, Service Portal, and variable editor in Workspace, and Catalog Item UIB component.</td>
</tr>
<tr>
<td></td>
<td>However, in Workspace and Catalog Item UIB component, you can view either help text or instructions. If both instructions and help text are available, you can view only the instructions.</td>
</tr>
<tr>
<td></td>
<td>In Workspace and Catalog Item UIB component, this field is additionally not applicable for a Masked variable.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For HTML tables, use sizes that are within the width of the variable.</td>
</tr>
</tbody>
</table>

**Type Specifications** (The fields in this section vary for each variable type)

<table>
<thead>
<tr>
<th>Variable Width</th>
<th>Width for the variable on the catalog item page, to specify what percentage of the screen size that it can span. For details, see <a href="#">Configure a default width for service catalog variables</a>.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>This field appears for all variable types except for break, container end, container start, container split, container layout, and label variables.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enable also request for</th>
<th>Option to allow a catalog item request to be submitted for multiple users. After you select this option, the <strong>Also request for</strong> field is displayed along with Requested For variable in a catalog item.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• This functionality is only applicable in Service Portal.</td>
</tr>
<tr>
<td></td>
<td>• This field is applicable only for the Requested For variable. For information about delegated request experience, see <a href="#">Delegated request experience</a>.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Roles to use also request for</th>
<th>Option to specify the roles that can submit a catalog item request for multiple users.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• This functionality is only applicable in Service Portal.</td>
</tr>
<tr>
<td></td>
<td>• This field is applicable only for the Requested For variable.</td>
</tr>
<tr>
<td></td>
<td>• This field appears only when the <strong>Enable also request for</strong> check box is selected.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If no role is specified, anyone who has access to the catalog item can submit the request.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Choice direction</td>
<td>The direction in which the choice list is arranged.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Across</strong>: Arranges choices horizontally.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Down</strong>: Arranges choices vertically.</td>
</tr>
<tr>
<td></td>
<td>This field appears for lookup multiple choice variables.</td>
</tr>
<tr>
<td></td>
<td>⚠ <strong>Note</strong>: The selected direction is also applicable in Service Portal.</td>
</tr>
<tr>
<td>Choice field</td>
<td>Table field to populate options for the variable. If no choices are defined for a field, then the variable loads field-related distinct values from the table.</td>
</tr>
<tr>
<td></td>
<td>This field appears for select box variables.</td>
</tr>
<tr>
<td>Choice table</td>
<td>Table with values to populate in the Choice field.</td>
</tr>
<tr>
<td></td>
<td>This field appears for select box variables.</td>
</tr>
<tr>
<td>Do not select the first choice</td>
<td>Check box to leave all options for the variable cleared on the catalog item page.</td>
</tr>
<tr>
<td></td>
<td>If this check box is selected, the first choice for the variable selected by default.</td>
</tr>
<tr>
<td></td>
<td>This field appears for multiple choice and numeric scale variables.</td>
</tr>
<tr>
<td>Dynamic ref qual</td>
<td>Dynamic qualifier. Select a dynamic filter to run a query against the reference field.</td>
</tr>
<tr>
<td></td>
<td>This field appears for reference variables when Use reference qualifier is set to Dynamic.</td>
</tr>
<tr>
<td>Include none</td>
<td>Check box to include the None option in a list of choices.</td>
</tr>
<tr>
<td></td>
<td>This field appears for lookup multiple choice, lookup select box, multiple choice, and select box variables.</td>
</tr>
<tr>
<td>Layout</td>
<td>Layout for a container, whether one or two columns.</td>
</tr>
<tr>
<td></td>
<td>This field appears for container start variables.</td>
</tr>
<tr>
<td>List table</td>
<td>Table with the values for the list collector. The table should have a display column specified.</td>
</tr>
<tr>
<td></td>
<td>This field appears for list collector variables.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Lookup from table</td>
<td>Table from which values are obtained for users to select. The values from this table are populated in the <strong>Lookup value field</strong>. This field appears for lookup multiple choice and lookup select box variables.</td>
</tr>
<tr>
<td>Lookup value field</td>
<td>Field in the lookup table that populates options for the variable. This field appears for lookup multiple choice and lookup select box variables.</td>
</tr>
<tr>
<td>Lookup label field(s)</td>
<td>Comma-separated list of fields in the lookup table whose values are used to display options. This field appears for lookup multiple choice and lookup select box variables.</td>
</tr>
<tr>
<td>Lookup price field</td>
<td>Field in the lookup table whose value is used to modify the price of the item being ordered. This field appears for lookup multiple choice and lookup select box variables.</td>
</tr>
<tr>
<td>Lookup recurring price field</td>
<td>Field in the lookup table whose value is used to modify the recurring price of the item being ordered. This field appears for lookup multiple choice and lookup select box variables.</td>
</tr>
<tr>
<td>Macro</td>
<td><strong>UI macro</strong> to insert into the catalog item. This field appears for macro, macro with label, and UI page variables.</td>
</tr>
<tr>
<td>Summary macro</td>
<td>Applicable only for Marco, and Macro with Label type variables.</td>
</tr>
<tr>
<td>Widget</td>
<td>Applicable only for Marco, and Macro with Label type variables.</td>
</tr>
<tr>
<td>Price if checked</td>
<td>Price of the item. This field appears for check box variables.</td>
</tr>
<tr>
<td>Recurring price if checked</td>
<td>Price that increments for the item, when the user requests more than one order of the item.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field Description</td>
<td>This field appears for check box variables. For more information about prices and recurring prices, see Using variables for price setup.</td>
</tr>
<tr>
<td>Reference</td>
<td>Reference table for the variable. The table should have a display column specified.</td>
</tr>
<tr>
<td>This field appears for reference variables.</td>
<td></td>
</tr>
<tr>
<td>Reference qual</td>
<td>Qualifiers to restrict data that is available in the field. Supports reference qualifiers and advanced reference qualifiers.</td>
</tr>
<tr>
<td>Returns all matching results (no maximum).</td>
<td></td>
</tr>
<tr>
<td>Note: For security reasons, the use of scripts in the Reference qual field is restricted to system administrators through the Allow javascript in Default Value business rule.</td>
<td></td>
</tr>
<tr>
<td>This field appears for list collector, lookup multiple choice, lookup select box, reference and Requested For variables.</td>
<td></td>
</tr>
<tr>
<td>It appears for reference variables when Use reference qualifier is set to Dynamic.</td>
<td></td>
</tr>
<tr>
<td>Reference qualifier condition</td>
<td>Options to build conditions.</td>
</tr>
<tr>
<td>This field appears for reference variables when Use reference qualifier is set to Simple.</td>
<td></td>
</tr>
<tr>
<td>Scale max</td>
<td>Highest value on the scale of available options for the variable.</td>
</tr>
<tr>
<td>This field appears for numeric scale variables.</td>
<td></td>
</tr>
<tr>
<td>Scale min</td>
<td>Lowest value on the scale of available options for the variable.</td>
</tr>
<tr>
<td>This field appears for numeric scale variables.</td>
<td></td>
</tr>
<tr>
<td>Unique values only</td>
<td>Check box to require a unique value for the field. When this check box is selected, two records cannot have the same value for that field.</td>
</tr>
<tr>
<td>This field appears for lookup multiple choice, lookup select box, and select box variables.</td>
<td></td>
</tr>
<tr>
<td>Use confirmation</td>
<td>Check box to prompt users to reenter data to verify their entries.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use encryption</td>
<td>Check box to store the answer in encrypted format in the database. If not encrypted, the answer is stored in plain text format. Encryption uses Triple DES with system encryption. This field appears for masked variables.</td>
</tr>
<tr>
<td>Use reference qualifier</td>
<td>Type of qualifier to use. This field appears for reference variables.</td>
</tr>
<tr>
<td>Validation Regex</td>
<td>Regular expression that validates the variable value. This field is displayed only for Single Line Text and Wide Single Line Text variable types. To define regular expressions, see Define a regular expression for a variable.</td>
</tr>
<tr>
<td>Variable attributes</td>
<td>Attributes that define the behavior and restrictions for a variable. For information on variable attributes, see Service Catalog variable attributes.</td>
</tr>
</tbody>
</table>

**Default Value**

| Default value         | Default value for the variable.                                                                                                                                                                            |

**Permission**

If no role is specified in this tab for the read, write, or create actions, all users who can access the catalog item can perform these actions irrespective of their role. For example, if no role is specified for the **Write roles** field, all users who can access the catalog item can edit the variable value in the variable editor.

A user with a role that does not match any of the following roles cannot set variable values even through scripting.

- This field is also applicable in Service Portal.
- The max_length attribute value is valid even when the validation regex is set.
- You cannot add a catalog item with regex validation errors to the wishlist.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>These roles are not available for Label, Break, Container Split, Container End, Macro, Macro with Label, and UI Page variables.</td>
<td></td>
</tr>
<tr>
<td>Read roles</td>
<td>Roles that can view the variable before or after requesting the catalog item or record producer. Only a user with the roles specified in this field can view the variable.</td>
</tr>
<tr>
<td>Write roles</td>
<td>Roles that can edit the variable in the variable editor after requesting the catalog item or record producer. If a user does not have the roles specified in this field, the variable is read-only in the variable editor.</td>
</tr>
<tr>
<td>Create roles</td>
<td>Roles that can create values for the variable before requesting the catalog item or record producer. If a user does not have the specified role, the variable is read-only before requesting the catalog item or record producer.</td>
</tr>
</tbody>
</table>

**Availability**

| Visible Elsewhere | If selected, the variable is visible in the item form before ordering the item, in VEditor after ordering the item, and in the cart view of the item. |
| Visible on Bundles| If selected, the variable is visible when the item is added to a bundle. |
| Visible on Guides | If selected, the variable is visible when it is added to an order guide, or when it is added to a catalog item that is included in the order guide. |

**Note:** If an order guide has too many items and variables, consider clearing this check box on as many items as possible, to improve loading performance on order guides.

<table>
<thead>
<tr>
<th>Visible on Summaries</th>
<th>If selected, the variable is visible on any variable summarizer of the catalog item.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>In Service Portal, the variable is visible in the RITM ticket page and the Approval page.</td>
</tr>
<tr>
<td></td>
<td>In Now Mobile, the variable is visible in the RITM and the Approval records.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.
Define help information for a service catalog variable

Enter help information for a variable to help users determine what info they must provide for a service catalog variable.

About this task

Demonstrates these options to provide help text for service catalog item variables: tooltips, help text, instructions (HTML help text), and example text.

Procedure

1. Navigate to Service Catalog > Catalog Definitions > Maintain Items and click the catalog item with the variable that you want to provide help for.
2. In the Variables related list, click the variable.
3. In the Annotation section of the Variable form, select the Show Help check box.
   The Help, Help text, and Instructions fields appear.
4. In the Help tag field, enter the short descriptive text that appears between the question and the responses.
   For example, Click here for help or Preview.
5. In the Help text field, enter the help text that displays for users who clicks the Help tag on the page for the catalog item.

   Note: The Help and Help text fields do not support HTML tags.

Example of help information

![Password Field Example](image)

Service catalog variable attributes

Few Service Catalog variables support specific attributes to define the behavior and restrictions for variables.

In the catalog variable form, under the Type Specifications tab, you can specify the variable attributes in the Variable attributes field.
Note:

- You can enter multiple attributes for a variable type by separating each with a comma.
- You can enter multiple values for an attribute by separating each with a semicolon.
- If you do not see the Variable attributes field, then enable the Show attributes when Type is One of Certain Values UI policy.

Variable attributes

allowed_extensions

Specifies a list of allowed file types. For example,
`allowed_extensions=txt;pdf`.

Applicable variables: Attachment

barcode

Specifies if the barcode can be scanned using the mobile camera for identifying a variable value of a catalog item. For example,
`barcode=true`.

Applicable variables: Single Line Text

max_file_size

Specifies the maximum file size in MB. For example, `max_file_size=2`.

Applicable variables: Attachment

glide_list

Changes the list collector interface from slushbucket to glide list.

Applicable variables: List collector

[Collapsed glide_list]

List Collector

Samsung SyncMaster 24" Class BackLight LED, P1000427 - Lenovo ThinkStation C20
is_searchable_choice

If set to true, allows you to search and select the required value for the variable. For example, `is_searchable_choice=true`

Note:
- For Lookup select box, a default value is available at the page load itself.
- This attribute is not applicable in Service Portal.

Applicable variables: Lookup select box, Select box

max_length

Sets the maximum number of characters allowed in the field. By default, the field accepts long strings of text, several thousand characters. Set the `max_length` attribute as appropriate for the
information the variable is collecting. For example, to allow for entry of an address, set `max_length=200`, or other appropriate length.

Applicable variables: Single-line text, Wide single-line text

**max_unit**

Sets the maximum unit of time for the duration. Possible values are `max_unit=days`, `max_unit=hours`, `max_unit=minutes`, and `max_unit=seconds`.

For example, if `max_unit=minutes`, the duration is displayed in minutes and seconds. In this case, a duration of 2 days 3 hours 5 minutes 15 seconds is displayed as 3065 minutes 15 seconds.

Applicable variables: Duration

**no_filter**

Hides the filter fields that appear above a list collector.

Applicable variables: List collector

![no_filter](image)

**ref_ac_columns**

Specifies the columns whose display values appear in an auto completion list in addition to the name. Separate column names with a semi-colon. For example, `ref_ac_columns=user_name;email;sys_created_on` allows auto-complete to match text from the user_name, email, and sys_created_on columns.

Applicable variables: Reference, Requested For
ref_ac_order_by

Specifies the column that is used to sort the auto completion list. For example, ref_ac_order_by=name sorts the auto-completion choices alphabetically by name.

Applicable variables: Reference

ref_auto_completer

Specifies the name of a JavaScript class (client-side) that creates the list for auto completion choices. Valid class values include:

- **AJAXReferenceCompleter**: Displays matching auto-complete choices as a drop-down choice-list. The list only displays the display value column of the reference table. If there is no other auto-completion class specified, reference fields automatically use this class.

- **AJAXTableCompleter**: Displays matching auto-complete choices as rows in a table. The table displays the display value column of the reference table and any columns listed in the ref_ac_columns attribute.

- **AJAXReferenceChoice**: Displays matching auto-complete choices as a drop-down choice-list. The list only displays the display value column of the reference table. Furthermore, the list only displays up to 25 matching choices. If there are more than 25 auto-complete choices, the reference field instead displays the choices with the AJAXTableCompleter class.

Applicable variables: Reference

ref_qual_elements

A list of fields to be sent back to the server to get an updated reference.

Applicable variables: Lookup multiple choice, Lookup select box, List Collector

⚠️ **Attention**: Attribute behavior is specific to the service catalog desktop.

Define a question choice for a variable

Define a question choice for a variable with service catalog.
About this task
Some variable types present the user with a list of choices. For example, a multiple choice variable that asks how much memory you want in a computer requires you to define the available choices, such as 1 GB and 2 GB.

Procedure
1. Open the variable definition.
2. In the Question Choices related list, click New.
3. Enter the question choice details in Question Choice form and click Submit to save the record.
   - Price and Recurring price: variables can affect the item price and recurring price (if used).
   - Order: the number defining the order in which the price appears when displayed.
   - Question: the actual question being asked for that variable.
   - Text: the choice presented to the user.
   - Value: the value stored in the database.
   - Inactive: Option to make a question choice inactive.
4. Repeat the steps for each available choice to define the full set of choices for that variable.

Note: When you modify variable choices that are attached to a catalog item, the existing requested items (RITMs) are also affected. For example, if you add a variable choice for the catalog item, the value of that choice is also considered in the existing RITMs. If you delete a variable choice that is selected for a RITM, the value of that choice still persists in the RITM.

Configure a default width for service catalog variables
Configure the default width for variables on a catalog item page to specify what percentage of the screen size that it can span.

About this task
The following figure shows how the variables for the different Apple iPhone 5 options are set to different widths.
A default width size cannot be set or does not apply to the following variables:

- The break, container end, container split, container start, and label variables.
- Any variable placed in a container with two-column layout.
- A variable set with a two-column layout.
- Any variable that is created with a custom width set in the **Variable width** field on the Variable form. For details, see Create a service catalog variable. The custom width for the variable overrides the default width set for the variable type.

**Note:** Custom variable widths are not supported in either Mobile or Service Portal.

**Procedure**

1. Navigate to **Service Catalog > Catalog Variables > Variable Default Size**.
2. For each variable type, select a default width.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>25%</td>
<td>Configures the variable to span 25% of the available screen size.</td>
</tr>
<tr>
<td>50%</td>
<td>Configures the variable to span 50% of the available screen size. By de-</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>fault, some variables require a minimum of 50% width.</td>
<td>75% Configures the variable to span 75% of the available screen size.</td>
</tr>
<tr>
<td>100% Configures the variable to span 100% of the available screen size.</td>
<td></td>
</tr>
</tbody>
</table>

3. **Click Save.**

**Define a regular expression for a variable**

Define a regular expression (regex) to validate a variable value.

**Before you begin**

Role required: catalog_admin or admin

**Procedure**

1. Navigate to Service Catalog > Catalog Variables > Variable Validation Regex.
2. Click New.
3. On the form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the regular expression.</td>
</tr>
<tr>
<td>Validation message</td>
<td>Message that appears when the validation fails.</td>
</tr>
<tr>
<td>Active</td>
<td>Specifies if the regex is active.</td>
</tr>
<tr>
<td>Regular Expression</td>
<td>Sequence of characters that define the format of the variable value. For example:</td>
</tr>
</tbody>
</table>

- **Invalid Regex:** `/((ftp|http|https):\/\/) | (www\.)\([-\w\./#$\?=+=@&%_::;]+)/i`  
- **Valid Regex:** `((ftp|http|https):\/\/) | (www\.)\([-\w\./#$\?=+=@&%_::;]+)`
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Note: | - Ensure that the regex does not cause catastrophic backtracking.  
      - You should not use embedded flag expressions.  
      - Use the **Regex Flag** list for the ignore case. |

<table>
<thead>
<tr>
<th>Regex Flag</th>
<th>Character set that is considered while validating the regular expression.</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>- None: No regex flags are applied.</td>
</tr>
<tr>
<td></td>
<td>- Case Insensitive: Enables case insensitive matching. Case insensitive matching assumes that only characters in the US-ASCII charset are being matched. Unicode-aware case-insensitive matching can be enabled by selecting <strong>Both</strong> as the regex flag.</td>
</tr>
<tr>
<td></td>
<td>- Unicode Case: (Reserved for future use) Same behavior as <strong>None</strong>.</td>
</tr>
<tr>
<td></td>
<td>- Both: Case insensitive matching is done in a manner consistent with the Unicode Standard.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Related information**

Create a service catalog variable

**Pass variables between tasks**

Pass variables from one step of the fulfillment process to another.

**About this task**

Variables can be processed by any workflow or execution plan that is associated with the requested items.

**Note:** To pass a variable between tasks, select the **Global** check box when you create a Service Catalog variable.

For example, consider the following tasks within the fulfillment process for a New PC catalog item.
Procedure

1. Procure a PC.
2. Install corporate standard software.
3. Set up email account.
4. Deliver and set up PC for requester.
   Step 4 may require a piece of information from step 3 (the email account credentials for setting up email on the PC). If steps 3 and 4 are executed by different fulfillment groups, you can use variables to make this information visible in the tasks for steps 3 and 4. You can then pass the information between groups so that the second group can access the email account credentials.

Service catalog data lookup

The Data Lookup and Record Matching Support for Service Catalog plugin offers similar features to the general Data Lookup and Record Matching Support plugin.

Use the plugin for service catalog to perform data lookups for variables. This lookup can be on service catalog item screens, on requested items, and on catalog tasks as a user fills out the values contained in variables.

Service Catalog data lookup roles

Service Catalog enables specific roles to participate in the process of creating and using Service Catalog data lookups.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>catalog_lookup_admin</td>
<td>Similar to data_lookup_admin. Can create, update, and delete catalog data lookup definitions, matcher variable definitions, and setter variable definitions.</td>
</tr>
<tr>
<td>catalog_lookup_manager</td>
<td>Can read catalog data lookup definitions, matcher variable definitions, and setter variable definitions. The role can be granted to anyone using catalog data lookups so they can see the definitions for which they are creating rules. As required, grant create, read, write, or delete</td>
</tr>
</tbody>
</table>
### Service Catalog data lookup roles (continued)

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>access to the individual data lookup rules tables created to delegate maintenance.</td>
</tr>
</tbody>
</table>

### Create a catalog lookup definition
Create a catalog data lookup definition record.

**Before you begin**
Role required: admin or catalog_admin

**About this task**

ℹ️ **Note:** The Run on Insert and Run on Update options are not supported for catalog data lookups. Other options operate the same as for normal data lookup.

**Procedure**

1. Navigate to **System Policy > Rules > Data Lookup Definitions**.
2. Click **New**.
3. Select **Catalog Data Lookup Rule**.
4. Enter a **Name**.
5. In **Applies to**, select catalog item or variable set.
6. In **Catalog item/Variable set**, select a specific item or set.
7. Select a **Matcher Table**.
8. Select other options, as required.
9. Right-click the form header and click **Save**.
10. From the **Catalog Matcher Variable Definitions** related list, click **New**.
11. Fill in the fields, as appropriate.

#### Catalog data lookup definitions fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name to identify the definition record.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select what the data lookup rule applies to: a catalog item or a variable set.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog item/Variable Set</td>
<td>Select the catalog item or variable set to which the data lookup rule applies.</td>
</tr>
<tr>
<td>Matcher Table</td>
<td>Any table within the current scope containing the lookup values.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The list shows only tables and database views that are in the same scope as the catalog data lookup definition.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to run this catalog data lookup rule. Clear the check box to ignore this catalog data lookup rule.</td>
</tr>
<tr>
<td>Run on form change</td>
<td>Select this check box to automatically look up values whenever a user changes a variable value on a catalog item or form. This option is the only supported method for catalog data lookup rules.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option does not include changes automatically made by other data lookup rules, such as the priority lookup rules.</td>
</tr>
</tbody>
</table>

12. Click **Submit**.

13. From the **Catalog Setter Variable Definitions** related list, click **New**.

14. Fill in the fields as appropriate.

### Setter variable definition fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Lookup</td>
<td>Displays the name of the parent data lookup definitions record.</td>
</tr>
<tr>
<td>Source variable field</td>
<td>Select the variable from the source item or variable set that the data lookup updates.</td>
</tr>
<tr>
<td>Matcher table field</td>
<td>Select the field from the matcher table that provides the new value for the update.</td>
</tr>
<tr>
<td>Always replace</td>
<td>Select this check box to replace any existing value with a value from the data lookup. Clear this check box to ignore the update if the field has an existing value.</td>
</tr>
</tbody>
</table>
15. Click **Submit**.
16. Click **Update**.

**Add a data lookup value**

The columns of a data lookup table contain both matcher and setter field data. Each data lookup is a query that searches for a row containing values that match the matcher fields.

**About this task**

The data lookup then returns the value listed in the setter fields.

For example, you can define the matching settings for bronze, silver, and gold offerings as described previously.

**Procedure**

1. In the navigation filter, enter the name of the new custom lookup table.
2. Configure the list and create appropriate fields for the lookup table.
3. From the table list, click **New** and enter appropriate matcher and setter field values. For example:

   ![Service Catalog lookup 1](image)

   ![Service Catalog lookup 1](image)

   **Note:** Each row in a data lookup table must be unique.

**Custom data lookup**

You can create a custom table to store lookup data.

The custom table must extend the Data Lookup Matcher Rules [dl_matcher] table.

For example, you can create a Server Offering Lookups table. It stores information about matcher offerings (bronze, silver, and gold) and associated setter values (memory and disk space) for each matcher offering.
Create a custom data lookup

Creating a catalog data lookup is similar to creating a normal, custom data lookup except when creating the catalog data lookup definition record.

1. Create a custom data lookup table. It must extend the Data Lookup Matcher Rules \([\text{dl_matcher}]\) table.
2. Add data lookup values to the data lookup table.
3. Create a catalog data lookup definition record.
4. (Optional) Create a data lookup module.

Troubleshooting

If the custom data lookup definition rules are not behaving as expected, check for certain conditions.

If the custom data lookup definition rules are not behaving as expected, check for the following conditions:

• Ensure that the matcher variable is not read-only. Since users cannot change read-only variables, there cannot be an on form change event for read-only variables.
• Ensure that the data in the matcher table is correct.
• If the lookup requires an exact match, verify that there is a matcher table row for each possible combination (including blank values). The lookup fails if it cannot find a matching value.
• If the variable is an option or check box, it always has a value, so you must select Always replace.
• Verify that you have not created a recursive rule, such as:
  If Variable A = 1, then Variable B = 2. If Variable B = 2, then Variable A = 2.

Audit service catalog variables

Audit the variables so that the audit history records all changes to the named variables.

About this task

Auditing is enabled by default for service catalog variables.

These changes are displayed in:
• The requested item history for all variables associated with the item.
• The catalog task history for all variables that are used by the task.

This auditing allows service catalog administrators to view a full history of changes to variables that can affect the parent record, including their creation.

⚠️ Note: Unnamed variables are not audited.

**Procedure**
1. Navigate to System Properties > Service Catalog.
2. Locate the line Audit changes to Service Catalog Variables.
3. Select the Yes check box to enable auditing.

**Service Catalog variable editors**
Variable editor displays variable values in fulfiller forms. A requester, while requesting the item, specifies these variable values in the catalog item questions.

Types of variable editors based on the catalog item type:

• For a catalog item, the VEditor displays the values of questions in the requested item and catalog task forms.
• For a record producer, the default variable editor displays the values of questions for records generated from a record producer for task-extended tables.

⚠️ Warning: The variable editor depends on the Variables column of the Task [task] table. By default, this column is inactive, and you should not make it active.

**VEditor**
The VEditor is applicable only for the requests created from catalog items.

In Now Platform, this editor is a formatter added on the requested item (RITM) form (Default View) and the catalog task form (Default View).

The VEditor is applicable only for RITMs and catalog tasks. It cannot be used for any other tables. To support catalog UI policies or catalog client scripts on the VEditor for the RITM and catalog task form, select the Applies on Requested Items and Applies on Catalog Tasks check boxes for the catalog UI policy or the catalog client script.
Note: The values in the VEditor are displayed from the Options [sc_item_option] table. This is an internal table and you should not add any business rules to this table.

To make the VEditor read-only in Now Platform, activate the onLoad client script, Variable Editor Readonly, for the following tables:

- Requested Item [sc_req_item]
- Catalog Task [sc_task]

Note: You can make the Variable Editor Readonly scripts conditional, by adding conditions to them.

Default variable editor

The default variable editor is applicable only for record producers. This editor is a formatter added on records that are generated by a record producer for task-extended tables. This editor displays the values of questions specified in the record producer.

By default, this editor is applicable for the Incident and Change tables. For other tables, you can configure this editor.

Catalog UI policies, catalog client scripts, catalog data lookups, reference qualifiers, and dependent reference fields are supported on the default variable editor only for task-extended tables. To support a catalog UI policy or a catalog client script on this editor, select the Applies on the Target Record check box for the catalog UI policy or the catalog client script.

Note: The values in the default variable editor are displayed in the Question Answer [question_answer] table. This is an internal table and you should not add any business rules to this table.
Default variable editor

Variable editor in Agent Workspace
In Agent Workspace, the following scenarios are possible:

• If the variable editor formatter is available in the Workspace view of the form, the variable editor is automatically added to the Variables section in the Agent Workspace UI.

• If the variable editor formatter is added inside a section in the Workspace view of the form, that section does not display the variable editor in the Agent Workspace UI.

The following variable types are not displayed in the variable editor.

• Macro
• Macro With Label
• UI Pages

The following variables are displayed as a select box in the variable editor:

• Multiple Choice
• Numeric Scale
• Lookup Multiple Choice

Variable editor in Service Portal
In the Service Portal UI, the variable editor is available for forms with the variable editor formatter.

⚠️ Note: Since Service Portal is only for requester use cases, it is recommended to use the Agent Workspace UI for the variable editor.

Making a variable editor read-only
`g_form.setVariablesReadOnly(isReadOnly)` API is supported for Now Platform and Agent Workspace forms to make the variable editor read-only. It should only be used in requested item, target record, and catalog tasks.
Note: This API is not applicable in Service Portal and not recommended for catalog forms.

To make the VEditor read-only in Service Portal, navigate to Service Portal > Portals, select Service Portal, and specify the following code in the Quick start config field:

```json
"readonly_variable_editor": "true"
```

Note: The UI Page, Macro, and Macro with Label variables are rendered even when the variable editor is read-only.

Configure the default variable editor for a task-extended table

After you configure the default variable editor for a task-extended table, you can view and edit the values of questions specified by the requester in the record producer. Applicable only for records generated by a record producer.

Before you begin
Role required: admin

Procedure
1. Create a formatter for the task-extended table.
   a. Navigate to System UI > Formatters.
   b. Click New.
   c. Fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the formatter that is displayed in the form of the task-extended table.</td>
</tr>
<tr>
<td>Formatter</td>
<td>The file name of the formatter. In this case, specify <code>com.glideapp_questionset_default_question_editor</code>.</td>
</tr>
<tr>
<td>Table</td>
<td>The table that uses the formatter.</td>
</tr>
<tr>
<td>Active</td>
<td>Specifies if the formatter is active.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of the formatter. In this case, specify <code>Formatter</code>.</td>
</tr>
</tbody>
</table>
d. Click Submit.

2. Add the formatter to the form of the task-extended table. The formatter is displayed on the form according to your selections.

   a. From the Additional Actions menu on the form, select Configure > Form Layout.

   b. Using the slushbucket, select the display order for the formatter field.
c. Click **Save**. The default variable editor is available on the form.

### Default variable editor

<table>
<thead>
<tr>
<th>Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is your question?</td>
</tr>
<tr>
<td>When is the next pay date?</td>
</tr>
</tbody>
</table>

### Debug actions on catalog item variables

Analyze the client-side actions affecting the state and values of all variables. You can also get insights into the performance of each script working on the variables.

#### Before you begin
Role required: admin, catalog_admin, catalog_manager, or catalog_editor.

#### About this task
The variable action logger displays the chronology of actions that happen on all variables of a catalog item before it is submitted. These actions can happen due to catalog client scripts, catalog UI policies, or catalog data lookups. This client-side logger does not store any data in the database. Also, the information displayed is applicable only while you work on the catalog form. Features available for debugging Service Catalog issues including UI macro customization debugging; variable action logger; variable watcher; item diagnostic report.

#### Procedure

1. Navigate to **Service Catalog > Catalog Administration > Enable Variable Action Logger**. The UI Page Customization Diagnostics logger is enabled.

   **Note:** Perform this step before you run the logger.

2. Navigate to **Service Catalog > Catalog Definitions > Maintain Items**.

3. In the Catalog Items list, select an item that you want to log.

4. On the Catalog Item form, click **Try it**.

5. On the catalog page for the item, right-click the header and select **Show Variable Action Logger**.
Note: The variable logs are grouped by catalog UI policies, catalog client scripts, and data lookups.

The following information is displayed in the Variable Action Logger window:

- Order in which scripts and actions are executed. When a new action is triggered from an existing action, the order of the new action is tracked at a sublevel under the order of the existing action. For example, the order of a new action triggered from step 1.2 is 1.2.1.
- Source of the action taken on a variable and the variable name.
- Details of the action taken on the variable.

Variable Action Logger window

6. Review the results of the variable action logger.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>To search for a variable or script, use the <strong>Search</strong> field.</td>
</tr>
<tr>
<td>Collapse All</td>
<td>To collapse variable logs within a group, click <strong>Collapse All</strong>.</td>
</tr>
<tr>
<td>Expand All</td>
<td>To expand variable logs within a group, click <strong>Expand All</strong>.</td>
</tr>
<tr>
<td>Filter</td>
<td>To filter variable logs, click the Filter icon (🔍) and select the required options.</td>
</tr>
<tr>
<td>Clear Logs</td>
<td>To clear variable logs, click the Actions icon (👀) and select <strong>Clear Logs</strong>.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Export to CSV</td>
<td>To export the variable logs to a .csv file, click the Actions icon (•••) and select Export to CSV.</td>
</tr>
<tr>
<td>Print Logs</td>
<td>To print variable logs, click the Actions icon (•••) and select Print Logs.</td>
</tr>
</tbody>
</table>

**Debug a Service Catalog variable**

Monitor changes in the state and the value of a Service Catalog variable due to catalog client scripts, catalog UI policies, and catalog data lookups. You can diagnose and resolve issues related to such changes, and track client-side scripting errors on this tab.

**Before you begin**

Role required: admin or catalog_admin  
Features available for debugging Service Catalog issues including UI macro customization debugging; variable action logger; variable watcher; item diagnostic report

**Procedure**

1. Enable the JavaScript log and field watcher..

   a. In the banner, click the settings icon (⚙).

   b. In the System Settings window, click the Developer tab.

   c. Enable the JavaScript Log and Field Watcher option.  
      The JavaScript Log and Field Watcher tabs are displayed in a pane at the bottom of the page. For information about JavaScript logs and fields watcher, see JavaScript log and Field Watcher.

   d. Close the System Settings window.

2. Navigate to Service Catalog > Catalog Definitions > Maintain Items.

3. In the Catalog Items list, select a catalog item to debug its variables, and click Try it.

4. On the form, right-click a variable field label and select Watch Variable.

   The debug icon (Ω) is displayed next to the variable, and the Field Watcher tab in the bottom pane is replaced with the Variable Watcher tab.
5. Edit the fields on the **Variable Watcher** tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>Current catalog item.</td>
</tr>
<tr>
<td>Variable</td>
<td>Variable that is being watched.</td>
</tr>
<tr>
<td>Type</td>
<td><strong>Type</strong> of the variable.</td>
</tr>
<tr>
<td>Create roles</td>
<td>User type that can create values for the variable.</td>
</tr>
<tr>
<td>Write roles</td>
<td>User type that can edit values for the variable.</td>
</tr>
<tr>
<td>Read roles</td>
<td>User type that can read values for the variable.</td>
</tr>
<tr>
<td>Reference</td>
<td>Reference table for the variable. Applicable for reference variables.</td>
</tr>
<tr>
<td>Reference Qual</td>
<td>Qualifiers to restrict data that is available in the field. Applicable for list collector, lookup multiple choice, lookup select box, and reference variables.</td>
</tr>
<tr>
<td>Attributes</td>
<td>Attributes of the variable.</td>
</tr>
<tr>
<td>Delete roles</td>
<td>User type that can delete values for the variable.</td>
</tr>
<tr>
<td>All</td>
<td>If selected, displays the action log of the variable due to catalog client scripts, data lookups, and catalog UI policies.</td>
</tr>
<tr>
<td>Catalog Client Script</td>
<td>If selected, displays the action log of the variable due to catalog client scripts.</td>
</tr>
<tr>
<td>Data lookup</td>
<td>If selected, displays the action log of the variable due to data lookups.</td>
</tr>
<tr>
<td>Catalog UI Policy</td>
<td>If selected, displays the action log of the variable due to catalog UI policies.</td>
</tr>
</tbody>
</table>
6. To watch another variable, right-click that variable and select **Watch Variable**.

   **Note:** You can watch only one variable at a time.

7. To stop watching a variable, right-click the variable and select **Unwatch Variable**.

8. To clear the logs, click the Clear log icon (●).

9. To resize the pane, click **Small**, **Medium**, or **Large**.

10. To close the pane, click the Close icon (○).

**Service catalog variable sets**

Administrators and catalog administrators often define multiple catalog items that use the same group of service catalog variables. Catalog managers and catalog editors can attach a variable set for items to which they are assigned. However, catalog managers and catalog editors cannot create a variable set.

For example, a catalog administrator defines 10 catalog items for types of servers. The request process for all these items asks the same five questions, using the same variables.

Associating these variables individually per catalog item is repetitive, time-consuming, and error-prone. Also, to make a single change to multiple catalog items involves manually changing each item. For example, to add a variable to
10 catalog items, you would need to manually associate the variable with each item.

Variable sets allow you to create a collection of variables that can be reused across multiple catalog items and order guides. Using variable sets saves time because you do not have to create the same variables individually for many catalog items. Also, when variables should be modified, you can modify the variable set and the changes are reflected across all the catalog items that are associated with the variable set.

Variable sets also allow you to define catalog client scripts and UI policies that are applicable to the variables in the set.

⚠️ **Note:** Variables in a set use the same rules as other variables to determine when the variables in a set appear on a task. For example, variables must either be global or be attached directly to an item.

A catalog administrator can provide read, write, and update roles to access a variable set. When you access variables of a variable set, a validation is first done at the variable set level, and then at the variable level. If the access is blocked at the variable set level, then the access settings on the variable are over-ridden. If the access is allowed at the variable set level, then access at the variable level is verified.

⚠️ **Note:** Both single-row and multi-row variable sets are supported in Now Platform, Service Portal, Now Mobile, and in the Variable editor in Agent Workspace.

### Single-row variable set

Use a single-row variable set to capture data from variables that are grouped together, while submitting a catalog item request for a single entity.

### Multi-row variable set

Use a multi-row variable set (MRVS) to capture variable data in a grid layout while submitting a catalog item request for a group of entities. For example, for HR during the reorganization of employees, a single record producer should be able to capture the relevant information such as the department and manager for a group of employees. Also, when you request a catalog item to order virtual machines and servers, configuration options should be captured as a single request. In this case, a requester can define multiple hardware units as rows and their configuration options as columns of an MRVS.

You cannot include the following variable types in an MRVS:
- Attachment
- Break
- Container End
- Container Start
- Container Split
- HTML
- Label
- Macro
- Macro with label
- Rich Text Label
- UI Page
Note:

- You can configure an MRVS variable to disallow duplicate values. For information about the **Unique** field, see Create a service catalog variable.
- You can hide a variable in the MRVS so that it does not appear when the modal is open.
- The **Map to field** functionality is not supported for variables used in an MRVS.
- Only the glide list interface is supported for the List Collector variable.
- Cascading functionality for variables in an order guide is not supported in an MRVS.
- An MRVS is not displayed when added within a container.
- You cannot add variables with read roles in an MRVS.
- When you clone a request that contains an MRVS, the information that is specified in the MRVS is available in all cloned requests. All UI policies and client scripts on the MRVS are also cloned.
- Set a limit to the number of rows that you can add to an MRVS by using the `max_rows` attribute in the **Variable Set attributes** field.
- In the RITM and request view in Now Mobile, an MRVS is not supported. A message is displayed in this view that this variable set is not viewable.
- An MRVS is supported in the variable summarizer only in Service Portal.
- You can include an MRVS in the GetCatalogVariables and CreateCatalogTask actions using Flow Designer.
- You can iterate through individual rows and access variables using the For Each flow logic.
- You can include MRVS while creating a catalog task using a workflow.

An MRVS form changes dynamically based on the data in the catalog item form that includes the following:

- Other rows of that MRVS
- Other variables outside of that MRVS on the catalog item form.

For information about accessing data in a multi-row variable set (MRVS) when a modal is open, see `g_service_catalog - Client`.

You can define catalog client scripts, catalog UI policies, and catalog data lookups for an MRVS. Visibility is honored just on the MRVS form and not in the list.
Note:

- onSubmit catalog client scripts are not supported for an MRVS.
- Catalog UI policies and catalog client scripts defined at the item level are not applicable for variables in an MRVS. Only those catalog UI policies and catalog client scripts defined within the MRVS are applicable for variables in the MRVS.
- Scripts that are not included in an MRVS cannot affect variables inside the MRVS. Similarly, the scripts included in the MRVS cannot affect the variables that are not included in the MRVS.
- Variables that are not included in an MRVS cannot be used in dependent reference qualifiers for variables in the MRVS. Similarly, the variables included in the MRVS cannot be used in dependent reference qualifiers for variables that are not in the MRVS. For a reference qualifier, the current row is the one that is being edited.

You cannot set `Global` as `True` for any variable that belongs to an MRVS. So, an MRVS is not available in catalog tasks.

If the variables included in the MRVS have price implications for a catalog item, the price of the catalog item reflects the corresponding changes when a row is added, edited, or removed from this variable set.

Note: When you disable the `glide.sc.use_cart_layouts` property, the Order Item Widget does not reflect the price changes of the item from the MRVS. However, when you add this item to the cart, these price changes are reflected.

You cannot select variables of an MRVS when defining the following for a catalog item:

- UI policy conditions
- Unsupported ATF step configurations. You can only validate if an MRVS is visible, mandatory, or read only.
- Reporting

Create a variable set and add it to an item

Create a set of variables and add them to multiple catalog items and order guides for reuse.

Before you begin

Role required: catalog_admin, admin, catalog_editor, or catalog_manager
About this task

• Variable sets within a catalog item cannot have the same internal name.

• Within a catalog item, the name of a variable cannot be the same as the title or internal name of a variable set.

Note: This condition is also applicable even when a variable is not part of the variable set.

• Any catalog client script or catalog UI policy script should refer to the internal name of a variable set instead of its name or title.

Procedure

1. Navigate to Service Catalog > Catalog Variables > Variable Sets.

2. Click New.

   The Variable Set Creation page is displayed.

3. Select any of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single-Row Variable Set</td>
<td>Creates a variable set with variables that are grouped together. <strong>Type</strong> field is set to <strong>Single Row</strong>.</td>
</tr>
<tr>
<td>Multi-Row Variable Set</td>
<td>Creates a variable set with multiple rows that captures variable data in a grid layout. <strong>Type</strong> field is set to <strong>Multi Row</strong>.</td>
</tr>
</tbody>
</table>

4. Enter details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title of a variable set. Appears if the <strong>Display title</strong> check box is selected.</td>
</tr>
<tr>
<td>Internal name</td>
<td>Variable set name for internal use. For example, to access the variable set for the front-end (through the <em>g_form</em> API) and server side scripting.</td>
</tr>
</tbody>
</table>

Note: If this field is empty, its value is auto-populated based on the **Title** field for all variable types except break, container split, and container end.

Order            | Order number for the variable set.                                                                                                             |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Type of the variable set. Possible choices are:</td>
</tr>
<tr>
<td></td>
<td>• Single Row</td>
</tr>
<tr>
<td></td>
<td>• Multi Row</td>
</tr>
<tr>
<td>Application</td>
<td>Applications that can use this variable set.</td>
</tr>
<tr>
<td>Display title</td>
<td>If selected, adds a title and an expandable header to the right of the variable set.</td>
</tr>
<tr>
<td>Note:</td>
<td>When a user requests the item, all check box variables are grouped under a default title of Options. To use a custom title, insert a variable of type Label, with an Order value that puts it directly above the check box variables.</td>
</tr>
<tr>
<td>Variable Set</td>
<td>Attributes for configuring a multi-row variable set. Use the max_rows attribute to set a limit to the number of rows that you can add to a multi-row variable set. For example, specify max_rows=1 as the field value.</td>
</tr>
<tr>
<td>attributes</td>
<td></td>
</tr>
<tr>
<td>Layout</td>
<td>The layout display. Set to 1 Column Wide or 2 Columns Wide, alternating sides or 2 Columns Wide, one side, then the other.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the variable set.</td>
</tr>
</tbody>
</table>

5. Right-click and select **Save**.

6. Create the variables to use in that set.

   a. In the Variables related list, click **New**.

   b. Follow the steps for creating variables.

   **Note:** For a multi-row variable set:

   • The included variables are displayed as columns of a table.
   • The column order is the order of variables defined in the variable set.

7. To create an associated catalog data lookup rule, perform the following steps.

   a. In the Catalog Data Lookup Definitions related list, click **New**.

   b. On the Catalog Data Lookup Definitions form, fill the fields. For information on creating a data lookup rule, see **Create a catalog lookup definition**.

8. Click **Submit**.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Add a variable set to a catalog item or order guide

Service Catalog enables you to add a variable set to one or more catalog items or order guides.

Before you begin
Role required: catalog_admin, admin, catalog_editor, or catalog_manager

Procedure

1. Open a catalog item or an order guide.

<table>
<thead>
<tr>
<th>Option</th>
<th>Navigation path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog item</td>
<td>Service Catalog &gt; Catalog Definition &gt; Maintain Items</td>
</tr>
<tr>
<td>Order guide</td>
<td>Service Catalog &gt; Catalog Definition &gt; Order Guides</td>
</tr>
</tbody>
</table>

2. In the Variable Sets related list, click Edit.

You can configure the form to add the Variable Sets related list.

3. Select and add a variable set.

   Note: If the Cascade Variables check box is selected for an order guide, multi-row variable set data should be cascaded to the included items.

4. Click Save.

5. Click Try.

   Note: For a multi-row variable set:
   - The associated variables are displayed as columns of a table on a catalog item or record producer. Each row corresponds to a set of data for all variables in the variable set.
   - The column order is the order of variables defined in the variable set.

a. To add a row, click **Add** within the variable set, specify the variable information in the **Add Row** window, and click **Add**.

**Note:**
- A maximum of 50 rows can be added.
- Unless default values are provided for variables or On Load scripts are used to pre-populate data, you should add variable data for each row.

b. To edit a row, click the edit row icon ✎ in the **Actions** column, specify the variable information in the Edit Row window, and click **Save**.

**Note:** When you add or edit an existing row, all catalog UI policies and client scripts associated with the multi-row variable set should be honored.

c. To remove a row, click the remove row icon ✗ in the **Actions** column and click **Remove** in the confirmation window.

d. To remove all rows of the table, Click **Remove All** within the variable set and click **Remove** in the confirmation window.

**Variable set layout**

Variable sets can have one of many layouts. You can define the order of the variables for each item.

- **1 column wide:** Variables appear in a single vertical column, ordered from top to bottom. This column is a simple way to display information, but can result in empty space to the right of questions. This order is the default layout.
- **2 columns wide, alternating sides:** Variables are laid out in two columns with variables placed alternately in the left and right columns.
- **2 columns wide, one side, then the other:** The first half of the variable set is laid out sequentially in the left column and the second half is laid out sequentially in the right column.

**Note:** Variables with several possible choices defined, such as multiple choice variables, are considered a single entity in layouts. All choices are displayed as a single, contiguous unit.
**Variable set order**

A variable set is a discrete unit with an order number by default. All variables within the set are included wherever the set is included.

For example, if you set the following order for some example variables and a variable set:

- Variable A (100)
- Variable B (200)
- Variable C (300)
- Variable Set 1 (250) - containing three variables (VS1, VS2, VS3) with incremental order values (150, 250, 350)

The variables are displayed in this order:

- Variable A (100)
- Variable B (200)
- Variable Set 1 (250): Variable VS1 (150)
- Variable Set 1 (250): Variable VS2 (250)
- Variable Set 1 (250): Variable VS3 (350)
- Variable C (300)

**Additional layout options**

For additional layout options, you can also add container variables to a variable set.

For example, create the following variables and orders:

<table>
<thead>
<tr>
<th>Order of variables</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Variable</strong></td>
</tr>
<tr>
<td>Alfa</td>
</tr>
<tr>
<td>Bravo</td>
</tr>
<tr>
<td>Charlie</td>
</tr>
<tr>
<td>Delta</td>
</tr>
<tr>
<td>Echo</td>
</tr>
<tr>
<td>Foxtrot</td>
</tr>
</tbody>
</table>
Order of variables in a layout

<table>
<thead>
<tr>
<th>1 Column Wide</th>
<th>2 Columns Wide, alternating sides</th>
<th>2 Columns Wide, 1 side, then the other</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alfa</td>
<td>Alfa Bravo</td>
<td>Alfa Delta</td>
</tr>
<tr>
<td>Bravo</td>
<td>Charlie Delta</td>
<td>Bravo Echo</td>
</tr>
<tr>
<td>Charlie</td>
<td>Echo Foxtrot</td>
<td>Charlie Foxtrot</td>
</tr>
<tr>
<td>Delta</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Echo</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Foxtrot</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Set an item-specific order

You can set the order value on a per item basis.

About this task

When a variable set is used by more than one catalog item, you can define item-specific ordering to provide more flexibility in the layout. You do this using the catalog variable set record associated with the item. Use the Order field in this catalog variable set record to set this order value on a per-item basis, overriding the default value defined in the variable set.

Procedure

1. Navigate to Service Catalog > Catalog Definition > Maintain Items.
2. Open the catalog item to edit.
3. Navigate to the Variable Sets related list.
4. Click the reference icon for the variable set.
5. Set the order value as required.
   The catalog variable set order is specific to the link between the item and the
   variable set. It overrides the default order defined on the variable set itself.

Examples of variable set orders

The following example demonstrates the layout of variables when variable sets
and item variables are associated with an item under different scenarios.

The order for display of the variables and variable sets is specified using the
Information icon in the Related Lists.
In Layout 1, order values are specified for both Variable Set A and Variable Set B at the Related Lists level and those order values always takes precedence. Hence, the layout is organized based on the order value specified for the variable sets at the Related Lists level.

In Layout 2, an order value is not specified for Variable Set A whereas an order value is specified for Variable Set B at the Related Lists level. In this case, the empty value for Variable Set A is considered as zero. Hence, the layout is organized based on the order value of 0 for Variable Set A and 300 for Variable Set B.

In Layout 3, order values are not specified for both Variable Set A and Variable Set B at the Related Lists level. In this case, the order values specified within the variable sets are considered. Hence, the layout is organized based on the order value of 400 for Variable Set A and 150 for Variable Set B.
Service Catalog scoping
Scoping support is available to define the limits of entities in Service Catalog.

- A catalog can have categories from different scopes.
- A category can only be in the same scope as its parent category.
- You can associate a catalog item with categories of a different scope.
- Catalog items can contain variable sets from a different scope.
- Variables can only be in the same scope as the catalog item or variable set.
- Catalog UI policies can only be in the same scope as the catalog item or variable set.
- Catalog client scripts can only be in the same scope as the catalog item or variable set.
- Catalog data lookup can only be in the same scope as the catalog item or variable set.
- The rule base of an order guide can have items from different scopes.
- The scope of the record producer and the target table should be the same.

Scriptable service catalog variables
You can use scripting to reference any request item variable from a table in scoped and non-scoped environment.

An example of a variable reference follows.

```plaintext
current.variables.<variable_name>
```

Where current refers to the current record, and `<variable_name>` is the name of your variable.

ℹ️ **Note:** In order to reference a variable from JavaScript, it must have a name.

When a variable is part of a variable set, you can reference it as `current.variables.<variable_name>` or `current.variables.<variable_set_name>.<variable_name>`.

Variable set is also a first-class citizen in Service Catalog. Like variables, a variable set has read, write, and create roles. If roles are provided for a variable set, the roles are applicable for the variables within the set. Roles of an individual variable are overridden by the roles of the variable set.
Print a variable

```javascript
var original = current.variables.original_number;
gs.print(original);
```

Set a variable

```javascript
current.variables.name = "Auto-Generated:" + current.variables.asset_tag;
```

Create an inventory item with fields set from variables

```javascript
doCreation();

function doCreation () {
  var create = current.variables.create_item;
  if (create == 'true') { // we want to create an asset
    var computer = new GlideRecord('cmdb_ci_computer');
    computer.initialize();
    computer.asset_tag = current.variables.asset_tag;
    computer.serial_number = current.variables.serial_number;
    computer.name = current.variables.name;
    computer.manufacturer = current.variables.company;
    computer.insert(); }
}
```

Get GlideElementVariable of variables and variable sets associated with a GlideRecord

```javascript
now_GR.variables
```

Get the name value pair of variables associated with a GlideRecord

```javascript
now_GR.variables.getVariableValue();
```

Get a list of GlideElementVariable for variables within a task record

```javascript
now_GR.variables.getElements();
```

Get a list of GlideElementVariable for variables (including multi-row variable set) within a task record

```javascript
now_GR.variables.getElements(true);
```
### APIs for GlideElementVariable

- `now_GR.variables.<var_name>.isMultiRow()`: Get whether the GlideElementVariable is a multi-row variable set or a variable.

- `now_GR.variables.<var_name>.getQuestion()`: Get the Question object for a variable. Applicable only for a variable (`isMultiRow()` is false) and not for a multi-row variable set.

- `now_GR.variables.<var_name>.getLabel()`: Get the label of the GlideElementVariable. For a variable, the label of the variable is returned. For multi-row variable set, the title of the variable set is returned.

- `now_GR.variables.<var_name>.canRead()`: Get whether the user can view a variable or multi-row variable set.

- `now_GR.variables.<var_name>.canWrite()`: Get whether the user can edit a variable or multi-row variable set.

- `now_GR.variables.<var_name>.getDecryptedValue()`: Get the decrypted value for a masked variable. Applicable only for a masked variable.

- `now_GR.variables.<var_name>.getRows()`: Get the list of row objects for a multi-row variable set. Applicable only for a multi-row variable set (`isMultiRow()` is true).

- `now_GR.variables.<var_name>.getRowCount()`: Get the number of rows for multi-row variable set. Applicable only for a multi-row variable set (`isMultiRow()` is true).

### Example to access variables of GlideRecord for the Task table

```javascript
var now_GR = new GlideRecord('sc_req_item');
if (now_GR.get('635af5387320300e0ef0cf888cb0b73')) {
    var variables = now_GR.variables.getElements();
    for (var i=0;i<variables.length;i++) {
        var question = variables[i].getQuestion();
        gs.log(question.getLabel() + ":" + question.getValue())
    }
}
```

### Example to access a multi-row variable set of GlideRecord for the Task table

```javascript
var now_GR = new GlideRecord('sc_req_item');
now_GR.get('02c38dcd87013300e0ef0cf888cb0bb2');
var vars = now_GR.variables.getElements(true);
```
for (var i=0; i<vars.length; i++) {
    var now_V = vars[i];
    if (now_V.isMultiRow()) {
        var rows = now_V.getRows();
        for (var j=0; j<now_V.getRowCount(); j++) {
            var row = rows[j];
            var cells = row.getCells();
            for (var k=0; k<cells.length; k++) {
                var cell = cells[k];
                gs.info(cell.getLabel() + ":" + cell.getCellDisplayValue())
            }
        }
    }
}

**Multi-row variable set**

<table>
<thead>
<tr>
<th>Operation</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table operations</strong></td>
<td></td>
</tr>
<tr>
<td>Return JSON array value as String</td>
<td>now_GR.variables.table_var</td>
</tr>
<tr>
<td>Set value of a multi-row variable set</td>
<td>now_GR.variables.table_var = &lt;val&gt;</td>
</tr>
</tbody>
</table>

**Note:** An array of ordered (key, value) pairs is also applicable as input.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get value of column, var1, of a multi-row variable set</td>
<td>now_GR.variables.table_var.var1</td>
</tr>
<tr>
<td>Set value of a variable set, var1</td>
<td>now_GR.variables.table_var.var1 = &lt;val&gt;</td>
</tr>
</tbody>
</table>

**Note:** An array of ordered (key, value) pairs is also applicable as input.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row operations</td>
<td></td>
</tr>
<tr>
<td>Get the current row count</td>
<td>now_GR.variables.table_var.getRowCount()</td>
</tr>
</tbody>
</table>
Multi-row variable set (continued)

<table>
<thead>
<tr>
<th>Operation</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Returns the row specified by the variable &quot;i&quot; - <code>getRow(&lt;int&gt; i)</code></td>
<td><code>var row = now_GR.variables.table_var.getRow(&lt;int&gt; i);</code></td>
</tr>
<tr>
<td>Get the cell value for a question column mapped to <code>&lt;var_name&gt;</code></td>
<td><code>row.&lt;var_name&gt;</code></td>
</tr>
<tr>
<td>Set the cell value for a question column mapped to <code>&lt;var_name&gt;</code></td>
<td><code>row.setCellValue('&lt;var_name&gt;', value)</code></td>
</tr>
<tr>
<td>Set the cell value for a question column mapped to <code>&lt;var_name&gt;</code></td>
<td><code>row.&lt;var_name&gt; = value</code></td>
</tr>
<tr>
<td>Add an empty row at the end of the table and return a scriptable object</td>
<td><code>var row = now_GR.variables.table_var.addRow()</code></td>
</tr>
<tr>
<td>Delete a row</td>
<td><code>row.deleteRow()</code></td>
</tr>
</tbody>
</table>

Notes and limitations

// Single column of table_Var
`now_GR.variables.table_var.var1`  
`now_GR.variables.table_var.var1 = <val>`

1. You can only set a variable in a before business rule. Variables set in an after rule are not written to the database.

2. There is nothing in place to prevent namespace collision with variables. Creating two variables named `computer_speed` would result in only one of them showing up; the second one would overwrite the first one.

3. Date/time variables use the same time zone formatting and storage rules as all other dates in the system. They are stored internally in GMT, but translated into the user's local time zone and format for display.

Service Catalog security

Service Catalog enables you to set the security for catalog with user criteria.

Set security for items and categories

An administrator can control access to content in the service catalog by creating and applying user criteria records.
Catalog managers and catalog editors can apply existing user criteria for items and categories to which they are assigned. Catalog managers and catalog editors cannot create or edit user criteria directly.

You can create user criteria records that define conditions for user information and then apply these criteria records to catalog items and categories. In this way you can control access to these items and categories.

For example, create a USA Sales user criteria record matching users who are both in the sales team and based in the USA. Then apply this record to the USA IT Hardware catalog category, so only users matching the record can access that category.

The feature is active by default in new Fuji instances and upgraded instances that do not use entitlement-based access controls. If you upgrade an instance that uses entitlements, you can migrate to user criteria to take advantage of the improved control, flexibility, and reuse.

Access controls allow you to:

• Manage access to multiple items and categories in one user criteria record. For example, create a single UK Employees user criteria record and apply it to multiple items and categories that are available to employees in the UK.

• Allow access if one condition matches, or if all conditions match. For example, define that only users who are both in a specific location and who belong to a specific department can have access.

• Use Available For and Not Available For lists to allow or prohibit access to users matching the conditions in a criteria record. For example, specify that a US-based catalog category is available for the users located in the USA but is not available for users belonging to the Sales department (whether in the US or not).

• Extend matching to create conditions matching additional fields in the User [sys_user] table, without having to use a script. For example, you can add a condition to match items against the Cost center field in user records.

**Important:** After making user criteria additions or changes, you may need to log out and log back in to clear the prior configuration.

**Related information**

  Debug user criteria of a catalog item

  Create a user criteria record in Service Catalog

Create a user criteria record to define conditions that are evaluated against user records.
**About this task**
You can apply several user criteria records to a single catalog item or category. In this situation, users match only one of these criteria records to have access.

**Procedure**
1. Navigate to **Service Catalog > Catalog Definition > User Criteria** and create a record.
2. Fill in the fields on the form, as appropriate.

### User criteria fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the criteria record.</td>
</tr>
<tr>
<td>Users</td>
<td>The individual user records to match.</td>
</tr>
<tr>
<td>Groups</td>
<td>The group records to match.</td>
</tr>
<tr>
<td>Roles</td>
<td>The roles to match.</td>
</tr>
<tr>
<td>Advanced</td>
<td>A check box to display or hide the Script field.</td>
</tr>
<tr>
<td>Script</td>
<td>A script to define any additional criteria, and return true or false. This field is available only if Advanced is selected.</td>
</tr>
</tbody>
</table>

**Note:**
- The evaluation of a role is cached in the session, so any change in the role requires you to logout and login, similar to roles in ACL (Access Control List).
- User Criteria is not applicable for elevated privilege roles.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td></td>
</tr>
<tr>
<td>•</td>
<td>The script is evaluated in the scope that the user criteria is created in.</td>
</tr>
<tr>
<td>•</td>
<td>The evaluation of the script is cached in the session, so any change in the</td>
</tr>
<tr>
<td>•</td>
<td>evaluation requires you to logout and login, similar to roles in ACL.</td>
</tr>
<tr>
<td>•</td>
<td>Do not use <code>gs.getUser()</code> or other session APIs since they cause conflict</td>
</tr>
<tr>
<td></td>
<td>when used in diagnostic tools. Use the pre-defined <code>user_id</code> variable</td>
</tr>
<tr>
<td></td>
<td>available in the script to get the user id of the user being used to</td>
</tr>
<tr>
<td></td>
<td>evaluate the script.</td>
</tr>
<tr>
<td>•</td>
<td>Because scripts are evaluated dynamically, including scripts in user</td>
</tr>
<tr>
<td></td>
<td>criteria records can decrease performance.</td>
</tr>
<tr>
<td>•</td>
<td>Because answer is a pre-reserved keyword, do not use a function with its</td>
</tr>
<tr>
<td></td>
<td>name as answer, that is, <code>answer()</code> (reserved).</td>
</tr>
<tr>
<td>Active</td>
<td>A check box to activate or deactivate this criteria record.</td>
</tr>
<tr>
<td>Companies</td>
<td>The companies to match.</td>
</tr>
<tr>
<td>Locations</td>
<td>The locations to match.</td>
</tr>
<tr>
<td>Departments</td>
<td>The departments to match.</td>
</tr>
<tr>
<td>Match All</td>
<td>A check box to determine whether all elements from each populated criteria</td>
</tr>
<tr>
<td></td>
<td>field must match. If selected, only users who match all criteria are given</td>
</tr>
<tr>
<td></td>
<td>access. If cleared, the user must meet one or more of the set criteria to</td>
</tr>
<tr>
<td></td>
<td>be given access.</td>
</tr>
<tr>
<td></td>
<td>By default, this check box is cleared so that any condition met provides a</td>
</tr>
<tr>
<td></td>
<td>match.</td>
</tr>
<tr>
<td></td>
<td>For example, consider a user criteria record for the following:</td>
</tr>
<tr>
<td></td>
<td>• Locations A or B</td>
</tr>
<tr>
<td></td>
<td>• Company C or D</td>
</tr>
<tr>
<td></td>
<td>With <strong>Match All</strong> selected, only users meeting all these conditions are</td>
</tr>
<tr>
<td></td>
<td>matched. For example, a user with a location A and a company C.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>With Match All cleared, users meeting any of these conditions are matched. For example, a user with a location B.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you select Match All, ensure that you do not create contradictory conditions which can never be met. For example, if all users in location A work for company G, then the conditions in this example can never be met.</td>
</tr>
</tbody>
</table>

**Implementing user criteria**

When creating user criteria for your system, consider the following recommendations.

- **Design Criteria for Reuse:**
  Ensure that you design user criteria for maximum reuse. Create user criteria records with common sets of conditions matching your organization requirements. Allow them to be shared across as many items and categories as possible, rather than creating multiple similar criteria records for individual items and categories.

- **Naming conventions:** Give each user criteria record a meaningful name, to help you determine the function for that record. For example,
  - Users in company Cloud Dimensions AND in Madrid
  - Users in company Cloud Dimensions OR in Madrid
  - Users belonging to the Group Development, IT, or Sales
  - Users with role itil, asset_manager, or catalog_admin

- **Test user criteria on a development or test instance, and then transfer the records from the user criteria tables and catalog records to your production instance using update sets.**

**Apply user criteria to items and categories**

Apply a user criteria record to items and categories, either from the item or category form or from the user criteria form.

**About this task**

The user criteria restriction applies only within Service Catalog for the specific item it is applied for. However, the user criteria restriction is not applied outside the Service Catalog where the user has access to the item via the table.
To apply criteria directly to an item or category, use the Available For or Not Available For related lists in the Item or Category form.

ℹ️ **Note:**
- When a change is made to the end-user profile, such as location, and it affects their ability to view items, those changes do not take effect until the end user has relaunched the session.
- The user criteria restrictions of a category do not automatically apply to the catalog items within the category. If required, you should apply the user criteria restrictions to the individual catalog items.

To apply criteria directly from the User Criteria form, add items to the Available For Catalog Items and Not Available For Catalog Items related lists, and add categories to the Available For Categories and Not Available For Categories related lists. You can configure the User Criteria form to add these lists.

ℹ️ **Note:**
The **Not Available For** settings override **Available For** settings. A user on the **Not Available For** list for an item cannot access that item, even if that user is also on the **Available For** list for that item.

**Apply user criteria to items**
Apply user criteria to an item to define which users can and cannot access that item.

**About this task**
You can apply user criteria to all types of catalog item, including order guides, content items, and record producers.

ℹ️ **Note:** The user criteria restriction applies only within Service Catalog for the specific item it is applied for. However, the user criteria restriction is not applied outside the Service Catalog where the user has access to the item via the table.

**Procedure**

1. In an item record, navigate to the Available For or Not Available For related lists.
2. Click **Edit** to add an existing user criteria record, or click **New** to create a new one.
3. Save the record to associate the user criteria record with the item.

⚠️ **Note:** The Not Available For settings override Available For settings. A user on the Not Available For list for an item cannot access that item, even if that user is also on the Available For list for that item.

### Apply user criteria to categories

Apply user criteria to a category to define which users can and cannot access a category.

**Procedure**

1. In a category record, navigate to the Available For or Not Available For related lists.
2. Click **Edit** to add an existing user criteria record, or click **New** to create a new one.
3. Save the record to associate the user criteria record with the category.

⚠️ **Note:**

- The Not Available For settings override Available For settings. A user on the Not Available For list for a category cannot access that category, even if that user is also on the Available For list for that category.

- The user criteria restrictions of a category do not automatically apply to the catalog items within the category. If required, you should apply the user criteria restrictions to the individual catalog items.

### Extend user criteria

Extend the user criteria table when the available user criteria fields are not sufficient. User criteria references various user fields (fields from the User [sys_user] table), such as department, company, and groups. You can extend user criteria with a custom field to include any other user reference field (field from the User [sys_user] table) of interest.

**About this task**

For example, you can extend user criteria to include the user’s cost center, and then restrict certain catalog items only to members of that cost center. Meet the following rules to extend the user criteria table.
• The field to add must be a reference field in the user record.
• The field added to the user criteria table must be List type.
• The fields must have matching names. For example, `cost_center [sys_user]` and `u_cost_center` ("u" prefix is added to custom fields in a table) are considered to be matching.

This example demonstrates how to extend the current user criteria record to include Cost center as an option.

**User criteria record before extending Cost center**

<table>
<thead>
<tr>
<th>Name</th>
<th>Users with 'snc_internal' role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td></td>
</tr>
<tr>
<td>Groups</td>
<td>snc_internal</td>
</tr>
<tr>
<td>Roles</td>
<td></td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to System Definition > Tables.
2. Open the User Criteria record.
3. In the Table Columns related list, click New.
4. Set the type to List, and then enter Cost center as the column label. The Column name field populates with `u_cost_center`.
5. In the Reference Specification form section, select Cost Center for the reference field.
6. Add any conditions or additional information to the dictionary entry as desired.
7. Click Submit.
8. Navigate to .
9. Select or create a user criteria record, and see that you can now use the new field.
What to do next
Test the user criteria record by navigating to Service Catalog > Catalog Definition > User Criteria, and opening any record. Verify that the extended field is available.

You can extend the User [sys_user] table if there are fields in other tables that you want considered in user criteria. After extending the User table, follow the steps in this procedure to extend it to user criteria.

User criteria with cost center

You can extend the User [sys_user] table if there are fields in other tables that you want considered in user criteria. After extending the User table, follow the steps in this procedure to extend it to user criteria.

User criteria migration
Service catalog user criteria records provide access control for service catalog items and categories.
You can migrate your access controls to use user criteria. The user criteria feature is automatically enabled for new instances. If you upgrade your instance, a script runs to determine current access control usage.

• If your instance does not use entitlement-based access controls, the user criteria feature is automatically enabled.

• If your instance does use entitlements, the user criteria feature is not enabled. If you want to use user criteria, use the procedure described on this page to migrate your access controls from entitlements to user criteria.

Migrate to user criteria to provide more reuse, control, and flexibility compared to entitlements.
For example, you can use a single criteria record to make multiple catalog items available to only users who meet all these requirements:
• Are located in EMEA or APAC
• Belong to ACER
• Are in the Training department

Migrate to Service Catalog user criteria

Service Catalog enables you to maintain the required access controls to your service catalog while migrating from entitlements to user criteria.

About this task

Procedure

1. Navigate to Service Catalog > Catalog Administration > Properties and verify that the user criteria feature is not already enabled on your system.
   • If the property Use "User Criteria" to define access to catalog items and categories (glide.sc.use_user_criteria) is set to true, you can skip the following steps. The user criteria feature is automatically enabled because entitlements were not used in your old system.
   • If this property is set to false, continue with the following steps. The user criteria feature has not been enabled yet on your system.

2. To preview the user criteria feature, set the service catalog property Enable both "User Criteria" and "Entitlement" related lists for catalog items and categories when migrating from entitlements (glide.sc.user_criteria_migration) to true. This option lets you compare user criteria records and entitlements before you fully switch to user criteria.

3. Inspect your service catalog items and categories to identify access control sets that you can configure user criteria records for. Review your current entitlements and record your current design for access controls. Focus on identifying patterns where multiple items have the same combination of location, group, and so on. Each combination is a possible access control set.

4. Create a user criteria record for each access control set that you identified from your inspection of the service catalog.
   You have a step with a list, note, and image.

5. Apply these user criteria records to the items and categories identified, replacing the equivalent entitlements.

6. Enable user criteria on your system by setting the service catalog property Use "User Criteria" to define access to catalog items and categories.
(glide.sc.use_user_criteria) to **true**. When this property is set to true, any remaining entitlements are no longer used.

*Note:* Scripts in user criteria cannot reference the category or catalog item as `current` as entitlement scripts do. For scripts in user criteria, use the `user_id` available for the user currently being evaluated against the category or catalog item.

**Data structure differences**

There are significant data structure differences between entitlements and user criteria, which you must be aware of while migrating.

Using entitlements, the following tables are loaded into memory and evaluated before rendering.

For catalog items:

```plaintext
Entitlements Data Structure - Catalog Items

- sc_cat_item_company_mtom
- sc_cat_item_dept_mtom
- sc_cat_item_group_mtom
- sc_cat_item_location_mtom
- sc_cat_item_user_mtom
- sc_cat_item_company_no_mtom
- sc_cat_item_dept_no_mtom
- sc_cat_item_group_no_mtom
- sc_cat_item_location_no_mtom
- sc_cat_item_user_no_mtom
```

For categories:

```plaintext
Entitlements Data Structure - Categories

- sc_category_company_mtom
- sc_category_dept_mtom
- sc_category_group_mtom
- sc_category_location_mtom
- sc_category_user_mtom
- sc_category_company_no_mtom
- sc_category_dept_no_mtom
- sc_category_group_no_mtom
- sc_category_location_no_mtom
- sc_category_user_no_mtom
```

The user criteria architecture collects all user attributes in the User Criteria [user_criteria] table.

User criteria records can link to items and categories, as follows.

For catalog items:
• Catalog Item Available for [sc_cat_item_user_criteria_mtom]
• Catalog Item Not Available for [sc_cat_item_user_criteria_no_mtom]

User Criteria Data Structure - Catalog Items

For categories:
• Category Available for [sc_category_user_criteria_mtom]
• Category Not Available for [sc_category_user_criteria_no_mtom]

User Criteria Data Structure - Categories

Legacy service catalog access controls

Service catalog supports several ways to control access to a catalog item or category. These controls are also known as catalog entitlements.

Instead of access controls, use user criteria that is the supported security model for catalog item and category. For information about user criteria, see Apply user criteria to items and categories.

A service catalog item with no specific access controls is available to all users. If access controls are specified, only users who meet all conditions have access.

The following entitlements are available:

• Role
• Custom script
• Company, Department, Group, User, or Location
Access controls are checked in the following order: roles, then scripts, then Company, Department, Group, User, or Location.

⚠️ Note: The functionality described here is superseded by access controls using user criteria. Migrate to user criteria for a more flexible and reusable way to define access controls.

**Service Catalog administration**

Service Catalog enables an administrator to configure the service catalog.

**About this task**

**Procedure**

1. Navigate to **Service Catalog > Maintain Items** or **Service Catalog > Maintain Categories**.
2. Open an item or category, and then configure the related lists in the form to add **Available for Department** and **Available for Company**.
3. Click **Update** to save the form layout.
4. Open the item or category you wish to secure and add companies and departments to related lists.

   The item or category is available only for the companies and departments listed. If no companies or departments are listed, then the item or category is available to all companies or departments.

**Restrict access**

Service Catalog enables an administrator to grant or deny access to a service catalog item or category by company, department, group, user, or location.

**Procedure**

1. Navigate to **Service Catalog > Maintain Items** or **Service Catalog > Maintain Categories**.
2. Open the relevant catalog item or category.
3. Configure the form to add the appropriate **Available** or **Not available** lists.
4. Add the companies, departments, groups, users, or locations to the appropriate list.

5. Click **Update**.

**Restrict access by role**

By default, individual catalog items and categories do not have access restrictions.

**About this task**

Administrators can grant or deny access to a service catalog item or category based on role.

**Procedure**

1. Navigate to **Service Catalog > Maintain Items** or **Service Catalog > Maintain Categories**.

2. Open the relevant catalog item or category.

3. Add the required roles to the **Roles** field.
You can, if needed, Configure the form or change to Default View to see the Roles field.

Roles Granted

---

Restrict access by a script

Service Catalog enables you to control access to a service catalog item or category with a custom script.

Procedure

1. Navigate to Service Catalog > Maintain Items or Service Catalog > Maintain Categories.
2. Open the relevant catalog item or category.
3. Configure the form to add the Entitlement Script field.
4. In the **Entitlement Script** field, enter the access control script.

**Sample Scripts**

The following example script grants access to a catalog item named French Blackberry to users with a language of Fr (French):

```java
gs.log ('Running Entitlement script for French Blackberry')

if (gs.getUser().getLanguage() == 'fr')
    answer = true; else
    answer = false;

answer;
```

The following example script could be used to distinguish between two categories of users (one with full access and one with restricted access) on the catalog of services:

```java
var userid = gs.getUserID(); var now_GR = new GlideRecord('sys_user');
now_GR.get('sys_id', userid);

if (now_GR.source)
    answer = true; else
    answer = false;

answer;
```

**Overriding Entitlement Scripts by Role**

**a.** Navigate to **Service Catalog > Properties**.

**b.** Enter the roles for which to override the entitlement script (grant access) in the property List of roles (comma-separated) that can override normal entitlement checking inside the catalog. An itil role of "itil" means that the itil role can order any catalog item, even one protected by entitlement restrictions.

**Service Catalog customization**

Service Catalog enables you to customize the catalog in various ways.

No updates are supported on the following internal service catalog tables, either directly or through business rules.

- Options [sc_item_option]
- Variable Ownership [sc_item_option_mtom]
- Question Answer [question_answer]
Cart layout
Service catalog enables catalog administrators to configure the layout and functionality of the service catalog cart used in your organization to place requests for catalog items.

You cannot check out a cart item that is no longer available.

You can perform the following:

- Remove components. For example, hide prices throughout the cart if your catalog does not use pricing.
- Change labels. For example, change the Order now button label to Request Item in the shopping cart.
- Change the order of elements. For example, change the order of the columns on the order status screen.
- Configure, hide, or create functionality. For example, add a Requested For reference field to the shopping cart.

Configure cart layout

Configure cart layout records to define functionality for widgets or screens in the shopping cart.

Procedure

1. Navigate to Service Catalog > Catalog Definitions > Maintain Cart Layouts.
2. Select a widget or screen.
   - **Cart widgets**: Item Ordering Widget, Shopping Cart Widget, or Item Ordering Widget (Order Guide)
   - **Preview screens**: Cart Preview Screen, Cart Preview Screen (Two Step), Cart Preview Screen (Wish List), or Cart Preview Screen (Classic Mobile)
   - **Order status screens**: Order Status Screen or Order, Status Screen (Classic Mobile)
3. Update the Title field to change the title that appears on the widget.
4. Leave the default Target value. Do not change this value because it identifies the cart element being defined.
5. Update the other sections of the cart layout record, as required. The availability of these sections varies for each widget and screen record.
• In the **Components** section, select the components to display, such as delivery times, item descriptions, and prices.

• In the **Columns** section, select which columns to display, such as the item description column, delivery time column, or price column.

• In the **Buttons** section, select the buttons to display, such as **Add to Cart**, **Edit Cart**, and **Delete Item**.

• In the **Button Labels** section, enter new labels to replace the default button labels.

  A new label is used on all screens that the button appears on. For example, the **Continue Shopping** button is used on several screens, so changing its label affects all those screens.

6. If required, configure the widget and column macros.

7. Save the record, and then test the results of your configuration by ordering items from your service catalog.

   Some settings and properties in your instance can override or affect your cart layout.

**Cart layout considerations**

When you enable cart layouts, service catalog properties are impacted. Consider the possible outcomes and alter the settings or properties to achieve the cart layout and functionality you require.

Some of these properties are impacted when you use cart layouts. For example, with the order status screen, the **When to show prices and sub-totals on the Service Catalog Cart** (**glide.sc.price.display**) property overrides cart layout settings for displaying prices.

<table>
<thead>
<tr>
<th>Property</th>
<th>Impact</th>
</tr>
</thead>
</table>
| Allow ESS users the option to cancel their requests from the checkout screen.  
[glide.sc.checkout.cancel] | Overridden when the **Cancel Request** check box in cart layout settings is selected. If this check box is selected, the **Cancel** button is displayed even if the property is set to **No**. |
| Enable cloning requests during checkout.  
[glide.sc.allow.checkout.clone] | Not used (deprecated) if cart layouts are enabled. Replaced by the **Clone Checkout** check box in cart layout settings. |
Table title (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Clone Checkout</strong> check box is cleared by default for new instances. For upgraded instances, the check box is set to the existing value of the glide.sc.allow.checkout.clone property.</td>
<td></td>
</tr>
<tr>
<td>List of roles (comma-separated) that can use the quantity selector in the shopping cart [glide.sc.allow.quantity]</td>
<td>Overrides any relevant cart layout settings.</td>
</tr>
<tr>
<td>Show the request item number for each line item on the checkout screen (default false). [glide.sc.checkout.request.number]</td>
<td>Not used (deprecated) if cart layouts are enabled. Replaced by the <strong>Request Item Number column</strong> check box in cart layout settings.</td>
</tr>
<tr>
<td>Show the 'Back to Catalog' button on the two-step checkout screen. [glide.sc.checkout.twostep.back]</td>
<td>Not used (deprecated) if cart layouts are enabled. Replaced by the <strong>Back to Catalog</strong> check box in cart layout settings.</td>
</tr>
<tr>
<td>When to show prices and subtotals on the Service Catalog Cart. [glide.sc.price.display]</td>
<td>Overrides any relevant cart layout settings.</td>
</tr>
</tbody>
</table>

**Configure widget and column macros**

Configure macros that define functionality for elements within each widget or screen.

**About this task**

Some widgets or screens also have column macros that define the horizontal layout and configuration of shopping cart contents.

You can configure these macros to alter the display order of elements, or hide elements, within the widget or screen. You can also create new macros to implement any extra requirements.

**Procedure**

1. Navigate to **Widget Macros > Column Macros** related list.
2. Click the order number entry of a macro to edit its display order, or to activate or deactivate it.
3. Click **Update**.

4. Click the **Widget / View Macro** entry of a macro to view its functionality settings. You cannot edit functionality settings for default macros, but these settings can be a useful reference for creating your own widget macros.

**Create macros for cart layout**

Create macros for cart layout records using Jelly scripts to define customized behavior and display within a widget or screen.

**About this task**

Macros that you create do not affect upgrades because customized widget functionality is isolated from general cart behavior.

**Procedure**

1. Open the relevant cart layout record.
2. Navigate to **Widget Macros** or **Column Macro** related list.
3. Click **New**.
4. Enter details for the macro.

**Macro form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name for the new macro.</td>
</tr>
<tr>
<td>Active</td>
<td>A check box to indicate whether the macro is displayed or not.</td>
</tr>
<tr>
<td>Description</td>
<td>A summary of how the macro is used.</td>
</tr>
<tr>
<td>Active</td>
<td>A check box to indicate whether the macro is displayed or not.</td>
</tr>
<tr>
<td>XML</td>
<td>The Jelly script to apply for your macro.</td>
</tr>
</tbody>
</table>

5. Save the macro record.
**Example:**
This example demonstrates the script to add a Requested for reference field as a widget macro to a cart layout record.

```xml
<?xml version="1.0" encoding="utf-8" ?>
<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null" xmlns:g2="null">
  <j:set var="ref" value="sc_cart" />
  <j:set var="jvar_ref" value="${jvar_cart.getRequestedFor()}" />
  <j:set var="jvar_ref_display" value="${jvar_cart.getRequestedForDisplayName()}" />
  <tr>
    <td colspan="3">
      <g:catalog_requested_for />
    </td>
  </tr>
</j:jelly>
```

**Configure cart layout for specific items**
Set fields in the Catalog Item form to configure the cart layout for specific items.

**About this task**
Overrides any general cart layout settings. For example, you can hide the price of an item by setting the Omit price in cart field to true for that item.

**Procedure**
1. Navigate to Service Catalog > Catalog Definition > Maintain Items.
2. Select the catalog item.
3. Configure the form to add both Use cart layout and any of the following item configuration fields you require:
   - Omit price in cart
   - No cart
   - No order
   - No order now
   - No proceed checkout
   - No quantity
4. Clear the **Use cart layout** check box to display the configuration fields for that item.

5. Set the item configuration field values as required.

6. Click **Update**.

### Override cart layouts for items

Service catalog enables you to use additional methods to configure cart behavior or layouts, which override cart layout record settings.

For example, your cart layout record settings can hide item prices, but you might decide to display the price of the **Sales Laptop**. In that case, you would set the relevant configuration values on that catalog item. Be aware of the impact of these additional methods, to ensure that your cart behaves in the way you want.

**Note:**

If you are migrating to cart layouts, you can have defined additional settings and properties that impact your cart layout settings.

### Configure Service Catalog cart widgets

You can configure widgets for the shopping cart, catalog items, and order guides.

**About this task**

Overview of configurable options in the Service Catalog on the Service Portal and explains how to perform those configurations.

### Configure order guide widgets

You can customize the widget that provides details of the current catalog item on an order guide or wizard.
Before you begin
Role required: admin, catalog_admin

About this task
Order guide cart widget is visible when an order guide item is ordered.

Procedure
1. Navigate to Service Catalog > Catalog Definitions > Maintain Cart Layouts.
2. Open the Item Ordering Widget (Order Guide) record.
3. You can add/remove components and rename widget title.
4. Click Update.

Cart widget displayed for an order guide item

Note: By default, order guides use a two-step process, and catalog items use a one-step checkout process. If you configure the checkout process, keep in mind that order guides and catalog items provide different cart experiences if they use different checkout processes.

Configure catalog item widgets
You can customize widgets that appear for catalog items.

Before you begin
Role required: admin, catalog_admin

About this task
Both shopping cart and item ordering widgets are visible on the standard catalog page and any ESS catalog page. The shopping cart widget is also available in additional locations, such as the catalog homepage.
Procedure

1. Navigate to **Service Catalog > Catalog Definitions > Maintain Cart Layouts**.
   
a. Open the **Item Ordering Widget** record to modify the widget for ordering item.
   
b. Open the **Shopping Cart Widget** record to modify the widget for shopping cart.

2. You can add/remove components, buttons, rename widget title and button labels.

3. Click **Update**.

### Item ordering and shopping cart widgets

![Image of Item Ordering and Shopping Cart Widgets]

**Configure Service Catalog preview screens**

You can configure shopping cart preview screens for the one-step and two-step carts, for the wish list, and for the Classic Mobile app.

### Configure wish list screen

Using Service Catalog, customize the cart preview screen for wish list items.

### Before you begin

Role required: admin, catalog_admin
About this task

Procedure
1. Navigate to Service Catalog > Catalog Definitions > Maintain Cart Layouts.
2. Open the Cart Preview Screen (Wish List) record.
3. You can add/remove components, columns, buttons, and rename labels. See Configure cart layout.
4. Click Update.

Cart preview screen for wish list items

<table>
<thead>
<tr>
<th>Item</th>
<th>Price (as)</th>
<th>Quantity</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>$199.00</td>
<td>1</td>
<td>$199.00</td>
</tr>
<tr>
<td>View</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Google Nexus 7</td>
<td>$1,399.00</td>
<td>&lt;200/month</td>
<td>$1,399.00</td>
</tr>
<tr>
<td>Delete</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard Laptop</td>
<td>$1,399.00</td>
<td>&lt;200/month</td>
<td>$1,399.00</td>
</tr>
<tr>
<td>Continue Shopping</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Configure Classic Mobile shopping cart screen

Using Service Catalog, customize the shopping cart screen that is displayed on mobile devices.

Before you begin
Role required: admin, catalog_admin

About this task
The shopping cart on Classic Mobile devices always uses a two-step checkout process. You cannot modify widget macros or button labels on Classic Mobile devices.

Procedure
1. Navigate to Service Catalog > Catalog Definitions > Maintain Cart Layouts.
2. Open the Cart Preview Screen (Classic Mobile) record.
3. You can add/remove components and buttons.
4. Click Update.

Configure one-step shopping cart screen
Using Service Catalog, customize the shopping cart display screen for a one-step checkout process.

Before you begin
Role required: admin, catalog_admin

About this task
One-step checkout is the default checkout process for catalog items.

Procedure
1. Navigate to Service Catalog > Catalog Definitions > Maintain Cart Layouts.
2. Open the Cart Preview Screen record.
3. You can add/remove components, columns, buttons, and rename title and button labels. See Configure cart layout.
Configure two-step shopping cart screen

Using Service Catalog, customize the shopping cart display screen for a two-step checkout process.

Before you begin
Role required: admin, catalog_admin

About this task
Changes made to the two-step record are visible only if the two-step checkout process is enabled in properties. By default, catalog items use a one-step checkout process.

Procedure
1. Navigate to Service Catalog > Catalog Definitions > Maintain Cart Layouts.
2. Open the Cart Preview Screen (Two Step) record.
3. You can add/remove components, columns, buttons, and rename title and button labels. See Configure cart layout.

   In the Components tab, both Shipping Location and Shipping Address are not supported simultaneously. Deselect the selected component to select the other component.

   If you enable Shipping Address in the Components tab, the editable Shipping address field is displayed in the cart preview screen. If you enable Shipping Location in the Components tab, the editable Shipping location field and a read-only Shipping address field are displayed in the cart preview screen.

4. Click Update.
Configure Service Catalog status screens
You can configure shopping cart status screens for desktop and Classic Mobile orders.
Configure desktop order status screen

Using Service Catalog, customize the order status screen that is displayed on desktops.

Before you begin
Role required: admin, catalog_admin

Procedure
1. Navigate to Service Catalog > Catalog Definitions > Maintain Cart Layouts.
2. Open the Order Status Screen record.
3. You can add/remove components, columns, buttons, and rename labels. See Configure cart layout.
4. Click Update.

Configure Classic Mobile order status screen

Using Service Catalog, customize the order status screen that is displayed on Classic Mobile devices.

Before you begin
Role required: admin, catalog_admin
About this task
You cannot modify widget macros or button labels on Classic Mobile devices.

Procedure
1. Navigate to Service Catalog > Catalog Definitions > Maintain Cart Layouts.
2. Open the Order Status Screen (Classic Mobile) record.
3. You can add/remove components and buttons.
4. Click Update.

Migrating to cart layouts
Service catalog enables you to configure cart layouts to add, remove, or change elements of the service catalog shopping cart. Before you migrate your system to use cart layouts, familiarize yourself with existing configurations for catalog content and decide whether to discard or retain these configurations.

This feature is enabled by default in new instances and the default cart layout settings are implemented. For upgrades, an upgrade script checks to see if your current cart macros are customized. Only a user with an admin role can migrate cart layouts.
• If cart macros are not customized, cart layout configuration is enabled by default.

• If cart macros are customized, cart layout configuration is disabled. Migrate your system to use this feature.

Cart configuration settings
Check your current configurations for:

• UI macros defining custom shopping carts that have been linked to items.
• Service catalog properties impacted by cart layouts.
• Item-specific settings that can override cart layout record settings.

Item-specific settings
Some catalog items can have cart layout settings that are specific to them. For example, these items can show prices even though the general cart layout record settings hide prices.

To retain item-specific settings, clear the Use cart layout check box in the catalog item form.

Note: You can configure the form to display the Use cart layout check box.

Migrate customizations and enable cart layouts
Move customization to cart layout widgets, and then enable cart layouts.
About this task
When you customize a few UI macros, you should migrate the customizations to cart layout widgets before you enable cart layouts. Following are the UI macros whose customizations need migration before you enable cart layouts:

- `sc_catalog_homepage_cart`
- `sc_catalog_requested_for`
- `catalog_item`
- `catalog_cart_default`
- `sc_cart_main`

In addition, if you have customized the `com.glideapp.servicecatalog_category_view` UI page, or the Catalog Cart dynamic content, you must migrate these customizations before you enable cart layouts.

Procedure
1. Save copies of the customizations for later reference.
2. Revert the customizations to restore the customized macros or other content to their standard state.
4. Run the following script in Background Scripts to set the property and set the correct state for all the items in the catalog:

```javascript
var cm = new CartLayoutMigration();
    cm.configureLayoutProperty();
    cm.setLayoutFalse();
    cm.setEmptyLayout();
```

5. Reimplement any cart layout customizations that you want to maintain in the upgraded instance by configuring widget macros.
6. To enable cart layouts, set the service catalog system property `glide.sc.use_cart_layouts` to **Yes**.

Legacy flexible checkout and delivery forms
ServiceNow includes several options that provide administrators some control over content in service catalog template-driven forms.
Some service catalog forms, such as the checkout form, are generated from templates, instead of being data-driven like other forms in the system, such as the Incident form.

Template-driven forms provide enhanced look-and-feel over standard data-driven forms, but they provide more limited control over the form content.

**Note:**

It is recommended that you use cart layout records to configure cart layouts. Using cart layout records lets you configure the service catalog cart without writing and maintaining scripts.

**Modifications in the delivery screen**

In the final checkout step, a summary screen provides a list of all items and services ordered.

**Warning:** Modifying the Order Status or Summary screen requires advanced scripting and a knowledge of Jelly. Also, the upgrade process skips updates to the summary screen after a customization. With these constraints in mind, you can modify the summary screen by editing the `com.glideapp.servicecatalog_checkout_view` UI page.
Requester search results

After you enable the two-step checkout process, the Requested for field appears on the Request form.

The Requested for field references the User [sys_user] table and has an auto-complete feature. Two service catalog properties (Service Catalog > Catalog Administration > Properties) enable an administrator to add columns to the search results for this field and to order the list by one of the columns.

### Service catalog properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional columns for the &quot;request for&quot; Service Catalog widget. (glide.sc.request_for.columns)</td>
<td>Choose fields from the User [sys_user] table. Must be semicolon separated.</td>
</tr>
<tr>
<td>Ordering of matches for the &quot;request for&quot; Service Catalog widget. (glide.sc.request_for.order_by)</td>
<td>Choose fields from the User [sys_user] table.</td>
</tr>
</tbody>
</table>

Modifications in the checkout form

You can modify the checkout form to use an alternate description field or to add request item number for each line.

By default, the checkout forms list the Description, Delivery Date, Stage, Price, Quantity, and Total columns. An example of default checkout form is shown:
Add the request item number on checkout form

Add the request item number to display this number as an extra column on the checkout form. By default, the request item number is not displayed in the list.

Procedure

1. Navigate to Service Catalog > Catalog Administration > Properties.
2. Locate the property: Show the request item number for each line item on the checkout screen (default false).
3. Select the Yes check box to add the number column to the checkout form.

Checkout number

Use an alternate description field on checkout form

Use an alternate description field to describe your category item in the checkout form. By default, the short_description column of the catalog item appears as the item description.

Procedure

1. Navigate to Service Catalog > Catalog Policy > Properties.
2. Locate the property Field name to use for the description column of the checkout form. If blank, the default (short_description) is used.
3. Enter the name of the alternative field (a column in the Catalog Item [sc_cat_item] table) and save it. For example, if you selected name:

**Checkout name**

<table>
<thead>
<tr>
<th>Description</th>
<th>Delivery Date</th>
<th>Stage</th>
<th>Price (ex)</th>
<th>Qty</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blackberry</td>
<td>2007-04-08</td>
<td></td>
<td>$500.00</td>
<td>1</td>
<td>$500.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Total: $500.00</td>
</tr>
</tbody>
</table>

**Delivery Information**

Estimated Delivery Date of Complete Order: 2007-04-08

**Define item quantity choices**

In the Service Catalog, the default quantity choices are 1–10. You can configure the quantity selector with additional choices. This configuration is also applicable in Service Portal.

**About this task**

**Procedure**

1. Navigate to **System Definition > Choice Lists**.
2. Search for the table **sc_cart_item** and the element **quantity**. The existing quantity choices appear.
3. Add quantity choices, modeling them after the existing ones.
To reduce the quantities available for catalog items, delete the relevant quantity records. For example, to reduce the quantity range to 1-3, delete the records for 4 and 5.

To restrict the roles allowed to change quantities, edit the list of roles (comma-separated) that can use the quantity selector in the shopping cart (glide.sc.allow.quantity) service catalog property. For example, you can limit this ability to the admin and catalog_admin roles.

Related information
Service Catalog administration

Remove item restrictions

Service Catalog enables you to remove or apply restrictions on all order guides, record producers, and wizard launchers.

About this task
Catalog administrators can use Service Catalog properties to configure the behavior and usage of a catalog item.

By default, all order guides, record producers, and wizard launchers have these restrictions:

- They cannot be added to a requested item
- They do not provide a Try It action
- They are not added to the cart as items

To remove these restrictions or apply these restrictions to other types of items:

Procedure

Modify the comma-separated lists of tables in the following properties:
• List of class names for catalog items that cannot be added to an existing request (glide.sc.item.cannot_add_to_request): restricts the items that can be added to a requested item, after an end user places a request. For example, to restrict content items from being added to an existing request, add sc_cat_item_content to the list for this property.

• List of class names for catalog items that do not use the default "Try It" UI Action (glide.sc.item.cannot_try_it): restricts the items which allow you to click Try It on the item form to preview how it appears in the service catalog. Items with such restrictions do not display Try It on the form.

• List of class names for catalog items that do not generate a normal cart item (glide.sc.item.not_normal_cart_item): restricts which item types are added to the cart by default.

Using variables for price setup
You can define a price for every service catalog item. The price or recurring price of a catalog item can be modified with variables, increasing the base price for that item.

This pricing is useful if you want the price or recurring price dynamically calculated based on how a user completes the ordering form. For example, the cost of an item can be increased based on options the user selects, such as extra memory in a PC.

The following variable types can be configured to modify the total cost of an item:

• Check box
• Multiple choice
• Reference
• List collector
• Select box
• Lookup select box

Check box
A check box variable helps to set the price or recurring price of the item being ordered.

You can Create a check box variable and set the price of the item. Use the Price if checked or Recurring price if checked field to specify the price or recurring price difference for that variable when the option is selected.
Under the **Type Specifications** tab, you can specify the price in different currency types. Also, you can configure the price in the following pricing models:

- Calculated
- Fixed
- Multiple

For information on the pricing models, see **Price fields**.

**Multiple choice**

For a multiple choice variable, there are two options for pricing.

- Specify the price difference in the **Price** field on the question choices.
- Specify the recurring price difference in the **Recurring Price** field on the question choices.

ℹ️ **Note:** Select boxes operate the same as multiple choice variables but are displayed as select boxes.

**Reference**

A reference variable includes a **Pricing implications** field.

If this field is selected and there is a **price**, **u_price**, **recurring_price**, or **u_recurring_price** field on the referenced table, the value of that field is used to modify the cost of the item being ordered when a reference value is selected.

For example, suppose that computers in Phoenix cost $100 more than the ordering price, and computers in Boise cost $100 less than the ordering price.

1. Set up a reference variable to the Location [cmn_location] table.
2. Put a **u_price** field on the Location table.
3. Set that field to 100 for the Phoenix location.
4. Set that field to -100 for the Boise location.

When ordering a computer, if **Phoenix** is selected as the location for this variable, the ordering price is increased by $100. If **Boise** is selected, the ordering price is decreased by $100.
Note: List collectors operate the same as a reference variable, but use the **List table** field to specify the table being referenced. Since it is a list collector variable, multiple selections can be made that all modify the ordering price or recurring price.

**Lookup select box**

A lookup select box variable is more powerful than a reference variable.

Specify the following when creating a lookup select box variable:

- **Lookup from table**: the table from which values are queried.
- **Lookup value field**: the field on the lookup table whose value is used as the value of the variable (typically sys_id).
- **Lookup label field(s)**: a comma-separated list of fields on the lookup table whose values are used to display the selections in the select box. For example, `manufacturer,name` for the Software [cmdb_ci_spkg] table would display selections as:
  - Microsoft | Excel
  - Adobe | Photoshop Elements
- **Lookup price field**: the field whose value is used to modify the price of the item being ordered.
- **Lookup recurring price field**: the field whose value is used to modify the recurring price of the item being ordered.

**Set a recurring price**

A catalog item can have a recurring price in addition to an initial price.

**About this task**

For example, a subscription to a mobile phone contract could cost $500.00, with a $30.00 monthly recurring price.

The price and the recurring frequency are set on the catalog item record. After the price and frequency are set, the recurring price appears in the catalog, catalog search results, catalog page for the item, shopping cart, and order summary screen.
If multiple items with the same recurring price frequency are placed in the shopping cart, they are grouped. The grouping makes it easier to view how much items cost for each frequency (for example, weekly, monthly, and annually). If the shopping cart contains items with and without recurring costs, they are grouped separately.

If multiple items with the same recurring price frequency are placed in the shopping cart, they are grouped. The grouping makes it easier to view how much items cost for each frequency (for example, weekly, monthly, and annually). If the shopping cart contains items with and without recurring costs, they are grouped separately.
On a request record, recurring prices are grouped by frequency and shown in the **Recurring Prices** related list. In the example below, two items each have a monthly recurring cost of $100.00 and their prices are grouped as a single record of $200.00 monthly. Another item with an annual recurring cost of $500.00 is listed as a separate record.

If a request record contains multiple items with the same recurring frequency, click the arrow next to the corresponding recurring prices record to view details. In the example below, two items (the mobile phone and the sales laptop) each have a monthly recurring cost. They are grouped under the **Monthly** recurring prices record, but are listed separately when the recurring prices record is expanded. Only one item has an annual recurring cost.
Extend the pricing model

The pricing model is useful if you want the price or recurring price to be dynamically calculated based on how a user completes the ordering form. You can extend the pricing model of a catalog item by editing the item price or the recurring price.

Procedure

1. From the left navigation pane, select **System Definition > Script Includes**.

2. Edit the CatalogPriceCalculator script to customize the item price and the CatalogRecurringPriceCalculator script to customize the recurring price.
**Hiding prices in the service catalog**

Administrators can configure options to hide catalog item prices in the service catalog for listings of specific items, for specific types of items, or for all items. Item prices can appear in the following locations:

- A catalog item listing in the **Order This Item** panel.
- Catalog item listings in categories and subcategories.
- The **Shopping Cart** panel.
- The Edit Cart, Order Confirmation, and Order Status pages.

**Hide prices globally**

Configure service catalog properties to hide prices globally.

To view and edit service catalog properties, navigate to **Service Catalog > Catalog Administration > Properties**.

**Hiding prices by item types**

By default, prices do not appear for order guides, record producers, and wizard launchers.

You can change which catalog item types show prices using the **List of class names for catalog items that do not show the price in listings** property (`glide.sc.item.cannot_show_price`). Provide a comma-separated list of table names for item types that you want to hide prices for.

For example, to hide prices for standard catalog items, add `sc_cat_item` to the list.

You can also remove an existing entry to display prices for that item type. For example, to display prices for order guides, remove the order guide entry `sc_cat_item_guide` from the list.

**Hiding prices for all items**

By default, zero-priced items have prices hidden in listings and carts.

You can configure this behavior to always hide or show prices, using the **When to show prices and sub-totals on the Service Catalog Cart** property (`glide.sc.price.display`).

Set this property to **Always show prices** to display prices for all items on all service catalog screens, or to **Never show prices** to hide prices for all items on all service catalog screens.
**Hide prices for specific items**
You can hide prices for specific items to match your organizational requirements.

**Procedure**
1. Navigate to Service Catalog > Catalog Definition > Maintain Items.
2. Open the relevant item definition.
3. Select the Omit Price on Cart check box.
   The price does not appear in the catalog listing or when the item is added to the cart. The price is listed as "-" on the edit cart, order confirmation, and order status screens.

**Clone requests**
Clone a request to create up to ten copies (clones) of the same Service Catalog request, for different users, without having to enter the same information multiple times. For example, you can request a new piece of equipment for several specified people, generating multiple individual requests quickly from a single initial request.

**Before you begin**
Role required: admin or catalog_admin

**Procedure**
1. Navigate to Service Catalog > Catalog Definitions > Maintain Cart Layouts
2. Under the Target type: Browser Screen section, select Order Status Screen.
3. In the Components tab, select the Clone Checkout check box.
4. Navigate to Service Catalog > Catalog Administration > Properties.
5. In the Cart category, perform the following:
   • Enable the Enable cloning requests during checkout property.
   • For the List of roles (comma-separated) that can use bulk ordering functionality property, enter the roles for which you want to enable bulk request capability for all users with these roles, or leave the field blank to enable the capability for all users.
6. Click Save.
Related information

- Clone a request
- Request a catalog item from Service Portal
- Request an order guide from Service Portal
- Delegated request experience

Create scripts

Service Catalog enables you to use certain scripts.

Some functions are available, specifically for Service Catalog:

- Client-side scripting allows catalog designers to use the same functionality available on other forms.
- The Service Catalog Script API makes catalog ordering easier from inside business rules.
- Scriptable Assignment of Execution Plans allows selection of an execution plan at the time of ordering, based on scripted conditions.

Create a custom cart

Administrators with a knowledge of Jelly can customize the look and feel of service catalog carts, either globally or for specific catalog items, using the UI macro capability.

Before you begin
Role required: admin

About this task

Note: You can configure cart layouts without scripting.

Procedure

1. Navigate to System UI > UI Macros.
2. Click New to create a new macro.
3. Fill in the details and write the script to define your custom cart.

Note: Designing a custom cart requires knowledge of the Jelly expression language. For reference purposes, the default cart script appears in the list as catalog_cart_default.

4. Click Submit.
What to do next
After creating a custom card, you can reuse it and link it to catalog items.

Link a cart to an item
Link the default cart or a custom cart to an item so the requester sees the pertinent information.

Before you begin
Role required: catalog_admin or admin

Procedure
1. Navigate to Service Catalog > Catalog Items.
2. Open an item to test the new cart.
3. In the Cart field, select the cart to use.
   You can configure the form layout to add this field to the form.
4. Save the changed form.

Example:
In the example below, the HP bl35p uses the irm_technical_cart.

![Catalog Item Form](image)

This cart appears as follows:
Service catalog home page configuration

The home page for a service catalog provides the primary front end for ordering items within that catalog. You can configure various elements of the pages within the Service Catalog.

Administrators and catalog administrators can design a home page in any of the following ways.

- Customizing the catalog home page.
- Adding, removing, and arranging categories.
- Enabling content types.
- Using catalog properties to provide additional control over behavior and appearance.
- Using renderers to define the appearance of categories.

⚠️ Note: End users can access the catalog through the customizable user home page, or with content management pages that use content blocks for categories.

Configure search and navigation

You can use service catalog properties to configure search and navigation within the service catalog homepage.

Navigate to Service Catalog > Catalog Administration > Properties to view service catalog properties.
**Restrict search access**

Each catalog homepage provides a search bar to help locate items not displayed on the homepage. By default, any user who can access the catalog homepage can search using this search bar.

To restrict access to this search function by role, use the **List of roles (comma-separated) that can search the service catalog** property (glide.sc.can_search).

For example, to only allow logged-in users to access search, set this field to blank. To remove the search function for all users, set this field to **None**.

⚠️ **Note:** Search results only show items that the logged-in user can access.

**Hide search results from inactive categories**

By default, search results are returned from all categories, including inactive categories.

To avoid returning results from inactive categories, set the **Service catalog searches return items in inactive categories** property (glide.sc.search.disabled_cats) to **No**. For example, when designing a new category, you can avoid users seeing search results from this category until you are ready to make it active.

⚠️ **Note:** Security constraints can also make a category or catalog item inaccessible.

**Restrict search by item type**

By default, a search field does not appear when viewing order guides, record producers, and wizard launchers.

To define which catalog item types do not show the search field, list these types in the **List of class names for catalog items that do not have the search field displayed** (glide.sc.item.cannot_show_search) property.

For example, to enable searching when viewing record producers, remove **sc_cat_item_producer** from this list.
Enable breadcrumb links

By default, breadcrumbs appear without links when using content management pages as service catalog homepages.

To display these breadcrumbs with links, set the Use links for breadcrumbs rendered in Service Catalog pages accessed via a CMS site property (glide.sc.use_breadcrumb_links.cms) to Yes. This setting provides greater navigational control for end users.

Disable search suggestions

By default, service catalog searches display "Did you mean?" suggestions if a search does not return any results and an alternate spelling or similar recent search does.
To disable these suggestions, set the **Specify whether search suggestions should be enabled** property (`glide.sc.search.suggestions`) to **No**.

**Refine search results**

Use properties to refine search results in Service Catalog.

**About this task**

The auto-completion feature returns values that contain an exact match to the letter combination entered.

Administrators can use the **Additional columns for the "request for" Service Catalog widget** (`glide.sc.request_for.columns`) property to add columns to this list, to further refine the search results, and help determine which user to select when two users have the same name.

In this example, the property is set to display two additional columns, **Department** and **Title**.
Administrators can use the **Ordering of matches for the "request for" Service Catalog widget**. *(glide.sc.request_for.order_by)* property to configure the columns to sort by one of the values. In this example, the is set to sort the results list by **department**.
Catalog auto complete results by department

This results list is ordered by department.

Auto-completion also applies to the Request for field, which can be added to the service catalog homepage.

**Procedure**

1. Navigate to Service Catalog > Catalog.
2. Click Add Categories.
3. Select Request for.
4. Place the category on the page.

**Add requested for catalog section**

Configure keyword search for catalog items

When you search for a catalog item by a keyword in Service Catalog, the search results are displayed by considering a few fields of the catalog table. If the keyword does not have exact matches, its closest matches are displayed as *Did you mean* suggestions. This search functionality is also applicable in Service Portal.

**Before you begin**

Role required: admin

**About this task**

When you search for a catalog item by a keyword in Service Catalog, the search results are displayed by considering a few fields of the catalog table. If the keyword does not have exact matches, its closest matches are displayed as *Did you mean* suggestions. This search functionality is also applicable in Service Portal.

The search results are sorted in the following order based on the frequency of the keyword:
• Catalog items whose **Name** field contains the keyword (top).
• Catalog items whose **Meta** field contains the keyword.
• Catalog items whose **Description** or **Short description** field contains the keyword.
• Categories whose **Name** or **Description** field contains the keyword.
• Catalogs whose **Name** or **Description** field contains the key term, or the catalog items whose **Class** field contains the keyword (bottom).

⚠️ **Note:**
• If your organization has multiple service catalogs, a search returns results only from the catalog being viewed.
• Search results return an item only when the item is active, has a valid catalog and category association, and you are authorized to view the item.

**Procedure**

1. Complete the following steps to regenerate a text index for the `sys_metadata` table.
   a. Navigate to **System Definition > Text Indexes**.
   b. Open the text index for the Application File `[sys_metadata]` table.
   c. Click the **Regenerate Text Index** related link and click **OK**. The system schedules the table for the text indexing.

2. Complete the following steps to enable the **Did you mean** suggestions.
   a. Navigate to **System Properties > Text Search**.
   b. Under the **Did You Mean Properties** section, enable the **Suggest alternate search spellings for knowledge, catalog or global search** property.

**Related information**

- Search administration
- Service Catalog for managers and end users
- Regenerate a text index for a table
- Configure a "Did You Mean?" suggestion
- Create or edit a catalog item
- Create a record producer
Create an order guide
Define a content item

Configure AI-based catalog search experience

Improve employee engagement with an AI-based catalog search experience in Service Portal and Now Mobile. Intelligent query features enable users to quickly and easily find the answers they need.

Before you begin
Role required: admin

About this task

You can configure AI-based catalog search experience in portals and Now Mobile. Following are the default search application configurations for Service Portal and Now Mobile:

- **Service Portal Default Search Application.** For information about AI Search in Service Portal, see [AI Search in Service Portal](#).
- **NowMobile App Search Configurations.** For information about AI Search in Now Mobile, see [AI Search in mobile](#).

Each of these search application configurations have an associated search profile based on which the search results are filtered and displayed.

**Note:** If the AI Search is enabled for Now Mobile, the **Experience for items not available in NOW Mobile** (`glide.sc.mobile.unsupported_discover`) property is not applicable. For information on Now Mobile properties, see [Service Catalog properties](#).

Following are a few limitations for AI-based catalog search experience:

- The facets in Service Portal always show the primary category of the catalog item (even if the user does not have access to the primary category and the accessible path to the item is via another category that the item is associated with).

- If the user does not have read permissions for the category record and its fields, the search results cards in Now Mobile do not show the category of the item.

Procedure

1. Navigate to **AI Search > Search Experience > Search Applications**.

2. To edit the searchable catalogs in a portal or Now Mobile, perform the following steps.
Note: Items are searched for only in the catalogs configured in the search source, irrespective of the catalogs associated with the portal. For information on associating a catalog with a portal, see Configure a catalog in Service Portal.

a. In the Search Application Configurations list, select the search application configuration associated with the portal. For example, Service Portal Default Search Application for Service Portal.

b. On the Search Application Configuration form, open the search profile. For example, Service Portal Default Search Profile specified for Service Portal.

Note: To avoid conflicts with future upgrades, it is recommended that you create a search profile instead of using the search profile available in the base system.

c. From the Search Sources related list, select a search source. For example, Service Portal Catalogs.

d. In the Conditions field, add catalogs where you want the items to be searched for.
e. Click Update.

**Related information**

**AI Search**

**Configure preview**

Configure the number of items that have the Preview section expanded to display item details. You can also change the default number (5) of items and categories that display, and hide the Exists in categories information.

**About this task**

By default, if not showing item details using pop-ups, the first two items listed in the category display have the Preview section expanded to display item details.

To change the number of items with this information expanded, set the Number of Catalog Items to expand in browsing and search when not using pop-up icons to view details (glide.sc.auto_expand) property to the number required.

| Expanding to 2 items | Expanding to 1 item |
Set number of items and categories to preview

By default, up to five items or categories appear in each category on the homepage.

About this task

To change this number, set the **Number of Catalog Items/Categories to preview in a section** (glide.sc.max_items) property to the required value.

Hide the existing categories in the categories display

By default, catalog items that are in several categories show **Exists in categories** information that shows other categories that the items are available in. You can hide this information.

Procedure

Set the **Show the additional categories section when viewing a catalog item** (glide.sc.show_additional.cats) property to **No**.
Create a renderer

Create or modify renderers using UI macros to provide the rendering instructions. Renderers define a specific look and feel for a catalog or category.

Before you begin
Role required: catalog_admin or admin

About this task
Use renderers to specify the following formats:

- How categories appear on a catalog homepage.

For example, you can create a renderer showing the category homepage image, the description, and the first two catalog items in a category.

Procedure
1. [Optional] Create a UI macro to define specific rendering instructions.
2. Navigate to Service Catalog > Catalog Definition > Renderers.
3. Click New.
4. Select to create a catalog or category renderer.
5. Enter the renderer details.

Renderer Details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name for the renderer.</td>
</tr>
<tr>
<td>Macro</td>
<td>The UI Macro to use.</td>
</tr>
<tr>
<td>Render catalog title</td>
<td>Appears for catalogs renderers. A check box to display the catalog title bar on the multi-catalog homepage.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Render title</td>
<td>Appears for category renderers. A check box to display the category title bar on the catalog homepage.</td>
</tr>
</tbody>
</table>

ℹ️ **Note:** The **admin** and **catalog_admin** roles can view the **Render title** even when the check box is not selected.

#### Service Catalog Renderers

- **Name**: All Details
- **Macro**: sc_catalog_homepage_ce
- **Render catalog title**: OFF

#### 6. Click **Submit**.

ℹ️ **Note:** To modify a default catalog or category renderer, follow a similar process, by selecting one of the default renderers listed.

This new renderer is added to the list of available choices when applying a renderer.

## Select a renderer for a catalog

Select a renderer and apply them to a catalog to change its appearance.

### Before you begin

**Role required:** catalog_admin or admin

### About this task

The following default catalog renderer schemes are available:

- **All Details**: shows desktop image, title, and categories.
- **Image Only**: shows desktop image only.
- **Title and Image**: shows title and desktop image.
- **Title Only**: shows title only.
Procedure

1. Navigate to **Service Catalog > Catalogs**.
2. Click the add content icon (+) on the upper right.
3. Select a catalog in the middle panel of the pop-up window.

   ![Service Catalog home page layout](image)

4. Select a renderer from the list displayed in the right-hand panel, for example **Title Only**.
5. Click **Close** to save the catalog with the renderer settings you defined.

**Select a renderer for a category**

Select a renderer scheme for your categories.

**Before you begin**

Role required: catalog_admin or admin
About this task
The following default category renderer schemes are available:

• **Category Items**: shows desktop image, title, and description.
• **Category Items No Title**: shows desktop image and description.
• **Category Details**: shows the subcategories and items in that category.

**Procedure**
1. Navigate to **Service Catalog > Catalog**.
2. Click the add content icon (+) on the upper right.
3. Select a category in the middle panel of the pop-up window.
4. Select a renderer from the list displayed in the right-hand panel, for example **Category Items**.
5. Click the close icon (x) to save the catalog with the selected renderer.

**Customize a catalog homepage**
Customize a catalog homepage to provide end users with access to catalogs from one homepage.

**Procedure**
1. Navigate to **Service Catalog > Catalog**.
2. Click the add content icon (+) at the top of the page to add a category.
3. Select a category in the middle panel of the pop-up window that appears.
4. Click **Add here** in the location where the category appears on the homepage.

5. **Optional:** Repeat steps 3–4 to add more categories.

6. Close the pop-up window.

7. **Optional:** To change a category location, drag it to the appropriate place.

8. **Optional:** To remove a category, click the (X) icon on the top right of the category header.

9. **Optional:** Add a shopping cart on the page.

Display subcategories in a panel

By default, subcategories are displayed in a panel at the bottom of the category page. You can change a system property to list subcategories at the top.

Before you begin
Role required: admin
**Procedure**

Use the **In category view display subcategories in a panel** property (*glide.sc.use_sub_cat_section*).

<table>
<thead>
<tr>
<th>Name of form</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>When set to <strong>Yes</strong>, the subcategories appear in a panel at the bottom.</td>
<td>When set to <strong>No</strong>, the subcategories appear as a list at the top.</td>
</tr>
</tbody>
</table>

**Set to Yes**

![Office](image)

- **Packaging and Shipping**
  - Package and Ship inter-office or to external addresses
- **Paper and Supplies**
  - Order office supplies such as paper, stationery and computer supplies
- **Videoconferencing**
  - Setup inter-office or external videoconferencing

**Set to No**

![Office](image)

- **Packaging and Shipping**
  - Package and Ship inter-office or to external addresses
- **Paper and Supplies**
  - Order office supplies such as paper, stationery and computer supplies
- **Videoconferencing**
  - Setup inter-office or external videoconferencing

**Customize the multi-catalog homepage**

Customize the multi-catalog homepage to provide end users with access to multiple catalogs from one homepage.

**About this task**

This task is similar to customizing the homepage for an individual catalog. In this task, you are adding catalogs, not catalog categories.

**Procedure**

1. Navigate to **Service Catalog > Catalogs**.
2. Select **Add Catalogs** at the top of the page to add catalogs to this page.
3. Select a catalog in the middle panel of the pop-up window.
Multi-catalog home page arrangement

Note: Only administrators can see catalogs that do not contain active categories or items.

4. [Optional] Select a renderer from the right-hand panel, for example Title Only.
5. Click Add here in the location where the catalog appears on the homepage.
6. [Optional] Repeat steps 3–5 to add more catalogs.
7. Close the pop-up window to save the changes.

You can modify the arrangement of catalogs within the homepage:
To change a catalog location, drag it to the appropriate place.

To remove a catalog, click the X in the catalog title bar.

To edit details for a catalog, click the pencil icon in the catalog title bar. The catalogs appear on the homepage.

Show item details in sections or pop-ups

By default, a service catalog category displays the first two items with the preview section expanded to show item details. You can change the number of items that are previewed, or change the preview to appear in a pop-up window.

Before you begin

Role required: admin

Procedure

1. Navigate to Service Catalog > Catalog Administration > Properties.

2. To change the number of items previewed, set the Number of Catalog Items to expand in browsing and search when not using pop-up icons to view details (glide.sc.auto_expand) property to the desired number.

Example

<table>
<thead>
<tr>
<th>Expanded to 2 items</th>
<th>Expanded to 1 item</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 items</td>
<td>1 item</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
3. To use the preview icon, set the **When browsing a category use the pop-up icon to show item details** (`glide.sc.cat_view_use_popup_for_details`) property to **Yes**.

When set to **No**, the item details appear when you click **Preview**. When set to **Yes**, the item details appear as a pop-up when the cursor hovers over the item icon.

### Configure Classic Mobile devices

When you configure Service Catalog on a Classic Mobile device, you can define the layout and presentation of catalogs. You can then perform actions such as ordering products and services, submit incidents and problems using record producers.

**About this task**

Users can access the service catalog on Classic Mobile devices to:

- View and order products and services.
- Submit incidents and problems using record producers.

**Note:** Users cannot access order guides, wizards, or content items from Classic Mobile devices.

Administrators and catalog administrators can configure the layout, presentation, and other aspects of the service catalog for Classic Mobile devices.

Including:
• Defining rendering options for Classic Mobile categories.
• Defining rendering options for Classic Mobile catalog items.

Accessing the Service Catalog on Mobile Devices
To access the service catalog, navigate to **Self-Service > Catalog**.

Catalog items are grouped into categories, which can also contain one or more subcategories.
You can browse and select an item. To browse for an item within a category, tap the category filter to select the category or subcategory.
Sample service catalog category

To request an item:
Procedure

1. Select an item.

2. Tap any field with an arrow (>) to add information, such as the name or location of the requestor, the need-by date, or item quantity.

3. Tap Add to Cart to add the item to your cart. The order screen appears.
4. Tap **Edit** to edit your order, if required.

5. To order the item as specified, tap **Order**, then tap **OK** when prompted to confirm ordering. A confirmation message appears.
6. Tap the item to see further details.
7. Tap the back arrow to return to the confirmation message.

8. Tap **Continue Browsing** to return to the service catalog.

   After the request is submitted, ServiceNow follows request fulfillment processes to fulfill the ordered item.

**Define the mobile layout**

You can configure the Classic Mobile layout for categories within a service catalog.

**Before you begin**

Role required: admin

**About this task**

By default, service catalog categories appear on mobile devices in the same order as on desktop devices.
Procedure

1. Navigate to Service Catalog > Classic Mobile Admin > Classic Mobile Layout to display a list of service catalogs.

2. Click the lookup icon for the service catalog you want to configure. The mobile layout displays details for the catalog.

3. Click Edit to select which categories appear on mobile devices, and in which order.

4. Add, remove, or reorder the selected mobile categories, and then click Save.

Note: To return the display to the default desktop layout settings for the portal page associated with that catalog, click the Replace categories with desktop layout related link.

Limit description sizes in the Classic Mobile UI

By default, item descriptions in the smartphone interface are truncated to a maximum of two lines.
Procedure

1. Navigate to Service Catalog > Catalog Administration > Properties.

2. Set the Limit descriptions in category and item listings to two rows in the Mobile UI property (glide.sc.mobile.limit.description) to No.

<table>
<thead>
<tr>
<th>If set to Yes</th>
<th>If set to No</th>
</tr>
</thead>
<tbody>
<tr>
<td>descriptions are limited to two lines</td>
<td>the full descriptions are given</td>
</tr>
</tbody>
</table>

Using the content management system with the service catalog

Use the content management system (CMS) to create a custom interface for the service catalog.

You must request the Content Management System (CMS) application from ServiceNow personnel. Instead of activating CMS, use Service Portal for new development. Service Portal is an alternative to CMS with a refined user experience, and is active by default in the base system. See Service Portal and Content Management and Service Portal.

Manage catalogs in CMS sites

When your organization uses the content management system (CMS) as well as Service Catalog, you can select which catalogs are supported within the CMS sites.
Before you begin
Role required: catalog_admin or admin

About this task
Associating catalogs with sites ensures that users can always access an appropriate catalog.

Procedure
1. Navigate to Service Catalog > Catalog Definitions > Maintain Catalogs and open the catalog to associate with a site.
2. In the Sites related list, click Edit, select the site to associate with the catalog, and then click Save.
3. Click the reference icon beside the site name, and then click Open Record.

Service catalog details - catalog sites details

4. Enter values in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMS homepage</td>
<td>The homepage for this site.</td>
</tr>
<tr>
<td>CMS search page</td>
<td>The location of the search page for the site.</td>
</tr>
<tr>
<td>CMS 'Continue Shopping' page</td>
<td>The location to direct end users to when they click the Continue Shopping button in that CMS site. This field is designed to reference a content page URL suffix.</td>
</tr>
</tbody>
</table>

5. Click Update.
Set up catalog portal pages

The Catalog Portal Page [sc_catalog_view_mtom] table links catalogs to CMS portal pages and defines the default catalog to portal page combination used by URLs.

For example, the default portal page for the service catalog is the catalog_default page.

Catalog portal page records appear in the Catalog Portal Pages related list on the Catalog form. The Catalog Portal Page table generates two values in a URL: sysparm_catalog_view and sysparam_catalog. Use the Catalog Portal Page form to enter a custom link, if required.

Resolve missing catalog portal pages

If a catalog record is not associated to a catalog portal page record, ServiceNow attempts to present a view based on a set prefix of: catalog_<catalog name>.

For example, if the default service catalog has no catalog portal page record, the system sets sysparm_view to catalog_Service_Catalog. With this setting, when you navigate to Self-Service > Service Catalog, you view a new and apparently blank catalog_Service_Catalog portal page, instead of the existing and populated catalog_default portal page.

To correct, go to the Sites related list on the Catalog form and add a new catalog portal page record manually.

For example, for the default service catalog, add a record with the following values:

- **Catalog**: Service Catalog
- **Portal Page**: Catalog (catalog_default)
- **Default**: true

Manage catalog portal pages

Using Service Catalog, you can create and manage multiple portal pages for a catalog.

About this task

A catalog portal page provides a homepage for a specific catalog. You can use portal pages to create different catalog views for different user groups. Each portal page accesses the same catalog content and presents that content in different ways.
Catalog portal page details include the owner, title, and view to use for that page.

**Procedure**

1. The Catalog Portal Pages related list shows portal pages available for that catalog. Each catalog has a default page, created automatically when the catalog is created.
2. Select an appropriate action:
   - Click **New** to create a new portal page.
   - Click **Edit** to select another portal page for the catalog.
   - Select a portal page to view and edit details for that page.

**Define filters for My Requests**

Define request filters to filter incidents, requests, or tasks under the **Self-Service > My Requests** module in Now Platform, the **My Requests** widget in Service Portal, and the My Requests applet in the Now® Mobile app.

**Before you begin**

Role required: catalog_admin or admin

Since the My Request Filter [request_filter] table has been reparented to the Filter [sys_filter] table, a few fields from the My Request Filter table have been migrated to fields in the Filter table. The **Short Description** field from the My Request Filter table has been migrated to the **Title** field in the Filter table. The **Table Name** field from the My Request Filter table has been migrated to the **Table** field in the Filter table.

**Note:** If the My Request Filter form is modified, the form still displays the **Short Description** and **Table Name** fields that are no longer valid. Delete these invalid fields from the form and add the **Title** and **Table** fields to the form.

**Procedure**

1. Navigate to **Service Catalog > Catalog Administration > My Request Filter**.
2. On the form, fill the fields.

**My Request Filter form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the filter.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Table</td>
<td>Table on which the filter condition is applied.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the filter.</td>
</tr>
<tr>
<td>Active</td>
<td>If set to true, the filter is active.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Interface for which the filter is applicable. Possible values:</td>
</tr>
<tr>
<td></td>
<td>• Desktop</td>
</tr>
<tr>
<td></td>
<td>• Service Portal</td>
</tr>
<tr>
<td></td>
<td>• Desktop/Service Portal</td>
</tr>
<tr>
<td></td>
<td>• Mobile</td>
</tr>
<tr>
<td>Filter</td>
<td>Conditions to filter requests.</td>
</tr>
<tr>
<td>Portal Settings</td>
<td>This section is displayed when the <strong>Applies to</strong> field is set to <strong>Service Portal</strong> or <strong>All</strong>.</td>
</tr>
<tr>
<td>Portal page</td>
<td>Portal page that opens when you click the request.</td>
</tr>
<tr>
<td>Primary field to display</td>
<td>Primary information displayed for the request.</td>
</tr>
<tr>
<td>Secondary fields to display</td>
<td>Secondary information displayed for the request.</td>
</tr>
</tbody>
</table>

**Note:**
- Add a maximum of three secondary fields.
- Do not add an image field.
- If the Request [sc_request] table is selected, secondary field is not configured. If the request contains only one item, the Requested Item name is displayed. Else, it contains the requested item count.

3. Click **Submit**.

**Related information**
- **My Requests widget**
- **Activate the page route map for the standard ticket page**
Catalog Builder

You can create or edit a catalog item (catalog item or record producer) using a visual and guided experience along with specified restrictions. The catalog builder experience enables you to delegate the creation and maintenance of the catalog.

You can also create a template that can be used to create catalog items. While creating the template, you can specify values or restrictions for items created using the template, for example, restrictions to catalogs, categories, variable types, and portal settings.

From the home page of the catalog builder, you can do the following:

• Create a catalog item
• Create a catalog item template
• View the available catalog items
• View the available catalog item templates
• View catalog items that are recently updated
• View the configured content that describes the catalog building process in your organization.

How does the catalog builder work

Catalog administrator creates templates for a business or service group. The business owner or service owner gathers catalog requirements and creates catalog items from these templates. All advanced capabilities are added by the catalog administrators or developers.

Catalog builder overview

[Image of catalog item creation process]
Catalog item states

A catalog item goes through various states during the item creation and maintenance process.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>A catalog item is in the Draft state in one of these scenarios:</td>
</tr>
<tr>
<td></td>
<td>• A new item is being created in catalog builder.</td>
</tr>
<tr>
<td></td>
<td>• An existing published item has been checked out for editing in catalog builder. When the item is being edited, catalog builder checks out the item and creates a copy of the item and its associated records (variables, UI policies, client scripts). The item copy is in the Draft state. The published item remains in the Published state and the <strong>Checked out</strong> field is set to <strong>True</strong>. Once the editing is done and the item is submitted, the edits to the draft item are merged with the associated published item and the draft item is deleted.</td>
</tr>
</tbody>
</table>

**Note:**

• You can only edit a draft item but not a published item that has been checked out.
• A draft item is always inactive and does not show up in the search or browse experience.
• You cannot modify the **Active** flag of a draft item.
• Any changes to the draft item are not available until it is submitted.

<table>
<thead>
<tr>
<th>Publishing</th>
<th>A catalog item is in this transient state for a while just after its submission and before its state changes to Published. You cannot check out an item in the Publishing state.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Published</td>
<td>When a new item is submitted, the item finally moves to the Published state. This state indicates that it is the item version being used by the application and available in the catalog. When you edit a published item, it is checked out in catalog builder and the item’s draft copy is created.</td>
</tr>
</tbody>
</table>
Limitations

Catalog builder is designed to support the most common and simple use cases so that it can easily be used by business users, while the complex functionality can be added to the item in Now Platform by catalog administrators.

When creating a record producer in a specific scope, you can only select tables in that scope for selecting a record submission table.

Catalog builder does not allow creation and editing of the following entities, but they can be set in Now Platform either for a draft item or a published item that has not been checked out.

- Catalog item
  - Meta tags
  - Execution plans. If an item is assigned an execution plan, the process engine cannot be changed in the catalog builder.
  - Price settings
- Variable settings
  - Tool tips
  - Advanced and dynamic reference qualifiers. If a variable has advanced or dynamic reference qualifiers, then the reference qualifier cannot be edited in the catalog builder.
  - Attributes
  - Default value
  - Permissions
  - Availability
  - Lookup label field (defaults to lookup value field)
  - Lookup price fields
  - Unique values only
  - Always expanded help
  - Help text
  - Advanced reference qualifiers
- Question types. The following questions are supported in catalog builder, and they are grouped into types and subtypes. For the unsupported question types, you can view the questions but not edit them:
Text
- Single-line. This is the Single-line text variable type in Now Platform.
- Multi-line. This is the Multi-line text variable type in Now Platform.
- Rich text. This is the HTML variable type in Now Platform.

Option
- Check box. This is the Check box variable type in Now Platform.
- Yes/No. This is the Yes/No variable type in Now Platform.

Choice
- Dropdown (fixed values). This is the Select Box variable type in Now Platform.
- Dropdown (values from a table). This is the Lookup Select Box variable type in Now Platform.
- Record reference. This is the Reference variable type in Now Platform.
- Radio. This is the Multiple Choice variable type in Now Platform.
- Multi-select. This is the List Collector variable type in Now Platform.

Date/Time
- Date. This is the Date variable type in Now Platform.
- Date & Time. This is the Date and time variable type in Now Platform.

Display label
- Plain text. This is the Label variable type in Now Platform.
- Rich text. This is the Rich Text Label variable type in Now Platform.

Catalog UI policy
- **On Load** field (defaults to true)
- **Script** field. When a catalog UI policy has a script, it does not show up in the question's behavior settings list in the catalog builder.
- **Reverse if false** field. By default, it is set to true.
- Multiple actions. When a catalog UI policy has multiple actions, it does not show up in the question's behavior settings list in the catalog builder.

For a catalog item, the questions cannot be viewed and edited in the catalog builder in the following scenarios:
- It has more than two levels of containers.
- It has a two-column question set or two-column container within a container.
• Catalog client scripts
• Data lookup rules

Set up the catalog builder
Set up the catalog item building process.

Before you begin
Role required: admin

Procedure

1. To direct users from the catalog builder homepage to your organization-specific catalog building process documentation, perform the following steps.
   a. Navigate to sys_properties.list.
   b. Select the glide.sc.builder.content_url property.
   c. On the System Property form, in the Value field, specify the URL for the documentation of your choice. You can include both absolute and relative URLs. Following are the examples:
      • Absolute URL: https://www.youtube.com
      • Relative URL: sp?id=kb_article&sysparm_article=KBXXXXXX
   d. Click Update.

2. Optional: To preview a catalog item in a specific portal, perform the following steps.
   a. Navigate to sys_properties.list.
   b. Select the glide.sc.builder.preview_portal_id.
   c. On the System Property form, in the Value field, specify the portal name. The default value is swp.
   d. Click Update.

3. Required: Create or duplicate catalog item templates. For information on creating a template, see Create or edit a catalog item template.

4. Optional: To allow users with access to a catalog item template to edit all items created using that template, perform the following steps.
a. Navigate to sys_properties.list.
b. Select the glide.sc.builder.template_access.
c. On the System Property form, in the Value field, set the value to true. The default value is false.
d. Click Update.

5. Optional: Define and configure a pre-publish subflow that is triggered after submitting the catalog item in catalog builder. This subflow is run after the catalog item has been submitted but before it gets published. For example, an approval flow after submitting the edited catalog item in catalog builder.

a. Create a pre-publish subflow by specifying the following input and output parameters. You can also copy the Template: Catalog Builder - Item review subflow and then define your subflow. For information about subflows, see Subflows.

<table>
<thead>
<tr>
<th>Template: Catalog Builder - Item review subflow input parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parameter</strong></td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>catalog_item</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Template: Catalog Builder - Item review subflow output parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parameter</strong></td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>state</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

For information about subflow field types, see Field types.

b. Create the glide.sc.builder.item_review_flow property.
   i. Navigate to sys_properties.list.
   ii. Click New.
   iii. On the form, fill in the fields.
### System Property form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique identifier of the property. Specify <code>glide.sc.builder.item_review_flow</code>.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the property. Specify <code>string</code>.</td>
</tr>
<tr>
<td>Value</td>
<td>sys_id of the review subflow.</td>
</tr>
</tbody>
</table>

iv. Click **Submit**.

6. **Optional:** To modify the content in feedback panels for catalog builder steps, perform the following steps.

   a. Navigate to `sc_wizard_feedback.list`.

   b. From the list of catalog wizard feedbacks, select the feedback panel content that you want to edit.

   c. On the Catalog Wizard Feedback form, in the **Content** field, edit the content.

   d. Click **Update**.

### Configure a step-based service fulfillment flow

Define service fulfillment steps while creating a catalog item in Catalog Builder.

**Before you begin**

Role required: admin, catalog_builder_editor, or catalog_admin

**About this task**

In the base system, the Step-based request fulfillment flow is available. It includes the Service Fulfillment Steps base flow subflow that runs all steps defined in the service fulfillment flow. Following are the input and output parameters of the subflow.

#### Service Fulfillment Steps base flow input parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>task</td>
<td>Reference</td>
<td>RITM record</td>
</tr>
</tbody>
</table>
Service Fulfillment Steps base flow output parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>state</td>
<td>String</td>
<td>State of the subflow. Possible values are: • completed: All steps are complete. • failed: At least one step failed because of invalid configurations such as missing subflow or step configurations.</td>
</tr>
</tbody>
</table>

For information about subflow field types, see Field types.

If your organization has processes to be run before or after the service fulfillment steps, create a flow and ensure that it is configured as a step-based service fulfillment flow.

Procedure

1. Create a Flow Designer flow (With the trigger type as Service Catalog). Ensure that the Service Fulfillment Steps base flow subflow is called from this flow.
   
   For information about creating a flow with Service Catalog trigger type, see Create a flow with a Service Catalog trigger.

2. Register the flow as service fulfillment flow.
   
   a. Navigate to Service Catalog > Catalog Administration > Service Fulfillment Steps Registry.
   
   b. Click New.
   
   c. On the form, fill in the fields.

   Service Fulfillment Flow Registry form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Fulfillment Flow Registry</td>
<td>Flow Designer flow for which you want to enable service fulfillment steps.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope in which the flow is supported for service fulfillment.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to enable the service fulfillment support for the flow.</td>
</tr>
</tbody>
</table>

   d. Click Submit.
Create a service fulfillment step type

Expand the coverage of service fulfillment use cases beyond those supported by step types in base system. Using a service fulfillment step type, catalog item owners can define multiple steps that are part of the request fulfillment process.

Before you begin
Role required: admin

About this task
The following step types are available in the base system.

- Task
- Custom approval
- Manager approval

Procedure

1. Set up a data store to store information needed for running the step. This information is provided by a catalog item owner while defining the request fulfillment process. Do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When additional input is required from the</td>
<td>Create a table by extending the Service Fulfillment Step [sc_service_fulfillment_step] table and add fields to store the additional input. For example, to create a step type for email notifications, the email id and body are the additional input provided by the catalog item owner while defining the steps. So, fields for email id and body should be added to the extended table to store the input.</td>
</tr>
<tr>
<td>catalog item owner for a step type</td>
<td></td>
</tr>
</tbody>
</table>

Note: Ensure that the new table has similar ACLs as that of the Service Fulfillment Step [sc_service_fulfillment_step] table.

For tables extending the Service Fulfillment Step [sc_service_fulfillment_step] table, the Domain master attribute should be added and its value should be set as service_fulfillmen-
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>t_stage</td>
<td>The domain of a service fulfillment step is then inherited from the catalog item.</td>
</tr>
</tbody>
</table>

When no input is required for a step type

Use the Service Fulfillment Step [sc_service_fulfillment_step] base table. For example, a department head approval does not require any additional input from the catalog item owner and does not need a new table.

2. Create a record producer to store the values provided by the catalog item owner to the data store (base table or extended table) of that step. For information about creating a record producer, see Create a record producer.

**Note:**

- The Service Fulfillment Steps - Properties set variable set is automatically added to the record producer and it should not be removed from the record producer.
- All additional columns defined in the extended table should have corresponding variables mapped in the record producer.
- Configure the Record Producer form to display the Allow edit option and Save Options field. Also, select the Allow edit option and set the value of the Save Options field to Save in Destination.
- Ensure that the record producer is not restricted for the users with catalog_builder_editor role.

3. Create a subflow to perform a sequence of actions by copying the Template: Service Fulfillment Steps subflow and then defining your subflow. For information about subflows, see Subflows.

### Template: Service Fulfillment Steps subflow input parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>requested_item</td>
<td>Reference</td>
<td>RITM record</td>
</tr>
<tr>
<td>service_fulfillment_step_data</td>
<td>Reference</td>
<td>Step data record. Update the state to one of the following values before ending the subflow:</td>
</tr>
<tr>
<td>Parameter</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>service_fulfillment_step</td>
<td>Reference</td>
<td>Step defined on a catalog item. It must refer to a table in which the record producer defined in the step configuration inserts a record. Do not update the step record.</td>
</tr>
</tbody>
</table>

For information about subflow field types, see Field types.

4. Create a step configuration to define the behavior and display of a service fulfillment step type.

   a. Navigate to Service Catalog > Catalog Administration > Service Fulfillment Step Configurations.

   b. Click New.

   c. On the form, fill in the fields.

   **Service Fulfillment Step Configuration form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the step configuration.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope in which the step configuration is supported.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to enable the service fulfillment support for the flow.</td>
</tr>
<tr>
<td>Order</td>
<td>Order of the step configuration.</td>
</tr>
</tbody>
</table>

   Based on the order of step configurations, the corresponding service fulfillment step types are displayed in the list in the Steps region of the Fulfillment step.

   The step type corresponding to the step configuration with the least order is displayed beside the list and step types for all other step configurations are included in the list based on their order.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Order of service fulfillment step types</strong></td>
<td>Add task</td>
</tr>
<tr>
<td><strong>Custom approval</strong></td>
<td><strong>Manager approval</strong></td>
</tr>
<tr>
<td>Hide</td>
<td>Hides the step type corresponding to this step configuration in the list in the <strong>Steps</strong> region of the <strong>Fulfillment</strong> step. No impact on existing steps.</td>
</tr>
<tr>
<td>Short description</td>
<td>Description of the step configuration.</td>
</tr>
<tr>
<td>Producer</td>
<td>Record producer that creates an instance of the step type in the step’s data store.</td>
</tr>
<tr>
<td>Service fulfillment subflow</td>
<td>Subflow triggered during the request fulfillment process.</td>
</tr>
<tr>
<td>Dynamic title</td>
<td>Text that should be displayed for the corresponding service fulfillment step in the <strong>Steps</strong> region of the <strong>Fulfillment</strong> step. If you don’t provide any value, the step configuration name is displayed.</td>
</tr>
<tr>
<td></td>
<td>To display dynamic text, you can include the field name from the step’s data store (base table or the extended table) where the associated record producer creates a record.</td>
</tr>
<tr>
<td></td>
<td>For example, in the base system, the <strong>Dynamic title</strong> field for the Custom approval step configuration contains the following value: Approval from ${approval_title}</td>
</tr>
<tr>
<td></td>
<td>Here, <strong>approval_title</strong> is the field from the Service Fulfillment Approval Step [sc_service_fulfillment_approval_step]</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Field | Description
--- | ---
 | table where the associated record producer, Add custom approval, creates a record.

**d. Click Submit.**

**Create or edit a catalog item template**

Pre-specify values or provide restrictions for attributes such as catalogs, categories, variable types, and portal settings, which are applicable during the catalog item creation or editing process. You can create a template for a catalog item or record producer.

**Before you begin**

Role required: admin or catalog_admin

Create a catalog item template in catalog builder

**Procedure**

1. Navigate to Service Catalog > Catalog Builder.
2. Select the Dashboard tab and click Create a catalog item template.
3. Select one of the following options.
   - **Standard** for a catalog item.
   - **Record Producer** for a record producer
4. In the wizard, specify the information for each step.

**Catalog item template creation wizard**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Template Details</strong></td>
<td>• Basic info: Contains the template name and short description&lt;br&gt;• Template Available for: Specifies the user criteria for users who can use the template. Users matching the criteria must have the catalog_builder_editor role.&lt;br&gt; Note: You can add up to a maximum of 50 user criteria.</td>
</tr>
<tr>
<td><strong>Details</strong></td>
<td>• Basic info: Suggestions for the item name and short description.&lt;br&gt; • Item details: Suggestions for the description of the item.</td>
</tr>
<tr>
<td><strong>Destination</strong></td>
<td>Destination table in which a record producer creates records.</td>
</tr>
<tr>
<td>Step</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Information" /> Note:</td>
<td>This step is available for a record producer template.</td>
</tr>
<tr>
<td>Location</td>
<td>Catalogs and categories that the item can be associated with.</td>
</tr>
<tr>
<td><img src="image" alt="Information" /> Note:</td>
<td>You can add up to a maximum of 50 catalogs or categories.</td>
</tr>
<tr>
<td>Questions</td>
<td>Question sets (variable sets) that should be included in the item. You can also restrict question types that can be used for items using the template by clicking the Define owner permissions icon (/button).</td>
</tr>
<tr>
<td>Settings</td>
<td>Settings to configure the catalog item behavior in Service Portal based on the request method.</td>
</tr>
<tr>
<td>Access</td>
<td>User criteria to specify users for whom the item is available or not available.</td>
</tr>
<tr>
<td>Fulfilment</td>
<td>Flow or workflow that you want to associate with the item using this template.</td>
</tr>
<tr>
<td>Overrides</td>
<td>Restrictions that apply while creating the catalog item.</td>
</tr>
<tr>
<td></td>
<td>• Can Edit: Only the attributes specified here can be edited.</td>
</tr>
<tr>
<td></td>
<td>• Must specify: Editable attributes that should be answered. The following attributes must be made mandatory:</td>
</tr>
<tr>
<td></td>
<td>◦ Item name</td>
</tr>
<tr>
<td></td>
<td>◦ Record submission table</td>
</tr>
<tr>
<td></td>
<td>• Restricted selections: For the attributes that allow selection of multiple values (for example, catalogs, categories, Available For, Not Available For), the user creating the item can only select or deselect the options from within the values specified in the template.</td>
</tr>
<tr>
<td>Review and submit</td>
<td>Review the template information and submit it.</td>
</tr>
</tbody>
</table>

![Information](image) Note: For each step, you can review the information in the feedback panel to know more about that step.

5. Click Submit.
6. To edit the catalog item template, navigate to the **Catalog item templates**, select the required template and perform any of these actions.

   a. To edit the item, make the necessary changes, and click **Save**.

      Note:
      - The changes to the template do not automatically apply to existing items.
      - While editing an existing catalog item, the new values in the template are not automatically updated in the item but the new restrictions apply. For example, if a new category is added to the template, that category is not automatically added to the catalog item. However, the restrictions to the categories will apply.
      - When question sets are added to the template, they do not have any impact on the existing catalog items using the template.

   b. To duplicate the catalog item template, click **Duplicate**.

      Note: You cannot delete a catalog item template in catalog builder, but it can be deleted in Now Platform. After a template is deleted, it is disassociated from all catalog items using the template and the restrictions no longer apply to those items.

### Create a catalog item using a template

Make an item available in service catalog for catalog item requests. You should create this item using one of the available catalog item templates.

**Before you begin**
Role required: catalog_builder_editor, catalog_admin, or admin

Create a catalog item in catalog builder

**Procedure**
1. Navigate to **Service Catalog > Catalog Builder**.
2. Select the **Dashboard** tab and click **Create a new catalog item**.
3. Review the steps involved in the creation process and click **Continue**.
4. Select a template from the list and click **Use this item template**.
Note:

- After you select the template, the preview of this template is available.
- You can only view templates assigned to you.
- Based on the template configuration, few attributes during the item creation or editing:
  - Have pre-specified values
  - Are not editable
  - Have limited options to select
  - Are mandatory
- When selecting a record submission table for record producers, you can only select tables in that scope.

5. Based on how each step is defined in the template, specify the required information.

Catalog builder steps

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| Details | - Basic info: Item name and short description.  
          - Item details: Description of the item. |
| Destination | Destination table in which a record producer creates records.  
            | Note: This step is available when using a record producer template. |
| Location | Catalogs and categories that the item can belong to. You can only view the catalogs and categories specified in the template.  
            | Note: You can add up to a maximum of 50 catalogs or categories. |
| Questions | Question sets (variable sets) or questions for the item. By default, the question sets included in the template are added and cannot be removed.  
            Available question types are restricted to those specified in the template.  
            From the Insert new question list, you can include additional question sets, questions, deactivated questions, single- |
<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>column container, two-column container, and line break. For information on creating a question and supported question types, see Create a question for a catalog item in catalog builder. You can also add dynamic form behavior for a question. For information on adding dynamic form behavior, see Edit a question in catalog builder.</td>
</tr>
</tbody>
</table>
| ✉️ Note: | - The questions within a question set cannot be edited. The question sets can be reordered by dragging and dropping them.  
- Question sets specified in the template cannot be removed, while the ones added by the user can be removed.  
- Removal of question sets simply removes the association with the item and does not delete the question set.  
- A single-column question set can be added to a single-column or a two-column container. Two-column question set cannot be added to a container. |
| Settings | Settings to configure the catalog item behavior in Service Portal based on the request method. |
| Access | User criteria to specify users for whom the item is available or not available.  
 ✉️ Note: You can add up to a maximum of 50 user criteria. |
| Fulfilment | Flow or workflow that you want to associate with this item. It defines how this catalog item can be fulfilled.  
When a catalog item is associated with a Flow Designer flow that supports service fulfillment steps, the catalog item owner creating the item can configure steps within the flow.  
By default, the Step based request fulfillment flow is available in the base system.  
For information about defining service fulfillment steps, see Define a service fulfillment step.  
For information about Flow Designer flows, see Flows. |
### Step Description

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review and submit</td>
<td>Review the item and submit it.</td>
</tr>
</tbody>
</table>

**Note:** A dot beside the step name indicates it has a mandatory field.

6. To save your changes in each step, click **Save**.
   All edits to the item attributes are automatically saved when you navigate to the next step.

7. To preview a catalog item in Portal, Now Mobile, or a Virtual Agent conversation, click **Preview**.

   **Note:** When you preview an item, you can interact with it but not submit it.

   a. To preview the item in Portal, select **Portal** for the **View within** field.

      **Note:** Portal preview is based on portal URL configured for the catalog builder.

   b. To view an item representation in Now Mobile, select **Now Mobile** for the **View within** field.

   c. To preview a catalog item in a Virtual Agent conversation, select **Virtual Agent** for the **View within** field.

   The Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks) and one of these plugins should be installed.

   • Glide Virtual Agent (com.glide.cs.chatbot)
   • Glide Virtual Agent Lite (com.glide.cs.chatbot.lite)

   A Virtual Agent conversation whose sys_id is specified in the `glide.sc.builder.va_preview_topic_id` property is opened. By default, the property has the sys_id of the base system Catalog builder preview topic. For information about this topic, see **Catalog builder preview topic conversation**. If the base system topic is used, the following scenarios are possible:

   • If the item is supported in the conversation mode, you can preview the item in the Virtual Agent conversation by answering the questions but cannot submit a request for the item. For information about when a catalog item is supported in the conversation mode, see **Service Catalog topic blocks in Virtual Agent**.
If the item is not supported in the conversation mode, a link is provided for the portal preview of the item.

When the required plugins are not installed, an illustration displaying a sample conversational experience for the catalog item submission appears.

d. To open the preview in a new tab, click **Open preview in a new tab**.

   ❓ **Note:** When you make any changes to the item and save it, the preview is dynamically refreshed in the opened tab.

8. To delete an unpublished draft item, click **Delete**.

   ❓ **Note:** You cannot delete a published item but can make it inactive.

9. Click **Submit**.

   ❓ **Note:** Until you submit the item, it is in the Draft state and is not available in the catalog.

**Define a service fulfillment step**

Define how a catalog item request should be fulfilled by creating simple service fulfillment steps.

**Before you begin**

Role required: catalog_builder_editor, catalog_admin, or admin

**About this task**

To configure fulfillment steps while creating a catalog item, associate it with a Flow Designer flow that supports service fulfillment steps.

Fulfillment process can contain multiple steps. These steps can run sequentially or can be grouped to run in parallel.

**Procedure**

1. In the **Fulfillment** step of creating a catalog item, for the **Selected flow** field, select a flow that supports service fulfillment steps.

2. In the **Steps** region, perform one of the following:
a. To create a task, click **Add task**.
   i. On the form, fill in the fields.

   **Task form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence</td>
<td>Sequence of this step relative to the previous step. Possible options are:</td>
</tr>
<tr>
<td></td>
<td>• With previous step: This step is grouped with the previous step or group. All grouped steps run simultaneously.</td>
</tr>
<tr>
<td></td>
<td>• After previous step: This step is placed after the previous step</td>
</tr>
<tr>
<td>Note:</td>
<td>This field is not editable if it is the first step.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the task. It appears in the <strong>Steps</strong> region.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the task.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>User group that the task should be assigned to.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User for which the task is assigned.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority of the task.</td>
</tr>
</tbody>
</table>

   ii. Click **Add**.

b. To create a custom approval and define who can approve the step, perform the following:
   i. From the list beside **Add task**, click **Custom approval**.
   ii. On the form, fill in the fields.

   **Custom approval form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence</td>
<td>Sequence of this step relative to the previous step. Possible options are:</td>
</tr>
</tbody>
</table>
### Field Description

- **With previous step**: This step is grouped with the previous step or group. All grouped steps run simultaneously.
- **After previous step**: This step is placed after the previous step.

**Note**: This field is not editable if it is the first step.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>Users that can approve this step.</td>
</tr>
<tr>
<td>Groups</td>
<td>User groups that can approve this step.</td>
</tr>
<tr>
<td>Approval</td>
<td>Type of the required approval.</td>
</tr>
</tbody>
</table>
| Approval type | • All approve: The step is approved only when all assigned users and user groups approve.  
 |             | • Anyone approves: The step is approved when any of the assigned users or any user from the assigned user groups approve. |

### iii. Click Add.

### c. To create a manager approval, from the list beside Add task, click Manager approval. An approval step is created and assigned to the manager of the requester of the requested item (RITM).

### Service fulfillment steps

3. In the **Estimated time to deliver** region, for the **Days** field, specify the time by which the RITM should be fulfilled. The due date is calculated based on when the service fulfillment flow is triggered.

4. **Optional**: To edit a step, click the edit icon (✏️).

   **Note**: You cannot edit a step that does not require any inputs, for example, manager approval.

5. **Optional**: To delete a step, click the delete icon (🗑️).
6. **Optional:** To rearrange steps, drag and drop the steps.

7. **Optional:** To group steps together, perform one of the following tasks.
   - Drag a step and drop it on another step or group of steps.
   - To group this step with the previous step or group, click the merge icon (\( \bar{V} \)).

### Merged service fulfillment steps

**Steps**

Define the different steps in your fulfillment process

- Approval from Abel Tutor: Custom approval
- Manager approval: Manager approval

---

8. **Optional:** To separate a step from a group of steps, perform one of the following tasks.
   - Click the separate icon (\( \bar{V} \)). The step is placed after the group.
   - Drag a step out of the group and drop it at a location of your choice.

### Catalog builder preview topic conversation

From the catalog builder, a user can preview a catalog item in a Virtual Agent conversation.

This conversation uses the Request Catalog Item topic block. For information on this topic block, see [Service Catalog topic blocks in Virtual Agent](#).

The Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks) and one of these plugins should be installed.

- Glide Virtual Agent (com.glide.cs.chatbot)
- Glide Virtual Agent Lite (com.glide.cs.chatbot.lite)

In catalog builder, when the user selects the required item and navigates to preview it, the following scenarios are possible:

- If the item is supported in the conversation mode, you can preview the item in the Virtual Agent conversation by answering the questions but cannot submit a request for the item. For information about when a catalog item is supported in the conversation mode, see [Service Catalog topic blocks in Virtual Agent](#).

- If the item is not supported in the conversation mode, a link is provided for the portal preview of the item.

- When the required plugins are not installed, an illustration displaying a sample conversational experience for the catalog item submission appears.
Related information
Service Catalog topic blocks in Virtual Agent

Create a question for a catalog item in catalog builder
Specify a question that the requester should answer before submitting the catalog item.

Before you begin
Role required: catalog_builder_editor, catalog_admin, or admin

About this task
If allowed in the template, the following question types can be used in the item creation process in the catalog builder. These question types are grouped into types and subtypes:

• Text
  ◦ Single-line. This is the Single-line text variable type in Now Platform.
  ◦ Multi-line. This is the Multi-line text variable type in Now Platform.
  ◦ Rich text. This is the HTML variable type in Now Platform

• Option
  ◦ Check box. This is the Check box variable type in Now Platform.
  ◦ Yes/No. This is the Yes/No variable type in Now Platform.

• Choice
  ◦ Dropdown (fixed values). This is the Select Box variable type in Now Platform.
  ◦ Dropdown (values from a table). This is the Lookup Select Box variable type in Now Platform.
  ◦ Record reference. This is the Reference variable type in Now Platform.
  ◦ Radio. This is the Multiple Choice variable type in Now Platform.
  ◦ Multi-select. This is the List Collector variable type in Now Platform.

• Date/Time
  ◦ Date. This is the Date variable type in Now Platform.
  ◦ Date &Time. This is the Date and time variable type in Now Platform.

• Display label
  ◦ Plain text. This is the Label variable type in Now Platform.
  ◦ Rich text. This is the Rich Text Label variable type in Now Platform.
For detailed information about these question types, see Types of service catalog variables.

**Procedure**

1. In the **Question** step of creating a catalog item, click **Insert new question**.
2. On the Create question form, specify the required details.

**Note:**
- The fields on the form vary based on the question type and subtype.
- While you configure each question, its preview is available.
- The question preview does not show interactions for the following question types till the question is saved and then edited.
  - Record reference
  - Multi-select
  - Dropdown (values from a table)
- The question preview does not show annotations.

a. Specify the details in the **Question** tab.

### Question tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td></td>
</tr>
<tr>
<td>Question type</td>
<td>Group under which the question type is categorized.</td>
</tr>
<tr>
<td>Question subtype</td>
<td>Subtype of the question.</td>
</tr>
<tr>
<td></td>
<td>Only the question types allowed in the template are available.</td>
</tr>
<tr>
<td>Details</td>
<td></td>
</tr>
<tr>
<td>Map to field</td>
<td>Maps the question to a specific field on the table for the record producer.</td>
</tr>
<tr>
<td>Question label</td>
<td>Question for a requester while ordering the catalog item.</td>
</tr>
<tr>
<td></td>
<td>For the Rich text question subtype, you can specify a formatted label to be</td>
</tr>
<tr>
<td></td>
<td>displayed on a catalog item form.</td>
</tr>
<tr>
<td>Name</td>
<td>Internal name to identify the question.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
| | The name should not contain spaces or special characters. Only underscore is allowed.
| Mandatory | Option to specify if the question is mandatory.
| Hidden | Option to specify if the question is hidden.
| Read-only | Option to specify if the question is read-only.

**b. Specify the details in the Annotation tab.**
This tab is available for the following question subtypes:

- Single-line
- Multi-line
- Rich text
- Yes/No
- Dropdown (fixed values)
- Dropdown (values from a table)
- Record reference
- Radio
- Date
- Date &Time
- Multi-select

**Annotation tab**

| Field | Description |
--- | ---
| Instructions | Option to specify if instructions should be displayed for the question. |
| Show instructions | Instruction for the requester while ordering the catalog item. |
| Instructions label | Detailed instruction content. |

**c. Specify the details in the Additional Details tab.**
This tab is available for the following question subtypes:
• Single-line
• Dropdown (values from a table)
• Record reference
• Multi-select

**Additional Details tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Validation</td>
<td>Available for the Single-line question type</td>
</tr>
<tr>
<td>Text validation</td>
<td>Option to validate the specified text value based on the regular expression validations that have been set up in the system.</td>
</tr>
<tr>
<td>Source</td>
<td>Available for the Dropdown (values from a table), Record reference, and Multi-select question subtypes</td>
</tr>
<tr>
<td>Table</td>
<td>Table from which the choices are retrieved.</td>
</tr>
<tr>
<td>Field</td>
<td>Field that should be displayed as a choice. This field is not available for the Record reference and Multi-select subtypes.</td>
</tr>
<tr>
<td>Filter conditions</td>
<td>Conditions to filter the choices.</td>
</tr>
</tbody>
</table>

d. Specify the details in the **Choices** tab.
This tab is available for the following question subtypes:

• Dropdown (fixed values)
• Dropdown (values from a table)
• Yes/No
• Radio

**Choices tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
<td>Option to include <strong>None</strong> as a choice for the question.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Choice direction</td>
<td>Direction in which the choices should be displayed. Possible options are Down and Across. This option is available only for the Radio question subtype.</td>
</tr>
<tr>
<td>Do not select first choice</td>
<td>Option to ignore the first choice. This option is available only for the Radio question subtype.</td>
</tr>
<tr>
<td>Available Choices</td>
<td>Available for the Dropdown (fixed values) and Radio question subtypes. You can add a name value pair for each choice.</td>
</tr>
<tr>
<td>Display name</td>
<td>Label for a choice.</td>
</tr>
<tr>
<td>Value</td>
<td>Value of the choice.</td>
</tr>
</tbody>
</table>

3. Click **Insert Question**.

**Note:**
- If there are two consecutive check boxes, then a virtual container is created for a group of check boxes. Only check box variable types can then be added inside that group.
- Even if a check box variable is added immediately after a group of check boxes, it is automatically added to the group.

**Edit a question in catalog builder**

Make changes to an existing question, for example, deactivate it or add dynamic form behavior (catalog UI policy in Now Platform).

**Before you begin**

Role required: catalog_builder_editor, catalog_admin, or admin

**About this task**

You cannot edit questions that are not specified in the template and questions within a single-row or multi-row variable set.

A question can be removed in the question designer and the following scenarios are possible:
• If the question is used in a published catalog item, it cannot be deleted but can only be marked inactive. Such questions can be included again in the catalog item by using the **Insert De-activated questions** option.

• Removing a new question that has never been published deletes the question.

• Questions of types not allowed in the template or supported in the catalog builder cannot be removed.

**Procedure**

1. Select a catalog item and navigate to the **Questions** tab.

2. To deactivate a question, perform the following steps.
   a. Point to the question and click the deactivate icon (🗑).
   b. In the dialog box, click Deactivate.

3. To edit a question, perform the following steps.
   a. Point to the question and click the edit icon (>Edit).
   b. Make the required changes and click Save.

4. To add dynamic form behavior to a question, perform the following steps.
   a. Point to the question and click the UI policies icon (🔗).
   b. In the Dynamic behavior dialog box, click **Define new behavior**.
   c. In the **Actions** tab, fill the required information.

**Actions tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outcome</td>
<td>Specify the behavior of this question when the trigger conditions are met</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Specifies how the dynamic behavior setting affects the mandatory state of the field. Following are the options:</td>
</tr>
</tbody>
</table>

- Leave alone
- True
- False
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible</td>
<td>Specifies how the dynamic behavior setting affects the visible state of the field. Following are the options:</td>
</tr>
<tr>
<td></td>
<td>• Leave alone</td>
</tr>
<tr>
<td></td>
<td>• True</td>
</tr>
<tr>
<td></td>
<td>• False</td>
</tr>
<tr>
<td>Read-only</td>
<td>Specifies how the dynamic behavior setting affects the read-only state of the field. Following are the options:</td>
</tr>
<tr>
<td></td>
<td>• Leave alone</td>
</tr>
<tr>
<td></td>
<td>• True</td>
</tr>
<tr>
<td></td>
<td>• False</td>
</tr>
<tr>
<td>Clear value</td>
<td>Option to clear the question value.</td>
</tr>
</tbody>
</table>

d. In the **Conditions** tab, add conditions that trigger the action on this question.

e. In the **Settings** tab, fill the required information.

### Settings tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applicability</td>
<td>Scenarios where this dynamic behavior applies</td>
</tr>
<tr>
<td></td>
<td>Applies when the item is being requested</td>
</tr>
<tr>
<td></td>
<td>Option to specify if the dynamic behavior applies when the item is being requested.</td>
</tr>
<tr>
<td></td>
<td>Applies while viewing the catalog tasks after the request is submitted</td>
</tr>
<tr>
<td></td>
<td>Option to specify if the dynamic behavior applies while viewing the catalog tasks after the request is submitted</td>
</tr>
<tr>
<td></td>
<td>Applies while viewing the submitted record</td>
</tr>
<tr>
<td></td>
<td>Option to specify if the dynamic behavior applies while viewing the submitted record</td>
</tr>
</tbody>
</table>

f. Click **Add policy**.

**Note:** When dynamic behavior is added, a catalog UI policy and action is created and a short description is automatically generated.
Edit a catalog item in catalog builder

Make changes to an existing catalog item if you have permissions to edit it.

Before you begin
Role required: catalog_builder_editor, catalog_admin, or admin

About this task
Following are the various scenarios in which a user can edit or view a catalog item:

• A user has permissions to edit an item in any of the following scenarios:
  ◦ The user has the catalog_admin role
  ◦ The user has the catalog_builder_editor role and any of the following scenarios is true:
    ▪ The user is the owner (updated in the Owner field) of the item. When the item is created in catalog builder, the owner is automatically updated as the user creating the item.
    ▪ The template access property, glide.sc.builder.template_access, is set to true and the item is associated with a template that the user has access to. By default, this property is set to false.
  
• In the catalog item list view in the catalog builder, a user can view all the items that the user has read access to. These items also include the items that the user may have read access to as a requester. However, if the user does not have permissions to edit an item, the user cannot view its details and edit it.

When a user is editing a published item in catalog builder, it creates a copy of the item and its associated records such as variables, UI policies, and client scripts.

• A draft version (a new item) of the item is created and it is inactive.

• The published item remains in the Published state and the Checked out field is set to True.

• Once the editing is done and item is submitted, the following scenarios are possible:
  ◦ A review subflow is not configured:
    ▪ The edits to the draft version are merged with the associated published item.
    ▪ The draft item and the associated records are deleted.
    ▪ The Checked out field of the published item is set to False.
A review subflow is configured. For information about configuring a review subflow, see Set up the catalog builder.

- The draft item’s state is changed to In review.
- If the state variable of the subflow output returns Completed:
  - The draft item’s state is changed to Reviewed and edits to the draft version are merged with the associated published item.
  - The published item’s state changes to Publishing, and then to Published and the Checked out field of the published item is set to False. The state change from Publishing to Published may not happen instantaneously.
  - The reviewed draft item and the associated records are deleted.
- If the state variable of the subflow output returns Failed, the draft item’s state is reverted to Draft and the item is ready for editing.

Procedure

1. To edit a catalog item in catalog builder, perform these steps.

   a. Navigate to Service Catalog > Catalog Builder.
   
   b. Select the Catalog Items tab.
   
   c. Select the item you want to edit and click Edit.

   Note:
   
   To edit an item in the In review state, you have to cancel the review. After you cancel the review, the item’s state is reverted to Draft.

   d. Make the required changes and click Save. For information on editing a question and catalog item fields, see Edit a question in catalog builder and Create a catalog item using a template.

   e. To make an item inactive, deselect the Item is active check box in the Basic info section of the Details step.

   f. To publish the modified item, navigate to the Review and submit step and click Submit.

2. To add advanced capabilities, such as catalog client scripts, data lookup rules, and advanced reference qualifiers, edit a catalog item in Now Platform. A user with the admin or catalog_admin role can perform this step.
a. Navigate to Service Catalog > Catalog Definitions > Maintain Items.

   Note:
   - A • beside a catalog item indicates that it is the published version of the item that has been checked out for editing in catalog builder.
   - A △ mark beside the item indicates that it is the draft version of the item that can be directly edited in Now Platform.

b. Open the published item you want to edit.

c. Select the Edit checked out item in advanced view related link to open the draft version of item and then add the required capabilities.

   Note:
   - When a published item is checked out for editing, you cannot edit the published version of the item in Now Platform, unless you cancel the checkout in Now Platform. Canceling the checkout cancels all changes made after the item was checked out.
   - To edit an item in the In review state, you have to cancel the review. After you cancel the review, the item’s state is reverted to Draft.

d. Make the required changes and click Update.

e. To edit the same item in catalog builder, click Edit in Catalog Builder.
   If the item has not already been checked out, this step checks out the item.

Service Catalog in Service Portal

Use Service Portal to configure an improved version of Catalog. You can customize Service Portal where your customers can request catalog items such as service and product offerings. You can use the Service Catalog widgets to build a catalog for your portal.

The Catalog landing page provides an interface from where you can access the catalog items, requests, approvals, popular items, recent items, and saved bundles. This page is available by default for zBoot users.

   Note: Upgrade users need to activate the Service Portal - Service Catalog v2 plugin (com.glideapp.servicecatalog.portal).
Overview of configurable options in the Service Catalog on the Service Portal and explains how to perform those configurations.

You can access the Catalog landing page in Service Portal using the Catalog option from the main menu header of Service Portal.

The landing page has:

• A search bar to search within all configured catalogs in Service Portal. When you search for a specific item, the search results page displays results based on the configured catalogs and categories. Only the items associated with a catalog and category are searchable. The primary category of the item is displayed under the Category filter. The catalog where the primary category is defined for the item is displayed under the Catalog filter.

• The Browse by Categories option to navigate to the list of categories in Service Catalog and the items within. Click this option to navigate to the categories landing page.

• The Requests and Approvals widget to display the list of requests and approvals associated with the user. The list is based on the configurations available in the My Request Filter module in Platform. For information about the My Request Filter module, see Define filters for My Requests.

• The My Saved Bundles widget to display the saved bundles associated with the user. You can remove a bundle, or open a bundle to add or replace the cart with the items in the bundle.

• The My Recent Items widget to display catalog items, record producers, or order guides that are most recently viewed or requested by the user. An instance option on the widget allows you to display either the viewed or requested items. This widget is not displayed when it has no data.

• The Popular Items widget to display the most popular catalog items ordered across the organization by other users. These items are displayed based on the Top Requests dynamic category. This widget is not displayed when there is no data.
Note:

- In the order status page of a request, stage renderer displays the current stage in a collapsed view. You can expand this view for all stages.
- These pages have dynamic titles to display the name of the selected entity.
  - Catalog Item [sc_cat_item]
  - Catalog Categories [sc_category]
  - Order Guide [sc_cat_item_guide]

Related information

Service Catalog widgets
Content Management and Service Portal

Access Service Catalog categories in Service Portal

Access Service Catalog categories to access the catalog items within.

Before you begin
Role required: requester

Procedure

1. Navigate to Service Portal > Service Portal Home.
   The Service Portal homepage is displayed.
2. Click any of the following:
   - The Request Something link from the Service Portal landing page.
   - The Catalog option from the main menu header of Service Portal and then the Browse by Categories option.
   The popular items from all categories are displayed.
3. In the Catalogs section, select the required catalog from the list. For information on how you can configure a catalog, refer to Configure a catalog in Service Portal

Note:

- The Catalogs section is available only when you have multiple catalogs and have access to items of multiple catalogs.
- The list contains all catalogs configured for Service Portal.

The following information is displayed:
• Categories of the selected catalog in the Categories section.
• Popular items of the selected catalog.

4. In the Categories section, click the required category. The category details and the items within are displayed.

   Note:
   • You can click the category count or anywhere in the row to view the category details.
   • For a category with a long name, additional text is displayed as ellipses. Point to the category name to view the additional text.

5. To change the display of category items, click the Card View icon (GridView) or the Grid View icon (CardView).

   Note: When you access a catalog item from the Catalog landing page or type ahead search results, the breadcrumb of the item displays the path based on the primary category configured on that item. When you access the item from a specific category, the breadcrumb of the item displays the path based on that category.

Related information

SC Categories widget

Add an item to the wish list in Service Portal
Add catalog items or record producers to the wish list to review them when required.

Before you begin
Role required: requester

Procedure

1. Navigate to Service Portal > Service Portal Home. The Service Portal homepage is displayed.
2. Select a catalog item or record producer from Service Catalog.
3. Click the Add to Wish List icon (WishList) in the Ordering widget.

   Note: When you edit an item that is added to the wish list, the Update Wish List icon (WishList) is displayed in the corresponding Ordering widget.

4. Click View Wish List from the confirmation message or the Wish List menu option on the main navigation bar.
The wish list details page is displayed.

5. If required, perform any of these actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove Item</td>
<td>To remove an item from the wish list, click the Remove Item icon (🗑️).</td>
</tr>
<tr>
<td>Clear Wish List</td>
<td>To clear the wish list, click <strong>Clear Wish List</strong>.</td>
</tr>
<tr>
<td>View the Catalog</td>
<td>To navigate to the Service Catalog landing page, click <strong>View the Catalog</strong>.</td>
</tr>
</tbody>
</table>

6. To navigate to any wish list item page, click the image or name of the item in the wish list details page.

⚠️ Note: This does not open a new instance of the item, but the instance that is in the wish list, where you can edit the details.

**Related information**

**SC Wish List Cart widget**

**Add a catalog item to the shopping cart**

Add a catalog item or order guide to the shopping cart to store at one place and checkout.

**Before you begin**

Role required: requester

**Procedure**

1. Navigate to Service Portal > Service Portal Home.
   The Service Portal homepage is displayed.

2. Select a catalog item or order guide from Service Catalog.

3. Click the Add to Cart icon (🛒) in the Ordering widget.

⚠️ Note:

- You can add the same item to the cart multiple times. Every time you add an item to the cart, a new instance of the item is created.
- The cart information is automatically updated in all open tabs or windows.
4. Click View Cart from the confirmation message or the Cart menu option on the main navigation bar. The cart details page is displayed.

5. To navigate to any cart item page, click the image or name of an item in the cart details page.

   Note: This step does not open a new instance of the item, but the instance that is in the cart, where you can edit the details.

6. If required, edit the quantity of items.

7. To remove an item from the cart, click the Remove Item icon (🗑).

8. To navigate to the Service Catalog landing page, click Continue Shopping.

9. To clear the cart, click Clear Cart.

10. To create a bundle from the cart:

    a. Click Save as Bundle.

    b. In the Create New Bundle window, specify the Bundle Name and select the items that you want to include.

    c. Click Save.

    Note: When you create a bundle from the cart, which includes an order guide, the association of the items to the order guide is lost.

11. To add a saved bundle to the cart, open the bundle from the My Saved Bundles section and click Add to Cart.

12. To replace the cart items with a saved bundle, open the bundle from the My Saved Bundles section and click Replace Cart.

13. Click Proceed to Checkout. The Order Confirmation window is displayed.

14. From the Request for list, select the user for whom you are requesting.
Note:

- By default, the user who is logged in is selected in this list.
- The search in this choice list is performed for the User [sys_user] table columns specified in the Service Catalog property, Additional columns for the "request for" Service Catalog widget. Choose fields in the sys_user table. Must be semicolon separated(glide.sc.request_for.columns).
- You can provide additional widget options to control the Request for default value. For example:

```
"requested_for_id": {
  "value": "62826bf03710200044e0bfc8bcbe5df1"
},
"requested_for_display": {
  "value": "Abel Tuter"
}
```

15. If required, specify the Delivery Information and Special instructions.

16. To add an attachment for the cart, click Add attachments and select the required attachment.

17. Click Checkout. The corresponding request is displayed in the Order Status page with the request number, estimated delivery date for the entire order, price, and the order status of individual ordered items.

Note:

- Use the instance options on the Order Status page to display the pre-defined columns.
- You can display either the RITM number or the name of the catalog item. By default, the name of the catalog item is displayed.

Related information

SC Shopping Cart widget

Request a catalog item from Service Portal

Use the SC Catalog Item widget in Service Portal to request a catalog item.

Before you begin

Role required: requester

Select the Allow Cloning instance option on the Order Status page to display the Additional Actions section after placing the request.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
For information about the SC Catalog Item widget, see SC Catalog Item widget

**Procedure**

1. Navigate to Service Portal > Service Portal Home.
   The Service Portal homepage is displayed.
2. Select a catalog item or record producer from Service Catalog.
3. Enter the required information in the catalog item form.
4. Enter the number of items in the Quantity field.
5. If required, perform any of these actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add attachments</td>
<td>To add attachments to the catalog item, click the Add attachments icon (_attach).</td>
</tr>
<tr>
<td>Add to Cart</td>
<td>To add the catalog item to the shopping cart, click the Add to Cart icon ( ShoppingCart).</td>
</tr>
<tr>
<td>Add to Wish List</td>
<td>To add the catalog item to the wish list, click the Add to Wish List icon ( Wish List).</td>
</tr>
</tbody>
</table>

6. Click Order Now.
   The Order Confirmation window is displayed.

> **Note:** For a record producer, you can edit the label of the Submit button by using the widget instance options. For example, if you want to change the label to Request, press Ctrl+click on the catalog item widget, select Instance in Page Editor, and specify the following parameters in the Additional options, JSON format field.

```json
"record_producer_label":{
  "value" : "Request"
}
```

7. From the Request for list, select the user for whom you are requesting.
Note:

- By default, the user who is logged in is selected in this list.
- The search in this choice list is performed for the User [sys_user] table columns specified in the Service Catalog property, Additional columns for the “request for” Service Catalog widget. Choose fields in the sys_user table. Must be semicolon separated (glide.sc.request_for.columns).
- You can provide additional widget options to control the Request for default value. For example:

```json
"requested_for_id": {
  "value": "62826bf03710200044e0bfc8bcbe5df1"
},
"requested_for_display": {
  "value": "Abel Tuter"
}
```

8. If required, specify the Delivery Information and Special instructions.

9. Click Checkout.
   The corresponding request is displayed in the Order Status page with the request number, estimated delivery date for the order, price, and the order status.

Note:

- Use the instance options on the Order Status page to display the pre-defined columns.
- You can display either the RITM number or the name of the catalog item. By default, the name of the catalog item is displayed.
- When a service catalog item is ordered from an existing record, a link is added between the order item request and the parent record.

10. Optional: To clone a request for other users, perform the following steps.

   a. In the Additional Actions section, from the Also request for list, select the required users and click Submit.

   b. In the Cloning Requests window, click Ok.
Note:

• The logged in user should be specified in the List of roles (comma-separated) that can use bulk ordering functionality. Blank means all users (glide.sc.allow.clone.roles) property.

• You can clone the request for multiple users.

• When you clone a request that contains a multi-row variable set, the information that is specified in the multi-row variable set is available in all cloned requests. All UI policies and client scripts on the multi-row variable set are also cloned.

• A separate request is created for each specified user and that user is displayed in the Requested For field of the request.

• The Opened By field of the cloned requests is updated with the logged in user.

• Select the Requests menu option or the My Requests widget on the catalog homepage to view the cloned request created for the user.

Related information

Service Catalog request screens
Create a variable set and add it to an item

Request an order guide from Service Portal

Use the SC Order Guide widget on Service Portal to request an order guide with several catalog items for a specific purpose.

Before you begin
Role required: requester
Select the Allow Cloning instance option on the Order Status page to display the Additional Actions section after placing the request.

For information about the SC Order Guide widget, see SC Order Guide widget.

Procedure

1. Navigate to Service Portal > Service Portal Home.
The Service Portal homepage is displayed.

2. Select an order guide from Service Catalog.

3. In the Describe Needs section, enter the required information and click Next.
4. In the Choose Options section, enter the requirements for catalog items and click Next.

- **Note:**
  - If a catalog item has fields that need user inputs, **Options** is displayed on the accordion.
  - If the fields are mandatory, a red asterisk is displayed beside **Options**.

- **a.** To expand or collapse the catalog item information, click the accordion.

- **b.** To include or exclude the catalog item from the order guide request, click the toggle on the accordion.

  - **Note:** When the item is excluded from the order guide request, the item is not editable and the corresponding mandatory field restrictions are ignored.

- **c.** To add an attachment for the catalog item, click the Add attachments icon (_attach) and select the required attachment.

- **d.** Click **Previous** to navigate to the Describe Needs section.

5. In the Summary section, review the order guide summary.

6. To add the order guide to the shopping cart, click the Add to Cart icon (🛒).

- **Note:**
  - When you add an order guide to the cart, you can only edit the order guide instance in the cart.

7. To go to the Choose Options section and edit the order guide items, click **Edit Options**.

8. Click **Order Now**.
   
   The Order Confirmation window is displayed.

9. From the **Request for** list, select the user for whom you are requesting.
Note:

- By default, the user who is logged in is selected in this list.
- The search in this choice list is performed for the User [sys_user] table columns specified in the Service Catalog property, Additional columns for the “request for” Service Catalog widget. Choose fields in the sys_user table. Must be semicolon separated (glide.sc.request_for.columns).
- You can provide additional widget options to control the Request for default value. For example:

```
"requested_for_id": {
  "value": "62826bf03710200044e0bfc8bcbe5df1"
},
"requested_for_display": {
  "value": "Abel Tuter"
}
```

10. If required, specify the Delivery Information and Special instructions.

11. To add an attachment for the order guide, click the Add attachments icon and select the required attachment.

12. Click Checkout.
   The corresponding request is displayed in the Order Status page with the request number, estimated delivery date for the entire order, price, and the order status of individual ordered items.

Note:

- Use the instance options on the Order Status page to display the pre-defined columns.
- You can display either the RITM number or the name of the catalog item. By default, the name of the catalog item is displayed.

13. Optional: To clone a request for other users, perform the following steps.

   a. In the Additional Actions section, from the Also request for list, select the required users and click Submit.

   b. In the Cloning Requests window, click Ok.
Note:

- The logged in user should be specified in the List of roles (comma-separated) that can use bulk ordering functionality. Blank means all users (glide.sc.allow.clone.roles) property.
- You can clone the request for multiple users.
- If a record producer is included in the order guide, a request is created for all items other than the record producer.
- When you clone a request that contains a multi-row variable set, the information that is specified in the multi-row variable set is available in all cloned requests. All UI policies and client scripts on the multi-row variable set are also cloned.

- A separate request is created for each specified user and that user is displayed in the Requested For field of the request.
- The Opened By field of the cloned requests is updated with the logged in user.
- A user can view the cloned request created for the user from the Requests menu option or the My Requests widget on the catalog homepage.

Related information

- Request an order guide
- Create an order guide

Standard ticket page for a requested item

In Service Portal, you can configure the ticket page of a requested item to display the related information, while still having a consistent layout that is similar to other request types. This configuration ensures a consistent experience when viewing submitted requests in Service Portal.

In Service Portal, you can access the ticket page for a requested item by using the Requests option from the main menu header.

For new instances, the standard ticket page for a requested item is available by default. For upgraded instances, you need to activate the Standard Ticket Route page route map. For information about activating this page route map, see Activate the page route map for the standard ticket page.

Standard ticket page configuration for a requested item

The layout of the standard ticket page can be configured for a requested item. Navigate to Standard Ticket > Standard Ticket Configurations and edit the
sc_req_item ticket configuration. For information about configuring the standard ticket page, see Configure the standard ticket page.

Related information
- Standard ticket page

Service Catalog in mobile
You can use a mobile and track request and approval flows of Service Catalog.

Fulfiller experience in ServiceNow Agent
Approve catalog requests, requested items, or change requests from anywhere using the ITSM ServiceNow Agent application.

As an ITSM agent or technician, you can use the mobile app when connected online to accomplish the following:
- Accept or reject the pending approval requests.
- View the completed approval requests.

Note:
- The request experience is not available in this mobile app.
- On-load catalog UI policies (non-scripted) are supported for variables in record views, for example, requested item and incident.
  - Only the visibility condition is considered.
  - A variable with no value is not displayed.
  - These policies are also applicable for container variables and a group of check boxes.
  - Since the multi-row variable set is displayed with a message that it is not viewable, these policies can be used to display or hide that message.

Watch this three-minute video to learn how to manage approval requests in the mobile app. This video covers: Accessing the Approvals mobile app and viewing and approving or rejecting requests.

Activation information
This mobile application runs on the ServiceNow® mobile platform. You should activate the ITSM Mobile Experience (com.sn_itsm_mobile) plugin that enables the ITSM mobile application.
Get started with the mobile app for Approvals

Access the My Approvals application instance on your mobile app to manage approval requests using your mobile device.

Before you begin
Role required: business_stakeholder or approver_user

About this task
Download the ServiceNow® mobile application on an iOS platform from the Apple App Store or on an Android platform from the Google Play Store.

Procedure
1. Open the mobile app and tap the plus icon (➕).
2. Add a ServiceNow instance. For more information on adding the instance, refer to Add a ServiceNow instance.
3. Tap My Approvals to start managing your requests.

Related information
Agent mobile app

Manage a catalog request approval

Manage your assigned catalog request or requested item by approving or rejecting it from anywhere using your mobile device.

Before you begin
Role required: business_stakeholder or approver_user

Procedure
1. Tap My Approvals on your mobile app.
2. To approve or reject a pending approval request, perform the following steps.
   a. Tap the Pending Approvals applet. All approvals in the Requested state are displayed.
   b. Swipe a request and tap Approve or Reject.

   Note: You should specify the reason while rejecting a request.
c. **Optional:** To view the details of a pending approval request, tap it.

   ![](image)

   **Note:** To approve or reject a request, tap the menu icon (ображення) and tap **Approve** or **Reject**.

3. To view a completed approval request, perform the following steps.

   a. Tap the Completed Approvals applet. All approval requests that are either accepted or rejected are displayed.

   b. To view the details of the request, tap it.

### Request experience in Now Mobile

You can enable users to request for an item or service, and track or approve requests on mobile using the Now® Mobile app.

### Activation of Now Mobile for Service Catalog

If you have the admin role, activate the ServiceNow Mobile Request Native Application Screens and Applet Launcher plugin (com.glide.mobile-employee). See [Now Mobile app](#). This plugin enables the Service Catalog functionality by default.

### For Me tab

When you log into Now Mobile, the following functionality related to Service Catalog is available:

- **My To-Dos:** Displays approval records of requests and requested items assigned or delegated to the user.

- **My Requests:** Displays requests based on the filters defined for mobile in the **My Requests Filter**. By default, the Incident Mobile and Service Catalog Request Mobile filters are available. For information about configuring filters, see [Define filters for My Requests](#) and [Configure My Requests](#).

   ![](image)

   **Note:** It is recommended to include only open requests.

### Services tab

You can submit or track requests.
• **Recent Services**: Displays the items and services (10 items and services in the last 12 months) that were requested recently by the logged-in user.

• **Popular Services**: Displays the most requested items and services (10 items and services in the last 12 months) that are visible to the user. Displays the 10 recent items and services in the last 12 months.

• **Browse Services**: Displays the categories of items and services that you can browse through and order.

⚠️ **Note:**

◦ If a category contains both items and sub-categories, the items specific to the category are displayed under **Others**.

◦ The category listings do not display the catalog information for users who do not have the roles that have permissions to read the records in the sc_category table. For such users, an ACL can be added to provide read permission for the Title field of the sc_catalog table.
Note:

- You cannot request these item types in the mobile app.
  - Content items
  - Wizard
  - Standard change template
- All items hidden in Service Portal are also hidden in the mobile app.
- In the RITM and record view, these variable types are not supported.
  - HTML
  - Macro
  - Macro with Label
  - UI Page
- In the RITM and request view, a multi-row variable set is not supported. A message is displayed in this view that this variable set is not viewable.
- On-load catalog UI policies (non-scripted) are supported for variables in record views, for example, requested item and incident.
  - Only the visibility condition is considered.
  - A variable with no value is not displayed.
  - These policies are also applicable for container variables and a group of check boxes.
  - Since the multi-row variable set is displayed with a message that it is not viewable, these policies can be used to display or hide that message.

From Now Mobile, you can also perform the following tasks:

- Browse catalog items using the catalog hierarchy in addition to the category hierarchy. For information about its configuration, see Browse catalog items using the catalog hierarchy.

- Change the label of the Submit button for a record producer. For information on editing the button label, see Edit the label of Submit button for a record producer.

- Use the mobile camera to scan bar codes for identifying a variable value of a catalog item. This is only applicable by using the barcode attribute for the Single Line Text variable. For information about this variable attribute, see Service catalog variable attributes.
Quick actions
You can provide easy access to a catalog item by creating a quick action. For information on creating a quick action in Now Mobile, see Create a quick action.

Siri shortcuts
iOS users can use Siri shortcuts to open the following pages in the mobile app.
- Browse items and services.
- Open my requests

See Siri shortcuts.

Now Mobile properties
You can define the following behavior for various catalog entities by configuring the Now Mobile properties. For information about configuring these properties, see Configure Now Mobile properties.

- Sort categories by the Order field.
- Define the availability of a catalog item in one of the following ways:
  - Include the catalog item with Availability set to Desktop only in Now Mobile.
  - Specify catalog item types to exclude in Now Mobile.
- Define the non-availability behavior of a catalog item by making it discoverable but not viewable, or not available at all.
- Specify colors for buttons to match your mobile theme.

Related information
- Now Mobile app
- Mobile plugins and upgrades

Configure catalogs
Enable your users to view and request their associated items in the Now Mobile app. If no catalogs are selected, users can view and request items from all catalogs in the system. By default, the app uses Service Catalog.

Before you begin
Role required: admin

About this task
Procedure
1. Navigate to Now Mobile App > Catalogs.

2. Optional: In the portal catalogs [m2m_sp_portal_catalog] table, add a catalog in addition to the base system catalog, or change the catalog that is associated with the base system record:
   
a. Click New or open the base system record.

b. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portal</td>
<td>Portal that you select. Select Employee Center.</td>
</tr>
<tr>
<td>Catalog</td>
<td>Catalog that you would like to associate with the app.</td>
</tr>
<tr>
<td>Order</td>
<td>Number that indicates the order that the configurations should run. If there are multiple configurations on a portal, the system runs the configurations from the lowest to the highest order that you selected.</td>
</tr>
</tbody>
</table>

Results
Your users can view and request items from all added catalogs.

Browse catalog items using the catalog hierarchy
In addition to the category hierarchy, browse catalog items using the catalog hierarchy for proper context.

Before you begin
Role required: admin

Procedure
1. Navigate to System Mobile > Now Mobile app > Applet Launchers.
2. Select the Services applet launcher.
3. Replace the Browse Services applet launcher section with the Browse Catalog applet launcher section.
   
a. On the Applet launcher form, navigate to the Body section.

b. Under the Section column, click Browse Services.
c. On the Item Section form, set **Destination screen** as **Browse Catalog**.

d. **Click Update.**
   After the **Browse Catalog** applet launcher section is enabled, the catalog appears as the first level of browsing and then the categories.

**Submit and track a request**
Submit a request for an item or service and track the progress of your request with the Now Mobile app.

**Before you begin**
Role required: none

**Procedure**
1. In the navigation bar, tap **Services**.
2. Browse items and services, or search for an item.
3. Tap the item or service that you would like to request.

   **Note:** If configured by your administrator, the related items and articles area provides alternatives and additional information.

4. Select **ORDER NOW**.
5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request for</td>
<td>Change this field if ordering the item for someone else.</td>
</tr>
<tr>
<td>Delivery Information</td>
<td>Confirm the shipping address for the item.</td>
</tr>
<tr>
<td>Special instructions (Optional)</td>
<td>Add any special instructions for the item.</td>
</tr>
</tbody>
</table>

6. **Tap CHECKOUT.**
   The app displays a confirmation that your request is submitted.

7. To return to the list of items, tap **Close**.
8. In the navigation bar, tap **For Me**.
9. To view all your requests, tap **My Requests**.
10. To view the status of your request, tap the item that you ordered.
a. To view information about the request, use the Details tab.

   Note: You can add comments for an open incident.

b. To view field changes and comments about your request, use the Updates tab. Tap to add comments and work notes, or to attach a file.

   Note: When you add comments for a resolved incident, you can reopen it.

Create a quick action in your mobile applications

Provide easy access to an important item by creating a quick action. For example, you can create a quick action that opens a Service Catalog item.
Before you begin
Role required: admin

Procedure
1. Create a function for the quick action.

   a. Navigate to **System Mobile > Functions**.
      The Function [sys_sg_button] table opens.

   b. Click **New**.

   c. On the form, fill in the fields.

**Button fields form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the function record.</td>
</tr>
<tr>
<td>Description</td>
<td>Description to enable other users to easily understand the purpose of the function.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of quick action that you want to create.</td>
</tr>
<tr>
<td>Context</td>
<td>Whether the function applies at the record or table level.</td>
</tr>
<tr>
<td></td>
<td>• Record: Action only applies at the record level. For example, updating a field.</td>
</tr>
<tr>
<td></td>
<td>• Global: Action that only applies at the table level. For example, creating or deleting a record. For this example, select <strong>Global</strong>.</td>
</tr>
<tr>
<td>Link Label</td>
<td>Label for the link. This value does not display in the user interface.</td>
</tr>
<tr>
<td>Link URL</td>
<td>Relative URL for the item that you want to open when the user clicks the function. For example, to open a Service Catalog item in the Now Mobile portal, enter <code>/mesp?id=sc_cat_item&amp;sys_id=060f3afa3731300054b6a3549dbe5d3e</code>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Relative URL</strong></td>
<td>This field only displays if the Type field is URL. Option that is selected to determine whether the URL is relative. For this example, choose Selected. This field only displays if the Type field is URL.</td>
</tr>
<tr>
<td><strong>Condition</strong></td>
<td>Table on which the condition runs.</td>
</tr>
<tr>
<td><strong>Condition</strong></td>
<td>Condition that should be met for the action to be successful. For a catalog item, enter <code>var item = new sn_sc.CatItem('3f1dd0320a0a0b99000a53f7604a2ef9'); answer = item.canView() &amp;&amp; item.isVisibleServicePortal();</code> to display the quick action only when the end user has permissions to view the item.</td>
</tr>
<tr>
<td><strong>Roles</strong></td>
<td>Roles that you want the user to have to view the quick action.</td>
</tr>
</tbody>
</table>

2. Add an instance of the function that you created to the page.

   a. In the native UI, navigate to **Now Mobile App > Applet Launchers**.

   b. Open the applet launcher record that you would like to add the quick action to.

   c. Select the **Body** tab.

   d. Insert a new row in the Quick Actions Menu Maps related list. If you're not able to insert a row, make sure that you're in the **ServiceNow Now Mobile App Screens and Applet Launcher** application scope.

   e. Click the magnifying glass to look up an item.

   The Function Instances [sys_sg_button_instance] table opens.

   f. Click **New**.

   g. On the form, fill in the fields.
### Function instance form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the function instance.</td>
</tr>
<tr>
<td>Description</td>
<td>Description to enable other users to easily understand the purpose of the function instance.</td>
</tr>
<tr>
<td>Parent</td>
<td>Page on which you are adding the quick action. For example, select <strong>Applet Launcher: Homepage</strong> to add the quick action to the home page. Select a value in the <strong>Parent table</strong> field first.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope.</td>
</tr>
<tr>
<td>Parent table</td>
<td>Table that contains the record type where the button appears. For this example, select <strong>applet Launcher</strong> to add the quick action to an applet launcher page.</td>
</tr>
<tr>
<td>Function</td>
<td>Function record that you created earlier.</td>
</tr>
<tr>
<td>Label</td>
<td>Label to help the user understand what the quick action opens. For example, <strong>Report an outage</strong>.</td>
</tr>
<tr>
<td>Location</td>
<td>Location where the button appears in the UI. For this example, select <strong>Quick Action</strong>.</td>
</tr>
</tbody>
</table>
| Icon         | Icon to display next to the label. For more details on mobile icons, see .LOCATIONS:  

  > **Note:** Not all listed icons work with quick actions. To see a list of compatible icons, filter your list where the **Icons** field contains **now-mobile-icons-buttons**.  

  > **Note:** The **Icons** field is not on the icon list by default. To add the **Icon** field to your list, right-click the list header and select **Configure > List Layout**. Then, add the **Icon** field to the selected list. You should see the icon field on your reference field list.  

| Order        | Number that indicates the order that the functions are listed. If there are multiple instances in the same location, the app displays them from the lowest to the highest. |
h. Click Submit.

i. Save the applet launcher record.

Results

Your users can open the quick action by selecting the + icon on the applet launcher page.

Enable notifications in Now Mobile

Allow push notifications on your mobile device when there is an update for a request.

Procedure

1. Tap Notifications in the navigation bar.
2. Tap the Enable notifications radio button.
   You'll receive a notification in any of the following scenarios.
   • Request Completed (one RITM)
   • Request Completed (multiple RITM)
   • Request not Processed
   • Approval Record Assigned - RITM
   • Approval Record Assigned - Request
   • Request Rejected
   • Agent adds comment to Requested Item

Enable the cart in Now Mobile

Allow a requester to add or edit items in the cart. By default, the cart is disabled in Now Mobile.

Before you begin

Role required: admin

Procedure

1. Navigate to sys_properties.list.
2. For the glide.sc.cart.enabled property, specify Value as true.
3. Click Update. The Cart icon is displayed at the top of the app and the Add to Cart button is enabled for items.
Edit the label of Submit button for a record producer

For a record producer submission experience that you can relate to, edit the label of the Submit button.

Before you begin
Role required: admin

Procedure
1. Navigate to Service Portal > Widgets.
2. Select the SC Catalog Item (widget-sc-cat-item-v2) widget.
3. From the Instances related list, preview and open the instance for the ServiceNow NowMobile App – Catalog Screens and Applet Launcher application.
4. In the Additional options, JSON format field, specify the record_producer_label parameter.
   For example, if you want to change the label to Request, press Ctrl+click on the catalog item widget, select Instance in Page Editor, and specify the following parameters in the Additional options, JSON format field.

   ```json
   "record_producer_label":{
     "value": "Request"
   }
   ```
5. Click Update.

Configure Now Mobile properties
Define the behavior of various catalog entities in Now Mobile.

Before you begin
Role required: admin

Procedure
1. Navigate to Service Catalog > Catalog Administration > Properties.
2. On the Service Catalog Configuration form, select the Mobile section.
3. Configure the required properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog category sort option in NOW Mobile (glide.sc.mobile.category.order_by)</td>
<td>Sort option for categories in Now Mobile.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>• Title:</strong> Categories are sorted by their title. By default, categories are sorted alphabetically by their title.</td>
<td></td>
</tr>
<tr>
<td><strong>• Order:</strong> Categories are sorted by their order</td>
<td></td>
</tr>
<tr>
<td>Include 'Desktop only' Items in NOW Mobile ([glide.sc.mobile.include_desktop_only_items])</td>
<td>Option to include the catalog item with Availability set to Desktop only in Now Mobile.</td>
</tr>
<tr>
<td>Catalog item classes not available in NOW Mobile (comma separated list) ([glide.sc.mobile.item_class_not_supported])</td>
<td>Catalog item types to exclude in Now Mobile. For example, sc_cat_item_content, sc_cat_item_producer</td>
</tr>
<tr>
<td>Experience for items not available in NOW Mobile ([glide.sc.mobile.unsupported_discover])</td>
<td>Option to define the non-availability behavior of a catalog item. Possible options are:</td>
</tr>
<tr>
<td>• Discoverable-show message that item is not viewable in the mobile: Item is discoverable in the search and browse experience but not viewable.</td>
<td></td>
</tr>
<tr>
<td>• Not discoverable-do not show in search and browse experience: Item is neither discoverable in the search and browse experience nor viewable.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td></td>
</tr>
<tr>
<td>• If the AI Search is enabled for Now Mobile, this property is not applicable.</td>
<td></td>
</tr>
<tr>
<td>• This property is supported only when one of the following properties are applicable:</td>
<td></td>
</tr>
<tr>
<td>◦ Include 'Desktop only' Items in NOW Mobile ([glide.sc.mobile.include_desktop_only_items])</td>
<td></td>
</tr>
<tr>
<td>◦ Catalog item classes not available in NOW Mobile (comma separated list) ([glide.sc.mobile.item_class_not_supported])</td>
<td></td>
</tr>
<tr>
<td>Primary color for buttons in the catalog request experience in NOW Mobile ([glide.sc.mobile.primary_color])</td>
<td>Color for buttons in the catalog request experience.</td>
</tr>
</tbody>
</table>
**Important:** The following properties are interdependent.

- Include 'Desktop only' Items in NOW Mobile
- Catalog item classes not available in NOW Mobile (comma separated list)
- Experience for items not available in NOW Mobile

### Dependency between the Include 'Desktop only' Items in NOW Mobile property and Experience for items not available in NOW Mobile property

<table>
<thead>
<tr>
<th>Availability value of the catalog item</th>
<th>Include 'Desktop only' Items in NOW Mobile (true)</th>
<th>Include 'Desktop only' Items in NOW Mobile (false) Desktop only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desktop only</td>
<td>Viewable in search and browse experience</td>
<td>If set as discoverable using the <strong>Experience for items not available in NOW Mobile</strong> property, viewable in search and browse experience, but not available when you click the item.</td>
</tr>
<tr>
<td>[Desktop and Classic Mobile]</td>
<td>Always viewable in search and browse experience</td>
<td>If set as not discoverable, not viewable in search and browse experience</td>
</tr>
<tr>
<td>Classic Mobile only</td>
<td>Not viewable in search and browse experience</td>
<td>Not viewable in search and browse experience</td>
</tr>
</tbody>
</table>

### Dependency between the Experience for items not available in NOW Mobile property and Items excluded using the Catalog item classes not available in NOW Mobile (comma separated list) property

<table>
<thead>
<tr>
<th>Experience for items not available in NOW Mobile property value</th>
<th>Items excluded using the Catalog item classes not available in NOW Mobile (comma separated list) property</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discoverable-show message that item is not viewable in the mobile experience</td>
<td>Item types are viewable in search and browse experience, but not available when you click them.</td>
</tr>
<tr>
<td>Not discoverable-do not show in search and browse experience</td>
<td>Item types do not appear in search and browse experiences</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective owners.
4. Click **Save**.

**Service Catalog topic blocks in Virtual Agent**

You can design a topic conversation in Virtual Agent by including reusable topic blocks to perform request submission tasks.

Activate these plugins:

1. Glide Virtual Agent plugin (com.glide.cs.chatbot) or Glide Virtual Agent Lite plugin (com.glide.cs.chatbot.lite)
2. Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks)

**Search Catalog Item**

You can use this topic block to search for a catalog item based on the search criteria. If there are multiple search results, you can select one from a carousel view.

**Input parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>query_term</td>
<td>Keyword to search for a catalog item. For information on configuring keyword search for a catalog item, see Configure keyword search for catalog items.</td>
</tr>
<tr>
<td>catalogs</td>
<td>Comma-separated list of catalogs where a catalog item should be searched for.</td>
</tr>
<tr>
<td>result_limit</td>
<td>Number of search results that should be displayed. By default, this number is set to 5.</td>
</tr>
</tbody>
</table>

**Output parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>catalog_item_id</td>
<td>If a catalog item is selected, sys_id of the item is returned. If no catalog item is selected, that is, <strong>None of these</strong> option is selected, -1 is returned.</td>
</tr>
<tr>
<td>item_type</td>
<td>sys_class_name of the catalog item that the user selected.</td>
</tr>
<tr>
<td>is_conversational</td>
<td>Specifies if the catalog item can be requested in the conversation mode in Virtual Agent. This is dependent on the <strong>glide.sc.conversational.request.question.limit</strong>.</td>
</tr>
</tbody>
</table>
Request Catalog Item
You can use this topic block to request for a catalog item.

Input parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>catalog_item_id</td>
<td>sys_id of the catalog item that should be requested.</td>
</tr>
<tr>
<td>execute_contextual_search</td>
<td>Option to specify if the contextual search should be run for a record producer based on its configuration. For information on defining contextual search for a record producer, see Define contextual search for record producer.</td>
</tr>
<tr>
<td>confirm_catalog_item</td>
<td>Option to specify whether the user must confirm the catalog item before continuing with the next step. If this is set to false, user can answer the catalog items questions by skipping the confirmation.</td>
</tr>
</tbody>
</table>

Output parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>record_id</td>
<td>sys_id of the record that is generated after the item submission.</td>
</tr>
<tr>
<td></td>
<td>If the catalog item is not supported in the conversation mode or if the user does not have access to the item, -1 is returned.</td>
</tr>
<tr>
<td>record_table</td>
<td>Name of the table in which the record is generated.</td>
</tr>
<tr>
<td>variables</td>
<td>Questions related to the catalog item.</td>
</tr>
</tbody>
</table>

Conditions for requesting a catalog item in a conversation mode
A user can submit a request in the conversation mode (by answering the questions in line).

⚠️ Note: The user can skip non-mandatory questions.

- A catalog item cannot have more than the number of questions specified in the glide.sc.conversational.request.question.limit property. By default, this number is set to 10. For more information about this property, see Service Catalog properties.
• A catalog item can have non-scripted catalog UI policies. These UI policies should be defined such that variables are affected sequentially, that is, only a variable with the lower order affects a variable with the higher order.

• A catalog item cannot have catalog client scripts that are defined for Now Mobile or Service Portal.

• These catalog item types are not supported:
  ◦ Content Item
  ◦ Order Guide
  ◦ Wizard Launcher
  ◦ Standard Change Template

• Only the following variables are supported:
  ◦ Attachment
  ◦ Date
  ◦ Date/Time
  ◦ Email
  ◦ IP Address
  ◦ Label
  ◦ Lookup Multiple Choice
  ◦ Lookup Select Box (without pricing implications and advanced reference qualifier)
  ◦ Multiple Choice (without pricing implications and advanced reference qualifier)
  ◦ Multi Line Text
  ◦ Numeric Scale (without pricing implications)
  ◦ Reference (without pricing implications and advanced reference qualifier)
  ◦ Requested For (without pricing implications and advanced reference qualifier)
  ◦ Select Box (without pricing implications)
  ◦ Single Line Text
  ◦ URL
  ◦ Wide Single Line Text
  ◦ Yes / No
  ◦ Container variables
• The following variable attributes are supported:
  ◦ ref_ac_order_by
  ◦ allowed_extensions
  ◦ max_file_size

• A catalog item can have a variable set.

Related information
  Catalog builder preview topic conversation

Submit a request topic conversation

Users can submit a request in a Virtual Agent conversation.

The Submit a request topic conversation uses the following topic blocks:

• Search Catalog Item
• Request Catalog Item

Using the Submit a request topic conversation, users can submit a request by choosing from all available options. For example, when a user is requesting an item, the Virtual Agent prompts the user to enter a search keyword. After the user enters the keyword, the Virtual Agent responds with available choices in a carousel view.

When the user selects the required item, the following scenarios are possible:

• A user can submit a request in the conversation mode (by answering the questions in line). After the request submission, a URL, which opens up the ticket page, is provided.

  Note: In Now® Mobile, the URL opens the native screen.

• In all other cases, Virtual Agent provides a link for the user to submit the request in the Service Portal defined in the sn_itsm_va.com.snc.itsm.virtualagent.portal_url property.
Note: Now Mobile opens the item in Mobile Employee Service Portal (mesp).

Related information
ITSM Virtual Agent conversation flows

Delegated request experience
You can request a catalog item on behalf of another user or multiple users using the Requested For variable.

Delegated request experience comprises of the following entities:

• Requested For variable for a catalog item. For information about this variable, see Requested For.
• Requested For field on a requested item (RITM)

Note: The form views, list views, and email notifications are not updated to reflect the Requested For field on a RITM.

Configuration options
The following configuration options are available:
• Specify who you want to submit the request for using the Requested For variable. You can also map the Requested For variable to a field on the table for record producers.

• If required, configure the Requested For field on the RITM form. This field automatically stores the value of the Requested For variable.

• Allow delegated requests for a catalog item using its Access Type field, where you can specify if a request can be submitted for a user who does not have access to the catalog item.

• Submit a single request for an item on behalf of multiple users in Service Portal

⚠️ Important: If two-step checkout is enabled, the delegated request experience is not supported.

Request Management
After you submit a catalog item request, the Requested For variable value is copied to the Requested For field of the RITM. In case this field is not available on the RITM form, you should configure it.

⚠️ Note: After you submit a catalog item, the Requested For field value is not automatically updated when the Requested For variable is modified, and vice versa.

In Service Portal,

• If RITMs have different Requested For users, the following information is displayed in the order status page.
  - The Requested For column to display the RITM's Requested For user.
  - When the user viewing the Order Status page is not the user who submitted the request, the Requestor information to display the request's Requested For user. This is also applicable in Now Mobile, when the user viewing the RITM is not the user who requested it.

• If the RITM's Requested For user is different from the request's (REQ) Requested For user, My Requests menu displays the RITM records to the user who the RITM is being requested for. If the RITM Requested for is the same as the REQ requested for user, My Requests menu displays REQs.

• When you create a bundle from the cart by adding a catalog item with a Requested For variable, the item preserves the variable value. When you later add it to the cart to request for another user, you should edit the Requested For variable value as required.
Request experience for a record producer
After you submit a record producer, the Requested For variable value is copied to the target record's field based on the Map To Field configuration.

Request experience for an order guide
This experience is supported in an order guide only if the following conditions are met:

- Order guide has a Requested For variable
- All items in the order guide have a Requested For variable

A catalog item is included in an order guide based on the Requested For user’s access to a catalog item.

- When the user has no access to the catalog item and its Access Type is set as Restricted, that item is not included in the order guide.
- When the user has no access to the catalog item and its Access Type is set as Delegated, that item is included in the order guide.

The Requested For variable value from the Describe Needs section is always cascaded to the Requested For variable of catalog items in rule bases.

- The cascading of the Requested For variable value depends just on the variable type, but not the variable name.
- The Requested For variable value is cascaded even when the Cascade Variables check box is not selected for the order guide.
- The Requested For variables in the included catalog item cannot be edited.

Submitting a catalog item request for multiple users
To support submitting a request for multiple users, you can configure the Requested For variable of a catalog item.

1. From the Type Specifications tab, select the Enable also request for check box.

2. Specify the roles in the Roles to use also request for field that can submit a catalog item request for multiple users. If no role is specified, anyone who has access to the catalog item can submit the request.

After you configure the Requested For variable of a catalog item, the Also request for field is displayed for that item in Service Portal. After you specify multiple users in this field, you can:
• Add the item to the cart
  ◦ Separate cart items are created for each user specified in the Also request for field.
  ◦ The Requested For variable of each cart item is populated with the corresponding user.

• Submit the request
  ◦ A single request is created and assigned to the current logged-in user requesting the item
  ◦ Separate RITMs are created, one for each user specified in the Enable also request for field and the Requested For variable.

Note:
  • This experience is available in Service Portal.
  • This experience is not available in Now Mobile and Workspace.
  • This experience is not available for a record producer and order guide.
  • The Also request for field is not displayed in the wish list and cart.
  • Catalog client scripts, catalog UI policies, and g_form() APIs are not applicable for the Also request for field.
  • The Also request for field is displayed only if the Requested For variable is editable. For example, the field is not displayed if the requesting user has no write permissions for the Requested For variable, or if the variable is made read-only via catalog client scripts.
  • You can add up to a maximum of 50 users in the Also request for field.
  • If any of the users does not have access to a catalog item with Access Level set as Restricted, then the item cannot be added to cart.

Request cloning
When you clone a request:

• The Requested For value for the cloned request is updated with the user for whom the request is being cloned.

• The Requested For value for cloned RITMs (with or without a Requested For variable) is updated with the user for whom the request is being cloned for the following entities:
  ◦ RITM Requested For user
  ◦ Requested For variable value
For information about cloning requests, see Clone requests.

**Important:**

- You can clone a request only when all RITMs are requested for the same user.
- You cannot clone a request for a user who does not have access (based on Access Type) to any item in the request.
- Variable dependencies on the Requested For variable are not considered when a request is cloned.

**Cart behavior**

Using the Requested For variable, you can add multiple catalog items to the cart for different users and submit the cart as one request. When you submit a request for a cart with multiple items, a single request is created with separate RITMs, one for each catalog item. In this case, the Requested for field of each RITM inherits the corresponding Requested For variable value.

When you add multiple items to the cart for different users and submit the request, a single request is created with a separate RITM for each catalog item with the corresponding Requested For user.

**Cart submission scenarios**

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Cart behavior</th>
</tr>
</thead>
</table>
| All items in the cart have a Requested For variable and are requested for the same user | - Requested For value of the RITM is the Requested For variable value.  
- Requested For value of the request is the Requested For variable value. |
| All items in the cart have a Requested For variable and are requested for different users | - Requested For value of the RITM is the Requested For variable value.  
- Requested For value of the request is the logged-in user or the default Requested For user specified in the cart. |
| No items in the cart have a Requested For variable | - Requested For value of the RITM is the default Requested For user specified in the cart.  
- Requested For value of the request is the logged-in user or the default Requested For user specified in the cart. |
Cart submission scenarios (continued)

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Cart behavior</th>
</tr>
</thead>
</table>
| Few items in the cart have a Requested for Variable while others do not  | • Requested For value of the RITM is one of the following:  
  ◦ If a Requested For variable exists, it is the variable value.  
  ◦ If no Requested For variable value exists, it is the logged-in user or the default Requested For user specified in the cart.  
  • Requested For value of the request is the logged-in user or the default Requested For user specified in the cart. |

**Passing parameters for the Requested For variable**
You can use parameters in Now Platform and Service Portal to specify the default Requested For variable value for a catalog item.

- In Platform, pass a user's sys_id as the `sysparm_requested_for` value in the URL.
- In Service Portal, specify the `requested_for_id` and `requested_for_display` parameters in widget instance options.

For example, navigate to a catalog item widget, press Ctrl+click to select **Instance in Page Editor**, and specify the following parameters in the **Additional options, JSON format** field.

```json
"requested_for_id": "a8f98bb0eb32010045e1a5115206fe3a
"requested_for_display": "Abraham Lincoln"
```

⚠️ **Note:** The Requested For value is set after the catalog form is loaded.

**Related reference**

Types of service catalog variables

**Configure the default behavior to request items for other users**
Define the default behavior when no roles are specified in the `glide.sc.req_for.roles` property.

**Before you begin**
Role required: admin
About this task
The `glide.sc.req_for.roles` property specifies the list of roles who can request items for other users. When no roles are specified, then the default behavior is defined by the `glide.sc.req_for.roles.default` property. For information about the `glide.sc.req_for.roles` property, see Service Catalog properties.

Following are the possible values for the `glide.sc.req_for.roles.default` property.

- When the property is set to `allow`, then any user can request items for other users.
- When the property is set to `deny`, then no user can request items for other users.

The value of the `glide.sc.req_for.roles.default` property is considered as `allow` in any of the following scenarios and any user can request an item for other users:

- The `glide.sc.req_for.roles.default` property is not defined.
- The value of the `glide.sc.req_for.roles.default` property is empty, `allow`, or any string other than `deny`.

A user with the admin role can request an item for other users. In this case, values of both the properties, `glide.sc.req_for.roles` and `glide.sc.req_for.roles.default`, are not considered.

For zBoot customers, the `glide.sc.req_for.roles.default` property is available in the base system with the default value as `deny`. Upgrade customers can add and modify the property if required.

Procedure
1. Navigate to `sys_properties.list`.
2. Select the `glide.sc.req_for.roles.default` property.
3. On the System Property form, in the **Value** field, specify the value.
4. Click **Update**.

Service Catalog request fulfillment
When a user orders a catalog item, a request is created that follows a fulfillment process. A fulfillment process defines the steps to request approval, assign fulfillment tasks, and fulfill requests. Execution plans or workflows are used to define fulfillment processes.
Introduces request fulfillment in Service Catalog, provides a comparison of execution plans versus workflows, and demonstrates creating an execution plan and a workflow.

Preparing to fulfill catalog item requests involves the following activities.

- Set up fulfillment groups to assign to tasks.
- Define the fulfillment processes using execution plans or workflows.
- Assign the fulfillment process to catalog items.

**Using workflows**

Workflows provide greater flexibility than execution plans, which are linear. Workflows allow for different paths to the end of the process. For example, an approver can reject a request, ending the process. If the request is approved, the process continues through fulfillment to the end of the process.

Use the Workflow Editor to define fulfillment workflows. The Workflow Editor offers the following features.

- Edit workflows graphically.
- Modify activities and conditions.
- Define transitions between workflow activities.
- Summarize workflow progress through stages.
- Validate workflows to identify potential problems.
- Publish workflows for other users.

**Service catalog workflows**

Two service catalog workflows are provided in the base system. Use the Graphical Workflow Editor to modify the default workflows or to create additional service catalog workflows. Service catalog workflows support domain separation.

**Default service catalog workflows**

- **Service Catalog Request**: a simple workflow that fulfills a simple order.
- **Service Catalog Item Request**: a more complex workflow that fulfills a more complex order.
Defining service catalog workflows
Creating a workflow involves the following processes:

- Create a workflow to process the catalog item.
- Define the workflow activities to process the catalog item.
- Publish the catalog item workflow.
- Create or edit a catalog item to call the catalog item workflow

Note: If your catalog workflow requires catalog tasks to access catalog variables, create the catalog tasks from a parent workflow. A catalog workflow cannot access catalog variables from catalog tasks created by a subflow.
Deleting catalog workflow records
Workflow stage fields for service catalog workflows display when a user deletes a record required by the workflow. If a user deletes a catalog item and that catalog item has active request workflows running, the workflow stage field displays **Catalog item removed**. Similarly, deleting the associated workflow context causes the stage field to display **Workflow context removed**.

Associating items with the domain-specific workflow
When using service catalog workflows with domain separation, ensure your catalog items use the domain-specific workflow. If you create a domain-specific version of a workflow, existing catalog items continue to use the original workflow. To configure the catalog item to use the domain-specific workflow, select the new workflow in the **Workflow** field on the catalog item record.

Create a catalog workflow
Create service catalog workflows when the default workflows are not appropriate for a fulfillment process.

**Before you begin**
Role required: workflow_creator, workflow_admin, or admin

**About this task**
This example describes the procedure to set up fulfillment for a laptop request.

**Procedure**
1. Navigate to **Workflow > Workflow Editor**
2. Click **New Workflow**.
3. Complete the form with the following information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Laptop Fulfillment</td>
</tr>
<tr>
<td>Table</td>
<td>Requested Item [sc_req_item]</td>
</tr>
</tbody>
</table>

Consider the following information:

- Workflows on the Service Catalog Requested Item [sc_req_item] table fulfill the request of a single catalog item. Each requested item triggers its own fulfillment workflow when the item is ordered. Use the Requested Item table to add workflows for requested items.

  **Note:** To enable approval-type workflows to operate smoothly, make sure that the appropriate users have the correct role to access necessary tables in all domains.

- Use caution when using `before query` business rules, as they can restrict access to the requested item record.

- Workflows on the Request [sc_request] table always run when a service catalog request is submitted, regardless of what item was ordered. These workflows control the entire request process, which can involve delivering several requested items.
Therefore, Request table workflows are not assigned to a specific item from the maintain item form. If you do use the Request table for service catalog requests, add conditions to the workflow to ensure it runs when the correct item is requested.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expected time</td>
<td><strong>Days 7, Hours 00:00:00.</strong> Workflows cannot calculate the end time because not all the activities within the workflow have defined times. Therefore, the Expected time on the workflow becomes the Delivery Time on the catalog request.</td>
</tr>
<tr>
<td>Schedule</td>
<td><strong>8–5 weekdays.</strong></td>
</tr>
<tr>
<td>Timezone</td>
<td><strong>US/Pacific.</strong> The timezone that the schedule applies to.</td>
</tr>
<tr>
<td>Description</td>
<td>A workflow for the fulfillment of laptop requests.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
What to do next
After initiating a workflow, add workflow activities to it. Workflow activities are listed on the Core tab in the right pane.

Add an activity to a catalog workflow
You can add activities to a workflow to perform tasks such as running a script, sending notifications, or requesting approvals. Activities can succeed or fail, which can result in actions performed by other activities.

Before you begin
Role required: workflow_creator, workflow_admin, or admin

About this task
After creating the workflow to add a laptop fulfillment process, add the activities.

Procedure
1. Complete the following steps to add an activity that requests manager approval.
   a. In the Core pane, expand Approvals and drag the activity Approval - User onto the arrow between Begin and End. This activity generates an approval from the manager of the person requesting the laptop.
   b. Complete the form with the following information.
      • Name: Manager Approval
      • Stage: Waiting for Approval
      • User: Click the lock icon in the Approvers section, and then click the select fields icon. Expand Requested > Requested For, and then select Manager.
   c. Click Submit.
2. Complete the following steps to add an action for when the approver rejects the request.
   a. Expand Utilities in the Core pane and drag the activity Set Values to the space below the approval.
   b. Complete the form with the following information.
• Name: Rejected
• Stage: Completed
• Values condition builder: [Approval] [Rejected]

c. Click Submit.

d. Drag from the yellow box beside Rejected on the Approval - User activity to the new Set Values activity.

e. Drag again from the yellow box beside Always on the Set Values activity to End.
This activity marks the request as rejected if the manager rejects the request and then ends the workflow.

3. Complete the following steps to add an action for when the approver approves the request.

a. Drag the activity Set Values onto the arrow between Approval - User and End.

b. Complete the form with the following information.
• Name: Approved
• Stage: Fulfillment
• Values condition builder: [Approval] [Approved]
This activity marks the request as approved once a manager approves it.

c. Click Submit.

4. Expand Tasks and drag the activity Create Task onto the arrow between Approval - User and End, add the following information, and click Submit.
• Name: Laptop Procurement
• Stage: Fulfillment
• Task Type: Catalog Task [sc_task]
• Priority: 3 - Moderate
• Fulfillment group: Procurement
• Short description: Procure a Laptop
This task tells Procurement to procure a laptop for the user.
5. Expand Notifications and drag the activity Notification onto the arrow between Laptop Procurement and End, add the following information, and click Submit.

- **Name**: Procurement
- **Stage**: Fulfillment
- **To**: Click the lock icon in the Addressee(s) section, and then click the select fields icon. Expand Requested and select Requested For.
- **Subject**: Your laptop has been procured.

This activity marks the request as approved if a manager approves it.

6. Drag the activity Create Task onto the arrow between Procurement and End, and then fill in the form.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Set Up Laptop</td>
</tr>
<tr>
<td>Stage</td>
<td>Fulfillment</td>
</tr>
<tr>
<td>Task Type</td>
<td>Catalog Task</td>
</tr>
<tr>
<td>Priority</td>
<td>3 - Moderate</td>
</tr>
<tr>
<td>Fulfillment Group</td>
<td>Hardware</td>
</tr>
<tr>
<td>Short Description</td>
<td>Set up laptop.</td>
</tr>
</tbody>
</table>

This task tells Hardware to configure the laptop and prepare it for use.

7. Drag the activity Create Task onto the arrow between Set Up Laptop and End, add the following information, and click Submit.

- **Name**: Pickup Laptop
- **Stage**: Delivery
- **Task Type**: Catalog Task [sc_task]
- **Priority**: 3 - Moderate
- **Assigned to**: Leave the field blank, as the script in the Advanced field assigns this task to the requester.
- **Short description**: Pick up laptop.
- **Advanced**: Select the check box and set the Advanced Script value to:

  ```
  task.assigned_to=current.requested_for;
  ```

This task informs the requester to come pick up the laptop.
8. Drag the activity **Log Message** onto the arrow between **Pick Up Laptop** and **End**, add the following information, and click **Submit**.

- **Name**: Delivered
- **Stage**: Completed
- **Message**: The laptop delivery workflow is complete.

Leaves a message in the log to record the successful completion of the workflow.

**Publish a catalog workflow**

Publish the catalog workflow to make it available for use in the system.

**Before you begin**

Role required: workflow_creator, workflow_admin, workflow_publisher, or admin

**About this task**

After adding activities to your workflow, publish it to make it available for use.
Procedure

1. Open the workflow actions menu on the left beside the workflow name.
2. Click **Publish** to publish the workflow.

Execution Plans

An execution plan describes how a catalog item is procured, configured, and installed.

Execution plans enable you to describe simple, linear processes. Each execution plan contains one or more tasks. For example, an organization could create an execution plan for delivering a corporate standard PC that contains these tasks:

1. Procure the PC from a supplier.
2. Configure the PC according to requester specifications.
3. Deliver the PC to the requester.
An execution plan is not specific to any one catalog item. There could be many different models of PC that a user can order, all using the same execution plan. It is not necessary to create a new execution plan for each individual catalog item in a mature service catalog.

**Note:** Execution plans are not as powerful or flexible as workflows, and cannot be designed using a graphical editor. Execution plans are useful in some circumstances, for example, if you want to build your processes programmatically or through imports. ServiceNow recommends using workflows for request fulfillment processes.

Create an execution plan
Administrators and catalog administrators can create and manage execution plans and the associated variable tasks.

**Procedure**
1. Navigate to Service Catalog > Catalog Administration > Execution Plans.
2. Click New.

   ![New execution plan](image)

3. Enter a **Name** and **Short description** for the execution plan.
4. Specify **delivery information** in the Total delivery time and On Calendar fields.
5. Click **Submit**.

Add catalog item variables to a task
You can add variables of a catalog item to a task to specify information about the requested catalog item.

About this task
For example, when a user requests a laptop, the fulfillment group can need to know what screen size and how much memory to order.
Each catalog item can contain one or more variables for gathering information from the user who requests the item. Assuming that the relevant catalog items have been associated to the execution plan, you can associate these variables to the specific created tasks that need the information.

**Procedure**

1. Navigate to **Service Catalog > Catalog Administration > Execution Plans**.
2. Open an execution plan.
3. In the **Execution Plan Tasks** related list, open a task.
   - Ensure that the form shows the Plan view. If not, right-click the header bar and select **View > Plan**.
4. Go to the **Available Variables** related list and click **Edit**.
5. Use the slushbucket to select the variables that are appropriate for the task.
   - Consider all the types of catalog items that could use this execution plan, and select all the variables that can be assigned to them.
6. Click **Save** to associate these variables to the execution plan task, making them accessible.

**Execution plan tasks**

An execution plan contains one or more execution plan tasks, such as for obtaining approval. Execution plan tasks are assigned to a fulfillment group. Each task represents work to be completed by a specific group as part of the overall request fulfillment process.

Administrators create templates for tasks as part of defining an execution plan. The catalog tasks themselves are then created when the relevant item is requested, based on these task templates.

**Set up an execution plan approval task**

Approval tasks are specific types of tasks within execution plans.

**About this task**

If an approval task is rejected, the execution plan can roll back to a previous task, but the approval record does not roll back.

To set up an approval task including a rollback action:
Procedure

1. Navigate to Service Catalog > Execution Plans.
2. Select an execution plan.
3. From the Execution Plan Tasks related list, select New Approval to create the approval task.
4. Fill in the fields for that approval task.

Upon Reject

5. Use the Upon reject field to define the action to take if the task is rejected:
   • Cancel all future Tasks: [default] cancels all future tasks in the execution plan and also cancels the parent request item.
   • Go to a previous Task: displays the Rejection goto field where you can select which task this execution plan rolls back to.

6. Save the task, then scroll down to the Approved By list and select one or more approvers for the tasks.
   You can also use an Approval script to select approvers.

7. Select Update to add the task to the execution plan.
   This example shows how the process works in practice, using a request to order a Blackberry phone.
   First, the request is ordered:
Next, complete the first two steps, which leads to the approval task.

Reject the request to roll back the execution plan to a previous task, and reset any intermediate tasks to pending:
Rollback 3

After a plan has been rolled back, ServiceNow adds to the rolled-back task a note indicating that it was rolled back and why.

ℹ️ **Note:** Rolling back reverts all intermediate tasks within the execution plan. Other plans within the same request are not rolled back, however.

**Set up a fulfillment group**

Fulfillment groups perform the tasks related to fulfilling an order.

**About this task**

This group setting can include approving an order based on characteristics such as content and price, or any direct action required to complete the order. For example, loading software or installing hardware. Any existing user group (in **User Administration > Groups**) can be assigned fulfillment tasks.

To create a group specifically for order fulfillment:

**Procedure**

1. Navigate to **Service Catalog > Catalog Policy > Fulfillment Groups**.
2. Click **New**.
3. Fill in the Group form as described under creating groups.
   These groups have the type **catalog** and are assigned the catalog and itil roles, but are otherwise normal groups.
Delivery information for tasks

When managing execution plans, catalog administrators can specify the delivery information to provide an estimated date of delivery based on the execution plan.

Use the **Total delivery time** field to specify an estimated delivery time for each task in your execution plan. This estimate is calculated based on the combined total of times for the tasks in that execution plan.

By default, time estimates do not use a “working days” calendar system, but are based on simple elapsed time. For example, for a 5-day execution plan, if you submit the request on a Friday, the delivery date is Wednesday of the following week. This estimate means five elapsed days later, even if your organization does not work on weekends.

Setting the calendar to Monday through Friday (9-5) defines each day as being eight hours long, but the task delivery time day is 24 hours. If you create a task that takes one day (24 hours), the plan calculates the task as needing three work days (which are eight hours each) for the total delivery time. Similarly, if a task takes two days (48 hours), the plan calculates eight days of total delivery time. This total breaks down as six work days of eight hours each and, because six days are longer than the five-day work week, two weekend days. When assigning delivery times, keep this calculation process in mind.

Use the **On Calendar** field to specify a calendar system to apply to the execution plan, to help estimate more accurate delivery times.

If using this calendar system for estimated delivery time, ensure that estimates are expressed in working hours and days. For example, a task which is supposed to take one day on a 9-5 calendar is assumed to take 24 working hours. This process takes three working days.

**Note:** This calendar system is used to help provide delivery estimates only, and is not linked to any SLAs you have set on execution tasks.

Skipped tasks

If a task is skipped, the request fulfillment process moves on to the next task.

If the last task in an execution plan is skipped, the process is finished and the appropriate request item is closed as complete. Skipped tasks have their state set to **Closed Skipped** and display as gray boxes on a requested items list.
Creating execution plan tasks

An execution plan contains one or more task templates. Each task template defines work that can be completed by a specific fulfillment group.

Execution plans are associated with catalog items. When the relevant catalog item is requested, these task templates are used to generate tasks. That is, tasks to be performed as part of the request fulfillment process for that requested item. Each generated task within that requested item is assigned a catalog task number.

Example

The execution plan for an executive desktop computer catalog item could define the following task templates in the execution plan:

- Obtain managerial approval
- Order hardware
- Install standard corporate applications
- Deliver computer to requester

When this catalog item is ordered, the following request, requested item, and tasks are then created:
• Request REQ0002 -- 1 PC
  ◦ Requested Item ITEM0004 -- 1 X executive desktop
    ▪ Catalog Task0001 -- Obtain managerial approval
    ▪ Catalog Task0002 -- Order hardware
    ▪ Catalog Task0003 -- Install standard corporate application
    ▪ Catalog Task0004 -- Deliver computer to requester

Define task templates
Each execution plan contains one or more task templates that define actions that must be taken to fulfill a request.

About this task
After creating the execution plan, define these task templates.
When the relevant catalog item is ordered, request tasks are generated for that requested item, based on this information.

To define an execution plan task template:

Procedure
1. Navigate to Service Catalog > Catalog Policy > Execution Plans.
2. Open an execution plan.
3. In the Execution Plan Tasks related list, click New.
4. Fill in the fields on the Execution Plan Task form (see table).
5. Click Submit.
Defining Task Templates

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the task. This name becomes the created task name.</td>
</tr>
<tr>
<td>Fulfillment group</td>
<td>The group that performs the task. Whenever a user requests a catalog item associated with this execution plan, the task is automatically assigned to the fulfillment group. Leave blank if automatic assignment to a group is not required.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The individual who performs the task. Leave blank if automatic assignment to a user is not required.</td>
</tr>
<tr>
<td>SLA</td>
<td>The service level agreement that applies to catalog items associated with this execution plan.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field is normally left blank, as the functionality was superseded by the service level management functionality.</td>
</tr>
<tr>
<td>Delivery plan</td>
<td>The parent execution plan for this task.</td>
</tr>
<tr>
<td>Order</td>
<td>A number representing the task sequence in the execution plan. It is good practice to &quot;leave gaps&quot; between order numbers (for example, 100, 200, 300). That way you can insert new tasks without changing the order number of existing tasks. (If the order for several execution plan tasks is the same, each of these tasks starts at the same time.)</td>
</tr>
<tr>
<td>Delivery time</td>
<td>Amount of time the task is expected to take. This value becomes a component of the overall time to complete the execution plan.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition under which the task is performed (if the condition is not met, the task is skipped).</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the task activity. This information populates the created task short description field.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Details of the activities to be performed for the task. This information populates the created task description field.</td>
</tr>
<tr>
<td>Work notes</td>
<td>A journal field for entering comments about the task template. Note: this information is separate from the created task work notes field.</td>
</tr>
</tbody>
</table>

**Conditions to run execution plan tasks**

Administrators and catalog administrators can define conditions under which a particular execution plan task runs, or is skipped, when the relevant item is requested.

For example, an execution plan can contain the following tasks:

1. Order hardware
2. Receive hardware
3. Configure hardware
4. Deliver hardware
If the hardware requested is already on-site, it does not need to be ordered. The first task in the list can be skipped.

**Note:** Skipped task records are still created, but are marked as skipped, and are not processed within the execution plan.

### Conditional Tasks

To make an execution plan task conditional, defining the conditions under which the task runs.

1. Navigate to **Service Catalog > Execution Plans**.
2. Open an execution plan, and then open a task within that plan.
3. Use the **condition** field to select the condition under which the task runs.

If no conditions are set, the task runs every time a user orders an item associated with this execution plan.

Here is an example of conditional task for an IT lab based in Atlanta:

**Applying Conditions to Execution Plan Tasks**

In this example, the **Deliver to IT Labs** step does not run if the request itself is in Atlanta. There is no need to deliver something to the IT lab if it is already there.
Condition scripts to run tasks

Administrators can use a condition script in addition to or instead of any condition to determine whether a task runs.

⚠️ **Note:** If you are using both a condition (via the condition field) and a condition script, both must be true before the task runs.

To use a script, you must configure the Execution Plan Task form to add the "Condition script" field. If the script returns true, the task runs. If the script returns false, the task does not run.

Ensure that you add the variable used in the script to the execution plan task.

Service catalog execution plans

Service catalog enables you to associate execution plans with catalog items.
Once you have created the execution plan record, you can associate it with catalog items, create task templates, and associate any catalog item variables to tasks, if required.

You can also:

• Apply conditions to tasks
• Create approval tasks, enabling you to step back to a previous step if the approver rejects the request.

## Associate execution plan with items

After you submit the execution plan record, you select a catalog item to use the execution plan.

### About this task

This association can be done later, but doing it at this stage enables you to access relevant catalog item variables in the execution plan.

### Procedure

1. Navigate to Service Catalog > Catalog Definition > Maintain Items.
2. Select a catalog item.
3. In the Execution Plan field, select the new execution plan.
4. Click Update.

### Service Catalog checkout models

The service catalog defaults to one-step checkout model, but also allows two-step checkout. Administrators and users with the catalog_admin role can enable and configure the two-step checkout model and control how the delivery address is populated.

The service catalog defaults to a one-step checkout model. When a user clicks Proceed to checkout or Order now, items in the shopping cart are ordered and the order summary or status screen appears. The one-step checkout model runs in the following order:

- Press Checkout > Order Summary

The service catalog also supports a two-step checkout model. Under this model, when a user clicks Proceed to checkout or Order now, an order confirmation screen appears. You can edit the order, choose a delivery location, or upload an attachment before submitting the order. The two-step checkout model runs in the following order:
Press Checkout Order > Confirmation Screen > Submit Order > Order Summary.

Access check for a catalog item is performed during its checkout. This check is also applicable in scripts and APIs.

Enable the two-step checkout process

You can enable the two-step checkout to specify a recipient, delivery address, and special instructions for an order.

Procedure

1. Navigate to Service Catalog > Catalog Administration > Properties.
2. Locate the property Use the two step catalog checkout model (default false).
3. Select the Yes check box to enable the two-step process.
4. Locate the property Show the 'Back to Catalog' button on the two step checkout screen.
5. Select the Yes check box to provide a button that navigates back to the catalog from the order confirmation screen (default). Clear the check box to hide the button.

Specify requester location

Administrators can control how the delivery address is populated. By default the delivery address is defined by the client script called set location.
When the two-step checkout process is enabled, the set location script retrieves the address of the user and enters formatted details in the Deliver to field.

Create a catalog request from another flow

You can create a catalog request to join the Service Catalog flow from a different flow. For example, from an incident flow, you can create a request, and associate the request with the incident. It helps you in tracking the requests associated with an incident and vice versa.

Before you begin

Role required: itil

- To associate a request with any parent table record, the corresponding mapping configuration should be available in the Catalog Administration > Request Parent Mapping submodule.
- To associate a record producer request with the parent table record, retrieve the sysparm_parent_sys_id and sysparm_parent_table parameters from the URL using the RP.getParameterValue() method in the Script field of the record producer.

Note: If you set the Use the sc_layout driven cart macros (default true) (glide.sc.use_cart_layouts) property to false and create a request from a parent table record, the request is not associated with the parent table record.
Procedure

1. Navigate to the required table and select a parent record.

2. Click the additional actions menu icon and select Create Request. The Catalogs home page is displayed with all active catalogs that you can access.

   Note: If there is only one active catalog, then that catalog page is displayed with available categories.

3. Select the required catalog and navigate through its categories and items.

4. Checkout the required catalog item, order guide, or record producer. For information on checkout models, see . For a catalog item or order guide, a request is created and displayed under the Requests tab of the parent table record. For a record producer, the corresponding task is created and displayed under the Problems tab of the parent table record, for example, an incident.

   Note:
   - The associated incident is specified in the annotation message throughout the request process.
   - Both for the one-step and two-step checkout, the caller of the incident is automatically set as the Requested For user for the request. If the two-step checkout is enabled, the fulfiller can change the Requested For.

   Note: For delegated request experience, the caller of the incident is populated in the Requested For variable. For information on delegated request experience, see Delegated request experience.

   - You cannot add items to the wish list, or save a record producer in this flow.

Configure a parent mapping for a request

You can configure a mapping that specifies the association between the parent record and the request record.

Before you begin
Role required: admin or catalog_admin
Procedure

1. Navigate to Catalog Administration > Request Parent Mapping.

   ⚠️ **Note:** The Incident request configuration that creates a mapping between the incident table and the request table is available by default.

2. Click **New** and specify the field information.

**Request Parent mapping fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the mapping configuration for a request.</td>
</tr>
<tr>
<td>Parent table</td>
<td>Table from which the request is created.</td>
</tr>
<tr>
<td>Request Parent</td>
<td>Request table field that specifies the association with the parent table.</td>
</tr>
<tr>
<td>Parent requestor</td>
<td>User reference field on the parent table that is specified as the requestor of the request.</td>
</tr>
</tbody>
</table>

   ⚠️ **Note:** For delegated request experience, the user from the parent table record is populated in the Requested For variable. For information on delegated request experience, see Delegated request experience.

3. Click **Submit**.

**State closure in the request fulfillment execution plan**

The state closure in the request fulfillment process of a catalog item depends on the status of the associated catalog tasks, request items, and the request. It is applicable only for execution flows.

**State closure dependency between a catalog task and RITM**

- If all catalog tasks are closed as **Closed Complete**, the RITM is closed as **Closed Complete**.
- If there is at least one catalog task closed as **Closed Incomplete**, the RITM is closed as **Closed Incomplete**.
- If all catalog tasks are closed as **Closed Skipped**, the RITM is closed as **Closed Skipped**.
State closure dependency between a RITM and request

- If all RITMs are closed as **Closed Complete**, the request is closed as **Closed Complete**.
- If there is at least one RITM closed as **Closed Incomplete**, the request is closed as **Closed Incomplete**.
- If all RITMs are closed as **Closed Skipped**, the request is closed as **Closed Skipped**.

Service Catalog for managers and end users

Every user with a login can view and order items from the Service Catalog from departments within your organization. These catalog items can include goods, services, and information.

Anything that can be ordered individually can be ordered as a catalog item. Anything that only exists as a part of a larger whole cannot be a catalog item. For example, a laptop can be a catalog item, but a high-resolution display for a laptop cannot.

After placing an order, its progress can be tracked by the requester. Fulfillment groups complete a predefined series of tasks in a fulfillment process that includes required approvals.

Managers can review record history and run reports to improve the service catalog process. For example, the manager can see most commonly ordered items, or those that are on backorder.

Service Catalog home page

The home page for a service catalog lists the goods and services available to order from that catalog.

Catalog items are grouped into categories, which can also contain one or more subcategories. By default, the first 10 items in a category appear under the category name on the service catalog home page.

To access the default service catalog home page, navigate to **Self-Service > Service Catalog**.
Click a category name to see a list of all subcategories and items in the category.
Searching a service catalog

If your organization has multiple service catalogs, you can search for the required catalogs using the Search field. The search results list items in active categories along with their short description.

Note: If your organization has multiple service catalogs, searches return results only from the currently viewed catalog.

To find a specific item in a catalog, use the Search field. Click the down arrow to see a list of previous searches. Catalog search is available on catalog and category pages.
Search results list items in active categories along with their short description. Use the breadcrumbs in the header bar or below the short description to quickly navigate to a different page. The **Found In** list shows the categories related to the search results in hierarchical format.

You can control the number of results shown on one page with the search results selection list.

In the catalog listing, click a link in the breadcrumbs at the top of the screen to quickly navigate back one or more levels in the hierarchy.

To remove the search term from the breadcrumbs, click the **x** next to the term.
If a search returns multiple results, obtain details about a specific catalog item by clicking **Preview**.

**Note:** The system performs the type-ahead search based on keywords only.

**Related information**

- Service Catalog for managers and end users

**Service Catalog request screens**

To place a request from a service catalog, navigate to the catalog home page and select the item to order.

When an item is ordered, the base system generates a request to track the order and displays a summary that includes the order status in the **Stage** column:

![Service Catalog Request Status](image)

Each individual catalog item in a request creates a discrete request item. For example, a request for 2 PCs, 1 chair, and 1 desk would produce four request items on a single request.

**Shopping cart screens**

The shopping cart screen displays previews of the cart immediately before an order is placed.

You can configure the layout for either the one-step or two-step catalog checkout process.

**Order status screens**

The order status screen is the final summary screen a user sees in the service catalog after placing an order successfully.
Request generation for a Service Catalog item

When a customer orders something from the catalog, a request is generated to track the order.

The user specified in the **Opened By** field of a Requested Item (sc_req_item) record has read access to it.

Each individual catalog item that is part of a request creates a discrete request item with the request.

For example, a request for 2 PCs, 1 Chair, and 1 Desk would produce:

- Request REQ0000001 -- 4 Things
  - Requested item RITM0000001 -- 2 X PC
  - Requested item RITM0000002 -- 1 X Chair
  - Requested item RITM0000003 -- 1 X Desk

After a service catalog request is submitted, a fulfiller may determine that the item is not in stock. The full filler can select the **Backordered** check box, and enter comments about when the item may be back in stock. The backorder status can be used in reports and dashboards.

If a service catalog request is canceled, all associated purchase orders and transfer orders that have not been received are canceled.

**Clone a request**

You can clone a request for up to 10 users on the notification list.
About this task
When you clone a request that contains a multi-row variable set, the information that is specified in the multi-row variable set is available in all cloned requests. All UI policies and client scripts on the multi-row variable set are also cloned.

Procedure
1. Create a Service Catalog request.
2. On the checkout page, enter the users for whom to copy the request, up to a maximum of 10, in the Copy this Request for: reference fields.
3. Click Order Now.

View catalog item audit history
You can view the audit history of changes to items you requested. For example, you can view changes to variable values to find out who made the changes. Fulfillers and administrators can view history for any requested item.

Before you begin
Role required: admin (history list or calendar), itil (calendar only)

Procedure
1. Complete one of the following actions for the history to view.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View history for your requested items</td>
<td>Navigate to Self-Service &gt; Requested Items and open the item you requested.</td>
</tr>
<tr>
<td>View history for any requested item</td>
<td>Navigate to Service Catalog &gt; Open Records &gt; Items and open the requested item to view.</td>
</tr>
</tbody>
</table>

2. Open the form context menu and select History > Calendar, or History > List (with permission).
   The history calendar shows you the days where the record was changed, who made the change, and when. The history list displays each change in a list view. History records of variables are prefixed with "VARIABLE::".

3. Click the day number to get a view of the changes for that day, or click the week number to get the week view.
Saving catalog items to a wish list

You can save catalog items to your wish list and visit them later to complete the ordering process.

For example, you need a laptop with specific software installed on it. Add the laptop to your wish list, then visit it when you have the complete software configuration list. Data you enter is saved when you add items to your wish list.

Users with catalog_admin or admin role can enable/disable the wish list feature and configure the wish list cart for end users. By default, the wish list is always disabled for a catalog.

To enable the wish list feature for catalog end users, select the check box for Enable Wish List in the catalog record.

The wish list feature does not function if the property glide.ui.doctype is set to false.

Catalog homepage displaying wish list feature

![Catalog homepage displaying wish list feature](image)

**Note:** When the wish list feature is disabled for a catalog, any items in its wish list are deleted. The items in the wish list are retained only if the item is associated with another wish list-enabled catalog.

Working with wish lists

To save an item to your wish list, click Add to Wish List on the catalog item page. A pop-up dialog informs you that the item is added to your wish list. Duplicate entries of an item are not added to your wish list. If you try to add an item that is already in your wish list, the latest entry of that item gets updated in the wish list.
Wish list popup dialog

Added to Wish List

Apple iPad 3

Continue Shopping  View Wish List

To access your wish list of catalog items, click View Wish List on the popup dialog. You can also click the link to wish list items on the header. The wish list cart allows you to update or delete wish list items.

To update a wish list item, go to wish list cart and click View for the item. Change the information, and then click Update to save the changes. To proceed with ordering the item, click Add to Cart. The item is removed from your wish list and added to the shopping cart for final checkout.

Debug UI customizations for a Service Catalog page

Perform the health check of a Service Catalog page. The UI Page Customization Diagnostics window displays the UI macros applicable for the Service Catalog page and their corresponding states. For issues on a Service Catalog page due to customized UI macros, you can identify the source of broken functionality.

Before you begin
Role required: admin or catalog_admin.
Watch this seven-minute video to learn more about UI customization debugging, variable action logger, variable watcher, and the Item Diagnostic report. Features available for debugging Service Catalog issues including UI macro customization debugging; variable action logger; variable watcher; item diagnostic report

Procedure
1. Navigate to Service Catalog > Catalog Administration > Debug UI Customization.
   The UI Page Customization Diagnostics window is enabled.
2. Navigate to a Service Catalog page that you want to debug.
3. Review the information in the UI Page Customization Diagnostics window at the bottom of the page.
   To maximize the UI Page Customization Diagnostics window, click . The following information is displayed:
• Name of the current Service Catalog page.
• State of the Service Catalog page.
• All UI macros applicable for the Service Catalog page.
• State of each UI macro. For details on possible states, click the Help icon (❓).
• Number of occurrences of each UI macro in the Service Catalog page.

### Possible states for a UI macro and a Service Catalog page

<table>
<thead>
<tr>
<th>State</th>
<th>Color indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unchanged</td>
<td>Green</td>
<td>Created by ServiceNow and one of the following scenarios is applicable:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• It has never been customized by the customer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• It has been customized by the customer and then reverted to the latest ServiceNow upgrade.</td>
</tr>
<tr>
<td>Skipped</td>
<td>Red</td>
<td>Created by ServiceNow and then customized by the customer, and hence skipped the latest ServiceNow upgrade. The customer should resolve a skipped update after an upgrade.</td>
</tr>
<tr>
<td>Customized</td>
<td>Orange</td>
<td>Created by ServiceNow, and then customized by the customer after the latest ServiceNow upgrade. The customer can revert a customization to implement the latest ServiceNow upgrade.</td>
</tr>
<tr>
<td>New</td>
<td>Blue</td>
<td>Created by the customer. The top element of the UI macro should have the following attribute:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>data-sn-macro-sys-id=&quot;${jvar_macro_sys_id}&quot;</td>
</tr>
</tbody>
</table>

⚠️ **Note:** The top element can be a div, span, or table.
Note:

- When you click the Service Catalog page name or the UI macro name, the corresponding UI page or the macro page is displayed.
- When you point to a macro in the UI Page Customization Diagnostics window, the corresponding UI elements are displayed with a pink border.
- The state-based color indication is applicable only for UI macros that have a visible UI.

**UI Page Customization Diagnostics window**

4. To minimize the UI Page Customization Diagnostics window, click 

**Related information**

- **UI macros**
- **Upgrade History module: Track every upgrade**

**Service Catalog item designer**

The Service Catalog item designer enables non-administrators to create, maintain, and publish catalog items. It uses a structured design and publishing process to ensure consistency of usage.
The item designer is best suited to manage items that have basic questions, approvals, and tasks.

**Note:** To create and manage more complex items, use the Service Catalog features for creating items.

**Item designer process flow**

- Administrators or catalog administrators set up the design environment to enable a controlled item design process, and process category requests.
- Catalog managers request categories, then manage their categories.
  - A user requests a category, either requesting to become the manager of that category, or assigning another user as the category manager.
  1. An administrator or catalog administrator processes that request, creating the category with a selected category manager.
  2. The category manager optionally assigns catalog editors to a category they manage.
- Catalog managers and catalog editors use the catalog item design to perform the following activities.
  1. Create items within a category they are assigned to.
  2. Create questions, approvals, tasks, and sections, for the item.
  3. Publish items to the category after review.
- Self-service users can use the service catalog to request items in the category, like any service catalog item.

**Catalog item designer roles**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator [admin]</td>
<td>Can set up the catalog item designer environment and process requests for categories. Can also perform other service catalog management functions.</td>
</tr>
<tr>
<td>Catalog administrator [catalog_admin]</td>
<td></td>
</tr>
<tr>
<td>Catalog Item Designer [catalog_item_designer]</td>
<td>Can view the status of category requests.</td>
</tr>
<tr>
<td>Catalog Manager [catalog_manager]</td>
<td>Can view and assign catalog editors to their categories. Can also create, modify, and publish items within their categories.</td>
</tr>
</tbody>
</table>
Catalog item designer roles (continued)

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog Editor [catalog_editor]</td>
<td>Can create, modify, and publish items within categories they are assigned to.</td>
</tr>
</tbody>
</table>

Configuring catalog item designer options

Administrators and catalog administrators can control the options for catalog managers and editors who use the catalog item designer.

Configuration includes defining question types, approval types, and task assignment types. You can restrict these options to ensure that items are designed consistently and with few variations, or expand them to enable greater design flexibility.

You can also process category creation requests and view or modify definitions of notifications used by the catalog item designer.

Process Flow

The catalog item designer uses the records in three distinct areas for creating, publishing, and requesting items:

1. Creating: The catalog item designer uses staging records for items that are being created, with staging records for any associated questions, approvals, and tasks. For example, a staging item [sc_ic_item_staging] record can have associated staging approval [sc_ic_aprvl_defn_staging] records. These records are staging only, and are not available to order from the Service Catalog.

2. Publishing: A published item can be requested from the Service Catalog. When item editors publish an item, the following actions occur:
   - Staging items create or update the corresponding catalog items.
   - Questions are copied into variables on that catalog item.
   - Associated approvals and tasks are copied into corresponding published tables. For example, approval [sc_ic_aprvl_defn_staging] records are copied to equivalent approval definition [sc_ic_aprvl_defn] records for the item.

3. Requesting: Requested items and associated records are created when a published catalog item is ordered by a self-service user.
• A requested item is generated based on the last-published item and the last-published versions of any variables used by that item.

• Associated approvals and tasks are copied from the published records into equivalent requested item tables. For example, Approval Definition [sc_ic_aprvl_defn] records are copied to equivalent Approval Definition (Requested Item) [sc_ic_req_item_aprvl_defn] records.

Define question types
Question types define the options available to catalog editors or catalog managers when they create questions for a catalog item.

About this task
To meet requirements for your design environment, you can modify question types by expanding or restricting the list of types available. For example, you can deactivate date-based question types.

Note: This list of available question types is also used when you create a new service in service creator. For example, if you deactivate Multi-Line Text, it is deactivated for both the catalog item designer and the service creator.

Procedure
1. Navigate to Item Designer > Administration > Question Types.
2. Click New or open an existing question type.
3. Fill in the fields, as appropriate.

**Question Type form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The question type name.</td>
</tr>
</tbody>
</table>
| Question class   | The base variable type to use as the class for this question type. The most common variable types are available, but some complex types, such as macros, are available only when you use the Catalog Item form. The following classes are available:
  * Checkbox
  * Date
  * Date/Time
  * Label
  * Multi-Line Text
  * Multiple Choice
  * Numeric Scale |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Reference</td>
<td>![Note:](https:// Raw Text) Reference fields are only available as preconfigured questions. If you set the question class to Reference, the <strong>Preconfigured Question</strong> check box is automatically selected and made read-only.</td>
</tr>
<tr>
<td>• Select Box</td>
<td></td>
</tr>
<tr>
<td>• Single-Line Text</td>
<td></td>
</tr>
<tr>
<td>• Yes / No</td>
<td></td>
</tr>
<tr>
<td>Order</td>
<td>The sequence in which the question type appears.</td>
</tr>
<tr>
<td>Active</td>
<td>A check box to indicate whether the question type is active or not. Clear this check box to deactivate a question type, so that it cannot be used when creating a question or a new service.</td>
</tr>
<tr>
<td></td>
<td>![Note:](https:// Raw Text) Deactivating a question type that is in use does not affect catalog items that are already using that question type.</td>
</tr>
<tr>
<td>Preconfigured question</td>
<td>A check box to indicate whether users can select this question as a preconfigured type when defining a question. This field is checked by default, and only one active non-preconfigured question type is available per question class. Some preconfigured question types are provided by default, such as a list of users. If <strong>Preconfigured Question</strong> is selected, the <strong>Read only</strong>, <strong>Question</strong>, <strong>Help text</strong>, and <strong>Default value</strong> fields also appear. Depending on the question class, additional fields can also appear to define variable attributes for that class. For example, if you select a preconfigured question type based on the <strong>Multiple Choice</strong> question class, the <strong>Question Type Choices</strong> field appears, allowing you to select the choices available for that question type.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the question type.</td>
</tr>
<tr>
<td>Read only</td>
<td>Whether the question type can be selected or not. Appears if <strong>Preconfigured Question</strong> is selected.</td>
</tr>
<tr>
<td>Question</td>
<td>The question itself, as displayed. Appears if <strong>Preconfigured Question</strong> is selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Help text</td>
<td>Help text to appear with the question. Appears if Preconfigured Question is selected.</td>
</tr>
<tr>
<td>Default value</td>
<td>The default value for the question. Appears if Preconfigured Question is selected.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**Manage approval types**

Approval types are available to catalog editors or catalog managers when they define approvals for an item. Add and change approval types, publish them, and expire them when they are no longer useful.

**About this task**

For example, you can define **Facilities Items Approvers**, a specific list of approvers for facilities items.

**Procedure**

1. Navigate to **Item Designer > Administration > Approval Type Definitions**.
2. Click **New**.

3. Fill in the fields, as appropriate.
### Approval Type form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name for the approval type.</td>
</tr>
<tr>
<td>Version</td>
<td>[Read-Only] The version of the approval type. The version number gets incremented whenever you save a change to that type.</td>
</tr>
<tr>
<td>State</td>
<td>[Read-Only] The approval type state. It is initially set to <strong>Draft</strong>. When you publish the approval type, the state changes to <strong>Published</strong>.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the approval type.</td>
</tr>
<tr>
<td>Type</td>
<td>The method for approving items that use the approval type. Can be <strong>User</strong>, <strong>Group</strong>, or <strong>Script</strong>. This selection determines which other fields are available.</td>
</tr>
<tr>
<td>User(s)</td>
<td>The individual users who can approve catalog items that use this approval type. This field is available only if the <strong>Type</strong> is set to <strong>User</strong>.</td>
</tr>
<tr>
<td>Group(s)</td>
<td>The groups who can approve catalog items that use this approval type. This field is available only if the <strong>Type</strong> is set to <strong>Group</strong>.</td>
</tr>
<tr>
<td>Script output</td>
<td>The result of the script, creating either a set of users or groups. This field is available only if the <strong>Type</strong> is set to <strong>Script</strong>.</td>
</tr>
<tr>
<td>Approver script</td>
<td>A script to define that approval type, such as a script to define the manager of the requester. This field is available only if the <strong>Type</strong> is set to <strong>Script</strong>.</td>
</tr>
</tbody>
</table>

### 4. Click **Submit**.

### Publish approval types

Publish an approval type after it is defined correctly for catalog editors or catalog managers to use when they create items.

- To publish an approval type, navigate to **Item Designer > Administration > Approval Type Definitions**, open an entry, and then click **Publish**.
- To view a list of published approval types, navigate to **Item Designer > Administration > Published Approval Type Definitions**.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Change approval types

Service Catalog enables you to change the details of an approval type.

• To change details for an approval type, navigate to **Item Designer > Administration > Approval Type Definitions**, open an entry, then edit the details and save your changes.

  ➤ **Note:** After you save your changes, the version number for that approval type increases by 1.

• To make your changes live, publish the changed approval type.

Expire approval types

To remove an approval type from use, you can expire it, making it inactive.

To expire an approval type, navigate to **Item Designer > Administration > Approval Type Definitions**, open an entry, and then click **Expire**.

Manage task assignment types

Task assignment types define the assignment options available to catalog editors and catalog managers when they define tasks for an item. You can add, change, publish, and expire task assignment types.

**About this task**

When a user then requests that item, these assignment options determine which users are assigned to complete these tasks. For example, you can use information the user enters when requesting an item to dynamically assign a task to the on-call IT support contact of the requester.

**Procedure**

1. Navigate to **Item Designer > Administration > Task Assignment Definitions**.
2. Click **New**.
3. Fill in the fields as appropriate.

### Task Assignment form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>A brief summary of the task assignment type.</td>
</tr>
<tr>
<td>Description</td>
<td>A longer description of the task assignment type.</td>
</tr>
<tr>
<td>Active</td>
<td>[Read Only] A check box that indicates whether the task assignment type is active or not. To deactivate a task assignment type, expire it.</td>
</tr>
<tr>
<td>Assignment type</td>
<td>The type of assignment. Set to <strong>Direct assignment</strong> to define users or groups explicitly, or <strong>Scripted assignment</strong> to calculate assignments dynamically using a script.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the task definition. Set to <strong>Draft</strong> if the record is being created or modified, or <strong>Published</strong> if the task assignment type is published.</td>
</tr>
<tr>
<td>Group</td>
<td>The group to assign to tasks that use this assignment type. This field is available only if the <strong>Assignment type</strong> is set to <strong>Direct assignment</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User</td>
<td>The specific user to assign to tasks that use this assignment type. This field is available only if the Assignment type is set to Direct assignment.</td>
</tr>
<tr>
<td>Assignment script</td>
<td>A script to determine who performs tasks that use this assignment type. This field is available only if the Assignment type is set to Scripted assignment. For example, a script to identify the on-call support team for the requestor as the group to assign.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Publish task assignment types**

You can publish task assignment types after defining them.

- To change details for a task assignment type, navigate to Item Designer > Administration > Task Assignment Definitions, open an entry, then edit the details and save your changes.

  ⚠️ **Note:** After you save your changes, the version number for that task assignment type increases by 1.

- To make your changes live, publish the changed task assignment type.

**Change task assignment types**

Service Catalog enables you to change the details of a task assignment type.

- To change details for a task assignment type, navigate to Item Designer > Administration > Task Assignment Definitions, open an entry, then edit the details and save your changes.

  ⚠️ **Note:** After you save your changes, the version number for that task assignment type increases by 1.

- To make your changes live, publish the changed task assignment type.

**Expire task assignment types**

To remove an assignment type from use, you can expire it, making it inactive.
To expire an assignment type, navigate to Item Designer > Administration > Task Assignment Definitions, open an entry, and then click Expire.

Review category requests from self-service users

The Item Designer Category Request catalog item can be enabled to allow self-service users to request service catalog categories. If the category request is approved, the Item Designer application becomes available for the user to create and manage catalog items in the category.

Before you begin
Role required: catalog_admin or admin

About this task
A catalog administrator reviews category requests and takes an action to create the category or reject the request. For example, a category request is rejected if it duplicates an existing category.

Procedure
1. Navigate to Item Designer > Administration > All Category Requests.
2. Open a category request.

3. Perform one of the following actions:
Option | Description
--- | ---
To approve the request | Click **Create Category**. The category is created, the nominated category manager receives an email notification, and is granted the catalog manager role for that category. The category manager can then manage the new category and create catalog items in it.

To reject the request | Click **Reject**. Category request rejections cannot be reversed. To create a new category, the original requester must submit a new request.

Using the catalog item designer

Users with the catalog_manager role use the catalog item designer to manage their categories, assign editors to those categories, and create, modify, and publish catalog items.

For example, a facilities team leader can manage a **Facilities** category. Facilities team members with the catalog_editor role can create, edit, and publish items within the **Facilities** category.

> **Note:** You can only manage standard catalog items using the catalog item designer, not more complex items such as order guides. In addition, UI policies and client scripts are not supported by the item designer. To implement these more advanced functions, use the service catalog features for creating items.

To view and manage catalog items created with the item designer, navigate to **Item Designer > Administration > All Items**.

For an overview of the catalog item designer process flow, see **Service Catalog item designer**.

Request a category

Self-service users can request a new category within a service catalog.
About this task
For example, a facilities team leader who manages office furniture could request the **Office Furniture Requests** category within the **Facilities** catalog.

To request a category:

**Procedure**
1. Navigate to **Self-Service > Service Catalog**.
2. Select the **Can We Help You? > Item Designer Category Request** item.
3. Fill in the request form.

![Request a category that you can use to create your own catalog items](image)

4. Click **Submit**.
   The catalog request record state is set to **Requested**, and you are granted the catalog item designer role so you can view the status of the request. Log out and back in to access the Item Designer application in the navigator.

5. Navigate to **Item Designer > My Item Categories** to view the status of the request.
Results
After the category is approved, new modules under Item Designer are provided to create and manage catalog items in the category.

Manage a category
After an administrator approves a category request, the category is immediately created with the selected category manager. The category manager can create and manage items in the category.

About this task
New categories do not appear in the catalog until items are added to them. Category managers can also create and manage items in their categories, and publish items to make them available to users.

Procedure
1. Navigate to Item Designer > My Item Categories to view and edit categories you manage.
2. Click the category number to open that category.
3. Complete any of the following actions.

Item designer category form

3. Complete any of the following actions.
<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign editors to a category</td>
<td>Select users in the Editors field of the category form, and then click Update.</td>
</tr>
<tr>
<td>Deactivate a category</td>
<td>Click Deactivate. The category no longer appears in the service catalog.</td>
</tr>
<tr>
<td>Reactivate a category</td>
<td>In the category form, click Activate.</td>
</tr>
</tbody>
</table>

Create an item
Category managers and catalog editors can create items using the item designer.

Procedure
1. Navigate to Item Designer > Create New.

2. Fill in the fields as appropriate.
Item designer view

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the item.</td>
</tr>
<tr>
<td>State</td>
<td>[Read-Only] The state of the item. Initially the state is set to Draft. When you publish the item, the state changes to Published.</td>
</tr>
</tbody>
</table>

Details tab or section

<table>
<thead>
<tr>
<th>Availability</th>
<th>The interface where this item is available. Choose from Desktop and Mobile, Desktop Only, or Mobile only.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalogs</td>
<td>The catalogs the item is published to.</td>
</tr>
<tr>
<td>Categories</td>
<td>The categories the item is published to within the selected catalogs.</td>
</tr>
<tr>
<td>Short Description</td>
<td>A brief description of the item.</td>
</tr>
<tr>
<td>Desktop image</td>
<td>An image of the item. This field is available only if Availability is set to either Desktop Only or Desktop and Mobile.</td>
</tr>
<tr>
<td>Mobile image</td>
<td>An image of the item for the smartphone interface. This field is available only if Availability is set to either Mobile Only or Desktop and Mobile.</td>
</tr>
<tr>
<td>Description</td>
<td>A full description of the item. This description appears in the catalog when a user selects the item or clicks the associated More Information link.</td>
</tr>
</tbody>
</table>

Costs tab or section

| One off cost               | The price for the item and the currency for that price.                                               |

3. Click **Next** to save the record.

4. Under **Related Links**, click the appropriate link to add questions, approvals, sections, or tasks for the item.

**Define an item question**

Item questions appear in the catalog when a user requests the item.
About this task

The user answers the questions to provide the information to fulfill the request. For example, a request for a new laptop can have a multiple choice question to specify the screen size. The requester can select one from a set of options.

You can organize questions into sections, to provide a logical flow for a multi-question item. If you plan to use sections, consider creating the sections so that you can select the appropriate section when defining the questions.

To add a question:

Procedure

1. On the Item form, click the Add a Question related link.

2. Fill in the fields, as appropriate.
## Add question

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Type** | The type for the question, defining the format you would like to receive the information in. By default, the options are:  
- Checkbox  
- Date  
- Date/Time  
- Label  
- Multi Line Text  
- Multiple Choice  
- Numeric Scale  
- Reference  
- Select Box  
- Single Line Text  
- Yes/No  
Each type allows you to create your own option, using the **Option** field.  
Administrators and catalog administrators determine the question types available. |
| **Option** | The standard questions available within the selected question type, as set by the value of the **Type** field.  
By default, all question types contain **Create your own <type>** as an option, allowing you to define your own question of that type. These types can contain additional fields, allowing you to further define the question options. For example, **Create your own Numeric Scale** allows you to define **Scale Min** and **Scale Max** values.  
Some types also have additional preconfigured options available. By default, the following extra options are available:  
- **Comments**: allow the user to enter a short message. Available if the Type is **Multi Line Text**.  
- **Contact preference**: ask the user to select a preferred contact method: email, telephone, or SMS. Available if the Type is **Multiple Choice**. |
Field | Description
--- | ---
| • Configuration item: allow the user to select a single configuration item from those items defined in the system. Available if the Type field is Reference.
• Active user: allow the user to choose from a list of active user records. Available if the Type is Reference.
| Administrators and catalog administrators define the options available for each question type.
| Mandatory | A check box to indicate whether users are required to provide an answer before they can submit the request. Only available for some question types.
| Read only | A check box for indicating whether the question is read only. Only available for some question types.
| Section | The section this question appears in. Sections allow you to group questions logically. Choose from the sections that have already been defined for the item.
| Column | The column this question appears in within the selected section. Fields appear in the left column by default, but can be moved to a right column.
| Question | The text of the question.
| Order | The numeric sequence for the question. Questions appear in the selected column in the order defined here.
| Default value | The default answer for the question, if any. Only available for some question types.
| Note: If you use a choice list, ensure that the default value matches a choice list value.
| Help text | Text that helps the user decide how to answer this question. Help text appears under the More information link below the question.
| Question Choices | The choices a user can choose for answering the question. Double-click the row to add an entry to the list. This field appears only for question types which have choices, such as Multiple Choice.

3. Click Submit.
The new question is added to the **Questions** related list.

4. To edit a question, open it from the related list.

**Define an item approval**

An approval for an item identifies a user or group that must approve each request for this item.

**About this task**

An approval for an item identifies a user or group that must approve each request for this item. All listed approvers must approve this request for it to be fulfilled. A rejection halts the process immediately. For example, you could define approvers for a facilities item to be the facility management team.

Users can view their open approvals by navigating to **Self-Service > My Approvals**, or by opening the requested item and viewing the approval in the **Group approvals** related list.

To add an approval to an item:

**Procedure**

1. On the Item form, click the **Add an Approval** related link.

2. Fill in the fields, as appropriate (see table).

3. Click **Submit**.

The new approval is added to the **Approvals** related list.
4. To edit an approval, open it from the related list.

**Define an item approval**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>A check box for indicating whether this approval is active.</td>
</tr>
<tr>
<td>Order</td>
<td>The sequence in which the approvals are requested. Approvals are only created when any approvals with lower-order numbers are completed. For example, if Approval 1 has order 100 and Approval 2 has order 150, Approval 2 is only created when Approval 1 is completed. If multiple approvals have the same order number, they are requested at the same time.</td>
</tr>
<tr>
<td>Type</td>
<td>The approval type. Set to <strong>User</strong> for a specific user, <strong>Group</strong> for a specific group, or <strong>Predefined Approval</strong> to select approvers from a predefined list.</td>
</tr>
<tr>
<td>User</td>
<td>A specific user to be the approver. Appears if the approval type is set to <strong>User</strong>.</td>
</tr>
<tr>
<td>Group</td>
<td>A specific group to be the approver. Appears if the approval type is set to <strong>Group</strong>. The first group member who responds to the approval request responds for the entire group.</td>
</tr>
<tr>
<td>Predefined</td>
<td>A check box allowing you to select an approval type created by the administrator or catalog administrator. Appears if the approval type is set to <strong>Predefined</strong>. For example, if you select the default predefined approval of <strong>Requester's Manager</strong>, the approval is sent to the manager of the person who requests the item.</td>
</tr>
</tbody>
</table>

**Define an item task**

Item tasks describe the work required to fulfill a request for an item.

**About this task**

Item tasks are generated as standard catalog tasks when an item is ordered, like the tasks generated by workflows. Tasks are assigned to users or groups as part of the fulfillment process when that item is ordered. For example, an item to request a laptop can have a task to deliver the laptop to the user.
Users can view their open tasks by navigating to Service Catalog > Open Records > Tasks, or can open the requested item and view the task in the Catalog Tasks related list.

To add a task to an item:

Procedure
1. On the Item form, click the Add a Task related link.

2. Fill in the fields, as appropriate (see table).

3. Click Submit.
   
   The new task is added to the Tasks related list.

4. To edit a task, open it from the related list.
Add task

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short</td>
<td>Description A brief description of the task.</td>
</tr>
<tr>
<td>Description</td>
<td>A more detailed description that provides details and instructions for the people performing the task.</td>
</tr>
<tr>
<td>Assignment</td>
<td>The assignment type. Select <strong>User specified</strong> to select your own assignment options, or <strong>Predefined</strong> to select from predefined task assignment definitions set by an administrator.</td>
</tr>
<tr>
<td>Group</td>
<td>The group to perform the task. Appears if the assignment is set to <strong>User specified</strong>.</td>
</tr>
<tr>
<td>User</td>
<td>The user to perform the task. Appears if the assignment is set to <strong>User specified</strong>. If you select a group first, only users from that group are available in the <strong>User</strong> selection list.</td>
</tr>
<tr>
<td>Assign to</td>
<td>A predefined assignment option. Appears if <strong>Assignment</strong> is set to <strong>Predefined</strong>. Select from the task assignment types created by the administrator or catalog administrator. Assignment types commonly base the task assignment on information provided with the request. For example, if you select <strong>Local database team for the requestor</strong>, the system assigns the task to someone from the designated team.</td>
</tr>
<tr>
<td>Order</td>
<td>The sequence in which tasks are created. Tasks are only created when any tasks with lower-order numbers are completed. For example, if Task 1 has order 100 and Task 2 has order 150, Task 2 is only created when Task 1 is completed. If multiple tasks have the same order number, they are created at the same time, so the tasks can be performed at the same time.</td>
</tr>
</tbody>
</table>

**Define an item section**

You can add sections to organize questions into logical groups, each with its own heading, which can streamline the request process.
About this task
For example, an item to request a new laptop can have sections for the hardware specifications and software requirements. Add the sections before you add the questions to simplify the layout process.

Procedure
1. On the Item form, click the Add a Section related link.

2. Fill in the fields as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>The section title that describes the type of questions in the section. For example, you can define sections such as User Details.</td>
</tr>
<tr>
<td>Position</td>
<td>A number indicating the vertical position of the section. Position 1 shows at the top, position 2 is below Position 1, and so on.</td>
</tr>
</tbody>
</table>

3. Click Submit.
The new section is added to the Sections related list.

4. To edit a section, open it from the related list. By default, a single two-column section is created for each item.

Publish an item
When you publish an item, it is available in the catalog for ordering.

About this task
When you create an item, it is in a Draft state. You can review the item, make changes, and refine the layout as many times as necessary to get the details exactly right.
When the item is ready, a category manager or catalog editor can publish it, making it available as a catalog item in the service catalog.

**Procedure**

1. Navigate to **Item Designer > Administration > All Items**.
2. Open the item record.
3. Click **Publish**.
   The item is now a live catalog item, available for ordering.
4. To view a list of published catalog items, navigate to **Item Designer > Published Items**.
   It is best not to edit an item record from the Published Items module. Doing so directly accesses that catalog item using standard service catalog functions, not the catalog item designer, losing the benefits of the controlled publishing environment.

   For example, if you copy an item, the copied catalog item is not listed in the Published Items module. To access this copy, navigate to **Service Catalog > Catalog Definition > Maintain Items** and locate the item named **Copy of [item name]**. The copied item is an active catalog item. Consider deactivating it by clearing the **Active** check box until your changes are complete.

**Republish an item**

Each time you make changes to an item, you must republish it in order for the changes to reflect in the item catalog.

**About this task**

When you edit an item, the item state returns to **Draft**. The live catalog item remains available to order, but does not have the changes you made. This process enables you to make changes to the item in a staging area, then apply those changes to the live catalog item after review.

**Procedure**

1. Navigate to **Item Designer > Administration > All Items**.
2. Open and edit the item record.
3. Click **Publish**.

**Unpublish an item**

When you unpublish an item, it is removed from the service catalog.
Procedure

1. Navigate to Item Designer > Administration > All Items.
2. Open the item record and select Unpublish.
   The item is then inactive within the service catalog, but remains available for editing and republishing. This state is useful if you do not want customers to order the catalog item while you are making changes to them.

**Expire an item**

When you expire an item, it is removed from both the service catalog and the item designer.

Procedure

1. Navigate to Item Designer > Administration > All Items.
2. Open the item record.
3. Click Expire.
   The item is removed from the list of active items, and cannot be edited or republished.

**Item version**

The system can create a new version of the item and deactivate the previous version to ensure that items currently being requested are not affected by these changes.

If you alter a question associated with an item, then you can republish the item. For example, if you change the default value of a question associated to an item, a new version of that item is automatically created when the changed item is published.

As a result, you can see multiple records with the same item name in the Catalog Item Table [sc_cat_item] when viewing all items. The published version of the item is the only active one.

**Installed with catalog item designer**

The catalog item designer adds or modifies tables, user roles, script includes, and other components.

Demo data is available with the catalog item designer.
Tables installed with catalog item designer

Tables are added with activation of the catalog item designer.

### Tables

<table>
<thead>
<tr>
<th>Display Name [Table Name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requesting Item Designer</td>
<td>Requests made by users for a new category.</td>
</tr>
<tr>
<td>Category Request [sc_ic_category_request]</td>
<td></td>
</tr>
<tr>
<td>Item [sc_ic_item_staging]</td>
<td>Item definitions, used when designing the item.</td>
</tr>
<tr>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>Approvals for items.</td>
</tr>
<tr>
<td>Approval Definition [sc_ic_aprvl_defn]</td>
<td>Approvals for catalog items.</td>
</tr>
<tr>
<td>Approval Definition (Requested Item) [sc_ic_req_item_aprvl_defn]</td>
<td>Approvals for requested items.</td>
</tr>
<tr>
<td>Approval Type [sc_ic_aprvl_type_defn_staging]</td>
<td>Approval types for items.</td>
</tr>
<tr>
<td>Approval Type Definition [sc_ic_aprvl_type_defn]</td>
<td>Approval types for catalog items and requested items.</td>
</tr>
<tr>
<td>Task Assignment [sc_ic_task_assign_defn_staging]</td>
<td>Task assignment types for items.</td>
</tr>
<tr>
<td>Task Assignment Definition [sc_ic_task_assign_defn]</td>
<td>Task assignment types for catalog items and requested items.</td>
</tr>
<tr>
<td>Task [sc_ic_task_defn_staging]</td>
<td>Tasks for items.</td>
</tr>
<tr>
<td>Task Definition [sc_ic_task_defn]</td>
<td>Tasks for catalog items.</td>
</tr>
<tr>
<td>Task Definition (Requested Item) [sc_ic_req_item_task_defn]</td>
<td>Tasks for requested items.</td>
</tr>
<tr>
<td>Question [sc_ic_question]</td>
<td>Questions for items. Stored as Variables [sc_item_variables_task] records for catalog items and requested items.</td>
</tr>
<tr>
<td>Question Choice [sc_ic_question_choice]</td>
<td>Choices if the question is a choice type (select box, multiple choice, or checkbox).</td>
</tr>
<tr>
<td>Display Name [Table Name]</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Question Class [sc_ic_question_class]</td>
<td>Base variable types to use as the class for a question type.</td>
</tr>
<tr>
<td>Question Type [sc_ic_question_type]</td>
<td>Question types for items.</td>
</tr>
<tr>
<td>Question Type Choice [sc_ic_question_type_choice]</td>
<td>Choices if the question type is a choice type (select box, multiple choice, or checkbox).</td>
</tr>
</tbody>
</table>

**Table relationships installed with catalog item designer**

Some equivalent information is stored as records in different tables in creating, publishing, or requesting areas to provide a controlled environment for item design.

For example, catalog items are stored as Item [sc_ic_item_staging] records in the creating area, as Catalog Item [sc_cat_item] records in the publishing area, and as Requested item [sc_req_item] records in the requesting area.

This table illustrates the relationships for these records.

<table>
<thead>
<tr>
<th>Creating</th>
<th>Publishing</th>
<th>Requesting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task [sc_ic_task_defn_staging]</td>
<td>Task Definition [sc_ic_task_defn]</td>
<td>Task Definition (Requested Item) [sc_ic_req_item_task_defn]</td>
</tr>
<tr>
<td>Item [sc_ic_item_staging]</td>
<td>Catalog item [sc_cat_item]</td>
<td>Requested item [sc_req_item]</td>
</tr>
<tr>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>Approval Definition [sc_ic_aprvl_defn]</td>
<td>Approval Definition (Requested Item) [sc_ic_req_item_aprvl_defn]</td>
</tr>
<tr>
<td>Approval Type [sc_ic_aprvl_type_defn_staging]</td>
<td>Approval Type Definition [sc_ic_aprvl_type_defn]</td>
<td></td>
</tr>
<tr>
<td>Question [sc_ic_question]</td>
<td>Variables [sc_item_variables_task]</td>
<td></td>
</tr>
<tr>
<td>Task Assignment [sc_ic_task_assign_defn_staging]</td>
<td>Task Assignment Definition [sc_ic_task_assign_defn]</td>
<td></td>
</tr>
</tbody>
</table>

**Roles installed with catalog item designer**

Roles are added with activation of the catalog item designer.
<table>
<thead>
<tr>
<th>Role</th>
<th>Contains Roles</th>
<th>Description</th>
</tr>
</thead>
</table>
| catalog_editor        | none           | Can create, modify, and publish items within categories to which they are assigned. Can also perform the following for items and categories to which they are assigned:  
  • Apply existing user criteria.  
  • Attach a variable set.  
  • Create a UI policy.  
  • Edit a catalog item in a catalog client script. |
| catalog_item_designer | none           | Can view the status of category requests.                                                                                                                                                                |
| catalog_manager       | none           | Can request a category, view and assign catalog editors to their categories, and create, modify, and publish items within their categories. Can also perform the following for items and categories to which they are assigned:  
  • Apply existing user criteria.  
  • Attach a variable set.  
  • Create a UI policy.  
  • Edit a catalog item in a catalog client script. |

**UI policies installed with catalog item designer**

UI policies are added with activation of the catalog item designer.

<table>
<thead>
<tr>
<th>UI Policy</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow category entry</td>
<td>Item [sc_ic_item_staging]</td>
<td>Allow category entry only if a catalog is selected.</td>
</tr>
<tr>
<td>Show Mobile Image</td>
<td>Item [sc_ic_item_staging]</td>
<td>Make the mobile image field visible if availability is set to Both Desktop.</td>
</tr>
<tr>
<td>UI Policy</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Desktop Image</td>
<td>Item [sc_ic_item_staging]</td>
<td>Make the desktop image field visible when availability set to <strong>Both Desktop and Mobile or Desktop Only.</strong></td>
</tr>
<tr>
<td>Show Published Item</td>
<td>Item [sc_ic_item_staging]</td>
<td>Show the catalog item if the staged item is published.</td>
</tr>
<tr>
<td>Hide Item field on Item Designer - Approval view</td>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>Hide the catalog item field from the item designer approval view.</td>
</tr>
<tr>
<td>Show &quot;User&quot; field when Type=User</td>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>Make the user field visible and mandatory if a user approval is selected.</td>
</tr>
<tr>
<td>Show &quot;Group&quot; field when Type=Group</td>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>Make the group field visible and mandatory if a group approval is selected.</td>
</tr>
<tr>
<td>Show &quot;Predefined approval&quot; field when Type=predefined_approval</td>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>Make the <strong>Predefined approval</strong> field visible if a predefined approval is selected and the predefined type is selected.</td>
</tr>
<tr>
<td>UI Policy</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Predefined approval description when appropriate</td>
<td>Approval</td>
<td>Make the predefined approval description visible and mandatory if a predefined approval is selected.</td>
</tr>
<tr>
<td></td>
<td>[sc_ic_aprvl_defn_staging]</td>
<td></td>
</tr>
<tr>
<td>Show &quot;User(s)&quot; field when Type=User</td>
<td>Approval Type</td>
<td>Make the <strong>User(s)</strong> field visible and mandatory if a user approval is selected.</td>
</tr>
<tr>
<td></td>
<td>[sc_ic_aprvl_type_defn_staging]</td>
<td></td>
</tr>
<tr>
<td>Show &quot;Group(s)&quot; field when Type=Group</td>
<td>Approval Type</td>
<td>Make the <strong>Group(s)</strong> field visible and mandatory if a group approval is selected.</td>
</tr>
<tr>
<td></td>
<td>[sc_ic_aprvl_type_defn_staging]</td>
<td></td>
</tr>
<tr>
<td>Show &quot;Script&quot; fields when Type=Script</td>
<td>Approval Type</td>
<td>Make the <strong>Script output</strong> and <strong>Approver script</strong> fields visible if a script approval is selected.</td>
</tr>
<tr>
<td></td>
<td>[sc_ic_aprvl_type_defn_staging]</td>
<td></td>
</tr>
<tr>
<td>Show published information</td>
<td>Approval Type</td>
<td>Make the approval definition and approval definition version visible if the published definition is not empty.</td>
</tr>
<tr>
<td></td>
<td>[sc_ic_aprvl_type_defn_staging]</td>
<td></td>
</tr>
<tr>
<td>Show assignment type fields</td>
<td>Task Assignment</td>
<td>Make the <strong>Assignment type</strong> field visible</td>
</tr>
<tr>
<td></td>
<td>[sc_ic_task_assign_defn_staging]</td>
<td></td>
</tr>
<tr>
<td>UI Policy</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show published assignment definition</td>
<td>Task Assignment [sc_ic_task_assign_defn_staging]</td>
<td>Make the published assignment definition visible if the published definition is not empty.</td>
</tr>
<tr>
<td>Show custom assignment fields</td>
<td>Task [sc_ic_task_defn_staging]</td>
<td>Make the <strong>User(s)</strong> and <strong>Group(s)</strong> fields visible if the assignment has a user specified.</td>
</tr>
<tr>
<td>Hide Item field</td>
<td>Task [sc_ic_task_defn_staging]</td>
<td>Hide the <strong>Item</strong> field if the item is not empty.</td>
</tr>
<tr>
<td>Hide meta fields</td>
<td>Question [sc_ic_question]</td>
<td>Hide fields used by underlying logic, but not requiring user input.</td>
</tr>
<tr>
<td>Hide Mandatory</td>
<td>Question [sc_ic_question]</td>
<td>Hide field if type is <strong>checkbox</strong> or <strong>label</strong>.</td>
</tr>
<tr>
<td>Show default value</td>
<td>Question [sc_ic_question]</td>
<td>Show default values, depending on the type of variable selected.</td>
</tr>
<tr>
<td>Numeric Scale type fields</td>
<td>Question [sc_ic_question]</td>
<td>Show numeric scales: <strong>Maximum</strong> and <strong>Minimum</strong> if the preconfigured</td>
</tr>
<tr>
<td>UI Policy</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Choices related list when appropriate</td>
<td>Question [sc_ic_question]</td>
<td>Show the Choices related list if the variable type Multiple Choice or Select Box is selected.</td>
</tr>
<tr>
<td>Hide Read Only</td>
<td>Question [sc_ic_question]</td>
<td>Hide the Read only field if the variable type Label, Date, or Date/Time is selected.</td>
</tr>
<tr>
<td>Read only question type</td>
<td>Question [sc_ic_question]</td>
<td>Hide field if the variable type Read only is selected.</td>
</tr>
<tr>
<td>Hide Item field on Item Designer - Question view</td>
<td>Question [sc_ic_question]</td>
<td>Hide Staging item field if the item is selected.</td>
</tr>
<tr>
<td>Force preconfigured Reference type fields</td>
<td>Question [sc_ic_question]</td>
<td>Set the value of preconfigured field to true and read-only if the variable type reference is selected.</td>
</tr>
<tr>
<td>Show Choices related list when appropriate</td>
<td>Question [sc_ic_question]</td>
<td>Show Choices related list if the variable type Multiple Choice or Select Box is selected.</td>
</tr>
<tr>
<td>Preconfigured checkbox type fields</td>
<td>Question Type [sc_ic_question_type]</td>
<td></td>
</tr>
<tr>
<td>UI Policy</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Preconfigured Reference fields</td>
<td>Question Type [sc_ic_question_type]</td>
<td>Show reference and reference qualifier fields if the question type is preconfigured reference type.</td>
</tr>
<tr>
<td>Preconfigured Questions</td>
<td>Question Type [sc_ic_question_type]</td>
<td>Show question text, read only, help text, and default value fields if the preconfigured question type is selected.</td>
</tr>
<tr>
<td>Preconfigured Numeric Scale type fields</td>
<td>Question Type [sc_ic_question_type]</td>
<td>Show numeric scales: <em>Maximum</em> and <em>Minimum</em> if the preconfigured variable type <em>Number</em> is selected.</td>
</tr>
<tr>
<td>Show &quot;Predefined Approval&quot; field when Type=predefined_approval</td>
<td>Approval Definition [sc_ic_aprvl_defn]</td>
<td>Make the <em>Predefined Approval</em> field visible and mandatory if no type is selected.</td>
</tr>
<tr>
<td>Show &quot;Group&quot; field when Type=Group</td>
<td>Approval Definition [sc_ic_aprvl_defn]</td>
<td>Make the <em>Group</em> field visible and mandatory if no type is selected.</td>
</tr>
<tr>
<td>Show &quot;User&quot; field when Type=User</td>
<td>Approval Definition [sc_ic_aprvl_defn]</td>
<td>Make the <em>User</em> field visible and mandatory if the user type is selected.</td>
</tr>
<tr>
<td>UI Policy</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show &quot;Script&quot; fields when Type=Script</td>
<td>Approval Type Definition [sc_ic_aprvl_type_defn]</td>
<td>Make the Script field visible and mandatory if the script type is selected.</td>
</tr>
<tr>
<td>Show &quot;User(s)&quot; field when Type=User</td>
<td>Approval Type Definition [sc_ic_aprvl_type_defn]</td>
<td>Make User(s) field visible and mandatory if the user type is selected.</td>
</tr>
<tr>
<td>Show &quot;Group(s)&quot; field when Type=Group</td>
<td>Approval Type Definition [sc_ic_aprvl_type_defn]</td>
<td>Make Group(s) field visible and mandatory if the group type is selected.</td>
</tr>
<tr>
<td>Show assignment type fields</td>
<td>Task Assignment Definition [sc_ic_task_assign_defn]</td>
<td>Make the User(s) and Group(s) fields visible and hide the Script field if the direct assignment variable type is selected.</td>
</tr>
<tr>
<td>Custom task fields</td>
<td>Task Definition [sc_ic_task_defn]</td>
<td>Make the User(s) and Group(s) fields visible and hide the Assignment Definition field if variable type Create my own selected.</td>
</tr>
</tbody>
</table>

**Script includes installed with catalog item designer**

Script includes are added with activation of the catalog item designer.

**Note:** Many of the business rules link to these script includes.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sc_ic_Section</td>
<td>Wrapper class for item designer question layout sections.</td>
</tr>
<tr>
<td>sc_ic_Factory</td>
<td>Entry point for all customization of the service catalog item designer script.</td>
</tr>
<tr>
<td>sc_ic_ColumnSecurityManager</td>
<td>Security manager for the Column table [sc_ic_column].</td>
</tr>
<tr>
<td>sc_ic_QuestionSecurityManager</td>
<td>Security manager for the Question table [sc_ic_question].</td>
</tr>
<tr>
<td>sc_ic_CatalogItemRecordProducer</td>
<td>Wrapper class for Record Producer table [sc_cat_item_producer] for the item creator.</td>
</tr>
<tr>
<td>sc_ic_Base</td>
<td>Base class for all item designer wrapper classes.</td>
</tr>
<tr>
<td>sc_ic_QuestionClass</td>
<td>Wrapper class for the Question class table [sc_ic_question_class].</td>
</tr>
<tr>
<td>sc_ic_TaskDefnStagingSecurityManager</td>
<td>Security manager for the Task table [sc_ic_task_defn_staging].</td>
</tr>
<tr>
<td>sc_ic_SectionSecurityManager</td>
<td>Security manager for the Section table [sc_ic_section].</td>
</tr>
<tr>
<td>sc_ic_CategoryRequest</td>
<td>Wrapper for the category request table.</td>
</tr>
<tr>
<td>sc_ic_ApprovalDefnStagingAJAX</td>
<td>Helper function which can be called from client scripts.</td>
</tr>
<tr>
<td>sc_ic_QuestionChoiceSecurityManager</td>
<td>Security manager for the Question Choice table [sc_ic_question_choice].</td>
</tr>
<tr>
<td>sc_ic_ApprovalDefnStagingSecurityManager</td>
<td>Security manager for staged approval definitions.</td>
</tr>
<tr>
<td>sc_ic_TaskAssignDefnStaging</td>
<td>Wrapper class for sc_ic_task_type_definition_staging.</td>
</tr>
<tr>
<td>sc_ic_TaskDefnStaging</td>
<td>Wrapper class for staged task definitions.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sc_ic_Question</td>
<td>Wrapper class for item designer questions. Subclass to modify and inject using sc_ic_Factory. See sc_ic_Factory for more information.</td>
</tr>
<tr>
<td>sc_ic_SectionAJAX</td>
<td>Service dealing with sections that can be called from client scripts.</td>
</tr>
<tr>
<td>sc_ic_CatalogTask</td>
<td>Wrapper class for Catalog Task table [sc_task] for item designer functionality.</td>
</tr>
<tr>
<td>sc_ic_CatalogItem</td>
<td>Wrapper class for Catalog Item table [sc_cat_item] for the item designer.</td>
</tr>
<tr>
<td>sc_ic_QuestionChoice</td>
<td>Wrapper class for Question Choice table [sc_ic_question_choice].</td>
</tr>
<tr>
<td>sc_ic_CatalogItemVariable</td>
<td>Wrapper for catalog item variables.</td>
</tr>
<tr>
<td>sc_ic_ApprovalDefnStaging</td>
<td>Wrapper for that approval definition staging table.</td>
</tr>
<tr>
<td>sc_ic_ReqItemApprovalDefn</td>
<td>Wrapper for requested item approval definitions.</td>
</tr>
<tr>
<td>sc_ic_Item</td>
<td>Subclasses, injected using sc_ic_Factory. For more information, see sc_ic_Factory.</td>
</tr>
<tr>
<td>sc_ic_CatalogItemVariableChoice</td>
<td>Wrapper class for variable choices.</td>
</tr>
<tr>
<td>sc_ic_ReqItemTaskDefn</td>
<td>Wrapper for requested item approval definitions.</td>
</tr>
<tr>
<td>sc_ic_ItemStagingSecurityManager</td>
<td>Security manager for the Item table [sc_ic_item_staging].</td>
</tr>
<tr>
<td>sc_ic_BaseTypeDefnStaging</td>
<td>Base class for all type definition staging classes</td>
</tr>
<tr>
<td>sc_ic_Column</td>
<td>Wrapper class for item designer question layout columns.</td>
</tr>
<tr>
<td>sc_ic_ApprovalTypeDefnStaging</td>
<td>Wrapper class for staged approval type definitions.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>sc_ic_CatalogItemRecordProducerService</td>
<td>Wrapper class for Service table sc_cat_item_producer_service for the item designer.</td>
</tr>
<tr>
<td>sc_ic_QuestionAJAX</td>
<td>Service for item designer questions that can be called from the client.</td>
</tr>
<tr>
<td>sc_ic_QuestionType</td>
<td>Wrapper class for item designer question types. Subclass to modify and inject using sc_ic_Factory. See sc_ic_Factory for more information.</td>
</tr>
<tr>
<td>sc_ic_TaskDefnStagingAJAX</td>
<td>Service for staged task definitions that can be called from client scripts.</td>
</tr>
<tr>
<td>sc_ic_RequestedItem</td>
<td>Item creator wrapper class for the Requested Item table sc_req_item.</td>
</tr>
<tr>
<td>sc_ic_ApprovalTypeDefn</td>
<td>Wrapper class for the approval type definition table.</td>
</tr>
<tr>
<td>sc_ic_TaskAssignDefn</td>
<td>Wrapper class for task assignment definitions.</td>
</tr>
<tr>
<td>sc_ic_TaskDefn</td>
<td>Wrapper class for task definitions.</td>
</tr>
<tr>
<td>sc_ic_SecurityManager</td>
<td>Base security manager class for the item designer tables.</td>
</tr>
<tr>
<td>sc_ic_BaseFactory</td>
<td>Base factory class. Make all customizations in the sc_ic_Factory class. See sc_ic_Factory for more information on how to mount customizations.</td>
</tr>
<tr>
<td>sc_ic_ApprovalDefn</td>
<td>Wrapper for approval definitions.</td>
</tr>
<tr>
<td>sc_ic_getCategoriesForModule</td>
<td>Class that gets categories.</td>
</tr>
</tbody>
</table>

**Client scripts installed with catalog item designer**

Client scripts are added with activation of the catalog item designer.
<table>
<thead>
<tr>
<th>Script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get next order number</td>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>Populates the Order field by adding 100 to the biggest order on an approval definition defined against the item.</td>
</tr>
<tr>
<td>Get Approval Type Description</td>
<td>Approval [sc_ic_aprvl_defn_staging] sc_ic_aprvl_defn_design</td>
<td>Displays or hides the approval type description on change of the predefined field value.</td>
</tr>
<tr>
<td>Reload when an image is deleted true</td>
<td>Item [sc_ic_item_staging]</td>
<td>Reloads the Item designer form when a Desktop or Classic Mobile image is deleted. If it has been Published, sets the record back to state Draft.</td>
</tr>
<tr>
<td>Process Dialog action</td>
<td>Item [sc_ic_item_staging]</td>
<td>Prompts to make a decision about keeping the modifications to the item before completing the selected action which causes an update. Performs the prompt if the state of the item is set to Published and there are unsaved changes to the item record.</td>
</tr>
<tr>
<td>Dialog functions</td>
<td>Item [sc_ic_item_staging]</td>
<td>Defines available dialog functions for actions such as display, process, and refresh.</td>
</tr>
<tr>
<td>Force update of Column dropdown</td>
<td>Question [sc_ic_question]</td>
<td>Updates the Section choice list values on load of the Question dialog box.</td>
</tr>
<tr>
<td>Mandatory checked</td>
<td>Question [sc_ic_question]</td>
<td>Ensures read only is not true if the question is mandatory.</td>
</tr>
<tr>
<td>Read only checked</td>
<td>Question [sc_ic_question]</td>
<td>If the question is read only, ensures mandatory is not true.</td>
</tr>
<tr>
<td>Populate meta fields [&quot;Type&quot; changed]</td>
<td>Question [sc_ic_question]</td>
<td>Populates the meta field values on change of Type on the Add Question form.</td>
</tr>
<tr>
<td>Script</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Populate meta fields ['Option' changed]</td>
<td>Question [sc_ic_question]</td>
<td>Populates the meta field values on change of Option on the Add Question form.</td>
</tr>
<tr>
<td>Get Question Type Description</td>
<td>Question [sc_ic_question]</td>
<td>Displays the Question type description on change of the Option field value for the following Types: <strong>Multi-Line Text, Multiple Choice, Reference</strong>.</td>
</tr>
<tr>
<td>Update Order on Section change</td>
<td>Question [sc_ic_question]</td>
<td>Updates the Order value on the question record to the next question order number available for a selected Section on change.</td>
</tr>
<tr>
<td>Hide Question Type Choices related list</td>
<td>Question Type [sc_ic_question_type]</td>
<td>Controls the visibility of Question Type Choice related list for questions of type Select Box and Multiple Choice.</td>
</tr>
<tr>
<td>Adjust position for display</td>
<td>Section [sc_ic_section]</td>
<td>Adjusts the position value on a section record to determine the correct display order.</td>
</tr>
<tr>
<td>Validate and adjust Position</td>
<td>Section [sc_ic_section]</td>
<td>Validates that the position on a section record value is greater than 0 and displays a field message if not.</td>
</tr>
<tr>
<td>Get next position</td>
<td>Section [sc_ic_section]</td>
<td>Populates the position field by adding 1 to the biggest position number on a section defined against the item.</td>
</tr>
<tr>
<td>Get next order number</td>
<td>Task [sc_ic_task_defn_staging]</td>
<td>Populates the <strong>Order</strong> field by adding 100 to the biggest order on an approval definition defined against the item.</td>
</tr>
</tbody>
</table>

**Business rules installed with catalog item designer**

Business rules are added with activation of the catalog item designer.
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>When</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Validate Category</td>
<td>Item [sc_ic_item_staging]</td>
<td>BEFORE</td>
<td>Abort action if category is invalid.</td>
</tr>
<tr>
<td>Set Question for non-preconfigured types</td>
<td>Question Type [sc_ic_question_type]</td>
<td>BEFORE</td>
<td>For non-preconfigured question types, set the label using the class name.</td>
</tr>
<tr>
<td>Prevent multiple non-preconfigured</td>
<td>Question Type [sc_ic_question_type]</td>
<td>BEFORE</td>
<td>Abort the insert/update action and display an error message to the user if a non-preconfigured question type exists.</td>
</tr>
<tr>
<td>Set Name field</td>
<td>Section [sc_ic_section]</td>
<td>BEFORE</td>
<td>Set name field to label field and add additional message detail.</td>
</tr>
<tr>
<td>Set value if nil</td>
<td>Question Choice [sc_ic_question_choice]</td>
<td>BEFORE</td>
<td>Set text field to empty string when value is null.</td>
</tr>
<tr>
<td>Check for duplicate</td>
<td>Section [sc_ic_section]</td>
<td>BEFORE</td>
<td>Abort the insert/update action and display an error message to the user if a section exists.</td>
</tr>
<tr>
<td>Check for Questions before deleting</td>
<td>Section [sc_ic_section]</td>
<td>BEFORE</td>
<td>Prevent deletion of columns by aborting the delete action and display an error message to the user if the column contains questions.</td>
</tr>
<tr>
<td>Position must be between 0 or 1</td>
<td>Column [sc_ic_column]</td>
<td>BEFORE</td>
<td>Show message to user.</td>
</tr>
<tr>
<td>Check for Questions before deleting</td>
<td>Column [sc_ic_column]</td>
<td>BEFORE</td>
<td>Show message to user.</td>
</tr>
<tr>
<td>Group/user required for user specified</td>
<td>Task [sc_ic_task_defn_staging]</td>
<td>BEFORE</td>
<td>Show message to user.</td>
</tr>
</tbody>
</table>
The following business rules do not contain independent logic, but simply call methods in script includes, as indicated. To find out which business rules call which script includes, refer to the default class registrations within the `sc_ic_BaseFactory` script include.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>When</th>
</tr>
</thead>
<tbody>
<tr>
<td>sc_ic: Copy Approval Definitions</td>
<td>Requested Item [sc_req_item]</td>
<td>AFTER</td>
</tr>
<tr>
<td>sc_ic: Copy Task Definitions</td>
<td>Requested Item [sc_req_item]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Approval definition changed</td>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Update detail field</td>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Set the item to draft</td>
<td>Approval Type [sc_ic_aprvl_type_defn_staging]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Check and update manager/editor roles</td>
<td>Item Designer Category Request [sc_ic_category_request]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Copy changes to real Category</td>
<td>Item Designer Category Request [sc_ic_category_request]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Add Item Designer role on insert</td>
<td>Item Designer Category Request [sc_ic_category_request]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Column changed</td>
<td>Column [sc_ic_column]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Set layout changed on delete</td>
<td>Column [sc_ic_column]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Create default Section</td>
<td>Item [sc_ic_item_staging]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Set draft if changed</td>
<td>Item [sc_ic_item_staging]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Check for Valid Name</td>
<td>Question [sc_ic_question]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Question definition changed</td>
<td>Question [sc_ic_question]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Question meta changed</td>
<td>Question [sc_ic_question]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>When</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>-------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Set definition changed on delete</td>
<td>Question [sc_ic_question]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Set Question Type and Base Type</td>
<td>Question [sc_ic_question]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Set question name</td>
<td>Question [sc_ic_question]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Question Choice changed</td>
<td>Question Choice [sc_ic_question_choice]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Set Order number</td>
<td>Question Choice [sc_ic_question_choice]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Set layout changed on delete</td>
<td>Section [sc_ic_section]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Create default Columns</td>
<td>Section [sc_ic_section]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Section changed</td>
<td>Section [sc_ic_section]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Set Draft</td>
<td>Task Assignment [sc_ic_task_assign_defn_staging]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Set assignment details</td>
<td>Task Assignment [sc_ic_task_assign_defn_staging]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Set assignment details</td>
<td>Task [sc_ic_task_defn_staging]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Set task definition changed on item</td>
<td>Task [sc_ic_task_defn_staging]</td>
<td>AFTER</td>
</tr>
</tbody>
</table>

**Email notifications installed with catalog item designer**

Email notifications are added with activation of the catalog item designer.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Condition</th>
<th>Recipients</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Designer Category Request Opened</td>
<td>Item Designer Category Request [sc_ic_category_request]</td>
<td>state EQUALS requested</td>
<td>manager</td>
</tr>
<tr>
<td>Item Designer Category Rejected</td>
<td>Item Designer Category Request [sc_ic_category_request]</td>
<td>state CHANGES TO rejected</td>
<td>manager</td>
</tr>
</tbody>
</table>
### Service Catalog configuration for Universal Request

You can configure a catalog item or record producer to create a universal request when a request is submitted. The associated requested item (for catalog item) or task-based record (for record producer) becomes the primary ticket for that universal request.

**Related information**

- Create or edit a catalog item
- Create a record producer
- Configure a catalog item or record producer to create a universal request

**Configure all catalog items or record producers to create a universal request**

Reduce the implementation time by configuring all catalog items or all record producers at a time for universal request creation.

**Before you begin**

Role required: admin

**About this task**

For catalog items, RiTM should be registered as a service in Universal Request.

For record producers, the target table should be registered as a service in Universal Request.

For information about service configurations, see [Service Configuration form](#).

**Procedure**

1. Navigate to sys_properties.list.
2. Click **New**.
3. To configure all catalog items to create a universal request:
a. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique identifier of the property. Specify <code>sn_uni_req.enable_ur_all_cat_items</code>.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the property. Specify <code>boolean</code>.</td>
</tr>
<tr>
<td>Value</td>
<td>Option to specify if all catalog items can be configured at a time to create a universal request. Possible values are <code>true</code> or <code>false</code>.</td>
</tr>
</tbody>
</table>

b. Click Submit.

4. To configure all record producers to create a universal request:

a. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique identifier of the property. Specify <code>sn_uni_req.enable_ur_all_rec_prod_items</code>.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the property. Specify <code>boolean</code>.</td>
</tr>
<tr>
<td>Value</td>
<td>Option to specify if all record producers can be configured at a time to create a universal request. Possible values are <code>true</code> or <code>false</code>.</td>
</tr>
</tbody>
</table>

b. Click Submit.

Installed with Service Catalog Management

Several types of components are installed with the Service Catalog Management.

Activating the Service Level Management plugin adds or modifies several tables, user roles, and other components.

Script includes installed with Service Catalog Management

Script includes are added with activation of Service Catalog Management.
Service Catalog management adds the following script includes.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DemoSCCreateItem</td>
<td>Demonstrates the use of service catalog scoped API.</td>
</tr>
</tbody>
</table>

Sample ATF tests for Service Catalog in Service Portal

Validate the continued functionality of Service Catalog after any configuration change such as an upgrade or after developing an application. All test suites and tests should pass on a default implementation. To validate a custom implementation, copy the automated tests and configure them for your customizations.

Service Catalog sample tests require activating the Service Catalog - ATF Tests plugin (com.glideapp.servicecatalog.atf.test) along with the demo data. To run these tests using a suite, follow the procedure described in Run an automated test suite by selecting the Service Catalog - ATF Tests test suite. These sample tests are dependent on the demo data items.

Service Catalog Tests test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ordering an item with a multi-row variable set (SP)</td>
<td>Validate ordering an item in Service Portal that needs data from a multi-row variable set</td>
</tr>
<tr>
<td>Ordering catalog items using an Order Guide (SP)</td>
<td>Validate ordering an item from an order guide in Service Portal</td>
</tr>
<tr>
<td>Request a catalog item (SP)</td>
<td>Validate requesting a catalog item in Service Portal</td>
</tr>
<tr>
<td>Search for items, add to cart and checkout (SP)</td>
<td>Validate using the cart in Service Portal</td>
</tr>
<tr>
<td>Submitting requests using a Record Producer (SP)</td>
<td>Validate using a record producer in Service Portal</td>
</tr>
<tr>
<td>Viewing and editing catalog item variables in the Catalog Task page</td>
<td>Validate catalog item variables from a catalog task</td>
</tr>
<tr>
<td>Viewing and editing catalog item variables in the Requested Item page</td>
<td>Validate catalog item variables from a requested item</td>
</tr>
</tbody>
</table>
### Service Catalog Tests test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add comment on catalog item(s) request created by user</td>
<td>Add comments on a ticket page for a requested item or incident</td>
</tr>
<tr>
<td>Approving requests on different catalog item ordered from end-users</td>
<td>Approving a request for catalog items</td>
</tr>
<tr>
<td>Catalog item(s) ordering from multiple catalogs</td>
<td>Order catalog items from multiple catalogs</td>
</tr>
<tr>
<td>Filter for recent records from My Request filter</td>
<td>Filter for recent open and closed records from the My Requests menu</td>
</tr>
<tr>
<td>Ordering catalog item(s) from saved bundle</td>
<td>Order catalog items from a saved bundle</td>
</tr>
<tr>
<td>Ordering catalog item(s) from wishlist</td>
<td>Order catalog items from the wish list</td>
</tr>
<tr>
<td>Validate contents of 'My Recent Items'</td>
<td>Validate contents of the My Recent Items widget</td>
</tr>
<tr>
<td>Validating Regex for Variables</td>
<td>Validate variables using a regular expression</td>
</tr>
<tr>
<td>Validate Requested For variable flow for Cart Checkout</td>
<td>Validate the Requested For variable flows for cart checkout</td>
</tr>
<tr>
<td>Validate Requested For variable flow for Order Guide</td>
<td>Validate the Requested For variable flows for an order guide</td>
</tr>
<tr>
<td>Validate Requested For variable flow with Catalog Item access</td>
<td>Validate the Requested For variable flows based on the catalog item access</td>
</tr>
</tbody>
</table>

### Domain separation and Service Catalog

Domain separation is supported in Service Catalog. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.
Support level: Standard

• Includes Basic level support.

• Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.

• The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see Application support for domain separation.

Activation information

You should activate the Service Catalog - Domain Separation plugin (com.glideapp.servicecatalog.domain_separation) to enable domain separation for Service Catalog. For information on how you can request for the plugin activation, see Request for domain separation in Service Catalog.

This plugin should only be activated if there is a need for the following scenarios:

• Isolate items to requesters in a specific domain.

• Make items unavailable for request in any other domain irrespective of the domain hierarchy.

If Service Catalog has already been domain separated as a custom solution, activating this plugin may override the existing behavior to enforce the plugin-specific isolation.

How domain separation works in Service Catalog

Service providers supporting multiple customers in a single ServiceNow instance can ensure data privacy across domains using domain separation. Service providers can ensure that items created or published in a specific domain can only be requested by users in that domain without adding additional user criteria to the individual catalog items.

In Service Catalog, catalog items (catalog items, record producers, content items, and order guides) are domain-separated as data. Catalogs, categories, and variables are not domain-separated, and belong to the global domain. Also, items that need to be shared across multiple domains must be published in the global domain and restricted by user criteria.
Domain separation in Service Catalog is applicable to all requester views in the Now Platform, Service Portal, Agent Workspace, mobile application, as well as to all API calls requesting for items.

**Domain-separated tables**

The **Domain** (sys_domain) and **Domain Path** (sys_domain_path) columns are added to the following tables that are domain-separated:

- sc_cat_item
- sc_item_option
- sc_multi_row_question_answer
- question_answer

**Effective domain for a user**

For users with visibility to a single domain, the effective domain is the user’s domain. For users with visibility to multiple domains, the effective domain is the domain selected in the domain picker.

**Visibility of catalog items - Item creation and maintenance**

A catalog item can be created or published in any domain in the hierarchy. For information on creating a catalog item, see [Create or edit a catalog item](#). The item is created in the effective domain of the user. For information on enabling the domain picker, see [Enable domain selection menus in UI16](#). Once the item is created in a specific domain, all future edits to the item are done in that domain itself.

If a catalog item is published using Item Designer, the domain of the item is the domain selected in the domain picker while publishing the item. Once the item is published, it can only be modified and re-published in the domain it was originally published in.

Catalog items are domain separated as data. Only for maintenance and administration, the visibility of the catalog items follows the data domain hierarchy rules. For information on domain separation hierarchies, see [Domain separation hierarchies](#).

User criteria associated with a catalog item must be visible in the domain of the catalog item. If not visible, catalog item is considered to be not associated with that user criteria.

**Visibility of catalog items - Item request flow**

The catalog item created in a specific domain is available in the browse, search, and request experience only in that domain and not available in the peer domains, child domains, and parent domains irrespective of the hierarchy
and visibility of the domains. So, requesters can only request for items in their
domain as well as in the global domain.

For users with access to multiple domains (for example, IT fulfiller), the items are
available for request based on the domain selected in the domain picker. To
view or request an item of a specific domain, the user should switch to that
domain. For information on enabling the domain picker, see Enable domain
selection menus in UI16.

When a requester submits a request using an order guide which has items from
multiple domains, only the items in the effective domain and the global domain
are ordered.

The target records such as requests, requested items, or records created by
record producers are created in the effective domain.

**Request fulfilment flow and reporting for a domain-separated
catalog item**

The target records such as requests, requested items, or records created by
record producers can be accessed by a fulfiller who has visibility to the domain
that the record has been generated in. For information on visibility in domain
hierarchies, see Visibility domains and Contains domains. Even when the fulfiller
modifies the requested item from a domain other than the requested item’s
domain, the modifications are recorded in the target record’s domain. Since the
target records are separated as data, the reports retrieve data based on the
effective domain of the user requesting the report.

**Request flow by a fulfiller from a different domain**

When a fulfiller creates a request from a parent record such as an incident
in Agent Workspace or in Now Platform, the fulfiller can only request for an
item from the parent record’s domain or from the global domain. Also, the
corresponding target records are created in the parent record’s domain.

⚠️ **Note:** Items from multiple domains cannot be added to the cart.

**Catalog client scripts and catalog UI policies**

Since the catalog client scripts and catalog UI policies are domain-separated
as processes, scripts and policies in the parent domain can be overridden in the
child domains. However, these scripts and policies are applicable based on the
domain of the catalog item or the domain of the target record.

For example, consider that A is the parent domain and B is its child domain. A
catalog item in domain B is associated with a catalog client script defined in
domain A. If this catalog client script is overridden in the child domain B, the
overridden script in domain B is applicable while fulfilling the requested item in
domain B. Even when a fulfiller from the parent domain A fulfills the requested item in the child domain B, the overridden script in domain B is applicable.

⚠️ Note: It is recommended to not override catalog client scripts and catalog UI policies.

**Catalog builder**
An item can only be edited in the domain that it has been created. Catalog UI policies and actions added in catalog builder are created in the same domain as that of the item.

**Related information**
- Domain separation for service providers

**Request for domain separation in Service Catalog**
Enable domain separation in Service Catalog by requesting for the activation of the Service Catalog - Domain Separation plugin (com.glideapp.servicecatalog.domain_separation).

**Before you begin**
Role required: admin

**About this task**
There are two ways to request a plugin:

- Access the Now Support Service Catalog directly by clicking **Service Catalog > Activate Plugin** on Now Support.
- Access the Now Support Service Catalog through the All Applications page on your instance by following these steps.

**Procedure**
1. Navigate to **System Applications > All Available Applications > All**.
2. On the All Applications page, click **Request Plugin** to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>
### Field Description

Note: Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

### Service Catalog parameters

You can use the Service Catalog parameters to identify the parent mapping configuration for a request, and join the service catalog flow from any other flow. For example, from an incident flow, you can create a request, and associate the request with the incident.

These parameters are passed in the application URL.

<table>
<thead>
<tr>
<th>Service Catalog parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_parent_sys_id</td>
<td>sys_id of the source record that is passed to the target record generated. Format is <code>sysparm_parent_sys_id=&lt;sys_id of the parent&gt;</code>. For example, <code>sysparm_parent_sys_id=85071a1347c12200e0ef563dbb9a71c1</code>.</td>
</tr>
<tr>
<td>sysparm_parent_table</td>
<td>Name of the parent table from which the catalog request is created. Format is <code>sysparm_parent_table=&lt;name of the parent table&gt;</code>. For example, <code>sysparm_parent_table=incident</code>.</td>
</tr>
<tr>
<td>sysparm_view</td>
<td>Type of the catalog view. Format is <code>sysparm_view=&lt;name of the catalog view&gt;</code>. For example, <code>sysparm_view=catalog_default</code>.</td>
</tr>
</tbody>
</table>
Service Catalog parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_processing_hint</td>
<td>Specifies a processing hint.</td>
<td>This is only applicable in Platform.</td>
</tr>
<tr>
<td></td>
<td>Format is <code>sysparm_processing_hint=setfield:request.parent=&lt;incident_sys_id&gt;</code>. For example,</td>
<td>If specified, this parameter overrides the configuration in the</td>
</tr>
<tr>
<td></td>
<td><code>sysparm_processing_hint=setfield:request.parent=85071a1347c12200e0ef563dbb9a71c1</code>.</td>
<td>Request Parent Mapping sub-module.</td>
</tr>
</tbody>
</table>

Related information

Create a request from an incident

Service Catalog properties

The Service Catalog application contains properties used to configure various settings in the application.

To configure Service Catalog system properties, navigate to Service Catalog > Catalog Administration > Properties. The properties are categorized into sections.

- **Homepage**: Configure settings for the Service Catalog homepage, and control the behavior of the categories and the items displayed on the homepage.
- **Catalog Items**: Configure settings for catalog items and record producers.
- **Order Guides > General**: Configure settings for the order guide.
- **Order Guides > Scriptable Order Guides**: Configure settings for scriptable order guides.
- **Cart**: Control the behavior of the shopping cart and checkout screens.
- **Request Fulfillment**: Configure settings for request fulfillment processes.
- **Search**: Configure search settings for the Service Catalog homepage.
- **Security**: Configure security settings for the Service Catalog.
- **Pricing**: Configure settings for the pricing engine and pricing display.
- **Portal**: Configure settings for catalog portal widgets.
- **Virtual Agent**: Configure settings for request submission in Virtual Agent.
This section is visible only when you activate the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks).

- **Mobile**: Configure settings for Now Mobile.
- **Other**: Additional settings for the Service Catalog.

### Service Catalog properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Homepage</strong></td>
<td>Number of catalog items or categories to preview in a section:</td>
</tr>
<tr>
<td>Number of Catalog Items/Categories to preview in a section</td>
<td>• <strong>Type</strong>: integer</td>
</tr>
<tr>
<td>(glide.sc.max_items)</td>
<td>• <strong>Default value</strong>: 5</td>
</tr>
<tr>
<td>Show category descriptions in the category view page</td>
<td>Number of catalog items or categories to preview in a section:</td>
</tr>
<tr>
<td>(com.glide.servicecatalog.view_includes_category_descriptions)</td>
<td>• <strong>Type</strong>: yes</td>
</tr>
<tr>
<td>In category view display subcategories in a panel</td>
<td>• <strong>Default value</strong>: yes</td>
</tr>
<tr>
<td>(glide.sc.use_sub_cat_section)</td>
<td>In category view, display subcategories in a panel:</td>
</tr>
<tr>
<td>Toggle whether the expand/collapse icon is rendered for category</td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td>widgets on the service catalog homepage</td>
<td>• <strong>Default value</strong>: true</td>
</tr>
<tr>
<td>(glide.sc.homepage.show.collapse)</td>
<td>Toggle whether the expand/collapse icon is rendered for category widgets on the service catalog homepage:</td>
</tr>
<tr>
<td>When browsing a category use the popup icon to show item details</td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td>(glide.sc.cat_view_use_popup_for_details)</td>
<td>• <strong>Default value</strong>: false</td>
</tr>
<tr>
<td>When browsing a category use the info icon next to the selected</td>
<td>When browsing for a category, use the info icon next to the selected item to preview category details:</td>
</tr>
<tr>
<td>item to preview category details</td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: false</td>
</tr>
</tbody>
</table>
### Service Catalog properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Number of catalog items to expand in browsing and search when not using popup icons to view details (glide.sc.auto_expand) | Number of catalog items to expand in browsing and search when not using popup icons to view details:  
- **Type:** integer  
- **Default value:** 2 |
| Show the additional categories section when viewing a catalog item (glide.sc.show_additional_cats) | Show the additional categories section when viewing a catalog item:  
- **Type:** true | false  
- **Default value:** true |
| Limit descriptions in category and item listings to two rows in the Mobile UI (glide.sc.mobile.limit.description) | Limit descriptions in category and item listings to two rows in the Mobile UI:  
- **Type:** true | false  
- **Default value:** true |
| List of content types (comma-separated) to allow on the catalog homepage. Blank allows all content types. (glide.sc.home.filter) | List of content types (comma-separated) to allow on the catalog homepage. Blank indicates all content types. |
| Name of placeholder picture for items that do not have a picture defined (glide.sc.placeholder.image) | Name of the placeholder picture for items that do not have a picture defined. Applicable only to Classic Mobile and not Desktop.  
By default, two images are available: sc_placeholder_image.png and sc_placeholder_image-01.png. In addition, the default can be replaced with a custom image:  
- **Default value:** sc_placeholder_image.png |

### Catalog Items

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Specifies the default behavior of record producer after record generation (glide.sc.producer.redirect_url) | Default redirect behavior of the record producer after its generation.  
**Possible values:** |
## Service Catalog properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Generated Task record: Redirects to the task record created using the record producer.</td>
<td></td>
</tr>
<tr>
<td>• Catalog Homepage: Redirects to the service catalog where the order for the record producer is placed.</td>
<td></td>
</tr>
</tbody>
</table>

Override this behavior by editing the value of the **Redirect To** field of the record producer or defining the redirect code in the **Script** field of the record producer.

<table>
<thead>
<tr>
<th>List of class names for catalog items that cannot be added to an existing request (glide.sc.item.cannot_add_to_request)</th>
<th>List of class names for catalog items that cannot be added to an existing request:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Type:</strong> string</td>
<td>• <strong>Default value:</strong> sc_cat_item_guide, sc_cat_item_producer, sc_cat_item_wizard</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>List of class names for catalog items that do not use the default &quot;Try It&quot; ui action (glide.sc.item.cannot_try_it)</th>
<th>List of class names for catalog items that do not use the default &quot;Try It&quot; UI Action:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Type:</strong> string</td>
<td>• <strong>Default value:</strong> sc_cat_item_guide, sc_cat_item_producer, sc_cat_item_wizard, sc_cat_item_service</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>List of class names for catalog items that do not generate a normal cart item (glide.sc.item.not_normal_cart_item)</th>
<th>List of class names for catalog items that do not generate a normal cart item:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Type:</strong> string</td>
<td>• <strong>Default value:</strong> sc_cat_item_guide, sc_cat_item_producer, sc_cat_item_wizard</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Relationship tables which should be part of 'Copy Item' action. Table Name should be comma separated (glide.sc.item.copy.include_relationship)</th>
<th>Specify the tables in which records having a reference to a catalog item are also copied when you copy the catalog item:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Note:</strong> Table names should be comma-separated without any spaces.</td>
<td></td>
</tr>
</tbody>
</table>
### Service Catalog properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disables clickthrough via the info-icon on a reference variable. Set value to true to enable this functionality. (glide.sc.variable.reference.clickthrough)</td>
<td>Disable clickthrough via the info-icon on a reference variable. Set the value to true to enable this functionality.</td>
</tr>
</tbody>
</table>

### Order Guides

**General**

- **List of class names for catalog items that cannot be included in an order guide.** (glide.sc.item.order_guide_exclusion)
  - Comma-separated list of class names for catalog items that cannot be included in an order guide. For example, sc_cat_item_guide and sc_cat_item_content.

- **Validate mandatory fields when switching tabs in 'Choose Options' section of Order Guides.** (glide.sc.guide.tab.validate)
  - Validate mandatory fields when switching tabs in the Choose Options section of order guides:
    - **Type:** true | false
    - **Default value:** true

- **Render order guide on cart preview and order status page.** (glide.sc.render_order_guide_column)
  - Render the order guide on cart preview and order status page. If an item is part of an order guide, the order guide is listed next to the item. If a user attempts to delete an item belonging to an order guide, a confirmation message appears.

- **On an order guide, reset cascading or assigned variable values on an item when a user goes back using the "describe needs" button.** (glide.sc.reset_cascade)
  - On an order guide, reset cascading variable values on an item when a user navigates back and forth between the Describe Needs and Choose Options screens.

- **On an order guide, reset all variables when cascading variables or assigned variable values are reset on an item after a user goes back using the "describe needs" button.** (glide.sc.reset_cascade_all)
  - In an order guide, reset the cascading variables and non-cascading variables when a user navigates back and forth between the described needs and choose options screens. If set to false, only the values for the cascading variables are reset.

### Scriptable Order Guides

- **During the processing of a scriptable order guide, create a failure record when the JSON payload is empty.** (glide.sc.sog.empty_payload)
  - If selected, creates a failure record when the JSON payload is empty during the processing of a scriptable order guide.
### Service Catalog properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| During the processing of a scriptable order guide, create a failure record when the order guide is inactive  
\(\text{glide.sc.sog.inactive_order_guide}\) | If selected, creates a failure record when the order guide is inactive during the processing of a scriptable order guide. |
| During the processing of a scriptable order guide, create a failure record when the order guide sys_id is invalid  
\(\text{glide.sc.sog.invalid_order_guide_id}\) | If selected, creates a failure record when the order guide sys_id is invalid during the processing of a scriptable order guide. |
| During the processing of a scriptable order guide, create a failure record when there is a general JSON parsing error  
\(\text{glide.sc.sog.json_parsing}\) | If selected, creates a failure record when there is a general JSON parsing error during the processing of a scriptable order guide. |
| During the processing of a scriptable order guide, create a failure record when JSON parameters are missing  
\(\text{glide.sc.sog.mandatory_json_parameters}\) | If selected, creates a failure record when JSON parameters are missing during the processing of a scriptable order guide. |
| Cart | Enable cloning requests during checkout. Deprecated by sc_layout; if sc_layout is enabled then this property is not used  
\(\text{glide.sc.allow.checkout.clone}\) |
| Enable cloning requests during checkout. Noted: This property is deprecated when cart layouts are enabled. |
| List of roles (comma-separated) that can use bulk ordering functionality. Blank means all users  
\(\text{glide.sc.allow.clone.roles}\) | Roles (comma-separated) for other users. Blank value indicates all users can clone requests. |
| Show the 'Back to Catalog' button on the two step checkout screen  
\(\text{glide.sc.checkout.twostep.back}\) | Show the Back to Catalog button on the two-step checkout screen. |
| Use the two step catalog checkout model (default false)  
\(\text{glide.sc.checkout.twostep}\) | Use the two-step catalog checkout model.  
- Default value: false |
| Condition under which users may cancel a request (previous property must also be true), e.g., current.opened_by == gs.getUserID() || current.caller_id == gs.getUserID()  
\(\text{glide.sc.checkout.cancel.condition}\) | Condition under which users can cancel a request. Requires Allow ess users the option to cancel their requests from the checkout screen. |
| Allow ess users the option to cancel their requests from the checkout screen. In conjunction with sc_layout feature, if either is set to true the cancel button becomes visible  
\(\text{glide.sc.checkout.cancel}\) | Enable Employee Self-Service (ESS) portal users the option to cancel their requests from the checkout screen. |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Use the two step checkout model when placing a Catalog Order from a Wizard (default true) (glide.expert.checkout.twostep) | Use the two-step checkout model when placing a catalog order from a wizard:  
  - Default value: true  
   
List of roles (comma-separated) that can update the "Requested for" widget in the service catalog. Blank means all users. If the user does not have privilege to change requested for, they will not have ability to get other user address details (glide.sc.req_for.roles)  
  
List of users with the roles (comma-separated) provided here can request items for other users. If no role is specified, then this behavior is defined by the glide.sc.req_for.roles.default property. For information about configuring the glide.sc.req_for.roles.default property, see Configure the default behavior to request items for other users.  
  
Controls access to the Requested For widget on the Catalog homepage. Users with access to this widget can request items for another person. Users without access can place orders in their own name only.  
  
Ordering of matches for the "request for" service catalog widget. Choose fields in the sys_user table (glide.sc.request_for.order_by)  
  
Ordering of matches for the "request for" Service Catalog widget. Choose fields in the user [sys_user] table.  
  
Show the request item number for each line item on the checkout screen (default false). Deprecated by sc_layout; if sc_layout is enabled then this property is not used (glide.sc.checkout.request.number)  
  
Show the request item number for each line item on the checkout screen:  
  - Default value: false  
  
> Note: This property is deprecated when cart layouts are enabled.  
  
Field name to use for the description column of the checkout form. If blank, the default (short_description) is used (glide.sc.ess.description)  
  
Field name for the description column of the checkout form. If blank, the default is used:  
  - Default value: short_description  
  
Additional columns for the "request for" service catalog widget. Choose fields in the sys_user table. Must be semicolon separated (glide.sc.request_for.columns)  
  
Additional columns for the "request for" Service Catalog widget. Choose fields in the user [sys_user] table. Must be semicolon separated.  
  
Automatically update the delivery address for catalog carts when the details of a users location changes (glide.sc.auto.cart.address.reset)  
  
Automatically update the delivery address for catalog carts when user location changes. If enabled, when changes to the address, and the user has access to the Requested For widget.
### Service Catalog properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>the user's address in the cart. If not enabled, the old address is retained in the cart:</td>
<td></td>
</tr>
<tr>
<td>• <strong>Type</strong>: true</td>
<td>false</td>
</tr>
<tr>
<td>• <strong>Default value</strong>: false</td>
<td></td>
</tr>
</tbody>
</table>

When determining the address of a user prioritise the details on an associated location record over the details on the user record itself (`glide.sc.prioritise.user.location`) - If selected, when determining the address of a user, prioritises the details on an associated location record over the details on the user record itself. Determines whether 'Order Now' button exhibits new or old behaviour. If this property is true, clicking "Order Now" button in the service catalog, only orders the item currently selected, any items saved in user's shopping cart is left untouched for future ordering. Old 'Order Now' feature is deprecated, 'Order Item' button is deprecated too (`glide.sc.enable_order_now`) - Determines whether the 'Order Now' button exhibits new or old behavior. If this is selected, when determining the address of a user, prioritises the details on an associated location record over the details on the user record itself. Any items saved in user's shopping cart are left untouched for future ordering. The legacy Order Now feature and the Order Item button are deprecated. |

| List of roles (comma-separated) that can use the quantity selector in the shopping cart. Blank means all users (`glide.sc.allow.quantity`) | List of roles (comma-separated) that can use the quantity selector in the shopping cart. Blank means all users. |
| Enable removal of inactive catalog items from cart (`glide.sc.remove_inactive_cat_items_from_cart`) | Enable removal of inactive catalog items from cart. If enabled, automatically removes all deactivated catalog items from the shopping cart. Avoids users ordering items which are placed in the cart while active and then are made inactive: |
| • **Type**: true | false |
| • **Default value**: false |

| Use the sc_layout driven cart macros (default true) (`glide.sc.use_cart_layouts`) | Use the sc_layout driven cart macros. Activates the new cart layout mechanism, which allows customization of cart widgets and pages without macros or pages: |
| • **Type**: true | false |
| • **Default value**: true |
## Service Catalog properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show tasks related to requests on the order status page (the screen you see in the service catalog after a successful order is placed) <em>(glide.sc.checkout.task.display)</em></td>
<td>Show tasks related to requests on the order status page, the screen that you see in the service catalog after a successful order is placed.</td>
</tr>
<tr>
<td>Round all delivery plans &gt; 1 day to the nearest day (true) or display the precise time (false) <em>(glide.sc.round.delivery.times)</em></td>
<td>Round all delivery plans &gt; 1 day to the nearest day (true) or display the precise time (false).</td>
</tr>
</tbody>
</table>

### Request Fulfillment

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prevent changes to requested item quantity when approved (except for catalog_admin users) <em>(glide.sc.restrict.quantity.changes)</em></td>
<td>Prevent changes to the requested item quantity when approved (except for catalog_admin users).</td>
</tr>
<tr>
<td>Show the current pending approver's name in the stage widget mouseover <em>(glide.sc.approval.hover)</em></td>
<td>Show the current pending approver's name in the stage widget mouseover.</td>
</tr>
<tr>
<td>Service catalog tasks approval engine <em>(glide.approval_engine.sc_task)</em></td>
<td>Service Catalog Tasks approval engine.</td>
</tr>
<tr>
<td>Audit changes to service catalog variables <em>(glide.sc.audit.variables)</em></td>
<td>Audit changes to Service Catalog variables.</td>
</tr>
<tr>
<td>Hide the border and background in variable editor UI <em>(glide.sc.hide_variable_editor_background)</em></td>
<td>If selected, hides the border and background in variable editor UI. Default value is false.</td>
</tr>
<tr>
<td>Use delivery task name instead of short_description for the delivery plan summarizer field. Default is false (uses the short_description) <em>(glide.sc.delivery_summary.name)</em></td>
<td>Use the delivery task name instead of short_description for the delivery plan summarizer field. Default is false (uses the short_description).</td>
</tr>
<tr>
<td>Render variables on a request item as they appear on the order panel, followed by the delivery plan variables (true), or merge the two based on their order values (false) <em>(glide.sc.variable.snapshot)</em></td>
<td>Render variables on a request item as they appear on the order panel, followed by the delivery plan variables (true), or merge the two based on their order values (false).</td>
</tr>
<tr>
<td>Service Catalog Requests approval engine <em>(glide.approval_engine.sc_request)</em></td>
<td>Service Catalog requests approval engine.</td>
</tr>
</tbody>
</table>

### Search

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List of class names for catalog items that do not have the search field displayed <em>(glide.sc.item.cannot_show_search)</em></td>
<td>List of class names for catalog items that do not have the search field displayed.</td>
</tr>
</tbody>
</table>
## Service Catalog properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Allow empty service catalog searches</strong> (<em>glide.sc.search.allow_empty_search</em>)</td>
<td>If selected, empty query in the search bar displays all items. This is performance-heavy.</td>
</tr>
<tr>
<td><strong>List of roles (comma-separated) that can search the service catalog</strong> (<em>glide.sc.can_search</em>)</td>
<td>List of roles (comma-separated) that can search the Service Catalog. Blank means all users.</td>
</tr>
<tr>
<td><strong>Show breadcrumbs for the categories associated with items when they are displayed in browse and search listings</strong> (<em>glide.sc.show_listing_breadcrumbs</em>)</td>
<td>If selected, display breadcrumbs for the categories associated with items when they are displayed in browse and search results.</td>
</tr>
<tr>
<td><strong>Service catalog searches return items in inactive categories</strong> (<em>glide.sc.search.disabled_cats</em>)</td>
<td>Service Catalog searches return items in inactive categories. Search results can include catalog items in non-accessible categories, as specified by the active flag or by security constraints:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> true</td>
</tr>
<tr>
<td><strong>List of catalog sys_ids (comma-separated) that are excluded from catalog item search</strong> (<em>glide.sc.search.exclude_catalogs</em>)</td>
<td>List of catalog sys_ids (comma-separated) that are excluded from catalog item search.</td>
</tr>
<tr>
<td><strong>Number of service catalog matches returned for global searches</strong> (<em>glide.sc.search.rowcount</em>)</td>
<td>Number of the service catalog matches returned for global searches. Limits the number of results returned by a catalog search to improve search performance.</td>
</tr>
<tr>
<td><strong>Specify whether search suggestions should be enabled</strong> (<em>glide.sc.search.suggestions</em>)</td>
<td>Specify whether search suggestions are enabled:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> true</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>Use user criteria to define access to catalog items and categories:</td>
</tr>
<tr>
<td><strong>Use &quot;User Criteria&quot; to define access to catalog items and categories</strong> (<em>glide.sc.use_user_criteria</em>)</td>
<td>Use user criteria to define access to catalog items and categories. Entitlements are not honored if set to true:</td>
</tr>
</tbody>
</table>
Service Catalog properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td>Enable both &quot;User Criteria&quot; and &quot;Entitlement&quot; related lists for catalog items and categories when migrating from entitlements (glide.sc.user_criteria_migration)</td>
<td>Enable User Criteria related lists for catalog items and categories when migrating from entitlements. Set to true to display the user criteria related lists without needing to switch to user criteria functionality:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td>List of roles (comma-separated) that can override normal entitlement checking inside the catalog. A role of &quot;itil&quot; means that the itil role can order any catalog item, even one protected by entitlement restrictions (glide.sc.entitlement.override)</td>
<td>List of roles (comma-separated) that can override normal entitlement checking inside the catalog. A role of &quot;itil&quot; means that the itil role can order any catalog item, even one protected by entitlement restrictions.</td>
</tr>
<tr>
<td>List of roles (comma-separated) that override entitlements so that they can view any category within the service catalog (glide.sc.category.canview.override)</td>
<td>List of roles (comma-separated) that override entitlements to enable viewing of any category within the Service Catalog.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: admin and catalog_admin</td>
</tr>
</tbody>
</table>

**Pricing**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Append pricing information to option labels (glide.sc.enhance.labels)</td>
<td>Append pricing information to option labels. This is also applicable in Service Portal.</td>
</tr>
<tr>
<td>List of class names for catalog items that do not show the price in listings (glide.sc.item.cannot_show_price)</td>
<td>List of class names for catalog items that do not show the price in listings.</td>
</tr>
<tr>
<td>When to show prices and sub-totals on the service catalog cart (overrides sc_layout record settings) (glide.sc.price.display)</td>
<td>When to show prices and sub-totals in the service catalog cart.</td>
</tr>
<tr>
<td>When set to true then the two script includes CatalogPriceCalculator and CatalogRecurringPriceCalculator are used to generate prices (enabling custom functionality) (glide.sc.use_custom_pricegenerator)</td>
<td>When set to true, the script includes CatalogPriceCalculator and CatalogRecurringPriceCalculator to generate prices, which enables custom functionality. To use your own price calculation logic, set this property to Yes. Then enable this property.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Service Catalog properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>- ServiceCatalogPriceCalculator</td>
<td>method inside the <strong>CatalogPriceCalculator</strong> and <strong>CatalogRecurringPriceCalculator</strong> script includes, using your own price calculation algorithm:</td>
</tr>
<tr>
<td>- <strong>Type:</strong> yes</td>
<td>no</td>
</tr>
<tr>
<td>- <strong>Default value:</strong> no</td>
<td></td>
</tr>
</tbody>
</table>

**Portal**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show order confirmation popup in checkout process</strong> (<a href="#">glide.sc.sp.twostep</a>)</td>
<td>If selected, displays the order confirmation window during the two-step checkout process in ServicePortal.</td>
</tr>
<tr>
<td><strong>Use Cart V2 widget in Header Menu widget</strong> (<a href="#">glide.sc.portal.use_cart_v2_header</a>)</td>
<td>If selected, the Cart V2 (SC Shopping Cart widget, ID: sc-shopping-cart-v2) widget is enabled in the Header Menu widget of ServicePortal.</td>
</tr>
</tbody>
</table>

**Virtual Agent**

This section is visible only when you activate the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks).

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Specifies the upper limit for the number of questions beyond which the item does not support conversational requests, default value of the property is 10</strong> (<a href="#">glide.sc.conversational.request.question.limit</a>)</td>
<td>Maximum number of questions for it to be eligible for request submission in the conversation mode in VirtualAgent.</td>
</tr>
</tbody>
</table>

**Mobile**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Catalog category sort option in NOW Mobile</strong> (<a href="#">glide.sc.mobile.category.order_by</a>)</td>
<td>Sort option for categories in NOW Mobile:</td>
</tr>
<tr>
<td>- <strong>Title:</strong> Categories are sorted by their title. By default, categories are sorted alphabetically by their title.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Order:</strong> Categories are sorted by their order.</td>
<td></td>
</tr>
<tr>
<td><strong>Include 'Desktop only' Items in NOW Mobile</strong> (<a href="#">glide.sc.mobile.include_desktop_only_items</a>)</td>
<td>Option to include the catalog item with Availability set to Desktop only in NOW Mobile.</td>
</tr>
<tr>
<td><strong>Catalog item classes not available in NOW Mobile (comma separated list)</strong> (<a href="#">glide.sc.mobile.item_class_not_supported</a>)</td>
<td>Catalog item types to exclude in NOW Mobile. For example, <code>sc_cat_item_content, sc_cat_item_producer</code></td>
</tr>
<tr>
<td><strong>Experience for items not available in NOW Mobile</strong> (<a href="#">glide.sc.mobile.unsupported_discover</a>)</td>
<td>Option to define the non-availability behavior of a catalog item. Possible options:</td>
</tr>
</tbody>
</table>
### Service Catalog properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Discoverable</strong></td>
<td>- show message that item is not viewable in the mobile: Item is discoverable in the search and browse experience but not viewable.</td>
</tr>
<tr>
<td><strong>Not discoverable</strong></td>
<td>- do not show in search and browse experience: Item is neither discoverable in the search and browse experience nor viewable.</td>
</tr>
</tbody>
</table>

**Note:**
- If the AI Search is enabled for NOW Mobile, this property is not applicable.
- This property is supported only when one of the following properties are applicable:
  - Include `Desktop only` Items in NOW Mobile (`glide.sc.mobile.include_desktop_only_items`)
  - Catalog item classes not available in NOW Mobile (comma separated list) (`glide.sc.mobile.item_class_not_supported`)

**Primary color for buttons in the catalog request experience in NOW Mobile** (`glide.sc.mobile.primary_color`)

- Color for buttons in the catalog request experience.

**Other**

**Log all client side actions on variable** (`glide.sc.log.variable_actions`)

- If set to true, captures the variable log in the Variable Action Logger window:
  - **Type:** true | false
  - **Default value:** false

**Use links for breadcrumbs rendered in service catalog pages accessed via a CMS site** (`glide.sc.use_breadcrumb_links.cms`)

- Enables users with the CMS (content_admin) role to choose whether service catalog breadcrumbs are displayed with or without links for greater navigation control:
  - **Type:** true | false
  - **Default value:** false
Service Catalog properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable the ui policies related to variable set to be run first</td>
<td>Enable the UI policies related to variable set to be run first.</td>
</tr>
<tr>
<td>(glide.sc.ui_policy.variable_set_run_first)</td>
<td>If enabled, UI policies related to the variable set are run first, then the UI policies on items:</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td>The maximum number of orphan sc_item_option records to delete when</td>
<td>Maximum number of orphan sc_item_option records to delete when any sc_req_item record is deleted:</td>
</tr>
<tr>
<td>any sc_req_item record is deleted (sc_orphan_item_option_delete_limit)</td>
<td></td>
</tr>
</tbody>
</table>

Service Portal

Service Portal allows you to build a mobile-friendly self-service experience for your users. It interacts with parts of the Now Platform, so users can access specific platform features using Service Portal. It is an alternative to the Content Management System (CMS) based on more modern technologies.

Both expert developers and beginners can configure Service Portal.

Less technical users can make basic configuration changes to the UI using Branding Editor and other components of Service Portal. More advanced users can edit and extend portals, pages, and widgets. Expert users can use the Widget Editor tool to write scripts to power a portal, and even create rich web applications on the Now Platform.

Best practices and tips and tricks for using Service Portal

Explore

• Upgrade to Rome
• Understanding Service Portal
• Service Portal core concepts

Set up

• Set up Service Portal
• Service Portal search
• Configure a portal header menu
• Content Management and Service Portal

Administer

• Single sign-on, logins, and URL redirects
• Service Portal security
• Automated test framework for Service Portal forms
Understanding Service Portal

Service Portal provides a modular user interface framework for quick and easy building of application portals and dashboards for the platform. It helps developers and non-technical administrators create attractive and engaging user experiences that drive employee adoption of critical enterprise applications.

How do you use Service Portal?

Service Portal is an application included in the platform UI, however it includes a visual layer for you to do most of your configuration. In the application navigator, navigate to Service Portal > Service Portal configuration to view the configuration page.

The Service Portal configuration page provides a unique, intuitive way of viewing all the pieces of your portal and how they interact with one another. The configuration page allows you to take advantage of a real-time preview, while configuring portal settings. Use each of the tiles on the configuration homepage to assemble the different components of your portal.

If you prefer the platform layout for configuring Service Portal, you still have the option of creating your portal components within the platform UI. The two options are not separate. Everything you create in the Service Portal configuration page also appears in a table in the platform UI.

Watch this five-minute video for an introduction to the Service Portal user interface, guided tours of the Service Portal, using the Service Portal, chat support, and Virtual Agent. Provides an overview of service portals and their components: the portal itself, pages, widgets, and widget instances.
Also describes the differences between service portals and the Content Management System, or CMS.

**Who uses Service Portal?**
Several different kinds of users can configure a portal.

- **Limited coding:** Service Portal was designed so that even users with limited coding ability or knowledge of the platform UI could set up a portal.

- **ServiceNow Experts:** Users with an understanding of the ServiceNow platform can create portals, set up URL redirects, and view all the components of the portal in a table. Most portal configuration takes place in the Service Portal configuration page, but in specific circumstances, Service Portal administrators may need to do additional configuration directly within the platform.

- **Developers:** Advanced customizations and new widget creation are tasks for a developer or someone who understands AngularJS and Twitter bootstrap.

In all cases, the user configuring a portal must have the `admin` or `sp_admin` role.

**Basic concepts**
You should have a basic understanding of all the following components that make up a portal:

- **Themes:** Themes define the look and feel of the whole portal, but can be overridden by other style configurations.

- **Pages:** Pages control where and how you store portal content. Pages do not have a defined relationship to portal records, they simply exist.

- **Widgets:** Components in Service Portal are called widgets. You can use HTML templates, CSS, client scripts, server scripts, and any JavaScript dependencies to define what a widget does. From an AngularJS standpoint, widgets are essentially a superset of an Angular directive.

- **Most of the data in Service Portal is managed in different locations throughout the system.**

  For example, if you are building a knowledge portal, the data exists in Service Portal, but the knowledge articles are authored and managed in the Knowledge application. The same is true for any other type of content you plan to leverage. Take time to understand which tables contain and control the data you are working with in Service Portal.

**Additional resources**
Service Portal is built using several well known technologies. Use the following websites as resources to help you understand and configure your portal:
• Twitter Bootstrap
• CSS 3 Flexbox
• AngularJS

Service Portal core concepts

Service Portal contains two parts: a framework and a portal. The framework is composed of a set of APIs, Angular services, directives, and tools that help to build portals. The portal is a group of pages linked by page IDs.

After you enter a URL, the framework uses the suffix and picks the appropriate portal to determine the theme and configurations. Then it loads the configured default portal homepage unless the URL has a specified ID.

Each widget added to a page becomes its own instance. A widget instance is basically the application of a widget in a page. Because widgets are reusable and can appear on different pages to do different things, the manifestation of a widget on a page is referred to as a Widget Instance. The page loads with content represented by widgets.

Widget instances get their logic from the base widget template, client scripts, server scripts, and depending on the widget, CSS.

Activate Service Portal

If Service Portal is not active on your instance, you can activate it from the plugin module. You must have the administrator role to activate a plugin.
Locate the Service Portal for Enterprise Service Management [com.glide.service-portal.esm] plugin in the list of plugins. Activate the plugin and select the option to include demo data. For more information on activating a plugin, see the topic.

Activating Service Portal automatically activates the following plugins:
- Service Portal - Knowledge Base [com.glide.service-portal.knowledge-base]
- Service Portal - Service Catalog [com.glide.service-portal.service-catalog]
- Service Portal - Service Status [com.glide.service-portal.service-status]
- Service Portal Configuration Pages [com.glide.service-portal.config]
- Service Portal Designer [com.glide.service-portal.designer]
- Service Portal Surveys [com.glide.service-portal.survey]

**Content Management and Service Portal**

Service Portal is a compelling alternative to the Content Management System (CMS) with a refined user experience. It does not duplicate CMS or platform UI functionality. Users who have sophisticated experiences delivered through CMS may need to invest time into transitioning to Service Portal, especially if the CMS implementation includes complex and customized Service Catalog forms.

**Service Portal compatibility with existing CMS sites**

ServiceNow continues to support CMS in current and upcoming releases. If you have existing CMS sites and activate Service Portal on your instance, your CMS sites will continue to work, as CMS and Service Portal are separate applications.

**Differences between Service Portal and CMS**

Service Portal is an alternative to CMS based on more modern technologies. Major differences include:

**Underlying technology**

CMS uses Jelly, which is not a widely used technology. Service Portal instead uses AngularJS, server-side JavaScript, HTML, and CSS. Any scripts that use Jelly do not work in Service Portal. Building widgets in Service Portal requires knowledge of AngularJS.

**Visual layer**

CMS uses iFrames which can be difficult to work with, limited in terms of styling, and susceptible to upgrade issues. Alternatively, Service Portal is a self-contained application that accesses data...
from other tables on the platform. This enables fine-tuned control over style and responsive design.

**Mobile first**

Unlike CMS, Service Portal is optimized for a mobile environment. For this reason, the following apply to the Service Portal environment:

- Any scripts used in Service Portal can only use APIs supported in a mobile environment. For example, some APIs used in your Service Catalog client scripts may not be supported. For a list of supported APIs, see Service Portal and client scripts.
- Service Portal forms support a maximum of two-columns. As a result, any highly customized Service Catalog forms, such as catalog items and record producers that use containers and variable sets, must be simplified to work in a two-column layout.

If transitioning to Service Portal, review the following resource: .

To understand how core CMS components are configured in Service Portal, refer to the following table.

### CMS and Service Portal components

<table>
<thead>
<tr>
<th>CMS component</th>
<th>Service Portal equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content site</td>
<td>Portal</td>
</tr>
<tr>
<td>Content page</td>
<td>Page</td>
</tr>
<tr>
<td>Content types</td>
<td>Content types link a table to a content page. In Service Portal, content types are no longer required. Record data is queried and displayed using base system widgets. You can add widgets to any number of Service Portal pages. Learn more: <a href="#">Service Portal widgets</a>.</td>
</tr>
<tr>
<td>Layout and dropzones</td>
<td>In Service Portal, pages are made up of containers, rows, and columns. Learn more: <a href="#">Pages</a>.</td>
</tr>
<tr>
<td>Content block</td>
<td>A content block is a reusable piece of content. In Service Portal, content blocks are replaced by widgets. Learn more: <a href="#">Service Portal widgets</a>.</td>
</tr>
</tbody>
</table>
### CMS and Service Portal components (continued)

<table>
<thead>
<tr>
<th>CMS component</th>
<th>Service Portal equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Catalog</td>
<td>Service Catalog pages are rendered using the SC Catalog Item widget in Service Portal. For this reason, Service Catalog forms such as catalog items and record producers are shared between your CMS implementation and Service Portal. If you have a highly customized Service Catalog, you may need to invest time in simplifying your Service Catalog items and client scripts so that they render as expected in Service Portal. Learn more: Service Catalog forms in Service Portal.</td>
</tr>
<tr>
<td>Theme</td>
<td>Theme</td>
</tr>
<tr>
<td>CSS</td>
<td>CSS</td>
</tr>
</tbody>
</table>

### CMS and Service Catalog customizations

Service Portal comes with base system widgets to address common use cases and to display record data. Even though there is no direct migration path from CMS to Service Portal, there may be some items, such as catalog items or knowledge articles, that render as expected in Service Portal without any effort.

However, because Service Portal is supported in a mobile environment, you may need to modify any customized forms and scripts. This approach ensures that the items display well on a mobile device and present a better user experience. Before transitioning to Service Portal, you may need to:

- Refactor client scripts used in your CMS/Service Catalog to use supported mobile APIs and global objects. For a list of supported APIs, see Service Portal and client scripts.
- Build widgets to replace UI Macros and other unsupported scripts. If using a UI Macro in a catalog item form and referencing values on the form, you can use the following workaround instead: Replace a Service Catalog form script with a widget.
- Simplify any complex forms used in your Service Catalog to fit the Service Portal two-column form layout.
- Consider which release supports the required functionality. You may want to upgrade your instance before transitioning to ensure that you have the required base system features.
CMS to Service Portal transition

Your CMS may include complex forms and customizations that do not render as expected in Service Portal. Use this guide to understand how best to modify your CMS and Service Catalog implementation for Service Portal adoption, and to understand how a conversion may affect your users.

If you are considering transitioning from CMS to Service Portal, make sure that you understand the impact of moving to a mobile environment. Review the support level and transition actions.

**Support level and transition actions**

<table>
<thead>
<tr>
<th>CMS component</th>
<th>Service Portal support</th>
<th>Possible transition actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data lookups</td>
<td>The client-side component of a data lookup is not supported in Service Portal. However, the data lookup is applied in the platform when a record is submitted or updated in Service Portal.</td>
<td>While data lookups are not applied in the Service Portal, the record updates as expected in the platform UI when submitted or updated in the Service Portal. If your CMS is used by requesters only, this limitation may not affect your implementation.</td>
</tr>
<tr>
<td>Content blocks</td>
<td>Because Content blocks use Jelly, they are not supported in Service Portal.</td>
<td>In the Service Portal, content blocks are replaced by widgets. Widgets are highly customizable components that can query record data, display and update records, and gather user input. Base system widgets generally cover most use cases. Just as you add content blocks to a page in your CMS, you can add widgets to a page using the Service Portal Designer.</td>
</tr>
<tr>
<td>UI Macros</td>
<td>Because UI Macros use Jelly, they are not supported in Service Portal.</td>
<td>• In Service Portal, you can use widgets instead of UI Macros. Base system widgets generally cover most use cases, but for custom solutions, you can...</td>
</tr>
<tr>
<td>CMS component</td>
<td>Service Portal support</td>
<td>Possible transition actions</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>develop new widgets using AngularJS.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If your implementation includes UI Macros in Service Catalog forms that reference other fields or variables in the form, you can embed the widget inside a Service Catalog variable. Learn more: Replace a Service Catalog form script with a widget.</td>
</tr>
<tr>
<td>UI actions</td>
<td>All server-side UI actions are supported in Service Portal, although <code>setRedirectURL()</code> operations are ignored because Service Portal forms handle redirection in a different way than the platform. The form widget ignores all UI actions marked as Client.</td>
<td>• Refactor any UI actions to remove <code>setRedirectURL()</code> operations. • Check that UI actions are not marked as client.</td>
</tr>
<tr>
<td>Catalog client scripts</td>
<td>Only UI Type options Mobile / Service Portal and All are supported. UI type Desktop is not supported in Service Portal. For a list of supported APIs, see Service Portal and client scripts.</td>
<td>• Update your scripts to remove any unsupported client APIs. • Check that the script UI Type is set to Mobile / Service Portal or All.</td>
</tr>
<tr>
<td>CMS component</td>
<td>Service Portal support</td>
<td>Possible transition actions</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Note:</td>
<td>Synchronous JavaScript calls are not supported in Service Portal and must be replaced by asynchronous calls. For example, the <code>getXMLWait()</code> method of the GlideAjax class is not supported in Service Portal. Instead, use one of the following supported asynchronous methods:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <code>getXML(Function callback)</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <code>getXMLAnswer(Function callback)</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td>For additional information on GlideAjax, refer to GlideAjax.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>To understand the impact of updating your CMS to work in a mobile environment, review.</td>
<td></td>
</tr>
<tr>
<td>UI policies</td>
<td>Scripted UI policies can only use APIs supported in Service Portal. For a list of supported APIs, see Service Portal and client scripts.</td>
<td>Update your scripts to remove any unsupported client APIs.</td>
</tr>
<tr>
<td>Service Catalog variables</td>
<td>Service Catalog variables are supported in Service Portal with the following exceptions:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• UI Macros and UI pages variable types are not supported.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Validation Scripts for variables are not supported. Supported validation types include:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If embedding a widget in a catalog item form, you can use the UI Macro variable type. Learn more: Replace a Service Catalog form script with a widget.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If using variable with annotations, make sure to test your catalog items in Service Portal to ensure that help text displays as expected.</td>
<td></td>
</tr>
<tr>
<td>CMS component</td>
<td>Service Portal support</td>
<td>Possible transition actions</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td></td>
<td>◦ The <strong>Mandatory</strong> field on the variable form.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ Read-only variables.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ All fields in the <strong>Availability</strong> tab of the variable form.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Default variable size is not supported.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Expanding and collapsing help text is not supported. Rather, the <strong>Help text</strong> and <strong>Instructions</strong> fields defined in the Annotations tab on the variable form are always expanded. The <strong>Help tag</strong> does not display.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The List Collector variable displays as a choice list instead of a slushbucket in the Service Portal.</td>
<td></td>
</tr>
<tr>
<td>Order guides</td>
<td>Order Guides in Service Portal use the Order Guide widget.</td>
<td>Large order guides can cause performance issues in the Service Portal. If you have large order guides, you can:</td>
</tr>
<tr>
<td></td>
<td>• Break them into multiple order guides.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Simplify variables used in the order guides.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• As a temporary solution, you can render the Service Catalog item using an iFrame. See <strong>Service Catalog forms in Service Portal</strong>.</td>
<td></td>
</tr>
<tr>
<td>Record producers</td>
<td>Record producers are used in Service Portal with the following differences:</td>
<td>Make sure to test all record producers used in Service Portal to make sure that they behave as expected.</td>
</tr>
<tr>
<td>CMS component</td>
<td>Service Portal support</td>
<td>Possible transition actions</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
|                     | • The sort order for catalog items in record producers is not honored.  
• Date values do not honor time zone when the record producer submits a record.                                                                                                                                                                                                                                                                                                                                                           | In Service Portal, define login behavior by modifying the SPEntryPage script include and setting system properties.  
For more information, see Single sign-on, logins, and URL redirects.                                                                                                                                                                                                                                         |
<table>
<thead>
<tr>
<th>CMS component</th>
<th>Service Portal support</th>
<th>Possible transition actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Variable sets are treated as containers. All previously listed rules apply to variable sets as well as any containers within them.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Default variable size is not supported in Service Portal.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Shopping cart

| The Service Portal includes a base system Shopping Cart widget. | Use the Shopping Cart widget. |

**Service Catalog forms in Service Portal**

Service Catalog forms are rendered within Service Portal widgets in a two-column layout. Complex forms may not display as expected.

**Recommendations when creating Service Catalog forms**

Use the following recommendations as a guide to building scalable forms that can be used in both applications:

- Keep forms simple. Because forms with multiple containers, variable sets, and client scripts do not always display as expected in Service Portal, keep forms short to eliminate conversion and debugging issues.

- Think in mobile. Any support for Catalog Client Scripts or Catalog UI Policies is the same as in mobile. Review the following resource: .

**Form rendering in Service Portal**

Containers and variable sets within Service Catalog forms are translated into a two-column layout when implemented in Service Portal. Service Catalog forms are rendered in Service Portal using the following rules:

- Only the top-level container settings are honored. If there are other containers within the top-level container, they are rendered as a single column. If there are container splits or nested containers within these additional containers, they are rendered as a single column. A top-level container is not a child of any other container.
• There can be a maximum of two columns in Service Portal. If your implementation includes forms with more than two columns, the fields are reorganized into two-columns in Service Portal.

• Variable sets are treated as containers. All previously listed rules apply to variable sets as well as any containers within them.

• Default variable size is not supported in Service Portal.

For other forms in the platform, the view determines how the form displays in Service Portal. For base system tables, the form opens in the Service Portal using the Service Portal table form view.

Example layout conversions

The following examples demonstrate how Service Catalog forms display in Service Portal.

Single-column form

A Service Catalog form with:

• Two containers.
• A single-column layout.

![Service Catalog form example](image-url)
In Service Portal, the single-column layout renders as expected.

Service Portal result

Container1
Variable1
Variable2

Container2
Variable3
Variable4

Two-column layout with subcontainers

A Service Catalog form with:

- A container with a two-column layout.
- A subcontainer with a single-column layout.
- A subcontainer with a two-column layout.

In Service Portal, the two-column layout setting of the subcontainer is ignored. The subcontainer renders as a single column.
Two-column layout with variable sets and subcontainers

A Service Catalog form with:

- Containers with single-column and two-column layouts.
- Variable sets with a two-column layout within containers.
In Service Portal, the two-column layout settings of the variable sets are ignored when inside a container column.
Containers within variable sets

A Service Catalog form with:

- Variable sets with single-column layouts.
- A container with a single-column layout with a container split within a single-column variable set.
- A container with a two-column layout within a single-column variable set.
In Service Portal, the container split and two-column container settings are ignored when inside a single-column variable set.
Service Portal result

Variable1

VariableSet1
  Container1
  Variable2

Variable3

Variable4

VariableSet2
  Container1
  Variable5

Variable6

Variable7

Variable8

**Nested containers**

A Service Catalog form with:

- Containers that contain variable sets.
- Variable sets that contain nested containers.

**Service Catalog form**

In Service Portal, nested container formatting is ignored and displays as a single-column.
### Render a complex form in Service Portal using an iFrame

Because complex forms do not display as expected in Service Portal, you can render catalog items, record producers, and order guides in Service Portal using an iFrame. This workaround is a temporary solution to enable your Service Portal to function as expected while you simplify any complex Service Catalog forms.

When rendering items in an iFrame in Service Portal, the following limitations apply:

- On catalog items and record producers, the attachment icon is not visible. As a result, users cannot attach any files during the submission. As a workaround, you can add the attachment button to your form.
- Click-through for the hover-over icon is not available.
- Forms are not optimized for a mobile environment.

Use the attached resources and follow the instructions detailed in the Community post: [Service Catalog on Service Portal](#).

> **Note:** Be sure to make changes in a test environment before updating your production instance.
Replace a Service Catalog form script with a widget

You can use widgets in Service Portal to replace UI Macros. If your Service Catalog form includes a UI Macro that references other fields or variables on the form, you can create a widget to hold reusable code and embed it within the Service Catalog form. Use special syntax to access any variable fields on the form.

Before you begin
Role required: admin or sp_admin

Procedure
1. Create a widget that performs the action you would like to use in catalog item forms. See step 7 for a simple example widget that accesses another variable on the form.
2. Open a catalog item that previously used a UI Macro or other reusable component not supported in Service Portal.
3. In related lists, add a new variable to the catalog item.
4. Configure the variable form to add the Widget field.
5. In the Type field, select Macro.
6. In the Widget field, select a widget that performs the desired action.
7. Optional: Use the $scope.page.g_form() or $scope.page.field syntax in the embedded widget to access the catalog item values.

Example
This example shows how to modify the value of a single-line text variable with the name color associated with the catalog item.

Widget HTML Template

```html
<div>
  Data from catalog variable:
  <h1>{{ c.data.message }}</h1>
</div>
```

Widget client script

```javascript
function($scope) {
  var c = this;

  //Watch for changes in the color variable
  $scope.$watch(function () {
    return $scope.page.g_form.getValue('color');
  }, function (value) {
```
// Update local data object with data from variable
    c.data.message = value ? 'Content of color variable: ' + value : ''; 
});
}

You can use the following to access variable or catalog item fields:

• $scope.page.g_form(): The g_form instance on the form. You can use all supported g_form methods described in Service Portal and client scripts. For example, g_form.setValue('variable_name', 'new value');.

• $scope.page.field(): The object that represents the variable. When you open the catalog item in the Service Portal, the embedded widget accesses the variable fields associated with the catalog item.

What color would you like?

Blue

Data from catalog variable:

**Content of color variable: Blue**

**Supported features in Service Portal**

Service Portal is an alternative presentation layer for the platform. As such, not all features of the platform are extended to Service Portal. Consider your full application and the abilities of Service Portal before making considerable investments.

**Not currently supported**

• Domain separation at Levels 1-3. However, Service Portal does include support for domain separation at the Data only level. For more information, see Application support for domain separation and Domain separation and Service Portal.

**No plans to support**

• @ Mentions
• Click-through/pop-ups
• Embedded HTML outside of HTML fields
• Embedded lists
• UI macros
• Formatters
• UI actions marked as Client
• Nested container Catalog variables
• Survey wizards
• OpenFrame

Service Portal and client scripts
You can use client scripts and catalog client scripts in the Service Portal if the UI Type is set to Mobile / Service Portal or All. Client scripts and catalog client scripts are used with the Form widget and SC Catalog Item widget, as opposed to a widget client controller.

Before flagging a script as Mobile/Service Portal or All, make sure that you are only using the mobile APIs. Setting a client script to Mobile does not ensure that it will work, it simply flags that the script should be attempted by the mobile app or the Service Portal. Many of your existing client scripts can be set to All as long as the API calls are supported by the mobile client scripting environment.

The topics in this section require advanced coding knowledge and an understanding of Service Portal APIs.

Checking desktop vs mobile runtime
You might want to mark a client script compatible with both desktop and mobile, but include behavior that depends on the runtime. You can use this script:

```javascript
if (window === null)
  // Write your mobile compatible code here
else
  // Write your desktop compatible code here
```

Unsupported client scripting globals
The following globals and APIs are unavailable in client scripts and catalog client scripts used in the Service Portal:

• $
• $$
• $j
• angular
• control
• document
• jQuery
• window

⚠️ **Note:** Widget client controllers are full Angular controllers and are not subject to the unsupported client script globals listed here. Use jQuery and Angular as needed.

**Embedded widgets & g_form**

When using the Service Catalog variable type **Macro** and **Macro with Label**, you can pick a widget to embed in a catalog item form. Within the client controller for the embedded widget you can access the field object and catalog item g_form instance using:

- `$scope.page.field`
- `$scope.page.g_form()`

**Example: Client scripts used with Service Portal**

The g_list global helps you set the filter of a Glide list element or a list collector variable. Use this API in place of the g_filter API on desktop client scripts.

```javascript
function onLoad() {
    var myListCollector = g_list.get("my_list_collector");
    myListCollector.reset();
    myListCollector.setQuery("active=true^category=8c7b22230b402200b0b02c6317673a62");
    myListCollector.addItem('3a700d39af5f4fc0aab978df90f4c692', 'Power Supply');
    myListCollector.addItem('1cb93419a3a248318da8f814140b42f6', 'Backpack');
}
```

**g_service_catalog** is only available in Service Portal service catalog item scripts. Use this API to know if your catalog item script is run as part of an order guide or on its own.

```javascript
function onLoad() {
    if (window) // if CMS, don't run this
        return;

    // g_service_catalog api for Service Portal and Mobile
    var isOrderGuide = g_service_catalog.isOrderGuide();
    g_form.setValue("is_order_guide", isOrderGuide ? "Yes!" : "Nope :(");
}
```
**Supported client script types and APIs**

Some client scripts are not supported in Service Portal. Others must have a UI type set to **All** or **Mobile / Service Portal**. If using a client script in the Service Portal, only client-side APIs supported in a mobile environment can be used.

### Client script support in Service Portal

<table>
<thead>
<tr>
<th>Client script</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog client scripts</td>
<td>Service Portal requires that the <strong>UI Type</strong> field be set to <strong>All</strong> or <strong>Mobile / Service Portal</strong>. Client Scripts marked as <strong>Desktop</strong> rely on legacy APIs that are not supported in Service Portal. Before flagging a script as Mobile / Service Portal or All, make sure you are only using supported client-side APIs.</td>
</tr>
<tr>
<td>Validation scripts</td>
<td>Service Portal requires that the <strong>UI Type</strong> field be set to <strong>All</strong> or <strong>Mobile / Service Portal</strong>. Client Scripts marked as <strong>Desktop</strong> rely on legacy APIs that are not supported in Service Portal. Before flagging a script as Mobile / Service Portal or All, make sure you are only using supported client-side APIs. Validate user input in a specific field type using a validation script. In new instances, Service Portal includes XML, Script, Script (Plain), Email, and Version validation scripts by default. If upgrading from a previous release, the Mobile and Service Portal version is not active by default. You must activate the Mobile and Service Portal version of the validation script to validate user input in the Service Portal. See <a href="#">Activate Service Portal validation scripts</a>.</td>
</tr>
<tr>
<td>UI scripts</td>
<td>Service Portal requires that the <strong>UI Type</strong> field be set to <strong>All</strong> or <strong>Mobile / Service Portal</strong>. Client Scripts marked as <strong>Desktop</strong> rely on legacy APIs that are not supported in Service Portal. Before flagging a script as Mobile / Service Portal or All, make sure you are only using supported client-side APIs.</td>
</tr>
<tr>
<td>UI Actions</td>
<td>All server-side UI actions are supported in Service Portal, although <code>setRedirectURL()</code> operations are ignored because Service Portal forms handle redirection in a different way than the platform. The form widget ignores any UI Actions marked as <strong>Client</strong>.</td>
</tr>
</tbody>
</table>

Note: To call a UI script within a validation script, use the `g_ui_scripts` global object. For more information, see [GlideUIScripts](#). Verify that the UI script has the **Global** field set to false and **UI Type** set to Mobile / Service Portal or All.
<table>
<thead>
<tr>
<th>Client script</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI Policies</td>
<td>Supported, although you should use only declarative UI Policies. Avoid scripting unless the outcome cannot be achieved through the condition builder.</td>
</tr>
<tr>
<td>UI Macros</td>
<td>Not supported as UI macros use Jelly.</td>
</tr>
<tr>
<td>Formatters</td>
<td>Not supported as formatters use Jelly.</td>
</tr>
</tbody>
</table>

**Supported client-side APIs**

Supported client scripting APIs for use in onLoad, onChange, and onSubmit client scripts.

For detailed class and method information, see the API reference.

<table>
<thead>
<tr>
<th>Class</th>
<th>Available methods</th>
</tr>
</thead>
<tbody>
<tr>
<td>g_form</td>
<td>• addDecoration(fieldName, icon, title)</td>
</tr>
<tr>
<td></td>
<td>• addErrorMessage(message)</td>
</tr>
<tr>
<td></td>
<td>• addInfoMessage(message)</td>
</tr>
<tr>
<td></td>
<td>• addOption(fieldName, value, label, index)</td>
</tr>
<tr>
<td></td>
<td>• clearOptions(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• getActionName()</td>
</tr>
<tr>
<td></td>
<td>• getBooleanValue(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• getDecimalValue(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• getEncodedRecord()</td>
</tr>
<tr>
<td></td>
<td>• getFieldNames()</td>
</tr>
<tr>
<td></td>
<td>• getIntValue(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• getLabel(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• getReference(fieldName, callback)</td>
</tr>
<tr>
<td></td>
<td>• getRelatedListNames()</td>
</tr>
<tr>
<td></td>
<td>• getSectionNames()</td>
</tr>
<tr>
<td></td>
<td>• getSysId()</td>
</tr>
<tr>
<td></td>
<td>• getTableName()</td>
</tr>
<tr>
<td></td>
<td>• getValue(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• hasField(fieldName)</td>
</tr>
<tr>
<td>Class</td>
<td>Available methods</td>
</tr>
<tr>
<td>-------</td>
<td>-------------------</td>
</tr>
<tr>
<td></td>
<td>• hideAllFieldMsgs(type: &quot;info</td>
</tr>
<tr>
<td></td>
<td>• hideErrorBox(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• hideFieldMsg(fieldName, clearAll)</td>
</tr>
<tr>
<td></td>
<td>• hideRelatedList(listTableName)</td>
</tr>
<tr>
<td></td>
<td>• hideRelatedLists()</td>
</tr>
<tr>
<td></td>
<td>• isMandatory(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• isNewRecord()</td>
</tr>
<tr>
<td></td>
<td>• isReadOnly(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• isVisible(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• removeDecoration(fieldName, icon, title)</td>
</tr>
<tr>
<td></td>
<td>• removeOption(fieldName, value)</td>
</tr>
<tr>
<td></td>
<td>• save()</td>
</tr>
<tr>
<td></td>
<td>• serialize(onlyDirtyFields)</td>
</tr>
<tr>
<td></td>
<td>• setFieldPlaceholder(fieldName, placeholder)</td>
</tr>
<tr>
<td></td>
<td>• setLabel(fieldName, label)</td>
</tr>
<tr>
<td></td>
<td>• setMandatory(fieldName, isMandatory)</td>
</tr>
<tr>
<td></td>
<td>• setReadOnly(fieldName, isReadOnly)</td>
</tr>
<tr>
<td></td>
<td>• setSectionDisplay(sectionName, isVisible)</td>
</tr>
<tr>
<td></td>
<td>• setValue(fieldName, value, displayValue)</td>
</tr>
<tr>
<td></td>
<td>• setVisible(fieldName, isVisible)</td>
</tr>
<tr>
<td></td>
<td>• showErrorBox(fieldName, message, scrollForm)</td>
</tr>
<tr>
<td></td>
<td>• showFieldMsg(fieldName, message, type: &quot;info</td>
</tr>
<tr>
<td></td>
<td>• showRelatedList(relatedTableName)</td>
</tr>
<tr>
<td></td>
<td>• showRelatedLists()</td>
</tr>
<tr>
<td></td>
<td>• submit(submitActionName)</td>
</tr>
</tbody>
</table>

**Note:** Using the `variables.var_name` notation with the `g_form` API is not supported in Service Portal. `g_form` as a global object cannot be used in a widget client controller or in a UI script.
<table>
<thead>
<tr>
<th>Class</th>
<th>Available methods</th>
</tr>
</thead>
</table>
| g_list               | • `get(fieldName)`  
                      | • `addItem(value, displayValue)`  
                      | • `removeItem(value)`  
                      | • `reset()`  
                      | • `setQuery(queryString)`  
                      | • `setDefaultOperator(operator)`  
                      | • `getDefaultOperator()`  |
| g_service_catalog    | `isOrderGuide()`  |
| GlideAjax            | • `addParam(name, value)`  
                      | • `getParam(name)`  
                      | • `getXML(callback)`  
                      | • `getXMLAnswer(callback)`  
                      | • `getJSON(callback)`  
                      | • `setErrorCallback(errorCallback)`  
                      | • `getURL()`  
                      | • `getParams()`  
                      | • `execute()`  
                      | • `successCallback(data, status, xhr)`  
                      | • `errorCallback(xhr)`  
                      | • `setScope(scope)`  |

**Note:** Because the mobile platform does not allow synchronous GlideAjax calls, the `getXMLWait()` method in a GlideAjax call does not work in the Service Portal. Instead, use one of the asynchronous calls such as `getXML(Function callback)` or `getXMLAnswer(Function callback).

**Note:** GlideAjax cannot be used in a widget client controller.

| GlideRecord          | • `addQuery(encodedQuery)`  
<pre><code>                  | • `addQuery(fieldName, operator, value)`  |
</code></pre>
<table>
<thead>
<tr>
<th>Class</th>
<th>Available methods</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• getEncodedQuery()</td>
</tr>
<tr>
<td></td>
<td>• get(id)</td>
</tr>
<tr>
<td></td>
<td>• getTableName()</td>
</tr>
<tr>
<td></td>
<td>• hasNext()</td>
</tr>
<tr>
<td></td>
<td>• insert(callback)</td>
</tr>
<tr>
<td></td>
<td>• gotoTop()</td>
</tr>
<tr>
<td></td>
<td>• next()</td>
</tr>
<tr>
<td></td>
<td>• loadRow(rowObj)</td>
</tr>
<tr>
<td></td>
<td>• getValue(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• setValue(fieldName, value)</td>
</tr>
<tr>
<td></td>
<td>• isDotWalkField(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• addOrderBy(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• setDisplayFields(fieldNames)</td>
</tr>
<tr>
<td></td>
<td>• query(callback)</td>
</tr>
<tr>
<td></td>
<td>• setRows(rowsArray)</td>
</tr>
<tr>
<td></td>
<td>• setTableName(tableName)</td>
</tr>
<tr>
<td></td>
<td>• setLimit(maxInt)</td>
</tr>
<tr>
<td></td>
<td>• getLimit()</td>
</tr>
</tbody>
</table>

| i18NV3 | getMessage(String messageKey, Function callback)                                   |

**Activate Service Portal validation scripts**

Validate user input in a specific field type using a validation script. In new instances, Service Portal includes XML, Script, Script (Plain), Email, and Version validation scripts by default. If upgrading from a previous release, the Mobile and Service Portal version is not active by default. You must activate the Mobile and Service Portal version of the validation script to validate user input in the Service Portal.

**Before you begin**

Role required: admin

**About this task**

Service Portal requires that the **UI Type** field be set to **All** or **Mobile / Service Portal**. Client Scripts marked as **Desktop** rely on legacy APIs that are not
supported in Service Portal. Before flagging a script as Mobile / Service Portal or All, make sure you are only using supported client-side APIs. See Supported client script types and APIs.

⚠️ Note: To change the UI Type from Mobile / Service Portal to All, delete the Desktop version from your instance to avoid activating conflicting scripts. Before deleting the Desktop version, make a backup in case you need to revert any changes.

Procedure

1. Navigate to System Definition > Validation Scripts.

2. Open the Mobile / Service Portal version of the validation script you would like to use in the Service Portal.

3. Click the Active flag to activate the validation script.

4. Optional: Set the UI Type to All to use the validation script in desktop, mobile, and Service Portal environments. To avoid activating conflicting validation scripts, you must first delete the Desktop version of the script.
   a. Navigate to the desktop version of the validation script you would like to replace. Desktop versions have the UI Type field set to Desktop.
   b. Open the record.
   c. Right-click the header menu and select Export > XML (This Record) to create a backup of the record.
   d. Once the export completes, click Delete and confirm the selection.
   e. Navigate back to the validation script set to Active in earlier steps and change the UI Type to All.

Results

User input into the designated field type in the Service Portal and Mobile environments is validated for correct formatting. For example, if you activated the Email validation script for use in the Service Portal, invalid user input into an Email field generates an error and prevents the browser from submitting the form.

⚠️ Note: On a desktop browser, the field is validated when you submit the record. On a mobile browser, the field is validated when you navigate away from the field.

Portal Analyzer

Get a summary of all widgets that appear on Service Portal pages. Use this data to better understand widget customizations and page usage.
The Portal Analyzer is a scheduled job that runs on-demand. After you select to run the Portal Analyzer job, the system produces a list of each widget and the page that it appears on.

The list also includes the following information:

- Level of customization of each widget
- Number of views on each page
- Number of user visits on each page

You can export the list as a CSV, Excel, XML, JSON, or PDF file. Use the exported list to consider which pages and widgets to focus on while redesigning your portal. For example, you might consider removing a page that has less user visits or replacing a customized widget with a cloned widget.

The Portal Analyzer is active by default on your instance.

Related information

Scheduled jobs

Run the Portal Analyzer

Run a scheduled job to get a summary of all widgets that appear on pages.

Before you begin
Role required: admin or sp_admin
Procedure

1. Navigate to System Definition > Scheduled Jobs.
2. Open the Portal Analyzer record.
3. On the form header, select Execute Now.

Results

The system creates a list of all the widgets on each page in your instance. You can view this list by entering sp_portal_analyzer.list in the application navigator.

What to do next

Export the list as a CSV, Excel, XML, JSON, or PDF file to reference during a system upgrade. For more information on exporting list data, see List export.

Domain separation and Service Portal

Domain separation is unsupported in Service Portal. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: No support

- The domain field may exist on data tables but there is no business logic to manage the data.
- This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation.

Overview

Domain separation provides complete data isolation for domain-specific users.

How domain separation works in Service Portal

Elements of the Service Portal platform such as settings, portals, pages and widgets are not domain-separated. However, the data within widgets does display when based on the appropriate domain. To provide different experiences, admins should create separate service portals, each with unique URLs, that they can redirect users to.

Related information

Domain separation for service providers
Antivirus Scanning in Service Portal

View the health status of file attachments in Service Portal. Antivirus Scanning scans files in the Attachments [sys_attachments] table by default. When viewed from a Service Portal page, attachments may not be available for download depending on their health status.

⚠️ Note: Antivirus Scanning is a Now Platform feature. For more information, see Antivirus Scanning.

Scanning scenarios

Review these scanning scenarios to understand how Antivirus Scanning interacts with attachments in Service Portal.

Upload a file

1. A user uploads an infected file to a record in Service Portal.
2. The system scans the file, moves it to quarantine, and displays a message. The file is unavailable for download. If viewing the record in the Ticket Form page, the thumbnail does not display.
3. The system sends an email notification to the user and the antivirus administrator.
Download a file

1. A user opens a record with an attachment in Service Portal.
2. The system scans the file and moves it to quarantine. The file is unavailable for download. If viewing the record in the Ticket Form page, the thumbnail does not display.
3. The system sends an email notification to the user and the antivirus administrator.
View a file

1. A user opens a record with an infected attachment.
2. The file is unavailable for download. If viewing the record in the Ticket Form page, the thumbnail does not display.

Set up Service Portal

Set up a site for your users using Service Portal.

Requirements


Role required: admin or sp_admin

Before you begin

Take the following into consideration before configuring Service Portal:

• Who are you building your site for and why?
• What information do you want to include in your site?
• What do you want the mobile experience to be for users?
• Which platform applications do you plan to use in your portal?
You can use parts of the platform, such as knowledge articles and catalog items, as the content for your portal.

For example, if you are building a knowledge portal, the content displays in Service Portal, but the knowledge articles are authored and managed in the Knowledge application. The same is true for any other type of content you plan to leverage. It is important to take time to understand the table structure of data to become acquainted with content.

- How customized is your service catalog? Catalog client scripts and UI policies only work in Service Portal if they use the mobile GlideForm API, so you may need to make some changes.

### What to do

#### Create a portal

A portal is the engine that houses all the references to content for your site. The portal record defines the URL extension for a site, as well as things like the knowledge base, catalog, and homepage. You can also use the portal record to define the header menu and the portal branding.

  - Create a portal

#### Create a page

Pages are the centerpiece of the end user experience. Page definitions not only control the layout of the content, they craft the experience for the user. Pages also help define mobile responsiveness, which is a key component in the user experience.

Use any existing page included with Service Portal as an example for your own creation.

Use the Service Portal Designer to create pages, assign layouts, and add widgets.

  - Create and edit a page using the Service Portal Designer

#### Create a widget

Widgets are the power behind the portal. Widgets are highly customizable and can be used to provide an endless variety of experiences for your users. Anytime you add a widget to a page it becomes an instance of itself. Each widget instance has its own record so you can configure it specifically for each use. For example, you can add several Icon Link widgets to a page and
configure them to link to different areas with different icons. None of the widgets are affected by the others.

You can start by cloning an existing widget and making changes to your cloned version. Developers with an advanced understanding of AngularJS can create widgets from scratch.

Create a portal homepage

When a portal is referenced by the URL suffix, it lands on a home page. This homepage is often labeled index in website language. The home page is probably the most important page of your portal as it houses the major information and actions that your users see.

• Assign a homepage to a portal

Configure the header menu

The header menu in a portal is comprised of two separate widgets: a header widget, which determines the style of the header, and the menu widget, which determines the actual items that appear in the header. Configure both widgets for the header menu to appear and act like a header menu in your portal.

• Create a portal header menu
• Add a header or footer to a portal

Configure the branding for the portal

With the Branding Editor, you can configure the styles and theme of your portal in a view with real-time updates. You can see how your portal appears to users with the click of a button. More advanced users still have the option of creating CSS style sheets for the portal theme. However, they cannot take advantage of the real-time update that the Branding Editor provides. Changes made in the Branding Editor or to specific components of the portal (such as a widget or a page container) override any customizations made to the theme.

• Configure portal branding
• Create a portal theme

Next steps

• Configure search in the portal.
• Limit user access to specific components.
• Set up URL redirects.
Service Portal configuration page

Most Service Portal configuration is accessible through the Service Portal configuration page landing page.

In your instance, access the Service Portal configuration page by navigating to Service Portal > Service Portal configuration. The Service Portal configuration page opens in a new tab in your browser.

You can also access the configuration page by appending your URL with sp_config. For example, https://<instance name>.service-now.com/sp_config.

Use each option on the Service Portal config page to set up the different parts of your portal.

Service Portal properties

The Service Portal properties page provides several configuration options for Service Portal.

Administrators can access these properties by navigating to Service Portal > Properties.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Default 404 page (page ID or sp_page sys_id) for Service Portal glide.service_portal.default_404_page | Set the default page that your users see whenever a page cannot load properly.  
- Type: string  
- Default value: 404  
- Learn more: Assign a default error page  
The string must match the name of the page exactly. |
| Show a message to admin users in Service Portal pages if a browser error is encountered glide.sp.show_console_error | • Type: true | false  
• Default value: true |
| Maximum number of stream entries displayed in Service Portal (activity widget, conversation widget, and so on) glide.service_portal.stream_entry_limit | Limit the number of entries users can see in the ticket conversation widget. Users only see the most recent entries and cannot go further back in the history than the max allowed amount.  
- Type: integer  
- Default value: 100 |
| Duration (in seconds) info and error messages persist in the Service Portal before auto-dismissal glide.serviceportal.notification_timeout.seconds | Set the duration in seconds that error and info messages remain on the screen before they are auto-dismissed. If set to 0, messages do not auto-dismiss and require that a user close them.  
- Type: integer  
- Default value: 5  
If the glide.ui.accessibility preference is enabled, messages do not auto-dismiss, regardless of the system |
### Service Portal Properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default sort order for announcements</strong>&lt;br&gt;<code>glide.service_portal.announcement.default.sort_order</code></td>
<td>Define the sort order for banner announcements.&lt;br&gt;• Type: choice list&lt;br&gt;• Default value: Start Date Descending&lt;br&gt;Options include:&lt;br&gt;• Start Date Ascending: The oldest start date appears first.&lt;br&gt;• Start Date Descending: The most recent start date appears first.&lt;br&gt;• End Date Ascending: The oldest end date appears first.&lt;br&gt;• End Date Descending: The most recent end date appears first.</td>
</tr>
<tr>
<td><strong>Enable debug runtime information</strong>&lt;br&gt;<code>glide.sp.debug</code></td>
<td>Controls whether the Angular.js flag <code>$compileProvider.debugInfoEnabled</code> is set to true or false. This option allows debug runtime information in the compiler, such as adding binding information and a reference to the current scope on to DOM elements. This property is disabled by default to improve performance on the instance.&lt;br&gt;• Type: true</td>
</tr>
</tbody>
</table>

If user criteria `[com.glide.service-portal.user-criteria]` is enabled, the following properties also appear in the Service Portal properties page:
User criteria properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enable use of User Criteria records instead of Roles fields for Service Portal entitlements | Define permissions for Service Portal widgets, widget instances, pages, and search sources.  
  - Type: true | false  
  - Default value: true  
  - More information: User criteria for Service Portal |
| List of roles (comma-separated) that bypass User Criteria validation in Service Portal | Allow users with a specific role to see any page, widget, widget instance, or search source regardless of user criteria.  
  - Type: string  
  - Default value: admin |

Create a portal

Create a portal for users to browse company resources, discover articles, and get help.

**Before you begin**
Role required: admin or sp_admin

**Procedure**
1. Navigate to Service Portal > Portals, then click **New**.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name to define your portal. In the browser header and for bookmarks, the title appears as &lt;Portal Title&gt; - &lt;Page Title&gt;.</td>
</tr>
<tr>
<td>URL suffix</td>
<td>Value that appears appended to an instance URL when you access a portal. For example, if you use sp, the instance URL for that portal would be &lt;instance name&gt;.service-now.com/sp.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ensure that this value is unique and is not the same as any other portal.</td>
<td></td>
</tr>
<tr>
<td>Note: Avoid using reserved words in your URL to prevent errors when navigating to your portal page. Avoid words such as portal and cms. Also avoid any JavaScript protected terms.</td>
<td></td>
</tr>
<tr>
<td>Homepage</td>
<td>Page that users see first after they sign in.</td>
</tr>
<tr>
<td>KB home page</td>
<td>Custom home page that users see when they go to a knowledge base.</td>
</tr>
<tr>
<td>Login page</td>
<td>Custom page to authenticate users.</td>
</tr>
<tr>
<td>Logo</td>
<td>Logo that appears in the page header. You can also configure the logo in the Branding Editor.</td>
</tr>
<tr>
<td>Icon</td>
<td>Icon that appears in the address bar for your portal. Each portal that you create can have a different icon.</td>
</tr>
<tr>
<td>Default</td>
<td>Portal to use as your main portal.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the portal. This field is uneditable and Global by default.</td>
</tr>
<tr>
<td>404 page</td>
<td>Default page that your users see whenever a page cannot load properly. You can also define a default 404 page using the glide.service_portal.default_404_page system property.</td>
</tr>
<tr>
<td>Catalog home page</td>
<td>Custom page to represent the Service Catalog.</td>
</tr>
<tr>
<td>Catalog category home page</td>
<td>Page to display catalog categories in the portal.</td>
</tr>
<tr>
<td>Main menu</td>
<td>Reference to the menu in the Instances with Menu [sp_instance_menu] table that appears in the header.</td>
</tr>
<tr>
<td>Theme</td>
<td>Refers to a theme in the Themes [sp_theme] table that defines the style and branding for the portal. The theme is the lowest level of style configuration. Any changes made in the Branding Editor or to specific portal components (such as widget or container CSS) override those styles.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Quick start</td>
<td>Schema that defines configuration items in the Branding Editor. In JSON format, you can define the fields and records used to generate your branding options.</td>
</tr>
<tr>
<td>config</td>
<td></td>
</tr>
</tbody>
</table>
|                  | ```
|                  | [{  
|                  |   "tagline": {  
|                  |     "table": "sp_instance",  
|                  |     "sys_id": "34fe3d96cb20020000f8d856634c9cf4",  
|                  |     "field": "title"  
|                  | },  
|                  |   "hero_background": {  
|                  |     "table": "sp_container",  
|                  |     "sys_id": "be98a8d2cb20020000f8d856634c9c63",  
|                  |     "field": "background_image"  
<p>|                  | }```                                                                                                                                         |
| CSS variables    | Portal-specific Sass variables. You can overwrite existing theme variables here.                                                                                                                        |
|                  | ▪ <strong>Note:</strong> Use the CSS variables field to define CSS variables only. Use CSS Includes to define CSS rules. As of the Madrid release, Sass and LESS can be used within CSS Includes. For more information on CSS Includes, see Create a portal theme. |
| Hide portal      | Option to hide the portal name in the page title.                                                                                                                                                    |
| name             |                                                                                                                                                                                                            |
| Enable favorites | Option to enable the My favorites functionality in the portal.                                                                                                                                             |
|                  | ▪ Displays the favorite icon (⭐) for all catalog items and KB articles in the portal.                                                                                                                      |
|                  | ▪ Displays the My Favorites menu item in the portal header. This menu item displays a list of all catalog items or KB articles that are bookmarked for quick reference.                                           |
|                  | ▪ <strong>Note:</strong>                                                                                                                                        |
|                  |   ◦ Only searchable catalog items or KB articles that are selected as favorites are displayed in this list.                                                                                               |
|                  |   ◦ This is applicable only for Service Portal. For other portals, you can clone the My Favorites menu item.                                                                                               |
|                  | You may need to configure the form to add this check box.                                                                                                                                             |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AI Search</td>
<td>Option to enable AI Search in your portal. For more information, see <a href="#">AI Search in Service Portal</a>.</td>
</tr>
<tr>
<td>Enable AIS</td>
<td></td>
</tr>
<tr>
<td>Search Application</td>
<td>Defines the search experience settings for your portal, such as the search engine, search results limit, and suggestions limit. For more information on defining a search application configuration, see <a href="#">Defining search application configurations</a>.</td>
</tr>
<tr>
<td>Search Results</td>
<td></td>
</tr>
<tr>
<td>Configuration</td>
<td>Defines how search results are displayed in the portal. For more information on defining a search results configuration, see <a href="#">Define a composite dataset</a>.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3. Save the form.

4. In the Knowledge Bases related list, select **Edit** and then select which knowledge bases appear for the knowledge base page. For example, if you select **IT** and **Instance Security Center**, only the article categories defined for these knowledge bases appear in the **KB categories widget**.

5. In the **Catalogs** related list, click **Edit** to select one or more catalogs listed in the sc_catalog table to use in the portal.

### Configure a catalog in Service Portal

Associate a portal with multiple catalogs. By default, Service Portal is associated with Service Catalog.

**Before you begin**

Role required: admin or sp_admin

**Procedure**

1. Navigate to **Service Portal > Portals**.
2. Click the **Service Portal** record.
3. To associate a portal with a catalog, perform the following steps.
a. In the **Catalogs** related list, click **Edit**.

b. Select one or more catalogs to add to the portal. The categories and catalog items associated with the selected catalogs are displayed in Service Portal.

**Note:**

- If no catalogs are selected, all active catalogs accessible to the requester are available in Service Portal.
- Irrespective of the catalogs associated with the portal, items are searched for only in the catalogs configured in the search source in AI Search. For information on configuring AI-based catalog search experience, see *Configure AI-based catalog search experience*.

4. **Optional:** To edit the label for a catalog, perform the following steps.
   a. For the **Main menu** field, click **Open Record**.
   b. From the **Menu Items** section, Click the **Catalog** record.
   c. In the **Label** field, specify the label for the catalog. The catalog label is displayed in the main menu of Service Portal.

5. Click **Update**.

**Related information**

- **Service Catalog in Service Portal**

**Associate a portal with a knowledge base**

You can associate a portal with any knowledge base. Multiple knowledge bases can be associated with a portal.

**Before you begin**

Role required: admin or sp_admin

**Procedure**

1. Navigate to **Service Portal > Portals**.
2. In the **Knowledge Bases** related list. Click the **Edit** button.
3. Select one or more knowledge bases to add to the portal. The knowledge bases are displayed in Service Portal page listed in the **KB Home page** for the
portal. If no knowledge bases are selected, all knowledge bases are available in the portal.

4. Click **Update**.

**Related information**

Configure the Knowledge Management Service Portal

**Configure Agent Chat in Service Portal**

Your end users can initiate and maintain an Agent Chat conversation in any portal page. Write a script to pass portal-specific data to Agent Chat. For example, pass the name of your knowledge base to a Virtual Agent conversation.

**Before you begin**

Role required: admin

- Activate the Glide Virtual Agent (com.glide.cs.chatbot) or the Agent Chat (com.glide.interaction.awa) plugin. You can activate the Glide Virtual Agent plugin only if you have a subscription.

**Procedure**


2. Click **New**.

3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Select to make the configuration active.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a unique name for the configuration record.</td>
</tr>
<tr>
<td>Portals</td>
<td>Select the portals in which you would like to use the specified chat configuration. If no portal is selected, the configuration applies to all portals in the system.</td>
</tr>
<tr>
<td>Application</td>
<td>Read-only application scope for the record.</td>
</tr>
<tr>
<td>Public</td>
<td>Select to make Agent Chat available to users before they log in.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Roles</td>
<td>Select the roles a user must have to use Agent Chat. If you don’t select a role, Agent Chat is available to all users regardless of their role.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter a number indicating the order that the configurations should run. Only one configuration applies per portal. If there are multiple configurations on a portal, the system runs the first configuration found from lowest to highest.</td>
</tr>
<tr>
<td>Server script</td>
<td>Write a script that passes page and widget data to an Agent Chat conversation when a user initiates the conversation. For example, pass a field to the chat conversation to enable Agent Chat to access the value. Data passed in this script is available to every page in the portal associated with this record. This script has access to the GlideSPScriptable API. Note: The portal suffix, page ID, and language are automatically available to Agent Chat and do not require a custom script. Sys ID and table are automatically available to Agent Chat when they are present in the URL. This example returns an object containing the list of catalogs associated with the portal to the current conversation.</td>
</tr>
</tbody>
</table>

```javascript
(function ($sp) {
    return {
        catalogs: $sp.getValue('catalogs')
    };

})(sp);  
```

When Agent Chat opens in an iframe HTML element, the list of catalogs is included in the iframe URL. Parameters from this field override any conflicting page data passed to Agent Chat.

4. Click Submit.

Results

Users can initiate and maintain an Agent Chat conversation from any page in the selected portal.
Customize the Agent Chat button

You can change the color and images that are used in the Agent Chat button in your portal.

Before you begin
If you plan to replace one or both of the images that are used in the Agent Chat button, upload the images to your instance. For more information on uploading an image, see Storing images in the database.

Role required: sp_admin or admin

About this task
You can configure the following elements of the Agent Chat button:

• The image to indicate that the chat window is open
• The image to indicate that the chat window is closed
• The button background color

These elements are determined in the portal theme. To customize the Agent Chat button, update the relevant SCSS variables in the portal theme record.

Procedure
1. Navigate to Service Portal > Themes.
2. Open a theme record.
3. In the CSS variables field, add the following variables:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$sp-agent-chat-btn-close</td>
<td>Image to indicate that the chat window is closed. Use an image URL that contains:</td>
</tr>
<tr>
<td></td>
<td>• Your instance address</td>
</tr>
<tr>
<td></td>
<td>• The name of the Image [db_image] record to reference</td>
</tr>
<tr>
<td></td>
<td>For example, to reference the tack-icon.png image in the database, enter the following:</td>
</tr>
<tr>
<td></td>
<td>$sp-agent-chat-btn-close:</td>
</tr>
<tr>
<td></td>
<td>url(&quot;https://&lt;instance-name&gt;.service-now.com/tack-icon.png&quot;);</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
</table>
| $sp-agent-chat-btn-open | Image to indicate that the chat window is open. Use an image URL that contains:  
  • Your instance address  
  • The name of the Image [db_image] record to reference  
For example, to reference the book-icon.png image in the database, enter the following: |

```plaintext
$url("https://<instance-name>.service-now.com/book-icon.png");
```
<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
</table>
| $sp-agent-chat-bg | Button background color. Use a Hex code to set the color. For example, to use red, enter the following:  

$sp-agent-chat-bg: #ff0000;

To use the default image, remove the variable.
<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>To use the default background color, remove the variable.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

**Migrate from the Virtual Agent Service Portal widget**

If you are upgrading from a previous release, your portal implementation may include the Virtual Agent Service Portal widget. Migrate widget options to the Agent Chat in Service Portal configuration and remove all instances of the widget to enable your users to initiate and maintain an Agent Chat conversation in any portal page.

**Procedure**

1. Record instance options and delete instances of the Virtual Agent Service Portal widget.
   a. Locate each instance of the Virtual Agent Service Portal widget and open the instance options.
   b. Record the values.
   c. Delete the widget instance.

2. If your widget instance included a color instance option, add the color variable to the portal theme record.
   a. Navigate to **Service Portal > Themes**.
   b. Open the theme record for the portal.
   c. In the **CSS variables** field, add the `$sp-agent-chat-bg` variable and set the value to the desired color.

**Example**

```
$sp-agent-chat-bg: #ff0000
```
3. If your widget instance options included URL parameters, add them to the Service Portal Agent Chat Configurations form **Server script** field.

**Note:** The portal suffix, page ID, and language are automatically available to Agent Chat and do not require a custom script. Sys ID and table are automatically available to Agent Chat when they are present in the URL.


b. In the **Server script** field, write a custom script to pass the parameters to Agent Chat.

**Example**

This example returns the value of the chat_queue field to the current conversation.

```javascript
(function ($sp) {
  return {
    chat_queue: $sp.getValue('chat_queue')
  }

})(sp);
```

**Results**

Widget instances are removed from individual portal pages. Instead, the portal applies the Service Portal Agent Chat Configurations record to every portal page.

**Pass page data to Agent Chat**

Use the `spContextManager` class in a widget client script to pass dynamic page data to Agent Chat. For example, pass the number of approvals in the Approvals widget to Agent Chat when a user initiates a conversation from the Service Portal homepage.

**Before you begin**

Role required: admin

Examine the widget to understand how data is passed to the widget client script. To make data available to Agent Chat, you must pass it to the `spContextManager` service. You can then access the data in a Virtual Agent topic using the `vaContext` object. For more information about using context variables in Virtual Agent scripts, see Virtual Agent scripts.
Procedure

1. Open the widget in the widget editor.
2. Update the widget client script.
   a. Inject the `spContextManager` service into the widget client script function.
   b. Pass variables to Agent Chat using the `spContextManager` API.
      This example passes `approval_count` to Agent Chat. When a user initiates a conversation from the Service Portal homepage, the system appends `&sysparm_approval_count=5` to the Agent Chat iframe URL.

```javascript
function ($scope, spContextManager) {
  spContextManager.addContext('agent-chat', {
    'approval_count': 5
  });
}
```

Keys passed to this API are unique per page. For example, if the `agent-chat` key is already initialized by another widget on the page through the `addContext()` method, you must use the `updateContextForKey()` method to update the key’s data. For more information about the `spContextManager` class, see `spContextManager`.

3. Click Save.
4. Use Service Portal data in a Virtual Agent topic.
   a. Navigate to Virtual Agent > Designer and open the topic in which you would like to use Service Portal data.
   b. Click Edit Topic Flow.
   c. Configure the topic as needed. In a script field, use the `vaContext` object to access the context variable passed from the Service Portal.
      For more information about creating a Virtual Agent topic, see Create a Virtual Agent topic.

Example

For example, this script accesses the value of the `approval_count` variable in the Approvals widget.

```javascript
(function execute() {
  return "Your approval count is: " + vaContext.approval_count;
}
```
d. Save and publish the topic.

**Results**
Agent Chat can access the variables when an end user initiates a conversation from the Service Portal page.

---

**Remove Live Chat link from the header menu**
If your portal includes a Live Chat link in the header menu, you can remove it by updating the widget's option schema.
Before you begin
Role required: admin

About this task
Adding the **Chat Queue** field to a portal record adds the Live Chat link to the portal’s header menu. If you integrate your portal with Agent Chat, the Live Chat link is no longer needed.

Procedure
1. In the Service Portal configuration page, navigate to **Portal Tables > Instance with Menu**.
2. Open the record for your portal’s header menu. For example, open **SP Header Menu** if using the base system portal.
3. In the **Additional options, JSON format** field, add the following JSON key-value pair.

```json
"enable_live_chat": {
    "displayValue": "false",
    "value": false
}
```

The final JSON looks like this.

```json
{
    "enable_cart": {
        "displayValue": "true",
        "value": true
    },
    "enable_wishlist": {
        "displayValue": "true",
        "value": true
    },
    "enable_live_chat": {
        "displayValue": "false",
        "value": false
    }
}
```

4. Click **Update**.

Results
When you navigate to the portal, **Live Chat** does not appear in the header menu.
Service Portal styles

Pages are made up of containers, columns, rows, widgets, and widget instances. You can configure the CSS of each component, or use the CSS defined in theme and branding as global definitions for the portal. If you do not define CSS in theme or branding, Bootstrap defaults are used.

You can define CSS in your portal at multiple levels.

**Bootstrap defaults**

If no other CSS is defined, all elements use Bootstrap version 3.3.6 defaults. You can use Bootstrap CSS Helper Classes with any Service Portal field that accepts CSS as a value. To show or hide Service Portal containers, use Bootstrap CSS Responsive Utilities Helper Classes such as `visible-lg` or `hidden-md`.

**Branding editor theme colors/Portal CSS**

CSS defined in the Branding Editor Theme Colors tab. Changes made to the theme colors in the Branding Editor appear in the CSS variables field in the portal table `[sp_portal]`.

Customizing the theme colors overwrites the Bootstrap defaults.

**Theme CSS**

CSS defined in the CSS variables field in the Themes table `[sp_theme]`. Use the Theme CSS as much as possible to allow for more flexible evolution of your portal in the future.

Using a theme overwrites the Portal CSS/Branding Editor theme colors.

**Page CSS**

CSS defined in the Page Specific CSS field in the Pages table `[sp_page]`. 
Page-specific CSS overwrites the theme CSS.

**CSS classes**
You can define CSS classes elements on the page within each respective record.

**Widget CSS**
CSS defined in the CSS field in the Widgets table [sp_widget].
Widget CSS overwrites container, column, and row CSS.

**Widget instance CSS**
CSS defined in the CSS field in the Instance table [sp_instance].
Widget instance CSS overwrites all other CSS definitions.

Configure portal branding

Use Branding Editor to give your portal its own look and feel.

To access the Branding Editor, navigate to **Service Portal > Service Portal Configuration**, then click **Branding Editor**.

Select the portal you want to customize the theme for from the portal list. Then use the options on the Quick Setup and Theme Colors tabs to customize your portal.
Quick Setup tab options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portal Title</td>
<td>The name of your portal. Changing the name of the portal in the Branding Editor also changes the title on the portal form field in the platform UI.</td>
</tr>
<tr>
<td>Logo</td>
<td>The logo that appears in the header for your portal. This image is scaled to a maximum height of 46 px and a maximum width of 200 px.</td>
</tr>
<tr>
<td>Logo padding</td>
<td>Where you want the logo to sit in location to the edge of the header. This information is stored in the CSS variables section on the portal form.</td>
</tr>
<tr>
<td>Tag line &amp; background</td>
<td>Fields defined by the JSON schema in the <code>Quick start config</code> field on the portal record in the platform UI. The sample Service Portal adds <strong>Tag Line</strong> and <strong>Background</strong> to the Branding Editor using the following schema:</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>[ {</td>
</tr>
<tr>
<td></td>
<td>&quot;tagline&quot;: {</td>
</tr>
<tr>
<td></td>
<td>&quot;table&quot;: &quot;sp_instance&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;sys_id&quot;: &quot;34fe3d96cb20020000f8d856634c9cf4&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;field&quot;: &quot;title&quot;</td>
</tr>
<tr>
<td></td>
<td>},</td>
</tr>
<tr>
<td></td>
<td>&quot;hero_background&quot;: {</td>
</tr>
<tr>
<td></td>
<td>&quot;table&quot;: &quot;sp_container&quot;,</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td></td>
<td>]</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
</tbody>
</table>
Quick Setup tab options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag line</td>
<td>Introduce your users to a portal page with a tag line. This text is stored in an instance of the homepage search widget.</td>
</tr>
<tr>
<td>Tag line color</td>
<td>Select a color for the tag line.</td>
</tr>
<tr>
<td>Homepage background color</td>
<td>Add a color for your background. You can type in a color name, hex color, decimal (RGB), or select from the color palate.</td>
</tr>
<tr>
<td>Background image</td>
<td>Upload an image to appear in the background of your homepage. This image is stored in the container for the widget on your homepage.</td>
</tr>
</tbody>
</table>

For any colors on the theme tab, you can use the standard color name, hex code, decimal (RGB) code, or select the color from the color palate. All the color definitions are stored in the CSS variables field of the portal form. The theme preview updates in real time as you make changes.

Theme colors tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navbar</td>
<td>Use the fields in this section to customize the colors for the header menu.</td>
</tr>
<tr>
<td>Brand</td>
<td>Use the fields in this section to customize the page colors. For example, the page background or the widget background.</td>
</tr>
<tr>
<td>Text</td>
<td>Use the fields in this section to customize the color of the text on a page.</td>
</tr>
</tbody>
</table>

Changes made to the theme colors in the Branding Editor appear in the CSS variables field of the portal form in the platform UI.

Activate La Jolla theme branding

Activate the Service Portal La Jolla Brand to apply the latest ServiceNow branding, which includes WCAG-AA compliance for contrast. This plugin is
active by default on new instances, but admins must activate the plugin on instances upgraded from earlier versions.

**Before you begin**
Role required: admin

**About this task**
The **Service Portal La Jolla Brand Update** activates these related plugins if they are not already active.

<table>
<thead>
<tr>
<th>Plugins for Service Portal La Jolla Brand Update</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Plugin</strong></td>
</tr>
<tr>
<td>Service Portal La Jolla Brand</td>
</tr>
</tbody>
</table>

**Note:** If you have modified the /sp or sp_config portal pages before installing the plugin, you may not see all elements of the La Jolla branding. All branding images are located in the db_image table for manual updates to your custom portals.

To purchase a subscription, contact your ServiceNow account manager. After purchasing the subscription, activate the plugin within the production instance. You can evaluate the feature on a sub-production instance without charge by requesting it from the HI Customer Service System.

**Procedure**

1. Navigate to **System Applications > All Available Applications > All.**
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see **Request a plugin.**
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   ! **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

**Related information**

**Create a portal theme**

If you need more customization than Branding Editor can provide, you can create your own custom theme.

Only users with an understanding of CSS should create custom themes.

1. Navigate to **Service Portal > Themes**, then click **New**.

2. Complete the form fields and select **Save**.
### Theme form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your theme. Use this name to associate the theme with your portal. This name is not visible to users, you should know it to apply the correct theme to a portal.</td>
</tr>
<tr>
<td>Application</td>
<td>The record scope. The header menu record and the source table must have the same application scope.</td>
</tr>
<tr>
<td>Header</td>
<td>List of headers and footers from the sp_header_footer table that you can associate with a portal theme. Headers and footers are widgets and can be configured the same way.</td>
</tr>
<tr>
<td>Footer</td>
<td>List of headers and footers from the sp_header_footer table that you can associate with a portal theme.</td>
</tr>
<tr>
<td>Fixed header</td>
<td>Locks the header at the top of the page so that when a user scrolls the header remains on the screen.</td>
</tr>
<tr>
<td>Fixed footer</td>
<td>Locks the footer at the bottom of the page so that when a user scrolls the footer remains on the screen.</td>
</tr>
<tr>
<td>CSS variables</td>
<td>CSS custom properties that you can use to change the color and styles in a portal. For example, the stock theme uses some of the following variables:</td>
</tr>
</tbody>
</table>

```bash
$sp-logo-margin-x: 15px !default;
$sp-tagline-color: $text-color !default;
$navbar-inverse-bg: #3a3f51 !default;
```

**Note:** Use the CSS variables field to define CSS variables only. Use CSS Includes to define CSS rules. As of the Madrid release, Sass and LESS can be used within CSS Includes. For more information on CSS Includes, see [Create a portal theme](#).

3. To add a style sheet to the theme, in the **CSS Include** related list, click **New**.
4. Complete the style sheet form fields, the click **Save**.

**Style sheet form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the CSS Include. Remember this name to associate the CSS Include with the theme.</td>
</tr>
<tr>
<td>Application</td>
<td>The record scope. The header menu record and the source table must have the same application scope.</td>
</tr>
<tr>
<td>Source</td>
<td>Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Style Sheet</strong>: Add an internal style sheet that has been uploaded to the CSS table [sp_css]. For example, ng-sortable.min.css. Internal style sheets use standard CSS in the CSS field.</td>
</tr>
<tr>
<td></td>
<td>• <strong>URL</strong>: Link to an external style sheet. Use external style sheets to use the same CSS as a corporate website or other online resource.</td>
</tr>
<tr>
<td>Style sheet</td>
<td>Associate a style sheet or CSS file URL, depending on which option you select in the Source field.</td>
</tr>
</tbody>
</table>

5. To add a JavaScript include to the theme, in the **JS Include** related list, click **New**.
6. Complete the JS Include form fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the JS Include. Remember this name to associate the JS Include with the theme.</td>
</tr>
<tr>
<td>Application</td>
<td>The record scope. The header menu record and the source table must have the same application scope.</td>
</tr>
<tr>
<td>Source</td>
<td>Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>UI Script</strong>: Add an internal UI script that has been uploaded to the UI script table [sys_ui_script]. UI scripts allow you to create client-side JavaScript and reuse it in multiple locations. For more information on UI scripts, see .</td>
</tr>
<tr>
<td></td>
<td>• <strong>URL</strong>: Link to an external JavaScript file. Use external URLs to use the same JavaScript as a corporate website or other online resource.</td>
</tr>
<tr>
<td>UI Script or Java file URL</td>
<td>Associate an internal UI script or Java file URL, depending on which option you select in the Source field.</td>
</tr>
<tr>
<td>Updated</td>
<td>Date and time that the JS Include was last updated</td>
</tr>
<tr>
<td>Package</td>
<td>The Service Portal package that the JS include is associated with. For example, Service Portal Configuration Pages. This field is populated by default.</td>
</tr>
</tbody>
</table>
Configure a portal header menu

Service Portal is designed to allow customers to have deep control over the behavior of their portals. One of the main navigation controls for users is the header main menu. The menu options are determined by the assignment of a main menu to the portal, but the look and behavior of the menu is defined within the theme and associated header.

About this task
Configuring a portal header with a menu involves several steps.

Procedure
1. Create a header and add it to a theme.
   Until you add a theme with a header to a portal, the header menu does not display.

2. Create a main menu with menu items and assign it to the portal.
   The main menu record is where you assign which navigation options appear in the header. For example, you can add a menu item that links to another page within your portal, such as the service catalog.

Results
The main menu and header form a header menu when associated with a theme and a portal.

Add a header or footer to a portal

Use the theme to add a header or footer to your portal.

Procedure
1. Navigate to the portal theme (Service Portal > Service Portal Configuration > Portal Tables > Themes) then click the theme you want to add the header or footer to.

2. In the header or footer field, select the header or footer you want to use for your portal.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
If you are just getting started, you can reuse the base system Stock Header or Sample Footer widgets.

3. **Optional:** Select **Fixed Header** or **Fixed Footer** to lock the header or footer in one place so when users scroll up or down they remain in the same location on the page.

4. To configure the appearance of the header, in the Service Portal configuration page, open the Branding Editor. Under the **Theme Colors** tab, use the color selectors in the Navbar section to control the colors in the header.

Create a portal header menu

Create a menu with menu items to display in the header of a portal.

**Procedure**

1. In the Service Portal configuration page (Service Portal > Service Portal Configuration), navigate to Portal Tables > Instance with Menu and click **New**.

2. Complete the fields in the menu form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the header menu. You need to know this when you associate the menu with your portal.</td>
</tr>
<tr>
<td>Additional options, JSON format</td>
<td>Advanced configuration options. For example, use this field to enable the shopping cart in the header menu with the following code:</td>
</tr>
</tbody>
</table>
|                                            | `{  
  "enable_cart": {  
  "displayValue": "true",  
  "value": true  
  }
  }
| Application                                | The record scope. The header menu record and the source table must have the same application scope. |
| Widget                                     | The widget that the header menu is based on. Select a menu-type widget from the list. For example, the header menu widget that is included as a base system widget. |

3. Save the form, and then click **Menu Items** from the related lists.
4. Click **New** and complete the menu item form.

### Menu item fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Name that appears for the item in the menu</td>
</tr>
<tr>
<td>Parent menu</td>
<td>This field should already contain the name of the menu you are adding items to. You can change the value as needed to other menus.</td>
</tr>
<tr>
<td>Parent menu item</td>
<td>Use this field to nest menu items within other menu items</td>
</tr>
<tr>
<td>Order</td>
<td>Value that determines where the item appears in the menu in relation to other menu items</td>
</tr>
<tr>
<td>Type</td>
<td>The kind of page the item links to. Form fields vary depending on the option that you select from this list. Choose from:</td>
</tr>
<tr>
<td></td>
<td>• Page: Link to another page in the Service Portal.</td>
</tr>
<tr>
<td></td>
<td>• URL: Link to an external website. To have the URL open on a new browser tab or window, enter _blank in the <strong>URL target</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• Service Catalog: Link to the Service Catalog.</td>
</tr>
<tr>
<td></td>
<td>• Catalog Category: Link to a specific catalog category within the Service Catalog.</td>
</tr>
<tr>
<td></td>
<td>• Catalog Item: Link to a specific catalog item.</td>
</tr>
<tr>
<td></td>
<td>• Knowledge Base: Link to the knowledge base that you previously configured as the portal's default knowledge base.</td>
</tr>
<tr>
<td></td>
<td>• KB Topic: Link to a KB topic page.</td>
</tr>
<tr>
<td></td>
<td>• KB Article: Link to a KB article by number.</td>
</tr>
<tr>
<td></td>
<td>• KB Category: Link to a specific KB category within the knowledge base.</td>
</tr>
<tr>
<td></td>
<td>• Filtered List: Set conditions to determine which page to link to.</td>
</tr>
<tr>
<td></td>
<td>• Scripted List: Enter a script to determine which page to link to.</td>
</tr>
<tr>
<td>Page</td>
<td>Name of the portal page the item links to. This option is available if you select <strong>Page</strong> as the menu item type.</td>
</tr>
<tr>
<td>Condition</td>
<td>Determines what conditions are required for menu items to show in the header. For example, the condition <code>gs.hasRole(&quot;sp_admin&quot;)</code></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>restricts access to menu items to users with the sp_admin role. Hide a menu item by setting this value to false. For more information on what conditions to use in the Condition field, see Create a UI Action.</td>
<td></td>
</tr>
</tbody>
</table>

Glyph          Icon that appears beside the menu item

5. Click Submit.

6. After you create a menu and menu items, add the menu to a portal.
   a. Navigate to Service Portal > Portals, then open the portal you want to add a menu to.
   b. From the main menu field, click the reference lookup icon, then select the appropriate menu by name.

   c. Click Save.
What to do next
Associate the menu you created with a portal, then create a header with a theme for your menu.

Service Portal pages
Use pages to organize content, ensure responsive mobile optimization, and design meaningful portal user experiences for your customers. A page houses containers and rows, which then contain widgets. By manipulating the layout of the page, and the widgets within it, you can construct your desired user experience.

- Pages are referenced using the page ID.
- Pages can be referenced in more than one portal.
- Use base system pages as templates.
Containers

Containers are markup artifacts that are put on a page to contain the layouts that house the widgets.

You can view containers and how they make up a page in the Service Portal Designer (Service Portal > Service Portal Configuration > Designer). Open a page in the Service Portal Designer, then click anything on the page. In the top left corner, breadcrumbs appear to show you which element on the page you have selected. Use the breadcrumbs to select a container, then click the edit icon.

You can also edit a container by navigating to the Page Editor and selecting the container node in the tree view. In this view, you can:

• Change the layout of widgets on a page.
• Determine the number of columns on a page.
• Determine whether to scale with changes to the browser window.
• Add a background color to a portion of a page.
• Add an background image to a portion of a page.
• View the current layout of the widgets within the page.

Create and edit a page using the Service Portal Designer

Create or edit a page and use layouts to organize the columns that house the widgets.

About this task

These steps are intended for users with little to no coding experience. The Service Portal Designer includes several layers of customization from simply adding widgets in a particular configuration on a page, to adding CSS classes.
Procedure

1. Navigate to Service Portal > Service Portal Configuration.

2. Click Designer.

3. Switch to the portal you want to design pages for by selecting the portal name in the header.

4. From the Service Portal Designer, select a page to customize or click Add a new page.

5. Under Layouts, select Container and drag it onto the page.

6. Drag one of the other layouts and drop it in the container. This layout defines the structure of your page and the space available to drop widgets. The structure of the layout aligns with the Bootstrap grid template and always adds up to 12.

7. Use the filter to search for a widget, then drag the widget to the layout.


   b. Edit the form.
### Page fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Internal name of the page. Use the title to search for a page in the Service Portal Designer.</td>
</tr>
<tr>
<td>ID</td>
<td>A unique ID for the page. The ID is what you use to assign a page to a portal. It also determines the URL for the page, for example [<a href="https://instance">https://instance</a> name.service-now.com/doc_portal/?id=doc_page](<a href="https://instance">https://instance</a> name.service-now.com/doc_portal/?id=doc_page), where doc_page is the page ID.</td>
</tr>
<tr>
<td>Application</td>
<td>The application scope.</td>
</tr>
<tr>
<td>Public</td>
<td>Enables the page to be accessed without the need for authentication. If <strong>Public</strong> is selected, all users can view the page no matter the roles listed.</td>
</tr>
<tr>
<td>Draft</td>
<td>Mark a page as draft to limit user ability to view the page while you are still creating it. Only users with the admin role can view a page in draft, all other users see a 404 page.</td>
</tr>
<tr>
<td>Roles</td>
<td>Limit user access to a page by role.</td>
</tr>
<tr>
<td>Short description</td>
<td>Describes the portal page. This field is not public facing.</td>
</tr>
<tr>
<td>Page Specific CSS</td>
<td>Unless a page has Page Specific CSS, the page inherits CSS from the Theme and Branding. If you need a page to look different, the Page Specific CSS overrides the inheritance from the Theme and Branding.</td>
</tr>
<tr>
<td>Dynamic page title</td>
<td>Create variables to generate descriptive titles depending on the content loaded into a page.</td>
</tr>
<tr>
<td>Clone Page</td>
<td>Enables you to make a copy of a page that can be modified. If you clone a base system page, a new widget instance is created for each widget on the page.</td>
</tr>
<tr>
<td>Use SEO script</td>
<td><em>(Optional)</em> Option to enable a script include that adds SEO tags for canonical URLs and hreflang tags. For more information, see Enable SEO for localized versions of a portal page.</td>
</tr>
<tr>
<td>SEO script</td>
<td><em>(Optional)</em> Script include to apply to the page. By default, the system uses the SPSEOScriptHeaderTags script.</td>
</tr>
</tbody>
</table>
include, which includes the default implementation for the canonical URL and hreflang tags for Service Portal Analytics pages.


   a. Click within the container you would like to edit, or select Container in the breadcrumbs.

   b. Click the edit icon [ ].
   The container record from the Containers table [sp_container] opens.

   c. Edit the form.

## Container fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Internal name of the container.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the containers appear on a page. To set a container to appear above all other containers, give the container the lowest number in the Order field.</td>
</tr>
<tr>
<td>Page</td>
<td>The page in which the container appears.</td>
</tr>
<tr>
<td>Screen reader title</td>
<td>The title used by a screen reader.</td>
</tr>
<tr>
<td>Application</td>
<td>The application scope.</td>
</tr>
<tr>
<td>Width</td>
<td>Width of the container. Options include:</td>
</tr>
<tr>
<td></td>
<td>• Fixed</td>
</tr>
<tr>
<td></td>
<td>• Fluid</td>
</tr>
<tr>
<td>Parent class</td>
<td>Parent CSS class for the container.</td>
</tr>
<tr>
<td>CSS class</td>
<td>The CSS classes for the container. Overwrites page-specific CSS.</td>
</tr>
<tr>
<td>Background color</td>
<td>The background color of the container.</td>
</tr>
<tr>
<td>Background image</td>
<td>Background image for the container.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Background style      | The display style of a background image. Options include:  
• Default  
• Cover  
• Contain  
• Repeating |
| Bootstrap alternative | Selecting this field removes the standard Bootstrap grid classes and disables the Bootstrap grid system in the container. If selected, the following are not applied:  
• The **Width** field in the container record.  
• Standard Bootstrap class in the row record within the container.  
• The **Size - xs**, **Size - sm**, **Size - md**, and **Size - lg** fields in column records within the container.  
Only select this field if you plan to provide custom CSS classes and CSS for the container, row, and column records. |
| Move to header        | If selected, the container sticks to the header and does not scroll. Use this option to create a subheader.                                |

**10. Optional:** To switch to a different page, click the **Pages** tab in the left pane, then select the next page you want to configure.

**11. Optional:** Use the Preview button in the header to view your page as you design it.
You can also use **Preview** to view your page in mobile or tablet mode through the controls presented in the header.

### Designer tablet view

![Designer tablet view](image)

---

**Add a subheader to a page**

Select a container record to serve as a page subheader. A subheader sticks to the page header and does not scroll.

**Before you begin**

Role required: admin

**Procedure**

1. From the Service Portal configuration page ([Service Portal > Service Portal Configuration](#)) open the Service Portal Designer.
2. Open the page you want to add a subheader to.
3. Click the container that you would like to use as a subheader, or select the container using the breadcrumbs.
4. Click the edit icon ().
5. Select **Move to header**.

**Container record**

<table>
<thead>
<tr>
<th><strong>Name</strong></th>
<th>Service Portal - Container 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Order</strong></td>
<td>1</td>
</tr>
<tr>
<td><strong>Page</strong></td>
<td><strong>index</strong></td>
</tr>
<tr>
<td><strong>Background color</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Background style</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Results**

As a subheader, the container sticks to the header and does not scroll.

**Assign a homepage to a portal**

Edit your portal record to specify any page as your homepage.

**About this task**

When a portal is referenced by the URL suffix, it lands on a home page. This homepage is often labeled **index** in website language. The home page is probably the most important page of your portal as it houses the major information and actions that your users see.
Procedure

1. From any page in the Service Portal Designer, click **Edit Portal Properties**.

2. From the Homepage list, select the page you want for your portal homepage and click **Save**.

**Assign a default error page**

Create a default 404 error page for your portal using a system property.
You can assign an error page to a portal using the portal form. If you do not assign an error page using that form, the system uses the default 404 page containing the breakout game widget. Use the default 404 page property [glide.service_portal.default_404_page] to configure the default error page.

Create a page before adding it as the default error page.

1. Navigate to Service Portal > Properties.
2. In the Default 404 page for Service Portals, type the page ID found in the ID field of the page form.

Add SEO information to Service Portal pages

Improve the searchability of Service Portal pages by adding meta tags and descriptive titles.

You can add SEO information to Service Portal pages by:

- Associating public pages with meta tags to optimize search from external search engines.
- Using record data loaded in a page to dynamically generate descriptive page titles and meta tags.

Dynamic meta tags and titles

Some pages in the Service Portal load record data based on a URL parameter. You can add meta tags and page titles that vary depending on the record loaded in the page.

Using Service Catalog as an example, the following URL includes a sys_id parameter in addition to the page ID. Different content is loaded depending on the value of the sys_id parameter.

https://<yourInstance>.service-now.com/sp?id=sc_cat_item&sys_id=060f3afa3731300054b6a3549de5d3e

If a page loads dynamic content, you can:

- Add meta tags to the page.
- Add meta tags that vary based on content.
- Add variables that generate descriptive page titles based on content.
- Add dynamic content to a page title.
- Create targeted page titles for use with a screen reader.
For example, you can set a Service Catalog page to generate a dynamic title and meta tag based on record data associated with the URL parameter.

Add meta tags to a public page

Improve the searchability of Service Portal pages by adding meta tags. You can add the meta name and description attributes to a page, define the robots attribute, or create dynamic meta tags for pages that load record data based on a URL parameter.

**Before you begin**
Role required: admin or sp_admin

**Procedure**

1. Navigate to **Service Portal > Pages**.
2. Open a page.
3. Check that **Public** is selected.
   * Pages that are not public are not indexed by external search engines.
4. Click the **Meta tags** related list tab.
5. Click **New** to create a new meta tag.
6. Complete the form.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td>Page to apply the meta tag to.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the page. This value is read-only.</td>
</tr>
</tbody>
</table>
| Name       | The HTML meta name attribute.  
To define the meta robots attribute, add **ROBOTS**. |
| Content    | The HTML meta description attribute.  
If **ROBOTS** is defined in the **Name** field, you can add one of the following content values:  
- **INDEX, FOLLOW**: The search engine shows the page in search results and trusts any links in the page. This is the default value.  
- **NOINDEX, FOLLOW**: The search engine does not show the page in search results, but trusts any links in the page.  
- **INDEX, NOFOLLOW**: The search engine shows the page in the search results, but does not trust links in the page.  
- **NOINDEX, NOFOLLOW**: The search engine does not show the page in search results and does not trust links in the page.  
Alternatively, you can pass a variable into this field based on record data. For example, you can define a **%description** variable in this field, and create a content variable to populate the content tag with record data. |

**Example**

![Meta Tag form](image)

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td><code>sc_home</code></td>
</tr>
<tr>
<td>Application</td>
<td><strong>Global</strong></td>
</tr>
<tr>
<td>Name</td>
<td><code>description</code></td>
</tr>
<tr>
<td>Content</td>
<td><code>Order something from the Service Catalog</code></td>
</tr>
</tbody>
</table>

7. Click **Submit**.
The meta information is added to the page header. For example:

```html
<meta name="description" content="Order something from the Service Catalog">
```

8. **Optional:** Create a content variable to populate the content tag with record data.
If the page loads record data based on one or more URL parameters, you can add meta tags generated from the record data.

**a.** Open a meta tag record and check that the **Content** field contains a variable, or add a variable.
Depending on the available URL parameters and the meta tag you would like to define, you can add the following types of values:

<table>
<thead>
<tr>
<th>Value types</th>
<th>Description</th>
<th>Example value</th>
</tr>
</thead>
<tbody>
<tr>
<td>One URL parameter variable</td>
<td>Populates the content tag with the value defined in the associated content variables record.</td>
<td>%description</td>
</tr>
<tr>
<td>More than one URL parameter variable</td>
<td>Populates the content tag with the values defined in the associated content variables records.</td>
<td>%description %price</td>
</tr>
<tr>
<td>Static value and a URL parameter variable</td>
<td>Populates the content tag with a static value and the associated content variables record.</td>
<td>Catalog item: %description</td>
</tr>
</tbody>
</table>

**b.** In the **Content variables** related list, click **New**.
The **Content variables** related list is only available after saving the meta tag record.

**c.** Complete the form.
Associate a field with a URL query parameter. When the value of the query parameter is used to display content, a field from the same record is used to generate the content tag. You can define the field to generate the content tag through the **Table field** field.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>one of the variables defined in the <strong>Content</strong> field in the Meta tag record.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the page. This value is read-only.</td>
</tr>
<tr>
<td>Metatag</td>
<td>The meta tag to apply the dynamic variable to.</td>
</tr>
<tr>
<td>URL query parameter</td>
<td>URL parameter to indicate the record that is being displayed. You can enter any string.</td>
</tr>
<tr>
<td><strong>Tip:</strong> To create a URL parameter that is meaningful and easily identifiable, use a field name from the record. For example, to refer to a knowledge article, you can enter <code>number</code> to reference the article by its number.</td>
<td></td>
</tr>
<tr>
<td>Relevant table column</td>
<td>Table field to match the URL query parameter. For example, if you entered <code>number</code> to reference a knowledge article by its number, select <code>Number</code>. If left blank, the system uses the record <code>sys_id</code>.</td>
</tr>
<tr>
<td>Table</td>
<td>The source table of the URL query parameter record.</td>
</tr>
<tr>
<td>Table field</td>
<td>Select a field from the table defined in the <strong>Table</strong> field. This field is used to generate the value of the content tag.</td>
</tr>
<tr>
<td><strong>Important:</strong> To support SEO, ensure that the referenced table field is public. For more information on granting access to a table field, see Create an ACL rule.</td>
<td></td>
</tr>
</tbody>
</table>

If more than one content variables match a variable defined in the **Content** field of the meta tag record, the record with the earliest Created date is used.
d. Click Submit.

The content tag loads record data. For example:

```html
<meta name="description" content="Apple iPad 3">
```

Add dynamic titles to a page

Create variables to generate descriptive titles depending on the content loaded into a page.

Before you begin
Role required: admin

About this task

Note: The dynamic titles don’t apply to the knowledge article view page in the Knowledge Management Service Portal.

Procedure

1. Navigate to Service Portal > Pages.
2. Open a page.
3. Add one or more variables to the Dynamic page title field.
Depending on the available URL parameters and the dynamic title you would like to define, you can add the following types of values:

<table>
<thead>
<tr>
<th>Value types</th>
<th>Description</th>
<th>Example value</th>
</tr>
</thead>
<tbody>
<tr>
<td>One URL parameter variable</td>
<td>Generates a page title using the associated record of one URL parameter.</td>
<td>%first_name</td>
</tr>
<tr>
<td>More than one URL parameter variable</td>
<td>Generates a page title using the associated records of multiple URL parameters.</td>
<td>%first_name %last_name</td>
</tr>
<tr>
<td>Static value and a URL parameter variable</td>
<td>Generates a page title using a static value and the associated record of a URL parameter.</td>
<td>Employee: %first_name</td>
</tr>
</tbody>
</table>

Enter the variables in the intended syntax of the title. For example, to have an employee’s name and title separated by a hyphen, you would enter `%first_name - %title`.

In the page title, this syntax would render as something like "Beth - System Administrator".
4. Click the **Dynamic page title variables** related list tab.

5. Click **New** to create a new variable.

6. On the form, fill in the fields.

   Associate a field with a URL query parameter. When the value of the query parameter is used to display content, a field from the same record is used to generate the title. You can define the field to generate the title through the **Table field** field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Variable to store the value. Must begin with % and cannot contain spaces. This value must match one of the variables defined in the <strong>Dynamic page title</strong> field.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the page. This value is read-only.</td>
</tr>
<tr>
<td>Page</td>
<td>Page to apply the dynamic variable to.</td>
</tr>
<tr>
<td>URL query parameter</td>
<td>URL parameter to indicate the record that is being displayed. You can enter any string.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> To create a URL parameter that is meaningful and easily identifiable, use a field name from the record. For example, to refer to a knowledge article, you can enter number to reference the article by its number.</td>
</tr>
<tr>
<td>Relevant table column</td>
<td>Table field to match the URL query parameter. For example, if you entered number to reference a knowledge article by its number, select <strong>Number</strong>. If left blank, the system uses the record sys_id.</td>
</tr>
<tr>
<td>Table</td>
<td>The source table of the URL query parameter record.</td>
</tr>
<tr>
<td>Table field</td>
<td>Field from the table defined in the <strong>Table</strong> field. This field is used to generate the dynamic page title.</td>
</tr>
</tbody>
</table>

If more than one dynamic page variables match a variable defined in the **Dynamic page title** field, the record with the latest Updated date is used.

Variables with same name aren’t supported and won’t be created multiple times. Each variable should be unique.
In this example, the value of the Title field in the User [sys_user] table populates the page title. The %title variable must also be defined in the Dynamic page title field in the page record.

7. Click Submit.

Results
When the page loads, the record defined in the URL query parameter displays. The field defined in Table field determines the title of the page.

Enable SEO for localized versions of a portal page
Allow users to discover portal pages in their preferred language by adding hreflang tags.

Before you begin
Role required: sp_admin

Procedure
1. Navigate to Service Portal > Pages and open a page record.
2. On the form, select the Use SEO script check box. Selecting this check box causes the SEO script field to appear. By default, the system uses the SPSEOHeaderTags script include. You can use a different script include by updating this field.
3. Click **Update**.

**Results**
The system adds default `hreflang` tags for each active language in your instance.

**What to do next**
You can override the default `hreflang` tags, add a canonical URL, or add custom header tags by updating the script include that is referenced in the **SEO script** field. This needs to be set by the page or content author.

To specify a canonical URL for the page, update the `generateCanonicalURL` function in the script include.

To specify custom header tags for the page, update the `generateCustomTagsForSEO` function in the script include.

For an example of inserting custom SEO tags into the knowledge article view page, see Configure custom SEO tags for canonical URLs and localized knowledge articles.
Page navigation by URL
You can navigate to a portal or a page using the URL.
A Service Portal URL contains the following elements.
https://<base instance url>/<sp url suffix>?id=<page id>&<page parameters>

Element

Description

Base Instance URL

Unique, secure web address for each instance. The
default format is: https://<instance name>.servicenow.com.

sp url suffix

Suffix established for the Service Portal. For example /sp.

id

The id of the Page to navigate to within the portal
frame. For example, ?id=index.

page parameters

Some pages require additional parameters to look
up a record (table, sys_id). Find the $sp.getParameter
calls in a widget server script to see what parameters
a widget uses. For more detail on this method see
GlideSPScriptable - Scoped

For example, https://<instance name>.service-now.com/sp?id=kb_view2
Note: If you use article versioning with the Knowledge Management
- Service Portal (com.snc.knowledge_serviceportal) plugin enabled,
you must add the article version number to the URL to open a
knowledge article in the base system or knowledge portals. For
example, instead of accessing an article using the URL https://
<instance name>/sp?id=kb_article&sys_id=KB0000005, you must
include the article version number: https://<instance name>/sp?
id=kb_article&sys_id=KB0000005%20V1.0. To learn more, see Article
versioning.

Referencing a page id
Widgets and widget instance options reference Service Portal pages using
the page id. For example, a link to the sc_home page within a widget HTML
template might appear as:
<div><a href="?id=sc_home">${Order something...}</a></div>

6811

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.


Redirect a reference to a page ID

Multiple widgets in the Service Portal may link to a single page using a hard-coded page ID. If you want to replace the page, all widgets that reference the page must be updated with the new page ID. Instead of cloning and updating each widget with the new page ID, you can create a single record that automatically redirects all references to the original page to point to the new page. This way, you can replace a page without locating and replacing all references to the page ID.

Before you begin
Role required: sp_admin

About this task
To redirect all references to a page, create a record in the Page Route Maps table [sp_page_route_map]. This table enables you to redirect a reference to a page without cloning base system widgets.

Creating a record in the Page Route Maps table only redirects references to a page. It does not redirect navigation to a page ID within a URL.

Note: You don’t need to create a page route map to redirect users to a 404 page. To specify the 404 page for your portal, update the 404 page field in the Portal [sp_portal] record.

Procedure
1. Navigate to Service Portal > Page Route Maps.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>Optional short description to describe the redirect.</td>
</tr>
<tr>
<td>Service Portal(s)</td>
<td>Portals that apply the redirect. If you don’t select a portal, the redirect applies to all portals in the instance.</td>
</tr>
<tr>
<td>Route from</td>
<td>Original page you are redirecting from.</td>
</tr>
<tr>
<td>Route to</td>
<td>Page you are redirecting to.</td>
</tr>
<tr>
<td>Active</td>
<td>Whether the Page Route Map record is active. The redirect only applies when the record is active.</td>
</tr>
<tr>
<td>Order</td>
<td>Priority of the Page Route Map record. If more than one active record has the same value in the Route</td>
</tr>
</tbody>
</table>
from field, the record with the lowest order applies. The system evaluates records from lowest to highest. If multiple records have a matching order, the system honors the oldest record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>from</td>
<td>from field, the record with the lowest order applies. The system evaluates</td>
</tr>
<tr>
<td></td>
<td>records from lowest to highest. If multiple records have a matching order,</td>
</tr>
<tr>
<td></td>
<td>the system honors the oldest record.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

**Results**

All references to the page listed in the **Route from** field redirect to the page in the **Route to** field.

**Activate the Knowledge Article View page on upgrade**

If upgrading from a previous release, take advantage of the latest article view features by activating the **Knowledge Article View** page route map. This map routes the **kb_article** page to the **kb_article_view** page, which includes new capabilities such as including links and images in article feedback and article versioning. This map is active by default in new instances and applies to all portals in the system.

**Before you begin**

Role required: admin

**About this task**

By default, users with the public role cannot access the **kb_article_view** page. However, your administrator can modify this behavior. For more information, see **Enable external or public users to view knowledge articles from the Knowledge Management Service Portal**.

After activating the **Knowledge Article View** page route map, you can:

- Comment on a knowledge article
- Create an article version by importing a Word document
- Create a version of a knowledge article from a managed document

**Procedure**

1. Navigate to **Service Portal > Page Route Maps**.
2. Open the **Knowledge Article View** record.
3. Select **Active**.
4. Click **Update**.
Results

Your end users view knowledge articles in the Service Portal using the **kb_article_view** page.

<table>
<thead>
<tr>
<th>Options</th>
<th>How to</th>
</tr>
</thead>
<tbody>
<tr>
<td>To add an electronic business card</td>
<td>Click <strong>Business Card</strong>, and then click a contact in the <strong>Filed As</strong> list. Then click <strong>OK</strong></td>
</tr>
<tr>
<td>To add a hyperlink</td>
<td>Click <strong>Insert Hyperlink</strong>, type in the information or browse to a hyperlink, click to select it, and then click <strong>OK</strong></td>
</tr>
<tr>
<td>To add a picture</td>
<td>Click <strong>Picture</strong>, browse to a picture, click to select it, and then click <strong>OK</strong>. Common image file formats for pictures include .bmp, .gif, .jpg, and .png.</td>
</tr>
</tbody>
</table>

1. To finish creating the signature, click **OK**.

**NOTE:**
The signature that you just created or modified won’t appear in the currently open message; it must be inserted into the message.

**Include font icons on a page**

Include font icons on a page so that all the widgets on the page have access to the font-icon set.

1. In the platform UI, navigate to **Service Portal > Pages** and click the page you want to add font icons to.

2. Attach the font-icon file to the page record.
3. In the Page Specific CSS field for the page, add the CSS for the font-icon definition. Use the sys_id of the attachment as the `src` in the CSS.

```css
/* fallback */
@font-face {
  font-family: 'Material Icons';
  font-style: normal;
  font-weight: 400;
  src: url('/42aead5e64fc32008a959a211310c748.iiix') format('woff2');
}

.material-icn {
  font-family: 'Material Icons';
  font-weight: normal;
  font-style: normal;
  font-size: 24px;
  line-height: 1;
  letter-spacing: normal;
  text-transform: none;
  display: inline-block;
  white-space: nowrap;
  word-wrap: normal;
  direction: ltr;
  -webkit-font-feature-settings: 'liga';
  -webkit-font-smoothing: antialiased;
}
```

**Result**

You can select an icon from the icon set for any widget on this page. For example, in the HTML widget you can use the source code option to use an icon.
Standard ticket page

In Service Portal, you can configure individual request types to display the request-specific information, while still having a consistent layout that is similar to other request types. This configuration ensures a consistent experience when viewing submitted requests.

For new instances, the standard ticket page is available by default. For upgraded instances, you need to activate the Standard Ticket Route page route map. For information about activating this page route map, see Activate the page route map for the standard ticket page.

The information displayed in each section of a standard ticket page depends on the individual request type. If a configurable section has no specified values or if a user does not have access to the information, it is not visible.
Standard ticket page for an incident

**Header section**
By default, this section displays the following information for a submitted request:

- Identification number
- Created and updated dates
- State. Instead of the State field, you can also configure any other field that represents the state of the ticket.

**Info section**
If configured, this section displays the following regions for a submitted request:

- Ticket description region with the short description, and optionally the description
- Fields region where the associated fields are configured. A configured field is not visible when it has no value or when a user does not have access to the field.

**Note:** A field of the Workflow type is not supported for any table. Only for the Requested Item [sc_req_item] table, the Workflow type field is supported, for example, the Stage field. This field is displayed at the last irrespective of the field position in the configuration.

- Actions region
Tabs section
If configured, this section displays the following types of tabs for a submitted request:

- Activity
- Attachments
- Variable editor
- Variable summarizer
- Associated Requests. Displays all associated requests (visible in the My Requests widget in Service Portal) for which the current ticket is the parent. It is applicable in any of the following scenarios:
  - If the current ticket is a universal request, then all requests associated (through the Parent field on the task table) with child tickets of the universal request are displayed.
  - If the current ticket is not a universal request, then all requests associated (through the Parent field on the task table) with the current ticket are displayed.

For information on defining filters for the My Requests widget, see Define filters for My Requests.

- Custom tab

By default, the Activity and Attachments tabs are available.

Configurations for a cross-scope application
For each request type of a cross-scope application, the following configurations are required:

- Restricted caller access privileges for the following standard ticket page widgets so that these widgets can access the application tables. For information about these privileges, see Set application scope, application resource, and event access.

  - Widget: Standard Ticket Header
  - Widget: Standard Ticket Attachments
  - Widget: Standard Ticket Tab

- Restricted caller access privileges for the Description field in the application. This field is displayed on the standard ticket page header.

- Page route map to route all the requests of that application to the standard ticket page
Domain separation for a standard ticket page

Tab configurations are not domain-separated.

Ticket configurations are process domain-separated. For any request type record, when a user opens the standard ticket page, it checks for ticket configurations in the following order irrespective of the user's domain:

1. In the record’s domain
   a. Ticket configurations for the record table
   b. Ticket configurations for the parent table of the record table
2. In the record domain’s parent hierarchy
   a. Ticket configurations for the record table
   b. Ticket configurations for the parent table of the record table

ℹ️ Note: For a table, only one active configuration is allowed per domain.

Related information

Standard ticket page for a requested item

Configure the standard ticket page

Give Service Portal users a consistent way to view their submitted requests. You can configure the standard ticket page for different request types.

Before you begin
Role required: admin or sp_admin

About this task
You can add a standard ticket configuration only for a task-extended table.

Procedure

2. Click New.
3. On the form, fill in the fields.

### Ticket Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Task-extended table for which you want to configure the standard ticket page.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Option to specify if the ticket configuration is active.</td>
</tr>
<tr>
<td>Application</td>
<td>Application associated with the ticket configuration.</td>
</tr>
<tr>
<td>State field</td>
<td>Any field of the task-extended table. By default, this field is mapped to the State field of the task-extended table. You have to configure the form to add this field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot add fields for any of the following information:</td>
</tr>
<tr>
<td></td>
<td>• Number</td>
</tr>
<tr>
<td></td>
<td>• Short description</td>
</tr>
<tr>
<td></td>
<td>• Created date</td>
</tr>
<tr>
<td></td>
<td>• Updated date</td>
</tr>
<tr>
<td></td>
<td>• Watch list</td>
</tr>
<tr>
<td></td>
<td>• Any user input such as comments and work notes</td>
</tr>
</tbody>
</table>

**Info Region**

<table>
<thead>
<tr>
<th>Show 'Description'</th>
<th>Scenario when the request description should be displayed. Possible options are:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• None</td>
</tr>
<tr>
<td></td>
<td>• Always</td>
</tr>
<tr>
<td></td>
<td>• When no variables</td>
</tr>
</tbody>
</table>

**Note:** When displayed, you can expand and collapse the description.

<table>
<thead>
<tr>
<th>Advanced</th>
<th>Option to specify that a widget should be displayed in the info region.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Info widget</td>
<td>Widget that should be displayed in the info region. This field appears only when the Advanced check box is selected.</td>
</tr>
<tr>
<td>Info widget parameters</td>
<td>Name value pair to specify the widget parameters. This field appears only when the Advanced check box is selected.</td>
</tr>
<tr>
<td>Info fields</td>
<td>Fields that should be displayed in the info region. This field disappears when you select the Advanced check box.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Note](#) | **Note:**
| ![•](#) | • You cannot add fields for any of the following information:
| ![◦](#) | ◦ Number
| ![◦](#) | ◦ Short description
| ![◦](#) | ◦ Created date
| ![◦](#) | ◦ Updated date
| ![◦](#) | ◦ Watch list
| ![◦](#) | ◦ State
| ![◦](#) | ◦ Any user input such as comments and work notes
| ![•](#) | • A field of the Workflow type is not supported for any table. Only for the Requested Item [sc_req_item] table, the Workflow type field is supported, for example, the **Stage** field. This field is displayed at the last irrespective of the field position in the configuration.

### Action Region

| Action Widget | Widget to specify the actions available in the Action region.
|---------------|--------------------------------------------------|
| Action Widget Parameters | Name value pair of action widget parameters.

4. Right-click the header menu and click **Save**.

5. From the Tab Configurations related list, click **New**.

![Note](#) **Note:**

• By default, the Activity and Attachments type tab configurations are available for all standard configurations. Other default tab configurations may vary based on the task-extended table. For example, for the sc_req_item configuration, the Variable Editor (Read-Only) type is also available.

• You cannot duplicate any tab type other than Custom.

• You can configure a maximum of six tabs.

• You can add either Variable Editor (Read-Only) or the Variable Summarizer tab type.
6. On the form, fill in the fields.

### Tab Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Tab type based on which a widget is displayed. Possible options are:</td>
</tr>
<tr>
<td></td>
<td>• Activity</td>
</tr>
<tr>
<td></td>
<td>• Associated Requests</td>
</tr>
<tr>
<td></td>
<td>• Attachments</td>
</tr>
<tr>
<td></td>
<td>• Custom</td>
</tr>
<tr>
<td></td>
<td>• Variable Editor (Read-Only)</td>
</tr>
<tr>
<td></td>
<td>• Variable Summarizer</td>
</tr>
<tr>
<td>Tab name</td>
<td>Name of the tab.</td>
</tr>
<tr>
<td>Application</td>
<td>Application associated with the ticket configuration.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the tab should be displayed in the tabs section. The tab with the least order is the tab selected on the page load.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Option to enable adding a script for the tab visibility. By default, this check box is cleared.</td>
</tr>
<tr>
<td>Visible (Script)</td>
<td>Script for the tab visibility.</td>
</tr>
<tr>
<td></td>
<td>• If the script returns true, the tab is visible on the standard ticket page.</td>
</tr>
<tr>
<td></td>
<td>• If the script returns false, the tab is not visible on the standard ticket page.</td>
</tr>
<tr>
<td>Note: This field appears only when the <strong>Advanced</strong> check box is selected.</td>
<td></td>
</tr>
<tr>
<td>Visible</td>
<td>Conditions for the tab visibility. This is not displayed if the <strong>Advanced</strong> check box is selected.</td>
</tr>
<tr>
<td>Widget</td>
<td>Widget that should be displayed in the tabs section. This field appears only when <strong>Custom</strong> is selected from <strong>Type</strong>.</td>
</tr>
<tr>
<td>Widget parameters</td>
<td>Comma-separated list of tab widget parameters. This field appears only when <strong>Custom</strong> is selected from <strong>Type</strong>.</td>
</tr>
</tbody>
</table>
7. Click **Submit**.
8. On the Ticket Configuration form, click **Update**.

**Enable instance options for the Activity tab**

Format the work notes and add @mentions in the Activity tab on a standard ticket page.

**Before you begin**

Role required: sp_admin or admin

You should add the **Activity** tab in the standard ticket configuration of a request type. For information on configuring tabs, see Configure the standard ticket page.

**Procedure**

1. Navigate to the request in Service Portal.
2. Press Control and right-click anywhere in the **Activity** tab.
3. Click **Instance Options**.
4. Configure settings for the **Activity** tab.

**Activity tab instance options**

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Rich Text Editor</td>
<td>Option to enable formatting the work notes.</td>
</tr>
<tr>
<td>Enable @ Mentions (works only when Rich Text Editor is enabled)</td>
<td>Option to enable mentioning the relevant people in work notes.</td>
</tr>
</tbody>
</table>

**Note:** This option is applicable only when the **Enable Rich Text Editor** instance option is selected.

5. Click **Save**.

**Activate the page route map for the standard ticket page**

If you have upgraded your instance, redirect the ticket page to standard_ticket page in Service Portal and view requests on the standard ticket page.

**Before you begin**

Role required: admin or sp_admin
Procedure
1. Navigate to Service Portal > Page Route Maps.
2. Select Standard Ticket Route.
3. Select the Active check box.
4. Click Update.

Related information
- Define filters for My Requests

Service Portal widgets
Widgets are what define the content in your portal. You can use the base system widgets provided with Service Portal, clone and modify widgets, or develop custom widgets to fit your own needs.

Base system widgets are read-only so you can benefit from future updates. To make changes, you can clone base system widgets. However, cloned widgets are considered custom and don't benefit from future updates to the widgets they were cloned from.

Provides an overview of service portal widgets and their components, and the life cycle of a widget.

Related information
- AngularJS
- Bootstrap documentation

Widget library
You can use base system widgets as-is in your Service Portal or clone them to suit your own business needs.

Note: Base system widgets are read-only so you can benefit from future updates. To make changes, you can clone base system widgets. However, cloned widgets are considered custom and don't benefit from future updates to the widgets they were cloned from.

Due to the ever-changing number of widgets that exist at any given time in Service Portal, this widget library is not a definitive list. You can find more widget descriptions as they become available.

Depending on your configuration, widgets that do not contain any information do not appear in your Service Portal page.
To view the instance options for a widget, use the widget context menu.

<table>
<thead>
<tr>
<th>Example widgets</th>
<th>Service Catalog widgets</th>
<th>Knowledge Management widgets</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Announcements widget</td>
<td>• Catalog Content widget</td>
<td>• KB also in Category widget</td>
</tr>
<tr>
<td>• Approvals widget</td>
<td>• Catalog Homepage Search widget</td>
<td>• KB Article Comments widget</td>
</tr>
<tr>
<td>• Approval Info widget</td>
<td>• Request Fields widget</td>
<td>• KB Article Page widget</td>
</tr>
<tr>
<td>• Approval Record widget</td>
<td>• Requested Items widget</td>
<td>• KB Categories widget</td>
</tr>
<tr>
<td>• Breadcrumbs widget</td>
<td>• Requests and Approvals widget</td>
<td>• KB Category Page widget</td>
</tr>
<tr>
<td>• Breakout Game widget</td>
<td>• SC Catalog Item widget</td>
<td>• KB Knowledge Bases widget</td>
</tr>
<tr>
<td>• Calculator widget</td>
<td>• SC Categories widget</td>
<td>• KB Most Viewed widget</td>
</tr>
<tr>
<td>• Carousel widget</td>
<td>• SC Category Page widget</td>
<td>• KB News widget</td>
</tr>
<tr>
<td>• Cool Clock widget</td>
<td>• SC Order Guide widget</td>
<td>• KB Search widget</td>
</tr>
<tr>
<td>• Header menu widget</td>
<td>• SC Popular Items widget</td>
<td>• KB Top Rated widget</td>
</tr>
<tr>
<td>• Hello World widgets</td>
<td>• SC Save Bundles widget</td>
<td>• KB View widget</td>
</tr>
<tr>
<td>• HTML widget</td>
<td>• SC Saved Carts widget</td>
<td>• KB View 2 widget</td>
</tr>
<tr>
<td>• Icon Link widget</td>
<td>• SC Scroll to top widget</td>
<td>• Knowledge Breadcrumbs widget</td>
</tr>
<tr>
<td>• Icon menu list widget</td>
<td>• SC Shopping Cart widget</td>
<td></td>
</tr>
<tr>
<td>• Language Switch widget</td>
<td>• SP Variable Editor widget</td>
<td></td>
</tr>
<tr>
<td>• Link button widget</td>
<td>• SC Wish List Cart widget</td>
<td></td>
</tr>
<tr>
<td>• Login widget</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• My Requests widget</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Organization Chart widget</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Sample Footer widget</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Ticket Attachments widget</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Ticket Conversations widget</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Ticket Fields widget</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Ticket Location widget</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• User Profile widget</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Service Status widgets</th>
<th>Service Portal configuration widgets</th>
<th>List and form widgets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Service Status widget</td>
<td>Service Portal Config Overview widget</td>
<td>Simple List widget</td>
</tr>
<tr>
<td>Current Status widget</td>
<td>Portal config widget</td>
<td>Data table from instance definition widget</td>
</tr>
<tr>
<td>Planned Maintenance widget</td>
<td>SP Page Map widget</td>
<td>Data Table from URL definition widget</td>
</tr>
<tr>
<td>Service History widget</td>
<td>SP Portal Map widget</td>
<td>Form widget</td>
</tr>
<tr>
<td>Service Status widget</td>
<td>Theme Preview widget</td>
<td></td>
</tr>
<tr>
<td>Service Status Legend widget</td>
<td>Widget Edit Panel widget</td>
<td></td>
</tr>
<tr>
<td>Service Status Subscription widget</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Search widgets**

- AI Search Assist widget
- Contextual Search widget
- Faceted Search widget
- Homepage Search widget
- Typeahead Search widget
- Legacy: Search Page widget

**Example widgets**

All widgets in Service Portal can be used as example code for how scripts are used in a widget. However, several base system widgets have been included expressly for this purpose.

Use the example widgets to see how to use HTML, CSS, or client and server scripts in Service Portal. You can also clone and extend each widget to suit your needs.

**Announcements widget**

Users can view all active announcements. You can use this base system widget as-is in your portal or clone it to suit your own business needs.
Announcements widget

<table>
<thead>
<tr>
<th>Announcements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email server down</td>
</tr>
<tr>
<td>RSVP to the company party</td>
</tr>
<tr>
<td>Sales Kickoff this weekend!</td>
</tr>
</tbody>
</table>

Rows 1 - 3 of 4  View all

Instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Type           | Select the type of announcements to display. Announcement types can be selected in the announcement record. Choices include:  
  • Banner  
  • Widget  
  If a type is not defined, the widget instance displays all active announcements. |
<p>| Title          | Widget header title. |
| Glyph          | Glyph displayed to the left of the title. |
| Use Display Style | If selected, each announcement displays according to the style defined in the announcement record. Before selecting this option, consider how the widget will display if multiple announcements in the widget use different styles. |
| Paginate       | Paginates multiple announcements. |
| Max Records    | Number of announcements displayed per page. |
| View All Page  | Click target for View all link. The View all link only displays when: |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• There are more announcements than can be displayed on a single page. The <strong>Max Records</strong> field defines the number of records displayed per page.</td>
<td></td>
</tr>
<tr>
<td>• A view all page is defined.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Who Can View Instances</th>
<th>Who Cannot View Instances</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control who can and cannot view a widget instance with user criteria. Only visible if user criteria for the Service Portal is activated.</td>
<td></td>
</tr>
</tbody>
</table>

**Approvals widget**

Users can approve or reject items directly within Service Portal. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

**Using the widget**

The Approvals widget displays data from the Approvals [sysapproval_approver] table. If the user has been assigned to approve a request, the approval record is displayed in the widget.

![My Approvals](image)

You can enable e-signature for the approvals widget to require re-authentication for your users. For more information on enabling e-signature, see Enable e-signature for Service Portal.

**Instance options**

Use the instance options to change the appearance of the approvals widget.
## Approvals widget instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Glyph</td>
<td>Add an icon to display beside the widget name.</td>
</tr>
<tr>
<td>Buttons stacked side by side</td>
<td>If this check box is selected, the Approve and Reject buttons appear horizontally beside each other. If this check box is cleared, the Approve and Reject buttons appear stacked vertically.</td>
</tr>
<tr>
<td>Max number of elements shown in the list</td>
<td>Limit the number of approvals users see on a page. The default number is 10. Only enter numbers greater than 0.</td>
</tr>
<tr>
<td>Who can view instances/who cannot view instances</td>
<td>Control who can or cannot view a widget instance with user criteria. User criteria must be enabled for this option to appear.</td>
</tr>
</tbody>
</table>

### Approval Info widget

The Approval Info widget works in tandem with the Approval widget to display details about the approval request. You can use this base system widget as-is in your portal or clone it to suit your own business needs.
Approval Info widget

This Change Request requires your approval

State
Requested
Created
3y
Updated
3y

Approve
Reject

Instance options

Approval info widget instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
</tbody>
</table>
Approval Record widget

The Approval Record widget shows the full record for an approval including the activity stream. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Instance options

The approval record widget does not include instance options.

Breadcrumbs widget

The breadcrumbs widget allows users to easily navigate around a portal. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Using the widget

The breadcrumbs widget displays information based on where a page is located in a portal. For example, if you navigate to the Knowledge Base from the home page, then the breadcrumb reads as **Home > Knowledge Base**. Each subsequent page that you open expands the breadcrumb.
Click a page name on the breadcrumbs widget to navigate to that page. For example, to return to the home page, click **Home**.

You can customize this widget to change the breadcrumb path. For more information, see [KB0719179](#).

**Instance options**

The breadcrumbs widget does not have instance options.

**Breakout Game widget**

Add a fun, interactive 404 page to pages that do not exist using the Breakout Game widget. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

![Breakout Game widget](image-url)
Instance options
The Breakout Game does not have instance option. You can use it as an example of how to use the Link Function as part of an Angular Directive.

Calculator widget
The calculator widget does simple calculations. You can use this base system widget as-is in your portal or clone it to suit your own business needs.
Use the calculator widget as an example of how to pass data between the client and server.
Instance options
The calculator widget does not include instance options.

Carousel widget
Showcase specific items in your catalog using a scrolling list of images in the carousel widget. You can use this base system widget as-is in your portal or clone it to suit your own business needs.
Use the carousel widget to showcase items on your portal page. For example, display items available in a service catalog at the top of the service catalog page.

Add slides to the carousel widget

Use the related lists for an instance of the carousel widget to add images for the carousel widget to scroll through.

Before you begin
Role required: Admin or sp_admin

Procedure
1. Navigate to Service Portal > Widgets.
2. Open the Carousel widget record.
3. From the carousel form, on the Instances related list, under instances, open a carousel instance.
4. From the instance of carousel form, click New on the Carousel Slides related list.
5. Complete the form.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the carousel slide. Use the name to differentiate the slide from other slide records.</td>
</tr>
<tr>
<td>Order</td>
<td>Where the slide appears in the list of slides</td>
</tr>
<tr>
<td>HREF/URL</td>
<td>Link to the item in the slide. For example, for a slide with a catalog item, link to page for the catalog item using the HREF ?id=&lt;page name&gt;&amp;sys_id=&lt;sys_id for item&gt;. For more information on linking to a page within a portal, see Page navigation by URL. You can also link to other sites using the URL.</td>
</tr>
<tr>
<td>Background</td>
<td>Upload an image for the slides. Carousel images should be 1022x300 pixels.</td>
</tr>
<tr>
<td>Application</td>
<td>Automatically populated with the name of the application the portal falls under.</td>
</tr>
<tr>
<td>Carousel</td>
<td>Name of the instance of the carousel widget you are adding the slide</td>
</tr>
</tbody>
</table>
Repeat this step for as many slides as you want to appear in the carousel widget.

**Change Password widget**

Users can change their passwords using the Change Password widget.

![Change Password widget](image)

> **Note:** Updated credentials are stored in the User [sys_user] record in the local instance.

**Instance Options**

The Change Password widget does not have instance options.

**Cool Clock widget**

Show different times around the world using the Cool Clock widget. You can use this base system widget as-is in your portal or clone it to suit your own business needs.
Cool clocks demonstrates how to use instance options in a widget. The time zone is loaded using an instance option. If you do not select a time zone, the widget uses a default time zone.

**Cool Clock widget**

![Cool Clock widget](image)

### Instance options

**Cool clock widget instance options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the clock, for example New York, NY. The name appears below the clock so it helps to use a name related to the time zone.</td>
</tr>
<tr>
<td>Timezone</td>
<td>The location from which the time is displayed. Use the local full name, for example, America/New York, instead of the abbreviated time zone. Using the full name allows time zones to stay consistent with daylight savings time. The default value is America/Los Angeles.</td>
</tr>
<tr>
<td>Second hand color</td>
<td>Color of the second hand using the hex code, RGB, or color name. The default value is red.</td>
</tr>
</tbody>
</table>
Data table from instance definition widget

Display a filtered list on your portal using the data table from instance definition widget. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

After you add the data table from instance definition widget to a page, use the instance options to configure the appearance of the table.

Data table from instance definition widget

<table>
<thead>
<tr>
<th>Number</th>
<th>Category</th>
<th>Short description</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC0000001</td>
<td>Network</td>
<td>Can’t read email</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>INC0000004</td>
<td>Inquiry / Help</td>
<td>Forgot email password</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>INC0000005</td>
<td>Hardware</td>
<td>CPU load high for over 10 minutes</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>INC0000006</td>
<td>Software</td>
<td>Hang when trying to print VISIO document</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>INC0000008</td>
<td>Inquiry / Help</td>
<td>Printer in my office is out of toner</td>
<td>1 - Critical</td>
</tr>
</tbody>
</table>

Instance options

Data table instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The title of the widget. If you leave this field empty the name of the table displays as the widget name.</td>
</tr>
<tr>
<td>Table</td>
<td>The table that the widget displays records from.</td>
</tr>
<tr>
<td>Filter</td>
<td>Text field from the condition builder that you can use to limit the items returned in the table. To create a filter, use the context menu to open the widget instance in the platform. Then use the condition builder to create a filter.</td>
</tr>
<tr>
<td>Maximum entries</td>
<td>Limits the number of items displayed in the table. If there are more entries than allowed in the table, users can scroll to the next page.</td>
</tr>
</tbody>
</table>
Data table instance options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Glyph</td>
<td>Icon that displays beside the widget title.</td>
</tr>
<tr>
<td>Fields</td>
<td>Columns to display in the table.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Link to this page</td>
<td>Direct users to a specific page when they click a record. By default, clicking an entry in the table opens that entry in a form.</td>
</tr>
</tbody>
</table>

Data Table from URL definition widget

The Data Table from URL definition widget displays the table you select from the list. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Instance options

Complete the instance options to define the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The title of the widget. Select the <strong>Use Instance Title</strong> check box to use this title instead of the name of the table.</td>
</tr>
<tr>
<td>Glyph</td>
<td>Icon that displays beside the widget title.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Link to this page</td>
<td>Direct users to a specific page when the click a record. By default, clicking an entry in the table opens that entry in a form.</td>
</tr>
<tr>
<td>Fields</td>
<td>Columns to display in the table. For example, short description or priority.</td>
</tr>
<tr>
<td>Use Instance Title</td>
<td>Select to use the title in the Title field instead of the table title</td>
</tr>
<tr>
<td>Enable Filter</td>
<td>Select this check box to allow users to create their own filter for the table</td>
</tr>
</tbody>
</table>

If **Enable filter** is enabled in the instance options, users can add custom conditions to filter the results.

![Data Table URL with condition builder](image)

For more information on using the condition builder, see .

ℹ️ **Note:** The condition builder is only available in the desktop view.
Form widget
The form widget is a platform form within the Service Portal UI with a few differences. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Form widget

URL Parameters
The form widget accepts the following parameters within the URL.

Form widget URL parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_id or sl_sys_id</td>
<td>Sys_id for the record to be displayed</td>
</tr>
<tr>
<td>table, sl_table, or t</td>
<td>Table for the record to be displayed</td>
</tr>
<tr>
<td>view or v</td>
<td>View used to display the record</td>
</tr>
</tbody>
</table>

In the following example, the URL would display an incident with a sys_id of 1c741bd70b2322007518478d83673af3 in the portal view.

https://example.service-now.com/sp?id=form&table=incident&sys_id=1c741bd70b2322007518478d83673af3&view=portal

Scripting
Not all client scripts are supported in the Service Portal. To understand how client scripts interact with forms in the Service Portal, see Service Portal and client scripts and Supported client script types and APIs.
Header menu widget

The Header Menu widget controls which options appear in the page header. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Unlike other widgets in Service Portal, the header menu widget is not something you drag onto a page. Instead you configure the header menu by associating the header menu with a portal. For more information on configuring a header menu, see Configure a portal header menu.

Instance options

The header menu widget does not include instance options.

Hello World widgets

The Hello World widgets are included with Service Portal as examples of how to use and create widgets. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

All three Hello World widgets display the same way. The real difference between them is in their underlying code base. Each version of the widget uses a different method of using the server and client script.

To view the Hello World widgets, navigate to Service Portal > Service Portal Configuration then click Widget Editor. In the Widget Editor, click Check out the Hello World Example.
Hello World 1

Hello world 1 displays how the HTML template and the client script communicate. For more information on using the client script in Service Portal, see Widget developer guide.

Use the widget list to switch to Hello World 2 or 3.

Hello World 2

Hello World 2 includes an example of how the server script can be used as well.
For more information on Service Portal APIs, see the GlideSPSriptable API.

**HTML widget**

Use the HTML widget to directly inject HTML, text, lists, or content in general into a page. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Because the HTML widget can contain content of any kind, any example may just appear as regular text. For example, the HTML widget appears as a box of text on the 404 page.

**Instance options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name for the HTML text. Users do not see this information.</td>
</tr>
</tbody>
</table>
HTML widget instance options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML</td>
<td>Text box for the HTML. Use the toolbar like most word processing tool bars.</td>
</tr>
<tr>
<td></td>
<td>For more information on using the toolbar, see Formatting icons for the</td>
</tr>
<tr>
<td></td>
<td>HTML field editors.</td>
</tr>
</tbody>
</table>

Icon Link widget

Link to any other item. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Configure Icon Link widgets to link to a specific URL, page within the portal, or a specific category in the knowledge base or the service catalog.

Order Something

Browse the catalog for services and items you need

Instance options

Instance options fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the icon link. Choose something that defines what the widget is linking to.</td>
</tr>
<tr>
<td>Glyph</td>
<td>Icon for the widget.</td>
</tr>
<tr>
<td>Bootstrap class name</td>
<td>Use concurrently with page or theme level CSS.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Defines what the widget links to. The fields that appear on the form vary depending on which option you select. Choose from:</td>
</tr>
<tr>
<td></td>
<td>• Page: Another page in the Service Portal</td>
</tr>
<tr>
<td></td>
<td>• URL: Link to an external website.</td>
</tr>
<tr>
<td></td>
<td>• Catalog category: Link to a specific catalog category within the service catalog.</td>
</tr>
<tr>
<td></td>
<td>• Catalog item: Link to a specific catalog item.</td>
</tr>
<tr>
<td></td>
<td>• KB topic: Link to a KB topic page.</td>
</tr>
<tr>
<td></td>
<td>• KB article: Link to a KB article by number.</td>
</tr>
<tr>
<td></td>
<td>• KB category: Link to a specific KB category within the knowledge base.</td>
</tr>
<tr>
<td><strong>Page</strong></td>
<td>Page within the portal that you want to link to. This field varies depending on the <strong>Type</strong> you choose.</td>
</tr>
<tr>
<td><strong>Bootstrap color</strong></td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td><strong>Template</strong></td>
<td>The appearance of the link icon widget. Choose from:</td>
</tr>
<tr>
<td></td>
<td>• Top icon</td>
</tr>
<tr>
<td></td>
<td>• Circle icon</td>
</tr>
<tr>
<td></td>
<td>• Color box</td>
</tr>
</tbody>
</table>
**Icon menu list widget**

A simple list with a glyph icon next to each link. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Configure the icon information using the Menu Items related list.

1. From the instance options for the icon menu list widget, under Related Lists, click **Menu Items**.
2. Click **New**.
3. Use the fields on the New Menu Items form to configure the icons for the icon menu list widget.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Name or description of the icon</td>
</tr>
<tr>
<td>Parent Menu</td>
<td>The name of the menu that the icon appears in. This automatically populates with the name of the icon menu list widget that you created but you have the option to switch it to another menu.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the icons appear in the icon menu list widget.</td>
</tr>
<tr>
<td>Parent menu Item</td>
<td>Nest menu items within a parent menu.</td>
</tr>
<tr>
<td>Page</td>
<td>The page within Service Portal that the icon links to. Select <strong>Page</strong> from the Type list to enable this option.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of link you want the icon to have. You can link to pages within Service Portal, external URLs, KB articles, Service Catalog, or lists. Different fields will appear on the form depending on the option you select from the list.</td>
</tr>
</tbody>
</table>
## Icon menu list widget instance options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Determines what conditions are required for menu items to show in the header. For more information on what conditions to use in the <strong>Condition</strong> field, see <a href="#">Create a UI Action</a>.</td>
</tr>
<tr>
<td>Glyph</td>
<td>Icon that you want to display in the icon menu list widget.</td>
</tr>
</tbody>
</table>

### Language Switch widget

Add the Language Switch widget to a landing or homepage to allow your users to change the language of the page. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

#### Language Switch widget

![Language Switch widget](image)

**Current Language:** en

[Apply]

### Instance options

The Language Switch widget does not include any instance options.

### Link button widget

The Link Button widget is a button you can nest in any other widget that links to another destination. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

#### Link Button widget

![Link Button widget](image)
Instance options

Instance option fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Link for button</td>
<td>Page that the button links to. Use <code>?id=&lt;page_name&gt;</code> to link to another page in the portal.</td>
</tr>
<tr>
<td>Contents of button</td>
<td>The button text.</td>
</tr>
</tbody>
</table>

Login widget

The login widget controls user access to your site. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Using the widget

Users log in to a portal by entering their credentials in the login widget.

The widget uses credentials from the User [sys_user] record. In the User name field, the user enters the User ID from their user record. In the Password field, the user enters the password from their user record.
The login widget by default includes a **Forgot Password?** link that enables users to reset their password using the Password Reset application. For more information about Password Reset configuration, see [Password Reset](#).

**Note:** When the user selects **Forgot Password?**, the system redirects the user to the page value specified in the `glide.security.password_reset.uri` system property.

If you don’t want to include the **Forgot Password?** link, set the `glide.security.forgot_password.display.link` system property to false.

**External user self-registration**

External user self-registration enables a large group of users to register to a ServiceNow app without the help of an administrator. Users register to the app via a link on the login widget.
For more information on external user self-registration, see Enable external users to self-register to your ServiceNow instance.

**PIV/CAC authentication**

With certificate-based authentication activated in your instance, users can register their Personal Identity Verification (PIV) or Common Access Card (CAC) card for Service Portal login.

After self-registering their PIV/CAC card, a user can log in by inserting their card into a card reader and then selecting **Login with PIV/CAC card** on the login widget.

Before a user can register their PIV/CAC card, an administrator must activate certificate-based authentication and then set up PIV/CAC authentication. For
more information on this setup process, see Personal Identity Verification (PIV) card or Common Access Card (CAC) based authentication. For more information on how a user self-registers their PIV/CAC card, see Register your PIV/CAC card for Service Portal login.

**Instance options**

Use the instance options to configure the login widget for a portal page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show panel</td>
<td>Show or hide the panel that appears behind the login widget. The panel helps the widget stand out from the page background rather than blending in.</td>
</tr>
<tr>
<td>Use Advanced View</td>
<td>Changes the widget layout. Adds the <strong>Forgot Password?</strong> link to the left of the <strong>Login</strong> button and adds field names for <strong>User name</strong> and <strong>Password</strong> instead of hint text.</td>
</tr>
</tbody>
</table>

**My Requests widget**

The My Requests widget stores all of your open requests in one place. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

The list is updated in real time so you can see your requests getting processed. The widget pulls open request information from the sc_request table.

**My Requests widget**

<table>
<thead>
<tr>
<th>My Requests</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sales Laptop</strong></td>
</tr>
<tr>
<td>REQ00100002 • about an hour</td>
</tr>
<tr>
<td><strong>Apple iPad 3</strong></td>
</tr>
<tr>
<td>REQ00100001 • about an hour</td>
</tr>
<tr>
<td><strong>Apple iPad 3</strong></td>
</tr>
<tr>
<td>REQ00100001 • 6d</td>
</tr>
</tbody>
</table>
Instance options

My Requests widget instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the widget. The name you enter here appears in the header for the widget.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Maximum entries</td>
<td>The maximum number of entries allowed to appear in the widget.</td>
</tr>
</tbody>
</table>

My Requests widget

Use the My Requests widget (my-requests-v2) to enable requesters to view open or closed requests in Service Portal. Requests, incidents, and tasks are displayed in a single view that is based on the filter conditions and display settings in the My Request Filter module. For information on defining filters for this module, refer to the Related information section.
**Instance options**

Use the widget instance options to customize the settings for the My Requests widget. To customize the settings for this widget, press the Ctrl key, click on the widget, and select **Instance Options**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Title of the widget.</td>
</tr>
<tr>
<td>Behavior</td>
<td></td>
</tr>
<tr>
<td>Show View</td>
<td>If selected, displays the <strong>View</strong> list. Using this list you can filter for closed or open requests. If deselected, only open requests are displayed.</td>
</tr>
<tr>
<td>Items per page</td>
<td>Number of records displayed per page.</td>
</tr>
</tbody>
</table>

**Related information**

Define filters for My Requests

**Enable the My Requests menu for an upgrade scenario**

Enable the My Requests menu that uses the My Requests (my-requests-v2) widget for an upgrade scenario.

**Before you begin**

Role required: admin

**About this task**

The My Requests menu that is based on the My Requests (my-requests-v2) widget is available by default for zBoot users. For more information about this widget, refer to My Requests widget.

**Procedure**

1. Navigate to **Service Portal > Portals**.
2. Select a portal.
3. Next to the **Main menu** field, click **Preview this record** and open the record.
4. In the Menu items related list, perform the following steps.
a. For the Requests menu item of the Page type, set Active as true.

b. For the Requests menu item of the Scripted List type, set Active as false.

5. Navigate to Service Portal > Page Route Maps.
6. For the My Request page route map, set Active as true.
7. Click Update.

Organization Chart widget

The Organization Chart widget shows employees in a tree structure relative to their manager. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Using the widget

In the text input field, enter or select a user to see their manager and subordinates. The widget uses information from the User [sys_user] record to display the organization hierarchy relative to the selected user.
Click a card to open the profile page for that user. To reconfigure the card link, change the **URL** or **Page** in the widget instance options.

You can drag individual cards to rearrange the chart.

You can zoom in or out of the chart view by clicking the magnifying glass icons or by scrolling.
Instance options
Use the instance options to configure the Organization Chart widget for a portal page.

ℹ️ **Note:** There are no valid values for several instance options. By default, you can set only the following instance options:

- User Background Color
- Node Background Color
- URL
- Page

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>Fields from the user record that appear on each card. By default, each card displays the name, title, department, email, phone, and location of each user.</td>
</tr>
<tr>
<td>Card Fields</td>
<td>Fields from the user record that appear on each card. By default, each card displays the name, title, department, email, phone, and location of each user. There are no valid values that you can enter in this field.</td>
</tr>
<tr>
<td>Presentation</td>
<td></td>
</tr>
<tr>
<td>User Background Color</td>
<td>Color of the user card. Use color names or Hex codes. For example, you can enter red or #ff0000.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td></td>
<td>David Loo</td>
</tr>
<tr>
<td></td>
<td>Bud Richman</td>
</tr>
<tr>
<td><strong>Node Background Color</strong></td>
<td>Color of cards that extend from the user card. Use color names or Hex codes. For example, you can enter yellow or #ffffff.</td>
</tr>
<tr>
<td></td>
<td>David Loo</td>
</tr>
<tr>
<td></td>
<td>Alissa Mountjoy</td>
</tr>
</tbody>
</table>

The user background color is **lightblue** by default.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td></td>
<td>The node background color is <strong>azure</strong> by default.</td>
</tr>
<tr>
<td>Table Layout</td>
<td>Size and margin of the content in each card.</td>
</tr>
<tr>
<td></td>
<td><strong>There are no valid values that you can enter in this field.</strong></td>
</tr>
<tr>
<td>Row Layout</td>
<td>Alignment of the text in the card. The text is left-aligned by default.</td>
</tr>
<tr>
<td></td>
<td><strong>There are no valid values that you can enter in this field.</strong></td>
</tr>
<tr>
<td>Line</td>
<td>Color of the lines that connect cards. The lines are black by default.</td>
</tr>
<tr>
<td></td>
<td><strong>There are no valid values that you can enter in this field.</strong></td>
</tr>
<tr>
<td>Tree Layout</td>
<td>Size, spacing, and alignment of the chart.</td>
</tr>
<tr>
<td></td>
<td><strong>There are no valid values that you can enter in this field.</strong></td>
</tr>
<tr>
<td>Picture Layout</td>
<td>Size of image space in each card. By default, the image space is 55x65 pixels. The user image is shrunk or stretched to fit the space.</td>
</tr>
<tr>
<td></td>
<td><strong>There are no valid values that you can enter in this field.</strong></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>Web address of the page that opens when you click a card. Use the part of the portal URL that references the page ID. For example, to navigate to the Service Catalog, enter ?id=sc_category. If left blank, clicking the card opens the page that is specified in the Page field. If the Page field is also blank, clicking the card opens the user profile page by default.</td>
</tr>
<tr>
<td>Page</td>
<td>Portal page that opens when you click a card. Use the page ID. If left blank, clicking the card opens the web address in the URL field. If the URL field is also blank, clicking the card opens the user profile page by default.</td>
</tr>
</tbody>
</table>

**Note:** The URL field overwrites the Page field. To specify a page rather than a URL, leave the URL field blank.

**Simple List widget**

The Simple List widget can be used to display any list in the system within Service Portal. You can use this base system widget as-is in your portal or clone it to suit your own business needs.
<table>
<thead>
<tr>
<th>My Open Incidents</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>InsideSales NeuralView Instance relocation from US datacenter to Hongkong dat...</strong></td>
</tr>
<tr>
<td>INC0006789 • a day</td>
</tr>
<tr>
<td><strong>Results not as per expectation after performing the documented steps in Oracl...</strong></td>
</tr>
<tr>
<td>INC0006911 • a day</td>
</tr>
<tr>
<td><strong>Performance degrade observed in Oracle Planning and Budgeting</strong></td>
</tr>
<tr>
<td>INC0006890 • a day</td>
</tr>
<tr>
<td><strong>Network response time is poor</strong></td>
</tr>
<tr>
<td>INC0006800 • a day</td>
</tr>
<tr>
<td><strong>Performance degrade observed in Eloqua Marketing Measurement</strong></td>
</tr>
<tr>
<td>INC0006790 • a day</td>
</tr>
<tr>
<td><strong>Fidelity Stock Plan Services upgrade to the latest version</strong></td>
</tr>
<tr>
<td>INC0006797 • a day</td>
</tr>
</tbody>
</table>
## Instance options

### Instance options fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The platform table that the simple list is formed from.</td>
</tr>
<tr>
<td>Display field</td>
<td>Main field that displays as the “title” of the list item.</td>
</tr>
<tr>
<td>Glyph</td>
<td>Icon that displays next to the widget name in the header</td>
</tr>
<tr>
<td>Filter</td>
<td>Conditions that are applied to the list. To edit the filter, in the widget instance options context menu, select <strong>Open in platform</strong>. Use the Table &amp; Filter tab to apply conditions to the simple list. For more information, see .</td>
</tr>
<tr>
<td>Link to this page</td>
<td>Portal page to link to from a list item.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Bootstrap size</td>
<td>Size of the widget</td>
</tr>
<tr>
<td>Maximum entries</td>
<td>Maximum allowed number of entries that appear in the list at one time.</td>
</tr>
<tr>
<td>Show even when empty</td>
<td>Widgets are designed to hide on a page when no results meet the criteria. Select this option to make the simple list widget display on a page even when empty.</td>
</tr>
<tr>
<td>List body height</td>
<td>Actual length of the widget in pixels or EMs. A long list with a small body height includes a scroll bar option.</td>
</tr>
<tr>
<td>Image field</td>
<td>Displays an image in the list. Select a field type that includes an image. For example, Photo.</td>
</tr>
</tbody>
</table>
Instance options fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary fields</td>
<td>Fields from the list item that display in addition to the main display field.</td>
</tr>
<tr>
<td>Rounded images</td>
<td>Makes any images selected in the Image field round in the list.</td>
</tr>
<tr>
<td>List page</td>
<td>The page that opens when a user selects View all in the widget footer. Select a page that correlates with the items that display in the list.</td>
</tr>
<tr>
<td>Hide footer</td>
<td>Show or hide the widget footer</td>
</tr>
<tr>
<td>View</td>
<td>The view option for when a list item links to a form. The Link to this page field must be set to a form page for this option to work.</td>
</tr>
</tbody>
</table>

Sample Footer widget

The Sample Footer widget is an example of a footer you can use in your portal. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Unlike other widgets in Service Portal, you add a footer to your portal by configuring it in the Theme form. For more information on adding a footer to a portal, see Add a header or footer to a portal.

Instance options

The Sample footer widget does not include instance options.

Ticket Attachments widget

Use the attachment widget to attach items to tickets. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Attachments should be less than 24MB. You can drag files into the Attachments widget to add them to a record.
Ticket Attachments widget

Instance options

Ticket attachments widget instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record ID</td>
<td>The ID number of the record for the attachment.</td>
</tr>
<tr>
<td>Record table</td>
<td>Limit the records users can add an attachment to by adding a table to the attachment widget. Users can then only add attachments if they are in a record for that table.</td>
</tr>
</tbody>
</table>

Ticket Conversations widget

Record of ticket items. Users can use this widget to communicate back and forth with the fulfiller and the receiver. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

The Ticket Conversations widget displays journal entries from the activity formatter of the target record. Journal entries are presented in chronological order, with the oldest entries appearing at the bottom of the widget. Entries made by the user that created the record appear on the right side of the center divider. Entries made by other users appear to the left.

The Ticket Conversations widget is intended only for tables that extend task.

Limit the number of journal entries that appears in the ticket conversation widget using the glide.service_portal.stream_entry_limit system property. The default number is 100. Change the number by navigating to Service Portal > Properties, and enter the new number in the Maximum number of stream entries displayed in Service Portal field.
Ticket Conversations widget

Instance options

Instance options fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use dynamic placeholder</td>
<td>Use a placeholder for journal fields. The default value is false.</td>
</tr>
<tr>
<td>No readable journal field message</td>
<td>The message that displays when there are no readable journal fields. Forms that have added journal fields may not display in the Ticket Conversation widget.</td>
</tr>
</tbody>
</table>

Ticket Fields widget

The Ticket Fields widget displays information about a request that a user has made. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Using the widget

After a user submits a request, they can track their request on a ticket page in Service Portal. The user can consult the Ticket Fields widget to review the details of their request and check its resolution status.
Fields for the Ticket Fields widget are defined by the HTML template and the server.

If a user entered variables when submitting the request, they can view those variables in the Options section.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>RITM0010001</td>
</tr>
<tr>
<td>State</td>
<td>Open</td>
</tr>
<tr>
<td>Priority</td>
<td>4 - Low</td>
</tr>
<tr>
<td>Created</td>
<td>about an hour ago</td>
</tr>
<tr>
<td>Updated</td>
<td>about an hour ago</td>
</tr>
<tr>
<td>Price</td>
<td>$600.00</td>
</tr>
<tr>
<td>Quantity</td>
<td>1</td>
</tr>
</tbody>
</table>

*Tickets are picked up within 4 hours (M-F 9-5)*

- I agree to the term: false
- desktop: false
- explorers: false
Note: The values that appear in the Options section are not field values from the ticket. They are Service Catalog variables that are associated with the ticket. For more information, see Service catalog variables.

Instance options
Use the instance options to configure the Ticket Fields widget for a portal page.

### Field Options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pickup message</td>
<td>Text to communicate the expected resolution time of the ticket. This text is displayed below the ticket fields. The default is <code>${Tickets are picked up within &lt;br/&gt; 4 hours (M-F 9-5)}</code>. Ensure that any changes you make are within the curly braces.</td>
</tr>
</tbody>
</table>

**Ticket Location widget**
Share your location in a ticket. You can use this base system widget as-is in your portal or clone it to suit your own business needs.
Location Shared

San Diego Fwy, Del Mar, CA 92014, USA
Instance options
The Ticket Location widget does not include any instance options.

User Profile widget
Display user profile information. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Users can use the User Preferences section to enable accessibility in a portal.

Search widgets
Several search widgets are provided with Service Portal. You can configure search in Service Portal using any of the search widgets.

AI Search Assist widget
Improve incident deflection for Service Portal users by displaying the most relevant search results within a record producer.
Using the widget

The widget is included in the **Create Incident** record producer form to display items based on keywords entered in the description. These items can be knowledge articles or Service Catalog items. These search results appear as the user types the information.

**AI Search Assist widget**

* Please describe your issue below

email

---

**Instance options**

The AI Search Assist widget doesn’t include instance options.

**Contextual Search widget**

Contextual Search is an embedded widget that can be added to a record producer. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

By default, the widget is included in the **Create Incident** record producer form to display items based on keywords entered in the description. These items can be knowledge articles or Service Catalog items. These search results appear as the user types the information.
The Faceted Search widget displays search results and search facets defined for a search source. The Faceted Search widget enables end users to filter search results for a more meaningful result set.

Using the widget
You can use facets, tabs, and breadcrumbs to refine your search in Service Portal. For example, you can filter search results to only knowledge articles by selecting the Knowledge tab. Or, to filter search results by certain knowledge categories, you can select one or more facets.
Faceted Search widget

The available facets are dynamic and based on the search. As you select facets, the search narrows and the number of available facets decreases. You can see which facets you've selected by viewing the pills in the facets panel. If you select a different tab, the selected facets are carried over and applied to the search criteria.

You can broaden your search by clearing an individual facet selection or selecting the All tab. To clear all facet selections, select Clear all.

You can initiate a new search by entering a new search term in the typeahead search box. After you enter the new search term, the system clears the facet and tab selections from the previous search. You can refine your new search by selecting new facets or tabs.

For more information on configuring the available facets, see Create a facet in an AI Search application configuration.

Instance options
Use the instance options to configure the Faceted Search widget for a portal page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Facet List Title</td>
<td>Display title for the facet component.</td>
</tr>
<tr>
<td>Typeahead Search - Title</td>
<td>Default text in the typeahead search component.</td>
</tr>
<tr>
<td>Typeahead Search - Color</td>
<td>Whether the glyph in the typeahead component is filled in.</td>
</tr>
<tr>
<td>Typeahead Search - Glyph</td>
<td>Icon that appears in the search field beside the widget. The search icon is the default. To use a different icon, type the name of the icon in the field, for example search-plus. For a list of icons to choose from, open the instance options for the Icon Link widget.</td>
</tr>
<tr>
<td>Typeahead Search - Size</td>
<td>Determines the font size and height of the widget. Choose from xs, sm, md, and lg.</td>
</tr>
<tr>
<td>Show Typeahead Search Box</td>
<td>Option to show or hide the search box on the portal page.</td>
</tr>
<tr>
<td>Behavior</td>
<td>Max results for All search</td>
</tr>
<tr>
<td>Max results for single search source</td>
<td>Maximum number of results that display for a single search source.</td>
</tr>
<tr>
<td>Show Did You Mean</td>
<td>Displays suggestions when a search produces no results.</td>
</tr>
<tr>
<td>Typeahead Search - Limit</td>
<td>Number of typeahead search results displayed. The default is 15.</td>
</tr>
<tr>
<td>AI Search</td>
<td>Text that appears in the search box before the user enters anything. By default, the placeholder text is Search.</td>
</tr>
</tbody>
</table>

**Note:** This instance option applies only if AI Search is enabled in your portal. For more information on enabling AI Search for Service Portal, see Enable and configure AI Search in Service Portal.
Homepage Search widget

Add a search bar to your home page. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Instance options

Use the instance options to configure the Homepage Search widget for a portal page.

Note: The AI Search instance options apply only if AI Search is enabled in your portal. For more information on enabling AI Search for Service Portal, see Enable and configure AI Search in Service Portal.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Name that appears above the search bar. For example &quot;How can we help?&quot;</td>
</tr>
<tr>
<td>Short description</td>
<td>A subtitle that appears below the title.</td>
</tr>
<tr>
<td>Typeahead search</td>
<td>Controls the appearance of the search bar. Use a comma separated list inside curly braces to add style details to the search bar, for example {title: 'Search', color: 'blue', size: 'lg'}. For more information on which style options you can add, see the instance options for the Typeahead Search widget.</td>
</tr>
<tr>
<td>AI Search</td>
<td></td>
</tr>
<tr>
<td>Search Application</td>
<td>Defines search experience settings for the widget, such as the search engine, search results limit, and suggestions limit. By default, the widget uses the same search application configuration as the portal, but you can override this configuration at the widget level.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>For more information on defining a search application configuration, see <a href="#">Defining search application configurations</a>.</td>
</tr>
<tr>
<td>Search Results</td>
<td>Defines how search results are displayed after using the widget. By default, the widget uses the same search results configuration as the portal, but you can override this configuration at the widget level. For more information on defining a search results configuration, see <a href="#">Define a composite dataset</a>.</td>
</tr>
<tr>
<td>Configuration</td>
<td></td>
</tr>
<tr>
<td>Disable All</td>
<td>Option to disable search suggestions.</td>
</tr>
<tr>
<td>Suggestions</td>
<td></td>
</tr>
<tr>
<td>Placeholder</td>
<td>Text that appears in the search box before the user enters anything. By default, the placeholder text is <em>How can we help?</em>.</td>
</tr>
<tr>
<td>AI Search Source</td>
<td>Content that portal users can search on, including tables in your instance or external data sources. For more information, see <a href="#">Defining search sources</a>.</td>
</tr>
<tr>
<td>Filter</td>
<td></td>
</tr>
</tbody>
</table>

**Legacy: Search Page widget**

The Search Page widget displays search results. The Faceted Search widget replaces the Search Page widget. You can use this base system widget as-is in your portal or clone it to suit your own business needs.
Search Page widget

Search results for 'email'

Deleted Email Recovery
Deleted Email Recovery By default, every email deleted from your OWA mailbox goes through the following process: The email is moved to your Deleted Items folder. If you purge or remove items from your
Article: KB0000030 · Published: 3y ago

What is Spam?
What is Spam? Spam has increasingly become a problem on the Internet. While every Internet user receives some spam, email addresses posted to web sites or in newsgroups and chat rooms attract the most.
Article: KB0000029 · Published: 3y ago

How to Deal with Spam
How to Deal with Spam Spam has increasingly become a problem on the Internet. While every Internet user receives some spam, email addresses posted to web sites or in newsgroups and chat rooms attract
Article: KB0000011 · Published: 3y ago

What are phishing scams and how can I avoid them?
Phishing explained: Phishing explained Phishing scams are typically fraudulent email messages appearing to come from legitimate enterprises (e.g., your company, your Internet service provider, your bank
Article: KB0000028 · Published: 3y ago

Search Page instance options

Search

Other Options

Show score

Max results for All search

Max results for single search group

Show Did You Mean

Search page instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show score</td>
<td>When selected, shows search results relative to ranking.</td>
</tr>
</tbody>
</table>
Search page instance options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max results for All search</td>
<td>The maximum number of results that show for all search groups when viewed together.</td>
</tr>
<tr>
<td>Max results for single search group</td>
<td>The maximum number of results that show for a single search group when you view that specific search group.</td>
</tr>
<tr>
<td>Show Did You Mean</td>
<td>Displays suggestions when a search produces no results.</td>
</tr>
</tbody>
</table>

For more information on configuring search, see Service Portal search.

**Typeahead Search widget**

Predictive search feature that shows words as users type. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

**Instance options**

Use the instance options to configure the Typeahead Search widget for a portal page.

⚠️ **Note:** The AI Search instance options apply only if AI Search is enabled in your portal. For more information on enabling AI Search for Service Portal, see Enable and configure AI Search in Service Portal.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>The name or words that appear in the search field before a user starts typing. For example, search or what are you looking for</td>
</tr>
<tr>
<td>Color</td>
<td>Whether the search button beside the search field is filled in or not</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glyph</td>
<td>The icon that appears in the search field beside the widget. The search icon is the default. To use a different icon, type the name of the icon in the field, for example <code>search-plus</code>. For a list of icons to choose from, open the instance options for the Icon Link widget.</td>
</tr>
<tr>
<td>Size</td>
<td>Determines the font size and height of the widget. Choose from xs, sm, md, and lg.</td>
</tr>
<tr>
<td>Behavior</td>
<td></td>
</tr>
<tr>
<td>Limit</td>
<td>If search suggestions is enabled, enter the number of suggestion entries you want to display. If search suggestions is disabled, enter the number of typeahead entries you want to display. The default is 15. See Enable and disable search suggestions.</td>
</tr>
<tr>
<td>Contextual Search</td>
<td>Limit the results available in the typeahead search by only configuring specific search sources. For example, users searching in the Service Catalog only see results for the Service Catalog when that search sources is configure. For more information on contextual search, see Configure Search Sources available on a page</td>
</tr>
<tr>
<td>AI Search</td>
<td></td>
</tr>
<tr>
<td>Search Application</td>
<td>Defines search experience settings for the widget, such as the search engine, search results limit, and suggestions limit. By default, the widget uses the same search application configuration as the portal, but you can override this configuration at the widget level. For more information on defining a search application configuration, see Defining search application configurations.</td>
</tr>
<tr>
<td>Search Results</td>
<td>Defines how search results are displayed after using the widget. By default, the widget uses the same search results configuration as the portal, but you can override this configuration at the widget level. For more information on defining a search results configuration, see Define a composite dataset.</td>
</tr>
<tr>
<td>Disable All Suggestions</td>
<td>Option to disable search suggestions.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Placeholder</td>
<td>Text that appears in the search box before the user enters anything. By default, the placeholder text is <em>Search</em>.</td>
</tr>
<tr>
<td>AI Search Source Filter</td>
<td>Content that portal users can search on, including tables in your instance or external data sources. For more information, see <a href="#">Defining search sources</a>.</td>
</tr>
</tbody>
</table>

### Knowledge Management widgets

Use Knowledge Management widgets to build a knowledge base for your portal.

Knowledge Management widgets are included as part of the Service Portal - knowledge base plugin [com.glide.service-portal.knowledge-base], which is activated automatically with the Service Portal for Enterprise Service Management [com.glide.service-portal.esm] plugin.

For more information on knowledge management, see [Knowledge Management](#).

### KB also in Category widget

List of articles also included within a particular category. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

The information that appears in the KB also in Category widget is determined by the knowledge article child categories. For more information, see [Define a knowledge article category](#).
Also in Windows

What is the Windows key?

How to set or change your default web browser

How can I restore my computer to a previous configuration?

Instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the</td>
</tr>
</tbody>
</table>
Instance Options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>instance to have a specific color, select the option from the list.</td>
</tr>
</tbody>
</table>

KB Article Comments widget

Rating and comment option for knowledge base articles. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Ratings on articles in the KB Article Comments widget determine the article popularity in the KB top rated widget.

Instance Options

KB comments widget instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show star rating</td>
<td>Yes</td>
</tr>
<tr>
<td>Show user comments</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Instance options fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show star rating</td>
<td>Select the option to show a star rating on the KB article comments widget. Selecting the <strong>Use system properties</strong> option shows the</td>
</tr>
</tbody>
</table>
Instance options fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>star rating option</td>
<td>star rating option based on the glide.knowman.show_star_rating system property.</td>
</tr>
<tr>
<td>Show user comments</td>
<td>Select the option to show the comment box on the KB article comments widget. Selecting the Use system properties option shows the comment box based on the glide.knowman.show_user_feedback system property.</td>
</tr>
</tbody>
</table>

KB Article Page widget

Use the Article page widget to view Knowledge Base articles within Service Portal. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Any specialized font or formatting added in the text field for the knowledge article within the platform, appears the same way in the portal.

Getting Around in Windows

Windows 8.x

Windows 8.x is designed for using touch, mouse, and keyboard together, on hardware ranging from touch-enabled tablets and laptops to PCs and all-in-one computers, including those without touch capability.

Start screen and Desktop

1. Microsoft updated the Windows 8.1 interface by returning the Start button, providing its ease of access along with the option of the Metro interface. The intent is to provide a seamless experience on desktops, laptops, tablets, and phone devices.

   By default, the Start screen is displayed. Move your mouse pointer to the bottom left corner of the screen to make the Start button appear. Click it to display the desktop; click it again to display the Start screen.

2. The Start screen has a default application display you can customize:

   1. Right-click any app and the Application bar will appear at the bottom, with options for the application you have selected.
   2. To add an app to the Start screen, click Pin to Start.

   If an application is already on the Start screen, you’ll see Unpin from Start instead.

Power User menu

The Power User menu displays the most commonly used applications from the Control Panel, File Explorer, and Task Manager, as well as Restart, Run, Search, and Shutdown/Update. Access it in one of the following ways:

- Press Win + X
Instance Options

KB article page widget instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Show star rating</td>
<td>Displays the star rating on the article page widget. If you select <strong>Use system properties</strong>, the appearance of the star rating is defined by the <strong>glide.knowman.show_star_rating</strong> system property.</td>
</tr>
</tbody>
</table>

KB Categories widget

Lists the categories for your Knowledge Base. You can use this base system widget as-is in your portal or clone it to suit your own business needs.
### KB Categories widget

<table>
<thead>
<tr>
<th>Categories</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Applications</td>
<td>3</td>
</tr>
<tr>
<td>Devices</td>
<td>1</td>
</tr>
<tr>
<td>Email</td>
<td>8</td>
</tr>
<tr>
<td>IT</td>
<td>7</td>
</tr>
<tr>
<td>Operating Systems</td>
<td>12</td>
</tr>
<tr>
<td>Suppliers</td>
<td>1</td>
</tr>
</tbody>
</table>

Categories are determined by the list of Knowledge Categories provided for the Knowledge Base. To view a list of categories for a knowledge base, in the platform navigate to **Knowledge > Administration > Knowledge bases** then select the name of the knowledge base, for example IT. Categories for the knowledge base appear in the related lists. If a category does not have any associated articles, it does not appear in the portal. For more information on defining categories for a knowledge base, see [Define a knowledge article category](#).

The knowledge base that a portal uses is determined in the portal form. If your portal uses multiple knowledge bases, you can use the **KB Knowledge Bases widget** to filter the content of the KB Categories widget.

For more information on associating your portal with a knowledge base, see [Associate a portal with a knowledge base](#).

**Instance options**
The KB categories widget does not include instance options.
KB Category Page widget

Articles and article preview within a particular category. Categories are specified within the Knowledge Base module. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

The KB Category Page widget works together with the KB Categories widget. When you select a category in the KB Categories widget, the KB Category page widget lists articles within that category.

To have the KB Categories and KB Category Page widgets work in tandem, add the two widgets to the same page.

If you add the KB Category Page widget to a page without adding the KB Categories widget, the KB Category Page widget displays an uncategorized list of all articles within the knowledge base.

Categories are determined by the list of Knowledge Categories provided for the Knowledge Base. To view a list of categories for a knowledge base, in the platform navigate to Knowledge > Administration > Knowledge bases, then select the name of the knowledge base, for example IT. Categories for the knowledge base appear in the related lists. If a category does not have any associated articles, it does not appear in the portal. For more information on defining categories for a knowledge base, see Define a knowledge article category.
The knowledge base that a portal uses is determined in the portal form. For more information on associating your portal with a knowledge base, see Associate a portal with a knowledge base.

**Instance options**

### KB category widget instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Show star rating</td>
<td>Displays the star rating on the category page. If you select <strong>Use system properties</strong>, the appearance of the star rating is defined by the glide.knowman.show_star_rating system property.</td>
</tr>
</tbody>
</table>

**Instance options fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Show star rating</td>
<td>Displays the star rating on the category page. If you select <strong>Use system properties</strong>, the appearance of the star rating is defined by the glide.knowman.show_star_rating system property.</td>
</tr>
</tbody>
</table>

**KB Knowledge Bases widget**

Give users the option to select which knowledge base to browse on your portal. You can use this base system widget as-is in your portal or clone it to suit your own business needs.
**Using the widget**

If you associate your portal with multiple knowledge bases, the KB Knowledge Bases widget provides users with a menu to select a knowledge base. After a user selects a knowledge base, other KB widgets on the page filter their content accordingly.

For example, if a user selects to browse only the IT knowledge base, then the KB Categories widget shows only the categories within the IT knowledge base.

If you associate your portal with only one knowledge base, then the KB Knowledge Bases widget remains hidden on the page.

For more information on associating your portal with knowledge bases, see [Associate a portal with a knowledge base](#).

**Instance options**

The KB Knowledge Bases widget doesn't include instance options.

**KB Most Viewed widget**

List of most viewed knowledge base articles, based on user feedback. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

**KB Most Viewed widget**

<table>
<thead>
<tr>
<th>Most Viewed Articles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting Around in Windows</td>
</tr>
<tr>
<td>4 Views</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Instance options

KB most viewed widget instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The name that appears in the widget header</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Max number</td>
<td>The maximum number of most viewed articles listed</td>
</tr>
<tr>
<td>KB category</td>
<td>KB category for the most viewed articles. The list is generated by the kb_category table.</td>
</tr>
</tbody>
</table>
**KB News widget**

The KB News widget displays information from the Knowledge Base. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

You can configure the KB News widget to display specific information by selecting a category from the KB category list.

**Instance options**

**KB news widget instance options**

- **Title**
  - News

- **Bootstrap color**
  - Default

- **Max number**
  - 

- **KB category**
  - 

**Save (3£ + s)**
## Instance option fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the widget that appears in the widget header</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Max number</td>
<td>The maximum number of news articles appearing in the widget. The default number is 5.</td>
</tr>
<tr>
<td>KB category</td>
<td>The knowledge base category determined by the kb_category table. Only published articles display. For a news widget, select something like <strong>Announcements</strong> to show upcoming events.</td>
</tr>
</tbody>
</table>

## KB Search widget

The KB Search widget is a search widget that is specifically confined to the knowledge base. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

The **typeahead search widget** is embedded in the KB search widget.
KB Search widget

Instance options

KB search widget instance options

Title
Search

Instance option fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the widget. This field is non-public facing.</td>
</tr>
</tbody>
</table>

KB Top Rated widget

Lists Knowledge Base articles with the highest rating. Ratings are determined by user feedback. You can use this base system widget as-is in your portal or clone it to suit your own business needs.
KB Top Rated widget

Top Rated Articles

Eclipse configuration for Java development ★★★★★

Instance options

KB top rated widget instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The name that appears in the widget header</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the</td>
</tr>
<tr>
<td>Max number</td>
<td></td>
</tr>
<tr>
<td>KB category</td>
<td></td>
</tr>
</tbody>
</table>

Instance options fields
### Instance options fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
<td></td>
</tr>
<tr>
<td>Max number</td>
<td>The maximum number of most viewed articles listed</td>
</tr>
<tr>
<td>KB category</td>
<td>KB category for the top rated articles. The list is generated by the kb_category table.</td>
</tr>
</tbody>
</table>

### KB View widget

The KB View widget is an example of how to structure a knowledge base page. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Use the search filter to find a specific topic or article.
### KB View widget

<table>
<thead>
<tr>
<th>Category</th>
<th>Articles</th>
</tr>
</thead>
<tbody>
<tr>
<td>IT</td>
<td></td>
</tr>
<tr>
<td>Excel</td>
<td></td>
</tr>
<tr>
<td>Excel Functionality</td>
<td></td>
</tr>
<tr>
<td>IE</td>
<td></td>
</tr>
<tr>
<td>Managing Settings in Internet Explorer 10 for Windows 8</td>
<td></td>
</tr>
<tr>
<td>Apple</td>
<td></td>
</tr>
<tr>
<td>How to configure VPN for Apple Devices</td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td></td>
</tr>
<tr>
<td>How to Deal with Spam</td>
<td></td>
</tr>
<tr>
<td>What are phishing scams and how can I avoid them?</td>
<td></td>
</tr>
<tr>
<td>What is Spam?</td>
<td></td>
</tr>
<tr>
<td>Outlook 2010</td>
<td></td>
</tr>
<tr>
<td>Automatic Replies (Out Of Office)</td>
<td></td>
</tr>
<tr>
<td>Create An Email Signature</td>
<td></td>
</tr>
<tr>
<td>Create And Edit A Contact Group</td>
<td></td>
</tr>
<tr>
<td>Deleted Email Recovery</td>
<td></td>
</tr>
<tr>
<td>Importing Address Book From CSV File</td>
<td></td>
</tr>
<tr>
<td>Android</td>
<td></td>
</tr>
</tbody>
</table>

### Instance options

The KB view widget does not have any included instance options.

### KB View 2 widget

The KB View 2 provides an alternative structure to the KB View widget to show a different example of how to display knowledge articles. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

The KB View 2 widget displays each knowledge category as a card. Click a card to access the articles within that category.
Categories are determined by the list of Knowledge Categories provided for the Knowledge Base. To view a list of categories for a knowledge base, in the platform navigate to **Knowledge > Administration > Knowledge bases**, then select the name of the knowledge base, for example IT. Categories for the knowledge base appear in the related lists. If a category does not have any associated articles, it does not appear in the portal. For more information on defining categories for a knowledge base, see [Define a knowledge article category](#).

The knowledge base that a portal uses is determined in the portal form. For more information on associating your portal with a knowledge base, see [Associate a portal with a knowledge base](#).

**Instance options**

The KB View 2 widget does not have any included instance options.

**Knowledge Breadcrumbs widget**

Help users navigate a knowledge base by adding the Knowledge Breadcrumbs widget. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

**Using the widget**

The knowledge breadcrumbs widget displays information based on where an article is located in a knowledge base. For example, if you open an article on "How to Deal with Spam," the breadcrumbs show that the article is located in the Email category of the IT knowledge base.
You can broaden your search of the knowledge case by selecting the titles in the breadcrumbs. For example, to see all articles in the Email category, you would select Email. To see all articles in the knowledge base, you would select IT (Knowledge Base).

The widget also includes a search box so that you can search for an article by name.

**Instance options**

Use the instance options to configure the Knowledge Breadcrumbs widget for a portal page.

ℹ️ **Note:** The AI Search instance options apply only if AI Search is enabled in your portal. For more information on enabling AI Search for Service Portal, see [Enable and configure AI Search in Service Portal](#).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Behavior</strong></td>
<td></td>
</tr>
<tr>
<td>Show Search Box</td>
<td>Option to include a search box for users to search the knowledge base.</td>
</tr>
<tr>
<td><strong>AI Search</strong></td>
<td></td>
</tr>
<tr>
<td>Search Application</td>
<td>Defines search experience settings for the widget, such as the search engine, search results limit, and suggestions limit. By default, the widget uses the same search application configuration as the portal, but you can override this configuration at the widget level. For more information on defining a search application configuration, see <a href="#">Defining search application configurations</a>.</td>
</tr>
<tr>
<td>Search Results</td>
<td>Defines how search results are displayed after using the widget. By default, the widget uses the same search results configuration as the portal, but you can override this configuration at the widget level. For more information on defining a search results configuration, see <a href="#">Define a composite dataset</a>.</td>
</tr>
<tr>
<td>Disable All Suggestions</td>
<td>Option to disable search suggestions.</td>
</tr>
<tr>
<td>Placeholder</td>
<td>Text that appears in the search box before the user enters anything.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AI Search Source</td>
<td>Content that portal users can search on, including tables in your instance or external data sources. For more information, see Defining search sources.</td>
</tr>
</tbody>
</table>

**Service Catalog widgets**

Use the Service Catalog widgets to build a catalog for your portal.

Most service catalog widgets are part of the Service Portal Service Catalog [com.glide.service-portal.service-catalog] plugin that is activated automatically with the Service Portal for Enterprise Service Management (com.glide.service-portal.esm) plugin.

The Service Portal - Service Catalog v2 plugin (com.glideapp.servicecatalog.portal) provides an enhanced Service Catalog experience. This plugin is active by default and enables the following widgets:

- Catalog Homepage Search (ID: cat-homepage-search)
- SC Scroll to top (ID: sc-scroll-to-top)
- Requests and Approvals (ID: sc_request_and_approvals)
- Recent & Popular Items (ID: sc-recent-popular)

Most of the configuration for the Service Catalog widgets takes place in the Service Catalog application of the platform. For more information on Service Catalog, see Service Catalog.

**Related information**

Service Catalog in Service Portal

**Catalog Content widget**

The Catalog Content widget is part of the Service Catalog and includes a tiled list of all the content items available in the catalog. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

The items that appear on the page are grouped by category alphabetically. Catalog items and categories are defined in the Service Catalog application in the platform. For more information on creating catalog items to appear in the catalog, see Create a catalog item.
Catalog Content widget

Can We Help You?

- Ask a Question
  Get an answer
- Change Password
- Create Incident
  Create an Incident record to report and request assistance with an issue you are having
- Emergency Change
  Open an Emergency Change
- International Plan Request
  International Plan Request
- New Hire
  New Hire Order Guide
- Password Reset
  Request a reset of a password for a service or an application
- Password Reset Enrollment
- Report an Issue
  Simple form with Subject and Description
- Report Outage
  Report an outage of a service or an environment
- Report Performance Problem
  Request assistance with a performance issue you are having with a particular service
- Request Knowledge Base
  Request for a Knowledge Base

Instance Options

The Catalog Content widget does not include instance options.

Catalog Homepage Search widget

Give your users the option to search the Service Catalog as soon as they log in. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Using the widget

Add the Catalog Homepage Search widget on your Service Catalog landing page. When users navigate to the Service Catalog, they can use the Catalog Homepage Search widget to find what they are looking for.
Users can enter a keyword in the search bar. The Catalog Homepage Search widget uses a predictive search feature that shows words as users type.

Alternatively, to navigate to a list of Service Catalog categories, users can select **Browse by Categories**.

**Instance options**
Use the instance options to configure the Catalog Homepage Search widget for a portal page.

⚠️ **Note:** The AI Search instance options apply only if AI Search is enabled in your portal. For more information on enabling AI Search for Service Portal, see [Enable and configure AI Search in Service Portal](#).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Title to appear above the search bar.</td>
</tr>
<tr>
<td>Short description</td>
<td>Text to appear under the title.</td>
</tr>
<tr>
<td>AI Search</td>
<td></td>
</tr>
<tr>
<td>Search Application</td>
<td>Defines search experience settings for the widget, such as the search engine, search results limit, and suggestions limit. By default, the widget uses the same search application configuration as the portal, but you can override this configuration at the widget level. For more information on defining a search application configuration, see <a href="#">Defining search application configurations</a>.</td>
</tr>
<tr>
<td>Search Results Configuration</td>
<td>Defines how search results are displayed after using the widget. By default, the widget uses the same search results configuration as the portal, but you can override this configuration at the widget level. For more information on defining a search results configuration, see <a href="#">Define a composite dataset</a>.</td>
</tr>
<tr>
<td>Disable All Suggestions</td>
<td>Option to disable search suggestions.</td>
</tr>
<tr>
<td>Placeholder</td>
<td>Text that appears in the search box before the user enters anything. By default, the placeholder text is <strong>How can we help?</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>AI Search Source Filter</strong></td>
<td>Content that portal users can search on, including tables in your instance or external data sources. For more information, see <a href="#">Defining search sources</a>.</td>
</tr>
</tbody>
</table>

### Other Options

| Typeahead Search       | Configuration of the search bar. You configure the search bar by using the instance options for the Typeahead Search widget. Use the syntax `{field1: 'value1', field2: 'value2'}`). For example, to configure the title, color, and size of the search bar, enter the following: `{title: 'Search...', color: 'default', size: 'lg'}). |

### Recent & Popular Items widget

Allow a user to browse recent and popular catalog items. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

#### Using the widget

The Recent & Popular Items widget includes two tabs: **My Recent Items** and **Popular Items**.

A user opens the My Recent Items tab to see catalog items that they recently viewed or requested.

![Recent & Popular Items widget](image)

A user opens the Popular Items tab to see catalog items that have been widely requested by other users.
Each item card displays basic information about the catalog item, such as the item name, image, and price.

To navigate to the item listing, the user selects View Details.

**Instance options**

Use the instance options to configure the Recent & Popular Items widget for a portal page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>Time span over which users have requested the popular items. You select one of the following options:</td>
</tr>
<tr>
<td>Poplar Items used in</td>
<td>- <strong>None</strong>--: Display popular catalog items with no time span specified. This is the default option.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Last 3 Months</strong>: Display the most requested catalog items in the past three months.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Last 6 Months</strong>: Display the most requested catalog items in the past six months.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Last 12 Months</strong>: Display the most requested catalog items in the past year.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Life time (Has performance implications)</strong>: Display the most requested catalog items of all time. Selecting this option may decrease system performance.</td>
</tr>
</tbody>
</table>

Presentation
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Items</td>
<td>Maximum number of catalog items to display in each tab. The value is 8 by default.</td>
</tr>
</tbody>
</table>
| Behavior            | My Recent Items By Criteria to qualify which catalog items are displayed in the My Recent Items tab. You can select one of the following options:  
  • **None**: Display recent items with no criteria specified. This is the default option.  
  • **View**: Display the catalog items that the user viewed most recently.  
  • **Request**: Display the catalog items that the user requested most recently. |

**Request Fields widget**

The Request Fields widget displays information about any request a user has made. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Fields for the Request Fields widget are defined by the HTML template and the server.

- **Estimated completion 2016-06-18**
  - Number: REQ0010001
  - State: Open
  - Priority: Created 4h ago
  - Price: $799.99

  Requests are picked up within 4 hours (M-F 9-5)
Instance options

Request fields widget instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pickup message</td>
<td>Information that appears at the bottom of the widget. Make sure any changes you make are within the curly braces. The default is ${Requests are picked up within &lt;br/&gt; 4 hours (M-F 9-5)}</td>
</tr>
</tbody>
</table>

Requested Items widget

Describes at what stage of the order a requested item is. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

You can define different workflows for items directly within the Service Catalog module. For more information on Service Catalog workflows, see Service Catalog request fulfillment.
# Instance options

## Requested Items widget instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the widget. The title appears in the header of the widget.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Display field</td>
<td>Determine what information displays as the title for each requested item. Short description is the default.</td>
</tr>
<tr>
<td>Filter</td>
<td>Limit what appears in the list using a filter. You can add a filter by opening the Requested Items record in the platform (From the context menu,</td>
</tr>
</tbody>
</table>
Requested Items instance options fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>click</td>
<td>Open in platform and using the condition builder.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that displays the item when the user clicks an entry</td>
</tr>
<tr>
<td>Link to this page</td>
<td>Page that opens when the user clicks an item</td>
</tr>
<tr>
<td>Maximum entries</td>
<td>Max number of entries that appear in the list of requested items</td>
</tr>
</tbody>
</table>

Requests and Approvals widget

Allow a user to refer to their open requests and approvals in the Service Catalog. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Using the widget

The Requests and Approvals widgets includes two tabs: My Requests and My Approvals.

A user opens the My Requests tab to see data from the Task [task] table. If the user has opened any task record, such as an incident or a change request, the record is displayed in the widget.
A user opens the My Approvals tab to see data from the Approvals [sysapproval_approver] table. If the user has been assigned to approve a request, the approval record is displayed in the widget.

If the user doesn't have any open requests or approvals, the widget remains hidden on the page.
**Instance options**

The Requests and Approvals widget doesn't include instance options.

**SC Catalog Item widget**

Use this widget (widget-sc-cat-item-v2) to view the information about a catalog item and order the item. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Configure catalog items using the Service Catalog in the platform UI by navigating to *Service Catalog > Catalog Definitions > Maintain Items*.

Catalog variables determine what information your users are allowed to select from, for example, color, size, or price. For more information on defining the variables for a catalog item, see *Create a service catalog variable*.

**Instance options**

Use the widget instance options to customize the settings for the SC Catalog Item widget. To customize the settings for this widget, press the Ctrl key, click on the widget, and select **Instance Options**.

**Instance options for the SC Catalog Item widget**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation</td>
<td></td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color of the widget based on the selections made in the Branding Editor.</td>
</tr>
<tr>
<td>Other Options</td>
<td></td>
</tr>
<tr>
<td>Show Add Cart Button</td>
<td>Displays the <strong>Add to Cart</strong> button in the Order Item widget.</td>
</tr>
<tr>
<td>Show field validation messages</td>
<td>Displays the <strong>Required information</strong> section with mandatory fields whose values are not specified.</td>
</tr>
<tr>
<td>Show Add/Update Wish List buttons</td>
<td>Displays the <strong>Add to Wish List</strong> or the <strong>Update Wish List</strong> buttons in the Order Item widget.</td>
</tr>
<tr>
<td>Order Item Section on Top</td>
<td>Displays the Order Item widget to the right of the catalog item form. Else, the Order Item widget is displayed below the catalog item form.</td>
</tr>
<tr>
<td>Enable Show More/Less for Item</td>
<td>Enables the Show more or Show less options for the catalog item description in the mobile view. By default, the Show more option is available.</td>
</tr>
</tbody>
</table>
Instance options for the SC Catalog Item widget (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>description on Mobile</td>
<td>• Click <strong>Show more</strong> to display the entire description.</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Show less</strong> to display only 150 characters of the description.</td>
</tr>
</tbody>
</table>

ℹ️ **Note:** For a record producer, you can edit the label of the **Submit** button by using the widget instance options. For example, if you want to change the label to **Request**, press Ctrl+click on the catalog item widget, select **Instance in Page Editor**, and specify the following parameters in the **Additional options, JSON format** field.

```
"record_producer_label": {
  "value": "Request"
}
```

### Related information

**Request a catalog item from Service Portal**

**SC Categories widget**

The SC Categories widget displays Service Catalog categories. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

The system renders the categories available in this widget from the Categories table in Service Catalog [sc_category].
If you associate your portal with multiple catalogs, then the SC Categories widget also includes a menu to select which catalog to browse.
For more information on associating your portal with catalogs, see Configure a catalog in Service Portal.

**Instance options**

<p>| Categories widget instance options fields |  |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td></td>
</tr>
<tr>
<td>Page</td>
<td>Defines what page opens when a user clicks a category. By default, this option redirects to the page for the selected category.</td>
</tr>
<tr>
<td>Number of categories to load</td>
<td>Specifies the number of categories displayed in the Categories pane. By default, ten categories are displayed. If there are additional categories, the Show All option is available.</td>
</tr>
<tr>
<td>Presentation</td>
<td></td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Category Layout</td>
<td>Select a flat or nested layout. A flat layout shows all of the available categories. A nested layout shows only the parent categories. Use a nested layout if you have a large number of categories to prevent an unnecessarily long list. Click that appears next to a category with nested topics to expand the sub-categories.</td>
</tr>
</tbody>
</table>
Categories widget instance options fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The widget only supports three levels of nesting. After level four, categories appear in the flat view.</td>
</tr>
</tbody>
</table>

**Behavior**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide at XS</td>
<td>Hides the categories option on small screens, for example, on smart phones. The default is set to false.</td>
</tr>
<tr>
<td>Omit badges</td>
<td>Show or hide the number of items included in each category.</td>
</tr>
<tr>
<td>Check canView per item</td>
<td>Verifies with each item that the user has the right roles to view the catalog item.</td>
</tr>
</tbody>
</table>

⚠️ **Note:** If a category contains more than 200 items, update the following instance options on this widget for better performance:

- Category Layout: Flat
- Omit badges: True
- Check canView per item: False

**Related information**

Access Service Catalog categories in Service Portal

**SC Category Page widget**

Lists the catalog items available within a certain category. Categories are determined within the Service Catalog module. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

⚠️ **Note:** Catalog items are sorted in ascending order by their Order value. If catalog items have the same order, they are sorted by the Name field.
### Instance options

#### Category page widget instance options fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click event name</td>
<td>The name of the event that is emitted when a user clicks a catalog item. You can override the default behavior when clicking on a catalog item by providing a different event name. This would be in a situation where you embedded the category page in another widget. The default value is $sp.cat_item_list.click.</td>
</tr>
<tr>
<td>Number of items to display per page</td>
<td>Number of items to display in the category page. <strong>Note:</strong> When defining the number of items to be displayed, consider the item data such as images and long descriptions. A large number may slow down the page performance.</td>
</tr>
</tbody>
</table>
### Category page widget instance options fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show items from Child Categories</td>
<td>Displays items in the child categories along with those in the parent category.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the Category Layout instance options is set to Flat in the SC Categories widget, then set this instance option to False.</td>
</tr>
</tbody>
</table>

### SC Order Guide widget

Use this widget (widget-sc-order-guide-v2) to request an order guide, that is, a single service catalog request for several catalog items with a specific purpose. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Configure order guides using the Service Catalog in the platform UI by navigating to Service Catalog > Catalog Definitions > Order Guides.

The order guide form comprises the following sections:

#### Describe Needs

This section displays the following that are associated with the order guide:

- Image
- Description
- Variables

#### Choose Options

This section displays a list of catalog items included in the order guide based on the information provided in the Describe Needs section and the rule base configured for the order guide. Each catalog item is displayed with its name and description on an accordion.

Each accordion displays:

- **Options**, if a catalog item has fields that need user inputs.

  **Note:** If the fields are mandatory, a red asterisk is displayed beside Options.
• A toggle to include the catalog item in the order guide request. You can make it mandatory to include all items in the order guide request by not displaying the toggle. You can make it optional to include items in the order guide request by displaying the toggle. To display the toggle for each catalog item of the order guide, select the **Show Include Toggle (Service Portal)** check box while configuring the order guide. For more information, see Create an order guide.

**Note:** When an item is excluded from the order guide request, the item is not editable and the corresponding mandatory field restrictions are ignored.

**Summary**
This section provides a summary of the order guide that you can review before requesting the order guide.

**Instance options**
Use the widget instance options to customize the settings for the SC Order Guide widget. To customize the settings for this widget, press the Ctrl key, click on the widget, and select **Instance Options**.

**Instance options for the SC Order Guide widget**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Name of the order guide.</td>
</tr>
<tr>
<td>Bootstrap Color</td>
<td>Color of the widget based on the selections made in the Branding Editor.</td>
</tr>
<tr>
<td>Enable Show More/Less for Item description on Mobile</td>
<td>Enables the <strong>Show more</strong> or <strong>Show less</strong> options for the description of the order guide or the associated catalog items in the mobile view. By default, the <strong>Show more</strong> option is available.</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Show more</strong> to display the entire description.</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Show less</strong> to display only 150 characters of the description.</td>
</tr>
</tbody>
</table>
Instance options for the SC Order Guide widget (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note: This instance option is applicable for the description of the order guide in the Describe Needs section, and the description of the associated catalog items in the Choose Options section.</td>
<td></td>
</tr>
<tr>
<td>Compact Mode</td>
<td>Displays the widget in the compact mode when configured for smaller real estates (less than 6*6).</td>
</tr>
<tr>
<td>Hide Delivery Time</td>
<td>Hides the delivery time for each catalog item in the accordion. It is not applicable for the order guide summary page and the delivery time is never displayed on the summary page.</td>
</tr>
<tr>
<td>Behavior</td>
<td>Option to display the Add to Cart button on the order guide summary page.</td>
</tr>
</tbody>
</table>

Related information

- Request an order guide from Service Portal
- Configure order guide widgets

SC Popular Items widget

List of Service Catalog items that users purchase often. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

SC Popular Items widget

<table>
<thead>
<tr>
<th>Popular Items</th>
<th>Apple iPad 3</th>
<th>Executive Desktop</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Apple iPad 3</td>
<td>Dell Precision 690</td>
</tr>
<tr>
<td>View Details</td>
<td>View Details</td>
<td>View Details</td>
</tr>
<tr>
<td>$600.00</td>
<td>$1,875.00</td>
<td></td>
</tr>
</tbody>
</table>
Instance Options

Popular Items widget instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit</td>
<td>Maximum number of popular items shown. The default number is 9.</td>
</tr>
<tr>
<td>Include Record Producers</td>
<td>Includes requests made through record producers.</td>
</tr>
</tbody>
</table>

SC Save Bundles widget

The Save Bundles widget allows you to save specific catalog items together for reuse. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

The Save Bundles widget is embedded within the SC Shopping Cart widget.
SC Save Bundles widget

Create New Bundle

Here, you can save the current contents of your cart as a bundle, which can be restored at any time.
To create a new bundle, provide a name for your bundle, select the items you would like to include in the bundle, and press save.

Bundle Name

<table>
<thead>
<tr>
<th>Item</th>
<th>Price</th>
<th>Quantity</th>
<th>Total Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple iPhone 5</td>
<td>$999.99</td>
<td>1</td>
<td>$999.99</td>
</tr>
<tr>
<td>+ $31.00 Monthly</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Logitech USB Headset for PC &amp; Mac</td>
<td>$29.99</td>
<td>1</td>
<td>$29.99</td>
</tr>
<tr>
<td>PC/Mac Compatible Headset</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sales Laptop</td>
<td>$1,100.00</td>
<td>1</td>
<td>$1,100.00</td>
</tr>
<tr>
<td>Acer Aspire NX</td>
<td>+ $100.00 Annually</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Save

Instance Options

The Save Bundles widget does not have any included instance options.

SC Saved Carts widget

The Saved Carts widget shows previously created and saved bundles from the Service Catalog. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

SC Saved Cart widget

When you add an existing cart bundle to a shopping cart, you have two options. You can:

- Replace the items in the shopping cart with the items in the bundle.
- Add the bundle in addition to the rest of the items in the cart.
Add bundle items to a cart

iPad + phone

Replace Cart will remove the current contents of your cart and replace it with the bundle.
Add to Cart will add the contents of the bundle into your cart without removing it's current contents.

Items In Bundle

<table>
<thead>
<tr>
<th>Item</th>
<th>Price</th>
<th>Quantity</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Google Nexus 7</td>
<td>$199.99</td>
<td>1</td>
<td>$199.99</td>
</tr>
<tr>
<td>Apple iPad 3</td>
<td>$600.00</td>
<td>1</td>
<td>$600.00</td>
</tr>
</tbody>
</table>

Instance Options

The Saved Carts widget does not have any included instance options.

SC Scroll to top widget

In the Service Portal mobile view, the SC Scroll to top widget (sc_scroll_to_top) lets you scroll to the top of the screen after you scroll down. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

This widget is displayed when you start to scroll upwards after reaching a specific screen height.
SC Scroll to top widget

**Sales Laptop**
Acer Aspire NX

View Details $1,100.00

**Test Order Guide**

View Details

**Create Incident**
Create an Incident record to report and request assistance with an issue you are having

View Details

Instance options

Use the widget instance options to customize the settings for the SC Scroll to top widget. To customize the settings for this widget, press the Ctrl key, click on the widget, and select **Instance Options**.

Instance options for the SC Scroll to top widget

<table>
<thead>
<tr>
<th>Height from top (px)</th>
<th>Screen height where the widget is displayed when you start to scroll upwards.</th>
</tr>
</thead>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
SC Shopping Cart widget

The SC Shopping Cart widget (sc-shopping-cart-v2), used with Service Catalog, stores all your orders at one place. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Use the shopping cart widget to:

• Control the quantity of items in the cart.
• Add items to a cart. This information is stored in the sc_cart table.
• Define who the items are being requested for.
• Save specific items together as a bundle, which can be reloaded later. You can replace the cart items with the saved bundles, or add the bundles to the cart items.
• Remove all items from your cart.

Instance options

Use the widget instance options to customize the settings for the SC Shopping Cart widget. To customize the settings for this widget, press the Ctrl key, click on the widget, and select Instance Options.
## Instance options for the SC Shopping Cart widget

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Presentation</strong></td>
<td></td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td><strong>Behavior</strong></td>
<td></td>
</tr>
<tr>
<td>Cart Template</td>
<td>Enter the name of a ng-template you want to use to provide a different template for the shopping cart. By default, two ng-templates are provided: small_shopping_cart_v2.html and large_shopping_cart_v2.html.</td>
</tr>
<tr>
<td>Auto update cart</td>
<td>Automatically updates the cart across all sessions.</td>
</tr>
</tbody>
</table>

### Related information

**Add a catalog item to the shopping cart**

**Enable the Shopping Cart widget**

The shopping cart widget is enabled automatically for instances upgrading to Istanbul, however, there are several ways to manually enable or disable the widget.

To enable the shopping cart for a catalog item:

1. Navigate to a catalog item on the Service Catalog page in Service Portal.
2. CTRL+right-click a catalog item widget to open the widget instance options.
3. Select or clear the **Show Add Cart Button** option to enable or disable the shopping cart for that particular catalog item.
To enable the shopping cart in the portal header:

1. From the Service Portal configuration page, select the Portal editor.
2. Select the SP Header Menu in the portal hierarchy.
3. In the **Additional options** section, make sure the enable cart value is set to **true**.

```json
{
   "enable_cart": {
       "displayValue": "true",
       "value": true
   }
}
```

Set the value to **false** to hide the shopping cart.
Enable automatic updates to the shopping cart

Update the shopping cart automatically with user-specific changes from multiple tabs and platforms.

**Before you begin**

Role required: admin or sp_admin

**Procedure**

1. Navigate to Service Portal > Service Portal Home. The Service Portal homepage is displayed.
2. In the banner, click Cart.
3. Press and hold the Ctrl key, click the wish list widget, and select Instance Options.
4. Select the **Auto update cart** check box and click **Save**.
5. Perform these steps only for upgrade customers.
   

   b. In the banner, click Portals.
c. In the list, ensure that Service Portal is selected.

d. In the portal hierarchy chart, select SP Header Menu.

e. In the Additional options, JSON format field, set the auto_update_cart value as true.

```
"auto_update_cart": {
  "displayValue": "true",
  "value": true
}
```

Automatic updates to the shopping cart

SP Variable Editor widget

The Variable Editor widget allows you to change the specifications you chose for an item in the Service Catalog. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

You can embed the variable editor widget in the shopping cart widget, to allow users to edit and make changes to their cart items. The options included in the
widget are determined by the specific catalog item and the variables that have been configured for it.

For more information on the service catalog variables that are available in Service Portal, see service catalog variable types.

<table>
<thead>
<tr>
<th>Variable Editor widget</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variables</td>
</tr>
<tr>
<td>Allocated carrier</td>
</tr>
<tr>
<td>Sprint Nextel</td>
</tr>
<tr>
<td>Monthly data allowance</td>
</tr>
<tr>
<td>500MB [$1 Monthly]</td>
</tr>
<tr>
<td>Contract duration</td>
</tr>
<tr>
<td>12 Months</td>
</tr>
<tr>
<td>Color</td>
</tr>
<tr>
<td>Black</td>
</tr>
<tr>
<td>Storage</td>
</tr>
<tr>
<td>64GB</td>
</tr>
</tbody>
</table>

**Instance Options**

The Variable Editor widget is embedded as part of the shopping cart widget, therefore no instance options are included.

**SC Wish List Cart widget**

Use this widget to add catalog items or record producers to the wish list so that you can review them. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

If the wish list is enabled for Service Catalog, SC Wish List Cart widget (sc_wishlist_cart) is available in Service Portal. Once enabled, the following options are available:
• The **Wish List** menu option on the main navigation bar.

• The **Add to Wish List** button in the Ordering widget for catalog items and record producers.

• A wish list details page that displays all items in the **Wish List**.

From the wish list details page, you can view or delete catalog items, clear the wish list, or navigate to the Service Catalog landing page.

### SC Wish List Cart widget

![SC Wish List Cart widget](image)

### Instance options

Use the widget instance options to customize the settings for the SC Wish List Cart widget. To customize the settings for this widget, press the Ctrl key, click on the widget, and select **Instance Options**.

### Instance options for the SC Wish List Cart widget

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto update wish list</td>
<td>Automatically updates the wish list across all sessions.</td>
</tr>
</tbody>
</table>

### Related information

**Add an item to the wish list in Service Portal**

**Enable the SC Wish List Cart widget in Service Portal**

Add catalog items or record producers to the wish list after you enable the wish list.

### Before you begin

**Role required:** admin or sp_admin
Procedure

1. Navigate to **Service Catalog > Maintain Catalogs**.

2. From the Catalogs list, select **Service Catalog**.

3. On the catalog form, select the **Enable Wish List** check box and click **Update**. The **Wish List** menu option is displayed in the Service Portal banner.

   ✉ Note: The **Use the sc_layout driven cart macros (default true)** (**glide.sc.use_cart_layouts**) property must be set to true to enable the wish list.

4. To enable the **Wish List** menu option in the Service Portal banner, perform these additional steps only for upgrade customers.

   a. Navigate to **Service Portal > Service Portal Configuration**.

   b. In the banner, click **Portals**.

   c. In the list, ensure that **Service Portal** is selected.

   d. In the portal hierarchy chart, select **SP Header Menu**.

   e. In the **Additional options, JSON format** field, set the **enable_wishlist** value as **true**.

   ```json
   "enable_wishlist": {
       "displayValue": "true",
       "value": true
   }
   ```
5. Enable the Add to Wish List icon (.addButton) in the Ordering widget of a catalog item or record producer:


   b. Click one of the available catalog items.

   c. Press and hold the Ctrl key, click a catalog item widget, and select Instance Options.

   d. Select the Show Add/Update Wish List buttons check box and click Save.

Enable automatic updates to the wish list
Update the wish list automatically with user-specific changes from multiple tabs and platforms.

Before you begin
Role required: admin or sp_admin
Procedure

1. Navigate to Service Portal > Service Portal Home.
   The Service Portal homepage is displayed.

2. Access the wish list.

3. Press and hold the Ctrl key, click the wish list widget, and select Instance Options.

4. Select the Auto update wish list check box and click Save.

5. Perform these additional steps only for upgrade customers.


   b. In the banner, select Portals.

   c. In the list, ensure that Service Portal is selected.

   d. In the portal hierarchy chart, select SP Header Menu.

   e. In the Additional options, JSON format field, set the auto_update_wishlist value as true.
Automatic updates to the wish list

Service Portal configuration page widgets

Service Portal uses widgets for configuration. When you configure a page or a widget for a portal in the Service Portal Configuration page, you actually use Service Portal widgets to do so.

Service Portal configuration widgets are internal only and cannot be extended.

Configuration page widgets are included as part of the Service Portal Configuration Pages plugin [com.glide.service-portal.config], which is activated automatically when you activate the Service Portal for Enterprise Service Management plugin [com.glide.service-portal.esm].

Navigate to Service Portal > Service Portal Configuration to view these widgets in action.
Service Portal Config Overview widget

The Service Portal Config Overview widget is the widget that appears on the sp_config homepage. Use this widget to navigate Service Portal Configuration. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Portal config widget

The Portal Config widget is the left panel of the Branding Editor, which you use to configure themes for your portal. You can use this base system widget as-is in your portal or clone it to suit your own business needs.
Portal Config widget

Quick Setup

Title and Logo

Portal title
Service Portal

Logo

Upload an image  Delete

Logo Padding
Left: 
Top: 

Use title and logo to represent your brand across all pages of a portal

Tag Line and Background

Tag Line
How can we help?
SP Page Map widget
The Page Map widget works in the Page Editor to display any Service Portal page in a tree structure. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

SP Portal Map widget
The Portal Map widget displays your portal in a tree structure.

Theme Preview widget
The Theme Preview widget appears in the Branding Editor and allows you to see any theme changes you make to your portal. You can use this base system widget as-is in your portal or clone it to suit your own business needs.
Theme Preview widget

The Theme Preview widget appears on the main page of the Widget Editor in Service Portal Configuration. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Use the Theme Preview widget to view widgets that have recently been updated, create a widget, or view an existing widget.

Widget Edit Panel widget

The Widget Edit Panel appears on the main page of the Widget Editor in Service Portal Configuration. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

Use the Widget Edit Panel to view widgets that have recently been updated, create a widget, or view an existing widget.
Service Portal service status widgets

Use the service status widgets to display current, planned, and historical outages for business services to your end users.

The service catalog widgets are part of the Service Portal Service Status [com.glide.service-portal.service-status] plugin, which is activated automatically with the Service Portal for Enterprise Service Management [com.glide.service-portal.esm] plugin.

Business Service Status widget

View how services are running on your system. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

The Business Service Status widget pulls information from the cmdb_ci_service table. You can change where the data comes from in a cloned version of the widget by adjusting the settings in the widget server script.
Business Service Status widget

<table>
<thead>
<tr>
<th>Service</th>
<th>Jun 12</th>
<th>Jun 13</th>
<th>Jun 14</th>
<th>Jun 15</th>
<th>Jun 16</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bond Trading</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Bond Trading - DR</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Client Services</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>E-Commerce</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Electronic Messaging</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Email</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>IT Services</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Outlook Web Access (OWA)</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>PeopleSoft Asset Lifecycle Management</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>PeopleSoft CRM</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>PeopleSoft Enterprise Services</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>PeopleSoft Financials</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

Instance options

Business Service Status widget instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the widget. This only appears in the header for the widget instance options, it is not user-facing. To</td>
</tr>
</tbody>
</table>
Instance option fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>change the title for the list of services, clone and edit the widget HTML.</td>
<td></td>
</tr>
<tr>
<td>Glyph</td>
<td>Icon for the widget. This is not user-facing.</td>
</tr>
<tr>
<td>Number of Services</td>
<td>The number of services displayed in the widget. The default number is 250.</td>
</tr>
</tbody>
</table>

**Current Status widget**

The Current Status widget displays any issues reported in the system. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

The Current Status widget checks the Outages [cmdb_ci_outage] table to see if the system is experiencing any outages.

Service owners and service desk managers report planned or unplanned outages by creating outage records. Each outage record includes **Begin** and **End** fields to indicate the duration of the outage. If the **End** time is later or empty, then the outage is still ongoing. The Current Status widget displays all ongoing outages.

The Current Status displays outages only for services, which are tracked in the Services [cmdb_ci_service] table.

**Instance options**

Use the instance options to configure the Current Status widget for a portal page.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show outage details</td>
<td>Option to display details from the Outage [cmdb_ci_outage] record.</td>
</tr>
<tr>
<td>Standalone</td>
<td>Option to remove explanatory information. This option also adds a link to more information.</td>
</tr>
</tbody>
</table>

**Planned Maintenance widget**

Describes any planned system maintenance. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

The widget gathers information from the cmdb_ci_outage table. Any planned maintenance within the following five days appears in the Planned Maintenance widget.

**Instance options**

The Planned Maintenance widget does not have any included instance options.

**Service History widget**

Displays the history of specific service's status. For example, if the Bond Trading widget has a history of planned outages or degradations, the widget displays those with a varied color scheme to differentiate the outage type. You can use this base system widget as-is in your portal or clone it to suit your own business needs.
Service History widget

From most recent to oldest, this list shows all outages, degradations and planned maintenance for this service.

Outage - Bond Trading
- 3d ago
- Started 2016-06-14 17:13:15, Duration 1 Hour 15 Minutes

Planned Outage - Bond Trading
- 7d ago
- Started 2016-06-10 14:50:26, Duration 3 Hours 31 Minutes

Planned Outage - Bond Trading
- 8d ago
- Started 2016-06-09 04:37:15, Duration 3 Hours 32 Minutes

Planned Outage - Bond Trading
- 9d ago
- Started 2016-06-08 16:08:12, Duration 3 Hours 24 Minutes

Instance options

The Service History widget does not include any instance options.

Service Status widget

The Service Status widget provides a visual representation of service availability over the past three months. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

The Service Status widget displays the history of service availability for one service from the Services [cmdb_ci_service] table. The widget uses the page URL to determine which service to represent.

Each pill represents one day. Each color correlates with a type of service availability.

<table>
<thead>
<tr>
<th>Color</th>
<th>Service availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>No issues</td>
</tr>
<tr>
<td>Color</td>
<td>Service availability</td>
</tr>
<tr>
<td>--------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Blue</td>
<td>Planned maintenance</td>
</tr>
<tr>
<td>Yellow</td>
<td>Service degradation</td>
</tr>
<tr>
<td>Red</td>
<td>Outage</td>
</tr>
</tbody>
</table>

### Instance options

The Service Status widget does not have any included instance options.

### Service Status Legend widget

Use concurrently with the Status History widget to show what the icons in the Status History widget mean. You can use this base system widget as-is in your portal or clone it to suit your own business needs.

### Instance options

The Service Status Legend widget does not have any included instance options.

### Service Status Subscription widget

Used in conjunction with the service status widget. Users subscribe to receive updates about the service status. You can use this base system widget as-is in your portal or clone it to suit your own business needs.
**Instance options**

The Service Status Subscription widget does not have any included instance options.

**Widget instances**

When you add a widget to a page using the Service Portal Designer, it creates a widget instance. A widget instance is a reference to a widget that contains a location, properties, and CSS specific to that instance. Adding the same widget multiple times to the same page creates multiple instances.

For example, the Icon Link widget displays as many different versions of itself as you add to a page.

- **Icon link widgets**

  ![Icon Link widgets](image)

  All widget instances point to a widget. If you make changes in that specific widget, all of the widget instances receive that change as well. You can also make changes specifically to a widget instance and only the widget instance will be affected.

**Configure widget instance options**

Each instance of the widget you configure remains unique, so you can have several instances of the same widgets on a page. For example, each instance of the cool clock widget on a page shows a different time zone. Configure a widget on a page by adjusting the instance options.

**Before you begin**

Role required: admin or sp_admin

**About this task**

Each time you add a widget to a page it creates a record on the sp_instance table with the following information:

- Reference to the column where the widget is located
- Reference to a widget
- Configuration for a widget in the form of pre-defined form fields and an Additional Options field in JSON format
Procedure

1. On a page in the Service Portal Designer, point to the Edit icon (-pencil) in a widget to open the widget instance options. You can also access widget instance options using the control + right-click menu.

2. From the Instance Options window, make the selections you want to configure your widget. Instance options vary depending on which widget you select.

Results

Configure widget instance options

What to do next
Advanced users can configure the available options for a widget. For more information, see Widget option schema.

Widget context menu

From any rendered Service Portal page you can CTRL+right-click a widget to see more configuration options in a context menu.

For example, navigate to Service Portal > Service Portal Home to open a sample portal page. CTRL+right-click Knowledge Base on that page.
**Note:** You must have the admin or sp_admin role to see the widget context menu. When you impersonate a user without one of those roles, you can still see the menu. However, a regular user signed in without those roles cannot see the menu.

**Widget context menu options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Widget performance</td>
<td>How long it takes for a widget to load</td>
</tr>
<tr>
<td>Instance options</td>
<td>Specify an instance of a widget. Widgets instance options vary depending on the widget you select. For example, the instance options for the cool clock widget include different time zones for each instance, so you can have the same clock four times on a page, but with all different time zones.</td>
</tr>
</tbody>
</table>
## Widget context menu options (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance in Page Editor</td>
<td>Opens that instance of the widget in the Page Editor</td>
</tr>
<tr>
<td>Page Designer</td>
<td>Opens the widget in the Service Portal Designer, which lets you add containers, columns, and widgets. You can add styling from the Service Portal Designer to your specific widget or to the page the widget lives on.</td>
</tr>
<tr>
<td>Show Widget Customizations</td>
<td>Shows customization levels of widgets on the page so that you can diagnose page issues. For more information, see Widget diagnostics.</td>
</tr>
<tr>
<td>Edit Container Background</td>
<td>Make changes to the layout in which the widget is located.</td>
</tr>
<tr>
<td>Widget Options Schema</td>
<td>Define the actual options you can select for an instance of a widget. For more information on configuring your own instance options, see Widget option schema.</td>
</tr>
<tr>
<td>Widget in Form Modal</td>
<td>Opens the widget form in a pop up window so you can make quick changes to the widget.</td>
</tr>
<tr>
<td>Widget in Editor</td>
<td>Opens the widget in the Widget Editor. You can use the Widget Editor to configure HTML templates, CSS, client scripts, service scripts, and demo data for the widget.</td>
</tr>
<tr>
<td>Log to console: $scope.data</td>
<td>The $scope.data object passes data from the server to the client side controller. Instead of adding console.log messages or alerts into the controller code, you can just log the $scope.data object to the browser console and view the data there.</td>
</tr>
<tr>
<td>Log to console: $scope</td>
<td>Similar to the $scope.data object, except it logs everything in $scope to the console.</td>
</tr>
</tbody>
</table>

### Widget developer guide

Develop custom widgets in the Service Portal using AngularJS, Bootstrap, and the ServiceNow API.

### What to know before you begin

To develop widgets, you need ServiceNow API experience to:
• Run record queries on the server.
• Create and update records.

You need AngularJS experience to:
• Bind variables to client controllers.
• Access server objects in a widget.
• Gather user input.

Optionally, you can build on the Bootstrap template by accessing Bootstrap components. Service Portal uses Bootstrap version 3.3.6.

Parts of a widget
Like Angular directives, widgets execute a specified behavior within a Service Portal page. A widget includes mandatory and optional scripting components.

HTML template
A mandatory widget component.
The HTML template requires knowledge of AngularJS to display and gather data. Use the HTML template to:

• Render the dynamic view that a user sees in the browser using information from the model and controller.
• Bind client script variables to your markup.
• Gather data from the end user.

Client script
A mandatory widget component.
A client script requires knowledge of both the ServiceNow API and AngularJS to create a client controller. Use the client script to:

• Map server data from JavaScript and JSON objects to client objects.
• Process data before rendering it.
• Pass data to the HTML template.
• Pass user input and data back to the server for processing.

Server script
A mandatory widget component.
A server script requires knowledge of the ServiceNow API to work with record data. Use the server script to:

- Set the initial state of the widget.
- Send record data to the widget client script using the `data` variable.
- Run server-side queries.

**Link function**

An optional widget component.

The link function requires knowledge of AngularJS. Use a link function to directly manipulate the DOM.

**Option schema**

An optional widget component.

Allows a Service Portal admin to configure a widget. Use the option schema to:

- Specify the parameters for a widget.
- Allow admin users to define instance options for a widget instance.
- Develop flexible, reusable widgets.

**Angular Providers**

An optional widget component.

Angular Providers require knowledge of AngularJS. Use Angular Providers to:

- Keep widgets in sync when changing records or filters.
- Share context between widgets.
- Maintain and persist state.
- Create reusable behaviors and UI components and inject them into multiple widgets.

**Dependencies**

An optional widget component.

A widget dependency is an external resource used by your widget such as JavaScript or CSS files.
Global objects in widgets

When a widget begins to render for the first time on a page, the server script executes first and accesses three global objects: `input`, `options`, and `data`. Because the `input` variable is a data object sent from the client script, this variable is undefined when first initialized.

When a widget is first instantiated, the server script:

1. Initializes an empty `data` object.
2. Initializes the `input` object with any data sent from the client controller, or the `options` object with any data used to initialize the widget.
3. Sends the `data` object to the client controller as JSON.

The client script:

1. Accesses the server `data` object using `c.data`.

   - **Note:** By default, widgets use the `c` variable to represent the controller instance using `controller as` syntax. You can change this variable when creating or cloning widgets.

2. Uses `server.update()` to post changes to the data model. This method updates the server script using the `input` object.

   - **Note:** After calling `server.update()`, the client script `data` object is automatically overwritten by the server script `data` object.

3. Uses `c.options` to access the values used to invoke the widget on the server. This object is read-only.
Using the Widget Editor

When you create a widget, a record is created in the sp_widget table. However, you can use the Widget Editor in Service Portal Configuration as your scripting environment. The Widget Editor is a full page application similar to an IDE. You can show the parts of the widget you want to edit and hide the rest, while previewing your changes in real time.

Recommendations for developing widgets

When developing custom widgets, keep these recommendations in mind for optimal performance, scalable development, and a good user experience.

Create a default state that provides an example to the end user

A widget does not have instance options defined when initially added to a page. A widget in this empty state can appear blank and cause confusion. In situations where a widget requires some initial configuration, ensure that your widget has a default state that communicates to the admin what configuration is necessary.

Widgets can also be created with demo data. Demo data can also be used to:
• Clearly demonstrate the widget functionality to the user.
• Provide data when previewing the widget in the widget editor. (Demo data is not visible in the designer).

Learn more: Tutorial: Build a custom widget.

Embed a widget rather than clone when possible

Embedding an existing widget into your custom widget takes advantage of pre-existing functionality without cloning or duplicating code. You can still pass parameters into the embedded widget to control its behavior.

Learn more: Embed an existing widget

Add limits to GlideRecord queries to improve performance

If your server-side script uses GlideRecord queries, the setLimit function can restrict the number of records returned, and improve response time on queries. For added flexibility, you can tie this limit to an instance option rather than assigning a hard-coded value (for example: gr.setLimit(options.limit || 100)).

Learn more: GlideRecord setLimit Function

Create a directive instead of embedding a complex widget

When an embedded widget is called from the server, all the scripts associated with that widget are returned. If you only need a subsection of a widget, embedding the entire widget creates unnecessary overhead. Instead, use directives to share lightweight code between widgets. Directives are useful, for example, when building UI components. Complex components with server-side and client-side functionality are best left as widgets. Use a directive instead of an embedded widget to:

• Share scope or custom scope behavior with multiple widgets.
• Share a reusable, lightweight subsection of a widget.
• Share a common UI feature, such as a list or an avatar.
• Augment widget behavior.

Learn more: Reuse components with Angular Providers.

Use a service or factory to share data and persist state

Data services and factories maintain and persist state in a widget without requiring multiple calls to the server, enabling you to:
- Keep widgets synchronized when changing records or filters.
- Share data between widgets.
- Develop more performant widgets.

Learn more: Reuse components with Angular Providers.

**Handle events with a publish/subscribe service**

Avoid using `$broadcast` in the DOM. `$broadcast` dispatches the event name to all child scopes notifying registered listeners, which can be an expensive call that requires the use of the `$rootScope` global object.

Instead, use a publish/subscribe service to handle events. When using a publish/subscribe service, a clear relationship forms between your widgets through callback handlers. In this model, you can better control the state of your events.

**Use REST calls or `server.get` to fetch data from the server**

When you call `server.update()`, the entire widget is returned from the server. If your widget includes divergent code paths, multiple calls to update the server can affect performance. As a rule, use your server script to set up the initial state of your widget. For subsequent updates, use scripted REST APIs that call script includes on your instance. This practice:

- Separates business logic from UI elements.
- Centralizes your code, allowing changes to be made in one place.

You can also use `server.get` to pass information to the server. Use this function along with `input.action` to execute specific parts of the server script.

**Develop with localization, accessibility, and UI in mind**

To create the best experience for your users, follow these guidelines:

- Consider the impact of your widget in a mobile environment. For example, avoid using mouse-over and other events that do not translate to a mobile device.
- Use SCSS variables to reuse items. See SCSS variables.
• Use variable names when using colors.
• Wrap strings for translation in localization APIs. See Internationalize a widget.

Remove unused Angular Providers from client script
For easier maintenance, remove any unused Angular Providers that were injected into the client script function statement.

Avoid using <script> tags in HTML templates
To lessen the likelihood of production issues in Service Portal, avoid using inline templates using <script> tags in a widget's HTML template. Instead, create a related Angular ng-template record for the widget.

Clone a widget
Take advantage of existing code by cloning and editing an existing widget.

Before you begin
Role required: admin or sp_admin

About this task
Tip: Base system widgets are read-only so you can benefit from future updates. To make changes, you can clone base system widgets. However, cloned widgets are considered custom and don’t benefit from future updates to the widgets they were cloned from.

Procedure
1. Open the Widget Editor in the Service Portal Configuration page, then select an existing widget from the Select a widget list. For example, select Hello World 2.
2. From the list menu in the widget header, click Clone "Hello World 2".
3. Enter a name for the cloned widget. The widget ID is created automatically based on the widget name.

4. **Optional:** Select **Create test page** to automatically create a page containing the widget.

5. Use the check boxes to show or hide the different components of the widget editor as needed. Make changes to the HTML Template, CSS, client script, server script, or the link function.
6. In order to enable a preview of your widget, use **Enable Preview** from the menu. Use the eye icon that appears to show or hide a preview of your widget.

**What to do next**

If you clone a widget that uses the Angular ng-template, you must manually clone the template and change the name of the template reference in the widget.

For example, the header menu widget uses the Angular ng-template `menuTemplate`. If you clone the header menu widget, you must also clone the `menuTemplate` and give the clone a unique name. When you open the clone of the header menu widget, you can see a reference to the `menuTemplate` in the HTML.

**menuTemplate in header widget HTML**

Create a new widget

Create a new widget to build a custom widget from scratch.
Before you begin
Role required: admin or sp_admin

Procedure
1. Navigate to Service Portal > Service Portal Configuration > Widget Editor.
2. Click Create a new widget.
3. Enter a name for the new widget. The widget ID is created automatically based on the widget name. Optionally select Create test page to automatically create a page containing the widget.

Note: After completing development of a widget with a test page, delete the test page. Maintaining test pages can create clutter when managing pages.

4. Click Submit.

The widget HTML template, client script, and server script display in the widget editor. Basic script templates are included as a guide.
**Widget option schema**

Widget instances allow users to uniquely configure each widget they add to a page. Use the option schema to define the parameters for your widget.

**Storing instance options**

When developing a widget, you can edit the option schema to create parameters for your widget, or you can create a table to store instance options. If you edit the existing option schema, any instance options defined are stored in JSON format in the Additional options, JSON format field in the sp_instance table. The following field types are available:

- String
- Boolean
- Integer
- Reference
- Choice
- Field_list (depends on table)
- Field_name (depends on table)
- Glide_list

To use other field types not supported in the option schema, create an extension table to store your custom widget option schema. Using a table enables you to:

- Add any ServiceNow field type, including fields with advanced customization, to the option schema.
- Define a complex option schema.
- Search and filter instance options.

⚠️ **Note:** While storing options in a table enables you to define more complex options, this method is more difficult to maintain than editing the option schema. To avoid creating unnecessary tables and adding additional server calls to your widget, edit the existing option schema when possible. Store options in a table only when complex or searchable options are required.

**Using options in a widget**

Access options in the widget from both the client script and the server script using the `options` global variable. You can access to any option value in your widget client script or server script using `options.optionName`. 
Client script

```javascript
function() {
    /* widget controller */
    var c = this;
    console.log(c.options.text_color) //Outputs the text_color option for this instance
}
```

Server script

```javascript
(function() {
    $sp.log(options.text_color) //Logs the value of the text_color option to the browser
    console;
})();
```

Defining default options

Before an option value is set on an instance, it appears as an undefined value when you access that option variable. Use the widget server script to specify default values for your options.

```javascript
(function() {
    options.text_color=options.text_color||"blue";
    options.maximum_entry_count=options.maximum_entry_count||5;
})
```

Edit the widget option schema

Widget instances allow users to uniquely configure each widget they add to a page. Edit the option schema to define basic parameters for your widget.

Before you begin
Role required: admin or sp_admin

Procedure

1. Navigate to Service Portal > Service Portal Configuration > Widget Editor.
2. Select the widget you want to configure the option schema for.
3. Click the menu icon (≡) and select Edit option schema. This option only appears for users that have the right to edit the widget.
4. Click + to add a widget option.
5. Define a label, name, type, hint and form section. More fields appear depending on the type you select.
Adding flexible widget options allows you to create more reusable widgets. You can add default values to help users understand each widget option. If you do not select a form section, the default is set to Other options.

6. Click **Save**.
   The option schema you defined is stored in JSON format in the **Option schema** field in the sp_widget table. Based on this option schema, each instance of the widget can use individually defined instance options.

7. Test the option schema by adding the widget to a page in the Service Portal Designer.

   a. Navigate to **Service Portal > Service Portal Configuration > Service Portal Designer**.

   b. Add the widget to a page and click the edit icon on the widget instance to view the instance options.

   c. Configure the widget instance options.

   d. View the configuration by navigating to the instance record in the sp_instance table. The instance options are stored in JSON format in the **Additional options, JSON format** field.
Store instance options in a table

Create a table to store widget instance options instead of editing the existing option schema. When using a table as your widget option schema, you can define custom fields using any ServiceNow field type, add filters to fields, and search or query instance options.

Before you begin
Role required: admin or sp_admin

About this task
To define a custom option schema, add fields to an sp_instance extension table, then set your widget to use the extension table as a data source. Using an extension table enables you to:

• Add any ServiceNow field type, including fields with advanced customization, to the option schema.
• Define complex widget options.
• Search and filter instance options.

Note: While storing options in a table enables you to define more complex options, this method is more difficult to maintain than editing the option schema. To avoid creating unnecessary tables and adding additional server calls to your widget, edit the existing option schema when possible. Store options in a table only when complex or searchable options are required.

Procedure
1. Create a table that extends an sp_instance table to store your custom option schema.

   a. Navigate to System Definition > Tables.

   b. Click New.

   c. Define a label and name.

   d. In the Extends table field, select an sp_instance table that provides the necessary fields.
### Instance table

<table>
<thead>
<tr>
<th>Instance table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance [sp_instance]</td>
<td>Includes base instance fields.</td>
</tr>
<tr>
<td>Instance with Table [sp_instance_table]</td>
<td>Includes sp_instance fields and fields to display table data such as Table and Filter.</td>
</tr>
</tbody>
</table>

**e. Save the form.**

2. **Define custom fields in the extension table.**
   You can define any field type to use in your option schema by adding new columns in the **Columns** list.

3. **Update your widget to use the extension table as a data source.**
   
   **a. Navigate to Service Portal > Widgets.**
   
   **b. Open the widget you would like to create custom options for.**
   
   **c. In the Data table field, select your sp_instance extension table.**

4. **Configure the extension table form to display the desired fields.** Fields configured on the form are available as instance options.
   
   **a. Navigate to the extension table form: `<yourInstance>/<your_extension_table>.do`.**
   
   **b. Right-click the header menu and select Configure > Form Layout.**
   
   **c. Add the fields to the form.**
   
   **d. Click Save.**

5. **Configure the widget to display the desired fields as instance options.**
a. Navigate to Service Portal > Widgets.

b. Open the widget that has the extension table set as the data source.

c. Use the Fields slushbucket to select fields to display as instance options.

d. Save the form.

What to do next
Test the option schema by adding the widget to a page in the Service Portal Designer. Click the edit icon on the widget instance to view the instance options. After configuring the widget instance options, view the configuration by navigating to the instance record in the sp_instance extension table.

Reuse components with Angular Providers
Angular Providers are reusable components that can be injected into multiple widgets. To ensure quick loading widgets and a high performing portal, create Angular Providers instead of overloading your client controllers with persistent data and additional logic. With Angular Providers, you can maintain data for the lifetime of your Service Portal and reuse components and data objects across multiple widgets.

Before you begin
Role required: admin or sp_admin

About this task
By creating an Angular Provider, you can:

• Keep widgets in sync when changing records or filters.
• Share context between widgets.
• Maintain and persist state.
• Create behaviors and inject them into multiple widgets.

To learn more, visit Angular Providers.
Tip: For easier maintenance and troubleshooting, remove any unused providers from the Angular Providers related list in the Widget [sp_widget] table.

Procedure

   The Widget Angular Providers table opens.

2. Click New to create a new record.

3. Select the type of Angular Provider.
   - Directive
   - Factory
   - Service
   To facilitate migration to ECMAScript 6 in the future, consider using services over factories.

4. Define a name.
   You will use the name to associate the Provider with your widget.
5. Add a script in the **Client Script** field.

**Example**

A basic factory that formats a number in US currency.

```javascript
function formatterFactory(){
    var myVal = Number;
    return {
        format: function(myVal) {
            return '$' + myVal.toFixed(2);
        }
    }
}
```

6. Associate the Angular Provider with a widget.

   a. Navigate to `<yourInstanceURL>/sp_config?id=widget_edit`.

   b. Open the widget you would like to associate with the Angular Provider.

   c. Under **Related Lists**, select **Angular Providers**.

   d. In the **Angular Providers** list, click **New**.

   e. In the **Angular Provider** field, select the appropriate Provider. Check the **Widget** field to ensure that you are associating the Angular Provider with the correct widget.

   f. Click **Save**.

7. Update the appropriate scripts in your widget to inject the Angular Provider into the widget.
Example

Inject the factory into your widget client script by passing the name of the factory as an argument in your client controller function. You can then access the object defined in the factory function in your widget client script.

```javascript
function(formatterFactory) {
    /* widget controller */
    var c = this;
    console.log(formatterFactory.format(300));
}
```

If defining a directive, use the directive in the widget HTML template.

8. To edit the Angular Provider after it is registered with your widget, open the Angular Provider client script in the widget editor.

   a. Navigate to Service Portal Configuration > Widget Editor.

   b. Under Edit an existing widget, select the widget associated with your Angular Provider.

   c. In the Show menu, open the Dependencies list and select the Angular Provider.

   ![Dependencies list]

   Note: Only Angular Providers associated with the widget are displayed in the Dependencies list. This list includes any external resources your widget depends on.

   The Angular Provider client script displays in the widget editor. In the widget editor interface, you can edit and save your widget and Provider scripts at the same time.

What to do next

To use an Angular Provider with multiple widgets, register your Provider with each widget and update the appropriate scripts.

Embedded widgets

Embed a widget in the HTML template, server script, or client script.
**Embed a widget in an HTML template**

Use the `<widget></widget>` element to embed a widget in an HTML template. Pass in the ID of the widget you are trying to embed as a parameter.

```html
<div>
  <widget id="widget-cool-clock"></widget>
</div>
```

If a widget has an option schema, you can define instance options in JSON format.

```html
<widget id="widget-cool-clock" options='{"zone": "America/Los_Angeles","title": "San Diego, CA"}'></widget>
```

Alternatively, you can define options in the widget server script.

**HTML template**

```html
<widget id="widget-cool-clock" options='data.clockOptions'></widget>
```

**Server script**

```javascript
(function() {
    data.clockOptions = {"zone": "America/Los_Angeles","title": "San Diego, CA"};
})();
```

**Embed a widget in a client script**

Use `spUtil.get()` to get a widget model in the client script.

```javascript
spUtil.get("widget-sc-cat-item", {sys_id: "your_catalog_item_sys_id"}).then(function(response) {
    c.catalogItemWidget = response;
});
```

When using the `spUtil` class in a widget client script, you must inject the class into the client script function. The following example embeds the Cool Clock widget:

**Client script**

```javascript
function(spUtil) {
    var c = this;
    spUtil.get("widget-cool-clock").then(function(response) {
        c.myClockWidget = response;
    });
}
```

**HTML template**
Embed a widget in a server script

Use `$sp.getWidget()` to get a widget model in the server script.

```javascript
data.catalogItemWidget = $sp.getWidget("widget-sc-cat-item");
```

The following example embeds the Cool Clock widget:

**Server script**

```javascript
(function() {
    var coolClockOptions = {"zone": "America/Los_Angeles","title": "San Diego, CA"}
    data.coolClockWidget = $sp.getWidget('widget-cool-clock',
                                coolClockOptions);
})();
```

**HTML template**

```html
<sp-widget widget="data.coolClockWidget"></sp-widget>
```

Widget model properties

When a widget model is called from within another widget, the HTML template, client script, and link function are loaded just as they are in the `sp_widget` record. The data property is the result of the widget server script execution. Anything that you put on the data object on the server is available in the data object on the client.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>client_script</td>
<td>string</td>
<td>Widget client script field.</td>
</tr>
<tr>
<td>css</td>
<td>string</td>
<td>Compiled CSS output from the SASS field for the widget.</td>
</tr>
<tr>
<td>data</td>
<td>object</td>
<td>Data object containing keys and values from the widget server script.</td>
</tr>
<tr>
<td>dependencies</td>
<td>array</td>
<td>Any third-party libraries to load before the widget executes.</td>
</tr>
<tr>
<td>options</td>
<td>object</td>
<td>Options used to initialize the widget.</td>
</tr>
<tr>
<td>template</td>
<td>string</td>
<td>HTML template field for the widget.</td>
</tr>
</tbody>
</table>
Embed a widget multiple times with custom options

Embed the cool clock widget multiple times using custom options.

Before you begin
Role required: admin or sp_admin

About this task
Create a widget that embeds multiple instances of the cool clock widget, each with a different time zone and title. Open the cool clock widget in the Widget Editor to see widget options referenced in the HTML template and the Client Script.

Cool Clock widget with Options highlighted

Procedure
1. Clone the Cool Clock widget with the name Embedded clock.
2. Replace the code blocks with the following:

```html
<div class="panel panel-default">
  <div class="panel-heading">Time across the US</div>
  <div class="panel-body">
    <div class="row">
      <div class='col-sm-3' ng-repeat="myClock in c.data.clocks">
        <sp-widget widget="myClock"></sp-widget>
      </div>
    </div>
  </div>
</div>
```
### CSS

```
.panel {
    margin-top: 10px;
}
```

### Client Script

```
function() {
    // nothing to do here...
}
```

### Server Script

```
(function() {
    var options = [
        {zone: "America/Los_Angeles", title: "San Diego"},
        {zone: "America/Denver", title: "Denver"},
        {zone: "America/Chicago", title: "Chicago"},
        {zone: "America/New_York", title: "New York"}
    ];

    data.clocks = [];
    for (var i in options) {
        data.clocks.push($sp.getWidget("widget-cool-clock", options[i]));
    }

})();
```

### Results

Each instance of the clock in the embedded clock widget appears with a different time zone.

### Sample clock options

<table>
<thead>
<tr>
<th>Time across the US</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="San Diego" /></td>
</tr>
<tr>
<td><img src="#" alt="Denver" /></td>
</tr>
<tr>
<td><img src="#" alt="Chicago" /></td>
</tr>
<tr>
<td><img src="#" alt="New York" /></td>
</tr>
</tbody>
</table>
Create a widget dependency

In Service Portal, you can link JavaScript and CSS files to widgets to create dependencies between widgets and third-party libraries, external style sheets, and angular modules.

Before you begin
Role required: admin or sp_admin

About this task
Dependencies are loaded asynchronously from the server when needed.
Widgets can have as many or as few dependencies as needed. However, the more you add, the more content a widget must download to render on the page. Keep dependencies as small as possible for more efficient load times.

Procedure

1. Create a dependency package.
   A dependency package is a collection of JavaScript and CSS files that can be then connected to a widget.
   
   a. Navigate to Service Portal > Dependencies.
   
   b. In the dependency record, define the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of your dependency. (Useful for selecting a dependency from a dropdown list.)</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for the dependency record.</td>
</tr>
<tr>
<td>Include on page load</td>
<td>Select if you want your dependency to be loaded onto the page on the initial page load of Service Portal, or leave unchecked to load the dependency only when the linked widget is loaded onto a page.</td>
</tr>
<tr>
<td>Angular module name</td>
<td>Optional. Define the value if the linked JavaScript is an Angular module. Provide the name of the Angular module being loaded, so that it can be injected into the Service Portal Angular application.</td>
</tr>
</tbody>
</table>

2. Add files to the dependency package.
After you save the information for your dependency package, use the related lists to add JS and CSS Include files. For each related list, include the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the script include.</td>
</tr>
<tr>
<td>Source</td>
<td>Depending on whether you add a JS Include or a CSS Include, select one of these options from the list:</td>
</tr>
<tr>
<td></td>
<td>• URL</td>
</tr>
<tr>
<td></td>
<td>• UI script (for a JS Include) or Style Sheet (for a CSS Include)</td>
</tr>
</tbody>
</table>

For a JS Include, use the UI Script field to reference a UI Script found in **System UI > UI Scripts**.

For the CSS Include, use the Style Sheet field to reference a record in the **sp_css** table.

3. Add a dependency package to a widget.
   After you have created a dependency package and added files, create a relationship between the dependency and a widget.
   a. Navigate to **Service Portal > Widgets** and find the widget record you want to add the dependency to.
   b. From the Dependencies related list, click **Edit**.
   c. In the slushbucket, find the dependency you created and double-click to add it to the selected items column on the right.
   d. Save the page to return to the widget record.

Include a font icon in a single widget
If you only want one widget to have access to a font icon, include the font icon in a single widget.

**Before you begin**
Role required: admin or sp_admin

**About this task**
Adding an icon to a specific widget keeps the icon scoped and prevents it from interfering with other CSS on the page.
Procedure

1. In the platform UI, navigate to Service Portal > Widgets, then click the widget you want to add an icon to.

2. Attach the individual icon file to the widget record.

3. In the HTML template, include something like the following:

   ```html
   <div>
   <i class='font-family'>icon_name</i> you did it!
   </div>
   ```

   Make sure the class is exactly the same as the font family called out in the CSS. For example `<i class='material-icons'>` should be the same as the `.material-icons` included in the CSS. The `icon_name` should match the name of the file you attached.

4. In the CSS field for the widget, add the CSS for the font-icon definition. Most font-icon sets include a CSS file similar to the material icons one used below. Use the sys_id of the attachment as the `src` in the CSS.
Results

An icon that you can select in the widget or widget instance.

What to do next
To use custom font-icons across widgets, add the icon to a page or make it a widget dependency.

Related information
  Include font icons on a page
  Include font icons as a widget dependency

Include font icons as a widget dependency
You can include font icons wherever a widget is loaded by including them as a widget dependency.

Before you begin
Role required: admin or sp_admin

About this task
⚠️ Note: CSS included as a widget dependency is not scoped and can disrupt other CSS on a page.

Procedure
1. In the platform UI, navigate to **Service Portal > CSS** and create a new style sheet.
2. Attach the font-icon set to the sp_css record you created, and use the sys_id of the attachment as the src for the font icon.
3. Navigate to **Service Portal > Dependencies** and create a new dependency.
4. Attach the CSS record you created to the new dependency using the CSS Includes related list.

**Internationalize a widget**

Use the `{{}}` or `gs.getMessage()` syntax in widgets to tag strings for translation so you can localize your Service Portal content.

The `{{}}` or `gs.getMessage()` searches in the messages table `[sys_ui_message]` in the platform to see what the translation would be.

Use the HTML template to internationalize strings in a widget. Type the following in an HTML template.

```html
<div>
  <p>{{This message will be internationalized.}}</p>
  <p>However, this will NOT be.</p>
</div>
```

Writing text as `{{message}}` is the equivalent of writing `$(gs.getMessage("message"))` in other parts of the system, but written as a more legible shorthand.
Note: In some cases, the translation might have quotes or double quotes on it. That could lead to JavaScript errors if you are using the ${} syntax in the client script. The safest way to fetch a translated message is to do it in the server script. Then, assign the value to a client-side Angular binding.

Translating strings in the client script

```javascript
function() {
    var c = this;
    c.message = "${This message will be internationalized}";
}
```

HTML template:

```html
<div>
    <!-- The output of this text will be internationalized. -->
    <p>{{c.message}}</p>
</div>
```

Translating strings in the server script

Use the server script to translate schema options and other values during server-side runtime.

Server script

```javascript
function() {
    data.message = gs.getMessage("this message contains 'quotes'");
    // You can also translate schema options using the server script
    // For example, data.message = gs.getMessage(options.title);
}
```

HTML template

```html
<div>
    <p>{{c.data.message}}</p>
</div>
```

Tutorial: Build a custom widget

Follow this tutorial to build a custom widget that displays Service Catalog items. Use this tutorial as a model to help you understand the advanced scripting power of the Service Portal.

In this tutorial, you will create the Quick Order widget. This widget:

- Displays popular items to the user prior to any search.
- Queries the Service Catalog and displays available options to the user.
Includes an embedded SC Catalog Item widget, allowing the user to view and order items within the Quick Order widget.

Uses an Angular Provider to display a category icon beside each queried item.

Create a widget and set up a template
Create the Quick Order widget to query items in the Service Catalog.

Before you begin
Role required: admin or sp_admin

Procedure
1. Navigate to Service Portal > Service Portal Configuration and click Widget Editor.
2. Click Create a new widget.

Widget Editor
Widget Editor is a development tool that allows you to view an widgets, create new widgets from scratch, and update the vari

• Check out the Hello World Example
• Create a new widget
• Edit an existing widget

Select a widget

3. Define the following values.
• Widget Name: Quick Order
• Widget ID: quick_order
Create a test page: Active
Page ID: quick_order

Adding a widget to a test page creates a record in each of the following tables:

- sp_page
- sp_container
- sp_row
- sp_column
- sp_instance
- sp_widget

Note: You can use the Page Editor in Service Portal Configuration to view the hierarchy of elements on your test page.
4. Click **Submit**.

5. From the **Widget Editor**, open the Quick Order widget.

6. Add the following simple template to the HTML field.

   ```html
   <div class="panel panel-primary">
     <div class="panel-heading">Request an item from the catalog</div>
     <div class="panel-body">
       My catalog results
     </div>
   </div>
   ```

7. Click **Save**.

8. Preview your test page in a new tab using the following URL:

    `<yourInstanceUrl>/sp?id=quick_order`.

   Your widget template displays on the test page.

Add a server script to query an instance table

After adding your widget and creating a basic template, you can define more advanced scripts that enable the user to query data from an instance table. Using client and server scripts, you can pass the data model between the client and server by querying data from the database, displaying it to the user, and sending any updates back to the server.

**Before you begin**

Role required: admin or sp_admin

**Procedure**

1. From the **Widget Editor**, open the Quick Order widget.

2. Select **Server Script** to open the server script script field.

3. Replace the default server script with the following custom script.

   ```javascript
   (function() {
     if (input.keywords != null && input.keywords != '')
       data.items = getCatalogItems(input.keywords);

   function getCatalogItems(keywords) {
     var sc = new GlideRecord('sc_cat_item');
   ```
This script performs a keyword search on the sc_cat_item table using the 123TEXTQUERY321 query method.

4. Replace the HTML template with the following script:

```html
<div class="panel panel-primary">
  <div class="panel-heading">Request an item from the catalog</div>
  <div class="panel-body">
    <input class="form-control" type="search" placeholder="Start typing here to search the list of catalog items" ng-model="c.data.keywords" ng-change="c.server.update()" ng-model-options="{debounce: 250}" />
    <ul class="list-group result-container">
      <li class="list-group-item" ng-repeat="item in c.data.items">
        <a href="{{item.name}}">{{item.name}}</a><span class="pull-right">{{item.price}}</span>
      </li>
    </ul>
  </div>
</div>
```

This template adds a search field and displays the results of the query performed in the server script using the following Angular directives. To learn more about these directives, review the Angular API Reference.
Angular directives used in the template

<table>
<thead>
<tr>
<th>Angular directive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ng-model</td>
<td>Automatically reads and writes value changes to the model variable <code>c.data.keywords</code>.</td>
</tr>
<tr>
<td>ng-model-options</td>
<td>Configures ng-model behavior. In this template, ng-model updates the model after a user has stopped typing for 250 milliseconds.</td>
</tr>
<tr>
<td>ng-change</td>
<td>Executes <code>c.server.update()</code> after the model value changes. This function posts the data object to the server script. After the script is executed, the data object is automatically updated with the new values from the server generated data object.</td>
</tr>
<tr>
<td>ng-repeat</td>
<td>Creates a template from the parent element and child elements. For each <code>item in c.data.items</code>, an instance of the template is created and the expressions <code>{{item.name}}</code> and <code>{{item.price}}</code> are replaced with the values from each item.</td>
</tr>
</tbody>
</table>

5. Add the following script to the **CSS - SCSS** field:

```css
.result-container {
  margin-top: 10px;
}
```

6. Refresh your test page preview to view the changes.

As you type in the search box, matching catalog items appear. Try searching for **iPad**.
Manage the empty state of a widget

Display a list of popular items to the user before any search terms are entered.

Before you begin
Role required: admin or sp_admin

About this task
Because no search has been executed when the widget initializes, the server input variable is undefined. This empty state may cause confusion when a user first interacts with the widget. To solve this issue, give your widget something to display when the input variable is empty. This initial data can guide your users when initially interacting with your widget.

Procedure
1. From the **Widget Editor**, open the Quick Order widget.
2. Replace the existing server script with the following script:

```javascript
(function() {
    if (input.keywords != null && input.keywords != '')
        data.items = getCatalogItems(input.keywords);
    else data.items = getPopularItems();

    function getCatalogItems(keywords) {
        var sc = new GlideRecord('sc_cat_item');
        sc.addActiveQuery();
        sc.addQuery('123TEXTQUERY321', keywords);
        sc.addQuery('sys_class_name', 'NOT IN', 'sc_cat_item_wizard,sc_cat_item_content');
        sc.addQuery('sc_catalogs', 'e0d08b13c3330100c8b837659bba8fb4');
        sc.setLimit(100);
        sc.orderByDesc('ir_query_score');
        sc.query();
        var results = [];
        while (sc.next()) {
            if (!$sp.canReadRecord(sc))
                continue;

            var item = {};
            $sp.getRecordDisplayValues(item, sc, 'name,price,sys_id');
            item.category = sc.getValue('category');
            results.push(item);
        }
        return results;
    }

    function getPopularItems() {
```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
function getPopularItems() {
    var items = [];
    var count = new GlideAggregate('sc_req_item');
    count.addAggregate('COUNT', 'cat_item');
    count.groupBy('cat_item');
    count.addQuery('cat_item.sys_class_name', 'NOT IN',
                   'sc_cat_item_guide,sc_cat_item_wizard,sc_cat_item_content');
    count.addQuery('cat_item.sc_catalogs', 'e0d08b13c3330100c8b837659bba8fb4');
    count.orderByAggregate('COUNT', 'cat_item');
    count.query();
    while (count.next() && items.length < 9) {
        if (!$sp.canReadRecord("sc_cat_item", count.cat_item.sys_id.getDisplayValue()))
            continue; // user does not have permission to see this item
        var item = {};
        item.name = count.cat_item.name.getDisplayValue();
        item.category = count.cat_item.category.toString();
        item.price = count.cat_item.price.getDisplayValue();
        item.sys_id = count.cat_item.sys_id.getDisplayValue();
        items.push(item);
    }
    return items;
}(i);

This script introduces a new function `getPopularItems()` to query the database and return popular items when the `input` variable is empty.

3. Replace the HTML template with the following script:

```html
<div class="panel panel-primary">
    <div class="panel-heading">Request an item from the catalog</div>
    <div class="panel-body">
        <input type="search" placeholder="Start typing here to search the list of catalog items" ng-model="c.data.keywords" ng-change="c.server.update()" ng-model-options="{debounce: 250}" />
        <h5 ng-if="!c.data.keywords">Showing the most popular items</h5>
        <ul class="list-group result-container">
            <li class="list-group-item" ng-repeat="item in c.data.items">
                <a href>{{item.name}}</a><span class="pull-right">{{item.price}}</span>
            </li>
        </ul>
    </div>
    <div class="panel-footer" ng-if="c.datakeywords">
        © 2021 ServiceNow, Inc. All rights reserved.
        ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
        Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
    </div>
</div>
```
This script provides a template to display the popular items returned from the server script.

4. Refresh your test page preview to view the changes.

The widget displays popular items to the user prior to any search input.

---

**Embed an existing widget**

Enable the user to view and purchase Service Catalog items in the Quick Order widget by embedding the SC Catalog Item widget.

**Before you begin**

Role required: admin or sp_admin

**About this task**

Instead of duplicating code, you can embed widgets to leverage pre-existing functionality. The SC Catalog Item widget is a base system widget that enables the user to view and purchase Service Catalog items.
Procedure

1. Inspect the SC Catalog Item widget.
   Before embedding the SC Catalog Item widget, inspect the widget to understand what data it needs access to. You may need to update your Quick Order widget client or server script to make sure that the correct data is passed to the embedded widget.

   a. Navigate to <yourInstanceURL>/sp_config?id=widget_editor.

   b. Open the SC Catalog Item widget.

   c. Note that the widget ID is `widget-sc-cat-item`. You will use this ID to embed the widget model in the client script.

   d. Examine the server script.

      Notice that the `data` object includes a `sys_id` property populated by either the `input` or `options` objects. If neither `input` nor `options` include a `sys_id`, the `$sp.getParameter()` method retrieves the `sys_id` from the request query string.

      To populate the `input` object, you can pass a catalog item `sys_id` from the Quick Order widget client script.

2. From the Widget Editor, open the Quick Order widget.

3. Replace the Quick Order widget client script with the following script.
function($location, spUtil) {
  var c = this;

  c.select = function(item_id) {
    if (c.openItem == item_id) {
      c.openItem = null;
      return;
    }

    renderCatalogItemWidget(item_id);
  }

  function renderCatalogItemWidget(item_id) {
    c.catalogItemWidget = null;
    spUtil.get("widget-sc-cat-item", {sys_id: item_id}).then(function(response){
      c.catalogItemWidget = response;
      c.openItem = item_id;
    });
  }
}

This script uses `spUtil.get()` to retrieve the widget model by ID (widget-sc-cat-item) and define the {sys_id: item_id} object. This object posts to the server script as input.

4. Replace the HTML template with the following script:

```html
<div class="panel panel-primary">
  <div class="panel-heading">Request an item from the catalog</div>
  <div class="panel-body">
    <input class="form-control" type="search" placeholder="Start typing here to search the list of catalog items" ng-model="c.data.keywords" ng-change="c.server.update()" ng-model-options="{debounce: 250}" />
    <h5 ng-if="!c.data.keywords">Showing the most popular items</h5>
    <ul class="list-group result-container">
      <li class="list-group-item" ng-repeat="item in c.data.items">
        <a href ng-click="c.select(item.sys_id)">{{item.name}}</a><span class="pull-right">{{item.price}}</span>
        <div class="catalog-item" ng-if="item.sys_id == c.openItem">
          <sp-widget ng-if="c.catalogItemWidget" widget="c.catalogItemWidget" />
        </div>
      </li>
    </ul>
  </div>
  <div class="panel-footer" ng-if="c.data.keywords">
    © 2021 ServiceNow, Inc. All rights reserved.
    ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
    Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
  </div>
</div>
```
This template:

- Adds on-click behavior using the ng-click directive.
- Displays the embedded SC Catalog Item widget using the sp-widget directive.

5. Replace the CSS with the following script:

```css
.result-container {
    margin-top: 10px;
}

.catalog-item {
    background-color: #f5f5f5;
    padding: 10px;
    @include border-top-radius($panel-border-radius);
    @include border-bottom-radius($panel-border-radius);
}
```

6. Refresh your test page preview to view the changes.
When you select a search result, the item opens in the embedded SC Catalog Item widget.

![Image of SC Catalog Item widget]

Create a reusable directive and add it to a widget

Angular Providers are reusable components that can be added to multiple widgets. Using the Widget Angular Providers table, create a directive that shows a category icon next to each result in the Quick Order widget.

Before you begin
Role required: admin or sp_admin

About this task
Angular Providers let you build angular directives and services that can be injected into your client script controller. The code in a Provider differs from a typical Angular directive or service because it must be anonymous, without being appended to a specific module.

Procedure
1. Navigate to **Service Portal > Service Portal Configuration > Portal Tables > Widget Angular Provider**.
   The Widget Angular Providers table opens.
2. Click **New** to create a new record.
3. Fill out the form.

a. Add the type and name.
   - **Type**: Directive
   - **Name**: categoryIcon

b. Add the client script.

```javascript
function() {
  return {
    template: '<span class="fa fa-stack fa-lg"><i class="fa fa-circle fa-stack-2x"></i><i class="fa fa-{{::icon}} fa-stack-1x fa-inverse"></i></span>',
    restrict: 'E',
    replace: true,
    scope: {
      category: '='
    },
    link: function(scope, element) {
      var _iconMap = {
        "b06546f23731300054b6a3549db8d8": "tablet", /* Tablets */
        "15706fc0a0a7007fc21e1e70c2f": "question", /* Can we help you? */
        "d6ebf4d637b130054b6a3549d6db2": "mobile-phone", /* Mobiles */
        "109cdff8c612276003b1799a09ad65": "print", /* Office and Print */
        "6d64c6a3771300054b6a3549d6db0": "print", /* Printers */
        "2c0b59874f7b4200086eed18110c71f": "plug", /* Peripherals */
        "2809952237b1300054b6a3549d6d4": "desktop" /* Software */
      };
      scope.icon = _iconMap[scope.category] || "shopping-cart";
    }
  }
}
```

This script associates the sys_id of the Category record with the Service Catalog item. The icon that displays is the icon defined in the Category record in the Service Catalog.
c. Click Save.

4. Associate the new Angular directive with the Quick Order Widget.

a. Navigate to `<yourInstanceURL>/sp_config?id=widget_editor`.

b. Open the Quick Order widget.

c. Under Related Lists, select Angular Providers.

d. In the Angular Providers list, click New to associate an existing Angular Provider with the Quick Order widget.

e. Add the following values to the form.

• **Angular Provider**: categoryIcon

• **Widget**: Quick Order

f. Click Save.
5. Add the `categoryIcon` directive to your Quick Order HTML template.

   a. From the **Widget Editor**, open the Quick Order widget.

   b. Replace the HTML template with the following script.

   ```html
   <div class="panel panel-primary">
       <div class="panel-heading">Request an item from the catalog</div>
       <div class="panel-body">
           <input class="form-control" type="search" placeholder="Start typing here to search the list of catalog items" ng-model="c.data.keywords" ng-change="c.server.update()"
                  ng-model-options="{debounce: 250}" />
           <h5 ng-if="!c.data.keywords">Showing the most popular items</h5>
           <ul class="list-group result-container">
               <li class="list-group-item" ng-repeat="item in c.data.items">
                   <a href ng-click="c.select(item.sys_id)"
                      category="item.category" style="margin-right: 10px"></a>{{item.name}}<span class="pull-right">{{item.price}}</span>
                   <div class="catalog-item ng-if="item.sys_id == c.openItem">
                       <sp-widget ng-if="c.catalogItemWidget" widget="c.catalogItemWidget" />
                   </div>
               </li>
           </ul>
       </div>
       <div class="panel-footer ng-if="c.data.keywords">
           <ng-pluralize count="c.data.items.length"
                         when="{'0': 'No items found for ',
                         '1': 'One item matching ',
                         'other': 'Found () items matching '}">
               {{c.data.keywords}}
           </ng-pluralize>
       </div>
   </div>
   
6. Refresh your test page preview to view the changes.
A category icon displays beside each result.

Widget API reference
Service Portal includes client and server side APIs to use in widget client and server scripts.

**Service Portal client-side APIs**
These are Service Portal APIs that you can use in a widget client controller.
See the API reference for detailed class and method information.

<table>
<thead>
<tr>
<th>Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>spAriaUtil</td>
<td>Show messages on a screen reader.</td>
</tr>
<tr>
<td>spContextManager</td>
<td>Make data from a Service Portal widget available to other applications and services in a Service Portal page. For example, pass widget data to Agent Chat when it opens in a Service Portal page.</td>
</tr>
<tr>
<td>spUtil</td>
<td>Utility methods to perform common functions in a Service Portal widget client script.</td>
</tr>
<tr>
<td>spModal</td>
<td>Show alerts, prompts, and confirmation dialogs in Service Portal widgets. The SPModal class is available in Service Portal client scripts.</td>
</tr>
</tbody>
</table>
Note: g_form as a global object cannot be used in a widget client controller or in a UI script.

Service Portal server-side APIs
These are Service Portal APIs that you can use in a widget server script.

<table>
<thead>
<tr>
<th>Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GlideSPScriptable</td>
<td>Interact with data and perform record operations in Service Portal widgets.</td>
</tr>
<tr>
<td>GlideSPSearchAnalytics</td>
<td>Generates search analytics from custom ServiceNow search widgets.</td>
</tr>
<tr>
<td>spScriptedFacet</td>
<td>Define facet items, filters, or mapped queries for a facets object.</td>
</tr>
<tr>
<td>spScriptedFacetService</td>
<td>Generate a multi choice or single choice facets object for an advanced search source.</td>
</tr>
</tbody>
</table>

Widget properties
Global variable and functions available in widget client and server scripts.

Server script global objects

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>input</td>
<td>An object containing client-side properties set under c.data. The value is undefined until the client controller calls c.server.update().</td>
</tr>
<tr>
<td>data</td>
<td>An object containing properties set during server-side execution.</td>
</tr>
<tr>
<td>options</td>
<td>An object containing the schema option properties.</td>
</tr>
</tbody>
</table>
Client script global functions

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>this.server.get([Object])</code></td>
<td>Calls the server and sends custom input. Returns Promise.</td>
</tr>
<tr>
<td><code>this.server.update()</code></td>
<td>Calls the server and posts <code>this.data</code> to the server script. Returns Promise.</td>
</tr>
<tr>
<td><code>this.server.refresh()</code></td>
<td>Calls the server and automatically replaces the current options and data from the server response. Returns Promise.</td>
</tr>
</tbody>
</table>

A promise represents the eventual result of an asynchronous operation. For more information on promises, see [https://promisesaplus.com/](https://promisesaplus.com/) or AngularJS documentation.

Widget troubleshooting guide

Use the following tools to investigate and resolve unexpected behavior in your custom Service Portal widgets.

Provides debugging tips for troubleshooting Service Portal configuration issues.

**Reduce complexity**

Deactivate widgets unrelated to the widget you are troubleshooting to isolate parts of the page that may be causing errors or unexpected behavior. Set the active field to false on a widget record to hide the widget on the page, and prevent associated scripts from executing.

**Use the browser developer console**

All supported desktop browsers have built in developer tools. Access your browsers developer tools to view console messages and errors thrown by client-side javascript. Many of the logging tools detailed below output information to this console.

**Use the widget context menu to access information and options**

CTRL+right-click a widget to access configuration options for the widget. There are also options to output the scope and scope data object to the browser console. For more detail on this menu, see Widget context menu.

**Use script methods to capture debugging output**
Several methods are available to output debugging information within your server and client-side code.

### Scripted debugging methods

<table>
<thead>
<tr>
<th>Method</th>
<th>Availability</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>console.log()</td>
<td>Server and client</td>
<td>Logs output to the browser developer console.</td>
</tr>
<tr>
<td>$sp.log()</td>
<td>Server</td>
<td>Logs output to the Service Portal Log Entries [sp_log] table, when the logged in user has the sp_admin or admin role.</td>
</tr>
<tr>
<td>gs.log()</td>
<td>Server</td>
<td>Logs output to the Log [syslog] table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> gs.log creates records on the syslog table. Excessive use can adversely affect performance.</td>
</tr>
<tr>
<td>gs.warn()</td>
<td>Server</td>
<td>Produces warning level output in the Log [syslog] table.</td>
</tr>
<tr>
<td>gs.error()</td>
<td>Server</td>
<td>Produces error level output in the Log [syslog] table.</td>
</tr>
<tr>
<td>gs.addInfoMessage()</td>
<td>Server</td>
<td>Displays a green information message at the top of the browser window.</td>
</tr>
<tr>
<td>gs.addErrorMessage()</td>
<td>Server</td>
<td>Displays a red error message at the top of the browser window.</td>
</tr>
<tr>
<td>spUtil.addErrorMessage()</td>
<td>Client</td>
<td>Displays an error message within the browser window.</td>
</tr>
<tr>
<td>spUtil.addInfoMessage()</td>
<td>Client</td>
<td>Displays an Info message within the browser window.</td>
</tr>
<tr>
<td>spUtil.addTrivialMessage()</td>
<td>Client</td>
<td>Displays a message which automatically disappears after a short time.</td>
</tr>
</tbody>
</table>
Scripted debugging methods (continued)

<table>
<thead>
<tr>
<th>Method</th>
<th>Availability</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>debugger</td>
<td>Client</td>
<td>Sets a break point in Chrome and Firefox browsers, allowing you to step through a script line by line in the browsers developer console.</td>
</tr>
<tr>
<td>{{data</td>
<td>json}}</td>
<td>HTML</td>
</tr>
</tbody>
</table>

Check for security restrictions

Often, widget display issues are caused by access rules rather than the widget script. Verify that any records that are not accessible within a widget are accessible using the platform UI. Use the ACL debugger to ensure that your users have the expected access to records used by your widgets. For more detail on the debugger, see ACL debugging tools.

Create a reference to the widgets scope in the console

Use reference to a widget to manipulate scope data or manually run the widgets client and server scripts. Use the following steps to create the reference.

- 1. Right-click the widget and choose **Inspect**.
- 2. In dev tools Elements tab, click to highlight the element with attribute `widget=widget`. You can find it a few elements above the currently inspected element. This element points the $0 scripting tool at the widget.
- 3. In the Javascript console, run the following code:

```javascript
var scopeRef = angular.element($0).scope();
```

Use the reference to your widget to change data within the console. See the following example. Remember to run **AngularJS $apply()** on the scope to apply changes to the page.

```javascript
scopeRef.data.prop1 = "Pear";
scopeRef.$apply();
```
Run any function defined in the widgets client controller from your reference using the syntax below.

```javascript
scopeRef.exampleFunction();
```

Use the refresh command to manually execute the widgets server script.

```javascript
scopeRef.server.refresh();
```

**Widget diagnostics**

Resolve Service Portal page issues by identifying widget customization levels and checking widget code directly from a portal page.

If a portal page isn't working as expected, it may be because of a bug in widget code. To diagnose the page, try diagnosing the widgets on the page.

Diagnosing widgets involves:

- Identifying widget customization levels
- Checking the code that is used in each widget

**Identifying customization levels**

Customization levels describe how widgets have been modified or developed. Identifying the customization level of a widget can help you know which part of the widget code is most important to check. There are four levels of widget customization.

<table>
<thead>
<tr>
<th>Customization level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base system</td>
<td>Base system widget with no modifications, including widgets for which you have set instance options.</td>
</tr>
<tr>
<td>Cloned</td>
<td>Widget that you cloned from a base system widget.</td>
</tr>
<tr>
<td>New</td>
<td>Widget that you created.</td>
</tr>
</tbody>
</table>
| Customized          | Base system widget that you configured in any of the following ways:  
  • Modified the widget code directly  
  • Modified widget option schema  
  • Modified widget dependencies, ng-templates, or Angular Providers |
To identify the customization levels of widgets on a portal page, open the widget context menu and select **Show Widget Customizations**. Widgets are color-coded as follows:

- **Green** – base system widget
- **Yellow** – cloned widget
- **Blue** – new widget
- **Red** – customized widget

### Checking the widget code

After you've identified the customization levels of widgets on a portal page, check the code in each widget.

To view the widget code from the portal page, click the information icon (ℹ️) on a widget.
From the widget diagnostics window, you can check the widget code in several ways:

- **View a widget record from a portal page**
  View and identify potentially problematic code in the widget record without navigating away from the portal page.

- **View related records**
  View and identify potentially problematic code in the widget dependencies, Angular Providers, and ng-templates that are being used by the widget.

- **Compare changes to related records**
  Compare an Angular Provider or ng-template against its previous version so that you check if your most recent code changes are causing issues on a portal page.

- **Compare changes to a customized widget**
  Compare your most recent update of a customized widget against the previous version to check if your recent changes are causing issues on a portal page.
• Compare a customized widget against the base system

Identify customizations to a base system widget so that you can revert your customized widgets and resolve issues on a portal page.

Recommendations for diagnosing widgets

Of the four customization levels, the highest priority issue is customized widgets. These widgets aren’t supported in system upgrades. If you’re experiencing page issues during an upgrade, it may be because you have a customized widget on your portal page.

To resolve page issues that may be caused by customized widgets, identify which parts of the widget code have been customized. Then revert the code to the original configuration. For more information on identifying these code differences, see Compare a customized widget against the base system.

Tip: Even if a customized widget is not causing page issues now, you may want to revert to the original widget to prevent issues during upgrades later.

If you’re still experiencing page issues after reverting customized widgets, check your new and cloned widgets next.

With a new widget, it’s likely that your most recent code changes are causing issues on your portal page. To identify your most recent changes so that you can debug your code, follow the steps in Compare changes to related records.

If you cloned a widget prior to a system upgrade, it’s likely that the cloned widget didn’t receive the same updated code as the base system widget. In this case, it’s recommended that you clone the widget again and add your customizations to the clone.

A base system widget is least likely to cause page issues. If you’ve already checked other widgets and are still experiencing page issues, remove base system widgets from the page and add them again without any widget options set. You can also try adding base system widgets to another page instead.

Limitations

There are several known limitations using widget diagnostics from a portal page:

• Although you can view and compare widget code, you can’t fix or revert code directly. Navigate away from the portal to change the code.

• If you navigate to another portal page while using widget diagnostics, the system disables the tool.

• Because the tool uses color to categorize widgets, it may not be accessible for visually impaired users.
• The widget dependencies that are listed on the portal page reflect only the first-level dependencies. Any dependency that is nested deeper than the first level is not included. To further troubleshoot the widget, check the nested dependencies in the widget record.

• There is no way for the system to track a Widget Dependency after you’ve deleted it.

View a widget record from a portal page

View and identify potentially problematic code in the widget record without navigating away from the portal page.

Before you begin
Role required: admin or sp_admin

Procedure

1. Navigate to a portal page.

2. On the page, open the widget context menu by CTRL+right-clicking any widget.

3. On the widget context menu, click Show Widget Customizations.

   Widgets are color-coded as follows:

<table>
<thead>
<tr>
<th>Color</th>
<th>Customization level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Base system widget</td>
</tr>
<tr>
<td>Yellow</td>
<td>Cloned widget</td>
</tr>
<tr>
<td>Blue</td>
<td>New widget</td>
</tr>
<tr>
<td>Red</td>
<td>Customized widget</td>
</tr>
</tbody>
</table>

4. On any widget, click the information icon (i).

5. On the window, click Open widget in platform.
Note: The Open widget in platform button doesn’t appear for all customized widgets. The button appears for customized widgets only if you modified one or more widget dependencies, Angular Providers, or ng-templates.

Results
A new window opens with a read-only view of the widget record.

View related records
View and identify potentially problematic code in the widget dependencies, Angular Providers, and ng-templates that are being used by the widget.

Before you begin
Role required: admin or sp_admin

About this task
Your widget may be using potentially problematic code from any of the following records:

• Widget Dependencies
• Angular Providers
• Angular ng-templates
You can view these related records directly from your portal page to check the code in each record.

**Procedure**

1. Navigate to a portal page.
2. On the page, open the widget context menu by CTRL+right-clicking any widget.
3. On the widget context menu, click **Show Widget Customizations**.

   Widgets are color-coded as follows:

<table>
<thead>
<tr>
<th>Color</th>
<th>Customization level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Base system widget</td>
</tr>
<tr>
<td>Yellow</td>
<td>Cloned widget</td>
</tr>
<tr>
<td>Blue</td>
<td>New widget</td>
</tr>
<tr>
<td>Red</td>
<td>Customized widget</td>
</tr>
</tbody>
</table>

4. On any widget, click the information icon (ℹ).
5. On the window, open links to the following related records:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dependencies</td>
<td>JavaScript and CSS files that the widget uses from the Widget Dependencies [sp_dependency] table.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Note:" /> The widget dependencies listed on this window only reflect the first-level dependencies. Any dependency that is nested deeper than the first level is not included. To further troubleshoot the widget, check the nested dependencies in the widget record.</td>
</tr>
<tr>
<td>Angular Providers</td>
<td>Angular Providers that the widget uses from the Widget Angular Providers [sp_angular_provider] table.</td>
</tr>
<tr>
<td>Angular templates</td>
<td>Angular ng-templates that the widget uses from the Angular ng-templates [sp_ng_template] table.</td>
</tr>
</tbody>
</table>

Related records that you modified or developed are outlined in red.
You can open each related record by clicking the record name.

What to do next
If you're still unable to diagnose the widget, consider checking nested dependencies or URL dependencies.

Compare changes to related records
Compare an Angular Provider or ng-template against its previous version so that you check if your most recent code changes are causing issues on a portal page.

Before you begin
Role required: admin or sp_admin

About this task
Your widget may be using potentially problematic code from any of the following records:

- Widget Dependencies
- Angular Providers
- Angular templates
You can compare versions for these related records directly from your portal page to check code changes for each related record.

ℹ️ **Note:** There's no option to compare versions for Widget Dependency records. Also, there's no option to compare versions for related records that you created. You can only compare versions of a base system record that you modified.

**Procedure**

1. Navigate to a portal page.
2. On the page, open the widget context menu by CTRL+right-clicking any widget.
3. On the widget context menu, click **Show Widget Customizations**.

Widgets are color-coded as follows:

<table>
<thead>
<tr>
<th>Color</th>
<th>Customization level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Base system widget</td>
</tr>
<tr>
<td>Yellow</td>
<td>Cloned widget</td>
</tr>
<tr>
<td>Blue</td>
<td>New widget</td>
</tr>
<tr>
<td>Red</td>
<td>Customized widget</td>
</tr>
</tbody>
</table>

4. On a widget, click the information icon (ℹ️).

Related records that you modified or developed are outlined in red.
5. Next to a Angular Provider or ng-template record, click **Compare**.

The system displays the records of the current and previous versions side by side.

Although both sides are labeled **Version**, the left-side record represents the previous version and the right-side record represents the current version.

6. For each field in which it appears, click the window icon ( görmek ) to open the code comparator.
Your most recent changes to the widget code are highlighted in the code comparator.

Compare changes to a customized widget

Compare your most recent update of a customized widget against the previous version to check if your recent changes are causing issues on a portal page.

Before you begin
Role required: admin or sp_admin

About this task
The option to compare versions is available only for customized widgets that you modified directly. There’s no option to compare versions of a customized widget for which you modified only the widget dependencies, Angular Providers, or ng-templates.

There’s no option to compare versions for new, cloned, or base system widgets.

Procedure
1. Navigate to a portal page.
2. On the page, open the widget context menu by CTRL+right-clicking any widget.
3. On the widget context menu, click Show Widget Customizations.
Customized widgets are outlined in red.

4. On a customized widget, click the information icon (i).

5. On the window, click **Compare with previous version**.

The system displays the widget records of the current and previous widget versions side by side.

<table>
<thead>
<tr>
<th>Action</th>
<th>INSERT_OR_UPDATE</th>
<th>INSERT_OR_UPDATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Other Applications</td>
<td>Other Applications</td>
</tr>
<tr>
<td>Client controller</td>
<td>function ($scope, spUtil, snRecordWatcher, $rootScope) { var c = this; }</td>
<td>function ($scope, spUtil, snRecordWatcher, $rootScope) { var c = this; }</td>
</tr>
<tr>
<td>controllerAs</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CSS</td>
<td>.bs-callout { margin: 10px 0 !important; padding: 20px !important; }</td>
<td>.bs-callout { margin: 10px 0 !important; padding: 20px !important; }</td>
</tr>
<tr>
<td>Data table</td>
<td>Instance [sp_instance]</td>
<td>Instance [sp_instance]</td>
</tr>
<tr>
<td>Demo data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Docs</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Has preview</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID</td>
<td>current-status</td>
<td>current-status</td>
</tr>
<tr>
<td>Internal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Link</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Although both widget records are labeled **Version**, the left-side record represents the previous version and the right-side record represents the current version.

6. For each field in which it appears, click the window icon (opens in a new tab) to open the code comparator.
Your most recent changes to the widget code are highlighted in the code comparator.

**Compare a customized widget against the base system**

Identify customizations to a base system widget so that you can revert your customized widgets and resolve issues on a portal page.

**Before you begin**

Role required: admin or sp_admin

**About this task**

The option to compare a widget against the base system version is available only for customized widgets. There’s no option to compare a cloned widget against the widget that you cloned it from.

**Procedure**

1. Navigate to a portal page.
2. On the page, open the widget context menu by CTRL+right-clicking any widget.
3. On the widget context menu, click **Show Widget Customizations**. Customized widgets are outlined in red.
4. On any customized widget, click the information icon (i).
5. On the window, click **Compare with Base system widget**.

The system displays the widget records of the base system and customized widgets side by side.

![Compare two versions](image)

Although both widget records are labeled **Version**, the left-side record represents the base system widget and the right-side record represents the customized widget.

6. For each field in which it appears, click the window icon (تحكم) to open the code comparator.
Differences between the code of current and previous widget versions are highlighted.

Service Portal search

Service Portal displays search data within a widget on the search page. To make data searchable from Service Portal, create a search source that fetches data from a single table within your ServiceNow instance, from multiple ServiceNow tables, or from an external site. Configure search options or build custom search components.

Search sources

A search source is a record that describes the behavior and source of searchable data. A search source defines:

- Where to retrieve search data from.
- Whether search suggestions can populate the search field based on user input.
- How a search entry displays in the search result page.

Search sources have simple and advanced configurations.

Simple
Define a table within your ServiceNow instance as a source of searchable data. To learn more, see Define a search source.

**Advanced**

Define a data fetch script to return data. A data fetch script executes on the server and returns a result array to the search widget. This method is more complex, but offers complete power over how a search executes. You are not limited to querying single tables within ServiceNow and can define a script that fetches data from multiple tables, or from anywhere on the web. To learn more, review the Tutorial: set up an external knowledge base search source.

**Note:** Search facets may not behave as expected if integrated into an advanced search source that queries data from a non-ServiceNow site.

**Text index groups**

A text index group defines how users see search results. For example, combine search results from several sources, or set the weight of certain fields. Text index groups are a Now Platform feature. To learn more, see Configure multiple tables for indexing and searching.

Associate a portal with a text index group to create common search rules and to combine search results from all search sources in the group. If you have a custom search source or portal, consider whether you want to use the base system **portal_index_group** text index group, or create your own text index group. The base system text index group includes the Catalog items and Knowledge tables. When a user searches for an item in Service Portal, they see combined results from these tables. To add an index group to a portal, see Add a text index group to a portal.

**Note:** Text index groups do not support external search sources.

**Typeahead settings**

Typeahead returns search results as a user types in the search field. You can configure typeahead settings, or disable the feature entirely, within the search source record.

**Simple**

Define an icon to display beside typeahead results and the target page to display typeahead selections.

**Advanced**
Define a template for the typeahead result. See Create an advanced typeahead template.

**Search facets**
Enable your end users to filter search results for a more meaningful result set. Facets can return results based on:

- Fields in a table such as **Active** or **Author**.
- Query conditions such as `[Updated][After][Last week]`.

**Note:** Only set search facets for indexed fields. Fields that are not indexed may take longer to return results and are not optimized for a fast search experience. Learn more: Enable text indexing for a table.

Search facets render in the Faceted Search widget on the sp_search page. In new instances, search facets are enabled by default. If upgrading from a previous release, enable search facets by activating a record in the Page Route Maps [sp_page_route_map] table. See Enable search facets.

**Simple**
Enable end users to refine search results for a simple search source. You can create facets for a table search source that return results based on field values or query conditions. See Add facets to a simple search source.

**Advanced**
Define facets for advanced search sources using the **Facet generation script** on the search source record. Use facet APIs to create facets and assign ServiceNow facet items or mapped queries to the facet.

<table>
<thead>
<tr>
<th>API</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPScriptedFacetService - Scoped</td>
<td>Creates a single or multi choice facet.</td>
</tr>
<tr>
<td>SPScriptedFacet - Scoped</td>
<td>Defines facet items, filters, or mapped queries for the facet.</td>
</tr>
</tbody>
</table>

**Search analytics and suggestions**
Generate relevant search suggestions for your users and monitor search analytics to understand what your users are searching for and whether they're
finding what they need. Search Suggestions is a Now Platform feature. For more information, see Search Suggestions.

**Populate suggestion data on upgrade**

If you are upgrading from a previous release, run a script to populate search suggestions with data from a platform search table to provide search suggestions to your users. For more information, see Populate search suggestions in Service Portal.

**Generate suggestions from custom widgets**

By default, the Search Events [sys_search_event] and Search Source Events [sys_search_source_event] tables collect search data from base system search widgets. To generate search analytics from custom Service Portal search widgets, use the GlideSPSearchAnalytics API. For more information, see GlideSPSearchAnalytics.

**Use suggestions instead of typeahead search**

Search suggestions replaces typeahead search in Service Portal. Update the `glide.service_portal.search_as_you_type_behavior` system property to change this behavior. For more information, see Enable and disable search suggestions. Service Portal search widgets automatically use whichever feature you enable.

**Search configurations**

When you create a simple search source, Service Portal uses the search engine settings configured on your instance. To learn more, see Zing text indexing and search engine.

**Performance recommendations**

To avoid performance degradation and to ensure a fast search experience for end users, follow these recommendations.

- Limit search sources when possible to perform only the necessary query. For example, if a search only needs to return active incidents, add a condition to the search source set to `[Active] [is] [true]`. A search that queries only active incidents is faster than a search that queries all records in the incident table.

- Create facet items and mapped queries with no more than 30 filter items. To verify, test each search source with a variety of keywords as a user with low permissions.

**Note:** Service Portal search results display as text only. HTML tags, images, and formatting do not display in search results.
Define a search source

Configure a basic search source to query data from an instance table, or configure an advanced data fetch script to query data across multiple tables and data sources, or to pull data from anywhere on the web.

Procedure

1. In the platform UI, navigate to Service Portal > Portals and select the portal you want to add search sources to.
2. From the Search Sources related list, click New to add a search source.
3. Define the fields on the Search Source form.

Search Source form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The display value for the search category.</td>
</tr>
<tr>
<td>ID</td>
<td>The record ID. The value should be unique, and should not include any spaces or special characters.</td>
</tr>
<tr>
<td>Application</td>
<td>The scope of the search source.</td>
</tr>
<tr>
<td>Roles</td>
<td>If the Service Portal User Criteria Support plugin is not enabled, define user roles to access this search source.</td>
</tr>
<tr>
<td>Search page template</td>
<td>The HTML template that displays the search results. If defining a basic search source, you do not need to change the default template. For an example of a modified template, see Tutorial: set up an external knowledge base search source.</td>
</tr>
</tbody>
</table>

4. Complete the fields on the Data Source tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is scripted source</td>
<td>Adds an advanced data fetch script. If configuring an instance table as the data source, do not check this option.</td>
</tr>
<tr>
<td>Data fetch script</td>
<td>Script defining the endpoint and API calls to fetch data. This field is only visible when Is scripted source is selected. For an example of a data fetch script, see Tutorial: set up an external knowledge base search source.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td><strong>Note:</strong> If defining a facet generation script, inject the facets object into the data fetch script and update the script to generate data for each facet item. For an example, see the Knowledge Base and Service Catalog search sources. Search facets may not behave as expected if integrated into an advanced search source that queries data from a non-ServiceNow site.</td>
<td></td>
</tr>
<tr>
<td>Facet generation</td>
<td>Script defining search facets for a scripted search source. Enable your end users to filter search results for a more meaningful result set. This field is only visible when is scripted source is selected.</td>
</tr>
<tr>
<td>script</td>
<td><strong>Note:</strong> If defining a facet generation script, inject the facets object into the data fetch script and update the script to generate data for each facet item. For an example, see the Knowledge Base and Service Catalog search sources. Search facets may not behave as expected if integrated into an advanced search source that queries data from a non-ServiceNow site.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table from the list that you want to draw your results from. You can select any table in the platform. For example, User [sys_user] or Knowledge [kb_knowledge].</td>
</tr>
<tr>
<td><strong>Note:</strong> Only indexed tables return search results. Learn more: Enable text indexing for a table.</td>
<td></td>
</tr>
<tr>
<td>Conditions</td>
<td>Filters results based on defined conditions. For example, Active is True.</td>
</tr>
<tr>
<td>Primary display field</td>
<td>Select which field you want to display on the search results page. For example, Name.</td>
</tr>
<tr>
<td>Display fields</td>
<td>Select additional fields to display on the search results page. For example, User ID, Email, and City.</td>
</tr>
<tr>
<td>Paginate results</td>
<td>Paginates search results. True by default. If is scripted source is selected, the value updates to false. To enable pagination for a scripted search source, see Paginate search source results.</td>
</tr>
</tbody>
</table>
5. Configure **Typeahead** settings to allow search results to populate the search field based on user input.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable typeahead</td>
<td>Allows typeahead functionality. If you do not want to integrate typeahead into your search source, clear the check box.</td>
</tr>
<tr>
<td>Advanced typeahead config</td>
<td>Optionally add an advanced typeahead script to configure the way search results display. For more information, see <a href="#">Create an advanced typeahead template</a>.</td>
</tr>
<tr>
<td>Typeahead glyph</td>
<td>Adds an icon beside each typeahead result.</td>
</tr>
<tr>
<td>Page</td>
<td>Defines a service portal page to display the selected result. For example, if <strong>form</strong> is configured, a selected typeahead result opens in a form.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

**What to do next**
To enable end users to refine search results, **Add facets to a simple search source**.

**Paginate search source results**
Limit the number of results that a search source displays at one time to improve performance. End users can load more results as needed.

**Before you begin**
Role required: admin or sp_admin
About this task
If adding pagination to a simple search source, set Paginate results on the search source record to true. However, if adding pagination to an advanced search source, you must also modify the data fetch script to handle multiple pages of results. When a user loads more search results, the search source re-executes the data fetch script.

**Note:** If paginating a search source with advanced facets, do not modify the facet generation script to load facets based on the results from each page. Facets should enable end users to filter results from an entire result set, rather than page-specific results.

Procedure
1. In the platform UI, navigate to Service Portal > Search Sources.
2. Open a search source to add pagination to.
3. Set Paginate results to true.
   Enabling this field adds a Load more results button to the search results page. This flag automatically enables pagination for simple search sources.
4. Optional: If the search source is advanced, modify the data fetch script to handle multiple search result pages.
   Update the data fetch script using one of the following GlideRecord APIs, depending on the scope of the search source.

<table>
<thead>
<tr>
<th>Scope</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
<td>setLocation() in GlideRecord - Global</td>
</tr>
<tr>
<td>Scoped application</td>
<td>chooseWindow() in GlideRecord - Scoped</td>
</tr>
</tbody>
</table>

The following is an example data fetch script for a global search source that queries the incident table and paginates results.

```javascript
// queryLocation is a special value injected into the script, // which holds the query_location property of the last item // in the previously fetched result set (function(query, queryLocation, count) {
var results = []; var now_GR = new GlideRecord("incident");
gr.addQuery("123TEXTQUERY321", query);
gr.query();
// Here, we are utilizing queryLocation to implement pagination. // In practice, there are many other ways to use the
```
// query_location value of the last item in the previous
// result set to implement pagination. Your implementation
// will vary by use case.
gr.setLocation(queryLocation - 1);

var resultCount = 0;
while(gr.next() && resultCount < count + 1) {
  results.push({
    label: gr.getDisplayValue(),
    short_description: gr.getValue("short_description"),
    // Here, we are populating the query_location
    // property of each result item. This is how the
    // framework knows what value to pass into the
    // next fetched search result script execution
    query_location: gr.getLocation(),
    primary: gr.getDisplayValue(),
    state: gr.getDisplayValue("state")
  });
  resultCount++;
}

if (results.length == 0)
  return results;

if(results.length > count) {
  results.pop();
} else {
  // In order to indicate that a result in the result
  // set is the final result (that there are
  // no more results to be fetched), add this property
  // to the final element in your result set.
  results[results.length - 1].isLastResult = true;
}
return results;
}) (query, queryLocation, count, facets);

For an additional example, see the Knowledge Base search source.

5. Define the maximum number of results per query for the search source in the Search Page widget or Faceted Search widget instance options.

Results
The search page only returns the defined number of results at one time. When a user selects Load more results, the search source re-executes the query or data fetch script.
Create an advanced typeahead template

Configure the way typeahead results display with an advanced template.

Procedure

1. Complete the required fields in Define a search source.
2. In the Typeahead tab of the Search Source record, select the Advanced typeahead config check box.
3. In the Typeahead template field, add an HTML template.

Example

This example uses AngularJS bindings to display service catalog images in the typeahead results.

```html
<i class="ta-img" ng-if="match.model.type=='sc'"
  style="background-image:url('{{match.model.picture}}')"></i>
<i class="ta-img" ng-if="match.model.type=='sc_guide'"
  style="background-image:url('{{match.model.picture}}')"></i>
<i class="ta-icon fa fa-file-text-o" ng-if="match.model.type=='sc_content' &&
  match.model.content_type == 'kb'"></i>
```
4. Click **Update**.

Typeahead results display beside the image defined in the service catalog record.

![Typeahead results for Apple](image)

**Tutorial: set up an external knowledge base search source**

Define an advanced search source to return data from any source on the Internet. To understand the power of search sources, follow this tutorial to set up an external knowledge base search source.

**Before you begin**

To create an advanced search source, you need an external resource that you can access via REST and basic knowledge of AngularJS.

**About this task**

In this integration, you will:
• Create a data fetch script that uses the ServiceNow Table API to query a knowledge base from another ServiceNow instance.
• Decode the JSON response and define the fields that the search widget expects.
• Update the search sources HTML template to open the search result in the external site.

Procedure

1. In the platform UI, navigate to Service Portal > Portals and select the portal you want to add the search source to.
2. From the Search Sources related list, click New.
3. Create a name and ID for the search source. The ID should be unique, and should not include any spaces or special characters.
4. On the Data Source tab, select the Is scripted source check box.
5. Add content to the data fetch script field.

   a. Define the search function to be executed by the instance.

   Example

   This example uses a recordless RESTMessage, but you can modify this example to use a pre-configured if needed, or create a more secure authentication profile.

   ```javascript
   (function(query) {
   var results = [];
   /* Calculate your results here. */
   var url = "https://myInstance.service-now.com/api/now/table/kb_knowledge?sysparm_query=GO123T Exiting%3D" + encodeURI(query) + 
   "&sysparm_fields=sys_id%2Cnumber%2Cshort_description%2Ccategory%2Ctext";
   var ws = new sn_ws.RESTMessageV2();
   ws.setBasicAuth("search_user", "search");
   ws.setHttpMethod("get");
   ws.setEndpoint(url);
   
   var jsonOutput = ws.execute();
   
   return results;
   })(query);
   ```
Note: In the preceding example, `ws.setBasicAuth` requires a user and password for the remote instance. For more detail, see `RESTMessageV2 - Scoped, Global`.

b. Add an if statement to the data fetch script to decode the JSON object being returned, iterate over each result, and set expected fields.

Example

The final data fetch script:

```javascript
(function(query) {
    var results = [];
    /* Calculate your results here. */
    var url = "https://<my-instance>.service-now.com/api/now/table/kb_knowledge?sysparm_query=GOTO1 23TEXTQUERY321%3D" + encodeURI(query) + "&sysparm_fields=sys_id%2Cnumber%2Cshort_description%2Ccategory%2Ctext";
    var ws = new sn_ws.RESTMessageV2();
    ws.setBasicAuth("search_user", "search");
    ws.setHttpMethod("get");
    ws.setEndpoint(url);

    var jsonOutput = ws.execute();
    if (jsonOutput) {
        var response = new JSON().decode(jsonOutput.getBody());
        results = response.result;
        results.forEach(function(result) {
            result.url = "https://myInstance.service-now.com/kb_view.do?sysparm_article=\" + result.number;
            result.target = "_blank";
            result.primary = result.short_description;
        });
    }

    if (jsonOutput.haveError()){
        gs.addErrorMessage(jsonOutput.getErrorMessage());
    }

    return results;
})(query);
```
In this example, the following fields are set on the result object:

- **url**: If linking to an external site rather than opening the record in your ServiceNow instance, this defines where the link leads to.
- **target**: The target for the link. Set the target to _blank to open results in a new tab, otherwise leave it blank.
- **primary**: The primary field displayed in the search results.

6. Update the search page template to open the search results in the external site.

**Example**

```html
<div>
  <a href="https://myInstance.service-now.com/kb_view.do?sysparm_article={{item.number}}" target="_blank" class="h4 text-primary m-b-sm block">
    <span ng-bind-html="highlight(item.primary, data.q)"></span>
  </a>
  <span class="text-muted" ng-repeat="f in item.fields | limitTo: 4">
    <span class="m-l-xs m-r-xs" ng-if="!$first"> &middot; </span>
    {{f.label}}: <span ng-bind-html="highlight(f.display_value, data.q)"></span>
  </span>
</div>
```

7. Click **Update**.

**Results**

Test the external search in your portal. Results display under the name field value defined in step three.
Each search result opens in the external site defined in the search page template.

**Importing Address Book From CSV File**

*KB0000027*

2 views

**Outlook 2010 - Importing Address Book From CSV File**

This article explains how to import your address book from a CSV file into Outlook 2010.

2. Select the File menu.
3. Choose Open.
4. Click Import.
5. Select Import from another program or file, then Next from the Import/Export Wizard.
6. Select Comma Separated Values (Windows), then Next.
7. Choose Browse to navigate to the .csv file that you want to import, and then click Open to return to the Import a File window.
8. Select Next and choose Contacts as the destination folder, and click Next again.
9. Click Finish to import the Address Book.

Authored by Ron Kettering
Last modified 2014-12-19 07:50:01

Helpful? Yes  No
Example: set up a GitHub search source

Set up an advanced search source that queries data from an external site.

Before you begin

To create an advanced search source, you need an external resource that you can access via REST and basic knowledge of AngularJS.

Procedure

1. In the platform UI, navigate to Service Portal > Portals and select the portal you want to add search sources to.
2. From the Search Sources related list, click New.
3. Create a name and ID for the search source. The ID should be unique, and should not include any spaces or special characters.
4. On the Data Source tab, select the Is scripted source check box.
5. Add content to the data fetch script field.

Example

To set up a GitHub integration:

```
(function(query) {
    var results = [];
    /* Calculate your results here. */
    var url = "https://api.github.com/search/repositories?q=" + encodeURI(query);
    var ws = new GlideHTTPRequest(url);
    ws.setBasicAuth("YOUR_USERNAME_HERE", "YOUR_PASSWORD_HERE");
    var jsonOutput = ws.get();
    if (jsonOutput) {
        var response = new JSON().decode(jsonOutput.getBody());
        results = response.items;
        results.forEach(function(result) {
            result.url = result.svn_url;
            result.target = "_blank";
            result.primary = result.full_name;
        });
    }

    return results;
})(query);
```

6. Use the Search page template to customize the way the search results display.
Enable search facets

In new instances, search facets are enabled by default. If upgrading from a previous release, enable search facets by activating a record in the Page Route Maps [sp_page_route_map] table.

Before you begin
Role required: admin or sp_admin

About this task
Search facets render in the Faceted Search widget on the sp_search page. To enable search facets after upgrade, activate the page route map record to route your search results to render in the sp_search page.

Procedure
1. Navigate to Service Portal > Page Route Maps.
2. Locate the Search record in the list.
   This record redirects users from the search page to the sp_search page when viewing search results in Service Portal. The sp_search page includes the Faceted Search widget, which supports search facets in both desktop and mobile environments.
3. Set the Active field to true.
Results
When using search in Service Portal, results render in the sp_search page. Add facets to the search source to enable end users to filter search results. To learn more about facets, see Add facets to a simple search source.

Add facets to a simple search source
Enable end users to refine search results for a simple search source. You can create facets for a table search source that return results based on field values or query conditions.

Before you begin
Role required: admin or sp_admin
In new instances, search facets are enabled by default. If upgrading from a previous release, enable search facets by activating a record in the Page Route Maps [sp_page_route_map] table. See Enable search facets. Create facet items and mapped queries with no more than 30 filter items. To verify, test each search source with a variety of keywords as a user with low permissions.

Note: Only set search facets for indexed fields. Fields that are not indexed may take longer to return results and are not optimized for a fast search experience. Learn more: Enable text indexing for a table.

Procedure
1. Navigate to Service Portal > Search Sources.
2. Open or create a simple search source.
   Simple search sources do not use a data fetch script. Rather, they define a table as the source of searchable data. To learn more about search sources, see Service Portal search.
3. Select the Facets related list.
4. Click New.
   The Facet form displays.
5. Complete the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Display name of the facet header.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the search source. This value is read-only.</td>
</tr>
<tr>
<td>Selection type</td>
<td>Type of user selection allowed:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
|                            | • **Single**: Only one filter value can be selected at a time. For example, if a facet is created for the **Assigned to** field, the end user can select **Fred Luddy** or **Beth Anglin**, but not both at the same time. Before filtering for a new value, the user must first clear the current value.  
|                            | • **Multiple**: Multiple filter values can be selected at the same time. For example, if a facet is created for the **Assigned to** field, the end user can select both **Fred Luddy** and **Beth Anglin**. Because multiple choice results in an OR query, records assigned to either Fred Luddy or Beth Anglin display. |
| Active                     | Whether the filter option displays in search results.                                                                                       |
| Use mapped facet filters   | Maps a facet to a query condition, such as `[Updated][After][Last week]`. When selected, the **Fields** and **Sort** fields are removed from the form. After saving, define filters in the Facet Filters related list. |
| Order                      | Defines the display order when multiple facets are defined. If some facets do not have an order value defined, facets with an order defined display first. Facets without an order defined are displayed alphabetically. |
| Table                      | Table that the query is created for. This value is read-only and defined by the table used in the search source.                             |
| Field                      | Field that end users can filter search results by. For example, if **Active** is selected, the user can filter search results by true or false.  
|                            | Only fields of the following types are supported: True/False, Choice, Decimal, Floating Point Number, Integer, IP Address, Long, Reference, String, String (Full UTF-8), and URL. |
| Sort                       | Determines the order in which filter options display.                                                                                  |
6. Save the record.
   If **Use mapped facet filters** is selected, the **Facet Filters** related list appears in the facet form.

7. **Optional:** If **Use mapped facet filters** is selected, define facet filters. Map facet filters map a query condition to a facet label. When the end user selects the label from the facet list, the defined query executes.

   a. In the **Facet Filters** related list, click **New**.
      The Mapped Facet Form appears.

   b. Define the facet filter fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Display name of the facet filter option.</td>
</tr>
<tr>
<td>Order</td>
<td>Defines the display order when multiple facet filters are defined.</td>
</tr>
<tr>
<td></td>
<td>(Optional) If some facet filters do not have an order value defined, facets filters with an order defined display first. Facet filters without an order defined are displayed alphabetically.</td>
</tr>
<tr>
<td>Application</td>
<td>The application scope of the search source. This value is read-only.</td>
</tr>
<tr>
<td>Facet</td>
<td>The search facet that uses the mapped query. This value is read-only.</td>
</tr>
<tr>
<td>Table</td>
<td>The table defined in the search facet. This value is read-only.</td>
</tr>
<tr>
<td>Mapped query</td>
<td>A query condition that users can set to filter search results. For example, <code>[Updated][On][Today]</code>.</td>
</tr>
</tbody>
</table>
c. Click Submit.
   Users can filter search results based on the query defined.

**Disable facets for a search source**

Disable facets for one or more search sources by adding a system property. Once disabled, the search source does not display search facets in the Faceted Search widget on the sp_search page. You can disable facets for simple or advanced search sources.

**Before you begin**
Role required: admin or sp_admin

**Procedure**

1. Enter `sys_properties.list` in the Application Navigator to navigate to the System Properties table.
2. Click New.
   The System Property form opens.
3. In the Name field, enter `glide.service_portal.disable_facets_for_search_sources`.
4. In the Value field, enter a comma-separated list of search source Sys IDs to disable facets for. Do not include spaces. For example, `c6170ae86721220023c82e08f585efe6,c96eb1686721220023c82e08f585efff`.
5. Click Submit.

**Results**
Facets do not display when the defined search source is selected in the sp_search page.

**Populate search suggestions in Service Portal**

If you are upgrading from a previous release, run a script to populate search suggestions with data from a platform search table to provide search suggestions to your users. Alternatively, you can wait until users search for keywords instead of running this script.

**Before you begin**
Role required: admin
In new instances, the search suggestions are enabled by default. In upgraded instances, you must enable the search suggestions. For more information, see Enable search suggestions.
About this task
The Now Platform collects search data and analytics that generate search suggestions. If you are upgrading from a previous release, the search analytics do not contain any data yet. To immediately provide suggestions to your users, you can populate the search suggestions using data from either the Text Searches [text_search] table or the Service Portal Log Entries [sp_log] table. The Service Portal Log Entries table includes search data from Service Portal only and may take less time to populate search suggestions. The Text Search table includes search data from the entire platform.

Search suggestions improve over time as more people use Service Portal. Search Suggestions is a Now Platform feature. For more information, see Search Suggestions.

⚠️ CAUTION: Populating search suggestions can be a resource-intensive task that may take a while to complete. Do not run this script during peak hours. Populating search suggestions is not supported on domain-separated instances.

Procedure
1. Navigate to System Definition > Scheduled Jobs.
2. Open the Populate Suggestions to avoid Cold Start - Portals scheduled job.
3. Modify the script for your search implementation.
   a. Define which portals the suggestions apply to. By default, the script populates suggestions in the base system service portal, but you can add as many as you want to the array.

```javascript
var portals = ["Service Portal"];```

   b. Change where the data comes from. By default, the script imports data from the Text Searches [text_search] table, but you can change the source table to the Service Portal Log Entries [sp_log] table. The Service Portal Log Entries only saves records from the last 90 days.

```javascript
var searchLogTable = "text_search";
```

   c. Push data to any custom search sources in your instance. Suggestions are not enabled for external search sources. You must push data to both the search source name and the Sys ID.

For example, push text searches from the Incident table to your custom Incident search source. For more information about custom search sources,
see Define a search source. By default, the system pushes text searches from the Catalog and Knowledge tables to the respective search sources.

Add the following code after line 11 in the script for each of your custom search sources.

```javascript
searchSources.push("<search-source-table-name>*");
searchSourceIds.push("<search-source-sys-id>*");
```

If the search source table does not exist, the system does not push suggestions to that search source.

d. Save the record.
   Make sure that the script includes the configuration you need. You can only run the script once.

4. Activate the record and select Execute Now.
   Running this scheduled job populates the Search Events [sys_search_event], Search Source Events [sys_search_source_event], and Search Suggestions [sys_search_suggestion] tables.

Results
Users see suggestions when they start typing in a Service Portal search widget.

Add a text index group to a portal
Define how users see search results. For example, combine search results from several sources, or set the weight of certain fields.

Before you begin
Role required: admin
If you have a custom search source or portal, consider whether you want to use the base system **portal_index_group** text index group, or create your own text index group. The base system text index group includes the Catalog items and Knowledge tables. When a user searches for an item in Service Portal, they see combined results from these tables.

ℹ️ **Note:** Index tables before adding them to a text index group. To learn more about text indexing, see Enable text indexing for a table.

Text index groups are a Now Platform feature. To learn more, see Configure multiple tables for indexing and searching.

About this task
ℹ️ **Note:** Text index groups do not support external search sources.
Procedure
1. Navigate to Service Portal > Portals.
2. Open the portal that you would like to add a text index group to.
3. Configure the form to add the Text Index Group field.
4. Add the text index group you want to the Text Index Group field.

Results
Search results display according to the text index group's rules.

Set the default portal search source
Use the glide.service_portal.default_search_sources system property to define default search sources.

Before you begin
Role required: admin

About this task
If you don’t define specific search sources for your portal, the system uses default search sources instead.

Default search source flow chart

Procedure
1. In the Navigation filter, enter sys_properties.list. The entire list of properties in the System Properties [sys_properties] table appears.
2. On the list, find the system property `glide.service_portal.default_search_sources`, and then open the property record.

3. Copy the sys_ID of any search source you want to add into the **Value** field of the system property using a comma-separated list.

   To change the order in which the default search sources show in the Search List, change the order of the IDs in the property.

   You can remove the default search source behavior by deleting the property value or deleting the property altogether.

4. Click **Update**.

**Configure Search Sources available on a page**

Use contextual search to limit search results for an instance of the type-ahead search widget.

With contextual search enabled, users only see type-ahead results for specific search sources. For example, searching on the Service Catalog page only shows results from the Service Catalog search source when contextual search is enabled.

1. In the Service Portal Designer (**Service Portal > Service Portal Configuration > Service Portal Designer**), find an instance of the type-ahead search widget.

2. Point to the widget and click the edit icon (-pencil).

   Alternatively, in any preview page containing the type-ahead search widget, for example the Service Catalog homepage, control + right-click to open the widget context menu. Then click **Instance Options**.

3. In the Contextual Search Sources field, select search sources from the list.

   Search sources listed for contextual search can be limited to just one, several, or all search sources.

Default search sources are defined in the `glide.service_portal.default_search_sources` property, so even if you do not have search sources configured, type-ahead search widget still shows type-ahead suggestions. For more information on default search sources, see **Set the default portal search source**.
AI Search in Service Portal

Configure the ServiceNow AI Search application for Service Portal so that portal users can take advantage of intelligent query features and quickly find the answers they need.

AI Search features

**Powerful and flexible search**

Unlike the legacy Zing search that was used in previous releases, AI Search is faster and more assistive. Portal users can find answers more quickly and easily with features like auto-complete search queries, natural language support, and typo handling.

### Search suggestions

![Search suggestions example](image)

### Typo handling

Showing results for *iphone*  
Search instead for *ipone*

### Relevant and actionable search results

With AI Search enabled in Service Portal, the portal search engine captures information about the user — such as their role, location, department, assets, and search history — and returns search results that are relevant and personalized.

AI Search also includes genius results that enable users to take action directly from the search results list.
Intelligent search refinement

Portal users can refine their search results using dynamic and static filters. For example, if a user searches Mac, they can use facets to filter search results by hardware or user profiles.

Search facets

For more information on using facets and tabs, see Faceted Search widget.
For more information on AI Search features, see Exploring AI Search.

**Activation information**

AI Search is a Now Platform feature that is active by default.

AI Search is enabled in Service Portal for all new and zBoot customers by default.

If you are upgrading to Rome as an existing customer, AI Search is disabled in Service Portal by default. You can enable it by updating the portal record. For more information, see Enable and configure AI Search in Service Portal.

⚠️ **Note:** Search widgets that you cloned or customized before a system upgrade may not be compatible with AI Search. You can resolve this issue by running a fix script that reclassifies search widget instances. For more information, see Reclassify cloned or customized search widgets.

**Configuring AI Search for Service Portal**

Configure AI Search in Service Portal by defining the following:

- **Search application configuration**
  
  Defines search experience settings, such as the search engine, search results limit, and suggestions limit. For more information on defining a search application configuration, see Defining search application configurations.

- **Search results configuration**
  
  Defines how search results are displayed. For more information on defining a search results configuration, see Define a composite dataset.

You can change the search application configuration or search results configuration that your portal uses by updating the portal record. For more information, see Enable and configure AI Search in Service Portal.

To use a different search application or search results configuration for a specific search widget, update the widget instance options. AI Search is used in the following widgets:

- Homepage Search widget
- Typeahead Search widget
- Faceted Search widget
- Catalog Homepage Search widget
- Knowledge Breadcrumbs widget
To configure the search results payload to navigate to and display the appropriate portal page for a selected data source, define an AI Search results action. For more information, see Define an AI Search Results Action.

You can configure the action buttons in genius results by defining an Entity View Action Mapping (EVAM) action. For more information, see Define an EVAM action.

You can customize the look and feel of the AI Search experience in Service Portal by updating the relevant CSS variables. For more information on these variables, see Theming for AI Search in Service Portal.

**Browser support**

With AI Search enabled in Service Portal, users must log in with a modern browser such as Google Chrome, Mozilla Firefox, Microsoft Edge (Chromium), or Apple Safari.

**Enable and configure AI Search in Service Portal**

Enable and define the AI Search experience in your portal.

**Before you begin**

AI Search is only supported in Service Portal, Employee Center (ESC), Consumer Service Portal, and Customer Service Portal. Custom portals must be built off a baseline of one of these portals to have the AI Search capability. The `glide.service_portal.enable_ais_portal.allow_list` property contains a list of supported baseline portals.

To use AI Search for knowledge articles, define a knowledge search source in the Search Sources related list of the portal record. You can keep the default Knowledge Bases search source or select a custom one.
Role required: sp_admin or admin

About this task
AI Search is enabled in Service Portal for all new and zBoot customers by default. If you are upgrading to Rome as an existing customer, AI Search is disabled in Service Portal by default. You can enable it by updating the portal record. If you leave AI Search disabled, the portal uses the legacy search experience.

Procedure
1. Navigate to Service Portal > Portals and open a portal record.
2. On the form, select Enable AI Search.
3. In the Search Application field, select the search application configuration to use for the portal.
   A search application configuration defines search experience settings, such as the search engine, search results limit, and suggestions limit. A search application configuration is selected by default, but you can select a different configuration if needed.
   For more information on defining a search application configuration, see Defining search application configurations.
4. In the Search Results Configuration field, select the search results configuration to enable for the portal.
   A search results configuration defines how search results are displayed. A search results configuration is selected by default, but you can select a different configuration if needed.
For more information on defining a search results configuration, see Create an EVAM definition.

5. Select Update.

Results
Al Search is enabled throughout the portal. Employees or customers can use AI Search the next time they log in.

The Search Sources related list is hidden from the portal record. You now define search sources in the AI Search application. For more information, see Defining search sources.

Note: If you’re experiencing issues using AI Search for knowledge articles, check that the associated search profile is linked to a knowledge bases search source. For more information, see Link a search source to a search profile.

What to do next
Search widgets that you cloned or customized before a system upgrade may not be compatible with AI Search. You can resolve this issue by running a fix script that reclassifies search widget instances. For more information, see Reclassify cloned or customized search widgets.

Reclassify cloned or customized search widgets
Search widgets that you cloned or customized before a system upgrade may not be compatible with AI Search. You can resolve this issue by running a fix script that reclassifies search widget instances.

Before you begin
1. Enable and configure AI Search in Service Portal
2. Run the Portal Analyzer to identify all cloned or customized search widgets. For more information, see Portal Analyzer.
3. For each cloned or customized search widget, copy the sys_id value of each widget instance that is associated with the widget.
4. For each cloned or customized search widget, ensure that the widget and its corresponding widget instances have the latest AI Search code from the base system search widget.

Warning: Run the fix script only after you’ve updated all cloned or customized search widgets. If you run the fix script without first updating the widget code, the widgets won’t be able to uptake the AI Search code later.
Role required: admin

About this task
If you’re unable to use AI Search in Service Portal, you may need to reclassify your cloned or customized search widgets. You can run the **Reclassifying Search widgets** fix script, which reclassifies widget instances to the sp_instance_ais class.

Procedure
1. Navigate to **System Definition > Fix Scripts**.
2. On the list, find and open the record named **Reclassifying Search widgets**.
3. On the form, update the script to define which widget instances to reclassify. Paste the sys_id value of each search widget instance in the array. For example, you would enter the sys_id values as follows:

   ```javascript
   var instances = ["sys_id_1", "sys_id_2"];
   ```
4. Save the form.
5. Select **Run Fix Script**.

Define an AI Search Results Action
Configure the search results payload to navigate to and display the appropriate portal page for the selected data source.

Before you begin
Role required: sp_admin or admin

About this task
This configuration is required for UXF Client Action buttons in genius results or search results cards.

⚠️ Note: If the action is being implemented as a server script, the script is executed by the search widget. Notification messages defined in the server script are displayed.

Procedure
1. Navigate to **Service Portal > AI Search > Search Results Action** and select **New**.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Description of the search results action.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service Portal(s)</td>
<td>Portals in which the search results action appears. If left blank, the search results action appears in all active portals.</td>
</tr>
<tr>
<td>AI Search Source</td>
<td>Content that portal users can search on, including tables in your instance or external data sources. For more information, see <a href="#">Defining search sources</a>.</td>
</tr>
<tr>
<td>Action name</td>
<td>Name of the action assignment. Only <strong>navigation</strong> is supported.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the search results action.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the search results action.</td>
</tr>
<tr>
<td>Order</td>
<td>Priority that the search results action takes over other actions with the same configuration. To give higher priority to an action, enter a lower number.</td>
</tr>
<tr>
<td></td>
<td>If two actions have the same order, then the oldest action takes priority.</td>
</tr>
<tr>
<td>Portal page</td>
<td>Page on which the search results action appears.</td>
</tr>
<tr>
<td>Payload query</td>
<td>Query parameters to apply to the URL. In the first drop-down, select the payload fields that correspond to the selected action name. In the next field, enter the query parameter to apply to the URL.</td>
</tr>
<tr>
<td>parameters</td>
<td></td>
</tr>
<tr>
<td>Additional query</td>
<td>Custom query parameters to use in addition to the payload query parameters. For example, to add <code>view=sp</code> as a query parameter, you would enter <code>view</code> and <code>sp</code> in the <strong>Name</strong> and <strong>Value</strong> fields, respectively.</td>
</tr>
<tr>
<td>parameters</td>
<td></td>
</tr>
</tbody>
</table>

3. Select **Submit**.

### Theming for AI Search in Service Portal

You can customize the look and feel of the AI Search experience in Service Portal by updating the relevant CSS variables.

The following CSS variables control the look and feel of the AI Search experience in Service Portal. You can edit these variables in a Theme [sp_theme] record by navigating to **Service Portal > Themes**.
<table>
<thead>
<tr>
<th>Variable</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>$now-sp-rem-factor</td>
<td>1.6</td>
</tr>
<tr>
<td>$now-sp-font-family-sans-serif</td>
<td>&quot;SourceSansPro&quot;, Helvetica, Arial, sans-serif</td>
</tr>
<tr>
<td>$now-sp-color--neutral-12</td>
<td>$gray-dark</td>
</tr>
<tr>
<td>$now-sp-global-border-radius</td>
<td>4px</td>
</tr>
<tr>
<td>$now-sp-color--focus-ring</td>
<td>$brand-primary</td>
</tr>
<tr>
<td>$now-sp-tabs--selected--color</td>
<td>$brand-primary</td>
</tr>
<tr>
<td>$now-sp-tabs--color-hover</td>
<td>$brand-primary</td>
</tr>
<tr>
<td>$now-sp-tabs--border-color</td>
<td>$sp-b-border-color</td>
</tr>
<tr>
<td>$now-sp-tabs--selected--background-color</td>
<td>$brand-primary</td>
</tr>
<tr>
<td>$now-sp-heading--title-primary--color</td>
<td>$gray-dark</td>
</tr>
<tr>
<td>$now-sp-checkbox-label--color</td>
<td>$gray-dark</td>
</tr>
<tr>
<td>$now-sp-button--primary--bare--color</td>
<td>$link-color</td>
</tr>
<tr>
<td>$now-sp-button--primary--bare--color--active</td>
<td>$link-color</td>
</tr>
<tr>
<td>$now-sp-button--primary--bare--color--hover</td>
<td>$link-hover-color</td>
</tr>
<tr>
<td>$now-sp-pill--selected--background-color</td>
<td>$brand-primary</td>
</tr>
<tr>
<td>$now-sp-pill--selected--border-color</td>
<td>$brand-primary</td>
</tr>
<tr>
<td>$now-sp-button--secondary--background-color</td>
<td>$btn-default-bg</td>
</tr>
<tr>
<td>$now-sp-button--secondary--color</td>
<td>$btn-default-color</td>
</tr>
<tr>
<td>$now-sp-button--secondary--border-color</td>
<td>$btn-default-border</td>
</tr>
<tr>
<td>$now-sp-button--secondary--background-color--hover</td>
<td>darken($btn-default-bg, 10%)</td>
</tr>
<tr>
<td>$now-sp-button--secondary--color--hover</td>
<td>$btn-default-color</td>
</tr>
<tr>
<td>Variable</td>
<td>Default value</td>
</tr>
<tr>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>$now-sp-button--secondary--border-color--hover</td>
<td>darken($btn-default-border, 12%)</td>
</tr>
<tr>
<td>$now-sp-button--secondary--background-color--active</td>
<td>darken($btn-default-bg, 10%)</td>
</tr>
<tr>
<td>$now-sp-button--secondary--color--active</td>
<td>$btn-default-color</td>
</tr>
<tr>
<td>$now-sp-button--secondary--border-color--active</td>
<td>darken($btn-default-border, 12%)</td>
</tr>
<tr>
<td>$now-sp-highlighted-value--tertiary--color</td>
<td>$gray-dark</td>
</tr>
<tr>
<td>$now-sp-button--border-radius</td>
<td>$now-sp-global-border-radius</td>
</tr>
<tr>
<td>$now-sp-container--border-radius</td>
<td>$now-sp-global-border-radius</td>
</tr>
<tr>
<td>$now-sp-color--text-primary</td>
<td>$gray-dark</td>
</tr>
<tr>
<td>$now-sp-button--primary-negative--background-color</td>
<td>$btn-primary-bg</td>
</tr>
<tr>
<td>$now-sp-button--primary-negative--border-color</td>
<td>$btn-primary-border</td>
</tr>
<tr>
<td>$now-sp-button--primary-negative--background-color--hover</td>
<td>darken($btn-primary-bg, 10%)</td>
</tr>
<tr>
<td>$now-sp-button--primary-negative--border-color--hover</td>
<td>darken($btn-primary-border, 12%)</td>
</tr>
<tr>
<td>$now-sp-button--primary-negative--background-color--active</td>
<td>darken($btn-primary-bg, 10%)</td>
</tr>
<tr>
<td>$now-sp-button--primary-negative--border-color--active</td>
<td>darken($btn-primary-border, 12%)</td>
</tr>
<tr>
<td>$now-sp-button--primary--background-color</td>
<td>$btn-primary-bg</td>
</tr>
<tr>
<td>$now-sp-button--primary--border-color</td>
<td>$btn-primary-border</td>
</tr>
<tr>
<td>$now-sp-button--primary--color</td>
<td>$btn-primary-color</td>
</tr>
<tr>
<td>$now-sp-button--primary--background-color--hover</td>
<td>darken($btn-primary-bg, 10%)</td>
</tr>
</tbody>
</table>
Service Portal announcements

Use announcements to broadcast messages to Service Portal users. Announcements can display in an announcement banner or an announcement widget instance.

Announcements are active on new instances. To activate announcements after upgrade, you can activate the Service Portal Announcements plugin (com.glide.service-portal.announcements).

When creating announcements, you can define the way an announcement displays.

**Sort order**

Announcements are displayed depending on the order defined in:

- The `glide.service_portal.announcement.default.sort_order` system property. See Service Portal properties.
- The **Display First** field in the announcement record.

If there is a tie between two records set to **Display first**, the sort order defined in the system property is honored.

**Display location**

Announcements can display in the following locations:

- Announcement banner
- Announcements widget instance

<table>
<thead>
<tr>
<th>Variable</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>$now-sp-button--primary--border-color--hover</td>
<td>darken($btn-primary-border, 12%)</td>
</tr>
<tr>
<td>$now-sp-button--primary--background-color--active</td>
<td>darken($btn-primary-bg, 10%)</td>
</tr>
<tr>
<td>$now-sp-button--primary--border-color--active</td>
<td>darken($btn-primary-border, 12%)</td>
</tr>
</tbody>
</table>
To define the announcement display location, define the announcement type in the announcement record.

**Display Style**

Using display styles, you can:

- Create a custom color scheme.
- Change the text alignment.

Announcements that appear in a banner use the display style defined in the Announcement record by default. To use the display style in an instance of the Announcements widget, you can select the **Use Display Style** instance option.

**User criteria**

If user criteria is set up for the Service Portal, you can define who can and who cannot view an announcement. Through user criteria,
you can create announcements only visible to specific users, groups, roles, organizations, and more.

Create an announcement

An announcement appears as a banner in Service Portal or within the announcements widget.

Before you begin
Role required: admin, sp_admin, or announcement_admin

Procedure
1. Navigate to Service Portal > Announcements.
   The Announcements [announcement] table displays all announcements.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Internal title that doesn't display in the announcement.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the announcement. To hide an announcement, clear the Active check box.</td>
</tr>
<tr>
<td>Title</td>
<td>Title to appear in the announcement.</td>
</tr>
<tr>
<td>From</td>
<td>Date and time that the announcement begins to appear.</td>
</tr>
<tr>
<td>To</td>
<td>Date and time that the announcement ends. If left empty, the announcement continues to appear until it's deactivated.</td>
</tr>
<tr>
<td>Summary</td>
<td>Text to appear in the announcement.</td>
</tr>
<tr>
<td>Display style</td>
<td>Defines the background color, text color, and text alignment of banner announcements. Base system styles include:</td>
</tr>
<tr>
<td></td>
<td>• Normal: Blue background and left-aligned, white text.</td>
</tr>
<tr>
<td></td>
<td>• Urgent: Red background and left-aligned, white text.</td>
</tr>
</tbody>
</table>

Announcements that appear in a banner use the display style defined in the Announcement record, by default. To use the display style in an instance of the Announcements widget, you can select the Use Display Style instance option.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Defines where an announcement displays. By default, announcements appear in the following locations:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Banner</strong>: Announcement banner above the banner frame in the Service Portal.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Widget</strong>: Instance of the announcements widget.</td>
</tr>
<tr>
<td></td>
<td>You can create an announcement type to define other widget instances to display an announcement.</td>
</tr>
<tr>
<td><strong>Glyph</strong></td>
<td>Glyph to display to the left of the title in banner announcements.</td>
</tr>
<tr>
<td><strong>Glyph alt text</strong></td>
<td>Alternative text for the glyph icon used with screen readers.</td>
</tr>
<tr>
<td><strong>Public</strong></td>
<td>Option to display the announcement to users before and after they've logged in.</td>
</tr>
<tr>
<td><strong>Display first</strong></td>
<td>If selected, the announcement displays before all other announcements.</td>
</tr>
<tr>
<td></td>
<td>If there is a tie between two records set to <strong>Display first</strong>, the sort order defined in the glide.service_portal.announcement.default.sort_order system property is honored. See Service Portal properties.</td>
</tr>
<tr>
<td><strong>Roles</strong></td>
<td>If <strong>Public</strong> is not selected, you can define the roles that the announcement is visible to. If left empty, the announcement is visible to all roles.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Alternatively, you can define user criteria for the announcement instead. To do so, set up User criteria for Service Portal and clear the <strong>Public</strong> check box. Announcements display to only the users who pass the access criteria.</td>
</tr>
<tr>
<td><strong>Unauthenticated only</strong></td>
<td>Option to display the announcement only to users who haven't logged in.</td>
</tr>
<tr>
<td></td>
<td>This option appears only if <strong>Public</strong> is selected.</td>
</tr>
<tr>
<td><strong>Click target</strong></td>
<td>Creates a link below the announcement body that opens to a target page or URL.</td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong>: Announcement doesn't include a link.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Page</strong>: Opens a Service Portal page in the current browser tab.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>URL in current browser tab</td>
<td>Opens a URL in the current browser tab.</td>
</tr>
<tr>
<td>URL in new browser tab</td>
<td>Opens a URL in a new browser tab.</td>
</tr>
</tbody>
</table>

If the Details link text field is empty and a click target is defined, the title of the announcement is the link.

- **Details page**: The page that opens in the current browser tab. Available if the Click target is **Page**.
- **Details URL**: The URL that opens in the current or new browser tab. Available if the Click target is **URL in current browser tab** or **URL in new browser tab**.
- **Details link text**: Link text for the page or URL click target. If you leave this field empty and define a click target, the title of the announcement is the link.
- **Dismiss options**: Determines whether the user can dismiss the announcement. Options include:
  - User can dismiss - no redisplay
  - User can dismiss for current session only
  - User cannot dismiss
- **Portals**: Portals that display the announcement. If this field is empty, the announcement displays in all portals.

4. Save or submit the record.

**What to do next**
If the Type is Banner, test your announcement by navigating to the portal defined in the Portals field. If the Type is Widget or a custom type, test your announcement by navigating to the page with the associated widget instance.

**Create an announcement display style**
Define the background color, foreground color, and text alignment of an announcement.

**Before you begin**
Role required: admin, sp_admin, or announcement_admin
Procedure

1. Navigate to Service Portal > Announcements.
2. Open an existing announcement or create a new announcement.
3. In the Display style field, click the reference lookup icon to open the referenced table. The Announcement Styles [announcement_style] list view opens.
4. Click New to create a new display style.
5. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Internal name of the display style.</td>
</tr>
<tr>
<td>Application</td>
<td>The application scope of the announcement. This value is read-only.</td>
</tr>
<tr>
<td>Background color</td>
<td>Color name or HEX value in the format #000000 for the announcement background.</td>
</tr>
<tr>
<td>Foreground color</td>
<td>Color name or HEX value in the format #000000 for the announcement text.</td>
</tr>
<tr>
<td>Alignment</td>
<td>Text alignment. Options include:</td>
</tr>
<tr>
<td></td>
<td>• Left align</td>
</tr>
<tr>
<td></td>
<td>• Center align</td>
</tr>
</tbody>
</table>

6. Click Submit.

Results
By default, the announcement appears in both the portal banner and the Announcements widget, but only the banner uses your new display style. You can configure the widget to use the display style also. For more information, see the instance options in Announcements widget.

Create an announcement type
Announcement types determine where an announcement displays. Announcements include two base system types: banner and widget.

Before you begin
Role required: admin, sp_admin, or announcement_admin
About this task
Similar to creating a category tag, you can create alternative types to define custom locations. For example, to display an announcement only in a specific widget instance, you can create an announcement type for that widget instance. Any announcements tagged with that type will only display in the desired widget instance.

Procedure
1. Navigate to System Definition > Tables > Announcement Consumer Type. The Announcement Consumer Type table [announcement_consumer_type] opens.
2. In the Columns section of the form, Click New.
3. Define a Name. The name is used to associate an announcement with a widget instance.
4. Click Save.
5. Add the custom type to an announcement.
   a. Navigate to Service Portal > Announcements.
   b. Open an existing announcement or create a new announcement.
   c. In the Type field, select the custom type.
   d. Click Save.
6. If using the type in a widget, define the type as a widget instance option. The announcement banner only displays announcements tagged with the Banner type.
   a. Navigate to an instance of the Announcement widget.
   b. Control + right-click the widget instance and select Instance Options.
   c. In the Type field, select the custom announcement type.

Results
The widget instance associated with the type displays any announcements tagged with the same type.

Service Portal security
Control user access to a portal.
Control who accesses your portal and what they can see in the following ways:
• Authentication: Configure login and single sign on for users
• Limit page access by role: Use roles to limit the users who can see a page.
• Public pages: Use the public check box on a page record to make the page publicly accessible.

⚠ Note: A number of portal pages that are installed by default are marked public. Filter your list of Service Portal pages for Public [is] true to identify these pages. Setting the Public value to false will prevent these pages from being publicly available.

• User criteria: For a more advanced way of limiting user access, create and apply user criteria to pages, widgets, widgets instances, and search sources.

• Multifactor authentication: If an instance is configured to require multifactor authentication, users are automatically directed to set up multifactor authentication upon initial login. For setup instructions, see . If multifactor authentication is optional, users can still enable or disable authentication from their user profile. For setup instructions, see .

Single sign-on, logins, and URL redirects

Service Portal uses a combination of system properties and script includes to determine how the system handles URL redirects for users logging in to the portal.

Only users who understand SSO, URL redirects, and the ServiceNow platform should make any changes.

Single sign-on and Service Portal

To use single sign-on with Service Portal, you must enable the Integration - Multiple Provider Single Sign-On Installer plugin (com.snc.integration.sso.multi.installer).

If you are using the system property to automatically redirect to your primary IdP, then Service Portal automatically redirects to that IdP. If you have multiple identity providers, Service Portal shows a link on the login page to Use external login. For more information on SSO and authentication in the platform, see Multiple-Provider single sign-on (SSO).

Require authentication for a Service Portal page

If you want to require authentication for a Service Portal page, ensure that the Public flag on the page record is not selected. For more information, see Create and edit a page using the Service Portal Designer. If a user navigates to a non-public page, they are redirected to the login page for the requested portal.
Because every page request is routed through the $sp page, this page must be public. The following values in the Public Pages sys_public table define the page as public:

- **Page**: $sp
- **Active**: true

**Configure the Service Portal login page**

Administrators can configure a login page URL redirect for a portal.

**Procedure**

1. **Add a system property** with the following settings:
   - Name: glide.entry.page.script
   - Type: string
   - Value: 
     ```java
     new SPEntryPage().getLoginURL()
     ```

2. To customize the actual entry page, from the Script Includes table, search for SPEntryPage.

   **Note**: If you make changes to the script include, it won't be upgraded with future updates.

3. Edit the script on the SPEntryPage to change the assigned portal to the portal_suffix you want. SPEntryPage uses /sp/ as the portal path to redirect to. Enter your own portal_suffix in place of sp.

   ```javascript
   SPEntryPage.prototype = {
     initialize: function() {
       this.logVariables = false; // for debugging
       this.portal = "/sp"; // The URL suffix specified in the sp_portal record
     },
   }
   ```

   **Note**: The slash character (/) after /sp may cause issues when configuring single sign-on. If you’re experiencing issues, try removing the character from the script.

**Redirect to Service Portal after login**

Use system properties and script includes to conditionally redirect users to a page after logging in.

Follow these steps to redirect a user to Service Portal after they log in.
1. In the `sys_properties` table, add the following property:

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.entry.first.page.script</td>
<td>string</td>
<td>new SPEntryPage().getFirstPageURL()</td>
<td>First page after authentication</td>
</tr>
</tbody>
</table>

getFirstPageURL primarily does the following:

- Redirects to `login_redirect.do` in order to break out of the frameset (if there is one).
- Redirects to Service Portal if the user has no roles, or the full platform for everyone else.

2. Customize the after login behavior by navigating to the `SPEntryPage` script include.

⚠️ **Note:** If you make changes to the script include, it won't be upgraded with future updates.

⚠️ **Note:** If you are using external authentication, ensure that your IdP supports the RelayState URL parameter. This parameter retains the originally requested URL while the user authenticates, and is necessary for redirection after login.

### Debug Service Portal URL redirects

Debug the URL redirects for logging in to Service Portal and redirecting to the first page.

To view debug output from SPEntryPage and see the session variables it redirects based on:

1. Make sure the system property `glide.entry.first.page.script` has the value: `new SPEntryPage().getFirstPageURL()`.
2. From the SPEntryPage script include, set `this.logVariables = true`.
3. In a separate browser, log in.
4. From the system navigator, view the log output by navigating to **System Logs > System Log > All**.

### Configure page security by role

Set up pages to be public or filter them by role.
Before you begin
Role required: admin or sp_admin

About this task
Public pages won't require a user login; anyone can access them. All other options require user authentication.

Procedure
1. In the Service Portal configuration page (Service Portal > Service Portal Configuration), open the Page Editor.
2. In the Select Page list, search for the page to apply page security to.
3. Select the highest level node in the tree view.
4. Configure page security.
   • To make a page public, select the Public check box. All users can access pages marked as Public.
   • To limit access to a certain role, add roles in a comma separated list. Users without the role listed can see links to the page if they appear in the portal. Trying to open the page results in a "page not found" error.

   Note: If you select Public and add a list of roles, the page is still accessible by any user.

   • To create a draft page that only administrators can see while the page is still in development, select Draft. Users must have the admin role to see any pages in draft. Everyone else sees a "page not found" error.
5. Click Save.
Example:

Page with limited access by role

What to do next
Follow the steps in Configure widget security to configure security for the widgets on your page.

Configure widget security
Configure widget security to ensure that your widget is being accessed only by the intended audience.

Before you begin
Role required: admin or sp_admin

About this task
There are several ways to configure widget security:

• Make the widget public to unauthenticated users
• Make the widget accessible to any user with a login
• Make the widget accessible to certain roles only

When you configure widget security, configure the page security accordingly so that users can access the widget via the page on which it appears. For more information, see Configure page security by role.

Procedure
1. Navigate to Service Portal > Widgets.
2. Open the record of the widget to configure.
3. On the form, configure the widget security.
<table>
<thead>
<tr>
<th>Option</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make the widget public to unauthenticated users</td>
<td>Select the <strong>Public</strong> check box.</td>
</tr>
<tr>
<td>Make the widget accessible to any user with a login</td>
<td>Note: If you select <strong>Public</strong> and add a list of roles, the widget is still accessible by any user.</td>
</tr>
<tr>
<td>Make the widget accessible to certain roles only</td>
<td>Clear the <strong>Public</strong> check box and leave the <strong>Roles</strong> field blank.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. Clear the <strong>Public</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>b. Next to <strong>Roles</strong>, click the edit icon (<strong>Roles</strong>)</td>
</tr>
<tr>
<td></td>
<td>c. On the Roles window, select a role by moving it from the <strong>Available</strong> list to the <strong>Selected</strong> list.</td>
</tr>
<tr>
<td></td>
<td>d. Click <strong>Done</strong>.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

**User criteria for Service Portal**

User criteria enables you to allow access to users based on role, department, group, location, or company. Administrators can control access to pages, widgets, widget instances, announcements, and search sources in a portal by creating and applying user criteria.

User criteria records define conditions that are evaluated against user records. When user criteria is defined, portal records are only visible to users who pass the defined conditions.

User criteria is a platform feature used in Service Portal. Learn more about user criteria in the Now Platform:

- **Service Catalog**: Set security for items and categories.
- **Knowledge management**: Control access at the knowledge base level through user criteria.

**Important**: After making user criteria additions or changes, you may need to log out and log back in to clear the prior configuration.
Converting role-based permissions to user criteria records

User criteria in Service Portal replaces role-based permissions. After activating the user criteria for Service Portal plugin, you must set the user criteria for Service Portal system property to \textbf{true}. When the system property is set to true, any existing roles defined for a page, widget, or search source are automatically converted into user criteria records. To disable user criteria and continue using role-based permissions, set the system property to \textbf{false}.

User criteria checks

User criteria uses the following checks in Service Portal to verify user access.

Page access user criteria

The following diagram shows how the system decides whether a user can access a page based on user criteria.
Widget access user criteria
The following diagram shows how the system determines whether a user has access to a particular widget or widget instance.

Activate the user criteria for Service Portal plugin
You can activate the Service Portal User Criteria Support plugin (com.glide.service-portal.user-criteria) if you have the admin role.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
Set the user criteria for Service Portal system property

After activating the Service Portal User Criteria Support plugin, you must set the system property to true.

Before you begin
Role required: admin

About this task
Setting the system property activates user criteria for Service Portal. When the system property is set to true, any existing roles defined for a page, widget, or search source are automatically converted into user criteria records. To disable user criteria and continue using role-based permissions, set the system property to false.

Procedure
1. Navigate to Service Portal > Properties.
2. Click the check box to set the following property to true.
   
   Enable use of User Criteria records instead of Roles fields for Service Portal entitlements
   Defines permissions for Service Portal widgets, widget instances, search sources and pages
   
   Yes | No

   3. Click Save.

Create a user criteria record for Service Portal

Create a user criteria record to apply to items in Service Portal and control user access to pages, widgets, widget instances, and search sources.

About this task
You can apply existing user criteria to records in Service Portal through Service Portal configuration (Service Portal > Service Portal configuration). You can only create user criteria within the platform UI.

Procedure
1. In the navigation filter, type Service Portal.
2. Select a page, widget, or widget instance record.
3. In the related list at the bottom of the record, select the **Can View** or **Cannot View** tab, then click **New**. If a user criteria record is already created, you can click **Edit** to apply user criteria to the page, widget, or widget instance.

User criteria records are stored in the user_criteria table.

![User Criteria Form](image)

4. Complete the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the criteria record.</td>
</tr>
<tr>
<td>Users</td>
<td>User records to match access criteria.</td>
</tr>
<tr>
<td>Groups</td>
<td>Group records to match access criteria.</td>
</tr>
<tr>
<td>Roles</td>
<td>Roles to match access criteria.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Displays or hides the <strong>Script</strong> field.</td>
</tr>
<tr>
<td>Script</td>
<td>Defines any additional criteria, and returns true or false. This field is available only if <strong>Advanced</strong> is selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Note:**    | • Because scripts are evaluated dynamically, including scripts in user criteria records can decrease performance.  
• Do not use a function with its name as answer, that is, answer(). |
| Application  | Application scope for the user criteria record.                                                        |
| Active       | Activate or deactivates this criteria record.                                                          |
| Companies    | Companies to match access criteria.                                                                    |
| Locations    | Locations to match access criteria.                                                                    |
| Departments  | Departments to match access criteria.                                                                   |
| Match All    | Determines whether all elements from each populated criteria field must match. If selected, only users who match all criteria are given access. If cleared, the user must meet one or more of the set criteria to be given access.  
By default, this check box is cleared so that any condition met provides a match.  
For example, consider a user criteria record for the following:  
• Locations A or B  
• Company C or D  
With **Match All** selected, only users meeting all these conditions are matched. For example, a user with a location A and a company C.  
With **Match All** cleared, users meeting any of these conditions are matched. For example, a user with a location B.  
**Note:** If you select **Match All**, ensure that you do not create contradictory conditions that can never be met.  
For example, if all users in location A work for company G, then the conditions in this example can never be met. |

5. Click **Submit**.
Apply user criteria to a page, widget, or widget instance
Assign user criteria to pages, widgets, or widget instances to limit user access to content in a portal.

Before you begin
Activate the Service Portal User Criteria Support (com.glide.service-portal.user-criteria) plugin and set the glide.service_portal.user_criteria_enabled system property to true.

Role required: admin or sp_admin

About this task
You can apply several user criteria records to a single portal item.

Procedure
1. In the Service Portal Configuration page (Service Portal > Service Portal Configuration), open the Page Editor.
2. Select a page from the list.
3. Select a page, widget, or widget instance node from the page tree.
4. Under related lists, click Who Can View or Who Cannot View.
5. Click New.
6. Select a criteria from the Can View or Cannot View list.
   Selecting criteria from the Can View or Cannot View list applies user criteria records created in Create a user criteria record for Service Portal to the selected page, widget, or widget instance.

7. Click Save.
Apply user criteria to a search source

Assign user criteria to search sources to limit user access to content in a portal.

Before you begin

Role required: admin

About this task

You can add user criteria to custom or default Service Portal search.

Procedure

1. In the Service Portal Configuration page (Service Portal > Service Portal Configuration), navigate to Portal Tables > Search Source in the header menu.

2. Open the search source record that you would like to modify.

3. Under related lists, click Who Can View Search Sources or Who Cannot View Search Sources.

4. Click New.

5. Select a criteria from the Can View or Cannot View list.
   Selecting criteria from the Can View or Cannot View list applies user criteria records created in Create a user criteria record for Service Portal to the selected search source.
6. Click **Save**.

**Enable e-signature for Service Portal**

You can configure e-signature in Service Portal to require re-authentication from approving users.

**Before you begin**

The `com.snc.integration.esig.window` system property is supported to enable SSO login in a new window.

Role required: admin

**Procedure**

1. Activate the Approvals with e-Signature `com.glide.e_signature_approvals` plugin.

2. Navigate to **System Definition > e-Signature Registry**.

3. Add any tables you want to require an e-signature for to the list.

**Results**

With e-signature enabled, approvers are required to provide a password to approve or reject any requests. Authentication with touch ID works in the mobile app. On the mobile web, approvers are still required to enter a password. For more information on configuring e-signature, see **Approval with e-signature**.

**Enable SSO login in a new window**

Open a new window for SSO authentication when using e-Signature for approvals.
Before you begin
Security Assertion Markup Language (SAML) login is only supported on the desktop Service Portal.
For additional information, see the e-signature SSO login KB article.
Role required: admin

Procedure
1. Enter the spEsignatureCustom script.
   a. Enter `sys_ui_script.list` in the Filter navigator.
   b. Select New, and create a new UI script.
   c. On the UI Script form, enter `spEsignatureCustom` in the API Name field.
   d. In the UI Type field, select Mobile/Service Portal.
   e. Paste the `spEsignatureCustom script` in the Script field.
   f. Select Submit.
2. Enter the spAuthCustom script.
   a. In the same `sys_ui_script.list` table, create another new UI script by selecting New.
   b. On the UI Script form, enter `spAuthCustom` in the API Name field.
   c. In the UI Type field, select Mobile/Service Portal.
   d. Paste the `spAuthCustom script` in the Script field.
   e. Select Submit.
3. Associate the UI scripts to the JS Include record.
   a. Navigate to Service Portal > Portals.
   b. Identify the Service Portal you want to apply the esignature support to and select the Theme.
   c. In the related lists, select JS Includes.
   d. Select New.
   e. On the form, fill in the fields.
### JS Include form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name for your JS Include. Enter spEsignatureCustom and associate the record with the spEsignatureCustom UI script you created, or enter spAuthCustom and associate the record with spAuthCustom you created.</td>
</tr>
<tr>
<td>Source</td>
<td>Source for your JS Include record. Select <strong>UI Script</strong>.</td>
</tr>
<tr>
<td>UI script</td>
<td>UI script source for your JS Include record. Select either spEsignatureCustom or spAuthCustom depending on the record you’re creating.</td>
</tr>
<tr>
<td>Application</td>
<td>Application for your JS Include record. The default application is <strong>Global</strong>.</td>
</tr>
<tr>
<td>Updated</td>
<td>Field displaying when the record was last updated.</td>
</tr>
<tr>
<td>Package</td>
<td>Field that establishes the JS Include package.</td>
</tr>
</tbody>
</table>

**f.** Select **Submit**.

**Results**

A new window opens when you use E-Signature for approvals.

**spEsignatureCustom script**

Paste the spEsignatureCustom script in the sys_ui_script.list script field.

```javascript
angular.module('sn.$sp').provider('spEsignature', function()

    'use strict';

    this.$get = function spEsignature($q, $http, $window, urlTools, xmlUtil) {
        var w = window;
        var esignOW;
```
var windowWidth;
var windowHeight;
var redirectURL;

function isWindowChosen() {
    var postParams = {
        sysparm_scope: 'global',
        sysparm_processor: 'ESignatureAuthUtils',
        sysparm_name: 'isWindowChosen'
    };
    return $http({
        method: 'POST',
        url: '/xmlhttp.do',
        data: urlTools.encodeURIParameters(postParams),
        headers: {
            'Content-Type': 'application/x-www-form-urlencoded'
        },
        transformResponse: function(response) {
            return xmlUtil.getDataFromXml(response);
        }
    }).then(
        function(response) {
            var data = response.data ? response.data[0] : {};  
            return data.answer === 'true'
        },
        function(response) {
            // Handling failure case.
            switch (response.status) {
                default:
                case 404:
                    return false;
            }
        });
    }

function initiateEsignature() {
    var postParams = {
        sysparm_scope: 'global',
        sysparm_processor: 'ESignatureAuthUtils',
        sysparm_name: 'fetchAuthDetails'
    }
    return $http({
        method: 'POST',
        url: '/xmlhttp.do',
    })
data: urlTools.encodeURIComponent(postParams),
headers: {
    'Content-Type': 'application/x-www-form-urlencoded'
},
transformResponse: function(response) {
    return xmlUtil.getDataFromXml(response, 'result');
});
}).then(
    function(response) {
        var data = response.data ? response.data[0] : {};
        process(data);
    });
}

function process(data) {
    var shouldLogoutFirst = data.logoutFirst === 'true';
    w['windowHeight'] = data.popup_window_height;
    w['windowWidth'] = data.popup_window_width;
    w['redirectURL'] = data.loginURL;
    if (shouldLogoutFirst)
        openEsignatureWindow(data.logoutURL);
    else
        authenticate();
}

function openEsignatureWindow(url) {
    w['esignOW'] = window.open(url, 'esignatureAuthentication',
        'height='+w['windowHeight']+',width='+w['windowWidth']+',top=100,left=100,toolbar=0,location=0,menubar=0');
}

w['authenticate'] = function(){
    if(w['redirectURL']){
        if(w['esignOW']) //when we signed out previously, a window is already opened. reuse it.
            w['esignOW'].location.href = w['redirectURL'];
        else
            openEsignatureWindow(w['redirectURL']);
    }
};

w['evaluateRedirect'] = function(msg) {
    w['esignOW'].close();
    if (msg == "saml2 login complete") {

$window.onReauthenticationComplete(msg);

})

return {
  isWindowChosen: isWindowChosen,
  initiateEsignature: initiateEsignature
};

});

spAuthCustom script

Paste the spAuthCustom script in the sys_ui_script.list script field.

angular.module('sn.$sp').factory('spAuthModal', function($q, spModal, i18n, $http,
spAuthentication, glideUserSession, cabrillo, $cookies, $window, spUtil, $uibModal,
spEsignature) {
  "use strict";

  function _showAuthenticationModal(requestParams, username, userSysId) {
    var currentUser;
    var deferred = $q.defer();
    glideUserSession.loadCurrentUser({reload: true}).then(function(user) {
      if (!user) {
        deferred.reject({
          error: {
            status: 'ANONYMOUS',
            message: i18n.getMessage('Not logged in')
          }
        });
        return;
      }
      currentUser = user;
      var serializedUser = {
        sysId: currentUser.userID,
        userName: currentUser.userName,
        firstName: currentUser.firstName,
        lastName: currentUser.lastName
      };

      // hand off to native clients
      if (cabrillo.isNative()) {
        cabrillo.auth.reauthenticate(currentUser).then(function() {
          cabrillo.auth.reauthenticate(currentUser).then(function() {

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc. in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
deferred.resolve(serializedUser);
}, function(error) {
if (error && error.status) {
    deferred.reject({
        error: error
    });
}
//TODO: Handle rejection a little more gracefully
deferred.reject();
});
return;
}

var loginMethod = currentUser.$private.loginMethod;
if (!loginMethod) {
    // As we were unable to determine the login method via the HTTP session, trying to get
    glide_sso_id cookie which is set in case of multisso login
    var providerSysId = $cookies.get('glide_sso_id');
    loginMethod = providerSysId ? 'multisso' : 'db';
}

if (loginMethod === 'saml' || loginMethod === 'oidc' || loginMethod === 'multisso') {
    spEsignature.isWindowChosen().then(function(result) {
        var modal;
        if (!spUtil.isMobile() && loginMethod !== 'oidc' && result === true) {
            // If enabled, Opening a new window for desktop saml login
            spEsignature.initiateEsignature();
        } else {
            glideUserSession.getSsoReauthenticationUrl().then(function(url) {
                requestParams.externalLoginURL = url;
                openExternalAuthModal(requestParams).then(function(m) {
                    modal = m;
                });
            });
        }
    });
    $window.onReauthenticationComplete = function(result) {
        deferred.resolve(serializedUser);
        if (modal)
            modal.close();
    });
} else {
    spModal.open(
        title:i18n.getMessage("Approver authentication"),

message: i18n.getMessage("Additional authentication is required, enter your username and password to continue.")

footerStyle: {border: 'none', 'padding-top': 0},
widget: 'simpleloginui',
widgetInput: {},
shared: requestParams,
onSubmit: function() {
    return onLoginModalSubmit(requestParams, username);
}
}).then(function(confirm) {
    if (confirm.label == i18n.getMessage("OK")) {
        deferred.resolve(serializedUser);
    } else {
        deferred.reject();
    }
});

return deferred.promise;
}

function onLoginModalSubmit(requestParams, username) {
    // (1) call login service to verify auth
    // (2) verify same user
    return $q(function(resolve, reject) {
        var errorMessage = null;
        if(!requestParams.username || requestParams.username.trim() === "") {
            errorMessage = i18n.getMessage("User name or password invalid");
        } else if(requestParams.username !== username) {
            errorMessage = i18n.getMessage("Attempted to authenticate as a different user");
        }

        if(!errorMessage || errorMessage === "") {
            spAuthentication.validateCreds(requestParams.username,
            requestParams.password).then(function(res) {
                resolve({status: res.success, errorMessage: res.message});
            });
        } else {
            resolve({status: !errorMessage || errorMessage === "", errorMessage: errorMessage});
        }
    });
}
function openExternalAuthModal(requestParams) {
    var deferred = $q.defer();

    var options = {
        title: i18n.getMessage("Approver authentication"),
        message: '',
        messageOnly: false,
        errorMessage: '',
        input: false,
        label: '',
        size: 'lg',
        value: '',
        required: false,
        footerStyle: {border: 'none', 'padding-top': 0},
        values: false,
        onSubmit: null,
        widget: 'simpleloginui',
        widgetInput: {},
        shared: requestParams,
        buttons: [{label: i18n.getMessage('Cancel'), cancel:true}]
    };

    var widgetURL = spUtil.getWidgetURL(options.widget);
    $http.post(widgetURL, options.widgetInput).success(function(response) {
        options.widget = response.result;
        options.widget.options.shared = options.shared;
        var modal = $uibModal.open(
            templateUrl:'sp-modal.html',
            controller: spModalCtrl,
            size: options.size,
            resolve: {
                options: function() {
                    return options;
                }
            }
        ));
    });

    deferred.resolve(modal);
}

return deferred.promise;
Enable external user self-registration for Service Portal

Enable external users to register to a ServiceNow app through Service Portal.

Before you begin
Complete the previous tasks:

1. Activate External User Registration
2. Configure the registration form for an external user configuration

Role required: admin

About this task
External user self-registration enables a large group of users to register to a ServiceNow app without the help of an administrator. For more information, see Enable external users to self-register to your ServiceNow instance.

Procedure

1. Navigate to Service Portal > Portals.
2. Open a portal record.
3. On the form, fill in the External user registration configuration field.
   Select a user registration configuration.
4. Click Update.
Results
The login widget includes a link to the registration form that you previously configured.

Register your PIV/CAC card for Service Portal login

Register your Personal Identity Verification (PIV) or Common Access Card (CAC) card so that you can log in to your organization's portal without entering a password.

Before you begin
To register your PIV/CAC card, an administrator must activate certificate-based authentication and then set up PIV/CAC authentication. For more information on this setup process, see Personal Identity Verification (PIV) card or Common Access Card (CAC) based authentication.

The following task assumes that you have a card reader connected to your system.
Role required: none

**Procedure**

1. Log in to a portal using your user name and password.
2. In the portal, open your user profile.
3. Insert your PIV/CAC card into a card reader and then select **Register your client certificate**.

4. In the dialog box that appears, review the PIV/CAC certificate and then select **Register**.
If the registration is successful, the system provides the following alert message:

The PIV/CAC certificate has been successfully registered and linked to the user account.

Close the dialog box to finish.

Results
The next time you log in to your portal, you can log in using your PIV/CAC card. To log in, insert your PIV/CAC card into a card reader and then select **Login with PIV/CAC card**.
To log out of the portal, select your avatar and then select **Logout**. Then, close the browser window.

**Related information**

- Login widget

**Service Portal SCSS Primer**

SCSS is a subset of the Syntactically Awesome StyleSheets (Sass) specification and is an extension of CSS. Every valid CSS style sheet is valid SCSS.
**SCSS variables**

SCSS variables are a way to store information that you want to reuse throughout your style sheet. You can store things like colors, font stacks, or any CSS value you think you want to reuse. SCSS uses the $ symbol to make something a variable.

SCSS supports the follow data types:

- Numbers (including units)
- Strings (with quotes or without)
- Colors (name, or names)
- Booleans

Variables can also be arguments to or results from one of several available functions or mixins. During translation, the values of the variables are inserted into the output CSS document.

For example:

```plaintext
$font-stack:    Helvetica, sans-serif;
$primary-color: #333;

body {
    font: 100%$font-stack;
    color: $primary-color;
}
```

For more information on Sass, see the [Sass/SCSS reference](#).

**SCSS functions**

List of functions for Service Portal SCSS compiler.

**RGB functions**

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>rgb($red, $green, $blue)</td>
<td>Creates a Color from red, green, and blue values.</td>
</tr>
<tr>
<td>rgba($red, $green, $blue, $alpha)</td>
<td>Creates a Color from red, green, blue, and alpha values.</td>
</tr>
<tr>
<td>red($color)</td>
<td>Gets the red component of a color.</td>
</tr>
<tr>
<td>green($color)</td>
<td>Gets the green component of a color.</td>
</tr>
</tbody>
</table>
### Function Description

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>blue($color)</td>
<td>Gets the blue component of a color.</td>
</tr>
<tr>
<td>mix($color1, $color2, [$weight])</td>
<td>Mixes two colors together.</td>
</tr>
</tbody>
</table>

### HSL functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>hsl($hue, $saturation, $lightness)</td>
<td>Creates a Color from hue, saturation, and lightness values.</td>
<td>Yes</td>
</tr>
<tr>
<td>hsla($hue, $saturation, $lightness, $alpha)</td>
<td>Creates a Color from hue, saturation, lightness, and alpha values.</td>
<td>Yes</td>
</tr>
<tr>
<td>hue($color)</td>
<td>Gets the hue component of a color.</td>
<td>Yes</td>
</tr>
<tr>
<td>saturation($color)</td>
<td>Gets the saturation component of a color.</td>
<td>Yes</td>
</tr>
<tr>
<td>lightness($color)</td>
<td>Gets the lightness component of a color.</td>
<td>Yes</td>
</tr>
<tr>
<td>adjust-hue($color, $degrees)</td>
<td>Changes the hue of a color.</td>
<td>Yes</td>
</tr>
<tr>
<td>lighten($color, $amount)</td>
<td>Makes a color lighter.</td>
<td>Yes</td>
</tr>
<tr>
<td>darken($color, $amount)</td>
<td>Makes a color darker.</td>
<td>Yes</td>
</tr>
<tr>
<td>saturate($color, $amount)</td>
<td>Makes a color more saturated.</td>
<td>Yes</td>
</tr>
<tr>
<td>desaturate($color, $amount)</td>
<td>Makes a color less saturated.</td>
<td>Yes</td>
</tr>
<tr>
<td>grayscale($color)</td>
<td>Converts a color to grayscale.</td>
<td>Yes</td>
</tr>
<tr>
<td>complement($color)</td>
<td>Returns the complement of a color.</td>
<td>No</td>
</tr>
<tr>
<td>invert($color)</td>
<td>Returns the inverse of a color.</td>
<td>No</td>
</tr>
</tbody>
</table>
### Opacity functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>alpha($color)</td>
<td>Gets the alpha component (opacity) of a color.</td>
<td>Yes</td>
</tr>
<tr>
<td>opacity($color)</td>
<td>Gets the alpha component (opacity) of a color.</td>
<td>Yes</td>
</tr>
<tr>
<td>rgba($color, $alpha)</td>
<td>Changes the alpha component for a color.</td>
<td>Yes</td>
</tr>
<tr>
<td>opacify($color, $amount)</td>
<td>Makes a color more opaque.</td>
<td>No</td>
</tr>
<tr>
<td>fade-in($color, $amount)</td>
<td>Makes a color more opaque.</td>
<td>No</td>
</tr>
<tr>
<td>transparentize($color, $amount)</td>
<td>Makes a color more transparent.</td>
<td>No</td>
</tr>
<tr>
<td>fade-out($color, $amount)</td>
<td>Makes a color more transparent.</td>
<td>No</td>
</tr>
</tbody>
</table>

### Other color functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>adjust-color()</td>
<td>Increases or decreases one or more components of a color.</td>
<td>Yes</td>
</tr>
<tr>
<td>scale-color()</td>
<td>Fluidly scales one or more properties of a color.</td>
<td>Yes</td>
</tr>
<tr>
<td>change-color()</td>
<td>Changes one or more properties of a color.</td>
<td>No</td>
</tr>
<tr>
<td>ie-hex-str()</td>
<td>Converts a color into the format understood by IE filters.</td>
<td>No</td>
</tr>
</tbody>
</table>
## String functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>unquote($string)</td>
<td>Removes quotes from a string.</td>
<td>Yes</td>
</tr>
<tr>
<td>quote($string)</td>
<td>Adds quotes to a string.</td>
<td>Yes</td>
</tr>
<tr>
<td>str-length($string)</td>
<td>Returns the number of characters in a string.</td>
<td>No</td>
</tr>
<tr>
<td>str-insert($string, $insert, $index)</td>
<td>Inserts $insert into $string at $index.</td>
<td>No</td>
</tr>
<tr>
<td>str-index($string, $substring)</td>
<td>Returns the index of the first occurrence of $substring in $string.</td>
<td>No</td>
</tr>
<tr>
<td>str-slice($string, $start-at, [$end-at])</td>
<td>Extracts a substring from $string.</td>
<td>No</td>
</tr>
<tr>
<td>to-upper-case($string)</td>
<td>Converts a string to upper case.</td>
<td>No</td>
</tr>
<tr>
<td>to-lower-case($string)</td>
<td>Converts a string to lower case.</td>
<td>No</td>
</tr>
</tbody>
</table>

## Number functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>percentage($number)</td>
<td>Converts a unitless number to a percentage.</td>
<td>Yes</td>
</tr>
<tr>
<td>round($number)</td>
<td>Rounds a number to the nearest whole number.</td>
<td>Yes</td>
</tr>
<tr>
<td>ceil($number)</td>
<td>Rounds a number up to the next whole number.</td>
<td>Yes</td>
</tr>
<tr>
<td>floor($number)</td>
<td>Rounds a number down to the previous whole number.</td>
<td>Yes</td>
</tr>
<tr>
<td>abs($number)</td>
<td>Returns the absolute value of a number.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
A function is a block of code that performs a specific task. Common functions include min(), max(), and random() for numerical operations, and length(), nth(), and set-nth() for list manipulations.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>min($numbers…)</td>
<td>Finds the minimum of several numbers.</td>
<td>Yes</td>
</tr>
<tr>
<td>max($numbers…)</td>
<td>Finds the maximum of several numbers.</td>
<td>Yes</td>
</tr>
<tr>
<td>random([[$limit]])</td>
<td>Returns a random number.</td>
<td>No</td>
</tr>
</tbody>
</table>

**List functions**

Lists in SCSS are immutable. All list functions return a new list rather than updating the existing list in-place.

All list functions work for maps as well, treating them as lists of pairs.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>length($list)</td>
<td>Returns the length of a list.</td>
</tr>
<tr>
<td>nth($list, $n)</td>
<td>Returns a specific item in a list.</td>
</tr>
<tr>
<td>set-nth($list, $n, $value)</td>
<td>Replaces the nth item in a list.</td>
</tr>
<tr>
<td>join($list1, $list2)</td>
<td>Joins two lists into one.</td>
</tr>
<tr>
<td>append($list1, $val)</td>
<td>Appends a single value onto the end of a list.</td>
</tr>
<tr>
<td>zip($lists…)</td>
<td>Combines several lists into a single multidimensional list.</td>
</tr>
<tr>
<td>index($list, $value)</td>
<td>Returns the position of a value within a list.</td>
</tr>
<tr>
<td>list-separator($list)</td>
<td>Returns the separator of a list.</td>
</tr>
</tbody>
</table>

**Adding custom functions**

```scss
@function my-calculation-function($some-number, $another-number)
{ @return $some-number + $another-number }
```

**SCSS nesting**

SCSS lets you nest your CSS selectors in a way that follows the same visual hierarchy of your HTML.

For example:
The `ul`, `li`, and `a` selectors are nested inside the `nav` selector, which is a great way to organize your CSS and make it more readable. When the widget is rendered, the generated CSS looks something like the following code block:

```css
nav { 
  ul { 
    margin: 0;
    padding: 0;
    list-style: none;
  }

  li { display: inline-block; }

  a { 
    display: block;
    padding: 6px 12px;
    text-decoration: none;
  }
}
```

For more information on Sass, see the [Sass/SCSS reference](#).

**SCSS operators**

SCSS has a handful of standard math operators like `+`, `−`, `∗`, `÷`, and `%.

Use simple math to calculate widths for an aside & article. For example:

```css
.container { width: 100%; }

article[role="main"] { 
```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
The generated CSS looks like:

```css
.container {
  width: 100%;
}

article[role="main"] {
  float: left;
  width: 62.5%;
}

aside[role="complementary"] {
  float: right;
  width: 31.25%;
}
```

For more information on Sass, see the [Sass/SCSS reference](#).

**SCSS mixins**

A mixin lets you make groups of CSS declarations that you want to reuse throughout your site. You can pass in values to make your mixin more flexible.

The following code block is an example for border-radius.

```scss
@mixin border-radius($radius) {
  -webkit-border-radius: $radius;
  -moz-border-radius: $radius;
  -ms-border-radius: $radius;
  border-radius: $radius;
}

.box { @include border-radius(10px); }
```

The generated CSS looks like:

```css
.box {
  -webkit-border-radius: 10px;
  -moz-border-radius: 10px;
```
For more information on Sass, see the Sass/SCSS reference.

**Performance Analytics Content Pack for Service Portal**

The Performance Analytics Content Pack for Service Portal enables service delivery executives to improve user engagement with your organization’s portals by tracking the usage of portals in preconfigured indicators and data visualizations.

To enable the Performance Analytics Content Pack for Service Portal, install the content pack from the ServiceNow Store. Purchasing a subscription to the licensed Performance Analytics is required to install the content pack.

After you enable the content pack, you can access the Service Portal dashboard by navigating to **Performance Analytics > Dashboards**. From the dashboard picker, open the Service Portal Usage dashboard.

Assign the pa_viewer role to users who need to view the dashboard. You must have the sp_admin or admin role to edit the dashboard.

The Service Portal Usage dashboard includes the following tabs:

- Overview
- Visitors
- Views
- Searches

You can view reports by selecting options in the interactive filter based on the Service Portal and the Service Portal User Country. The statistics provided in each tab change based on the options selected in the interactive filter.

**Overview tab**

The Overview tab displays the following widgets:

<table>
<thead>
<tr>
<th>Widget</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Searches</td>
<td>Total number of user searches today.</td>
</tr>
<tr>
<td>Average Click-Through Rate</td>
<td>Average number of searches that have resulted in a click today.</td>
</tr>
<tr>
<td>Widget</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Average Click Rank</td>
<td>Average position of clicked items in a search result list today. A lower value means a higher position on the search result list.</td>
</tr>
<tr>
<td>Visitors vs Views</td>
<td>Comparison of three metrics:</td>
</tr>
<tr>
<td></td>
<td><strong>Visitors</strong></td>
</tr>
<tr>
<td></td>
<td>Total number of unique visitors per week.</td>
</tr>
<tr>
<td></td>
<td><strong>Pages per Visitor</strong></td>
</tr>
<tr>
<td></td>
<td>Number of unique views by a unique visitor per week.</td>
</tr>
<tr>
<td></td>
<td><strong>Page views</strong></td>
</tr>
<tr>
<td></td>
<td>Total number of unique views per week.</td>
</tr>
<tr>
<td>Top Portals by Page Views</td>
<td>Weekly ranking of portals by the number of unique views.</td>
</tr>
<tr>
<td></td>
<td><strong>Name</strong></td>
</tr>
<tr>
<td></td>
<td>Name of the portal.</td>
</tr>
<tr>
<td></td>
<td><strong>Week</strong></td>
</tr>
<tr>
<td></td>
<td>Number of unique views each week.</td>
</tr>
<tr>
<td></td>
<td><strong>Change %</strong></td>
</tr>
<tr>
<td></td>
<td>Percentage of change in the number of unique views since last week.</td>
</tr>
<tr>
<td></td>
<td><strong>Trend</strong></td>
</tr>
<tr>
<td></td>
<td>Visualization of how the number of unique views has changed over the course of the last month.</td>
</tr>
<tr>
<td></td>
<td><strong>Distribution</strong></td>
</tr>
<tr>
<td></td>
<td>Visualization of the number of unique views in relation to other portals in your instance. A full bar means that the portal has the highest number of unique views.</td>
</tr>
</tbody>
</table>
Visitors tab

The Visitors tab displays the following widgets:

<table>
<thead>
<tr>
<th>Widget</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visitors - Last 7 Days</td>
<td>Total number of unique visitors in the last week.</td>
</tr>
<tr>
<td>Visitors</td>
<td>Number of unique visitors each day, over the course of the last week.</td>
</tr>
<tr>
<td>Top Pages by Unique Visitor</td>
<td>Daily ranking of pages by number of unique visitors.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the page.</td>
</tr>
<tr>
<td>Day</td>
<td>Number of unique visitors each day.</td>
</tr>
<tr>
<td>Change %</td>
<td></td>
</tr>
<tr>
<td>Widget</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Percentage of change in number of unique visitors since yesterday.** | **Trend**  
Visualization of how the number of unique visitors has changed over the course of the last week. | **Distribution**  
Visualization of the number of unique visitors in relation to other pages. A full bar means that the page has the highest number of unique visitors. |

### Views tab

The Views tab displays the following widgets:
<table>
<thead>
<tr>
<th>Widget</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Views - Last 7 Days</td>
<td>Total number of portal views in the last week.</td>
</tr>
<tr>
<td>Views</td>
<td>Number of portal views each day, over the course of the last week.</td>
</tr>
<tr>
<td>Top Pages by Views</td>
<td>Daily ranking of pages by the number of unique views.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the page.</td>
</tr>
<tr>
<td>Day</td>
<td>Number of unique views each day.</td>
</tr>
<tr>
<td>Change %</td>
<td>Percentage of change in number of unique views since yesterday.</td>
</tr>
<tr>
<td>Trend</td>
<td>Visualization of how the number of unique views has changed over the course of the last week.</td>
</tr>
<tr>
<td>Distribution</td>
<td>Visualization of the number of unique views in relation to other pages. A full bar means that the page has the highest number of unique views.</td>
</tr>
</tbody>
</table>
The Searches tab displays the following widgets:

<table>
<thead>
<tr>
<th>Widget</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Click Rank</td>
<td>Average position of clicked items in a search result list today. A lower value means a higher position on the search result list.</td>
</tr>
<tr>
<td>Average Click-Through Rate</td>
<td>Average number of searches that have resulted in a click today.</td>
</tr>
<tr>
<td>User who Searched</td>
<td>Number of users who searched the portal today.</td>
</tr>
<tr>
<td>Click Rank Distribution</td>
<td>Number of clicks within each click rank today.</td>
</tr>
<tr>
<td>Searches</td>
<td>Total number of user searches today.</td>
</tr>
</tbody>
</table>
Breakdowns
To analyze data according to different categories, select a breakdown from the dashboard menu:

- Service Portal
- Service Portal Page
- Service Portal User Country
- Click Rank Distribution

For more information on analyzing data with breakdowns, see Using breakdowns on dashboards.

User Experience Analytics for Service Portal
Visualize metrics and interactions to better understand the Service Portal user experience and identify how to improve it.
User Experience Analytics for Service Portal provides dashboard views for monitoring the key performance indicators (KPIs) of web applications built on Service Portal. You can use these insights to optimize your portal.

For example, User Experience Analytics tracks when a user orders a catalog item or views a knowledge article. You can use this data to infer which items or articles are the most popular among users.

For more information on user-triggered events that are tracked automatically, see Service Portal events.

**Getting started**

1. **Request User Experience Analytics for Service Portal**

   To activate User Experience Analytics for Service Portal, request the Service Portal Analytics plugin (com.glide.service-portal.analytics) through the Now Support Customer Service system.

2. **Create User Experience Analytics settings**

   Turn on user analytics tracking for Service Portal so that you can monitor key performance indicators in the Analytics Dashboard.

**User consent**

ServiceNow has provided template notices that are presented to users depending on their geographic region. Customers should review these notices and confirm they are in accordance with applicable law before they are presented to users (as per our Data Processing Addendum). Customers may tailor the specific options for how these notices are presented to users (including the specific wording). For more information on changing the wording, see Modify user consent text.
When launching the application for the first time, European users are prompted to select whether to consent to analytics tracking. US users are automatically opted-in for tracking, by default. Non-EU/non-US users see a notice of enabled analytics tracking.

Pop-up for EU users

Enable Analytics

Help Optimize this ServiceNow App. We are working to improve our user experience by tracking your in-app activity, including your interaction with our app, to improve performance and user experience.

For more details of how we use your information see: Privacy Statement

No Yes

Pop-up for non-EU/non-US users

Enable Analytics

We are working to improve our user experience by tracking your in-app activity, including your interaction with our app, to improve performance and user experience.

For more details of how we use your information see: Privacy Statement

Agree

To disable this pop-up, set the glide.analytics.user.consent.popup.disabled system property to true.

Next steps

After you set up User Experience Analytics for Service Portal, you are ready to start tracking portal usage in the analytics dashboard.

You can view user analytics tracking for the portal by navigating to User Experience Analytics > Dashboard.

For more information on using the dashboard, see Overview of the Dashboard.

Related information

User Experience Analytics
Request User Experience Analytics for Service Portal

To activate User Experience Analytics for Service Portal, request the Service Portal Analytics plugin (com.glide.service-portal.analytics) through the Now Support Customer Service system.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. On the All Applications page, click **Request Plugin** to open the Request form on HI.

3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. On the form, fill in the fields.
Activate Plugin request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

5. Click **Submit**.

Create User Experience Analytics settings

Turn on user analytics tracking for Service Portal so that you can monitor key performance indicators in the Analytics Dashboard.

**Before you begin**
Get the Service Portal Analytics plugin (com.glide.service-portal.analytics) by submitting a request in Now Support. For more information, see Request User Experience Analytics for Service Portal.

Role required: portal_analytics_admin
Procedure

1. Navigate to **Service Portal > Portals**.
2. Open the record for the base system Service Portal.
3. On the portal form, click **Create Analytics Settings**.

![Portal Form](image)

4. Review the User Experience Analytics Settings form. Optionally, to track users who use your portal without logging in, select the **Enable Unauthenticated User Tracking** field.

![Analytics Settings Form](image)

5. Click **Update**.

Results

An entry for your portal is added to the User Experience Analytics Settings [sys_analytics_bucket] table. You can review this entry by clicking **View SP Analytics Settings** on the portal record. You can review the table by navigating to **User Experience Analytics > Settings**.

You can view user analytics tracking for the portal by navigating to **User Experience Analytics > Dashboard**.
For more information on using the dashboard, see *Overview of the Dashboard.*

**What to do next**
If you selected to enable unauthenticated user tracking, you may be required by law to notify unauthenticated users that you are tracking their usage for analysis. You can display a legal notice by activating the Privacy Notice announcement, which is inactive by default. For more information, see *Activate the privacy notice for unauthenticated users.*

**Activate the privacy notice for unauthenticated users**
If you enabled unauthenticated user tracking in your portal, you may be required by law to notify unauthenticated users that you are tracking their usage for analysis. You can display a legal notice by activating the Privacy Notice announcement.

**Before you begin**
Complete the previous tasks:

1. Request User Experience Analytics for Service Portal
2. Create User Experience Analytics settings

Role required: sp_admin

**Procedure**
1. Navigate to *Service Portal > Announcements* and open the inactive record named *Privacy Notice.*
2. Review the form.
Privacy Notice announcement form

You can modify the default text of the Summary field or leave it as-is.

By default, the Unauthenticated only option is selected to display the announcement only to users who haven't logged in to the portal. The announcement disappears after the user logs in.

3. In the Portals section, select a portal in which to display the announcement.

Note: The Privacy Notice announcement appears only in portals for which you’ve created User Experience Analytics settings.

4. Activate the announcement by selecting the Active option.

5. Click Update.

Results
The Privacy Notice announcement is displayed to unauthenticated portal users.
Privacy Notice example

Notice
We use cookies and related technologies to improve your browsing experience, analyze individualized usage and website traffic, tailor content to your preferences, and make your interactions with this website more meaningful. More information can be found in our privacy policy.

Related information

Create an announcement

Modify user consent text

Modify the text that appears in the pop-up requesting user consent.

Before you begin
Role required: admin

Procedure

Modify the relevant user consent text.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Modify the consent text for EU users | a. Navigate to System UI > Messages.  
b. Find and open the glide.analytics.consent.eu.text record.  
c. Update the Message field.  
d. Click Update. |
**Modify the consent text for non-EU/non-US users**

- Navigate to **System UI > Messages**.
- Find and open the `glide.analytics.consent.other.text` record.
- Update the **Message** field.
- Click **Update**.

**Service Portal events**

View Service Portal events to get insight into how a portal is being used in your organization.

User Experience Analytics automatically detects the gestures and actions of portal users. You can view each occurrence of these events on the Analytics Dashboard.

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submit Catalog Request</td>
<td>Tracks when a user submits a request through the SC Catalog Item widget. You can view the request ID and the number of items in each request. Use these analytics to optimize the Service Catalog.</td>
</tr>
<tr>
<td>Order Catalog Item</td>
<td>Tracks when a user orders a catalog item through the SC Catalog Item widget. You can view the name and ID of each ordered item. You can also view the associated request ID. Use these analytics to optimize the Service Catalog.</td>
</tr>
<tr>
<td>Submit Record Producer Request</td>
<td>Tracks when a user submits a request through any record producer. Use these analytics to optimize the Service Catalog.</td>
</tr>
<tr>
<td>View Knowledge Article</td>
<td>Tracks when a user views a knowledge article. You can view the name, ID, and language of each viewed article. Use these analytics to optimize the knowledge base.</td>
</tr>
<tr>
<td>Initiate Search</td>
<td>Tracks when a user searches the portal using the Faceted Search and Typeahead Search widgets. You can view the search keywords that users enter. You can also compare usage of the two search widgets.</td>
</tr>
<tr>
<td>Event</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Search Result Selected</td>
<td>Tracks when a user selects a search result when using the Faceted Search widget. You can view the click rank and sys_id of the selected search item. Use these analytics to improve search in Service Portal.</td>
</tr>
<tr>
<td>Successful Login</td>
<td>Tracks when a user logs in to Service Portal. Use these analytics to monitor login activity within a given time period.</td>
</tr>
</tbody>
</table>

You can create custom events to be triggered. For more information, see SNAnalytics - Client

**Related information**

- SC Catalog Item widget
- Faceted Search widget
- Typeahead Search widget

**User Experience Analytics roles**

Designate people in your organization to use and configure User Experience Analytics for Service Portal.

The portal_analytics_admin and portal_analytics_viewer roles are installed with the Service Portal Analytics plugin (com.glide.service-portal.analytics).

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| User Experience Analytics Admin [analytics_admin] | Administrators:  
• can view the **Dashboard** link and settings within User Experience Analytics in the application navigator.  
• can control the User Experience Analytics settings for each mobile application and portal. | • web_analytics_admin  
• mobile_analytics_admin  
• analytics_viewer |
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| User Experience Analytics Viewer [analytics_viewer] | Users with this role can view the **Dashboard** link within User Experience Analytics in the application navigator, and have viewer role permissions for User Experience Analytics.                                      | • web_analytics_viewer  
• mobile_analytics_viewer |
| Mobile Analytics Admin [mobile_analytics_admin] | Administrators:  
• can view the **Analytics Dashboard** link and settings within Mobile Analytics in the application navigator.  
• can control the Mobile Analytics settings for each mobile application.  
• have **admin** role permissions to be able to create funnel and cohort reports from the Analytics Dashboard. | • mobile_analytics_viewer |
<p>| Mobile Analytics Viewer [mobile_analytics_viewer] | Users with this role can view the <strong>Analytics Dashboard</strong> link within Mobile Analytics in the application navigator, and have viewer role permissions for Mobile Analytics.                                    | • None                                           |</p>
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Web Analytics Admin [web_analytics_admin] | Administrators:  
  • can view the **Analytics Dashboard** link and settings within User Experience Analytics in the application navigator.  
  • can control the User Experience Analytics settings for each web application.  
  • have **admin** role permissions to be able to create funnel and cohort reports from the Analytics Dashboard. | • web_analytics_viewer  
• portal_analytics_admin                                                                 |
| Web Analytics Viewer [web_analytics_viewer] | Users with this role can view the **Analytics Dashboard** link within User Experience Analytics in the application navigator, and have viewer role permissions for web application analytics. | • portal_analytics_viewer |
| Portal Analytics Admin [portal_analytics_admin] | Administrators:  
  • can view the **Analytics Dashboard** link and settings within **Service Portal > Analytics** in the application navigator. | • portal_analytics_viewer |
### Role title [name]

### Description

- can create User Experience Analytics settings for Service Portal.

### Contains roles

• None

| Portal Analytics Viewer [portal_analytics_viewer] | Users with this role can view the Analytics Dashboard link and settings within Service Portal > Analytics in the application navigator, and have viewer role permissions for portal metrics in the User Experience Analytics Dashboard. |

## Related properties

Use system properties to configure User Experience Analytics for Service Portal.

**glide.analytics.tracking.force_allowed.portals**

Disables the user consent pop-up for specified portals. This property overrides the `glide.analytics.user.consent.popup.disabled` property. You specify a portal by pasting its sys_id in the Value field. To specify multiple portals, enter a comma-separated list with no spaces. To disable the pop-up in all portals, configure the `glide.analytics.user.consent.popup.disabled` property.

- Type: string
- Default value: none

**glide.analytics.tracking.restricted.portals**

Disables user analytics tracking for specified portals. This property overrides the `glide.sp.analytics.enabled.portals` property. You specify a portal by pasting its sys_id in the Value field. To specify multiple portals, enter a comma-separated list with no spaces.

- Type: string
- Default value: none

**glide.analytics.user.auto.consent**
Allows user analytics tracking for all users when the user consent pop-up is disabled.

- Type: true | false
- Default value: true

**glide.analytics.user.consent.popup.disabled**

Disables pop-up for getting user consent.

- Type: true | false
- Default value: false

**glide.sp.analytics.enabled.portals**

Enables user analytics tracking for specified portals. By default, tracking is enabled for the base system Service Portal.

- Type: string
- Default value: 81b75d3147032100ba13a5554ee4902b

Related information

- Add a system property
- Unique record identifier (sys_id)

**Skills Management**

Use Skills Management to associate skills with individual users or groups and assign them to tasks or projects. You can also assess the skills needed for your organization, identify gaps, and implement effective plans for hiring or training of your teams.

Skills can contain other skills. For example, if you define network as a skill, you can add router as the skill it contains. A user assigned to a parent skill grants access to a child skill. Once a skill is assigned to a group, all members of the group inherit that skill and any others contained within it. Skills management works similar to ServiceNow platform role management.

Using this application, you can:

- Manage skills for agents and your employees from a central location.
- Use a standard way to identify skills for your organization and keep them up to date.
- Group skills into categories and define skill levels to track the expertise of your resources at a granular level.
• Reduce task or project reassignments by assigning tasks to agents and projects to teams that have the right skills to work on those items.
• Identify skill gaps and resolve them by implementing effective plans for coaching and training of resources.
• Manage the effectiveness of your team by evaluating the skills your team has and determining the skills you need for on your projects.

Integration with ServiceNow® applications

A skill is an ability to do something that comes from training, experience, and practice. As a system administrator, you can define skills for your organization and assign it to users and groups from a central location. As an application manager, you can assign users to tasks based on these skills. For example, if you are an IT manager, you can use the Skills Management application to define skills for your agents and assign those agents to resolve incidents using the ITSM application.

Group skills into categories and define skill levels to standardize skill implementation across your organization.

Use skills from the centralized location in the following applications:

• IT service management As an IT manager, reduce your time and costs while resolving incidents by assigning work items to the right agent. Assess the skill gaps that agents have in your team and coach or train agents based on those needs. Identify and define a standard way to keep skill categories and levels consistent within your team.
• **Customer service management** As a customer service manager, identify agent skills and automatically route tasks to agents who have the required skill to work on those tasks. Manage your team's effectiveness by understanding what type of skills your employees need to get hired or get trained to take on other roles.

• **Field service management** As a field service or customer service manager, use rules to identify skills and skill levels that agents require to resolve work items such as cases, work order tasks, and agent interactions. Automate skill assignment to reduce a manager's work load. Automatically assign tasks to agents using Field Service dynamic scheduling.

• **Human resources management** As an HR manager, identify the types of skills your organization needs and make hiring decisions based on those needs. Manage your team's effectiveness by understanding what type of skills your employees need to get hired or get trained to take on other roles.

• **Project portfolio management** As a project and portfolio manager, standardize how you categorize skills, define skill level types, and add skill levels for your team. Set up skills for your team in a central location and make them available within your team. Prevent project reassignments by assigning projects to the team members who have the right skills to work on them.

### Roles used in Skills Management

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
</table>
| Skill administrator [skill_admin] | - Inherits the skill manager [skill_manager] and skill user [skill_user] roles.  
                        - Can perform create, read, update, and delete (CRUD) operations on skills, skill levels, skill level types, skill categories, and sub categories. |
| Skill manager [skill_manager] | - Inherits the skill user [skill_user] role.  
                          - Can perform read operations on skills, skill levels, skill level types, skill categories, and sub categories.  
                          - Can assign skills to users and groups. |
| Skill user [skill_user] | Can perform read operations on skills, skill levels, skill level types, skill categories, and sub categories. |
Activating Skills Management
The Skills Management application is activated when you enable the Skills Management (com.snc.skills_management) plugin.

Configuring skills
Create skills, identify the type of skill level it belongs to and associate skill levels for each type to define skills for your users consistently across your organization and be able to assign resources accordingly. For example, you can add French as a skill, language as the skill level type, and familiar, proficient, and expert as the skill levels.

Identify all skills you currently have and would need across your organization to begin implementing skills. For example, if you are in Customer Service, you might have agents who have Java as a technical skill and you might need agents who have experience in network administration. If you are in Human Resources, you may have employees who have coaching as a skill and you might need employees who can get new hires on board.

Associate each skill you have identified with a skill level type. For example, you could associate Java with programming as the skill level type and coaching with leadership as the skill level type.

Define skill levels for each type you have identified. As an example, you could use familiar, proficient, and expert as skill levels for the Java skill level type and beginner, intermediate, and advanced as the skill levels for the coaching skill level type.

Define the skill taxonomy
Organize related skills into categories and subcategories so that you can manage skills and create reports quickly and efficiently.

Before you begin
Role required: skill_admin

About this task
A skill category can contain parent and child categories that together create a category hierarchy. You can add skills to the lowest category in the hierarchy. You can build your skill taxonomy from scratch or use the sample data provided with your application.
**Procedure**

1. Navigate to **Skills > Skill Taxonomy**.
2. In the **Skills Categories** list, click **New**.
3. In the **Name** field, enter a unique name for the category.
4. **Optional:** In the **Parent** field, select a parent category.
5. Right-click the form header and click **Save**. The category is added to the **Category Hierarchy**.
6. Do one of the following:

<table>
<thead>
<tr>
<th>To add</th>
<th>Do this</th>
</tr>
</thead>
</table>
| **Subcategories** | • In the **Child Categories** related list, click **New**.  
• In the **Name** field, enter a unique name for the category. |
| **Skills** | • Select the **Add Skills** check box.  
• Right-click the form header and click **Save**. |
To add | Do this
--- | ---
- In the **Skills** related list, click **New**.
- In the **Name** field, enter the name of the skill.

7. Click **Submit**.

**Create skill categories using sample data**

Onboard your team quickly using the skill taxonomy framework provided with your application.

**Before you begin**

Role required: skill_admin

**About this task**

The sample data provides 150 records that you can use to get started building your skill taxonomy.

**Procedure**

1. **Activate** the Skills Library Data for Skills Management (com.snc.skills_management.seed_data) plugin.

2. Navigate to **Skills > Skill Taxonomy**.

3. In the **Skill Categories** list, review each category and set the **Add skills** field to **true** for all skill categories you want to add to your application.

**Define a skill level type**

Define skill levels (for example, beginner, intermediate, advanced) for different skill level types (for example, a language or an IT certification) so you can associate skill levels to users and define skill levels and types required for tasks.

**Before you begin**

Role required: skill_admin or admin

**Procedure**

1. Identify skill level types.

   You can group skills that belong to the same category into a skill level type. For example, you could use language as the skill level type if Japanese and French are defined as skills. Take an inventory of every type of skill your organization needs.

2. Add skill level types, define skill levels, and associate them with a skill level type.
After you add a skill level type, you can define different levels for that type of skill. For example, if you add language as a type of skill, you can associate familiar, proficient, and expert as skill levels. When you select French, for example, as a skill for a user, you will be able to define the user’s skill level for French as either familiar, proficient, or expert.

**a.** Navigate to **Skills > Skill Level Types**.

**b.** Click **New**.

c. Enter a name and description for the skill level type, and then right-click the form and click **Save**.

d. Associate skill levels with this skill type.

By default, skill level types are associated with the **Default** skill level and have a value of 1. You can change the name and value for this default skill level. The value is used to measure skill gaps. For example, if you give a value of 10 for a skill level defined as proficient and a value of 25 for a skill level defined as expert, when you create a skill report to measure gaps, you will see a value of 15 as a measure for the skill gap.

3. Click **Submit**.

**Example:**

This example shows a system administrator creating the skill level type Language, adding the skill level Proficient to that type, and associating a value for the level.
Add a skill
Create skills to specify the competencies of your users and associate them with users, and configuration items so you can.

Before you begin
Role required: skill_admin or admin

Procedure
1. Identify skills.
   Take an inventory of all skills you currently have and would need across your organization. For example, if you are using Customer Service, you may have agents who have Java as a technical skill and you may need agents who have experience in network administration. If you are using Human Resources, you may have employees who have coaching as a skill and you may need employees who can get new hires on board.

2. Add skills.
   You can associate each skill with other skills, users, or configuration items. You can assign users to tasks or projects, or identify employees with specific skills using these associations.
   
   a. Navigate to Skills > All Skills.
   
   b. Click New.
   
   c. Enter a name and description for the skill and then right-click the form and click Save.
   
   d. If you want to associate subskills with the skill, click the Contains Skills tab and create a new skill or add an existing skill as a subskill. The subskill is automatically inherited by the user or group that contains the associated skill.
   
   e. Specify skills for users by clicking the Users tab and creating a new user for the skill or adding existing users.
   
   f. Associate the skill with configuration items by clicking the Model tab and adding one or more configuration items.

3. Click Update.
Managing skills

Manage skill assignment efficiently by simultaneously assigning a skill to multiple users or multiple skills to multiple users. Assign your agents to tasks and teams to projects based on skills.

Assign IT skills to users

Assign IT skills and skill levels to users to facilitate the automatic assignment of skill-based tasks to agents.

Before you begin
Role required: skill_manager or skill_admin

About this task
Only skill administrators can create or edit skills. Skill managers can assign skills to users.

Procedure
1. Navigate to Skills > Manage IT Skills.
2. Do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Add a skill to a user | a. Click New Skill.  
b. In the Skill field, enter a name for the skill.  
c. In the Level Type field, select the type to which the skill belongs. |
| Assign a skill to multiple users | a. From the All Skills list, select a skill.  
b. Click Assign/Remove Users.  
c. Select the name of each user you want to assign this skill.  
d. From the list, select the level for this skill for each user.  
e. Click Assign/Remove Users again to assign the skill and skill level to the users. To remove the assigned skill, select the name of the user and clear the check box for the skill. |
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| **Assign multiple skills to multiple users** | **a.** From the All Users list, select a user.  
**b.** From the Skill list, select each skill and the skill level to assign for this user.  
**c.** Repeat the steps above for all users you would like assign multiple skills and associated skill levels. |

**Example:**  
In this example, a system administrator assigns the skill **iPhone** to multiple users and adds a skill level for each user.
In this example, a system administrator assigns multiple skills and associated skill levels to multiple users.

**Associate skills with users and groups**

Add skills to users and groups and effectively assign users to tasks and teams to projects.

**Before you begin**

Role required: skill_manager

**About this task**

Users automatically inherit a skill contained within a skill. Members of a group inherit all skills assigned to the group.

**Procedure**

1. Perform one of the following actions:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| **Assign a skill to a user** | a. Navigate to **Skills > User Skills**.  
  b. Click **New**.  
  c. In the **Skill** field, click the lookup icon and select a skill.  
  d. In the **User** field, click the lookup icon and select a user. |
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Assign a skill to a group | a. Navigate to Skills > Group Skills.  
b. Click New.  
c. In the Skill field, click the lookup icon and select a skill.  
d. In the Group field, click the lookup icon and select a group. |

2. Optional: In the **Skill level** field, click the lookup icon and select a level for the selected skill.

3. Optional: If the skill level is inherited, enable the **Skill level inherited** check box. You must configure the form to display the **Skill level** field and **Skill level inherited** check box.

4. Click **Submit**.

**Associating skills with work items**

Assign skills to tasks manually or use rules to associate them automatically to work items such as cases, tasks, or chat interactions.

The video below shows an overview of how skills are automatically added to work items.

**Skill-based routing**

**Assign skills to tasks**

Add skills and the level required for each skill to tasks. Identify whether the skill is mandatory to perform the task.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to incident, problem, change request or any task record to which you want to associate skills.

2. In the related list, select the **Tasks Skills** tab. You must configure the related list and add **Task Skill->Task** to the **Selected** column to display this tab.

3. In the Task Skills table, do the following:
a. In the **Skill** field, click the lookup icon and select a skill.

b. In the **Skill level** field, select a level for the selected skill.

c. In the **Mandatory** field, select **true** if the skill is mandatory for the selected task.

4. Click **Submit**.

**Example:**
The image below shows an administrator configuring skills for an incident task where the user is unable to access the shared folder. It is mandatory for agents working on this task to have familiarity with IT skills.

Using rules to identify skills for work items

Automate the identification of skills required for work items using rules, which eliminates the need to assign them manually.

When you automate skill identification, you prevent task reassignments by assigning agents with the right skills to work on tasks and make time available for agents and managers to work on more important tasks.

You can identify skills using rules for tasks such as cases, work order tasks, incidents, problems, and change requests and also for interactions such as chat, phone, or walk-up experience.

The video below gives you an overview of how skills are added to work items using rules. Skill-based routing
Related information

AWA for CSM overview
Create rules to route and assign customer service cases
Dynamic scheduling

Create rules to assign skills to work items
Create rules to identify skills and automatically associate them to work items.

Before you begin
Role required: skill_admin or admin

About this task
You can automatically add a skill to a case based on the product associated with the case if you enable the Product to Skill mapping table (Skill Required for Model Maintenance [cmn_m2m_skill_model]).

A skill determination rule is created for every new skill required for a work item.

- If a skill is no longer required for a work item, deactivate or remove the rule applied for the work item.
- If two rules have the same skill associated with one work item and one rule evaluates the skill as mandatory and the other rule evaluates it as optional, then the rule that evaluates the skill as mandatory is always used.

Note: If you create a new skill determination rule, you also need to create a corresponding business rule.

Procedure

1. Navigate to Skills > Skill Determination Rules.
2. Click New.
3. In the Name field, enter a name for the rule.
4. Select the Active check box to enable the rule to assign skills to work items.
5. From the Source table drop-down menu, select the work item source table for this rule.
6. Using the condition builder, select the conditions to evaluate the work item.
7. Create the rule.
<table>
<thead>
<tr>
<th>Rule type</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Create a simple rule   | a. From the **Type** drop-down menu, select **Simple**.  
    b. In the **Skills** table, add each skill required for the selected work item.  
    c. If a skill is optional for selected work item, in the **Mandatory** field, select **False**.  
    d. In the **Skill Level** field, add a level for the skill. You must configure the form to display this field.  
    For information about defining skill levels, see                                                                 |
| Create a lookup rule   | a. From the **Type** drop-down menu, select **Lookup**.  
    b. From the **Lookup table** drop-down menu, select the reference table to connect to the source table.  
    The **Skills Field** that connects the source and reference tables is automatically populated.  
    c. If this skill is mandatory, select the **Mandatory** check box.  
    d. From the **Skill Level Field** drop-down menu, select a level for this skill.  
    e. Click **Save**.  
    f. In the **Field Mappings** related list, click **New**.  
    g. From the **Source table field** drop-down menu, select an attribute to map to the reference table.  
    h. From the **Lookup table field** drop-down menu, select an attribute to map to the source table. |
| Create an advanced rule| a. From the **Type** drop-down menu, select **Advanced**.  
    b. In the **Script** window, enter a script.  |

8. Click **Submit**.

**Activate business rules for skill determination**

Enable the business rules to determine skills for cases, work order tasks, and chat interactions that are available in your application.

**Before you begin**

**Role required:** admin
About this task
You can also Create a business rule for tasks such as incidents, problems and change requests to associate skills to those tasks.

Create skill determination rules based on any of the following rule types:

• **Simple**
  Adds skills to work items based on a set of conditions used to evaluate the source table.

• **Lookup**
  Adds skills to work items based on selections from two different tables connected using one or more reference fields.

• **Advanced**
  Adds skills to work items using a script.

Procedure
2. Do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| **Enable the business rules for cases, work order tasks, or chat interactions** | • To create rules for cases, select the **Active** check box in the **Skill determination for case** business rule record.  
  • To create business rules for work order tasks, select the **Active** check box in the **Skill determination for work order task** business rule record.  
  • To create rules for chat interactions, select the **Active** check box in the **Skill determination for interaction** business rule record. |
| **Create business rules for tasks such as incidents, problems, and change requests** |  
  a. Open a case, work order, or chat interaction business rule record.  
  b. Right-click the record and select **Insert and Stay**. |
Routing work items to agents based on skills

Use rules to automatically route work items to agents.
For more information on routing agents to work items, see Advanced work assignments

Qualify and rank users based on skills and skill levels

Rank users so that you can select the right users based on skills needed to complete tasks. Qualify users to work on tasks such as case, work order task, or chat interaction based on the number of skills and skill levels required to work on those tasks.

Before you begin
Role required: skill_admin

About this task
Use the UserSkillAnalyzer API to analyze the skills and skill levels of users and the UserSkillRanking API to rank and assign them to tasks. For example, when you use the Field Service Management application to assign agents to tasks, you can analyze and rank them based on their skills and skill levels using these APIs and use dynamic scheduling to assign them to tasks.

Note: You must add the Matching Skill Level Gap for Dynamic Scheduling criterion to the task filter to rank agents assessed based on skill gaps. For more information on adding this criterion, see Create a task filter

Procedure
1. Analyze the skills and skill levels users have to complete work items using the UserSkillAnalyzer API.
The API performs the following verification to check if users are qualified to be assigned to the work items:
a. If the user has all mandatory skills required to complete the work item, but
does not have the skill level, the agent is not qualified to work on the task if
the skill level is mandatory to work on the task.

b. If the user does not have all mandatory skills required to complete the task,
the agent is not qualified to work on the task.

c. If the user has all skills and the skill levels required to complete the task, the
agent is qualified to work on the task.

d. If the user has all skills required, but not mandatory to complete the task, the
agent is qualified to work on the task.

If the user is qualified to work on the task, the API performs the following
verification to analyze gaps in skill level and the total number of skills the users
have to execute tasks based on the skill requirements for the work item:

a. Verifies if a work item requires a skill that does not have a level type defined.

b. Verifies if a work item requires a skill that has a level type defined but does
not have the skill level defined.

c. Verifies if a work item requires a skill that has the skill level defined, but the
agent does not have the skill level defined. If the skill level is mandatory to
complete the task, the user who does not have those skill levels will not be
assigned to those tasks.

d. Verifies whether a user has all skill levels that are mandatory, but not
optional, to perform a task.

2. Rank users qualified to complete work items using UserSkillRanking API.
The API retrieves a list of qualified users based on matching and mandatory
skills and skill levels.

Related information

Dynamic scheduling

Skills Management dashboard and reporting

Use the Skills Management dashboard to analyze trends in assessing skill gaps in
your organization and plan for coaching or training of your employees based
on needs. Identify users and teams who have the right skills to work on tasks and
projects. The Skills Management dashboard provides comprehensive reports on
skill competencies of users, the tasks that require those skills, and skill gaps you
can address to fulfill your organizational needs.

You can access the dashboard by navigating to Skills > Dashboard.
Overview and Skill Matrix tab

Skill Taxonomy
You can filter these reports based on the skill category and view reports for each category.

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>As a skill manager, you can:</td>
<td>skill_manager</td>
</tr>
<tr>
<td>End user and goal</td>
<td>Required role</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>• Build your teams based on the skills set your organization needs.</td>
<td></td>
</tr>
<tr>
<td>• Have visibility into skill competencies of employees.</td>
<td></td>
</tr>
<tr>
<td>• Analyze skill gaps and plan for coaching or training of your employees based on the needs.</td>
<td></td>
</tr>
<tr>
<td>• Identify users who have a specific skill or belong to specific skill categories.</td>
<td></td>
</tr>
<tr>
<td>• Track skill proficiencies of users over time.</td>
<td></td>
</tr>
<tr>
<td>• Identify key skills being used in solving your business needs and the users with those skills.</td>
<td></td>
</tr>
<tr>
<td>• Build learning programs based on skill strengths, weaknesses, preferences, gaps, and risks identified for your organization.</td>
<td></td>
</tr>
<tr>
<td>• Build teams based on skills you need to complete projects.</td>
<td></td>
</tr>
<tr>
<td>• Evaluate how effectively users solve business needs using their skill competencies and provide feedback to implement improvements.</td>
<td></td>
</tr>
<tr>
<td>• Review how efficiently work assignments are made based on skill levels.</td>
<td></td>
</tr>
<tr>
<td>• Match user skills with skills needed to complete work items and assign projects to teams based on those skills.</td>
<td></td>
</tr>
</tbody>
</table>
## Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Skills Matrix                        | Multi-level pivot table     | • View competencies for all users in a particular group.  
• View the competency of all users for a particular skill in a group.                                                                    |
| Top 10 skills used in the last six months | Bar chart                 | Identify the top 10 skills that are in use and which users have those skills.                                                             |
| Tasks associated with skills         | Bar chart                  | View the number of tasks that have skills assigned to them. The example report shows data for the last six months.                           |
| Users with Skills                   | Bar chart                  | View the total number of users with skills assigned in each skill category.                                                                 |
| Skills in Category                  | Bar chart                  | View the total number of skills in the selected category.                                                                                   |
### Domain separation and Skills Management

Domain separation is supported in the Skills Management app, and configured to apply to all features of the application. Separation of data is configured along with separation of logic and process. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Support level: Basic**

- **Business logic:** Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see [Application support for domain separation](#).

### How domain separation works in Skills Management

Domain separation is supported in Skill Management with no explicit setup or configuration requirements. Skills, skill categories, skills levels can be created in separate domains, including the global domain. When domain separation is implemented, people with skill app roles can view skill information only in the domain assigned. **Domain** and **Domain Path** columns are available for all Skill tables provided with the base system. The **Domain** column contains the name of the domain to which the event or alert belongs, and the **Domain Path** column contains the unique domain identifier.

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List of user skills</td>
<td>List of skills with total count of users for each skill</td>
<td>View number of users available for each skill.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Table name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_user_has_skill</td>
<td>User skill information</td>
</tr>
<tr>
<td>cmn_skill</td>
<td>Main skill table</td>
</tr>
<tr>
<td>cmn_skill_category</td>
<td>Define skill categories</td>
</tr>
<tr>
<td>cmn_skill_level_type</td>
<td>Define skill level type</td>
</tr>
<tr>
<td>cmn_skill_level</td>
<td>Define skill level</td>
</tr>
<tr>
<td>sys_group_has_skill</td>
<td>Group skills</td>
</tr>
<tr>
<td>cmn_skill_contains</td>
<td>Define skills contained within skills</td>
</tr>
<tr>
<td>task_m2m_skill</td>
<td>Task skill information</td>
</tr>
</tbody>
</table>

Note: If the domain column is not shown, click the **Update Personalized List** icon and add the required column. You can also add the domain path column, if desired.

Use cases:

- A Skill Manager that belongs to the Acme domain creates a skill and wants to view and associate it to user in the Acme domain. A user must belong to the Acme domain, its parent domain, or the global domain to view the skill record.

- A Skill Manager that belongs to a parent domain tries to view a skill in a child domain. The user of a parent domain can view a skill record of the parent as well as all child domains of that parent.

- A Skill Manager that belongs to a parent domain wants to create/associate a skill on behalf of another user in the Acme domain. A user must belong to the same domain as the user for which the skill record is created.

- A Skill Manager wants to associate a record for an integrated application in the Acme domain. A user must belong to the domain of the integrated application from which a record is associated.

- A Skill Manager has access to multiple domains but wants to update a record with content within a specific domain. The domain specified for the current record drives the functionality of that record and reference fields.

Quick start tests for Skills Management

Validate that Skills Management still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.
Skills Management quick start tests require activating the Skills Management plugin (com.snc.skills_management).

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skills MGMT: User skill level inheritance when user is part of multiple groups</td>
<td>Verify that the user is assigned the highest skill level when the user belongs to multiple groups that have been assigned the same skills with different skill levels.</td>
<td>New York</td>
</tr>
<tr>
<td>Skills MGMT: Add skills to lowest level category</td>
<td>Verify that skills can be added to the lowest level category.</td>
<td>New York</td>
</tr>
<tr>
<td>Skills MGMT: Create a child category under a parent category</td>
<td>Verify that a lower-level category can be created when the flag for <strong>Add skills</strong> is unchecked in the parent category.</td>
<td>New York</td>
</tr>
<tr>
<td>Skills MGMT: Create a skill category</td>
<td>Verify that a skill category can be created on the skill category form.</td>
<td>New York</td>
</tr>
<tr>
<td>Skills MGMT: Create skill level type and skill levels</td>
<td>Define the skill level type and different skill levels for the type.</td>
<td>New York</td>
</tr>
<tr>
<td>Skill MGMT: Skill level inheritance from group to user</td>
<td>Verify that skill levels can be inherited from a group to the users of the group and that the <strong>Inherited and Skill level inherited</strong> fields are set to true.</td>
<td>New York</td>
</tr>
<tr>
<td>Skills MGMT: Create a skill from Manage IT Skills user interface.</td>
<td>Verify that you can create a skill from the Manage IT Skills user interface.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Skills MGMT: Add skills and skill levels to users in</td>
<td>Verify that you can add skills and associated skill levels to users in the</td>
<td>Orlando</td>
</tr>
</tbody>
</table>
Skills Management test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>the Manage IT Skills user interface.</td>
<td>Manage IT Skills user interface.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Skills MGMT: Select a skill and add users to the skill in the Manage IT Skills user interface.</td>
<td>Verify that you can select a skill and add the skill and associated skill levels to one or more users in the Manage IT Skills user interface.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Skills MGMT: Select a skill that does not have a skill level and add users to that skill in the Manage IT Skills user interface.</td>
<td>Verify that you can select a skill that does not have a skill level and add the skill to one or more users in the Manage IT skills user interface.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

Related information
Quick start tests

Subscription Management
With the ServiceNow® Subscription Management application, manage how your ServiceNow subscriptions are used on your instances.
Subscription Management lifecycle

Subscription Management - Introduction

- **Subscription Management** helps you proactively manage your ServiceNow subscription usage and gain insight into compliance

Allocate or monitor subscriptions

Track usage and adjust allocations

Plan for subscription renewals

- Current subscriptions are displayed on your instance
- Enables active management of user-based licenses, monitoring of capacity licenses
- Has no cost, enabled by default

Explore, learn, develop

<table>
<thead>
<tr>
<th>What's new in Rome</th>
<th>Recommended practices</th>
</tr>
</thead>
<tbody>
<tr>
<td>See the latest offerings in this release.</td>
<td>Tips and tricks for managing your subscriptions wisely.</td>
</tr>
</tbody>
</table>

- Using Subscription Management
- Managing your subscriptions
- Managing your users
- Managing your custom applications and tables
- Managing your subscription compliance

<table>
<thead>
<tr>
<th>Setup and administration</th>
<th>Classes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Subscription Management Overview (Now Learning login required)</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• Upgrade to Rome
• Setting up Subscription Management
• Configure the color-code threshold
• Configure the enforcement properties

Subscription Management overview
The ServiceNow® Subscription Management application gives you visibility and control of your ServiceNow subscriptions and applications. Get a real-time view of allocation and entitlement usage and reports showing your usage over time. Use Subscription Management to stay within compliance and make informed decisions about your subscription usage and purchases.

Subscriptions
ServiceNow sells subscription services. To use products from the ServiceNow Store, the members of your organization must have valid subscription licenses. Subscription licenses give your users access to ServiceNow and third-party applications available on the ServiceNow Store.

• The subscriptions that your organization purchases entitle an agreed-upon number of users to use applications included in various subscription plans.

• Subscriptions come in different types, such as per-user and capacity. The type of subscription determines the properties and attributes of the licenses that your company receives. For example, per-user subscriptions give a certain amount of fulfiller users access to applications. To learn more, see types of subscriptions.

Setting up Subscription Management
Subscription Management is active for all production instances by default. Assign a usage_admin and configure your properties to get started. For more information, see Setting up Subscription Management.
Using Subscription Management
The admin or usage_admin can use Subscription Management to manage your subscriptions, users, custom resources, and compliance. Use Subscription Management to manage and monitor your subscriptions to help you make informed decisions about subscription purchases. For more information, see Using Subscription Management.

Setting up Subscription Management
Set up Subscription Management to help you with using the application.

What to do

Assign the usage admins
Assign the usage_admin role to users that manage subscriptions for your organization. Assign the usage_admin role to at least one person in your organization. Only admins and usage_admins can use Subscription Management.

Configure the color-code threshold
The Subscription Management module uses color-coded dots to represent your allocation numbers. You can change the threshold for your instance.

Configure the enforcement properties
If you have non-production instances, you can configure how licensing behaves in those instances.

Map your custom applications
If your organization has custom applications, you must map your applications to a subscription.

Map your custom tables
If your organization purchased subscriptions that include custom table entitlements, you must map your custom tables to a subscription.

What to do next

Monitor and manage your subscriptions
Use Subscription Management to manage your subscriptions, users, custom resources, and compliance. See Using Subscription Management.
Subscription Management Properties

The **Properties** module gives you control over certain settings within Subscription Management.

![Subscription Management](image)

### Color-code threshold

Subscription Management uses a color-code within the interface to represent subscription allocation values. See **Configure the color-code threshold**.

### Enforcement Overrides

Non-production instances associated with a production instance receive the same licenses. You can set up your non-production instances to behave like your production instance. Alternately, you can override the enforcement and have your non-production instance behave differently. Licensing in your non-production instances gives you visibility of your entitlements prior to deploying to production instances.

With Subscription Management, you can set the **enforcement properties** of your non-production instances. Enforcement properties determine the behavior of application and plugin installation and user entitlement on your non-production instance.

For entitlement checks on the non-production instances, the **DEFAULT** is **OFF**. The system performs no licensing checks and displays no warning messages. For license checks on applications and plugins, the **DEFAULT** is **WARN**. The system allows installation and activation of plugins and store apps without a valid license, but displays a warning message.

**Note:** The licensing server controls the enforcement properties for some instances. For those instances, you must contact customer support to change the enforcement overrides.
To learn more about enforcement properties and to change the behavior of your non-production instances, see Configure the enforcement properties.

Configure the color-code threshold

Configure the color-code threshold to be used on your lists, forms, and charts within Subscription Management. The color code indicates the percentage of the subscription that has been allocated. Use the color codes to help you stay in compliance.

Before you begin
Role required: usage_admin or admin

About this task
The color code indicates the percentage of the subscription that has been allocated. The threshold you set dictates the colors.

- Green indicates that usage is below the threshold that you set.
- Yellow indicates that usage is between the threshold and 100%.
- Red indicates that usage is greater than 100%.

Procedure
1. Navigate to Subscription Management > Properties.
2. Update the Color-code threshold (subscription.used.thresh) property setting and then click Save. Specify a percentage value greater than 0 and less than 100. Default: 90% of the purchased subscription limit.
Related information

View your subscriptions

Configure the enforcement properties

Configure the enforcement properties to change the behavior of plugin activation and user entitlement on your non-production instance.

Before you begin
Role required: usage_admin or admin

About this task
The enforcement properties apply only to your non-production instance.

Note: The licensing server controls the enforcement properties for some instances. For those instances, you must contact customer support to change the enforcement overrides.

Procedure

1. Navigate to Subscription Management > Properties.
2. Under Enforcement Overrides (Non-Production), select your options from the lists.

   Enforcement Overrides (Non-Production)

   Entitlement checks on entitlement-driven actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td>The system performs no licensing checks and displays no warning messages.</td>
</tr>
<tr>
<td>WARN</td>
<td>The system allows users to access applications without the proper role or entitlement, but displays warning messages. The system logs unpermitted users.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENFORCE</td>
<td>The system denies users access to applications without the proper role or entitlement. The system logs unpermitted users.</td>
</tr>
<tr>
<td>DEFAULT</td>
<td>The system defaults to OFF.</td>
</tr>
</tbody>
</table>

License checks on application and plugin installation

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WARN</td>
<td>The system allows activation and installation of plugins and store apps without a valid subscription, but displays warning messages.</td>
</tr>
<tr>
<td>ENFORCE</td>
<td>The system denies activation and installation of plugins and store apps without a valid subscription.</td>
</tr>
<tr>
<td>DEFAULT</td>
<td>The system defaults to WARN.</td>
</tr>
</tbody>
</table>

3. Select **Save**.

**Domain separation and Subscription Management**

Domain separation is supported in Subscription Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data. Subscription Management tracks subscription data across your domains.

**Support level: Basic**

- Business logic: Ensure that data goes into the proper domain for the application’s service provider (SP) use cases.
- In the application, the user interface, cache keys, reporting, rollups, aggregations, and so on, all use domain at production run time.
- The owner of the instance needs to be able to set up the application to function across multiple tenants.

Use case: When an SP uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

**Overview**

Subscription Management tracks user allocation of your subscriptions and user actions counts across domains.
Note: This feature is available only in domain-separated instances only. Non-domain separated instances do not see this feature.

Your organization has a single instance containing your own domain (A1) and three customer domains (C1, C2, C3). Your organization has purchased an ISTM Fulfiller subscription. You allocate five of your own employees and five customers from each domain to the ISTM Fulfiller subscription.

The Subscription form shows that 20 users are allocated to the subscription. However, when you view the Allocated Users by Domain tab, the page lists a breakdown by domain:

- A1: 5
- C1: 5
- C2: 5
- C3: 5

**Domain Compliance Overview dashboard**

The Domain Compliance Overview dashboard shows all of your domain-separated subscription information. The dashboard contains the list of users by domain and reports generated for certain types of user actions.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
</table>
| Access Count       | For Per-User License Types  
Tracks the applications that users are accessing. The dashboard shows the user's domain, number of times accessed, and accrual period.  
The dashboard also shows visual representations for the top 20 domains, count by application and domain, and count by user and domain. |
| Fulfillment Count  | For Per-User License Types  
Tracks the fulfillment actions by application. The dashboard shows the user's domain, number of actions, and accrual period.  
The dashboard also shows visual representations for the top 20 domains, count by application and domain, and count by user and domain. |
| Producer Count     | For Per-User License Types  
Tracks the producer actions by application. The dashboard shows the user's domain, number of actions, and accrual period. |
<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
</table>
| Capacity Based               | For Capacity Based License Types  
Tracks action counts for capacity-based licenses. Each subscription ties to a definition ID which is used for the data. The dashboard shows the domain, number of actions, and accrual period.  
The dashboard also shows visual representations of the total capacity count, count by definition ID, and count by definition ID and domain. |
| Allocated Users by Domain    | Lists users and their subscriptions separated by domain.                                                                                                                                                     |

To view and to learn more about the dashboard, see [View your domain compliance overview](#).

**Related information**

- Domain separation for service providers

### Analytics and Reporting Solutions for Subscription Management

Analytics and Reporting Solutions contain prepackaged Performance Analytics and Reporting content for use with other Now Platform products. This Analytics and Reporting Solution helps you track parts of your subscriptions so you can stay within compliance and plan your future subscription purchases.

**Required roles**
The following roles and tasks are associated with this Solution:

- Now Platform administrator (admin): Install and activate this Analytics and Reporting Solution and make any necessary changes to system properties.
- Performance Analytics administrator (pa_admin): Review the indicators, breakdowns, widgets, and dashboards. Set up and start data collection. Share the dashboards with appropriate stakeholders.

**Related information**

- Analytics and Reporting Solutions
Subscription Overview dashboard

Use the Subscription Overview dashboard in Subscription Management to view and track your subscriptions and entitlements.

Manage your product subscriptions

Get visibility into your subscription entitlement to track usage over time, identify compliance issues and make informed decisions.

Subscription Status

<table>
<thead>
<tr>
<th>Subscriptions</th>
<th>Allocated</th>
<th>Unmapped applications with cui</th>
<th>Unpermitted Users This Month</th>
<th>Unsubscribed Application Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM/Unrestricted User</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HR Service Automation</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SD Datas Standard</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IL Security</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UI Performance Analytics For HR</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UT Free Card Users v2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Required Now Platform roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>• usage_admin, to view and edit Subscription Management</td>
</tr>
</tbody>
</table>

Use cases

For examples of how different people in your organization would use this dashboard, see these use cases.

<table>
<thead>
<tr>
<th>User</th>
<th>Dashboard use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Usage Admin</td>
<td>Tracks the allocation of subscriptions to ensure that users have the correct access and the company stays within compliance.</td>
</tr>
</tbody>
</table>

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocated</td>
<td>Donut</td>
<td>Subscription [license_details]</td>
<td>Represents the percentage of</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Source table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>----------</td>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Subscriptions - PA</td>
<td>List</td>
<td>Subscription [license_details]</td>
<td>Lists all of your active subscriptions and important information for each subscription.</td>
</tr>
<tr>
<td>Subscription Status</td>
<td>Donut</td>
<td>Subscription [license_details]</td>
<td>Represents the percentage of active and expired subscriptions.</td>
</tr>
<tr>
<td>Unsubscribed Application Usage</td>
<td>Single</td>
<td>Unsubscribed Usage [unlicensed_details]</td>
<td>Number of users attempting to use an application without the proper subscription entitlement.</td>
</tr>
<tr>
<td></td>
<td>Score</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unmapped applications with custom tables</td>
<td>Single</td>
<td>Application [sys_scope]</td>
<td>Number of applications that contain custom tables not mapped to a valid subscription.</td>
</tr>
<tr>
<td></td>
<td>Score</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unpermitted Users This Month</td>
<td>Single</td>
<td>Subscription Enforcement Log [ua_enforce_log]</td>
<td>Number of users that have the proper role, but not a valid subscription entitlement.</td>
</tr>
<tr>
<td></td>
<td>Score</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Custom Application Inventory dashboard**

The Custom Application Inventory dashboard in Subscription Management helps you manage your custom applications and tables on your instance from one place.
Required Now Platform roles

- usage_admin, to view and edit Subscription Management
- admin

Use cases

For examples of how different people in your organization would use this dashboard, see these use cases.

<table>
<thead>
<tr>
<th>User</th>
<th>Dashboard use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Usage Admin</td>
<td>• View custom application and custom table allocation</td>
</tr>
<tr>
<td></td>
<td>• Map custom applications and custom tables to subscriptions</td>
</tr>
<tr>
<td></td>
<td>• View Grandfathered and Exempt tables</td>
</tr>
</tbody>
</table>
### User

<table>
<thead>
<tr>
<th>Admin</th>
<th>Dashboard use</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• View custom application and custom table allocation</td>
</tr>
<tr>
<td></td>
<td>• Map custom applications and custom tables to subscriptions</td>
</tr>
<tr>
<td></td>
<td>• View Grandfathered and Exempt tables</td>
</tr>
</tbody>
</table>

### Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exempt Tables</td>
<td>Single Score</td>
<td>Exempted Table Inventory [ua_exempted_table_inventory]</td>
<td>View a list of your exempted tables. Exempted tables are custom tables that do not count towards your subscription entitlements.</td>
</tr>
<tr>
<td>Grandfathered Tables</td>
<td>Single Score</td>
<td>Custom Table Inventory [ua_custom_table_inventory]</td>
<td>View a list of your grandfathered tables. Grandfathered tables are older custom tables that do not count towards your subscription entitlements.</td>
</tr>
<tr>
<td>Custom Applications by Subscription</td>
<td>Horizontal Bar</td>
<td>Custom Table Inventory [ua_custom_table_inventory]</td>
<td>View custom applications by subscription.</td>
</tr>
<tr>
<td>Custom Application Subscriptions</td>
<td>List</td>
<td>Custom Table Inventory [ua_custom_table_inventory]</td>
<td>View your custom application subscriptions.</td>
</tr>
</tbody>
</table>
Domain Compliance Overview dashboard

The Domain Compliance Overview dashboard shows subscription information for instances that support domain separation. Use the dashboard to see application usage, subscription allocation, and actions by fulfillers and producers broken up by domain.

Required Now Platform roles

- usage_admin, to view and edit Subscription Management
- admin

Use cases

For examples of how different people in your organization would use this dashboard, see these use cases.

<table>
<thead>
<tr>
<th>User</th>
<th>Dashboard use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Usage Admin</td>
<td>Tracks subscription allocation and user actions across domains to ensure compliance and monitor trends.</td>
</tr>
</tbody>
</table>

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity Count by Domain (Capacity Based License Type)</td>
<td>List</td>
<td>Aggregate data for tablestats definition [ua_defn_agg_data]</td>
<td>Lists the total number of capacity actions, accrual</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Source table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-----------</td>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Capacity Count by Definition ID &amp; Domain</td>
<td>Heatmap</td>
<td>Aggregate data for tablestats definition [ua_defn_agg_data]</td>
<td>Displays the number of actions performed for each definition ID, which is linked to a capacity-based subscription, by domain.</td>
</tr>
<tr>
<td>Producer Count by Application &amp; Domain</td>
<td>Heatmap</td>
<td>Usage Data for Applications [ua_app_usage]</td>
<td>Displays the number of producer actions for each application by domain.</td>
</tr>
<tr>
<td>Producer Count % (Top 20)</td>
<td>Pie</td>
<td>Usage Data for Applications [ua_app_usage]</td>
<td>Displays the domains with the most producer counts.</td>
</tr>
<tr>
<td>Unique User Producer Count (Top 20)</td>
<td>Bar</td>
<td>Usage Data for Applications [ua_app_usage]</td>
<td>Displays the number of producer actions for each user stacked up by application and separated by domain.</td>
</tr>
<tr>
<td>Access Count by User (Per User License Type)</td>
<td>List</td>
<td>Usage Data for Applications [ua_app_usage]</td>
<td>Lists the application name, domain, time period and number of times accessed by each user.</td>
</tr>
<tr>
<td>Fulfillment Count by User &amp; Domain</td>
<td>Heatmap</td>
<td>Usage Data for Applications [ua_app_usage]</td>
<td>Displays the number of fulfiller actions done by</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Source table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>------------</td>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Access Count by User &amp; Domain</td>
<td>Heatmap</td>
<td>Usage Data for Applications [ua_app_usage]</td>
<td>Displays the number of times each user accessed an application by domain.</td>
</tr>
<tr>
<td>Access Count by Application and Domain</td>
<td>Heatmap</td>
<td>Usage Data for Applications [ua_app_usage]</td>
<td>Displays the number of times the application was accessed for each domain.</td>
</tr>
<tr>
<td>Fulfillment Count by Application &amp; Domain</td>
<td>Heatmap</td>
<td>Usage Data for Applications [ua_app_usage]</td>
<td>Displays the number of fulfills actions for each application by domain.</td>
</tr>
<tr>
<td>Total Capacity Count</td>
<td>Bar</td>
<td>Aggregate data for tablestats definition [ua_defn_agg_data]</td>
<td>Displays the number of capacity actions in each domain, stacked by definition id, which links to a capacity-based subscription.</td>
</tr>
<tr>
<td>Allocated Users by Domain</td>
<td>List</td>
<td>User Subscription [sys_user_has_license]</td>
<td>Lists users for each domain.</td>
</tr>
<tr>
<td>Producer Count by User (Per User License Type)</td>
<td>List</td>
<td>Usage Data for Applications [ua_app_usage]</td>
<td>Lists the application name, domain, time period and number of producer actions performed by each user.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Source table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>----------</td>
<td>--------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unique User Access Count (Top 20)</td>
<td>Bar</td>
<td>Usage Data for Applications [ua_app_usage]</td>
<td>Displays the number of access counts for each user stacked up by application and separated by domain.</td>
</tr>
<tr>
<td>Capacity Count % by Definition ID</td>
<td>Pie</td>
<td>Aggregate data for tablestats definition [ua_defn_agg_data]</td>
<td>Displays the percentage of actions for each definition ID, which is linked to a capacity-based subscription.</td>
</tr>
<tr>
<td>Fulfillment Count by User (Per User License Type)</td>
<td>List</td>
<td>Usage Data for Applications [ua_app_usage]</td>
<td>Lists the application name, domain, time period, and number of fulfillment actions performed by each user.</td>
</tr>
<tr>
<td>Access Count % (Top 20)</td>
<td>Pie</td>
<td>Usage Data for Applications [ua_app_usage]</td>
<td>Displays the domains with the most number of times an application was accessed.</td>
</tr>
<tr>
<td>Producer Count by User &amp; Domain</td>
<td>Heatmap</td>
<td>Usage Data for Applications [ua_app_usage]</td>
<td>Displays the number of producer actions for each individual user by domain.</td>
</tr>
<tr>
<td>Fulfillment Count % (Top 20)</td>
<td>Pie</td>
<td>Usage Data for Applications [ua_app_usage]</td>
<td>Displays the domains with the most fulfillment counts.</td>
</tr>
<tr>
<td>Subscription Definition IDs</td>
<td>List</td>
<td>Subscription [license_details]</td>
<td>Matches each subscription to a</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Source table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>------</td>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>definition ID to track capacity counts.</td>
</tr>
</tbody>
</table>

**Using Subscription Management**

Use the ServiceNow® Subscription Management application to manage how purchased subscriptions are used on your instances. You can manage subscriptions, users, and custom resources to stay within compliance and make informed decisions about subscription purchases.

**Subscription life cycle**

A typical subscription life cycle is as follows:

1. Purchase new subscriptions from the ServiceNow Store.
2. After your subscriptions are delivered to your production instance, view them in Subscription Management. See View your subscriptions.
3. Make sure that your users have access to the subscriptions they need. See Managing your users.
4. If your subscriptions come with custom table entitlements, map your custom tables to a subscription. If you create custom applications, map them to a subscription as well. To learn more about custom applications and tables, see Managing your custom applications and tables.
5. Monitor and adjust the resources of your subscriptions to ensure you are within compliance. Watch for:
   - overallocation of users on a subscription
   - out-of-policy users
   - unmapped custom applications and tables
   To learn more about monitoring your compliance, see Managing your subscription compliance.
6. Review the activity of your subscriptions. Look for:
   - usage patterns over time
   - application popularity
   - custom table usage
   To learn about reviewing subscription activity, see View subscription history reports and View user subscription history.
7. Consider your subscription usage to help you make informed decisions on future purchases.
Managing your subscriptions

Subscription Management gives you the information and tools to help you manage your subscriptions.

Subscriptions

Subscription Management shows your purchased subscriptions associated with your current instance. Each subscription contains licenses for the included applications. The subscriptions you purchase allow an agreed-upon number of users to access and use those applications.

Your purchased subscriptions come with applications, plugins, and roles. Some subscriptions come with entitlements for custom applications and tables. Subscription Management tracks and displays metrics and information for your subscriptions.

Types of subscriptions

Subscriptions to ServiceNow applications come in different types. The type of subscription determines the licenses to applications and custom resources that your users are permitted.

For a full breakdown of the subscription types, see Types of subscriptions.

Types of subscriptions

Subscriptions to ServiceNow applications come in different types. The type of subscription determines the allocation of users, access to applications, and custom application and table entitlements.

<table>
<thead>
<tr>
<th>Subscription type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity</td>
<td>Your ServiceNow instance auto-allocates resources such as users, devices, software, or nodes to Capacity subscriptions. For example, resources like each CI that Discovery finds or each password reset request.</td>
</tr>
<tr>
<td>Unrestricted User (UU)</td>
<td>Previously Max User. Your organization purchases an anticipated maximum number of unrestricted-user licenses. Unrestricted user licenses have no restrictions on role assignment. Your ServiceNow instance auto-allocates active users from the sys_user table to the unrestricted-user licenses. An active user is any user in the sys_user table that has a user id and has the Active field set to true.</td>
</tr>
</tbody>
</table>
### Subscription type | Description
--- | ---
**Note:** Editing the Unrestricted Users list affects your sys_user table and other UU subscriptions.

| PA Indicator | Your organization purchased a subscription for an application family that uses Performance Analytics capabilities (for example, PA for ITSM or PA for Service Management). The PA admin creates indicators on tables that are used by the applications. |
| Per-User | Your organization purchased a subscription for the number of fulfiller users for subscription applications and capabilities. Your instance can monitor and report usage by both subscribed users and users who are not subscribed. Users are automatically allocated to subscriptions based on their roles. |
| Unlimited | ServiceNow Store apps only. Your instance auto-allocates and tracks active users to an Unlimited subscription. There is no limit to the number of users that can be allocated. An active user is any user in the sys_user table that has a user id and has the **Active** field set to true. |

### Pooled subscriptions
When you purchase multiple qualifying subscriptions for certain types of products, such as IntegrationHub, those individual subscriptions combine into a single subscription pool. Any usage against that subscription deducts from the common pool.

For example, if you buy an IntegrationHub spoke with 1,000 entitlements, and another type of spoke with 500 entitlements, they combine into a common pool of 1,500 entitlements. This total entitlement pool appears in the all allocation counts for the subscription pool. Qualifying entitlement usage for either type of spoke automatically deducts from this common pool.

### View your subscriptions
Use the **Subscriptions** page to view the subscriptions that your organization has purchased.

### Before you begin
**Role required:** usage_admin or admin

### About this task
By default, the page lists active subscriptions only. To view expired subscriptions as well, set the list filter to **All**.
Procedure

1. Navigate to Subscription Management > Subscriptions.

   • The page attempts to list all subscriptions that your organization has purchased. Some subscriptions do not appear. See Why a subscription might not appear in the list.

   Note: In a non-production environment, your subscription allocation counts will not match with production.

   • A color-coded dot next to a subscription’s Allocated number indicates how close that subscription allocation is to the purchased number of subscribers. See Configure the color-code threshold.

2. Click a subscription Name to open the Subscription Form, where you can:

   • View the subscription allocation metrics and history reports.
   • View applications, plugins, and roles associated with a subscription.
   • Manage groups and custom tables.

Related information

View subscription history reports
View subscription applications and plugins
View subscription roles

Subscription form

The Subscription form contains important information about your subscription. Use the Subscription form to view subscription metrics and update subscription resources, such as groups or custom tables.

In any list of subscriptions, click a subscription name to open the Subscription form. Some fields do not appear for ServiceNow Store apps.
**Note:** For information on why a subscription is not in the list, see Why a subscription might not appear in the list.

### Subscription form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the subscription.</td>
</tr>
<tr>
<td>Category</td>
<td>Source of the purchased subscription: ServiceNow platform or ServiceNow Store.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of subscription:</td>
</tr>
<tr>
<td></td>
<td>• Per-User</td>
</tr>
<tr>
<td></td>
<td>• Unrestricted-User</td>
</tr>
<tr>
<td></td>
<td>• Capacity</td>
</tr>
<tr>
<td></td>
<td>• PA Indicator</td>
</tr>
<tr>
<td></td>
<td>• Unlimited</td>
</tr>
<tr>
<td></td>
<td>To learn more about subscription types, see Types of subscriptions.</td>
</tr>
<tr>
<td>Start date/End date</td>
<td>Start and end of the subscription period as agreed in your service contract. This information appears in the General section of the service contract for the subscription.</td>
</tr>
<tr>
<td>Display only</td>
<td>Value of <strong>true</strong> indicates that user allocation or monitoring is not currently supported for the subscription.</td>
</tr>
<tr>
<td>Product Code</td>
<td>The product SKU shown on your subscription order form.</td>
</tr>
</tbody>
</table>
Subscription Metrics

The **Subscription Metrics** section shows subscription allocation visually. Select data on the graphs to see more information.

### Subscription Allotment

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocated</td>
<td>Number of licenses currently allocated to users.</td>
</tr>
<tr>
<td>Available</td>
<td>Number of available licenses remaining from the purchased amount.</td>
</tr>
<tr>
<td></td>
<td>If you have allocated to more users than the purchased amount, <strong>Over-Allocated</strong> replaces Available.</td>
</tr>
</tbody>
</table>

### Tables

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tables Available</td>
<td>Number of available custom table entitlements remaining from the purchased amount.</td>
</tr>
<tr>
<td>Tables Used</td>
<td>Number of custom tables currently mapped to the subscription.</td>
</tr>
</tbody>
</table>

### Subscription Allotment History

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocated</td>
<td>Number of users allocated during the month.</td>
</tr>
</tbody>
</table>
### Subscription Allotment History (continued)

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available</td>
<td>Number of available licenses during that month.</td>
</tr>
<tr>
<td>Over-Allocated</td>
<td>Number of users allocated over the purchased amount during that month.</td>
</tr>
</tbody>
</table>

The **Subscription Allotment History** chart shows allocation history of the subscription for previous months. The chart shows the allocated, over-allocated, and available counts for each month up to the last 13 months.

### Related links and lists

The related links on the subscription form may vary depending on the subscription.

<table>
<thead>
<tr>
<th>Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Your Tables</td>
<td>See custom tables mapped to the subscription.</td>
</tr>
<tr>
<td></td>
<td>Map your custom tables</td>
</tr>
<tr>
<td>View Subscription History</td>
<td>View subscription status, dates, and trend information.</td>
</tr>
<tr>
<td></td>
<td>View subscription history reports</td>
</tr>
<tr>
<td>View User Subscription</td>
<td>See past user allocation.</td>
</tr>
<tr>
<td>History</td>
<td>View user subscription history</td>
</tr>
</tbody>
</table>

Depending on the type of subscription, the Subscription form contains related lists that provide more details or actions for the subscription you are viewing.

<table>
<thead>
<tr>
<th>List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscribed Users</td>
<td>Users subscribed to the applications. Users added via automatic allocation appear as <em>System Entitlement</em> in the source field. Users added via groups appear as Groups.</td>
</tr>
<tr>
<td>UU Subscriptions</td>
<td>Other unrestricted-user subscriptions associated with the unrestricted-user population.</td>
</tr>
<tr>
<td>Groups</td>
<td>Groups allocated to the subscription.</td>
</tr>
</tbody>
</table>

**Note:** Only for Unrestricted-User subscriptions.
<table>
<thead>
<tr>
<th>List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>See Allocate a group to a subscription.</td>
</tr>
<tr>
<td>Custom Tables</td>
<td>Custom tables mapped to the subscription.</td>
</tr>
<tr>
<td></td>
<td>See Managing your custom applications and tables.</td>
</tr>
<tr>
<td>Subscription Applications</td>
<td>Applications included within the subscription. For example, your subscription to ITSM can contain several applications, like Asset Management and Agent Workspace. Click an application to see associated plugins. See View subscription applications and plugins.</td>
</tr>
<tr>
<td>Associated Roles</td>
<td>Roles included in the subscription and what application the role belongs to. The Requires Subscription column indicates if users with this role must be allocated to the subscription to stay in compliance.</td>
</tr>
<tr>
<td>Entitlement Purchase History</td>
<td>Purchase information for your subscription. Includes product codes, dates, and number of licenses and tables purchased.</td>
</tr>
</tbody>
</table>

Why a subscription might not appear in the list

The Subscriptions list displays the subscriptions that your organization has purchased. Some missing subscriptions might not appear on the list.

Why does my subscription not appear in the Subscriptions list?

• You might not see all subscription services that you have purchased because the Subscription Management application does not yet allow management of some subscription services.
• The subscription may have expired. The page lists only subscriptions that are currently active. To view expired subscriptions as well, set the list filter to All.
• Subscription data arrives on production instances only.
• Self-hosted instances do not receive subscription information.
• Subscriptions that are marked as Display only do not currently support resource allocation or monitoring.

Why is the Subscriptions list empty?

• The subscription information might not yet have arrived. The data is downloaded daily.
View subscription enforcement logs

View subscription enforcement logs to see attempted actions by unlicensed users.

Before you begin
Role required: usage_admin or admin

About this task
Enforcement logs track users with the proper roles but have not been granted the proper entitlement.

Procedure

1. Navigate to Subscription Management > Subscription Overview.
2. Select Unpermitted Users This Month.
3. Click a user’s ID to open the log.
The **Subscription Enforcement Log** form lists information regarding the user's attempts to perform licensable actions:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Name</td>
<td>Name of the table that the user attempted to access without proper permissions.</td>
</tr>
<tr>
<td>User</td>
<td>Name of the user.</td>
</tr>
<tr>
<td>User ID</td>
<td>ID of the user</td>
</tr>
<tr>
<td>Application Type</td>
<td>Origin of the application.</td>
</tr>
<tr>
<td>Application Name</td>
<td>Name of the application</td>
</tr>
<tr>
<td>Application ID</td>
<td>ID of the application that the user attempted to access without proper permissions. This ID can be any of the following examples:</td>
</tr>
<tr>
<td></td>
<td>• Plugin ID (com.snc.incident)</td>
</tr>
<tr>
<td></td>
<td>• Package ID of a custom application (x_snc_custom_app1)</td>
</tr>
<tr>
<td></td>
<td>• Scope of the application (global)</td>
</tr>
<tr>
<td></td>
<td>• Sys ID of a custom application (3b72c0ec346b2010f8774b046215bd6a)</td>
</tr>
<tr>
<td>Product ID</td>
<td>ID of the product that the application belongs to. This ID can be any of the following examples:</td>
</tr>
<tr>
<td></td>
<td>• Product Family ID (incident_management)</td>
</tr>
<tr>
<td></td>
<td>• Package ID of a custom application (x_snc_custom_app1)</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Scope of the product (global)</td>
<td></td>
</tr>
<tr>
<td>• Sys ID of a custom application (3b72c0ec346b2010f8774b046215bd6a).</td>
<td></td>
</tr>
<tr>
<td>Reason Code</td>
<td>Reason for the system rejecting the user.</td>
</tr>
<tr>
<td>Accrual Period</td>
<td>Month and year that the log collected data.</td>
</tr>
<tr>
<td>Requested Entitlement</td>
<td>Type of entitlement the user attempted to use to access the table.</td>
</tr>
<tr>
<td>Entitlement Checks</td>
<td>Number of times the system rejected a check for the requested entitlement.</td>
</tr>
<tr>
<td>Last Attempted</td>
<td>Date and time the user last attempted to access the table without proper permissions.</td>
</tr>
</tbody>
</table>

### View subscription history reports

View a subscription's history report to see subscription status, dates, and trend information.

**Before you begin**

Role required: usage_admin or admin

**Procedure**

1. Follow the **How to** instructions in the table.
2. Navigate to **Subscription Management > Subscription Overview**.
3. Select a subscription.
4. Under related links, select **View Subscription History**.
   - The Subscription History pop-up lists the operations on subscriptions for your current instance. Select an operation to view details.

### View subscription roles

The **Associated Roles** related list shows the roles included with a subscription.

**Before you begin**

Role required: usage_admin or admin
About this task
Subscriptions auto-allocate users based on their roles. To see which roles are associated with a subscription and what applications they have access to, use the Associated Roles related list. Select a role to see more details.

<table>
<thead>
<tr>
<th>Associated Roles</th>
<th>Search</th>
<th>Application</th>
<th>Requires Subscription</th>
</tr>
</thead>
<tbody>
<tr>
<td>asset</td>
<td>Asset Management</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>category_manager</td>
<td>Asset Management</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>inventory_admin</td>
<td>Asset Management</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>inventory_user</td>
<td>Asset Management</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>model_manager</td>
<td>Asset Management</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>sam</td>
<td>Asset Management</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>agent_schedule_admin</td>
<td>Customer Service Management</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>agent_schedule_manager</td>
<td>Customer Service Management</td>
<td>true</td>
<td></td>
</tr>
</tbody>
</table>

Procedure
1. Navigate to Subscription Management > Subscriptions
2. Select a subscription.
3. Select the Associated Roles related list.
   The page lists the associated roles, the application for each role, and if the role requires a subscription license. Select a role to view more information.

Related reference
Subscription form

View subscription applications and plugins
See what applications and plugins are included with your purchased subscription.

Before you begin
Role required: usage_admin or admin

Procedure
1. Navigate to Subscription Management > Subscription Overview.
2. Select a subscription.
3. Select the Subscription Applications related list.
The page lists the applications included with the subscription.

<table>
<thead>
<tr>
<th>Subscribed Users</th>
<th>Groups</th>
<th>Custom Tables</th>
<th>Subscription Applications (14)</th>
<th>Associated Roles (26)</th>
<th>Entitlement Purchase History (4)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscription Applications</td>
<td>Search</td>
<td>Application Entitlement</td>
<td>Search</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4. Select an application.
The Application Entitlement page lists system plugins and roles associated with the application. Select a plugin or role to see more information.

Related reference
Subscription form

Managing your users
Use Subscription Management to monitor and manage your users and their licenses. Ensure that users have access to the correct applications and monitor over-allocation to stay within compliance.

Overview
System entitlement allocates subscriptions to users based on their roles.
You can over-allocate users to subscriptions, meaning more users possess an entitlement than the number of purchased entitlements. Subscription Management flags over-allocated subscriptions. Remove users or groups from the subscription or purchase more entitlements to stay within compliance.

Managing users
You can manage aspects of user allocation. Based on your role, you can perform different actions regarding user allocation.
• If you have the admin or user_admin role:
  ◦ Change a user’s role
  ◦ Create a group
  ◦ Add a user to a group
• If you have the admin or usage_admin role:
  ◦ Assign a group to a subscription
  ◦ Edit the unrestricted-user population

**Monitoring users**

Use the following methods to monitor your user's allocations. Monitoring your users can help you stay within compliance.

• View a subscription’s users.
• View user subscription history.
• View subscription enforcement logs.
• View subscription roles.

**Related information**

User administration
Roles
Groups

**View a subscription’s users**

View the list of users allocated to a subscription.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to Subscription Management > Subscription Overview.
2. Select a subscription.
3. Select the Subscribed Users related list.
   The Subscribed Users related list shows the currently subscribed users. The list also shows how each user was allocated and their roles.
View user subscription history

View a history of the users allocated to a subscription.

Before you begin
Role required: usage_admin or admin

Procedure
1. Navigate to Subscription Management > Subscription Overview.
2. Select a subscription.
3. Under related links, select View User Subscription History.
   The Subscription User History pop-up lists the user allocation history for the
   subscription. The list shows the user's current subscription status and how they
   were allocated.

User sets and groups
Subscription Management uses groups (previously user sets) to provide licenses
to sets of users.

User set and groups overview
Prior to Rome, Subscription Management used user sets to group users together.
Usage_admins grouped users by conditions, such as what city or department they are in. User sets could then be assigned to subscriptions to give every user in
the user set a license to the subscription.

In Rome, all user sets converted to groups. A group is a set of users who share a
common purpose. Similar to user sets, groups can be allocated to subscriptions.
Allocating a group to a subscription gives every user in the group a license to
that subscription.

User set conversion
On upgrade to Rome, all current user sets convert to groups. The new groups
contain the same users and properties as your user sets.

Group management
Admins and user_admins create groups and add users in the User Administration
application.
To learn more about creating and editing groups, see Groups.
Groups in Subscription Management

Admins and usage_admins allocate groups to subscriptions. Allocating a group to a subscription gives every user in the group a license. Users added via a group show Group as their source when looking at subscribed users.

Allocate a group to a subscription

Allocate a group to a subscription to give every member of the group entitlement.

Before you begin

Role required: usage_admin or admin

Procedure

1. Navigate to Subscription Management > Subscription Overview.
2. Select a subscription.
3. Under the Groups related list, click Edit Groups.
4. Move the group you want to allocate to the Groups List.
5. Click Save.

The group allocates all users within it to the subscription. Your allocation totals update with the next system refresh. Or you can select Update Allocation Totals in the Subscription Overview dashboard to apply your changes immediately.
Remove a group from a subscription

Remove a group allocated to a subscription to remove entitlement for all the users in the group. Remove groups to free up entitlements.

Before you begin
Role required: usage_admin or admin

Procedure
1. Navigate to Subscription Management > Subscription Overview.
2. Select a subscription.
3. Under the Groups related list, click Edit Groups.
4. Move the group you want to remove to the Collection list.
5. Click Save.
   The group allocates all users within it to the subscription. Your allocation totals update with the next system refresh. Or you can select Update Allocation Totals in the Subscription Overview dashboard to apply your changes immediately.

Edit the unrestricted-user population

Add or remove users from the groups of users that are part of the unrestricted-user population. Editing the population affects all unrestricted-user subscriptions.

Before you begin
Role required: admin or usage_admin
Procedure

1. Navigate to Subscription Management > Subscription Overview.
2. Select an unrestricted-user subscription.
3. In the Groups related list, select Edit Groups.

A warning message appears.

4. Select OK.

5. Move groups to the Groups List to add them to the population. Move groups to the Collection List to remove them.

6. Select Save.

Managing your custom applications and tables

Subscription Management helps you manage and track custom applications and custom tables on your instances.
Custom applications

A custom application is defined as any non-ServiceNow-provided application that you create on the Now Platform. If your organization purchased App Engine, you can use Subscription Management to manage your custom application subscriptions.

Custom tables

A custom table is defined as any non-ServiceNow-provided table that you create on the Now Platform. Some tables are exempted from being classified as a custom table.

Note: For more information on custom tables on the Now Platform, see Table administration. For a detailed description of custom table use rights and exempt tables, see the Custom Table Guide on http://www.servicenow.com/upgrade-schedules.html

Subscriptions come with custom table entitlements that dictate the number of custom tables that you can map to a subscription. The number of custom table entitlements depends on the subscription.

Mapping custom applications and tables

Installation of custom applications and custom tables on a production instance requires you to map your application and tables to a valid subscription. On non-production instances, your enforcement properties determine the installation of applications and tables without proper entitlement. For more information on your enforcement properties, see Subscription Management Properties.

When you purchase a subscription with custom table entitlements, the entitlement data appears in Subscription Management. On the Subscription Overview dashboard or Subscription form, your remaining entitlements appear as Available.

As your developers create and deploy new custom applications and tables on your instances, use Subscription Management to map and monitor them. Map all of your custom applications and tables to valid subscriptions for accurate entitlement and to help you stay within compliance.

Related information
Now Platform App Engine

View your custom application and table inventory

Use the Custom Application Inventory to view your applications and tables. From the dashboard, you can track the allocation of your custom applications tables and map any unallocated applications or tables.
Before you begin
Role required: admin or usage_admin

Procedure

Navigate to Subscription Management > Custom Application

Inventory

What to do next
With the Custom Application Inventory, you can view and manage your custom applications and tables.

• View your Grandfathered and exempted tables.
• Map your custom applications.
• Map your custom tables.

Grandfathered and exempted tables
Grandfathered and exempted custom tables are treated differently than other custom tables on your instance. Please refer to your organization’s ServiceNow® contract for additional information.

Grandfathered tables
Depending on your organization’s legacy subscription entitlements and contractual migration, grandfathered tables may be allotted to your production instance. To preserve an organization’s previous custom table entitlements...
through the license migration, a grandfathered table entitlement may be provided to the production instance. This one-time process ensures that custom tables that currently exist in a production instance do not count against your new custom table entitlements.

To view your grandfathered tables, navigate to **Subscription Management > Custom Application Inventory**, and select **Grandfathered Tables**.

**Example: Grandfathered tables on an instance**

Scenario: Your organization purchases three new subscriptions with entitlements for a total of 55 App Engine Starter custom tables (formerly Bundled Custom Tables). To ensure your organization doesn't lose the previous custom table entitlements, a grandfather subscription with an entitlement for 25 grandfathered tables is allotted to your instance. This subscription requires the admin to identify and map the existing 25 tables. These subscriptions result in a total custom table entitlement of 80. Once a custom table has been assigned to the grandfather subscription there is no option to revert this.

<table>
<thead>
<tr>
<th>Multiple subscriptions with grandfathered and custom table entitlements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Subscription</strong></td>
</tr>
<tr>
<td>Grandfathered subscription</td>
</tr>
<tr>
<td>New Subscription 1</td>
</tr>
<tr>
<td>New Subscription 2</td>
</tr>
<tr>
<td>New Subscription 3</td>
</tr>
</tbody>
</table>

**Exempted tables**

Exempted tables are custom tables that do not count towards your subscription entitlements. These tables consist mostly of custom extensions of certain system-related tables, such as sys_portal_page and sys_user_preference, that you extend for operational improvements in your production instance.

To view a list of exempted tables:

- In the instance, navigate to **Subscription Management > Custom Table Inventory** and select **Exempt Tables**.

The **Custom Table Guide legal schedule** provides the complete definition of which tables are considered exempt.
Note: Legal schedules are enforced based on when the contract is executed.

To find past versions of the Custom Table Guide, see the Legal Schedules Custom Table Guide.

Map your custom applications

Map your custom applications to a subscription to properly track your applications and monitor your compliance.

Before you begin
Role required: admin or usage_admin

About this task
Custom applications must be mapped to a valid subscription on installation. Existing custom applications must be mapped to a valid subscription to maintain accurate entitlement and stay within compliance.

Note: On non-production instances, custom-application mapping is suggested, but not required.

Procedure

1. Navigate to Subscription Management > Subscription Overview.
2. Select the Unmapped applications with custom tables tile.
   The page lists all applications without a subscription.
3. Select an application to bring up the custom application form.
4. Under Subscription Management, select the Subscription field and select a valid subscription from the list.
5. Select Update.

Results
The selected custom application maps to the subscription. Select the Update Allocation Totals button in the Subscription Overview dashboard for the allocation numbers to update. Otherwise, wait for the nightly system update.
Map your custom tables

Map your custom tables to your subscriptions to maintain and track custom table compliance over time. Mapping and tracking your tables ensures that your organization does not run out of custom table entitlements.

**Before you begin**
Role required: admin or usage_admin

**About this task**
Administrators and application developers can create custom tables to store application data. Map your custom tables to a subscription with available custom-table entitlements to stay within compliance. The system flags unmapped tables as out of compliance.

**Procedure**

1. Navigate to **Subscription Management > Custom Application Inventory**.
2. Click the **Global Tables Without Applications** tile on the dashboard. The page lists all tables not mapped to a subscription.
3. Select a table.
4. In the **Subscription** field, select a subscription.
5. Click **Update**.

**Results**
The selected custom tables map to the subscription. Select the **Update Allocation Totals** button in the **Subscription Overview** dashboard to update the allocation numbers immediately. Otherwise, wait for the nightly system update.

**Example:**
Your developers create a custom table to store the data...

**App Engine subscriptions**
Use Subscription Management to monitor subscription usage of your organization's custom applications.
With the Now Platform® App Engine, you can create custom applications and monitor the usage with Subscription Management. For more information on creating applications, see Now Platform App Engine.

ℹ️ **Note:** App Engine requires a separate purchase.

App Engine subscriptions entitle you to develop applications and deploy custom tables in production instances. Based on your App Engine version, you monitor the subscription usage of your App Engine applications differently.

### App Engine V1

Use the **App Engine Usage** dashboard to see App Engine subscriptions present on your instance. The dashboard lists:

- The total number of users that are currently allocated to each subscription.
- The number of custom tables that each user in the subscription is entitled to access.
- The list of specific users that are counted against each subscription.
- The number of unlicensed users if the subscription is over-allocated.
- Individual users with access to more custom tables than permitted by available entitlements.

ℹ️ **Note:** If you do not own App Engine V1, the **App Engine Usage** module is hidden.

### App Engine V2

View your App Engine subscriptions in the **Subscriptions** list. In the Subscription form, select the **Usage Details** related link. The **App Engine Subscription Management** page lists:

- The total number of users that are currently allocated to that subscription.
- The number of entitled custom tables each user is permitted.
- The roles that have access to the subscription.
- The number of unlicensed users if the subscription is over-allocated.
Custom-table mapping with App Engine subscriptions

Similarly to your other subscriptions, you can map custom tables to your App Engine subscriptions. Custom-table mapping helps track subscription usage, entitle roles, and help you stay in compliance. For more information, see Managing your custom applications and tables.

Custom table entitlements for App Engine subscriptions depend on your App Engine version.

**App Engine V1**

Your purchased App Engine subscriptions contain a *limited* number of custom table entitlements. Keep your mapped custom tables under the defined amount to stay within compliance.

**App Engine V2**

Your purchased App Engine subscriptions contain an *unlimited* number of custom table entitlements.

Unmapped custom tables are considered unsubscribed and unlicensed. Map your custom tables to track usage and maintain compliance over time.

**View App Engine V1 subscription compliance**

View your usage metrics for App Engine subscriptions. Use the information to help stay within compliance and help with subscription purchases.

**Before you begin**

Role required: usage_admin or admin

**About this task**

For App Engine V1 customers, use the **App Engine Usage** module to view metrics for custom application subscriptions. Monitor users, roles, and custom-table mapping. Use the information to determine if you need to make changes or purchase additional licenses and subscriptions.

**Procedure**

1. Navigate to **Subscription Management > App Engine Usage**.
2. Select the App Engine subscription you want to see metrics for.

<table>
<thead>
<tr>
<th>Tile</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscription</td>
<td><strong>n/n allocated</strong> Total number of users that are currently allocated to the selected App</td>
</tr>
<tr>
<td>Tile</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Engine subscription and the total number of users who are licensed to use it. For example,</td>
</tr>
</tbody>
</table>

**a.** If **105/100** appears, the subscription is not in compliance because it has 105 currently allocated users, while only 100 users are entitled to use the subscription. A red vertical bar appears, indicating that the subscription is over-allocated and out of compliance.

**Note:** To fix this situation, you must remove 5 users from the subscription. To learn how to remove users, see Remove individual user access to a custom table by role or group or Remove access to a custom table for large numbers of users.

**b.** If **85/100** appears, then the subscription is in compliance because it has 85 currently allocated users, and 100 users are entitled to use the subscription. A green vertical bar appears, indicating that
<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>the subscription is in compliance.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Both of these scenarios apply for all types of App Engine subscriptions.</td>
</tr>
</tbody>
</table>

**n–n custom tables**

Total number of custom tables that each user can access for the selected App Engine subscription. For example, if 1-5 appears, a Starter subscription lets each entitled user to access from 1 through 5 custom tables.

| Unlicensed       | Red vertical bar and an **Unlicensed** message appears, indicating the unlicensed use of any of the App Engine subscriptions: \* Users with access to more custom tables than allowed by any purchased App Engine subscription that is present on the instance. \* Total number of tables that are unlicensed, or over-allocated, based on the total of all purchased App Engine subscriptions. |

3. To view the individual users that are assigned to the selected subscription, click the Users related list.

<table>
<thead>
<tr>
<th>Users related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>User</td>
<td>Names of the users who can access the selected subscription. Click a</td>
</tr>
</tbody>
</table>
user to view the user’s profile and the related lists of the custom tables and custom applications that they can access.

**Note:** To learn more about how to manage user compliance, including how to remove individual users that are assigned to an App Engine subscription, see [Remove individual user access to a custom table by role or group](#).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entitled Custom Tables</td>
<td>Number of entitled custom tables per user. It is the total number of custom tables that each user can access for the selected subscription.</td>
</tr>
<tr>
<td>Entitled Custom Applications</td>
<td>Number of entitled custom applications per user. It is the total number of custom applications that each user can access for the selected subscription.</td>
</tr>
</tbody>
</table>

4. To view the roles that grant access to the custom tables for the selected subscription, click the Roles related list.

### Roles related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roles Granting Access</td>
<td>Names of the individual role that grants custom table access to users that are counted in the selected subscription. Click a role to view the users that are associated with the role.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Entitled Custom Tables</td>
<td>Names of the custom tables that are granted access by the role.</td>
</tr>
<tr>
<td>Entitled Custom Applications</td>
<td>Names of the custom applications that are granted access by the role.</td>
</tr>
<tr>
<td>Users in Subscription</td>
<td>Names of the users in the associated roles.</td>
</tr>
</tbody>
</table>

**Note:** To learn more about how to manage role compliance, see Remove access to a custom table for large numbers of users.

**Remove individual user access to a custom table by role or group**
Remove an individual user’s access to a role or group to fix situations where too many users have access to custom tables for the subscription.

**Before you begin**
Role required: usage_admin or admin

**About this task**
The Users related list in the App Engine Usage dashboard lets you view all users who currently use App Engine subscriptions. You can select any user and view their user profile. The user profile lists each custom table and related custom application that the user can access.

**Procedure**
1. Navigate to **Subscription Management > App Engine Usage**.
2. To view the users or roles that are assigned to a specific App Engine subscription, click a subscription tile.
3. In the Users related list, click an individual user to view their standard user profile.
4. Click the Entitled Custom Tables related list to view information about the custom tables that the user can access for the subscription.
Entitled custom tables related list

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Name of the custom table that the user is entitled to access.</td>
</tr>
<tr>
<td>Application</td>
<td>Name of the custom application that the custom table belongs to. <strong>Global</strong> appears if the custom table is for global use.</td>
</tr>
<tr>
<td>Role</td>
<td>Role(s) that grant the user access to the table.</td>
</tr>
</tbody>
</table>

5. To remove the selected user from the subscription, select a line in the Entitled Custom Tables listing.

6. From **Actions on selected rows**, click **Remove user's access to table**.

7. When the **Remove User from Role** confirmation dialog appears, click **OK**.
   If you receive a message stating that access to the table was granted via an inherited role or group, you must instead remove the user from the group:
   • Click the Groups related list.
   • Select the user that you want to remove.
   • From **Actions on selected rows**, click **Delete**.
   • When the confirmation dialog appears, click **Delete**.

8. To formally remove the user's access to the custom table, click **Confirm** when the final **Remove User from Role** confirmation dialog appears.

Remove access to a custom table for large numbers of users

Adjust roles or remove multiple users from those roles by granting custom table access in the subscription as needed. Use the Roles related list in the App Engine Usage dashboard to view the roles that grant user access to custom tables in a selected App Engine subscription.

**Before you begin**
Role required: usage_admin or admin

**About this task**
This procedure is similar to the procedure for removing custom table access for an individual user or smaller number of users. However, you may need to remove custom table access for several hundred, or several thousand users. Rather than doing this one by one, you can either:
• Remove the role or roles that grant access to the custom tables for these groups of users, depending on permissions
• Remove large groups of users from these roles.

For example, you would use this procedure if you are developing an application for use in North America and need to remove access for all European users.

Procedure

1. Navigate to Subscription Management > App Engine Usage.

2. To view the users or roles assigned to that specific App Engine subscription, click a subscription tile.

3. In the Roles related list, click a role to view the Role record.
   To learn more about roles and how they relate to users and groups, see . The Custom Tables related list contains information about the custom tables that the role can access for the subscription:

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Name of the custom application that the custom table belongs to. Global appears if the custom table is for global use.</td>
</tr>
<tr>
<td>Table</td>
<td>Name of the custom table that belongs to the application.</td>
</tr>
</tbody>
</table>

4. To view the users assigned to the role, click the Subscribed Users related list.

<table>
<thead>
<tr>
<th>Subscribed users related list</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fields</td>
</tr>
<tr>
<td>User</td>
</tr>
<tr>
<td>State</td>
</tr>
<tr>
<td>Inherited</td>
</tr>
</tbody>
</table>

5. To remove users from the role, select the users in the Subscribed Users listing, and from Actions on selected rows, click Remove user's access to table.
6. When the **Remove User from Role** confirmation dialog appears, click **OK**.
7. To formally remove the user's access to the custom table, click **Confirm** when the final **Remove User from Role** confirmation dialog appears.

**Results**
The selected user's access is removed from the custom table for the selected subscription. After either remediation action is complete, the subscription compliance automatically updates to reflect the change.

**View App Engine V2 subscription compliance**
View your usage metrics for App Engine subscriptions. Use the information to help stay within compliance and help with subscription purchases.

**Before you begin**
Role required: admin or usage_admin

**About this task**
For App Engine V2 customers, use the **App Engine Subscription Management** page to view metrics for custom application subscriptions. Monitor users, roles, and custom-table mapping. Use the information to determine if you need to make changes or purchase additional licenses and subscriptions.

**Procedure**
1. Navigate to **Subscription Management > Subscription Overview**.
   The **Subscriptions** page lists your active subscriptions, including installed App Engine V2 subscriptions. Some subscriptions might not appear. See **Why a subscription might not appear in the list**.
2. Select the App Engine subscription you want to view.
3. In the Subscription form, select the **Usage Details** related link.
   The **App Engine Subscription Management** page lists the users, roles, and metrics associated with the custom application subscription.
Managing your subscription compliance

With Subscription Management, you can review and monitor your subscription compliance. By monitoring the allocation of users, applications, and tables, you can make better decisions about your subscription purchases and stay within compliance.

Subscription Management monitoring

Subscription Management tracks metrics on the usage of your subscriptions. Use the data to:

• Track over-allocation of users
• Determine whether users who are not subscribed are accessing a subscription application.
• Ensure that your custom applications and custom tables are mapped to subscriptions.
• Monitor your custom application and custom table entitlements.
• Plan and budget for upcoming or future subscription needs.
  ◦ Assess whether you have allocated too many fulfiller users to a per-user subscription. Consider purchasing more subscription entitlements.
  ◦ Assess your custom application and table entitlements. Consider purchasing more entitlements to map all of your custom applications and tables to subscriptions.
Compliance dashboards

The **Subscription Overview** dashboard shows a breakdown of your active and expired subscriptions, allocation numbers, and other important information about your subscriptions. See View your subscription overview.

The **Domain Compliance Overview** dashboard shows a breakdown of units per domain for instances that support domain separation. See View your domain compliance overview.

Related reference
- Types of subscriptions
- Related information
  - View your subscriptions
  - Managing your users

**View your subscription overview**

Use the **Subscription Overview** dashboard to see important information about your active, expired, and unsubscribed subscriptions. The dashboard also shows numbers for unmapped custom applications, unpermitted users, and application usage by unsubscribed users.

**Before you begin**

Role required: admin or usage_admin

**Procedure**

1. Navigate to **Subscription Management > Subscription Overview**.
2. Select on a tile to see more information.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscription status</td>
<td>Visual representation of your active and expired subscriptions. Select a section to view a list of those subscriptions.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unpermitted users this month</td>
<td>Number of users that have proper roles but no proper entitlements. Select the see the list of users and enforcement logs.</td>
</tr>
<tr>
<td>Unsubscribed application usage</td>
<td>Number of users using an application without the proper entitlement.</td>
</tr>
</tbody>
</table>

**What to do next**

After editing your subscriptions, select the **Update Allocation Totals** button for Subscription Management to show the changes. Otherwise, the changes show after the nightly system update.

**View your domain compliance overview**

View the Domain Compliance Overview dashboard to see a breakdown of units per domain for instances that support domain separation.

**Before you begin**

Role required: usage_admin or admin

**About this task**

The Domain Compliance Overview dashboard appears only for instances that support domain separation. For more information, see Domain separation and Subscription Management.

**Procedure**

Navigate to **Subscription Management > Domain Compliance Overview**.

The **Access Count**, **Fulfiller Count**, and **Producer Count** tabs display action counts in lists and charts.
The **Capacity Based** tab displays counts for capacity-based licenses and charts.

The **Allocated Users by Domain** tab displays a list of users separated by domain. Selecting a domain shows more information on the allocated users in each domain.
Survey Management

With the ServiceNow® Survey Management application you can create, send, and collect responses for basic surveys. If installed, you can also use the Survey widget to set up a survey within Service Portal.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Upgrade to Rome</td>
<td>• Survey Management roles</td>
<td>• Survey designer</td>
</tr>
<tr>
<td>• Get started with Survey Management</td>
<td></td>
<td>• Survey users and groups</td>
</tr>
<tr>
<td>• Key survey terms</td>
<td>• Survey definitions</td>
<td>• Customize the appearance of a survey</td>
</tr>
<tr>
<td>• Domain separation and Survey Management</td>
<td></td>
<td>• Survey trigger conditions</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Migrate</th>
</tr>
</thead>
<tbody>
<tr>
<td>• View the results for a survey</td>
<td>• Developer training</td>
<td>• Legacy survey migration</td>
</tr>
<tr>
<td>• View results for all surveys</td>
<td>• Developer documentation</td>
<td></td>
</tr>
<tr>
<td>• Metric result fields</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• View a survey scorecard</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Survey questionnaires</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Troubleshoot and get help</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Ask or answer questions in the IT Service Management forum</td>
<td></td>
</tr>
<tr>
<td>• Search the Known Error Portal for known error articles</td>
<td></td>
</tr>
<tr>
<td>• Contact Customer Service and Support</td>
<td></td>
</tr>
</tbody>
</table>

Get started with Survey Management

Two versions of the application are supported, Survey Management, which is the latest version, and Legacy Surveys. Survey Management improves the user interface and extends the capabilities of the Legacy Surveys application.

The differences between assessments, surveys, and quizzes, and when to use each; also provides a quick look at the three stages in the survey process: designing, sharing, and evaluating.
Configuring surveys
There are many options for advanced configuration in Survey Management:

- Create a survey, add questions, and choose recipients, all in one interface.
- Create conditional questions, which appear only when users answer other questions a certain way.
- Restrict a survey so only specific survey users can take it, and send invitations to those users simultaneously. Alternatively, make the survey a public survey so that any user can take the survey, even anonymous users (users who have not logged in to the ServiceNow system).

⚠️ **Tip:** The assessment_take2 UI page should be public for public surveys. If that page is not public, anonymous users do not have access to the page and public surveys do not work.

- Set a schedule to automatically assign a survey to users and to limit how often the same user can take a survey.
- Customize the look and feel of survey questionnaires.
- Save anonymous survey responses.
- Convert survey responses to numerical scores and view them on scorecards.
- Deactivate a survey for maintenance or to retire it without deleting it.

⚠️ **Note:** Because surveys use the same tables and other back-end components as assessments, you may see assessment elements such as table and field names in certain places throughout the survey feature.

Legacy Surveys
Survey administrators can continue to use legacy survey functionality and data, however, it is recommended that you migrate legacy surveys to the Survey Management application. Concurrent use of both survey applications can cause confusion and redundancy.

Survey wizards are not impacted and cannot be migrated.

⚠️ **Note:** The Legacy Surveys application is not described in the documentation that you are viewing. It is documented on the ServiceNow wiki.

<table>
<thead>
<tr>
<th>Capability</th>
<th>Surveys</th>
<th>Legacy Surveys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surveys in Service Portal.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Version comparison (continued)

<table>
<thead>
<tr>
<th>Capability</th>
<th>Surveys</th>
<th>Legacy Surveys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save new survey responses each time a user takes the same survey.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create question templates to reuse sets of answer options.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Categorize survey questions and report on category results.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deactivate a survey without deleting it.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create conditional questions.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Send surveys automatically based on a schedule.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Customize survey questionnaire color scheme.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save anonymous survey responses for logged-in users.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>View survey responses on graphical scorecards.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save surveys in a draft state until they are ready to publish.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create and send surveys from one page.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow only specific users to access a survey.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Send surveys based on conditions.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Send survey email notifications.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Limit how often a user can take the same survey.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Add introduction and end note text.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Create survey modules.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Public survey: Allow persons to take a survey without logging in.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Use update sets to track changes.</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

### Related reference

Survey Management roles
Related information

Legacy survey migration
Survey designer
Surveys in Service Portal
Service Portal

Survey Management roles

The Survey Management application uses the following roles.

No role is required to take assigned survey questionnaires.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Survey administrator      | Create and administer surveys. Survey administrators know what types of surveys are necessary, when to send a survey, and to whom. Survey administrators can use all modules in the Survey application menu. | • survey_reader  
                           |                                                                             | • assessment_admin |
| survey_reader             | View surveys and related information, such as survey responses, survey groups, scorecards, and reports. | none                            |

Key survey terms

These survey terms are used throughout the documentation to describe survey management functions and capabilities.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey definition</td>
<td>Root record on which a survey is built. A survey definition contains information such as the survey name, state, and distribution schedule. Each survey definition has its own categories and questions. Survey definitions are comparable to legacy survey masters.</td>
</tr>
</tbody>
</table>
Key survey terms (continued)

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public survey</td>
<td>Any user can take a public survey, even users who have not logged in to the ServiceNow system. For a completed survey, the <strong>Assigned to</strong> field value is Guest.</td>
</tr>
<tr>
<td>Survey category</td>
<td>Represents a theme for survey questions. Categories contain one or more questions. The system creates one category per survey by default. Additional categories are optional.</td>
</tr>
<tr>
<td>Survey question</td>
<td>A question that appears on a survey questionnaire for the associated survey definition. Survey questions are comparable to legacy survey questions.</td>
</tr>
<tr>
<td>Survey user</td>
<td>User who is authorized to receive invitations for a restricted survey.</td>
</tr>
<tr>
<td>Survey instance</td>
<td>Represents one survey questionnaire assigned to one user. Survey instances are comparable to legacy survey instances.</td>
</tr>
<tr>
<td>Trigger condition</td>
<td>Defines a rule that enables the system to send a survey when an action occurs on a table, such as when an incident closes. Trigger conditions are comparable to legacy survey conditions.</td>
</tr>
<tr>
<td>Scorecard</td>
<td>Visual representation of survey responses. Scorecards display a variety of data summaries for one survey definition.</td>
</tr>
</tbody>
</table>

### Survey questionnaires

All surveys that are assigned to you appear in your personal assessment and survey queue.

No special role is required to complete a survey but you must be logged in and the survey must be assigned to you. When you submit a survey, the system stores your responses.

### Survey notification

If the system is configured to send email, it sends you a notification when a survey is assigned to you. The message contains a link to the survey and instructions for viewing the assessment and survey queue.
Take a survey

Surveys that are assigned to you, and that are not complete, appear in your assessment and survey queue.

Before you begin
Role required: none

About this task
Each assessment or survey appears as a card in the queue. The card contains helpful information, including the survey name, state, and due date, and a button to launch the questionnaire. Overdue surveys are clearly marked with a red icon and red due date. You must answer every mandatory question, indicated by a red asterisk, before you can submit the survey. If you start to take a survey but cannot complete it, save your responses and return to it later. When you have answered all the questions and are satisfied with the responses, submit the survey.

Procedure

1. Navigate to **Self-Service > My Assessments & Surveys**.
   Users with the assessment_admin role, including survey administrators, can display other users’ assessments and surveys in addition to their own. Use the Show all and Show assigned to me related links at the bottom of the queue to show and hide assessments and surveys. Click a card assigned to another user to open the associated metric type or survey definition.

2. Click **Take Survey** on a survey card to open the questionnaire.
   If there is more than one survey category, you can click the collapse or expand icon to hide or show the questions in the category.

3. Answer each question to the best of your ability.
   If you are unsure of how to respond to a question or if a question does not apply to a particular record, select **Not Applicable**, if available.

4. Complete one of the following steps.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save your responses without submitting them</td>
<td>Click <strong>Save</strong>. You can close the questionnaire and access it later from your queue.</td>
</tr>
</tbody>
</table>
### Domain separation and Survey Management

Domain separation is supported in Survey Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: Basic**

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.

---

**Option** | **Description**
--- | ---
Submit the survey after answering all questions

- **Note:** The system does not save the survey if there are invalid responses, such as a letter in a date field. You must enter valid responses or remove invalid responses before you can save the survey.

Click **Submit**. You cannot return to the questionnaire after submitting.

- **Note:** If there is an unanswered mandatory question or an invalid response, an error message appears and the problematic questions are temporarily highlighted.
Overview
As a survey creator, survey_admin can create surveys in the assigned domain. A Global domain survey_admin can create or edit survey in any domain.

As a survey taker, a user can access the survey record and take the survey based on the domain of the survey record and user. Global domain users can take a survey in any domain.

How domain separation works in Survey Management
There are several main areas to consider in how domain separation works in Survey Management.

Survey Management in domain-separated instances
The following domains are available by default after activating the Domain Support-Domain Extensions Installer [com.glide.domain.msp_extensionsinstaller] plugin. Only ServiceNow employees can activate this plugin.

• Global
• Acme
• Cisco

Access to surveys in domain-separated instances
Based on the domain of the survey record and users, users can access the survey record and take the survey.

Global domain users can access survey records in any domain. Users in any other domain can access records in their domain and Global domain. For example, users in the Acme domain can access records in the Acme domain and the Global domain.

Global domain users can take a survey in any domain. Users in any other domain can take surveys in their domain as well as the Global domain. For example, users in Acme domain can take surveys in the Acme domain and the Global domain.

<table>
<thead>
<tr>
<th>Location of the survey record</th>
<th>Users who can access and take the survey</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Global</td>
</tr>
<tr>
<td></td>
<td>Acme</td>
</tr>
<tr>
<td></td>
<td>Cisco</td>
</tr>
<tr>
<td>Global</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Acme</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>No</td>
</tr>
<tr>
<td>Cisco</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
</tbody>
</table>
Any domain user can assign a survey in that domain to the same domain user or a Global domain user. For example, an Acme domain user can assign a survey to a Global domain user or an Acme domain user. Users from other domains are not visible to the Acme domain user.

Although the Global domain user can view a survey from other domains, this user cannot assign the survey of one domain to a user from a different domain. For example, a Global domain user can assign a survey from the Acme domain to another Global domain user or an Acme domain user, but not to a Cisco domain user.

⚠️ Note: When a task is closed in a child domain and the assigned survey is either in the child domain or the global domain, the user from the child domain can then take the survey.

**Trigger conditions in domain-separated instances**

A Global domain user can create a triggered condition for a survey from any domain. The Global domain user can create an incident and trigger the survey by selecting a user from the other domain in the **User field** under **Caller**. However, the Global user cannot assign the survey to the user of different domain.

A user can assign a trigger condition to a survey if the user belongs to the Global domain or the Survey domain.

If there is no domain path for a trigger condition, users from any domain can view the trigger condition. For example, in the **asmt_condition** table that has no column for the domain path, users from the Acme domain can view the trigger condition created by the Cisco domain users.

**Related information**

- Domain separation for service providers

**Survey responses and results**

There is a metric result record for each user response to each question on every survey instance. Survey results for each question and category are calculated automatically based on the metric result records.

If you use survey result calculations for results and scorecards, ensure that the **positive indicator** field for the question is set appropriately, based on the answer options. To have any results, a category must contain scored questions.
Survey responses

Survey responses are stored in the Metric Result [asmt_metric_result] table and display the recipients’ answers to each question in a category. To view general results, navigate to **Survey > Survey Responses**. To view results for a particular criterion, use a filter on the Metric Result [asmt_metric_result] table. For example, to view results based on the assignment group, apply a filter condition for assignment group.

**Survey metric results**

![Survey metric results table](image)

**Category results**

Category results are stored in the Assessment Category Result [asmt_category_result] table and display the overall ratings for each category based on the weighted value for each scored question. To view these results, navigate to **Assessments > Results > Category results** and filter the results using the `[Type.Evaluation method] [is] [Survey]` condition.
Assessment category results

Survey scorecards
A scorecard provides a visual breakdown of survey responses, based on the way questions were answered, by category. To access a scorecard, see View a survey scorecard.

Related information
- View a survey scorecard
- Survey designer elements
- Configure category weights for a survey

View results for all surveys
You can view the survey responses that are stored on the Metric Result [asmt_metric_result] table.

Before you begin
Role required: survey_admin or survey_reader

Procedure
1. Navigate to Survey > Survey Responses.
   Do not confuse this module with Survey > Legacy Surveys > Survey Responses, which displays legacy survey responses.

   The Type column displays the survey definition each response is associated with.

2. Select a response to view its details.
View the results for a survey

You can view the responses for one survey definition. Survey results are stored on the Metric Result [asmt_metric_result] table.

Before you begin
Role required: survey_admin or survey_reader

Procedure
1. Navigate to Survey > View Surveys
2. Open a survey definition.
3. Under Related Links, click View Responses, which is available only if there are results.
   The results are grouped by metric, which is what questions are called in assessments.
4. Open a metric result to view more detail.
   The metric result contains the user's response and calculated values of interest to advanced survey administrators. Because the Metric Result table is also used by the assessment feature, many field names are not clear in the context of surveys.

Example

Metric result fields
List of field descriptions for the Metric Result form.
# Metric Result form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment group</td>
<td>Assessment group to which the metric result belongs. An assessment group is a container for survey instances and results generated in a single occurrence. The system generates an assessment group every time at least one survey instance is created. If multiple survey instances are created at once, such as when a survey administrator sends invitations to a list of survey users, they are all stored in the same assessment group.</td>
</tr>
<tr>
<td>Metric</td>
<td>Question that the user answered.</td>
</tr>
<tr>
<td>Data type</td>
<td>Data type of the question the user answered.</td>
</tr>
<tr>
<td>Method</td>
<td>Assessment method. Always Assessment for surveys.</td>
</tr>
<tr>
<td>Updated</td>
<td>Date and time the metric result was last updated.</td>
</tr>
<tr>
<td>Source</td>
<td>Survey definition from which the associated survey instance was generated.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User who completed the survey questionnaire.</td>
</tr>
<tr>
<td>Instance</td>
<td>Survey instance completed by the Assigned to user.</td>
</tr>
<tr>
<td>Actual value</td>
<td>Value obtained from the user response to the question. The actual value is determined by the question data type:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Checkbox</strong>: The actual value is 0 if the check box is cleared and 1 if it is selected.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Choice</strong> or <strong>Likert Scale</strong>: The actual value is equal to the Value of the metric definition associated with the chosen answer option.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Date, Date/Time, or String</strong>: The actual value is -1 to indicate that these data types do not contribute to category result calculations.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Template</strong>: The actual value is equal to the Value of the template definition associated with the chosen answer option.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Yes/No</strong>: The actual value is 0 if the response is No and 1 if it is Yes.</td>
</tr>
<tr>
<td>Normalized value</td>
<td>Adjusted value that accounts for the Scale definition setting, minimum and maximum values, and other factors.</td>
</tr>
</tbody>
</table>
### Metric Result form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The equation that generates the value and an example calculation appear in <strong>Normalized value for an assessment</strong>.</td>
</tr>
<tr>
<td>String value</td>
<td>Value that displays the response as it appears on a questionnaire. In some cases this is the same as the <strong>Actual value</strong>, such as when the question data type is <strong>Percentage</strong>. The string value is <strong>N/A</strong> for unanswered questions of certain data types.</td>
</tr>
</tbody>
</table>

### Normalized value for an assessment

The normalized value is calculated based on a linear equation and the scale definition of the metric. This value can be used for risk assessment.

### Normalized value for any metric

The normalized value is directly proportional to the scale definition of the metric. If the scale definition is low, that is, the lower scale values are better, then

\[
\text{Normalized value} = 1.0 - \text{Normalized value}
\]

For reporting purpose, use the Metric Result [asmt_metric_result] table.

\[
\text{Normalized value} = \frac{(\text{Input Value} - \text{Min value defined in metric})}{(\text{Max value defined in metric} - \text{Min value defined in metric})} * \text{(current metric weight / (sum of valid metric weight in the metric category))} * \text{scale_factor}
\]

**Note:**

- If a metric is skipped when taking the assessment, its weight is excluded when calculating `sum of valid metric weight in the metric category`.
- The following metric types are excluded in the normalized value calculation:
  - String
  - Date
  - Date/Time
  - Reference
  - Attachment
  - Ranking

For example, consider the following scenario.

Calculate the normalized value for the **Please rate the competency of the technician** metric.
### Values of the metric

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input value</td>
<td>3</td>
</tr>
<tr>
<td>Minimum value</td>
<td>1</td>
</tr>
<tr>
<td>Maximum value</td>
<td>6</td>
</tr>
<tr>
<td>Current metric weight</td>
<td>10</td>
</tr>
<tr>
<td>Number of metrics in the metric category</td>
<td>6</td>
</tr>
<tr>
<td>• of type=number</td>
<td></td>
</tr>
<tr>
<td>• of type=yes/no</td>
<td></td>
</tr>
<tr>
<td>• of type=string (invalid data type; value cannot be calculated)</td>
<td></td>
</tr>
<tr>
<td>Valid metric weight of each response</td>
<td>10</td>
</tr>
<tr>
<td>Scale factor</td>
<td>10</td>
</tr>
</tbody>
</table>

Normalized value = \(\frac{(3 - 1)}{(6 - 1)} \times \frac{10}{(10 + 10 + 10 + 10 + 10)} \times 10 = 0.8\)

**Normalized value for a multiple selection metric**

The normalized value for a multiple selection metric is calculated by using the weight of the metric and the score for each choice of the metric.

In a multiple selection metric, for each choice that should be used for the normalization calculation, define the normalization input value.

\[
\text{Normalized value} = (\text{Score of all choices}) \times \left(\frac{\text{current metric weight}}{\text{sum of valid metric weight in the metric category}}\right) \times \text{scale_factor}
\]

Here, score of all choices of the metric is the sum of individual scores of each choice.

- Score of each choice in a multiple selection metric = Normalization input of the choice / max value of the metric
- max value of the metric = Sum of the normalization input for all choices of the metric
- min value of the metric is always 0

For example, consider the following scenario.

Calculate the normalized value for the multiple selection metric, **Please rate the competency of the technician**, with three choices, A, B, and C.
Values of the metric

<table>
<thead>
<tr>
<th>Choice</th>
<th>Normalization input is 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choice A</td>
<td>Normalization input is 1</td>
</tr>
<tr>
<td>Choice B</td>
<td>Normalization input is 1</td>
</tr>
<tr>
<td>Choice C</td>
<td>Normalization input is 2</td>
</tr>
<tr>
<td>Minimum value</td>
<td>0</td>
</tr>
<tr>
<td>Maximum value</td>
<td>4</td>
</tr>
<tr>
<td>Current metric weight</td>
<td>10</td>
</tr>
<tr>
<td>Number of metrics in the metric category</td>
<td>5</td>
</tr>
<tr>
<td>Valid metric weight of each metric</td>
<td>10</td>
</tr>
<tr>
<td>Scale factor</td>
<td>10</td>
</tr>
</tbody>
</table>

If Choice A and B are selected, Normalized value = \((\frac{1}{4} + \frac{1}{4}) \times \frac{10}{(10 + 10 + 10 + 10 + 10)} \times 10 = 1\)

Weighted value for a risk assessment

For a risk assessment, the weighted value from metric results table is calculated as following.

\(\text{weighted\_value} = \text{metric\_weight} \times \text{result\_actual\_value}\)

View a survey scorecard

A survey scorecard provides a visual breakdown of survey responses by category, based on the way questions were answered.

Before you begin
Role required: survey_admin or survey_reader

About this task
A scorecard displays charts for survey results, in which category and question responses are analyzed and current ratings are compared with previous ratings. Users can examine ratings over time, compare question ratings, or compare the ratings of all categories. All ratings are averages for the time range selected. The system dynamically updates a scorecard each time you view it, so the ratings reflect recently completed surveys.
**Procedure**

1. Navigate to **Survey > View Surveys**.
2. Open a survey definition.
3. Under **Related Links**, click **View Scorecard**. The interactive scorecard displays the following filters:
   - **Question Results**: Displays the result of all questions or an individual question.
   - **Category Results**: Displays the results of all questions associated with an individual category or all categories.
   - **Average Ratings**: Displays the result of weighted average rating for each survey question in an individual category or all categories.
   - **History**: Displays the result of all questions in comparison with their history (by calendar year or quarters).
   - **Sentiment Analysis Results**: Displays the results of sentiment analysis for the survey.

   **Note**: The scorecard link is hidden if there are no survey results to report.

**Survey scorecard category results**

The Category Results view is a stacked bar chart showing survey results for all questions in an individual category or all categories by respondent count.

Select a category from the list to display the questions from that category in the chart.

This view displays responses that use the following data types:

- Checkbox
- Choice
- Likert Scale
- Number
- Template
- Yes/No
- Multiple selection
- Image Scale
- Numeric Scale
**Note:** The **Checkbox** and **Yes/No** data types are combined into the **Boolean** data type in the Survey Designer.

Survey category results

Scorecard Customer Satisfaction Survey

To view details about a specific response, point to the colored bar to display the response, the number of responses, and the percentage it represents of all the responses to that question.

Survey scorecard category results detail

Survey scorecard question results

The **Question Results** filter displays the result of all questions or an individual question using charts or lists. For the String, Attachment, Date, Date/time, Reference, and Ranking data types, the results are displayed in the list view. The results of all other data types are displayed in the pie chart view.

**Pie chart**

The pie chart shows question results for all data types other than those that are displayed in the list view. See **Survey question data types**.
• Checkbox.
• Boolean.
• Choice.
• Likert Scale.
• Number.
• Percentage.
• Yes/No.
• Image Scale.
• Multiple Selection.
• Template. The question result shows the aggregated net promoter score (NPS) with promoters, detractors, and passives.

<table>
<thead>
<tr>
<th>Question score</th>
<th>NPS category</th>
</tr>
</thead>
<tbody>
<tr>
<td>9 or 10</td>
<td>Promoter</td>
</tr>
<tr>
<td>7 or 8</td>
<td>Passive or Neutral</td>
</tr>
<tr>
<td>0 to 6</td>
<td>Detractor</td>
</tr>
</tbody>
</table>

The result is calculated as:
- \( \% \text{Promoters} = \frac{\text{Number of promoters}}{\text{Sample size}} \)
- \( \% \text{Detractors} = \frac{\text{Number of detractors}}{\text{Sample size}} \)
- \( \% \text{Passives} = \frac{\text{Number of passives}}{\text{Sample size}} \)
- \( \text{NPS} = \% \text{Promoters} - \% \text{Detractors} \)

Note: The Checkbox and Yes/No data types are combined into the Boolean data type in the survey designer.
Survey scorecard average ratings

The Average Ratings view displays the weighted average rating for each survey question in an individual category or all categories.

Use this view to learn how individual questions affect the overall rating for the category. Select a survey category from the choice list to display the chart for that category.
To view the effect of each question's ratings on the entire category's ratings, point to the colored bar. The pop-up box shows the percentage of the total ratings represented by each individual question's weighted average.

**Survey scorecard history**

The History view compares the current ratings for the categories and their questions with ratings from the previous three years or four quarters.

Ratings that have declined are highlighted in red and display negative numbers. Ratings that have improved are highlighted in green with positive numbers. Arrow icons beside the values in the **Diff** column indicate the trend of the current survey against the previous survey.
Point to a category to display a line chart that shows the rating trend for that category. Click a category to view the Survey Category form containing the survey questions.

![Survey scorecard trend chart](chart.png)

**3 years**

To calculate the current ratings, the system averages the ratings from the trailing twelve month (TTM) period. The **Diff** column shows the discrepancy between the current ratings and the previous calendar year's ratings.
Survey scorecard history - 3 years

<table>
<thead>
<tr>
<th>Survey Scorecard</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Overall Rating</strong></td>
<td><strong>Current</strong></td>
<td><strong>Diff</strong></td>
<td><strong>2013</strong></td>
<td><strong>2012</strong></td>
</tr>
<tr>
<td>Service Desk Satisfaction Survey</td>
<td>5.40</td>
<td>0.00</td>
<td>5.40</td>
<td>0.00</td>
</tr>
<tr>
<td>How satisfied were you with the response time to your incident? (1=not at all, 6=excellent)</td>
<td>0.00</td>
<td>-1.02</td>
<td>1.02</td>
<td>0.00</td>
</tr>
<tr>
<td>How courteous and respectful was the technician who responded? (1=poor, 6=excellent)</td>
<td>0.00</td>
<td>-1.21</td>
<td>1.21</td>
<td>0.00</td>
</tr>
<tr>
<td>Please rate the technical competency of the technician serving you (1=poor, 6=excellent)</td>
<td>0.00</td>
<td>-1.02</td>
<td>1.02</td>
<td>0.00</td>
</tr>
<tr>
<td>Was technician able to resolve your issue during the first call?</td>
<td>0.00</td>
<td>-1.00</td>
<td>1.00</td>
<td>0.00</td>
</tr>
<tr>
<td>How satisfied are you with your overall service experience? (1=not at all, 6=excellent)</td>
<td>0.00</td>
<td>-1.14</td>
<td>1.14</td>
<td>0.00</td>
</tr>
</tbody>
</table>

4 quarters
Quarterly surveys compare the average rating for each question and category in the current quarter against the average ratings from the previous four quarters. The **Diff** column shows the discrepancy between the current ratings and the previous quarter's ratings. The column labels count backward, by quarter from the current quarter. For example, if the current quarter is the 3rd quarter of 2015, then the previous quarters appear as 2nd [2015], 1st [2015], 4th [2014], and 3rd [2014]. All four of the previous quarters appear, whether or not there was any data for those quarters.
Export a survey scorecard as an image

You can export a scorecard as an image to use in presentations or other documents.

Before you begin
Role required: admin or survey_admin
Procedure

1. Click the menu icon (≡) and select **Save as PNG** or **Save as JPEG** and wait for the export to complete.

Example

2. Click **Download** and save the scorecard image to a storage location.

Survey administration

Survey administrators—users with the survey_admin role—create and maintain surveys and configure how they are distributed and published. Surveys on Service Portal are also supported.

Survey administration includes the following procedures.

• Create, customize, and publish surveys.

• Write and maintain survey questions.

• Define trigger conditions for when surveys are sent to users, such as when an incident closes.

• Maintain surveys and survey questions as the organization's needs change.
To set up surveys in Service Portal, you must first install Service Portal and then configure the Survey widget on the page. The base system includes the Survey widget.

**View the overview of all surveys**

Use this homepage to view various survey reports such as results by metric type and state.

**Before you begin**

Role required: admin or survey_admin

**About this task**

You can refresh, add, delete, and rearrange widgets. All reports on the Survey Overview page have demo data.

**Procedure**

1. Navigate to **Survey > Overview**.
   The following reports are available:

<table>
<thead>
<tr>
<th>Report</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment group Customer Satisfaction</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>90 day average</td>
<td></td>
</tr>
<tr>
<td>Service Desk Survey 'Timely Response'</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>90 Days</td>
<td></td>
</tr>
<tr>
<td>Surveys by Metric Type and State</td>
<td>Assessment Instance [asmt_assessment_instance]</td>
</tr>
<tr>
<td>Service Desk Survey 'Overall Experience'</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>60 Days</td>
<td></td>
</tr>
<tr>
<td>Service Desk Survey 'Tech Courteous'</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>90 Days</td>
<td></td>
</tr>
<tr>
<td>Service Desk Survey 'First Call Resolve'</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>60 Days</td>
<td></td>
</tr>
<tr>
<td>Service Desk Survey 'Tech Competence'</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>60 Days</td>
<td></td>
</tr>
</tbody>
</table>
2. To view the required information, click elements within the reports.
3. To refresh, edit, or close a widget, point to the widget and select the required option.

**Survey designer**

Users with the survey_admin role can use the survey designer. The survey designer lets you create survey categories and questions, configure the details, and publish the survey to specific users or groups.

You can assign a survey to individual users or groups who receive all the questions from all the categories. You can also customize each question and make it dependent on the response to another question. The following describes the procedures you follow to create and publish a survey.

- Create survey categories.
- Create questions within each category.
- Configure survey details, such as introductory and closing remarks and time limit.
- Select recipients for the survey.
- Publish the survey to the selected users or groups.

**Note:** The survey designer replaces the survey creator in the Legacy Surveys application. If you are using Internet Explorer version 8 or earlier, the system redirects you to the survey creator.

**Related information**

Create a survey designer template question
Select recipients for a survey in the Survey Designer
Publish a survey in the Survey Designer

**Survey designer elements**

The survey designer is accessible from **Survey > Survey Designer**.

The survey designer contains the Controls tab, the Questions tab, the Categories tab, a header bar, and the design canvas.

**Controls tab**

To create a question, drag the appropriate data type control from the Controls palette and drop it onto the designer canvas.
The assessment engine provides a built-in result calculation feature that converts responses to scored question data types to a score from 0 through 10.

### Question data types

<table>
<thead>
<tr>
<th>Data type</th>
<th>Scored</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>No</td>
<td>Question with a Manage Attachments icon that allows users to attach one or more files.</td>
</tr>
</tbody>
</table>
### Question data types (continued)

<table>
<thead>
<tr>
<th>Data type</th>
<th>Scored</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>Yes</td>
<td>Question with a check box or Yes and No choices for user responses.</td>
</tr>
<tr>
<td>Choice</td>
<td>Yes</td>
<td>List of predefined options. For more information, see the definition of the <strong>Choices</strong> field in Create a question in the survey designer.</td>
</tr>
<tr>
<td>Date</td>
<td>No</td>
<td>Date field.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>No</td>
<td>Date and time field.</td>
</tr>
<tr>
<td>Number</td>
<td>No</td>
<td>Number field with predefined minimum and maximum values. The default is 1-10.</td>
</tr>
<tr>
<td>Percentage</td>
<td>No</td>
<td>Percentage field with a prescribed range.</td>
</tr>
<tr>
<td>Scale</td>
<td>Yes</td>
<td>Predefined Likert scale. Answer options appear as radio buttons.</td>
</tr>
<tr>
<td>Numeric Scale</td>
<td>Yes</td>
<td>Selectable number scale. The default is 1-5. Answer options appear as radio buttons.</td>
</tr>
<tr>
<td>String</td>
<td>No</td>
<td>Single or multi-line text field.</td>
</tr>
<tr>
<td>Template</td>
<td>Yes</td>
<td>Choice list of templates that provide a predefined scale of options. For details, see <strong>Quiz scorecards</strong>.</td>
</tr>
<tr>
<td>Reference</td>
<td>No</td>
<td>Choice list of fields from a specified reference table. This data type does not support reference qualifiers. For example, a user could select a user name if you specify sys_user as the reference table.</td>
</tr>
<tr>
<td>Image Scale</td>
<td>Yes</td>
<td>Question with a choice of images that can be selected. A template can be used to apply the same images to multiple questions.</td>
</tr>
<tr>
<td>Multiple Selection</td>
<td>Yes</td>
<td>Question with multiple check boxes that can be selected.</td>
</tr>
<tr>
<td>Ranking</td>
<td></td>
<td>Question with an order number to be selected for each option. One order number cannot be selected twice. This question can be mandatory and it can also be dependent on a parent question, but not vice versa.</td>
</tr>
</tbody>
</table>
Questions tab
This tab displays all metrics added to the question bank for surveys. Use the Filter field to search for questions. Each metric is displayed with its name and type.

Categories tab
This tab displays all metric categories added to the question bank for surveys. All metrics in the question bank are grouped under the corresponding metric category. Use the Filter field to search for categories or questions.

Header bar
The tabs on the header bar display views and a menu of functions. Click a tab to change the view on the canvas:

• **Design**: Add and configure the properties of categories and questions. This is the default view.
• **Configuration**: Create introductions and end notes for surveys and select a signature.
• **Availability**: Select the recipients for each category in the survey.

Point to the menu icon (≡) to select an option. The list of options depends on the currently open survey.

• **Save**: Save the current survey without changing its state.
• **Preview**: Display a preview of the survey as it appears to recipients.
• **Publish**: Distribute the survey to the selected recipients.
• **Save and Publish**: Save the survey to the Draft state and distribute the survey in one step.
• **New Survey**: Open a fresh canvas for a new survey.
• **Load Survey**: View the list of existing surveys.
• **Copy Survey**: Copy the current survey.

Design canvas
New surveys open in the canvas of the Design view. The survey Name field appears above first category in the canvas. A blank question field appears in the category container.
Configure a survey in the survey designer

Configuration settings apply to the entire survey.

**Before you begin**
Role required: admin, survey_creator, or survey_admin

**Procedure**

1. Navigate to **Survey > View Surveys**.
2. Open a survey definition in Survey Designer.
3. Select the **Configuration** tab and complete the Survey Designer Configuration form.

**Configuration tab fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Select the check box to enable the distribution of this survey to recipients.</td>
</tr>
<tr>
<td>Survey Owners</td>
<td>Owners of the survey. You can add a user with the survey_creator, survey_admin, or assessment_admin role.</td>
</tr>
<tr>
<td>Anonymize responses</td>
<td>Select the check box to collect survey responses anonymously. Recipients are not listed with survey results. When a user submits a survey, the system clears the Assigned to field for the associated survey instance. Also, survey responses for anonymous surveys do not contain Assigned to values.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of this configuration or the survey to which it is attached.</td>
</tr>
</tbody>
</table>

**Note:** The Assigned to field is cleared. However, each response record includes the Created By and Updated By fields that are accessible to users with the survey_admin role.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not show survey introduction notes</td>
<td>Check box to skip the introduction notes when a survey is launched. This functionality is applicable in both the Now Platform and Service Portal product versions.</td>
</tr>
<tr>
<td>Introduction</td>
<td>Introductory content to display on surveys. You can add a welcome message or background information about the survey.</td>
</tr>
<tr>
<td>Signature</td>
<td>Acknowledgement by a survey recipient of requirements, admonitions, or expectations related to a survey.</td>
</tr>
<tr>
<td>Return URL</td>
<td>Destination address of a web page that is presented to users after they submit a completed survey. When a return URL is configured, the End note content does not appear.</td>
</tr>
<tr>
<td>End note</td>
<td>Content that is displayed to recipients after they submit a completed survey. You can add a thank you message, follow-up instructions, or other applicable information. End notes are not displayed if a Return URL is specified.</td>
</tr>
<tr>
<td>Public Survey</td>
<td>Enables public access to the survey. No login is required to take a public survey and users or non-users can respond anonymously. For completed public surveys, the Assigned to field value is Guest.</td>
</tr>
<tr>
<td>Note:</td>
<td>This check box is available only after you save the survey.</td>
</tr>
<tr>
<td>Survey Publish URL</td>
<td>Specifies a URL of the survey that can be shared with users.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field is available only after you publish the survey.</td>
</tr>
<tr>
<td>Pagination setting for Service Portal view</td>
<td>Specify how the user will see pages on the desktop or tablet view in Service Portal.</td>
</tr>
<tr>
<td>• Category</td>
<td>Display each category on a separate page.</td>
</tr>
<tr>
<td>• Question</td>
<td>Display each question on a separate page. This happens for mobile regardless of this setting.</td>
</tr>
<tr>
<td>• None</td>
<td>All items on a single page—no pagination</td>
</tr>
<tr>
<td>Default: Category</td>
<td>Category</td>
</tr>
<tr>
<td>Note:</td>
<td>This field appears only when Service Portal is installed.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Chat Survey</td>
<td>Option to validate if survey questions are supported in a chat survey. Enables conversational questionnaires (pre-chat and post-chat surveys) in the chat client. Also enables you to map chat context variables to survey questions. For information on a chat survey in ITSM Virtual Agent, see <a href="#">Surveys in ITSM Virtual Agent</a>.</td>
</tr>
<tr>
<td>One Click Survey</td>
<td>Enables a One Click survey in Service Portal.</td>
</tr>
<tr>
<td>Source Table</td>
<td>Table whose field is used as a dynamic value for a question in a triggered survey.</td>
</tr>
<tr>
<td>Allow Sentiment Analysis</td>
<td>Enables sentiment analysis for this survey.</td>
</tr>
<tr>
<td>Duration</td>
<td>Amount of time that recipients are given to complete this survey, starting from the time that the survey is generated. The default duration is 14 days.</td>
</tr>
<tr>
<td>Outlook Actionable Message</td>
<td>Includes an embedded survey in the survey email notification. After you select this check box and save the survey, a validation is run to ensure all survey questions are supported.</td>
</tr>
</tbody>
</table>

4. Select the **Availability** tab and complete the form,

**Availability tab fields**

| Accessible by | Defines who can access the survey. Possible values are |

---

Note: This field is available only when the Glide Conversation Server plugin (com.glide.cs) is activated. **Note:** This option can be selected if the Pagination setting for Service Portal view is set to **None.** **Note:** When you select a source table, ensure that its relevant field is selected as **Source Field** value of a metric. **Note:** By default, the system runs the **Cancel Expired Assessments** script every 30 days to cancel expired survey, assessment, and quiz instances that are in the Work in progress or Ready to take states.
Anyone: Accessible by anyone with the survey link.
Specific users: Accessible by specified users.

<table>
<thead>
<tr>
<th>Survey groups only</th>
<th>If selected, a survey is available for survey groups only.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note:</td>
<td>This field is displayed only if the Accessible by is Specific users.</td>
</tr>
</tbody>
</table>

Add group users

Group users for whom the survey is available.

Note: This field is displayed only if the Accessible by is Specific users.

Add users

Users for whom the survey is available.

Note: This field is displayed only if the Accessible by is Specific users.

Add recipients lists

Recipients lists for whom the survey is available.

Note: This field is displayed only if the Accessible by is Specific users.

Related information

View a survey scorecard
Create a survey designer template question
Select recipients for a survey in the Survey Designer
Publish a survey in the Survey Designer
Create an assessment signature

Survey categories

Survey categories provide a way to group questions of a similar theme for a given survey.

There must be at least one survey category per survey definition and every survey question must be associated with a category. When you create a survey, the system generates one category, which all the questions belong to.

For simple surveys, one category is usually enough. Consider creating additional categories if you want to accomplish any of the following tasks.
• Separate groups of questions into collapsible sections by category on the survey questionnaire.
• Report on category scores, which are calculated based on responses for all questions within each category.

Create a category in the survey designer
A category represents a theme for evaluating a specific element of the survey topic and contains questions pertaining to that theme.

Before you begin
Role required: admin or survey_admin

About this task
When you create a survey, the system creates a default category, using the name of the survey. You can use this category, modify it, and create additional categories as needed. To have any results, a category must contain scored questions.

Procedure
1. Navigate to Survey > Survey Designer.
2. Enter the name of the survey in the Name field.
   The system uses this name as the name of the survey and of the first category.
3. To configure the category, click the gear icon in its title bar and complete the following steps in the Properties dialog box.
   a. Enter a new name and a description for the category.
   b. Enter text in the Details field that introduces or explains the category to recipients.
   c. Click the X icon to close the Properties dialog box and save your settings.
4. To add a new category, click the + icon in the title bar of an existing category.
   The new category appears below the category that you selected to create it. You can click the X icon in a category header to delete a category that you added in error.

Create a survey category in a survey
You can modify an existing survey to add one or more survey categories.

Before you begin
Role required: admin or survey_admin
About this task

Only one category is required for each survey, but you can add additional categories as needed.

Procedure

1. Navigate to Survey > View Surveys.
2. Open a survey definition.
3. In the Metric Categories related list, open a category or click New. Each survey category is stored as a record on the Metric Category [asmt_metric_category] table with a modified view for survey use.
4. Enter the survey category name and description. The category name appears on questionnaires when either of the following is true.
   - There is more than one category for the survey.
   - There is only one category and its name is different from the survey definition name. If you create a survey using the survey creator, the category name is the same as the survey definition name.
5. Right-click the form header and click Save. The Assessment Metrics and Users related lists appear.
6. Click Update.

Create a question in the survey designer

You can create multiple questions for each category in the survey designer, but each question can only be associated with one category.

Before you begin
Role required: admin or survey_admin

About this task
The data type that you select for each question determines how it can be answered by survey recipients.

Procedure
1. In the Design view, drag a data type icon from the Controls palette and drop it into a category container.
2. To configure the question, click the gear icon in its title bar. The Properties dialog box opens.
3. Complete the form.
### Question property fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Concise name of the question. The system uses this value to identify the question in Assessment Metric lists and in scorecard charts.</td>
</tr>
<tr>
<td>Question</td>
<td>Text to display as the question on surveys. Enter a clear, straightforward question that is easy to understand.</td>
</tr>
<tr>
<td>Type</td>
<td>Data type selected for this question. See the table in Controls for the available data types.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that determines whether this question is available on a survey. A question does not appear on surveys that are generated after the question becomes inactive.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Check box to require users to answer the question. Mandatory questions are denoted by a red field status indicator and must be answered before the survey can be submitted. This field is available when the question does not have a dependency and the question type is not <strong>Boolean</strong> with a check box option.</td>
</tr>
<tr>
<td>Allow Additional Information</td>
<td>If selected, the <strong>Additional Information Label</strong> field is enabled. The <strong>Additional Information Label</strong> field value is displayed as a field on the survey response page to provide additional information for a question.</td>
</tr>
<tr>
<td>Note:</td>
<td>This is not applicable for the String and Template data types.</td>
</tr>
<tr>
<td>Boolean option</td>
<td>Whether a check box or a <strong>Yes/No</strong> list appears as the option for a Boolean question.</td>
</tr>
<tr>
<td>String option</td>
<td>Setting for the appearance of a string field in a question. This field is available when the question type is <strong>String</strong>. The string options include the following.</td>
</tr>
<tr>
<td>• Single line</td>
<td>Single-line text field 40 characters in length that allows strings of any length.</td>
</tr>
<tr>
<td>• String line wide</td>
<td>Full page width text field that allows a single-line entry of any length.</td>
</tr>
<tr>
<td>• Multiline</td>
<td>Full page width multiline text field that allows word wrap and returns</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Min</td>
<td>Lowest positive whole number that users can enter or select to answer the question. This field is available when the question type is <strong>Number, Percentage, or Numeric Scale</strong>.</td>
</tr>
<tr>
<td>Max</td>
<td>Highest positive whole number that users can enter or select to answer the question. This field is available when the question type is <strong>Number, Percentage, or Numeric Scale</strong>.</td>
</tr>
<tr>
<td>Allow not applicable</td>
<td>Check box for including <strong>Not Applicable</strong> as an option for this question. Users can select <strong>Not Applicable</strong> if they do not have sufficient information to respond to a question. User responses of <strong>Not Applicable</strong> are excluded from results calculations. This field is available when the question does not have a dependency and the question type is not <strong>Boolean</strong> with a check box option.</td>
</tr>
<tr>
<td>Randomize answers</td>
<td>Check box for displaying answer options in a random order. Answer preference is sometimes influenced by the order in which options appear, which can result in biased results. Randomizing options can help prevent this bias. <strong>Note:</strong> Randomizing options for certain questions may make those questions confusing for users. In general, only randomize options that do not follow a logical order.</td>
</tr>
<tr>
<td>Positive indicator</td>
<td>Setting that determines whether smaller or larger numerical values equate to a good score in result calculations. Select <strong>Low values</strong> if smaller numerical values are better, such as for a question that measures the number of incidents for a vendor. Select <strong>High values</strong> if larger numerical values are better, such as for a question that measures user satisfaction on a scale of one to five.</td>
</tr>
<tr>
<td>Source Field</td>
<td>Source table field that appears as a dynamic value for the question in a triggered survey. When this field value is selected, a <code>$(param)</code> placeholder is added at the end of the question label. <strong>Note:</strong> You can move this placeholder anywhere in the question label. When a user takes the survey, the question with dynamic value is included in the survey instance and <code>$(param)</code> placeholder is replaced with the source field value.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>If the record table specified in the trigger condition does not match the source table specified for the survey, or if the system fails to get the dynamic value from the source record, the <code>${param}</code> placeholder is not replaced by any value and is displayed as is in the question. For example, if the survey is triggered from a PRB record and the survey question is configured with a dynamic value from Incident, the <code>${param}</code> placeholder in the survey question label is not replaced by any dynamic value and is displayed as is. <strong>Note:</strong> When survey questions are translated to other languages by a survey admin, the <code>${param}</code> placeholder should not be translated.</td>
</tr>
<tr>
<td>Allow Sentiment Analysis</td>
<td>Includes this question for the sentiment analysis of a survey. <strong>Note:</strong> This field is available only for String type questions.</td>
</tr>
<tr>
<td>Details</td>
<td>Information about the question that is displayed on the survey. Include details that help users understand how to answer the question.</td>
</tr>
<tr>
<td>Choices</td>
<td>Options for a question with a data type of Choice or Scale. The system automatically adds text and values that you can edit for each option. You must have at least two options, and each option must have a unique value. Click the + icon to add an option, or click the X icon to delete an option. By default, the system arranges options in the order established by their values. To change the order, drag and drop the options. <strong>Note:</strong> Value numbers also contribute to the calculations of survey response scores, which can be used by advanced survey administrators.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
4. To create any special conditions that must be met before the question appears on the survey, click the Dependency tab.
   The question must have a data type of **Boolean, Choice, Scale, or Template**.

5. Select a question in the **Displayed when** field.
   The system selects the appropriate operator and displays the possible answers for the selected question.

6. Select the answer that satisfies the condition.
   You can select more than one answer. Selected answers are indicated by a check mark.
   The system prevents recursive dependencies between questions. For example, if Question A depends on Question B, Question B cannot depend on Question A.

7. Click the **X** icon to close the question properties dialog box and save your settings.

8. To add a question with the same data type as an existing question in the category, click the **+** icon in the title bar of the existing question.

9. Drag and drop questions to change their order within a category or move them between categories.

10. To delete a question, click the **X** icon in its title bar.

**Related information**

- Survey question template
- Create a survey designer template question

**Survey question data types**

You must choose a data type for each survey question. The data type determines the format of the question and the kind of data that is collected on survey questionnaires.

The following data types are available for surveys:

**Attachment data type**

On questionnaires, users can attach one or more files to a question.

Users click the Manage Attachments icon and select one or more files in the Attachments pop-up window to attach to the question. From this window, users can:
• View a list of the attached files.
• View an attached file in a separate window.
• Rename an attached file.
• Add or delete files

Once a survey has been submitted, attachments cannot be updated or deleted.

Any type of file supported by the platform can be attached to a question. One or more files can be attached a question while taking a survey or completing an assessment.

The assessment administrator can see the attachments associated with an individual question as well as those associated with the survey.

See Administering Attachments for more information.

Boolean data type
On questionnaires, users select a check box beside a statement or leave it cleared.

If you select Boolean, you must fill in the Scale definition field. Select High if it is best when users select the check box.

Choice data type
On questionnaires, users select a value from a list of choices.

If you select Choice, you must fill in the Scale definition field and create answer options. Select High for the scale definition if the answer option with the largest metric definition Value is best.

Note: The system sets the Min and Max fields automatically based on the Value settings for the associated metric definitions.
Date and Date/Time data types

The **Date** and **Date/Time** data types are similar.

- **Date**: On questionnaires, users select a date.

- **Date/Time**: On questionnaires, users select a date and time.

Likert Scale data type

On questionnaires, users select a multiple choice value from a custom Likert scale. Each answer option is represented by a radio button on the scale. A Likert scale question that evaluates an application’s ease of use might have the answer options **Easy**, **Average**, and **Difficult**.
If you select **Likert Scale**, you must fill in the **Scale definition** field and create answer options. Select **High** for the scale definition if the answer option with the largest metric definition **Value** is best.

ℹ️ **Note:** The system sets the **Min** and **Max** fields automatically based on the **Value** settings for the associated metric definitions.

### Number data type
On questionnaires, users enter a number.

If you select **Number**, you must fill in these additional fields:
- **Scale definition**: Select **High** if a larger number is better, such as for a question that measures the number of sales made in a quarter.
- **Min** and **Max**: Enter the smallest and largest numbers users can enter. State the range of acceptable answers in the question text.

### Percentage data type
On questionnaires, users enter a number.

If you select **Percentage**, you must fill in these additional fields:
- **Scale definition**: Select **High** if a larger percentage is better, such as for a question that measures the percentage of work an agent has completed.
- **Min** and **Max**: Enter the smallest and largest numbers users can enter. Generally **0** and **100** are appropriate minimum and maximum values. If you choose values other than **0** and **100**, it is usually best to state the range of acceptable answers in the question text.
Reference data type

On questionnaires, users select a value from a list that is generated from a specified reference table. The response field supports auto-completion.

ℹ️ Note: Reference qualifiers are not supported.

For example, a user could select a user name in response to a question if you specify User [sys_user] as the reference table.

String data type

On questionnaires, users enter text. When you select String, the String option field appears. Select one of the following options to determine how the string field appears on questionnaires:
• Single line

| Additional comments |

• Single line wide

| Additional comments |

• Multiline

| Additional comments |

**Template data type**

On questionnaires, users select a value from a predefined series of answer options. To use this data type, a question template must be defined.

If you select **Template**, you must fill in these additional fields:

• **Template**: Select a template.

• **Scale definition**: Select **High** if the answer option with the largest template definition **Value** is best.

**Yes/No data type**

On questionnaires, users select **Yes** or **No** from a list.
If you select **Yes/No**, you must fill in the **Scale definition** field. Select **High** if **Yes** is the best answer.

**Image Scale data type**

On questionnaires, users select an image from a predefined set of images as their response. Image scale questions can also be used in a template for better performance with surveys that have the same type of answer options.

Five emojis, similar to the Likert scale (very dissatisfied to very satisfied) are provided. However, you can upload additional images in JPG, PNG, or GIF format. Two images can be uploaded, one for selected case and another for unselected case. Larger size images are reduced to 64 x 64 pixels.

The result behavior depends on the presence of uploaded images. If no selected image is uploaded, then the question shows up blank.

<table>
<thead>
<tr>
<th>Selected image</th>
<th>Unselected image</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Unselected image loads. Clicking on the image changes it to the selected image.</td>
</tr>
<tr>
<td>Yes</td>
<td>No</td>
<td>Selected image loads with 50% opacity. Clicking on the image changes the opacity to 100%.</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>A blank placeholder box is displayed.</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>A blank placeholder box is displayed.</td>
</tr>
</tbody>
</table>

**Note:** N/A option is not supported for image scale type question.

**Multiple selection data type**

On questionnaires, users can select multiple check boxes indicating all answers that apply. For instance, a user can be instructed to "Select all that apply" in a multiple selection question.
Ranking data type

On questionnaires, users can select a different order number for each option to rank them. Drag-and-drop functionality is also supported, which allows a user to either fill in the number, or simply drag an option.

One order number cannot be selected twice. This question can be mandatory and it can also be dependent on a parent question, but not vice versa.

Related information
Survey question template

Edit a survey in the survey designer
You can modify surveys using the survey designer.

Before you begin
Role required: admin or survey_admin

About this task
You can edit a survey even after it has been distributed, with the following results.
• Added questions are available only on surveys that are distributed after this change.
• Changes to existing questions are immediately available to users before the survey is submitted or during the retake period. This includes changes to the answers, such as additional choices or changes to the data type.
• Deleted questions are also deleted from the distributed surveys in user queues.

⚠️ **Note:** You can only edit a survey that has the same application scope as that of your current session.

**Procedure**
1. Navigate to **Survey > Survey Designer**.
2. Point to the menu icon in the survey header bar, and select **Load Survey**.
3. Select a survey from the list and modify it as needed.
4. Point to the menu icon in the survey header bar, and select **Save** or **Save and Publish**.
   - When you publish the edited survey, the system generates survey instances for any associated survey users.

**Configure category weights for a survey**
You can assign a weight to each category in a survey. The system calculates results from the weight that you configure.

**Before you begin**
Configure the Survey Category form to display the **Weight** field.
Role required: admin or survey_admin

**About this task**
Weights are set to a value of **10** by default but can be changed.

**Procedure**
1. Navigate to **Survey > View Surveys** and select a survey from the list.
2. In the Survey Definition form, select a category from the **Metric Categories** related list.
3. Edit the default weight value.
4. Click **Update**.
View a survey instance

A survey instance represents one questionnaire assigned to one user. You view an instance to verify that survey instances were created, to check the state of a survey instance, or to reassign a survey instance.

Before you begin
Role required: admin or survey_admin

Procedure
1. Navigate to Survey > Survey Instances. The following sub-modules are available based on the state of the instances:

   • **Ready to take**: Displays survey instances that are ready to be taken by the user. By default, these instances are sorted in ascending order by the **Number** field.

   • **In progress**: Displays survey instances that are in progress. By default, these instances are sorted in ascending order by the **Number** field.

   • **Completed**: Displays survey instances that are complete. By default, these instances are sorted in descending order by the **Taken on** field.

   • **Cancelled**: Displays survey instances that are cancelled. By default, these instances are sorted in ascending order by the **Number** field.

   • **All**: Displays survey instances in all states. By default, these instances are sorted in ascending order by the **Number** field.

2. Open a survey instance from the required sub-module. By default, the following fields are displayed in the Survey Instance form for all sub-modules other than **Completed**.

   **Note:**
   - When you open an instance in the **Completed** sub-module, you are redirected to the User's Response page.
   - Each survey instance is stored as a record on the Assessment Instance [asmt_assessment_instance] table with a modified view for survey use.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated record number.</td>
</tr>
<tr>
<td>Metric type</td>
<td>Survey definition this survey instance was created from. Survey definitions are stored on the Assessment Instance table, and the field label on that table is <strong>Metric type</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Due date</td>
<td>Date by which the survey instance should be completed. The system populates the due date based on the <strong>Assessment duration</strong> of the associated survey definition, which is set to 14 days by default. The survey due date is not enforced in the base system. If you want to enforce the due date, consider using a workflow or other mechanism to send survey recipients reminders when a survey is overdue. <strong>Note:</strong> By default, the system runs the <strong>Cancel Expired Assessments</strong> script every 30 days to cancel expired survey, assessment, and quiz instances that are in the Work in progress or Ready to take states.</td>
</tr>
<tr>
<td>State</td>
<td>State of the survey instance.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User this survey instance is assigned to. This field becomes read-only when the state is In progress, Complete, or Canceled.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain associated with the instance.</td>
</tr>
<tr>
<td>Expiration date</td>
<td>Date on which the assigned user can receive a new instance of the same survey definition. The system automatically populates the expiration date based on the <strong>Schedule period</strong> of the associated survey definition.</td>
</tr>
<tr>
<td>Related Link</td>
<td></td>
</tr>
<tr>
<td>View User's Response</td>
<td>Shows a read-only version of the survey responses completed by the user.</td>
</tr>
<tr>
<td>Retry Sentiment Analysis</td>
<td>Sends the survey instances for sentiment analysis. <strong>Note:</strong> This link is available only if any sentiment analysis result is not available for this instance under <strong>Survey &gt; Question Sentiment Results</strong></td>
</tr>
<tr>
<td>Related List</td>
<td></td>
</tr>
</tbody>
</table>
| Assessment Instance Questions | All instance question records, which store user response values for each question on the survey questionnaire. The following columns are relevant to surveys:  
  • **Category:** Displays the survey categories the questions belong to.  
  • **Metric:** Displays the survey questions.                                                                                                                                                                                                                                                                                                                                 |

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Related information

Schedule periods

Survey users and groups

Survey users and survey user groups help survey administrators control who can take a survey.

Survey administrators can restrict a survey so that only specified users can access it unless a survey administrator manually assigns the survey to a different user. Survey user groups provide a way to quickly designate multiple survey users.

Administering survey users

The list of survey users for a survey is visible on the Survey Definition and Survey Category forms. You can add or remove users from the list of survey users at any point. Note that designating a survey user does not automatically generate a survey instance for that user unless both of the following conditions are true:

- The survey definition Schedule period is set to Daily, Weekly, Monthly, or Yearly. In this case the system assigns a new survey instance to each survey user at the beginning of each schedule period.
- The user has no instances of the survey that are incomplete or that have not yet reached their expiration date.

You can designate survey users from the Survey Designer, the Survey Definition form, or the Survey Category form.

Note: If there are trigger conditions for a survey, do not create survey users. Instead, use the Trigger Conditions form to assign users.

Related information

Send survey invitations to users
Survey trigger conditions
Survey categories
Survey definitions

Create a survey user group

Survey user groups are groups that have the Type field set to survey and display only the information most relevant to surveys. You can assign survey groups or any user group to surveys.
Before you begin
Role required: admin or user_admin

About this task
Though it is possible to designate members of any group as survey users, one reason to create a survey group is to view it conveniently in the survey User Groups module.

By default, the Survey Creators user group is available. When you add a user to this group, the user will be assigned the survey_creator role to create surveys, quizzes, or assessments and view only those surveys, quizzes, or assignments created by the user.

Procedure
1. Navigate to Survey > Administration > User Groups.
2. Click New.
3. Complete the Group form.
4. Right-click the form header and click Save. The Group Members and Groups related lists appear.
5. To add group members, complete the following steps.
   a. In the Group Members related list, click Edit.
   b. Select users from the list on the left and add them to the Group Members List on the right.
   c. Click Save.

Related information

Select recipients for a survey in the Survey Designer
You can assign survey users while designing or modifying the survey.

Before you begin
Role required: admin or survey_admin

Procedure
1. In the Survey Designer, click the Availability tab.
2. Under Accessible by: select the Specific users option, then select users.
3. If desired, select the **Survey groups only** check box, then select survey user groups or other groups.

4. Click **Save**.

**Designate a survey user**

You can designate one survey user at a time from the Survey Definition form.

**Before you begin**

Role required: admin or survey_admin

**Procedure**

1. Navigate to **Survey > View Surveys**.
2. Open a survey definition.
   There must be at least one category.
3. In the **Survey Users** related list, click **New**.
4. Select a **User**.
5. Click **Submit**.
   The Survey Definition form reopens.
6. **Optional:** To remove survey users, in the **Survey Users** related list, select the check box beside the user, and then select **Delete** from the action list below the list.

**Designate or remove multiple survey users at one time**

Use the Survey Category form to designate or remove multiple survey users at a time.

**Before you begin**

Role required: admin or survey_admin

**Procedure**

1. Open a survey definition.
2. In the **Metric Categories** related list, open a category.
   You can choose any category. The system applies survey user changes to all the survey’s categories automatically.
3. In the **Users** related list, click **Edit**.
4. Use the slushbucket to add or remove survey users.
5. Click **Save** to return to the survey category.
   The changes are also reflected in the **Survey Users** related list on the survey definition.

**Allow recipients to retake a survey**

You can configure a survey to allow recipients to resubmit their answers as many times as they like, up to the survey's due date.

**Before you begin**

Configure the Survey Definition form to display the **Allow retake** field. For more information, see

Configure the form .

Role required: admin or survey_admin

**About this task**

Results are not calculated for the survey until the configured duration has elapsed. The card in the user's queue remains visible until the due date of the survey, and a button is displayed to allow retakes.

**Procedure**

1. Navigate to **Surveys > View Surveys**.
2. Select a survey from the list.
3. Select the **Allow retake** check box.
4. Click **Update**.

**Copy a survey**

Create a copy of a survey with at least one category to reduce the effort of creating another survey with similar data.

**Before you begin**

Role required: survey_admin or admin

**About this task**

All associated questions (type), configurations, categories, metrics, domain separation rules, and role-based categories are copied. Assigned users, category users, instances, and trigger conditions are not copied.
Procedure
1. Navigate to Survey > View Surveys.
2. Open a survey definition.
3. Perform any of the following steps:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Platform</td>
<td>In the title bar, click <strong>Copy</strong>.</td>
</tr>
<tr>
<td>From Platform</td>
<td>In the title bar, select <strong>Copy</strong> from the context menu.</td>
</tr>
<tr>
<td>From survey designer</td>
<td>a. In the title bar, click Survey Designer.</td>
</tr>
<tr>
<td></td>
<td>b. In the Survey Designer title bar, point to the menu icon (≡) on the header bar and click <strong>Copy Survey</strong></td>
</tr>
</tbody>
</table>

Publish a survey
You must publish a survey to enable people to receive and complete survey instances.

Before you begin
Role required: admin or survey_admin

About this task
The **State** field on the Survey Definition form indicates whether the survey is in the **Draft** or **Published** state.

⚠️ Note: You cannot return a survey to the **Draft** state after it has been published. You do have the option to deactivate a survey by clearing the **Active** check box.

Procedure
1. Navigate to Survey > View Surveys and select a survey to publish.
2. Click **Publish**.
   When you publish a survey, the system generates survey instances for any associated survey users. You can assign the survey to other users manually.
Publish a survey in the Survey Designer

You must save changes to a survey before you can publish it to the specified recipients or groups.

Before you begin
Role required: admin or survey_admin

Procedure
1. In the Survey Designer, point to the menu and select Load Survey.
2. Select a survey to publish.
3. To preview the survey as a user, point to the menu icon and click Preview.
4. When you are satisfied with the survey, click either Save and Publish or Publish to distribute it.
   When you publish a survey, the system sends email notifications to the recipients and to their managers. The system displays a link to the survey on a card in each recipient's My Assessments & Surveys portal.

Customize the appearance of a survey

Assessment and survey administrators can set properties to customize the color of various elements on the questionnaires.

Before you begin
Role required: admin or survey_admin

About this task
For color properties, enter either an HTML color name or hexadecimal (hex) value. For hex values, the # character is required. Values are not case-sensitive.

For example, all of the following formats are valid: LightGray, lightgray, #D3D3D3. A preview of the color appears next to the field.

Note that the customizations you make apply to all assessments and surveys.

Procedure
1. Navigate to either of the following modules.
   - Assessments > Admin > Assessment Properties
   - Survey > Administration > Properties
2. On the properties page, edit the properties as needed.
   Refer to the screenshot below to see what parts of assessment questionnaires are controlled by the properties.
3. Click **Save**.
   You may need to clear the browser's cache to see updates.

**Assessment and survey properties**

You can configure a variety of properties to customize the appearance of assessment and survey questionnaires, require authentication for user signatures, open surveys in the service portal view from emails, and limit the number of items shown in a decision matrix field filter.

### Assessment and survey properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sn_portal_surveys.sp_survey.email_redirection</code></td>
<td>Allow survey link from email to open in service portal view (applies only for surveys)</td>
<td>When Yes is selected, a survey accessed from a link in an email opens in the Service Portal.</td>
</tr>
<tr>
<td><code>com.snc.assessment.signature_authentication</code></td>
<td>Require authentication</td>
<td>When Yes is selected,</td>
</tr>
</tbody>
</table>

### Note:
This property applies only to surveys.

- Default value: No
### Assessment and survey properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>for user signature.</td>
<td></td>
<td>this property requires credentials for a full name signature.</td>
</tr>
<tr>
<td>• Default value: Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>css.assessment.question.header.background.color</td>
<td>Assessment question header background color</td>
<td>Sets the background color of question headers on assessment and survey questionnaires.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: #767676</td>
</tr>
<tr>
<td>css.assessment.caption.background.color</td>
<td>Assessment caption background color</td>
<td>Sets the background color of the caption on assessment and survey questionnaires.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: #eee</td>
</tr>
<tr>
<td>com.snc.assessment.decision_matrix_filter_max_entries</td>
<td>Maximum number of items to show for a decision matrix field filter</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 1000</td>
</tr>
<tr>
<td>css.assessment.caption.font.color</td>
<td>Assessment caption font color</td>
<td>Sets the font color of the caption text on assessment</td>
</tr>
</tbody>
</table>
Assessment and survey properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>and survey questionnaires.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: #ffffff</td>
</tr>
</tbody>
</table>

Survey definitions

A survey definition is the root record upon which a survey is built.

The survey designer generates a survey definition automatically when you save or publish the survey. Survey administrators may want to modify the survey definition to configure additional options for the survey, or to publish the survey when it is ready for distribution.

Survey administrators and survey readers can also send survey invitations directly to users from the survey definition.

Related information

Send survey invitations to users

Modify a survey definition

You can configure additional options for a survey definition.

Before you begin

Role required: admin, survey_creator, or survey_admin

Procedure

1. Navigate to Survey > View Surveys.
   Each survey definition is stored as a record on the Assessment Metric Type [asmt_metric_type] table with a modified view for survey use.

2. Open a survey definition.
   The Response Trend chart with the weekly trend of the survey instance count, and the Survey Summary chart with the overall summary response based on instance states are displayed.

3. Modify the fields on the Survey Definition form.

   Note: You can only edit a survey that has the same application scope as that of your current session.
# Survey Definition Form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the survey which appears on the questionnaire.</td>
</tr>
<tr>
<td>Description</td>
<td>Helpful information about the survey.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the survey definition. When the <strong>Active</strong> check box is cleared, new survey instances cannot be generated and users cannot complete existing survey instances. Use the <strong>Active</strong> check box to deactivate or activate a published survey.</td>
</tr>
<tr>
<td>Owners</td>
<td>Owners of the survey. You can add a user with the survey_creator, survey_admin, or assessment_admin role.</td>
</tr>
<tr>
<td>Anonymize responses</td>
<td>Check box to ensure that all responses for this survey are stored without the submitting user names. When a user submits a survey, the system clears the Assigned to field for the associated survey instance. Also, survey responses for anonymous surveys do not contain Assigned to values. Note: The Assigned to field is cleared. However, each response record includes the Created By and Updated By fields that are accessible to users with the survey_admin role.</td>
</tr>
<tr>
<td>Send notifications</td>
<td>Check box to send a notification that the survey has been taken.</td>
</tr>
<tr>
<td>State</td>
<td>Status of the survey: <strong>Draft</strong> or <strong>Published</strong>.</td>
</tr>
<tr>
<td>Allow retake</td>
<td>Check box that allows users to modify their answers to a completed survey. Users can resubmit a survey as many times as they want until the due date. After that date, the system removes the survey from the user's My Assessments &amp; Surveys page.</td>
</tr>
</tbody>
</table>
| Scheduled job         | Scheduled job that the system creates for this survey definition when the schedule period is a repeating interval. The system sets the scheduled job to run according to the selected schedule period. If you change the schedule period and save the survey definition:  
  - The system deletes the old scheduled job.  
  If you selected a recurring schedule period: |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• A new scheduled job is created.</td>
</tr>
<tr>
<td></td>
<td>For example, if you change the schedule period from <strong>Daily</strong> to <strong>Weekly</strong> and save the record:</td>
</tr>
<tr>
<td></td>
<td>• The system deletes the daily scheduled job.</td>
</tr>
<tr>
<td></td>
<td>• Creates a weekly one set to run a week from the current date.</td>
</tr>
<tr>
<td></td>
<td>This field is visible to administrators only if the schedule period is <strong>Daily</strong>, <strong>Weekly</strong>, <strong>Monthly</strong>, or <strong>Yearly</strong>.</td>
</tr>
<tr>
<td>Assessment duration</td>
<td>The length of time to complete assigned survey instances, starting from the time the survey instance is generated. The</td>
</tr>
<tr>
<td></td>
<td>assessment duration sets the Due date for each survey instance. The default duration is 14 days. Configure the form to view this field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> By default, the system runs the <strong>Cancel Expired Assessments</strong> script every 30 days to cancel expired survey, assessment, and quiz</td>
</tr>
<tr>
<td></td>
<td>instances that are in the Work in progress or Ready to take states.</td>
</tr>
<tr>
<td>Send notifications</td>
<td>Send notifications for the survey when it is published.</td>
</tr>
<tr>
<td></td>
<td>Configure the form to see the field.</td>
</tr>
<tr>
<td>Other Options</td>
<td></td>
</tr>
<tr>
<td>Sample Metric</td>
<td>A metric of the current survey that you can include as an image in the email or invitation sent to a survey user. When the survey user</td>
</tr>
<tr>
<td></td>
<td>clicks the image in the email or while previewing the HTML body, the entire survey is available to be taken.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot edit or delete a metric that is selected in this field.</td>
</tr>
<tr>
<td>Signature</td>
<td>Acknowledgement by a survey recipient of requirements, admonitions, or policies related to the survey. The signature may require the</td>
</tr>
<tr>
<td></td>
<td>recipient to select a check box or to type in a full signature to verify having read these assertions. You can display assertions without</td>
</tr>
<tr>
<td></td>
<td>requiring a signature. Select an existing signature from the list or click <strong>New</strong> to create a new one. The signature form contains these fields:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Name</td>
<td>Descriptive name for this signature.</td>
</tr>
<tr>
<td>Signature type</td>
<td>Type of signature required. The selections are Check box, Full name, or Assertion only. If Assertion only is selected, no signature is required to submit the survey.</td>
</tr>
<tr>
<td>Assertion</td>
<td>Text you want to display to recipients.</td>
</tr>
<tr>
<td>Schedule period</td>
<td>Option that determines how often a user can take the same survey and whether the system generates survey instances on a schedule.</td>
</tr>
<tr>
<td>Do not show survey introduction notes</td>
<td>Check box to skip the introduction notes when a survey is launched. This functionality is applicable in both the Now Platform and Service Portal product versions.</td>
</tr>
<tr>
<td>Pagination setting for Service Portal view</td>
<td>The setting on which the pagination is based for desktop or tablet view in Service Portal.</td>
</tr>
<tr>
<td></td>
<td>• Category: default</td>
</tr>
<tr>
<td></td>
<td>• Question: 1 question per page (automatic for mobile)</td>
</tr>
<tr>
<td></td>
<td>• None: no pagination</td>
</tr>
<tr>
<td></td>
<td>✉️ Note: This field is displayed only when Service Portal is installed.</td>
</tr>
<tr>
<td>One Click Survey</td>
<td>Enables a One Click survey in Service Portal.</td>
</tr>
<tr>
<td></td>
<td>✉️ Note: This option can be selected if the Pagination setting for Service Portal view is set to None.</td>
</tr>
<tr>
<td>Source Table</td>
<td>Table whose field is used as a dynamic value for a question in a triggered survey.</td>
</tr>
</tbody>
</table>

By default, a property called **Require authentication for user signature** (com.snc.assessment.signature_authentication) requires users to authenticate when providing a full name signature.

Note: If you use a trigger condition for a survey, ensure the schedule period is set to **No Limit**. Trigger conditions use a different method to regulate how often users can receive survey instances.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chat Survey</strong></td>
<td>Option to validate if survey questions are supported in a chat survey. Enables conversational questionnaires (pre-chat and post-chat surveys) in the chat client. Also enables you to map chat context variables to survey questions. For information on a chat survey in ITSM Virtual Agent, see <em>Surveys in ITSM Virtual Agent</em>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available only when the Glide Conversation Server plugin (com.glide.cs) is activated.</td>
</tr>
<tr>
<td><strong>Outlook Actionable Message</strong></td>
<td>Includes an embedded survey in the survey email notification. After you select this check box and save the survey, a validation is run to ensure all survey questions are supported.</td>
</tr>
<tr>
<td><strong>Allow Sentiment Analysis</strong></td>
<td>Enables sentiment analysis for this survey.</td>
</tr>
<tr>
<td><strong>Introduction &amp; End Notes</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Introduction</strong></td>
<td>Introductory content to display on survey questionnaires. Consider adding a company logo, a welcome message, background information about the survey, or instructions.</td>
</tr>
<tr>
<td><strong>End note</strong></td>
<td>End note that appears when someone submits a survey questionnaire. Consider adding a thank you message, follow-up instructions, or other applicable information.</td>
</tr>
<tr>
<td><strong>Related Links</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Enable Public Access</strong></td>
<td>Link that enables/disables the survey as a public survey. No login is required to take a public survey (including a survey with a trigger condition) and users or non-users can respond anonymously. For completed public surveys, the Assigned to field value is Guest.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can use the View Survey URL related link to share the URL with users.</td>
</tr>
<tr>
<td><strong>Remove Public Access</strong></td>
<td></td>
</tr>
<tr>
<td><strong>View Responses</strong></td>
<td>Link that opens the list of responses for this survey. This related link is available only if there are results for the survey.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>View Scorecard</td>
<td>Link that opens the scorecard for this survey. This related link is available only if there are results for the survey.</td>
</tr>
<tr>
<td>View Survey URL</td>
<td>Link that opens a dialog box that displays a URL for this survey. The URL is useful for sharing a public survey. This related link is available only if the Active check box is selected. The URL does not work until the survey definition is published.</td>
</tr>
<tr>
<td>Show Benchmarks</td>
<td>Opens the Benchmarks Dashboard that provides visibility into your key performance indicators (KPIs) and trends.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• This related link is available only for survey_admin, assessment_admin and survey_reader with bm_viewer role.</td>
</tr>
<tr>
<td></td>
<td>• You must opt in to Benchmarks to view the dashboard. See Enable Benchmarks</td>
</tr>
<tr>
<td></td>
<td>• This is applicable only for a published survey.</td>
</tr>
<tr>
<td>Create Improvement Initiative</td>
<td>Opens the Improvement Initiative window to create an improvement initiative record that helps in improving the performance of the survey.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• This related link is available only for the survey_admin and assessment_admin role. A survey_reader can only view the created improvement initiative records.</td>
</tr>
<tr>
<td></td>
<td>• You should activate the Continual Improvement Management plugin (com.sn_cim).</td>
</tr>
<tr>
<td>Retry Sentiment Analysis</td>
<td>Checks all survey instances of this survey that do not have sentiment analysis data and sends them for analysis.</td>
</tr>
<tr>
<td>Related Lists</td>
<td></td>
</tr>
<tr>
<td>Trigger Condition</td>
<td>Displays all the trigger conditions associated with the survey.</td>
</tr>
<tr>
<td>Survey Responses</td>
<td>Displays all the responses associated with the survey.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Metric Categories</td>
<td>All survey categories for this survey.</td>
</tr>
<tr>
<td>Survey Users</td>
<td>All survey users who are authorized to take this survey. If no users are listed, any user can take this survey.</td>
</tr>
<tr>
<td>Assessment Instances</td>
<td>All survey instances for this survey. Configure the form to add this related list to see it.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you add a related list to the form, use list control to omit the New button. The system generates survey instances to produce functional surveys.</td>
</tr>
<tr>
<td>Improvement Initiatives</td>
<td>Displays improvement initiatives associated with the survey.</td>
</tr>
<tr>
<td>Note:</td>
<td>This related list is available only when there is at least one improvement initiative record.</td>
</tr>
<tr>
<td>Survey Recipients Lists</td>
<td>Recipients lists that are added to the survey.</td>
</tr>
</tbody>
</table>

4. Save the record.

**Related information**

- Survey trigger conditions
- Publish a survey

**Schedule periods**

The available schedule periods are **Only Once**, **No Limit**, **Daily**, **Weekly**, **Monthly**, and **Yearly**.

The default schedule period is **No Limit**. When you set the schedule period to anything except **Only Once** or **No Limit**, the system creates a corresponding scheduled job. The scheduled job performs the following actions.

- Ensures that a user can take one survey instance of the same survey per schedule period.
- Generates a new survey instance for each survey user at the beginning of the new schedule period, as long as the survey user does not have an incomplete instance of that survey. A survey instance is incomplete if the state is not **Complete**.
For example, if you set the schedule period to **Monthly** and someone attempts to send survey invitations twice in the same day, the system generates survey instances for the survey users the first time only. At the beginning of the next schedule period, the system generates another survey instance for each survey user who completed the previous one.

Schedule periods are enforced by the **Expiration date** field on the survey instance. As long as the survey instance expiration date has not passed, the assigned user cannot receive a new survey instance. When the system generates a survey instance and the schedule period is anything except **No Limit**, the **Expiration date** field is automatically set to the appropriate date. For example, if the schedule period is **Weekly**, the expiration date is a week after the survey instance is generated.

If you change the schedule period, the scheduled job updates automatically to the correct schedule. However, users who have survey instances for the survey cannot receive new survey instances until their existing survey instances expire, regardless of the new schedule period.

Consider the following example: Sal Pindell receives a survey instance when the schedule period is **Weekly**. The next day, a survey administrator changes the schedule period to **No Limit**. Sal cannot receive another survey instance until one of the following actions occurs.

- Seven days pass from the time Sal’s survey instance was generated.
- A survey administrator deletes Sal’s survey instance.

After one of these actions occurs, Sal can receive a new survey instance anytime, as long as he has no incomplete instances of the survey.

⚠️ **Note:** If you use a trigger condition for a survey, ensure the schedule period is set to **No Limit**. Trigger conditions use a different method to regulate how often users can receive survey instances.

**Related information**
- Publish a survey
- Survey trigger conditions

**Create a survey designer template question**

You can create a question that uses choice lists from a template.

**Before you begin**
- Role required: admin or survey_admin
Procedure

1. Navigate to **Survey > Survey Designer** and load a survey or create a new survey.
2. Drag the **Template** data type icon into a category container.
3. Click the gear icon in the question title bar to open the template properties dialog box.
4. Select a predefined scale from the list.

![Image of Survey Designer interface]

Question entry fields appear for that template.

5. Enter one or more questions that are appropriate for the template.
6. Click the arrow to the right of a question to configure its properties. You must provide a name for each question.

7. Click the back arrow to return to the template properties dialog box.
8. Configure the properties for the remaining questions.

9. Click the X icon to close the template properties dialog box and save your settings.

Related information
- Survey designer elements
- Survey designer
- Edit a survey in the survey designer

Survey questions
Survey questions appear on survey questionnaires for the associated survey definition.

The survey creator generates questions and answer options automatically. However, it provides only the basic configuration options for questions, such as the question text and the data type. You may want to create additional questions or set advanced configuration options for the questions, including making a question appear conditionally or making a question mandatory. You can also use question templates to define reusable sets of answer options.

Survey questions are available from Survey > Questions. The list displays information about each question, including the associated survey definition listed in the Type column, and the data type. Survey administrators can modify these questions.

Create or modify survey questions
You can create and administer survey questions.

Before you begin
Role required: admin or survey_admin

About this task
Changes to a survey, such as the addition of questions or the modification of question templates, do not apply immediately to the existing survey instances. However, the changes apply immediately to any new survey instances that are created after the changes are saved.

Procedure
1. Navigate to Survey > View Surveys.
2. Open a survey definition.
3. In the **Metric Categories** related list, open a category.

4. In the **Assessment Metrics** related list, open an existing question or click **New**. Each survey question is stored as a record on the Assessment Metric [asmt_metric] table with a modified view for survey use.

5. Complete the Survey Question form. The fields that appear depend on the selected **Data type**.

### Survey Question form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the question. When you create a survey, the question name is the same as the text in the Question field.</td>
</tr>
<tr>
<td>Question</td>
<td>Text to use for the question, which appears on survey questionnaires.</td>
</tr>
<tr>
<td>Data type</td>
<td>Data type of the question. The fields for the response depend on the data type.</td>
</tr>
<tr>
<td></td>
<td>Note: If another question depends on this question, you cannot change the data type.</td>
</tr>
<tr>
<td>Template</td>
<td>Question template to use for the answer options. This field is visible and required only if the data type is Template.</td>
</tr>
<tr>
<td></td>
<td>Note: If another question depends on this question, you cannot change the template.</td>
</tr>
<tr>
<td>Scale definition</td>
<td>Setting that determines whether smaller or larger numerical values equate to a good score in result calculations. Select Low if smaller numerical values are better, such as for a question that measures the number of incidents for a vendor. Select High if larger numerical values are better, such as for a question that measures user satisfaction on a scale of one to five. This field is visible and required only when certain data types are selected.</td>
</tr>
<tr>
<td>Randomize answers</td>
<td>Check box that determines whether to present the answer options for this question in a random order each time a user opens the survey. Answer preference is sometimes influenced by the order in which answer options appear, which can result in biased results. Randomize answer options to help prevent this bias. This field is visible only if the data type is Choice or Likert Scale.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Note: <strong>Randomizing answer options may make a question confusing. In general, only randomize answer options that do not follow a logical order.</strong></td>
<td></td>
</tr>
<tr>
<td>Mandatory</td>
<td>Check box that makes the question mandatory (selected) or optional (cleared) on survey questionnaires. Users cannot submit questionnaires until they provide valid responses to all mandatory questions, which are denoted by a red field status indicator. This field is visible only when the <strong>Depends on</strong> field is empty and the data type is not <strong>Checkbox</strong>. Questions that depend on other questions and check box questions cannot be mandatory.</td>
</tr>
<tr>
<td>Allow not applicable</td>
<td>Check box that determines whether to include a <strong>Not Applicable</strong> answer option for this question on survey questionnaires. User responses of <strong>Not Applicable</strong> are excluded from results calculations. This field is visible only if the data type is <strong>Choice</strong>, <strong>Likert Scale</strong>, <strong>Template</strong>, or <strong>Yes/No</strong>.</td>
</tr>
<tr>
<td>Allow Additional Information</td>
<td>If selected, the <strong>Additional Information Label</strong> field is enabled. The <strong>Additional Information Label</strong> field value is displayed as a field on the survey response page to provide additional information for a question. <strong>Note:</strong> This is not applicable for the String and Template data types.</td>
</tr>
<tr>
<td>Depends on</td>
<td>Setting used to make this a conditional question, meaning that it only appears when users answer another question a certain way. To make a question depend on another question, select an existing question from the list, which displays <strong>Checkbox</strong>, <strong>Choice</strong>, <strong>Template</strong>, and <strong>Yes/No</strong> questions of the same category as this question. Then, use the <strong>Displayed when</strong> field to set the conditions that cause this question to appear on surveys. The system prevents the creation of recursive dependencies between questions. For example, if Question A depends on Question B, Question B cannot depend on Question A.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Displayed when</td>
<td>Answer options for the selected <strong>Depends on</strong> question which, when chosen on surveys, display this question. This field is visible and required only when the <strong>Depends on</strong> field is set.</td>
</tr>
<tr>
<td>Min</td>
<td>Smallest numerical value to be used as an answer option for this question. This field is visible and required only if the data type is <strong>Choice</strong>, <strong>Likert Scale</strong>, <strong>Number</strong>, or <strong>Percentage</strong>.</td>
</tr>
<tr>
<td>Max</td>
<td>Largest numerical value to be used as an answer option for this question. This field is visible and required only if the data type is <strong>Choice</strong>, <strong>Likert Scale</strong>, <strong>Number</strong>, or <strong>Percentage</strong>.</td>
</tr>
<tr>
<td>String option</td>
<td>Selection that determines what kind of response text box appears for this question on survey questionnaires. This field is visible and required only if the data type is <strong>String</strong>.</td>
</tr>
<tr>
<td>Source Field</td>
<td>Source table field that appears as a dynamic value for the question in a triggered survey. When this field value is selected, a <code>{param}</code> placeholder is added at the end of the question label.</td>
</tr>
</tbody>
</table>

  ❗️ **Note:** You can move this placeholder anywhere in the question label.

  When a user takes the survey, the question with dynamic value is included in the survey instance and `{param}` placeholder is replaced with the source field value.

  If the record table specified in the trigger condition does not match the source table specified for the survey, or if the system fails to get the dynamic value from the source record, the `{param}` placeholder is not replaced by any value and is displayed as is in the question.

  For example, if the survey is triggered from a **PRB** record and the survey question is configured with a dynamic value from **Incident**, the `{param}` placeholder in the survey question label is not replaced by any dynamic value and is displayed as is.

  ❗️ **Note:** When survey questions are translated to other languages by a survey admin, the `{param}` placeholder should not be translated.

<table>
<thead>
<tr>
<th>Allow Sentiment Analysis</th>
<th>Includes this question for the sentiment analysis of a survey.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>❗️ <strong>Note:</strong> This field is available only for String type questions.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition to filter the reference records from the table specified in the Reference field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field appears only for the Reference metric type.</td>
</tr>
<tr>
<td>Field validation</td>
<td>Validate the value entered for a String type metric of a survey. Possible validations are:</td>
</tr>
<tr>
<td></td>
<td>• Email</td>
</tr>
<tr>
<td></td>
<td>• IP Address(IPV4,IPV6)</td>
</tr>
<tr>
<td></td>
<td>• Phone Number (E.164)</td>
</tr>
<tr>
<td></td>
<td>• URL</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field appears only for the String metric type.</td>
</tr>
</tbody>
</table>

**Related Lists**

| Assessment Metric Definitions | Answer options for this question. This related list is available only if the Data type is Choice or Likert Scale. |

6. Save the record.

**Note:**

- Be sure to create answer options if you select the Choice or Likert Scale data type.
- You cannot delete a survey question (metric) with user responses. To delete a survey question with user responses, you should delete the responses, and then delete the survey question.

**Related reference**

Trigger condition example

**Related information**

Survey question template

Survey trigger conditions
Survey question data types

You must choose a data type for each survey question. The data type determines the format of the question and the kind of data that is collected on survey questionnaires.

The following data types are available for surveys:

Attachment data type

On questionnaires, users can attach one or more files to a question. Users click the Manage Attachments icon and select one or more files in the Attachments pop-up window to attach to the question. From this window, users can:

- View a list of the attached files.
- View an attached file in a separate window.
- Rename an attached file.
- Add or delete files

Once a survey has been submitted, attachments cannot be updated or deleted.

Any type of file supported by the platform can be attached to a question. One or more files can be attached a question while taking a survey or completing an assessment.

The assessment administrator can see the attachments associated with an individual question as well as those associated with the survey.

See Administering Attachments for more information.

Boolean data type

On questionnaires, users select a check box beside a statement or leave it cleared.

If you select Boolean, you must fill in the Scale definition field. Select High if it is best when users select the check box.

Choice data type

On questionnaires, users select a value from a list of choices.
If you select **Choice**, you must fill in the **Scale definition** field and create answer options. Select **High** for the scale definition if the answer option with the largest metric definition **Value** is best.

ⓘ **Note:** The system sets the **Min** and **Max** fields automatically based on the **Value** settings for the associated metric definitions.

**Date and Date/Time data types**

The **Date** and **Date/Time** data types are similar.

- **Date:** On questionnaires, users select a date.
• **Date/Time:** On questionnaires, users select a date and time.

![Date/Time Image]

**Likert Scale data type**

On questionnaires, users select a multiple choice value from a custom Likert scale. Each answer option is represented by a radio button on the scale. A Likert scale question that evaluates an application’s ease of use might have the answer options **Easy, Average, and Difficult.**

![Likert Scale Image]

If you select **Likert Scale**, you must fill in the **Scale definition** field and create answer options. Select **High** for the scale definition if the answer option with the largest metric definition **Value** is best.

ℹ️ **Note:** The system sets the **Min** and **Max** fields automatically based on the **Value** settings for the associated metric definitions.

**Number data type**

On questionnaires, users enter a number.

![Number Image]

If you select **Number**, you must fill in these additional fields:
• **Scale definition**: Select **High** if a larger number is better, such as for a question that measures the number of sales made in a quarter.

• **Min** and **Max**: Enter the smallest and largest numbers users can enter. State the range of acceptable answers in the question text.

**Percentage data type**

On questionnaires, users enter a number.

![Approximately what percent of the time are your incidents resolved in a week or less?](image)

If you select **Percentage**, you must fill in these additional fields:

• **Scale definition**: Select **High** if a larger percentage is better, such as for a question that measures the percentage of work an agent has completed.

• **Min** and **Max**: Enter the smallest and largest numbers users can enter. Generally 0 and 100 are appropriate minimum and maximum values. If you choose values other than 0 and 100, it is usually best to state the range of acceptable answers in the question text.

**Reference data type**

On questionnaires, users select a value from a list that is generated from a specified reference table. The response field supports auto-completion.

⚠️ **Note**: Reference qualifiers are not supported.

For example, a user could select a user name in response to a question if you specify User [sys_user] as the reference table.
String data type
On questionnaires, users enter text. When you select String, the String option field appears. Select one of the following options to determine how the string field appears on questionnaires:

- **Single line**

![Single line](image)

- **Single line wide**

![Single line wide](image)

- **Multiline**

![Multiline](image)

Template data type
On questionnaires, users select a value from a predefined series of answer options. To use this data type, a question template must be defined.

If you select Template, you must fill in these additional fields:

- **Template**: Select a template.
- **Scale definition**: Select High if the answer option with the largest template definition Value is best.

Yes/No data type
On questionnaires, users select Yes or No from a list.
If you select Yes/No, you must fill in the **Scale definition** field. Select **High** if Yes is the best answer.

### Image Scale data type

On questionnaires, users select an image from a predefined set of images as their response. Image scale questions can also be used in a template for better performance with surveys that have the same type of answer options.

Five emojis, similar to the Likert scale (very dissatisfied to very satisfied) are provided. However, you can upload additional images in JPG, PNG, or GIF format. Two images can be uploaded, one for selected case and another for unselected case. Larger size images are reduced to 64 x 64 pixels.

The result behavior depends on the presence of uploaded images. If no selected image is uploaded, then the question shows up blank.

<table>
<thead>
<tr>
<th>Selected Image</th>
<th>Unselected Image</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Unselected image loads. Clicking on the image changes it to the selected image.</td>
</tr>
<tr>
<td>Yes</td>
<td>No</td>
<td>Selected image loads with 50% opacity. Clicking on the image changes the opacity to 100%.</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>A blank placeholder box is displayed.</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>A blank placeholder box is displayed.</td>
</tr>
</tbody>
</table>

⚠️ **Note:** N/A option is not supported for image scale type question.
**Multiple selection data type**

On questionnaires, users can select multiple check boxes indicating all answers that apply. For instance, a user can be instructed to “Select all that apply” in a multiple selection question.

![Multiple Selection Example](image)

**Ranking data type**

On questionnaires, users can select a different order number for each option to rank them. Drag-and-drop functionality is also supported, which allows a user to either fill in the number, or simply drag an option.

![Ranking Example](image)

One order number cannot be selected twice. This question can be mandatory and it can also be dependent on a parent question, but not vice versa.

**Related information**

Survey question template

**Survey question template**

Question templates define reusable sets of answer options for survey questions.

Question templates define reusable rating scales for answering questions, where each answer option on the scale is a template definition. For example, the template named **Satisfaction** represents a satisfaction scale and contains the
following template definitions: **Very Satisfied**, **Satisfied**, **Neutral**, **Dissatisfied**, and **Very Dissatisfied**.

**Template definition**

Templates are available for survey questions that have **Data type** set to **Template**. The following question templates are available in the base system. You can create or update a template as described in [Create a survey question template](#).

**Default question templates**

<table>
<thead>
<tr>
<th>Name</th>
<th>Template definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>None, Few or little, Average amount, Many, Quite a lot</td>
</tr>
<tr>
<td>Complexity</td>
<td>Very Complex, Complex, Moderate, Simple, Very Simple</td>
</tr>
<tr>
<td>Frequency</td>
<td>Never, Seldom, Sometimes, Most of the time, All of the time</td>
</tr>
<tr>
<td>Likert 5</td>
<td>Strongly Disagree, Disagree, Neutral, Agree, Strongly Agree</td>
</tr>
<tr>
<td>Quality</td>
<td>Very Poor, Poor, Average, Good, Very Good</td>
</tr>
<tr>
<td>Satisfaction</td>
<td>Very Dissatisfied, Dissatisfied, Neutral, Satisfied, Very Satisfied</td>
</tr>
<tr>
<td>Size</td>
<td>Very Small, Small, Average, Large, Very Large</td>
</tr>
</tbody>
</table>

**Create a survey question template**

You can create and administer question templates.

**Before you begin**

Role required: admin or survey_admin

**About this task**

Changes to a survey, such as the modification of question templates, apply to existing survey instances immediately. Templates that you create are available for use with both surveys and assessments.
Procedure

1. Navigate to Survey > Templates.
   Each template is stored as a record on the Assessment Metric Template [asmt_template] table.

2. Click **New**.

3. Enter a **Name**.

4. Right-click the form header and click **Save**.

5. In the **Assessment Template Definitions** related list, click **New**.
   Create a template definition for each answer option you want to appear on a question.

6. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Enter the text to appear as the answer option.</td>
</tr>
<tr>
<td>Value</td>
<td>Enter a numeric value, greater than or equal to zero, to which the answer option equates. Values are used in results calculations. When you view questions that use templates, answer options appear in order from smallest to largest <strong>Value</strong>. Each template definition for a given template must have a unique <strong>Value</strong>.</td>
</tr>
</tbody>
</table>

7. Click **Update**.

**Update min and max values to match templates**

If you use survey result calculation data, ensure that the **Min** and **Max** values for a question that uses a template are equal to the smallest and largest template definition **Value**.

**Before you begin**
Role required: admin or survey_admin

**About this task**
When you create a question of the **Template** data type, the system sets the **Min** and **Max** fields based on the template definition values. The fields for existing questions are not updated if you add a new template definition to a template or if you update the **Value** of an existing template. If the new **Value** is less than the minimum value or greater than the maximum value of any questions that use the template, update the questions accordingly.
Procedure

1. Navigate to Survey > Questions.
2. Configure the list to show the Min and Max columns.
3. Add the following list filter condition: [Template] [is] [<select the template you updated>].
4. Ensure the Min and Max values match the smallest and largest template definition Value for the selected template.
   If the values do not match, edit the Min and Max values directly from the list.

Note: When the data type is Template, a UI policy prevents the editing of Min and Max from the form.

Add a metric category and metric in the question bank for surveys

Reuse the question categories (metric categories) and questions (metrics) added in the question bank for surveys. You can add metric categories or metrics from the question bank to a survey, or from the survey to a question bank.

Before you begin
Role required: admin or survey_admin
Activate the Survey Question Bank Sample Data plugin (com.snc.question_bank_data) to access the demo data for the question bank.

Procedure

1. Navigate to Survey > Question Bank.
2. Click New.
3. In the Metric Category form, fill the fields.

Metric Category fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the metric category.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the metric category.</td>
</tr>
<tr>
<td>Total metrics</td>
<td>Total number of metrics in the metric category. This number is automatically updated when you add or delete metrics from the category.</td>
</tr>
</tbody>
</table>

4. Right-click on the title bar and click Save.
5. In the Assessment Metrics related list, click New.
6. In the Survey Question form, fill the fields. For information on these fields, see Create or modify survey questions.

7. Click Submit.

Configure metric categories or metrics for a survey using the question bank

Reuse question categories (metric categories) and questions (metrics) from the Question Bank module while creating or updating a survey.

Before you begin
Role required: admin or survey_admin
Activate the Survey Question Bank Sample Data plugin (com.snc.question_bank_data) to access the demo data for the question bank.

Procedure
1. Navigate to Survey > View Surveys.
2. Open a survey definition.
3. Optional: To add metric categories to a survey from the question bank in Platform, perform the following steps.
   a. In the Metric Categories related list, click New Category from Bank. The New Category from Bank dialog box is displayed with a list of all metric categories added in the question bank.
   b. Select the required categories and click Add Selected. A copy of the metric category and the corresponding metric definitions is created in the Metric Categories related list.

4. Optional: To add metrics to a survey from the question bank in Platform, perform the following steps.
   a. In the Metric Categories related list, open a metric category definition.
   b. In the Assessment Metrics related list, click New Metric from Bank. The New Metric from Bank dialog box is displayed with a list of questions available in the question bank.
   c. Select the required metrics and click Add Selected. A copy of the metric and the corresponding metric definitions is created in the Assessment Metrics related list of the category.

5. Optional: To add a metric category to the question bank from a survey in Platform, perform the following steps.
a. In the Metric Categories related list, open a metric category definition.

b. Click Add to question Bank.
   A copy of the category is created along with its metrics and metric definitions in the question bank.

6. Optional: To add a metric to the question bank from a survey in Platform, perform the following steps.

   a. In the Metric Categories related list, open a metric category definition.
   b. In the Assessment Metrics related list, open the required metric definition.
   c. Click Add to Question Bank.
      The Add to Question Bank dialog box is displayed.
   d. In the Choose a question bank to add this question/metric field, select a metric category that you want to add this metric to, and click OK.
      A copy of the metric and the corresponding metric definitions is created for the selected category in the question bank.

7. Optional: To add a metric category or metric to a survey from the question bank in Survey designer, perform the following steps.

   a. Open the survey in Survey Designer.
   b. Optional: To add a metric category from the question bank, from the Categories tab in the left panel, drag the required category banner and drop in the Design tab.
   c. Optional: To add a metric from the question bank, drag and drop the required metric from the Questions tab or the Categories tab.

Note:
- When you drag and drop a metric category, all dependencies within the category are also added to the survey.
- From the Categories tab, you can drag and drop an individual metric within a metric category.
- When you drag and drop a parent metric, all dependent questions are also added to the metric category.
- When you drag and drop a child metric, only the child question is added to the metric category.
Create or modify answer options

You must create answer options, called metric definitions, for survey questions that have **Data type** set to **Choice** or **Likert Scale**.

**Before you begin**
Role required: admin or survey_admin

**About this task**
Changes to a survey, such as the addition or modification of answer options, apply to existing survey instances immediately.

**Procedure**

1. Navigate to **Survey > Questions**.
2. Open a choice or Likert scale survey question.
3. In the **Assessment Metric Definitions** related list, open a metric definition or click **New**.
   Each answer option is stored as a record on the Assessment Metric Definition [asmt_metric_definition] table.
4. Complete the Assessment Metric Definition form.

**Assessment Metric Definition fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Text to appear as the answer option.</td>
</tr>
<tr>
<td>Value</td>
<td>Numeric value, greater than or equal to zero, to which the answer option equates. Values determine the order in which answer options appear. See the example below. Values are also used to calculate survey results. Each metric definition for a given question must have a different <strong>Value</strong>.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Example:**
On survey questionnaires, the answer options for a question appear in order from smallest to largest **Value**. For example, consider the survey question **How do you feel?** with the answer options **Good**, **Neutral**, and **Bad**. The following table shows the answer option order based on the **Value**.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Answer option order based on value

<table>
<thead>
<tr>
<th>Answer option</th>
<th>Value</th>
<th>Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good</td>
<td>1</td>
<td>First</td>
</tr>
<tr>
<td>Neutral</td>
<td>3</td>
<td>Second</td>
</tr>
<tr>
<td>Bad</td>
<td>5</td>
<td>Third</td>
</tr>
</tbody>
</table>

If you use survey result calculations, ensure the question Scale definition is set appropriately based on the answer options. In the previous example, if you want the answer option Good to earn the highest score, the scale definition should be Low because Good has the smallest value.

### Change the order of survey questions

You can easily reorder survey questions at the category level or the question level.

**Before you begin**

Role required: admin or survey_admin

**About this task**

You can change the order in which the questions in one category appear relative to those in other categories for the same survey definition. If you add a new question manually after you create other questions, you may want to change the order of questions.

When you create questions using the survey creator, the system sets the Order field for the first question to 101, the second to 102, and so on. After you create a new question outside of the survey creator, the Order is set to 100 by default, which means it appears before all questions generated by the survey creator.

**Procedure**

1. Navigate to Survey > View Surveys and open the appropriate survey definition.

2. In the Metric Categories related list, edit the values in the Order column.

3. To change the order of questions within a category, complete the following steps.
   a. Open the Assessment Metrics related list.
   b. Edit the values in the Order column.

4. Click Update.
Survey trigger conditions

Trigger conditions specify when to send a particular survey and the persons to send it to.

Survey administrators can use trigger conditions to configure the system to generate a survey instance each time a specified action occurs on a specified table, for example, when an incident or change request closes. The system sends the survey to users that are related to the triggering record, for example, incident callers or change request assignees. You can choose to send a survey every time the condition is met, or you can set a probability for the system to send a survey at random when the condition is met.

Trigger conditions are ideal for sending transactional surveys. Transactional surveys generally measure satisfaction with a recent experience, such as closing an incident or purchasing an item.

⚠️ Note: Trigger conditions are comparable to survey conditions in legacy surveys. If you migrate a legacy survey that has survey conditions, ensure that the survey conditions are deactivated before you recreate them as trigger conditions.

Configure a trigger condition for a survey

Configure trigger conditions to specify when to send a particular survey and the persons to send it to.

Before you begin
Role required: admin or survey_admin

Procedure

1. Navigate to Survey > Trigger Conditions.
2. Click New.

⚠️ Note: Do not specify particular users for a triggered survey because only the specified users are allowed to take the survey.

3. Complete the form.

<table>
<thead>
<tr>
<th>Trigger condition fields</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Assessment</td>
</tr>
<tr>
<td>Table</td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>--------------------------</td>
</tr>
<tr>
<td>whenever an incident closes, select the Incident [incident] table.</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Repeat interval</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Application</td>
</tr>
<tr>
<td>Active</td>
</tr>
<tr>
<td>Business rule</td>
</tr>
<tr>
<td>Trigger randomly</td>
</tr>
<tr>
<td>Probability (%)</td>
</tr>
<tr>
<td>Related Field 1- 4</td>
</tr>
</tbody>
</table>

Note: To avoid requiring users to log in to take a survey with a trigger condition, set the survey to Public.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field specification</td>
<td>the system stores the value from the triggering record. Specify up to four fields. For example, select the Incident table, <strong>Assigned to</strong> and <strong>Problem</strong> as related fields. The system stores the assigned user and problem associated with the incident as Related record 1 and Related record 2 in the survey instance record. To view the fields, configure the form for any survey instance.</td>
</tr>
</tbody>
</table>

**Note:** You cannot use a related field for the ticket number because you cannot select the Number column. You can, however, use the `trigger_id` column of the table.

<table>
<thead>
<tr>
<th>Description</th>
<th>Summary information to identify the trigger condition.</th>
</tr>
</thead>
</table>

**Note:** For a triggered record, the table title is used for the survey description.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Condition builder that defines the criteria that must be true to send the survey. For example, to send a survey whenever an incident closes, create the condition <code>[State] [is] [Closed]</code>.</th>
</tr>
</thead>
</table>

**Note:** When defining conditions like case sensitivity or null values, see API `GlideFilter - Scoped, Global`.

You can also create a trigger condition directly from the survey creator. If you select **Certain users can take this survey, based on conditions** in the Survey User Access section, the Trigger Condition form opens automatically when you click **Save as Draft** or **Publish**.
Example:

You can send out auto-triggered surveys when an incident is closed or resolved.

A trigger condition is configured as follows:

- **Assessment**: Service Desk Satisfaction Survey
- **Table**: Incident [incident]
- **User field**: Caller
- **Repeat interval**: 30 days
- **Active**: true
- **Trigger randomly**: false
- **Related Field 1**: Assigned to
- **Related Field 2**: Problem
- **Condition**: [State] [is] [Closed] [or] [State] [is] [Resolved]

Fannie Steese is the caller on incident INC00004305 that is assigned to Boris Catino, a service desk technician. Boris creates PRB010101 based on Fannie’s complaint and closes the incident. The system creates a survey instance assigned to Fannie so she can rate her satisfaction with the incident experience.
Because two related fields were selected as part of the trigger condition, the survey instance stores the following information from the incident:

- **User** (Related Field 1): Boris Catino
- **Problem** (Related Field 2): PRB010101
- **Task** (automatically created): INC00004305

Because the task field is automatically populated, UI-based filtering by dot-walking on incidents (or any task-based table) is supported when creating a report on survey results. For example, you can query all survey instances related to incidents assigned to a group (survey reports on all incidents assigned to networking group, for instance).

**Note:** Even though the trigger condition is set to be triggered each time that the conditions are met, the **Repeat interval** setting ensures that Fannie does not receive another survey for another of her incidents closes within 30 days of the first incident.

**Survey report example based on task field**

One of the most common use cases for Surveys is to send out an auto-triggered survey when an incident, request, or task is closed. Once you get the survey results back, you can filter the results by users and groups related to the ticket, such as Assignment Group, or Assignee.

Filtering the survey results provides more detail on how people and teams are performing based on ticket data. Since this information is automatically captured, you can dot-walk while filtering the data (instead of utilizing a related field on the Survey trigger condition form, as previously required).

To create a report on incident-triggered survey responses by Assignment group, set up the report on the Task Assessment Details by navigating to **ReportsView/Run** and clicking **Create a report**.
Survey distribution

There are several ways for survey administrators to distribute surveys to users. Surveys are distributed using any of the following methods.

- Send survey invitations to users
- Share a survey URL that opens the survey directly.
- Create a module that opens a survey.

Send survey invitations to users

You can send survey invitations using the Assign Survey or Send Invitations buttons on the Survey Definition form.

Before you begin
Role required: admin or survey_admin

About this task
Use the Send Invitations button to immediately assign survey instances to each survey user that is listed in the survey definition. Use the Assign Survey button to assign a survey instance to any one user at a time.

Each of the buttons generates survey instances assigned to the appropriate users. In addition, if the instance is configured to send email, the system generates survey notifications. For either button to be available, the survey definition must meet all of the following conditions.

- Active check box is selected.
- State is Published.
- Survey is associated with at least one question.
Note: You (or a trigger) can send more than one instance of a survey to a user at any time.

Procedure
1. Navigate to Survey > View Surveys.
2. Select an active, published survey.
3. Complete one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign a survey to users listed in the Survey Users related list</td>
<td>Click Send invitations.</td>
</tr>
<tr>
<td>Assign a survey to any user</td>
<td>Click Assign Survey and select one or more users, and then click OK.</td>
</tr>
</tbody>
</table>

The system creates a survey instance assigned to the user or users, assuming the user is eligible to receive a new survey instance. When you use the Assign Survey button, the selected user is not saved as a survey user.

Define a recipients list for surveys
Use a recipients list to define targeted set of users for whom the survey invite can be sent. You can use a recipients list for multiple surveys.

Before you begin
Role required: admin or survey_admin

Procedure
1. Navigate to Survey > Administration > Recipients Lists.
2. Click New.
3. In the Recipients List form, add the field information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the recipients list.</td>
</tr>
</tbody>
</table>
| Type      | Type of users to include in the list. Possible values are:  
<p>|           | • Contacts                                       |
|           | • Internal Users                                 |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>State of the recipients list.</td>
</tr>
<tr>
<td></td>
<td>• <strong>New</strong>: List has not yet been generated.</td>
</tr>
<tr>
<td></td>
<td>• <strong>In Progress</strong>: List is currently being generated. (You can see this state only when generating a very large list of recipients.)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Complete</strong>: List is generated.</td>
</tr>
<tr>
<td>Setup</td>
<td>Method used to generate the recipients list. Possible values are:</td>
</tr>
<tr>
<td>Method</td>
<td>• <strong>Upload File</strong>: Upload an Excel file with the recipients list using the specified template.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Dynamic Condition</strong>: Run a script or condition builder to create the recipients list.</td>
</tr>
<tr>
<td>Choose File</td>
<td>Allows you to download an Excel template, and then upload the Excel file with user information using the specified template.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• This field is available only if the <strong>Method</strong> is <strong>Dynamic Condition</strong>.</td>
</tr>
<tr>
<td></td>
<td>• The templates vary based on the entity selected in the <strong>Type</strong> field. For accounts, the template includes columns for sys_id and account number values. For contacts, consumers, and internal users, the template includes columns for sys_id and email values.</td>
</tr>
<tr>
<td>Show Script</td>
<td>If selected, displays the script to create the recipients list.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is available only if the <strong>Method</strong> is <strong>Dynamic Condition</strong>.</td>
</tr>
<tr>
<td>Script</td>
<td>Script to create the recipients list.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is available only if the <strong>Method</strong> is <strong>Dynamic Condition</strong> and the <strong>Show Script</strong> check box is selected.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that stores the user information. The table is selected based on the <strong>Type</strong> field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is available only if the <strong>Method</strong> is <strong>Dynamic Condition</strong>.</td>
</tr>
<tr>
<td>User Field</td>
<td>Table field that refers to users.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Note:</td>
<td>This field is available only if the <strong>Method</strong> is <strong>Dynamic Condition</strong>.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Condition builder to create the recipients list based on the specified table and user field. A condition is made up of a selected field, an operator, and a value. Add conditions using the AND and OR buttons. Delete conditions by clicking the Delete button to the right of a condition.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field is available only if the <strong>Method</strong> is <strong>Dynamic Condition</strong>.</td>
</tr>
</tbody>
</table>

**Note:** When the **Method** is **Dynamic Condition**, you can either use a script or a condition builder to create the recipients list.

4. Click **Submit**.
   For recipients lists created by the file upload, clicking **Submit** validates the records in the Excel file. Following validation, the system displays a pop-up window with the upload results, including valid and invalid user records.

5. **Optional:** To get the updated user list, navigate to the recipient list and click **Refresh Recipient List**.

### Add a recipients list to a survey
Send the survey invites to targeted sets of users by adding a recipients list to a survey.

**Before you begin**
Role required: admin or survey_admin
Recipients lists should be pre-defined in the Recipients Lists submodule. For more information on defining recipients lists, see [Define a recipients list for surveys](#).

**Procedure**
1. Navigate to **Survey > View Surveys**.
2. Open a survey definition.
3. Perform any of the following steps.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Platform</td>
<td>a. Under the Survey Recipients Lists related list, click New.</td>
</tr>
<tr>
<td></td>
<td>b. In the Survey Recipients Lists form, from the Recipients List list, select the required recipients list.</td>
</tr>
<tr>
<td></td>
<td>c. Click Submit.</td>
</tr>
<tr>
<td>From Survey Designer</td>
<td>a. Under the Availability tab, for the Accessible By field, select Specific users.</td>
</tr>
<tr>
<td></td>
<td>b. In the Add recipients lists list, select the required recipients list.</td>
</tr>
<tr>
<td></td>
<td>c. To send the survey to users, click Save and Publish.</td>
</tr>
</tbody>
</table>

4. To send survey invites to all survey users and recipients lists, click Send Invitations.

**Note:**
- The Send Invitations UI action is available when there is at least one recipients list or survey user for the survey.
- If a user is available in the Survey Users related list and multiple recipients lists, the survey invite is sent only once to the user.

**Embed a survey within the Outlook email client**

Embed an interactive survey in the email notification sent to a user. The user can answer the survey questions and submit the survey from the email client instead of opening the survey in a new browser tab.

**Before you begin**
Role required: admin or survey_admin
The Outlook Actionable Messages plugin (com.sn_ms_oam) should be activated.
Note:

• The Outlook Actionable Messages (OAM) feature is not supported in all Microsoft mail products and versions. To verify whether your version of Outlook supports OAM, refer to the Microsoft website.

• Actionable messages are supported only for emails sent from the @service-now.com email address. If you are sending an email from a customized email address, you should register as a new service in the Microsoft website setting the scope as Organization. Specify the provider ID value in the `sn_ms_oam.outlookactionable.originator` property.

• Actionable messages are based on the Sender Policy Framework (SPF)/DomainKeys Identified Mail (DKIM) validation for the email sender verification. If an email recipient receives email via an external provider, emails may are not rendered as adaptive cards.

• You cannot customize the default actionable message templates.

Procedure

1. Navigate to System Notification > Email > Notifications.

2. For the Survey User Invite notification, in the What it will contain tab, add the following script in the Message field in addition to the existing information.

   ```
   ${mail_script:include_survey_actionable}
   ```

   This script includes the Outlook actionable message in the email notification sent to the user.

3. Navigate to Survey > View Surveys, and open a survey.

4. To send an email notification to the survey user, select the Send notifications check box.

5. Select the Outlook Actionable Message check box and save the survey.
Note:

- The following questions are not supported for an embedded survey:
  - Attachment
  - Date
  - Datetime
  - Template
  - Reference
  - Image Scale
  - Ranking
- Dependent questions are not supported.
- Signature is not supported.
- Mandatory questions are supported.

In both the Platform UI and Survey Designer, a validation is run to ensure all survey questions are supported.

6. Click Assign Survey and assign the survey to a user.
   An email notification with the embedded survey is sent to the user. The user can take the survey and submit it from the email client instead of opening the survey in a new browser tab.

Enable localization for a survey
Enable a survey user to take a survey in multiple languages.

Before you begin
Role required: admin or survey_admin
The plugin for the language that you want the survey to be available in should be installed.

Note: Localization is applicable only for public surveys.

Procedure
1. Navigate to Survey > Administration > Properties.
2. Enable the Enable/Disable whether to show language picker when a public survey is taken property.
3. In the System Settings window, from the Language list, select the language that you want the survey to be available in.
4. Navigate to Survey > View Surveys and open a public survey.
5. Enter the translated text for the survey title, questions, and answers.
6. Save and publish the survey.

Note: The localization is also applicable in Service Portal if the Assessment Properties Allow survey link from email to open in service portal view (applies only for surveys) (sn_portal_surveys.sp_survey.email_redirection) property is enabled.

- The survey is available for survey users in the translated language.
- Users can change the language of the survey using the language picker.

Survey URLs
You can distribute a survey by giving survey users a survey URL.

Survey administrators can obtain one of the following types of URLs.

- A general URL for a survey, which users can open to take the survey questionnaire. The following process occurs.
  - When someone opens the URL, the system ensures that the person is logged in. It then searches for an instance of the associated survey that is assigned to the logged-in user.
  - If a survey instance is found, the appropriate action occurs based on the State of the survey instance (see table). If there are multiple active survey instances (Ready to take or In progress), the instance with the earliest due date opens.
  - If no survey instance is found, the system creates a new instance for the survey, assigns it to the user, and opens the survey questionnaire.

- A URL for a specific survey instance, which the assigned user can open to take the survey questionnaire. The following process occurs.
  - When someone opens the URL, the system ensures the person is logged in as the user the survey instance is assigned to. Only the assigned user can access the survey questionnaire.
  - The appropriate action occurs, depending on the State of the survey instance (see table).
Survey states

<table>
<thead>
<tr>
<th>Survey instance state</th>
<th>Action upon opening URL</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ready to take:</strong></td>
<td>The survey questionnaire appears for the user to begin. The user can save or submit responses.</td>
</tr>
<tr>
<td>User has not saved any responses.</td>
<td></td>
</tr>
<tr>
<td><strong>In progress:</strong></td>
<td>The survey questionnaire appears for the user to continue. Any previously saved responses are displayed. The user can save or submit responses.</td>
</tr>
<tr>
<td>User has saved at least one response.</td>
<td></td>
</tr>
<tr>
<td><strong>Complete:</strong></td>
<td>If the schedule period is <strong>No Limit</strong> or if the period restriction has expired, the survey questionnaire for a new survey instance appears for the user to begin. If the schedule period restricts the number of times a user can take the same survey, and the period restriction has not expired since the user last completed survey, an error message appears.</td>
</tr>
<tr>
<td>User has submitted all required responses.</td>
<td></td>
</tr>
</tbody>
</table>

If someone opens a URL for an unpublished or deactivated survey, an error message appears.

**Obtain and distribute a general survey URL**

You can distribute a general survey URL to allow any eligible user to open a survey questionnaire.

**Before you begin**

Role required: admin or survey_admin

**About this task**

The general URL is available on the Survey Definition form and on the survey creator. You can also email the URL for a public survey that is published.

**Procedure**

1. Navigate to **Survey > View Surveys**.
2. Open a survey definition from the Assessment Metric Types list.
3. To view or copy the URL, click the **View Survey URL** related link. This related link is visible only if the survey definition is **Active**.
4. To distribute the URL to users, paste the copied URL as desired, or click the Email button to send via email. The Email button is visible only for a public survey that is published.

What to do next
When a survey user clicks the general survey URL, the system creates a survey instance for the survey user as long as the user does not have an instance in the Ready to take state. The system is configured by default to send an email notification when a survey instance is generated.

As a result, the survey user receives a second notification in addition to the notification that you sent with the general survey URL. This may confuse the survey user. To avoid this issue, you can deactivate auto-notification.

Deactivate auto-notification for surveys
When you send a survey notification with a general survey URL to a survey user, the user may receive a second system-generated notification. To avoid this issue, you can deactivate auto-notification.

Before you begin
Role required: admin or survey_admin

Procedure
1. Navigate to System Notification > Email > Notifications.
2. Open the Survey User Invite notification.
3. Configure the form to add the Send to event creator check box to the Who will receive section. The Send to event creator check box is selected by default.
4. Clear the Send to event creator check box. The system will no longer send auto-notification messages to survey users.

Obtain a survey instance URL
You can distribute a survey instance URL to allow the assigned user to open a survey questionnaire.

Before you begin
Role required: admin or survey_admin

About this task
The survey instance URL is available on the survey instance record.
Procedure
1. Navigate to Survey > Survey Instances.
2. Open the instance for the survey.
3. To view or copy the URL, click View Instance URL related link. The related link is available only when the survey instance State is Ready to take or In progress and the associated survey definition is Active.
4. In the dialog box, select and copy the URL then click OK or Cancel.
5. Distribute the URL to the assigned user.

Test a survey URL
When there are survey users associated with a survey, the survey is restricted so only those users can use the survey URL. You can test the survey URL to ensure it is restricted.

Before you begin
Role required: admin or survey_admin

Procedure
1. Navigate to Survey > View Surveys and open a survey for which you are not a survey user.
2. Under Related Links, click View Survey URL.
3. Copy the URL and click OK or Cancel.
4. Navigate to the URL.
   You see a message that you are not authorized to take the survey.

Create a survey module
You can create a module that opens a survey.

Before you begin
Role required: admin or survey_admin

About this task
When a user clicks a survey module, the system performs one of the following actions, depending on the configuration options for the survey and other factors.
• Creates a new survey instance
• Opens an existing survey instance
• Displays an error message.

Procedure
1. Perform the appropriate action for your version of the UI:
   • **UI16**: Point to the application menu that contains the module to which you want to add the survey module and click the edit application (pencil) icon.
   • **UI15**: Right-click the application menu you want to add the module to and select **Edit Application Menu**
2. In the **Modules** related list, click **New**.
3. Complete the following fields.
   • **Link type**: Assessment
     Do not select **Survey**, which is used for legacy surveys only.
   • **Assessment**: Select the survey you want the module to open.
4. Complete and save the form.

Sharing surveys: export and import
You can export a survey and then import it to a different ServiceNow instance.

ℹ️ **Note:** Update sets are available in the Helsinki release and should be used to move data from one instance to another. For information about update sets, see **System update sets**.

The system exports a single XML file that contains a survey definition [asmt_metric_type] and the associated records, including the following.

• Assessment Metric Template [asmt_template]
• Assessment Template Definition [asmt_template_definition]
• Metric definitions [asmt_metric_definition] (survey question answer options)
• Scheduled Jobs associated with the Survey [sys_trigger]
• Survey categories [asmt_metric_category]
• Survey questions [asmt_metric]
• Survey users [asmt_m2m_category_user]
• Trigger Condition [asmt_condition]
**Export a survey**

You can export a survey and then import it to another instance.

**Before you begin**
Role required: admin, survey_reader, or survey_admin
For information about update sets, see System update sets.

**Procedure**

1. Navigate to **Survey > View Surveys**.
2. Right-click the name of a record to show the context menu.
3. Select **Export Assessment**.
4. If applicable, follow the prompt in your browser to save the XML file.

**Import a survey**

You can import a survey that has been exported as an XML file. The exported XML file does not contain result data.

**Before you begin**
Role required: admin or survey_admin

⚠️ **Note:** Update sets are available in the Helsinki release and should be used to move data from one instance to another. For information about update sets, see System update sets.

**About this task**

**Procedure**

1. Verify that the target instance has assessments enabled.
2. Follow the steps to import the assessment.

**Use update sets for surveys and assessments**

Use an update set to capture changes to surveys and assessments.

**Before you begin**
Role required: admin or survey_admin

When developing surveys and assessments, you can use an update set to capture the changes and move them from a development instance to a production instance. Once an update set is created and marked current, all of the updates to the following tables are recorded in the update set.
The following tables are now update set enabled and also extend the application file:

- Assessment Metric Templates [asmt_template]
- Assessment Template Definitions [asmt_template_definition]
- Assessment Metric Definitions [asmt_metric_definition]: survey question answer options
- Schedule [sys_trigger]: scheduled jobs associated with the survey
- Assessment Metric Categories [asmt_metric_category]: survey categories
- Assessment Metrics [asmt_metric]: survey questions
- Assessment Category Users [asmt_m2m_category_user]: survey users
- Trigger Conditions [asmt_condition]

**Configure a survey in the Connect chat support**

Enable a user to take a survey after chatting with a survey agent.

**Before you begin**

Role required: admin or survey_admin

⚠️ Note: The Connect Support plugin (com.glide.connect.support) should be activated.

**Procedure**

1. Navigate to **Connect Support > Support Administration > Chat Survey**.
2. Click **New**.
3. In the Chat Survey form, fill the fields.

**Chat Survey form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey</td>
<td>Survey whose instance should be available in Connect Support.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of chat where the survey is available.</td>
</tr>
<tr>
<td>Chat queue</td>
<td>Chat queue where the survey is available.</td>
</tr>
<tr>
<td>Active</td>
<td>Specifies if the chat survey configuration is active.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the chat survey configuration.</td>
</tr>
</tbody>
</table>
4. Click Submit.
When a support agent of the assignment group associated with the chat queue ends a chat with a user, the survey instance is available in the chat window for the users.

Related information
Monitor incoming Connect Support conversations

Outlook Actionable Messages
Outlook actionable messages plugin enables users to respond to the survey from within the Microsoft Outlook application.

Install Outlook Actionable Messages plugin
Install Outlook Actionable Messages(sn_ms_oam) plugin to configure actionable messages.

Before you begin
Role required: oam_admin

Procedure
1. Navigate to System Application > All Available Applications > All.
2. In the search field, enter Outlook Actionable messages.
   You can search for the application by its name or ID. If you cannot find an application, you may have to request it from ServiceNow store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release note information for all released apps, see the ServiceNow Store version history release notes.
3. Click Install.

Customize fields for the approval message
Customize the body message for a request, change, and request item approval sent in Microsoft Outlook.

Customize fields in the approval message for request
Customize the body message for a request and request item sent in Microsoft Outlook.

Before you begin
Role required: oam_admin
Procedure

1. Navigate to Actionable Messages > OAM Definition.

2. Choose one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request</td>
<td>Click OAM Request Approval</td>
</tr>
<tr>
<td>Request Item</td>
<td>Click OAM RITM Approval</td>
</tr>
</tbody>
</table>

3. In the OAM Container section, customize the following fields as required:
   a. Title: Title of the Outlook approval notification.
   b. Requester info: User who created the request.
   c. Request Details: This field can be customized. You can also add additional fields as per the requirement.

4. Click Update.

   The approval message is displayed in Microsoft Outlook as shown below. Click View Details button to view the request in ServiceNow instance.

Customize fields in the approval message for change request

Customize the body message for a change request approval sent in Microsoft Outlook.

Before you begin
Role required: oam_admin
Procedure
1. Navigate to Actionable Messages > OAM Definition.
2. Click OAM Change Approval.
3. In the OAM Container section, customize the following fields as required:
   a. **Title**: Title of the Outlook approval notification.
   b. **Requester info**: User who created the request.
   c. **Request Details**: This field can be customized. You can also add additional fields as per the requirement.
4. Click Update.
   The approval message is displayed in Microsoft Outlook as shown below. Click View Approval Request to view the request in ServiceNow instance.

Enable Advanced view for Outlook Actionable Message definition
Enable the advanced view to customize the actionable message as per the requirement for Microsoft Outlook.

Before you begin
Role required: oam_admin

Procedure
1. Navigate to Actionable Messages > OAM Definition.
2. Choose one of the following:
### OAM definition

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request</td>
<td>Click OAM Request Approval</td>
</tr>
<tr>
<td>Request Item</td>
<td>Click OAM RITM Approval</td>
</tr>
<tr>
<td>Change</td>
<td>Click OAM Change Approval</td>
</tr>
</tbody>
</table>

3. Click **Advanced OAM** under **Related Links**.

4. In the OAM Definition form, perform the following actions:
   a. Modify the script as required.
   b. Click **Update**.

### Sentiment analysis for surveys

You can use sentiment analysis to determine whether user responses for a survey are considered positive, negative, or neutral.

Activate the Sentiment Analysis (com.snc.sentiment_analysis) plugin.

For a survey, you can select questions that should be used for analysis. The survey responses of these questions are sent to the thirdparty platforms for analysis through the specified connector configurations.

**Note:** You can only use string type questions for sentiment analysis.

The sentiment analysis results are displayed under **Survey > Question Sentiment Results**. The sentiment label is based on the normalized score:

<table>
<thead>
<tr>
<th>Normalized score</th>
<th>Sentiment label</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1 to 0</td>
<td>Negative</td>
</tr>
<tr>
<td>0</td>
<td>Neutral</td>
</tr>
<tr>
<td>0 to 1</td>
<td>Positive</td>
</tr>
</tbody>
</table>

### Configure a sentiment connector

Specify the service URL and other configuration information for third party APIs that are used for sentiment analysis.

**Before you begin**

Role required: admin
Procedure

1. Change the scope of the current session to **Sentiment Analysis**.
2. Navigate to **Sentiment Analysis > Sentiment Connector Configurations**.
3. Add or edit the connector configuration for a third party vendor such as Google, IBM Watson, and MS Azure.

   **Note:** By default, placeholders are available for configuring connectors for Google, IBM Watson, and MS Azure.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the sentiment analysis connector configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the connector configuration.</td>
</tr>
<tr>
<td>Credential Alias</td>
<td>Credential alias associated with the connector configuration. It has a reference to the system level table (sys_alias_list).</td>
</tr>
<tr>
<td>Default</td>
<td>Check box to make this as the default connector configuration.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the connector configuration.</td>
</tr>
<tr>
<td>Script</td>
<td>Script to call the Sentiment Analysis API and the normalize the values.</td>
</tr>
</tbody>
</table>

4. Configure the connector credentials

   **a.** Open the record referred in the **Credential Alias** field.

   **b.** Under the **Connections** tab, select the connection.

   **c.** In the **Connection URL** field, enter the value.

   **d.** Open the record referred in the **Credentials** field.

   **e.** Enter the credential information.
Note:

- You should obtain the connection credentials from the respective third-party vendors.
- If the credential is an API key, specify its value. If the credential is basic authentication, that is, user name and password, specify the corresponding information.

f. Select the Active check box and click Update.

5. Select the Active check box for the connector configuration and click Update.

Sentiment analysis properties

You can use the sentiment analysis properties to customize the Sentiment Analysis module.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response time for the outbound call of Sentiment Analysis API (sn_nlp_sentiment.glide.sentiment.transaction.timeout)</td>
<td>Maximum time (milliseconds) expected for executing the outbound call for Sentiment Analysis API before it's timeout.</td>
</tr>
</tbody>
</table>

Sentiment analysis results

The sentiment analysis results view contains a bar chart that displays the percentage of positive, negative, and neutral results, along with the instance count for each category.

Color indicators

Following are the color indicators in the bar chart:

- Green: Positive
- Red: Negative
- Blue: Neutral
Surveys in Service Portal

If Service Portal is installed, you can use the Survey widget to set up surveys, quizzes, assessments, risk assessments, and attestations in Service Portal. Surveys for users on mobile devices are fully supported in Service Portal.

To create an intuitive interface for your users, you can set up surveys in Service Portal. You must first install Service Portal and then configure the survey widget on the page. To learn more about configuring a widget, see configure widget instances.

To configure a Survey widget on a page, CTRL + right-click the widget heading and select Instance Options.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max records</td>
<td>Number of surveys to list on the Service Portal homepage. The user can click the View all link to view all items. Default: 5</td>
</tr>
<tr>
<td>Title of the widget</td>
<td>Text that appears in the title bar of the surveys widget. Default: My Surveys</td>
</tr>
</tbody>
</table>
Each survey on the My Surveys page contains a progress bar and a description. The color in the progress bar increases as a survey is completed. In the case of a triggered record, the table title is used for the survey description.

For mobile users, the Pagination setting for Service Portal view survey designer property is set to one question per page by default.

One Click survey
A One Click survey has no introduction page in Service Portal. This survey does not have the Submit and Cancel buttons in the desktop and iPad view.
Note:
- The **One Click Survey** field should be selected in the survey definition.
- If the public access is enabled for a One Click survey, a user can submit the survey without having to log in.

A kiosk survey is a One Click survey with only one question of any of the following types:
- Image Scale
- Choice
- Likert Scale
- Numeric Scale
- Yes/No

When you click the answer of the kiosk survey question in Service Portal, the survey is submitted and the end note is displayed on the same page as that of the survey questions.

Note:
- A kiosk survey does not have any **Submit** or **Cancel** buttons.
- A kiosk survey cannot have a signature, dependent questions, or additional information.

**URI parameters for One Click survey**

Pass these URI parameters through the `createAssessment()` API to store their values in the `asmt_assessment_instance` table for both platform view and Service Portal view.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sysparm_refresh_interval</code></td>
<td>Refresh time (in seconds) after the survey submission to create another instance. For example, <code>sysparm_refresh_interval=5</code>.</td>
</tr>
<tr>
<td><code>sysparm_trigger_table</code></td>
<td>Location that is stored as the <strong>Trigger Table</strong> field in the <code>asmt_assessment_instance</code> table. For example, <code>sysparm_trigger_table=incident</code>.</td>
</tr>
</tbody>
</table>
URI parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_trigger_id</td>
<td>Location sysId that is stored as the <strong>Trigger ID</strong> field in the asmt_assessment_instance table. For example, sysparm_trigger_id=1c741bd70b2322007518478d83673af3.</td>
</tr>
<tr>
<td>sysparm_kiosk</td>
<td>When set to true, both sysparm_trigger_table and sysparm_trigger_id parameters should be specified. This is a mandatory parameter for kiosk requests. For example, sysparm_kiosk=true.</td>
</tr>
</tbody>
</table>

**Related information**

- Service Portal
  - Create and edit a page using the Service Portal Designer
- Survey designer
  - Configure a survey in the survey designer

**Surveys in ITSM Virtual Agent**

You can use surveys in ITSM Virtual Agent to collect survey responses from users through conversational questionnaires (pre-chat and post-chat surveys) in the chat client.

A chat survey is available in ITSM Virtual Agent through the Provide Virtual Agent Feedback topic. The logic that renders the survey dynamically is called from the re-usable Survey topic block. It is common to use the Provide Virtual Agent Feedback topic as the survey setup topic in the general definitions of ITSM Virtual Agent, so that users automatically receive a survey at the end of their conversations. For information about the Survey topic block, see [ITSM Virtual Agent](#).

When you select the **Chat Survey** check box for a survey, the following conditions are validated for surveys on ITSM Virtual Agent.

- Survey should contain only one metric category.
- Survey can contain only these metric types.
  - Attachment
  - Boolean
  - Check box
  - Choice
  - Date
For information on configuring a survey, see *Modify a survey definition* and *Configure a survey in the survey designer*.

The following capabilities are supported for the survey:

- Dependent survey fields
- Introduction and end notes

**Association between a survey and Virtual Agent chat**

After a survey is submitted in a Virtual Agent conversation, a survey instance is created. This instance displays the following information:

- Trigger ID, which is the sys_id of the associated interaction ID created in the Virtual Agent chat
- Trigger table, which is the interaction table

**Related information**

- ITSM Virtual Agent

**Quick start tests for Assessments and Surveys**

Validate that Assessments and Surveys still work after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Assessments and Surveys quick start tests require activating the Automated Test Framework for Survey plugin (com.glide.automated_testing_impl.Survey).
## Test Suite for Survey

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey: Basic Platform Based Test</td>
<td>Create a survey using Platform UI actions.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Survey: Platform test for Dynamic Validation</td>
<td>Validate a survey dynamically.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Survey: Clone Action</td>
<td>Clone a survey and validate the records of the original survey and the cloned survey.</td>
<td>New York</td>
</tr>
<tr>
<td>Survey: Question Bank Flow</td>
<td>Verify the addition of a question bank to a survey.</td>
<td>New York</td>
</tr>
<tr>
<td>Survey: Survey Creator Work Flow</td>
<td>Survey creator can create a survey and assign to the user who can take the survey and submit it.</td>
<td>New York</td>
</tr>
<tr>
<td>Assessment: Assign assessment to assessor</td>
<td>Assign an assessment to an assessor and verify that the instance is created for the assessor.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Assessment: Create assessment as survey creator</td>
<td>Create an assignment as a survey creator.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Assessment: Basic test flow</td>
<td>Verify the basic flow of an assessment.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

## Related information

**Quick start tests**

**Legacy survey migration**

Users with the survey_admin role can migrate legacy survey data to create copies of legacy surveys and their related records in assessment tables. The Survey Management application, which is built on the assessment engine, is available as an alternative to legacy surveys.
The following legacy survey components are migrated:

• Survey masters
• Supported survey questions and question choices
• Survey instances
• Survey responses

Legacy survey conditions are not migrated and must be recreated as trigger conditions.

⚠️ Note:

• The Legacy Surveys and Legacy Administration modules are available on instances upgraded from a previous release but not available for new instances. Customers using legacy survey or survey wizard should plan to migrate to the Survey Management application to create modern and high quality surveys for their users.

• The following legacy survey plugins are inactive by default, and are available upon request:
  ◦ Best Practice - Task Survey Management (ID: com.snc.bestpractice.task_survey)
  ◦ Survey Management (ID: com.glideapp.survey)
  ◦ Assessment Components (ID: com.snc.assessment)
  ◦ Survey Wizard (ID: com.glideapp.survey_wizard)

• Survey wizards cannot be migrated.

Migrate a legacy survey

Migrate a legacy survey and its related records to take advantage of a more powerful feature set.

Before you begin
Role required: admin or survey_admin

About this task
To avoid timing out for very large surveys, you can disable the transaction quota. See.
Procedure

1. Navigate to Survey > Legacy Surveys > Masters.
   The list of legacy survey masters appears. By default, the list shows only survey masters that have not been migrated. To show all survey masters, remove the Assessment is empty breadcrumb.

2. Open a survey and click the Migrate to New Survey Management related link or Migrate to New Survey Management in the title bar.
   A dialog box describes what happens when you migrate the survey. Note that certain types of survey questions cannot be migrated.

3. Click OK.
   The system generates records on assessment tables based on the survey master, eligible questions and choices, results, and other related survey components. The original survey components are unaffected.

   System messages may appear at the top of the Survey form to notify you of questions that could not be migrated and to advise you to review migrated Multiple Choice questions.

4. Optional: Click the reference icon beside the Assessment field to view the new survey definition.

5. Optional: Remove survey users from the assessment survey if you want all users to be able to take it.
   When you migrate a survey, any users who have taken it are automatically associated with the assessment survey and become survey users. When there are survey users associated with an assessment survey, only those users can take it.

6. Deactivate any survey conditions associated with the survey by completing the following steps.
   a. Navigate to Survey > Legacy Administration > Survey Conditions.
   b. In the Active column, ensure the value is false for any survey conditions that reference the migrated survey.

7. Navigate to Survey > Administration > Trigger Conditions to create new trigger conditions for the migrated survey.

Results
The Migrate to Assessment related link on the legacy survey record becomes unavailable after the migration. However, if you delete the record referenced in the Assessment field, the related link reappears and you can migrate the legacy survey again.
Survey question migration

Before you migrate a legacy survey, understand that some legacy survey questions cannot be migrated due to incompatible question types.

Legacy survey questions are migrated from the Survey Question [survey_question_new] table to the Assessment Metric [asmt_metric] table. In legacy surveys, the **Type** field on the Survey Question table determines how the question renders on the survey questionnaire. In assessment surveys, the **Data type** field on the Assessment Metric table serves a similar purpose. Certain legacy survey types are not supported in assessment surveys.

The following table shows the conversion path for each legacy survey question type to an assessment data type, if there is one.

<table>
<thead>
<tr>
<th>Legacy survey type</th>
<th>Assessment data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Break</td>
<td>Not available</td>
</tr>
<tr>
<td>CheckBox</td>
<td>Checkbox</td>
</tr>
<tr>
<td>Date</td>
<td>Date</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date/Time</td>
</tr>
<tr>
<td>HTML</td>
<td>Not available</td>
</tr>
<tr>
<td>Label</td>
<td>Not available</td>
</tr>
<tr>
<td>List Collector</td>
<td>Not available</td>
</tr>
<tr>
<td>Lookup Multiple Choice</td>
<td>Not available</td>
</tr>
<tr>
<td>Lookup Select Box</td>
<td>Not available</td>
</tr>
<tr>
<td>Macro</td>
<td>Not available</td>
</tr>
<tr>
<td>Macro with Label</td>
<td>Not available</td>
</tr>
<tr>
<td>Multi Line Text</td>
<td>String (String option set to Multiline)</td>
</tr>
<tr>
<td>Multiple Choice</td>
<td>Likert Scale</td>
</tr>
<tr>
<td>Numeric Scale</td>
<td>Number</td>
</tr>
<tr>
<td>Reference</td>
<td>Not available</td>
</tr>
<tr>
<td>Select Box</td>
<td>Choice</td>
</tr>
<tr>
<td>Single Line Text</td>
<td>String (String option set to Single line)</td>
</tr>
</tbody>
</table>
Survey question migration (continued)

<table>
<thead>
<tr>
<th>Legacy survey type</th>
<th>Assessment data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI Page</td>
<td>Not available</td>
</tr>
<tr>
<td>Wide Single Line Text</td>
<td>String <em>(String option set to Single line wide)</em></td>
</tr>
<tr>
<td>Yes / No</td>
<td>Yes/No</td>
</tr>
</tbody>
</table>

**Migrated components**

When you migrate a survey, the system maps records from survey tables to assessment tables.

To create a functional survey on the assessment framework, the system converts survey records to the most logical equivalent assessment survey records. This may mean multiple assessment survey records represent one legacy survey record.

**Migrated components**

<table>
<thead>
<tr>
<th>Survey component</th>
<th>Assessment survey components</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey master [survey_master]</td>
<td>• Survey definition [asmt_metric_type]</td>
</tr>
<tr>
<td></td>
<td>• Assessable record [asmt_assessable_record], for system use only</td>
</tr>
<tr>
<td></td>
<td>• Survey category [asmt_metric_category]</td>
</tr>
<tr>
<td>Survey question [survey_question_new]</td>
<td>• Survey question [asmt_metric]</td>
</tr>
<tr>
<td>Question choice [question_choice]</td>
<td>• Assessment metric definition [asmt_metric_definition]</td>
</tr>
<tr>
<td>Survey instance [survey_instance]</td>
<td>• Assessment group [asmt_assessment], for system use only</td>
</tr>
<tr>
<td></td>
<td>• Survey instance [asmt_assessment_instance]</td>
</tr>
<tr>
<td>Survey response [survey_response]</td>
<td>• Survey instance question [asmt_assessment_instance_question]</td>
</tr>
<tr>
<td></td>
<td>• Survey response [asmt_metric_result]</td>
</tr>
<tr>
<td></td>
<td>• Category result [asmt_category_result], for system use only</td>
</tr>
</tbody>
</table>
Migrated question review

To maintain accurate result calculations, you may need to make minor adjustments to some of the migrated survey records to ensure results are calculated correctly.

**Note:** The assessment engine provides a built-in result calculation feature that converts each survey response to a score between 0 and 10. The configuration required to maintain accurate result calculations is advanced and is not recommended for basic survey implementations. If you do not plan to use result calculation data, ignore the information in this section.

For each legacy question migrated, the system creates a survey question record on the Assessment Metric [asmt_metric] table. For legacy questions of the Multiple Choice and Select Box types, the system also creates a metric definition record, on the Assessment Metric Definition [asmt_metric_definition] table, for each legacy question choice.

### Comparable metric definitions and survey question choices

<table>
<thead>
<tr>
<th>Survey question choice field</th>
<th>Related metric definition field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Display</td>
</tr>
<tr>
<td>Value (can be any string value)</td>
<td>Value (must be a numerical value)</td>
</tr>
<tr>
<td>Order</td>
<td>Value (metric definition with smallest Value is first)</td>
</tr>
</tbody>
</table>

When the system migrates legacy survey question choices, it uses the legacy Order to set each metric definition Value. For the legacy question choice with the smallest Order, the corresponding metric definition Value is set to 1. For the legacy question choice with the next smallest Order, the metric definition Value is 2, and so on.

The Scale definition field on the migrated Survey Question form determines whether smaller or bigger metric definition values equate to a good score in survey result calculations. By default, the scale definition is set to High, meaning bigger values are good. When you migrate a legacy survey, check that the default scale definition makes sense for each question.

For example, the following tables depict a sample migrated question and the metric definitions automatically created for it. Recall that the system uses the order of the legacy survey question choices to set the metric definition value.
Excellent has the lowest Order value, so when the system creates a metric definition for this question choice, the Value is set to 1. In this case the default scale definition value, High, does not make sense, as the system will calculate the worst scores for responses of Excellent.

### Legacy question: Please rate the overall quality of your service.

<table>
<thead>
<tr>
<th>Question choice text</th>
<th>Question choice value</th>
<th>Question choice order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excellent</td>
<td>A</td>
<td>100</td>
</tr>
<tr>
<td>Good</td>
<td>B</td>
<td>200</td>
</tr>
<tr>
<td>Fair</td>
<td>C</td>
<td>300</td>
</tr>
<tr>
<td>Poor</td>
<td>D</td>
<td>400</td>
</tr>
</tbody>
</table>

### Migrated question: Please rate the overall quality of your service.

<table>
<thead>
<tr>
<th>Metric definition display</th>
<th>Metric definition value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excellent</td>
<td>1</td>
</tr>
<tr>
<td>Good</td>
<td>2</td>
</tr>
<tr>
<td>Fair</td>
<td>3</td>
</tr>
<tr>
<td>Poor</td>
<td>4</td>
</tr>
</tbody>
</table>

If there are no Order values for the legacy survey question choices, the system sets each corresponding metric definition Value based on the alphanumeric order of the legacy Text value.

### Migrated question: Please rate the overall quality of your service.

<table>
<thead>
<tr>
<th>Metric definition display</th>
<th>Metric definition value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excellent</td>
<td>1</td>
</tr>
<tr>
<td>Good</td>
<td>2</td>
</tr>
<tr>
<td>Fair</td>
<td>3</td>
</tr>
<tr>
<td>Poor</td>
<td>4</td>
</tr>
</tbody>
</table>

You may also need to change the Scale definition setting for other migrated questions. For details, see the scale definition recommendations for each survey question data type.
Task Communications Management

Task Communications Management (TCM) provides a framework for defining and managing a communication process for any entity that extends the task table.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Task Communications Management process</td>
<td>• Activate Task Communications Management</td>
<td>• Working with Task Communications Management</td>
</tr>
<tr>
<td>• Slack Communication</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Integrate</th>
</tr>
</thead>
<tbody>
<tr>
<td>• NA</td>
<td>• Developer training</td>
<td>• NA</td>
</tr>
<tr>
<td></td>
<td>• Developer documentation</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Troubleshoot and get help</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Ask or answer questions in the Incident Management community</td>
<td></td>
</tr>
<tr>
<td>• Search the Known Error Portal for known error articles</td>
<td></td>
</tr>
<tr>
<td>• Contact Customer Service and Support</td>
<td></td>
</tr>
</tbody>
</table>

Task Communications Management process

Task Communications Management helps you to streamline the process by creating designated communication plans for effective communication during an event. The communication plan, with its defined tasks, helps you to focus on resolving the current issue instead of deciding when to send a communication, what information to share, and whom to inform.
**How Task Communications Management works**

With Task Communications Management, you can predefine a communication plan for an event such as major incident, planned maintenance, and release. Each plan generally involves a series of tasks that define different communication and collaboration activities along with frequency and method of communication. For each task, you must specify the communication channel for contacting the stakeholders. You can also define templates for email and SMS messages.

After defining the task and channel for communication, you can define the contacts or the target audience to be contacted for each task.

After a communication plan is defined, the plan gets associated with the appropriate task table based on the conditions defined. Thereafter, the tasks defined in the plan get executed sequentially and stakeholders are contacted as defined in the plan. The communication plan makes communication and collaboration process smoother and brings a quicker resolution of the issue.

**Example: Task Communications Management flow in major incident management**

Assume that you want an incident communication plan generated for a high-priority major incident.

- As the major incident manager, you can predefine a communication plan and the conditions that drive its attachment. In this case, the conditions are: Priority = High and Major Incident state = Accepted. Consider that the target audience is the technical stakeholders of the incident and the communication plan definition is named Technical Communications.

- The plan definition can have multiple communication task definitions such as:
  - Initiate Technical Communications
  - Technical Status Update
• Each communication task definition also specifies the channel of communication and the communication frequency (one time or recurring).
  ◦ Initiate Technical Communications uses email as a channel of communication and communication frequency is one time.
  ◦ Technical Status Update uses email and SMS as channel of communication and the communication frequency is recurring.
• The target audience for the communications is defined as communication contact definitions on the plan definition. In this case, consider Service owners of the affected configuration items (CIs) related to the incident as technical stakeholders.
• When an incident meets these conditions, an incident communication plan together with its tasks gets attached to the incident record.
• As the major incident manager, you can effectively carry out the communication without any delay in the resolution of the major incident.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Task Communications Management plugins
The Task Communications Management plugins is activated in the base system. The plugin includes demo data.

Activate Task Communications Management
The Task Communications Management plugin (com.snc.task_communication_management) is activated when you activate the Incident Communications Management plugin (com.snc.iam) or the Incident Management - Major Incident Management plugin (com.snc.incident.mim). This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

About this task
Task Communications Management activates these related plugins if they are not already active.
Plugins for Task Communications Management

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Management [com.snc.contact_management]</td>
<td>The Contact Management plugin manages the connections between users or groups and other resources in the system.</td>
</tr>
<tr>
<td>Targeted Communications [com.sn_publications]</td>
<td>The Targeted Communications plugin provides a way to publish and send out newsletter like articles to targeted internal or external customers.</td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see **Request a plugin**.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

Related information

**Components installed with Task Communications Management**

Several types of components are installed with the Task Communications Management plugin, including tables and user roles.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see **Find components installed with an application**.

Demo data is available for this feature.
### Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Plan Admin [sn_comm_management.comm_plan_admin]</td>
<td>Provides overall accountability of Task Communications Management. This role has create and edit access to Task Communications Management tables including Communication Plan Definitions and other related records.</td>
<td>• Notify_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Sn_publications_recipients_list_user</td>
</tr>
<tr>
<td>Communication Plan Viewer [sn_comm_management.comm_plan_viewer]</td>
<td>This role has read access to Task Communications Management tables.</td>
<td>• Notify_view</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Sn_publications_recipients_list_user</td>
</tr>
<tr>
<td>Communication Plan Manager [sn_comm_management.comm_plan_manager]</td>
<td>This role has create and edit access to Task Communications Management instance tables such as Communication Plans, Communication Tasks. Users with this role can send impromptu communications.</td>
<td>Communication Plan Viewer</td>
</tr>
</tbody>
</table>

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Plan Type Lookup [comm_plan_type_lookup]</td>
<td>Stores the communication plan types.</td>
</tr>
<tr>
<td>Communication Task Type Lookup [comm_task_type_lookup]</td>
<td>Stores the communication task types.</td>
</tr>
<tr>
<td>Communication Plan Definition [comm_plan_definition]</td>
<td>The definition table for the communication plan entity.</td>
</tr>
<tr>
<td>Communication Task Definition [comm_task_definition]</td>
<td>The definition table for the communication task entity.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Communication Channel Definition</td>
<td>Main table for channel definitions.</td>
</tr>
<tr>
<td>[comm_channel_definition]</td>
<td></td>
</tr>
<tr>
<td>Communication Channel Definition — Email</td>
<td>Defines email as a channel.</td>
</tr>
<tr>
<td>[comm_channel_def_email]</td>
<td></td>
</tr>
<tr>
<td>Communication Channel Definition — SMS</td>
<td>Defines SMS as a channel.</td>
</tr>
<tr>
<td>[comm_channel_def_sms]</td>
<td>Note: This table is available only when you install the Notify plugin (com.snc.notify).</td>
</tr>
<tr>
<td>Communication Channel Definition — Conference</td>
<td>Defines Conference as a channel.</td>
</tr>
<tr>
<td>[comm_channel_def_conference]</td>
<td>Note: This table is available only when the Notify plugin (com.snc.notify) is installed.</td>
</tr>
<tr>
<td>Communication Contact Definition</td>
<td>Defines the contacts for sending out communications. Contacts can be users, groups, or recipient lists.</td>
</tr>
<tr>
<td>[comm_contact_definition]</td>
<td></td>
</tr>
<tr>
<td>Communication Channel Configuration</td>
<td>Lists all available channels for an instance.</td>
</tr>
<tr>
<td>[comm_channel_config]</td>
<td>Note: Configuration script for each channel is a script include.</td>
</tr>
<tr>
<td>Communication Plan</td>
<td>Stores the communication plan that outlines the communication activity during an event.</td>
</tr>
<tr>
<td>[comm_plan]</td>
<td></td>
</tr>
<tr>
<td>Communication Task</td>
<td>Stores the task to be carried out to communicate with the involved contacts.</td>
</tr>
<tr>
<td>[comm_task]</td>
<td></td>
</tr>
<tr>
<td>Communication Channel</td>
<td>Main table for channel instances.</td>
</tr>
<tr>
<td>[comm_channel]</td>
<td></td>
</tr>
<tr>
<td>Communication Channel — Email</td>
<td>Stores record that indicate email is used as a communication</td>
</tr>
<tr>
<td>[comm_channel_email]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Communication Channel — SMS [comm_channel_sms]</td>
<td>Stores record that indicate SMS is used as a communication channel for a communication task.</td>
</tr>
<tr>
<td>Communication Channel — Conference [comm_channel_conference]</td>
<td>Stores record that indicate conference is used as a communication channel for a communication task.</td>
</tr>
<tr>
<td>Communication Task Handler [comm_task_handler]</td>
<td>Lists specific handlers for various task types. Example: For incident, CommunicationManagementIncidentHandler.</td>
</tr>
</tbody>
</table>

**Install Collaboration Services for Task Communications Management**

Install the Collaboration Services for Task Communications Management plugin (sn_tcm_collab_hook) from ServiceNow Store to get the Slack functionality.

**Before you begin**
Role required: admin

**About this task**

**Procedure**

1. Navigate to ServiceNow Store.
2. Find the Collaboration Services for Task Communications Management store application.
3. Click the Collaboration Services for Task Communications Management store application and then click **Request App**.

**Related information**

Configure Slack workspace
Components installed with Collaboration Services for Task Communications Management

Several types of components are installed with the Collaboration Services for Task Communications Management (sn_tcm_collab_hook) plugin, including tables.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Channel Definition – Slack</td>
<td>The table extends the Communication Channel Definition table.</td>
</tr>
<tr>
<td>[comm_channel_def_slack]</td>
<td></td>
</tr>
<tr>
<td>Communication Channel – Slack</td>
<td>The table extends the Communication Channel table.</td>
</tr>
<tr>
<td>[comm_channel_slack]</td>
<td></td>
</tr>
<tr>
<td>Communication Plan — Collaboration Service Data</td>
<td>Stores Collaboration Service related data.</td>
</tr>
<tr>
<td>[comm_plan_collab_data]</td>
<td></td>
</tr>
</tbody>
</table>

Related information

Configure Slack workspace

Working with Task Communications Management

The section covers topics that help you with a variety of technical concepts related to Task Communications Management such as creating communication plan definition, task definition, channel definition, and contact definition.

Define a communication plan

Define a communication plan for a task record to specify communication task and contact definitions. When specified conditions for the plan definition are met, the communication plan and its associated records are automatically attached to the task record, eliminating manual effort.
Before you begin
Role required: sn_comm_management.comm_plan_admin or admin

Procedure
2. On the form, fill in the fields.

Communication Plan Definition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the communication plan.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that the plan is attached to when the conditions are met.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of communication plan such as Technical, Internal, External, Customer.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the communication plans must be associated to the table.</td>
</tr>
<tr>
<td>Condition based</td>
<td>Option to define whether the plan is attached to a table based on the conditions. For example, if you want to attach a communication plan to an incident of priority = 2, you can mention the condition in the <strong>Condition</strong> field.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to define whether the plan definition is active.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the plan definition.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition under which a communication plan gets attached to a table.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
The communication plan is submitted. The following related lists appear in the communication plan definition:
- Communication Task Definitions
- Communication Contact Definitions

What to do next
Define a communication task for the plan.
Define a communication task

Define a communication task for a communication plan. When a plan gets attached to a table, the tasks related to the plan need to be executed to resolve the issue. You can associate multiple tasks with a communication plan.

Before you begin
Role required: sn_comm_management.comm_plan_admin or admin

You have defined a communication plan.

Procedure
1. Navigate to **Task Communications Management > Plan Definitions**.
2. Click the communication plan for which you want to define a communication task.
3. Click the Communication Task Definitions related list and then click **New**.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication plan definition</td>
<td>Unique name of the communication plan definition that you are defining the task for.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique name for the communication task definition.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of task, such as internal communication, that is applicable globally or to a particular table.</td>
</tr>
<tr>
<td>Note: The value in the Type field helps you to filter a task by its type. The value also helps to generate a report of a particular task type or to create SLAs on any communication task.</td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the task definition. The task definition is available for all applications or for scoped applications.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the communication tasks appear in the plan. This field indicates which communication task to execute first.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Option to define whether the task is active or not.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the task definition.</td>
</tr>
<tr>
<td>Communication frequency</td>
<td>Frequency of the communication task execution. You can send the notification once or the notification can be repeated.</td>
</tr>
<tr>
<td>Duration</td>
<td>Time by which you want to send a notification. For example, if the communication frequency is <strong>One time</strong> and the <strong>Duration</strong> is 15 minutes, then the notification is sent only once in 15 minutes. If the communication frequency is <strong>Recurring</strong>, then the notification is sent every 15 minutes.</td>
</tr>
</tbody>
</table>

5. Click **Update**. The communication task is defined for the communication plan.

**What to do next**
Define communication channel for the task.

**Define a communication channel**
Define a communication channel for each communication task to determine which mode of communication to use for the task when a plan is attached to a table.

**Before you begin**
Role required: sn_comm_management.comm_plan_admin or admin
You have defined a communication plan and its related tasks.

**About this task**
- The modes of communication available are: email, SMS, conference, and Slack.
- For the incident table, the functionality for SMS and conference appears only if you activate the Notify plugin (com.snc.notify) and the `com.snc.iam.notify_number` property value is set to the registered notify number. The notify number is registered while configuring the Twilio account.
- For the incident table, the functionality for Slack appears only if you activate the Collaboration Services for Task Communications Management plugin (sn_tcm_collab_hook). To activate the Collaboration Services for Task Communications Management plugin, navigate to ServiceNow Store and...
install the Collaboration Services for Task Communications Management application. For more information, refer Collaboration services for Task Communications Management.

**Note:** For information on how to configure Slack, refer to [Configure Slack workspace](#).

- **Add Channel – Conference** is mutually exclusive to **Add Channel – SMS** and **Add Channel – Email**. If you select **Add Channel – Conference**, you cannot select **Add Channel – Email** or **Add Channel – SMS**.

**Procedure**

1. Navigate to **Task Communications Management > Plan Definitions**.
2. Click a communication plan.
3. Click the Communication Task Definitions related list and then click the task for which you want to define the communication channel.
4. On the Communication Task Definition form, click any one of the following related links based on your requirement:
   - **Add Channel – Conference**
   - **Add Channel – Email**
   - **Add Channel – SMS**
   - **Add Channel – Slack**
5. On the form, fill in the fields.

**Communication Channel Definition form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Channel – Conference</td>
<td>Communication task definition that the channel definition is associated with.</td>
</tr>
<tr>
<td>Notify provider selector</td>
<td>Lookup icon (🔍) to select the selector from the Provider Selector [notify_group_selector] table.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Note: The selector can be associated with notify number group or conference provider. Each notify number group can have one or more Notify numbers that can be used to make conference calls.</td>
<td></td>
</tr>
<tr>
<td>Add Channel – Email</td>
<td></td>
</tr>
<tr>
<td>Communication task definition</td>
<td>Communication task definition that this channel definition is associated with.</td>
</tr>
<tr>
<td>Email client template</td>
<td>Lookup icon (🔍) to select the email client template used to send emails to the targeted audience.</td>
</tr>
<tr>
<td>Note: This email template must be defined in the Communication task table.</td>
<td></td>
</tr>
<tr>
<td>Add Channel – SMS</td>
<td></td>
</tr>
<tr>
<td>Communication task definition</td>
<td>Communication task definition this channel definition is associated with.</td>
</tr>
<tr>
<td>Notify SMS template</td>
<td>Lookup icon (🔍) to select the notify SMS template used to send an SMS to the targeted audience.</td>
</tr>
<tr>
<td>Note: This SMS template must be defined in the Communication task table.</td>
<td></td>
</tr>
<tr>
<td>Notify provider selector</td>
<td>Lookup icon (🔍) to select the selector from the Provider Selector [notify_group_selector] table.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Note: | The selector can be associated with notify number group or conference provider. Each notify number group can have one or more Notify numbers that can be used to send SMS.

Add Channel – Slack

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication task definition</td>
<td>Communication task definition this channel definition is associated with.</td>
</tr>
<tr>
<td>Channel Type</td>
<td>Channel type is Slack.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.
A communication channel is defined for the communication task.

**What to do next**
After creating communication tasks and communication channels for those tasks, define contacts for the communication plan.

**Define a communication contact**
Define the recipients of a particular plan to determine the target audience involved in each communication task and the responsibilities the recipients are expected to handle. A notification for a task is sent to all individuals specified for that task.

**Before you begin**
Role required: sn_comm_management.communication_plan_admin or admin
You have defined a communication plan.

**About this task**
You can add or remove any particular communication contact manually.

**Procedure**
1. Navigate to **Task Communications Management > Plan Definitions**.
2. Click the communication plan that you want to define the contacts for.
3. Click the **Communication Contact Definitions** related list and then click **New**.
4. On the form, fill in the fields.
Communication Contact Definition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Type of contact such as user, group, or recipient list that you want to involve in the plan. The contact type is assigned dynamically at the time of the table execution. For information on recipient lists, refer Define a recipient list for communication contact.</td>
</tr>
<tr>
<td>Responsibility</td>
<td>Responsibility that the user, group, or individuals in the recipient list are expected to handle.</td>
</tr>
<tr>
<td>User</td>
<td>Name of the user, group, or recipient list to be added to the contact list. Note: You can use the recipient list to specify dynamic criteria for fetching the list of users for a particular communication plan.</td>
</tr>
</tbody>
</table>

5. Click Submit.
A communication contact is defined for the communication plan.

Define a recipient list for communication contact

A recipient list lets you specify a filter to fetch a list of users. Use the recipient list as the contact for a particular communication plan.

Before you begin
Role required: sn_comm_management.comm_plan_admin or admin

About this task
Sometimes, the contacts that you want to include in a plan can only be known dynamically. For example, you might want the support group associated with a particular business service in an incident to be involved in the communication plan. The support group might change depending on the business service that you select. In such a case, a recipient list provides the flexibility to add recipients dynamically.
Procedure

1. Navigate to Task Communications Management > Administration > Recipients Lists.
2. Click New to create a new recipient list.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the recipient list.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of recipient.</td>
</tr>
<tr>
<td>State</td>
<td>[Read only] The state of the recipient list.</td>
</tr>
<tr>
<td>Setup Method</td>
<td>The method used to generate the recipient list.</td>
</tr>
<tr>
<td></td>
<td>• Upload File: Upload an Excel file with the recipient information to create a recipient list. This list is static.</td>
</tr>
<tr>
<td></td>
<td>• Dynamic Condition: Use scripts or conditions to receive recipient information.</td>
</tr>
</tbody>
</table>

4. Click Submit.
   A recipient list is defined for the contact.

What to do next
Define a communication contact for the task.

Create a plan type

Create the communication plan type and specify whether the plan type is applicable globally or to a particular table. When you create the communication plan type, it is referenced in the communication plan definition. The type of the communication plan helps you to filter the plan by its type, generate a report of a particular plan type, or create SLAs for any communication plan.

Before you begin
Role required: sn_comm_management.comm_plan_admin or admin
Procedure

1. Navigate to Task Communication Management > Administration > Plan Types, and click New.

2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the communication plan type.</td>
</tr>
<tr>
<td>Global</td>
<td>Option to determine whether the plan type is available for all tables or for a specific table. If the check box is not selected, the Table field appears where you can select the table for which the plan type appears.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the plan type. The plan type is available for all applications or for scoped applications.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to define whether the plan type is active.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the plan type.</td>
</tr>
</tbody>
</table>

3. Click Submit.
   A communication plan type is created.

What to do next
Define a communication plan.

Create a task type
Create the communication task type and specify whether the task is applicable to a particular table or is globally applicable. The communication task type helps you to filter a task by its type, generate a report of a particular task type, or create SLAs for any communication task.

Before you begin
Role required: sn_comm_management.comm_plan_admin
Procedure

1. Navigate to **Task Communication Management > Administration > Task Types**, and click **New**.
2. On the form, fill in the fields.

**Communication Task Type Lookup form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the communication task type.</td>
</tr>
<tr>
<td>Global</td>
<td>Option to determine whether the task type is available for all tables or for a specific table. If the check box is not selected, the <strong>Table</strong> field appears where you can select the table the task type appears for.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the task type. The task type is available for all applications or for scoped applications.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to define whether the task type is active or not.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description regarding the type of the task.</td>
</tr>
</tbody>
</table>

3. Click **Submit**. 
   A communication task type is created.

**What to do next**
Define a communication task.

**Define contact responsibilities**
Define the different contacts or target audience involved in the communication process and their responsibility to understand the expectations from those contacts throughout the process.

**Before you begin**
Role required: sn_comm_management.comm_plan_admin or admin
Procedure

1. Navigate to Task Communication Management > Administration > Contact Responsibilities, and click New.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
<td>Option to determine whether the contact responsibility is available for all tables or for a specific table. If the check box is not selected, the Table field appears where you can select the table that you are defining the contact responsibility for.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique name of the contact, such as Business Director or Communication Manager, involved in the communication process.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of contact such as user, group, or recipient list.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that the contact is activated on when a communication plan is attached.</td>
</tr>
</tbody>
</table>

3. Click Submit.

Contact responsibilities are defined.

What to do next
Define a communication contact for the task.

View communication channel configuration

View the configuration of different communication channels that are used to contact the target audience in the communication process. By default, the communication channels available are email, SMS, Slack, and conference.

Before you begin
Role required: sn_comm_management.comm_plan_admin or admin

About this task
You only have read access to the Channel Configuration module. If you want to create a new channel configuration, request the channel configuration through the Now Support Customer Service system.
Procedure
1. Navigate to Task Communication Management > Administration > Channel Configuration.
2. Open any communication channel record.
3. On the form, view the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>[Read only] Mode of channel.</td>
</tr>
<tr>
<td>Configuration script</td>
<td>[Read only] Lookup icon (🔍) to select the script that defines the channel configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>[Read only] Option to define whether the communication channel is active or not.</td>
</tr>
<tr>
<td>Classification</td>
<td>[Read only] Internally used to group the channels between conference or major incident management workbench.</td>
</tr>
</tbody>
</table>

Configure Slack for a communication task
Configure Slack as a mode of communication for a communication task to send direct message to the users.

Before you begin
Role required: sn_comm_management.comm_plan_admin or admin
Install the Collaboration Services for Task Communications Management plugin (sn_tcm_collab_hook) from ServiceNow Store.

Procedure
1. Navigate to Incident > Communication Plan Definitions.
2. Open the communication plan where you want to add Slack as a communication channel for a communication task.
3. Open the communication task definition for which you want to add Slack as the mode of communication.
4. Click the Add Channel – Slack related links.
5. Click Submit.
   Slack gets added as a communication channel for the communication task.
Timeline Visualizations

A timeline visualization is a representation of an organization's activities over time.

Typically, timeline visualizations are useful for quickly assessing the impact of future strategic and operational activities such as change requests and projects. Timeline visualizations come in two varieties: a two-dimensional (2D) view where activities are grouped by month, and a three-dimensional (3D) view where activities are grouped in lanes. Both views are interactive, and the 2D view can be printed.

Timeline administrators, users with the timeline_admin role, can set up visualizations to represent ITSM-related activities, such as incidents, problems, changes, and projects. Timeline administrators or users with the timeline_user role can personalize their timeline visualizations from the Settings pane in the visualization.

The CIO Roadmap timeline visualization shows your organization's projects grouped by portfolios. Organizational leaders can use the CIO Roadmap to monitor and evaluate the status of current and upcoming projects.

Note: Activating timeline visualizations does not activate predefined CIO roadmap. You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.

Key terms for timeline visualizations

- **Lane**: A logical grouping of items on the 3D timeline visualization. For example, one lane might show pending projects while another lane shows open projects.

- **Panel**: A block that represents an item record in a 2D timeline visualization, or a block that represents one or more item records in a 3D timeline visualization.

- **Summary view**: A pop-up window that appears when a user clicks a panel in either the 2D or 3D timeline visualization. The summary view contains additional information about the record. Timeline administrators configure the information that appears in the summary view.

- **Marker**: A bar indicating the start of a month in a 3D timeline visualization.

- **Slider**: A tool used to control the time period seen in a 3D visualization.

- **Slider track**: An alternative view of the panels displayed in both the 2D and 3D timeline visualization.
An administrator can activate the Timeline Visualization plugin (com.snc.timeline_visualization) to access the functionality.

About this task
To use the CIO roadmap with timeline visualization, you must activate Project Portfolio Management (com.snc.financial_planning_pmo) plugin.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

- **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: *Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.*

### Installed with Timeline Visualizations

Several components are installed with timeline visualizations.

#### Tables

Timeline visualization adds the following table.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timeline Visualization [roadmap_-page]</td>
<td>Stores all available timeline visualizations.</td>
</tr>
<tr>
<td>Personalize Timeline [roadmap_user_-page]</td>
<td>Stores timeline personalization settings for all timeline visualizations.</td>
</tr>
</tbody>
</table>

#### UI Policies

Timeline visualization adds the following UI policy.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Timeline Visualization configuration</td>
<td>Timeline Visualization [roadmap_page]</td>
<td>Script that hides fields in the Timeline Visualization form when the form loads.</td>
</tr>
</tbody>
</table>

#### Script Includes

Timeline visualization adds the following script includes.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roadmap2DUtil</td>
<td>Timeline Visualization - 2D API to generate data for lanes and panels.</td>
</tr>
<tr>
<td>RoadmapCommonUtil</td>
<td>Timeline visualization common utility to handle generic functions.</td>
</tr>
</tbody>
</table>
### Timeline Visualization Utility

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RoadmapConfig</td>
<td>Timeline visualization utility allowing configuration through the Timeline Visualization [roadmap_page] table.</td>
</tr>
<tr>
<td>RoadmapItems</td>
<td>Timeline visualization utility to get lane items.</td>
</tr>
<tr>
<td>RoadmapUtil</td>
<td>API to generate data for lanes and panels.</td>
</tr>
</tbody>
</table>

### Business Rules

Timeline visualization adds the following business rule.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check only one default</td>
<td>Timeline Visualization [roadmap_page]</td>
<td>Checks if another visualization is already set as default when user sets a</td>
</tr>
</tbody>
</table>

### Client Scripts

Timeline visualization adds the following client scripts.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roadmap Color Choice</td>
<td>Timeline Visualization</td>
<td>Sets color values for the color choice fields in the timeline visualization configuration page.</td>
</tr>
<tr>
<td>Roadmap Item Table</td>
<td>Timeline Visualization</td>
<td>Allows changing the color fields for the item_color_key whenever there is a change to the panel table.</td>
</tr>
<tr>
<td>Roadmap On Load</td>
<td>Timeline Visualization</td>
<td>Loads the personalized version of the roadmap/visualization.</td>
</tr>
<tr>
<td>Roadmap Panel Table Change</td>
<td>Timeline Visualization</td>
<td>Allows changing the field name for item_color_key whenever there is a change to the panel/visualization table.</td>
</tr>
</tbody>
</table>
Timeline visualizations roles

Timeline visualizations provides two roles.

<table>
<thead>
<tr>
<th>Role Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timeline administrator</td>
<td>Create and edit timeline visualization pages and view timeline visualizations.</td>
</tr>
<tr>
<td>Timeline user</td>
<td>View timeline visualizations. Timeline user access is also granted to users with the project_manager and project_user roles.</td>
</tr>
</tbody>
</table>

Create a Timeline Visualization

Set up timeline visualizations for the organization’s leaders by creating a timeline that provides visual representations of the organization’s operational and strategic activities.

**Before you begin**
Role required: timeline_admin

**About this task**
Additionally, create timeline visualization views to define what data appears in the summary window when a user clicks a panel on the timeline.

ℹ️ **Note:** Activating timeline visualizations doesn’t activate predefined CIO roadmap. You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.

**Procedure**
Navigate to Timeline Visualization > Create New and create a new record.
Timeline visualization configuration form

Timeline visualization configuration form field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the visualization.</td>
</tr>
</tbody>
</table>
| Panel table         | Table that provides the records displayed as lanes and panels in the timeline.  
                      | **Note:** The list shows only tables and database views that are in the same scope as the visualization.                                 |
| Relationship field  | Field on the table that contains values displayed as lane titles. Typically this field is a reference field or a field that contains a limited range of values.  
                      | **Note:** The CIO Roadmap timeline visualization is a ServiceNow customized visualization for the Project application that does not use the Relationship field. |
| Show slider         | Check box that enables (selected) or disables (cleared) displaying the timeline slider that users move to change the dates shown.              |
| Panel name          | Field from the Panel table that contains the values displayed in the panel body.                                                             |
| Panel date          | Field from the Panel table that contains the date values displayed in the panel head in 3D view and in the panel body in  |

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.  
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lane condition</td>
<td>Condition builder used to create filters and apply sorting to values that are used as lanes in 3D view visualizations. For example, if you set <code>[Name] [is not] [IT]</code> as a lane condition for the CIO Roadmap, then IT no longer appears as a lane in the roadmap, nor does it appear as a lane option in the Settings pane. Removing the filter restores the IT lane to the visualization and to lane options in the Settings pane. To order the results, specify sorting based on relevant field names. For example, to order the portfolio names so that they appear in reverse alphabetical order on the CIO Roadmap, set the sort fields to <code>[Name] [z to a]</code>.</td>
</tr>
<tr>
<td>Panel condition</td>
<td>Condition builder used to create filters and apply sorting to values that are used as panels in 2D and 3D view visualizations. For example, if you set <code>[State] [is one of] [Pending, Open, Work in Progress]</code> as the panel condition for the CIO Roadmap, only projects that are in one of those states appear on the roadmap.</td>
</tr>
</tbody>
</table>
Timeline visualization configuration color options form field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel color key</td>
<td>Field from the Panel table that contains values used for color coding the information displayed. The field selected here determines the values that are available in the Label fields on the form.</td>
</tr>
<tr>
<td></td>
<td>The CIO Roadmap uses State, which is a field in the Project table. Panels on the CIO Roadmap are color coded according to the project state, which can be Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Skipped.</td>
</tr>
<tr>
<td></td>
<td>❖ Note: You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.</td>
</tr>
<tr>
<td></td>
<td>Examples of other fields that are suitable for this selection include Priority, Risk, and Approval.</td>
</tr>
<tr>
<td>Label 1</td>
<td>Values to be color coded. The values available are determined by the Panel color key field. For example, the CIO Roadmap is based on the Project table and has the Panel color key set to the State field, which contains the values Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Closed Skipped.</td>
</tr>
<tr>
<td>Label 2</td>
<td></td>
</tr>
<tr>
<td>Label 3</td>
<td>You can set specific colors for up to four values from the selected field. Other values are shown in the Default color.</td>
</tr>
<tr>
<td>Label 4</td>
<td></td>
</tr>
<tr>
<td>Default color</td>
<td>Color applied to values that are not selected for labels. For example, the CIO Roadmap color codes and creates labels for the values Pending, Open, Work in Progress, and Closed Complete. The additional values, Closed Incomplete and Closed Skipped, use the default color.</td>
</tr>
<tr>
<td>Color 1</td>
<td>Colors that correspond to each of the Label field values. For example, if Label 1 is the Pending state, and Color 1 is red, then panels for projects in the pending state are red.</td>
</tr>
<tr>
<td>Color 2</td>
<td></td>
</tr>
<tr>
<td>Color 3</td>
<td></td>
</tr>
<tr>
<td>Color 4</td>
<td></td>
</tr>
</tbody>
</table>

Create a Timeline Visualization view

The timeline visualization view determines which record details appear in the pop-up summary window when a user clicks a panel.
About this task
You can create one timeline visualization view per table. For example, if your view shows incident records, you can create a view on the Incident table to show only certain information, such as the incident number, priority, and short description.

If no Timeline Visualization view exists, all panels use the default view that shows all the fields that currently appear on the default view of the form for that table. After you create a Timeline Visualization view for a table, all panels then use that view.

For example, to create a Timeline Visualization view using the Incident form:

Procedure
1. Navigate to Incident > All.
2. Open an incident.
3. Right-click the form header and select Configure > Form Layout.
4. Under Form view and section, go to the View name field and select New.
5. Enter timeline visualization in the View name field.
6. Click Ok to create the timeline visualization view.
7. Add fields to or remove items from the timeline visualization view using the Available and Selected columns.
8. Click Save.

Planning Your Timeline Visualization
Before creating a timeline visualization, you should have a clear idea of the information that you want to display.

This planning process helps you identify the required table and fields, and determine filtering and sorting requirements. Since users can personalize the visualization, avoid setting restrictive filters that may prevent users from finding categories that they are accustomed to seeing. You can use the CIO Roadmap as a starting point for creating your own timeline visualizations.

Note: Activating timeline visualizations doesn't activate predefined CIO roadmap. You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.
Use Timeline Visualization

Timeline Visualization provides a high-level view of an organization's strategic and operational activities over time.

Organizational decision makers can use the information in visualizations for activities such as planning future projects and estimating resource requirements. Users can personalize the information displayed with the visualization Settings pane.

Activating the Timeline Visualization application does not install the CIO Roadmap. You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap. CIO Roadmap is a timeline visualization that displays an organization's IT projects and portfolios. This following sections use the CIO Roadmap to demonstrate features of timeline visualizations.

Lanes, markers, and panels

Lanes, markers, and panels are the fundamental elements of a timeline visualization. appear in the 3D view only.

Note: Lanes and markers are available in the 3D view only. A panel in the 2D view always represents a single record, while panels in 3D view may represent one or more records.

Lanes

A lane is a channel in which activities are grouped. A visualization can display up to eight lanes at a time. While viewing a visualization, you can use the Settings pane to show or hide individual lanes.

Note: The number of items displayed in a lane depends on the Max items per lane and Max items per lane 2d settings on Timeline Visualization form.

Markers

Markers are horizontal lines that cross all lanes and identify a transition to the next month.

Panels

Panels in both 2D and 3D views are color coded according to values that the administrator selects during the initial setup.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
In 2D view, panels are grouped by month and stacked in chronological order, from the earliest date to the latest date. By default, the 2D view opens with the current month displayed on the left side of the visualization. You can print visualizations from the 2D view using the browser's print option. In 3D view, panels are grouped in lanes and ordered by date, from earliest to latest. The date that appears on the panel determines its placement in 2D and 3D view. The date displayed is based on a value the timeline administrator selects during initial setup.

Panels appear in the CIO Roadmap according to the planned completion date for the project. In 3D view, projects with the same planned date of completion are consolidated into a single panel. In 2D view, projects with the same planned date of completion are displayed as individual panels.

Panel headers in the CIO Roadmap are color coded based on project state. However, in 3D view, if a panel represents more than one project, the panel header is colored black. The Settings pane contains a key showing each available project state and the corresponding color.

**Note:** Activating timeline visualizations doesn’t activate predefined CIO roadmap. You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.

To view additional information about a panel:

- Click a panel for a single record while in 2D or 3D view to open a summary window that contains additional information. Click the heading in the summary window to open the full record.
- Press the Shift key and then click a panel to open the full record.
- Click a panel that represents multiple records to open a list of those records. Click a record number to open the full record.

The timeline administrator can configure the information that appears in summary windows.

**Personalize Timeline Visualizations**

You can configure settings for timeline visualizations like lane and panel conditions, colors, and labels.
Personalization
Open the Settings pane and click **Configure**. Complete the form as appropriate (see table).

Visualization personalization

![Visualization personalization form]

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lane conditions</td>
<td>Condition builder used to create filters and apply sorting to values that are used as lanes in 3D view visualizations. For example, if you set [Name] [is not] [IT] as a lane condition for the CIO Roadmap, then IT no longer appears as a lane in the roadmap, nor does it appear as a lane option in the Settings pane. Removing the filter restores the IT lane to the visualization and to lane options in the Settings pane. To order the results, specify sorting based on relevant field names. For example, to order the portfolio names so that they appear in reverse alphabetical order on the CIO Roadmap, set the sort fields to [Name] [z to a].</td>
</tr>
<tr>
<td>Panel conditions</td>
<td>Condition builder used to create filters and apply sorting to values that are used as panels in the visualization. For example, if you set [State] [is one of] [Pending, Open, Work in Progress] as the panel condition for the CIO Roadmap, only projects that are in one of those states appear on the roadmap.</td>
</tr>
<tr>
<td>Panel color key</td>
<td>Field from the Panel table that contains values used for color coding the information displayed. The field selected here determines the values that are available in the Label fields on the form. The CIO Roadmap uses State, which is a field in the Project table. Panels on the CIO Roadmap are color coded according to the state values.</td>
</tr>
</tbody>
</table>
**Timeline visualization personalization form (continued)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>project state, which can be Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Skipped. Examples of other fields that are suitable for this selection include Priority, Risk, and Approval.</td>
</tr>
<tr>
<td>Label 1</td>
<td>Values to be color coded. The values available are determined by the Panel color key field. For example, the CIO Roadmap is based on the Project table and has the Panel color key set to the State field, which contains the values Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Closed Skipped. You can set specific colors for up to four values from the selected field. Other values are shown in the Default color.</td>
</tr>
<tr>
<td>Label 2</td>
<td>Color applied to values that are not selected for labels. For example, the CIO Roadmap color codes and creates labels for the values Pending, Open, Work in Progress, and Closed Complete. The additional values, Closed Incomplete and Closed Skipped, use the default color.</td>
</tr>
<tr>
<td>Label 3</td>
<td>Colors that correspond to each of the Label field values. For example, if Label 1 is the Pending state, and Color 1 is red, then panels for projects in the pending state are red.</td>
</tr>
<tr>
<td>Label 4</td>
<td></td>
</tr>
<tr>
<td>Default color</td>
<td></td>
</tr>
</tbody>
</table>

**Note:**

- Activating timeline visualizations doesn't activate predefined CIO roadmap. You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.

- If the Max items per lane field is set to more than 1000, you may observe a delay when displaying the timeline data using Internet Explorer (IE) as the browser.

**The Settings pane**

Element names in the Settings pane vary based on the table and fields used to create the visualization.
The Settings pane contains the following elements:

### Settings pane elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>Identifies the type of information that is color coded on the timeline, such as state or priority. It also lists the color assigned to each possible value, such as pending state and open state.</td>
</tr>
<tr>
<td>Configure</td>
<td>Allows you to personalize a visualization by creating filters on lane information and panel information, specifying sort order for results, and reassigning panel colors. These changes affect your view of the visualization only.</td>
</tr>
<tr>
<td>View</td>
<td>Allows you to switch between 2D and 3D view.</td>
</tr>
</tbody>
</table>
Settings pane elements (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View List</td>
<td>Opens a separate browser tab showing the complete record list for the associated table.</td>
</tr>
<tr>
<td>Portfolio</td>
<td>Allows you to click lane names to add or remove them from the visualization. While the visualization is in 2D view, the Settings pane displays a Show all &lt;records&gt; button that allows you to override lane filters applied to the initial setup.</td>
</tr>
</tbody>
</table>

Use the slider and slider track

The slider and slider track are useful for quickly navigating to any point in time on a visualization.

⚠️ **Note:** Activating timeline visualizations doesn't activate predefined CIO roadmap. You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.

For the CIO Roadmap, the slider track allows you to quickly view the distribution of projects over time and determine project states. While in 3D view, click and drag the slider to move the timeline forward or backward. In 2D view, click and drag the slider track right or left to move the timeline forward or backward.

The slider track provides an alternative view of panels on a visualization. For the CIO Roadmap, a colored dot in the slider track indicates the presence of one or more projects for a given day. The different dot colors correspond to different project states. This allows you to scan the slider track to identify projects of interest by their color, and then use the slider or slider track to quickly navigate to those projects. For example, if you are interested in projects that are in a pending state, you can use the slider to navigate to the colored dots that represent that state.

⚠️ **Note:** Dots in the slider track do not correspond one-to-one with panels in a visualization. A dot represents the presence of one or more projects on a given date. In 3D view, if there is more than one project for a given day, all of the projects for that day are combined into a single panel on the roadmap. When the slider track is populated, projects in a multi project panel are analyzed for project state and then represented as appropriately colored dots in the slider track.
Similarly, you can use the slider or slider track in conjunction with the calendar to quickly navigate to any point in time. For example, if you are concerned about resource issues in April 2014 because you see a large cluster of dots during that time, dragging the slider or slider track to those dots brings those projects into view. Click the individual panels to view additional information.

**View timeline visualization**

You can view timeline visualizations from a project.

**Procedure**

1. Navigate to **Project > Projects > All**.

2. Scroll to the bottom of the list and click the **Timeline Visualization** related link. By default, the CIO Roadmap opens in three-dimensional (3D) view with the current date at the forefront of the timeline. You can use the Settings pane to change between two-dimensional (2D) and 3D view. As soon as you view a timeline visualization, it is considered personalized. After that, you see your personalized view even if the timeline administrator makes changes to the default visualization.

   **Note:** Activating timeline visualizations doesn’t activate predefined CIO roadmap. You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.

   Timeline administrators can create timeline visualizations on other tables. If you are not sure whether a timeline visualization exists for a certain application, use the application navigator to open the application of your choice, and click **All**. If a timeline visualization exists for the application's table, a Timeline Visualization related link appears.

**Work with timeline visualizations**

There are various tools that allow you to move visualizations backward and forward in time depending on whether you are in 2D or 3D view.

The following options are available for navigating between months.

**2D views**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dragging</td>
<td>Hold down the left mouse button and drag the slider track right or left to view other months.</td>
</tr>
</tbody>
</table>
### 2D views (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left and right arrow keys</td>
<td>Press the left or right arrow keys on the keyboard to move the timeline forward or backward.</td>
</tr>
<tr>
<td>Mouse wheel button</td>
<td>Scroll the wheel to move the timeline forward or backward.</td>
</tr>
<tr>
<td>Right and left navigation arrows</td>
<td>Click the arrows to move from month to month. Arrows do not appear if there are no additional months to view.</td>
</tr>
</tbody>
</table>

The following options are available for navigating stacked panels.

#### Navigating stacked panels

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dragging</td>
<td>Hold down the left mouse button and drag the stack up or down to view other panels.</td>
</tr>
<tr>
<td>Up and down navigation arrows</td>
<td>Click the arrows in a stack to view additional panels for the same month. Arrows do not appear if there are no additional panels to view.</td>
</tr>
</tbody>
</table>

The following options are available for navigating in 3D view.

#### 3D view

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dragging</td>
<td>Hold down the left mouse button and drag the slider along the slider track to move the timeline forward or backward.</td>
</tr>
<tr>
<td>Mouse wheel button</td>
<td>Scroll the wheel to move the timeline forward or backward.</td>
</tr>
<tr>
<td>Up and down arrow keys</td>
<td>Press the arrow keys to move the timeline forward or backward.</td>
</tr>
<tr>
<td>Shift key</td>
<td>Press the shift key and click the panel for a single record to open the complete record that contains additional information.</td>
</tr>
</tbody>
</table>
Visual Task Boards

Visual Task Boards (VTB) transform the navigation of lists and forms into an interactive graphical experience.

With Visual Task Boards, you can view and update multiple task records, which appear as cards that can be moved between lanes. An activity stream on the board displays recent activity so you can easily track changes to tasks. You can add task cards from any table that extends Task to intuitively and easily track updates and edit records directly from the board. Any user can use task boards, regardless of role, though access control rules (ACLs) may limit which cards each user can see. The Visual Task Board interface provides a graphic-rich environment suited for managing and collaborating on records. For example, a support manager might create a board for her team to track their assigned incidents by state in real time.

This video demonstrates how Visual Task Boards work.

Video on Visual task boards

Note: UI16 or UI15 is required to use Visual Task Boards.

Visual task boards have domain separation at the data level only. For more information, see Domain separation and Visual Task Boards.

The following podcast offers additional information on the use of Visual Task Boards.

Visual Task Boards Podcast

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Upgrade to Rome</td>
<td>• Activate Visual Task Boards</td>
<td>• Configure a task board</td>
</tr>
<tr>
<td>• Task board structure</td>
<td>• Supported browsers for Visual Task Boards</td>
<td>• Configure Visual Task Boards labels</td>
</tr>
<tr>
<td>• Domain separation and Visual Task Boards</td>
<td></td>
<td>• Configure the task board card view</td>
</tr>
<tr>
<td>• Visual Task Boards release notes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Activate Visual Task Boards

Visual Task Boards are active by default on new instances. For upgraded instances, you can activate the Visual Task Boards plugin [com.glide.ui.vtb] if you have the admin role.

Before you begin
Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the Visual Task Boards plugin (com.glide.ui.vtb) using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Domain separation and Visual Task Boards

Domain separation is supported in the Visual Task Boards application. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Basic
• Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.

• The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.

How domain separation works in Visual Task Boards

Visual Task Boards that are "data-driven" show the data from tables that are like Task tables. The data that is domain separated is also supported.

Condition-based criteria is used to filter that data. Free-form VTBs’ use Private Tasks (vtb_task), which supports domain separation as an extension of Task and inherits domain separation logic as a result.

Related information

Domain separation for service providers

Installed with Visual Task Boards

Several types of components are installed with Visual Task Boards.

Tables installed with Visual Task Boards

Tables are added with activation of Visual Task Boards.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Board Member</td>
<td>Stores a record for each member of each task board.</td>
</tr>
<tr>
<td>[vtb_board_member]</td>
<td></td>
</tr>
<tr>
<td>Private Task</td>
<td>Stores a record for each personal task on each freeform board.</td>
</tr>
<tr>
<td>[vtb_task]</td>
<td></td>
</tr>
<tr>
<td>Visual Task Board</td>
<td>Stores a record for each task board.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table Description

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[vtb_board]</td>
<td>Visual Task Board Card</td>
</tr>
<tr>
<td></td>
<td>Stores a record for each task card on each task board.</td>
</tr>
<tr>
<td>[vtb_card]</td>
<td>Visual Task Board Card History</td>
</tr>
<tr>
<td></td>
<td>Stores records for certain task card changes, such as lane or assignee changes. Each record indicates the previous value and the new value.</td>
</tr>
<tr>
<td>[vtb_card_history]</td>
<td>Visual Task Board Lane</td>
</tr>
<tr>
<td></td>
<td>Stores a record for each lane on each task board.</td>
</tr>
</tbody>
</table>

### Properties installed with Visual Task Boards

Properties are added with activation of Visual Task Boards.

**Note:** To open the System Property [sys_properties] table, enter `sys_properties.list` in the navigation filter.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>vtb.board.upload_limit</td>
<td>Sets the maximum file size in megabytes allowed for each task card attachment.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 10</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> System Property [sys_properties] table</td>
</tr>
</tbody>
</table>

### Script includes installed with Visual Task Boards

Script includes are added with activation of Visual Task Boards.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VisualTaskBoards</td>
<td>Provides general utilities for Visual Task Boards.</td>
</tr>
<tr>
<td>VTBBoardSecurity</td>
<td>Provides security utilities to control board access.</td>
</tr>
<tr>
<td>Script Include</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VTBGetBoardsByUser</td>
<td>Provides a method that retrieves all the boards a specified user owns or is a member of.</td>
</tr>
<tr>
<td>VTBTaskSecurity</td>
<td>Provides security utilities to control task access.</td>
</tr>
</tbody>
</table>

### Client scripts installed with Visual Task Boards

Client scripts are added with activation of Visual Task Boards.

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Kanban Choice</td>
<td>Visual Task Board [vtb_board]</td>
<td>Adds the <strong>Kanban Board</strong> option to the <strong>Lane field</strong> field. This option indicates that the task board is a flexible board.</td>
</tr>
</tbody>
</table>

### Business rules installed with Visual Task Boards

Business rules are added with activation of Visual Task Boards.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add members to live group</td>
<td>Board Member [vtb_board_member]</td>
<td>If a Connect Chat conversation is created for a task board, this business rule adds the board members as conversation members.</td>
</tr>
<tr>
<td>Remove member from live group</td>
<td>Board Member [vtb_board_member]</td>
<td>If a Connect Chat conversation exists for a task board and a user is removed from the board members, this business rule removes the user from the conversation members.</td>
</tr>
<tr>
<td>Remove member from VTB</td>
<td>Live Group Member [live_group_member]</td>
<td>If a Connect Chat conversation exists for a task board and a user is removed from the conversation members, this business rule removes the user from the task board members.</td>
</tr>
<tr>
<td>Sync board name to Connect</td>
<td>Visual Task Board [vtb_board]</td>
<td>If a Connect Chat conversation exists for a task board and someone updates the board name, this business rule updates the conversation name.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sync chat name to VTB board</td>
<td>Live Group Profile [live_group_profile]</td>
<td>If a Connect Chat conversation exists for a task board and someone updates the conversation name, this business rule updates the board name.</td>
</tr>
<tr>
<td>Sync Members With VTB</td>
<td>Live Group Member [live_group_member]</td>
<td>If a Connect Chat conversation exists for a task board and a user is added to the conversation members, this business rule adds the user as a board member.</td>
</tr>
<tr>
<td>Update Board on Card Change</td>
<td>Visual Task Board Card [vtb_card]</td>
<td>Triggers the system to update the task board when changes occur to the cards.</td>
</tr>
<tr>
<td>Update Board on Lane Change</td>
<td>Visual Task Board Lane [vtb_lane]</td>
<td>Triggers the system to update the task board when changes occur to the lanes.</td>
</tr>
<tr>
<td>update board on lane change</td>
<td>Board Member [vtb_board_member]</td>
<td>Triggers the system to update the task board when changes occur to the board members.</td>
</tr>
<tr>
<td>VTB Previous Additional Assignees</td>
<td>Private Task [vtb_task]</td>
<td>Triggers the system to send an email notification to users when they are designated as additional assignees for cards.</td>
</tr>
</tbody>
</table>

**Related information**

**Connect Chat**

**Notifications installed with Visual Task Boards**

Notifications are added with activation of Visual Task Boards.

<table>
<thead>
<tr>
<th>Notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VTB member addition notification</td>
<td>Sends an email notification to the member about their addition to the board.</td>
</tr>
<tr>
<td>Notification</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VTB member deletion notification</td>
<td>Sends an email notification to the member about their removal from the board.</td>
</tr>
<tr>
<td>VTB additional assignee notification</td>
<td>Sends an email notification to users when they are designated as additional assignees for tasks.</td>
</tr>
<tr>
<td>VTB assignee notification</td>
<td>Sends an email notification to users when they are designated as the primary assignees for personal tasks.</td>
</tr>
<tr>
<td>VTB lane change notification</td>
<td>Sends an email notification to a task’s assignees when the task changes lanes.</td>
</tr>
<tr>
<td>VTB lane limit reached</td>
<td>Sends an email notification to the board member that the number of tasks in the lane has reached the set lane limit.</td>
</tr>
<tr>
<td>VTB lane limit exceeded</td>
<td>Sends an email notification to the board member that the number of tasks in the lane has exceeded the set lane limit.</td>
</tr>
<tr>
<td>VTB card movement across vertical lanes and swimlanes</td>
<td>Sends an email notification to the board member with the details of the card moved and the member who moved the card.</td>
</tr>
</tbody>
</table>

**Supported browsers for Visual Task Boards**

The system supports Visual Task Boards on most modern browsers.

**Supported browsers**

- The latest public release of Firefox or Firefox ESR
- The latest public release of Chrome
- Safari version 12
- Internet Explorer version 11
  - Edge mode is supported.
  - Compatibility mode is not supported.
  - Setting Security Mode to High (via the **Internet Options > Security** tab) is not supported.
Internet Explorer 11 is susceptible to memory leaks, which may impact performance, especially in Windows 7.

**Note:** VTB loading is comparatively slower on Internet Explorer 11 browsers.

The recommended limit to include various elements to the board while working on Internet Explorer and Edge browsers is as follows:

<table>
<thead>
<tr>
<th>Browser</th>
<th>Scenario</th>
<th>Recommended Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Cards</td>
</tr>
<tr>
<td>IE</td>
<td>Without Swimlane</td>
<td>500</td>
</tr>
<tr>
<td></td>
<td>With Swimlane</td>
<td>500</td>
</tr>
<tr>
<td>Edge</td>
<td>Without Swimlane</td>
<td>1000</td>
</tr>
<tr>
<td></td>
<td>With Swimlane</td>
<td>1000</td>
</tr>
</tbody>
</table>

- Access Visual Task Boards on your mobile device using either a browser or the native mobile app. See supported devices for more information.

**Scripting support**

Visual task boards do not interact with client scripts. Use a UI policy or a data policy instead.

**Task board structure**

Different types of task boards work for different kinds of task management. However, all board types share the same overall structure.

<table>
<thead>
<tr>
<th>Task board types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Board type</td>
</tr>
<tr>
<td>Freeform boards</td>
</tr>
</tbody>
</table>
Task board types (continued)

<table>
<thead>
<tr>
<th>Board type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flexible boards</td>
<td>Display tasks that match a filter against a particular table. Members of flexible boards can add task cards. Cards are removed automatically when the tasks no longer match the filter conditions. Members can define custom lanes, similar to a freeform board.</td>
</tr>
<tr>
<td>Guided boards</td>
<td>Similar to flexible boards except that guided board lanes correspond to field values and cannot be edited in most cases.</td>
</tr>
</tbody>
</table>

You can identify the task board type by the icon beside the board name.

- The freeform board icon: ( )
- Flexible board icon: ( )
- Guided boards icon: ( )

Sample Visual Task Board dashboard

All boards have the displayed elements. The color of the left boundary of a card represents the color you choose in the color palette for that board.

Task board elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick panel</td>
<td>Displays labels and users associated with the board. Board members can</td>
</tr>
</tbody>
</table>
### Task board elements (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>use the quick panel to quickly label or assign tasks. Members can also</td>
</tr>
<tr>
<td></td>
<td><strong>configure</strong> what appears in the quick panel.</td>
</tr>
<tr>
<td>Lanes</td>
<td>Organize cards on a board into vertical groups. These groups often</td>
</tr>
<tr>
<td></td>
<td>represent the status of the task, such as <strong>To Do</strong>, <strong>Doing</strong>, and <strong>Done</strong>.</td>
</tr>
<tr>
<td></td>
<td>When using a guided board, each lane represents a possible field value.</td>
</tr>
<tr>
<td></td>
<td>For example, a board on the Incident table can display one lane for each</td>
</tr>
<tr>
<td></td>
<td><strong>State</strong> value such as <strong>New</strong>, <strong>Active</strong>, or <strong>Resolved</strong>.</td>
</tr>
<tr>
<td></td>
<td>Users can move cards from one lane to another to update the task that card</td>
</tr>
<tr>
<td></td>
<td>represents.</td>
</tr>
<tr>
<td>Cards</td>
<td>Represent individual tasks that you can assign to users. You can add</td>
</tr>
<tr>
<td></td>
<td>comments, attachments, and labels to cards. Each card is tied to a task</td>
</tr>
<tr>
<td></td>
<td>record; updating one immediately updates the other. For freeform boards,</td>
</tr>
<tr>
<td></td>
<td>each card represents a personal task.</td>
</tr>
<tr>
<td></td>
<td>For flexible and guided boards, each card represents a record from the</td>
</tr>
<tr>
<td></td>
<td>list that board was created from. For more information, see **Create</td>
</tr>
<tr>
<td></td>
<td>Flexible and Guided boards**.</td>
</tr>
<tr>
<td>Task board tools</td>
<td>Displays board information, board members, the board activity stream, and</td>
</tr>
<tr>
<td></td>
<td>board labels.</td>
</tr>
<tr>
<td>Board header</td>
<td>Displays the board name in the title bar. You can rename the board by</td>
</tr>
<tr>
<td></td>
<td>double-clicking on the board name. Filter the tasks in the board by:</td>
</tr>
</tbody>
</table>
Task board elements (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>• Entering the title or number of the task card</td>
</tr>
<tr>
<td>Due By</td>
<td>• Selecting an option in the <strong>Due By</strong> list</td>
</tr>
<tr>
<td>Swimlanes</td>
<td>Organize cards on a board into horizontal lanes. These lanes often represent the user assigned to a task. You can add any number of swimlanes to the board, and move cards from one user to another easily.</td>
</tr>
</tbody>
</table>

Sample Visual Task Board elements

Visual Task Board use

Any user can create, view, and edit freeform, flexible, and guided visual task boards, and add users to these boards as members.

You can create a freeform board and add cards from multiple task tables, or create a flexible or guided board from an existing list of records.
Create a freeform board

You can create freeform Visual Task Boards (VTBs) for tracking any kind of task or project.

Before you begin
Role required: none

Procedure
2. Next to My Task Boards, click New, or if you have never created a task board before click Create New Visual Task Board.
3. From the Create New Board window, click Freeform.
   A new task board opens with the default freeform lanes, To Do, Doing, and Done.
4. Click the board name and enter a new name.

What to do next
After the board is created, board members can:
- Add and modify lanes
- Create and modify task cards
- Add and remove members
- Configure the look and feel

Create a data driven board

You can create a flexible or guided data driven Visual Task Board (VTB) for any table that extends Task, such as Incident or Change.

Before you begin
Role required: none

About this task

Procedure
2. Next to My Task Boards, click New, or if you have never created a task board before click Create New Visual Task Board.
3. From the Create New Board window, click Data Driven Board.
4. From the Task Table list, select a base table of tasks on which to base your board, for example, an incident table.

5. Optional: From the Lane Field list, select the field you want to use for the lane headers. Create a Flexible board with editable lane headers by selecting None.
   The type of board that is created and the lanes that appear on the board depend on which type of column you select. If you select a reference or choice column, the board is a guided board. Each lane in a guided board represents one possible value for that column and the cards appear in the appropriate lane. For example, if you create a guided task board for incidents using the State column, the board shows one lane for each incident state, such as New or Closed. If you select a column that is not a reference or choice, the board is a flexible board and the board shows the default lanes, To Do, Doing, and Done, with all cards in the To Do lane.

6. Optional: Create a filter to show only the records you want to work with. For example, you might filter out incidents that are not assigned to you.
   (Optional) Any card that no longer fits the parameters of the filter is automatically removed from the task board.

7. Optional: Click the board name and enter a new name.

   Note: For guided boards created from choice fields, such as State, the system creates a lane for each possible choice value. For guided boards created from reference fields, the system creates a lane only for each value in use by a task card. Lanes are added as needed if the reference field values change.

What to do next
After the board is created, board members can:

• Add and modify lanes
• Create and modify task cards
• Add and remove members
• Configure the look and feel

Delete a task board
You can delete any task board you own.

Before you begin
Role required: none
About this task
Deleting a board does not impact the underlying task records. However, you cannot recover a board after you delete it.

Procedure
2. Under Boards you own, point to a board and click the delete icon (X).
3. In the confirmation dialog, click Delete.

Add or modify task board lanes
Any board member can change the names and add new lanes to accommodate the task workflow you want to track. When you create a freeform or flexible task board, it includes the default lanes To Do, Doing, and Done.

Before you begin
Role required: none

About this task
Unlike guided boards, the lanes on a freeform or flexible task board do not match possible field values.

Note: You cannot remove lanes from guided boards.

Procedure
1. Open a task board.
2. Perform any of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new lane</td>
<td>a. Scroll past the last lane and click Add Lane.</td>
</tr>
<tr>
<td></td>
<td>b. Enter a title for the lane, then press the Enter key.</td>
</tr>
<tr>
<td></td>
<td>The Add Lane option is always available for freeform and flexible boards.</td>
</tr>
<tr>
<td></td>
<td>It is available for guided boards only if the lanes are based on a reference</td>
</tr>
<tr>
<td></td>
<td>field, such as Assigned to.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rearrange lanes</td>
<td>Click a lane header and drag the lane to the desired drop zone. To cancel the move, press the Escape key while you drag the lane. You can also change the lane order from the board configuration menu.</td>
</tr>
<tr>
<td>Hide a lane</td>
<td>a. Click the lane menu (3) in a lane header.</td>
</tr>
<tr>
<td></td>
<td>b. Select Hide Lane. You can restore hidden lanes from the board configuration menu.</td>
</tr>
<tr>
<td>Delete a lane</td>
<td>a. Click the lane menu in a lane header.</td>
</tr>
<tr>
<td></td>
<td>b. Select Delete Lane.</td>
</tr>
<tr>
<td></td>
<td>c. In the confirmation dialog box, click Delete. When you delete a lane on a freeform or flexible board, all the cards in the deleted lane are archived.</td>
</tr>
<tr>
<td></td>
<td>The Delete Lane option is always available for freeform and flexible boards. It is available for guided boards only if the lanes are based on a reference field, and only for lanes that contain no cards.</td>
</tr>
<tr>
<td>Exclude Child Table Records</td>
<td>a. Click Info icon (i)</td>
</tr>
<tr>
<td></td>
<td>b. Under Structure menu, select Exclude Child Table Records</td>
</tr>
</tbody>
</table>
### Task cards

Visual Task Board task cards can represent a personal task or a record on a table.

You can add task cards, edit task card details, add labels to cards, and access the underlying task record the card represents, depending on the board type.

**Note:** Each board can display up to 1,000 cards by default. When the number of tasks exceeds the maximum, a warning appears and the system determines which cards to show by most recent update time. Administrators can configure a different maximum card limit for task boards.

### Freeform board tasks

You can add personal task cards directly to lanes on a freeform board. You can also add other kinds of task cards to a freeform board from a list or form.

#### Add a personal task to a freeform board

You can add cards directly to a freeform board lane. These cards are called personal tasks and represent records on the Private Task [vtb_task] table.

### Before you begin

Role required: none
Procedure

1. In a lane header, click the lane menu (Ξ) and select **Add Task**. Alternatively, click **Add Task** at the bottom of a lane. A new task card appears in the lane.
2. Enter a short description for the new task card.
3. To save the card, click another area of the board or press **Enter**.

**Add a task to a freeform board from a form**

You can add a task card to a freeform board from any table that extends Task. These cards represent records on whichever table you add them from.

**Before you begin**
Role required: none

**About this task**
You can add cards from multiple task tables, such as Incident or Problem, to the same freeform board.

**Procedure**

1. Open a task record, such as an incident.
2. Click the menu icon (Ξ) or right-click the form header to show the form context menu.
3. Select **Add to Visual Task Board**. A pop-up window appears with a list of freeform task boards.

4. Click the name of the board you want to add the card to. A confirmation message appears.
5. To view the board, click the board name in the confirmation message. The task appears in the first lane by default.
Add a task to a freeform board from a list

You can add a task card to a freeform board from any table that extends Task. These cards represent records on whichever table you add them from.

Before you begin
Role required: none

About this task
You can add cards from multiple task tables, such as Incident or Problem, to the same freeform board.

Procedure
1. Navigate to a list of task records, such as Incident > Open.
2. Perform either of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add one task</td>
<td>Right-click a record and select Add to Visual Task Board</td>
</tr>
<tr>
<td>Add multiple tasks</td>
<td>Select the check box beside each record you want to add and select Add to Visual Task Board from the actions choice list</td>
</tr>
</tbody>
</table>

A pop-up window appears with a list of freeform task boards.

3. Click the name of the board you want to add the card to.
   A confirmation message appears.

4. To view the board, click the board name in the confirmation message.
   The task appears in the first lane by default.

Data driven board tasks
You can add a task to a flexible or guided task board.
Add a task to a flexible or guided board

Cards in a flexible or guided board represent records on whichever table the board is associated with.

Before you begin
Role required: none

Procedure

1. In a lane header, click the lane menu (…) and select Add Task. Alternatively, click Add Task at the bottom of a lane.

   A pop-up window appears with a new record. Fields are populated based on any filter conditions for the board and, for guided boards, the lane you add the card to.

   Consider the example of a guided board that shows incidents with the Software category, with a lane for each assignee. If you add a card to the ITIL User lane, the new incident record Category and Assigned to fields are automatically set to Software and ITIL User.

2. Complete the form and click Submit.
   A new task card appears in the lane.

Edit task board card details

Edit the details of the card if you need to assign tasks, add comments, change the due date, or change other features of the card.

Before you begin
Role required: none

About this task

You can edit various card details. Updating these values also updates the underlying task record.
Procedure

1. Open the task board from the My Task Boards dashboard.

2. Click a card on the board.
   The details for the card appear in a pop-up window.

3. Modify the card details.
   Possible modification actions include:
   • Rename the card by clicking the card title and providing the new name.
   • Modify the short description.
   • Add comments or work notes in the activity stream.
   • Edit the users assigned to tasks.
   • Add a label to the card by selecting one or more of the available labels.
   • Add or edit the Due Date. If the completion of a task exceeds the due date, the date appears in red.
• Add or remove file attachments.
• Archive the card (freeform boards only). Once archived, the card is not visible in active items.
• Move the card to a different board (freeform boards only).

Add an attachment to a task card
You can add an attachment to a record within a task board.

Before you begin
Role required: none

About this task
Adding an attachment to a task card also adds the attachment to the underlying task record.
Procedure
1. Click a card.

2. Click the attachment tab (_attachment_icon_).

3. Click **Add Attachment** and select a file to add as an attachment.

**Label a task card**
Labels help categorize tasks and visually distinguish them on the task board.

**Before you begin**
**Enable** labels for the board.

**Role required:** none

**About this task**
You can filter the visible tasks to show only those with certain labels. Labels appear on cards as colored dots.

**Task card labels**

My desk phone does not work

 Labels

INC0000041

a day ago

You can add one or more labels to a task card.

**Procedure**
Do one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Add a label to a card from the quick panel** | a. Drag a label from the quick panel directly to a task card.  
b. Drop the label in the drop zone. |
| **Add a label to a card from the card details** | a. Open the card details for a task.  
b. Click the details tab (details_icon). |
### Option Description

c. Under **Labels**, select one or more labels. Point to a label to display its name.

d. Close the card detail pop-up window.

---

**What to do next**

You can use configuration options to rename or disable labels or to hide labels altogether.

**Assign a task card to a user**

Assignees represent ownership of task cards and the associated records. Each task card can have one primary assignee and multiple additional assignees.

**About this task**

You can filter the visible tasks on a board to show only tasks assigned to a certain user. Assignees appear on cards as avatars.

---

#### Task card assignees

<table>
<thead>
<tr>
<th>PRIMARY</th>
<th>ITIL User</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADDITIONAL</td>
<td>Add Additional Assignee</td>
</tr>
<tr>
<td>David Loo</td>
<td>Assignee</td>
</tr>
<tr>
<td>Bow Ruggeri</td>
<td>Assignee</td>
</tr>
</tbody>
</table>
When a card changes lanes, all the assignees receive an email notification.

For flexible and guided boards, the primary assignee corresponds to the underlying task’s **Assigned to** field. For example, on a board created from the Incident table, if you add Joe Employee as the primary assignee for a card, the associated incident is assigned to Joe. Note that assignment rules on the associated table may restrict who you can make the primary assignee of a card. If you attempt to assign a task card to a user in a way that violates an assignment rule, a notification appears and the assignment does not take place.

**Note:** Assignees are not automatically granted access to the board. Only members can access the board.

**Procedure**

Do one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add an assignee from the quick panel</td>
<td>a. Drag a user’s avatar from the quick panel directly to the task card.</td>
</tr>
<tr>
<td></td>
<td>b. Drop the avatar in the <strong>Primary</strong> or <strong>Additional</strong> drop zone.</td>
</tr>
<tr>
<td>Add an assignee from the card details</td>
<td>a. Open the card details for a task.</td>
</tr>
<tr>
<td></td>
<td>b. Click the assignees tab ( ).</td>
</tr>
<tr>
<td></td>
<td>c. Click <strong>Add Primary Assignee</strong> or <strong>Add Additional Assignee</strong>. The <strong>Add Primary Assignee</strong> option is not available if there is already a primary assignee.</td>
</tr>
<tr>
<td></td>
<td>d. Select a user.</td>
</tr>
<tr>
<td></td>
<td>e. Close the card detail pop-up window.</td>
</tr>
</tbody>
</table>

The system sends an email notification to inform the new assignee of the change.

**Visual Task Board checklists**

Checklists help you track the progress of tasks on your Visual Task Board. Checklists are available as a tab in the card details.
You can add, remove, or rearrange checklist items. You can also save a checklist as a template for future use on other cards. Any user can create or edit a checklist. When the compact card view is disabled, the task card displays a progress bar to show how many items are complete.
You can also use checklists with task records in the standard interface. For more information, see.

Create a checklist for a card
You can create a unique checklist for each Visual Task Board card or create a task from a checklist item.

Before you begin
Role required: none

Procedure
1. Open the card details for a task.
2. Click the checklist tab (✓).
3. Click Add Item.
4. Enter text for the checklist item.
5. Press the Enter key to add the checklist item.
6. Create as many additional checklist items as desired.
7. To delete a checklist item, click the minus (-) icon.
8. To reorder checklist items, click the drag icon (_drag_ ) and drag a checklist item to a different position in the list.
9. To create a task from a checklist item:
   a. Point to a checklist item and click the create task icon (create).
   b. Select the type of task you want to create. An administrator can configure which task types are available. The new task record appears in a pop-up window. The short description is automatically populated with the checklist item text.
   c. Fill in the form with additional detail as necessary.
   d. Click Update.

Create checklist template
A template saves time by creating checklist items automatically. You can add, edit, or remove checklist items without impacting the template.
Before you begin
Role required: none
See Activate Visual Task Boards

Procedure
1. Open the card details for a task.
2. Click the checklist tab (✓).
3. Add items to the checklist that you want to save as part of the template.
4. Click the more icon (ameleon).
   The more icon does not display unless you have added an item to the checklist, or if you have a pre-existing checklist template.
5. Select Save as Template.
6. In the dialog box, enter a descriptive template name to identify the checklist. When a user creates a checklist from a template, all templates are listed in alphabetical order and there is no way to filter which templates appear. To provide a better user experience, consider implementing a naming system for checklist templates. For example, include the name of the table or another identifier to clarify how the checklist should be used.
7. Click Save.

What to do next
Create a checklist from a checklist template by selecting the template from the more icon.

Delete a checklist from a card
You can remove a checklist from a Visual Task Board card.

Before you begin
Role required: none

Procedure
1. Open a task card that contains a checklist.
2. Click the checklist tab (✓).
3. Click the more icon (ameleon).
4. Select Remove Checklist.
   A confirmation dialog box appears.
5. Click Delete.
Configure which types of tasks can be created from checklist items

A system property controls which types of tasks you can create from a Visual Task Board checklist item.

Before you begin
Role required: admin

About this task
You might want to add custom tables or remove tables you do not use.

Procedure
1. Navigate to `sys_properties.list`.
2. Locate the `glide.ui.create_task_type_option_list` property.
3. Edit the Value to add or remove tables.
   You can add any table that extends Task [task]. Use the table name, not the label. For example, you would enter `change_request`, not Change Request. Ensure the tables listed are separated by commas, with no spaces.
   The property value populates the task type selection list users choose from when they create a task from a checklist item. Note that users can only see task types for which they have the appropriate access roles.

Archive a card

Archiving a card is a non-destructive way to remove a card from a freeform board. You can archive cards you are no longer working on to reduce visual clutter.

Before you begin
Role required: none
About this task

ℹ️ Note: You can only archive cards on a freeform board.

Procedure
Perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Archive one card from the lane view | 1. Point to a card and click the X icon that appears in the corner.  
2. In the confirmation dialog, click Archive. |
| Archive one card from the card details | 1. Click a card and view the Details tab.  
2. Under Tools, click Archive.  
3. In the confirmation dialog, click Confirm. |
| Archive all the cards in a lane | 1. In the lane header, click the more options icon (⋮).  
2. Select Archive All Tasks.  
3. In the confirmation dialog, click Archive. |

What to do next

• To see all archived cards for the current board, from the board navigation panel, open the board information menu (⋮) and click View Archived Tasks.

• To restore an archived card, point to it and click Restore.

Access a task record from a VTB card

You can open the form view of any task card. Viewing a task record on a form allows you to see all fields for that record, including fields that are not visible in the card details.

Before you begin

Role required: none
Access a task record using one of the following options.
Procedure

• Access the record from the task card by clicking the record number on the task card.

• Access the record from the card details by doing the following:
  1. Open the card details for a task.
  2. Click the record number in the header.

Move a card to a different lane
You can move a card from one lane to another.

Before you begin
Role required: none

About this task
When you move a card to a different lane on a guided board, the field on which the lanes are based is updated to reflect the new lane value.

Procedure

1. Open a Visual Task Board.
2. Select a card and drag it to a different lane.
   To cancel the move, press the Escape key while you drag the card.

   Note: All mandatory fields on a record must be filled in to move the associated card to a new lane. For example, assume you have a guided board based on the Incident [incident] table, with a lane for each State. The Close code and Close notes fields become mandatory when the State changes to Closed. If you attempt to move an incident card from the New lane to the Closed lane, a pop-up view of the form appears and prompts you to fill in the mandatory fields.

Move a card to a different board
You can move a card from one freeform board to another.

Procedure

1. Open the card details.
2. In the details tab ( ), click Move Card.
3. In the pop-up window that appears, select the board and lane to move the card to. The board selection list displays freeform boards only.

**Task board tools**

The task board tools area in a Visual Task Board contains several tabs, each represented by an icon.

Click an icon to open the tab. Click the same icon again to hide the tab. The tabs you see for each conversation depend on the conversation type and other conditions.

**Conversation tool tabs**

<table>
<thead>
<tr>
<th>Tab icon</th>
<th>Tab name</th>
<th>Description</th>
</tr>
</thead>
</table>
| 📘       | Info     | Contains the following information about the task board:  
            • Board Name  
            • Board type  
            • Board Owner  
            • Number of members  
            • Number of assignees  
            • Number of lanes  
            • Number of tasks  
            • Table name  
            • Filter conditions (visible on data driven boards only)  
            • Lane field (visible to the board owner, on data driven boards only)  
            • Swimlane field - To change Swimlane field for the board  
            • Due Date field - To change the Due Date field for the board.  
            • URL |
| 🧑‍💻    | Members  | Lists all members and assignees of the board. You can add or remove board members, promote assignees |
### Conversation tool tabs (continued)

<table>
<thead>
<tr>
<th>Tab icon</th>
<th>Tab name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Labels icon" /></td>
<td>Labels</td>
<td>Use labels to visually distinguish tasks on the task board. Filter board contents by toggling the label. You need to enable labels before being able to use this tab.</td>
</tr>
<tr>
<td><img src="image" alt="Activity icon" /></td>
<td>Activity</td>
<td>Displays all of the activity for cards on the board.</td>
</tr>
<tr>
<td><img src="image" alt="Configuration icon" /></td>
<td>Configuration</td>
<td>Configure the settings for the task board. This setting is only available for the board owner. For more information, see <a href="#">Configure a task board</a></td>
</tr>
</tbody>
</table>

### View board information

You can display key information about any task board.

**Before you begin**

Role required: none
About this task
Procedure
1. Open a task board.

2. Click the board information icon (i).

Add a board as a favorite
Add boards you access frequently to the application navigator using the favorite option.

Before you begin
Role required: none

About this task
Adding a board as a favorite is only available in UI16.

Procedure
1. Navigate to Self Service > Visual Task Boards.

2. From the board you want to favorite, select the information icon from the board tools. Then select the star.
3. Remove the board as a favorite by clearing the star icon.

**View a task board in a list**

You can view a task board in the list view using the board information option.

**Before you begin**
Role required: none

**Procedure**
1. Open a task board.
2. From the task board tools, click the board information icon (.setImageResource).
3. Click **View List** at the bottom of the information panel.
   The cards from the board open in the list view.

  **Note:** The freeform board list view only shows cards made by the board and no other tasks that might be added manually.
Add or remove a task board member

You can add and remove task board members using the members tab of the activity stream. You can also promote assignees to board members.

Before you begin
Role required: none

About this task
Only members of a task board can access the board. Any board member can add or remove other members.

Procedure
1. On a Visual Task Board, open the task board tools.
2. Click the members tab.
3. Perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a member</td>
<td>a. In the Users section, click Add Members.</td>
</tr>
<tr>
<td></td>
<td>b. Enter a user's name or select a user from the drop-down menu.</td>
</tr>
<tr>
<td>Remove a member</td>
<td>a. In the Members section, point to a user.</td>
</tr>
<tr>
<td></td>
<td>b. Click the remove icon (🗑️).</td>
</tr>
<tr>
<td>Promote an assignee to a member</td>
<td>a. In the Assignees section, point to a user.</td>
</tr>
<tr>
<td></td>
<td>b. Click the upward arrow icon.</td>
</tr>
<tr>
<td>Promote all assignees to members</td>
<td>In the Assignees section, click Promote All.</td>
</tr>
</tbody>
</table>
Visual Task Board SLA indicators

SLA (service level agreement) indicators alert board members if any cards on the board have breached SLAs.

When SLA indicators are enabled, a status bar appears on each card that has an associated SLA. If any cards have breached SLAs, an alert appears at the top of the board and a filter option appears in the quick panel. The indicator displays the elapsed percentage of the SLA. If there are multiple SLAs associated with a task card, the indicator displays the status of the SLA with the greatest elapsed percentage.

Any board member can enable SLA indicators from the board configuration menu. The setting applies to the current user only.

Related information
Share a Visual Task Board in a Connect conversation

You can share a Visual Task Board in a Connect Chat or Connect Support conversation.

Before you begin
Role required: none

Procedure
2. Drag a task board to a Connect mini window.
   A link to the task board appears in the conversation. The task board is also listed in the conversation tools, which are visible in the Connect workspace. Only conversation members who are members of the board can access it.
   If you share a task board in a record conversation, it appears as a URL in the record activity stream.

Related information
   Connect
   Visual Task Boards

Create a Connect conversation from a Visual Task Board

Create a Connect Chat conversation from a Visual Task Board to collaborate with board members and keep track of activity as it happens.

Before you begin
Role required: none

About this task
When you create a conversation from a task board, all the board members become members of the conversation. The members are synchronized between the task board and the conversation. For example, if you remove a user from the conversation, the system automatically removes the user from the board as well.

Procedure
2. Open a task board.
3. In the board header, click the connect with board members icon (🔗).
   The system automatically opens a record conversation for the board. Each board member becomes a member of the conversation.
Related information

Connect Chat
Visual Task Boards

Visual Task Board accessibility

Several accessibility improvements are included in Visual Task Boards.

Skip links

Skip links allow you to tab directly to the main content on a page. When accessibility mode is enabled, task boards include a skip link to view tasks as a list. The View tasks as a list skip link switches all the task cards to the table view. For more information on viewing task boards in a list view, see View card details in a task board.

View card details

With accessibility mode enabled, visual indicators appear on task cards that users can tab to in order to open card details. For more information, see View card details in a task board.

View card details in a task board

With accessibility mode enabled, tab through cards in a task board. Use the card details button to view task card details.

Before you begin

Enable accessibility from the General tab of the system settings menu.
Role required: none

Procedure

2. Open an existing task board.
3. Press the Tab key to navigate through the board to get to a task card.
4. Press the Tab key to navigate through the card until the Open Card Details button appears.
5. Press **Enter** to open the card.

6. To exit the card, press **Escape**.

**Configure a task board**

You can configure several options in the Visual Task Boards to customize the look and feel of the board.

**Before you begin**

Role required: none

**Procedure**

1. From the task board tools, click the menu icon (.Excel).

2. Click **Advanced Settings**.

3. In the **Theme** section, select a color from the palette.
   The selected theme is applied to the background of the board, lane header, add card button, quick filter, tab header, quick panel, and board header.
   It also appears as the color for the board on the My Task Boards page. This setting applies only to the boards of the user.
4. In the Quick Panel section, toggle the options to customize the quick panel.

**Note:** Unless otherwise noted, these settings apply to the current user only.

### Quick panel options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Panel</td>
<td>Option for making visible on the board.</td>
</tr>
<tr>
<td>User Names</td>
<td>User names that appear next to user avatars in the quick panel.</td>
</tr>
<tr>
<td>Show Labels</td>
<td>Labels that appear on cards and in the quick panel.</td>
</tr>
</tbody>
</table>

**Note:** The setting applies to all users.
### Option Description

<table>
<thead>
<tr>
<th>Label Names</th>
<th>Label name that appears beside the colored icon for that label in the quick panel.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Note:</strong> This setting is available only when you enable Show Labels.</td>
</tr>
</tbody>
</table>

When all the options are enabled, a quick panel looks like the following illustration.

![Quick Panel Illustration](image)

5. In the Configure Cards section, toggle the options to customize the appearance and information of cards.

Changes to the cards apply to the current user only.

<table>
<thead>
<tr>
<th>View options</th>
<th>Option</th>
<th>Description</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Compact Cards</td>
<td>Decreases the lane width and card information. Thumbnail images do not appear on the card.</td>
<td>This setting is available only when Compact Cards is disabled.</td>
</tr>
<tr>
<td></td>
<td>Show Card Info</td>
<td>Displays card information on each card. Card information typically includes details like the task state, date opened, and last user to update it.</td>
<td>This setting is available only when Compact Cards is disabled.</td>
</tr>
<tr>
<td></td>
<td>Show Card Attachment</td>
<td>Cards display the first image attached to that card as a thumbnail.</td>
<td>This setting is available only when Compact Cards is disabled.</td>
</tr>
<tr>
<td></td>
<td>Show SLAs</td>
<td>SLA status indicators appear on cards and alerts appear when one or more card has a breached SLA. SLA status indicators are hidden when Compact Cards is enabled.</td>
<td>This setting is available only when SLAs are associated with the tasks on the board.</td>
</tr>
</tbody>
</table>

6. Under Advanced Settings, in the Lane Configuration section, show or hide lanes by selecting or clearing the check box for each lane. This setting is a user preference.
Sort Visual Task Boards

You can sort Visual Task Boards using criteria that you create with a Sort-Filter option, grouping items by properties to help organize your cards.

About this task

Only the owner of the board can create the sorting criteria, and add, edit, or delete the criteria. The criteria appear as “read-only” for other users.

Note: The procedure is slightly different for Data Driven and Freeform boards. The instructions below contain both options.

Procedure

1. For a Data Driven board: In the left pane of your instance, navigate to Visual Task Boards > My Task Boards > New.
2. From the Create New Board window, select Data Driven Board.
3. Fill out the fields with your choices and then select Next.
4. Select Add sort, choose the conditions you want from the fields and then select Create.

5. In the Add Sort window, choose your sorting order and then select Save.

Your criteria displays. You can edit your sort order here, or add new criteria. You can also edit your choices in the navigation pane on the right.
6. For a **Freeform Board**: From the Create New Board window select **Freeform Board**.

7. Make your selections and then select **Save**.

8. The sorting criteria and filtering appear in the right navigation pane.

You can edit your sorting criteria for both Freeform and Data Driven boards by selecting the **Edit Filter and Sort** button.

## Configure Visual Task Boards labels

Labels help categorize tasks and visually distinguish them on the task board. You can disable or rename labels using the labels tab of the activity stream.

**Before you begin**

Role required: tags_admin and global_tags_creator

**About this task**

Every board has seven labels by default.
Any board member can edit the labels on a board. All the labels are visible on the Quick Panel under Labels.

Procedure

1. From the task board tools, click the Labels tab.

2. Turn on the Show Labels button if it is turned off. You can see seven default labels:
   - Users with global_tags_creator role can add labels to the board and rename the label.
   - To add labels, click Add Labels. Newly added label remains in off state by default. You can assign any color or no color to the label. To rename the label, click the label text and enter new value.
   - To change the color of the label, click the Select color icon beside the label. Select the color of your choice from the color picker and click Save.
To disable or enable a specific label, toggle the button next to the label. To turn on or turn off a specific label, toggle the button next to the label. Only turned on labels show up in the quick filter and can be applied to a card.

- Board owner can delete the label by clicking Delete Label icon next to the label.
- To filter the cards by labels, type the Label name in the Search bar or click Add to Filter icon against the label. Once you filter by the label, you can only see cards with that label.

**Labels on Card Details Page**

When user clicks the card, the card opens with the details of the card. It contains all the applied labels under **Details** tab.
Under the **Labels** tab, the toggle button for applied labels is On and Off for the labels that are not applied.

**Configure visual task board with swimlanes**

Swimlanes enable you to create an environment with horizontal lanes in addition to vertical lanes. Swimlanes use only compact cards in task board.

**Before you begin**
Role required: none

**About this task**
You can add swimlanes in the following types of the visual task boards:
• Freeform Board
• Flexible Board
• Guided Board

You can perform following activities when you select swimlanes in visual task boards.

• Name and rename the swimlanes.
• Move the tasks horizontally and vertically from one user to another.
• Drag the cards across swimlanes.
• Reorder swimlanes by dragging them or from Lane Configuration.

• Collapse and expand swimlanes.

Procedure
1. Navigate to **System Definition > Self-service > Visual Task Boards**.
2. Click **New** and select the board type.
   • Freeform Board
   • Data Driven Board
3. Configure swimlanes in the boards.
• In a freeform board, activate the swimlanes by sliding the swimlanes toggle in the **Info** tab to the right.

The following figure shows a sample freeform board created with swimlanes.

• In a Ddata driven flexible board:
  a. Select **None** in **Vertical Lane Field** from the drop-down.
  b. Click **Next** and slide the toggle under the **Info** tab to the right.
The following figure shows a data driven flexible board created with swimlanes.

• In a data driven guided board, select **Vertical Lane Field** and **Swimlane Field** while creating the board. You must have created a freeform board in order to create a guided board.

You can also add swimlanes to the existing guided board by selecting **Swimlane Field** under **Info** tab in the board.
Modify the query or lane field for an existing board

For flexible and guided boards, you can edit the board query or lane field. This ability enables you to change the board contents while preserving the member list, board configuration settings, and, if applicable, Connect Chat conversation history.
Before you begin
Inform the board members that you plan to change the board query or lane field. If you or any members have manually sorted cards within a lane, the order may be reset.
Role required: none but you must be the board owner

About this task
The board query consists of filter conditions that determine which tasks the board tracks. For example, you might edit the query so the board shows only active incidents, rather than all incidents.
The lane field is the field on the underlying table that defines the lanes. For example, you might change the lane field so the lanes represent incident states, rather than assignees. This change is called a lane field pivot. Lane field pivots also make it possible to convert a flexible board to a guided board or vice versa.

Procedure
1. Open a task board.
2. Click the board information icon (i) by the board name.
3. Perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit the board query</td>
<td>a. Under Board Filter, click Edit Filter to open the condition builder.</td>
</tr>
<tr>
<td></td>
<td>b. Add and remove conditions as needed to edit the query.</td>
</tr>
<tr>
<td></td>
<td>c. Click Save.</td>
</tr>
<tr>
<td>Change the lane field</td>
<td>a. Click the Lane Field picker and select a field or the None option.</td>
</tr>
<tr>
<td></td>
<td>Guided boards have the Lane Field set to a field, such as State. Flexible</td>
</tr>
<tr>
<td></td>
<td>boards have the Lane Field set to None. You can change the Lane Field value</td>
</tr>
<tr>
<td></td>
<td>accordingly to change the board type.</td>
</tr>
<tr>
<td></td>
<td>b. In the confirmation dialog, click OK.</td>
</tr>
</tbody>
</table>

The board reloads to reflect the changes.
Configure WIP Lane Limit

You can set a limit to the number of cards added to a lane. If the limit is not set, any number of cards can be added to a lane by default.

**Before you begin**
Role required: admin

**Procedure**
1. Open the Visual Task Board.
2. Click on the lane header.
3. Select **Set Lane Limit.** **Set Lane Limit for <name of the lane>** window appears.
4. Enter the number you want to set for the specific lane. Leave blank, if you want set no limit to the lane.
5. Click **Save.**

**Results**
The number appears on the lane header.

```
Hardware 4/10
```

If the number of cards exceeds the set limit, the Red symbol appears on the lane header for all the board members.

```
Hardware ! 9/8
```

If a card is moved to a lane with exceeded WIP lane limit, the error message **To lane limit exceeded!** appears on the top of the page. The member who moves a card to the lane with exceeded limit can view the error message.

Configure the card limit for Visual Task boards

Freeform and Data Driven boards can display up to 1,000 cards by default. You can change the default card limit by adding a property.

**Before you begin**
Role required: admin

**About this task**
You can set card limit for both Freeform board and Flexible and Guided board in Data Driven board.
Procedure

1. Add a new system property with the following field values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.vtb.board_max</td>
</tr>
<tr>
<td>Type</td>
<td>integer</td>
</tr>
</tbody>
</table>

2. Set the Value to the maximum number of cards allowed for each board.

*Note:* Performance degradation may occur if you set the Value to a number greater than 1,000, especially on tablet devices.

Configure the task board card view

Configure the fields that appear in a card on a task board.

*Before you begin*
Role required: admin

Procedure

1. Navigate to the form you want to configure fields for.
2. Right-click the header and select **Configure > Form Layout.**
3. Under the Form View section, select the VTB view.
   You may need to create a VTB view for the form. For more information, see [Create and delete views](#).
4. Select the fields to appear on the card by adding or removing the fields from the Selected column. You can also adjust the order they appear on the form by moving the fields up or down.

Workflow

Workflow provides a drag-and-drop interface for automating multi-step processes across the platform. Each workflow consists of a sequence of activities, such as generating records, notifying users of pending approvals, or running scripts. The graphical Workflow Editor represents workflows visually as a type of flowchart. It shows activities as boxes labeled with information about that activity and transitions from one activity to the next as lines connecting the boxes.
Note: As of the New York release, Workflow is a legacy product. Use Flow Designer for any new process automation. As many organizations have workflows in production, use this Workflow documentation to learn how to work with existing workflows.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Upgrade to Rome</td>
<td>• Getting started with workflows</td>
<td>• Workflow roles</td>
</tr>
<tr>
<td>• Workflow movement with update sets</td>
<td></td>
<td>• Administering workflow contexts</td>
</tr>
<tr>
<td>• Workflow activity pinning</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Domain separation and Workflow</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Workflow training on the ServiceNow® Developer Site</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Workflow editor</td>
<td>• Developer training</td>
<td>• Ask or answer questions in the Developer Community</td>
</tr>
<tr>
<td>• Create a workflow</td>
<td>• Developer documentation</td>
<td>• Troubleshoot workflows</td>
</tr>
<tr>
<td>• Workflow activities</td>
<td>• Workflow API reference</td>
<td>• Search the Known Error Portal for known error articles</td>
</tr>
<tr>
<td></td>
<td>• Using variables in a workflow</td>
<td>• Contact Customer Service and Support</td>
</tr>
</tbody>
</table>

Getting started with workflows

The graphical Workflow Editor provides a drag-and-drop interface for automating multi-step processes across the platform.

Parts of a workflow

Workflows consist of these parts.

**Properties**

Specify configuration settings such as the workflow name, the table whose records the workflow acts on, and the conditions under which to run it.

**Activities**
Specify the sequence of operations the workflow performs such as generating records, notifying users of pending approvals, or running scripts.

Transitions
Specify the conditions under which to run an activity.

Exit conditions
Specify the conditions under which to run a transition.

Contexts
Store historical runtime information about a specific workflow run in a Workflow Context record.

Versions
Store historical design information about a specific workflow in a Workflow version record.

Workflow life cycle
A workflow starts when a triggering event occurs. Common triggers include a record being inserted into a specific table, or a particular field in a table being set to a specified value. For example, you might create a workflow that runs whenever a user requests approval for an item they want to order from the catalog. You can also schedule workflows to run periodically or call them from scripts such as business rules.

When an activity completes, the workflow transitions to the next activity. An activity might have several different possible transitions to various activities, depending on the outcome of the activity. Continuing the example above, if the user's request is approved, the activity might transition to an activity that notifies someone to order the item. If the user's request is denied, the activity might transition to notifying the user that their request has been denied.

The graphical Workflow Editor represents workflows visually as a type of flowchart. It shows activities as boxes labelled with information about that activity and transitions from one activity to the next as lines connecting the boxes.

At each step in a workflow:
1. An activity is processed and an action defined by that activity occurs.
2. At the completion of an action by an activity, the workflow checks the activity's conditions.
3. For each matching condition, the workflow follows the transition to the next activity.
When the workflow runs out of activities, the workflow is complete. The Workflow Context stores the execution history of the activities and transitions run. The Workflow Version stores the design history of the activities, transitions, and exit conditions available to run.

**Workflow properties**

The workflow properties specify when to run a workflow and what records it acts on. For more information about workflow properties, see [Workflow properties](#).

**Workflow activities**

A workflow activity contains instructions that are processed by the workflow. Activities can include running scripts, manipulating records, waiting for a set period of time, or logging an event. Workflow conditions determine whether or not the activity is performed. Activities can be added, removed, or rearranged. Transitions can be drawn between activities.

This is an activity that triggers a notification:

![Sample activity](image)

Workflow runs activities as the user session that starts them. Workflows started from record operations will run activities as the user session that performed the record operation. Workflows started from schedules or restarted from timers run activities as the System user. Workflows started from script calls run activities as the user session that started the script.

For more information on available activities and their behaviors, see [Workflow activities](#).

**Transitions**

After the workflow condition is evaluated, the workflow transition determines which activity is performed when the workflow condition is met.

This is a transition that always leads from the **Change Approved** Script to the **Change Task** activity:
Exit conditions

After a workflow activity is performed, the workflow condition is evaluated to determine which transition is activated.

The condition determines behavior based on a change being approved or rejected:

Workflow example

During workflow editing or while an unpublished workflow is running, only the person who checked out the workflow can view the changes.

After a workflow is published, it is available to other users. The workflow moves through the process as defined in the Workflow Editor. The entire workflow is represented in one screen. For example, this is the Standard Change workflow:
Workflow editor

The Workflow Editor is an interface for creating and modifying workflows by arranging and connecting activities to drive processes.

You can manage multiple workflows in the same screen, create custom workflow activities, and use existing activities as data sources. Users with the workflow_creator role can create workflows. Users with the workflow_admin role can create, modify, delete, and publish workflows.

To open the Workflow Editor, navigate to Workflow > Workflow Editor. For information about using the editor, see Create a workflow.

Welcome screen

The editor opens with the Welcome page, which displays a list of active, published workflows. From this tab, you can open existing workflows, create new workflows, and open help resources related to workflow.
<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Owner</th>
<th>Created</th>
<th>Updated</th>
<th>Published</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Catalog Item Request</td>
<td>Requested Item [or, req, item]</td>
<td>admin</td>
<td>2021-04-18</td>
<td>13:46:40</td>
<td>true</td>
<td>Global</td>
</tr>
<tr>
<td>Procurement Process Flow - Software</td>
<td>Requested Item [or, req, item]</td>
<td>admin</td>
<td>2021-04-18</td>
<td>13:46:40</td>
<td>true</td>
<td>Global</td>
</tr>
<tr>
<td>Comprehensive Change Management</td>
<td>Change Request [or, req, change, request]</td>
<td>test, admin</td>
<td>2021-04-18</td>
<td>14:01:12</td>
<td>true</td>
<td>Global</td>
</tr>
<tr>
<td>Delegate to a group member</td>
<td>Change Request [or, req, change, request]</td>
<td>admin</td>
<td>2021-04-18</td>
<td>14:02:05</td>
<td>true</td>
<td>Global</td>
</tr>
<tr>
<td>Default SLA Workflow</td>
<td>Task SLA [or, task, sl]</td>
<td>SLA Manager</td>
<td>2021-04-18</td>
<td>13:36:06</td>
<td>true</td>
<td>Global</td>
</tr>
<tr>
<td>Procurement Process Flow - Hardware</td>
<td>Requested Item [or, req, item]</td>
<td>admin</td>
<td>2021-04-18</td>
<td>12:49:04</td>
<td>true</td>
<td>Global</td>
</tr>
<tr>
<td>Change Request - Normal</td>
<td>Change Request [or, req, change, request]</td>
<td>admin</td>
<td>2021-04-18</td>
<td>11:46:06</td>
<td>true</td>
<td>Global</td>
</tr>
<tr>
<td>Procurement Process Flow - Mobile</td>
<td>Requested Item [or, req, item]</td>
<td>admin</td>
<td>2021-04-18</td>
<td>12:14:02</td>
<td>true</td>
<td>Global</td>
</tr>
<tr>
<td>Service Catalog Item Request</td>
<td>Requested Item [or, req, item]</td>
<td>admin</td>
<td>2021-04-18</td>
<td>11:53:49</td>
<td>true</td>
<td>Global</td>
</tr>
<tr>
<td>Test of Incident</td>
<td>Incident [or, inc, incident]</td>
<td>admin</td>
<td>2021-04-18</td>
<td>21:32:42</td>
<td>true</td>
<td>PDB7778</td>
</tr>
<tr>
<td>SUA notification and escalation workflow</td>
<td>Task SUA [or, task, sl]</td>
<td>admin</td>
<td>2021-04-18</td>
<td>21:20:17</td>
<td>true</td>
<td>SUA</td>
</tr>
<tr>
<td>Threat Sharing Client - Process Incident</td>
<td>Global</td>
<td>admin</td>
<td>2021-04-18</td>
<td>21:30:36</td>
<td>true</td>
<td>Threat Sharing Client</td>
</tr>
<tr>
<td>Threat Intelligence - RANT Notification</td>
<td>Lookup [or, lookup]</td>
<td>admin</td>
<td>2021-04-18</td>
<td>21:32:02</td>
<td>true</td>
<td>Threat Intelligence</td>
</tr>
<tr>
<td>Security incident - Resolve</td>
<td>Incident [or, sec, incident]</td>
<td>admin</td>
<td>2021-04-18</td>
<td>21:48:03</td>
<td>true</td>
<td>Security Incident</td>
</tr>
<tr>
<td>ServiceNow Incident Response - Intl</td>
<td>Global</td>
<td>admin</td>
<td>2021-04-18</td>
<td>21:02:03</td>
<td>true</td>
<td>Security Operators System Command Interface</td>
</tr>
<tr>
<td>ServiceNow Incident Response - Intl</td>
<td>Global</td>
<td>admin</td>
<td>2021-04-18</td>
<td>21:02:03</td>
<td>true</td>
<td>Security Operators System Command Interface</td>
</tr>
<tr>
<td>ServiceNow Incident Response - Intl</td>
<td>Global</td>
<td>admin</td>
<td>2021-04-18</td>
<td>21:02:03</td>
<td>true</td>
<td>Security Operators System Command Interface</td>
</tr>
<tr>
<td>ServiceNow Incident Response - Intl</td>
<td>Global</td>
<td>admin</td>
<td>2021-04-18</td>
<td>21:02:03</td>
<td>true</td>
<td>Security Operators System Command Interface</td>
</tr>
<tr>
<td>ServiceNow Incident Response - Intl</td>
<td>Global</td>
<td>admin</td>
<td>2021-04-18</td>
<td>21:02:03</td>
<td>true</td>
<td>Security Operators System Command Interface</td>
</tr>
<tr>
<td>ServiceNow Incident Response - Intl</td>
<td>Global</td>
<td>admin</td>
<td>2021-04-18</td>
<td>21:02:03</td>
<td>true</td>
<td>Security Operators System Command Interface</td>
</tr>
<tr>
<td>ServiceNow Incident Response - Intl</td>
<td>Global</td>
<td>admin</td>
<td>2021-04-18</td>
<td>21:02:03</td>
<td>true</td>
<td>Security Operators System Command Interface</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**Core**: Available workflow activities appropriate for the selected workflow. Contents can include activities provided by the base system and those purchased with orchestration.

**Packs**: Orchestration activity packs downloaded from the ServiceNow® App Store, organized by vendor and scope. Custom activities and workflows that you scope also appear as packs. Only visible if the orchestration plugin is installed.

**Custom**: Orchestration custom activities available. Only visible if the orchestration plugin is installed.

**Data**: Activities in the current workflow that output data. You can use these activities as data sources for other activities. Only visible if the orchestration plugin is installed.

⚠️ **Note**: If your workflow welcome page does not look like this example, you may have customized the workflow welcome page before upgrading to Rome. You can update the workflow welcome page to the latest version by editing the **UI pages**.

Navigate to **System UI > UI Pages > Workflow Editor welcome**. In the UI page record for `workflow_editor_welcome`, scroll to the **Versions** related list. Select the row for the version corresponding to the upgrade to Rome, right-click and select **Revert to this version**.

### Workflow canvas

After you open or create a new workflow, the system displays the workflow canvas. On the canvas you interact with the Workflow Editor through several different elements: the canvas itself, the canvas tabs, the title bar, the palette, and the palette tabs.

The drawing canvas is where you add activities and configure transitions for checked out workflows. Add an activity by dragging it from the palette to the workflow in the canvas. For more information, see [Create a workflow](#).

- **Canvas tabs**: Contains tabs for accessing workflows being edited or created.
- **Title bar**: Displays the workflow name and status. Provides a menu and controls for configuring, testing, and validating workflows.
- **Canvas**: Provides the working surface for creating new workflows or editing existing ones.
• **Palette tabs**: Contains tabs for accessing activities being edited or created.

• **Palette**: Contains all available workflow activities and existing workflows you can use as subflows. Drag activities and subflows to the canvas to create new workflows or edit existing ones.

**Workflow user interface**

The default workflow palette contains workflow activities and existing workflows you can use as subflows.

The basic workflow palette contains these tabs:

• **Workflows**: Displays existing workflows and provides controls for creating new ones.

• **Core**: Displays baseline workflow activities available to all systems and Orchestration activities (when Orchestration is activated).

**Workflows tab**

The **Workflows** tab lists existing workflows that you can edit or use as subflows in other workflows. Double-click a workflow to open it in the canvas. To add a workflow as a subflow, drag it to another workflow in the canvas. Click the + icon to create a new workflow.
Workflows tab in the palette

The Core tab contains the standard activities available by default to all workflows and any activities purchased with Orchestration, organized by category. Click the arrow icons to expand or collapse the activity lists under each category. To add an activity to a workflow, drag it to the canvas. For more information, see Add an activity to a workflow.
When a workflow is opened in the canvas, the title bar displays the workflow title and the workflow status in italics. Possible states are Checked out by <name> and Published.

Controls on the right side of the title bar manage the workflow.
• **Workflow Properties**: Opens the current workflow's properties form.

• **Start**: Runs the workflow. This control is only available for workflows running on the Global table that are accessible from all application scopes. To test workflows that are on other tables, insert a record into that table that meets the condition of the workflow.

• **Validate**: Tests the workflow prior to publication. Validation detects potential problems that can prevent the workflow from publishing or cause the workflow to fail. For more information, see [Workflow Validation](#).

• **Help**: Opens documentation to help you create the workflow.

### Workflow menu

Click the menu icon in the title bar for additional options to configure the workflow.

These menu options are available:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Workflow</td>
<td>Creates a new workflow.</td>
</tr>
<tr>
<td>Open Existing</td>
<td>Opens another existing workflow.</td>
</tr>
<tr>
<td>Copy</td>
<td>Creates a duplicate of the workflow. Give the copy a different name.</td>
</tr>
<tr>
<td>Publish</td>
<td>Makes the personal workflow version public, overwriting the current published workflow version.</td>
</tr>
<tr>
<td>Checkout</td>
<td>Creates a personal version of the workflow for you, which you can edit. This option is only available for published workflows.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the workflow. You cannot delete workflows that have contexts associated with them.</td>
</tr>
<tr>
<td>Set Inactive</td>
<td>Inactivates the workflow so that it cannot be used.</td>
</tr>
<tr>
<td>Expand Transitions</td>
<td>Redraws the transitions so that they do not overlap when they leave the activity condition.</td>
</tr>
<tr>
<td>Start Workflow</td>
<td>Starts a test run of the current workflow.</td>
</tr>
<tr>
<td>Validate Workflow</td>
<td>Runs validation tests on your workflow prior to publication. Use this validation to detect potential problems that can prevent the workflow from publishing or cause the workflow to fail. For more information, see Work on workflows.</td>
</tr>
<tr>
<td>Collapse Transitions</td>
<td>Redraws the transitions so they overlap when they leave the activity condition.</td>
</tr>
<tr>
<td>Show Contexts</td>
<td>Displays all the contexts for the current workflow. You can use this option to troubleshoot a workflow.</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens the Workflow Properties form, which defines the workflow's attributes.</td>
</tr>
<tr>
<td>Edit Inputs</td>
<td>Opens the Workflow Inputs list of variables that the workflow can accept when used as a subflow. For more information, see Pass a variable from a workflow to a subflow.</td>
</tr>
</tbody>
</table>
Workflow menu options (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Stages</td>
<td>Opens the Workflow Stages list. For more information, see Workflow stages. For tables with a column of Type = Workflow.</td>
</tr>
</tbody>
</table>

Workflow editor keyboard navigation

The platform includes accessibility features that support Web Content Accessibility Guidelines (WCAG) 2.0 level A and make the interface accessible to users with disabilities.

These features improve the user experience when accessing platform functions with screen readers and keyboard navigation. In general, you use the following set of standard keyboard navigation functions:

- Press **Tab** to navigate major groupings in a pre-defined sequence. This usually includes moving between standard interface controls (fields and lists) in a module, or between records within a tab.
- Press **Shift Tab** to move backwards in a pre-defined sequence.
- Use arrow keys (left, right, up, down) to navigate between individual elements within a group. This usually includes moving between tabs, or between available selections within a specific control (for example, within a list).
- Press **Enter** to select a control or tab, or enter text within a control.

The Workflow Editor is constructed in a unique manner. It includes a series of main (left) panel tabs, a series of side (right) panel tabs, and a drawing canvas for workflow creation or editing. As such, it has its own unique set of keyboard accessibility functions and commands.

Welcome page keyboard commands

Use keyboard commands to navigate and operate the Workflow Editor Welcome page.
### Task or Action

Navigate to main content (left) panel, and select a workflow

<table>
<thead>
<tr>
<th>Keyboard Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. After accessing the Workflow Editor from a menu, press Tab. <strong>Skip to Main Content</strong> appears in the upper left corner.</td>
</tr>
<tr>
<td>2. Press Enter to position the cursor in the first record displayed in the Published tab.</td>
</tr>
<tr>
<td>3. Press Tab to navigate down the listing of workflow records. Press Enter to select and open a workflow record in the Workflow drawing canvas.</td>
</tr>
<tr>
<td>Task or Action</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
</tr>
</tbody>
</table>
| Select a checked out workflow or a help function in main content panel | 1. After accessing the Workflow Editor from a menu, press **Tab** until the **Published** tab is highlighted.  
   **Note:** Do not select **Skip to Main Content** or **Skip to Workflow Side Panel**.  
   2. Press the right or left arrow keys to navigate between the **Published**, **Checked Out**, or **Help** tabs.  
   3. Press **Tab** to navigate across the columns and down the listing of checked out workflow records or help selections.  
   Press **Enter** to select and open a checked out workflow record in the Workflow drawing canvas, or open a help selection (work or orchestration videos, documentation, community discussions, knowledge base, or live feed). |
| Create a workflow                                  | 1. After accessing the Workflow Editor from a menu, press **Tab** until **New Workflow** is highlighted.  
   2. Press **Enter** to open **New Workflow** |
<p>| Jump to Top                                         | After tabbing through the displayed records in a tab in the main panel (for example, within the <strong>Published</strong> tab), <strong>Jump to top</strong> appears at the bottom of the listing. Press <strong>Enter</strong> to return to the Welcome tab at the top of the Workflow Editor. |</p>
<table>
<thead>
<tr>
<th>Task or Action</th>
<th>Keyboard Commands</th>
</tr>
</thead>
</table>
| Navigate to page selection controls                                          | 1. After tabbing through the displayed records in a tab in the main panel (for example, within the **Published** tab), including **Jump to top**, press **Tab** to access the page selection controls. Continue to press **Tab** until you access the desired one.  
2. Press **Enter** to operate the selected page control.                       |
| Navigate directly to side (right) panel to open help, create a new workflow, or open an existing one | 1. After accessing the Workflow Editor from a menu, press **Tab** two times. Do not select **Skip to Main Content**.  
2. Press **Enter** to position the cursor in the **Workflows** tab in the side panel.  
3. To open help, press **Tab** to navigate to **Help**. Press **Enter** to open help, or press **Tab** to skip.  
4. To create a new workflow, press **Tab** to navigate to **Create**. Press **Enter** to open **New Workflow**, or press **Tab** to skip.  
5. To open an existing workflow:  
   • As needed, stop at the filter field to filter workflows.  
   • Press **Tab** to navigate down the workflow list.  
   • Press **Enter** to select and open a workflow record in the Workflow drawing canvas. |
<p>| Add a core activity to a checked out workflow in the Workflow drawing canvas  | If a checked out workflow is open in the Workflow drawing canvas, core activity records display in the <strong>Core</strong> tab. To |</p>
<table>
<thead>
<tr>
<th>Task or Action</th>
<th>Keyboard Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>select a core activity and place it in the checked out workflow:</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> Core activity records only display when a checked out workflow is open in the Workflow drawing canvas. Other tabs display in the side panel only if Orchestration functions are enabled.</td>
<td></td>
</tr>
<tr>
<td>1. In the Workflow drawing canvas, press <strong>Shift Tab</strong> until <strong>Skip to Workflow Side Panel</strong> appears in the upper left corner.</td>
<td></td>
</tr>
<tr>
<td>2. Press <strong>Enter</strong> to position the cursor in the <strong>Workflows</strong> tab in the side panel.</td>
<td></td>
</tr>
<tr>
<td>3. Press the right arrow key to navigate to the <strong>Core</strong> tab.</td>
<td></td>
</tr>
<tr>
<td>4. Press <strong>Tab</strong> or the down arrow key to navigate down the listing of core activities.</td>
<td></td>
</tr>
<tr>
<td>• To open a core activities folder (for example, Approvals), press the right arrow key.</td>
<td></td>
</tr>
<tr>
<td>• To navigate up the list, press the left or up arrow keys.</td>
<td></td>
</tr>
<tr>
<td>5. Press <strong>Tab</strong> to select a core activity and open the New Activity dialog to specify properties for it.</td>
<td></td>
</tr>
<tr>
<td>6. After creating the activity, remember to link it to another activity in the workflow. See Create a connection from a condition on one activity to the next activity that follows in Workflow drawing canvas keyboard commands.</td>
<td></td>
</tr>
</tbody>
</table>

**Workflow drawing canvas keyboard commands**

Use keyboard commands to navigate and operate the Workflow Editor canvas.

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Task or Action</th>
<th>Keyboard Commands</th>
</tr>
</thead>
</table>
| Select Workflow Actions menu command (for example, Validate Workflow or Publish Workflow) | 1. Press **Tab** until the context menu (≡) is highlighted.  
2. Press **Enter** to open the context menu.  
3. Use the down arrow key to move to the command, then press **Enter** to select it. |
| Set general workflow properties                   | 1. Press **Tab** until **i** is highlighted.  
2. Press **Enter** to open **Workflow Properties**.                                                                                           |
| Navigate from activity box to activity box.       | Simply press **Tab** or use the arrow keys (right, left, up and down) to navigate from activity to activity within the workflow.                |

**Note:** Depending on the complexity and number of activity boxes in the workflow, the sequence of navigation is not always predictable. Depending on how you are navigating within the workflow, the navigation sequence is generally (but not always) row-by-row, and focus is usually placed on the nearest activity box.
<table>
<thead>
<tr>
<th>Task or Action</th>
<th>Keyboard Commands</th>
</tr>
</thead>
</table>
| Modify a selected activity. | 1. Navigate to the activity box, then press **Enter** to select it and place it in Edit mode. When you select an activity box, it appears as highlighted.  
2. Once in Edit mode, use **Tab** to move around within the activity box to change or access elements such as:  
   - Activity Properties (√)  
   - Title  
   - Node context menu  
   - Delete Node (⊗)  
   - Condition Properties (Always)  
   - Node conditional context menu (†)  
   - Node conditional port options (✉)  
   > **Note:** All elements in a selected activity are only accessible when working with a checked out workflow. When working with a published workflow, you can only access its activity properties and title,  
3. Press **Enter** to select an element, or press **Esc** to escape an element without making changes. |
| Add a condition to an activity. | 1. Within an activity box, select **Condition Properties**.  
2. In **Condition Properties**, specify the conditions for the activity. |
| Create a connection from a condition on one activity to the next activity that follows | 1. Within an activity box, select **Node conditional context menu (†)**.  
2. Select **Link to...** to create a connection to the next activity box that follows, or select **Delete** to delete an existing connection. |
| Add a core or custom activity | 1. Within an activity box, select **Node conditional port options (✉)**.  
2. Select **Add Core Activity** to access Workflow Activity Definitions to add a new core activity, or select **Add Custom Activity** to add a custom activity to the workflow. |
<table>
<thead>
<tr>
<th>Task or Action</th>
<th>Keyboard Commands</th>
</tr>
</thead>
</table>
| Move an activity box         | 1. Press **Tab** to navigate to the activity box, enter press **Enter** to select it.  
                               | 2. Use the arrow keys to move the activity box. To move the activity box one pixel at a time, press **Shift** while using the arrow keys. |
| Validate a workflow          | 1. Press **Tab** until ✅ is highlighted.  
                               | 2. Press **Enter** to validate the workflow.                                                                                              |
|                              | You can also select **Validate** from the Workflow Actions menu.                                                                               |
| Run a workflow               | 1. Press **Tab** until ⏬ is highlighted.  
                               | 2. Press **Enter** to run the workflow.                                                                                                     |
|                              | **Note**: If the workflow is tied to a database table, this function is disabled. The workflow runs when the proper table conditions are activated (for example, insertion of a new record into the table). |
| Close workflow drawing canvas| 1. Press **Tab** until ✗ (on the right side of the tab that contains the name of the workflow) appears.  
                               | 2. Press **Enter** to close the canvas.                                                                                                     |
| Publish a workflow           | 1. Press **Tab** until ⏬ (on the right side of the tab that contains the name of the workflow) appears.  
                               | 2. Press **Enter** to open the context menu.                                                                                               |
|                              | 3. Use the down arrow key to move to the **Publish** command, then press **Enter** to select it.                                               |
| Jump to Top                  | After tabbing through the entire workflow, appears at the bottom of the listing. Press **Enter** to jump to the top of the Workflow drawing canvas. |

**Workflow management**

Create, edit, validate, and publish workflows to automate multi-step processes across the platform. Understand workflow activities and variables and how to
use them effectively. Take a deeper look at how workflows are constructed, validated, and used.

Create a workflow

Automate a multi-step process by creating a workflow with the Workflow Editor.

Before you begin

- You must have the workflow_admin or workflow_creator role to use the Workflow Editor.
- If you are designing the workflow as part of an update set process, see Workflow movement with update sets before creating the workflow.

Procedure

1. Navigate to Workflow > Workflow Editor.
   The Welcome tab of the Workflow Editor opens.
2. On the Workflows tab in the palette, click New Workflow.
   A simplified version of the New Workflow form opens.
3. Fill in the Name and Table fields
4. [Optional] Add a Description.
5. [Optional] Do one of the following:
a. If the **Conditions** UI section is displayed, specify a **Condition** if needed and edit the fields. (The **Conditions** UI section shows only if the selected table supports conditions for launching workflows. For example, if you select the `sc_req_item` table, conditions are not applicable and the **Conditions** UI section is not displayed.)

b. If the **Stages** UI section is displayed, check that the **State rendering** and **Stage order** fields contain the correct information. (The **Stages** UI section shows only if the selected table supports stages. For example, if you select the `sc_req_item` table, the **Stages** UI section is displayed.)

6. Click **Submit**.

   The new workflow is created with the **Begin** and **End** activities connected by a single transition.

![Diagram of a workflow with Begin and End activities connected by a single transition.](image)

7. Finish creating the workflow by adding activities, validating, and publishing so the workflow is available to other users. For more information, see **Work on workflows**.

8. To change advanced settings for the workflow, click the **Properties** icon 🔍. If you make changes, click **Update**.

**Workflow properties**

In the properties of a workflow, you can configure settings such as its application scope, start conditions, schedule, inputs, stages, and run time metrics. You can also view information such as the workflow author, version, and history.

When you create a new workflow, the following fields are available in the dialog box:

- **Name**
- **Table**
- **Description**
• If condition matches
• Condition

If you click Diagrammer view, in Related Lists, the following UI sections are available in the dialog box:
• General
• Conditions
• Inputs
• Activities
• Application
• Schedule
• Stages
• Estimated Runtime

General

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name to identify the workflow.</td>
</tr>
<tr>
<td>Table</td>
<td>The table for the workflow to run on. Workflows that run on specific tables can still interact with other tables. Select Global [global] to run the workflow on all tables.</td>
</tr>
</tbody>
</table>

Note: The list shows only tables and database views that are in the same scope as the workflow. Also, all users who edit the workflow must have access to the necessary tables and domains.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checked out</td>
<td>[Read-only] When the workflow was checked out. Automatically set by the Checkout action in the workflow menu.</td>
</tr>
<tr>
<td>Checked out by</td>
<td>[Read-only] The user who has this workflow checked out. This value is automatically set by the Checkout action in the workflow menu.</td>
</tr>
<tr>
<td>Published</td>
<td>[Read-only] Check box to indicate whether the workflow has been published. Automatically set by the Publish action in the workflow menu.</td>
</tr>
<tr>
<td>Description</td>
<td>The purpose of the workflow.</td>
</tr>
</tbody>
</table>
Conditions
Create conditions to trigger the workflow. The Conditions section does not appear if you select a table, such as sc_req_item, that does not require a condition.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| If condition matches   | When the condition evaluates to true, the workflow launches an active context:  
  • **None**: The workflow is not automatically started by the workflow engine. To run this workflow, write a script to start the workflow.  
  • **Run the Workflow**: The default value. The workflow engine starts the workflow if the information in the Condition field matches a record that is inserting into the table.  
  • **Run if no other workflows match yet (deprecated)**: The workflow only runs if no other workflows are running on the execution thread that started this workflow. Avoid using.  
  • **Run if no other workflows matched**: The workflow only runs if no other workflows are running on a specific record. For example, there are four workflows inserted into the Incident table, which have a condition such as short_desc contains test. A new workflow, which has If condition matches is set to Run if no other workflows match yet, only runs if none of the four workflows have started running on the Incident record. |

| Condition              | A condition builder for specifying workflow conditions that trigger the behavior selected from the If condition matches list.                                                                                     |
| Order                  | Numeric value that determines the order of the workflow, relative to other workflows. Workflows are evaluated in order from the lowest order number to the highest. A workflow runs if it is the first to match conditions. |

Inputs
The Inputs section lists all the activities in the current workflow that input data, the data type, and the default value. The Inputs section is only available after a workflow has been created. To create a variable, click **New**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displayed column label. Localized depending on user locale.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reference</td>
<td>Input field from another table.</td>
</tr>
<tr>
<td>Type</td>
<td>Data type. For example, integer or string.</td>
</tr>
<tr>
<td>Default value</td>
<td>Value used if you do not provide a value.</td>
</tr>
</tbody>
</table>

**Activities**
The Activities section enables you to set activity pinning and maximum activity count.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Activity pinning        | List of options that control updates to custom activities at the workflow level. Pinning protects custom activities from being updated automatically when downloaded from the ServiceNow Store. For more information, see Workflow activity pinning. The possible options are:  
  • **Set by activity**: Allows all activities in the workflow to use their own pinning settings. This is the default pinning option.  
  • **Pin all activities**: Pins all activities in the workflow to their current version.  
  • **Unpin all activities**: Allows all activities in the workflow to be updated.                                                                 |
| Max activity count      | The maximum number of activities performed by the workflow. This value is used to prevent infinite loops and is set to 100 by default. When the stated maximum count is reached, the workflow is canceled. If this field is blank, the maximum count is set to -1, and the workflow is canceled. |

**Application**
The Application section enables you to see application scope and scope restrictions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>[Read-only] Scope of this activity. For more information, see Application Scope.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Scope restrictions for this workflow. Possible settings are:</td>
</tr>
</tbody>
</table>
### Field Description

- **All application scopes**: Workflow is accessible to all application scopes.

- **This application scope only**: Workflow access is limited to the scope named in the Application field.

For more information see Workflow scope.

### Schedule

Use the Schedule section to create a schedule for this workflow using the schedule builder.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery based on</td>
<td>The schedule type for this workflow. Possible types are:</td>
</tr>
<tr>
<td></td>
<td>- <strong>User-specified duration</strong>: Duration based on a user-specified value. This is the default schedule type.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Relative duration</strong>: Duration calculated from a preconfigured schedule, such as 8-5 weekdays.</td>
</tr>
<tr>
<td>Expected time</td>
<td>User-defined interval. This field is visible when the schedule type is User-specified duration.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Preconfigured schedule that determines when this workflow runs.</td>
</tr>
<tr>
<td>Timezone</td>
<td>Time zone for this instance.</td>
</tr>
</tbody>
</table>

### Stages

The Stages section appears if you select a table with **Type = Workflow**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stage</td>
<td>Displays the workflow stage progress on the selected table. Optionally, select Stage rendering and Stage order schemes to customize the appearance of the stage field. The default values cover typical scenarios.</td>
</tr>
<tr>
<td>Stage rendering</td>
<td>The renderer to use when displaying stage icons on a form or list view. For more information about renderers, see Workflow stage renderers.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
**Stage order** | The order of workflow stages when you view a workflow field in a list. Select **Computed** to let the workflow engine compute the stage order from the order of execution in the workflow. Select **User Specified** to use the **Order** field from that Workflow stages.

**Name** | The name of the stage as it appears in workflow fields.

**Duration** | Time allocated for the specific stage.

**Order** | The order of workflow stages when you view a workflow field in a list. Select **Computed** to let the workflow engine compute the stage order from the order of execution in the workflow. Select **User Specified** to use the **Order** field from that Workflow stages.

**Value** | The value of the stage when it is referenced from elsewhere in the system, such as in a script.

---

### Estimated Runtime
The **Estimated Runtime** section opens the controls for configuring the ERT for the workflow. Core workflows included in the base system are not configured for estimated run time by default. All new workflows are configured with default ERT values automatically. You can edit existing run time estimates or configure new ones for any existing workflow. For details about how estimated run times are configured and calculated, see **Workflow run time metrics**.

### Field | Description
--- | ---
**Requires ERT** | Check box to indicate that this workflow requires an estimated runtime configuration.

You can use the ERT calculations to determine if workflows are running longer or shorter than expected and to identify errors in workflow processing. By default, new workflows require an ERT.

**Estimated Run Time** | The initial estimate for the workflow's run time.

**Number of data points** | [Read only] The number of times the system has compared the estimated run time to an actual run time result.

**Outlier Percentage Threshold for ERT** | [Required] The percentage deviation from the estimated run time that identifies an outlier workflow run time. The system uses a default value of 20. For more information, see **Outlying workflow run times**.
Create a workflow from a table

Automate a multi-step process by creating a workflow from the list view of any table that supports workflows.

Before you begin

- If you are designing the workflow as part of an update set process, see Workflow movement with update sets before creating the workflow.

Procedure

1. Open a table, such as Incident or Problem, in list view. For example, navigate to Incident > Open.

2. Right-click in the column header and select Configure > Workflows.

   ![Image of column header with Configure and Workflows options selected]

   The Workflow Versions on that table appear in a list.

3. Click New.

   The Workflow Version opens in New Workflow view. The Table field is filled in with the table you selected in step 1 and is read-only.

4. Enter Name.

5. [Optional] Enter Description.
6. [Optional] Edit conditions fields as necessary.

7. Click Submit.
   The new workflow is added to the Workflow Versions list.

8. Click the workflow Name.
   The new workflow is created with the Begin and End activities connected by a single transition.

9. Finish creating the workflow by adding activities, validating, and publishing so the workflow is available to other users.
   For more information, see Work on workflows.

10. [Optional] To change advanced settings for the workflow, click the Properties icon. If you make changes, click Update.

Create a workflow for a new service catalog item

When you create a new service catalog item, you can create a new corresponding workflow at the same time.

Before you begin

- If you are designing the workflow as part of an update set process, see Workflow movement with update sets before creating the workflow.

Procedure

1. Navigate to Service Catalog > Catalog Definitions > Maintain Items.

2. At the top of the form, next to Catalog Items, click New.
   The Catalog Item form opens.

3. Add a Name.

4. Next to the Workflow field, click the lookup icon.

5. Next to Workflow at the top, click New.
The Workflow version dialog opens in the New Workflow View. The **Table** field is set to **Requested Item (sc_req_item)** and is read-only.

6. Add a **Name**.

7. [Optional] Add a **Description**.

8. [Optional] Change the stage information as necessary.

9. Click **Submit**.

   The new workflow is created with the **Begin** and **End** activities connected by a single transition.

10. Finish creating the workflow by adding activities, validating, and publishing so the workflow is available to other users.

    For more information, see [Work on workflows](#).

11. To change advanced settings for the workflow, click the **Properties** icon.
12. Click **Update**.
   If you close the Workflow Editor, you can see the Catalog Item record. Note that the workflow is added to the Workflow field. The Show Workflow and Information icons appear next to the **Workflow** field. Hover over the information icon to view a read-only summary of the workflow.

**Create a workflow for an SLA Definition**

Automate a multi-step process by creating a workflow from an SLA definition.

**Before you begin**
- If you are designing the workflow as part of an update set process, see **Workflow movement with update sets** before creating the workflow.

**Procedure**

1. Open a list of SLA definitions. For example **Facilities > SLA Definitions** or **Service Level Management > SLA Definitions**.

2. At the top of the form, next to **SLA Definitions**, click **New**.

3. Select **Contract SLA** or **Service Offering SLA**.
   The SLA Definition or Service Offering SLA form opens.

4. Next to the **Workflow** field, click the lookup icon.

5. Next to **Workflow** at the top, click **New**.
The Workflow Version dialog shows in the New Workflow view. The Table field is set to SLA Definition (contract_sla) or Service Offering SLA (service_offering_sla) and is read-only.

6. Enter **Name**.
7. [Optional] Enter **Description**
8. [Optional] Edit conditions fields as necessary.
9. Click **Submit**.
   The new workflow is created with the **Begin** and **End** activities connected by a single transition.

10. Finish creating the workflow by adding activities, validating, and publishing so the workflow is available to other users.
For more information, see Work on workflows.

11. [Optional] To change advanced settings for the workflow, click the **Properties** icon 📋. If you make changes, click **Update**.

**Ending workflows with multiple branches**

A workflow is complete when it reaches the **End** activity, even if there are still active branches of the workflow in progress. To ensure that both branches are completed, add a **Join** activity to resolve the branches.

For example, the following figure shows a workflow with two branches that execute independently. When Task 1 and Task 2 of Branch B are completed, the workflow is marked complete even if the Branch A tasks are not completed.

![Workflow with uncompleted branch](image)

For both branches to complete, add a **Join** activity to resolve the branches. When one branch reaches the join, the workflow waits for the other branch. When both branches are complete, the workflow reaches the end. The **Incomplete** condition of the **Join** activity is met only if one of the branches cannot be completed.

![Workflow with completed branches](image)

**Work on workflows**

To complete a workflow, you add workflow activities, validate the workflow, and publish it.

**Add a workflow activity**

Activities determine the functionality of the workflow.
Before you begin
Role required: workflow_admin, workflow_creator, or admin

About this task
When they are created, all workflows contain Start and End activities.
For more information, see Workflow activities.

Procedure
1. Open a workflow.
2. Check out the workflow.
3. Drag a workflow activity from the Activities menu into the workflow body.
4. Populate the Workflow Activity form that appears.

Validate a workflow
You can manually validate a workflow from the Workflow Editor. You can generate a workflow validation report from the Workflow Version form.

Before you begin
Role required: workflow_admin, workflow_creator, or admin

About this task
Running a workflow on a new node automatically attempts to validate the workflow. If validation is successful, the system updates the workflow version record to indicate the workflow has been validated and marks the record as updated by the user who ran the workflow.

Procedure
1. Open the workflow to validate in the Workflow Editor.
   When the workflow is loaded, the workflow validator icon appears in the toolbar.
   ![Workflow Editor toolbar with validator icon]

2. Click the validator icon to run a series of validation tests on the current workflow version and generate a report.
3. Complete the following steps to generate a workflow validation report from the Workflow Version form

   a. Navigate to Workflow > Administration > Workflow Versions, and select a workflow to validate.

   b. Under Related Links, click Validate Workflow.

Publish a workflow

When a workflow is complete, publish the workflow so that it is available to all users.

Before you begin

Before you publish a workflow, validate it to test it for issues that might cause it to fail, such as missing subflows or disconnected transitions. For more information, see Workflow validation.

Role required: workflow_admin, workflow_creator, or admin

About this task

To publish a workflow:
Procedure
1. Navigate to Workflow > Workflow Editor.
2. Open the workflow that you want to publish.
3. In the title bar, click the menu icon and select Publish.

Results
If you published a new version of workflow, the changes are not applied to running workflow contexts. Any currently running workflow context continues using the workflow version that was available when the workflow started. The next time the workflow runs, it uses the new version.

Determine whether a workflow can run
A workflow can run only if a checked out version is available to the user who has it checked out, and a valid, published version is available for all users with permission to run it.

Before you begin
Role required: workflow_admin, workflow_creator, or admin

Procedure
1. In the navigation filter, enter wf_workflow.list, and then open one of the workflows.
2. In the Versions related list, check for all of the following conditions:
   a. There is only one workflow version in a state of Checked out and Checked out by.
   b. There is only one version and it is not checked out. This version must be both Active and Published.
      You may need to personalize the list and add the Active column.
   c. If there are multiple versions, only one is Published.

These checks determine the only two conditions under which a workflow can run:
• A checked out version of a workflow is available for the user who has it checked out.
• A valid, published version of a workflow is available for all users who have permission to run the workflow.
Main flows containing subflows that do not meet one of these two conditions are not permitted to execute against a current record transaction. Instead, a critical log entry detailing the subflow state is added to the Workflow Context record. To enable the workflow to execute on the next appropriate transaction, remove the subflow from the main flow or modify the published and active states of the subflow.

**Edit a published workflow**

You can edit a published workflow after you check it out.

**Before you begin**

Role required: workflow_admin, workflow_creator, workflow_publisher, or admin

**About this task**

⚠️ **Note:** You cannot check out or delete workflows that are associated with a read-only application file.

To check out a workflow:

**Procedure**

1. Navigate to **Workflow > Workflow Editor**.
2. Open the workflow that you want to edit.
3. In the title bar, click the menu icon and select **Checkout**.
   - A new version of the workflow is created and assigned to you.
   - If you are in a different domain than the published workflow, the new workflow version is created in your domain.

**What to do next**

After you finish editing the workflow, validate and publish the workflow to make the new version available to other users.

**Copy a workflow between two application scopes**

Application scoping protects applications by identifying and restricting access to application files and data. You can copy a workflow created in one application scope (for example, Test) to another (Production) as needed.

**Before you begin**

Role required: admin
Procedure

1. On the Home page, click  located next to the logged in user name.
2. In the Developer tab, in the Application field, select the application scope (for example, Test) in which you want to operate the ServiceNow platform.
3. Close the System Settings page.
4. Navigate to Workflow > Workflow Editor.
5. Create a workflow in the Workflow Editor. For more details, see Create a workflow.
6. In the Workflow Editor, click  i.
7. In the Application tab, Application is set to the current application scope selected in System Settings.
8. In Accessible from, select All application scopes if the workflow is available to all application scopes, or select This application scope only if it is only available to, and accessible in the current application scope only. Only those workflows that are accessible from all application scopes can be copied to another application scope.
9. Go back to the Homepage, click  .
10. In the Developer tab, in the Application field, select the application scope (for example, Production) to which you want to copy the workflow.
11. Navigate to Workflow > Workflow Editor.
12. Refresh the page, then open the same workflow you created. An Out of scope workflow, workflow belongs to <scope name> scope message appears, where <scope name> is the application scope in which the workflow was originally created.
13. In the Workflow Editor, click  .
14. Select Copy.
The Workflow Name dialog appears:

   Workflow Name
   Workflow Name
   New_Workflow_Name
   Cancel
   OK

   a. In Workflow Name, type the new name for the copied workflow.
   b. Click OK. The system creates a workflow in the current application scope.
15. In the Workflow Editor, click ![i](image).

16. In the Application tab, Application is set to the current application scope.

17. In Accessible from, select This application scope only if to make the newly copied workflow a private one that cannot be accessed from outside current scope.

18. Click Update.

**Results**

A new workflow record is created in the selected application scope and marked as private if designated as one in the Workflow Editor.

**Workflows used as subflows**

A workflow can launch another workflow as an activity.

The parent workflow triggers the subflow and then waits for the subflow to complete before continuing. Run the workflow validation tool prior to publishing to detect missing subflows and other dependency problems, such as those involving update sets.

The Workflows tab in the Workflow Editor contains a list of the workflows available for use as subflows.

![Workflows available to use as subflows](image)

Make sure that the selected subflow is active. If the subflow is inactive, the main workflow will hang with a **Loading** message. If you place an inactive subflow into
a workflow, the subflow appears with a red banner, indicating that it cannot run. An active subflow is highlighted in blue when selected.

![Workflow with active subflows](image)

**Subflows and the Create Task activity**

If a workflow contains a **Create Task** activity that has executed on the current record, additional task activities in the workflow might not execute as expected. This can happen when the same subflow containing a Create Task activity runs more than once in a parent flow. When the subflow reruns and attempts to execute the **Create Task** activity again, the system reopen the first task activity instead and does not create an additional task.

ℹ️ **Note:** An alternative to creating duplicate subflows that use the **Create Task** activity is to add a **Run Script** activity to the workflow that creates a task with a script.
The same create task activity runs twice in a workflow

In this configuration, the workflow does not run the same subflow containing a **Create Task** activity more than once. This allows the workflow to create additional tasks.

Running different subflows containing the Create Task activity

Pass a variable from a workflow to a subflow

Use this process to pass variables from a parent workflow to a subflow.

**Before you begin**
Role required: workflow_admin, workflow_creator, or admin

**About this task**

**Note:** You can also use the **Return Value** activity in the subflow to return values to the parent workflow. Make sure to have a **Return Value** on every ending transition path.
**Procedure**

1. Prepare the subflow to accept variables from the parent workflow by defining the inputs.

2. Include the subflow in the parent workflow and connect the inputs to the parent workflow variables.

   **Note:** You cannot pass variables to a subflow that runs on the Requested Item [sc_req_item] table.

**Define inputs for a subflow**

Define the input variables for a workflow to request from parent workflows when it is launched as a subflow.

**About this task**

All inputs are stored in the Variables [var_dictionary] table.

**Procedure**

1. In the editor, open and check out the workflow.

2. In the title bar, click the menu icon and select *Edit Inputs*.

3. In the Workflow Inputs window, click *New*.

4. Populate the record with the definition of the variable, including the column name, the label that is displayed to the user, and the type of field.

5. Click *Submit*.

**Invoke a subflow in a workflow**

Use this procedure to add a subflow to a workflow.

**Procedure**

1. In the Workflow Editor, open and check out the parent workflow.

2. Drag the subflow from the *Workflows* tab to the parent workflow.

3. In the New Activity dialog box, define the variables defined by the subflow's *Inputs*.

   These fields can accept both static values or variables in the following format:

   `${variable_name}`
4. Click **Submit**.

   The workflow triggers the subflow at the appropriate time and passes the variables as indicated by the **Inputs** definition.

Prepare a subflow

Review the process of preparing a subflow for use in a parent workflow, and for preparing the parent workflow to use a subflow.

**Procedure**

1. In the editor, open and check out the workflow that you want to use as a subflow.

2. In the title bar, click the menu icon and select **Edit Inputs**.

3. In the Workflow Inputs window, click **New** in the **Variables** list.

4. Add a new variable depending on the type of values that it is going to store.

   The following example sets up a string value.
5. Click Submit.

6. Close the Workflows Inputs dialog.

7. Create a Run Script activity on the subflow.
   - Set the value from the parameter to a field on the current form. This is important because the Notification activity can only pull values from the current variable and not from the newly added variable. The following example sets the value in the Description field.

   ```javascript
   current.description = workflow.inputs.bluesubvariable;
   ```
   - Create a new field on the request form but do not display the field. This serves as temporary storage.

8. Create a Notification activity on the subflow. Use `${description}` in the subject to return the value from the field.
This is what the subflow would look like:

![Subflow Diagram]

**Prepare a workflow to use a subflow**

After you create a subflow, use this procedure to prepare the parent workflow.

**Procedure**

1. On the parent workflow, create a variable similar to what you did on the subflow, but name it something different.
   
   In the following example, the variable is named **Blue Main Variable**.
2. Click Submit.

3. Insert a Run Script activity to return the value from a field to the newly created variable.

   In this example, the value of the Short Description field is returned and given to the newly created variable.

   \[
   \text{workflow.scratchpad.bluemainvariable} = \text{current.short_description};
   \]

4. Click Submit.

5. In the subflow activity, set the Blue Sub Variable to pass the bluemainvariable to the bluesubvariable.

   \[
   \text{@{workflow.scratchpad.bluemainvariable}}
   \]
This is what the main workflow looks like:

![Workflow Diagram]

**Using variables in a workflow**

Within workflow there are several different types of variables that are available. Some variables define, describe, or compose the pieces of the workflow (such as workflow activities). Some variables are available specifically to facilitate the execution of a workflow (such as scratchpad variables). Some variables define, describe, or compose the data records being manipulated by the workflow process (for example, the elements of a Glide Record that are defined in a dictionary.xml file describing a record, such as an incident).

**Activity variables**

Activity variables are properties specifically associated with a workflow activity.

**About this task**

These are the inputs that appear on the activity definition when a specific activity is dragged onto the workflow canvas. These variables are properties that define, compose or describe the workflow activity, or the work it is designed to perform.

Activity variables are declared in a related list within the Workflow Activity Definition.

To add, view, or modify a variable:

**Procedure**

1. Navigate to **Workflow > Activity Definitions**.
2. Select a workflow activity, such as **Approval - User**.
3. In the **Activity Variables** section or tab, add, view, or modify the variables. Activity variables are defined using the same fields as Dictionary records.

**Note:** If defining a new activity variable that is dependent on another activity variable, put the prefix "vars." before the name of the parent activity variable. For example, if the child field is dependent on a field named `parent`, put the value `vars.parent` in the **Dependent** field.
To control the visibility of an activity variable on the workflow canvas after the activity has been dragged to the canvas, use a UI policy on the wf_activity table. To access the variables or assign values to these variables within the workflow activity, use the vars variable of the workflow activity.

```
activity.vars.variable_name = new_variable_value
```

**Workflow input variables**

Workflow variables are external values that are passed into and referenced by a workflow during its execution.

**About this task**

Workflow variables can be declared externally in a script and passed into a main workflow or they can be declared within a main workflow and passed as inputs to a subflow.

*Note:* There is a specific kind of input variable for any workflow that is declared against the table Requested Item [sc_request_item]. To understand the use of these variables see Workflow catalog variables.

Workflow variables are declared in a form available from the Workflow Editor gear menu.

To add, view, or modify a variable:

**Procedure**

1. Navigate to **Workflow > Workflow Editor**.
2. Edit and checkout a workflow.
3. Select the Workflow Activities menu and select **Edit Inputs**.
4. Select an existing variable or click **New**.

   - Note the **Column name** field. Use this value when accessing the variable from a script.

Workflow variables do not appear on the workflow canvas, they are only available for view from the Workflow Activity menu.

The input variables are available to use in scripts. To access an input variable from a script:

```
var input  = workflow. variables. variableName //get the workflow variable identified by column name.
```
Assigning values to variables from outside of workflow

After being declared in a workflow, values can be assigned to the variables from where the workflow is kicked off.

The following example demonstrates how a workflow variable’s value can be set in a script include, business rule, or UI action:

```javascript
//Declare an instance of workflow.js
var wf = new Workflow(); //Get the workflow id
var wfId = wf.getWorkflowFromName("Workflow Name");
//Start workflow, passing along name : value pair(s) for mapping to variable
//where input_var_name is the name of the variable declared in gear menu
//and input_var_value is whatever that value should be for this execution of
//workflow
wf.startFlow(wfId, null, "Workflow Name", {input_var_name: input_var_value});
```

Another example that demonstrates a more readable way of passing multiple variables involves declaring an object, adding the names/values to the object, and passing it:

```javascript
//Declare an instance of workflow.js
var wf = new Workflow(); //Get the workflow id
var wfId = wf.getWorkflowFromName("Workflow Name");
//Start workflow, passing along object containing name/value pairs mapping to inputs
//expected by the workflow
var vars = {};
vars.input_var_name1 = input_var_value1;
vars.input_var_name2 = input_var_value2;
// add as many variables as your workflow is expecting, then pass the object
wf.startFlow(wfId, null, "Workflow Name", vars);
```

Assigning Values for Subflow Inputs from inside of a Main Workflow

If a workflow that accepts inputs is called from within another workflow, those input values can be set from the workflow canvas within the UI of the workflow activity. Each input variable declared for a subflow will have a text box input area displayed on the activity. Within these text boxes, the variables can be set with any value either from the scratchpad or from within the current record.

For more information, see Workflows used as subflows.

Reading the Value of a Workflow Input Variable

The value of a Workflow input variable is accessible anywhere within the workflow that accepts javascript by dot walking the current workflow object:
Workflow scratchpad variables

Store and share string-based variables as name-value pairs between workflow activities.

The scratchpad is global to the instance of the running workflow and as such, is available equally to all activities.

Declaration

The scratchpad itself is automatically available to an executing workflow and requires no specific declaration. Variables are declared and stored in the scratchpad simultaneously by referencing it. For example:

```javascript
workflow.scratchpad.variableName = variableValue;
```

Display

View activity scratchpad values from the Workflow Activity History Scratchpad [wf_history_scratchpad] table. Workflow Activity History Scratchpad is also an embedded list in Workflow Activity History records.

Sample Workflow Activity History Scratchpad records

Access and Assignment

Use standard JavaScript object notation to access or assign scratchpad values. For example, use this format to assign a particular scratchpad variable value.

```javascript
var readValue = workflow.inputs.variable_name;
```
Workflow.scratchpad.variableName = variableValue;

Use this format to assign a JavaScript variable to a scratchpad variable.

var myValue = workflow.scratchpad.variableName;

Current variables

Current is the database GlideRecord that kicked off the workflow, either by association to the table in the Workflow properties table or by being associated with a catalog item.

Declaration

Variables in current are the columns that are defined in the dictionary.xml file that support the database record. There is no way at runtime to add variables to the current record.

Display

Variables of a current record are displayed on the Glide Forms and Lists throughout the applications that use them.

Access and Assignment

To access the variables or assign values to the variables within the workflow activity, get the value from the current record by referencing the Glide Element.

var myVarValue = current.getElement(nameOfTheField);

or

var myVarValue = current.fieldName;

or

current.variableName.setValue( "A Variable Value");

Workflow catalog variables

Workflows that are associated with the Requested Item [sc_req_item] table have a specific type of workflow input.

The inputs into this workflow are essentially question:answer pairings that, when associated with a specific catalog task, become options on the task form. These options are generated by that catalog task activity within a workflow.
**Scope**

For the purposes of Service Catalog and workflow, a variable’s scope determines its availability to a catalog task activity within a workflow. You can define variables as global or catalog item-specific. When a variable is associated to a catalog item and the workflow generating the catalog task is associated to the catalog item, the variable scope determines which variables are available for mapping within the catalog task activity in a workflow. If a workflow is associated with Requested Item [sc_request_item], and is not specifically associated with a catalog item, any catalog variable with a blank Cat Item field value is available to all catalog task activities within the workflow.

**Declaration**

You can declare requested item catalog variables at the catalog item level or at a global level.

**About this task**

You can declare global catalog variables using the Workflow Editor context menu.

Also see, Global variable declaration option 2.

**Procedure**

1. Navigate to Workflow > Workflow Editor.
2. Open and check out a workflow that runs against the Requested Item [sc_req_item] table.
3. Click the menu icon and select Edit Catalog Variables.
4. Click New to create a new variable or select an existing variable.
5. Select the Global check box.
6. Click Submit.

**Global variable declaration option 2**

You can declare global catalog variables using the Service Catalog.

**Procedure**

1. Navigate to Service Catalog > Item Variables.
2. The list of variables that appears in the workspace has a default filter of Cat Item !=<blank>. Change the filter to Cat Item = <blank> and run the query.
The catalog variables that appear are available to any catalog task that is initiated from within a workflow.

3. Click **New** to create a new variable.
4. Leave the **Cat Item** field blank.
5. Select the **Global** check box.
6. Click **Submit**.
   Also see, [Global variable declaration option 1](#).

**Catalog item specific variable declaration option 1**
You can declare a catalog item-specific variable.

**About this task**
These variables are only available to the catalog item referenced in the **Cat Item** field on the variable record.

**Procedure**
1. Navigate to **Service Catalog > Catalog Variables > Item Variables**.
   Note the list of variables that appears in the workspace has a default filter of **Cat Item != <blank>**.
2. Enter or select a catalog item in the **Cat Item** reference field.
   Selecting a **Cat Item** restricts the scope and availability of the catalog variable to that specific catalog item.
3. Click **Submit**.
   Also see, [Catalog item specific variable declaration option 2](#).

**Catalog item specific variable declaration option 2**
You can declare a catalog item-specific variable directly from a catalog item record.

**About this task**
Creating a catalog variable in this way automatically sets the **Cat Item** reference to the catalog item selected.

**Procedure**
1. Navigate to **Service Catalog > Catalog Definitions > Maintain Items**.
2. Select or create an a catalog item.
Note the **Variables** related list. All variables declared using this related list have a **Cat Item** reference value of the current catalog item.

3. From the **Variables** related list, click **New**.

4. Ensure that the **Cat Item** field correctly references the catalog item previously selected or created.

5. Go to or open the **Question** section or tab.

6. Add a **Question**.

7. Add a **Name**.
   Variable names should not include white space and cannot begin with a number.

8. Click **Submit**.
   Also see, *Catalog item specific variable declaration option 1*.

---

**Display**

Catalog specific item variables are visible in several places depending on where in the process the variable is viewed.

Declaration can happen and variables can be seen from within the menu, inside both the **Maintain Items** module and in the **Item Variable** modules of the Service Catalog.

Within a workflow, the Catalog Specific Item variables are available to the **Catalog Task** activity in the form of a slushbucket at the bottom of the **Catalog Task** activity. Item variables that are selected, are the question and answer pairs that will appear on the task that is generated by that instance of **Catalog Task** when executing that workflow.

If a workflow is associated with a specific catalog item, the association acts as a filter for item variables that appear in the slushbucket of the **Catalog Task** activity.

The last place the variables are seen is in the task form that is generated by the **Catalog Task Item**. The variables selected in the slushbucket are the question and answer pairs that appear to the user on the task form.

**Access and assignment**

The Catalog Item Variables are available and assigned to a specific **Catalog Task** activity (thereby to a specific task) using the slushbucket entry of a catalog task.

The user working the task enters the values of the variables.

To access the values of a Catalog Item Variable inside a script:
var now_GR = current; // or create and query a new GlideRecord
var itemVariable = now_GR. variables[variableName]; //access the service catalog variable identified by the variable name.
var itemVariableValue = itemVariable.getValue();
var itemVariableName = itemVariable.getName();
var itemQuestion = itemVariable.getQuestion(); //All GlideappQuestion API are accessible on itemQuestion

Workflow events

The system employs two types of events: registered platform events and workflow events.

Registered platform events

Registered events are created in business rules and are used for such tasks as sending email notifications when records are inserted into the database. Workflow events are registered within workflows only and are not used anywhere else in the platform. Registered platform events can be triggered by a workflow for external use, but cannot be used within a workflow.

Workflow events

Workflow events follow different rules than platform events that are registered using the event registry. Platform events are entered into the Event Registration [sysevent_register] table and are available for platform processes to use. Workflow events are triggered exclusively for the workflow engine and are used only to direct the work of executing workflow contexts. When an event is registered in a workflow, it is attached to a currently executing activity in the registered_events column of the Workflow Executing Activity [wf_executing] table.

Workflow events also can be broadcast to a workflow from any scripting source that has access to the workflow context, such as a script include or a Run Script activity. In this case, the event, such as cancel, is passed to all records in the Workflow Executing [wf_executing] table for a specific context.

Whether by registry or by broadcast, an event is handled by the activity definition associated with the currently executing activity. Each activity definition comes with a set of handlers. For example, most activities come with onExecute, onCancel, and onUpdate event handlers. As an example of a more specific event, the Approval - User activity also comes with onDetermineApprovalState, which is specific to the work of the approval activity.
Multiple parallel events

A single workflow can have multiple event threads running concurrently, such as when a workflow has timers that overlap on separate workflow branches. If any additional thread completes before the first thread, the system stores event information from the additional thread on the Workflow Queued Commands [wf_command] table. After the first thread completes, the system retrieves the information stored by the additional thread and proceeds through the workflow with the event information from each thread.

Workflow events in the base system

Several workflow events are available in the base system.

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
<th>Purpose</th>
<th>To use</th>
</tr>
</thead>
<tbody>
<tr>
<td>activityComplete</td>
<td>String value used by activity definitions to respond to the onActivityComplete event handler.</td>
<td>Informs records in the Workflow Executing Activity [wf_executing] table about the completion of other activities in the same workflow context.</td>
<td>If the activity is allowed to set the boolean value for <code>wf_executing.notify_termination</code>, then set the value to <code>true</code> (activity.notify_termination = true) during the onExecute event.</td>
</tr>
<tr>
<td>otherEvent</td>
<td>String value used by the Join activity to respond to an otherEvent.</td>
<td>Informs records in the Workflow Executing Activity [wf_executing] table about an otherEvent that has completed.</td>
<td>The Join activity transitions from n number of preceding activities. These preceding activities create a wf_executing record which causes a check to see if the record already exists; the Join already exists, then the Join created by the execute transition sets the wf_executing record for deletion.</td>
</tr>
<tr>
<td>timer</td>
<td>String value used by workflow activities to respond to a timer.</td>
<td>Allows wf_executing records to be informed about a timer</td>
<td>The Timer activity schedules a job that calls a script. The script fireEvent (wf_executing, timer).</td>
</tr>
<tr>
<td>Event</td>
<td>Description</td>
<td>Purpose</td>
<td>To use</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Timer activity that has expired.</td>
<td>activity that has completed and has fired the timer event.</td>
<td><strong>execute</strong>&lt;br&gt;String value used by workflow activities to respond to a <strong>Timer</strong> activity that has expired.</td>
<td>The workflow engine, for each transition executed, creates an executing record with a state of <strong>Executing</strong>. Once created, the executing record is put in a queue for processing. For each item in the queue, the Rhino globals are established, the activity definition that drives the executing record is instantiated, and the <code>run()</code> function is called. When the state of a record is <strong>Executing</strong>, this function always calls <code>onExecute</code>.</td>
</tr>
<tr>
<td>execute (specific to <strong>Lock</strong>)&lt;br&gt;String value used by the <strong>Lock</strong> activity to respond to a waiting lock that is ready to make another attempt to obtain a specific lock. This execute is different than the previous execute because it is called on a separate thread, at specified intervals, and is treated as an outside event.</td>
<td>Informs a wf_executing record waiting to execute that the specified wait interval has passed and that it should attempt to get the lock again.</td>
<td><strong>Lock</strong> activity schedules a job with a script that uses the workflow script include's <code>fireEvent(wf_executing,'execute')</code> method.</td>
<td></td>
</tr>
<tr>
<td>Event</td>
<td>Description</td>
<td>Purpose</td>
<td>To use</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>determineApprovalState</td>
<td>String value used by approval activities to respond to a change in the overall approval status of the current record.</td>
<td>Informs wf_executing records for approval activities about an approval that completed and triggered the timer event.</td>
<td>Approval Coordinator both registers for the event and triggers the event. The child approvals have listeners that determine their approval state.</td>
</tr>
<tr>
<td>cancel (from within activity definitions)</td>
<td>String value used by workflow activities to respond to a request for cancellation.</td>
<td>Informs all wf_executing records in a context that the workflow is being canceled.</td>
<td>The End activity uses the global workflow.broadcastEvent('cancel') to interrupt the currently running wf_executing records. This changes the state of those records to Cancelled.</td>
</tr>
<tr>
<td>cancel (outside current context)</td>
<td>String value used by workflow activities to respond to a request for cancellation.</td>
<td>This event is the same as the cancel event above and handled the same. However, the management of this event is subtly different. This event informs all wf_executing records in a context that the workflow is being canceled. The event is managed via Any script can call cancel on a known executing context via the workflow script include. For example, var w = new Workflow(); w.cancel(context); //where context is a GlideRecord of the context to be canceled.</td>
<td></td>
</tr>
</tbody>
</table>
### Workflow events in the base system

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
<th>Purpose</th>
<th>To use</th>
</tr>
</thead>
<tbody>
<tr>
<td>stop (see <strong>End activity</strong>)</td>
<td>The <strong>End</strong> activity checks for this event.</td>
<td>If the stop event is the current event, then the cancel operation of the <strong>End</strong> activity is bypassed.</td>
<td>Only in the <strong>End</strong> activity.</td>
</tr>
</tbody>
</table>

The `onCancel` event handler of each executing activity definition, but the event is called differently. In particular, the call to cancel from outside an activity definition is blocked by the current mutex. This is a significant difference in that the event does not interrupt a currently executing activity that is still operating within the parameters of the current mutex.
Workflow events in the base system (continued)

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
<th>Purpose</th>
<th>To use</th>
</tr>
</thead>
<tbody>
<tr>
<td>listener</td>
<td>String value that the workflow (subflow) activity triggers as an event.</td>
<td>When a main workflow calls a subflow, the workflow keeps the ID of the subflow’s context in the scratchpad. When the subflow is complete, it triggers the listener event via a business rule.</td>
<td>The listener event is passed to the parent context on completion of a subflow and is managed via the \texttt{onListener} action of the workflow activity.</td>
</tr>
<tr>
<td>probe_complete</td>
<td>String value triggered in the workflow by an Orchestration activity indicating that the MID Server has completed a task.</td>
<td>The \texttt{probe_complete} event is triggered from Orchestration sensor processors via the workflow helper function \texttt{handleEventById}.</td>
<td>The \texttt{onProbe_complete} event handler is in the \texttt{WebServiceActivityHandler} and is used by most Orchestration activities.</td>
</tr>
<tr>
<td>pause</td>
<td>String value sent to a workflow from an SLA to pause the \texttt{Timer} activity.</td>
<td>When an SLA is paused, the SLA workflows must be paused if there is a timer running.</td>
<td>Use is exclusive to the SLA activity.</td>
</tr>
<tr>
<td>resume</td>
<td>String value used by the \texttt{Timer} activity to resume a paused timer (see pause).</td>
<td>When an SLA is resumed, the SLA workflows must be resumed as well.</td>
<td>Use is exclusive to the SLA activity.</td>
</tr>
</tbody>
</table>

Glide events relative to workflows

Workflow uses several Glide events.
## Workflow Glide events

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
<th>Purpose</th>
<th>To Use</th>
<th>Source</th>
<th>Thread</th>
<th>Listeners</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Insert</strong></td>
<td>Global event set upon the insert of a GlideRecord that causes the script engine, and through that the workflow engine, to wake up.</td>
<td>Starts workflows that are associated with the current GlideRecord either by reference, as in request items and SLA timers, or by conditions associated with the GlideRecord's table.</td>
<td>There is no explicit customer-facing use for this in a workflow. It is part of the Glide engine, and with this event, the only thing workflows can do is start. Workflows can also be started manually using a script.</td>
<td>Workflow Engine, RunEngine</td>
<td>Current thread, current mutex</td>
<td>User action of insert</td>
</tr>
<tr>
<td><strong>Update</strong></td>
<td>Global event set upon the update of a GlideRecord that causes the script engine, and through that the workflow engine, to wake up.</td>
<td>Looks to the Workflow Context [wf_context] table to find running workflows that are associated with the current GlideRecord by document ID.</td>
<td>There is no explicit customer-facing use for this in a workflow. It is part of the Glide engine, and with this event, the only thing workflows</td>
<td>Workflow Engine, RunEngine</td>
<td>Current thread, current mutex</td>
<td>User action of update of a GlideRecord</td>
</tr>
</tbody>
</table>
### Workflow Glide events (continued)

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
<th>Purpose</th>
<th>To Use</th>
<th>Source</th>
<th>Thread</th>
<th>Listeners</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Global event set upon the delete of a GlideRecord that causes the script engine, and through that the workflow engine, to wake up.</td>
<td>Looks to the Workflow Context [wf_context] table to find running workflows that are associated with the current GlideRecord by document ID.</td>
<td>There is no explicit customer-facing use for this in a workflow. It is part of the Glide engine, and with this event, the only thing workflows can do is advance through the next set of transitions.</td>
<td>Workflow Engine, RunEngine</td>
<td>Current thread, current mutex</td>
<td>User action of delete of a GlideRecord</td>
</tr>
<tr>
<td>Query</td>
<td>Global event set upon the query of the Glide database that causes the script engine, and through that the workflow</td>
<td>Looks to the Workflow Context [wf_context] table to find running workflows that are associated with the current GlideRecord</td>
<td>There is no explicit customer-facing use for this in a workflow. It is part of the Glide engine, and with this event, the only thing workflows can do is advance through the next set of transitions.</td>
<td>Workflow Engine, RunEngine</td>
<td>Current thread, current mutex</td>
<td>User action of query of a GlideRecord</td>
</tr>
</tbody>
</table>
Workflow Glide events (continued)

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
<th>Purpose</th>
<th>To Use</th>
<th>Source</th>
<th>Thread</th>
<th>Listeners</th>
</tr>
</thead>
<tbody>
<tr>
<td>engine, to wake up.</td>
<td>by document ID.</td>
<td>the only thing workflows can do is advance through the next set of transitions.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Workflow event-specific functions

There are several functions that relate specifically to workflow events.

Workflow event-specific functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Purpose</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>registerForEvent (eventName)</td>
<td>Function in the workflow environment that writes events represented as strings to the \texttt{wf_executing.registered_events} field.</td>
<td>The workflow events are just strings. When an activity that has registered for an event executes, a comma delimited set of events is stored with the Workflow Executing Activity [wf_executing] record. When the event is triggered in the workflow context, the \texttt{wf_executing} table looks for all executing records that contain the string that represents the event in the \texttt{wf_executing.registered_events} field.</td>
<td>The global variable workflow that is available to all Workflow Activity [wf_activity] records is the source of the call. For example, from inside a Run Script activity, a designer can write: <code>workflow.registerForEvent('myEventName');</code></td>
</tr>
<tr>
<td>unRegisterForEvent (eventName)</td>
<td>Function in the workflow environment that removes a string value representing an event that has been written to the \texttt{wf_executing.registered_events} field.</td>
<td>The workflow events are just strings that are written to the \texttt{wf_executing.registered_events} field. When an activity unRegisters for an event, the comma delimited set of events stored with the workflow that is available to all Workflow Activity [wf_activity] records is the source of the call. For example, from inside a Run Script activity, a designer can write: <code>workflow.unRegisterForEvent('myEventName');</code></td>
<td></td>
</tr>
</tbody>
</table>
## Workflow event-specific functions (continued)

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Purpose</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>fireEvent(eventName)</td>
<td>Function in the workflow environment that examines the contents of the <code>wf_executing.registered_events</code> field, comparing its contents to the <code>eventName</code> passed in.</td>
<td>The workflow events are just strings that are written to the <code>wf_executing.registered_events</code> field. When <code>fireEvent(eventName)</code> is called by a workflow activity, the workflow engine queues up any executing records that contain the string in the registered field.</td>
<td>Thread = current thread, current mutex Global variable workflow</td>
</tr>
<tr>
<td>fireEvent(eventRecord,eventName)</td>
<td>Function in the workflow environment that sends an event to a specific Workflow Executing Activity [wf_executing] record. The <code>eventRecord</code> is a GlideRecord of the type <code>wf_executing</code>.</td>
<td>This event call expects an <code>onMyEvent</code> event handler in the activity represented in the event record (Workflow Executing Activity [wf_executing] table). When <code>fireEvent(eventRecord, eventName)</code> is called by a workflow activity, the workflow engine queues up the specific executing record with that event and passes the event into the activity definition for the <code>on&lt;eventName&gt;</code> handler to manage. This event is queued up in its own mutex, so the current queue completes before this event is processed.</td>
<td>Thread = current thread, current mutex Global variable workflow</td>
</tr>
<tr>
<td>fireEvent(eventRecordSysId, eventName)</td>
<td>Function in the workflow environment that sends an event to a specific Workflow Executing Activity [wf_executing] record. The <code>eventRecordSysId</code> is the <code>sys_id</code></td>
<td>This is the same as the <code>fireEvent</code> above, except that it accepts an ID and returns the Workflow Executing Activity [wf_executing] record.</td>
<td>Thread = current thread, current mutex Global variable workflow</td>
</tr>
</tbody>
</table>
### Workflow event-specific functions (continued)

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Purpose</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>fireEvent (eventRecordSysId, eventName, optionalJSONObject)</td>
<td>Function in the workflow environment that sends an event to a specific Workflow Executing Activity [wf_executing] record. The <code>eventRecordSysId</code> is the sys_id of a GlideRecord of the type <code>wf_executing</code>.</td>
<td>This is the same as the <code>fireEvent</code> above, except that it accepts a JSON object as a third parameter. This object can specify any data expressible as JSON. You can also specify additional functionality when creating a workflow activity.</td>
<td>The <code>Workflow</code> script include contains the call for this. For example, from inside a Run Script activity, a designer can write: <code>var w = new Workflow(); w.fireEvent(executing, eventName, JSONObject);</code></td>
</tr>
<tr>
<td>broadcastEvent (contextId, eventName)</td>
<td>Function in the workflow environment that sends an event to all currently running Workflow Executing Activity [wf_executing] records in a specified context, regardless of their state.</td>
<td>This is the same as the <code>fireEvent</code> above, except that it accepts an ID and returns the Workflow Executing Activity [wf_executing] record.</td>
<td>The <code>Workflow</code> script include contains the call for this. For example, from inside a Run Script activity, a designer can write: <code>var w = new Workflow(); w.broadcastEvent(contextId, eventName);</code></td>
</tr>
<tr>
<td>broadcastEvent (eventName)</td>
<td>Function in the workflow environment that sends an event to all currently running Workflow Executing Activity [wf_executing] records in the current context, regardless of their state.</td>
<td>This should not be confused with <code>broadcastEvent</code> above. This event is only available to current Workflow Executing Activity [wf_executing] records.</td>
<td>This is available only through the global workflow variable of the current context. The following is an example of its use from within an activity definition's script: <code>workflow.broadcastEvent(eventName)</code></td>
</tr>
</tbody>
</table>

### Event-specific workflow activities

The following workflow activities trigger events.

<table>
<thead>
<tr>
<th>Activity Name</th>
<th>Description</th>
<th>Purpose</th>
<th>To Use</th>
<th>Source</th>
<th>Thread</th>
<th>Listeners</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Event</td>
<td>Requires an event from the event</td>
<td>Fires the notification event specified</td>
<td>1. Navigate to System Policy &gt; Events &gt; Registry</td>
<td>Event Registry</td>
<td>Triggered in the current thread and handled on</td>
<td>On the notification thread of workflow</td>
</tr>
</tbody>
</table>
### Event-specific workflow activities (continued)

<table>
<thead>
<tr>
<th>Activity Name</th>
<th>Description</th>
<th>Purpose</th>
<th>To Use</th>
<th>Source</th>
<th>Thread</th>
<th>Listeners</th>
</tr>
</thead>
<tbody>
<tr>
<td>registry</td>
<td>registry rather than a workflow event. This activity is located in the Notification category of the workflow tree.</td>
<td>in the Workflow Activity [wf_activity] table.</td>
<td>2. Create an event.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Navigate to System Policy &gt; Templates and create an email template.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Navigate to System Policy &gt; Email &gt; Notifications.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. Create a new notification that is triggered by the event you created and sends the template you created.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6. On the workflow canvas, drag the Create Event activity onto the canvas and associate it with the newly registered event.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When the workflow executes, the event is created

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Event-specific workflow activities (continued)

<table>
<thead>
<tr>
<th>Activity Name</th>
<th>Description</th>
<th>Purpose</th>
<th>To Use</th>
<th>Source</th>
<th>Thread</th>
<th>Listeners</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait for WF Event</td>
<td>Listens for workflow events, as described in the Workflow Events in the Base System table, and only within the current context. This activity is located in the <strong>Conditions</strong> category of the workflow tree.</td>
<td>Waits for another transition branch of the current context to trigger an event.</td>
<td>Takes an event name as input. When the activity is executed, the specified event name is added to a string array stored in the <strong>registered_events</strong> column. The values in this column are in a list of all events the activity waits for when it is executing.</td>
<td>The <strong>Wait for WF Event</strong> activity has a generic <code>onUnhandledEvent</code> that tests the current event against the value that was passed to the variable. If they match, the <strong>Wait for WF Event</strong> moves the workflow forward.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Workflow stages**

Workflows can indicate workflow progress by updating any field designated as a stage field.

For example, the Incident [incident] table has an **Incident state** field that indicates progress, but the service catalog uses the **Stage** field.

To indicate the workflow’s progress through the possible stage values, the interface updates the **Stage field** selected in the workflow properties. Available fields depend on the table used by the workflow. If the field provides a choice list, then the choices are available as stage values for the workflow. If the field is a workflow field, it displays an icon to indicate the workflow’s progress, as with the Service Catalog’s **Stage** field.
After stages are added to the workflow, they can be assigned to each workflow activity. If an activity with an assigned stage is encountered when the workflow runs, the workflow engine assigns the stage to the record associated with the workflow context.

For workflows that use the Requested Item [sc_req_item] table, the stage field is automatically set to the **Stage** field of the table and cannot be changed. The stage state displayed for a workflow running on the Requested Item table is based on the state of the workflow activities.

- If an activity is active, then the stage is shown with the state of **In progress**.
- If an activity is in the **Pending** or **Completed** state, the stage reflects this state.
- If an activity is canceled, **Request Cancelled** appears in the **Stage** field. The "Cancelled" label set in the wf_stage table is a reserved word, and does not display in the **Stage** field.

**How stage values are derived**

Stage values are derived from various sources in the interface.

ℹ️ **Note:** An updated method for managing workflow stages as a set is also available. For information about grouping and reusing stages, see [Workflow stage sets](#).

Stage values are derived from the following sources:

- **Choices for Stage column**: Choices defined for the column selected as the **Stage** column for the workflow.
- **Default stages for table**: Stages defined in the Stage Default [wf_stage_default] table for the table selected.
• **Workflow-specific stages**: Applied only to the workflow for which they were defined in the Workflow Stage [wf_stage] table.

• **Stage values in existing records**: Values from the designated Stage column in the table assigned to the workflow are inherited from existing records.

If the stage field for a workflow is the table column named **Stage**, then the progress of the workflow appears in any list view containing the Stage column.

**Stages in a list**

Stage values shown in the list views are accompanied by the state, based on the workflow activities being executed. If an activity has a stage specified for it, and the activity is currently active in the workflow, then the stage is shown with a state of **In progress**. Similarly, if the activity is in the **Pending** or **Completed** state, the stage reflects this state.

**Example**

If the workflow table is Request Item [sc_req_item], then the stage field is automatically set to the **Stage** column of that table and cannot be changed. The following stage values for the request item are displayed in a choice list from the Dictionary Entry [sys_dictionary] table:

- Waiting for Approval
- Fulfillment
- Delivery

In addition, the Request Item table has the following default stages:

- Request Cancelled
- Completed
**Note:** If an activity is cancelled, Request Cancelled appears in the **Stage** field. The "Cancelled" label set in the wf_stage table is a reserved word, and does not display in the **Stage** field.

When you edit available activity stages in the Workflow Editor, the list displays the following stage values:

- Waiting for Approval
- Fulfillment
- Delivery
- Request Cancelled
- Completed

The following diagram depicts the process used to gather stage values from the Request Item table to populate the **Stages** list in workflow activities.

**Note:** If you are creating a workflow with a table other than Request Item [sc_req_item], you must select a **Stage field** in the workflow properties for the workflow to have stages.

**Use workflow stages**

You can add or modify workflow stages.
Before you begin
Role required: workflow_admin, workflow_creator, or admin

Procedure

1. Navigate to **Workflow > Workflow Editor**.

2. Create a new workflow by clicking **New** or open an existing workflow.

3. In the Workflow Properties form, if the table is not the Requested Item [sc_req_item] table, select a field to display stages in the **Stage** field property. Available fields depend on the table selected for the workflow.

4. After assigning a list of stages to the workflow, you can set a stage value in any of the workflow activities that provide a **Stage** field in their dialog box. Setting a stage value in a workflow activity tells the workflow engine to assign that stage to the record associated with the workflow context when the activity is encountered during a run.

When an activity starts with a specified stage, the platform updates the **Stage** field with the current value. In workflows run against the Requested Item [sc_req_item] table, the **sc_req_item.stage** field is defined as a workflow type field.

When displaying the stages for a workflow on the Requested Item [sc_req_item] table, the stage state is based on the state of the workflow activities. If an activity has a stage specified for it, and the activity is currently active in the workflow, then the stage is shown with an **In progress** state. Similarly, if the activity is in the **Pending** or **Completed** state, the stage reflects this state.
5. To edit the workflow-specific stages for an existing workflow, click the gear icon in the header bar and select **Edit Stages**. Again, these stage values are combined with the choices, defaults, and existing values.

![Workflow editor interface](image)

**Example: Workflow stages**

To optimize the use of stages, you can assign a stage to multiple activities in a workflow. For example, if your workflow uses the following activities to create tasks:

1. Get approval
2. Order equipment
3. Receive equipment
4. Add equipment to CMDB
5. Set up equipment
6. Install software
7. Configure software
8. Deliver to user

The following stages might be used:
• Approval
• Order
• Configure
• Deliver

A good practice is to assign stages to the activities as follows:

<table>
<thead>
<tr>
<th>Activity</th>
<th>Assigned stage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get approval</td>
<td>Approval</td>
</tr>
<tr>
<td>Order equipment</td>
<td>Order</td>
</tr>
<tr>
<td>Receive equipment</td>
<td>Order</td>
</tr>
<tr>
<td>Add equipment to CMDB</td>
<td>Order</td>
</tr>
<tr>
<td>Set up equipment</td>
<td>Configure</td>
</tr>
<tr>
<td>Install software</td>
<td>Configure</td>
</tr>
<tr>
<td>Configure software</td>
<td>Configure</td>
</tr>
<tr>
<td>Deliver to user</td>
<td>Deliver</td>
</tr>
</tbody>
</table>

Examples of stages added to workflow activities

When the Order equipment, Receive equipment, or Add equipment to CMDB activity is active, the Stage display shows that the Order stage is In progress.

Add and translate stages

You can add default stages to use for a table, and stages to existing workflow

Add default stages for a table

You can assign a stage set as a default set to any number of tables.

About this task

The stages in the assigned stage set pre-fill the workflow version stages when you create a new workflow for the associated table.

Procedure

1. Navigate to Workflow > Default Stages (by table).
2. Click New.
3. Select a stage Set.
You can create a new set by clicking **New**, typing a name, and clicking **Submit**.

4. Select a corresponding **Table**.

5. Click **Submit**.

The stages in the selected stage set are automatically added to any new workflows that use the corresponding table.

### Add a stage to an existing workflow

If a stage required for a workflow has not been imported or is not in the stage set assigned to the workflow table, you can add it to the workflow manually.

**Procedure**

1. Navigate to **Workflow > Workflow Editor**.
2. Open and check out the workflow.
3. In the title bar, click the menu icon and select **Edit Stages**.
4. In the Workflow Stages list, click **New**.
5. On the Workflow Stage form, fill in the fields as appropriate.

   Do not use a **Name** or **Value** field value that already exists in the base system.

### Workflow stage fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the stage as it appears in workflow fields.</td>
</tr>
<tr>
<td>Value</td>
<td>The value of the stage when it is referenced from elsewhere in the system, such as in a script.</td>
</tr>
<tr>
<td>Duration</td>
<td>The default duration for the stage. Currently not used.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

7. Publish the workflow.

### Add a stage to a workflow activity

After stages are added to a workflow, you can assign them to the workflow activities.

**Procedure**

1. Navigate to **Workflow > Workflow Editor**.
2. Open and check out the workflow.
3. Double-click the activity.

4. In the **Stage** field on the Activity Properties form, find and select the stage to display when the workflow reaches the activity.

5. Click **Update**.

**Translate workflow stages**

You can provide translations for workflow stage names so the names appear in the language selected for the instance.

**Before you begin**
The instance must already have language internationalization plugins installed. For more information, see **Activate a language**.

**About this task**
Language-specific text appears in workflow fields displayed in a list, **workflow stage sets**, and the Workflow Editor for users with that language selected. Language-specific text does not automatically appear when displaying stages on a form. To translate stages on a form, add translated text to the workflow field choices.

You can add translated text for any language enabled on the instance. For example, to translate workflow stages into French:

**Procedure**

1. Set the interface language to **French**.
2. Navigate to **Workflow > Workflow Editor**.
3. Open and check out a workflow.
4. In the title bar, click the menu icon and select **Edit Stages**.
5. Edit the **Name** field for each stage and enter the text to display to French users.
   
   Do not change the **Value** field.
6. Confirm that the workflow stages display the French text.

**Results**
Alternatively, to translate stages for multiple workflows at once, you can directly edit the Workflow Stages [wf_stage] table. For example, to translate workflow stages from multiple workflows into French:
1. Set the interface language to **French**.

2. In the application navigation filter, enter `wf_stage.list`.

3. Edit the **Name** field for each stage and enter the text to display to French users. Do not change the **Value** field.

**Workflow stage sets**

Stage sets are named groups of workflow stages commonly used together. Create a stage set and assign it as a default set to any number of tables. You can import the choice list values of a workflow field as stages for a workflow, and export a stage set to create a new one.

A single stage set usually represents a process, such as the stages required to display the progress of a service catalog request. You can also assign a stage set as the default set for workflows on specific tables.

In an active context, workflow stages provide summary-level feedback about the progress of a workflow. Stage icons display the status of each activity as it is being driven by a workflow. The system updates a **Stage** field, defined in the workflow properties, to indicate the progress of the workflow through the possible stage values.

**Updates to workflow stage values**

During an upgrade, the system makes changes to the **Value** field of records in the Workflow Stage `[wf_stage]` table.

- All entries are made lowercase.
- All spaces and special characters are replaced with underscores.

These changes support and enable workflows to display translated text in the **Stage** field.

**Create a new stage set**

You can create a new stage set by creating a stage set record and adding stage set entries manually.

**About this task**

Create a stage set record only when you want additional stages that are not available on the table by default.
Procedure
1. Navigate to **Workflow > Stage Sets**.
2. Click **New**.
3. Enter a **Name** that indicates the purpose of the stage set.
   
   **Example**
   For example, you can create a Requested Item stage set to hold the stages commonly used by inventory tracking workflows or service catalog fulfillment workflows.
4. Click **Submit**.
5. Open the new stage set record.
6. In the **Stage Set Entries** related list, click **New**.
   Each stage set entry can be used as the **Stage** for an activity in a workflow that uses this stage set.
7. Enter a **Name** that indicates the stage name to appear in workflow fields.
8. Enter a **Value** to use when referencing the entry, such as in a script.
9. Click **Submit**.
10. In the **Stage Set Entries** related list, ensure that each entry has a unique **Order** value.
    Enter a low value for stages that should appear early in the workflow and a higher value for later stages.
What to do next
The stage set can be added to a workflow or assigned as the default stage set for workflows that are created for a specific table.

Use a default stage set
You can assign a stage set as a default set to any number of tables.

About this task
The stages in the assigned stage set pre-fill the workflow version stages when you create a new workflow for the associated table.

Procedure
1. Navigate to Workflow > Default Stages (by table).
2. Click New.
3. Select a Table.
4. Select the Set you want to assign to the selected table.
5. Click Submit.

Import stages from a choice list
You can import the choice list values of a workflow field as stages for a workflow.

Before you begin
Create a choice list as follows:
- Add a custom field of Type Workflow to the table.
- Configure the custom field to use a choice list.
- If you are creating a new field, set the Choice List type to Display without --None-- and create the choices for the newly created field.

For more information, see Create a workflow stage field.

Procedure
1. Navigate to Workflow > Workflow Editor.
2. Open and check out the workflow.
3. In the title bar, click the menu icon and select Properties.
4. In the Workflow Properties dialog box, click the Stages tab.
5. From the Stage field list, verify that the correct workflow field is selected.
6. In the Related Links section, click **Import Stages from Choice List**.
7. In the dialog box asking you to confirm that you want to import the choice list, click **OK**.
8. Click **Update**.

**What to do next**
The stage set can be added to a workflow or assigned as the default set for workflows that are created for a specific table.

---

**Export a stage set from a workflow**
You can create a new stage set by exporting the stages from an existing workflow as a set, instead of manually adding stage set entries to a stage set record.

**Procedure**

1. Navigate to **Workflow > Workflow Editor**.
2. Open and check out the workflow containing stages that you want to export as a new stage set.
3. In the title bar, click the menu icon and select **Edit Stages** to open the Workflow Stages dialog box.
4. In the Related Links section, click **Export to Stage Set**.
5. Enter a unique **Name** for the new stage set.
6. Click **OK**.

**What to do next**
The stage set can be added to a workflow or assigned as the default set for workflows that are created for a specific table.

---

**Add a stage set to a workflow**
You can add any number of stage sets to an existing workflow.

**About this task**
When multiple stage sets have stage set entries with the same **Value**, the stage appears on the workflow only once.
Procedure

1. Navigate to Workflow > Workflow Editor.
2. Open and check out the workflow.
3. In the title bar, click the menu icon and select Edit Stages to open the Workflow Stages dialog box.
4. In the Related Links section, click Import from Stage Set.
5. Select the stage set.
6. Click Ok.
7. Import additional stage sets as needed for the workflow.

What to do next
After you add all necessary stage sets to the workflow, you can add them to the workflow activities. For more information, see Add a stage to a workflow activity.

Create a workflow stage field
Workflows can provide a summary of workflow progress by updating any field of the Workflow type. If the field is a workflow field, it displays an icon to indicate the workflow stage progress.

Before you begin
Role required: admin

About this task
In a form, the workflow field displays the current stage as a choice list value.

In a list, the workflow field displays stage icons that represent the series of states, stages, phases, or tasks within a workflow. The stage icons are populated using the activity stages from the associated workflow. For more information, see Workflow stages.
To create a workflow stage field:

**Procedure**

1. Navigate to **Workflow > Default Stages (by table)**.
2. Right-click near a column header and select **Configure > List Layout**.
3. Create a new field in lower right.
4. On the form view of the table used by the workflow, create a field with the **Type** set to **Workflow**.
   For detailed steps, see .
5. Click **Save**.
6. Right-click the field label and select **Configure Dictionary**.
7. Open a dictionary entry.
8. In the Choice List Specification section of the Dictionary Entries form, select **Dropdown with --None--** from the **Choice** list.
9. Click **Update**.
10. To ensure that the workflow field properly displays stages on the form, define a choice for each workflow stage.
   - To create workflow stages using a choice list that already has choices, you can import the stages from the choice list. A stage is created for each choice defined for the **Stage field** selected in the workflow properties.
     For detailed steps about importing a choice list, see **Import stages from a choice list**.
   - The **Value** of each choice must match the **Value** of the corresponding workflow stage.
   - Do not use spaces in the **Value** field for either choices or stages. Use underscores in place of spaces.
   - Make the choice list read-only. If a user changes the stage value for a record from the choice list rather than allowing the workflow to control the value, the workflow-driven, legacy, and linear renders may not work as intended. You can also use business rules or events to ensure the workflow progresses accordingly.
     For detailed steps on defining choice lists, see .
11. To see workflow stages as icons, add the field to the list layout of the workflow table.
    For detailed steps, see .
What to do next

After you create or update the workflow field:

• Unless the workflow uses the Requested Item [sc_req_item] table, ensure that the workflow field is selected from the Stage field list in the workflow properties. For detailed steps, see Select a stage field. If a workflow uses the Requested Item table, the stage field is automatically set to the Stage field of the table and cannot be changed.

• Work through the workflow. Any other updates made to the workflow field, such as updates from business rules or other scripts, can interfere with displaying workflow stages.

Select a stage field

A Stage field allows the workflow context to show additional workflow information, such as the stage name and the estimated completion time for an activity.

Before you begin

Ensure that the workflow field you want to use as the stage field is configured to properly display stages. For detailed steps, see Create a workflow stage field.

About this task

Unless the workflow uses the Requested Item [sc_req_item] table, you can specify which field from the workflow table is the stage field. For workflows that use the Requested Item [sc_req_item] table, the stage field is automatically set to the Stage field of the table and cannot be changed.

To add or edit a workflow stage field:

Procedure

1. Navigate to Workflow > Workflow Editor.
2. Create or check out the workflow.
3. In the title bar, click the menu icon and select Properties.
4. In the Workflow Properties dialog box, click the General tab.
5. In the Table list, verify that the table containing the workflow field is selected.
6. Click the Stages tab.
7. From the Stage field list, select the workflow field.
8. Click Update.
Display approvers in workflow stage fields

Enable workflow stage fields to display approvers, change the number of approvers to display, or disable displaying approvers.

Before you begin
Role required: admin

About this task
By default, only workflow stage fields that use the Workflow-driven renderer can display a list of approvers. Only these workflow stage renderer types support displaying approvers.

- Linear renderer
- Main flow renderer
- Workflow-driven renderer

Procedure

1. Navigate to Workflow > Administration > Properties.
   The system displays the Workflow Properties page.

2. Set the following properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Number of approvers to show if approvers are displayed for workflow stages. Only valid for supported list v2 renderers. glide.workflow.renderer.show_approver_limit | Sets the maximum number of approvers to display within a workflow stage field. The system displays an ellipsis character when there are more approvers than the display limit allows.  
  - Type: integer  
  - Default value: 5 |
| Show approvers when displaying workflow stages with the Linear renderer. glide.workflow.renderer.linear.show_approver | Enables (true) or disables (false) the Linear renderer to display approvers.  
  - Type: true | false  
  - Default value: false |
<p>| Show approvers when displaying workflow stages with the Main flow renderer. | Enables (true) or disables (false) the Main flow renderer to display approvers. |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.workflow.renderer.mainflow.show_approver | - Type: true | false  
  - Default value: false |

Show approvers when displaying workflow stages with the Workflow-driven renderer.

| glide.workflow.renderer.workflowdriven.show_approver | Enables (true) or disables (false) the Workflow-driven renderer to display approvers.  
  - Type: true | false  
  - Default value: true |

3. Click **Save**.

4. Add stages to workflows that have associated workflow stage fields.

   **Note:** If you add stages to a subflow, the parent workflow must also have stages.

5. For each approval activity you want to display approvers, select a **Stage** value.

**Example**

For example, the sample workflow **Service Catalog Item Request** has two approval activities. The first **Approval - User** activity has a **Stage** value of **Dept. Head Approval**. The second **Approval - User** activity has a **Stage** value of **CIO Approval**.

**Results**

The workflow stage field renderers you enabled display approvers up to the approver display limit. For example, a Workflow-driven stage field displays up to five approvers when the workflow reaches an approval stage.

**Workflow stage field icons and tooltips**

A workflow stage field displays icons to indicate the workflow stage.

Based on the stage renderer selected for the workflow, these icons may display a tooltip with additional information.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Workflow stage</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Current active step</td>
</tr>
</tbody>
</table>
### Workflow field icons (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Workflow stage</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Approval pending</td>
</tr>
<tr>
<td>✗</td>
<td>Approval rejected</td>
</tr>
<tr>
<td>✔</td>
<td>Complete</td>
</tr>
<tr>
<td>✗</td>
<td>Late (Change/Request) or Canceled (Catalog)</td>
</tr>
<tr>
<td>🔄</td>
<td>Skipped (Catalog only)</td>
</tr>
</tbody>
</table>

#### Stage tooltips

Based on the stage renderer selected for a workflow, workflow stage icons may display tooltips with detailed information about a stage.

#### Stage renderers and tooltip behavior

<table>
<thead>
<tr>
<th>Renderer</th>
<th>Tooltip behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legacy</td>
<td>When a user points to a stage, the tooltip displays the name of the stage. In the expanded view, the activity status appears in parentheses next to the stage.</td>
</tr>
<tr>
<td>Other renderers</td>
<td>When a user points to a stage, the tooltip displays the name of the stage. If the stage is a gated approval, the tooltip also shows the name of the approver. In the expanded view, the activity status appears in parentheses next to the stage.</td>
</tr>
</tbody>
</table>
Stage renderers and tooltip behavior (continued)

<table>
<thead>
<tr>
<th>Renderer</th>
<th>Tooltip behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Waiting for Approval by Eric Schroeder</strong></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Waiting for Approval by Eric Schroeder" /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Waiting for Approval by Eric Schroeder (In progress)" /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Dept. Head Approval (Pending - has not started)" /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="CIO Approval (Pending - has not started)" /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Order Fulfillment (Pending - has not started)" /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Backordered (Pending - has not started)" /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Deployment (Pending - has not started)" /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Completed (Pending - has not started)" /></td>
<td></td>
</tr>
</tbody>
</table>

If you do not want the approver’s name included in the tooltip, navigate to **System Properties > Service Catalog** and clear the **Show the current pending approver’s name in the stage widget mouseover** check box.

**Property for displaying pending approver’s name**

- **Show the current pending approver’s name in the stage widget mouseover**
  - Yes | No

**Workflow stage renderers**

Workflow stage renderers determine how a workflow displays stages in a workflow field.

There are multiple renderers available.

*Note:* Most workflows should use the workflow-driven renderer. This renderer is used by default for all workflows. Use a different stage renderer only after careful consideration and to satisfy specific requirements for how the stages appear.

**Workflow-driven**

Use the workflow-driven renderer as much as possible. This renderer displays icons for stages using the stage state controlled by the workflow. Icons are
displayed in a way that is meaningful for many situations. This renderer can display stages from a main workflow and subflows. The order of the icons is determined by the expected path of the executing workflow. As the workflow progresses, stages on paths that the workflow did not take are removed from the display. Stages from paths other than the expected path are not included unless the workflow follows that path.

The **Stage order** field on the **Stages** tab has two options:

- **Computed** uses the actual workflow path in order
- **User-specified** uses the order specified in the **Order** column on the Workflow Stages record

**Note:** If the workflow context for a request item has been deleted, the stages for that request item can no longer be rendered. This stage history is stored on the workflow context.

**Main flow**

The main flow renderer displays icons for stages defined in the main workflow only. Use this renderer when you do not want to expose the details of the subflows. For example, a single main workflow may run several subflows to handle implementation details. The stages in these subflows do not provide useful information for the user who starts the workflow, but are useful when editing the subflow. In this scenario, using the main flow renderer leads to the best user experience. The stage field displays the high-level process of the workflow without exposing unnecessary details.

The **Stage order** field on the **Stages** tab has two options:

- **Computed** uses the actual workflow path in order
- **User-specified** uses the order specified in the **Order** column on the Workflow Stages record

**Linear**

Linear rendering displays all stage icons from the main workflow and all subflows within a single workflow field on a list or form. It displays icons in a linear sequence regardless of the paths the workflow follows as it executes. This renderer uses stages defined in both the main workflow and any subflows that the main flow launches. The icons appear in the user-specified order. Skipped stages do not appear.

Use this renderer when the workflow stages must display in a consistent order and the actual details of how the workflow runs are less important. For example, a workflow may revisit or revert to previous stages based on one or more Condition Workflow activities. Displaying these loops in the stage field does not provide useful information to the user. In this scenario, using the linear renderer
leads to the best user experience. The stage field displays the predefined process, including stages from subflows, in a consistent order.

For example, you can create a service catalog workflow that uses a subflow to complete delivery of the requested item. The following images illustrate the main flow and subflow for ordering corporate-branded supplies.

The linear renderer displays all these stages in one workflow field. The parent workflow specifies the **Waiting for approval**, **Fulfillment**, and **Completed** stages. The subflow specifies the **Delivery** and **Waiting for Task**, and **Delivery OK** stages.

**Progress bar**

The progress bar renderer displays a single progress bar instead of a sequence of stage icons. This renderer is particularly useful when you want to display the general progress of the workflow as a percent. Each stage in the workflow controls an equal percentage of the progress bar. For example, if a workflow has 10 stages, reaching each stage causes the workflow field to display an additional 10% of the progress bar. Stage names do not appear in the progress bar.

The progress bar renderer provides a way to display the status of a workflow that has a large number of stages. Other rendering options may provide a better user experience when rendering fewer than four stages in a single workflow.

The **Stage order** field on the **Stages** tab has two options:
• Computed uses the actual workflow path in order
• User-specified uses the order specified in the Order column on the Workflow Stages record

**Workflow field progress bar**

<table>
<thead>
<tr>
<th>Stage</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

**Legacy**

The legacy renderer displays stages in the same way as releases prior to Dublin. When an instance is upgraded from a release prior to Dublin, all existing workflows are set to use the legacy renderer. Whenever possible, use a different stage renderer instead. If you want your workflow to maintain pre-Dublin behavior, use the Legacy option. The legacy renderer sometimes assigns incorrect data to and/or reports incorrect data from the workflow stage field. If possible, we recommend all workflows use the Workflow-driven renderer.

With the legacy renderer, you can create and reference a custom workflow field icon set by setting the icons attribute to a new script include. For example, to use the `WorkflowIconsSCR` script include to define which icons to use, add the attribute `icons=WorkflowIconsSCR` to the Attributes field of the dictionary entry for the workflow field. To use the default icon display behavior, use the attribute `icons=WorkflowIconsStages`.

The legacy renderer works with all tables except the Requested item `[sc_req_item]` table. In this case, use the requested item renderer instead.

**Requested item**

The requested item renderer functions the same way as the legacy renderer, but is for use with the Requested Item `[sc_req_item]` table.

Only in Now Mobile, default stage renderer is used.

**Select a stage renderer**

In most cases, the default workflow-driven renderer should be used. If you have specific requirements for displaying stages, you can select a different stage renderer.

**Before you begin**

Consider the following when selecting a stage renderer:
• Use the workflow-driven renderer if possible. This is the default renderer that should be used in most cases.

• Use the legacy renderer only if your instance was upgraded from a release prior to Dublin and you want your workflow to maintain pre-Dublin behavior.

To use linear, main flow, or progress bar rendering, satisfy the following requirements.

### Linear and progress bar renderer requirements

<table>
<thead>
<tr>
<th>Renderer</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear</td>
<td>• The parent workflow and all subflows must modify the same current record.</td>
</tr>
<tr>
<td></td>
<td>• In the properties for all subflows, the <strong>Stage field</strong> value for all subflows must match that of the parent workflow.</td>
</tr>
<tr>
<td></td>
<td>• The parent flow and all subflows must contain the same stages. Use a stage set to ensure the parent flow and all subflows have the same stages.</td>
</tr>
<tr>
<td></td>
<td>• On the workflow canvas, each workflow needs only the stages used directly by that workflow. It is not necessary to add stages from subflows to activities on the parent flow, or stages from the parent flow to activities on the subflows.</td>
</tr>
<tr>
<td>Main flow</td>
<td>• The workflow contains subflows.</td>
</tr>
<tr>
<td></td>
<td>• You do not want or need to reveal the details about the subflows.</td>
</tr>
<tr>
<td>Progress bar</td>
<td>• The workflow properties must have a <strong>Stage ordering</strong> value of <strong>User-defined</strong></td>
</tr>
<tr>
<td></td>
<td>• There must be workflow stages within the workflow.</td>
</tr>
<tr>
<td></td>
<td>• Because stage names do not appear in a workflow field when using the progress bar renderer, you can simplify stage names to represent a percentage of the workflow. For example, if a process has four main steps, name the workflow stages as 25%, 50%, 75%, and 100%. Enter the numerical value of each stage, such as 25, in the <strong>Value</strong> and <strong>Order</strong> fields.</td>
</tr>
</tbody>
</table>

### About this task

To select a stage renderer:
Procedure

1. Navigate to **Workflow > Workflow Editor**.
2. Open and check out the workflow.
3. In the title bar, click the menu icon and select **Properties**.
4. In the Workflow Properties dialog box, click the **Stages** tab.
5. From the **Stage rendering** list, select a stage renderer.
   - If you are using two workflows to update two unique workflow fields on a single record, both workflows must use a non-legacy renderer. You can select a different stage renderer for each workflow but do not select **Legacy** for either one.
   - If you want to use the linear renderer, make sure you select **Linear** in the properties for the parent workflow and all subflows.
6. Click **Update**.

**Workflow fields with deleted records**

Workflow fields may indicate when a record required by the workflow is deleted. After a referenced record is deleted, the reference in the primary record is no longer valid. If the stage renderer detects a reference that is no longer valid, the stage field displays a message about the deleted record.

Administrators can restore deleted records. For more information, see .

The image shows a list with two workflows. The top request does not have an associated request item. The bottom request has an associated request item, but the item does not have an associated workflow context.

**Workflow validation**

Workflow validation examines different characteristics of a workflow to locate issues that might prevent the workflow from being published or cause it to fail. The validation report summarizes the results of each separate workflow validation.
Validation prevents workflows with critical flaws from executing and resulting in an unstable or incomplete state. There are a number of validators in the base system that notify workflow designers of potential problems. For example, multiple End activities, disconnected transitions, incorrect table references, missing subflows, and dependencies affected by update sets. A workflow validation report displays the results from each validator, including a message explaining what was found. The system automatically validates a workflow when you publish it. You can also run validation on a workflow directly from controls in the Workflow Editor.

**Highlighting critical errors**
The graphical Workflow Editor highlights critical errors when a workflow is loaded. In this example, a subflow is missing and is not available to the parent workflow for the current user. The graphical Workflow Editor indicates the error when the parent workflow loads by highlighting (in red) the activity that calls the subflow. To correct the error in the parent workflow, click the validate icon in the header bar and inspect the error description in the validation report.

![Validate missing subflow](image)

**Validations at publishing**
If you attempt to publish an invalid workflow or a workflow with potential problems, the system displays an error message and blocks the operation, if necessary. When validation error messages appear, click the validate icon in the graphical Workflow Editor to see the error report.

**Validation warning**
A validation warning notifies you that a potential problem exists in a workflow but permits you to publish the workflow. Validation warnings appear when:
• You edit and then attempt to publish a workflow that is included as a subflow in another workflow. The system cannot determine how your changes will affect the parent workflow and alerts you of the relationship.

• A workflow activity uses a different table than the table assigned to the workflow. The system alerts you of the potential conflict.

Validation failure
A validation failure notifies you that a critical error has occurred in the workflow that prevents you from publishing the workflow. An example of a critical error is a missing subflow.

Workflow validation report
Validators display three notification levels: CRITICAL, WARN, and INFO. The designer can publish a workflow that returns WARN or INFO level validation, but not a workflow that returns an overall validation level of CRITICAL.
Workflow validation report

Header summary

The header of the validation report summarizes the entire validation run against the specified workflow.

- **Validate Summary**: The overall score reflects the most severe notification level encountered during the validation.
- **Total checks performed**: The total number of validations run is also broken down to show the number at each notification level.

Report columns

The body of the report displays the results of each individual validation check that was performed. The columns are **Type**, **Level**, and **Message**. You can sort and filter these columns as you would any list.

Workflow termination and external dependencies levels

<table>
<thead>
<tr>
<th>Name</th>
<th>Implication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Info</td>
<td>Provides information about the current workflow version. An example of an</td>
</tr>
<tr>
<td></td>
<td>information level message is one that names the lowest common table in the</td>
</tr>
<tr>
<td></td>
<td>workflow. Workflows at this validation level are considered valid and</td>
</tr>
<tr>
<td></td>
<td>publishable.</td>
</tr>
</tbody>
</table>
## Workflow termination and external dependencies levels (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Implication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning</td>
<td>Alerts the user that the validator detected anomalies in the workflow that might compromise its ability to execute. An example of a warning level message is one that alerts you to a missing activity input transition. Workflows at this validation level are considered valid and publishable.</td>
</tr>
<tr>
<td>Critical</td>
<td>Names a workflow element containing a critical error that prevents the workflow from executing successfully. Examples of this are missing or invalid subflows and missing transitions. Workflows at this validation level cannot be published or run in production.</td>
</tr>
</tbody>
</table>

### Message

The validation message provides a detailed description of the results, including table names, update sets, and other specifics.

For the procedure to validate a workflow and generate a validation report, see [Validate a workflow](#).

### Workflow validator

ServiceNow offers several workflow validators for workflow designers to test their workflows.

This page lists all available workflow validators. See [Workflow validation](#) for information on using workflow validators and the workflow validation report to see the type of information that is returned.

### Hanging workflows and update sets

<table>
<thead>
<tr>
<th>Hanging Workflows</th>
<th>Update Sets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identify workflow design decisions that can result in a hanging workflow</td>
<td>Identify related artifacts being moved in different update sets</td>
</tr>
<tr>
<td>ValidateTransitionOut</td>
<td>ValidateUpdateSetDependencies</td>
</tr>
<tr>
<td>ValidateTransitionIn</td>
<td>ValidateUpdateSetParentDependencies</td>
</tr>
<tr>
<td>ValidateDanglingTransition</td>
<td>ValidateInputVarUpdateSetDependencies</td>
</tr>
</tbody>
</table>
Hanging workflows and update sets (continued)

<table>
<thead>
<tr>
<th>Hanging Workflows</th>
<th>Update Sets</th>
</tr>
</thead>
<tbody>
<tr>
<td>ValidateSubflows</td>
<td></td>
</tr>
<tr>
<td>ValidateScriptForCurrentDotUpdate</td>
<td></td>
</tr>
</tbody>
</table>

Workflow termination and external dependencies

<table>
<thead>
<tr>
<th>Unexpected Workflow Termination</th>
<th>External Dependencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identify workflows that can end unexpectedly</td>
<td>Identify external artifacts that have potential workflow dependencies</td>
</tr>
<tr>
<td>ValidateSingleEnd</td>
<td>ValidateParentFlow</td>
</tr>
</tbody>
</table>

Workflow conflicts

<table>
<thead>
<tr>
<th>Workflow Properties Conflicts</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Identify workflow design decisions that conflict with workflow properties</td>
<td></td>
</tr>
<tr>
<td>ValidateLowestCommonTable</td>
<td></td>
</tr>
<tr>
<td>ValidateTableChange</td>
<td></td>
</tr>
</tbody>
</table>

**ValidateTransitionOut**

The **ValidateTransitionOut** validator finds activity conditions with no exit transitions.

**Validation summary**

- **Risk**: Activity conditions might not transition to the next activity, which could cause the workflow to hang.
- **Severity Level**: Warning
- **Valid Result**: Valid
- **Valid Message**: All conditions have transitions.
- **Invalid Result**: Invalid
- **Invalid Message**: This workflow contains <condition count> activity conditions without an output transition.
• **Suggested Action:** If this is a conscious design decision, there is no corrective action. Otherwise, find the condition cited in the validator and add an appropriate transition to the next activity.

• **Publishable:** Yes

• **Runnable:** Yes

• **Related Information:** None

**Troubleshooting**

Design choices made when creating a workflow on the canvas might legitimately use an activity without an exit condition. In the first example, the **Notification** and **Timer** activities both execute at the start of the workflow. The **Timer** is the entity that decides when the workflow ends. In this situation, executing the **Notification**, but not transitioning away, keeps the design simple and adds no risk. The validator finds and reports the missing transition from the **Notification** activity as a **Warning** that the designer can ignore.

![Condition with no valid transition](image)

In the second example, the **Notification** activity has no exit transition. The designer missed this because of the layout. The transition from the **Timer** activity passes behind the **Notification** activity and appears to connect the exit from the **Notification** activity to the **End**. In workflows with more than 10 or 15 activities, it might be difficult to see all the transitions clearly. This workflow's designer intended for the **Notification** activity to transition to the **End**.
No condition out

This validator directs the designer to the specific activity and condition that does not have an exit transition. The designer then makes the decision whether or not to respond to the warning.

ValidateTransitionIn

The ValidateTransitionIn validator finds activities that do not have inbound transitions and cannot execute in the workflow.

Validation summary

• Risk: Activities that do not have inbound transitions have no means of being executed in the workflow. If other logic builds from these activities, the workflow could hang, with no means of moving forward.

• Purpose: Find activities that do not have inbound transitions.

• Severity Level: Warning.

• Valid Result: Valid.

• Valid Message: All activities in this workflow have at least one inbound transition.

• Invalid Result: Invalid.

• Invalid Message: This workflow contains <activity count> activity conditions without an input transition.

• Suggested Action: Either remove the activities to reduce confusion and make the workflow easier to understand or provide the appropriate inbound transition.

• Publishable: Yes

• Runnable: Yes

• Related Information: None

Troubleshooting

Although the activities detected in this validator do no harm to the execution of the workflow, the designer needs to know that there are activities on the canvas that cannot execute and serve no purpose, particularly in a production system. This error is typically caused by a visual misinterpretation of the drawing.
This example workflow appears to be perfectly valid. Under closer inspection, however, we see that the transition from **Set Values** does not stop at **Approval - User** (there is no arrow end). Instead, that transition goes directly to **End**. As a result, **Approval - User** cannot execute. Because there is an activity in the workflow based on the approval's condition routing, it appears that the designer intended for the approval to execute and that a correction is needed.

This validator directs the designer to the specific activity and condition that has no inbound transition. The designer should establish a transition or remove the activity.

**ValidateDanglingTransition**

The **ValidateDanglingTransition** validator finds and reports any transitions that do not terminate on an activity.

⚠️ **Note:** These transitions are not drawn on the workflow canvas, but are still present in the database.

⚠️ **Warning:** This is a critical error that prevents a workflow from running.

**Validation summary**

- **Risk:** A workflow with dangling transitions will silently hang a workflow with no recovery options.
- **Severity Level:** Critical
- **Valid Result:** Valid
- **Valid Message:** Valid
- **Invalid Result:** Invalid
- **Invalid Message:** Invalid
• **Suggested Action:** Remove or connect the offending transition. Get the source activity name from the validation report details and resolve the issue. Then, run the validation again to test your changes.

• **Publishable:** No

• **Runnable:** No

• **Related Information:** None

**Troubleshooting**

On rare occasions, the destination of a workflow transition becomes null. The workflow canvas shows no evidence of the transition, but at run time, the workflow hangs when it encounters one of these dangling transitions. If the `ValidateDanglingTransition` validator reports this condition at publishing time, it blocks the publication action until the issue is resolved. If this condition is detected on a runtime check, the workflow is not allowed to execute against a current record's transaction. Instead, the system adds a critical log entry detailing the activity with the faulted transition to the current record's workflow context. To enable the workflow to execute on the next appropriate transaction, remove the faulted transition from the workflow model.

To find and remove the faulted transition:

1. Make note of the workflow version and activity that contains the faulted transition as indicated in the validator details.

2. Navigate to **Workflow > Administration > Workflow Version**.

3. In the list of workflow versions, select the workflow that has the faulted transition.

4. On Workflow Version form, add the workflow activities related list. Click the menu icon, select **Configure > Related Lists**, move **Workflow Activity--Workflow Version** from the Available list to the Selected list, and click **Save**.

5. In the **Workflow Activities** related list, select the activity cited in the validator.

6. In the Workflow Activity form, view the **Workflow Transitions** section or tab and identify the transition in that list that has no value or a null value in the **To** column.

7. Delete this transition.

8. Return to the workflow version and re-run the validation check.

The **Critical** warning should disappear. The workflow should execute as expected on the next appropriate transaction.
ValidateSubflows

The ValidateSubflows validator detects any workflows included as subflows that are either inactive, deleted, or not available as a published workflow for the current user.

Any of these conditions cause the workflow to hang when the workflow activity in the main flow is encountered.

⚠️ Warning: This is a critical error that prevents a workflow from running.

Validation summary

- **Risk:** A parent workflow that transitions to a deleted subflow hangs indefinitely, with no recovery options.
- **Severity Level:** Critical
- **Valid Result:** Valid
- **Valid Message:** This workflow contains <count> valid subflows.
- **Invalid Result:** Invalid
- **Invalid Message:** This workflow contains <invalid count> invalid subflow(s) of <total subflow count> total subflows.
- **Suggested Action:** Remove the link in the parent workflow to the questionable subflow, examine the subflow to ensure that it is valid and published, or that it is checked out to the current user. After making the correction to the state of the subflow, run the validation again to test your changes.

- **Publishable:** No
- **Runnable:** No
- **Related Information:** Workflows used as subflows

Troubleshooting

When a workflow runs, regardless of whether it is a subflow or a main flow, the script engine determines which version of a workflow should execute, given the current user and workflow conditions. When a workflow is checked out by the same user who is running the workflow, the checked out version is the version that executes. If the user is not the same person who has the workflow checked out, the published version of the workflow executes. If there is no published workflow, no workflow runs.

One scenario addressed by the ValidateSubflows validator is when a workflow:
• Is checked out to User A.
• Is a subflow in a parent workflow being run by User B.
• Has no published alternative to the subflow being run by User B.

When this occurs, the parent workflow runs to the execution of the unpublished subflow and then hangs at that activity, with no means to transition forward. Main flows that encounter this condition in a subflow are not permitted to execute against a current record's transaction. Instead, a critical log entry detailing the subflow's state is added to the current workflow's Workflow Context record. To correct the problem, remove the subflow from the main flow, or publish the subflow so it is available to User B. This allows the workflow to execute on the next appropriate transaction.

Another scenario addressed by the ValidateSubflow validator is when a workflow:

• Is a subflow in a parent workflow being run by any user.
• Has no published alternative to the subflow, because the workflow has been deleted or all versions of the workflow are unpublished or inactive.

Note: You cannot delete a from a list or form workflow that is a subflow. However, you can create one of these unstable conditions with advanced scripting, SQL options, or incomplete update sets that contain main flows, but not the referenced subflows. When troubleshooting a workflow that triggered this validator, consider the history of the subflow while assessing the error condition.

ValidateScriptForCurrentDotUpdate

The ValidateScriptForCurrentDotUpdate validator finds workflow activities with scripts that use the current.update() function.

Calling current.update() causes significant performance delays in transaction processing and might cause an instance to hang.

Validation summary

• Risk: At best, a workflow that uses current.update() in scripts experiences degraded performance. In the worst case, the workflow enters an infinite, recursive loop that crashes the server.
• Severity Level: Warning
• Valid Result: Valid
- **Valid Message**: The JavaScript in this workflow has no instances of 'current.update()'.
- **Invalid Result**: Invalid
- **Invalid Message**: This workflow uses 'current.update()' in <count of current.update references> JavaScript statements.
- **Suggested Action**: Remove `current.update()` from the activity scripts cited by this validator. Workflows execute within a transaction, and current is updated, or possibly inserted, at the end of the transaction, as appropriate. There is no need to explicitly update the record during the transaction.
- **Publishable**: Yes
- **Runnable**: Yes

**Problems with `current.update()` in workflow scripts**

A workflow initiates execution in one of these ways:

- **Script Engine**: If a workflow is assigned to a specific table, and given a run condition, the workflow runs on INSERT.

- **Script**: Any business rule, script include, background script, or client script can initiate a workflow using the workflow script include and calling `startFlow()`.

The workflow engine initiates a workflow based on the matched criteria of the current record being inserted. The transaction for current is managed by the script engine and not the workflow. Workflows that progress on the `update()` of the current record are not invoked via the workflow engine, but as a call from either a client script or business rule. In either case, the script engine is invoked, and the current record is put in memory. Edits and modifications to any current fields are made and are available to other activities and scripts that are executed in the same transaction.

When appropriate, other engines that run in sequence with the workflow engine, such as the business rule engine or field normalization, are invoked against the same current record transaction. Any changes made to current through these scripts and activities modify the record in memory. These changing values are available for reference in any other transactions called from activities and scripts in the same INSERT transaction. When all expected changes are executed, the current record is inserted.

When one of these scripts calls `current.update()` on a record that has yet to be inserted, the action forces an unnecessary and error-prone database transaction. If a record is not yet in the database, it cannot be updated. Business rules that trigger on `update()` on a record that is in the process of being inserted can cause a very unstable and potentially infinite looping condition.
Troubleshooting

This validator detects the use of `current.update()` in any of the editable script fields. Do not call `current.update()` from within a workflow script. In the event of an INSERT or UPDATE of `current`, the changes made to `current` are available to all scripts executing in the same transaction, and the script engine stores all changes in the database. Leave the update of `current` to the engine. Use the scripts only for setting and referencing the current field values.

**ValidateLowestCommonTable**

The **ValidateLowestCommonTable** validator reports the lowest table in the Glide hierarchy that the workflow uses.

For example, the Requested Item [sc_req_item] table is the lowest table in a workflow containing a **Catalog Task** activity. This information is significant to a designer who wants to change the table against which an existing workflow runs after adding activities to the canvas.

⚠️ **Note:** This validator provides information only. It does not indicate an error or warning condition.

**Validation summary**

- **Risk:** This validator informs only and has no risk associated with it.
- **Severity Level:** Data/Information
- **Valid Result:** Valid
- **Valid Message:** The lowest common table in this workflow is <<table_name>>.
- **Invalid Result:** N/A (informational only)
- **Invalid Message:** N/A (informational only)
- **Suggested Action:** None
- **Publishable:** Yes
- **Runnable:** Yes
- **Related Information:** Workflow activities

**ValidateTableChange**

The **ValidateTableChange** validator reports any activities in the workflow that are invalid given the table associated with the workflow version.
For example, a workflow version that is associated with the Change Request [change_request] table but has a Catalog Request activity on the canvas is invalid, since the activity is not compatible with the selected table.

Validation summary

- **Risk:** If the current record at runtime does not originate from the table specified by the lowest common table, the activities for the lowest common table cannot set specific values.
- **Severity Level:** Warning if the table that is associated with a workflow is higher in the table hierarchy than the lowest common table required for the workflow activities.
- **Valid Result:** Valid
- **Valid Message:** All activities are valid for the newly selected table
- **Invalid Result:** Invalid Activity
- **Invalid Message:** This workflow contains <count of invalid activities> invalid activities for the newly selected table.
- **Suggested Action:** Make one of these changes:
  - Change the workflow to not require the activities associated with the lowest table reported.
  - Modify the workflow to use a table that contains the lowest common table in its hierarchy.
  - Ensure that the current record meets the requirements of the at-risk activities.
- **Publishable:** Yes
- **Runnable:** Yes
- **Related Information:** Workflow activities

Troubleshooting

Navigate to **Workflow > Administration > Activity Definitions.** Note the **Table** column in the list. Each activity that is not global is associated with a table.

When you select a table in the Workflow Properties form, the activity menu presents only activities that are compatible with the selected table. Associating a table with a workflow activity enables the system to make certain decisions about the activity that affect value comparison, condition routing, or the setting and getting of field values in the current record.

When a workflow is set to the Global [global] table, it is possible that the process executing the workflow ensures that the current record meets the requirements
of the activities identified by this validator. In that case, the activity still works as expected. If that assurance cannot be guaranteed by the user process, do not use the activity identified by the validator without assigning a table that meets the requirements of all the activities on the canvas.

This validation check ensures that the table specified by all the activities in a particular workflow is included in the hierarchy of the table selected for the workflow.

**ValidateParentFlow**
The **ValidateParentFlow** validator reports any workflows that use the workflow as a subflow.

**Validation summary**
- **Risk:** There is no risk in a workflow being a subflow. This is only a warning that other workflows are at risk from dramatic changes to a subflow.
- **Severity Level:** Warning
- **Valid Result:** Valid
- **Valid Message:** Currently <workflow version name> is not a subflow.
- **Invalid Result:** None
- **Warning Message:** This workflow version (<workflow version name>) is required as a subflow in <workflow version count> other workflows.
- **Suggested Action:** Exercise caution when modifying things like input parameters and return values to assure that parent workflows are not adversely affected.
- **Publishable:** Yes
- **Runnable:** Yes
- **Related Information:** Workflows used as subflows

**Troubleshooting**
The system warns the workflow designer at publishing time and during validation that a workflow is a subflow. This warning reminds the designer that changes to the current workflow have the potential to affect workflows cited in the validation report or other workflows already running in production. Regardless of how simple the change to a workflow that is a subflow, thoroughly test all parent flows cited in this validation report before publication.

When a workflow is a subflow, changes that can cause it to become invalid include:
• Changing the data types of **input variables**. Verify that all parent workflows cited in this validation report can pass the correct value type.

• Adding input variables. Verify that all parent workflows cited in this validation report are able to pass all variable values into the subflow.

• Changing or removing the return value of a workflow. Verify that any changes to the return value of a workflow are compatible with the requirements of all the parent flows.

• Changing the table on which the workflow runs. Verify that the table selection is compatible with all parent flows.

**Note:** To delete a workflow that is a subflow, first remove the dependency by removing the subflow from all parent flows cited in this validation report. After the dependencies are cleared, a user with the proper role can delete the subflow.

**ValidateSingleEnd**

The **ValidateSingleEnd** validator finds and identifies multiple **End** activities in a single workflow.

Multiple **End** activities in a workflow might be intentional and have no affect on the workflow, or might be a mistake that the designer needs to correct.

**Validation summary**

- **Risk:** If the execution paths to the **End** activities are not mutually exclusive, then the first **End** encountered completes the workflow and cancels all other executing activities.

- **Severity Level:** Warning

- **Valid Result:** Valid

- **Valid Message:** This workflow contains 1 End activity.

- **Invalid Result:** Invalid Activity

- **Invalid Message:** This workflow contains <count of ends> End activities.

- **Suggested Action:** Remove extraneous **End** activities that are not intended as part of the design.

- **Publishable:** Yes

- **Runnable:** Yes

- **Related Information:** None
Troubleshooting

As soon as an End activity is encountered in the workflow, the workflow completes even if there are other viable execution paths leading to a second End activity that is still executing. Those executing activities are canceled as part of the End activity's clean up actions. Therefore, the results of designing workflows with multiple Ends must be carefully considered.

In the case of large workflows, it is often more intuitive to read the workflow when there are multiple End activities. In the following example, the paths to the two Ends are mutually exclusive execution paths. If this was a large workflow, with many activities between Branch and the second End, the value of the multiple ends becomes apparent. Tracing a No response from User is invalid to a single End behind 33 other activities would be significantly more difficult. There is no risk in this workflow design because there is no reason for other activities to execute if the End after the Notification activity terminates the workflow.

Mutually exclusive execution paths

The next example has multiple End activities in execution paths that are not mutually exclusive. A Yes response from User is valid causes the Set Values activity to finish immediately. By reaching its End activity first, this execution path cancels the Approval for Apps and the DB Task activities, which might not be the desired outcome. If the paths are all expected to complete before End, the activities should come to a Join (as in the previous example) that transitions to a single End.
Mutually inclusive execution paths

![Diagram of workflow execution paths]

**Note:** To add the second End, right-click to copy the original End activity and paste it onto the canvas. In most cases, a single End is the best and most reliable way to ensure that all activities expected to execute prior to workflow completion, do so successfully.

**ValidateUpdateSetDependencies**

The ValidateUpdateSetDependencies validator identifies all the subflows called in the current workflow and determines if any of those subflows are being edited in a different (in progress) update set.

This warning informs the user that this workflow and one or more of its dependencies are being actively modified in a way that will not deploy concurrently to another instance without additional effort.

For information about update sets, see Create and select an update set.

**Validation summary**

- **Risk:** If a parent workflow is edited in one update set and its dependent subflow is edited in another, the two workflows might not be compatible when moved to a different instance. Making independent changes, such as to common or expected values, can make the two workflows incompatible.

- **Severity Level:** Warning

- **Valid Result:** Valid

- **Valid Message:** There were no Update Set dependency issues found.

- **Invalid Result:** Invalid
• **Invalid Message**: This workflow has dependent workflows that are in a different update set.

• **Suggested Action**: Modify and deploy both workflows in the same update set. If you must modify dependencies in separate update sets, use one of these methods:
  ◦ Ensure that all update sets migrate concurrently.
  ◦ Prior to deploying the main flow update set, merge the dependencies into one update set before completing that update set.

• **Publishable**: Yes
• **Runnable**: Yes
• **Related Information**: Workflow movement with update sets

**Troubleshooting**
A workflow is added to an update set only when the workflow is published. This validator issues a warning when either of the following conditions exist:

• A published subflow is in a different update set than the parent workflow and that update set is In progress.
• A subflow is checked out by another user, who is working in a different update set than the current user.

⚠ **Note**: This validator does not look for update sets that have been closed. It looks only at update sets that are In progress or at the update sets of all subflows being used by the current workflow that are checked out to users who are working in a different update set.

**Example**
Following is an example of an at-risk development scenario in which two users create dependencies between workflows in different update sets.

**User A:**
1. Sets Update Set A to the current update set.
2. Checks out Workflow A.
3. Changes the return value of the **String** type in Workflow A to a **Reference/User** type.
4. Publishes Workflow A, causing an entry into Update Set A.

**User B:**
1. Sets Update Set B to the current update set.
2. Checks out Workflow B.
3. Includes Workflow A as a subflow.
4. Uses the user reference return value from Workflow A as an approval assignment.
5. Publishes Workflow B, causing an entry into Update Set B.

**Risks**

- User B moves Update Set B to a different instance that has an older version of Workflow A. The return value is not a user reference, which causes the outcome of Workflow B to be different than it was when tested in development.
- User B moves Update Set B to a new instance that does not have a version of Workflow A. Workflow B experiences a validation failure at runtime and cannot execute. A log entry is added to the workflow log of the current record.

**Possible solutions**

**Solution 1**

Migrate the parent workflow and all dependent workflows to a new instance together using the same update set.

1. Set the update set to the one you want to migrate to new instances.
2. Check out and republish the workflows that need to be included.
   - This action forces an entry into the current update set.
3. Complete the update set with all dependencies.
4. Follow standard procedures for migrating update sets to local instances.

**Solution 2**

Move dependent workflows between update sets.

1. Identify the update set containing the main workflow to be migrated.
2. Navigate to **System Update Sets > Local Update Sets**.
3. Find and select the update set that contains the dependencies to the main workflow.
4. In the **Customer Updates** related list, select the workflow version of the subflow you want to move.
5. Select the update set containing the parent workflow in the **Update set** field.
• If this field is not on the Customer Update form, configure the form and add the field.

6. Click Update.
   • The base system moves the dependent subflow to the update set selected.

7. Repeat steps 4-6 to add additional dependent subflows to the parent flow update set.

**ValidateUpdateSetParentDependencies**

The ValidateUpdateSetParentDependencies validator identifies all the workflows that call the current workflow as a subflow and determines if any of those parent workflows are being edited in a different update set that is in progress.

This warning informs the user that this workflow and one or more workflows that depend on this workflow are being actively modified in a way that will not deploy concurrently to another instance without additional effort.

**Validation summary**

- **Risk:** If a parent workflow is edited in one update set and its dependent subflow is edited in another, the two workflows might not be compatible when moved to a different instance. Making independent changes, such as editing common or expected values, can make the two workflows incompatible.
- **Severity Level:** Warning
- **Valid Result:** Valid
- **Valid Message:** There were no Update Set dependency issues found.
- **Invalid Result:** Invalid
- **Invalid Message:** This workflow has dependent workflows that are in a different update set.
- **Suggested Action:** Modify and deploy both workflows in the same update set. If you must modify dependencies in separate update sets, use one of these methods:
  - Ensure that all update sets migrate concurrently.
  - Prior to deploying the main flow update set, merge the dependencies into one update set before setting that update set to complete.

- **Publishable:** Yes
- **Runnable:** Yes
- **Related Information:** Workflow movement with update sets
Troubleshooting

A workflow is added to an update set only when the workflow is published. This validator issues a warning when either of the following conditions exist:

• A published subflow is in a different update set than the parent workflow and that update set is In progress.
• A subflow is checked out by another user, who is working in a different update set than the current user.

Note: This validator does not look for update sets that have been closed. It looks only at update sets that are In progress or at the update sets of all parent workflows that call the current workflow and are checked out to users who are working in a different update set.

Example

Following is an example of an at-risk development scenario in which two users create dependencies between workflows in different update sets.

User A:

1. Sets Update Set A to the current update set.
2. Checks out Workflow A.
3. Changes the return value of the String type in Workflow A to a Reference/User type.
4. Publishes Workflow A, causing an entry into Update Set A.

User B:

1. Sets Update Set B to the current update set.
2. Checks out Workflow B.
3. Includes Workflow A as a subflow.
4. Uses the user reference return value from Workflow A as an approval assignment.
5. Publishes Workflow B, causing an entry into Update Set B.
Risks

• User B moves Update Set B to a different instance that has an older version of Workflow A. The return value is not a user reference, which causes the outcome of Workflow B to be different than it was when tested in development.

• User B moves Update Set B to a new instance that does not have a version of Workflow A. Workflow B experiences a validation failure at runtime and cannot execute. A log entry is added to the workflow log of the current record.

Possible solutions

Solution 1

Migrate the parent workflow and all dependent workflows to a new instance together using the same update set.

1. Set the update set to the one you want to migrate to new instances.
2. Check out and republish the workflows that need to be included.
   • This action forces an entry into the current update set.
3. Complete the update set with all dependencies.
4. Follow standard procedures for migrating update sets to local instances. For information about update sets, see System update sets.

Solution 2

Move dependent workflows between update sets.

1. Identify the update set containing the main workflow to be migrated.
2. Navigate to System Update Sets > Local Update Sets.
3. Find and select the update set that contains the dependencies to the main workflow.
4. In the Customer Updates related list, select the workflow version of the subflow you want to move.
5. Select the update set containing the parent workflow in the Update set field.
   • If this field is not on the Customer Update form, configure the form and add the field.
6. Click Update.
   • The base system moves the dependent subflow to the update set selected.
7. Repeat steps 4-6 to add additional dependent subflows to the parent flow update set.
ValidateInputVarUpdateSetDependencies

The **ValidateInputVarUpdateSetDependencies** validator examines update sets to ensure that workflow input variables for a given workflow have not been deleted in different update sets than those currently **in progress**.

**Validation summary**

- **Risk:** Workflows and their input variables are not moved together in a single update set. The deletion of input variables is captured in a different update entry. If these two entries are not in the same update set, the workflow execution can be unstable.

- **Purpose:** Determine whether input variables that belonged to this workflow were deleted in a different update set.

- **Severity Level:** Warning

- **Valid Result:** Valid

- **Valid Message:** There were no Input Variable Update Set dependency issues found.

- **Invalid Result:** Invalid

- **Invalid Message:** There are input variables that have been deleted and logged in a different update set.

- **Suggested Action:** If the deletion is not intended to be separate from the workflow, ensure that both update sets are committed concurrently to the new instance, or merge both payloads into a single update set.

- **Publishable:** Yes

- **Runnable:** Yes

- **Related Information:** Workflow movement with update sets

**Troubleshooting**

Workflow input variables get individual entries in the **Customer Update** related list in the current user's update set. This validator reports to the user when workflow input deletions have happened in an update set other than the current user's update set.

Follow the instructions for **Input variable removal** when the validator issues this warning.
ValidateWorkflowEndStages

The ValidateWorkflowEndStages validator checks that in workflows with stages, the end activity of the workflow has a stage named Complete or Completed.

If the workflow has stages associated with it, but does not have the completed stage on the end activity, then the stage indicator will not show that the workflow completed.

Validation summary

- **Risk:** The stage indicator will not show the workflow is completed.
- **Severity Level:** Warning
- **Valid Result:** Valid
- **Valid Message:** Workflow end stages are valid.
- **Invalid Result:** invalid
- **Invalid Message:** End activity A found with invalid stage "S."
- **Suggested Action:** If this is not by design, make the appropriate changes.
- **Publishable:** Yes
- **Runnable:** Yes
- **Related Information:** Workflow activities

Troubleshooting

Check the workflow for an end activity. Ensure that this activity assigns a stage named Complete or Completed.

ValidateWorkflowStageColumn

The ValidateWorkflowStageColumn validator detects and reports when the stage field (stage column) for a workflow is not correct or is unusable.

Validation summary

- **Risk:** The stage indicators may not display appropriate information.
- **Severity Level:** Warning
- **Valid Result:** Valid
- **Valid Message:** Workflow stage values are valid.
- **Invalid Result:** Warning
- **Invalid Message:** Workflow stage values are invalid.
- **Suggested Action:** If this is not by design, make the appropriate changes.
- **Publishable:** Yes
- **Runnable:** Yes
- **Related Information:** Stage warnings found.
• Invalid Messages:
  ◦ Table T does not have a column named C.
  ◦ Workflow for table T has stages, but no stage column.
  ◦ Table T has a stage column "C," but no stages are set by activities.
  ◦ Workflow on table T has stage column "C" that is not type=workflow.

• Suggested Action: If this is not by design, make the appropriate changes.

• Publishable: Yes

• Runnable: Yes

• Related Information: Workflow activities, Workflow stages

Troubleshooting
To check the stage column:
1. Open and check out a workflow.
2. Open the workflow version properties dialog by clicking the menu icon and selecting Properties.
3. View the Stages tab or section.
4. Check that the assigned stage column is actually a column in the table to which the workflow is associated.
5. Check that the column is type=workflow.

Tip: Stage columns should not be choice lists. If they are, the list appears read-only in form views, since changing that column value outside the workflow engine does not ensure safe tracking of stage states.

ValidateWorkflowStateValues
The ValidateWorkflowStateValues validator checks a number of stage aspects in workflow activities for correctness.

This validator has multiple possible error messages.

Validation summary
• Risk: The stage indicators may not display appropriate information.
• Severity Level: Warning
• Valid Result: Valid
• Valid Message: Workflow stage values are valid.
• **Invalid Result:** invalid

• **Warning summary:** Stage warnings found.

• **Invalid Messages:**
  ◦ Stage with empty name is not allowed.
  ◦ Stage with empty value is not allowed.
  ◦ Cannot have more than one stage with the same name: x.
  ◦ Cannot have more than one stage with the same value: y

• **Suggested Action:** If this is not by design, make the appropriate changes.

• **Publishable:** Yes

• **Runnable:** Yes

• **Related Information:** Workflow activities

**Troubleshooting**
Use the following procedure to troubleshoot this validator:

1. Open and check out a workflow.

2. Open the list of stages for the workflow by clicking the menu icon and selecting **Edit Stages**.

3. Check the names and values.
   
   Ensure that the names and values are unique and are not empty.

4. If the same stage name or value appears more than once, remove one of the rows. It is then very important to go through the workflow and reassign stages in the activities that used the removed stage.
Validate Workflow State Values

Workflow State Values

| Workflow Stages [Auto-ordered stages view] | New | Go to | Name | Search | L to 3 of 3 |  
|---|---|---|---|---|---|---|
| Request Cancelled | Closed Incomplete | closed_incomplete |  
| Closed Incomplete | complete |  

**Tip:** Make a list of which activities assign which stages.

**Workflow concepts**

You can do many things using the Workflow Editor.

- Modify core activities and exit conditions.
- Create custom activities and reuse the data for other workflows.
  See Orchestration activity designer.
- Download activity packs from the ServiceNow Store and create packs for upload.
- Edit workflows graphically.
- Define transitions between workflow activities.
- For the table that corresponds to the workflow, customize business rules.
- Summarize workflow progress through stages.
- Validate workflows to identify potential problems.
- Publish workflows for other users.
- Edit multiple tables without needing to directly modify them.
Workflow versions

To prevent users from making changes to a workflow that affect other users of the system, workflows must be checked out before they can be edited.

Only one user can check out a workflow at a time. When a workflow is checked out, changes apply only to the user who has the workflow checked out. Other users can continue to use the published workflow. After the changes are complete, the workflow can be published so that it is available to all users.

Note: Because each workflow has a unique sys_id, different workflows can have the same name. This is typically expected in a domain-separated environment where users in different companies cannot see each other’s workflows because they are in different domains. However, this can lead to confusion in other environments. In general, give each workflow a unique name to prevent workflow designers from making changes to the wrong workflow.

When a new version of an existing workflow is published, the changes are not applied to running workflow contexts. Any currently running workflow context continues using the workflow version that was available when the workflow started. The next time the workflow runs, it uses the updated, published version.

Workflow scope

Workflow application scope determines the access that an application has to the information in a workflow, specifically to the data contained in the activities in that workflow.

When a workflow is created, it inherits the application scope from the gear menu for the logged in user. This scope cannot be changed in the Workflow Editor. When the workflow executes, it runs in this scope and can only be called from a different application if the workflow’s accessibility setting permits access to all scopes (public). Otherwise, the workflow’s application scope is private to the application.

Note: Any script that is created in the Workflow Editor, such as an advanced script in an If activity, runs in the scope of the workflow. All core activities provided in the base system or for Orchestration run in the scope of the workflow.

Custom activities run in their own scope, even if it is different from that of the workflow. The scope of a custom activity can be private or public. Any script that runs inside a custom activity with a scope can only access outside artifacts that are within the scope of that activity or artifacts that are configured to run in
any scope. Conversely, an outside artifact can only access the script inside that private activity if the outside artifact is running in the same scope. Activities with public scopes can interact with outside artifacts in any application scope.

You can use private activities as part of a workflow that has a public application scope. These activities are protected from reaching outside of the workflow or from being reached from outside the workflow. For details about setting application scoping for custom activities, see the field description table for the appropriate activity template.

⚠️ **Note:** Custom activities uploaded to the ServiceNow Store must be configured as accessible to all application scopes.

### Workflow scope restrictions

There are some restrictions to public and private application scopes.

During runtime, publicly scoped workflows can access other application resources, as long as these resources are set to be accessible to all application scopes. Privately scoped workflows in a private application scope can only access resources private to its scope. Due to scope access boundaries, any privately scoped workflows that make calls out to other scoped resources fail with either an exception or a hung activity while waiting for returned results. This occurs when making calls to these common global resources:

- ECC queues
- Tasks
- Approvals
- Events
- SLA timers
- Timers
- Script includes
- Business rules
- Workflow APIs

As you design workflows, validate the visibility and accessibility of all resources prior to deployment.

See Application scope.

For information on how to configure the scope for a workflow, see Workflow properties.
Domain separation and Workflow

Domain separation is supported in the Workflow application. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Standard*

- Includes Basic level
- Business logic: Processes can be created or modified per customer by the service provider. The use cases reflect proper use of the application by multiple service provider customers in a single instance.
- The owner of the instance needs to be able to configure MVP business logic and data parameters per tenant as expected for the specific application.

Use case: As an admin, I need the ability to make comments mandatory on close of a record for one tenant, but not for another.

Overview

When domain separation is enabled, workflows and workflow activities inherit the domain of the user who publishes or creates them.

How domain separation works in the Workflow application

While workflows are managed by multiple tables, only the following tables are used for domain separation features:

- Workflow [wf_workflow] and Workflow Version [wf_workflow_version]: used for delegated administration or process separation.
- Workflow Context [wf_context]: used for data separation.

Note: The Workflow Version table [wf_workflow_version] table does not contain a domain field; Workflow Version records inherit their domain from the parent Workflow record.

The Workflow Editor displays a workflow’s domain in the title bar after the workflow name.
Related information

Domain separation for service providers

Workflows and delegated administration

Delegated administration allows child domains to inherit workflows from higher up the domain hierarchy and to override them with domain-specific versions if necessary.
Workflow records in the Workflow [wf_workflow] and Workflow Version [wf_workflow_version] tables are considered processes. A user in a child domain may check out but not copy a workflow from a parent domain. When a user in a child domain checks out a workflow from a parent domain, the system creates a version of the workflow in that user's domain. This new version is a unique record in the Workflow [wf_workflow] table. After the user publishes this new workflow, other users in the child domain use the new workflow, which overrides the workflow from the parent domain. The original workflow in the parent domain is no longer visible to users in the child domain.

For example, a managed service provider (MSP) hosts ITSM services for several companies, including ACME and Initech, on a single instance. As administrators, the MSP creates a Change Request - Emergency workflow that applies to all domains because it was created in the TOP domain, which is the highest domain in the domain hierarchy. This workflow overrides the global Change Request - Emergency workflow and specifies that emergency change requests require approval from the CAB approval group. Because of delegated administration, every domain in the hierarchy sees and uses this workflow.

Now suppose the ACME domain requires a different approval policy where emergency change requests require approval from the emergency CAB approval group. The MSP creates another version of the Change Request -
Emergency workflow in the ACME domain. This workflow overrides the version in the TOP domain and only applies to users in the ACME domain.

**Workflow permissions**

When a user starts a new workflow, the workflow runs with that user's domain and credentials.

The workflow preserves a user's domain and credentials until an activity causes the workflow to wait, such as an approval activity waiting for approval or rejection. When the stopped workflow resumes, such as when a user approves a request, the workflow uses the credentials of the approving user, but continues to run within the domain of the original user.

**Workflows and data separation**

Data separation restricts workflow contexts to users who are either in the same domain of the workflow or are members of a parent domain.

Workflow records in the Workflow Contexts [wf_contexts] table are considered data. Data separation restricts workflow contexts to users who are either in the same domain of the workflow or are members of a parent domain. While a user

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
in a parent domain can see running workflows in a child domain, a user in a child domain cannot see running workflows in a parent domain. If necessary, administrators can use visibility or contains domains to expand who can see domain-specific data.

For example, when an ACME user requests something from the service catalog, a Service Catalog Request workflow context is created in the ACME domain. Similarly, a service catalog request from an Initech user creates a workflow context in the Initech domain. An MSP user in the TOP domain can see both workflow contexts because it is the parent domain for both the ACME and Initech domains. However when an ACME or Initech user logs in, data separation prevents them from seeing each other's service catalog requests. This is expected behavior because each workflow context contains data specific to that domain, such as the item requested and the request's approval history.

**Workflow engine operation order**

The workflow engine runs in a predefined order relative to business rules and database operations. It caches commonly-used published workflows to improve performance.

The **Run after bus. rules run** workflow property defines if a workflow is **Default** or **Deferred**.

The diagram below shows the workflow engine order of operations and when Default and Deferred flows are executed. For a more general overview of engine operation order, see.
Workflow engine order diagram

Before business rules (order <1000)
Do not use current.update() here

Default workflows
Do not use current.update()

Before business rules (order >=1000)
Do not use current.update()

Database operation (insert, update, delete)
The current record is inserted or updated at the end of the database operation.

After business rules (order <1000)
Use current.update() if there is no deferred workflow

Deferred workflows
Do not use current.update()

After business rules (order >=1000)
Always use current.update().
Workflow caching

The workflow engine caches commonly-used published workflows to improve performance.

Caching significantly reduces the number of database queries per workflow. By default, the engine caches up to 300 unique workflow versions. Caching very large workflows may reduce this number as the cache size cannot exceed the Java Virtual Machine (JVM) heap size.

To change the maximum number of cached workflow versions, navigate to Workflow > Administration > Properties and modify the value of the The max number of models that will be concurrently held in the LRU cache (glide.workflow.model.cache.max) property. You must restart the instance to apply this change.

Workflow tables

For full flexibility, workflows store information over a number of different tables.

Usually tables containing workflow information are not edited one-by-one. Instead, use the Workflow Editor to edit workflows. The following lists are provided for reference purposes.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflows</td>
<td>A renderer widget for a stage column. Stage renderers are written in Jelly as a UI Macro. The default is Workflow-Driven; it covers most workflow related stage scenarios.</td>
</tr>
<tr>
<td>Column Renderer [column_renderer]</td>
<td>Tracks different versions of element definitions [wf_element_activity].</td>
</tr>
<tr>
<td>Workflow [wf_workflow]</td>
<td>The primary records of workflows.</td>
</tr>
<tr>
<td>Workflow Binding [wf_workflow_binding]</td>
<td>History of workflows run and the triggering record. Workflow Binding records prevent the system from running workflows again when the associated Workflow Context record has been deleted.</td>
</tr>
<tr>
<td>Workflow Context [wf_context]</td>
<td>Individual instances of a workflow being used.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Workflow Execution [wf_workflow_execution]</td>
<td>Synthetic &quot;current&quot; records for workflows that run on Global.</td>
</tr>
<tr>
<td>Workflow Instance [wf_workflow_instance]</td>
<td>Connections of workflows to subflows.</td>
</tr>
<tr>
<td>Workflow Version [wf_workflow_version]</td>
<td>Particular versions of a workflow, either published versions or versions that have been checked out.</td>
</tr>
<tr>
<td>Activities</td>
<td></td>
</tr>
<tr>
<td>Activity Variables [wf_activity_variable]</td>
<td>Variables for activities.</td>
</tr>
<tr>
<td>Workflow Activity [wf_activity]</td>
<td>Activities as they are being used in workflows.</td>
</tr>
<tr>
<td>Workflow Activity Definition [wf_activity_definition]</td>
<td>Definitions of activities that can be used in a workflow.</td>
</tr>
<tr>
<td>Workflow Executing Activity [wf_executing]</td>
<td>Individual instances of activities being performed in active contexts.</td>
</tr>
<tr>
<td>Workflow components</td>
<td></td>
</tr>
<tr>
<td>Element Provider [wf_element_provider]</td>
<td>Template definitions for custom activities.</td>
</tr>
<tr>
<td>Variable [item_option_new]</td>
<td></td>
</tr>
<tr>
<td>Workflow Condition [wf-condition]</td>
<td>All of the defined conditions in workflows.</td>
</tr>
</tbody>
</table>
### Workflow tables (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow Queued Command [wf_command]</td>
<td>Temporary internal storage for workflows that are currently executing.</td>
</tr>
<tr>
<td>Workflow SC Variable [wf_variable]</td>
<td>The Service Catalog variables for a workflow.</td>
</tr>
<tr>
<td>Workflow Schedule [wf_workflow_schedule]</td>
<td>Definitions of the times to run specific workflows.</td>
</tr>
<tr>
<td>Workflow Transition [wf_transition]</td>
<td>All of the defined transitions in workflows.</td>
</tr>
<tr>
<td>History</td>
<td></td>
</tr>
<tr>
<td>Workflow Activity History [wf_history]</td>
<td>The history of executed activities.</td>
</tr>
<tr>
<td>Workflow Log Entry [wf_log]</td>
<td>All of the events and history of the workflow.</td>
</tr>
<tr>
<td>Workflow Transition History [wf_transition_history]</td>
<td>The history of executed transitions.</td>
</tr>
<tr>
<td>Stages</td>
<td></td>
</tr>
<tr>
<td>Stage Default [wf_stage_default]</td>
<td>Definitions of default stage fields for tables to use.</td>
</tr>
<tr>
<td>Stage Set [stage_set]</td>
<td>A named set of stages that can be used to populate workflow stages for multiple workflows.</td>
</tr>
<tr>
<td>Stage Set Entry [stage_set_entry]</td>
<td>The stages that belong to a named stage set.</td>
</tr>
<tr>
<td>Stage Set for Table [stage_set_table]</td>
<td>Defines a relationship of a stage set to a table so that the stage set can be used as the default stages when a new workflow is created for the table. This replaces the wf_default_stage table and is the view that shows when you click Default Stages (by table) in the menu.</td>
</tr>
<tr>
<td>Workflow Stage [wf_stage]</td>
<td>Definitions of stages used by workflows.</td>
</tr>
</tbody>
</table>
**Workflow administration**
Tailor workflows exactly the way you want them.

**Workflow roles**
Certain roles are required to use workflows.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity creator [activity_creator]</td>
<td>Creates and edits custom workflow activities, reuses custom activity data, and manages activity packs downloaded from the ServiceNow Store.</td>
</tr>
<tr>
<td>Web service administrator [web_service_admin]</td>
<td>Accesses and uses REST and SOAP messages in the Orchestration activity designer. Creates and edits custom activities that use the REST web service and SOAP web service templates.</td>
</tr>
<tr>
<td>Workflow administrator [workflow_admin]</td>
<td>Creates, edits, publishes, and deletes graphical workflows.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning:</strong> Granting this role to a user is equivalent to giving the user the admin role, because workflow Script activities bypass access controls and grant access to all tables and database operations. Script activities do not bypass application scope settings.</td>
</tr>
<tr>
<td>Workflow creator [workflow_creator]</td>
<td>Creates new graphical workflows.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning:</strong> Granting this role to a user is equivalent to giving the user the admin role, because workflow Script activities bypass access controls and grant access to all tables and database operations. Script activities do not bypass application scope settings.</td>
</tr>
<tr>
<td>Workflow publisher [workflow_publisher]</td>
<td>Publishes graphical workflows.</td>
</tr>
</tbody>
</table>
Administering workflow contexts

The workflow context performs the activities and transitions defined in the workflow with the new record as current.

Workflow in ServiceNow names a running workflow a Workflow Context. The Workflow Context maintains the state of the overall process in the Workflow Context record. The Workflow Context maintains the state of the individual activities as they execute in a series of related lists. These lists maintain the state of currently executing activities, the result of finished activities, and the execution path the workflow took through the process model.

The Workflow Context canvas provides a visual representation of the execution path the workflow took through the process model. The state of each activity (finished, executing, cancelled, error) is represented using the color palette. The executed paths are represented in the color blue; the non-executed paths are represented in grey. Active and historic workflow contexts, as well as the activities within them, can be viewed using the Live Workflows section of the Workflow application menu.

Viewing a workflow context

Workflow contexts can be found in two places:

- From the Workflow Context related link on the form of the task being powered by the workflow.
- By navigating to Workflow > All Contexts and selecting an active context.

Displaying workflow progress

Two related links on the Workflow Context form allow you to view the progress of a workflow in different formats.

- Show Timeline displays the workflow context as a timeline.
- Show Workflow displays the workflow context in the graphical Workflow Editor.

Graphical interface

To view the workflow context in the graphical Workflow Editor interface, click the Show Workflow link from either the workflow context record or the current record.
In the top right hand corner are two controls:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="refresh_icon.png" alt="Refresh" /></td>
<td>Refreshes the workflow context.</td>
</tr>
<tr>
<td><img src="help_icon.png" alt="Help" /></td>
<td>Displays a key of the colors used in the workflow to denote the state of activities and transitions:</td>
</tr>
</tbody>
</table>

**Execution order**

View tooltip text in the workflow context graphical view to see the execution order of individual activities.

In **Workflow > Live Workflows > Active Contexts** or **All Contexts**, Open the context you want to examine. Click **Show Workflow**, and point to a finished or executing activity. The tooltip shows error data, execution time, and the order in which the activity executed in the workflow. Use this data to help troubleshoot activities in an error state.
Cancel a workflow

Canceling a workflow stops the workflow from executing and sets the workflow context **State** to **Canceled**. To cancel an executing workflow, you can use the `cancelContext(context)` script. You can define an `onCancel` script to clean up unresolved workflow activities.

**About this task**

Canceling a workflow attempts to stop the workflow gracefully by injecting a cancel command into the workflow engine.

**Procedure**

1. Navigate to **Workflow > Active Contexts**.
2. Select a workflow context record.
3. Select the **Cancel** related link.
   A confirmation window appears.
4. Click OK.
   The Wait for Cancel window appears. The workflow engine attempts to cancel the workflow gracefully.

If the workflow does not respond to the cancel command, the Force Cancel window appears.

5. Click Force cancel to interrupt the thread the workflow is actively executing or click Continue waiting to continue waiting for the workflow to cancel gracefully.

⚠️ Warning: Whenever possible, allow a workflow to cancel gracefully. Forcing a workflow to cancel can leave related workflows and scripts in an unresolved state. You can use an on-cancel script to clean up unresolved artifacts from a cancelled workflow.
Cancel a workflow with the `cancelContext(context)` script

To cancel an executing workflow, you can use the `cancelContext(context)` script. This script can be useful in cases where a workflow must be canceled in response to an event or where a user must manually cancel a workflow.

**About this task**
For more information, see the API reference.

Define an on-cancel script

Canceling a workflow can leave records or scripts in an unresolved state. For example, canceling a service catalog workflow may leave catalog items in the requesting user's cart. An administrator can specify an On-cancel script that runs when the workflow transitions to the Canceled state. This script can notify users, log information, or resolve the state of any scripts run within a workflow activity. The sys_id of the workflow context is available in this script using the `context_sys_id` variable.

**About this task**
On-cancel scripts run asynchronously from the global scope. Your instance workload determines when the system schedules and runs the on-cancel script.

**Important:** Since the system runs on-cancel scripts from the global scope, they cannot call or run scoped script includes.

**Procedure**

1. Navigate to **Workflow > Workflow Versions**.
2. Select a workflow version that you have checked out. Workflow versions that are not checked out are not editable.
3. Edit the **On-cancel script** field. You may need to configure the form to add this field.
4. Click **Update**.

**Example:**
This example script adds a comment to a Requested Item [sc_req_item] record indicating the workflow for that request has been canceled.

```javascript
var grContext = new GlideRecord("wf_context");
grContext.get(context_sys_id);
var grReq = new GlideRecord("sc_req_item");

// The current record may not exist, make sure it exists before modifying it.
if (grReq.get(grContext.id)) {
```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Scheduling a workflow

In addition to being run based on conditions, workflows can also be scheduled to perform at a particular time, similar to a scheduled job.

Scheduled workflows do not have a defined current record and do not run on specific records within a table. Due to this behavior, certain activities that depend on a current record, such as Create Task or Catalog Task are unavailable on scheduled workflows. If your workflow requires one of these activities, consider using a scheduled job that inserts a record to start the workflow instead of using a scheduled workflow.

To schedule a workflow, navigate to Workflow > Scheduled Workflows and click New. Populate the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the scheduled workflow.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Select an existing published workflow to be triggered at the specified date, time, or interval.</td>
</tr>
<tr>
<td>Active</td>
<td>If selected, the scheduled workflow will be triggered at the appropriate time.</td>
</tr>
<tr>
<td>Application</td>
<td>Specifies the type of application, such as Global.</td>
</tr>
<tr>
<td>Run</td>
<td>A choice list to determine when the workflow should be triggered. Options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Daily</strong>: At a particular hour every day.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Weekly</strong>: On a particular day of the week.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
|               | • **Monthly**: On a particular day of the month  
|               | • **Periodically**: After every set duration.  
|               | • **Once**: At one specific date and time.  
| Time          | For daily/weekly/monthly scheduled workflows, the time of day to run the workflow.  
| Day           | For weekly scheduled workflow, the day of the week to run the workflow.  
|               | For monthly scheduled workflows, the day of the month to run the workflow.  
| Repeat Interval | For periodical workflows, the interval between workflows, beginning from the **Starting** date and time.  
| Starting      | For periodical workflows, the first date and time to run the workflow.  
|               | For scheduled workflows run once, the date and time to run the workflow.  

**Related information**

**Workflow movement with update sets**

The system tracks workflows in update sets differently than other records because workflow information is stored across multiple tables.

Changes made to a workflow version are not added to the update set until the **workflow is published**, at which point the entire workflow is added into the update set. Update sets store workflows as a single Workflow [wf_workflow] record and only retain the latest version with the update type of Workflow.

For information about update sets, see [System update sets](#).

**Workflow update set migration use case - simple**

Create a new workflow with no dependencies and then migrate the workflow in an update set.
1. User A selects Update Set A.
2. User A creates a new workflow called Workflow A.
3. User A publishes Workflow A.

   A customer update set record is added to Update Set A containing an XML payload, including the published Workflow A and all activity dependencies. The XML payload also contains the workflow input variables associated with the workflow.

4. User A completes Update Set A and migrates it to the production instance.
5. Update Set A commits successfully.
6. Workflow A works as expected.

**Workflow update set migration use case - subflow dependency (success)**
Successfully edit and migrate an existing workflow and its dependent subflow.

1. User A selects Update Set B.
2. User A checks out Workflow A.
3. User A adds a subflow called Workflow B to Workflow A.

   Assume that Workflow B was previously published and migrated to the production instance.

4. User A publishes Workflow A.

   A customer update set record is added to Update Set B containing an XML payload, including the published Workflow A and all activity dependencies. The XML payload also contains the workflow input variables associated with the workflow.

5. User A completes Update Set B and migrates it to the production instance.
6. Update Set B commits successfully.
7. Workflow A works as expected with Workflow B as a subflow.

**Workflow update set migration use case - subflow dependency (failure)**
Edit and migrate an existing workflow from a test instance to a production instance that fails to run on the production instance because of a missing dependent subflow.
1. User A selects Update Set C.
2. User A checks out Workflow A.
3. User A adds a subflow called Workflow B to Workflow A.
   Assume that Workflow B was previously published, but has not been migrated to the production instance.
4. User A publishes Workflow A.
   A customer update set record is added to Update Set C containing an XML payload, including the published Workflow A and all activity dependencies. The XML payload also contains the workflow input variables associated with the workflow.
   Notably absent from Update Set C is the subflow called Workflow B. Workflow B was published before User A selected Update Set C.
5. User A completes Update Set C and migrates it to the production instance.
6. Update Set C commits with warnings.
7. Workflow A is invoked on the production instance with the following results:
   Workflow A fails the runtime validation check and is prevented from running on the production system. The system adds to the workflow context a workflow log entry detailing the cause of the failure, notably the absence of a dependent workflow.
   To learn more about the validation checks on workflow dependencies and update sets see ValidateUpdateSetDependencies.

Workflow update set migration use case - subflow dependency (risk)
Multiple users migrate a workflow from a test instance to a production instance without proper coordination. This use case can succeed, but only when each user understands the dependencies and properly migrates the dependent parts of the workflow to the new instance.

This example does not represent an update set failure, although update sets are most often blamed in this use case. Validation increases the visibility of workflow dependencies across multiple update sets and provides designers with better information. In most cases, the warnings do not prevent an action, but only identify risk. The designer is responsible for taking action on advice given in the validation checks.

1. User A selects Update Set C.
2. User A checks out Workflow A.
3. User A adds a subflow called Workflow B that returns a **User ID**.

   † **Note:** Assume that Workflow B was previously published and migrated to the production instance.

4. User A uses the return value of Workflow B to generate approvals.

5. User B selects Update Set D.

6. User B checks out Workflow B (the subflow in Workflow A).

7. User B modifies the return value of the workflow by changing it from a **User ID** to a **String Message**.

8. User A publishes Workflow A.

   † **Note:** A dialog box displays warnings associated with Workflow A and encourages User A to validate the workflow before publishing.

9. User A cancels publishing and **validates** Workflow A.

10. User A is warned that Workflow B was modified by a user in a different update set.

11. User A ignores this warning and publishes Workflow A.

   † **Note:** A customer update set record is added to Update Set C containing an XML payload, including the published Workflow A and all activity dependencies. The XML payload also contains the workflow input variables associated with the workflow.

12. User A completes Update Set C and migrates it to the production instance.

13. Workflow A is invoked on the production instance and runs successfully using the older version of Workflow B already on the system.

14. User B publishes Workflow B.

   † **Note:** User B is not warned of the Update Set C dependency, because the update set is no longer In progress. However, User B is informed via a dialog box that there are warnings associated with the workflow version and is instructed to validate Workflow B. If User B cancels publication and validates the workflow, User B is warned that there are workflows that use Workflow B as a subflow. Knowing the return value was changed, User B should test those workflows as well. See `ValidateUpdateSetDependencies` to understand the parameters of update set warnings.

15. User B finally publishes Workflow B.
1. Note: A customer update set record is added to Update Set D containing an XML payload, including the published Workflow B and all activity dependencies.

16. User B completes Update Set D and migrates it to the production instance.
17. Update Set D commits without warnings.
18. Workflow A is invoked on the production instance and fails to run successfully, because the return value of Workflow B no longer generates a User ID.

**Input variable movement**

You can add input variables to existing workflows and add them to update sets.

When you submit the new variables, an entry is made into the current update set that reflects the addition of a variable to the Variables [var_dictionary] table. Unlike the workflow version that only writes to the update set when the workflow is published, the variables write individual update entries into the currently selected update set immediately upon submission.

**Input variable movement use case - two input variables**

An existing workflow already contains two input variables.

1. User A checks out the workflow.
2. User A adds two input variables.
   ServiceNow adds to the current update set one customer update record for each new variable.
   The current workflow now has 4 input variables: the two that were present prior to check out and the two new ones.
3. User A publishes the workflow.
   There are now three related customer update records: two for new variables, and one for the published workflow. The XML payload of the new workflow version now includes all input variable database entries. So while the two original input variables do not have individual customer update records, all four variables are migrated to the local instance with the payload of the newly published workflow version.
4. Verify variables included in a specific workflow.
5. User A completes the update set.
6. Adding Input Variables - Success
User A migrates and commits the update set to a local instance where the original workflow version had previously been committed.

- The two existing input variables are already present because of the earlier version.
- The system adds the two new input variables when the user commits the update set.
- The system preserves the two legacy input variables on the instance receiving the update set. The update set does not overwrite these variables.
- The new published workflow version uses all four variables.
- The user tests the new workflow version and it runs as expected.

Verify variables included in a specific workflow

You can verify the variables that are included in a specific workflow.

Procedure

1. Navigate to System Update Sets > Local Update Sets.
2. Select the active update set.
3. Select the customer update entry for the workflow.
4. View the XML Payload.
5. Search for the name of one of the columns or search for var_dictionary.
   There is one var_dictionary entry for each input variable.

Input variable removal

Deleting workflow input variables, like insert and update actions, creates a customer update record in a user’s current update set.

These deletions migrate to a new instance with the update set, regardless of whether the workflow that owns the input variables is published in the same update set. Plan carefully and use caution when editing a workflow and selecting update sets.

Input variable removal risk

An existing workflow already contains two input variables.
1. The workflow was migrated to a production instance with the two variables.

2. On a development instance, User A selects Update Set A and checks out the workflow.

3. User A removes one input variable and all references to it in the workflow.

   The system enters into Update Set A one customer update record reflecting the deletion of the input variable. No record is added for the new workflow version which no longer depends on the input. This does not happen until the workflow is published.

4. User A continues working on other features in Update Set A that need to be moved to production.

5. User A completes Update Set A and migrates it to the production instance without publishing the workflow.

   The update set entry that deletes the workflow input variable now applies to the production instance. The prior version of the workflow is running on this instance and still references the missing variable.

Input variable removal solution

When editing workflows, particularly when deleting input variables, be sure to use a single update set for all variable editing and workflow publishing.

If necessary, merge the update set into a more general set targeted for deployment after the workflow is published. For information about update sets, see System update sets.

Note: If a workflow version is already running on a production system and input variables are deleted from a newer version, those deletions could affect transactions already running against the earlier version. Use extreme caution when deleting workflow input variables and plan the migration carefully.

Input variable removal prevention

Prior to publishing a workflow version, the system validates the workflow model to assist the designer in planning for deployment.

This validation warns of critical errors that can prevent a workflow from running successfully, but also warns of dependencies and conflicts in update sets. See ValidateUpdateSetDependencies for more details.
Avoiding duplicate workflows

Update sets manage the published state of all versions of a workflow prior to committing the workflow version on a local instance.

The last version of a workflow committed as an Insert or Update using an update set becomes the currently published version, regardless of the publishing sequence for the workflow versions.

Commit a workflow in an update set

Follow the steps in this page to commit a workflow in an update set.

Procedure

1. Workflow A - Version 1 is created and published in Update Set A.
2. Update Set A is completed and migrated to a local instance.
3. When the update set is committed, the system sets all prior versions of Workflow A to published = false.
   In the first migration, there are no prior versions.
4. Workflow A - Version 1 becomes the only published version of the workflow.

Update set migration example

It is not possible to have multiple published versions as a result of update set commits. However, this does not eliminate risk, and care should be taken when migrating update sets.

Consider this example:

1. Workflow A - Version 1 is migrated and committed to the production instance.
2. Update Set B is created.
3. Update Set C is created.
4. Workflow A - Version 2 is published in Update Set B.
   A customer update record is added to Update Set B with the Version 2 payload.
   A customer update record is added to Update Set B with the Version 1 workflow left unpublished.
5. Update Set B is completed.
6. Workflow A - Version 3 is published in Update Set C.
A customer update record is added to Update Set C with the Version 3 payload.

A customer update record is added to Update Set C with the Version 2 workflow left unpublished.

7. Update Set C is completed.

8. Update Set C is migrated and committed to the production instance.
   Workflow A - Version 1 is set to unpublished.
   Workflow A - Version 2 update is skipped since Update Set B, which contains Version 2, was never migrated.
   Workflow A - Version 3 is committed and becomes the only published version of the workflow.

Update set migration risk
Update Set B is migrated and committed to the production instance.

1. Workflow A - Version 3 is set to unpublished.
3. Workflow A - Version 2 is committed and becomes the only published version of the workflow.
   The workflow has gone back a version, perhaps unintentionally. The regressed version becomes the currently published version.

Workflow timelines
The system provides a timeline view of history activities associated with a workflow context.

Timelines display a linear calendar of activities, such as tasks and approvals, defined by their start and end dates. Each activity on the timeline is represented by a span, which is displayed as a horizontal, colored bar. Each span has a label and a tooltip that contains additional information about the activity. The left pane displays all the activities in the context (or contexts) in an expandable hierarchy. You can change the timeline's perspective for a more granular view of the data.

Note: Workflow timelines reflect context history only and are not real-time gauges of workflow activity.
Use a timeline

By default, the timeline displays all activities and transitions requested when first opened.

About this task

Collapse any part of the hierarchy in the activity pane and the timeline adjusts automatically. Date/time and duration controls enable you to scale the timeline to view all the elements at once. To display a timeline, click a UI action within a Workflow Context record.

Procedure

1. Navigate to Workflow > Live Workflows > Active Contexts.
2. Select a context.
3. In Related Links, click Show Timeline to display the timeline for the entire context.

The timeline opens with all activities expanded and the view set to Max, which displays the entire timeline at the width of the pane. The title of the timeline is in the form Workflow context: <context name>, Requested Item: <requested item number>.

4. Use the Range Selectors at the top of the timeline to change the perspective.

The increments go from one day to one year. To limit the timeline to an increment between the start date of the first span and the end date of the last span, click Max.
5. Use the starting and ending calendar fields to select the timeline perspective. These fields control the same perspective as the slider at the bottom of the timeline.

6. Use the pink slider at the bottom of the timeline to change the perspective.

   a. Move the slider from right to left to view all the spans on a long timeline.

   b. Adjust the end points of the slider to make arbitrary changes to the magnification.

      A narrow slider zooms in on the spans and provides a more detailed view of complex timelines. A wide slider pulls the view out and makes more of the timeline visible on the screen.

7. To focus the timeline view on selected activities, expand or collapse the activity tree.

   Spans not visible in the activity tree are not shown in the timeline pane.

8. Hover over an activity span to display a tooltip with information about the activity.

   This action highlights the activity in the activity pane.

9. Hover over the transition between two activities to highlight the activity and the predecessor activity in the activity pane.
10. Double-click a span to display a history record for that activity. History records shows information such as the State and the starting and ending times.

Timeline for a selected activity
You can display a partial workflow timeline.

Procedure
1. Navigate to Workflow > Live Workflows > Active Contexts.
2. Open a Workflow Context record.
3. On the Workflow Activity History related list, select one or more individual activities.
4. Click Show Timeline from the action menu.
   The resulting view is a snapshot of the timeline, showing only the selected activities and their transitions, if any.
5. Collapse the tree to confine the view even further.
6. To view a timeline displaying activities from different contexts:
   You might use this feature to display a subflow's context with the parent workflow context.
   
a. Navigate to Workflow > Live Workflows > History.
   
b. Select individual history items from the list.
   
c. Select the Show Timeline option from the actions menu.

   History items are arranged in a hierarchy in the activities pane under their contexts. The timeline title is Multiple Contexts. The timeline draws only the activities and relationships of the history items selected.

**View subflows in a workflow timeline**

In a workflow timeline, subflow spans appear as a different color than the activities of the main workflow.

**Workflow error handling**

The personalized JavaScript that users create in workflow activity variables is vulnerable to run-time syntax errors. Available error information is available in a tooltip when you point to a workflow activity in an error state.
In the base system, workflow activities do not provide condition routing on the error state. As a result, the workflow progresses based on the state of the current record. For example, a workflow contains an Approval - User activity that uses an advanced script to add additional approvers. A syntax error in the script results in no approvers being added. Because a state of no approvers is a valid return, even without the syntax error, the approval activity is skipped and the workflow progresses along a positive path. However, this might not be a valid response for the workflow designer who does not want the workflow to progress along the positive path without approvers.

Workflow error handling detects and logs syntax errors and provides a state that the workflow designer can use to add error conditions to the workflow. Use error handling to locate syntax errors in advanced script fields for these workflow activities:

- Approval - User
- Approval - Group
- Catalog Task
- Create Task
- If
- Run Script
- Notification

**Available error information**

This table shows which activities support error exits.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Workflow log</th>
<th>Red error indicator</th>
<th>Activity state</th>
<th>Activity result</th>
<th>Fault description</th>
<th>Reroute on error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval - User</td>
<td>Yes</td>
<td>Yes</td>
<td>Error</td>
<td>Skipped</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Approval - Group</td>
<td>Yes</td>
<td>Yes</td>
<td>Error</td>
<td>Skipped</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Catalog Task</td>
<td>Yes</td>
<td>No</td>
<td>Finished</td>
<td>none</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Create Task</td>
<td>Yes</td>
<td>Yes</td>
<td>Error</td>
<td>none</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>If</td>
<td>Yes</td>
<td>Yes</td>
<td>Error</td>
<td>error</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Run Script</td>
<td>No</td>
<td>Yes</td>
<td>Error</td>
<td>error</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Available error information (continued)

<table>
<thead>
<tr>
<th>Activity</th>
<th>Workflow log</th>
<th>Red error indicator</th>
<th>Activity state</th>
<th>Activity result</th>
<th>Fault description</th>
<th>Reroute on error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification</td>
<td>Yes</td>
<td>Yes</td>
<td>Error</td>
<td>error</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Workflow error tracking features

Error handling provides visual cues within the workflow, such as error descriptions for activities in pop-ups, and detailed log records.

Banners

Look for an activity with a red banner, indicating that a syntax error has occurred in a script field. All activities that provide error handling, with the exception of Catalog Task and Create Task, display a red banner for this error.

![Image of a red banner with activity details]

Tooltips

Point to the activity displaying a red banner to view information about the error. A tooltip shows the State and Result of the activity and provides a brief Fault Description (except for task activities). Note that this approval continued as skipped despite the error given in the fault description. See Workflow error handling for the information available to each activity.

![Tool tip image]

Execution order

Tooltip text in the Workflow Context graphical view displays the execution order of individual activities, which assists in troubleshooting.

To view the order in which a workflow activity was executed:

1. Navigate to Workflow > Live Workflows > Active Contexts or All Contexts.
2. Open the context you want to examine.
3. Click **Show Workflow**.

4. Hover the cursor over a finished or executing activity.

A tooltip appears showing error data, execution time, and the order in which that activity executed in the workflow. You can use this data to help troubleshoot activities in an error state.

![Activity execution order](image)

**Workflow log**

View the log in the Workflow Context form for more information about the syntax error in the activity. Since task activities do not display a red banner when a syntax error has occurred, you must view the log if you suspect the workflow has not run properly. Examine the error description in the log, and then inspect the script in the activity named in the log.

To view the activity by name, navigate to **Workflow > Administration > Properties** and enable the **Log workflow debug messages** property.

In this example, an SSH activity named File Read specifies an invalid MID Server.
If the credentials used by an activity in the workflow fail, and the activity cannot authenticate on the target, a message describing the failure appears in the **Workflow Log** related list. The message displays the target IP address and the credential details.

### Credential debugging in the workflow log

![Credential debugging in the workflow log](image)

**Create an error condition exit**

An administrator can reroute the workflow when a script error occurs by creating an error condition exit for specific activities within the workflow. This allows the workflow to process script errors in a predictable way and not create undesirable results.

**Procedure**

1. Open and check out a workflow.
2. Right-click in the top portion of the activity for which you want to create an error exit.
3. Select **Add condition** from the context menu.
4. Add a condition exit with the following values:
• Name: Error
• Condition: `activity.state=='faulted'`

5. Click Submit.

The Error exit appears on the activity.

6. Connect the Error exit to another activity for handling the error state, such as Notification or Log Message.

Reconfigure an approval condition

Approval activities react differently to script errors than the other activities.

About this task

Approval activity script errors can prevent an approval from being processed successfully. This, in turn, can cause the approval to complete as Skipped, which can appear to be an Approved state. To prevent this from happening, reconfigure the Approved exit as follows:

Procedure

1. Open an approval workflow and make sure it is checked out.
2. On an approval activity, double-click the Approved exit.
3. Add the following script to the Condition field:

   ```javascript
   && activity.state != 'faulted'
   ```

   This prevents the activity from continuing down the normal path in an error state and ensures that Skipped or Approved is the desired state.
4. Click Update.
Workflow run time metrics

You can enable the collection of workflow run time metrics to determine whether workflows are performing as expected or consuming additional resources.

Outlying run times for a workflow are identified by comparing actual run times to an outlier range calculated with the outlier threshold and estimated run time defined in the workflow properties.

You can monitor the results of these metrics on the Workflow Operations Dashboard and custom homepages with workflow gauges.

Enable workflow run time metrics

Provide an estimated run time that can be compared to actual workflow run times.

About this task

For baseline workflows, you must also manually enable the collection of run time metrics. The system automatically enables the collection of run time metrics for new workflows.

Procedure

1. Navigate to Workflow > Workflow Editor.
2. Open and check out the workflow.
3. In the title bar, click the menu icon and select Properties.
4. In the Workflow Properties dialog box, click the Estimated Runtime tab.
5. To enable the collection of run time metrics, check that the Requires ERT option is selected.
6. Open a configuration from the Estimated Run Time column.
7. In Estimated Run Time, enter an initial estimate for the workflow’s run time.
   The system compares this initial estimate to actual run time results to create outlier reports. The system can automatically update this field in certain circumstances. Workflow designers can also manually update this field.
8. In the Outlier Percentage Threshold for ERT field, enter the percentage deviation from the estimated run time that identifies an outlier workflow run time.
   The system uses a default value of 20.
9. Click Update.
**Outlying workflow run times**

Workflow run times are identified as outliers when they are longer or shorter than the outlier range that is computed for the workflow.

The outlier range is automatically computed with the *Estimated Run Time* and *Outlier Percentage Threshold for ERT* values in the workflow properties. These values are used in the following formulas.

### Formulas for computing workflow outlier ranges

<table>
<thead>
<tr>
<th>Value computed</th>
<th>Computation used</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outlier Value</td>
<td>Estimated Run Time * (Outlier Percentage Threshold for ERT / 100)</td>
<td>10 seconds * (20 / 100) = 2 seconds</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10 seconds * 0.2 = 2 seconds</td>
</tr>
<tr>
<td>Outlier Range</td>
<td>(Estimated Run Time - Outlier Value) to (Estimated Run Time + Outlier Value)</td>
<td>(10 seconds - 2 seconds) to (10 seconds + 2 seconds) = 8 to 12 seconds</td>
</tr>
</tbody>
</table>

When a workflow runs within the outlier range, its estimated run time is automatically updated.

If a workflow has an outlying run time, it appears in any outlier workflow gauges on the Workflow Operations Dashboard and custom home pages.

### Workflow estimated run time updates

When a workflow runs within the outlier range, its estimated run time is automatically updated.

The estimated run time is updated with the cumulative moving average of the latest run time value in relation to previous run times. The computed value is rounded to the nearest second and stored as a GlideDateTime.

For example:

<table>
<thead>
<tr>
<th>Data point</th>
<th>Latest value (CRA)</th>
<th>Cumulative running average (CRA)</th>
<th>CRA after rounding to the nearest second</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10 seconds</td>
<td>10 seconds</td>
<td>10 seconds</td>
</tr>
<tr>
<td>2</td>
<td>12 seconds</td>
<td>11 seconds</td>
<td>11 seconds</td>
</tr>
</tbody>
</table>
Data point | Latest value | Cumulative running average (CRA) | CRA after rounding to the nearest second  
---|---|---|---
3 | 9 seconds | 10.333 seconds | 10 seconds

**Note:** Because the system rounds to the nearest second, the calculation is less precise with short durations.

You can also manually update the estimated run time in the workflow properties.

**Workflow pause utility**

Workflow Pause Utility provides functionality you can use to pause or resume all workflow contexts, a subset of qualified workflow contexts, or individual workflow contexts. You designate the data and time of day at which the paused workflows should resume, and can manually resume individual workflows as needed.

Once activated, the Workflow Pause Utility plugin (com.glideapp.workflow.pause) updates several tables when you pause or resume workflows. Each table stores specific data related to each paused or resumed workflow.

**wf_pause_request**

Records every workflow pause request. The system automatically updates and inserts records in this table whenever you pause workflow contexts. It tracks user-specified resume time, whether the pause request is still active, and the total number of workflow activities that paused or resumed.

**wf_pause_status**

Records the status of each workflow context you pause. When you pause workflow contexts, the plugin waits until the current executing activity finishes, and pauses it before the next activity starts. It tracks the specific activity on which the workflow context was paused and whether it has resumed. If the workflow is paused, it tracks the time at which it is scheduled to resume.

**wf_pause_group_request**

Pauses the specific set of workflow contexts you designate using filtering in Group Pause Requests. You can manually pause all currently active workflows by clicking the Pause All check box.

**wf_pause_snapshot**
Before pausing and after resuming a workflow, the table records a snapshot of the current state of the workflow context. The table also records the state of the currently executing activity on the paused workflow context.

**Use examples**

When you take down an instance for maintenance, you can pause all or selected active workflow contexts, and then resume them after you complete the maintenance.

You have an integration workflow context that hits an internal service that is down for maintenance. You can pause all instances of that workflow context from progressing to the next activity, allowing time for the internal service to be restored. Then, the paused workflow contexts can be resumed.

**Activate workflow pause utility**

You can activate the Workflow Pause Utility plugin (com.glideapp.workflow.pause) if you have the admin role. This plugin may include demo data and activates related plugins if they are not already active.

**Before you begin**

Role required: Workflow_admin or workflow_publisher, workflow_creator

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note**: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the *global* domain. Otherwise, the following error appears: *Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>*.

**Related information**

[List of plugins](#)
Pause and resume individual workflows

To pause individual workflow contexts, specify the date and time of day at which the workflow context should resume. When a workflow context is paused, the system saves basic information about the pause request, such as the resume date and time, in the wf_pause_request table. A workflow context automatically resumes at a specified date and time of day, but paused workflow context can be manually resumed as needed.

Before you begin
Role required: Workflow_admin or workflow_publisher, workflow_creator
Install and activate the Workflow Pause Utility plugin.

Procedure
1. Navigate to Workflow > Live Workflows > Active Contexts.
2. Select the individual workflow context you are pausing.
   Workflow Context appears.
3. In Related Links, click Pause.
   A Workflow Pause Inputs dialog appears.
4. In the Workflow Pause Inputs dialog:
   a. Click to select the date, and enter the time of day (in hours, minutes, and seconds) at which the workflow should resume. You can select the current date or future date, but you must enter a time of day in the future. For example, to pause the workflow context at 13:30:00 (1:30 pm), select the date from the calendar, and then enter 13, 30, and 00 into the respective Time: fields.
   b. Click when finished.
   c. The selected date and time of day appear in the Resume At field.
   d. Click OK to return to Workflow Contexts.
      The selected workflow is now paused. Use Workflow pause request to monitor its status.
5. Paused workflows resume on the date and time of day specified in the Resume At field. To manually resume a currently paused workflow context:
a. Navigate to **Workflow > Live Workflows > Active Contexts.**

b. Select the individual workflow context you are pausing. **Workflow Context** appears.

c. In **Related Links**, click **Resume**.

**Pause and resume all or multiple workflows**

Use Workflow Pause Group Requests to pause, or resume, groups of workflows, or all active workflows. If pausing a group of workflows, use filtering functions to select the workflows. If pausing all active workflows, select the Pause All check box to indicate that all currently active workflows should be paused.

**Before you begin**

Role required: Workflow_admin or workflow_publisher, workflow_creator

Install and activate the Workflow Pause Utility plugin.

**Procedure**

1. Navigate to **Workflow > Operations > Group Pause Requests.** **Workflow Pause Group Requests** appears and displays existing workflow pause group requests.

2. Click **New**.

   **Workflow Pause Group Request** appears, and assigns a workflow pause group request ID.

3. To pause all active workflows, select **Pause All**, then click **Update**. To pause a filtered group of active workflow contexts, skip this step.

   All currently active workflow contexts in the instance are paused until you resume them. Use **Workflow pause request** to monitor their status.

4. To pause a filtered group of active workflow contexts, use the **Filter** field, specify the conditions for the search, then click **Update**.

   **Workflow Pause Group Requests** appears, and displays the results of the workflow group search. It assigns a workflow pause group request ID and indicates if the group is active (true = paused) or inactive (not yet paused).

5. To update, resume or delete a specific workflow pause group request, select it.

   **Workflow Pause Group Request** appears, and displays the selected workflow pause group request.

6. If the selected workflow pause group request is active (paused), and you do not want to pause it, click **Do Not Pause Incoming Workflows**. If the selected
workflow pause group request is inactive (not yet paused), click **Pause** to pause it.

7. For the paused workflow group request, use the **Resume At** field to specify the date and time of day at which the paused workflow contexts should resume.

   a. Click ![calendar icon] to select the date, and enter the time of day (in hours, minutes, and seconds) at which the workflow contexts should resume. You can select the current date or future date, but you must enter a time of day in the future.
   
   For example, to pause the workflow context group at 13:30:00 (1:30 pm), select the date from the calendar, and then enter 13, 30, and 00 into the respective **Time** fields.

   b. Click ![checkmark icon] when finished.

   c. The selected date and time of day appear in the **Resume At** field.

   d. Click **OK** to return to Workflow Pause Group Request.

8. Click **Submit**.

9. Paused workflow contexts automatically resume on the date and time of day specified in the **Resume At** field. To manually resume currently paused workflow contexts:

   a. Navigate to **Workflow Pause Group Requests**.

   b. Select the workflow pause group request to resume.

   **Workflow Pause Group Request** appears.

   c. Click **Resume**, and then click **Update**.

10. Workflow Group Pause Request also contains the following information fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Indicates if workflow group is paused.</td>
</tr>
<tr>
<td>Completed Resume Activity Count</td>
<td>Number of resumed workflow context activities that are completed.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Filter</td>
<td>Standard filtering fields used to specify the conditions for selection of a group of workflow contexts.</td>
</tr>
<tr>
<td>Log</td>
<td>Activity work notes generated by the group pause request.</td>
</tr>
<tr>
<td>Not Transitioned Workflow Count</td>
<td>Number of workflow contexts that were not transitioned when the group pause request was placed. When a group pause request is placed, the affected workflow contexts are paused before start of the next activity.</td>
</tr>
<tr>
<td>Resume Act Count</td>
<td>Number of workflow context activities resumed after the group pause completed.</td>
</tr>
<tr>
<td>Pause Act Count</td>
<td>Number of paused workflow context activities.</td>
</tr>
<tr>
<td>Requester Name</td>
<td>Name of the person requesting the workflow context pause.</td>
</tr>
<tr>
<td>Pause percentage</td>
<td>Total percentage of workflow contexts that are paused.</td>
</tr>
<tr>
<td>Resume Percentage</td>
<td>Total percentage of workflow contexts that have resumed.</td>
</tr>
<tr>
<td>Total Workflow Count</td>
<td>Total number of workflows matching the specified filter conditions that are being paused.</td>
</tr>
<tr>
<td>Paused Workflow Count</td>
<td>Number of current paused workflow contexts.</td>
</tr>
</tbody>
</table>

**Monitor workflow pause requests**

You can monitor the status of workflow pause requests using Workflow Pause Request.

**Before you begin**

Role required: Workflow_admin or workflow_publisher, workflow_creator
You must install and activate the Workflow Pause Utility plugin.

**Procedure**

1. Navigate to **Workflow > Operations > Pause Requests**.

   **Workflow Pause Requests** appears and displays existing workflow pause requests.
2. Select the workflow pause request.  

*Workflow Pause Request* appears, and displays the selected workflow pause request.

**Workflow pause request fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Req Number</td>
<td>Unique assigned pause request number.</td>
</tr>
<tr>
<td>Completed Resume Activity Count</td>
<td>Number of workflow context activities resumed after the pause completed.</td>
</tr>
<tr>
<td>Pause Active</td>
<td>Selected indicates the workflow context is currently paused. Cleared indicates it is not.</td>
</tr>
<tr>
<td>Transitioned During Pause</td>
<td>Number of workflow contexts that transitioned when the pause request was placed. When a pause request is placed, the affected workflow contexts are paused before start of the next activity.</td>
</tr>
<tr>
<td>Workflow Context</td>
<td>Reference number for the paused workflow context.</td>
</tr>
<tr>
<td>Log</td>
<td>Activity work notes generated by the group pause request.</td>
</tr>
<tr>
<td>Paused Act Count</td>
<td>Date and time of day (h:m:s) at which the paused workflow context is resuming.</td>
</tr>
<tr>
<td>Requester Name</td>
<td>Name of the person who requested the workflow pause.</td>
</tr>
<tr>
<td>Resume Act Count</td>
<td>Number of workflow context activities resumed after the pause completed.</td>
</tr>
<tr>
<td>Resume At</td>
<td>Date and time of day (h:ms:s) at which the workflow contents are scheduled to resume.</td>
</tr>
<tr>
<td>Table</td>
<td>Related record table name.</td>
</tr>
<tr>
<td>Application</td>
<td>Application in which the workflow context is executing.</td>
</tr>
<tr>
<td>Exec Act Count</td>
<td>Number of activities executing when the workflow context was paused.</td>
</tr>
<tr>
<td>Group Pause Request</td>
<td>Reference number for the associated group pause request, if any. Appears only if pause request was the result of a group pause request.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Is Workflow Complete</td>
<td>Selected indicates the workflow context is complete. Cleared indicates it is not.</td>
</tr>
<tr>
<td>Is Workflow Stuck</td>
<td>Selected indicates the workflow context is stuck. Cleared indicates it is not.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the workflow context - Paused or Resumed.</td>
</tr>
<tr>
<td>Stuck Activities Count</td>
<td>The number of workflow context activities that are stuck.</td>
</tr>
<tr>
<td>Stuck Act Count</td>
<td>Writer to whom the documentation request is assigned.</td>
</tr>
<tr>
<td>To be subtracted for Pause</td>
<td></td>
</tr>
<tr>
<td>Percentage</td>
<td></td>
</tr>
</tbody>
</table>

**Encrypted workflow scratchpad**

The Encrypted Workflow Scratchpad plugin (com.snc.encrypted.scratchpad) provides encrypted scratchpad support for workflow context and workflow executing activities.

The platform supports encryption on most fields, and workflows can execute on tables with encrypted fields. Encrypted data is typically stored in the workflow scratch pad for workflows that execute using encrypted fields and must access this data after processing an approval, timer, or create task activity.

Data in the workflow scratchpad is not encrypted by default. The Workflow engine supports scratchpad encryption and executing activity records only when the Encrypted Workflow Scratchpad plugin is activated. Once activated, data stored in the wf_context and wf_executing scratchpads is protected by a private workflow engine encryption context, and is prevented from being stored in plain text.

**Activate encrypted workflow scratchpad**

Activate the Encrypted Workflow Scratchpad plugin (com.snc.encrypted.scratchpad) if you have an admin role.

**Before you begin**

Role required: admin

The Encrypted Workflow Scratchpad plugin must be activated via a Customer Service and Support request. You should activate and thoroughly test the plugin.
in a non-production instance. Only after you satisfied with the results should you activate it in a production instance.

When activating it in a production instance, you should pick a low transactional volume time to do so. Prior to its activation, first activate the Workflow Pause Utility (com.glideapp.workflow.pause), and then pause all active workflows. Refer to Workflow pause utility. After activating the Encrypted Workflow Scratchpad plugin, resume all paused workflows.

About this task
Encrypted Workflow Scratchpad activates these related plugins if they are not already active.

### Plugins for Encrypted Workflow Scratchpad

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encryption Support [com.glide.encryption]</td>
<td>Allows text fields and attached files to be encrypted.</td>
</tr>
</tbody>
</table>

### Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

### What to do next
Once you install and activate the plugin, resume all paused workflows. Refer to Pause and resume all or multiple workflows.

### Related information

- List of plugins

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Troubleshoot workflows

Troubleshooting tools for workflows enable administrators to isolate execution paths, compare contexts, and track incomplete activities.

The workflow timeline provides a visual representation of the workflow, including transitions and the elapsed time for each activity. A troubleshooting tool for highlighting execution paths helps users perform forensics on a workflow. The highlighting feature can group multiple execution paths in various colors and can isolate rollback processing. Use the workflow highlighter to isolate incomplete tasks and approvals. You can also enable a workflow performance timing feature to troubleshoot slow workflows.

Execution path troubleshooting in timelines

Use the controls in a workflow timeline to isolate specific execution paths or compare multiple execution paths over time.

Timelines show how the activities in the workflow progressed in relation to one another over time. Isolate execution paths and follow transition lines between subflows and the main flow. Processing times provide a view of the workflow that you cannot get from the workflow diagram. Tooltips give precise information about each activity, such as duration.

Execution history table

Highlight execution paths and rollbacks to locate activities that may have been left in an unresolved state.

About this task

Rollbacks, cancels, and deletions during the execution of a workflow can prevent some activities from fully completing. Use highlighting in the execution
history table to determine which activities in the workflow were left in an unresolved state.

Procedure

1. Run the workflow.
2. Navigate to **Workflow > All Contexts**.
3. Select a context to troubleshoot.
4. In the Workflow Context form, select the **Workflow Activity History** related list.
5. Right-click an activity and select **Workflow Debug > Toggle Execution Path Highlighting** from the context menu.

   All activities in that execution path are highlighted in a color selected by the platform. The debug path shows all activities that completed successfully during the workflow.

   ![Workflow Activity History Table](image)

6. Right-click a rollback activity and select **Workflow Debug > Toggle Rollback Highlighting** from the context menu.

   The platform highlights the rollback path (restarted activities) in a different color. Each color represents a group of activities that were part of the same rollback execution. The highlighting includes the activity that initiated the rollback. If you right-click an activity that was not part of a rollback, no rows are highlighted.

   **Note:** The rollback activity itself appears in both execution path and rollback highlighting.
7. To remove highlighting, right-click in the list and select an option to clear execution path or rollback highlighting.

You can clear individual rollback paths or all rollback highlighting.

Use the Workflow Operations Dashboard

On the Workflow Operations Dashboard, view and add widgets to help you monitor workflows. Review the performance of workflows and determine which workflows must be improved.

Before you begin
Role required: workflow_admin
The different levels of access are:

- **View**: View the dashboard and refresh report widgets.
- **Customize**: Refresh, add, delete, and rearrange widgets.

About this task
On the Workflow Operations Dashboard, you can click widget elements to view the records they represent. You can also add new report widgets that are not displayed by default.

Procedure
1. To view the Workflow Operations Dashboard, navigate to **Workflow > Operations > Workflow Operations Dashboard**.

The default reports on the dashboard include:

- Workflow contexts providing run time metrics
- Active workflows started during a specified time period
- Workflows run between yesterday and today
- Workflows by state for the current month
- Aged workflow contexts for the past month

2. To find and add more widgets, click the **Add Content** icon ( ) in the upper left corner of the dashboard.

**What to do next**
If a workflow consistently appears as an outlier and there is no error causing the run time values, you can use its historical run time values to calculate a new estimated run time value. Then update the estimated run time in the workflow properties.

**Workflow gauges**
Multiple gauges are available to help you review the performance of workflows. You can add these gauges to the Workflow Operations Dashboard or custom homepages.

<table>
<thead>
<tr>
<th>Content</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ERT Dashboard Controls</strong></td>
<td></td>
</tr>
<tr>
<td>Outlier Finished Workflows for ERT (Percentage Outlier)</td>
<td>Identifies workflows that finished, but did not finish within estimated runtime (ERT) values. Enter an outlier percentage to see workflows that ran outside the specified runtime range.</td>
</tr>
<tr>
<td>Outlier Long Running Workflows for ERT (Percentage Outlier)</td>
<td>Displays workflows running longer than the configured runtime threshold.</td>
</tr>
<tr>
<td><strong>Workflow Dashboard</strong></td>
<td></td>
</tr>
<tr>
<td>Workflows Without Current Record</td>
<td>Displays workflow contexts that do not have an associated current record.</td>
</tr>
<tr>
<td><strong>Gauges</strong></td>
<td></td>
</tr>
<tr>
<td>Number of Active Workflows Started</td>
<td>Displays the total number of running workflows per hour over a given time period. By default, it displays the</td>
</tr>
</tbody>
</table>
### Workflow gauges (continued)

<table>
<thead>
<tr>
<th>Content</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly Over Time (Yesterday)</td>
<td>number of workflows that ran per hour over the previous day (yesterday).</td>
</tr>
<tr>
<td>Outlier Finished Workflows Not Cumulated to ERT</td>
<td>Displays workflow contexts that are finished outside the estimated runtime outlier value and not cumulated to estimated run time value.</td>
</tr>
<tr>
<td>Running Workflow Contexts</td>
<td>Displays the total number of running workflows.</td>
</tr>
<tr>
<td>Successfully Finished Workflows Cumulated to ERT</td>
<td>Displays the total number of successfully completed workflows whose running duration is cumulated to the estimated run time value.</td>
</tr>
<tr>
<td>Workflows by State (This Month)</td>
<td>Displays the total number of workflows run in a month grouped by the current state.</td>
</tr>
<tr>
<td>Aged Workflow Contexts (Running Since Last Month)</td>
<td>Displays the total number of workflow contexts running for a given period of time by workflow name. By default, it displays the total number of workflow contexts running over the last month.</td>
</tr>
<tr>
<td>Workflows Run Between Yesterday and Today (by Table)</td>
<td>Displays workflows that have run in the last day grouped by table name.</td>
</tr>
</tbody>
</table>

### Workflow performance timing

The workflow engine can generate detailed performance timing data that is useful for troubleshooting slow workflows.

An administrator must enable this functionality.

When workflow performance timing is enabled, the workflow engine tracks key performance data, including various execution speed metrics. The Workflow Timing [wf_workflow_timing] table stores the data, with a record for each workflow context. The workflow timing record is updated when the workflow engine completes the workflow, waits for an activity to complete, or otherwise exits the workflow execution.
Workflow estimated run time properties

Administrators can enable the collection of workflow run time metrics by setting Estimated Run Time (ERT) properties.

Administrators can use ERT metrics to determine if workflows are running longer or shorter than expected and to identify errors in workflow processing. The system displays run time metrics on the Workflow Operations Dashboard.

Enable workflow performance timing

Workflow performance timing is disabled by default. You can create a system property to enable it.

Before you begin

Role required: admin

Procedure

with the following specifications.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.workflow.show_timing</td>
</tr>
<tr>
<td>Type</td>
<td>true</td>
</tr>
<tr>
<td>Value</td>
<td>true</td>
</tr>
</tbody>
</table>

Workflow activities

Workflow activity properties reference

Each activity performs a different task, such as running a script, sending notifications, or requesting approvals. Activities can succeed or fail, which can result in actions performed by other activities.

For information about configuring different types of activities, click an activity name in the list below or see Workflow activities reference.

Core activities provided in the base system

- Approval and rollback workflow activities
- Condition Workflow activities
- Notification workflow activity
- Notify workflow activities
Subflow activities
• Task workflow activities
• Timer workflow activities
• Utility workflow activities

Activities provided with Orchestration
The following activities are included with Orchestration.
• Active Directory activity pack
• Orchestration activities
• PowerShell activities
• Puppet activities

Templates provided for creating custom activities
If Orchestration is active on your system, users with the proper roles can create custom activities using the ServiceNow Orchestration activity designer. For information about the templates Orchestration provides for creating custom activities that you can upload to the ServiceNow Store, see Activity designer components.

Workflow activities reference
Workflow activity reference, organized by category.
Each activity performs a different task, such as running a script, sending notifications, or requesting approvals.
Workflow runs activities as the user session that starts or advances them. Workflows started from record operations will run activities as the user session that performed the record operation. Workflows started from schedules or restarted from timers run activities as the System user. Workflows started from script calls run activities as the user session that started the script.

Approval and rollback activities
Approval and rollback activities generate and manage approvals. Not all workflows can include approval activities. For more information, read Approval and rollback workflow activities.

Note: Approval activities run as the user whose actions match the approve or reject conditions the workflow was waiting for and advances the workflow.
## Approval and rollback activities

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Action</td>
<td>The <strong>Approval Action</strong> activity performs an approval action on the current task.</td>
</tr>
<tr>
<td>Approval Coordinator</td>
<td>The <strong>Approval Coordinator</strong> activity creates an approval whose outcome depends on the outcome of one or more child activities, including one or more <strong>Approval - User</strong>, <strong>Approval - Group</strong>, and/or <strong>Manual Approval</strong> activities.</td>
</tr>
<tr>
<td>Approval - Group</td>
<td>The <strong>Approval - Group</strong> activity creates approval records for each member of a specified group.</td>
</tr>
<tr>
<td>Approval - User</td>
<td>The <strong>Approval - User</strong> activity creates one or more individual user approvals.</td>
</tr>
<tr>
<td>Generate</td>
<td>The <strong>Generate</strong> activity immediately creates task or approval records from any task or approval activities placed after the <strong>Generate</strong> activity in the workflow path. These pre-generated tasks and approvals start when the task and approval activities are reached during flow execution. This allows a task to have a set of associated pre-generated sequential tasks or approvals, but still require them to be completed in order.</td>
</tr>
<tr>
<td>Manual Approvals</td>
<td>The <strong>Manual Approvals</strong> activity watches and manages any approvals that users add manually outside of the workflow process. This activity only selects approvals that are in the Not requested state.</td>
</tr>
<tr>
<td>Rollback To</td>
<td>The <strong>Rollback To</strong> activity transitions directly to the activity specified by the outgoing transition line arrow.</td>
</tr>
</tbody>
</table>

### Condition activities

Condition activities provide conditional branching and logical operation functionality for workflows.

**Note:** Condition activities run as the user whose actions match the conditions the workflow was waiting for and advances the workflow.
**Condition activities**

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If workflow activity</td>
<td>The <em>If</em> activity checks a condition or script to determine if a <em>Yes</em> or <em>No</em> transition should be taken.</td>
</tr>
<tr>
<td>Switch workflow activity</td>
<td>The <em>Switch</em> activity checks if the value of a passed field or variable is equivalent to one of several case values.</td>
</tr>
<tr>
<td>Wait for condition workflow activity</td>
<td>The <em>Wait for condition</em> activity causes the workflow to wait at this activity until the current record matches the specified condition.</td>
</tr>
<tr>
<td>Wait for WF Event workflow activity</td>
<td>The <em>Wait for WF Event</em> activity causes the workflow to wait at this activity until the specified event is fired.</td>
</tr>
</tbody>
</table>

**Notify activities**

Notify workflow activities manage calls and SMS messages in Notify.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forward call workflow activity</td>
<td>The <em>Forward Call</em> activity forwards a Notify call to an E.164-compliant phone number.</td>
</tr>
<tr>
<td>Input workflow activity</td>
<td>The <em>Input</em> activity creates a phone menu by presenting a list of options on a Notify call.</td>
</tr>
<tr>
<td>Hangup workflow activity</td>
<td>The <em>Hangup</em> activity disconnects an active Notify phone call.</td>
</tr>
<tr>
<td>Play workflow activity</td>
<td>The <em>Play</em> activity plays a sound file on a Notify call.</td>
</tr>
<tr>
<td>Record workflow activity</td>
<td>The <em>Record</em> workflow activity records audio from a user on a Notify call.</td>
</tr>
<tr>
<td>Reject workflow</td>
<td>The <em>Reject</em> workflow activity rejects an incoming Notify call.</td>
</tr>
<tr>
<td>Say workflow activity</td>
<td>The <em>say</em> workflow activity allows you to play a message, using text to speech, on a Notify call.</td>
</tr>
<tr>
<td>Forward to notify client workflow activity</td>
<td>The <em>forward to notify client</em> workflow activity connects a phone call to a Notify WebRTC client.</td>
</tr>
</tbody>
</table>
Notify activities (continued)

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call workflow activity</td>
<td>The <strong>Call</strong> activity makes outbound phone calls using a Notify workflow. This workflow activity can be added to any table.</td>
</tr>
<tr>
<td>Join conference call workflow activity</td>
<td>The <strong>Join Conference Call</strong> activity connects an incoming or outgoing call to a Notify conference call.</td>
</tr>
<tr>
<td>Send SMS workflow activity</td>
<td>The <strong>send SMS</strong> workflow activity to send short text messages using Notify to users' phones. This workflow activity can be added to any table.</td>
</tr>
<tr>
<td>Queue workflow activity</td>
<td>The <strong>Queue</strong> activity places an active Notify call in a queue.</td>
</tr>
</tbody>
</table>

Notification activities

Notification workflow activities notify users of events that occur during the workflow.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Event workflow activity</td>
<td>The <strong>Create Event</strong> activity adds an event to the event queue, but does not immediately fire the event.</td>
</tr>
<tr>
<td>Notification workflow activity</td>
<td>The <strong>Notification</strong> activity sends an email or SMS message to specified users or groups.</td>
</tr>
</tbody>
</table>

Subflow activities

Subflow activities run and manage workflows from a parent workflow.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parallel Flow Launcher workflow activity</td>
<td>The <strong>Parallel Flow Launcher</strong> activity launches multiple subflows in parallel.</td>
</tr>
</tbody>
</table>
**Task activities**
Task activities create and modify workflow tasks.

ℹ️ **Note:** Task activities run as the user whose actions complete the task the workflow was waiting for and advances the workflow.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Worknote workflow activity</td>
<td>The <strong>Add Worknote</strong> activity adds text to the Worknotes field of the current incident record.</td>
</tr>
<tr>
<td>Attachment Note workflow activity</td>
<td>The <strong>Attachment Note</strong> activity adds an attachment to the current record.</td>
</tr>
<tr>
<td>Catalog Task workflow activity</td>
<td>The <strong>Catalog Task</strong> activity creates a service catalog task record.</td>
</tr>
<tr>
<td>Create Task workflow activity</td>
<td>The <strong>Create Task</strong> activity generates a record on any of the tables that extend Task [task].</td>
</tr>
</tbody>
</table>

**Timer activities**
Timer activities pause workflows for set periods of time.

ℹ️ **Note:** Timer activities run as the System user because the system scheduler advances the workflow.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA Percentage Timer workflow activity</td>
<td>The <strong>SLA Percentage Timer</strong> activity pauses the workflow for a duration equal to a percentage of an SLA.</td>
</tr>
<tr>
<td>Timer workflow activity</td>
<td>The <strong>Timer</strong> activity pauses the workflow for a specified period of time.</td>
</tr>
</tbody>
</table>

**Utility activities**
Utility activities provide controls over the path of the workflow, and other useful tools.
<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Branch workflow activity</td>
<td>The <strong>Branch</strong> activity splits the workflow into multiple transition paths from a single activity.</td>
</tr>
<tr>
<td>Join workflow activity</td>
<td>The <strong>Join</strong> activity unites multiple execution paths into one transition.</td>
</tr>
<tr>
<td>Lock workflow activity</td>
<td>The <strong>Lock</strong> activity prevents other instances of this workflow from continuing past this activity until the lock is released.</td>
</tr>
<tr>
<td>Log Message workflow activity</td>
<td>The <strong>Log Message</strong> activity writes a message to the workflow log.</td>
</tr>
<tr>
<td>Log Trace Message workflow activity</td>
<td>The <strong>Log Trace Message</strong> activity writes a trace message to the workflow log.</td>
</tr>
<tr>
<td>REST Message legacy workflow activity</td>
<td>The legacy <strong>REST Message</strong> activity enables an administrator to override the REST endpoint or supply the variables configured in the REST Message module.</td>
</tr>
<tr>
<td>Return Value workflow activity</td>
<td>The <strong>Return Value</strong> activity returns a value to a parent workflow, when run from a subflow.</td>
</tr>
<tr>
<td>Run Script workflow activity</td>
<td>The <strong>Run Script</strong> activity runs the specified script in the scope of the workflow version.</td>
</tr>
<tr>
<td>Set Values workflow activity</td>
<td>The <strong>Set Values</strong> activity sets values on the current record when the workflow quiesces or ends.</td>
</tr>
<tr>
<td>SOAP Message legacy workflow activity</td>
<td>The legacy <strong>SOAP Message</strong> activity uses SOAP messages defined in the System Web Services plugin and can call the messages using a MID Server.</td>
</tr>
<tr>
<td>Turnstile workflow activity</td>
<td>The <strong>Turnstile</strong> activity limits how many times a workflow can pass through the same point.</td>
</tr>
<tr>
<td>Unlock workflow activity</td>
<td>The <strong>Unlock</strong> activity releases a lock that was previously placed by the <strong>Lock</strong> activity.</td>
</tr>
</tbody>
</table>

**Activities provided with Orchestration**

The following activities are included with Orchestration.

- Active Directory activity pack
- Orchestration activities
• PowerShell activities
• Puppet activities

Templates provided for creating custom activities

If Orchestration is active on your system, users with the proper roles can create custom activities using the ServiceNow Orchestration activity designer. For information about the templates Orchestration provides for creating custom activities that you can upload to the ServiceNow Store, see Orchestration custom activity templates.

Approval and rollback workflow activities

Approval and rollback activities generate and manage approvals.

Approval and rollback activities are not available in some workflows.

• With two exceptions, approval and rollback activities are only available when the workflow runs on a table that extends Task. The exceptions are the Approval - User and Approval Action activities, which are available globally.
• Approval and rollback activities are available only if approval engines are turned off for the table on which the workflow runs. If approval engines are enabled for the table, approval activities appear greyed out and cannot be selected. To learn more about how workflow and approval engines interact, read Approval workflow activities and approval engines.

Approval Action workflow activity

The Approval Action activity performs an approval action on the current task.

Use this activity to mark the current task record as approved or rejected.

Note: When an Approval Action activity is used to mark a task approved, the activity marks all pending approvals as No Longer Required. This activity behaves differently from Set Values or Run Script when used to set the Approval field's value.

Results

The result value of the activity is the final approval disposition selected by the approver. The result value can be Approved or Rejected. A workflow designer can assign a result value using the activity.result variable from within a script field of the activity.
**Input variables**

Input variables determine the initial behavior of the activity.

**Approval Action activity input variables**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>The action to perform on the task. Options are:</td>
</tr>
<tr>
<td></td>
<td>• Mark task approved</td>
</tr>
<tr>
<td></td>
<td>• Mark task rejected</td>
</tr>
<tr>
<td></td>
<td>• Mark task requested</td>
</tr>
<tr>
<td></td>
<td>• Disregard pending approvals: the system sets approval records to no longer required and marks the activity as approved.</td>
</tr>
</tbody>
</table>

**Conditions**

The conditions determine which transition runs after this activity.

⚠️ **Note:** Approval activities run as the user whose actions match the approve or reject conditions the workflow was waiting for and advances the workflow.

**Approval Action activity conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always</td>
<td>The event or condition that causes the approval to move to the next workflow step.</td>
</tr>
<tr>
<td>Error</td>
<td>The event or condition that generates an error.</td>
</tr>
<tr>
<td>Skipped</td>
<td>The event or condition that allows a skipped approval.</td>
</tr>
</tbody>
</table>

**States**

The activity state tells the workflow engine what to do with the activity.

**Approval Action activity states**

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine starts the execute function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
</tbody>
</table>
Approval Action activity states (continued)

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

Approval Coordinator workflow activity

The Approval Coordinator activity creates an approval whose outcome depends on the outcome of one or more child activities, including one or more Approval - User, Approval - Group, and/or Manual Approval activities.

⚠️ Note: This activity is only available when the workflow runs on a table that extends Task.

To create an Approval Coordinator activity, first drag the activity onto the workflow canvas, causing the activity form to display. On the activity form, fill in the appropriate fields, then click Submit.

After you click Submit, the activity appears on the workflow canvas. From there, specify the child activities by clicking the links that appear on the body of the activity.

When the Approval Coordinator activity completes, all pending approvals that were created by any of the Approval Coordinator approval activities are immediately set to No Longer Required. If a single user is called as an approver twice by the same workflow, such as when a single user is both a product approver and an executive approver, any approvals for that user after the first are skipped.

Results

The result value of the Approval Coordinator activity depends on the approval actions taken by the approvers and the approval conditions specified in the Wait for field. Possible result values are:

- Approved
- Rejected
- Deleted
- Cancelled
# Input variables

Input variables determine the initial behavior of the activity.

## Approval Coordinator activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait for</td>
<td>Indicate what to wait for to indicate that the approval activity is approved or rejected. Options are:</td>
</tr>
<tr>
<td></td>
<td>• Any child activity to be approved: Any child activity (User, Group, or Manual Approval) that completes with a result of approved causes the Approval Coordinator activity to complete with a result of approved.</td>
</tr>
<tr>
<td></td>
<td>• All child activities to be approved: All child activities of the Approval Coordinator activity must complete with a result of approved to cause the Approval Coordinator activity to complete with a result of approved.</td>
</tr>
<tr>
<td></td>
<td>• The first approval or rejection from any child activity: The first child activity that completes with a result of approved or rejected causes the Approval Coordinator activity to complete with the same result.</td>
</tr>
<tr>
<td></td>
<td>• Condition based on script: Call a script to determine how to manage an approval or rejection.</td>
</tr>
</tbody>
</table>

When a rejection occurs

<table>
<thead>
<tr>
<th>Only appears if Wait for is set to All child activities to be approved or Any child activity to be approved.</th>
<th>Specify what the coordinator should do when it sees a rejection from any one of the child activities. Options are:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Reject the approval: Immediately complete the Approval Coordinator activity with a result of rejected.</td>
</tr>
<tr>
<td></td>
<td>• Wait for other responses before deciding: Wait until we get other responses from other child activities before making an approval or rejection decision. This allows users to change their minds until a decision is made.</td>
</tr>
<tr>
<td></td>
<td>In addition, if Wait for is set to Any child activity to approve then a single child activity completion with a result of approved will cause the Approval Coordinator activity to complete with a result of approved even if other child activities have completed with a result of rejected.</td>
</tr>
</tbody>
</table>
Approval Coordinator activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval script</td>
<td>Only appears if Wait for is set to Condition based on script.</td>
</tr>
<tr>
<td></td>
<td>If the Wait for variable is set to Condition based on script this script is called to determine how to handle an approval or rejection. The script needs to set the variable answer to approved, rejected or pending to indicate the overall approval status for this approval. When called, the following variable is available to the script:</td>
</tr>
<tr>
<td>counts.total</td>
<td>total number of child approval activities that are part of this approval</td>
</tr>
<tr>
<td>counts.approved</td>
<td># of child approval activities that approved so far</td>
</tr>
<tr>
<td>counts.rejected</td>
<td># of child approval activities that rejected so far</td>
</tr>
<tr>
<td>counts.requested</td>
<td># of child approval activities that are pending approval</td>
</tr>
</tbody>
</table>

Conditions
The conditions determine which transition runs after this activity.

⚠️ Note: Approval activities run as the user whose actions match the approve or reject conditions the workflow was waiting for and advances the workflow.

Approval Coordinator activity conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>The users from the groups have approved the request based on the Wait for rules.</td>
</tr>
<tr>
<td>Rejected</td>
<td>The users from the groups have rejected the request based on the Wait for rules.</td>
</tr>
</tbody>
</table>

States
The activity state tells the workflow engine what to do with the activity.

Approval Coordinator activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine starts the execute function of the activity.</td>
</tr>
</tbody>
</table>
Approval Coordinator activity states (continued)

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

Approval - Group workflow activity

The Approval - Group activity creates approval records for each member of a specified group.

⚠️ Note: This activity is only available when the workflow runs on a table that extends Task.

The group approval is approved or rejected based on the user approvals, according to the logic specified in the Wait For field.

Results

The workflow designer can assign a result value using activity.result from within a script field of the activity. By default, the result value is the final approval disposition. This disposition depends on the approval actions take by the approvers and the approval conditions specified in the Wait for or When Anyone Rejects fields. Possible result values are:

- Approved
- Rejected
- Deleted
- Cancelled

Input variables

Input variables determine the initial behavior of the activity.
### Approval - Group activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval - Group When</td>
<td>Specify when this activity generates a group approval record.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions which, if met, cause the group approval to be generated. If the conditions are not met, the approval is skipped.</td>
</tr>
<tr>
<td>Approval - Group Approvers</td>
<td>Specify the groups whose approval will be requested.</td>
</tr>
<tr>
<td>Groups</td>
<td>The groups whose approval will be requested.</td>
</tr>
<tr>
<td></td>
<td>To edit this field, click the lock icon. To select specific groups by name, use the lookup list. To select groups from field values on the current record at runtime, click the tree icon.</td>
</tr>
<tr>
<td></td>
<td>Each member of the group will be assigned an individual approval record.</td>
</tr>
<tr>
<td></td>
<td>If no group is selected, the activity automatically sets the approval to Approved.</td>
</tr>
<tr>
<td>Approval - Group Condition</td>
<td>Specify how the activity decides to approve or reject the group approval, based on the responses from individual members of the group.</td>
</tr>
<tr>
<td>Wait for</td>
<td>A choice between different approval logics to determine which individual approvals or rejections result in approval or rejection of the activity's approval. Options are:</td>
</tr>
<tr>
<td></td>
<td>• An approval from each group: Any user from each group can approve and the first approval from each group causes the activity to complete with a result of approved (see below for how a rejection is handled).</td>
</tr>
<tr>
<td></td>
<td>• An approval from any group: Any user from any group can approve and the first approval from any group causes the activity to complete with a result of approved.</td>
</tr>
<tr>
<td></td>
<td>• An approval from everyone from all groups: All users from all groups must approve to cause the activity to complete with a result of approved (see below for how a rejection is handled).</td>
</tr>
</tbody>
</table>
### Approval - Group activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>First response from each group</strong>: The first approval or rejection from any user in each group is used to indicate the state of the group approval (see below for how a rejection is handled).</td>
<td></td>
</tr>
<tr>
<td>Indicate what happens when any user rejects their approval request. Options are:</td>
<td></td>
</tr>
<tr>
<td><strong>Reject the approval</strong>: Immediately complete the activity with a result of rejected.</td>
<td></td>
</tr>
<tr>
<td><strong>First response from any group</strong>: The first approval or rejection from any user in any group causes the activity to complete with a result of approved or rejected.</td>
<td></td>
</tr>
<tr>
<td><strong>Condition based on script</strong>: Each time a user approves or rejects, the Approval script is called to determine if the activity should complete.</td>
<td></td>
</tr>
</tbody>
</table>

**Approval script**

If the **Wait for** variable is set to **Condition based on script** this script is called to determine how to handle an approval or rejection. The script needs to set the variable answer to approved or rejected to indicate the overall status for this approval.

This script is responsible for setting the approval state for each group that is part of this approval activity before returning the overall approval state for all of the groups.

When called, the following variables are available to the script for all the groups that are part of this approval activity:

- `counts.total` = total number of groups that are part of this approval
- `counts.approved` = # of groups that approved so far
- `counts.rejected` = # of groups that rejected so far
- `counts.requested` = # of groups that are pending approval
- `counts.not_requested` = # of groups that are not pending approval
- `counts.not_required` = # of groups that approval is not required

And for each group:
**Approval - Group activity input variables (continued)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>groups[group_id].total</td>
<td>total number of users that are part of this group's approval</td>
</tr>
<tr>
<td>groups[group_id].approved</td>
<td># of users that approved so far</td>
</tr>
<tr>
<td>groups[group_id].rejected</td>
<td># of users that rejected so far</td>
</tr>
<tr>
<td>groups[group_id].requested</td>
<td># of users that are pending approval</td>
</tr>
<tr>
<td>groups[group_id].not_requested</td>
<td># of users that are not pending approval</td>
</tr>
<tr>
<td>groups[group_id].not_required</td>
<td># of users that approval is not required</td>
</tr>
<tr>
<td>groups[group_id].approvalIDs[state]</td>
<td>array of user ids that are at the specified approval state</td>
</tr>
</tbody>
</table>

**Note: Iterate the groups using:**

```javascript
for (var id in groups) {
    var group = groups[id];
    ... group.total ...
}
```

**Note: Get group object using the following code (to get things like the group name being iterated on):**

```javascript
var objGroup = fncGetGroupObj(id);
    var strGroupName = objGroup.name;

    function fncGetGroupObj(sidGroupApproval) {
        var objGroupApproval = new GlideRecord('sysapproval_group');
        objGroupApproval.get(sidGroupApproval);
        var objGroup = new GlideRecord('sys_user_group');
        objGroup.get(objGroupApproval.assignment_group.sys_id);
        return objGroup;
    }
```
Approval scripts also allow computations. For example, if only half of the approvals are required:

```java
if (counts.approved/counts.total > .49) {
    answer = 'approved';
}
else if (counts.rejected/counts.total > .50) {
    answer = 'rejected';
}
```

When anyone rejects

A choice between different approval logics to determine which individual rejections result in rejection of the activity's approval. Options are:

- **Reject the approval**: Immediately complete the activity with a result of **rejected**.
- **Wait for other responses before deciding**: Wait until we get other responses before making an approval or rejection decision. This allows users to change their mind until a decision is made.

**Note**: If **Wait for** is set to **Anyone to approve**, then a single approval causes the activity to complete with a result of **approved**, even if one or more users reject.

Approval - Group Schedule

Specify how workflow calculates the approval record's expected start date and due date. Once you've made a selection for 'Due date based on', and 'Schedule based on', the appropriate fields will display.

**Due date based on**

Select how workflow determines the task's duration, due date, and schedule.

- **A user specified duration**: The duration is based on a user specified value.
- **A relative duration**: The duration is calculated from a relative duration (such as End of Next Business Day).
- **A date/time or duration field**: The duration is based on the value of a field on the current record.
- **Script**: The duration is returned by a script.
## Approval - Group activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>The specific number of days and hours.</td>
</tr>
<tr>
<td></td>
<td>Only appears when <strong>Due date based on</strong> is set to a user specified duration</td>
</tr>
<tr>
<td>Relative duration</td>
<td>The general number and length of business days.</td>
</tr>
<tr>
<td></td>
<td>Only appears when <strong>Due date based on</strong> is set to a relative duration</td>
</tr>
<tr>
<td>Due date field</td>
<td>The date/time or duration field.</td>
</tr>
<tr>
<td></td>
<td>Only appears when <strong>Due date based on</strong> is set to a date/time or duration field</td>
</tr>
<tr>
<td>Due date script</td>
<td>The script that sets 'answer' to the number of seconds for the duration.</td>
</tr>
<tr>
<td></td>
<td>Only appears when <strong>Due date based on</strong> is set to Script</td>
</tr>
<tr>
<td>Schedule based on</td>
<td>The basic schedule the timer uses to count working hours. If a schedule is specified, the duration will only be considered for times that are specified on the schedule. For example, if the duration is 2 hours and the workflow begins at 4:00pm on a schedule that is 8am - 5pm, then it ends at 9:00am the next day. The options are:</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc. in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
## Approval - Group activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>This workflow’s schedule:</strong></td>
<td>The schedule uses workflow context date, time, and an optional <strong>Time zone based on</strong> value.</td>
</tr>
<tr>
<td><strong>A specific schedule:</strong></td>
<td>The schedule uses a pre-defined <strong>Schedule</strong> and an optional <strong>Time zone based on</strong> value.</td>
</tr>
<tr>
<td><strong>A schedule field:</strong></td>
<td>The schedule uses a value from a table and an optional <strong>Time zone based on</strong> value.</td>
</tr>
</tbody>
</table>

### Schedule

<table>
<thead>
<tr>
<th>Schedule</th>
<th>The predefined <strong>Schedule</strong> from a list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only appears when <strong>Schedule based on</strong> is set to <strong>A specific schedule</strong></td>
<td></td>
</tr>
</tbody>
</table>

### Schedule field

<table>
<thead>
<tr>
<th>Schedule field</th>
<th>A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only appears when <strong>Schedule based on</strong> is set to <strong>A schedule field</strong></td>
<td></td>
</tr>
</tbody>
</table>

### Time zone based on

<table>
<thead>
<tr>
<th>Time zone based on</th>
<th>The time zone for calculating the duration. The time zone may be based on:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>No time zone:</strong></td>
<td>Default. Workflow uses the GMT time zone.</td>
</tr>
<tr>
<td><strong>A specific time zone:</strong></td>
<td>A specific <strong>Time zone</strong> that you choose from a choice list.</td>
</tr>
<tr>
<td><strong>A time zone field:</strong></td>
<td>A <strong>Time zone field</strong> to track time duration from a field on the form.</td>
</tr>
</tbody>
</table>

### Time zone

<table>
<thead>
<tr>
<th>Time zone</th>
<th>Select the time zone you want from the choice list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only appears when <strong>Time zone based on</strong> is set to <strong>A</strong></td>
<td></td>
</tr>
</tbody>
</table>
Approval - Group activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>specific time zone</td>
<td></td>
</tr>
<tr>
<td>Time zone field</td>
<td>A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog.</td>
</tr>
<tr>
<td>Only appears when Time zone based on is set to</td>
<td>A time zone field.</td>
</tr>
</tbody>
</table>

Approval - Advanced
If desired, write a script for determining additional users to request approvals from.

Advanced
Select this check box to write a script for determining additional users to request approvals from. Use the Additional groups script to customize group approvals.

Additional groups script
If the Advanced check box is selected, this script is called to determine any additional group approvals to be created. The script needs to set the variable answer to a comma-separated list of group ids or an array of group ids to add as approver groups. For example:

```javascript
answer = [];  
answer.push('id1');  
answer.push('id2');
```

Conditions
The following conditions determine which transition runs after this activity.

ℹ️ Note: Approval activities run as the user whose actions match the approve or reject conditions the workflow was waiting for and advances the workflow.
Approval - Group activity conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>The users from the groups have approved the request based on the <em>Wait for</em> rules.</td>
</tr>
<tr>
<td>Rejected</td>
<td>The users from the groups have rejected the request based on the <em>Wait for</em> rules.</td>
</tr>
<tr>
<td>Error</td>
<td>The event or condition that generates an error.</td>
</tr>
<tr>
<td>Skipped</td>
<td>The event or condition that allows a skipped approval.</td>
</tr>
</tbody>
</table>

**States**
The activity state tells the workflow engine what to do with the activity.

Approval - Group activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine starts the <code>execute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

Approval - User workflow activity

The *Approval - User* activity creates one or more individual user approvals.

**Results**
The result value is the final approval disposition. This disposition depends on the approval actions take by the approvers and the approval conditions specified in the *Wait for* or *When Anyone Rejects* fields. Possible result values are:

- Approved
- Rejected
- Deleted
- Cancelled

**Input variables**

<table>
<thead>
<tr>
<th>Approval - User activity input variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Approval - User When</td>
<td>Specify when this activity generates a user approval record.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions which, if met, cause the individual approval to be generated. If the conditions are not met, the approval is skipped.</td>
</tr>
<tr>
<td>Approval - User Approvers</td>
<td>Specify the users whose approval will be requested.</td>
</tr>
</tbody>
</table>
| Users                                    | The users for the approval. Use the tree icon to select user reference fields from the current record to create approvals, such as ${assigned_to}. If no user is selected, the activity automatically sets the approval to Approved.  

**Note:** Workflow only manages approval records generated by the Approval User activity. After starting the workflow, newly added approvals do not affect the workflow context. |
| Groups                                   | Groups whose members should also receive approvals. Note that this is different than the Approval - Group activity, which creates a group approval in addition to the individual approvals. The tree icon can be used to select group reference fields from the current record to create approvals, such as ${assignment_group}. |
| Approval - User Condition                | Specify how the activity decides to approve or reject the approval, based on the responses from individual approvers. |
| Wait for                                 | A choice between different approval logics to determine which individual approvals result in approval of the activity's approval. Options are: |
Approval - User activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Anyone to approve:</strong></td>
<td>Any user can approve and the first approval causes the activity to complete with a result of <strong>approved</strong>.</td>
</tr>
<tr>
<td>• <strong>Everyone to approve:</strong></td>
<td>All users must approve (see below for how a rejection is handled).</td>
</tr>
<tr>
<td>• <strong>First response from anyone:</strong></td>
<td>The first approval or rejection from any user causes the activity to complete.</td>
</tr>
<tr>
<td>• <strong>Condition based on script:</strong></td>
<td>Each time a user approves or rejects, the <strong>Approval script</strong> is called to determine if the activity should complete.</td>
</tr>
</tbody>
</table>

When anyone rejects

A choice between different approval logics to determine which individual rejections result in rejection of the activity's approval. Options are:

- **Reject the approval:** Immediately complete the activity with a result of **rejected**.
- **Wait for other responses before deciding:** Wait until we get other responses before making an approval or rejection decision. This allows users to change their mind until a decision is made.

⚠ **Note:** Note that if **Wait for** is set to **Anyone to approve** then a single approval will cause the activity to complete with a result of **approved** even if one or more users reject.

**Approval Column**

A string field for the name of the approval field on the table the workflow is running on. The default value is **approval**, which is the field on the Task table.

⚠ **Note:** Use the field's name, not its label.

⚠ **Note:** If using any custom approval column fields and approval column journals, use Set Value activities in the workflow to set the custom Approval column fields.
Approval - User activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Script</td>
<td>If the <strong>Wait for</strong> variable is set to <strong>Condition based on script</strong>, this script is called to determine how to handle an approval or rejection. The script needs to set the variable <strong>answer</strong> to approved or rejected to indicate the approval status for this approval. When called, the following information is available:</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Approval - User Schedule

Specify how workflow calculates the approval record's expected start date and due date. Once you've made a selection for 'Due date based on', and 'Schedule based on', the appropriate fields will display.

<table>
<thead>
<tr>
<th>Due date based on</th>
<th>Select how workflow determines the task's duration, due date, and schedule.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>A user specified duration</strong>: The duration is based on a user specified value.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A relative duration</strong>: The duration is calculated from a relative duration (such as End of Next Business Day).</td>
</tr>
<tr>
<td></td>
<td>• <strong>A date/time or duration field</strong>: The duration is based on the value of a field on the current record.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Script</strong>: The duration is returned by a script.</td>
</tr>
</tbody>
</table>

Duration

Only appears when **Due date based on** is set to **A user specified duration**

The specific number of days and hours.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative duration</td>
<td>The general number and length of business days.</td>
</tr>
<tr>
<td>Only appears when <strong>Due date based on</strong> is set to <strong>A relative duration</strong></td>
<td></td>
</tr>
<tr>
<td>Due date field</td>
<td>The date/time or duration field.</td>
</tr>
<tr>
<td>Only appears when <strong>Due date based on</strong> is set to <strong>A date/time or duration field</strong></td>
<td></td>
</tr>
<tr>
<td>Due date script</td>
<td>The script that sets ‘answer’ to the number of seconds for the duration.</td>
</tr>
<tr>
<td>Only appears when <strong>Due date based on</strong> is set to <strong>Script</strong></td>
<td></td>
</tr>
<tr>
<td>Schedule based on</td>
<td>The basic schedule the timer uses to count working hours. If a schedule is specified, the duration will only be considered for times that are specified on the schedule. For example, if the duration is 2 hours and the workflow begins at 4:00pm on a schedule that is 8am - 5pm, then it ends at 9:00am the next day. The options are:</td>
</tr>
<tr>
<td>Schedule based on</td>
<td>• <strong>This workflow's schedule:</strong> The schedule uses workflow context date, time, and an optional <strong>Time zone based on</strong> value.</td>
</tr>
<tr>
<td>Schedule based on</td>
<td>• <strong>A specific schedule:</strong> The schedule uses a pre-defined <strong>Schedule</strong> and an optional <strong>Time zone based on</strong> value.</td>
</tr>
<tr>
<td>Schedule based on</td>
<td>• <strong>A schedule field:</strong> The schedule uses a value from a table and an optional <strong>Time zone based on</strong> value.</td>
</tr>
<tr>
<td>Schedule based on</td>
<td>The predefined <strong>Schedule</strong> from a list.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Approval - User activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only appears when <strong>Schedule based on</strong> is set to <strong>A specific schedule</strong></td>
<td></td>
</tr>
<tr>
<td>Schedule field</td>
<td>A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog.</td>
</tr>
</tbody>
</table>
| Time zone based on | The time zone for calculating the duration. The time zone may be based on:  
  - **No time zone**: Default. Workflow uses the GMT time zone.  
  - **A specific time zone**: A specific **Time zone** that you choose from a choice list.  
  - **A time zone field**: A **Time zone field** to track time duration from a field on the form. |
| Time zone | Select the time zone you want from the choice list. |
| Time zone field | A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog. |
### Approval - User activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>on is set to</strong></td>
<td>A time zone field.</td>
</tr>
</tbody>
</table>

**Approval - Advanced**

If desired, write a script for determining additional users to request approvals from.

- **Advanced**
  - Select this check box to write a script for determining additional users to request approvals from.

- **Additional approvers script**
  - If the **Advanced** check box is selected, this script is called to determine any additional user approvals to be created. The script needs to set the variable `answer` to a comma-separated list of user ids and group ids or an array of user and group ids to add as approvers. For example:

```javascript
answer = [];
answer.push('id1');
answer.push('id2');
```

### Conditions

The following conditions determine which transition runs after this activity.

**Note:** Approval activities run as the user whose actions match the approve or reject conditions the workflow was waiting for and advances the workflow.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>The users approved the request based on the <strong>Wait for</strong> rules.</td>
</tr>
<tr>
<td>Rejected</td>
<td>The users rejected the request based on the <strong>Wait for</strong> rules.</td>
</tr>
<tr>
<td>Error</td>
<td>The event or condition that generates an error.</td>
</tr>
<tr>
<td>Skipped</td>
<td>The event or condition that allows a skipped approval.</td>
</tr>
</tbody>
</table>

### States

The activity state tells the workflow engine what to do with the activity.
Approval - User activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine starts the <code>execute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

Generate workflow activity

The Generate activity immediately creates task or approval records from any task or approval activities placed after the Generate activity in the workflow path. These pre-generated tasks and approvals start when the task and approval activities are reached during flow execution. This allows a task to have a set of associated pre-generated sequential tasks or approvals, but still require them to be completed in order.

Note: This activity is only available when the workflow runs on a table that extends Task.

By default, the workflow does not create any tasks or approvals until it reaches them in the workflow.

The Generate activity follows all transitions through the workflow to each activity. For each activity:

- If it is a task activity, creates the task and sets:
  - The State to Pending
  - The Expected Start Date
  - The Due Date

  Note: Task activities run as the user whose actions complete the task the workflow was waiting for and advances the workflow.
• If it is an approval activity, creates the approvals and sets:
  ◦ The approval State to Not Requested
  ◦ The Expected Start Date
  ◦ The Due Date

Note: Approval activities run as the user whose actions match the approve or reject conditions the workflow was waiting for and advances the workflow.

Expected start dates and due dates are calculated based on the Expected Duration of all of the tasks and approvals between the Generate activity and the activity being updated. In the case of a branched path (between a Branch and Join activity), the longer duration will be used for any post-branch activities.

The Generate activity can be used more than once, and any tasks or approvals will be refreshed with updated information. This is useful in situations where the list of approvers or other important information is still editable while the workflow is in process and it may be necessary to update or correct the generated approvals or tasks.

To exclude a set of activities from the Generate activity, select the Skip during generate check box on any condition and its transitions will not be followed during the generate process. By default, the following conditions have the Skip during generate check box selected:

• Rejected (for any of the approval activities)
• No condition of If activity
• Continue condition of Turnstile activity
• Incomplete condition of Join activity

Input variables
Input variables determine the initial behavior of the activity.

Generate activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate approvals</td>
<td>If selected, approvals are created when running the Generate activity. If cleared, the approvals are used to compute their estimated duration, but no approvals are created.</td>
</tr>
</tbody>
</table>
Generate activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate</td>
<td>If selected, tasks are created when running the <strong>Generate</strong> activity.</td>
</tr>
<tr>
<td>tasks</td>
<td>If cleared, the tasks are used to compute their estimated duration, but no</td>
</tr>
<tr>
<td></td>
<td>tasks are created.</td>
</tr>
</tbody>
</table>

**States**
The activity state tells the workflow engine what to do with the activity.

**Generate activity states**

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The activity is executing.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the</td>
</tr>
<tr>
<td></td>
<td>activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
</tbody>
</table>

**Example**

**Generate workflow**

In this example, the following approvals are generated:
• Approval-2
• Approval-3

Approval-4 is skipped since the **Rejected** condition of Approval-3 has **Skip during generate** selected.

Here is an example of using the **Generate** activity that describes the expected start and due dates:

**Generate workflow start and due date**

<table>
<thead>
<tr>
<th>Task</th>
<th>Expected Start Date</th>
<th>Reason</th>
<th>Due Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task 2 (1 day)</td>
<td>Jan. 2, 2016</td>
<td>Task 1 is 1 day</td>
<td>Jan. 3, 2016</td>
</tr>
<tr>
<td>Task 4 (1 day)</td>
<td>Jan. 3, 2016</td>
<td>Task 3 is 2 days</td>
<td>Jan. 4, 2016</td>
</tr>
<tr>
<td>Task 5 (1 day)</td>
<td>Jan. 4, 2016</td>
<td>Task 4 ends the latest before the Join</td>
<td>Jan. 5, 2016</td>
</tr>
</tbody>
</table>

Notice that Task 5 starts on Jan. 4, 2016 since the longest path (based on due dates) to the **Join** is Task 3/Task 4.
Manual Approvals workflow activity

The **Manual Approvals** activity watches and manages any approvals that users add manually outside of the workflow process. This activity only selects approvals that are in the Not requested state.

⚠ **Note:** This activity is only available when the workflow runs on a table that extends Task.

If there are no pending manual approvals when this activity executes, the activity immediately completes with a result of **approved**. This activity does not create approval records. Use this activity to pause the workflow when a user adds a manual approval to a record with an associated workflow, and it is in the Not requested state. The workflow waits for the approval to be closed before proceeding.

**Results**

The workflow designer can assign a result value using `activity.result` from within a script field of the activity. By default, the result value of the activity is the final approval disposition determined by the approval actions take by the approvers. Possible result values are:

- Approved
- Rejected
- Deleted
- Cancelled
- Error

**Input variables**

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait for</td>
<td>Indicate what to wait for to indicate that the approval activity is approved or rejected. Options are:</td>
</tr>
</tbody>
</table>
Manual Approvals activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Any manual user or group approval:</td>
<td>Any user can approve and the first approval causes the activity to complete with a result of approved.</td>
</tr>
<tr>
<td>• All manual user or group approvals:</td>
<td>All users must approve (see below for how a rejection is handled).</td>
</tr>
<tr>
<td>• The first response from any manual approval:</td>
<td>The first approval or rejection from any user causes the activity to complete.</td>
</tr>
</tbody>
</table>

When anyone rejects

Indicate what happens when any user rejects their approval request. Options are:

• Reject the approval: Immediately complete the activity with a result of rejected.
• Wait for other responses before deciding: Wait until we get other responses before making an approval or rejection decision. This allows users to change their mind until a decision is made.

In addition, if Wait for is set to Anyone to approve then a single approval will cause the activity to complete with a result of approved even if one or more users reject.

Conditions

The conditions determine which transition runs after this activity.

Note: Approval activities run as the user whose actions match the approve or reject conditions the workflow was waiting for and advances the workflow.

Manual Approvals activity conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>The users from the groups have approved the request based on the Wait for rules.</td>
</tr>
<tr>
<td>Rejected</td>
<td>The users from the groups have rejected the request based on the Wait for rules.</td>
</tr>
</tbody>
</table>

States

The activity state tells the workflow engine what to do with the activity.
Manual Approvals activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine starts the <code>execute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

Rollback To workflow activity

The **Rollback To** activity transitions directly to the activity specified by the outgoing transition line arrow.

⚠️ Note: This activity is only available when the workflow runs on a table that extends Task.

**Rollback To** determines which activities to reset based on the actual workflow sequence (transition line attachments) of activities between itself and the transitioned to activity, not the execution order. **Rollback To** then marks all the approvals that have transitioned between the rollback and the transitioned to activity as **Not Yet Requested** and the tasks as either **Open** or **Pending**.

Use the **Rollback To** activity for all workflows in which multiple rollbacks are required. **Rollback To** has no variables.

Conditions

The conditions determine which transition runs after this activity.

**Rollback To activity conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always</td>
<td>The event or condition that causes the approval to revert to the previous workflow step.</td>
</tr>
<tr>
<td>Error</td>
<td>The event or condition that generates an error.</td>
</tr>
<tr>
<td>Skipped</td>
<td>The event or condition that allows a skipped approval.</td>
</tr>
</tbody>
</table>
States
The activity state tells the workflow engine what to do with the activity.

Rollback To activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine starts the execute function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

Rollback To behavior
The Rollback To activity transitions directly to the activity specified by the transition line arrow.

Use the Rollback To activity for all workflows that use multiple or nested rollbacks. Rollback To resets the targeted task (the direct transition) to Open. All tasks that have executed between the Rollback To activity and the targeted task (rolled back task) are set to Pending.

(0) Begin
(1) Log Message
(2) Task 1
(3) Task 3
(4) Task 2
(5) Timer
(6) Approval 1
(7) Roll back to first task
(8) Task 1
(9) Task 2
(10) Approval 1
(11) Log approval
(12) Join
(14) Send email
(15) End

Rollback to workflow

Transition history

The state of (3) Task 3 does not change, since this activity does not directly transition from the rollback target activity. To see what activities were rolled back, select the Workflow Transition History related list and look at the Rolled back column.

The Rollback To activity (7) updates the following activities:

(8) Task 1: reset to Open
(9) Task 2: reset to Pending
(10) Approval 1: reset to Not Yet Requested
Rollback To activity

When conditions in a workflow trigger a Rollback To activity, the workflow moves processing backward to a specified activity in the workflow and resets certain activities that have already executed back to their original state. This is useful when handling an unexpected failure or as part of a programmed logical flow.

When an activity is reset during a workflow rollback, the following happens:

• Approvals are reset to Not Requested.
• Tasks are reset to either Open or Pending. A rollback workflow path cannot create new tasks.

Activities that perform external system operations, such as deleting a file or sending an email, are not rolled back. Only approval and task activity states are reset.

A workflow can contain a single rollback, multiple rollbacks, or nested rollbacks in more complex workflows. The Rollback To activity resets activities based on the actual workflow sequence (transition line attachments) of activities between itself and the transitioned to activity, rather than using the execution order to determine where processing should restart.

Condition Workflow activities

Condition activities provide conditional branching and logical operation functionality for workflows.

If workflow activity

The If activity checks a condition or script to determine if a Yes or No transition should be taken.

If the workflow creator specifies both the Condition and the Advanced script, both must evaluate successfully for activity to take the Yes transition.

Results

The workflow designer can assign a result value using activity.result from within the Script field on the activity record. By default, the result value of the activity is the final result of the condition or script specified. Possible result values are:

• Yes
• No

Input variables

The following variables determine the behavior of the activity.
**Note:** Condition activities run as the user whose actions match the conditions the workflow was waiting for and advances the workflow.

### If activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>If specified and the current record matches the condition, the <strong>Yes</strong> transition is taken.</td>
</tr>
<tr>
<td>Advanced and Script</td>
<td>To specify a script, select the <strong>Advanced</strong> check box. You may then enter a script that is evaluated. If your script sets the variable answer to <strong>yes</strong>, then the <strong>Yes</strong> transition is taken. Otherwise, the <strong>No</strong> transition is taken.</td>
</tr>
</tbody>
</table>

### Conditions

The following conditions determine which transition comes after the activity.

### If activity conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Taken when the condition, if specified, matches and the <strong>Advanced</strong> script, if specified, returns yes.</td>
</tr>
<tr>
<td>No</td>
<td>Taken when either the condition does not match or the <strong>Advanced</strong> script, if specified, returns no.</td>
</tr>
</tbody>
</table>

### States

The activity state tells the workflow engine what to do with the activity.

### If activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine knows to start the <code>onExecute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
</tbody>
</table>
If activity states (continued)

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

Switch workflow activity

The **Switch** activity checks if the value of a passed field or variable is equivalent to one of several case values.

The switch activity behavior is similar to a switch statement in Java.

When creating a switch activity, select a **Variable** or **Field** to check against activity conditions for a matching field value. When the value passed in this variable or field matches the value defined in the **Condition** field of the activity condition, the workflow progresses through that activity condition.

ℹ️ **Note:** Condition activities run as the user whose actions match the conditions the workflow was waiting for and advances the workflow.

Results

The variable or field selected in the **Variable** or **Field** activity variable determines the possible result values.

Input variables

The following variables determine the behavior of the activity.

Switch activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select <strong>Variable</strong> or <strong>Field</strong> as the type of value to check against available conditions. This selection sets the label and available options for the other field.</td>
</tr>
</tbody>
</table>
| Variable or Field | Select the source of the value compared against the switch activity conditions. The field label and available options depend on the **Type** selection.  
  • **Variable**: select any service catalog variable.  
  • **Field**: select any field from the **Table** defined in the workflow properties. |
States
The activity state tells the workflow engine what to do with the activity.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine knows to start the <code>onExecute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

Example
You can create a switch activity that sets different field values on an incident based on the Assignment group of the incident record.

Switch activity example

The **Field** selected is the incident **Assigned to** field.
If the value of the Assigned to field of the workflow-triggering incident is **Service Desk** or **Field Services**, the workflow populates values on the incident record before continuing. If the Assigned to value is **Hardware**, the workflow continues without populating any field values.

Condition type (Standard, Else, or Error) is used. For more information, see [Manage workflow activity conditions](#).
Wait for condition workflow activity

The **Wait for condition** activity causes the workflow to wait at this activity until the current record matches the specified condition.

The workflow evaluates the **Wait for condition** activity each time the current record is updated. Use this activity to pause a workflow indefinitely until a particular criteria is met by a record update. To pause a workflow for a timed duration see **Timer workflow activities**.

For workflow to consider the condition met, all conditions specified – whether in the builder or in a script – must be true.

> **Note:** A **Wait for condition activity** should only be used to wait for an external event such as a record update, and not one from a workflow setting a value. If you have a workflow setting a value and want to wait for that same field to be seen as 'changed,' try inserting a one-second timer.

Results

The workflow designer can assign a result value using `activity.result` from within a script field of the activity. The activity transitions when the result value is true.

Input variables

The following variables determine the behavior of the activity.

> **Note:** Condition activities run as the user whose actions match the conditions the workflow was waiting for and advances the workflow.

### Wait for condition activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>The workflow is paused at this activity until this condition matches the current record.</td>
</tr>
<tr>
<td>Condition script</td>
<td>If specified, the workflow is paused at this activity until this script sets the answer variable to true.</td>
</tr>
</tbody>
</table>

States

The activity state tells the workflow engine what to do with the activity.
Wait for condition activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine knows to start the <code>onExecute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

Wait for WF Event workflow activity

The **Wait for WF Event** activity causes the workflow to wait at this activity until the specified event is fired.

Use this activity to wait for another activity to fire an event. Events from other activities are fired in a script using the `workflow.fireEvent('eventName')` API call.

**Results**

The workflow designer can assign a result value using `activity.result` from within a script field of the activity. This activity transitions when the specified event fires.

**Input variables**

The following variables determine the behavior of the activity.

ℹ️ **Note:** Condition activities run as the user whose actions match the conditions the workflow was waiting for and advances the workflow.

**Wait For WF Event activity input variables**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait for Event</td>
<td>An event name to trigger the workflow.</td>
</tr>
</tbody>
</table>

**States**

The activity state tells the workflow engine what to do with the activity.
### Wait For WF Event activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine knows to start the <code>onExecute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

### Notify workflow activities

Notify workflow activities manage calls and SMS messages in Notify.

All Notify workflows that manage a phone call must run on the `notify_call` table. Call-related Notify activities can be added only to workflows where the **Table** field value is **Notify Call [notify_call]**.

You can identify if an outbound call was answered by a human or by an answering machine from within a Notify workflow by evaluating the `current.is_human` variable, such as with an *If* workflow activity. This variable is set by the telephony provider when an outbound call is answered. This variable is always true for inbound calls.

**Note:** Do not add a *Timer* activity between multiple Notify activities that interact with active phone calls.

**Important:** When creating a Notify workflow, set the workflow **If condition matches** field to **-- None --**. Notify controls which workflow to run based on the configured number groups.

### Related information

- **Using variables in Notify workflow activities**
- **Forward call workflow activity**

#### Forward call workflow activity

The **Forward Call** activity forwards a Notify call to an E.164-compliant phone number.
If the person receiving a forwarded call hangs up, the **forward call** activity completes and transitions to the next activity. Any further Notify activities in the workflow run for the caller only.

### Input variables

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone number to call</td>
<td>Enter the phone number to forward the call to.</td>
</tr>
<tr>
<td>Timeout (in seconds)</td>
<td>Enter the amount of time to wait for the call to be answered before hanging up.</td>
</tr>
<tr>
<td>Record</td>
<td>Select this check box to record the conversation.</td>
</tr>
</tbody>
</table>

### Conditions

The conditions determine which transition comes after this activity. The **forward call** activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if the phone number to call is invalid.

### Input workflow activity

The **Input** activity creates a phone menu by presenting a list of options on a Notify call.

### Input Variables

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of digits</td>
<td>Specify the maximum number of digits the caller can enter. A caller can enter fewer digits than the maximum and press the <strong>Finish key</strong> to complete the entry.</td>
</tr>
<tr>
<td>Finish key</td>
<td>Specify the key a caller can press on their phone when finished selecting a menu option.</td>
</tr>
</tbody>
</table>
## Input Variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timeout (in seconds)</td>
<td>Specify the amount of time to wait before closing the menu automatically when the caller does not select a menu option.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use a script to build the phone menu, instead of using the activity conditions.</td>
</tr>
<tr>
<td>Script</td>
<td>Define the script to build the phone menu. The script must specify an <code>answer</code> variable as a JavaScript object with the following format:</td>
</tr>
</tbody>
</table>

```javascript
answer = {
  "1": {
    "play": "https://some_url.com/options/one.mp3",
    "myCustomData": "some data here"
  },
  "2": {
    "play": "https://some_url.com/options/two.mp3",
    "myCustomData": "some other data here"
  },
  "3": {
    "speak": "type 3 to speak to a representative",
    "language": "en-US",
    "myCustomData": "some more data here"
  }
};
```

The script may specify either a text-to-speech string and language code using the `speak` attribute or URL of the music to be played using the `play` attribute. You can also add optional attributes to store related information, such as `myCustomData` in the example above.

ℹ️ **Note:** The script object continues to support `say` attribute for backward compatibility.

## Conditions

The conditions determine the transition that comes after this activity.

The `input` activity does not specify any conditions by default. You must define conditions to build the phone menu. Each condition is one option on the phone
menu. Notify reads the text from each condition **Name** to the caller, up to 100 characters per condition.

You can specify a language for each condition by prefixing the message with the language code, in the format `xx-XX:<Message>`. For example, add `fr-CA:` for Canadian French. Available languages are stored on the Notify Language [notify_language] table.

The condition that the activity transitions through depends on the digits entered by the caller. Set the condition **Condition** value to `parseInt(workflow.scratchpad.digits) == <expected digits>`. For example, to transition through a condition when the caller presses the number 3, set the **Condition** to `parseInt(workflow.scratchpad.digits) == 3`.

You can add an error condition to this activity. The activity transitions through the error condition if the advanced script returns an invalid value, or if the text to say for a condition is empty.

**Scratchpad Entries**
The activity uses the workflow scratchpad to write persistent values.

<table>
<thead>
<tr>
<th>Values written to scratchpad</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Entry</strong></td>
</tr>
<tr>
<td>workflow.scratchpad.digits</td>
</tr>
<tr>
<td>workflow.scratchpad.menu&lt;activity name&gt;</td>
</tr>
</tbody>
</table>

```javascript
var previousActivity = "choices";
var choicesMenu = workflow.scratchpad.menu[previousActivity];
var menuItem = choicesMenu[workflow.scratchpad.digits]; // Selects the menu item based on the caller's input.
var selectedValue = menuItem.myCustomData; // get the custom data for the selected menu item.
```
**Hangup workflow activity**

The **Hangup** activity disconnects an active Notify phone call.

You can use the **hangup** activity to disconnect only calls that have been answered. Use the **reject** activity to disconnect calls that have not been answered.

**Play workflow activity**

The **Play** activity plays a sound file on a Notify call.

**Input Variables**

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>Enter the URL of a sound file to play. If the URL is inaccessible, or if the audio file mime type is not supported by the telephony provider, the <strong>play</strong> activity is skipped.</td>
</tr>
<tr>
<td>Loop</td>
<td>Enter the number of times the sound file should play.</td>
</tr>
</tbody>
</table>

**Conditions**

The conditions determine which transition comes after this activity. The **play** activity does not specify any conditions by default.

You can create an error condition to handle errors with the sound file. The activity transitions through the error condition if the specified sound file is not available, or has an unsupported mime type. Supported mime types are listed on the Notify Audio MIME Types [notify_mime_type] table.

**Record workflow activity**

The **Record** workflow activity records audio from a user on a Notify call.

**Note:** The Record workflow activity records Notify call but not the Notify conference call. To record the Notify conference call, you can set the **Record** activity variable on the **Join Conference Call** workflow activity.

**Input Variables**

Input variables determine the initial behavior of the activity.
### Input Variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max duration (in seconds)</td>
<td>Enter the maximum duration, in seconds, allowed for a recording.</td>
</tr>
<tr>
<td>Timeout (in seconds)</td>
<td>Enter the amount of time to wait before ending a recording automatically when the caller is silent.</td>
</tr>
<tr>
<td>Finish Key</td>
<td>Specify the key a caller can press on their phone to end the recording.</td>
</tr>
</tbody>
</table>

### Scratchpad Entries

The activity uses the workflow scratchpad to store persistent values.

The `record` activity adds the `recording` variable to the workflow scratchpad. This variable stores metadata about the recording, such as URL, ID, and duration. You can access the following values from this variable.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>recording.recordingDuration</td>
<td>The duration of the recording, in seconds.</td>
</tr>
<tr>
<td>recording.from_number</td>
<td>The caller's phone number, including country code.</td>
</tr>
<tr>
<td>recording.notify_number</td>
<td>The Notify phone number used to respond to the call, including country code.</td>
</tr>
<tr>
<td>recording.recordingID</td>
<td>The ID used by the telephony provider to identify the recording.</td>
</tr>
<tr>
<td>recording.recordingURL</td>
<td>The URL from the telephony provider to access the recording.</td>
</tr>
</tbody>
</table>

### Reject workflow

The **Reject** workflow activity rejects an incoming Notify call.

You can use the **reject** activity to disconnect only calls that have not yet been answered. Use the **hang up** activity to disconnect calls that have been answered.
Input variables
Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reason</td>
<td>Select a reason for rejecting the call, such as busy.</td>
</tr>
</tbody>
</table>

Say workflow activity
The say workflow activity allows you to play a message, using text to speech, on a Notify call.

Input variables
Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text to say</td>
<td>Specify the text to read.</td>
</tr>
<tr>
<td>Language</td>
<td>Select the language and locale to use when reading text.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use a script to define the language and message, instead of using the Text to say and Language values.</td>
</tr>
<tr>
<td>Script</td>
<td>Define a script to set what text is read on the call. The script must return a string that defines the language and the text to read. For example, to play an English-language message, return {language: 'en-US', text: 'Text to read'}.</td>
</tr>
</tbody>
</table>

Forward to notify client workflow activity
The forward to notify client workflow activity connects a phone call to a Notify WebRTC client.

Input variables
Input variables determine the initial behavior of the activity.
Input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Select the user to connect the call to.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use a script to determine which client to</td>
</tr>
<tr>
<td></td>
<td>connect to, instead of using the <strong>User</strong> variable.</td>
</tr>
<tr>
<td>Script</td>
<td>Define a script that controls which client to connect to. This script</td>
</tr>
<tr>
<td></td>
<td>should return a GlideRecord for a single User [sys_user] record.</td>
</tr>
<tr>
<td>Timeout (in seconds)</td>
<td>Enter the amount of time to wait for the call to be connected</td>
</tr>
<tr>
<td>Record</td>
<td>Select this check box to record the call.</td>
</tr>
</tbody>
</table>

Conditions

The conditions determine which transition comes after this activity. The **Forward to Notify Client** activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if there is an issue with the Notify client.

Call workflow activity

The **Call** activity makes outbound phone calls using a Notify workflow. This workflow activity can be added to any table.

Input variables

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify Number</td>
<td>The Notify phone number to make the call from. When you initiate a call, the</td>
</tr>
<tr>
<td></td>
<td>outgoing call workflow for the number group associated with this number runs.</td>
</tr>
<tr>
<td>Phone number to</td>
<td>The E.164-compliant phone number to call.</td>
</tr>
<tr>
<td>call</td>
<td></td>
</tr>
</tbody>
</table>
**Input variables (continued)**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Advanced</strong></td>
<td>Select this check box to use a script to determine number to call, and the Notify number to call from instead of using the <strong>Phone number to call</strong> and <strong>Notify Number</strong> variables.</td>
</tr>
<tr>
<td><strong>Script</strong></td>
<td>Define a script that controls which number to call. This script should return a string listing the Notify number sys_id, as well as the phone number to call, such as <code>{notify_number: 'sys_id', phone_number: '+316...'}</code></td>
</tr>
</tbody>
</table>

**Conditions**

The conditions determine which transition comes after this activity. The call activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if the call could not be set up due to invalid data returned by the advanced script.

**Join conference call workflow activity**

The **Join Conference Call** activity connects an incoming or outgoing call to a Notify conference call.

Notify includes the workflows Notify: (Re)join Conference Call and Notify: Join Conference Call Via SMS to demonstrate how to use the **join conference call** activity to connect inbound and outbound calls, and inbound SMS messages to a conference call.

**Input variables**

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Input variables</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Record</strong></td>
</tr>
<tr>
<td><strong>Advanced</strong></td>
</tr>
<tr>
<td><strong>Script</strong></td>
</tr>
</tbody>
</table>
Input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>conference call. You can access values from the workflow scratchpad.</td>
</tr>
</tbody>
</table>

Conditions
The conditions determine which transition comes after this activity. The join conference call activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if the conference.call scratchpad variable is not set.

Scratchpad entries
The activity uses the workflow scratchpad to read persistent values.

Values read from scratchpad

<table>
<thead>
<tr>
<th>Scratchpad variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>workflow.scratchpad.conference_call</td>
<td>A GlideRecord for a single conference call record. A call processed by this activity is added to this conference call. If this value is not specified, the join conference call activity will log an error. When initiating an outgoing call workflow using the Notify API call(String notifyPhoneNumber, String toPhoneNumber, GlideRecord conferenceCall) method, this scratchpad value is set automatically to the conference call GlideRecord. For incoming call workflows, or workflows initiated using a different mechanism, you must explicitly set this scratchpad value.</td>
</tr>
</tbody>
</table>

Enable different attributes available with Join Conference Call activity
System administrators can enable any or all of the below attributes and use them in the Join Conference Call workflow activity.
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hangupOnStar</td>
<td>When hangupOnStar is enabled (set to true), participants in a conference call can press the * button to disconnect from the call. Control is returned to the workflow, which can be used to trigger customer-defined actions.</td>
</tr>
<tr>
<td>muted</td>
<td>When muted is enabled (set to true), the participant will join the conference in a muted state.</td>
</tr>
<tr>
<td>beepOnEnter</td>
<td>When beepOnEnter is enabled (set to true), a notification beep is played when a user joins the conference.</td>
</tr>
<tr>
<td>beepOnExit</td>
<td>When beepOnExit is enabled (set to true), a notification beep is played when a user leaves the conference.</td>
</tr>
<tr>
<td>enableImmediateInput</td>
<td>When enableImmediateInput is enabled (set to true), it allows input of a single digit immediately after the conference ends for this user and sets that in workflow.scratchpad.confDigits. This option will be ignored if hangupOnStar is false.</td>
</tr>
</tbody>
</table>

To enable any of the above attributes, perform the following steps:

1. Navigate to **Workflow > Administration > Workflow Versions**.
2. Open the Notify: (Re)join Conference Call workflow.
3. Click the **Show Workflow** related link.
4. To modify the workflow, click the WorkFlow Actions icon and click **Checkout**.
5. Open the Join Conference Call workflow activity.
6. Enable the **Advanced** check box to display the **Script** field.
7. Set the **hangupOnStar** attribute to true in the **config** variable in the script. The default setting is false.
8. Click **Update**.
9. Click the WorkFlow Actions icon and click **Publish** to save the changes.

Similarly, you can enable the other attributes.

**Send SMS workflow activity**
The send SMS workflow activity to send short text messages using Notify to users' phones. This workflow activity can be added to any table.

**Input variables**
Input variables determine the initial behavior of the activity.

**Input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>From</strong></td>
<td>Select the Notify phone number to use to send the SMS message.</td>
</tr>
<tr>
<td><strong>Advanced</strong></td>
<td>Select this check box to use JavaScript to determine which numbers to send the message to, and the Notify number to use to send the message.</td>
</tr>
<tr>
<td><strong>To</strong></td>
<td>Select any number of users to send the message to. The user record must have a E.164-compliant phone number or notification device configured for SMS messages.</td>
</tr>
<tr>
<td><strong>To (groups)</strong></td>
<td>Select any number of groups to send the message to. All members of that group with an E.164-compliant phone number or SMS notification device receive the message.</td>
</tr>
<tr>
<td><strong>Message</strong></td>
<td>Enter the message to send. You can add field values from the current record by using the <strong>Select variables</strong> box. You can also add values from the workflow scratchpad. If a field and a scratchpad variable have the same name, the field value is used. Because you can use variables in this message, it is not possible to determine the length of the message at design time. If the activity sends a message that is longer than supported by the telephony provider, the message is truncated and the instance logs a warning.</td>
</tr>
<tr>
<td><strong>To (script)</strong></td>
<td>Enter a script to determine which numbers to send the message to, and the Notify number to use to send the message.</td>
</tr>
</tbody>
</table>
Input variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The script should return a JavaScript object with the format <code>{notify_number: &quot;...sys_id...&quot;}, users: [...], groups: [...], numbers: [...]</code>. Specify the users or groups to send the message to as an array of sys_id values. Specify other numbers as an array of E.164-compliant phone numbers. This field appears only if Advanced is selected.</td>
</tr>
</tbody>
</table>

Conditions

The conditions determine which transition comes after this activity. This activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if the Notify number used to make the call is not configured correctly or unable to send SMS messages, or if an error occurs while sending the SMS.

Queue workflow activity

The Queue activity places an active Notify call in a queue.

Add the Queue activity to a workflow on the Notify Call [notify_call] table to put the current call on hold. This activity does not specify any input variables.

The queue that the call is added to is given a random ID.

Workflow notification activities

Notification workflow activities notify users of events that occur during the workflow.

Create Event workflow activity

The Create Event activity adds an event to the event queue, but does not immediately fire the event.

The event processor typically processes the event within one minute. This activity triggers any business rules or email notifications that would normally be triggered by the event.

Results

Finished: the activity added the event to the event queue.
Input variables

Create Event activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event name</td>
<td>The name of the event to create. From the Event Name lookup list, select the event to add to the queue. If the event requires parameters, specify them in the Parameter script field.</td>
</tr>
<tr>
<td>Parameter 1</td>
<td>The first parameter of the event.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If this parameter is a string value, it must be within quotes (“ ”).</td>
</tr>
<tr>
<td>Parameter 2</td>
<td>The second event parameter.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If this parameter is a string value, it must be within quotes (“ ”).</td>
</tr>
</tbody>
</table>

Notification workflow activity

The Notification activity sends an email or SMS message to specified users or groups.

Input variables

Notification activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Addressees</td>
<td></td>
</tr>
<tr>
<td>To</td>
<td>The users who will be recipients of the email.</td>
</tr>
<tr>
<td>To (groups)</td>
<td>The members of the groups that will be recipients of the email.</td>
</tr>
<tr>
<td>Advanced</td>
<td>If selected, the script in the To (script) field is called to specify additional recipients of the email.</td>
</tr>
<tr>
<td>To (script)</td>
<td>If Advanced is selected, this script is called and should set the variable answer to a comma-separated list of user or group sys_ids that you want to add as recipients of the email.</td>
</tr>
<tr>
<td>Message</td>
<td></td>
</tr>
<tr>
<td>Subject</td>
<td>The subject line of the email.</td>
</tr>
</tbody>
</table>
Notification activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message</td>
<td>The email body that is sent.</td>
</tr>
<tr>
<td></td>
<td>To include the value of a field in the message body, place</td>
</tr>
<tr>
<td></td>
<td>the cursor at the point in the text where you want the field's value inserted. Then click the + icon next to <strong>Fields</strong> and select the field you want.</td>
</tr>
</tbody>
</table>

States
The activity state tells the workflow engine what to do with the activity.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine knows to start the <strong>run</strong> function of the activity.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
</tbody>
</table>

Timer workflow activities
Timer activities pause workflows for set periods of time.

Related information

Use multiple timer activities in one workflow

SLA Percentage Timer workflow activity

The **SLA Percentage Timer** activity pauses the workflow for a duration equal to a percentage of an SLA.

A workflow must run on the Task SLA table to use this activity.

⚠️ **Note:** Timer activities run as the System user because the system scheduler advances the workflow.
Results

SLA Percentage Timer activity results

<table>
<thead>
<tr>
<th>Result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete</td>
<td>The activity successfully reached the specified duration</td>
</tr>
<tr>
<td>Cancelled</td>
<td>The activity or workflow was canceled before the timer reached the specified duration</td>
</tr>
</tbody>
</table>

Input variables

Input variables determine the initial behavior of the activity.

SLA Percentage Timer activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percentage</td>
<td>The duration to pause the workflow for, as a percentage of the current SLA</td>
</tr>
</tbody>
</table>

States

The activity state tells the workflow engine what to do with the activity.

SLA Percentage Timer states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The activity is in this state very briefly while initializing, after which it immediately changes to <em>Waiting</em>.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine waits until the SLA reaches the specified percentage. The engine then transitions the workflow to the next activity.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

Timer workflow activity

The Timer activity pauses the workflow for a specified period of time.
This duration can be an absolute time value or a relative value based on a defined schedule. It is best to adjust the **Duration** so the workflow can progress in a timely manner. To pause a workflow indefinitely until a condition is met, see **wait for condition**.

ℹ️ **Note:** Timer activities run as the System user because the system scheduler advances the workflow.

### Results

**Timer activity results**

<table>
<thead>
<tr>
<th>Result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete</td>
<td>The activity successfully reached the specified duration.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>The activity or workflow was canceled before the timer reached the specified duration.</td>
</tr>
</tbody>
</table>

### Input variables

Input variables determine the initial behavior of the activity.

**Timer activity input variables**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timer based on</td>
<td>How the timer duration is computed. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>A user specified duration:</strong> The duration is based on the Duration fields, such as days and hours.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A relative duration:</strong> The duration is based on the Relative duration (such as End of Next Business Day) and <strong>Wait</strong> fields.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A date/time or duration field:</strong> The duration is based on the Field value and the <strong>Wait</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Script:</strong> The duration is based on a script that returns the number of seconds.</td>
</tr>
<tr>
<td>Duration</td>
<td>The specific number of days and hours to wait before proceeding to the next activity in the workflow.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>A user specified duration.</strong></td>
<td></td>
</tr>
<tr>
<td>Relative duration</td>
<td>Appears only when <strong>Timer based on</strong> is <strong>A relative duration</strong>&lt;br&gt;Note: Relative duration appears only when <strong>Timer based on</strong> is <strong>A relative duration</strong> or <strong>A date/time or duration field</strong>. The general number and length of business days to wait before progressing to the next workflow activity.</td>
</tr>
</tbody>
</table>
| **Wait** | An additional timer adjustment when **Timer based on** is **A relative duration** or **A date/time or duration field**. The options are:  
  - **The full duration**: No modification of the calculated duration.  
  - **A % of the duration**: The duration is adjusted by multiplying the number of seconds by the (Percentage / 100).  
  - **Some time before**: The duration is shortened by the **Time before** days and hours.  
  - **Some time after**: The duration is lengthened by the **Time after** days and hours. |
| **Percentage** | The **Wait** percentage value when **Timer based on** is **A relative duration** or **A date/time or duration field**. |
| **Time before** | The modifier time value when **Wait** is **Some time before**. |
| **Time after** | The modifier time value when **Wait** is **Some time after**.
### Timer activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appears only when Timer based on is A relative duration or A date/time or duration field and Wait is Some time after.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>The date/time or duration field that contains the elapsed wait-time before moving to the next workflow activity.</td>
</tr>
<tr>
<td>Appears only when Timer based on is A date/time or duration field.</td>
<td></td>
</tr>
<tr>
<td>Script</td>
<td>The script that sets 'answer' to the number of seconds for the duration.</td>
</tr>
<tr>
<td>Appears only when Timer based on is Script</td>
<td></td>
</tr>
<tr>
<td>Timer Schedule</td>
<td>The basic schedule the timer uses to count working hours. If a schedule is specified, the duration will only be considered for times that are specified on the schedule. For example, if the duration is 2 hours and the workflow begins at 4:00pm on a schedule that is 8am - 5pm, then it ends at 9:00am the next day. The options are:</td>
</tr>
<tr>
<td>Schedule based on</td>
<td>• <strong>This workflow's schedule:</strong> The schedule uses workflow context date, time, and an optional <em>Time zone based on</em> value.</td>
</tr>
<tr>
<td>Schedule</td>
<td>• <strong>A specific schedule:</strong> The schedule uses a pre-defined Schedule and an optional <em>Time zone based on</em> value.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A schedule field:</strong> The schedule uses a value from a table and an optional <em>Time zone based on</em> value.</td>
</tr>
<tr>
<td>Appears only when Schedule based on is A specific schedule.</td>
<td>The pre-defined Schedule from a list.</td>
</tr>
</tbody>
</table>
Timer activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule field</td>
<td>A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog.</td>
</tr>
<tr>
<td>Timer Time Zone</td>
<td>The time zone for calculating the duration. The time zone may be based on:</td>
</tr>
<tr>
<td></td>
<td>• No time zone: Default. Workflow uses the GMT time zone.</td>
</tr>
<tr>
<td></td>
<td>• A specific time zone: A predefined Time zone.</td>
</tr>
<tr>
<td></td>
<td>• A time zone field: A Time zone field to track time duration from a field on the form.</td>
</tr>
<tr>
<td>Time zone</td>
<td>The predefined time zone.</td>
</tr>
<tr>
<td>Time zone field</td>
<td>A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog.</td>
</tr>
</tbody>
</table>

States
The activity state tells the workflow engine what to do with the activity.

Timer activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The Timer activity is in this state very briefly while initializing, after which it immediately changes to Waiting.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine waits until the timer reaches the specified duration. The engine then transitions the workflow to the next activity.</td>
</tr>
</tbody>
</table>
Timer activity states (continued)

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

Example

You can use a **Timer** activity to pause the workflow until the end of the business day.

In this example, the script evaluates the time between the `now` variable and the `eod` variable. The `eod` variable is defined, in 24 hour time, as 4:00 PM. The script then sets the `answer` variable to the difference between these variables, in seconds, and logs a message.
// get now and calc end of day (4:00pm)

var now = new Date();

var eod = new Date();
eod.setHours(16);
eod.setMinutes(0);
eod.setSeconds(0);

answer = (eod.getTime() - now.getTime()) / 1000;

workflow.debug('Timer will fire @: ' + eod + ' ' + (answer / 60) + ' minutes from now');

Task workflow activities
Task activities create and modify workflow tasks.

Task activities are only available when the workflow runs on a table that extends Task.

Add Worknote workflow activity
The Add Worknote activity adds text to the Worknotes field of the current incident record.

A workflow must run on the Incident table to use this activity.

Note: Task activities run as the user whose actions complete the task the workflow was waiting for and advances the workflow.

Input variables

Add Worknote activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Note</td>
<td>The text to add to the incident record.</td>
</tr>
</tbody>
</table>

Attachment Note workflow activity
The Attachment Note activity adds an attachment to the current record.

Note: This activity is only available when the workflow runs on a table that extends Task.

This activity allows the use of irregular HTML tags to reference attachments, specifically the [code] tag. Entries in a journal field that use irregular HTML do not
work if the `glide.ui.allow_deep_html_validation` property is true. This property is set to false by default.

⚠️ **Note:** Task activities run as the user whose actions complete the task the workflow was waiting for and advances the workflow.

### Results
- **Finished:** the activity added the attachment to the record.

### Input variables
The following variables determine the behavior of the activity.

#### Attachment Note activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>When this activity runs, it makes a note on the current record that a file has been attached. Specify the field on the current record in which you want this note to appear. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>none</strong> (defaults to Work Notes)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Additional Comments</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Work notes</strong></td>
</tr>
<tr>
<td>Attachment note information</td>
<td></td>
</tr>
<tr>
<td>Attachment Name</td>
<td>When this activity runs, it creates a .txt file with the name you specify in this field.</td>
</tr>
<tr>
<td>Attachment Data</td>
<td>The content of the .txt file attachment. It can be in plain text or use variables to extract specific data from a table.</td>
</tr>
</tbody>
</table>

### Catalog Task workflow activity

The **Catalog Task** activity creates a service catalog task record.

⚠️ **Note:** This activity is only available when the workflow runs on a table that extends Task.

A user must complete the catalog task. This activity is available only for workflows running on the Catalog Request Item `[sc_req_item]` table.

⚠️ **Note:** Task activities run as the user whose actions complete the task the workflow was waiting for and advances the workflow.
Results

You can assign a result value using `activity.result` from within a script field of the activity. The final State value of the catalog task record determines the result value for the Create Task activity. Possible result values are:

- Closed complete
- Closed incomplete
- Closed skipped
- Deleted
- Cancelled

Input fields

The values you enter in the following fields determine the behavior of the activity.

### Catalog task activity information

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Catalog Task Activity Settings</strong></td>
<td>The following fields specify the behavior of the Catalog Task Activity.</td>
</tr>
<tr>
<td>Task Table</td>
<td>The table on which this activity runs. In most cases, leave set to the default value: <code>[sc_req_item]</code>.</td>
</tr>
<tr>
<td>Priority</td>
<td>The value you want assigned to the Priority field for the new task.</td>
</tr>
<tr>
<td>Wait for completion</td>
<td>If selected, the workflow activity waits for the task to complete before continuing. If cleared, the task is created but the workflow proceeds.</td>
</tr>
<tr>
<td><strong>Catalog Task Record Settings</strong></td>
<td>The following fields specify the field values that this activity sets for the catalog task it creates.</td>
</tr>
<tr>
<td>Task value from</td>
<td>Specify how you want to populate fields on the new task.</td>
</tr>
<tr>
<td>Fields</td>
<td>a predefined set of fields including <strong>Fulfillment group</strong>, <strong>Assigned to</strong>, <strong>Short description</strong> and <strong>Instructions</strong>.</td>
</tr>
<tr>
<td>Template</td>
<td>an existing template for the selected task table.</td>
</tr>
<tr>
<td>Values</td>
<td>values that you specify using a Set Values widget.</td>
</tr>
</tbody>
</table>
### Catalog task activity information (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>After you select a value for Task value from, additional fields specific to that value appear on the form.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Fulfillment group</strong></td>
<td>The group that is responsible for completing the task. Populates the Assignment group field on the new task.</td>
</tr>
<tr>
<td><strong>Assigned to</strong></td>
<td>The user who is responsible for completing the task. Populates the Assignment to field on the new task.</td>
</tr>
<tr>
<td><strong>Short description</strong></td>
<td>A short description for the task. Populates the Short description field on the new task.</td>
</tr>
<tr>
<td><strong>Instructions</strong></td>
<td>The task instructions for the user to complete prior to closing the task. Populates the Description field on the new task.</td>
</tr>
<tr>
<td><strong>Template</strong></td>
<td>The values in the task will be populated from the values in the template you select.</td>
</tr>
<tr>
<td><strong>SetValues</strong></td>
<td>Select any field on the task record to a value you specify here.</td>
</tr>
</tbody>
</table>
**Catalog task activity information (continued)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>value from is set to Values.</strong></td>
<td></td>
</tr>
<tr>
<td>Advanced</td>
<td>Check <strong>Advanced</strong> if you want to use a script to assign values on the catalog task. When you check <strong>Advanced</strong>, a text box appears where you can enter your script.</td>
</tr>
</tbody>
</table>
| Advanced Script        | Set additional values for the task in this script. This script is run after the task values are set using the **Fields, Template** or **Values** you have specified. Use the variable **task** when setting additional values, for example:  
```
  task.short_description = current.short_description;
```

**Catalog Task Variables**

**Variables on Task Form**

Specify optional catalog variables to include on the Catalog task form. The variables you select here will be displayed in a field called **Variable Editor**. If you select no variables here, the **Variable Editor** field in the Catalog Task form will not be visible.

**Catalog Task Schedule**

Due date based on

Select how workflow determines the task’s duration, due date, and schedule.

- **A user specified duration**: The duration is based on a user specified value.
- **A relative duration**: The duration is calculated from a relative duration (such as End of Next Business Day).
- **A date/time or duration field**: The duration is based on the value of a field on the current record.
- **Script**: The duration is returned by a script.

Duration

The specific number of days and hours.
### Catalog task activity information (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative duration</td>
<td>The general number and length of business days.</td>
</tr>
<tr>
<td>Only appears when <strong>Due date based on</strong> is set to A relative duration</td>
<td></td>
</tr>
<tr>
<td>Due date field</td>
<td>The date/time or duration field.</td>
</tr>
<tr>
<td>Only appears when <strong>Due date based on</strong> is set to A date/time or duration field</td>
<td></td>
</tr>
<tr>
<td>Due date script</td>
<td>The script that sets 'answer' to the number of seconds for the duration.</td>
</tr>
<tr>
<td>Only appears when <strong>Due date based on</strong> is set to Script</td>
<td></td>
</tr>
<tr>
<td>Schedule based on</td>
<td>The basic schedule the timer uses to count working hours. If a schedule is specified, the duration will only be considered for times that are specified on the schedule. For example, if the duration is 2 hours and the workflow begins at 4:00pm on a schedule that is 8am - 5pm, then it ends at 9:00am the next day. The options are:</td>
</tr>
<tr>
<td>Schedule</td>
<td></td>
</tr>
<tr>
<td><strong>This workflow's schedule</strong>: The schedule uses workflow context date, time, and an optional <strong>Time zone based on</strong> value.</td>
<td></td>
</tr>
<tr>
<td><strong>A specific schedule</strong>: The schedule uses a pre-defined <strong>Schedule</strong> and an optional <strong>Time zone based on</strong> value.</td>
<td></td>
</tr>
<tr>
<td><strong>A schedule field</strong>: The schedule uses a value from a table and an optional <strong>Time zone based on</strong> value.</td>
<td></td>
</tr>
<tr>
<td>Schedule</td>
<td>The predefined <strong>Schedule</strong> from a list.</td>
</tr>
</tbody>
</table>
### Catalog task activity information (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only appears when <strong>Schedule based on</strong> is set to <em>A specific schedule</em></td>
<td>A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog.</td>
</tr>
<tr>
<td><strong>Schedule field</strong>&lt;br&gt;Only appears when <strong>Schedule based on</strong> is set to <em>A schedule field</em></td>
<td></td>
</tr>
<tr>
<td><strong>Time zone based on</strong>&lt;br&gt;The time zone for calculating the duration. The time zone may be based on:</td>
<td></td>
</tr>
<tr>
<td>• <strong>No time zone</strong>: Default. Workflow uses the GMT time zone.</td>
<td></td>
</tr>
<tr>
<td>• <strong>A specific time zone</strong>: A specific <strong>Time zone</strong> that you choose from a choice list.</td>
<td></td>
</tr>
<tr>
<td>• <strong>A time zone field</strong>: A <strong>Time zone field</strong> to track time duration from a field on the form.</td>
<td></td>
</tr>
<tr>
<td><strong>Time zone</strong>&lt;br&gt;Only appears when <strong>Time zone based on</strong> is set to <em>A specific time zone</em></td>
<td>Select the time zone you want from the choice list.</td>
</tr>
<tr>
<td><strong>Time zone field</strong>&lt;br&gt;Only appears when <strong>Time zone based</strong></td>
<td>A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog.</td>
</tr>
</tbody>
</table>
Catalog task activity information (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>on is set to A time zone field.</td>
<td></td>
</tr>
</tbody>
</table>

**States**
The activity state tells the workflow engine what to do with the activity.

**Catalog Task activity states**

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine knows to start the <code>onExecute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

**Create Task workflow activity**
The Create Task activity generates a record on any of the tables that extend Task [task].

⚠️ **Note:** This activity is only available when the workflow runs on a table that extends Task.

If the **Wait for completion** check box is selected, the workflow context waits for a user action on the task, such as Complete or Incomplete, and then progresses based on the user action.

⚠️ **Note:** Task activities run as the user whose actions complete the task the workflow was waiting for and advances the workflow.
Results
You can assign a result value using `activity.result` from within a script field of the activity. By default, the final `State` value of the task record determines the result value for the Create Task activity. Possible result values are:

- Closed complete
- Closed incomplete
- Closed skipped
- Deleted
- Cancelled

Input variables
The following variables determine the behavior of the activity.

Create Task activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Task Activity Settings</td>
<td>The following fields specify the behavior of the Create Task Activity.</td>
</tr>
<tr>
<td>Task type</td>
<td>The type of task to create. Select from the corresponding task table for the workflow.</td>
</tr>
<tr>
<td>Priority</td>
<td>The default priority assigned to the task. If you also set the Task priority in the Task values from section, the Task value overrides the default priority.</td>
</tr>
<tr>
<td>Wait for completion</td>
<td>If selected, the workflow activity waits for the task to complete before continuing. If cleared, the task is created but the workflow proceeds.</td>
</tr>
<tr>
<td>Create Task Record Settings</td>
<td>The following fields specify the field values that this activity sets for the task it creates.</td>
</tr>
<tr>
<td>Task values from</td>
<td>The values used to create the task may either come from:</td>
</tr>
<tr>
<td></td>
<td>• Fields: a predefined set of fields including Fulfillment group, Assigned to, Short description and Instructions.</td>
</tr>
<tr>
<td></td>
<td>• Template: an existing template for the selected task table.</td>
</tr>
<tr>
<td></td>
<td>• Values: values that you specify using a Set Values widget.</td>
</tr>
</tbody>
</table>
Create Task activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fulfillment group</strong></td>
<td>The group that is responsible for completing the task. Populates the Assignment group field on the new task.</td>
</tr>
<tr>
<td><strong>Assigned to</strong></td>
<td>The user who is responsible for completing the task. Populates the Assignment to field on the new task.</td>
</tr>
<tr>
<td><strong>Short description</strong></td>
<td>A short description for the task. Populates the Short description field on the new task.</td>
</tr>
<tr>
<td><strong>Instructions</strong></td>
<td>The task instructions for the user to complete prior to closing the task. Populates the Description field on the new task.</td>
</tr>
<tr>
<td><strong>Task template</strong></td>
<td>A template that is used to fill in values for the task.</td>
</tr>
<tr>
<td><strong>Set values</strong></td>
<td>A widget that is used to specify values for any fields of the task.</td>
</tr>
</tbody>
</table>

**Note:** Any Task priority you set here overrides the default priority set by the Priority field.
Create Task activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>values from</td>
<td>is set to Values.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Check Advanced if you want to use a script to assign values on the catalog task. When you check Advanced, a text box appears where you can enter your script.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Set additional values for the task in this script. This script is run after the task values are set using the Fields, Template or Values you have specified.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Use the variable task when setting additional values, for example:</td>
</tr>
<tr>
<td></td>
<td>task.short_description = current.short_description;</td>
</tr>
<tr>
<td>Task Schedule</td>
<td></td>
</tr>
<tr>
<td>Due date based on</td>
<td>Select how workflow determines the task's duration, due date, and schedule.</td>
</tr>
<tr>
<td></td>
<td>• A user specified duration: The duration is based on a user specified value.</td>
</tr>
<tr>
<td></td>
<td>• A relative duration: The duration is calculated from a relative duration (such as End of Next Business Day).</td>
</tr>
<tr>
<td></td>
<td>• A date/time or duration field: The duration is based on the value of a field on the current record.</td>
</tr>
<tr>
<td></td>
<td>• Script: The duration is returned by a script.</td>
</tr>
<tr>
<td>Duration</td>
<td>The specific number of days and hours.</td>
</tr>
<tr>
<td>Relative duration</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The general number and length of business days.</td>
</tr>
</tbody>
</table>
Create Task activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only appears when <strong>Due date based on</strong> is set to <strong>A relative duration</strong></td>
<td></td>
</tr>
<tr>
<td>Due date field</td>
<td>The date/time or duration field.</td>
</tr>
<tr>
<td>Only appears when <strong>Due date based on</strong> is set to <strong>A date/time or duration field</strong></td>
<td></td>
</tr>
<tr>
<td>Due date script</td>
<td>The script that sets 'answer' to the number of seconds for the duration.</td>
</tr>
<tr>
<td>Only appears when <strong>Due date based on</strong> is set to <strong>Script</strong></td>
<td></td>
</tr>
<tr>
<td>Schedule based on</td>
<td>The basic schedule the timer uses to count working hours. If a schedule is specified, the duration will only be considered for times that are specified on the schedule. For example, if the duration is 2 hours and the workflow begins at 4:00pm on a schedule that is 8am - 5pm, then it ends at 9:00am the next day. The options are:</td>
</tr>
<tr>
<td>Schedule based on</td>
<td>• <strong>This workflow's schedule</strong>: The schedule uses workflow context date, time, and an optional <strong>Time zone based on</strong> value.</td>
</tr>
<tr>
<td>Schedule based on</td>
<td>• <strong>A specific schedule</strong>: The schedule uses a pre-defined <strong>Schedule</strong> and an optional <strong>Time zone based on</strong> value.</td>
</tr>
<tr>
<td>Schedule based on</td>
<td>• <strong>A schedule field</strong>: The schedule uses a value from a table and an optional <strong>Time zone based on</strong> value.</td>
</tr>
<tr>
<td>Schedule based on</td>
<td>The predefined <strong>Schedule</strong> from a list.</td>
</tr>
</tbody>
</table>
## Create Task activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Schedule based on</strong></td>
<td><strong>is set to</strong> A specific schedule</td>
</tr>
<tr>
<td>Schedule field</td>
<td>A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog.</td>
</tr>
<tr>
<td>Time zone based on</td>
<td>The time zone for calculating the duration. The time zone may be based on:</td>
</tr>
<tr>
<td></td>
<td>• No time zone: Default. Workflow uses the GMT time zone.</td>
</tr>
<tr>
<td></td>
<td>• A specific time zone: A specific Time zone that you choose from a choice list.</td>
</tr>
<tr>
<td></td>
<td>• A time zone field: A Time zone field to track time duration from a field on the form.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Select the time zone you want from the choice list.</td>
</tr>
<tr>
<td>Time zone field</td>
<td>A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog.</td>
</tr>
</tbody>
</table>
Create Task activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A time zone</td>
<td>field.</td>
</tr>
</tbody>
</table>

States
The activity state tells the workflow engine what to do with the activity.

Create Task activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine knows to start the onExecute function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

Utility workflow activities
Utility activities provide controls over the path of the workflow, and other useful tools.

Branch workflow activity
The Branch activity splits the workflow into multiple transition paths from a single activity.

To add a transition path, drag the Branch activity onto the canvas. When the Branch activity properties form displays, click Submit to add the activity to the canvas. Once the activity is on the canvas, right click in the activity body, then click Add Condition.

All transitions from this activity execute concurrently. This activity provides a single Always condition. You can draw any number of transitions from this condition. Using this activity is equivalent to drawing multiple transitions from a single condition of another activity.
Branching can affect the behavior of rollback activities. See Rollback To activity for more information.

Join workflow activity

The **Join** activity unites multiple execution paths into one transition.

Use this activity to cause a workflow to wait for all activities in multiple paths to finish before continuing. If multiple concurrent workflow paths meet without a **Join** activity, any subsequent activities execute twice.

To add Join to the canvas, click Submit. On the canvas, connect incoming transitions from each activity you want to act as a predecessor to the Join activity. Then connect outgoing transitions to the two exit conditions: Complete and Incomplete.

Results

Provide an Incomplete transition out of a **Join** whenever it is possible for any predecessor activities to follow a transition path that does not lead to the **Join** activity.

<table>
<thead>
<tr>
<th>Result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete</td>
<td><strong>Join</strong> exits along the Complete path when the system has determined that all predecessor activities have completed and transitioned to the <strong>Join</strong>.</td>
</tr>
<tr>
<td>Incomplete</td>
<td><strong>Join</strong> exits along the Incomplete path when the system determines that at least one predecessor activity completed but transitioned along a path that bypassed the <strong>Join</strong> activity.</td>
</tr>
</tbody>
</table>

Lock workflow activity

The **Lock** activity prevents other instances of this workflow from continuing past this activity until the lock is released.

Several instances of the same workflow may run concurrently. For example, if a workflow is triggered when a record is added to a particular table and multiple records are added one after the other, that workflow will be triggered multiple times: once by each record insertion. In such cases, you can use the lock activity to ensure that this instance of the workflow has completely finished one or more activities before any other instance of the workflow can proceed.
A workflow can explicitly release a lock with the **Unlock** activity. The lock may also be released when the **Max duration** is reached.

When an instance of the workflow reaches the **Lock** activity, it attempts to obtain a lock using the key specified in the lock activity. If another instance has already obtained the lock and has not yet released it, this lock attempt fails. The instance continues trying to obtain the lock until **Max attempts** has been reached.
Note:

We recommend placing a one-second timer activity before the lock activity. This helps prevent a rare condition in which the lock activity may not be able to distinguish one workflow instance from another. This condition can occur because the entity owning the lock is not the specific workflow instance, but rather the code-execution thread in which that instance is running. In most cases, each workflow instance runs on a different thread, but adding a timer activity ensures that this is the case.

**Example of Lock Activity Preceded by Timer Activity**

Since a **Lock** activity can only temporarily prevent processing of other workflow instances, do not add activities that cause the workflow to wait between a **Lock** and **Unlock** activity block. This may cause the **Unlock** activity to be unable to acquire the lock to release it and instead take 60 seconds to complete. Restricted wait activities include:
• Approval activities
• Task activities
• Timer activities
• Wait for condition activity
• Wait for WF Event activity

Results

Lock activity results

<table>
<thead>
<tr>
<th>Result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity successfully obtained a lock. This instance of the workflow can proceed past this point, but other instances cannot until the lock is released.</td>
</tr>
<tr>
<td>Failure</td>
<td>After attempting to obtain the lock <strong>Max attempts</strong> times, the activity could not obtain the lock.</td>
</tr>
</tbody>
</table>

Input variables

Input variables determine the initial behavior of the activity.

Lock activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>A unique mutex key. The <strong>Unlock activity</strong> activity uses this key to release the lock.</td>
</tr>
<tr>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Max. duration</td>
<td>The maximum time the lock persists. The lock is released after it reaches this duration. Releasing a lock this way is equivalent to running the <strong>Unlock</strong> activity.</td>
</tr>
<tr>
<td>Lock attempts</td>
<td>Specify how the activity behaves if the lock attempt is denied. If the final lock attempt fails, the activity state will be set to ‘timeout’ and the activity result will be set to ‘failed’.</td>
</tr>
<tr>
<td>Max. attempts</td>
<td>Specify the maximum number of times the activity may attempt to obtain the lock.</td>
</tr>
</tbody>
</table>
Lock activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delay between attempts</td>
<td>The amount of time required after a failed lock attempt before another lock attempt is allowed.</td>
</tr>
</tbody>
</table>

States

The activity state tells the workflow engine what to do with the activity.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waiting</td>
<td>The workflow engine is waiting to obtain a lock.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity successfully obtained the lock.</td>
</tr>
<tr>
<td>Timeout</td>
<td>The activity could not obtain a lock within the number of attempts specified by the Max. attempts input variable.</td>
</tr>
</tbody>
</table>

Log Message workflow activity

The Log Message activity writes a message to the workflow log.

Use this activity to add entries to the workflow's log for debugging or tracing purposes.

Input variables

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Log Message activity input variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Message</td>
</tr>
</tbody>
</table>

Log Trace Message workflow activity

The Log Trace Message activity writes a trace message to the workflow log.
The trace message includes the activity name, the event that invoked the workflow, and the table of the current record. There are no variables or conditions. To log other data, use the Log Message workflow activity activity.

**REST Message legacy workflow activity**

The legacy REST Message activity enables an administrator to override the REST endpoint or supply the variables configured in the REST Message module.

This activity is deprecated in the Rome release and no longer shows up in the Workflow canvas for new workflow development. New workflows should use the Orchestration REST Activity templates instead.

Existing workflows using it will continue to work as designed. To edit this activity in an existing workflow, you must re-activate the activity.

The REST Message activity executes a dead link REST function (POST, PUT, GET, or DELETE) on an endpoint using values defined in the function record.

**Note:** If you want to use a MID Server to send the REST message, the MID Server must be accessible by the instance and configured to use SSH.

**Input variables**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rest Message</td>
<td>Name of the REST message to run. This is a reference field to the REST Message [sys_rest_message] table (System Web Services &gt; Outbound &gt; REST Message).</td>
</tr>
<tr>
<td>REST Message Function</td>
<td>Function to call that is defined in a REST message function. This is a reference field to the HTTP Method [sys_rest_message_fn] table (System Web Services &gt; Outbound &gt; REST Message). Available functions are put, post, get, or delete. You can edit functions in the HTTP Methods related list in each REST Message record.</td>
</tr>
<tr>
<td>REST Endpoint</td>
<td>REST endpoint to use instead of the Endpoint defined in the HTTP Method record. Leave this field blank to use the defined endpoint in the REST Message Function record.</td>
</tr>
<tr>
<td>Rest Message Variables</td>
<td>Variables Values to use for variables defined in the HTTP Method record.</td>
</tr>
</tbody>
</table>
REST Message activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the following format for the string:</td>
<td>name1=value1, name2=value2, ...</td>
</tr>
<tr>
<td>For example, use name=${nameValue}, id=${idValue} where name and id are function variables. If either the variable name or value contains a comma or equal sign, escape those characters with a backslash.</td>
<td></td>
</tr>
</tbody>
</table>

Rest Message MID Server

<table>
<thead>
<tr>
<th>Use MID Server</th>
<th>Check this box if you want to use a MID Server to send the REST message. A MID Server might be necessary to reach an endpoint within a firewall or a subnetwork that is not visible from the instance. If this check box is selected, but no MID Server is defined in the MID Server field, the workflow automatically attempts to find a MID Server based on IP range and the REST capability.</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server</td>
<td>Name of the MID Server to use. This field is available when Use MID Server is selected. The workflow ignores this parameter if the use_midserver parameter is disabled.</td>
</tr>
</tbody>
</table>

Rest Message Script

| Sensor Script | The script to execute after the request has been made and a response has been received. You can access the full response body from the activity.output variable. |

Return Value workflow activity

The Return Value activity returns a value to a parent workflow, when run from a subflow.

This activity has no variables or conditions. For more information, see Workflows used as subflows.

Use this activity within a subflow to store data that the parent flow can access. The Return Value activity adds the data from the subflow’s value variable to the parent workflow’s scratchpad.

 Scratchpad entries

The activity uses the workflow scratchpad to read and write persistent values.
Return Value activity scratchpad entries

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>value</td>
<td>The activity writes the value from the subflow value variable to the parent scratchpad. The parent workflow activity that runs the subflow includes a Map return value to variable that defines where the parent workflow stores the returned data. This data can be scalar, a stringifiable JavaScript object, or an expression that evaluates to a stringifiable JavaScript object.</td>
</tr>
</tbody>
</table>

Related information
- Workflow scratchpad variables
- Using variables in a workflow

Run Script workflow activity
The Run Script activity runs the specified script in the scope of the workflow version.

⚠️ Note: All changes to current are automatically updated. There is no need to call `current.update()`

Input variables
Input variables determine the initial behavior of the activity.

Run Script activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script</td>
<td>Script to execute.</td>
</tr>
</tbody>
</table>

Set Values workflow activity
The Set Values activity sets values on the current record when the workflow quiesces or ends.

Input Fields
The values you enter in the following fields determine the behavior of the activity.
Set Values Activity Input Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set these values</td>
<td>From the list on the left, select the field on the current record whose value you want to set when the workflow quiesces or ends. In the user-input field to the right, select or enter the value to which you want that field set.</td>
</tr>
</tbody>
</table>

⚠️ Note: Avoid setting the same fields from different Set Value activities. The workflow only sets the value specified by the last Set Values activity run before quiescing or ending.

⚠️ Note: Using the Set Values activity to set the Approval field on a task does not cancel pending approvals. To approve a task in a workflow, use the Approval Action activity instead.

**SOAP Message legacy workflow activity**

The legacy SOAP Message activity uses SOAP messages defined in the System Web Services plugin and can call the messages using a MID Server.

This activity is deprecated in the Rome release and no longer shows up in the Workflow canvas for new workflow development. New workflows should use the Orchestration SOAP Activity templates instead.

Existing workflows using it will continue to work as designed. To edit this activity in an existing workflow, you must re-activate the activity.

**Input variables**

**SOAP Message activity input variables**

<table>
<thead>
<tr>
<th>Field</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOAP Message</td>
<td>soap_message</td>
<td>The SOAP Message defined under the System Web Services plugin's Outbound SOAP Message [sys_soap_message] table. (System Web Services &gt; Outbound &gt; SOAP Message)</td>
</tr>
<tr>
<td>SOAP Message Function</td>
<td>soap_message_function</td>
<td>The function to call that is defined in the SOAP Message. Functions are listed in the SOAP Message Functions related list in each SOAP Message record.</td>
</tr>
</tbody>
</table>
### SOAP Message activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOAP Endpoint</td>
<td>soap_endpoint</td>
<td>Endpoint to use instead of the <strong>SOAP endpoint</strong> value in the SOAP Message Function record. Leave this field blank to use the defined endpoint in the SOAP Message Function record.</td>
</tr>
</tbody>
</table>
| Variables           | variables      | Variables to substitute into the SOAP **Envelope** defined in the SOAP Message Function record. Use this format for the string:  
```
name1=value1, name2=value2, ...
```
If either the name or value contains a comma or equal sign, escape these characters with a backslash. |
| Use MID Server      | use_midserver  | Check box for using a MID Server to send the SOAP message. A MID Server might be necessary to reach an endpoint within a firewall or a sub-network that is not visible from the instance. If this check box is selected (true), but no MID Server is defined in the **MID Server** field, Workflow automatically attempts to find a MID Server. |
| MID Server          | midserver      | Name of the MID Server to use. This field appears when you select the **Use MID Server** check box. The workflow ignores this parameter if the **use_midserver** parameter is disabled. |
| Sensor Script       | sensor_script  | The script to execute after the request has been made and a response has been received. You can access the full XML response body from the **activity.output** object. |
Turnstile workflow activity

The Turnstile activity limits how many times a workflow can pass through the same point.

Use this activity to prevent infinite loops. This activity is useful alongside the Rollback To workflow activity activity.

Results

You can assign a result value using the activity.result variable from within a script field of the activity. By default, the activity script evaluates if the activity should continue to iterate or stop.

<table>
<thead>
<tr>
<th>Result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continue</td>
<td>The Allowed iterations value is greater than the number of times the workflow accessed this activity.</td>
</tr>
<tr>
<td>Cancel</td>
<td>The workflow accessed this activity more times than the Allowed iterations value.</td>
</tr>
</tbody>
</table>

Input variables

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allowed iterations</td>
<td>Number of times the workflow can pass through this activity before the turnstile ends the loop.</td>
</tr>
</tbody>
</table>

Conditions

The conditions determine which transition comes after this activity.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continue</td>
<td>If the workflow has returned to this point an amount of times less than the allowed iteration.</td>
</tr>
<tr>
<td>Cancel</td>
<td>If the workflow has returned to this point an amount of times more than the allowed iteration.</td>
</tr>
</tbody>
</table>
States
The activity state tells the workflow engine what to do with the activity.

Turnstile activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine knows to start the <code>onExecute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is triggered.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

Unlock workflow activity

The Unlock activity releases a lock that was previously placed by the Lock activity.

To release a lock, specify the same lock key that was specified in the Lock activity. If the Lock activity had a Duration specified, and that duration has already passed, the lock will already be released.

Input variables
Input variables determine the initial behavior of the activity.

Unlock activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock key</td>
<td>The Mutex key that releases the lock. This key must match the key specified by a Lock activity. For more information, see Lock activity.</td>
</tr>
</tbody>
</table>

States
The activity state tells the workflow engine what to do with the activity.
Unlock activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finished</td>
<td>The activity successfully released the lock.</td>
</tr>
</tbody>
</table>

Subflow activities in workflow
Subflow activities run and manage workflows from a parent workflow.

The Parallel Flow Launcher subflow activity is available.

Parallel Flow Launcher workflow activity
The Parallel Flow Launcher activity launches multiple subflows in parallel.

Workflows running in parallel execute simultaneously and may complete in any order. The activity can launch a single subflow or multiple subflows as needed. You can manage the input values and values returned for each subflow.

Note: The Parallel Flow Launcher activity waits until all subflows are completed before proceeding. If any subflow does not finish, the activity waits indefinitely.

Note: Do not launch a large number of subflows with the Parallel Flow Launcher activity. If overused, this activity can overburden the instance. For launching very large numbers of subflows, consider putting the Parallel Flow Launcher inside a loop controlled by a turnstile or other conditional activity and having it do batches.

Activity variables
Activity variables determine the initial behavior of the activity.

Parallel Flow Launcher activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parallel Flow Launcher configuration</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the activity.</td>
</tr>
<tr>
<td>Stage</td>
<td>The stage to display when the workflow reaches the activity.</td>
</tr>
<tr>
<td>Inputs</td>
<td>Inputs to the subflows to run. Specify an array of name: value pairs for each input defined in the workflow being launched. The name and data type of each input variable entered must</td>
</tr>
</tbody>
</table>
### Parallel Flow Launcher activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td></td>
<td>match those used by the subflow that this activity launches. For a detailed example, see Parallel Flow Launcher Example.</td>
</tr>
</tbody>
</table>

**Parallel Flow Launcher selection**

**Workflow**
The workflow to run.

**Advanced**
Check Advanced, to enter a script that uses a WorkflowCoordinator object to manage the subflows. When you check Advanced, a text box appears where you can enter a script that specifies a unique workflow for each set of input variables. See WorkflowCoordinator object for more information.

**Parallel Flow Launcher iteration**

Specify parameters to tune the performance of batched workflows.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count</td>
<td>If not specified by an input set, Count determines the number of subflows executed in parallel from this activity. If the Advanced option is not selected, ensure that this field is populated with a valid number.</td>
</tr>
<tr>
<td>Max flows</td>
<td>The maximum number of workflows this activity can launch. If this value is a positive integer, it overrides the max parameter used in the WorkflowCoordinator constructor.</td>
</tr>
<tr>
<td>Max simultaneous</td>
<td>The maximum number of parallel workflows this activity can run at one time. If this value is a positive integer, it overrides the poolsize parameter used in the WorkflowCoordinator constructor.</td>
</tr>
</tbody>
</table>

**Parallel Flow Launcher Process**

**Process flow complete**
To specify a script that runs after each subflow completes, check Process flow complete. If you check this field, a text box labelled Flow complete appears, where you can enter the script to run.

**Flow complete**
The script that runs each time a subflow finishes. This field is available when the Process flow complete option is selected. The same script functions and variables available in other workflow scripts, such as those in the Run Script activity, are available here. For more information, see Completed subflow values in scripts.
Parallel Flow Launcher activity input variables (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The variable “flow” is available to this script. It is an object that contains the following information about the flow that is finishing:</td>
<td></td>
</tr>
<tr>
<td><strong>flow.output (String)</strong>: The value that the subflow returns to the parent if it executed a Return Value activity before ending.</td>
<td></td>
</tr>
<tr>
<td><strong>flow.index (Number)</strong>: The zero-relative index of the subflow that finished.</td>
<td></td>
</tr>
<tr>
<td><strong>flow.contextId (String)</strong>: The sys_id of the workflow context for the completed subflow.</td>
<td></td>
</tr>
<tr>
<td><strong>flow.inputs (Object)</strong>: The inputs that were passed to the subflow when its context was created and started.</td>
<td></td>
</tr>
<tr>
<td><strong>flow.status (String)</strong>: The final state of the context. This corresponds to the <strong>state</strong> column in the subflow context record, which has possible values of <strong>executing</strong>, <strong>finished</strong>, <strong>cancelled</strong>, or <strong>faulted</strong>. (Since the flow is completed, it cannot be <strong>executing</strong> at this point.)</td>
<td></td>
</tr>
</tbody>
</table>

Parallel Flow Launcher Split

<table>
<thead>
<tr>
<th>Process finished</th>
<th>To specify a script that runs after all subflows have finished, check <strong>Process finished</strong>. If you check this field, a text box labelled <strong>Finished Script</strong> appears where you can enter the script to run. The ‘coordinator’ variable is made available to this script and is an object that allows access to any of the finished subflows using the <strong>getFlow(index)</strong> method. For example:</th>
</tr>
</thead>
</table>
|                                                      | for (var i = 0; i < coordinator.getNumFlows(); i++)
|                                                      | writeFlowResultsToTable( i, coordinator.getFlow(i) );                                                                                                                                                  |

<table>
<thead>
<tr>
<th>Finished script</th>
<th>The script that runs after all subflows launched by the activity are complete. You can use variables that contain completed flow information in this script. The ‘coordinator’ variable is made available to this script and is an object that allows access to any of the finished subflows using the <strong>getFlow(index)</strong> method. For example:</th>
</tr>
</thead>
</table>
|                                                      | for (var i = 0; i < coordinator.getNumFlows(); i++)
|                                                      | writeFlowResultsToTable( i, coordinator.getFlow(i) );                                                                                                                                                  |
| This field is available when **Process finished** is selected. |------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------|
States

The activity state tells the workflow engine what to do with the activity. To view an activity’s state, point to the activity. A pop-up window shows the State and Result of the activity. If the activity is in an error state, the pop-up window provides a brief Fault Description.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waiting</td>
<td>The activity is waiting for all subflows to finish. All subflows have started and some may have finished.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity successfully completed all of the subflows.</td>
</tr>
<tr>
<td>Error</td>
<td>The activity encountered an error.</td>
</tr>
</tbody>
</table>

WorkflowCoordinator object

A WorkflowCoordinator object specifies which subflows to run and the input variables to pass to those subflows.

When using a WorkflowCoordinator object, you can create a Parallel Flow Launcher activity that launches multiple subflows. When using the activity without a WorkflowCoordinator object, you can only launch a single subflow multiple times. Use one of the following methods to specify a WorkflowCoordinator object for the activity when the Advanced activity input variable is selected.

- Reference a workflow scratchpad variable that contains an existing WorkflowCoordinator object. To save a WorkflowCoordinator object to the scratchpad, call the save(variableName) function on the WorkflowCoordinator object. You can reference the object using the value passed in the variableName parameter. For example, you can create a WorkflowCoordinator object in a Run Script activity, save the object using <object>.save('coord'), and then call this object by entering coord in the Workflow activity variable of a subsequent Parallel Flow Launcher activity.

- Define the WorkflowCoordinator within the Workflow activity variable. Add the javascript: identifier at the beginning of the script. The Parallel Flow Launcher example shows how to use a WorkflowCoordinator object in this way.

- Create a factory class to define the WorkflowCoordinator object. The system does not provide a factory class for WorkflowCoordinator by default.
Completed subflow values in scripts

The **Parallel Flow Launcher** activity exposes additional variables you can use in scripts.

### Additional variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>coordinator</td>
<td>The WorkflowCoordinator used when running the subflows. You can use this variable in the <strong>Finished script</strong> to perform any final operations. Additionally, you can use the WorkflowCoordinator in a later workflow activity by passing the activity name or sys_id to the <code>WorkflowCoordinator.load('&lt;Activity&gt;')</code> function. For example, to load the WorkflowCoordinator object from a <strong>Parallel Flow Launcher</strong> activity called <strong>Launch Subflows</strong>, enter <code>var coord = WorkflowCoordinator.load('Launch Subflows');</code> in a later activity.</td>
</tr>
<tr>
<td>flow</td>
<td>The subflow launched by the activity that completed most recently. You can use this variable in the <strong>Flow complete script</strong> to perform any post-processing operations on each subflow. To get a complete subflow from a coordinator object, use <code>var flow = coord.getFlow(I);</code> where <code>I</code> is the numeric index of the subflow based on the order it was launched. These values are available from the completed subflow:</td>
</tr>
<tr>
<td></td>
<td>• <strong>index</strong>: the numerical index of this subflow based on the order it was launched</td>
</tr>
<tr>
<td></td>
<td>• <strong>workflow</strong>: the sys_id or name, depending on which you passed to the WorkflowCoordinator constructor, of the workflow used for this subflow</td>
</tr>
<tr>
<td></td>
<td>• <strong>inputs</strong>: any input values provided to the launched subflow</td>
</tr>
<tr>
<td></td>
<td>• <strong>status</strong>: status of the subflow context</td>
</tr>
<tr>
<td></td>
<td>• <strong>output</strong>: the value returned by the subflow</td>
</tr>
<tr>
<td></td>
<td>• <strong>contextId</strong>: the sys_id of the workflow context for the subflow</td>
</tr>
</tbody>
</table>

**Parallel Flow Launcher example**

This example shows how to use the **Parallel Flow Launcher** activity with an array of input values and with a WorkflowCoordinator object.
Sample workflow

This example shows a SQL-based web server with four application nodes. A single subflow runs to provision the database, and multiple parallel subflows each configure an application node. Finally, a separate set of parallel subflows configures the nodes to use a load balancer and sets up the server DNS.

Provision the application nodes

The first Parallel Flow Launcher activity launches the Provision Node subflow four times. The activity passes a unique IP address to each subflow from an array in the Inputs variable. The scripts defined in the Flow complete and Finished script variables write log messages regarding the status of the subflows.
Add nodes to the load balancer
The second Parallel Flow Launcher activity uses WorkflowCoordinator objects to specify which subflows to run. The coordinator variable stores the completed flow information from the previous Provision Nodes activity. The script then retrieves the IP address and port for each node that was provisioned. The coord2 WorkflowCoordinator object runs the Add Node to Load Balancer subflow once for each node, using the retrieved IP address and port information as input variables. Finally, the coord2 WorkflowCoordinator object runs the SetupDNS subflow once to configure the load balancer.
Specifying which subflows to run

```javascript
var coordinator = WorkflowCoordinator.load("Provision Nodes");
var coord2 = new WorkflowCoordinator(
  workflow: 'Add Node to Load Balancer'
);
for (var i = 0; i < coordinator.getNumFlows(); i++) {
  var ip = coordinator.getInput(i).ip;
  var port = coordinator.getInput(i).port;
  coord2.add({
    ip: ip,
    port: port
  });
}
var loadBalancerIP = '10.0.20.10';
coord2.add({
  ip: loadBalancerIP,
  hostname: 'www.snow1.net',
  'SetupDNS':
  coord2;
}
```

**Workflows used as subflows**

A workflow can launch another workflow as an activity.

The parent workflow triggers the subflow and then waits for the subflow to complete before continuing. Run the workflow validation tool prior to publishing to detect missing subflows and other dependency problems, such as those involving update sets.

The **Workflows** tab in the Workflow Editor contains a list of the workflows available for use as subflows.

Make sure that the selected subflow is active. If the subflow is inactive, the main workflow will hang with a **Loading** message. If you place an inactive subflow into
a workflow, the subflow appears with a red banner, indicating that it cannot run. An active subflow is highlighted in blue when selected.

Subflows and the Create Task activity

If a workflow contains a Create Task activity that has executed on the current record, additional task activities in the workflow might not execute as expected. This can happen when the same subflow containing a Create Task activity runs more than once in a parent flow. When the subflow reruns and attempts to execute the Create Task activity again, the system reopens the first task activity instead and does not create an additional task.

Note: An alternative to creating duplicate subflows that use the Create Task activity is to add a Run Script activity to the workflow that creates a task with a script.
The same create task activity runs twice in a workflow

In this configuration, the workflow does not run the same subflow containing a **Create Task** activity more than once. This allows the workflow to create additional tasks.

**Running different subflows containing the Create Task activity**

**View workflow activity descriptions**

Tooltips are available for workflow activities to help you understand how to use each activity.
About this task

Procedure

1. To view an activity description in the Workflow Editor, point to the icon for the activity in the palette.

2. To modify activity descriptions, navigate to Workflow > Administration > Activity Definitions and edit the Description field.

   Note: To view more information about an activity, double-click the activity on the canvas and then click the help icon in the title bar of the Activity Properties window.

Elements in workflow activity definitions

Each activity can specify a number of elements that control the behavior of the activity or are controlled by the activity.
Not all activities specify all possible elements. See Workflow activities for links to the activities provided by default. Each activity description includes a detailed explanation of the specific elements offered by that activity.

### Workflow activity elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Results</td>
<td>The possible <code>activity.results</code> value. The activity result usually determines which condition the activity transitions through.</td>
</tr>
<tr>
<td>Scratchpad entries</td>
<td>Scratchpad variables the activity depends on to run, or variables the activity writes to the scratchpad.</td>
</tr>
<tr>
<td>Input variables</td>
<td>Values that control the behavior of the activity. Fields to set these values appear on the Activity Properties form when a new activity is added to a workflow. See Activity variables for more information.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Determines which transition the activity follows after completing. See Manage workflow activity conditions for more information.</td>
</tr>
<tr>
<td>States</td>
<td>Determines how the workflow handles the record being executed.</td>
</tr>
</tbody>
</table>

### Add an activity to a workflow

Available activities are displayed in the Core, Packs, and Custom tabs in the Workflow Editor palette.

**Procedure**

1. In the Workflow Editor, check out a workflow.

2. To add a workflow activity, drag it from the Core, Packs, or Custom tab to the canvas and drop it on a transition line in the workflow body.

   The transition turns blue when it is connected to the new activity. The designer adds the activity to the flow at that point and displays the property form for the new activity.

   If an activity is greyed out, approval engines are enabled for the table on which the workflow runs. To use the activity, turn approval engines off for the table.
3. Create any additional conditions needed for the activity and ensure that all exits are connected.

4. Run the workflow validation tool prior to publishing to detect missing or disconnected transitions that can cause a workflow to hang.
Note: All activity descriptions have a **Table** value. If this value is **Global**, the activity is available for use with any workflow regardless of the table selected in the workflow properties. Activities that identify a specific table appear in the palette only if the table configured for the workflow matches or extends the table identified in the activity.

### Adding an activity to a workflow

![Workflow Diagram]

Duplicate a workflow activity

You can duplicate an activity used in a workflow, including all the configured properties.

**Procedure**

1. Right-click the activity and select **Copy Activity** from the context menu.
   
   The system automatically duplicates the activity, but does not create transitions.
2. Double-click the copy and configure the properties appropriately.
3. Drag the activity to a location in the workflow.
4. Add transitions.

Manage transitions between workflow activities

Transitions define the processing path of the workflow, depending on conditions defined in each activity.
About this task
All conditions in an activity must have a transition and all transitions must have a connection to another activity or to the End activity.

Note:
Run the workflow validation tool prior to publishing to detect missing or disconnected transitions that could cause a workflow to hang.

Procedure
1. Add transitions to the workflow using either of these methods:
   - Drag and drop an activity directly onto a transition line to connect it to the adjacent activities. The transition line turns blue when the connection is made. The system updates the transitions automatically to reflect the new sequence.
   - Drag the activity to an open area in the canvas and create the transitions manually. Click the yellow square on the right side of the activity condition and drag a connector to the next task.
2. You can draw multiple transitions from the same activity condition if the activity executes concurrently.

3. To remove a transition, click to highlight it, and then press **Delete**.

**Custom activity transitions**

Controls on the **Approval - User** activity enable an administrator to add additional workflow transitions to the activity other than the default transitions of **Approved** or **Rejected**.

Transitions defined using this method do not become a permanent feature of the **Approval - User** activity. After a new transition is configured, that transition must be applied manually to subsequent instances of the activity, where desired.

**Manage workflow activity conditions**

Activities contain default conditions that determine which transitions are followed.

**About this task**

For example, the **Approval - User** activity has two conditions, **Approved** and **Rejected**.
Example of activity conditions

You can use a JavaScript condition check to create custom conditions on Core workflow activities. (Custom activities do not support this feature.)

**Procedure**

1. Right-click the activity and select **Add Condition** from the context menu.
2. In the New Workflow Condition dialog box, fill in the fields as appropriate (see table).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The label that is displayed on the workflow.</td>
</tr>
<tr>
<td>Activity</td>
<td>Name of the activity for which this condition is submitted. This value is populated automatically by the system.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of this condition.</td>
</tr>
<tr>
<td>Condition</td>
<td>A JavaScript condition check. The following variables are available:</td>
</tr>
<tr>
<td></td>
<td>• <strong>current</strong>: Current record that the workflow is running against.</td>
</tr>
<tr>
<td></td>
<td>• <strong>activity.result</strong>: Result value set by the activity upon completion.</td>
</tr>
<tr>
<td></td>
<td>• <strong>activity</strong>: Workflow Executing Activity (wf_executing) record. Used for advanced condition checks.</td>
</tr>
<tr>
<td></td>
<td>• <strong>activity.vars</strong>: Variables associated with the Workflow Executing Activity record. Used for advanced condition checks.</td>
</tr>
<tr>
<td>Skip during generate</td>
<td>If selected, the <strong>Generate activity</strong> does not follow this transition to generate approvals or tasks.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
4. To change the order in which conditions appear on the workflow activity, right-click the activity and select **Reorder Conditions**.
A dialog box appears, with a list of the available conditions.

5. Drag the conditions to a new position in the list.

6. Click **OK**.

**Activity result value**

The *result* value specified by an activity controls the condition through which the activity transitions.

Use the *result* value as part of the *Condition* field in the activity. For example, if the *Condition* field of an *Approval - User* activity contains `activity.result == 'rejected'`, the activity transitions through that condition when a rejection is received from the approver. Result values are set in the *Script* field of the activity definition.

**Edit the workflow activity properties form**

Customize which workflow variables appear on an activity properties form and how the variables are arranged on the form.

**Procedure**

1. Navigate to **Workflow > Administration > Activity Definitions**.
2. Scroll to the activity that you want to work with and click the activity name.
3. On the Workflow Activity Definition form, click the **Edit Variables Layout** related link.
4. On the Form Design page for the Activity Properties form, add and remove activity variables. The activity variables appear as separate items that you can rearrange on the form.

For more details on using the form design interface, see .

**Using workflow approval activities and rolling back workflows**

When you work with approvals, you need to understand how approval activities interact with approval engines, how to correct a skipped approval workflow activity, and how rollbacks work.

**Approval workflow activities and approval engines**

Approvals can be managed by approval activities or approval engines, but not both. Approval activities can be used if approval engines are not turned on for the table associated with the workflow.

Approvals can be managed by approval activities or approval engines, but not both. Trying to use both can cause a range of issues. Approval activites are not available (greyed out) in the palette if approval engines are used on the specified table. If you hover over a greyed out approval activity in the palette, a comment with more information is provided. For more information about approvals and approval engines, see Approvals.

**Unavailable approval activities**

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
## Correct a skipped workflow approval activity

While a workflow is in an active context, an approval activity can skip to the next activity.

### About this task

An approval activity might skip for the following reasons:

- The approval user or group is missing or invalid (for example, sys_id).
- The approval user or group became inactive after the approval record was created.
- The activity is a dot-walked field, such as "current.opened_by.department.manager", and it has a missing or invalid approval user or group.
- The business rule on the table that is associated with the workflow is invalid.

### To correct a missed approval activity:

1. Identify the approval activity that missed.
2. Determine why the approval activity missed.
3. Adjust the workflow configuration or data to correct the approval.

---

**Turn off approval engines**

Select the Approval Engine to be used for each of the Task tables. The valid options are:

- Approval Rules - Use Approval Rules to create approvals
- Process Guides - Use Process Guides to create approvals
- Turn engines off - Turn the approval engines off for this table (use this when Workflow is being used to manage approvals)

<table>
<thead>
<tr>
<th>Table</th>
<th>Name</th>
<th>Approval Engine</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Phase</td>
<td>change_phase</td>
<td>Turn engines off</td>
</tr>
<tr>
<td>Change Request</td>
<td>change_request</td>
<td>Turn engines off</td>
</tr>
<tr>
<td>KB</td>
<td>kb_request</td>
<td>Turn engines off</td>
</tr>
<tr>
<td>Request</td>
<td>request</td>
<td>Turn engines off</td>
</tr>
<tr>
<td>Task</td>
<td>task</td>
<td>Turn engines off</td>
</tr>
<tr>
<td>Ticket</td>
<td>ticket</td>
<td>Turn engines off</td>
</tr>
<tr>
<td>Private Task</td>
<td>private_task</td>
<td>Turn engines off</td>
</tr>
</tbody>
</table>

**Related reference**

Approvals

**Related information**

Approval and rollback workflow activities

---

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Procedure

1. Navigate to Workflow > Live Workflows > All Contexts.
2. Click the date and time in the Started column for the workflow that is incorrectly processing approval activities.
3. In Related Links, click Show Workflow.
4. Review the portion of the workflow that executed, and then do one or more of the following:
   - Verify that after approval, the workflow progressed to the next activity. If a workflow failed to progress, check the business rules. For more information, see .
   - Point to each processed approval activity to find activities where the State is Finished and Result is Skipped.
5. Navigate to Workflow > Workflow Editor and open the workflow.
6. Double-click the skipped approval activity.
7. Click Users or Groups.
8. Assign an active user or group for the approval activity. For more information, see Workflow error handling.

Rollback To activity

When conditions in a workflow trigger a Rollback To activity, the workflow moves processing backward to a specified activity in the workflow and resets certain activities that have already executed back to their original state. This is useful when handling an unexpected failure or as part of a programmed logical flow.

When an activity is reset during a workflow rollback, the following happens:

- Approvals are reset to Not Requested.
- Tasks are reset to either Open or Pending. A rollback workflow path cannot create new tasks.

Activities that perform external system operations, such as deleting a file or sending an email, are not rolled back. Only approval and task activity states are reset.

A workflow can contain a single rollback, multiple rollbacks, or nested rollbacks in more complex workflows. The Rollback To activity resets activities based on the actual workflow sequence (transition line attachments) of activities between itself and the transitioned to activity, rather than using the execution order to determine where processing should restart.
**Rollback To behavior**

The **Rollback To** activity transitions directly to the activity specified by the transition line arrow.

Use the **Rollback To** activity for all workflows that use multiple or nested rollbacks. **Rollback To** resets the targeted task (the direct transition) to **Open**. All tasks that have executed between the **Rollback To** activity and the targeted task (rolled back task) are set to **Pending**.

(0) Begin
(1) Log Message
(2) Task 1
(3) Task 3
(4) Task 2
(5) Timer
(6) Approval 1
(7) Roll back to first task
(8) Task 1
(9) Task 2
(10) Approval 1
(11) Log approval
(12) Join
(14) Send email
(15) End

**Rollback to workflow**
Transition history

The state of (3) Task 3 does not change, since this activity does not directly transition from the rollback target activity. To see what activities were rolled back, select the Workflow Transition History related list and look at the Rolled back column.

The Rollback To activity (7) updates the following activities:

(8) Task 1: reset to Open
(9) Task 2: reset to Pending
(10) Approval 1: reset to Not Yet Requested

Using variables in Notify workflow activities

Certain Notify workflow activities support variable substitution for reading text to callers.

Certain Notify workflow activities allow you to use variables, such as those from the workflow scratchpad, to determine the activity behavior. Each activity supports a maximum of 20 variables. The following activities allow variable substitution:

<table>
<thead>
<tr>
<th>Activity</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Say</td>
<td>Supports variable substitution in the Text field only.</td>
</tr>
<tr>
<td>Input</td>
<td>Supports variable substitution in the Text field only.</td>
</tr>
<tr>
<td>Play</td>
<td>Supports variable substitution in the URL field only.</td>
</tr>
</tbody>
</table>
(continued)

<table>
<thead>
<tr>
<th>Activity</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forward call</td>
<td>Supports variable substitution in the <strong>Phone number</strong> field only.</td>
</tr>
</tbody>
</table>

**Scratchpad variables**

You can call variables from the workflow scratchpad or the activity scratchpad using the syntax `${variable_name}`. You do not need to include either workflow.scratchpad or activity.scratchpad before the variable name. For example, to use the variable `activity.scratchpad.langCode = ‘en-US’`, call `${langCode}` within the activity. If the scratchpad does not contain the specified variable, the variable evaluates to an empty value.

You can get values from objects on the scratchpad using the format `${object.value}`. For example, you can get the name of a user object, such as `workflow.scratchpad.user = {name:’john.smith’}` by calling `${user.name}`.

**The digit variable**

The **Input** activity exposes the `${digit}` variable. Use this variable in each condition presented by the activity. The number read to the user is determined automatically by each condition. The caller can press that number to cause the activity to transition through that condition.

**Use multiple timer activities in one workflow**

Workflow timer activities store data independently of each other in an activity-specific scratchpad.

Previously, all timer activities in a workflow accessed a single, shared scratchpad, which could lead to conflicts when adding multiple timer activities to one workflow.

Timer scratchpads entries hold these values:

- `workflow.scratchpad.endTime`
- `workflow.scratchpad.realStartTime`
- `workflow.scratchpad.retroactiveSecsLeft`

**Related information**

Timer workflow activities
Publish a custom workflow activity

When a user creates a custom activity and saves or submits it, that activity appears in the Custom and Packs tabs of the designer palette, but is only visible to the user who created it.

When configuration is complete, the user clicks Publish, which makes the activity accessible to other users on the instance with the workflow_admin or activity_creator role. Published activities are available for upload to the ServiceNow Store, can be added to workflows, and can be edited by any user with the proper roles.

To edit a published activity, click Checkout. When an activity is checked out by a user, only that user can modify it. The fields of a checked out activity are read-only for all other users. When the checked out activity has been modified successfully, the user publishes it again. The system adds a new version of this activity to the Custom tab in the Workflow Editor palette.

⚠️ Note: Activities you create and publish are only visible in the Packs tab if they were created in the current application scope.

Locked versions

Problems can arise if an activity version is checked out by a user and not checked back in, for example, when the user is sick or leaves the company. An activity in this state cannot be checked out for update.

A user with the admin role can return a locked activity to a published state. The administrator opens the locked activity from the Custom tab of the Workflow Editor, selects the checked-out version, and selects Force Checkout, and then Publish.

Workflow activity pinning

Workflow administrators can pin a custom activity to prevent the system from automatically updating that activity when a new version is downloaded from the ServiceNow Store.

You can pin or unpin individual activities or set pinning within workflow properties that controls the versions used for all the activities in that workflow. This can result in two workflows using different versions of the same activity.

⚠️ Note: Activity pinning and unpinning applies to the custom activities downloaded from the ServiceNow Store only, and does not apply to newly published activity definitions made locally on your instance. To make use of these locally updated custom activities, you must check out your workflow and manually add the activities.
Index

A
Access Service Catalog
categories in Service Portal
6581
accessibility
visual task boards
7383
account
Twilio
associating
4382
Action Designer
getting started
2188
activate Service Portal
6726
activate Service Portal user
criteria
7059, 7060
Active Directory
Orchestration activity pack
5365
Orchestration example
5358
activities
Active Directory activity
pack
5365
activity packs
requesting activation of
5283
Add F5 Pool Member
5417
Add F5 Profile to Virtual
Server
5421
Add F5 Virtual Server
5424
Add User to Group
5367
Add User to Group Azure
AD
5382
Assign User License
5384
Azure AD
5382
Change AD User Password
5368
Change Service State
5473
Check F5 Pool
5420
Copy File
5500
Create AD Object
5369
Create Directory
5502
Create User
5385
Delete F5 Pool
5427
Delete F5 Pool Member
5425
Delete F5 Virtual Server
5419
Delete User
5388
Disable AD User Account
5371
Enable AD User Account
5372
F5 load balancer
5416
File Copy
5514
File Read
5511
Files Compare
5510
Get F5 Pool Member
  5418
Get File List
  5503
Get User Info
  5389
Global activities
  5518
Infoblox DDI
  5429
Install Windows App
  5471
Is AD Account Locked
  5373
Join Domain
  5470
Modify F5 Virtual Server
  5423
PowerShell activity pack
  5456
PowerShell HResult codes
  5294
Probe activity pack
  5477
Query AD
  5374
Remove AD Object
  5376, 5428
Remove File or Directory
  5504
Remove User from Group
  5377, 5391
Remove User License
  5392
Rename File or Directory
  5506
Reset AD User Password
  5378
Reset User Password
  5393
Restart Windows Server
  5475
Secure Copy
  5509
Set File Attributes
  5507
SFTP File Transfer
  5495
SSH activity pack
  5508
Uninstall Windows App
  5476
Unlock AD Account
  5380
Update AD Object
  5381
activity designer
activity packs
  5364
activity scoping
  5635
auto-mapping JDBC output variables
  5542, 5561
auto-mapping REST output variables
  5596
auto-mapping SOAP output variables
  5571
copying activities
  5637
creating custom activities
  5528
introduction to
  5520
JavaScript probe activity, creating
  5580
JavaScript Probe execution command
  5584
JavaScript probe execution parameter
  5582
JavaScript probe template post-processing parameters
  5583
JDBC activity, creating
  5556
JDBC connections 1544, 5559
JMS activity system setup 1548, 5631
JMS activity, creating 5629
JMS execution parameters 5633
JMS template post-processing parameters 5634
mapping output variables 5545
output variables 5543
parsing rules example 5551
parsing rules, creating 5546
parsing sources 5549
PowerShell 5457
PowerShell activity, creating 5586
Powershell execution command 5535
Powershell execution parameters 5588
Powershell template post-processing parameters 5590
Pre-processing fields 5540
Probe activity, creating 5617
Probe execution command 5620
Probe execution parameter 5618
Probe template post-processing parameters 5620
REST activity, creating 5592
REST execution command 5600
REST execution parameters 5597
REST execution parameters, JavaScript array in 5598
REST template post-processing parameters 5599
reusing data 5639
run script activity, creating 5628
Run Script processing script 5628
SFTP activity, creating 5603
SFTP execution command 5613
SFTP template post-processing parameters 5612
SOAP activity, creating 5567
SOAP execution command 5574
SOAP execution parameters 5577
SOAP execution parameters, JavaScript array in 5579
SOAP input variables 5532
SOAP template post-processing parameters 5580
SSH activity, creating 5621
SSH execution command 5626
SSH execution parameters
5624
SSH template post-processing parameters
5625
Template conditions
5554
Template outputs
5545
Template post-processing fields
5541
templates
5555
testing input fields
5537
testing JDBC input fields
5565
variables, mapping
5534
Adapters
2478
add
actions
chat window menu
4362
Add a catalog item to the shopping cart
6583
add a service to a group
1133
Add an item to the wish list in Service Portal
6582
add attachment
539
add blank line
email template
4982
add CI
1123
add variable to catalog
6458
admin configuration
142
administering
context
workflow
7529
Legacy Notify
4381
workflow context
7529
Administration
service catalog
6480, 6503
AES 128
configure
1806
encryption key
1806
AES 256
configure
1808
encryption key
1808
Agent Assist
knowledge
594
Service Catalog
596
agent workspace
lists
196
Agent Workspace
104
Agent Assist
552
form header
251
list filters
198
lists
192, 526
supported field types
230
Agent Workspace configuration
142
allocate users
to subscriptions
7160
Allow IP Addresses
1882
Amazon EC2
instance
5937, 5937, 5939
Amazon Web Services
external credential storage
configure AWS credentials
on a CyberArk vault
1618
configure the credential
identifier for AWS
1628
Angular directives
6987
Angular providers
6987
Announcement display style
7049
announcement type
7050
API
MID Server encryption
4685
application service
history
1143, 1149
approval
types
changing
6664
defining
6662
expiring
6664
publishing
6663
Approval Action
Input Variables
7577
Results
7577
States
approval summarizer
changing
formatter example
new custom, create
Approval User
Conditions
Input Variables
Results
States
approvals
delegate
generate
using approval rules
using approvers related list
using workflows
status
arrange services in groups
assessable record
delete
delete stakeholder
assessable records
generate
manage
automatically
Assessable Records
assessment
take
assessment groups
assessment metric
assessable record
manage
category
delete
assessment metrics
creating
data types
metric definitions, creating
metric templates
metric templates, creating
metric values, updating
Assessment notification
workflow
assessment properties
assessment questionnaires
assessment trigger condition
creating
example
assessments
5947
categories, create
5989
category users
6023
category users, creating
6024
change the order of an
answer
6002
clean up data
6040
create metrics
6003
create quizzes with forms
6089
creating quizzes with forms
6073, 6090, 6091, 6099
customize appearance
6232, 7239
export
6011
generate
5985
generate assessable
records
6003
generate on-demand
assessments
6033
generate with on-demand
API
6035
import
6012
installed components
5947
instances
6040
metric categories
5988
notifications
6048
on-demand assessments
6032
on-demand for multiple
assessable records
6034
on-demand for one
assessable record
6034
process
5973
publish metric types
6038
results
6052, 6055
schedule types
6037
scheduled
configure for
6037
generate manually
6039
vendor type, generating
6039
scheduled assessments
6036, 6038
signatures
6013
stakeholders
6023
stakeholders, creating
6025
view instances
6041
assessments overview
reports
6053
roles
6053
assessments overview module
6053
Associate Service Portal with a
catalog
6767
associating
account
Twilio
Baseline
creating
1011
differences
Calculator widget
6833
call
conference
viewing
4379
canceling
workflow
7532
Capacity subscriptions
7149
catalog
6458
item
designer
6658
Catalog
configure navigation
6515
configure search
6515
home page
managing
6515
homepage
managing
6530, 6541
Catalog Content widget
6898
catalog item
6458
copy
6378
diagnostic
6381
catalog item designer
administering
6658
business rules
6696
client scripts
6694
email notifications
6699
script includes
6691
Catalog Item Designer
create an item
6671
create new item version
6682
define an item approval
6676
define an item question
6672
define an item section
6679
define an item task
6677
expired item
6682
installed components
tables
6682
manage a category
6670
publish an item
6680
republish an item
6681
request a category
6668
UI policies
6685
unpublish an item
6681
catalog items
add
6379, 6379
adding ordered item links
6386
additional catalogs
6379
additional categories
6379
configure cart layout
6488
defining
check out a document
1697
checklists
using with visual task boards
7368
configuring checklists
7372
creating new checklists
7370
deleting checklists
7371
choice
Legacy Notify
creating
4376
response
4376
CI
config files
1141
configuration files
1141
proposed changes
1014
add
1015
displaying
1014
Service Mapping
attributes
1141
name labels
1141
properties
1141
CI class
reclassify
1049
CI relation rollups
create
1042
CI relations formatter
1033
CI relationship builder
1040
CI relationship editor
1035
CI relationships
1021, 1022
security
1042
CI type
create
1046
client scripts
catalog item designer
6694
client software distribution
(CSD)
activating
5320
configuration
retrieving SCCM data for
5338
SCCM server Discovery
5340
configuring providers
5354
creating catalog items for
SCCM applications
5344
creating software models
for SCCM
3870, 5341
dashboard
3880, 5351
deploying software from
SCCM
5333
extension keys
5356
extension points
3882, 5353, 5356
installed components
5322
introduction
lease extensions
licenses and counters for ordering software from the service catalog
plugins installed with properties for providing Windows credentials for SCCM revoking software not installed by SCCM roles installed with SCCM configuration SCCM deployment workflow SCCM software revocation workflow script includes installed with tables installed with validating software installations workflows installed with cloning issues

Cloud Call Center for ITSM Integrating Cloud Call Center with ITSM cloud management credentials for CMDB Extended CMDB Classifications CMS gauge on a page, putting what happens on a click, controlling CMS gauge support CMS to Service Portal transition CMS translation viewing color codes Subscription Management com.glide.service-portal.user-criteria Common Information Model (CIM) credentials for communication channels communication contact definition
communication management 7308
communication plan definition create 7315
communication task definition 7317
compare application service versions 1149
compare business service versions 1149
condition parameters 1750
condition activities 7606
if 7606 switch 7608
wait for condition 7610
wait for WF event 7612
Condition script 4529
conference call viewing 4379
configuration CMBD 748 CMDB 1044
Related Lists of CI components 1045
Configuration Business service 1120
configuration files track changes 1143, 1149
Configuration Management CI forms 1351 related lists 1351
Configure variable default width 6433
Configure a sentiment connector 6286, 7293
configure access to maps 1135
configure access to services 1135
Configure an assessment 5982
configure user access to services 1135
configuring endpoints Twilio 4384
Legacy notify Twilio 4381
Twilio endpoints 4384
Legacy notify 4381
configuring email alternate POP3 4849
SMTP 4847
SMTP and POP3
4852
connect
administering
1384
audio notifications
customizing
1389
chat mini windows
drag files
1382
customizing
connect actions
1390
customizing
connect interface
1369
customizing
connect overlay
1369
disabling
1388
customizing
connect sidebar
1370
customizing
connect workspace
1373
conversation pane
1374
conversation tools
1375, 7375
installed components
properties
1361
mentioning users
1383
mini windows
1372
mini windows
notifications
1376, 1379
polling interval
1388
properties
1384
record conversations
disabling for all tables
1403
disabling for specific
tables
1403

supported browsers
1359
uploading a profile picture
1381
visual task boards
sharing
1382, 1400, 7381, 7382
Connect
1358
Connect administration
disable top-level domains
1395
connect chat
1396
administering
1401
customizing
connect workspace
adding and removing
conversation members
1399
editing conversation
details
1399
conversation members
adding and removing
1399
email notification interval
1401
following a record
1397
record conversations
1397
enabling
1401
starting conversations
1396
using
1396
Connect chat
browser notifications
1378
disable
1404
Connect Chat
activate
n
Connect Support
add users to support conversations
1425
administration
1425
chat states
1413
Connect Support and Service Portal
1426
Connect Support migration
1415
Connect Support Service Portal
1426
Connect Support Service Portal widget instance options
1427
consumer replication set
2468
contact responsibilities
7325
containment service rule metadata
1250
content blocks
create header block
1463
dynamic block
1480
static html block
1484
types
1463
Content Blocks
add an image
1485
catalog cart block
1481
CMS block tag
1461
configure
1460
content management
1360
record cards
1392
Connect chat notifications browser support
1378
Connect record card
1392
connect support
1405
activating
1364
additional plugins
1367
administering
1415
administering queues
1419
creating an incident from a conversation
1411
dashboards for
1422, 1424
escalating a conversation
1411
homepage for
1422, 1423
installed components properties
1365
making a queue accessible to end users
1421
metrics for
1422, 1423
monitoring incoming conversations
1405
sharing knowledge
1407
transferring a conversation
1408
Connect Support
add users to conversation
1410
detailed content block
Flash movie block
iFrame
Live Feed
static html block
content items
adding
service catalog
content management
corporate style guide
design
organize content
prepare data
prototypes
rapid web design
team members
Content Management
Apache Jelly engine
base template
configure a new site
configure list definitions
configure menu items
content block types
content blocks
catalog card block
detailed content blocks
dynamic blocks
Flash movie block
header block
iframe
static HTML block
content links
content pages
content site
content types
Content Types
copy a page to create a template
copy a site
create a navigation menu block
create menu sections
customize the menu style
DIV-based layouts
element link examples
frame
global search
integration points
1507
integration points example
1513
Jelly
Examples
1497
list block
1482
login rules
1444
menu types
1470
navigation
1436
navigation menu example
1479
security
1444, 1445, 1450, 1501
set up site
1439
single sign on
1445
source view
1509
style
1499
design themes
1500
frame
1502, 1502
frame UI macro
1503
themes
1500
style sheets
1499
testing
1515
translation
1516
URLs
1444
Content Management
integration points
example
1477
static methods
1510
Content Management
Integration Points
1508
dynamic methods
1512
iFrame method examples
1491
manage system content
1436
Content Management meta
tags
1503
hierarchy
1506
page level
1504
site level
1504
content management system
1429
Content Management
templates
1451
content pages
1445
add content
1447
application
1449
assign to a site
1449
copy
1449
create
1445
Content Types
configure
1456
Content Types
1455
view
context
workflows
administering
7529
contextual search
Service Portal
7034
conversation
Legacy notify
viewing
4378
copy
catalog item
6378
Copy a quiz
6321
Copy a survey
6230, 7237
Copy an assessment
6020
create
6355
bubble charts
6056
communication plan
7315
communication plan
definition
7315
interaction
3889
Create a catalog request
from another flow
6643
create a widget
6954
Create a widget
6975, 6976, 6978, 6980, 6983, 6987
create rules
item variable assignment
6364
create variable set
6455
creating
Legacy Notify
choice
4376
question
4375
response
4376
creating quizzes with forms
available data types
6073
modify a published quiz
6099
select a user for a category
6091
set up a category
6090
credential alias for
Orchestration activities
1561
credential issues after cloning
4735
credential tagging
5464
credentials
affinity
1601
applicative credentials
1566
basic authentication
1568
checking IP service affinity
1630
CIM
1570
cloud management
1572
creating
1561
CyberArk integration
1608
collection tasks
1612
CyberArk storage
data archiving
activate push retention
plugin
email archiving
email messages
manually archive push notifications
push notification retention
data certification
activating
certification audit definition
certification audit instances
certification element
certification instances
certification schedules
certification tasks
Data Certification
installed
perform data certification
1660, 1660, 1662, 1662, 1664, 1664, 1665, 1666, 1666, 1667, 1668, 1668, 1669, 1670, 1670, 1670, 1671, 1671, 1671
data certification overview module
using
data driven board tasks
data encryption
Orchestration activities
data fetch script
7019, 7020, 7024
data table from URL definition
widget
data types
survey questions
6216, 6249, 7223, 7256
datibus
5638, 5639
Debug MetricBase
4538
Debug performance
diagnostics of a catalog item
6394
decision matrix
creating
6118
decision matrixes
administering
6122
Default variable editor
service catalog
6445
define
communication contact
7321
communication task
7317
contact responsibilities
7325
plan type
7323
recipient list
7322
responsibilities
7325
task type
7324
define access to services
1135
define user access to services
1135
defining
approval
types
6662
on-cancel
script
7534
question
types
6659
script
on-cancel
7534
task assignment
types
6664
delete
assessable record
6017, 6128
Delivery forms
6499, 6500, 6501, 6502
demand management
assessment category
creating
5987
Dependency Views
menus
1727
Dependent identification rule
1191
designer
catalog
item
6658
develop widgets in the
Service Portal
6945
Devices
mobile
6535
Discovery
credentials for
1523, 1552, 5523
activating external
storage
1606
affinity
1601
applicative credentials
1566
basic authentication
1568
checking IP service
affinity
1630
CIM
1570
configuring external
storage
1620
configuring identifier of
1625
creating
1561
CyberArk integration
1608
external storage
1603
importing a JAR file for
resolution of
1624
JDBC
1578
JMS
1579
NetApp storage devices
1571
SAP JCo
1582
SNMP
1583
SNMP community
1584
SNMPv3
1585
SSH
1588
VMware
Windows

domain separation setup
4643
long running commands
with sudo
4830
document feeds
configure
4415
calculate security
4415
disable
4416
installed components
4416
live feed UI action
4414
document publication
approval
1709
draft review
1711, 1714
electronic signature
1712
publish
1713
Document viewer
view attachments
1688
Document Viewer
1684
Document Viewer disable
1689
Documents
parameters
1699, 1701, 1701, 1702,
1703, 1704, 1705
domain separation
live feed
4428
MID Server
4642
domain separation setup

Discovery
4643
dynamic approval forms
6154
Dynamic Service Portal page
6801, 6802
Dynamic Service Portal page
titles
6806

E
e-signature approval
6145, 6146
approval tables, selecting
6147
de-activate
6146
local database, setting up
6147
plugin, installed with
6146
SAML 2.0 authentication,
setting up
6148
setting up
6150
Edge Encryption
1766, 1793, 1838, 1922, 1922,
1923
adding proxies
1834
attachment decryption job
1877
attachment encryption
1875
attachment encryption job
1876
attachment key rotation job
1869
attachments
1875
configuration
1866
configure
1924, 1924
database recovery job
1882 deactivate encryption
1872 decryption job
1874 dictionary attributes
1919 digital signature
1816 encryption application
1771 encryption change
1878 encryption deactivation
1872 encryption job
1872 encryption key
management
1773 encryption patterns
1879 encryption proxy
1771 encryption rule actions
1893 encryption rule conditions
1891 encryption rules
1887, 1891 encryption type
change
1878 deactivate
1872 encryption types
1777 field encryption
1870 file store
1826 getting started
1781 installation
1795
installed components
tables
1779 installer
1798, 1800, 1804, 1805,
1806, 1808, 1811, 1812
instance configuration
1870 Java Cryptography
Extension (JCE) installation
1819 Java KeyStore
1821 java.security policy file
1819 key management
1773, 1827 key rotation
1827, 1866 key store management
1773 keytool utility
1822 limitations
1789 Linux installation
1814 Linux uninstall
1836 Linux update
1863 mass encryption jobs
1881 mass key rotation job
1868 NAE key store
1823 order token repair job
1881 overview
1767 password encryption
1833 patterns
1777
prohibited keywords
1918
properties
1829
proxy download
1797
proxy properties
1841
proxy system requirements
1782
proxy update rollback
1865
proxy upgrade
1856
secure SSL connection
1817
set up encryption key
1820
set up keystore
1820
single key rotation job
1867
start the proxy
1812, 1832
stop the proxy
1836
user account
1797
web proxy configuration
properties
1830
Windows installation
1814
Windows uninstall
1837
Windows update
1864
Edge Encryption environment
memory
1787
Number of proxy servers
1787
redundancy
1787
edit catalog item
6377
edit item
6377
editing
Legacy notify
properties
4385
properties
Legacy notify
4385
e-mail
accounts
creating
4865, 4866
testing
4866
alternate configurations
4846
attachment limit properties
4901
client
SMS
5138
configuration
4842
creating an email client
template
5125
existing users, matching
5158
filters
4905
activating
4906
creating
4907
inbound actions
importing users
5159
inbound email
action criteria
5150
inbound email action
processing order
5170
configuring
5171
managing multiple filters
in an inbound email
action
5172
inbound email actions
5142
creating
5152
example: creating a
change request
5169
example: handling email
replies
5166
example: logging a
problem
5168
examples
5166
notifications
4910, 4928
baseline
4956
creating a notification
filter
5073
forcing delivery
5072
subscription-based
5046
accessing
5064
adding notifications
5065
creating a service
provider
5067
filtering notifications
with a schedule
5074
making mandatory
5071
OAuth 2.0
4858
OAuth authentication
4856
activating
4857
quick messages
5137
service availability
4842
size limits
4899
size restrictions
4842
standard configuration
4844
system mailboxes\4904
templates
4973
applying to a notification
4976
calendar integration
4982
convert to HTML
4977
creating
4974
the client
5114
Email
additional properties
4887
diagnostics
5009
inbound mail configuration
properties
4882
outgoing mail configuration
properties
4878
properties
4877
troubleshooting
5009
Email API
email digests
configuring
enabling in notification preferences
intervals
properties
email layout
creating
email layouts
email message
construct
email notification
specifying HTML content of
email notifications
applying a template
assignment groups
calendar integration
creating invitations for custom tables
mapping date fields to variables
catalog item designer
content pages links
converting to Rich HTML
creating
creating categories
creating custom watermark
document attachments
editing HTML in notifications
email
enabling record links
effects
assignment notification
priority 1 incident update
hiding watermarks
line breaks with rich HTML
omitting watermarks
specifying alternative outbound email
specifying outbound email address for a language
subscription-based advanced scripting for SMS
selecting a service provider
time zone
used by live feed
watermarks
email objects
accessing with variables
email retention plugin
activating
Enable automatic updates to the shopping cart

Enable automatic updates to the wish list

Enable the wish list in Service Portal

encryption
  API for MID Server

encryption proxy
  adding proxies
  digital signature
  download
  encryption key management
  file store

installer

Java Cryptography Extension (JCE) installation

Java KeyStore

java.security policy file

key management

keytool utility

Linux installation

Linux uninstall

Linux update

NAE key store

password encryption

properties

scheduled upgrade

secure SSL connection

start the proxy

stop the proxy

system requirements

update rollback

web proxy configuration properties

Windows installation

Windows uninstall
assessments
  6011
export scorecard
  image
  6200, 7207
extend
  pricing model
  6510
external credential storage
  1603
CyberArk
  configuration tasks
  1612
  configuring credential identifier
  1617
  configuring SNMPv2 credentials
  1616
  configuring the MID Server
  1614
  configuring the vault
  1612
  import the JAR file
  1613
  installing the AIM API
  1612
  JAR file for
  1620
F
  Field Service Management
    Configure a simple skill determination rule
    7119
  filters
    Notification conditions
    5053, 5053
  fix map
    1123
  flexible board tasks
    7362
  Flexible checkout
    6499, 6500, 6501, 6501, 6502
Flow Designer
  getting started
ab
workflows included with 5430
input variables parallel flow launcher 7660
install edge encryption 1813
Installation 4550, 4557, 4578, 4697, 4835
Installed with Catalog Item Designer 6682, 6684, 6684
instance data replication 2456, 2462, 2468
Instant Messaging 4365, 4366, 4367
Integrate Edge Encryption 1920
integration 1922
interaction activate 3886
channel metadata 3888
context 3888
create 3889
interaction connector hooks 3887, 3892
interactions 3886, 3890
ITIL 745
service design 746
service transition 747
ITIL configuration management 873
ITIL Configuration Management 740, 741
integration 744
J
J2SSH
long running commands 4830
JAR files synchronizing to MID Servers 4644
JavaScript MetricBase 4515
JDBC credentials 1578
JMS credentials 1579
JSON API 1910
JsonNode 1910
encodedQueryFor(String tableName) 1916
getAsString() 1914
getAsString(String propertyName) 1914
getIterator(String xPath) 1913
getName() 1915
iterator() 1914
valueFor(String tableName, String fieldName) 1915
JsonNode API 1913
JsonNodeIterator hasNext() 1916
next()
Knowledge management
  Request a knowledge base
  4267
  Service catalog
  4267
Knowledge Management
  3897, 3960
    Actionable Knowledge
    Feedback Properties
    3934
    activate plugin
    3964
    Article quality index
    4093
    article templates
    3966
    article versioning
      activate plugin
      4024
      approve article being reviewed
      4143
      compare versions
      3986
      configuration properties
      3930
      create new article version
      3984
      disable article versioning
      3987
      feedback on versions
      3979
      manually update customized files
      3976
      overview
      3975, 3980, 3982
      recall article being reviewed
      3986, 4142
      revert previous version to published
      3985
      version information
      3982

versioning changes
  3976
  view all article versions
  3985
  assign AQI checklist to knowledge base
  4096
  Automate feedback management
  4088
  case-to-article creation
  4102
  create a new article template
  3968
  create an AQI checklist
  4094
  create an article from a case
  4267
  define an external knowledge source
  4074
  delete questions from a checklist
  4097
  duplicate article numbers
  4084
  Enable actionable knowledge feedback
  4089
  external content integration
  4073
  Generate SEO tags for knowledge articles
  3974
  homepage
  4259
  internationalization
  4012, 4013
  Knowledge Advanced plugin
  3964, 4024
  Knowledge Management Service Portal
Knowledge Subscriptions
configuration properties
3932

knowledge subscriptions
4061, 4062, 4225, 4226, 4227, 4228, 4229, 4229

open search results content
4077

Perform AQI
4098

remove an AQI checklist
4097
roles
3904

run an import job
4076

secure article template
using encryption context
3971

Service Portal
4021, 4025, 4027, 4028, 4030, 4031, 4032

configuration properties
4020

set up
3939

submissions
4331

Track progress on feedback task
4092

view all pending and completed AQI checklists
4100

Work on feedback task
4090

Knowledge Management
(diagnose user criteria for articles)
4008

Knowledge Management
(diagnose user criteria for knowledge base)
4005

Knowledge Management
(User Criteria Diagnosis)
4005

Knowledge Management
Service Portal
widgets
4021, 4025, 4027, 4028, 4030, 4031, 4032

Knowledge submissions
4331

Knowledge subscriptions
4226
e-mail notification templates
4062
knowledge subscription notifications
4225
knowledge subscription properties
4061
manage knowledge subscriptions
4229
subscribe to knowledge article
4228
subscribe to knowledge base
4227
unsubscribe from knowledge article
4229
unsubscribe from knowledge base
4227
Knowledge v3
after migration

ah
default knowledge base
knowledge article view
knowledge portal changes
migrate knowledge content
migrating functionality
migration guide
publish and retire workflows
replace modules
security changes
using legacy knowledge

layouts
email

legacy chat
installed components
business rules
properties
tables
use legacy chat

legacy chat migration
Legacy Notify

conversion
viewing
properties
editing

viewing
public conference calls
Twilio
configuring
viewing
conversation
Legacy Notify
account status messages
administering
call
conference
call
Conference call
participants

account status messages
administering
call
conference
call

Conference call
participants

Legacy survey
migrate
6295, 7302
legacy surveys
migrate
6294, 7301

conference
call

Conference call
participants

link cart
catalog item
6514
Linux
1834
Lists menu
513

live feed
access from CMS pages
administer
bookmarking feeds
following feeds
4478
following other users
4475
messages
4473
multiple records
4461
post a message
4480
post content in live feed
post a message
4480
records
4456, 4458, 4459, 4459,
4460, 4461, 4461, 4462
selecting feeds
4477
UI usage
4472
update profile
4472
using
4440
using social IT
post content in live feed
4480
viewing another user
4474
live feed teams
security
4432
load balancers
F5 custom Orchestration
activities
5416
locked out user
inbound email actions
5161
M
manage
communication
7308
task communication
7308
managed document record
create
1696
managed documents
1690
Managed Documents
cancel a document
1720
check in a document
1718
check out a document
1721
concepts
1691
copy a document
1719
create a document
1709
create a document
collection
1721
create or request a new
document
1715
deactivate a document
1719
features
1690
install plugin
1692
plugin
1693
reopen a deactivated a
document
1719
roll back a document
1720
specify an approver
1717
upload a document
1722
manager notifications
enabling
6047
Manual Approvals

Conditions
7600
Input Variables
7600
Result Values
7600
States
7600
manually install
proxy server
1813
Map values
2478
message
Legacy Notify
viewing
4377
metric result
field names
6188, 7195
Metric Results
6050
metric types
6002, 6010, 6014, 6016, 6127
create
6003
Metric Types
6014, 6129
MetricBase
4491, 4493, 4504, 4518, 4536,
4539
Microsoft Exchange
activity pack
configuring MID Server for
5396
Create Address List
5397
Create Mailbox
5407
Delete Address List
5399
Delete Mailbox
5409
Disable Mailbox
5410
Enable Mailbox 5412
Get Address List 5401
Get Mailbox 5413
introduction to 5395
Move Address List 5402
passing multivalued properties 5397
Set Address List 5404
Set Mailbox 5415
Update Address List 5405

MID server
variables 4834
MID Server
4550, 4557, 4578, 4697, 4835
adding privileged commands 4831
authentication failure 4742
authorization failure 4742
auto-assignment 4615
automation status sets 4617
capabilities 4623, 5641
configuration
capabilities 4622, 5643
IP address range 4609
configure 1924, 1924

classify the ALL application 4608
configuring for SCCM 3866, 5337, 5482
configuring privileged commands for 4832
credentials for 1552, 5523
dashboard 4775
debug 1602
domain separation 4642
electronic API 4685
extensions
configuring the SNMP trap collector 4658
counting vCenter event collector 4653
SNMP trap collector 4657
vCenter event processor 4646
guided setup 4595
heartbeat 4835
installation 4548
installing on Linux 4559
installing on multiple machines 4590
installing on Windows 4571, 4582
integrate Edge Encryption 1924, 1924
keypairs used for encryption
rekey the MID Server
4705
mapping IP addresses to
DNS names
4620
network connectivity testing
4588
pause
4840
pausing
4839
pinning
4719
PowerShell authentication
failure errors
  troubleshooting an Active
  Directory activity
  5467
  troubleshooting an
  Exchange activity
  5468
PowerShell troubleshooting
5466
privileged commands for
4828
  pbrun special
  configuration
  4833
properties
4779
role validation
4556
selection criteria
4602
selection criteria for
5645
setting up role
4554
SNMP OIDs for IP range
auto-assignment
4616
specify MID Server
applications
4606
troubleshooting RCP server
5469
upgrades
4719
upgrading manually
4730
user compatibility
4731
user connectivity
4742
user connectivity
debugging
4751
validation of
4585
MID Server active issues table
4733
MID Server alerts
4736
MID Server cloning issue
4735
MID Server clusters
4626
MID Server Clusters
4627
MID Server configuration
4599, 4630, 4714, 4791, 4824
  memory size and allocation
  4837
MID Server requirements
  system
  4761
MID Server resource thresholds
4736
MID Server signed script file
4712
MID Server upgrade check
4726
MID Server upgrade error
messages
4719
MID Servers
  and JAR files
  4644
deploying
4593
Multiple provider SSO
1838

NetApp storage devices
credentials for
1571

New Menu configuration
218

New Menu items
218

NG CI relations formatter
1026

Nmap
installation
4632

Notification

Calendar integration
4982

Notification Activities
7625

Create Event
7625

Notification Activity
7626

Notification channels
5052

Notification conditions
5053, 5053

e-mail digests
5053

Notification message
subscribe
5061

Notifications
deactivate for surveys
6278, 7285

Editing devices
5061

e-mail client
5114

creating an e-mail client
template
5125

quick messages
5137

an
SMS 5138
email digests 4996
email unsubscribe links 4946, 5075
image filtering properties 4885
message body limit properties 4899
previewing 4932
push 5016
activating 5019
architecture 5018
business rules 5023
components 5023
creating a content record 5036
creating a push action 5041
creating a push message 5028
creating a push notification 5029
creating an attribute definition 5038
creating an attribute value 5040
handling failed messages 5042
installed with 5021
properties 5025
push application 5034
register 5030
responses 5018
REST messages 5023
roles 5023
setup with a custom mobile app 5031
setup with the ServiceNow mobile app 5026
tables 5021
setting up devices on user preferences 5059
Notify activate 5174
Associate a number to a group 5212
Business rules 5237
Conference call 5188
Configure Twilio 5178
Create a number group 5210
Creating Notify activities 5230
differences between Notify and Legacy Notify 5175
disconnect from Twilio 5181
event handlers 5230
events 5229
Forward call activity 5222, 7613
Hang up activity 5226, 7617
incoming calls
processing 5187
Input activity 5223, 7614
installed components 5231
kick a participant 5193, 5194
Languages 5230
migration 5176
mute a participant 5193, 5194
Notify on task 5200
Notify with incident communication plan 5203
Notify with on-call scheduling 5206
Number groups 5209
On-call: assign by acknowledgement workflow 5208
outbound requirements 5200
Play activity 5226, 7617
Properties 5234
Reject activity 5227, 7618
Roles 5232
Say activity 5228, 7619
Tables 5232
Using SMS 5198
variable substitution 7682
workflow activities 5217, 7613
Notify on task
Conference call from task 5201
SMS from task 5202
Notify with on-call scheduling
NotifyNow key differences 5209
Set up 5206
NotifyNow 4394
addConferenceCallParticipant(String conferenceCall, String participant)
convertLocalPhoneNumberToE164(String userID, String phoneNumber)
getConferenceCallParticipants(String conferenceCallId, Boolean isCallable)
getFrequentlyCalledUsers(Number limit)
getPreferredE164SMSNumber(GlideRecord user)
getPreferredE164VoiceNumber(GlideRecord user)
getPreferredEmailAddress(GlideRecord user)
getReadyState()
getStatus()
initiateConferenceCall(String, String, GlideRecord, Boolean)
isCallable(String participant)
isSMS Capable()
isSMS Capable(String userID)
isVoiceCapable()
isVoiceCapable(String userID)
kick(GlideRecord participant)
mute(GlideRecord participant)
sendTimeQuestion(String emailAddress, String question, GlideRecord sourceRecord, String emailSubject)
sendSMS(String phoneNumber, String smsBody, GlideRecord source)
sendSMS(String phoneNumber, String smsBody)
sendSMSQuestion(String phoneNumber, String question, GlideRecord sourceRecord)

SMS codes

umute(GlideRecord participant)
ODBC Driver 1922, 1923
ODBC truststore 1922
On-call scheduling with Notify Force communication channel 5207
on-cancel script defining 7534
one assessable record one category user, associating 6029
Orchestration activating 5268
Active Directory example 5358
Active Directory activity pack
Add User to Group 5367
Change AD User Password 5368
Create AD Object 5369
Disable AD User Account 5371
Enable AD User Account 5372
introduction 5365
Is AD Account Locked 5373
Query AD
Remove AD Object
Remove User from Group
Reset AD User Password
Unlock AD Account
Active directory user management
activities for workflows
reactivating deprecated activities
activity designer
activity scoping
auto-mapping JDBC output variables
auto-mapping REST output variables
auto-mapping SOAP output variables
creating custom activities
JavaScript probe activity, creating
JavaScript Probe execution command
JavaScript probe execution parameters
JavaScript probe template post-processing parameters
JDBC activity, creating
JDBC connections
JMS activity system setup
JMS activity, creating
JMS execution parameters
JMS template post-processing parameters
mapping output variables
output variables
parsing rules example
parsing rules, creating
parsing sources
PowerShell
PowerShell activity, creating
Powershell execution command
Powershell execution parameters
Powershell template post-processing parameters
Pre-processing fields
Probe activity, creating
Probe execution command
Probe execution parameters
5618
Probe template post-processing parameters
5620
REST activity, creating
5592
REST execution command
5600
REST execution parameters
5597
REST execution parameters, JavaScript array in
5598
REST template post-processing parameters
5599
reusing data
5639
run script activity, creating
5628
Run Script processing script
5628
SFTP activity, creating
5603
SFTP execution command
5613
SFTP template post-processing parameters
5612
SOAP activity, creating
5567
SOAP execution command
5574
SOAP execution parameters
5577
SOAP execution parameters, JavaScript array in
5579
SOAP input variables
5532
SOAP template post-processing parameters
5580
SSH activity, creating
5621
SSH execution command
5626
SSH execution parameters
5624
SSH template post-processing parameters
5625
Template outputs
5545
Template post-processing fields
5541
templates
5555
testing input fields
5537
testing JDBC input fields
5565
variables, mapping
5534
activity packs
5364
requesting activation
5283
applications included with
5296
Azure AD activity pack
5382
Add User to Group
5382
Assign User License
5384
Create User
5385
Delete User
5388
Get User Info
5389
Remove User from Group
5391
Remove User License
5392
Reset User Password
5393

basic activities
5285

client software distribution
SCCM deployment
workflow
5347

client software distribution
(CSD)
activating
5320
components installed with
5322
configuring providers
5354
creating catalog items for
SCCM applications
5344
creating software models
for SCCM
3870, 5341
dashboard
3880, 5351
deploying software from
SCCM
5333
extension keys
5356
extension points
3882, 5353, 5356
introduction to
5320
lease extensions
3861, 5332
licenses and counters for
3858, 5329
ordering software from
the service catalog
5330
plugins installed with
5324
properties for
5326
providing Windows
credentials for SCCM
5338
retrieving SCCM data for
5338
roles installed with
5324
SCCM configuration
3871, 5341
SCCM server Discovery
5340
SCCM software
revocation workflow
5351
script includes installed
with
5325
tables installed with
5322
validating installations
3877, 5348
workflows installed with
5328
configuring client software
distribution
revoking software not
installed by SCCM
5349
credentials for
1523, 1552, 5523
activating external
storage
1606
affinity
1601
basic authentication
1568
checking IP service affinity 1630
CIM 1570, 1585, 1588
cloud management 1572
configuring external storage 1620
configuring identifier of creating 1625 CyberArk integration 1608 external storage 1603 importing a JAR file for resolution of 1624 JDBC 1578 JMS 1579 NetApp storage devices 1571 SAP JCo 1582 SNMP 1583 SNMP community 1584 VMware 1596 Windows 1597 data encryption 5539 databus 5638 documentation links for 5264 example 5357 examples
5357 Exchange activity pack configuring MID Server for 5396 Create Address List 5397 Create Mailbox 5407 Delete Address List 5399 Delete Mailbox 5409 Disable Mailbox 5410 Enable Mailbox 5412 Get Address List 5401 Get Mailbox 5413 introduction to 5395 Move Address List 5402 passing multivalued properties 5397 Set Address List 5404 Set Mailbox 5415 Update Address List 5405 F5 custom activities 5416 F5 Network Management activity pack Add F5 Pool 5428 Add F5 Pool Member 5417 Add F5 Profile to Virtual Server 5421
Add F5 Virtual Server 5424
Check F5 Pool 5420
Delete F5 Pool 5427
Delete F5 Pool Member 5425
Delete F5 Virtual Server 5419
Get F5 Pool Member 5418
Modify F5 Virtual Server 5423
Global activities
introduction 5518
how probes work 5289
Infoblox activity pack 5429
Create Network 5450
Delete Network 5453
DHCP activities 5433
DHCP Delete IP Reservation 5434
DHCP List IP Reservations 5436
DHCP Reserve IP v4 Address Range 5433
DNS activities 5437
DNS Delete 5443
Get Network Details 5452
IPAM activities 5444
IPAM Delete 5449
IPAM List IP Reservations 5448
IPAM Register IP Address 5445
IPAM Reserve IP Address 5446
List DNS C-records 5437
List DNS Record 5442
List Registered Networks 5455
network activities 5450
Register DNS A-record 5439
Register DNS C-Record 5440
REST credential for roles and permissions needed 5431
workflows included with 5430
introduction to 5265
list of activities 5275
list of plugins 5270
MID Server autofinder mapping IP addresses to DNS names 4620
MID servers 5640
PowerShell credential tagging 5464
Powershell activities enable WMI Windows Installer Provider 5473
PowerShell activities
basic
5292
Run PowerShell
5292
Powershell activity pack
Change Service State
5473
Install Windows App
5471
Join Domain
5470
Restart Windows Server
5475
Uninstall Windows App
5476
PowerShell activity pack
HResult codes
5294
introduction
5456
PowerShell protocols
introduction to
5457
MID Server PowerShell files
5459
probe activities
Resolve DNS Name
5477
SNMP Query
5479
Test Server Alive
5518
Probe activity pack
5477
publishng custom activities
5636
returning locked activity to
published state
5636
runtime plugin
5273
SCCM activity pack
activating
5480
Add to Device Collection
5483
Add to User Collection
5484
configuring MID Server for
3866, 5337, 5482
Get Applications
5485
Get Deployments
5487
Get Device Collections
5488
Get User Collections
5490
introduction to
5480
Remove from Device
Collection
5493
Remove from User
Collection
5494
SCCCM software revocation
5348
revoking software
installed by SCCM
5349
SFTP File Transfer activity
pack
5495
Copy File
5500
Create Directory
5502
Get File List
5503
Remove File or Directory
5504
Rename File or Directory
5506
Set File Attributes
5507
workflow included with
5496
SSH activity pack
5508
File Copy
5514
File Read
5511
Files Compare
5510
Secure Copy
5509
SSH legacy activities
File Replace String
5515
File Write
5512
introduction to
5295
Reset Linux User Password
5516
Run Command
5295
Run SCP
5296
Update AD Object custom
activity
5381
Orchestration ROI
automation entry record
5298
correlated task rules
5300
installed components
5302
business rules
5306
client scripts
5305
plugins
5303
roles
5304
script includes
5305
tables
5302
UI actions
5304
introduction
5297
labor rate card
5297
premium reports
scheduled job for
5319
reports
activating premium
plugin
5317
introduction to
5306
premium
5315
standard
5306
standard reports
properties for
5314
scheduled job for
5314
time range for calculations
5301
order-preserving database
1811
Order-preserving encryption
1788
organize services in groups
1133
PA Indicator subscriptions
7149
page ID
6811
Page Route Maps
6811
page subheader
6798
page templates
1451
parallel flow launcher
example use of
7664
input variables
script values in subflow activities WorkflowCoordinator object parameters condition script
ParameterValue
encodedQueryFor(String tableName) toString()
valueFor(String tableName, String fieldName)
Password Change
design the process reports
password reset
activate enroll enroll Email verification enroll Google Authenticator enroll SMS password reset orchestration add-on
SMS codes
Password Reset
properties
5716
reports
5777
script includes
5749
Security Questions
5712, 5738
service desk-assisted
5771
SMS verification
5710
SOAP credentials
5705
unblock users
5773
user lockout
5731
user requests
5772
verification types
5742
verifications
5706, 5708, 5741
Password Reset CMS
Integration
5775
Password Reset Windows Application
5675
Per-User subscriptions
7149, 7160
Perform Data Certification
cancel a certification instance
1666
cancel all tasks in an instance
1671
cancel an individual task
1671
cancel certification tasks
1671
certification task form
1667, 1670
certification task list
1668, 1670
certify an element
1662
escalate a certification task
1667, 1668
export the certification list
1662
fulfill certification tasks
1660
mark certification task as closed incomplete
1670
reassign a certification task
1668
reset certifications
1664
send certification task reminders
1669
send email reminder
1670, 1670
track a certification task
1666
track task with certification instance
1665
view an audit result
1664
performance analytics dashboards
connect support
1424
Permissions in Workspace
144
pinning
in workflows
7684
pinning MID Servers
4719
plan type
define
7323
Planning Data Certification
plugins, subscription
7159
Populate services
1128
Portal CSS
6778
post content in live feed
add @mentions
4489
add a knowledge article
link
4487
add a link
4486
add a poll
4487
attach files
4482, 4482
attach images
4482
attach knowledge articles
4482
attach links
4482
clipboard
4484
copy an image
4484
delete a message
4491
like a message
4490
message
4487, 4489
messages
4482
post
4482, 4486, 4487
reply
4482, 4486, 4487
reply to a message
4481
Powershell
Change Service State activity
5473
Install Windows App activity
5471
Join Domain activity
5470
Restart Windows Server activity
5475
Uninstall Windows App activity
5476
PowerShell
HResult codes
5294
Orchestration activity pack
5456
protocols
introduction to
5457
MID Server PowerShell files
5459, 5464
troubleshoot authentication failure
Active Directory activity
5467
troubleshooting
5466
troubleshooting authentication failure
Exchange activity
5468
troubleshooting RCP server
5469
privileged commands
adding for MID Server
4831
configuring for MID Server
4832
MID Server
4828
pbrun special configuration
4833
probe activities
  Resolve DNS Name
  5477
  SNMP Query
  5479
  Test Server Alive
  5518
Probe activity pack
  introduction
  5477
processing
  requests
  category
  6667
producer replication set
  2462
properties
  1923
  Legacy notify
  editing
  4385
  viewing
  4385
  MID Server
  4779
Properties
  Notify
  5234
proposed changes
  create validation script
  1019
  edit validation script
  1019
  verify
  1018
proxy database
  1811
Proxy database
  size
  1788
Proxy Error Reports
  1925
Proxy performance
  dashboard
  1925
proxy server
  1922
  set initial memory
  1831
  set memory
  1831
  set upper bound memory
  1831
proxy server installation
  1813
publish a document
  managed documents
  1697
publishing
  approval
  types
  6663
  task assignment
  types
  6666
put the class name here
  4256, 4258
question
  Legacy Notify
  creating
  4375
  viewing
  4374
  types
  defining
  6659
questions
  in quizzes
  6092
quiz
  6325
  questions
  6092
quiz designer
  6076, 6081, 6086, 6088, 6088, 6102, 6103, 6106, 6107, 6305, 6310, 6317, 6318, 6319, 6320, 6321, 6322, 6323
Quiz Designer
tools
   6076, 6305
Quiz Overview module
   6075, 6304
quiz reports
   6107, 6333
quiz scorecards
   6062, 6109, 6109, 6110, 6111, 6113, 6114, 6328, 6329, 6330, 6332
quizzes
   6071, 6300
   activate
   6074, 6304
administer
   6070, 6303
categories
   6071, 6300
category user
   6071, 6300
create
   6079, 6309
process
   6070, 6303
questions
   6071, 6300
roles
   6071, 6300
set up
   6070, 6303
templates
   6071, 6300

R
recipient list
   define
   7322
Reconciliation
   1189
record feed
   4461, 4461
record feeds
   add live feed
   4418, 4419
   configure
   4418
configure security
   4420
context menu
   4419
disable
   4416, 4420
form header
   4418
Record Producer
   6349, 6349, 6353, 6354, 6355
Record view
   216
relationship editor
   filter list of CI relationships
   1036
   select a CI relationship type
   1036
   select targets
   1036
relationship filter
   create
   1032
   edit
   1032
replace CI
   1123
Replication, bi-directional
   2484
report lowest table
   Glide hierarchy
   7502
reports
   Orchestration ROI
   5306
   premium
   5315
   standard
   5306
   premium for Orchestration ROI
   activating plugin
   5317
request
getAsJsonContent()
1894, 1899
getAsXmlContent()
1895, 1900
XMLContains(String path)
1895
Request an order guide from Service Portal
6588
request API
1894
request fulfillment
manage
6618
requests
category
processing
6667
reset your password
5787
response
Legacy Notify
choice
4376
creating
4376
responsibilities
definition
7325
REST API
4908
REST API MetricBase
4515
REST MetricBase
4504
ribbon settings
260
ROI for Orchestration
automation entry records
5298
correlated task rules
5300
installed components
5302
business rules
5306
client scripts
5305
plugins
5303
roles
5304
script includes
5305
tables
5302
UI actions
5304
introduction to
5297
labor rate cards
5297
premium reports
scheduled job for
5319
properties for
5314
standard reports
scheduled job for
5314
time range for calculations
5301
roles
MID Server
4554
user set
7158
Roles
Notify
5232
rollback to
behavior
7604, 7680
Rollback To
States
7603
rollback to activity
7605, 7680
RSA key pair
1804
SAP credentials
1582
Save business service as IT service
1120
SC Categories widget
6909
SC Order Guide Widget
6914
SC Scroll to top widget
6919
SC Shopping Cart widget
6921
SC Wish List Cart widget
6926
SCCM
configuring collections for
3871, 5341
creating catalog items for
5344
creating software models for
3870, 5341
deploying software with client software distribution (CSD)
5333
deployment workflow
5347
discovering SCCM server
5340
lease extensions
3861, 5332
ordering software from the service catalog
5330
retrieving data for client software distribution
5338
revoking software installed by
5349
revoking software installed by another process
5349
revoking software with
5348
software revocation workflow
5351
validating deployments
3877, 5348
Windows credentials for
5338
SCCM activity pack activating
5480
Add to Device Collection
5483
Add to User Collection
5484
configuring MID Server for
3866, 5337, 5482
Get Applications
5485
Get Deployments
5487
Get Device Collections
5488
Get User Collections
5490
introduction to
5480
Remove from Device Collection
5493
Remove from User Collection
5494
SCCM cmdlet libraries
3865, 5336
SCCM configuration
3863, 5334
SCCM roles
3863, 5334
schedules
Notification conditions
5053, 5053
Scoped GlideElement
using JavaScript 4950
service administration 5947
service catalog 6334
  adding to 6368
catalog items 6369, 6369
catalog variables 6432
catalog variables, content items 6368
create 6369
Define a question choice 6432
defining 6369
hiding prices 6511
navigating 6646
requesting item 6650
searching 6648
set up 6337
UI policy 6391
url 6338
variables 6432, 6432
  auditable 6441, 6652
viewing 6646
Service catalog 144
  Catalog Items 6347
  Categories

Extension 6348, 6513
Items 6473
Requests 6651
script 6392
Scripting 6348, 6513
Variable pricing 6505, 6506, 6507, 6510
Service Catalog 5937, 5937, 5939, 6455, 6535, 6729, 6735
  access by a script 6482
  access by role 6481
  access controls 6468, 6469, 6472, 6472,
    6474, 6476, 6477, 6479, 6480
  administration 6480
  configuration 149
  data structure differences 6478
  Debug actions on catalog item variables 6447
  Debug UI customization 6654
desktop order status configure 6496
hiding prices 6510, 6511
item widgets configure 6490
mobile order status configure
catalog data lookup
definition record
6438
catalog data lookup
create custom catalog
data lookups
6440
catalog data lookup
create custom data lookup
table
6440
data lookup table
6440
data lookup value
6440
troubleshooting
6441
Service Catalog forms
6735
Service Catalog item designer
6656
Service Catalog
Management
catalog item designer
6668, 6668, 6670, 6671, 6672, 6676, 6677, 6679, 6680, 6681, 6681, 6682, 6682
enabling
6501, 6518, 6641, 6642, 6642
execution plan
6629, 6629, 6633, 6641
installed components
6701
script includes
6701
multiple service catalog
6342, 6342, 6544
service catalog data
lookup
6437, 6438, 6440, 6440, 6440, 6441
service catalog order
guides
6356, 6357, 6360, 6360, 6362, 6363, 6365, 6365, 6366, 6366, 6367
two-step checkout

6496
Multiple
6338, 6339, 6341, 6341, 6379, 6532, 6543, 6545
one-step shopping cart
configure
6493
order guide widgets
configure
6489
Request a catalog item
6585
roles
6335
search for a catalog item
6521
Service Portal
6579
terms
6335
two-step shopping cart
configure
6494
two-step shopping cart
mobile
configure
6492
UI Macro
6743
UI policy
6387
creating
6388
user criteria
6477
using
6646
Watch a variable
6449
wish list
configure
6491
Workflows
6619, 6621, 6624, 6627
Service Catalog Data Lookup
Service Catalog Order Guides

cascade
create rules
create variables
enforcement
example
mandatory field
new employee hire
order guide
order guides
order process
ordered items
variable set
variables

Service Catalog parameters

Service Catalog properties

Service Catalog Renderers

Service Catalog requests
add new request items
create incident
create change request
delete request items
place a request

view request status
service delegation
Service Desk
service mapping
service groups
Service Mapping
business service
changes
compare configuration files
configuration files
credentials for
applicative credentials
IT service
map
MID Server
view configuration files
WinRM
service portal
Service Portal
advanced search source
before you begin
Branding Editor
carousel widget slides
Catalog Item Widget
   6908
CMS
   6727
Config Overview widget
   6931
contextual search
   7034
core concepts
   6726
create user criteria
   7060
custom CSS
   6784
debug URL redirects
   7054edit widget option schema
   6957
Faceted Search widget
   6872
homepage
   6799
KB News Widget
   6889
KB search widget
   6891
KB View 2
   6895
KB View widget
   6894
Language Switch widget
   6849
Link button widget
   6849
login page configuration
   7053
login widget
   6850
My Requests widget
   6853
nested widgets
   6964
page
   create
   6793
Page Map widget
   6933
pages
   6792
portal
   6764
Portal Config widget
   6932
Portal Map widget
   6934
properties
   6761
public pages
   7054
redirect after login
   7053
Request a catalog item
   6585
role-based pages
   7054
Sample Footer widget
   6864
Save Bundles widget
   6917
Saved Carts widget
   6918
search
   7010
Search Page widget
   6876
search source
   7014
Simple List widget
   6861
sp_instance extension table
   6958
Theme Preview widget
   6934
URL redirects
   7052
user criteria
   7057
Variable Editor widget
   6925
widget
Service Portal Contextual Search widget
6871
Service Portal Cool Clock widget
6837
Service Portal CSS
6778
Service Portal current status widget
6938
Service Portal data table widget
6838
Service Portal default search sources
7033
Service Portal e-signature
7065
Service Portal error page default
6800
Service Portal example widgets
6826
Service Portal font icon in a widget
6970
Service Portal font-icons in a widget dependency
6972
Service portal header menu
6789
Service Portal headers and footers
6788
Service Portal home page search widget
6874
Service Portal HTML widget
6845
Service Portal Icon Link widget
6846
Service Portal icon menu list widget
6847
Service Portal KB also in Category widget
6880
Service Portal KB article page widget
6883
Service Portal KB categories widget
6884
Service Portal KB category page widget
6885
Service Portal KB most viewed widget
6888
Service Portal KB Top Rated widget
6892
Service Portal knowledge management widgets
6880
Service Portal list of widgets
6824
Service Portal navigation
6811
Service Portal page navigation
6810
Service Portal Planned Maintenance widget
6939
Service Portal Request Fields widget
6903
Service Portal Requested Items widget
6904
Service Portal SC Category Page widget
6912
Service Portal SC Popular Items widget
6916
Service Portal SCSS
7078
Service Portal SCSS mixins
7085
Service Portal SCSS nesting
7083
Service Portal SCSS operators
7084
Service Portal SCSS variables
7078
Service Portal search widgets
6870
Service Portal security
7051
Service Portal service catalog widgets
6898
Service Portal Service History
6939
Service Portal Service Status legend widget
6941
Service Portal Service Status Subscription widget
6941
Service Portal Service Status widget
6940
Service Portal service status widgets
6936
Service Portal setup
6758
Service Portal supported client scripts
6746
Service Portal Ticket Attachments widget
6864
Service Portal Ticket Conversations widget
6865
Service Portal Ticket Location widget
Service Portal Typeahead
Search widget
Service Portal unsupported client scripts
Service Portal unsupported features
Service Portal URL
Service Portal User Profile widget
Service Portal widget instances
Service Portal widget showcase
Service Portal widgets
Service Release Automation Orchestration Runtime plugin
Service Workspace
set order example
set url
catalog
Setting Up Chat Queues for Help Desk Chat
add custom link
assign service desk staff
chat queue
define a chat queue
end user
ess portal
help desk chat
link syntax
monitor chat queues
monitor help desk chat tasks
SFTP File Transfer activity pack
Copy File
Create Directory
Get File List
Get File List introduction
Remove File or Directory
Rename File or Directory
Set File Attributes
workflow included with
signature key
configure
signatures for assessments
create
Skills Management
Configure skills
Qualify and rank users based on skills and skill levels
SMS codes
NotifyNow password reset
5711
password reset
5711
SMS verification
Password Reset
5710
SNCSHH
long running commands
4830
SNMP community credentials
1584
SNMP credentials
1583
SNMP OIDs
for MiD Server IP range
auto-assignment
4616
SNMP trap collector
4657
configuring
4658
SNMPv3 credentials
1585
social it administration
get started
4336
social it
4336
Social IT Administration
set up chat queues for help
desk chat
4368, 4368, 4369, 4370,
4371, 4371, 4372, 4372
software licenses
creating licenses and
counters for CSD
3858, 5329
solution
1358, 1426, 4063
Solutions
95, 7139
SSH
Update AD Object
orchestration activity
5381
SSH activities
File Replace String
5515
File Write
5512
SSH activity pack
File Copy
5514
File Read
5511
Files Compare
5510
introduction
5508
Secure Copy
5509
SSH credentials
1588
SSH legacy activities
introduction
5295
Reset Linux User Password
5516
Run Command
5295
Run SCP
5296
stakeholders
6023
State closure in the request
fulfillment flow
6645
state flows
installed components
6159
business rules
6159
script includes
6160
tables
6159
rebuilding
6160
State Flows
Static Service Portal page 6801, 6802

Strong identification rule 1191

Style in Content Management
  design theme 1500
  design themes 1500
  frame 1502
  frame UI macro 1503

Style in Content Management
  style sheets 1499

subflow activities
  parallel flow launcher example 7664
  parallel flow launcher for 7660
  parallel flow launcher input variables 7660
  script values in 7663
  WorkflowCoordinator object in 7663

subflows 7437, 7667
  inputs for 7440
  invoking in a parent workflow 7440
  preparing for use in a parent workflow 7441

variables passed from parent workflow 7439
subscription allocation
  color codes 7135
subscription histories 7158
Subscription Management
  color codes 7130
  user sets 7162
Subscription Management admin guide 7148
Subscription Management application 7180
Subscription Management setup guide 7133
subscription plugins 7159
subscription types 7149
subscription user sets 7162
subscriptions
  allocate users to 7160
  monitoring 7180
  not in list 7155
Subscriptions list 7150
sudo commands
  long running 4830
suggested CI relationship
  add 1023
survey
urls
6276, 7283
synchronize services
1128

T

table access
live feed
4428
table notifications
live feed examples
4424
setting up for non-task
tables
4423
tables installed with live feed
4434
Task
conditions
6638
script
6639
skipped
6634
Task Activities
7634, 7634, 7634, 7635, 7641, 7678
task assignment
types
changing
6666
defining
6664
expiring
6666
publishing
6666
task communication
management
7308
overview
7308
topics
task management
7308
  overview
    7308
task table notifications
  live feed
    4421
task type
  define
    7324
tasks
  delegate
    5945
tcm
  topics
    7315
templates
    315
Time
  view system logs
    5012
time series metric
    4504
Timeline Visualization
  create
    7332
  create view
    7335
  use Timeline Visualization
    7336
timeline visualizations
  installed components
    7330
Timeline Visualizations
  7328, 7329, 7332, 7336
  lanes, markers, and panels
    7337
  personalize Timeline Visualizations
    7338
  slider and slider track
    7342
  view timeline visualizations
    7343
  work with timeline visualizations
    7343
Tokenization
    1788
  transfer chat to agent
    538
  transfer chat to queue
    537
Transform business service
    1120
Transforms
    2478
transitions that do not terminate on an activity reporting
    7497
trigger
    4516
Trigger
  2489, 4529
trigger condition
  create
    6264, 7271
  example
    6267, 7274
  for assessments
    6043
trigger conditions
  6264, 7271
Trigger flows using MetricBase
    4532
troubleshoot map
    1123
Twilio
  account
    associating
      4382
  endpoints
    configuring
      4384
  Legacy notify
    configuring
      4381
types
approval
changing
6664
defining
6662
expiring
6664
publishing
6663
question
defining
6659
task assignment
changing
6666
defining
6664
expiring
6666
publishing
6666

U
UI actions
Agent workspace
403
UI Macro
Service Portal
6743
UI policies
Catalog Item Designer
6685
UI policy
service catalog
6391
Unlimited subscriptions
7149
Unrestricted user subscriptions
7149
Update services
1128
update sets
use with assessments
6012, 6281, 7288
use with surveys
6012, 6281, 7288

upgrade
proxy server
1861
Upgrade test
4726
upload document
attachment
1699
usage
subscriptions
7180
Use Chat
add a favorite room
4357
add favorite user
4347
change the display
4356
chat window
4354
create a chat room
4349, 4351
delete a chat room
4359
invite a user
4357
join chat room
4352, 4353, 4353
join one-to-one chat
4352
message
4355
remove a favorite room
4357
remove favorite user
4347
send emoticons
4355
send message
4354
set chat preferences
4358
start a one-to-one chat
4349
task
4351, 4353
Task record
4353
Update profile
4343
Update status
4344
Use favorites list
4345
View a room
4348
View online user
4347
Use feeds in live feed
Activity stream
4465
Create a group feed
4463
Create record feeds
4464
Delete a feed
4471
Group feed
4468
Invite a new member
4468, 4469
Leave a feed
4471
Live feed
4465, 4471
Mark a feed as a favorite
4467
Navigate
4471
Other modules
4471
Participate in a feed
4466
Record feed
4469
Record feeds
4465
Records
4465
Remove a member from a feed
4469
Subscribe to a feed
4470
View a feed
4468
View a feed member
4468
Use form templates
570
Use hashtags in live feed
Add an image to a hashtag
4443
Bookmark a hashtag
4445
Change a hashtag
4442
Follow a hashtag
4444
Merge a hashtag
4442
Posted message
4446
Remove a hashtag
4446
Tag messages
4441
Unfollow a hashtag
4444
View available hashtags
4442
Use knowledge
Mobile
4268
Use teams in live feed
Automatic team creation
4449
Create a team
4447
Delete a team
4455
Email
4453
Email notification
4452
feed notification
4453
invite a new member
4451
join a team
4449
leave a team
4453
manage
4454
membership request
4454
modify a team
4453
remove a member
4451
reply to notifications
4453
subscribe
4452, 4453
team
4453
team notification
4452
view a team feed
4450
view a team member
4450
useful attachment scripts
4953
user access
  event management
    1135
  service mapping
    1135
user creation
  enabling automatic creation
    5159
user criteria
  Service Portal
    7057
user notification preferences
  channels
use feeds in Live Feed

use hashtags in live feed

use teams in live feed

Using Social IT
use chat

using workflows
generate approvals

Using Workflows
workflow concepts

utility activities
branch activity

join activity

lock activity

log message activity

log trace message

REST message activity

Return value activity

Run script activity

set values activity

SOAP message activity

turnstile activity

unlock activity

workflow

Utility Activities
join activity

Variable attributes
service catalog

Variable editor
service catalog

variable types

variables

 passing between tasks

service catalog

vCenter event collector
configuring

vCenter event processor
4646

Verifications
configuring

view

bubble charts
survey results
6187, 7194
View a quiz instance
6327
view legacy chat messages
journal field
4360
View MetricBase data
4514
View MetricBasedata
4515
View System Logs
e-mail logs
5012
View the overview of all
surveys
6202, 7209
viewing
calls
conference
4379
conference
call
4379
Legacy notify
conversation
4378
properites
4385
Legacy Notify
message
4377
question
4374
properties
Legacy Notify
4385
visual task board
checklist template
7370
visual task board checklist
template
7370
visual task boards
7344
activate
7346
attachments
7365
browser support
7351
card details
7363
checklists
7368
configuring
7372
creating new
7370
deleting
7371
client script
7351
configuring
7384
connect
sharing visual task boards
in
1382, 1400, 7381, 7382
deleting
7357
favorite
7378
flexible boards
adding tasks to
7363
creating
7356
freeform boards
adding personal tasks to
7360
adding tasks to
7361, 7361
configuring card limit
7397
creating
7355
moving cards between
boards
7374
tasks 7360
guided boards
  adding tasks to 7363
  creating 7356
installed components 7347
  business rules 7349
  client scripts 7349
  notifications 7350
  properties 7348
  tables 7347
labels
  configuring 7388
lanes
  adding 7358
  deleting 7358
  modifying 7358
members
  adding 7379
  removing 7379
script 7351
scripting support 7351
SLA indicators 7380
task cards 7360, 7360
  archiving 7372
  assigning 7367
labels 7366
moving between boards 7374
moving between lanes 7374
opening form view of 7373
using 7355
viewing board information 7376
Visual task boards
  installed components 7348
Visual Task Boards
  list view 7379
VMware credentials 1596
VTB
  card view configuration 7398
Weight for metric categories 5988
widget client script 6978
widget client script global functions 6992
widget developer guide 6945
widget empty state 6945
widget html template 6980
widget server script 6978
widget server script variables 6992
Widget tutorial
Windows credentials 1597
Wish List 6652
WMI Windows Installer Provider 5473
workflow
  activity designer
    activity packs 5364
    copying activities 5637
    Template conditions 5554
  canceling 7532
  context
    administrating 7529
  menu options 7408
  performance timing 7569, 7570
  roles 7529
  scheduling 7535
  title bar controls 7408
Workflow
  Documentation tab 7420
  estimated run time 7554
  estimated run time updates 7555
  Estimated Runtime tab 7420
  execution history table 7565
  execution path timelines 7565
  gauges 7568
  General tab 7420
  History (Past Contexts) tab 7420
  Inputs tab 7420
  monitor 5647, 7567
  Orchestration Usage Dashboard 5647
  outlying run times 7554
  overview 7398, 7399, 7529
  properties 7420
  run time metrics, enable 7554
  run time metrics, overview 7553
  Schedule tab 7420
  Stages tab 7420
  troubleshoot 7564
  variables 7445, 7446, 7447, 7448, 7449, 7450, 7450, 7451, 7451, 7452, 7452
  Version tab 7420
  Workflow Operations Dashboard 7567
workflow activities
  activity designer 7570
  activity result value 7677
  adding to a workflow
core

correcting skipped activities

creating custom transitions

duplicating in a workflow

elements listed

locked versions

managing conditions

managing transitions between

Orchestration

pinning introduction

publishing a custom activity

utility activities

workflow activity

Forward to notify client

queue

Send SMS

Workflow activity

Call

Forward call

Hang up

Join conference call

Reject call

Say

Workflow Activity

Input

Play

Workflow Administration

error

errors

workflow timelines

Workflow Concepts

data separation

delegated administration

domain separation

restrictions

workflow caching
workflow engine operation
order
7524
workflow permissions
7523
workflow scope
7518
workflow tables
7526
workflow versions
7518
workflows
7519, 7521, 7523
Workflow Editor
7403
Workflow Error Handling
approval condition
7553
Workflow Events
7453, 7454, 7458, 7461, 7463
Workflow Field
7478, 7480, 7482, 7483, 7484, 7489
Workflow icons
7482
workflow movement with
update sets
7536
avoiding duplicate
workflows
7542
commit a workflow in an
update set
7543
input variable movement
7540, 7540, 7541
input variable removal
7541, 7541, 7542, 7542
update set migration
7543, 7544
workflow update set
migration
7536, 7537, 7537, 7538
workflow run
determine
7434
workflow run time metrics
7569
Workflow stage icons
7482
workflow stage sets
7474
add a stage set
7477
create a stage set
7474
export a stage set
7477
import a choice list
7476
use default
7471, 7476
Workflow Stages
7465, 7468, 7471, 7472, 7472,
7473
Workflow validation
7432, 7489
Workflow Validator
validate subflows
7498
ValidateDanglingTransition
7497
ValidateInputVarUpdateSetDependencies
7513
ValidateLowestCommonTable
7502
ValidateParentFlow
7504
ValidateScriptForCurrentDotUpdate
7500
ValidateSingleEnd
7505
ValidateTableChange
7502
validateTransitionIn
7496
ValidateTransitionOut
7494
ValidateUpdateSetDependencies
7507
ValidateUpdateSetParentDependencies
7510
ValidateWorkflowEndStages
7513
ValidateWorkflowStageColumn
7514
ValidateWorkflowStateValues
7515
workflows
add activities
7431
cancel with a script
7534
cancelContext(context) methods
7534
cancelContext(context)
check out
7435
create
7419, 7425, 7427, 7429
edit
7435
ending with multiple branches
7431
error tracking for
7550
invoking subflows in
7440
palette
7406
passing variables to a subflow
7439
prepare for adding subflow
7443
preparing a subflow for
7441
publish
7433
selecting activities for
7406
subflow inputs
7440
subflows in
7437, 7667
Workflows
2489
Service catalog
6619, 6621, 6624, 6627
X
XML API
1901
XmlContent
1901
XMLContent
getIterator()
1905
getIterator(String xPath)
1905
XMLContent API
1905
XMLElement
encodedQueryFor(String tableName)
1908
getAttributeValue(String attribute)
1909
getIterator(String xPath)
1907
getIteratorOverAllChildren()
1907
getName()
1909
valueFor(String tableName, String fieldName)
1908
XMLElement API
1907
XMLElementIterator
hasNext()
1906
next()
1906
XMLElementIterator API
1906